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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
Industry Sector
Postfach 48 48
90026 NÜRNBERG
GERMANY
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System overview of STEP 7 and WinCC 1
1.1 Scaling of STEP 7 and WinCC in the TIA Portal

Scope of performance of the products
The following graphic shows the scope of performance of the individual products of STEP 7 
and WinCC:

* Only with STEP 7 Professional for S7-300/400/WinAC and S7-1500

**  With installed optional package "STEP 7 Safety Advanced"

STEP 7
STEP 7 (TIA Portal) is the engineering software for configuring the SIMATIC S7-1200, 
S7-1500, S7-300/400 and WinAC controller families. STEP 7 (TIA Portal) is available in two 
editions, depending on the configurable controller families:

● STEP 7 Basic for configuring the S7-1200

● STEP 7 Professional for configuring S7-1200, S7-1500, S7-300/400 and WinAC
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WinCC
WinCC (TIA Portal) is an engineering software for configuring SIMATIC Panels, SIMATIC 
Industrial PCs, and Standard PCs with the WinCC Runtime Advanced or the SCADA System 
WinCC Runtime Professional visualization software.

WinCC (TIA Portal) is available in four editions, depending on the configurable operator control 
systems:

● WinCC Basic for configuring Basic Panels
WinCC Basic is included with every STEP 7 Basic and STEP 7 Professional product.

● WinCC Comfort for configuring all panels (including Comfort Panels, Mobile Panels)

● WinCC Advanced for configuring all panels and PCs with the WinCC Runtime Advanced 
visualization software
WinCC Runtime Advanced is a visualization software for PC-based single-station systems. 
WinCC Runtime Advanced can be purchased with licenses for 128, 512, 2k, 4k as well as 
8k PowerTags (tags with a process interface).

● WinCC Professional for configuring panels and PCs with WinCC Runtime Advanced or 
SCADA System WinCC Runtime Professional. WinCC Professional is available in the 
following editions: WinCC Professional for 512 and 4096 PowerTags as well as "WinCC 
Professional max. PowerTags".
WinCC Runtime Professional is a SCADA system for structuring a configuration ranging 
from single-station systems to multi-station systems including standard clients or web 
clients. WinCC Runtime Professional can be purchased with licenses for 128, 512, 2k, 4k, 
8k, and 64k PowerTags (tags with a process interface).

With WinCC (TIA Portal), it is also possible to configure a SINUMERIK PC with WinCC Runtime 
Advanced or WinCC Runtime Professional and HMI devices with SINUMERIK HMI Pro sl RT 
or SINUMERIK Operate WinCC RT Basic.

1.2 Options for STEP 7 Engineering System

Additional STEP 7 products
For applications with increased safety requirements, STEP 7 Professional can be 
supplemented with the STEP 7 Safety Advanced option.

When using the STEP 7 Safety Advanced option, you can configure failsafe I/O and program 
safety programs for F-CPUs in LAD and FBD.

1.3 Options for WinCC Engineering and Runtime systems
SIMATIC Panels as well as WinCC Runtime Advanced and WinCC Runtime Professional 
contain all essential functions for operator control and monitoring of machines or plants. 
Additional options allow you to extend the functionality in some cases to increase the range 
of available tasks.

System overview of STEP 7 and WinCC
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Options for Comfort Panels, Mobile Panels, Multi Panels
The following possible extensions are available for Comfort Panels, Mobile Panels, and Multi 
Panels:

● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail and electronic signature for regulated applications)
 

 Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, WinCC 
flexible /Sm@rtAccess options as well as the WinCC flexible /OPC Server option are 
incorporated into the basic functionality.

 

Options for WinCC Runtime Advanced
The following possible extensions are available for WinCC Runtime Advanced:

● WinCC SmartServer (remote operation)

● WinCC Recipes (recipe system)

● WinCC Logging (logging of process values and alarms)

● WinCC Audit (audit trail for regulated applications)

● WinCC ControlDevelopment (extension by means of customer-specific controls)
 

 Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, WinCC 
flexible /Sm@rtAccess options as well as the WinCC flexible /OPC Server option are 
incorporated into the basic functionality.

 

Options for WinCC Runtime Professional
The following possible extensions are available for WinCC Runtime Professional:

● WinCC Client (standard client for structuring multi-station systems)

● WinCC Server (supplements WinCC Runtime to include server functionality)

● WinCC Recipes (recipe system, formerly WinCC /UserArchives)

● WinCC WebNavigator (Web-based operator control and monitoring)

● WinCC DataMonitor (display and evaluation of process states and historical data)

● WinCC ControlDevelopment (extension by means of customer-specific controls)

System overview of STEP 7 and WinCC
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 Note

In contrast to WinCC V7, functions from the WinCC /OPC-Server and WinCC /
ConnectivityPack options are incorporated into the basic functionality. Likewise, the basic 
functionality includes the Runtime API from WinCC /ODK.

 

System overview of STEP 7 and WinCC
1.3 Options for WinCC Engineering and Runtime systems

WinCC Professional V13.0
36 System Manual, 02/2014



Readme 2
2.1 General notes

The information in this readme file supersedes statements made in other documents.

Read the following notes carefully because they include important information for installation 
and use. Read these notes prior to installation.

Notes on the information system
The following function is already described in the information system, but is not available in 
TIA Portal V13:

● Hardware comparison of devices

Functions for S7-1200 as of firmware version V4
In the information system for the TIA Portal V13, functions are documented for S7-1200 as of 
firmware version V4 which are not yet available in the software.

The 64-bit data types will be available for an S7-1200 as of firmware version V4.

User-defined documentation
On the product DVD under "Documents\UserDocumentation", you will find instructions for 
creating and using user-defined documentation.

Display of interfaces via online access
If the Ethernet interfaces for online access are not displayed sporadically, install hotfix 
KB2588507 (for Microsoft Windows) from the Microsoft Support website.

Internet link: http://support.microsoft.com/kb/2588507 (http://support.microsoft.com/kb/
2588507/en-us)

Display of Asian characters in the TIA Portal
If the Chinese TIA Portal is installed on a different Asian Windows operating system (for 
example Korean) and texts are not displayed correctly in the TIA Portal, select English as the 
"Language for non-Unicode programs" in the Windows Control Panel.

Instruction "GET_NAME: Read out name of a module"
According to the online help, the read name depends on the IO device type. 

For an HMI Panel, however, it is not the name of the station that is output – as described in 
the online help – but the name of the interface module.
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Online operation in hibernate mode
We recommend that you do not use the two options "Hibernate" and "Sleep" in online operation; 
if you do, communication problems could occur. If necessary, adapt the computer's energy 
options.

Installing new .Net versions or .Net service packs
● Close the TIA Portal before installing a new .Net version or a new .Net service pack on your 

programming device/PC.

● Restart the TIA Portal only after successful installation of the new .Net version or the 
new .Net service pack.

Notes on handling
● If a project in the list of projects last used is located on a network drive that is not connected, 

you may experience delays when opening the "Project" menu.

● When you insert a CPU, you may need to wait for some time if the project editor is open at 
the same time. This generally takes longer when you insert the first CPU in a newly created 
project. To be able to continue working more quickly, you should close the project editor 
before inserting a CPU.

● The alarm "Application is not responding" may appear in Windows 7 with functions that 
take a long time to run (loading the CPU for example). If this occurs, wait until the function 
has correctly finished.

● If you have installed a Microsoft mouse with IntelliPoint, you may find that it superimposes 
components over the buttons of the title bar. If this is the case, uninstall the IntelliPoint 
software from Microsoft.

● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. In 
this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver.

Using the TIA Portal via a remote desktop
In principle, it is possible to use the TIA Portal via a remote desktop connection. During 
configuration, you should, however, avoid disconnecting the connection to the desktop client. 
In rare cases, this can lead to the software user interface being blocked.

If you experience this blockage, follow these steps on the desktop client.

1. Open the Windows Task-Manager and close the "rdpclip.exe" process.

2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that the current content of the clipboard will be lost. You can, however, then continue 
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next 
opportunity.
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Notes on SIMATIC memory cards
The SIMATIC memory cards have been formatted and set up by Siemens for use with S7-1200 
and S7-1500 modules. This format must not be overwritten; otherwise, the card will no longer 
be accepted by the modules. Formatting with Windows tools is therefore not permitted.

Behavior in case of open force job
Note that an active force job is retained even after you have loaded a new project to the 
SIMATIC memory card. This means you should first delete the active force job before you 
remove a SIMATIC memory card from the CPU and before you overwrite the card in the PC 
with a new project. If you use a SIMATIC memory card with unknown content, you should 
format the SIMATIC memory card before the next download.

Subnet addressing for CP 1613 and CP 1623 
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure 
management of communication links, these are processed on the module. The protocol stack 
in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol stacks (i.e. 
CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same partners, is 
recommended to place both stacks of a module in the same subnet.

Editing a device IP address
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP 
address. If necessary, this address range is automatically assigned by the system to a 
programming device. Depending on the subnet mask, this applies also for all network classes.

Migrating projects with the TIA Portal
After the migration of hardware configurations and program blocks from earlier automation 
solutions, first check the functionality of the migrated project before you use it in productive 
operation.

Working with automatically synchronized network drives
Automatic synchronization after a network interruption can result in current (local) project data 
being stored as a "backup" on the network drive through user interactions. This could cause 
outdated project data to be loaded from the network drive when opening the project. For this 
reason, we do not recommend that you store TIA Portal projects on synchronized network 
drives. 

If, however, you do work on synchronized drives, you can continue working locally in the event 
of a network interruption. In this case, you must always ensure that the TIA Portal application 
is closed while data is synchronized. The synchronization itself must be implemented in such 
a way that the current (local) project data replaces the project data on the network drive. 
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Entry of decimal places
With certain Windows language settings, it may occur that the entry of values with a comma 
as decimal place is not recognized (entering "1,23" leads to an error). Instead, use the 
international format ("1.23").

Access protection for memory cards in USB card readers
By improving the security mechanisms for online access and engineering of S7-1500 CPUs, 
the data storage on memory cards has been changed. For this reason, this version of STEP 
7 cannot evaluate the passwords of the configured protection level when reading project data 
from memory cards that is accessed via a USB card reader. The changed behavior affects the 
memory cards for CPUs of the S7-1200/1500 series. Therefore, use physical safeguards to 
protect critical project data on memory cards for these devices.

 

 Note

This restriction is not related to online access to devices or the know-how protection of 
program blocks.

 

Information on the TIA Portal in online support
Overview of the most important technical information and solutions for the TIA Portal in the 
Siemens Industry online support.

Internet link: TIA Portal in Siemens Industry online support (www.siemens.com/industry/
onlinesupport/tiaportal)

All information on service and support in the Siemens Industry online support:

Internet link: Service and support in Siemens Industry online support (http://
support.automation.siemens.com)

Here, you can also subscribe to the newsletter that provides you with latest information relating 
to your products.

Starting the TIA Portal
When you start the TIA Portal, Windows attempts to update the Certificate Revocation List 
(CRL) of "windowsupdate.com".

If no Internet access is available and there are multiple DNS servers, a timeout may occur and 
delay the start of the TIA Portal.

Compatibility with V12 SP1
An empty V12 SP1 project with the name "TIA_Portal_Project_V12.0.1.3.ap12" is installed in 
the installation directory under ..\Portal V13\SampleProjects to allow TIA Portal V13 to be 
opened in compatibility mode V12 SP1. This project must be copied to a local directory with 
full access before it can be used. For more information on this, refer to FAQ ID 835846.
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FAQs on the TIA Portal
FAQs on the TIA Portal are available at FAQs (http://support.automation.siemens.com/WW/
view/en/28919804/133000). 

2.2 STEP 7 Basic

2.2.1 Security information

Upgrades and updates
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. For more information about industrial security, visit

http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx)

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002)

Network settings
The following tables show the network settings of each product you need to analyze the 
network security and to configure external firewalls:

STEP 7 Basic
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

RFC 1006 102 TCP Outbound S7 
communicatio
n

Communication to the S7 controller via 
Ethernet/PROFINET for programming and 
diagnostic purposes.
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STEP 7 Basic
DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and Basic 

Configuration Protocol) is used by 
PROFINET and provides the basic 
functionality for locating and configuring 
PROFINET devices.

SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by 
STEP 7 to read status information from 
PROFINET devices.

* Default port that can be changed by user configuration

 

WinCC ES Basic (without simulation)
Name Port number Transport 

protocol
Direction Function Description

ALM 4410* TCP Inbound/
outbound

License 
service

This service provides the complete 
functionality for software licenses and is 
used by both the Automation License 
Manager as well as all license-related 
software products.

HMI Load 1033 TCP Outbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

* Default port that can be changed by user configuration

 

Simulation RT Basic
Name Port number Transport 

protocol
Direction Function Description

HMI Load 1033 TCP Inbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

Ethernet/
IP
 

44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus 
TCP

502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication to the S7 controller via 
Ethernet/PROFINET

Mitsubishi 
MC

5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for 
connections to Mitsubishi PLCs.
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2.2.2 News

News in the TIA Portal
To keep you up-to-date with the latest news, Siemens Industry Online Support now offers a 
website with the latest news on a variety of topics of the TIA Portal.

All news on STEP 7 Basic are available at a glance at this link:

http://support.automation.siemens.com//WW/view/84047138 (http://
support.automation.siemens.com/WW/view/en/84047138)

2.2.3 Notes on use

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Online operation
The simultaneous online operation of STEP 7 V5.5 or earlier and STEP 7 Basic V13 has not 
been approved.

Simultaneous online connections on an S7-1200 CPU
It is not possible to establish an online connection from multiple TIA Portal instances 
simultaneously to the same S7-1200 CPU.

Configuring and assigning module parameters
You will find an overview of the modules that can be configured and assigned parameters with 
STEP 7 Basic V13 at http://support.automation.siemens.com (http://
support.automation.siemens.com/WW/view/en/28919804/133000).

Removing/inserting the memory card
After removing or inserting a memory card, always perform a memory reset on the CPU in 
order to restore the CPU to a functional condition.

Removing and inserting Ethernet modules
If Ethernet modules are removed and re-inserted during operation, you must boot the PC; 
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all 
devices. While the PC boots, Ethernet modules must be activated.
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Comparing project data
The comparison functions (online/offline, offline/offline) currently do not take hardware into 
consideration.

Loading project data with TIA Portal V12 and V13 (S7-1200) 
If you load the project data of an S7-1200 CPU with the TIA Portal V13, you can no longer use 
TIA Portal V12 to access this data. To do this, first restore the factory settings of the CPU. 
Read the additional information on this in the online help under "How to reset a CPU to factory 
settings".

Using project data of distributed IO-Link master modules from TIA Portal V12 in V13
The following procedure applies if you are using distributed IO-Link master modules in TIA 
Portal V12 that are not GSD devices and were configured with PCT: To continue using your 
project data from TIA Portal V12.0 in TIA Portal V13.0, you have to export them in the PCT 
before you upgrade the project. After the upgrade, you must import the project data once again 
using the PCT.

Compatibility
The device configuration and program of an S7-1200 CPU must always be configured with the 
same STEP 7 version. Usually, the TIA Portal makes sure that no version conflicts occur by 
outputting appropriate notifications during loading to the device.

This automatic verification is not possible with S7-1200 CPUs with firmware version V1.x. In 
this case, users themselves must ensure that no version conflicts occur.

2.2.4 Editing devices and networks

2.2.4.1 General information on devices and networks

Contents
General information on devices and networks.

S7 PCT IO-Link
The S7 Port Configuration Tool is available for free download at the following link.

http://support.automation.siemens.com/WW/view/37936752 (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&groupid=4000002&extranet=standard&viewreg=WW&n
odeid0=33102519&objaction=csopen)
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2.2.4.2 Use of modules on the S7-1200

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Use of modules on the S7-1200
The modules listed below are not supported on the S7-1200.

Family Module Order number
S7-300 FMs SM 338 6ES7 338-4BC01-0AB0

FM 350-1 6ES7 350-1AH03-0AE0
FM 350-2 6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0
FM 351 6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0
FM 352 6ES7 352-1AH02-0AE0
FM 355 S 6ES7 355-1VH10-0AE0
FM 355 C 6ES7 355-0VH10-0AE0
FM 355-2 C 6ES7 355-2CH00-0AE0
FM 355-2 S 6ES7 355-2SH00-0AE0

S7-300 PtP-CP CP 340 6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7 
340-1CH02-0AE0

CP 341 6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7 
341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7 
341-1CH01-0AE0, 6ES7 341-1CH02-0AE0

Network component Diagnostics repeater 6ES7 972-0AB01-0XA0
ET 200S 1 Count 24 V 6ES7 138-4DA04-0AB0

1 Count 5 V 6ES7 138-4DE02-0AB0
1 Step 5 V 6ES7 138-4DC00-0AB0, 6ES7 138-4DC01-0AB0
2 pulses 6ES7 138-4DD00-0AB0, 6ES7 138-4DD01-0AB0
1 SI 6ES7 138-4DF01-0AB0
1 SI Modbus 6ES7 138-4DF11-0AB0
1 SSI 6ES7 138-4DB02-0AB0, 6ES7 138-4DB03-0AB0
1 Pos Universal 6ES7 138-4DL00-0AB0
SIWAREX 7MH4910-0AA01, 7MH4912-0AA01, 7MH4920-0AA01

ET 200M SIWAREX 7MH4 900-2AA01, 7MH4 900-3AA01, 7MH4 950-1AA01, 
7MH4 950-2AA01

Loading S7-1200 module comments to the PG/PC
In central configurations with S7-1200, comments of modules, submodules and signal boards 
are not loaded. With CPs/CMs, only the comments of the IE interface or DP interface are 
loaded. In distributed configurations with ET 200SP or ET 200MP, only the comment of the 
channels is loaded from the I/O modules.
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2.2.4.3 Replacing ET 200S positioning modules

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Replacing ET 200S positioning modules
This information relates to the positioning module "1 Step 5V" (6ES7 138-4DC00-0AB0) from 
a project which was created with TIA Portal V11.0. When replacing these modules from the 
TIA Portal V11.0 with a new version of these modules, the parameter settings are reset to the 
default values.

This is the case with one of the following procedures:

● Replace the positioning module 6ES7 138-4DC00-0AB0 with its successor module 6ES7 
138-4DC01-0AB0 by means of a device exchange.

● Updating the module version using the appropriate button in the device properties in the 
Inspector window.

2.2.4.4 CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX

Contents
Information that could not be included in the online help and important information about 
product characteristics.

CP 343-2 on SIMATIC S7 Embedded Controller EC31-RTX
The module AS-Interface CP 343-2 (order no.: 6GK7 343-2AH01) can be inserted in an 
expansion rack of the SIMATIC S7 Embedded Controller EC31-RTX (order no.: 6ES7 
677-1DDxx-0BB0), but the CP 343-2 cannot be operated with the EC31-RTX.

2.2.4.5 Notes on online and diagnostics

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Hardware detection followed by online connection
When the "Online > Hardware detection" command is performed for an unspecified CPU, the 
online configuration is not loaded from the CPU. If you do not load the configuration resulting 
from the hardware detection to the CPU, the device and network views will always show a 
difference between the offline and online configurations. It will appear that there are different 
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configurations in the online and diagnostic views, although the MLFBs are identical in the actual 
CPU and the offline CPU.

2.2.4.6 Network components

Network components

CP 1242-7

Copying the CP 1242-7 into another project
If you copy a CP 1242-7 from one project into another project, the following parameters in the 
parameter group "CP identification" are changed on the target station:

● Project number of the CP

● Station number of the CP

Download to device
Only use the "Download to device" function with the CP 1242‑7 via a TeleService connection 
as follows:

1. Select the CP in STEP 7.

2. Select the "Online" > "Download to device" menu.

3. In the "Extended download" dialog that appears, select the TeleService interface.

4. Download the project data from the "Extended download" dialog.

Upload from device
The function "Upload from device" is not supported by the CP 1242‑7.

PC CPs

PC CPs for VMware vSphere Hypervisor ESXi
The following communications processors have been released for operation with VMware 
vSphere 5.1 Hypervisor ESXi:

● CP 5622

● CP 5711

● VMware E1000 network adapter

The following communications processors have not been released for operation with VMware 
vSphere 5.1 Hypervisor ESXi:
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● CP 5611 

● CP 5612

● CP 5621

● CP 5512

Other communications processors such as the CP 1613, CP 1623, CP 5613, CP 5614, CP 
5623, CP 5624 are released following installation of the SIMATIC NET PC software. You will 
find information on this in the readme file of the SIMATIC NET PC software.

Media converters
When you migrate a project, you need to reconfigure the media converters.

2.2.5 Programming a PLC

2.2.5.1 General notes on PLC programming

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Information about network security
For communications access between the TIA Portal and CPU or between HMI (except for HMI 
access using "GET/PUT communication") and CPU, there are integrated security functions. 
The provide greater protection from manipulation and higher access protection. To protect 
against unauthorized network access to a CPU with standardized communications access 
such as "GET/PUT", "TSEND/TRCV", "Modbus", "FETCH/WRITE", you should also take 
suitable additional measures (e.g. cell protection concept).

Renumbering PLC data types
For better performance, the CPUs of the S7-1200 module process PLC data types with 
numbers. The user is not aware of these numbers, because the system processes the numbers 
independently. This means number conflicts are automatically resolved. When using know-
how protected blocks that use PLC data types, it may be useful to set up your own numbering 
system (recommended > 5000) because the automatic resolution of numbering conflicts may 
result in a password prompt (compilation required).

To renumber the default number of a PLC data type, follow these steps:

1. Open the project library in the "Libraries" task card.

2. Drag the compilable PLC data type to the "Types" folder.
The "Add type" dialog opens.

3. Enter the properties of the new type.
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4. Click "OK" to confirm.

5. Right-click the PLC data type.
The shortcut menu opens.

6. Select "Edit type" in the shortcut menu.

7. Open the "PLC programming" task card once again.
The extension "in testing" is now added to the name of the PLC data type.

8. Right-click the PLC data type.
The shortcut menu opens.

9. Select "Properties" in the shortcut menu.

10.Change the number of the PLC data type in the "General" section.

11.Select "Release version" from the shortcut menu of the library.

The PLC data type now has the new number and can be used. The assigned number is retained 
even if the type of the PLC data type is revoked.

Generating external sources from blocks
When generating external sources from blocks, the changes made directly in the block 
interface to the default values of PLC data types are not exported to the sources. This means 
these values are not available when the sources are imported once again. The default values 
are applied instead. To prevent this loss of data for the modified default values, the changes 
must be made directly in the PLC data type and not in the block interface. In this case, the 
changes are also exported when generating external sources.

Indirect indexing of ARRAY components of data type bit string in SCL
In TIA Portal V13, you can address the components of an ARRAY for a CPU of the S7-1200 
series in SCL with a tag of the data type BYTE, WORD or DWORD as index in addition to a 
tag of the integer data type if the IEC check is not set.

Explicit data type conversion in SCL
As of TIA Portal V13, the string is displayed with a leading sign during explicit data type 
conversion of SINT/INT/DINT/LINT_TO_STRING or WSTRING in SCL and transferred aligned 
to the left.

The result is an incompatibility with TIA Portal V12 SP1, in which the string was transferred 
aligned to the right during conversion.

Start value behavior during "Upload from device"
The start values that you have changed with the instruction "WRIT_DBL: Write to data block 
in the load memory" will be lost during execution of the action "Upload from device".
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Loading inconsistent programs to a device
In TIA Portal, it is not possible to download inconsistent programs to a device without a 
consistency check. During the loading process, all blocks of the program are implicitly checked 
and are compiled again in the event of inconsistencies. If, however, there are programs on 
your CPU which were loaded with earlier versions of STEP 7, these programs could 
demonstrate inconsistencies. 

In this case, note the following:

If you load an inconsistent program from a device, you will not be able to load the program 
unchanged to the device afterwards, because a consistency check always takes place during 
the loading process and existing inconsistencies are corrected.

Process image of PTO/PWM outputs
Do not use PTO/PWM outputs in the process image (for example, for access in the user 
program, for online functions or in HMI). The update rate of the process image is much slower 
than the rate of the signal changes. The display in the process image therefore does not reflect 
the signal flow.

Monitoring blocks in LAD and FBD
If the start of the current path is outside the visible range, it may not be possible to determine 
the input value. In this case, the current path is shown grayed out.

Avoid using PLC data types generated by the system in libraries
Some instructions generate their own PLC data types during instancing which are saved in 
the "PLC data types" project folder. However, you should not use these system-generated 
PLC data types in any library, because they may be recreated by the system at any time and 
may result in an unfavorable system behavior. 

Using global data blocks in assignments
It is not possible to assign the contents of a global data block to a structurally identical data 
block, e.g. using a move box.

2.2.5.2 Instructions

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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Notes on the information system
The following function is already described in the information system, but is not available in 
TIA Portal V13:

● "ASI_CTRL" instruction for CPUs of the S7-1200 module

Instruction "TRCV_C: Receive data via Ethernet" 
Contrary to the information provided in the online help, the communication connection is 
terminated immediately, and not after sending data, when the CONT parameter is set to the 
value "0".

Instruction "T_CONFIG: Configure interface" 
The CPU is restarted after you have executed the "Configure interface" instruction in order to 
change an IP parameter. The CPU goes to STOP mode, a warm restart is carried out and the 
CPU starts up again (RUN mode). Make sure that the control process is in a secure operating 
mode after the CPU has been restarted following execution of the "Configure interface" 
instruction. Uncontrolled operation can result in serious material damage or personal injury 
due to malfunctions or programming errors, for example. Non-retentive data could be lost.

Parameters ERROR and STATUS

ERROR STATUS
(DW#16#..)

ERR_LOC Explanation

0 00000000 0 After the instruction has been 
executed successfully, the 
STATUS parameter 
"00000000" does not return 
any value.

Instruction "GET_DIAG: Read diagnostics information"
MODE 3 at the MODE parameter is not supported by the S7-1200 CPU.

Using instructions with parameters of type VARIANT in code blocks with different access types 
(S7-1200)

Code blocks (FBs/FCs) and data blocks (DBs) can be created with different access types 
("standard" and "optimized"). In code blocks, you can call any instructions. Certain instructions 
(for example, "WRIT_DBL" and "READ_DBL") use pointers of type VARIANT at input and 
output parameters to address data blocks.

Ensure that you do not use these instructions in programs in which code blocks of different 
access types are called reciprocally. This could cause the following to occur:
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● A structure from a standard data block is directly or indirectly passed to an optimized code 
block, which forwards this structure directly or indirectly to one of the blocks mentioned 
above.

● The reverse scenario, whereby a structure from an optimized code block is directly or 
indirectly passed to a standard data block, which forwards this structure directly or indirectly 
to one of the blocks mentioned above.

2.2.5.3 Testing the user program

Testing with the watch table

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Multiple access to the same CPU
Access to a CPU from a PG/PC is permitted only when a TIA Portal is open. Multiple access 
to the same CPU is not permitted and can lead to errors.

Loading data blocks during an active control job
 

 Note

Loading changed data blocks during an active control job can result in unforeseen operating 
states. The control job continues to control the specified address, although the address 
allocation may have changed in the data block. Complete active control jobs before loading 
data blocks.

 

Testing programs converted from STEP 7 V10.5/V11.0
To monitor and test a program converted from STEP 7 V10.5, you have to first compile and 
load with STEP 7 V13.0.

Testing with the force table

Contents
Information that could not be included in the online help and important information about 
product characteristics.
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Example
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to force 
the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P.

2.2.6 Inter Project Engineering (IPE)

2.2.6.1 Notes on IPE

Contents
Information that could not be included in the online help and important information about 
product characteristics.

 

Comment box of the device proxy
Contrary to the description in the information system for the TIA Portal V13, with the "Inter 
Project Engineering" functionality, the comment field for a device proxy cannot be edited.

Restricted functionality
In the TIA-Portal V13, the "S7 GRAPH overview" and "PLC code display" functionality cannot 
be used in conjunction with the IPE device proxy. 

2.2.7 Technological functions

2.2.7.1 Notes on technological functions
There are no notes about the technology functions.

2.3 WinCC Professional

2.3.1 Security information

Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
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important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Any third-party products that may be in use must 
also be taken into account. For more information about industrial security, visit

http://www.siemens.com/industrialsecurity (http://www.industry.siemens.com/topics/global/
en/industrial-security/Pages/Default.aspx) 

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. For more information, visit

http://support.automation.siemens.com (http://support.automation.siemens.com)

Passwords
Various passwords are set by default in WinCC. For security reasons, you should change 
these passwords.

● On HMI devices with version V11 or V12, the password "100" is preset for the Sm@rtServer 
and for the integrated Web server. A default password is not preset for HMI devices with 
version V13.

● For the user "Administrator", the default password is "administrator".

Integrated Web server
It is always possible on a PC to access HTML pages in Runtime, even though the option"HTML 
pages" is disabled. Setup always installs the standard pages of the Web Server on the PC. 
Assign an administrator password to prevent unauthorized access to the pages.

Communication via Ethernet
In Ethernet-based communication, end users themselves are responsible for the security of 
their data network. The proper functioning of the device cannot be guaranteed in all 
circumstances; targeted attacks, for example, can lead to overload of the device.

Ending Runtime automatically
If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped on the HMI device. The HMI device then 
switches autonomously to "Transfer" mode. Transfer mode may cause undesired reactions in 
the system.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode. To block access to the transfer settings 
and thus avoid unauthorized changes, assign a password in the Control Panel.
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Network settings
The following tables show the network settings of each product which you need in order to 
analyze the network security and for the configuration of external firewalls:

WinCC Professional (without simulation)
Name Port 

number
Transport 
protocol

Direction Function Description

ALM 4410* TCP Inbound, 
Outbound

License service This service provides the complete 
functionality for software licenses and is used 
by both the Automation License Manager as 
well as all license-related software products.

HMI Load 1033 TCP Outbound HMI Load (RT 
Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

HMI Load 2308 TCP Outbound HMI Load 
(RT Advanced)

This service is used to transmit images and 
configuration data to panels.

RPC ** UDP Inbound, 
Outbound

Client / server & 
ES 
communication 
(CCAgent)

This service is used by WinCC Professional 
and WinCC Runtime Professional.

* Default port that can be changed by user configuration
** Port is assigned automatically

 

WinCC Simulation for Basic Panels
Name Port 

number
Transport 
protocol

Direction Function Description

HMI Load 1033 TCP Inbound HMI Load 
(RT Basic)

This service is used to transmit images and 
configuration data to Basic Panels.

EtherNet/IP 44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

2222 UDP Inbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Modbus TCP 502 TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

Mitsubishi MC 5002 TCP Outbound Mitsubishi MC 
channel

The Mitsubishi protocol is used for connections 
to Mitsubishi PLCs.

 

WinCC Simulation for Panels and Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

DCP --- Ethernet Outbound PROFINET The DCP protocol (Discovery and basic 
Configuration Protocol) is used by PROFINET 
and provides the basic functionality for locating 
and configuring PROFINET devices.
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WinCC Simulation for Panels and Runtime Advanced
LLDP --- Ethernet Inbound, 

Outbound
PROFINET The LLDP protocol (Link Layer Discover 

Protocol) is used by PROFINET for topology 
detection.

SMTP 25 TCP Outbound SMTP 
Communication

This service is used by WinCC Runtime 
Advanced to send e-mails.

HTTP 80* TCP Inbound Sm@rtServer The Web server is only available when 
Sm@rtService is activated. The used port may 
differ depending on automatically selected 
settings.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET

NTP 123 UDP Outbound Time 
synchronization

The NTP protocol (Network Time Protocol) is 
used for time synchronization in IP-based 
networks.

SNMP 161 UDP Outbound PROFINET The SNMP client functionality is used by STEP 
7 to read status information from PROFINET 
devices.

HMI Load 2308 TCP Outbound HMI Load
(RT Advanced)

This service is used to transmit images and 
configuration data to panels.

HTTPS 443* TCP Inbound Sm@rtServer The Web server with HTTPS protocol is only 
available when Sm@rtService is activated. 
The used port may differ depending on 
automatically selected settings.

VNC server 5900* TCP Inbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

5800* TCP Inbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

VNC client 5500 TCP Outbound Sm@rtServer This service is only available when 
Sm@rtService is activated.

* Default port that can be changed by user configuration

 

WinCC Simulation for Runtime Professional
Name Port 

number
Transport 
protocol

Direction Function Description

RPC ** UDP Inbound, 
Outbound

Client / server & 
ES 
communication 
(CCAgent)

This service is used by WinCC Professional 
and WinCC RT Professional.

RPC ** UDP Inbound, 
Outbound

Client / server 
communication 
(CCEServer / 
CCEClient)

This service is used by WinCC Runtime 
Professional.

HTTP 80 TCP Inbound, 
Outbound

Client / server 
communication 
(CCEServer / 
CCEClient)

This service is used by WinCC Runtime 
Professional.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET
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WinCC Simulation for Runtime Professional
OPC UA 4840 TCP Inbound OPC UA server This service is required for primary 

communication via OPC UA. It is activated and 
configured during installation.

OPC UA 
discovery

52601 TCP Inbound OPC UA server The OPC UA discovery service provides 
information about installed OPC servers on the 
same system. This one will be active if installed 
and configured via the OPC UA server.

DCOM 135 TCP Inbound OPC server This service is part of the Windows operating 
system. DCOM functionality is part of Microsoft 
Windows operating system. Because 
communication via OPC (DA) is based on 
DCOM, this service is required to initialize 
OPC (DA) connections.

DCOM ** TCP Inbound OPC server The communication via OPC (DA) is based on 
DCOM and uses unspecified ports assigned 
by the system. This should be taken into 
consideration when using OPC (DA) and 
creating rules for the firewall.

HTTP 80 TCP Inbound OPC server This service is required for primary 
communication via OPC XML. It is activated 
and configured during installation.

NetBIOS 137 UDP Inbound OPC server This service is part of the Windows operating 
system. Access to this service is required by 
OPC-Scout, for example, for browsing.

NetBIOS 138 UDP Inbound OPC server This service is part of the Windows operating 
system. Access to this service is required by 
OPC-Scout, for example, for browsing.

SNMP 161 UDP Outbound SNMP OPC 
server

This service is used by the SNMP OPC server 
to change or query data on network drives, for 
example. 

SNMP Traps 162 UDP Inbound SNMP OPC 
server

This service is used by the SNMP OPC server 
to query events from network drives, for 
example.

** Port is assigned automatically

 

PROFINET protocols for Panels and Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

DCP --- Ethernet Outbound Lifelist, 
PROFINET 
Discovery and 
configuration

The DCP protocol (Discovery and basic 
Configuration Protocol) is used by PROFINET 
and provides the basic functionality for locating 
and configuring PROFINET devices.

LLDP --- Ethernet Inbound, 
Outbound

PROFINET Link 
Layer Discovery 
protocol

The LLDP protocol (Link Layer Discover 
Protocol) is used by PROFINET for topology 
detection.

MRP --- Ethernet Outbound PROFINET 
medium 
redundancy

The MRP protocol (Medium redundancy 
protocol) enables control of redundant 
transmission paths using a ring topology.
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PROFINET protocols for Panels and Runtime Advanced
PROFINET IO 
Data

--- Ethernet Inbound, 
Outbound

PROFINET 
Cyclic IO data 
transfer

Cyclic data exchange is used by panels for 
direct keys and LEDs.

NARE --- Ethernet Inbound, 
Outbound

Name Address 
Resolution

This protocol is used to resolve network names 
and assign IP addresses.

PROFINET 
Context 
Manager

34964 UDP Inbound, 
Outbound

PROFINET 
connection less 
RPC

The PROFINET Context Manager provides an 
endpoint mapper in order to establish an 
application relation (PROFINET AR).

Communication connections for Panels and WinCC Runtime Advanced
Name Port 

number
Transport 
protocol

Direction Function Description

Telnet 23 TCP Inbound Telnet This service can be used for maintenance.
SMTP 25 TCP Outbound SendEMail This service is used by Windows CE / PC 

Runtime to send e-mails.
HTTP 80* TCP Inbound Hypertext 

Transfer 
Protocol

The HTTP protocol is used for communication 
with the internal Web server.

RFC 1006 102 TCP Outbound S7 channel Communication with the S7 controller via 
Ethernet/PROFINET.

NTP 123 UDP Outbound Time 
synchronization

The NTP protocol (Network Time Protocol) is 
used for time synchronization in IP-based 
networks.

DCOM*** 135 TCP Inbound OPC server This service is a component of the Microsoft 
Windows operating system. Communication 
via OPC (DA) is based on DCOM. Therefore, 
this service is required to initialize OPC (DA) 
connections.

DCOM*** ** TCP Inbound OPC server The communication via OPC (DA) is based on 
DCOM and uses unspecified ports assigned by 
the system. This should be taken into 
consideration when using OPC (DA) and 
creating rules for the firewall.

NetBIOS over 
TCP/IP

137 UDP Outbound With the use of 
Remote File 
Share

Register / log on to a remote server.

NetBIOS over 
TCP/IP

138 UDP Outbound With the use of 
Remote File 
Share

Register / log on to a remote server.

SNMP 161 UDP Outbound Simple Network 
Management 
Protocol

The SNMP client functionality is used by STEP 
7 to read status information from PROFINET 
devices.

HTTPS 443* TCP Inbound Secure 
Hypertext 
Transfer 
Protocol

The HTTP protocol is used for communication 
with the CPU-internal Web server via Secure 
Socket Layer (SSL).

Modbus TCP 502* TCP Outbound Modbus TCP 
channel

The Modbus TCP protocol is used for 
connections to Schneider PLCs.
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Communication connections for Panels and WinCC Runtime Advanced
Mitsubishi MC 1025* TCP Outbound Mitsubishi MC 

channel
The Mitsubishi protocol is used for connections 
to Mitsubishi PLCs.

Printing 1032 TCP Outbound Printing Printing on the control panel (via Ethernet).
HMI Load 2308 TCP Outbound Transfer This service is used to transmit images and 

configuration data to panels. On Comfort 
Panels, this service is replaced by 
DeviceManager and SCS in V13 and higher. 
This service is used to transmit configuration 
data to WinCC Runtime Advanced.

HMI Load 50523 TCP Outbound Transfer This port is used if port 2308 is not available.
This service is used to transmit images and 
configuration data to panels. On Comfort 
Panels, this service is replaced by 
DeviceManager and SCS in V13 and higher.
This service is used to transmit configuration 
data to WinCC Runtime Advanced. 

ALM 4410* TCP Inbound, 
Outbound

Application 
License 
Manager

This service of RT Advanced makes available 
the complete functionalities for software 
licenses and is used by the Automation 
License Manager.

OPC UA 4870* TCP Inbound OPC UA server This service is required for communication via 
OPC UA.

HMI Load 5001 TCP Outbound Device Manager This service is used to transmit images and 
Runtime to panels.

HMI Load 5002 TCP Outbound SCS (System 
Configuration 
Server)

This service is used to transmit configuration 
data to panels.

VNC client 5500 TCP Outbound Sm@rtServer VNC client connection
VNC server 5800* TCP Inbound Sm@rtServer VNC server connection HTTP

5900* TCP Inbound Sm@rtServer VNC server connection
SIMATIC Logon 16389* TCP Outbound UMAC (User 

Management to 
the Access 
Control)

Register / log on to a remote server.

Allen Bradley 
Ethernet IP

44818 TCP Outbound Ethernet/IP 
channel

The Ethernet/IP protocol is used for 
connections to Allen Bradley PLCs.

Reserved 49152 ... 
65535

TCP/UDP Outbound  Dynamic port range is used, for example, to 
connect to the remote file sharing. 

*   Default port that can be changed by user configuration
**  Port is assigned automatically.
*** Supported by WinCC Runtime Advanced only.
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2.3.2 News

News about the TIA Portal
You can learn about the latest news about various topic areas of the TIA Portal in Siemens 
Industry Online Support.

All news concerning WinCC can be found here: News (http://support.automation.siemens.com/
WW/view/en/88360672)

2.3.3 Notes on use

Contents
Information that could no longer be included in the online help and important information about 
product features.

Working with standard user rights 
If you are working with standard user rights in Windows 7, "User Account Control (UAC)" must 
not be disabled.

The "User Account Control" is enabled in Windows 7 by default.

For more information on the "User Account Control", refer to the online help for Windows 7.

On-screen keyboard
Once you have opened the TIA Portal, you can no longer call the on-screen keyboard.

To call the on-screen keyboard in Windows, use the following command: “Start > All Programs 
> Accessories > Ease of Access > On-screen keyboard”.

Installation on a computer with regional setting "Turkish"
If the computer is operated with the regional setting "Turkish" at the time of the installation, 
WinCC Runtime Professional cannot be started.

Copying HMI devices with HMI connections
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new HMI 
device is not automatically connected to an existing PLC with the same name. This applies to 
copying within a project as well as copying across projects.     

To access the PLC tag via HMI tag in the new HMI device, you have to complete the 
configuration of the HMI connection immediately after copying. Proceed as follows:

1. Open the "Devices & Networks" editor.

2. Connect the new HMI device to the desired network.
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3. Open the connection table.

4. Select the HMI connection of the new HMI device.

5. Select the desired PLC under "Partner".

If you compile the new HMI device or connect additional PLC tags in between copying the HMI 
device and completing the connection, there may be some instances in which an additional 
HMI connection to the same PLC is created. This is especially true if you connect HMI tags 
with DB array elements.

Device replacement
After an HMI device has been replaced, you should check the appearance of the configured 
screens. Changing the size of the display may result in changes to the position and appearance 
of screen objects, e.g. recipe view and alarm view.

Device replacement - character sets
If you have configured different character sets on screen objects for multilingual texts in the 
various project languages, you should check the screens after an HMI device replacement 
from a panel to a PC-based Runtime. The configured character sets may be changed by the 
device replacement.

Device replacement - communication
If an HMI device is replaced, error messages of the type "... are not supported in the new 
configuration. and will therefore be removed" may be generated. These alarms refer to 
configured connections of the device and are triggered, for example, if the HMI devices have 
a different number of interfaces. These connections are marked red after a device replacement. 
If you would like to continue to use these connections, you have change the configuration of 
the connection. Proceed as follows:   

1. Open the "Devices and Networks" editor.

2. Click "Network" in the toolbar of the network view.

3. Network the interface of the HMI device with the interface of the CPU.

4. Click in the table area of the network view on the "Connections" table.

5. Select the connection marked red.

6. Enter the new interface under "Properties > General > Interface" in the Inspector window.

Specifying the time of modification in the overview window
The times of modification displayed in the overview window only refer to changes to the object 
itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause the time 
of the last change to the screen to change in the overview window.   
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Reports with Asian character sets on Windows CE devices
If Asian characters sets are displayed in an illegible manner in a report on a Windows CE 
device, you must change the character sets for the objects in the report. it is sufficient to change 
to a different character set and then reset the original character set.

Texts in the simulation
If a Runtime language which does not correspond to an installed product language is used in 
the simulation, system texts are shown in an installed product language. Depending on the 
operating system and the installed product languages, this will be either English or Chinese.

If you wish to see all texts in Japanese, Korean or Taiwanese in the relevant language in the 
simulation, you should first install WinCC without simulation. Then install WinCC Runtime 
Professional with the required languages.

Online delta load with user-defined cycles
If you have configured new custom cycles in the "Cycles" editor, "Load > Software (compile 
all)" command when loading the project. Delta loading is not possible in online mode.     

License transfer via S7USB
You always need to run WinCC to transfer a license to a panel via S7USB.

Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect 
HMI device" menu command is not available in Automation License Manager, open command 
line input and run the following command with administrator rights:

"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Installation sequence for Startdrive
When you install Startdrive on a PC, adhere to the following installation sequence:

● Install STEP7 V12.0.

● Install Startdrive.

Compatibility with V12
An empty V12.0.1.3 project with the name "TIA_Portal_Project_V12.0.1.3.ap12" is installed in 
the installation directory under ..\Portal V13\SampleProjects to allow TIA Portal V13 to be 
opened in compatibility mode V12. This project must be copied to a local directory with full 
access before it can be used. For more information on this, refer to FAQ ID 66027369.
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Operation on a network server
Operation of WinCC Professional on a network server (e.g., domain controller, file and name 
utility server, router, software firewall, media server, exchange server) is not permissible.

File browser on a Windows 8 PC with touch screen
You can only operate the file browser dialog with a mouse, keyboard or on-screen keyboard 
(without using the touch function) on a Windows 8 PC with touch screen. We recommend using 
the file browser dialog of the Windows operating system with the help of a script on a touch 
screen PC with Windows 8.

2.3.4 Migration

Contents
Information that could no longer be included in the online help and important information about 
product features.

Project languages in WinCC
WinCC V13 does not support all project languages that were available in WinCC flexible, such 
as Arabic. If you receive an empty project as the result of your migration, you may want to 
check the set editing language. Do not set the project languages that are not supported as 
editing language in the source project. Proceed as follows:

1. Open the project with WinCC flexible.

2. Change the editing language to English, for example.

3. Save the project.

4. Restart the migration.

Migrating an integrated project with ProTool objects
The "PROTOOL option package(s) missing in STEP 7" error message output during migration 
of a WinCC flexible project that is integrated in STEP 7 indicates that WinCC flexible 2008 
SP3 is installed on your system. Moreover, the project still contains objects that were 
configured using ProTool. Do not open the project with WinCC flexible 2008 SP3! Proceed as 
follows to migrate the project:

1. Copy the project to a computer on which WinCC flexible 2008 SP2 and STEP 7 are installed.

2. Open the project in the SIMATIC Manager.

3. Remove all ProTool objects from the project.

4. Execute the "Save as" command in the "File" menu.

5. Enable the option "With reorganization" in the "Save project as" dialog.

6. Click OK.
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7. Copy the project back to the original computer.

8. Restart the migration.

Migrating a WinCC V7 project: Border line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1" 
and "Draw insider border = yes".

You then migrate the WinCC V7 project to WinCC V13.  To have the rectangle displayed 
correctly, follow these steps. 

1. Open the Inspector window of the rectangle.

2. Open the property list.

3. Disable "Widen border line inwards".

Progress bar
As long as the progress bar still shows a value of 100%, the software is still busy running 
remaining tasks such as the closing of references. The software will not respond to user input 
while this status is given.

Open a project created with WinCC V11
When you open a V11 project with a WinCC V13 version, it is no longer be possible to open 
this project with an older version afterwards.

Managing third-party ActiveX controls
The migration also supports third-party ActiveX controls. However, the controls must be 
registered in the operating system. If an ActiveX control is not registered, migration is canceled.

If you save a project with the migration tool and perform the migration yourself on another PC, 
the controls must also be registered on this PC.

Migrating integrated projects with alarm views 
An alarm view is enabled with all alarm classes in an integrated project. The alarm classes are 
disabled during migration of the project.
Once the migration of the project is completed, check the settings in the alarm view. 
Enable the require alarm classes in the Inspector window of the alarm view if needed under 
"Properties > General".

Migrating more extensive projects from WinCC V7
We recommend the use of a 64-bit operating system for the migration of more extensive 
projects from WinCC V7.
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Migrating projects from WinCC V7
In TIA Portal V13, you can continue to use projects from WinCC V7.2 after migration. Projects 
from earlier WinCC versions cannot be migrated directly to WinCC TIA Portal version V13. If 
you wish to continue using such projects in TIA Portal V13, you must first migrate them to the 
WinCC V7.2 Classic page. To do so, use WinCC V7.2 with the latest update.

Migration log
As of TIA Portal V13.0 alarms are sorted into a tree structure in the migration log. This means 
all alarms that are part of a specific subsystem are stored in one folder. The result is an increase 
in the number of folders in the tree structure. Press the shortcut <NUM+ X> to expand the 
currently selected folder and all subfolders in one single step.

 

Restrictions for user-specific project data
1. Folders and files you have created in the WinCC V7.2 project directory are not copied to 

the new project directory during the migration. You must adapt all scripts that access such 
directories and files after the migration.

2. C standard functions of WinCC V7 are not migrated. If you have made changes to the C 
standard functions in the WinCC V7 project, you must apply these changes manually to 
the TIA Portal after the migration.

Migration of texts in Spanish (international sorting) and Spanish (traditional sorting)
If the WinCC V7 project includes texts in Spanish (traditional sorting), these texts are migrated 
as Spanish (Spain) in WinCC V13. 

If the WinCC V7 project includes texts in Spanish (international sorting), these texts are 
migrated as Spanish (Spain) in WinCC V13.

If the WinCC V7 project includes texts in Spanish (international sorting) as well as Spanish 
(traditional sorting), only the texts from Spanish (traditional sorting) are migrated as Spanish 
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(Spain) in WinCC V13. The texts from Spanish (international sorting) are not taken into 
consideration.

See also
Object support in the migration (WinCC flexible) (Page 177)

Object support during migration

2.3.5 Engineering System

2.3.5.1 Screens and Screen Objects

Contents
Information that could no longer be included in the online help and important information about 
product features.

Display objects after HMI device replacement
If you upgrade a device to the new HMI device versions, you should check the screens 
contained in the project. Because of the new appearance and improved operability, texts of 
symbolic I/O fields may not be completely legible and may be concealed by operator controls. 

Copying display objects between two projects or two devices
In Project_1 configure an alarm window in the Global Screen, for example. You copy the alarm 
window and paste it in the Global Screen in Project_2.             

The enabled alarm classes are partly not enabled in the alarm window after pasting.

This behavior applies to the following display objects:

● Alarm window

● Alarm indicator

● Alarm view

Display of the cross-references in the Inspector window
The Inspector window displays objects used by a screen object in the "About > Cross-
reference" tab.

A screen is open and an object selected. You are using an HMI tag at the object as process 
tag.

The object and the linked HMI tag are displayed in the cross-references. All locations of use 
of the object and the HMI tags are listed.
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If the HMI tag is interconnected with a PLC tag or a DB tag, the locations of use of the 
interconnected PLC tag or DB tag are displayed.     

Event names in case of alarms in the "Info" tab of the Inspector window
In some alarms of the Inspector window the event names in the "Info" tab will deviate from the 
names in the "Properties" tab.       

Name in the "Properties" tab of the Inspector 
window

Name in the "Info" tab of the Inspector window

Cleared ClearScreen
Loaded GenerateScreen
Enable Activate
Change Change
When a dialog is opened ONMODALBEGIN
When a dialog is closed ONMODALEND
User change PASSWORD
Screen change SCREEN
Disable Deactivate
Press Press
Outgoing Going
Incoming Coming
Limit "high limit error" violated AboveUpperLimit
Limit "low limit error" violated BelowLowerLimit
Click Click
Loop-in alarm LoopInAlarm
Release Release
Alarm buffer overflow OVERFLOW
Acknowledge Acknowledgement
Runtime stop Shutdown
Press key KeyDown
Release key KeyUp
Toggle ON SwitchOn
Toggle OFF SwitchOff
Value change Change value

Faceplates
Faceplates cannot be rotated or mirrored.

Tab sequence in screens with faceplates
If you have configured a tab sequence in screens with faceplates in WinCC V12 or WinCC 
V12 SP1, you should check the tab sequence of these screens in WinCC V13. The tab 
sequence may have been changed in both the screen and the faceplate.
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Tag prefix of a screen window in WinCC Runtime Professional
The objects of the "Controls" palette do not support the tag prefix that can be configured for a 
screen window.

I/O field with "decimal" display format and format pattern without "s" prefix
You have linked a process tag to an I/O field. The I/O field is assigned the "decimal" display 
format.     

You may select a signed or an unsigned display format.

A "Format pattern" setting without "s", e.g., "999" has the following effects:

1. You cannot set negative values using the I/O field in Runtime.

2. If the tag assumes a negative value, the I/O field generates a two's complement and a 
corrupted positive value is output.

Trend view on Basic Panels
The trend view buttons are not displayed on Basic Panels. You can operate the trend view 
using the function keys of the HMI device that are assigned corresponding system functions.

Grouping of screen objects
When you group screen objects in WinCC, performance problems can arise in WinCC in the 
case of large nesting depths.

ActiveX and .NET controls
ActiveX and .NET controls are always positioned in the foreground in runtime. 

The configuration of ActiveX and .NET controls on levels is not supported.

Use of bitmaps as icons
In Windows 8 and Windows 8.1, the use of bitmaps with a size of 48x48 pixels and a color 
depth of 32 bits as icons is not supported. 

Border line of rectangles
In a WinCC V7 project, you have configured a rectangle with the settings "Line weight = 1" 
and "Draw insider border = yes".

You then migrate the WinCC V7 project to WinCC V12.  To have the rectangle displayed 
correctly, follow these steps. 

1. Open the Inspector window of the rectangle.

2. Open the property list.

3. Disable "Widen border line inwards".
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Border line of “Graphic I/O field" object
In WinCC V13, the dynamization of the border line of the "Graphic I/O field" object in "Two 
states" mode has no effect during runtime.

Dynamization of instances of a faceplate type in a group
You are using the instance of a faceplate type in an object group. The properties of the instance 
are also displayed as properties of the group. Any dynamization with tags, scripts or animations 
of the group is not displayed in Runtime.

Preview in screen window
You use your own designs with shadows for screen objects. The screen objects can be 
displayed in a screen window.
The shadows of the screen objects are not displayed in the preview of the screen window. The 
response occurs only in the engineering system. It is displayed correctly in Runtime.

Assigning graphics to a softkey
A graphic can only be assigned to a softkey if the bottom edge of the permanent window does 
not conceal the area of the softkey graphic.

Renaming a PLC in Runtime
If a PLC is connected to the PLC code display in WinCC Professional and Runtime is running, 
changing the name of the PLC during runtime will trigger a error. Do not change the PLC name, 
the IP address, or other properties of the HMI connection during runtime.

Panels and RT Advanced with device version V13: many visually different screen objects 
The use of screen objects with very many visually different properties (e.g., very many different 
styles) can reduce the performance of the user interface in Runtime and can increase the 
amount of available memory space used. Avoid using, for example, very many different corner 
radii: 0 pixel, 1 pixel, 2 pixels, 3 pixels, etc. 

The use of many differently sized “Gauge” objects can have the same effect. Avoid “Gauge” 
of height 48 pixels, 49 pixels, 51 pixels, etc. Instead, use sizes such as 50 pixels, 70 pixels, 
100 pixels.

Dynamization of grouped objects
For groupings with multiple nestings (group in group, faceplate in group, group in faceplate, 
etc.), only the events of the outermost group and the innermost objects can be used for 
dynamization with system functions. System functions that are configured at events of the 
lower-level group or lower-level faceplate are not executed.
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Number of characters in text fields, lists and alarm texts
The number of available characters in the text of a screen object is dynamic and depends on 
the HMI device and the memory format. Control instructions and formatting are taken into 
consideration when entering text data and the maximum number of characters is reduced 
accordingly.

Transparency in WinCC V13
Transparent screens can be displayed without any problems in Runtime. This is true for all 
Comfort Panels and WinCC Runtime Advanced with version 13.0.0.0.
To use the transparency in a graphic view or in a graphic I/O field, the "Fill pattern" property 
must be set to "Transparent" and the property "Use transparent color" must be disabled.

If the property "Use transparent color" is enabled in a device with version 13.0.0.0, the 
transparency of the screen is lost and the transparent screen areas are displayed in black. We 
recommend that you check the "Use transparent color" property at the points of use of 
transparent screens after upgrading existing projects to device version 13.0.0.0. If the screens 
are not displayed correctly, disable this property.

2.3.5.2 Tags and connections

Contents
Information that could no longer be included in the online help and important information about 
product features.

Display of deleted array elements at location of use of HMI tags
The locations of use of HMI tags, such as the process value of IO fields, are usually indicated 
by the tag name. If the element of an array tag is used, then the tag name will be extended by 
the index of the array element indicated in brackets.

If a used tag is no longer included in the project, then the tag name will still be displayed at the 
location of use. The field will be displayed with a red background to indicate the missing tag. 
If a used array element or the array tag is no longer present, then only the index of the array 
element will be displayed in brackets. The tag name will not be displayed. The field is 
highlighted in red. You can no longer identify the name of the associated array tag based on 
the location of use in this instance.

If you do not know which array tag was linked to this location of use, then it may be necessary 
to link the array element once again.

If a tag or array tag was created based on a reference, then the selected reference will be 
closed automatically.

If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no longer 
exist in the project, then the same behavior will take place in the "HMI tags" editor.       

Array tags as list entry of multiplex tags
You can use the array tags of the Char data type just like the tags of the String data type.       
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The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI 
tags" editor is not supported. 

Multiplexing tags on a Basic Panel
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the PLC 
in runtime during the first read cycle. The value of the address read is not available until the 
second read cycle.

Runtime Advanced and Panels: Importing array elements and structure elements
Array tags and structure tags are always imported in full with all elements. The elements of 
the array tags and structure tags are not filled further during import.

A new tag is created if the name of a tag corresponds to the name of an array or structure 
element in the import file.

Example:

The import file contains an array tag called "Otto" with 10 array elements. The array elements 
are then called Otto[1], Otto[2], for example.

If the import file contains a tag named "Otto[1]", the first element of the array tag will not be 
filled. Instead, a new tag will be created in the engineering system.

Local ID of HMI connections
You cannot edit the "Local ID" value in the HMI connection properties. You need the local ID, 
for example, for communication by way of AR_SEND. To enable usage of the "Local ID" for 
communication, proceed as follows:

1. Open the network view in the "Devices & Networks" editor.

2. Click "Connections".

3. Select an S7 connection.

4. Select the "Add new connection" command in the shortcut menu of the PLC.

5. Click on the interface.

6. Specify the "Local ID (hex)".

7. Click "Add" and then "Close".

8. Select "Properties > General" from the partner area of the Inspector window and enter the 
IP address of the HMI device for the new connection.

9. Configure the necessary raw data tags for communication in the HMI device.

Tags with the DTL data type
Tags that use the "DTL" data type element by element, can only be used as read-only.
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Tag names in faceplates
Use of the "." or "@" character in names of tags in faceplate types is not permitted. Do not use 
these special characters in the tag names in faceplates. 

RT Professional: Tags with symbolic addressing and "Char Array" data type
Tags with symbolic addressing and the "Char Array" data type are not released for 
communication of RT Professional and SIMATIC S7-1200 V3.

Array elements in WinCC
If you have connected an HMI tag with an array from a STEP 7 data block which does not start 
with a low limit of 0, the array elements are mapped in WinCC to the low limit of 0.

To ensure that you do not have to rethink between the STEP 7 indices and the WinCC indices 
when accessing the individual array elements, the low limits of arrays should also start at 0 in 
STEP 7.

2.3.5.3 Alarm system and alarm displays

Contents
Information that could not be included in the online help and important information about 
product properties.

Displaying special characters in alarm texts
When configuring alarm texts, a fixed character set is used in the Engineering System. This 
character set allows you to use numerous special characters in alarm texts.     

Language-dependent fonts are used in runtime to display the texts, for example MS PGothic, 
SimSun. The fonts used in runtime do not support all special characters. As a result, some 
special characters are not displayed in runtime.

Use of multiplex tags in output boxes with alarm texts
It is also possible to use multiplex tags in the output boxes of alarm texts in the engineering 
system. During runtime, this leads to an incorrect display of the alarm, because the use of 
multiplex tags is not supported by the basic panels.     

Parameters in user alarms
Contrary to the information in the online help, it is not possible to configure parameters for user 
alarms.
The menu command "Properties > Properties > Alarm parameters" is not available in the 
Inspector window.
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Tags in alarm texts of RT Advanced
Tags of data type WChar or WString cannot be displayed in the alarm view in RT Advanced.

2.3.5.4 System functions and scripts

Contents
Information that could no longer be included in the online help and important information about 
product features.

Runtime error on startup on TP 277 and OP 277
At the start of the runtime on a TP 277 or OP 277, the error "Global unknown error with VBScript: 
'Expected statement' in script ..." can be reported.

This error is triggered on devices with the Windows CE 3.0 operating system by user functions 
of the following type:

 
Sub VBFunction_1()
With HmiRuntime.Screens("Screen_1").ScreenItems("Button_1")
    .backcolor = vbred
    .visible = not .visible
End With
End Sub

If the error occurs, you need to re-program the user function as follows:

 
Sub VBFunction_1()
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").backcolor = vbred
    HmiRuntime.Screens("Screen_1").ScreenItems("Button_1").visible = not .visible
End Sub

Hiding warnings for scripts
Enable "Runtime settings > General > Settings > Also start with faulty scripts". 

As a result, Runtime is started irrespective of faulty scripts. In addition, script warnings will not 
be displayed during a complete compilation

Graphics in faceplates
You have added a graphic view in a faceplate and defined the "Graphic" property as the 
interface of the faceplate. The "Graphic" property can be made dynamic using the interface of 
the faceplate instance.
Use the following notation to address the graphic property via a script: "..\\..\\Graphic name".
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Scripts for service projects
Since no interactive user is usually logged in service projects, C scripts and VB scripts lead to 
problems in the following cases:

● When the scripts require interaction, for example, operator input.

● When the scripts show message boxes.

There is no common data area for C scripting in service mode. Thus, for example, no global 
C variables can be exchanged between the "Scheduled tasks" and "Screens".

Find and Replace in local scripts in WinCC Professional
Use the "Find and Replace" function to find and replace texts within editors. It is not possible 
to use Find and Replace in local scripts.

System functions in local scripts
System functions can be converted into local C scripts or VB scripts. 

If a WString type tag is used in a SetTag system function that was converted into a C script, 
an error message is generated in the Global Script diagnostics window when the function is 
executed. The message does not affect the execution of the function.

This concerns the following SetTag functions:

● SetTagWithOperatorEvent

● SetTagIndirect

● SetTagByTagIndirect

● SetTagIndirectByTagIndirect

● SetTagByProperty

● SetTagIndirectByProperty

Properties no longer used in Comfort Panels and RT Advanced
In WinCC V13, many new visual properties have been introduced and many existing properties 
have been harmonized. 

In the course of revision of the object properties, some properties that could be used in VB 
scripts in earlier versions of WinCC are no longer supported for use in WinCC V13. Scripts 
that use properties that are no longer supported remain valid, but the relevant calls within the 
scripts have no function. These limitations pertain exclusively to Comfort Panels and RT 
Advanced in device version V13.0.

The following table shows the properties of screen objects that are no longer being used: 
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Property Screen object
BorderBrightColor3D Slider
BorderColor Text field, I/O field, symbolic I/O field, 

date/time field
BorderInnerWidth3D Slider
BorderOuterWidth3D Slider
BorderShadeColor3D Slider
BorderStyle3D Text field, I/O field, button, symbolic I/O field, graphic I/O field, 

date/time field, bar, switch
BorderWidth Text field, symbolic I/O field
CenterColor Gauge
DialColor Gauge
EdgeStyle Text field, I/O field

System function "ChangeConnection"
Contrary to the description in the online help, the system function "ChangeConnection" is 
released for the following devices:

● SIMATIC S7-300/400 

● SIMATIC S7-NC

● SIMOTION

The system function "ChangeConnection" is not released for SIMATIC S7-1200.

2.3.5.5 Reports

Contents
Information that could not be included in the online help and important information about 
product features.

Displaying controls in protocols
A project with WinCC V11 SP2 with Update 4 or earlier is upgraded to WinCC V13.

In this process, it may happen that archive data is not displayed in controls for protocols.

The following controls are affected:

● f(t) trend view

● f(x) trend view

● Table view

Remedial measures for f(t) trend view and f(x) trend view
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1. In the control, select "Properties > Properties > General > Display > Online". 

2. Recompile your project.

3. Load the project onto your HMI device.

Remedial measures for Table view:

1. In the control, select "Properties > Properties > General > Upon opening screen > Start 
update". 

2. Recompile your project.

3. Load the project onto your HMI device.

2.3.5.6 Recipes

Contents
Information that could not be included in the online help and important information about 
product features.

Arrays in recipe elements
If you have configured both an array as well as the elements of this array for recipe elements 
of a recipe, the loading of data records aborts with the following error message: "290055: Import 
of data records aborted with error"

Use either the array or just the array elements for recipe elements of a single recipe.

2.3.5.7 User administration

Contents
Information that could not be included in the online help and important information about 
product features.

2.3.5.8 Communication

Contents
Information that could no longer be included in the online help and important information about 
product features.

Connection interruptions with Mitsubishi PLCs
After multiple connection interruptions, a situation may arise where all the connection 
resources of the Mitsubishi PLC are in use and the connection can no longer be established. 
It is recommended to check these connection resources in the PLC program of the PLC and 
also to enable them again.   
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Accuracy of the "DTL" data type
The "DTL" data type supports time information down to the nanosecond range. Because panels 
only support time information down to the millisecond, the following restrictions arise when 
used at the area pointers:   

● Area pointer "Date/time"
For the transmission of time information from a panel to the PLC, the smallest unit of time 
is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" data 
type is filled with zeros.

● Area pointer "Date/time PLC"
For the transmission of time information from a PLC to a panel, the range from 
microseconds to nanoseconds is ignored. The time information down to and including 
milliseconds continues to be processed on the panel.

Limited number of possible HMI connections
An error message is displayed during compilation of a device indicating that the configuration 
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that 
the maximum number of possible connections of the HMI device or PLC has been exceeded.

Check the maximum number of available connections. Consult the device manuals of the 
devices you are using.

Communication by means of routing with S7 300/400
Communication of connection partners in different subnets is possible via routing with the 
following connections: PROFINET, PROFIBUS, MPI.

Use of PROFINET IO with panel HMI devices
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC, 
you can define an offset for the address area of the inputs and outputs during configuration in 
HW Config.

The following restriction applies when a PROFINET IO-capable S7-400 CPU is used with one 
of the HMI devices listed below:

The offset for the start of the address area of the inputs must not be greater than the offset for 
the start of the address area of the outputs.

The restriction applies to the following HMI devices:

● OP 177B

● OP 277

● Mobile Panel 177

For the configuration of the address parameters, open the PLC with the S7-400 CPU in HW 
Config. Select the HMI device connected via PROFINET IO in the station window of HW Config. 
A table with the properties of the HMI device is displayed at the bottom of the station window 
in the detail view. Select the line containing the addresses of the HMI device in the table and 
open the object properties using the shortcut menu.
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Enable the "Addresses" tab in the "Object properties" dialog. Configure the offset for the inputs 
under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start".

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX
With some data types, the Mitsubishi MC and Mitsubishi FX communication drivers do not 
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data 
types affected are:

● 4-bit block

● 12-bit block

● 20-bit block

● 24-bit block

● 28-bit block

Coordination area pointer in an OPC connection
In principle, the coordination area pointer can be used eight times in an OPC connection. If 
you have configured an OPC connection and you automatically create another OPC 
connection using "Add", the coordination area pointer is only displayed once in the newly 
created connection. In this case, you should change the communication driver of the 
connection. If you then set OPC again as the communication driver, the coordination area 
pointer can again be used eight times.

RT Advanced communication via Station Manager (SIMATIC NET) with an S7-1200
For communication of a SIMATIC S7-1200 with a PC with WinCC RT Advanced via a router, 
the following restrictions apply to the PC:

● Windows 7: Only with installed SIMATIC NET 8.1

● Windows XP: Communication via Station Manager (SIMATIC NET) is not supported

These restrictions also apply if you are using WinAC MP or Station Manager. Connections with 
the help of the Station Manager of Runtime Advanced are always treated as routed 
connections.

Communication between S7-1200 and a multi panel
Communication between an S7-1200 and a multi panel with the "WinAC MP" option installed 
via ProSave is not possible. The HMI devices affected are:

● SIMATIC MP 177 6" Touch

● SIMATIC MP 277 8" Touch

● SIMATIC MP 277 8" Key

● SIMATIC MP 277 10" Touch

● SIMATIC MP 277 10" Key

● SIMATIC MP 377 12" Touch
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● SIMATIC MP 377 12" Key

● SIMATIC MP 377 15" Touch

● SIMATIC MP 377 19" Touch

HMI connections in WinCC V13
HMI connections to SIMATIC S7-1200 PLCs with firmware versions earlier than V2.0 are not 
possible in WinCC V13.

Connections via PROFIBUS DP
When a connection between a PLC and an HMI device via PROFIBUS DP is interrupted and 
then re-established, sporadically all other PROFIBUS DP connections in the communication 
network are interrupted and re-established.

De-energize the disconnected station before reconnecting it.

"Set the IP suite (address) of the PLC in the Control Panel" with SIMATIC S7-1200 V1
The function "Set the IP suite (address) of the PLC in the Control Panel" has not been approved 
for the following PLCs:

● SIMATIC S7-1200 V1

Switching a connection
A connection may be interrupted when it is switched from an HMI device to a SIMATIC 
S7-300/400, to a SIMATIC S7-1500 or to a SIMATIC S7-1200 PLC.

Note the following settings in the SIMATIC S7-1500 or SIMATIC S7-1200 controllers: 

● Absolute addressing of tags

● The "Disable PUT-GET communication" option must be selected

● The "Complete protection" protection level may not be set

Communication of Runtime Professional with SIMATIC S7-1200
In productive operation, communication of WinCC Runtime Professional with SIMATIC 
S7-1200 is only released for single-user systems.

RT Advanced in the Station Manager
If RT Advanced and WinAC RTX use the same communication processor of a PC, HMI 
communication with SIMATIC S7-1200 and SIMATIC S7-1500 is not possible.
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Raw data communication in redundant projects
Simatic.NET, Named Connections and various communication blocks, such as BSEND/BRCV, 
for example, can only be used to a limited extent in a redundantly configured PC station 
because the connection parameters for the redundant partner server cannot be configured.

2.3.6 System-wide functions

Contents
Information that could no longer be included in the online help and important information about 
product features.

Inter Project Engineering: Displaying alarms of system diagnostics 
If you do not enable "PLC alarms" when you create device proxy data, system diagnostic 
alarms are not applied to the device proxy data.

System diagnostic alarms of the device proxy are not displayed after initialization of device 
proxy data without "PLC alarms".

2.3.7 Compiling and loading

Contents
Information that could no longer be included in the online help and important information about 
product features.

Compiling and loading
If internal errors or warnings occur during compiling, compile the complete project using the 
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device.

Before you start productive operation with your project, compile the entire project using the 
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device.

If you are using HMI tags that are connected to the control tags in your project, compile all 
modified blocks with the command "Compile > Software" in the shortcut menu before you 
compile the HMI device.

Settings for update of operating system
If you select the command "Online > HMI device maintenance > Update operating system" 
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud 
rate. The settings used during the last download are always used.
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To make changes to the settings, open the "Extended download" dialog using the "Online > 
Extended download to device" command and change the settings. When you click the "Load" 
button the changed settings are saved.

Alternatively, you can perform an update of the operating system with changed settings with 
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options and 
Tools > HMI Tools > SIMATIC ProSave".

Incorrect installation of ProSave
If you receive an error message during installation of ProSave when loading data to a target 
device or maintenance of an HMI device, then you cannot remedy this error using the repair 
function of setup. Remove ProSave via the Control Panel. Then start setup and install the 
"ProSave" component again.     

Checking the address parameters
During compilation of an HMI device in the project tree with the command "Compile > Software" 
in the shortcut menu, the address parameters of the HMI device, such as the IP address, will 
not be checked. If you want to ensure that the address parameters are checked as well, you 
will have to compile the HMI device using the "Compile" button in the "Devices & Networks" 
editor of the toolbar.   

Error message when downloading data to the PLC
A panel and a PLC are connected and communicating with other. 

If a tag is accessed while downloading data from the panel to the PLC, an error message is 
displayed on the panel.     

Delayed reaction in the "Extended download to device" dialog
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface" 
and "PG/PC interface" do not match the settings on the HMI device, this can result in the 
application not responding for up to a minute.

     

Extended download with an S7-1200 and a Comfort Panel
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the PG/
PC. You open the "Extended download to device" dialog for the Comfort Panel. 

If you enable the option "Show all accessible devices", it may occur that the application stops 
responding.   

OP77A, OP73, TP177A: Loading projects
When loading a project to an HMI device, it can happen that Runtime is not automatically 
ended, even though "Remote Transfers" is activated in the Panel.

If this happens, stop Runtime and manually set the transfer mode on the HMI device.       
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Loading a SIMATIC HMI application to a PC station
The following circumstances can lead to an error message during the first load of a SIMATIC 
PC station:

● A SIMATIC HMI application is configured in a PC station in the project

– WinCC Runtime Advanced

– WinCC Runtime Professional

– WinCC Standby

– or WinCC Client

● The property "S7RTM is installed" is activated.

Before you load a SIMATIC PC station for the first time, select the configured device HMI_RT 
(WinCC...) in the project tree. Open the "Extended download to device" dialog and select the 
appropriate interface and parameter settings. Click "Load".

You then load the PC station as normal.     

Project transfer via USB
If you have connected more than one HMI device via USB to your configuration PC, project 
transfer is only possible to the last connected device.

Opening project files
When you run "HmiIRTm.exe", a dialog opens asking if you want to open the project file (.fwc). 

The following options are available to you: 

● "Yes": A dialog opens allowing you to select a project file (.fwc).

● "No": The dialog closes.

Tag simulator in WinCC Professional does not start
If the tag simulator does not start in WinCC Professional, it may be because the fm20.dll file 
has not been installed in the system yet. The fm20.dll file cannot be distributed and must be 
installed as part of a Microsoft application:
http://support.microsoft.com (http://support.microsoft.com/default.aspx?scid=kb;EN-US;
224305)

You have the following two options for installing the fm20.dll file:

● Install an application, such as Microsoft Office 97, on the destination system. The 
installation routine also installs the fm20.dll file.

● You can also download and install the Microsoft ActiveX Control Pad free of charge. The 
fm20.dll file is also installed in this case. Additional information on the ActiveX Control Pad 
is available on the Microsoft Developer Network website:
http://msdn.microsoft.com/en-us/library/ms968493.aspx (http://msdn.microsoft.com/en-us/
library/ms968493.aspx)
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2.3.8 Runtime

2.3.8.1 Notes on operation in Runtime

Contents
Information that could no longer be included in the online help and important information about 
product features.

Focus in Runtime
If you have configured a low-contrast combination of focus color and border color in a V12 
project, the focus may no longer be identifiable after changing the HMI device version in 
Runtime. Change one of the two colors.

Language behavior - Layout of on-screen keyboard
The layout of the on-screen keyboard is not switched when the runtime language changes.     

Tag values exceed the maximum length     
You enter a character string in a string tag via an I/O field. If the character string exceeds the 
configured number of tags, the character string will be shortened to the configured length.

Empty message texts
Runtime is running with a project. The project is saved on a network drive.

In the event of interruptions to the network drive connection, Runtime may attempt to load 
message texts from the network drive.

In the event of disconnection, the alarm window or the alarm view remains empty.

To avoid this, copy the project to a local drive before the starting the project in Runtime.

Complete download in Service mode
If you need to perform a "complete download" to the OS in Service mode from the engineering 
station, Runtime automatically stops and then starts again. 

The project is then no longer in Service mode.

In this state, the power supply is interrupted and WinCC Runtime no longer starts automatically 
on the OS.

Remedy: 

1. Switch the project manually to Service mode after you have performed the "complete 
download". 

2. Close the project manually.
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3. Enable Service mode.

4. Start Runtime again using the surrogate icon in the taskbar.

Slow response from the screen keyboard and SmartServer
The following programs may start and respond very slowly under Windows 7 and Windows 
2008 servers:

● Microsoft OSK screen keyboard and HMI TouchInputPC

● SmartServer: <Ctrl+Alt+Del> shortcut in the logon dialog

The delay is caused by the callback for the Internet certificate validation.

Remedy:

You can find the following files
on the product DVD under:
Support\Windows7\CRL_Check or CD_RT\ Support\Windows7\CRL_Check\:

● DisableCRLCheck_LocalSystem.cmd

● DisableCRLCheck_CurrentUser.cmd

1. Run the "DisableCRLCheck_LocalSystem.cmd" file with administrator rights. Select the 
command "Run as administrator" from the shortcut menu of the file.

2. Reboot the PC.

If the problem persists, follow these steps:

1. Double-click the file and run the "DisableCRLCheck_CurrentUser.cmd" file with user rights.

2. Reboot the PC.
 

  Note

The callback for the certificate validation is disabled for all users or PCs. To restore the 
original state, perform the following files:
● RestoreDefaults_LocalSystem.cmd
● RestoreDefaults_CurrentUser.cmd

You can find the files in the following directory of the product DVD:
● Support\Windows7\CRL_Check or CD_RT\Support\Windows7\CRL_Check\

 

Starting Runtime
Only WinCC Runtime V13 can be started in TIA Portal V13. WinCC Runtime V11.02, V12 or 
V13 can be simulated in TIA Portal V13. 
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2.3.8.2 Notes on operation of panels in Runtime

Contents
Information that could not be included in the online help and important information about 
product features.

License transfer via S7USB
You always need to run WinCC to transfer a license to a panel via S7USB.

Transferring licenses to a panel on 64-bit operating systems
If you are running a 64-bit operating system and the "Edit > Connect target systems > Connect 
HMI device" menu command is not available in Automation License Manager, open command 
line input and run the following command with administrator rights:

"%WINDIR%\system32\RegSvr32.exe" "%CommonProgramFiles%\siemens\AlmPanelPlugin
\ALMPanelParam.dll"

Using the mouse wheel in Runtime
The use of the mouse wheel in Runtime is not supported on all panels.   

Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime 
The default font selected in the "Runtime settings > Languages & font" editor has an effect on 
the display of texts in runtime. 

Text entries may be truncated if you selected an unfavorable font size or style.

This setting possibly has an effect on the following text entries:

● Tooltips

● long alarm text

● text in the dialogs

Basic Panels: Connections to S7-1200 and S7-1500 with Backup/Restore
If you use the "Backup/Restore" function, a maximum of two connections from Basic Panels 
to the controllers are possible at any given time.

● SIMATIC S7-1200

● SIMATIC S7-1500

Basic Panels: Backup on the memory card of the PLC
Create the backup file "A.psb" on the memory card of the PLC. An error, for example a 
connection break, occurs when creating the backup.
This will create a corrupt file on the memory card of the PLC. Such a file has "~$" as prefix. 
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Delete the file with the prefix "~$" if you want to save a backup again under the same name 
"A.psb".

Basic Panels: Panel Data Storage and S7-1500F
The "Panel Data Storage" PDS function cannot be used on Basic Panels in conjunction with 
S7-1500F when the password for the protection level "Full access incl. fail-safe" is used.

2.3.8.3 Notes on operation of Runtime Advanced

Contents
Information that could not be included in the online help and important information about 
product features.

Permission for starting Runtime
On a computer running the 32-bit version of Windows 7, WinCC Runtime Professional or 
WinCC Runtime Advanced can only be started when a user is a member of the automatically 
created group, "Siemens TIA Engineer". 

.Net-Controls in Runtime
If you have incorporated a .Net Control in your project as "Specific .Net-Control", you have to 
copy the files belonging to these controls to the installation directory of WinCC Runtime, e.g. 
"C:\ProgramFiles\Siemens\Automation\WinCC RT Advanced". Otherwise, the control cannot 
be loaded in Runtime.

2.3.8.4 Notes on operation of Runtime Professional

Contents
Information that could no longer be included in the online help and important information about 
product features.

Authorization for starting Runtime
On a computer running the 32-bit version of Windows 7, WinCC Runtime Professional or 
WinCC Runtime Advanced can only be started when a user is a member of the automatically 
created group, "Siemens TIA Engineer". 
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User authorizations within the operating system
1. All user must be added to the "SIMATIC HMI" user group. This also applies to users who 

want to open WinCC projects remotely.

2. The storage folders of the projects must have the NTFS authorizations "SIMATIC HMI" with 
full access and "SIMATIC HMI Viewer" with read access. The authorizations must be 
inherited for all subordinate objects.

3. Members of the Windows user group "SIMATIC HMI" should not simultaneously be 
members of the Windows user group "SQLServerMSSQLUser$<Computername>
$WINCC". The members of this group have administrator rights to the SQL server. 
Therefore remove all Windows users from this group for whom restricted access to the 
WinCC database is sufficient.

Windows 7 / Windows Server 2008: Locking key combinations
If you want to lock key combinations under Windows 7 or Windows Server 2008, you must 
change the group policies in the administrative tools of the operating system.

A detailed description of this can be found in the FAQ with the entry ID "44027453" in the 
SIMATIC Customer Online Support:

Internet: WinCC FAQ 44027453 (http://support.automation.siemens.com/WW/view/en/
44027453) 

Undocked toolbars
If the setting "Always on Top" is used for the Windows taskbar, undocked toolbars can be 
hidden behind the Windows taskbar in Runtime. Follow the steps below to show the toolbars 
again:

1. Select the "Properties" command in the shortcut menu of the taskbar.

2. Disable "Keep taskbar on top of other windows".

Fault in the connection between the server and the client
If the connection between the server and client is faulty, check the settings of the PG/PC 
interface. TCP/IP(Auto) should not be used for the "Interface Parameter Assignment Used". 
Used fixed IP addresses instead.

Fault in the connection between the server and the client
If the computer is simultaneously used as a server with the engineering system and a client 
cannot establish the connection to the server, you should check the releases set on the server.

1. Exit Runtime on the server.

2. Select the command "Find computer..." in the shortcut menu of the network environment 
on the desktop of the server.

3. Enter the name of the server as the computer to be found.
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4. Open the computer found to see the released directories.

5. Remove all the releases that begin with "WinCC_Project_HMI". Information on this is 
available in the documentation for the operating system.

This malfunction is caused by the use of the command "Save as..." in conjunction with the 
startup of the Runtime of this new project. You can make copies of the projects for backup 
purposes using the "Save as..." command. You should, however, continue to work with the 
original project.

Starting WinCC Runtime Professional
If engineering system and Runtime are operated on a computer, Runtime or simulation for a 
project opened in the engineering system should only be started and ended via the TIA Portal. 
Other options, for example, the symbol in the taskbar information area, should not be used.

Setting the services for the SQL server
In order to ensure the full functionality of the SQL server for WinCC and WinCC Runtime, you 
have to check the SQL server settings.

1. Start "Programme > Microsoft SQL Server 2008 R2 > Configuration Tools > SQL Server 
Configuration Manager" in the start menu.

2. Click "SQL Server Services" in the tree.

3. Check the services "SQL Server (WinCC)","SQL Server (WINCCPLUSMIG)" and "SQL 
Server Browser". "Automatic" must be entered for "Start Mode". "LocalSystem" must be 
entered for "Log On As". Change the settings, if necessary.

4. Click "SQL Server Network Configuration" in the tree.

5. Click "Protocols for WinCC".

6. Check the "TCP/IP" protocol. "Enabled" must be entered for "Status". Change the settings, 
if necessary.

"Report system error" in WinCC Runtime Professional
The "Report system error" functionality is limited in WinCC Runtime Professional in conjunction 
with an S7-300 or S7-400. In an alarm view, only one alarm is ever displayed for each 
diagnostics type. Alarms on other errors of the same diagnostics type are not displayed.

WinCC interface and 64-bit operating system
The open interfaces of WinCC Runtime Professional do not offer native 64-bit support. Runtime 
API, VBS and the WinCC OleDB provider are primarily affected by this. To be able to use 
WinCC interfaces with a 64-bit operating system, note the following:
- VB scripts cannot be started by simply double-clicking. You must explicitly use the 32-bit 
version under "syswow64\wscript.exe".
- .NET applications that use the WinCC API have to be explicitly compiled as 32-bit 
applications, not with "AnyCPU", but with "x86".
- C++ applications must not be compiled as 64-bit applications.
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Dynamic graphics in WinCCViewer RT
If you use dynamic graphics from a graphics collection, e.g. linked with scripts, these graphics 
are not updated in the WinCCViewer RT.

Select the "User-defined" option under "Runtime Settings" > Graphic Settings".

RT Professional: Loading a project without connection to the configuration PC 
Before you begin to load a project on the operator station, backup data such as "User 
administration" and "Recipe data".

1. User administration data are overwritten by default. 
Therefore, configure two buttons in your project for exporting and importing the user 
administration with the system function "ExportUserManagement“. The data only needs to 
be exported if you have made changes to the user view in Runtime.

2. In the "Load preview" dialog, specify whether recipe data should be overwritten when 
loading the project. 
You can save recipe data in the recipe view using the operator controls "Export log" and 
"Import log".

Note that the most recently imported or loaded data are used in Runtime.

Operation on a network server
Operation of WinCC Professional on a network server (e.g., domain controller, file and name 
utility server, router, software firewall, media server, exchange server) is not permissible.

API functions for recipes
You need the following files to use the Runtime API functions for recipes:

ccuacapi.h

ccuacapi.lib

ccuacapi.dll

Connection with S7-1200 in system diagnostics
Only a WinCC Runtime Professional HMI system can be connected with an S7-1200 (up to 
V3) when you use system diagnostics.
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2.3.9 HMI devices

2.3.9.1 Notes on HMI devices

Contents
Information that could no longer be included in the online help and important information about 
product features.

If the PC goes into standby or hibernate mode while the transfer is in progress, the panel status 
after interruption of the transfer is not defined.

Multi-key operation
Unintentional actions can be triggered by multi-key operation:         

● When you are using a key device, you cannot press more than two function keys at the 
same time.

● When you are using a touch device, a standard PC or a panel PC, you can only press one 
function key or button at the same time.

TS Adapter with Ethernet interface
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory 
settings.   

Simulation of the Basic Panels
Use an output field in an alarm text to output an external tag. The content of the output field 
will always be displayed with "0" during simulation.   

Simulation with real PLC connection
The access point used by the simulation is independent from the settings of the engineering 
system and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool. 
If the PLC connection is terminated right after the start of the simulation with alarm 140001, 
you should check the access point used by the simulation with "Setting PG/PC Interface".

1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens.

2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI.

3. Select the interface in the "Interface Parameter Assignment Used" area.

4. Exit the dialog "Setting PG/PC Interface" with OK 

Loading of projects without recipe data records
You are using recipes in a project. You transfer the project to a Basic Panel without recipe 
data records. 
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You may encounter inconsistencies if you have altered the structure of the recipe in the 
engineering system and the device already held recipe data records.

Check the consistency of the data records in this case. The device will not issue a note for all 
structural changes.       

Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the 
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it 
is displayed as 0.

Mobile Panels V2
If you use Mobile Panels V2 in a project, it is not possible to open the project with WinCC V11 
SP1. This affects projects with the following devices:

● Mobile Panel 277F IWLAN (RFID Tag)

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile Panel 
277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project.

HMI devices with operating system Windows CE 5.0 or higher
Owing to a modified client-server communication security setting, the time difference between 
the HMI device (client) and PC (server) must not exceed 1 day. If you back up recipe data from 
the HMI device on a network drive, for example, make sure that the time is set correctly on the 
PC (server) and the HMI device (client).

HMI devices with high communication load
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other 
HMI devices. Otherwise, you will risk overload on the Panel.

Device replacement in the engineering system
In the engineering system, you replace a device with configured LED keys with a device without 
LED keys. Runtime start fails after you have transferred the project data to the device. 

For this reason, delete the LED key configuration before you replace the device.

Restrictions for the HMI device, MP 377 15" Touch daylight readable
The following functions are not supported in WinCC V12 for the MP 377 15" Touch daylight 
readable HMI device:
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● Option: Sm@rtServer

● System function: SetAndGetBrightness

● Direct keys

Upgrading Basic Panels to WinCC V13
Before you upgrade Basic Panels from version V12 to version V13, transfer the image of the 
V12 SP2 Update 5 or higher to the devices.
In the "SIMATIC ProSave [OS Update]" dialog, select the setting "Reset to factory settings". 

In this way, you always start a functional update of the image.

Affected devices:

● KP300 Basic mono PN 

● KP400 Basic color PN

● KTP400 Basic color PN

Connection switch in the Control Panel with Basic Panels
If you use the "Override protected connection information" function, the following restriction 
applies:

You cannot perform a connection switch in the Control Panel of a Basic Panel from a PLC 
without a protection level to a PLC with a "Complete protection" level.

Mobile Panels 277F 8'' IWLAN
Mobile Panels 277F 8" IWLAN V2 and 277F 8" IWLAN (RFID Tag) cannot be configured with 
WinCC V13.

Basic Panels 2nd Generation
Basic Panel KTP1200 Basic can currently not be configured with WinCC V13. 

The following maximum values are in effect for Basic Panels 2nd Generation.       

 

Alarms

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of discrete alarms 1000 1000 1000 1000

 

Screens
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 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of complex objects per screen  1) This information is not relevant for Basic Panels 2nd Generation.
Number of system diagnostic displays 
per screen

5 5 5 5

Number of array elements per screen 2) 100 100 100 100

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

2) Array elements contained in recipes are included in the count.

 

Logs

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of entries per log (including all 
log segments) 1)

10000 10000 10000 10000

Number of log segments 400 400 400 400
Number of tags that can be logged per 
log

10 10 10 10

Cyclic trigger for tag logging 1 s 1 s 1 s 1 s

2.3.9.2 Using multi-touch functions

Multi-touch operation

Introduction
RT Advanced supports multi-touch operation under Windows 7 and Windows 8.  You operate 
objects on the multi-touch screens by touching them with one or two fingers. Multi-touch 
operation is supported by TIA Portal V13. Versions V12 or older only support single-touch 
operation.

Requirement
The used monitor must support multi-touch functions.

Scrolling in lists and controls 
You can scroll through lists and controls by dragging the screen margin.

You use horizontal dragging to move the content of the screen to the left or right. You use 
vertical dragging to scroll up or down in the view. An indicator appears during scrolling to 
indicate your position. When you drag a list diagonally on the screen, the content is moved 
horizontally and vertically at the same time.

Horizontal scrolling is not supported in the "Trend view" object. 
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You scroll five times faster up or down on a page when you use two fingers to drag up or down. 
 

 Note
Current view is not persistent

The position in the trend window changed by scrolling is not saved. 
In case of a screen change, the trend view is reset to the default setting.

 

Zoom in and out
You enlarge or reduce the view in "Trend view" and "f(x) trend view" objects by pinch-to-zoom 
with two fingers.

Double tap to switch from the magnified trend view back to the normal view.

The zooming function is limited to the time axis in the "Trend view" object.  

If you have enabled the option "Range > Auto-size" during configuration of the value axes in 
f(x) trend view, the axes are constantly calculated during zooming.

 

 Note
Current view is not persistent

The changes of the zoom factor are not saved.

In case of a screen change, the trend view is reset to the default setting.
 

Supported gestures

Supported gestures
The following gestures are supported.

Gesture  Function
Tap You can select a button, for 

example, by tapping.

Drag Use one finger to scroll horizontally 
and vertically, for example, in lists. 
You scroll horizontally and vertically 
at the same time with a vertical drag.
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Gesture  Function
 Use two fingers to scroll up or down 

a page quickly. 

Scale Pinch-to-zoom to enlarge or reduce 
the display of the control.

Double tap Double tap the display to reset the 
view to the default zoom factor 
100%. 
 
 

 

 
 

 Note
Operating with three of more fingers

Do not use three or more fingers to operate the device. This can lead to incorrect operations.
 

Two-hand operation of operator controls

Two-hand operation of operator controls

Introduction
WinCC supports two-hand operation of operator controls with RT Advanced. It ensures safe 
operation of operator controls which are used to change critical system settings, for example, 
control tags with machine limits. 

Readme
2.3 WinCC Professional

WinCC Professional V13.0
System Manual, 02/2014 95



Locked and unlocked operator controls
You define specific operator controls as "locked operator controls" for two-hand operation of 
operator controls. Locked operator controls usually cannot be operated in runtime. The 
operator can only operate the locked operator controls if he presses a release button at the 
same time.  

In runtime, locked operator controls can only be accessed with the tab sequence if a release 
button is pressed at the same time.

Locked operator controls and release buttons
You can configure the following operator controls as locked operator controls: 

● I/O field as input field or input/output field 

● Button (visible)

● Button (invisible)

● Status/Force

● Slider

● Date/time field

You must configure at least one button in the screen as release button. This can be any 
unlocked button. 

 

 Note

You cannot configure operator controls or release buttons in the permanent window. 
 

Templates with locked operator controls
You can also use locked operator controls in screen templates. To lock or unlock operator 
controls in templates, proceed as you would with operator controls in screens.  

You can also implement a release button in the template. Use the same approach as for release 
buttons in screens. 

In a screen created from the template, the release buttons from the template and any release 
buttons of the screen are active.  

Display in runtime 
The locked operator controls are displayed as dimmed in runtime. The release buttons are 
optically highlighted as soon as the operator presses a locked operator control. The locked 
operator controls are completely visible when they are unlocked by means of the release 
buttons. 

This means you can configure the release buttons as invisible operator controls. 
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Simulation of projects with multi-touch functions
WinCC supports the simulation of configured multi-touch functions. Requirement is that your 
monitor supports multi-touch operation. 

Locking and unlocking operator controls
You can lock and unlock operator controls in projects for multi-touch devices. Locked operator 
controls can only be operated in runtime if the operator presses a release button at the same 
time. 

You can lock and unlock individual operator controls or several operator controls 
simultaneously. 

Procedure
1. Configure operator controls of the type I/O field,button or slider. 

2. Select the required operator control(s). 

3. To lock the operator controls, enable the option "Activate two-hand operation" under 
"Properties > Properties > Security". 
 

4. To unlock the operator controls, disable the option "Activate two-hand operation" under 
"Properties > Properties > Security".  

In runtime, locked operator controls can only be operated if a release button is pressed at the 
same time. 

Defining release button
To use the locked operator controls, you must configure at least one release button (Page 98) 
in the same screen.

If no release button is configured, WinCC makes you aware of this fact during compilation of 
the project.  
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Configuring release button in screen or template
For the operator to operate locked operator controls on multi-touch devices (Page 97), at least 
one release button must be configured in the same screen. 

If the screen is based on a template and a release button is already defined in the template, 
the release button from the template is automatically in effect as release button of the screen. 
You can then configure an additional release button in the actual screen.  

Requirement
At least one unlocked button is configured in the screen or in the template. 

Procedure
1. Select the required button of the screen or template under "Release button" under 

"Properties > Properties > General". 
 

 

  Note

You can also select a button from a group for this purpose. Buttons from faceplates, 
however, are not available. 

The selected button can also be displayed as invisible. It is optically highlighted in runtime 
when you press a locked operator control. 

 

If the screen is based on a template and a release button is already defined in this template, 
this button is automatically in effect as release button of the screen.  

Locked operator controls can only be operated in runtime if the operator presses one of the 
configured release buttons at the same time.  
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Restrictions in Sm@rtServer/Client mode

Multi-touch server and single-touch client
The single-touch client device does not support operation by touch with two or more fingers 
as well as multi-touch functions. Single-touch client cannot be operated with gestures of the 
multi-touch Sm@rtServer. 

Single-touch gestures work the same way as in WinCC V12.  

Single-touch server and multi-touch client
The single-touch server device does not support operation by touch with two or more fingers 
as well as multi-touch functions. Multi-touch client cannot be operated with gestures of the 
single-touch Sm@rtServer. 

Single-touch gestures work the same way as in WinCC V12.  

2.3.10 Add-ons

2.3.10.1 DataMonitor

Contents
Information that could no longer be included in the online help and important information about 
product features.

Approved versions of Microsoft Office
The following 32-bit versions of Microsoft Office are approved for use of "Excel Workbook": 

● Office 2007 SP2

● Office 2010 SP1

● Office 2013

Use of the 64-bit version of Office is not approved.

Removal of WinCC Runtime
If you also want to use DataMonitor after removing WinCC Runtime Professional, you have to 
perform a repair of the installation as follows:

1. Open the Control Panel.

2. Double-click on "Add/Remove Programs".

3. Select "SIMATIC WinCC/DataMonitor client" in the list of programs installed
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4. Click on the "Change/Remove" button.

5. Select the setting "Repair" in the WinCC DataMonitor setup".

Excel Workbook and Excel Reports
The regional settings of the operating system must match the installed Office language for 
operation of Excel Workbook and Excel Reports. You may also have to adapt the system 
account settings.

To configure the regional and language settings for system accounts in Windows 7 and 
Windows 2008(R2), select the "Regions and Language > Administration" dialog in the Control 
Panel.

Opening Excel workbooks on a computer not connected to the internet
If you want to used the DataMonitor client on a computer not connected to the internet, you 
must disable certificate checking. To do this, follow these steps:

1. Open Internet Explorer.

2. Select the "Internet options" command from the "Tools" menu.

3. Click "Advanced".

4. In the field "Security" disable the setting "Check for publisher's certificate revocation".

Opening Excel workbooks with Excel 2010/Excel 2013
Due to safety settings, the automatic connection of an Excel workbook with the server does 
not work in Excel 2010 and Excel 2013.

If you wish to enable automatic connection, disable the "Enable protected view for files 
originating from the internet" and "Enable Protected View for files located in potential unsafe 
locations" settings in Excel 2010/Excel 2013 under "Files > Options > Trust Center > 
ProtectedView".

Name of the user groups
The name of the user groups differs at certain locations of the Online Help from the actually 
created user groups. The following assignment is valid:

SIMATIC Report Administrators corresponds to DM_Admin

SIMATIC Report Users corresponds to DM_User

Connecting archives
If you have connected archives by means of the WinCC objects ""f(x) trend view", f(t) trend 
view", "table view" or "alarm view", you can no longer connect these archives with the 
DataMonitor.

If you have connected archives with the DataMonitor, you can no longer connect these archives 
by means of the WinCC objects ""f(x) trend view", f(t) trend view", "table view" or "alarm view".
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Excel-Workbook on a PC with Windows 7
If you operate Excel-Workbook on a PC with Windows 7, you need to disable the "Aero Glass" 
display mode.

Importing configuration data
If you load a project to a device via an external data medium, DataMonitor cannot export a 
correct XML file on this device. 

The exported XML file can then no longer be used for importing configuration data.

Reports in DataMonitor
If the PC with WinCC Runtime Professional performs a restart and then switches back to 
service mode without Windows login, the following print jobs and Excel workbooks are no 
longer output:

● Cyclically controlled print jobs and Excel workbooks

● Event-controlled print jobs and Excel workbooks

Remedy:

1. Open the "Reports" area in DataMonitor.

2. Click the "Print jobs" or "Excel Workbooks" tab.

The cyclically and event-controlled print jobs and Excel workbooks are executed again after 
this selection.

2.3.10.2 WebNavigator

Contents
Information that could no longer be included in the online help and important information about 
product features.

Removal of WinCC Runtime
If you also want to use WebNavigator after removing WinCC Runtime Professional, you have 
to perform a repair of the installation as follows:

1. Open the Control Panel.

2. Double-click on "Add/Remove Programs".

3. Select "SIMATIC WinCC/WebNavigator client" in the list of programs installed

4. Click on the "Change/Remove" button.

5. Select the setting "Repair" in the WinCC/WebNavigator setup".
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Access via Web client
A user can only get access via a Web client if a screen released for Web access has been 
assigned to him as the start screen in the user administration.

To release a screen for Web access:

1. Select the "Properties" command in the shortcut menu of a screen.

2. Enable the "Web access" option under "Properties > Web access".

To assign a start screen to a user:

1. In the user administration, select the user to whom you would like to assign a start screen.

2. Click "Properties > General" > Web options > Settings in the Inspector window to specify 
a start screen. You can only select screens which have been released for Web access.

Virus scanner Trend Micro OfficeScan
It is not recommended to use the virus scanner of Trend Micro OfficeScan in combination with 
WebNavigator, as this virus scanner may have an adverse impact on screen loading times.

PLC code display and S7 GRAPH overview
Screen objects “PLC code display” and"S7-GRAPH overview” are not supported by the WinCC 
Web Navigator option

Time zone of Web parts
When you create and configure a Web part in a specific time zone in the Web center, the time 
zone is stored in the Web center. 

If the time zone is changed in the operating system, this can lead to an incorrect display of the 
time in the Web part. 

2.3.10.3 Redundancy

Contents
Information that could no longer be included in the online help and important information about 
product features.

Tag synchronization in WinCC V13
The "Online synchronization of internal tags (tag synchronization)" function that could be set 
in WinCC V7 with the tag properties is not supported in WinCC V13. This function is not 
available in projects that you have migrated from WinCC V7 to WinCC V13.
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Installation 3
3.1 Notes on the installation

Contents
Information that could not be included in the online help and important information about 
product characteristics.

Automated Installation
A description of automated installation is available on the product DVD in the directory 
"Documents\Readme\<Language directory>".

Using the same versions of TIA Portal products
The TIA Portal products STEP 7 (incl. PLCSIM), WinCC and Startdrive must be upgraded to 
the same version (V13). If the versions are different, you will no longer be able to start the TIA 
Portal. Even uninstalling a product will not restore an operational status. Please ensure that 
you have the service packs for these products to hand before you start the installation. You 
can download the service packs from the Internet under Siemens Industry online support (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=99&lang=en&referer=%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002).

Target directory of the installation
Do not use any UNICODE characters (for example, Chinese characters) in the installation path.

Use of antivirus programs
During the installation, read and write access to already installed files is necessary. Some 
antivirus programs block this access. We therefore recommend that you disable antivirus 
programs during the installation of the TIA Portal and enable them again afterwards.
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3.2 System requirements for installation

3.2.1 Notes on licenses

Availability of licenses     
The licenses for the products of the TIA Portal are usually supplied on the installation data 
medium and installed automatically by the Automation Licence Manager  during the installation 
process of the TIA Portal. 

Before you uninstall the TIA Portal, you must transfer and back up the licenses still required. 
Use the Automation License Manager for this purpose. 

Provision of the Automation License Manager
The Automation License Manager  is supplied on the installation data medium and is 
transferred automatically during the installation process. 

If you remove the TIA Portal, the Automation License Manager  remains installed on your 
system.

Working with the Automation License Manager
The Automation License Manager is a product of Siemens AG, which is used for handling 
license keys (technical representatives of licenses). 

Software products that require license keys for operation, such as the TIA-Portal, register the 
required license key automatically with the Automation License Manager . If the Automation 
License Manager finds a valid license key for this software, the software can be used according 
to the license usage terms associated with this license key.

 
 

 Note

For additional information on how to manage your licenses with the Automation License 
Manager , refer to the documentation supplied with the Automation License Manager .

 

See also
Notes on the system requirements (Page 105)

Starting installation (Page 129)

Displaying the installed software (Page 133)

Modifying or updating installed products (Page 133)

Repairing installed products (Page 135)
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Starting to uninstall (Page 136)

Installation log (Page 128)

3.2.2 Notes on the system requirements

System requirements for individual products  
The system requirements may differ depending on the products you want to install. You should 
therefore check the individual system requirements of your products.

If you want to install several products, make sure that your system meets the demands of the 
product with the highest requirements.

Displaying PDF files
To be able to read the supplied PDF files, you require a PDF reader that is compatible with 
PDF 1.7 e.g. Adobe (R) Reader version 9.

Displaying the Welcome Tour
You require the Adobe (R) Reader as of version 9 to start the Welcome Tour for the TIA portal.

 

See also
Notes on licenses (Page 104)

Starting installation (Page 129)

Displaying the installed software (Page 133)

Modifying or updating installed products (Page 133)

Repairing installed products (Page 135)

Starting to uninstall (Page 136)
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3.2.3 System requirements STEP 7 Basic

3.2.3.1 Licensing of STEP 7

Introduction
You require a  License Key to license the following STEP 7 editions:

● STEP 7 Basic

● STEP 7 Professional

You can install the corresponding  License Key when you are installing STEP 7 or transfer it 
using the Automation License Manager after the installation has been completed.

Licenses for STEP 7
The following licenses with the corresponding license keys are available:

● STEP 7 Basic

● STEP 7 Professional

● STEP 7 Professional Combo
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Validity of license keys for older versions of STEP 7
With a valid License Key for V13.x of STEP 7 Professional and STEP 7 Professional Combo, 
you can also operate older versions of STEP 7 without restrictions. The following table provides 
more detailed information about this: 

Edition License Valid for
STEP 7 Basic V13.x STEP 7 Basic ● STEP 7 Basic V13.x

● STEP 7 Basic V12.x
● STEP 7 Basic V11.x
● STEP 7 Basic V10.5

STEP 7 Professional 
V13.x

STEP 7 Professional ● STEP 7 Professional V13.x
● STEP 7 Professional V12.x
● STEP 7 Professional V11.x
● STEP 7 Basic V13.x
● STEP 7 Basic V12.x
● STEP 7 Basic V11.x
● STEP 7 Basic V10.5

STEP 7 Professional 
V13.x

STEP 7 Professional Combo ● STEP 7 Professional V13.x
● STEP 7 Professional V12.x
● STEP 7 Professional V11.x
● STEP 7 Basic V13.x
● STEP 7 Basic V12.x
● STEP 7 Basic V11.x
● STEP 7 Basic V10.5
● STEP 7 V5.5
● STEP 7 V5.4
● STEP 7 Professional 2010
● STEP 7 Professional 2006

 

Starting without a valid license key     
If you start an edition of STEP 7 without a valid License Key , the system alerts you that you 
are working in non-licensed mode. You have the one-time option of activating a Trial License. 
However, this license is valid for a limited period only and expires after 21 days.

When the Trial License expires, the following scenarios can occur:

● STEP 7 has never been licensed on the PC in question:

– Operations requiring a license can no longer be performed in STEP 7.

● STEP 7 was already licensed on the PC in question:

– A window requiring acknowledgment presents an alert for non-licensed mode every 10 
minutes and for every action requiring a license.
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License requirements for simulation
You do not require additional licenses when you use the menu command "Online > Simulation" 
to start the simulation in STEP 7. 

If the following conditions are met, the appropriate licenses for the edition of STEP 7 you have 
installed are also required for the simulation.

● The engineering station is connected to a PLC.

● The connection to the PLC is configured and active.

See also
Handling licenses and license keys (Page 108)

3.2.3.2 Handling licenses and license keys

Introduction
In each case, you require a valid License Key to use STEP 7 Basic and STEP 7 Professional.

Installing license keys   
When you install STEP 7 Basic, the License Key is installed automatically during setup. When 
you install STEP 7 Professional you will be prompted at the end of the setup to transfer the 
license from the supplied storage medium to your PC.

If you want to install additional License Keys, you have to use the Automation License Manager 
to do this.

When you install a license, the associated license key is removed from the license key storage 
location.

 

 NOTICE

Destruction of license keys by copying   

It is not possible to copy a License Key. The copy protection prevents the license keys from 
being copied. If you attempt to copy a License Key this will be destroyed.

 

 

Uninstalling license keys   
License keys are always uninstalled using the Automation License Manager. You uninstall a 
License Key in the following cases:

● When backing up data.

● If you no longer require the license.

You can then use a valid license on another PC or HMI device.     
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Data backup
When backing up data on the HMI device or creating a backup during device replacement, 
remove the License Keys on the HMI device. To do this, open the Automation License Manager 
and back up the uninstalled license key to another storage location.

 

 NOTICE

Destruction of license keys on PCs

Start by removing all license keys in the following situations:
● Before you format the hard disk.
● Before you compress the hard disk.
● Before you restore the hard disk.
● Before you start an optimization program that moves fixed blocks.
● Before you install a new operating system.

Read the description of Automation License Manager ("Start > Siemens Automation > 
Documentation"). Observe all warnings and notices.

 

On PC-based HMI devices and on non-PC-based HMI devices where Automation License 
Manager is used, the license key storage location may contain multiple license keys. This 
capability means you can store multiple licenses of the same type at one location. Save all 
license keys of an HMI device to the same storage location.

 

 NOTICE

Always keep the original storage location of the license keys.
 

Invalid license after time zone change   
The installed license no longer functions in the following case.

● If you change the time zone on a PC as follows:
From a time based on a complete hour to a time not based on a complete hour.
Example: You change the time zone from GMT +3:00 to GMT +3:30.

To avoid this inconvenience, uninstall the license key using the Automation License Manager 
under the time zone setting that was set when the license key was installed.

This behavior does not apply to the Trial License.

Defective license       
A license is defective in the following cases:

● If the license key is no longer accessible at the storage location.

● If the license key disappears during its transfer to the destination drive.

You can use the Automation License Manager to repair the defective license. To do this, use 
the "Restore" function or the "Restore wizard" of the Automation License Manager. To perform 
this restore operation you must contact Customer Support. 
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You can find more detailed information on the Internet: http://support.automation.siemens.com 
(http://support.automation.siemens.com/WW/llisapi.dll?aktprim=99&lang=en&referer=
%2fWW
%2f&func=cslib.csinfo2&siteid=csius&extranet=standard&viewreg=WW&groupid=4000002) 

See also
Licensing of STEP 7 (Page 106)

3.2.3.3 Software and hardware requirements STEP 7

System requirements for installation
The following table shows the minimum software and hardware requirements for installation 
of the "SIMATIC STEP 7 Basic" software package:

Hardware/software Requirement
Processor Intel® Celeron® Dual Core 2.2 GHz (Ivy/Sandy Bridge)
RAM 4 GB 
Available hard disk space 5 GB
Operating systems * Windows 7 (32-bit)

● Windows 7 Home Premium SP1
● Windows 7 Professional SP1
● Windows 7 Enterprise SP1
● Windows 7 Ultimate SP1
Windows 7 (64-bit)
● Windows 7 Home Premium SP1
● Windows 7 Professional SP1
● Windows 7 Enterprise SP1
● Windows 7 Ultimate SP1
Windows 8.1 (64-bit)
● Windows 8.1
● Windows 8.1 Professional
● Windows 8.1 Enterprise
Windows Server (64-bit)
● Windows Server 2012 R2 StdE (full installation)

Screen resolution 1024 x 768

* For more detailed information on operating systems, refer to the help on Microsoft Windows 
or the Microsoft homepage. 
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Recommended software and hardware requirements
The following table shows the recommended software and hardware for the operation of STEP 
7.

Hardware/software Requirement
Computer From SIMATIC FIELD PG M4 PREMIUM (or similar PC)
Processor From Intel® Core™ i5-3320M 3.3 GHz
RAM 8 GB or more
Hard disk 300 GB SSD
Monitor 15.6" Wide Screen Display (1920 x 1080)
Operating systems * Windows 7 (64-bit)

● Windows 7 Home Premium SP1
● Windows 7 Professional SP1
● Windows 7 Enterprise SP1
● Windows 7 Ultimate SP1
Windows 8.1 (64-bit)
● Windows 8.1
● Windows 8.1 Professional
● Windows 8.1 Enterprise
Windows Server (64-bit)
● Windows Server 2012 R2 StdE (full installation)

* For more detailed information on operating systems, refer to the help on Microsoft Windows 
or the Microsoft homepage

Supported virtualization platforms
You can install the "SIMATIC STEP 7 Basic" software package on a virtual machine. For this 
purpose, use one of the following virtualization platforms in the specified version or a newer 
version:

● VMware vSphere Hypervisor (ESXi) 5.5

● VMware Workstation 10

● VMware Player 6.0

● Microsoft Windows Server 2012 R2 Hyper-V

These virtualization platforms can use the following operating systems as host operating 
system:

● Windows 7 Professional/Ultimate/Enterprise (64-bit)

● Windows Server 2008 R2 (64-bit)

● Windows Server 2012 R2 (64-bit)

● Windows 8.1 Professional/Enterprise (64-bit)

You can use the following host operating systems to install "SIMATIC STEP 7 Basic" within 
the selected virtualization platform:
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● Windows 7 Professional/Ultimate/Enterprise (64-bit)

● Windows 8.1 Professional/Enterprise (64-bit)
 

 Note
● The same hardware requirements apply to the host operating system as for the respective 

TIA products. 
● The plant operator must ensure that sufficient system resources are available for the host 

operating systems.
● The hardware certified by the manufacturers is recommended for the use of HyperV server 

and ESXi.
● When you use Microsoft Hyper-V, accessible stations cannot be displayed.

 

Supported security programs
The following security programs are compatible with "SIMATIC STEP 7 Basic":

● Antivirus programs:

– Symantec Endpoint Protection 12.1 

– Trend Micro Office Scan Corporate Edition 10.6 

– McAfee VirusScan Enterprise 8.8

– Kaspersky Anti-Virus 2014

– Windows Defender (as of Windows 8.1)

● Encryption software:

– Microsoft Bitlocker

● Host-based Intrusion Detection System:

– McAfee Application Control 6.0
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3.2.4 WinCC Professional system requirements

3.2.4.1 Software and hardware requirements

Introduction
Specific requirements for the operating system and software configuration must be met for the 
installation.

 

 Note

WinCC is generally authorized for use in a domain or workgroup.

However, be aware that domain group policies and restrictions of the domain may hinder the 
installation. In this happens, remove the computer from the domain prior to installing Microsoft 
Message Queuing, Microsoft SQL Server and WinCC. Log onto the computer in question 
locally with administrative rights. Then perform the installation. After successful installation, 
you can enter the WinCC computer back into the domain. If the domain group policies and 
restrictions of the domain do not impede the installation, the computer need not be removed 
from the domain during the installation.

Be aware that domain group policies and restrictions of the domain may also hinder operation. 
If you cannot avoid these restrictions, run the WinCC computer in a workgroup.

Consult with the domain administrator if needed.
 

Installation requirements
The following table shows the minimum software and hardware requirements that have to be 
met for installation of the "SIMATIC WinCC Professional" software package:   

Hardware/software Requirement
Processor type Intel® Celeron® Dual Core 2.2 GHz (Ivy/Sandy Bridge)
RAM 4 GB
Free hard disk space 5 GB
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Hardware/software Requirement
Operating systems * Windows 7 (32 bit)

● Windows 7 Professional SP1
● Windows 7 Enterprise SP1
● Windows 7 Ultimate SP1
Windows 7 (64 bit)
● Windows 7 Professional SP1
● Windows 7 Enterprise SP1
● Windows 7 Ultimate SP1
Windows 8 (64 bit)
● Windows 8.1 Professional
● Windows 8.1 Enterprise
Windows Server (64 bit)
● Windows Server 2008 R2 Standard Edition SP1
● Windows Server 2012 R2 Standard Edition

Screen resolution 1024x768
Network Ethernet 10 Mbps or faster
Optical drive DVD-ROM
Software Microsoft .Net Framework 3.5 SP1

Microsoft .Net Framework 4.5

* For additional information on the operating systems, refer to the Microsoft Windows help or 
the Microsoft homepage. 

Simultaneously opening multiple instances of WinCC on a configuration PC can also increase 
the hardware capacity required.

 

 Note
"Aero Glass Style" of Microsoft Windows 7

A powerful graphics card is required for "Aero Glass Style". It requires DirectX9 capabilities 
and 128 MB of dedicated graphics memory.

The performance of the architecture of the graphics system can significantly influence the 
performance of WinCC.

 

Recommended hardware
The following table shows the recommended hardware for the operation of SIMATIC WinCC.

Hardware Requirement
Computer SIMATIC FIELD PG M4 PREMIUM or higher (or comparable PC)
Processor Intel® Core™ i5-3320M 3.3 GHz or higher
RAM 8 GB or more
Hard disk 300 GB SSD
Monitor 15.6" Wide Screen Display (1920 X 1080)
Optical drive DL MULTISTANDARD DVD RW
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Supported virtualization platforms
You can install the "SIMATIC WinCC Professional" software package on a virtual machine. To 
do this, use one of the following virtualization platforms:

● VMware vSphere Hypervisor (ESXi) 5.5

● VMware Workstation 10

● VMware Player 6.0

● Microsoft Windows Server 2012 R2 Hyper-V

The following operating systems can serve as a host operating system for these virtualization 
platforms:

● Windows 7 Professional/Ultimate/Enterprise (64-bit)

● Windows Server 2008 R2 (64-bit)

● Windows Server 2012 R2 (64-bit)

● Windows 8.1 Professional/Enterprise (64-bit)

You can use the following guest operating systems to install "SIMATIC WinCC Professional" 
on the selected virtualization platform:

● Windows 7 Professional/Ultimate/Enterprise (64-bit)

● Windows 8.1 Professional/Enterprise (64-bit)
 

 Note
● The same hardware requirements apply to the guest operating system as to the respective 

TIA products. 
● The plant operator must provide sufficient system resources for the guest operating 

systems.
● The hardware certified by the manufacturers is recommended for the use of HyperV server 

and ESXi.
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Supported security programs
The following security programs are compatible with "SIMATIC WinCC Professional":

● Virus scanners:

– Symantec Endpoint Protection 12.1 

– Trend Micro Office Scan Corporate Edition 10.6 

– McAfee VirusScan Enterprise 8.8

– Kaspersky Anti-Virus 2014

– Windows Defender (Windows 8.1 and higher)

● Encryption software:

– Microsoft Bitlocker

● Host-based Intrusion Detection System:

– McAfee Application Control 6.0

Installing Microsoft .Net Framework
The software requires .Net Framework 3.5 SP1 and 4.5; it is automatically installed and 
activated for Windows 7. Automatic activation of the .Net Framework 3.5 SP1 is not possible 
for Windows 8.1. Request this to be performed by your administrator.

You will be prompted to install the required .Net Framework version if this cannot be performed 
by the software package installation. After installing .Net Framework 4.5, you may have to 
reboot.

Online help for Windows 7 / Windows Server 2008
Windows 7 and Windows Server 2008 no longer support all online help formats by default. 
These online help formats are used in WinCC in the following scenarios:

● Call-up of WinCC Direct Help

● Call-up of the WinCC Information System from the WinCC editors or via the Direct Help 
links

Calling the Direct Help
In order to still call WinCC Direct Help, the following component is installed during the 
installation of WinCC:

● Microsoft Help Engine

Calling the "WinCC Information System" online help
You can also call the WinCC Information System in Windows 7 and Windows Server 2008 
from the Windows Start menu or from the installation folder.

To call the WinCC Information System from the WinCC editors or via the Direct Help links, 
some changes have to be made to the operating system. You can find more information on 
this in the section "More information for advanced users" of Microsoft Support article "917607": 
http://support.microsoft.com/kb/917607 (http://support.microsoft.com/kb/917607) 
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Security settings during installation
When you install WinCC V13, security settings are changed in your operating system. 

The security settings in question are listed during the installation. 

You must confirm the changes to the security settings.

If you make changes to your operating system after the installation, the changes to the security 
settings made by the installation of the TIA Portal could be changed. 

You can restore the changes to the security settings made by the installation of the TIA Portal: 
"Start > All Programs > Siemens Automation > Security Controller > Restore settings".

SQL instance of WinCC V13
If you have installed a WinCC V11 product and you wish to install WinCC V13, you must 
uninstall the WinCC instance of SQL Server 2005 before the installation.

A new WinCC SQL 2008 instance is installed with the installation of WinCC V13.

See also
Options for WinCC Engineering and Runtime systems (Page 118)

Licensing of WinCC Engineering System (Page 121)

3.2.4.2 Parallel installation

Parallel installations in TIA Portal V13
You will be prevented from starting the TIA Portal if you perform a non-permitted parallel 
installation of STEP 7 and WinCC. The following parallel installations are permitted in the TIA 
portal:

● STEP 7 V13 and WinCC V13

 

A dialog opens during installation to inform you of any inconsistencies in your parallel 
installation. The following parallel installations are permitted:

● WinCC V13 and RT Advanced V13

● WinCC V13 and RT Professional V13

The engineering system and Runtime must always be of the same version after an installation.

Parallel installation of WinCC V13 and other SIMATIC HMI products
Parallel installation of WinCC V13 and versions of WinCC flexible earlier than WinCC flexible 
2008 SP1 is not allowed.

Parallel installation of WinCC V13 with versions of WinCC earlier than WinCC V7.0 SP2 is not 
allowed. Parallel installation of WinCC V13 with WinCC V7.0 SP2 or WinCC V7.0 SP3 is only 
allowed for:
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● WinCC V 13 Professional

● WinCC V 13 Professional

Parallel use
If the term "Combo" appears in the name or license key of the software after installation, the 
use of the following products/versions is permitted in accordance with paragraph 1.6 of the 
General Terms and Conditions (see also setup text):

● With license for "WinCC V13 Comfort Combo": WinCC flexible 2008 Standard

● With license for "WinCC V13 Advanced Combo": WinCC flexible 2008 Advanced

3.2.4.3 Add-ons

Options for WinCC Engineering and Runtime systems
SIMATIC Panels as well as WinCC Runtime Advanced and WinCC Runtime Professional 
contain all essential functions for operator control and monitoring of machines or plants. 
Additional add-ons allow you to extend the functionality in some cases to increase the range 
of available tasks.

Add-ons for Comfort Panels, Mobile Panels, Multi Panels
The following add-ons are available for Comfort Panels, Mobile Panels, and Multi Panels:

● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail and electronic signature for regulated applications)
 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess add-ons as well as the WinCC flexible /OPC Server add-
on are incorporated into the basic functionality.

 

Add-ons for WinCC Runtime Advanced
The following add-ons are available for WinCC Runtime Advanced:

● WinCC Recipes (recipe system)

● WinCC Logging (logging of process values and alarms)
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● WinCC SmartServer (remote operation)

● WinCC Audit (audit trail for regulated applications)
 

  Note

For use of the WinCC SmartServer and WinCC Audit add-ons, one license each is 
required.

 

  Note

In contrast to WinCC flexible 2008, functions from the WinCC flexible /Sm@rtService, 
WinCC flexible /Sm@rtAccess add-ons as well as the WinCC flexible /OPC Server add-
on are incorporated into the basic functionality.

 

Add-ons for WinCC Runtime Professional
WinCC Runtime Professional contains the following components, which you can activate with 
a corresponding license:

● WinCC Server (supplements WinCC Runtime to include server functionality)

● WinCC Recipes (recipe system, formerly WinCC /UserArchives)

● WinCC Logging (logging system, previously WinCC/TagLogging)

You can select and install the following add-ons in the installation dialog:

● WinCC Client (standard client for building multiple-station systems)

● WinCC WebNavigator (Web-based operator control and monitoring)

● WinCC DataMonitor (display and evaluation of process states and historical data)
 

  Note

To use the add-ons, one license each is required.
 

  Note

In contrast to WinCC V7, functions from the WinCC / OPC Server add-on have been 
incorporated into the basic functionality. Likewise, the basic functionality includes the 
Runtime API from WinCC /ODK.

 

In addition to the Runtime add-ons, you can also expand WinCC Runtime Professional with 
customized controls. The WinCC ControlDevelopment add-on is required to develop controls.

See also
Software and hardware requirements (Page 113)

Installing and uninstalling options (Page 120)
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Installing and uninstalling options

Introduction
Some add-ons are included in standard WinCC installation and are installed automatically.

During the installation of WinCC Engineering System, the following add-ons are available for 
you to select for installation:

● Simulation for WinCC Runtime Advanced

● Simulation for WinCC Runtime Professional

During the installation of WinCC Runtime Professional, the following add-ons are available for 
you to select for installation:

● SIMATIC WinCC Web Navigator

● SIMATIC WinCC Data Monitor

● SIMATIC Logon

You must enable all the necessary add-ons for use.
 

 Note

Each add-on requires a license. You activate an add-on by installing the appropriate license 
key.

 

Add-ons for non-PC-based HMI devices
The required Runtime add-ons are installed on the HMI device as follows:       

● During the transfer of the project to the HMI device
Add-ons that are no longer required are removed automatically.

● With ProSave

Procedure - activating add-ons
To activate an add-on for use, install the appropriate license key using the Automation License 
Manager.

In order to backup the license key of an add-on or use it on a different configuration PC or HMI 
device, you must uninstall this license key using the Automation License Manager.

 

 Note

When no valid license key is installed on a PC with WinCC Runtime, Runtime runs in Demo 
mode.

 

See also
Options for WinCC Engineering and Runtime systems (Page 118)
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3.2.4.4 Licenses and Powerpacks

Licensing of WinCC Engineering System
You require a license key for the following:

● WinCC Engineering System, for example, WinCC Professional

● Add-ons for WinCC Engineering System

You can transfer the license key for WinCC simultaneously with the WinCC installation. You 
transfer licenses for the WinCC add-ons after installation with the Automation License Manager.

Starting without a valid license key 
If you start WinCC without a valid license, the system alerts you that you are working in non-
licensed mode. You have the one-time option of activating a trial license. The trial license for 
Engineering editions WinCC Basic, Comfort/Advanced, and Professional expires after 21 days.

When the trial license has expired, the following scenarios may occur:

● WinCC was never licensed on the PC in question.

– Operations requiring a license can no longer be performed in WinCC.

● WinCC was already licensed on the PC in question.

– Non-licensed mode is indicated every 10 minutes and at every action requiring a license 
by a window, which you must acknowledge.

License requirements for simulation
When you want to start simulation in WinCC using the "Online > Simulation> With tag simulator" 
menu command, you do not need licenses for WinCC Runtime or for add-ons that require a 
license.

If the following conditions are met, you will need the appropriate licenses for WinCC Runtime 
and add-ons that require a license even for simulation:

● The engineering station is connected to a PLC.

● The connection to the PLC is configured and active.

● You start the simulation with the "Online > Simulation > Start" menu command.

See also
Software and hardware requirements (Page 113)

Licensing WinCC Runtime on PC-based HMI devices (Page 122)

Licensing of HMI devices (Page 122)

Working with license keys (Page 123)

Licensing WinCC Runtime Professional Asian (Page 126)
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Powerpack (Page 127)

Installing a Powerpack (Page 127)

Licensing WinCC Runtime on PC-based HMI devices
With PC-based HMI devices, you require a license key for the following:

● WinCC Runtime with 128 tags, for example.

● WinCC add-ons

You can install the license key for WinCC Runtime during the installation of WinCC. You 
transfer licenses for the WinCC add-ons after installation with the Automation License Manager.

 

 Note

Only the Certificate of License for WinCC Runtime V13 authorizes operation of WinCC 
Runtime V13.

 

The appropriate new license is required to license WinCC Runtime.

You can upgrade the runtime licenses of WinCC flexible 2008 and WinCC V7 with an upgrade 
to WinCC Runtime V13.

Productive operation of the software is only allowed with a valid Certificate of License that 
matches the version listed on it.

Non-licensed mode   
WinCC Runtime and the Runtime add-ons can be used freely without license. Non-licensed 
mode is indicated every 10 minutes by a window, which you must acknowledge.

 

See also
Licensing of WinCC Engineering System (Page 121)

Licensing of HMI devices
Non-PC-based HMI devices are equipped with Runtime licenses. A license key is not required 
for runtime operation.     

A license may be required for an add-on for non-PC-based HMI devices. The license key of 
the respective license always activates one add-on for use.

License key
In order to license non-PC-based HMI devices with license keys, the 
"SIMATIC HMI License Manager Panel Plugin" add-on is needed.   
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WinCC Setup installs this add-on by default. You open the License Manager Panel Plugin in 
the Automation License Manager with the "Edit > Connect Target System > Connect HMI 
Device" menu command.

If WinCC is not installed, an installation of ProSave 7.2 or higher is required.
 

 Note

Further information on license handling can be found in the Automation License Manager 
help.

 

 Note

Verify that the current version of the operating system (or higher) is installed on the HMI 
device before you start licensing. If necessary, update the operating system using ProSave.

 

Non-licensed mode   
Runtime add-ons can be used for a short time without restrictions without a valid license. Non-
licensed mode is indicated every 10 minutes by a window, which you must acknowledge.

See also
Licensing of WinCC Engineering System (Page 121)

Working with license keys

Introduction
You transfer a license key to the HMI device in the following cases:

● To use the WinCC engineering system

● To operate WinCC Runtime

● To use add-ons for WinCC Runtime on PC-based HMI devices

● To use add-ons on non-PC-based HMI devices

You transfer a license key from the HMI device in the following cases:

● When backing up data

● If you no longer require the license

You can then use this license on another PC or HMI device.   
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When you transfer a license to an HMI device, the associated license key is removed from the 
license key storage location.

 

 Note

A license key cannot be copied. The copy protection employed prevents the license keys 
from being copied.

 

Data backup
You transfer the license keys from the HMI device for data backup on the HMI device or as a 
backup for device replacement. 

You use the Automation License Manager to back up license keys from an HMI device to the 
storage area of the license keys.  

 

 NOTICE

Destruction of license keys on non-PC-based HMI devices

License keys transferred as a result of backup/restore operations are destroyed in the case 
of the following HMI devices: 
● 270 series
● 370 series

Carry out the following before beginning restoring:
● Use the Automation License Manager and ProSave to check whether license keys are on 

the HMI device.
● Transfer the license keys present from the HMI device

After restoring has been carried out, transfer the license keys back to the HMI device.
 

 NOTICE

Destruction of license keys on PCs

Transfer all license keys to a storage location in the following cases:
● Before you format the hard disk
● Before you compress the hard disk
● Before you restore the hard disk
● Starting an optimization program that moves fixed blocks
● Installing a new operating system

Read the description of Automation License Manager ("Start > Simatic Automation > 
Documentation"). Observe all warnings and notices.

 

The license key storage location on PC-based HMI devices and on non-PC-based HMI devices 
where Automation License Manager is used may contain multiple license keys. This capability 
means you can store multiple licenses of the same type at one location. For the backup, use 
a single storage location for all license keys present on an HMI device.
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Invalid license after time zone change   
The transferred license no longer functions in the following case.

● If you change the time zone on a WinCC PC as follows:

– From a time based on a complete hour to a time not based on a complete hour.
Example: You change the time zone from GMT +3:00 to GMT +3:30.

To work around this, transfer the license key from the HMI device with a time zone setting that 
was set when the license key was transferred to the HMI device.

Example: 

You transferred the license key to the HMI device with a time zone setting based on a full hour. 
Then, also transfer the license key from the HMI device with a time zone setting based on a 
full hour.

This behavior does not apply to the trial license.

Defective license     
A license is defective in the following cases:

● If the license key is no longer accessible at the storage area.

● If the license key disappears during its transfer to the destination drive.
 

 Note

Resetting of the system date to an earlier time causes all licenses to be become defective. 
 

You can use the Automation License Manager to repair the defective license. Use the "Restore" 
function or the "Restore Wizard" of the Automation License Manager for this purpose. You 
must contact Customer Support in order to restore the license. For additional information see: 
http://support.automation.siemens.com (http://support.automation.siemens.com)  

 

 Note

The Runtime software can also be operated without errors if the license is missing or 
defective. The system alerts you at brief intervals that you are working in non-licensed mode.

 

 Note

If you start the WinCC Engineering System without a valid license key, the system alerts you 
that you are working in non-licensed mode. You have the one-time option of activating a trial 
license. The trial license expires after 21 days.

When the trial license has expired, the following scenarios may occur:
● WinCC was never licensed on the PC in question.

WinCC can no longer be started.
● WinCC was already licensed on the PC in question.

WinCC can be started. Non-licensed mode is indicated every 10 minutes by a window, 
which you must acknowledge.
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See also
Licensing of WinCC Engineering System (Page 121)

Licensing WinCC Runtime Professional Asian

Introduction       
If you are using WinCC Runtime Professional in an Asian language, a dongle is additionally 
used for the validation of the required license. The dongle comes in the form of a certified USB 
stick together with the required license key for WinCC Runtime Professional Asian. The license 
key is stored on the certified USB flash drive. 

The following Asian languages are protected by a dongle:

● Chinese Simplified

● Chinese Traditional

● Japanese

● Korean

Using the dongle for an Asian Runtime Professional
In order to successfully license a WinCC project in an Asian language, transfer the required 
license key from the certified USB stick to the HMI device using the "Automation License 
Manager". Plug the USB into the USB port of the HMI device. The USB stick acts as a dongle 
during runtime. The dongle must always remain plugged in the USB port in during runtime.

If you remove the dongle during runtime, WinCC Runtime switch to Demo mode.

The USB sticks supplied for the Asian markets are certified for permanent use in production. 
Therefore, you cannot transfer or copy the content to another disk or USB medium. If you lose 
the certified USB stick or it becomes defective, you need a new, certified USB stick.

Simulation of a WinCC project in an Asian language
You then also need a certified USB stick as dongle for the simulation. If no dongle is available, 
the simulation runs in Demo mode.

See also
Licensing of WinCC Engineering System (Page 121)
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Powerpack

Introduction   
The following upgrades are possible with a Powerpack:

● From a smaller to a larger edition of WinCC

● To a runtime system with a larger tag volume

A Powerpack also includes a special license that you can use at any time to activate a higher 
level of WinCC for use.

Engineering system   
You own WinCC Advanced, for example. You use the "SIMATIC WinCC Professional 
Powerpack WinCC Advanced -> WinCC Professional PowerTags V13" Powerpack to activate 
WinCC Professional with 512 tags for use. 

Runtime   
You have WinCC Runtime Professional with 128 tags, for example. You use the "SIMATIC 
WinCC Runtime Professional Powerpack 128 PowerTags -> 512 PowerTags V13" Powerpack 
to increase the tag volume from 128 to 512 tags. 

You have WinCC Runtime Advanced with 128 tags, for example. You use the "SIMATIC 
WinCC Runtime Professional Powerpack Runtime Advanced 128 PowerTags -> Runtime 
Professional 128 PowerTags V13" Powerpack to activate WinCC Runtime Professional with 
128 tags for use.

See also
Licensing of WinCC Engineering System (Page 121)

Installing a Powerpack

Introduction
Install a Powerpack by transferring the corresponding license key. The Powerpack license key 
replaces the license key of an existing installation.       

Requirement
● The conditions described in the "System requirements" section must be fulfilled.

● The license key for the license for which you have purchased a Powerpack is available on 
the PC.
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Installing a Powerpack
1. Transfer the purchased Powerpack license key using the Automation License Manager.

Result
The Powerpack license key replaces the former license key. You cannot reverse this process.

See also
Licensing of WinCC Engineering System (Page 121)

3.3 Installation log

Function of the installation log   
The progress during the following installation processes is logged in a file:

● Installing products

● Modifying or updating already installed products

● Repairing an existing installation

● Uninstalling products

If errors occur during the installation process or warnings are issued, these can be evaluated 
with the help of the log file. You can do this yourself or contact product support. 

Installation logs storage location
The log file is the most recent file with the file extension ".log" and the name of which that starts 
with "SIA".

The location of the log file is stored in the environment variable "%autinstlog%". You can enter 
this environment variable in the address bar of Windows Explorer to open the folder with the 
log files. Alternatively, you can navigate to the corresponding directory by entering "CD 
%autinstlog%" in the command line. 

The location depends on the operating system, e.g. "C:\Documents and Settings\All Users
\Application Data\Siemens\Automation\Logfiles\Setup" in the English version of Windows XP. 

Setup_Report (CAB file)
To make it easier to provide Product Support with all necessary files, an archive file that 
contains the installation log and all other required files is saved in CAB format. This archive 
can be found at "%autinstlog%\Reports\Setup_report.cab". Send this CAB file to Product 
Support if you need assistance with installation. With this information, Product Support can 
determine whether the installation was executed properly. CAB files that were generated 
during earlier installation processes are saved with a date ID in the "Reports" directory. 
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See also
Notes on licenses (Page 104)

Starting installation (Page 129)

Checking availability of updates and support packages and installing them (Page 131)

Displaying the installed software (Page 133)

Modifying or updating installed products (Page 133)

Repairing installed products (Page 135)

Starting to uninstall (Page 136)

3.4 Starting installation

Introduction
Software packages are installed automatically by the setup program. The setup program starts 
once the installation medium has been inserted in the drive. 

Requirement
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To install the software packages, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the product languages opens.
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6. Select the languages for the product user interface, and click the "Next" button.
 

  Note

"English" is always installed as the basic product language.
 

The dialog for selecting the product configuration opens.

7. Select the products you want to install:

– If you wish to install the program in a minimal configuration, click on the "Minimal" button.

– If you wish to install the program in a typical configuration, click on the "Typical" button.

– If you wish to personally select the products to be installed, click on the "User-defined" 
button. Then select the check boxes for the products you wish to install.

8. If you want to create a shortcut on the desktop, select the "Create desktop shortcut" check 
box.

9. Click the "Browse" button if you want to change the target directory for the installation. Note 
that the length of the installation path must not exceed 89 characters.

10.Click the "Next" button.
The dialog for the license terms opens.

11.To continue the installation, read and accept all license agreements and click "Next".
If changes to the security and permissions settings are required in order to install the TIA 
Portal, the security settings dialog opens.

12.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.
The next dialog displays an overview of the installation settings.

13.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking on "Next".

14.Click the "Install" button.
Installation is started. 

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

Following installation, you will receive a message indicating whether the installation was 
successful.

 

15.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

16.If the computer does not reboot, click "Exit".

Result
The TIA Portal along with the products and licenses you have ordered and the Automation 
License Manager have been installed on your computer. 
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See also
Installation log (Page 128)

Notes on the system requirements (Page 105)

Notes on licenses (Page 104)

Displaying the installed software (Page 133)

Modifying or updating installed products (Page 133)

Repairing installed products (Page 135)

Starting to uninstall (Page 136)

3.5 Checking availability of updates and support packages and installing 
them

In the TIA Portal, you have the option of checking whether new software updates or support 
packages are available, for example, Hardware Support Packages (HSPs). If this is the case, 
you can then install the software.

 

 Note

Updates and support packages from TIA Portal V13 or higher are supported.
 

Procedure
To check the availability of software updates and support packages and then install these, 
follow these steps:

1. Use one of the two following methods to start the installation process:

– Click "Installed software" in the "Help" menu in the TIA Portal.
The "Installed software" dialog opens.

– Open the "Siemens TIA Updater" program using the program link on your computer.
The "Siemens TIA Updater" dialog is opened and the available software packages are 
displayed.

2. Click "Check for updates". This step is optional if the "Siemens TIA Updater" dialog is 
already open.
If you started the installation procedure in the TIA Portal, the "Siemens TIA Updater" dialog 
is opened and the available updates are displayed.
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3. Click "Download" in the line of the update or support package that you want to install.
The update or support package is downloaded. The associated "Install" button becomes 
active as soon as the download process has been completed.

 

  Note
Please note the following:
1. You can initiate multiple download processes simultaneously.
2. You can log off or also shut down the computer while the download process is running. 

In such cases, the download process continues in the background as soon as you log 
on again.

 

4. Close the TIA Portal if it is still open.

5. In the "Siemens TIA Updater" dialog, click the "Install" button of the software package you 
want to install.
The installation dialog appears.

 

  Note
Please note the following:
1. It is not possible to install multiple updates simultaneously.
2. Do not log off during an installation and do not shut down the computer. This avoids 

inconsistent versions of the software on your computer.
 

6. Click "Next".
The selected product is installed.

Alternative procedures for the installation of support packages
Another procedure is available for the installation of a support package. To do this, follow these 
steps:

1. Click "Support packages" in the "Options" menu in the TIA Portal.
The "Detailed information" dialog opens. A table lists all support packages from the directory 
that you selected as the storage location for support packages in the settings.

2. If you want to install a support package that is not in the list, you have the following options:

– If the support package is already on your computer, you can add it to the list by selecting 
"Add from the file system".

– If you add a support package from the "Service & Support" page on the Internet, first 
you download it by selecting "Download from the Internet". Then you can add it from 
the file system.

3. Select the support package that you want to install.

4. Click "Install".

5. Close and then restart the TIA Portal.

See also
Installation log (Page 128)
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3.6 Displaying the installed software
You can find out which software is installed at any time. In addition, you can display more 
information on the installed software.

Procedure
To display an overview of the software installed, follow these steps:

1. Click "Installed software" in the "Help" menu.
The "Installed software" dialog opens. You will see the installed software products in the 
dialog. Expand the entries to see which version is installed in each case.

2. If you would like to display additional information on the installed automation software, click 
the link on the "Detailed information about installed software" dialog.
The "Detailed information" dialog opens.

3. Chose the topic you want more information about in the area navigation.

 

See also
Notes on the system requirements (Page 105)

Notes on licenses (Page 104)

Starting installation (Page 129)

Modifying or updating installed products (Page 133)

Repairing installed products (Page 135)

Starting to uninstall (Page 136)

Installation log (Page 128)

3.7 Modifying or updating installed products
You have the option to modify installed products using the setup program or to update to a 
new version.

Requirement 
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.
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Procedure
To modify or update installed products, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Modify/Upgrade" option button and click the "Next" button.
The dialog for selecting the product languages opens.

7. Select the check boxes of the product languages that you want to install. You can remove 
previously installed product languages by clearing the corresponding check boxes.

 

  Note

Note that the product language "English" cannot be removed.
 

8. Click the "Next" button.
The dialog for selecting the product configuration opens.

9. Select the check boxes of the components that you want to install. You can remove 
previously installed components by clearing the corresponding check boxes.

10.Click the "Next" button.
 

  Note

Note that you cannot change the target directory because the existing installation is being 
modified.

 

If changes to the security and permissions settings are required in order to install the TIA 
Portal, the security settings dialog opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.
The next dialog displays an overview of the installation settings.

12.Click the "Modify" button.
This starts the installation of the additional components. 

 

  Note

Following installation, you will receive a message indicating whether the existing 
installation was successfully changed.
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13.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

14.If the computer does not reboot, click "Exit".

Result
The existing installation has been modified on your computer. 

See also
Notes on the system requirements (Page 105)

Notes on licenses (Page 104)

Starting installation (Page 129)

Displaying the installed software (Page 133)

Repairing installed products (Page 135)

Starting to uninstall (Page 136)

Installation log (Page 128)

3.8 Repairing installed products
You have the option to repair installed products by completely reinstalling them using the setup 
program.

Requirement
● Hardware and software of the programming device or PC meet the system requirements.

● You have administrator privileges on your computer.

● All running programs are closed.

Procedure
To repair installed products, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The help file containing the notes opens.
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5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Repair" option button, and click the "Next" button.
The next dialog displays an overview of the installation settings.

7. Click the "Repair" button.
This starts the repair of the existing installation. 

 

  Note

Following installation, you will receive a message indicating whether the existing 
installation was successfully repaired.

 

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

Result
The installed products have been reinstalled. 

See also
Notes on the system requirements (Page 105)

Notes on licenses (Page 104)

Starting installation (Page 129)

Displaying the installed software (Page 133)

Modifying or updating installed products (Page 133)

Starting to uninstall (Page 136)

Installation log (Page 128)

3.9 Starting to uninstall

Introduction
Software packages are removed automatically by the setup program. Once started, the setup 
program guides you step-by-step through the entire removal procedure. 

You have two options for removing:

● Removing selected components via the Control Panel 

● Removing a product using the installation medium
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 Note

The Automation License Manager will not be removed automatically when you remove the 
software packages, because it is used for the administration of several license keys for 
products supplied by Siemens AG. 

 

Removing selected components via the Control Panel
To remove selected software packages, follow these steps:

1. Open the Control Panel with "Start > Settings > Control Panel".

2. Double click on "Add or Remove Programs" in the control panel.
The "Add or Remove Programs" dialog opens.

3. Select the software package to be removed in the dialog "Add or Remove Programs", and 
click "Remove".
The dialog for selecting the setup language opens.

4. Select the language in which you want the dialogs of the setup program to be displayed 
and click "Next".
The dialog for selecting the products you want to remove opens.

5. Select the check boxes for the products that you want to remove and click "Next".
The next dialog displays an overview of the installation settings.

6. Check the list with the products to be removed. If you want to make any changes, click the 
"Back" button.

7. Click the "Uninstall" button.
Removal begins.

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

Removing a product using the installation medium 
To remove all software packages, follow these steps:

1. Insert the installation medium in the relevant drive.
The setup program starts automatically unless you have disabled Autostart on the 
programming device or PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog for selecting the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click "Read product information" or 
"Read installation notes".
The help file containing the notes opens.
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5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for selecting the installation variant opens.

6. Select the "Uninstall" option button and click the "Next" button.
The next dialog displays an overview of the installation settings.

7. Click the "Uninstall" button.
Removal begins.

8. It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

9. If the computer does not reboot, click "Exit".

See also
Installation log (Page 128)

Notes on the system requirements (Page 105)

Notes on licenses (Page 104)

Starting installation (Page 129)

Displaying the installed software (Page 133)

Modifying or updating installed products (Page 133)

Repairing installed products (Page 135)
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3.10 Installing and uninstalling the migration tool

3.10.1 System requirements

System requirements for the migration tool   
The following system requirements apply to the use of the migration tool:

● All products used to create the source project must be installed. The following products are 
supported:

– WinCC flexible 2008 SP2 and SP3

– WinCC V7.0 SP3

– STEP 7 V5.5

– Integrated projects from STEP 7 V5.5 and the WinCC products listed above

– SINUMERIK

– STARTER and Startdrives

– SIMOTION SCOUT V4.4
You need the SCOUT Migration Tool PlugIn V4.4 to migrate SIMOTION SCOUT V4.4 
projects.

● All optional packages needed to process the STEP 7 project are installed. For example, all 
HSPs for the devices used in the source project are required.

3.10.2 Installing the migration tool

Distribution of the migration tool   
You can find the migration tool in the "Support" directory on the installation DVD of the TIA 
Portal. Alternatively, it can be downloaded from the Service & Support area of the Siemens 
website. For some products, (such as SIMATIC Failsafe or SIMOTION) additional plug-ins are 
required for the migration tool. These plug-ins can also be downloaded from the Service & 
Support page or installed from the installation DVD of the specific products.

Normally, the migration tool is installed without the TIA Portal. Because the TIA Portal has its 
own integrated migration function, a separate installation of the migration tool is not necessary.
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Procedure
To install the migration tool, proceed as follows:

1. Download the installation DVD from the Service & Support area of the Siemens website or 
use the installation file from the "Support" directory of the installation DVD of the TIA portal 
to perform the installation.

2. Run the installation file.
The setup program for the migration tool will open.

3. First, select the language in which the setup should be displayed and click the "Next" button.
The page for selecting the software language is displayed.

4. Since the migration tool is provided exclusively in English, you cannot choose any other 
language for the installation. Therefore, click "Next" to proceed to the next step.
The page for selecting the product is displayed.

5. The migration tool consists solely of a software component. Therefore, the migration tool 
is already selected.
To create a Desktop icon for starting the migration tool, select the check box "Create 
Desktop icon". Then click the "Next" button.
The page for confirming the licensing terms is shown.

6. Click on an entry in the list of license terms to read the selected license term. If you agree 
with all license terms, select the check box "I accept the terms of the displayed license 
agreement". Then click the "Next" button.
An overview of the installation is displayed.

7. Click the "Install" button.
The installation is performed with the displayed settings.

3.10.3 Uninstalling the migration tool
The migration tool can be removed using the Control Panel.

Procedure  
To remove the migration tool, follow these steps:

1. Open the Control Panel.

2. Double click on "Add or Remove Programs" in the Control Panel.
The "Add or Remove Programs" dialog opens.

3. Select the entry for the migration tool in the "Add or Remove Programs" dialog, and click 
the "Remove" button.
A security prompt appears.

4. Click the "Uninstall" button to confirm this prompt.
The migration tool will be removed.
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Migrating projects and programs 4
4.1 Migrating projects in a TIA portal project

4.1.1 Migration of projects with the TIA Portal

Migration of existing projects   
You can migrate projects from earlier automation solutions to the TIA Portal. Each time you 
migrate, a new project is created for the migrated data with which you can then work. Any TIA 
Portal projects already open are closed first.

The migration is then displayed in the table of the project history. From there, you have access 
to the migration log that is created automatically for the migration.

Supported products for migration   
The chapter "System overview STEP 7 and WinCC" includes information on the products that 
are available for the TIA Portal. In principle, all products listed there are supported by the TIA 
Portal during migration.

Any additional requirements that must be met depend on the initial products that were used 
and the currently installed products. For more information on the migration options for your 
products, you can, for example, refer to the Siemens Industry Online Support and the 
documentation of your software products.

See also: Scaling of STEP 7 and WinCC in the TIA Portal (Page 33) 

Procedure during migration   
The migration process is divided into the following basic steps:

1. Preparing the initial project
If the software for editing the initial project is not or not fully installed on the programming 
device/PC with the TIA Portal, or if the initial project is an integrated project, the initial project 
must first be converted into a migration file. To do this, install the migration tool on a 
programming device/PC on which the required software for editing the initial project is 
installed. Then, use the migration tool to convert the initial project, and copy the file to the 
programming device/PC on which the TIA Portal is installed. You can omit this step if the 
initial project and its associated software are on the same programming device/PC as the 
TIA Portal, and if the initial project is not an integrated project.

2. Performing migration
Perform the actual migration within the TIA Portal. For the migration, specify as source 
either the migration file which you created with the migration tool or the initial project when 
all required software has been installed.
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3. Checking the migration log
A migration log is created for each migration. It contains information about modified project 
parts. You can call the log under "Common data > Logs" in the project tree or in the project 
history. After completion of the migration, the migration log will be displayed in the TIA 
Portal. Check the log following completion of the migration.
If the migration failed, an XML file is created as a log under "\Logs" in the project directory. 
You can use any XML editor to open this log and view the reasons why the migration failed.

4. Correcting the migrated project
Because the configurations of the initial project may not always be completely compatible 
with the TIA Portal, not all configurations are transferred in identical form in the migrated 
project. You should therefore work through the points in the migration log systematically. 
If you have not included the hardware configuration in the migration, you also have to 
convert the unspecified devices to the appropriate hardware.

 Including the hardware configuration in the migration   
By default, only the software parts of the project are included in the migration. An unspecified 
device is generated in the migrated project for the devices contained in the initial project. The 
hardware and network configurations and the connection are not migrated. You can convert 
the unspecified devices into suitable devices after the migration and create any network 
configurations and connections manually.

If you are certain that the hardware used in the initial project has a corresponding equivalent 
in the TIA Portal, you can include the hardware configuration in the migration. In this case, 
both the hardware configuration and the software are migrated.

See also
Display migration log (Page 147)

Scaling of STEP 7 and WinCC in the TIA Portal (Page 33)

4.1.2 Preparing projects with the migration tool

4.1.2.1 Migrating projects with the migration tool

Preparation for migration   
In many cases, a project that you wish to migrate will not be located on the same programming 
device/PC on which the latest version of the TIA Portal is installed. Therefore, the initial project 
must first be converted to a compatible format for the migration. The same applies to integrated 
projects.

After creation of the migration file, you copy the migration file to the programming device/PC 
on which the current version of the TIA Portal is installed. In the TIA Portal, enter the migration 
file as source for the migration. You can now create a project in the current file format of the 
TIA Portal.
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Procedure for migration with the migration tool
The following steps are necessary to prepare a migration with the migration tool:

1. Install the migration tool on the programming device/PC where the source project is located. 
To do this, download the installation file from the Siemens Industry Online Support or install 
the migration tool from the setup DVD of the TIA Portal.

2. Start the migration tool, and use it to convert the source project to the migration file format 
with file extension ".am13".
For this step, make sure that all software needed to process the source project is installed 
on the programming device/PC. This also includes all necessary service packs, hardware 
support packages and all expansion software that is needed to process the initial project. 
If individual products are not installed it may not be possible to perform the migration or the 
migration may be incomplete.

3. Copy the migration file to the target system on which a current version of the TIA Portal is 
installed.
Note that the target system must have been installed with all software needed to configure 
the complete set of devices contained in the migration.

4. Perform the migration within the TIA Portal, and specify the migration file with the extension 
".am13" as the source.

5. Once migration is complete, check the migration log and systematically work through the 
information provided there for the newly created project. Read the information in the 
Inspector window with special care after the first compilation of the configuration.

Including the hardware configuration in the migration
By default, only the software parts of the project are included in the migration. An unspecified 
device is generated in the migrated project for the devices contained in the initial project. The 
hardware and network configurations and the connection are not migrated. You can convert 
the unspecified devices into suitable devices after the migration and create any network 
configurations and connections manually.

If you are certain that the hardware used in the initial project has a corresponding equivalent 
in the TIA Portal, you can include the hardware configuration in the migration. In this case, 
both the hardware configuration and the software are migrated.

 

See also
Migration of projects with the TIA Portal (Page 141)

Migrating projects (Page 145)

Calling the migration tool (Page 144)

Creating a migration file (Page 144)
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4.1.2.2 Calling the migration tool

Starting the migration tool   
During the installation, a "Migration to TIA Portal V13" shortcut is created as standard in the 
Start menu under "Siemens Automation > Migration Tool". Click this shortcut.

Alternatively, you can call the migration tool directly in Windows Explorer. During the 
installation, the migration tool is saved by default in one of the following folders:

● On a 64-bit operating system:
C:\Program Files (x86)\Siemens\Automation\MIGTOOL_V13\Bin

● On a 32-bit operating system:
C:\Program Files\Siemens\Automation\MIGTOOL_V13\Bin

 To start the migration tool, click the "Siemens.Automation.MigrationApplication.exe" file in one 
of the directories.

See also
Creating a migration file (Page 144)

4.1.2.3 Creating a migration file
The section below describes how you can use the migration tool to convert the initial project 
into a migration file that can be read by the TIA Portal. Following conversion, this file is 
transferred to the target system and migrated there.

You can specify whether the migration file should contain the entire project, including the 
complete hardware configuration and the associated software, or whether you want to migrate 
the software only.

Requirements
● The suitable, original software with a valid license is installed for all configurations used in 

the initial project.

● The initial project is not provided with access protection.

● The initial project must be consistent, otherwise problem-free migration cannot be assured.
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Procedure   
To create the migration file, proceed as follows:

1. Choose the path of the source file for the migration in the "Storage Location (Path)" field.

2. Specify which project parts are to be migrated:

– Select the "Include HW and Network data during the migration" check box to migrate 
not only the software but also the complete hardware parts and the network configuration 
of the project.

– Select the "Copy SCADA runtime data" check box if you also want to migrate the runtime 
data, such as alarm archives, tag archives and user archives, in addition to the data of 
the engineering system.

3. Choose the path and the file name for the migration file in the "Intermediate file" field.

4. Click the "Migrate" button.

Result:
A migration file is created. Finally, copy this file to the target system and migrate this file in the 
TIA Portal.

See also
Migrating projects (Page 145)

Calling the migration tool (Page 144)

Migrating projects with the migration tool (Page 142)

4.1.3 Migrating projects

Requirements   
● A converted file in the format ".am13" is already available or the original software with a 

valid license is installed for all configurations used in the initial project.

● The initial project is not provided with access protection.

● The initial project must be consistent, otherwise problem-free migration cannot be assured.

Read the additional information on the requirements in the help for the respective products 
installed.

 

 Note
System hibernation during the migration

While a migration is running, the system should not be changed to the standby or hibernate 
mode. Otherwise the migration will be aborted.
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Procedure   
To migrate a project, follow these steps:

1. Select the "Migrate project" command in the "Project" menu.
The "Migrate project" dialog opens.

2. Specify the path and the file name for the project to be migrated in the "Source path" field. 
Choose either a project in the ".am12" migration format or in the format of the initial project.

3. To include the hardware configuration in the migration, select the "Include hardware 
configuration" check box.
If you have selected a migration file that was created with the migration tool, the check box 
cannot be selected. In this case, you must specify if you wish to include the hardware 
configuration in the migration before the conversion with the migration tool .

4. Select the "Copy WinCC Runtime Professional data" check box, if you also want to migrate 
the runtime data, such as alarm archives, tag archives and user archives, in addition to the 
data of the engineering system.
If you have selected a migration file that was created with the migration tool, the check box 
cannot be selected. In this case, you must specify if you wish to include the SCADA runtime 
data in the migration before the conversion with the migration tool .

5. Choose a name for the new project in the "Project name" box.

6. Choose a path in the "Target path" box where the new project will be created.

7. Enter your name or the name of another person responsible for the project in the "Author" 
field.

8. Enter a comment in the "Comment" box, if you require one.

9. Click "Migrate".

Result
The initial project is converted and a message appears after conversion is complete. The newly 
created project is then opened in the project view and the migration log is opened in the TIA 
Portal.

Even if the migration failed, a project directory is created and a migration log in the form of an 
XML file is generated in this directory. The completion message that appears after the migration 
contains a link to this XML file. Click the link to open the XML file. Alternatively, you can find 
the XML file in the project directory under "\Logs".

See also
Post-editing integrated projects (Page 260)

Display migration log (Page 147)

Using logs (Page 357)

Migrating projects with the migration tool (Page 142)

Creating a migration file (Page 144)
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4.1.4 Displaying the history of the migration
If a project was created by migration, the migration will be listed in the table of the project 
history. You can open the migration log in the table. The time of the migration is also shown.

Procedure   
To display the migration in an overview table, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the "Project history" group in the area navigation.
The overview table is displayed.

See also
Displaying properties of the project (Page 363)

4.1.5 Display migration log
A log is created for each successful migration. The log contains the following information:

● Migrated objects

● Modifications to objects made during migration

● Errors that occurred during migration

● In certain cases a link to more help with specific events.
In this case, click the question mark to obtain more help.

Procedure   
To display the log file of the migration, follow these steps:

1. Open the "Common data > Logs" folder in the project tree.

2. Double-click the desired log in the list.
The contents of the log are displayed in the work area.

See also
Migration of projects with the TIA Portal (Page 141)

Using logs (Page 357)
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4.1.6 Migrating STEP 7 projects

4.1.6.1 Migration of STEP 7 projects

Introduction
You can migrate a project from SIMATIC STEP 7 V5.4 SP5, or from SIMATIC STEP 7 V5.5 
to be able to continue to use it in the TIA Portal. If you want to migrate projects from older 
STEP 7 versions, you have to open, compile and save these projects first in STEP 7 V5.4 SP5 
or V5.5. It is also possible to migrate integrated projects with devices from other software 
products.

Scope of migration
Generally, you can migrate all of the configurations and objects from SIMATIC STEP 7 V5.4 
SP5 or V5.5 which also support the installed version of the TIA Portal. This includes, for 
example, the following devices and configurations:

● Devices of the S7-300 and S7-400 family.

● PROFIBUS configurations with connected distributed I/O. These include GSD-based 
slaves, I-slaves as well as direct data exchange.

● PROFINET configurations with distributed I/O. These include GSD-based devices and I-
devices.

● Network configurations

● Connections

● Blocks created in the programming languages LAD, FBD or STL, S7-SCL, S7-GRAPH

● PLC tags

● User-defined data types (UDT)

● Alarms and alarm classes

● Interrupts

● User-defined attributes (UDA)

● User text libraries

Including the hardware configuration in the migration
By default, only the software parts of the project are included in the migration. An unspecified 
device is generated in the migrated project for the devices contained in the initial project. The 
hardware and network configurations and the connection are not migrated. You can convert 
the unspecified devices into suitable devices after the migration and create any network 
configurations and connections manually.

If you are certain that the hardware used in the initial project has a corresponding equivalent 
in the TIA Portal, you can include the hardware configuration in the migration. In this case, 
both the hardware configuration and the software are migrated.
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See also
Reporting system errors (Page 156)

General notes on migrating program blocks (Page 156)

4.1.6.2 Requirements for the migration of STEP 7 projects
Various requirements for the software installed on the original PG/PC and for the initial project 
apply to the migration.

Requirements for the original PG/PC   
The following requirements apply to the PG/PC:

● A licensed version of STEP 7 V5.4 SP5 or V5.5 must be installed. For projects that only 
contain PC stations, it is sufficient if the SIMATIC NET PC software is installed.

● For all of the configurations used in the project, the corresponding additional software must 
be installed with a valid license, for example, optional packages.

● All HSPs for modules not included in the hardware catalog must be installed.

● All GSD files used in the project must comply with the specifications.

● You must be logged on to the operating system with administrative rights.

● One of the following software products must be installed:

– The TIA Portal with STEP 7 Professional V13 or higher
If you do not migrate with the most recent version of the TIA Portal to the original 
programming device/PC, the functional scope of the project in the more recent version 
of the TIA Portal is initially limited. You first have to upgrade the project before you can 
use the full functional scope of more recent versions.

– The migration tool

Requirements for the initial project   
● The initial project must not be configured with access protection.

● The hardware and software must be consistent.

● The alarm number assignment must be set to CPU-oriented.

● It must contain no protected blocks with time stamp conflict.

● It must be possible to compile all programs and their sources without errors.

● All called blocks must be available in the block folder.
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● The block folder must contain no blocks that are not called, in particular no instance data 
blocks.

● We recommend that you migrate blocks unencrypted, because blocks encrypted with 
KNOW_HOW_PROTECT (from STEP 7 V5.x) or S7-Block Privacy (from STEP 7 V5.5) 
cannot be read or modified in the TIA Portal.

Requirements for the PG/PC with STEP 7 Professional
● One of the following software products must be installed:

– STEP 7 Professional V13 or later

– STEP 7 Professional V13 or later (without license) when the project to be migrated only 
contains components that have been configured with the SIMATIC NET PC software.

● For all of the configurations used in the project, the corresponding additional software must 
be installed with a valid license, for example, optional packages.

● All HSPs for modules that are not contained in the hardware catalog and all GSD files used 
in the project must be installed.

4.1.6.3 Checking whether STEP 7 projects can be migrated
Before you launch migration, you can check if all necessary requirements for migration have 
been met.

 

 Note

Note that the actual values are reset in the original project when the following steps are carried 
out. Also note that running the block consistency check in STEP 7 V5.x resets the initial values 
in the instance DBs to the default values. If you are using technology functions, this behavior 
is not desired.

 

Procedure   
To check whether a project can be migrated, follow these steps:

1. Open the original project in SIMATIC STEP 7 V5.4 SP5 or V5.5. For a correct update, it is 
necessary that only the optional packages and modules, including HSPs and GSD files, 
that are contained in the TIA Portal are installed.

2. Open the individual stations. If no messages indicating missing components are displayed 
when the stations are opened, all the components necessary for migration are available.

3. Perform a block consistency check for each block container contained in the project.
For more information on the consistency check, refer to Chapter "Consistency check in 
initial project prior to the migration (Page 151)".

4. Compile the entire project. If no errors are displayed during the compilation, the programs 
can be migrated.

5. Check whether all modules with an identical MLFB and the same firmware version are 
contained in the TIA Portal hardware catalog.
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6. Check whether the CPU-oriented message number assignment is activated for each CPU.

7. Compile the project in NetPro. Here too, no errors should be reported.

See also
Consistency check in initial project prior to the migration (Page 151)

FAQ entry on consistency check (http://support.automation.siemens.com/WW/view/en/
5416540)

4.1.6.4 Consistency check in initial project prior to the migration

Consistent initial project   
A consistent initial project is a requirement for the successful migration of a SIMATIC STEP 7 
V5.x project to the TIA Portal. It is therefore advisable to perform a consistency check on the 
initial project before migration. You can find a guide to the consistency check in SIMATIC STEP 
7 V5.x in an FAQ entry (http://support.automation.siemens.com/WW/view/en/5416540) on the 
Service and Support page or in the SIMATIC STEP 7 V5.x help.

Migrate start values in instance DBs for technology blocks
The compilation in the block consistency check causes the tags in instance DBs to be reset 
to the default values. The set start values are lost in the process. 

To migrate the start values anyway, we recommend one of the following procedures:

● For smaller projects: Backup the instance DBs outside the block folder.
Backup the instance DBs before you start the consistency check. After the consistency 
check has been completed, copy the instance DBs back to the block folder.

● For larger projects: Create a copy of the project
Make a copy of the project and then carry out the check on the copy of the project. Correct 
any errors found during the consistency check in the initial project.

You can then migrate the project with the configured values. In this way, the configuration of 
the technology functions is also retained.

4.1.6.5 Removing unsupported hardware components
If you have created configurations in the initial project for which not all of the right software is 
installed, then you can still migrate the project by manually deleting the unsupported 
configurations from the project. Alternatively, you can use the "Reorganize" function.
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Procedure
To clean the original project, follow these steps:

1. Use an Installation of SIMATIC STEP 7 V5.4 or V5.5 that contains only the optional 
packages contained in the TIA Portal and all required modules.

2. Save the project again and select the "With reorganization" option when saving. Any 
unsupported configurations will be removed from the project.

For modules that are only available in a new version or with a new firmware version in the TIA 
Portal, use the "Exchange object" function in the station to exchange an older module for one 
that can be migrated.

4.1.6.6 Special points to observe during migration

Device names

Device names of PROFINET IO devices
In STEP 7 V5.5 the device name of a PROFINET IO device is used as the name of the IO 
devices. After the migration to a TIA Portal project, the device name of the PROFINET IO 
device from the initial project is used as follows:

● As the PROFINET device name

● As the name for the interface module

● As the name of the station
A maximum of 24 characters is permitted for the name of the station in the TIA Portal. The 
name of the station is therefore truncated to a maximum of 24 characters where required. 
If truncating of the station name would result in several stations with the same name, the 
last characters of the station name are used to number the stations consecutively.

Names of modules and racks   
In SIMATIC STEP 7 V5.5, the names of modules and racks do not have to be unique. In the 
TIA Portal, however, unique names are required. Therefore, the names of the modules and 
racks are incremented during the migration to make sure that unique names are assigned. 
This does not apply to PROFINET IO devices and PROFINET CPs. You must provide unique 
names for these yourself.

PROFINET IO configurations

Unique name assignment required
The names of PROFINET IO devices must be unique within the subnet. The same applies to 
the names of PROFINET CPs. For this reason, ensure that the name assignment is unique 
before the migration into the initial project or provide unique names after migration and before 
the first compilation.
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Media redundancy with sync domains   
If a sync domain with activated media redundancy is found in the initial project, the sync domain 
configuration is imported during migration. If, however, several sync domains with activated 
media redundancy are found in the initial project, they are removed and the project is migrated 
without the sync domains. In any case, you will receive a message which sync domains were 
imported.

In any case, use SIMATIC STEP 7 V5.5 to configure the media redundancy in the initial project.

Isochronous mode with PROFINET IO   
Observe the following for PROFINET IO configurations in isochronous mode:

● IRT with high performance
If you have configured IRT with high performance when planning the topology in the initial 
project, the option is changed to "RT" during migration. You will receive a message 
informing you of the change.

● Use of OB 61
If the isochronous mode for PROFINET IO with OB 61 is activated in the original 
configuration in the STEP 7 project, it will be deactivated by the migration. The devices will 
still be imported. PROFINET IRT configurations with the option "high flexibility" without the 
use of OB 61 can be migrated.

CBA for IO controllers   
If you have used the cyclical service CBA (Component Based Automation) in the initial project, 
it is deactivated during migration. You will receive a message informing you of the change.

Use of Shared Devices   
If Shared Devices are configured in the initial project, they are removal during migration. You 
will receive a message informing you of their removal.

Transfer areas   
If transfer areas for data exchange between the IO controller and I-device are configured in 
the initial project, they are removed during migration. You will receive a message informing 
you when a transfer area is removed during migration.

Update groups for PROFINET IO   
If necessary, also remove update groups from the STEP 7 project before you start the 
migration. If any update groups are still configured, then the migration can not be carried out.

I slaves and I-devices   
Only connected and consistent I slave and I-device configurations can be migrated. If the 
configuration is inconsistent, then the configurations in question will be excluded from the 
migration.
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PROFINET IO systems that are not connected
Devices with PROFINET IO systems that are not connected can be migrated. The IO devices 
and the PROFINET IO systems are located in the network view without connection after 
migration. Connect these IO devices after migration with an IO controller or delete any 
unnecessary IO devices.

PROFIBUS configurations

Isochronous PROFIBUS 
It is possible to migrate isochronous PROFIBUS configurations. You should compile the project 
again after the migration, however, to rule out any possible inconsistencies. Also pay attention 
to slightly changed SDBs.

Orphaned master systems
Devices with orphaned DP master systems can be migrated. The DP slaves of the abandoned 
DP master system are located in the network view without connection after migration. Connect 
these DP slaves after migration with a DP master or delete any unnecessary DP slaves.

GSD and GSDML devices

For devices that were configured with PROFIBUS GSD or PROFINET GSD files, the 
corresponding GSD files must also be installed in the TIA Portal. If GSD files are not yet 
installed in the TIA Portal, they will be installed automatically during the migration. The GSD 
files must comply with the specifications (e.g., GSDML Specification for PROFINET IO, see 
www.profinet.com (http://www.profinet.com)), in order for the project to be migrated 
successfully. If GSD files of a device manufacturer do not comply with the specification, the 
project cannot be migrated. In the migration log, you receive alarms notifying you of non-
compliant GSD files.

If the GSD files do not comply with specifications, check whether a newer version of the GSD 
file is available from the manufacturer. Install the current version. If a version of the GSD file 
that complies with the specification is not available, contact the device manufacturer.

Connections
Connections from SIMATIC STEP 7 projects can usually be migrated if they are also supported 
by the installed version of the TIA Portal.

Migratable types of connection 
The following connection types can be migrated:

● S7 connection one-way

● S7 connection two-way

● Failsafe S7 connection
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● TCP connection

● ISO-on-TCP connection

● ISO connection

● UDP connection

● E-mail connection

● FDL connection

● Point-to-point connection

FMS connections on the PROFIBUS are not accepted during the migration. Adapt the 
connections or modify the user program.

Multiprojects

Multiprojects in SIMATIC STEP 7 
In SIMATIC STEP 7, you can organize projects into a multiproject if, for example, a project is 
very large or if several people are working on it. The subprojects may contain cross-project 
references, for example connections. All subprojects of a multiproject and the associated 
libraries are stored in the same directory.

Migration of parts of a multiproject
You can migrate the subprojects of a multiproject. To do this, select one of the subprojects 
during the migration. All of the devices and configurations contained in the respective 
subproject will be imported during the migration.

Observe the following when migrating a subproject:

● Cross-project connections
Cross-project connections between subprojects are created as unspecified connections.

● Cross-project networking
Information on networking of devices across project boundaries will be lost during the 
migration. Links between devices in the same subproject will be retained however.

Grouping a multiproject for the migration.
It is only possible to migrate an entire multiproject with all of its associated subprojects if you 
manually regroup the different subprojects prior to the migration. This is possible, for example, 
by copying the individual devices and pasting them back into a single project.

Messages
PLC alarms are migrated with all parameters and including all alarm classes. Alarm types and 
alarm instances are also migrated and stored under the PLC alarms in the TIA Portal.
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Requirement  
Requirement is that the CPU-wide assignment of alarm numbers is selected in the initial 
project. Before the migration, select the "Always assign CPU-oriented unique message 
numbers" option in the initial project, if necessary, and perform "Save As > With 
Reorganization".

Restrictions
● Symbol-based alarms cannot be migrated.

● The keywords "$$AKZ$$", "$$BlockComment$$", and "$$Area$$" are transferred but no 
replacement takes place during runtime.

Reporting system errors
In principle, you can migrate system error messages that you have configured using SIMATIC 
STEP 7.

Restrictions
When migrating the "Report system errors" application, only the settings that were set by the 
user in the SIMATIC STEP 7 project will be migrated (e.g. basic settings, block numbers, block 
names).

The following elements are not migrated:

● SFM blocks

● SFM messages and the settings that were made to configure the message texts

● System text libraries

 

After migration, the settings can be manually adjusted once again. The missing elements will 
be recreated during the first compilation of the hardware configuration.

Migrating program blocks

General notes on migrating program blocks
You can generally migrate all blocks created in LAD, FBD, SCL, STL, and GRAPH. Please 
note the following:

Programs with absolute addressing   
In the TIA Portal, symbolic operands are automatically declared for all absolute addresses. If 
absolute addressing was used in the STEP 7 program to be migrated, symbolic operands are 
also declared for the absolute addresses during the migration. This automatic declaration can 
lead to data type conflicts, particularly if the IEC check is activated in the TIA Portal. A data 
type conflict could occur, for example, if a 32-bit data value is declared as a DWORD type tag 
but a REAL data type tag is expected later in the program. 
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In this case, it is not enough to deactivate the IEC check. Instead, you must correct the 
declaration in the PLC tag table.

Migration of communication blocks
During the migration of communication instructions from STEP 7 V5.x, pointers of the data 
type ANY are replaced by PLC tags within the own S7 station.

● After the migration a warning is displayed at the affected parameters.

● Replace the PLC tags with a pointer at the affected parameters.
For absolute addressing of a data block with data type ANY, the data block must have been 
created with standard access, since symbolic addressing with data type ANY is not possible.
Example: To input values, use the appropriate parameters of instruction P#M10.0 BYTE 4 
instead of %MD10.

Symbolic names for blocks and user-defined data types (UDT)
In the TIA Portal, each block or UDT has a number and a name. It is therefore no longer 
necessary to declare symbolic names. If the migrated program contains symbol declarations 
for blocks or UDTs, they will be used as names after the migration. 

Blocks from STEP 7 libraries
In the TIA Portal, standard functions and function blocks are not provided in libraries. Instead, 
they are available as instructions in the "Instructions" task card. The instructions are sorted by 
function and can be found under their symbolic name.

If calls of standard functions or function blocks are contained in the migrated program, they 
are replaced during the migration by the instructions that correspond to the original standard 
function or the original standard function block.

If the library block is no longer supported in the TIA Portal, you have the following options:

● Replace the library block with a compatible instruction. In this case, you will receive an 
alarm informing you that you have to compile the program after migration. Note that the 
calling block may not carry any know-how protection, as the block call has to be adapted 
during compilation.

● If there is no compatible instruction, the block is migrated as user block. It is then available 
as know-how protected block in the folder "Program blocks" with the extension "_LF" (legacy 
function).

User-defined block libraries
User-defined block libraries are no longer available in the familiar form in the TIA Portal. 
However, you can migrate user-defined libraries by integrating these into a project prior to 
migration and then migrating the project. After this, you can copy these from this project in the 
TIA Portal and use them.
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Instructions in a modified display
The display of some of the LAD, FBD, STL, SCL and GRAPH commands in the TIA Portal 
differs from the display in earlier versions of STEP 7. Thus, for example, the mathematical 
functions and the comparators are no longer specific for data types. Instead, there is a central 
instruction, which can be used for all types of data. The "ADD_I" command is no longer 
permitted, for example; the instruction "ADD" is used instead. 

Some other commands also have a new display in the TIA Portal, e.g., edge commands, word 
logic operations, conversions, IEC timers, IEC counters, etc. 

The commands will be converted for the new display during the migration. 

Stricter IEC check
Stricter rules for checking data type compatibility will be used in the TIA Portal. In addition, 
errors that can lead to runtime errors are already detected during the syntax check. It is no 
longer permitted to write your own input parameters or to read your own output parameters in 
functions (FC). Observe the following rules to avoid syntax errors:

● Only use tags with compatible data types when transferring the parameters.

● In comparison instructions or arithmetic instructions, only use tags with compatible data 
types.

● You may not write to input parameters or read from output parameters.

For more information on the block interface and on data type conversion with IEC check, refer 
to "See also".

Peripheral access ID ":P"
In the TIA Portal, the access ID ":P" is used for direct addressing of the peripherals. The 
following notation is not permitted, for example:
%PIW3
The following notation is used instead:
%IW3:P //absolute display
MyTag:P //symbolic display
The accesses are converted into the new notation during the migration. However, symbolic 
names, which were declared to be peripheral tags in the original program, cannot be accepted. 
New declarations will be created instead. For additional information on peripheral access, refer 
to "See also".

No distinction is made between upper and lower case for jump marks
No distinction is made between upper and lower case for jump marks in the TIA Portal. If the 
source program contains jump labels that differ only through upper/lower case, these will be 
converted into unique jump labels. The log file provides information on the modified jump labels.
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German special character "ß" is not distinguished from "ss"
In tag names, the German special character "ß" is not distinguished from "ss" in the TIA Portal. 
If, for example, the source program contains tag names that differ only in these two characters, 
they will be converted into unique tag names.

Migration of global data blocks
The display and handling of data values in data blocks is different in the TIA Portal than in 
SIMATIC STEP 7. In global data blocks which are not derived from a high-level object, for 
example a UDT, the tags are always assigned the default value of the data type as the default 
value, for example FALSE for the data type BOOL. This default value is not editable. If offline 
initial values were assigned in the declaration view, they are not imported during the migration. 
If you require user-specific default values in the program, use a global data block based on a 
PLC data type. You can assign user-specific default values for tag values in a PLC data type.

For additional information on data values, refer to "See also".

Migration of LAD/FBD/STL programs
LAD, FBD and STL blocks can run after the migration without being recompiled or reloaded.

Know-how protection       
Blocks that were know-how protected before the migration remain know-how protected after 
the migration. Because the sources are not migrated, the know-how protection cannot be 
canceled. The blocks can thus not be opened or edited. It is possible, however, to load the 
blocks into the CPU and to run them.

The following options are available for disabling the a block's know-how protection:

● Prior to the migration, remove the KNOW_HOW_PROTECT attribute from the source and 
create a block without know-how protection from this. Then migrate this block.

● Import the source into the TIA Portal and create a block without know-how protection from 
this. Then use the "Edit > Know-how protection" menu command to provide the block with 
a password.

Switch-over from LAD/FBD to STL
As determined by the system, programs that were created in LAD or FBD and contain jump 
operations to subsequent networks will be displayed in STL after the migration. In the block 
properties, however, the language is still set as LAD or FBD.

In the block properties, change the program again to STL. Then reset the language to LAD or 
FBD.
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Migrating GRAPH programs

Requirement   
The prerequisite for migrating GRAPH blocks is to have the "S7-GRAPH" optional package, 
version 5.3 SP6 or later, installed on the original device. 

GRAPH-specific block settings
The GRAPH-specific block settings have been significantly reduced in the TIA Portal. The 
following table gives an overview of how the original block settings will be transferred to the 
TIA Portal.

Setting in the initial project Setting in the TIA Portal
FB 
paramete
r

Minimum Existing parameters will be migrated
Standard
Maximum
Definable

Interface 
descriptio
n

Minimized memory 
space

Generate DB with minimized memory space

Structure fields Individual structures are always created
Individual structures

Run 
capability

FC70/71 FC 73 if the option "Generate DB with minimized memory 
space" is active; otherwise FC 72FC72

FC73
Criteria analysis in the DB Setting not relevant in the TIA Portal
Skip steps Skip steps
Acknowledgment of errors required Acknowledge supervision errors
Synchronization Always activated in the TIA Portal
Permanent processing of all 
interlocks in manual mode

Permanent processing of all interlocks in manual mode

Disable operating mode selection Disable operating mode selection
Safeguarded switching behavior Always activated in the TIA Portal
Warnings None Always activated in the TIA Portal

Any
Activate messages Activate messages
Messages with WR_USMSG Messages in the TIA Portal always with ALARM_SQ/ALARM_S

Step name extension
Step name extensions are not supported in the TIA Portal. They are converted to step-specific 
text during the migration.

Compiling the migrated block
GRAPH blocks must be recompiled and reloaded after the migration. 
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The following errors may occur when compiling:

● Data type conflicts may occur due to the stricter IEC check. In this case, change the 
declaration.

● Since the "structure fields" setting for the interface is no longer available in the TIA Portal, 
interface elements can no longer be addressed with G7S[1].X, for example. Access to the 
element must therefore be corrected, e.g. to STEP1.X.

Changing the interface of the GRAPH block
The changed settings can lead to interface changes of the block. Therefore, it may be 
necessary to regenerate the instance DB or to update block calls. 

 

Migrating SCL programs
The prerequisite for migrating SCL blocks is to have the "S7-SCL" option package, version 5.3 
SP5 or later, installed on the original device.

SCL blocks must be recompiled and reloaded after the migration. 

Basic procedure for the migration     
A complete migration of SCL blocks is only carried out if the associated sources exist in the 
initial project. 

The table below gives you an overview of the basic procedure.

Existing in the initial project Existing after migration
SCL blocks with source Editable SCL blocks
Know-how protected SCL blocks with source Editable SCL blocks. After the migration, the 

blocks no longer have know-how protection but 
can be re-protected, if necessary.

SCL blocks without source Know-how protected SCL blocks
Know-how protected SCL blocks without source Know-how protected SCL blocks

SCL-specific compiler options
Only the compiler options that are defined directly in an SCL source are adopted as block 
properties in the TIA Portal during migration. If no compiler options are defined in the original 
SCL source, the options in the properties of the migrated block are deactivated. 

Compiler options defined as settings in the SCL Editor or in an SCL compile control file are 
not migrated. 

The following table gives an overview of the compiler options that are transferred as block 
property to the TIA Portal.
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Compiler option in the SCL source Block property in the TIA Portal
scl_monitorarraylimits Check ARRAY limits
scl_createdebuginfo Create extended status information
scl_setokflag Set ENO automatically

New EN/ENO mechanism
SCL uses the EN/ENO mechanism of the TIA Portal. For this reason, all usages of the OK flag 
are replaced by ENO during the migration. The points where ENO was used in the original 
program are highlighted. You must check these points after the migration and adapt them to 
the new mechanism. 

For additional information on the EN/ENO mechanism of the TIA Portal, refer to "See also".

Operator "DIV"
The "DIV" operator is no longer available in the TIA Portal. All usages of "DIV" will be converted 
to the standard notation "/" during the migration.

Nested ARRAYs
In the TIA Portal it is not possible to nest ARRAYs. The following declaration is not permitted, 
for example:
ARRAY[1..5] OF ARRAY[0..3] OF INT
Nested ARRAYs are converted into multi-dimensional ARRAYs during migration. The example 
would look as follows after the migration:
ARRAY[1..5, 0..3] OF INT

Declaration of jump labels (LABEL)
The declaration of jump labels is not possible in the TIA Portal. The following declaration would 
not be accepted from the initial project, for example:
LABEL
MARKE1, MARKE2, MARKE3 ; 
END_LABEL
Set jump labels, however, will be retained in the program code and can be used for GOTO 
operations.

Declaration of symbolic constants in the block interface
In the TIA Portal, symbolic constants always have a data type. If symbolic constants are 
declared without data type in the source program, an appropriate data type will be assigned 
to them during the migration. 

Indexed peripheral accesses
In the TIA Portal, the syntax with rounded parentheses is used for indexed peripheral accesses. 
The following notation is not permitted, for example:
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PEB[1]
The following notation is used instead:
EB(1):P
The accesses are converted into the new notation during the migration. For additional 
information on peripheral access, refer to "See also".

Indexed memory accesses
In the TIA Portal, the syntax with rounded parentheses is used for indexed memory accesses. 
The following notation is not permitted, for example:
EB[2]
The following notation is used instead:
EB(2)
The accesses are converted into the new notation during the migration. For additional 
information on addressing, refer to "See also".

Indexed access to data blocks
In the TIA Portal, the syntax with rounded parentheses is used for indexed data block accesses. 
The following notation is not permitted, for example:
%DB100.DW[5]
The following notation is used instead:
%DB100.DW(5)
The accesses are converted into the new notation during the migration. For additional 
information on addressing, refer to "See also".

Absolute access to data blocks
For an absolute access, the absolute designator of the data block must be used. Access using 
the symbolic designator is not permitted in the TIA Portal. 

The following notation is not permitted, for example:
DB100.DW3
The following notation is used instead:
%DB100.DW3
During the migration, the marker "%" will be added for a detected absolute data block access. 
For additional information on addressing, refer to "See also".

Logarithmic functions "EXPD" and "LOG"
Logarithmic functions "EXPD" and "LOG" are no longer available in the TIA Portal. All usages 
of "EXPD" are converted to the standard notation "10**(<expression>)" during the migration. 
All usages of "LOG" are converted to the standard notation "LN(<expression>)" during the 
migration. 
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Mathematical instruction "MAX"
The "MAX" instruction cannot process any time data types in the TIA Portal. However, you can 
use comparators instead. 

The following example shows how you can find the "larger" of two time data types using 
comparators. 

SCL  
#xs_tod := #xi_tod + #xi_time;
   // statt #xstod1 := MAX(IN1:=#xtod1, IN2:=#xstod1);
   IF #xs_tod < #xi_tod THEN
         #xs_tod := #xi_tod;  
   END_IF;
 
   // statt #xsd1 := MAX(IN1:=#xd1, IN2:=#xsd1);
   IF #xi_date <#xs_date THEN
         #xs_date := #xi_date;  
   END_IF;
#xs_date_time := #xi_date_time + #xi_time;
   // statt #xs_date_time := MAX(IN1:=#xi_date_time, IN2:=#xs_date_time);
   IF #xi_date_time <#xs_date_time THEN
          #xs_date_time := #xi_date_time;  
   END_IF;

 

  

Floating point numbers - exponential display
The exponential notation of floating point numbers without a decimal point is no longer 
permitted in the TIA Portal. The following notation is not permitted, for example:
3E10
The following notation is used instead:
3.0E10
During the migration, all usages of "3E10" will be converted to the standard notation "3.0E10". 
For additional information on floating point numbers, refer to "See also".

Blocks from STEP 7 libraries
The functions FC 1 to FC 40 from the STEP 7 classic library "IEC standard functions" are no 
longer available in the TIA Portal. Calls to the standard functions are converted to calls to the 
corresponding extended instructions during the migration. If there is no clear conversion 
possibility, a system error is issued.

In this case, change the SCL block after the migration and use SCL instructions or operators 
instead of IEC standard functions.

Examples:

Use S5TIME_TO_TIME instead of S5TI_TIM (FC 33)
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"TAG_TIME" := S5TIME_TO_TIME ("TAG_S5TIME"); 
Use the comparator operator <> instead of NE_DT (FC 9):
IF #D1 <> #D2 THEN "MyOutput" : = 10;
END_IF;
Use the comparator operator = instead of EQ_STRING (FC 10):
IF #My_String1 = #MyString2 THEN "MyOutput" : = 10;
END_IF;

Interruption of strings with "$"
In STEP 7 Classic, strings in SCL could be interrupted by special characters, e.g., control 
characters or non-printable characters. These characters were identified by the interruption 
sequences "$>" and "$<". 

Example: 
#myString := 'Test1$>     $<Test1'; 
This option no longer exists in the TIA Portal. String interruptions will be deleted during the 
migration.

NULL pointer
Null pointers are no longer specified in the TIA Portal with "NIL" but instead with "NULL". The 
notation is replaced automatically during the migration.

Comments
Comments from the migrated source are transferred when possible. The following rules apply:

● Comments in the output block directly after the block definition are converted as block 
comments.

● Comments that appear as line comments after a tag declaration are transferred to the 
"Comment" column in the block interface.

● All other comments are not transferred.

Example:
// Comment that is not transferred.
FUNCTION_BLOCK FB57
// Comment that is transferred to the block properties.
(*Comment that is transferred to the block properties. *)
VAR_TEMP
    myVar1 : INT;// Comment that is transferred to the interface.
    myVar2 : INT;(* Comment that is not transferred because it is a 
comment segment. *)
END_VAR
// Comment that is not transferred.
BEGIN
    ;
END_FUNCTION_BLOCK
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4.1.7 Migrating projects (professional)

4.1.7.1 Migrating WinCC flexible 2008 projects

Basics (WinCC flexible)

Migration (WinCC flexible)

Introduction
You can continue to use projects in WinCC from WinCC flexible. The following versions of 
WinCC flexible are supported:

● WinCC flexible 2008 SP2

● WinCC flexible 2008 SP3

The following sections describe the HMI devices that are supported and the required basic 
conditions for a successful migration.

Projects from ProTool Pro and earlier WinCC flexible versions cannot be migrated directly to 
WinCC. If you want to continue using such projects in WinCC, you have to migrate these to a 
supported version of WinCC flexible first and change the HMI device type.   

If the project to be migrated contains components of a supported option package, the option 
package must be installed for successful migration to WinCC. If the option package is not 
installed, migration is canceled. This concerns the following option packages:

● SINUMERIK

The following option packages are not supported by the migration:

● ProAgent

● Open Platform Program - OPP

See also
Basics on migration (WinCC flexible) (Page 167)

Migrating projects from WinCC flexible (WinCC flexible) (Page 169)

Compiling and loading a migrated project (WinCC flexible) (Page 171)

Supported HMI devices (WinCC flexible) (Page 172)

Object support in the migration (WinCC flexible) (Page 177)

Migration of connections (WinCC flexible) (Page 181)

Migration of tags (WinCC flexible) (Page 184)

Migrating runtime data (WinCC flexible) (Page 194)

Migrating integrated projects (WinCC flexible) (Page 197)

Migrating data types (WinCC flexible) (Page 200)
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Basics on migration (WinCC flexible)

Introduction
In the migration the project data are converted from a WinCC flexible project into the new data 
format of WinCC. The data will not be evaluated to see if they are consistent in the project you 
want to migrate. If errors or warnings are output in a source project during compilation, these 
will not be resolved as part of the migration. This means you should be able to compile the 
project without errors prior to migration. Note the scope of a project during migration. The 
features of WinCC apply for migration. For additional information refer to the online help in 
chapter "Process visualization > Performance features > Engineering System".     

Unique object names
The objects are clearly identified by the folders in which they are contained in WinCC flexible. 
Screen objects in groups are clearly identified by the group name.       

In WinCC, an object name must be unique within an HMI device. The name of screen objects 
must be unique within a screen.

The uniqueness of the name is verified during migration. If a name is not unique according to 
the new rule, the object in question will be renamed. A renamed object will receive the suffix 
"#Mign", where "n" stands for a sequential number.

 

 Note
Changed OPC DA server name

If you have configured an OPC-DA server in the WinCC flexible project, the OPC-DA server 
is no longer available under the old name after migration. 

In the migrated project, change the name of the OPC-DA server to the following value for the 
OPC clients concerned: "OPC.SimaticHMI.CoRtHmiRTm". 

 

Points to note when renaming tags
If you have structured tags in folders in WinCC flexible, the name of the tag will be formed 
during migration from the folder name and the tag name. The names of the folders and tags 
are separated by the character \. The name of the tag after migration is then, for example: 
Plant1\Line3\Tag17.

If the name would otherwise be longer than 128 characters after migration, the name is formed 
by the character string #mig, a consecutive number, the character # and the tag name from 
WinCC flexible, for example #mig2#Tag17.

If you dynamically compose tag names in scripts, you must check the tags whose names were 
changed during migration with "#mig".
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Affected objects
The following objects are renamed if necessary:

● Screens

● Faceplates

● Screen objects

● Graphics

● Recipes

● Structures

● Structural elements

● Alarm logs

● Tags

● Data logs

● Connections

Cancelling migration
The migration is cancelled in the following cases:

● If the project to be migrated is opened in the engineering system or in Runtime.

● If not enough memory space is available on the hard disk to create a a copy for migration 
of the project.

● If the migration cannot address the project database due to problems with the installed SQL-
Server.

● If the migration cannot address the project database due to missing user authorization.

● If you select the "*.hmi" file for the migration in an integrated project. You must select the 
"*.s7" file for the migration in an integrated project.

● If the project was created with a version not supported by the migration.

Saving the project in the migration format 
You do not have to execute the migration of a WinCC flexible project completely on the PC on 
which the project is available. You can prepare the migration by saving the project in the 
migration format. The migration tool is available for saving a WinCC flexible project in the 
migration format. The migration tool exports the engineering data from the WinCC flexible 
project and saves the data in the migration format "*.AM11".   

For the actual migration, copy the data in the migration format to a PC on which the TIA-Portal 
is installed.

For more detailed information, please refer to the migration tool documentation.
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See also
Migration (WinCC flexible) (Page 166)

Engineering system (Page 7187)

Migrating projects from WinCC flexible (WinCC flexible)

Introduction
When you migrate a project, data from a WinCC flexible project is loaded into a new project 
for WinCC. A new project is therefore created automatically for project migration. You cannot 
migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal. 

Information on the migration of an integrated project can be found in the section Migrating 
integrated projects (WinCC flexible) (Page 197).

If you only want to save the project in migration format, you can use the migration tool. See 
Basics on migration (WinCC flexible) (Page 167) for additional information.

Requirement
● A project from WinCC flexible is available.

● The project is not open in WinCC flexible.
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Procedure
Migrate a project in the Portal view as follows:       

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the WinCC flexible project file "*.hmi".

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.

5. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– The project is saved and a message displayed upon completion of the migration. The 
message contains a link that you can use to open the log.
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When migration is complete, you will find a newly created device for each migrated HMI device 
in the project tree. These devices contain the migrated data, such as screens, alarms and tags.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Open the "Common data > Logs" folder in the project tree. It contains the logs of all 
previously performed migrations.

2. Double-click the required migration log.
The log is opened.

See also
Migration (WinCC flexible) (Page 166)

Migrating integrated projects (WinCC flexible) (Page 197)

Basics on migration (WinCC flexible) (Page 167)

Compiling and loading a migrated project (WinCC flexible)

Compiling a migrated project
Once you have successfully migrated a WinCC flexible project, you need to recompile it before 
loading it to the HMI device. The project will only compile successfully if it was capable of error-
free compiling prior to migration.

If errors occur during compilation of the migrated project, they have to be eliminated.

Once compiling is successfully completed, load the project to the HMI device.   

Settings for download to the HMI device
The settings for loading the HMI device are not included in the migration. Once you have 
migrated the project, you must configure the settings for loading.

Select the HMI device in the project tree and select "Loading in device > Software (complete 
loading)" from the shortcut menu.The dialog "Advanced Loading" is opened. Configure the 
required settings for the interface. Click the "Load" button. The project is recompiled and the 
dialog "Load preview" is opened.

Expand the "Overwrite" entry and verify the settings for the following options:

● Would you like to overwrite the existing user administration data from this device

● Would you like to overwrite the existing recipe data on HMI system

Configure the options as you want to use them in the project in the future. Subsequently, load 
the project to the HMI device.
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See also
Migration (WinCC flexible) (Page 166)

Migrating engineering data (WinCC flexible)

HMI devices (WinCC flexible)

Supported HMI devices (WinCC flexible)

Introduction
When migrating projects from WinCC flexible you must bear in mind that WinCC does not 
support all HMI devices. You have to distinguish between the following cases:

● HMI device is supported by WinCC.
The project is migrated 1:1 and gets the same HMI device after migration as before 
migration.

● The HMI device is replaced by a compatible successor model.
The project is migrated. The migration replaces the HMI device with a compatible successor 
model. See HMI device change by the migration (WinCC flexible) (Page 174) for additional 
information.

● HMI device is not supported.
If your WinCC flexible project contains an HMI device that is not supported by WinCC, the 
migration process is cancelled. To migrate the project, you must change the HMI device in 
WinCC flexible to a HMI device type supported by WinCC.

The following HMI device types are supported both by WinCC flexible and WinCC:

Basic Panels  
● KTP400 Basic mono PN

● KTP400 Basic mono PN Portrait

● KTP600 Basic DP

● KTP600 Basic DP Portrait

● KTP600 Basic PN

● KTP600 Basic PN Portrait

● KTP600 Basic mono PN

● KTP600 Basic mono PN Portrait

● KTP1000 Basic DP

● KTP1000 Basic PN

● TP1500 Basic PN
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Mobile Panels
● Mobile Panel 177 6'' DP

● Mobile Panel 177 6'' PN

● Mobile Panel 277 8''

● Mobile Panel 277 8'' IWLAN V2

● Mobile Panel 277F 8'' IWLAN V2

● Mobile Panel 277F 8'' IWLAN (RFID Tag)

● Mobile Panel 277 10''

Panels
● OP 73

● OP 77A

● OP 77B

● OP 177B 6'' mono

● OP 177B 6'' color PN/DP

● TP 177B 4'' color PN/DP

● TP 177A

● TP 177A Portrait

● TP 177B 6'' mono DP

● TP 177B 6'' color PN/DP

● OP 277 6''

● TP 277 6''

Multi Panels
● MP 177 6'' Touch

● MP 277 8'' Key

● MP 277 8'' Touch

● MP 277 10'' Key

● MP 277 10'' Touch

● MP 377 12'' Key

● MP 377 12'' Touch

● MP 377 15'' Touch

● MP 377 15" Touch daylight readable

● MP 377 19'' Touch
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Sinumerik PC
● OP 010 Key

● OP 012 Key

● OP 015 Key

● OP 015A Key

● TP 015A Touch+Key

HMI applications
● WinCC flexible Runtime

WinCC only supports the functions provided by these HMI device types.

Other functions which are not migrated because of the restricted device selection are 
documented in the following sections.

Adaptations before migration
If the HMI device was changed to an HMI device with a different screen size in the project to 
be migrated, you must recompile and save the project in WinCC flexible before the migration. 
The compilation process will adjust the size of the screens and screen elements.   

See also
Migration (WinCC flexible) (Page 166)

HMI device change by the migration (WinCC flexible) (Page 174)

Configuration change after HMI device change (WinCC flexible) (Page 177)

Object support in the migration (WinCC flexible) (Page 177)

Migration of connections (WinCC flexible) (Page 181)

HMI device change by the migration (WinCC flexible)

Introduction
WinCC flexible supports some HMI devices which are discontinued in the future. These HMI 
devices are no longer supported by WinCC. When migrating a WinCC flexible project, an HMI 
device that is not supported is replaced by a compatible successor device.

Only the HMI device type is changed during the migration. HMI device-specific data are not 
changed by the migration. 

Inconsistencies in the project may occur due to a change in the HMI device. In a project which 
was compilable before the migration, errors may occur in the project compilation after changing 
the HMI device. E.g. because the changed HMI device supports different memory media to 
the previous HMI device.
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HMI device change by the migration
The following table provides information about which successors replace the HMI devices that 
are not supported.

Unsupported HMI devices Successors
C7-635 6" Key MP 177 6“ Touch
C7-635 6" Touch MP 177 6“ Touch
C7-636 6" Key MP 177 6“ Touch
C7-636 10" Touch MP 277 10“ Touch
HT 8 PCU50.3 -C (resolution: 640*480)
Mobile Panel 170 6'' Mobile Panel 177 6'' DP
Mobile Panel 277 8'' IWLAN Mobile Panel 277 8'' IWLAN V2
Mobile Panel 277F 8'' IWLAN Mobile Panel 277F 8'' IWLAN V2
OP010 Key PCU50.3B -C (resolution: 640*480)
OP012 Key PCU50.3B -C (resolution: 800*600)
OP015 Key PCU50.3B -C (resolution: 1024*768)
OP 08T PCU50.3 -C (resolution: 640*480)
OP 73micro OP 73
OP 170B 6'' mono OP 177B 6'' color PN/DP
OP 270 6'' OP 277 6''
OP 270 10'' MP 277 10'' Key
TP015A Touch Key PCU50.3B (resolution: 1024*768)
TP 170A 6'' TP 177A 6''
TP 170B 6'' mono TP 177B 6'' color PN/DP
TP 170B 6'' color TP 177B 6'' color PN/DP
TP 170micro 6'' TP 177A
TP 177micro 6'' TP 177A
TP 270 6'' TP 277 6''
TP 270 10'' MP 277 10'' Touch
MP 270 6'' Touch TP 277 6''
MP 270 10'' Key MP 277 10'' Key
MP 270 10'' Touch MP 277 10'' Touch
MP 370 12'' Key MP 377 12'' Key
MP 370 12'' Touch MP 377 12'' Touch
MP 370 15'' Touch MP 377 15'' Touch
PC 477 12'' Key PC 477B 12'' Key PB
PC 477 12'' Touch PC 477B 12'' Touch PB
PC 477 15'' Key PC 477B 15'' Key PB
PC 477 15'' Touch PC 477B 15'' Touch PB
PC 477 19'' Touch PC 477B 19'' Touch PB
PC 577 12'' Key IPC 577C 12'' Key PB
PC 577 12'' Touch IPC 577C 12'' Touch PB
PC 577 15'' Key IPC 577C 15'' Key PB
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Unsupported HMI devices Successors
PC 577 15'' Touch IPC 577C 15'' Touch PB
PC 577 19'' Touch IPC 577C 19'' Touch PB
PC 670 10" Key HMI IPC677C 12" Key PB
PC 670 12'' Key PC 677B 12'' Key PB
PC 670 12'' Touch PC 677B 12'' Touch PB
PC 670 15'' Key PC 677B 15'' Key PB
PC 670 15'' Touch PC 677B 15'' Touch PB
PC 677 12'' Key PC 677B 12'' Key PB
PC 677 12'' Touch PC 677B 12'' Touch PB
PC 677 15'' Key PC 677B 15'' Key PB
PC 677 15'' Touch PC 677B 15'' Touch PB
PC 677 17'' Touch PC 677B 17'' Touch PB
PC 677 19'' Touch PC 677B 19'' Touch PB
PC 870 12" Key HMI IPC677C 12" Key PB
PC 870 15" Key HMI IPC677C 15" Key PB
PC 870 15" Touch HMI IPC677C 15" Touch PB
PC 877 12" Key HMI IPC677C 12" Key PB
PC 877 15" Key HMI IPC677C 15" Key PB
PC 877 15" Touch HMI IPC677C 15" Touch PB
PC 877 19" Touch HMI IPC677C 19" Touch PB
PC IL 70 12" Touch HMI IPC577C 12" Touch PB
PC IL 70 15" Touch HMI IPC577C 15" Touch PB
PC IL 77 12" Touch HMI IPC577C 12" Touch PB
PC IL 77 15" Touch HMI IPC577C 15" Touch PB
PC IL 77 19" Touch HMI IPC577C 19" Touch PB
PC IL 77 12" Key HMI IPC577C 12" Key PB
PC IL 77 15" Key HMI IPC577C 15" Key PB
P012T Touch IPC 677C 12'' Touch PB

(if a P350 is connected)
P012T Touch IPC 477C 12'' Touch PB 

(if a P320  is connected)

HMI device change by the user
If a project contains an HMI device that is not supported by WinCC and no compatible 
successor model exists, the migration is cancelled. If you want to migrate the project, you must 
change the HMI device to WinCC yourself before the migration. Use an HMI device which is 
supported both by WinCC flexible and WinCC for this.

See also
Supported HMI devices (WinCC flexible) (Page 172)
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Configuration change after HMI device change (WinCC flexible)
 

 Note

If you migrate a project with embedded screens, this can result in the project file becoming 
larger than the old project file. 

 

HMI device replacement by the migration
If the migration makes an HMI device replacement, it replaces the existing HMI device with a 
compatible successor model. The successor models are further developed and therefore more 
efficient than their predecessors. The new models therefore support all the properties of their 
predecessors. Therefore only a little rework is to be expected on the project due to the HMI 
device replacement.     

HMI device replacement by the user
if you change an HMI device yourself before the migration, you must ensure that the HMI 
device used supports all properties which are used in the project. Compile the project after the 
HMI device replacement in WinCC flexible. The project must be perfectly compilable before 
the migration. Then migrate the project to WinCC. 

See also
Supported HMI devices (WinCC flexible) (Page 172)

Object support in the migration (WinCC flexible)

Introduction
When migrating projects from WinCC flexible, all configuration data involving an HMI device 
supported by WinCC will be migrated. Basically, all object types and functions that are available 
and can be mapped to the new project environment will be fully migrated.

Some global object types are not migrated, for example, dictionaries and global libraries.

Supported object types
The following object types are supported for migration:

● Animations
Disabled animations are not migrated.

● Audit settings

● Audit reports

● Scheduler

● User administration
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● Area pointers

● Faceplates

● Screens

● Screen template

● Data types

● Function lists

● Graphics lists

● Display and operating elements
All display and operating elements that are available on the supported HMI devices are 
supported for migration.

● Alarms

● Alarm classes

● Alarm groups

● Project library

● Project languages

● Reports

● Recipes

● Runtime languages

● Runtime scripting

● Sm@rtAccess/Sm@rtService

● Structures

● System events

● System functions

● Texts

● Text lists

● Tags

● Connections

● Effective ranges

● Zones

● Cycles

Unsupported object types
The following object types are not supported by migration:

● Global libraries

● Dictionaries
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● Project versions

● Change log

Mapping of the screen navigation
WinCC does not support the screen navigation from WinCC flexible. The data of the screen 
hierarchy from WinCC flexible are not migrated. To map the functionality of a screen navigation 
from WinCC flexible, the naivigation buttons are migrated to the button available in WinCC. 
The system functions migrated to the "ActivateScreen" system function are migrated to the 
"Click" event of the respective button. The following system functions used in WinCC flexible 
are not available for the screen navigation in WinCC:

● ActivateRootScreen

● ActivateLeftScreen

● ActivateRightScreen

● ActivateParentScreen

● ActivateFirstChildScreen

These system functions are migrated to the "ActivateScreen" system function. The "Screen 
name" parameter is taken from the data of the screen hierarchy. If one of the named system 
functions is called from a screen which is not contained in the screen hierarchy, the 
"ActivateScreen" function is created without parameters. You must configure the desired 
screen to this system function after the migration.

Tab sequence in pictures with faceplates
In pictures with faceplates, the tab sequence is changed in both the screen and the faceplate 
as a result of the migration.

Migration of the screen template
WinCC offers an extended concept for working with screen templates. WinCC offers a global 
screen and several templates for each device. During migration of a template from 
WinCC flexible, the objects contained there and the properties configured in the template are 
migrated to the extended concept of the screen templates of WinCC.

The following objects are migrated to the "global screen" of WinCC:

● Alarm window

● Alarm indicator

● Help indicator

● Function keys of HMI devices with function keys

All other objects and properties are migrated to a template of WinCC.

The connection of the objects and properties to the respective template is automatically 
adapted.
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See also
Supported HMI devices (WinCC flexible) (Page 172)

Migration (WinCC flexible) (Page 166)

Changes of values of object properties by the migration (WinCC flexible) (Page 180)

Changes of values of object properties by the migration (WinCC flexible)

Introduction
The standardization of object properties from WinCC V7 and WinCC flexible requires changes 
to the object properties during the migration process. The migration calculates the changes in 
such a way that the representation of the objects after migration is the same as prior to 
migration. Changes made during migration result in different units of measurements and values 
in the configuration for some object properties. 

Migrating the font settings of an object
In WinCC V7 and WinCC flexible, the unit of measurement "point" is used to denote the size 
of the fonts used for an object. In WinCC, the unit of measurement "pixel" is used to denote 
the size of the fonts used for an object. During migration, the font size is converted accordingly 
to ensure that the representation of the font is the same size at zoom level 100%. The different 
units of measurement result in changes to the numerical values for the font sizes after 
migration.   

Example:

Font style before migration Font style after migration
Arial 10 points Arial 13 pixels
Arial 16 points Arial 21 pixels
Tahoma 10 points Tahoma 13 pixels
Tahoma 16 points Tahoma 21 pixels

Migration of object margins
In WinCC flexible, some objects permit the entry of values <0 and >127 for setup of the object 
margins for the configuration of the representation. In WinCC, the range of values for object 
margins is limited to values between 0 and 127. The migration changes values <0 to the value 
"0" and values >127 to the value "127".

See also
Object support in the migration (WinCC flexible) (Page 177)
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Connections (WinCC flexible)

Migration of connections (WinCC flexible)

Introduction
If you migrate a project in which a supported communication driver is used, this driver is used 
further in WinCC. Objects which communicate via this driver are migrated 1:1. No rework is 
necessary.

Not all communication drivers which are available in WinCC flexible are supported in WinCC. 
If an unsupported driver is used in the project to be migrated, there are two possible scenarios:

1. A compatible spare driver is available for the used driver.

2. No compatible spare driver is available for the used driver.

Compatible spare driver is available
If a driver is available in WinCC which addresses the used PLC or a comptaible PLC, the driver 
is automatically replaced during the migration.

You get an appropriate warning if the used driver is replaced.

In this case, check whether all the external tags and area pointers are valid after the migration 
by means of the migration report.

If the used driver is replaced, all the connection parameters are reset to the standard values. 
The CPU type is adapted to the appropriate PLC. The properties of the connected tags and 
area pointers are not changed.

Compatible spare driver is not available
If no driver is available in WinCC which addresses the used PLC or a compatible PLC, the 
configured connection is not migrated. All external tags which were connected to the PLC by 
this driver are converted into internal tags. External tag properties are lost in the conversion, 
e.g. the address in the PLC. All changes to the tags are recorded in the migration report.

You must reconnect the tags with the PLC after the migration and configuring of a connection.

You get an appropriate warning if the driver is not migrated.

Converting the communication driver
The following tables show the mapping of communication drivers from WinCC flexible to 
WinCC.
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Supported communication drivers

WinCC flexible WinCC
Allen Bradley DF1 Allen Bradley DF1
Mitsubishi FX Mitsubishi FX
Modicon MODBUS Modicon MODBUS RTU
Modicon MODBUS TCP/IP Modicon MODBUS TCP/IP
Omron Hostlink/Multilink Omron HostLink
OPC OPC
SIMATIC HMI HTTP Protocol SIMATIC HMI HTTP Protocol
SIMATIC S7 200 SIMATIC S7 200
SIMATIC S7 300/400 SIMATIC S7 300/400

Compatible communication drivers

WinCC flexible WinCC
Allen Bradley DH485 Allen Bradley DF1
Allen Bradley E/IP C.Logix Allen Bradley EtherNet/IP
Mitsubishi Protocol 4 Mitsubishi MC TCP/IP

Not supported communication drivers

WinCC flexible WinCC
GE Fanuc SNP Not supported
ISAC Not supported
LG GLOFA-GM Not supported
SIMATIC 500/505 DP Not supported
SIMATIC 500/505 serial Not supported
SIMATIC S5 AS511 Not supported
SIMATIC S5 DP Not supported
Telemecanique Uni-Telway Not supported

See also
Migration (WinCC flexible) (Page 166)

Supported HMI devices (WinCC flexible) (Page 172)

Adaptation of the configuration for non-migrated connection (WinCC flexible) (Page 183)

Migration of area pointers (WinCC flexible) (Page 184)

Migration of tags (WinCC flexible) (Page 184)
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Adaptation of the configuration for non-migrated connection (WinCC flexible)

Introduction
If a connection cannot be migrated you have the following options:

● Change the configuration in WinCC flexible before the migration

● Change the configuration after the migration

Change a connection before the migration
If the communication driver selected for the connection is not supported by the migration, you 
must select a driver which is supported by the migration. The HMI device must also support 
the selected communication driver.   

If no suitable driver is available for the used HMI device, you must use a suitable HMI device. 
Then adapt the configuration in WinCC flexible and recompile the project. Migrate the project 
after successful adaptation and compiling. The connection is then also migrated.

Changing a connection before the migration
If you migrate a WinCC flexible project in which the connection is not migrated, all external 
tags of this connection are mapped to internal tags. You receive an appropriate entry in the 
migration protocol for every tag concerned. 

You must configure a new connection after the migration. For this connection you select a 
communication driver which supports the used HMI device. If no suitable driver is available for 
the used HMI device, you must use a suitable HMI device.

If you have configured the new connection, you must reconnect all tags which were mapped 
to internal tags before the migration. Open the migration report to make reconfiguration easier. 
Reconfigure the tags according to the log entry.

If the project contained area pointers, you must also reconfigure these. You will also find 
corresponding entries for the area pointers in the migration log.

See the section Migrating projects from WinCC flexible (WinCC flexible) (Page 169) for further 
information about the migration log.

See also
Migration of connections (WinCC flexible) (Page 181)

Migrating projects from WinCC flexible (WinCC flexible) (Page 169)
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Migration of area pointers (WinCC flexible)

Introduction
The migration of area pointers depends on the used communication driver. 

● If the used communication driver is supported by the migration, area pointers from WinCC 
flexible are taken over unchanged in the migration.

● if the used communication driver is not supported by the migration, area pointers are not 
migrated.  

Migration of the area pointers
If the connection used by the area pointers is fully migrated, the area pointers are also fully 
migrated. The parameters of the area pointers are taken over unchanged.

If you replace the communication driver of the connection before the migration, check whether 
all the parameters of the area pointers are still valid after the migration.

If the connection used by the area pointer is not migrated, the area pointers are not migrated 
either. See Adaptation of the configuration for non-migrated connection (WinCC flexible) 
(Page 183) for additional information.

See also
Migration of connections (WinCC flexible) (Page 181)

Adaptation of the configuration for non-migrated connection (WinCC flexible) (Page 183)

Migration of tags (WinCC flexible)

Introduction
You need to make some special considerations when migrating tags. The following aspects 
should be distinguished:

● Migrating data types of tags

● Migrating internal tags

● Migrating external tags

● Tag names

● Tag limits

Migrating data types
WinCC features some other data types and uses different data type names than 
WinCC flexible. When migrating a relevant tag, the data type from WinCC flexible is mapped 
to the corresponding data type in WinCC. See Migrating data types (WinCC flexible) 
(Page 200) for additional information.
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Migrating internal tags
Internal tags are always migrated completely. Only the data type names and tag names may 
change due to migration.

Migrating external tags
If the connection used by the external tags is migrated, the external tags are also fully migrated. 
The migration of external tags depends on whether the used communication driver is supported 
by the migration. See Migration of connections (WinCC flexible) (Page 181) for additional 
information.

If the connection used by the external tags is not migrated, the external tags are not migrated 
either. The external tags are then mapped to internal tags. You must configure a new 
connection and reconnect the tags with the tags of the PLC after the migration.

Migrating names of tags
In WinCC flexible, tags located in different folders can have the same name. In WinCC, the 
tag name must be unique on the configured HMI device. This means that tags with the same 
name from different folders will be renamed during migration. See Basics on migration (WinCC 
flexible) (Page 167) for additional information.

See also
Migration of connections (WinCC flexible) (Page 181)

Migration (WinCC flexible) (Page 166)

Migration of alarm classes and alarm groups (WinCC flexible) (Page 186)

Migrating scripts (WinCC flexible) (Page 189)

Migration of language-dependent contents (WinCC flexible) (Page 190)

Migration of libraries (WinCC flexible) (Page 193)

Migrating data types (WinCC flexible) (Page 200)

Basics on migration (WinCC flexible) (Page 167)

Migrating structures (WinCC flexible)
In WinCC V12, the "StringChar" data type is not supported in HMI user data types. 

If you have used this data type in a structure in a WinCC flexible project, an invalid element is 
created by the migration in the HMI user data type.

After migration , you must re-work this user data type in WinCC and enable the user data type. 

At the same time, check the offset of the following elements and any existing interconnections 
between a faceplate and the elements of the user data type. Adapt the elements if required.
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Migration of logs

Storage location of logs
WinCC flexible allowed you to store logs in a database which was automatically set up upon 
WinCC flexible installation ("System-defined data source" setting). This option is not available 
in WinCC.

If you have used this setting in your WinCC flexible project, it will be changed to "User-defined 
name of data source" during migration. Before you can store logs in a database, you must 
configure an ODBC data source in the Windows control panel and configure the name of the 
user data source specified there as the "name of the data source" in the log in WinCC.

Migration of alarm classes and alarm groups (WinCC flexible)

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Error Alarms
System System
Warnings Events

The names of the alarm classes can be changed as necessary after migration.

Migrating alarm groups
Migration will migrate only those alarm groups actually in use.   

Alarm groups with an ID from 1-31 will be migrated 1:1.

A corresponding alarm group is created in WinCC for each alarm class in the system. These 
alarm groups created by the system are assigned IDs beginning with the number 32 and 
consecutively incremented. The 4 pre-defined message classes in every WinCC project are 
automatically given IDs 32-35 by their alarm groups. Additionally created alarm group and an 
additional ID is assigned to each user-defined alarm class. Therefore, the IDs for alarms groups 
with IDs > 31 may be changed after migration. This step also changes the assignment of the 
alarm group names to the IDs. 

Example:

In the example, you can see the assignment of the IDs in WinCC for the migration. 

Alarm groups ID in WinCC flexible ID in WinCC  
Alarm group 1-16 1-16 1-16 Default for alarm groups from system 

alarms
Alarm group 17-31 17-31 17-31 Custom alarm groups
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Alarm groups ID in WinCC flexible ID in WinCC  
  32-35 Default in WinCC for alarm groups of 

predefined alarm classes.
Alarm group 32 32 36 Changed assignment of ID to alarm group 

in WinCC
Alarm group 33 33 37 Changed assignment of ID to alarm group 

in WinCC

Also note:

When migrating alarm groups that supposedly have the same group name, the migration 
adapts the name. This occurs, for example, when a group name contains a space at the end 
of the name. The migration deletes all existing spaces at the end of names. If two groups 
obtained the same group names due to this deletion, the migration adds the suffix "# Mign" to 
the group name of the following alarm groups, where "n" stands for a sequential number.

Example:

The following alarm groups exist in WinCC flexible: 

"AlarmGroup_18"

"AlarmGroup_18 " - group name contains one space

"AlarmGroup_18 " - group name contains two spaces

"AlarmGroup_18" is the alarm group with the highest number. 

Result after migration:

"AlarmGroup_18"

"AlarmGroup_18#Mig1"

"AlarmGroup_18#Mig1.1"

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:   

WinCC flexible WinCC
Error Errors
System System
Warnings Warnings

The names of the alarm classes can be changed as necessary after migration.

Display of ALARM_S messages and SIMATIC SFM messages
In WinCC flexible you can activate the display classes for ALARM_S messages in integrated 
projects. In WinCC flexible, you activate the display of SIMATIC SFM messages via a separate 
setting. The separate setting for activating the display of SIMATIC SFM messages is not 
required in WinCC. You control the display of SIMATIC SFM messages, and also the display 
of ALARM_S messages in WinCC only by activating the corresponding display class.
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The changed concept may cause the display of messages to change following migration.

If all the display classes for ALARM_S messages are activated and the display of 
SIMATIC SFM messages is deactivated in the WinCC flexible project , ALARM_S messages 
and SIMATIC SFM messages are displayed following migration.

To ensure that only ALARM_S messages are displayed following migration, you have to assign 
the SIMATIC SFM messages to an unused display class after migration to STEP 7. You then 
have to deactivate this display class in WinCC.

If all the display classes for ALARM_S messages are deactivated and the display of 
SIMATIC SFM messages is activated in the WinCC flexible project , ALARM_S messages and 
SIMATIC SFM messages are not displayed following migration.

To ensure that only SIMATIC SFM messages are displayed following migration, you have to 
assign the SIMATIC SFM messages to an unused display class after migration to STEP 7. 
You then have to activate this display class in WinCC.

The display class is dependent on the settings in STEP 7. The default setting for SIMATIC SFM 
messages in Step 7 is the display class "0". To activate the display in WinCC, the display class 
"0" must be activated.

You activate the display class in WinCC in the Runtime settings of the respective HMI device 
in the "Messages" category.
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See also
Migration of tags (WinCC flexible) (Page 184)

Migrating scripts (WinCC flexible)

Introduction
The migration supports VB-scripts which were created in WinCC flexible. For a VB-script to 
be migrated successfully it must be functionable in WinCC flexible first.

 
 

 Note
Script errors

The most efficient way to locate scripting errors in the course of the initial test run after 
migration is to use an installed Script Debugger and the diagnostics controls.

 

Migration of a VB script
A script is analyzed in the migration and adapted to the system behavior of WinCC if necessary. 
The following is adapted:        

● System functions which have changed their names are renamed.
This concerns the following system functions:

Function name in WinCC flexible Function name in WinCC
IncreaseValue IncreaseTag
DecreaseValue DecreaseTag
SetBrightness SetAndGetBrightness
SetValue SetTag
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● The access to tags as parameters of system functions is adapted to the system behavior 
of WinCC. In WinCC scripts are no longer transfromed as in WinCC flexible. The scripts 
are executed directly as a source code. Therefore the stricter rules for the VBS syntax 
apply. A tag call is always migrated with inverted commas. If several parameter types are 
allowed for a system function, these are migrated with the keyword "SmartTags".
Example 1:
The value of the "temperature" tag should be incremented by the value "1".
Valid expressions in WinCC flexible:
IncreaseValue temperature, 1
IncreaseValue "temperature", 1
IncreaseValue SmartTags("temperature"), 1
Valid expression in WinCC:
IncreaseTag "temperature", 1
 
Example 2:
You use a system function on which several parameters are allowed. The value of the 
"temperature" tag should be incremented by the value of the "heatcontrol" tag.
Valid expression for WinCC flexible:
IncreaseValue "temperature", "heatcontrol"
Valid expression for WinCC:
IncreaseTag "temperature", SmartTags("heatcontrol")

● Objects renamed by the migration are also renamed in the script when using in a script. 
See the section Basics on migration (WinCC flexible) (Page 167) for further information 
about the renaming objects. You only have to observe the following rules when renaming 
objects:
If you address objects whose names are dynamically generated by the script with the help 
of a script, the object names in the script can not be automatically changed by the migration. 
In such a case, you have to correct the generation of the object names in the script after 
migration. 

 

See also
Migration of tags (WinCC flexible) (Page 184)

Basics on migration (WinCC flexible) (Page 167)

Migration of language-dependent contents (WinCC flexible)

Introduction
WinCC offers the same options for configuring projects in different languages as those 
available in WinCC flexible. All languages supported by WinCC are included in the migration 
of a project. 
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Migrating language-dependent content
The following language-dependent content is migrated:       

● Project languages

● Project texts

● Fonts for display in runtime

● Language-dependent graphics

You need to consider the following when migrating language-dependent content:

● The operating system on the PC performing the migration must support the project 
languages used in the project.

● The fonts used for runtime display must be installed on the PC performing the migration.

● Dictionaries are not supported by the migration.

Editiing language of integrated projects following migration
During migration of an integrated project, the project components to be migrated from STEP 7 
and WinCC flexible also bring their respective settings for the editing language. In WinCC there 
is only one editing language for all project components. Migration activates for the mgrated 
project the editing language which was set in STEP 7 prior to migration. If this setting is not 
the same as the setting from WinCC flexible, the configured texts are no longer visible in 
WinCC. No text is displayed at the usage locations, or only the entry "Text" can be seen. To 
make the texts visible, you must change the editing language. Click the "Tasks" taskcard at 
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the right-hand edge of the TIA portal and select the correct editing language in the "Language 
& Resources" area.

Unsupported languages
The migration of language-dependent content depends on whether or not WinCC supports the 
respective language. 

If a project only contains project languages not supported by WinCC, the project will not be 
migrated.

If a project contains supported and unsupported project languages, only the supported 
languages will be migrated. The editing language and reference language are set to a 
supported language.

The following languages are not supported by WinCC:

● Arabic

● Hebrew

● Dhivehi

● Gujarati

● Kannada
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● Tamil

● Telugu

● Urdu

● Punjabi

● Persian

● Syrian

See also
Migration of tags (WinCC flexible) (Page 184)

Migration of libraries (WinCC flexible)

Introduction
You need to consider two different cases when migrating from libraries:

1. Migrating a project library

2. Migrating a global library

Migrating a project library
A project library is stored together with the project data in the project file. For this reason, a 
project library is migrated with the same restrictions as the project data.   

Migrating a global library
Global libraries are not supported by the migration. The library objects used in the project will 
be migrated, however. The library objects are copied when used in the project and then no 
longer have a connection to the library.

To migrate a global library, you must copy or move the objects contained in the library to the 
project library. The objects are then included in the migration. In WinCC, you move the migrated 
objects to a new global library that is created. You can copy or move both individual objects 
or entire library categories.   

See also
Migration of tags (WinCC flexible) (Page 184)
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Migrating runtime data (WinCC flexible)

Migrating runtime data (WinCC flexible)

Introduction
Only the configuration data are migrated by the migration when migrating a project. The runtime 
data are not affected. You need to update the runtime data following migration.

The runtime data consists of the following: 

● Runtime project
The runtime project contains the compiled project data.

● Recipe data and user administration
The recipe data and user administration are data that can be changed in runtime.

● Log data
The data of tag logs and alarm logs are acquired and logged in runtime.

Migrating recipe data and user administration
If the recipe data and user administration were changed in runtime, you need to back up this 
information from the HMI device before you load the migrated project.

Depending on the used HMI device, you have different options for saving the above data.

If the HMI device supports external memory media and the recipe data are saved there, the 
data remain on the memory medium. External memory media are for example StorageCard 
or a network drive. You use the data again after the migration. The user adminsitration is not 
saved on an external memory medium so you have to save these data, e.g. with ProSave.

If the recipe data are saved in the internal memory of the HMI device, save these data on an 
external memory medium. Use ProSave to save the recipe data. If you have already configured 
appropriate system functions in your project, use the system functions. The following system 
functions are available for the recipe data:

● "ExportDataRecords" for the backup

● "ImportDataRecords" for the restore

You update the runtime project by compiling the project in WinCC again and loading it to the 
HMI device.

After you have loaded the migrated project on the HMI device, restore the recipe data and the 
user administration to the HMI device.

See also
Migration (WinCC flexible) (Page 166)

Backing up recipe data and user administration (WinCC flexible) (Page 195)

Restoring recipe data and user administration (WinCC flexible) (Page 196)

Backing up log data (WinCC flexible) (Page 197)
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Backing up recipe data and user administration (WinCC flexible)

Introduction
To continue using the recipe data and user administration in a migrated project, you first need 
to back up this data from the HMI device. Then load the data into the migrated WinCC project. 
Use ProSave to back up the data. 

Requirement
● The WinCC flexible project is running on the HMI device in Runtime.

● The HMI device is connected to a PC on which ProSave is installed.

Procedure
Proceed as follows to back up the recipe data and user administration:

1. Start ProSave.

2. Select the device type and the connection parameters in the "General" tab.

3. Open the "Backup" tab.

4. Select the "Recipes from the device memory" entry in the "Data type" box.
Do not select "Complete backup" because otherwise you will not be able to select separately 
when restoring the recipe data.

5. Navigate to the desired location in the "Save as" box and click "Start Backup".
The recipe data are saved.

6. Select "User administration" in the "Data type" box and click "Start Backup".
The user administration is saved.

For additional information refer to the online help for ProSave.

Alternative procedure
ProSave is automatically installed with WinCC flexible. The entire functional range of ProSave 
is available on the configuration PC within WinCC flexible via the menu command "Project > 
Transfer".

Alternatively, you can back up the recipe data and user administration via the ProSave 
integrated in WinCC flexible. Start WinCC flexible and select the menu command "Project > 
Transfer > Backup". Back up the recipe data and user administration as described in steps 4-6.

See also
Migrating runtime data (WinCC flexible) (Page 194)
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Restoring recipe data and user administration (WinCC flexible)

Introduction
To continue using saved recipe data and user administration after the migration, you first need 
to compile the migrated project and load it to the HMI device. You can then transfer the saved 
data to the HMI device. Use ProSave to restore the data. 

Requirement
● The migrated project has been transferred to the HMI device and is running in runtime.

● The HMI device is connected to a PC on which ProSave is installed.

Procedure
Proceed as follows to load the saved recipe data and user administration to the HMI device:

1. Start ProSave.

2. Select the device type and the connection parameters in the "General" tab.

3. Open the "Restore" tab.

4. Navigate to the location of the saved recipe data in the "Opening..." box and select the file.

5. Click "Start Restore".
The recipe data will be transferred to the HMI device..

6. Repeat steps 4-5 to restore the user administration.
The user administration will be transferred to the HMI device.

For additional information refer to the online help for ProSave.

Alternative procedure
ProSave is automatically installed with WinCC. The entire functional range of ProSave is 
available on the configuration PC within WinCC flexible via the menu command "Project > 
Transfer".

You can also restore the recipe data and user administration via the ProSave integrated in 
WinCC. Start WinCC and select the menu command "Online > Device maintenance > 
Restore". Restore the recipe data and user administration as described in steps 4-6.

See also
Migrating runtime data (WinCC flexible) (Page 194)
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Backing up log data (WinCC flexible)

Introduction
If an HMI device supports external memory media and the log data are saved there, the data 
remain on the memory medium. External memory media are for example StorageCard or a 
network drive. If a log is saved on an external memory medium, the migrated project accesses 
this storage location again after the migration. In this case the log data must not be backed up.

Backing up log data
If you want to back up the log data externally before the migration, you have the following 
options:

● Backup with the "ArchiveLogFile".
If you have already configured the "ArchiveLogFile" function in the WinCC flexible project, 
use this function to back up the data.

● Copy the log files by Copy&Paste with the Windows Explorer to an external memory 
medium or network drive.

See also
Migrating runtime data (WinCC flexible) (Page 194)

Migrating integrated projects (WinCC flexible)

Migrating integrated projects (WinCC flexible)

Introduction
The controllers and HMI devices contained in a project integrated in STEP 7 are linked together 
by the configuration. The configuration data of WinCC flexible and STEP 7 are also connected. 
When an integrated project is migrated, the complete project will be migrated with components 
from WinCC flexible and STEP 7. The connections remain intact.

 
 

 Note

It is advisable to compile and save an integrated project in WinCC flexible before you migrate 
it. You can be sure that the data in WinCC flexible and STEP 7 is synchronized if compilation 
was completed without errors.

 

Migrating an integrated project
When migrating an integrated project, the same requirements apply for the WinCC flexible 
component as those for the migration of a non-integrated WinCC flexible project. The objects 
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and properties contained in the WinCC flexible component must be supported by WinCC, for 
example, the HMI device or the communication driver. The "Online" property must be activated 
on the configured connection. A connection with deactivated "Online" property is not migrated.

In addition to the requirements for the WinCC flexible component, there are also requirements 
for the STEP 7 component of the integrated project. The objects and properties contained in 
the STEP 7 V5.4 SP5 or V5.5 component must be supported in STEP 7. For detailed 
information, refer to the documentation for STEP 7.     

To fully migrate an integrated project and then edit it, the following components must be 
installed on the PC performing the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC flexible 2008 SP2 or WinCC flexible 2008 SP3

● STEP 7

If you only want to save the project in migration format, you can use the migration tool. See 
Basics on migration (WinCC flexible) (Page 167) for additional information.

An integrated project is always fully migrated. If you only want to migrate the WinCC flexible 
project it contains, you need to separate it from the STEP 7 project before the migration. To 
separate the project from the integrated form, open the project in STEP 7 V5.4 SP5 or V5.5. 
Open the WinCC flexible project in the SIMATIC Manager. The project is opened with 
WinCC flexible. In WinCC flexible, select the menu command "Project > Copy project from 
STEP 7". WinCC flexible saves a non-integrated copy of the project.

See also
Migration (WinCC flexible) (Page 166)

Migrating an integrated project (WinCC flexible) (Page 198)

Basics on migration (WinCC flexible) (Page 167)

Migrating an integrated project (WinCC flexible)

Introduction
When migrating an integrated project, the components from both the WinCC flexible project 
and the STEP 7 project will be migrated. This means you need to select the project file with 
the file extension "*.s7p" for migration. During migration, the data is copied from the existing 
project and migrated to a new project. You cannot migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal.

If you only want to save the project in migration format, you can use the migration tool. For 
more information, refer to basics of migration (WinCC flexible).

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Professional V13.0
198 System Manual, 02/2014



Requirement
● STEP 7 V5.4 SP5 or STEP 7 V5.5 and all add-on packages used are installed.

● STEP 7 and all add-on packages used are installed.

● The TIA portal is newly started.

● No project is open in WinCC.

● An integrated project is available.

● The integrated project is not open.

Procedure
To migrate an integrated project in the portal view, follow these steps:       

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the "*.s7p" project file.

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.
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5. To migrate the project with hardware configuration, activate "Include hardware 
configuration".

6. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– A message is displayed upon completion of the migration. The message contains a link 
that you can use to open the log.

7. Once migration is completed, save the project.

Once the migration is complete, you will find a newly created device for each migrated HMI 
device and controller in the project tree. These devices include the migrated data.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Open "Shared data > Logs" in the project navigation.

2. Double-click the log file. The migration log opens.

See also
Migrating integrated projects (WinCC flexible) (Page 197)

Basics on migration (WinCC flexible) (Page 167)

Reference (WinCC flexible)

Migrating data types (WinCC flexible)

Introduction
To harmonize the data types used by PLCs and HMI systems, some data types of the internal 
HMI tags are renamed. The naming takes place in accordance with IEC conventions. Because 
only the names change, there are no changes to the internal tags for the configuration. 

The following table describes the mapping of the internal data types from WinCC flexible to 
the data types in WinCC.
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Migrating internal data types
The internal data types are mapped as follows during migration:    

Internal data types WinCC flexible Internal data types WinCC
Bool Bool
Char SInt
Byte USInt
Int Int
UInt UInt
Long DInt
ULong UDInt
Float Real
Double LReal
String WString
DateTime DateTime

Migrating external data types
See the following pages for how to map the available communication drivers.

See also
Migration (WinCC flexible) (Page 166)

Migrating data types of Allen-Bradley DF1 (WinCC flexible) (Page 202)

Migrating data types of Allen-Bradley DF485 (WinCC flexible) (Page 202)

Migrating data types of Allen-Bradley Ethernet IP (WinCC flexible) (Page 203)

Migrating data types of GE Fanuc SNP (WinCC flexible) (Page 203)

Migrating data types of LG GLOFA GM (WinCC flexible) (Page 204)

Migrating data types of Mitsubishi FX (WinCC flexible) (Page 205)

Migrating data types of Modicon Modbus (WinCC flexible) (Page 206)

Migrating data types of Modicon Modbus TCP/IP (WinCC flexible) (Page 207)

Migrating data types of Omron Hostlink/Multilink (WinCC flexible) (Page 207)

Migrating data types of OPC (WinCC flexible) (Page 208)

Migrating data types of SIMATIC 500/505 DP (WinCC flexible) (Page 208)

Migrating data types of SIMATIC 500/505 serial (WinCC flexible) (Page 209)

Migrating data types of SIMATIC S5 AS511 (WinCC flexible) (Page 210)

Migrating data types of SIMATIC S5 DP (WinCC flexible) (Page 210)

Migrating data types of SIMATIC S7 200 (WinCC flexible) (Page 211)

Migrating data types of SIMATIC S7 300/400 (WinCC flexible) (Page 211)
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Migrating data types of Telemecanique Uni-Telway (WinCC flexible) (Page 214)

Migrating data types of Mitsubishi Protocol 4 (WinCC flexible) (Page 205)

Migrating data types of SIMATIC HMI HTTP Protocol (WinCC flexible) (Page 209)

Migrating data types of Allen-Bradley DF1 (WinCC flexible)

Migrating data types Allen-Bradley DF1
The data types of the Allen-Bradley DF1 communication driver are mapped as follows in the 
migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
ASCII ASCII
BCD4 UInt
BCD8 UDInt
Bit Bool
Int Int
Long DInt
Real Real
UInt UInt
ULong UDInt

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of Allen-Bradley DF485 (WinCC flexible)

Migrating data types Allen-Bradley DH485
The Allen-Bradley DH485 communication driver is not supported by WinCC, it is replaced by 
the Allen-Bradley DF1 driver. The data types of the Allen-Bradley DH485 communication driver 
are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
ASCII ASCII
Bit Bool
Int Int
Long DInt
Real Real
UInt UInt
ULong UDInt
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See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of Allen-Bradley Ethernet IP (WinCC flexible)

Migrating data types Allen-Bradley Ethernet IP
The data types of the Allen-Bradley Ethernet IP communication driver are mapped as follows 
in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
DInt DInt
Int Int
Real Real
SInt SInt
String String
UDInt UDInt
UInt UInt
USInt USInt

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of GE Fanuc SNP (WinCC flexible)

Migrating data types GE Fanuc SNP
The GE Fanuc SNP communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the GE Fanuc SNP 
communication driver are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
BCD4 UInt
BCD8 UDInt
Bit Bool
Byte USInt
DInt DInt
Word UInt
Int Int
Real Real
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Data type in WinCC flexible Data type in WinCC
UInt UInt
DWord UDInt

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of LG GLOFA GM (WinCC flexible)

Migrating data types LG GLOFA GM
The LG GLOFA GM communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the LG GLOFA GM 
communication driver are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte USInt
DInt DInt
DWord UDInt
Int Int
SInt SInt
String WString
Time UDInt
UDInt UDInt
UInt UInt
USInt USInt
Word UInt

See also
Migrating data types (WinCC flexible) (Page 200)
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Migrating data types of Mitsubishi FX (WinCC flexible)

Migrating data types Mitsubishi FX
The data types of the Mitsubishi FX communication driver are mapped as follows in the 
migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
12 Bit Block 12-Bit Block
16 Bit Block 16-Bit Block
20 Bit Block 20-Bit Block
24 Bit Block 24-Bit Block
28 Bit Block 28-Bit Block
32 Bit Block 32-Bit Block
4 Bit Block 4-Bit Block
8 Bit Block 8-Bit Block
Bit Bool
Double DWord
IEEE-Float Real
String String
Word Word

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of Mitsubishi Protocol 4 (WinCC flexible)

Migrating data types Mitsubishi Protocol 4
The Mitsubishi Protocol 4 communication driver is not supported by WinCC, it is replaced by 
the Mitsubishi MC TCP/IP driver. The data types of the Mitsubishi Protocol 4 communication 
driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
4 Bit Block 4-Bit Block
8 Bit Block 8-Bit Block
12 Bit Block 12-Bit Block
16 Bit Block 16-Bit Block
20 Bit Block 20-Bit Block
24 Bit Block 24-Bit Block
28 Bit Block 28-Bit Block
32 Bit Block 32-Bit Block
Bit Bool
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Data type in WinCC flexible Data type in WinCC
DInt DInt
DWord DWord
Int Int
Real Real
String String
Word Word

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of Modicon Modbus (WinCC flexible)

Migrating data types Modicon Modbus
The Modicon Modbus communication driver is not supported by WinCC, it is replaced by the 
Modicon Modbus RTU driver. The data types of the Modicon Modbus communication driver 
are mapped as follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
+/-Double  +/- Double
+/-Int  +/- Int
16 Bit Group 16 Bit Group
ASCII ASCII
Bit Bit
Double Double
Float Float
Int Int

See also
Migrating data types (WinCC flexible) (Page 200)
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Migrating data types of Modicon Modbus TCP/IP (WinCC flexible)

Migrating data types Modicon Modbus TCP/IP
The data types of the Modicon Modbus TCP/IP communication driver are mapped as follows 
in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double  +/- Double
+/-Int  +/- Int
16 Bit Group 16 Bit Group
ASCII ASCII
Bit Bit
Double Double
Float Float
Int Int

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of Omron Hostlink/Multilink (WinCC flexible)

Migrating data types Omron Hostlink/Multilink
The Omron Hostlink/Multilink communication driver is not supported by WinCC, it is replaced 
by the Omron Host Link driver. The data types of the Omron Hostlink/Multilink communication 
driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-DEC Int
+/-LDEC DInt
ASCII String
BIN Bool
BYTE Byte
DEC UInt
IEEE Real
LDEC UDInt

See also
Migrating data types (WinCC flexible) (Page 200)
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Migrating data types of OPC (WinCC flexible)

Migrating data types OPC
The data types of the OPC communication driver are mapped as follows in the migration to 
WinCC:   

Data type in WinCC flexible Data type in WinCC
Bool VT_BOOL
Byte VT_UI1
Char VT_I1
Date VT_DATE
Double VT_R8
DWord VT_UI4
Float VT_R4
Long VT_I4
Short VT_I2
String VT_BSTR
Word VT_UI2

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of SIMATIC 500/505 DP (WinCC flexible)

Migrating data types SIMATIC 500/505 DP
The SIMATIC 500/505 DP communication driver is not supported by WinCC, the data types 
are mapped to the internal data types of WinCC. The data types of the SIMATIC 500/505 DP 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double DInt
+/-Int Int
ASCII WString
Bit Bool
Double UDInt
Int UInt
Real Real

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Professional V13.0
208 System Manual, 02/2014



Migrating data types of SIMATIC 500/505 serial (WinCC flexible)

Migrating data types SIMATIC 500/505 seriell
The SIMATIC 500/505 seriell communication driver is not supported by WinCC, the data types 
are mapped to the internal data types of WinCC. The data types of the SIMATIC 500/505 seriell 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Double DInt
+/-Int Int
ASCII WString
Bit Bool
Double UDInt
Int UInt
Real Real

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of SIMATIC HMI HTTP Protocol (WinCC flexible)

Migrating data types SIMATIC HMI HTTP Protocol
The data types of the SIMATIC HMI HTTP Protocol communication driver are mapped as 
follows in the migration to WinCC:  

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte USInt
Char SInt
DateTime DateTime
Double LReal
Float Real
Int Int
Long DInt
String WString
UInt UInt
ULong UDInt

See also
Migrating data types (WinCC flexible) (Page 200)
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Migrating data types of SIMATIC S5 AS511 (WinCC flexible)

Migrating data types SIMATIC S5 AS511
The SIMATIC S5 AS511 communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the SIMATIC S5 AS511 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
Bit in D Bool
Bit in W Bool
DF DInt
DH UDInt
KC WString
KF Int
KG Real
KH UInt
KM UInt
KT UDInt
KY UInt
KZ UInt

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of SIMATIC S5 DP (WinCC flexible)

Migrating data types SIMATIC S5 DP
The SIMATIC S5 DP communication driver is not supported by WinCC, the data types are 
mapped to the internal data types of WinCC. The data types of the SIMATIC S5 DP 
communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
Bit in D Bool
Bit in W Bool
DF DInt
DH UDInt
KC WString
KF Int
KG Real
KH UInt
KM UInt
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Data type in WinCC flexible Data type in WinCC
KT UDInt
KY UInt
KZ UInt

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of SIMATIC S7 200 (WinCC flexible)

Migrating data types SIMATIC S7 200
The data types of the SIMATIC S7 200 communication driver are mapped as follows in the 
migration to WinCC:     

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte Byte
Char Char
DInt DInt
DWord DWord
Int Int
Real Real
StringChar StringChar
Timer Timer
Word Word

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of SIMATIC S7 300/400 (WinCC flexible)

Migrating data types SIMATIC S7 300/400
The data types of the SIMATIC S7 300/400 communication driver are mapped as follows in 
the migration to WinCC:     

Data type in WinCC flexible Data type in WinCC
Bool Bool
Byte Byte
Char see below
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Data type in WinCC flexible Data type in WinCC
Counter see below
Date Date
Date and Time Date_And_Time
DInt DInt
DWord DWord
Int Int
Real Real
String String
StringChar see below
Time Time
Time of Day Time_Of_Day
Timer see below
Word Word

Special considerations for some data types
There are special considerations to be made when migrating external tags that contain data 
types of a SIMATIC S7-300/400 PLC.

Mapping of the S7 data type "Char"
The S7 data type "Char" is a data type for mapping characters according to the specification. 
However, since this data type is often used for reading and writing numerical values, it is 
mapped in WinCC to the S7 data type "Byte". If this should be the case during migration, an 
alarm will appear in the output window.

If the S7 data type "Char" is used for numerical values and negative numbers were configured 
at the point of use, the result is an error in mapping to the S7 data type "Byte". The S7 data 
type "Byte" cannot map any negative numbers. You have to adapt the configuration accordingly 
to correct the error. Use a signed data type, such as the data type "Int", for processing positive 
and negative numerical values.

If the S7 data type "Char" is used for mapping characters, you must change the configuration 
after migration. To represent characters, use the data type "String".

When an integrated project is migrated, the data type "Char" in WinCC is also migrated to the 
data type "Byte". With a connected PLC tag, the data type "Char" remains "Char". As a result 
of changing the data type of the HMI tag, symbolic addressing of the tags in question is not 
migrated. After migration. the tags are interconnected by absolute addresses and continue to 
work. If you want to restore symbolic addressing, you have to change the configuration 
accordingly after the migration.

Mapping an array of the S7 data type "Char"
An array of the S7 data type "Char" is mapped to an array of the data type "Byte" during 
migration.

If an array of the S7 data type "Char" is used for numerical values and negative numbers were 
configured at the point of use, the result is an error in mapping to an array of the S7 data type 
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"Byte". The S7 data type "Byte" cannot map any negative numbers. You have to adapt the 
configuration accordingly to correct the error. Use a signed data type, such as the data type 
"Int", for processing positive and negative numerical values.

Mapping of the S7 data type "Counter"
An external tag with the S7 data type "Counter" with counter address is mapped to the S7 data 
type "Counter". The address will be retained.

If an external tag with the S7 data type "Counter" addresses a data block or a bit memory 
address, it is is mapped to the S7 data type "Word". The address will be retained. The migration 
sets the coding to "SimaticBCDCounter".

The S7 data type "Counter" has a value range of 0-999. When supplied by the S7 data type 
"Word" the value range may be exceeded on the PLC side. Ensure that you are observing the 
value range.

Example:

WinCC flexible

Tag S7 data type Address Comment
Counter_Actual_Value Counter C10 BCD coded counter value
Counter_Setpoint_Value Counter DB10.DBW200 BCD coded counter value
Counter_Setpoint_Value#2 Counter MW20 BCD coded counter value

WinCC

Tag S7 data 
type

Address Coding Comment

Counter_Actual_Value Counter %C10 <Standard> BCD coded counter 
value

Counter_Setpoint_Value Word %DB10.%DB
W200

SimaticBCDCounter BCD coded counter 
value

Counter_Setpoint_Value#2 Word %MW20 SimaticBCDCounter BCD coded counter 
value

Mapping of the data type "StringChar"
In WinCC there is no corresponding data type to which the "StringChar" data type can be 
mapped. Mapping in WinCC depends on the property "Length" of the S7 data type.

A tag of the "StringChar" data type with the "Length" property > 1 is migrated to an array of 
the S7 data type "Char". The length of the array corresponds to the length of the originally 
configured data type "StringChar".

If the property "Length" = 1, the data type in WinCC is migrated to an array of the S7 data type 
"Char" with length = 1. The expression for an array with an element is "Array[0 ..0] of Char".
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Mapping of the S7 data type "Timer"
An external tag with the S7 data type "Timer" with timer address is mapped to the S7 data type 
"Timer". The address will be retained.

If an external tag with the S7 data type "Timer" addresses a data block or a bit memory address, 
it is is mapped to the S7 data type "S5 Time". The address will be retained.

Example:

WinCC flexible

Tag S7 data type Address Comment
Timer_Actual_Value Timer T10 BCD coded timer value
Timer_Setpoint_Value Timer DB10.DBW200 BCD coded timer value
Timer_Setpoint_Value#2 Timer MW20 BCD coded timer value

WinCC

Tag S7 data type Address Comment
Timer_Actual_Value Timer %T10 BCD coded timer value
Timer_Setpoint_Value S5Time %DB10.%DBW200 BCD coded timer value
Timer_Setpoint_Value#2 S5Time %MW20 BCD coded timer value

See also
Migrating data types (WinCC flexible) (Page 200)

Migrating data types of Telemecanique Uni-Telway (WinCC flexible)

Migrating data types Telemecanique Uni-Telway
The Telemecanique Uni-Telway communication driver is not supported by WinCC, the data 
types are mapped to the internal data types of WinCC. The data types of the Telemecanique 
Uni-Telway communication driver are mapped as follows in the migration to WinCC:   

Data type in WinCC flexible Data type in WinCC
+/-Int Int
+/-Long DInt
ASCII WString
Bool Bool
Float Real
Int UInt
Long UDInt
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See also
Migrating data types (WinCC flexible) (Page 200)

4.1.7.2 Migrating WinCC V7.2 projects

Basics (WinCC V7.2)

Migration (WinCC V7.2)

Supported versions
You can migrate projects from WinCC V7.2 to WinCC V13.

Projects from earlier WinCC versions cannot be migrated directly to WinCC V13. If you want 
to continue using such projects in WinCC V13, you have to migrate them to a supported version 
of WinCC V7.2 first.

1. Open the project in WinCC V7.2.

2. Select "Convert screens" from the shortcut menu of the Graphic Designer.

3. Open the Alarm Logging editor.

Projects which can be migrated without constraints
The following project types are supported:

● Single-user projects

● Multi-user projects

Projects from WinCC V7.2 are migrated to WinCC Runtime Professional devices. 

Migrating projects with redundant systems
When a redundant system is configured in WinCC V7.2, the configuration of the redundant 
partner is migrated.

Projects which cannot be migrated
It is not possible to migrate WinCC V7.2 projects with the following devices or functions:

● Multi-Client

● CAS

● Connectivity Station

● Maintenance Station

The migration is terminated and an alarm is generated.
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See also
Basics of migration (WinCC V7.2) (Page 216)

Migrating projects from WinCC V7.2 (WinCC V7.2) (Page 217)

Starting Runtime (WinCC V7.2) (Page 220)

Changing the project name by migration (WinCC V7.2) (Page 222)

Object support during migration (WinCC V7.2) (Page 223)

Migration of connections (WinCC V7.2) (Page 225)

Migration of tags (WinCC V7.2) (Page 228)

Migration of user objects (WinCC V7.2) (Page 234)

Migration of alarms and alarm groups (WinCC V7.2) (Page 240)

Migration of functions and actions (WinCC V7.2) (Page 242)

Basics on migration of reports (WinCC V7.2) (Page 245)

Copying runtime data (WinCC V7.2) (Page 252)

Migration of data types (WinCC V7.2) (Page 253)

Basics of migration (WinCC V7.2)

Introduction
For migration, the project data are converted from a WinCC V7.2 project into the new data 
format of WinCC. The data will not be evaluated to see if they are consistent in the project you 
want to migrate. If the source project contains errors, these will not be remedied in the 
migration. This means that the project to be migrated should be free from errors prior to 
migration. Note the scope of a project during migration. The features of WinCC apply for 
migration. For additional information refer to the online help in section "Process visualization 
> Performance features > Engineering System".     

Requirements for the migration
Several basic requirements need to be considered in order to perform the migration.

● The project to be migrated may not be open, neither in the WinCC V7.2 Explorer nor in 
Runtime.

● There must be enough free space on the PC hard disk for the migration. During migration, 
the requirement for disk space can amount to 10 times the size of the WinCC V7.2 project 
without runtime data.

Cancelling migration
The migration is cancelled in the following cases:

● If the project to be migrated is opened in the engineering system or in Runtime.

● If not enough space is available on the hard disk to create a copy for migration of the project.
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● If the migration cannot address the project database due to problems with the installed SQL-
Server.

● If the migration cannot address the project database due to missing user authorization.

● If the project was created with a version not supported by the migration.

● If an Active-X control which is not registered in the operating system is used in the project.

Preparing project with the migration tool
You do not have to execute the migration of a WinCC V7.2 project on the PC on which WinCC 
is installed. 

You can use the migration tool to prepare the migration on a PC on which WinCC V7.2 is 
installed. The migration tool exports the engineering data from the WinCC V7.2 project and 
saves the data in the format "*.am13".   

For the actual migration, copy the data to the PC on which WinCC is installed.

See the section "Preparing project with the migration tool" for more information on the migration 
tool.

See also
Migration (WinCC V7.2) (Page 215)

Migrating projects from WinCC V7.2 (WinCC V7.2)

Introduction
Data from a WinCC V7.2 project are loaded into a new project for WinCC when a project is 
migrated. A new project is therefore created automatically for project migration. You cannot 
migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

Requirement
● A project from WinCC V7.2 is available.

● The project is not open in WinCC V7.2.
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Procedure
Migrate a project in the Portal view as follows: 

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the WinCC V7.2 project file "*.mcp".

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.
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5. To migrate all of the runtime data of the project, select "Copy WinCC Runtime Professional 
data". 
These runtime data are visible only after they are loaded on the target device. 

6. Click "Migrate". 
A new project is created and the migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a log file.

– The project is saved and a message displayed upon completion of the migration. The 
message contains a link that you can use to open the log.

After the migration you can find a newly created device in the project tree for every migrated 
PC system. These devices contain the migrated data, such as screens, alarms and tags. In a 
multistation project, a device is created for every Client and the Server in the project tree of 
WinCC. 

Once the project is successfully migrated, a notice appears reporting the success.

Opening the migration log at a later point in time
The migration log is saved together with the migrated project. You can view the log at a later 
point in time. Open the log as follows:

1. Open the "Common data > Logs" folder in the project tree. It contains the logs of all 
previously performed migrations.

2. Double-click the required migration log.
The log is opened.

See also
Migration (WinCC V7.2) (Page 215)

Adapting a project (WinCC V7.2)

Causes:
You must adapt a project when you migrate it. The required post-configuration is caused by:

● Messages that occur during the migration and are entered in the migration log.

● Data which was inconsistent or invalid in the project to be migrated. WinCC has stringent 
criteria for checking, for example, the validity of the tag addresses or the length of object 
names. Invalid information is not corrected by the migration.
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Criteria for messages during the migration
Messages are issued in the migration log during the migration:

● If a property was changed by the migration, a message is output in the migration log.

● If a property has the state "Invalid" after the migration, because a tag is outside the value 
range, for example, no message is issued in the migration log. You can recognize the 
"Invalid" state in the Engineering System, by the entry fields highlighted in color, for 
example. When you compile a project, messages for the invalid information are output in 
the inspector window.

Adapting project and starting Runtime
1. Edit the messages in the migration log.

2. In the project tree, click on the migrated project.

3. Select the "Compile > Software" command in the shortcut menu.

4. Edit the error messages in the Inspector window:

Starting Runtime (WinCC V7.2)

Starting Runtime
As in WinCC V7.2, you can start Runtime directly on a PC on which the engineering system 
is installed. To do this, select the menu command "Online > Start Runtime" or the command 
"Start Runtime" from the shortcut menu of the device in the project tree.

Load the project on a PC with WinCC Runtime Professional.
WinCC also provides the option of transferring the project to a PC on which only WinCC 
Runtime Professional is installed. To do this, you must load the project onto the relevant target 
computer. No information is available in a WinCC V7.2 project for loading onto another target 
computer. The migration cannot therefore migrate any data for communication with another 
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target computer. To load a migrated project onto another target computer, you must configure 
the necessary settings in WinCC.     

1. Double click the "Device configuration" item in the project tree. The "Devices & Networks" 
editor opens.    

2. Select the "WinCC RT Professional" device in the device view.

3. Navigate to the target computer in the inspector window under "Properties > Load" by using 
the "Path to target computer" field. Click "OK" to confirm your selection.

4. Select the "WinCC RT Professional" device in the project tree and select the "Load to device 
> Software (load completely)" command in the shortcut menu.
The project is recompiled and checked. The "Load preview" dialog opens.

5. If the check is successfully completed, click the "Load" button.
The project is loaded onto the target computer.

6. Start WinCC on the target computer "WinCC StartTool" and open the loaded project.

See also
Migration (WinCC V7.2) (Page 215)
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Changing the project name by migration (WinCC V7.2)

Introduction
If you have migrated a WinCC V7.2 project, the migrated project is displayed in the WinCC 
project tree as a new device with the name of the WinCC V7.2 project.

When you compile the migrated project, WinCC renames the Runtime project and the folder 
that contains it. This prevents the path length of 256 characters allowed in Windows from being 
exceeded. The Runtime project therefore has a different name to the device in the project 
tree.       

Starting Runtime
You can ignore the new name when you start Runtime on the configuration PC. Open the 
project in WinCC and start Runtime with the "Online > Start Runtime" menu command.

The following rules apply if you want to start the project on a PC on which no WinCC 
engineering system is installed.

● You must use the menu command "Extended download to device" for the first loading 
process.

● WinCC Runtime creates the "WinCCProjects" authorization directory during the installation. 
In the "Extended loading" dialog, you enter the path for the authorization directory on the 
target device in the "Target path" field. Alternatively you navigate to the authorization 
directory with the navigation button.

● When you subsequently load the project, it is saved in the "WinCCProjects" authorization 
directory.

● If you want to start the project, use the "WinCC StartTool". See Starting Runtime 
Professional (Page 7017) for additional information.

Adapt scripts
If you have created an executable program which references a migrated project by its name, 
you must adapt this script accordingly. The new project name is the sequence of numbers in 
curly brackets in the path specification of the MCX file described above.

See also
Migration (WinCC V7.2) (Page 215)

Starting Runtime Professional (Page 7017)
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Migrating engineering data (WinCC V7.2)

Object support (WinCC V7.2)

Object support during migration (WinCC V7.2)

Introduction
When migrating projects from WinCC V7,2, all object types and functions that are available 
and can be mapped to the new project environment are fully migrated.

Supported object types
The following object types are supported for migration:   

● Screens

● Display and operating objects

● Faceplates

● Tags

● Data types

● Structures

● Connections

● Cycles

● Alarms

● Alarm classes

● Alarm groups

● Alarm types

● User logs

● Alarm logs

● Data logs

● Reports

● Print jobs

● Layouts

● Project functions

● Standard functions

● Actions

● User administration

● Texts
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● Project library

● Project languages

● Runtime languages

● Runtime scripting

● ODK functions of the RT

Constraints and conditionally supported objects are described in the following sections.

Unsupported object types
The following object types are not supported by the migration:

● 3D bar

● Screen hierarchy

● Extended analog display

● Extended status display

● Inserted layout

● Global libraries

● Acoustic alarms

● Group display

● Server to server communication

● XAML Controls, e.g. WPF Controls

● ODK functions of the CS

● Default screens of the PCS7 Standard/Advanced libraries

Prohibited characters
WinCC does not support exactly the same character set for object names as WinCC V7.2. For 
example, the following characters are prohibited for tags in WinCC: ? " %

Object names are not changed by the migration, even if the name contains a character which 
is not permitted in WinCC. Unallowed characters will make the object name invalid and an 
alarm will be output during compilation. In WinCC, you can change object names centrally. All 
other occurrences are always changed as well.

See also
Changed objects (WinCC V7.2) (Page 225)

Migration (WinCC V7.2) (Page 215)

Migration of user objects (WinCC V7.2) (Page 234)
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Changed objects (WinCC V7.2)

Introduction
Some objects which are available in WinCC V7.2 are no longer supported by WinCC. The 
migration maps these objects to the objects available in WinCC. Since not all properties can 
be mapped, rework is partly necessary. Changed and non-migrated properties are recorded 
in the migration report.

Changed objects
The following objects are mapped to other objects or partly have different properties:

● OLE object

● Push Button Control

● Online Table Control

● WinCC AlarmControl

● Text list

● Status display

● WinCC Controls before WinCC V7

● User objects

● Faceplates

● Object groups

● Dynamizations

See the section Screens and screen objects (WinCC V7.2) (Page 229) for additional 
information.

See also
Screens and screen objects (WinCC V7.2) (Page 229)

Object support during migration (WinCC V7.2) (Page 223)

Connections (WinCC V7.2)

Migration of connections (WinCC V7.2)

Introduction
The following cases must be distinguished in the migration of connections:     

● Communication driver is supported in WinCC.

● Communication driver is not supported in WinCC.
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See the following description for how to migrate the individual communication drivers.

Migration with supported communication driver
If WinCC supports the used communication driver, the connection is migrated with this 
communication driver. The following communication drivers are supported:

WinCC V7.2 WinCC
SIMATIC S7 PROTOCOL SUITE SIMATIC S7-300/400
SIMATIC S7-1200 SIMATIC S7-1200
SIMATIC S7-1500 SIMATIC S7-1500
ALLEN BRADLEY - ETHERNET IP Allen Bradley Ethernet/IP
MITSUBISHI ETHERNET Mitsubishi MC TCP/IP
MODBUS TCPIP Modicon MODBUS TCP/IP
OPC OPC

The  "Industrial Ethernet (I + II)" channel units of the S7 Protocol Suite are migrated to the 
Industrial Ethernet channel unit of the SIMATIC S7-300/400 driver.

The  "PROFIBUS (I + II)" channel units of the S7 Protocol Suite are migrated to the PROFIBUS 
channel unit of the SIMATIC S7-300/400 driver.

The "Named Connection" channel unit will not be migrated.

Migration of an unsupported communication driver
Not all communication drivers which are available in WinCC V7.2 are supported in WinCC. If 
a communication driver is not supported, the configured connection is not migrated.

If you migrate a WinCC V7.2 project which includes a connection that is not supported, all 
external tags of this connection are mapped to internal tags in a tag table. The PLC address 
is stored as comment with the tag. You receive a tag table and an entry in the migration log 
for each affected connection. 

You must reconnect the converted tags with the PLC after the migration and configuring of a 
new connection.

You get an appropriate warning if the driver is not migrated.

The following communication drivers are not supported by WinCC:

WinCC V7.2 WinCC
Profibus DP not supported
Profibus FMS not supported
SIMATIC TI Serial not supported
SIMATIC 505 TCP IP not supported
SIMATIC S5 Ethernet Layer 4 not supported
SIMATIC S5 Ethernet TF not supported
SIMATIC S5 Profibus FDL not supported
SIMATIC S5 Programmers Port AS 511 not supported
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WinCC V7.2 WinCC
SIMATIC S5 Serial 3964R not supported
SIMATIC TI Ethernet Layer 4 not supported
SIMATIC TI Serial not supported
System Info not supported
Windows DDE not supported

Existing functions from Windows DDE can be converted to WinCC by means of OPC. You 
have to do the conversion yourself.

See also
Adaptation of the configuration for a non-migrated connection ((WinCC V7.2) (Page 227)

Migration (WinCC V7.2) (Page 215)

Migration of tags (WinCC V7.2) (Page 228)

Adaptation of the configuration for a non-migrated connection ((WinCC V7.2)

Introduction
If a connection cannot be migrated you have the following options:

● Change the configuration in WinCC V7.2 before the migration

● Change the configuration after the migration

Change a connection before the migration
If the communication driver selected for the connection is not supported by the migration, you 
must select a driver which is supported by the migration.     

If no suitable driver is available, you must use suitable components for the communication. 
Then adapt the configuration in WinCC V7.2. Migrate the project after successful adaptation. 
The connection is then also migrated.

Changing a connection before the migration
If you migrate a WinCC V7.2 project which includes a connection that is not supported, all 
external tags of this connection are mapped to internal tags in a tag table. The PLC address 
is stored as comment with the tag. You receive a tag table and an entry in the migration log 
for each affected connection. 

You must configure a new connection after the migration. For this connection you select a 
communication driver which supports the used communication partner. If no suitable driver is 
available for the communication partner, you must use suitable components for the 
communication.

If you have configured the new connection, you must reconnect all tags which were mapped 
to internal tags before the migration. Open the migration report to make reconfiguration easier. 
Reconfigure the tags according to the log entry.
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See also
Migrating projects from WinCC V7.2 (WinCC V7.2) (Page 217)

Migration of connections (WinCC V7.2) (Page 225)

Migration of tags (WinCC V7.2)

Introduction
You need to make some special considerations when migrating tags. The following aspects 
should be distinguished:     

● Migrating data types of tags

● Migrating internal tags

● Migrating external tags

Migrating data types
WinCC has the same data types but sometimes uses other data type names as WinCC V7.2. 
When migrating from external tags that contain data types of a SIMATIC S7 controller, some 
peculiarities are observed. See the section Migration of data types (WinCC V7.2) (Page 253) 
for additional information.

Migrating internal tags
Internal tags are always migrated completely. Only the data type name can be changed by the 
migration. See the section Migration of data types (WinCC V7.2) (Page 253) for additional 
information. 

Migrating external tags
If the connection used by the external tags is migrated, the external tags are also fully migrated. 
The migration of external tags depends on whether the used communication driver is supported 
by the migration. See the section Migration of connections (WinCC V7.2) (Page 225) for 
additional information.

If the connection used by the external tags is not migrated, the external tags are not migrated 
either. The external tags are then mapped to internal tags. You must configure a new 
connection and reconnect the tags with the tags of the PLC after the migration.

See also
Migration of data types (WinCC V7.2) (Page 253)

Migration of connections (WinCC V7.2) (Page 225)

Migration of structures (WinCC V7.2) (Page 229)

Migration (WinCC V7.2) (Page 215)
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Migration of structures (WinCC V7.2)

Migration of structures
Structured tags are implemented in WinCC V7.2 by means of structure types and structure 
elements. The structure types are valid for the device in which they are created in WinCC V7.2. 
Structure types are created in the project library in WinCC and are valid for all devices of a 
project. The structure of the structure types in WinCC and WinCC V7.2 is identical.

See also
Migration of tags (WinCC V7.2) (Page 228)

Screens and screen objects (WinCC V7.2)

Migration of screens and screen objects (WinCC V7.2)

Introduction
The majority of screen objects available in WinCC V7.2 is applied without restrictions after 
migration to WinCC.

For some screen objects, such as text list and status display, improved options are available. 
Through the migration these objects are converted in such a manner that no reworking is 
required.

Single screen objects such as WinCC Push Button Control are no longer supported by WinCC. 
The migration maps as far as possible these objects to the objects available in WinCC.

The following special features must be taken into account during the migration.

Newly introduced properties in WinCC V7.2
New properties introduced in WinCC V7.2 are not migrated to WinCC. If one of the new 
properties is dynamic, a message is generated about the non-migrated dynamic properties. 
In contrast, no message is generated for non-migrated static properties. 

Tab sequences in screens with faceplates or object groups
In screens with faceplates or object groups, the migration causes tab sequences to change 
both in the screen and in the faceplate or in the object group.

Renaming events
Some events are assigned new names in WinCC; for example, the event "Mouse click" is 
called "Click" in WinCC. The migration converts this renaming completely. No reworking is 
necessary.
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Migrating triggers
Triggers from WinCC V7.2 of the window cycle type are migrated to the valid update cycle of 
a screen in WinCC.

Migrating a text list
In WinCC V7.2, the "Text list" object enables the output of texts based on the value of a tag. 
For this, the output texts must re-specified for each object In WinCC, a text list independent 
of the point of use is available. The "Symbolic IO field" object is used to display texts from a 
text list.

The texts used in WinCC V7.2 are migrated to a text list and connected with the symbolic IO 
field. The used texts are stored as project text. You can find project texts under "Languages 
& Resources" in the project tree.

Migration of a status display
In WinCC V7.2, the "Status display" object enables the output of graphics based on the value 
of a tag. For this, the output graphics must be re-specified for each object. In WinCC, a graphic 
list independent of the point of use is available. The "Graphic IO field" object is used to display 
graphics from a graphics list.

The screens used in the status display are migrated to a graphics list and connected with the 
graphic I/O field. The used screens are stored in the Graphics of WinCC.  The Graphics can 
be found in the project tree under "Languages & Resources".

Migration of a faceplate
The faceplates in WinCC have several differences compared to the faceplates in WinCC V7.2. 
Therefore the following special considerations need to be made in the migration of a 
faceplate:     

● A property of an inner object can only be interconnected to one property respectively of the 
faceplate in a faceplate. If a property of an inner object is interconnected to several 
properties of the faceplate, only the connection of the first configured property is migrated. 
An alarm is output in the migration report for the properties that are not migrated.

● If an event of an inner object is multiply bound to the event interface of the faceplate, only 
the last event is connected to the inner object after the migration.  The other events of the 
event interface are migrated to the inner object without a connection. If dynamizations are 
configured on these events, the events are migrated. Binding of the dynamization to the 
inner objects will be lost.
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● If an object property is dynamized within a faceplate type and this property is fed 
simulaneously to the event interface of the faceplate, the connection to the event interface 
is rejected in the migration. The inner dynamization is migrated. The property at the event 
interface is also migrated, only the connection to the property of the inner object is lost.
Example:
A faceplate type has the inner object "Circle". The "Background color" property of the circle 
is dynamized with an inner event, e.g. by a faceplate tag. The "background color" property 
of the circle is passed out to the event interface of the faceplate and is additionally 
dynamized externally in the faceplate instance. This configuration is no longer allowed in 
WinCC. The inner dynamization is migrated in the migration. The external dynamization 
and the property at the event interface of the faceplate are also migrated. The connection 
between the external property and the inner "Background color" property of the circle is 
resolved. 

● If a faceplate type contains an I/O field, its "Output format" property cannot be bound to the 
event interface.

Migrating an OLE object
The OLE object is not supported in WinCC. The functions of the OLE object are mapped by 
the migration to a graphic display. An alarm is output in the migration report.     

If the OLE object is connected to a text-oriented file, such as an Excel table, a screenshot of 
the Excel table is generated by the migration and connected with the graphic display. 

Migration of a WinCC Push Button Control
WinCC Push Button Control is not supported in WinCC. The functions of the Push Button 
Control are mapped to a button by the migration.     

The following properties of the Push Botton Control are not available on a button and are 
therefore not integrated:

● Outline

● FontStrikeThru

● FocusRect

● AutoSize

● Transparent

If you have configured a dynamic on one of these properties, the dynamization will be lost in 
the migration. If a property or a dynamic of the object cannot be migrated, an appropriate entry 
is made in the migration report.

Since a button supports other events, the following special features have to be taken into 
account for the migration:

● The event "Click" of the Push Button Control is migrated without constraints to the "Click" 
event of the button.

● The events "KeyDown" and "KeyUp" of the Push Button Control are migrated to the events 
"Press button on keyboard" and "Release button on keyboard". However, the parameters 
cannot be uniquely mapped for this. If you use these parameters in a script, the script will 
cause an alarm during compilation.
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● The event "MouseDown" of the Push Button Control is migrated to the two events "Press 
left mouse button" and "Press right mouse button". The event "MouseUp" of the Push Button 
Control is migrated to the two events "Release left mouse button" and "Release right mouse 
button". However, the parameters cannot be uniquely mapped for this. If you use these 
parameters in a script, the script will cause an alarm during compilation.

● It is not possible to migrate the events "KeyPress" and "MouseMove" of the Push Button 
Control. The configuration on the two events is lost during the migration. An alarm is output 
in the migration report.

See also
Migration of user objects (WinCC V7.2) (Page 234)

Value changes to object properties by the migration (WinCC V7.2) (Page 232)

Value changes to object properties by the migration (WinCC V7.2)

Introduction
The standardization of object properties from WinCC V7.2 and WinCC flexible requires 
changes to the object properties during the migration process. The migration calculates the 
changes in such a way that the representation of the objects after migration is the same as 
prior to migration. Changes made during migration result in different units of measurements 
and values in the configuration for some object properties. 

Migrating the font settings of an object
In WinCC V7.2 and WinCC, various units of measurement are used in some cases to denote 
the size of the fonts used. During migration, the font size is converted to ensure that the 
representation of the font is the same size at zoom level 100%. Due to the different units of 
measurement, the numerical values for the font sizes are changed after migration.     

Example:

Font style before migration Font style after migration
Arial 10 points Arial 13 pixels
Arial 16 points Arial 21 pixels
Tahoma 10 points Tahoma 13 pixels
Tahoma 16 points Tahoma 21 pixels

Migrating the size data of an object
In WinCC V7.2, position data and size data are specified for objects of the Report Designer in 
accordance with the default setting in Report Designer, for example, in cm, inch or points. In 
WinCC, position data and size data are specified in pixels. During migration, the values for the 
size data are converted so that the representation of the objects is identical prior to and after 
the migration. The conversion produces different numerical values for the data in the object 
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properties after the migration. The object properties affected are, for example, X position, Y 
position, width and height.         

See also
Migration of user objects (WinCC V7.2) (Page 234)

Migration of screens and screen objects (WinCC V7.2) (Page 229)

Migration of object groups (WinCC V7.2)

Object group with objects at several levels
In WinCC V7.2, the objects of an object group may be in different layers of the screen and are 
subject to the layer administration of the screen. The object group itself has no layer 
administration. It is therefore possible to position an object in a layer between two objects of 
an object group in WinCC V7.2. The Z order applies for all objects in the screen. Therefore, it 
is possible to hide an object in an object group in WinCC V7.2 by deactivating a layer.

In WinCC an object group and the objects that it contains are in the same layer of the screen. 
An object group has its own layer administration in WinCC. The Z order of the objects only 
applies within the object group in WinCC. If an object is positioned above an object group and 
a layer is moved back, this object is behind the object groups and is no longer visible. The 
object is not included in the Z order of the object group either. Therefore it is possible to hide 
an object in an object group in WinCC by deactivating a layer. If the migration cannot fully map 
the layout of an object group, an alam is output in the info window and the migration report. 
Check whether the object group is displayed correctly after the migration.

Object group with objects that are not supported
An object group in WinC consists of at least 2 objects. If WinCC does not support an object of 
a group, the group is still migrated. The unsupported object is not migrated and is missing from 
the group after the migration. If the object groups only contains 2 objects before the migration 
and one of them is not migrated, an invalid object group results. The object group is marked 
as an invalid object in WinCC. Select the invalid object and cancel the grouping. The valid 
object is displayed.     

If not all objects in a group can be migrated, the coordinates and the size of the group are 
recalculated and adapted accordingly.

An entry is made in the migration report in both the above cases.

Migration of properties of an object group
Static values and dynamizations of properties of grouped objects are migrated without 
constraints.

Object groups in WinCC V7.2 have their own properties: X-position, Y-position, width, height, 
object name, level, tooltip text, authorizations, operator control  enable and visibility. Static 
values and dynamizations of these properties are migrated without constraints.
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In addition to the above named properties, an object group also has a collection of all properties 
of the grouped objects. These collected properties can be used, for example, to influence the 
background colors of all grouped objects in WinCC V7.2. Changes are stored both on the 
object group and on the grouped objects. The changes to the object group are not migrated. 
The dynamizations on the collected properties are lost during the migration. 

See also
Migration of user objects (WinCC V7.2) (Page 234)

Migration of user objects (WinCC V7.2)

Introduction
User objects are no longer supported in WinCC. The migration maps user objects to faceplates. 
Identical user objects are grouped to a faceplate type. Each user object is replaced by a 
faceplate instance.

User objects
A faceplate does not offer exactly the same characteristics as a user object, therefore the 
following special considerations must be made in the migration:

● A property of an inner object can only be interconnected to one property of a faceplate in 
a faceplate. If a property of an inner object is interconnected to several properties of the 
faceplate, the connection to the first property is migrated. An alarm is output in the migration 
report for the properties that are not migrated.

● The coordinates for the position of an object within the user object cannot be interconnected 
to the properties of a faceplate. The property of the user object on which a position is 
configured is migrated. If a dynamic is configured on this property, this is also migrated. 
However, the property and the dynamic in the faceplate are no longer interconnected with 
the object position of the inner object.

● Faceplates cannot be rotated or mirrored. If the project contains rotated or mirrored user 
objects, a message is entered in the migration report.

● If a user object contains objects which are not supported by the migration, these objects 
are missing in the resulting faceplate after the migration. The faceplate then only contains 
the objects supported by the migration. If a dynamic is configured on an unsupported object, 
this dynamic will be lost. If an inner object of a user object is not migrated, the size of the 
resulting faceplate may change. The object position of the user object is retained and 
applied to the faceplate.

● The position of an inner object is related to the coordinate system of the screen in which 
the user object is positioned in the user project. A faceplate has its own coordinates system 
which is independent of the screen in which it is positioned. The coordinates of the inner 
objects therefore change in the migration. If the project contains a script which uses or 
changes the coordinates of an inner object, you must adapt the script accordingly. Changing 
of the coordinates of an inner object is not logged.
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● In the case of user objects, internal tags can be directly interconnected with the interface. 
This is not possible for faceplates. To achieve the same behavior for faceplates, two 
faceplate functions are generated by the migration and interconnected with an interface 
property. But you can only migrate up to 23 tags that are interconnected with the interface.

● Use of the "Connector" object is not allowed in a faceplate. Therefore a connector is not 
migrated within a user object.

● Use of WinCC Controls is not allowed in a faceplate. Therefore a control is not migrated 
within a user object. The following controls are exceptions; these are also migrated as inner 
objects of a user object:

– WinCC Digital/Analog Clock Control

– WinCC Gauge Control

– Slider Object

If the migration makes changes to the configuring data due to these described special 
considerations, these are entered in the migration report.

See also
Migration (WinCC V7.2) (Page 215)

Object support during migration (WinCC V7.2) (Page 223)

Migration of screens and screen objects (WinCC V7.2) (Page 229)

Migration of object groups (WinCC V7.2) (Page 233)

Migration of dynamizations by the Dynamic dialog (WinCC V7.2) (Page 235)

Migration of dynamizations per script (WinCC V7.2) (Page 236)

Migration of ActiveX controls (WinCC V7.2) (Page 238)

Migration of color settings (WinCC V7.2) (Page 239)

Migration of a dynamization per direct connection (WinCC V7.2) (Page 237)

Value changes to object properties by the migration (WinCC V7.2) (Page 232)

Migration of dynamizations by the Dynamic dialog (WinCC V7.2)

Introduction
The Dynamic dialog is available in WinCC V7.2 for the animation of library objects. The 
functions of the Dynamic dialog are mapped as animation of a property in WinCC. This 
animation offers similar functionality for dynamization as the Dynamic dialog in WinCC V7.2. 
If you have configured dynamization for a property in a WinCC V7.2 project, this dynamization 
is converted into an animation in WinCC by the migration.

 

 Note

The new properties in WinCC V7.2 are not migrated to WinCC V13. If dynamization has been 
configured for such a property, a warning is generated with the migration. 
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Migration of dynamizations by Dynamic dialog
The expression of a dynamization, which is created using the Dynamic dialog from WinCC 
V7.2, is based on the syntax of C script. The migration attempts to convert the expression of 
a dynamization from WinCC V7.2 to the syntax of VB script. This form of conversion can 
generally be performed if the dynamization uses the following C operators:  

● Arithmetic operators [+, -, *, /, %, ^]

● Logical operators [&&, ||]

● Comparative operators [<, >, !=, <=, >=, ==]

● Numerical constants

If the conversion to the syntax from VB script is not possible, the dynamization is mapped to 
a C script. Mapping to a C script takes place in the following cases:

● If the expression of the Dynamic dialog uses no tag or cyclic trigger. If a tag and a trigger 
tag are used, these must match. No cyclic trigger is allowed when using tags in the 
expression.

● If the result of the expression in the Dynamic dialog is an "Analog" data type and the range 
of validity "other" in the "Result of expression" field has a different value to the "Static" value 
of the dynamized property.

● If several tags are used in the expression for the Dynamic dialog and not all tags have the 
same configuration for the Quality Code.

● If a tag is used whose tag status is used.

● If the expression of the Dynamic dialog cannot be converted to an equivalent in VB script.

See also
Migration of user objects (WinCC V7.2) (Page 234)

Migration of dynamizations per script (WinCC V7.2)

Introduction
The migration executes various measures to ensure that the VB scripts and C scripts from 
WinCC V7.2 remain functional: These measures above also apply to actions on events.     

Migration of VB scripts for the dynamization
In WinCC V7.2, you can use several functions in a dynamization by VB script; this is no longer 
allowed in WinCC. If the migration finds several functions in a script, the function which is called 
when triggering the event is migrated. The other functions are migrated in the declaration area. 
This leads to an alarm during the compiling of the project.

In WinCC, some of the function names of VB scripts have changed compared to WinCC V7.2. 
The "LeftTrigger" function name was changed to "LeftValue", for example. If the function has 
to return a value, the source code contains a statement in which the value is assigned to the 
function name. The migration finds and replaces the function name in the function and the 
function header. If the new function name is already used as the name of a function, tag or 
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parameter, an alarm is output in the info window and in the migration report. Adapt the 
configuration yourself after the migration.

Migration of C scripts for the dynamization
In WinCC V7.2, some parameters for C scripts have names that are different to those in WinCC. 
To keep a script functional, the migration inserts a tag with the previous parameter name for 
every changed parameter name.
Example:
The parameter name "lpszPictureName" is replaced by the parameter name "ScreenName". 
The migration inserts the following tag in the script: "char* lpszPictureName = ScreenName".
If a tag or parameter with this name already exists, an alarm is generated in the info window 
and entered in the migration report.
The following parameters are affected:

WinCC V7.2 WinCC
lpszPictureName ScreenName
lpszObjectName ObjectName
lpszPropertyName PropertyName

In WinCC, the function names of C scripts change in relation to WinCC V7.2. The function 
name of a dynamic is given the label "_main". In WinCC the expression changes to <Name of 
property>_value. The migration corrects the names in the same way as it changes the function 
names of VB scripts described in the previous paragraph.

Migrating triggers
Triggers from WinCC V7.2 of the window cycle type are migrated to the screen cycle valid in 
WinCC.

See also
Migration of user objects (WinCC V7.2) (Page 234)

Migration of a dynamization per direct connection (WinCC V7.2)

Migration of a direct connection
A dynamization by direct connection is migrated as a function list.

See also
Migration of user objects (WinCC V7.2) (Page 234)

Direct connection (Page 7674)

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Professional V13.0
System Manual, 02/2014 237



Migration of ActiveX controls (WinCC V7.2)

Introduction
A WinCC V7.2 project may contain the following ActiveX controls:

● WinCC controls prior to V7
The controls prior to WinCC V7 are still supported in WinCC V7. These controls are not 
supported in WinCC. If a project contains controls prior to WinCC V7, these controls are 
migrated to the version as of WinCC V7. The names of properties, buttons or toolbars can 
also change in the process. 
Changes can occur in the display in runtime.
Scripts that have had an effect on controls prior to WinCC V7, have to be adapted after the 
migration.

● WinCC controls as of V7
The controls as of WinCC V7 listed below are supported by WinCC V13.

● ActiveX controls of third parties
The migration also supports the ActiveX controls from third parties. However, the controls 
must be registered in the operating system. If an ActiveX control is not registered, the 
migration is terminated.
When you save a project with the migration tool and perform the migration itself on another 
PC, the controls must be registered on this PC.

Supported WinCC Controls
WinCC supports the following controls from WinCC V7.2:       

● Siemens HMI Symbol Library 1.4.1

● WinCC Channel Diagnosis Control

● WinCC Digital/Analog ClockControl

● WinCC Gauge Control

● WinCC Slider Control

● WinCC Ruler Control

● WinCC Media Control

● WinCC AlarmControl

● WinCC FunctionTrendControl

● WinCC OnlineTableControl

● WinCC OnlineTrendControl

● WinCC UserArchiveControl

● CCDiskSpace.Diskspace

● WinCC_WB.WinCCWebBrowser

● .Net Controls
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Special features of WinCC OnlineTableControl
In WinCC V7.2, WinCC OnlineTableControl can display exceeded values with different colors. 
For this, at least two high and two low limits and associated colors can be configured.  

WinCC V13 does not support these features. During migration, a warning is generated when 
the corresponding values are configured. 

Special features of WinCC AlarmControl
The new "Class Priority" alarm text block in WinCC AlarmControl from WinCC V7.2 is not 
supported by WinCC V13. During migration, a warning is generated if the alarm text block is 
configured. 

Unsupported WinCC Controls
The following controls are not supported by WinCC:

● WinCC push-button control
The WinCC push-button control is mapped to a button in WinCC. See Migration of screens 
and screen objects (WinCC V7.2) (Page 229) for additional information.

● XAML controls, e.g. WPF controls
If a project contains XAML controls, these controls are not migrated. An alarm is output in 
the migration report for every control that is not migrated.

See also
Migration of user objects (WinCC V7.2) (Page 234)

Migration of screens and screen objects (WinCC V7.2) (Page 229)

Migration of color settings (WinCC V7.2)

Migrating the color settings of an object
In WinCC V7.2, it is possible to configure the color settings of objects using the central color 
palette. The central color palette is omitted in WinCC. The migration takes over the color 
settings for an object from the central color palette and defines the colors directly on the 
respective object. The color settings can no longer be changed centrally in the migrated 
project.  

See also
Migration of user objects (WinCC V7.2) (Page 234)
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Migration of alarms and alarm groups (WinCC V7.2)

Introduction
The alarm system of WinCC clearly differs in structure from the alarm system of 
WinCC V7.2.             

WinCC V7.2 offers up to 18 alarm classes with 16 alarm types per alarm class.

WinCC only offers alarm classes but no alarm types.

In the migration of a project the alarm types are converted into alarm classes in the migrated 
project. The alarm types are omitted completely.

Migration of alarm groups
The alarm classes and alarm types are migrated according to the following scheme:

The migration assigns IDs for all alarm classes and their alarm types throughout. The IDs 1-63 
are reserved for the system side in WinCC. The migration begins assignment of the IDs at ID 
64.

Alarm class WinCC V7.2 Alarm type WinCC V7.2 Alarm class WinCC
ID 1 ID 1-16 ID 64-79
ID 2 ID 17-32 ID 80-95
... ... ...
ID 16 ID 241-256 ID 304-319
ID 17 ID 257-272

257-258 of which are used
ID 320-335

ID 18 ID 273-288
273-274 of which are used

ID 336-351

The migration computes new IDs for all alarm classes and alarm types which are contained in 
the project to be migrated.

After assignment of the IDs, the alarm classes and alarm types existing in the project are 
migrated. To ensure unique names for the alarm classes, the migration links the names of the 
alarm classes with the alarm types contained therein.

Example:

The "Tolerance" alarm class with the "ToleranceHigh" alarm type is used in WinCC V7.2. This 
becomes alarm class "Tolerance_ToleranceHigh" after the migration.

With the exception of scripts and ODK functions, all application points in the project are adapted 
accordingly. E.g. all static filters of an alarm display are adapted to the new alarm class.

The migration does not correct any scripts or ODK functions which process an alarm type. If 
the migration detects the use of an alarm type in a script, an alam is output in the info window 
and the migration report. Adapt such a script yourself after the migration.
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Migration of alarms
In WinCC V7.2, system events have IDs from the 1000000 to 1019999 range. However, alarms 
can also be freely configured in this number range.

In WinCC, the 1000000 to 1019999 range is reserved for system events.

WinCC V7.2 system events are migrated. User-defined alarms with IDs in this range are not 
migrated.

Logging Settings
In WinCC V7.2, you can define the settings for the logging of every alarm separately. In WinCC 
you can only define the settings for the logging for an alarm class and not for single alarms. If 
the logging is activated on an alarm, the migration accepts this setting for the entire alarm 
class. This ensures that no logging settings are lost. Then all alarms which are contained in 
this alarm class are logged after the migration even if they were not logged before the migration. 
An alarm is output in the migration report for each affected alarm.

See also
Migration (WinCC V7.2) (Page 215)

Migration of user logs (WinCC V7.2) (Page 241)

Migration of user logs (WinCC V7.2)

Migration of user logs 
User logs from WinCC V7.2 are called recipes in WinCC. Data fields of a user log are called 
recipe elements. 

The configuration data are mapped directly to recipes during the migration of user logs. Views 
are mapped to recipe queries. You have to observe the following rules in the migration:

● If you have configured a relation in a view, this relation may not be "NULL". 
If the relation results in "NULL", an error message is generated when the migrated project 
is compiled. To remedy the error, you must reconfigure the relation in the recipe view so 
that a valid relation results.

● In WinCC V7.2, control tags can be configured independent of the specifications for the 
communication. Control tags are only migrated if the WinCC tags are used for the 
communication.

● In WinCC V7.2, the PLC ID is used as unique name of the log for communication via raw 
data tags. In WinCC, the recipe number is used to uniquely identify a recipe. Information 
on PLC ID is not migrated.

● If an alias is configured in WinCC V7.2 for a user log, this is migrated to the display names 
of the recipe.

The Runtime data of user logs can be copied during migration.
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See also
Copying runtime data (WinCC V7.2) (Page 252)

Migration of alarms and alarm groups (WinCC V7.2) (Page 240)

Scripts and standard functions (WinCC V7.2)

Migration of functions and actions (WinCC V7.2)

Introduction
Similar to WinCC V7.2, WinCC supports ANSI-C as well as VBS. Some things need to be 
considered for the migration of functions and actions due to the system-side changes. The 
basic conditions for migration are described below.

Migration of functions and actions
Note the following points for the migration of functions and actions: 

● VBA scripts are no longer supported in WinCC so that VBA scripts are not migrated.

● Some functions are given new names in WinCC. No function names are adapted during 
the migration. Scripts continue to function without adapting because the old names can still 
be used in scripts. However, the old names are no longer supported by auto-completion 
and help.

Special features of  VB scripts
● In WinCC V7.2, VB scripts are structured as modules, which may contain one or more 

procedures. In WinCC every script may only contain one procedure. The migration splits 
modules with multiple procedures and creates a new script for each procedure. 
Declarations for several global tags can be included in a script from WinCC V7.2. The global 
tags are initialized when calling the script and are available for all procedures of the script. 
When a script is split, the global tags are migrated to the script  which follows the tag 
declaration. After the migration you must ensure that this first script is also called first so 
that the global tags are initialized. The global tags are only available for the split scripts 
after initialization. 

● WinCC does not support the declaration of VB classes.

● In WinCC, the parameters in a VB script must always be transferred with the keywords 
"ByRef" or "ByVal". There is no defined transfer with the keywords in WinCC V7.2 scripts. 
In the migration, the transfer of the parameters is supplemented by the keyword "ByRef".

Stricter criteria in the checking of functions may make it necessary to rework scripts and 
functions after the migration. Errors and warnings are caused in WinCC by, for example:

● Objects, such as tags of faceplates, which are referenced in the functions but do not exist.

● Incorrect use of the VB object model, e.g. HmiRuntime.ActivateScreen.Item.

● Different number of parameters in the definition and call of a function.
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● VB functions that deliver no return value.

● If the return value of another function is set within the VB function.

● Tags which are used in a VB function, but not defined in this function.

Special features of VB script passwords
VB script passwords were not saved correctly until Update 2 in WinCC V7.2 . When a project 
which was created with such a version of WinCC V7.2 is migrated, only half of the characters 
are migrated in each case. A warning about the truncated size of the password is generated 
during migration .  

Special features of C-functions
WinCC V7.2 is sensitive to upper case/lower case in the names of C functions. In WinCC, 
names which only differ by upper/lower case letters are not allowed. Upper/lower case letters 
of function names remain unchanged during the migration. If a migrated project contains 
function names which only differ by upper/lower case letters, one of the functions in the 
engineering system is identified as invalid. An error message is generated during compiling.

Stricter criteria in the checking of functions may make it necessary to rework scripts and 
functions after the migration. Errors and warnings are caused in WinCC by, for example:

● Objects, such as tags of faceplates, which are referenced in the functions but do not exist.

● Different number of parameters in the definition and call of a function.

● If the external definition of a used function does not match the function definition. In this 
case you can either remove the external definition or adapt it.

● If the names of functions or tags in the Defines contain special characters which are not 
permitted.

ODK functions
ODK functions for both changing CS data and for changing Runtime data are supported in 
WinCC V7.2. In WinCC, only functions for changing Runtime data are still supported. The ODK 
functions for changing CS data are no longer supported. Functions and applications which call 
these ODK functions may not work as desired after the migration.  Further information about 
using ODK functions can be found in the Runtime API online help.

See also
Migration (WinCC V7.2) (Page 215)

Migration of header files (WinCC V7.2) (Page 244)

Migration of actions (WinCC V7.2) (Page 244)

Migration of standard functions (WinCC V7.2) (Page 245)

Changing of function names (WinCC V7.2) (Page 254)
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Migration of header files (WinCC V7.2)

Introduction
Some things need to be considered for the migration of header files due to the system-side 
changes. The changes due to the migration are described below.

Migration of header files
Header files are usually saved in the project in WinCC V7.2. The header files stored in the 
project are migrated and stored in WinCC in the project tree in the respective device under 
"Functions > C-Header". If you have saved header files elsewhere and have integrated them 
into the project in WinCC V7.2, these header files are not migrated. You have to bind the 
header files that have not been migrated into the project yourself.     

See also
Migration of functions and actions (WinCC V7.2) (Page 242)

Migration of actions (WinCC V7.2)

Introduction
Actions in WinCC V7.2 are migrated to tasks in WinCC. Jobs are managed in WinCC in the 
"Jobs" editor. Some things need to be considered for the migration of actions due to the system-
side changes.    

Migration of actions
In WinCC only one trigger is ever assigned to a task. In WinCC 7.2, you have the option of 
configuring several triggers for starting an action, for example, a tag trigger or a cyclic trigger. 
An action with several triggers is split up into several jobs in the migration. A new task is created 
for each trigger.

There are global actions and local actions in WinCC V7.2. In WinCC there are only global jobs. 
A global action is migrated to a global job. A local action is also migrated to a global job. 
However, the script of a local job is extended. In the extension of the script the system tag 
"@LocalMachineName" is evaluated so that the job only runs on the PC which is provided for 
the local action. If a script is extended, an alarm is output in the info window and in the migration 
report.

Migration of password-protected actions
An action can be protected by a password in WinCC V7.2. A task and a password-protected 
script are created from this during the migration. 
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See also
Migration of functions and actions (WinCC V7.2) (Page 242)

Migration of standard functions (WinCC V7.2)

Migration of standard functions
Standard functions are part of the Runtime installation of WinCC and are therefore not 
migrated. if you have changed the source code of a standard function in your WinCC V7.2 
project, the change is lost in the migration.   

Standard functions " OnDeactivateExecute"
The standard function "OnDeactivateExecute" is migrated to a task with the "Runtime-Stop" 
trigger.

Customized standard functions
Customized standard functions are saved in WinCC V7.2 in the "APLIB" folder. You should 
copy these functions into the project directory to ensure that user-defined standard functions 
are migrated.

You can find C standard functions in the "wincc\aplib" folder of the WinCC V7.2 installation 
directory. Copy these functions to the "library" folder in the project directory.

You can find C standard functions in the "wincc\aplib\ScriptLibStd" folder of the WinCC V7.2 
installation directory. Copy these functions to the "ScriptLib" folder in the project directory.

See also
Migration of functions and actions (WinCC V7.2) (Page 242)

Migration of reports (WinCC V7.2)

Basics on migration of reports (WinCC V7.2)

Introduction
The report system of WinCC V7.2 can process and output both configuration data and runtime 
data. WinCC only supports the documentation of Runtime data.

The definition of which data are documented is stored in WinCC V7.2 in layout files. The output 
of contents is controlled by print jobs.
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Migration of reports 
The migration recognizes the layout files for the Runtime documentation from their content. If 
a layout file contains objects for the project documentation, this layout file is not migrated. If a 
layout file contains embedded layouts which are also used for the project documentation, this 
layout file is not migrated. if a print job references a layout file for the project documentation, 
this print job is not migrated. An alarm is output in the info window and in the migration report 
for every layout file that is not migrated.  

 

 Note

If a WinCC V7.2 project was already created with earlier versions of WinCC, for example 
V5.0, a report can contain objects which were supplied with data in Runtime by providers 
from the earlier version. These objects are not migrated.

 

Language-dependent contents 
The report system of WinCC V7.2 does not support multilingual contents. Therefore the report 
system requires a separate layout file for every Runtime language. The language assignment 
of the files is defined by name conventions of the contained folders or file names. The language-
dependent layout files are combined in a multilingual report file in the migration. The migration 
must therefore consider different files to create a multilingual report. The following rules apply 
for merging the layout files for different languages: 

● The first found layout file is used respectively for the migration of report objects. Differences 
in the layout of the different languages are therefore lost in the migration.

● All language-dependent files of a report are used to extract the language-dependent 
contents.

● The text entries of a language-independent report are adopted for all configured Runtime 
languages.

Migration of print jobs 
In WinCC V7.2, the start parameters for a print job are defined in the properties of the respective 
print job. In WinCC you cannot define start parameters on a print job. The job planner is 
available in WinCC for starting print jobs. There is a job of the "Print job" type in the job planner.  

The print job is split into two parts in the migration of a cyclic print job. The migration creates 
a job of the "Print job" type in the job planner. The migration also creates a print job in the 
report system and connects it with the newly created job.

Migration of system layouts
The following system layouts are migrated from WinCC V7.2:

WinCC V7.2
Print job

WinCC V13
System print job

WinCC V13
System report

AlarmControl - Picture Alarm Control - Picture @Alarm Control - Picture
AlarmControl - Table Alarm Control - Table @Alarm Control - Table
Function Trend Control - Picture Function Trend Control - Picture @Function Trend Control - Picture
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WinCC V7.2
Print job

WinCC V13
System print job

WinCC V13
System report

Online Trend Control - Picture Online Trend Control - Picture @Online Trend Control - Picture
OnlineTableControl - Picture Online Table Control - Picture @Online Table Control - Picture
OnlineTableControl - Table Online Table Control - Table @Online Table Control - Table
UserArchiveControl - Picture Recipe Control - Picture @Recipe Control - Picture
UserArchiveControl - Table Recipe Control - Table @Recipe Control - Table
RulerControl - Table Ruler Control - Table @Ruler Control - Table
RulerControl - Picture Ruler Control - Picture @Ruler Control - Picture

Changes in one of these system layouts are also available after the migration.

See also
Migration (WinCC V7.2) (Page 215)

Migration of report layouts (WinCC V7.2) (Page 247)

Migration of the "tag" object (WinCC V7.2) (Page 248)

Migration of a message sequence report (WinCC V7.2) (Page 249)

Migration of report layouts (WinCC V7.2)

Introduction
The layout file for a report from WinCC V7.2 is split up into several sections. The structure of 
a layout in WinCC differs in several details. Therefore, the output of a report may differ slightly 
from the output in WinCC V7.2 after the migration.

Migration of report layouts
The following table shows the different structure of the layouts of WinCC V7.2 and WinCC:

WinCC V7.2 WinCC
Static layer of the cover sheet Watermark cover sheet
Cover sheet Title page
Static layer of the header Header detail page
Static layer of the report content Watermark detail page
Log content Detail page
Static layer of the footer Footer detail page
End page Back page
Line layout Line report

If a report layout contains page feeds, the migration generates a new detail page for every 
page feed in the report of WinCC.

The report objects that are allowed in a certain section of a report differ in WinCC V7.2 and 
WinCC. If a report object from a WinCC V7.2 log is not allowed in WinCC, this object is not 
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migrated. If a report object is not migrated, an alarm is output in the info window and in the 
migration report.

See also
Basics on migration of reports (WinCC V7.2) (Page 245)

Migration of the "tag" object (WinCC V7.2)

Introduction
Some report objects that are available in WinCC V7.2 are no longer supported by WinCC. The 
migration maps no longer available objects to objects available in WinCC as far as possible. 

Static metafile
When a copy of the WinCC V7.2 project is migrated, the storage directory of the assigned 
*.emf file cannot be resolved by the migration. A corresponding note is entered in the migration 
report. 

I/O field of a report
The "tag" report object from WinCC V7.2 is no longer available in WinCC. The object is replaced 
in WinCC by an I/O field. When mapping the "Tag" object to the I/O field, the properties 
"Calculation" and "Output value" are replaced by the "Process value" property. The 
"Calculation" property has priority over the "Output value" property. If both properties are used 
in the project to be migrated, the value of the "Calculation" property is migrated. The value of 
the "Output value" property is not migrated.

The migration takes places as shown in the table below:

WinCC V7.2 WinCC 
Calculation Output value Process value
not set not set not set
Script not set Script
not set Tag Tag
Script Tag Script

If the value of a property is not migrated, an alarm is output in the info window and in the 
migration report.

See also
Basics on migration of reports (WinCC V7.2) (Page 245)
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Migration of a message sequence report (WinCC V7.2)

Introduction
A print job is available for a message sequence report in WinCC 13. You can configure a 
system report for line printers or a system report for page printers for this print job. In 
WinCC V7.2, only one print job is available for a line report as well but several layouts can be 
configured for the output.

Migration of a message sequence report 
Since only a line layout and a page layout are allowed for the message sequence report in 
WinCC, the layout configured on the print job is migrated. If you want to use another type of 
message sequence report after the migration, you must execute the "Add system reports" 
command in WinCC in the reports' shortcut menu. 

If a report layout is not migrated, an alarm is output in the info window and in the migration 
report.

See also
Basics on migration of reports (WinCC V7.2) (Page 245)

Migration of the user administration (WinCC V7.2)

Migrating user administration
The user administration of WinCC V7.2 differs from that in WinCC in several details. The 
migration of the user administration may therefore lead to changes.     

In WinCC V7.2, a user may have authorizations which differ from the authorizations of his user 
group. In WinCC the authorizations are assigned at the user group level.

To migrate all authorizations, the migration creates a new user group for every user group first. 
A new group is created additionally for every user whose authorizations differ from the user 
group. If several users have the same deviation from the group authorization, they all become 
members of the same, newly created group.

Example 1

WinCC V7.2 WinCC after migration
Group 1(Auth A, Auth B)
User 1(Auth A, Auth B)
User 2(Auth C)
User 3(Auth C)

Group 1(Auth A, Auth B)
User 1

 Group 1_1(Auth C)
User 2
User 3
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Example 2

WinCC V7.2 WinCC after migration
Group 2(Auth A, Auth D)
User 4(Auth D)
User 5(Auth A, Auth B)

Group 2(Auth A, Auth D)
User empty

 Group 2_1(Auth D)
User 4

 Group 2_2(Auth A, Auth B)
User 5

Example 3

WinCC V7.2 WinCC after migration
Group 3(Auth C, Auth E)
User empty

Group 3(Auth C, Auth E)
User empty

An alarm is output in the info window and in the migration report for every newly created user 
group.

Migrating passwords
Passwords are not migrated. The password "administrator" is set by default for the 
administrator. Users are not assigned any passwords. This means that you must assign new 
passwords in WinCC.

Migration of cycles (WinCC V7.2)

Migration of  cycles
In WinCC V7.2, there are two types of cycles:    

● Update cycles

● Logging cycles

These types of cycles are edited in WinCC V7.2 in different editors.

In WinCC there is only one editor for editing all cycles.

The cycles of a project are migrated as follows:

● The 10 standard update cycles are used unchanged.

● The migration creates five user-defined update cycles.

● The migration creates a new cycle for every update cycle.

WinCC manages internally which cycles are used for updating and which for logging.

Migrating projects and programs
4.1 Migrating projects in a TIA portal project

WinCC Professional V13.0
250 System Manual, 02/2014



Unsupported settings 
Not all of the cycle settings available in WinCC V7.2 are supported by WinCC. During migration, 
an unsupported setting is replaced by an existing one in WinCC and a warning is generated.   

The log tags with an unsupported acquisition cycle are therefore logged in Runtime with a 
cycle other than the one configured. 

Example: If a cycle was configured for "Monday", "Wednesday" and "Friday", for example, the 
tag is logged "Once Daily" after migration.  

Migration of process value logging (WinCC V7.2)

Introduction
The settings for process value logging in WinCC V7.2 are migrated to WinCC. There are special 
features in this regard. 

Compressed logs
WinCC supports compressed logs from WinCC V7.2 with one exception: In WinCC V13, there 
is no "Difference" compression method. 

During migration, the "Difference" method  is replaced by the "Current" method.  

Weighted quality codes
Evaluation criteria for the quality code can be entered in WinCC V7.2. This is done in the Tag 
Logging editor for the compressed log or in the properties of the compressed tags.  

Weighted quality codes are not supported in WinCC V13. During migration, these settings are 
ignored and a warning is generated. 

Manual input
In WinCC V7.2, values can be entered manually in logs and in individual log tags. There is 
also the "Recalculation with manual input" function. 

Manual input and recalculation are not supported in WinCC V13. During migration, these 
settings are ignored and a warning is generated.  

Basic Process Control (WinCC V7.2)

Introduction
A project in which you have used Basic Process Control can always be migrated to WinCC. 
However, specific configurations for Basic Process Control are lost in the migration of such a 
project.     
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Migration of Basic Process Control
Default screens of Basic Process Control as well as screens generated by Basic Process 
Control are not migrated. Other screens of project are migrated. But these screens can include 
objects that are not supported by WinCC. These objects are not migrated. This concerns the 
following objects:

● Acoustic alarms

● 3D bar

● Extended analog display

● Extended status display

● Group display

A screen hierarchy which was created with Basic Process Control will not be migrated. Only 
those screens are migrated which are configured for the display in the work area. Screen in 
screen characteristics are not migrated.

Unsupported components and functions
The following components of Basic Process Control are not supported by WinCC:

● OS Project Editor

● Time Synchronization

● Lifebeat Monitoring

● Picture Tree Manager

● Block List Editor

● Area-specific user administration

● Multi-VGA

Entries in the start list for processes from Basic Process Control are not supported by the 
migration.

If you call API functions of Basic Process Control in a script, you get an error message in the 
compiling of the project.

Appropriate error messages are output in the info window and the migration log.

Copying runtime data (WinCC V7.2)

Runtime data
When migrating a project, the configuration data is migrated. You can copy the runtime data 
during migration to continue using it. 

The runtime data consists of the following:
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● User logs from user archives
User logs are process data that are saved in a database in Runtime.

● Log data
The data of data logs and alarm logs are acquired and logged in runtime.

See also
Migration (WinCC V7.2) (Page 215)

Reference (WinCC V7.2)

Migration of data types (WinCC V7.2)

Introduction
The following table describes the mapping of data types from WinCC V7.2 to the data types 
in WinCC.

Migrating data types
The internal data types are mapped as follows during migration:       

Internal data types of WinCC V7.2 Internal data types of WinCC
Bool Bool
Char SByte
Byte UByte
Int Short
UInt UShort
Long Long
ULong ULong
Float Float
Double Double
String WString
DateTime DateTime

Mapping of the S7 data type "Timer"
An external tag with the S7 data type "Timer" with timer address is mapped to the S7 data type 
"Timer". The address will be retained.

An external tag of the S7 data type "Timer" addressing a data block or a memory address will 
be mapped to the S7 data type "S5 Time". The address will be retained.

Example:

WinCC V7.2
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Tag S7 data type Address Comment
Timer_Actual_Value Timer T10 BCD coded timer value
Timer_Setpoint_Value Timer DB10.DBW200 BCD coded timer value
Timer_Setpoint_Value#2 Timer MW20 BCD coded timer value

WinCC

Tag S7 data type Address Comment
Timer_Actual_Value Timer %T10 BCD coded timer value
Timer_Setpoint_Value S5Time %DB10.%DBW200 BCD coded timer value
Timer_Setpoint_Value#2 S5Time %MW20 BCD coded timer value

See also
Migration (WinCC V7.2) (Page 215)

Changing of function names (WinCC V7.2) (Page 254)

Changing of function names (WinCC V7.2)

Changed function names
In WinCC, the function names of C functions and VB functions sometimes change in relation 
to WinCC V7.2. This affects the following function names:

WinCC V7.2 WinCC
GetLinkedVariable GetLinkedTag
GetLocalPicture GetLocalScreen
GetParentPicture GetParentScreen
GetParentPictureWindow GetParentScreenWindow
PASSCheckLevelPermission IsUserAuthorized
OpenHomePicture ActivateStartScreen
OpenNextPicture ActivateNextScreen
OpenPrevPicture ActivatePreviousScreen
OpenStoredPicture ActivateStoredScreen
StorePicture StoreScreen
GetLanguage GetLanguageByLocaleID
InquireLanguage InquireLocale or InquireLocaleID
SetLanguage SetLanguageByLocaleID
OpenPicture ActivateScreen
PASSLoginDialog ShowLogonDialog
ProgramExecute StartProgram
DeactivateRTProject StopRuntime
ExitWinCC StopRuntime
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See also
Migration of functions and actions (WinCC V7.2) (Page 242)

Migrating integrated projects

Migrating an integrated project

Introduction
PLCs and HMI devices contained in a project integrated into STEP 7 are connected with each 
other by the configuration. The configuration data of WinCC V7.2 and STEP 7 are also 
connected to each other. During migration of an integrated project, the complete project is 
migrated with the parts from WinCC V7.2 and STEP 7. The connections are retained.

Migrating an integrated project 
When migrating an integrated project, the same requirements apply for the WinCC V7.2 
component as those for the migration of a non-integrated WinCC V7.2 project. The objects 
and properties contained in the WinCC V7.2 part must be supported by WinCC, e.g., the 
communication driver. 

In addition to the requirements for the WinCC V7.2 part, other requirements apply for the 
STEP 7 V5.4 SP5 or STEP 7 V5.5 component of the integrated project. The objects and 
properties contained in the STEP 7 V5.4 SP5 or STEP 7 V5.5 component must be supported 
in STEP 7. For detailed information, refer to the documentation for STEP 7. 

In order to be able to fully migrate an integrated project, the following components must be 
installed on the PC for the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC V7.2

In order to be able to fully edit an integrated project, the following components must be installed 
on the PC for the editing:

● STEP 7

● WinCC

If you only want to save the project in migration format, the migration tool is available. See 
Auto-Hotspot for additional information.

An integrated project is always fully migrated. You cannot migrate the WinCC project contained 
in the integrated project on its own.  You can only migrate the contained STEP 7 project on its 
own. If you want to migrate the STEP 7 project on its own, you must delete the integrated 
WinCC project in the SIMATIC-Manager. Then you migrate the STEP 7 project without the 
WinCC project.

Client with own project
Clients with own project are not supported in WinCC. If you create a WinCC Client in the 
SIMATIC-Manager, a Client with its own project is created automatically. The Client project is 
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integrated in STEP 7. If the migration recognizes a Client with own project, it cancels the 
migration. To migrate the STEP 7 project despite this, you must delete the Client with own 
project in the SIMATIC-Manager. Then you migrate the STEP 7 project without the WinCC-
Client.

Storage location of an integrated WinCC project
If you want to migrate an integrated project, the HMI parts which is contained must be on the 
same PC as the STEP 7 part of the project. If the HMI part is on another PC, only the STEP 7 
part is migrated, the HMI part of the project is missing after the migration.

Unsupported objects
The following components are not supported by the migration:

● STEP 7 multiproject
A STEP 7 multiproject cannot be migrated; the migration cancels the procedure.

● Central Archive Server - CAS
If an integrated project contains a CAS, the migration is executed. The CAS data are not 
migrated, however, and are missing after the migration.

Migrating an integrated project

Introduction
When migrating an integrated project, the components from both the WinCC V7.2 project and 
the STEP 7 project are migrated. This means you need to select the project file with the file 
extension "*.s7p" for migration. During migration, the data is copied from the existing project 
and migrated to a new project. You cannot migrate to an existing project.

The migration can be started in both the Portal view and the Project view.

You should only migrate a project in a newly started TIA portal.

If you only want to save the project in migration format, the migration tool is available. See 
Auto-Hotspot for additional information.

Requirement
● STEP 7 V5.4 SP5 or STEP 7 V5.5 and all add-on packages used in the project are installed.

● STEP 7 and all the options packages used in the project are installed.

● The TIA portal is newly started.

● No project is open in WinCC.

● An integrated project is available.

● The integrated project is not open.
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Procedure
Proceed as follows to migrate an integrated project in the Portal view:       

1. Select the action "Start > Migrate Project".

2. In the "Source path" box, navigate to the project you want to migrate.

3. Select the "*.s7p" project file.

4. Change the information for the project to be created, if necessary. For example, change 
the project name or project path. The data to be migrated is created in the new project.

5. Click "Migrate".
A new project is created and migration of the data is started:

– The Project view opens.

– The progress of the migration is shown in a migration window.

– Warnings and errors about the migration process are displayed in the Inspector window 
under "Info > General".

– All information about the migration is saved in a report file.

– An alarm is displayed upon completion of the migration. The alarm contains a link that 
you can use to open the report.

6. Once migration is completed, save the project.
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After the migration you can find a newly created device in the project tree for every migrated 
HMI device. You will also find a newly created device for every migrated PLC. These devices 
include the migrated data.

Opening the migration report
The migration report is saved together with the migrated project. You can view the report at a 
later point in time. Open the report file as follows:

1. Select the project.

2. Select the "Properties" menu.

3. Click "Project History".

4. Click on the report file.
The migration report opens.

4.1.8 Migrating integrated projects

4.1.8.1 Migrating an integrated project

Introduction
In integrated projects, you use SIMATIC controllers and WinCC components together in a 
project. When an integrated project is migrated, the complete project will be migrated with 
components from WinCC and STEP 7. Configured connections between control and 
visualization remain intact.

Migrating an integrated project   
When migrating an integrated project, the same requirements apply for the STEP 7 component 
as those for migration of a non-integrated STEP 7 project. The objects and properties contained 
in the WinCC component must also be supported in WinCC (TIA Portal). For detailed 
information, refer to the documentation for WinCC.     

Also note that the initial project must be compiled before the migration.

To fully migrate an integrated project, the following components must be installed on the PG/
PC performing the migration:

● STEP 7 V5.4 SP5 or STEP 7 V5.5

● WinCC V7.0 SP3 or WinCC Flexible 2008 SP2 and SP3

To be able to fully post-edit an integrated project, the following components must be installed 
on the PC for post-editing:

● STEP 7 Professional V12 SP1

● WinCC Basic, WinCC Comfort/Advanced or WinCC Professional, depending on the 
components used
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Using the migration tool
It is necessary to use the migration tool under the following circumstances:

● The initial project is not located on the same PG/PC as the installation of the TIA Portal.

● SCADA devices are included in the initial project. These can only be migrated with the 
migration tool.

● WinCC Professional V12 and STEP 7 with WinCC V7.0 SP3 cannot be installed on the 
same PG / PC. Therefore, integrated projects with WinCC V7.0 SP3 parts must be prepared 
for migration with the migration tool.

Migration of the STEP 7 part of an integrated project
An integrated project is always fully migrated. Individual components cannot be migrated on 
their own. You can only migrate the included STEP 7 project alone, if you have previously 
deleted all HMI stations in the SIMATIC stations in the SIMATIC Manager and then recompiled 
the project in NetPro.

Alternatively, you can open the project in an installation of STEP 7 V5.4 SP5 or V5.5 without 
an installation of WinCC. Then, save the project again and select the "Reorganize" function 
during saving. The WinCC parts are then automatically removed when the copy is saved.

You can then migrate the STEP 7 project without the WinCC project.

Migration of an integrated project with the hardware configuration
In integrated projects, HMI devices are migrated even if the hardware configuration is not 
included in the migration. The STEP 7 part of the hardware configuration, including network 
configurations, and connections and interrupts, is migrated only if you include the hardware 
configuration in the migration. Otherwise, unspecified modules will be created for the STEP 7 
devices and you will need to convert them into suitable modules after the migration.

HMI modules that are plugged into a PC station are converted to a separate Station during the 
migration. If you perform the migration without including the hardware configuration, the 
migrated project then contains a non-specified SIMATIC PC Station and a SIMATIC PC Station 
with the HMI devices. References to HMI devices are not imported during migration. When the 
hardware configuration is included, the migrated project contains two separate stations: the 
HMI Station and the PC Station.

Storage location of an integrated WinCC project
If you migrate an integrated project, the HMI part of it must be on the same PG/PC as the 
STEP 7 part of the project. If the HMI part is on a different PG, then only the STEP 7 part will 
be migrated.
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Unsupported objects
The following components are not supported for migration:

● STEP 7 multiproject
A STEP 7 multiproject cannot be migrated. Migration will be canceled.

● Central Archive Server - CAS
If a CAS is part of an integrated project, then the migration will be carried out but the CAS 
data will not be migrated.

See also
Post-editing integrated projects (Page 260)

4.1.8.2 Post-editing integrated projects
If you have migrated an integrated project without hardware configuration, unspecified CPUs 
are used instead of the CPUs of the original project. Since no connection can exist between 
an unspecified CPU and an HMI device, connections from the source project are also imported 
only unspecified. 

The following figure shows the state after a Migration without hardware configuration in an 
example project:

1

2

① The original CPU 317-2 PN/DP was replaced with an unspecified CPU during migration.
② The link between the CPU and HMI device is also unspecified and must be renewed.
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Procedure
To continue to use an integrated project after the migration, follow these steps:

1. Convert the unspecified devices into suitable devices again.

2. Restore the integrated HMI connection between the HMI device and the PLC.

3. Connect all HMI tags to the newly created integrated connection.

4. Restore the connection between HMI tags and PLC tags.

5. Delete the non-integrated HMI connection.

In the following chapters a sample project is used to describe the individual steps in more detail.

See also
Converting unspecified CPUs into specified CPUs (Page 261)

Creating an integrated HMI connection (Page 263)

Re-linking HMI tags (Page 265)

Deleting an unspecified connection (Page 266)

4.1.8.3 Converting unspecified CPUs into specified CPUs
The first step after the migration without hardware configuration is the conversion of the 
unspecified CPUs into specified CPUs. Unspecified CPUs are placeholders for certain CPUs 
from the hardware catalog that are not currently known. You can define general parameters 
and home the CPUs already in the user program. However, the project is not fully functional 
until the unspecified CPU has been specified.
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Specifying a CPU using module replacement    
To use module replacement to specify an unspecified CPU, follow these steps:

1. Select the unspecified CPU in the network or device view.

2. Select the "Replace device" command in the shortcut menu.
The "Replace device" dialog opens.

1

2

3. Under "New device" in the tree structure, select the module with which you want to replace 
the unspecified CPU. (Area 1)
"Compatibility information" provides you with information on the extent to which the selected 
CPU is compatible with the configuration in source project. (Area 2)

4. Click "OK".

5. Perform the above-described steps for all unspecified CPUs.

See also
Creating an integrated HMI connection (Page 263)
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4.1.8.4 Creating an integrated HMI connection
After you have specified the unspecified CPU, establish the connection to the HMI-device.

Procedure   
To create a connection graphically, follow these steps:

1. On the toolbar, click the "Connections" icon. This activates connection mode.

2. Select the connection type "HMI connection" in the adjacent drop-down list.
The network view highlights in color all CPUs and HMI devices that can be used for an HMI 
connection.

3. You can now have the connection path automatically determined, or explicitly select a 
connection path via specific interfaces:

– Allow connection path to be automatically determined
Select the source CPU for a connection. Drag the mouse to the target components. 
Confirm the connection endpoint with another mouse click.
Alternatively: While holding down the shift button, select the target components and with 
the right mouse button select the "Add new connection" command.

– Selecting an explicit connection path from interface to interface
Click on the subnet interface in the device for which you want to create a connection. 
Hold down the mouse button, drag the cursor to the relevant interface in the target device 
and then release the mouse button.
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Result
The following figure shows the state after the integrated connection has been created:

1

2

3

① An integrated HMI connection is created and highlighted in the network view.
② The connection is shown in the connection table of the components.
③ The connection can be edited in the connection properties.

 

See also
Re-linking HMI tags (Page 265)
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4.1.8.5 Re-linking HMI tags
When you have created a new HMI connection between the CPU and HMI device, you have 
to assign the existing HMI tags to the new connection. Perform the following steps for each 
line in the relevant tag table.

Procedure   
To re-link HMI tags, follow these steps:

1. In the project tree, navigate to the HMI tags and double-click the relevant tag table to show 
this in the work area.
The tag table opens.

2. Click the " ... " button in the "Connection" column.
A dialog box for selecting the connection opens.

3. Select the newly established HMI connection.

4. Click the "✓" button to apply the selected connection.

5. On the toolbar, click the "Re-connect PLC tag" button.
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See also
Deleting an unspecified connection (Page 266)

4.1.8.6 Deleting an unspecified connection
Finally, you can remove unspecified connections that still remain from the source project.

Procedure   
To delete unspecified connections, follow these steps:

1. In the project tree, open the HMI device and double-click the "Connections" entry.
The connection table opens.

2. Select the row with the old connection in the table.

3. Select the "Delete" command in the shortcut menu of the connection line.

4. Perform the above-described steps for all unspecified connections of the source project.

4.2 Migrating S7-1200 to firmware as of V4

4.2.1 Basic information on upgrading to V4

Introduction
If you have used a CPU with firmware version V3 in your project and want to upgrade to a 
CPU with firmware V4.0 or later, you can easily replace the device. 
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The TIA Portal offers the "Change device" function for this purpose. The project remains 
unchanged when the device is replaced. You can continue using the programs that you created 
with firmware version V3. 

Rules
The following basic rules apply when replacing a device:

● Device replacement is only possible if the CPU used to date has been operating with 
firmware version V3.0. S7-1200 CPUs with firmware version V1.0 or V2.0 must first be 
replaced with a V3.0 CPU.

● It is not possible to replace a V4 CPU with a V3 CPU. If you want to continue using the 
existing V3 CPU, create a copy of this CPU before replacing the device.

● The program cannot be transferred to the new CPU via a memory card. Instead, use the 
"Change device" function, which is described in the following sections.

HMI panels
Configured HMI panels are treated differently during device replacement, depending on the 
firmware version of the panel and the communication mode.

The following table shows the HMI connections that are supported with the migration:

Firmware version of 
the panel

PUT/GET 
communication

Migration to V4

V11 or later No S7-1200 does not support this configuration. Upgrade the firmware of the 
HMI panel to V12.0. Then compile and load the configuration.

V11 or later Yes S7-1200 supports this configuration. The connection is established 
automatically while you compile and load the project after replacing the 
device.

V12 or later No S7-1200 supports this configuration. The connection is established 
automatically while you compile and load the project after replacing the 
device. 

 
 

 Note
HMI TP 177B 4"

The HMI TP 177B 4" with firmware version V11.0.2 cannot be operated with S7-1200 V4. 
Replace the panel with a new device, if necessary.
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S7-1200 expansion modules
If you are already using the following centrally plugged S7-1200 modules in your system, you 
must perform a firmware update for these modules in order to guarantee operation with 
S7-1200 V4.

● ASi - Master - CM 1243 

● DP - Master - CM 1243-5 

● WAN CP - CP1243-1 

Newly shipped S7-1200 modules have the latest firmware installed ex works.

Protected blocks
Blocks equipped with know-how protection or copy protection cannot be converted to V4. If 
the project contains protected blocks, you must remove the protection prior to migration.

If these are supplied blocks and you do not know the password, ask your supplier either for 
the password or for a V4-compatible block.

 
 

 WARNING

Preventing personal injury and material damage

Changes are made to the program during device replacement in some cases. Therefore, 
thoroughly check the program in a test environment after replacing the device and before 
putting it in operation.

 

 
 

 Note
Additional support

You can find the latest FAQs about migrating to S7-1200 V4 (http://
support.automation.siemens.com/WW/view/en/82140966) in Siemens Industry Online 
Support.

If you need further assistance with migrating to S7-1200 V4, please contact SIMATIC 
Customer Support. 

 

See also
Migrating to V4 (Page 269)

Special considerations after migrating to V4 (Page 270)

Migrating projects and programs
4.2 Migrating S7-1200 to firmware as of V4

WinCC Professional V13.0
268 System Manual, 02/2014

http://support.automation.siemens.com/WW/view/en/82140966
http://support.automation.siemens.com/WW/view/en/82140966


4.2.2 Migrating to V4

Requirement
● A CPU with firmware version V3 is available in the project.

● The project contains no protected blocks.

Procedure
Proceed as follows to replace a CPU:

1. Select the V3 CPU you want to replace.

2. Select the "Change device" command in the shortcut menu.
The "Change device" dialog box appears.

3. Under "New device" in the tree structure, select the V4 CPU with which you want to replace 
your current V3 CPU.

4. Click "OK".
The existing CPU is replaced by the new one.

5. Select the new CPU and select the "Compile > Hardware and software (only changes)" 
command in the shortcut menu.
The device configuration and the user program are compiled again. 

6. Optional: If necessary, apply know-how protection or copy protection to individual blocks 
in the program.

7. Select the new CPU and select the "Download to device > Hardware and software (only 
changes)" command in the shortcut menu.
The device configuration and the user program are loaded into the new CPU.
This completes the device replacement.

 
 

 WARNING

Preventing personal injury and material damage

Changes are made to the program during device replacement in some cases. Therefore, 
thoroughly check the program in a test environment after replacing the device and before 
putting it in operation.
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 Note
Additional support

You can find the latest FAQs about migrating to S7-1200 V4 (http://
support.automation.siemens.com/WW/view/en/82140966) in Siemens Industry Online 
Support.

If you need further assistance with migrating to S7-1200 V4, please contact SIMATIC 
Customer Support. 

 

See also
Basic information on upgrading to V4 (Page 266)

Special considerations after migrating to V4 (Page 270)

4.2.3 Special considerations after migrating to V4

Functional changes in V4
S7-1200 V4 offers significantly enhanced functionality. The most important functional changes 
that you need to consider after migrating from V3 are described briefly below. 

You can find more information on S7-1200 in the "SIMATIC S7-1200 Programmable controller" 
system manual.

See also: 

TIA Portal in Siemens Industry Online Support (http://support.automation.siemens.com/WW/
view/en/65601780)

Organization blocks
With S7-1200 V4, you can specifically set the interruptibility of each organization block used. 
When a device is replaced, all the organization blocks are configured as non-interruptible, to 
ensure that the executability of your V3 program remains unchanged. The OB priorities from 
the V3 program also remain unchanged. After migration, you can change the settings for 
priority and interruptibility as needed.

The behavior of diagnostic interrupts in V4 has changed as follows:

In V3, the start information always contained information on the triggering module, including 
the channel number. In V4, this information is only generated for a pending diagnostics event. 
If no diagnostic event is pending, for example, because the fault has already been corrected, 
only the triggering module is indicated.
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Access levels
S7-1200 V4 offers an extended access level concept. The following table shows how the 
protection levels of the V3 firmware are indicated in V4:

V3 protection level V4 access level
No protection Full access (no protection)
Read-only Read access
Write/read protection HMI access

The access level "No access (complete protection)" has been newly introduced with V4. It was 
not available in previous versions.

Instruction libraries
After migrating to S7-1200 V4, instructions from the libraries of the V3 firmware version are 
still available. This ensures that you can continue to use your program unchanged. In addition, 
S7-1200 V4 offers many new instructions which are also compatible with the instructions of 
the S7-1500. 

You can find more information on the instruction libraries of S7-1200 in the "SIMATIC S7-1200 
Programmable controller" system manual. 

See also:

TIA Portal in Siemens Industry Online Support (http://support.automation.siemens.com/WW/
view/en/65601780)

Motion Control
When a device is replaced, the Motion Control objects from the libraries of the firmware 
versions V1 and V2 are replaced with the corresponding objects from the V3 libraries. The 
objects from V3 libraries are compatible so that you can continue to use the programs 
unchanged. 

The libraries of the S7-1200 V4 offer many new Motion Control functions, which are compatible 
with the functions of the S7-1500. If you want to use V4 libraries, select them on the 
"Instructions" task card after replacing the device.

You can find more information on the new Motion Control functions in the "SIMATIC S7-1200 
Programmable controller" system manual. 

See also:

TIA Portal in Siemens Industry Online Support (http://support.automation.siemens.com/WW/
view/en/65601780)

Web server
The following settings for operation via a web server are transferred from the V3 CPU to the 
V4 CPU during device replacement:

● Activate web server on this module

● Permit access only with HTTPS
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If you want to operate the V4 CPU via a web server, you need to set up user accounts with 
assigned user rights in the user management. Only the standard web pages are available to 
standard users without any additional rights.

 
 

 Note
Additional support

You can find the latest FAQs about migrating to S7-1200 V4 (http://
support.automation.siemens.com/WW/view/en/82140966) in Siemens Industry Online 
Support.

If you need further assistance with migrating to S7-1200 V4, please contact SIMATIC 
Customer Support. 

 

Communication via PUT/GET
Communication via PUT/GET is enabled after the device replacement. Note that the new 
integrated connection types offer a security standard higher than PUT/GET communication. 
If you do not use PUT/GET communication, you should disable it.

See also
Basic information on upgrading to V4 (Page 266)

Migrating to V4 (Page 269)

4.3 Programming recommendations

4.3.1 The new S7-1500 CPU functions at a glance

Higher performance
The S7-1500 represents a CPU series that provides much higher performance than the CPUs 
of the S7-300/400 series. When programming with STEP 7 V5.x, you were probably used to 
working with programming methods such as absolute addressing to achieve higher 
performance from the CPU and leaner program code.

Due to the high performance that the S7-1500 provides, these programming methods are made 
obsolete.

In the paragraphs below we would like to introduce some new programming options of the 
S7-1500.
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Universal symbolism
The S7-1500 allows you to use the symbolism throughout the entire project. Using the auto-
complete function, you are given context-dependent support for programming with symbols 
within the programming editors. The data elements, for example those in a data block, are 
assigned only a symbolic name in the declaration but no fixed address within the data block. 
This allows you to fully exploit the high performance of the S7-1500 when accessing these 
data elements. The absolute addresses of operands need not be known and access errors 
are avoided.

Your program code will be clearer due to the symbolism and you have to comment less. All 
points of use are automatically updated when a correction is made to the symbolism.

An example of the use of universal symbols is available at: Symbolic addressing (Page 276)

Optimized block access
With optimized block access, the declared data elements are arranged automatically in the 
available memory area of the block in a way that makes optimal use of its capacity. The data 
is structured and saved in way that is optimal for the CPU used. The storage is left to the 
system. The data elements are assigned only a symbolic name in the declaration by which the 
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tag within the block can be addressed. This allows you to increase the performance of the 
CPU. Access errors, from the HMI, for example, are not possible.

You can find additional information on blocks with optimized access under "See also".

New data types
The new data types LWORD, LINT, ULINT, LTIME, LTOD, LDT and the array (32-bit limit) 
offer much higher calculation accuracy when using mathematical functions. In the area of 
implicit and explicit data type conversion, you have more options in comparison to the CPUs 
of the S7-300/400 series.

You can find additional information on the new data types under "See also".

PLC data types
PLC data types (UDT) are data structures that you define and that can be used multiple times 
within the program. The structure of a PLC data type is made up of several components, each 
of which can contain different data types. You define the type of components in the declaration 
of the PLC data type.
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You can use the PLC data type as a base data type for defining tags and as a template for 
creating global data blocks. If you later make changes to the PLC data type, the changes are 
automatically updated at all points of use.

You can also symbolically access individual elements of an array within a PLC data type.

You can find additional information on the new data types under "See also".

You can find an example for using PLC data types under: Using PLC data types (UDT) 
(Page 284)

Uniform instructions in all programming languages
You are provided with a uniform set of instructions in all programming languages (LAD, FBD, 
STL, SCL, and GRAPH).

Slice access
Slice access gives you the option of specifically addressing areas within declared tags. You 
can implement symbolic access to a single bit up to the level of the tag. The single bit is then 
addressed absolutely.

You can find additional information on slice access under "See also".

Indirect addressing
Indirect addressing offers you the option of addressing operands whose address is not 
calculated until runtime. All programming languages provide general methods for indirect 
addressing, for example, via POINTER. In the SCL programming language, you can also use 
PEEK and POKE instructions.

You can find additional information on indirect addressing under "See also".

Additional programming recommendations
You can find more information about programming recommendations and a programming 
guide in the Siemens Industry online support under:

● FAQs: Programming recommendations (http://support.automation.siemens.com/WW/
llisapi.dll?aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&Datakey=47071380&extranet=standard&groupid=40
00002&viewreg=WW&nodeid0=29156492&objaction=csopen)

● Background and system descriptions in the Programming Guideline (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=100&lang=en&referer=%2fWW
%2f&func=cslib.cssearch&nodeid0=4000024&viewreg=WW&siteid=csius&extranet=stand
ard&groupid=4000002&objaction=cssearch&content=adsearch%2Fadsearch%2Easpx)
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4.3.2 Symbolic addressing

Advantages of symbolic addressing
The use of universally applied and meaningful symbols in the overall project makes the 
program code easier to read and understand.

This gives you the following advantages:

● You do not have to write detailed comments.

● Data access is faster.

● No errors occur when accessing data.

● You no longer have to work with absolute addresses.

● The assignment of the symbol to the memory address is monitored by STEP 7, which 
means all points of use are automatically updated when the name or the address of a tag 
changes.

Programming in STEP 7 V5.x
STEP 7 V5.x already gave you the option to write a program that is easier to read by using 
descriptive names for operands and blocks. You did this by assigning the symbolic operands 
to memory addresses and blocks in the symbol table. In order for a change in the symbolism 
to also have an affect on the program code in the programming editor, you had to use the 
"Operand priority" property to specify whether the symbol or the absolute value had priority.

The use of symbolic addressing allowed you to create a program with greater clarity. However, 
in some cases, such as when programming with user-defined data types (UDT), this could 
impair performance.

You could increase the performance by ignoring the symbolism in the UDT and using absolute 
addressing. This made in necessary, however, to know the data storage. Changes to the UDT 
were not automatically updated. Using absolute addressing, you could also access parts of a 
tag and edit these. The only drawback of absolute addressing, however, was that after a certain 
level the program code was cluttered and you had to insert additional comments for better 
orientation.

Procedure in STEP 7 TIA Portal
The S7-1500 CPU offers much higher performance than the S7-300/400 CPUs. To fully use 
this high performance, we recommend you enable optimized block access for all blocks and 
use symbolic addressing in the program code.

The programming editor helps you work with symbols through context-sensitive input help, for 
example, auto-complete. Using it, you can easily access existing tags or instructions during 
programming.
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Programming example
The following example shows you how to symbolically access individual elements:

You can use the tag names that you have defined in the block interface directly at the 
parameters of the TON instruction without knowing the absolute address of the tag.

See also
Using VARIANT instructions (Page 290)

4.3.3 Using IEC timers and counters

Advantages of IEC timers and counters
The universal use of IEC timers and counters makes your program code more efficient.

This gives you the following advantages:

● The blocks can be called multiple times with newly generated instance data blocks.

● The IEC counters have a large counting range.

● Compared to S5 timers, IEC timers have better performance and greater time accuracy.
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Programming in STEP 7 V5.x
The S5 timers and counters in STEP 7 V5.x were addressed absolutely via a number. Due to 
this dependency on numbers, program blocks were not reusable with S5 timers and counters.

The value range of a timer was limited to 9990 seconds and that of a counter limited to a 
maximum of 999.

Procedure in STEP 7 TIA Portal
You declare IEC timers and counters in the program block where they are called or needed. 
The IEC timer is a structure of data type IEC_TIMER, IEC_LTIMER, or TON_TIME and 
TON_LTIME, for example, which you can also declare as a local tag in a block. The IEC counter 
is a structure of data type IEC_SCOUNTER, IEC_USCOUNTER, etc.

Programming example in the TIA Portal
The following example shows you how to declare an IEC timer and IEC counter as a local tag:

The data of the TON IEC timer and the CTU IEC counter is stored as a local tag (multi-instance) 
in the block interface.
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4.3.4 Flexibly using enable output ENO

Advantages
You can to detect runtime errors and avoid program termination using the EN/ENO mechanism 
for each instruction and block call. Overflow, for example, is reported via the ENO enable 
output for mathematical functions.

In STEP 7 TIA Portal, the ENO enable output is disabled by default in the programming 
languages LAD and FBD. If needed, you can activate the enable output and thereby 
deliberately target the instructions for which you want to have error evaluation.

This gives you the following advantages:

● The performance increases with ENO disabled.

● Runtime errors do not cause the CPU to go to STOP when ENO is enabled.

Procedure in STEP 7 TIA Portal
Proceed as follows to activate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to activate the EN/ENO 
mechanism.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is generated for the instruction. Other instructions are inserted with the 
enable output.

The tables below list the instructions for which ENO enable output can be disabled:

Basic instructions
Math functions ADD, SUB, MUL, DIV, MOD, INC, DEC, ABS, NEG, SQR, SQRT, LN, 

EXP, SIN, COS, TAN, ASIN, ACOS, ATAN, FRAC, EXPT, MIN, MAX, 
LIMIT, CALCULATE

Move operations MOVE, SWAP, MOVE_BLK, UMOVE_BLK, FILL_BLK, UFILL_BLK, 
MOVE_BLK_VARIANT

Conversion operations CONVERT, ROUND, CEIL, TRUNC, FLOOR, NORM_X, SCALE_X
Word logic operations AND, OR, XOR, INV, DECO, ENCO
Shift and rotate SHR, SHL, ROR, ROL

 

Extended instructions
String + Char CONCAT, LEFT, RIGHT, MID, DELETE, INSERT, REPLACE, FIND, 

LEN, S_CONV
Date and time T_CONV

You can find additional information on the EN/ENO mechanism in each programming language 
under "See also".
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Programming example
The following example shows you how to use instructions with the ENO enable output enabled 
and disabled:

If you have activated the ENO enable output, for example with the SUB instruction, all 
subsequent instructions are also applied with an activated enable output. If an arithmetic error 
occurs during the execution of the SUB instruction, the ADD instruction is not executed. 

The ENO enable output is disabled for the DIV instruction in the second branch. If a runtime 
error occurs during execution, the MUL instruction is executed anyway.

4.3.5 Using MOVE instructions in STL

Possible applications
You can now program with MOVE instructions in STL on an S7-1500 CPU.

This gives you the following advantages:

● The program structure is easier to create.

● The performance of the CPU increases.

Programming in STEP 7 V5.x
In STEP 7 V5.x, you used the "BLKMOV: Move block" and "UBLKMOV: Move block 
uninterruptible" system functions to implement the MOVE functionality.
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Procedure in STEP 7 TIA Portal
The following new MOVE instructions are available in STEP 7 TIA Portal:

● MOVE: Move value

● MOVE_BLK: Move block

● MOVE_BLK_VARIANT: Move block

● UMOVE_BLK: Move block uninterruptible

You can find additional information on the new MOVE instructions under "See also".

Programming example
The following example shows you how the "MOVE_BLK instruction works: Move block". An 
array block is copied into another array block:
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Using the MOVE_BLK instruction, ten elements from "Array_1" of the "Data_DB" data block 
are copied into "Array_2" of the same data block.

4.3.6 Implementing array access with a variable index

Advantages of the variable index
For addressing the components of an array, you can specify tags of the integer data type as 
well as constants as the index. Integers with lengths up to 32 bits are allowed here. When tags 
are used, the index is calculated during runtime. You can, for example, use a different index 
for each cycle in program loops. You can also access an array within a PLC data type.

This gives you the following advantages:

● No addressing with address registers or with self-assembled pointers, for example, an ANY 
pointer, is necessary.

● More flexibility within your program.

● The variable index is available in all STEP 7 programming languages.

● It uses the existing names of data blocks and array tags. This improves readability of the 
program code.

● The start address of the array does not have to be known.

● The program code is easier to write.

● The compiler generates optimized program code.

Procedure in STEP 7 V5.x
In STEP 7 V5.x, you had to use an address register with the help of a self-configured POINTER 
for indexed addressing of array elements. The SCL programming language already supported 
indirect addressing with variable index.
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Programming example in STEP 7 V5.x
The "Data_classic" data block is required for the following STL example. To address an 
element of the "Quantities" array, the following commands must be used:

STL Explanation
OPN "Data_classic" // The "Data_classic" data block is called.
L #index // The value of the local tag #index is loading in 

accumulator 1.
SLD 3 // Move bits 0 to 31 of accumulator 1 by 3 positions to 

the left.
// Fill the now empty bit places with zeros.

LAR1 // Load address register 1 with contents of accumulator 
1.

L DBW [AR1, P#10.0] // Load the array element addressed with #index into 
accumulator 1.
// P#10.0 = Start address of the array

You need to consider the following with this procedure, however:

● The array name is not used. This reduces the readability of the program code and makes 
it necessary to add a comment.

● The start address of the array (P#10.0) must be known to perform the addressing.

● The indexed addressing must involve the use of the address register.

Programming example in STEP 7 TIA Portal
The following syntax is used for indirect indexing of the "Quantities" array that was declared 
in the "Data_DB" data block:

  
"Data_DB".Quantities["i"] // One-dimensional array
"Data_DB".Quantities["i"].a // One-dimensional array of STRUCT
"Data_DB".Quantities["i","j"] // Multi-dimensional array
"Data_DB".Quantities["i","j"].a // Multi-dimensional array of STRUCT

Part Description
Data_DB Name of the data block in which the array is located
Quantitie
s

Tag of the Array data type

i, j PLC tags of the integer data type that are used as pointers
a Additional partial tag of the structure

The following example shows indirect indexing of an array component in STL.

You need another program line for addressing an array element:
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Addressing in STL Explanation
L "Data_DB".Quantities[#index] // The value of the array element #index 

is loaded directly from the data block 
into accumulator 1.

Note the following to get the best performance:

● Declare tags that are used as an array index as an integer of less than or equal to 32 bits.

● Store intermediate results and array indexes in the temporary local data area.

4.3.7 Using PLC data types (UDT)

Advantages of the PLC data types
PLC data types (UDT) are data structures that you define and that can be used multiple times 
within the program. The structure of a PLC data type is made up of several components, each 
of which can contain different data types. You define the type of components in the declaration 
of the PLC data type. By using PLC data types, you can optimally exploit the high performance 
of the S7-1500 CPU.

Many programs require contiguous data records that have to be processed by different 
locations in the program. They are optimized or replaced as the program runs. These are, for 
example:

● Data records for material tracking

● A parameter set for a motor setting

● Various recipes

This gives you the following advantages:

● PLC data type elements can also be addressed indirectly, which means the address is 
variable and is first calculated in runtime.

● Tags based on a PLC data type inherit all properties of the PLC data type.

● Modifying the PLC data type results in automatic adjustment of all tags derived from it.

● Using universal symbolism makes the program easier to read, because the names of the 
individual elements of a PLC data type are displayed in the program.

● Increased performance because optimized program code is generated.

● The PLC data type can be passed as a complete structure for a block call.

● Simplified calling interface due to fewer parameters that have to be supplied.

Procedure in STEP 7 V5.x
STEP 7 V5.x already gave you the option to create a data record as a structured tag using the 
STRUCT data type or a PLC data type (UDT). However, the performance was adversely 
affected by the use of symbolic addressing.

The declaration in the data blocks was mostly implemented as an anonymous structure. The 
blocks themselves were then programmed to pass the values of the structure as actual 

Migrating projects and programs
4.3 Programming recommendations

WinCC Professional V13.0
284 System Manual, 02/2014



parameters and the calculated values were copied back into the structure. This enabled you 
to also pass the data block number and use absolute addressing in the block. The number of 
parameters that you had to supply was often very large. The actual data was stored in the data 
blocks and the calculated values were passed to other blocks. But no symbolism was available 
when passing the data block tags.

Procedure in STEP 7 TIA Portal
If you work with PLC data types in your program, you can assign them to both a formal 
parameter and an actual parameter. This means you no longer have to declare each individual 
parameter. If a block has an input parameter that is based on a PLC data type, you must 
transfer a tag that has the same PLC data type as an actual parameter.

To use a PLC data type, follow these steps:

1. Declare the data records as PLC data type with a suitable name, for example, "Material 
tracking".

2. Use this data type to declare a data block or a DB tag.

3. Define the formal parameter as VAR_IN_OUT / VAR_IN or VAR_OUT tag in the block 
interface.

4. Assign the PLC data type to the formal parameter in the "Data type" column.

Programming example in the TIA portal
The following example shows the call and the parameter assignment of a function block (FB) 
with two formal parameters. The data type of the DB tag (Array [1 .. 10] of BOOL) and the PLC 
data type (UDT) are identical to the data types of the FB parameters.
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Declare the "UserDataType" PLC data type in the project tree in the "PLC data types" folder. 
Then use it as a data type for the "UserData_Var" tag. You declare both tags "UserData_Var" 
and "Arr_Var" in the "Data_block_1" data block and use them to supply the parameters of the 
"FB_Module" block.

4.3.8 Querying and fixing errors in the program code

Error handling in the TIA Portal
Various error scenarios can occur within the program code during runtime. These can involve, 
for example, an access error or an overflow in mathematical operations. If you do not catch 
such a runtime error using a program code sequence within your program, the CPU reacts as 
follows in the event of an error, depending on the model:

● CPU S7-1200:

– The CPU remains in RUN mode and writes an entry to the diagnostic buffer.

● CPU S7-1500:

– When a programming error occurs, the CPU goes to STOP mode and writes an entry 
to the diagnostic buffer.

– With an I/O access error, the CPU remains in RUN mode and writes an entry to the 
diagnostic buffer.

To be able to respond appropriately to possible errors, in addition to global error handling (for 
example, the use of the organization blocks "Programming error OB" or "I/O access error OB"), 
we recommend that you implement local error handling in your program (for example, use an 
EN/ENO mechanism, the parameters RET_VAL, STATUS and ERROR, or the instructions 
"GET_ERROR"/"GET_ERR_ID").

 

 Note
STL programming language

In STL, you use the BR bit of the status word instead of the EN/ENO mechanism.
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Global error handling intervenes at the end of each program cycle, while local error handling 
is capable of intervening immediately after an error occurs.

 

 Note
BR bit and EN/ENO mechanism as first indicator

A first indicator for an error can be either the BR bit of the status word or the ENO enable 
output. If these return signal state "0", there is an error in the execution of the instruction. 
Signal state "1" indicates that there is no error and no further error analysis is necessary.

 

Options for local error handling
The following options for local error handling of programming and access errors are available:

Error handling method Validity Explanation
EN/ENO mechanism S7-1200/15

00
You can use the ENO enable output to detect and handle runtime errors. 
Execution of subsequent instructions depends on the signal state of this 
parameter. You can avoid program crashes by using the EN/ENO mechanism. 
The block status is passed on in the form of a Boolean tag.

Output parameter RET_VAL S7-1200/15
00

Using the RET_VAL parameter as the return value of system functions (SFCs). 
you can display general error codes that may relate to any instruction or specific 
error codes that apply only to the instruction at hand. A maximum of one tag of 
the data type INT or WORD can be output. This error handling method is 
suitable for querying a communication error or incorrect data access, for 
example.

Output parameters STATUS 
and ERROR

S7-1200/15
00

Using the STATUS and ERROR parameters as return values of system 
function blocks (SFBs), you can query device-specific error information. The 
error information is output in a pre-defined structure.

Instructions "GET_ERROR" 
and "GET_ERR_ID"

S7-1200/15
00

The instructions give you the opportunity to obtain an error ID or detailed error 
information. You can use the error information for an access error, for example, 
to determine the parameter that caused the access error. In order for the 
instructions to output the required error information, they must be programmed 
in the user program for each individual block from which potential errors are to 
be evaluated. This option is ideal especially for custom libraries with error 
handling. If you work with the "GET_ERROR" or "GET_ERR_ID" instructions, 
no error OB is called and there is no entry in the diagnostic buffer. With this 
method of error handling, you actively intervene in the program sequence when 
an error occurs.

BR bit of the status word S7-1200/15
00

Using the BR bit of the status word, you can determine whether an error 
occurred when the instruction was executed. (BR bit = "0" => An error has 
occurred; BR bit = "1" => No error has occurred)

 

 WARNING

Output parameter RET_VAL

When errors occur in the supply of the input parameters during the execution of the instruction 
that contains the RET_VAL parameter, an invalid error code is output at the RET_VAL 
parameter and the output parameters of the instruction cannot be evaluated.
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Example
The above-mentioned local error handling options can be programmed individually or in 
combination with one another. To ensure that each error scenario that can occur within your 
program is recognized, we recommend a combination of local error handling options, as shown 
in the example below.

For a more precise error analysis, in addition to the RET_VAL output parameter you can also 
use the instructions "GET_ERROR" or "GET_ERR_ID". These options provide you with error 
codes, the detailed explanations of which are available in the descriptions of the respective 
instructions.

There are also error scenarios in which the RET_VAL output parameter does not output a valid 
error code. If an access error occurs while reading an input parameter, for example, the outputs 
of the instruction are no longer written, because the execution of the instruction is interrupted. 
In this case, we recommend that you integrate the two instructions "GET_ERROR" and 
"GET_ERR_ID" in your program because they provide reliable error information even when 
this type of error occurs.

 

 WARNING

Access error when reading an input parameter

The RET_VAL parameter does not return a valid error code and no detailed error information 
is output to the diagnostic buffer.

 

The following example shows you how you can recognize an access error when reading an 
input parameter:
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In network 1, the instruction "MOVE_BLK_VARIANT": Move block" is called. The "SrcField" 
source area is accessed at the SRC parameter using a variable index. If no errors occur during 
the execution of the instruction, the ENO enable output returns signal state "1", and program 
execution jumps to network 4 and continues there.

If an access error occurs during the execution of the instruction, for example, due to the variable 
index, the instruction "GET_ERR_ID: Get error ID locally" in network 2 returns an error ID. The 
comparison of the error ID for "NOT EQUAL" with the value "0" returns the result "Test2" = 
TRUE.

The #TagRet_Val operand at the RET_VAL output parameter returns no valid error code in 
this case.

See also
Evaluating errors with output parameter RET_VAL (Page 1854)

4.3.9 Using VARIANT instructions

The VARIANT data type
The VARIANT data type can be used to create generic function blocks or functions. It is used 
to interconnect the parameters of the block to tags of any type when called. Parameters of the 
VARIANT data type can be declared in the sections VAR_IN, VAR_IN_OUT and VAR_TEMP.

When the block is called, the type information of the tag is passed in addition to a pointer to 
the tag. The code of the block can then be executed according to its type with regard to the 
tags passed during runtime.

If, for example, a block parameter of a function has the VARIANT data type, then a tag of the 
integer data type can be passed at one point in the program, and a tag of the PLC data type 
can be passed at another point in the program. With the help of the VARIANT instructions, the 
function is then in a position to react to the situation without errors.

Procedure in the S7-300/400
The ANY data type can be used as follows for CPUs of the S7-300/400 series:

● In SCL and STL, memory of any kind can be passed at a block call when a pointer of the 
ANY data type has been programmed at a block parameter.
However, important information about the structure of the memory is lost because the ANY 
pointer does not store the information that it points to a tag of the PLC data type, for example. 
The ANY pointer sees this as an ARRAY of BYTE.

● Parameters of the ANY data type can be passed to system function blocks (SFBs) or system 
functions (SFCs).

● In combination with the ANY data type, you can use the instruction "BLKMOV: Move block" 
to copy data of any data type in the program.

The ANY data type has the following restrictions:
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● The ANY pointer has to manually constructed.

● No data with optimized block access can be passed.

● The ANY pointer cannot point to structures.

Procedure in S7-1500
In the TIA Portal, we recommend that you use the VARIANT data type instead of the ANY 
pointer.

Advantages of the VARIANT data type:

● Using the VARIANT data type, it is possible to write programs that perform dynamic type 
definition, i.e. integrated type checking during runtime of the program.
The VARIANT data type loses the information about the data type of the tag to which it 
points. In other words, if the block parameter of a function of the VARIANT data type is 
supplied with a PLC data type, you can check within the function during runtime whether 
VARIANT points, for example, to "myUDTa" or "myUDTb".

● The VARIANT pointer can also be constructed symbolically. This improves the readability 
of your program code. You can find more information on the advantages of symbolic 
addressing here: Symbolic addressing (Page 276)

● Any data can be passed at a parameter of the VARIANT data type.

● The data type of the actual parameter to which the VARIANT points is determined during 
runtime. This gives you the possibility to program different responses in the program code 
depending on the data type of the actual parameter.

You can find more information about working with the VARIANT data type in the Siemens 
Industry online support under: Indirect addressing with the VARIANT data type (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&groupid=4000002&extranet=standard&viewreg=WW&n
odeid0=29156492&objaction=csopen)

The TIA Portal provides, among others, the following instructions of the VARIANT data type 
as parameters:

Basic instructions
Programming language Instruction Description
LAD/FBD comparator 
operations

EQ_Type Compare data type for EQUAL with the data type of a tag
NE_Type Compare data type for UNEQUAL with the data type of a tag
EQ_ElemType Compare element data type for EQUAL with the data type of a tag
NE_ElemType Compare element data type for UNEQUAL with the data type of a tag
IS_NULL Compare for EQUALS ZERO
NOT_NULL Compare for UNEQUALS ZERO
IS_ARRAY Check for ARRAY

SCL comparator operations TypeOf Check data type of a VARIANT tag
TypeOfElements Check element data type of a VARIANT tag
IS_ARRAY Check for ARRAY

LAD/FBD/SCL/GRAPH move 
operations

VariantGet Read out VARIANT tag value
VariantPut Write VARIANT tag value
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Basic instructions
Programming language Instruction Description

CountOfElements Get number of ARRAY elements
LAD/FBD/STL/SCL/GRAPH 
move operations
 

ReadFromArrayD
B

Read from the array data block

WriteToArrayDB Write to the array data block
ReadFromArrayD
BL

Read from the array data block in the load memory

WriteToArrayDBL Write to array data block in the load memory
BLKMOV Move block
UBLKMOV Move block uninterruptible
FILL Fill block
Deserialize Move data type from ARRAY of BYTE (Deserialize)
Serialize Move data type to ARRAY of BYTE (Serialize)
MOVE_BLK_VAR
IANT

Move block

SCL move operations READ_LITTLE Read data in little endian format
WRITE_LITTLE Write data in little endian format
READ_BIG Read data in big endian format
WRITE_BIG Write data in big endian format

LAD/FBD/STL/SCL conversion 
operations

VARIANT_TO_D
B_ANY

Convert VARIANT to DB_ANY

DB_ANY_TO_VA
RIANT

Convert DB_ANY to VARIANT

You can find additional instructions with the VARIANT data type in the online help under 
"Extended instructions".

Example
The following example in the SCL programming language shows you a queue (FIFO, First In 
First Out), which works with elements of any data type. Programmed using the instructions 
described above.

Declaration of the block interface of the "FIFOQueue" function block:

Declaration Parameters Data type Comment
Input request BOOL The instruction is executed when 

a positive signal edge is detected 
at the "request" parameter.

mode BOOL 0 = The first entry in the ring buffer 
is returned.
1 = An entry is written at the last 
position in the ring buffer.

initialValue VARIANT Value with which the ARRAY of 
the ring buffer is initialized.

Output error INT Error information
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Declaration Parameters Data type Comment
InOut item VARIANT The entry that is either returned 

from the ring buffer or written to 
the ring buffer.

buffer VARIANT An ARRAY that is used as a ring 
buffer.

Static edgeupm BOOL Edge memory bit in which the 
RLO of the previous query is 
saved.

firstItemIndex INT Index of the oldest entry in the ring 
buffer

nextEmptyItemIndex INT Index of the next free entry in the 
ring buffer

Temp edgeup BOOL Result of edge evaluation
internalError INT Error information
newFirstItemIndex INT Variable index
newNextEmptyItemInde
x

INT Variable index

bufferSize UDINT Number of ARRAY elements in 
the ring buffer

Program code of the "FIFOQueue" function block:

 
(* This program code section is only executed once after a positive signal edge. If there 
is no change in the signal state of the RLO, the program execution of the "FIFOQueue" FB 
ends. *)
#edgeup := #request & NOT #edgeupm;
#edgeupm := #request;
IF NOT (#edgeup) THEN
   RETURN;
END_IF;
 
 
// ------Validation of whether all parameter inputs are valid.----
(* This program code section checks whether the ring buffer is an ARRAY. If so, the number 
of the ARRAY elements is read out. If it is not an ARRAY, the program execution is 
terminated at this point and the error code "-10" is output. *)
IF NOT (IS_ARRAY(#buffer)) THEN
   #error := -10;
   RETURN;
ELSE
   #bufferSize := CountofElements(#buffer);
END_IF;
 
(* This program code section checks whether the data type of the ARRAY elements matches the 
data type of the entry (tag #item). If the data types do not match, the program execution 
is terminated at this point and the error code "-11" is output. *)
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IF NOT (TypeOf(#item) = TypeOfElements(#buffer)) THEN
   #error := -11;
   RETURN;
END_IF;
 
(* This program code section checks whether the initial value of the ring buffer matches 
the entry (tag #item). If the data types do not match, the program execution is terminated 
at this point and the error code "-12" is output. *)
IF NOT (TypeOf(#item) = TypeOf(#initialValue)) THEN
   #error := -12;
   RETURN;
END_IF;
 
(* This program code section checks whether the variable indices are within the ARRAY 
limits. If they are not, the program execution is terminated at this point and either error 
code "-20" or "-21" is output depending on the index. *)
IF (#nextEmptyItemIndex >= #bufferSize) THEN
   #error := -20;
   RETURN;
END_IF;
IF (#firstItemIndex >= #bufferSize) THEN
   #error := -21;
   RETURN;
END_IF;
 
 
//-----------Program code execution, depending on the Mode parameter-------------
// The execution of the instructions depends on the signal state of the Mode parameter.
IF #mode = 0 THEN
 
// If the Mode parameter has the signal state "0", the first entry from the passed ring 
buffer is returned.
(* This program code section checks whether the ring buffer is empty. If this is the case, 
program execution is terminated at this point and the error code "-40" is output. *)
   IF (#firstItemIndex = -1) THEN
      #error := -40;
      RETURN;
   END_IF;
 
// This program code section returns the first entry of the ring buffer.
   #internalError := MOVE_BLK_VARIANT(SRC := #buffer,
                                      COUNT := 1,
                                      SRC_INDEX := #firstItemIndex,
                                      DEST_INDEX := 0,
                                      DEST => #item);
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   IF (#internalError = 0) THEN
(* This program code section checks whether the ring buffer contains ARRAY elements. If it 
does, the first entry is passed further on and the index is incremented by 1. *)
      #internalError := MOVE_BLK_VARIANT(SRC := #initialValue,
                                         COUNT := 1,
                                         SRC_INDEX := 0,
                                         DEST_INDEX := #firstItemIndex,
                                         DEST => #buffer);
 
// This program code section calculates the new index of the first entry.
      #newFirstItemIndex := #firstItemIndex +1;
      #newFirstItemIndex := #newFirstItemIndex MOD #bufferSize;
 
// This program section checks whether the ring buffer is empty.
      IF (#nextEmptyItemIndex = #newFirstItemIndex) THEN
// If the ring buffer is empty, the index is set to 0.
         #firstItemIndex := -1;
         #nextEmptyItemIndex := 0;
      ELSE
// The index of the first entry is changed.
         #firstItemIndex := #newFirstItemIndex;
      END_IF;
   END_IF;
ELSE
 
 
// If the Mode parameter has the signal state "1", the entry is written to the passed ring 
buffer.
(* This program code section checks whether the ring buffer is full. If this is the case, 
program execution is terminated at this point and the error code "-50" is output. *)
   IF (#nextEmptyItemIndex = #firstItemIndex) THEN
      #error := -50;
      RETURN;
   END_IF;
 
// This program code section writes the entry to the ring buffer.
   #internalError := MOVE_BLK_VARIANT(SRC := #item,
                                      COUNT := 1,
                                      SRC_INDEX := 0,
                                      DEST_INDEX := #nextEmptyItemIndex,
                                      DEST => #buffer);
 
   IF (#internalError = 0) THEN
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// This program code section increments the index by 1 and calculates the new empty entry 
index.
      #newNextEmptyItemIndex := #nextEmptyItemIndex +1;
      #newNextEmptyItemIndex := #newNextEmptyItemIndex MOD #bufferSize;
      #nextEmptyItemIndex := #newNextEmptyItemIndex;
 
(* This program code section checks which index the "#firstItemIndex" tag has. If the number 
= -1, the ring buffer is initialized and the entry is written to the ring buffer. Therefore, 
"0" must be assigned to the tag. *)
      IF (#firstItemIndex = -1) THEN
         #firstItemIndex := 0;
      END_IF;
   END_IF;
END_IF;
 
//-------------------------Local error handling----------------------------
(* This program code section checks whether a local error has occurred. If this is the case, 
program execution is terminated at this point and the error code "-100" is output. *)
IF (#internalError > 0) THEN
   #error := -100;
   RETURN;
END_IF;
 
// If no error occurred during program execution, the error code "0" is output.
#error := 0;
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First steps 5
5.1 Getting Started Documentation

Getting started with the TIA Portal
The Getting Started documentation is available to help you begin using the TIA portal.

The Getting Started documentation contains instructions which show you, step-by-step how 
to create a project in the TIA portal and give you the chance to get a quick overview of all the 
possibilities the TIA portal offers you.

Contents
The Getting Started documents describe the creation of a single, continuous project for STEP 7 
and WinCC that is extended with each chapter. You start with simple basic functions, and use 
more complex ones as you continue with the creation of the project.

In addition to the step-by-step instructions, the Getting Started documents also give you 
background information that explains the functions used and illustrate how they relate to each 
other.

Target audience
The Getting Started documents are intended for beginners, but are also useful for users 
migrating from a previous version of SIMATIC STEP 7 and WinCC.

Download
The documentation is available, free of charge at the Service&Support (https://
support.automation.siemens.com) portal in PDF form. 

You can download the documents here:

● STEP 7 Basic and WinCC Basic (V10.5) (http://support.automation.siemens.com/WW/
view/en/40263542/0/en)

● STEP 7 Professional and WinCC Advanced (V11) (http://support.automation.siemens.com/
WW/view/en/28919804/133300)

● STEP 7 Professional and WinCC Advanced (V12) (http://www.automation.siemens.com/
salesmaterial-as/interactive-manuals/getting-started_simatic-s7-1500/_content/EN/
content_en.html)
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Introduction to the TIA Portal 6
6.1 User interface and operation

6.1.1  Starting, setting and exiting the TIA Portal

6.1.1.1 Starting and exiting the TIA Portal

Starting the TIA Portal   
Follow the steps below to start the TIA Portal:

1. In Windows, select "Start > Programs > Siemens Automation > TIA Portal V13".
The TIA Portal opens with the last settings used.

Exiting the TIA Portal
Follow the steps below to exit the TIA Portal:

1. In the "Project" menu, select the "Exit" command.
If the project contains any changes that have not been saved, you will be asked if you wish 
to save them.

– Select "Yes" to save the changes in the current project and close the TIA Portal.

– Select "No" to close the TIA Portal without saving the most recent changes in the project.

– Select "Cancel" to cancel the closing procedure. The TIA Portal will remain open if you 
select this option.

6.1.1.2 Overview of the program settings

Overview     
The following table shows the application settings that you can make:

Group Setting Description
General settings User name The user name of the user. The user name is stored in the project 

properties when a new project is created.
User interface language Language for the program interface
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Group Setting Description
Mnemonic Specifies the mnemonics for programming: 

"German" uses the German mnemonics, for example, "E1.0".
"International" uses international mnemonics, for example, "I1.0".
For information on the differences in the mnemonics of the 
individual commands, refer to the description of the relevant 
programming language.

Show list of recently used 
projects

Number of entries in the list of recently used projects in the 
"Project" menu

Load most recent project 
during startup

The last opened project is opened automatically after the TIA 
Portal starts.

Displaying truncated text 
in full

Texts which are truncated due to their length are displayed in a 
tooltip.

Show tooltips (context-
sensitive help is available)

Tooltips are displayed and you get context-sensitive help. If this 
function is disabled, you can open the tooltip with <F1>.

Open cascade 
automatically in tooltips

After a brief time, the tooltips automatically expand to display a 
cascade containing additional help. If this option is cleared, the 
tooltips must be manually expanded.

Reset to default All application settings All changes that you made in the TIA Portal after installation are 
reversed.

Layout of the editors Resets the complete layout of the application to the factory state.
Show all message 
windows

All message windows whose appearance was manually 
suppressed are displayed again.

Start view Most recent view Starts the program in the last view that was used. This can be 
either the portal view or the project view.

Portal view The TIA Portal will always be started in the portal view, 
irrespective of the last view you worked in.

Project view The TIA Portal will always be started in the project view, 
irrespective of the last view you worked in.

View for objects in overview Details When several views are available, the detail view opens by 
default, for example, in the overview window.

List When several views are available, the list view opens by default, 
for example, in the overview window.

Thumbnails When several views are available, the symbol view opens by 
default, for example, in the overview window.

Storage settings Recently used storage 
location

When a project is saved the first time, the most recently used file 
path is set by default.

Default storage location Enables the specification of file paths for:
● Projects
● Libraries
● Configuration file for corporate libraries

Data exchange Storage location for data 
import

Imported files are searched for at this storage path by default.

Storage location for data 
export

This is the default storage path for the data export.

Storage location for 
support packages

When support packages are downloaded, they are stored in the 
specified storage path and can be installed from there.

Storage location for log 
files

Log files are stored at the location specified here.
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See also
Starting and exiting the TIA Portal (Page 299)

Resetting the user interface layout (Page 333)

Changing the settings (Page 302)

Configuring the display of tooltips and tooltip cascades (Page 353)

6.1.1.3 Overview of the script and text editor settings

Overview
The following table shows the available settings for script and text editors:

Group Setting Description
Font Font type and size Sets the font type and size for the text in text editors.
Font colors Color settings You can choose the colors for individual text elements from the 

respective drop-down lists in the text editors. Optional settings are 
available for the following text elements:
● Text
● Keywords
● Comments
● Operands
● Scripts
● Standard functions
● Instructions/system functions
● Constant strings
● Numeric constants
● Constant tags
● Tags
● Object models
● Formal parameters

Reset to default Resets all font colors in editors to their factory settings.
Tabs Tab width Sets the width of tabs.

Use tabs Enables the use of tabs.
Use spaces Specifies use of space characters instead of tabs.

Indent None Text entries are not automatically indented.
Block The lines or the selected paragraph are automatically indented.
Smart The lines or the selected paragraph are automatically indented. 

All unnecessary spaces are also removed.
View Show white spaces Shows control characters within a text.
STL (Statement List) Font type and size Sets the font type and size for STL program code.
SCL (Structured Control 
Language)

Show line numbers Shows the row numbers in SCL programs.
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See also
Changing the settings (Page 302)

6.1.1.4 Overview of the print settings

Overview
The following table shows the available settings for printing:

Group Setting Description
General Always print table data as 

pairs of values
Tables are printed as a list and not in tabular form. The corresponding 
values are listed for each column.
Enable this option, for example, if you want to print a table that is too 
large for the print area.

Hardware 
configuration

Active graphic view The graphics of network and device view are included in the printout.
Active table A table associated with an editor is included when printing with the 

editor.
PLC Programming Zoom factor Specifies the size in which blocks are to be printed out.

With interface The interfaces of blocks are included in the printout.
With comments Comments on blocks are included in the printout.
With line numbers The line numbers of the program code are printed for text-based 

programming languages.
Motion & Technology Dialog display/graphic The content of the editor is printed out as a graphic if the editor 

supports this.
Table The parameters of the technology objects are printed out in the form 

of a table.
HMI screens Show tab order In the printout you can specify the order in which the runtime objects 

can be selected with the TAB key.

See also
Changing the settings (Page 302)

6.1.1.5 Changing the settings

Procedure 
To change the settings, proceed as follows:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation to change the settings described in the 
previous sections. Or click on one of the other entries in area navigation to make settings 
for your installed products.

3. Change the settings.
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Result
The change will be adopted immediately, there is no need to save it explicitly.

See also
Overview of the program settings (Page 299)

Overview of the script and text editor settings (Page 301)

Overview of the print settings (Page 302)

6.1.2 Layout of the user interface

6.1.2.1 Views

Views 
Three different views are available for your automation project:

● The portal view is a task-oriented view of the project tasks.

● The project view is a view of the components of the project, as well as the relevant work 
areas and editors.

● The library view (Page 307) shows the elements of the project library and the open global 
libraries. 

You can change over between the two views using a link.

6.1.2.2 Portal view

Purpose of the portal view 
The portal view provides you with a task-oriented view of the tools. Here, you can quickly 
decide what you want to do and call up the tool for the task in hand. If necessary, the view 
changes automatically to the project view (Page 305) for the selected task.
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Layout of the portal view
The following figure shows an example of the components in the portal view:

① Portals for different tasks 
② Actions for the selected portal
③ Selection panel for the selected action
④ Change to the project view
⑤ Display of the project that is currently open

Portals
The portals provide the basic functions for the individual task areas. The portals that are 
provided in the portal view depends on the products that have been installed.

Actions for the selected portal
Here, you will find the actions available to you in the portal you have selected. You can call up 
the help function in every portal on a context-sensitive basis.
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Selection panel for the selected action
The selection panel is available in all portals. The content of the panel adapts to your current 
selection. 

Change to the project view
You can use the "Project view" link to change to the project view.

Display of the project that is currently open
Here, you can obtain information about which project is currently open.

See also
Project tree (Page 308)

Basics of the work area (Page 311)

Inspector window (Page 319)

Basics on task cards (Page 321)

Details view (Page 325)

6.1.2.3 Project view

Purpose of the project view
The project view is a structured view of all components of the project. 
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Layout of the project view
The following figure shows an example of the components of the project view:

① Title bar
② Menu bar
③ Toolbar
④ Project tree (Page 308) 
⑤ Reference projects (Page 323)  
⑥ Details view (Page 325) 
⑦ Work area (Page 321)
⑧ Dividers
⑨ Inspector window (Page 319)
⑩ Changing to the Portal view (Page 303)
⑪ Editor bar
⑫ Status bar with progress display
⑬ Task cards (Page 321)  
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Title bar
The name of the project is displayed in the title bar.

Menu bar
The menu bar contains all the commands that you require for your work.

Toolbar
The toolbar provides you with buttons for commands you will use frequently. This gives you 
faster access to these commands.

Dividers
Dividers separate individual components of the program interface. The arrows on the dividers 
allow you to display and hide the adjacent sections of the user interface.

Changing to the portal view
You can use the "Portal view" link to change to the portal view.

Editor bar
The Editor bar displays the open editors. If you have opened a lot of editors, they are shown 
grouped together. You can use the Editor bar to change quickly between the open elements.

Status bar with progress display
In the status bar, you will find the progress display for processes that are currently running in 
the background. This also includes a progress bar that shows the progress graphically. Hover 
the mouse pointer over the progress bar to display a tooltip providing additional information 
on the active background process. You can cancel the background processes by clicking the 
button next to the progress bar.

If no background processes are currently running, the status bar displays the last generated 
alarm.

See also
Basics of the work area (Page 311)

6.1.2.4 Library view

Function of the library view
The library view provides an overview of the elements in the project library and the open global 
libraries. You can switch to the library view using the "Libraries" task card.
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See also: Overview of the library view (Page 446)

6.1.2.5 Project tree

Function of the project tree     
Using the project tree features gives you access to all components and project data. You can 
perform the following tasks in the project tree:

● Add new components

● Edit existing components

● Scan and modify the properties of existing components

You can select the objects of the project tree either with the mouse or via the keyboard by 
typing the first letter of the desired object. If more than one object begins with the same letter, 
the next lower object is selected. The project tree must be the focused user interface element 
in order for you to select an object with its initial letter. 
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Layout of project tree
The following figure shows an example of the project tree components:

1
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① Title bar
② Toolbar
③ Project
④ Devices
⑤ Common data
⑥ Documentation settings
⑦ Languages & resources
⑧ Online access
⑨ Card Reader / USB memory

Title bar
The title bar of the project tree has a button for automatically and manually collapsing the 
project tree. Once it is collapsed manually, the button is "Reduced" to the left-hand margin. It 
changes from an arrow pointing left to one that is pointing right, and can now be used to reopen 
the project tree. You can use the "Reduce automatically" button collapse to project tree 
automatically when you do not need it. 

See also: Maximizing and minimizing the work area (Page 313) 

Toolbar
You can do the following tasks in the toolbar of the project tree:

● Create a new user folder; for example, in order to group blocks in the "Program blocks" 
folder.

● Navigate forward to the source of a link and back to the link itself.
There are two buttons for links in the project tree. You can use these to navigate from the 
link to the source and back.

● Show an overview of the selected object in the work area.
When the overview is displayed, the lower-level objects and actions of the elements in the 
project tree are hidden. 

Project
You will find all the objects and actions related to the project in the "Project" folder, e.g.:

● Devices

● Languages & resources

● Online access

Device
There is a separate folder for each device in the project, which has an internal project name. 
Objects and actions belonging to the device are arranged inside this folder.
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Common data
This folder contains data that you can use across more than one device, such as common 
message classes, logs, scripts and text lists.

Documentation settings
In this folder, you can specify the layout for project documentation to be printed at a later point.

Languages & resources
You can determine the project languages and texts in this folder. 

Online access
This folder contains all the interfaces of the programming device / PC, even if they are not 
used for communication with a module.

Card Reader / USB memory
This folder is used to manage all card readers an other USB storage media connected to the 
programming device / PC.

See also
Portal view (Page 303)

Project view (Page 305)

Basics of the work area (Page 311)

Inspector window (Page 319)

Basics on task cards (Page 321)

Details view (Page 325)

6.1.2.6 Work area

Basics of the work area

Function of the work area     
The objects that you can open for editing purposes are displayed in the work area. These 
objects include, for example:

● Editors and views

● Tables

You can open several objects. However, normally it is only possible to see one of these at a 
time in the work area. All other objects are displayed as tabs in the Editor bar. If, you would 
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like to view two objects at the same time when performing certain tasks, you can tile the work 
area either horizontally or vertically or undock elements of the work area. If no objects are 
open, the work area will be empty.

Layout of the work area
The following figure shows an example of a vertically split work area:

1

2

3

4

① Title bar of left-hand editor 
② Work area of left-hand editor
③ Title bar of right-hand editor
④ Work area of right-hand editor
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See also
Maximizing and minimizing the work area (Page 313)

Splitting the work area (Page 315)

Floating the work area elements (Page 315)

Using grouped elements of the work area (Page 316)

Minimizing and maximizing elements of the work area (Page 318)

Switching between the elements in the work area (Page 318)

Saving a layout of editors and tables (Page 332)

Save user interface layout (Page 330)

Maximizing and minimizing the work area
You have the option to adapt the work area to make it as large as possible. You can use the 
following function for this:

● Maximizing the work area
You can close the task cards, project tree and inspector window with a single click. This 
increases the size of the work area. You can minimize the work area again at any time in 
order to return to the previous view.

● Collapsing task cards, project tree, and Inspector window automatically
You can use the "Collapse automatically" option for the task cards, project tree, and 
Inspector window. This function causes these items to collapse automatically when you 
don't need them. 

Maximizing and minimizing the work area    
To maximize the work area, follow these steps:

1. Open an element such as an editor or a table.
The element appears in the work area.

2. Click the "Maximize" button in the title bar of the element.
The task cards, project tree and inspector window collapse, and the work area is shown 
with its maximum dimensions.

To minimize the work area again, follow these steps:
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1. Click the "Embed" button in the title bar of the displayed element.
This restores the view that existed before the work area was maximized. That is, if the task 
cards, project tree, or Inspector window were expanded before, they will be expanded 
again. 

Collapsing task cards, project tree, and Inspector window automatically   
To collapse the task cards automatically, follow these steps:

1. Click "Collapse automatically" in the title bar of the task cards.
The task cards collapse when you click anywhere outside the task cards. 

2. To use the task cards, click the collapsed task cards.

3. The task cards expand and are available for use. The "Collapse automatically" option 
remains enabled.

To collapse the project tree automatically, follow these steps:

1. Click "Collapse automatically" in the title bar of the project tree.
The project tree collapses when you click anywhere outside the project tree. 

2. To use the project tree, click the collapsed project tree.
The project tree expands and is available for use. The "Collapse automatically" option 
remains enabled.

To collapse the Inspector window automatically, follow these steps: 

1. Click "Collapse automatically" in the title bar of the Inspector window.
The Inspector window collapses when you click anywhere outside the Inspector window. 

2. To use the Inspector window, click the collapsed Inspector window.
The Inspector window expands and is available for use. The "Collapse automatically" option 
remains enabled.

To disable the automatic collapse option, follow these steps:

1. Click "Expand permanently" again in the relevant window.
The Collapse automatically" option is disabled, and the window remains expanded.

 

See also
Basics of the work area (Page 311)

Splitting the work area (Page 315)

Floating the work area elements (Page 315)

Using grouped elements of the work area (Page 316)

Minimizing and maximizing elements of the work area (Page 318)

Switching between the elements in the work area (Page 318)

Saving a layout of editors and tables (Page 332)
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Splitting the work area
You can split the work area vertically or horizontally.

Procedure
To split the work area vertically or horizontally, follow these steps:

1. In the "Window" menu, select the "Split editor space vertically" or "Split editor space 
horizontally" command.
The element you have clicked and the next element in the Editor bar will be displayed either 
next to one another or one above the other.

 

 Note

If no elements are open in the work area, the "Split editor space vertically" and "Split editor 
space horizontally" functions will not be available.

 

See also
Basics of the work area (Page 311)

Maximizing and minimizing the work area (Page 313)

Floating the work area elements (Page 315)

Using grouped elements of the work area (Page 316)

Minimizing and maximizing elements of the work area (Page 318)

Switching between the elements in the work area (Page 318)

Saving a layout of editors and tables (Page 332)

Floating the work area elements
You can float work area elements in their own separate window:

● Editors

● Tables

● Setting windows

● Task cards

● Inspector window

You can embed floating elements again in the work area at any time.
 

 Note
Properties of elements in a floating window

The properties of elements that you have selected in a floating window are only displayed in 
the Inspector window if the Inspector window is floating as well.
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Floating the work area elements    
To float work area elements, follow these steps:

1. Click the "Float" button in the title bar of the element.
The element will be released from the work area and displayed in its own window. You can 
now place the window wherever you wish. If you have minimized the window, you can 
restore it via the editor bar.

Embedding elements in the work area
To embed elements in the work area again, follow these steps:

1. Click the "Embed" button in the title bar of the element.
The element will appear in the work area again.

See also
Basics of the work area (Page 311)

Maximizing and minimizing the work area (Page 313)

Splitting the work area (Page 315)

Using grouped elements of the work area (Page 316)

Minimizing and maximizing elements of the work area (Page 318)

Switching between the elements in the work area (Page 318)

Saving a layout of editors and tables (Page 332)

Using grouped elements of the work area
If you open more than five elements of the same type, e.g., editors or tables, they are grouped 
in the editor bar. You can use these groups as follows:

● Displaying individual elements of a group

● Displaying all elements of a group in separate windows

● Embedding all displayed elements of a group in the work area

● Minimizing all displayed elements

● Closing all elements of a group

Displaying individual elements of a group  
To display individual elements of a group, follow these steps:

1. In the editor bar, click the group containing the element you want to display.
All list of all available elements of the group is displayed.

2. Click the element that you want to display.

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Professional V13.0
316 System Manual, 02/2014



Displaying all elements of a group in separate windows
To display all elements of a group in separate windows, follow these steps:

1. In the editor bar, right-click the group whose elements you want to display.

2. Select "Restore group" in the shortcut menu.
All elements of the group are displayed in separate, overlapping windows. Move the 
windows in order to see the individual element, or choose an element via the group in the 
editor bar.

Embedding all displayed elements of a group in the work area
To embed all elements of a group displayed in separate windows in the work area again, follow 
these steps:

1. In the editor bar, right-click the group whose elements you want to embed.

2. Select "Embed group" in the shortcut menu.
All elements of the group are embedded in the work area again.

Minimizing all displayed elements
To minimize all elements of a group, follow these steps:

1. In the editor bar, right-click the group whose elements you want to minimize.

2. Select "Minimize group" in the shortcut menu.
All elements of the group are minimized. However, the minimized elements remain open 
and can be quickly maximized again via the group in the editor bar.

Closing all elements of a group
To close all elements of a group, follow these steps:

1. In the editor bar, right-click the group whose elements you want to close.

2. Select "Close group" in the shortcut menu.
All elements of the group are closed. The group is removed. 

See also
Basics of the work area (Page 311)

Maximizing and minimizing the work area (Page 313)

Splitting the work area (Page 315)

Floating the work area elements (Page 315)

Minimizing and maximizing elements of the work area (Page 318)

Switching between the elements in the work area (Page 318)

Saving a layout of editors and tables (Page 332)
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Minimizing and maximizing elements of the work area
You can minimize the elements that are open in the work area, such as editors or tables, as 
needed. However, an element remains open even if it has been minimized, and can quickly 
be maximized again using the editor bar.

Minimizing elements in the work area 
To minimize elements in the work area, follow these steps:

1. Click the "Minimize" button in the title bar of the element.
The element is minimized, but can still be accessed via the editor bar.

To minimize all elements at the same time, follow these steps:

1. In the "Window" menu, select the "Minimize all" command.

Maximizing elements in the work area 
To maximize elements in the work area again, follow these steps:

1. Click the required element in the editor bar.
The element is maximized and appears in the work area.

See also
Basics of the work area (Page 311)

Maximizing and minimizing the work area (Page 313)

Splitting the work area (Page 315)

Floating the work area elements (Page 315)

Using grouped elements of the work area (Page 316)

Switching between the elements in the work area (Page 318)

Saving a layout of editors and tables (Page 332)

Switching between the elements in the work area
You can switch between the elements in the work area at any time.

Switching between the elements in the work area
To switch to the previous or next editor, follow these steps:

1. In the "Window" menu, select the "Next editor" or "Previous editor" command.
The next or previous editor will be displayed.

See also
Basics of the work area (Page 311)

Maximizing and minimizing the work area (Page 313)
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Splitting the work area (Page 315)

Floating the work area elements (Page 315)

Using grouped elements of the work area (Page 316)

Minimizing and maximizing elements of the work area (Page 318)

Saving a layout of editors and tables (Page 332)

6.1.2.7 Inspector window

Function of the Inspector window  
Additional information on an object selected or on actions executed are displayed in the 
inspector window. 

Layout of the Inspector window
The following figures show the components of the Inspector window:

① "Properties" tab
② "Info" tab
③ "Diagnostics" tab
④ Area navigation within the "Properties" tab
⑤ Content of the "Properties" tab
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① "Properties" tab
② "Info" tab
③ "Diagnostics" tab
④ Navigation within the tabs (only available in the "Info" and "Diagnostics" tabs)
⑤ Content of the "Diagnostics" tab

"Properties" tab
This tab displays the properties of the object selected. You can change editable properties 
here.

"Info" tab
This tab displays additional information on the object selected, as well as alarms on the actions 
executed (such as compiling). 

"Diagnostics" tab
This tab provides information on system diagnostics events, configured alarm events, and 
connection diagnostics.

Navigation within the tabs
You can use area navigation and the lower-level tabs to display the information you require 
within the tabs. 

See also
Project tree (Page 308)

Basics of the work area (Page 311)

Portal view (Page 303)

Project view (Page 305)
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Basics on task cards (Page 321)

Details view (Page 325)

6.1.2.8 Task cards

Basics on task cards

Function of task cards  
Depending on the edited or selected object, task cards that allow you perform additional actions 
are available. These actions include:

● Selecting objects from a library or from the hardware catalog

● Searching for and replacing objects in the project

● Dragging predefined objects to the work area

The task cards available can be found in a bar on the right-hand side of the screen. You can 
collapse and reopen them at any time. Which task cards are available depends on the products 
installed. More complex task cards are divided into panes that you can also collapse and 
reopen.
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Layout of task cards
The following figure shows an example of the bar with the task cards:

① Task cards closed
② Task card open
③ Opened palette of a task card
④ Closed palette of a task card

See also
Changing the pane mode (Page 323)

Project tree (Page 308)

Basics of the work area (Page 311)

Inspector window (Page 319)

Portal view (Page 303)

Project view (Page 305)

Details view (Page 325)

Introduction to the TIA Portal
6.1 User interface and operation

WinCC Professional V13.0
322 System Manual, 02/2014



Changing the pane mode
You can choose between two pane modes:

● Single pane mode:
Only one pane is open at any given time. If you open another pane, the previously opened 
pane is closed automatically.

● Multi-pane mode:
You can open several panes at the same time.

Procedure   
To change the pane mode, follow these steps:

1. Click the "Change pane mode" button above the panes inside a task card.

See also
Basics on task cards (Page 321)

6.1.2.9 Reference projects

Function of reference projects
In the "Reference projects" palette, you can open other projects in addition to the current 
project. These reference projects are write-protected and cannot be edited. However, you can 
drag the objects of a reference project into your current project and further edit them there. 
You can also compare the objects of a reference project to the objects of your current project. 

Layout of the "Reference projects" palette
The following figure shows the layout of the "Reference projects" palette:
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1

2

3

① Title bar
② Toolbar
③ Opened reference projects

Title bar
The arrow for closing the palette is located in the title bar of the "Reference projects" palette. 
Once it is closed, the direction in which the arrow is pointing changes from downwards to right. 
It can now be used to reopen the palette.

Toolbar
The toolbar contains buttons for opening and closing reference projects.

Opened reference projects
Opened reference projects are displayed as read-only with their objects and their hierarchical 
structure.

See also
Basics of reference projects (Page 377)

Opening and closing a reference project (Page 377)
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6.1.2.10 Details view

Purpose of the details view 
The detail view shows certain content of the selected object is in the overview window or in 
the project tree. This might include text lists or tags.

The content of folders is not shown, however. To display the content of folders, use the project 
tree or the Inspector window.

Layout of the details view
The following figure shows an example of the details view:

① Title bar
② Content of the selected object

Title bar
The arrow for closing the details view is located in the title bar of the details view. After it has 
closed, the direction in which the arrow is pointing changes from left to right. It can now be 
used to reopen the details view.

Objects
The displayed content varies depending on the selected object. You can move the content of 
objects from the details view to the required location using drag-and-drop.

See also
Project tree (Page 308)

Basics of the work area (Page 311)

Inspector window (Page 319)

Basics on task cards (Page 321)
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Portal view (Page 303)

Project view (Page 305)

6.1.2.11 Overview window

Overview window

Functions of the Overview window
The Overview window supplements the project tree. The Overview window shows the contents 
of the folder currently selected in the project tree.

In addition, you can perform the following actions in the Overview window:

● Open objects

● Display and edit the properties of objects in the Inspector window

● Rename objects

● Call object-specific actions from the shortcut menu

● Compare objects side by side

● Perform various object operations, such as inserting objects from the library via drag-and-
drop and moving, copying, pasting, and deleting objects
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Layout of the Overview window
The following figure shows the components of the Overview window:

5 6 6

8

1

2 3 4

7

① Overview window
② Switch to the Details view
③ Switch to the List view
④ Switch to the Icon view
⑤ Move to higher level
⑥ Split the overview window in two. Either the right or left half of the overview window is synchronized. Clicking again 

cancels the split.
⑦ All elements within a selected folder are displayed even if these are located in lower-level groups. This option is 

only available in details view.
⑧ Contents of the object selected in the project tree.
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Display forms of the Overview window
The content of the Overview window can be displayed as follows:

● Details view
The objects are displayed in a list with additional information, such as the date of the last 
change.

● List view
The objects are displayed in a simple list.

● Icon view
The objects are displayed as icons according to category.

See also
Comparing objects in the overview window (Page 328)

Sorting the details view of the overview window (Page 329)

Overview of the library view (Page 446)

Comparing objects in the overview window
You can display the contents of two folders or objects side by side in the Overview window. 
The Overview window is split in half and you can display different contents on the left and right 
sides.

In addition, you can use a drag-and-drop operation to move objects between the split windows. 
Thus, for example, you can move contents from one window to the other.

Procedure  
To split the Overview window in half or cancel the split, follow these steps:

1. In the toolbar, click on the "Synchronize left side" or "Synchronize right side" icon to split 
the overview window. Either the left or the right side of the overview window synchronized 
with the contents of the selected object in the project tree.

2. To cancel the split, click again on the previously selected icon.

See also
Overview window (Page 326)
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Sorting the details view of the overview window
You have several options for adapting the display in the details view of the overview window:

● Adding additional columns
Some columns are hidden by default to increase clarity. You can display hidden columns 
if needed. The columns available depend on the selected object.

● Display of folder contents in a flat hierarchy
Folder contents can be displayed in a flat hierarchy. All the content is displayed at once 
even if it is located in different groups.

● Sorting the table columns
You can sort individual columns of the table in ascending or descending order.

Showing or hiding columns  
To show or hide additional table columns, follow these steps:

1. Right-click the title bar of the table.

2. Select the "Show/Hide" command in the shortcut menu, and select the columns you want 
to display.

Displaying folder contents in flat hierarchy
To display the content of a folder in a flat hierarchy, follow these steps:

1. Select the required folder in the project tree or in the library navigation of the library view.

2. Click the "Show subordinate elements" icon in the toolbar.
All elements are displayed at once in the table even if they are located in subfolders.

Sorting a table in ascending or descending order
To sort the table by a column in ascending or descending order, follow the steps below:

1. Click the table header of a column if you want to sort the column in ascending order.

2. Click again on the same column of the table header to sort the column in descending order.

3. Click a third time on the table header of the same column to cancel the sorting.

See also
Overview window (Page 326)
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6.1.2.12 User interface layout

Save user interface layout

Options for saving the user interface layout  
When you make a change to the user interface, this is retained even after a restart of the TIA 
portal. A change to the user interface layout includes, for example, moving a window or 
adjusting the size of an editor.

In addition to the automatic saving of the user interface layout, you have the option of saving 
certain layouts:

● Saving the window layout 
You can save the layouts of the windows and editors of the TIA portal manually and restore 
these at a later time. It is possible to call five window layouts using a key combination.
Use this function, for example, if you are work with a notebook which you connect to an 
external monitor when necessary. You can create a window layout for mobile use on the 
notebook display and another layout for when you work at the office with an external monitor.

● Save the layout within editors   
With some editors, you can adjust the display. You can, for example, adjust the width of 
tables or show or hide individual table columns.

See also
Save window layout (Page 330)

Load window layout (Page 331)

Managing window layouts (Page 332)

Saving a layout of editors and tables (Page 332)

Resetting the user interface layout (Page 333)

Basics of the work area (Page 311)

Save window layout
You can save the current window layout in order to call it again in the same form at a later time.

Procedure   
To save a window layout, follow these steps:

1. Arrange all windows in the way in which you want to save them.

2. In the "Window" menu, select the "Save window layout as" command.
The "Save window layout" dialog box appears.

3. Enter a name for the window layout in the "Name" field.
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4. Enter a description of the window layout in the "Description" field in order to be able to 
identify the window layout more easily later.

5. Click "Save".

Result
The new window layout is saved in the last position after the existing saved window layouts. 
The first five window layouts can be called using a key combination.

See also
Save user interface layout (Page 330)

Load window layout
If you have already saved a window layout, you can load this, allowing you to quickly adjust 
your work environment to the respective conditions. You can load the first five window layouts 
using quick access via the "Window" menu or via a key combination.

If you load a window layout and then make changes to the arrangement of the window, you 
can restore the originally saved window layout.

Using quick access to load window layouts 1 to 5   
To load one of the first five saved window layouts, follow these steps:

1. In the "Window" menu, select a window layout or select the key combination <Alt+Shift+[1 ... 
5]>.

Loading additional window layouts   
To load a window layout that is not among the first five window layouts, follow these steps:

1. In the "Window" menu, select the "Additional window layouts" command.
The "Manage window layouts" dialog box appears.

2. Select the desired window layout.

3. Click "OK".

Restore window layout   
To go back to a saved window layout, follow these steps:

1. In the "Window" menu, select the "Restore window layout" command or select the key 
combination <Alt+Shift+0>.

See also
Save user interface layout (Page 330)
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Managing window layouts
You can carry out the following actions with existing window layouts:

● Changing the order of window layouts 
The order of the window layouts is important, as the first five window layouts can be called 
directly via the "Window" menu and via a key combination.

● Select a window layout
If a window layout is not one of the first five window layouts, you can call it using the "Manage 
window layouts" dialog box.

● Deleting window layouts 

Procedure
To manage the existing window layouts, follow these steps:

1. In the "Window" menu, select the "Manage window layouts" command.
The "Manage window layouts" dialog box appears.

2. Select the window layout which you want to modify.

3. Click the "Up" or "Down" symbol to move the window layout up or down.

4. Click the "Delete" symbol to delete the selected window layout.

5. Click "OK".
The selected window layout is activated.

See also
Save user interface layout (Page 330)

Saving a layout of editors and tables
You have the option of adapting editors and tables to meet your requirements. For example, 
you can hide columns in tables that you don't need. You can then save your customized view.

Procedure  
To save the layout of editors and tables in the work area, follow these steps:

1. Adapt the editor or table according to your requirements.

2. Click the "Remember Layout" button in the editor or table.

Result
The layout is saved. When you reopen the editor or table, this layout will be used.
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See also
Basics of the work area (Page 311)

Maximizing and minimizing the work area (Page 313)

Splitting the work area (Page 315)

Floating the work area elements (Page 315)

Using grouped elements of the work area (Page 316)

Minimizing and maximizing elements of the work area (Page 318)

Switching between the elements in the work area (Page 318)

Save user interface layout (Page 330)

Resetting the user interface layout
Every change you make to the layout of the user interface is saved. The changes are thus 
available even after a restart of the TIA Portal. For example, if you change the height and width 
of a text editor or the division of a table, your changes are retained so that you don't have to 
re-customize elements every time.

In some cases, however, it may be helpful to restore the original layout settings; for example, 
if another user prefers a different arrangement of the user interface.

Procedure   
To reset the user interface settings to the default, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation.

3. Click the "Reset to default" button under "Reset to default > Editor layout".

Result
The default settings for the user interface are restored.

See also
Overview of the program settings (Page 299)

Save user interface layout (Page 330)
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6.1.3 Keyboard operation in the TIA Portal

6.1.3.1 Operating the TIA Portal with the keyboard
You can navigate through the TIA Portal using the keyboard, for example if you do not have 
a mouse available at the given moment. Many functions are also accessible via keyboard 
shortcuts. You can find an overview of all keyboard shortcuts in the settings for the TIA Portal.

In the following sections, you will learn how to navigate in the TIA Portal using the keyboard, 
edit objects and customize the TIA Portal to your needs.

See also
Displaying an overview of all keyboard shortcuts (Page 334)

6.1.3.2 Displaying an overview of all keyboard shortcuts
You can display an overview of all keyboard shortcuts.

Procedure
To display an overview of all available keyboard shortcuts, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The settings of the TIA Portal are displayed.

2. Open the "Keyboard shortcuts" entry in the area navigation.
You can see an overview of all keyboard shortcuts, which are valid for the currently installed 
products.

6.1.3.3 Basic functions of the TIA Portal
Below, you will learn how you can use the basic functions of the TIA Portal using only your 
keyboard.

Operating basic functions of the TIA Portal with a keyboard  
The following table shows how you can access basic functions of the TIA Portal with keyboard 
shortcuts:

Function Keyboard shortcuts Menu command
Switch between the project view and the portal view <Alt+F7>  
Open the Help system
If you need help on the TIA Portal, press <F1>.

<F1> Help > Show help

Cancel the current action <Esc>  
Find <Ctrl+F>  
Replace an object <Ctrl+H>  
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Function Keyboard shortcuts Menu command
Find next
If you have started a search, you can jump to the next hit with <F3>

<F3>  

Print object <Ctrl+P> Project > Print

Operating menus
The following table shows how you can navigate through menus using the keyboard:

Function Keyboard shortcuts
Start keyboard operation in the menu
You can access the menu using the <Alt> key and then continue to navigate with the arrow keys 
to scroll through the menu. Confirm your selection of the menu command with <Return>.

<Alt>

Go directly to a specific menu
You can go directly to an individual menu command by holding down the <Alt> key. There is an 
underlined letter for each menu command. Press the <Alt> key along with the underlined letter.

<Alt+underlined letter in 
respective menu>

Open shortcut menu of an object
With the shortcut menu key (on Microsoft Windows compatible keyboards), you can open the 
shortcut menu of the selected object. Alternatively, you can use <Shift+F10> if you are not using 
a Microsoft Windows compatible keyboard. You can use the arrow keys to scroll through the 
shortcut menu and select a menu command with <Return>.

<Shortcut menu key>
Alternative: <Shift+F10>

Operating expandable elements
The following table shows how you can operate expandable elements using the keyboard:

Function Keyboard shortcuts
Expand a folder in a tree
With <Arrow right>, for example, you expand a folder in the project tree.

<Arrow right>

Close a folder in a tree
With <Arrow left>, for example, you collapse a folder in the project tree.

<Arrow left>

Open a drop-down list
You can open drop-down lists with <F4> and then navigate with the arrow keys to scroll through 
the drop-down list. Finally, press the <Return> key to confirm your selection.

<F4>

Open autocompletion <Ctrl+Space>
<Ctrl+I>

Show object selection <Ctrl+J>
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6.1.3.4 Using project-related functions

Editing a project   

Function Keyboard shortcuts Menu command
Open a project <Ctrl+O> Project > Open
Close a project <Ctrl+W> Project > Close
Save a project <Ctrl+S> Project > Save
Save a project under a different name <Ctrl+Shift+S> Project > Save as
Delete a project <Ctrl+E> Project > Delete project
Print project <Ctrl+P> Project > Print
Undo last action <Ctrl+Z> Edit > Undo
Redo last action <Ctrl+Y> Edit > Redo

Calling up the help function

Function Keyboard shortcuts Menu command
Calling up the help function <F1> or <Shift+F1> Help > Show help

6.1.3.5 Arranging windows
Below, you will learn how to open and close individual windows of the TIA Portal and save 
window layouts using the keyboard .

Opening and closing windows   
The following table shows how you can open and close windows with keyboard shortcuts:

Function Keyboard shortcuts Menu command
Open/close project tree <Ctrl+1> View > Project tree
Opening/closing the detailed view <Ctrl+4> View > Details view
Opening/closing the overview <Ctrl+2> View > Overview
Opening/closing a task card <Ctrl+3> View > Task card
Open libraries <Ctrl+Shift+L>  
Open hardware catalog
If you are in the device or network view, the hardware 
catalog opens.

<Ctrl+Shift+C>  

Open/close inspector window <Ctrl+5> View > Inspector window
Open the "Properties" tab in the inspector window <Ctrl+6>  
Open the "Info" tab in the Inspector window <Ctrl+7>  
Open the "Diagnostics" tab in the Inspector window <Ctrl+8>  
Display or hide reference projects <Ctrl+9>  
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Function Keyboard shortcuts Menu command
Display the on-screen keyboard
You can display a keyboard on the screen, for example, 
to operate with a touch screen.

<Ctrl+Shift+K>  

Close all editors <Ctrl+Shift+F4> Window > Close all

Using saved window layouts
You can save individual window arrangements and restore them at a later point in time. The 
following table shows how you to access saved window layouts with keyboard shortcuts:

Function Keyboard shortcuts Menu command
Restore active window layout
If you use a saved window layout and have made 
changes to the program interface in the meantime, you 
can restore the original state of the active window layout 
with <Alt+Shift+0>.

<Shift+Alt+0> Window > Restore window 
layout

Load window layout
You can use <Alt+Shift+[number of the window layout]> 
to activate the first of the five saved window layouts.

<Shift+Alt+[Number of the 
window layout]>

Window > Window layout 1 to 
5

6.1.3.6 Navigating through the program interface
The TIA Portal is divided into several interface areas, for example, individual windows, toolbars 
and editors. If you want to work with the keyboard within an interface area, you first have to 
place the focus on it. Below, you will learn how to place the focus on individual interface areas 
using the keyboard. You will also learn how to move within an interface area in the TIA Portal 
using the keyboard.

Switching between interface areas and editors  
The following table shows how to move between individual interface areas of the TIA Portal:

Function Keyboard shortcuts
Move clockwise between the interface areas
You can use the <F6> key to move clockwise between the various interface areas of the 
TIA Portal. The interface area currently in focus is highlighted with a blue title bar. If you 
are in the project tree, for example, and press the <F6> key, you jump to the currently 
open editor. If you press <F6> again, and the task cards are in focus.
If you press <Shift+F6>, on the other hand, you move counterclockwise between the work 
areas.

<F6>
 

Move counter-clockwise between the interface areas
With <Shift+F6> you move counter-clockwise between the interface areas of the TIA Portal.

<Shift+F6>

Go to the next open editor
With <Ctrl+Alt+Arrow right> you move to the next open editor. You can see the open editors 
in the editor toolbar.

<Ctrl+Alt+Arrow right>
Alternative: <Ctrl+F6>
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Function Keyboard shortcuts
Go to the previously open editor
With <Ctrl+Alt+Arrow left> you move to the most recently open editor.

<Ctrl+Alt+Arrow left>
Alternative: <Ctrl+Shift+F6>

Go to the next higher section of the interface area
With <Shift+Esc>, you move to the next higher section of the program interface. If, for 
example, you have selected a device in the project tree and you press <Shift+Esc>, the 
entire project navigation is put into focus.

<Shift+Esc>
Alternative: <Alt+Arrow up>

Go to the next lower section of the interface area
With <Return>, you place the focus on the next lower section of the program interface. For 
example, if you have just opened the properties of a device in the Inspector window in 
order to assign parameters to the device, press <Return> to go one level deeper in the 
program interface. You can then navigate to the desired parameter using the Tab key.

<Return>
Alternative: <Alt+Arrow down>

Navigation within interface areas and editors
The following table shows how you can navigate within an interface area using the keyboard:

Function Keyboard shortcuts
Jump to the next element within an interface area
You can use the Tab key to jump from one element to the next within a work area. If, for 
example, you have opened the properties of a device and want to jump from one field to 
the next, press the Tab key. Any changes you have made to the current text box are applied 
in this case.

<Tab>

Jump to the previous element within an interface area
With <Shift+Tab>, you can jump to the previous element in a work area, for example, a 
previous text box. Any changes you have made to the current text box are applied in this 
case.

<Shift+Tab>

Move to the next tab within an interface area
If an interface area is divided into separate tabs, you can move between the tabs with the 
shortcut keys <Ctrl+Tab>. If, for example, you are in the "Properties" tab of the Inspector 
window and you want to jump to the "Info" tab, press the shortcut keys <Ctrl+Tab>.

<Ctrl+Tab>

Go to the previous tab
With <Ctrl+Shift+Tab>, you move to the most recently open tab within an interface area.

<Ctrl+Shift+Tab>

Jumping to the toolbar of an editor
You can use the <Alt+F10> key to jump to the toolbar of an editor. For example, if you 
have opened the print preview and want to switch to the next page of the printout in the 
toolbar, press <Alt+F10>. Then, use the arrow keys to navigate to the appropriate icon in 
the toolbar and confirm the selection with <Return>.

<Alt+F10>

Use arrows on the divider to display or hide user interface components
The table in the work area can be minimized and maximized. First, navigate to the work 
area and use the Tab key to place the focus on one of the little arrows on the separator 
line above the table. The arrows have the focus as soon as they are highlighted in blue. 
Then, press the space bar to minimize or maximize the table.

<Space>

6.1.3.7 Customizing editors
Below, you will learn how to arrange editors using the keyboard. You will also learn how to 
select the display size and the area within a graphical editor.
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Arranging and customizing editors  
The following table shows how to arrange open editors above and below each other or side-
by-side, and how to close an open editor:

Function Keyboard shortcuts Menu command
Close active editor <Ctrl+F4>  
Split editor space vertically
If, for example, you have opened the overview window and the 
network view and want to display them side-by-side, press the 
<F12> key.

<F12> Window > Split editor space 
vertically

Split editor space horizontally
You can display two open editors in the work area above and below 
each other.

<Ctrl+F12> Window > Split editor space 
horizontally

Remove window split
If you have displayed two editors in the work area horizontally or 
vertically in split mode, you can remove the split with <Alt+Shift
+F12>.

<Alt+Shift+F12> Window > Unsplit editor space

Customizing the display in an editor
The following table shows how you how to zoom in and out in graphical editors and how to 
move the area selection in an editor:

Function Keyboard shortcuts
Zoom in step-by-step in an editor
With <Ctrl> and the <Plus> key on the numeric keypad of the keyboard, you can zoom in 
on the display of the editor.

<Ctrl+Plus>
Alternative: <Ctrl+mousewheel 
up>
 

Zoom out step-by-step in an editor
Use the <Ctrl> and the <Minus> key on the numeric keypad of the keyboard to zoom out 
of the display of the editor.

<Ctrl+Minus>
Alternative: <Ctrl+mousewheel 
down>

Set view in editor to 100%
You can zoom in or out of the display in a graphical editor to set the current view to 100% 
by pressing <Ctrl+0>.

<Ctrl+0>

Moving the area selection of the editor
If you hold down the spacebar, you can move the displayed section of an editor using the 
mouse.

<Space>
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6.1.3.8 Editing objects

Selecting objects  
The following table shows how to select individual objects, for example, devices in the project 
tree:

Function Keyboard shortcuts Menu command
Select an object located at the left, right, above or below <Arrow keys>  
Jump to the first object within the current interface area
The first object in the interface area currently in focus is selected. 
In the project tree, this would be the project node at the top, for 
example.

<Home>  

Jump to the last object within the current interface area
The last object in the interface area currently in focus is selected, 
for example, the last item in the project tree.

<End>  

Select all objects in an area
All objects in the work area currently in focus are selected.

<Ctrl+A> Edit > Select all

Select multiple objects
If you want to select several objects that are not located directly 
next to each other, you first have to move the focus (gray outline 
of an object) to the next desired object using <Ctrl+Arrow keys>. 
The current selection is maintained. Then, press the space bar to 
select the new focused object as well. Repeat this process until all 
desired objects are selected.

<Ctrl+Arrow keys> + 
<Space>

 

Editing objects  
The following table provides an overview of all the keyboard shortcuts required for editing 
objects:

Function Keyboard shortcuts Menu command
Insert new object
A new object is inserted depending on your current context. If, for 
example, you are in the device view, the "Add Device" dialog opens 
for creating a new device.

<Ctrl+N>  

Open object <Return>  
Rename an object <F2> Edit > Rename
Copy an object <Ctrl+C>

Alternative: <Ctrl+Ins>
Edit > Copy

Cut an object <Ctrl+X>
Alternative: <Shift+Del>

Edit > Cut

Paste an object <Ctrl+V>
Alternative: <Shift+Ins>

Edit > Paste

Delete an object <Del> Edit > Delete
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Function Keyboard shortcuts Menu command
Compile an object <Ctrl+B> Edit > Compile
Open properties of an object
Many objects in the TIA Portal have editable properties. Press the 
shortcut keys <Alt+Enter> to display the properties of an object.

<Alt+Return> -

6.1.3.9 Text editing
Below, you will learn how to operate text editing functions using only the keyboard.

Editing text   
The following table shows the basic editing functions for text:

Function Keyboard shortcuts
Switch to insert or overwrite mode <Insert>
Exit edit mode <Esc>
Delete <Del>
Delete characters <Backspace>
Confirm entry in a text box and leave the text box <Return>
Line break in a multiline text box
In a multiline text box, hold down the <Shift> button to create a line break.

<Shift+Return>

Reset input in a text box
If you are in an text box and press <Esc>, you exit the box and the changes are discarded.

<Esc>

Navigating within a text area
The following table shows how to navigate in a text area with the keyboard:

Function Keyboard shortcuts
Jump to start of line <Home>
Jump to end of line <End>
Jump to start of text <Ctrl+Home>
Jump to end of text <Ctrl+End>
Jump to the previous page <PgUp>
Jump to the next page <PgDn>
Confirm entry in a text box and leave the text box <Return>
Line break in a multiline text box <Shift+Return>
Reset input in a text box
If you are in an text box and press <Esc>, you exit the box and the changes are discarded.

<Esc>
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Selecting text
The following table shows how to select text with the keyboard:

Function Keyboard shortcuts
Expand selection to the word at the left or right
The text or current text selection is marked up to the end of word. If you are at the beginning or 
end of a word, the previous or next word is selected. 

<Ctrl+Shift+Arrow left or 
Arrow right>

Expand selection to beginning of line <Shift+Home>
Expand selection to end of line <Shift+End>
Expand selection to beginning of text
The text is selected up to the beginning or the end.

<Ctrl+Shift+Home>

Expand selection to end of text
The text is selected up to the beginning or the end.

<Ctrl+Shift+End>

6.1.3.10 Editing tables
Below, you will learn how to navigate with the keyboard in tables, edit individual fields, and 
select parts of tables.

General keyboard operation in tables   
The following table shows how you can edit tables using only the keyboard:

Function Keyboard shortcuts
Place a cell in edit mode <F2> or <Return>
Confirm entry and exit edit mode <Return>
Cancel editing and discard changes <Esc>
Open drop-down list in a cell
Open the drop-down list with <F4>. Use the arrow keys to 
select the desired entry and then confirm the selection with 
<Return>.

<F4>

Close drop-down list in a cell and discard changes <Esc>

Navigate in tables
The following table shows how you can navigate within a table using the keyboard:

Function Keyboard shortcuts
Go to the next cell <Arrow keys>
Go to the next editable cell on the right <Tab>
Go to the next editable cell on the left <Shift+Tab>
Move a screen upwards <PgUp>
Move a screen downwards <PgDn>
Go to the first cell in the row <Home>
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Function Keyboard shortcuts
Go to the last cell in the row <End>
Go to the first cell in the table <Ctrl+Home>
Go to the last cell in the table <Ctrl+End>
Go to the top cell in the column <Ctrl+Arrow up>
Go to the bottom cell in the column <Ctrl+Arrow down>

Selecting areas in tables
The following table shows how you can select areas within a table using the keyboard:

Function Keyboard shortcuts
Select column <Ctrl+Space>
Select line <Shift+Space>
Select all cells <Ctrl+A>
Expand selection by one cell <Shift+arrow keys>
Extend selection up one page <Shift+PgUp>
Extend selection down one page <Shift+PgDn>
Expand selection up to the first row <Ctrl+Shift+Arrow up>
Expand selection down to the last row <Ctrl+Shift+Arrow down>
Expand selection to the first cell in the row <Ctrl+Shift+Arrow left>
Expand selection to the last cell in the row <Ctrl+Shift+Arrow right>

6.1.3.11 Using online functions

Controlling online functions with the keyboard 
The following table provides an overview of the shortcut keys that you can use for the online 
functions of the TIA Portal:

Function Keyboard shortcuts Menu command
Establish an online connection <Ctrl+K> Online > Go online
Go offline <Ctrl+M> Online > Go offline
Download project data to the device <Ctrl+L> Online > Download to 

device
Show accessible devices
This opens a dialog showing all devices that are connected to the PG/
PC interface of the PG/PC.

<Ctrl+U> Online > Show 
accessible devices

Start CPU
The CPU is set to "RUN" mode. The CPU must be online for this.

<Ctrl+Shift+E> Online > Start CPU
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Function Keyboard shortcuts Menu command
Stop CPU
The CPU is set to "STOP" mode. The CPU must be online for this.

<Ctrl+Shift+Q> Online > Stop CPU

Start simulation
The hardware and software of the project can be tested in a simulated 
online environment, without the modules actually being online.

<Ctrl+Shift+X> Online > Simulation > 
Start

6.1.3.12 Using the on-screen keyboard

Introduction
When working with the TIA portal, you also have the Microsoft on-screen keyboard available. 

Displaying the on-screen keyboard
To display the on-screen keyboard, follow these steps:

1. In the "View" menu, select the "Screen keyboard" command.

 

Exiting the on-screen keyboard
To exit the on-screen keyboard, follow these steps:

1. In the "File" menu of the on-screen keyboard, select the "Exit" command.

6.1.4 Special features specific to the operating system

6.1.4.1 Influence of user rights

Restrictions when user rights are limited  
The software provides several functions that require direct access to the hardware of the 
programming device / PC and therefore also to the installed operating system. To make full 
use of the range of functions, the software must cooperate closely with the operating system. 
To ensure problem-free interaction, you should therefore be logged on to the operating system 
with adequate user rights.

In particular, you may not be able to use functions requiring an online connection or those that 
change the settings of interface cards if you work with limited user rights.
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Recognizing restricted functions  
You can recognize functions requiring special rights as follows:

● A shield icon is displayed beside the function.

The function can be used but is regulated by the user account control.

● A box is grayed out and cannot be accessed.
You require administrator privileges to access the box. In some operating system 
environments, you can obtain administrator privileges by entering an administrator 
password.

 

 Note

A box being grayed out does not necessarily mean a lack of rights. You should also check 
the additional information in the tooltip cascades to find out the conditions for editing the box.

 

6.1.4.2 Expanding user rights

Counteracting restrictions due to user rights 
Certain functions may not be available if you are not logged on to the operating system with 
adequate rights. You can counteract these restrictions in the following ways:

● Enabling of extended rights using Windows user account control

● Logging on to the operating system with administrator privileges

● Using temporary administrator rights

Enabling extended rights using the Windows user account control 
To be able to use a function indicated by the shield icon of the Windows user account control, 
follow these steps:

1. Click on the box or button with the shield icon.
The security prompt of the Windows user account control opens.

2. Follow the instructions of the Windows user account control and, when prompted enter an 
administrator password, if possible.

The function can now be used once without restrictions.

Logging on to the operating system with administrator privileges 
To be able to use a function that is disabled due to lack of user rights, follow these steps:

1. Close the software.

2. Log off from the operating system.

3. Log on to the operating system with administrator privileges.

4. Restart the software.
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Using temporary administrator rights
To obtain administrator privileges temporarily, follow these steps:

1. Click the "Change settings" button. You will find this button in dialogs that allow the 
temporary assignment of administrator privileges.
An operating system dialog box for entering an administrator password opens.

2. Enter an administrator password.

The settings can be temporarily changed. When you call the dialog again, the procedure must 
be repeated.

 

 Note

This function is not supported by all operating systems. If no "Change settings" button is 
present or the button is grayed out, you will need to log on to the operating system with 
administrator privileges instead.

 

6.2 Help on the information system

6.2.1 General remarks on the information system

Quick answers to your questions   
A comprehensive help system is supplied with the TIA Portal for solving your tasks. It describes 
basic concepts, instructions and functions. While working with the program, you also receive 
the following support:

● Roll-out for correct inputs in dialog boxes

● Tooltips for information on elements of the user interface, for example text boxes, buttons 
and icons. Some of the tooltips are supplemented by cascades containing more precise 
information.

● Help on the current context, on menu commands for example when you click on the keys 
<F1> or <Shift+F1>.

The following figure shows an example of a cascading tooltip (top) and a roll-out (bottom):

Introduction to the TIA Portal
6.2 Help on the information system

WinCC Professional V13.0
346 System Manual, 02/2014



Help
The supplied help system describes concepts, instructions and functions. It also contains 
reference information and examples. The help opens in a separate window.

A navigation pane appears on the left side of the help window. You can also hide the navigation 
pane to make room on the screen. The navigation pane provides you with the following 
functions:

● Table of contents

● Search in the index

● Full text search of the entire help

● Favorites

Identification of the topics in the help according to the type of information   
The help topics are identified by different symbols depending on the type of information they 
contain.

Symbol Information type Explanation
Operating instructions Describes the steps to follow in order to carry out a particular task.
Example Contains a concrete example to explain the task.
Factual information Contains background information that you need to know to carry 

out a task.
Reference Contains comprehensive reference information to refer back to.

Identification of the topics in the help according to the target system
Depending on the products that are installed, the help system may contain sections that apply 
to specific devices only. To be able to recognize such sections at first glance, you will find a 
note in brackets in the table of contents. The search results in the full text search and in the 
index are marked in the same way if they only apply to a specific device.
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Roll-out   
Certain text boxes offer information that rolls out and helps you to enter valid parameters and 
values. The roll-out informs you about permitted value ranges and data types of the text boxes.

The following figure shows a roll-out (yellow) and a roll-out error message (red), which indicates 
an invalid value:

The roll-out is closed as soon as you exit the window or click on the "x" in the upper right-hand 
corner.

Tooltip   
Interface elements offer you a tooltip for easier identification. 

Tooltips, which have an arrow icon on the left, contain additional information in tooltip 
cascades. If you position the mouse pointer briefly over the tooltip or click the arrow icon, this 
information is displayed. The automatic display of tooltip cascades can be disabled.

If additional information is contained in the help system, a link to the corresponding help topic 
appears in the cascade. If you click on the link, the corresponding topic opens in help.

The following figure shows a tooltip with opened cascade:
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See also
Configuring the display of tooltips and tooltip cascades (Page 353)

6.2.2 Opening the supplied Help system
You access the help via the menu, using links in the tooltip cascades, or with the <F1> key.

Procedure
To open the supplied help system, follow these steps: 

1. In the "Help" menu, select the "Show help" command or press <F1> to display the help 
matching the current context.

Or:
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1. Click on the link in a tooltip cascade to go directly to a point in the help system that contains 
more detailed information.

6.2.3 Searching the Help system for keywords

Searching for keywords in the help text  
To search the help topics for predefined keywords, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Index" tab.

3. Enter the search term in the input box or select the search term from the list of key words.

4. Click "Display".

6.2.4 Full-text searches

Full-text searches
To search the entire text for specific words, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Search" tab.

3. Type in your search term in the text box.

4. Refine your search if necessary using additional criteria:

– Select "Search previous results" to start an additional search operation of your last 
search results only.

– Select "Search for similar words" to find words that differ only slightly from your search 
term.

– Select "Search titles only" to obtain only results that contain your search term in the title. 
The contents of the Help topics are ignored during the search.
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5. Click on the arrow button to the right of the search field to use logic operations. The following 
logic operations are available:

– Combine two or more search terms using the "AND" operator to find only Help topics 
that contain all the search terms in the text.

– Combine two or more search terms using the "OR" operator to find only Help topics that 
contain one or more of the search terms in the text.

– Combine two or more search terms using the "NEAR" operator to find only Help topics 
that contain terms in close proximity to each other (eight words).

– Precede a word with the "NOT" operator to exclude Help topics from the search that 
contain this word.

6. Click on "List topics" to start the search.
The results are now listed with title, position and ranking. The "Position" column shows the 
section in which the Help topic found is located. Sorting according to ranking is based on 
the position of the Help topics found in the table of contents and based on the number of 
hits in the Help topics.

6.2.5 Using favorites

Using favorites
You can save individual help topics as favorites. This saves you searching for the help topic 
a second time.

Saving favorites: 
To save a page as a favorite, follow these steps:

1. Open the help topic or the chapter you want to save as a favorite.

2. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

3. Open the "Favorites" tab.

4. Click the "Add" button.
The help topic or chapter is saved as a favorite and is available the next time you open the 
help system.

Calling up favorites: 
To call up a page from the favorites, follow these steps:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Favorites" tab.
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3. Select the topic you want to open from the list.

4. Click the "Display" button.

Deleting favorites
To delete an entry from the favorites, proceed as follows:

1. Click the "Show/hide table of contents" button in the help toolbar to display the table of 
contents.
The table of contents is displayed and the "Index", "Search" and "Favorites" tabs are visible.

2. Open the "Favorites" tab.

3. Select the topic you want to remove from the list.

4. Click the "Remove" button.

6.2.6 Printing help topics

Printing information
You can either print all the contents of the Help system or individual topics only.

Procedure
To select the topics you would like to print, follow these steps:

1. Click the "Display printing dialog" button.
The table of contents opens in a separate window.

2. Select the check boxes for the folders and help topics to be printed in the "Print help topics" 
dialog.

3. Click the "Print" button to print the selected information.
The "Print" dialog opens.

4. Select the printer on which you want print the help topics.

5. Click "Properties" if you want to make additional printer settings.

6. Confirm your entries with "OK".
The help topics are printed out on the selected printer.
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6.2.7 Configuring the display of tooltips and tooltip cascades

Configuration options for tooltips and tooltip cascade
You can customize the display of tooltips and tooltip cascades to suit your needs. You can 
make the following settings:

● Display or hide truncated text
Sometimes texts may be too long for a text field. The texts are then fully displayed in a 
tooltip when you hover your mouse over the text field. You can enable or disable this 
function.

● Enable or disable tooltips
Tooltips provide more detailed information about an element of the user interface. You can 
also have tooltips displayed in a cascade. If you disable the tooltips, the cascade with 
context-sensitive help is also no longer displayed. However, you have the option of 
manually displaying the tooltip for the currently active interface element by pressing <F1>.

● Enable or disable automatic opening of tooltip cascades
By keeping the mouse pointer over a tooltip for a brief time, any available cascades are 
displayed automatically. You can enable or disable the automatic display of cascades. 
When automatic display is disabled, you must open the cascade manually if necessary. To 
do this, click on the arrow icon in the tooltip.

Procedure   
To configure the display of tooltips and tooltip cascades, follow these steps:

1. Select the "Settings" command in the "Options" menu.

2. Select the "General" group in the area navigation.

3. Select or clear the individual check boxes in the "Tooltips" area to suit your needs. The 
"Open cascade automatically in tooltips" check box is only available if you have enabled 
the display of tooltips.

See also
General remarks on the information system (Page 346)

6.2.8 Safety Guidelines

Safety guidelines
This Help manual contains notices you have to observe in order to ensure your personal safety, 
as well as to prevent damage to property. The notices referring to your personal safety are 
highlighted in the manual by a safety alert symbol, notices referring only to property damage 
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have no safety alert symbol. These notices shown below are graded according to the degree 
of danger.

 

 DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 CAUTION

with a safety alert symbol, indicates that minor personal injury can result if proper precautions 
are not taken.

 

 NOTICE

without a safety alert symbol, indicates that property damage can result if proper precautions 
are not taken.

 

 Note

indicates that an unintended result or situation can occur if the corresponding information is 
not taken into account.

 

If more than one degree of danger is present, the warning notice representing the highest 
degree of danger will be used. A notice warning of injury to persons with a safety alert symbol 
may also include a warning relating to property damage.

Qualified Personnel
The device/system may only be set up and used in conjunction with this documentation. 
Commissioning and operation of a device/system may only be performed by qualified 
personnel. Within the context of the safety notes in this documentation qualified persons are 
defined as persons who are authorized to commission, ground and label devices, systems and 
circuits in accordance with established safety practices and standards.

Prescribed Usage
Note the following:

 

 WARNING

This device may only be used for the applications described in the catalog or the technical 
description and only in connection with devices or components from other manufacturers 
which have been approved or recommended by Siemens. Correct, reliable operation of the 
product requires proper transport, storage, positioning and assembly as well as careful 
operation and maintenance.
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Trademarks
All names identified by ® are registered trademarks of the Siemens AG. The remaining 
trademarks in this publication may be trademarks whose use by third parties for their own 
purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware 
and software described. Since variance cannot be precluded entirely, we cannot guarantee 
full consistency. However, the information in this publication is reviewed regularly and any 
necessary corrections are included in subsequent editions.

6.2.9 Assembling customized documentation

Customized documentation    
In the Siemens Industry Online Support, you can assemble customized documentation that is 
tailored to your needs. All configurable manuals and operating instructions of the Siemens 
Industry Online Support are available to you for this purpose. You can select the parts that are 
of interest to you and combine them into in a library to form personal documentation. You can 
organize the documentation using folders in the library. The folders will later become the 
individual chapters of your custom documentation.

You can open your personal library here (https://www.automation.siemens.com/mdm/?
guiLanguage=en).

Requirements
● The manuals or operating instructions used must be configurable. You can recognize 

configurable manuals by the suffix "configurable" in their name.

● To use all the functions, you have to register in the Siemens Industry Online Support and 
log on.

Documentation in different languages
You can change the language of the assembled documentation to German, French, Spanish, 
Italian and Chinese. This gives you the possibility, for example, to gather relevant information 
for a specific project and make it available to colleagues who speak other languages.

Export function in the documentation
You can perform an export at any part of your library in various formats (PDF, XML, RTF).

Introduction to the TIA Portal
6.2 Help on the information system

WinCC Professional V13.0
System Manual, 02/2014 355

https://www.automation.siemens.com/mdm/?guiLanguage=en
https://www.automation.siemens.com/mdm/?guiLanguage=en


Help on creating documentation
You can find more help on creating and using custom documentation in the Siemens Industry 
Online Support (https://www.automation.siemens.com/mdm/_help/en/
mdm_reference_manual_de-DE.htm).

Introduction to the TIA Portal
6.2 Help on the information system

WinCC Professional V13.0
356 System Manual, 02/2014

https://www.automation.siemens.com/mdm/_help/en/mdm_reference_manual_de-DE.htm
https://www.automation.siemens.com/mdm/_help/en/mdm_reference_manual_de-DE.htm


Editing projects 7
7.1 The basics of projects

Introduction   
Projects are used to organize the storage of data and programs resulting from the creation of 
an automation solution. The data that makes up a project includes the following:

● Configuration data on the hardware structure and parameter assignment data for modules

● Project engineering data for communication over networks

● Project engineering data for the devices

● Logs for important events in the life cycle of the project

Project hierarchy
Data is stored in a project in the form of objects. Within the project, the objects are arranged 
in a tree structure (project hierarchy). 

The project hierarchy is based on the devices and stations along with the configuration data 
and programs belonging to them. 

Common data of the project and online access, for example, are also displayed in the project 
tree. 

See also
Creating a new project (Page 358)

Opening projects (Page 360)

Saving projects (Page 364)

Deleting projects (Page 365)

Using logs (Page 357)

7.2 Using logs
For some operations within the TIA Portal, logs are created automatically in the background. 
These logs document changes in the project. Logs are created automatically, for example, 
when you migrate projects and programs or when you update instances from the library.

Logs are displayed in the "Common data" folder in the project tree. They are stored together 
with the project in the project folder and can therefore be read independently of the 
programming device/PC used as soon as you have opened the project. 

In addition to displaying them in the TIA Portal, logs can also be printed.
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Opening logs
To open a log, follow these steps:

1. Open the "Common data > Logs" folder in the project tree.

2. Double-click the desired log in the list.
The contents of the log are displayed in the work area.

Deleting logs
To delete a log, follow these steps:

1. Select the log in the project tree.

2. Press <Del>.
The selected log is deleted from the project directory and removed from the project tree.

7.3 Creating and managing projects

7.3.1 Creating a new project

Procedure
To create a new project, follow these steps:

1. Select the "New" command in the "Project" menu.
The "Create a new project" dialog opens.

2. Enter your project name and path or accept the proposed settings.

3. Click the "Create" button.

Result
The new project is created and displayed in the project tree.

See also
The basics of projects (Page 357)

Opening projects (Page 360)

Saving projects (Page 364)

Deleting projects (Page 365)
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7.3.2 Compatibility of projects
You can use the TIA Portal to open projects that were created with an older version of the TIA 
Portal or with a different installation package. In the following, you will learn what to consider 
in this case.

Opening projects from older product versions
The table below demonstrates the behavior of the TIA Portal when opening projects from older 
product versions:

Product version of the TIA 
Portal
(file extension of the 
respective version)

Behavior when opening with TIA Portal V13

V10.5 (.ap10)
V11.x (.ap11)

The project is automatically upgraded to the latest product version when opened, following 
your confirmation. The upgraded project is a copy of the original project. The original project 
is retained unchanged.

V12 (.ap12) The project is upgraded when you open it. You can select if you want to upgrade the project 
to product version V12 SP1 or V13. The upgraded project is a copy of the original project in 
both cases. The original project is retained unchanged. When you upgrade the project to 
product version V12 SP1, the project is opened in compatibility mode.

V12 SP1 (.ap12) When you open the project, you can decide if you want to open it in compatibility mode or 
upgrade it to the current product version. A copy of the original project is created when you 
upgrade the project. The original project is retained unchanged.

Compatibility mode
When you open a project in the V12 SP1 project format and do not upgrade it, the project is 
in compatibility mode. The range of functions of the TIA Portal is limited to the range of functions 
of V12 SP1. The project remains backward compatible and can still be opened and edited with 
TIA Portal V12 SP1.

To projects in compatibility mode, components can be added that were supplied at a later date 
for version V12 SP1 as part of a Hardware Support Package (HSP). The project is still 
backward compatible with TIA Portal V12 SP1. To continue working with the project in TIA 
Portal V12 SP1, you merely have to also install the Hardware Support Package.

Global libraries are always created in the most recent format and are not backwards 
compatible, even if the project is opened in compatibility mode.

You need to upgrade the project to use the full range of functions of the current version. By 
upgrading the project you convert it to the current project format. The full range of functions of 
the current version becomes available.

Backward compatibility with the current product version
Projects saved with the current version of the TIA Portal are not backward compatible with 
older versions due to their enhanced functionality. Projects saved with TIA Portal V13 can only 
be opened with TIA Portal V13 or later.
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Opening projects created with add-on products
The project you want to open may include data that were created with an optional software. 
The following cases may occur if you did not install these software components:

● Software components which are not absolutely required are missing:
A dialog appears listing the missing software components. After the project is opened, its 
properties are displayed. You now have the opportunity to install missing components. All 
the devices contained in the project are available even if you do not install the missing 
components. However, you can only work with the devices that are supported by the 
currently installed software.
Devices which are not supported because software components are missing are identified 
by the following symbol in the project tree:

● Essential software packages are missing:
A dialog appears listing the missing software components. The essential software 
components are marked. The project can only be opened if you install the missing software 
components.

See also
Opening projects (Page 360)

Upgrading projects (Page 361)

Compatibility of global libraries (Page 455)

7.3.3 Opening projects
You can open all projects from the current version and earlier versions in the TIA Portal.

Projects from earlier versions of the TIA Portal may first have to be upgraded to a more recent 
project format. You are prompted to upgrade the project when you open it.

You recognize projects of the TIA Portal by their file name extension ".ap[version number]". 
TIA Portal V13 projects have the file name extension ".ap13".

Procedure
To open an existing project, follow these steps:

1. Select the "Open" command in the "Project" menu.
The "Open project" dialog box opens and the list of most recently used projects is displayed.

2. Select a project from the list and click "Open".

3. If the project you require is not included in the list, click the "Browse" button. Navigate to 
the desired project folder, and open the project file.
Projects in the current project format are opened in the project view. The "Upgrade project" 
dialog box opens if you have selected a project from an older version of the TIA Portal. 
More information on upgrading the project can be found in chapter "Upgrading projects 
(Page 361)".
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See also
Compatibility of projects (Page 359)

Upgrading projects (Page 361)

Compiling project data (Page 380)

Opening a global library (Page 456)

The basics of projects (Page 357)

Creating a new project (Page 358)

Saving projects (Page 364)

Deleting projects (Page 365)

7.3.4 Upgrading projects
Projects from older versions of the TIA Portal can be edited with the current version of the TIA 
Portal. Depending on the product version that was used to create the project, you either 
upgrade the project or open the project in compatibility mode. To find out which options you 
have depending on the product version of the project, go to chapter "Compatibility of projects 
(Page 359)".

When you open projects from older product versions, you are prompted to upgrade the project. 
You can manually upgrade projects that are already open in compatibility mode. After 
upgrading the project to the current product version, it can no longer be opened in older 
versions of the TIA Portal. But the original project is still available. The upgraded project is 
saved as a copy.

Upgrading projects from V11.x or lower
Proceed as follows to upgrade a project from TIA Portal V11.x or lower:

1. Open the project.
The "Upgrade project" dialog box opens.

2. Click "OK".
A copy of the project is created and upgraded. The project copy receives the name 
extension "_V13". The project is opened.

3. Compile the hardware and software of all devices in the project.
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Upgrading projects from V12
Proceed as follows to upgrade a project from TIA Portal V12:

1. Open the project.
The "Upgrade project" dialog box opens.

2. Select the target version for the upgrade:

– Click "Yes" to upgrade the project to product version V13.

– Click "No" to upgrade the project to product version V12 SP1 and to work in compatibility 
mode.

A copy of the project is created and upgraded. The project copy receives the name 
extension "_V13" or "_V12SP1". The project is opened.

3. Compile the hardware and software of all devices in the project.

Upgrading V12 SP1 projects or using them in compatibility mode
Proceed as follows to upgrade a project from TIA Portal V12 SP1 or to use it in compatibility 
mode:

1. Open the project.
The "Upgrade project" dialog box opens.

2. Select how you want to proceed with the project:

– Click "Yes" to upgrade the project to product version V13.

– Click "No" to use the project in compatibility mode.

3. Optional: If you have upgraded the project to the current product version, compile the 
hardware and software of all devices in the project.

Manually upgrading projects in compatibility mode to V13
To do this, the project must already be open in compatibility mode for the TIA Portal V12 SP1.

To manually upgrade a project in compatibility mode, follow these steps:

1. Select the "Upgrade" command in the "Project" menu.
A security prompt appears.

2. Click "Yes" to confirm.
A copy of the project is created and upgraded. The project copy receives the name 
extension "_V13". The project is opened.

3. Compile the hardware and software of all devices in the project.
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Notes
Pay attention to the following notes after upgrading a project:

 

 Note
Upgrading global libraries

Because global libraries are independent of projects, they are not upgraded automatically 
together with the project. If you want to continue using libraries from older versions of the TIA 
Portal, you need to upgrade these global libraries as well. More information on upgrading 
global libraries can be found in the chapter "Compatibility of global libraries (Page 455)".

 

 Note
Upgrading know-how-protected blocks

The block is only upgraded and loaded after it has been opened once with the password. 
This means you should open know-how-protected blocks once after upgrading the project to 
also upgrade the blocks. If you have protected numerous know-how-protected blocks with 
the same password, you can select and open all of them at once.

 

See also
Compatibility of projects (Page 359)

Opening projects (Page 360)

Upgrading global libraries (Page 457)

Compiling project data (Page 380)

Compatibility of global libraries (Page 455)

7.3.5 Displaying properties of the project
You can display the properties of a project. Properties include the following:

● Metadata for the project
This includes the following information: creation time, author, file path, project size, 
copyright, project languages, etc. Many of the properties can be changed.

● Project history
The project history contains an overview with important events in the project life cycle. Here, 
for example, you can see the version of the TIA Portal used to create a project and whether 
it has been converted into another version in the meantime. If a project was created during 
a migration, for example, this is also indicated in the project history table with the date and 
time of the migration. If a log was created for an event, you can also call the log directly.
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● Support packages in the project
An overview of the add-on software needed to work with all devices in the project is 
displayed. In addition, installed GSD files are listed (device description files for other devices 
in the hardware catalog).

● Software products in the project
You can display an overview of all installed software products needed for the project.

Procedure   
To display the project properties, follow these steps:

1. Select the open project in the project tree.

2. Select "Properties" in the shortcut menu of the project.
The dialog with the properties of the project opens.

3. Select the project properties in the area navigation that you want to have displayed.

7.3.6 Saving projects
You can save the project at any time either under the same or a different name. You can even 
save a project when it still contains elements with errors.

Saving a project  
To save a project, follow these steps:

1. Select the "Save" command in the "Project" menu.
All changes to the project are saved under the current project name. If you are editing a 
project from an earlier version of the TIA Portal, the file extension of the project is also 
retained and you can continue to edit the project in the earlier version of the TIA Portal.

Project Save as
To save a project under another name, follow these steps:

1. Select the "Save as" command in the "Project" menu.
The "Save current project as" dialog opens.

2. Select the project folder in the "Save in" box.

3. Enter the new project name in the "File name" box.

4. Confirm your entry with "Save".
The project is saved under the new name and opened.

See also
The basics of projects (Page 357)

Creating a new project (Page 358)

Opening projects (Page 360)
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Deleting projects (Page 365)

Upgrading projects (Page 361)

Compatibility of projects (Page 359)

7.3.7 Closing projects

Procedure
To close a project, follow these steps:

1. Select the "Close" command in the "Project" menu.
If you have made changes to the project since the last time you saved it, a message is 
displayed. 

2. Decide whether or not you want to save the changes.

7.3.8 Deleting projects
 

 Note

When you delete a project, the entire project data is removed from the storage medium.
 

Requirement
The project you want to delete is not open.

Procedure  
Follow the steps below to delete an existing project:

1. Select the "Delete project" command in the "Project" menu.
The "Delete project" dialog opens and includes the list of most recently used projects.

2. Select a project from the list.
If the project you require is not included in the list, click the "Browse" button. Navigate to 
the desired project folder, and open the project file.

3. Click the "Delete" button.

4. Click "Yes" to confirm. This starts the deletion of the project.

Result
The entire project folder is deleted from the file system. 
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See also
The basics of projects (Page 357)

Creating a new project (Page 358)

Opening projects (Page 360)

Saving projects (Page 364)

7.3.9 Working with multi-language projects

7.3.9.1 Project text basics

Texts in different languages in the project   
When you enter texts while working on a project, you would normally do this in your own 
language. If you then pass on the project to someone else who does not know this language, 
this person will require a translation of the relevant texts to a language they know. This is why 
all texts can be translated. In this way, you can ensure that anyone who is subsequently 
confronted with the texts sees the texts in his/her language of choice.

Project language 
Project languages are all languages in which a project will later be used. Based on the editing 
language, all the texts can be translated to the various project languages. You specify the 
languages that will be available in the project tree under "Languages & Resources > Project 
languages".   

Editing language 
Every project has an editing language. When you enter texts, these are always created in the 
editing language. You should therefore make sure that the editing language set is the language 
in which you enter the texts. This avoids problems if you translate the texts later.

The editing language does not depend on the language of the user interface. You could, for 
example, set English as the user interface language, but use Italian as the editing language. 
If you enter texts, these will be created in this case in the project language "Italian", although 
the user interface of the TIA Portal displays English.

You set the editing language in the project tree under "Languages & Resources > Project 
languages > Editing language".

Reference language 
The reference language is used as a template for translation. The text is displayed in the 
reference language for each text box in the "Tasks > Languages and resources" task card. 
You therefore know which text that belongs in a text box, even when no text is entered in the 
currently selected editing language.
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User texts and system texts     
For clarification purposes, a distinction is made between user texts and system texts:

● User texts are texts that the user created.

● System texts are texts that are created automatically according to the configuration in the 
project.

You manage the project texts in the project tree under "Languages & Resources > Project 
texts".

Examples of multilingual project texts
You can, for example, manage the following project texts in more than one language:

● Block titles and block comments

● Network titles and network comments

● Comments in tables

● Alarm texts

● Operator-relevant texts

● Text lists

● Labels of buttons

● Display names of recipes

Translating texts
The following procedures are available to translate texts.

● Translate all texts used in the project in tabular form
You can enter the translations for the individual project languages directly in the "Project 
texts" table. You will find this in the project tree under "Languages & Resources > Project 
texts".

● Specify text assigned to individual objects in the Inspector window
In the Inspector window, you can translate the texts that are assigned to the currently 
selected objects. Columns are displayed in a table for all available project languages. You 
can enter the translations for each text there.

● Translating texts using reference texts
You can change the editing language for shorter texts. All the text cells are filled again with 
the default values and can be filled in the current language. As orientation, you can display 
what you last entered in the box in the reference language. To do this, select the "Tasks" 
task card and open the "Languages & resources".

● Exporting texts and translating them externally
With larger volumes of text, you can export the texts to an Office Open XML file and translate 
them in a conventional table calculation program. You then import the translated texts again 
into the TIA Portal.
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 Note
Using Asian project languages

East Asian project languages are only displayed correctly in Windows XP, if the option "Install 
files for East Asian languages" is selected on the Languages tab of Regional and Language 
Options in the Control Panel of Windows XP Professional.

 

See also
Overview of the program settings (Page 299)

Changing the settings (Page 302)

Application examples for multilanguage projects (Page 373)

7.3.9.2 Select project languages
All the texts can be displayed within a project in the same language that you selected for your 
software user interface. This means that all project texts must exist in the corresponding 
language. You can select the available project languages yourself.

Requirement
● You are in the project view.

● A project is open.

Procedure
To select the project languages, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The elements below this are displayed.

2. Double-click on "Project languages".
In the work area, you will see a list of languages that you can select.

3. Select the required languages.

Result
All texts can be displayed in the activated languages if there is already a translation for these 
languages.

7.3.9.3 Setting the editing language
All the texts in the project are created in the editing language when they are entered. If you 
change the editing language, all future text input will be stored in the new editing language.
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Requirement
● You are in the project view.

● A project is open.

Procedure
To change the editing language, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The lower-level elements are displayed.

2. Double-click on "Project languages".
The possible settings for the project languages are displayed in the work area.

3. Select the editing language in "General > Editing language".

7.3.9.4 Translating all project texts in tabular form
You can display and edit all project text used in the currently open project in a list. User and 
system texts are separated into two different lists for clarity. Both lists contain a separate 
column for each project language in which you can enter the translations for text.

Requirement
● You are in the project view.

● You have selected at least one further project language.

Procedure   
To translate text in the project-wide list, follow these steps:

1. Click on the arrow symbol to the left of "Languages & Resources" in the project tree.
The elements below this are displayed.

2. Double-click "Project texts".
A list with the user texts in the project is displayed in the work area.

3. Click on "System texts" if you you want to edit the list of system texts rather than the user 
texts.

4. You can improve the clarity of the lists if you have a lot of texts.

– To group identical texts and to translate them all at once, click the "Switch on/off 
grouping" button in the toolbar.

– To hide texts that do not have a translation, click the "Filter for empty texts on/off" button 
in the toolbar.

– To further limit the displayed project texts to certain devices, select the devices for which 
you want to display project texts in the drop-down list.

5. Enter the translation of the project texts in the relevant column.
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7.3.9.5 Translating text associated with individual objects
If you want to edit the text of individual objects, it would be too difficult to locate the matching 
text in the table with all project texts. For this reason, there is a table in the Inspector window 
in which only the texts assigned to the currently selected objects are displayed. In the table, 
you can add missing translations for individual project languages or change existing texts.

Requirement
Text must be entered in at least one project language for the texts to be translated.

Procedure   
To edit the text of the currently selected object, follow these steps:

1. Select the object whose text you want to edit.

2. Open the "Properties" tab in the Inspector window.

3. Open the lower-level "Texts" tab in the inspector window.
A table with all the texts that belong to the selected objects is displayed. It contains one 
column for the currently selected editing language and the reference language, as well as 
additional columns for the other project languages.

4. Add or change the entries in the table for each project language.

See also
Application examples for multilanguage projects (Page 373)

7.3.9.6 Translating texts using reference texts

Introduction   
After changing the editing language, all texts are shown in input boxes in the new editing 
language. If there is not yet a translation available for the newly set language, the input boxes 
are empty or filled with default values.

If you enter text in an input box, this is saved in the current editing language. Following this, 
the texts exist in two project languages for this input field, in the previous editing language and 
in the current editing language. This makes it possible to create texts in several project 
languages.

You can display existing translations for an input box in other project languages. These serve 
as a comparison for text input in the current editing language and they are known as the 
reference language.

 

 Note

The display of reference texts depends on the installed products and is not supported by 
every editor.
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Requirement
There is at least one translation into a different project language for an input field.

Procedure
To display the translation of an input cell in a reference language, follow these steps:

1. In the "Tasks" task card, select the "Languages & Resources" pane.

2. Select a reference language from the "Reference language" drop-down list.

Result
The reference language is preset. If you click in a text box, translations that already exist in 
other project languages are shown in the "Tasks > Languages & Resources" task card.

7.3.9.7 Exporting and importing project texts
You can export project texts for translation and then reimport them. The texts are exported to 
an Office Open XML file with the extension ".xlsx". This can be edited in Microsoft Excel or a 
number of other spreadsheet programs.

The following export options are available:

● Exporting individual project texts

● Exporting all user texts or system texts at once
In this case, the export can be additionally limited by categories.

 

 Note
Row limit in Microsoft Excel

Note that spreadsheet programs may be able to process only a certain number of rows. 
Microsoft Excel 2003 supports a maximum of 65536 rows, for example. Later versions of 
Microsoft Excel support significantly more rows.

 

Exporting individual project texts   
To export individual project texts, follow these steps:

1. Open the "Languages & Resources" folder in the project tree.
The lower-level elements are displayed.

2. Double-click "Project texts".
The project texts editor opens.

3. Choose the "User texts" or "System texts" tab in the editor, depending on which texts you 
want to export.

4. Select the project texts you want to export.

5. Click "Export project texts" on the editor toolbar.
The "Export" dialog box opens.
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6. Choose the language you want to translate from in the "Source language" drop-down list.

7. Choose the language you want to translate to in the "Target language" drop-down list. The 
drop-down list contains the project languages you specified previously. If the required 
language is missing, you must first specify it in the project languages editor.

8. Specify a file path and a file name for the export file in the "Select file for export" input box.

9. Click "Export".

Exporting all system or user texts   
To export all project texts, follow these steps:

1. Select the "Export project texts" command in the "Tools" menu.
The "Export" dialog box opens.

2. Choose the language you want to translate from in the "Source language" drop-down list.

3. Choose the language you want to translate to in the "Target language" drop-down list. The 
drop-down list contains the project languages you specified previously. If the required 
language is missing, you must first specify it in the project languages editor.

4. In "Select content", select the check box "User texts" to export user texts. To export system 
texts, select "System texts". To export both user texts and system texts, select both check 
boxes.

5. In "Select content", select the required text categories for the user texts or the system texts.

6. In the "Export file" input field, specify a file name for the export file.

7. In the "Path" input field, select a path in the data system to which the export file is to be 
saved.

8. Click "Export".

Importing project texts   
To import a file containing project texts, follow these steps:

1. Select the "Import project texts" command in the "Tools" menu.
The "Import" dialog box opens.

2. Select the path and the file name of the import file from the "Select file for import" field.

3. Select the "Import base language" check box if you have made changes to the base 
language in the export file and you want to overwrite the entries in the project with the 
changes.

4. Click "Import".

See also
Application examples for multilanguage projects (Page 373)
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7.3.9.8 Application examples for multilanguage projects

Introduction 
Let us assume you are working in a team with colleagues some of whom speak English, some 
French and some German. You have created a project with the TIA Portal and have already 
created a functioning configuration.

To allow your other colleagues to be able to keep track of the project, you would like all devices 
being used to have comments in English and German. First, you would like to enter the 
comments in German. Following this, to save time and costs, you want to have the texts 
translated into English in a spreadsheet program by an external translation office.

In addition to this, you also want a single comment for a particular device in French so that 
your French-speaking colleague can continue working on this device.

The section below describes an example of how you can achieve this with the tools of the TIA 
Portal.

Translating the project into English
To enter the comments in German and to have them translated into English later, follow these 
steps:

1. Set the editing language to "German" and fill all the comment boxes with the relevant texts 
in German.
On the device selected from the French-speaking colleague, enter, for example "Unser 
neues Gerät" in German first.
All the comments are now stored in German.

2. Export all user texts to an Office Open XML file with the extension ".xlsx".

3. Have the user texts contained in the file translated into English in a spreadsheet program 
such as Microsoft Excel.

4. Import the file into the TIA Portal after it has been translated.
All texts are now available in German and English.

Translating a single comment field to French
To translate an individual comment field to French, follow these steps:

1. Open the comment box for the device on which the French-speaking colleague will be 
working.

2. Open the "Languages & Resources" pane in the "Tasks" task card.

3. Set "French" as the editing language in the "Languages & Resources" pane. As the 
reference language, set, for example, "English".
Since no translation has yet been installed in French, the comment box is empty. In the 
"Languages & Resources" pane, the English translation "Our new device" is displayed as 
a reference.

4. Orientating yourself on the English reference text enter "Notre nouvel appareil" in the 
comment box.
The comment for this device is now available in the languages German, English and French.
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See also
Project text basics (Page 366)

Exporting and importing project texts (Page 371)

Translating text associated with individual objects (Page 370)

7.3.10 Archiving and retrieving projects

7.3.10.1 Working with project archives

Archiving and transferring projects     
If you work for a long time with a project, large files may result, especially with extensive 
hardware configurations. Therefore, you may want to reduce the size of the project, for 
example, when you archive it to an external hard drive, or when you send it via e-mail and 
require a smaller file size.

Options for reducing the size of the project
There are two ways to reduce the size of the project:

● Creating a project archive
TIA Portal project archives are compressed files, each containing an entire project, 
including the entire folder structure of the project. Before the project directory is compressed 
into the archive file, all files are reduced to their essential components to further decrease 
the size of the project. Project archives are therefore well suited for sending via e-mail.
Project archives have the file extension ".zap[version number of the TIA Portal]". Projects 
created with TIA Portal V13 have the file extension ". zap13".
To open a project archive, retrieve the project archive. By retrieving it, the archive file with 
the included project files is extracted to a previously selected location in the original project 
directory structure.

● Minimizing a project
You can skip additional compression in an archive file, and instead create a copy of the 
project directory. The included files are reduced to the essential elements of the project. 
This minimizes the required storage space. The full functionality of the project is maintained 
and you can open the project as usual.
A minimized project is especially well suited for archiving, for example, on an external 
medium.

See also
Retrieving projects (Page 376)

Archiving projects (Page 375)
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7.3.10.2 Archiving projects
You can reduce the storage space required for the currently open project by compressing the 
project into a file, or by reducing the project files to their essential components. You can do 
both of these with the archiving function of the TIA Portal.

 

 Note

The most recently saved state of the project is used for archiving. Therefore, save the project 
before using the archiving function. This will ensure that your most recent changes are 
included in the archived project.

 

Procedure 
To archive a project, follow these steps:

1. Select the "Archive" command in the "Project" menu.
The "Archive current project as..." dialog opens.

2. Select the directory where you want to save the archive file or the new project directory.

3. Select the file type from the "File type" drop-down list:

– TIA Portal project archive, if you want to create a compressed file of the project.

– Minimized TIA Portal project, if you only want to create a copy of the project directory 
with minimal storage space.

4. Enter a file name in the "File name" field if you are creating an archive file. If you are creating 
a minimized project directory instead, enter the name of the new project directory to be 
created in the "File name" box.

5. Click "Save".

Result
When you have created a project archive, a compressed file with the extension ".zap13" is 
generated. Project archives of projects in compatibility mode for product version V12 SP1 
receive the file extension ".zap12" and are backward compatible with TIA Portal V12 SP1. The 
archive file contains the complete project directory. The individual files of the project are also 
reduced to the essential components in order to save space.

If you have created a minimized TIA Portal project, only a copy of the original project directory 
is created at the desired location. The files contained within it are reduced to their essential 
components in order to save space.

See also
Working with project archives (Page 374)

Retrieving projects (Page 376)
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7.3.10.3 Retrieving projects
You extract project archives of the TIA Portal with the "Restore from archive" function. This 
restores the project directory structure including all project files.

Requirement 
No project should be open.

Procedure
To unpack a project archive, follow these steps:

1. Select the "Restore from archive" command in the "Project" menu.
The "Retrieve archived project" dialog opens.

2. Select the project archive.

3. Click "Open".

4. The "Find folder" dialog opens.

5. Select the target directory to which the archived project should be extracted.

6. Click "OK".

Result
The project is extracted to the selected directory and opened immediately. If you extract a 
project archive that includes a project from a product version lower than V12 SP1, you may 
have to upgrade the project. You will automatically receive the corresponding prompt as soon 
as you open the project. The same rules apply that are described in the chapter "Compatibility 
of projects (Page 359)".

See also
Working with project archives (Page 374)

Opening projects (Page 360)

Compatibility of projects (Page 359)

Upgrading projects (Page 361)
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7.4 Using reference projects

7.4.1 Basics of reference projects

Introduction
You can open other projects as a reference in addition to the current project. You can use 
these reference projects as follows:

● You can drag individual objects from a reference project into the current project and then 
edit them.

● You can open specific objects, for example, code blocks from a reference project as read-
only. But this is not possible for all elements.

● You can use an offline/offline comparison to compare devices of the reference project to 
devices from the current project. 

Note that reference projects are read-only. You cannot change the objects of a reference 
project.

Projects that were created with an older version of the TIA Portal or with a different installation 
package can also be opened as reference projects. The same compatibility rules as those for 
the normal opening of a project from an older version of the TIA Portal apply here.

See also: Compatibility of projects (Page 359) 

See also
Comparing reference projects (Page 378)

Opening and closing a reference project (Page 377)

Reference projects (Page 323)

7.4.2 Opening and closing a reference project

Opening a reference project
To open a reference project, follow these steps:

1. In the "Reference projects" palette of the project tree, click on "Open reference project" in 
the toolbar.
The "Open reference project" dialog box opens.

2. Navigate to the desired project folder, and open the project file. TIA Portal V13.x projects 
have the extension ".ap13". Older projects of the TIA Portal have the extension ".ap[version 
number]".

3. Click "Open".
The selected project is opened as a read-only reference project.

Editing projects
7.4 Using reference projects

WinCC Professional V13.0
System Manual, 02/2014 377



Closing a reference project
To close a reference project, follow these steps:

1. In the "Reference projects" palette of the project tree, select the reference project you want 
to close.

2. Click on "Close reference project" in the toolbar.
The selected reference project is closed.

See also
Basics of reference projects (Page 377)

Comparing reference projects (Page 378)

Reference projects (Page 323)

7.4.3 Comparing reference projects

Introduction
You can compare devices from reference projects with devices from both the current project 
as well as from the same or another reference project or from a library.  

 

 Note

Please note the following:
● You cannot specify actions for the comparison objects, since the reference projects are 

write-protected.
● You can perform a detailed comparison for the comparison objects, if the type of 

comparison object generally allows a detailed comparison.
● When comparing reference projects, you can always switch between automatic and 

manual comparison.
 

Procedure
To compare the objects of a reference project to the device data of the current project, follow 
these steps:

1. In the project tree, select the device whose data you want to compare to the data of a 
reference project and which allows offline/offline comparison.

2. Select "Compare > Offline/Offline" from the shortcut menu.
The compare editor opens with the selected device displayed in the left area.

3. Open the "Reference projects" palette in the project tree.
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4. Select the device of a reference project that you want to compare to the device data from 
the current project.

5. Drag the device from the reference project into the right drop area of the compare editor.
You can identify the status of the objects based on the symbols in the status and action 
area. When you select an object, the object's properties and the corresponding object of 
the associated device is clearly shown in the properties comparison.
You can drag a library or other devices from a reference project from the current project 
into drop areas at any time and thus start a new comparison. It does not matter which device 
you drag into the drop area.

See also
Basics of reference projects (Page 377)

Reference projects (Page 323)

Opening and closing a reference project (Page 377)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

7.5 Editing project data

7.5.1 Compiling and loading project data

7.5.1.1 Compiling project data

General information on compiling project data

Compiling project data
During compilation, project data is converted so that it can be read by the device. Hardware 
configuration data and program data can be compiled separately or together. You can compile 
the project data for one or more target systems at the same time.

The following project data must be compiled prior to loading:

● Hardware project data, for example, configuration data of the devices or networks and 
connections

● Software project data, for example, program blocks or process screens
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 Note

While a device is being compiled, no additional compiling process can be started. Note in 
this regard that you can not only perform a compiling process manually, but you can also 
trigger it automatically for HMI devices.

 

Scope of the compilation
When you compile project data, you have the following options depending on the device 
involved:

● Hardware and software (only changes)

● Hardware (only changes)

● Hardware (rebuild completely)

● Software (only changes)

● Software (rebuild all blocks)

● Software (reset memory reserve)

See also
Compiling project data (Page 380)

Compiling project data
The following section describes the general procedure for compiling project data in the project 
tree. You will find details of how certain objects are compiled and any special points to note in 
the online help of the product.

Procedure     
To compile project data, follow these steps:

1. In the project tree, select the devices whose project data you want to compile.

2. Select the option you require in "Compile" submenu of the shortcut menu.
 

  Note

Note that the options available to you depend on the selected device.
 

The project data is compiled. You can check whether or not the compilation was successful 
in the Inspector window with "Info > Compile".

 

See also
General information on compiling project data (Page 379)
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7.5.1.2 Loading project data

General information on loading

Introduction
In order to set up your automation system, you need to load the project data you generated 
offline on the connected devices. This project data is generated, for example when configuring 
hardware, networks, and connections or when programming the user program or when 
creating recipes. 

The first time you download, the entire project data is downloaded. During later loading 
operations, only changes are downloaded. 

You can download the project data to devices and memory cards.
 

 Note

While a device is being compiled, no additional download process can be started. Note in 
this regard that you can not only perform a compiling process manually, but you can also 
trigger it automatically for HMI devices.

 

Possible options for downloading
Depending on the object you want to download, you have the following options:

● Hardware and software (only changes)
Both the hardware configuration and software are downloaded to the destination if 
differences exist between the online and offline versions.

● Hardware configuration
Only the hardware configuration is downloaded to the destination.

● Software (only changes)
Only the objects that differ online and offline are downloaded to the destination.

● Load PLC program to device and reset
All the blocks are loaded to the destination and all values are reset to their initial state. Be 
aware that this also applies to retentive values.

You can also upload project data already contained in a device back to your project. You have 
the following options:

● Upload entire device as new station
The hardware configuration of the device and the software on the device is uploaded to the 
project. 
All relevant data of the device is uploaded to the project.

● Upload software of a device
Only the blocks and parameters from the device are uploaded to an existing CPU in the 
project. 

In both cases, during loading all instances of library types are connected again with the 
corresponding version of the type in the project library. If no suitable type is yet available for 
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a loaded instance or the correct version of the type does not exist in the project library, the 
type or the version is added to the project library.

Downloading with synchronization
In team engineering, it is possible for several users to work on one project with several 
engineering systems at the same time and to access one S7-1500 CPU. To ensure consistency 
within the shared project, it is necessary to synchronize the changed data prior to loading so 
that nothing gets overwritten unintentionally.

If differences are detected between the online and offline data management within the shared 
project that were caused by a different engineering system, automatic synchronization of the 
data to be loaded is offered when loading.

In this case, the "Synchronization" dialog displays the data to be synchronized with the current 
status (online-offline comparison) and the possible actions.

Use case Recommendation Synchronization
One or more blocks on the CPU (online) 
are more recent than in the engineering 
system (offline).

These blocks should be uploaded from 
the CPU to the engineering system 
before downloading.

Automatic synchronization is possible:
The blocks in the engineering system 
are updated prior to loading.

One or more new blocks have been 
created and exist only on the CPU 
(online).

These blocks should be uploaded from 
the CPU to the engineering system 
before downloading.

Automatic synchronization is possible:
The new blocks are added to the 
engineering system prior to the 
download.

One or more blocks on the CPU have 
been deleted.

The blocks should also be deleted prior 
to the download in the engineering 
system.

Automatic synchronization is not 
possible.
The blocks deleted on the CPU should 
be manually deleted in the offline project 
in the engineering system.
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Use case Recommendation Synchronization
One or more blocks on the CPU and in 
the engineering system are different.
This is the case when a different user 
has changed blocks to which you have 
also made corrections and has already 
downloaded them to the CPU. 

These blocks with competing changes 
must be adapted manually. You decide 
in this case which changes you are 
going to accept.
If the blocks on the CPU are to be 
retained, you should adopt these blocks 
from the CPU in your engineering 
system before downloading to the CPU.
If the blocks that you have changed are 
to be applied, you can continue with the 
download without synchronization. 

Automatic synchronization is not 
possible:
The affected blocks on the CPU or in the 
engineering system must be adapted 
manually. One of the existing block 
versions (online or offline) will be 
overwritten in the process.

There are differences in the hardware 
configuration on the CPU (online) and in 
the engineering system (offline).

Differences in the hardware 
configuration must be adapted 
manually. You decide in this case which 
hardware configuration you are going to 
accept.
If the existing hardware configuration on 
the CPU is to be retained, you should 
adopt this in your engineering system 
prior to downloading.
If you want to apply the hardware 
configuration you changed, you can 
continue downloading without 
synchronization.

Automatic synchronization is not 
possible:
The hardware configuration must be 
adapted manually.
One of the existing hardware 
configurations (online or offline) will be 
overwritten.

If required, you can use the "Force download to device" command to download blocks without 
synchronization. 

See also
Downloading project data to a device (Page 383)

Downloading project data to a memory card (Page 385)

Uploading project data from a device (Page 386)

Downloading project data to a device
The following section describes the general procedure for downloading project data to a device. 
You will find details of how certain objects are downloaded and any special points to note in 
the online help of the product.

Requirement
● The project data is consistent.

● Each device to which you want to download is accessible via an online access.
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Procedure
To download the project data to the selected devices, follow these steps:

1. Select one or more devices systems in the project tree.

2. Right-click on a selected element.
The shortcut menu opens.

3. Select the option you require in the shortcut menu of the "Download to device" submenu.
 

  Note

Note that the options available to you depend on the selected device.
 

When necessary, the project data is compiled. 

– If you had previously established an online connection, the "Load preview" dialog opens. 
This dialog displays messages and proposes actions necessary for downloading.

– If you had not previously established an online connection, the "Extended download to 
device" dialog opens, and you must first select the interfaces via which you want to 
establish the online connection to the device. You have the option of showing all 
compatible devices by selecting the corresponding option and clicking the "Start search" 
command.
See also: Auto-Hotspot 

4. Check the messages in the "Load preview" dialog, and select the actions in the "Action" 
column, if necessary.

 

 
 WARNING

Preventing personal injury and material damage

Performing the proposed actions while the plant is in operation can cause serious bodily 
injury and property damage in the event of malfunctions or program errors.

Make sure that no dangerous situations can arise before you start the actions! 
 

As soon as loading becomes possible, the "Load" button is enabled.

5. Click the "Load" button.
The loading operation is performed. If there is a need for synchronization, the system 
automatically displays the "Synchronization" dialog. This dialog displays messages and 
suggests actions that are required for the synchronization. You have the option of 
performing these actions or forcing the download without synchronization by clicking "Force 
download to device". If you have performed the suggested actions, you will be asked 
whether you want to continue with the download. The "Load results" dialog then opens. In 
this dialog, you can check whether or not the loading operation was successful and take 
any further action that may be necessary.

6. Click the "Finish" button.

Result
The selected project data was downloaded to the devices. 
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See also
General information on loading (Page 381)

Downloading project data to a memory card (Page 385)

Uploading project data from a device (Page 386)

Downloading project data to a memory card
You can drag-and-drop project data to load it to a memory card. For CPUs of the S7-300/400 
series you can also explicitly download the user program to a memory card inserted in the 
CPU.

Requirement
A memory card is displayed.

See also: Accessing memory cards (Page 440)

Dragging project data to a memory card
To download project data to a memory card, follow these steps:

1. In the project tree, drag the project data you want to load to the memory card.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for downloading.

2. Check the messages, and select the actions in the "Action" column, if necessary.
As soon as loading becomes possible, the "Load" button is enabled.

3. Click the "Load" button.
The loading operation is performed. The "Load results" dialog then opens. In this dialog, 
you can check whether or not the loading operation was successful and take any further 
action that may be necessary.

4. Click the "Finish" button.

Download the user program to a memory card in the CPU (S7-300/400 only)
To download the user program to a memory card in a CPU of the S7-300/400 series, follow 
the steps below:

1. Select a CPU of the S7-300/400 series in the project tree.

2. Select the "Download user program to memory card" command in the "Online" menu.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for downloading. 

3. Check the messages, and select the actions in the "Action" column, if necessary. 
As soon as loading becomes possible, the "Load" button is enabled.

4. Click the "Load" button.
The download is made and the "Load results" dialog is displayed. This dialog displays 
messages and suggests possible actions. 
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5. Check the messages, and select the actions in the "Action" column, if necessary. 

6. Click the "Finish" button.

See also
General information on loading (Page 381)

Downloading project data to a device (Page 383)

Uploading project data from a device (Page 386)

Uploading project data from a device
The following section describes the general procedure for uploading project data from a device. 
Which project data you can upload from a device depends on the products installed.

You have the following options for uploading project data from a device to your project:

● Upload as new station
With this option you upload existing project data of a device to your project as a new station.

● Uploading project data of a device
With this option you upload project data from the device to an existing CPU in the project. 
You will find the project data that can be loaded in the online help of the product.

In both cases, all instances of library types are connected again with the corresponding version 
of the type in the project library during loading. If no suitable type is yet available for a loaded 
instance or the correct version of the type does not exist in the project library, the type or the 
version is added to the project library.

Requirement
● A project is open.

● The hardware configuration and software to be downloaded have to be compatible with the 
TIA Portal. If the data on the device was created with a previous program version or with 
a different configuration software, please make sure they are compatible.

Upload as new station
To upload the complete device to your project, follow these steps:

1. Select the project name in the project tree.

2. Select "Upload device as new station (hardware and software)" in the "Online" menu.
The "Upload device to PG/PC" dialog opens.

3. Select the type of interface you want to use for the load operation in the "Type of the PG/
PC interface" drop-down list.

4. Select the interface to be used from the "PG/PC interface" drop-down list.

5. Click the "Configure interface" button to the right of the "PG/PC interface" drop-down list to 
adapt the settings for the selected interface.
See also: Auto-Hotspot 
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6. Display all compatible devices by selecting the relevant option and clicking the "Start 
search" command. In the accessible devices table, select the device from which you want 
to upload project data.

7. Click on "Load".
Depending on the selected device, a dialog appears in which you have to enter additional 
information, such as the position of the module rack.
The project data of the device is uploaded to the project. You can edit it offline and then 
download it to the device again.

Uploading project data of a device
To upload only project data from one device to your project, follow these steps:

1. Establish an online connection to the device from which you want to download the project 
data.
See also: Auto-Hotspot 

2. Select the device in the project tree.
The "Upload from device (software)" command in the "Online" menu is enabled.

3. Select the "Upload from device (software)" command in the "Online" menu.
The "Upload preview" dialog box opens.

4. Check the messages in the "Upload preview" dialog, and select the necessary actions in 
the "Action" column.
As soon as uploading becomes possible, the "Upload from device" button is enabled.

5. Click the "Upload from device" button.
The loading operation is performed. 

See also
General information on loading (Page 381)

Downloading project data to a device (Page 383)

Downloading project data to a memory card (Page 385)

Loading project data from a memory card
You have the following options for uploading project data from a memory card to your project:

● Upload project data of the memory card as a new station
With this option you upload the project data of a memory card to your project as a new 
station.

● Upload project data of the memory card to an existing device
With this option you upload project data of a memory card to an existing device in your 
project. You will find the project data that can be loaded in the online help of the product.

In both cases, all instances of library types are connected again with the corresponding version 
of the type in the project library during loading. If no suitable type is yet available for a loaded 
instance or the correct version of the type does not exist in the project library, the type or the 
version is added to the project library.
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Requirement
● A project is open.

● The memory card is displayed.
See also: Accessing memory cards (Page 440)

● The hardware configuration and software to be downloaded have to be compatible with the 
TIA Portal. If the data on the memory card was created with a previous program version or 
with different configuration software, please make sure they are compatible.

Upload project data as a new station
To upload project data from a memory card to your project, follow these steps:

1. In the project tree, select the project data you want to upload.

2. Select "Upload device as new station (hardware and software)" in the "Online" menu.

Or:

1. In the project tree, drag the memory card folder to the project.

Or:

1. Right-click on the memory card.

2. Select "Copy" in the shortcut menu.

3. Right-click on the project.

4. Select the "Paste" command in the shortcut menu.

Uploading project data to an existing device
To upload the project data of a memory card to an existing device, follow these steps:

1. In the project tree, drag the folder of the memory card to a device in the project or copy the 
memory card and paste the data into a device.
The "Upload preview" dialog box opens.

2. Check the messages in the "Upload preview" dialog, and select the necessary actions in 
the "Action" column.
As soon as uploading becomes possible, the "Upload from device" button is enabled.

3. Click the "Upload from device" button.
The loading operation is performed. 

Editing projects
7.5 Editing project data

WinCC Professional V13.0
388 System Manual, 02/2014



7.5.2 Comparing project data

7.5.2.1 Basics of project data comparison

Function
You can compare project data of the same type in order to determine possible differences. In 
principle, the following comparison methods are available:

● Online/offline comparison
With this comparison method you can compare the software of objects of a device with the 
objects of a project. This is only possible when you establish an online connection to the 
device.

● Offline/offline comparison
With this comparison method you can either compare the software or the hardware. When 
you compare the software, you can compare objects from projects or libraries. The 
hardware comparison is available for devices from the currently open project or from 
reference projects. You can decide for the software as well as the hardware comparison 
whether the comparison should be performed automatically for all objects or whether you 
want to compare individual objects manually.

● Detailed comparison
For some objects, for example, blocks, you can also perform a detailed comparison in 
addition to the online/offline and offline/offline comparison. This involves opening the blocks 
to be compared beside each other and highlighting the differences.

A simple online/offline comparison is performed as soon as you establish an online connection. 
During this process, comparable objects in the project tree are marked with icons that represent 
the result of the comparison. 

The normal online/offline and offline/offline comparison is performed in the compare editor. 
With the software comparison, you can also select actions for non-identical objects in the 
compare editor.

 

 Note
● Not all objects allow all types of comparison. Which comparison method you can use for 

which project data depends on the products installed.
● Compile your user program before you start a comparison or detailed comparison. After 

each change of the program during a comparison, repeat this step before you update the 
result of the comparison. This ensures that the comparison shows the current status.

 

See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Running a detailed comparison (Page 399)
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7.5.2.2 Carrying out an online/offline comparison
The online/offline comparison lets you compare objects of a device with objects of a project. 

Requirement
The project tree is open.

Procedure
To perform an online/offline comparison, follow these steps:

1. Select a device in the project tree that allows online/offline comparison.

2. Select the "Compare > Offline/online" command in the shortcut menu.

3. If you have not already established an online connection to this device, the "Go online" 
dialog opens. In this case, set all the necessary parameters for the connection and click 
"Connect". 
The online connection is established and compare editor opens.

Result
All objects that exist online and offline are displayed. The symbols in the compare editor and 
in the project tree show you the status of the objects. In the compare editor, you can now define 
certain actions for the objects, depending on their status. 

See also
Basics of project data comparison (Page 389)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Running a detailed comparison (Page 399)

7.5.2.3 Carrying out offline/offline comparisons
With offline/offline comparison you have the option to compare the project data of two devices. 
You can carry out a software as well as a hardware comparison. When you compare the 
software, you can compare objects from projects or libraries. The hardware comparison is 
available for devices from the currently open project or from reference projects. You can decide 
whether the comparison should be performed automatically for all objects or whether you want 
to compare individual objects manually. 

You can drag any other device to the drop area at any time to perform further comparisons.

Requirement
The project tree is open.
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Procedure
To perform an offline/offline comparison, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane. 
All existing objects of the selected devices are displayed depending on the settings of the 
compare editor in the "Software" tab and an automatic comparison is carried out. You can 
identify the status of the objects based on the symbols in the compare editor. You can 
define certain actions depending on the status of the objects.

4. If you want to carry out a manual comparison, click on the button for switching between 
automatic and manual comparison in the status and action area. Then select the objects 
that you want to compare. 
The properties comparison is displayed. You can identify the status of the objects based 
on the symbols. You can define certain actions depending on the status of the objects.

5. If you want to carry out a hardware comparison, open the "Hardware" tab. You can once 
again carry out a manual comparison, if necessary. But you cannot specify any action.

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Using the compare editor  (Page 391)

Running a detailed comparison (Page 399)

7.5.2.4 Using the compare editor 

Overview of the compare editor

Function
The compare editor gives an overview of the results of a comparison in a table. The appearance 
varies slightly depending on whether it is an online/offline comparison or a hardware/software 
comparison.
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Layout of the compare editor
The following figure shows the layout of the compare editor for an online/offline comparison:

① Compare editor toolbar

③ Left comparison table

③ Status and action area

④ Right comparison table

⑤ Properties comparison

The following figure shows the layout of the compare editor for an offline/offline comparison 
(software):
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① Compare editor toolbar

② Drop areas

③ Button to toggle between automatic and manual comparison

④ Left comparison table 

⑤ Status and action area 

④ Right comparison table

⑦ Properties comparison

The following figure shows the layout of the compare editor for an offline/offline comparison 
(hardware):
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① Compare editor toolbar

② Drop areas

③ Button to toggle between automatic and manual comparison

④ Left comparison table 

⑤ Status area 

④ Right comparison table

⑦ Properties comparison

Compare editor toolbar
With the toolbar, you can access the following compare editor functions: 

● Only show different objects
You can hide identical objects to make the comparison easier to follow.

● Show identical and different objects
You can show identical objects if you want to view the comparison in full.

● Scope of the comparison (only online/offline comparison and offline/offline comparison for 
software)
You can define which objects are to be compared. 

● Select assignment criterion (only offline/offline comparison for hardware)
You can specify the criterion according to which the modules are to be assigned to each 
other for the comparison.
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● Changing the view
You can choose between a hierarchical and a flat view. In the hierarchical view, the devices 
are shown in their structure; in the flat view, the objects of the devices are listed without 
structure. 

● Start detail comparison (only online/offline comparison and offline/offline comparison for 
software)
You can start a detailed comparison for objects to show the individual differences. This 
function is, however, not available for every object. 

● Updating comparison results
After you have modified objects, you can update the comparison results using this function. 

● Synchronize non-identical objects (only online/offline comparison and offline/offline 
comparison for software)
You can synchronize non-identical objects using specific actions. 

Drop areas
In the case of an offline/offline comparison, you can drag the devices you want to compare 
into the drop areas. In the case of a software comparison, the devices to be compared can 
originate from the opened project, from reference projects, from the project library or from 
global libraries. However, note that you can only drop complete libraries into the right drop 
area. In the case of a hardware comparison, you can compare devices from the opened project 
or from reference projects.

Button to toggle between automatic and manual comparison
With an offline/offline comparison, you can switch between automatic and manual comparison. 
In the case of automatic comparison, the objects to be compared are assigned automatically 
to each other. In the case of a manual comparison, you can select the objects that are to be 
compared.

Comparison tables
Comparison tables show the objects of the devices being compared to one another. 

The following table shows the meaning of the columns of the comparison table:

Column Description
Name Name of the compare object
Comment Comment on the compare object
Title Title of the compare object
Address Address of the compare object
Numbering Type of numbering for the comparison object
Type Type of compare object
Language Programming language set for the compare object.
Time stamp interface Time of the last modification to the block interface 
Time stamp code Time of the last modification to the source code
Author Name of the author of the compare object
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Column Description
Version Version of the compare object
Family Name of the object family
Load memory Memory usage of the load memory of the compare object
Work memory Memory usage of the work memory of the compare object
Modified on Time of last modification
Signature Signature of the compare object (SIMATIC Safety)
Interface signature Signature of the block interface of the compare object (SIMATIC Safety)

Not all columns are shown in the default setting. However, as in all table editors, you can show 
or hide the columns as required and sort according to individual columns. In the case of a 
hardware comparison, the comparison tables only contain the "Name" column.

Status and action area
The status and action area offers the following options:

● You can view the results of automatic comparison. The results are displayed with symbols.

● In an online/offline comparison and an offline/offline comparison for software, you can 
specify actions for non-identical objects.

Status and action symbol 
The following table shows the comparison results symbols for an online/offline comparison:

Symbol Description
Folder contains objects whose online and offline versions differ

Comparison results are not known

Online and offline versions of the object are identical

Online and offline versions of the object are different 

Object only exists offline

Object only exists online

The following table shows the comparison results symbols for an offline/offline comparison:

Symbol Description
Reference program

Version compared

Folder contains objects of which the versions compared differ

Results of the offline/offline comparison are not known
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Symbol Description
The versions of the object compared are identical

The versions of the object compared differ

Object only exists in the reference program

Object only exists in the version compared

Hardware comparison only: Although the lower-level objects of the container are 
identical, there are differences between the containers themselves. Such a 
container may be a rack, for example.
Hardware comparison only: The lower-level objects of the container are different. 
There are also differences between the containers. Such a container may be a 
rack, for example.

The following table shows the symbols for possible actions in a software comparison:

Symbol Description
No action

Overwrite the object of the compared version with the object from the reference 
program
Overwrite the object of the output program with the object from the compared 
version
Different actions for the compare objects in the folder

Properties comparison
The properties comparison compares the properties of the selected compare objects. The 
result is displayed with symbols. Only the properties comparison is made with a manual 
comparison so that the status and action area remains empty. With automatic comparison, 
you can perform the property comparison in addition to the comparison in the comparison 
tables.

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Changing the view (Page 403)

Show and hide table columns (Page 398)

Filtering the compare editor view (Page 398)

Updating the comparison results (Page 400)

Synchronizing non-identical objects (Page 401)
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Show and hide table columns
In a software comparison, you can show or hide the columns of comparison tables as required.

Procedure
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

The change affects both the left and the right comparison table.

Result
The columns in both the left and the right comparison table are shown or hidden.

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Filtering the compare editor view (Page 398)

Running a detailed comparison (Page 399)

Updating the comparison results (Page 400)

Synchronizing non-identical objects (Page 401)

Changing the view (Page 403)

Filtering the compare editor view
You can improve the clarity of the compare editor using the following filters:

● Hiding identical comparison objects
You can hide comparison objects which have identical online/offline or offline/offline 
versions. Any such comparison objects you have hidden can also be shown again at any 
time.

● Displayed objects
In an online/offline comparison or an offline/offline comparison for software, you can specify 
the objects for which the comparison results are to be shown. 
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Requirement
The compare editor is open.

Hiding identical comparison objects
To hide identical objects, follow these steps:

1. Click on the "Show only objects with differences" button in the toolbar.
Only the elements that differ online and offline are displayed.

Showing identical comparison objects
To show identical objects again, follow these steps:

1. Click on the "Show identical and different objects" button in the toolbar.
All elements will be displayed.

Selecting displayed objects
To select the objects for which comparison results should be displayed, follow these steps:

1. Perform an online/offline or an offline/offline comparison for software.

2. Click the arrow of the button "Show additional available filters" in the toolbar.

3. Select the required filter.

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Changing the view (Page 403)

Show and hide table columns (Page 398)

Running a detailed comparison (Page 399)

Updating the comparison results (Page 400)

Synchronizing non-identical objects (Page 401)

Running a detailed comparison
 

 Note

Not all objects allow a detailed comparison. The project data for which you can perform a 
detailed comparison depends on the products installed. A detailed comparison of the 
hardware components is not available for hardware comparison.
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Procedure
Proceed as follows to perform a detailed comparison:

1. First, perform an online/offline or an offline/offline comparison for software.
The compare editor opens.

 

  Note

You can only perform a detailed comparison for objects that are listed in the left as well 
as the right comparison table.  

 

2. In the compare editor, select the object for which you want to perform a detailed comparison. 

3. Click the "Start detailed comparison" button in the toolbar.

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Show and hide table columns (Page 398)

Changing the view (Page 403)

Filtering the compare editor view (Page 398)

Updating the comparison results (Page 400)

Synchronizing non-identical objects (Page 401)

Updating the comparison results
As soon as you change an object, the comparison results are no longer valid and must be 
updated. 

 

 Note

For online/offline comparisons, you should note that changes in the device may result in the 
system automatically updating the comparison editor if objects in the comparison are affected 
by the change. This can have the following results:
● Some of the actions you have defined may become invalid, for example if the device no 

longer contains the object in question. Objects with such invalid actions will be highlighted 
so you can define new, valid actions.

● The selection you made before the automatic update may also be cancelled.
 

Requirement   
The comparison editor is open.
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Procedure
To update the comparison results, follow these steps:

1. Click the "Refresh view" button in the toolbar.
The comparison results are updated.

 

  Note

Please note that the "Refresh view" button will not be available while the comparison editor 
is loading or synchronizing content. 

 

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Show and hide table columns (Page 398)

Changing the view (Page 403)

Filtering the compare editor view (Page 398)

Running a detailed comparison (Page 399)

Synchronizing non-identical objects (Page 401)

Synchronizing non-identical objects

Specifying actions
If you have performed a comparison, you can specify the actions to be performed for non-
identical objects in the compare editor. You cannot select any actions for identical objects. 
Note that you cannot execute any actions during hardware comparison.

In the case of an online/offline comparison, only synchronization actions in one direction are 
permitted, in order to retain program consistency. Thus, for example, you can load multiple 
blocks to a device or from a device, but you cannot perform a combination of loading actions 
in one synchronization action. In this case, the first action you set in the compare editor 
determines the synchronization direction. For example, if you specify for a block that the offline 
block is to be loaded to the device, then the other objects can also only be loaded to the device 
via a synchronization action. To load objects from the device again, first select the "No action" 
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option. You can then specify the action settings again as required. Or, you can perform a new 
comparison.

 

 Note

Please note the following CPU-specific aspects when defining actions:
● S7-300/400:

– You can define actions for the "Program blocks" folder, for folders you have created 
yourself or for individual blocks.

– Neither SCL nor GRAPH blocks can be loaded from the device to the offline project.
● S7-1200/1500:

– You can define actions for the "Program blocks" folder, for folders you have created 
yourself or for individual blocks. If you have performed an online/offline comparison 
and select download to the device as action, a consistent download is executed. If you 
upload the object from the device to the project, however, you can also upload 
individual blocks.

– SCL blocks cannot be loaded from the device to the offline project.
 

Requirement
The compare editor is open. 

Procedure
To select an action for a non-identical object, follow these steps:

1. In the status and action area, double-click in the "Action" column on the cell of the object 
for which you want to define an action. 
The cell changes to a drop-down list.

2. Click on the drop-down list.

3. Select the action you want.
The action set will be carried out for the object in question the next time synchronization is 
performed. 
If you have accidentally changed the action you had selected, you can undo the change 
before the next synchronization. 

4. To restore the previous action selected, right-click on the object or folder.

5. Select the "Restore previous selection" command in the shortcut menu. 

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Show and hide table columns (Page 398)
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Filtering the compare editor view (Page 398)

Updating the comparison results (Page 400)

Synchronizing objects (Page 403)

Synchronizing objects
Synchronization executes the actions you have specified for non-identical objects. Note, 
however, that in the case of an online/offline comparison you can only perform actions in one 
direction in one synchronization action.

Requirement
● The compare editor is open.

● The desired actions have been selected.

Procedure
To synchronize objects, follow these steps:

1. Click the "Execute actions" button in the toolbar.

Result
The actions you specified for the objects are performed. 

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Show and hide table columns (Page 398)

Filtering the compare editor view (Page 398)

Updating the comparison results (Page 400)

Specifying actions (Page 401)

Changing the view
You can choose between a hierarchical and a flat view for the left comparison table. In the 
hierarchical view, the devices are shown in their structure; in the flat view, the objects of the 
devices are listed without structure. In the right comparison table, the objects are always 
displayed flat.

Editing projects
7.5 Editing project data

WinCC Professional V13.0
System Manual, 02/2014 403



Setting the hierarchical view
To set the hierarchical view, follow these steps:

1. Click the "Display in hierarchical view" button in the toolbar of the compare editor.

Setting the flat view
To set the flat view, follow these steps:

1. Click the "Display in flat view" button in the toolbar of the compare editor.

See also
Basics of project data comparison (Page 389)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Overview of the compare editor (Page 391)

Show and hide table columns (Page 398)

Filtering the compare editor view (Page 398)

Running a detailed comparison (Page 399)

Updating the comparison results (Page 400)

Synchronizing non-identical objects (Page 401)

7.5.3 Protecting project data

7.5.3.1 Protection concept for project data

Introduction     
You can protect your project data from unauthorized access. These include, for example:

● Access protection for devices

● Copy and display protection of objects

● Restrictions for printouts of know-how-protected objects

For objects with know-how protection, this protection is also retained after the object is pasted 
into a library. Note that every protection mechanism is not available for all objects. How to 
protect specific objects is described in the online help of the product. 

Revoking access rights for devices
If you want to execute a function that is password-protected by means of the device protection 
level, you are prompted to enter a password. When the password is entered correctly, you can 
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execute the required function. You continue to have access rights on the device until you close 
the TIA Portal. 

If you want to reactivate password protection while the TIA Portal is open, you can explicitly 
revoke the access rights for a device. As a result, certain functions for the protected device 
cannot be executed until the correct password is entered again. You specify the functions for 
which a password must be entered when you assign the device protection level. 

See also
Printing project data (Page 423)

7.5.3.2 Revoking access rights for devices

Requirement    
● A protection level has been set for the device.

● A protected function for the device has been enabled by entering the password.

Procedure
To revoke the access rights for the device, follow these steps:

1. Select the device for which you want to revoke access rights in the project tree.

2. Select the "Delete access rights" command in the "Online" menu.

Result
The access rights are revoked, and starting from now the user will be prompted to enter the 
password again to execute a password-protected function on the device. The function can only 
be executed if the correct password is entered. 

If the device has an online connection, it will be disconnected. 

See also
Protection concept for project data (Page 404)
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7.5.4 Printing project contents

7.5.4.1 Printing project documentation

Documentation settings

Introduction 
Once a project is created, the contents can be printed in an easy-to-read format. You may print 
the entire project or individual objects within the project. A well-structured printout is helpful 
when editing the project or performing service work. The printout can also be used for your 
customer presentations or as full system documentation.

You can prepare the project in the form of standardized circuit manuals and print it in a uniform 
layout. You can limit the scope of the printout. You have the option to print to the entire project, 
individual objects along with their properties, or a compact overview of the project. In addition, 
you can print the contents of an open editor.

Improving the printout with frames and cover pages 
You can design the appearance of the printed pages according to your own requirements, for 
example, to add your own company logo or the corporate design of your company in the project 
documentation. You can create any number of design variants as frames and cover pages. 
The frames and cover pages are stored in the project tree under the item "Documentation 
settings" and are part of the project. You can insert placeholders for data from previously 
entered document information within the frames and cover pages. These will be filled 
automatically with the appropriate metadata during printing.

If you want to avoid designing your own template, there are ready-made frames and covers 
pages available. These include templates complying with the ISO standard for technical 
documentation.

Modular structure of a printout 
An printout generally consists of the following components:

● Cover page (only when printing from the project tree)

● Table of contents (only when printing from the project tree)

● Name and path of an object within the project tree

● Object data

Printout of the cover page or the table of contents can be deactivated in the "Print" dialog.

See also
Creating frames (Page 412)

Creating a cover page (Page 412)
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Editing cover pages and frames (Page 414)

Entering document information (Page 410)

Print function for module labels (Page 425)

Printout of project contents

Availability of print function     
The following contents can be printed:

● An entire project in the project tree

● One or more project-related objects in the project tree

● Contents of an editor

● Tables

● Libraries

● Diagnostics view of the Inspector window

It is not possible to print in the following areas:

● Portal view

● Detailed view

● Overview window

● Compare editor

● All tabs of the Inspector window, except the diagnostics view

● All task cards, except the libraries

● Most of the dialogs

● Properties and devices of the programming device/PC not related to the project, for example 
online portals and connected card readers.

Scope of printout   
To be able to print, at least one printable element has to be selected.

If a selected object is printed, all subordinate objects are also printed. For example, if a device 
is selected in the project tree, all of its data is also printed. If you select the entire project in 
the project tree for printing, all project contents are printed with the exception of the graphical 
views. These have to be printed separately. Items in the project tree that are not part of the 
project cannot be printed. For example, this includes online portals and connected card readers 
and USB memory devices.

When table contents are printed, all lines in the table in which a cell is selected are printed. In 
order to print one or more table columns, the desired columns must be selected. If no individual 
cells or columns are selected, the entire table is printed.
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Limitations when printing   
In general, it is possible to print all objects that can be visualized on the user interface. 
Conversely, this means that you cannot print objects that you do not have access to. If a printout 
fails, possible reasons may include the following:

● A valid license does not exist for displaying an object.

● There is no device description for an object.

● A software component needed to display an object is not installed.

See also
Printing project data (Page 423)

Changing the print settings

Changing the print settings   
You can specify general print settings that are retained even after the TIA Portal is closed and 
re-opened. Some settings are dependent on the products installed. The following settings are 
possible in every case:

Always print table data as pairs of values
If this option is selected, tables are not printed in tabular format but rather as a pairs of key 
and value.

Example:

Object name Property 1 Property 2
Object A Value A1 Value A2
Object B Value B1 Value B2

In this case, the printout has the following appearance:

Object A

Property 1: Value A1

Property 2: Value A2

Object B

Property 1: Value B1

Property 2: Value B2
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Printing mask editors
● Always print data in tables

All parameters of technology objects are printed in tabular format.

● Print mask graphics if possible
If the utilized editor supports this function, the contents of the editor are not printed as a 
table but rather as a complete graphic as it appears on the screen.

Procedure
To change the print settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group.

3. Select the desired default settings in the "Print settings" area.
The changes are applied immediately and are retained for all projects, even after the TIA 
Portal is closed.

See also
Overview of the print settings (Page 302)

Specifying the print layout

Specifying the print layout     
If you do not want to rely on ready-made print templates, you can specify your own cover page 
or your own layout for the individual pages. Your designs are saved together with the respective 
project.

Your designs for the cover page and your templates for the page layout can be found in the 
project tree under the "Documentation information" group. You will also find metadata on the 
project there under the entry "Document information". For subsequent print operations, you 
can customize the appearance of the printout in the "Print" dialog using the saved cover pages 
and page layout templates and the available metadata.

Designing the cover page   
The cover page can be customized. You can insert a background graphic and provide 
placeholders for text on the page. The placeholders are automatically filled with data from a 
documentation information during printing.

Cover pages are located in the project tree under the "Documentation information > Cover 
pages" group.
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Designing the content page   
The regular pages of a printout can contain the following elements:

● Frame with static content, such as a company logo

● Placeholders for text, such as the name of the project, the page number, and the time the 
printout was started
Several different values for the individual placeholders can be specified in the document 
information. Other values, such as the project name, are preassigned and are inserted 
automatically during printing.

● Footnote
The footnote is always output below the content area.

● Content area
You can specify an area where the printed content is to be embedded.

The design of the content pages is saved in Frames. The individual frames are located in the 
project tree under the "Documentation information > Frames" group.

Entering document information
You can enter metadata in the document information for every project. In addition, a print frame 
and a cover page are specified in the document information. You can create different 
information, if required, to enable you to quickly switch between different document information 
containing different information, frames, cover pages, page sizes, and page orientations when 
printing. For example, this is useful if you want to generate printouts in different languages and 
different document information is provided for each language.

In the documentation editor, you can specify placeholders on the cover page or in the frame 
of the regular pages. These placeholders can be automatically replaced with metadata from 
the documentation information during printing.

The various document information are therefore part of the printing function and specify the 
print layout and print content.

Procedure  
To add metadata, follow these steps:

1. To create new document information, double-click "Add new document information" under 
"Documentation information > Document information" in the project tree.
The new document information is created and opened immediately.

2. Enter a name for the set in the "Name" field.

3. Fill in the individual fields with the metadata for the project.
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Managing cover pages and frames

Using cover pages and frames

Uses for cover pages
You can give your plant documentation printouts a professional appearance by adding a cover 
page. You can design your own cover page or use ready-made cover pages. Ready-made 
cover pages can be adapted and stored again as a template.

Cover pages can be saved in global libraries where they are available for use across projects.

Cover pages are designed for use as a right printed page only.

Uses of frames  
You can embed the regular pages of your plant documentation inside a consistently uniform 
page frame. The frame can contain placeholders for project metadata, which is stored in the 
document information. It can also contain graphic elements that you design yourself.

You can create your own frames or rely on ready-made page frames. You can adapt a ready-
made page frame and then store it again as a new frame.

Like cover pages, frames can be saved in global libraries where they are available for use 
across projects.

Frames are designed for use on right printed pages only.

Cover pages and templates in the project tree  
Cover pages and frames associated with the project are stored in the project tree under the 
entry "Documentation information". There are separate folders here for frames and cover 
pages.

The following actions are available in the project tree for cover pages and frames.

● Creating your own subfolders

● Copying and pasting

● Inserting cover pages and frames from the "Documentation templates" system library

● Copying cover pages and templates to a global library

Cover pages and templates in libraries  
The "Documentation templates" system library contains a few cover pages and templates that 
are available in every project. The cover pages and templates can be moved from there to the 
project tree using a drag-and-drop operation. You can then adapt the cover pages and 
templates in the project tree according to the requirements of your project.

Cover pages and templates can be moved from the project tree to a global library. Afterwards, 
these are available in every project.

Editing projects
7.5 Editing project data

WinCC Professional V13.0
System Manual, 02/2014 411



See also
Library basics (Page 441)

Overview of the "Libraries" task card (Page 443)

Designing cover pages and frames (Page 414)

Using ready-made frames and cover pages (Page 413)

Creating frames
You can create any number of frames for each project. The frames are stored in the project 
tree below the "Documentation information > Frames" group. You can assign a frame to all 
document information. When you select document information for printing, its associated frame 
is used.

Procedure  
To create a new frame, follow these steps:

1. Double-click the entry "Add new frame" below the "Documentation information > Frames" 
group in the project tree.
The "Creating frames" dialog opens.

2. Enter a name for the frame in the "Name" field.

3. Choose the paper size from the "Paper type" drop-down list.

4. Choose whether the page is to be created in portrait or landscape format in the "Orientation" 
drop-down list.

Click the "Add" button.

Result
A new frame is created. The frame is then opened automatically in the documentation editor 
where it can be edited.

See also
Editing cover pages and frames (Page 414)

Creating a cover page (Page 412)

Creating a cover page
You can create any number of cover pages for the printout for each project. The cover pages 
are stored in the project tree below the the "Documentation information > Cover pages" group. 
You can assign a cover page to all document information. When you select specific document 
information for printing, its associated cover page is used.
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Procedure  
To create a new cover page, follow these steps:

1. Double-click the entry "Add new cover page" below the "Documentation information > Cover 
pages" group in the project tree.
The "Add new cover page" dialog box opens.

2. Enter a name for the cover page in the "Name" field.

3. Choose the paper size from the "Paper type" drop-down list.

4. Choose whether the page is to be created in portrait or landscape format in the "Orientation" 
drop-down list.

Click the "Add" button.

Result
A new cover page is created. The cover page is then opened automatically in the 
documentation editor where it can be edited.

See also
Editing cover pages and frames (Page 414)

Creating frames (Page 412)

Using ready-made frames and cover pages
The TIA Portal comes with some ready-made frames and cover pages. These can change 
according to your wishes.

Procedure  
To create and edit the ready-made frames and cover pages, follow these steps:

1. Open the "Global libraries" pane in the "Libraries" task card.

2. In the "Templates" folder, open the "Cover Pages" or "Frames" folder.

3. Drag a cover page or a frame from one of the folders into the project tree and drop it into 
one of the following folders:

– For frames: "Document information > Frames"

– For cover pages: "Document information > Cover pages".

The ready-made frame or cover page can now be used in the project.

4. Double-click on the new entry in the project tree click to edit the frame or the cover page.

See also
Using cover pages and frames (Page 411)

Editing cover pages and frames (Page 414)
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Designing cover pages and frames

Editing cover pages and frames
The documentation editor is a graphical editor which allows you to design frames and cover 
pages for your plant documentation. You can place images or text elements on the frame and 
the cover pages in the document editor. The text elements are either static or they are 
automatically filled during printing with the data from the document information that you have 
selected in the print dialog.

Procedure     
To edit a cover page or a frame in the documentation editor, follow these steps:

1. In the project tree, double-click on the entry for an existing cover page or frame under the 
"Documentation information > Frames " or "Documentation information > Cover pages" 
group.
The documentation editor opens.

2. Design the cover page or frame as desired.

3. Close the documentation editor.
The changes to the cover page or frame are applied automatically.

See also
Creating a cover page (Page 412)

Creating frames (Page 412)

General operation of the documentation editor (Page 415)
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General operation of the documentation editor

Components of the documentation editor   
The following figure provides an overview of the components of the documentation editor:
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① Toolbar
The toolbar provides the following tools (from left to right):
● Arrow tool

Enables object selection.
● Navigation tool

Allows shifting of the partial page.
● Zoom-in button

Magnifies the page display incrementally.
● Zoom-out button

Reduces the page display incrementally.
● Zoom with selection

Adapts the page size to a selected work area.
● Dynamic zoom

Adapts the page width to the work area.
② Work area

You can design the cover page or frame in the work area.
③ "Toolbox" task card

The "Toolbox" task card contains various types of placeholders that you can use on 
the cover sheet or frame. The placeholders can be placed in the work place using 
a drag-and-drop operation.

④ Properties in the Inspector window
You can display and modify the properties of the currently selected object in the 
"Properties" tab of the Inspector window. For example, you can modify the properties 
of the page, format text, specify the position of objects on the page, etc.
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Operation in the documentation editor
The following basic functions are available in the documentation editor:

● Drag-and-drop functionality
The documentation editor is a graphic editor. which means you can place objects anywhere 
with the mouse. An image of the page is displayed in the work area. This image corresponds 
to the ultimate print layout.
If you want to select objects on the page in order to move them or modify their properties, 
the arrow tool must be activated in the toolbar.

● Zoom function
You can use the zoom function to change the size of the page display. You have two options 
for changing the page size:

– Via the buttons in the toolbar
Select the "Zoom in" or "Zoom out" magnifying glass button in the toolbar of the 
documentation editor. Then click on the page in order to magnify (zoom in) or reduce 
(zoom out) the page incrementally.
To zoom in on a particular area, select the "Zoom with selection" tool and use the mouse 
to drag an outline around the area you want to focus on.
To continuously zoom in or zoom out of the work area, use the "Dynamic zoom" tool. 
To magnify the page display, click anywhere on the work area, and then hold down the 
mouse button while dragging the mouse toward the top of the page. To reduce the page 
display, drag the mouse toward the bottom of the page.

– Via the zoom bar
You can also use the zoom bar (located in the bottom right corner of the work area) to 
change the display size. Choose a percentage value from the drop-down list or enter a 
percentage value. Alternatively, you control the display size using the slider.

● Navigation over the page
In addition to scrolling, you the option of changing the partial page with the navigation tool. 
To change the partial page with the navigation tool, select the Hand button in the toolbar. 
Then, click anywhere on the page and hold the mouse button down while moving the page 
to the desired position.

Using and adapting the positioning aids
You have various aids at your disposal to help you position elements on the page:

● Rulers
Rulers are affixed to the page margins in the work area.

● Page grid
A grid is placed underneath the page in the work area.

You can display, hide or adapt the positioning aids in the Inspector window under "Properties 
> Rulers and grid". You can make the following settings:

● Units:
Specify the unit of measurement for the grid and the rulers.

● Grid steps:
Specify the width of the grid.

● Show grid:
Specify whether the grid is to be displayed or hidden.
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● Snap to grid:
Specify whether objects are to be aligned automatically to the grid. If the option is selected, 
the grid lines function like a "magnet".

● Show rulers:
Specify whether the rulers are to be displayed.

See also
Editing cover pages and frames (Page 414)

Specifying the print area (Page 418)

Inserting placeholders for metadata (Page 418)

Specifying the print area
An area within the frame is provided for the actual printed contents. The project data is then 
always inserted inside this defined and uniformly consistent area within the frame. You can 
adjust the size of the print area.

Requirement  
A frame is open in the documentation editor.

Procedure
To define an area for the printed contents, follow these steps:

1. Click on the slightly darker area within the page display in the documentation editor to select 
the area for the print content.
This opens the properties of the area to be printed in the Inspector window.

2. Enter the position of the print area on the X and Y axes in the Inspector window.

3. Specify the width and height of the print area in cm in the Inspector window.

Alternatively, you can change the width and position of the print area in the graphic display of 
the page. To do so, use the mouse to drag the margins of the print area until the desired size 
and position are achieved.

See also
Creating frames (Page 412)

General operation of the documentation editor (Page 415)

Inserting placeholders for metadata
You can provide placeholders on the cover page and in a frame. The placeholders are 
automatically filled with metadata from documentation information during printing, if they are 
placeholders for text. Alternatively, you can add non-modifiable data, such as free text or an 
image.
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All elements are arranged in numbered Z-Orders. If objects overlap, you can determine in 
which sequence these are to be arranged.

Types of placeholders
The following types of placeholders are available to you:

● Text field
The text field stands as a placeholder for a text element from a document information. In 
the properties of the text field, you set which text from a document information should be 
automatically inserted during printing.

● Field for date and time
A date and time is inserted instead of the placeholder when printing. This can be the date 
of creation or the point in time when the last change was made to the project. In the 
properties of the Inspector window, you specify which date or time is printed.

● Page number
The correct page number is automatically applied when printing.

● Free text
You can enter freely selectable text in the properties of the text field. The text is static and 
is not influenced by the document information selected at the time of printing.

● Image
Select the image file in the properties of the placeholder in the Inspector window. Images 
in the formats BMP, JPEG, PNG, EMF or GIF are possible.

Requirement
An cover page or frame is open in the documentation editor.

Procedure     
To insert placeholders for metadata on the cover sheet or in a frame, follow these steps:

1. Drag a field from the "Toolbox > Elements" task card to the work area of the documentation 
editor.
The placeholder is inserted. The placeholder properties are shown in the Inspector window 
and can be edited there.

2. Select the metadata to be inserted during printing from the "Text" drop-down list in the 
Inspector window under "Properties > General > Text box". Alternatively, you have the 
option of entering free text or selecting an image depending on the type of placeholder.

3. In the Inspector window under "Properties > General > Position and size", specify the 
position of the placeholder on the X and Y axis and enter the width and height of the text 
box in cm. You specify the sequence of the objects in the "Z-Order" field, if these overlap. 
The smaller the value, the further down an object is located.

4. In the Inspector window, go to "Properties > View" and select the font formatting and the 
orientation of the text as well as the alignment of the text. You cannot make this setting for 
images.
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See also
General operation of the documentation editor (Page 415)

Displaying print preview

Creating a print preview

Creating a print preview   
You can create a preview of the printout. Document information can be chosen for this, in the 
same way as for the actual printout. In this way, you preview the selected frame and, if 
applicable, the cover sheet. The settings are retained for later printing.

Procedure
To create a print preview and to set the scope of the later printout, follow these steps:

1. Select the "Print preview" command in the "Project" menu.
The "Print preview" dialog opens.

2. Select the frame layout you want to use for the printout.

– In the "Document information" drop-down list, select the documentation information you 
want to use later for the printout. 

– Select the "Print cover page" check box to print the cover page, which is specified in the 
selected document information.

– Select the "Print table of contents" check box to add a table of contents to the printout.

The check boxes for printing the cover page and the table of contents can only be selected 
if you have started the printout in the project tree.

3. Under "Print objects/area", select what is to be printed. The selection is only possible if you 
have started the printout from an editor that supports this function.

– Choose "All" to print out the entire content of the editor.

– Choose "Selection" to print only the objects currently selected in the editor.
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4. Select the print scope under "Properties".

– Choose "All" to print all configuration data of the selected objects.

– Choose "Visible" to print the information of an editor that is currently visible on the 
screen. This option can only be chosen if you have started the printout from an editor 
that supports this function.

– Choose "Compact" to print out an abbreviated version of the project data.

5. Click "Preview" to generate the preview.
A print preview is created in the work area.

 

  Note
Wait time for extensive documents

It can take several minutes to generate the print preview in the case of very extensive 
projects. You can continue working normally in the meantime on systems with adequate 
resources. The progress of the print preview is shown in the status bar.

 

See also
Operation within the print preview (Page 422)
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Operation within the print preview

Functions within the print preview
The print preview shows an exact image of the subsequent printout. You can use the buttons 
in the toolbar to modify the print preview display. The following functions are available (from 
left to right):

● Navigation mode
Allows shifting of the partial page.
To change the partial page with the navigation tool, select the arrow button in the toolbar. 
Then, click anywhere on the page and hold the mouse button down while moving the page 
to the desired position.

● Zoom function

– "Zoom in" and "Zoom out"
Magnifies or reduces the page display.
To zoom in or zoom out the display incrementally, select the corresponding button. Then 
click on the page in order to magnify (zoom in) or reduce (zoom out) the page 
incrementally.
To zoom in on a particular area, enable the "Zoom with selection" icon and use the 
mouse to drag an outline around the area you want to focus on.
To zoom dynamically through the page, select the button "Zoom in / zoom out 
dynamically". With pressed mouse button, scroll down over the page to zoom in. Scroll 
up to zoom out.

– Percentage value in the drop-down list
Specifies the display size of the page in percent.
Enter a percentage value or select a percentage value from the drop-down list. 
Alternatively, choose the "Fit to page" option from the drop-down list to adapt the page 
size to the work area. Or, choose "Fit to width" to adapt the page width to the work area.

● "Forward" and "Backward"
Each change in the partial page, the page count, or the display size is saved in a history in 
the background. You can use the "Forward" or "Backward" button to return to the previous 
view or the next view.

● Page navigation

– "First page"
Jumps to the first page

– "Previous page"
Goes to the previous page.

– "Page number" input field
Shows the current page. To jump directly to a page, enter the page number of the page 
you want to view.

– "Next page"
Goes to the next page.

– "Last page"
Jumps to the last page.
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See also
Creating a print preview (Page 420)

Printing project data
You have two options for printing out project data:

● Print immediately using default settings by means of the "Print" button in the toolbar.
The button is only active if a printable object is selected.

● Printout with additional setting options with the "Project > Print" menu command.
For example, you can choose a different printer or specific documentation information or 
you can specify whether a cover page and table of contents are to be printed. In addition, 
you can specify the print scope or display a print preview prior to printing.

Requirement 
● At least one printer is configured.

● The objects to be printed are not protected.
The print scope for protected objects is limited. Disable the know-how protection to print 
the objects in full.

Printing project data   
To print out data from the current project or the entire project with additional setting options, 
follow these steps:

1. Select the entire project in the project tree in order to print out the entire project. To print 
only individual elements within a project, select them in the project tree.

2. Select the "Print" command in the "Project" menu.
The "Print" dialog opens.

3. Select the printer in the "Name" box.

4. Click "Advanced" to modify the Windows printer settings.

5. Select the frame layout you want to use for the printout.

– Select the documentation information in the "Document information" drop-down list.
The frame stored in the document information is used for the printout. All placeholders 
within the chosen frame are filled with the metadata from the selected document 
information.

– Select the "Print cover page" check box to print the cover page, which is stored in the 
selected document information.

– Select the "Print table of contents" check box to add a table of contents to the printout.

The check boxes for printing the cover page and the table of contents can only be selected 
if you have started the printout in the project tree.
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6. Under "Print objects/area", select what is to be printed. The selection is only possible if you 
have started the printout from an editor that supports this function.

– Choose "All" to print out the entire content of the editor.

– Choose "Selection" to print only the objects currently selected in the editor.

7. Select the print scope under "Properties".

– Choose "All" to print all configuration data of the selected objects.

– Choose "Visible" to print the information of an editor that is currently visible on the 
screen. This option can only be chosen if you have started the printout from an editor.

– Choose "Compact" to print out an abbreviated version of the project data.

8. Click "Preview" to generate a print preview in advance.
A print preview is created in the work area.

9. Click "Print" to start the printout.
 

 Note
Scope of the "Print" dialog

The options available in the "Print" dialog vary depending on the elements to be printed.
 

Result
The project data is prepared in the background for printing and then printed on the selected 
printer. The status bar shows the progress of the print operation. You can continue working 
normally while data is being prepared for printing.

The print results and any errors or warnings are listed in the Inspector window under "Info" at 
the conclusion of the print job.

Canceling a print job   
To cancel an active print job, follow these steps:

1. Click the blue cross in the status bar next to the progress display for the printout.
The printout is cancelled promptly.

See also
Protection concept for project data (Page 404)

Revoking access rights for devices (Page 405)

Printout of project contents (Page 407)

Designing cover pages and frames (Page 414)
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7.5.4.2 Printing module labels

Print function for module labels

Printing of module labels for hardware modules
You can print labels for the modules in your project with the help of the TIA Portal. The labels 
are custom-fit to each module and can contain the following printed information:

● Symbolic name of the input or output

● Absolute address of the input or output

● Symbolic name and additionally the absolute address of the input or output. The order of 
the information can be specified.

The modules are displayed graphically in the device view. If you set the zoom level in the 
device view to at least 200%, the labels for the individual modules will be visible. The printout 
on the labels corresponds to the representation of the labeling in the device view.

The following figure shows an example of two modules in the device view on which the labeling 
of the inputs and outputs is visible:

 

Export and further editing as Microsoft Word file
Before you can print them, the labels are first exported as a Microsoft Word file (.docx). This 
file can be further edited with commonly available word processing programs such as Microsoft 
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Word 2010. The individual labels are represented as a table in the .docx file. You can format 
the text or the backgrounds of the individual cells as desired.

The character spacing of the text within the table is adapted by default, so that texts are not 
truncated. If you want to prevent this from stretching or compressing the text too much, change 
the character spacing of the text in the table cell properties.

Print media
You can print the labels either on ready-made print sheets or on standard DIN A4 paper. You 
can separate the individual labels from the ready-made print sheets and insert them in the 
designated labeling areas of your modules. If you print on standard paper, the individual labels 
must be cut out. Cut marks are automatically included on the printout and serve as aids.

Because the paper feeds of different printers differ slightly, the printout may be slightly offset 
on the paper. When the labels are printed on ready-made print sheets, printing that is accurate 
to the millimeter is important, because otherwise the text will not be custom-fit inside the 
stamped area. In addition, if the printing is imprecise, the labeling of an input or output may 
no longer be congruent with the channel status displays of the module. For this reason, you 
can enter an offset value for your printer in the TIA Portal to ensure precise printing. For 
information on how to determine the proper offset value for your printer, refer to Chapter 
"Determining the print area offset (Page 428)".

See also
Printing labels (Page 426)

Determining the print area offset (Page 428)

Documentation settings (Page 406)

Printing labels
You can print labels for the modules in your project if provision has been made for attaching 
labels to the utilized modules. The labels are first exported to a Microsoft Word file (.docx). A 
separate .docx file is created for each module family (for example, for all selected S7-1500 
modules). You can then modify the labels according to your wishes. The labels are always 
printed from the word processing program.

If no provision has been made for printing labels, the corresponding shortcut menu command 
is inactive. If you have selected multiple modules for printing of labels and at least one of the 
modules does not support this, a message is shown on the "Info > General" tab of the Inspector 
window. The message lists all unsupported modules, and the export of the print file is continued 
for the supported modules.

Requirement
● The chosen modules must support the printing of labels.

● A word processing program that supports Microsoft Word .docx files must be installed, e.g., 
Microsoft Word 2010.

● You need the ready-made labels for your modules or commercially available DIN A4 paper.
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Procedure
To print labels for hardware modules, follow these steps:

1. In the project tree, select the modules for which you want to print labels.

– You can select one or more stations in order to print out labels for all modules plugged 
into these stations.

– Or, select the desired modules below the stations in the "Local modules" folder.

2. Right-click on one of the devices, and select the "Export labels" command from the shortcut 
menu.
The "Export labels" dialog box opens.

3. In the "Content of label" area, select which data are to be printed on the label:

– Choose "Symbolic name" in order to print the symbolic name of the input or output 
(corresponds to the contents of the "Name" column in the IO tag table).

– Choose "Absolute address" in order to print the absolute address of the input or output 
(corresponds to the contents of the "Address" column in the IO tag table).

– Choose "Absolute and symbolic address" or "Symbolic and absolute address" in order 
to print both addresses. The print order corresponds to the indicated order.

4. Select which paper you plan to print on in the "Paper type" area.

– Choose "Print on SIEMENS label sheet" if you want to print on a ready-made label sheet 
for your modules.

– Choose "Print on standard paper" if you want to print on standard DIN A4 paper.

5. In the "Offset print area" select correction values for your printer, if required, for proper 
orientation of the print area. This is only necessary if you are printing on ready-made labels.

– Enter a correction value, in millimeters, in the "Vertical offset" field. A negative value 
shifts the print area upward. A positive value shifts the print area downward.

– Enter a correction value, in millimeters, in the "Horizontal offset" field. A negative value 
shifts the print area to the left. A positive value shifts the print area to the right.

6. In the "Path" field, select the path to which the exported .docx files should be stored.

7. Click the "Export" button to start the export to a .docx file.
The .docx files are created.

8. Open the .docx files with a conventional word processing program, such as Microsoft Word 
2010, and change the design of the labels if necessary.

9. Print out the labels from your word processing program. To do so, use the paper that you 
specified in the Export dialog box.

10.If you are using ready-made sheets, separate the labels at the stamped lines provided for 
that purpose. When standard DIN A4 paper is used, you must cut out the labels.

See also
Determining the print area offset (Page 428)
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Determining the print area offset
If you are using a ready-made label sheet, the printing on it must be applied precisely so that 
the text is properly oriented on the prestamped labels and will have the proper fit relative to 
the channel status displays of the module. However, the paper feeds vary slightly from one 
printer to another. For this reason, you must enter a suitable correction value for your printer 
in the TIA Portal, if necessary. The print area is then shifted in the exported .docx file in such 
a way that the printing fits precisely on the ready-made label sheet.

The settings for shifting the print area are stored for the specific Windows user. If you log on 
to Windows using a different user name, you have to enter the correction values again.

The procedure for determining the correction value for your printer is described below.

Requirement
● You require a ready-made label sheet.

● You must have access to the actual printer that you will use subsequently for the printout. 
The printer must be made ready for printing on standard DIN A4 paper.

Procedure
To determine the correction value for your printer, follow these steps:

1. Print out a label sheet on standard DIN A4 paper, as described in Chapter "Printing labels 
(Page 426)".

2. Compare the printout on the DIN A4 paper with the ready-made label sheet.

3. If the print area is offset, you must use correction values.

– Using a ruler, measure the horizontal offset relative to the ready-made label sheet. This 
will be entered later in the "Horizontal offset" field of the Export dialog box for the printing. 
If the print area is offset to the right, a negative correction value must be entered. If the 
print area is offset to the left , a positive correction value must be entered.

– Using a ruler, measure the vertical offset relative to the ready-made label sheet. This 
will be entered later in the "Vertical offset" field of the Export dialog box for the printing. 
If the print area is offset downward, a negative correction value must be entered. If the 
print area is offset upward, a positive correction value must be entered.

7.6 Undoing and redoing actions

7.6.1 Basics of undoing and redoing actions

Function     
You can undo performed actions at any time. For this purpose, every action you perform is 
saved in an action stack. When undoing actions, the stack is processed from top to bottom. In 
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other words, if you undo an action that lies further down in the stack, all actions located above 
it in the stack will also be undone automatically. 

You can redo previously undone actions until you execute a new action. Once you execute a 
new action, it is no longer possible to redo previously undone actions.

Particularities for undoing
There are a few actions that empty the action stack. You cannot undo these actions or the 
actions performed before these actions. The following actions empty the action stack:

● Saving

● Project management (creating a new project, opening project, closing a project, deleting a 
project)

● Compiling

● Restoring blocks

● Establishing an online connection

● Loading

● Writing to memory cards

Displaying the action stack
The "Undo" button in the toolbar is enabled as soon as you perform an action that can be 
undone. This button is split; you can use the arrow down portion to open a drop-down list 
containing all actions of the action stack that you can undo. If you had performed actions in 
an editor other than the currently displayed editor, the corresponding editor is also displayed 
as a subheading. This allows you to always identify the point at which the undo operation will 
be applied. The subheadings are removed from the list when the editor responsible can no 
longer undo actions. 

Actions you have undone are entered in the action stack from where they can be redone. Here, 
you can redo actions you have undone. The display of actions you can redo it is analogous to 
the display of the actions that you can undo.
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Example of undoing actions
The figure below shows how actions performed in various editors and tables are undone:

In this example, you cannot undo actions 1 to 3 because the project was saved. You can undo 
actions 4 to 10 in the order indicated by the direction of the arrow. In other words, you must 
undo action 10 first. Once you have undone action 8, you cannot then undo action 5. You must 
first undo actions 7 and 6. As the final step in the sequence, you can then undo action 4. You 
also have the option of undoing several actions in a single step by undoing an action located 
further down in the action stack. All actions located above it in the stack will be undone 
automatically. 

The same principle also applies to redoing of actions. 

See also
Undoing an action (Page 430)

Redoing an action (Page 431)

7.6.2 Undoing an action
The following options are available for undoing actions:

● Undoing the last action only
Only the last action performed is undone.

● Undoing as many actions as required
Multiple actions in the action stack are undone in a single step.
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Undoing the last action only
To undo the last action performed, follow the steps below:

1. Click the "Undo" button in the toolbar.

– If the action was not performed in the currently displayed editor, a confirmation prompt 
appears.

– If the undo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

2. Click "Yes" to confirm.

3. Enter the password, if necessary.
The editor in which the action was performed is displayed and the action is undone.

Undoing as many actions as required
To undo multiple actions in the action stack in a single step, follow these steps:

1. Click the Down arrow next to the "Undo" button in the toolbar.
This opens a drop-down list containing all actions you can undo. Actions performed in other 
editors are identified by the editor name in the subheading.

2. Click the action you want to undo.
The chosen action and all actions in the stack located above the chosen action are undone. 
If the undo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

3. Enter the required passwords, if necessary.
The editors in which the actions were performed are displayed and the actions are undone. 

See also
Basics of undoing and redoing actions (Page 428)

Redoing an action (Page 431)

7.6.3 Redoing an action
You have the option of redoing an action that has been undone, so that you can return to the 
status present before "Undo" was performed. However, this is only possible until you perform 
a new action. The following options are available for redoing actions:

● Redoing the last undone action only
Only the last undone action is redone.

● Redoing as many undone actions as required
Multiple undone actions in the action stack are redone in a single step.
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Redoing the last undone action only 
To redo the last undone action, follow the steps below:

1. Click the "Redo" button in the toolbar.

– If the action is not being redone in the currently displayed editor, a confirmation prompt 
appears.

– If the redo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

2. Click "Yes" to confirm.

3. Enter the password, if necessary.
The editor in which the action was undone is displayed and the action is redone.

Redoing as many undone actions as required
To redo multiple undone actions in the action stack in a single step, follow these steps:

1. Click the Down arrow next to the "Redo" button in the toolbar.
This opens a drop-down list containing all actions you can redo. Actions performed in other 
editors are identified by the editor name in the subheading.

2. Click the action you want to redo.
The chosen action and all actions in the stack located above the chosen action are redone. 
If the redo operation requires an editor containing a protected object to be opened, you 
must enter the password for the object.

3. Enter the required passwords, if necessary.
The editors in which the actions were undone are displayed and the actions are redone. 

See also
Basics of undoing and redoing actions (Page 428)

Undoing an action (Page 430)

7.7 Finding and replacing in projects

7.7.1 Information on the search function

Find and replace   
You can search for texts in the editors. The search function finds all texts containing the search 
key in the currently opened editor. The results are selected in sequence in the opened editor.

You also have the following options:

● Narrowing down the search with additional options

● Replacing found texts
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The additional options and the type of texts for which you can search depend on the installed 
products and the currently open editor.

See also
Search and replace (Page 433)

7.7.2 Search and replace

Using Find  
The "Find and replace" function enables you to search for or replace texts in an editor.

Additional options for searching
You can narrow down your search by selecting one of the following additional options:  

● Whole words only
Only whole words are found. Words that contain the search key as part of the word are 
ignored.

● Match case
Upper- and lowercase letters are taken into account in the search.

● Find in substructures
The search also includes texts contained in another object.

● Find in hidden texts
Texts that are assigned to another text but that are currently hidden are also included in 
the search.

● Use wildcards
Enter an asterisk as the wildcard for any number of characters. Example: You want to 
search for all words starting with "Device". Type in "Device*" in the search key box.
Enter a question mark as the wildcard, however, if you only want to leave out a single 
character.

● Use regular expressions (for searching in scripts only)
A regular expression is a character string used to describe sets of values and for filtering. 
This allows you to create complex search patterns.

The additional options available depend on the installed products and the editor opened.
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Start search  
Follow these steps to start the "Find and replace" function:

1. Select the "Find and replace" command in the "Edit" menu or open the "Find and replace" 
pane in the "Tasks" task card.
The "Find and replace" pane opens.

2. Enter a term in the "Find" drop-down list.
As an alternative, you can select the most recent search key from the drop-down list.

3. Select the options desired for the search.

4. Using the option buttons, select the starting point for the search and the search direction.

– Select "Whole document" if you want to search through the entire editor regardless of 
the current selection,

– Select "From current position" if you want to start the search at the current selection.

– Select "Selection" if you only want to search within the current selection.

– Select "Down" to search through the editor from top to bottom or from left to right.

– Select "Up" to search through the editor from bottom to top or from right to left.

5. Click "Find".
The first hit is marked in the editor.

6. Click "Find" again to display the next hit.
The next hit is marked in the editor. Repeat this process, as necessary, until you reach the 
last hit.

Replacing the search key  
You have the option of replacing hits individually or automatically replacing all the found texts, 
if the respective editor supports this function. Follow these steps to replace terms:

1. Enter a term in the "Find" drop-down list.
As an alternative, you can select the most recent search key from the drop-down list.

2. Select the options desired for the search.

3. Click the "Find" button to start a search for the specified search key.
The first hit is displayed in the editor.

4. In the "Replace" drop-down list, enter the text you wish to use to replace the search key.
As an alternative, you can select the most recently text specified from the drop-down list.

5. Click the "Replace" button to replace the selected hit with the specified text.
The found text is replaced and the next hit is marked in the editor.
Repeat this process until you have replaced all the hits as wanted. To skip to the next hit 
without replacing the marked word, click the "Find" button instead of "Replace".

6. Click "Replace all" to automatically replace all hits at once.

See also
Information on the search function (Page 432)
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7.8 Working with text lists

7.8.1 Text lists

Introduction  
You can manage texts to be referenced in alarms centrally. All the texts are stored in text lists. 
Each text list has a unique name with which you can call up its content. A range of values is 
assigned to each text in a text list. If a value from a range of values occurs, the corresponding 
text is called up.

All the texts can be translated to all project languages. Here, you have two options available:

● You can enter the translation of the texts in a list. You will find the list in the project tree 
under "Languages & Resources > Project texts".

● You can export all texts to a file in Office Open XML format and enter the translation in a 
spreadsheet program. The translations can then be imported again.

The texts are translated into the other project languages within the framework of the project 
texts. In the text lists editor, you only have to manage the assignment of individual texts to a 
text list.

Each device in the project has its own text lists. For this reason, these lists are arranged under 
the devices in the project tree. In addition, there are text lists that apply to all devices. These 
can be found in the project tree under "Common data > Text lists".

User-defined and system-defined text lists
There are two types of text lists:

● User-defined text lists
You can create user-defined text lists yourself and fill them with texts; in other words, you 
can specify value ranges and the corresponding texts yourself. With user-defined text lists, 
the name of the text list begins with "USER" as default. You can change this name to any 
suitable name.

● System-defined text lists
System-defined text lists are created by the system. These always involve texts relating to 
devices. They are automatically created as soon as you insert a device in the project. With 
system alarms, the name of the text list begins with "SYSTEM". The name of the text list 
and the ranges of values it contains cannot be modified. You can only edit texts assigned 
to individual value ranges.

User-defined text lists System-defined text lists
A user-defined text list can only be assigned to one 
device.

System-defined text lists can be assigned both to 
a device as well as to the entire project.

You can create new text lists and delete existing 
text lists.

You cannot create new text lists or delete text lists.
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User-defined text lists System-defined text lists
You can add and delete value ranges in the text 
lists.

You cannot add or delete value ranges in the text 
lists.

You can specify both the value ranges as well as 
the associated texts.

You can only edit the text associated with one 
value range.

Device-specific and cross-device text lists
Device-specific text lists relate to only one device in the project and are therefore only valid 
for this device. For this reason, they are arranged under a device in the project tree. Device-
specific text lists can be used-defined or created by the system. 

If system-defined text lists are generally valid for several devices or not intended uniquely for 
one device, these are grouped together in the project tree under "Common data". These text 
lists are available for all devices. Cross-device text lists are always created by the system and 
are used solely for system diagnostics alarms. For this reason, you cannot store any user-
defined text lists under "Common data". 

See also
Exporting and importing project texts (Page 371)

7.8.2 Creating user-defined text lists

Creating text lists
You can create user-defined text lists for individual devices.

Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Procedure
To create user-defined text lists, follow these steps:

1. Click on the arrow to the left of a device in the project tree.
The elements arranged below the device are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device are displayed in the work area listed in a table.

3. Double-click on the first free row in the table.
A new user-defined text list is created.

4. Enter a name for your new text list in the "Name" column.
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5. From the drop-down list in the "Selection" column, select whether you want to specify the 
value ranges in decimal, binary or in bits. Depending on the device, there may be further 
options available at this point.

6. Enter a comment in the "Comment" column.
A new user-defined text list has been created and you can now enter the value ranges and 
texts.

7.8.3 Editing user-defined text lists

Editing user-defined text lists  
You can enter value ranges and the corresponding texts in user-defined text lists. User-defined 
text lists are always located below a device in the project tree.

Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Adding to user-defined text lists with value ranges and texts  
To add to user-defined text lists with value ranges and texts, follow these steps:

1. Click on the arrow to the left of a device in the project tree.
The elements arranged below are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device are displayed in the work area listed in a table.

3. Select a text list in the table.
The contents of the selected text list are displayed in the work area. There, you can enter 
a value range and assign texts to the individual value ranges.

4. Enter the value ranges you require in the "Range from" and " Range to" columns. The entry 
must be made in the numeric format selected for the text list.

5. Enter a text for each value range in the "Entry" column.

7.8.4 Editing system-defined text lists

Editing system-defined text lists  
In system-defined text lists, you can only modify the individual texts assigned to a value range. 

System-defined text lists are located in the project tree either below a device or under 
"Common data".
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Requirement
● You are in the project view.

● A project is open.

● The project includes a least one device.

Modifying texts in system-defined text lists  
To edit texts in system-defined text lists that are assigned to a value range, follow these steps:

1. Click on the arrow to the left of a device in the project tree or the "Common data" element.
The elements arranged below are displayed.

2. Double-click on "Text lists".
All the text lists assigned to the device or used in common are displayed in the work area 
listed in a table.

3. Select a text list in the table.
The contents of the selected text list are displayed in the work area. Here, you can add to 
or edit the texts assigned to a value range.

4. Enter a text for each value range in the "Entry" column.

7.9 Using memory cards

7.9.1 Basics about memory cards

Introduction 
Memory cards are plug-in cards that come in a variety of types and can be used for a variety 
of purposes. Depending on the device type or device family, memory cards can be used for 
purposes, such as: 

● Load memory of a CPU 

● Storage medium for projects, firmware backups, or any other files

● Storage medium for performing a firmware update

● Storage medium for the PROFINET device name 

For information regarding the technical variants of the respective memory cards and general 
information on their handling, refer to the respective documentation for the device. For 
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information on handling memory cards in the TIA Portal, refer to the online help under keyword 
"Memory Card".

 

 NOTICE

Do not use memory cards for non-SIMATIC-related purposes, and do not use third-party 
devices or Windows tools to format them. This will irrevocably overwrite the internal structure 
of the memory card, rendering it unusable for SIMATIC devices!

 

 

See also
Adding a user-defined card reader (Page 439)

Accessing memory cards (Page 440)

Displaying properties of memory cards (Page 440)

7.9.2 Adding a user-defined card reader

Introduction
If your card reader is not detected automatically, you can add it manually.

Requirement   
The project view is open.

Procedure
To add a card reader, follow these steps:

1. Open the project tree.

2. Select the "Card Reader / USB memory > Add user-defined Card Reader" command in the 
"Project" menu.
The "Add user-defined Card Reader" dialog opens.

3. In the drop-down list box, select the path for the card reader.

4. Confirm your entries with "OK".

See also
Basics about memory cards (Page 438)

Accessing memory cards (Page 440)

Displaying properties of memory cards (Page 440)
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7.9.3 Accessing memory cards

Requirement   
● A memory card is inserted in the card reader.

● The project view is open.

Procedure
To access memory cards, follow these steps:

1. Open the project tree.

2. Select the "Card Reader / USB memory > Card Reader / Show USB memory" command 
in the "Project" menu.
The "Card reader / USB memory" folder is displayed in the project tree.

3. Open the "Card Reader / USB memory" folder.
You can now access the memory card. 

 

  Note

If data from a non-installed product is stored on the memory card, the folders that contain 
these data are shown in gray. You receive an error message when you attempt to access 
such a folder. Install the corresponding product if needed.

 

See also
Basics about memory cards (Page 438)

Adding a user-defined card reader (Page 439)

Displaying properties of memory cards (Page 440)

7.9.4 Displaying properties of memory cards
You can display the properties for the utilized memory cards. Note that different memory cards 
with different properties must be used, depending on the device.

Requirement
● A memory card is inserted in the card reader.

● The project view is open.
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Procedure
To display the properties of a memory card, follow these steps:

1. Right-click on the memory card for which you want to display the properties.

2. Select the "Properties" command in the shortcut menu.
The "Memory Card <name of the memory card>" dialog opens. The properties are displayed 
in this dialog.

 

See also
Basics about memory cards (Page 438)

Adding a user-defined card reader (Page 439)

Accessing memory cards (Page 440)

7.10 Using libraries

7.10.1 Library basics

Introduction
You can store objects you want to reuse in libraries. For each project there is a project library 
that is connected to the project. In addition to the project library, you can create any number 
of global libraries that can be used over several projects. Since the libraries are compatible 
with each other, library elements can be copied and moved from one library to another. 
Libraries are used, for example, to create templates for blocks that you first paste into the 
project library and then further develop there. Finally, you copy the blocks from the project 
library to a global library. You make the global libraries available to other employees working 
on your project. They use the blocks and further adapt them to their individual requirements, 
where necessary.

Both the project library and global libraries distinguish between two different types of objects:

● Master copies
Almost every object can be saved as a master copy and pasted into the project again later. 
You can, for example, save entire devices with their contents or cover sheets for plant 
documentation as master copies.

● Types
Elements that are required to run user programs, for example, blocks, PLC data types, user-
defined data types or faceplates are suitable as types. Types can be versioned and 
therefore support professional further development. Projects using the types can be 
updated as soon as new versions of the types are available.
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Project library
Each project has its own library, the project library. Here, you store the objects you want to 
use more than once in the project. This project library is always opened, saved, and closed 
together with the current project.

Global libraries
In addition to the project library, you use global libraries if you want to use libraries over several 
projects. Global libraries exist in three versions:

● System libraries
Siemens supplies global libraries for its own software products. These include off-the-peg 
functions and function blocks that you can use within your project. The supplied libraries 
cannot be changed. The supplied libraries are loaded automatically matching the project. 
If you are working in V12 SP1 compatibility mode, the matching libraries for product version 
V12 SP1 are loaded. For all other projects the supplied libraries of the latest TIA Portal 
version are loaded.

● Corporate libraries
Corporate libraries are made available centrally by your organization, for example, in a 
central folder on a network drive. The TIA Portal manages the corporate libraries 
automatically. As soon as a more recent version of an existing corporate library becomes 
available, you receive a prompt to update the corresponding corporate library to the more 
recent version.

● User libraries
Global user libraries are independent of a specific project and can therefore be passed on 
to other users. Shared access to global user libraries is also possible, for example on a 
network drive, if all users open the global user library with write protection.
Global user libraries you have created yourself from older versions of the TIA Portal can 
still be used. To continue using global user libraries from older versions of the TIA Portal, 
they must first be upgraded.

Comparing library objects
You can compare blocks and PLC data types with the objects of a device. This allows you to 
determine, for example, whether certain blocks or PLC data types have been used in a project 
and whether they have been modified. 

See also
Overview of the "Libraries" task card (Page 443)

Overview of the library view (Page 446)

Overview of the library management (Page 449)

Basics on master copies (Page 467)

Basics on types (Page 470)

Editing projects
7.10 Using libraries

WinCC Professional V13.0
442 System Manual, 02/2014



7.10.2 Using the "Libraries" task card

7.10.2.1 Overview of the "Libraries" task card

Function of the "Libraries" task card 
The "Libraries" task card enables you to work efficiently with the project library and the global 
libraries.

Layout of the "Libraries" task card
The "Libraries" task card consists of the following components:
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① "Library view" button
② "Project library" pane
③ "Global libraries" pane
④ "Elements" pane
⑤ "Info" pane
⑥ "Types" folder
⑦ "Master copies" folder

"Library view" button
The "Library view" button is used to change to the library view. The "Libraries" task card and 
the project tree are hidden with this action.

See also: Using the library view (Page 446)

"Project library" pane
In the "Project library" pane, you can store the objects that you want to use more than once in 
the project. 

"Global libraries" pane
In the "Global libraries" pane, you manage the global libraries whose elements you want to 
reuse over several projects. 

The "Global libraries" pane also lists libraries that were shipped together with the products you 
purchased. These libraries provide you with ready-made functions and function blocks, for 
example. The supplied global libraries cannot be edited. 

"Elements" pane
In this pane, you can display the contents of folders in the library. The "Elements" pane is not 
displayed by default. If you want to display the "Elements" pane, you have to enable it first. 
Three view modes are available in the "Elements" palette:

● Details mode
The properties of folders, master copies and types are shown in table form in details mode.

● List mode
In list mode, the contents of folders are listed.

● Overview mode
In overview mode, the contents of folders are displayed with large symbols.

See also: Using the element view (Page 445)

"Info" pane
You can display the contents of the library elements in the "Info" pane. The individual versions 
of types and the last revision date of the version are also displayed.
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"Types" folder
In the "Types" directories, you can manage types and type versions of objects that you use as 
instances in the project.

See also: Using types (Page 470)

"Master copies" folder
In the "Master copies" directories, you can manage master copies of objects that you can use 
as copies in the project.

See also: Using master copies (Page 467)

See also
Library basics (Page 441)

Comparing library elements (Page 497)

7.10.2.2 Using the element view

Introduction 
When you open the "Libraries" task card the first time, the "Project library" and "Global libraries" 
palettes are opened and the "Info" palette is closed. You can display the "Elements" palette if 
needed. 

The elements view shows the elements of the selected library. Three view modes are available 
in the elements view:

● Details
The properties of folders, master copies and types are shown in table form in details mode.

● List
In list mode, the contents of folders are listed.

● Overview
In overview mode, the contents of folders are displayed with large symbols.

The "Info" palette shows the contents of the selected library element. If you select a type in 
the elements view, for example, the type versions are displayed in the "Info" palette.

Requirement
The "Libraries" task card is displayed.
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Procedure
To use the element view, follow these steps:

1. Click "Open or close the element view" in the "Project library" or "Global libraries" pane.

2. To change the view mode from the details view to the list mode or overview mode, click the 
corresponding icon on the toolbar.

See also
Library basics (Page 441)

Overview of the "Libraries" task card (Page 443)

Using global libraries (Page 454)

Comparing library elements (Page 497)

7.10.3 Using the library view

7.10.3.1 Overview of the library view

Function of the library view
The library view combines the functionality of the "Libraries" task card and the overview 
window. In the library view, the elements of a library are displayed in various views. In the 
details view, for example, you see additional properties of the individual elements. You can 
also edit and version the types in the library view.
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Layout of the library view
The following figure shows the components of the library view:

① Library tree
② Library overview
③ "Library view" button
④ "Open or close library overview" button

Library tree
The library tree is similar to the "Libraries" task card, apart from a few minor differences. In 
contrast to the task card, there is no "Elements" palette, because the elements are displayed 
in the library overview. In addition, you can close the library view in the library tree, or open 
and close the library overview.

See also: "Libraries" task card (Page 443)
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Library overview
The library overview corresponds to the overview window and displays the elements of the 
currently selected object in the library tree. You can display the elements in three different 
views:

● Details view
The objects are displayed in a list with additional information, such as the date of the last 
change.

● List view
The objects are displayed in a simple list.

● Icon view
The objects are displayed as icons according to category.

In addition, you can perform the following actions in the library overview:

● Renaming elements

● Deleting elements

● Copying elements 

● Moving elements

● Editing type instances

● Versioning types

● WinCC only: Editing faceplates and HMI user data types

See also: Overview window (Page 326)

See also
Basics on master copies (Page 467)

Basics on types (Page 470)

Opening and closing the library view (Page 448)

Library basics (Page 441)

Comparing library elements (Page 497)

7.10.3.2 Opening and closing the library view
The library view is opened automatically in some cases, for example, when you edit the test 
instance of a type or when you edit faceplates and HMI user data types. You can also open 
the library view manually.
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Opening the library view
To open the library view manually, follow these steps:

1. Open the "Libraries" task card.

2. Click the "Open library view" button in the "Libraries" task card.
The library tree opens. The "Library" task card and the project tree are closed.

3. If the library overview is not displayed, click "Open/close library overview" button in the 
library tree.
The library overview opens. 

Exit library view
To exit the library view, follow these steps:

1. Click the "Close library view" button in the library tree.
The library tree closes. The "Libraries" task card and the project tree are opened.

See also
Overview of the library view (Page 446)

Library basics (Page 441)

Using the "Libraries" task card (Page 443)

Using global libraries (Page 454)

Comparing library elements (Page 497)

7.10.4 Using library management

7.10.4.1 Overview of the library management

Function of the library management
Master copies and types with dependencies to other library elements are subject to some 
functional restrictions. They can, for example, not be deleted as long as dependencies still 
exist. This prevents other library elements from becoming useless. The library management 
is used to identify the dependencies and to create an overview of the work progress.

The library management offers the following functions:

● Display of the correlations of types and master copies
If a type is referenced in other types or master copies, the correlations are displayed in the 
library management. You will also be able to see which library elements reference a type 
or a master copy.

● Display of points of use of types in the project

● Use of filters to narrow down the displayed types
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Layout of the library management
The following figure shows the components of the library management:

① Toolbar of the library management
② "Types" area
③ "Uses" area

Toolbar of the library management
You can perform the following tasks in the toolbar of the library management:

● Update view
If the project was changed, you can update the view of the library management.

● Clean up library
You can clean up the project library and global libraries. By cleaning up a library, you delete 
all types and type versions that are not linked to an instance in the project.

● Harmonize project
By harmonizing a project, you adapt the names and the path structures of type uses in the 
project to the corresponding names and path structures of the types within a library.

"Types" area
The "Types" area displays the contents of the folder that you have selected in the library view. 
For each type, the types that it references are displayed. You can expand or collapse all type 
nodes by using the buttons in the toolbar of the "Types" area. You can also filter the view with 
the "Filter" drop-down list. 
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"Uses" area
The "Uses" area gives you an overview of the points of use of the selected types and master 
copies. The "Uses" area is divided into two tabs:

● "Uses in the project" tab
The "Uses in the project" tab is used to show the instances of type versions and their 
respective point of use in the project. When you select an instance, you can show the cross 
references of the instance in the project in the Inspector window.

● "Uses in the library" tab
The "Uses in the library" tab is used to show all points within the library at which a type or 
a master copy is used.

See also
Opening library management (Page 451)

Filtering the display of types (Page 452)

Displaying cross references of an instance (Page 453)

Displaying instances in the project (Page 452)

Displaying relations to other library objects (Page 453)

Library basics (Page 441)

Basics on master copies (Page 467)

Basics on types (Page 470)

7.10.4.2 Opening library management

Procedure
To open the library management, follow these steps:

1. Open the library view.

2. Select a type or any folder that contains types.

3. Select the "Library management" command from the shortcut menu.

Result
The library management opens and the types are displayed with their versions.

See also
Overview of the library management (Page 449)
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7.10.4.3 Filtering the display of types
Use filters to obtain a better overview of types in extensive libraries. A filter provides you with 
the option of limiting the displayed types. The following filters are available:

● Display all types that include a version with the "In test" or "In progress" status

● Display all released types

● Display all types that have no instances in the project

● Display all types that have more than one version

Requirement
The library management is open.

Procedure
To filter the displayed types, follow these steps:

1. In the "Types" area, select the folder whose contents you want to filter.

2. Select the required filter in the "Filter" drop-down list.
In the "Types" area, types are displayed that correspond to the selected filter criteria.

See also
Overview of the library management (Page 449)

State of type versions (Page 472)

Creating a test version of a type (Page 477)

Editing a test version of a type (Page 478)

Creating an editing version of a type (Page 479)

7.10.4.4 Displaying instances in the project
In the library management, you can have the instances of all versions of a type or an individual 
type version displayed. You can jump directly to each instance in the project.

Requirement
The library management is open.
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Procedure
To display the instances of a type or its versions, follow these steps:

1. Select a type or one of its versions in the "Types" area.

2. Open the "Uses in the project" tab in the "Uses" area.
The instances in the project are displayed for each type version. The "Path" column shows 
the path at which the respective instance is located in the project.

3. Optional: Click the path to jump directly to the respective instance in the project tree.
The library management is hidden and the instance is selected in the project tree.

See also
Displaying cross references of an instance (Page 453)

Using types (Page 476)

Overview of the library management (Page 449)

Displaying relations to other library objects (Page 453)

7.10.4.5 Displaying cross references of an instance
You can display the cross references of an instance without exiting the library management.

Requirement
The library management is open.

Procedure
To display the cross references of an instance in the project, follow these steps:

1. In the "Types" area, select a type version whose instances you want to display.

2. Select the instance of the required type version in the "Uses > Uses in the project" area.

3. Open the "Info > Cross-references" tab in the inspector window.
The cross reference of the instance are displayed in the project.

See also
Using cross-references (Page 498)

Overview of the library management (Page 449)

Displaying instances in the project (Page 452)

7.10.4.6 Displaying relations to other library objects
You can display relations between individual library objects in the library management. The 
references of the individual type versions to the other library objects are automatically 
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displayed in the "Types" area. In the "Uses" area, you can also view the other library objects 
in which the respective type version is referenced. 

Requirement
The library management is open.

Procedure
To display the other library objects from which a type version is referenced, follow these steps:

1. Select a folder, an individual type or an individual version in the "Types" area.

2. Open the "Uses in the library" tab in the "Uses" area.
In the "Uses" area, you can now see which other library objects are referenced by the 
individual type versions.

3. Optional: To jump to the referenced library object, click on the respective path in the "Path" 
column.

See also
Displaying instances in the project (Page 452)

Overview of the library management (Page 449)

7.10.5 Using global libraries

7.10.5.1 Creating a global library

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure
To create a new global library, follow these steps:

1. Click the "Create new global library" icon in the toolbar of the "Global libraries" palette or 
select the command "Global libraries > Create new library" in the "Options" menu.
The "Create new global library" dialog opens.

2. Specify the name and the storage location for the new global library.

3. Confirm your entries with "Create".
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Result
The new global library is generated and pasted into the "Global libraries" palette. A folder with 
the name of the global library is created in the file system at the storage location of the global 
library. This actual library file is given the file name extension ".al12". 

See also
Library basics (Page 441)

Opening a global library (Page 456)

Displaying properties of global libraries (Page 459)

Saving a global library (Page 460)

Closing a global library (Page 461)

Deleting a global library (Page 462)

7.10.5.2 Compatibility of global libraries
You can use the TIA Portal to open global libraries that were created with an older version of 
the TIA Portal. However, the product version of global libraries must correspond to the product 
version of the opened project if you want to use objects from the global library in the project. 
Consequently, you may need to upgrade the global libraries.

Opening global libraries from older product versions
The table below illustrates the behavior of the TIA Portal when global libraries from older 
product versions are opened:

Product version of the TIA 
Portal
(file extension of the 
respective global library)

Behavior when a global library is opened

V10.5 (.al10)
V11.x (.al11)

The global library is automatically upgraded to the latest library version when opened, 
following your confirmation. The upgraded global library is a copy of the original library. The 
original global library is retained unchanged.

V12 (.al12) The global library is upgraded when opened. You can choose whether you want to upgrade 
the global library to the library version V12 SP1 or V13. In both cases, the upgraded library 
is a copy of the original global library. The original global library is retained unchanged. When 
you upgrade the global library to library version V12 SP1, the library is opened in compatibility 
mode.

V12 SP1 (.al12) When you open the global library, you can decide whether you want to open it in compatibility 
mode or upgrade it to the current library version. If you upgrade the global library, a copy of 
the original global library is created. The original global library is retained unchanged.

Compatibility mode
If a project is open in compatibility mode for product version V12 SP1 of the TIA Portal, the 
global library must also be in compatibility mode. You can use objects from the global library 
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in the project opened in compatibility mode. You can also save new objects in the global library 
if the objects originate from a project in compatibility mode. A global library in compatibility 
mode can still be opened and edited with TIA Portal V12 SP1.

Backward compatibility of the current library version
Global libraries saved with the library format of the TIA Portal V13 are not backward compatible 
with older versions due to their enhanced functionality. Global libraries in TIA Portal V13 library 
format can only be used in connection with TIA Portal V13 projects.

See also
Compatibility of projects (Page 359)

Opening a global library (Page 456)

Upgrading global libraries (Page 457)

Upgrading projects (Page 361)

7.10.5.3 Opening a global library
Global libraries can be further developed centrally and used over several projects. Several 
persons can open a global library simultaneously from a central storage location, provided all 
users open the global library in write-protected mode.

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure
To open a global library, follow these steps: 

1. Click the "Open global library" icon in the toolbar of the "Global libraries" pane or select the 
command "Global libraries > Open library" in the "Options" menu.
The "Open global library" dialog box is displayed.

2. Select the global library you want to open. Library files are identified by the file name 
extension ".al[version number]". This means global libraries that were saved with TIA Portal 
V13 have the file name extension ".al13".

3. Write protection is activated for the library. If you want to modify the global library, disable 
the "Open as read-only".

4. Click "Open".
The global library is opened and pasted into the "Global libraries" pane if the library version 
matches the project version. The "Upgrade global library" dialog box opens if you have 
selected a global library from an older version of the TIA Portal. More information on 
upgrading the global library can be found in the chapter "Upgrading global libraries 
(Page 457)".

Editing projects
7.10 Using libraries

WinCC Professional V13.0
456 System Manual, 02/2014



See also
Retrieving global libraries (Page 464)

Upgrading global libraries (Page 457)

Opening projects (Page 360)

Compatibility of global libraries (Page 455)

Library basics (Page 441)

Creating a global library (Page 454)

Displaying properties of global libraries (Page 459)

Saving a global library (Page 460)

Closing a global library (Page 461)

Deleting a global library (Page 462)

7.10.5.4 Upgrading global libraries
If you want to use objects from a global library in a project, the library version must match the 
product version of the project. Global libraries must be present in the library version of the TIA 
Portal V12 SP1 if you want to edit a project in V12 SP1 compatibility mode. Global libraries 
must be present in the library version of the TIA Portal V13 if you want to edit a project of the 
product version V13.

Depending on the library version, the following options are available:

● Upgrading the global library to the product version V13
You can upgrade each global library from an older product version to the current product 
version. You are prompted accordingly when you open the global library. You can manually 
upgrade global libraries projects that are already open in compatibility mode to product 
version V13.

● Upgrading the global library to the product version V12 SP1 (compatibility mode)
If you open a global library from version V12 of the TIA Portal, you also have the option of 
upgrading the global library to the library version V12 SP1. In this case, however, the global 
library can only be used in connection with projects from the TIA Portal V12 SP1.

Upgrading global libraries from V11.x or lower
Proceed as follows to upgrade a global library from TIA Portal V11.x or lower:

1. Open the global library.
The "Upgrade global library" dialog box opens.

2. Click "OK".
A copy of the global library is created and upgraded. The copy of the global library receives 
the name extension "_V13". The global library is opened.
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Upgrading global libraries from V12
Proceed as follows to upgrade a global library from TIA Portal V12:

1. Open the global library.
The "Upgrade global library" dialog box opens.

2. Select the target version for the upgrade:

– Click "Yes" to upgrade the global library to product version V13.

– Click "No" to upgrade the global library to product version V12 SP1 and to work in 
compatibility mode.

A copy of the global library is created and upgraded. The copy of the global library receives 
the name extension "_V13" or "_V12SP1". The global library is opened.

Upgrading V12 SP1 libraries or using them in compatibility mode
Proceed as follows to upgrade a global library from TIA Portal V12 SP1 or to use it in 
compatibility mode:

1. Open the global library.
The "Upgrade global library" dialog box opens.

2. Select how you want to proceed with the global library:

– Click "Yes" to upgrade the global library to product version V13.

– Click "No" to use the global library in compatibility mode.

A copy of the global library is created and upgraded or the library is opened changed. The 
copy of the global library receives the name extension "_V13".

Manually upgrading libraries in compatibility mode to V13
To do this, a global library must already be open in compatibility mode for the TIA Portal V12 
SP1.

Proceed as follows to manually upgrade global libraries to the library version V13:

1. Right-click on the global library you want to upgrade.

2. Select the "Upgrade library" command in the shortcut menu.
The "Upgrade" dialog opens.

3. Confirm with "Yes".
A copy of the global library is created and upgraded. The copy of the global library receives 
the name extension "_V13". The upgraded global library is opened. The original global 
library is closed.

See also
Opening a global library (Page 456)

Compatibility of global libraries (Page 455)

Upgrading projects (Page 361)
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7.10.5.5 Displaying properties of global libraries
Global libraries contain properties for describing the respective library in more detail. Properties 
include the following:

● General information about the library
This includes the following information: creation time, author, file path, file size, copyright, 
etc. Many of the attributes can be changed.

● Library history
The library history contains an overview of the migrations performed. Here you can also 
call the log file for the migrations. The library history also contains information on updates 
of the global library.

● Support packages in the library
You can display an overview of the additional software needed to work with all devices in 
the project.

● Software products in the library
You can display an overview of all installed software products needed for the project.

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure
To display the properties of a global library, follow these steps:

1. Right-click the global library whose properties you want to display.

2. Select the "Properties" command in the shortcut menu.
A dialog containing the properties of the global libraries opens.

3. Select the properties in the area navigation that you want to have displayed.

 

See also
Opening a global library (Page 456)

Library basics (Page 441)

Creating a global library (Page 454)

Saving a global library (Page 460)

Closing a global library (Page 461)

Deleting a global library (Page 462)

7.10.5.6 Displaying logs of global libraries
Logs are created when you update or clean up global libraries or assign a shared version to 
several types. The logs list all changes you have made to the global library. The logs are stored 
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together with the global library and are always available once you have opened the global 
library.

Procedure
To open the logs of a global library, follow these steps:

1. Open the global library in the "Libraries" task card or in the library view.

2. Open "Common data > Logs" in the lower-level folder.

3. Double-click the required log.
The log opens in the work area.

See also
Updating a library with the contents of another library (Page 493)

7.10.5.7 Saving a global library
After you have changed a global library, you need to save it. You can save a global library 
under another name using the "Save library as" command.

 

 Note
Backward compatibility to older versions of the TIA Portal

Note that global libraries can no longer be opened in older versions of the TIA Portal once 
they have been saved in the newer version.

 

Requirement
The "Libraries" task card is displayed or the library view is open.

Saving changes
To save a global library, follow these steps:

1. Right-click on the global library you want to save.

2. Select the "Save library" command in the shortcut menu.

Saving a global library under another name
To save a global library under another name, follow these steps:

1. Right-click the global library that you want to save under a different name.

2. Select the "Save library as" command in the shortcut menu.
The "Save global library as" dialog opens.
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3. Select the storage location and enter the file name.

4. Confirm your entries with "Save".
The library is saved in the specified location under the new name. The original library is 
retained. 

See also
Working with archives of global libraries (Page 462)

Archiving global libraries (Page 463)

Library basics (Page 441)

Creating a global library (Page 454)

Opening a global library (Page 456)

Displaying properties of global libraries (Page 459)

Closing a global library (Page 461)

Deleting a global library (Page 462)

7.10.5.8 Closing a global library
Global libraries are independent of projects. This means that global libraries are not closed 
together with your project. You must therefore close global libraries explicitly. 

Requirement 
The "Libraries" task card is displayed or the library view is open.

Procedure
To close a global library, follow these steps:

1. Right-click on the global library you want to close.

2. Select the "Close library" command in the shortcut menu.
If you have made changes to the global library, select whether or not you want to save the 
changes.
The global library is closed.

See also
Creating a global library (Page 454)

Opening a global library (Page 456)

Displaying properties of global libraries (Page 459)

Saving a global library (Page 460)

Library basics (Page 441)

Deleting a global library (Page 462)
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7.10.5.9 Deleting a global library
If you no longer require a global library, you can delete it. Libraries supplied by Siemens cannot 
be deleted.

Requirement
The "Libraries" task card is displayed or the library view is open.

Procedure 
To delete a global library, follow these steps:

1. Right-click the global library you want to delete.

2. Select the "Delete" command in the shortcut menu.

3. Click "Yes" to confirm.

Result
The global library is removed from the "Global libraries" palette. The entire library for the global 
library is deleted from the file system. 

See also
Library basics (Page 441)

Creating a global library (Page 454)

Opening a global library (Page 456)

Displaying properties of global libraries (Page 459)

Saving a global library (Page 460)

Closing a global library (Page 461)

7.10.5.10 Archiving and disabling global libraries

Working with archives of global libraries
If you want to back up global libraries on an external hard drive or send them via e-mail, for 
example, use the archiving function to reduce the storage space of the library.
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Options for reducing the size of the project
There are two ways to reduce the storage space of global libraries:

● Creating a compressed archive of global libraries
Archives of global libraries are compressed files, each containing an entire global library, 
including the entire folder structure of the library. Before the directory with the global library 
is compressed into the archive file, all files are reduced to their essential components to 
further decrease the storage space. Compressed archives of global libraries are therefore 
well suited for sending via e-mail.
Compressed archives of global libraries of TIA Portal V13 have the file extension ".zal13". 
Archives from TIA Portal V12.x have the file extension ".zal12".
To open a compressed archive of a global library, retrieve the archive. The archive file is 
extracted to a location you have selected with the entire folder structure and all files.

● Minimizing global libraries
You can skip additional compression in an archive file, and instead create a copy of the 
global library directory. The included files can be reduced to the essential elements. This 
minimizes the required storage space. The full functionality of the global library is retained 
and the global library can be loaded as usual.
Minimized global libraries are especially well suited for archiving, for example, on an 
external medium.

See also
Archiving global libraries (Page 463)

Retrieving global libraries (Page 464)

Archiving global libraries
You reduce the storage space of a global library by packing it into a compressed file. You can 
also reduce the storage space by saving the global library reduced to the essential elements. 
You can do both of these with the archiving function for global libraries. When you archive a 
library, the original library version is retained. This means libraries in compatibility mode for 
TIA Portal V12 SP1 are still compatible with TIA Portal V12 SP1.

Requirement
The global library is loaded.

Procedure 
To archive a global library, follow these steps:

1. Select the global library that you want to archive.

2. Right-click the global library and select the "Archive" command from the shortcut menu.
The "Archive global library as..." dialog opens.

3. Select the directory where you want to save the archive file or the new directory of the global 
library.
The directory may not be located in a project directory or within the directory of a global 
library.
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4. Select the file type from the "File type" drop-down list:

– Global libraries archive, if you want to create a compressed file of the library.

– Minimized global library, if you only want to create a copy of the library directory with 
minimal storage requirement.

5. Enter a file name in the "File name" field if you are creating an archive file. If you are creating 
a minimized global library, enter the name of the new library directory to be created in the 
"File name" box.

6. Click "Save".

Result
A compressed file with the extension ".zal13" or ".zal12" is generated. The file extension 
depends on whether you have archived a library in V12 SP1 compatibility mode or in the library 
format of TIA Portal V13

The file includes the complete directory of the global library. The individual files of the global 
library are also reduced to the essential components in order to save space.

If you have minimized the global library, only a copy of the original directory of the global library 
is created at the required location. The files contained within it were reduced to their essential 
components in order to save space.

See also
Working with archives of global libraries (Page 462)

Retrieving global libraries (Page 464)

Retrieving global libraries
Before you can use an archived global library, you have to retrieve it. The global library is 
extracted and then opened in the TIA Portal.

Procedure
To extract the archive of a global library, follow these steps:

1. Select the "Global libraries > Retrieve library" command in the "Options" menu.
The "Retrieve archived global library" dialog opens.

2. Select the archive file.

3. Select the check box "Open read-only" if you want to load the global library write-protected.

4. Click "Open".

5. The "Find folder" dialog opens.

6. Select the target directory to which the archived global library should be extracted.

7. Click "OK".
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Result
The global library is extracted to the selected directory and opened immediately.

If the archive file contained a global library from TIA Portal V12 SP1, the global library is opened 
in compatibility mode. Manually upgrade the library to the library version of TIA Portal V13, if 
necessary.

See also
Working with archives of global libraries (Page 462)

Archiving global libraries (Page 463)

Opening a global library (Page 456)

Compatibility of global libraries (Page 455)

Upgrading global libraries (Page 457)

7.10.5.11 Using global corporate libraries

Basics of corporate libraries

Introduction
Corporate libraries are global libraries made available by an administrator and assigned to the 
TIA Portal. The administrator can assign new libraries or change libraries at any time. New 
libraries are automatically uploaded in the TIA Portal following your confirmation. As soon as 
more recent versions of corporate libraries are available, the existing corporate libraries are 
automatically updated to the more recent version, also following your confirmation.

The corporate libraries are located just like normal global libraries in the "Global libraries" 
palette of the "Libraries" task card.

Providing corporate libraries
Corporate libraries can be saved in any directory on the hard drive of the computer or on a 
network drive. Use an XML file to assign corporate libraries to the TIA Portal. The XML file 
includes the directories and names of the assigned corporate libraries. The XML file must be 
saved in the following directory on the hard drive of the computer:

C:\ProgramData\Siemens\Automation\Portal V13\CorporateSettings\
The XML file must be named "CorporateSettings.xml".

You either copy the configuration file yourself to the corresponding directory or the 
configuration file is assigned to you through the company network. The valid configuration is 
automatically applied when the TIA Portal is started. When the TIA Portal is started, it 
continuously monitors the directory for configuration files. If the configuration file has changed, 
you receive a prompt to apply the new configuration. You can reject this prompt twice. You will 
always receive the next prompt three hours later. You must apply the new configuration at the 
third prompt. You receive a changed configuration file from the project administrator, for 
example, if corporate libraries have been added or deleted.
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Options as project administrator
You can automatically assign the configuration file or the corporate libraries to the computers 
of the team members or distribute updates to the team members. This function is not part of 
the TIA Portal and requires a corresponding IT infrastructure in your company.  If you want to 
administer the configuration file centrally, discuss this approach with the IT managers at your 
company.

Creating a configuration file
Use a configuration file in XML format to make the corporate libraries available in the TIA 
Portal. The configuration file includes the directories and file names of the libraries to be loaded. 
Below you will learn how you create the XML configuration file and where to save it.

Procedure
To provide a configuration file for corporate libraries, follow these steps:

1. Create an XML configuration file with the content listed below. Use the coding "UTF-8".

2. Save the XML file under the name "CorporateSettings.xml".

3. Save the file in the following directory on your computer:
C:\ProgramData\Siemens\Automation\Portal V13\CorporateSettings\

Content of the XML configuration file
The XML configuration file must have the following content:

XML
<?xml version="1.0" encoding="utf-8"?>
<Document>
 <Settings.Settings ID="0">
  <ObjectList>
   <Settings.General ID="1" AggregationName="General">
    <AttributeList>
     <CorporateLibraryPaths>
     <!-- Example of an entry -->
     <Item>D:\CorporateLibraries\Corporate_Library_1.al13</Item>
     <!-- Here you enter additional global libraries, if any. -->
     </CorporateLibraryPaths>
    </AttributeList>
   </Settings.General>
  </ObjectList>
 </Settings.Settings>
</Document>

Result
As soon as you have saved the XML configuration file in the respective directory, you will 
receive the prompt (in the TIA portal) to download the corporate libraries in the TIA Portal.
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7.10.6 Creating folders in a library
The library elements are stored in the libraries according to their type in the "Types" and 
"Master copies" folders. Create additional folders below "Types" and "Master copies" to further 
organize master copies and types.

Requirements 
● The "Libraries" task card is displayed or the library view is open.

● If you want to create new folders within a global library, you have to open the global library 
with write permission.

Procedure
To create a new folder, follow these steps:

1. Right-click any folder within the library.

2.  Select "Add folder" from the shortcut menu.
A new folder is created.

3. Enter a name for the new folder. 

See also
Working with types in the project library (Page 475)

Filtering master copies (Page 469)

7.10.7 Using master copies

7.10.7.1 Basics on master copies

Master copies are used to create standardized copies of frequently used elements. You can 
create as many elements as needed and insert them into the project based on a master copy. 
The elements inherit the properties of the master copy.

You store master copies either in the project library or in a global library. Master copies in the 
project library can only be used within the project. When you create the master copy in a global 
library, it can be used in different projects.

The following elements can be created as master copies in the library, for example:

● Devices with their device configuration

● Tag tables

● Instruction profiles

● Monitoring tables

● Elements from the documentation settings, for example, cover sheets and frames

Editing projects
7.10 Using libraries

WinCC Professional V13.0
System Manual, 02/2014 467



● Blocks and groups containing multiple blocks

● PLC data types and groups containing multiple PLC data types

● Text lists

● Alarm classes

● Technology objects

In many cases, the objects you add as master copy contain additional elements. A CPU, for 
example, can contain blocks. If the included elements are uses of a type version, the used 
versions of the types are automatically created in the library. The elements contained therein 
are then used as an instance and linked to the type.

See also
Adding master copies (Page 468)

Using master copies (Page 470)

Basics on types (Page 470)

Filtering master copies (Page 469)

7.10.7.2 Adding master copies
If you want to use objects multiple times, copy them as master copies in the project library or 
in a global library. You can choose from the following methods for creating master copies:

● You can select one or more elements and generate a master copy from it

● You can select multiple elements and generate a master copy from each element

Requirement
● The "Libraries" task card is displayed.

● If you add a device as a master copy, this device meets the following requirements:

– The device is compiled and consistent.

– The device contains no test instance of a type.

● If you add the master copy to a global library, the global library is opened with write 
permission.

Creating a master copy from one or more elements 
To create a master copy for one or more elements, follow these steps:

1. Open the library in the "Libraries" task card.

2. Drag one or more elements and drop them into the "Master copies" folder or any subfolder 
of "Master copies".
Alternative: Copy the elements to the clipboard and paste them at the required location.
The element is pasted into the library as a single master copy.
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Creating a master copy for each element among multiple elements
To create a master copy for each element among multiple elements, follow these steps:

1. Open the library in the "Libraries" task card.

2. Copy to the clipboard the elements that you want to create as master copies.

3. Right-click on the "Master copies" folder or any of its subfolders in the library.

4. In the shortcut menu, select "Paste as separate master copies".
The elements are pasted into the library as separate master copies. In each case, a 
separate type is created automatically for any objects contained.

See also
Basics on master copies (Page 467)

Using master copies (Page 470)

Library basics (Page 441)

Adding types to the project library (Page 475)

7.10.7.3 Filtering master copies
To make it easier to keep track of a large number of master copies, you can filter the display 
according to the type of master copy.

Requirement   
The "Libraries" task card is displayed or the library view is open.

Procedure
To filter the view, follow these steps:

1. Open the "Master copies" folder in the project library or a global library.

2. In the drop-down list of the toolbar, select the type of objects you want to display under 
"Master copies".

Result
Only the selected type of master copies is displayed. You can set the filter to "All" to return to 
an unfiltered view.

See also
Library basics (Page 441)

Creating folders in a library (Page 467)

Basics on master copies (Page 467)
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Using master copies (Page 470)

Using the element view (Page 445)

7.10.7.4 Using master copies
Master copies are contained either in the project library or in a global library.

Requirement
The "Libraries" task card is displayed.

Procedure
To paste a master copy into the project, follow these steps:

1. Open the "Master copies" folder or any subfolder of "Master copies" in a library.

2. Drag-and-drop one or more master copies to the desired point of use.
A copy of the master copy is inserted.

Or:

1. Open the element view.

2. Drag the master copy from the "Elements" palette and drop it at the location where you 
want to use it.
A copy of the master copy is inserted.

See also
Basics on master copies (Page 467)

Adding master copies (Page 468)

Filtering master copies (Page 469)

Library basics (Page 441)

Using the element view (Page 445)

7.10.8 Using types and their versions

7.10.8.1 Basics on types

Using types
Types are elements that are required for the execution of user programs. Types can be 
versioned and further developed from a central location.

The following elements can be stored as type in the project library or the global library:
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● Functions (FCs)

● Function blocks (FBs)

● PLC data types

● User data types

● Faceplates

● Figures

● User-defined functions

Any number of instances can be derived from the versions of types in the project. The instances 
are then linked to the version of the type. If you are using types from a global library, the type 
is also created in the project library. If the type already exists in the project library, any missing 
type versions are added if necessary. The instance is then linked only to the respective type 
version in the project library.

Types and their instances are marked with a black triangle. The following figure shows an 
instance, marked with a black triangle, and an ordinary program block:

Basics on versioning types
Type versioning provides you with the means to develop types centrally and then roll out the 
most recent version to the individual projects as an update. In this way, error corrections and 
added functions can be easily integrated into existing projects. If you have created a new 
version of a global library, you can update existing projects in an automatic process. This 
minimizes errors and reduces the amount of maintenance work for large automation solutions 
that contain numerous individual projects.

Versioning allows you to trace the development process of individual types. Before you release 
a version, you can try it out in a test environment to determine whether changes made to a 
type integrate smoothly into an existing project. You only release a version for productive use 
after you have made sure that everything operates without errors. You can view the history of 
individual instances in the project at any time and determine the version from which the 
instance was derived.

The TIA Portal also checks automatically if there are associated objects with individual versions 
of a type.  Associated objects can be, for example, PLC data types or other blocks referenced 
in a block. All associated objects are already taken into consideration during the creation of a 
type or during copying between libraries. Before being released, versions of types are checked 
for their consistency to ensure that no inconsistencies arise in the project.

Versions of types
Versions are assigned to each type. The version number is displayed in both the "Libraries" 
task card as well as the library view next to the respective type. The version number is also 
displayed in the project tree next to instances of types. This allows you to see at all times which 
version of an instance is used in the project.
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The version number consists of three numbers separated by periods. You can randomly assign 
the first two digits. Numbers from 1 to 999 are permitted as the first two numbers. The third 
digit is the build number. It is automatically incremented by one when you edit an instance 
related to the version. The build number is reset to 1 when you release the version.

The versions of types can have three states:

● In progress (faceplates and HMI user data types)

● In test (all sorts of types except faceplates and HMI user data types)

● Released

The following figure shows a type with two versions. One version is "in test" and one version 
is released:

See also
State of type versions (Page 472)

Basics on master copies (Page 467)

Adding types to the project library (Page 475)

Using types (Page 476)

7.10.8.2 State of type versions
The versions of types can be in three different states. The states can be determined from the 
instance or in the library.

"In progress" status
Only versions of faceplates and HMI user data types have the "in progress" state. If a version 
is in progress, "in progress" appears next to the version in the library.

When you create a new type or a new version of a released type, the type is assigned the 
status "in progress".

Types with the status "in progress" can be edited in the library view. A reference to an instance 
in the project does not have to exist. Upon release, the compatibility of the type is tested by a 
consistency check.

"In test" status
All types except for faceplates and HMI user data types can have the "in test" status. If a version 
is in test, "in test" appears next to the instance and in the library. A version in the test state is 
linked to a test instance in the project. This allows you try out the effects of your changes in a 
test environment including all online functions before you release a type for use in actual 
operations.
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"Released" status
The "released" status is available for all types, regardless of the point of use. If a version has 
been released, the symbol of the version is marked with a seal in the library:

Released versions can be opened with write protection in their instance. If you want to edit a 
released version, you must first create a new "in progress" or "in test" version.

See also
Basics on types (Page 470)

Using types (Page 476)

Creating a test version of a type (Page 477)

Editing a test version of a type (Page 478)

Creating an editing version of a type (Page 479)

Performing a consistency check for a version (Page 479)

Discarding versions (Page 480)

Release versions (Page 481)

Assigning a version (Page 489)

Updating the project to the latest versions (Page 484)

Remove the link between instance and type (Page 485)

Filtering the display of types (Page 452)

7.10.8.3 Displaying a released type version
If you display a released version but do not want to edit it, open the instance with write 
protection. All types except faceplates and HMI user data types can be opened directly at the 
instance. Faceplates and HMI user data types can only be opened in the "Libraries" task card 
or in the library view.

Requirement
The released version has an instance in the project; except with types, this is a faceplate or 
an HMI user data type.
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Opening a type version at an instance
To open a released version of a type with write protection starting from an instance, follow 
these steps:

1. Select the released version at the instance in the project tree.

2. To do this, right-click the instance and select the "Open" command from the shortcut menu.
The instance is opened with write protection.

Opening a type version in the "Libraries" task card or library view
To open a released version of a type in the "Libraries" task card or in the library view, follow 
these steps:

1. Select the version.

2. To do this, right-click the version and select the "Open" command from the shortcut menu.
If it is a faceplate or HMI user data type, it is opened directly in the library view. In this case, 
skip the remaining steps. If it is any other type, the "Open type" dialog opens.

3. Select the instance with the version that you want to display from the list of instances.

4. Click "OK" to confirm.
The instance is opened with write protection.

7.10.8.4 Displaying properties of a type or version
The following properties can be viewed and changed in the properties of a type or its versions, 
if needed:

● Name of the type

● Version number (only visible in the case of a version)

● Data and time of the last change to the version (only visible in the case of a version)

● Author who created the version (only visible if there is a version)

● Comments on the type or the version of the type
The comment on the type can be changed.

● Original library (only visible in the case of a version)
Displayed is the project and the library from which the current version of the type was 
generated. This information is important, for example, for finding the original of the type 
after it has been copied from another library.

● ID of the type or the version of the type
This ID is used to uniquely identify the type or the version of the type, even if, for example, 
there are types or versions with an identical name within the project library or the global 
library. The ID cannot be changed and is assigned automatically.
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Procedure
To display the properties of a type or a version and to enter a comment, follow these steps:

1. Select a type or the version of a type in the "Libraries" task card or in the library view.

2. To do this, right-click on the type or one of its versions and select the "Properties" command 
from the shortcut menu.
The "Properties" dialog box opens.

3. If needed, enter a comment on the type in the "Comment" field or edit an existing comment.

7.10.8.5 Working with types in the project library

Adding types to the project library
Types for reuse in the project can be created in the project library for various elements. You 
can create the following elements as types, for example:

● Program blocks

● Faceplates

● PLC data types

● HMI user data type

If you add an element as a type to the project library and this element has dependencies to 
other elements, the dependent elements are automatically created as a type as well.

After a type has been added to the project library, the type is linked to the added element from 
the project.

Requirement
● The "Libraries" task card is displayed.

● The elements that you want to add as type are compiled.

● The elements are consistent.

Procedure
To add an existing element to the project library as a type, follow these steps:

1. Open the project library in the "Libraries" task card.

2. Drag-and-drop one or more elements into the "Types" folder or any subfolder of "Types".
Alternative: Copy the elements in the project tree to the clipboard and add the elements in 
the desired project library folder.
The "Generate type" dialog opens.
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3. Enter the properties of the new type:

– Enter a name for the new type in the "Name of the type" field.

– Enter a version number for the new type in the "Version" field.

– Enter the name of the editor who is responsible for the type in the "Author" field.

– Enter a comment on the type in the "Comment" field.

4. Click "OK" to confirm.
The new type is generated with a released version. The version is linked to the element 
that has been added.

See also
Basics on types (Page 470)

Library basics (Page 441)

Adding master copies (Page 468)

Using types
To use the version of a type, create an instance of the version at a suitable location in the 
project tree. You can also position faceplates and HMI user data types directly in the editor. 
The instance is then linked to the version of the respective type. If the type contains dependent 
elements such as a PLC data types referenced in a block, these are also created as instance 
at a suitable location. You can only assign a version of the same type to a device.

If necessary, you can create instances of several types at the same time.

Requirement
● The "Libraries" task card is displayed.

● The desired versions have been released.

● A device which supports the sort of desired type is already available in the project

● The device is not yet assigned any further instance of the same type.

Procedure
To create instances of type versions, follow these steps:

1. In the project library, navigate to the versions of the types that you want to use.

2. Select the versions of which you want to create instances.

3. Drag the required type versions from the project library and drop them at the location where 
you want to use them.
Alternative: To automatically use the most recent version, drag the types from the project 
library and drop them at the location where you want to use them.
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Result
Instances of the types and their dependent elements are generated and pasted at the location 
where you want to use them. The instances are connected to the respective version of the 
type in the project library.

See also
Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Using master copies (Page 470)

Creating a test version of a type
Before you release a type for productive use, you need to test the type within a project and on 
the automation system. The test is conducted in a specific test environment. This test 
environment can be a CPU, for example.

Create a version with "in testing" status for the test. The creation of a version "in testing" is 
suitable for all sorts of types except for faceplates and HMI user data types. On the other hand, 
versions "in progress" can be created from faceplates and HMI user data types.

There are two ways to create a test version of a type and define the test environment:

● In the "Libraries" task card or library view
Generate the new version with "in testing" status in the "Libraries" task card or in the library 
view. You can generate the new version either directly from the type or from a specific 
version of the type.

● At an instance in the project tree
You can also create the test version directly at the instance in the project tree. Since the 
instance is always used in a specific version in the project, a new version of the type is 
generated from the version used at the instance.

You can also create test versions from several types at the same time.

The following rules apply to a version "in testing":

● You can set only one version to "in testing" for each type at a given time.

● A version in testing may only be linked to a single instance in the project. Therefore, it is 
not possible to copy an instance to the clipboard, to duplicate it or to create an additional 
type from the instance as long as it has "in testing" status.

Requirement
● There is at least one instance of the type within the project in a given version. 

● If you want to create the new version from a particular version of the type, the instance 
must be used in this version in the project.
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Procedure
To generate a new test version of a type or the version of a type, follow these steps:

1. Select the type, a version of the type, or the instance. 
When you create the test version directly at the instance, you can select several elements 
or folders with multiple selection. You can skip steps 3 and 4 because the test environment 
is already defined by the selected instance.

2. Right-click the selected element and select the "Edit type" command from the shortcut 
menu.
If you have started the editing in the "Libraries" task card or in the library view, the "Edit 
type" dialog opens. If you have started the editing at the instance in the project tree, the 
test instance is immediately opened for editing in the library view.

3. Select an instance of the type from the list in the project.
If you have started editing at the type itself, the following applies:

– The location at which the instance is used (for example, the CPU) is also used as test 
environment for the subsequent editing of the type. 

– Selecting the test instance also defines the version to be edited.

The following applies to editing a specific version:
If your starting point is a specific version, you can only select from the list instances that 
are used in the same version.

4. Click "OK" to confirm.

Result
A new version of the type is created. The new version is "in testing" and is identified as such 
in the user interface.

See also
Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Editing a test version of a type
When you edit a version "in testing", a new version is not created. You can start the editing of 
the test version at the instance in the project tree, in the "Libraries" task card" or in the library 
view.

 
 

 Note
Deleting and renaming interface parameters

You can add new parameters. However, if you rename or delete existing parameters, these 
parameters will not be supplied when the block is called.

 

Editing projects
7.10 Using libraries

WinCC Professional V13.0
478 System Manual, 02/2014



Procedure
To edit the test version of a type, follow these steps:

1. Right-click the test version or the instance.

2. Select the "Edit type" command from the shortcut menu.
The test instance is opened in the library view and can be edited.

See also
Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Performing a consistency check for a version (Page 479)

Discarding versions (Page 480)

Release versions (Page 481)

Creating an editing version of a type
If you want to edit a type with faceplates or HMI user data types, create a new "in progress" 
version of the type. The new version is edited in the library view. To check the compatibility of 
the changes, a consistency check is automatically performed for the type prior to the release.

Requirement
The project library is opened in the "Libraries" task card or in the library view.

Procedure
To create a new version of a type in progress, follow these steps:

1. Right-click the type or the version of the type.

2. Select the "Edit type" command from the shortcut menu.
A new "in progress" version is created and opened for editing in the library view.

See also
Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Performing a consistency check for a version
A type version can unintentionally obtain an inconsistent state during editing. To notice errors 
in the development process in good time, you can regularly perform a consistency check. 
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However, the consistency check always takes place automatically as soon as you release a 
version.

Details of how to start the consistency check manually for the version of a type are provided 
below.

Requirement
● The project library is opened in the "Libraries" task card or in the library view.

● The version is "in progress" or "in test".

Procedure
To perform a consistency check for the version of a type, follow these steps:

1. Right-click on the version that you want to check for consistency.

2. Select the "Consistency check" command in the shortcut menu.
The consistency check is carried out. You receive a message with the result of the 
consistency check.

See also
Release versions (Page 481)

Discarding versions (Page 480)

Editing a test version of a type (Page 478)

Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Discarding versions
Discard versions of a type "in test" or "in progress" when you no longer need the version. You 
can also select several types or folders and discard all test or editing versions contained 
therein. All uses of the deleted versions are reset to the last released status.

Requirement
● The versions that you want to discard are in the "In test" or "In progress" status.

● Your are in the library view of the "Libraries" task card is open.
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Procedure
To discard one version, follow these steps:

1. Right-click the version that you want to discard.

2. Select the "Discard changes and delete version" command from the shortcut menu.
The version is deleted.

Alternative:

1. Click the "Discard changes and delete version" button in the toolbar while a version is 
opened for editing.
The version is deleted.

See also
Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Performing a consistency check for a version (Page 479)

Discarding all versions within a folder
You can discard all versions with the "In test" or "In progress" status at the same time within 
a folder. All uses of the deleted version are reset to the last released status.

Requirement
Your are in the library view of the "Libraries" task card is open.

Discarding a version of a single type
To discard all versions within a folder, follow these steps:

1. Right-click the folder.

2. Select the "Discard all" command from the shortcut menu.
All "In test" or "In progress" versions are deleted.

Release versions
When you are finished editing a type version, release the version for productive use. Assign 
a version number for the release. You can also select to release several type versions at the 
same time.
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Requirement
● The "Libraries" task card is open or you are in the library view.

● The versions that you want to release are "in test" or "in progress" status.

● The versions are consistent.
A consistency check is performed as soon as you start the release. If errors that prevent a 
release occur during the consistency check, a message is displayed indicating how you 
can correct the errors.

Procedure
To release type versions, follow these steps:

1. Select the versions you want to release.

2. Right-click your selection.

3. Select the "Release version" command from the shortcut menu.
The "Release type version" dialog box opens.

4. If necessary, change the properties of the version:

– Enter a name for the type in the "Name" field. If you have selected several versions for 
release, the "Name" field cannot be changed.

– In the "Version" field, define a main and an intermediate version number for the version 
to be released. If you have selected several versions for release, the "Version" field 
cannot be changed and the last version number is used for the release.

– In the "Author" field, enter the editor of the version to be released.

– In the "Comment" field, enter a comment on the version to be released.

5. Optional: Select the "Delete all unused type versions from the library" check box to delete 
all versions from the library that are not connected to any instance in the project. Versions 
with dependencies on other types or master copies are not deleted.

6. Click "OK" to confirm.

Alternative:

1. Click the "Release version" icon in the toolbar while a version is opened for editing.

2. Continue with steps 3 to 5 of the description above.

Result
The selected versions are released.

The properties are applied for the types themselves, the versions to be released, and for all 
future versions. Versions already released remain unaffected by the changes.

If needed, all instances with the same original version are updated to the most recent version 
and the unused versions of the type are deleted.
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See also
Releasing all versions within a folder (Page 483)

Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Performing a consistency check for a version (Page 479)

Assigning a version (Page 489)

Adding types to a global library (Page 486)

Updating the project to the latest versions (Page 484)

Releasing all versions within a folder
When you are finished editing all types within a folder, release all versions simultaneously.

Requirement
● Your are in the "Libraries" task card or in the library view.

● The folder includes versions "in test" or "in progress" status.

● All versions "in test" or "in progress" are consistent.
A consistency check is performed as soon as you start the release. If errors that prevent 
release occur during the consistency check, a message is displayed indicating how to 
correct the errors.

Procedure
To release all type versions within a folder, follow these steps:

1. Right-click the required folder.

2. Select the "Release all" command from the shortcut menu.
The "Release type version" dialog box opens.

3. If necessary, change the properties of the version:

– In the "Author" field, enter the editor of the versions to be released.

– In the "Comment" field, enter a comment on the versions to be released.

4. Select the "Delete all unused type versions from the library" check box to delete all versions 
from the library that are not connected to any instance in the project. Versions with 
dependencies on other types or master copies are not deleted.

5. Click "OK" to confirm.

Result
All type versions "in test" or "in progress" status within the selected folder are released.
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The properties are applied for the versions to be released and for all future versions. Versions 
already released remain unaffected by the changes.

Versions of types not used in the project may be deleted.

See also
Release versions (Page 481)

Updating the project to the latest versions
After you have updated several types in the project library, update all instances in the project 
to the most recent version of the types from the project library. If you do not want to apply the 
changes to the entire project, restrict the update to individual devices in the project.

Each of the following elements can be selected as source for the update:

● The entire project library

● Individual folders within the project library

● Individual types
You can select multiple types.

Requirement
Your are in the "Libraries" task card or in the library view.

Procedure
To update instances in a project with the contents from the project library, follow these steps:

1. Select the entire project library or elements from it.

2. Right-click the required elements and select the "Update > Project" command from the 
shortcut menu.
The "Update project" dialog box opens.

3. Select either the entire project or individual devices for the update.

4. Select the options for the update process:

– The "Update all instances of the affected types" check box is always selected during 
this process.

– Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

5. Click "OK" to confirm.
The update is performed.
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Result
The following changes were made to the project:

● All older versions were deleted from the project library as needed.

● All instances within the selected devices were updated to the most recent version of the 
linked types.

● You can find a log of the update process in the projection tree under "Common data".

See also
Updating the project to the latest type versions (Page 488)

Using logs (Page 357)

Updating a library with the contents of another library (Page 493)

Basics on types (Page 470)

Library basics (Page 441)

State of type versions (Page 472)

Remove the link between instance and type
Instances of types are always connected to the version of the corresponding types. They 
cannot be edited like an ordinary object. If you edit the instance, a new version of the type is 
created automatically in the library and the changes therefore affect the entire project.

If you remove the link between the instance and its type, you then edit the object like an ordinary 
object in the project tree.

Requirement
The instance may not be "in test".

Procedure
To remove the link between instances and their type versions, follow these steps:

1. Select one or more instances in the project tree.

2. Right-click the selection and select the "Terminate connection to type" command from the 
shortcut menu.

3. The link to the corresponding type versions is removed.

See also
Basics on types (Page 470)

Library basics (Page 441)

State of type versions (Page 472)
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7.10.8.6 Working with types in global libraries

Adding types to a global library
Global libraries are used as a central resource when working on multiple projects. Among the 
types, only the types in the project library can be edited directly. Therefore, use the project 
library if you want to work on types. When you are finished editing a type in the project library, 
you can add the type to a global library. Adding types from the project library corresponds to 
a normal copy process from the project library. 

Requirement
● The "Libraries" task card is displayed or the library view is open.

● The global library to which you want to add types is opened and can be written to.

Procedure
To add types to a global library, follow these steps:

1. Open the required folder in the global library in the "Libraries" task card or in the library 
view.

2. Drag one or more types from the project library to the "Types" folder or any subfolder of the 
global library.

Alternative:

1. Copy the required types from the project library to the clipboard.

2. Open the required global library in the "Global library" palette of the "Libraries" task card.

3. Right-click the "Types" folder or any of its subfolders.

4. Select the "Paste" command in the shortcut menu.

Result
The types are inserted in the global library. Dependent types, such as types of HMI user data 
types or tags, are also copied to the global library, provided they do not already exist there. 
This ensures that all necessary elements for generating an instance are present in the global 
library.

If a type already exists in the global library, the described action corresponds to an update of 
the global library. In this case, the most recent released versions of the types are added to the 
global library.

See also
Basics on types (Page 470)

Release versions (Page 481)

Assigning a version (Page 489)
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Updating the project to the latest type versions (Page 488)

Library basics (Page 441)

Using types
To use the version of a type from the global library, create an instance of the version at a 
suitable location in the project tree. You can also position faceplates and HMI user data types 
directly in the editor.

In the project, instances of types from a global library are not linked to the type in the global 
library. Instead, a copy of the type and its dependent elements is generated in the project 
library when an instance is pasted into the project. Dependent elements, for example, can be 
PLC data types that are referenced in a block. In each case, the copy of the type and the 
dependent elements in the project library contain the version that you link to the instance. If 
the type or a dependent element already exists in the project library, only the missing version 
is added when necessary to the type in the project library. 

The instance is linked to the type in the project library. You can only assign a type to a device 
once irrespective of the version.

Requirement
● The "Libraries" task card is displayed.

● A device which supports the sort of desired type is available in the project.

● The device is not assigned to any further instances of the same type.

Procedure
To generate and use an instance from a type, follow these steps:

1. In the global library, navigate to the version of the type that you want to use.

2. Drag the required version of the type and drop it at the location where you want to use it.
Alternative: To automatically use the most recent version, drag the type to the location 
where you want to use it.

Result
Missing elements are added to the project library. An instance is generated from the type and 
its dependent elements and pasted at the location where you want to use it. The instances are 
connected to the respective version of the type in the project library.

See also
Basics on types (Page 470)

Updating the project to the latest type versions (Page 488)

Library basics (Page 441)

Using the element view (Page 445)
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Updating the project to the latest type versions
In large enterprises with numerous automation projects. the global libraries are frequently 
edited from a central location. The updated global libraries of the individual projects are made 
available after the completion of a new version. If you have received a more recent version of 
a global library, replace the outdated instances in your project with the most recent version. If 
you do not want to apply the changes to the entire project, restrict the update to individual 
devices in the project.

The project library is also updated with the new versions of the types in the global library during 
the updating of the project or individual devices.

The following elements can be selected as source for the updating:

● A global library

● Individual folders within a global library

● Individual types
You can select multiple types.

Requirement
● Your are in the "Libraries" task card or in the library view.

● The updated global library is open.

Procedure
To update instances in a project with the contents from a global library, follow these steps:

1. Select the updated global library or the individual elements from it.

2. Right-click the global library or the required elements and select the "Update > Project" 
command from the shortcut menu.
The "Update project" dialog box opens.

3. Select either the entire project or individual devices for the update.

4. Select the options for the update process:

– The "Update all instances of the affected types" check box is always selected during 
this process.

– Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

5. Click "OK" to confirm.
The update is performed.
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Result
The following changes were made to the project:

● The most recent version of the select types is present in the project library. All older versions 
were deleted if necessary.

● All instances within the selected devices were updated to the most recent version of the 
linked types.

● You can find a log of the update process in the projection tree under "Common data".

See also
Updating the project to the latest versions (Page 484)

Using logs (Page 357)

Updating a library with the contents of another library (Page 493)

Basics on types (Page 470)

Library basics (Page 441)

Adding types to a global library (Page 486)

7.10.8.7 Assigning a version
A library is more clearly structured if types related by content have the same version number. 
The identical version number reflects the work progress. When you have completed the work 
on multiple associated types, you can assign the same version number to these types.

You have the following options to assign a common version to types:

● The entire project library or a complete global library

● One or more folders in a library

● One or more types

Requirement
● The "Libraries" task card or the library view is open.

● Your selection must not contain types with "in test" or "in progress" status.

Procedure
To assign several types the same version, follow these steps:

1. Select the types to which you want to assign a common version.

2. Select the "Assign version" command from the shortcut menu.
The "Assign version" dialog box opens.
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3. If necessary, change the properties of the version:

– In the "Version" field, determine the new version number. The version number must be 
higher than the highest version number of all selected types.

– In the "Author" field, enter the person responsible for the version to be released.

– In the "Comment" field, enter a comment on the version to be released.

4. If you have started the operation within the project library, select the options for the release. 
The following options cannot be selected in a global library.

– Select the "Update all instances" check box to update all instances in the project to the 
new version. Types used in master copies are not updated.

– Select the "Delete all unused versions from the library" check box to delete all older 
versions of the types from the project library. The versions are only deleted if they are 
not assigned to an instance in the project and if they have no dependencies to other 
types.

5. Click "OK" to confirm.

Result
The selected type versions are changed as follows:

● A new version of all selected types is created with the specified version number. 

● The properties are applied to all selected types, the new version and to all future versions. 
Lower versions remain unaffected by the changes. If you make no changes to the 
properties, the properties of the last released version of each type are applied.

● If needed, all instances are updated to the most recent version and the unused versions of 
all types are deleted from the project library.

● The build number of dependent types is incremented to the next free build number as long 
as the dependent types were not in your selection. If you had selected a dependent type 
as well, the version number you specified will be assigned.

A log of the changes is created. If you have versioned the types in the project library, you find 
the log in the project tree under "Common data > Logs". If you have versioned types in a global 
library, you find the log in the "Common data > Logs" folder in the level below the global library.

See also
Basics on types (Page 470)

State of type versions (Page 472)

Library basics (Page 441)

Release versions (Page 481)

Adding types to a global library (Page 486)

Using logs (Page 357)

Displaying logs of global libraries (Page 459)
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7.10.9 Editing library elements
Types, master copies and folder can be cut, copied, pasted, moved, renamed or deleted in 
the usual way within the "Libraries" task card or the library view. Global libraries must be 
opened with write permission for each of the above-described processes.

 
 

 Note
User help for types and master copies

User help is not affected by any of the operations within the library. When you move a master 
copy or a type to a different location, you are also moving the associated user help in the file 
system to the corresponding location.

Additional help on using the user help can be found in the chapter "Conventions for creating 
user help".

 

Copying types
The following rules apply when you copy types to the clipboard:

● Types are always copied to the clipboard with all associated versions. However, only 
versions that have previously been released are copied.

● Types are always copied to the clipboard with all dependent elements.

● Master copies are always copied to the clipboard with all type versions used in them.

Copying and pasting type versions
When you copy type versions to another library, the types must already exist in the target 
library.

Cutting elements
You can only paste previously cut library elements into the same library. In so doing, you can 
only paste master copies into the "Master copies" folder or any of its subfolders. Likewise, you 
can only paste types into the "Types" folder or any of its subfolders.

Pasting types 
Pasting types in a different library corresponds to updating the target library.

The following rules apply when you have pasted a type into a different library:

● A type is always pasted with all its versions.

● If the type already exists in the target library, all versions that are more recent than the 
existing versions are added to the corresponding types in the target library.

● If there is already a version with released status in the target library, this version is not 
pasted again.
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● If the same version exists with in test or in progress status in the target library, it is replaced 
by the released version.

● If a type needs other types, these are also added at the respective location.

Pasting master copies
When you paste master copies, all type versions contained in these copies are also pasted. 
If the corresponding types already exist in the library, only the missing versions are added to 
the individual types. If one of the types used does not yet exist, it is pasted at the highest level 
in the library. The type includes the type version that was used in the master copy.

Moving elements
When you move an element from one library to another, the element is copied and not moved. 
The same rules apply as described under "Pasting types" and "Pasting master copies".

Deleting of types and type versions
Note the following when you delete types or type versions:

● A type or a type version can only be deleted if there are no dependencies to other types.

● When you delete a type, all versions of the type are deleted.

● If you delete all versions of a type, the type is also deleted.

● If you delete a version that has instances in the project, the instances are also deleted from 
the project.

● If you delete a type that is also stored at the same time as a master copy, the master copy 
is also deleted.

Deleting instances
If you delete an instance that has dependencies to other instances, this instance is restored 
during the next compilation. The instance is then linked again to the original type version. This 
restores the consistency of the project.

See also
Library basics (Page 441)

Remove the link between instance and type (Page 485)

Updating a library with the contents of another library (Page 493)
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7.10.10 Updating a library with the contents of another library
An existing library can be updated with the contents of another library. The following options 
are available for updating libraries:

● Updating a global library with types from another global library or from the project library

● Updating the project library with types from a global library

Each of the following elements can be selected as source for the update:

● An entire library

● Individual folders within a library

● Individual types
You can select multiple types.

During the update, new versions are added to the types that already exist in the target library. 
Types that do not yet exist in the target library are copied together with all their versions to the 
target library.

 

 Note
User help for copying types

User help is not copied together with a type to another library. You need to copy the user 
help for types to the corresponding directory.

Additional help on using the user help can be found in the chapter "Conventions for creating 
user help".

 

Requirement
If you want to update a global library, you have to open it with write permission.

Procedure
To update a library with the contents of a different library, follow these steps:

1. Select a library or individual elements from a library as source for the update.

2. Right-click the source and select the "Update > Library" command from the shortcut menu.
The "Update library" dialog box opens.

3. Select the type of library you want to update:

– Select "Update the project library" to update the project library with types from a global 
library.

– Select "Update a global library" if you want to update a global library.

4. Optional: In the drop-down list, select the global library that you want to update, if you want 
to update a global library.
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5. Select the options for the update:

– The "Update all instances of the affected types" option is always disabled during this 
process.

– Select the "Delete all unused versions of the affected types" check box to delete all older 
versions of types from the project library if these are not assigned to any instance in the 
project and if there are no dependencies to other types. This option cannot be selected 
for the update of a global library, since types of a global library never have a point of 
use in the project.

6. Click "OK" to confirm.
The update is performed.

Result
The following changes were made to the target library:

● Types not yet available in the target library were copied together with all their versions. 
More recent versions were added to the types that already exist in the target library. If a 
more recent version of a type already existed in the target library, the latest version was 
nevertheless copied and automatically assigned a newer version number.

● If needed, all versions of types were deleted from the project library if these were not used 
in any instance in the project.

● A log listing all performed changes to the target library was created for the update process.
If you have updated the project library, you can find the log in the project tree under 
"Common data > Logs".
If you have updated a global library, you can find the log in the "Common data > Logs" 
folder in the level below the global library.

See also
Using logs (Page 357)

Updating the project to the latest versions (Page 484)

Updating the project to the latest type versions (Page 488)

Displaying logs of global libraries (Page 459)

Library basics (Page 441)
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7.10.11 Harmonizing names and path structure
You can harmonize the project with a library. This helps you correct the following items:

● Names of the instances:
Instances can be created during the development phase of a library, the names of which 
are appended by "_1", "_2", etc. due to an automatic correction. This extension is used to 
prevent duplicate names in the project. During harmonization, the instances once again 
receive the names of their associated types.

● Path structure:
The original path structure can be lost due to parallel development or copying of dependent 
instances. This affects the clarity of the project. During harmonization, the path structure 
within the project is adapted to the path structure of the library.

Procedure
To harmonize the names and the path structure, follow these steps:

1. Open the library management.

2. Click "Harmonize project" in the toolbar.
The "Harmonize project" dialog box opens.

3. Select the device with which you wish to harmonize the library.

4. Select the "Harmonize paths between project and library" check box if you want to restore 
the path structure.

5. Select the "Harmonize names between project and library" check box if you want to have 
the names corrected.

6. Confirm your entries with "OK".

Result
Depending on your settings, the names and the path structure in the project are harmonized 
with the library.

The changes to the project are logged. The log is available under "Common data > Logs" in 
the project navigation.

See also
Library basics (Page 441)

Overview of the library view (Page 446)

Overview of the library management (Page 449)

Using logs (Page 357)

Editing projects
7.10 Using libraries

WinCC Professional V13.0
System Manual, 02/2014 495



7.10.12 Clean up library
You can clean up the project library or global libraries to remove types or versions that are not 
connected to any instance in the project. This step provides more clarity within the libraries 
and decreases the size of the library.

Cleaning up the project library
To clean up the project library, follow these steps:

1. Open the library management.

2. Click on "Clean up library" in the toolbar.
The "Clean up project library" dialog box opens.

3. Select the scope in which types or versions are to be deleted:

– to retain the version with the highest version number, even if this has no instance, select 
the option "Delete old type versions and retain the newest type version".

– Select the option "Delete complete types" to delete the complete type if no version is 
connected to an instance.

4. Confirm your entry with "OK".
Depending on your selection, either unused type versions or types are removed from the 
project library.
The changes are logged. The log is available under "Common data > Logs" in the project 
navigation.

Clean up global library
To clean up a global library, follow these steps:

1. Open the library management.

2. Click on "Clean up library" in the toolbar.
The "Clean up global library" dialog box opens. 

3. Click "Continue".
Unused type versions are deleted. The latest version of a type is always retained.
The changes are logged. The log is available in the "Common data > Logs" folder in the 
level below the global library.

See also
Library basics (Page 441)

Overview of the library view (Page 446)

Overview of the library management (Page 449)

Using logs (Page 357)

Displaying logs of global libraries (Page 459)
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7.10.13 Comparing library elements

Introduction
You can compare devices from libraries with devices from both the current project as well as 
from the same or another libraries or reference projects. Note, however, that reference projects 
are write-protected. You can also compare instances in a device with their type version in a 
library. Not all actions are available for the comparison with types. You cannot, for example, 
overwrite an instance of a newer version with an older type version from the library.

When comparing library elements, you can always switch between automatic and manual 
comparison.

Procedure
To compare library elements with the device data of a project, follow these steps:

1. In the project tree, select the device whose data you want to compare to a library element 
and which allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Open the "Libraries" task card.

4. Select the library element that you want to compare to the device data.

5. Drag the library element into the right drop area of the compare editor.
You can identify the status of the objects based on the symbols in the status and action 
area. When you select an object, the object properties and the corresponding object of the 
assigned device are clearly shown in the property comparison.
You can drag other devices into the drop areas from the current project, a library or from a 
reference point at any time to start a new comparison. It does not matter which device you 
drag into the drop area.

See also
Using the compare editor  (Page 391)

Carrying out offline/offline comparisons (Page 390)

Using the library view (Page 446)

Library basics (Page 441)

Overview of the "Libraries" task card (Page 443)

Overview of the library view (Page 446)

Using the element view (Page 445)

Using global libraries (Page 454)

Editing projects
7.10 Using libraries

WinCC Professional V13.0
System Manual, 02/2014 497



7.11 Using cross-references

7.11.1 Using cross-references

Introduction to cross-references
The cross-reference list provides an overview of the use of objects within the project. You can 
see which objects are interdependent and where the individual objects are located. Cross-
references are therefore part of the project documentation.

You can also jump directly to the point of use of an object.

Which objects you can display and localize in the cross-reference list depends on the installed 
products.

See also
Displaying cross references of an instance (Page 453)

7.12 Simulating devices

7.12.1 Simulation of devices

Introduction
You can use the TIA Portal to run and test the hardware and software of the project in a 
simulated environment. The simulation is performed directly on the programming device or 
PC. No additional hardware is required.

The simulation software provides a graphical user interface for monitoring and changing the 
configuration. It differs according to the currently selected device.

Integration in the TIA Portal
The simulation software is fully integrated in the TIA Portal but is only supported by certain 
devices. Therefore, the button for calling the simulation software is only active if the selected 
device supports simulation.

The simulation software for some devices requires its own virtual interface to communicate 
with the simulated devices. The virtual interface can be found in the project tree under the 
"Online access" entry next to the physical interfaces of the programming device/PC.

Once you have opened the software, additional help on the simulation software is available 
via a separate link.
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See also
Starting the simulation (Page 499)

7.12.2 Starting the simulation
Some devices can be simulated with additional software. You therefore do not have to have 
the actual devices to perform comprehensive testing of your project. 

Procedure 
To start the simulation software, follow these steps:

1. Select the device you want to simulate, for example, in the project tree.

2. Select the "Simulation > Start" command in the "Online" menu.
This calls the simulation software.

See also
Simulation of devices (Page 498)
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Editing devices and networks 8
8.1 Configuring devices and networks

8.1.1  

8.1.1.1 Overview of hardware and network editor

Function of the hardware and network editor     
The hardware and network editor opens when you double-click on the "Devices and Networks" 
entry in the project tree. The hardware and network editor is the integrated development 
environment for configuring, networking and assigning parameters to devices and modules. It 
provides maximum support for the realization of the automation project.
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Structure of the hardware and network editor 
The hardware and network editor consists of the following components:

① Device view (Page 505), Network view (Page 503), Topology view (Page 508): Graphic area
② Device view (Page 505), Network view (Page 503), Topology view (Page 508): Table area
③ Hardware catalog (Page 514)
④ Inspector window (Page 513)

The hardware and network editor provides you with three views of your project. You can switch 
between these three views at any time depending on whether you want to produce and edit 
individual devices and modules, entire networks and device configurations or the topological 
structure of your project.

Drag the devices and modules you need for your automation system from the hardware catalog 
to the network, device ot topology view. 

The inspector window contains information on the object currently marked. Here you can 
change the settings for the object marked.
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8.1.1.2 Network view

Introduction
The network view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Configuring and assign device parameters

● Networking devices with one another

Structure 
The following diagram shows the components of the network view:

① Changeover switch: device view / network view / topology view
② Toolbar of network view
③ Graphic area of network view
④ Overview navigation
⑤ Table area of network view

You can use your mouse to change the spacing between the graphic and table areas of the 
network view. To do this, click between the graphic and the table areas and change the spacing 
by moving the divider to the left or right while keeping the mouse button pressed. The Speedy 
Splitter (the two small arrow keys) allows you to use a single click to minimize the table view, 
maximize the table view or restore the last selected split.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Mode to network devices.

Mode to create connections.
You can use the adjacent drop-down list to set the connection type.
Mode to create relations.

Show interface addresses.

Adjust the zoom setting.
You can use the adjacent drop-down list to select or directly enter the zoom setting. You 
can also zoom in or zoom out the view in steps using the zoom symbol or draw a frame 
around an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines are displayed at the positions where the pages 
break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view 
is stored.

Graphic area
The graphic area of the network view displays any network-related devices, networks, 
connections and relations. In this area, you add devices from the hardware catalog, connect 
them with each other via their interfaces and configure the communication settings.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the network view includes various tables for the devices, connections and 
communication settings present:

● Network overview

● Connections

● Relations

● I/O communication

● VPN

You can use the shortcut menu of the title bar of the table to adjust the tabular display.
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See also
Adding a device to the hardware configuration (Page 531)

Layout of the user interface (Page 303)

Displaying diagnostics status and comparison status using icons (Page 1203)

Networking devices in the network view (Page 546)

Tabular network overview (Page 549)

8.1.1.3 Device view

Introduction
The device view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Configuring and assign device parameters

● Configuring and assign module parameters
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Structure     
The following diagram shows the components of the device view:

① Changeover switch: device view / network view / topology view
② Toolbar of device view
③ Graphic area of the device view
④ Overview navigation
⑤ Table area of device view

You can use your mouse to change the spacing between the graphic and table areas of the 
device view. To do this, click between the graphic and the table areas and change the spacing 
by moving the divider to the left or right while keeping the mouse button pressed. The Speedy 
Splitter (the two small arrow keys) allows you to use a single click to minimize the table view, 
maximize the table view or restore the last selected split.

Toolbar   
The toolbar provides the following functions:

Icon Meaning
Switches to the network view.
Note: The device view can switch between the existing devices using the drop-down 
list.
Show the area of unplugged modules.

Show module labels.
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Icon Meaning
Adjust the zoom setting.
You can use the adjacent drop-down list to select or directly enter the zoom setting. 
You can use the Zoom icon to zoom in or out incrementally or to drag a frame around 
an area to be enlarged.
With signal modules, you can recognize the address labels from a zoom level of 200% 
or higher.
Show page breaks
Enables page break preview. Dotted lines are displayed at the positions where the 
pages break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the device view displays hardware components and if necessary the 
associated modules that are assigned to each other via one or more racks. In the case of 
devices with racks, you have the option of installing additional hardware objects from the 
hardware catalog into the slots on the racks.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the device view gives you an overview of the modules used and the most 
important technical and organizational data.

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

See also
Working with racks (Page 524)

Network view (Page 503)

Area for unplugged modules (Page 528)

Inserting a module into a rack (Page 533)

Objects in the device view (Page 526)

Layout of the user interface (Page 303)

Displaying diagnostics status and comparison status using icons (Page 1203)
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8.1.1.4 Topology view

Introduction
The topology view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Displaying the Ethernet topology

● Configuring the Ethernet topology

● Identifying and minimizing differences between the desired and actual topology

Structure     
The following figure provides an overview of the topology view.

① Changeover switch: device view / network view / topology view
② Topology view toolbar
③ Graphic area of the topology view
④ Overview navigation
⑤ Table area of the topology view

You can use your mouse to change the spacing between the graphic and table areas of the 
topology view. To do this, click between the graphic and the table areas and change the 
spacing by moving the divider to the left or right while keeping the mouse button pressed. The 
Speedy Splitter (the two small arrow keys) allows you to use a single click to minimize the table 
view, maximize the table view or restore the last selected split.
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Toolbar  
The toolbar provides the following functions:

Icon Meaning
Adjusting the zoom setting.
You can use the adjacent drop-down list to select or directly enter the zoom setting. 
You can also zoom in or zoom out the view in steps using the zoom symbol or draw 
a frame around an area to be zoomed in.
Show page breaks
Enables page break preview. Dotted lines are displayed at the positions where the 
pages break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the topology view displays Ethernet modules with their appropriate ports 
and port interconnections. Here you can add additional hardware objects with Ethernet 
interfaces. See: Adding a device to the hardware configuration (Page 531) 

Overview navigation    
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
This displays the Ethernet or PROFINET modules with their appropriate ports and port 
interconnections in a table. This table corresponds to the network overview table in the network 
view. 

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

See also
Layout of the user interface (Page 303)

Displaying diagnostics status and comparison status using icons (Page 1203)

8.1.1.5 Overview of settings for hardware configuration
You can make some settings for the hardware configuration in the settings of the TIA Portal.

Overview
The following table provides an overview of the settings for the hardware configuration:
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Group Setting Description
Information on product 
support

Deactivated Prevents access to the Siemens Industry Online Support
Via Internet Enables access to product information about individual devices in 

the hardware catalog via the Internet.
Topological overview Temporarily assigning an 

IP address
Assigns a temporary IP address for topology discovery if a device 
does not have a valid IP address. Topology information (LLDP) 
cannot be read from a device without valid IP address.

Show a warning if the 
option is activated

Shows a warning when a temporary IP address is assigned to a 
device during topology discovery.

Compiling Download module 
comment

Transfers any existing comments in addition to the hardware 
configuration when loading the hardware configuration to the device. 
The comment is available after the device is loaded to a programming 
device. 

See also
Changing the settings (Page 302)

8.1.1.6 Printing hardware and network configurations

Printout of hardware and network configurations  
You can print out the following elements of the hardware and network view as part of the project 
documentation:

● Graphic network view

● Network overview table

● Graphic device view

● The device overview table

● The parameters of the object currently selected in the editor

Printout of editor content
If you start a printout within an opened editor and no module is selected, the content of the 
editor is always printed. This includes a graphic representation of the editor as well as the table 
for the editor. You can adapt the scope of the printout. You can specify whether only the graphic 
view, the table or both together are to be printed. Read section "Changing the print options 
(Page 512)" for more on this.

If the graphic is larger than the page layout you have selected, the printout is continued on the 
next page. No content is lost this way. Alternatively, you can change the zoom level of the 
graphic representation to fit the printout on one page. The printout is always made in the 
currently selected zoom setting.
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To check that all content fits on one page, you can either use the print preview or activate the 
page break preview. When page break preview is activated, dashed lines are displayed within 
the graphic editor at the location where the page break is later made.

Printing very large tables
If a table is larger than the print area and therefore cannot be fully printed, the content of the 
table is not printed as a table, but instead as pairs between value and key.

Example:

Object name Property 1 Property 2
Object A Value A1 Value A2
Object B Value B1 Value B2

In this case, the printout has the following appearance:

Object A

Property 1: Value A1

Property 2: Value A2

Object B

Property 1: Value B1

Property 2: Value B2

You can also preset this as a template so that tables are always printed as pairs between the 
key and the value. Read section "Changing the print settings (Page 408)" for more on this.

Printing module parameters
Parameters of selected modules are printed out along with the current value settings in text 
form. All parameters from corresponding modules are also printed. For example, if you have 
selected a CPU, the parameters of an inserted signal board, if present, are printed as well.

You can determine the scope of the module parameters to be printed. In the "Print" dialog, 
select whether all properties and parameters of a module are to be printed or whether to use 
the compact printout. If you select the compact form, only the entries in the "General" area of 
the module properties are printed. Comments on modules, as well as the author and module 
description, are excluded. In compact mode, the following module parameters are therefore 
printed, for example:

● Module specifications
Name, module slot, short description, order number, firmware version

● Name of the PROFINET interface

● Subnet specifications
Name of the subnet, ID of the S7 subnet
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See also
Changing the print options (Page 512)

Documentation settings (Page 406)

Creating a print preview (Page 420)

Printing project data (Page 423)

Activating the page break preview for printout (Page 512)

8.1.1.7 Activating the page break preview for printout
You can activate the page break preview for the printout in the graphic editor. If this option is 
activated, dashed lines are shown within the graphic editor at the locations where page breaks 
are later made during printout.

Procedure
Proceed as follows to activate the page break preview:

1. Select the graphic area of the corresponding view.

2. Click on the "Show page break" symbol in the toolbar of the graphic editor.
Dashed lines are displayed within the graphic editor at the location a page break is later 
made.

3. To modify the frame layout, select the "Print" command in the "Project" menu.

4. To disable page break preview, click again on the "Show page break" symbol in the toolbar 
of the graphic editor. 

8.1.1.8 Changing the print options

Changing the scope of the printout
When printing from an editor, you can specify whether both graphics and tables are to be 
printed or just one of the two. Both are printed by default.

Procedure
To change the scope of the printout, proceed as follows:

1. In the "Options" menu, select the "Settings" command.

2. In the area navigation, open the "Print settings" parameter group under "General".

3. Scroll to the "Hardware configuration" group.

4. Select or clear the "Active graphic view" check box, depending on whether you want to print 
the graphics of the network and device view as well.

5. Select or clear the "Active table" check box, depending on whether you want to print the 
table for the editor as well.
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See also
Printing hardware and network configurations (Page 510)

8.1.1.9 Inspector window 
The properties and parameters shown for the object selected can be edited in the Inspector 
window.

Structure     
The Inspector window consists of the following components:

① Switch between various information and work areas
② Switch between various tabs of the information and work areas
③ Navigation between various pieces of information and parameters
④ Display showing the selected information and parameters

Function
The information and parameters in the Inspector window are split into different types of 
information:

● Properties

● Info

● Diagnostics
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To display the corresponding information and parameters, click in the relevant area. The 
"Properties" area is the most important one for configuring an automation system. This area 
is displayed by default and contains various tabs:

● General: Display the properties and settings of the device or module. Here you can edit the 
settings and parameters. The left pane of the Inspector window is used for area navigation. 
Information and parameters are arranged there in groups. If you click on the arrow symbol 
to the left of the group name, you can expand the group if sub-groups are available. If you 
select a group or sub-group, the corresponding information and parameters are displayed 
in the right pane of the Inspector window and can be edited there too.

● IO tags: Display the IO tags of the PLC. You can assign names for the tags, assign the tags 
to the user-defined tag tables via a drop-down list, and enter comments for the tags. The 
IO tags are also shown in the PLC tag table.

● System constants: Display the constants required by the system with the HW IDs of the 
modules. The system constants are also shown in the PLC tag table.

● Texts: Display the reference language and specify the text source for the project texts.

See also
Editing properties and parameters (Page 539)

Overview of hardware and network editor (Page 501)

Translating text associated with individual objects (Page 370)

Project text basics (Page 366)

Addressing modules (Page 781)

8.1.1.10 Hardware catalog
The "Hardware catalog" task card gives you easy access to a wide range of hardware 
components.
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Structure         
The "Hardware catalog" task card consists of the following panes:

① "Catalog" pane, search and filter function
② "Catalog" pane, component selection
③ "Information" pane

Search and filter function
The search and filter functions of the "Catalog" pane make it easy to search for particular 
hardware components. You can limit the display of the hardware components to certain criteria 
using the filter function. For example, you can limit the display to objects that you can also 
place within the current context or which contain certain functions.

Objects that can be used in the current context include, for example, interconnectable objects 
in the network view or only modules compatible with the device in the device view.
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Component selection
The component selection in the "Catalog" pane contains the installed hardware components 
in a tree structure. You can move the devices or modules you want from the catalog to the 
graphic work area of the device or network view.

Installed hardware components without a license are grayed out. You cannot use non-licensed 
hardware components.

Hardware components belonging to various components groups thematically are partially 
implemented as linked objects. When you click on such linked hardware components, a catalog 
tree opens in which you can find the appropriate hardware components.

Information
The "Information" pane contains detailed information on the object selected from the catalog:

● Schematic representation

● Name

● Order number

● Version number

● Description

See also
Browsing the hardware catalog  (Page 523)

Overview of hardware and network editor (Page 501)

8.1.1.11 Enabling product support
For each device in the hardware catalog, you have the option of displaying additional 
information that is stored in the Siemens Industry Online Support. By default, the function is 
disabled. Instructions for enabling the function are given below.

Requirement
The TIA Portal has access to the Internet.

Procedure
To enable access to Siemens Industry Online Support, follow these steps:

1. In the "Options" menu, select the "Settings" command.

2. Open the "Hardware configuration" group in the area navigation.

3. Select the "Via Internet" check box.
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Result
You can access product support, FAQs and manuals in the hardware catalog via the shortcut 
menu for the module.

See also
Displaying product support for hardware components (Page 517)

8.1.1.12 Displaying product support for hardware components
In the hardware catalog, you have direct access to information that is stored for each module 
in Siemens Industry Online Support. You can jump directly to the following pages in Siemens 
Industry Online Support:

● Information on product support

● FAQs

● Manuals

Requirement
● You have access to the Internet.

● Access to product support is enabled in the settings of the TIA Portal.
For information on how to enable the function, refer to section "Enabling product support 
(Page 516)". 

Procedure
To display the information for a particular module in Siemens Industry Online Support, follow 
these steps:

1. Navigate to the required module in the hardware catalog.

2. Right-click the module.

3. Select one of the following entries in the shortcut menu:

– Information on product support

– FAQs

– Manuals

Result
The default browser set in the operating system is opened and the relevant page in the 
Siemens Industry Online Support is loaded.

See also
Enabling product support (Page 516)
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8.1.1.13 Keyboard operation: Navigation in the editor
You can use shortcut keys in the network and device view to navigate between the components 
of the hardware and network editor and its objects. 

Navigating between elements and functions

Function Shortcut keys
Switch to the next lower selection level
You can for example, use <Return> to switch from a selected rack to the lower selection 
level of the devices and modules that are snapped onto it. If a device is selected, you 
can use <Return> to switch to the lower selection level of the interfaces that are 
displayed on the device.

<Return>

Switch to the next higher selection level
You can use <Esc>, for example, to switch from a selected interface to the higher 
selection level of the devices and modules. If a device is selected, you can use <Esc> 
to switch to the higher selection level of the rack.

<Esc>

Navigation between objects in the current selection level
You can use the arrow keys to switch between the objects within a current selection 
level. To change the selection level, use the <Return> or <Esc> keys.

<Up arrow>
<Down arrow>
<Right arrow>
<Left arrow>

Switches to the device view <Ctrl+Shift+D>
Switches to the network view <Ctrl+Shift+N>
Switches to the topology view <Ctrl+Shift+T>
Switch between editor elements
Use the <Tab> key to switch from one editor element to the next element. Use <Shift
+Tab> to switch to the previous element. You can switch, for example, between the 
graphical view, Speedy Splitter, table view or underlying tabs.

<Tab>
<Shift+Tab>

Switch between tabs
Use the <Ctrl+Tab> keys to switch from one tab to the next tab on the right. Use <Ctrl
+Shift+Tab> to switch to the next tab to the left. You can use these keys, for example, 
to switch between the device view, the network view and the topology view.

<Ctrl+Tab>
<Ctrl+Shift+Tab>

Opening elements and functions

Function Shortcut keys
Opening the online and diagnostics view
When a device is selected, <Ctrl+D> opens the online and diagnostics view for the 
selected device.

<Ctrl+D>

Opening the download to device dialog
When a device is selected, <Ctrl+L> opens the advanced download dialog.

<Ctrl+L>

Add new device
<Ctrl+N> opens the dialog for adding a new device.

<Ctrl+N>

Opens the "Hardware catalog" task card <Ctrl+Shift+C>
Opens "Online Tools" task card <Ctrl+Shift+O>
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See also
Keyboard operation in the TIA Portal (Page 334)

8.1.1.14 Keyboard operation: Editing objects
You can execute some of the functions of the network and device view directly with a 
combination of keyboard and mouse in the hardware and network editor. The keyboard 
operation in tables (Page 334) corresponds to standard characteristics. Here you find the 
keyboard operation for the graphic work area of the network and device view. 

General keyboard operation        

Function Shortcut keys
Zoom in on view in frame
Drag a frame in the graphical view in order to correspondingly change the size of the 
view.

<Ctrl+Space> + pressed mouse 
button

Move view
Move the mouse pointer in order to move the view.

<Space> + pressed mouse button

Cancel current operation <Esc>
Separate connection
Use <Esc> or a double-click to exit connection mode when dragging a connection.

<Esc> or double-click

Zoom in graphic view
The enlargement or reduction depends on the direction of rotation.

<Ctrl> + turn mouse wheel

Selected objects

Function Shortcut keys
Select object Mouse click
Cut an object
The selected object is copied to the clipboard and deleted from the graphical view.

<Ctrl+X>

Copy object
The selected object is copied to the clipboard. 

<Ctrl+C>

Paste object
The object from the clipboard is inserted into the selection.

<Ctrl+V>

Delete selected object <Del>
Select several objects 1
You can add several objects to the selected objects by clicking on them individually. 
Alternatively, you can use <Shift> + pressed mouse key to drag a frame around the 
objects that are to be selected.

<Shift> + click

Select several objects 2
You can add several objects to the selected objects by clicking on them individually. 
Alternatively, you can use <Shift> + pressed mouse key to drag a frame around the 
objects that are to be selected. When holding down the <Ctrl> key, you can use a 
mouse click to deselect selected objects.

<Ctrl> + click
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Function Shortcut keys
Move selection
When the mouse button is pressed, you can drag devices or modules to allowed slots 
on a rack.

Mouse button pressed

Copy selection
Using <Ctrl> + pressed mouse button you can drag devices and modules to allowed 
slots on a rack. This copies the devices or modules.

<Ctrl> + pressed mouse button

8.1.2 Configuring devices

8.1.2.1 Basics

Introduction to configuring hardware
To set up an automation system, you will need to configure, assign parameters and interlink 
the individual hardware components. The work needed for this is undertaken in the device and 
network view.

Configuring     
"Configuring" is understood to mean arranging, positioning, and networking devices and 
modules within the device or network view. Racks are represented symbolically. Just like "real" 
racks, they allow you to plug in a defined number of modules. 

An address is automatically assigned to each module. The addresses can be subsequently 
modified. 

When the automation system is started, the CPU compares the configuration that is preset by 
the software with the actual configuration of the system. Possible errors can be detected and 
reported straight away.

Assigning parameters   
"Assigning parameters" is understood to mean the setting of properties of the components 
used. Parameter assignment is carried out for hardware components and for data exchange 
settings:

● Properties of modules with assignable parameters

● Settings for data exchange between components

The parameters are loaded to the CPU and transferred to the corresponding modules when 
the CPU starts up. Modules can be replaced with ease since the assigned parameters are 
automatically loaded into the new module during startup.
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Adjusting the hardware to the project requirements
You need to configure hardware if you want to set up, expand or change an automation project. 
To do this, add hardware components to your configuration, connect them to existing 
components, and adapt the hardware properties to the tasks.

The properties of the automation systems and modules are preset in such a way that in many 
cases there is no need for additional parameter assignment. Parameter assignment is however 
needed in the following cases:

● You want to change the default parameter settings of a module.

● You want to use special functions.

● You want to configure communication connections.

See also
Changing properties of the modules (Page 1086)

Using existing configurations

Open existing projects
When opening existing projects, an automatic check is made to determine if the appropriate 
software is installed for all modules used within the project. If you try to open a project with 
modules that are not supported by the current scope of the installation of the TIA portal, a 
message appears on opening the project informing you of the missing software components. 
If the software components are not absolutely required to open the project, the project can still 
be opened.
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Reaction to missing software components
Projects that contain modules not supported by the current scope of the installation react as 
follows:

● Display the modules on the GUI

– The non-supported modules are displayed in the project navigation with all of their 
nested objects. However, the modules themselves cannot be processed in editors or in 
inspector windows. When possible, a replacement module is used that best matches 
the original module. Replacement modules are indicated by an exclamation mark.

– Display of properties in tables is limited. This applies in particular to the display of 
network parameters, such as the IP address.

● Functional limitations

– Non-supported modules cannot be printed out or compiled.

– An online connection cannot be established to the module. It is therefore also impossible 
to download.

– To change the device type, the device must first be deleted and then re-inserted. The 
"Change device type" function is not supported.

– Copying and inserting nested objects, such as modules, is possible although the device 
itself cannot be copied and inserted.

– The network configuration cannot be changed with replacement modules within the 
network view.

– Cross-references can be displayed. However, the cross-references only reflect the state 
last saved within the project because on online comparison to the original module cannot 
be made.

See also
Opening projects (Page 360)

General slot rules

Introduction   
Specific slot rules apply to each automation system and module.

If you select a module from the hardware catalog in the device view, all possible slots for the 
module selected are marked in the rack. You can only drag modules to marked slots.

If you insert, move or swap a module, the slot rules are also applied.

Consistency   
Some slot rules depend on how the environment is configured. This means that you can 
sometimes plug modules into the rack although this would result in inconsistencies at the 
current time. If you change the configuration, for example by selecting different modules or 
module parameter settings, you can make the configuration consistent again.
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In cases where inserting a module results in an inconsistency that can be corrected, this will 
be permitted. A consistency check is run when the configuration is compiled. Inconsistencies 
are displayed as alarms in the Inspector window under "Info". Based on the result of the 
consistency check, you can revise your configuration and make it consistent again.

Rules for arranging modules   
The following rules apply generally to modules in racks:

● You can only plug modules into a rack.

● You can only plug interface modules into a module.

● You can only use modules of the same product or system family in one rack.

There are also other special rules for some modules:

● Can only be inserted in certain slots

● Insertion depends on other modules, CPUs or settings

● Limited number of uses in a rack

Browsing the hardware catalog 

Introduction  
Use the "Hardware catalog" task card to select the hardware components you want for a 
hardware configuration. Use the hardware catalog to select the interconnectable hardware 
components in the network and topology view and to select the modules you want in the device 
view.

Context filter   
You can use the "Filter" option of the hardware catalog to restrict the number of displayed 
hardware components and the number of hardware components that can be found by 
searching.

If you select the filter, only those components are displayed that can be selected currently in 
the hardware catalog. If the do not select the filter, the entire hardware catalog is displayed.

If you switch between the various views, the view of the filter objects is adapted to the current 
context.

Search options  
You can use the search function to search for specific entries in the hardware catalog. Note 
the following rules when entering search terms:

● No distinction is made between upper and lower case text.

● Dashes and blanks are ignored during the search.

● The search function considers parts of a search term.

● Several search terms must be separated by a space
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You start the search from an object highlighted in the hardware catalog and either search 
upwards or downwards.

Symbol Meaning
Downwards search
Upwards search

Browsing the hardware catalog 
If you want to browse the hardware catalog, proceed as follows:

1. Click in the entry field of the search function

2. Enter a search term. The search includes the following elements:

– Name of device or module

– Order number (MLFB)

– Description in "Information" pane

3. Click on either the "Downwards search" or "Upwards search" buttons.
 

  Note

To ensure the right search direction, note which point you have marked in the hardware 
catalog. To browse the entire catalog, click on the topmost object of the hardware catalog 
and start the search once you have entered the search term by clicking "Downwards 
search".

The first match with the search term found is displayed as the result. For more search 
results, again click on the "Downwards search" or "Upwards search" button.

Observe the context filter of the hardware catalog. If this is selected, the search in the 
hardware catalog is restricted to the displayed inserted hardware components.

 

See also
Hardware catalog (Page 514)

Working with racks

Introduction   
To assign modules to a device, you need a rack, for example a mounting rail. Secure the 
modules on the rack and connect these via the backplane bus with the CPU, a power supply 
or other modules.
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Creating a rack
If you insert a device in the network view, a station and a rack suitable for the device selected 
are created automatically. The rack and slots available are displayed in the device view. The 
number of slots available again depends on the type of device used.

Rack structure   
A rack always contains the device that has been inserted in the network view. The device is 
permanently assigned a slot which will depend on the type of device in question. There are 
additional slots on the right of the device and, if necessary, on left of the device; slot numbers 
are located above slots in which devices are plugged.

A corresponding short description is displayed above the plugged devices and modules. You 
show or hide this short description via the toolbar under "View" with the command "Display 
module titles" or the corresponding symbol in the toolbar of the device view (Page 505).

Symbol Meaning
Show module titles

When modules are selected in the hardware catalog, all the slots permitted for this module are 
marked. This allows you to see immediately the slot into which the selected module can be 
inserted.

In the following screenshot, a signal module has been selected in the hardware catalog for a 
partially filled S7-1200 rack:

Since slots 101-103 are reserved for communications modules, only the other free slots are 
shown as available slots.

You can expand and collapse the front group of slots using an arrow symbol above the 
expandable slot. When the group of slots is collapsed, the first and last of the group's slot 
numbers are displayed.

The following figure shows the expanded slot group:
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Groups of slots into which modules have already been plugged cannot be collapsed.

Multiple selection of modules and slots    
There are various ways of selecting several modules or slots:

● By pressing <Shift> or <Ctrl>, you can select several modules or slots at the same time.

● Click outside the rack and then hold the mouse button and drag a frame to include the 
modules or slots you want to select.

Objects in the device view
A graphic display of the rack and the devices plugged into it is shown in the left area of the 
device view. You can see the device overview in the right area of the device view. The device 
overview is a table showing you the most important information about the modules inserted in 
the rack. Both areas are displayed in a window. The size of both areas is adjusted using a 
divider. You can also use it to display one or the other area in full or to hide them.

Structure and content of device view
The offline configuration of the devices in the rack are displayed in the graphic device view. 
This is a symbolic representation of the configuration on the real rack.

The rack configuration is displayed as a table in the device view. Each line in the table contains 
the information for assigning a slot.

The following screenshot shows the device view with the configuration of a SIMATIC S7-1200 
CPU. 
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① Graphic view of the allocation of the rack by the CPU and various modules in slots 1 to 4, as well as 101 and 102.
② You can use the divider to adjust the proportion of the device view between the left area (graphic view) and the right 

area (device overview). If you click on the arrows, you can quickly switch the division of the separate areas.
③ Device overview with a tabular representation of the slots of the rack and the plugged components.

Each line in the device overview represents one slot. The key information for each slot is 
displayed in the various columns:

Column Meaning
Module Name of module, can be edited in any way
Slot Slot number
I address Input address area, can be edited in any way
Q address Output address area, can be edited in any way
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Column Meaning
Type Catalog name of module
Order no. Module order number
Firmware Firmware version of module
Comments Optional comments

See also
Device view (Page 505)

Area for unplugged modules
In some cases, the modules for a hardware configuration are not assigned a slot for short 
periods. Such unplugged modules are moved to the area of unplugged modules, a special 
area in the device view.

Adding modules to the storage area       
The modules that, for example, should be assigned to a device using a copy action but for 
which the corresponding rack does not have a free compatible slot, are moved automatically 
into the area of unplugged modules.

Under the following conditions, modules are automatically added to the area of unplugged 
modules:

● In the network view, a module is moved to a device but the rack does not have a compatible 
free slot.

● In the device view, a module is moved or copied from the rack, the hardware catalog or the 
project tree straight into the storage area.

CPs and FMs that occupy a network resource can be moved into the area of unplugged 
modules but will lose the network resources they have been assigned.

You can add modules to the area of unplugged modules by means of drag-and-drop, for 
example. To do this, the area must be opened.

Using the area of unplugged modules
Use the corresponding button to open the area of unplugged modules.

You can find the area of unplugged modules in the device view.

You open the area of unplugged modules with the respective icon in the toolbar of the device 
view (Page 505).
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Icon Meaning
Open area of unplugged modules

 

 Note

To free up slots, move modules from your configuration into the storage area and plug the 
modules you want from the storage area into the freed up slots.

You can use this approach to temporarily move modules whose parameters have already 
been assigned out of the configuration without deleting them.

 

Treatment of modules in the storage area
The following rules apply to modules in the storage area:

● The modules appear in the project tree under the corresponding device in the "Local 
modules" folder.

● The modules retain all settings and parameters previously assigned.

● The modules are not taken into account during loading to a target system. This means that 
a consistency check is not undertaken for modules in the area of unplugged modules.

● Using the context menu, the modules can be copied, cut, or deleted, for example.

8.1.2.2 Configuring individual devices

Selecting a CPU

Introduction
Select a CPU from the hardware catalog and place it, together with a rack, in the network view. 
On this device drag the desired modules from the hardware catalog; they are arranged 
automatically on the rack.

Selecting the components in the hardware catalog   
Each hardware component is displayed as a folder in the hardware catalog. When you open 
this folder you will see the different versions of the selected hardware component with its 
respective order numbers.

There will be an example of how to set up a CPU with a rack in network view.

Requirement
● The hardware catalog is open.

● You must be in the network view.
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Procedure
To select a CPU from the hardware catalog, proceed as follows:

1. In the hardware catalog navigate to the folder with the desired CPUs.

2. Open the folder with the desired CPU type; you will see all order numbers for the selected 
CPU type.

3. Click on a CPU order number to get information about the selected CPU under "Information" 
pane.

4. Set up the CPU and a rack. You have the following options:

– Use drag-and-drop to drag the CPU from the hardware catalog into network view.

– Use Copy & Paste to copy the CPU to the network view.

– Double-click the CPU entry in the hardware catalog.

See also
Browsing the hardware catalog  (Page 523)

Adding a device to the hardware configuration (Page 531)

Inserting a module into a rack (Page 533)

Working with racks (Page 524)

Creating an unspecified CPU (Page 532)
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Adding a device to the hardware configuration

Introduction   
There are various ways of adding a connectable device from the hardware configuration in the 
network view and the topology view:

● Command "Add new device" in the project tree

● Double-click device in hardware catalog

● Drag-and-drop from the hardware catalog in network view or in topology view:

– Text entry from the "Catalog" pane

– Preview graphic from the "Information" pane

● "Add > Device" command from menu bar in network view or topology view

● Shortcut menu of a device in the hardware catalog for copying and pasting

A suitable rack is created along with the new device. The selected device is inserted at the 
first permitted slot of the rack.

Regardless of the method selected, the added device is visible in the project tree and the 
network view of the hardware and network editor.

Adding device using the project tree  
To use the project tree to add a device to the hardware configuration, proceed as follows:

1. Click on the command "Add new device" in the project tree.
The "Add new device" dialog box opens.

2. Display the required device in the tree structure:

– Go to required device in the tree structure.

– Enter a device name in the entry field.

3. Select the required device from the tree.
More information about the device presently selected is displayed on the right-side of the 
dialog box.

4. If necessary, set the firmware version using the drop-down list in the dialog box.

5. Select the "Open device view" check box if you want to change to the device view 
immediately after adding the device.
There you can immediately continue with device configuration and equipping the rack.

6. Click on "OK" to add the device selected.
The dialog box closes.

Adding device from the hardware catalog    
To add a device to the hardware configuration using the hardware catalog, proceed as follows:

1. Open the network view or the topology view.

2. Open the hardware catalog.
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3. Go to the required device in the hardware catalog.

4. Click on the chosen device to select it.

5. If necessary, set the firmware version using the drop-down list in the hardware catalog.

6. Drag the device to the network view or the topology view.

You have now placed the device in the network view or in the topology view. The displayed 
rectangle (in other words "Station") symbolizes the plugged device together with its rack and 
any lower-level modules. Double-click on the device or station to open the device view and 
view the new rack and inserted device. In the next steps, you can configure the device in the 
device view and equip the rack with modules.

See also
Network view (Page 503)

Creating an unspecified CPU (Page 532)

Topology view (Page 508)

Creating an unspecified CPU

Introduction
If you have not yet selected a CPU but have already started programming or want to use an 
existing program, you have the option of using an unspecified CPU. You can also adjust some 
settings with unspecified CPUs. The setting options are restricted to parameters that all CPUs 
of the same CPU family have in common.

Creating an unspecified CPU in the portal view 
To create an unspecified CPU in the portal view, follow these steps:

1. Now, click one of the following options:

– "Devices & networks > Add new device"

– "PLC programming" > "Device" button

2. For a device family, select an unspecified CPU from the tree structure of the "Add new 
device" dialog.

3. Click on "Add".

An unspecified CPU is created and the device view for this CPU appears.
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Further options for creating unspecified CPUs
In the project view, you can create unspecified CPUs like specified CPUs:

● Using the "Add new device" button in the project tree

● In the "Hardware catalog" task card

You can also use these methods to create multiple unspecified CPUs.

Specifying unspecified CPUs
You have two options for specifying unspecified CPUs:

● Use drag-and-drop to assign an existing CPU from the hardware catalog to an unspecified 
CPU by means of module replacement (Page 539).

● Select a selected, unspecified CPU and then the menu command "Online > Hardware 
detection" and assign a CPU identified online. For this purpose, you assign an IP address 
using the "Add address for PG/PC" button.

 

  Note

If you want to go online after the hardware detection, you have to first download the 
detected configuration to your project; otherwise, an error may occur due to inconsistent 
configurations. After hardware detection, the order numbers of the CPU in the project and 
the actually existing CPU are identical, but their parameters are not. The parameters of 
the CPU in the project have the default values; the parameters of the actually existing 
CPU have the values set by you.

 

See also
Selecting a CPU (Page 529)

Adding a device to the hardware configuration (Page 531)

Inserting a module into a rack

Introduction   
Once you have added devices from the hardware catalog to your configuration in network view, 
you can add modules to the devices. There are various ways of adding a module to a rack in 
the device view:

● If there is an available valid slot, double-click a module in the hardware catalog.

● Use drag-and-drop to move the module from the hardware catalog to an available valid slot 
in the graphic or table area:

– Text entry from the "Catalog" pane

– Preview graphic from the "Information" pane

● Select "Copy" in the shortcut menu for a module in the hardware catalog and then select 
"Paste" in the shortcut menu on an available valid slot in the graphic or table area.
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To access the device view from the network view, double-click a device or station in the network 
view or select the Device view tab. The device view contains an illustration of the device 
selected within a rack. The graphic illustration of the rack in the software corresponds to the 
real structure, i.e. you can see the same number of slots as exist in the real structure.

 

 Note

You can also move a module to a rack in the network view. The filter function for the hardware 
catalog must be deactivated in this instance. The module is automatically plugged into a free 
and permitted slot. If there are no slots available, the module will be moved to the area of 
unplugged modules (Page 528).

 

Equipping a rack   
Arrange the modules on a rack according to the applicable slot rules.

After a module has been inserted in a rack with an already inserted CPU, the address areas 
are checked automatically so that addresses are not assigned twice. After it has been inserted, 
each module then has one valid address range. To do so, DP slaves and IO devices must be 
networked with a CPU via the corresponding DP master or IO system.

Requirements
● You are in the device view.

● The hardware catalog is open.

Adding module from the hardware catalog 
How to insert a module from the hardware catalog into a rack is illustrated based on the 
example of a signal module. To do this, follow these steps:

1. Go to the required module board in the hardware catalog.
 

  Note

If you activate the filter function of the hardware catalog, only those modules which match 
the selected device type will be displayed.

 

2. Select the chosen module.
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3. If necessary, set the firmware version using the drop-down list in the hardware catalog.

4. Drag the signal module to a free slot in the rack.

You have now inserted the digital signal module in a slot in the rack. Repeat these steps with 
the other modules.

The name of the module is displayed above the inserted modules. You can activate or 
deactivate module labeling in the menu bar with "View > Show module labels".

Inserting module  
You can also drag modules and drop them between modules that have already been inserted. 
To do this, drag a module above and between the two existing modules while holding down 
the mouse button.

A mouse pointer appears. When you release the mouse button, all modules plugged to the 
right of the pointer are moved one slot to the right. Any redundant modules are moved to the 
area of unplugged modules. The new module is plugged at the point of the freed up slot. 

See also
Device view (Page 505)

Area for unplugged modules (Page 528)

General slot rules (Page 522)

Deleting a hardware component
There are various ways of deleting hardware components. Deleted hardware components are 
removed from the system and assigned addresses made available again.
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Rules
● CPUs or modules from the rack and from the area of unplugged modules can be deleted.

● When a rack is deleted in the device view, the plugged hardware components are moved 
to the area of unplugged modules.

Procedure         
Proceed as follows to delete a hardware component:

1. Select the hardware components you want to delete.

– Network view: Select devices or network relevant hardware components in the graphic 
view or in the network view.

– Device view: In the graphic view or device overview, select racks or modules in racks 
or in the area of unplugged components.

– Topology view: Select devices or hardware components with Ethernet interfaces in the 
graphic view or in the topology view.

– Project tree: Select devices or individual hardware components from the tree structure.

2. Select "Delete" from the shortcut menu or press <Del>.
If the "Delete" menu item is unavailable, your selection contains at least one component 
that cannot be deleted.

The selected hardware components are deleted.
 

 Note

Deleting hardware components may result in inconsistencies in the project, such as violation 
of slot rules. Inconsistencies are reported during the consistency check. Correct the 
inconsistencies by taking appropriate action, for example, ensuring compliance with the slot 
rules.

 

See also
Keyboard operation: Editing objects (Page 519)

Copying a hardware component
You can copy hardware components in the device or network view. Copied hardware 
components are stored on a clipboard and can be pasted at another point from this clipboard. 
Copied stations are pasted as new stations in the network view. Copied devices and modules 
can be pasted into existing racks in the network and device view.

Rules
● Single objects as well as several objects can be copied at the same time.

● Modules inserted in the rack and in the area of unplugged modules can be copied.
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● You can only copy devices and modules to free and valid slots in keeping with the slot rules.

● Racks with a CPU inserted cannot be copied individually, but only as complete units along 
with all inserted hardware components.

Procedure     
Proceed as follows to copy a hardware component:

1. Select the hardware components you want to copy.

– Device view: Select the module in a rack or put it in the area of unplugged modules.

– Network view: Select the station or the relevant hardware component from the network 
view.

– Project tree: Select the station or module.

2. Select "Copy" from the shortcut menu or press <Ctrl+C>.
If the "Copy" menu item is unavailable, your selection contains at least one component that 
cannot be copied.

3. Select the location at which the content of the clipboard is to be pasted.

– Device view: Select a free slot in the rack or area of unplugged modules.

– Network view: Select a station where you want to insert devices or modules or move 
the mouse pointer to a free location in the network view to paste a copied station or a 
hardware component relevant to the network view.

4. Select "Paste" from the shortcut menu or press <Ctrl+V>.
If the "Paste" menu item is unavailable, the clipboard is empty or contains at least one 
component that cannot be pasted at this point.

The selected object is pasted at the chosen point.

Once you have selected a station where you want to insert a module in the network view, the 
module is inserted in the first free and valid slot. If no free, valid slots are available, the object 
is inserted in the area of unplugged modules.

 

 Note

You can also copy a module from one device to another:

To do so, copy a module in the hardware and network editor, select a different device in the 
network view or the drop down list of the device view and insert the module.

You can insert the copied object directly in a slot or place it in the area of unplugged modules 
in the device view. If you add the copied object in the network view of a device or a station, 
it will be inserted in the first available slot.

If there is no slot available for the object, it is automatically placed in the area of unplugged 
modules (Page 528).

 

 Note

You can use <Ctrl> and drag-and-drop to directly copy a selected hardware component.
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See also
Keyboard operation: Editing objects (Page 519)

Moving a hardware component
You can move hardware components in the device or network view.

Rules
● You can move devices and modules from the rack and the area for unplugged modules 

taking the slot rules into consideration.

● CPs can be moved in the network view. The CP is plugged in a free and valid slot in the 
target device. If there are no free slots available, the CP to be inserted is moved to the area 
for unplugged modules.

● In the network view, CPU and slave head modules can be moved between the devices; 
depending on CPU type also within the rack.

 

 Note

Moved CPs are disconnected from their network but keep their network parameters and 
address. If you reconnect the CP to the network and its address has been assigned, use a 
dialog to assign a new unique address to the CP.

 

Procedure 
Proceed as follows to move a hardware component:

1. Select the hardware component you want to move.

– Device view: Select the module in a rack or put it in the area of unplugged modules.

– Network view: Select the hardware component of relevance to the network view.

2. Select "Cut" from the shortcut menu or press <Ctrl+X>.
If the "Cut" menu item is unavailable, your selection contains at least one component that 
cannot be cut.

3. Select the location to which the cut object is to be moved.

– Device view: Select a free slot in the rack or area of unplugged modules.

– Network view: Select a station where you want to insert devices or modules.

4. Select "Paste" from the shortcut menu or press <Ctrl+V>.
If the "Paste" menu item is unavailable, the clipboard is empty or contains at least one 
component that cannot be pasted at this point.
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The selected hardware component is moved to the target. If the hardware component being 
moved is a networked object, it is disconnected from the network.

 

 Note

You can use drag-and-drop to directly move a selected hardware component.
 

See also
Keyboard operation: Editing objects (Page 519)

Replacing a hardware component
You can replace hardware components with others. This, for example, allows you to replace 
unspecified CPUs (Page 532) with available CPUs from the hardware catalog.

Rules
You can only replace hardware components if they support module replacement and if the two 
components are compatible.

Procedure   
To replace one module with another, proceed as follows:

1. Select the module you want to replace.

2. Open the shortcut menu:

– If the "Replace device" entry is enabled, the module can be replaced.

– If the "Replace device" entry is disabled, a module cannot be replaced.

3. Click on "Replace device" in the shortcut menu. The "Replace device" dialog box appears.

4. Under "New device" in the tree structure, select the module with which you want to replace 
your current module.

5. Click "OK".

The existing module is replaced by the new one.

As an alternative, you can take a module by dragging it from the hardware catalog to the module 
you are replacing. If the module can be replaced by the selected module, this is indicated by 
the mouse pointer symbol.

Editing properties and parameters
Once you have inserted hardware components in your rack, you can edit their default 
properties, for example parameters or addresses in the network or device view.
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Requirement
You are in the device view.

 

 Note

You can also edit properties and parameters in the network view. In the graphic network view, 
you have access to the network-related hardware components and the station. You can 
access modules and hardware components not displayed in the graphic network view using 
the table network view.

 

Procedure         
To change the properties and parameters of the hardware components, proceed as follows:

1. In the graphic view, select the CPU, module, rack or interface you want to edit.

2. Edit the settings for the selected object:

– Use the table view to edit addresses and names, for example.

– In the Inspector window additional setting possibilities are available in "Properties".

Note that modules can only be fully parameterized if they are assigned to a CPU. Therefore, 
PROFIBUS or PROFINET interfaces modules must first be networked with the CPU or a 
centrally inserted communication module so that they form a master system or IO system. 
Only then is it possible, for example, to edit the addresses of the distributed components that 
are inserted. 
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Example of changing settings

① Selection of a module
② Editing option for addresses in the device overview
③ Selection options in the inspector window
④ Editing option for addresses in the inspector window

 

See also
Inspector window  (Page 513)

Input and output addresses in the address overview

Introduction  
The currently used input and output addresses can be displayed in the address overview in a 
table form. The address overview can be found in the Inspector window under "Properties" of 
the CPU.
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Design of the address overview
With the different check boxes, you can set which objects should be displayed in the address 
overview:

● Inputs: Display of the input addresses

● Outputs: Display of the output addresses

● Address gaps: Display of open address spaces

● Slot: Display of the slot number

The following information is typically shown in the address overview:

Table header Meaning
Type Indicates whether the area is an input address area or an output address 

area.
Addr. from Start address of the address range.
Addr. to End address in the address range.
Module Module using the address area.
PIP Number of the process image partition. Shows whether the cyclic OB is 

within the process image partition.
OB Organization block that is assigned to the process image. This column is 

not available for every CPU.
DP Number of the master system. You can use the number to determine which 

slaves are assigned to a master. The value in brackets specifies the 
PROFIBUS address of the hardware component.

PN Number of the IO system. The value in brackets stands for the device 
number of the hardware component.

Rack Number of the rack on which the hardware component is inserted.
Slot Number of the slot in the rack in which the hardware component is inserted.

See also
Specifying input and output addresses (Page 782)

Update module version

Explanation of terms 
The terms "Module version" and "Firmware version" are explained in more detail in the 
following section.

● Module version: The specific version of the configuration software from which the module 
description stems.
Example: V11.0.0.0

● Firmware version: The version of the firmware of the module whose parameters are 
assigned offline
Example: V2.0
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Requirement
● You have created a device configuration.

● You have installed an update or an optional package at a later date. As a result of this 
installation, the module version of at least one module type was updated in the hardware 
catalog, whereby the new version is incompatible with the previous version.

● You have used such modules in your device configuration and want to use the modified or 
added properties.

Procedure
Perform the following step for each affected module type.

1. Select the affected module in the device view.

2. In the Inspector window, go to "Properties > General > Catalog Information". Click the 
"Update module version" button there.

3. In the query that then appears, specify whether you want to update the module version only 
for the selected module or for all modules of this type in the current project.

Result
The selected modules are replaced by the same modules with updated module version in the 
the current project.

In which cases is it unnecessary to update the module version?
An updating of the module version is not necessary in the following cases:

● You do not want to use the modified or added properties of the modules.

● You open an existing project with a version of the configuration software that is more recent 
than the version with which you created the project, and the system automatically performs 
a project conversion, for example, from TIA Portal V12 to V13. In this case, all older module 
versions are automatically adapted.

 

8.1.2.3 Comparing devices

Basics of device comparison

Function
You have the option of comparing the hardware components of two devices allowing you to 
identify any differences. You can perform an offline/offline comparison for this purpose. The 
devices to be compared can be from one project or different projects.  

You can compare the central as well as the distributed I/O. The devices to be compared can 
be assigned either automatically or manually. The automatic assignment of central I/O is based 
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on the slot number. With the distributed I/O, the automatic assignment can be made according 
to the following criteria:

● Assignment using the address/ID: The assignment is made using the addresses or IDs of 
the devices. This criterion is suitable for comparing devices within a project.

● Assignment using the name: The assignment is made based on the device names. This 
criterion is suitable for comparing devices in different projects.

You can either specify the assignment yourself or let the system decide. In the latter case, the 
system selects the assignment itself depending on the context.

See also
Basics of project data comparison (Page 389)

Overview of the compare editor (Page 391)

Making a device comparison (Page 544)

Making a device comparison

Procedure
Follow the steps below to compare devices:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The comparison editor opens and the selected device is displayed in the left area.

3. Open the "Hardware" tab.

4. Drag an additional device to the drop area in the right-hand pane. 
All existing objects of the selected devices are displayed depending on the settings of the 
comparison editor in the "Hardware" tab and an automatic comparison is made. You can 
identify the status of the objects based on the symbols in the comparison editor. 

5. If you want to change the matching criterion, click on the arrow of the "Available matching 
criteria" button in the toolbar. Then, select the matching criterion you want to use.

6. If you want to make a manual comparison, click the button for switching between automatic 
and manual comparison above the status area. Then select the objects you want to 
compare. 
The properties comparison is displayed. You can see the status of the objects based on 
the symbols. 

See also
Basics of device comparison (Page 543)

Overview of the compare editor (Page 391)
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8.1.3 Configure networks

8.1.3.1 Networking devices

Communication and networks

Communication between devices   
The basis of all types of communication is always a previously configured network. The network 
configuration provides the necessary requirements for communication:

● All the devices in a network are provided with a unique address

● Communication of the devices with consistent transmission properties

Network configuration   
The following steps are necessary when configuring networks:

● Connect devices to subnet

● Specify the properties/parameters for each subnet

● Specify the device properties for every networked module

● Download configuration data to the devices to supply interfaces with the settings resulting 
from the network configuration

● Document the network configuration

For Open User Communication, creating and configuring a subnet is supported by the 
assignment of connection parameters.

Relation between network configuration and project   
Within a project, subnets and their properties are managed. Properties result mainly from 
adjustable network parameters and the quantity and communication properties of the 
connected devices.

The devices to be networked must be in the same project.

Subnet name and subnet ID
Within the project, subnets are clearly identified by a subnet name and ID. The subnet ID is 
saved in all components along with interconnectable interfaces. Components can then be 
clearly assigned to a subnet even after uploading into a project.
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Networking options
In the project, you can create and network devices with components capable of 
communication. The following basic options are available for networking the devices:

● You link the interfaces of the components capable of communication with one another. A 
new subnet is created suitable for the type of interface.

● You connect the interface of the devices capable of communication with a new or existing 
subnet.

● You create an Open User Communication connection. When you assign parameters to the 
connection for Open User Communication, a subnet is created automatically between the 
communication partners.

● You use the graphic connection configuration to configure connections; missing networks 
are hereby recognized and are created either automatically or via dialog.

Due to the different tasks of the devices or the span of the plant, you may need to use several 
subnets. These subnets are managed in a project.

Networking devices in the network view

Options
In the graphic network view, you have an overview of the subnets of the entire system in the 
project. You can use the tabular network overview for additional support.

Depending on the starting situation, there are various ways of undertaking configuration to 
network the interface for a component capable of communication. The procedures are 
described in the following section:

● Creating an individual subnet

● Creating several subnets at one time

● Connecting two target devices via a new subnet

● Connecting devices to existing subnet

● Selecting an existing subnet from a list

● Automatic networking during the configuration of the connection;
See also: Auto-Hotspot

Possible starting situations are:

● A suitable subnet is not yet available.

● The subnet with which you want to connect the component already exists.

Procedure - creating a single subnet  
To create a subnet and to connect it to an interface, proceed as follows:

1. Select the interface of a CPU / a CP.

2. Select the "Create subnet" command in the shortcut menu of the interface.
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The selected interface is connected to a new subnet. Consistent address parameters are set 
automatically for the interface.

The following schematic shows an interface with outgoing line connecting to a subnet:

Procedure - creating several subnets at one time  
To create several subnets at one time, proceed as follows:

1. Select several interfaces by clicking on them while pressing the <Ctrl> button.

2. Select the "Create subnet" command in the shortcut menu of the interface.

Each selected interface is connected to a new subnet. Consistent address parameters are set 
automatically for the interface.

The following figure shows multiple subnets created by selecting multiple interfaces:

Procedure – Connecting two target devices via a new subnet
To connect an interface with another device via a subnet that does not yet exist, proceed as 
follows:

1. Position the mouse pointer over the interface for a component capable of communication 
requiring networking.

2. Click with the left mouse button and hold the button down.

3. Move the mouse pointer.
The pointer now uses the networking symbol to indicate "Networking" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear when the pointer is 
on a valid target.
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4. Now move the pointer onto the interface of the target device. You can either keep the mouse 
button pressed or release it.

5. Now release the left mouse button or press it again (depending on previous action).

A new subnet is created. The interfaces are now connected via the new subnet. Consistent 
address parameters are set automatically for the interface.

The following schematic shows two networked devices:

Procedure - Connecting devices to existing subnet  
To connect an interface to an existing subnet, proceed as follows:

1. Position the mouse pointer on the interface of a communications-compliant component you 
want to network or on the existing subnet.

2. Click with the left mouse button and hold the button down.

3. Move the mouse pointer.
The pointer now uses the networking symbol to indicate "Networking" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear once the pointer is 
moved to a valid target.

4. Now move the mouse pointer to the existing subnet or to the interface to be networked. 
You can either keep the mouse button pressed or release it.

5. Now release the left mouse button or press it again (depending on previous action).

Result:

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.
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Procedure - selecting an existing subnet from a list
To link an interface with a subnet that has already been created, proceed as follows:

1. Select the interface of a CPU.

2. Select the "Assign to new subnet" command in the shortcut menu of the interface.
A list box containing the available subnets appears.

3. Select a subnet from the list.

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.

Tabular network overview

Meaning
The tabular network overview adds the following functions to the graphic network view:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect components capable of communication with 
created subnets.

Basic functions for tables
The network overview supports the following basic functions for editing a table:

● Displaying and hiding table columns
 Note: The columns of relevance to configuration cannot be hidden. 

● Optimizing column width

● Sorting table

● Displaying the meaning of a column, a row or cell using tooltips.

Networking devices in the device view

Networking in the device view 
In the device view, you can check and set all the parameters of the components belonging to 
a device and the interfaces in detail. Here you can also assign the interfaces to the subnets 
created in the project.

Requirements
● The subnet with which you want to connect an interface has already been created.

● If the subnet has not yet been created, change to the network view and make the settings 
required for networking. 
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Procedure - connecting to an existing subnet 
To connect an interface to an existing subnet, proceed in the device view as follows:

1. Select the entire communications-compliant component or the interface to be networked.
The properties of the selected interface or component are displayed in the Inspector window.

2. In the Inspector window, select the parameter group for the selected interface; for example, 
the "Ethernet addresses" parameter group for a PROFINET interface.

3. Select the subnet to be connected from the "Interface connected with" drop-down list.

The interface and selected subnet are now connected. Consistent address parameters are set 
automatically for the interface.

Procedure - creating a new subnet 
To create a subnet and to connect it to the interface, proceed as follows in the device view:

1. Select the entire communications-compliant component or the interface to be networked.
The properties of the selected interface or component are displayed in the Inspector window.

2. In the Inspector window, select the parameter group for the selected interface; for example, 
the "Ethernet addresses" parameter group for a PROFINET interface.

3. In "Interface connected with", click the "Add new subnet" button.

The interface is connected to a new subnet of the appropriate subnet type. Consistent address 
parameters are set automatically for the interface.

Checking or changing network parameters and interface parameters

Introduction 
Communication between networked devices requires the following parameters to be 
configured:

● Network parameters
Network parameters identify the network within the system configuration, for example, using 
a name.

● Interface parameters
Interface parameters define specific properties of a component capable of communication. 
Addresses and transmission characteristics are set automatically and are consistent with 
the network parameters.

 

  Note

Network parameters and interface parameters are usually set during networking such that 
communication can take place for numerous applications without the parameters having 
to be changed.
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Procedure - checking or changing network parameters 
Proceed as follows to check or change network parameters:

1. Enter the network view.

2. Select the subnet from the network view.
You can see the network parameters in the "Properties" tab in the inspector window.

3. If necessary, check or modify the network parameters in the relevant group of parameters.

Procedure - checking or changing interface parameters 
You can check and modify interface parameters in the network and device view.

Proceed as follows to check or change interface parameters:

1. Enter the network view or device view.

2. Select the interface.
You can see the interface parameters in the "Properties" tab in the inspector window.

3. If necessary, check or modify the interface parameters in the relevant group of parameters.

 

Changing networkings

Introduction
You can cancel an interface's network connection or assign it to another subnet of the same 
subnet type.

Consequences
Depending on the version, a distinction should be made between:

● Canceling a network connection for an interface
The configured parameters for the interface remain unchanged.

● Assigning a network connection to another subnet
If the addresses in the assigned subnet are not unique, in other words, they already exist, 
they will be changed automatically to make them unique.
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Procedure - disconnecting from a network  
Proceed as follows to cancel the network connection for an interface:

1. Select the networked interface.

2. Select the "Disconnect from subnet" command in the shortcut menu of the interface.

The network connection is deleted, the interface addresses are, however, not changed.

Configured connections are retained; however these connections are marked red in the 
connection table because they are not networked. Specified connections remain specified.

See also
Networking devices in the network view (Page 546)

Copying, cutting or deleting subnets

Introduction
You can copy subnets as individual objects or copy them along with networked devices or 
other networks.

For example, you can create complex configurations to be used more than once in different 
variants within the project with no additional effort.

Effects on the copied subnet 
Properties that have to be assigned explicitly within a project are re-assigned appropriately 
when the copied objects are copied. 

For subnets, this means: The subnet ID and name are re-assigned to the copied subnet.

The configured properties are adopted in the copied subnet.

Procedure - copying a subnet
Proceed as follows to copy one or more subnets:

1. Select one or more subnets.

2. In the shortcut menu, select the "Copy" command.

3. Select the "Paste" command in the shortcut menu.

The copied subnets are shown as "orphaned" subnets in the top part of the network view.
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Procedure - copying a subnet with connected devices 
To copy one or more subnets with networked devices, proceed as follows:

1. Select one or more subnets with the connected devices, for example by drawing a lasso 
around them.

2. In the shortcut menu, select the "Copy" command.

3. Select the "Paste" command in the shortcut menu.

Complete copies of the subnets and connected devices are created.

Configured connections are adopted and remain within the copied devices. Connections to 
devices that have not been copied are interrupted and become unspecified.

MPI network configuration

Allocating MPI addresses 
Note the following for devices with an MPI interface: All devices of a subnet must have different 
device addresses. 

CPUs with MPI address ship with the default MPI address 2. Since you can only use this 
address once in the MPI subnet, you will have to change the default address in all other CPUs.

The following applies to devices with the order no. 6ES7 3xx-xxxxx-0AB0:

When planning the MPI addresses for several CPUs, you have to fill "MPI address gaps" for 
FMs and CPs with separate MPI addresses to prevent addresses being assigned twice. 

Only when all the modules in a subnet have different addresses and your actual structure 
matches that of the network configuration produced, should you load the settings across the 
network.

Rules for assigning the MPI address 
● Allocate the MPI addresses in ascending order.

● Reserve MPI address 0 for a programming device.

● You can link up to 126 (addressable) devices with one another in an MPI subnet; up to 8 
devices at a transfer speed of 19.2 KB/s.

● All MPI addresses in an MPI subnet must be different.
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You will find other rules relating to the structure of a network in the manuals for setting up 
automation systems.

PROFIBUS network configuration

PROFIBUS addresses

Rules for the network configuration  
All the devices in a subnet must have a different PROFIBUS address. 

Only when all the modules in a subnet have different addresses and your actual structure 
matches that of the network configuration produced, should you load the settings across the 
network.

You can connect devices to the PROFIBUS subnet that communicate via configured 
connections or that belong to a PROFIBUS DP master system.

You can find more information on configuring a DP master system in the following sections.

Requirements
The 121xC CPU is PROFIBUS compatible as of firmware version 2.0.

Rules for assigning PROFIBUS addresses
● Allocate the PROFIBUS addresses in ascending order.

● Reserve the PROFIBUS address "0" for a programming device.

● Allocate a unique PROFIBUS address between 0 and 126 for each device on the 
PROFIBUS network and/or for each DP master and each DP slave in the PROFIBUS 
network.

● There are modules with which the smallest address that can be set has to be greater than 
1.

● All PROFIBUS addresses of a PROFIBUS subnet must be different.

You will find additional rules relating to the structure of a network in the manuals for setting up 
automation systems, for example SIMATIC S7-1200.

 

 Note
PROFIBUS address "0"

Reserve PROFIBUS address "0" for a programming device that you will briefly connect up 
to the PROFIBUS network at a later date for servicing.

 

See also
What you need to know about PROFIBUS bus parameters (Page 555)
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What you need to know about PROFIBUS bus parameters

Matching parameters to one another   
The PROFIBUS subnet will only function without problem if the parameters for the bus profile 
are matched to one another. You should therefore only change the default values if you are 
familiar with how to configure the bus profile for PROFIBUS.

 

 Note

It may be possible for the bus parameters to be adjusted depending on the bus profile. If the 
bus parameters cannot be adjusted, they are grayed out. The offline values of the bus 
parameters are always shown even if you are online and linked to the target system.

 

The parameters shown apply to the entire PROFIBUS subnet and are briefly explained below.

Activating cyclic distribution of the bus parameters
If the "Enable cyclic distribution of the bus parameters" check box is selected under "Bus 
parameters" while PROFIBUS subnet is selected in the Inspector window, the bus parameters 
are transferred cyclically during operation by the modules that support this function. This allows 
a programming device, for example, to be easily connected to the PROFIBUS in runtime. 

You should deactivate this function:

● For a heterogeneous PROFIBUS subnet (or more accurately: when external devices are 
connected whose protocol uses the DSAP 63 for Multicast)

● When in constant bus cycle time mode (minimize bus cycle)

Bus parameters for the bus profile of PROFIBUS subnets   

Bus parameter Adjustable? Limit values
Tslot_Init Yes Max. Tsdr + 15 <= Tslot_init <= 16.383 t_bit
Max. Tsdr Yes 35 + 2*Tset + Tqui <= Max. Tsdr <= 1.023 t_bit
Min. Tsdr Yes 11 t_bit <= Min. Tsdr <= MIN(255 t_bit, ...

... Max. Tsdr - 1, 34 + 2*Tset + Tqui)
Tset Yes 1 t_bit <= Tset <= 494 t_bit
Tqui Yes 0 t_bit <= Tqui <= MIN(31 t_bit, Min. Tsdr - 1)
GAP factor Yes 1 <= GAP factor <= 100
Retry limit Yes 1 <= Retry limit <= 15
Tslot No ---
Tid2 No Tid2 = Max. Tsdr
Trdy No Trdy = Min. Tsdr
Tid1 No Tid1 = 35 + 2*Tset + Tqui
Ttr Yes 256 t_bit <= Ttr <= 16.777.960 t_bit
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Bus parameter Adjustable? Limit values
Ttr typical No This time is provided for information only and is not transferred to the 

nodes.
Response monitoring  10 ms <= response monitoring (watchdog) <= 650 s

If you want to create a customized bus profile, we recommend the following settings:

● Minimum target rotation time (Ttr) = 5000 x HSA (highest PROFIBUS address)

● Minimum response monitoring (watchdog) = 6250 x HSA

Recalculating
You can use the "Recalculate" button to recalculate the parameters. 

See also
PROFIBUS addresses (Page 554)

Description of the bus parameters (Page 556)

Description of the bus parameters

Detailed description of PROFIBUS bus parameters

Bus parameter Meaning
Tslot_Init The wait-for-reception (slot time) defines the maximum time the sender will wait 

to receive a response from the addressed partner. If the influence of the line 
components on message frame run times is entered in the "Cable Configuration" 
parameter group, these components must also be taken into account. The 
component is added to the specified Tslot_Init and the total used as Tslot.

Max. Tsdr The maximum protocol processing time defines the latest time by which the 
responding node should have replied.

Min. Tsdr The minimum protocol processing time defines the earliest time by which the 
responding node may reply.

Tset The trigger time is the time which may lapse between the reception of a data 
message frame and the response to it in the node.

Tqui The modulator quiet time is the time which a sending node needs after the end 
of the message frame to switch from sending to receiving.

GAP factor The GAP update factor defines the number of token rotations after which a newly 
added, active node can be added to the logical token ring.

Retry limit This parameter defines the maximum number of attempts (message frame 
repeats) made to reach a node.

Tslot The wait-for-reception time (slot time) defines the maximum time the sender will 
wait to receive a response from the addressed partner.
If the influence of the bus design components on message frame run times is 
entered in the "Cable Configuration" parameter group, these components must 
also be taken into account. The component is added to the specified Tslot_Init 
and the total used as Tslot.
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Bus parameter Meaning
Tid2 Idle time 2 defines the earliest time by which a sending node may send the next 

message frame after sending a message frame that has not been acknowledged.
Trdy The ready time specifies the earliest time by which a sending node may receive 

a response message frame.
Tid1 Idle time 1 defines the earliest time by which a sending node may send the next 

message frame after receiving a response.
Ttr The target rotation time is the maximum time made available for a token rotation. 

During this time, all active nodes (DP masters etc.) have the right to send (token) 
once. The difference between the target rotation time and the actual token holding 
time of a node determines how much time is left over for the other active nodes 
(programming device, other DP masters etc.) to send message frames.

Ttr typical The typical data cycle time is the average response time on the bus if all 
configured slaves are exchanging data with the DP master. None of the slaves 
report diagnostics and there is no extra message frame traffic with programming 
devices or other active nodes etc. on the bus.

Response monitoring The response monitoring time is only needed for PROFIBUS-DP bus systems. It 
defines the latest time by which a DP slave has to be addressed by its DP master 
with a new data message frame. If this does not happen, the DP slave assumes 
that the DP master has failed and resets its outputs to a secure mode.

See also
What you need to know about PROFIBUS bus parameters (Page 555)

Bus profiles with PROFIBUS

Introduction  
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.   

Devices with different profiles on the same PROFIBUS subnet  
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. For example, if both DP and FMS services are being used on a subnet, 
the "slower" sets of bus parameters must always be set for all devices, i.e. even the "Universal 
(DP/FMS)" profile for DP devices.  

Profiles and transmission rates  

Profiles Supported transmission speeds in Kbits/s
DP 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000 
Standard 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000
Universal (DP-FMS) 9.6 19.2 93.75 187.5 500 1500
Customized 9.6 19.2 45.45 93.75 187.5 500 1500 3000 6000 12000
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Meaning of profiles  

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal (DP/FMS) Select the "Universal (DP/FMS)" bus profile when individual devices on the 
PROFIBUS subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5 (SIMATIC S7)
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.

Customized The PROFIBUS subnet will only function without problem if the parameters for 
the bus profile are matched to one another. Select the "Customized" profile 
when none of the usual profiles "match" a PROFIBUS device and you need to 
adapt the bus parameters to your special structure. Information on this can be 
found in the documentation for the PROFIBUS device. 
You should only change the default values if you are familiar with how to 
configure the bus profile for PROFIBUS. 
Not all combinations that can be theoretically set can be used even with this 
bus profile. The PROFIBUS standard specifies several parameter limits that 
depend on other parameters. For example, a responder must not respond (Min 
Tsdr) before the initiator can receive the message frame (Trdy). These standard 
specifications are also checked in the "Customized" profile. 
Tip: The bus parameters last valid on the PROFIBUS subnet are always 
automatically set as customized. For example, if the "DP" bus profile was valid 
for the subnet, then the bus parameters for "DP" are set in the "Customized" 
bus profile. The parameters can be modified on this basis. 
The monitoring times are not automatically recalculated so that you do not put 
at risk the consistency of set values, for example with configurations in other 
configuration tools without realizing that you have done so.
You can also have the Ttr monitoring times and target rotation time calculated 
on the basis of parameters you have set: Click here on the "Recalculate" button.

 

 Note

Both mono-master mode and multi-master mode are possible with all PROFIBUS profiles. 
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What you need to know about PROFIBUS line configuration

Cable configuration and bus parameters
Information regarding the cable configuration can be taken into consideration when calculating 
the bus parameters. For this purpose, you must select the "Consider cable configuration" check 
box in the properties for the PROFIBUS subnet.

The remaining information then depends on the type of cable used; the following settings are 
available:

● Copper cable

● Fiber-optic cable/optical ring

PROFIBUS line configuration, optical ring
The calculation depends on the OLM types used. The selection is made by activating the check 
box (multiple activation is possible, at least one OLM type must be selected):

● OLM/P12

● OLM/G12

● OLM/G12-EEC

● OLM/G12-1300

The following bus parameter adjustments are made:

● Configuration of a node not present
 

  Note
The following restrictions apply to optical rings, even for passive nodes (DP slaves for 
example):

A maximum of HSA-1 nodes may be connected to the PROFIBUS network. With an HSA 
of 126, addresses 126 and 125 must not be used. A maximum of 125 nodes are possible 
on the bus (No. 0 to 124).

If an HSA is less than or equal to 125, the addresses HSA and greater may not be used. 
The address HSA-1 may not be used.

 

● Increase the retry value to 3

● Setting of minimum slot time needed for ring mode
 

  Note

Short slot time values are needed for OLM/P12, average ones for OLM/G12 and OLM/
G12-EEC and long ones for OLM/G12-1300. This results in high performance for small 
network lengths and average to low performance for average to large network lengths.
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PROFIBUS communication load

Communication load - allowing for additional network stations
The bus parameters depend on the volume of communication between the active network 
nodes. There are differences between cyclic communication (DP) and connection-based, 
acyclic communication (S7 communication, Send/Receive (FDL), FMS). Unlike DP, the volume 
and size of communication tasks (communication load) depends on the user program. For this 
reason, the communication load cannot always be calculated automatically. 

To calculate the bus times you can define a network configuration in the "Additional network 
stations" parameter group that differs from the network configuration.

Taking the profile into account
The network configuration can be defined for the "Standard", "Universal (DP/FMS)", and "User-
defined" profiles. Parameters cannot be entered in the "Additional network stations" parameter 
group for the "DP" profile.

Quantification of the communication load
The following settings are available in order to make allowance for the communication load.

● Information regarding the number of unconfigured network stations;

● Information on the communication load resulting from the user programs for FDL or S7 
communication. Here you can selected from the following settings:

– Low
Typically used for DP, no great data communication apart from DP.

– Medium
Typically used for mixed operations featuring DP and other communication services 
(such as for S7 communication), when DP has strict time requirements and for average 
acyclic volumes of communication.

– High
For mixed operations featuring DP and other communication services (such as for S7 
communication), when DP has loose time requirements and for high acyclic volumes of 
communication.

 

Configuring Industrial Ethernet

Rules for the network configuration   
The Ethernet interfaces of the devices have a default IP address that you can change.
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IP address   
The IP parameters are visible if the module capable of communication supports the TCP/IP 
protocol. This is usually the case for all Ethernet modules.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of: 

● Address of IP subnet

● Address of the device (generally also called host or network node)

Subnet mask   
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the device. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the device, i.e. 0.2. 

It is generally true that: 

● The network address results from AND logic operation of the IP address and subnet mask.

● The device address results from the AND NOT logic operation of the IP address and subnet 
mask.

Relation between IP address and default subnet mask   
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0
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 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D, etc). This is not recommended, however, because there is no address 
check for these values.

 

Masking other subnets   
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of devices they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (for example IP address 129.80.xxx.xxx) and change 
the default subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All devices with addresses between 129.80.001.xxx and 129.80.127.xxx are on one IP subnet, 
all devices with addresses between 129.80.128.xxx and 129.80.255.xxx are on another IP 
subnet.

Router   
The task of the routers is to connect the IP subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, you have to enter the 
address of the router for each device in the IP subnet.

The IP address of a device in the subnet and the IP address of the router can only differ at the 
points at which there is a "0" in the subnet mask.

See also
Settings for interconnecting Ethernet devices (Page 562)

Settings for interconnecting Ethernet devices
The following paragraph describes the behavior of STEP 7 during interconnection of 
PROFINET devices and the effects of the port interconnection on the network view. 
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Relation between port interconnection and network view
 

Topology view:

In the topology view, you specify the physical interconnection of Ethernet ports. 

You specifically determine which Ethernet port of a device is to be connected with a specific 
Ethernet port of another device by means of an Ethernet cable (preset topology). 

Example:

You specify that port 1 of the PROFINET interface of the CPU is to be connected to port 2 of 
the PROFINET interface of device A by means of an Ethernet cable.

You also specify the interface for devices with several PROFINET interfaces.

Example: 

You specify that port 1 of PROFINET interface X2 of the CPU is to be connected to port 2 of 
the PROFINET interface of device A by means of an Ethernet cable.

The Ethernet ports can be interconnected in a table or graphically.

 

Network view:

In the network view, you specify which devices are to be connected with each other via an 
Ethernet subnet. You do not specify the Ethernet ports by which the devices are interconnected 
with each other (that is the task of the port interconnection).

The port interconnection has effects on the network view: 

When you interconnect Ethernet ports of devices with each other in the topology view, STEP 
7 connects the interconnected PROFINET interfaces of the devices in the network view with 
an Ethernet subnet (green line).

However, the course of the green line does not reflect the actual cable routing. You specify 
the actual wiring in the topology view.

An Ethernet subnet always has a name and an S7 subnet ID. You can set these two values 
in the subnet properties.

Which Ethernet subnet is used to link interconnected devices?
STEP 7 distinguishes between the following cases:

● Ethernet subnet specified (default subnet).

● No Ethernet subnet specified (no default subnet).

Ethernet subnet specified (default subnet)
The option "Connect devices that are not linked with this subnet in case of port connection" is 
activated in the properties of an Ethernet subnet (default). 

This option can be activated for exactly one Ethernet subnet. 

Activate the option, if necessary, for the Ethernet subnet that is to be continued when 
interconnecting devices that are not linked. This subnet is referred to as "default subnet" below.
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Response of STEP 7:

When you interconnect the ports of two devices that are not linked in the topology view, STEP 
7 links these devices with the default subnet.

Example:

Step 1: Create a subnet in the network view at PLC_4, "Connect devices that are not linked 
with this subnet in case of port connection" option is enabled. 

Step 2: Interconnect PLC_1 with PLC_2 (topology view).

Result: All PLCs are now connected to the same default subnet (network view).

No Ethernet subnet specified (no default subnet).
This is the case when the following conditions are fulfilled:

● A subnet has been added to a PROFINET interface (this interface is referred to as "Interface 
A" below).

● The option "Connect devices that are not linked with this subnet in case of port connection" 
is deactivated in the properties of this subnet (no default subnet).

● There is no other Ethernet subnet for which this option is activated.

Response of STEP 7:

● The Ethernet subnet of interface A is only continued when you interconnect a port of 
interface A with a port of another device. 

● When you interconnect ports of other devices that are not linked with each other, STEP 7 
creates a new Ethernet subnet.
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Example:

Step 1: Create a subnet in the network view at PLC_4, "Connect devices that are not linked 
with this subnet in case of port connection" option is disabled. 

Step 2: Interconnect PLC_1 with PLC_2 (topology view).

Result: PLC_1 and PLC_2 are connected to a new subnet (network view).

Manual adaptation of the IP addresses
It can occur that STEP 7 does not adapt the IP addresses of the interconnected devices in 
such a way that the resulting network can be correctly compiled, for example, for devices with 
multiple PROFINET interfaces. 

In these situations, you need to adapt the IP addresses of the devices manually.

The following rules apply:

● Devices that are to communicate with each other without a router cannot belong to different 
IP subnets.

● For devices with multiple PROFINET interfaces, the interfaces must be in different IP 
subnets.

To change the IP address of a PROFINET interface, perform the following steps:

1. Change to the network view (if not selected already).

2. Left-click on the icon of the PROFINET interface that is not to be part of the IP subnet.

3. Change the subnet part of the IP address in the properties of the PROFINET interface (in 
the "Ethernet addresses" area).
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Example: Manual conversion of the IP subnet part for devices with multiple PROFINET 
interfaces in a subnet

The IP address is: "192.168.0.1".

The subnet mask is "255.255.255.0".

The first three numbers "192.168.0" form the IP subnet part of the IP address "192.168.0.1".

Change the IP subnet part, for example, to "192.168.1"

 

See also
Interconnecting ports in the graphic view (Page 635)

Interconnecting ports in the table view (Page 636)

Configuring Industrial Ethernet (Page 560)

Network configuration of AS interface
AS-Interface consists of an AS-i master and AS-i slaves connected to each other over an AS-
i subnet.

Rules for AS interface network configuration
All the nodes in an AS-i subnet must have a different AS-i node address.

You should only load the settings over the network when all the modules in a subnet have 
different addresses and when the actual structure matches that of the network configuration 
you have created.

One AS-i master and up to 31 AS-i slaves can be operated on one AS-i subnet.

For more information on configuring an AS-Interface with an AS-i master and AS-i slaves, refer 
to the section on AS-Interface and the documentation of the AS-i master modules.
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8.1.3.2 Communication via connections

Working with connections

S7 connection

Introduction to configuring connections

Definition   
A connection defines a logical assignment of two communication partners in order to undertake 
communication services. A connection defines the following:

● Communication partner involved

● Type of connection (for example, S7 connection)

● Special properties (e.g., whether a connection is established permanently or whether it is 
established and terminated dynamically in the user program, and whether status messages 
are to be sent)

● Connection path

What you need to know about connection configuration
During connection configuration, a local connection name is assigned for an S7 connection as 
a unique local identification.

In the network view, a "Connections" tab is displayed in addition to the "Network overview" 
tab. This tab contains the connection table. A row in this connection table represents a 
configured connection from the viewpoint of the local communication partner with its properties, 
for example, between two S7-1200 CPUs.

What you need to know about using connection resources

Introduction  
Each connection requires connection resources for the end point and/or transition point on the 
devices involved. The number of connection resources is device-specific. 

If all the connection resources of a communication partner are assigned, no new connections 
can be established. This situation is apparent when a newly created connection in the 
connection table has a red background. The configuration is then inconsistent and cannot be 
compiled.
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S7 connections
In the case of S7 connections via the PN interface, one connection resource per S7 connection 
is assigned for the endpoint for the S7-1200 CPU. One connection resource is also required 
for the connection partner.

You can find an overview of available and assigned connection resources for selected S7-1200 
CPU in the Inspector window at "Properties > Connection Resources"
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Views containing information about the configured connections
The views described below will provide you with comprehensive access to all the information 
and functions regarding configuring and checking communication connections.

● Connection display in the network view

● Connection table

● "Properties" tab for a connection in the inspector window
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Benefits
The information shown in these views are always up-to-date in terms of the current user 
actions. This means:

● The connection table displays all connections created.

● If you have selected a connection in the connection table:

– When connection mode is enabled, the connection path is highlighted in the network 
view.

– The "Properties" tab in the Inspector window displays the parameters of this connection.

The connection table
The connection table offers the following functions:

● List of all connections in the project

● Selection of a connection and display of connections associated with it in the network view 
(when connection mode is enabled)

● Changing of connection partners

● Display showing status information

"Properties" tab for a connection in the inspector window
The properties dialog has the following meaning:

● Display for connection parameters

● Display of connection path

● Subsequent specification of connections using the "Find connection path" button

Creating a new connection

Creating a connection - alternatives
You have the following options for creating a connection in the network view:

● Graphic connection configuration

● Interactive connection configuration

You'll find the individual steps for this in the following chapters.

Requirement and result
In the network view, you have add devices between which the connections should be 
configured.
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Specifying a connection
If both partners for the connection type selected are networked on the same network, use the 
graphic or interactive selection of both communication partners to create a fully specified 
connection.

This connection is entered automatically in the connection table of the S7-1200 CPU. A local 
connection name is assigned for this connection.

The following schematic shows a configured connection with a networked device:

Creating a new connection graphically

Graphically configuring connections
In the case of graphic connection configuration, the connection path is automatically specified 
provided interfaces and resources are available. Select the devices to be connected in the 
current configuration.
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Automatically determining connection path
To create a connection graphically, follow these steps:

1. Click the "Connections" button.

This step activates the connection mode: You can now select the connection type you want. 
You will see this from the following:
The devices that can be used for the connection type selected in your project are color-
highlighted in the network view.

2. Hold down the mouse button and drag the mouse pointer from the device from which the 
connection will originate to the device at which the connection ends.

3. Release the mouse button over the destination device to create the connection between 
the two devices.

Result
● A specified connection is created.

● The connection path is highlighted.

● The connection is entered in the connection table.

Configuring a connection when there is no or no clear network assignment
Any networking not in place will if possible be created automatically when a connection is 
created. A query will be made upon completion of connection configuration if unique network 
assignment is not possible. You will be able to choose from the existing subnets.

Example below: A query is made upon creation of a connection between stations PLC_1 and 
PLC_2, which are not yet networked.
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Interactively creating a new connection

Interactively configuring connections
Define the local device and its connection partners.

Procedure
Proceed as follows to interactively create a connection:

1. Select the "Add new connection" command in the shortcut menu of a connection partner 
for which you want to create a connection.
The "Create new connection" dialog appears. 

2. Select the partner endpoint.
In the right pane of the dialog, a possible connection path fitting the selected endpoint is 
displayed, if available. Incomplete paths, for example, for a non-specified CPU, are marked 
by an exclamation mark on a red background. 

3. To accept the configured connection and to configure additional connections to other 
endpoints, click "Add".
To close the dialog, click "OK".

Working in the network view

Highlighting connection path and partner in the network view
To display the connection partners for all or certain connection types in the network view, 
proceed as follows:

1. Click the "Connections" button.

2. Select the S7-CPU for which you want to display the connection partners in the network 
view and then select the "Highlight connection partners" command in the shortcut menu.

3. Select "All connection partners" in the following menu.
The local device and the CPUs of the target devices are selected. The local connection 
partner shows an arrow pointing right and the remote connection partners show an arrow 
pointing left.

4. To open a list with information on the target devices, click the arrow of the local device. 
This additional function is useful in complex network configurations in which some devices 
are not visible.
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 Note

You can display one of the connection partners which cannot be seen in the current display 
range of the network view. Click on the communication partner in the list that appears. Result: 
The display is moved such that the connection partner becomes visible.

 

 

Working with the connection table

Basic functions for tables
The connection table supports the following basic functions for editing a table:

● Changing column width

● Displaying the meaning of a column, a row or cell using tooltips.

Changing column width
To adjust the width of a column to the content so that all texts in the lines are legible, follow 
these steps:

1. Position the cursor in the header of the connection table to the right of the column that you 
want to optimize until the cursor changes its shape to two parallel lines (as if you wanted 
to change the width of the column by dragging it with the cursor).

2. Double click on this point.

or

1. Open the shortcut menu on the header of the table.

2. Click on

– "Optimize column width" or

– "Optimize width of all columns".

For columns that are too narrow, the complete content of specific fields is shown when you 
pause with the cursor on the respective field.

Show / hide columns
You can use the shortcut menu of the header of the connection table to control the display of 
the various table columns. The shortcut menu entry "Show/hide columns" provides you with 
an overview of the available columns. Use the check box to control whether columns are shown 
or hidden.

If you want to store the layout, width and visibility of the table columns, click on the "Remember 
layout" function in the top right-hand of the network view.
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Symbol Meaning
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view is 
stored.

Using cursor keys to move within the connection table 
You can use the UP and DOWN cursor keys to select a connection from the connection table; 
the selected connection is marked and is shown highlighted in the network view.

Changing properties of connection
You can directly edit some of the parameters displayed in the connection table. The name of 
the connection can, for example, only be changed in the connection table.

Changing connection partners
You can change the connection partner of a connection as follows:

1. Select the connection.

2. Select the new connection partner from the open drop-down list in the "Partner" column.

Deleting connections
You can delete configured connections using the network view or the connection table.

In the network view you can delete one highlighted connection per action. In the connection 
table you can delete one or several connections per action.

Procedure
To delete a connection, follow these steps:

1. Select the connection to be deleted:

– In the network view: Select the connection to be deleted.

– In the connection table: Select the rows of the connections to be deleted (multiple 
selection possible).

2. Open the shortcut menu with a right mouse click.

3. Select the "Delete" command.

Result
The selected connection is removed completely.
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Copying connections

Introduction
Connections are not copied singly but always in context along with the project or the device.

You can copy:

● Entire projects

● One or more devices within a project or from one project to another

Copying a project
When you copy a project all configured connections will also be copied. No settings whatsoever 
are required for the copied connections because the connections remain consistent.

Copying devices
If you copy devices for which connections have been configured, the connections are copied 
as well. To complete the connection path, you must still finalize the networking. 

An S7-1200 CPU with a V.10 firmware is merely a server for connections and has no 
connection configuration itself. Consequently, no connections are copied along with it when 
an S7-1200 CPU with a V1.0 firmware is copied. 

Inconsistent connections - connections without assignment
With an inconsistent connection the structure of the connection data is destroyed or the 
connection is not functional in the project context. 

Inconsistent connections cannot be compiled and loaded - operation is not possible with such 
a connection. 

In the connection table inconsistent connections are marked in red.

Possible causes for inconsistent connections
● Deletion or change of the hardware configuration.

● Missing interface network links in the project, which are necessary for a connection.

● Connection resources are exceeded

● Connections to an unspecified connection partner without partner address information.

Detailed information regarding the reasons for the inconsistency can be found in the "Compile" 
tab following compilation (Edit > Compile). 

Remedies
To assign a closed connection path to an existing open connection path, expand the device 
configuration in such a way that the interfaces required for the connection type are available 
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for both partners. At "Properties > General > Interface" in the Inspector window, you can use 
the "Find connection path" button to create a connection to an existing partner.

S7 connection - general settings

General connection parameters
General connection parameters are displayed in the "General" parameter group under the 
properties of the connection; these connection parameters identify the local connection end 
point.

Here, you can assign the connection path and specify all aspects of the connection partner.

Local ID
The local ID of the module from which the connection is viewed is displayed here (local partner). 
You can change the local ID. You may need to do this if you have already programmed 
communication function blocks, and you want to use the local ID specified in those function 
blocks for the connection.

Special connection properties
Display of connection properties (can be modified depending on the components used):

● One-way
One-way means that the connection partner functions as a server on this connection and 
cannot send or receive actively.

● Active connection establishment
In the case of one-way connection, for example with a S7-1200 CPU (firmware version 
V1.0), a connection partner can only be provided for the active connection establishment. 
In the case of a two-way connection you can set which connection partner will assume the 
active role.

● Sending operating mode messages
Indicates whether or not the local partner sends operating mode messages to the 
connection partner.

Address details
Displaying address details of the S7 connection. With an unspecified partner, the values for 
the rack and slot can be changed. All other values are obtained from the current configuration 
and cannot be changed.

S7 connection - address details

Meaning
The address details show the end points of the connection and can localize these via the 
specification of rack and slot.
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When a connection is established, the connection-specific resources of a module are assigned 
specifically to this connection. This assignment requires that the connection resource can be 
addressed. The TSAP (Transport Service Access Point) is, as it were, the address of the 
resource that is formed with the help of the connection resource or, in the case of  S7-1200 
CPUs (firmware V2.0 or higher) with the SIMATIC-ACC (SIMATIC Application Controlled 
Communication). 

Configuration of TSAP for S7-1200  
● For S7-1200 CPU (firmare V2.0 or higher):

"SIMATIC-ACC"<nnn><mm>
nnn = Local ID
mm = any value

● For S7-1200 CPU (firmare V1.0):
<xx>.<yz>
xx = Number of the connection resource
y = Rack number
z = Slot number

TSAP structure, dependent on partner
The configuration of the TSAP for S7-1200 CPUs is dependent on the respective firmware and 
on the remote connection partner. When a S7-1200 CPU is connected with a S7-300/400 CPU, 
a S7-1200 CPU also uses a TSAP configuration that includes the connection resource.

See the following examples for TSAPs of various connection configurations

● Connection between two S7-1200 CPUs (both with firmware V2.0):

– S7-1200 CPU "A" with firmware V2.0 and local ID 100:
TSAP: SIMATIC-ACC10001

– S7-1200 CPU "B" with firmware V2.0 and local ID 5AE:
TSAP: SIMATIC-ACC5AE01

● Connection between two S7-1200 CPUs (firmware V2.0 and V1.0):

– S7-1200 CPU with firmware V2.0 and local ID 1FF:
TSAP: SIMATIC-ACC1FF01

– S7-1200 CPU with firmware V1.0 (rack 0, slot 1, connection resource 03):
TSAP: 03.01

● Connection between S7-1200 CPUs (firmware V2.0) and S7-300/400 CPU:

– S7-1200 CPU with firmware V2.0 (rack 0, slot 1, connection resource 12):
TSAP: 12.01

– S7-300/400 CPU (rack 0, slot 2, connection resource 11):
TSAP: 11.02
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S7 connections via CM/CP

Introduction
S7-1200 CPUs with a firmware version of V2.0 or higher support one-way and two-way S7 
connections via CM/CP interfaces. This increases the number of Ethernet ports and networks 
that can be used for S7 connections. Even though the connection is then guided via the CM/
CP, the associated S7-1200 CPU is an end point of the connection. The other end point can 
be any other device in the case of two-way connections. This other device must also support 
S7 connections.

Data volumes and configuration limit
The number of communication connections which are supported by CM/CP can be found in 
the manual accompanying every CM/CP. The number of connections per device can be further 
increased by adding other CM/CPs.

If several CM/CPs are fitted in a device, an automatic switch is made to the next CM/CP when 
this limit is exceeded. Specifically assign the connections using the path selection as required.

 

 Note

Data transfer > 240 byte transfer is supported by the current CPs. 

CPs with an older product version support the transfer of data with a data length of up to 240 
bytes.

For more information, refer to the details provided in the Ethernet CP equipment manual.
 

Tasks of the Ethernet CM/CP in online mode
During data transfer via a connection, the Ethernet CM/CP takes on the following tasks:

● Receiving
Receiving data from the Ethernet and forwarding to the user data area in the CPU

● Sending
Transferring data from the user data area of the CPU and sending data via the Ethernet

The connection is established automatically as soon as the partner can be reached.
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HMI connection

Introduction to configuring connections

Definition    
A connection defines a logical assignment of two communication partners in order to undertake 
communication services. A connection defines the following:

● Communication partner involved

● Type of connection (e.g., HMI connection)

● Special properties (e.g., whether a connection is established permanently or whether it is 
established and terminated dynamically in the user program, and whether status messages 
are to be sent)

● Connection path

What you need to know about connection configuration
During connection configuration, a local connection name is assigned for an HMI connection 
as a unique local identification.

In the network view, a "Connections" tab is displayed in addition to the "Network overview" 
tab. This tab contains the connection table. A line in this connection table represents a 
configured connection, e.g., between an HMI device and PLC, along with its properties.

What you need to know about using connection resources

Introduction
Each connection requires connection resources for the end point and/or transition point on the 
devices involved. The number of connection resources is device-specific. 

If all the connection resources of a communication partner are assigned, no new connections 
can be established. This situation is apparent when a newly created connection in the 
connection table has a red background. The configuration is then inconsistent and cannot be 
compiled.

HMI connections
For HMI connections via the integrated PN interface, one connection resource for the endpoint 
per HMI connection is occupied for the HMI device. 

One connection resource is also required for the connection partner (PLC). 
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Views containing information about the configured connections
The views described below will provide you with comprehensive access to all the information 
and functions regarding configuring and checking communication connections.

● Connection display in the network view

● Connection table

● "Properties" tab for a connection in the inspector window
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Benefits
The information shown in these views are always up-to-date in terms of the current user 
actions. This means:

● The connection table displays all connections created.

● If you have selected a connection in the connection table:

– You will graphically see the connection path in the network view.

– The "Properties" tab in the Inspector window displays the parameters of this connection.

The connection table
The connection table offers the following functions:

● List of all connections in the project

● Selection of a connection and display of connections associated with it in the network view

● Changing of connection partners

● Display showing status information

"Properties" tab for a connection in the inspector window
The properties dialog has the following meaning:

● Display for connection parameters

● Display of connection path

● Subsequent specification of connections using the "Find connection path" button

Creating a new connection

Creating a connection - alternatives
You have the following options for creating a connection in the network view:

● Graphic connection configuration

● Interactive connection configuration

You'll find the individual steps for this in the following chapters.

Requirement and result
You have created the devices with CPUs and HMI devices between which you want to 
configure connections in the network view.
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Specifying a connection
If both partners for the connection type selected are networked on the same network, use the 
graphic or interactive selection of both communication partners to create a fully specified 
connection.

This connection is entered automatically into the connection table of the HMI device. A local 
connection name is assigned for this connection.

The following schematic shows a configured connection with a networked device:

Creating a new connection graphically

Graphically configuring connections
When using the graphic connection configuration, if necessary the system asks you to define 
the connection path. Select the devices to be connected in the current configuration.
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Automatically determining connection path
To create a connection graphically, follow these steps:

1. Click the "Connections" button.

The connection mode for the connection type you have selected is then activated.
You will see this from the following:
The devices that can be used for the connection type selected in your project are color-
highlighted in the network view.

2. Hold down the mouse button and drag the mouse pointer from the device from which the 
connection will originate to the device at which the connection ends.

3. Release the mouse button over the destination device to create the connection between 
the two devices.

Result
● A specified connection is created.

● The connection path is highlighted.

● The connection is entered in the connection table.

Interactively creating a new connection

Interactively configuring connections
Define the local device and its connection partners.
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Procedure
Proceed as follows to interactively create a connection:

1. Select the "Create new connection" command in the shortcut menu of a connection partner 
for which you want to create a connection.
The "Create new connection" dialog is opened. 

2. Select the partner endpoint.
In the right pane of the dialog, a possible connection path fitting the selected endpoint is 
displayed, if available. Incomplete paths, for example, for a non-specified CPU, are marked 
by an exclamation mark on a red background. 

3. To close the dialog, click "OK". 
To accept the configured connection and to configure additional connections to other 
endpoints, click "Apply".

Working in the network view

Highlighting connection path and partner in the network view
To display the connection partners for all or certain connection types in the network view, 
proceed as follows:

1. Click the "Connections" button.

2. Select the "Highlight connection partners" command in the shortcut menu for the HMI device 
whose connection partners you want to display in the network view.

3. Select "All connection partners" in the following menu.
The local device and the CPUs of the target devices are selected. The local connection 
partner shows an arrow pointing right and the remote connection partners show an arrow 
pointing left.

4. To open a list with information on the target devices, click the arrow of the local device. 
This additional function is useful in complex network configurations in which some devices 
are not visible.

 

 Note

You can display one of the connection partners which cannot be seen in the current display 
range of the network view. Click on the communication partner in the list that appears. Result: 
The display is moved such that the connection partner becomes visible.
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See also
Creating a new connection graphically (Page 583)

Working with the connection table

Basic functions for tables
The connection table supports the following basic functions for editing a table:

● Changing column width

● Displaying the meaning of a column, a row or cell using tooltips.

Changing column width
To adjust the width of a column to the content so that all texts in the lines are legible, follow 
these steps:

1. Position the cursor in the header of the connection table to the right of the column that you 
want to optimize until the cursor changes its shape to two parallel lines (as if you wanted 
to change the width of the column by dragging it with the cursor).

2. Double click on this point.

or

1. Open the shortcut menu on the header of the table.

2. Click on

– "Optimize column width" or

– "Optimize width of all columns".

For columns that are too narrow, the complete content of specific fields is shown when you 
pause with the cursor on the respective field.

Show / hide columns
You can use the shortcut menu of the header of the connection table to control the display of 
the various table columns. The shortcut menu entry "Show/hide columns" provides you with 
an overview of the available columns. Use the check box to control whether columns are shown 
or hidden.

Using cursor keys to move within the connection table 
You can use the UP and DOWN cursor keys to select a connection from the connection table; 
the selected connection is marked and is shown highlighted in the network view.

Changing properties of connection
You can directly edit the parameters displayed in the connection table in some cases. To 
change the name of a connection, you do not have to navigate to the Inspector window. 
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Changing connection partners
You can change the connection partner of a connection as follows:

1. Select the connection.

2. Select the new connection partner from the open drop-down list in the "Partner" column.

Deleting connections
You can delete configured connections using the network view or the connection table.

In the network view you can delete one highlighted connection per action. In the connection 
table you can delete one or several connections per action.

Procedure
To delete a connection, follow these steps:

1. Select the connection to be deleted:

– In the network view: Select the connection to be deleted.

– In the connection table: Select the rows of the connections to be deleted (multiple 
selection possible).

2. Open the shortcut menu with a right mouse click.

3. Select the "Delete" command.

Result
The selected connection is removed completely.

Copying connections

Introduction
Connections are not copied singly but always in context along with the project or the device.

You can copy:

● Entire projects

● One or more devices within a project or from one project to another

Copying a project
When you copy a project all configured connections will also be copied. No settings whatsoever 
are required for the copied connections because the connections remain consistent.
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Copying devices
If you copy devices for which connections have been configured (HMI devices), the 
connections are copied as well. To complete the connection path, you must still finalize the 
networking. 

An S7-1200 CPU with a V.10 firmware is only a server for connections and has no connection 
configuration itself. Consequently, no connections are copied along with it when an S7-1200 
CPU with a V1.0 firmware is copied. 

Inconsistent connections - connections without assignment
With an inconsistent connection the structure of the connection data is destroyed or the 
connection is not functional in the project context. 

Inconsistent connections cannot be compiled and loaded - operation is not possible with such 
a connection. 

In the connection table inconsistent connections are marked in red.

Possible causes for inconsistent connections
● Deletion or change of the hardware configuration.

● Missing interface network links in the project, which are necessary for a connection.

● Connection resources are exceeded

● Errors when backing up data due to insufficient memory

● Connections to an unspecified connection partner without partner address information.

Detailed information regarding the reasons for the inconsistency can be found in the "Compile" 
tab following compilation (Edit > Compile). 

Remedies
If the connection cannot be repaired by opening the connection properties, changing them or 
undoing them in the configuration, then it may be necessary to delete the connection and re-
create it. 

HMI connection general settings

General connection parameters
General connection parameters are displayed in the "General" parameter group under the 
properties of the connection; these connection parameters identify the local connection end 
point.

Here, you can also assign the connection path and specify all aspects of the connection 
partner. 
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Special connection properties
Display of the connection properties (cannot be changed): 

● Active connection establishment
The connection establishment always starts from the HMI device. This option is selected 
by default if the address of the partner is specified.

● One-way
One-way means that the connection partner functions as a server on this connection and 
cannot send or receive actively.

● Sending operating mode messages
Not relevant for HMI devices. 

Address details
Displaying address details of the HMI connection. With an unspecified partner, the values for 
the rack and slot can be changed. All other values are obtained from the current configuration 
and cannot be changed. 

Miscellaneous
Display of the access points for the online connection between HMI device and connection 
partner. 

Using Open User Communication

Basics of Open User Communication

Introduction   
Open User Communication is the name given to a program-controlled communication process 
for communicating via the integrated PN/IE interface of the S7-1200/1500 and S7-300/400 
CPUs. Different connection types are available for this communication process.

The main feature of Open User Communication is its high degree of flexibility in terms of the 
data structures transferred. This allows open data exchange with any communicating devices 
providing they support the connection types available here. Since this communication is 
controlled solely by instructions in the user program, event-driven connection establishment 
and termination is possible. Connections can also be modified by the user program during 
runtime.

For CPUs with an integrated PN/IE interface, the TCP, UDP, and ISO-on-TCP connection 
types are available for Open User Communication. The communication partners can be two 
SIMATIC PLCs or a SIMATIC PLC and a suitable third-party device.
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Instructions for Open User Communication   
To create the connections, you have various instructions available after opening in the program 
editor in the "Instructions > Communication > Open User Communication" task card:

● Compact instructions for sending or receiving data via the integrated functions for 
establishing and terminating the connection (S7-1200/1500 only):

– TSEND_C (connection establishment/termination, sending)

– TRCV_C (connection establishment/termination, receiving)

● Individual instructions for sending and receiving data or for establishing or terminating 
connections:

– TCON (connection establishment)

– TDISCON (connection termination)

– TSEND (TCP or ISO-on-TCP: Sending)

– TRCV (TCP or ISO-on-TCP: Receiving)

– TUSEND (UDP: Sending)

– TURCV (UDP: Receiving)

Connection establishment   
For Open User Communication, instructions for establishing and terminating the connection 
must exist for both communication partners. One communication partner sends its data using 
TSEND, TUSEND or TSEND_C while the other communication partner receives the data using 
TRCV, TURCV or TRCV_C. 

One of the communication partners starts the connection establishment as the active partner. 
The other communication partner reacts by starting its connection establishment as the 
passive partner. If both communication partners have initiated their connection establishment, 
the communication connection is fully established.

Connection configuration     
You can specify establishment of the connection via a connection description DB with the 
TCON_Param, TCON_IP_v4, or TCON_IP_RFC structure by means of parameter assignment 
as follows:

● Manually create, assign parameters and write directly to the instruction.

● Supported by connection configuration.

Connection configuration supports the establishment of the connection and should, therefore, 
be given preference over the other methods.

You specify the following in the connection configuration:

● Connection partner

● Connection type

● Connection ID
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● Connection description DB

● Address details according to selected connection type

In addition, you specify here which communication partner activates the connection 
establishment and which partner establishes a connection passively in response to a request 
from its communication partner.

See also
Principle of operation of connection-oriented protocols (Page 603)

Connection configuration

Overview of connection configuration

Introduction
You can find the connection configuration in the inspector window of the program editor if you 
want to program Open User Communication with the communication instructions TSEND_C, 
TRCV_C or TCON.

Connection configuration supports the flexible functionality of communication programming: 
The parameters entered for the connection configuration are stored in an automatically 
generated global DB derived from the TCON_Param, TCON_IP_v4 or TCON_IP_RFC 
structure. You can modify the connection parameters in this connection description DB.
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Structure of the connection configuration     
The connection configuration is made up of the following components:
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① Communication instruction for TCON, TSEND_C or TRCV_C
② "Configuration" tab in the "Properties" tab
③ Area navigation of the "Configuration" tab
④ General properties of the connection parameters
⑤ Address details of the connection parameters (for selected connection DBs)

"Configuration" tab
Enter the desired connection parameters in the "Configuration" tab. The area navigation of the 
"Configuration" tab includes the "Connection parameters" group. This group contains the 
connection configuration. Here, you can enter the parameters for the connections and the 
address details with system support. Here, you also connect the CONNECT (TCON, 
TSEND_C, TRCV_C) or ID (TCON, TSEND, TRCV, TUSEND, TURCV) block parameters of 
the selected communication instructions.

When all the required parameters are assigned, a check mark is set in front of the "Connection 
parameters" group in the area navigation.

 

 Note

The connection parameter assignment does not check whether the connection IDs and port 
numbers (TCP, UDP) or TSAPs (ISO-on-TCP, ISO) are unique. When you configure Open 
User Communication, you should, therefore, make sure that the parameter settings are 
unique within a device.

 

See also
Connection parameters with structure according to TCON_Param (Page 605)

Connection parameters with structure according to TCON_IP_v4 (Page 608)

Connection parameters with structure according to TCON_IP_RFC (Page 609)
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Description of the connection parameters

Overview     
The following table shows the general connection parameters:

Parameter Description
End point The names of the local end point and the partner end point are shown.

The local end point is the CPU for which TCON, TSEND_C or TRCV_C is programmed. The 
local end point is, therefore, always known.
The partner end point is selected from the drop-down list. The drop-down list shows all 
available possible connection partners including unspecified connection partners for devices 
whose data is unknown in the project.
For S7-1500, broadcast can be selected as the partner end point (message to all subnet 
devices). For S7-1500 CPs/CMs, multicast can also be selected as the partner end point 
(message to a group within the subnet). The connection type is converted automatically to 
UDP in this case.
As long as no connection partner is set, all other parameters in the mask are disabled.

Interface The interface of the local end point is displayed. If multiple interfaces are available, e.g., by 
means of CPs or CMs, the interface can be selected from the drop-down list. To display or 
select the partner interface, a specified partner end point must first be selected.

Subnet The subnet of the local end point is displayed, provided this exists. The partner subnet is 
displayed only after the partner end point has been selected.
If at least one of the two connection partners is not connected with a subnet, the two 
connection partners are connected with each other.
A connection between partners in different subnets is only possible with IP routing. The IP 
routing settings can be edited in the properties of the relevant Ethernet interfaces.

Address The IP address of the local end point is displayed. The IP address of the partner is displayed 
only after the partner end point has been selected.
If you have selected an unspecified connection partner, the input box is empty and has a red 
background. In this case, you need to specify a valid IP address.
Broadcast (S7-1500 only): If "Broadcast" is set as the partner end point, a non-editable IP 
address with host address 255 is entered automatically for the connection partner. The 
network allocation corresponds to that of the sender. Example: Local IP address 192.168.0.1, 
partner IP address 192.168.0.255.
Multicast (S7-1500 CPs/CMs only): If "Multicast" is set as the partner end point, the editable 
IP address 224.0.1.0 is entered automatically for the connection partner.

Connection type Select the connection type you want to use from the "Connection type" drop-down list:
● TCP
● ISO-on-TCP
● UDP
With the S7-1500, you can also select the ISO connection type at the configuration type of 
the configured connections for TSEND_C and TRCV_C or TCON.
The connection types can only be used for partners that support the corresponding protocol.
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Parameter Description
Connection type
(for S7-1500 only)

With the S7-1500, two different configuration types can be set for TSEND_C and TRCV_C:
● Programmed connections use program blocks for the connection description.
● Configured connections are saved for the configuration and are only created after 

download to the device in runtime. You can also use the configured connection to select 
the connection type ISO.

The specified configuration method depends on the selected connection type. If both 
configuration methods are possible, the programmed connection is preset.
The same configuration method must be set for both connection partners.

Connection ID Enter the connection ID in the input box. You can change the connection ID in the input boxes 
or enter it directly in TCON.
Ensure that the connection ID assigned is unique within the device.

Connection data The names of the connection description DBs for the connection description structured 
according to TCON_IP_v4, TCON_IP_RFC or TCON_Param are displayed in the drop-down 
lists.
The drop-down list is still empty after selection of a connection partner. You can use the drop-
down list to generate a new data block or to select an existing data block. This data block is 
filled automatically with the values from the connection configuration. The name of the 
selected data blocks is entered automatically in the CONNECT block parameter of the 
selected TSEND_C, TRCV_C or TCON instruction.
From the drop-down list, you can also reference another valid data block. If a DB is referenced 
using the CONNECT input parameter of the TSEND_C, TRCV_C or TCON extended 
instructions and this does not correspond to the structure of a TCON_IP_v4, TCON_IP_RFC 
or TCON_Param, the drop-down list is shown with no content on a red background.

Connection name
(for S7-1500 only)

If the connection type of the configured connections is set for TSEND_C and TRCV_C for the 
S7-1500, the "Connection data" parameter is replaced with the "Connection name" 
parameter. The name of the configured connection serves here as the connection data.
The drop-down list is still empty after selection of a connection partner. You can use the drop-
down list to generate a new connection or to select an existing connection. If needed, a data 
block is created and automatically filled with the values from the connection configuration. 
The name of the data block is entered automatically in the CONNECT block parameter of the 
TSEND_C or TRCV_C instruction.
You can also reference an existing connection from the drop-down list.

Active connection 
establishment

Use the "Active connection establishment" check box to specify the active partner of the Open 
User Communication (only with TCP and ISO-on-TCP).

Port
(only with TCP and UDP)

Address component for a TCP or UDP connection. The default after creating a new TCP 
connection is 2000.
You can change the port numbers. 
The port numbers must be unique on the device!

TSAP
(ISO-on-TCP only)

Address component for an ISO-on-TCP connection. The default value after creating a new 
ISO-on-TCP connection is E0.01.49.53.4F.6F.6E.54.43.50.2D.31 (S7-1200/1500) or 
E0.02.49.53.4F.6F.6E.54.43.50.2D.31 (S7-300/400). 
You can enter the TSAP-ID with an extension or as an ASCII TSAP. 
The TSAPs must be unique on the device!
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 Note
UDP connection for the "Broadcast" setting (S7-300/400/1200)

The parameters of the UDP connection for the "Broadcast" setting for the partner end point 
are stored in a connection description DB TCON_IP_v4 : With respect to UDP communication 
with TCON and TUSEND/TURCV , the TCON_IP_v4 is not filled with any partner parameters 
(value=0). However, the partner address and the partner port are necessary for sending the 
data and must be entered by the user in the TADDR_Param . The TADDR_Param for UDP 
communication is referenced by the TUSEND-/TURCV block parameter ADDR . The values 
for both parameters can be taken from the connection configuration.

The configuration must also be adapted for the other recipients of UDP communication. In 
order to receive broadcast frames, the partner port must be configured at the receiver end. 
For this purpose, the RemotePort parameter of the TADDR_Param must be filled at the ADDR 
block.

 

 Note
Communication via TSEND_C and TRCV_C (S7-1500)

When TSEND_C and TRCV_C are used, a separate TSEND_C and TRCV_C block pair with 
a configured connection is required for each communication. Multiple TSEND_C and 
TRCV_C block pairs cannot simultaneously use the same configured connection for 
communication.

Additional connections for a TSEND_C or TRCV_C instruction can be created in the inspector 
window for the connection parameters using the appropriate button next to the connection 
data.

The connections configured using TSEND_C and TRCV_C are displayed in a connection 
table in the inspector window under "Properties > Configuration > Overview of configured 
connections" when the TSEND_C or TRCV_C block is selected.

 

See also
Assignment of port numbers (Page 610)

TSAP structure (Page 613)

Examples of TSAP assignment (Page 615)

Ability to read back connection description parameters (Page 611)

Creating and assigning parameters to connections (Page 599)

Connection parameters with structure according to TCON_Param (Page 605)

Connection parameters with structure according to TCON_IP_v4 (Page 608)

Connection parameters with structure according to TCON_IP_RFC (Page 609)
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Starting connection parameter assignment
The connection configuration for Open User Communication is enabled as soon as a TCON, 
TSEND_C or TRCV_C instruction for communication is selected in a program block.

Requirement
● Your project must contain at least one S7-CPU.

● The program editor is open.

● A network is available.

Procedure     
To insert the extended instructions for Open User Communication, proceed as follows:

1. Open the task card, pane and folder "Instructions > Communication > Open User 
Communication".

2. Drag one of the following instructions to a network:

– TSEND_C

– TRCV_C

– TCON

The "Call options" dialog opens.

3. Edit the properties of the instance DB in the "Call properties" dialog. You have the following 
options:

– Change the default name.

– Select the "Manual" check box to assign your own number.

– You can also execute the DB as a multi-instance for function blocks.

4. Click "OK" to complete your entry.

Result
A corresponding instance DB is created at a single instance for the inserted instruction 
TSEND_C, TRCV_C or TCON. In the case of a multi-instance, the instance DB of the function 
block is used.

With TSEND_C, TRCV_C or TCON selected, you will see the "Configuration" tab under 
"Properties" in the Inspector window. The "Connection parameters" group in area navigation 
contains the connection parameter assignment that you can now make.

See also
Creating and assigning parameters to connections (Page 599)
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Creating and assigning parameters to connections
In the connection configuration for Open User Communication, you can create and configure 
connections of the TCP, UDP or ISO-on-TCP type.

Requirement
A CPU exists with a TCON, TSEND_C or TRCV_C communication instruction.

Procedure     
To create a connection for Open User Communication, follow these steps:

1. Select a TCON, TSEND_C or TRCV_C block of Open User Communication in the program 
editor.

2. Open the "Properties > Configuration" tab in the inspector window.

3. Select the "Connection parameters" group. Until you select a connection partner, only the 
empty drop-down list for the partner end point is enabled. All other input options are 
disabled.
The connection parameters already known are displayed:

– Name of the local end point

– Interface of the local end point

– IP address of the local end point

4. In the drop-down list box of the partner end point, select a connection partner. You can 
select an unspecified device or a CPU in the project as the communication partner. Certain 
connection parameters are then entered automatically.
The following parameters are set:

– Name of the partner end point

– Interface of the partner end point

– IP address of the partner end point

If the connection partners are networked, the name of the subnet is displayed.

5. With the S7-1500, in the "Configuration type" drop-down list, you choose between using 
program blocks or configured connections. 
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6. Select an existing connection description DB in the "Connection data" drop-down list or for 
configured connections select an existing connection under "Connection name". You can 
also create a new connection description DB or a new configured connection. Later, you 
can still select other connection description DBs or configured connections or change the 
names of the connection description DBs in order to create new data blocks:

– You can also see the selected data block at the interconnection of the CONNECT input 
parameter of the selected TCON, TSEND_C or TRCV_C instruction.

– If you have already specified a connection description DB for the connection partner 
using the CONNECT parameter of the TCON, TSEND_C or TRCV_C instruction, you 
can either use this DB or create a new DB.

– If you edit the name of the displayed data block in the drop-down list, a new data block 
with the changed name but with the same structure and content is generated and used 
for the connection.

– Changed names of a data block must be unique in the context of the communication 
partner.

– A connection description DB must have the structure TCON_Param, TCON_IP_v4 or 
TCON_IP_RFC, depending on CPU type and connection.

– A data block cannot be selected for an unspecified partner.

Additional values are determined and entered after the selection or creation of the 
connection description DB or configured connection. 
The following is valid for specified connection partners:

– ISO-on-TCP connection type

– Connection ID with default of 1

– Active connection establishment by local partner

– TSAP ID 
for S7-1200/1500: E0.01.49.53.4F.6F.6E.54.43.50.2D.31
for S7-300/400: E0.02.49.53.4F.6F.6E.54.43.50.2D.31

The following is valid for unspecified connection partners:

– TCP connection type

– Partner port 2000

The following applies for a configured connection with a specified connection partner:

– TCP connection type

– Connection ID with default of 257

– Active connection establishment by local partner

– Partner port 2000

The following applies for a configured connection with an unspecified connection partner:

– TCP connection type

– Local port 2000
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7. Enter a connection ID as needed for the connection partner. No connection ID can be 
assigned to an unspecified partner.

 

  Note

You must enter a unique value for the connection ID at a known connection partner. The 
uniqueness of the connection ID is not be checked by the connection parameter settings 
and there is no default value entered for the connection ID when you create a new 
connection.

 

8. Select the desired connection type in the relevant drop-down list. Default values are set for 
the address details depending on the connection type. You can choose between the 
following:

– TCP

– ISO-on-TCP 

– UDP

For configured connections with S7-1500, ISO applies in addition.

9. You can edit the input boxes in the address details. Depending on the selected protocol, 
you can edit the ports (for TCP and UDP) or the TSAPs (for ISO-on-TCP and ISO).

10.Use the "Active connection establishment" check box to set the connection establishment 
characteristics for TCP, ISO and ISO-on-TCP. You can decide which communication 
partner establishes the connection actively.

Changed values are checked immediately for input errors by the connection configuration and 
entered in the data block for the connection description.

 

 Note

Open User Communication between two communication partners can only work when the 
program section for the partner end point has been downloaded to the hardware. To achieve 
fully functional communication, make sure that you load not only the connection description 
of the local CPU on the device but also that of the partner CPU as well.

 

See also
Description of the connection parameters (Page 595)

Starting connection parameter assignment (Page 598)

TSAP structure (Page 613)

Assignment of port numbers (Page 610)

Connection parameters with structure according to TCON_Param (Page 605)

Connection parameters with structure according to TCON_IP_v4 (Page 608)

Connection parameters with structure according to TCON_IP_RFC (Page 609)
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Deleting connections

Introduction
The data of a created connection for Open User Communication is stored in a connection 
description DB. You can delete the connection by deleting the data block containing the 
connection description.

Requirement
You have created an Open User Communication connection.

Procedure     
To delete a connection, follow these steps:

1. Select a communication partner for Open User Communication in the project tree.

2. Open the "Program blocks > System blocks > Program resources" folder below the selected 
communication partner.

3. Select the "Delete" command from the shortcut menu of the data block with the connection 
parameter assignment.

 

 Note

If you are not certain which block to delete, open the extended instruction TCON, TSEND_C 
or TRCV_C. You will find the name of the data block as the CONNECT input parameter or 
in the connection parameter assignment as the "Connection data" parameter.

If you only delete the instance DBs of the extended instructions TCON, TSEND_C or 
TRCV_C, the assigned connections are not deleted as well.

 

 Note

If the connection DB is still being used by other blocks of the extended instructions, then the 
corresponding calls, their instance DBs, and, if present, the combination blocks TSEND_C 
and TRCV_C must also be deleted from the block folder, provided they are not used 
elsewhere.

This action prevents the program from being inconsistent.
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Result
You have deleted the connection.

 

 Note

Insert an extended instruction TCON, TSEND_C, or TRCV_C again in order to reference an 
existing connection description with the TCON_Param, TCON_IP_v4, or TCON_IP_RFC 
structure again via the "Connection data" parameter. 

 

How protocols work

Principle of operation of connection-oriented protocols

Introduction   
Connection-oriented protocols establish a logical connection to the communication partner 
before data transmission is started. After the data transmission is complete, they then terminate 
the connection, if necessary. Connection-oriented protocols are used especially when reliable 
data transmission is important. Several logical connections can exist over one physical line. 

Open User Communication supports the following connection types: 

● TCP

● ISO-on-TCP

● ISO (S7-1500 only)

● UDP

Both communication partners must support the same connection type for a connection. If a 
communication partner does not support a connection of the type ISO-on-TCP, for example, 
use the connection type TCP instead, if it is supported.

For communication partners that cannot be configured in the TIA Portal, such as third-party 
devices or PCs, enter "unspecified" for the partner end point during connection parameter 
assignment. The required connection type for unspecified devices is listed in the respective 
documentation.

 
 

 Note
Connections with ISO

For S7-1500 CPUs, configured connections of the type ISO can be created using the 
TSEND_C and TRCV_C instructions. For additional information on these connection types, 
refer to the general connection descriptions.
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Characteristics of TCP   
TCP is a streaming protocol in which the length of the data stream is transmitted to the receiver 
so that it can receive the data stream as individual TCP segments. This means no information 
about the start and end of a message is transmitted during data transmission via a TCP 
connection. The receiver cannot determine by the received segments of the data stream where 
one message in the data stream ends and the next one begins. It is therefore recommended 
that the number bytes to be received (parameter LEN, instruction TRCV/TRCV_C) be assigned 
the same value as the number of bytes to be sent (parameter LEN, instruction TSEND/
TSEND_C).

If the length of the sent data and the length of the expected data do not match, the following 
occurs:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies the received data to the specified receive area (parameter DATA) 
only after the assigned length is reached. When the assigned length is reached, data of 
the subsequent job are already being received. As a result, the receive area contains data 
from two different send jobs. If you do not know the exact length of the first message, you 
are unable to recognize the end of the first message and the start of the second message.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies the number of bytes you specified in the LEN parameter to the 
receive data area (parameter DATA). Then, it sets the NDR status parameter to TRUE (job 
completed successfully) and assigns RCVD_LEN (amount of data actually received) the 
value of LEN. With each subsequent call, you receive a further block of the sent data.

A receive area with fixed data length can be specified in the TRCV/TRCV_C instructions with 
the protocol version of the Ad-hoc mode.

Characteristics of ISO-on-TCP   
 ISO-on-TCP is a message-oriented protocol which detects the end of the message at the 
receiver end and indicates the data that belongs to the message to the user. This does not 
depend on the specified reception length of the message. This means that information 
regarding the length and the end of a message is included during data transmission via an 
ISO-on-TCP connection.

If the length of the sent data and the length of the expected data do not match, the following 
occurs:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C copies all the sent data to the receive data area (parameter DATA). Then, 
it sets the NDR status parameter to TRUE (job completed successfully) and assigns 
RCVD_LEN (amount of data actually received) the length of the data sent.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TSEND/TSEND_C):
TRCV/TRCV_C does not copy any data to the receive data area (parameter DATA), but 
instead supplies the following error information: ERROR=1, STATUS=W#16#8088 
(destination buffer too small).
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Characteristics of UDP   
UDP is a message-oriented protocol which detects the end of the message at the receiver end 
and indicates the data that belongs to the message to the user. This does not depend on the 
specified reception length of the message. This means that information on the length and the 
end of a message is included during data transmission via a UDP connection.

If the length of the sent data and the length of the expected data do not match, the following 
occurs:

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) greater than 
length of data to be sent (parameter LEN, instruction TUSEND/TSEND_C):
TURCV/TRCV_C copies all the sent data to the receive data area (DATA parameter). Then, 
it sets the NDR status parameter to TRUE (job completed successfully) and assigns 
RCVD_LEN (amount of data actually received) the length of the data sent.

● Length of data to be received (parameter LEN, instruction TRCV/TRCV_C) less than length 
of data to be sent (parameter LEN, instruction TUSEND/TSEND_C):
TRCV/TRCV_C copies as much data to the receive data area (parameter DATA) as the 
LEN parameter requests. No further error message is generated. In this case, the user has 
to call a T_URCV again in order to receive the remaining bytes.

See also
Basics of Open User Communication (Page 589)

Connection parameters with structure according to TCON_Param

Data block for connection description     
A connection description DB with a structure according to TCON_Param is used for some 
S7-1200 CPUs when it comes to the assignment of parameters for TCP, UDP and ISO-on-
TCP communication connections. The fixed data structure of the TCON_Param contains all 
the parameters that are needed to establish the connection. The connection description DB is 
automatically created for a new connection by the connection configuration for Open User 
Communication when the TSEND_C, TRCV_C or TCON instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the data block used.

Structure of the connection description according to TCON_Param       

Byte Parameter Data type Start value Description
0 … 1 block_length UINT 64 Length: 64 bytes (fixed) 
2 … 3 id CONN_OUC 1 Reference to this connection (value range: 1 to 4095).

You must specify the value of this parameter for the 
TSEND_C, TRCV_C or TCON instruction under ID. 
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Byte Parameter Data type Start value Description
4 connection_type USINT 17 Connection type: 

● 17: TCP
● 18: ISO-on-TCP
● 19: UDP

5 active_est BOOL TRUE Identifier for the type of connection establishment: FALSE 
always applies to UDP, since data can be sent and received 
via local ID.
The following is valid for TCP and ISO-on-TCP:
● FALSE: Passive connection establishment
● TRUE: Active connection establishment

6 local_device_id USINT 1 ID for the local PN/IE interface.
7 local_tsap_id_len USINT 0 Length of parameter local_tsap_id used, in bytes; possible 

values: 
● 0 or 2, if connection type = 17 (TCP)

Only the value 0 is permissible for the active side. 
● 2 to 16, if connection type = 18 (ISO-on-TCP)
● 2, if connection type = 19 (UDP)

8 rem_subnet_id_len USINT 0 This parameter is not used.
9 rem_staddr_len USINT 4 Length of address of partner end point, in bytes: 

● 0: unspecified, in other words, parameter rem_staddr is 
irrelevant.

● 4: valid IP address in the parameter rem_staddr 
(TCP and ISO-on-TCP only)

10 rem_tsap_id_len USINT 2 Length of parameter rem_tsap_id used, in bytes; possible 
values: 
● 0 or 2, if connection type = 17 (TCP)

Only the value 0 is permissible for the passive side. 
● 2 to 16, if connection type = 18 (ISO-on-TCP)
● 0, if connection type = 19 (UDP)

11 next_staddr_len USINT 0 This parameter is not used.
12 … 
27

local_tsap_id ARRAY 
[1..16] of 
BYTE 

- Local address component of connection: 
● TCP and UDP: local port no. (possible values: 1...49151; 

recommended values: 2000...5000);
local_tsap_id[1] = high byte of port no. in hexadecimal 
notation;
local_tsap_id[2] = low byte of port no. in hexadecimal 
notation;
local_tsap_id[3-16] = irrelevant 

● ISO-on-TCP: local TSAP-ID:
local_tsap_id[1] = B#16#E0;
local_tsap_id[2] = rack and slot of local end points (bits 0 
to 4: Slot number, bits 5 to 7: rack number);

local_tsap_id[3-16] = TSAP extension, optional 
Note: Make sure that every value of local_tsap_id is unique 
within the CPU. 
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Byte Parameter Data type Start value Description
28 … 
33

rem_subnet_id ARRAY 
[1..6] of 
USINT

- This parameter is not used. 

34 … 
39

rem_staddr ARRAY 
[1..6] of 
USINT 

- TCP and ISO-on-TCP only: IP address of the partner end 
point, for example, for 192.168.002.003: 
● rem_staddr[1] = 192
● rem_staddr[2] = 168
● rem_staddr[3] = 002
● rem_staddr[4] = 003
● rem_staddr[5-6]= irrelevant

40 … 
55

rem_tsap_id ARRAY 
[1..16] of 
BYTE 

- Partner address component of connection
● TCP: partner port no. (possible values: 1...49151; 

recommended values: 2000...5000);
rem_tsap_id[1] = high byte of port no. in hexadecimal 
notation;
rem_tsap_id[2] = low byte of port no. in hexadecimal 
notation;
rem_tsap_id[3-16] = irrelevant

● ISO-on-TCP: partner TSAP-ID:
rem_tsap_id[1] = B#16#E0; 
rem_tsap_id[2] = rack and slot of partner end point (bits 0 
to 4: Slot number, bits 5 to 7: rack number);
rem_tsap_id[3-16] = TSAP extension, optional

● UDP: This parameter is not used.
56 … 
61

next_staddr ARRAY 
[1..6] of 
BYTE 

- This parameter is not used.

62 … 
63

spare WORD W#16#0000 Reserved. 

 
 

 Note
TCON_Param for S7-1500 CPU

The connection description DB with the structure according to TCON_Param is also 
supported by S7-1500 CPUs for migration reasons. However, we recommend that you use 
the new structures TCON_IP_v4 and TCON_IP_RFC.

 

See also
Principle of operation of connection-oriented protocols (Page 603)

Description of the connection parameters (Page 595)

Ability to read back connection description parameters (Page 611)

Overview of connection configuration (Page 591)
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TSAP structure (Page 613)

Assignment of port numbers (Page 610)

Connection parameters with structure according to TCON_IP_v4

Data block for connection description 
A connection description DB with a structure according to TCON_IP_v4 is used for CPUs of 
S7-1200 V4.0 and higher and S7-1500 to assign parameters for TCP and UDP communication 
connections. The fixed data structure of the TCON_IP_v4 contains all parameters that are 
required to establish the connection. The connection description DB is automatically created 
for a new connection by the connection configuration for Open User Communication when the 
TSEND_C, TRCV_C or TCON instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the data block used.

Structure of the connection description according to TCON_IP_v4 

Byte Parameter Data type Start value Description
0 … 1 interface_id HW_ANY 64 Hardware identifier of the local interface (value range: 0 to 

65535).
 

2 … 3 id CONN_OUC 1 Reference to this connection (value range: 1 to 4095).
You must specify the value of this parameter for the 
TSEND_C, TRCV_C or TCON instruction under ID. 

4 connection_type BYTE 11 Connection type: 
● 11: TCP
● 13: UDP

5 active_established BOOL TRUE Identifier for the type of connection establishment:
● FALSE: Passive connection establishment
● TRUE: Active connection establishment

6 … 9 remote_address ARRAY 
[1..4] of 
BYTE

- IP address of the partner end point, for example, for 
192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1

10 … 
11

remote_port UINT 2000 Port address of the remote connection partner (value range: 
1 to 49151).

12 … 
13

local_port UINT 2000 Port address of the local connection partner (value range: 1 
to 49151).
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See also
Principle of operation of connection-oriented protocols (Page 603)

Description of the connection parameters (Page 595)

Ability to read back connection description parameters (Page 611)

Overview of connection configuration (Page 591)

Assignment of port numbers (Page 610)

Connection parameters with structure according to TCON_IP_RFC

Data block for connection description 
A connection description DB with a structure according to TCON_IP_RFC is used for CPUs of 
S7-1200 V4.0 and higher and S7-1500 to assign parameters to ISO-on-TCP communication 
connections. The fixed data structure of the TCON_IP_RFC contains all parameters that are 
required to establish the connection. The connection description DB is automatically created 
for a new connection by the connection configuration for Open User Communication when the 
TSEND_C, TRCV_C or TCON instruction is used.

The CONNECT connection parameter of the instance DBs for TSEND_C, TRCV_C or TCON 
contains a reference to the data block used.

Structure of the connection description according to TCON_IP_RFC 

Byte Parameter Data type Start value Description
0 … 1 interface_id HW_ANY 64 Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 id CONN_OUC 1 Reference to this connection (value range: 1 to 4095).

You must specify the value of this parameter for the 
TSEND_C, TRCV_C or TCON instruction under ID. 

4 connection_type BYTE 12 Connection type: ISO-on-TCP
5 active_established BOOL TRUE Identifier for the type of connection establishment:

● FALSE: Passive connection establishment
● TRUE: Active connection establishment

8 … 
11

remote_address ARRAY 
[1..4] of 
BYTE

- IP address of the partner end point, for example, for 
192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1
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Byte Parameter Data type Start value Description
12 … 
45

remote_tselector TSelector - TSelector of the remote connection partner:
● TSelLength = Value range 0 to 32 as UINT
● TSel[1-32] = Value range each 0 to 255 in bytes

46 … 
79

local_tselector TSelector - TSelector of the local connection partner:
● TSelLength = Value range 0 to 32 as UINT
● TSel[1-32] = Value range each 0 to 255 in bytes

See also
Principle of operation of connection-oriented protocols (Page 603)

Description of the connection parameters (Page 595)

Ability to read back connection description parameters (Page 611)

Overview of connection configuration (Page 591)

TSAP structure (Page 613)

Assignment of port numbers

Introduction
When an Open User Communication is created, the value 2000 is automatically assigned as 
the port number.

Permissible values for port numbers are 1 to 49151. You can assign any port number within 
this range. However, because some ports may already be used depending on the system, port 
numbers within the range from 2000 to 5000 are recommended.

 

 Note

Port numbers must be unique. The connection configuration or a corresponding block call is 
rejected with an error if the port numbers are assigned twice. 

 

Overview of port numbers 
The following table summarizes the system reactions to various port numbers.

Port no. Description System reaction
2000 … 5000 Recommended range No warning, no error message on entry

Port number is permitted and accepted
1 … 1999, 5001 … 49151 Can be used, but is outside the 

recommended range
Warning message on entry
Port number is permitted and accepted
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Port no. Description System reaction
0, 20, 21, 25, 80, 102, 135, 161, 34962 
… 34964

Can be used conditionally*

53, 80, 102, 135, 161, 162, 443, 520, 
9001, 34962 … 34964

Can be used conditionally**

* Ports defined for specific functions:
0: ANY - Port number is automatically assigned by S7-1500 CPU as value (>49151)
20: FTP data transmission
21: FTP control
25: TMAIL_C (Simple Mail transfer protocol)
80: Web server
102: ISO-on-TCP (RFC1006)
135: DCE Endpoint Mapper for PROFINET
161: SNMP (Simple Network Management Protocol)
34962 ... 34964: PROFINET

 

 Note

The user usually specifies the value 0 for the local port on the active connection end point 
for UDP/TCP. In this case, the CPU operating system selects the next available port above 
49151. The partner port usually has the default 0 with the passive connection end point. The 
corresponding parameter is disabled in the connection configuration.

 

** These ports are disabled depending on the function scope of the CPU in use. The 
documentation of the respective CPUs provides the assignment of these ports.

See also
Description of the connection parameters (Page 595)

Creating and assigning parameters to connections (Page 599)

Ability to read back connection description parameters

Changing parameter values in the connection description   
The connection description for exactly one connection of the Open User Communication is 
entered from the connection configuration in the connection description DB.

You can change the parameter values of the connection description DB outside of the 
connection configuration in the user program. Connection description DBs containing values 
you changed subsequently can be read back from the connection configuration. Under 
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"Properties > Configuration > Connection parameters", the inspector window displays only the 
connection parameters stored in the connection description DB.

 

 Note

You can only change the values in the running user program if the instructions TCON, 
TSEND_C or TRCV_C are not being processed and the referenced connection is not 
established.

 

The connection configuration does not support nested entries of connection descriptions in 
DB types that can only be found via offset referencing (for example, Global-DB).

The structure of the connection description cannot be changed.

Ability to read back individual connection parameters   
For the "Address" parameter of the communication partner in a TCP or ISO-on-TCP 
connection, its IP address is displayed from the "rem_staddr" parameter of the connection 
description.

The following values can also be reloaded from the connection description:

● Connection type

● Local connection ID

● Active/passive connection establishment (only with UDP)

● Local TSAP (ISO-on-TCP only)

● Partner TSAP (ISO-on-TCP only)

● Local port (only with TCP and UDP)

● Partner port (only with TCP)

The values of the connection ID parameters of the communication partner, the connection 
data, as well as the connection establishment, are not included in the connection description 
in the local connection description DB. Consequently, these parameters cannot be displayed 
when the connection configuration is reopened. The connection establishment of the partner 
results from the local connection establishment and is therefore also displayed.

A new communication partner can be selected at any time in the "Partners" drop-down list box.

When a CPU recognized in the project is selected as a specified communication partner, the 
entry options for the connection ID and the connection data are shown again.

See also
Connection parameters with structure according to TCON_Param (Page 605)

Description of the connection parameters (Page 595)
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TSAP structure

Introduction   
For an ISO-on-TCP connection, Transport Service Access Points (TSAPs) must be assigned 
for both communication partners. TSAP IDs are assigned automatically after an ISO-on-TCP 
connection is created. To ensure the uniqueness of TSAP IDs within a device, you can change 
the preassigned TSAPs in the connection parameter assignment.

Structure of TSAPs     
You must comply with certain rules when assigning TSAPs. A TSAP must contain a certain 
number of bytes, which are able to be displayed and entered as hexadecimal values (TSAP-
ID) or as ASCII characters (ASCII-TSAP):

Entries or changes of the TSAP-ID or the ASCII-TSAP in the corresponding entry fields always 
take effect in the other display format as well.

If a TSAP contains no valid ASCII characters, the TSAP is displayed only as TSAP-ID and not 
as ASCII-TSAP. This is the case after a connection is created. The first two hex characters as 
TSAP-ID identify the communication type and the rack/slot. Because these characters are not 
valid ASCII characters for a CPU, the ASCII-TSAP is not displayed in this case.

In addition to the rules for length and structure of TSAPs, you must also ensure the uniqueness 
of the TSAP-ID. The assigned TSAPs are not automatically unique.
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Length and content of TSAPs
A TSAP is structured as follows:

● TSAP-ID with TSAP extension
Length = 2 to 16 bytes
x_tsap_id[0] = 0xE0 (Open User Communication)
x_tsap_id[1] (bits 0 to 4) = slot number of CPU
x_tsap_id[1] (bits 5 to 7) = rack number of CPU
x_tsap_id[2...15] = any characters (TSAP extension, optional)
(x = loc (local) or x = rem (partner))

● TSAP-ID as ASCII-TSAP
Length = 3 to 16 bytes
x_tsap_id[0 to 2] = 3 ASCII characters (0x20 to 0x7E)
x_tsap_id[3...15] = any characters (optional)
(x = loc (local) or x = rem (partner))

The following table shows the schematic structure of a TSAP-ID:

TSAP-ID tsap_id_len tsap_id[0] tsap_id[1] tsap_id[2..15] tsap_id[3..15]
...with extension 2...16 bytes 0xE0 0x01 or

0x02 or
0x00*

Extension
(optional)

Extension
(optional)

...as ASCII-TSAP 3...16 bytes 0x20...0x7E 0x20...0x7E 0x20...0x7 Any
(optional)

*An S7-1200/1500 CPU is normally inserted on rack 0 and slot 1, and an S7-300/400 CPU on 
rack 0 and slot 2. For this reason, hex value 01 or 02 is valid for the second position of the 
TSAP-ID with extension. If the connection partner is an unspecified CPU, for example, a third-
party device, the hex value 00 is also permissible for the slot address.

 

 Note

For unspecified communication partners, the local TSAP-ID and the partner TSAP-ID can 
have a length of 0 to 16 bytes, in which all hex values from 00 to FF are permitted.

 

ASCII code table for entry of ASCII TSAPs       
For entry of an ASCII-TSAP in the connection parameter assignment, only hexadecimal values 
from 20 to 7E are permitted:

Code ..0 ..1 ..2 ..3 ..4 ..5 ..6 ..7 ..8 ..9 ..A ..B ..C ..D ..E ..F
2..  ! " # $ % & ’ ( ) * + , - . /
3.. 0 1 2 3 4 5 6 7 8 9 : ; < = > ?
4.. @ A B C D E F G H I J K L M N O
5.. P Q R S T U V W X Y Z [ \ ] ^ _
6.. ` a b c d e f g h i j k l m n o
7.. p q r s t u v w x y z { | } ~  
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See also
Examples of TSAP assignment (Page 615)

Description of the connection parameters (Page 595)

Creating and assigning parameters to connections (Page 599)

Examples of TSAP assignment
The following examples show the processing of the TSAPs for CPUs of the S7-1200/1500 
(CPU on slot 1) under various points of view: 

● Example 1: Creating a new connection for PLC-PLC communication

● Example 2: Entry of a local ASCII-TSAP

● Example 3: Entry of a TSAP extension in the TSAP-ID

● Example 4: Incorrect editing of the TSAP-ID

● Example 5: Entry of an ASCII-TSAP via the "TSAP-ID" entry field

Example 1: Creating a new connection for PLC-PLC communication
Once you have created a new connection with two PLCs for the Open User Communication, 
the TSAP extension "ISOonTCP-1" is assigned automatically.

This TSAP extension produces the TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31, which is 
entered automatically in the connection description DB and in the entry fields of the local and 
the partner TSAP. The entry fields of the ASCII-TSAPs remain empty:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

You can change the values in the entry fields of the TSAP-ID and the ASCII-TSAP at any time. 

The entry field of the TSAP-ID shows the complete TSAP stored in the data block of the 
connection description. The TSAP-ID with TSAP extension, which is limited to 16 characters, 
is not displayed in the "TSAP (ASCII)" entry field because the character E0 does not represent 
a valid character for the ASCII-TSAP.

If the displayed TSAP-ID is a valid ASCII-TSAP, it is displayed in the "TSAP (ASCII)" entry 
field.

Changes in the entry fields for TSAP-ID and ASCII-TSAP affect the other field.

Example 2: Entry of a local ASCII-TSAP
If you have created a new connection and assigned an ASCII value for the local TSAP in the 
"TSAP (ASCII)" entry field, for example, "ISOonTCP-1", the resulting TSAP-ID is created 
automatically.

When you exit the "TSAP (ASCII)" entry field, the number of ASCII characters is checked 
automatically for compliance with the limit (3 to 16 characters) and the resulting TSAP-ID is 
entered into the corresponding entry field:
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 Local TSAP Partner TSAP
TSAP (ASCII) ISOonTCP-1  
TSAP-ID 49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

Example 3: Entry of a TSAP extension in the TSAP-ID
If, following creation of a connection and entry of an ASCII-TSAP (see examples 1 and 2) in 
the entry field of the local TSAP-ID, you add the prefix "E0.01" to the TSAP value, the ASCII-
TSAP will no longer be displayed when the entry field is exited.

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID E0.01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

Once you have exited the entry field of the TSAP-ID, a check is performed automatically to 
determine whether the first character of the TSAP-ID is a valid ASCII character. Since the 
character "E0" now present in the TSAP-ID is not a valid character for the ASCII-TSAP, the 
"TSAP (ASCII)" entry field no longer displays an ASCII-TSAP.

If a valid ASCII character is used, the check for compliance with the length specification of 2 
to 16 characters follows.

Example 4: Incorrect editing of the TSAP-ID
If you remove the hex value "E0" from a TSAP-ID beginning with "E0.01", the TSAP-ID now 
begins with "01" and therefore no longer complies with the rules and is invalid:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID 01.49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

After the entry field is exited, a message is output because the TSAP-ID is neither a valid ASCII-
TSAP (this would have to have a hex value in the range from 20 to 7E as the first value) or a 
valid TSAP-ID (this would have to have the identifier "E0" as the first value).

Example 5: Entry of an ASCII-TSAP via the "TSAP-ID" entry field
If you remove the value "01" in addition to the value "E0" from the incorrect TSAP-ID in example 
4, the TSAP-ID begins with the hex value 49. This value is within the permissible range for 
ASCII-TSAPs:

 Local TSAP Partner TSAP
TSAP (ASCII)   
TSAP-ID 49.53.4F.6F.6E.54.43.50.2D.31 E0.01.49.53.4F.6F.6E.54.43.50.2D.31

When you exit the entry field, the TSAP-ID is recognized as a valid ASCII-TSAP and the 
resulting ASCII-TSAP "ISOonTCP-1" is written to the "TSAP (ASCII)" entry field.
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See also
TSAP structure (Page 613)

Description of the connection parameters (Page 595)

Communication via PUT and GET instructions

Basic information on communication via the PUT/GET instruction

Basic information on PUT/GET instructions   
Use PUT and GET instructions to exchange data between two CPUs via an S7 connection.

The GET instruction is used to read data from a partner CPU. The PUT instruction is used to 
control the writing of tags by the communication partner via the user program. Apart from the 
PUT and GET instructions, no additional communication functions are provided for reading 
and writing tags.

To simplify the use of the two instructions, specify all required parameters for the connection 
and all block parameters in the Inspector window of the program editor.

Requirement   
To be able to use the PUT and GET instructions, the following requirements must be satisfied:

● At least one S7-1200/1500 CPU or S7-300/400 CPU must be created in the project. 
Firmware 2.0 or higher must be installed on an S7-1200 CPU. If you have not yet created 
a second CPU in the project, you can initially establish the connection to an unspecified 
partner.

● An S7 connection must exist between the two CPUs. If you have not yet established a 
connection between two CPUs, a connection is automatically established during the 
configuration of the instructions.

● For both instructions, an instance data block is required in which all data used by the 
instruction is stored. The instance data block is created automatically as soon as you drag 
a PUT or GET instruction to a network in the program editor. For the correct execution of 
the program, it is essential that the instance data blocks are not changed; consequently, 
these data blocks are know-how protected. You only have read access to the instance data 
blocks.

See also
Overview of connection configuration (Page 618)

Assigning parameters to start request (Page 623)

PUT: Set parameters for write and send area (Page 624)

GET: Set parameters for read and memory area (Page 625)
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Connection configuration

Overview of connection configuration

Introduction   
The connection parameters for the PUT and GET instructions are assigned in the inspector 
window of the program editor. All parameters are saved in the corresponding instance data 
block.
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Structure of the connection configuration
The connection configuration is made up of the following components:

① Communication instruction for PUT or GET
② Call of online and diagnostic functions
③ "Configuration" tab in the "Properties" tab
④ Area navigation of the "Configuration" tab
⑤ General properties of the connection parameters

Display of online and diagnostic functions
If you click the icon for starting the online and diagnostic functions, the associated CPU goes 
online automatically. The connection table in the network view is opened. In addition, the 
"Diagnostics" tab and the connection information are displayed in the inspector window.
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Entering the connection parameters
Enter the desired connection parameters in the "Configuration" tab. The area navigation of the 
"Configuration" tab includes the "Connection parameters" group. This group contains the 
connection configuration. Here, you can enter the parameters for the connections using system 
functions. When all the required parameters are assigned, a check mark is set behind the 
"Connection parameters" group in the area navigation.

See also
Assigning parameters to start request (Page 623)

PUT: Set parameters for write and send area (Page 624)

GET: Set parameters for read and memory area (Page 625)

Description of the connection parameters

Overview 
The following table shows the general connection parameters:

Parameter Description
End point The names of the local end point and the partner end point are shown.

● Local end point
The local end point is the CPU in which the PUT or GET instruction is programmed.

● Partner end point
The partner end point is selected from the drop-down list. The drop-down list shows all 
available possible connection partners including unspecified connection partners for 
devices whose data is unknown in the project.
As long as no connection partner is set, all other parameters in the mask are disabled.

Interface The interface of the partner CPU is displayed. The partner interface is not displayed until a 
specified partner CPU has been selected.

Interface type The type of interface via which communication is handled is displayed.
Subnet name The subnet of the local end point is displayed, provided this exists. The partner subnet is 

displayed only after the partner end point has been selected.
If at least one of the two connection partners is not connected with a subnet, the two 
connection partners are automatically connected with each other. The partner which is not 
connected to a network is hereby connected to the same subnet via which the other partner 
is already connected to a network.
A connection of connection partners to different subnets is only possible with IP or S7 routing. 
The IP routing settings can be edited in the properties of the relevant Ethernet interfaces.

Address The IP address of the local end point is displayed. The IP address of the partner is displayed 
only after the partner end point has been selected.
If you have selected an unspecified connection partner, the input box is empty and has a red 
background. In this case, you will need to specify a valid IP address for the connection partner.

Connection ID The currently set connection ID is displayed. You can change the connection ID in the 
connection table in the network view. You can also directly access the connection table while 
you are setting the connection parameters. To do this, click the "Create new connection" icon.
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Parameter Description
Connection name The name of the connection which was automatically created when the PUT/GET instruction 

was inserted is displayed. You can change the name of the connection by entered a different 
name in the field. You can also create a new connection or edit existing connections by 
clicking the "Create new connection" icon.

Active connection 
establishment

Use the "Active connection establishment" option button to specify which partner starts the 
communication. When the connection is created, the local partner is initially specified by 
default for the establishment of the connection. If a device does not support active connection 
establishment, you have to activate active connection establishment on the other partner.

Configured at one end If this check box is selected, the connection partner is the server for this connection. It cannot 
actively send or receive. This corresponds to the behavior of the PUT/GET instructions. In 
this case, other instructions are not possible. If the check box is not selected, other 
instructions can also be used for the communication.

Starting connection parameter assignment
You can assign the connection parameters for PUT and GET in the inspector window as soon 
as you have inserted and selected a PUT or GET instruction in a program block.

Procedure     
To insert PUT/GET instructions, follow these steps:

1. Open the "Instructions" task card in the "Communication > S7 Communication" folder.

2. Drag a PUT or GET instruction to a network.
The "Call options" dialog opens.

3. Optional: Edit the properties of the instance DB in the "Call properties" dialog. You have 
the following options:

– Change the default name.

– Select the "Manual" check box to assign your own number.

4. Click "OK".

Result
A corresponding instance data block is created for the inserted PUT or GET instruction. For 
S7-300 CPUs, a function block is also created in the program resources.

When PUT or GET instruction is selected, you will see the "Configuration" tab under 
"Properties" in the inspector window. The "Connection parameters" group in area navigation 
contains the connection parameter assignment that you can now make.

See also
Creating and assigning parameters to connections (Page 622)

Deleting connections (Page 623)
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Creating and assigning parameters to connections
You can create S7 connections and assign the parameters for these in the connection 
parameter assignment of the PUT/GET instructions. Changed values are checked immediately 
by the connection parameter assignment for input errors.

Requirement
A CPU exists with a PUT or GET communication instruction.

Procedure  
To configure an S7 connection using PUT/GET instructions, follow these steps:

1. In the program editor, select the call of the PUT or GET instruction.

2. Open the "Properties > Configuration" tab in the inspector window.

3. Select the "Connection parameters" group. Until you select a connection partner, only the 
empty drop-down list for the partner end point is enabled. All other input options are 
disabled.
The connection parameters already known are displayed:

– Name of the local end point

– Interface of the local end point

– IP address of the local end point

4. In the drop-down list box of the partner end point, select a connection partner. You can 
select an unspecified device or a CPU in the project as the communications partner.
The following parameters are automatically entered as soon as you have selected the 
connection partner:

– Interface of the partner end point

– Interface of the partner end point. If several interfaces are available, you can change 
the interface as required.

– Interface type of the partner end point

– Subnet name of both end points

– IP address of the partner end point

– Name of the connection which is used for the communication. If no connection exists 
yet, it is automatically established.

5. If required, change the connection name in the "Connection name" input box. If you want 
to create a new connection or edit an existing connection, click on the "Create new 
connection" icon.

 

  Note

The PUT and GET instructions between two communication partners can only run if both 
the hardware configuration and the program part for the partner end point have been 
loaded into the hardware. To achieve fully functional communication, make sure that you 
load not only the connection description of the local CPU on the device but also that of 
the partner CPU as well.
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Deleting connections
A connection which was automatically created during the insertion of a PUT or GET instruction 
appears in the connection table of the network view like every standard connection. As a result, 
it can be deleted in the connection table. 

Procedure  
To delete a connection, follow these steps:

1. Open the connection table in the network view.

2. In the connection table, select the connection that you want to delete.

3. To do this, right-click the connection and select the "Delete" command from the shortcut 
menu.

Result
The connection is deleted. The PUT or GET instruction and the associated instance data blocks 
are retained and must be manually deleted if necessary.

To continue using the PUT or GET instruction, you must configure the connection again in the 
inspector window of the program editor, since all connection parameters were also deleted 
when the connection was deleted. In this case, specify a new communication partner and a 
suitable connection. 

Block parameter assignment

Assigning parameters to start request
To start communication via the PUT or GET instruction, you have to specify an event which 
activates the instruction. This event is referred to as control parameter (REQ). The 
communication job is activated as soon as there is a positive edge at the control parameter 
REQ.

Please note that the control parameter REQ is assigned the default FALSE at first call.

Requirement
● The program editor is open.

● You have already inserted a PUT or GET instruction.

● A connection has been established between two communication partners.

Procedure
To define the REQ control parameter, follow these steps:

1. Select the PUT or GET instruction in the program editor.

2. Open the "Configuration" tab in the inspector window.
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3. Select the "Block parameter assignment" entry in the area navigation.

4. In the "REQ" field, select a tag of the "BOOL" data type to initialize the execution of the 
instruction. Alternatively, you can also interconnect a previous instruction in the program 
editor.

See also
PUT: Set parameters for write and send area (Page 624)

GET: Set parameters for read and memory area (Page 625)

PUT: Set parameters for write and send area
For communication via the PUT instruction, you must specify the memory area of the partner 
CPU to which the data should be written. In addition, you must specify the memory area of the 
local CPU from which the data is to be read.

Requirement
● The program editor is open.

● You have already inserted a PUT instruction.

● A connection has been established between two communication partners.

Procedure
To specify the read and the memory area for the instruction, follow these steps:

1. Select the PUT instruction in the program editor.

2. Open the "Configuration" tab in the inspector window.

3. Select the "Block parameter assignment" entry in the area navigation.

4. In the "In/Outputs > Write area (ADDR_1) > Start" field, select a "REMOTE" data type 
pointer to the area of the partner CPU which is to be written.
Only absolute addressing is permitted.
Example: P#DB10.DBX5.0 Byte 10

5. In the "Length" field, enter the length of the write area and select the data type of the memory 
area from the drop-down list.

6. In the "In/Outputs > Send area (SD_1) > Start" field, select a pointer to the area in the local 
CPU which contains the data to be sent.

7. In the Length field, enter the length of the memory area to be read and select the data type 
from the drop-down list.
Only the data types BOOL (for a bit array, "0" must be used as address and an integer 
multiple of byte must be used as length), BYTE, CHAR, WORD, INT, DWORD, DINT, REAL, 
COUNTER, TIMER are permitted.
If the VARIANT pointer accesses a DB, the DB must always be specified (for example: 
P#DB10.DBX5.0 Byte 10).
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See also
GET: Set parameters for read and memory area (Page 625)

GET: Set parameters for read and memory area
For communication via the GET instruction, you must specify the memory area of the local 
CPU to which the data should be written. In addition, you must specify the memory area of the 
partner CPU from which the data is to be read.

Requirement
● The program editor is open.

● You have already inserted a GET instruction.

● A connection has been established between two communication partners.

Procedure
To specify the read and the memory area for the instruction, follow these steps:

1. Select the GET instruction in the program editor.

2. Open the "Configuration" tab in the inspector window.

3. Select the "Block parameter assignment" entry in the area navigation.

4. In the "In/Outputs > Read area (ADDR_1) > Start" field, select a "REMOTE" data type 
pointer to the area of the partner CPU which is to be read.
Only absolute addressing is permitted.
Example: P#DB10.DBX5.0 Byte 10

5. In the "Length" field, enter the length of the read area and select the data type of the memory 
area from the drop-down list.

6. In the "In/Outputs > Memory area (RD_1) > Start" field, select a pointer to the area in the 
local CPU in which the read data is to be stored.

7. In the Length field, enter the length of the memory area and select the data type from the 
drop-down list.
Only the data types BOOL (for a bit array, "0" must be used as address and an integer 
multiple of byte must be used as length), BYTE, CHAR, WORD, INT, DWORD, DINT, REAL, 
COUNTER, TIMER are permitted.

See also
PUT: Set parameters for write and send area (Page 624)
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8.1.3.3 Displaying and configuring topology

Overview of the topology view

Functions of the topology view   
The topology view is one of three working areas of the hardware and network editor. You 
undertake the following tasks here:

● Displaying the Ethernet topology

– Displaying all the PROFINET devices and passive Ethernet components of the project 
along with their ports

– Displaying interconnections between the ports

– Displaying corresponding logical networks

– Display diagnostic information of all ports

● Configuring the Ethernet topology

– Creating, modifying and deleting interconnections of the ports

– Renaming stations, devices, interfaces or ports

– Adding PROFINET devices and passive Ethernet components to the project from the 
hardware catalog

● Identifying and minimizing differences between the desired and actual topology

– Running an offline/online comparison of Ethernet modules, ports and port 
interconnections

– Adopting existing online topology information in the offline project
 

 Note
Devices without valid IP address

Topology information (LLDP) cannot be read from a device without valid IP address.

To prevent devices from having an invalid IP address, specify in the settings of the TIA Portal 
for hardware configuration that devices without valid IP address are temporarily assigned an 
IP address.
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Differences between network view and topology view   
● The network view shows all the logical subnets of the project.

The topology view shows all Ethernet components of the project. These include passive 
components such as switches, media converters and cables.

 

  Note

Stations with non-Ethernet components are also displayed if the station has a least one 
Ethernet component.

 

● The position of a device in the network view and its position in the topology view are not 
dependent on each other; in other words, the same device generally appears at different 
locations in the two views.

● If you open the hardware catalog in the topology view, you only see devices with an Ethernet 
interface.

Structure of the topology view
The topology view (Page 508) essentially consists of a graphic area (called the graphic view 
below) and a table area (called the table view below).

Which functions are there in the graphic view and which functions are there in the table view?
● Displaying the Ethernet topology

Function Graphic view Table view
Displaying all the PROFINET devices and passive Ethernet 
components of the project along with their ports

yes yes

Display interconnections between the ports (including type of 
medium)

yes yes

Displaying corresponding logical networks no yes
Displaying properties of the cables between the ports no yes
Display diagnostic information of all ports yes yes

● Configuring the Ethernet topology

Function Graphic view Table view
Creating, modifying and deleting interconnections of the ports ● Create: yes

● Modify: no
● Delete: yes

● Create: yes
● Modify: yes
● Delete: yes

Renaming stations, devices, interfaces or ports no yes
Adding PROFINET devices and passive Ethernet components to 
the project from the hardware catalog

yes no

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 627



● Identifying and minimizing differences between the desired and actual topology

Function Graphic view Table view
Running an offline/online comparison of Ethernet modules, ports 
and port interconnections

no yes

Adopting existing online topology information in the offline project no yes

See also
Overview of settings for hardware configuration (Page 509)

Starting the topology view

Requirement
The device or network view is open in the hardware and network editor.

Procedure
To start the topology view of your project, follow these steps:  

1. Click on the "Topology view" tab.

Or:

1. Open the network view of the hardware editor.

2. Select a PROFINET device or a PROFINET module.

3. Select the "Go to topology view" command in the shortcut menu.

Result
The graphic view of the topology view is started. If you opened the topology view using the 
shortcut menu, the selected component remains selected after the change of view.

Displaying topology

Displaying the graphic view of the configured topology

What is shown?   
The graphic view of the configured topology shows the following:

● Configured PROFINET devices and passive Ethernet components along with their ports

● Configured stations with non-Ethernet components if there is at least one Ethernet 
component in the station

● Configured interconnections between the ports
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Type of display
The way in which the graphic view of the topology view and the network view are displayed is 
very similar:

● Compared with the device view, components are shown in a simplified form.

● The interconnections between ports are shown as horizontal and vertical lines. These are 
dashed when an interconnection between a tool changer port and its possible partner ports 
is involved.

Displaying the table view of the configured topology

What is shown?   
The table view of the configured topology shows exactly the same content as the graphic view 
except for the logical PROFINET subnets.

● All the configured PROFINET devices and passive Ethernet components along with their 
ports

● All the configured stations with non-Ethernet components if there is at least one Ethernet 
component in the station

● Configured interconnections between the ports
For each port with the "Alternating partner port" property, there are as many completed 
rows as there are potential partner ports plus one empty row.

Type of display
As the name implies, the table view of the topology view consists of a table, the topology 
overview table. It is structured like the network overview table. It consists of the following 
columns:

● Device / port
This is the most important column of the table. The entries in this column have a hierarchical 
structure with the PROFINET ports being the last element in the hierarchy. You can expand 
and collapse the hierarchical entries. For a CPU, for example, an entry consists of the 
following elements:

– Station name

– Device name

– Name of the PROFINET interface

– Names of the ports

Note: All the other columns only have entries in the rows containing the port names.

● Type (as default, this column is not displayed)
Shows what type of station, device or interface the table row relates to or whether it belongs 
to a port.

● Order no. (as default, this column is not displayed)
Order no. of device
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● Subnet (as default, this column is not displayed)
Configured subnet to which the interface belongs

● Master / IO system (as default, this column is not displayed)
Shows whether or not the interface belongs to a PROFIBUS DP master system or a 
PROFINET IO system.

● Device address (as default, this column is not displayed)
Configured address of the interface in the subnet

● Partner station
Name of the station that contains the partner port

● Partner device
Name of the device that contains the partner port

● Partner interface
Interface to which the partner port belongs

● Partner port

● Cable data
Contains the cable length and the signal delay of the cable connecting the ports

Basic functions for tables
The topology overview table supports the following basic functions for editing a table:

● Displaying and hiding table columns
Note: The columns that define the configuration cannot be hidden.

● Optimizing column width

● Displaying the meaning of a column, a row or cell using tooltips.

 

Displaying the diagnostics status of ports and cables in the graphic view

Requirements
The graphic view of the topology view is open.
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Procedure  
To determine the diagnostics status of the port, follow these steps: 

1. Go online with the required component or components.

Result
The following icons are displayed:

● The corresponding diagnostics icon is displayed for each device.

● If there is an error in at least one lower-level component, the diagnostics icon "Error in lower-
level component" is also displayed in the left-hand lower corner of the diagnostics icon.

● The corresponding diagnostics icon is displayed for each port.

● Every cable between two ports that are online has the color that matches its diagnostics 
status.

You will find the possible diagnostics icons for ports and the color coding of Ethernet cables 
in the description of hardware diagnostics. See: Displaying diagnostics status and comparison 
status using icons (Page 1203)

Showing the diagnostics status of hardware components in the table view

Requirement
The table view of the topology view is open.

Procedure 
To obtain the diagnostics status of hardware components of the topology overview table, follow 
these steps: 

1. Go online with the required components.

Result
The following icons are displayed at the left-hand edge of the topology overview table in each 
row that belongs to the component involved:

● The diagnostics icon belonging to the hardware component is displayed.

● If the hardware component has lower-level components and if there is an error in at least 
one of the lower-level components, the diagnostics icon "Error in lower-level component" 
is also displayed in the left-hand lower corner of the diagnostics icon of the hardware 
component.
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For the possible diagnostics icons for hardware components, refer to the description of 
hardware diagnostics. See: Displaying diagnostics status and comparison status using icons 
(Page 1203)

 

 Note

The display of the diagnostics status of hardware components in the topology overview table 
and the network overview table is identical.

 

Running an offline/online comparison and displaying the results

Requirement
The topology view is open. There may be an online connection to one or more devices, but 
this is not actually necessary.

Procedure   
To find the differences between the configured and the actual topology, follow these steps: 

1. Click the "Offline/online comparison" button in the toolbar of the topology overview.

Result
The "Partner station", "Partner interface" and "Cable data" columns in the topology overview 
table are removed.

Two additional groups of columns are added to the right-hand side of the table and these are 
initially empty:

● On the far right, columns for the topology to be identified online are added.

● Between the columns for the offline and the online topology, the "Status", "Action" and 
"Description" columns are added to show the result of the offline/online comparison.

 

  Note

As default, the "Description" column is not displayed.
 

The following buttons are enabled in the toolbar of the table:

Button Name Meaning
Update The detection of the existing online topology is started again.

Synchronize ● Adopting the port interconnections identified online in the 
project (Page 641)

● Adopt the devices identified online in the project 
(Page 642)
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After the actual topology has been identified, the added columns are filled. These steps are 
described in more detail in the following section.

 

 Note

A difference between offline and online view is displayed for that port connected with the PG/
PC which is only available online. This is because the PG/PC cannot be configured offline.

 

Columns for the topology identified online
The following columns are displayed:

● "Device / port"

● "Type" (as default, this column is not displayed)

● "Order no." (as default, this column is not displayed)

● "IP address" (as default, this column is not displayed)

● "Partner device"

● "Partner port"

● "Cable data"

Columns for the result of the offline/online comparison
The following columns are displayed:

● "Status"
The result of the offline/online comparison is shown here in the form of diagnostics icons. 
The following icons are possible:

Diagnostics icon Meaning
Differing topology information in at least one lower-level component 

Identical topology information

Topology information only available offline or device is disabled.

Topology information only exists online

Differing topology information

 If a device does not support topology functions, the "Status" column remains 
empty.
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● "Action"
The possible actions are shown here in the form of icons. The following icons are possible:

Icon Meaning
No action possible

Adopt the interconnection found online

● "Description"
This column describes the selected action in words.

Configuring topology

Interconnecting ports

Overview

Interconnecting ports in the topology view 
In the topology view, you have the following options for interconnecting ports:

● in the graphic view (Page 635)

● in the graphic view of a tool changer (Page 637)

● in the table view (Page 636)

● in the table view of a tool changer (Page 637)

● by adopting port interconnections identified online (Page 641)

What effects does the interconnection of ports have on the network view?
 

 Note

In the properties of a subnet in the network view, you can specify that this subnet is used 
when a port interconnection is created between two devices that are not networked.

 

When you create an interconnection between two ports, the following effects are possible in 
the network view:

● If the corresponding interfaces are not networked: If you have specified a default subnet, 
this is used. Otherwise a new subnet is created to connect the two interfaces.

● If one (and only one) of the two interfaces involved is networked: The non-networked 
interface is connected to the same subnet as the already networked interface.

● In all other cases: The corresponding interfaces are not connected to a logical subnet.
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See also
Interconnecting ports (Page 1036)

Settings for interconnecting Ethernet devices (Page 562)

Interconnecting ports in the graphic view

Requirement
You are in the graphic view of the topology view.

Procedure – Creating a new interconnection between two ports   
To interconnect a port of a device with a port of another device, follow these steps:

1. Place the mouse cursor on the port you want to interconnect.

2. Click with the left mouse button and hold it down.

3. Move the mouse pointer.
The pointer now shows the networking symbol to indicate "Interconnect" mode. At the same 
time, the mouse pointer shows the lock symbol that will only disappear when the pointer is 
on a valid target.

4. Now drag the mouse cursor to the target port. You can do this while holding down or after 
releasing the mouse button.

5. Now release the left mouse button or press it again (depending on your previous action).

Result: A new port interconnection is created.
 

 Note
Creating a ring for S7-300, S7-400, and S7-1500 CPUs

If you create a ring using port interconnections for S7-300, S7-400, or S7-1500 CPUs, an 
MRP domain is created automatically.

 

Procedure – Changing an existing port interconnection without deleting it first
To do this, follow these steps:

1. Place the mouse cursor on the port of an existing interconnection that is to receive a new 
partner port.

2. Drag the port to the new partner port.

Result: The existing port interconnection is deleted. The new port interconnection is created.

Alternative procedure:

1. Place the mouse cursor on a port without an interconnection that is to be connected with 
an already interconnected port.

2. Drag the port to the already interconnected port.
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Result: The existing port interconnection is deleted. The new port interconnection is created.

Procedure – Interconnecting two interconnected ports with each other without first deleting the two 
existing port interconnections

To do this, follow these steps:

1. Place the mouse cursor on the interconnected port that is to receive a new partner port.

2. Drag the port to the new partner port that is also interconnected already.

Result: The two existing port interconnections are deleted. The new port interconnection is 
created.

Interconnecting ports in the table view

Which actions are possible with port interconnections in the table view?
The following actions are possible with port interconnections in the table view:

● Creating a new port interconnection

● Changing an existing port interconnection

● Deleting an existing port interconnection

Requirement
The row with the port whose interconnection you want to create, modify or delete is visible in 
the topology overview.

Procedure 
To create the interconnection of a port for the first time, to modify it or delete it, follow these 
steps:

1. Move the mouse pointer to the "Partner port" column in the row of the source port.

2. Click the drop-down list there.

3. Select the required partner port (when creating or changing a port interconnection) or the 
"Not interconnected" entry (when deleting a port interconnection).

Result
The required action is performed. The new partner port (after creating or modifying a port 
interconnection) or the "Select port" entry (after deleting a port interconnection) is displayed 
in the "Partner port" column.
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Interconnecting a port with more than one partner port in the graphic view

Requirement
● You have configured a port of a PROFINET device with the "Alternative partners" property 

and have specified its possible partner ports.

● The graphic view of the topology view is open.

Procedure 
1. Interconnect this port (referred to hereafter as source port) with one of the partner ports 

you have specified (referred to hereafter as target port).

2. Interconnect the source port with an additional target port.
You can do this in several ways:

– Drag the mouse pointer from a partner port that is already interconnected to a target 
port.

– Drag the mouse pointer from an interconnection that has already been created to a 
target port.

– Drag the mouse pointer from a target port to a partner port that is already interconnected.

– Drag the mouse pointer from a target port to an already created interconnection.

3. If necessary, repeat the step above one or more times.

Result
An interconnection is created between the source port and the alternative partner ports. This 
is indicated by a dashed line.

Interconnecting a port with more than one partner port in the table view

Which actions are possible with port interconnections to several partner ports in the table view?
When working with a tool changer, the following actions can be performed with port 
interconnections to multiple partner ports in the table view:

● Creating a new port interconnection

● Changing an existing port interconnection

● Deleting an existing port interconnection

Requirement
● You have configured a port of a PROFINET device with the "Alternative partners" property 

and have specified its possible partner ports.

● The row with the port whose interconnection you want to create, modify or delete is visible 
in the topology overview.
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Procedure  
To create the interconnection of a port to one or more partner ports for the first time, to modify 
it, or to delete it, follow these steps:

1. Move the mouse pointer to the "Partner port" column in the row of the source port.

2. Click the drop-down list there.

3. Select the required partner port (when creating or changing a port interconnection) or the 
"Not interconnected" entry (when deleting a port interconnection).

Result
The required action is performed:

● If you are creating an interconnection, a new row is inserted in the topology overview table. 
The new partner port is displayed there in the "Partner port" column.

● If you change an interconnection, the new partner port is displayed in the "Partner port" 
column.

● If you delete an interconnection, the row with the previous port interconnection is deleted.
 

  Note

With a tool changer, there are normally several rows for a port with port interconnections 
to more than one partner port. The last row is always an empty row. The first row can be 
edited, all other rows are read-only.

 

Renaming stations, devices, interfaces or ports

Rename a station, a device, an interface or a port

Requirement
The table view of the configured topology is open.

Procedure        
To rename a station, a device, an interface or a port, proceed as follows:

1. Click twice in the relevant field of the topology overview table (the second click starts the 
editing mode).

2. Enter the new name and then press the ENTER key (this closes editing mode).

Result
The object is renamed.

 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
638 System Manual, 02/2014



Offline/online comparison

Automatic assignment of devices by offline/online comparison

Overview  
During the offline/online comparison, the configured topology is compared with the actual 
existing topology. Devices identified online are automatically assigned to configured devices 
as far as this is possible.

Start of availability detection
You start the availability detection the first time by clicking the "Compare offline/online" button 
in the toolbar of the topology overview.

You restart availability detection by clicking the "Update" button.
 

 Note

The availability detection can take several seconds. During this time, no user input is possible.
 

Automatic assignment
A device identified online is automatically assigned to a configured device if the following 
properties of the two devices match up:

● Device name

● Order number

● Number of ports

The following section describes the situations that can occur and what action you can take:
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● Identical port interconnections
This is the ideal situation. No action is necessary here.

"Action" column Meaning
No action

● There are interconnections for the identified and configured device, there are however 
differences.
The following actions are possible:

– If it is possible to adopt the online configuration

"Action" column Meaning
Adopt online interconnection (Page 641)

No action

– If it is not possible to adopt the configuration

"Action" column Meaning
No action

● The interconnection only exists online.
The following actions are possible:

– If it is possible to adopt the online configuration

"Action" column Meaning
Adopt online interconnection (Page 641)

No action

– If it is not possible to adopt the configuration

"Action" column Meaning
No action

● The interconnection only exists in the configuration.
The following actions are possible:

"Action" column Meaning
Adopt the online interconnection (Page 641), in other words, the 
interconnection in the configuration will be deleted
No action
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No automatic assignment
In the following situations, no automatic assignment is possible:

● No device can be identified online to match a configured device. In this case the 
corresponding columns in the "Online topology" area of the topology overview table are 
empty.
In this case, you should add the already configured device to your system or delete the 
configured device from the configuration.

● A device identified online cannot be assigned to any configured device. In this case the 
corresponding columns in the "Offline topology" area of the topology overview table are 
empty.
In this case, you can adopt the device identified online in the project (Page 642).

Adopting the port interconnections identified online in the project

Requirement
You have run an offline/online comparison in the topology view. The result of this is that at 
least one device identified online was automatically assigned to a configured device, but that 
there are differences relating to the interconnection.

Procedure   
To adopt one more port interconnections identified online in the project manually, follow these 
steps: 

1. Select the value "Adopt" in the "Action" column for a port of a configured device to which 
a device identified online was assigned.

2. Repeat the step if necessary for other ports of the same configured device.

3. Repeat the steps up to now if necessary for other configured devices to which devices 
identified online were assigned and for which there are differences relating to the 
interconnection.

4. Click the "Synchronize" button.

Result
The port interconnections identified online and the cable information for the corresponding 
devices are adopted in the project. Successful adoption is indicated by the diagnostics icon 
"Identical topology information" for each port.

 

 Note

If other port interconnections are recognized for a device identified online and these differ 
from those that exist in the project, adopting these in the project means that the port 
interconnections that were previously in the project are replaced by those identified online. 
If no port interconnections are detected for a device identified online, adopting in the project 
means that all the port interconnections of this device are deleted in the project.
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Adopt the devices identified online in the project

Requirements
You have run an offline/online comparison in the topology view. The result of this is that at 
least one device identified online could not be assigned to any configured device.

Procedure  
To adopt one more devices identified online in the project manually, follow these steps: 

1. For a configured device without an online partner, move the mouse pointer to the "Device/
port" column of the online topology.

2. Select the device you want to assign to the configured device from the drop-down list of 
this box.

3. Repeat the previous steps if necessary for other configured devices without an online 
partner.

Result
The selected device that was identified online is moved up from the end of the table. Following 
this, it is in the row of the configured device to which you have just assigned it.

8.1.3.4 Industrial Ethernet Security

Configuring security

General

Supported devices

Supported devices
Security functions can be configured for the following products:

● SCALANCE S:

– S602 V2/V3/V4

– S612 V2/V3/V4

– S613 V2

– S623 V3/V4

– S627-2M V4

● SOFTNET Security Client:

– SOFTNET Security Client V4
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● S7-CPs: CP 343-1 GX31 Advanced, CP 443-1 GX30 Advanced, CP 1543-1

● PC CP: CP 1628 

● Mobile wireless router: SCALANCE M875

General terminology "security module"
In this section of the information system, the following products are grouped together under 
the term "security module": SCALANCE S602 / SCALANCE S612 / SCALANCE S613 / 
SCALANCE S623 / SCALANCE S627-2M, CP 343-1 GX31 Advanced, CP 443-1 GX30 
Advanced, CP 1543-1, CP 1628, SCALANCE M875.

Use of the terms "interface" and "port"
In this documentation, the following terms are used for the ports of SCALANCE S modules:

● "External interface": The external port of the SCALANCE S602 / S612 / S623 or an external 
port of the SCALANCE S627-2M (marked red)

● "Internal interface": The internal port of the SCALANCE S602 / S612 / S623 or an internal 
port of the SCALANCE S627-2M (marked green)

● "DMZ interface": The DMZ port of the SCALANCE S623 / S627-2M (marked yellow)

The term "port" itself is used when the focus of interest is a special port of an interface.

General use of the term "CP x43-1 Adv." 
In this documentation, the term "CP x43-1 Adv." includes the following products: CP 343-1 
GX31 Advanced / CP 443-1 GX30 Advanced.

Structure of this section of the help system
Topics that are relevant to all security modules can be found in the "General" section. 
Information that is only relevant to certain module types can be found in the sections relating 
specifically to these modules.

Overview - Scope of performance and method of operation

General use of the term "STEP 7"
Configuration of security functions is supported as of STEP 7 V12. For this reason, in this 
section of the information system, the name "STEP 7" will be used for all versions of STEP 7 
V12 or higher.
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Scope of performance
You can use the following security functions in STEP 7:

● Configuration of the security modules

● Creating VPN configuration data for SOFTNET Security Client V4

● Creating VPN configuration data for SCALANCE M875

● Test and diagnostics functions, status displays

Offline configuration view and online diagnostics view       
The security functions are configured in two views:

● Offline configuration view
In the offline configuration view, you create the configuration data for the security modules 
and the SOFTNET Security Client. Prior to downloading, there must already be a 
connection to the security modules.

● Online diagnostics view
The online diagnostics view is used for diagnostics of the security module and, among other 
things, allows you to run firmware updates.

How it works - security and consistency
● Access only for authorized users

The security functions of every project are protected from unauthorized access by assigning 
user names and passwords.

● Consistent project data
Consistency checks are running even while you make the entries in the dialogs. In addition, 
cross-dialog, project-wide consistency checks are carried out.
Only consistent project data can be downloaded to the security modules.

● Protecting project data by encryption 
The project and configuration data relevant to security are protected by encryption. 
Depending on the security module, data can be stored in the project and/or on the C-PLUG.
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User interface - layout and menu commands

User interface for security functions in STEP 7
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① Global security settings

The global security settings are located in the project navigation. These security settings can be configured 
independently of the module and subsequently assigned to individual security modules as required. If the first 
security module to be configured is a CP, the global security settings are only displayed when the security functions 
have been enabled in the local security settings of the CP. If the first security module to be configured is a SCALANCE 
S module, the global security settings are displayed after logging in to the security project. The following main folders 
and entries are available in the global security settings:
● User login

For the security configuration within a project, there is a separate user management. Log in to the security 
configuration using the "User login" entry. The first time that there is a login to the security configuration, a user 
with the system-defined role "Administrator" is created automatically. You can create further users in the security 
configuration in the user management.

● User administration
In user administration, you can create users, define rights for roles and assign these roles to users.

● Certificate manager
In the certificate manager, you see an overview of all the certificates used in the project. You can, for example, 
import new certificates as well as export, modify or replace existing certificates.

● Firewall
Under the "Firewall" entry, you can define global IP and MAC firewall rule sets and user-specific IP rule sets 
(SCALANCE S modules only) and assign security modules. IP and MAC service definitions are used to define 
the IP and MAC firewall rules compactly and clearly.

● VPN groups
All created VPN groups are contained in this folder. You can create new VPN groups here and assign security 
modules to these VPN groups. You can also adapt VPN group properties of VPN groups that have already been 
created.

● NTP
Here, you can create NTP servers and assign them to one or more security modules. This ensures that time 
synchronization is performed through the assigned NTP server. Unsecured NTP servers can only be configured 
in the local security settings.
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② Working area with security module

Once you have selected a security module in the work area, you can configure its local security settings in 
"Properties" > "General". If the selected security module is in a VPN group, related information is displayed in the 
VPN tab.

③ VPN tab

This tab displays information about all the VPN groups to which the security module that was selected in the working 
area belongs. Information about the respective participants of a VPN group can be displayed and hidden.
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④ Local security settings

Local security settings are configured for a specific security module. After a security module has been selected in 
the working area, its local security settings are available in the inspector window under "Properties" > "General".
 
Note for CPs:
Before security settings can be configured for CPs, the local security settings must be enabled. To do this, log in to 
your security project and then in the Inspector window, select the "Activate security features" check box under 
"Properties" > General" > "Security". The local security settings are then displayed below the "Security" entry. When 
the check box is selected, the following settings (assuming they were enabled) are migrated automatically to the 
local security settings.
CP x43-1 Advanced:
● SNMP
● FTP configuration
● Time-of-day synchronization
● Web server
● Entries of IP access lists
 
CP 1543-1:
● SNMP
● FTP configuration
● Time-of-day synchronization
 
CP 1628:
● SNMP
● Time-of-day synchronization
 
In addition, firewall rules that enable a connection to be established are created automatically for configured 
connections. Log settings are available to record blocked packets.

Secure and non-secure configuration areas
The user interface can be divided into secure and non-secure configuration areas.

The secure areas are areas in which configuration is possible only after logging in to the 
security configuration. These areas are encrypted and therefore only accessible to persons 
authorized in the user management even if the project is accessible to a wider circle of people.

Functions from the non-secure areas, on the other hand, can be configured without logging in 
to the security configuration. The correctness of the settings must be checked before 
downloading the project to the plant components if a wider circle of people can make 
modifications to the project.
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Below, you will find a list of the configuration areas of the user interface showing which areas 
are secure and which are non-secure. To some extent, this depends on the security module 
for which the configuration is created.

● All settings from the global security settings are secure.

● Secure and non-secure configuration areas for SCALANCE S modules:

– All the settings for the interfaces and ports, in particular IP addresses, are non-secure.

– The settings under the entry "General" in the local security settings are non-secure.

– Higher-level settings (e.g. MRP settings such as MRP manager etc.) that are not 
configured on the security module itself but may affect the security module are non-
secure. This does not relate to the global security settings.

– The other settings are protected.

● Secure and non-secure configuration areas for CP 343-1 GX31 Advanced, CP 443-1 GX30 
Advanced, CP 1628, CP 1543-1:

– All settings outside the "Security" entry are non-secure.

– Higher-level settings (e.g. MRP settings such as MRP manager, PROFINET settings, 
connections etc.) that are not configured on the security module itself but may affect the 
security module are non-secure. This does not relate to the global security settings.

– All the settings for the interfaces and ports, in particular IP addresses, are non-secure.

– All settings below the "Security" entry are secure.

Running a consistency check

Overview
The following consistency checks are available:

● Local consistency checks

● Project-wide consistency checks

In the individual dialog descriptions in this help system, the rules you need to take into account 
for your entries are listed under the keyword "Consistency check".

Local consistency checks   
A consistency check is local when it can be performed directly within a dialog. With the following 
actions, local consistency checks are made:

● After exiting a box

● After exiting a row in a table

● When you confirm a dialog with OK.
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Project-wide consistency checks   
Project-wide consistency checks provide you with information indicating whether or not project 
data is correctly configured. With the following actions, there is a consistency check through 
the entire project:

● When compiling a configuration

● When downloading a configuration
 

 Note

You can only download configured data to a security module when the entire project is 
consistent.

 

Managing certificates

Overview of certificates

How do you manage certificates?
In the certificate manager, you have an overview of all the certificates, for example, CA 
certificates used in the project with information about the applicant, issuer, validity, use and 
the existence of a private key. 

The CA certificate is issued by a certificate authority from which the device certificates are 
derived. These include the SSL certificates and if the security module is a member of a VPN 
group the VPN group certificates. The SSL certificates are required for authentication during 
secure communication between a network node and a security module. Certificate authorities 
can be:

● STEP 7 itself. If the "applicant" and "issuer" are the same, this is a self-signed certificate; 
in other words, issued by STEP 7.

● A higher ranking (commercial) certificate authority. These third-party certificates are 
external to the project and are imported and stored in the certificate store of STEP 7.

Certificates created by one of the two certificate authorities always have a private key so that 
the device certificates can be derived from them. 

The following functions are also available in the certificate manager:

● Modification of existing certificates (for example, duration of validity).

● Import of new certificates and certificate authorities.

● Import of SSL certificates (CP x43-1 Adv. only), e.g. for FTP communication. 

● Export of the certificates and certificate authorities used in the project.

● Renewal of expired certificates and certificate authorities.

● Replacement of existing certificate authorities with others.
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● Addition of trusted certificates and certificate authorities.

● Deleting manually imported certificates.
 

 Note
Downloading the configuration

After replacing or renewing certificates, the configuration must be downloaded to the relevant 
security modules. 

After replacing or renewing CA certificates, the configuration must be downloaded to all 
security modules.

 

 
 

 Note
Current date and current time of day on the security modules

When using secure communication (for example, HTTPS, VPN...), make sure that the 
security modules involved have the current time of day and the current date. Otherwise the 
certificates used are not evaluated as valid and the secure communication does not work.

 

How to access this function
Double-click on the "Certificate manager" entry in the global security settings.

In the individual tabs, you have the following commands available in the shortcut menu:

Command Meaning
Import / Export Import / export of device certificates or CA certificates. The 

certificates are transferred to the security module. The following 
formats are permitted:
*.cer (certificate only)
*.crt (certificate only)
*.pem (certificate only) 
*.p12 (certificate and corresponding private key)   

Displays Opens the certificate dialog of Windows where you see an overview 
of all certificate data.

Renew
(only in the "CA" and "Device 
certificates" tabs)

Opens the "Create new certificate" dialog in which you can import 
a certificate or have a new certificate created by STEP 7 when 
necessary, for example with compromised certificates.

Replace
(only in the "CA" tab)

Opens the "Change certificate authority (CA)" dialog in which you 
can replace an existing certificate authority with a new one.

Delete
(only with manually imported 
certificates)

Deletes a certificate in the "Trusted certificates and root certification 
authorities" tab.
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Certificate authorities

"CA" tab
The certificates displayed here are created by a certificate authority.

● CA certificates of a project: When you create a new project, a CA certificate is generated 
for the project. The SSL certificates for the individual security modules are derived from 
this certificate.

● CA group certificates: When you create a new VPN group, a CA certificate is generated for 
the VPN group. The VPN group certificates of security modules located in the VPN group 
are derived from this certificate.

Device certificates

"Device certificates" tab
Display of the device-specific certificates generated by STEP 7 for a security module. These 
include:

● SSL certificate of a security module: An SSL certificate that is derived from a CA certificate 
of the project is generated for each security module that you create. SSL certificates are 
used for authentication during secure communication between PG/PC and security module 
when downloading the configuration.

● VPN group certificate of a security module: A VPN group certificate is also generated for 
each security module for each VPN group in which it is located.

Trusted certificates and root certification authorities

"Trusted root certification authorities" tab   
Display of the third-party certificates imported into STEP 7. For example, server certificates 
can be imported from external FTPS servers or project certificates from other projects that 
were created with STEP 7.

With CPs, the imported third-party certificate is transferred to all the CPs managed in the project 
and these check the certificate. If you classify the certificate sent to the security modules as 
trusted, a connection can be established, for example, to an FTPS server. The imported 
certificate is not used at any other point in STEP 7.

With SCALANCE S modules, the certificate authorities required for verifying the security 
modules using external services such as dyn. DNS are displayed in this tab.
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Renewing certificates

Meaning   
In this dialog, you renew CA certificates and device certificates. If necessary, for example with 
compromised certificates, you can import a certificate or have a new certificate generated by 
STEP 7.

How to access this function
1. Right-click on a list entry in the certificate manager.

2. Select the "Renew" entry in the shortcut menu.

3. Decide whether or not the new certificate will be self-signed or signed by a certificate 
authority.    

4. If the certificate is to be signed by a certificate authority, select the certificate authority to 
be used with the "Select" button. Only certificate authorities stored in the certificate store 
of the current project can be selected.

5. Depending on the certificate, enter the following values in the "Applicant" or "Alternative 
applicant name" input box:

Certificate to be renewed Parameter
Applicant Alternative applicant name

CA certificates of the project   Name of the CA certificate -
CA group certificate Name of the CA group 

certificate
-

SSL certificate for S7 CP   Name of the security module Comma-separated IP addresses of 
the Gigabit and PROFINET interface    

SSL certificate for PC CP Name of the security module IP address of the security module
SSL certificate for 
SCALANCE S, 
SCALANCE M, SOFTNET 
Security Client

Name of the security module For SCALANCE S: External IP 
address, internal IP address and, if 
applicable, IP address of the DMZ 
interface
For SCALANCE M: External IP 
address, internal IP address
For SOFTNET Security Client: DNS 
name

VPN group certificate of the 
security module

Name of the VPN group 
certificate

Derived from the CA group certificate.

6. Select a period during which the certificate is valid. As default the current time is entered 
in the "Valid from:" box and the value of the current certificate is entered in the "Valid to:".
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Replacing certificates

Meaning   
Open the "Change certification authority (CA)" to replace the existing CA certificate of the 
project or the CA group certificate with a new one.     

How to access this function
1. Right-click a list entry in the "CA" tab.

2. Select the "Replace" entry in the shortcut menu.

3. The "Change certification authority (CA)" dialog opens.

All certificates listed in the "Certificates involved" table are derived once again. This means 
that the CA group certificate of an already configured VPN group can be replaced in the project 
by the CA group certificate of a different project. The VPN group certificates for the VPN group 
members are therefore derived from the same CA group certificate in both projects.   

After making changes in the certificate manager, download the configuration to all security 
modules affected.

Which format can the certificate have?
Other certificates are derived from the imported certificate authority in STEP 7. For this reason, 
you can only select certificates with a private key.

● *.p12 

Managing users and roles

Rules for user names, roles and passwords

Which rules apply to user names, role names and passwords?
When creating or modifying a user, a role or a password, remember the following rules:

Table 8-1 Rules for user management

Permitted characters The following characters from the US-ASCII character set are 
permitted:

0123456789
A...Z a...z

!#$%&()*+,-./:;<=>?@ [\]_{|}~¦^
Characters not allowed " '
Length of the user name 1 ... 32 characters
Length of the password 8 ... 32 characters
Length of the role name 1 ... 32 characters
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Maximum number of users per 
project

128

Maximum number of users on one 
security module

32 + 1 administrator when creating the project

Maximum number of roles per 
project 

124 (120 user-defined + 4 system-defined)

Maximum number of roles on one 
security module

33 (29 user-defined + 4 system-defined)

 
 

 Note
User names and passwords

As vital measure under the aspect of maximizing security, always make sure that user names 
and passwords have a minimum length of 8 characters and that these contain special 
characters, uppercase/lowercase letters, number, etc..

 

Create users

Meaning
The security functions configured in STEP 7 are protected from unauthorized access by a 
separate user management. Before you can access the global and local security settings of 
security modules, you need to log in to the security configuration as a user.

Creating the first user in the project  
After creating the first security module in the project, you first need to create a user. To do this, 
in the local security settings of the created security module, click the "User login" button under 
the "Security properties" entry and enter the login data of the user you want to create. You will 
then be logged in as the created user and the user is assigned the system-defined 
"Administrator" role. This role includes all configuration and module rights.

Creating users in the user management
When you are logged in as a user in the security configuration, you can create further users 
or delete users with the "User management" entry in the global security settings.

 

 Note
Users with the "Administrator" role

There must always be at least one user with full configuration rights within a project. The 
administrator that is created automatically when you first enable the security functions in the 
project can only be deleted if at least one other user exists with the system-defined role 
"Administrator".

 

The following parameters are available in user management in the "User" tab:
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Table 8-2 Information in the "User" tab

Parameter Meaning
User name   Name of the user to be created.

Click on the "Add new user" entry in the "User name" column to create a 
new user.

Password Password with which a user authenticates him/herself when logging on.
Role Selecting a system-defined or user-defined role.
Maximum time of the 
session (only for 
SCALANCE S V3 or higher)

Entry of the time after which a user logged on to the Web page for user-
specific IP rule sets of SCALANCE S modules is automatically logged 
off. The time entered here starts after the logon and after renewing the 
session on the Web page of the security module.
● Default setting: 30 minutes
● Minimum value: 5 minutes
● Maximum value: 480 minutes

Comment Entry of optional comments.

Creating roles

Overview   
You can assign a system-defined or a user-defined role to a user. Specify the module rights 
of a user-defined role for each security module. 

System-defined roles     
The system-defined roles listed below are predefined. Certain rights are assigned to the roles 
that are the same on all modules and that the administrator can neither change nor delete.

● Administrator    
Default role when creating a security configuration.
Unlimited access rights to all configuration data and all security modules.

● Standard 
Role with restricted access rights.

● Diagnose    
Default role when creating new user.

– Read access to configurations.

– Read access to the security module in the "Online" mode for testing and diagnostics.

● Remote-Access       
Can be used as a template when creating user-defined roles.

You will find a detailed list of the configuration and module rights assigned to the system-
defined roles "Administrator", "Standard" and "Diagnostics" in tables 1-3 to 1-7 of the section 
Managing rights (Page 657).
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User-defined role     
In addition to the system-defined roles, you can create user-defined roles. For a user-defined 
role, select the configuration or module rights and specify the appropriate module rights for 
every security module used in the project. You manually assign the user-defined roles to the 
relevant user.

How to access this function
1. Double-click on the "User management" entry in the global security settings.

2. Select the "Roles" tab in User management.

Table 8-3 Information in the "Roles" tab

Parameter Meaning
Role   Freely selectable role name.

Double-click on the "Add new role" entry to create a new user-defined role.
You can then set the rights for the created role.

Description Specifying the system-defined role With user-defined roles, the "User-
defined role" character string is displayed.

Maximum time of the 
session (only for 
SCALANCE S V3 or higher)

Entry of the time after which a user with the assigned role is automatically 
logged off from the Web page for user-specific IP rule sets of SCALANCE 
S modules. The time entered here starts after the logon and after 
renewing the session on the Web page of the security module.
● Default setting: 30 minutes
● Minimum value: 5 minutes
● Maximum value: 480 minutes

Comment Entry of additional, optional comments.
 

 Note
Deleting roles

A user-defined role can only be deleted when it is no longer assigned to any user. If necessary, 
assign the user a different role.

System-defined roles cannot be deleted.
 

Managing rights

How to access this function
1. Double-click on the "User management" entry in the global security settings.

2. Select the "Roles" tab in User management.
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Creating and assigning a user-defined role   
1. Double-click on the "Add new role" entry.

2. Enter a role name.

3. If necessary, select the system-defined role whose rights will be used as the template for 
the user-defined role from the drop-down list labeled "<Copy rights from>". User-defined 
roles cannot be selected from the drop-down list.
Result: In the list of rights of the user roles, the rights are selected that are assigned to the 
selected system-defined role.

4. For each security module, enable or disable the rights to be assigned to the user-defined 
role.

5. Assign the role to a user in the "User" tab.

Configuration rights
Configuration rights are not module dependent and control the rights for configuration in STEP 
7.

Depending on the user type, the following configuration rights are available for selection:

Table 8-4 Configuration rights   

Configuration right Administrator Standard Diagnose
Diagnose security x x x
Configure security x x -
Managing users and roles x - -

Module rights    
Module rights are configured per module. The "Service" column shows the service to which 
the particular right relates. With the "Copy rights" and "Paste rights" commands in the shortcut 
menu, you can transfer the rights from one module to another.

Depending on the user type, the following module rights are available for selection:

Table 8-5 Module rights CP x43-1 Advanced

Right within the service Administrator Standard Diagnose Service
Web: Format CP file system * x - - File system
FTP: Read files from the CP file system x x x
FTP: Write files to the CP file system x x -
FTP: Read files (DBs) from the S7 CPU **   x x x PLC
FTP: Write files (DBs) to the S7 CPU *** x x -
Applet: Read tags using configured symbols * x x x
Applet: Write tags using configured symbols * x x -
Applet: Read tags using absolute addresses *   x x x
Applet: Write tags using absolute addresses * x x -
Applet: Read status of the modules in the rack * x x x
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Right within the service Administrator Standard Diagnose Service
Applet: Query order numbers of the modules in the 
rack *

x x x

SNMP: Read MIB-II    x x x SNMP
SNMP: Write MIB-II x x -
SNMP: Read automation MIB x x x
SNMP: Read LLDP-MIB  x x x
SNMP: Read SNMPv2-MIB x x x
SNMP: Read MRP MIB x x x
SNMP: Write MRP MIB x x -
TIA Portal: Run diagnostics of the security module 
****

x x x Security

Web: Expand IP access control list *   x - - Web
Web: Access Web diagnostics and CP file system x x x
Web: Send test e-mails * x x x
Web: Update firmware * x x - Maintenance
Web: Load diagnostics texts later * x x -

Table 8-6 Module rights CP 1628

Right within the service Administrator Standard Diagnose Service
SNMP: Read MIB-II x x x SNMP
SNMP: Write MIB-II x x -
SNMP: Read automation MIB x x x
SNMP: Read SNMPv2-MIB x x x
TIA Portal: Run diagnostics of the security module **** x x x Security

Table 8-7 Module rights SCALANCE S

Right within the service Administrator Standard Diagnose Service
Download the configuration files x x - Security
TIA Portal: Run diagnostics of the security module **** x x x
SNMP: Read automation MIB x x x SNMP
SNMP: Read MIB-II x x x
SNMP: Write MIB-II x x -
SNMP: Read MRP-MIB x x x
SNMP: Write MRP-MIB x x -
SNMP: Read SNMPv2-MIB x x x
Web: Update firmware x x - Maintenance

Table 8-8 Module rights CP 1543-1

Right within the service Administrator Standard Diagnose Service
FTP: Read files from the CP file system x x x File system
FTP: Write files to the CP file system x x -
TIA Portal: Run diagnostics of the security module **** x x x Security
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Right within the service Administrator Standard Diagnose Service
SNMP: Read automation MIB x x x SNMP

 SNMP: Read IPv6 MIB x x x
SNMP: Read LLDP-MIB  x x x
SNMP: Read MIB-II x x x
SNMP: Write MIB-II x x -
SNMP: Read SNMPv2-MIB x x x
FTP: Read files (DBs) from the S7 CPU **  x x x PLC
FTP: Write files (DBs) to the S7 CPU *** x x -

* To be able to use the function, the module right "Web: Access Web diagnostics and CP 
file system" must be enabled as well.   

** To be able to use the function, the module right "FTP: Read files from CP file system" 
must be enabled as well.

*** To be able to use the function, the module right "FTP: Write files to CP file system" must 
be enabled as well.

**** To use the function, the configuration right "Security diagnostics" must also be enabled.

Setting module rights before and after creating the security modules
Within a user-defined role, the module rights for each security module are defined separately. 
If a security module was created before this role was added and module rights within a role 
need to be set, STEP 7 presets the module rights for the security module according to the 
selected rights template. The preset module rights can then be adapted when adding the role. 
If a security module was created after adding a role, no rights are preset for this security 
module. In this case, you will need to edit an existing role and set all the module rights yourself 
for the security module.

You can also transfer existing module rights to another module by copying and, if necessary, 
adapting them there. To do this, select a module in the shortcut menu in the module rights and 
select the "Copy rights" or "Paste rights" menu command.

Generating configuration data for SCALANCE M modules

Context
You can generate the VPN information for the assignment of parameters to a SCALANCE M 
using STEP 7. For this to be possible, the module must be in at least one VPN group with a 
security module or a SOFTNET Security Client. With the generated files, you can then 
configure the SCALANCE M using the Web Based Management of the device.
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Generated files
The following file types are generated:

● Export file with the configuration data

– File type: *.txt file in ASCII format

– Contains the exported configuration information for the SCALANCE M including 
information on the additionally generated certificates.

● VPN group certificates of the module

– File type of the private key: *.p12 file

– The file contains the module certificate and the key material.

– Access is password protected.

● CA certificates of VPN groups

– File type: *.cer file

Figure 8-1 SCALANCE M configuration file

 

 Note
No transfer to the security module

Configuration files are not transferred to the security module. An ASCII file is generated with 
which you can configure the SCALANCE M. To allow this, the SCALANCE M must be located 
in at least one VPN group with another security module.

 

Follow the steps below
1. Select the module of the type "SCALANCE M".

2. In the local security settings, select the entry "SCALANCE M configuration".
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3. Select the "Generate SCALANCE M files" check box and select a storage location for the 
configuration files.

4. Compile the configuration of the SCALANCE M module.

5. In the dialog that follows, choose whether you want to create your own password for the 
created .p12 file.
If you select "Cancel", the project name is assigned as the password, not the project 
password.

Result: The files (.txt file and certificates) are stored in the folder you specify.

Configuring interfaces for SCALANCE S modules

Overview
You will find information on configuration interfaces of SCALANCE S modules in Auto-Hotspot 
of the section "SCALANCE S". The information contained here deals with the following 
configuration options:

● Mode (bridge mode / routing mode): Setting the operating mode (Page 729)

● IP address parameters: Configuring IP address parameters (Page 729)

● Port settings (only for SCALANCE S ≥ V3): Configuring port mode (Page 731)

● Settings for the Internet Service Provider (ISP) if one of the interfaces is operated using 
PPPoE (only for SCALANCE S ≥ V3): Configuring an Internet connection (Page 731)

● Dynamic DNS (only for SCALANCE S ≥ V3): Configuring dynamic DNS (Page 732)

● LLDP (only for SCALANCE S ≥ V4 in routing mode): Configuring LLDP (Page 735)

● Media redundancy in ring topologies (MRP client), (only for SCALANCE S ≥ V4 in routing 
mode): Auto-Hotspot

The configuration of the interfaces of CPs is described in the sections dealing with the CPs.

Setting up a firewall

Overview of the firewall

Meaning
The firewall functionality of the security modules is intended to protect networks and stations 
from third-party influence and interference. This means that only certain, previously specified 
communications relations are permitted. The firewall discards invalid frames without sending 
a response.

To filter the data traffic, IP addresses, IP subnets, port numbers or MAC addresses can be 
used. You can also set a bandwidth limitation.

The firewall functionality can be configured for the following protocol levels:
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● IP firewall with stateful packet inspection (layer 3 and 4)    

● Firewall also for Ethernet "non-IP" frames according to IEEE 802.3 (layer 2)      

With security modules capable of VPN, the firewall can also be used for the encrypted data 
traffic (IPsec tunnel). With the SCALANCE S602 Security module, the firewall can only be used 
for unencrypted data traffic. 

Firewall rules   
Firewall rules describe which packets in which direction are permitted or forbidden.

Types of firewall rules
● Global firewall rule sets: Global firewall rule sets can be assigned to several security 

modules at the same time. Global firewall rule sets are configured in the global security 
settings.

● Local firewall rules: Local firewall rules are configured in the local security settings of a 
security module.

● User-specific IP rule sets (only for SCALANCE S ≥ V3): User-specific IP rule sets can be 
assigned to individual or several security modules at the same time. User-specific IP rule 
sets are configured in the global security settings and assigned there to one or more users. 
You will find information on configuring user-specific IP rule sets for SCALANCE S V3 
modules in the following section:
Auto-Hotspot

Service definitions
With the aid of service definitions, you can also define firewall rules clearly in a compact form. 
Service definitions are configured in the global security settings and can be used in the global, 
local and user-specific firewall rules.

Adapting standard rules for IP services
For SCALANCE S modules V3 or higher, you can adapt service-specific firewall rules that are 
set as default for the interfaces of the security modules. You will find information on configuring 
these firewall rules in Adapting standard rules for IP services (Page 744) of the section 
"SCALANCE S".

Automatically generated firewall rules for CP connections
For connections that were configured using CPs, STEP 7 automatically creates firewall rules 
that allow communication with the partner of the CP in the specified direction (CP active/
passive). The connection establishment directions are taken into account. To display these 
firewall rules, if the advanced firewall mode is enabled, the "Update connection rules" button 
needs to be clicked. The firewall rules are then displayed in advanced firewall mode.

Which firewall rules are generated automatically is described in the following sections.
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● For S7-300 CPs/S7-400 CPs/PC CPs: Connection-related automatic firewall rules 
(Page 768) in the section "Security for S7-300 / S7-400 / PC CPs".

● For S7-1500 CPs: Connection-related automatic firewall rules (Page 777) in the section 
"Security for S7-1500 CPs".

Enabling the firewall
Firewall functionality for a specific security module is controlled in the local security settings 
using the "Enable firewall" check box. If the check box is enabled, the firewall can be configured 
and is effective following the download. For a security module that is a member of a VPN group, 
the "Enable firewall" check box is activated by default and cannot be deactivated. After 
switching to advanced firewall mode, it is not possible to switch back to standard mode. For 
more information about the standard and advanced firewall modes, refer to the section:

Overview of local firewall rules (Page 672).

Global firewall rule sets
 

Application     
Regardless of the module, global firewall rule sets are configured in the global security settings. 
A firewall rule set consists of one or more firewall rules and is assigned to the individual security 
modules.

In the global firewall rule sets, a distinction is made between the following:

● IP rule sets 

● MAC rule sets 

The following schematic illustrates the relationship between globally defined rule sets and 
locally used rule sets.
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Configuring
When configuring global firewall rules, you can make detailed firewall settings. You can allow 
individual services for a single node or all services for the node for access to the station or 
network.

When are global IP and MAC firewall rules useful?
Global firewall rules are useful if you want to define identical filter criteria for communication 
with several security modules.

 

 Note
Assigning firewall rule sets with incompatible firewall rules

For a security module, only the firewall rules from firewall rule sets are adopted correctly if 
the security module supports them. A firewall rule with the direction "From external" or "To 
any" in a global firewall rule set is not assigned to a CP 1628. The other firewall rules of the 
global firewall rule set are adopted if the CP supports them.

 

 

Global firewall rule sets - conventions

Global firewall rule sets are used locally
The following conventions apply when creating a global set of firewall rules and when assigning 
it to a module:

● Configuration view
Global firewall rule sets are configured in the global security settings.

● Priority
As default, locally defined rules have a higher priority than the global IP and MAC firewall 
rule sets. Newly assigned global IP and MAC firewall rule sets are therefore initially entered 
at the bottom of the local rule list.
The priority can be changed by changing the position in the rule list.

● Entering, changing or deleting rule sets
Global firewall rule sets cannot be edited in the local rule list of the firewall rules in the 
module properties. They can only be displayed there and positioned according to the 
required priority.
It is not possible to delete a single rule from an assigned rule set in the local security settings. 
Only the entire rule set can be removed from the local list of rules. The firewall rule sets in 
the global security settings remain unaffected.
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Creating global firewall rule sets

How to access this function     
1. In the global security settings, select the entry "Firewall" > "Global firewall rule sets" > "IP 

rule sets" or "MAC rule sets".
Result: The previously created IP rule sets or MAC rule sets are displayed under the 
selected entry.

2. Double-click on the entry "Add new IP rule set" or "Add new MAC rule set".

3. Enter the following data:

– Name: Project-wide, unique name of the rule set. The name appears in the local rule 
list of the security module after the rule set is assigned.

– Description (optional): Enter a description of the global rule set.

4. Enter the firewall rules one by one in the list.
Note the parameter description in the following sections:
For IP rule sets: Defining IP packet filter rules (Page 673) 
For MAC rule sets: Defining MAC packet filter rules (Page 676) 

Result
You have created the global firewall rule set and can now assign this to the required security 
modules.
Note the descriptions in the following section:

Assigning global firewall rule sets (Page 666) 

Assigning global firewall rule sets

Requirement
You have enabled the advanced firewall mode for the security modules you want to assign to 
a firewall rule set.

Procedure
1. In the global security settings, select the entry "Firewall" > "Global firewall rule sets" > 

"Assign module to a firewall rule set".

2. From the "Rule set" drop-down list, select the rule set to which you want to assign the 
security module.
In the right-hand table, you will see the security modules that you can assign to the selected 
firewall rule set. In the left-hand table, you will see the security modules already assigned 
to the selected firewall rule set.

3. In the "Available modules" area, select the security modules you want to assign to the 
selected rule set.

4. Click the  button to assign the selected modules to the selected rule set.
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Result
The global rule set is used by the assigned security modules as a local rule set and appears 
automatically at the end of the list of firewall rules in the local security settings. 

IP services

Defining IP services

How to access this function
In the global security settings, select the entry "Firewall" > "Services" > "Define services for IP 
rules".

Procedure
Using the definition of IP services, you can define succinct and clear firewall rules for specific 
services. You select a name and assign the service parameters to it.   

These services defined in this way can also be grouped together under a group name.   

When you configure the packet filter rules, you then use this name.

Parameters for IP services
You define the IP services using the following parameters:

Table 8-9 IP services: Parameter

Parameter Meaning/comment Available options / ranges of 
values

Name Name for the service that is used as identification in 
the rule definition or in the group. The names of 
predefined services cannot be changed.

● Name must start with a 
letter.

● Name must not contain any 
special characters.

● Name must not be 
redundant.

Protocol   Selection of the protocol type ● TCP   
● UDP   
● All

Source port The filtering is based on the specified port number; 
this defines the service access at the frame sender.

Examples: 
*: Port is not checked
20 or 21: FTP service

Destination 
port

The filtering is based on the specified port number; 
this defines the service access at the frame recipient.

Examples: 
*: Port is not checked     
TCP 80: Web HTTP service     
TCP 102: S7 protocol 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 667



Defining ICMP services

How to access this function
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

IP rules".

2. Select the "ICMP" tab. 

Procedure
Using the definition of ICMP services, you can define succinct and clear firewall rules for 
specific services. You select a name and assign the service parameters to it.

These services defined in this way can be grouped together under a group name.

When you configure the packet filter rules, you then use this name.

Parameters for ICMP services

Parameter Meaning/comment Available options / ranges of 
values

Name User-definable name for the service that is 
used as identification in the rule definition or 
in the group. The names of predefined 
ICMPv6 services cannot be modified.

● Name must start with a letter.
● Name must not contain any 

special characters.
● Name must not contain more 

than 20 characters.
● Name must not occur more 

than once
ICMPv6 If you enable this check box, the ICMP service 

is declared as an ICMPv6 service and you can 
select an ICMPv6-specific type and code for 
the service. An ICMPv6 service can only be 
used in the firewall rule of a security module 
that supports IPv6.

● Enabled
● Disabled (default)

Type Type of the ICMPv4 or ICMPv6 message. If the "ICMPv6" check box is 
deselected, ICMPv4-specific 
types can be selected. If the 
check box is selected, ICMPv6-
specific types can be selected.

Code Code of the ICMP type. Values depend on the selected 
type.
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Creating service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

IP rules".

2. Select the "Service groups" tab.

Forming service groups   
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name. 
IPv4 and IPv6 services can be collected in the same service group.

Create groups in the open "Service groups" tab. You can then assign services to a group in 
the "Group management" tab.

Follow the steps below
1. First, create groups in this tab with names to suit your requirements and add a description 

if required.

2. Select the "Group management" tab. You can assign the previously specified IP services 
to the groups defined in this tab.

Managing service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

IP rules".

2. Select the "Group management" tab.

Forming service groups
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name. 
IPv4 and IPv6 services can be collected in the same service group.

Use the "Group management" tab to assign services to a selected group you created previously 
in the "Service groups" tab.

Follow the steps below
1. Select a group created previously in the "Service groups" tab from the "Service groups" 

drop-down list in this tab.

2. Then assign the required services from the right-hand "Available services" list box to the 
group.
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MAC services

Define MAC services

How to access this function
In the global security settings, select the entry "Firewall" > "Services" > "Define services for 
MAC rules".

Meaning
Using the definition of MAC services, you can define succinct and clear firewall rules for specific 
services. You select a name and assign the service parameters to it.

These services defined in this way can be grouped together under a group name.

When you configure the global or local packet filter rules, you use this name.     

Parameters for MAC services 
A MAC service definition is formed using protocol-specific MAC parameters:

Table 8-10 MAC services - parameters

Parameter Meaning/comment Available options / ranges of values
Name User-definable name for the service that is used as 

identification in the rule definition or in the group.
● Name must start with a letter.
● Name must not contain any special 

characters.
● Name must not be redundant.

Protocol Name of the protocol type:
● ISO

ISO identifies frames with the following properties:
Lengthfield <= 05DC (hex), 
DSAP= userdefined 
SSAP= userdefined 
CTRL= userdefined

● SNAP
SNAP identifies frames with the following properties:
Lengthfield <= 05DC (hex), 
DSAP=AA (hex),
SSAP=AA (hex), 
CTRL=03 (hex), 
OUI=userdefined, 
OUI-Type=userdefined

● PROFINET IO
● As an alternative, a protocol number can be entered.
The protocol entries 0800 (hex) and 0806 (hex) are not 
accepted since these values apply to IP or ARP frames.

● ISO
● SNAP
● PROFINET IO
● 0x (code entry)

DSAP Destination Service Access Point: LLC recipient address  
SSAP Source Service Access Point: LLC sender address  
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Parameter Meaning/comment Available options / ranges of values
CTRL LLC control field  
OUI Organizationally Unique Identifier

(the first 3 bytes of the MAC address = vendor ID)
 

OUI type Protocol type/identification  

 
 

 Note
Processing for S7-CPs

Only settings for ISO frames with DSAP=SSAP=FE (hex) are processed. Other frame types 
are not relevant for S7 CPs and are therefore discarded even before processing by the firewall.

 

Special settings for SIMATIC NET services
To filter special SIMATIC NET services, please use the following protocol settings:

● DCP (Primary Setup Tool):  
PROFINET

● SiClock :  
OUI= 08 00 06 (hex) , OUI-Type= 01 00 (hex)

Creating service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

MAC rules".

2. Select the "Service groups" tab.

Forming service groups   
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name.

Create groups in the open "Service groups" tab. You can then assign services to a group in 
the "Group management" tab.

Follow the steps below
1. First, create groups in this tab with names to suit your requirements and add a description 

if required.

2. Select the "Group management" tab. You can assign the previously specified MAC services 
to the groups defined in this tab.
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Managing service groups

How to access this function   
1. In the global security settings, select the entry "Firewall" > "Services" > "Define services for 

MAC rules".

2. Select the "Group management" tab.

Forming service groups
You can put several services together by creating service groups. This allows you set up more 
complex services that you can then use in the packet filter rules simply by selecting the name.

Use the "Group management" tab to assign services to a selected group you created previously 
in the "Service groups" tab.

Follow the steps below
1. Select a group created previously in the "Service groups" tab from the "Service groups" 

drop-down list in this tab.

2. Then assign the required services from the right-hand "Available services" list box to the 
group.

Overview of local firewall rules

Meaning
Local firewall rules are configured in the local security settings of a security module and apply 
only to this security module. After enabling the firewall functionality you can either use 
predefined firewall rules or define firewall rules in the advanced firewall mode.

Using predefined firewall rules
Here, you use simple, predefined rules. You can only enable service-specific rules. The 
enabled services are allowed for all nodes in the specified direction. You can find detailed 
information on the definition of firewall rules in this dialog in the following module-specific 
sections:

● For SCALANCE S: Auto-Hotspot 

● For S7-300 CPs/S7-400 CPs/PC CPs: Auto-Hotspot 

● For S7-1500 CPs: Auto-Hotspot 

Defining firewall rules in advanced firewall mode
In advanced firewall mode, you can make detailed firewall settings. You can allow individual 
services for a single node or all services for the node for access to the station or network. You 
enable the advanced firewall mode using the "Activate firewall in advanced mode" check box. 
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In the local security settings, the firewall rules can then be configured in "Firewall" > "IP rules" 
or "MAC rules". The configuration options available here are described individually in the 
following section:

For IP packet filter rules: Defining IP packet filter rules (Page 673) 

For MAC packet filter rules: Defining MAC packet filter rules (Page 676)
 

 Note
Deactivating the advanced firewall mode not possible

Once you have activated the advanced firewall mode, you can no longer deactivate it.
 

Quantity structure

Number of firewall rules (advanced firewall mode)
SCALANCE S Maximum of 256
S7 CPs Maximum of 256
CP 1628 Maximum of 256

Defining IP packet filter rules

Meaning
With IP packet filter rules, you filter according to IP frames, such as TCP, UDP and ICMP.       

Within a packet filter rule, you can also fall back on the definitions of the IP services.

Entering IP packet filter rules
Enter the firewall rules one by one in the list. Note the following parameter description.
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Table 8-11 IP rules: Parameter

Parameter Meaning/comment Available options / ranges of values
Action Allow/disallow (enable/block) ● Allow

Allow frames according to definition.
● Drop

Block frames according to definition.
For firewall rules generated automatically as result of configuring a connection 
and subsequently adapted manually:
● Allow*
● Drop*

If you change automatically created connection rules, when the "*" option 
is selected they are not recreated and overwritten by STEP 7.

From / To Selection of the 
communications directions 
for which the rule will apply.
 

Described in separate sections.
● For SCALANCE S modules: IP packet filter directions SCALANCE S 

(Page 743)
● For S7-300 CPs/S7-400 CPs/PC CPs: IP packet filter directions S7-300-/

S7-400-/PC-CPs (Page 766)
● For S7-1500 CPs: IP packet filter directions S7-1500 CPs (Page 776)

IPv6 (for the 
CP 1543-1 
only)

If this check box is selected, 
you can use a previously 
defined ICMPv6 service in 
the firewall rule. For the CP 
1543-1 V1.1, after selecting 
the check box you can enter 
additional IPv6 addresses in 
the "Source IP address" and 
"Destination IP address" 
input boxes. For the CP 
1543-1 V1.0, after enabling 
the check box you cannot 
enter any source IP address 
or any destination IP address 
for the firewall rule.

The check box can only be selected and deselected if there are no entries in 
the "Source IP address" and "Destination IP address" input boxes.
If IPv6 is disabled in the local settings of the CP 1543-1, you cannot select 
the "IPv6" check box in the local security settings of the CP and therefore 
cannot use ICMPv6 services or IPv6 addresses in firewall rules. Existing 
firewall rules that use IPv6 are shown grayed out if IPv6 is disabled.

Source IP 
address

The firewall rule is applied to 
the frames whose sender 
has the IP address specified 
here. If you do not specify an 
IP address, the firewall rule 
applies to all nodes in the 
communications direction 
you selected in the "From" 
column.

You can find additional information about IP addresses in the IP addresses 
in IP packet filter rules (Page 677) section.
 

Destination 
IP address

The firewall rule is applied to 
the frames whose recipient 
has the IP address specified 
here. If you do not specify an 
IP address, the firewall rules 
applies to all nodes in the 
communications direction 
you selected in the "To" 
column.
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Parameter Meaning/comment Available options / ranges of values
Service Name of the IP/ICMP service 

or service group used.
Here, you select one of the 
services you defined in the 
"IP services" dialog:
● IP services
or 
● ICMP services
Before you select an ICMPv6 
service, you need to select 
the "IPv6" check box.

The drop-down list box displays the services and service groups configured 
in the global security settings and you can select them.

Bandwidth 
(Mbps)

Option for setting a 
bandwidth limitation
Can only be entered if the 
"Allow" action is selected.
A packet passes through the 
firewall if the allow rule 
matches and the permitted 
bandwidth for this rule has 
not yet been exceeded.

CP x43-1, CP 1543-1 and SCALANCE S < V3.0: 0.001 ... 100 Mbps
CP 1628 and SCALANCE S ≥ V3.0: 0.001 ... 1000 Mbps
For global and user-specific rules: 0.001 ... 100 Mbps
Note: If the direction "From tunnel to station" is configured in a firewall rule 
for the CP 1543-1, no bandwidth limitation can be specified.

Logging Enable and disable logging 
for this rule. If logging is 
enabled, the settings for the 
packet filter logging 
configured in the local 
security settings apply.

● Enabled
● Disabled (default)

Number Automatically assigned 
number for the rule

 

Comment Space for your own 
explanation of the rule

If a comment is marked with "AUTO", it was created for an automatic 
connection rule. For rules you have created, entry of a comment is optional.

Table 8-12 Meaning of the entries in the shortcut menu

Entry in the shortcut menu Meaning
Delete This deletes the selected rule or the selected rule set.

Notes on removing a globally defined and locally assigned rule set:
if you delete a rule set here, this only cancels the assignment to the security 
module.

Save as global rule set (only for local 
firewall rules)

Copies the selected firewall rule(s) and inserts it as a global firewall rule set in the 
global security settings. The firewall configuration currently configured for the 
security module remains unaffected by this procedure.

Move up Use this button to move the selected rule or selected rule set up one position in 
the list. The rule / rule set you moved is therefore handled with higher priority.

Move down Use this button to move the selected rule or selected rule set down one position 
in the list. The rule / rule set you moved is therefore handled with lower priority.

Define service for IP rules This opens the dialog in which you can manage the IP services and service groups.
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Defining MAC packet filter rules

Meaning
With the MAC packet filter rules, you filter according to MAC frames. 

Within a packet filter rule, you can also fall back on the definitions of the MAC services.

Entering MAC packet filter rules   
Enter the firewall rules one by one in the list. Note the following parameter description.

Table 8-13 MAC rules: Parameter

Parameter Meaning/comment Available options / ranges of values
Action Allow/disallow (enable/block) ● Allow

Allow frames according to definition.
● Drop

Block frames according to definition.
From / To Selection of the communications 

directions for which the rule will 
apply.

Described in separate sections.
● For SCALANCE S modules: MAC packet filter directions 

SCALANCE S (Page 744) 
● For S7-300 CPs/S7-400 CPs/PC CPs: MAC packet filter 

directions S7-300-/S7-400-/PC-CPs (Page 767) 
● For S7-1500 CPs: MAC packet filter directions S7-1500 CPs 

(Page 777) 
Source MAC 
address

The firewall rule is applied to the 
frames whose sender has the MAC 
address specified here. If you do not 
specify a MAC address, the firewall 
rule applies to all nodes in the 
communications direction you 
selected in the "From" column.

MAC address in the correct format

Destination 
MAC address

The firewall rule is applied to the 
frames whose recipient has the MAC 
address specified here. If you do not 
specify a MAC address, the firewall 
rule applies to all nodes in the 
communications direction you 
selected in the "To" column.

Service Name of the MAC service or service 
group used

The drop-down list box displays the configured services and service 
groups you can select.

Bandwidth 
(Mbps)

Option for setting a bandwidth 
limitation. Can only be entered if the 
"Allow" action is selected.
A packet passes through the firewall 
if the allow rule matches and the 
permitted bandwidth for this rule has 
not yet been exceeded.

CP x43-1, CP 1543-1 and SCALANCE S < V3.0: 0.001 ... 100 Mbps
CP 1628 and SCALANCE S ≥ V3.0: 0.001 ... 1000 Mbps
For global rules: 0.001 ... 100 Mbps
Note: If the direction "From tunnel to station" is configured in a 
firewall rule for the CP 1543-1, no bandwidth limitation can be 
specified.
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Parameter Meaning/comment Available options / ranges of values
Logging Enable and disable logging for this 

rule. If logging is enabled, the 
settings for the packet filter logging 
configured in the local security 
settings apply.

● Enabled
● Disabled (default)

Number Automatically assigned number for 
the rule

 

Comment Space for your own explanation of 
the rule

If a comment is marked with "AUTO", it was created for an automatic 
connection rule. For rules you have created, entry of a comment is 
optional.

Table 8-14 Meaning of the menu commands

Button Meaning
Delete This deletes the selected rule or the selected global rule set.

Notes on removing a globally defined and locally assigned rule set:
if you delete a rule set here, this only cancels the assignment to the security 
module.

Save as global rule set (only for local 
firewall rules)

Copies the selected firewall rule(s) and inserts it as a global firewall rule set in the 
global security settings. The firewall configuration currently configured for the 
security module remains unaffected by this procedure.

Move up Use this button to move the selected rule or selected global rule set up one position 
in the list. The rule / rule set you moved is therefore handled with higher priority.

Move down Use this button to move the selected rule or selected global rule set down one 
position in the list. The rule / rule set you moved is therefore handled with lower 
priority.

Define service for MAC rules This opens the dialog in which you can manage the MAC services and service 
groups.

IP addresses in IP packet filter rules

Entering IP addresses in IP packet filter rules
In IP packet filter rules, you have the following options for entering IP addresses:

● Nothing specified
The rule applies to all IP addresses.

● An IP address
The rule applies specifically to the specified address.
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● Address range
The rule applies to all the IP addresses covered by the address range.
An address range is defined by specifying the number of valid bit places in the IP address 
in the format: [IP address]/[number of bits to be included]

– [IP address]/24 therefore means that only the most significant 24 bits of the IP address 
are included in the filter rule. These are the first three octets of the IP address.

– [IP address ]/25 means that only the first three octets and the highest bit of the fourth 
octet of the IP address are included in the filter rule.

● Address area
For the source IP address, an address range can be entered in the following format:
[Start IP address]-[End IP address]

IPv4 addresses  
An IPv4 address consists of 4 decimal numbers in the range from 0 to 255 separated from 
each other by a dot.

Table 8-15 Examples of address ranges in IPv4 addresses   

Source IP address or 
destination IP address

Address range Number of 
addresses*)

 from to  
192.168.0.0/16 192.168.0.0 192.168.255.255 65.536
192.168.10.0/24 192.168.10.0 192.168.10.255 256
192.168.10.0/25 192.168.10.0 192.168.10.127 128
192.168.10.0/26 192.168.10.0 192.168.10.63 64
192.168.10.0/27 192.168.10.0 192.168.10.31 32
192.168.10.0/28 192.168.10.0 192.168.10.15 16
192.168.10.0/29 192.168.10.0 192.168.10.7 8
192.168.10.0/30 192.168.10.0 192.168.10.3 4
*) Note: Note that the network address and the broadcast address are not available as IP addresses 
of network nodes in an address range.   

IPv6 addresses 
IPv6 addresses consist of 8 fields each with four hexadecimal numbers (128 bits in total). The 
fields are separated by a colon. IPv6 addresses can only be entered in IP packet filter rules 
for the CP 1543-1 V1.1.

Example: fd00:ffff:ffff:ffff:ffff:ffff:2f33:8f21

Rules / simplifications:
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● Leading zeros within a field can be omitted.
Example: Instead of 2001:0db8:2426:08d3:1457:8a2e:0070:7344 it is also possible to use 
the notation 2001:db8:2426:8d3:1457:8a2e:70:7344.

● If one or more fields have the value 0 (or 0000), a shortened notation is possible.
Example: Instead of 2001:0db8:0:0:0:0:1428:57ab it is also possible to use the notation 
2001:db8::1428:57ab.
To ensure uniqueness, this shortened form can only be used once within the entire address.

● Decimal notation with periods
The last 2 fields or 4 bytes can be written in the normal decimal notation with periods.
Example: The IPv6 address fd00::ffff.125.1.0.1 is equivalent to fd00::ffff:7d01:1.

● Address range notation in IP packet filter rules: In the same way as IPv4 addresses, IPv6 
addresses can also be noted in the form of address ranges.
Example: The entry "2001:0db8:85a3:08d3:1319:8a2e:0:0/96" covers all IPv6 addresses 
from 2001:0db8:85a3:08d3:1319:8a2e:0:0 to 2001:0db8:85a3:08d3:1319:8a2e:ffff:ffff.

Carrying out module-specific log settings

Log settings - overview

Log settings in the configuration
The log settings made here are loaded on the module with the configuration and take effect 
when the security module starts up.

You can restrict the configured packet filter log settings in the online functions if necessary. 
For example, you can use the online functions to specify that merely IP logging is displayed if 
you have configured IP and MAC logging.

Logging procedures and event classes
Here, you can specify which data should be logged. As a result, you enable logging as soon 
as you download the configuration to the security module.

During configuration, you also select one or both of the possible logging procedures:

● Local logging

● Network Syslog

In both logging procedures, the security module recognizes the three following types of events:

● Packet filter events

● Audit events

● System events
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Configuring local logging

How to access this function
1. Select the module to be edited.

2. Select the "Log settings" > "Local log memory" entry in the local security settings.
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Configuring local logging

Table 8-16 Local logging - settings for log events

Log event Meaning Comments
Packet filter log (firewall) The packet filter log records certain packets 

of the data traffic. Only those data packets 
for which a configured packet filter rule 
(firewall) applies or to which the basic 
protection reacts (corrupt or invalid 
packets) are logged. This is only possible 
when logging is enabled for the packet filter 
rule.
In the "Packets to be logged" drop-down 
list, you can specify the data packets to be 
logged:
● "All packets": The data packets that are 

logged are those to which a configured 
firewall rule applies. In addition to this, 
all the response packets to such 
packets are recorded that have passed 
the firewall according to a configured 
allow rule.

● "Status generating packets": The only 
data packets that are logged are those 
to which a configured firewall rule 
(standard mode or advanced mode) 
applies and that initially generate a 
status in the firewall. Data packets that 
pass through the firewall by using this 
firewall status are not logged.

Packet filter log data is not retentive
The data is stored in volatile memory on the 
security module and is therefore no longer 
available after the power supply has been 
turned off. For retentive storage, you can also 
save the log data displayed in the "Online & 
diagnostics" dialog in a file.

Audit log The logging of audit events is always 
enabled.
The logged information is always stored in 
the ring buffer.
The audit log automatically records 
security-relevant events, for example user 
actions such as activating or deactivating 
packet logging or downloading 
configurations to the security module.

Audit log data is retentive
The data is stored in a retentive memory of 
the security module and is therefore still 
available after turning off the power supply.
Note for CPs:
The audit log files are not retentive on CPs. 
You should therefore use a Syslog server to 
backup this data.

System log The system log automatically logs 
successive system events, for example the 
start of a process or the failed login attempt 
of a user.
Select the "Log settings" > "Configure 
system events" entry to configure the event 
filter and cable diagnostics functions.

System log data is not retentive
The data is stored in volatile memory on the 
security module and is therefore no longer 
available after the power supply has been 
turned off. For retentive storage, you can also 
save the log data displayed in the "Online & 
diagnostics" dialog in a file.
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Table 8-17 Local logging - storage of recorded data

Storage Meaning
Ring buffer At the end of the buffer, the recording continues at the start of the buffer 

and overwrites the oldest entries.
One-shot buffer Recording stops when the buffer is full.

Configuring system events

How to access this function
1. Select the module to be edited.

2. Select the "Log settings" > "Configure system events" entry in the local security settings.

Filtering of the system events
In this dialog, you set a filter level for the system events. As default, the following values are 
set:

● SCALANCE S: Level 3 (Error)

● CP: Level 3 (Error)

The priority of the selected filter level must be the same or lower than the severity set for the 
cable diagnostics; see the "Setting parameters for line diagnostics" table (not for CPs).

Recommendation: Select "Error" as the filter level or a higher value to exclude logging of 
general, uncritical events.

Note for CP
For CPs, select only level 3 or level 6 since only events of these levels are generated for CPs.

● Level 0 to level 3 error messages are output if level 3 is selected.

● If you select level 6, the error messages of levels 0 to 6 are output.

Properties of the system events - line diagnostics (not for CPs)
Line diagnostics generates a special system event. A system event is generated when a 
selectable percentage of bad frames is reached. This system event is assigned the severity 
and facility set in this dialog.

Table 8-18 Setting parameters for line diagnostics

Function / option / parameter Meaning
Enable Enabling and disabling logging
Limit Selectable percentage of faulty frames representing the limit at which 

a system event is triggered.
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Function / option / parameter Meaning
Facility Select a facility from the drop-down list that identifies the system event 

to be logged.
Severity Using the severity, you weight the system events of line diagnostics 

relative to the severity of the other system events.

 
 

 Note
Severity of the system events of line diagnostics

Make sure that you do not assign a lower severity to the system events of line diagnostics 
than for the filter. At a lower severity, these events will not pass through the filter and will not 
be logged.

 

Configuring the network Syslog

How to access this function
1. Select the module to be edited.

2. Select the "Log settings" > "Network Syslog" entry in the local security settings.

Configuring the network Syslog

Table 8-19 Network Syslog - basic settings

Option / parameter  
Enable network Syslog Enables and disables the transfer of logging events to the Syslog server.
Syslog server Here, enter the IP address of the Syslog server. As an alternative, an FQDN 

can be entered for SCALANCE S V4 modules.
The Syslog server must be accessible from the security module at the 
specified address and, if applicable, using the router configuration under 
the "Routing" entry of the local security settings. If the Syslog server cannot 
be accessed no Syslog messages are sent. You can recognize this 
operating state on the basis of corresponding system alarms. To activate 
the sending of the Syslog information again, you may have to update the 
routing information and initiate a restart of the security module.

Module name The module name is displayed and cannot be changed at this point.
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Table 8-20 Network Syslog - settings for log events

Log event Configuring Comments
Packet filter events (firewall) The packet filter log records certain 

packets of the data traffic. Only those 
data packets for which a configured 
packet filter rule (firewall) applies or to 
which the basic protection reacts 
(corrupt or invalid packets) are logged. 
This is only possible if logging is 
activated for the packet filter rule.
Syslog alarms can be classified 
according to their origin and their 
severity level by setting Facility and 
Severity. This assignment is carried 
out with drop-down lists. The severity 
and facility that you set here is 
assigned to every event.   

The value you select here depends on the 
evaluation in the Syslog server.
If you retain the "default" value setting, the 
security module specifies the combination of 
facility and severity with which the event is 
displayed.

Audit events The audit log automatically records 
security-relevant events, for example 
user actions such as activating or 
deactivating packet logging or 
downloading configurations to the 
security module.
Assignment of the severity and facility 
is carried out with drop-down lists. The 
severity and facility that you set here 
is assigned to every event.

The value you select here for the severity and 
facility depends on the evaluation in the 
Syslog server.   
If you retain the "default" value setting, the 
security module specifies the combination of 
facility and severity with which the event is 
displayed.

System events The system log automatically logs 
successive system events, for 
example the start of a process or the 
failed login attempt of a user.

Select the "Log settings" > "Configure system 
events" entry in the local security settings to 
configure the event filter and cable 
diagnostics functions.

Security module as router

Overview of the routing settings

Meaning   
If you operate the security module in routing mode, the networks connected to the internal and 
external interface are transformed into separate subnets. The DMZ interface (SCALANCE 
S623/S627-2M only) is connected in routing mode regardless of the mode. In routing mode, 
the frames intended for an existing IP address in the subnet are forwarded. The firewall rules 
for the direction of transmission also apply.

You have the following additional options:
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● Setting specific routes - can be set in the local security settings under "Routing" 
(SCALANCE S only), see Specifying routes (Page 746) in the section "SCALANCE S".

● Use standard router - can be set in the local security settings with "External interface [P1] 
red", "Internal interface [P2] green" or "DMZ interface [P3] yellow" (SCALANCE S623/
S627-2M only) see Configuring IP address parameters (Page 729) in the section 
"SCALANCE S".
Only one standard router can be used per interface.

● NAT/NAPT routing - can be set with "NAT / NAPT" (not for CP 1628 and CP 1543-1) in the 
local security settings. To be able to use NAT/NAPT, the security module must be in routing 
mode.

Enabling routing mode (required for SCALANCE S modules only)
For this mode, you configure an internal IP address and an internal subnet mask for addressing 
the router in the internal subnet in the local security settings. All network requests that do not 
belong to a subnet are forwarded by the security module to a different subnet.

Note: In contrast to the bridge mode of the security module, VLAN tags are lost in routing 
mode. VLAN is not supported by SCALANCE S modules. Frames with a VLAN tag are 
therefore discarded by SCALANCE S modules.

1. Select the "Routing mode" option under "Mode" in the local security settings.

2. In the local security settings, enter an internal IP address and an internal subnet mask for 
addressing the router on the internal subnet in the input boxes under "Internal interface 
[P2] green" > Ethernet addresses".

Overview of NAT/NAPT

Module-specific function
This function is not available for the CP 1628 and CP 1543-1.

Requirement
The security module is in routing mode or the DMZ interface is activated (SCALANCE S623 / 
S627-2M only).

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "NAT / NAPT".

3. When required, enable address translation according to NAT(Network Address Translation) 
or NAPT (Network Address Port Translation).
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Address translation with NAT (Network Address Translation)
NAT is a procedure for address translation between two address spaces.
The main task is to translate private addresses into public addresses; in other words into IP 
addresses that are used and even routed on the Internet. As a result, the IP addresses of the 
internal network are not known to the outside in the external network. The internal nodes are 
only visible to the external network by means of external IP address that is specified in the 
address translation list (NAT table). If the external IP address is not the address of the security 
module and if the internal IP address is unique, this is known as 1:1 NAT. With 1:1 NAT, the 
internal address is translated to this external address without port translation. Otherwise, n:1 
NAT is being used.

Address translation with NAPT (Network Address Port Translation)
The address translation with NAPT changes the target address and the target port to a 
communication relation (port forwarding).

Frames coming from the external network or DMZ network and intended for the IP address of 
the security module are translated. If the destination port of the frame is identical to one of the 
values specified in the "Source port" column, the security module replaces the destination IP 
address and the destination port as specified in the corresponding row of the NAPT table. With 
the reply, the security module uses the values for the destination IP address and destination 
port as contained in the initial frame as the source IP address and the source port.

The difference to NAT is that with this protocol ports can also be translated. There is no 1:1 
translation of the IP address. There is now only a public IP address that is translated to a series 
of private IP addresses with the addition of port numbers.

Consistency check - these rules must be adhered to
When assigning addresses, remember the following rules to obtain consistent entries:

Check / rule Check made
locally project-wide

The internal IP addresses must not be identical to the IP addresses of the module.  x
Use the part specified by the subnet mask for the IP addresses:
● IP addresses that you specify for the direction "external" must be in the same 

subnet range as the external IP address of the security module under the entry 
"External interface [P1] red".

● IP addresses that you specify for the direction "internal" must be in the same 
subnet range as the internal IP address of the security module under the entry 
"Internal interface [P2] green".

● IP addresses that you specify for the direction "DMZ" must be in the same subnet 
range as the DMZ IP address of the security module under the entry "DMZ 
interface [P3] yellow".

 x

An IP address used in the NAT/NAPT address conversion list must not be a multicast 
or broadcast address.     

 x
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Check / rule Check made
locally project-wide

The external ports assigned for the NAPT translation are in the range > 0 and 
≤ 65535.
Port 123 (NTP), 443 (HTTPS), 514 (Syslog), 161 (SNMP), 67+68 (DHCP), 
500+4500 (IPsec) and 161 (SNMP) are excluded if the relevant services are 
activated on the security module.

x  

The external IP address of the security module or the IP address of the DMZ interface 
may only be used in the NAT table for the action "Source NAT".

x  

Checking for duplicates in the NAT table
An external IP address or an IP address in the DMZ network used in the direction 
"Destination NAT", "Source NAT +Destination NAT" or "Double NAT" may only be 
used once in each specified direction.

x  

Checking for duplicates in the NAPT table: A source port number may only be 
entered once for each interface.

x  

Internal NAPT ports can be in the range > 0 and ≤ 65535. x  

See also
Overview of the routing settings (Page 684)

NAT/NAPT routing

Enabling NAT
The input boxes for NAT are enabled. NAT address translations only take effect with the entries 
in the address translation list described below. After creating NAT rules, the corresponding 
firewall rules are generated and displayed in advanced firewall mode, see section:

Relationship between NAT/NAPT router and firewall (Page 692)

If PPPoE is activated for the external interface or the DMZ interface, the action "Destination 
NAT" cannot be configured. When configuring the action "Source NAT", the IP address cannot 
be entered in the "Source translation" input box because this is obtained dynamically during 
runtime.

Possible address translations for NAT
The following tables show the input options for address translation with NAT. 

Action "Destination NAT" - "Redirect"
The action "Destination NAT" can be performed in the following direction:

● External to internal

If the DMZ interface of the security module (SCALANCE S623/S627-2M only) is activated, the 
action "Destination NAT" can also be performed in the following directions:
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● External to DMZ

● DMZ to internal

● DMZ to external

The following applies, for example for the direction "external to internal":  The destination IP 
address of a frame coming from the external network is checked to see whether it matches 
the IP address specified in the "Destination IP address" input box. If it matches, the frame is 
forwarded into the internal network by replacing the destination IP address of the frame with 
the IP address specified in the "Destination translation" input box. Access from external to 
internal using the external address is possible.

The following table shows the input required for the action "Destination NAT".

Box Possible entries Meaning
Source IP address Not relevant for this action. -
Source translation Not relevant for this action. -
Destination IP address IP address in the source network Destination IP address in the source network with 

which an IP address in the destination network will be 
accessed.
If the destination IP address in a frame matches the 
address entered, the address is replaced by the 
corresponding IP address in the destination network.
If the IP address entered here is not the IP address of 
the security module, this becomes an alias address. 
This means that the specified IP address is also 
registered as an IP address on the selected interface. 
Make sure that the alias address does not cause an 
IP address conflict in the network.

Destination translation IP address in the destination network The destination IP address is replaced by the IP 
address specified here.

No. - Consecutive number assigned by STEP 7 used to 
reference the firewall rule generated by STEP 7 for the 
NAT rule.

Action "Source NAT" - "Masquerading"
The action "Source NAT" can be performed in the following direction:

● Internal to external

If the DMZ interface of the security module (SCALANCE S623/S627-2M only) is activated, the 
action "Source NAT" can also be performed in the following directions:

● Internal to DMZ

● External to DMZ

● DMZ to external

The following applies, for example for the direction "internal to external": The source IP address 
of a frame coming from the internal network is checked to see whether it matches the IP 
address specified in the "Source IP address" input box. If it matches, the frame with the external 
IP address specified in the "Source translation" input box is forwarded to the external network 
as a new source IP address. In the external network, the external IP address is effective.
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The following table shows the input required for the action "Source NAT".

Box Possible entries Meaning
Source IP address IP address in the source network The source IP address of the specified node is replaced 

by the IP address specified in the "Source translation" 
input box.

IP address range in the source network The IP address range is replaced by the IP address 
specified in the "Source translation" input box.

* The IP addresses of all nodes in the source network are 
replaced by the IP address specified in the "Source 
translation" input box.

Source translation IP address in the destination network
 

Entry of the IP address that will be used as the new 
source IP address.
If the IP address entered here is not the IP address of 
the security module, this becomes an alias address. This 
means that the specified address is also registered as 
an IP address on the selected interface. Make sure that 
the alias address does not cause an IP address conflict 
in the network.

Destination IP address Not relevant for this action. Not relevant for this action.
Destination translation Not relevant for this action. Not relevant for this action.
No. - Consecutive number assigned by STEP 7 used to 

reference the firewall rule generated by STEP 7 for the 
NAT rule.

You can configure an address translation to the module IP address in the destination network 
for all frames going from a source network to a destination network. The security module also 
assigns a port number for each frame. This is an n:1 NAT address translation in which multiple 
IP addresses of the source network are translated to one IP address of the destination network.

Enter, for example, the following parameters for the direction "internal to external":

● Action: "Source NAT"

● From: "Internal"

● To "External"

● Source IP address: "*"

● Source translation: External IP address of the security module
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Action "Source NAT + Destination NAT" - "1:1-NAT"
The action "Source NAT + Destination NAT" can be performed in the following direction:

● Internal to external

If the DMZ interface of the security module (SCALANCE S623/S627-2M only) is activated, the 
action "Source NAT + Destination" can also be performed in the following directions:

● Internal to DMZ

● External to DMZ

● DMZ to external

The following applies, for example for the direction "internal to external": When accessing from 
internal to external, the action "Source NAT" is performed. When accessing from external to 
internal, the action "Destination NAT" is performed.

The following table shows the input required for the action "Source NAT + Destination NAT":

Box Possible entries Meaning
Source IP address IP address in the source network The configuration is always specified in the source 

NAT direction. The IP addresses of the destination 
NAT direction are then inserted automatically by 
STEP 7.

Source translation IP address in the destination network
Destination IP address Not relevant for this action.
Destination translation Not relevant for this action.
No. - Consecutive number assigned by STEP 7 used to 

reference the firewall rules generated by STEP 7 for 
the NAT rule.

Action "Double NAT"
The action "Double NAT" can be performed in the following directions:

● Internal to external

● External to internal

If the DMZ interface of the security module (SCALANCE S623/S627-2M only) is activated, the 
action "Double NAT" can also be performed in the following directions:

● Internal to DMZ

● External to DMZ

● DMZ to internal

● DMZ to external

In every direction, Source and Destination NAT always take place at the same time.
The following applies, for example for the direction "external to internal": When accessing from 
external to internal, the source IP address of the external node is replaced (Source NAT). 
Access to the internal network also uses the external IP address specified in the "Destination 
IP address" input box (Destination NAT).

You can, for example, use this action if a standard router other than the security module is 
entered for a device to be accessed using Destination NAT. Response frames from this device 
are then not sent to the entered standard router but to the corresponding interface of the 
security module.
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The following table shows the input required for the action "Double NAT":

Box Possible entries Meaning
Source IP address IP address in the source network IP address of the node in the source 

network
Source translation - The Source NAT address translation is 

always to the IP address of the security 
module in the destination network. For 
this reason, the "Source translation" 
input box cannot be configured.

Destination IP address IP address in the source network Destination IP address in the source 
network with which an IP address in the 
destination network will be accessed.
If the destination IP address in a frame 
matches the IP address entered, the IP 
address is replaced by the IP address 
specified in the "Destination translation" 
input box.
If the IP address entered here is not the 
IP address of the security module, this 
becomes an alias address. This means 
that the specified address is also 
registered as an IP address on the 
selected interface. Make sure that the 
alias address does not cause an IP 
address conflict in the network.

Destination translation IP address in the destination network The destination IP address is replaced 
by the IP address specified here. 

No. - Consecutive number assigned by 
STEP 7 used to reference the firewall 
rule generated by STEP 7 for the NAT 
rule.

Enabling NAPT
The input boxes for NAPT are enabled. NAPT translations only take effect with the entries in 
the list described below. After creating NAPT rules, the corresponding firewall rules are 
generated and displayed in advanced firewall mode, see section:
Relationship between NAT/NAPT router and firewall (Page 692)

The IP address translation with NAPT can be performed in the following direction:

● External to internal

If the DMZ interface of the security module (SCALANCE S623/S627-2M only) is activated, the 
IP address translation with NAPT can also be performed in the following directions:

● External to DMZ

● DMZ to internal

● DMZ to external

The following applies, for example for the direction "external to internal": Frames intended for 
the external IP address of the security module and for the port entered in the "Source port" 
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column are forwarded to the specified destination IP address in the internal network and to the 
specified destination port.

The following table shows the input required for address translation with NAPT:

Box Possible entries Meaning
Source port TCP/UDP port or port range

Example of entering a port range: 78:99
A node in the source network can send a frame to a node in the 
destination network by using this port number.

Destination IP 
address

IP address in the destination network Frames intended for the IP address of the security module in 
the source network and the TCP/UDP port specified in the 
"Source port" box are forwarded to the IP address specified here.

Destination 
port

TCP/UDP port Port number to which the frames coming from the source 
network are forwarded.

Protocol ● TCP+UDP
● TCP
● UDP

Selection of the protocol family for the specified port numbers

No. - Consecutive number assigned by STEP 7 used to reference the 
firewall rule generated by STEP 7 for the NAPT rule.

Relationship between NAT/NAPT router and firewall

Meaning
After creating NAT/NAPT rules, STEP 7 automatically generates firewall rules that enable 
communication in the configured address translation direction. The generated firewall rules 
are visible in advanced firewall mode and can, if necessary, be moved and expanded 
(additional IP address, services, bandwidth). In addition to this, the generated firewall rules 
should be checked in terms of their priority and their position. If necessary, the generated 
firewall rules can be moved. Firewall parameters generated by STEP 7 cannot be adapted. 
After deactivating NAT/NAPT, the firewall rules generated by 7 are disabled.

To clarify the relationship between the NAT/NAPT rules and the corresponding firewall rules, 
they are identified by corresponding, consecutive numbers.

The following table shows the system behind the firewall rules generated for NAT rules.

Table 8-21 NAT address translation and corresponding firewall rules

NAT action Created firewall rule
Action From To Source IP address Destination IP 

address
Source NAT Allow Source network Destination network IP address of the 

node specified in 
the "Source IP 
address" input box

-

Destination 
NAT

Allow Source network Destination network - IP address of the 
node specified in 
the "Destination 
translation" input 
box
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NAT action Created firewall rule
Action From To Source IP address Destination IP 

address
Source NAT + 
Destination 
NAT

Allow Source network Destination network IP address of the 
node specified in 
the "Source IP 
address" input box

-

Allow Destination network Source network - IP address of the 
node that was 
inserted in the 
"Destination 
translation" input 
box by STEP 7

Double NAT Allow Source network Destination network IP address of the 
node specified in 
the "Source IP 
address" input box

IP address of the 
node specified in 
the "Destination 
translation" input 
box

The following table shows the system behind the firewall rules generated for NAT rules.

Table 8-22 NAPT translations and created firewall rules

Created firewall rule
Action From To Source IP address Destination IP 

address
Service

Allow Source network Destination 
network

- IP address of 
the node 
specified in the 
"Destination IP 
address" input 
box

[Portnumber_proto
col]

Configuring time-of-day synchronization

Overview of time-of-day synchronization

Meaning
The date and time are maintained on the security module to verify the validity (time) of a 
certificate and for time stamping log entries. For CPs, time-of-day synchronization is active as 
default.

The following alternatives can be configured:
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● Set time of day when loading (only for SCALANCE S): The module time is set automatically 
to the PC time when a configuration is downloaded.

● SIMATIC (for CPs only): If the security module receives MMS time-of-day messages, its 
local time is synchronized provided the NTP procedure was not configured (MMS = 
Manufacturing Message Specification).

● NTP: Automatic setting and cyclic synchronization of the time-of-day by means of Network 
Time Protocol server.

 

  Note

Time-of-day synchronization relates solely to the security module and cannot be used to 
synchronize devices in the internal network of the security module. S7 CPs can forward 
the time of day to other modules of the station.

 

  Note
Configuring the firewall for communication with NTP servers

If the NTP server cannot be reached by the security module, you will need to allow the 
frames from the NTP server explicitly in the firewall (UDP, port 123).     

 

Defining an NTP server

Creating NTP servers in the global security settings
In the global security settings only NTP servers of the type "NTP (secure)" can be created and 
assigned CPs or SCALANCE S V4 modules. Non-secure NTP servers for SCALANCE S 
modules < V4 and CPs therefore need to be created in the local security settings.

1. Double-click the "NTP" entry in the global security settings.

2. Double-click on the "Add new NTP server" entry.

3. Enter a name for the NTP server (secure).

4. Enter the IP address of the NTP server (secure). If the NTP server will only be assigned 
SCALANCE S V4 modules, an FQDN can be specified as an alternative.

5. Specify the encryption parameters for the NTP server (secure).

Property Meaning
Key ID Numeric value between 1 and 65534.
Authentication Select the authentication algorithm.
Hex/ASCII Select the format for the NTP key.
Key Enter the NTP key with the following lengths:

Hex: 22 ... 40 characters
ASCII: 11 ... 20 characters

6. Assign a the required security module to the NTP server (secure) you have created, see 
section:
Assigning the security module to an NTP server (secure) (Page 698).
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Creating NTP servers in the local security settings
1. Select the module to be edited.

2. Select the "Time-of-day synchronization" entry in the local security settings.

3. Select the required synchronization mode.

4. Enter a name and the IP address of the NTP server. If you have selected the "NTP (secure)" 
synchronization mode, you can select an NTP server (secure) that you created in the global 
security settings in the "Name" column.

Configuration limits for NTP servers
The following rules apply when creating NTP servers:

● You can create 32 NTP servers throughout the project.

● You can assign a maximum of 4 NTP servers to one security module.

Importing/exporting NTP servers (secure)
Using the "Import" or "Export" commands in the shortcut menu, you can export the key list of 
the currently selected NTP server (secure) and import the file into an NTP server (secure) or 
vice versa.   

Configuring time-of-day synchronization for a security module

How to access this function
1. Select the module to be edited.

2. Select the "Time-of-day synchronization" entry in the local security settings.

3. Select the "Activate time-of-day synchronization" check box.

Alternatives for time-of-day synchronization
The following alternatives can be configured:

Table 8-23 Time synchronization for CP and SCALANCE S

Possible selection Meaning / effect
Set time of day when loading (only for 
SCALANCE S)

The module time is set automatically to the PC time when 
a configuration is downloaded.

SIMATIC (not for SCALANCE S) If the security module receives MMS time-of-day 
messages, its local time is synchronized provided the 
NTP procedure was not configured (MMS = 
Manufacturing Message Specification).

NTP (not for SCALANCE S ≥ V3) Automatic setting and periodic synchronization of the 
time using an NTP server. 

NTP (secure) (not for SCALANCE S < V4)  Automatic setting and periodic synchronization of the 
time using an NTP server (secure).
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Selecting the mode of time-of-day synchronization
Follow these steps:

1. Select the synchronization mode.

2. The following configuration options are available to you depending on the selected mode:
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● Set time of day when loading: When a configuration is downloaded to a SCALANCE S 
module, the module time of day is set with the PC time of day.

● SIMATIC: For the CP x43-1 select whether the CP is to adopt or forward the time of day. 
The CP 1628 always forwards the time of day. For CPs you also the set direction for 
forwarding the time.
Available directions:

– Automatic (only for CP x43-1): The CP receives the time from the station or from the 
LAN and forwards it to the station or to the LAN. If multiple CPs are being operated in 
the station, this automatic setting can cause collisions. To avoid this, you can specifically 
define the forwarding direction.

– From station (for CP x43-1 only).

– From LAN.

If forwarding of the time of day is enabled, you can use the "Use corrected time" check box 
to specify whether or not a correction factor included in the time-of-day frame is used. For 
the CP 1628, this option is enabled as default and cannot be disabled.

● NTP:

– Time zone: In NTP mode, generally UTC (Universal Time Coordinated) is transmitted. 
This corresponds to GMT (Greenwich Mean Time). The time offset from UTC can be 
set by configuring the local time zone.

– Update interval in seconds: Defines the interval between the time queries in seconds. 
For SCALANCE S ≥ V3, the time interval for querying the NTP server is specified 
automatically.

 

  Note
Setting the update interval for CPs

If the "Enable security functions" check box is enabled in the local security settings of 
a CP, the setting for the update interval is transferred from the CP's local settings into 
the CP's local security settings.

 

– Time-of-day synchronization on the full minute (for CP x43-1/CP 1628 only): With this 
option, you can decide whether or not the time of day is forwarded to the communications 
bus on the full minute. This option is required for certain special applications.

– Accept time of non-synchronized NTP servers (only for CP x43-1/CP 1628/CP 1543-1): 
Here you can specify whether the security module also accepts the time-of-day from 
non-synchronized NTP servers.

– Forward time of day to station (only for CP x43-1/CP 1628): Disable this option if the 
CPU requests the time separately from an NTP server. This prevents the time on the 
CPU obtained directly from the NTP server from being overwritten by the time detected 
in the CP. The accuracy may be reduced slightly due to forwarding via the CP.

– NTP server: Creating NTP servers in the local security settings is described in the 
section Defining an NTP server (Page 694).
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Assigning the security module to an NTP server (secure)

Requirement
● You have defined an NTP server (secure) in the global security settings.

● "NTP" or "NTP (secure)" is selected as the time-of-day synchronization mode in the local 
security settings of the security module that you want to assign to an NTP server (secure).

Procedure
1. Double-click the "NTP" entry in the global security settings.

2. Double-click the entry "Assign module to an NTP server".

3. From the "NTP Server" drop-down list, select the NTP server (secure) to which you want 
to assign a security module.

4. In the "Available modules" section, select the security module that you want to assign to 
the selected NTP server (secure).

5. Click the  button to assign the selected security module to the selected NTP 
server (secure).

Result
You have assigned the security module to the NTP server (secure). The NTP server (secure) 
is displayed automatically in the local security settings in the list of NTP servers.

Security module as DHCP server

Module-specific function
The use of the security module as a DHCP server is only possible with SCALANCE S modules, 
see subsection:
Auto-Hotspot in the section "SCALANCE S".

Configuring SNMP

Overview of SNMP

What is SNMP?
The security module supports the transfer of management information using the Simple 
Network Management Protocol (SNMP). For this purpose, an SNMP agent that receives and 
responds to SNMP requests is installed on the security module. The information on the 
properties of SNMPcompliant devices is entered in MIB files (MIB = Management Information 
Base) for which the user must have the required rights.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
698 System Manual, 02/2014



In SNMPv1, the "community string" is also sent. The "community string" is like a password that 
is transmitted along with the SNMP request. If the community string is correct, the security 
module replies with the required information. If the string is incorrect, the security module 
discards the query and does not reply. The community string is transmitted via SNMPv1 without 
encryption.

SNMPv3 lets you transmit encrypted data.

Configuring SNMP - "SNMP" entry

Module-specific function
The configuration of SNMP is possible only for SCALANCE S V3 or higher, S7 CPs and the 
CP 1628.

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "SNMP".

3. Activate the "Activate SNMP" check box.

4. Select one of the following SNMP protocol versions:
 

  Note
Encrypted data transmission with SNMPv3

You should use SNMPv3 to transmit data in encrypted form in order to enhance security.
 

– SNMPv1 
The security module uses the following default values for the community strings to 
control the access rights in the SNMP agent. These default values should be adapted 
to increase security.
For read access: public
For read and write access: private
To enable write access using SNMP, select the "Allow write access" option. 

– SNMPv3 
Select either only an authentication algorithm or an authentication algorithm and an 
encryption algorithm.
Authentication algorithm: none, MD5, SHA-1 
Encryption algorithm: none, AES-128, DES   

 

  Note
Preventing the use of DES

DES is an insecure encryption algorithm. Therefore, it should only be used for reasons 
of down compatibility.
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5. If SNMPv3 is to be used, assign a user a role with corresponding activated SNMP rights to 
enable access to the module via SNMP. An overview of SNMP rights is available in the 
section 
Managing rights (Page 657).

6. In the "Advanced settings" area, configure module-specific information about the author, 
location and e-mail address overwriting the information from the project properties.
The following applies to values written to the security module by an SNMP tool using an 
SNMP-SET command:
If you select the "Keep values written by SNMP set" check box, the values are not 
overwritten when there is another download of an SCT configuration to the security module.

Configuring proxy ARP

Module-specific function
This function is available only for SCALANCE S V3 modules or higher, see section
Configuring proxy ARP (Page 750)

Activate Web server on security module

Module-specific function
This function is only available for CP x43-1 Advanced, see subsection:
Activating the Web server on CP x43-1 Advanced (Page 771) in the section "Security for 
S7-300 / S7-400 / PC CPs".

IPsec tunnel: Creating and assigning VPN groups

How to create an IPsec tunnel with VPN groups

Module-specific function
This function is not available for SCALANCE S602 and CP 1543-1 V1.0. CP 1543-1 supports 
this function only as of firmware V1.1. 

Requirement
 

 Note
Current date and current time of day on the security modules

When using secure communication (for example, HTTPS, VPN...), make sure that the 
security modules involved have the current time of day and the current date. Otherwise the 
certificates used are not evaluated as valid and the secure communication does not work.

 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
700 System Manual, 02/2014



How to access this function   
1. Double-click on the entry "VPN groups" > "Add new VPN group" in the global security 

settings to create a VPN group.

2. Double-click on the entry "VPN groups" > "Assign module to a VPN group" in the global 
security settings and assign the security modules and SOFTNET security client modules 
to the VPN group between which VPN tunnels will be established. Here, note the rules for 
forming VPN groups. You will also find these rules in the section:
Modes of VPN groups (Page 705).

Display of the VPN groups with their properties
If you select a security module that is in one or more VPN group(s), the properties of the VPN 
group(s) of which the security module is a member are shown in the "Network data" area.

The following properties of the VPN groups are displayed in columns in the "VPN" tab of the 
"Network data" area:

Property/column Meaning
VPN Names of the VPN groups of which the selected 

security module is member
Security module Names of the assigned security modules
Authentication Type of authentication: Preshared key or certificate
Group membership until Date and time up to which the VPN group 

certificate of the security module is valid
Type Model numbers of the assigned security modules
Comment Comment
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Setting the life of certificates   
Open the dialog in which you can set the expiry date of the certificate as follows:

1. Select the VPN group you want to edit in the "VPN" tab.

2. In the "Properties" > "General" tab of the Inspector window, select the entry "Authentication".
 

  Note
Expiry of a certificate

Communication through the VPN tunnel continues after the certificate has expired until 
the tunnel is terminated or the SA lifetime expires. For more information on certificates, 
refer to section:
Auto-Hotspot.

 

Quantity structure

Number of IPSec tunnels
SCALANCE S612 V2 Maximum of 64
SCALANCE S612 V3/V4 Maximum of 128
SCALANCE S613 Maximum of 128
SCALANCE S623 V3/V4 Maximum of 128
SCALANCE S627-2M V4 Maximum of 128
CP x43-1 Advanced Maximum of 32
CP 1628 Maximum of 64
CP 1543-1 V1.1 Maximum of 16

Authentication methods

The following methods are available:   
The authentication method is specified per VPN group and decides the type of authentication 
used.

The following key-based or certificate-based authentication methods are supported:
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● Preshared key 
Authentication is achieved using a previously specified character string that is distributed 
to all modules in the group. 
Enter a preshared key in the "Key" field under "Authentication" > "General" in the VPN 
group properties dialog.

● Certificate 
Certificate-based authentication "Certificate" is the default setting. The procedure is as 
follows:

– When a group is created, a CA certificate is generated as a root certificate.

– Each security module that is a member of the VPN group also receives a group certificate 
signed with the key of the CA certificate.

All certificates are based on the ITU standard X.509v3 (ITU, International 
Telecommunications Union).
The certificates are generated by a certificate authority contained in STEP 7. 

 

  Note
Restriction in VLAN operation     

No VLAN tagging is transmitted in IP frames via the VPN tunnel of the security module. 
The VLAN tags included in IP frames are lost when they pass through the security modules 
because IPsec is used to transfer the IP frames. 

As default, no IP broadcast or IP multicast frames can be transferred with IPsec through 
a layer 3 VPN tunnel. Through a layer 2 VPN tunnel of the security module, IP broadcast 
or IP multicast frames are packaged just like MAC packets including the Ethernet header 
in UDP and transferred. With these packets, the VLAN tagging is therefore retained.

 

 

Group properties for selected VPN group

VPN group properties     
 

 Note
Knowledge of IPsec necessary

To be able to set these parameters, you require IPsec experience. If you do not make or 
modify any settings, the defaults apply.

 

The following settings can be configured in the properties of a VPN group:

● Authentication method (entry: "General") 

● IKE settings (entry: "Advanced settings phase 1")  

● IPsec settings (entry: "Advanced settings phase 2")  
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How to access this function
1. In the global security settings select the VPN group whose properties you want to configure 

under the entry "VPN groups".

2. Select "Open" in the shortcut menu of this entry.
Result: The VPN group properties appear in the area of the local security settings.

3. In the "Authentication" entry, select whether to use a preshared key or certificate for 
authentication. For more detailed information, refer to section:
Authentication methods (Page 702).

Parameters for advanced settings phase 1 - IKE settings
Phase 1: Key exchange (IKE = Internet Key Exchange):

Here, you set the parameters for the protocol of the IPsec key management. Key exchange is 
handled by means of the standardized IKEv1 method for which you can set the following 
protocol parameters:   

Parameter Description
IKE mode Key exchange method:

● Main mode 
● Aggressive mode 
The difference between the main and aggressive mode is the "identity 
protection" used in the main mode. The identity is transferred encrypted 
in main mode but not in aggressive mode.

DH group phase 1 Diffie-Hellman key agreement:   
● Group 1
● Group 2
● Group 5
● Group 14
Diffie-Hellman groups (selectable cryptographic algorithms in the Oakley 
key exchange protocol).

SA lifetime type Phase 1 Security Association (SA):
● Time: Time limit in minutes
The lifetime of the current key material is limited in time. When the time 
expires, the key material is renegotiated.

SA lifetime Numeric value:
Range of values for time: 1440 ... 2500000 minutes (default: 2500000)

Encryption phase 1 Encryption algorithm:
● DES*: Data Encryption Standard (56 bit key length, mode CBC)
● 3DES-168: Triple DES (168-bit key length, mode CBC) 
● AES-128, 192, 256: Advanced Encryption Standard (128 bit, 192 bit 

or 256 bit key length, mode CBC)    
Authentication phase 1 Authentication algorithm:

● MD5: Message Digest Algorithm 5
● SHA1: Secure Hash Algorithm 1
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*DES is an insecure encryption algorithm. It should only be used for reasons of down 
compatibility. DES is not supported by the CP 1543-1 V1.1.

Parameters for advanced settings phase 2 - IPsec settings
Phase 2: Data exchange (ESP = Encapsulating Security Payload)

Here, you set the parameters for the protocol of the IPsec data exchange. The data exchange 
is in "quick mode". The entire communication during this phase is encrypted using the 
standardized security protocol ESP for which you can set the following protocol parameters:   

Parameter Description
SA lifetime type Phase 2 Security Association (SA):

● Time: Time limit in minutes. The lifetime of the current key material is 
limited in time. When the time expires, the key material is renegotiated.

● Limit: Limitation of the data volume in MB
SA lifetime   Numeric value:

● Range of values for time: 60 ... 16666666 minutes (default: 2880)
● Range of values for limit: 2000 ... 500000 MB (default: 4000)

Encryption phase 2 Encryption algorithm:
● DES*: Data Encryption Standard (56 bit key length, mode CBC)    
● 3DES-168: Triple DES (168-bit key length, mode CBC)
● AES-128: Advanced Encryption Standard (128-bit key length, mode 

CBC)
Authentication phase 2 Authentication algorithm:

● MD5: Message Digest Algorithm 5 
● SHA1: Secure Hash Algorithm 1 

Perfect Forward Secrecy   Select whether or not before each time an IPsec-SA is renegotiated, the 
key is negotiated again using the Diffie-Hellman method. Perfect Forward 
Secrecy safely prevents the new key from being derived from keys 
generated previously.

*DES is an insecure encryption algorithm. It should only be used for reasons of down 
compatibility. DES is not supported by the CP 1543-1 V1.1.

Modes of VPN groups

VPN modes
Depending on the mode of the security modules that were added to a VPN group, different 
modes of VPN groups are distinguished. The mode of a VPN group provides information about 
the security modules and their modes that can be added to the VPN group.
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Rules for forming groups
Remember the following rules if you want to create VPN groups:

● For SCALANCE S612 / S613 / S623 / S627-2M / SCALANCE M
The first module assigned in a VPN group decides which other modules can be added to 
it.
If the first SCALANCE S module to be added is in routing mode or if the first security module 
is a SCALANCE M module, only additional SCALANCE S modules with routing activated 
or SCALANCE M modules can be added because SCALANCE M modules always operate 
in routing mode. If the first SCALANCE S module added is in bridge mode, you can only 
add other SCALANCE S modules in bridge mode. If you want to change the mode of a 
VPN group, you have to remove all the modules contained in the group and add them again. 
A CP and an SSC can be added to a group with a SCALANCE S in bridge or routing mode.

● For CP / SSC
If a CP / SSC is the first module in a VPN group, security modules can be added in any 
mode. The next security module that decides the mode then also decides the mode of the 
VPN group. A CP / SSC can be assigned to several VPN groups at the same time and use 
different modes. The CP / SSC is then operated in mixed mode.   

● It is not possible to add a SCALANCE M module to a VPN group that contains a module in 
bridge mode.

Refer to the following table to see which modules can grouped together in a VPN group:

Table 8-24 Security modules and VPN modes

Module Can be included in a VPN group in...
Bridge mode Routing mode

SCALANCE S612 / S613 / S623 / S627-2M in 
bridge mode

x -*

SCALANCE S612 / S613 / S623 / S627-2M in 
routing mode

- x

CP x43-1 Adv. x x
CP 1543-1 V1.1 x x
CP 1628 x x
SOFTNET Security Client V4.0 x x
SCALANCE M875 - x

* SCALANCE S623/S627-2M modules in bridge mode can be inserted in a VPN group in routing mode 
if their DMZ interface is activated (not at the same time).

Including security module in configured VPN group
The configured VPN group properties are adopted for security modules added to in an existing 
VPN group. 
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Procedure after including a security module in a configured VPN group
Depending on whether or not you have changed the VPN group properties since the last 
download, you must make a distinction between the following:

● Case a: If you have not changed the VPN group properties and the module to be added 
actively establishes the connection to the configured modules:

1. Add the new security module to the VPN group.

2. Download the configuration to the new module.

● Case b:If you have changed the VPN group properties or the module being added does 
not actively establish the connection to the already configured modules:

1. Add the new security module to the VPN group.

2. Download the configuration to all modules that belong to the VPN group.

In case a, it is not necessary to reconfigure and load the already commissioned security 
modules. Active communication is not influenced or interrupted.

Settings for nodes with an unknown IP address   
Nodes whose IP address is unknown at the time of configuration (unknown peers) can be 
inserted in an existing VPN group. Since the nodes are usually mobile and obtain their IP 
addresses dynamically (for example a SOFTNET security client or SCALANCE M), the VPN 
tunnel can only be established if you set the parameters for Phase 1 according to one of the 
following tables ("Encryption parameter 1 to Encryption parameter 4). If you use other settings, 
you cannot establish a VPN tunnel to the end device.   

Table 8-25 Encryption parameter 1

Parameter Setting
Authentication method Certificate
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 AES-256
Authentication phase 1 SHA-1

Table 8-26 Encryption parameter 2

Parameter Setting
Authentication method Certificate
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 3DES-168
Authentication phase 1 SHA-1
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Table 8-27 Encryption parameter 3

Parameter Setting
Authentication method Certificate
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 DES
Authentication phase 1 MD5

Table 8-28 Encryption parameter 4

Parameter Setting
Authentication method Preshared key
DH group phase 1 Group 2
SA lifetime 1440 … 2500000 minutes
Encryption phase 1 3DES-168
Authentication phase 1 SHA1

Additional restrictions for the SOFTNET Security Client
For the SOFTNET security client, the following restrictions also apply:

Table 8-29 Encryption parameters for the SOFTNET Security Client

Parameter Setting / special feature
Encryption phase 1 AES-256 possible only with Windows 7
SA lifetime phase 1 1440 to 2879 minutes
SA lifetime type Must be selected identical for both phases
Encryption phase 2 No AES 128 possible
SA lifetime phase 2 60 to 2879 minutes
Authentication phase 2 No MD5 possible

Procedure after removing an active member from a VPN group  
If you remove an active node from an existing VPN group, this can still establish a connection 
to the group members even if you have downloaded the project to all members of the VPN 
group again.

If you do not want the removed active node to be able to establish the connection any longer, 
renew the CA group certificate and download the project again to the members of the VPN 
group. The certificate can be renewed in the group properties of the VPN group or in the "CA" 
tab of Certificate Manager. 
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Configuring internal network nodes

Overview of configuring internal network nodes

Configuring internal network nodes   
Each security module must know the network nodes in the entire internal network to be able 
to recognize the authenticity of a frame.

The security module must know both its own internal nodes as well as the internal nodes of 
the security modules in the same VPN group. This information is used on a security module 
to decide which data packet will be transferred in which tunnel.

By adding a security module to a VPN group, the local internal nodes/subnets of the security 
module are automatically made known to the security module. To allow communication via the 
VPN tunnel with other subnets or nodes of another subnet, these subnets or nodes need to 
be enabled for VPN tunnel communication in the configuration.

SCALANCE S modules allow network nodes to be learned automatically or configured 
statically. The mode of the security module also decides the options available for learning 
internal network nodes.  

SCALANCE S in bridge mode
In bridge mode, you can configure the internal IP/MAC nodes and the internal subnets or 
alternatively can allow automatic learning of internal nodes by the SCALANCE S.

SCALANCE S in routing mode
In routing mode there is no automatic learning mode available. Instead, enter entire subnets 
here that need to be released for tunnel communication.

CP x43-1 Advanced and CP 1628
● CP x43-1 Adv.

Decide whether or not tunnel communication to the CP (Gbit interface) and/or to the internal 
subnet (PROFINET subnet) is permitted for VPN connection partners in routing mode 
(SCALANCE S / M).

● CP 1628
Enter the NDIS nodes you want to be reachable through the tunnel of VPN connection 
partners in routing mode (SCALANCE S / M).

Automatic learning of internal network nodes

Module-specific function
SCALANCE S modules in bridge mode provide a learning mode with which the internal network 
nodes can be learned automatically during operation. For more detailed information, refer to 
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subsection:
Using the learning mode to learn internal nodes (Page 750) in the section "SCALANCE S".

Configuring IP network nodes manually for SCALANCE S

Module-specific function
How to configure IP network nodes for SCALANCE S modules manually is explained in:
Configuring IP network nodes manually (Page 752) in the section "SCALANCE S".

Configuring MAC network nodes manually for SCALANCE S

Module-specific function
How to configure MAC network nodes for SCALANCE S modules manually is explained in 
Configuring MAC network nodes manually (Page 752) in the section "SCALANCE S".

Configuring internal subnets for SCALANCE S manually

Module-specific function
How to configure the internal subnets for SCALANCE S modules is explained in 
Configuring internal subnets manually (Page 753) in the section "SCALANCE S".

Allow access to S7-300 / S7-400 CPs for VPN connection partners

Module-specific function
How to allow access to S7-300 / S7-400 CPs for VPN connection partners is explained in 
Allow access to S7-300 / S7-400 CPs for VPN connection partners (Page 771) in the section 
"Security for S7-300 /S7-400 /PC CPs".

Configuring NDIS nodes for PC CPs that can be reached through the tunnel

Module-specific function
How you configure NDIS nodes for PC CPs that can be reached through the tunnel is explained 
in 
Configuring NDIS nodes manually for PC CPs that can be reached through the tunnel 
(Page 771) in the section "Security for S7-300 / S7-400 / PC CPs".

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
710 System Manual, 02/2014



Configuring module- and connection-specific VPN settings

Requirement
The module is a member of a VPN group.

Module- and connection-specific settings
With module- and connection-specific settings, you can configure specific VPN settings. 
Module-specific settings are configured specifically for a security module while connection-
specific settings are configured specifically for a security module in a certain VPN group.

You can configure the following module-specific properties in the local security settings with 
the "VPN" entry:

● Dead peer detection

● Permission to initiate connection establishment

● Public address (IP address / FQDN) for communication via Internet gateways

● Nodes that need to be enabled for tunnel communication

If you select a security module in the list of VPN groups in the "Network data" area, the following 
connection-specific VPN settings can be seen and can be configured:

● Permission to initiate connection establishment

● Partner modules to which tunnel connections exist

● Type of transferred packets

● Selection of the local interface of the selected security module that will serve as the tunnel 
endpoint

● Selection of the partner interface that will serve as the tunnel endpoint

Dead peer detection (DPD)   
As default, DPD is enabled.

When DPD is enabled, the modules exchange additional messages at selectable intervals if 
no communication occurs at these points in time. This means that it is possible to recognize 
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whether the IPsec connection is still valid or possibly needs to be re-established. If there is no 
longer a connection, the security associations (SA) of phase 2 are terminated prematurely. If 
DPD is disabled, the SA is ended only after the SA lifetime has expired. For information on 
setting the SA lifetime, see section 
Group properties for selected VPN group (Page 703).

Permission to initiate connection establishment
You can restrict the permission for initiating the VPN connection establishment to certain 
modules in the VPN.

The decisive factor the setting of the parameter described is the assignment of the IP address 
for the gateway of the module you are configuring. If a static IP address is assigned, the module 
can be found by the partner. If the IP address is assigned dynamically and therefore changes 
constantly, the partner cannot establish a connection as things stand.

Mode Meaning
Start connection to partner (initiator/
responder) (default)

If this option is selected, the module is "active", in other 
words, it attempts to establish a connection to the partner 
with a fixed IP address.
This option is recommended when you obtain a dynamic IP 
address from the provider for the gateway of the security 
module you are configuring.
The partner is addressed over its external module IP 
address or its configured WAP IP address.

Wait for partner (responder) If this option is selected, the module is "passive", in other 
words, it waits for the partner to initiate the connection.
This option is recommended when you have been assigned 
a static IP address by the provider for the gateway of the 
security module you are configuring. It means attempts to 
establish a connection can only be initiated by the partner. 
This partner can, for example, have a dynamic WAN IP 
address.

 

 Note

Make sure that you do not set all the modules in a VPN group to "Wait for connection from 
remote VPN gateway" otherwise no connection is established.

 

WAN IP address / FQDN - IP addresses of the modules and gateways in a VPN over Internet   
When operating a VPN with IPsec tunnel over the Internet, additional IP addresses are 
generally required for the Internet gateways such as DSL routers. The individual security or 
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SCALANCE M modules must know the external IP addresses of the partner modules in the 
VPN.

 

 Note

To use a WAN as an external public network, enter the IP address that you received from 
the provider as the external IP address, through which the security module is then reachable 
in the WAN (Internet). To allow the security module to send packets via the WAN, you need 
to enter your DSL router as "Standard router".

If you use a DSL router as Internet gateway, the following ports (at least) must be opened on 
it:
● Port 500 (ISAKMP)    
● Port 4500 (NAT-T)

 

To allow this, when you configure the module, you have the option of assigning an external IP 
address as a "WAN IP address". When you download the module configuration, the group 
members are then informed of the WAN IP addresses of the partner modules. As an alternative 
to a WAN IP address, you can also enter an FQDN. If you have configured dynamic DNS on 
the security module at the same time, this FQDN must match the FQDN from the dyn. DNS 
configuration tab that is registered with a provider for dynamic DNS.

Whether the external IP address, the IP address of the DMZ interface (only SCALANCE S623 / 
S627-2M) or the WAN IP address / the FQDN will be used can be specified in the module-
specific VPN settings of the security module. In these settings, you can also specify the 
interface to be used for communication by the nodes of a VPN group and the security module 
that is authorized to set up connections.

If you do not enter an access point here, the external IP address or the IP address of the DMZ 
interface (SCALANCE S623/S627-2M only) will be used as the VPN endpoint.
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WAN

① Internal IP address - of a module
② External IP address - of a module
③ IP address of an Internet gateway (for example, GPRS gateway)
④ IP address (WAN IP address) of an Internet gateway (for example, DSL router)

Configuring internal network nodes
The configuration of internal network nodes is described in the following section:
Auto-Hotspot

See also
How to create an IPsec tunnel with VPN groups (Page 700)

Online functions - test / diagnostics and logging

Overview of diagnostics and logging in
For test and monitoring purposes, the security module has diagnostic and logging functions.     

● Diagnostic functions
These include various system and status functions that you can use for an existing network 
connection to the security module.

● Logging functions
This involves the logging of system and security events and data packets. 
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Recording events with logging functions
You select the events to be logged in the log settings for the relevant security module.

You can configure the following variants for logging:

● Local logging 
In this variant, you log events in the local buffer of the security module. You can then access 
these logs, display them and archive them on the service station in the "Online & 
diagnostics" dialog. The evaluation of the buffer areas of the security module is only 
possible if there is a network connection to the selected security module.

● Network Syslog 
With Network Syslog, you use a Syslog server that exists in the network. This logs the 
events according to the configuration in the log settings for the relevant security module.   

Archiving log data and reading in from a file
You can save the logged events for archiving in a log file and open this later even without a 
network connection to the security module. For more detailed information, refer to section 
Auto-Hotspot.

Function overview online dialog

Functions of the "Online & diagnostics" dialog
In STEP 7, the security module provides the following functions in the "Online & diagnostics" 
dialog:

Entry in the online dialog Function
Status Display of status information about the selected security module, such as the 

current IP addresses of the interfaces and the current time and date.
Interface settings (only for SCALANCE S 
V3 or higher)

Overview of the settings of the individual interfaces.

Dyn DNS (only for SCALANCE S V3 or 
higher)

Overview of the settings for dynamic DNS.

System log Display of logged system events, starting and stopping logging (only if there is 
an online connection to SCALANCE S modules) and starting and stopping the 
reading out of log data from the local buffer of the security module.

Audit log Display of logged security events, starting and stopping reading out of log data 
from the local buffer of the security module.

Packet filter log Display of logged data packets, starting and stopping logging (only if there is 
an online connection to SCALANCE S modules) and starting and stopping the 
reading out of log data from the local buffer of the security module.

ARP table (only for SCALANCE S V3 or 
higher)

Display of the ARP table of the security module.

Logged in users (only for SCALANCE S V3 
or higher)

Shows the users logged in to the Internet page for user-specific IP rule sets.

Communication status (not for SCALANCE 
S602 and CP 1543-1 V1.0)

Display of status information about VPN tunnel connections and members of 
VPN groups to which the selected security module belongs.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 715



Entry in the online dialog Function
Internal nodes (not for SCALANCE S602, 
CP 1543-1 V1.0 and PC CPs)

Display of the learned or configured internal network nodes of the security 
module.

Log files (offline view)  
● System log Display of logged system events as well as starting and stopping the display.
● Audit log Display of logged security events as well as starting and stopping the display.
● Packet filter log Display of logged data packets as well as starting and stopping the display.
Dynamically updated firewall rules (only for 
S7 CPs)

Display of the IP addresses that were released dynamically over HTTP or 
HTTPS, or loaded by a user.

Date and time (only for SCALANCE S) Date and time setting.

Requirements for access
The following requirements must be met to use the online functions of a security module:

● There is a network connection to the selected module

● The project with which the module was configured is open

● a user with the required rights must be logged in to the project

How to access this function
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. If there is no online connection established to the security module, click the "Connect online" 
button in the "Diagnostics" entry.

Online settings are not saved in the configuration
Settings that you make in online mode (for example settings for the logging memory) are not 
stored in the configuration on the security module. This is why the configuration settings are 
always applied at the restart of the module.

Functions of the online diagnostics

Status information of the security module - "Status" entry

Meaning
Display of the status of the security module selected in the project. 

Table 8-30 Online & diagnostics: - "Status" entry

System and status functions Meaning
Overview
Hardware type The type of the security module.
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System and status functions Meaning
External IP address The external IP address of the security module.

For CP 1628: The IP address of the Industrial 
Ethernet interface.
For S7 CPs: The IP address of the Gbit interface.

Internal IP address The internal IP address of the security module.
For CP 1628: The IP address of the NDIS 
interface. If there is more than one NDIS address, 
only one is displayed.
For S7 CPs: The IP address of the PROFINET 
interface.

DMZ IP address (SCALANCE S623 / S627-2M 
only)

The DMZ IP address of the security module.

Serial number The serial number of the security module.
Order number The MLFB identifier of the security module that is 

used when ordering.
Firmware version The firmware version of the security module.
Operating mode Mode of the security module (bridge mode / 

routing mode)
External MAC address The external MAC address of the security module.

For CP 1628: The MAC address of the Industrial 
Ethernet interface.
For S7 CPs: The MAC address of the Gbit 
interface.

Internal MAC address The internal MAC address of the security module.
For CP 1628: The MAC address of the NDIS 
interface.
For S7 CPs: The MAC address of the PROFINET 
interface.

DMZ MAC address (SCALANCE S623 / S627-2M 
only)

The DMZ MAC address of the security module

Hardware release The hardware product version of the security 
module.

C-PLUG Shows whether or not a C-PLUG is inserted.
Local time

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 717



System and status functions Meaning
Current time Date and time that is displayed on the security 

module.
Format for "German" user interface language: 
dd.mm.yyyy (date) hh:mm:ss (time)
Format for "English" user interface language:
mm/dd/yyyy (date) hh:mm:ss AM/PM (time)
Format for "French" user interface language:
dd/mm/yyyy (date) hh:mm:ss (time)
Format for "Italian" user interface language:
dd/mm/yyyy (date) hh:mm:ss (time)
Format for "Spanish" user interface language:
dd/mm/yyyy (date) hh:mm:ss (time)
Note (not for CPs)
You set the local time on the SCALANCE S module 
in "Functions" > "Date and time".

Operating time Time since the last restart of the security module.
Format for "German" user interface language: 
dddd.hh:mm:ss
Format for "English" user interface language: 
dddd.hh:mm:ss
Format for "French" user interface language: 
dddd.hh:mm:ss
Format for "Italian" user interface language: 
dddd.hh.mm.ss
Format for "Spanish" user interface language: 
dddd.hh:mm:ss

Time-of-day source The source from which the date and time are 
obtained.

Configuration
Created
 

Date and time when the project was first created. 
Format for "German" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "English" user interface language: 
dddd.hh:mm:ss hh:mm:ss AM/PM (time)
Format for "French" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "Italian" user interface language: 
dddd.hh.mm.ss hh.mm.ss (time)
Format for "Spanish" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)

Name File name under which the project was last saved. 
The name is set by default by STEP 7 and is 
changed when you rename the project.

Author Name of the user who created the project. Is 
adopted from the project properties.
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System and status functions Meaning
Loaded Date and time when the project was last loaded 

on the security module. 
Format for "German" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "English" user interface language: 
dddd.hh:mm:ss hh:mm:ss AM/PM (time)
Format for "French" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)
Format for "Italian" user interface language: 
dddd.hh.mm.ss hh.mm.ss (time)
Format for "Spanish" user interface language: 
dddd.hh:mm:ss hh:mm:ss (time)

Storage location Specifies the location (e.g. town) to be set using 
an SNMP tool. For SCALANCE S modules, the 
storage location can be configured as an 
alternative in the advanced SNMP settings.

File system (not for CPs)
RAM Indicates how much RAM and flash is occupied 

in the file system.Flash

Overview of the individual interfaces - "Interface settings" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher, see section
Overview of the individual interfaces - "Interface settings" entry (Page 754)

Overview of the DDNS settings - "Dynamic DNS" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher, see section
Overview of the DDNS settings - "Dynamic DNS" entry (Page 755)

Display of the ARP table - "ARP table" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher, see section
Display of the ARP table - "ARP table" entry (Page 757)
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Users logged in to the Web page - "Logged in users" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher, see section
Users logged in to the Web page - "Logged in users" entry (Page 758)

VPN connections of the security module - "Communication status" entry

Module-specific function
This function is not available for SCALANCE S 602 modules.

Meaning   
Display of the communication status of the following network components:

● Other security modules of the VPN group to which the selected security module belongs

● Internal network nodes of these security modules

Table 8-31 Online & diagnostics: "Communication Status" entry

System and status functions Meaning
Known security devices or modules Display of the nodes with which the selected 

security module is in a VPN group. This also 
shows whether the tunnel status is active or 
passive. To obtain additional information on one 
of the nodes, select this in the list. 
Note:
Configured, inactive tunnels are indicated for CPs 
only.

Endpoints Display of information on the internal network 
nodes of the security module that you selected in 
the "Known security devices or modules" table. 
For each internal network node, this shows 
whether it was learned or configured. It also shows 
the subnet in which the internal network node is 
located.
With SCALANCE S modules, the subnet of 
network nodes is only displayed in bridge mode.

Tunnel properties Display of properties of the VPN tunnel 
established to the security module that you 
selected in the "Known security devices or 
modules" table.
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Found internal network nodes - "Internal nodes" entry

Module-specific function
This function is not available for SCALANCE S602 modules and the CP 1543-1.

Meaning
Display of all learned and configured network nodes. This also displays whether or not the 
learning mode of the security module is enabled.   

Updated firewall rules - "Dynamically updated firewall rules" entry

Module-specific function
This function is only available for CP x43-1, see subsection:
Updated firewall rules - "Dynamically updated firewall rules" entry (Page 772) in the section 
"Security for S7-300 / S7-400 / PC CPs".

Display of the firewall blacklist - "Firewall blacklist" entry

Module-specific function
This function is available only for SCALANCE S V4 modules or higher, see section 
Display of the firewall blacklist - "Firewall blacklist" entry (Page 758).

Setting the date and time - "Date and Time" entry

Module-specific function
This function is available only for SCALANCE S modules, see section 
Setting the date and time - "Date and time" entry (Page 759).

Logging functions

Logging system events - "System log" entry

Meaning       
Display of logged system events and starting and stopping reading system events from the 
local memory of the security module.

The system log automatically logs successive system events, for example the start of a 
process. The logging can be scaled based on event classes.
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System and status functions Meaning
Start/stop logging (not for CPs) Starts/stops recording of system events. The 

method and the event classes that are logged are 
configured in the local security settings.

Start/stop reading Starts/stops reading of system events from the 
local memory of the security module. If you select 
the "Save log file" check box, the recorded log data 
is also saved as file. Select the storage location 
and enter a file name.
Note
If you select the "Save log file" check box after 
starting reading, the data read out up to then can 
no longer be saved in a log file.

Clear display Deletes the log data shown in the table.

For more information on opening saved system events in log files, refer to section
Evaluating system events in offline mode - "System log" entry (offline view) (Page 723).

Logging security events - "Audit log" entry

Meaning       
Display of logged security events and starting and stopping reading of security events from 
the local memory of the security module.

The audit log automatically logs successive security-relevant events. This includes, for 
example, user actions such as enabling and disabling packet logging.

System and status functions Meaning
Start/stop reading Starts/stops reading of security events from the 

local memory of the security module. If you select 
the "Save log file" check box, the recorded log data 
is also saved as file. Select the storage location 
and enter a file name.
Note
If you select the "Save log file" check box after 
starting reading, the data read out up to then can 
no longer be saved in a log file.

Clear display Deletes the log data shown in the table.

For more information on opening security events stored in log files, refer to section 
Evaluating security events in offline mode - "Audit log" entry (offline view) (Page 724).

Logging data packets - "Packet filter log" entry

Meaning     
Display of logged data packets and starting and stopping reading of packet filter events.
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The packet filter log records certain packets of the data traffic. Data packets are only logged 
if they match a configured packet filter rule (firewall) or to which the basic protection reacts 
(corrupt or invalid packets). This is only possible when logging is enabled for the packet filter 
rule. 

For information about activation of the logging, refer to section 
Auto-Hotspot.

As well as reading the log data from the buffer and transferring it to the display, it can also be 
saved in a file for archiving.

System and status functions Meaning
Start/stop logging (not for CPs) Starts/stops logging of data packets. The method 

with which the data is logged is configured in the 
local security settings.

Start/stop reading Starts/stops reading out of logged data packets 
from the local memory of the security module. If 
you select the "Save log file" check box, the 
recorded log data is also saved as file. Select the 
storage location and enter a file name.
Note
If you select the "Save log file" check box after 
starting reading, the data read out up to then can 
no longer be saved in a log file.

Clear display Deletes the log data shown in the table.
Log category Select the data packets for which the logging will 

be displayed. The selection depends on the 
settings you configured offline in the local security 
settings. Only the data packets for which logging 
was enabled are logged. If you select a category 
for which logging was not enabled, no data will be 
logged for this category.

For information on opening the stored packet filter log data, refer to section 
Evaluating packet filter events in offline mode - "Packet filter log" entry (offline view) 
(Page 724).

Evaluating log files in offline mode

Evaluating system events in offline mode - "System log" entry (offline view)

How to access this function
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. Select "Diagnostics" > "Log files (offline view)" > "System log".
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Meaning       
Opens logged system events that you saved as a file in the online view.

For more information, refer to chapter Logging system events - "System log" entry (Page 721).

Evaluating security events in offline mode - "Audit log" entry (offline view)

How to access this function       
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. Select "Diagnostics" > "Log files (offline view)" > "Audit log".

Meaning
Opens logged security events that you saved as a file in the online view.

For more detailed information, refer to section Logging security events - "Audit log" entry 
(Page 722).

Evaluating packet filter events in offline mode - "Packet filter log" entry (offline view)

How to access this function
1. Right-click on the module to process.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. Select "Diagnostics" > "Log files (offline view)" > "Packet filter log".

Meaning     
Opens logged data packets that you saved as a file in the online view.

For more detailed information, refer to section Logging data packets - "Packet filter log" entry 
(Page 722).

Download functions

Special features when downloading security configurations 
Security configurations can influence the reachability of the security module for the 
configuration PC. This, for example, is the case if there is a tunnel connection configured for 
one security module to another security module in a configuration and this configuration is 
downloaded from the configuration PC to the security module. After the download by the 
configuration PC, the security module can no longer be reached and the reachability test 
performed as default by STEP 7 following the download of the configuration fails. The error 
message output by STEP 7 relates solely to the reachability test; the actual download of the 
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configuration is ensured if the project data is consistent and the IP address relationship 
between the security module and the configuration PC is correct.

Special features when downloading configurations and firmware to SCALANCE S modules 
are described in the following subsection of the section "SCALANCE S":
Auto-Hotspot

Uploading configurations to the engineering station
Uploading a configuration from a SCALANCE S module or from the CP 1628 to an engineering 
station is not possible.

Uploading a configuration from an S7 CP that supports security to an engineering station is 
also possible if security features were included in the configuration. Configured security 
functions are not, however, transferred to the engineering station. In the transferred 
configuration on the engineering station, the "Activate security features" check box is also 
deselected.

SOFTNET Security Client

Using the SOFTNET Security Client

Area of application - access over VPN   
With the SOFTNET Security Client (SSC) PC software, secure remote access is possible from 
PGs/PCs to automation systems protected by a security module via public networks. You 
require SOFTNET Security Client V4.0 HF1 for S7-300/S7-400 CPs and for the PC CP 1628. 
These CPs are not approved for operation with SOFTNET Security Client ≤ V4.0. The 
SOFTNET Security Client has not been released for the CP 1543-1.

With the SOFTNET Security Client, a PG/PC is configured automatically so that it can establish 
a secure IPsec tunnel communication in the VPN (Virtual Private Network) with one or more 
security modules.

This IPsec tunnel communication makes it possible for PG/PC applications such as NCM 
diagnostics to securely access devices or networks that are located in an internal network 
protected by SCALANCE S.

How does the SOFTNET Security Client work?
The SOFTNET Security Client reads the configuration that was created by STEP 7 and 
determines from the file which certificates are to be imported.

The CA certificate and, when applicable, the private key are imported and stored on the local 
PG/PC. 

Following this, security settings are made based on the data from the configuration so that 
applications can access IP addresses downstream from the security modules.

If the learning mode is enabled for the internal nodes or programmable controllers, a security 
policy is first set for secure access to security modules. Then, the SOFTNET Security Client 
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addresses the security modules in order to obtain the IP addresses of the relevant internal 
nodes.

The SOFTNET Security Client enters these IP addresses in special filter lists belonging to this 
security policy. Applications can then communicate with the programmable controllers via VPN.

Creating a configuration file in STEP 7

Configuring a SOFTNET Security Client module in the project     
The SOFTNET security client is created as a module in the project. In contrast to the other 
security modules, you do not need to configure any further properties.

Assign the SSC module to the VPN group or groups at which an IPsec tunnel to the PG/PC is 
to be set up.

 

 Note

Refer to the information on parameters in section 
Including security module in configured VPN group (Page 706).

 

 Note

If you create several SOFTNET Security Clients within a group, no tunnels are set up between 
these clients but only from the relevant client to the security modules.

 

Configuration files for the SOFTNET Security Client   
The interface between STEP 7 as configuration tool and the SOFTNET Security Client is 
controlled by configuration files.

The configuration is stored in the following file types:

● *.dat 

● *.p12 

● *.cer 
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Procedure
To generate the configuration files, perform the following steps in STEP 7:

1. In the "Devices & networks" view, select the "Topology view" or the "Network view" tab.

2. Insert a PC system of the type "SOFTNET Security Client" in the selected tab from the 
hardware catalog.

3. Assign the SOFTNET Security Client to the VPN groups in which the PG/PC will 
communicate over IPsec tunnels.

4. Make sure that the "Generate SSC files" check box is selected under the "Configuration of 
the SOFTNET Security Client" entry in the local security settings of the SOFTNET Security 
Client.

5. Select the storage location for the configuration files.

6. Compile the configuration of the SOFTNET Security client to export the configuration file.

7. If you selected certificate as the authentication method, specify a password for the 
certificate of the VPN configuration. If you do not assign a password, the project name (not 
the project password) is used as the password.
Result: Export of the configuration files is completed.

8. Adopt the files of the type *.dat, *.p12, *.cer on the PG/PC on which you want to operate 
the SOFTNET Security Client.

SCALANCE S

Configuring interfaces for SCALANCE S modules 

Overview

Configuring the mode
With the mode you specify how interface routing is handled (external/internal). The DMZ 
interface of the security module (SCALANCE S623/S627-2M only) is always connected in 
routing mode. For more detailed information, refer to the section
Configuring IP address parameters (Page 729)

Configuring the interfaces
If the external interface or the DMZ interface (SCALANCE S623/S627-2M only) of a security 
module needs to be configured, it must be activated using the "Activate interface" check box. 
Set the IP address information for each interface and settings for the individual ports. The 
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following options are available with which you can assign an IP address for the external 
interface and for the DMZ interface in the "General" entry (SCALANCE S623/S627-2M only):

● Static IP address with subnet mask. For more detailed information, refer to the section
Configuring IP address parameters (Page 729)

● Address assignment using PPPoE. For more detailed information, refer to the section
Configuring an Internet connection (Page 731)
The internal interface can only be configured using a static IP address.

 

 Note
External interface and DMZ interface as Internet access

The simultaneous operation of PPPoE on the external interface and on the DMZ interface 
(dual ISP) is not possible.

 

Point to Point Protocol over Ethernet (PPPoE)
To allow Internet/WAN access directly via a DSL modem, the IP address on the external 
interface or on the DMZ interface is assigned using PPPoE. PPPoE is a dial-in protocol for 
obtaining IP addresses from an Internet service provider (ISP). SCALANCE S is operated here 
in routing mode.

To use this IP address assignment mode, specify the ISP in the "PPPoE" entry. The IP address, 
the subnet mask, the standard router and the DNS server of the interface are specified by the 
ISP.

 

 Note

A configured standard router is not taken into account when using PPPoE. This is assigned 
dynamically to the module by the ISP.

 

 Note
No network components between SCALANCE S and DSL modem

If the interface of a SCALANCE S module is operated using PPPoE, there must be no other 
network components between this interface and the connected DSL modem, otherwise the 
dial-in data of the Internet Service Provider will be transferred unencrypted over this link due 
to the protocol being used.

 

Configuring media modules
In addition to the functions of the SCALANCE S623, the S627-2M has two media module slots 
in which an electrical or optical media module with two ports can be inserted. This expands 
both the external and internal interface by up to two ports. In routing mode, the additional ports 
of the security module can be used to link the external and internal interface to ring topologies.

To integrate media modules in the SCALANCE S627-2M, select the security module and 
change to the device view. Then select the required media modules from the hardware catalog.
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For ports with the port type "Copper", you can set the transmission speed and the duplex 
method manually using the port mode. For ports with the port type "Optical", the port mode is 
fixed by the media module used or by the SFP transceiver used and cannot be adapted.

You will find information on connecting the media module ports to MRP rings in the following 
section:
Auto-Hotspot

See also
Setting the operating mode (Page 729)

Setting the operating mode

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "Mode".

Operating mode - possible selections
You can change the operating mode in this dialog if the security module is not included in a 
VPN group. If the security module is in a VPN group, the mode cannot be changed.

The selection applies to interface routing between the external and internal interface. The DMZ 
interface (SCALANCE S623 and S627-2M only) is always connected in routing mode.

Bridge mode For operation in flat networks. External and internal interface 
are in the same IP subnet.
For S623 / S627-2M: External and internal interface are in 
the same IP subnet, the DMZ interface is in a different IP 
subnet or is deactivated.

Routing mode All interfaces are in different IP subnets. If you have activated 
the routing mode, you must configure an internal IP address 
and subnet mask for the internal interface of the security 
module.
Note
If you have enabled the routing mode for the SCALANCE S 
module, no MAC firewall rules can be defined.

Configuring IP address parameters

Meaning
Specify network parameters such as the IP address and subnet mask for the interface(s) of 
the security module.
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How to access this function
1. Select the module to be edited.

2. Select "External interface [P1] red" or "DMZ interface [P3] yellow" in the local security 
settings.

 

  Note
Configuration of the internal interface in routing mode

If you have selected the "Routing" mode for the security module, you must also configure 
an internal IP address and subnet mask for the internal interface of the security module. 
You can access this function in the local security settings under "Internal interface [P2] 
green" > Ethernet addresses".

 

3. If applicable, enable the interface using the "Activate interface" check box.

4. Select the "Ethernet addresses" entry.

5. Complete the settings specified in the following table.

Parameter Meaning
IP address IP address for the external interface.

The IP address consists of four decimal numbers from 0 to 
255, with each number being separated by a period, for 
example, 141.80.0.16.

Subnet mask The subnet mask consists of four decimal numbers that are 
separated by period, for example, 255.255.0.0

Use router Select this check box if you want to use a standard router and 
enter its address in the "Router address" input box.

 

 Note
Networking the interfaces

Network the individual interfaces of the security module with suitable subnets to avoid IP 
address conflicts.

 

Special features with a standard router
● If the IP assignment configured is via "PPPoE", no standard router needs to be configured 

because the standard route is always automatically via the PPPoE interface.

● If the address assignment configured is with "Static address" and if the security module is 
connected to the Internet via a DSL (NAPT) router, the DSL router must be entered as the 
standard router.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
730 System Manual, 02/2014



Configuring port mode

Meaning
The port mode specifies the transmission speed and the duplex method. For SCALANCE S 
V2 modules, the port mode is set to "Autonegotiation" as default. This means the transmission 
speed and the duplex setting are selected automatically. Moreover, the auto-crossing function 
is supported.

Configurable port modes
For SCALANCE S V3 and higher, the following port modes can be configured:

Port mode Meaning
Autonegotiation The transmission speed and the duplex setting are selected 

automatically.
Note
A transmission speed of 1000 Mbps and the autocrossing 
function are supported only if autonegotiation is selected.

10 Mbps, half and full duplex Transmission speed of 10 Mbps
100 Mbps, half and full duplex Transmission speed of 100 Mbps

Configuring an Internet connection

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.

Requirement
The "PPPoE" entry is only displayed in the local security settings if the IP assignment method 
"PPPoE" is configured for one of the interfaces.

How to access this function
1. Select the security module to be edited

2. In the local security settings, select the entry "PPPoE".
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Meaning
In this entry, you make settings related to the Internet Service Provider (ISP) if a connection 
using PPPoE is set for one of the interfaces of the security module.

Table 8-32 Settings for the ISP account

Function Description
Authentication Select none or one of the following authentication protocols:

● PAP (Password Authentication Protocol)
● CHAP (Challenge Handshake Authentication Protocol)
Note
Both communications partners have to use the same 
authentication method otherwise no connection can be 
established.

User name Enter the name for logging in with the ISP account.
Password Enter the password for logging in with the ISP account.
Repeat password Enter the password for logging in with the ISP account again.

Table 8-33 Settings for the connection

Function Description
Permanent connection Permanent Internet connection. After the connection has been 

terminated by the provider, the connection is automatically 
restored even if there are currently no packets to be sent.

On-demand connection The Internet connection is established automatically if packets 
need to be sent to the Internet. 
In this setting, delays in the sending of packets are possible.

Maximum idle time (only with the 
setting "on-demand connection")

If no packets are sent during a certain time, the Internet 
connection is automatically terminated. In the "Maximum idle 
time" box, enter the time in seconds after which the connection 
will be terminated. Permitted values: 10 … 3600.

Forced disconnection (only with 
the "Permanent connection" 
setting)

Select the check box to be able to adapt the time of the forced 
disconnection by the security module.

Forced disconnection time (only 
with the "Permanent connection" 
setting)

The provider terminates the Internet connection automatically 
after a certain period. If you enter a time of day in this box, the 
security module terminates the Internet connection itself at this 
time. This allows disconnection of the Internet connection by the 
provider to be delayed under certain circumstances. A self-
initiated forced disconnection is only possible with an existing 
permanent connection. Permitted entries: 00:00 ... 23:59

Configuring dynamic DNS

Module-specific function
FQDNs can be configured for SCALANCE S V3 or higher. The resolution of FQDNs by 
SCALANCE S modules is possible as of SCALANCE S V4.
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Meaning
With dynamic DNS, you can access a constantly changing IP address with a permanently 
defined name (FQDN). This is necessary, for example, if you want to access a server that can 
be reached via a public IP address that changes.

How it works
The security module signals the current WAN IP address via which the security module can 
be reached to a provider for dynamic DNS (for example DynDNS.org, no-ip.com). The provider 
makes sure that DNS queries sent to the FQDN of the security module are replied to with the 
current WAN IP address of the security module.

Dynamic DNS is permitted on the following interfaces:

● External interface

● DMZ interface

Setting up dynamic DNS - Requirements
Requirement:

● An account has been created with a provider of dynamic DNS and an FQDN has been 
registered.

Setting up dynamic DNS - Follow the steps below:
1. Select the security module to be edited.

2. In the local security settings, select the entry "DNS".

3. If the security module is downstream from a DSL router or DSL modem, you specify a valid 
DNS server address. To do this, two options are available:

Option Meaning
Obtain DNS server address automatically The address of the DNS server can be obtained 

automatically using PPPoE if the security module 
is connected to the Internet via a DSL modem. Can 
only be set for the external interface and the DMZ 
interface.

Use the following DNS server address: Enter the address of the preferred and of the 
alternative DNS server manually.
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4. Activate the "Activate service" check box in the "Primary dynamic DNS service" area and 
make the following settings:

Setting Meaning
Provider Choose the provider with which you have set up 

an account for dynamic DNS.
User account with the provider Enter the user name that you specified when you 

created the account.
Password with the provider Enter the password that you specified when you 

created the account.
FQDN Enter the host name (e.g. mysecuritymodule) and 

the domain name (e.g. dyndns.org) that is 
registered with the provider separated by a period. 
If an FQDN is also entered in the "VPN" entry, both 
must match.

Monitor IP address change on DSL router If the security module is connected to the Internet 
via a DSL router, enabling this function activates 
the function of the Check IP service. The security 
module periodically sends queries to determine 
the current IP address of the DSL router and to 
detect an IP address change on the DSL router. 
The IP address specified in this way is sent to the 
provider with each change ID.

Period Specify the interval at which the Check IP service 
is called. Permitted values: 10 to 1440 minutes

5. In case the primary provider fails, create a second provider in the "Secondary dynamic DNS 
service" area (optional setting).

Setting up a user-defined provider - follow the steps below:
Select the "User-defined" entry in the "Provider" drop-down list and make the following entries:

Setting Meaning
Ignore errors when checking the 
server certificate

To ensure that the authentication data is protected, the certificate 
of the update server is checked as default. If the certificate check 
fails, the HTTPS connection is terminated and the account data 
is not transferred. If you select the check box, the function is 
disabled, for example if the server certificate of the dynamic DNS 
service is invalid (for example expired). It is advisable not to ignore 
the check and not to select the check box.

Provider update URL With the predefined providers (DynDNS.org and No-IP.com), the 
URL is already populated.

Check IP service URL With the predefined providers (DynDNS.org and No-IP.com), the 
URL is already populated.
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Configuring LLDP

Module-specific function
This function is available only for SCALANCE S V4 modules or higher.

Requirement
The security module is in routing mode.

Meaning
LLDP (Link Layer Discovery Protocol) is a protocol used to discover network topologies. A 
device capable of LLDP can send information about itself to neighboring devices at regular 
intervals and at the same time receive information from neighboring devices. The received 
information is stored on every device with LLDP capability in an LLDP MIB file. Network 
management systems can access these LLDP MIB files using SNMP and therefore recreate 
the existing network topology.

Configurable parameters
The degree of activity of the security module in terms of LLDP can be configured under the 
"LLDP mode" entry of the relevant interface.

Parameter Description
Name Name of the port for which the setting is configured.
LLDP mode Configured LLDP mode:

● RxTx: LLDP frames can be sent and received
● Off: No LLDP frames can be sent or received

Media redundancy in ring topologies

Media redundancy with MRP

Module-specific function
This function is available only for SCALANCE S627-2M modules.

Meaning
The term "media redundancy" groups together various methods for increasing availability in 
Industrial Ethernet networks in which devices can be reached over different paths. This might 
be achieved by meshing networks, arranging parallel transmission paths or by closing a linear 
bus topology to form a ring.
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Media redundancy method MRP
Media redundancy within a ring topology is available with SIMATIC NET products among other 
things with the MRP method (Media Redundancy Protocol).

With this method, one of the nodes is configured as the redundancy manager. The other nodes 
are redundancy clients. SCALANCE S627-2M modules can only adopt the role of an MRP 
client. Using test frames, the redundancy manager checks the ring to make sure it is not 
interrupted. The redundancy clients forward the test frames. If the test frames of the 
redundancy manager no longer arrive at the other ring port of the redundancy manager due 
to an interruption, the redundancy manager switches through its two ring ports and informs 
the redundancy clients of the change immediately.

The time the SCALANCE X switches need to switch through their ring ports as redundancy 
manager is 200 ms.

Note on the use of MRP
● MRP is supported in ring topologies with up to 50 devices. Exceeding this number of devices 

can lead to a loss of data traffic.

● It is recommended that you set the ring ports involved to full duplex and 100 Mbps. 
Otherwise there may be a loss of data traffic.

Possible uses of MRP on media module ports
MRP is supported only on the media module ports of the SCALANCE S627-2M. The following 
table shows the possible uses of MRP on the media module ports of a SCALANCE S627-2M:

Ring ports Media module 1 Media module 2
P4 P5 P6 P7

MRP Client - - - -
Ring 1 Ring 1 - -

- - Ring 2 Ring 2
Ring 1 Ring 1 Ring 2 Ring 2

With two lower-layer rings per SCALANCE S module, layer 3 communication is possible 
between the rings.

Configuring MRP for the security module

Requirement
● The security module is in routing mode.

● The interfaces of the security module to be connected to MRP rings are networked with the 
relevant ring managers. 
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How to access this function
1. Select the security module to be edited.

2. In the settings of the required interface, select the "Media redundancy" entry.

Configurable parameters

Parameter Meaning Possible selections
MRP domain (only if the "MRP client" media 
redundancy role is selected)

The members of an MRP ring 
are specified with the help of 
MRP domains. The same 
MRP domain must be 
selected for the interfaces of 
all modules to be connected 
to the same MRP ring.

Display of the MRP domain used for the 
interface.

Media redundancy role Selection of the media 
redundancy protocol or 
disabling of media 
redundancy for the interface.

● Not a node in the ring
● MRP Client

Ring port 1 (only when the media redundancy 
role "MRP client" is selected)

Name of the first ring port of 
the selected interface if the 
media redundancy role "MRP 
client" was selected for it.

-

Ring port 2 (only when the media redundancy 
role "MRP client" is selected)

Name of the second ring port 
of the selected interface if the 
media redundancy role "MRP 
client" was selected for it.

-

Domain settings Using the domain settings, 
you can add new MRP 
domains, edit the names of 
existing MRP domains and 
delete existing MRP domains.

-

Alternative media redundancy protocol Select this check box to 
enable the interface of the 
security module for other 
media redundancy protocols.

● Enable interface for other media 
redundancy protocols

● Disable interface for other media 
redundancy protocols (default setting)

Passive listening Enable this check box if the 
selected interface will be 
connected to third-party 
networks in which STP/RSTP 
(Spanning Tree Protocol/
Rapid Spanning Tree 
Protocol) is used.

● Activate passive listening
● Deactivate passive listening (default)
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Setting up a firewall

Local firewall rules for SCALANCE S modules

Configuring a firewall with predefined firewall rules

Configuring a firewall using predefined firewall rules

How to access this function
1. Select the module to be edited.

2. Select the "Firewall" entry in the local security settings.

Firewall enabled as default     
The "Enable firewall" check box is enabled by default. The firewall is therefore activated 
automatically and all access from external to the security module is blocked. By clicking the 
relevant check box, enable the firewall rules for the specific direction.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Enable firewall in advanced mode" check box. For more 
detailed information about the advanced firewall mode, refer to the section
Overview of local firewall rules (Page 672)

 

Firewall configuration with VPN     
If the security module is in a VPN group, the "Tunnel communication only" check box is enabled 
as default. This means that only encrypted IPsec data transfer is permitted via the external 
interface or via the DMZ interface.

If you deselect the check box, tunneled communication and also the types of communication 
selected in the other boxes are permitted.
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Table 8-34 Available firewall rules and directions

Service From 
interna

l to 
extern

al

From 
external to 

internal

From internal 
to DMZ (only 

for S623 / 
S627-2M)

From 
DMZ 

to 
interna
l (only 

for 
S623 / 
S627-
2M)

Enabled ports Meaning

Allow IP 
communica
tion

x x x x - IP communication for the selected 
communication directions is allowed. 

Allow S7 
protocol

x x x x TCP port 102 Communication of the nodes using the S7 
protocol is allowed.

Allow FTP/
FTPS 
(explicit 
mode)

x x x x TCP port 20
TCP port 21

For file management and file access 
between server and client.

Allow HTTP x x x x TCP port 80 For communication with a Web server.
Allow 
HTTPS

x x x x TCP port 443 For secure communication with a Web 
server, for example, for Web diagnostics.

Allow DNS x x x x TCP port 53
UDP port 53

Communication connection to a DNS server 
is allowed.

Allow 
SNMP

x x x x TCP port 
161/162 
UDP port 
161/162

For monitoring nodes capable of SNMP. 

Allow 
SMTP

x x x x TCP port 25 For sending e-mails via an SMTP server.

Allow NTP x x x x UDP port 123 For synchronization of the time of day.
Allow 
DHCP

x x x x UDP port 67
UDP port 68

Only in bridge mode
Communication connection with a DHCP 
server is permitted.

Table 8-35 Logging

Option Action when activated
Log tunneled packets Only active if the security module is a member of a VPN group. All IP packets transferred via 

the tunnel are logged.
Log blocked incoming 
packets

All incoming IP packets that are discarded are logged.

Log blocked outgoing 
packets

All outgoing IP packets that are discarded are logged.

You can view the logged packets at the "Packet filter log" entry in the "Online & Diagnostics" 
dialog. For more detailed information, refer to the section Logging data packets - "Packet filter 
log" entry (Page 722).
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Configuring a firewall with predefined MAC rules

How to access this function
1. Select the module to be edited.

2. Select the "Firewall" entry in the local security settings.

Firewall enabled as default     
The "Enable firewall" check box is enabled by default. The firewall is therefore activated 
automatically and all access from external to the security module is blocked. By clicking the 
relevant check box, enable the firewall rules for the specific direction.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Enable firewall in advanced mode" check box. For more 
detailed information about the advanced firewall mode, refer to the section Overview of local 
firewall rules (Page 672).

 

Firewall configuration with VPN     
If the security module is in a VPN group, the "Tunnel communication only" check box is enabled 
as default. This means that only encrypted IPsec data transfer is permitted via the external 
interface or via the DMZ interface.

If you deselect the check box, tunneled communication and also the types of communication 
selected in the other boxes are permitted.

Available MAC rules and directions

Service From internal to 
external

From external to 
internal

Meaning

Allow MAC 
communication

x x The MAC traffic from internal to external and vice versa is 
allowed.

Allow ISO protocol x x The ISO traffic from internal to external and vice versa is 
allowed.

Allow SiClock x x SiClock time frames from internal to external nodes and 
vice versa are permitted.

Allow DCP x x Internal to external or external to internal DCP traffic for IP 
address assignment is permitted.
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Table 8-36 Logging

Option Action when activated
Log tunneled packets Only active if the security module is a member of a VPN group. All 

MAC packets transferred via the tunnel are logged.
Log blocked incoming packets All incoming MAC packets that are discarded are logged.
Log blocked outgoing packets All outgoing MAC packets that are discarded are logged.

User-specific IP rule sets

Overview

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.

Meaning
Initially, individual or multiple users are assigned to user-specific IP rule sets. The user-specific 
IP rule sets are then assigned to individual or multiple security modules. This makes it possible, 
to allow user-specific access. If, for example all access to the networks downstream from a 
security module is blocked, certain nodes can be allowed for a user based on their IP 
addresses. This means that access is allowed for this user but access remains blocked for 
other users.

User logon via the Internet
The user can log in to the external interface or the DMZ interface of the security module via a 
Web page. If authentication is successful, the predefined IP rule set for this user is enabled. 
The connection of the security module is via HTTPS using the IP address of the connected 
port and taking into account the valid routing rules:

Example:

External interface: 192.168.10.1

Call up of the login page with: https://192.168.10.1/

Users can log on with every role as long as the user is assigned to a user-specific firewall rule 
set.

User-specific IP rule sets are used locally - conventions
The same conventions as described in the following section apply:
Global firewall rule sets - conventions (Page 665)
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Creating and assigning user-specific IP rule sets

Creating user-specific IP rule sets
1. In the global security settings, select the entry "Firewall" > "User-specific IP rule sets" > "IP 

rule sets".
Result: The previously created user-specific IP rule sets are displayed under the selected 
entry.

2. Double-click on the "Add new IP rule set" entry.

3. Enter the following data:

– Name: Project-wide, unique name of the rule set. The name appears in the local rule 
list of the security module after the rule set is assigned.

– Description (optional): Enter a description of the user-specific IP rule set.

4. Enter the firewall rules one by one in the list.
Note the parameter description in the following sections:
Defining IP packet filter rules (Page 673)

Assigning user-specific IP rule sets
1. Within the created user-specific IP rule set, change to the "User" tab.

2. In the "Available users" area, select the users you want to assign to the user-specific rule 
set.

3. Click the  button to assign the selected users to the user-specific rule set.
 

  Note
Assignment of user-specific IP rule sets
● A security module can only be assigned one user-specific rule set per user.
● Due to the assignment, the right to log in to the security module is activated implicitly 

for all users assigned to the IP rule set.
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Result
● The user-specific rule set is used by the assigned security modules as a local rule set and 

automatically appears in the local list of firewall rules.

● The user can log on with the security module. 

IP packet filter directions SCALANCE S

Meaning
Possible selections for the communication directions "From" and "To" in the IP rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Security module
From To S602 S61x S623 / S627-2M
Internal External x x x

Tunnel - x x
Any - x x
DMZ - - x
Internal x x x

External Internal x x x
Any - - x
Tunnel - - x
DMZ - - x

Tunnel Internal - x x
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Available options / ranges of values Security module
External - x x
DMZ - - x

Any Internal - x x
External - - x
DMZ - - x

DMZ Internal - - x
External - - x
Any - - x
Tunnel - - x

x = communication direction is configurable
- = communication direction is not configurable

MAC packet filter directions SCALANCE S

Meaning
Possible selections for the communication directions "From" and "To" in the MAC rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Security module
From To S602 S61x S623 / S627-2M
Internal External x x x

Tunnel - x x
Any - x x

External Internal x x x
Any - - x
Tunnel - - x

Tunnel Internal - x x
External - x x

Any Internal - x x
External - - x

x = communication direction is configurable
- = communication direction is not configurable

Adapting standard rules for IP services

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.
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Requirement
This function is available only in advanced firewall mode.

How to access this function
1. Select the security module to be edited.

2. In the local security settings, select the entry "Firewall" > "Standard rules for IP services".

Meaning of the advanced settings

Parameter Meaning when activated
Use advanced status options The permitted number of connections and firewall statuses 

per time unit is limited. If a network node exceeds this limit, 
its IP address is entered in the IP blacklist of the security 
module. The IP blacklist of the security module can be viewed 
in online mode.

Log all activated rules Packets that are allowed according to the default rules for IP 
services are logged.

Enable ICMP test for interfaces Ping queries coming in on an interface of the security module 
can be forwarded to other interfaces. This means that, for 
example, ping queries can be made from the external network 
to the internal interface of the security module.

Default firewall rules for SCALANCE S
The following table lists the default firewall rules for SCALANCE S modules. In some cases, 
the firewall rules are only set if the relevant service is used by the security module (e.g. SNMP).

Service Direction X1 interface 
(red)

Interface X2 
(green)

Interface X3 
(yellow) 
(only for 
S623, 
S627-2M)
 

Tunnel 
interface (not 
for S602)
 
 

Interface rerouting outgoing - x - -
HTTPS  x x* x x*
ICMP incoming - x - x
SNMP incoming x x x x
Syslog outgoing x x x x
NTP outgoing x x x x
DNS outgoing x x x x
HTTP outgoing x - x -
VPN (IKE)  x - x -
VPN (NAT Traversal)  x - x -
BootP Server incoming - x x -
BootP Client outgoing - x x -

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 745



 x enabled as default

- disabled as default

* cannot be adapted

Specifying routes

Meaning
Specify routes for addressing subnets that cannot be reached directly via the security module.

How to access this function     
1. Select the module to be edited.

2. In the local security settings, select the "Routing" entry.

3. Double-click "Add new" in the table to add a route.

4. Enter the following values:

Parameter Function Example of a value
Network ID   Requests to nodes of the subnet with the network ID and 

the subnet mask specified here are forwarded to the 
subnet via the specified router IP address.
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.
The specified network ID must not be located in the 
same subnet as the IP address of the security module.

192.168.11.0

Subnet mask The subnet mask determines the network structure. 
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.

255.255.255.0

Router IP address   IP address of the router that connects to the subnet. As 
an alternative, an FQDN can be entered for SCALANCE 
S V4 modules.
The specified router IP address must be in the same 
subnet as the IP address of the security module.

192.168.10.2

Activate rerouting 
(only for SCALANCE 
S V3/V4 modules)

Select this check box if the frames of the entered route 
will enter and leave on the same interface of the security 
module (rerouting). Rerouting is only supported on the 
internal interface of the security module.
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Security module as DHCP server

Overview DHCP server

Overview
You can operate the SCALANCE S module on the internal network and on the DMZ network 
as DHCP server (DHCP = Dynamic Host Configuration Protocol). This allows IP addresses to 
be assigned automatically to the devices connected to the internal network.   

Simultaneous DHCP server operation on both interfaces is possible (SCALANCE S623/
S627-2M only).

The IP addresses are either distributed dynamically from an address range you have specified 
or you can select a specific IP address and assign it to a particular device. If devices on the 
internal interface or on the DMZ interface should always be assigned the same IP address for 
firewall configuration, the address assignment must only be static based on the MAC address 
or based on the client ID.

Requirements
You configure the devices on the internal network or on the DMZ network so that they obtain 
the IP address from a DHCP server.

Depending on the mode, the security module sends an IP address of the standard router to 
the nodes in the relevant subnet or you need to inform the nodes in the subnet of a router IP 
address.

● Router IP address will be transferred
In the following situations, the DHCP protocol of the security module will inform the nodes 
of the router IP address:

– The node is connected to the DMZ interface (SCALANCE S623/S627-2M only)
In this case, the security module sends its own IP address as the router IP address.

– The node is connected to the internal interface and the security module is configured 
for router mode
In this case, the security module sends its own IP address as the router IP address.

– The node is connected to the internal interface and the security module is not configured 
for router mode, there is, however, a standard router specified in the configuration of 
the security module.
In this case, the security module transfers the IP address of the standard router as the 
router IP address.

● Router IP address will not be transferred
In the following situations, enter the router IP address manually on the node:

– The node is connected to the internal interface and the security module is not configured 
for router mode. There is also no standard router specified in the configuration of the 
security module.
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See also
Configuring a DHCP server (Page 748)

Configuring a DHCP server

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "DHCP server".

3. Select the interface for which you want to make the DHCP settings.

4. Make the address assignment. You have the following configuration options:

– Static address assignment
Devices with a specific MAC address or client ID are assigned the specified IP 
addresses. You specify these addresses by entering the devices in the address list in 
the "Static address assignment" group box.

– Dynamic address assignment
Devices whose MAC address or whose client ID was not specified specifically, are 
assigned a random IP address from a specified address range. For this purpose, activate 
the "Dynamic IP address pool" check box. Set the address range in the "Dynamic IP 
address pool" input area.

 

 Note
Dynamic address assignment - reaction after interrupting the power supply

Please note that dynamically assigned IP addresses are not saved if the power supply is 
interrupted. On return of the power, you must therefore make sure that the nodes request an 
IP address again.

You should therefore only use dynamic address assignment for the following nodes:
● Nodes that are used temporarily in the subnet (such as service devices).
● Nodes that have been assigned an IP address and send this as the "preferred address" 

the next time they request an address from the DHCP server (for example PC stations).

For permanent nodes you should preferably use static address assignment by specifying a 
client ID or the MAC address.
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Consistency check - these rules must be adhered to   
Remember the following rules when making the entries.

Check / rule Check made1)

locally Project-wide/
module-wide

The IP addresses assigned in the address list in the "Static address 
assignments" group box must not be in the range of the dynamic IP 
addresses.

 x

IP addresses, MAC addresses and client IDs may only occur once in 
the "Static address assignment" table (related to the security module).

 x

For the statically assigned IP addresses, you must specify either the 
MAC address or the client ID (computer name).

x  

The client ID is a string with a maximum of 63 characters. Only the 
following characters may be used: a-z, A-Z, 0-9 and - (dash).
Note
In SIMATIC S7, a client ID can be assigned to the devices on the 
Ethernet interface to allow them to obtain an IP address using DHCP.
With PCs, the procedure depends on the operating system being 
used; it is advisable to use the MAC address here for the assignment.

x  

For the statically assigned IP addresses, you must specify the IP 
address.

x  

The following IP addresses must not be in the range of the free IP 
address range (dynamic IP addresses):
● All router IP addresses in the "Routing" entry
● Syslog server
● Standard router
● Security module address(es)

 x

DHCP is supported by the security module on the interface to the 
internal subnet and on the interface to the DMZ network. The 
following additional requirements for IP addresses in the range of the 
dynamic address assignments result from this operational behavior 
of the security module:
● Bridge mode

The range must be within the network defined by the security 
module.

● Routing mode
The range must be within the internal subnet defined by the 
security module.
Note
The DMZ network always represents a separate subnet. When 
using DHCP on the DMZ interface, make sure that the free IP 
address range (dynamic IP addresses) is within the DMZ subnet.

 x

The free IP address range must be fully specified by entering the start 
address and the end address. This end address must be higher than 
the start address.

x  

The IP addresses you enter in the address list in the "Static address 
assignments" input area must be in the address range of the internal 
subnet or in the DMZ subnet of the security module.

 x
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Legend:
1) Note the explanations in the section 
Running a consistency check (Page 649).

Configuring proxy ARP

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.

Overview
Proxy ARP allows routers to respond to ARP queries for hosts. The hosts are in networks 
separated by routers but use the same IP address range.

If PC1 sends an ARP request to PC2, it receives an ARP response and the hardware address 
of the interface (MAC address of the port of the security module) on which the query was 
received from the security module located in between and not from PC2. The querying PC1 
then sends its data to the security module that then forwards it to PC2.

How to access this function
This function is only available for the internal interface of a security module that is a member 
of a VPN group and is in bridge mode.

1. Select the security module to be edited.

2. In the local security settings, select the entry "Proxy ARP".

3. If the security module is to respond to an ARP query from its own LAN as a substitute for 
the specific connection partner, enter the corresponding IP address.

IPsec tunnel: Creating and assigning groups

Configuring internal network nodes

Using the learning mode to learn internal nodes

Finding nodes for tunnel communication automatically   
One great advantage when configuring and operating tunnel communication is that 
SCALANCE S modules in bridge mode can find the nodes on the internal interface 
automatically. New nodes are detected by the security module during operation. The detected 
nodes are signaled to the security modules belonging to the same group. This allows data 
exchange within the tunnels of a group in both directions at any time.
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Detectable nodes
The following nodes are detected:

● Network nodes with IP capability
Network nodes with IP capability are found when they transmit an ICMP response to the 
ICMP subnet broadcast. 
IP nodes downstream from routers can be found if the routers pass on ICMP broadcasts.

● ISO network nodes 
You can also teach-in network nodes without IP capability that can be addressed by means 
of ISO protocols.
This is only possible if they reply to XID or TEST packets. TEST and XID (Exchange 
Identification) are auxiliary protocols for exchanging information on layer 2. By sending 
these packets with a broadcast address, these network nodes can be located.

● PROFINET nodes
Using DCP (Discovery and basic Configuration Protocol), it is possible to find PROFINET 
nodes.

Network nodes that do not meet these conditions must be configured manually.

Subnets located on the other side of internal routers also need to be configured manually.

How to access the function
1. Select the module.

2. In the local security settings, select the entry "VPN" > "Nodes".

Enabling/disabling the learning mode
The learning function is enabled in the configuration as default for every security module.

Learning can also be disabled completely for SCALANCE S. In this case, you will need to 
configure all internal network nodes participating in the tunnel communication manually.

When is it useful to disable the automatic learning mode?
The default settings for the security module assume that internal networks are always secure; 
in other words, in a normal situation, no network node is connected to the internal network if 
it is not trustworthy.

Disabling the learning mode can be useful if the internal network is static; in other words, when 
the number of internal nodes and their addresses do not change.

If the learning mode is disabled, this reduces the load on the medium and the nodes in the 
internal network resulting from the learning packets. The performance of the security module 
is also slightly improved since it does not need to process the learning packets.
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Note: In the learning mode, all nodes in the internal network are detected. The information 
relating to VPN configuration limits relates only to nodes that communicate over VPN in the 
internal network.

 

 Note

If more than 128 internal nodes are being operated, the permitted configuration limits are 
exceeded and an illegal operating status results. Due to the dynamics in the network traffic, 
this causes internal nodes that have already been learned to be replaced by new previously 
unknown internal nodes. 

 

See also
Configuring internal subnets manually (Page 753)

Configuring IP network nodes manually

Meaning
As an alternative to the learning mode that you enable using the "Enable learning of internal 
nodes" check box and that allows the security module to learn the internal network nodes 
dynamically, you can enter the network nodes to be learned manually in the "Internal IP nodes" 
entry and in doing so enable them for VPN tunnel communication. The MAC address of a 
network node can be specified as an option.

Requirement
● The security module is in bridge mode.

● The security module is a member of a VPN group.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "VPN" > "Nodes" > "Internal IP nodes".

Configuring MAC network nodes manually

Meaning
As an alternative to the learning mode that you enable using the "Enable learning of internal 
nodes" check box and that allows the security module to learn the internal network nodes 
dynamically, you can enter the network nodes to be learned manually in the "Internal MAC 
nodes" entry and in doing so enable them for VPN tunnel communication.
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Requirement
● The security module is in bridge mode.

● The security module is a member of a VPN group.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "VPN" > "Nodes" > "Internal MAC nodes".

Configuring internal subnets manually

Requirement
● The security module is a member of a VPN group.

How to access this function   
1. Select the module to be edited.

2. In the local security settings, select the entry "VPN" > "Nodes" > "Internal subnets".

Security module in bridge mode - "Internal subnets" entry
To be able to enable internal subnets for VPN tunnel communication manually, you need to 
enter the following address parameters:

Parameter Function Example of a value
Network ID Network ID of the subnet to be enabled for VPN tunnel 

communication.
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.
Must not be located in the same subnet as the IP 
address of the security module.

192.168.11.0

Subnet mask The subnet mask determines the network structure. 
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.

255.255.255.0

Router IP address IP address of the router via which the subnet you are 
allowing is reached.
Must be located in the same subnet as the IP address 
of the security module.

192.168.10.2
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Security module in routing mode - "Subnets reachable through tunnel" entry
In routing mode, entire subnets are always tunneled. To be able to enable internal subnets for 
VPN tunnel communication manually, you need to enter the following address parameters:

Parameter Function Example of a value
Network ID Network ID of the subnet to be enabled for VPN tunnel 

communication.
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.
Must not be located in the same subnet as the IP 
address of the security module.

192.168.11.0

Subnet mask The subnet mask determines the network structure. 
Based on the network ID, the router recognizes whether 
a destination address is inside or outside the subnet.

255.255.255.0

Comment Entry of additional, optional comments.  

Online functions - testing / diagnostics and logging

Overview of the individual interfaces - "Interface settings" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.
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Meaning

Table 8-37 Online diagnostics: "Interface settings" entry

System and status functions Meaning
Interfaces Table above: General overview of the interfaces of the 

security module.
 
Table below: Information on the interface operated via 
PPPoE.
● Status: Indicates whether or not a connection was 

established to the Internet Service Provider (ISP).
● Current IP address: Current IP address of the interface
● Gateway: IP address of the gateway
● Primary dynamic DNS service: Primary service for 

dynamic DNS
● Secondary dynamic DNS service: Secondary service 

for dynamic DNS
● Error code (numeric): Error information if no 

connection could be established to the ISP.
Media redundancy (SCALANCE S627-2M 
only)

● Interface: Interface connected to the MRP ring
● Protocol: Protocol used (MRP)
● Ring port 1: Name of the first media module port of the 

interface connected to the MRP ring
● Ring port 2: Name of the second media module port 

of the interface connected to the MRP ring
● Domain name: Name of the MRP domain
● Discrepancy: Displays whether or not there is an error 

in the MRP configuration
● Domain UUID: UUID of the MRP domain

Media modules (SCALANCE S627-2M 
only)

● Port: Port ID(s) of the media module port(s)
● Name: Name of the media module
● MLFB: MLFB of the media module
● Revision: Version of the media module
● Discrepancy: Displays whether or not there is an error 

in the configuration of the media module

Overview of the DDNS settings - "Dynamic DNS" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.
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Meaning

Table 8-38 Online diagnostics: "Dynamic DNS"

System and status functions Meaning
Client status Indicates whether or not a connection was established to a dyn. DNS server.
Current IP address Own (in other words logged on to dyn. DNS provider) IP address.
Defined IP address IP address assigned via PPPoE.
Current time The current time-of-day.
Force update The security module obtains the current IP address of its Internet access and sends 

an update query to the configured update server(s). This publishes the current IP 
address on the Internet. The status is displayed in the primary or secondary dynamic 
DNS service fields. This means, for example that it is possible to check whether 
configured data such as the user name and password of the dynamic DNS account 
are correct.

Cancel suspension Cancels the suspension (blocking of IP address updates from the dynamic DNS 
provider on the security module), for example after the dynamic DNS provider 
password has been corrected or an error has been eliminated.

Primary and secondary dynamic DNS service
FQDN Fully Qualified Domain Name registered with the provider.
Server IP Address IP address of the update server used.
Successful update Successful update in the dynamic DNS update service.
Last update attempt Last update attempt for DynDNS update service.
Last failed update Last update error in the dynamic DNS update service.
Error code Error status of the last unsuccessful update attempt during a dynamic DNS update.

What is the meaning of the messages?
The messages of the last DDNS update attempt have the following meaning:

Message Meaning
Success
DDNS_OK The update query was successful.
Connection-related status messages
DDNS_E_CON_UPD_SRV_RESOLV_ERR DNS name of the update server unknown, FQDN cannot 

be resolved using the known DNS server.
DDNS_E_CONUPD_SRV_UNREACHABLE Update server unreachable ("Timeout").
Security-related status messages (errors)
DDNS_E_CERT_SUBJECT_INVALID The common name of the subject in the certificate does 

not match the domain name of the update server or its 
IP address.

DDNS_E_CERT_UNABLE_TO_GET_ISSUER_CERT Issuer certificate not found.
The certificate chain could not be followed back to the 
root CA because an issuer certificate was not found. The 
trust chain is incomplete.

DDNS_E_CERT_SIGNATURE_INVALID The signature of a certificate could not be read or is 
invalid.
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Message Meaning
DDNS_E_CERT_NO_TRUST A certificate in the trust chain is invalid, in other words:

● Not yet valid or ready expired
● V3 extensions invalid
● Critical V3 extension is not supported

DDNS_E_CERT_DEPTH_ZERO_SELFSIGNED_CERT The update server has supplied a self-signed certificate 
and the certificate is not in the certificate store for 
trustworthy root CA certificates.

DDNS_E_CERT_SELF_SIGNED_CERT_IN_CHAIN The certificate chain could be established using non 
trustworthy certificates but no suitable root CA certificate 
was found in the certificate store for trustworthy 
certificates.

DDNS_E_CERT_CHAIN_TOO_LONG The certificate chain exceeds the maximum supported 
verification depth.

DDNS_E_CERT_INVALID_CA A CA certificate is invalid, in other words expired, not yet 
valid or the V3 extensions are not suitable for the 
intended purpose (for example CA not set to TRUE for 
CA certificates).

DDNS_E_CERT_KEYUSAGE_UNSUITED The V3 extensions key usage or extended key usage 
set in a certificate of the trust chain are not suitable for 
the use of the certificate.

DDNS_E_CERT_EXTENSION_UNSUPPORTED A certificate in the trust chain used an extension marked 
as critical that is not supported.

Agent-related status messages (errors)
DDNS_E_AGT_BAD_AGENT ● The update request does not correspond to the 

structure required by cRSP, for example URL 
parameters missing.

● The update request was sent to an illegal URL on 
the update server.

● The configured update string contains errors.

 

Display of the ARP table - "ARP table" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.
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Meaning
Display of the ARP table of the security module.   

Table 8-39 Online diagnostics: "ARP table" tab

System and status functions Meaning
ARP table Display of the static (proxy ARP) and dynamic 

entries of the ARP table on the security module. 
The "Publication type" tab specifies whether the 
entry is configured statically or learnt.     

Users logged in to the Web page - "Logged in users" entry

Module-specific function
This function is available only for SCALANCE S V3 modules or higher.

Meaning
Shows the users logged in to the Internet page for user-specific IP rule sets.

System and status functions Meaning
User name Name of the logged on user.
Source IP address IP address with which the user logged on.
Time remaining Remaining time before the user is automatically logged off.
Maximum time of the session Configured total time of the session.
Log off If you click the button, the selected user is logged off.

Display of the firewall blacklist - "Firewall blacklist" entry

Meaning
Displays the IP addresses of nodes that have exceeded the permitted number of connections 
and firewall statuses per time unit. These nodes are entered in the IP blacklist of the firewall.

The number of connections and firewall statuses per time unit is only limited if the "Use 
extended status options" check box is selected in the "Standard rules for IP services" entry in 
the local security settings.

If you click the "Delete all" button, the displayed IP addresses are removed from the firewall 
blacklist of the security module. The IP addresses are also no longer displayed.
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Setting the date and time - "Date and time" entry

How to access this function
1. Select the security module whose time and date you want to check or set.

2. Select the "Online & diagnostics" command from the shortcut menu.

3. In online diagnostics, select the "Functions" > "Date and time" entry.

Setting the local time on the security module
In this area, you can read out and set the time and date of the security module. When you click 
the "Apply" button, the security module is assigned the time and date currently entered in the 
"Date" and "Time" input boxes.

Setting the local time on PC
This area shows the current time and current date of the PC on which STEP 7 is installed. If 
you click the "Adopt for module" button, the security module is assigned the current time and 
current date of the PC.
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Download functions

Downloading a configuration

This needs to be taken into consideration before downloading a configuration
● IP address used for downloading configurations

Configurations are always downloaded to the security module using the IP address 
configured in the local security settings for the internal or external port. This IP address 
must match that of the security module.

● Ports
You can download the configuration data to the security module both via the external and 
the internal interface. 
Ideally, you should configure the modules of a VPN group via the common external network 
of these modules (device port 1). If the configuration computer is located on an internal 
network, you must enable the IP addresses of the other modules of the group explicitly in 
the firewall of this SCALANCE S module and first load this module.

 

  Note
Selecting a network adapter   

If you are using more than one network adapter in your PC/PG, first select the network 
adapter via which you can reach the SCALANCE S module in the "PG/PC Interface" drop-
down list of the "Extended download to device" dialog.

 

● Operating mode 
Configurations can be downloaded while the SCALANCE S devices are operating. Restart 
the SCALANCE S module to activate your configuration changes. 

 

  Note
Special characteristics
● As long as a module has not yet set IP parameters (in other words, prior to the first 

configuration), there must be no router between the module and the configuration 
computer.

● If you swap a PC from the internal to the external interface of the SCALANCE S, access 
from this PC to the SCALANCE S is blocked for approximately 20 minutes.

 
 

Transferring firmware

This needs to be taken into consideration before transferring new firmware
To transfer new firmware to a security module, the following conditions must be met:

● You have the rights required to transfer firmware; refer to section 
Auto-Hotspot.  

● The security module is configured with an IP address.
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The transfer is secure
The firmware is transferred over a secure connection and can therefore also be transferred 
from the unprotected network.

The firmware itself is signed and encrypted. This ensures that only authentic firmware can be 
downloaded to the SCALANCE S module.

The transfer can take place during operation
The firmware can be transferred while a SCALANCE S module is in operation. Newly 
downloaded firmware only becomes active after the SCALANCE S module has been restarted. 
If the transfer is disturbed and aborted, the module starts up again with the old firmware version.

Security for S7-300 /S7-400 / PC CPs

Setting up a firewall

Local firewall rules for S7-300 /S7-400 / PC CPs

Overview S7-300 CPs / S7-400 CPs /PC CPs

Enabling packet filter rules
If you enable the security function for the CPs in the local security settings, initially all access 
to and via the CP is permitted. To enable individual packet filter rules, select the "Activate 
firewall" check box. Then enable the required services. Firewall rules created automatically 
due to a connection configuration have priority over rules set manually.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Activate firewall in advanced mode" check box.

 

Firewall configuration with VPN     
If the security module is added to a VPN group, the firewall is enabled by default. In addition, 
the "Tunnel communication only" check box is enabled. This means that only encrypted IPsec 
data transfer is permitted via the external interface. External data traffic is blocked.

If you deselect the check box, tunneled communication and also the types of communication 
selected in the other boxes are permitted.
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Updating connection rules
Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button. The 
modified firewall rules are then displayed in advanced firewall mode.

Configuring a firewall with predefined firewall rules - CP x43-1 Advanced

Configuring a firewall with predefined IP rules - CP x43-1 Advanced

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "Firewall" > "Predefined IP rules".

Table 8-40 Available services and directions

Service From station/
internal to 
external

External to 
internal

From external 
to station

Enabled ports Meaning

Allow 
IP 
communicatio
n

x x x All IP traffic for the selected communication 
directions is allowed. 

Allow S7 
protocol

x x x TCP port 102 Communication of the nodes using the S7 
protocol is allowed.

Allow FTP/
FTPS (explicit 
mode)

x x x TCP port 20
TCP port 21

For file management and file access 
between server and client.

Allow HTTP x x x TCP port 80 For communication with a Web server.
Allow HTTPS x x x TCP port 443 For secure communication with a Web 

server, for example, for Web diagnostics.
Allow DNS x x - TCP port 53 

UDP port 53
Communication connection to a DNS 
server is allowed.

Allow SNMP x x x TCP port 
161/162 
UDP port 
161/162

For monitoring nodes capable of SNMP.

Allow SMTP x x - TCP port 25 For sending e-mails via an SMTP server.
Allow NTP x x - UDP port 123 For synchronization of the time of day.
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Table 8-41 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security module is 

a member of a VPN group. All IP 
packets transferred via the tunnel 
are logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that are 
discarded are logged.

Drop External Station

 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined MAC rules - CP x43-1 Advanced

How to access this function
1. Select the module to be edited.

2. Select the entry "Firewall" > "Predefined MAC rules".

Table 8-42 Available services and directions

Service From station 
to external

From external to 
station

Meaning

Allow MAC 
communication

x x The MAC traffic from station to external and vice versa is 
allowed.

Allow ISO protocol x x The ISO traffic from station to external and vice versa is 
allowed.

 

Table 8-43 Logging

Option Action when activated Relevant firewall rule
MAC log settings Action From To
Log tunneled packets Only active if the 

security module is a 
member of a VPN 
group. All MAC 
packets transferred via 
the tunnel are logged.

Allow Station Tunnel
Allow Tunnel Station
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Option Action when activated Relevant firewall rule
MAC log settings Action From To
Log blocked incoming 
packets

All incoming MAC 
packets that are 
discarded are logged.

Drop External Station

Log blocked outgoing 
packets

All outgoing MAC 
packets that are 
discarded are logged.

Drop Station External

 
 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined firewall rules - CP 1628

Configuring a firewall with predefined IP rules - CP 1628

How to access this function
1. Select the module to be edited.

2. Select the "Security" > "Firewall" > "Predefined IP rules" entry.

Table 8-44 Available services and directions

Service From external to 
station

Enabled ports Meaning

Allow IP communication x All IP traffic from external to station is 
allowed.

Allow S7 protocol x TCP port 102 Communication of the nodes using the 
S7 protocol is allowed.

Allow FTP/FTPS (explicit 
mode)

x TCP port 20
TCP port 21

For file management and file access 
between server and client.

Allow HTTP x TCP port 80 For communication with a Web server.
Allow HTTPS x TCP port 443 For secure communication with a Web 

server, for example, for Web 
diagnostics.

Allow DNS x TCP port 53
UDP port 53 

Communication connection to a DNS 
server is allowed.
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Service From external to 
station

Enabled ports Meaning

Allow SNMP x TCP port 161/162
UDP port 161/162

For monitoring nodes capable of 
SNMP.

Allow SMTP x TCP port 25 For sending e-mails via an SMTP 
server.

Allow NTP x UDP port 123 For synchronization of the time of day.

Table 8-45 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security 

module is a member of a 
VPN group. All IP packets 
transferred via the tunnel are 
logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that 
are discarded are logged.

Drop External Station

 
 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined MAC rules - CP 1628

How to access this function
1. Select the module to be edited.

2. Select the entry "Security" > "Firewall" > "MAC rules".

Table 8-46 Available services and directions

Service From station to 
external

From external to 
station

Meaning

Allow MAC level communication x x The MAC traffic from external to the 
station and vice versa is allowed.

Allow ISO communication x x ISO traffic from external to the station and 
vice versa is allowed.

Allow SiClock x x SiClock time-of-day frames from external 
to the station and vice versa are allowed.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 765



Table 8-47 Logging

Option Action when activated Relevant firewall rule
MAC log settings Action From To
Log tunneled packets Only active if the security 

module is a member of a 
VPN group. All MAC packets 
transferred via the tunnel are 
logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming MAC packets 
that are discarded are logged.

Drop External Station

Log blocked outgoing packets All outgoing MAC packets 
that are discarded are logged.

Drop Station External

 
 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

IP packet filter directions S7-300-/S7-400-/PC-CPs

Meaning
Possible selections for the communication directions "From" and "To" in the IP rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges 
of values

Security module Meaning

From To CP x43-1 
Adv.

CP 1628  

Internal Station x - Access from the internal network to the station.
Any x - Access from internal to the external network, VPN tunnel partner 

and the station.
External Station x x Access from the external network to the station.

Any x - Access from external to the internal network and the station.
Station Internal x - Access from the station to the internal network.

External x x Access from the station to the external network.
Tunnel x x Access from the station to the VPN tunnel partner.

Tunnel Station x x Access via the VPN tunnel partner to the station.
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Available options / ranges 
of values

Security module Meaning

Any x - Access from VPN tunnel partners to the internal network and the 
station.

Any External x - Access from the internal network and the station to the external 
network.

MAC packet filter directions S7-300-/S7-400-/PC-CPs

Context
Possible selections for the communication directions "From" and "To" in the MAC rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of 
values

Security module Meaning

From To CP x43-1 Adv. CP 1628  
External Station x x Access from the external network to the station.
Station External x x Access from the station to the external network.

Tunnel x x Access from the station to the VPN tunnel 
partner.

Tunnel Station x x Access via the VPN tunnel partner to the 
station.

Configuring the access list

Module-specific function
This function is not available for the CP 1628.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 767



Meaning
You set access protection for certain IP addresses using the IP access lists. List entries that 
have already been created and the corresponding rights are displayed in the local settings of 
the CP in the entry "Firewall" > "IP rules" (advanced firewall mode). 

 

 Note
Changed behavior after activation of security
● Once you have activated the security function for a CP, access protection will only apply 

to the external interface. You can apply access protection to the internal interface as well, 
by configuring suitable firewall rules in advanced firewall mode.

● The CP also responds to ARP requests from IP addresses that have not been released 
(layer 2).

● If the IP access list of a CP contains no entries and you activate security for the CP, the 
firewall will be activated and prevent access to the CP from external locations. Configure 
the corresponding firewall rules in advanced firewall mode so that the CP can be reached.

 

Effect of IP access list entries at activation of security
If security is enabled in the local settings of a CP, the corresponding rules are created in the 
advanced firewall mode. A firewall rule "Allow" > "External" > "Station" is created for an IP 
address you specified in the address list. The IP address from the IP access list is used 
accordingly as source IP address. IP addresses from a defined IP address range are also 
integrated into corresponding firewall rules.

Requirements for editing
Before you can edit created firewall rules, the following condition must be met:

● for editing using STEP 7: "Configure security" configuration right

● for editing using a Web server: Module right "Web: Expand IP access control list"

The requirements for editing the IP access lists outside the local security settings are described 
in the sections on the specific CPs. 

Connection-related automatic firewall rules

Meaning   
For connections that were configured using CPs, STEP 7 automatically creates firewall rules 
that allow communication with the partner of the CP in the specified direction (CP active/
passive). The connection establishment directions are taken into account. To display these 
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firewall rules, if the advanced firewall mode is enabled, the "Update connection rules" button 
needs to be clicked. The firewall rules are then displayed in advanced firewall mode.

 

 Note
Enabling UDP multicast and UDP broadcast connections manually

No automatic firewall rules are created for UDP multicast and UDP broadcast connections. 
To enable the connections, add the relevant firewall rules manually in advanced firewall mode.

 

Depending on how the connection establishment is configured, the following level 3 firewall 
rules are created. If the security module is in a VPN group, the direction "External" changes 
to "Tunnel". This applies only to CPs that support VPN.

The IP address of the connection partner is entered in the "Source IP address" or "Destination 
IP address" column of these firewall rules.

CP->external Action From To
active Allow Station External

Drop External Station
passive Drop Station External

Allow External Station
active and passive Allow External Station

Allow Station External

CP->internal Action From To
active Allow Station Internal

Drop Internal Station
passive Drop Station Internal

Allow Internal Station
active and passive Allow Internal Station

Allow Station Internal

For level 2 connections, "Allow" rules are created for both directions. If the security module is 
in a VPN group, the direction "External" changes to "Tunnel". This applies only to CPs that 
support VPN.

The MAC address of the connection partner is entered in the "Source MAC address" or 
"Destination MAC address" column of these firewall rules.

CP->external Action From To
active, passive, active and passive Allow Station External

Allow External Station
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 Note
Changing the connection configuration

Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button.

 

Conventions for automatically created firewall rules
● Priority

The rules have highest priority and are therefore inserted at the top in the local rule list. 

● Deleting rules
The rules cannot be deleted. Logging can be enabled and services can be assigned. 
Moreover, you may insert a bandwidth and a comment. 

● Changing the action
If you set the action from "Allow" to "Drop" or vice versa, this is overwritten again during 
renewed system synchronization. Select "Allow*" or "Drop*" to retain your changes. In this 
case, only the IP address is synchronized and the action and direction remain as set. 
Settings for logging, service, bandwidth and comment are also retained after a renewed 
system synchronization even without changing the action to "Allow*" or "Drop*". If the 
configured connection is deleted, the corresponding rules are removed from the list.

Security module in VPN group
As default, the "Tunnel communication only" check box is enabled. If you deselect the check 
box, in addition to tunnel communication between tunnel partners, communication is also 
possible with network nodes to which there is no tunnel.

● Communication is untunneled if the partner address belongs to a station known in STEP 7 
for which no VPN tunnel is configured.

● Communication is through the tunnel if the partner address is a VPN endpoint.

● If it is not clear whether connection should bypass or run through the VPN tunnel, the 
connection is assigned to the VPN tunnel and a message to this effect is displayed. The 
assignment can be adapted in advanced firewall mode, for example, by changing the 
"From" direction "Tunnel" to "External". To avoid this adaptation being overwritten by the 
next system synchronization, the "Allow*" or "Drop*" action must be selected.

 

  Note

If you want to ensure that only communication through the tunnel is possible, you will need 
to create suitable firewall rules in advanced firewall mode, for example, for internal nodes 
or NDIS addresses.

To allow only tunneled communication for a CP, add a "Drop" > "Any" > "External" rule. 
For the CP 1628, add a "Drop" > "Station" > "External" rule.  In addition to this, you need 
to remove existing firewall rules that allow untunneled communication.
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Activating the Web server on CP x43-1 Advanced

Module-specific function
This function is only available for CP x43-1.

Meaning
After activating the Web server, you have access to the Web pages of the module. In the local 
security settings, you can restrict access to these Web pages using the HTTPS protocol. This 
access is controlled using the "Allow access only using HTTPS" check box. In addition, you 
must configure the firewall accordingly.

IPsec tunnel: Creating and assigning groups

Configuring internal network nodes - "Nodes" entry

Allow access to S7-300 / S7-400 CPs for VPN connection partners

Possible selections
Decide whether or not the VPN connection partner can have access to the CP and/or the 
internal subnet of the CP in routing mode (SCALANCE S / M).

How to access this function
1. Select the module to be edited.

2. In the local security settings, select the entry "Node".

3. Configure access for the VPN connection partner of the CP in routing mode (SCALANCE 
S / M):

– Allow connection to the CP (Gbit interface)

– Allow connection to the internal subnet (PROFINET subnet)

Configuring NDIS nodes manually for PC CPs that can be reached through the tunnel

Configuring NDIS nodes that can be reached through the tunnel
The internal nodes are learned and assigned to the routes dynamically. This concerns the 
NDIS IP addresses of the Windows PC.
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Follow the steps below
1. Select the module to be edited.

2. In the local security settings, select the entry "Nodes" > "NDIS nodes reachable via tunnel".

3. Enter the NDIS IP addresses.

Online functions - Debug / Diagnostics and Logging

Updated firewall rules - "Dynamically updated firewall rules" entry

Meaning
Display of the IP addresses or IP address ranges that were enabled dynamically using HTTP 
or HTTPS, or loaded by a user. The rights assigned for accessing the S7 CP are displayed for 
the enabled IP addresses. An update of the IP addresses in this tab can only be triggered by 
the following events:

● Extension/modification of the IP access control list

● Update of firewall rules

● Dynamic extensions transmitted to the CP at runtime, for example, PROFINET IO devices

Since only the dynamically updated firewall rules are displayed here, you also need to take 
into account the firewall rules that were configured offline and downloaded to the station for a 
full picture of the current firewall status of the module.

Security for S7-1500 CPs

Setting up a firewall

Local firewall rules for S7-1500 CPs

Overview of local firewall rules

Enabling packet filter rules
If you enable the security function for the CPs in the local security settings, initially all access 
to and via the CP is permitted. To enable individual packet filter rules, select the "Activate 
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firewall" check box. Then enable the required services. Firewall rules created automatically 
due to a connection configuration have priority over rules set manually.

 

 Note
Detailed firewall settings in advanced firewall mode

In advanced firewall mode, you can restrict firewall rules to individual nodes. To change to 
advanced firewall mode, select the "Activate firewall in advanced mode" check box.

 

Updating connection rules
Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button. The 
modified firewall rules are then displayed in advanced firewall mode.

Configuring a firewall with predefined firewall rules - CP 1543-1

Configuring a firewall with predefined IP rules - CP 1543-1

How to access this function 
1. Select the module to be edited.

2. In the local security settings, select the entry "Firewall" > "Predefined IP rules".

Table 8-48 Available services and directions

Service From 
external to 

station

Enabled ports Meaning

Allow IP 
communication

x All IP traffic from external to station is allowed.

Allow S7 protocol x TCP port 102 Communication of the nodes using the S7 protocol is allowed.
Allow FTP/FTPS 
(explicit mode)

x TCP port 20
TCP port 21

For file management and file access between server and client.

Allow HTTP x TCP port 80 For communication with a Web server.
Allow HTTPS x TCP port 443 For secure communication with a Web server, for example, for 

Web diagnostics.
Allow SNMP x TCP port 161/162 

UDP port 161/162
For monitoring nodes capable of SNMP.

Allow SMTP x TCP port 25 For sending e-mails via an SMTP server.
Allow security 
diagnostics

x TCP port 8448 Allow/do not allow security diagnostics.
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Table 8-49 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security module is 

a member of a VPN group. All IP 
packets transferred via the tunnel 
are logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that are 
discarded are logged.

Drop External Station

 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

Configuring a firewall with predefined IPv6 rules - CP 1543-1

Meaning
With the predefined IPv6 rules, you have the option of configuring the firewall for services in 
which IPv6 is used. By enabling a predefined IPv6 rule in the local security settings of the CP 
1543-1 V1.1, the system-defined ICMPv6 services that can be seen in the global security 
settings in the "ICMP" tab in "Firewall" > "Services" > "Define services for IP rules"are also 
enabled in the firewall. The firewall of the CP 1543-1 V1.0 allows ICMPv6 packets through 
even without enabling a predefined IPv6 rule.

How to access this function
1. Select the module to be edited.

2. Select the "Firewall" > "Pre-defined IPv6 rules" item in the local security settings.

Table 8-50 Available services and directions

Service From 
external to 

station

Enabled ports Meaning

Allow IP traffic x All IP traffic from external to station is allowed.
Allow S7 protocol x TCP port 102 Communication of the nodes using the S7 protocol is allowed.
Allow FTP/FTPS 
(explicit mode)

x TCP port 20
TCP port 21

For file management and file access between server and client.

Allow HTTP x TCP port 80 For communication with a Web server.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
774 System Manual, 02/2014



Service From 
external to 

station

Enabled ports Meaning

Allow HTTPS x TCP port 443 For secure communication with a Web server, for example, for 
Web diagnostics.

Allow SNMP x TCP port 161/162 
UDP port 161/162

For monitoring nodes capable of SNMP.

Allow SMTP x TCP port 25 For sending e-mails via an SMTP server.
Allow security 
diagnostics

x TCP port 8448 Allow/do not allow security diagnostics via IPv6.

Table 8-51 Logging

Option Action when activated Relevant firewall rule
IP log settings Action From To
Log tunneled packets Only active if the security module is 

a member of a VPN group. All IP 
packets transferred via the tunnel 
are logged.

Allow Station Tunnel
Allow Tunnel Station

Log blocked incoming packets All incoming IP packets that are 
discarded are logged.

Drop External Station

 

 Note
Relationship between log settings in default mode and firewall rules

Log settings made in "Predefined IPv6 rules" have no effect on firewall rules that were 
automatically generated as a result of configuring a connection. This means, for example, 
that tunneled frames belonging to a configured connection cannot be logged. In advanced 
firewall mode, logging can be extended to the automatically generated firewall rules of 
connections.

 

Configuring a firewall with predefined MAC rules - CP 1543-1

How to access this function
1. Select the module to be edited.

2. Select the entry "Firewall" > "Predefined MAC rules".
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Table 8-52 Available services and directions

Service From 
station to 
external

From 
external 

to 
station

Enabled 
ports

Meaning

Allow MAC 
communication

x x - The MAC traffic from external to the station and vice versa is 
allowed.

Allow ISO protocol x x - ISO traffic from external to the station and vice versa is allowed.
Allow SiCLOCK x x - SiCLOCK traffic from external to the station and vice versa is 

allowed.

 

Table 8-53 Logging

Option Action when 
activated

Relevant firewall rule

MAC log settings Action From To
Log blocked incoming 
packets

All incoming MAC 
packets that are 
discarded are 
logged.

Drop External Station

Log blocked outgoing 
packets

All outgoing MAC 
packets that are 
discarded are 
logged.

Drop Station External

 

 Note
Relationship between log settings in default mode and firewall rules

Log settings that are made in "Predefined IP rules" and "Predefined MAC rules" have no 
effect on firewall rules that were automatically created as a result of configuring a connection. 
This means, for example, that tunneled frames belonging to a configured connection cannot 
be logged. In advanced firewall mode, logging can be extended to the automatically 
generated firewall rules of connections.

 

IP packet filter directions S7-1500 CPs

Meaning
Possible selections for the communication directions "From" and "To" in the IP rules of the 
advanced firewall mode.
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The following directions are available

Available options / ranges of values Meaning
From To  
External Station Access from the external network to the station.
Station External Access from the station to the external network.

Tunnel Access from the station to VPN tunnel partners.*
Tunnel Station Access by VPN tunnel partners to the station.*

* Not for the CP 1543-1 V1.0.

MAC packet filter directions S7-1500 CPs

Meaning
Possible selections for the communication directions "From" and "To" in the MAC rules of the 
advanced firewall mode.

The following directions are available

Available options / ranges of values Meaning
From To  
External Station Access from the external network to the station.
Station External Access from the station to the external network.

Tunnel Access from the station to VPN tunnel partners.*
Tunnel Station Access by VPN tunnel partners to the station.*

* Not for the CP 1543-1 V1.0.

Connection-related automatic firewall rules

Meaning   
For connections that were configured using CPs, STEP 7 automatically creates firewall rules 
that allow communication with the partner of the CP in the specified direction (CP active/
passive). The connection establishment directions are taken into account. To display these 
firewall rules, if the advanced firewall mode is enabled, the "Update connection rules" button 
needs to be clicked. The firewall rules are then displayed in advanced firewall mode.

 

 Note
Enabling UDP multicast and UDP broadcast connections manually

No automatic firewall rules are created for UDP multicast and UDP broadcast connections. 
To enable the connections, add the relevant firewall rules manually in advanced firewall mode.
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Depending on how the connection establishment is configured, the following level 3 firewall 
rules are created. If the CP 1543-1 V1.1 is in a VPN group, the direction "External" changes 
to "Tunnel".

The IP address of the connection partner is entered in the "Source IP address" or "Destination 
IP address" column of these firewall rules.

CP->external Action From To
active Drop External Station

Allow Station External
passive Drop Station External

Allow External Station
active and passive Allow External Station

Allow Station External

 For level 2 connections, "Allow" rules are created for both directions. If the CP 1543-1 V1.1 
is in a VPN group, the direction "External" changes to "Tunnel".

The MAC address of the connection partner is entered in the "Source MAC address" or 
"Destination MAC address" column of these firewall rules.

CP->external Action From To
active, passive, active and passive Allow Station External

Allow External Station
 

 Note
Changing the connection configuration

Changes to the connection configuration of CPs also change the connection-related firewall 
rules. To display the modified firewall rules, click the "Update connection rules" button.

 

Conventions for automatically created firewall rules
● Priority

The rules have highest priority and are therefore inserted at the top in the local rule list.

● Deleting rules
The rules cannot be deleted. Logging can be enabled and services can be assigned. 
Moreover, you may insert a bandwidth and a comment.

● Changing the action
If you set the action from "Allow" to "Drop" or vice versa, this is overwritten again during 
renewed system synchronization. Select "Allow*" or "Drop*" to retain your changes. In this 
case, only the IP address is synchronized and the action and direction remain as set. 
Settings for logging, service, bandwidth and comment are also retained after a renewed 
system synchronization even without changing the action to "Allow*" or "Drop*". If the 
configured connection is deleted, the corresponding rules are removed from the list.
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Security module in VPN group
As default, the "Tunnel communication only" check box is enabled. If you deselect the check 
box, in addition to tunnel communication between tunnel partners, communication is also 
possible with devices to which there is no tunnel.

● Communication is untunneled if the partner address belongs to a station known in STEP 7 
for which no VPN tunnel is configured.

● Communication is through the tunnel if the partner address is a VPN endpoint.

● If it is not clear whether connection should bypass or run through the VPN tunnel, the 
connection is assigned to the VPN tunnel and a message to this effect is displayed. The 
assignment can be adapted in advanced firewall mode, for example, by changing the 
"From" direction "Tunnel" to "External". To avoid this adaptation being overwritten by the 
next system synchronization, the "Allow*" or "Drop*" action must be selected.

 

  Note

If you want to ensure that only communication through the tunnel is possible, you will need 
to create suitable firewall rules in advanced firewall mode.

To allow only tunneled communication for a CP, add a "Drop" > "Any" > "External" rule. 
In addition to this, you need to remove existing firewall rules that allow untunneled 
communication.

 

8.1.4 Creating configurations

8.1.4.1 Information about the web server

Introduction
The web server lets you monitor and administer the CPU through authorized users by means 
of a network. This permits evaluation and diagnostics over long distances. All you need is a 
web browser.

Alarms and status information are visualized on HTML pages.

Web browser   
You need a web browser to access the HTML pages of the CPU.

The following web browsers have been tested for communication with the CPU:

● Internet Explorer (Version 8)

● Mozilla Firefox (Version 21)

● mobileSafari (iOS5)
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Web access to the CPU via PG/PC
Proceed as follows to access the web server:

1. Connect the client (PG/PC) to the CPU via the PROFINET interface.

2. Open the web browser.
Enter the IP address of the CPU in the "Address" field of the web browser in the format 
http://ww.xx.yy.zz (example: http://192.168.3.141).
The start page of the CPU opens. From the start page, you can navigate to further 
information. 

Additional information
Additional information about the web server of the various CPU families is available under the 
key word "Web server" in the information system.

Information on creating your own web pages for access to the CPU is available under the 
keyword "User-defined web pages" in the information system. 

See also
S7-1500 web server (http://support.automation.siemens.com/WW/view/en/59193560)

Documentation S7-300 (http://support.automation.siemens.com/WW/view/en/12996906)

Documentation S7-400 (http://support.automation.siemens.com/WW/view/en/44444467)

S7-1200 web server (http://support.automation.siemens.com/WW/view/en/36932465)

8.1.4.2 Things you should know about PROFIBUS DP operating modes

Introduction
DP master systems that consist of a DP master and DP slaves which are connected via a bus 
and communicate with one another via the PROFIBUS DP protocol are referred to as 
distributed I/O.

Below, we refer to communication-capable modules with DP interface that can take on the role 
of DP master or DP slave. 

"DP master" and "DP slave" option   
Communication-capable modules, such as CPUs with DP interface and CPs or CMs with DP 
interface, have the area "Mode" in their module properties. 

For S7-300 CPUs with integrated DP interface, for example, you can set the mode "DP master" 
and "DP slave". A CPU or a CP that is configured as DP slave is also referred to as intelligent 
DP slave (I-slave). 

For S7-1500 CPUs with integrated DP interface, only the "DP master" mode is possible. To 
operate S7-1500 CPUs as I-slave, you have to insert the communication module CM 1542-5 
and configure it as DP slave. 
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S7-1200 CPUs do not have integrated DP interfaces. To operate an S7-1200 as DP master 
or DP slave, you must insert a communication module CM 1243-5 (DP master only) or a 
communication module CM 1242-5 (DP slave only; I-slave). 

Additional information
Additional information on distributed I/O is available under the key word "Distributed I/O" and 
"I-slave" in the information system.

8.1.4.3 Configuring automation systems

Addressing modules

Addressing modules

Introduction 
In the device overview, you see the addresses or address ranges of the modules in the I 
address and Q address columns. There are other addresses as well, which are explained 
below. 

I/O address   
I/O addresses (input/output addresses) are required to read inputs and set outputs in the user 
program. 

Input and output addresses are assigned automatically when modules are inserted in the rack. 
The address of the first channel is the start address of a module. The addresses of the other 
channels are derived from this start address. The address end is obtained from the module-
specific address length.

Device address (e.g., Ethernet address)
Device addresses are addresses of programmable modules (Industrial Ethernet addresses). 
They are required to address the different stations of a subnet, for example, to download a 
user program to a CPU.

Hardware identifier for identifying modules and submodules
In addition to the I addresses and Q addresses, a hardware identifier (HW ID) is assigned 
automatically and is used to address and identify the module. Submodules (units of a module), 
such as an integrated counter, also receive such a hardware identifier. 

The hardware identifier consists of an integer and is output by the system with diagnostics 
alarms to allow the faulty module or the faulty submodule to be localized. 

In addition, the hardware identifier is used for a number of instructions to address the 
corresponding module. 
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The hardware identifier cannot be changed.

Example: Identifying high-speed counters of the S7-1200 CPU

The hardware identifier is assigned automatically when components are inserted in the device 
or network view and in the PLC tags. A name is also assigned automatically for the hardware 
identifier. The system constants of the PLC tags cannot be changed either. 

See also
Specifying input and output addresses (Page 782)

Assigning addresses to a location in the program (Page 783)

Introduction to loading a configuration (Page 1049)

Inspector window  (Page 513)

Specifying input and output addresses
Default input and output addresses are set automatically. You can, however, change the 
address assignment later. 

All addresses of modules are located in the process image area. The process image is 
automatically updated cyclically. 

Requirement
You are in the device view. 

Procedure   
To change the preset address range proceed as follows:

1. In the device view, click on the module for which you want to set the start address.

2. Go to "I/O addresses" in "Properties" in the inspector window.

3. Under "Start address" enter the required start address.

4. Press <Return> or click on any object to accept a modified value.
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If you have entered an invalid address, a message indicating the next available address is 
displayed.

 

 Note

You can also change the addresses directly in the device overview. 
 

See also
Editing properties and parameters (Page 539)

Input and output addresses in the address overview (Page 541)

Assigning addresses to a location in the program
You can assign addresses of the I/O channels of modules directly to the points of use in the 
program or to a tag table.

Requirement
● The device view of the hardware and network editor is open.

● The zoom level in the device view must be set to at least 200% to allow you to see the 
individual I/O channels.

● The instruction window of the programming editor or a tag table is open.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 783



Procedure       
To assign I/O channels of modules to the points of use in the program or to a tag table, follow 
these steps:

1. In the device view, navigate to the module with the desired I/O channel.

2. Click and hold down the mouse button to drag the desired I/O address to the corresponding 
point of use of the block or to the tag table.
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The address of the module is assigned to the point of use in the program or entered as a tag 
in the tag table.

 

 Note

The tag for an input or output of a block can also be dragged to the input or output of a module 
in order to link the tag to the I/O channel of the module.

 

 

Signal board

Inserting a signal board in a CPU

Introduction 
Signal boards allows you to increase the number of the S7-1200 CPU's own inputs and outputs. 
Just like all other hardware components, you will find signal boards in the hardware catalog. 
However, you do not insert signal boards in the rack like other modules but directly in a slot of 
the CPU itself.

Note the following points when using a signal board:

● Each CPU can have only one signal board inserted in it.

● A signal board can only be inserted when the slot in the CPU is free.

There are various ways of inserting a signal board in a CPU:

● Double click on a signal board in the hardware catalog when there is a free slot in the CPU

● Drag from the hardware catalog to a free slot in the CPU

● Shortcut menu of a signal board in the hardware catalog for copying and pasting

Requirement
● The hardware catalog is open.

● The S7-1200 CPU has a free slot for the signal board.
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Inserting a signal board in a CPU 
To insert a signal board in a CPU, proceed as follows:

1. Go to the required signal board in the hardware catalog.

2. Select the signal board you want to use.

3. Drag the signal board to the free slot in the CPU.

You have now inserted a signal board in the slot of the CPU.

If you are in the network view, you can also drag a signal board to a device. If the CPU has a 
an empty slot for a signal board, the signal board is inserted automatically into this slot.

Configurations for Web server

Information about the web server

Introduction
The web server allows you to monitor the CPU via the Internet or the intranet of your company. 
This permits evaluation and diagnostics over long distances.

Alarms and status information are visualized on HTML pages.

Web browser   
You need a web browser to access the HTML pages of the CPU.

The following PC web browsers, for example, are suitable for communication with the CPU:

● Internet Explorer (Version 8.0, 9.0)

● Mozilla Firefox (Version 17.0.1 and higher)

● Google Chrome 23.0

● Apple Safari 5.1.7 (Windows)

● Apple Safari 6.0.2 (Mac)

The following Web browsers of mobile devices are also suitable:

● Internet Explorer 6.0 for HMI Panels

● Mobile Safari (iOS 5.0.1)
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● Mobile Android Browser 2.3.4

● Mobile Google Chrome 23.0

Reading information via the web server
The following information can be read from the CPU. The availability of the respective web 
pages depends on the CPU and its firmware version.

As of firmware version 4, the web pages are also available in several languages.

Page/information Description
Intro/Introduction Entry page for the standard web pages
Start Page
Start page with general CPU information

The start page provides an overview of general 
information on the CPU, the name of the CPU, the 
type of CPU and basic information on the current 
operating state.

Identification
Identification information

Displays the static identification information such 
as serial number, order number and version 
numbers.

Diagnostic Buffer
Diagnostic information

Displays the content of the diagnostics buffer with 
the most recent entries first.

Module Information
Module information

Displays whether the centrally inserted 
components of a station are OK, whether there are 
maintenance requirements or components cannot 
be reached, for example.
As of firmware version 4 a firmware update is 
possible via this Web page.

Communication
Communication

Displays the communication connections during 
open communication (OUC); displays resources 
and address parameters.

Varable Status
Tags

Displays the status of operands of the user 
program to monitor and change the values.

Data Logs
(File Browser as of firmware version 4)

Data logs in CSV format to transfer to the hard disk 
of the programming device. The data logs are 
created with data log instructions in the user 
program and filled with data. 
As of firmware version 4 you have access to files 
of the internal load memory and of the external 
load memory (Memory Card), for example to the 
content of the directory "DataLogs" and "Recipes" 
via the Web page "File Browser".

User Pages
User pages (if user-defined web pages have been 
configured and loaded)

The user web pages deliver a list of web pages 
with customer-specific web applications.

 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 787



Web access to the CPU via PG/PC
Proceed as follows to access the web server:

1. Connect the client (PG/PC) to the CPU via the PROFINET interface.

2. Open the web browser.
Enter the IP address of the CPU in the "Address" field of the web browser in the format 
http://ww.xx.yy.zz (example: http://192.168.3.141).
The start page of the CPU opens. From the start page, you can navigate to further 
information. 

See also
S7-1200 web server (http://support.automation.siemens.com/WW/view/en/36932465)

Standard web pages

Requirements for web access
The requirements for access to standard CPU web pages are explained in the following, as 
well as the effects of missing or existing configuration information.

Requirement   
The web server must be started.

The web server only starts when it has been activated in the properties of the CPU in the "Web 
server" section.

Note the following:

The web pages are normally transmitted via an non-secure connection and are not secured 
against hacker attacks. If you want to transfer the web pages in encrypted form to the browser, 
use the URL https://, followed by the IP address of the CPU.

Logon      
No logon is required to access the standard web pages read-only. A user must be logged on 
to execute certain actions like changing the operating mode of the CPU or for write access. 

For S7-1200 CPUs up to FW version V3: 

You must be logged on as "admin" for the actions listed above. The logon input boxes are on 
the top left of each standard web page.

If you log on as "admin", you must enter the user name and password there.

Name: admin.
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Password: configured CPU password (for password-protected CPU).

For S7-1200 CPUs as of FW version 4: 

You can freely select the names of users and the passwords (CPU parameter "Web server", 
area "User management"). 

You assign rights to the users, for example the right to query diagnostics or to update the 
firmware.

JavaScript and cookies
The standard web pages use JavaScript and cookies. You must enable both in your web 
browser.

If JavaScript is not enabled, the following limitations apply:

● Data from standard web pages is not automatically updated.

● You cannot log on as user.

● Fields cannot be sorted (module information)

If cookies are not enabled, you cannot log on.

See also
Access for HTTPS (Page 790)

Settings for operation

Settings for operation
To be able to use the web server of an S7-1200-CPU, you must select the CPU in the network 
view or the device view and make the following settings in the inspector window under 
"Properties > General > Web server":

● Enable the web server 

● Restricting access to the CPU to HTTPS transmission protocol (encrypted transmission)
Access via port 80 is then blocked. Communication is only possible via port 443.
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● Enabling automatic update of web pages 
The update interval is set by default and cannot be changed. The CPU updates web pages 
with changing content ( (for example, status information or diagnostics information) at 
regular intervals. 

● Creating and managing users
Users are exclusively entitled to options that are assigned to the access rights.
Depending on the CPU and firmware used, you can assign different user rights. Rights that 
your CPU does not support cannot be activated. A user called "Everybody" with minimal 
access rights, that you can, however, extend, is set by default in the user list. A user who 
uses the Web server without entering a password has "Everybody" user rights. 
You have the possibility of configuring further users with different access rights. These 
users have to log on with the configured user name and password.

 

 
 WARNING

Unauthorized access to the CPU by means of the Web server

Unauthorized access to the CPU or the changing of PLC variables to invalid values can 
result in interruptions of the processes controlled by the CPU and cause death, serious 
bodily harm or material damage!

Since the activation of the Web server allows authorized persons for example to change 
operating modes, to write-access CPU data or to update the firmware, we recommend 
that the following security measures be taken:
● If possible limit access to the HTTPS protocol.
● Create users with secure passwords. An example of a secure password is one which 

is only used for a single application, is more than 8 characters long, and consists of 
lower- and upper-case letters as well as symbols and numbers (?!+%$1234...). In 
addition, passwords based on common keyboard sequences or words from the 
dictionary should be avoided.
Change the password at regular intervals.

● Do not extend the rights of the "Everybody" user.
● Check the PLC variables in the user program and limit the range of values to 

permissible ranges since users can set invalid values via the Web server. 

 
 

Access for HTTPS

Access via HTTPS   
HTTPS is used for encrypting and authentication of communication between the browser and 
web server.

To transfer data between the browser and the CPU using the HTTPS protocol, enter the URL 
as https://ww.xx.yy.zz  in the address line of your browser, whereby ww.xx.yy.zz  stands for 
the IP address of the CPU. 

You require a valid, installed certificate for error-free HTTPS access to the CPU. 

If no certificate is installed a warning is displayed with a recommendation not to use this page. 
To view the page you must explicitly "Add exception".
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You can receive a valid certificate (Certification Authority) "SIMATIC CONTROLLER" as a 
download from the "Intro" web page under "Download certificate". The help function for your 
respective web browser provides information on how to install a certificate.

Accessing data of the CPU memory
You can access data in the internal or external CPU load memory by means of a standard web 
page.

● Use the web page "Data logs" for S7-1200 CPUs up to and including FW version 3. From 
this web page, you transfer the data logs from the CPU to a drive on your PC.

● Use the web page "File Browser" for S7-1200 CPUs as of FW version 4. From this web 
page, you transfer data from the folders "Data logs" or "Recipes", for example, to a drive 
on your PC. 

Depending on the file type and the access permissions you have configured for the web server 
user, you can download, delete, rename or upload the files. The actual directories can only be 
created, deleted or renamed.

Example: Data logs   
To open a data log, click on the link of the desired data log. You can then open the file (.csv), 
for example, in Microsoft Excel or in another program you choose or you can save the file.

Special note: Data logs are saved in U.S. American CSV format. You can only open the file 
directly using the U.S. version of Microsoft Excel. If you are using another national version of 
Microsoft Excel, you must import the file, selecting "comma" in the import assistant as the 
delimiter. 

Downloading a data log
To download a data log, click on the download icon of the desired data log. You can then open 
the file (.csv), for example, in Microsoft Excel or in another program you choose or you can 
save the file.

Downloading and clearing or deleting a data log
For a CPU with FW version up to V3.0: 

To download and delete the current entries of the data log, you must be logged on. To do this, 
click on the "Download and delete" icon of the required data log. You can then open the file 
(.csv), for example, in Microsoft Excel or in another program you choose or you can save the 
file. 

For a CPU as of FW version V4.0: 

To reset the data log, follow these steps: 

1. Open the CSV file, for example with Excel.

2. Delete the rows between the headline and the row with the entry "//END", if this row exists. 
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3. Save the file to a drive on your PC.

4. On the web page "File Browser", delete the data log (which means the CSV file) and load 
the prepared CSV file to the CPU with the "Upload file" button of the "File Browser" web 
page. 

Additional information is available in the S7-1500 CPU system manual.

Create and download user-defined websites

What you need to know about user-defined web pages

Concept       
The concept of user-defined web pages allows you to access freely-designed web pages of 
the CPU from a web browser. The web server of the CPU provides this function.

You are not dependent on special tools for the design and functionality of the user-defined 
web pages. You can adapt the pages in the layout with CSS, provide dynamic content with 
JavaScript or use any framework to produce web pages.

The totality of files processed by the web server is also referred to as the "web application".

Web application and user program
Using HTML code in user-defined web pages, you can also transmit data via a web browser 
to the user program of the CPU for further processing and can display data from the operand 
area of the CPU in the web browser.

You can use script instructions (such as Javascript) to optimize your web pages, for example 
to dynamically change contents or validate user entries.

To synchronize between the user program and the web server, but also to initialize, you must 
call the WWW (SFC 99) instruction in the user program.

● If no interaction is required between the web application and the user program, for example, 
if a web page only provides static information, only initialization in the user program is 
required.

● If a simple data exchange is necessary between PLC tags and tags in web applications, to 
display the contents of PLC tags or write a value in a PLC tag for example, the syntax for 
reading and writing tags has to be observed. In this case only an initialization is required 
in the user program, for example in the startup OB. 

● If a further interaction is required between the web application and the user program, you 
must handle status and control information from the Web Control DB in addition to the 
synchronization between Web server and user program. This is the case, for example, 
when user entries are transmitted via the web browser to the web server for evaluation by 
the CPU. Unlike simple data exchange, the user program directly influences the time at 
which the requested web page is relayed back to the web browser. In this case, you must 
be acquainted with the concept of manual fragments and the structure of the Web Control 
DB.
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Initialization   
User-defined web pages are "packaged" in data blocks for processing by the CPU. You must 
generate appropriate data blocks from the source data (HTML files, images, JavaScript files, 
etc.) during configuration to be able to download the web application into the CPU. The Web 
Control DB takes on a special role (default: DB 333). It contains status and control information 
as well as links to additional data blocks with coded web pages. Data blocks that contain coded 
web pages are termed "Fragment DBs".

When the data block is downloaded into the CPU, the CPU does not "know" that user-defined 
web pages are coded inside it. The "WWW" (SFC 99) instruction, for example, in the Startup 
OB informs the CPU which DB is the Web Control DB. The user-defined web pages can be 
accessed via a web browser after this initialization.

Synchronization   
If the user program is to exchange data with the user-defined web pages, the WWW (SFC 99) 
instruction must be used in the cyclic program section.

Examples of interaction between user program and web page:

● Check received data

● Compiling and returning data for web browser making request

In this case, the status information must be able to be evaluated and control information must 
be transmitted to the web server, for example, to release a requested web page.

Procedural overview

Basic information
This section provides a step-by-step explanation of the basic procedure used to create and 
download custom web pages and to use them in the operating phase.

The following graphic provides a simplified representation of the process used in creating and 
displaying custom web pages:

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 793



① Programming a web application (using suitable tools when required and AWP commands for 
dynamic pages when applicable).

② The web application is comprised of single source files, for example, *.html, *.gif, *.js, etc.
③ Using STEP 7:

● Generate the data blocks (Web Control DB and fragment DBs) from source files. The DBs 
contain meta information and the complete web application, including the images and the 
dynamic and static parts of the web application. The DBs are stored under "System blocks" 
in the project tree.

● Call the "WWW" instruction in the user program. This instruction initializes the web server 
of the CPU for a web application.

● If required, complete final programming for interaction between the web server and user 
program

④ Downloading the blocks to the CPU.
⑤ Call the web page in the browser. The web pages of the CPU are called by entering the IP 

address of the CPU.

Additional information
You can find additional information and examples relating to the S7-1200 web server on the 
Internet (http://support.automation.siemens.com/WW/view/en/36932465). 

Creating web pages
Web design tools from various companies can be used to create user-defined web pages. As 
a rule, the web pages should be programmed and designed compliant to the conventions of 
the W3C (World Wide Web Consortium). No check is made for compliance to W3C criteria in 
the web server of the CPU.
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Rules   
● The tool must be able to directly edit the HTML code so that the AWP command can be 

inserted into the HTML page.
Only the AWP commands are parsed in the CPU and, for example, replaced by values from 
the user program/process image of the CPU.

● Files containing AWP commands must be coded in UTF-8. In the metadata of the HTML 
page, therefore, set the attribute charset to UTF-8 and save the file UTF-8 coded.

● Files containing AWP commands must not contain the following sequence: ]]

● Files containing AWP commands must not contain the following sequence outside of the 
"Tag read ranges" (:=<Tag name>:): :=
Tip: Replace the first character of a prohibited sequence with its character coding; for the 
colon, for example, &#58;.

A small example for a custom web page should make clear the basic design.

Requirement
● The CPU must have a web server and the web server of the CPU must be activated.

● To be able to access PLC tags with write access as a user, you must be logged on as 
"admin".

● For the example below, PLC tags must be defined for those PLC tags that are to be shown 
on the web page. This is shown here for the first tab used, "Tank_below_max".

Creating user-defined web pages
The following code for an example web page reads values from the process image and 
provides them in a table.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w3.org/
TR/html4/strict.dtd">
<html>
  <head>
   <meta http-equiv="Content-Type" content="text/html; 
charset=utf-8">
   <title>Mix</title>
  </head>
   <body>
    <h1>Mix</h1>
    <h2> Actual State </h2>
    <table border="1">
     <tr>
      <th>Variable</th>
      <th>State</th>
     </tr>
     <tr>
      <td>Tank below max</td>
      <td>:="Tank_below_max":</td>
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     </tr>
     <tr>
      <td>Tank above min</td>
      <td>:="Tank_above_min":</td>
     </tr>
    </table>
   </body>
</html>

AWP commands
The interface between a freely-programmable web application for a CPU that has a web server 
and the CPU data is declared by the AWP command (Automation Web Programming). 

To develop web applications you are only subject to the restrictions of the web browser. In one 
of the programming languages of STEP 7, control with the user program which CPU data is 
displayed at what time in the web browser of the viewer. Use AWP commands, which you 
comment within the HTML files, to declare data to be used for intentional interaction between 
the web application and the user program.

AWP commands are inserted as HTML comments with a special syntax into HTML files; they 
declare the following features:

● Read PLC tags

● Write PLC tag

● Read special tags

● Write special tags

● Define enum types

● Assign tags to enum types

● Defining fragments

● Import fragments

Syntax of AWP commands     
An AWP command begins with "<!--AWP_" and ends with "-->". In JavaScript files, the 
commands should also be enclosed by JavaScript comments ("/*...*/").

Notation rules for PLC tag names within an AWP command   
The AWP commands "AWP_In_Variable" and "AWP_Out_Variable" contain a name attribute 
and optionally a use attribute. A PLC tag name is assigned to these attributes, by means of 
which the PLC tags in the browser are written or read. The following rules apply to handling 
PLC tag names in HTML code:

● PLC tags must be enclosed in quotation marks (" ... ").

● PLC tags used in AWP commands must also be enclosed by single quotation marks  ('" ... 
"') or with quotation marks masked by a backslash ("\" ... \"").
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● If the PLC tag name contains the character \ (backslash), this character must be designated 
with the escape sequence \\ as standard character of the PLC tag name.

● If the PLC tag name in the AWP command is also enclosed by single quotation marks and 
the single quotation mark (') occurs within the name, it must also be designed as normal 
character by the escape sequence \'.

● If an absolute address (input, output, bit memory) is used in AWP command, it is enclosed 
by single quotation marks.

PLC tag PLC tag in HTML code
"Velocity" <!-- AWP_In_Variable Name='"Velocity"' -->

<!-- AWP_In_Variable Name="\"Velocity\"" -->
"abc\de" <!-- AWP_In_Variable Name='"abc\\de"' -->
"abc'de" <!-- AWP_In_Variable Name='"abc\'de"' -->
"abc'de" <!-- AWP_In_Variable Name="abcde" Use'"abc\'de"' -->
"DB name".tag <!-- AWP_In_Variable Name='"DB name".tag' -->
"DB name"."ta.g" <!-- AWP_In_Variable Name='"DB name"."ta.g"' -->
- <!-- AWP_Out_Variable Name=’flag1’ Use='M0.0' -->

See also
Reading tags (Page 797)

Writing tags (Page 799)

Special tags (Page 800)

Reading tags
User-defined web pages can read PLC tags.

The PLC tag must be specified by a PLC tag name.

These OUT variables (direction of output as viewed from the controller) are inserted at any 
location within the HTML text with the syntax described in the following.

Syntax       
:=<varname>:
These references are replaced when the web server is in operation by the current values of 
the PLC tag in each case.

<varname> can be a simple, global PLC tag but also a complete tag path to a structural 
element.
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Notation rules for PLC tag names 
● PLC tags in HTML code are enclosed by quotation marks ("), if they are defined in the tag 

table. In the case of data block tags, the name of the data block is enclosed by quotation 
marks. If special characters are used in the structure elements of the data block, for example 
the dot (.) or blank, this part must also be enclosed by quotation marks.

● Quotation marks are not used for absolute addresses of inputs, outputs or bit memories.

PLC tag PLC tag in HTML code
"DB_name".var_name :="DB_name".var_name:
"DB_name"."var.name" :="DB_name"."var.name":
"memory" :="memory":
- :=I0.0:

:=Q0.0:
:=MW100:
:=%MW100:

"My_Data_Block".flag1 <!-- AWP_Out_Variable Name='flag1' 
Use='"My_Data_Block".flag1' -->
...
:=flag1:

● If the PLC tag name contains the character : (colon) or \ (backslash), this character must 
be designated with the escape sequence \: or \\ as standard character of the PLC tag name.

 PLC tag PLC tag in HTML code
"abc:de" :="abc\:de":
"abc\de" :="abc\\de":

● Special characters "<, &, >"
Display problems can occur if these characters are contained in the tag name (for example, 
"a<b"). 
Avoid expressions such as :="a<b": in the HTML page. 
To prevent display problems from occurring, use e.g. an AWP command with a use 
expression according to the pattern depicted below. The use attribute defines the PLC tag 
with the problematic character, the name attribute defines the name without problematic 
character, as it is used in the HTML page. 

 PLC tag PLC tag in HTML code
"a<b" <!—AWP_Out_Variable Name='simplename' 

Use='"a<b"' -->
...
:=simplename:

See also
AWP commands (Page 796)
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Writing tags
Custom web pages can write data into the CPU. 

This requires an AWP command that identifies the PLC tag to be written.

The PLC tag must also be specified by a PLC tag name.

The IN tags (direction of input as viewed from the controller) are placed on the browser page. 
This can be done, for example, in a form.

The tags are either set in the HTTP header (by cookie or POST method) or in the URL (GET 
method) by the browser and are then written by the web server into the respective PLC tag.

Syntax       
To allow the IN tags to be written to the CPU, the tags must first be defined by an explicit AWP 
instruction:
<!-- AWP_In_Variable Name='<PLC_Varname1>' Name='<PLC_Varname2>' 
Name='<PLC_Varname3>' -->
Several tags can be defined in an instruction - such as that shown above.

The specific PLC tag name is hereby written in double quotation marks; for example 
<PLC_Varname1> = "myVar".

In cases where the name of the tag that you use for the web application is not identical to the 
name of the PLC tag, the "Use" parameter can be used to assign to a PLC tag.
<!-- AWP_In_Variable Name=’<Webapp_Varname>’ Use=’<PLC_Varname>’

Example
The "AWP_In_Variable" AWP command is indispensable when handling forms.
<form method='post' action='/awp/appl/x.html'>
 <p>
  <input name='"var1"' type='text'>
  <input value='set' name='Button1' type='submit'>
 </p>
</form>
In the form defined above, the HTTP request method "post" is used to transfer the tag "var1" 
to the web server. The user places the "var1" tag in the form field. The tag 'Button1' has the 
value 'set', but is not required for the CPU. To allow the "var1" tag to be written to the CPU, 
the following instruction must be included in the same fragment:
<!-- AWP_In_Variable Name='"var1"' -->
Since PLC tags are enclosed in double quotation marks ("), the name in the AWP command 
must be enclosed in single quotation marks (') or in masked quotation marks (\"). To avoid the 
numerous escape sequences, we recommend the use of single quotation marks.
<!-- AWP_In_Variable Name=’"Info".par1’ -->
<!-- AWP_In_Variable Name="\"Info".par1\"" -->
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Conditions for write access during operation 
The following requirements have to be met in order for a user to be able to write to PLC tags 
from a user-defined web page.

● The CPU is is password protected.

● The user is logged in as "admin".

This rules applies to all writing access to web pages on a CPU. 

See also
Requirements for web access (Page 788)

AWP commands (Page 796)

Special tags
Special tags are mainly HTTP tags set in the definition of the World Wide Web Consortium 
(W3C) . Special tags are also used for cookies and server tags.

The AWP command to read and write special tags differ only in that they have additional 
parameters than the AWP command used to read and write normal tags.

Reading a special tag     
The Web server can read PLC tags and transfer these to special tags in the HTTP Response 
Header. You can, for example, read a URL for a diversion to another web page and transfer 
to the special tag HEADER:Location using the special tag HEADER:Location. 

The following special tags can be read:

Name Description
COOKIE_VALUE:name Value of cookie with name: "name"
COOKIE_EXPIRES:name Execution time of cookie with name: "name" in 

seconds (must be set beforehand).
HEADER:Status HTTP status code (if no other value has been set, 

status code 302 is returned).
HEADER:Location Path for forwarding to another page. Status code 

302 must be set.
HEADER:Retry-After Anticipated time in which the service is not 

available. Status code 503 must be set.
HEADER: … All other header tags can also be forwarded in this 

way.

Use the AWP command "AWP_Out_Variable" to specify which PLC tags are to be transferred 
in the HTTP header to the web browser.

Basic structure:

 
<!-- AWP_Out_Variable Name="<Typ>:<Name>" [Use="<Varname>"] -->
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Parameter description
● Name: Type and name of special tag

● Use (optional parameter): In cases where the name of the special tag is not identical to the 
name of the PLC tag, parameter "Use" can be used to assign to a PLC tag.

Example:

 
<!-- AWP_Out_Variable Name="COOKIE_VALUE:siemens" Use='"info".language' -->

Writing a special tag
In principle, all HTTP tags written in the HTTP header by the web browser can be evaluated 
by the user program of the CPU. Examples of tag types:

Name Description
HEADER:Accept-Language Accepted or preferred language
HEADER:Authorization Proof of authorization for a requested resource
HEADER:Host Host and port of the requested resource
HEADER:User-Agent Information on the browser
HEADER: … All other header tags can also be forwarded in this 

way
  
SERVER:current_user_id Indicates whether a user is logged on 

(current_user_id=0: no user logged on)
SERVER:current_user_name User name of the user logged on
SERVER:GET Request method is GET
SERVER:POST Request method is POST
  
COOKIE_VALUE:name Value of cookie with name: "name"

The AWP command "AWP_In_Variable" is used to define which special tags are to be 
evaluated in the user program of the CPU. 

Basic structure:

 
<!-- AWP_In_Variable Name="<Typ>:<Name>" [Use="<Varname>"] -->
 

Parameter description:

Name: Type and name of special tag

Use (optional parameter): In cases where the name of the special tag is not identical to the 
name of the PLC tag, the parameter Use can be used to assign to a PLC tag.
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Examples:

 
<!-- AWP_In_Variable Name="COOKIE_VALUE:siemens" Use='"info".language' -->
 

The tag name in the HTTP header is replaced by the PLC tag name specified by Use . The 
cookie is written to the PLC tag "info".language . 

 
<!-- AWP_In_Variable Name='COOKIE_VALUE:siemens' Use='"info".language' -->
 

The tag name in the HTTP header is replaced by the PLC tag name specified by Use. The 
cookie is written to the PLC tag "info".language .

 
<!-- AWP_In_Variable Name='"COOKIE_VALUE:siemens"' -->
 

The HTTP-header variable is written in the same-name PLC variable.

See also
AWP commands (Page 796)

Enumeration types

Enumeration types (enums) 
Numerical values from the PLC program can be converted into text and vice versa using 
enums. The numerical values can also be assigned for several languages.

Creating enums 
Enter an AWP command using the following syntax at the start of the HTML file:
<!-- AWP_Enum_Def Name="<Name of the enum type>" 
Values='0:"<Text_1>", 1:"<Text_2>", ... , x:"<Text_x>"' -->
For example, for German values to be saved as an HTML file in the "de" folder of the HTML 
directory:

 
<!-- AWP_Enum_Def Name="Enum1" Values='0:"an", 1:"aus", 2:"Störung"' -->
 

For example, for English values, to be saved as an HTML file in the "en" folder of the HTML 
directory:
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<!-- AWP_Enum_Def Name="Enum1" Values='0:"on", 1:"off", 2:"error"' -->
 

Assigning enums 
Tags are assigned from the user program to the individual enum texts using a special AWP 
command:

 
<!-- AWP_Enum_Ref Name="<VarName>" Enum="<EnumTypeName>" -->
 

<VarName>  is thereby the symbolic name from the user program and <EnumTypeName> is 
the previously set name of the enum type.

 

 Note

In each fragment in which enum texts are referenced by a PLC tag, this PLC tag must be 
assigned by the appropriate AWP command of the enum type name.

Ensure that no AWP command for importing fragments is positioned between an enum 
assignment and enum usage because this import can result in the enum assignment lying in 
a different fragment than the enum usage.

 

Example
Enum type "state" is defined with values "0" and "1". "0" means "off", "1" means "on":

 
<!-- AWP_Enum_Def Name="state" Values='0:"off", 1:"on"' -->
 

The following code is contained in the HTML code of the web page to be output:

 
<!-- AWP_Enum_Ref Name="operating state" Enum="state" -->
:=operating state:
 

Depending on the value of the "operating state" tag, the ´result displayed  is no longer "0" or 
"1", but "off" or "on".

Simplified use of enumeration types
At S7-1200 CPUs as of firmware version 4 it is possible to use enumerations directly in AWP 
commands to read and write PLC variables. 
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You create enums as described in the previous section, and you can then utilize the values 
with user program read and write commands.   

Creating enums 
<!-- AWP_Enum_Def Name="<Name des Enum Typs>" Values='0:"<Text_1>", 
1:"<Text_2>", ... , x:"<Text_x>"' --> 

Utilizing enums in the user program read and write commands
<!-- AWP_In_Variable Name='<Varname>' Enum="<EnumType>" -->
<!-- AWP_Out_Variable Name='<Varname>' Enum="<EnumType>" -->

Example of reading PLC tags
<!-- AWP_Enum_Def Name='AlarmEnum' Values='0:"No alarms", 1:"Tank is 
full", 2:"Tank is empty"' --><!-- AWP_Out_Variable Name='"Alarm"' 
Enum="AlarmEnum" -->...<p>The current value of "Alarm" 
is :="Alarm":</p>
If the value of "Alarm" in the CPU is "2", the following text will be displayed on the HTML page:

'The current value of "Alarm" is Tank is empty' because the enum definition assigns the string 
"Tank is empty" to the numerical value 2.

Example of writing PLC tags
<!-- AWP_Enum_Def Name='AlarmEnum' Values='0:"No alarms", 1:"Tank is 
full", 2:"Tank is empty"' --><!-- AWP_In_Variable Name='"Alarm"' 
Enum='AlarmEnum' -->...
<form method="POST">
<p><input type="hidden" name='"Alarm"' value="Tank is full" /></p>
<p><input type="submit" value='Set Tank is full' /><p>
</form>
Because the enum definition assigns the string "Tank is full" to the numerical value "1", the 
value "1" is written to the PLC tag "Alarm". 

Definition of fragments

Fragments       
Fragments are "logical sections" of a web page to be processed by the CPU individually.

Fragments are usually complete pages but can also be individual elements such as files (for 
example, images) or complete documents.
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Defining fragments

 
<!-- AWP_Start_Fragment Name="<Name>" [Type="<Type>"] [ID="<Id>"] 
[Mode=<Mode>]-->
 

The start of a fragment is specified by this command. A fragment runs to the start of the next 
fragment or to the end of the file.

● <Name> Indicates the name of the fragment.
The name must start with a letter [a-zA-Z] or an underscore ( _ ). Letters, underscores or 
numbers [0-9] can follow after this first character.

● <Type> Indicates the type of the fragment.

– "manual" The user program is informed of the request for a fragment; the web page to 
be returned can be changed by the user program.

– "automatic" The page is automatically processed (default).

● <id> A numeric ID can be stipulated for the fragment. If no ID is assigned, the fragment is 
automatically assigned an ID. For manual pages (<Type>=manual) , the fragment can be 
addressed in the user program of the CPU by this ID.

 

  Note

Keep the ID low because the highest ID influences the size of the Web Control DB.
 

● <Mode> Fragments support the visible and hidden modes.

– "visible" The fragment is a part of the web page. This mode is preset and can also be 
omitted.

– "hidden" The fragment is not part of the web page. However, the fragment will be saved 
in the Web DB and is available to the user program for inserting in a requested web 
page. You use an exchange of the fragment ID (Web-Control-DB.fragment_index tag) 
to insert a "hidden" fragment in the requested web page.

The input document is completely divided into fragments by the "AWP_Start_Fragment" 
command. "AWP_End_Fragment" is therefore unnecessary.

Without a start fragment command, a file is mapped as a fragment; the fragment name is 
derived from the file name. If a file is divided into several fragments (by 
"AWP_Start_Fragment"), the file must begin with the "AWP_Start_Fragment" command.

Importing fragments
You can declare a fragment in an HTML page and import this fragment into other web pages.

Example
A company logo is to be displayed on all web pages of a web application.

There is only one instance of the HTML code for the fragment that displays the company logo. 
You can import the fragment as often and into as many HTML files as required.
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Syntax

 
<!-- AWP_Import_Fragment Name = "<name>"-->
 

● <name> is the name of the fragment to be imported.

Example
HTML code within a web page that declares a fragment:

 
<!-- AWP_Start_Fragment Name = "My_Company_Logo"-->
<p><img src = "compay_logo.jpg"></p>

Example
HTML code within another web page that imports the declared fragment:

 
<!-- AWP_Import_Fragment Name = "My_Company_Logo"-->
 

Creating and loading a data block

Requirement
● All source files required for the web application (*.html, *.js, *.png, ...) have been created.

● The source files are located in one folder, but only those source files that are required for 
the web application. No other files may be located in this folder.

 

 Note
Length of file names and tag names

If you have a comprehensive web application with many files and directories, the generation 
of the web data blocks may possibly fail. If this happens, the generation is aborted with the 
message "Text list overflow...". The cause is system-internal size limitations for management 
information saved in the web data block. 

Remedy: Use short file names and short tag names. 
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Procedure
To create data blocks from the source files for user-defined web pages in STEP 7, proceed 
as follows:

1. Select the CPU, for example, in the device configuration.

2. Select the properties for user-defined web pages in the inspector window under "Properties 
> General > Web server".

3. As "HTML source", select the folder that contains the source files for the web application.

4. Enter the HTMP page to be opened on starting the web application as the start HTML page.

5. Enter a name for the application if required.

6. You can supplement a range of file name extensions as "Files with dynamic content" if 
necessary. Only enter those file name extensions that also contain AWP commands.

7. The number for the Web Control DB and for the fragment DB start number can be kept as 
long as they are not already being used by your user program.

8. Click on the "Generate" button to create DBs from the source files.
The generated data blocks are saved in the project navigation in the "System block" folder 
(in the "Web server" subfolder).

9. In the CPU, select the network view to be loaded and then select the "Download to device" 
command in the "Online" menu to download the blocks. Compilation of the blocks is 
implicitly initiated before downloading.
If errors are reported during this process, you must correct these errors before you can 
download the configuration.

Structure of the PLC program
Your user program must call the " WWW" instruction to even allow the web application, for 
example, the user-defined web pages, to be available to the CPU on the standard web pages 
and to allow them to be called up there.   

The Web Control DB you have created from the source files is the input parameter (CTRL_DB) 
for the "WWW" instruction. The Web Control DB references the content of the user-defined 
web pages coded in the fragment DB and then receives status and control information.

Calling the "WWW" instruction in the startup program
If you do not want the user program to influence requested web pages, it is sufficient to only 
call the "WWW" instruction once in a startup OB. This instruction initializes communication 
between the web server and the CPU.

Calling the "WWW" instruction in the cyclic program
The "WWW" instruction can also be called in an OB processed in cycles (for example, OB 1). 
This has the advantage of being able to respond to web server requests from within the user 
program. Manual fragments must be used for this.

In this case, you must evaluate information from the Web Control DB in order to identify the 
requested web page or the requested fragment. On the other hand, you must set a bit in the 
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user program in order to explicitly release the web page to be returned by the web server after 
processing the web page request.

The structure of the Web Control DB is described in the following section.

Web Control DB
The Web Control DB (DB 333 by default) is created by STEP 7 and contains information on 
the structure of user pages, the status of communication and any errors that occur.

Additional fragment DBs are also created as well as the Web Control DB. These fragment DBs 
(there may also only be one fragment DB) are referenced in the Web Control DB. The fragment 
DBs contain the web pages and media data coded in fragments, for example, images. The 
content of the fragment DB cannot be changed by the user program. It is created automatically 
and is only for data management.

The status and control tags of the Web Control DB are accessed via symbols.

The following lists the tags of the Web Control DB required for status evaluation and to control 
interaction.

The Web Control DB provides two types of information:

● Global status information: Not bound to a concrete web page request.

● Request status and control information: Information about queued requests.

Global status information 

"WEB-Control_DB".commandstate.init Activates and initializes the web application.
"WEB-Control_DB".commandstate.deactivate Deactivates the web application.
"WEB-Control_DB".commandstate.inititializing The web application is initialized (read Web 

Control DB, etc.).
"WEB-Control_DB".commandstate.error Web application could not be initialized. The 

reason is coded  in "WEB-
Control_DB".commandstate.last_error .

"WEB-
Control_DB".commandstate.deactivating

The web application is closed.

"WEB-Control_DB".commandstate.initialized The web application has been initialized and is 
ready.

"WEB-Control_DB".commandstate.last_error Refer to the next table for a value table of 
possible errors.

Last_error Description
1 Fragment DB is inconsistent (does not match the Web Control DB).
2 A web application already exists with this name.
3 Memory problem initializing in the web server.
4 Inconsistent data in the Web Control DB.
5 A fragment DB is not available (not loaded).
6 No AWP ID for a fragment DB.
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Last_error Description
7 The enum fragment is not available (contains the texts and information on the enum 

types).
8 An action requested via the command flag in the Web Control DB is prohibited in the 

current state.
9 Web application is not initialized (if there is no reinitializing after disabling).
10 Web server is disabled.
... Last_error is reset once the web application has been successfully initialized.

Request status information
Request status information is bound to one of four possible requests, x = [1 … 4].

"WEB-Control_DB".requesttab[x].idle Nothing need be done.
"WEB-Control_DB".requesttab[x].waiting The user program must react to a request from 

a manual fragment and explicitly initiate further 
processing in the web browser.

"WEB-Control_DB".requesttab[x].sending The web server is occupied with processing the 
request/fragment.

"WEB-Control_DB".requesttab[x].aborting The TCP connection is closed by the web 
server.

Request control information
Request control information is bound to one of four possible requests, x = [1 … 4].

"WEB-Control_DB".requesttab[x].continue Releases the fragment being processed for 
transmission. Processing of the next fragment 
is initiated.

"WEB-Control_DB".requesttab[x].repeat Releases the fragment being processed for 
transmission. The fragment is then processed 
again.

"WEB-Control_DB".requesttab[x].abort Closes the TCP connection.
"WEB-Control_DB".requesttab[x].finish Releases the fragment being processed for 

transmission. Stops further processing of 
requests (terminates the request).

Example:
The tag for the DB is: "WEB-Control_DB". Whether errors have occurred during initialization 
of the web application can be determined by requesting bit "WEB-
Control_DB".commandstate.error in the user program.

If an error has occurred you can analyze it using the "WEB-
Control_DB".commandstate.last_error value.
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Interaction with the user program
Using manual fragments ensures that the user program reacts synchronously to the user 
program, thereby allowing the responding web page to be processed by the user program.

Fragment type     
To react to the received data in the user program the "manual" fragment type must be used 
for the fragment writing the data (for "manual pages"):
<!-- AWP_Start_Fragment Name="testfrag" ID="1" Type="manual" -->
The values are always transferred to the web server of the CPU for automatic and manual 
pages in the same way:

Example:
<form method="POST" action="">
<p>
<input type="submit" value="Set new value">
<input type="text" name='"Velocity"' size="20">
</p>
</form>

User program for manual fragments
When using manual pages, the "WWW" instruction must be called in cycles in the user program 
of the CPU.

To react to values entered in the browser, the request - which is made by the manual page to 
the web server - must first be evaluated in the user program. To do this, the Web Control DB 
(for example, DB 333) must be examined in cycles for queued requests. The array that 
manages four requests is contained in the "requesttab" section of the Web Control DB. Each 
element of the array thereby contains information on the respective request within a structure.

A simple programming example shows how queued requests are checked based on the tags 
of the Web Control DB.
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In cases where a request has been made, this program section writes the fragment ID in the 
#frag_index  tag and the request no. (value range 1-4) in the #req_index tag.

Using the information from this, the information transferred in the request can now be 
processed separately for each fragment ID in the program (for example, plausibility check).

Once processing of the request has been completed by the program, the request must be 
answered and the appropriate entry is once more reset under"requesttab" of the Web Control 
DB (for example, DB 333).

A simple programming example for replying to requests:
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Principle sequence of a browser request with interaction from the user program
The following figure shows the simplified, principle sequence of the web browser request on 
the effects of Web Control DB content and the actions required from the user program until 
the processed web page is returned (response).

Displaying custom web pages in the browser

Display web pages in browser 
Web pages are called from the standard web pages of the web browser. 
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In addition to the other links in the navigation bar, the standard web pages also have a link to 
"user pages". 

Click on the "user pages" link to open the web browser you have configured as the default 
HTML page. 

Creating custom web pages in several languages
You can make each of your custom web pages available in various languages.

Requirements
The language-dependent HTML; pages must be stored in a folder structure containing folders 
with the respective language abbreviations:

Specified language abbreviations  
Language abbreviations "de", "en", "fr", "es", "it" and "zh" are fixed. Additional language folders 
or other designated language folders are not supported.

Additional folders within the same folder hierarchy for other files can be created as required; 
for example, an "img" folder for images and a "script" folder for JavaScript files.

Language switching for custom web pages

Requirements
The HTML pages are contained in the predefined language folders, for example, HTML pages 
with German text are in the "de" folder, HTML pages with English text are in the "en" folder.

Language switching concept 
Language switching is based on a predefined cookie named "siemens_automation_language". 
If the cookie is set to value "de", at the next web page request or web page update, the web 
server switches to the web page from the  "de" folder.

Similarly, the web server switches to the web page from the "en" folder when the cookie is set 
to "en".
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Example of language switching
The example is structured as follows:

● The language-dependent HTML files with the same name, for example,  "langswitch.html" 
are located in both language folders "de" and "en". The text to be displayed within the two 
files are German or English, corresponding to the name of the folder.

● There is an additional "script" folder in the folder structure containing the JavaScript file 
"lang.js". Functions required for language switching are stored in this file .

Structure of the "langswitch.html" file ("de" folder)
Meta data "content language", charset and path to JavaScript file are set in the file header.
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta http-equiv="Content-Language" content="de">
<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<title>Switch language to German page</title>
<script type="text/javascript" src="script/lang.js" ></script>
<head>
Language selection is implemented in the body of the file by the "select" HTML element. The 
select element initiates a list box and contains the "de" option, labeled as "German" and "en", 
labeled as "English"; "de" is the default. 

The "DoLocalLanguageChange(this)" function is called using the "onchange" event handler. 
The "this" parameter transmits the select object with the selected option to this function. 
"onchange" calls the function each time the option is changed.
<!-- Language Selection -->
<table>
    <tr>
        <td align="right" valign="top" nowrap>
          <!-- change language immediately on change of the selection 
-->
          <select name="Language" 
onchange="DoLocalLanguageChange(this)" size="1">
                <option value="de" selected >Deutsch</option>
                <option value="en" >English</option>
            </select>
        </td>
     </tr>
</table>
<!-- Language Selection End-->

Structure of the "langswitch.html" file ("en" folder)
The header of the HTML file with English text is structured similarly to the HTML file with 
German text. 
<!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01 Transitional//EN">
<html>
<head>
<meta http-equiv="Content-Language" content="en">
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<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<title>Language switching english page</title>
<script type="text/javascript" src="script/lang.js" ></script>
Language selection is also implemented in the body of the file by the "select" HTML element. 
In contrast to the German HTML file, the English option is already selected as a default and 
the test or the labels are in English.
<!-- Language Selection -->
<table>
    <tr>
        <td align="right" valign="top" nowrap>
          <!-- change language immediately on change of the selection 
-->
          <select name="Language" 
onchange="DoLocalLanguageChange(this)" size="1">
                <option value="de" >German</option>
                <option value="en" selected >English</option>
            </select>
        </td>
     </tr>
</table>
<!-- Language Selection End-->

Structure of "lang.js" file (in the "script" folder)
The " DoLocalLanguageChange" function is defined in the Java script file and calls the 
"SetLangCookie" function with the language selection value. SetLangCookie combines the 
cookie name and cookie value and then sets the cookie by means of the corresponding 
document.cookie property. The web page must then be reloaded (top.window.location.reload) 
to allow the web server to react to the setting of the cookie by displaying the required language.

 
function DoLocalLanguageChange(oSelect) {
        SetLangCookie(oSelect.value);
        top.window.location.reload();
    }
 
 function SetLangCookie(value) {
        var strval = "siemens_automation_language=";
            // this is the cookie by which the web server
            // detects the desired language
            // this name is required by the web server
        strval = strval + value;
        strval = strval + "; path=/ ;";
            // set path to the application, since otherwise
            // path would be set to the requesting page 
            // would not get the cookie. 
            // The path for user defined applications follows this 
sample: 
            // path=/awp/<application name>/<pagename>
            // example: path=/awp/myapp/myappstartpage.htm 
            //(where myapp is the name of the web application 
            // entered in the web server properties of the cpu)
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            /*
            use expiration if this cookie should live longer
            than the current browser session
            var now      = new Date();
            var endttime = new Date(now.getTime() + expiration);
            strval = strval + "; expires=" + endttime.toGMTString() 
+ ";";
            */
        document.cookie = strval;
    }

Additional configurations

Configuring additional functions
The S7-1200 automation system has numerous additional functions that are useful as 
integrated CPU functions or available via plug-in modules (for example, communication 
modules). You can find the description via the following links.

See also
Overview of point-to-point communication (Page 1099)

General information on high-speed counters (Page 1095)

Configuring PID_Compact V1 (Page 7754)

Configuring PID_3Step V1 (Page 7786)

Motion functionality of the CPU S7-1200 (Page 7801)

8.1.4.4 S7-1200 CM/CP

S7-1200 CM/CP

Telecontrol S7-1200

CP 1242-7
 

Copying the CP 1242-7 into another project
If you copy a CP 1242-7 from one project into another project, the following parameters in the 
parameter group "CP identification" are changed on the target station:

● Project number of the CP

● Station number of the CP
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Download to device
Only use the "Download to device" function with the CP 1242‑7 via a TeleService connection 
as follows:

1. Select the CP in STEP 7.

2. Select the "Online" > "Download to device" menu.

3. In the "Extended download" dialog that appears, select the TeleService interface.

4. Download the project data from the "Extended download" dialog.

Upload from device
The function "Upload from device" is not supported by the CP 1242‑7.
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CP 1242-7 configuration

Modes of the GPRS-CP

Modes of the CP     
The CP 1242‑7 allows an S7‑1200 to communicate as a GPRS station with a central station 
or other remote networks via the GSM network. For communication using GPRS, the CP is 
set to one of the following operating modes:

● Telecontrol
This operating mode of the CP allows the GPRS station to exchange data with the following 
partners:

– Communication with the Telecontrol server
This CP mode allows the GPRS station to exchange data with a telecontrol server.
The Telecontrol server is a PC connected to the Internet with the "TELECONTROL 
SERVER BASIC" application. It is generally located in the master station and serves to 
monitor and control the remote GPRS stations. Data can be exchanged with the OPC 
client of a central control system via the integrated OPC interface.
The Telecontrol server PC is not configured in STEP 7. The "TELECONTROL SERVER 
BASIC" application has its own configuration user interface.

– Communication with another remote GPRS station
The message frames are transmitted via the Telecontrol server.

– Communication with an engineering station (for TeleService)

Communication with the Telecontrol server is performed via the GSM network and the 
Internet.
This operating mode requires a SIM card with GPRS service enabled and a Telecontrol 
server that can be reached by the CP.

● GPRS direct
This operating mode of the CP is used for direct communication between remote stations 
via the GSM network. No Telecontrol server is required.
To allow network nodes in public wireless networks to be directly accessible, these need 
to be addressed using a fixed address. Here, SIM cards with a fixed IP address are used 
that allow the stations to address each other directly.
The possible communications services and security functions (for example VPN) depend 
on what is offered by the network provider.
Possible communications partners of the GPRS station with a CP 1242‑-7 in "GPRS direct" 
mode are:

– A subscriber that can be reached by the CP via an IP address (GPRS station with 
CP 1242‑7)

– An engineering station (for TeleService)
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Establishing a connection using GPRS communication

Connection modes  
● "GPRS direct" mode

There are no different connection modes in the "GPRS direct" mode.

● "Telecontrol" mode
The CP can be configured for the following connection modes.

– "Permanent" connection mode  
There is a permanent TCP connection to the telecontrol server. Following connection 
establishment, there is a permanent TCP connection to the telecontrol server even if 
data is not transferred permanently.

– "Temporary" connection mode   
A connection is only established to the telecontrol server when required.

If a TCP connection is established, process data is sent as soon as the telecontrol instructions 
are called on the CPU.

A connection is always established by the CP. If a connection established by the CP is 
interrupted, the CP automatically attempts to re-establish the connection.

Triggering connection establishment for permanent stations ("Telecontrol" mode)
In the "Telecontrol" mode, the permanent connection to the telecontrol server is established 
when the station starts up. If there is an interruption on the connection, the establishment of 
the connection can be triggered by a wake-up SMS (see below).

Triggering connection establishment for temporary stations ("Telecontrol" mode) 
With "temporary" stations, connection establishment can be triggered by the following events:

● Event on the local CPU that needs to be evaluated by the program.
In terms of the program, two situations need to be distinguished:

– Events that lead to a single connection establishment (for example alarms or commands 
from the operator).

– Expiry of an interval that leads to cyclic connection establishment (for example once 
daily for data transmission)

● Request by a communications partner (OPC client or S7 station)
The request from the communications partner leads to the connection being established.

● Request for TeleService by an engineering station
The request switched by the telecontrol server or TeleService gateway does not need to 
be evaluated in the program.

● Wake-up SMS of the telecontrol server
The wake-up SMS can be triggered spontaneously on the telecontrol server. It is also 
possible to configure cyclic sending on the telecontrol server.
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● Telephone wake-up call
The wake-up call can be sent from a telephone that has a phone number authorized in the 
STEP 7 project. The telephone must support the CLIP function (transfer of its own call 
number).
The connection establishment with the (main) telecontrol server is triggered.

● Telephone wake-up SMS
The wake-up SMS can be sent from a telephone that has a phone number authorized in 
the STEP 7 project. The telephone must support the CLIP function (transmission of its own 
number) and sending of SMS.
The connection establishment with the telecontrol server specified in the SMS is triggered.

When a temporary station is woken up, all the data is transferred if this has changed since the 
last data transfer.

Triggering connection establishment in "GPRS direct" mode
In "GPRS direct" mode, a connection establishment is triggered by the following events:

● Event on the local CPU that is evaluated by the program.

● Request by a communications partner (not an engineering station)
The request in the frame received from the communications partner is evaluated in the 
program by calling the telecontrol instructions.

● Request for TeleService by an engineering station
The request switched by the telecontrol server or TeleService gateway does not need to 
be evaluated in the program.

Right to wake-up by "authorized phone numbers"
The CP only accepts an SMS if the sending communication partner is authorized based on its 
phone number. These numbers are in configured for the CP in STEP 7 in the "authorized phone 
numbers" list. 

 

 Note
"Authorized phone numbers" in the STEP 7 project
● A phone number entered here gives the sender who transfers this phone number the right 

to trigger connection establishment.
● If an asterisk (*) is entered in the list, the CP accepts SMS messages from all senders.
● If the list is empty, the CP cannot be woken up for connection establishment.

 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 821



Wake-up SMS
Depending on the connection type and the triggering server or intermediary TeleService 
server, the following text must be transferred in the wake-up SMS:

● For telecontrol connections:

– Text for the wake-up SMS message for establishing a connection to the telecontrol 
server:
TELECONTROL

– Text for the wake-up SMS message for establishing a connection to the main telecontrol 
server:
TELECONTROL MAIN

– Text for the wake-up SMS message for establishing a connection to the substitute 
telecontrol server:
TELECONTROL BACKUP

The configuration of the telecontrol server for the GPRS CP is set in STEP 7 in "Telecontrol 
interface > Operating mode > main or substitute telecontrol server".

 

  Note
Wake-up with a mobile phone
● One of the texts listed above can be used in a wake-up SMS message.
● With a wake-up call, the station always connects to the main telecontrol server.

 

● For TeleService connections:

– Text for the wake-up SMS message for establishing a connection to the first configured 
TeleService server:
TELESERVICE
or
TELESERVICE 1

– Text for the wake-up SMS message for establishing a connection to the second 
configured TeleService server:
TELESERVICE 2

The configuration of the TeleService server for the GPRS CP is set in STEP 7 in "Telecontrol 
interface  > TeleService authorization > 1st or 2nd TeleService server".
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Preferred GSM networks

Selection of preferred GSM networks
The following options are provided to select the GSM networks that the CP 1242‑7 should 
preferably dial up:

● Automatic dialup
The CP dials with highest priority into the GSM network of the contracted network operator 
set on the SIM card. If a connection cannot be made within the contracted network, the CP 
dials up another GSM network with which the network operator has a roaming contract and 
whose access data is stored on the SIM card.

● Contract network only
The CP only dials up the GSM network of the contracted network operations whose SIM 
card is plugged into the CP. No roaming.

● Contracted network and alternative network
The CP dials up the contracted network with the highest priority. If dialup to the contracted 
network is unsuccessful, the CP dials up an alternative GSM network, in decreasing priority, 
as entered in the list of preferred network operators.
The alternative networks are entered in the list as "Public Land Mobile Network" (PLMN). 
PLMN is a construct of Mobile Country Code (MCC) and Mobile Network Code (MNC).
Example: 26276
This is the PLMN for the test network of Siemens AG with MCC = 262 and MNC = 76.

Time-of-day synchronization in NTP mode - parameter assignment

NTP mode (NTP: Network Time Protocol)
In NTP mode, the CP sends time-of-day queries at regular intervals to one or more NTP 
servers. From the responses of the servers, the CP selects the most accurate time of day.

The advantage of this mode is that it allows the time to be synchronized across subnets.

In NTP mode, it is generally UTC (Universal Time Coordinated) that is transferred. This 
corresponds to GMT (Greenwich Mean Time).

CP 1242-7 TeleService

TeleService via GPRS

Communication path for TeleService via GPRS  
With TeleService for remote S7 stations with the CP 1242‑7 via GPRS, the connection is 
always established via an intermediary between the engineering station and remote S7 station.

This intermediary can be either:
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● A telecontrol server (and possibly a substitute telecontrol server)
The telecontrol server can be a separate PC or installed on the engineering station in the 
form of the "TELECONTROL SERVER BASIC" application.

● A TeleService server
A TeleService server is used when no telecontrol server is available; in other words, when 
the CP operates in "GPRS direct" mode.

The telecontrol server or TeleService server can be connected to the engineering station via 
LAN or Internet and the TeleService function can be called from there.

Requirements for TeleService via GPRS
● A telecontrol server or a TeleService server

● The STEP 7 project with the required data for GPRS communication

Note on project engineering
The telecontrol server and TeleService server are not configured in STEP 7.

See also
Establishing a connection using GPRS communication (Page 820)

Modes of the GPRS-CP (Page 819)

Establishing a TeleService connection via GPRS

Establishing a connection for TeleService via GPRS
The request to establish a connection is triggered by the engineering station and transmitted 
by a wake-up SMS to the station. The CP 1242‑7 in the S7‑1200 station establishes a 
connection to the engineering station via the GSM network and the Internet.

Starting the TeleService via GPRS  
Start the TeleService via GPRS as follows:

1. In the project on the authorized engineering station, select the remote S7 station with which 
you want to establish a TeleService connection via GPRS.

2. Alternatively, open the "Connect online" dialog box as follows:

– "Connect online" button

– "Connect online" shortcut menu (right mouse button)

– "Online" > "Connect online" menu

The "Connect online" dialog box opens.

3. Choose interface type "TeleService GPRS" in the "Type of PG/PC interface" drop-down 
list.
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4. In the "PG/PC interface" drop-down list, select the "GPRS TeleService board" option if it is 
not automatically displayed.

5. Click on the "Connect" icon next to the "PG/PC interface" drop-down list.
The "Establish remote connection" dialog box opens.

6. Make the necessary settings in the "Establish remote connection" dialog.
Details of this are contained in the tooltip cascade of STEP 7.

The following details are required to successfully establish a connection:

Details required to establish a connection with the GPRS station
The following information is necessary in the Establish remote connection" dialog:

● IP address or DNS name of the telecontrol server

● TCP port number of the telecontrol server or the DSL router via which the connection 
between the engineering station and the remote GPRS station is running.

● Server password of the ES to authenticate the engineering station at the telecontrol server
Only required if a group-specific password has been configured in the "TELECONTROL 
SERVER BASIC" application.

● TeleService user name
See CP configuration in STEP 7.

● TeleService password
See CP configuration in STEP 7.

● Access ID of the CP
Only required when there are several CP 1242‑7s in the station. See CP configuration in 
STEP 7.

Status

Connection statuses of TeleService via GPRS
The following connection statuses can be displayed in the "Establish remote connection" dialog 
box:

● Not connected
There is no connection to the remote GPRS station. Connection establishment has not yet 
started.

 

If connection establishment was started by clicking the "Connect" button, the following statuses 
are displayed one after the other after the connection has been established:

● Connect to telecontrol server
The engineering station connects to the telecontrol server.

● Wait for S7 station
The wake-up SMS has been sent to the remote station. Wait for reply from station.
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● Authentication at S7 station
The S7 station has established an IP connection with the engineering station via GPRS 
and Internet and is checking the received logon and authentication data.

● Connected
The station has successfully established the connection to the engineering station.

 

The following states may be displayed if the connection cannot be successfully established:

● Telecontrol server not accessible
Possible causes:

– The connection between the engineering station and the telecontrol server has been 
interrupted.

– The telecontrol server is switched off.

● Wrong server password
Cause: The wrong server password for logging on and authentication was entered at the 
telecontrol server.

● S7 station not responding
Possible causes:

– Faulty GSM communication between the telecontrol server and the station.

– Faulty connection between the GSM network and the Internet.

– Faulty Internet connection.

– The telecontrol server could not send a wake-up SMS.

– The CP has not received a wake-up SMS.

– The sender of the SMS was not configured in the list of authorized wake-up call numbers.

● Wrong TeleService user name or TeleService password
Possible causes:

– An incorrect TeleService user name or incorrect TeleService password was entered in 
the authentication dialog for the CP 1242‑7.

– The TeleService user name or TeleService password was not configured in STEP 7.

● All TeleService access points are in use.

● The CP is not known to the telecontrol server.
Cause: The CP originates from a STEP 7 project that does not match the project of the 
telecontrol server.

● No resources available for TeleService on the CP: Please contact the hotline.

● Protocol error
Cause: Wrong frame or frame from wrong subscriber. Please contact the hotline.
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CP 1243-1

CPU scan cycle

Structure of the CPU scan cycle
The cycle (including the pause) with which the CP scans the memory area of the CPU is made 
up of the following phases:

● High-priority read jobs
For data points of the type "Input", which are configured with the "High priority" setting in 
the data point configuration in "General > Priority in the scan cycle", the PLC tags are all 
read in one scan cycle.

● Write jobs
In every cycle, the values of a certain number of unsolicited write jobs are written to the 
CPU. The number of tags written per cycle is specified for the CP in the "Communication 
with the CPU" parameter group with the "Max. number of write jobs" parameter. The tags 
whose number exceeds this value are then written in the next or one of the following cycles.

● Low-priority read jobs - proportion
For data points of the type "Input", which are configured with the "Low priority" setting in 
the data point configuration in "General > Priority in the scan cycle", the values of a part of 
the PLC tags are read in every scan cycle.
The number of tags read per cycle is specified for the CP in the "Communication with the 
CPU" parameter group with the "Max. number of read jobs" parameter.  The tags that 
exceed this value and can therefore not be read in one cycle are then read in the next or 
one of the following cycles.

● Cycle pause time
This is the waiting time between two scan cycles. It is used to reserve adequate time for 
other processes that access the CPU via the backplane bus of the station.

Duration of the CPU scan cycle
Since no fixed time can be configured for the cycle and since the individual phases cannot be 
assigned a fixed number of objects, the duration of the scan cycle is variable and can change 
dynamically.

Datapoint types
During the configuration of the user data to be transferred by the CP, each data point is 
assigned a protocol-specific data point type. The data point types supported by the CP along 
with the compatible S7 data types are listed below. They are grouped according to format 
(memory requirements).

The direction relates to the direction of transfer (monitoring direction = "in", control direction = 
"out").
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CP 1243‑1 DNP3: Supported data point types

Table 8-54 Supported data point types, DNP3 object groups, variants and compatible S7 data types

Format (memory 
requirements)

Data point type DNP3 object group
[variations]

Direction S7 data types Address area

Bit Binary Input 1  [1, 2] in BOOL I, Q, M
Binary Input Event 2  [1, 2] in BOOL I, Q, M
Binary Output  1) 10  [2] out   
Binary Output Event  1) 11  [1, 2] out   
Binary Command 12  [1] out BOOL I, Q, M

Integer (16 bits) Counter Static 20  [2] in UINT, WORD I, Q, M
Frozen Counter  2) 21  [2, 6] in   
Counter Event 22  [2, 6] in UINT, WORD I, Q, M
Frozen Counter Event  3) 23  [2, 6] in   
Analog Input 30  [1] in INT I, Q, M
Analog Input Event 32  [2, 4] in INT I, Q, M
Analog Output Status  4) 40  [2] out   
Analog Output 41  [2] out INT I, Q, M
Analog Output Event  4) 42 [2, 4] out   

Integer (32 bits) Counter Static 20  [1] in UDINT, 
DWORD

I, Q, M

Frozen Counter  2) 21  [1, 5] in   
Counter Event 22  [1, 5] in UDINT, 

DWORD
I, Q, M

Frozen Counter Event  3) 23  [1, 5] in   
Analog Input 30  [2] in DINT I, Q, M
Analog Input Event 32  [1, 3] in DINT I, Q, M
Analog Output Status  4) 40  [1, 3] out   
Analog Output 41  [1] out DINT I, Q, M
Analog Output Event  4) 42  [1] out   

Floating-point 
number (32 bits)

Analog Input 30  [5] in REAL Q, M
Analog Input Event 32  [5, 7] in REAL Q, M
Analog Output Status  4) 40  [3] out   
Analog Output 41  [3] out REAL Q, M
Analog Output Event  4) 42  [5, 7] out   

Floating-point 
number (64 bits)

Analog Input 30  [6] in LREAL Q, M
Analog Input Event 32  [6, 8] in LREAL Q, M
Analog Output 41  [4] out LREAL Q, M
Analog Output Event  4) 42  [6, 8] out   

Block of data (1...64 
bytes)  5)

Octet String 110  [ ‑ ] in 5) I, Q, M
Octet String Event  5) 111  [ ‑ ] in 5) I, Q, M

1) This object group can be configured in the Data point editor of STEP 7 using object group 12.
2) This object group can be configured in the Data point editor of STEP 7 using object group 20.
3) This object group can be configured in the Data point editor of STEP 7 using object group 22.
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4) This object group can be configured in the Data point editor of STEP 7 using object group 41.
5) With these data point types, contiguous memory areas up to a size of 64 bytes can be transferred. All S7 data types with a 
size between 1 and 64 bytes are compatible. If the array is modified later, the data point must be recreated.

Configuration and feedback of binary and analog values
● Binary values

You configure binary values (inputs) using object groups 1 and 2.
The object groups 10 and 11 are used to feed back the current values in the process image 
of the CPU to the control system.

● Analog values
You configure analog values using the object groups 30, 32 and 41 depending on the 
transfer direction.
The object groups 40 and 42 are used to feed back current values in the process image of 
the CPU to the control system.

CP 1243‑1 IEC: Supported data point types

Table 8-55 Supported data point types, IEC types and compatible S7 data types

Format (memory 
requirements)

Data point type IEC type Direction S7 data types Address area

Bit Single point information <1> in BOOL I, Q, M
Single point information with time tag <30> in BOOL I, Q, M
Single command <45> out BOOL I, Q, M

Byte Step position information <5> in BYTE I, Q, M
Step position information with time tag <32> in BYTE I, Q, M
Regulating step command <47> out BYTE I, Q, M

Integer (16 bits) Measured value, normalized value <9> in INT I, Q, M
Measured value, normalized value 
with time tag

<34> in INT I, Q, M

Measured value, scaled value <11> in INT I, Q, M
Measured value, scaled value with 
time tag

<35> in INT I, Q, M

Set point command, normalised value <48> out INT I, Q, M
Set point command, scaled value <49> out INT I, Q, M

Integer (32 bits) Bitstring of 32 bits <7> in DWORD, 
UDINT

I, Q, M

Bitstring of 32 bits with time tag <33> in DWORD, 
UDINT

I, Q, M

Integrated totals <15> in DWORD, 
UDINT

I, Q, M

Integrated totals with time tag <37> in DWORD, 
UDINT

I, Q, M

Floating-point 
number (32 bits)

Measured value, short floating point 
number

<13> in REAL Q, M

Measured value, short floating point 
number with time tag

<36> in REAL Q, M
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Format (memory 
requirements)

Data point type IEC type Direction S7 data types Address area

Set point command, short floating 
point number

<50> out REAL Q, M

Block of data 
(1...32 Bit)  1)

Bitstring of 32 bits  1) <7> in 1) I, Q, M
Bitstring of 32 bits with time tag  1) <33> in 1) I, Q, M
Bitstring of 32 bits  1) <51> out 1) I, Q, M

1) With these data point types, contiguous memory areas up to a size of 32 bits can be transferred. All S7 data types with a 
size between 1 and 32 bits are compatible. If the array is modified later, the data point must be recreated.

Types of transmission and event classes

Storing and transferring values
The values of data points can be assigned to different memory areas on the CP and therefore 
to different types of transfer:

● Static values
Static values are entered in the process image of the CP.
The value of a static data point is sent after being requested by the communications partner.

● Events
The values of data points configured as an event are also entered in the process image of 
the CP.
The values of events are also entered in the send buffer of the CP.
The value of a data point that was configured as an event is sent unsolicited to the 
communications partner if this function is enabled by the master.
The send buffer has the following size:

– With DNP3: Max. 64000 events

– With IEC: Max. 65535 events

The capacity of the send buffer is divided up equally for all enabled partners.

Types of transmission
Depending on your CP type, you have the following transmission types available:

● Transfer after call
The current value of the data point is entered in the image memory of the CP. A new value 
overwrites the older value in the image memory.
After being called by the communications partner, the current value at the time is transferred.

● Every value triggered
Whenever the trigger condition is met, the individual value of the data point is entered 
separately in the send buffer and transferred to the communications partner.
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● Event class ...
The value is transferred to the send buffer triggered as a class 1, 2 or 3 event. If unsolicited 
transfer is enabled by the master, the value is transferred unsolicited.
You will find details of the event classes in the following sections.

● Current value triggered
Only the current value of a data point at the time of the trigger is entered in the send buffer 
and transferred to the communications partner.

Event classes for the DNP3 protocol
The process data of the various event classes is handled as follows:

● Event class 1 / event class 2
Classes according to the DNP3 protocol: Event, class 1 / class 2
Each value change is entered in the send buffer in chronological order.
The evaluation of the classification (1 or 2) must be handled by the master.

● Event class 3
Class according to the DNP3 protocol: Static event, class 3
Only the current value at the time the trigger condition was met is entered in the send buffer 
and overwrites the last value stored there.

Event classes for the IEC protocol
The process data of the various event classes is handled as follows:

● Event class 1
Classes according to the IEC protocol: Event, class 1
Each value change is entered in the send buffer in chronological order.

● Event class 3
Class according to the IEC protocol: Static event, class 3
Only the current value at the time the trigger condition was met is entered in the send buffer 
and overwrites the last value stored there.

Analog value preprocessing
Some CPs have analog value preprocessing that, among other things, supports the functions 
described below.

Smoothing factor
Analog values that fluctuate quickly can be evened out using the smoothing function.

The smoothing factors are calculated according to the following formula as with S7 analog 
input modules.

1
y

x k y

k
n

n n
=

+ − −( )1

where
yn = smoothed value in the current cycle 
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xn = value acquired in the current cycle n
k = smoothing factor

The following values can be configured for the module as the smoothing factor.

● 1 = No smoothing

● 4 = Weak smoothing

● 32 = Medium smoothing

● 64 = Strong smoothing

Fault suppression time
An analog value in the overflow range (32767 / 7FFFh) or underflow range (-32768 / 8000h) is 
not transferred for the duration of the fault suppression time. This also applies to live zero 
inputs. The value in the overflow/underflow range is only sent after the fault suppression time 
has elapsed, if it is still pending.

If the value returns to the measuring range before the fault suppression time elapses, the 
current value is transferred immediately.

A typical use case for this parameter is the suppression of peak current values when starting 
up powerful motors that would otherwise be signaled to the control center as a disruption.

The suppression is adjusted to analog values that are acquired by the S7 analog input modules 
as raw values. These modules return the specified values for the overflow or underflow range 
for all input ranges (also for live zero inputs).

If the CPU makes preprocessed finished values available in the bit memory area or in a data 
block, fault suppression is only possible or useful if these values have the values listed above 
(32767 / 7FFFh) or (-32768 / 8000h) in the overflow or underflow range. If this is not the case, 
the parameter should not be enabled for preprocessed values.

Mean value generation
With this parameter, acquired analog values are transferred as mean values.

The current values of an analog datapoint are acquired cyclically and totaled. The number of 
acquired values per time unit depends on the read cycle of the CPU and the CPU scan cycle 
of the CP. The mean value is calculated from the accumulated values as soon as the transfer 
is triggered by a time trigger. Following this, the accumulation starts again so that the next 
mean value can be calculated.

The mean value can also be calculated if the transmission of the analog value message is 
triggered by a request from the communications partner. The duration of the mean value 
calculation period is then the time from the last transmission (for example triggered by the 
trigger) to the time of the request. Once again, the accumulation restarts so that the next mean 
value can be calculated.

If the acquired analog value in the overflow range (32767 / 7FFFh) or underflow range (-32768 / 
8000h), this value can either be taken into account immediately in the calculation of the mean 
value or it can be suppressed for a specific period for the calculation of the mean value. The 
required response can be decided with the Fault suppression time parameter:
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● Fault suppression time = 0
Acquisition of a value in the overflow or underflow range results in the mean calculation 
being stopped immediately. The value 32767 / 7FFFh or -32768 / 8000h is saved as an 
invalid mean value for the current mean value calculation period and sent when the next 
analog value message is triggered. The calculation of a new mean value is then started. If 
the analog value remains in the overflow or underflow range, this new value is again saved 
immediately as an invalid mean value and sent when the next frame is triggered.

● Fault suppression time > 0
If the acquired analog value is in the overflow or underflow range, the bad values are 
excluded from the calculation of the mean value for a maximum time as defined by the Fault 
suppression time. If this time is exceeded, the value 32767 / 7FFFh or -32768 / 8000h is 
saved as an invalid mean value and sent when the next analog value frame is triggered. 
The procedure is identical in each new averaging period; in other words, bad values are 
again suppressed for the duration of the fault suppression time.

The duration of the fault suppression time also indirectly decides the proportion of invalid values 
per averaging period. If the mean value is formed, for example in a cycle of 15 minutes, and 
the fault suppression time is set to 5 minutes, this means that the mean value is only transferred 
as invalid if more than 33% of the acquired analog values are in the overflow or underflow 
range in the current averaging period.

8.1.4.5 SCALANCE X, W and M

SCALANCE X

Useful information

VLAN

Network definition regardless of the spatial location of the nodes   
VLAN (Virtual Local Area Network) divides a physical network into several logical networks 
that are shielded from each other. Here, devices are grouped together to form logical groups. 
Only nodes of the same VLAN can address each other. Since multicast and broadcast frames 
are only forwarded within the particular VLAN, they are also known as broadcast domains. 

The particular advantage of VLANs is the reduced network load for the nodes and network 
segments of other VLANs. 

To identify which packet belongs to which VLAN, the frame is expanded by 4 bytes (VLAN 
tagging (Page 835)). This expansion includes not only the VLAN ID but also priority information.
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Options for the VLAN assignment
There are various options for the assignment to VLANs:

● Port-based VLAN
Each port of a device is assigned a VLAN ID. You configure port-based VLAN in "Layer 2 
> VLAN > Port-based VLAN". 

● Protocol-based VLAN
Each port of a device is assigned a protocol group. You can configure protocol-based VLAN 
in "Layer 2 > VLAN > Protocol Based VLAN Port"

● Subnet-based VLAN
The IP address of the device is assigned a VLAN ID. You configure subnet-based VLAN 
in "Layer 2 > VLAN > lpv4 Subnet Based VLAN".

processing the VLAN assignment
If more than one VLAN assignment is created on the device, the assignments are processed 
in the following order:

1. Subnet-based VLAN

2. Protocol-based VLAN

3. Port-based VLAN

The frame is first examined for the IP address. If a rule on the "lpv4 Subnet Based VLAN" tab 
applies, the frame is sent to the corresponding VLAN. If no rule applies, the protocol type of 
the frame is examined. If a rule on the "Protocol Based VLAN Port" tab applies, the frame is 
sent to the corresponding VLAN. If no rule applies, the frame is sent via the port-based VLAN. 
The rules for the port-based VLAN are specified on the "Port Based VLAN" tab.

See also
General (Page 919)

GVRP (Page 921)

Port-based VLAN (Page 922)

Protocol-based VLAN group (Page 923)

Protocol-based VLAN port (Page 924)

IPv4 subnet-based VLAN (Page 924)
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VLAN tagging

Expansion of the Ethernet frames by four bytes
For CoS (Class of Service, frame priority) and VLAN (virtual network), the IEEE 802.1 Q 
standard defined the expansion of Ethernet frames by adding the VLAN tag.   

 

 Note

The VLAN tag increases the permitted total length of the frame from 1518 to 1522 bytes. With 
the IE switches, the standard MTU size is 1536 bytes. The MTU size can be changed to 
values from 64 to 9216 bytes.
The end devices on the networks must be checked to find out whether they can process this 
length / this frame type. If this is not the case, only frames of the standard length may be sent 
to these nodes.

 

The additional 4 bytes are located in the header of the Ethernet frame between the source 
address and the Ethernet type / length field:

Figure 8-2 Structure of the expanded Ethernet frame

The additional bytes contain the tag protocol identifier (TPID) and the tag control information 
(TCI).

Tag protocol identifier (TPID)
The first 2 bytes form the Tag Protocol Identifier (TPID) and always have the value 0x8100. 
This value specifies that the data packet contains VLAN information or priority information.

Tag Control Information (TCI)
The 2 bytes of the Tag Control Information (TCI) contain the following information:

CoS prioritization   
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The tagged frame has 3 bits for the priority that is also known as Class of Service (CoS). The 
priority according to IEEE 802.1p is as follows:

CoS bits Type of data
000 Non time-critical data traffic (less then best effort [basic setting])
001 Normal data traffic (best effort [background])
010 Reserved (standard)
011 Reserved ( excellent effort )
100 Data transfer with max. 100 ms delay
101 Guaranteed service, interactive multimedia
110 Guaranteed service, interactive voice transmission
111 Reserved

The prioritization of the data packets is possible only if there is a queue in the components in 
which they can buffer data packets with lower priority.

The device has eight parallel queues in which the frames with different priorities can be 
processed. First, the frames with the highest priority ("Strict Priority" method) are processed. 
This method ensures that the frames with the highest priority are sent even if there is heavy 
data traffic.

Canonical Format Identifier (CFI)

The CFI is responsible for compatibility between Ethernet and the token Ring.
The values have the following meaning:

Value Meaning
0 The format of the MAC address is canonical. In the canonical representation of the MAC 

address, the least significant bit is transferred first. Standard-setting for Ethernet switches.
1 The format of the MAC address is not canonical.

VLAN ID

In the 12-bit data field, up to 4095 VLAN IDs can be formed. The following conventions apply:   

VLAN ID Meaning
0 The frame contains only priority information (priority tagged frames) and no valid 

VLAN identifier.
1 - 4094 Valid VLAN identifier, the frame is assigned to a VLAN and can also include priority 

information.
4095 Reserved

SNMP

Introduction        
With the aid of the Simple Network Management Protocol  (SNMP), you monitor and control 
network elements from a central station, for example routers, switches. SNMP controls the 
communication between the monitored devices and the monitoring station.
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Tasks of SNMP:

● Monitoring of network components

● Remote control and remote parameter assignment of network components

● Error detection and error notification

In versions v1 and v2c, SNMP has no security mechanisms. Each user in the network can 
access data and also change parameter assignments using suitable software. 

For the simple control of access rights without security aspects, community strings are used. 

The community string is transferred along with the query. If the community string is correct, 
the SNMP agent responds and sends the requested data. If the community string is not correct, 
the SNMP agent discards the query. Define different community strings for read and write 
permissions. The community strings are transferred in plain text.

Standard values of the community strings:

● public
has only read permissions

● private
has read and write permissions

 

  Note

For security reasons, do not use the standard values "public" or "private". Change the 
values following the initial installation.

 

Further simple protection mechanisms at the device level:

● Allowed Host
The IP addresses of the monitoring systems are known to the monitored system.

● Read Only
If you assign "Read Only" to a monitored device, monitoring stations can only read out data 
but cannot modify it.

SNMP data packets are not encrypted and can easily be read by others.

The central station is also known as the management station. An SNMP agent is installed on 
the devices to be monitored with which the management station exchanges data.

The management station sends data packets of the following type:

● GET
Request for a data record from the agent

● GETNEXT
Calls up the next data record.

● GETBULK (available as of SNMPv2)
Requests multiple data records at one time, for example several rows of a table.

● SET
Contains parameter assignment data for the relevant device.

The SNMP agent sends data packets of the following type:
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● RESPONSE
The agent returns the data requested by the manager.

● TRAP
If a certain event occurs, the SNMP agent sends traps.

SNMPv1 and SNMPv2 and SNMPv3 use UDP (User Datagram Protocol). The data is 
described in a Management Information Base (MIB).

SNMP v3
Compared with the previous versions SNMP v1 and SNMP v2, SNMP v3 introduces a 
comprehensive security concept. 

SNMP v3 supports:

● Fully encrypted user authentication

● Encryption of the entire data traffic

● Access control of the MIB objects at the user/group level

Spanning Tree
 

Avoiding loops on redundant connections
The spanning tree algorithm allows network structures to be created in which there are several 
connections between two stations. Spanning tree prevents loops being formed in the network 
by allowing only one path and disabling the other (redundant) ports for data traffic. If there is 
an interruption, the data can be sent over an alternative path. The functionality of the spanning 
tree algorithm is based on the exchange of configuration and topology change frames.

Definition of the network topology using the configuration frames
The devices exchange configuration frames known as BPDUs (Bridge Protocol Data Unit) with 
each other to calculate the topology. The root bridge is selected and the network topology 
created using these frames. BPDUs also bring about the status change of the root ports.

The root bridge is the bridge that controls the spanning tree algorithm for all involved 
components.

Once the root bridge has been specified, each device sets a root port. The root port is the port 
with the lowest path costs to the root bridge.

Response to changes in the network topology
If nodes are added to a network or drop out of the network, this can affect the optimum path 
selection for data packets. To be able to respond to such changes, the root bridge sends 
configuration messages at regular intervals. The interval between two configuration messages 
can be set with the "Hello Time" parameter.
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Keeping configuration information up to date
With the "Max Age" parameter, you set the maximum age of configuration information. If a 
bridge has information that is older than the time set in Max Age, it discards the message and 
initiates recalculation of the paths.

New configuration data is not used immediately by a bridge but only after the period specified 
in the "Forward Delay" parameter. This ensures that operation is only started with the new 
topology after all the bridges have the required information.

RSTP, MSTP, CIST

Rapid Spanning Tree Protocol (RSTP)
One disadvantage of STP is that if there is a disruption or a device fails, the network needs to 
reconfigure itself: The devices start to negotiate new paths only when the interruption occurs. 
This can take up to 30 seconds. Fur this reason, STP was expanded to create the "Rapid 
Spanning Tree Protocol" (RSTP, IEEE 802.1w). This differs from STP essentially in that the 
devices are already collecting information about alternative routes during normal operation 
and do not need to gather this information after a disruption has occurred. This means that the 
reconfiguration time for an RSTP controlled network can be reduced to a few seconds.
This is achieved by using the following functions:   

● Edge ports (end node port)
Edge ports are ports connected to an end device. 
A port that is defined as an edge port is activated immediately after connection 
establishment. If a spanning tree BPDU is received at an edge port, the port loses its role 
as edge port and it takes part in (R)STP again. If no further BPDU is received after a certain 
time has elapsed (3 x hello time), the port returns to the edge port status.

● Point-to-point (direct communication between two neighboring devices)

By directly linking the devices, a status change (reconfiguration of the ports) can be made 
without any delays.  

● Alternate port (substitute for the root port)

A substitute for the root port is configured. If the connection to the root bridge is lost, the 
device can establish a connection over the alternate port without any delay due to 
reconfiguration.

● Reaction to events

Rapid spanning tree reacts to events, for example an aborted connection, without delay. 
There is no waiting for timers as in spanning tree.

● Counter for the maximum bridge hops
The number of bridge hops a package is allowed to make before it automatically becomes 
invalid.
In principle, therefore with rapid spanning tree, alternatives for many parameters are 
preconfigured and certain properties of the network structure taken into account to reduce 
the reconfiguration time.
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Multiple Spanning Tree Protocol (MSTP)
The Multiple Spanning Tree Protocol (MSTP) is a further development of the Rapid Spanning 
Tree Protocol. Among other things, it provides the option of operating several RSTP instances 
within different VLANs or VLAN groups and, for example, making paths available within the 
individual VLANs that the single Rapid Spanning Tree Protocol would globally block.

Common and internal Spanning Tree (CIST)
CIST is a term from the multiple spanning tree. CIST identifies the internal instance used by 
the switch that is comparable in principle with an internal RSTP instance. 

Routing function
 

Introduction      
The term routing describes the specification of routes for communication between different 
networks; in other words, how does a data packet from subnet A get to subnet B.

SCALANCE X supports the following routing functions:

● Static routing
With static routing, the routes are entered manually in the routing table.

● Router redundancy
With standardized VRRP (Virtual Router Redundancy Protocol), the availability of important 
gateways is increased by redundant routers.

● Dynamic routing
The entries in the routing table are dynamic and are updated continuously. The entries are 
created by the routing protocol.

– OSPF v2 (Open Shortest Path First)

Static routing
The route is entered manually in the routing table. Enter the route in the routing table on the 
WBM page "Routes".

Router redundancy with VRRP    
With the Virtual Router Redundancy Protocol (VRRP), the failure of a router in a network can 
be countered.

Several VRRP routers in a network segment are put together as a logical group that forms a 
virtual router (VR). The group is defined using the virtual ID (VRID). Within the group, the VRID 
must be the same. The VRID can no longer be used for other groups. 

The virtual router is assigned a virtual IP address and a virtual MAC address. One of the VRRP 
routers within the group is specified as the master router. The master router has priority 255. 
The other VRRP routers are backup routers. The master router assigns the virtual IP address 
and the virtual MAC address to its network interface. The master router sends VRRP packets 
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(advertisements) to the backup routers at specific intervals. With the VRRP packets, the master 
router signals that it is still alive. The master router also replies to the ARP queries.

If the virtual master router fails, a backup router takes over the role of the master router. The 
backup router with the highest priority becomes the master router. If the priority of the backup 
routers is the same, the higher MAC address decides. The backup router becomes the new 
virtual master router. 

The new virtual master router adopts the virtual MAC and IP address. This means that no 
routing tables or ARP tables need to be updated. The consequences of a device failure are 
therefore minimized.

You configure VRRP in "Layer 3 > VRRP".

OSPFv2

Dynamic routing with OSPF v2
OSPF (Open Shortest Path First) is a cost-based routing protocol. To calculate the shortest 
and most cost-effective route, the Short Path First algorithm by Dijkstra is used. OSPF was 
developed by the IETF (Internet Engineering Task Force). 
You configure OSPFv2 in "Layer 3 > OSPFv2".

OSPF v2 divides an autonomous system (AS) into different areas. 

Areas in OSPF         
The following areas exist:

● Backbone
The backbone area is area 0.0.0.0. All other areas are connected to this area. The backbone 
area is connected either directly or via virtual connections with other areas.
All routing information is available in the backbone area. As a result, the backbone area is 
responsible for forwarding information between different areas.

● Stub Area
This area contains the routes within its area within the autonomous system and the standard 
route out of the autonomous system. The destinations outside this autonomous system are 
assigned to the standard route.

● Totally Stubby Area
This area knows only the routes within its area and the standard route out of the area.

● Not So Stubby Area (NSSA)
This area can forward (redistribute) packets from other autonomous systems into the areas 
of its own autonomous system. The packets are further distributed by the NSSA router.
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Routers of OSPF
OSPF distinguishes the following router types:

● Internal router (IR)
All OSPF interfaces of the router are assigned to the same area.

● Area Border Router (ABR)
The OSPF interfaces of the router are assigned to different areas. One OSPF interface is 
assigned to the backbone area. Where possible, routes are grouped together.

● Backbone Router (BR)
At least one of the OSPF interfaces is assigned to the backbone area.

● Autonomous System Area Border Router (ASBR)
One interface of the router is connected to a different AS, for example an AS that uses the 
routing protocol RIP.

Virtual connection
Each area must be physically connected to the backbone area. In some situations a physical 
connection is not possible. The remote router is connected to a backbone router via a virtual 
connection. In the area through which the virtual connection runs, there is no designated router 
or designated backup router. 

LSA types
Within the autonomous system, packets are exchanged that contain information about the 
connections of a router and the connection status message. The packets are also known as 
LSAs (Link State Advertisements). The LSAs are always sent from the router to the neighbor 
router. 

If there are changes in the network, LSAs are sent to all routers in the network. The information 
depends on the LSA type.
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Router LSA (LSA Type 1)
The LSA Type 1 is only sent within an area. For each active connection of the router 
that belongs to the area in consideration, an LSA Type 1 is generated. The LSA Type 
1 contains information about the status and the costs of the connection, for example IP 
address, network mask, network type
Network LSA (LSA Type 2)
The LSA Type 2 is sent only within an area. For each network that belongs to the relevant 
area, the router generates an LSA Type 2. If several routers are interconnected in a 
network, the LSA Type 2 is sent by the designated router (DR). The LSA Type 2 includes 
the network address, the network mask and a list of routers that are connected to the 
network

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 843



Summary LSA (LSA Type 3 / LSA Type 4) 
The Summary LSA is generated by the area border router and sent into the area. The 
Summary LSA contains information about routes outside the area but inside the AS. 
Where possible, the routes are grouped together. 
● Summary LSA (LSA Type 3)

The LSA Type 3 describes the routes to the networks and advertises the standard 
route to the areas.

● AS Summary LSA (LSA Type 4)
The LSA Type 4 describes the routes to the ASBR.

External LSA (LSA Type 5 / LSA Type 7)
The External LSA is generated by the ASBR. The LSA type depends on the area.
● AS External LSA (LSA Type 5)

The LSA Type 5 is sent by the AS border router into the areas of the autonomous 
system except the Stub and NSSA areas. The LSA contains information about routes 
to a network in another AS. The routes are either created manually or learned 
externally. The ASBR uses LSA Type 5 to distribute standard routes to the backbone 
area.

● NSSA External LSA (LSA Type 7)
The LSA Type 7 is generated by the AS border router of an NSSA. The router is also 
known as the NSSA ASBR. The LSA Type 7 is sent only within the NSSA. If the P 
bit in LSA Type 7 = 1, these LSAs are converted to LSA Type 5 by the ABR and sent 
to the backbone area.

Establishing the neighborhood
The router runs through the following statuses to establish a connection to the neighbor router.

1. Attempt state / Init state
The router activates OSPF and begins to send and receive Hello packets. Based on the 
received Hello packets, the router learns which OSPF routers are in its vicinity. The router 
checks the content of the Hello packet. The Hello packet also contains the list of the 
neighbor routers (neighbor table) of the "sender".

2. Two way state
If, for example, the ID of the area, the area type and the settings for the times match, a 
connection (adjacency) can be established to the neighbor. In a point-to-point network, the 
connection is established directly. If several neighbor routers can be reached in a network, 
the designated router (DR) and the designated backup router (DBR) are identified based 
on Hello packets. The router with the highest router priority becomes the designated router. 
If two routers have the same router priority, the router with the lower router ID becomes the 
designated router. The router establishes a connection to the designated router. 

3. Exchangestart state
The neighbor routers decide which router starts communication. The router with the higher 
router ID becomes master. 

4. Exchange state
The neighbor routers send packets that describe the content of their neighborhood 
database. The neighborhood database (link state database - LSDB) contains information 
on the topology of the network.
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5. Loading state
The router completes the received information. If the router still has questions relating to 
the status of a specific connection, it sends a link state request. The neighbor router sends 
a response (link state update). The response contains a suitable LSA. The router confirms 
receipt of the response (link state acknowledge).

6. Full State
The information exchange with the neighbor router is completed. The neighborhood 
database of the neighbor router is the same. Based on the Short Path First algorithm, the 
router calculates a route to every destination. The route is entered in the routing table.

Check the neighborhood
The Hello packets are only used to establish the neighborhood relations. Hello packets are 
used to check the connection to the neighbor router by sending them cyclically. If no Hello 
packet is received within a certain interval (dead interval), the connection to the neighbor is 
marked as "down". The relevant entries are deleted.

Updating the neighborhood database
Once the neighborhood database is established, LSAs are sent to all routers in the network if 
there are changes in the topology. 

RIPv2

Dynamic routing with RIPv2
The Routing Information Protocol (RIPv2) is used to create routing tables automatically. RIPv2 
is used in autonomous systems (AS) with a maximum of 15 routers. It is based on the Distance-
Vector algorithm.

RIPv2 was developed by the IETF (Internet Engineering Task Force) and is described in RFC 
2453.
You configure RIPv2 in "Layer 3 > RIPv2".

Setting up a routing table
Since a router initially only knows its directly connected networks, it sends a request to its direct 
neighbor routers. As the reply, it receives the routing tables of the neighbor routers. Based on 
the information it receives, the router set up its own routing table.

The routing table contains entries for all possible destinations. Each entry includes the distance 
to the destination and the first router on the route.

The distance is also known as the metric. This indicates the number of routers to be passed 
through on the route to the destination (hop count). The maximum distance is 15 routers (hops).

Updating the routing table
Once the routing table is set up, the router sends its routing table to each direct neighbor router 
at intervals of 30 seconds.
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The router compares new routing information with its existing routing table. If the new 
information includes shorter routes, the existing routes are overwritten. The router only keeps 
the shortest route to a destination. 

Checking neighbor routers
If a router does not receive messages from a neighbor router for longer than 180 seconds, it 
marks the router as being invalid. The router assigns the metric 16 for the neighbor router.

Link aggregation

Link aggregation
With link aggregation, several parallel physical connections with the same transmission speed 
are grouped together to form a logical connection with a higher transmission speed. This 
method based on IEEE 802.3ad is also known as port trunking or channel bundling.

Link aggregation works only with full duplex connections with the same transmission speed in 
point-to-point mode. This achieves multiplication of the bandwidth or transmission speed. If 
part of the connection fails, the data traffic is handled via the remaining parts of the connection.

To control and monitor, the Link Aggregation Control Layer (LACL) and the Link Aggregation 
Control Protocol (LACP) are used.

Authentication

Authentication method
You can configure the authentication methods "802,1x" and "MAC Authentication" as well as 
the "Guest VLAN" option separately for each port.

The functions have a hierarchical order. If all three functions are enabled, an attempt is made 
initially to authenticate the end device using "802.1x". If this authentication is unsuccessful, 
"MAC Authentication" is started. If this authentication is also unsuccessful, the end device is 
enabled for communication in the "Guest VLAN". ""Guest VLAN" can only be used if at least 
one authentication method is active.

The two authentication methods depend on the end device. If the end device supports EAP 
(Extensible Authentication Protocol), it can be authenticated using the "802.1x" method. If the 
end device does not support EAP, it can be authenticated using "MAC Authentication". In this 
case, the IE switch adopts the role of the end device and uses the MAC address of the device 
as the authentication parameter.

802.1x
The "802.1x" authentication method works as follows:
An end device that supports EAP sends authentication information to the IE switch. The IE 
switch forwards the information to the authentication server. The authentication server checks 
the information and allows or denies the end device access to the network.
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MAC Authentication
The "MAC Authentication" authentication method works as follows:
As soon as the IE switch receives a frame from the end device, the IE switch sends a query 
to the RADIUS server to allow or deny the end device access to the network.

Editing properties and parameters

Editing options
You have the following options for editing properties and parameters:

● Hardware and network editor
Once you have inserted the network component, you can edit the properties and 
parameters, for example the device name. You will find more detailed information in 
"Hardware and network editor".

● Web Based Management (WBM) 
The parameters and properties are accessible using the supplied HTML pages (WBM 
pages). Each WBM page has its own help page that describes the properties and 
parameters. For further information, refer to the configuration manual "SCALANCE XM400/
X-500 Web Based Management". You will find the MIB at Siemens Industry Automation 
and Drives Service & Support on the Internet under the entry ID 67428305 (http://
support.automation.siemens.com/WW/view/en/67428305).

● Command Line Interface
All the configuration settings for the device can be made using the CLI. The CLI provides 
the same options as Web Based Management (WBM). For further information, refer to the 
configuration manual "SCALANCE XM400/X-500 Command Line Interface". You will find 
the MIB at Siemens Industry Automation and Drives Service & Support on the Internet 
under the entry ID 67430663 (http://support.automation.siemens.com/WW/view/en/
67430663).

Availability
The availability of the settings depends 　

● on the port type

● on the configuration mode　

SCALANCE X distinguishes the following port types:　

● Switch port　

● Router port　

The following configuration modes are available:　
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● Offline configuration
You can configure a PC station the first time offline. In this mode only the settings that 
require no connection to the device are available.　

● Online configuration mode
If there is a connection to the device, there are additional pages available in the Inspector 
window. These pages include the note "This page is only available if there is an online 
connection to the device". With some settings, the additional information "only available 
online" is included.

Creating and deleting an entry
As an example, an entry will be created and deleted on the Syslog client. The procedure is 
valid on all pages.

Creating a new entry

1. Select the device in the network or device view.　

2. Open the properties of the device in the Inspector window.　

3. In the Inspector window go to System > Syslog client. 　

4. Enter the IP address for the Syslog server.

5. Click in the table.

6. Select the entry "New entry" in the shortcut menu.
A new entry is created in the table.

Deleting an entry

1. Select the required entry in the table.

2. Select the "Delete" entry in the shortcut menu.

Buttons you require often
● Refresh the display with "Refresh"

Pages that display current parameters have a "Refresh" button at the lower edge of the 
page. Click this button to request up-to-date information from the device for the current 
page.

● Save settings for all ports with "Transfer to table"
Pages on which you can configure several ports have 2 tables. In the first table, you can 
make the settings for all ports and transfer these to the second table. In the last column of 
the first table, there is the "Transfer to table" button. Click this button to save the settings 
you have made for all ports.

IP address assignment 

Configuration options
When shipped and after restoring to the factory settings, the device does not have an IP 
address.
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The following options are available to assign an IP address to the device:

● DHCP (default setting)

● Primary Setup Tool
For further information, refer to the configuration manual "Primary Setup Tool". You will find 
the MIB at Siemens Industry Automation and Drives Service & Support on the Internet 
under the entry ID 19440762 (http://support.automation.siemens.com/WW/view/en/
19440762).

● STEP 7

● CLI via the serial interface
For further information, refer to the configuration manual "SCALANCE X500 Command 
Line Interface". You will find the MIB at Siemens Industry Automation and Drives Service 
& Support on the Internet under the entry ID 67430663 (http://
support.automation.siemens.com/WW/view/en/67430663).

Requirement
● "Set IP address on device" is enabled in the properties of the device. You will find more 

detailed information in "Addressing PROFINET devices".

SCALANCE XR500 as IO device: "Compile" and "Download to device"
With a SCALANCE XR500 configured as a PROFINET IO device and assigned to an IO 
controller, the functions "Compile" and "Download to device" only download the data to the 
switch that can also be configured in Web Based Management (WBM) (layer 2, layer 3, system, 
security).

If you want to use the "Compile" or "Download to device" functions for the PROFINET IO device 
data of the XR500, first select the assigned IO controller.

Information

Versions
 

 Note

The page is only available if there is an online connection to the device.
 

This page shows the versions of the hardware and software of the device.

Description
Table 1 has the following columns:

● Hardware
Shows the device being used.

● Name
Shows the name of the device or module.
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● Revision
Shows the hardware version of the device.

● Order ID
Shows the order number of the device or module.

Table 2 has the following columns:

● Software

– Firmware
Shows the current firmware version. If a new firmware file was downloaded and the 
device has not yet restarted, the firmware version of the downloaded firmware file is 
displayed here. After the next restart, the downloaded firmware is activated and used.

– Bootloader
Shows the version of the boot software stored on the device.

● Description
Shows the short description of the software.

● Version
Shows the version number of the software version.

● Date
Shows the date on which the software version was created.

I&M
 

 Note

The page is only available if there is an online connection to the device.
 

This page contains information about device-specific vendor and maintenance data such as 
the order number, serial number, version number etc. You cannot configure anything on this 
page.

Description of the displayed values
The table has the following rows:

● Manufacturer ID
Shows the manufacturer ID.  

● Order number
Shows the order number.  

● Serial number
Shows the serial number.  

● Hardware revision
Shows the hardware version.  

● Software version
Shows the software version.  

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
850 System Manual, 02/2014



● Revision counter
Shows the revision counter: Counter for revisions since the initial commissioning

● Revision Date
Date and time of the last revision

● Function tag
Shows the function tag (plant designation) of the device. The plant designation (HID) is 
created during configuration of the device with HW Config of STEP 7.

● Location tag
Shows the location tag of the device. The location identifier (LID) is created during 
configuration of the device with HW Config of STEP 7.

ARP table
 

 Note

The page is only available if there is an online connection to the device.
 

Assignment of MAC address and IP address   
With the Address Resolution Protocol (ARP), there is a unique assignment of MAC address 
to IPv4 addresses. This assignment is kept by each network node in its own separate ARP 
table. The page shows the ARP table of the device. 

Displayed values
The table has the following columns:

● Interface
Shows the interface via which the row entry was learnt.

● MAC address
Shows the MAC address of the target device.

● IP address
Shows the IP address of the target device.

● Media Type
Shows the type of connection.

– Dynamic
The device recognized the address data automatically.

– Static
The addresses were entered as static addresses
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Log table

Logging events     
 

 Note

The page is only available if there is an online connection to the device.
 

The device allows you to log events that occur, some of which you can specify in " System > 
Events". This, for example, allows you to record when an authentication attempt failed or when 
the connection status of a port has changed. The content of the events log table is retained 
even when the device is turned off.

Settings
● Severity Filters

You can filter the entries in the table according to severity. To display all the entries, enable 
or disable all settings.

– Info
Information (6)

– Warning
Warnings (4)

– Critical
Critical (2)

Displayed values
The table has the following columns:

● Restart
Counts the number of restarts since you last reset to factory settings and shows the device 
restart after which the corresponding event occurred.

● System up time
Shows the time the device has been running since the last restart when the described event 
occurred.
If the system time is set, the time is also displayed at which the event occurred.

● System Time
Shows the date and time of the device.

● Severity
Shows the severity.

● Log Message
Displays a brief description of the event that has occurred.
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Buttons
● Delete

Click this button to delete the content of the event log file. The display is also cleared. The 
restart counter is only reset after you have restored the device to the factory settings and 
restarted the device.

 

  Note

The number of entries in this table is restricted to 400. When this number is reached, the 
oldest entries are overwritten. The table remains permanently in memory.

 

Fault

Error status   
 

 Note

The page is only available if there is an online connection to the device.
 

This page displays any errors that occur. If there are no more unanswered error/fault 
messages, the fault LED goes off. 

The time calculation always begins after the last system start. When the system is restarted, 
a new entry with the type of restart is created in the fault memory.

Description of the displayed values
● No. of Signaled Faults

Shows the number of reported faults.

The table contains the following columns:

● Fault Time
Shows the time the device has been running since the last restart when the described error/
fault occurred.

● Fault description
Display of the fault state for the device.

● Clear Fault State
When you can delete faults, the "Clear Fault State" button is enabled.
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Redundancy

Spanning Tree
 

 Note

The page is only available if there is an online connection to the device.
 

The page shows the current information about the Spanning Tree and the settings of the root 
bridge.

● If Spanning Tree is turned off, only the basic information about this device is displayed.

● If Spanning Tree is activated, the following is displayed: 

– Parameters of the selected instance 

– Parameters for the ports of the selected instance 

The information depends on the selected Spanning Tree mode.

Displayed values     
● Spanning Tree Mode

Shows the set mode. You specify the mode in "Layer 2 > MSTP > General".
The following values are possible:

– '-'

– STP

– RSTP

– MSTP

● Instance ID
Shows the number of the instance. The parameter depends on the configured mode.

● Bridge Priority / Root Priority
Which device becomes the root bridge is decided by the bridge priority. The bridge with the 
highest priority (in other words, with the lowest value for this parameter) becomes the root 
bridge. If several devices in a network have the same priority, the device whose MAC 
address has the lowest numeric value will become the root bridge. Both parameters, bridge 
priority and MAC address together form the bridge identifier. Since the root bridge manages 
all path changes, it should be located as centrally as possible due to the delay of the frames. 
The value for the bridge priority is a whole multiple of 4096.

● Bridge address / root address
The bridge address shows the MAC address of the device and the root address shows the 
MAC address of the root bridge.

● Root Cost
Shows the path costs from the device to the root bridge.
In MSTP mode, the path costs as far as the root bridge of the CIST are displayed.

● Bridge Status
Shows the status of the bridge, e.g. whether or not the device is the root bridge.
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● Regional root priority (available only with MSTP)
For a description, see Bridge priority / Root priority.

● Regional root address (available only with MSTP)
Shows the MAC address of the device.

● Regional root costs (only available with MSTP)
The path costs from this device to the regional root bridge.

The table has the following columns:

● Port
Shows the port via which the device communicates.  

● Role
Shows the status of the port. The following values are possible:

– Disabled 
The port was removed manually from the spanning tree and will no longer be taken into 
account by the spanning tree.

– Designated
The ports leading away from the root bridge.

– Alternate
The port with an alternative route to a network segment

– Backup
If a switch has several ports to the same network segment, the "poorer" port becomes 
the backup port.

– Root
The port that provides the best route to the root bridge.

– Master
This port points to a root bridge located outside the MST region.

● Status
Displays the current status of the port. The values are only displayed. The parameter 
depends on the configured protocol. The following statuses are possible:

– Discarding
The port receives BPDU frames. Other incoming or outgoing frames are discarded.

– Listening
The port receives and sends BPDU frames. The port is involved in the spanning tree 
algorithm. Other outgoing and incoming frames are discarded.

– Learning
The port actively learns the topology; in other words, the node addresses. Other 
outgoing and incoming frames are discarded.

– Forwarding
Following the reconfiguration time, the port is active in the network. The port receives 
and sends data frames.

● Oper. Version
Describes the type of spanning tree in which the port operates
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● Priority
If the path calculated by the spanning tree is possible over several ports of a device, the 
port with the highest priority (in other words the lowest value for this parameter) is selected. 
A value between 0 and 240 can be entered for the priority in steps of 16. If you enter a 
value that cannot be divided by 16, the value is automatically adapted. 

● Path costs
This parameter is used to calculate the path that will be selected. The path with the lowest 
value is selected. If several ports of a device have the same value, the port with the lowest 
port number will be selected.
If the value "Cost Calc." is "0", the automatically calculated value is displayed. Otherwise, 
the value of "Cost Calc." is displayed.
The calculation of the path costs is largely based on the transmission speed. The higher 
the achievable transmission speed is, the lower the value of the path costs.
Typical values for path costs with rapid spanning tree:

– 10,000 Mbps = 2,000

– 1000 Mbps = 20,000

– 100 Mbps = 200,000

– 10 Mbps = 2,000,000.

● Edge type
Shows the type of the connection. The following values are possible:

– Edge Port

An edge port is connected to this port.

– No Edge Port
There is a spanning tree or rapid spanning tree device at this port.

● P.t.P. Type
Shows the type of point-to-point link. The following values are possible:

– P.t.P.
With half duplex, a point-to-point link is assumed.

– Shared Media

With a full duplex connection, a point-to-point link is not assumed.

VRRP statistics

Introduction   
 

 Note

The page is only available if there is an online connection to the device.
 

This page shows the statistics of the VRRP protocol and all configured virtual routers.
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Description of the displayed values
The following fields are displayed:

● VRID errors
Shows how many VRRP frames containing an unsupported VRID were received.

● Version errors
Shows how many VRRP frames containing an invalid version number were received.

● Checksum errors
Shows how many VRRP frames containing an invalid checksum were received.

The table has the following columns:

● Interfaces
Interface to which the settings relate.

● VRID
Shows the ID of the virtual router. 
Valid values are 1 to 255.

● Change to master status
Shows how often this virtual router changed to the "Master" role.

● Advertisements recd.
Shows how often a VRRP frame was received that contained a bad address list.

● Advertisement Interval Errors
Shows how many bad VRRP packets were received whose interval does not match the 
value set locally.

● IP TTL errors
Shows how many bad VRRP packets were received whose TTL (Time to live) value in the 
IP header is incorrect.

● Prio 0 received
Shows how many VRRP packets with priority 0 were received. VRRP packets with priority 
0 are sent when a master router is shut down. These packets allow a fast handover to the 
relevant backup router.

● Prio 0 sent
Shows how many VRRP packets with priority 0 were sent. Packets with priority 0 are sent 
when a master router is shut down. These packets allow a fast handover to the relevant 
backup router.

● Invalid Type
Shows how often a VRRP packet was received that had the wrong type.

● Address List Errors
Shows the number of errors in the address list.

● Invalid Auth. Type
Shows how many bad VRRP packets were received whose authentication type was not 
type 0. Type 0 means "no authentication".
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● Auth. Type Mismatch
Shows how many bad VRRP frames were received whose authentication type does not 
match.

● Frame length error
Shows how many bad VRRP frames were received whose length is not correct.

Ring Redundancy
 

 Note

The page is only available if there is an online connection to the device.
 

Automatic Redundancy Detection (ARD) is the default when the device ships. If you want to 
use the previous High Speed Redundancy Protocol (HRP), HRP must be configured.

● Reconfiguration time of the frame traffic following a failover in MRP: 200 ms

● Reconfiguration time of the frame traffic following a failover in HRP: 300 ms

This page informs you about the values currently set for the device.
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Description
The following fields are displayed:

● Redundancy Function
The following values are shown:

– Disabled
Ring redundancy is disabled on the device.

– MRP Manager
The device is operating as MRP manager.

– MRP Client
The device is operating as MRP client.

– HRP Client
The device is operating as HRP client.

– HRP Manager
The device is operating as HRP manager.

● RM Status
The "RM Status" column shows whether or not the IE switch is operating as redundancy 
manager and whether it has opened or closed the ring in this role.

– Passive
The IE switch is operating as redundancy manager and has opened the ring; in other 
words, the line of switches connected to the ring ports is operating problem free. The 
passive status is also displayed if the IE switch is not operating as the redundancy 
manager (RM Function Disabled). 

– Active
The IE switch is operating as redundancy manager and has closed the ring; in other 
words, the line of switches connected to the ring ports is interrupted (problem). The 
redundancy manager connects its ring ports through and restores an uninterrupted 
linear topology.

– If media redundancy in ring topologies is completely disabled, ring ports configured last 
are displayed and the text "Ring Redundancy disabled" is displayed. 

● Observer Status
Shows the current status of the observer.

● Ring ports 
Ring ports 1 and ring port 2 show the ports used for redundancy.

● No. of Changes to RM Active State
Shows how often the device as redundancy manager switched to the active status, i.e. 
closed the ring.
If the redundancy function is disabled or the device is not the HRP/MRP manager, the text 
"Redundancy manager disabled" appears.

● Max. delay of the RM test frames [ms]
Shows the maximum delay for test frames of the redundancy manager.
If the redundancy function is disabled or the device is not the HRP/MRP manager, the text 
"Redundancy manager disabled" appears.
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Standby
 

 Note

The page is only available if there is an online connection to the device.
 

This page shows the standby status of the device.

For more information on Ethernet cabling and the topological location of master and slave, 
refer to the "Industrial Ethernet Network Manual".

Description
The following fields are displayed:

● Standby ports
Shows the ports being used.

● Standby name
Shows the name for the standby connection. The master/slave device pair is defined by 
this name (both must be in the same ring). This is achieved by entering the same name on 
two devices in the ring. You can select any name to suit your purposes, however, you can 
only use the name for one pair of devices in the entire network.

● Standby Function
Shows whether the standby connection is activated or deactivated.

– Master
The device has a connection to the partner device and is operating as master. In normal 
operation, the standby port of this device is active. 

– Slave
The device has a connection to the partner device and is operating as slave. In normal 
operation, the standby port of this device is inactive. 

– Disabled
The  standby link is disabled. The device is operating neither as master nor slave. The 
standby port is working as a normal port without standby function. 

– Waiting for Connection...
No connection has yet been established to the partner device. The standby port is 
inactive. In this case, either the configuration on the partner device is inconsistent (for 
example incorrect connection name, standby link disabled) or there is a physical fault 
(for example device failure, link down). 

– Connection Lost
The existing connection to the partner device has been lost. In this case there is either 
a physical fault (for example, device failure, link down) or the configuration on the partner 
device was modified (for example different connection name, standby link disabled). 
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● Standby status
Shows the status of the standby port:

– Active
The standby port of this device is active; in other words is enabled for frame traffic. 

– Passive
The standby port of this device is inactive; in other words is blocked for frame traffic. 

● No. of Changes to Standby Active State
Shows the number of changes from the inactive to the active status.

Ethernet Statistics

Interface statistics

Interface statistics 
The page shows the statistics from the interface table of the Management Information Base 
(MIB).

 

 Note

The page is only available if there is an online connection to the device.
 

Displayed values
The table has the following columns:

● Received bytes
Shows the number of received bytes.

● Sent bytes
Shows the number of sent bytes.

● Received unicast frames
Shows the number of received unicast frames.

● Received non-unicast frames
Shows the number of received frames that are not of the type unicast.

● Sent unicast frames
Shows the number of sent unicast frames.

● Sent non-unicast frames
Shows the number of sent frames that are not of the type unicast.
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Frame length

Frames sorted by length 
This page displays how many frames of which size were sent and received at each port. 

 

 Note

The page is only available if there is an online connection to the device.
 

Displayed values
The table has the following columns:

● Port
Shows the available ports and link aggregations. 

 

  Note
Display of frame statistics

In the statistics relating to frame lengths, note that both incoming and outgoing frames are 
counted.

 

● Frame lengths
The other columns after the port number contain the absolute numbers of incoming frames 
according to their frame length.
The following frame lengths are distinguished:

– 64 bytes

– 65 - 127 bytes

– 128 - 255 bytes

– 256 - 511 bytes

– 512 - 1023 bytes

– 1024 - max.

Button
Reset Counter

Click "Reset Counter" to reset all counters. The counters are also reset by a restart.
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Frame type

Received frames sorted by type  
This page displays how many frames of the type "unicast", "multicast", and "broadcast" were 
received at each port.

 

 Note

The page is only available if there is an online connection to the device.
 

Displayed values
The table has the following columns:

● Port
Shows the available ports and link aggregations. 

● Unicast/Multicast /Broadcast
The other columns after the port number contain the absolute numbers of the incoming 
frames according to their frame type "unicast", "multicast" and "broadcast".

Button
Reset Counter

Click "Reset Counter" to reset all counters. The counters are also reset by a restart.

Packet Errors

Received bad frames 
This page shows how many bad frames were received per port. 

 

 Note

The page is only available if there is an online connection to the device.
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Displayed values
The table has the following columns:

● Port
Shows the available ports and link aggregations.

● Error types
The other columns after the port number contain the absolute numbers of the incoming 
frames according to their error type.
In the columns of the table, a distinction is made according to the following error types:

– CRC
Frames whose content does not match the CRC checksum.  

–
Undersize
Frames with a length less than 64 bytes.

– Oversize
Frames discarded because they were too long.  

–
Fragments
Frames with a length less than 64 bytes and a bad CRC checksum.  

– Jabbers
VLAN-tagged frames with an incorrect CRC checksum that were discarded because 
they were too long.  

– Collisions
Collisions that were detected.  

Button
Reset Counter

Click "Reset Counter" to reset all counters. The counters are also reset by a restart.

History

Samples of the statistics 
The page shows samples from each port with information from the statistics.

 

 Note

The page is only available if there is an online connection to the device.
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Settings
● Port

Select the port for which the history will be displayed.

Displayed values
● Entries

Maximum number of samples that can be saved at the same time.

● Interval [s]
Interval after which the current status of the statistics will be saved as a sample.

The table has the following columns:

● Sample
Number of the sample

● Time for the Sample
System up time at which the sample was taken.

● Unicast
Number of received unicast frames.

● Multicast
Number of received multicast frames.

● Broadcast
Number of received broadcast frames.

● CRC
Number of frames with a bad CRC checksum.

● Undersize
Number of frames that are shorter than 64 bytes.

● Oversize
Number of frames discarded because they were too long.

● Fragments
Number of frames that are shorter than 64 bytes and have a bad CRC checksum.

● Jabbers
Number of frames with a VLAN tag that have a bad CRC checksum and will be discarded 
because they are too long.

● Collisions
Number of collisions of received frames.

● Utilization
Utilization of the port during a sample.

Unicast
This page shows the learnt and static unicast MAC addresses.
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Description
● VLAN ID

Shows the VLAN-ID assigned to this MAC address.

● MAC Address
Shows the MAC address of the node that the device has learned or the user has configured.

● Status
Shows the status of each address entry:

– Learnt
The specified address was learned by receiving a frame from this node and will be 
deleted when the aging time expires if no further packets are received from this node.

– Static
Configured by the user. Static addresses are stored permanently; in other words, they 
are not deleted when the aging time expires or when the switch is restarted.

● Port
Shows the port via which the node with the specified address can be reached. Frames 
received by the device whose destination address matches this address will be forwarded 
to this port.

Multicast
This page shows the learnt and static multicast MAC addresses.

Description
● VLAN ID

Shows VLAN ID of the VLAN to which the MAC multicast address is assigned.

● MAC Address
Shows the MAC multicast address that the device has learned or the user has configured.

● Status
Shows the status of each address entry. The following information is possible:

– static
The address was entered statically by the user. Static addresses are stored 
permanently; in other words, they are not deleted when the aging time expires or when 
the device is restarted. These must be deleted by the user.

– IGMP
The destination port for this address was obtained by IGMP configuration.

– GMRP
The destination port for this address was registered by a received GMRP frame.

Routing

Routing table
This page shows the routing table of the device. 
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Description 
The table has the following columns:

● Destination network
Shows the destination address of this route.

● Subnet mask
Shows the subnet mask of this route.

● Gateway
Shows the gateway for this route.

● Interface
Shows the interface for this route.

● Metric
Shows the metric of the route. The higher value, the longer the packets require to their 
destination.

● Routing protocol
Shows the routing protocol from which the entry in the routing table originates. The following 
entries are possible:

– Connected: Connected routes

– Static: Static routes

– RIP: Routes using RIP

– OSPF: Routes using OSPF

– other: Other routes

OSPFv2 interfaces

Overview
 

 Note

The page is only available if there is an online connection to the device.
 

This page shows the configuration of the OSPF interface. 

Description of the displayed values
The table has the following columns:

● IP address
Shows the IP address of the OSPF interface

● Area ID
Shows the Area ID to which the OSPF interface belongs.
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● Interface Status
Shows the status of the WLAN interface:

– Down
The interface is not available.

– Loopback
 Loopback interface

– Waiting
Startup and negotiation of the interface.

– Point to Point
Point-to-point connection

– Designated Router
The router is a designated router and generates a network LSA.

– Backup D. Router
The router is backup for the designated router.

– Other D. Router
The interface is started up. The router is neither a designated router nor a backup 
designated router.

● OSPF status
Shows the status of OSPF.

– Enabled: OSPF is enabled on the interface.

– Disabled: OSPF is disabled on the interface.

● Designated Router
Shows the IP address of the designated router for this OSPF interface.

● Backup Designated Router
Shows the IP address of the designated backup router for this OSPF interface.

● Events
Shows the number of status changes of OSPF.

OSPFv2 neighbors
 

 Note

The page is only available if there is an online connection to the device.
 

This page shows the dynamically detected neighbor routers in the relevant networks.   

Description of the displayed values 
The table has the following columns:

● IP address
Shows the IP address of the neighbor router in this network.

● Router ID
Shows the ID of the neighbor router. The two addresses can match.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
868 System Manual, 02/2014



● Status
Shows the status of the neighbor router. The status can adopt the following values:

– unknown
Status of the neighbor router is unknown.

– down
The neighbor router cannot be reached.

– attempt and init
Short-lived statuses during initialization

– two-way
Two-way receipt of Hello packets. Specification of the designated router and the 
designated backup router.

– exchangestart, exchange and loading
Status during exchange of the LSAs

– full 
The database is complete and synchronized within the area. The routes can now be 
detected.

 

  Note
Normal status

If the partner router is a designated router or a designated backup router, the status is 
"full". Otherwise the status is "two-way".

 

● Assoc. Area Type
Shows the area type via which the neighbor-neighbor relation is maintained. The following 
area types exist:

– Normal

– Stub

– NSSA

– Backbone

● Priority
Shows the priority of the neighbor router. This is only significant when selecting the 
designated router on a network. For virtual neighbor routers, this information is irrelevant.

● Hello Suppr.
Shows whether there are suppressed Hello packets to the virtual neighbor router.

– no: There are no suppressed Hello packets (default).

– yes: There are suppressed Hello packets.

● Hello Queue
Shows the length of the queue with Hello packets still to be transmitted.

● Events
Shows the number of status changes.
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OSPFv2 virtual neighbors
 

 Note

The page is only available if there is an online connection to the device.
 

This page shows the configured virtual neighbor routers.  

Overview 
The table has the following columns:

● IP address
Shows the IP address of the virtual neighbor router in this network.

● Router ID
Shows the router ID of the virtual neighbor router.

● Status
Shows the status of the neighbor router. The status can adopt the following values:

– unknown
Status of the neighbor router is unknown.

– down
The neighbor router cannot be reached.

– attempt and init
Short-lived statuses during initialization

– two-way
Two-way receipt of Hello packets. Specification of the designated router and the 
designated backup router.

– exchangestart, exchange and loading
Status during exchange of the LSAs

– full 
The database is complete and synchronized within the area. The routes can now be 
detected.

 

  Note
Normal status

If the partner router is a designated router or a designated backup router, the status is 
"full". Otherwise the status is "two-way".

 

● Trans. Area ID
Shows the ID of the area via which the virtual neighborhood relation exists.

● Hello Suppr.
Shows whether there are suppressed Hello packets to the virtual neighbor router.

– no: There are no suppressed Hello packets (default)

– yes: There are suppressed Hello packets.
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● Hello Queue
Shows the length of the queue with Hello packets still to be transmitted.

● Events
Shows the number of status changes.

OSPFv2 LSDB

Overview 
 

 Note

The page is only available if there is an online connection to the device.
 

The link state database is the central database for managing all links within an area. It consists 
of the link state advertisements (LSAs). The most important data of these LSAs is shown on 
the this WBM page.
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Description of the displayed boxes
The table has the following columns:

● Area ID
Shows the ID of the area to which the LSA belongs. If the LSA is an external connection, 
'-' is displayed.

● LSA type
Shows the LSA type. The following values are possible:

– unknown
LSA type is unknown.

– Router
The router LSA (Type 1) is sent by the OSPF router within an area. The LSA contains 
information about the status of all router interfaces.

– Network
The network LSA (Type 2) is sent by the designated router within an area. The LSA 
contains a list of routers connected to the network.

– NSSA External
The NSSA external LSA (Type 7) is sent by the NSSA-ASBR within an NSSA. The 
NSSA-ASBR receives LSAs of Type 5 and converts the information to LSAs of Type 7. 
The NSSA router can forward these LSAs within an NSSA.

– Summary
The summary LSA (Type 3) is sent by the ABR within an area. The LSA contains 
information about routes to other networks.

– AS Summary
The AS summary LSA (Type 4) is sent by the area border router within an area. The 
LSA contains information about routes to other autonomous systems.

– AS External
The AS external LSA (Type 5) is sent by the AS border router within an autonomous 
system. The LSA contains information about routes from one network to another.

● Link State ID
Shows the ID of the LSA.

● Router ID
Shows the ID of the router that sent this LSA.

● Sequence number
Shows the sequence number of the LSA. Each time an LSA is renewed, this sequence 
number is incremented by one.

RIPv2 statistics

Overview
 

 Note

The page is only available if there is an online connection to the device.
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This page shows the statistics of the RIP interface. 

Description of the displayed values
The table has the following columns:

● IP address
Shows the IP address of the RIPv2 interface

● Bad packets
Number of received RIP packets that were deleted and therefore ignored.

● Bad Routes
Number of routes of valid RIP packets that could not be taken into consideration.

● Updates Sent
Shows how often the router has sent its routing table to its neighbor routers.

System

Configuration
On this page, you specify the services with which the device can be accessed. With some 
services, there are further configuration pages on which more detailed settings can be made.

Settings  
● Telnet Server

Enable or disable the "Telnet Server" service for unencrypted access to the CLI.

● SSH server
Enable or disable the "SSH Server" service for encrypted access to the CLI.

● HTTPS server only
Enable or disable access using HTTP.

● DNS client
Enable or disable depending on whether the IE switch should operate as a DNS client. You 
can configure other settings in "System > DNS Client".

● SMTP Client
Enable or disable the SMTP client. You can configure other settings in "System > SMTP 
Client".

● Syslog Client
Enable or disable the system event client. You can configure other settings in "System > 
Syslog client".
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● DCP Server
Specify whether or not the device can be accessed with DCP (Discovery and Configuration 
Protocol): 

– "-" (disabled)
DCP is disabled. Device parameters can neither be read nor modified.

– Read/write access
With DCP, device parameters can be both read and modified.

– Read-Only
With DCP, device parameters can be read but cannot be modified.

● Time
Select the required setting. The following settings are possible: 

– Manual
The system time is set manually. 

– SNTP Client
The system time is set via an SNTP server. You can configure other settings in "System 
> System time > SNTP client".

– NTP Client
The system time is set via an NTP server. You can configure other settings in "System 
> System time > NTP client".

– SIMATIC Time
The system time is set using a SIMATIC time transmitter. You can configure other 
settings in "System > System Time SIMATIC Time Client".

– PTP Client
The system time is set via a PTP server. You can configure other settings in "System > 
System Time > PTP Client".
This function is only available for SCALANCE X500.

● SNMP
Select the required protocol. The following settings are possible: 

– "-" (SNMP disabled)
Access to device parameters using SNMP is not possible.

– SNMPv1/v2c/v3
Access to device parameters is possible with SNMP versions 1, 2c or 3. You can 
configure other settings in "System > SNMP > General".

– SNMPv3
Access to device parameters is possible with SNMP version 3. You can configure other 
settings in "System > SNMP > General".

● SNMPv1/v2 Read-Only
Enable or disable write access to SNMP variables with SNMPv1/v2c.

● SNMPv1 traps
Enable or disable the sending of SNMP traps (alarm frames). You can configure other 
settings in "System > SNMP > Traps".
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● NFC (Near Field Communikation)
Enable or disable the "NFC" function.
This function is only available for SCALANCE XM400.

● Configuration mode 
Select the required mode. The following modes are possible:

– Automatic save
Automatic save mode. Approximately 1 minute after the last parameter change or when 
you restart the device, the configuration is automatically saved.

– Trial
In the "Trial" configuration mode, although changes are adopted, they are not saved in 
the configuration file (startup configuration). 
To save changes in the configuration file, use the "Write startup config" button. The 
button is displayed when you set this configuration mode. The display area also shows 
the message "Trial mode active - Press "Write Startup Config" button to make your 
settings persistent" as soon as there are unsaved modifications. This message can be 
seen on every page until the changes made have either been saved or the device has 
been restarted.

General

Device
This page contains the general device information.

Settings  
● Current System Time(Only available online)

Shows the current system time. The system time is either set by the user or by a time-of-
day frame: either SINEC H1 time-of-day frame, NTP or SNTP. (readonly)

● System Up Time(only available online)
Shows the operating time of the device since the last restart. (readonly)

● Device Type(only available online)
Shows the type designation of the device. (readonly)

● System Name
You can enter the name of the device. The entered name is displayed in the selection area. 
A maximum of 255 characters are possible. The system name is also displayed in the CLI 
input prompt. The number of characters in the CLI input prompt is limited. The system name 
is truncated after 16 characters.
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● System Contact
You can enter the name of a contact person responsible for managing the device. 

● Location
You can enter the location of the device. The entered installation location is displayed in 
the selection area.  

 

  Note

The ASCII characters 0x20 to 0x7e are used in the input boxes. 

At the start and end of the input boxes"System Name", "System Contact" and "System 
Location", the characters "<", ">" and "space" are not permitted.

 

Coordinates
On this page, you configure the geographic coordinates (latitude, longitude and the height 
above the ellipsoid according to WGS84). These boxes are purely for information with a 
maximum length of 32 characters.

Getting the coordinates

Use suitable maps for obtaining the geographic coordinates of the device.

The geographic coordinates can also be obtained using a GPS receiver. The geographic 
coordinates of these devices are normally displayed directly and only need to be entered in 
the input boxes of this page.

Settings 
● Latitude

Enter the north or south latitude for the location of the device.
For example, +49° 1´ 31.67" means that the device is located at 49 degrees, 1 arc minute 
and 31.67 arc seconds north latitude.
A south latitude is shown by a preceding minus character.
You can also append the letters N (north latitude) or S (south latitude) to the numeric 
information (49° 1´ 31.67" N).

● Longitude
Enter the value of the eastern or western longitude of the location of the device.
For example, +8° 20´ 58.73" means that the device is located at 8 degrees, 20 minutes and 
58.73 seconds east.
A western longitude is indicated by a preceding minus sign.
You can also add the letter E (eastern longitude) or W (western longitude) to the numeric 
information (8° 20´ 58.73" E).

● Height
Enter the value of the height above sea level in meters.
For example, 158 m means that the device is located at a height of 158 m above sea level.
Heights below sea level (for example the Dead Sea) are indicated by a preceding minus 
sign.
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Agent IP

Configuration of the IP addresses
 

 Note

The page is only available if there is an online connection to the device.
 

On this page, you set the IP configuration for the device.

With devices with more than one IP interface, this call references the "Subnets > Configuration" 
menu item in the "Layer 3" menu and the configuration of the TIA interface there.

 

 Note

The IP address of the in-band port and the out-band port must belong to different subnets.
 

Settings 
● IP Address

In the input boxes under "In band", enter the IP address, subnet mask and the default 
gateway. In the input boxes under "Out band", enter the IP address, subnet mask and the 
default gateway.
If you change the IP address, the Web browser should automatically set itself to the new 
address. If this does not happen, enter the new address in the Web browser manually.

● Subnet mask
Here, in "In-band", you enter the subnet mask of the in-band port and in "Out-band" the 
subnet mask of the out-of-band port.

● Default Gateway
If the device is required to communicate with devices (diagnostics stations, e-mail servers 
etc.) in another subnet, enter the IP address of the default gateway here. The out-of-band 
port it is not accessible from a different subnet.

● Agent VLAN ID 
From the drop-down list, select the VLAN ID for the in-band management. You can only 
select VLANs that have already been configured.

 

  Note
Changing the agent VLAN ID

If the configuration PC is connected directly to the device via Ethernet and you change 
the agent VLAN ID, the device is no longer reachable via Ethernet following the change.

 

● MAC Address
Shows the MAC address of the device. The MAC address is linked to the hardware and 
cannot be modified.
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DNS client
The DNS () server (Domain Name System) assigns a domain name to an IP address so that 
a device can be uniquely identified.

If this function is enabled, the IE switch can communicate with a DNS server as a DNS client.
 

 Note

The DNS client function can only be used if there is a DNS server in the network.
 

Description
The page contains the following boxes:

● DNS Client
Enable or disable depending on whether the IE switch should operate as a DNS client.

● DNS Server IP Address
Enter the IP address of the DNS server.

Restart
On this page, there is a button with which you can restart the device and various options for 
resetting to the device defaults.

 

 Note

The page is only available if there is an online connection to the device.
 

 Note

Note the following points about restarting a device:
● You can only restart the device with administrator privileges.
● A device should only be restarted with the buttons of this page or with the appropriate CLI 

commands and not by a power cycle on the device.
● Any modifications you have made only become active on the device after clicking the "Set 

Values" button on the relevant page. If the device is in "Trial Mode", configuration 
modifications must be saved manually before a restart. In "Automatic Save" mode, the 
last changes are saved automatically before a restart.
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Settings
The following options are available for restarting:

● Restart
Click this button to restart the system. You must confirm the restart in a dialog box. During 
a restart, the device is reinitialized, the internal firmware is reloaded, and the device runs 
a self-test. The learned entries in the address table are deleted. You can leave the browser 
window open while the device restarts. You then need to log in again:

● Restore Factory Defaults and Restart
Click this button to restart the system. You must confirm the restart in a dialog box. During 
a restart, the device is reinitialized, the internal firmware is reloaded, and the device runs 
a self-test. The learned entries in the address table are deleted. You can leave the browser 
window open while the device restarts. You then need to log in again.

 

  Note

By resetting all the defaults to the factory settings, the IP address and the passwords are 
also lost. Following this, the device can only be accessed using the Primary Setup Tool 
or using DHCP.

With the appropriate attachment, a previously correctly configured device can cause 
circulating frames and therefore the failure of the data traffic.

 

Load & save

Uploading and saving using HTTP

Loading and saving data via HTTP
On this page, you store device data in an external file on your client PC or load such data from 
an external file from the PC to the devices. This means, for example, that you can also load 
new firmware from a file located on your client PC.

 

 Note
Incompatibility with predecessor versions

During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed.
Incompatibility with previous versions with PLUG inserted

During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed. In this 
situation, if a PLUG is inserted in the device, following the restart, this has the status "Not 
Accepted" since the PLUG still has the configuration data of the previous more up-to-date 
firmware. This allows you to return to the previous, more up-to-date firmware without any loss 
of configuration data. If the original configuration on the PLUG is no longer required, the PLUG 
can be deleted or rewritten manually using System > PLUG.
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 Note
Configuration files and Trial mode/Automatic Save

In "Automatic Save" mode, the data is saved automatically before the configuration files 
(ConfigPack and Config) are transferred.
In Trial  mode, although the changes are adopted, they are not saved in the configuration 
files (ConfigPack and Config). Use the "Write Startup Config" button on the "System > 
Configuration" WBM page to save changes in the configuration file.

 

Settings
The table has the following columns:

● Type
Shows the file type.

● Description
Shows the short description of the file type.

● Load
With this button, you can upload files to the device. The button can be enabled, if this 
function is supported by the file type.

● Save
With this button, you can save files from the device. The button can only be enabled if this 
function is supported by the file type and the file exists on the device.

● Delete
With this button, you can delete files from the device. The button can only be enabled if this 
function is supported by the file type and the file exists on the device.

Loading new firmware

After successfully downloading the firmware, you will be requested to restart the device. 

Restart the device and continue to configure the newly started firmware.

Procedure
Loading files using HTTP

1. Start the upload function by clicking the one of the "Load" buttons.
The dialog for uploading a file opens.

2. Go to the file you want to upload.

3. Click the "Open" button in the dialog.
The file is now uploaded.

4. When the message "Restart required" appears, click the "Yes" button to trigger the restart. 
If you click the "No" button, there is no device restart. The changes only take effect after a 
restart.

Saving files using HTTP
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1. Start the save function by clicking the one of the "Save" buttons.

2. You will be prompted to select a storage location and a name for the file. Or you accept the 
proposed file name. To make the selection, use the dialog in your browser. After making 
your selection, click the "Save" button.

Deleting files using HTTP

1. Start the delete function by clicking the one of the "Delete" buttons.
The file will be deleted.

Reusing configuration data

If several devices are to receive the same configuration and the IP addresses are assigned 
using DHCP, the effort for configuration can be reduced by saving and reading in the 
configuration data. 

Follow the steps below to reuse configuration data:

1. Save the configuration data of a configured device on your PC.

2. Download this configuration file to all other devices you want to configure in this way.

3. If individual settings are necessary for specific devices, these must be made online on the 
relevant device.

Note that the configuration data is coded when it is saved. This means that you cannot edit 
the files with a text editor.

Uploading and saving using TFTP

Loading and saving data via a TFTP server   
On this page, you can configure the TFTP server and the file names. You can also store device 
data in an external file on your client PC or load such data from an external file from the PC 
to the devices. This means, for example, that you can also load new firmware from a file located 
on your client PC. 

 

 Note
Incompatibility with predecessor versions

During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed.
Incompatibility with predecessor versions with inserted PLUG
During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed. In this 
situation, if a PLUG is inserted in the device, following the restart, this has the status "Not 
Accepted" since the PLUG still has the configuration data of the previous more up-to-date 
firmware. This allows you to return to the previous, more up-to-date firmware without any loss 
of configuration data. If the original configuration on the PLUG is no longer required, the PLUG 
can be deleted or rewritten manually on the "System > PLUG page. 
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 Note
Configuration files and Trial mode/Automatic Save

In "Automatic Save" configuration mode, the data is saved automatically before the 
configuration files (ConfigPack and Config) are transferred.
In the "Trial" configuration mode, although the changes are adopted, they are not saved in 
the configuration files (ConfigPack and Config). Use the "Write Startup Config" button on the 
"System > Configuration" WBM page to save changes in the configuration files.

 

Settings
● TFTP Server IP Address

Here, enter the IP address of the TFTP server with which you exchange data.

● TFTP Server Port
Here, enter the port of the TFTP server via which data exchange will be handled. If 
necessary, you can change the default value 69 to your own requirements.

The table has the following columns:

● File type
Shows the file type.

● Description
Shows the short description of the file type.

● File name
Enter a file name.

● Select action (only available online)
Select the action from the drop-down list. The selection depends on the selected file type, 
for example the log file can only be saved.
The following actions are possible:

– Save file
With this selection, you save a file on the TFTP server.

– Load file
With this selection, you load a file from the TFTP server.

Events

Configuration
On this page, you specify how the device reacts to events. 
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Settings
● Signaling Contact Response

Select the behavior of the signaling contact. The following reactions are possible:

– conventional
Default setting for the signaling contact. An error/fault is displayed by the fault LED and 
the signaling contact is opened. When the error/fault state no longer exists, the fault 
LED goes off and the signaling contact is closed.

– User-defined
The way the signaling contact works does not depend on the error/fault that has 
occurred. The signaling contact can be opened or closed as required by user actions.

● Signaling Contact Status
Select the status of the signaling contact. The following statuses are possible:

– close
Signaling contact is closed.

– open
Signaling contact is opened.

Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● E-mail/Trap/Log table/Syslog/Errors
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:
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● Event
The "Event" column contains the following values:

– Cold/Warm Start
The device was turned on or restarted by the user.

– Link Change
This event occurs only when the port status is monitored and has changed, see "System 
> Fault Monitoring > Link Change".

– Authentication Failure
This event occurs when attempting access with a bad password.

– RMON Alarm 
An alarm or event has occurred relating to the remote monitoring of the system.

– Power Supply Switchover
This event occurs only when power supply lines 1 and 2 are monitored. It indicates that 
there was a change to line 1 or line 2, see System > Fault monitoring > Power supply".

– RM status change
The status of the redundancy manager has changed

– Spanning Tree Topology Change
The STP or RSTP or MSTP topology has changed.

– Fault State Change
The fault state has changed. The fault state can relate to the activated port monitoring, 
the response of the signaling contact or the power supply monitoring.

– VRRP State Change (only with routing using VRRP) 
The status of the virtual router has changed

– Loop Detection
A loop was detected in the network segment.

– OSPF State Change (only with routing using OSFP)
The status of OSPF has changed

● E-mail
The device sends an e-mail. This is only possible if the SMTP server is set up and the 
"SMTP client" function is enabled.

● Trap
The device sends an SNMP trap. This is only possible if "SNMPv1 traps" is enabled in 
"System > Configuration".

● Log table
The device writes an entry in the log table.

● Syslog
The device writes an entry to the system log server. This is only possible if the system log 
server is set up and the "Syslog client" function is enabled.

● Fault
The device triggers a fault. The error LED lights up

Severity filter
On this page, set the threshold levels for sending system event notifications.
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Settings
The table has the following columns:

● Client Type
Select the client type for which you want to make settings:

– E-mail
Sending system event messages by e-mail

– Log table
Entry of system events in the log table.

– Syslog
Entering system events in the Syslog file

● Severity
Select the required level. The following settings are possible:

– Info
System events are processed as of the severity level "Info".

– Warning
System events are processed as of the severity level "Warning".

– Critical
System events are processed as of the severity level "Critical".

SMTP client
The device provides the option of automatically sending an e-mail if an alarm event occurs (for 
example to the network administrator). The e-mail contains the identification of the sending 
device, a description of the cause of the alarm in plain language, and a time stamp. This allows 
centralized network monitoring to be set up for networks with few nodes based on an E-mail 
system. When an e-mail event message is received, the WBM can be started by the browser 
using the identification of the sender to read out further diagnostics information.  

On this page, you can configure up to three SMTP servers and the corresponding e-mail 
addresses.

 

 Note

Depending on the properties and configuration of the SMTP server, it may be necessary to 
adapt the "From” input box for the e-mails. Check with the administrator of the SMTP server.

 

Settings
● SMTP Client

Enable or disable the SMTP client.

● Email address of the sender
Enter the name of the sender that will be included in the e-mail, for example the device 
name.
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● SMTP Port
Change the port if the SMTP server is not obtainable via port 25.

● SMTP Server IP Address
Enter the IP address of the SMTP server.

This table contains the following columns:

● SMTP Server IP Address
Shows the SMTP server IP address.

● Email address of the recipient
Enter the e-mail address to which the device sends an e-mail if a fault occurs. The e-mail 
address can be the address of a single person or a distribution list.

Syntax of email addresses
The following conditions apply to e-mail addresses:

● Alphanumeric characters are permitted.

● The following special characters are permitted:

– @

– _ (underscore)

– - (hyphen)

– . (period) 

● A @ character must be included.

● Only one @ may be used. 

● The characters "@" and the "." must not be the first or last character.

DHCP client
If the DHCP mode is activated, the DHCP client starts a DHCP request to a configured DHCP 
server and is assigned an IP address as the response. The server manages an address range 
from which it assigns IP addresses. It is also possible to configure the server so that the client 
always receives the same IP address in response to its request.
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Settings
● DHCP client configuration request (opt. 66, 67)

Select this option if you want the DHCP client to use options 66 and 67 to download and 
then enable a configuration file.

● DHCP Mode
Select the DHCP mode. The following modes are possible:

– via MAC Address
Identification is based on the MAC address.

– via DHCP Client ID
Identification is based on a freely defined DHCP client ID.

– via System Name
Identification is based on the device name. If the device name is 255 characters long, 
the last character is not used for identification.

This table contains the following columns:

● Interface
Shows the available interfaces.

● DHCP
Enable or disable the DHCP client.

SNMP

General
On this page, you make the basic settings for SNMP. Enable the functions you want to use. 

Settings
● SNMP

Select the SNMP protocol. The following settings are possible:

– "-" (disabled)
SNMP is disabled.

– SNMPv1/v2c/v3
SNMPv1/v2c/v3 is supported.

– SNMPv3
Only SNMPv3 is supported.

● SNMPv1/v2 Read-Only
If you enable this option, SNMPv1/v2c can only read the SNMP variables.

 

  Note
Community String

For security reasons, do not use the standard values "public" or "private". Change the 
community strings following the initial installation.
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● SNMPv1/v2c Read Community String
Enter the community string for access of the SNMP protocol.

● SNMPv1/v2c Read/Write Community String
Enter the community string for read and write access of the SNMP protocol.

● SNMPv1 Traps
Enable or disable the sending of SNMP traps (alarm frames). On the "Trap" tab, specify 
the IP addresses of the devices to which SNMP traps will be sent.

● SNMPv1/v2c Trap Community String
Enter the community string for sending SNMPv1/v2 messages.

Traps
If an alarm event occurs, a device can send SNMP traps (alarm frames) to up to ten different 
management stations at the same time. Traps are only sent if events specified in "Events > 
Configuration" occur.

 

 Note

SNMP traps are sent only when the "SNMPv1 Traps" setting was selected in "SNMP > 
General".

 

Settings 
● IP Address

Enter the IP address of the stations to which the device sends SNMP traps

The table has the following columns:

● IP Address
Shows the IP addresses of the stations to which the device sends SNMP traps. 

● Trap
Enable or disable the sending of SNMP traps. Stations that are entered but not selected 
do not receive SNMP traps.

v3 Groups

Security settings and assigning permissions
SNMP version 3 allows permissions to be assigned, authentication, and encryption at protocol 
level. The security levels and read/write permissions are assigned according to groups. The 
settings automatically apply to every member of a group.
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Settings
● Group Name

Enter the name of the group. This name must have at least two characters, the maximum 
length is 32 characters.

● Security Level
Select the security level (authentication, encryption) valid for the selected group. You have 
the following options for the security levels:   

– no Auth/no Priv
No authentication enabled / no encryption enabled.

– Auth/no Priv
Authentication enabled / no encryption enabled.

– Auth/Priv
Authentication enabled / encryption enabled.

The table has the following columns:

● Group Name
Shows the defined group names.

 

  Note

Once a group name and the security level have been specified, they can no longer be 
modified after the group is created. If you want to change the group name or the security 
level , you will need to delete the group and recreate it and reconfigure it with the new 
name.

 

● Security Level
Shows the configured security level.

● Read
Enable or disable read access.

● Write
Enable or disable write access.

● Persistence
Shows whether or not the group is assigned to an SNMPv3 user. If the group is not assigned 
to an SNMPv3 user, no automatic saving is triggered and the configured group disappears 
again after restarting the device.

– Yes
The group is assigned to an SNMPV3 user.

– No
The group is not assigned to an SNMPV3 user.

v3 users

User-specific security settings   
On the WBM page, you can create new SNMPv3 users and modify or delete existing users. 
The user-based security model works with the concept of the user name; in other words, a 
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user ID is added to every frame. This user name and the applicable security settings are 
checked by both the sender and recipient.

Settings 
● User name

Enter a freely selectable user name. After you have entered the data, you can no longer 
modify the name. 

The table has the following columns:

● User name
Shows the created users.

● Group Name
Select the group to which the user will be assigned. 

● Authentication Protocol
Select the authentication protocol. Can only be enabled, if this group supports the function.
The following settings are available:

– None

– MD5

– SHA

● Encryption Protocol
Specify whether or not the user uses the DES algorithm. Can only be enabled, if the group 
supports this function.

● Authentication Password
Enter the authentication password in the first input box. 

● Confirm authentication password
Confirm the password by repeating the entry. 

● Encryption Password
Enter your encryption password. 

● Confirm Encryption Password
Confirm the encryption password by repeating the entry.

● Persistence
Shows whether or not the user is assigned to an SNMPv3 group. If the user is not assigned 
to an SNMPv3 group, no automatic saving is triggered and the configured user disappears 
again after restarting the device.

– Yes
The user is assigned to an SNMPv3 group.

– No
The user is not assigned to an SNMPv3 group.
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System time

Manual time setting
On this page, you set the date and time of the system. For this setting to be used, enable 
"Manual time setting".

 

 Note

The page is only available if there is an online connection to the device.
 

Settings
● Time Manually

Enable or disable the manual time setting.

● System Time
Enter the date and time in the format "MM/DD/YYYY HH:MM:SS". Can only be edited, if 
manual time setting is enabled.
After a restart, the time of day begins at 01/01/2000 00:00:00

● Use PC Time
Click the button to use the time setting of the PC.

● Last Synchronization Time
This box is read-only and shows when the last time-of-day synchronization took place. If 
no time-of-day synchronization was possible, the box displays "Date/time not set".

● Last Synchronization Mechanism
This box displays how the last time-of-day synchronization was performed.

– Not set
The time was not set.

– Manual
Manual time setting

– SNTP
Automatic time-of-day synchronization using SNTP

– NTP
Automatic time-of-day synchronization using NTP

– SIMATIC
Automatic time-of-day synchronization using the SIMATIC time frame.

– PTP
Automatic time-of-day synchronization with PTP

DST overview
On this page, you can create new entries for the daylight saving time changeover.

The table provides an overview of the existing entries.
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Settings
● DST No.

Shows the number of the entry.
If you create a new entry, a new line with a unique number is created. 

● Name
Shows the name of the entry.

● Year
Shows the year for which the entry was created.

● Start Date
Shows the month, day and time for the start of daylight saving time. 

● End Date
Shows the month, day and time for the end of daylight saving time.

● Type
Shows how the daylight saving time changeover is made:

– Date
A fixed date is entered for the daylight saving time changeover. 

– Recurring
A rule was defined for the daylight saving time changeover.

DST configuration
On this page, you can configure the entries for the daylight saving time changeover. As result 
of the changeover to daylight saving or standard time, the system time for the local time zone 
is correctly set.

You can define a rule for the daylight saving time changeover or specify a fixed date.

Settings
 

 Note

The content of this page depends on the selection in the "Type" box.

The boxes "DST No.", "Type" and "Name" are always shown.
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● DST No.
Select the type of the entry.

● Type
Select how the daylight saving time changeover is made: 

– Date
You can set a fixed date for the daylight saving time changeover.
This setting is suitable for regions in which the daylight saving time changeover is not 
governed by rules.

– Recurring
You can define a rule for the daylight saving time changeover.
This setting is suitable for regions in which the daylight saving time always begins or 
ends on a certain weekday.

● Name
Enter a name for the entry.

Settings with "Date" selected
You can set a fixed date for the start and end of daylight saving time.

● Year
Enter the year for the daylight saving time changeover.

● Start Date
Enter the following values for the start of daylight saving time:

– Day

– Hour

– Month

● End Date
Enter the following values for the end of daylight saving time:

– Day

– Hour

– Month

Settings with "Recurring" selected
You can create a rule for the daylight saving time changeover.
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● Start Date
Enter the following values for the start of daylight saving time:

– Hour

– Month

– Week
You can select the 1st to 5th or the last week of the month.

– Weekday

● End Date
Enter the following values for the end of daylight saving time:

– Hour

– Month

– Week
You can select the 1st to 5th or the last week of the month.

– Weekday

SNTP client
SNTP (Simple Network Time Protocol) is used for synchronizing the time in the network. The 
appropriate frames are sent by an SNTP server in the network.     

Settings
● SNTP Client

Enable or disable automatic time-of-day synchronization using SNTP.

● Current System Time (only available online)
Shows the values currently set in the system for date and time.

● Last Synchronization Time (only available online)
This box is read-only and shows when the last time-of-day synchronization took place. If 
no time-of-day synchronization was possible, the box displays "Date/time not set".
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● Last Synchronization Mechanism (only available online)
This box displays how the last time-of-day synchronization was performed.

– Not set
The time was not set.

– Manual
Manual time setting

– SNTP
Automatic time-of-day synchronization using SNTP

– NTP
Automatic time-of-day synchronization using NTP

– SIMATIC
Automatic time-of-day synchronization using the SIMATIC time frame

– PTP
Automatic time-of-day synchronization with PTP

● Time Zone
Enter the time zone you are using in the format "+/- HH:MM". The time zone relates to UTC 
standard world time. Settings for daylight-saving and standard time are taken into account 
in this box by specifying the time offset.

● SNTP Mode
Select the synchronization mode. The following types of synchronization are possible:

– Poll
If you select this protocol type, the input boxes "SNTP Server IP Address", "SNTP Server 
Port" and "Poll Interval" are displayed for further configuration. With this type of 
synchronization, the device is active and sends a time query to the SNTP server.

– Listen
With this type of synchronization, the device is passive and "listens" for SNTP frames 
that deliver the time of day.

● SNTP Server IP Address
Enter the IP address of the SNTP server.

● SNTP Server Port
Enter the port of the SNTP server. 

● Poll Interval [s]
Enter the interval in seconds between two time polls.

NTP client
If you require time-of-day synchronization using NTP, you can make the relevant settings here.

Settings
● NTP Client

Enable or disable automatic time-of-day synchronization using NTP.

● Current System Time (only available online)
Shows the values currently set in the system for date and time.
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● Last Synchronization Time (only available online)
This box is read-only and shows when the last time-of-day synchronization took place. If 
no time-of-day synchronization was possible, the box displays "Date/time not set".

● Last Synchronization Mechanism (only available online)
This box displays how the last time-of-day synchronization was performed.

– Not set
The time was not set.

– Manual
Manual time setting

– SNTP
Automatic time-of-day synchronization using SNTP

– NTP
Automatic time-of-day synchronization using NTP

– SIMATIC
Automatic time-of-day synchronization using the SIMATIC time frame

– PTP
Automatic time-of-day synchronization with PTP

● Time Zone
Enter the time zone you are using in the format "+/- HH:MM". The time zone relates to UTC 
standard world time. Settings for daylight-saving and standard time are taken into account 
in this box by specifying the time offset.

● NTP Server IP Address
Enter the IP address of the NTP server.

● NTP Server Port
Enter the port of the NTP server.

● Poll Interval [s]
Enter the interval in seconds between two time polls. 

SIMATIC Time Client
On this page, you configure time synchronization with the SIMATIC Time Client.

Settings
● SIMATIC Time Client

Enable or disable loop the SIMATIC Time Client.

● Current System Time (only available online)
Shows the values currently set in the system for date and time.
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● Last Synchronization Time (only available online)
This box is read-only and shows when the last time-of-day synchronization took place. If 
no time-of-day synchronization was possible, the box displays "Date/time not set".

● Last Synchronization Mechanism (only available online)
This box displays how the last time-of-day synchronization was performed.

– Not set
The time was not set.

– Manual
Manual time setting

– SNTP
Automatic time-of-day synchronization using SNTP

– NTP
Automatic time-of-day synchronization using NTP

– SIMATIC
Automatic time-of-day synchronization using the SIMATIC time frame

– PTP
Automatic time-of-day synchronization with PTP

PTP Client
On this page, you configure time synchronization with PTP (Precision Time Protocol).

This function is only available for SCALANCE X500.

Settings
● PTP Client

Enable or disable time synchronization using PTP. You can configure other settings in 
"Layer 2 > PTP".

● Current System Time (only available online)
This box is read-only and displays the current system time.

● Last Synchronization Time (only available online)
This box is read-only and shows when the last time-of-day synchronization took place. If 
no time-of-day synchronization was possible, the box displays "Date/time not set".
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● Last Synchronization Mechanism (only available online)
This box displays how the last time-of-day synchronization was performed.

– Not set
The time was not set.

– Manual
Manual time setting

– SNTP
Automatic time-of-day synchronization using SNTP

– NTP
Automatic time-of-day synchronization using NTP

– SIMATIC
Automatic time-of-day synchronization using the SIMATIC time frame

– PTP
Automatic time-of-day synchronization with PTP

● Time Zone
Enter the time zone you are using in the format "+/- HH:MM". The time zone relates to UTC 
standard world time. 

Auto logout
On this page, set the times after which there is an automatic logout from WBM or the CLI 
following user in activity.

 

 Note
No automatic logout from the CLI

If the connection is not terminated after the set time, check the setting of the "keepalive" 
mechanism on the Telnet client. 

If the interval is shorter than the configured time, the connection is kept alive although no 
user data is transferred. Example: you selected 300 seconds for the automatic logout and 
120 seconds is set for the keepalive function. In this case, a packet is sent every 120 seconds 
that keeps the connection up. 
● Disable the keepalive mechanism (interval time = 0)

or
● Set the interval high enough so that the underlying connection is terminated when there 

is inactivity.
 

Settings
● Web Based Management [s]

Enter the time in seconds for the automatic logout from WBM. If you enter the value 0, the 
automatic logout is disabled.

● CLI (TELNET, SSH, Serial) [s]
Enter the time in seconds for the automatic logout from the CLI. If you enter the value 0, 
the automatic logout is disabled.
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Button
The "Select/Set" button has the following functions:

● Change display mode

● Enable redundancy manager

● Restore to factory defaults

● Fault mask and LED display

You will find a detailed description of the individual functions available with the buttons in the 
operating instructions of the specific device.

Settings
● Restore Factory Defaults

Enables or disables the "Restore Factory Defaults" function for the Select/Set button.
 

 
 CAUTION

Button function "Restore Factory Defaults" active during startup

If you have disabled this function in your configuration, disabling is only valid during 
operation. When restarting, for example after power down, the function is active until the 
configuration is loaded so that the device can inadvertently be reset to the factory settings. 
This may cause unwanted disruption in network operation since the device needs to be 
reconfigured if this occurs. An inserted PLUG is also deleted and returned to the status 
as shipped

 

● Redundancy Manager
Enables or disables the redundancy manager function for the Select/Set button.

● Set Fault Mask
Enable or disable the function "Define fault mask via the LED display" with the Select/set 
button. This function only works in display mode D.

Syslog client
Syslog according to RFC 3164 is used for transferring short, unencrypted text messages over 
UDP in the IP network. This requires a system log server.

Requirements for sending log entries:
● The system log function is enabled on the device.

● The system log function is enabled for the relevant event.

● There is a system log server in your network that receives the log entries. Since this is a 
UDP connection, there is no acknowledgment to the sender.

● The IP address of the system log server is entered on the device.
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Settings
● Syslog Client

Enable or disable the system log function.

● Syslog Server IP Address
Enter the IP address of the system log server.

This table contains the following columns

● Syslog Server IP Address
Shows the IP address of the system log server.

● Server Port
Enter the port of the Syslog server being used.

Ports

Port overview
The page shows the configuration for the data transfer for all ports of the device.

Settings
● Port

Shows the configurable ports. 

● Port name
Shows the name of the port.

● MAC Address (only available online)
Shows the MAC address of the port.

● Mode (only available online)
Shows the transfer parameters of the port

● Negotiation
Shows whether the automatic configuration is enabled or disabled.  

● Flow Ctrl. Type
Shows whether flow control is enabled or disabled for the port.

● Flow Ctrl.
Shows whether or not flow control is working on this port.

● MTU
Shows the maximum packet size.

● Port Type (only with routing)
Shows the type of the port. The following types are possible:

– Router Port

– Switch Port VLAN Hybrid

– Switch-Port VLAN Trunk

● Status
Shows whether the port is on or off. Data traffic is possible only over an enabled port.
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● Combo Port Media Type(SCALANCE XM400 only)
Shows the mode of the combo port:

– auto

– rj45

– sfp

● Link (only available online)
Shows the connection status to the network. With the connection status, the following is 
possible:

– Up
The port has a valid link to the network, a link integrity signal is being received.

– Down
The link is down, for example because the connected device is turned off.

Configuration
On this page, you configure the ports of the device 

Settings
● Port

Select the port to be configured. The port is made up of the port number and the slot number, 
for example port 0.1 is slot 0, port 1.

● Status
Specify whether the port is enabled or disabled.

– enabled
The port is enabled. Data traffic is possible only over an enabled port.

– disabled
The port is disabled but the connection remains.

– Link down
The port is disabled and the connection to the partner device is terminated.

● Port name
Enter a name for the port.

● MAC Address (only available online)
Shows the MAC address of the port.

● Mode Type
Shows the transmission speed and the transmission method of the port. You make the 
settings for "Autonegotiation" and "Transmission rate" in the port options.

 

  Note

Before the port and partner port can communicate with each other, the settings must match 
at both ends.

 

● Mode (only available online)
Shows which transmission speed and which transmission mode is currently being used.
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● Negotiation
Shows whether the automatic configuration of the connection to the partner port is enabled 
or disabled.

● Flow Ctrl. Type
Shows whether or not flow control is working on this port.

 

  Note
Turning flow control on/off with autonegotiation

Flow control can only be enabled or disabled if the "autonegotiation" function is turned off. 
The function cannot enabled again afterwards.

 

● Flow Ctrl.
Shows whether or not flow control is working on this port.

● MTU
Enter the packet size.

● Port Type (only with routing)
Select the type of the port:

– Router Port
The port is an IP interface. It does not support layer 2 functions.

– Switch Port VLAN Hybrid
The port sends tagged and untagged frames. It is not automatically a member of a VLAN.

– Switch-Port VLAN Trunk
The port only sends tagged frames and is automatically a member of all VLANs.

● Combo Port Media Type(SCALANCE XM400 only)
Specify the mode for the combo port:

– auto
If you select this mode, the SFP transceiver port has priority. As soon as an SFP 
transceiver is plugged in, an existing connection at the fixed RJ-45 port is terminated. 
If no SFC transceiver is plugged in, a connection can be established via the fixed RJ-45 
port.

– rj45
If you select this mode, the fixed RJ-45 port is used regardless of the SFP transceiver 
port.

– sfp
If you select this mode, the SFP transceiver port is used regardless of the built-in RJ-45 
port.

The factory setting is auto mode.

● Link (only available online)
Shows the connection status to the network. With the connection status, the following is 
possible:

– Up
The port has a valid link to the network, a link integrity signal is being received.

– Down
The link is down, for example because the connected device is turned off.
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Changing the port configuration     
 

 Note

Optical ports only work with the full duplex mode and at maximum transmission rate. As a 
result, the following settings cannot be made for optical ports:
● Automatic configuration
● Transmission speed
● Transmission technique

 

 Note

With various automatic functions, the device prevents or reduces the effect on other ports 
and priority classes (Class of Service) if a port is overloaded. This can mean that frames are 
discarded even when flow control is enabled.

Port overload occurs when the device receives more frames than it can send, for example 
as the result of different transmission speeds.

 

Fault monitoring

Power supply
Configure whether or not the power supply should be monitored by the messaging system. 
Depending on the hardware variant, there are one or two power connectors (Supply 1 / Supply 
2). With a redundant power supply, configure the monitoring separately for each individual 
feed-in line.   

If there is no power on one of the monitored lines (Supply 1 or Supply 2) or when the voltage 
is too low, a fault is signaled by the signaling system.

 

 Note

You will find the permitted operating voltage limits in the compact operating instructions of 
the device.

 

An error causes the fault LED to light up on the device. Depending on the configuration, the 
error may trigger a trap, an e-mail or an entry in the event log table.

Settings
● Line 1

Enable or disable the monitoring of power connector 1.

● Line 2
Enable or disable the monitoring of power connector 2.
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Link Change
On this page, you configure whether or not an error message is triggered if there is a status 
change on a network connection.   

If connection monitoring is enabled, an error is signaled 

● when there should be a link on a port and this is missing.

● or when there should not be a link on a port and a link is detected.

An error causes the signaling contact to trigger and the fault LED to light up on the device. 
Depending on the configuration, the error may trigger a trap, an e-mail or an entry in the event 
log table.

Settings
Table 1 has the following columns:

● 1st column 
Shows that the settings are valid for all ports.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns

● Port
Shows the available ports.

● Setting
Select the setting. You have the following options:

– Up
Error handling is triggered when the port changes to the active status.
(From "Link down" to "Link up")

– Down
Error handling is triggered when the port changes to the inactive status.
(From "Link up" to "Link down")

– "-" (disabled)
The error handling is not triggered.

Redundancy
On this page, you configure whether or not an error message is triggered if there is a status 
change on a network connection.   
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Setting
● Redundancy loss (HRP only)

Enable or disable connection monitoring. If the redundancy of the connection is lost, an 
error is signaled.

PNIO
On this page, you configure the device response to PROFINET input and output.

Description
The page contains the following boxes:

● PNIO runtime mode
Shows the status of the PNIO operation.

● PNIO runtime mode for next startup
Select the runtime mode that will be active the next time the device starts up.

● PNIO AR status
This box shows the PROFINET IO application relation status; in other words, whether or 
not the IE switch is connected "online" or "offline" with a PROFINET controller.
In this context, online means that a connection to a PROFINET IO controller exists, that 
the controller has downloaded its configuration data to the IE switch and that the device 
can send status data to the PROFINET IO controller. In this status known as "in data 
exchange", the parameters set with the PROFINET IO controller cannot be configured on 
the IE switch.

● PNIO Device Name
Enter the PROFINET IO device name.

● Allow PNIO Data Exchange
Enable or disable PNIO data exchange

● Simulate PNIO Data Exchange
Enable or disable the simulation of PNIO data exchange.

PLUG

PLUG configuration
 

 Note

The page is only available if there is an online connection to the device.
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 NOTICE

Do not remove or insert a C-PLUG / KEY-PLUG during operation!

A PLUG may only be removed or inserted when the device is turned off.
The device checks whether or not a PLUG is present at one second intervals. If it is detected 
that the PLUG was removed, there is a restart. If a valid KEY-PLUG was inserted in the 
device, the device changes to a defined error state following the restart.

 

Information about the configuration of the C-PLUG / KEY-PLUG   
This page provides detailed information about the configuration stored on the C-PLUG or KEY-
PLUG. It is also possible to reset the PLUG to "factory defaults" or to load it with new contents.

 

 Note

The action is only executed after you click the "Set Values" button.

The action cannot be undone.

If you decide against executing the function after making your selection, click the "Refresh" 
button. As a result the data of this page is read from the device again and the selection is 
canceled.

 

 Note
Incompatibility with previous versions with PLUG inserted

During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed. In this 
situation, if a PLUG is inserted in the device, following the restart, this has the status "NOT 
ACCEPTED" since the PLUG still has the configuration data of the previous more up-to-date 
firmware. This allows you to return to the previous, more up-to-date firmware without any loss 
of configuration data. 

If the original configuration on the PLUG is no longer required, the PLUG can be deleted or 
rewritten manually using "System > PLUG".
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Settings
The table has the following rows:

● Status
Shows the status of the PLUG. The following are possible:

– ACCEPTED
There is a PLUG with a valid and suitable configuration in the device.

– NOT ACCEPTED
Invalid or incompatible configuration on the inserted PLUG.

– NOT PRESENT
There is no C-PLUG or KEY-PLUG inserted in the device.

– FACTORY
PLUG is inserted and does not contain a configuration. This status is also displayed 
when the PLUG was formatted during operation.

– MISSING
There is no PLUG inserted. Functions are configured on the device for which a license 
is required.

● Device Family
Shows the SIMATIC NET product line that used the C-PLUG or KEY-PLUG previously.

● Device Type
Shows the device type within the product line that used the C-PLUG or KEY-PLUG 
previously.

● Configuration Revision
The version of the configuration structure. This information relates to the configuration 
options supported by the device and has nothing to do with the concrete hardware 
configuration. This revision information does not therefore change if you add or remove 
additional components (modules or extenders), it can, however, change if you update the 
firmware.

● File System
Displays the type of file system on the PLUG.

 

 
 NOTICE

New file system UBI

As of firmware version 3.0, UBI is the standard file system for the C-PLUG or KEY-PLUG. 
If a C-PLUG with the previous file system IECP is detected in such a device, this C-PLUG 
will be formatted for the UBI file system and the data will be rewritten to the C-PLUG.

The file system is also changed following a firmware update to V3.0. A downgrade to the 
previous version of the corresponding software is then a problem. The firmware can 
neither read nor write the C-PLUG or KEY-PLUG and it is not even possible to "Erase 
PLUG to factory default". 

 

● File System Size [bytes]
Shows the maximum storage capacity of the file system on the C-PLUG.

● File System Usage
Displays the storage space in use in the file system of the C-PLUG.
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● Info String
Shows additional information about the device that used the PLUG previously, for example, 
order number, type designation, and the versions of the hardware and software. The 
displayed software version corresponds to the version in which the configuration was last 
changed. With the "NOT ACCEPTED" status, further information on the cause of the 
problem is displayed.

● Modify PLUG
Select the required setting.

– Write current configuration to PLUG 
This option is available only if the status of the PLUG is "NOT ACCEPTED" or FACTORY.
The configuration in the internal flash memory of the device is copied to the PLUG.  

– Erase PLUG to factory default
Deletes all data from the C-PLUG and triggers low-level formatting.  

PLUG license
 

 Note

The page is only available if there is an online connection to the device.
 

 NOTICE

Do not remove or insert a C-PLUG / KEY-PLUG during operation!

A PLUG may only be removed or inserted when the device is turned off.
The device checks whether or not a PLUG is present at one second intervals. If it is detected 
that the PLUG was removed, there is a restart. If a valid KEY-PLUG was inserted in the 
device, the device changes to a defined error state following the restart.

If the device was configured at some time with a PLUG, the device can no longer be used 
without this PLUG. To be able to use the device again, reset the device to the factory settings.

 

 Note
Incompatibility with previous versions with PLUG inserted

During the installation of a previous version, the configuration data can be lost. In this case, 
the device starts up with the factory settings after the firmware has been installed. In this 
situation, if a PLUG is inserted in the device, following the restart, this has the status "NOT 
ACCEPTED" since the PLUG still has the configuration data of the previous more up-to-date 
firmware. This allows you to return to the previous, more up-to-date firmware without any loss 
of configuration data. 

If the original configuration on the PLUG is no longer required, the PLUG can be deleted or 
rewritten manually using "System > PLUG".

 

Information about the license of the KEY-PLUG
A C-PLUG can only store the configuration of a device. In addition to the configuration, a KEY-
PLUG also contains a license that enables certain functions of your SIMATIC NET device.
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This page provides detailed information about the license on the KEY-PLUG. In this example, 
the KEY-PLUG contains the data for enabling the layer 3 functions of the device.

Displayed values
● Status

Shows the status of the KEY-PLUG. The following are possible:

– ACCEPTED
The KEY-PLUG in the device contains a suitable and valid license.

– NOT ACCEPTED
The license of the inserted KEY-PLUG is not valid.

– NOT PRESENT
No KEY-PLUG is inserted in the device.

– MISSING
There is no KEY-PLUG or a C-PLUG with the status "FACTORY" inserted in the device. 
Functions are configured on the device for which a license is required.

– WRONG
The inserted KEY-PLUG is not suitable for the device.

– UNKNOWN
Unknown content of the KEY-PLUG.

– DEFECTIVE
The content of the KEY-PLUG contains errors.

● Order ID
Shows the order number of the KEY-PLUG. The KEY-PLUG is available for various 
functional enhancements and for various target systems.

● Serial Number
Shows the serial number of the KEY-PLUG.

● Info String
Shows additional information about the device that used the KEY-PLUG previously, for 
example, order number, type designation, and the versions of the hardware and software. 
The displayed software version corresponds to the version in which the configuration was 
last changed. With the "NOT ACCEPTED" status, further information on the cause of the 
problem is displayed. 

 

 Note

When you save the configuration, the information about whether or not a KEY-PLUG was 
inserted in the device at the time is also saved. This configuration can then only work if a 
KEY-PLUG with the same order number / license is inserted.
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Ping

Reachability of an address in an IP network
 

 Note

The page is only available if there is an online connection to the device.
 

With the ping function, you can check whether a certain IP address is reachable in the network.

Settings
The table has the following columns:

● IP Address
Enter the IP address of the device.

● Repeat
Enter the number of ping requests.

● Ping
Click this button to start the ping function.

● Ping Output
This box shows the output of the ping function.

PoE

General
On this page, you specify the maximum power for the power sourcing equipment (PSE).

PSE (power sourcing equipment)
The SCALANCE X-500 represents a PSE (Power Sourcing Equipment).

With a SCALANCE XM400, you can use the "Power over Ethernet" function via the port 
extender PE408PoE. Each group of four ports with PoE capability is known as a PSE. The 
numbering of the PSEs is fixed and does not change with the number of plugged-in PoE port 
extenders or the slot. A maximum of 4 PSEs are possible.

Setting
● PSE

Shows the number of the PoE power supply.

● Maximum Power
Maximum power that a PSE provides to supply PoE devices.

● Allocated Power
Sum of the power reserved by the PoE devices according to the "Classification".
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● Used power
Sum of the power used by the end devices.

● Usage Threshold [%]
When the power being used by the end devices exceeds the percentage shown here, an 
event is triggered.

Port

Settings for the ports
For each individual PoE port, you can specify whether or not the power will be supplied via 
Ethernet. You can also set a priority for each connected powered device (PD). Devices for 
which a high priority was set, take preference over other devices for the power supply.

Settings
The table has the following columns:

● Port
Shows the configurable PoE ports.
The port is made up of the port number and the slot number, for example port 0.1 is slot 0, 
port 1.

● Setting
Enable the PoE power supply for this port or interrupt it.

● Priority
Select which priority this port will have for the power supply.
The following settings are possible, in ascending order of relevance:

– low
low priority

– high
medium priority

– critical
high priority

If the same priority is set for two ports, the port with the lower port number will be preferred 
when necessary.

● Type
Here, you can enter a string to describe the connected device in greater detail. 

● Classification
The classification specifies the class of the device. From this, it is possible to recognize the 
maximum power of the device.
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● Status
Shows the current status of the port.
The following states are possible:

– disabled
The PoE power supply is deactivated for this port.

– delivering
The PoE power supply is activated for this port and a device is connected.

– searching
The PoE power supply is activated for this port but there is no device connected.

 

  Note

If a device is connected to a port with PoE capability, a check is made to determine whether 
the power of the port is adequate for the connected device. If the power of the port is 
inadequate, although PoE is enabled in "Setting", the port nevertheless has the status 
"disabled". This means that the port was disabled by the PoE power management.

 

● Power [mW]
Shows the power that the SCALANCE provides at this port.

● Voltage [V]
Shows the voltage applied to this port.

● Current [mA]
Shows the current with which a device connected to this port is supplied.

Port diagnostics

Cable tester
 

 Note

The page is only available if there is an online connection to the device.
 

With this page, each individual Ethernet port can run independent fault diagnostics on the 
cable. This test is performed without needing to remove the cable, connect a cable tester and 
install a loopback module at the other end. Short-circuits and cable breaks can be localized to 
within a few meters. 

 

 Note

Please note that this test is permitted only when no data connection is established on the 
port to be tested.
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Settings
● Port

Select the required port from the drop-down list.

● Run Test
Activates error diagnostics. The result is shown in the table.

This table contains the following columns:

● Pair
Shows the wire pair in the cable.

 

  Note
Wire pairs

Wire pairs 4-5 and 7-8 of 10/100 Mbps network cables are not used.

In 1000 Mbps or gigabit Ethernet, all 4 wire pairs are used.

The wire pair assignment - pin assignment is as follows (DIN 50173):

Pair 1 = pin 4-5

Pair 2 = pin 1-2

Pair 3 = pin 3-6

Pair 4 = pin 7-8
 

● Status
Displays the status of the cable.

● Distance [m]
Displays the distance to the cable end, cable break, or short-circuit.

SFP diagnostics
On this page, you run independent error diagnostics for each individual SFP port. This test is 
performed without needing to remove the cable, connect a cable tester or install a loopback 
module at the other end.

 

 Note

Please note that this test is permitted only when no data connection is established on the 
port to be tested.

If, however, there is a data connection to the port to be tested, this is briefly interrupted.

Automatic re-establishment of the connection can fail and then needs to be done manually. 
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Description
The page contains the following boxes:

● Port
Select the required port from the drop-down list.

The values are shown in the following boxes:

● Name
Shows the name of the interface.

● Model
Shows the type of interface.

● Revision
Shows the hardware version of the SFP.

● Serial
Shows the serial number of the SFP.

● Nominal Bit Rate [Mbps]
Shows the nominal bit rate of the interface.

● Max. Link (50.0/125um) [m]
Shows the maximum distance in meters that is possible with this medium.

● Max. Link (62.5/125um) [m]
Shows the maximum distance in meters that is possible with this medium.

The following table shows the values of the SFP transceiver used in this port:

● Temperature [°C]
Shows the temperature of the interface.

● Voltage [V]
Shows the voltage applied to the interface [V].

● Current [mA]
Shows the current consumption of the interface [mA].

● RX Power [mW]
Shows the receive power of the interface [mW].

● Tx Power [mW]
Shows the transmit power of the interface [mW].

● Current
Shows the current value.

● Low
Shows the lowest value.

● High
Shows the highest value.
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Layer 2

Configuration
The functions of layer 2 are configured on this page. With some functions, there are further 
configuration pages on which more detailed settings can be made. You can also check the 
settings on the configuration pages.

Settings
● Protocol Based VLAN

Enable or disable protocol-based VLAN. You can configure other settings in "Layer 2 > 
VLAN".

● Subnet Based VLAN
Enable or disable subnet-based VLAN. You can configure other settings in "Layer 2 > 
VLAN".

● Dynamic MAC Aging
Enable or disable the "Aging" mechanism. You can configure other settings in "Layer 2 > 
Dynamic MAC Aging".

● Redundancy Type
The following settings are available:

– "-" (disabled)
The redundancy function is disabled.

– Ring
Enables ring redundancy. You can configure other settings in "Layer 2 > Ring 
Redundancy > Ring".

– Spanning Tree
If you select this option, you specify the required redundancy mode in "Redundancy 
Mode".
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● Redundancy Mode
If you select "Spanning Tree" for the "Redundancy Type", the following options are then 
available:

– STP
Enables the Spanning Tree Protocol (STP). Typical reconfiguration times with spanning 
tree are between 20 and 30 seconds. You can configure other settings in "Layer 2 > 
Spanning Tree".

– RSTP 
Enables the Rapid Spanning Tree Protocol (RSTP). If a spanning tree frame is detected 
at a port, this port reverts from RSTP to spanning tree. You can configure other settings 
in "Layer 2 > Spanning Tree".

 

  Note

When using RSTP (Rapid Spanning Tree Protocol), loops involving duplication of 
frames or frames being overtaken may occur briefly. If this is not acceptable in your 
particular application, use the slower standard spanning tree mechanism.

 

– MSTP
Enables the Multiple Spanning Tree Protocol (MSTP). You can configure other settings 
in "Layer 2 > Spanning Tree".

If you select "Ring" for the "Redundancy Type", the following options are then available:

– Automatic Redundancy Detection
Select this setting to create an automatic configuration of the redundancy mode. In this 
mode, the device automatically detects whether or not there is a device with the "HRP 
Manager" role in the ring. If this is the case, the device adopts the role of "HRP Client". 
If no HRP manager is found, all devices with the "Automatic Redundancy Detection" or 
"MRP Auto Manager" setting negotiate among themselves to establish which device 
adopts the role of "MRP Manager". The device with the lowest MAC address will always 
become "MRP Manager".  The other devices automatically set themselves to 
redundancy type "MRP Client".

– MRP Auto-Manager
Automatic media redundancy manager

– MRP Client
Media redundancy client

– HRP Client
High Speed Redundancy Protocol client

– HRP Manager
High Speed Redundancy Protocol manager

● Standby
Enable or disable the "Standby redundancy" function. You can configure other settings in 
"Layer 2 > Ring Redundancy > Standby".

● Passive Listening
Enable or disable the "passive listening" function. 
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● RMON
If you select this check box, Remote Monitoring (RMON) allows diagnostics data to be 
collected on the device, prepared and read out using SNMP by a network management 
station that also supports RMON. This diagnostic data, for example port-related load trends, 
allow problems in the network to be detected early and eliminated.

● Dynamic Multicast
The following settings are possible:

– "-" (disabled)

– IGMP Snooping
Enables IGMP (Internet Group Management Protocol). You can configure other settings 
in "Layer 2 > Multicast > IGMP".

– GMRP
Enables GMRP (GARP Multicast Registration Protocol). You can configure other 
settings in "Layer 2 > Multicast > GMRP".

 

  Note

GMRP and IGMP cannot operate at the same time.
 

● GVRP
Enable or disable "GVRP" (GARP VLAN Registration Protocol). You can configure other 
settings in "Layer 2 > VLAN > GVRP".

● Mirroring
Enable or disable port mirroring. You can configure other settings in "Layer 2 > Mirroring > 
Port".

● Loop Detection
Enable or disable loop detection. You can configure other settings in "Layer 2 > Loop 
Detection".

● PTP
Specify how the device will process PTP messages. You can configure other settings in 
"Layer 2 > PTP".

– Off
The device does not process any PTP messages. PTP messages are, however, 
forwarded according to the rules of the switch.

– transparent
The device adopts the function of a transparent clock and forwards PTP messages to 
other nodes while at the same time making entries in the correction field of the PTP 
message.

QoS

CoS map
On this page, CoS priorities are assigned to certain queues (traffic queues).
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Settings 
● CoS

Shows the CoS priority of the incoming packets.

● Queue
Select the forwarding queue (send priority) that is assigned the CoS priority. 
The higher the number of the queue, the higher the send priority. 

DSCP map
On this page, DSCP settings are assigned to various queues (traffic queues).

Settings
● DSCP

Shows the DSCP priority of the incoming packets.

● Queue
Select the forwarding queue (send priority) that is assigned the DSCP value. The higher 
the queue number, the higher the send priority.

Load limitation

Limiting the transfer rate of incoming and outgoing data
On this page, you configure the load limitation (maximum number of data packets per second) 
for the individual ports. You can specify the category of frame for which these limit values will 
apply. 

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports.

● Limit Ingress Unicast (DLF) / Limit Ingress Broadcast / Limit Ingress Multicast
Select the required setting.

– enabled: Enables the function.

– disabled: Disables the function

– No Change: The setting in table 2 remains unchanged

● Total Ingress Rate [pkts/s]
Specify the maximum number of incoming packets processed by the device. If "No Change" 
is entered, the entry in table 2 remains unchanged.
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● Egress Rate [Kb/s]
Specify the data rate for all outgoing frames. If "No Change" is entered, the entry in table 
2 remains unchanged

● Transfer to table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the port to which the settings relate. 

● Limit Ingress Unicast (DLF) 
Enable or disable the data rate for limiting incoming unicast frames with an unresolvable 
address (Destination lookup failure).

● Limit Ingress Broadcast
Enable or disable the data rate for limiting incoming broadcast frames.

● Limit Ingress Multicast
Enable or disable the data rate for limiting incoming multicast frames.

● Total Ingress Rate [pkts/s]
Specify the maximum number of incoming packets processed by the device.

● Egress Rate [Kb/s]

● Specify the data rate for all outgoing frames.
 

  Note
Rounding of the values, deviation from desired value

When you enter the values for transmission rates, note that the WBM rounds to correct 
values.

If values are configured for total ingress transmission rate and egress transmission rate, 
the actual values in operation can exceed or fall below the set values by 10%.

 

VLAN

General
On this page, you define the VLAN and specify the use of the ports.

 

 Note
Changing the "Agent VLAN ID"

If the configuration PC is connected directly to the device via Ethernet and you change the 
"agent VLAN ID", the device is no longer reachable via Ethernet following the change.
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Important rules for VLANs
Make sure you keep to the following rules when configuring and operating your VLANs:

● Frames with the VLAN ID "0" are handled as untagged frames but retain their priority value.

● As default, all ports on the device send frames without a VLAN tag to ensure that the end 
node can receive these frames. 

● With SCALANCE X devices, the VLAN ID "1" is the default on all ports.

● If an end node is connected to a port, outgoing frames should be sent without a tag (static 
access port). If, however, there is a further switch at this port, the frame should have a tag 
added (trunk port).

● With a trunk port, the VLAN assignment is dynamic. Static configurations can only be 
created if, in addition to the trunk port property, the port is also entered statically as a 
member in the VLANs involved. An example of a static configuration is the assignment of 
the multicast groups in certain VLANs.

Settings
● VLAN ID

Enter the VLAN ID. 

The table has the following columns:

● VLAN ID
Shows the VLAN ID. The VLAN ID is assigned once when you create a new data record 
and can then no longer be changed. To make a change, the entire data record must be 
deleted and created again. 

● Name
Enter a name for the VLAN. The name only provides information and has no effect on the 
configuration.
The VLAN name can be a maximum of 32 characters long.
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● Status
Shows the status of the entry. Here, static means that the address was entered as a static 
address by the user. The entry GVRP means that the configuration was registered by a 
GVRP frame. This is, however, only possible if GVRP was enabled for the device.

● List of ports
Specify the use of the port. The following options are available:

– "-"

– The port is not a member of the specified VLAN.
With a new definition, all ports have the identifier "-".

– M
The port is a member of the VLAN. Frames sent in this VLAN are forwarded with the 
corresponding VLAN tag.

– R
The port is a member of the VLAN. A GVRP frame is used for the registration.

– U (upper case)
The port is an untagged member of the VLAN. Frames sent in this VLAN are forwarded 
without the VLAN tag. Frames without a VLAN tag are sent from this port.

– u (lower case)
The port is an untagged member of the VLAN, but the VLAN is not configured as a port 
VLAN. Frames sent in this VLAN are forwarded without the VLAN tag.

– F
The port is not a member of the specified VLAN and it is not possible for the VLAN to 
be registered dynamically at this port using GVRP. You can configure other settings in 
"Layer 2 > VLAN > Port-based VLAN".

GVRP

Configuration of GVRP functionality
Using GVRP frame, a different device can register at the port of the device for a specific VID. 
A different device, can, for example be an end device or a switch. The device can also send 
GVRP frames via this port. 

Settings
● GVRP

Enable or disable the "GVRP" function.

Table 1 has the following columns:
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● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the setting. You have the following setting options:

– enabled
Enables the sending of GVRP frames.

– disabled
Disables the sending of GVRP frames.

– No Change
No change in table 2.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2. If you have selected 
"No Change", the content of table 2 will not be changed.

Table 2 has the following columns:

● Port
Shows the available ports. 

● Setting
Enable or disable the sending GVRP frames.

Port-based VLAN

Processing received frames
On this page, you specify the configuration of the port properties for receiving frames.

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports.

● Priority / Port VID / Acceptable Frames / Ingress Filtering
Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:
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● Port
Shows the available ports and link aggregations. 

● Priority
Select the priority assigned to untagged frames.    
The CoS priority (Class of Service) used in the VLAN tag. If a frame is received without a 
tag, it will be assigned this priority. This priority specifies how the frame is further processed 
compared with other frames.
There are a total of eight priorities with values 0 to 7, where 7 represents the highest priority 
(IEEE 802.1p Port Priority). 

● Port VID
Select the VLAN ID. Only VLAN IDs defined on the "VLAN > General" page can be selected.
If a received frame does not have a VLAN tag, it has a tag with the VLAN ID specified here 
added to it and is sent according to the rules at the port.  

● Acceptable Frames
Specify which types of frames will be accepted. The following alternatives are possible:

– Tagged Frames Only
The device discards all untagged frames. Otherwise, the forwarding rules apply 
according to the configuration.

– All
The device forwards all frames

● Ingress Filtering
Specify whether the VID of received frames is evaluated. 
The following options are available:

– enabled
The VLAN ID of received frames decides whether they are forwarded: To forward a 
VLAN tagged frame, the receiving port must be a member in the same VLAN. Frames 
from unknown VLANs are discarded at the receiving port.

– disabled
All frames are forwarded.

Protocol-based VLAN group
On this page, you specify groups to which a protocol will be assigned.
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Settings
● Protocol Based VLAN

Enable or disable the protocol-based VLAN assignment.

● Protocol Value
Enter the hexadecimal protocol value. 
A few examples are shown below:

– PROFINET: 88:92

– IP: 08:00

– Novell: 81:37

– netbios: f0:f0

– appletalk: 80:9b

● Group ID
Enter the ID of the group.

The table has the following columns:

● Protocol Value
Shows the file value.

● Group ID
Shows the group ID.

Protocol-based VLAN port
On this page, you specify which protocol and which VLAN is assigned to the individual port.

Settings
● Port

Select the required port. All available ports and the link aggregations can be selected.

● Group ID
Select the group ID from the drop-down list. Specify the ID in "Layer 2 > VLAN > Protocol 
Based VLAN Group".

The table has the following columns:

● Port
All available ports and the link aggregations are shown.

● Group ID
Shows the group ID assigned to the port.

● VLAN ID
Select the required VLAN ID to be assigned to the port.

IPv4 subnet-based VLAN
On this page, you specify which VLAN ID is assigned to the subnet.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
924 System Manual, 02/2014



Settings
● Subnet Based VLAN

Enable or disable the subnet-based VLAN assignment

● Port
Select the port. All available ports and the link aggregations can be selected.

● Subnet Address
Enter the IP address of the subnet. 
Example: 192.168.10.0 for the network 192.168.10.x with nodes 192.168.10.1 to 
192.168.10.254.

● Subnet Mask
Enter the subnet mask.

The table has the following columns:

● Port
All available ports and the link aggregations are shown.

● Subnet Address
Shows the subnet assigned to the port.

● Subnet Mask
Shows the subnet mask.

● VLAN ID
Select the VLAN ID you want to assign to the port or the subnet.

Mirroring

Basics

Mirroring
The device provides the option of simultaneously channeling incoming or outgoing data 
streams via other interfaces for analysis or monitoring. This has no effect on the monitored 
data streams. This procedure is known as mirroring. In this menu section, you enable or disable 
mirroring and set the parameters.

Mirroring ports
Mirroring a port means that the data traffic at a port (mirrored port) of the IE switch is copied 
to another port (monitor port). You can mirror one or more ports to a monitor port.   

If a protocol analyzer is connected to the monitor port, the data traffic at the mirrored port can 
be recorded without interrupting the connection. This means that the data traffic can be 
investigated without being affected. This is possible only if a free port is available on the device 
as the monitor port. 
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General
On this page, you can enable or disable the mirroring function and make the basic settings.

 

 Note

If the maximum data rate of the mirrored port is higher than that of the monitor port, data may 
be lost and the monitor port no longer reflects the data traffic at the mirrored port. Several 
ports can be mirrored to one monitor port at the same time.

Mirroring a port does not work beyond switch core boundaries.

Disable port mirroring if you want to connect a normal end device to the monitor port.
 

Settings
● Mirroring

Enable or disable mirroring of the data traffic.

● Monitor Barrier
Enable or disable the option to restrict communication via the monitor port.

 

  Note
Monitor Barrier

If you enable the monitor barrier, the data traffic on the destination port is automatically 
blocked (broadcast, multicast, unicast, DCP forwarding, LLDP) so that only the mirrored 
traffic is present. To be able to allow other data traffic again, you need to configure this. 
The previous statuses of these options are not restored after stopping the monitor barrier 
and must be reconfigured.

 

– enabled
The monitor port is taken out of normal frame switching.

– disabled
Communication via the monitor port is unrestricted.

This table has the following columns:
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● Session ID
Enable or disable listening in on incoming packets at the required port.

● Session Type
Specify which data traffic is mirrored. The following options are available:

– '-'
None

– Port Based
Port-based mirroring You can configure other settings in "Layer 2 > Mirroring > Port".

– VLAN
VLAN-based mirroring. You can configure other settings in "Layer 2 > Mirroring > VLAN".

– MAC ACL
Mirroring of the MAC Access Control List. You can configure other settings in "Layer 2 
> Mirroring > MAC Flow".

– IP ACL
Mirroring of the IP Access Control List. You can configure other settings in "Layer 2 > 
Mirroring > IP Flow".

● Status
Shows whether or not mirroring is active.

● Dest. Port
Select the destination port to be mirrored to in this session.

Port

Mirroring ports
You can only configure the settings on this page if you have already generated a session ID 
with the session type "Port Based" on the "General" tab.

Settings 
● Session ID

Select the session ID. Only session IDs of the session type "Port Based" are available. 

The table has the following columns:

● Port
Shows the port to be monitored.

● Ingress Mirroring
Enable or disable mirroring of incoming packets at the required port.

● Egress Mirroring
Enable or disable mirroring of outgoing packets at the required port.
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VLAN

VLAN sources of the port mirroring function
You can only configure the settings on this page if you have already generated a session ID 
with the session type "VLAN" on the "General" tab.

On this page, you specify the VLAN whose incoming data traffic will be mirrored to the monitor 
port.

Settings
● Session ID

Select the session ID. Only session IDs of the session type "VLAN" are available.

● VLAN ID
Enter a VLAN ID. The VLAN ID can only be assigned once when you create a new data 
record and can then no longer be changed. To make a change, the entire data record must 
be deleted and created again.

The table has the following columns:

● VLAN ID
Shows the VLAN ID.

MAC Flow
You can only configure the settings on this page if you have already generated a session ID 
with the session type "MAC ACL" on the "General" tab.

The MAC ACL filter decides which data is available at the monitor port. 

Settings
● Session ID

Select the session ID. Only session IDs of the session type "MAC ACL" are available.

The table has the following columns:

● ACL Filter Number
Shows the number of the ACL filter. You configure the MAC ACL filter in "SecurityPort ACL 
MAC".

● Ingress Mirroring
Shows whether incoming packets are mirrored.

 

  Note
Rules

A rule selected for ingress mirroring only becomes active if it was configured as a port 
ingress rule on at least one port. You configure the port ingress rules in "Security> Port 
MAC IP > Port Ingress Rules".
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● Source MAC
Shows the MAC address of the sender.

● Dest. MAC
Shows the MAC address of the recipient.

● Ingress Port
Shows a list of all ports to which this rule applies.

● Egress Port
Shows a list of all ports to which this rule applies.

IP Flow
You can only configure the settings on this page if you have already generated a session ID 
with the session type "IP ACL" on the "General" tab.

The IP ACL filter decides which data is mirrored to the monitor port.

Settings
● Session ID

Select the session ID. Only session IDs of the session type "IP ACL" are available.

The table has the following columns:

● ACL Filter Number
Shows the number of the ACL filter. You configure the IP ACL filter in "Security > Port ACL 
IP".

● Ingress Mirroring
Shows whether incoming packets are mirrored.

 

  Note
Rules

A rule selected for ingress mirroring only becomes active if it was configured as a port 
ingress rule on at least one port. You configure the port ingress rules in "Security> Port 
ACL IP > Port Ingress Rules".

 

● Source IP
Shows the IP address of the sender.

● Source Subnet Mask
Shows the subnet mask of the sender.

● Dest. IP
Shows the IP address of the recipient.

● Dest. Subnet Mask
Shows the subnet mask of the recipient.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

● Egress Port
Shows a list of all egress ports to which this rule applies.
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Dynamic MAC Aging
The device automatically learns the source addresses of the connected nodes.

This information is used to forward data frames to the nodes specifically involved. The network 
load for the other nodes is reduced.
If a device does not receive a frame whose source address matches a learnt address within 
a certain time, the learnt address is deleted. This mechanism is known as aging. Aging prevents 
frames being forwarded incorrectly, for example when an end device (for example a 
programming device) is connected to a different port. If the check box is not enabled, a device 
does not delete learned addresses automatically.

Settings
● Dynamic MAC Aging

Enable or disable the function for automatic aging of learned MAC addresses:

● Aging Time [s]
Enter the time in seconds. After this time, a learned address is deleted if the device does 
not receive any further frames from this sender address.

Ring Redundancy

Ring
On this page, you can select the required mode for fast ring redundancy. The "Automatic 
Redundancy Detection" ring redundancy mode is the default when the device ships.

 

 Note

 The ring redundancy cannot be enabled if Spanning Tree is still enabled on the device.
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Settings
● Ring Redundancy

Enable or disable ring redundancy.

● Ring redundancy mode
Specify the ring redundancy mode. The following options are available:

– "-" (disabled)
The redundancy function is disabled.

– Automatic Redundancy Detection
Select this setting to create an automatic configuration of the redundancy mode. In this 
mode, the device automatically detects whether or not there is a device with the "HRP 
Manager" role in the ring. If this is the case, the device adopts the role of "HRP Client". 
If no HRP manager is found, all devices with the "Automatic Redundancy Detection" or 
"MRP Auto Manager" setting negotiate among themselves to establish which device 
adopts the role of "MRP Manager". The device with the lowest MAC address will always 
become "MRP Manager".  The other devices automatically set themselves to 
redundancy mode "MRP Client".

– MRP Auto Manager
Devices with the setting "Automatic Redundancy Detection" or "MRP Auto Manager" 
negotiate among themselves which device will adopt the "MRP Manager" role. The 
device with the lowest MAC address will always become "MRP Manager". In contrast 
to the setting "Automatic Redundancy Detection", the devices are not capable of 
detecting whether or not an HRP manager is in the ring. This means that they never 
adopt the role of HRP client.

– MRP Client
In a ring whose devices are configured with MRP, at least one device must be set to the 
"Automatic Redundancy Detection" or "MRP Auto Manager" mode. You can set the 
"MRP Client" role for all other devices. If all devices except one are configured as "MRP 
Client", this one device automatically adopts the role of "MRP Manager".
Select "MRP Client" mode if you want to operate the device along with components that 
do not originate from Siemens in the ring.

– HRP Client
Here, you can select the role "HRP Client".

– HRP Manager
When you configure an HRP ring, one device must be set as HRP manager. All other 
devices must be configured as HRP clients.

● Ring ports
Specify the ports to be used as ring ports in media redundancy in ring topologies.
The ring port you select in the upper drop-down menu is the "Isolated Port" in HRP.

 

  Note

If you restore the factory defaults, the default redundancy mode "Automatic Redundancy 
Detection" becomes active.

The ring port configuration is also reset to the factory default ports. If other ports were 
used previously as ring ports, with the appropriate attachment, a previously correctly 
configured device can cause circulating frames and therefore the failure of the data traffic.
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● Observer
Enable or disable the observer. The "Observer" function is only available in HRP rings.
The ring port selected in the upper drop-down menu is connected to the "Isolated Port" of 
an HRP manager.
The observer monitors malfunctions of the redundancy manager or incorrect configurations 
of an HRP ring.
If the observer is enabled, it can interrupt the connected ring if errors are detected. To do 
this, the observer switches a ring port to the "blocking" status. When the error is resolved, 
the observer enables the port again.

● Restart  Observer (only available online)
If numerous errors occur in quick succession, the observer no longer enables its port 
automatically. The ring port remains permanently in the "blocking" status. This is signaled 
by the error LED and a message text.
After the errors have been eliminated, you can enable the port again using the "Restart 
Observer" button. 

Standby

Standby manager   
The standby manager allows the redundant linking of two HRP rings. To do this, two 
neighboring devices within a ring must be configured as standby partners. Enable the standby 
manager for both standby partners and select the port via which the device is connected to 
the ring you want to link to. For the "Standby Connection Name", a name unique within the 
ring must be assigned for both partners. This identifies the two modules as standby partners 
that belong together. 

 

 Note

To be able to use the function, HRP must be activated.
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Settings 
● Standby

Enable or disable the standby manager.
 

  Note

If two devices are linked by the standby function, the "Standby" function must be enabled 
on both devices.

 

  Note

The standby manager always requires an activated HRP client.
 

● Standby Connection Name
Enter the name for the standby connection. This name defines the master/slave device 
pair. Both must be located in the same ring. This is achieved by entering the same name 
on two devices in the ring.

 

  Note

Make sure that the standby name (for one pair of devices) is used only once in the network.
 

● Force device to standby master
When selected, the device is configured as standby master regardless of its MAC address. 

– If the setting is enabled for neither of the two devices for which the standby function is 
enabled, then assuming that no error has occurred, the device with the higher MAC 
address adopts the role of standby master.

– If the setting is enabled for both devices or if the setting is only supported by one device, 
the standby master is also selected based on the MAC address.  

This type of assignment is important in particular when a device is replaced. Depending on 
the MAC addresses, the previous device with the slave function can take over the role of 
the standby master.

This table has the following columns:

● Port
Shows the port to which the setting relates.

● Setting
Here, you specify which ports are standby ports. The standby ports are involved in the 
redirection of data traffic. 
If there are no problems, only the standby ports of the master are enabled and handle to 
the data traffic into the connected HRP rings (buses). If the master or the Ethernet 
connection (link) of one of the standby ports of the master fails, all standby ports of the 
master will be disabled and the standby ports of the slave enabled. As a result, a functioning 
Ethernet connection to the connected network segments (HRP rings/linear buses) is 
restored.
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Spanning Tree

General

General settings of MSTP
On this page, you configure the settings for MSTP. As default, Rapid Spanning Tree is enabled 
that can be set to the MSTP, RSTP or STP compatible mode with a switch.

On the configuration pages of these functions, you can make detailed settings.

Depending on the compatibility mode, you can configure the corresponding function on the 
relevant configuration page.

Settings
● Spanning Tree

Enable or disable Spanning Tree.

● Protocol Compatibility
Select the compatibility mode of Spanning Tree. If, for example, you select RSTP, Spanning 
Tree behaves like RSTP.
The following settings are available:

– STP

– RSTP

– MSTP

Using a link aggregation in an MSTP instance
If you want to use a link aggregation in an MSTP instance, follow the steps below during 
configuration:

1. Create a link aggregation in "Layer 2" > "Link aggregation (Page 944)".

2. Create an MSTP instance in "Layer 2" > "Spanning Tree" > "MST General (Page 939)".

3. Configure the link aggregation in "Layer 2" > "Spanning Tree" > "MST port (Page 940)".

Automatic activation of MRP in redundant topologies
If you connect SCALANCE X switches with redundant network structures in the topology view, 
MRP is activated automatically on the switches involved.

If there is an existing configuration with other redundancy mechanisms, such as MSTP, this 
is automatically deactivated.

CIST general
On this page, you configure CIST.
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Settings
● Bridge Priority / Root Priority (only available online)

Which device becomes the root bridge is decided based on the bridge priority. The bridge 
with the highest priority becomes the root bridge. The lower the value, the higher the priority. 
If several devices in a network have the same priority, the device whose MAC address has 
the lowest numeric value will become the root bridge. Both parameters, bridge priority and 
MAC address together form the bridge identifier. Since the root bridge manages all path 
changes, it should be located as centrally as possible due to the delay of the frames. 

● Bridge Address / Root Address(only available online)
The bridge address shows the MAC address of the device and the root address shows the 
MAC address of the root bridge.

● Root Port  (only available online)
Shows the port via which the switch communicates with the root bridge.

● Root Cost (only available online)
The path costs from this device to the root bridge.
In MSTP mode, path costs up to the root bridge are shown.

● Topology Changes / Last Topology Change (only available online)
The entry for the device shows the number of reconfigurations due to the spanning tree 
mechanism since the last startup. For the root bridge, the time since the last reconfiguration 
is displayed as follows:

– Seconds: sec unit after the number

– Minutes: min unit after the number

– Hour: hr unit after the number

● Bridge Hello Time / Root Hello Time  (only available online)
Each bridge regularly sends configuration frames (BPDUs). The interval between two such 
frames is the Hello time. The default for this parameter is 2 seconds.

● Bridge Forward Delay / Root Forward Delay
New configuration data is not used immediately by a bridge but only after the period 
specified in the parameter. This ensures that operation is only started with the new topology 
after all the bridges have the required information. 

● Bridge Max Age / Root Max Age  (only available online)
Bridge Max Age defines the maximum "age" of a received BPDU for it to be accepted as 
valid by the switch.

● Bridge Max Hop Count
This parameter specifies how many MSTP nodes a BPDU may pass through. If an MSTP 
BPDU is received and has a "Bridge Max Hop Count" that exceeds the value configured 
here, it is discarded. 

● Regional root priority  (only available online)
For a description, see Bridge Priority / Root Priority

● Regional root address (only available online)
The MAC address of the device.

● Regional root costs (only available online)
Shows the path costs from this device to the regional root bridge.
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● Region Name
Enter the name of the MSTP region to which this device belongs. As default, the MAC 
address of the device is entered here. This value must be the same on all devices that 
belong to the same MSTP region.

● Region Version
Enter the version number of the MSTP region in which the device is located. This value 
must be the same on all devices that belong to the same MSTP region.

● Reset Counter (only available online)
Click this button to reset the counters on this page to zero.

CIST port

MSTP-CIST port configuration
When the page is called, the table displays the current status of the configuration of the port 
parameters.

To configure them, click the relevant cells in the port table.

Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● MSTP Status
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports. 

● MSTP Status
Specify whether or not the port is integrated in the spanning tree.

 

  Note

If you disable the "MSTP Status" option for a port, this may cause the formation of loops. 
The topology must be kept in mind.

 

● Priority
Enter the priority of the port. The priority is only evaluated when the path costs are the same.
The value must be divisible by 16. If the value that cannot be divided by 16, the value is 
automatically adapted.

● Cost Calc.
Enter the path cost calculation. If you enter the value "0" here, the automatically calculated 
value is displayed in the "Path Costs" box.
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● Path Costs (only available online)
This parameter is used to calculate the path that will be selected. The path with the lowest 
value is selected as the path. If several ports of a device have the same value for the path 
costs, the port with the lowest port number is selected.
If the value for "Cost Calc." is "0", the automatically calculated value is displayed. Otherwise, 
the value of the "Cost Calc." box is displayed. The calculation of the path costs is largely 
based on the transmission speed. The higher the achievable transmission speed is, the 
lower the value of the path costs.
Typical values for path costs with rapid spanning tree:

– 10,000 Mbps = 2,000

– 1000 Mbps = 20,000

– 100 Mbps = 200,000

– 10 Mbps = 2,000,000

The values can, however, also be set individually.

● Status (only available online)
Displays the current status of the port. The values are only displayed and cannot be 
configured. The "Status" parameter depends on the configured protocol. The following is 
possible for status:

– Disabled

The port only receives and is not involved in STP, MSTP and RSTP.

– Discarding
In the "Discarding" mode, BPDU frames are received. Other incoming or outgoing 
frames are discarded.

– Listening

In this status, BPDUs are both received and sent. The port is involved in the spanning 
tree algorithm.

– Learning

Stage prior to the forwarding status, the port is actively learning the topology (in other 
words, the node addresses).

– Forwarding

Following the reconfiguration time, the port is active in the network; it receives and 
forwards data frames.
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● Fwd. Trans (only available online)
Specifies the number of changes from the "Discarding" status to the "Forwarding" status

● Edge type
Specify the type of edge port. You have the following options:

– "-"
Edge port is disabled. The port is treated as a "no edge port".

– Admin
Select this option when there is always an end device on this port. Otherwise a 
reconfiguration of the network will be triggered each time a connection is changed.

– Auto
Select this option if you want a connected end device to be detected automatically at 
this port. When the connection is established the first time, the port is treated as a "no 
Edge Port".

– Admin/Auto
Select these options if you operate a combination of both on this port. When the 
connection is established the first time, the port is treated as an Edge Port.

● Edge (only available online)
Shows the status of the port.

– Enabled

An edge port is connected to this port.

– Disabled
There is a spanning tree or rapid spanning tree device at this port.

With an end device, a switch can change over the port faster without taking into account 
spanning tree frames. If a spanning tree frame is received despite this setting, the port 
automatically changes to the "Disabled" setting for switches.
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● P.t.P. Type
Select the required option. The selection depends on the port that is set.

– "-"
Point to point is calculated automatically. If the port is set to half duplex, a point-to-point 
link is not assumed.

– P.t.P.

Even with half duplex, a point-to-point link is assumed.

– Shared Media

Even with a full duplex connection, a point-to-point link is not assumed.
 

  Note

Point-to-point connection means a direct connection between two devices. A shared 
media connection is, for example, a connection to a hub.

 

● Hello Time
Enter the interval after which the bridge sends configuration BPDUs

 

  Note

The port-specific setting of the Hello time is only possible in MSTP compatible mode.
 

MST General

Multiple Spanning Tree configuration
With MSTP, in addition to RSTP, several VLANs can be managed in a LAN with separate 
RSTP trees.     

Settings
● MSTP Instance ID

Enter the number of the MSTP instance.

The table has the following columns:

● MSTP Instance ID
Shows the number of the MSTP instance.

● Root Address
Shows the MAC address of the root bridge

● Root Priority
Shows the priority of the root bridge.
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● Bridge Priority
Enter the bridge priority. The value for the bridge priority is a whole multiple of 4096.

● VLAN ID 
Enter the VLAN ID. Here, you can also specify ranges with Start ID, "-", End ID. Several 
ranges or IDs are separated by ",". 

MST port

Configuration of the Multiple Spanning Tree port parameters   
On this page, you set the parameters for the ports of the configured multiple spanning tree 
instances.

Settings
● MSTP Instance ID

Select the ID of the MSTP instance.  

Table 1 has the following columns

● 1st column
Shows that the setting is valid for all ports.

● MSTP Status
Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2

The table has the following columns:

● Port
Shows all available ports and link aggregations.

● MSTP Instance ID 
ID of the MSTP instance.  

● MSTP Status 
Enable or disable MSTP for this port.

● Priority
Enter the priority of the port. The priority is only evaluated when the path costs are the same.
The value must be divisible by 16. If the value that cannot be divided by 16, the value is 
automatically adapted.

● Cost Calc.
Enter the path cost calculation in the input box. If you enter the value "0" here, the 
automatically calculated value is displayed in the next box "Path Costs".
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● Path Costs (only available online)
This parameter is used to calculate the path that will be selected. The path with the lowest 
value is selected as the path. If several ports of a device have the same value for the path 
costs, the port with the lowest port number is selected.
If the value for "Cost Calc." is "0", the automatically calculated value is displayed. Otherwise, 
the value of the "Cost Calc." box is displayed. The calculation of the path costs is largely 
based on the transmission speed. The higher the achievable transmission speed is, the 
lower the value of the path costs.
Typical values for path costs with rapid spanning tree:

– 10,000 Mbps = 2,000

– 1000 Mbps = 20,000

– 100 Mbps = 200,000

– 10 Mbps = 2,000,000

The values can, however, also be set individually.

● Status (only available online)
Displays the current status of the port. The values are only displayed and cannot be 
configured. The "Status" parameter depends on the configured protocol. The following is 
possible for status:

– Disabled

The port only receives and is not involved in STP, MSTP and RSTP.

– Discarding
In the "Discarding" mode, BPDU frames are received. Other incoming or outgoing 
frames are discarded.

– Listening

In this status, BPDUs are both received and sent. The port is involved in the spanning 
tree algorithm.

– Learning

Stage prior to the forwarding status, the port is actively learning the topology (in other 
words, the node addresses).

– Forwarding

Following the reconfiguration time, the port is active in the network; it receives and 
forwards data frames.

● Fwd. Trans (only available online)
Specifies the number of changes from the "Discarding" status to the "Forwarding" status

Enhanced Passive Listening Compatibility

Enabling the function
On this page, you enable the expanded compatibility for passive listening.
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Settings
● Enhanced Passive Listening Compatibility

Enable or disable this function for the entire device.

Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Displays the port of the device.

● Setting

– enabled
Enables the function for all ports of the device.

– disabled
Disables the function for all ports of the device.

Loop detection
With the "Loop Detection" function, you specify the ports for which loop detection will be 
activated. The ports involved send special test frames - the loop detection frames. If these 
frames are sent back to the device, there is a loop.

A "local loop" involving this device means that the frames are received again at a different port 
of the same device. If the sent frames are received again at the same port, there is a "remote 
loop" involving other network components.

 

 Note

A loop is an error in the network structure that needs to be eliminated. The loop detection 
can help to find the errors more quickly but does not eliminate them. The loop detection is 
not suitable for increasing network availability by deliberately including loops.

 

 Note

Note that loop detection is only possible at ports that were not configured as ring ports or 
standby ports.
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Settings 
● Loop Detection

Enable or disable loop detection.

● VLAN Loop Detection
Enable or disable loop detection in a VLAN.

Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2

● Threshold / Remote Reaction / Local Reaction
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table 
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Specify how the port handles loop detection frames. 

 

  Note

Test frames create additional network load. We recommend that you only configure 
individual switches, for example at branch points of the ring, as "sender" and the others 
as "forwarder".

 

– sender
Loop detection frames are sent out and forwarded.

– forwarder
Loop detection frames from other devices are forwarded.

– blocked
The forwarding of loop detection frames is blocked.

● Threshold
Specify the number of received loop detection frames as of which a loop is assumed.

● Remote Reaction
Specify how the port will react if a remote loop occurs. Select one of the two options from 
the drop-down list:

– no action
A loop has no effect on the port.

– disable
The port is blocked.
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● Local Reaction
Specify how the port will react if a local loop occurs. Select one of the two options from the 
drop-down list:

– no action
A loop has no effect on the port.

– disable
The port is blocked

● Status (only available online)
This box shows whether loop detection is enabled or disabled for this port.

● Source Port (only available online)
Shows the output port of the loop detection frame that triggered the last reaction

● Source VLAN (only available online)
Shows the VLAN ID of the loop detection frame that triggered the last reaction. 
This is only possible if "VLAN Support Enabled" was selected earlier on the "Loop Detection 
Configuration" page.

● Reset (only available online)
After a loop in the network has been eliminated, click this button to reset the port again

Link aggregation

Bundling network connections for redundancy and higher bandwidth
A link aggregation according to IEEE 802.3ad allows several connections between neighboring 
devices to be bundled to achieve higher bandwidths and to protect against failure.   

Ports on both partner devices are included in link aggregations and the devices are then 
connected via these ports. To assign ports (in other words links) correctly to a partner device, 
the Link Aggregation Control Protocol (LACP) from the IEEE 802.3ad standard is used. 

Up to 8 link aggregations can be defined. A maximum of 8 ports can be assigned to each link 
aggregation.

You can also use link aggregations within an MSTP instance, see "Layer 2" > "Spanning Tree" 
> "General (Page 934)".

Settings
The table has the following columns:

● Port
Shows the virtual port number of this link aggregation. This identifier is assigned internally 
by the firmware.

● Link Aggregation Name
Enter the name for the link aggregation. This name can be specified by the user during 
configuration. The name is not absolutely necessary but can be useful to distinguish 
between the various link aggregations.

● MAC Address
Shows the MAC address.
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● Status
Enable or disable link aggregation.

● MTU
Specify the packet size.

● LACP

– on
Enables the sending of LACP frames. 

– off
Disables the sending of LACP frames.

● Frame Distribution
Set the type of distribution of packets on the individual links of an aggregation.

– Destination&Source Mac
The distribution is based on a combination of the destination and source MAC address.

– Destination&Source IP-MAC
The distribution is based on a combination of the destination and source IP address and 
MAC address.

● VLAN Mode
Specify how the link aggregation is entered in a VLAN:

– Hybrid
The link aggregation sends tagged and untagged frames. It is not automatically a 
member of a VLAN.

– Trunk
The link aggregation only sends tagged frames and is automatically a member of all 
VLANs.

● Port
Shows the ports that belong to this link aggregation. The following values can be selected 
from the drop-down list:

– "-" (disabled)
Link aggregation is disabled.

– "a" (active)
The port sends LACP frames and is only involved in the link aggregation when LACP 
frames are received.

– "p" (passive) 
The port is only involved in the link aggregation when LACP frames are received.

– "o" (on) 
The port is involved in the link aggregation and does not send any LACP frames.

 

  Note

Within a "link aggregation", only ports with the following configuration are possible:
● all ports with "o"
● all ports with "a" or "p".
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DCP forwarding

Applications
The DCP protocol is used by STEP 7 and the PST Tool for configuration and diagnostics. 
When shipped, DCP is enabled on all ports; in other words, DCP frames are forwarded at all 
ports. With this option, you can disable the sending of these frames for individual ports, for 
example to prevent individual parts of the network from being configured with the PST Tool or 
to divide the full network into smaller parts for configuration and diagnostics.       

Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table 
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports. 

● Setting
Specify whether the port should block or forward outgoing DCP frames. The following 
options are available:

– forward
DCP frames are forwarded via this port.

– block
No outgoing DCP frames are forwarded via this port. It is nevertheless still possible to 
receive via this port.

LLDP

Applications
PROFINET uses the LLDP protocol for topology diagnostics. In the default setting, LLDP is 
enabled for all ports; in other words, LLDP frames are sent and received on all ports. With this 
function, you have the option of enabling or disabling sending and/or receiving per port.
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Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table 
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the port.

● Setting
Specify the LLDP functionality. The following options are available:

– Rx
This port can only receive LLDP frames.

– Tx
This port can only send LLDP frames.

– Rx & Tx
This port can receive and send LLDP frames.

– "-" (disabled)
This port can neither receive nor send LLDP frames.

Unicast

Filter

Address filtering
This page shows the current content of the unicast filter table. This table lists the source 
addresses of unicast address frames. The displayed entries were made statically, in other 
words, the user set them.

On this page, you also define the static unicast filters.

Settings
● VLAN ID

Select the VLAN ID in which you configure a new static MAC address. If nothing is set, 
"VLAN1" is set as the basic setting.

● MAC Address
Enter the MAC address here.

This table contains the following columns:
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● VLAN ID
Shows the VLAN-ID assigned to this MAC address.

● MAC Address
Shows the MAC address of the node that the device has learned or the user has configured.

● Status
Shows the status of each address entry:

– static
Configured by the user. Static addresses are stored permanently; in other words, they 
are not deleted when the aging time expires or when the switch is restarted.

● Port
Shows the port via which the node with the specified address can be reached. Frames 
received by the device whose destination address matches this address will be forwarded 
to this port.

 

  Note

You can only specify one port for unicast addresses.
 

Learning

Starting/stopping learning       
 

 Note

The page is only available if there is an online connection to the device.
 

With the automatic learning function, all connected devices are automatically entered in the 
unicast filter table. As long as the "Start learning" function is enabled, all learned unicast 
addresses are created immediately as static unicast entries. 
The learning process is ended only after clicking the "Stop learning" button. With this method, 
learning can take a few minutes or several hours in larger networks before all nodes have 
really been learned. Only nodes that send packets during the learning phase are found.
By subsequently enabling the Port Lock function, only packets from the nodes known after the 
end of the learning phase (static unicast entries) will be accepted at the relevant ports.

 

 Note

If the Port Lock function was already active on individual ports prior to the automatic learning 
phase, no addresses will be learned on these ports. This makes it possible to restrict learning 
to certain ports. To do this, first enable the Port Lock function of the ports that are not intended 
to learn addresses.
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Settings
● Start learning

Click the "Start learning" button to start the learning phase.
The device now enters the addresses of connected devices until you stop the function.

● Stop learning
Click the "Stop Learning" button to stop the learning phase.
The learned entries are stored.

● Deleting all static unicast addresses
Click the "Clear all static unicast addresses" button to delete all static entries.
In large networks with numerous nodes, automatic learning may lead to a lot of undesired 
static entries. To avoid having to delete these individually, this button can be used to delete 
all static entries. This function is disabled during automatic learning.

 

  Note

Depending on the number of entries involved, deleting may take some time.
 

Locked ports

Activating the access control
On this page, you can block individual ports for unknown nodes. 

If the Port Lock function is enabled, packets arriving at this port from unknown MAC addresses 
are discarded immediately. Packets from known nodes are accepted by the port. 
Since ports with the port lock function enabled cannot learn any MAC addresses, learned 
addresses on these ports are automatically deleted after the port lock function is enabled. 

Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Enable or disable access the port lock function for the port.
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Blocking

Blocking the forwarding of unknown unicast frames
On this page, you can block the forwarding of unknown unicast frames for individual ports.

Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Enable or disable the blocking of unicast frames

 

  Note
Ring redundancy / standby

If ring redundancy or standby is enabled, the ports configured for this are not included in 
the blocking.

 

Multicast

Groups

Multicast applications
In the majority of cases, a frame is sent with a unicast address to a particular recipient. If an 
application sends the same data to several recipients, the amount of data can be reduced by 
sending the data using one multicast address. For some applications, there are fixed multicast 
addresses (NTP, IETF1 Audio, IETF1 Video etc.).     

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
950 System Manual, 02/2014



Reducing network load
In contrast to unicast frames, multicast frames represent a higher load for the device. 
Generally, multicast frames are sent to all ports. There are three ways of reducing the load 
caused by multicast frames:

● Static entry of the addresses in the multicast filter table.

● Dynamic entry of the addresses by listening in on IGMP parameter assignment frames 
(IGMP Configuration).

● Active dynamic assignment of addresses by GMRP frames.

The result of all these methods is that multicast frames are sent only to ports for which an 
appropriate address is entered.

"Multicast" shows the multicast frames currently entered in the filter table and their destination 
ports. The displayed entries were made statically, in other words, the user set them.

Settings
● VLAN ID

Select the VLAN ID to be assigned to the MAC multicast address. 

● MAC Address
Here you enter a new MAC multicast address you want to configure.

The table has the following columns:

● VLAN ID
Shows VLAN ID of the VLAN to which the MAC multicast address is assigned.

● MAC Address
Shows the MAC multicast address that the device has learned or the user has configured.

● Status
Shows the status of each address entry. The following information is possible:

– static
The address was entered statically by the user. Static addresses are stored 
permanently; in other words, they are not deleted when the aging time expires or when 
the device is restarted. These must be deleted by the user.

IGMP

Function
IE switches support "IGMP snooping" and the IGMP querier function. If "IGMP snooping" is 
enabled, IGMP frames are evaluated and the multicast filter table is updated with this 
information. If "IGMP Querier is also enabled, IE switches also send IGMP queries that trigger 
responses from IGMP-compliant nodes.
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IGMP Snooping Aging Time
In this menu, you can configure the aging time for IGMP Configuration. When the time elapses, 
entries created by IGMP are deleted from the address table if they are not updated by a new 
IGMP frame. 

This applies to all ports; a port-specific configuration is not possible.     

IGMP Snooping Aging Time depending on the querier

SCALANCE XR500 as IGMP querier:
If a SCALANCE XR500 is used as an IGMP querier, the query interval is 125 seconds. For 
the "IGMP Snooping Aging Time", set at least 250 seconds.

Other IGMP queriers
If a different IGMP querier is used, the value of the "IGMP Snooping Aging Time" should be 
at least twice as long as the query interval.

Settings
● IGMP Snooping

Enable or disable IGMP (Internet Group Management Protocol). The function allows the 
assignment of IP addresses to multicast groups. If the check box is selected, IGMP entries 
are included in the table and IGMP frames are forwarded.

● IGMP Snooping Aging Time
Enter the value for the aging time in seconds in this box. 

● IGMP Querier
Enable or disable "IGMP Querier". The device sends IGMP queries.

GMRP

Enabling GMRP
By selecting the check box, you specify whether or not GMRP is used for each individual port. 
If "GMRP" is disabled for a port, no registrations are made for it and it cannot send GMRP 
frames.   

Settings
● GMRP

Enable or disable the GMRP function.

Table 1 has the following columns:
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● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the settings are adopted for all ports of table 2. 

Table 2 has the following columns:

● Port
Shows the available ports and the link aggregations.

● Setting

● Enable or disable GMRP for the port or for the link aggregation.

Blocking
On this page, you can block the forwarding of unknown multicast frames for individual ports.

Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the available ports.

● Setting
Enable or disable the blocking of multicast frames.
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Broadcast

Blocking the forwarding of broadcast frames
On this page, you can block the forwarding of broadcast frames for individual ports.   

 

 Note

Some communication protocols work only with the support of broadcast. In these cases, 
blocking can lead to loss of data communication. Block broadcast only when you are sure 
that you do not need it.

 

Settings
Table 1 has the following columns:

● 1st column
Shows that the setting is valid for all ports of table 2.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Transfer to table
If you click the button, the setting is adopted for all ports of table 2. 

Table 2 has the following columns:

● Port
All available ports and the link aggregations are shown.

● Setting
Enable or disable the blocking of broadcast frames.

PTP

General
 

 Note

PTP is only available with SCALANCE X500.
 

The Precision Time Protocol (PTP) complying with IEEE 1588v2 allows the time-of-day 
synchronization of devices connected to the ports of a device. These devices forward the 
synchronization frames through the network using the "Transparent Clock" (TC) mechanism. 
The connection mechanisms "end-to-end" and "peer-to-peer" are supported.

To use IEEE 1588v2, enable this function and configure every port that is on the 
synchronization path as well as ports that are blocked due to redundancy mechanisms. IEEE 
1588v2 can also be used with redundancy mechanisms in the ring such as HRP, standby 
linking of rings, MRP and RSTP.
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Setting
● 1588 Mode

You can make the following settings:

– off
The device does not process any PTP messages. PTP messages are, however, 
forwarded according to the rules of the device.

– transparent
The device adopts the function of a transparent clock and forwards PTP messages to 
other nodes while at the same time making entries in the correction field of the PTP 
message. 

TC general

1588 Transparent Clock
On this page, you specify the general settings for PTP. 

Settings
● Delay Mechanism

Specify the delay mechanism the device will work with:

– End-to-end(delay request response mechanism will be used)

– Peer-to-peer (peer delay mechanism will be used)

● Domain Number
Enter the identification number for the time domain. Synchronization is only for the devices 
within the domain. The device ignores PTP messages with a different domain number. A 
SCALANCE device can only be assigned to one synchronization domain.

TC port
On this page, you specify the ports that can process PTP messages.

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● Setting / Transport Mechanism
Select the setting. If "No Change" is selected, the entry in table 2 remains unchanged.  

● Transfer to table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:
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● Port
Shows the available ports. 

● Setting
Enable or disable PTP. When enabled, the port processes PTP messages.

● Faulty Flag
Shows error status relating to PTP.

– true
An error occurred.

– false
No error has occurred on this port.

● Transport Mechanism
Specifies the protocol for transferring the PTP messages. This protocol must also be 
supported by the communications partner of the port

– Ethernet

– UDP IPv4

 

RMON

Statistics

Statistics 
On this page you can specify the ports for which statistics are displayed.

Settings
● RMON

If you select this check box, Remote Monitoring (RMON) allows diagnostics data to be 
collected on the device, prepared and read out using SNMP by a network management 
station that also supports RMON. This diagnostic data, for example port-related load trends, 
allow problems in the network to be detected early and eliminated.

● Port
Select the ports for which statistics will be displayed.

The table has the following columns:

● 1st column
Select the check box of the ports for which no more statistics will be displayed.

● Port
Shows the ports for which statistics will be displayed.
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History

Samples of the statistics 
On this page, you can specify whether or not samples of the statistics are saved for a port. 
You can specify how many entries should be saved and at which intervals samples should be 
taken.

Settings
Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports.

● Setting
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Entries
Enter the maximum number of samples to be stored at the same time. If "No Change" is 
entered, the entry in table 2 remains unchanged.

● Interval [s]
Enter the interval after which the current status of the statistics will be saved as a sample. 
If "No Change" is entered, the entry in table 2 remains unchanged.

● Transfer to table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the port to which the settings relate. 

● Setting
Enable the port for which the history will be displayed.

● Entries
Enter the maximum number of samples to be stored at the same time.

● Interval [s]
Enter the interval after which the current status of the statistics will be saved as a sample.

Layer 3

Configuration
The page contains the overview of the layer 3 functions of the device.  To use the "Routing", 
"VRRP", "OSPF" and "RIP" functions, the device requires a KEY-PLUG.
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Settings
● Routing (only available on layer 3)

Enable or disable the "Routing" function.

● DHCP Relay Agent
Enable or disable the DHCP relay agent. You can configure other settings in "Layer 3 > 
DHCP Relay Agent".

● VRRP (only available on layer 3)
Enable or disable routing using VRRP. To use VRRP, first enable the "Routing" function. 
You can configure other settings in "Layer 3 > VRRP".

● OSPF (only available on layer 3)
Enable or disable routing using OSPF. To use OSPF , first enable the "Routing" function. 
You can configure other settings in "Layer 3 > OSPFv2".

● RIP (only available on layer 3)
Enable or disable routing using RIP. To use RIO , first enable the "Routing" function. You 
can configure other settings in "Layer 3 > RIPv2".

Subnets

Overview

Subnet
The page shows the subnets for the selected interface. If more than one subnet is available 
on an interface, the first entry of this interface is of the address type "Primary". All other subnets 
have the address type "Secondary".

On this page, you can create further subnets "Layer 3 > Subnets > Overview". In "Layer 3 > 
Subnets > Configuration", you configure the settings of the created subnets. 

Settings
The following settings are possible for subnets of the "Secondary" address type:

● Interface 
Select the interface on which you want to configure another subnet.

The table has the following columns:

● Interface
Shows the interface.

● TIA Interface
Shows whether or not the entry is a TIA interface.

● Interface Name
Shows the name of the interface.

● MAC Address
Shows the MAC address.
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● IP Address
Shows the IP address of the subnet.

● Subnet Mask
Shows the subnet mask.

● Address Type
Shows the address type. The following values are possible:

– Primary
The first IP address that was configured on an IP interface.

– Secondary
All other IP addresses that were configured on an interface.

● IP Assignment Method
Shows how the IP address is assigned.

– Static
The IP address is static. You enter the IP settings in "IP Address" and "Subnet Mask".

– Automatic (DHCP)
The device obtains a dynamic IP address from a DHCP server.

● Address Collision Detection Status
Shows the status of the "Detection of address collisions" function.

– Idle
The interface is not enabled and does not have an IP address.

– Starting
This status indicates the start-up phase. In this phase, the device initially sends a query 
as to whether the planned IP address already exists. If the address is not yet been 
assigned, the device sends the message that it is using this IP address as of now.

– Conflict
The interface is not enabled. The interface is attempting to use an IP address that is 
already been assigned.

– Defending
The interface uses a unique IP address. Another interface is attempting to use the same 
IP address.

– Active
The interface uses a unique IP address. There are no collisions.

– Not supported
The function for detection of address collisions is not supported.

Configuration
On this page, you configure the subnet. You create the subnet in "Layer 3 > Subnets > 
Overview".
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Settings
● Interface (Name) 

Select the required interface. 

● Interface Name
Enter the name of the interface, e.g. eth0; P3.

● MAC Address (only available online)
Shows the MAC address of the selected interface

● DHCP
Enable or disable the DHCP client for this interface.

● IP Address
Enter the IP address of the subnet. The IP address must not be used more than once.

● Subnet Mask
Enter the subnet mask of the subnet you are creating. Subnets on different interfaces must 
not overlap.

● Address Type
Shows the address type. The following values are possible:

– Primary
The first subnet of the interface.

– Secondary 
All other subnets of the interface.

● Address Collision Detection
Enable or disable the function.
If new IP addresses become active in the network, this function checks whether this can 
result in address collisions.
With this function, IP addresses that will be assigned twice can be detected.

 

  Note

The function does not run a cyclic check.
 

● TIA Interface
Enable or disable the setting.
The following conditions apply to the TIA interface:

– Only interfaces with the address type "Primary" can be enabled as the TIA interface.

– There must only ever be one TIA interface.

– There can only be one TIA interface.

– A TIA interface is always a VLAN interface.

TIA interface and PROFINET interface
The IP address of the TIA interface is linked to the IP address located in the parameter group 
"Properties > General > PROFINET interface > Ethernet addresses".

Both IP addresses always have the same value. If you change the value of one IP address, 
the other IP address changes accordingly.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
960 System Manual, 02/2014



TIA Interface
The TIA interface is the interface via which all PROFINET functions of the IE switch are handled.

TIA interface is the name of the IP address for PROFINET from the perspective of the IE switch.

PROFINET interface
You make the IP setting of the PROFINET device in TIA under PROFINET interface.

PROFINET interface is the name of the IP address for PROFINET from the perspective of the 
TIA Portal.

Routes

Static route
On this page, you create the static routes. During automatic adaptations, static routes are not 
taken into account and need to be adapted manually.

Settings
● Destination Network

Enter the network address of the destination.

● Subnet Mask
Enter the corresponding subnet mask.

● Gateway
Enter the IP address of the next gateway.

● Metric
Enter the metric for the route. The metric corresponds to the quality of a connection, for 
example speed, costs.

The table has the following columns:

● Destination Network
Shows the network address of the destination.

● Subnet mask
Shows the corresponding subnet mask.

● Gateway
Shows the IP address of the next gateway.

● Interface (only available online)
Shows the interface of the route.

● Metric
Enter the metric for the route. When creating the route, "not used" is entered automatically. 
The metric corresponds to the quality of a connection, for example speed, costs. If there 
are several equal routes, the route with the lowest metric value is used.

● Status (only available online)
Shows the status of the route.
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Route maps

General

Route maps
With route maps, you control how routing information is further processed. You can filter routing 
information and specify whether the information is further processed, modified or discarded.

Route maps operate according to the following principle:

● Routing information is compared with the filters of the route maps.

● The comparison is continued until the filters of a route map match the properties of an item 
of information.

● The information is then processed according to the route map settings:

– The routing information is discarded. 

– The properties of the routing information are changed.

Settings
● Name

Enter the name for the route map.

● Sequence No
Enter a number for the route map.
The numbers specify the order in which the route maps are processed.

The table has the following columns:

● Name
Shows the name of the route map.

● Sequence No
Shows the sequence number of the route map.

● Action
Specify what happens to the routing information that matches the settings of the route map:

– permit
The routing information is further processed according to the settings you make in the 
"Settings" tab.

– deny
The routing information is discarded.

Interface and metric match
On this page, you specify whether or not the routing information for a route map is filtered 
according to interfaces or metric.
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Settings
● Route Map (name/seq. no.)

Select a route map.
The created route maps are available to you.

● Type
Select the basis for the filtering:

– Interface

– Metric

● Interface
Select an interface.
This box is active only if you have selected the "Interface" entry in the "Type" drop-down 
list.

● Metric
Enter a value for the metric.
This box is active only if you have selected the "Metric" entry in the "Type" drop-down list.

The table has the following columns:

● Type
Shows the selected type:

– Interface

– Metric

● Value
Shows the selected interface or the value of the metric.

Source match
On this page, you specify whether or not the routing information for a route map is filtered 
based on the source IP address.

Settings
● Route Map (name/seq. no.)

Select a route map.

● IP Address
Enter the IP address of the source on which the filtering is based.

● Subnet Mask
Enter the subnet mask of the source on which the filtering is based.

The table has the following columns:

● IP Address
Shows the IP address of the source.

● Subnet Mask
Shows the subnet mask of the source.
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Destination match
On this page, you specify whether or not the routing information for a route map is filtered 
based on the destination IP address.

Settings
● Route Map (name/seq. no.)

Select a route map.

● IP Address
Enter the IP address of the destination on which the filtering is based.

● Subnet Mask
Enter the subnet mask of the destination on which the filtering is based.

The table has the following columns:

● IP Address
Shows the IP address of the destination.

● Subnet Mask
Shows the subnet mask of the destination.

Next hop match
On this page, you specify whether or not the filtering for a route map will be based on the router 
to which the routing information is sent next.

Settings
● Route Map (name/seq. no.)

Select a route map.

● IP Address
Enter the IP address of the router to which the routing information will be sent next.

The table has the following columns:

● IP Address
Shows the IP address of the next router.

Settings
On this page, you specify whether or not the routing information for a route map will be changed.

If, for example, you have filtered based on a certain metric, you can change the value of the 
metric here. The routing information is then forwarded with the new value.

Settings
● Route Map (name/seq. no.)

Select a route map.

The table has the following columns:
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● Name
Shows the name of the route map.

● Sequence No
Shows the sequence number of the route map.

● Interface
Enter the new interface via which the routing information will be forwarded.

● Metric
Enter the new value for the metric with which the routing information will be forwarded.

● Next Hop IP Address
Enter the IP address of the router to which the routing information will be sent next.

DHCP Relay Agent

General
If the DHCP server is in a different network, the device cannot reach the DHCP server. The 
DHCP relay agent intercedes between a DHCP server and the device. The DHCP relay agent 
forwards the port number of the device with the DHCP query to the DHCP server.  If a DHCP 
server is unreachable, the device can switch to a different DHCP server.

Settings 
● DHCP Relay Agent (Opt. 82)

Enable or disable the DHCP relay agent.

● Server IP Address
Enter the IP address of the DHCP server.

The table has the following columns:

● Server IP address
Shows the IP address of the DHCP server.

Option

Parameters of the DHCP relay agent
On this page, you can specify parameters for the DHCP server, for example the circuit ID.
The circuit ID describes the origin of the DHCP query, for example which port received the 
DHCP query.

You specify the DHCP server on the "General" tab.
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Settings

Global configuration
● Circuit ID router index

When enabled, the router index is added to the generated circuit ID.

● Circuit ID recipient VLAN ID
When enabled, the VLAN ID is added to the generated circuit ID.

● Circuit ID receiving port
When enabled, the receiving port is added to the generated circuit ID.

 

  Note

You need to select a least one option.
 

● Remote ID
Shows the device ID.

Interface-specific configuration
● Interface

Select the required interface.

The table has the following columns:

● Interface
Shows the selected interface.

● Remote ID type
Select the type of the device ID. You have the following options:

– IP Address
The current IP address of the interface will be used as the device identifier and copied 
to the "Remote ID" box.

 

  Note
No automatic updating

There is no link between the "Remote ID" box and the currently set IP address.

If the IP address is changed, the new IP address is not entered in the "Remote ID" box 
automatically. Only the value of the "Remote ID Type" box changes to "Free Text". To 
use the current IP address again, select "IP Address" again in the "Remote ID Type" 
box.

 

– MAC Address
The MAC address of the device is used as the device ID.

– Free Text
If you use "Free Text", you can enter the device name as the device identifier in the 
"Remote ID" box.

● Remote ID
The box can only be edited if you select the entry "Free Text" for "Remote ID Type".
The remote IP must be unique.
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● Circuit ID Type
Select the type of circuit ID from the drop-down list. You have the following options:

– Predefined
The circuit ID is created automatically based on the router index, VLAN ID or port.

– Free Number
If you use "Free Number", you can enter the ID for "Circuit ID".

● Circuit ID
Enter the circuit ID.
The box can only be edited if you select the "Free Number" entry for the "Circuit ID Type". 

VRRP

Router
On this page, you create virtual routers. You can configure other parameters in "Layer 3 > 
VRRP > Configuration".

 

 Note
● VRRP is available only on layer 3.
● VRRP can only be used in conjunction with VLAN interfaces. Router ports are not 

supported.
● Select "VRRP" to configure VRRP

 

Settings   
The following settings are available:

● VRRP
Enable or disable routing using VRRP. 

● React to pings on virtual interfaces
When enabled, the virtual IP addresses also reply to the ping.

● Interface
Select the interface operating as virtual router.

● VRID
Enter the ID of the virtual router in the input box. This ID defines the group of routers that 
form a virtual router (VR). In the group, this is the same. it can no longer be used for other 
groups.

The table has the following columns:

● Interface
Shows the Interface that functions as the virtual router.

● VRID
Shows the ID of the virtual router.
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● Virtual MAC Address
Shows the virtual MAC address of the virtual router.

● Primary IP Address
Shows the primary IP address in this VLAN. The entry 0.0.0.0 means that the "Primary" 
address on this VLAN is used. Otherwise all IP addresses configured in this VLAN in "Layer 
3 > Subnets" are valid values.

● Router Status 
Shows the current status of the virtual router. Possible values are as follows:

– Master 
The router is the master router and handles the routing functionality for all assigned IP 
addresses.

– Backup
The router is the backup router. If the master router fails, the backup router takes over 
the tasks of the master router.

– Initialize 
The virtual router has just been turned on. It will soon change to the "Master" or "Backup" 
status.

● Master IP Address (only available online)
Shows the IP address of the master router.

● Priority
Shows the priority of the virtual router. 
The current master router is automatically given 255. All other priorities can be distributed 
freely among the VRRP routers. The higher the priority, the earlier the VRRP router 
becomes "Master".

● Advert. Internal
Shows the interval at which the master router sends VRRP packets.

● Preempt
Shows the precedence of a router when changing roles between backup and master.

– yes
This router has precedence when changing roles.

– no
This router does not have precedence when changing roles.

Configuration

Introduction
On this page, you configure the virtual router.  

 

 Note

VRRP is available only on layer 3.
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Description of the displayed values
The page contains the following boxes:

● Interface / VRID
Select the ID of the virtual router to be configured.

● Primary IP Address
Select the primary IP address. If the router becomes master router, the router uses this IP 
address.

 

  Note

If you only configure one subnet on this VLAN, no entry is necessary. The entry is 0.0.0.0. 
If you configure more than one subnet on the VLAN and you want a specific IP address 
to be used as the source address for VRRP packets, select the IP address from the drop-
down list. Otherwise, the IP address with priority will be used.

 

● Master
If this option is enabled, the primary IP address is entered for "Associated IP Address". This 
means that the highest priority IP address of the VRRP router is used as the virtual IP 
address of the virtual master router. The option must be disabled for the backup routers in 
this group and the IP address of the router in "Assigned IP address" must be used.

● Priority
Enter the priority of this virtual router. 
The current master router is always given 255. All other priorities can be distributed freely 
among the redundant routers. The higher the priority, the earlier the router becomes 
"Master".

● Advertisement Interval [s]
Enter the interval in seconds after which a master router sends a VRRP packet again.

● Preempt lower priority master
Allow the precedence when changing roles between Backup and Master based on the 
selection process.

Address overview

Overview
This page shows which IP addresses the virtual router monitors. 

 

 Note

VRRP is available only on layer 3.
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Settings
The table has the following columns:

● Interface
Shows the Interface that functions as the virtual router.

● VRID
Shows the ID of this virtual router.

● Number of Addresses
Shows the number of IP addresses.

● Associated IP Address (1) ... Associated IP Address (4) 
Shows the router IP addresses monitored by this virtual router. If a router takes over the 
role of master, the routing function is taken over by this router for all these IP addresses.

Address configuration
 

 Note

VRRP is available only on layer 3.
 

Settings
The following settings are possible:

● Interface / VRID
Select the required virtual router.

● Associated IP Address
Enter the IP address that the virtual router will monitor. 

The table has the following columns:

● Associated IP Address
Shows the IP addresses that the virtual router monitors.

OSPFv2

Configuration

Introduction   
On this page, you configure routing with OSPF.

 

 Note

OSPF is available only on layer 3.
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Settings
● OSPFv2

Enable or disable routing using OSPF.

● Router ID
Enter the name of one of the OSPF interfaces. The name is entered in the IP address format 
and does not need to match the local IP address.

● OSPFv2 RFC1583 Compatibility
Enable the option if you still have old OSPF routers in operation that are not compatible 
with RFC 2328.

● Border Router
Shows the status of the OSPF router. If the local system is an active member in at least 2 
areas, this is an area border router.

● AS Border Router
Specify whether the router is an AS border router. An AS border router intercedes between 
multiple autonomous systems, for example if you have an additional RIP network. An AS 
border router is also necessary to add and to distribute static routes.

● New LSA Received (only available online)
Shows the number of received LSAs.
Updates and local LSAs are not counted.

● New LSA Configured (only available online)
Number of different LSAs sent by this local system.

● External LSA Maximum
To limit the number of entries of external LSAs in the database, enter the maximum number 
of external LSAs.

● Exit Interval [s]
Enter the interval after which the OSPF router once again attempts to come out of the 
overflow status. A 0 means that the OSPF router attempts to exit the overflow status only 
following a restart.

● Inbound Filter
Select a route map that filters inbound routes.
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● Redistribute Routes 
Specify which known routes are distributed using OSPF. 
The following types of route exist:

– Default

– Connected

– Static 

– RIPv2
 

  Note

The settings can only be enabled on an AS border router. Enabling "Default" and "Static", 
in particular, can cause problems if they are enabled at too many points in the network, 
for example, forwarding loops.

 

● Route Map
Select a route map that filters which routes are forwarded using OSPF.

Areas

Overview
An autonomous system can be divided into smaller areas. 

On this page, you can view, create, modify or delete the areas of the router. 
 

 Note

OSPF is available only on layer 3.
 

Settings
● Area ID

Enter the ID of the area. The database is synchronized for all routers of an area.
Input format: x.x.x.x 
x = 0 ... 255

This table contains the following columns:
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● Area ID
Shows the ID of the area.

● Area Type
Select the area type from the drop-down list.

– Normal

– Stub

– NSSA

– Backbone

● Summary
Specify whether summary LSAs are generated for this area.

– Summary: Summary LSAs are sent to the area.

– No Summary: Summary LSAs are not sent to the area.

● Metric
Displays the costs for the OSPF interface.

● Updates
Shows the number of recalculations of the routing tables.

● LSA Count
Shows the number of LSAs in the database.

● Area BR
Shows the number of reachable area border routers (ABR) within this area.

● AS BR
Shows the number of reachable autonomous system border routers (ASBR) in this area.

Area range

Creating a new OSPFv2 area range  
On this page, networks can be grouped together under one area ID. The method is used only 
with area border routers. This means that an area border router only propagates one route for 
each address area to the outside.

 

 Note

OSPF is available only on layer 3.
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Settings
● Area ID

Select the area ID. You configure the ID in "Layer 3 > OSPFv2 > Areas".

● Subnet Address
Enter the address of the network that will be grouped.

● Subnet Mask
Enter the subnet mask of the network that will be grouped.

This table contains the following columns:

● Area ID
Shows the ID of the area.

● Subnet Address
Shows the address of the network that will be grouped with other networks.

● Subnet Mask
Shows the subnet mask of the network that will be grouped with other networks.

● Advertise
Enable this option to advertise the grouped network.

Interfaces

Overview
On this page, you can configure OSPF interfaces.

 

 Note

OSPF is available only on layer 3.
 

Settings 
● IP Address

Select the IP address of the OSPF interface.

● Area ID
Select the area ID of the area with which the OSPF interface is connected.

 

  Note

For secondary address types, select the same Area ID as for the corresponding primary 
address type.
The information whether an address type is primary or secondary can be found in the 
"Address Type" column on the "Subnets > Overview" page.

 

This table contains the following columns:
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● IP Address
Displays the IP address of the OSPF interface.

● Area ID
Select the area ID with which the OSPF interface is connected.

● OSPF Status
Specify whether or not OSPF is active on the interface.

– Enabled: OSPF is enabled on the interface.

– Disabled: OSPF is disabled on the interface

● Metric
Enter the costs for the OSPF interface.

● Priority
Enter the router priority. The priority is only relevant for selecting the designated router. 
This parameter can be selected differently on routers within the same subnet.

● Trans. Delay
Enter the required delay when sending a connection update.

● Retrans. Delay
Enter the time after which an OSPF packet is transferred again if no confirmation was 
received.

● Hello Interval
Enter the interval between two Hello packets.

● Dead Interval
Enter the interval after which the neighbor router is marked as "failed" if no more Hello 
packets are received from it during this time.

Interface authentication

Configuring the interface login
On this page, you define the authentication of the interface.

 

 Note

OSPF is available only on layer 3.
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Settings
● OSPF Interface

Select the OSPF interface for which you want to configure authentication.

● Authentication type
Select the authentication method of the OSPF interface. You have the following options:

– None: No authentication

– simple: Authentication using an unencrypted password  

– MD5: Authentication using MD5

Simple authentication
● Password

For "Simple authentication, enter the password if you have selected this type of 
authentication.

● Confirmation
Confirm the entered password.

MD5 authentication
● Authentication Key ID 

If you have selected this type of authentication, enter the ID for the MD5 authentication 
under which the password is used as the key. Since the key ID is transferred with the 
protocol, the same key must be stored under the same key ID on all neighboring routers.

The table has the following columns:

● Authentication Key ID
Can only be edited if you set the MD5 authentication method. It is only possible to use 
several keys there.

● MD5 Key
Enter the MD5 key. 

● Confirm MD5 Key
Confirm the entered key.

● Youngest Key ID (only available online)
Shows whether or not the MD5 key is the latest key ID.

Virtual links

Overview  
Due to the protocol, each area border router must have access to the backbone area. If a 
router is not connected directly to the backbone area, a virtual link to it is created.

 

 Note

OSPF is available only on layer 3.
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 Note

Note that when creating a virtual link both the transit area and the backbone area must already 
be configured.

the virtual link must be configured identically at both ends.
 

Note
● Virtual links are not effective unless the device is an ABR. (only available online)

This is displayed when at least one virtual link entry is configured and the device is not an 
area border router.

Settings
● Neighbor Router ID

Enter the ID of the neighbor router at the other end of the virtual connection.

● Transit Area ID
Select the ID of the area that connects the two routers.

This table contains the following columns:

● Transit Area ID
Shows the ID via which the two routers are connected.

● Neighbor Router ID
Shows the ID of the neighbor router at the other end of the virtual connection.

● Virt. Link Status
Specify the status of the virtual link. The following statuses are possible:

– down: The virtual link is inactive.

– point-to-point: The virtual link is active.

● Trans. Delay
Enter the required delay when sending a link update packet (in seconds).

● Retrans. Delay
Enter the time after which a packet is transferred again if no confirmation was received (in 
seconds).

● Hello Interval
Enter the interval between two Hello packets (in seconds).

● Dead Interval
Enter the interval after which the neighbor router counts as "failed" if no more Hello packets 
are received from it during this time (in seconds).
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Virtual Link Authentication

Configuring the virtual link login
On this page, you define the authentication for the virtual link.

 

 Note

OSPF is available only on layer 3.
 

Settings
● Virtual link (area/neighbor) 

Select the virtual link for which you want to configure authentication.

● Authentication type
Select the authentication method of the OSPF interface. You have the following options:

– None: No authentication

– simple: Authentication using an unencrypted password.  

– MD5: Authentication using MD5

Simple authentication
● Password

Enter the password for "simple authentication".

● Confirmation
Confirm the entered password.

MD5 authentication
● Authentication Key ID

Enter the ID for MD5 authentication with which the password will be used as a key. Since 
the key ID is transferred with the protocol, the same key must be stored under the same 
key ID on all neighboring routers.

The table has the following columns:

● Authentication Key ID
Can only be edited if you set the MD5 authentication method. It is only possible to use 
several keys there.

● MD5 Key
Enter the MD5 key. 

● Confirm MD5 Key
Confirm the entered key.

● Youngest Key ID
Shows whether or not the MD5 key is the latest key ID.
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RIPv2

Configuration
On this page, you configure routing with RIP.

 

 Note

RIPv2 is available only on layer 3.
 

Settings   
● RIPv2

Enable or disable routing using RIPv2.

● Inbound Filter
Select a route map that filters inbound routes.

● Redistribute Routes 
Specify which known routes are distributed using RIPv2.
The following types of route exist:

– Static Default

– Connected

– Static 

– OSPF

● Route Map
Select a route map that filters which routes are forwarded using RIPv2.

Interfaces

Overview
On this page, you can configure RIPv2 interfaces.

 

 Note

RIPv2 is available only on layer 3.
 

Settings 
● IP Address

Select the IP address of the RIPv2 interface.

This table contains the following columns:
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● IP Address
Displays the IP address of the RIPv2 interface.

● Send Updates
Select the way in which updates are sent:

– no send
No updates are sent.

– RIPv1
Updates for RIPv1 are sent.

– RIPv1-compat.
RIPv2 updates are sent as broadcasts according to the rules of RIPv1.

– RIPv2
Updates for RIPv2 are sent as multicasts.

– RIPv1 demand/RIPv2 demand
RIP packets are sent only as a response to an explicit query.

● Receive Updates
Select the form in which received updates are accepted:

– no receive
No updates are received.

– RIPv1
Only updates of RIPv1 are received.

– RIPv2
Only updates of RIPv2 are received.

– RIPv1/v2
Updates of RIPv1 and RIPv2 are received.

● Default Metric
Enter the costs for the RIPv2 interface.

Security

Passwords
 

 Note

The page is only available if there is an online connection to the device.
 

Only the administrator can change the device passwords for administrator and users. 

The factory settings for the passwords when the devices ship are as follows:

● Administrator: admin

● User: user
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 Note

If you log on the first time or log on after a "Reset to factory defaults and restart", you will be 
prompted to change the password.

 

 Note
Changing the password in "Trial" configuration mode

Even if you change the password in "Trial" configuration mode, this change is saved 
immediately.

 

Settings
● Current Admin Password

Enter the valid administrator password.

● User name
Select the required user. The following options are available:

– Administrator: admin

– User: user

● New Password
Enter the new password.

● Password Confirmation
Confirm the new password.

AAA

General
The term "AAA" used in the menu stands for "Authentication, Authorization, Accounting" and 
is used to identify and allow network nodes, to provide them with the appropriate services and 
to determine the amount of use.

On this page, you configure the login.
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Settings
● Login Authentication

Specify how the login is made: 

– Local
Login with local user name and password.

– RADIUS
Login using a RADIUS server.

RADIUS client
The term "AAA" used in the menu stands for "Authentication, Authorization, Accounting" and 
is used to identify and allow network nodes, to provide them with the appropriate services and 
to determine the amount of use.

Authentication over an external server
The concept of RADIUS is based on an external authentication server. An end device can only 
access the network after the device has verified the logon data of the device with the 
authentication server. Both the end device and the authentication server must support the EAP 
protocol (Extensive Authentication Protocol).   

Each column of the table contains access data for one server. In the search order, the primary 
server is queried first. If the primary server cannot be reached, secondary servers are queried 
in the order in which they are entered.

If no server responds, there is no authentication. The client has no access to the network 
although a link is indicated at the port.

Settings
The table has the following columns:

● Server IP Address
Enter the IP address of the RADIUS server. 

● Server Port
Here, enter the input port on the RADIUS server. As default, input port 1812 is set. 

● Shared Secret
Enter your access ID.

● Confirm Shared Secret
Enter your access ID again as confirmation.

● Max. Retrans
Enter the maximum number of query attempts before another configured RADIUS server 
is queried or the login counts as having failed. As default, 3 is set.
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● Primary Server
Specify whether or not this server is the primary server. You can select one of the options 
"yes" or "no".

● Status
Enable or disable the RADIUS server.

 

  Note

You can configure a maximum of two servers on this page.
 

802.1x authenticator
The term "AAA" used in the menu stands for "Authentication, Authorization, Accounting" and 
is used to identify and allow network nodes, to provide them with the appropriate services and 
to determine the amount of use.

Enabling authentication for individual ports
By selecting the check box, you specify whether or not network access protection according 
to IEEE 802.1x is enabled on this port.   

Settings
● MAC Authentication

Enable or disable MAC authentication for the device.

● Guest VLAN
Enable or disable the "Guest VLAN" function for the device.

Table 1 has the following columns:

● 1st column
Shows that the settings are valid for all ports of table 2.

● 802.1x Auth. Control
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● 802.1x Re-authentication
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● MAC Authentication
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Adopt RADIUS VLAN Assignment
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● MAC Auth. Max Permitted Addresses
Enter how many end devices are allowed to be connected to the port at the same time. If 
"No Change" is entered, the entry in table 2 remains unchanged.
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● Guest VLAN
Select the required setting. If "No Change" is selected, the entry in table 2 remains 
unchanged.

● Guest VLAN ID
Enter the VLAN ID of the port. If "No Change" is entered, the entry in table 2 remains 
unchanged.

● Guest VLAN max. Permitted Addresses
Enter how many end devices are allowed in the guest VLAN at the same time.

● Transfer to table
If you click the button, the settings are adopted for all ports of table 2.

Table 2 has the following columns:

● Port
Shows the port to which the setting relates.
If a configuration is not possible for a port, it is displayed grayed out and you cannot modify 
the settings.

● 802.1x Auth. Control
Specify the authentication of the port:

– Force Unauthorized
Data traffic via the port is blocked.

– Force Authorized
Data traffic via the port is allowed without any restrictions.
Default setting

– Auto
End devices are authenticated on the port with the "802.1x" method.
The data traffic via the port is permitted or blocked depending on the authentication 
result.

● 802.1x Re-authentication
Enable this option if you want reauthentication of an already authenticated end device to 
be repeated cyclically.

● MAC Authentication
Enable this option if you want end devices to be authenticated with the "MAC 
Authentication" method.

● Adopt RADIUS VLAN Assignment
The RADIUS server informs the IE switch of the VLAN to which the port belongs.
Enable this option if you want the information of the server to be taken into account. The 
port then belongs to the corresponding VLAN.
If the option is disabled, the VLAN information is discarded.

● MAC Auth. Max Permitted Addresses
Enter how many end devices are allowed to be connected to the port at the same time. 

● Guest VLAN
Enable this option if you want the end device to be permitted in the guest VLAN if 
authentication fails.

● Guest VLAN ID
Enter the VLAN ID of the port.
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● Guest VLAN max. Permitted Addresses
Enter how many end devices are allowed in the guest VLAN at the same time.

● MAC Auth. Currently Permitted Addresses
Shows the number of currently connected end devices.

● MAC Auth. Currently Blocked Addresses
Shows the number of currently blocked end devices.

● Guest VLAN Currently Permitted Addresses
Shows how many end devices are currently allowed in the guest VLAN.

Port ACL MAC

Rule configuration
On this page, you specify the ACL rules for the MAC-based ACL. 

Settings
The table has the following columns:

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source MAC
Enter the unicast MAC address of the source.
Dest. MAC
Enter the unicast MAC address of the destination.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

● Egress Port
Shows a list of all egress ports to which this rule applies.

 

 Note

If you enter the address "00:00:00:00:00:00" for the source and/or destination MAC address, 
the rule created in this way applies to all source or destination MAC addresses.
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Port ingress rules
On this page, you specify the ACL rule according to which incoming frames are handled by 
the port. 

Settings
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add" button. The configuration 
is shown in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Rule Order
Shows the order of the ACL rules.

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source MAC
Shows the unicast MAC address of the source.

● Dest. MAC
Shows the unicast MAC address of the destination.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

Port egress rules
On this page, you specify the ACL rule according to which outgoing frames are handled by the 
port.
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Description
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add" button. The configuration 
is shown in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Rule Order
Shows the order of the ACL rules.

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source MAC
Shows the unicast MAC address of the source.

● Dest. MAC
Shows the unicast MAC address of the destination.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

Port ACL IP

Rule configuration
On this page, you specify the rules for the IP-based ACL. 
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Settings
The table has the following columns:

● Rule Number 
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● Source IP
Enter the IP address of the source.

● Source Subnet Mask
Enter the subnet mask in which the source is located.

● Dest. IP
Enter the IP address of the destination.

● Dest. Subnet Mask
Enter the subnet mask in which the destination is located.

● Action
Select the action from the drop-down list. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

● Ingress Port
Shows a list of all ingress ports to which this rule applies.

● Egress Port
Shows a list of all egress ports to which this rule applies.

Protocol configuration
On this page, you specify the rules for protocols. 

Settings
The table has the following columns:

● Rule Number 
Shows the number of the protocol rule. When you create a rule, a new row with a unique 
number is created.

● Protocol
Select the protocol for which this rule is valid.

● Protocol Number
Enter a protocol number to define further protocols.
This box can only be edited if you have set "Other Protocol" for the protocol.

● Source Port Min.
Enter the lowest possible port number of the source port.
This box can only be edited if you have set "TCP" or "UDP" for the protocol.
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● Source Port Max.
Enter the highest possible port number of the source port.
This box can only be edited if you have set "TCP" or "UDP" for the protocol.

● Dest. Port Min.
Enter the lowest possible port number of the destination port.
This box can only be edited if you have set "TCP" or "UDP" for the protocol.

● Dest. Port Max.
Enter the highest possible port number of the destination port.
This box can only be edited if you have set "TCP" or "UDP" for the protocol.

● Message Type
Enter a message type to decide the format of the message.
This box can only be edited if you have set "ICMP" for the protocol.

● Message Code
Enter a message code to specify the function of the message.
This box can only be edited if you have set "ICMP" for the protocol.

● DSCP
Enter a value for classifying the priority.
This box cannot be edited if you have set "ICMP" for the protocol.

Port ingress rules
On this page, you specify the ACL rule according to which incoming frames are handled by 
the port.

Settings
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add" button. The configuration 
is shown in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Rule Order
Shows the order of the ACL rules. 

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created. 
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● Protocol
Shows the protocol for which this rule is valid.

● Protocol Number
Shows the protocol number.

● Source IP
Shows the IP address of the source.

● Source Subnet Mask
Shows the subnet mask in which the source is located.

● Dest. IP
Enter the IP address of the destination.

● Dest. Subnet Mask
Enter the subnet mask in which the destination is located.

● Action
Select the action. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

● Source Port Min.
Shows the lowest possible port number of the source port.

● Source Port Max.
Shows the highest possible port number of the source port.

● Dest. Port Min.
Shows the lowest possible port number of the destination port.

● Dest. Port Max.
Shows the highest possible port number of the destination port.

● Message Type
Shows the message type.

● Message Code
Shows the message code.

● DSCP
Shows the value for classifying the priority.

Port egress rules
On this page, you specify the ACL rule according to which outgoing frames are handled by the 
port. 
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Settings
● Ports

Select the required port.

● Add Rule
Select the ACL rule to be assigned to the port. You specify the ACL rule on the "Rules 
Configuration" page.

● Add
To permanently assign the ACL rule to the port, click the "Add" button. The configuration 
is shown in the table.

● Remove Rule
Select the ACL rule to be deleted.

● Remove
To remove the ACL rule from the port, click the "Remove" button.

The table has the following columns:

● Rule Order
Shows the order of the ACL rules. 

● Rule Number
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created. 

● Protocol
Shows the protocol for which this rule is valid.

● Protocol Number
Shows the protocol number.

● Source IP
Shows the IP address of the source.

● Source Subnet Mask
Shows the subnet mask in which the source is located.

● Dest. IP
Enter the IP address of the destination.

● Dest. Subnet Mask
Enter the subnet mask in which the destination is located.

● Action
Select the action from the drop-down list. The following is possible:

– Forward
If the frame complies with the ACL rule, the frame is forwarded.

– Discard
If the frame complies with the ACL rule, the frame is not forwarded.

● Source Port Min.
Shows the lowest possible port number of the source port.

● Source Port Max.
Shows the highest possible port number of the source port.
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● Dest. Port Min.
Shows the lowest possible port number of the destination port.

● Dest. Port Max.
Shows the highest possible port number of the destination port.

● Message Type
Shows the message type.

● Message Code
Shows the message code.

● DSCP
Shows the value for classifying the priority.

Management ACL
On this page, you can increase the security of your device. To specify which station with which 
IP address is allowed to access your device, configure the IP address or an entire address 
range.

You can select the protocols and the ports of the station with which it is allowed to access the 
device. You define the VLAN in which the station may be located. This ensures that only certain 
stations within a VLAN have access to the device.

 

 Note

Note that a bad configuration may mean that you can no longer access the device.
 

Settings
● Management ACL

Enable or disable the function.

● IP Address
Enter the IP address or the network address to which the rule will apply. If you use the IP 
address 0.0.0.0, the settings apply to all IP addresses.

● Subnet Mask
Enter the subnet mask. The subnet mask 255.255.255.255 is for a specific IP address. If 
you want to allow a subnet, for example a C subnet, enter 255.255.255.0. The subnet mask 
0.0.0.0 applies to all subnets.

The table has the following columns:

● Rule Order
Shows the number of the ACL rule. When you create a rule, a new row with a unique number 
is created.

● IP Address
Shows the IP address.

● Subnet Mask
Shows the subnet mask.
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● VLANs Allowed 
Enter the number of the VLAN from which access is allowed.
Only stations located in these VLANs can access the device. If this input box remains empty, 
there is no restriction.
You can enter several individual VLANs and VLAN ranges separated by commas, for 
example 1,5,10-12.

● SNMP
Specify whether the station or the IP address can access the device using the SNMP 
protocol.

● TELNET
Specify whether the station or the IP address can access the device using the TELNET 
protocol.

● HTTP
Specify whether the station or the IP address can access the device using the HTTP 
protocol.

● HTTPS
Specify whether the station or the IP address can access the device using the HTTPS 
protocol.

● SSH
Specify whether the station or the IP address can access the device using the SSH protocol.

● Px.y
Specify whether the station or the IP address can access this device via this port.

8.1.4.6 Configuring PROFIBUS DP

The basics of configuring a DP master system

Distributed I/O  
DP master systems that consist of a DP master and DP slaves which are connected via a bus 
and communicate with one another via the PROFIBUS DP protocol are referred to as 
distributed I/O.

Firmware version of the S7‑1200 CPU
Use of the PROFIBUS functions with the S7‑1200, requires CPUs with firmware version 2.0 
or higher.

Configuring distributed I/O
Since DP masters and DP slaves are different devices, these instructions only provide a basic 
configuration procedure. However, the process for configuring distributed I/O is practically 
identical to that of non-distributed configuration.
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Creating the DP master system in the network view  
After you have used dragged a DP master and a DP slave (for example, a CM 1243‑5 and a 
CM 1243‑5) from the hardware catalog to the network view, connect them both to a PROFIBUS 
subnet.

Additional information
Observe additional information on the scope of functions in the manuals of the respective 
device.

DP slaves within the hardware catalog

DP slaves within the hardware catalog   
You will find the DP slaves in the "Distributed I/O" folder of the hardware catalog. Compact 
and modular DP slaves are located there:

● Compact DP slaves
Modules with integrated digital/analog inputs and outputs, for example, ET 200L

● Modular DP slaves
(Interface modules with S7 modules assigned, for example, ET 200M

The available DP master and the desired functionality will determine which DP slaves can be 
used.

I slaves within the hardware catalog  
The CM 1242-5 is, for example, an DP slave that can be configured as intelligent DP slave. 
You can find it in the hardware catalog at:

● CM 1242‑5
"PLC > SIMATIC S7 1200 > Communication module > PROFIBUS"

DP/DP coupler in the hardware catalog 

Introduction
A DP/DP coupler connects two PROFIBUS DP networks as a gateway so that the DP master 
from one network can transfer data to the DP master of the other network.

The maximum amount of data that can be transferred is 244 bytes input data and 244 bytes 
output data.

DP/DP coupler in the hardware catalog      
Details of a DP/DP coupler as gateway between two DM master systems are contained in the 
hardware catalog in the folder "Other field devices > PROFIBUS-DP > Gateways".
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Configuring the DP/DP coupler
DP/DP couplers are configured in both PROFIBUS networks, each in their own master 
systems.

The input and output areas of both networks must thereby be matched to one another. The 
output data from one end of the DP/DP coupler are accepted as input data at the other 
respective end and vice versa.

Configurations involving PROFIBUS DP

Configurations involving basic DP slaves

Communication between DP master and DP slave         
In the case of a configuration involving simple DP slaves, data is exchanged between the DP 
master and simple DP slaves, i.e. with I/O modules via the DP master. The DP master 
sequentially polls each DP slave configured within the DP master system and contained in its 
polling list. In doing so, it transfers the output data to the slaves and receives their input data 
in return.

Mono-master system   
The configuration with only one DP master is also described as mono-master system. A single 
DP master with its associated DP slaves is connected to a physical PROFIBUS DP subnet.
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Configurations involving intelligent DP slaves

Definition     
DP slaves that feature their own preprocessing program are referred to as intelligent DP slaves 
(I-slaves).

CM 1242-5 is an intelligent DP slave.

I-slave <> DP master data exchange     
A higher-level automation system processes the automation task, which is broken down into 
sub-tasks. The sub-tasks are processed in the lower-level automation systems. The necessary 
control tasks are processed separately and efficiently in the CPUs as preprocessing programs.

In the case of configurations involving intelligent DP slaves, the DP master only accesses the 
operand area of the I-slave's CPU, and not the I/O modules of the intelligent DP slave. The 
operand area must not be assigned to any actual I/O modules in the I-slave. The assignment 
must be made during I-slave configuration.

The addresses of the data to be exchanged between the master and slave are configured in 
the transfer area of the I-slave.

Configuring distributed I/O systems

Hint: Quick configuration of master systems
If the DP master system has several DP slaves, use drag-and-drop operation to assign to the 
master in one step all DP slaves that were placed.
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Requirements   
DP master and DP slaves are placed in the network view.

Assigning DP slaves to a DP master system
To do this, follow these steps:

1. Select an appropriate zoom factor so that you can see as many DP slaves as possible in 
the network view.

2. Arrange the DP slaves in a maximum of two rows.

3. Select all DP interfaces with the mouse cursor (not all devices!). This only works if you 
begin to drag the mouse cursor outside of the first DP slave and release the mouse button 
at the last DP slave (selection with the lasso).

4. Select the shortcut menu "Assign to new master" and select the corresponding DP interface 
for the DP master in the subsequent dialog.

5. The DP slaves are automatically networked with the DP master and combine with it to form 
a DP master system.

 

  Note

When a DP master system is highlighted, you can double-click on a DP slave in the 
hardware catalog and thereby quickly add additional DP slaves. This will result in the DP 
slave being added to the highlighted DP master system automatically.
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Creating a DP master system

Introduction   
To create a DP master system, you need to have one DP master and at least one DP slave. 
As soon as you connect a DP master to a DP slave, a master-slave link is established.

DP master   
You can use any of the following devices as a DP master:

● CM 1243‑5

Requirement
● You must be in the network view.

● The hardware catalog is open.

Procedure     
To create a DP master system, follow these steps:

1. Select a DP master from the hardware catalog.

2. Pull the DP master onto the free area within the network view.

3. Right-click on the DP master's DP interface.

4. Select "Create master system" from the shortcut menu.
A DP master system with one DP master will be created as a single node.

If you connect a DP slave's DP interface to that of the DP master, the DP slave will be added 
to the master system.
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Assuming that you have already placed both a DP master and a DP slave within the network 
view, you can drag-and-drop to connect the two and thereby create a DP master system. To 
do so, follow these steps:

1. Click on the DP interface of either the DP master or DP slave.

2. Hold down the mouse button and draw a connecting line between this DP interface and 
that of the desired communication partner.

This will create a subnet with one DP master system between the DP master and DP slave.
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DP master display on the DP slave     
When you connect a DP slave to a DP master, the name of the DP master is displayed on the 
DP slave as a hyperlink. Click the hyperlink to select the associated DP master.

Highlighting applied to the DP master system   
When you create a new DP master system, highlighting will be applied to it. This enables you 
to identify quickly which devices belong to the DP master system. You can also highlight a DP 
master system yourself by moving the mouse pointer over a subnet. This will result in the 
names of the available DP master systems being displayed. Click the required DP master 
system to highlight it.

There are various ways of removing the highlighting from a DP master system:

● Highlight a different master system.

● Click on the drawing pin with the name of the master system in the top right-hand corner 
of the network view.
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Editing DP master systems and interfaces

Introduction     
Once you have created a DP master system, you also have the option of disconnecting the 
DP master system from its components. This can result in subnets with DP slaves but without 
DP master. 

Generally, there is no need to edit the interfaces of a DP master.

You can change the name and number on the DP master system.

Disconnection of master or slaves from the DP master system
If you have configured a PROFIBUS CP as a DP master with master system, you can then 
disconnect the DP master system from the DP master. After this, the device will no longer be 
connected to the DP master system.

Disconnecting the subnet from a DP master effectively eliminates the master system in the 
sense that it is no longer assigned to a DP master. However, the individual DP slaves are still 
interconnected via the subnet.

If you delete the DP slaves or disconnect them from the master system, the master system is 
then retained on the DP master. 

Requirement
● You must be in the network view.

● There has to be a DP master system with one DP master and at least one DP slave.

Disconnecting the DP master from the DP master system   
To disconnect the DP master system, proceed as follows:

1. Right-click on the DP master's DP interface.

2. Select "Disconnect from master system" from the shortcut menu.

The selected DP master will be disconnected from the DP master system. A subnet with the 
DP slaves will be retained.

Adding a DP master to the DP master system   
To reassign a DP master to a subnet, proceed as follows:

1. Right-click on the DP master's DP interface.

2. Select "Create master system" from the shortcut menu.

3. Draw connecting lines between the new DP master system and the DP interfaces of the 
DP slaves.

The DP master combines with the DP slaves to recreate a DP master system.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 1001



Editing the properties of a DP master system   
To edit the properties of a DP master system, proceed as follows:

1. Move the mouse pointer over a subnet with a DP master system.

2. A message will appear displaying the available DP master systems. Click the one you want 
to edit. The DP master system will now be color-highlighted.

3. Click on the highlighted DP master system.

4. In the inspector window, edit the DP master system attributes under "Properties > General".
 

  Note

If you click a subnet when no DP master system is highlighted, you will be able to edit the 
properties of the entire subnet under "Properties" in the inspector window. 

 

Adding DP slaves to the master system and configuring them
In the network view, you can add various DP slaves from the hardware catalog directly by 
using the drag-and-drop function or by double-clicking.

DP slaves  
For configuration purposes, DP slaves are broken down into the following categories:

● Compact DP slaves
(Modules with integrated digital/analog inputs and outputs, for example, ET 200L)

● Modular DP slaves
(interface modules with S5 or S7 modules assigned, for example ET 200M)

● Intelligent DP slaves (I slaves)
(CM 1242‑5 or ET 200S with IM 151-7 CPU)

Rules
● Your DP master system should only contain one DP master, but it may contain one or or 

more DP slaves.

● You may only configure as many DP slaves in a DP master system as are permitted for the 
specific DP master.

 

  Note

When configuring the DP master system, remember to observe the DP master technical 
data (max. number of nodes, max. number of slots, max. quantity of user data). User data 
restrictions may possibly prevent you from being able to use the maximum number of 
nodes that is theoretically possible.
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Requirements
● You must be in the network view.

● A DP master system must have been created.

Adding a DP slave to the DP master system  
To add a DP slave from the hardware catalog to the DP master system, follow these steps:

1. Select a DP slave from the hardware catalog.

2. Drag-and-drop the DP slave from the hardware catalog into the network view.

3. Draw a connecting line between the DP master's DP interface or a highlighted DP master 
system and the DP interface of the new DP slave.

A DP master system will be created and the DP slave will be connected to the DP master 
automatically.

 

 Note

When a DP master system is highlighted, you can double-click the required DP slave in the 
hardware catalog. This will result in the DP slave being added to the highlighted DP master 
system automatically.

 

Disconnecting a DP slave from the DP master system  
To disconnect a DP slave from the DP master system, follow these steps:

1. In the network view, right-click on the DP slave's DP interface.

2. From the shortcut menu, select the method for disconnecting from the DP master system:

– "Disconnect from subnet": The PROFIBUS connection is broken and the device is no 
longer connected to the DP master system or a subnet.

– "Disconnect from master system": The DP slave remains connected to the subnet, but 
is no longer assigned to the DP master system as a DP slave.

The selected DP slave will be disconnected from the DP master system.

Assigning a DP slave to a new DP master system 
To assign an existing DP slave to a new DP master system, follow these steps:

1. Right-click on the DP slave's DP interface.

2. From the shortcut menu, select "Assign to new master".
It does not matter whether the DP slave concerned is already assigned to another DP 
master system.

3. From the selection list, select the DP master whose DP master system is to have the DP 
slave connected to it.
The selected DP slave is now assigned to a new DP master system.
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The "Assign to new subnet" function works in a similar way in that it allows you to connect a 
DP slave to a new subnet. However, in this case, the DP slave will not be connected to an 
existing DP master system.

Configuring a DP slave  
To configure a DP slave, follow these steps:

1. Switch to the DP slave's device view.

2. Select the module you want.

3. Configure the DP slave in the Inspector window.

Configuring intelligent DP slaves

Adding an I-slave to a DP master system

Introduction       
One of the characteristics of an intelligent DP slave (I-slave) is that the DP master is not 
provided with I/O data directly by a real I/O, but by a preprocessing CPU. Together with the 
CP, this preprocessing CPU forms the I-slave.

Difference: DP slave v. intelligent DP slave
In the case of a DP slave, the DP master accesses the distributed I/O directly.

In the case of an intelligent DP slave, the DP master actually accesses a transfer area in the 
I/O address space of the preprocessing CPU instead of accessing the connected I/O of the 
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intelligent DP slave. The user program running on the preprocessing CPU is responsible for 
ensuring data exchange between the address area and I/O.

 

 Note

The I/O areas configured for data exchange between the DP master and DP slaves must not 
be used by I/O modules.

 

Applications
Configurations involving intelligent DP slaves: I-slave <> DP master data exchange

Procedure     
To add an I-slave to a DP master system, follow these steps:

1. In the network view, drag from the hardware catalog to a station one CM 1242-5  as an I-
slave and one CM 1243-5 as a DP master.

2. Draw a connecting line between the DP interfaces of both devices.
This way you connect the I-slave with a DP master in a DP master system.
Result: You have now set up a DP master system with one DP master and one I-slave.

Configuring access to I slave data

Data access   
The following applies to the CP 1242-5 in its function as I-slave: The addresses for the data 
transfer area and the address for the I/O modules in the I-slave differ. This means that the start 
address occupied by an I/O module can no longer be used for the transfer memory. If the 
higher-level DP master is to access the data of an I/O module in the I-slave, you must configure 
this data exchange between the I/O module and transfer area in the I-slave user program.
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Configuration of the transfer area for the CM 1242-5 (transfer area)
With CM 1242‑5, the transfer area for the cyclic PROFIBUS data exchange is configured as 
transfer area in the parameter group "PROFIBUS interface > Mode > I Slave Communication".

Direct data access from CPU to CPU
Direct data access from CPU to CPU via PROFIBUS is supported by the S7-1200 PROFIBUS 
CMs only via the PUT/GET services.

Configuring DP slaves as distributed I/O devices

Configuring an ET 200S

Slot rules for configuring an ET 200S   
The following rules apply when configuring an ET 200S:

● Do not leave any gaps when inserting the ET 200S modules.

● Slot 1: only for PM-E or PM-D Power Modules.

● To the left of an Electronics Module (EM): an EM or a Power Module (PM-E or PM-D) only.

● To the left of Motor Starter (MS): an MS, a PM-D, PM-D Fx (1..x..4) Power Module or a PM-
X Power Module only.

● To the left of a PM-X: a motor starter or a PM-D only

● Up to 63 modules and one IM Interface Module are permitted
 

  Note

Remember to ensure that the correct PM-E and EM voltage ranges are assigned.
 

Configuring reference junctions  
A reference junction is the connection of a thermocouple to a supply line (generally in the 
terminal box). The voltage that occurs due to the effects of temperature falsifies the 
temperature value measured by the module. 

On the ET 200S, one channel of the AI RTD module can be programmed as a reference 
junction. Other AI TC modules can correct their measured values using the temperature at the 
reference junction as measured by this module.
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① Configuring the AI TC:

→ Selection of the reference junction used
② Configuring of the AI RTD: 

→ Activation of the reference junction
→ Specifying the slot and channel of the AI RTD

 

Special characteristics to be noted when assigning parameters for reference junctions  
The process of assigning parameters for reference junctions will be explained based on the 
example of a resistance thermometer with a Pt 100 climatic range that is used for measuring 
the reference junction temperature.

To assign parameters for the reference junction, follow these steps: 

1. In the ET 200S device view, insert an analog electronics module, for example a 2AI RTD HF.

2. Select the module on the rack.

3. Under "Properties > Inputs" in the inspector window, set a channel for the reference 
junctions function to the "RTD-4L Pt 100 climatic range" measuring range.

4. Select the ET 200S.

5. Under "Properties > Module parameters > Reference junctions" in the inspector window, 
select the "Reference junction" check box and specify the slot and channel number of the 
relevant RTD module.

6. Insert the analog electronics module for measuring the temperature using a thermocouple 
(TC module) and parameterize it with the reference junction number of the RTD module.

Additional information
For additional information on the various types and uses of ET 200S modules, please refer to 
the operating instructions and the manual titled "ET 200S Distributed I/O System".

For additional information on analog value processing, please see the documentation for the 
ET 200S distributed I/O system.
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Packing addresses

Introduction 
DP slaves and I/O devices from the ET 200S family are configured in the same way as other 
modular DP slaves and I/O devices. As well as supporting all the standard modular DP slave 
and I/O device functions, the ET 200S also offers the "Pack addresses" function:

When digital electronics modules requiring an address space of 2 or 4 bits are inserted into 
the device view, they will initially be spread over a total area of 1 byte. However, the address 
area actually occupied can be compressed after configuration using the "Pack addresses" 
function. 

 Initial state After "Pack addresses"
Module I address I address
2DI (2-bit) Byte 10 10.0...10.1
4DI (4-bit) Byte 11 10.2...10.5

Requirements
● You are in the device view.

● An ET 200S, for example an IM 151-1, must be present.

● A pair of digital electronics modules, for example 2DI AC120V ST, must be inserted into 
the slots.

Packing addresses   
To pack addressed, follow these steps:

1. Select the electronics modules whose addresses are to be packed. The following options 
are available for selecting multiple electronics modules:

– Press and hold down <Shift> or <Ctrl> while clicking the relevant electronics modules.

– Click off the rack and select the required electronics modules by drawing round them 
with the mouse.

2. Click "Pack addresses" in the shortcut menu for the selected electronics modules.

The address areas for inputs, outputs and motor starters are packed separately. The packed 
addresses will be displayed in the I address and Q address columns of the device overview.
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How packed addresses are generated and structured  
If you make use of the "Pack addresses" function, the addresses of the selected electronics 
modules will be packed in accordance with the following rules:

● The start of the address area is determined by the lowest address of the selected electronics 
modules: X.0

● If the bit address is not "0", then the next (free) byte address as of which the selected area 
can be compacted will be selected automatically: (X+n).0

● If no coherent area exists, the addresses will be automatically packed into any available 
address gaps.

Electronics modules with packed addresses and the same byte address form a packing group.

Unpacking addresses  
To unpack addressed, follow these steps:

1. Select one or more electronics modules with packed addresses.

2. Click "Unpack addresses" in the shortcut menu for the selected electronics modules.

The packing groups of the selected electronics modules will be disbanded and the packed 
addresses for the relevant electronics modules unpacked.

The packing group will also be disbanded and the packed addresses unpacked in the following 
cases: if you delete electronics modules from a packing group, move electronics modules out 
of a packing group or insert electronics modules on a free slot within a packing group.

The start addresses of the unpacked electronics modules will be assigned to the next available 
byte addresses in each case.

Special characteristics of electronics modules with packed addresses
The following special characteristics apply to electronics modules with packed addresses:

● As far as the CPU is concerned, there is no way of assigning a slot for the electronics 
module. Consequently, the instruction GADR_LGC (SFC 5) outputs error information 
W#16#8099 "Slot not configured" for the actual slot of the electronic module.

● The instruction LGC_GADR (SFC 49) and SZL-ID W#16#xy91 "module status information" 
cannot be evaluated for an electronics module.

● The electronics module receives an additional diagnostics address via the DPV1 function, 
because otherwise the packed addresses would prevent interrupts from being assigned as 
far as the CPU is concerned.

● The "Insert/remove interrupt" is not possible. This is because the "Pack addresses" and 
"Insert/remove interrupt" functions are mutually exclusive. 

Configuring option handling with standby modules
You can use the option handling function to prepare the ET 200S with PROFIBUS interface 
for future expansions (options). This section describes option handling with standby modules. 
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You do this by assembling, wiring, configuring, and programming the maximum configuration 
envisaged for the ET 200S and by using cost-effective standby modules (138-4AA00 or 
138-4AA10) during assembly until it becomes time to replace them with the necessary 
electronics modules.

 

 Note

The ET 200S can be completely factory-wired with the master cabling, as no connection 
exists between a standby module and the terminals of the terminal module (and, in turn, to 
the process).

 

Requirement
● ET 200S interface module

– IM 151-1 STANDARD (6ES7 151-1AA03-0AB0 or higher)

– IM 151-1 FO STANDARD (6ES7 151-1AB02-0AB0 or higher)

● Power module with option handling

– PM-E DC24..48V

– PM-E DC24..48V/AC24..230V

Procedure  
To activate option handling, follow these steps:

1. Select the IM 151-1 in the device view and enable it in "Option handling" check box under 
"Properties > General >  Option handling" in the inspector window.

2. Select the numbered check boxes for the slots that are initially to accommodate the standby 
modules prior to the future electronics modules.

3. Select the power module in the device view and enable it in the "Option handling" check 
box under "Properties > Addresses" in the inspector window. Reserve the necessary 
address space for the control and check-back interface in the process image output (PIQ) 
and process image input (PII).

The assembled standby modules can be replaced with the configured modules at a later date 
without having to modify the configuration.

 

 Note

The addresses for these interfaces are reserved as soon as you activate option handling on 
the power module. The "Option handling" function must also be activated on the DP slave 
(IM 151-1 STANDARD Interface Module). If it is not activated, the addresses reserved for the 
control and check-back interface will be released again.

Note that activating and deactivating the option handling function repeatedly can change the 
address of the control and check-back interface.

Option handling may be activated for one PM-E DC24..48V or one PM-E DC24..48V/
AC24..230V Power Module only.
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Additional information
For additional information on the assignment and significance of bytes within the process 
image, option handling with PROFIBUS and the use of standby modules, please refer to the 
documentation for the ET 200S distributed I/O system.

How option handling works during startup
If "Startup when expected/actual config. differ" is not available, the ET 200S will still start up 
if a standby module is inserted instead of the configured electronics module and option 
handling has been activated for the slot concerned. 

How option handling works during operation
During operation, the option handling mode varies in accordance with the following:

● Option handling enabled for a slot: 
Either the standby module (option) or the configured electronics module can be plugged 
into this slot. If any other kind of module is present on this slot, diagnostics will be signaled 
(no module/incorrect module).

● Option handling disabled for a slot: 
Only the configured electronics module can be plugged into this slot. If any other kind of 
module is present, diagnostics will be signaled (no module/incorrect module).

Standby module substitute values  
● Substitute value for digital inputs: 0

● Substitute value for analog inputs: 0x7FFF

Control and evaluation in the user program
The ET 200S is equipped with a control and feedback interface for the "Option handling" 
function. 

The control interface is located in the process image output (PIQ). Each bit in this address 
area controls one of the slots from 2 to 63: 

● Bit value = 0: Option handling parameterized. Standby modules are permitted.

● Bit value = 1: Option handling canceled. Standby modules are not permitted on this slot.

The check-back interface is located in the process image input (PII). Each bit in this address 
area provides information about the modules that are actually plugged into slots 1 to 63: 

● Bit value = 0: This slot has the standby module, an incorrect module or no module plugged 
into it.

● Bit value = 1: The configured module is plugged into this slot.

See also
Which modules support option handling? (http://support.automation.siemens.com/WW/view/
en/22564754)
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Configuring option handling without standby modules
You can use the option handling function to prepare the ET 200S for future expansions 
(options) without installing standby modules. This section describes option handling without 
standby modules.

 

 Note
ET 200S with PROFINET interface

This description refers to the ET 200S with PROFIBUS interface. In principle, option handling 
for ET 200S with PROFINET interface functions as described here without standby modules. 
PN interface modules are to be used instead of the DP interface modules listed here. You 
can find additional information about option handling for ET 200S with PROFINET interface 
in the corresponding manuals.

 

Requirement
● ET 200S interface module 

– IM 151-1 HIGH FEATURE (6ES7151-1BA02 or higher)

– IM 151-1 STANDARD (6ES7 151-1AA05-0AB0 or higher)

● Power module with option handling

– PM-E DC24..48V

– PM-E DC24..48V/AC24..230V
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Procedure  
To activate option handling, follow these steps:

1. Select the IM 151-1 in the device view and enable it in "Option handling" check box under 
"Properties > General >  Option handling" in the inspector window.

2. Select the power module in the device view and enable it in the "Option handling" check 
box under "Properties > Addresses" in the inspector window. Reserve the necessary 
address space for the control and check-back interface in the process image output (PIQ) 
and process image input (PII).

3. Configure the slave's maximum configuration. The selection/clearing of options is controlled 
via the user program. 

 

  Note

The addresses for these interfaces are reserved as soon as you activate option handling 
on the power module. The "Option handling" function must also be activated on the DP 
slave (IM 151-1 interface module). If it is not activated, the addresses reserved for the 
control and check-back interface will be released again.

Note that activating and deactivating the option handling function repeatedly can change 
the address of the control and check-back interface.

Option handling may be activated for one PM-E DC24..48V or one PM-E DC24..48V/
AC24..230V Power Module only.

 

Additional information
For additional information on the assignment and significance of bytes within the process 
image, option handling with PROFIBUS and the use of standby modules, please refer to the 
documentation for the ET 200S distributed I/O system.

Control and evaluation in the user program
The ET 200S is equipped with a control and feedback interface for the "Option handling" 
function. 

The control interface is located in the process image output (PIQ). Each bit in this address 
area controls one of the slots from 1 to 63: 

● Bit value = 0: Slot is not available in the actual configuration.

● Bit value = 1: Slot is available in the actual configuration.

The check-back interface is located in the process image input (PII). Each bit in this address 
area provides information about the modules that are actually plugged into slots 1 to 63: 

● Bit value = 0: Slot belongs to an option that is not available or module status is faulty.

● Bit value = 1: The configured module is plugged into this slot.

See also
Sample applications for ET 200S, option handling without standby module (http://
support.automation.siemens.com/WW/view/en/29430270)
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Configuring the ET 200S in DPV1 mode
PROFIBUS DPV1 enables you to access extended PROFIBUS functions.

Requirement
● You must be in network view.

● A DP master with DPV1 functionality must be available.

● A master-slave connection must be established with PROFIBUS.

Procedure   
To switch the DP slave over to DPV1, follow these steps:

1. Select the DP slave.

2. Under "Properties > Module parameters" in the Inspector window, select "DPV1" mode 
from the "DP interrupt mode" drop-down list.

or

1. Select the DP master.

2. In the I/O communications table, select the row with the connection between the DP master 
and the desired DP slave.

3. Under "Properties > Module parameters" in the Inspector window, select "DPV1" mode 
from the "DP interrupt mode" drop-down list.

Special characteristics
The parameters are subject to interdependencies, which are outlined below: 

Parameter DPV0 mode DPV1 mode
Operation when target 
configuration does not match 
actual configuration

Fully available Fully available

Diagnostics interrupt (OB 82) Not available, not set Fully available
Hardware interrupt (OB 40 to 47) Not available, not set Fully available
Insert/remove interrupt (OB 83) Not available, not set Only available when addresses 

are not packed.
"Startup when target 
configuration does not match 
actual configuration" is activated 
automatically along with an 
insert/remove interrupt.

Interrupts in the case of modules with packed addresses  
If the module is capable of triggering interrupts and the bit address is not equal to 0 because 
of packed addresses, you will need to assign a diagnostics address in the ET 200S address 
dialog. 
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The diagnostics address is required for the purpose of assigning a DPV1 interrupt to the module 
as an interrupt trigger. The CPU will only be able to assign an interrupt correctly and store 
information on the interrupt in the interrupt OB start information/in the diagnostics buffer if the 
module concerned has this "unpacked" address. In this context, the CPU cannot make use of 
"packed" addresses. 

From the point of view of interrupt processing (interrupt OB), this means the module will have 
the assigned diagnostics address, but from the point of view of processing the input and output 
data in the user program, the module will have the packed addresses.

 

 Note

When the module addresses are packed, the insert/remove interrupt for the ET 200S is 
unavailable. 

 

Using GSD files

GSD revisions

What you need to know about GSD revisions   
The properties of DP slaves are made available to configuration tools by means of GSD files.

Functional enhancements in the area of the distributed I/O will have an effect on the GSD 
specification, for example, they will require the definition of new keywords.

This results in the versioning of the specification. In the case of GSD files, the version of the 
specification on which a GSD file is based is called a "GSD revision".

From GSD revision 1, the GSD revision must be included as a keyword "GSD_revision" in 
GSD files. GSD files without this keyword will therefore be interpreted by configuration tools 
as GSD revision "0".

GSD files can be interpreted up to GSD revision 5. This means that DP slaves that support 
the following functions, for example, will be supported: 

● Diagnostic alarms for interrupt blocks

● Isochronous mode and constant bus cycle time 

● SYNC/FREEZE

● Clock synchronization for DP slaves

Installing the GSD file

Introduction
A GSD file (device data file) contains all the DP slave properties. If you want to configure a DP 
slave that does not appear in the hardware catalog, you must install the GSD file provided by 
the manufacturer. DP slaves installed via GSD files are displayed in the hardware catalog and 
can then be selected and configured.
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Requirement
● The hardware and network editor is closed.

● You have access to the required GSD files in a directory on the hard disk.

Procedure  
To install a GSD file, proceed as follows:

1. In the "Options" menu, select the "Install device master data files" command.

2. In the "Install device master data files" dialog box, choose the folder in which you want to 
save the GSD files.

3. Choose one or more files from the list of displayed GSD files.

4. Click on the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.
Any problems during the installation can be tracked down using the log file.

You will find the new DP slave installed by means of the GSD file in a new folder in the hardware 
catalog.

 

 Note

Installation of GSD file cannot be undone.
 

Configuring GSD-based DP slave
DP slaves that you have inserted through installation of a GSD file can be selected as usual 
via the hardware catalog and inserted in the network view. If you want to insert the modules 
of the GSD-based DP slaves, you must take into account some particular details.

Requirement
● You have installed a DP slave using a GSD file.

● You have inserted the head module in the network view in the usual manner.

● The device overview opens in the device view.

● The hardware catalog is open.

Procedure 
To add the modules of a GSD-based DP slave, proceed as follows:

1. In the hardware catalog, navigate to the modules of the GSD-based DP slave.
GSD-based DP slaves, also referred to as DP standard slaves, can be found in the "Other 
field devices" folder of the hardware catalog.

2. Select the desired module.
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3. Use drag-and-drop to move the module to a free space in the device overview.

4. Select the module in the device overview to edit parameters.

You have now inserted the module in a free slot of the GSD-based DP slave and can edit its 
parameters.

 

 Note

You can see only the GSD-based DP slave in the graphic area of the device view. The added 
modules of GSD-based DP slaves are only found in the device overview.

 

Preset configuration
For modules with an adjustable preset configuration, you can change this configuration in the 
inspector window under "Properties > Preset configuration". 

8.1.4.7 Configurations for PROFINET IO

What you need to know about PROFINET IO

What is PROFINET IO?

PROFINET IO   
PROFINET is an Ethernet-based automation standard of PROFIBUS Nutzerorganisation e.V. 
(PNO) which defines a manufacturer-neutral communication, automation and engineering 
model.

Objective
The objective of PROFINET is:

● Integrated communication via field bus and Ethernet

● Open, distributed automation

● Use of open standards

Architecture
The PROFIBUS User Organisation e.V. (PNO) has designated the following aspects for 
PROFINET architecture:

● Communication between controllers as components within distributed systems.

● Communication between field devices, such as I/O devices and drives.
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Implementation by Siemens
The demand for "Communication between controllers as components within distributed 
systems" is implemented by "Component Based Automation" (CBA). Component Based 
Automation is used to create a distributed automation solution based on prefabricated 
components and partial solutions. 

The demand for "Communication between field devices" is implemented by Siemens with 
"PROFINET IO". Just as with PROFIBUS DP, the complete configuration and programming 
of the components involved is possible using the Totally Integrated Automation Portal. 

The following sections deal with the configuration of communication between field devices 
using PROFINET IO.

Overview of RT classes

RT classes in PROFINET IO   
PROFINET IO is a scalable, real-time communication system based on Ethernet technology. 
The scalable approach is reflected in several real-time classes:

● RT: Transmission of data in prioritized, non-isochronous Ethernet frames. The required 
bandwidth is within the free bandwidth area for TCP/IP communication.

● IRT: Isochronous transmission of data with high stability for time-critical applications (for 
example, motion control). The required bandwidth is from the area of bandwidth reserved 
for cyclic data.

Depending on the device, not all real-time classes are supported. 

Connecting existing bus systems

Connection of PROFINET and PROFIBUS       
PROFINET IO and PROFIBUS DP can be connected with each other as follows: 

● via Industrial Ethernet: 
To connect the two network types, Industrial Ethernet (plant control level) and PROFIBUS 
(cell level/field level), use the IE/PB link, for example.

● via Industrial Wireless LAN: 
PROFIBUS devices, for example, can be connected to PROFINET IO via a wireless LAN/
PB link. This allows existing PROFIBUS configurations to be integrated into PROFINET.

AS interface devices can be connected by an IE/AS-i link PN IO to the interface of a PROFINET 
device. This allows the existing AS-i network to be integrated into PROFINET.

The following figure shows the connection of a PROFIBUS subnet via a PROFINET device 
with proxy functions. 
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① PROFINET devices
② PROFINET device with proxy functions (for example, IE/PB link)
③ PROFIBUS devices

PROFINET device with proxy functions used as proxy for a PROFIBUS device
The PROFINET device with proxy functions is the proxy for a PROFIBUS device on the 
Ethernet. The proxy functionality enables a PROFIBUS device to communicate with all devices 
on the PROFINET and not just with its master.

Existing PROFIBUS systems can easily be integrated into PROFINET communication using 
the proxy functions.

If, for instance, you connect a PROFIBUS device via an IE/PB link to PROFINET, the IE/PB 
link acts as a proxy for the PROFIBUS components for communicating via PROFINET.

Configuration using IE/PB link PN IO

Configuration using IE/PB Link PN IO
You can use the IE/PB Link PN IO to connect PROFIBUS DP configurations to PROFINET 
IO. 

From the CPU perspective, the PROFIBUS DP slaves are connected to the same network as 
the IE/PB Link PN IO. These slaves have the same device name and IP address as the IE/PB 
Link PN IO, but different device numbers. Furthermore, each also has a specific PROFIBUS 
address. 

In the properties of the IE/PB link, the PROFIBUS addresses of the connected DP slaves are 
displayed in addition to the PROFINET device numbers, as this device has two addressing 
schemes. 
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Handling device numbers and PROFIBUS addresses on the master system
During placement, the same number is assigned for the PROFINET device number and the 
PROFIBUS address. 

In the Inspector window under "General Properties > PROFINET device number", you can find 
an overview of the device numbers used and the PROFIBUS addresses of an IE/PB link. The 
device number can also be changed here. You can also set that the device number and the 
PROFIBUS address should or should not always be identical. If the "PROFINET device 
number=PROFIBUS address" option is activated, you do not have to update the device number 
when the PROFIBUS address changes. 

The PROFIBUS address can be changed in the properties of the PROFIBUS device.

Restrictions
The following restrictions apply to DP slaves configured as described above on the PROFIBUS 
subnet of an IE/PB link:

● No pluggable IE/PB link

● No pluggable DP/PA link

● No pluggable Y link

● Not CiR-compliant

● No pluggable redundant slaves

● No isochronous transmission / constant bus cycle time can be configured

● SYNC/FREEZE instructions ("DPSYC_FR") of a CPU on the the Ethernet subnet for DP 
slaves behind the IE/PB-Link are not supported.

Configuration using IWLAN/PN link

Maximum number of devices in a IWLAN segment
If an Ethernet subnet is set up as wireless network (IWLAN = Industrial Wireless LAN), cyclic 
data exchange between IO controllers and IO devices is possible via a wireless route. 

On one side of the wireless route there are fixed installed access points (for example, 
SCALANCE W 788) and on the other side mobile stations (with, for example IWLAN/PB links 
with PROFIBUS devices). 

If the action radius of the mobile stations is large, it may be necessary to install several access 
points (SCALANCE W 788). Since each access point forms a segment with its wireless range, 
the IWLAN is made up of a series of segments. 

The mobile devices "on the one side" of the wireless link with their IWLAN/PB links can move 
along the segments.
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Special feature
If several IWLAN/PB links are located within a segment, they have to share the bandwidth that 
is available for wireless transmission. This leads to a lengthening of the update time for these 
devices.

Example
In the following example there are two IO devices (IWLAN/PB link) with a segment. 

If no more than a maximum of two IWLAN/PB links are present in a IWLAN segment at the 
same time, enter a "2".

① Segment 1
② Segment 2
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Configure PROFINET IO 

Addressing PROFINET devices

Assigning addresses and names to PROFINET devices
In this chapter you will learn which address and naming conventions are valid for the 
PROFINET devices.

IP addresses       
All PROFINET devices work with the TCP/IP protocol and therefore require an IP address for 
Ethernet operation. 

You can set the IP addresses in the module properties. If the network is part of an existing 
company Ethernet network, ask your network administrator for this data.

The IP addresses of the IO devices are assigned automatically, usually at CPU startup. The 
IP addresses of the IO devices always have the same subnet mask as the IO controller and 
are assigned in ascending order, starting at the IP address of the IO controller.

Device names 
Before an IO device can be addressed by an IO controller, it must have a device name. This 
procedure was chosen for PROFINET because names are easier to administer than complex 
IP addresses. 

Both the IO controller as well as IO devices have a device name. When the "Generate 
PROFINET device name automatically" option is activated, the device name is automatically 
derived from the name configured for the device (CPU, CP or IM):

● The PROFINET device name is made up of the name of the device (for example, the CPU), 
the name of the interface (only with multiple PROFINET interfaces) and optionally the name 
of the IO system:
<CPU name>.<Name of the interface>.<IO system name>
You cannot change this name directly. You change the PROFINET device name indirectly, 
by changing the name of the affected CPU, CP or IM in the general properties of the module. 
This PROFINET device name is also displayed, for example, in the list of accessible 
devices. If you want to set the PROFINET device name independently of the module name, 
you have to deactivate the "Generate PROFINET device name automatically" option. 

● A "converted name" is generated from the PROFINET device name. This is the device 
name that is actually loaded into the device.
The PROFINET device name is only converted if it does not comply to the rules of IEC 
61158-6-10. You cannot change this name directly either. 
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Rules for the converted name
The rules for the converted name are listed in the following section. If the converted name is 
not different from the name of the module, the name of the module must comply with this rule. 

● The name consists of one or more labels , which are separated by a dot [.].

● Restricted to a total of 240 characters (lower case letters, numbers, dash, or dot)

● A name component within the device name, which means a character string between two 
dots, must not exceed 63 characters.

● A name component consists of the characters [a-z, 0-9].

● The device name must not begin or end with the "-" character.

● The device name must not begin with a number.

● The device name form n.n.n.n (n = 0, ... 999) is not permitted.

● The device name must not begin with the string "port-xyz" or "port-xyz-abcde" (a, b, c, d, 
e, x, y, z = 0, ... 9).

Example of device names
device-1.machine-1.plant-1.vendor
If you assign this name to a CPU, for example, STEP 7 will not convert it since it conforms to 
the rules described above.

Device number   
In addition to the device name, a device number is also automatically assigned when an IO 
device is plugged in. You can change this number. 

Devices in the PROFINET subnet
In a PROFINET subnet the maximum allowable number of devices is monitored during 
configuration. 

See also
Assigning the device name and IP address (Page 1023)

Retentivity of IP address parameters and device names (Page 1031)

Assigning the device name and IP address

Assigning an IP address and subnet mask for an IO controller the first time       
There are various options for this. 

During parameter assignment of the PROFINET interface you must specify if the IP address 
is set in the project (which means in the hardware configuration) or if the IP address is to be 
set on the device. 

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 1023



 

Assignment of an IP address Comments
Option "IP address is set in the project":
The IO controller receives the IP address by 
loading the hardware configuration, for example, 
via one of the PROFINET interfaces, by means of 
the PROFIBUS interface or via the MPI interface. 

When the hardware configuration is loaded to the 
IO controller (e.g. CPU), the IP address and the 
device name, if set, are also loaded. 
Example PROFINET interface: 
1. Connect your programming device/PC to the 

same network as the relevant PROFINET 
device. The interface of the PG/PC must be set 
to TCP/IP (Auto) mode. 

2. Have a list of accessible devices displayed. 
3. Select the target device by using its MAC 

address and load the hardware configuration 
including the configured IP address (IP 
address is then saved retentively).

If your PROFINET device has an MPI or 
PROFIBUS DP interface, connect your 
programming device/PC directly to the PROFINET 
device via the MPI or PROFIBUS DP interface. 
The configured IP address is applied when the 
hardware configuration is loaded.

Option "IP address is set directly at the device":
● Assign online
● Assignment by user program (instruction 

IP_CONFIG for S7-300/400, T_CONFIG for 
S7-1200/1500) 

● Assign via CPU display (S7-1500)
● Higher-level IO controller makes assignment 

(only with I-devices)

If you have selected this option in the properties 
of the PROFINET interface, the IP address can be 
assigned by the online and diagnostics editor, by 
the primary setup tool, or by the user program 
("IP_CONFIG" instruction). 
This option is set automatically if the option 
"Multiple use IO system" has been enabled in the 
properties of the PROFINET IO system (standard 
machine project).
In case of an S7-1200-CPU, make sure that 
access to the CPU is not protected by a password. 
If the CPU is write-protected, no IP address and 
no device name can be assigned directly on the 
device.

Commissioning a PROFINET interface
Further details of how to commission a PROFINET interface can also be found in the operating 
instructions for the PROFINET devices of the SIMATIC family. 

Assignment of device name for IO devices when the "Support device replacement without exchangeable 
medium" option is selected   

For IO controllers with the "Support device replacement without exchangeable medium" option 
selected, you do not have to assign device names to the IO devices locally, for example in the 
event of device replacement. Another application is automatic commissioning, in which the 
CPU automatically assigns the device name and IP address parameters to the IO devices 
during startup. 
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Requirement: The ports of the devices are interconnected, and the devices involved support 
LLDP. The devices have been put into delivery state or - for S7-1500 CPUs version V1.5 and 
higher - the "Permit overwriting device names of all assigned IO devices" option is selected 
for the IO controller ("Ethernet addresses" area, "PROFINET" section of the properties of the 
PROFINET interface). 

Assignment of device name and address for an IO device  
The following graphic illustrates the process for assigning the device name and address. This 
process does not apply when the "Support device replacement without exchangeable medium" 
option is selected. 

① Each device receives a name; STEP 7 automatically assigns an IP address. 
② From the name, STEP 7 generates a PROFINET device name that you assign to an IO device 

online (MAC address) and that is written to the device. 
③ You load the configuration to the IO controller.
④ The IO controller assigns the appropriate IP address to the IO device with the assigned 

PROFINET device name during startup.
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Changing the device name and IP address
You can change the name and IP address manually. The device name must first be changed 
in the configuration in order to subsequently assign it to the IO device via the memory card or 
online with programming device/PC. 

Offline with memory card:

1. Place the configured data (device name: for example, turbo-3) for the IO device on the 
MMC in the PG/PC. Use the command "SIMATIC Card Reader > Save Device Name to 
Memory Card" in the "Project" menu for this.

2. Then insert the MMC into the IO device. The IO device automatically adopts the configured 
device name.

Online with programming device/PC:

1. Connect the programming device/PC directly to the Ethernet subnetwork via the 
PROFINET interface. 

2. Select the subnet in the network view and then select the "Assign device name" shortcut 
command. 

3. In the "Assign PROFINET device name" dialog box, select the suitable PG/PC interface to 
connect to the Ethernet subnet. All configured PROFINET device names are in the top drop-
down list. Select a PROFINET device name from it and select the IO device to receive this 
device name from the table at the bottom. You can filter the display of devices in the table 
according to various criteria. 

4. You can easily identify the device using the "Flash LED" button. 

5. Click "Assign name". 

The IO controller recognizes the IO device by its device name and automatically assigns the 
configured IP address to it.

IP address assignment for special IO devices
Special IO devices, for example, SCALANCE X, S7-300 CPs, support the option of assigning 
the IP addresses not from the IO controller during startup. In this case, the IP address is 
assigned in a different way. The option is called "IP address is set directly at the device". For 
additional information, refer to the manual of the respective PROFINET device of the SIMATIC 
device family.

Another special case is the option "IP address is set by the IO controller during runtime" in the 
"IP protocol" area of the Ethernet address properties of an IO device. This option is set 
automatically when the option "Multiple use IO system" is selected for a standard machine 
project in the associated PROFINET IO system. In this case, an adapted IP address is not 
assigned by the IO controller until the IO controller itself has received a local IP address. 
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Requirement for additional procedures when assigning IP address and device name
If the IO device, as described above, should not obtain the IP address or device name from 
the IO controller, proceed as follows:

1. Select device or network view.

2. Open the properties of the respective PROFINET device and select the area "PROFINET 
interface [X1]" > "Ethernet addresses".

3. Select the option "IP address is set directly at the device" under "IP parameters" or the 
option "Permit setting of PROFINET device name directly on the device" under 
"PROFINET".

Rules 
If the "IP address/device name is set directly at the device" option is used for a PROFINET 
device, note the following: 

● The subnet part of the IP address of the IO device must match the subnet part of the IP 
address of the IO controller.

● The corresponding PROFINET device cannot be used as a gateway.

See also
Assigning a name in the online and diagnostics view opened via "Accessible devices" 
(Page 1239)

Enabling device replacement without exchangeable medium (Page 1042)

Example of the assignment of the device name
In this example you assign device names to a PROFINET IO controller and a PROFINET IO 
device. To make assignment easier, the device names should also contain the names of the 
PROFINET IO system. 

Requirement
● You must be in the network view.

● A CPU 1214C (V2.0 or higher) must be available in the network view.

● An interface module IM 151-3PN exists.

● The PROFINET interfaces of both modules are networked.
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Procedure         
To assign the names, follow these steps: 

1. Select the CPU.
Make sure that you have selected only the CPU and not the complete device! 

2. Assign the name "myController" in the Inspector window, under "General".

3. Select the interface module.
Ensure that you have selected only the interface module and not the complete ET 200S 
device.

4. Assign the name "Device_1" in the Inspector window, under "General".

5. Right-click on the PROFINET IO system and select the "Properties" command.
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6. Assign the name "Plant_section1" to the IO system and select the check box "Use name 
as extension for PROFINET device names".

7. You can find the automatically generated PROFINET device names at the selected device 
in the Inspector window, at "PROFINET interface".

The PROFINET device name corresponds to the name of the module (with the name of 
the IO system as extension) with the difference that only lower case text is used. 
Background: No distinction is made between upper and lower case ("case insensitive") for 
the storing of the name.
If you want to specify the device name independently of the module name, you have to 
deactivate the "Generate PROFINET device name automatically" option. The PROFINET 
device name can be edited in this case.
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The converted name is displayed below. This is the name that is automatically generated 
from the PROFINET device name and satisfies the DNS conventions. If you work with STEP 
7, you do not require this name. This name is displayed here as a check and corresponds 
to the name that is stored in the device. If you work with other tools that are able to record 
the data exchange and read the actual device names, then you find the converted names. 

Other special features
For PROFINET devices with multiple PROFINET interfaces, the name of the interface is 
attached to the name of the module, separated by a dot. 

Example: 

● Name of the module: myController

● Name of the interface: Interface_1

● PROFINET device name: mycontroller.interface_1

Assign device name via memory card

Introduction
You can configure the device names of PROFINET IO devices offline. To do this, store a 
configured device name on a memory card and then insert the card into the appropriate IO 
device. 

If an IO device has to be completely replaced due to a device defect, the IO controller 
automatically reconfigures the new device. Using the memory card, a device can be replaced 
without a programming device. 

Requirements
● The programming device has a card reader for memory cards.

● The IO device must support the assignment of the device name via memory card.

● The station and its PROFINET IO system is configured.

Procedure
To store a device name on a memory card, follow these steps:

1. Insert the memory card into the card reader.

2. Select the IO device whose device name is to be assigned by the memory card.

3. Select the "Card reader > Save Device Name to Memory Card" command in the "Project" 
menu.
If the memory card is not empty, a message will be issued informing you of this and you 
will have the option to delete the card.
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Retentivity of IP address parameters and device names
The retentivity of IP address parameters (IP address, subnet mask, router setting) and device 
name depends on how the address is assigned.           

The non-retentive, temporary assignment means:

● IP address parameters and device name remain valid for the following time period:

– Until the next POWER OFF

– Until the next memory reset

– Until termination of the online connection (for example, after loading the program)
After POWER OFF / POWER ON or a memory reset, the CPU can only be accessed 
via the MAC address.

If the IP address parameters are not retentive, communication based on the IP protocol can 
no longer take place after the above described events (for example, after POWER OFF/
POWER ON).

The assignment of a temporary IP address also deletes retentively saved IP address 
parameters.

Assigning IP address parameters and device name non-retentively
IP address parameters and device name are not retentive in the following cases:

● A temporary IP address that is not retentive is implicitly assigned with the "Accessible 
devices" function, if the device (e.g. CPU) does not yet have an IP address.

● The device is a "normal" IO controller (i.e., not an I-device), and it is specified in the user 
program ("IP_Conf" instruction) that the IP address parameters/device name are not to be 
retentive.

Assigning IP address parameters and device name retentively
IP address parameters and device name are retentive in the following cases: 

● In the properties of the PROFINET interface, it is specified that the IP address parameters 
are set in the project ("Set IP address in the project" option).

● In the properties of the PROFINET interface, it is specified that the IP address is to be set 
on the device.

– Once the configuration is loaded, the IP address parameters and the device name are 
assigned via STEP 7 or a setup tool such as PST (STEP 7: online and diagnostic function 
"Assign IP address"). The assigned IP address parameters are retentive.

– The device is a "normal" IO controller (i.e., not an I-device), and it is specified in the user 
program ("IP_Conf" instruction) that the IP address parameters/device name are to be 
retentive.
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Special features of the I-device
In the properties of the PROFINET interface of the I-device, it is specified that the IP address 
parameters are to be set on the device. The IP address parameters for the I-device are 
assigned by the higher-level IO controller.

● If prioritized startup is set, the IP address parameters are retentive.

● If no prioritized startup is set, the IP address parameters are not retentive.

Recommendation
If possible, use the "Set IP address in project" option and specify an appropriate IP address. 
In this case, the IP address is assigned retentively. 

Resetting of retentive IP address parameters and device names 
Retentive IP address parameters and device names are reset via the online and diagnostic 
function "Reset to factory settings". 

 

 Note
Consequences of reassignment of IP address parameters on top of existing IP parameters
● The temporary assignment of IP address parameters/device names results in a reset of 

any retentively saved IP address parameters/device names.
● With a fixed assignment of IP address parameters/device names, previously retentively-

saved parameters are replaced by the newly assigned parameters.
 

 Note
Reuse of devices 

Execute the "Reset to factory settings" before you install a device with retentive IP address 
parameters and device name in another subnet or system or before you place it in storage.

 

Creating a PROFINET IO system
A PROFINET IO system is comprised of a PROFINET IO controller and its assigned 
PROFINET IO devices. 

To create a PROFINET IO system you require an IO controller (for example, CPU 1214C) and 
one or more IO devices (for example, a head module from the distributed I/O family ET 200S). 

As soon as you connect an IO controller to an IO device, a controller-device link is established.
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Procedure  
To create a PROFINET IO system, proceed as follows:

1. Use drag-and-drop to pull an IO controller from the hardware catalog (for example, CPU 
1214C) into the free area of the network view.
The IO controller is created in the project.

2. Use drag-and-drop to move an IO device from the hardware catalog (for example, ET 200S) 
into the free area of the network view.

3. Click on the PROFINET interface of the IO controller or the IO device.

4. Hold down the mouse button and draw a connecting line between this selected interface 
and that of the partner device.
A subnet with an IO system between the IO controller and the IO device is created. 

5. If required, adapt the properties of the Ethernet subnet or the IO controller (for example, IP 
address) under "Properties" in the inspector window.

 

Handling PROFINET IO systems
Using shortcut menu commands, you can delete PROFINET IO systems, create new ones or 
even connect the interface to another subnet from within the network view. 

An existing PROFINET configuration can thereby be corrected in the network view. 

Create new PROFINET IO system for IO controller
To create a new PROFINET IO for an IO controller, proceed as follows: 

1. Make sure that no IO system is already assigned to the IO controller. If an IO system is 
already assigned to the IO controller, the "Assign IO system" shortcut menu command is 
disabled.

2. Select the PROFINET interface and then select the "Assign IO system" shortcut menu 
command.

A new PROFINET IO system is created at the IO controller and you can assign IO devices to 
this IO system. 
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Disconnecting PROFINET IO devices from PROFINET IO system   
To disconnect an already networked PROFINET IO device from its PROFINET IO system, 
follow these steps:

1. Click on the PROFINET interface of an IO device.

2. Select the "Disconnect from IO system" shortcut menu command.
The IO device that was assigned to this IO system is then no longer assigned to it. 

You can create a new IO systems and can assign each of the non-assigned IO devices to an 
IO controller. 

Assign PROFINET IO devices to other IO controllers
Existing PROFINET IO systems can be easily reconfigured in the network view: 

1. Select the interface of an IO device and then select the shortcut menu. You have the 
following options here:

– Assign a new subnet to the IO device or disconnect it from the existing subnet

– Assign a new IO controller to the IO device

– Assign a new IO system to the IO device or disconnect it from the existing subnet

2. To assign another IO controller to the IO device, select the "Assign to new IO controller" 
shortcut menu command.
If there is no connection, a subnet is automatically created and the IO device is assigned 
to the IO system of the new IO controller. 

Tip: Quick configuration of IO systems
If the IO system has a lot of IO devices, assign all IO devices placed by drag-and-drop operation 
to an IO controller on one step.

Requirements   
IO controller and IO devices are placed in the network view.
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Assign IO devices to an IO system
To do this, follow these steps:

1. Select an appropriate zoom factor so that you can see as many IO devices as possible in 
the network view.

2. Arrange the IO devices in not more than of two rows.

3. Select all IO interfaces (not all devices) with the mouse cursor. This only works if you begin 
to drag the mouse cursor outside of the first IO device and release the mouse button at the 
last IO device (selection with the lasso).

4. Select the shortcut menu "Assign new IO controller" and select the corresponding IO 
interface of the IO controller in the subsequent dialog.

5. The IO devices are automatically networked with the IO controller and combine with it to 
form an IO system.

 

  Note

When an IO system is highlighted, you can double-click on an IO device in the hardware 
catalog and thereby quickly add additional IO devices. Result: The IO device is 
automatically added to the highlighted IO system.
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Interconnecting ports
If an IO device is assigned to an IO controller, this does not yet specify how the ports are 
connected to each other. 

Although a port interconnection is not required to make use of the Ethernet/PROFINET 
functions, it does offer the following advantages:

● A target topology is specified with the port interconnection. Based on an online-offline 
comparison, it is possible to conduct a target-actual comparison with all devices that support 
this function.

● Only with IRT communication: If a port interconnection is configured, STEP 7 can determine 
the required bandwidth more precisely. As a rule, this leads to a higher performance.

Make sure that no invalid ring structures occur through the interconnection of ports. 

Port interconnection is only advisable for devices that support the topology configuration. 

Interconnecting ports in the Inspector window  
To interconnect ports, follow these steps: 

1. Select the Ethernet/PROFINET device or the Ethernet/PROFINET interface.

2. Navigate to the port property "Port interconnection".
When the Ethernet/PROFINET interface is selected, you can find this setting in the 
Inspector window as follows: Properties > General > Advanced Options > Port [...] > Port 
Interconnection. 

3. In the "Local port" section, you can find the settings at the local port. In the case of fiber-
optic cable you can, for example, set the cable names here.
In the "Partner port" section, click on the black triangle in the "Partner port" box to display 
and select the available partner ports. 

4. If the port interconnection is a port interconnection with copper as medium and the devices 
support IRT communication, you can also set cable length and signal transit time.

If the Ethernet/PROFINET interface was not networked, it is automatically networked by this 
action. In the properties of the subnet you can set whether this subnet should or should not 
be used for the networking. 

See also
Overview (Page 634)

Setting the send clock

Requirements to change the send clock at the PROFINET device
No IRT (Isochronous Realtime) should be configured. In detail, this means: 

● No device must be configured at the IO system as a sync slave or sync master.

● All devices at the IO system must be unsynchronized.
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If IRT is configured (in other words, if the IO controller is configured as sync master), the send 
clock can only be configured in the sync domain.

Procedure
To set the send clock on the PROFINET device, follow these steps:

1. Select the PROFINET IO controller in the device or network view.

2. Change the value for the shortest possible update interval in the properties of the 
PROFINET interface under "PROFINET Interface > Advanced options > Real-time settings 
> IO communication > Send clock".

The send clock is valid for all PROFINET devices at the IO system. If the synchronization role 
is set to a value other than "Unsynchronized", you can only set the send clock in the sync 
domain, in other words, centrally at the PROFINET IO system. 

Setting the update time

Update time  
An IO device / IO controller in the PROFINET IO system is supplied with new data from the 
IO controller / IO device within this time period. The update time can be separately configured 
for each IO device and determines the time interval in which data is transmitted from the IO 
controller to the IO device (outputs) as well as data from the IO device to the IO controller 
(inputs).

STEP 7 calculates the update time automatically in the default setting for each IO device of 
the PROFINET IO system, taking into account the volume of data to be exchanged as well as 
the set send clock. 

Setting the update time
If you do not want to have the update time calculated automatically, you can change the setting.

To change the update time, proceed as follows:

1. Select the PROFINET interface of the IO device in the network or device view.

2. Change the update time in the interface properties under "Advanced options > Realtime 
settings > IO cycle".

– To have a suitable update time calculated automatically, select "Automatic".

– To set the update yourself, select "Can be set" and enter the required update time in 
ms.

3. To ensure consistency between the send clock and the update time, activate the "Adapt 
update time when send clock changes" option.
This option ensures that the update time is not set to less than the send clock. 

Non-automatic setting of the send clock may result in errors if the available bandwidth is 
insufficient or if other limits are exceeded (for example, too many devices are configured). 
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Setting the watchdog time

Watchdog time 
You can configure the watchdog time for PROFINET IO devices. 

If the IO device is not supplied with input or output data (IO data) by the IO controller within 
the watchdog time, it switches to the safe state. 

Do not enter the watchdog time directly, but as "Accepted number of update cycles when IO 
data is missing". This makes setting easier because the update time can be shorter or longer, 
depending on the power of the IO device or the setting. 

The resulting watchdog time is automatically calculated from the "Accepted number of update 
cycles when IO data is missing". 

Configuring the watchdog time
To specify the watchdog time, follow these steps:

1. Select the PROFINET interface of the IO device in the network or device view.

2. In the properties of the interface, navigate to "Advanced options > Realtime settings > IO 
cycle".

3. Select the required number of cycles from the drop-down list "Trigger watchdog after # 
cycles with missing IO data". 

The watchdog time is subsequently calculated automatically based on the preset factor. It must 
not be more than 1.92 seconds.

 

 Note

The default setting should only be changed in exceptional cases, for example, during the 
commissioning phase.

 

Calculated bandwidth for cyclic IO data

Calculated bandwidth for cyclic IO data
Adherence to the maximum available bandwidth for cyclic IO data is monitored by the system. 
The maximum bandwidth depends on the send clock cycle. If the send clock cycle is greater 
than or equal to 1 ms, the maximum bandwidth is 0.5 ms. If the send clock cycle is shorter, 
the maximum available bandwidth is also reduced.

The bandwidth actually required for cyclic IO data is determined by the system based on the 
number of configured IO devices and IO modules. Furthermore, the required bandwidth 
depends on the update time that is used.

In general, the calculated bandwidth increases in the following cases:
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● There is a greater number of IO devices

● There is a greater number of IO modules

● The update times are shorter.

Maximum bandwidth for cyclic IO data depending on the send clock
The following table shows how the maximum available bandwidth for cyclic IO data reacts 
based on the send clock:

Send clock cycle Maximum bandwidth for cyclic IO data
250 µs – 468.75 µs << 125 µs
500 µs – 968.75 µs = send clock / 2
1 – 4 ms = 500 µs

Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.

Possible settings for transmission medium/duplex       
Depending on the selected device, you can make the following settings for "Transmission 
medium/duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the partner port. The "Enable autonegotiation" option is automatically 
selected by default.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.
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"Monitor" option     
This option is used to activate or deactivate the port diagnostics. Examples of port diagnostics: 
The link status is monitored, in other words, the diagnostics are generated during link-down 
and the system reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "     
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.

You must make sure the partner port has the same settings because, with this option, the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can therefore not be optimally set.

 

 Note

When a local port is interconnected, STEP 7 makes the setting for the partner port if the 
partner port supports the setting. If the partner port does not support the setting, an error 
message is generated. 

 

See also
Wiring rules for disabled autonegotiation (Page 1040)

Boundaries at the port (Page 1041)

Wiring rules for disabled autonegotiation

Requirement
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission speed

● Autonegotiation incl. autocrossing disabled

This saves you the time required to negotiate the transmission rate during startup.

If you have disabled autonegotiation, you must observe the wiring rules.
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Wiring rules for disabled autonegotiation         
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.

Rules for cabling
You can connect several IO devices in a line using a patch cable (one-to-one wiring of both 
connectors). To do this, you connect port 2 (P2) of the IO device to port 1 (P1) of the next IO 
device. The following graphic gives an example with two IO devices.

Boundaries at the port

Requirement
To use boundaries, the respective device must have more than one port. If the device for 
PROFINET does not support boundary settings, the corresponding parameters are disabled.
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Enable boundaries        
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of detection of accessible devices"
DCP frames for detection of accessible devices are not forwarded. Devices located behind 
this port are no longer displayed in the project tree under "Accessible devices". Devices 
located behind this port can no longer be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) for topology detection are not forwarded.

● "End of sync domain"
Sync frames transmitted for synchronization of devices within a sync domain are not 
forwarded. 
For example, if you operate a PROFINET device with more than two ports in a ring, you 
should prevent the sync frames from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device of the other sync domain. 

Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been defined for the port, the following check boxes cannot be used:

– "End of detection of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

Enabling device replacement without exchangeable medium

Replacing an IO device without exchangeable medium    
It is often necessary to replace IO devices in automation systems. The IO devices are generally 
assigned a device name by either inserting an exchangeable medium or via the programming 
device. The IO controller uses this device name to identify the IO device.

Subject to certain conditions, IO devices can also receive their device names without the 
insertion of an exchangeable medium (e.g., memory card) or without a programming device. 
For this purpose, the IO controller uses Ethernet mechanisms (LLDP protocol; Link Layer 
Discovery Protocol) to analyze the relationships between the individual IO devices and the IO 
controller. From these relationships, the IO controller detects which IO device was replaced 
and assigns the configured device name to it.
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Requirements
● A port interconnection is already configured.

● The affected IO devices in the automation system must support device replacement without 
exchangeable medium (LLDP protocol).
If the individual IO devices in the automation system do not support device replacement 
without exchangeable medium, a corresponding alarm is output for the IO device.

 

  Note

Use only new IO devices as replacement devices, or restore IO devices with an existing 
parameter assignment to delivery state prior to commissioning.

For S7-1500 CPUs with firmware version V1.5 or higher, it is not necessary to reset IO 
devices with an existing parameter assignment to delivery state. The condition for this is 
that the "Permit overwriting of device name" option is enabled for the IO controller 
("Ethernet addresses" area, "PROFINET" section of the properties of the PROFINET 
interface). 

 

Procedure
In order to enable the replacement of an IO device without exchangeable medium, proceed 
as follows:

1. In the device or network view, select the PROFINET interface of the corresponding IO 
controller.

2. In the interface properties under "Advanced settings > Interface options", select the 
"Support device replacement without exchangeable medium" check box.

The option "Support device replacement without exchangeable medium" also permits 
automatic commissioning, which means you can commission the IO system with the IO devices 
without assigning their device names in advance.

See also
Assigning the device name and IP address (Page 1023)

Components with the the device replacement without exchangeable medium function (http://
support.automation.siemens.com/WW/view/en/36752540)

Using GSD files

GSD files for IO devices

Basic information on GSD files of IO devices       
The properties of PROFINET IO devices are not stored in a keyword-based text file (as for 
PROFIBUS DP slaves), but in an XML file whose structure and rules are determined by a 
GSDML schema.
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The language used to describe the GSD files is GSDML (Generic Station Description Markup 
Language). It is defined by the GSDML schema.

A GSDML schema contains validation rules that allow it, for example, to check the syntax of 
a GSD file. GSDML schemas (as schema files) are acquired by IO device manufacturers from 
PROFIBUS International.

Functional enhancements in the area of PROFINET IO will have an effect on the GSDML 
specification and the corresponding schema. A new version of the specification and of the 
schema is created by the functional enhancement.

Names of GSD files for IO devices
One possible example of a GSD file name for IO devices is:

"GSDML-V1.0-Siemens-ET200S-20030616.xml"

Name component Explanation
GSDML String at the start of each GSD file for IO devices
V1.0 Version of the GSDML schema
Siemens Manufacturer
ET200S Name of the device
20030616 Version code (date)
.xml File extension

Versioning of GSD files for IO devices
The version information of GSD files is two-fold: 

First, the version of the GSDML schema is indicated. This determines the language scope 
used by a GSD file. 

This is followed by the version, listed as an issue date. The version number of GSD files is 
incremented, for example, after elimination of an error or introduction of a functional 
enhancement. 

Functional enhancements may result in a new version of the GSDML schema. A new version 
of a GSDML schema might only be supported with restrictions.

Installing the GSD file

Introduction
A GSD file (generic station description file) contains all properties of an IO device. If you want 
to configure an IO device that is not available in the hardware catalog, you must install the 
GSD file provided by the manufacturer. IO devices installed via GSD files are displayed in the 
hardware catalog and can then be selected and configured.
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Requirement
● The hardware and network editor is closed.

● You have access to the required GSD files in a directory on the hard disk.

Procedure       
To install a GSD file, follow these steps:

1. In the "Options" menu, select the "Install generic station description files" command.

2. In the "Install generic station description files" dialog box, select the folder in which the GSD 
files are stored.

3. Choose one or more files from the list of displayed GSD files.

4. Click on the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.
Any problems during the installation can be tracked down using the log file.

You will find the new IO devices installed by means of GSD files in the hardware catalog under 
"Additional field devices > PROFINET".

 

 Note

Installation of a GSD file cannot be undone.
 

Changing the revision of a GSD file

Changing the revision of a GSD file   
You can change the revision of a GSD file for an IO device:

● Only for the current IO device

● All suitable IO devices within the IO system

● All suitable IO devices within the complete project

First, all existing GSD files for the current IO device are shown. The only difference between 
the GSD files shown is their revision status. The currently used GSD file is highlighted.

Requirement
● The I/O data is the same for all IO devices whose revision is to be changed.

● The order number has not changed.

● The number of submodules is identical.

● The configuration data has not changed.

● There must be no module or submodule in a slot that is invalid after the new GSD file has 
been created.
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Procedure
To change the revision of one or more IO devices, proceed as follows:

1. Select the IO device whose GSD file revision is to be changed.

2. Click on the "Change revision" button under "General> Catalog information" in the 
properties of the IO device.
The "Change revision" dialog box opens.

3. Select the GSD revision you want to use in the "Available revisions" table.

4. Under "Use selected revision for", select the devices whose version are to be changed:

– Only for the current IO device

– For all suitable IO devices in the IO system

– For all suitable IO devices in the project

5. Click the "Apply" button.

8.1.4.8 Bus coupling with PN/PN coupler

Application and function

Application  
The PN/PN coupler is used to link two Ethernet subnets with one another and to exchange 
data. That way use data about input or output address areas or datasets can be used. The 
maximum size of the transferable input and output data is 1024 bytes. The division into input 
and output data is preferable, so that e.g. 800 byte input data and 200 byte output data can 
be configured.

As a device, the PN/PN coupler has two PROFINET interfaces, each of which is linked to one 
subnet.

In the configuration, two IO Devices are produced from this one PN/PN coupler which means 
that there is one IO Device for each station with its own subnet. The other part of PN/PN coupler 
in each case is known as the bus node. Once configuring is complete, the two parts are joined.

 

Figure 8-3 Coupling two PROFINET IO subnets with one PN/PN coupler
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Additional information
For additional information on "PN/PN couplers", refer to Service & Support on the Internet 
(http://support.automation.siemens.com/WW/view/en/44319532).

Linking Ethernet subnets

Linking Ethernet subnets with a PN/PN coupler
You can link Ethernet subnets with the standard device PN/PN coupler.  

To link Ethernet subnets, follow these steps:

1. Create your Ethernet subnets.

2. Select the standard field devices in the hardware catalog. Find the PN/PN coupler as head 
module in the "PROFINET IO" folder.

3. In the network view, drag the two components X1 and X2 to the required version of the PN/
PN coupler per drag-and-drop operation. The components form a device, but are shown 
separately to make handling easier.

4. Connect the Ethernet interface of the PN/PN coupler X1 to the first Ethernet subnet.

5. Connect the Ethernet interface of the PN/PN coupler X2 to the second Ethernet subnet.
The Ethernet subnets are now linked through the two components of the PN/PN coupler.

8.1.4.9 Integrating external tools

Integrating S7-external tools

Introduction
Tools external to STEP 7 ("Device Tools") with a special call interface (Tool Calling Interface) 
can be used to configure distributed devices. Such devices are also referred to as "TCI 
capable". 
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The performance range of these tools exceeds the possibilities provided within GSD 
configuration, for example, they can provide expanded graphical input options.       

Distributed devices can be as follows:

● PROFIBUS DP slaves

● Modules within a DP slave

● PROFINET IO devices

● Modules within an IO device
 

 Note
Warranty and liability

Siemens accepts no liability for third-party software (device tools) called with the TCI (Tool 
Calling Interface) or for proper interaction with the associated devices. 

 

Requirement
The call interface of the tool complies with the TCI specification. Parameters and commands 
are forwarded to the distributed device via this call interface. 

Such tools have to be installed using a setup provided by the manufacturer. The "S7-PCT" 
(Port Configuration Tool) device tool for IO-Link master modules and IO-Link devices is an 
exception; this is supplied with STEP 7. Special note: After the installation, the tool is not shown 
in the list of installed software or in the list of software products in the project. 

The GSD file of the distributed device that is to be configured with the Device Tool must be 
installed. 

Starting the device tool
The command for starting the device tool is available in the shortcut menu of the TCI-capable 
device in the shortcut menu of the graphical and tabular device view: "Start device tool".

See also
Starting the SIMATIC S7-PCT (Page 1048)

Starting the SIMATIC S7-PCT

Introduction   
The "S7-PCT" (Port Configuration Tool) device tool is installed with STEP 7.

The tool is used to assign parameters to the ports of IO-Link modules such as 4SI IO-Link 
(S7-1200, ET 200S) or 4IOL+8DI+4DO (ET 200eco PN). 
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Requirement
You have configured the corresponding CPU, the DP slave or the IO device with an IO-Link 
module.

Procedure
To start via the graphical device view, follow these steps:

1. Select the IO-Link module in the device view.

2. Select "Start device tool" from the shortcut menu.

OR, to start with the tabular device view, follow these steps:

1. Select the IO-Link module in the device view.

2. Arrange the areas in the work area in such a way that the tabular device overview is visible 
(it is located between the device view and the inspector window).

3. Select the row with the IO-Link module in the device overview.

4. Select "Start device tool" from the shortcut menu.

Result
The tool starts and you can configure the ports. 

See also
Integrating S7-external tools (Page 1047)

8.1.4.10 Loading a configuration

Introduction to loading a configuration
In order to commission a device, identical configurations must be stored on the programming 
device/PC and on the connected devices. To synchronize the configurations on the 
programming device/PC and the connected devices, you load a configuration. Configuration 
data can be loaded in two directions:

● From the programming device/PC to a device

● From the device to a PG/PC

See also
Uploading project data from a device (Page 386)

General information on loading (Page 381)

Downloading a configuration to a device (Page 1050)

Downloading project data to a device (Page 383)
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General information on loading to PG/PC (Page 1051)

Special features during startup (Page 1069)

Downloading a configuration to a device

Loading the hardware configuration         
After you have inserted a new device in the project and configured it or if you have modified 
an existing hardware configuration, the next step is to load the current configuration to the 
device. This ensures that the same configuration is set on the programming device/PC and 
on the module that is physically present. Use the "Online > Download to device (Page 383)" 
menu command for this.

In the first download, the complete hardware configuration is downloaded. In subsequent 
downloads, only changes to the hardware configuration are downloaded.

You have the following options for loading the hardware configuration:

● Loading in the device or network view

● Loading in the project tree

● Loading to an accessible device
 

 WARNING

Perform load operation only in STOP mode

Following loading, the machine or process may behave unexpectedly if the parameter 
assignment is incorrect. A CPU must be set to STOP mode for the load operation to rule out 
possible damage to equipment or personal injury.

 

Special considerations for loading isochronous applications
Isochronous applications consist of a hardware configuration part and a software part. 

Example: If you change the number of an IO system, the delay time, or the assignment of a 
process image partition of the isochronous I/O in the hardware configuration, this affects the 
parameters of the isochronous mode interrupt OB and thus also the software part. 

With isochronous applications, you should always load the complete project (hardware and 
software). With partial loading (loading hardware and software separately at different times), 
inconsistencies can arise that, for example, can prevent CPU startup or isochronous operation 
of the application. 

See also
General information on loading (Page 381)
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Loading a configuration to PG/PC

General information on loading to PG/PC

Introduction 
If you bring your PG/PC to a plant and the STEP 7 project used to create the configuration of 
this plant is not available, load the configuration to a new project on your PG/PC, for example. 
Use the "Online > Loading the device as new station (hardware and software) (Page 386)" 
menu command for this.

The list of accessible devices in the project tree is always used when loading a device to your 
programming device. You can select multiple devices and load them to the project at the same 
time.

Requirements
● The hardware configuration in the device must be created in TIA Portal V12 or higher. A 

hardware configuration present in the device that was created with an older version cannot 
be loaded and must be upgraded (Page 361).

● Modules present in the device from GSD (ML), HSPs, or service packs must be installed 
in the TIA Portal on the PG/PC.

● A project must be open. This project can be a new (empty) project or an existing project.

● The opened project is in offline mode.

Scope of load operation
The following list shows an overview of the loadable components of a configuration:

● The device (e.g., a CPU) with all I/O modules and all parameter settings

● PROFIBUS master systems and all PROFIBUS-relevant settings

● PROFINET IO systems and all PROFINET-relevant settings

● I devices and I slaves

● Settings for direct data exchange

After loading a CPU, all other modules within the address area of the CPU are also loaded.

The following connections are also loaded when the configuration is loaded:

● S7 connections (including routed connections) in combined PB/IE networks, including via 
IE-CP or PB-CM interfaces. S7 connections are automatically accepted as configured at 
one end when a device configuration is loaded, even if the S7 connection was configured 
at both ends in the original project. When both connection partners are loaded, the 
connection is joined together again during the next compilation.

● TCP connections via CPU-internal Ethernet interface, UDP/ISOonTCP connections, and 
TCP, UDP, ISO, and ISOonTCP connections via IE-CP interface

● Connections via the OUC connection parameter assignment for projects from STEP 7 V13 
and higher
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 Note

The hardware configuration loaded to PG/PC is not completely identical to the configuration 
originally loaded to the device. Note the additional information on loading, in particular with 
regard to partially loaded configuration data in the case of cross-device communication.

Loading PC systems, such as WinAC or PC-based automation, is not possible.
 

See also
General information on loading (Page 381)

Loading specific device configurations

Information on loading
When device configurations are loaded to the PG/PC, all assigned parameters are transferred 
from the device to the project. If the CPU is connected to a subnet, all parameters of the device 
are loaded and the CPU is displayed in the network view as networked.

 

 Note

CPUs reset to their factory settings do not have any hardware configuration. Therefore, 
nothing is loaded in this case after "Load to PG/PC" is selected in the "Online" menu.

 

Loading S7-300/400 configurations
To avoid conflicts when loading a device to an existing project, the following rules must be 
followed:

● Device names for CPUs, PROFIBUS slaves (DP slaves, I-slaves) and PROFINET devices 
(IO devices, I devices) must be unique

● The combination of network name, subnet ID, and IP/DP address for modules must be 
unique

If conflicts occur, the load operation is canceled and an alarm provides information about the 
problems that occurred. You can then adapt the project correspondingly or install missing 
components and then repeat the load operation.

Alarm configurations are not loaded to PG/PC.
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Loading S7-1200/1500 configurations
Take the following into consideration when loading:

● CPUs of the S7-1200 series with firmware version V1.0 are not supported when loading.

● Device-specific diagnostic interrupts of the S7-1200 are not supported when loading. For 
device-specific diagnostic interrupts of the S7-1200 to be generated on the PG/PC once 
again, the hardware configuration must be compiled once again.

● Module comments of the S7-1200/1500 are loaded from the device to the PG/PC if the 
same project language is set that was used during loading to the device. You can deselect 
the loading of comments, if desired.

 

 Note

All types of PC systems, such as WinAC, Embedded Controller, CP 1616 or PC CPs, do not 
support loading to PG/PC.

 

Loading distributed I/O
The following functionalities and settings of the distributed I/O are loaded:

● DP master systems/IO systems with associated DP masters/IO controllers (CPUs and 
CPs), DP slaves/IO devices, the utilized modules and their parameter assignment and 
properties, such as options handling, status bytes, or SYNC/FREEZE

● Connection of process image partitions (PIP) to organization blocks (OB). Applies to the 
module and OB properties 

● Configured hardware interrupts with the associated properties

● DP master systems with I-slave

● CPs as PROFIBUS I-slave or PROFINET I-device

● Direct data exchange

Master-slave relationships between the I-slave/I-device and assigned DP master/IO controller 
are only established in the project if both the master as well as the I-slave are loaded to the 
PG. It does not matter whether you load the DP master/IO controller or the I-slave/I-device 
first. As soon as both devices are loaded, the master-slave/controller-device relationships will 
also be re-established.
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Loading subnets and devices with MPI, PROFIBUS, Ethernet, and PtP
The following special considerations apply to loading subnets and end points of connections 
for MPI, PROFIBUS, Ethernet, and PtP with their respective connection properties:

● If a device with PROFIBUS interface is loaded, the bus parameters of the device will initially 
be different from the settings in the original project. The bus parameters will only match 
those of the original project after all devices involved are loaded and no additional devices 
are on the same bus.

● Passive communication devices that are not connected as DP slaves or IO devices to a 
corresponding master system or IO system do not participate in the data exchange. They 
are therefore not loaded.

● All devices involved should therefore be loaded for cross-device configurations. A warning 
is output during compiling of the project for missing network stations. Missing routing 
information due to communication stations that are not loaded is displayed as warning 
during compilation. If the configuration is loaded from the PG/PC back to the device, 
different routing information results. 

When you compile the project after loading devices to the PG/PC, STEP 7 checks if all devices 
to which communication relationships have been configured are available. If devices are 
missing, you receive an alarm with the number of missing communication stations.

 

 NOTICE

Cross-device communication

When you load a configuration with cross-device communication to the PG/PC, you must 
also load all corresponding network stations to the PG/PC. If required network stations are 
missing and the configuration is loaded back to the device, there is no guarantee that cross-
device communication is working again.

 

See also
Upgrading projects (Page 361)

Loading configurations with web server

Information on loading
The hardware configuration of a CPU also contains the web server settings. A number of 
restrictions apply to loading a web server configuration to the PG/PC:

● The assignment of the web server language and project language is not loaded for 
S7-300/400. The project texts are not loaded and an alarm is output that no project 
languages are assigned. The languages assigned in STEP 7 are loaded without restriction 
for S7-1200/1500 CPU.

● User administration data of the S7-1200/1500 can be loaded but not edited. You can use 
a check box to select whether you want to use the existing data as read-only data or discard 
these data and enter new data. 

● Watch tables of the web server are not loaded.
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The source files of the user-defined web pages (HTML pages, Java scripts, etc.) are not loaded. 
The program blocks generated during loading can only be edited if you enter the properties 
and the HTML page yourself.

See also
Information about the web server (Page 786)

Loading configurations with PROFIBUS

Information on loading
A DP master is loaded to PG/PC. The DP master system and all connected DP slaves are 
inserted into the project. The respective settings remain unchanged. If a suitable PROFIBUS 
subnet has already been created, the loaded devices with PROFIBUS interface are connected 
to the existing subnet.

As a prerequisite for loading DP master systems with standard slaves, the corresponding GSD 
files must be installed in the TIA Portal and available in the hardware catalog. If a required 
GSD file is not available in the same version as in the device, differences are identified during 
the consistency check.

 

 Note

Direct data exchange in a configuration is only loaded if all communication partners involved 
in the direct data exchange are loaded to the PG/PC. Missing communication partners are 
represented by a placeholder device. This means the configuration with direct data exchange 
can still be compiled.

 

Isochronous mode
Note the following when loading DP master systems with activated PROFIBUS functionality 
"Isochronous mode": 

● Bus parameters and the settings for isochronous mode are only identical after the device 
is loaded to the PG/PC if all devices relevant for calculation of isochronous mode are loaded.

● Only mono-master systems with isochronous mode are supported. Therefore, only 
configurations with just one DP master on the PROFIBUS subnet are loaded.

Loading configurations with PROFINET

Information on loading
If you have selected a CPU in the list of accessible devices and perform an load operation to 
PG/PC, all IO controllers and IO devices associated with this device along with their IO systems 
will be loaded. Settings for the topology are also transferred. If there is already a suitable 
Ethernet network in the project, the loaded devices are integrated into the existing network.
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Relationships between the IO controllers and IO devices are only established within the project 
if both the IO controller as well as the I-device are loaded to the PG. It does not matter whether 
you load the IO controller or the I-devices first.

Supported functions
The following functionalities and settings are loaded:

● PROFINET configurations (RT and IRT) in IO systems with the associated IO controllers 
(CPUs and CPs), IO devices, and the modules used

● Logical addresses and interface properties

● Port interconnections

● Isochronous mode

● Sync domains/MRP domains

● Redundancy role "Client" or "Manager" for MRP configurations
 

 Note

Empty Sync domains and MRP domains are not included in the loading.
 

GSD-based IO devices
As a prerequisite for loading GSD based IO devices, the corresponding GSD files must be 
installed in the TIA Portal and available in the hardware catalog. If a required GSD file is not 
available in the same version as in the device, differences are identified during the consistency 
check.

I-device
If you load the IO controller from an IO system with connected I-device, the IO controller and 
its IO devices will be loaded. An involved I-device is loaded only as an I-device proxy. The 
CPU parameter assignment, including the parameter assignment of the CPU's "own" 
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(subordinate) IO system, is missing in the I-device proxy. Only the interface to the higher-level 
IO controller is loaded.

For I-device proxy devices:

● IO controller can be compiled and loaded

● Properties are displayed but cannot be changed

● Diagnostics in the project tree is not carried out

In the network view, placeholder devices are represented with a question mark:

In order to edit the I-device in the project, you must load the I-device from the device to the 
PG/PC. This replaces the I-device proxy with the complete I-device along with its subordinate 
IO devices.
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It is possible to load an IO controller with connected I-device proxy from the PG/PC to the 
device.

 

 Note

The replacement of I-device placeholders is only possible if the required I-device is available 
in the hardware catalog. 

An I-device proxy representing a SIMOTION I-device cannot be loaded and replaced.
 

Configurations with IE/PB link
If one of the following configurations with IE/PB Link PN IO as PROFINET IO device is present, 
the complete configuration with all subordinate PROFIBUS devices is loaded:

● CPU/CP of S7-300/400 

● PC station and connected PROFIBUS master system

The complete configuration consists of the following:

● CPU

● CP configuration

● PROFINET IO system with connected IE/PB link

● PROFIBUS master system of the IE/PB link with connected DP slaves

An example configuration consists of an S7-300 CPU with a CP as PROFINET IO controller. 
An IE/PB link as IO device is connected to the IO controller. As the PROFIBUS DP master, 
the IE/PB link polls a PROFIBUS DP slave, e.g., ET 200L. If you load the CPU from the device 
to the PG/PC, the complete configuration is loaded.

 

 Note

If the IE/PB link is not operated as a PROFINET IO proxy but rather as a gateway in standard 
mode, the IE/PB link functions as a CPU and can be loaded separately.

 

Loading Shared Devices
The following applies to loading comments: If an input/output module with the Module-internal 
Shared Input (MSI) or Module-internal Shared Output (MSO) function consists of only one 
submodule, the submodule does not have its own comment. Instead, it uses the comment of 
the input/output module. The module must be subdivided into several submodules for the input/
output module and all submodules to have their own comment fields.
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Loading HMI devices

Information on loading 
We distinguish between the following cases when loading HMI devices to PG/PC:

● HMI devices connected to a DP master as DP slave or to an IO controller as IO device are 
loaded as DP slave or IO device respectively (for example, PP 17-I PROFIsafe).

● HMI devices in a master system as I-slave or in an IO system as I-device are loaded as I-
slave proxies or I-device proxies (Page 1055) (for example, SIMATIC Comfort Panels). The 
settings of the device proxy are read-only. 

● HMI devices are not loaded if they are connected to a subnet (PROFIBUS or PROFINET) 
but not to a master system or IO system (for example, KP600 Basic color DP).

Going online with loaded configurations
You can go online with the loaded project or with loaded portions of the project.

Requirement
The hardware configuration loaded from the device to the PG/PC has been compiled. The 
statuses of the central and distributed modules are only correctly displayed after compilation.

 

 Note

If you go online before compiling, the diagnostics icon “?” is displayed (diagnostics not 
possible). A corresponding alarm is displayed under "Info > General" in the Inspector window.

 

Dependencies
Depending on how completely the hardware configuration was loaded to the PG, restrictions 
apply to going online and to diagnostics:

● Completely loaded device with all associated central and distributed modules, such as DP 
slaves or IO devices: 
Going online and diagnostics are possible.

● Loaded device with connected I-devices/I-slaves:

– I device/I slave is not loaded: Going online for the device and its modules is possible. 
For the dependent components of the configuration that are not loaded, device proxies 
are handled with only minimum diagnostics support. The online status is represented 
as an icon. The standard diagnostics is shown in the online and diagnostics view. I&M 
data are not loaded.

– I device/I slave is also loaded: Going online is possible for all devices; diagnostics is 
fully supported.
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8.1.5 Displaying alarms

8.1.5.1 Overview of the alarm display
The "Alarm display" function can be used to output asynchronous alarms of diagnostics events 
and user-defined diagnostics alarms as well a alarms from ALARM instructions.

From the alarm display, you can also start the alarm editor with the "Edit alarm" shortcut menu 
command and then create user diagnostic alarms.

Icons     
The following table shows the icons and their functions:

Icon Function

Archive view

Shows the alarms located in the archive. 

Active alarms

Shows the currently active (pending) alarms. 
Alarms that must be acknowledged are shown in 
blue lettering. 

Ignore

Ignores the arrival of alarms, These alarms are 
neither shown in the window nor stored in the 
archive. 

Acknowledge

Confirms the selected alarm as read. Alarms 
requiring acknowledgment are shown in blue 
lettering. 

Clear archive

Deletes all alarms in the archive. 

Export archive

Exports the current alarm archive to a file in xml 
format. 

8.1.5.2 Archive view
In the archive view, alarms are displayed and archived according to the time they appear. You 
can set the size of the archive (between 200 and 3000 alarms) with the menu command 
"Options > Settings > Online & Diagnostics". If the selected archive size is exceeded, the oldest 
alarm it contains is deleted. 

Alarms that must be acknowledged are displayed in blue lettering and can be acknowledged 
with the shortcut menu command "Acknowledge alarm(s)".

The archive is constantly updated and does not need to be saved explicitly.
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8.1.5.3 Layout of the alarms in the archive view
In the archive view, all events occurring on the selected CPUs are logged. A new entry is 
created for each individual event and shown as a further row in the table. 

Table structure
All attributes of the alarms can be shown as columns. You can show or hide individual columns 
as well as modify the width and order of the columns. These settings are saved when the 
project is closed. 

The alarms can be displayed in one or more rows. In the single row display, only the first row 
of the multiple-row alarm data is displayed. 

The alarms either require acknowledgment or do not require acknowledgment. The alarms 
requiring acknowledgment that have not yet been acknowledged are highlighted in blue 
lettering and can be acknowledged either with the button in the toolbar for the particular context 
or with the shortcut menu command "Acknowledge alarm(s)".

8.1.5.4 Receiving alarms
To allow alarms to be displayed, you must first set the receipt of alarms for each CPU. 

Procedure
Toe receive alarms, follow these steps: 

1. Double-click on the "Online & Diagnostics" folder of the relevant CPU in project navigation.

2. Click the "Online access" group in the area navigation.

3. Select the option "Receive alarms".
 

  Note
If you select this procedure, alarms are only received after you have re-established an 
online connection to the device.

 
 

Or: 

1. Select the relevant CPU in the device, network, or topology view.

2. Select the command "Receive alarms" in the "Online" menu or in the shortcut menu.

Or: 

1. Select the CPU in project navigation.

2. Select the command "Receive alarms" in the "Online" menu or in the shortcut menu.
 

  Note
If you select one of the two above-named procedures, you must have first established an 
online connection to the device.
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8.1.5.5 Export archive
To archive alarms, you can export the archive. Follow these steps:

1. Go to the archive view.

2. Click the "Export archive" button.

3. In the dialog that opens, select the path to export the archive.

Result
The archive is saved as an xml file at the location you selected.

8.1.5.6 Clear archive
The archive is organized as a ring buffer, in other words, when it is full, the oldest alarms are 
deleted from the archive. With the "Clear archive" button, you can delete the entire archive.

Procedure
To clear the archive, follow these steps:

1. Click the "Clear archive" button in the toolbar of the alarm display.

8.1.5.7 "Active alarms" view
The "Active alarms" view is an image of the alarm acknowledgement memory of the selected 
CPU(s). 

8.1.5.8 Layout of the alarms in the "Active alarms" view
The "Active alarms" view represents an image of the alarm acknowledgment memory of the 
selected CPUs. One entry is shown in the table per active alarm. Events of an alarm 
("incoming", "outgoing" and "acknowledged") are displayed in one row.  

Table structure 
All attributes of the alarms can be shown as columns. You can show or hide individual columns 
as well as modify the width and order of the columns. These settings are saved when the 
project is closed.

The alarms can be displayed in one or more rows. In the single row display, only the first row 
of the multiple-row alarm data is displayed. 

The alarms either require acknowledgment or do not require acknowledgment. The alarms 
requiring acknowledgment that have not yet been acknowledged are highlighted in bold print 
and can be acknowledged either with the button in the toolbar for the specific context or with 
the shortcut menu command "Acknowledge alarm(s)". 
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8.1.5.9 Status of the alarms
Depending on whether you are in the "Active alarms" view or the archive view, the displayed 
alarms may have a different status.

Status of the alarms in the "Active alarms" view
● I: Alarm came

● IA: Alarm came and was acknowledged

● IO: Alarm has gone

If more signal changes occur than can be sent (signal overflow), OV is displayed as the status 
and the status is shown in red. 

Status of the alarms in the archive view
● No information: only with alarms generated by the PG/PC and displayed in the "Archive" 

tab, for example logon status, connection abort, mode changes

● I: Alarm came

● A: Alarm came and was acknowledged

● O Alarm has gone

● D: The alarm was deleted.

If more signal changes occur than can be sent (signal overflow), OV is displayed as the status 
and the status is shown in red.

8.1.5.10 Acknowledging alarms
Alarms that must be acknowledged are shown in blue lettering.

Procedure  
To acknowledge an alarm, follow these steps:

1. Select the required alarm or alarms from the table.

2. Click the "Acknowledge" button.
 

  Note

You can select more than one alarm to acknowledge at the same time. To do this, hold 
down the <Ctrl> key and then select the alarms you want to acknowledge.
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Result
The selected alarm was acknowledged and is then shown in normal characters. 

 

 Note

In the "Active alarms" view, acknowledged alarms that have already gone are no longer 
displayed. 

 

 

8.1.5.11 Ignoring alarms

Ignoring alarms 
To ignore alarms, follow these steps:

1. Click the "Ignore" button.
The icon is shown on a gray background.

Result
From this point onwards, all alarms will be ignored. A message is created in the archive view 
indicating that the display of alarms and events is disabled.

Canceling the ignoring of alarms
To cancel the ignoring of alarms, follow these steps:

1. Click the "Ignore" button.
The icon is shown on a white background.

Result
All alarms, in other words, even the alarms currently pending on the CPU while the "Ignore 
alarms" function was active, are displayed again from this point onwards. A message is created 
in the archive view indicating that the display of alarms and events is enabled again.

 

8.1.5.12 Keyboard commands in the alarm display

Alarm display 

Function Shortcut keys
Select all alarms Ctrl+A
Acknowledge all selected alarms Ctrl+Q
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8.1.6 Additional information on configurations

8.1.6.1 Functional description of S7-1200 CPUs

Operating modes

Principles of the operating modes of S7-CPUs

Introduction  
Operating modes describe the behavior of the CPU. The following operating modes are 
possible:

● STARTUP

● RUN

● STOP

In these operating modes, the CPU can communicate via the PN/IE interface, for example.

Other operating modes
If the CPU is not ready for operation, it is in one of following two operating modes:

● Deenergized, i.e. the supply voltage is switched off.

● Defective, which means an internal error has occurred.
If the "Defective" status is caused by a firmware error, this state is indicated by the status 
LEDs of the CPU (refer to the description of the CPU). To find out the cause, follow these 
steps:

– Turn the power supply switch off and on again.

– Read out the diagnostics buffer when the CPU starts up and send the data for analysis 
to Customer Support.

If the CPU does not start up, replace it.

See also
STOP mode (Page 1070)

RUN mode (Page 1070)
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Operating mode transitions

Overview  
The following figure shows the operating modes and the operating mode transitions of S7-1200 
CPUs:

The following table shows the conditions under which the operating modes will change:

No. Operating mode transition Conditions
① POWER ON → STARTUP After switching on, the CPU goes to "STARTUP" mode if:

● "Warm restart" startup type is set, and
● the hardware configuration and the program blocks are consistent.
Non-retentive memory is cleared and the contents of non-retentive DBs are reset 
to the initial values of the load memory. Retentive memory and retentive DB contents 
are retained.

② POWER ON → STOP When startup type "No startup" is set, the CPU goes to "STOP" mode after the supply 
voltage is switched on.
Non-retentive memory is cleared and the contents of non-retentive DBs are reset 
to the initial values of the load memory. Retentive memory and retentive DB contents 
are retained.

③ STOP → STARTUP The CPU switches to "STARTUP" mode if:
● CPU is set to "RUN" from the programming device, and
● the hardware configuration and the program blocks are consistent.

④ STARTUP → STOP The CPU returns to the "STOP" mode in the following situations:
● Error detected during startup.
● The CPU is set to "STOP" from the programming device.
● A STOP command is processed in the STARTUP OB.

⑤ STARTUP → RUN If the STARTUP is successful, the CPU switches to "RUN".
⑥ RUN → STOP The CPU returns to the "STOP" mode in the following situations:

● An error is detected that prevents continued processing.
● The CPU is set to "STOP" from the programming device.
● A STOP command is processed in the user program.
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"STARTUP" operating mode

Principles of the STARTUP mode

Function   
After turning on the CPU, it executes a startup program before starting to execute the cyclic 
user program. 

By suitably programming startup OBs, you can specify certain initialization variables for your 
cyclic program in the startup program. There is no rule in terms of the number of startup OBs. 
That is, you can set up one or several startup OBs in your program, or none at all.

Parameter settings for startup characteristics
You can specify whether the CPU remains in STOP mode or whether a warm restart is run. 
Over and above this, you can set the response during startup (RUN or previous mode) in the 
"Startup" group of the CPU properties.

Special characteristics
Note the following points regarding the "STARTUP" mode:

● The startup OBs are executed. All startup OBs you have programmed are executed, 
regardless of the selected startup mode.

● No time-based program execution can be performed.

● Interrupt controlled program execution limited to:

– OB 82 (diagnostics interrupt)

● The outputs on the modules are disabled.

● The process image is not updated; direct I/O access to inputs is possible.

See also
Editing properties and parameters (Page 539)

Principles of the operating modes of S7-CPUs (Page 1065)

Organization blocks for startup (Page 1115)

Warm restart (Page 1067)

Warm restart

Function
During a warm restart, all non-retentive bit memory is deleted and non-retentive DB contents 
are reset to the initial values from load memory. Retentive bit memory and retentive DB 
contents are retained. 
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Program execution begins at the call of the first startup OB.

Triggering a warm restart   
You can trigger a "Warm restart" using a corresponding menu command on your programming 
device in the following situations:

● The CPU must be in "STOP" mode.

● After a memory reset

● After downloading a consistent program and a consistent hardware configuration in the 
"STOP" mode of the CPU.

"POWER ON" triggers a "warm restart" if you have set the following parameters for the startup 
response:

● Startup type "warm restart - RUN" (regardless of the CPU operating mode prior to POWER 
OFF).

● "Warm restart - mode prior to POWER OFF" (depending on the CPU operating mode prior 
to POWER OFF. The CPU must have been in RUN mode prior to this.)

See also
Retentive memory areas (Page 1075)

Startup activities

Overview  
The following table shows which activities the CPU performs at STARTUP:

Activities in execution sequence At warm restart
Clear non-retentive bit memories Yes
Clear all bit memories No
Clear the process image output Yes
Processing startup OBs Yes
Update the process image input Yes
Enable outputs after changing to "RUN" mode Yes

Sequence
The following figure shows the activities of the CPU in "STOP", "STARTUP", and "RUN" modes.

You can use the following measures to specify the state of the I/O outputs in the first cycle of 
the user program:

● Use assignable output modules to be able to output substitute values or to retain the last 
value.

● Set default values for outputs in startup OBs.
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During the startup, all interrupt events are entered in a queue so that they can be processed 
later during RUN mode. In RUN mode, hardware interrupts can be processed at any time.

Special features during startup

Response when expected and actual configurations do not match 
The expected configuration is represented by the engineering configuration loaded on the 
CPU. The actual configuration is the actual configuration of the automation system. 

If the expected configuration and actual configuration differ, the CPU nevertheless initially 
changes to RUN.

Canceling a STARTUP
If errors occur during startup, the startup is canceled and the CPU remains in "STOP" mode. 

Under the following conditions, a startup will not be performed or will be canceled:
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● If an invalid SD card is inserted.

● If no hardware configuration has been downloaded.

See also
Overview of the CPU properties (Page 1087)

RUN mode

Function   
In "RUN" mode the cyclic, time-driven, and interrupt-driven program sections execute:

● The process image output is read out.

● The process image input table is read.

● The user program is executed.

Active data exchange between S7-1200 CPUs by means of Open User Communication is only 
possible in "RUN" mode.

Running the user program
Once the CPU has read the inputs, the cyclic program runs from the first to the last instruction. 

If you have configured a minimum cycle time, the CPU will not end the cycle until this minimum 
cycle time is up even if the user program is completed sooner. 

A maximum cycle time is set which you can adjust according to your requirements. This 
ensures that the cyclic program is completed within a specified time. The system will respond 
with a time error if the cyclic program is not completed within this time. 

Other events such as hardware and diagnostic interrupts can interrupt the cyclic program flow 
and prolong the cycle time. 

See also
Principles of the operating modes of S7-CPUs (Page 1065)

Events and OBs (Page 1079)

STOP mode

Function   
In "STOP" mode, the user program is not executed. All outputs are disabled or react according 
to the parameter settings: They provide a substitute value as set in the parameters or retain 
the last value output and bring the controlled process to a safe status. 

The CPU checks the following points:
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● Hardware, for example whether are all modules are available

● Whether the default settings for the CPU are applicable or parameter sets are present

● Whether the general conditions for the programmed startup behavior are correct

See also
Principles of the operating modes of S7-CPUs (Page 1065)

Basics of a memory reset

Function  
A memory reset on the CPU is possible only in STOP mode.

When memory is reset, the CPU is changed to an "initial status". This means:

● An existing online connection between your programming device/PC and the CPU is 
terminated.

● The content of the work memory and the retentive and non-retentive data are deleted.

● The diagnostic buffer, the time, the IP address, the hardware configuration, and active force 
jobs are retained.

● The load memory (code and data blocks) is then copied to work memory. As a result, the 
data blocks no longer have current values but their configured initial values.

 

Memory areas

Useful information on memory cards

How the memory card functions       
The SIMATIC Memory Card for a S7-1200 is an SD memory card preformatted by Siemens 
for the CPU user program. 

You may only delete files and folders. If you format the memory card with Windows, for example 
with a commercially available card reader, you make the memory card unusable as a storage 
medium for an S7 CPU.
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Setting the card type   
You can use the memory card as a transfer card, a program card or a firmware update card.

To set the card type, insert the memory card into the card reader of the programming device 
and select the "Card reader/USB memory" folder from the project tree. In the properties of the 
selected memory card, designate the card type:

● Program
If it is used as a program card, you can load the user program on the memory card. In this 
case, the internal load memory of the device is replaced by the memory card and the internal 
load memory is erased. The user program is then fully executable from the memory card. 
If the memory card with the user program is removed, there is no longer a program available.

● Transfer
If it is used as a transfer card, you can transfer the user program from the memory card to 
the internal load memory of the CPU. You can then remove the memory card again. 

● Firmware card
Firmware for the S7-1200 modules can be stored on a memory card. Therefore it is possible 
to perform a firmware update with the help of a specifically prepared memory card. Likewise, 
a backup copy of firmware for a module can be stored on a memory card.

Transferring objects from the project to a memory card
When the memory card is inserted in the programming device or in an external card reader, 
you can transfer the following objects from the project tree to the memory card: 

● Individual blocks (multiple selection possible)
In this case a consistent transfer is available, as the dependencies of the blocks to each 
other is taken into account with block selection. 

● PLC
In this case, all objects relevant to processing are transferred, such as blocks and the 
hardware configuration on the memory card, just as with downloading.

To perform the transfer, you can move the objects with drag-and-drop or use the command 
"Card reader/USB memory > Write to memory card" in the "Project" menu. 

Transferring objects from the memory card to the project
You can transfer Individual blocks (multiple selection is possible) by dragging them to the 
project. A hardware configuration cannot be transferred from the memory card to the project.
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Updating firmware with a memory card
You can get the latest firmware data on the Internet from the Service & Support pages: 

http://support.automation.siemens.com (http://support.automation.siemens.com/WW/view/en/
34143537)

Save the firmware files on the hard disk and plug the SIMATIC Memory Card into the card 
reader of your programming device.

To store the file on the memory card, select the memory card in the "Card Reader/USB 
memory" folder in the project tree. Select the shortcut menu "Card Reader/USB memory > 
Create firmware update memory card". 

Then follow the instructions in the Service & Support portal for performing a firmware update 
with your CPU.

Updating the firmware changes the CPU firmware status. If you have used the CPU in the 
project, you will have to update the CPU already configured to the CPU with the new firmware 
status by changing devices offline, and adapt and then load the program or configuration. 

See also
Replacing a hardware component (Page 539)

Useful information on CPU firmware versions and STEP 7 versions (Page 1137)

Load memory

Function    
Each CPU has an internal load memory. The size of this internal load memory depends on the 
CPU used. 

This internal load memory can be replaced by using external memory cards. If there is no 
memory card inserted, the CPU uses the internal load memory; if a memory card is inserted, 
the CPU uses the memory card as load memory. 

The size of the usable external load memory cannot, however, be greater than the internal 
load memory even if the inserted SD card has more free space. 

See also
Using memory cards (Page 438)

Work memory

Function    
Work memory is a non-retentive memory area for storing elements of the user program that 
are relevant for program execution. The user program is executed exclusively in work memory 
and system memory.
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System memory

System memory areas

Function                         
System memory contains the memory elements that each CPU makes available to the user 
program, such as the process image and bit memory. 

By using appropriate operations in your user program, you address the data directly in the 
relevant operand area. 

The following table shows the operand areas of the system memory:

Operand area Description Access via units of the following size: S7 notation
Process image output The CPU writes the values 

from the process image 
output table to the output 
modules at the start of the 
cycle.

Output (bit) Q
Output byte QB
Output word QW
Output double word QD

Process image input The CPU reads the inputs 
from the input modules and 
saves the values to the 
process image input table at 
the start of the cycle.

Input (bit) I
Input byte IB
Input word IW
Input double word ID

Bit memory This area provides storage 
for intermediate results 
calculated in the program.

Bit memory (bit) M
Memory byte MB
Memory word MW
Memory double word MD

Data block Data blocks store 
information for the program. 
They can either be defined 
so that all code blocks can 
access them (global DBs) or 
assigned to a specific FB or 
SFB (instance DB).
Requirement: The block 
attribute "Optimized block 
access" is not enabled.

Data bit DBX
Data byte DBB
Data word DBW
Data double word DBD

Local data This area contains the 
temporary data of a block 
while the block is being 
processed. 
Requirement: The block 
attribute "Optimized block 
access" is not enabled.
Recommendation: Access 
local data (temp) 
symbolically.

Local data bit L
Local data byte LB
Local data word LW
Local data double word LD

I/O input area The I/O input and output 
areas permit direct access to 

I/O input bit <tag>:P

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
1074 System Manual, 02/2014



Operand area Description Access via units of the following size: S7 notation
central and distributed input 
and output modules.

I/O input byte
I/O input word
I/O input double word

I/O output area I/O output bit
I/O output byte
I/O output word
I/O output double word

See also
Diagnostics buffer (Page 1077)

Basic principles of process images (Page 1076)

Access to the I/O addresses (Page 1078)

Retentive memory areas

Retentive memory areas   
Data loss after power failure can be avoided by marking certain data as retentive. This data is 
stored in a retentive memory area. A retentive memory area is an area that retains its content 
following a warm restart, in other words, after cycling the power when the CPU changes from 
STOP to RUN. 

The following data can be assigned retentivity:

● Bit memory: The precise width of the memory can be defined for bit memory in the PLC tag 
table or in the assignment list.

● Tags of a function block (FB): You can define individual tags as retentive in the interface 
of an FB if you have enabled optimized block access. Retentivity settings can be defined 
only in the assigned instance data block if optimized block access has not been activated 
for the FB.

● Tags of a global data block: You can define retentivity either for individual or for all tags of 
a global data block depending on the settings for access.

– Block with optimized access: retentivity can be set for each individual tag.

– Block with standard access: The retentivity setting applies to all tags of the DB; either 
all tags are retentive or no tag is retentive.

See also
Warm restart (Page 1067)
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process image input/output

Basic principles of process images

Function
When the user program addresses the input (I) and output (O) operand areas, it does not query 
or change the signal states on the digital signal modules. Instead, it accesses a memory area 
in the system memory of the CPU. This memory area is referred to as the process image.

Advantages of the process image
Compared with direct access to input and output modules, the main advantage of accessing 
the process image is that the CPU has a consistent image of the process signals for the 
duration of one program cycle. If a signal state on an input module changes during program 
execution, the signal state in the process image is retained until the process image is updated 
again in the next cycle. The process of repeatedly scanning an input signal within a user 
program ensures that consistent input information is always available.

Access to the process image also requires far less time than direct access to the signal modules 
since the process image is located in the internal memory of the CPU.

Updating the process images

Sequence    
The operating system updates the process images at cyclic intervals unless defined otherwise 
in your configuration. The process image input/output is updated in the following order:

1. The internal tasks of the operating system are performed.

2. The process image output (PIQ) table is written to the outputs of the module.

3. The status of inputs is read to the process image input (PII) table.

4. The user program is executed with all the blocks that are called in it.

The operating system automatically controls the writing of the process image output to the 
outputs of the modules and the reading of the process image input.

Special characteristics
You have the option of accessing inputs or outputs directly using direct I/O access. 

● If an instruction accesses an output directly and the output address is located in the process 
image output, the process image of the relevant output is updated.

● If an instruction accesses an output directly and the output address is not located in the 
process image output, the process image of the relevant output is not updated.
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Example of normal I/O access by way of the process image

Update QW10 in the I/O output area with the value from MW0.

I/O access error during process image updating
If an error occurs during process image updating (I/O access error), the CPU reacts with the 
default system reaction "Ignore". 

See also
Start address of a module (Page 1078)

Access to the I/O addresses (Page 1078)

Startup activities (Page 1068)

Diagnostics buffer

Function   
The diagnostics buffer is part of the system memory of the CPU. It contains the errors detected 
by the CPU or modules with diagnostics capability. It includes the following events:

● Every mode change of the CPU (for example, POWER UP, change to STOP mode, change 
to RUN mode)

● Every diagnostics interrupt

The diagnostics buffer of the S7-1200-CPU has a capacity of 50 entries of which the last (most 
recent) 10 entries are retained following power cycling. 

Those entries can only be cleared by restoring the CPU to factory defaults.

You can read the content of the diagnostics buffer with the help of the Online and Diagnostics 
view.

See also
Basic information on the diagnostics buffer  (Page 1245)
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I/O data area

Start address of a module

Definition 
The start address is the lowest byte address of a module. It acts as the initial address of the 
module user data area. 

Configuring module start addresses 
The addresses used in the user program and the module start addresses are coordinated 
when the modules are configured. 

In the module properties ("I/O addresses" group), you can change the start addresses that 
were assigned automatically after the modules were inserted. 

You can also make a setting that decides whether or not the addresses are located in the 
process image. 

Access to the I/O addresses

I/O addresses               
If you insert a module in the device view, its user data is located in the process image of the 
S7-1200 CPU (default). The CPU handles the data exchange between the module and the 
process image area automatically during the update of the process images. 

Append the suffix ":P" to the I/O address if you want the program to access the module directly 
instead of using the process image. 

This could be necessary, for example, during execution of a time-sensitive program which also 
has to control the outputs within the same cycle. 
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Basics of program execution

Events and OBs

Events and OBs
The operating system of S7-1200-CPUs is based on events. There are two types of events:

● Events which can start an OB

● Events which cannot start an OB

An event which can start an OB triggers the following reaction:

● It calls the OB you possibly assigned to this event. The event is entered in a queue according 
to its priority if it is currently not possible to call this OB.

● The default system reaction is triggered if you did not assign an OB to this event.

An event which cannot start an OB triggers the default system reaction for the associated event 
class.

The user program cycle is therefore based on events, the assignment of OBs to those events, 
and on the code which is either contained in the OB, or called in the OB.

The following table provides an overview of the events which can start an OB, including the 
associated event classes and OBs. The table is sorted based on the default OB priority. Priority 
class 1 is the lowest.

Event class OB no. Number of 
OBs

Start event OB priority 
(default)

Cyclic program 1, >= 123 >= 1 Starting or end of the last program cycle OB 1
Startup 100, >= 

123
>=0 STOP to RUN transition 1

Time-of-day interrupt >= 10 Max. 2 Start time has been reached 2
Time-delay interrupt >= 20 Max. 4 Delay time expired 3
Cyclic interrupt >= 30 Constant bus cycle time expired 8
Hardware interrupt >= 40 Max. 50 

(more can 
be used with 
DETACH 
and 
ATTACH)

● Positive edge (max. 16)
● Negative edge (max. 16)

18

● HSC: Count value = reference value (max. 
6)

● HSC: Count direction changed (max. 6)
● HSC: External reset (max. 6)

18

Status interrupt 55 0 or 1 CPU has received status interrupt 4
Update interrupt 56 0 or 1 CPU has received update interrupt 4
Manufacturer- or profile-
specific interrupt

57 0 or 1 CPU has received manufacturer-specific or 
profile-specific interrupt

4

Diagnostic error interrupt 82 0 or 1 Module has detected an error 5
Pull/plug interrupt 83 0 or 1 Removal/insertion of modules of distributed I/O 6
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Event class OB no. Number of 
OBs

Start event OB priority 
(default)

Rack error 86 0 or 1 Error in the I/O system of the distributed I/O 6
Time error 80 0 or 1 ● Maximum cycle time exceeded

● Called OB is still being executed
● Time-of-day interrupt missed
● Time-of-day interrupt missed during STOP
● Queue overflow
● Interrupt loss due to high interrupt load

22

 

The following table describes events which do not trigger an OB start, including the 
corresponding reaction of the operating system. The table is sorted based on event priority.

Event class Event Event priority System reaction
Insert/remove central modules Insert/remove a module 21 STOP
I/O access error during 
process image update

I/O access error during process image update 22 Ignore

Programming error Programming error in a block for which you 
use system reactions provided by the 
operating system (note: the error handling 
routine in the block program is executed if 
you activated local error handling).

23 RUN

I/O access error I/O access error in a block for which you use 
system reactions provided by the operating 
system (note: the error handling routine in the 
block program is executed if you activated 
local error handling).

24 RUN

Maximum cycle time exceeded 
twice

Maximum cycle time exceeded twice 27 STOP

 

Assignment between OBs and events
With the exception of the cyclic program and startup program and event can only be assigned 
to one OB. However, in certain event classes such as hardware interrupts one and the same 
OB can be assigned to several events.

The assignment between OBs and events is defined in the hardware configuration. Defined 
assignments can be changed at runtime by means of ATTACH and DETACH instructions.

OB priority and runtime behavior
S7-1200-CPUs support the priority classes 1 (lowest) to 27 (highest). An OB is assigned the 
priority of its start event.

OBs are always executed on a priority basis: The OBs with the highest priority are executed 
first. Events of the same priority are processed in order of occurrence. 
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As of firmware version V4.0 of the S7-1200 CPUs you can specify in the device configuration, 
under properties of the CPU, if the OBs are interruptible or not. This parameter assignment 
has an effect on all OBs with exception of the cycle OBs which are always interruptible.

The following applies to S7-1200 CPUs with firmware version < V4.0:

● Any OB with priority >= 2 will interrupt cyclic program execution.

● An OB of priority 2 to 25 cannot be interrupted by any event of priority group 2 to 25. This 
rule also applies to events of a priority higher than that of the currently active OB. Such 
events are processed later.

● A time error (priority 26) will interrupt any other OB.

The following applies to S7-1200 CPUs as of firmware version V4.0:

If you do not configure the OBs as interruptible, an OB is always processed completely even 
if an event of a higher priority occurs during its runtime. Specifically, this means:

● Any OB with priority >= 2 will interrupt cyclic program execution.

● An OB of priority 2 to 25 cannot be interrupted by any event. This rule also applies to events 
of a priority higher than that of the currently active OB, which also includes a time error. 
Such events are processed later.

If you do configure the OBs as interruptible and an event of a higher priority occurs during the 
runtime of an OB, the running OB is interrupted and the OB associated with the occurring event 
is processed. Once this OB has been completed, processing of the interrupted OB continues. 
Specifically, this means:

● Any OB with priority >= 2 will interrupt cyclic program execution.

● An OB of priority 2 to 25 can be interrupted by any event whose priority is higher than that 
of the running OB. This is also true for time errors: A time error (priority 26) will interrupt 
any OB.

OB start information
Certain OBs have start information, while others do not. This is explained in greater detail in 
the description of the relevant OB.

See also
Event-based program execution (Page 1081)

Event-based program execution

OB priority and runtime behavior
S7-1200-CPUs support the priority classes 1 (lowest) to 27 (highest). An OB is assigned the 
priority of its start event.

Interrupt OBs can only be interrupted by time error interrupts. This rule also applies to events 
of a priority higher than that of the currently active OB. That is, only one interrupt OB can be 
active, with exception of the time error interrupt OB.
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Any further event of generated while an interrupt OB is being executed is added to a queue in 
accordance with its priority. Start events within a queue are processed later based on the 
chronological order of their occurrence.

Program execution on the CPU
Cyclic OBs are interrupted by interrupt OBs.

Reactions to events which start an interrupt OB:

● For CPUs up to firmware version V3: Interrupt OBs can only be interrupted by time error 
interrupt OBs.

● For CPUs as of firmware version V4: Interrupt OBs can be interrupted by interrupt OBs of 
a higher priority.

The figure below shows the basic procedure in case interrupt OBs cannot be interrupted 
(behavior up to firmware version V3):
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① and 
②

An event (e.g. a hardware interrupt) calls its associated OB. 
A called OB is executed without interruption, including all of its nested blocks. Execution of 
the cyclic OB is resumed on completion of interrupt processing, provided the queue does not 
contain any events which trigger an OB start.

③ An interrupt OB can only be interrupted by a time error interrupt OB (OB 80).
④ An new alarm-triggering event occurs during interrupt processing. 

Reaction for CPUs up to and including firmware version V3: 
This new event is added to a queue. The queued events successively call their corresponding 
OBs only after execution of the current interrupt OBs was completed and according to the 
following rules: 
● Events are processed in the order of their priority (starting at the highest priority).
● Events of the same priority are processed in chronological order.
Reaction for CPUs as of firmware version V4:
You use a CPU parameter to set the interruptibility for CPUs as of firmware version V4. 
Default behavior: OBs are interruptible. In this case: If the new event has a higher priority 
than the currently running OB, the OB started by the new event interrupts the currently running 
OB.
If you disable the option, the interrupt OBs cannot be interrupted.

⑤ The cyclic OBs are processed one after the other. 
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Notes on queues
● Every priority class (OBs of the same priority to be called) is assigned a separate queue. 

The size of those queues is set by default.

● Any new event leading to the overflow of a queue is discarded and therefore lost. A "time 
error interrupt event" is generated simultaneously. Information identifying the OB that 
caused the error is included in the start information of the time error interrupt OB (OB 80). 
A corresponding reaction such as an alarm trigger can be programmed in the time error 
interrupt OB.

Example of a hardware interrupt event
The function principle of event-oriented program execution in the S7-1200 CPU is described 
based on the example of a hardware interrupt-triggering module. 

Process events and their priority
Process events are triggered by the I/O (e.g. at a digital input) and initiate a call of the assigned 
OB in the S7-1200 CPU. OBs assigned to a process event are called hardware interrupt OBs. 

Examples of process events and their priority:

● Process events "rising edge" or "falling edge" at an interrupt-triggering module: The 
hardware interrupt OB started by such an event is always assigned priority 5.

● Process events from a high-speed counter

– Count value corresponds to the reference value

– Change count direction

– External reset of the high-speed counter
The hardware interrupt OB started by this event is always assigned priority 6. 

The figure below shows the chronological sequence of hardware interrupt execution: In the 
case of two hardware interrupt events in immediate succession, the second hardware interrupt 
triggering event is held back in the queue until the first OBx has been processed. The next 
hardware interrupt triggering event can only start the associated OBx when the OBx has been 
processed. Additional hardware interrupt triggering events are lined up in the queue according 
to this principle. 
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Hardware interrupt execution

① A hardware interrupt-triggering event such as a rising edge at the input calls the OB to 
which it is assigned.

② If a new event occurs that triggers a hardware interrupt while the OB is executing, this 
event is entered in a queue. 

③ The new event that triggers a hardware interrupt starts the hardware interrupt OB 
assigned to the event. 

Assigning the interrupt-triggering event
The interrupt-triggering event is assigned to an OB in the input properties of the device view.

● An interrupt-triggering event can only be assigned to a single OB.

● OBs, however, can be assigned to several interrupt-triggering events. 
This means, for example, that you can assign both the rising and the falling edge to the 
same interrupt OB in order to trigger the same reaction to any change of the input signal.
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● The started OB can interrupt a cycle OB at every instruction. Consistent data access is 
secured up to dword size.

● You can parameterize module-specific interrupt-triggering events such as a rising and the 
falling edge at the input.

● Assign the interrupt-triggering event and the OB to be started in the configuration of the 
interrupt-triggering module. However, within the started hardware interrupt OB you can 
override this assignment using the DETACH instruction, or assign the same event to a 
different OB using the ATTACH instruction. This functionality allows a flexible reaction to 
external process signals.

Setting the operating behavior

Changing properties of the modules

Default settings
When they leave the factory, all hardware components with parameters have default settings 
suitable for standard applications. These default values allow the hardware components to be 
used immediately without making any additional settings. 

You can, however, modify the behavior and the properties of the hardware components to suit 
the requirements and circumstances of your application. Hardware components with settable 
parameters include, for example, communications modules and several analog and digital 
modules.

Setting and loading parameters
When you have selected a hardware component in the device or network view, you can set 
the properties in the Inspector window. When you save a device configuration with its 
parameters, data is generated that needs to be loaded on the CPU. This data is transferred 
to the relevant modules during startup.

Properties of the CPUs  
The properties of the CPUs have special significance for system behavior. For example for a 
CPU you can set:

● Interfaces

● Inputs and outputs

● High-speed counters

● Pulse generators

● Startup behavior

● Time-of-day

● Protection level

● Bit memory for system and clock
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● Cycle time

● Communications load

The entry possibilities specify what is adjustable and in which value ranges. Fields that cannot 
be edited are disabled or are not shown in the properties window.

Requirement
You have already arranged the hardware components for which you want to change properties 
on a rack.

Procedure
To change the properties and parameters of the hardware components, follow these steps:

1. In the device or network view, select the hardware component or interface that you want 
to edit.

2. Edit the settings for the selected object:

– For example in the device view you can edit addresses and names.

– In the Inspector window additional setting possibilities are available.

You do not need to confirm your entries, the changed values will be applied immediately.

See also
Editing properties and parameters (Page 539)

Introduction to loading a configuration (Page 1049)

CPU properties

Overview of the CPU properties

Overview                           
The following table provides you with an overview of the CPU properties:

Group Properties Description
General Project information General information to describe the inserted CPU. Except for the 

slot number, you can change this information.
Catalog information Read-only information from the hardware catalog for this CPU.

PROFINET interface General Name and comment for this PROFINET interface. The name is 
limited to 110 characters.
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Group Properties Description
Ethernet addresses Select whether the PROFINET interface is networked. If subnets 

have already been created in the project, they are available for 
selection in the drop-down list. If not, you can create a new subnet 
with the "Add new subnet" button.
Information on the IP address, subnet mask and IP router usage 
in the subnet is available in the IP protocol. If an IP router is used, 
the information about the IP address of the IP router is necessary.

Advanced options Name, comment and additional setting options of the Ethernet 
interface port.

Time synchronization Settings for time synchronization in the NTP time format.
The NTP (network time protocol) is a general mechanism for 
synchronizing system clocks in local and global area networks. 
In NTP mode, the interface of the CPU sends time queries (in 
client mode) at regular intervals to NTP servers on the subnet 
(LAN) and the addresses must be set in the parameters here. 
Based on the replies from the server, the most reliable and most 
accurate time is calculated and synchronized. The advantage of 
this mode is that it allows the time to be synchronized across 
subnets. The accuracy depends on the quality of the NTP server 
being used.

DI#/DO# General Name of and comment on the integrated digital inputs of the CPU. 
Digital inputs
 

Input delays can be set for digital inputs. The input delays can be 
set in groups (in each case for 4 inputs). 
The detection of a positive and a negative edge can be enabled 
for each digital input. A name and a hardware interrupt can be 
assigned to this event. 
Depending on the CPU, pulse catches can be activated at various 
inputs. When the pulse catch is activated, even pulse edges that 
are shorter than the cycle time of the program are detected. 

Digital outputs The reaction to a mode change from RUN to STOP can be set 
for all digital outputs: 
The state can either be frozen (corresponds to retain last value) 
or you set a substitute value ("0" or "1")

I/O addresses The address space of the input and output addresses is specified 
as is the process image.

Hardware identifier The hardware identifier of the device is displayed.
AI# General Name of and comment on the integrated analog inputs of the 

CPU.
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Group Properties Description
Analog inputs During noise reduction, the specified integration time suppresses 

interference frequencies at the specified frequency (in Hz). 
The channel address, measurement type, voltage range, 
smoothing and overflow diagnostics must be specified in the 
"Channel #" group. The measurement type and voltage range 
are set permanently to voltage, 0 to 10 V.
Smoothing analog values provides a stable analog signal for 
further processing. Smoothing analog values can be useful with 
slow measured value changes, for example, in temperature 
measurement. The measured values are smoothed with digital 
filtering. Smoothing is achieved by the module forming mean 
values from a specified number of converted (digitalized) analog 
values. The selected level (slight, medium, strong) decides the 
number of analog signals used to create the mean value.
If overflow diagnostics is enabled, a diagnostics event is 
generated if an overflow occurs.

I/O addresses The address space of the input addresses is specified as is the 
process image.

Hardware identifier The hardware identifier of the device is displayed.
High-speed counter 
(HSC)

High-speed counter (HSC)# High-speed counters are typically used to drive counting 
mechanisms.
See: Configuring high-speed counters (Page 1098) 

Pulse generators 
(PTO/PWM)

PTO#/PWM# A pulse generator is activated and can be initialized with project 
information.
For the configuration of an activated pulse generator, specify the 
usage as PWM (Pulse Width Modulation) or as PTO (Pulse Train 
Output).
Specify the output source, time base, pulse width format, cycle 
time and initial pulse width for PWM. A pulse output is specified 
as the hardware output. The PWM output is controlled by the 
CTRL_PWM instruction, see CTRL_PWM.
Specify the output source for PTO. A pulse output and a direction 
output are specified as the hardware outputs. A PTO is operated 
together with a high-speed counter in the "axis of motion" count 
mode and controlled by the Motion Control technology object 
(see keyword "Motion Control S7-1200") . 
The hardware ID is displayed in the I/O-diagnostics addresses 
and, if the PWM function is selected, the address space of the 
output addresses and the process image can be selected.

Startup Startup after POWER ON Setting the startup characteristics after cycling power. 
See: Principles of the STARTUP mode (Page 1067) 

Comparison of preset 
configuration and actual 
configuration

Specifies whether modules (SM, SB, CM, CP or even the CPU) 
can be replaced:
● Startup of the CPU only if compatible
● Startup of the CPU even if there are differences
Example: A signal module with 16 digital inputs and 16 digital 
outputs (DI16/DQ16) can be a compatible replacement for a 
signal module with 8 digital outputs (DQ8) or 4 digital inputs (DI4).
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Group Properties Description
Parameter assignment time for 
distributed I/O

Specifies a maximum period (standard: 60000 ms) in which the 
distributed I/O must start up. (The CMs and CPs are supplied 
with voltage and communication parameters during the CPU 
startup. This configuration time provides a time period during 
which I/O modules connected to the CM or CP must start up.)
The CPU switches to RUN as soon as the distributed I/O has 
started and is ready for operation, regardless of the "Parameter 
assignment time for distributed I/O" parameter. If the distributed 
I/O has not started up during this period, the CPU switches to 
RUN without the distributed I/O.

Cycle Maximum cycle time and 
minimum cycle time. 

Specification of a maximum cycle time or a fixed minimum cycle 
time.
If the cycle time exceeds the maximum cycle time, the CPU goes 
to STOP mode. 
See: Cycle time and maximum cycle time (Page 1091) 

Communication load Maximum allocation of the cycle 
for communication (as a 
percentage)

Controls the duration of communication processes that always 
also extend the cycle time, within certain limits. Examples of 
communication processes include: Transferring data to another 
CPU or loading blocks (initiated via the PC).
See: Cycle loading by communications (Page 1092) 

System and clock 
memory

System memory bits and clock 
memory bits

You use system memory bits for the following scans: 
● Is the current cycle the first since cycling power?
● Have there been any diagnostics state changes compared 

with the previous cycle?
● Scan for "1" (high)
● Scan for "0" (low)
Clock memory bits change their values at specified periodic 
intervals.
See: Enabling system memory (Page 1108) 
See: Using clock memory (Page 1109) 

Web server Automatic update Sends the requested web page with current CPU data 
periodically to the web browser. Enter the period duration under 
"Update interval". Automatic update can only be activated if the 
web server is enabled.
See: Auto-Hotspot 

User-defined web pages Allows access to freely-designed web pages of the CPU via a 
web browser.
See: Auto-Hotspot 

Time Local time and daylight saving 
time

Setting of the time zone in which the CPU is operated and setting 
of the daylight-saving/standard time changeover.

Protection Protection and password for read/
write access

Setting the read/write protection and the password for access to 
the CPU.
See: Setting options for the protection level (FW V1 to V3) 
(Page 1110) 
See: Setting options for the protection (FW as of V4) 
(Page 1111)
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Group Properties Description
Connection resources - Display of available, reserved and previously configured 

connection resources of the CPU.
Address overview - Tabular representation of all addresses used by the CPU for 

integrated inputs/outputs as well as for the inserted modules. 
Addresses that are not used by any module are represented as 
gaps. 
The view can be filtered according to 
● Input addresses
● Output addresses
● Address gaps

See also
Specifying input and output addresses (Page 782)

Assigning parameters to hardware interrupt OBs (Page 1132)

Access to the I/O addresses (Page 1078)

Addressing modules (Page 781)

Special features during startup (Page 1069)

Cycle time and maximum cycle time

Function       
The cycle time is the time that the operating system requires to execute the cyclic program 
and all the program sections that interrupt this cycle. The program execution can be interrupted 
by: 

● Time errors and 2xMaxCycleTime errors

● System activities, e.g., process image updating

The cycle time (Tcyc) is therefore not the same for every cycle. 

The following schematic shows an example of different cycle times (TZ1 ≠ TZ2) for S7-1200 
CPUs:
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In the current cycle, the cyclic OB used here (e.g. OB 1) will be interrupted by a time error (e.g. 
OB 80). Following the cyclic OB, the next cycle OB 201 is processed. 

Maximum cycle time   
The operating system monitors the execution time of the cyclic program for a configurable 
upper limit known as the maximum cycle time. You can restart this time monitoring at any point 
in your program by calling the RE_TRIGR instruction.

If the cyclic program exceeds the maximum cycle time, the operating system will attempt to 
start the time error OB (OB 80). If the OB is not available, the CPU ignores the overshoot of 
the maximum cycle time.

In addition to monitoring the runtime for overshooting of the maximum cycle time, adherence 
to a minimum cycle time is guaranteed. To do this, the operating system delays the start of 
the new cycle until the minimum cycle time has been reached. During this waiting time, new 
events and operating system services are processed.

If the maximum cycle time is exceeded a second time, for example while the time error OB is 
being processed (2xMaxCycleTime error), the CPU changes to STOP mode.

Cycle loading by communications

Function    
The cycle time of the CPU can be extended due to communications processes. These 
communications processes include for example: 

● Transferring data to another CPU

● Loading of blocks initiated by a programming device

You can control the duration of these communications processes to some extent using the 
CPU parameter "Cycle load due to communication". 
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In addition to communications processes, test functions also extend the cycle time. The "Cycle 
load due to communication" parameter can be used to influence the duration. 

How the parameter works
You use the "Cycle load due to communication" parameter to enter the percentage of the 
overall CPU processing capacity that can be available for communications processes. This 
CPU processing capacity is now available at all times for communication. This processing 
capacity can be used for program execution when not required for communication.

Effect on the actual cycle time
The "Cycle load due to communication" parameter can be used to extend the cycle time of the 
cyclic organization block (e.g., OB 1) by a factor calculated according to the following formula:

The formula does not take into account the effect of asynchronous events such as hardware 
interrupts or cyclic interrupts on the cycle time. 

If the cycle time is extended due to communication processes, more asynchronous events 
may occur within the cycle time of the cyclic organization block. This extends the cycle still 
further. The extension depends on how many events occur and how long it takes to process 
them.

Example 1 – no additional asynchronous events:
If the "Cycle load due to communication" parameter is set to 50%, this can cause the cycle 
time of the cyclic organization block to increase by up to a factor of 2.

Example 2 – additional asynchronous events:
For a pure cycle time of 500 ms, a communication load of 50% can result in an actual cycle 
time of up to 1000 ms, provided that the CPU always has enough communications jobs to 
process. If, parallel to this, a cyclic interrupt with 20 ms processing time is executed every 100 
ms, this cyclic interrupt would extend the cycle by a total of 5*20 ms = 100 ms without 
communication load. That is, the actual cycle time would be 600 ms. Because a cyclic interrupt 
also interrupts communications, it affects the cycle time by adding 10 * 20 ms at 50 % 
communication load. That is, in this case, the actual cycle time amounts to 1200 ms instead 
of 1000 ms.

 

 Note

Observe the following:
● Check the effects of changing the value of the "Cycle load due to communication" 

parameter while the system is running.
● You must always consider the communication load when setting the minimum cycle time 

as time errors will otherwise occur.
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Recommendations
● Increase this value only if the CPU is used primarily for communication purposes and the 

user program is not time critical.

● In all other situations you should only reduce this value.

Time-of-day functions

Basic principles of time of day functions
All S7-1200 CPUs are equipped with an internal clock. The backup supports the display of the 
correct time for up to 10 hours if the power supply is interrupted.

Time-of-day format    
The clock always shows the time of day with a resolution of 1 millisecond and the date including 
the day of the week. The time adjustment for daylight-saving time is also taken into account.

Setting and reading the time of day

Setting and reading the time with instructions     
You can set, start and read the time-of-day and date on the CPU clock with the following 
instructions in the user program:

● Set the time-of-day: "WR_SYS_T"

● Read time of day "RD_SYS_T"

● Read local time "RD_LOC_T"

● Set time zone "SET_TIMEZONE"

Manual setting
You can also read and set the time-of-day manually in the online and diagnostics view under 
"Functions > Set time-of-day".
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Assigning the clock parameters

Clock parameters 
The clock parameters allow you to make the following settings:

● Enable time synchronization via NTP server
Select this check box if you want the internal clock to be synchronized using the NTP 
synchronization mode.

● Network time server
The IP addresses of up to four NTP servers need to be configured.

● Update interval
The update interval defines the interval between time queries.

High-speed counters

General information on high-speed counters

Introduction    
High-speed counters are typically used to drive counting mechanisms in which a shaft turning 
at a constant speed is equipped with an incremental step encoder. The incremental step 
encoder ensures a certain number of count values per rotation and a reset pulse once per 
rotation. The clock memory bit(s) and the reset pulse of the incremental step encoder supply 
the inputs for the high-speed counter.

The various S7-1200 CPUs have differing numbers of high-speed counters available:

S7-1200 CPU Number of HSCs HSC designation
CPU 1211C 3 (with digital signal board 4)* HSC1…3 (and HSC5)*
CPU 1212C 4 (with digital signal board 5)* HSC1…4 (and HSC5)*
CPU 1214C
CPU 1215C
CPU 1217C

6 HSC1…6

* with DI2/DO2 signal board

How it works  
The first of several default values is loaded on the high-speed counter. The required outputs 
are enabled for the time during which the current value of the counter is lower than the default 
value. The counter is set up so that an interrupt occurs if the current value of the counter is 
equal to the default value or when the counter is reset.

If the current value is equal to the default value and an interrupt event results, a new default 
value is loaded and the next signal state is set for the outputs. If an interrupt event occurs 
because the counter is reset, the first default value and the first signal states of the outputs 
are set and the cycle repeated.
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Since the interrupts occur much less frequently than the high-speed counter counts, a precise 
control of the fast operations can be implemented with only a slight influence on the overall 
cycle of the automation system. Since you can assign specific interrupt programs to interrupts, 
each new default can be loaded in a separate interrupt program allowing simple control of the 
state.

 

 Note

You can also process all interrupt events in a single interrupt program.
 

Count algorithms of the various counters
All counters work in the same way, however some high-speed counters do not support all 
count algorithms. There are four basic count algorithms:

● Single-phase counter with internal direction control

● Single-phase counter with external direction control

● 2-phase counter with 2 clock inputs

● A/B counter

Each high-speed counter can be used with or without a reset input. If the reset input is activated, 
this resets the current value. The current value remains reset until the reset input is deactivated.

See also
Configuring high-speed counters (Page 1098)

Interdependency of the counter mode and counter inputs (Page 1096)

Interdependency of the counter mode and counter inputs

General information on counter mode and counter inputs   
You can assign not only the counter modes and counter inputs to the high-speed counters but 
also functions such as clock pulse generator, direction control, and reset. The following rules 
apply:

● An input cannot be used for two different functions.

● If an input is not required by the current counter mode of the defined high-speed counter, 
it can be used other purposes.

If, for example, you set HSC1 to counter mode 1, in which inputs I0.0 and I0.3 are required, 
you can use I0.1 for edge interrupts or for HSC2.

If, for example, you set HSC1 and HSC5, inputs I0.0 (HSC1) and I1.0 (HSC5) are always used 
with the counting and frequency counter modes. As a result, these two inputs are not available 
for any other functions when counters are operated.

You have additional inputs available if you use a digital signal board.
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Overview of the interdependency of counter mode and counter inputs

Counter mode Description Inputs
 HSC1 I0.0 (CPU)

I4.0 (signal board)
I0.1 (CPU)
I4.1 (signal board)

I0.3 (CPU)
I4.3 (signal board)

HSC2 I0.2 (CPU)
I4.2 (signal board)

I0.3 (CPU)
I4.3 (signal board)

I0.1 (CPU)
I4.1 (signal board)

HSC3* I0.4 (CPU) I0.5 (CPU) I0.7 (CPU)
HSC4 (CPU 1212/14/15/17C 
only)

I0.6 (CPU) I0.7 (CPU) I0.5 (CPU)

HSC5 (CPU 1214/15/17C 
only)**

I1.0 (CPU)
I4.0 (signal board)

I1.1 (CPU)
I4.1 (signal board)

I1.2 (CPU)
I4.3 (signal board)

HSC6 (CPU 1214/15/17C 
only)**

I1.3 (CPU) I1.4 (CPU) I1.5 (CPU)

Counting / 
frequency

Single-phase counter with 
internal direction control

Clock pulse 
generator

- -

Counting Resetting
Counting / 
frequency

Single-phase counter with 
external direction control

Clock pulse 
generator

Direction -

Counting Resetting
Counting / 
frequency

2-phase counter with 2 clock 
inputs

Clock pulse 
generator forwards

Clock pulse 
generator backwards

-

Counting Resetting
Counting / 
frequency

A/B counter Clock pulse 
generator A

Clock pulse 
generator B

-

Counting Resetting
Motion axis Pulse generators PWM/PTO HSC1 and HSC2 support the motion axis count mode for the PTO1 

and PTO2 pulse generators:
● For PTO1, HSC1 evaluates the Q0.0 outputs for the number of 

pulses.
● For PTO2, HSC2 evaluates the Q0.2 outputs for the number of 

pulses.
Q0.1 is used as the output for the motion direction.

* HSC3 can only be used for CPU 1211 without a reset input

** HSC5 can be also be used for CPU 1211/12 if a DI2/DO2 signal board is used

See also
General information on high-speed counters (Page 1095)

Configuring high-speed counters (Page 1098)
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Configuring high-speed counters

Requirement
An S7-1200 CPU has been inserted in the hardware configuration.

Procedure  
To configure a high-speed counter, follow these steps:

1. Select an S7-1200 CPU in the device or network view.

2. Click on the required high-speed counter under "Properties > High-speed counter" in the 
inspector window:

– CPU 1211C: HSC1 to HSC3 (also HSC5 with a DI2/DO2 signal board)

– CPU 1212C: HSC1 to HSC4 (also HSC5 with a DI2/DO2 signal board)

– CPU 1214C / 1215C / 1217C: HSC1 to HSC6

3. Enable the high-speed counter in the "General" parameter group using the relevant check 
box.

 

  Note

If you use a CPU 1211C or CPU 1212C with a DI2/DO2 signal board, you can also enable 
the high-speed counter HSC5.

 

  Note

If you activate the pulse generators and operate them as PTO1 or PTO2, they use the 
associated high-speed counter HSC1 or HSC2 with "Motion axis" counting mode to 
evaluate the hardware outputs. If you configure high-speed counter HSC1 or HSC2 for 
other counting tasks, these cannot be used by pulse generator PTO1 or PTO2, 
respectively.

 

If required, you can enter a name and a comment for the high-speed counter here.

4. Define the functionality of the high-speed counter in the "Function" parameter group:

– Count mode: Select what you want to be counted from the drop-down list.

– Operating phase: Select the count algorithm from the drop-down list.

– Input source: Select the on-board CPU inputs or the inputs of an optional digital signal 
board as the input source for the count pulses from the drop-down list.

– Count direction is specified by: If you have selected a single-phase operating phase, 
open the drop-down list and select whether the count direction is set internally by an 
SFB parameter of the user program or externally via a digital input.

– Initial count direction: If the user program is set as the internal direction control for the 
count direction, you can select the count direction at the start of counting from the drop-
down list.

– Frequency meter period: If frequency is set as the count mode, you can select the 
duration of the frequency meter periods in the drop-down list.
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5. Specify the initial values and reset condition of the high-speed counter in the "Reset to initial 
values" parameter group:

– Initial counter value: Enter a start value for the high-speed counter.

– Initial reference value: Enter a maximum value for the high-speed counter.

Here, you can also specify whether the high-speed counter will use a reset input and the 
set the corresponding signal level for the reset input from the drop-down list.

6. Configure the reaction of the high-speed counter to certain events in the "Event 
configuration" parameter group. The following events can trigger an interrupt:

– The counter value matches the reference value.

– An external reset event was generated.

– A change of direction was triggered.

Enable an interrupt reaction using the check box, enter a name and select a hardware 
interrupt for the interrupt from the drop-down list.

7. Assign the start address for the high-speed counter in the "I/O/Diagnostics addresses" 
parameter group.

 

  Note

In the "Hardware inputs" parameter group, you can only see which hardware inputs and 
values are being used for the clock, direction determination, reset pulse, and maximum 
count speed.

 

Result
You have now adapted the parameters of the high-speed counter to the requirements of your 
project.

See also
General information on high-speed counters (Page 1095)

Interdependency of the counter mode and counter inputs (Page 1096)

Point-to-point communication

Overview of point-to-point communication
PtP communication is communication via a serial interface that uses standardized UART data 
transmission (Universal Asynchronous Receiver/Transmitter). The S7-1200 uses 
communications modules with an RS-232 or RS-485 interface to establish PtP communication.
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Functions of point-to-point communication  
Point-to-point communication (PtP) allows numerous applications:

● Direct transmission of information to an external device, for example a printer or a barcode 
reader

● Reception of information from external devices such as barcode readers, RFID readers, 
cameras and third-party optical systems as well as many other devices.

● Exchange of information with third-party devices, for example GPS devices, radio modems 
and many others

The Freeport protocol  
The S7-1200 supports the Freeport protocol for character-based serial communication. Using 
Freeport communication, the data transmission protocol can be configured entirely by the user 
program.

Siemens provides libraries with Freeport communication functions that you can use in your 
user program:

● USS Drive protocol

● Modbus RTU Master protocol

● Modbus RTU Slave protocol

See also
Configuring a communications port (Page 1101)

Using RS-232 and RS-485 communications modules

Communications modules with RS-232 and RS-485 interfaces  
In an S7-1200 CPU, you can use two different communications modules:

● RS-232 communications module

● RS-485 communications module

The communications modules can be connected to the S7-1200 CPU via the I/O channel on 
the left. You can plug in up to three different modules.

Properties of the communications modules  
The communications modules have the following features:

● Support of the Freeport protocol

● Configuration by the user program with the aid of expanded instructions and library functions
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Configuring a communications port

Configuring a communications port   
After you have inserted a communications module with an RS-232 or RS-485 interface, you 
then set the interface parameters. You set the parameters for the interface either in the 
properties of the interface or you control the interface parameters from the user program using 
the PORT_CFG instruction. The following description relates to the graphic configuration.

 

 Note

If you use the user program to change the port setting, the settings of the graphic configuration 
are overwritten.

You should also keep in mind that the settings made by the user program are not retained if 
there is a power down.

 

Requirement
● A communications module is already plugged in.

● You are in the device view.

Procedure
To configure the communications port, proceed as follows:

1. Select the interface in the graphic representation in the device view.
The properties of the interface are displayed in the Inspector window.

2. Select the "Port configuration" group in the area navigation of the Inspector window.
The settings of the port are displayed.

3. From the "Transmission speed" drop-down list, select the speed for the data transmission. 
With user-programmed communication, remember the influence of the transmission speed 
on the changeover time.

4. From the "Parity" drop-down list, select the type of detection of bad information words.

5. Using the "Data bits" drop-down list, decide whether a character consists of eight or seven 
bits.

6. From the "Stop bit" drop-down list, select how many bits will identify the end of a transmitted 
word.
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7. From the "Flow control" drop-down list, select the method for ensuring a trouble-free data 
stream between sender and receiver. This parameter can only be set for the RS-232 
interface.

– Enter a HEX value in the "XON character" box that will cause the transmission of the 
message to be continued when it is detected. This parameter can only be set for 
software-controlled data flow control.

– Enter a HEX value in the "XOFF character" box that will cause the transmission of the 
message to be suspended for the set wait time. This parameter can only be set for 
software-controlled data flow control.

8. In the "Wait time" box, enter a wait time in ms that must be kept to after the end of the 
message before the next transmission can start.

 

 Note

You can configure the interface in the network view as well. To do so, you must first select 
the communication module in the tabular network view and then select the interface in the 
Inspector window. Then you can continue as described above.

 

See also
Setting data flow control (Page 1102)

Setting data flow control

Data flow control
Data flow control is a method that ensures a balanced send and receive behavior. In the ideal 
situation, the intelligent control does not allow data to be lost. It ensures that a device does 
not send more information than the receiving partner can process.

There are two methods of data flow control:

● Hardware-controlled data flow control

● Software-controlled data flow control

With both methods, the DSR signals of the communications partners must be active at the 
beginning of transmission. If the DSR signals are inactive, the transmission is not started.

The RS-232 communications module can handle both methods. The RS-485 communications 
module does not support data flow control.

Hardware-controlled data flow control
Hardware-controlled data flow control uses the request to send (RTS) and clear to send (CTS) 
signals. With the RS-232 communications module, the RTS signal is transmitted via the output 
by pin 7. The CTS signal is received via pin 8.

If hardware-controlled data flow control is enabled, the RTS signal is then always set to 
activated when data is sent. At the same time, the CTS signal is monitored to check whether 
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the receiving device can accept data. If the CTS signal is active, the module can transfer data 
until the CTS signal becomes inactive. If the CTS signal is inactive, the data transfer must be 
suspended for the set wait time. If the CTS signal is still inactive after the set wait time, the 
data transfer is aborted and an error is signaled back to the user program.

Data flow control using hardware handshaking
If data flow control is controlled by hardware handshaking, the sending device sets the RTS 
signal to active as default. A device such as a modem can then transfer data at any time. It 
does not wait for the CTS signal of the receiver. The sending device itself monitors it own 
transmission by sending only a limited number of frames (characters), for example to prevent 
overflow of the receive buffer. If there is nevertheless an overflow, the transferring device must 
hold back the message and signal an error back to the user program.

Software-controlled data flow control
Software-controlled data flow control uses certain characters within the messages and these 
control the transfer. These characters are ASCII characters selected for XON and XOFF.

XOFF indicates when a transmission must be suspended. XON indicates when a transmission 
can be continued.

If the sending device receives the XOFF character, it must suspend sending for the selected 
wait time. If the XON character is sent after the selected wait time, the transfer is continued. 
If no XON character is received after the wait time, an error is signaled back to the user program.

Software data flow control requires full duplex communication because the receiving partner 
needs to send the XON character during the ongoing transfer.

See also
Configuring a communications port (Page 1101)

Configuration of message transfer

User-programmed communication  
You can control the data traffic between a communications module and a device connected 
externally via the serial interface using your own mechanisms. If you want to do this, you will 
need to define a communications protocol yourself. In freely programmable communication, 
ASCII and binary protocols are supported for message transfer.

Within the communications protocol, you will need to specify the criteria by which the start and 
end of a transferred message can be recognized in the data stream.

User-programmed communication can only be activated in RUN mode. If there is a change to 
STOP mode, the user-programmed communication is stopped.
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Specifying the communications protocol  
You can specify the communications protocol as follows:

● With the user program

– The behavior when sending data is controlled by the SEND_CFG instruction.

– The behavior when receiving data is controlled by the RCV_CFG instruction.

● Using parameter settings set graphically in the Inspector window
 

  Note

If you change the communications protocol from the user program, the settings of the 
graphic configuration are overwritten.

You should keep in mind that the settings made by the user program are not retained if 
there is a power down.

 

 

See also
User-programmed communication with RS-232 devices (Page 1104)

Making the settings for sending (Page 1106)

Specifying the start of the message (Page 1106)

Specifying the end of the message (Page 1107)

User-programmed communication with RS-232 devices

RS-232/PIP multi-master cable and user-programmed communication with RS-232 devices 
Using the RS-232/PIP multi-master cable and user-programmed communication, you can 
connect a wide variety of RS-232-compliant devices to the communications modules of the 
S7-1200. The cable must, however, be set to the "PIP/user-programmed communication" 
mode.

Settings on the cable
The switches on the cable must be set as follows:

● Switch 5 must be set to 0

● Switch 6 sets either the local mode (DCE) or the remote mode (DTE):

– Switch set to 0 for the local mode

– Switch set to 1 for the remote mode
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Changing over between send and receive mode
The RS-232/PIP multi-master cable is in send mode when data is sent from the RS-232 
interface to the RS-485 interface. The cable is in receive mode when it is idle or when data is 
sent from the RS-485 interface to the RS-232 interface. The cable changes from receive to 
send mode immediately when it detects characters on the RS-232 send line.

Supported transmission speeds
The RS-232/PIP multi-master cable supports transmission rates between 1200 baud and 115.2 
kbaud. The RS-232/PIP multi-master cable can be set to the required transmission rate using 
the DIP switch on the PC/PIP cable.

The following table shows the switch settings for the various transmission speeds:

Transmission speed Switchover time Settings (1 = up)
115200 bps 0.15 ms 110
57600 bps 0.3 ms 111
38400 bps 0.5 ms 000
19200 bps 1.0 ms 001
9600 bps 2.0 ms 010
4800 bps 4.0 ms 011
2400 bps 7.0 ms 100
1200 bps 14.0 ms 101

 

The cable returns to receive mode when the RS-232 send line is idle for a certain time that is 
defined as the changeover time of the cable. The set transmission speed influences the 
changeover time as shown in the table.

Influence of the changeover time 
When working with an RS-232/PIP multi-master cable in a system in which user-programmed 
communication is used, the program must take into account the changeover time for the 
following reasons:

● The communications module reacts to messages sent by the RS-232 device.
Once the communications module has received a request from the RS-232 device, it must 
delay the reaction message for a period that is equal to or longer than the changeover time 
of the cable.

● The RS-232 device reacts to messages sent by the communications module.
Once the communications module has received a reaction message from the RS-232 
device, it must delay the next request message for a period that is equal to or longer than 
the changeover time of the cable.

In both situations, the RS-232-PIP multi-master cable has enough time to change from send 
to receive mode so that the data can be sent from the RS-485 interface to the RS-232 interface.

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 1105



See also
Configuration of message transfer (Page 1103)

Making the settings for sending (Page 1106)

Specifying the start of the message (Page 1106)

Specifying the end of the message (Page 1107)

Making the settings for sending

Sending messages  
You can program pauses between individual messages.

The following table shows which pauses can be set:

Parameter Definition
RTS ON delay You can set the time that must elapse after the send request RTS 

(request to send) before the actual data transfer starts.
RTS OFF delay You can set the time that must elapse after the complete transfer 

before RTS signal is deactivated.
Send pause at the start of the 
message

You can specify that a pause is sent at the start of every message 
transfer when the RTS ON delay has elapsed.
The pause is specified in bit times.

Send Idle Line after a pause You can make a setting so that following a selected pause at the start 
of the message, the "Idle Line" signal is output to signal that the line 
is not in use. To enable the parameter, "Send pause at message start" 
must be set.
The duration of the "Idle Line" signal is specified in bit times.

See also
Specifying the start of the message (Page 1106)

Specifying the end of the message (Page 1107)

User-programmed communication with RS-232 devices (Page 1104)

Specifying the start of the message

Recognizing the start of the message  
To signal to the receiver when the transfer of a message is completed and when the next 
message transfer starts, criteria must be specified in the transmission protocol to identify the 
end and start of a message.

If a criterion is met that indicates the start of a message, the receiver starts searching the data 
stream for criteria that mean the end of the message.

There are two different methods for identifying the start of a message:
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● Starting with any character:
Any character can defined the start of a message. This is the default method.

● Starting with a specific condition:
The start of a message is identified based on selected conditions.

Conditions for detecting the start of a message
The following table shows the various options for defining the start of a message:

Parameter Definition
Recognize start of message 
by line break

The receiver recognizes a line break when the received data stream is 
interrupted for longer than one character. If this is the case, the start of 
the message is identified by the line break.

Recognize start of message 
by idle line

The start of a message is recognized when the send transmission line 
is in the idle state for a certain time (specified in bit times) followed by an 
event such as reception of a character.

Recognize start of message 
with individual characters

The start of a message is recognized when a certain character occurs. 
You can enter the character as a HEX value.

Recognize start of message 
by a character string

The start of a message is detected when one of the specified character 
sequences arrives in the data stream. You can specify up to four 
character sequences each with up to five characters.

The individual conditions can be logically linked in any way.

See also
Making the settings for sending (Page 1106)

User-programmed communication with RS-232 devices (Page 1104)

Specifying the end of the message

Recognizing the end of the message   
To signal to the receiver when the transfer of a message is completed and when the next 
message transfer starts, criteria must be specified in the transmission protocol to identify the 
end and start of a message.

In total, there are six different methods of recognizing the end of a message and these can all 
be logically linked in any way. The following table shows the various possible setting options:

Parameter Definition
Recognize end of message by 
message timeout

The end of a message is recognized automatically when a selected 
maximum duration for a message is exceeded. Values from 0 to 65535 
ms can be set.

Recognize end of message by 
reply timeout

The end of a message is recognized when there is no reply within a 
set time after transferring data. Values from 0 to 65535 ms can be set.
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Parameter Definition
Recognize end of message by 
timeout between characters

The end of a message is detected when the time between two 
characters specified in bit times is exceeded. Values from 0 to 2500 
bit times can be set.
The S7-1200 CPU only accepts a maximum time of eight seconds 
even if the value that is set results in a duration of more than eight 
seconds.

Recognize end of message by 
maximum length

The end of a message is recognized when the maximum length of a 
message is exceeded. Values from 1 to 1023 characters can be set.

Read message length from 
message

The message itself contains information about the length of the 
message. The end of a message is reached when the value taken from 
the message is reached. Which characters are used for the evaluation 
of the message length is specified with the following parameters:
● Offset of the length field in the message

The value decides the position of the character in the message that 
will be used to indicate the message length. 
Values from 1 to 1022 characters can be set.

● Size of the length field
This value specifies how many characters starting at the first 
evaluation position will be used to indicate the message length. 
Values of 0, 1, 2 and 4 characters can be set.

● The data following the length field 
(does not belong to the message length)
The value specifies the number of bytes after the length field that 
must be ignored in the evaluation of the message length. 
Values from 0 to 255 characters can be set.

Recognize message end with 
a character sequence

The end of a message is detected when the specified character 
sequence arrives in the data stream. You can define up to five 
characters in the character string that are to be checked. If the 
specified characters appear at the correct location in the message, the 
message end is recognized. To recognize the message end when 
character 1 and character 3 have a certain value, for example, you 
have to activate the check box for character 1 and character 3 and 
enter a character value.

 

See also
Making the settings for sending (Page 1106)

User-programmed communication with RS-232 devices (Page 1104)

Enabling system memory

System memory     
A system memory is a bit memory with defined values. 

You decide which memory byte of the CPU will become the system memory byte when 
assigning the system memory parameters. 
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Benefits
You can use system memory in the user program, for example to run program segments in 
only the first program cycle after start-up. Two system memory bits are constant 1 or constant 
0. 

Bits of the system memory bytes
The following table shows the meaning of the system memory:

Bit of the system 
memory bytes

7 6 5 4 3 2 1 0

Meaning Reserved 
(=0)

Reserved 
(=0)

Reserved 
(=0)

Reserved 
(=0)

=0 =1 =1 with 
change to 
the 
diagnosis 
status

=1 in first 
program 
cycle after 
startup, 
otherwise 0

 
 

 Note

The selected memory byte cannot be used for intermediate storage of data. 
 

Using clock memory

Clock memory  
A clock memory is a bit memory that changes its binary status periodically in the pulse-no-
pulse ratio of 1:1. 

You decide which memory byte of the CPU will become the clock memory byte when assigning 
the clock memory parameters. 

Benefits
You can use clock memory, for example, to activate flashing indicator lamps or to initiate 
periodically recurring operations such as recording of actual values.

Available frequencies
Each bit of the clock bit memory byte is assigned a frequency. The following table shows the 
assignment:

Bit of the clock 
memory byte

7 6 5 4 3 2 1 0

Period (s) 2.0 1.6 1.0 0.8 0.5 0.4 0.2 0.1
Frequency (Hz) 0.5 0.625 1 1.25 2 2.5 5 10
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 Note

Clock memory runs asynchronously to the CPU cycle, i.e. the status of the clock memory can 
change several times during a long cycle.

The selected memory byte cannot be used for intermediate storage of data. 
 

Protection

Setting options for the protection level (FW V1 to V3)

Protection level       
The following section describes how to use the various protection levels of the S7-1200 CPUs 
V1 to V3. 

Effects of the protection level setting
You can choose between the following protection levels:

● No protection: This corresponds to the default behavior. You cannot enter a password. 
Read and write access is always permitted.

● Write protection: Only read-only access is possible. You cannot change any data on the 
CPU and cannot load any blocks or a configuration. HMI access and communication 
between CPUs are excluded from the write protection. Assignment of a password is 
required to select this protection level.

● Write/read protection: No write or read access is possible in the "Accessible devices" area 
or in the project for devices that are switched online. Only the CPU type and the identification 
data can be displayed in the project tree under "Accessible devices". Display of online 
information or blocks under "Accessible devices", or in the project for devices 
interconnected online, is possible.
HMI access and communication between CPUs are excluded from the write protection. 
Assignment of a password is required to select this protection level.

Behavior of a password-protected CPU during operation
The CPU protection takes effect after the settings are downloaded to the CPU.

Validity is checked before the online function is executed. If password protection is in place, 
you are prompted to enter a password. 

Example: The module was assigned write protection and you want to execute the "Modify tags" 
function. This requires write access; therefore, the assigned password must be entered to 
execute the function. 

The functions protected by a password can only be executed by one programming device/PC 
at any one time. Another programming device/PC cannot log on with a password. 
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Access authorization to the protected data is in effect for the duration of the online connection 
or until the access authorization is manually rescinded with "Online > Delete access rights". 
Access authorization will also expire when the project is closed. 

 

 Note

You can not restrict functions for process control, monitoring, and communications. 

Some functions are still protected due to their use as online data. RUN/STOP in the "Online 
Tools" task card or "Set the time" in the diagnostics and online editor is therefore write-
protected.

 

 

Setting options for the protection (FW as of V4)

Protection level     
The following section describes how to use the various access levels of the S7-1200 CPUs as 
of V4.

S7-1200 CPUs provide various access levels to limit the access to specific functions. 

The parameters for the access levels are assigned in a table. The green checkmarks in the 
columns to the right of the respective access level specify which operations are possible 
without knowing the password of this access level. If you want to use the functions of check 
boxes that are not selected, a password has to be entered.

 

 NOTICE

Configuring an access level does not replace know-how protection

Configuring access levels prevents unauthorized changes to the CPU by restricting download 
privileges. However, blocks on the memory card are not write- or read-protected. Use know-
how protection to protect the code of blocks on the memory card.

 

Default characteristics 
The default access level is "Full access (no protection)". Every user can read and change the 
hardware configuration and the blocks. A password is not set and is also not required for online 
access. 
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The access levels in detail
With an S7-1200 CPU, you can configure the following access levels:

● Full access (no protection): The hardware configuration and the blocks can be read and 
changed by all users.

● Read access: With this access level, only read access to the hardware configuration and 
the blocks is possible without entering a password - meaning that you can load the hardware 
configuration and blocks into the programming device. In addition, HMI access and access 
to diagnostics data is possible. 
You cannot load blocks or a hardware configuration into the CPU without entering the 
password. Moreover, writing test functions and firmware updates are not possible without 
a password.

● HMI access: With this access level, only HMI access and access to diagnostics data is 
possible without entering the password.
Without entering the password, you can neither load blocks and hardware configuration 
into the CPU, nor load blocks and hardware configuration from the CPU into the 
programming device. In addition, the following is not possible without a password: Writing 
test functions, changing the operating state (RUN/STOP) and firmware updates.

● No access (complete protection): When the CPU is completely protected, no read or write 
access to the hardware configuration and the blocks is possible. HMI access is also not 
possible. The server function for PUT/GET communication is disabled in this access level 
(cannot be changed).
Authorization with the password again provides you full access to the CPU.

Behavior of a password-protected module during operation
The CPU protection takes effect after the settings are downloaded to the CPU.

Validity is checked before the online function is executed. If password protection is in place, 
you are prompted to enter a password. 

Example: The module was configured with read access and you want to execute the "Modify 
tags" function. This requires write access; therefore, the assigned password must be entered 
to execute the function.

The functions protected by a password can only be executed by one programming device/PC 
at any one time. Another programming device/PC cannot log on.

Access authorization to the protected data is in effect for the duration of the online connection 
or until the access authorization is manually rescinded with "Online > Delete access rights".

Each access level allows unrestricted access to certain functions without entering a password, 
for example, identification using the "Accessible devices" function.

Configuring access levels
The following section describes how to configure an access level and enter passwords for an 
S7-1200 CPU as of V4.

For an S7-1200 CPU, you can enter multiple passwords and thereby set up different access 
rights for individual user groups.
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The passwords are entered in a table in such a way that exactly one access level is assigned 
to each password. 

The effect of the password is visualized in the "Access" column and explained in the text below 
the table.

Example
You select the "No access (complete protection)" access level for a standard CPU (in other 
words, not an F-CPU) and enter a separate password for each of the access levels that lie 
above it in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the set passwords, the effect depends on the table row in which 
the password occurs:

● The password in row 1 (Full access (no protection)) allows access as if the CPU were 
completely unprotected. Users who know this password have unrestricted access to the 
CPU.

● The password in row 2 (read access) allows access as if the CPU were write-protected. 
Users who know this password have read-only access to the CPU.

● The password in row 3 (HMI access) allows access as if the CPU were write-protected and 
read-protected so that only HMI access is possible for users who know this password.

Procedure
To configure the access levels of an S7-1200 CPU, follow these steps:

1. Open the properties of the module in the inspector window.

2. Open the "Protection" entry in the area navigation.
A table with the possible access levels appears in the inspector window.

Figure 8-4 Access protection 

3. Activate the required access level in the first column of the table. The green checkmarks 
in the columns to the right of the respective protection level show you which operations are 
still available without entering the password.
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4. In the "Password" column, specify a password for full access in the first row. In the 
"Confirmation" column, enter the selected password again to protect against incorrect 
entries.
Ensure that the password is sufficiently secure, in other words, that is does not follow a 
machine-recognizable pattern!
You must enter a password in the first row "Full access (no protection)". This enables 
unrestricted access to the CPU for those who know the password, regardless of the 
selected protection level.

5. Assign additional passwords as needed to other access levels if the selected protection 
level allows you to do so.

6. Download the hardware configuration so that the access level takes effect.

Result
The hardware configuration and the blocks are protected against unauthorized access 
according to the set access level. If an operation cannot be executed without a password due 
to the set access level, a dialog for entering a password is displayed.

Restriction of communication services

Introduction
The CPU can be the server for a number of communication services. This means that other 
communication participants can access CPU data even if you have not configured and 
programmed connections for the CPU.

The local CPU as a server thus does not have the possibility to control communication to the 
clients. 

The parameter "Connection mechanisms" in the "Protection" area of the CPU parameters is 
used to specify whether this type of communication is permitted or not for the local CPU during 
operation. 

Permit access with PUT/GET communication from remote partners     
By default, the "Permit access with PUT/GET communication from remote partners (...)" option 
is disabled. In this case, read and write access to CPU data is only possible for communication 
connections that require configuration or programming both for the local CPU and for the 
communication partner. Access through BSEND/BRCV instructions is possible, for example. 

Connections for which the local CPU is only a server (meaning that no configuration/
programming of the communication with the communication partner exists at the local CPU), 
are therefore not possible during operation of the CPU, for example, 

● For PUT/GET, FETCH/WRITE or FTP access via communication modules

● For PUT/GET access from other S7 CPUs

● For HMI access that is realized via PUT/GET communication
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If you want to allow access to CPU data from the client side, meaning that you do not want to 
restrict the communication services of the CPU, activate the "Permit access with PUT/GET 
communication from remote partners" option.

Organization blocks

Organization blocks for startup

Description    
You can determine the boundary conditions for the startup characteristics of your CPU, for 
example, the initialization values for "RUN". To do this, write a startup program. The startup 
program consists of one or more startup OBs (OB numbers 100 or >= 123). 

The startup program is executed once during the transition from "STOP" mode to "RUN" mode. 
Current values from the process image of the inputs are not available for startup program, nor 
can these values be set.

After the complete execution of the startup OBs, the process image of the inputs is read in and 
the cyclic program is started.

There is no time limit for executing the startup routine. Therefore the scan cycle monitoring 
time is not active. Time-driven or interrupt-driven organization blocks cannot be used. 

Start information
A startup OB has the following start information:

Tag Data type Description
LostRetentive BOOL = 1, if retentive data storage areas have been lost
LostRTC BOOL = 1, if realtime clock has been lost

See also
Events and OBs (Page 1079)

Organization blocks for cyclic program execution

Introduction           
For the program execution to start, at least one program cycle OB must be present in the 
project. The operating system calls this program cycle OB once in each cycle and thereby 
starts the execution of the user program. You can use multiple OBs (OB numbers >= 123). 
When multiple program cycle OBs are used, these are called in one after the other in the order 
of their OB numbers. The program cycle OB with the lowest OB number is called first.

The program cycle OBs have the priority class 1. This corresponds to the lowest priority of all 
OBs. The cyclic program can be interrupted by events of any other event class. 
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Programming cyclic program execution
You program cyclic program execution by writing your user program in the cycle OBs and the 
blocks that they call.

The first cyclic program execution begins as soon as the startup program has ended without 
errors. The cycle restarts after the end of each cyclic program execution.

Sequence of cyclic program execution
One cycle of the program execution encompasses the following steps:

1. The operating system starts the maximum cycle time.

2. The operating system writes the values from the process image output to the output 
modules.

3. The operating system reads out the state of the inputs of the input modules and updates 
the process image input.

4. The operating system processes the user program and executes the operations contained 
in the program.

5. At the end of a cycle, the operating system executes any tasks that are pending, for 
example, loading and deleting blocks or calling other cycle OBs.

6. Finally, the CPU returns to the start of the cycle and restarts the scan cycle monitoring time.

See also: Auto-Hotspot

Options for interrupting
Cyclic program execution can be interrupted by the following events:

● Interrupt

● A STOP command, triggered by

– Operation of the programming device

– "STP" instruction

● Supply voltage failure

● Occurrence of a device fault or program error

Start information
● None

● Optimized start information:

Name Data type Meaning
first_scan BOOL = TRUE in the first call of this OB:

● Transition from STOP or HOLD to RUN
● After reloading

retentivity BOOL = TRUE, if retentive data are available
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See also
Events and OBs (Page 1079)

Organization blocks for interrupt-driven program execution

Organization blocks for time-of-day interrupt

Function           
Organization blocks for time-of-day interrupt (OB number >=123) can be processed as follows:

● One time to a preset time (date with time of day)

● Periodically with preset start time and the following intervals:

– Every minute

– Hourly

– Daily

– Weekly

– Monthly

– Yearly

– End of month

Time-of-day interrupt-OBs are therefore used to run parts of the user program on a time-
controlled basis.

Status for time-of-day interrupt
The following table contains the possible status of a time-of-day interrupt as well as it's meaning.

Status Meaning
Cancelled The one-time processing has already taken place, or the start event of an not yet processed time-of-day 

interrupt has been deleted with the extended instruction CAN_TINT.
Set You have scheduled the time or start time for processing.
Activated You have scheduled whether processing takes place one time or periodically, and in the case of periodic 

processing, you have scheduled the interval.

Rules for time-of-day interrupts
The following rules apply to the use of time-of-day interrupts:

● A time-of-day interrupt can only be processed if it is set and activated, and a corresponding 
organization block exists in the user program.

● The start times of periodic time-of-day interrupts must correspond to a real date. For 
example, it is not possible to repeat an organization block monthly which first occurs on 
January 31st. In this case, on OB will only be started in the months that have 31 days.
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● A time-of-day interrupt activated during startup by extended instruction call ACT_TINTwill 
not be executed until the startup is complete.

● After each CPU startup, you must reactivate previously set time-of-day interrupts

Setting and activating a time-of-day interrupt OB
Before a time-of-day interrupt can be deleted and the corresponding time-of-day interrupt OB 
can be processed from the operating system, you must set and activate the interrupt. You have 
the following options:

Set time-of-day interrupt Activate time-of-day interrupt
Means of configuring Means of configuring
Means of configuring By extended instruction call ACT_TINT
By extended instruction call SET_TINTL By extended instruction call ACT_TINT

 
 

 Note

If you configure a time-of-day interrupt in such a way that the corresponding OB is to be 
processed once, the start time must not be in the past (relative to the real-time clock of the 
CPU).

If you configure a time-of-day interrupt in such a way that the corresponding OB is to be 
processed periodically, but the start time is in the past, then the time-of-day interrupt will be 
processed the next time it is due.

 

 

Time-of-day interrupt status query
In order to query the status of the time-of-day interrupt, call the extended instruction QRY_TINT.

Cancelling a time-of-day interrupt
You can cancel a time-of-day interrupt which has not yet been processed with the extended 
instruction CAN_TINT.

You can reset cancelled time-of-day interrupts with the extended instruction SET_TINTL and 
activate them with the extended instruction ACT_TINT.

 

Conditions that effect the time-of-day interrupt OBs
Since a time-of-day interrupt occurs only at specific intervals, certain conditions can affect the 
function of the associated OBs during execution of your program. The following table shows 
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some of these conditions and describes how these affect the processing of a time-of-day 
interrupt OB.

Condition Result
The extended instruction CAN_TINT is called in the user 
program.

The operating system deletes the start event (date and time) 
of the time-of-day interrupt. You must reset and reactivate the 
time-of-day interrupt if you are going to call the corresponding 
time-of-day interrupt OB again.

By synchronizing or correcting the CPU system clock, the 
time of day will be set ahead. With this, the start time for a 
time-of-day interrupt OB will be bypassed.

The operating system calls the time error interrupt OB (OB 
80) and records the start event, the number, and the priority 
of the first bypassed time-of-day interrupt OB in its start 
information. After completion of the OB 80, the operating 
system processes the bypassed time-of-day interrupt OB 
only once.

By synchronizing or correcting the CPU system clock, the 
time of day will be set back. The corrected clock time is before 
the start time of an already processed time-of-day interrupt 
OB.

The time-of-day interrupt OB is repeated.

A time-of-day interrupt OB is still being processed when the 
start event for its next execution occurs.

The operating system then calls time error interrupt OB 80. 
The requested OB is processed only after the processing and 
further execution of the current time-of-day interrupt OB has 
completed.

 

Start information
A time-of-day interrupt OB has the following start information:

Tag Data type Description
CaughtUp BOOL =1, if the OB call is executed because clock time is turned ahead.
SecondTime BOOL =1 if the OB is called a second time because clock time is turned back (more 

exactly,  if the planned time of the current OB processing is earlier than or the 
same time as the planned time for the previous OB processing).
Note: SecondTime is only set once.

Organization block for status interrupts

Description     
When it receives a status interrupt, the operating system of the S7-1200 CPU calls the status 
interrupt OB from a DP master or IO controller. This may be the case if a module of a slave 
changes its operating mode, for example, from "RUN" to "STOP". For more detailed information 
on events that trigger a status interrupt, refer to the documentation of the slave or device 
manufacturer.
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Structure of the start information
The status-interrupt OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware address of the component triggering the interrupt
Slot UINT Slot number of the component triggering the interrupt
Specifier WORD Interrupt specifier from the interrupt frame

See also
Events and OBs (Page 1079)

Organization block for update interrupts

Description     
When it receives a status interrupt, the operating system of the S7-1200 CPU calls the update 
interrupt OB from a DP master or IO controller. This may be the case if you changed a 
parameter on a slot of a slave or device. For more detailed information on events that trigger 
an update interrupt, refer to the documentation of the slave or device manufacturer.

Structure of the start information
The update interrupt OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware address of the component triggering the interrupt
Slot UINT Slot number of the component triggering the interrupt
Specifier WORD Interrupt specifier from the interrupt frame

See also
Events and OBs (Page 1079)

Organization block for manufacturer-specific or profile-specific interrupts

Description     
When it receives a manufacturer-specific or profile-specific interrupt from a DP master or IO 
controller, the operating system of the S7-1200 CPU calls OB 57. For more detailed information 
on events that trigger this type of interrupt, refer to the documentation of the slave or device 
manufacturer.
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Structure of the start information
The OB for manufacturer-specific and profile-specific interrupts has the following start 
information:

Name Data type Meaning
LADDR HW_IO Hardware address of the component triggering the interrupt
Slot UINT Slot number of the component triggering the interrupt
Specifier WORD Interrupt specifier from the interrupt frame

See also
Events and OBs (Page 1079)

Organization blocks for time-delay interrupts

Description   
A time-delay interrupt OB is started after a configurable time delay of the operating system. 
The delay time starts after the SRT_DINT instruction is called.

You can use up to four time-delay interrupt OBs or cyclic OBs (OB numbers >= 123) in your 
program. If, for example, you are already using two cyclic interrupt OBs, you can insert a 
maximum of two further time-delay interrupt OBs in your program.

You can use the CAN_DINT instruction to prevent the execution of a time-delay interrupt that 
has not yet started.

Function of time-delay interrupt OBs
The operating system starts the corresponding OB after the delay time, which you have 
transferred with an OB number and an identifier to the SRT_DINT instruction.

To use a time-delay interrupt OB, you must execute the following tasks:

● You must call the instruction SRT_DINT.

● You must download the time-delay interrupt OB to the CPU as part of your program.

The delay time is measured with a precision of 1 ms. A delay time can immediately start again 
after it expires.

Time delay interrupt OBs are executed only when the CPU is in the "RUN" mode. A warm 
restart clears all start events of time-delay interrupt OBs. 

The operating system calls the time-delay interrupt OB if one of the following events occurs:

● If the operating system attempts to start an OB that is not loaded and you specified its 
number when calling the SRT_DINT instruction.

● If the next start event for a time-delay interrupt occurs before the time delay OB has 
completely executed.
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You can disable and re-enable time-delay interrupts using the DIS_AIRT and EN_AIRT 
instructions.

 

 Note

If you disable an interrupt with DIS_AIRT after executing SRT_DINT, this interrupt executes 
only after it has been enabled with EN_AIRT. The delay time is extended accordingly.

 

 

Start information
● None

● Optimized start information:

Name Data type Meaning
sign WORD User ID: Input parameter SIGN from the call of the "SRT_DINT" instruction

See also
Events and OBs (Page 1079)

Organization blocks for cyclic interrupts

Description   
Cyclic interrupt OBs serve to start program in periodic time intervals independently of the cyclic 
program execution. The start times of a cyclic interrupt OB are specified using the time base 
and the phase offset. 

The time base defines the intervals at which the cyclic interrupt OB is started and is an integer 
multiple of the basic clock cycle of 1 ms. The phase offset is the time by which the start time 
is offset compared with the basic clock cycle. If several cyclic interrupt OBs are being used, 
you can use this offset to prevent a simultaneous start time if the time bases of the cyclic 
interrupt OBs have common multiples.

You can specify a time period between 1 ms and 60000 ms as the time base. 

You can use up to four cyclic interrupt OBs or time-delay OBs (OB numbers >= 123) in your 
program. If, for example, you are already using two time-delay interrupt OBs, you can insert a 
maximum of two further cyclic interrupt OBs in your program.

 

 Note

The execution time of each cyclic interrupt OB must be noticeably smaller than its time base. 
If a cyclic interrupt OB has not been completely executed but execution is again pending 
because the cycle clock has expired, the time error OB is started. The cyclic interrupt that 
caused the error is executed later or discarded. 
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Example of the use of phase offset
You have inserted two cyclic interrupt OBs in your program:

● Cyclic interrupt OB1

● Cyclic interrupt OB2

For cyclic interrupt OB1, you have set a time base of 20 ms and for cyclic interrupt OB2 a time 
base of 100 ms. After expiration of the time base of 100 ms, the cyclic interrupt OB1 reaches 
the start time for the fifth time, cyclic interrupt OB2 for the first time. To nevertheless execute 
the cyclic interrupt OBs offset, enter a phase offset for one of the two cyclic interrupt OBs.

Start information
● None

● Optimized start information:

Name Data type Meaning
first_scan BOOL = TRUE in the first call of this OB

● At the transition from STOP or HOLD to RUN
● After reloading

event_count INT Number of lost start events since the last start of this OB

See also
Assigning parameters to cyclic interrupt OBs (Page 1131)

Events and OBs (Page 1079)

Organization blocks for hardware interrupts

Description   
You can use hardware interrupt OBs to react to specific events. You can assign an event that 
triggers an alarm to precisely one hardware interrupt OB. A hardware interrupt OB in contrast 
can be assigned to several events.

Hardware interrupts can be triggered by high-speed counters and input channels. For each 
high-speed counter and input channel that should trigger a hardware interrupt, the following 
properties need to be configured:

● The process event that should trigger the hardware interrupt (for example, the change of 
a count direction of a high-speed counter)

● The number of the hardware interrupt OB which is assigned to this process event

You can use up to 50 hardware interrupt OBs (OB numbers >= 123) that are independent of 
each other in your program.
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Functionality of a hardware interrupt OB
After triggering a hardware interrupt, the operating system identifies the channel of the input 
or the high-speed counter and determines the assigned hardware interrupt OB.

If no other interrupt OB is active, the determined hardware interrupt OB is called. If a different 
interrupt OB is already being executed, the hardware interrupt is placed in the queue of its 
priority class. The hardware interrupt is acknowledged after the completion of the assigned 
hardware interrupt OB.

If another event that triggers a hardware interrupt occurs on the same module during the time 
between identification and acknowledgement of a hardware interrupt, the following applies:

● If the event occurs on the channel that previously triggered the hardware interrupt, then no 
additional hardware interrupt is triggered. Another hardware interrupt can only be triggered 
if the current hardware interrupt is acknowledged.

● If the event occurs on a different channel, a hardware interrupt is triggered.

Hardware interrupt OBs are called only in the CPU's "RUN" mode.

Start information
● None

● Optimized start information:

Name Data type Meaning
Laddr HW_IO Hardware identifier of the module that triggers the hardware interrupt
USI WORD Identifier for future extensions (not user-relevant)
IChannel USINT Number of the channel that triggered the hardware interrupt
EventType BYTE Identifier for the event type associated with the event triggering the 

interrupt (e.g., positive edge)
This identifier can be found in the description of the respective module.

See also
Assigning parameters to hardware interrupt OBs (Page 1132)

Events and OBs (Page 1079)

Organization block for time error

Description     
The operating system calls the time error OB (OB 80) if one of the following events occurs:

● The cyclic program exceeds the maximum cycle time.

● The OB called is currently still being executed (possible for time-delay interrupt OBs and 
cyclic interrupt OBs).

● A time-of-day interrupt was missed because the clock time was set forward by more than 
20 seconds.
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● A time-of-day interrupt was missed during a STOP.

● An overflow has occurred in an interrupt OB queue.

● An interrupt was lost due to the excessive interrupt load.

If you have programmed no time error OB, the S7-1200 CPU reacts as follows:

● CPUs with firmware version V1.0: The CPU remains in RUN mode.

● CPUs with firmware version V2.0:

– The CPUs goes to STOP mode when the maximum cycle time is exceeded.

– With all other start events of the time error OB, the CPU remains in RUN mode.

With CPUs with firmware version V1.0, the two-time overshooting of the maximum cycle time 
does not lead to the calling of an OB, but to the STOP of the CPU. You can avoid the second 
violation by restarting the cycle monitoring of the CPU with the RE_TRIGR instruction.

You can use only one time error OB in your program.

Start information
The time error OB has the following start information:

Tag Data type Description
fault_id BYTE ● 0x01: Maximum cycle time exceeded

● 0x02: Called OB is still being executed
● 0x05: Expired time-of-day interrupt due to time jump
● 0x06: Expired time-of-day interrupt on return to RUN mode
● 0x07: Queue overflow
● 0x09: Interrupt loss due to high interrupt load

csg_OBnr OB_ANY Number of the OB being executed at the time of the error
csg_prio UINT Priority of the OB being executed at the time of the error

See also
Events and OBs (Page 1079)

Organization block for diagnostic interrupts

Description   
You can enable the diagnostic error interrupt for diagnostics-capable modules so that the 
module detects changes in the I/O status. As a result, the module triggers a diagnostic error 
interrupt in the following cases:

● A fault is present (incoming event)

● A fault is no longer present (outgoing event)
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If no other interrupt OB is active, then the diagnostic interrupt OB (OB 82) is called. If another 
interrupt OB is already being executed, the diagnostic error interrupt is placed in the queue of 
its priority group. 

You can use only one diagnostic interrupt OB in your program.

Start information
The diagnostic interrupt OB has the following start information:

Tag Data type Description
IO_state WORD Contains the I/O status of the diagnostics-

capable module. 
laddr HW_ANY HW-ID
Channel UINT Channel number
multi_error BOOL = 1, if there is more than one error

IO_state tag
The following table shows the possible I/O states that the IO_state tag can contain:

IO_state Description
Bit 0 Configuration correct:

= 1, if the configuration is correct
= 0, if the configuration is no longer correct

Bit 4 Error:
= 1, if an error is present, e.g., a wire break
= 0, if the error is no longer present

Bit 5 Configuration not correct:
= 1, if the configuration is not correct
= 0, if the configuration is correct again 

Bit 6 I/O cannot be accessed:
= 1, if an I/O access error has occurred
In this case, laddr contains the hardware identifier of the I/O with the access error. 
= 0, if the I/O can be accessed again

See also
Events and OBs (Page 1079)
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Organization block for pulling and plugging

Description    
The S7-1200 CPU operating system calls the pull/plug interrupt OB (OB 83) if a configured 
and non-disabled distributed I/O module or submodule (PROFIBUS, PROFINET, AS-i) is 
removed or inserted.

 

 Note

The removal or insertion of a central module leads to the STOP of the CPU.
 

Start information
The pull/plug interrupt OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware identifier of the affected module or submodule
Event_Class BYTE ● B#16#38: (Sub)module plugged

● B#16#39: (Sub)module pulled or not responding
Fault_ID BYTE Error code (possible values: B#16#51, B#16#54, B#16#55, 

B#16#56, B#16#57, B#16#58)

The following table shows which event caused the start of the pull/plug interrupt OB.

ev_class (B#16# ...) fault_id (B#16# ...) Meaning
39 51 Module pulled
39 54 Submodule pulled
38 54 Submodule plugged, which conforms to the 

parameterized submodule
38 55 Submodule inserted, which does not conform to 

the submodule parameter assignment
38 56 Submodule inserted, but error in module 

parameter assignment
38 57 Submodule or module inserted, but with a fault or 

maintenance
38 58 Submodule access error remedied

See also
Events and OBs (Page 1079)
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Organization block for rack fault

Description   
The S7-1200 CPU operating system calls the OB 86 in the following cases:

● The failure of a DP master system or of a PROFINET IO system is detected (in the case 
of either an incoming or an outgoing event).

● The failure of a DP slave or of an IO device is detected (in the case of either an incoming 
or an outgoing event).

● Failure of some of the submodules of a PROFINET I-device is detected.

Structure of the start information
The rack fault OB has the following start information:

Name Data type Meaning
LADDR HW_IO Hardware identifier of the defective hardware object
Event_Class BYTE ● B#16#32: Activation of a DP slaves or an IO device

● B#16#33: Deactivation of a DP slaves or an IO device
● B#16#38: outgoing event
● B#16#39: incoming event

Fault_ID BYTE Error code (possible values: B#16#C3, B#16#C4, B#16#C5, 
B#16#C6, B#16#C7, B#16#C8, B#16#C9, B#16#CA, B#16#CB, 
B#16#CC, B#16#CD, B#16#CE, B#16#CF, B#16#F8, B#16#F9)

The following table shows which event caused the start of OB 86.

Ev_class
B#16# ...

Fault_id
B#16# ...

Meaning

39 C3 Failure of a DP master system
39/38 C4 Failure/return of a DP slave
38 C5 Return of a DP slave; however, slave is faulty
38 C6 Expansion unit return, but error in module parameter assignment
38 C7 Return of a DP device, but there is error in module configuration
38 C8 Return of a DP device, but discrepancy between preset/actual configuration
32/33 C9 Activation/deactivation of a DP slave with the "D_ACT_DP" instruction
39 CA Failure of a PROFINET IO system
39/38 CB Failure/return of a PROFINET IO device
38 CC Return of a PROFINET IO device with fault or maintenance
38 CD Return of a PROFINET IO device, deviation between preset/actual 

configuration
38 CE Return of a PROFINET IO device, error in module configuration
32/33 CF Activation/deactivation of an IO device with the "D_ACT_DP" instruction
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Ev_class
B#16# ...

Fault_id
B#16# ...

Meaning

39/38 F8 Failure/return of some of the submodules of a PROFINET I-device
38 F9 Return of some of the submodules of a PROFINET I-device with a device 

configuration difference

See also
Events and OBs (Page 1079)

Block parameters of organization blocks

Basics of block parameters

Introduction   
Several organization blocks (OBs) have properties with which you can control their behavior 
or their assignment to specific events. You can influence these properties by assigning 
parameters.

Overview
You can assign parameters to the properties for the following organization blocks:

● Time-of-day interrupt OBs

● Cyclic interrupt OBs

● Hardware interrupt OBs

 

See also
Assigning parameters to hardware interrupt OBs (Page 1132)

Assigning parameters to cyclic interrupt OBs (Page 1131)

Parameter assignment for time-of-day interrupt OBs

Procedure for setting the parameters
To set the parameters of a time-of-day interrupt OB, proceed as follows:

1. Open the "Properties" dialog belonging to the time-of-day interrupt OB in question.

2. Click the "Time-of-day interrupt" group in the area navigation.
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Overview of the parameters that can be set 
You can set the following parameters:

● Execution

● Start date and time-of-day

● Option buttons "Local time" and "System time"

"Execution" parameter
Use the drop-down list "Execution" to define the periods at which the time-of-day interrupt OB 
is to be executed. The time intervals relate to the settings for "Start date" and "Time-of-day".

The following values are possible for "Execution":

● Never

● Once

● Every minute

● Hourly

● Daily

● Weekly

● Monthly

● Yearly

● End of month
 

  Note

With the value "End of month", the value specified under "Start date" is irrelevant.
 

"Start date" and "Time-of-day" parameter
Here, you specify the time at which the time-of-day interrupt is to be executed for the first time.

Example: Start date = 07/05/2013, time =11:16

Depending on the value of the "Execution" parameter, the CPU generates additional time-of-
day interrupts periodically. Depending on the setting, the start time relates either to the local 
time or to the coordinated universal timeUTC.

 

 Note

If you set the "Execution" parameter to "Monthly", the start date cannot be set to the 29th, 
the 30th, or the 31st. If you want the time-of-day interrupt OB to start at the end of the month, 
you should set the parameter "Execution" to "End of month".
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"Local time" or "System time"
Here, you decide which time the start time of the time-of-day interrupt OB relates to:

● "Local time": The start time relates to the time zone set for the CPU.

● "System time": The start time relates to the coordinated universal time UTC (Universal Time 
Coordinated).

Assigning parameters to cyclic interrupt OBs

Introduction  
You can use cyclic interrupt OBs to start programs at regular time intervals. To do so you must 
enter a scan time and a phase shift for each cyclic interrupt OB used.

You can use up to four cyclic interrupt OBs or time-delay OBs (OB numbers >= 200) in your 
program. If, for example, you are already using two time-delay interrupt OBs, you can insert a 
maximum of two further cyclic interrupt OBs in your program.

 

 Note

If you assign multiple cyclic OBs, make sure that you assign a different cycle time or phase 
offset to each cyclic interrupt OB to avoid them executing at the same time or having to queue. 
When you create a cyclic interrupt OB, the cycle time 100 and the phase offset 0 are entered 
as start value.

 

Procedure
To enter a scan time and a phase shift for a cyclic interrupt OB, proceed as follows:

1. Open the "Program blocks" folder in the project tree.

2. Right-click on an existing cyclic interrupt OB.

3. Select the "Properties" command in the shortcut menu.
The "<Name of the cyclic interrupt OB>" dialog box opens.

4. Click the "Cyclic interrupt" group in the area navigation.
The text boxes for the scan time and the phase shift are displayed.

5. Enter the scan time and the phase shift.

6. Confirm your entries with "OK".

 

 

See also
Basics of block parameters (Page 1129)

Organization blocks for cyclic interrupts (Page 1122)
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Assigning parameters to hardware interrupt OBs

Introduction    
You must select the corresponding event and assign the following parameters for every input 
channel and high-speed counter that should trigger a hardware interrupt:

● Event name

● Number of the hardware interrupt OB that is assigned to this process event

The parameters of the hardware interrupt are assigned in the properties of the corresponding 
device. You can assign parameters for up to 50 hardware interrupt OBs.

You can create the hardware interrupt OB to be assigned parameters either before or during 
activation of an event. 

Procedure
To configure a hardware interrupt event, follow these steps:

1. Double-click the "Devices & Networks" command in the project tree.
The hardware and network editor opens in the network view.

2. Change to the device view.

3. If the Inspector window closed in the device view, select the "Inspector window" check box 
in the "View" menu.
The Inspector window opens.

4. Click the "Properties" tab.

5. In the device view, select the module for which you want to a assign a hardware interrupt.

6. Select the corresponding event that will trigger a hardware interrupt, e.g., a positive edge.

7. Enter an event name.

8. Select an existing hardware interrupt OB from the "Hardware interrupt" drop-down list or 
create a new hardware interrupt OB. If you have not previously created any hardware 
interrupt OBs, you can click the "Add new block" button in the drop-down list.
The start information of the corresponding hardware interrupt OB, including all 
specifications for the interrupt-triggering event, is updated. 

9. If you want to assign further hardware interrupts, repeat steps 5 to 8.
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A system constant of data type Event_HwInt is created automatically for the event identified 
by the explicit event name. The system constants are displayed in the standard tag table. 

 

See also
Basics of block parameters (Page 1129)

Organization blocks for hardware interrupts (Page 1123)

Events and OBs (Page 1079)

Symbolic and numerical names of instructions

Description
The instructions from the task card are comprised of functions (FC), function blocks (FB), 
system functions (SFC) and system function blocks (SFB) that are identified internally by 
numbers.

The following tables show the assignment of numerical and symbolic names.

Function blocks (FBs)

Numerical name Symbolic name
FB 105 TC_CONFIG
FB 110 Port_Config
FB 111 Send_Config
FB 112 Receive_Config
FB 113 Send_P2P
FB 114 Receive_P2P
FB 115 Receive_Reset
FB 116 Signal_Get
FB 117 Get_Features
FB 118 Set_Features
FB 163 TC_SEND
FB 164 TC_RECV
FB 165 TC_CON
FB 166 TC_DISCON
FB 804 SET_TIMEZONE
FB 1030 TSEND_C
FB 1031 TRCV_S
FB 1071 USS_DRIVE
FB 1080 MB_COMM_LOAD
FB 1081 MB_MASTER
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Numerical name Symbolic name
FB 1082 MB_SLAVE
FB 1084 MB_CLIENT
FB 1085 MB_SERVER
FB 1100 MB_Halt
FB 1101 MC_Home
FB 1102 MC_MoveAbsolute
FB 1103 MC_MoveJog
FB 1104 MC_MoveRelative
FB 1105 MC_MoveVelocity
FB 1107 MC_Power
FB 1108 MC_Reset
FB 1110 MC_MoveInterrupt
FB 1111 MC_ChangeDynamik
FB 1112 MC_CommandTable
FB 1113 MC_MoveLinearAbs_2D
FB 1114 MC_MoveLinearRel_2D
FB 1115 MC_MoveCircular_2D
FB 1130 PID_Compact
FB 1134 PID_3Step
FB 1140 HSC
FB 2040 RecipeCreate
FB 2041 RecipeOpen
FB 2042 RecipeRead
FB 2043 RecipeWrite
FB 2044 RecipeAppend
FB 2045 RecipeClose

Functions (FCs)

Numerical name Symbolic name
FC 2 (1) CONCAT
FC 4 (1) DELETE
FC 11 (1) FIND
FC 17 (1) INSERT
FC 20 (1) LEFT
FC 21 (1) LEN
FC 22 (1) LIMIT
FC 25 (1) MAX
FC 26 (1) MID
FC 27 (1) MIN
FC 31 (1) REPLACE
FC 32 (1) RIGHT
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Numerical name Symbolic name
FC 36 (1) ENCO
FC 36 (1) SEL
FC 37 DECO
FC 800 LED
FC 801 IM_DATA
FC 802 DeviceStates
FC 803 ModuleStates
FC 1070 USS_PORT
FC 1072 USS_RPM
FC 1073 USS_WPM
(1) MC7+ instruction

System data types (SDTs)

Numerical name Symbolic name
SDT 99 WWW_CDB
SDT 513 CONDITIONS
SDT 581 Send_Conditions
SDT 582 Receive_Conditions

System function blocks (SFBs)

Numerical name Symbolic name
SFB 0 (1) CTU
SFB 1 (1) CTD
SFB 2 (1) CTUD
SFB 3 (1) TP
SFB 4 (1) TON
SFB 5 (1) TOF
SFB 27 START_OB
SFB 52 RDREC
SFB 53 WRREC
SFB 54 RALRM
SFB 105 T_CONFIG
SFB 106 TDIAG
SFB 107 TRESET
SFB 110 PORT_CFG
SFB 111 SEND_CFG
SFB 112 RCV_CFG
SFB 113 SEND_PTP
SFB 114 RCV_PTP
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Numerical name Symbolic name
SFB 115 SGN_GET
SFB 116 SGN_SET
SFB 117 RCV_RST
SFB 120 CTRL_HSC
SFB 122 CTRL_PWM
SFB 140 DataLogCreate
SFB 141 DataLogOpen
SFB 142 DateLogWrite
SFB 143 DataLogClear
SFB 144 DataLogClose
SFB 145 DataLogDelete
SFB 146 DataLogNewFile

System functions (SFCs)

Numerical name Symbolic name
SFC 7 DP_PRAL
SFC 11 DPSYC_FR
SFC 13 DPNRM_DG
SFC 14 DPRD_DAT
SFC 16 RD_OBINF
SFC 23 DEL_DB
SFC 28 SET_TINT
SFC 29 CAN_TINT
SFC 30 ACT_TINT
SFC 31 QRY_TINT
SFC 32 SRT_DINT
SFC 33 CAN_DINT
SFC 34 QRY_DINT
SFC 41 DIS_AIRT
SFC 42 EN_AIRT
SFC 43 RE_TRIGR
SFC 45 DE_ACT
SFC 46 STP
SFC 82 CREA_DBL
SFC 83 READ_DBL
SFC 84 WRIT_DBL
SFC 86 CREATE_DB
SFC 89 RST_EVOV
SFC 99 WWW
SFC 101 RTM
SFC 117 GET_DIAG
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Numerical name Symbolic name
SFC 124 ATTR_DB
SFC 140 IO2MOD
SFC 143 RD_ADDR
SFC 154 RD_LOC_T
SFC 154 DPWR_DAT
SFC 161 WR_LOC_T
SFC 180 ID2LOG
SFC 181 LOG2ID
SFC 182 ID2GEO
SFC 190 SET_CINT
SFC 191 QRY_CINT
SFC 192 ATTACH
SFC 193 DETACH
MC7+ Anweisung GET_ERROR
MC7+ Anweisung GET_ERR_ID

Useful information on CPU firmware versions and STEP 7 versions
CPUs and engineering software for configuring the CPUs is constantly developed further to 
improve performance and security. New versions that have some special features with respect 
to the interaction of the components are created in this way. The sections below describe the 
special features of the S7-1200 CPUs with firmware version V4 as compared to firmware 
versions V1 to V3. 

For a detailed comparison of the range of functions, read the S7-1200 System Manual 
(description of new instructions, new organization blocks and advanced configuration options).

Required engineering software
S7-1200 CPUs V4 can be configured with STEP 7 as of V13.

Compatibility between memory card content and firmware version of the CPU
Memory cards (transfer cards or program cards) with configuration and program for an S7-1200 
CPU V1, V2 or V3 do not work with an S7-1200 CPU V4. 
Memory cards with configuration and program for an S7-1200 CPU V4 do not work with an 
S7-1200 CPU V1, V2 or V3. 

You must change an S7-1200 CPU V1 to V3 configuration to an S7-1200 CPU V4 configuration 
(device replacement) and then download it to the CPU. A gradual device replacement is 
required for an S7-1200 CPU V1-V2 (see below). 

When you insert the memory card into a CPU with an incompatible firmware version, the CPU 
does not start up. When you insert a memory card for a CPU V1, V2 or V3 into an S7-1200 
CPU V4, this CPU outputs a version error. 
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Going online and loading
When you have configured an S7-1200 CPU with firmware version V1, V2 or V3 with STEP 
7, the CPU to which you want to go online or which you want to download must have one of 
these firmware versions. You cannot go online to an S7-1200 CPU V4 with a configured 
S7-1200 CPU V1, V2 or V3.   

On the other hand, you cannot go online to an S7-1200 CPU V1, V2 or V3 with a configured 
S7-1200 CPU V4 or download this CPU.

Replacing an existing CPU
You can replace a configured S7-1200-CPU V1, V2 or V3 with a new CPU with a firmware 
version greater than or equal to 4. In case of an existing S7-1200 CPU V1 or V2, you must 
start by replacing the device with an S7-1200 CPU V3: It is not possible to directly replace it 
with an S7-1200 CPU V4.

1. S7-1200 CPU V1 (V2) > S7-1200 CPU V3

2. S7-1200 CPU V3 > S7-1200 CPU V4

As long as you do not download the configuration, you can undo the device replacement 
("Undo" command in the "Edit" menu). When you download the configuration for the new CPU 
firmware version ("V4 configuration") to the CPU, you can no longer return to version V3. 

This means you should save the existing project, for example, with a V3 configuration as project 
archive so that you can access it later. 

Special notes for device replacement (V3 > V4):

● The interrupt behavior of interrupt OBs remains the same; they are not configured as 
interruptible. This is also the default behavior of S7-1200 CPUs V1-V3. The interrupt 
behavior of the interrupt OB can be configured for S7-1200 V4 CPUs. If you drag an 
S7-1200 CPU V4 directly from the hardware catalog into the network view, this option is 
activated (interrupt OBs are interruptible).

● The behavior for PUT/GET access of remote partners remains the same; access is 
permitted.  This is also the default behavior of S7-1200 CPUs V1-V3. The access via PUT/
GET communication by means of remote partners can be configured for S7-1200 V4 CPUs 
("Protection" area of CPU parameters). If you drag an S7-1200 CPU V4 directly from the 
hardware catalog into the network view, access is not permitted and must be explicitly 
enabled. 

● The wording for the protection levels changes but the effect of the settings remains the 
same. You can also select the access level "No access (complete protection)". 

● The web server settings for activation of the web server and HTTP/HTTPS settings are 
applied. You also have the option to create users and assign them specific rights (Web 
server area > User management of CPU parameters). Web server users only have access 
to standard websites when you do not configure users. An S7-1200 CPU V4 no longer 
supports the user "admin" and his/her password. 

Communication with HMI devices
When you connect an HMI device to an S7-1200 CPU V4, make sure that you use the 
appropriate Runtime software version of the HMI device. 
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You may have to transfer the latest HMI Runtime version by means of the WinCC engineering 
software. 

You must compile the HMI configuration once again and download it to the HMI device for the 
CPU-HMI communication to work.

See also
Useful information on memory cards (Page 1071)

8.1.6.2 Identification systems

RFID systems

Communications module RF120C

Reader parameter group
The "Reader" parameter group contains the following:

● Diagnostics: Setting to decide whether or not hardware diagnostics messages are output.

● Reader System: Selection of the connected RFID system. Depending on the selection you 
make, the "Reader System" parameter group is adapted.

"Diagnostics" parameter
Parameter assignment options:

● None
Apart from standard diagnostics messages, no other diagnostics messages are generated.

● Hard Errors
Extended diagnostics messages are generated if the following events occur.

– Hardware error (memory test)

– Firmware error (checksum)

– Connection to reader lost

– Short-circuit fault/interruption if supported by the hardware

Further information
For further information on diagnostics, refer the documentation for the RF120C 
communications module with application blocks for S7-1200 and S7-1500.
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Reader System parameter group
 

The parameters for the selected identification system are set in the "Reader system" parameter 
group.

The table shows the parameters that exist for all identification systems (RFID and code reader 
systems).

Table 8-56 Standard parameters for all identification systems

Parameter Parameter value Default value Description
Baud rate reader 19.2 kBd

57.6 kBd
115.2 kBd

115.2 kBd After changing the baud rate, the reader must 
be turned off and on again.

Presence Check On
Off (RF field off)
Off (RF field on)

On On = presence is reported as soon as there is 
a transponder in the antenna field of the reader
Off (RF field on ) = the presence check in the 
FB is suppressed. The antenna on the reader 
is nevertheless turned on as long as it has not 
been turned off by a command.
Off (RF field off) = the antenna is turned on only 
when a command is sent and it then turns itself 
off again (RF300 only)

Reset ERR‑LED On
Off

Off On = the flashing of the error LED on the 
RF120C is reset by each FB reset.
Off = the error LED always indicates the last 
error. The display can only be reset by turning 
off the RF120C.

The following parameters are system specific according to the selection you made in the 
"Reader" parameter group.

RF200

Table 8-57 RF200 general

Parameter Parameter value Default value Description
- - - Only the standard parameters are available.

Table 8-58 RF290R

Parameter Parameter value Default value Description
RF power 0.50 - 5.00 W 1.00 W Setting for the output power of the reader.
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RF300

Table 8-59 RF300 general

Parameter Parameter value Default value Description
Transponder type RF300

ISO 15693
RF300 Selection of the transponders used.

Table 8-60 RF380R

Parameter Parameter value Default value Description
RF power 0.50 - 2.00 W 1.25 W Setting for the output power of the reader.
Transponder type RF300

ISO 15693
RF300 Selection of the transponders used.

RF600

Table 8-61 Reader System: RF600

Parameter Parameter value Default value Description
Max. no. of transponders 1 - 80 1 Number of transponders expected in the 

antenna field.
Permitted values:
● 1 - 40 for RF620R
● 1 - 80 for RF630R with 2 antennas 
● 1 - 40 for RF630R with 1 antenna 
The value stored in "multitag" defines the 
expected number of transponders to be read 
(EPC-ID) in the inventory.
The value does not restrict the number of 
transponders to be processed in the antenna 
field.
To ensure an efficient inventory of 
transponders in the antenna field, make sure 
that the values specified here do not deviate by 
more than approximately 10% from the 
maximum number of transponders to be 
expected in the antenna field.

Reader type RF620R ETSI
RF620R FCC
RF620R CMIIT
RF630R ETSI
RF630R FCC
RF630R CMIIT

RF620R ETSI Selection of the reader used.
By selecting a reader, you open the "Reader 
type" parameter group. The parameters are 
described in the following table.
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Reader type (RF600 only)
In the "Reader type" parameter group further specific parameters are set for the reader type 
selected in the "Reader system" parameter group.

Table 8-62 RF600 menu: Reader type

Parameter Parameter value Default value Description
Wireless profile - - Selection of the relevant wireless profile for 

ETSI, FCC or CMIIT.
Multitag mode UID = EPC-ID 

(8 bytes)
UID = Handle ID 
(4 bytes)

UID = EPC-ID 
(8 bytes)

● UID = EPC-ID (8 bytes) 
8 byte UID of the bytes 5-12 of the 12 byte 
long EPC-ID

● UID = handle ID (4 bytes)
4 byte UID as handle ID for access to 
transponders with an EPC-ID of any length

Intelligent Single Tag Mode 
(ISTM)

On
Off

Off Enable/disable the "Intelligent Single Tag Mode 
ISTM" algorithm 1)

Black List On
Off

Off Enable/disable the "Black list" 1)

Radiated power internal 
antenna (RF620R)

0 - B 4 Setting the radiated power for the internal 
antenna 1) 2)

Internal antenna (RF620R) - - Enable/disable the internal antenna. 
With the RF620R, either only the internal or 
only the external antenna can be set.

Transmit power (external 
antenna RF620R)

0 - 9 4 Setting the transmit power for the external 
antenna 1) 2)

External antenna (SetAnt 
block required) (RF620R)

- - Enable/disable the external antenna. 
With the RF620R, either only the internal or 
only the external antenna can be set.

Transmit power ANT 1 
(RF630R)

0 - 9 4 Setting the transmit power for antenna 11) 2)

Transmit power ANT 2 
(RF630R)

0 - 9 4 Setting the transmit power for the antenna 21) 2)

Communications speed Reliable detection
Fast detection

Reliable detection 1)

Tag hold On
Off

Off Enable/disable "Tag hold" 1)

Scanning mode On
Off

Off Enable/disable the "Scanning mode" 1)

Channel assignment (only 
with wireless profile ETSI)

- - Selection of the wireless channels to be used 1)

1) You will find further information in the "Configuration manual RF620R/RF630R". *
2) The values for the transmit/radiated power of the antennas can be found in the following table.

* You will find the configuration manual RF620R/RF630R here (http://
support.automation.siemens.com/WW/view/en/10805817).
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Table 8-63 Transmit / radiated power of the antennas

Hex value RF630R
transmit power

RF620R 
radiated power (internal antenna)

RF620R 
transmit power

 
dBm / (mW)

ETSI
dBm / (mW) 

ERP

FCC
dBm / (mW) 

EIRP

CMIIT
dBm / (mW) 

ERP

 
dBm / (mW)

0
1
...
4
...
9
A

B (...F)

18 / (63)
19 / (79)

...
22 / (158)

...
27 / (501)
27 / (501)
27 / (501)

18 / (63)
19 / (79)

...
22 / (158)

...
27 / (501)
28 / (631)
29 / (794)

20 / (100)
21 / (126)

...
24 / (251)

...
29 / (794)

30 / (1000)
31 / (1259)

18 / (65)
19 / (79)

...
22 / (158)

...
27 / (501)
28 / (631)
29 / (794)

18 / (63)
19 / (79)

...
22 / (158)

...
27 / (501)
27 / (501)
27 / (501)

SLG D10S

Table 8-64 SLG D10S

Parameter Parameter value Default value Description
RF power 0.50 - 10.00 W 1.00 W Setting for the output power of the reader.
Transponder type ISO

I-Code (e.g. 
MDS D139)

ISO Selection of the transponders used.

SLG D11S/D12S

Table 8-65 SLG D11S/D12S

Parameter Parameter value Default value Description
Transponder type ISO

I-Code (e.g. 
MDS D139)

ISO Selection of the transponders used.
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MOBY U

Table 8-66 MOBY U

Parameter Parameter value Default value Description
Standby time 0 - 1400 ms 0 ms Standby time (scanning_time) for the 

transponder.
If the transponder receives a further command 
before the standby time has elapsed, this 
command can be executed immediately. If the 
transponder receives a command after standby 
time has elapsed, command execution is 
delayed by the "sleep_time" of the transponder.

Range limitation 0.2 m
0.5 m
1.0 m
1.5 m
2.0 m
2.5 m
3.0 m
3.5 m

1.5 m -

Max. no. of transponders 1 - 12 1 Maximum number of transponders that can be 
processed at the same time in the antenna field.

BERO mode Without BEROs
1 or 2 BEROs
1st BERO on, 2nd 
BERO off
Synchronization by 
cable connection

Without BEROs ● Without BEROs
No reader synchronization

● 1 or 2 BEROs
The BEROs are logically ORed. The 
antenna field is turned on during the 
actuation of a BERO.

● 1st BERO on, 2nd BERO off
1st BERO turns on the antenna field and the 
2nd BERO turns the antenna field off.
If there are two BEROs present and "BERO 
time in s" is set, the antenna field is turned 
off automatically if the 2nd BERO does not 
switch within this BERO time. If no "BERO 
time in s" is set, the antenna field remains 
turned on until the 2nd BERO is activated.

● Synchronization by cable connection 
Enable reader synchronization via cable 
connection (see manual on configuration, 
installation and service for MOBY U).

BERO time in s 0 - 255 s 0 s Can only be set if the BERO mode is set to "1st 
BERO on, 2nd BERO off".
● 0

The time monitoring is disabled. To turn off 
the field, the 2nd BERO is required.

● 1 ... 255 s
Operating time for the reader field
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General Reader

Table 8-67 General Reader

Parameter Parameter value Default value Description
Input box for byte sequence 
(hexadecimal)

00000000 00000000 Expert mode
With this function, you can specify the reset 
parameters directly in hexadecimal notation. 
This setting may only be selected if you have 
previously received the hexadecimal string for 
the setting from a member of the SIEMENS 
staff.

Parameters via FB / code readers

Table 8-68 Parameters via FB / code readers

Parameter Parameter value Default value Description
MOBY mode RF200, RF300, 

RF600, MOBY D/U, 
MV

RF200, RF300, 
RF600, MOBY D/U, 
MV

Only the mode "RF200, RF300, RF600, MOBY 
D/U, MV" is supported.
For further information on resetting a function 
block, refer to the documentation for the 
RF120C communications module with 
application blocks for S7-1200 and S7-1500. *

* You will find information on the documentation here (http://support.automation.siemens.com/
WW/view/en/10805817).

8.1.6.3 Distributed I/O

Distributed I/O systems

SIMATIC ET 200 - The right solution for all applications
SIMATIC ET 200 provides the most varied range of distributed I/O systems.

● Solutions for use in the control cabinet 

● Solutions without control cabinet directly at the machine

Additionally, there are also components that can be used in explosive areas. SIMATIC ET 200 
systems for construction without a control cabinet are contained in robust, glass-fibre 
reinforced plastic casing and are therefore shock-resistant, resistant to dirt and watertight.

Their modular design allows the ET 200 systems to be easily scaled and expanded in small 
steps. Fully-integrated auxiliary modules lower costs and also provide a wide range of possible 
applications. There are several combination possibilities available:

● Digital and analog I/OS

● Intelligent modules with CPU functions,
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● Safety technology,

● Pneumatics,

● Frequency converters

● Various technology modules.

Communication via PROFIBUS and PROFINET, uniform engineering, clear diagnostic 
possibilities as well as optimal connection to SIMATIC controller and HMI devices vouch for 
the unique consistency provided by Totally Integrated Automation.

The following table provides an overview of I/O devices for use in the control cabinet:           

I/O device Properties
ET 200S ● Highly modular design with multiple conductor 

connections
● Multifunctional due to a wide range of modules
● Use in explosive areas (Zone 2)

ET 200S COMPACT ● Highly modular design with multiple conductor 
connections

● Multifunctional due to a wide range of modules
● Use in explosive areas (Zone 2)
● Integrated DE/DA

ET 200L ● Cost-effective digital block I/OS
● Digital electronic blocks up to 32 channels

ET 200M ● Modular design with standard modules from 
SIMATIC-S7-300

● Failsafe I/O modules
● Use in explosive areas up to Zone 2, sensors 

and actuators up to Zone 1
● High level of plant availability, for example by 

plugging and unplugging when in operation
ET 200iSP ● Modular design, also possible with redundancy

● Robust and intrinsically safe design
● Use in explosive areas up to Zone 1/21; 

sensors and actuators even up to Zone 0/20
● High level of plant availability, for example by 

plugging and unplugging when in operation

 

The following table provides an overview of I/O devices for use without a control 
cabinet:         
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I/O device Properties
ET 200pro ● Modular design with compact housing

● Easy assembly
● Multifunctional due to a wide range of modules
● High level of availability due to plugging and 

unplugging in operation and permanent wiring
● Comprehensive diagnostics

ET 200eco PN ● Cost-efficient, space-saving block I/OS
● Digital modules up to 16 channels (also 

configurable)
● Analog modules, IO-link master and load 

voltage distributor
● PROFINET connection with 2-port switch in 

each module
● Can be flexibly distributed via PROFINET in 

line or star shape directly within the plant
ET 200eco ● Cost-effective digital block I/OS

● Flexible connection possibilities
● Failsafe modules
● High level of plant availability

ET 200R ● Specially for use on robots
● Assembled directly on the chassis
● Resistant to weld spatter due to robust metal 

housing

 

See also
Documentation on ET 200L (http://support.automation.siemens.com/WW/view/de/1142908/0/
en)

Documentation on ET 200S (http://support.automation.siemens.com/WW/view/en/1144348)

Documentation on ET 200M (http://support.automation.siemens.com/WW/view/de/1142798/0/
en)

Documentation on ET 200pro (http://support.automation.siemens.com/WW/view/de/
21210852/0/en)

Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Documentation on ET 200R (http://support.automation.siemens.com/WW/view/de/
11966255/0/en)

Documentation on ET 200eco PN (http://support.automation.siemens.com/WW/view/de/
29999018/0/en)

Documentation on ET 200eco  (http://support.automation.siemens.com/WW/view/de/
12403834/0/en)
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ET 200iSP

ET 200iSP Distributed I/O Station

Definition  
The ET 200iSP distributed I/O station is a highly modular and intrinsically safe DP slave with 
degree of protection IP 30.

Area of application
The ET 200iSP distributed I/O station can be operated in potentially explosive atmospheres 
characterized by gas and dust:

Approval ET 200iSP Station* Inputs and outputs
ATEX
IECEx

Zone 1, Zone 21 up to Zone 0, Zone 20 **
Zone 2, Zone 22 up to Zone 0, Zone 20 **

* In combination with an appropriate enclosure
** for electronic module 2 DO Relay UC60V/2A: up to Zone 1, Zone 21

The ET 200iSP distributed I/O station can, of course, also be used in the safety area.

You can insert almost any combination of ET 200iSP I/O modules directly next to the interface 
module that transfers the data to the DP master. This means you can adapt the configuration 
to suit your on-site requirements.

Every ET 200iSP consists of a power supply module, an interface module and a maximum of 
32 electronic modules (for example digital electronics modules). Remember not to exceed the 
maximum current consumption.

Terminal modules and electronic modules  
In principle, the ET 200iSP distributed I/O station consists of various passive terminal modules 
onto which you plug the power supply and the electronic modules.

The ET 200iSP is connected to PROFIBUS RS 485-IS by means of a connector on terminal 
module TM-IM/EM. Every ET 200iSP is a DP slave on the PROFIBUS RS 485‑IS. 

DP master  
All ET 200iSP modules support communication with DP masters that are compliant with 
IEC 61784-1:2002 Ed1 CP 3/1 and operate with "DP" transmission protocol (DP stands for 
distributed peripherals or distributed I/O).  

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)
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Assigning the channel and IEEE tag

Properties  
Analog electronic modules 4 AI I 2WIRE/HART, 4 AI I 4WIRE/ HART and 4 AO I HART support 
up to four IEEE tags. 

The process input image (PII) provides up to 20 bytes per module for the IEEE tags. Thus, 
four blocks of 5 bytes each are available for the four IEEE tags within the PII.

Requirements
The HART field device must support the assigned number of IEEE tags.
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Assigning IEEE tags 
You assign the IEEE tags of the field devices to any one of the four blocks in the PII.

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
1150 System Manual, 02/2014

http://support.automation.siemens.com/WW/view/de/28930789/0/en
http://support.automation.siemens.com/WW/view/de/28930789/0/en


Assigning parameters to reference junctions for thermocouples

Compensation of the reference junction temperature 
There are various ways of obtaining the reference junction temperature in order to get an 
absolute temperature value from the temperature difference between the reference junction 
and the measuring point.

Table 8-69 Compensation of the reference junction temperature

Option Explanation Reference junction parameters
No compensation You record not only the temperature of 

the measurement point. The 
temperature of the reference junction 
(transition from Cu line to thermocouple 
line) also affects the thermo-
electromotive force. The measured 
value then includes an error.

None

Use of a Pt100 
Climatic Range 
resistance 
thermometer to 
record the reference 
junction temperature 
(best method)

You can record the reference junction 
temperature using a resistance 
thermometer (Pt100 Climatic Range). If 
parameterized accordingly, this 
temperature value is distributed to the 4 
AI TC modules in the ET 200iSP where 
it is offset against the temperature value 
obtained at the measuring location.
Number of reference junctions: 2

The parameter assignment of the IM 
152 and the 4 AI TC must be 
coordinated:
● 4 AI RTD assigned parameters 

for Pt100 climatic range in 
correct slot;

● 4 AI TC: Reference junction : 
"yes"; select reference junction 
number "1" or "2"

● IM 152-1:Assignment of the 
reference junction to a slot with 4 
AI RTD; channel selection;

Internal 
compensation 4 AI 
TC

The TC sensor module (temperature 
sensor) is mounted onto the terminals of 
terminal module EM 4 AI TC. The 
temperature sensor reports the 
temperature of the terminals to the 4 AI 
TC. This value is then calculated 
together with the measured value from 
the channel of the electronic module.

● 4 AI TC: Reference junction 
number "internal"

Compensation by means of a resistance thermometer at the 4 AI RTD 
If thermocouples that are connected to the inputs of the 4 AI RTD have the same reference 
junction, compensate by means of a 4 AI RTD.

For both channels of the 4 AI TC module, you can select "1", "2" or "internal" as the reference 
junction number. If you select "1" or "2", the same reference junction (RTD channel) is always 
used for all four channels.
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Setting parameters for the reference junction 
You set the reference junctions for the 4 AI TC electronic modules by means of the following 
parameters:

Table 8-70 Reference junction parameters

Parameter Module Range of values Explanation
Slot reference junction 1 to slot 2 IM 152 none, 4 to 35 With this parameter, you can assign up to 2 

slots (none, 4 to 35), on which the channels 
for reference temperature measurement 
(calculating the compensation value) are 
located.

Input reference junction 1 to 4 
input reference junction  

IM 152 RTD on channel 0
RTD on channel 1
RTD on channel 2
RTD on channel 3

This parameter allows you to set the channel 
(0/1/2/3) for measuring the reference 
temperature (calculation of the 
compensation value) for the assigned slot. 

Reference junction E0 to 
reference junction E3

4 AI TC None
yes

This parameter allows you to enable the use 
of the reference junction.

Reference junction number 4 AI TC 1
2
Internal

This parameter allows you to assign the 
reference junction (1, 2) that contains the 
reference temperature (compensation 
value).

See also
Documentation on ET 200iSP (http://support.automation.siemens.com/WW/view/de/
28930789/0/en)

Fundamentals of Time Stamping

Properties 
Time stamping is possible with the IM 152 in customer applications using FB 62 (FB 
TIMESTMP). 

Principle of operation 
A modified input signal is assigned a time stamp and stored in a buffer (data record). If time 
stamped signals exists or a data record is full, a hardware interrupt is generated to the DP 
master. The buffer is evaluated with "Read data record". Special messages are generated for 
events that influence the time stamping (communication with the DP master interrupted, frame 
failure of time master, ...).
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Parameter Assignment
With the parameter assignment you define which IM 152 user data will be monitored. For the 
time stamping these are digital inputs that are monitoring for signal changes.

Parameter Setting Description
Time stamping ● disabled

● enabled
Activate the time staming for the 
channels of the electronics module 8 
DI NAMUR.

Edge evaluation 
incoming event

● rising edge
● falling edge

Determine the type of signal change 
that will be time-stamped.

Counting

Count properties

Counting functions
The 8 DI NAMUR electronics module has configurable counting functions:

● 2 x 16-bit up counters (standard counting function) or

● 2 x 16-bit down counters (standard counting function) or

● 1 x 32-bit down counter (cascading counter function)

● Setting a setpoint with the PIQ

● GATE function

● You can configure the control signals of the counters:

– Configuration channel 0..1: "Counter", channel 2..7: "DI": Two counters are configured. 
The control signals of the counters are stored in the PIQ (process image output).

– Configuration channel 0..1: "Counter", channel 2..7: "Control": Two counters are 
configured. The control signals of the counters are stored in the PIQ (process image 
output). They are also controlled by the digital inputs of the 8 DI NAMUR. 

See also
Principle of operation (Page 1153)

Configuring counters (Page 1156)

Assigning parameters to counters (Page 1159)

Principle of operation

16-bit up counters (standard counting function)
The counting range is 0 to 65,535. 
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With each count pulse at the digital input, the count is incremented by 1. Once the count limit 
is reached, the counter is reset to 0 and it counts up again from this value.

If there is counter overflow, the corresponding output is set in the PII.

A positive edge of the Reset output control signal resets the output in the PII. This does not 
affect the current count value.

In 16-bit up counting operations, the system does not set any outputs in the PIQ. These are 
always reset.

The positive edge of the Reset counter control signal sets the counter to 0 and resets the set 
counter output.

The GATE control signal pauses the counting on a positive edge. Count pulses are processed 
at the digital input again, but only at the negative edge. The Reset counter control signal is 
also effective when GATE is active.

16-bit down counters (periodic counting function)
The maximum counting range is always 65,535 to 0.

When the counter is started, the actual value is set to the selected setpoint. Each counted 
pulse reduced the actual value by 1. Once the actual value reaches 0, the corresponding output 
in the PII is turned on and the actual value is set to the selected setpoint. The counter then 
counts down from this value.

The positive edge of the Reset counter control signal resets the selected setpoint and the 
corresponding output in the PII.

A positive edge of the Reset output control signal resets the output in the PII. This does not 
affect the current count value.
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The GATE control signal pauses the counting on a positive edge. At the same time, the 
assigned output in the PII is reset. Count pulses are processed at the digital input again, but 
only at the negative edge. The Reset output and Reset counter control signals are also effective 
when GATE is active.

The setpoint of the counter is set and changed using the PIQ. The setpoint is adopted on a 
positive edge of the Reset counter control signal or when the counter has reached zero.

 

32-bit down counter (cascading counter function)   
The maximum counting range is always 4294967295 to 0.

The principle of operation is identical to that of the 16-bit down counter. Channel 1 has no 
function.

See also
Count properties (Page 1153)
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Configuring counters

Procedure
1. Using the mouse, pull module 8 DI Namur from the hardware catalog into distributed I/O 

station ET 200iSP.

2. Select the required configuration (channel 0..1: "Counter", channel 2..7: "DI" or "Control"). 
In the module properties (inspector window), you can find this setting under "Parameters 
> Inputs > Configuration".

Configuration channel 0..1: "Counter", channel 2..7: "DI"
● Assignment of the digital inputs on the electronic module 8 DI NAMUR

Table 8-71 Assignment of digital inputs for channel 0..1: "Counter", channel 2..7: "DI": 

Digital input Terminal Assignment
Channel 0 1, 2 Counter 1
Channel 1 5, 6 Counter 2 (does not apply to 32-bit down counters)
Channel 2 9, 10 Digital input 2
Channel 3 13, 14 Digital input 3
Channel 4 3, 4 Digital input 4
Channel 5 7, 8 Digital input 5
Channel 6 11, 12 Digital input 6
Channel 7 15, 16 Digital input 7
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● Assignment of the process image input (PII)

● Assignment of the process image output (PIQ)
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Configuration channel 0..1: "Counter", channel 2..7: "CONTROL"
With this configuration, you can also control the counters over the digital inputs.

● Assignment of the digital inputs on electronic module 8 DI NAMUR
For further information on input assignments, refer to the technical data for electronic 
module 8 DI NAMUR.

Table 8-72 Assignment of the digital inputs for 2 Count/ 6 Control

Digital input Terminal Assignment
Channel 0 1, 2 Counter 1
Channel 1 5, 6 Counter 2 (does not apply to 32-bit down counters)
Channel 2 9, 10 control signal GATE 1
Channel 3 13, 14 control signal GATE 2
Channel 4 3, 4 control signal Reset counter 1
Channel 5 7, 8 control signal Reset counter 2
Channel 6 11, 12 control signal Reset counter output 1
Channel 7 15, 16 control signal Reset counter output 2

● Assignment of the process image input (PII)
Assignment is identical to configuration 0..1: "Counter", channel 2..7: "DI".

● Assignment of the process image output (PIQ)
Assignment is identical to configuration 0..1: "Counter", channel 2..7: "DI".

See also
Count properties (Page 1153)
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Assigning parameters to counters

Parameters for the counting function
Only those parameters that are relevant for the counters are explained below. These belong 
to the parameters of electronic module 8 DI NAMUR and depend on the selected configuration:

Table 8-73 Parameters for the counters

Parameter Setting Description
Sensor type counter 
inputs

● Channel disabled
● NAMUR sensor
● Single contact, no load resistance

Select the sensor for the respective 
counter of channels 0 or 1.

Mode for counter 1 ● Standard counting function
● Periodic counting function
● Cascaded counting function

Select the mode for counter 1.

Mode for counter 2 ● Standard counting function
● Periodic counting function
● Cascaded counting function

Select the mode for counter 2. This 
parameter is not relevant if you have 
set the "Mode for counter 1" 
parameter to "Cascaded counter 
function".

See also
Count properties (Page 1153)

Frequency measurement

Frequency measurement properties

Properties
The electronic module 8 DI NAMUR allows the frequencies to be measured on channel 0 and 
1:

● 2 frequency meters from 1 Hz to 5 kHz

● Configurable metering window (GATE)

● The signals of the frequency meter are read in by means of the digital inputs of the electronic 
module. 

See also
Principle of operation (Page 1160)

Configuring frequency meters (Page 1160)

Assigning parameters for the frequency meters (Page 1162)
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Principle of operation

Frequency measurement
The signal frequencies are identified from the input signals of channel 0 or 1 of the electronic 
module. To calculate the frequency the signals are measured within a configurable gate.

The frequency is displayed as 16-bit value in fixed-point format and transferred to the PII.

The frequency meter calculates the frequency according to the follow formula:

Exceeding the input frequency
If the input frequency exceeds 5kHz, 7FFFH is reported as actual value. If the input frequency 
is above approx. 8 kHz it is no longer possible to display correct actual values.

See also
Frequency measurement properties (Page 1159)

Configuring frequency meters

Procedure
1. Using the mouse, pull module 8 DI Namur from the hardware catalog into distributed I/O 

station ET 200iSP.

2. Select the required configuration (channel 0..1: "Trace", channel 2..7: "DI"). In the module 
properties (inspector window), you can find this setting under "Parameters > Inputs > 
Configuration".

Configuration 0..1: "Trace", channel 2..7: "DI"
Assignment of the digital inputs on electronic module 8 DI NAMUR

Digital input Terminal Assignment
Channel 0 1, 2 Frequency counter 1
Channel 1 5, 6 Frequency counter 2
Channel 2 9, 10 Digital input 2
Channel 3 13, 14 Digital input 3
Channel 4 3, 4 Digital input 4
Channel 5 7, 8 Digital input 5
Channel 6 11, 12 Digital input 6
Channel 7 15, 16 Digital input 7
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Assignment of process image input (PII) for configuration of channel 0..1: "Trace", channel 
2..7: "DI"

Assignment of the process image output (PIQ): The PIQ is not assigned.

See also
Frequency measurement properties (Page 1159)
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Assigning parameters for the frequency meters

Parameters for frequency meter
Only those parameters that are relevant for the frequency meters are explained below. These 
are part of the parameters of electronic module 8 DI NAMUR.

Table 8-74 Parameters for the frequency meters 

Parameter Setting Description
Sensor type frequency 
inputs

● Channel disabled
● NAMUR sensor
● Single contact, no load 

resistance

Select the sensor for the relevant frequency 
meter for channel 0 or 1.

Measuring window 
(GATE)

● 50 ms
● 200 ms
● 1 s

Select the required measuring window for 
channel 0 or 1. 
To achieve the highest possible accuracy 
when metering frequencies, remember the 
following rules:
● High frequencies (> 4 kHz): Set a low 

measuring window (50 ms)
● Variable/medium frequencies: set 

medium measuring window (200 ms)
● Low frequencies (< 1 kHz): Set a high 

measuring window (1 s)

See also
Frequency measurement properties (Page 1159)

ET 200eco PN

ET 200eco PN Distributed I/O Device

Definition   
The ET 200eco PN distributed I/O device is a compact PROFINET IO device in degree of 
protection IP 65/66 or IP 67 and UL Enclosure Type 4x, Indoor use only.
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Field of application 
The fields of application of the ET 200eco PN are derived from its special properties. 

● A robust design and degree of protection IP 65/66 or IP 67 make the ET 200eco PN 
distributed I/O device suitable in particular for use in rugged industrial environments.

● The compact design of the ET 200eco PN is particularly favorable for applications in 
confined areas.

● The easy handling of ET 200eco PN facilitates efficient commissioning and maintenance.

Properties
The ET 200eco PN has the following properties:

● Integrated switch with 2 ports

● Supported Ethernet services:

– ping

– arp

– Network diagnostics (SNMP)

– LLDP

● Interrupts

– Diagnostics interrupts

– Maintenance interrupts

● Port diagnostics

● Isochronous real-time communication

● Prioritized startup

● Device replacement without programming device

● Media redundancy

● Connection to intelligent sensors/actuators via IO link master interface module.

IO Controller 
The ET 200eco PN can communicate with all IO Controllers that conform to IEC 61158. 

ET 200eco PN can be configured on a CPU with advanced diagnostics.

 

See also
Documentation on ET 200eco PN (http://support.automation.siemens.com/WW/view/en/
29999018)

Editing devices and networks
8.1 Configuring devices and networks

WinCC Professional V13.0
System Manual, 02/2014 1163

http://support.automation.siemens.com/WW/view/en/29999018
http://support.automation.siemens.com/WW/view/en/29999018


Parameter description analog input

Group diagnostics
You can generally enable and disable the diagnostics function of the device with this parameter.

The "Fault" and "Parameter assignment error" diagnostics functions are always independent 
of the group diagnostics.

Diagnostics, missing 1L+
If you enable this parameter, the check for missing supply voltage is enabled.

Diagnostics, sensor supply short circuit  
If you enable this parameter, a diagnostics event is generated if a short-circuit of the sensor 
supply to ground is detected and the channel is enabled. The sensor supply is monitored for 
connectors X1, X3, X5 and X7. It is not possible to differentiate which connector has 
experienced the sensor short circuit.

Interference frequency suppression
With this parameter, you set the integration time of the device, based on the selected 
interference frequency. Select the frequency of the supply voltage used. Interference 
frequency suppression Off means 500 Hz, which corresponds to an integration time of 2 ms 
for a measurement channel.

Temperature unit
Specify the unit of the temperature measurement here.

Measurement type (channel-wise)
With this parameter, you set the measurement type, for example, voltage. For any unused 
channels, you must select the disabled setting. For a disabled channel, the conversion time 
and integration time of the channel = 0 s and the cycle time is optimized.

Measuring range
With this parameter, you set the measuring range of the selected measurement type.

Temperature coefficient (for RTD, thermoresistor)  
The correction factor for the temperature coefficients (α-value) indicates by what extent the 
resistance of specific material changes relatively if the temperature increases by 1 ℃.

The α-values conform to EN 60751, GOST 6651, JIS C 1604 and ASTM E-1137.

The temperature coefficient depends on the chemical composition of the material. 
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Smoothing  
Smoothing of the analog values produces a stable analog signal for further processing. The 
smoothing of analog values is useful when handling wanted signals (measured values) with a 
slow rate of change, for example, temperature measurements.

The measured values are smoothed by digital filtering. To achieve smoothing, the device 
generates a mean value from a specified number of converted (digitized) analog values.

You assign a maximum of four levels for the smoothing (none, weak, medium, strong). The 
level determines the number of module cycles, from which the mean value is generated.

The stronger the smoothing, the more stable the smoothed analog value and the longer it takes 
until the smoothed analog value is applied following a signal change (see the example below).

The figure below shows the number of cycles a module requires to apply the smoothed analog 
value at almost 100% after a step response, based on the smoothing function settings. The 
figure applies to all signal changes at the analog input. The smoothing value defines the 
number of cycles a module requires to reach 63% of the end value of the changed signal.

① Smoothing, weak
② Smoothing, medium
③ Smoothing, strong

Diagnostics, wire break 
When this parameter is enabled, the Wire break diagnostics event is generated when a wire 
break is detected. 

Observe the rules outlined below to handle a wire break in the 1 to 5 V and 4 to 20 mA 
measuring ranges:
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Parameter Event Measured 
value

Explanation

Enable wire break1 Wire break 7FFFH Diagnostics, wire break
Wire break disabled1

 
Underflow enabled

Wire break 8000H Measured value after leaving the 
underrange
 
Diagnostic message Lower limit value 
undershot

Wire break disabled1

Underflow disabled
Wire break 8000H Measured value after leaving the 

underrange
1 Measuring range limits for wire break detection and measuring range undershoot detection:
● 1 to 5 V: At 0.296 V
● 4 to 20 mA: At 1.185 mA

Diagnostics, underflow 
If you enable this parameter, the Underflow diagnostics event is generated when the measured 
value reaches the underflow range.

Diagnostics, overflow 
If you enable this parameter, the Overflow diagnostics event is generated when the measured 
value reaches the overflow range.

Reference junction for thermoresistor (TC) 
A difference in temperature between the measuring point and the free ends of the 
thermocouple (terminal point) generates a voltage between the free ends, namely the 
thermoelectric voltage. The value of this thermoelectric voltage is determined by the 
temperature difference between the measuring point and the free ends and by the type of 
material combination of the thermocouple. Since a thermocouple always measures a 
temperature difference, the free ends at the reference junction must be maintained at a known 
temperature in order to determine the temperature of the measuring point.

If you specify Internal compensation, the temperature of the measuring point in the housing of 
the I/O device is measured. With the External compensation setting, you can connect a 
compensation box in series in order to increase the accuracy of the temperature measurement. 

Parameter description analog output

Group diagnostics
You can generally enable and disable the diagnostics function of the device with this parameter.

The "Fault" and "Parameter assignment error" diagnostics functions are always independent 
of the group diagnostics.
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Diagnostics, missing 1L+
If you enable this parameter, the check for missing supply voltage is enabled.

Diagnostics, sensor supply short circuit
When this parameter is enabled, the system generates a diagnostics event if it detects a short-
circuit of the sensor supply to ground. This diagnostics function is activated when the group 
diagnostics function is enabled.

Response to CPU/Master STOP
Select how the module's outputs will respond to a CPU STOP:

● Shut down
The I/O device goes to the safe state. The process image output is deleted (=0).

● Keep last value
The I/O device retains the last value to be output before STOP.

● Substitute value
The I/O device outputs the value for the channel set beforehand.

 

  Note

Make sure that the plant is always in a safe state if "Keep last value" is selected.
 

Type of output
With this parameter, you set the output type, for example, voltage. For any unused channels, 
select the disabled setting. For a disabled channel, the conversion time and integration time 
of the channel = 0 s, and the cycle time is optimized.

Output range
With this parameter, you set the output range of the selected output type.

Diagnostics, wire break (in current mode)
When this parameter is enabled, the Wire break diagnostics event is generated when a wire 
break is detected. This diagnostics event cannot be detected in the zero range.

Diagnostics, short circuit (in voltage mode)
If you enable this parameter, a diagnostics event is generated in the event of a short circuit in 
the output line. This diagnostics event cannot be detected in the zero range.

Diagnostics, overload
If you enable this parameter, the diagnostics event is generated in the event of an overload.
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Substitute values
With this parameter, you enter a substitute value that the module is to output in CPU-STOP 
mode. The substitute value must be in the nominal range, overrange, or underrange.

ET 200SP

ET 200SP distributed I/O system

Definition   
The ET 200SP distributed I/O system is a scalable, highly flexible distributed I/O system for 
connection of process signals to a central controller via a field bus. 

Application area   
The ET 200SP is a multi-functional distributed I/O system for various fields of application. The 
scalable design allows you to configure the system exactly to the specific requirements on 
location.

The ET 200SP is approved for degree of protection IP 20 and for installation in a control cabinet.

Structure   
The ET 200SP is mounted on a mounting rail and comprises:

● An interface module which can communicate with all IO controllers that conform to the 
PROFINET standard IEC 61158

● Up to 32 I/O modules which can be inserted on passive BaseUnits in any combination

● A server module that completes the design of the ET 200SP.

Interface module parameters

Status bytes

Status bytes
If you enable the "Status bytes" option, 4 bytes of input data are reserved for the status of the 
supply voltage of each I/O module.
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 Note

An inserted or missing server module always reports for the slot bit = 0.
 

Group diagnostics, missing supply voltage L+

Group diagnostics, missing supply voltage L+
This diagnostics is a group diagnostics that covers the supply voltage status of all I/O modules 
of a potential group which are defined by BaseUnits with incoming power supply (light-colored 
BaseUnit BU...D). 

The group diagnostics is formed from the states of the supply voltage of the inserted I/O 
modules within the potential group.

The group diagnostics does not depend on the "Missing supply voltage L+" parameter of the 
I/O modules being enabled.

The server module does not influence the missing supply voltage L+ group diagnostics.

Requirements for the correct operation of the group diagnostics for missing supply voltage L+:
● I/O modules or BU covers must be inserted on the light-colored and dark-colored BaseUnits.

If no I/O module is inserted on a light-colored BaseUnit, the start of this potential group will 
not be detected by the interface module; the I/O modules of this potential group will thus 
belong to the previous potential group. A supply voltage L+ group error will then be assigned 
to the wrong potential group. 
When an I/O module is inserted on the light-colored BaseUnit, the interface module detects 
the new potential group, re-evaluates the status, and reports a new group diagnostics in 
the case of an error. 

● The server module must be inserted.
The server module itself does not influence the missing supply voltage L+ group diagnostics.

Configuration control

Operating principle     
Configuration control allows you to operate various real configurations (options) with a single 
configuration of the distributed I/O device ET 200SP.

Configuration control provides you with the option of configuring the ET 200SP  distributed I/
O device with its maximum configuration and nevertheless operating it with missing modules. 
If missing modules are retrofitted later, no new configuration is required and the hardware 
configuration does not have to be reloaded either. 

Using control data records, which are transferred to the interface module in the user program, 
you define a current preset configuration. 
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● The configured module is not present on a slot.

– A base unit cover may be inserted on this slot instead of the configured I/O module. As 
there is no configured module on the slot, the term "Configuration control with empty 
slots" is also used.

– The module that is configured to the right of the missing module can be inserted on this 
slot instead of the configured module. The missing module makes the actual 
configuration appear pushed together. As the configured module is missing but no gap 
arises in the configuration, this is also referred to as a "Configuration without empty 
slots".

● The configuration is extended by an already configured module.

– In the case of configuration control with empty spaces, you extend the configuration by 
inserting the configured module on the corresponding empty slot.

– In the case of configuration control without empty spaces, insert the configured module 
on the right-hand side next to the last module of the ET 200SP.

Addressing the interface module using the hardware identifier
To transfer data record 196 with the instruction WRREC, you must enter the hardware identifier 
of the interface module as input parameter for the instruction. The system constant of this 
hardware identifier is, for example, "IO-Device_2 [Head]". The system constants of a selected 
device are, for example, displayed in the network view in the "System constants" tab. Use the 
associated value for addressing.

More information and examples 
For information on the rules for configuration control, the structure of the control data record, 
and the behavior during operation as well as examples of the structure of the control data 
record for various configurations, refer to the IM 155-6 PN interface module manual (http://
support.automation.siemens.com/WW/view/en/59768173). 

Output module parameters

Substitute value reaction

Substitute value reaction
In the ET 200SP, the substitute value reaction is executed by the IO controller per slot.

The respective output reacts according to its set substitute value reaction:

● "Turn off"

● "Output substitute value"

● "Keep last value"

This substitute value reaction is triggered in the following cases:
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● IO controller in STOP

● Controller failure (connection interruption)

● Firmware update

● Reset to factory settings

● More than one I/O module withdrawn simultaneously

● Disable the IO device

● Station stop

– Missing server module

– More than one I/O module withdrawn simultaneously

– At least one I/O module is inserted on the wrong BaseUnit
 

  Note
Reducing a configuration

If you reduce the configuration of the ET 200SP and download the configuration to the 
CPU, the modules which are no longer configured but still present retain their original 
substitute value reaction. This applies until the supply voltage on the BaseUnit BU...D 
or on the interface module is turned off.

 

Input module parameters

Parameters of the digital input modules

Diagnostics missing supply voltage L+
Enabling of the diagnostics for missing or insufficient supply voltage L+.
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Diagnostics short-circuit to ground   
Enabling of the diagnostics if a short-circuit of the actuator supply to ground occurs.

① Encoder supply
② Short-circuit
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Diagnostics short-circuit to L+   
Enabling of the diagnostics if a short-circuit of the encoder supply to L+ occurs.

① Encoder supply
② Short-circuit

Diagnostics wire break
Enabling diagnostics if the line to the encoder is interrupted.

Operating mode
Determines whether a channel is enabled or disabled.

Pulse extension (only High Feature modules)   
Pulse extension is a function for changing a digital input signal. A pulse at a digital input is 
extended to at least the configured length. If the input pulse is already longer than the 
configured length, the pulse is not changed.

Pulse extension is started whenever the state of the input signal changes and no pulse 
extension is active for this channel. 
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Potential group of the left module / new potential group
Specifies whether the I/O module is located on a base unit with supply voltage feed (new 
potential group) or whether it is it located on a base unit without supply voltage feed (in which 
case it belongs to the potential group of the left module). 

Parameters of the analog input modules

Missing supply voltage L+        
Enabling of the diagnostics, with missing or too little supply voltage L+.

Reference junction (AI 4xRTD/TC 2-/3-/4-wire HF)
A BaseUnit with internal temperature sensor (BU..T) or the channel 0 of the I/O module can 
be used as reference junction, provided this has been configured as "Thermal resistance Pt100 
climatic range Celsius".

A possible configuration is shown below:

Table 8-75 RTD channel

Setting Description
No reference channel operation Temperature value at channel 0 can be used as module-wide reference value 

if the parameters of the other channels are assigned accordingly. 
Reference channel of Group 0 The channel acts as sender for the reference junction temperature of Group 0. 

Distribution is performed via the interface module.

Table 8-76 TC channel

Setting Description
Reference channel of the module The corresponding TC channel uses the channel 0 of the same module as 

reference junction temperature. This must be set as "Thermal resistance Pt 100 
climatic range Celsius" and "No reference channel operation"; otherwise, 
reference junction diagnostics is triggered.

Internal reference junction The reference junction temperature is read by an internal temperature sensor 
on the BaseUnit. Reference junction diagnostics is triggered if there is a wrong 
BaseUnit type.

Reference channel of Group 0 With the setting "TC" (thermocouple...), the channel acts as receiver for the 
reference junction temperature of Group 0 

Fixed reference temperature No temperature compensation occurs. The linearization is executed with an 
assumed reference junction temperature of 0 °C.

Overflow
Enabling of the diagnostics if the measured value exceeds the overflow range.
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Underflow
Enabling of the diagnostics if the measured value falls below the underflow range.

Wire break
Enabling of the diagnostics if the module has no current flow or too low a current flow for the 
measurement on the corresponding configured input.

Smoothing
The individual measurements are smoothed using digital filtering. The smoothing can be set 
in 4 stages, whereby the smoothing factor k multiplied by the cycle time of the I/O module 
corresponds to the time constant of the smoothing filter. The larger the smoothing, the larger 
the time constant of the filter.

The following figure shows the step response for the various smoothing factors depending on 
the number of module cycles.

Figure 8-5 Smoothing with AI 4×RTD/TC 2‑/3‑/4‑wire HF

Interference frequency suppression
With analog input modules, suppresses the disturbance caused by the frequency of the AC 
network used. 

The frequency of the AC network may interfere with measured values, particularly for 
measurements within low voltage ranges and when thermocouples are being used. This 
parameter is used to define the predominant power frequency of the system.

Hardware interrupt limits
If the high limit 1/2 or the low limit 1/2 is violated, the module triggers a hardware interrupt.
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Below are some examples for the selection of the limits 1 and 2. 

Low limit 1/2
Specify a threshold whose undershoot triggers a hardware interrupt.

High limit 1/2
Specify a threshold whose overrange triggers a hardware interrupt.

Potential group of the left module / new potential group
Specifies whether the I/O module is located on a base unit with supply voltage feed (new 
potential group) or whether it is it located on a base unit without supply voltage feed (in which 
case it belongs to the potential group of the left module). 

Temperature coefficient (measuring type thermoresistor) 
The correction factor for the temperature coefficient (α value) defines the relative rate of change 
of the resistance of a specific material at a temperature rise of 1 ℃.

The temperature coefficient depends on the chemical composition of the material. In Europe, 
only one value is used per sensor type (default value). 

The further values facilitate a sensor-specific setting of the temperature coefficient and 
enhance accuracy.

See also
Special features of AI 4xRTD/TC 2-/3-/4-wire HF (Page 1177)
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Special features of AI 4xRTD/TC 2-/3-/4-wire HF

Use of Cu10 sensors  
● Select "3-wire thermal resistor" and "Cu10" in the parameter assignment.

● Wire the Cu10 sensor using 3-wire connection technology.

● An automatic, internal compensation of the line resistance of the missing measuring line 
takes place during operation.

 

  Note

To ensure optimum line compensation for Cu10, please note the following:
● The sum of cable resistance and measuring resistance must not exceed 31 Ω.
● Cable resistance should not exceed 8 Ω if you want to use the temperature range up 

to over 312 °C. 
Example: A 200 m long copper cable with 0.5 mm2 core cross-section has approx. 
7 Ω. A lower cross-section reduces the permissible cable length accordingly.

 

Use of PTC resistors
PTCs are suitable for temperature monitoring of or as thermal protective equipment for 
complex drives or transformer windings.

● Select "2-wire resistor" and "PTC" in the parameter assignment.

● Connect the PTC using 2-wire technology.

● Use type A PTC resistors (PTC thermistors) in accordance with DIN/VDE 0660, Part 302.

● If the "Over-/underflow" diagnostics is enabled, a "low limit violation" diagnostics which 
shows a short circuit is generated for resistance values < 18 Ω.

● Sensor data on PTC resistance:

Table 8-77 Use of PTC resistors

Property Technical 
specifications

Note

Switching points Reaction to rising temperature
< 550 Ω Normal range:

● SIMATIC S7: bit 0 = "0", bit 2 = "0" (in the PII)
550 Ω to 1650 Ω Prewarning range:

● SIMATIC S7: bit 0 = "0", bit 2 = "1" (in the PII)
< 1650 Ω Response range:

● SIMATIC S7: bit 0 = "1", bit 2 = "0" (in the PII)
Reaction to falling temperature
< 750 Ω Response range:

● SIMATIC S7: bit 0 = "1", bit 2 = "0" (in the PII)
750 Ω to 540 Ω Prewarning range:

● SIMATIC S7: bit 0 = "0", bit 2 = "1" (in the PII)
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Property Technical 
specifications

Note

< 540 Ω Normal range:
● SIMATIC S7: bit 0 = "0", bit 2 = "0" (in the PII)

(TNF-5) °C
(TNF+5) °C
(TNF+15) °C
Measuring voltage 
Voltage on the PTC

max. 550 Ω
min. 1330 Ω
min. 4000 Ω
max. 7.5 V 

RRT= rated response temperature

● Assignment in the process image inputs (PII) with SIMATIC S7

Figure 8-6 Assignment in the process image inputs (PII) 

● Notes on programming
 

  Note

Only the bits 0+2 are relevant for the evaluation in the process image inputs. You can use 
the bits 0+2 to monitor the temperature, for example, of a motor.

The bits 0+2 in the process image inputs have no latching function. When you are 
assigning parameters, take into consideration that a motor, for example, starts up in a 
controlled manner (via an acknowledgment).

Bits 0+2 can never be set simultaneously, but are instead set consecutively.

For safety reasons, always evaluate the diagnostic entries of the AI 4×RTD/TC 2-/3-/4-
wire HF, as no measurement is possible if I/O modules are unplugged, if the supply voltage 
of the I/O module has failed, or if there is a wire break or short circuit of the measuring 
lines.
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Example
The following diagram shows the temperature variation and the associated switching points. 

See also
Parameters of the analog input modules (Page 1174)

ET 200MP

ET 200MP distributed I/O system

Definition   
The ET 200MP distributed I/O system is a scalable and flexible distributed I/O system for 
connection of process signals to a central controller via a field bus. 

Application area 
The ET 200MP is a multi-functional distributed I/O system for various fields of application. The 
scalable design allows you to configure the system exactly to the specific requirements on 
location.

The ET 200MP complies with IP 20 degree of protection and is intended for installation in a 
control cabinet.
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Structure   
The ET 200MP is installed on a mounting rail and comprises:

● An interface module that communicates with all IO controllers conforming to the PROFINET 
standard IEC 61158

● Up to 30 modules (power supply modules and I/O modules from the S7-1500 I/O range) 
can be inserted to the right of the interface module.

● If you insert a power supply module to the left of the interface module, this yields a possible 
maximum configuration of 32 modules in total. 

● The number of insertable I/O modules is limited by their power requirements. 

Slot rules
● Slot 0: Power supply module (optional)

● Slot 1: Interface module

● Slot 2 to 31: I/O modules or power supply modules

Interface module parameters

Supply voltage L+ connected

Parameter "Supply voltage L+ connected"
This parameter influences the diagnostics and the checking of the power budget. 

● Diagnostics of the ET 200MP:
If the actual configuration does not conform to the setpoint configuration with regard to the 
supply voltage of the interface module, the interface module generates a diagnostic alarm. 
Example: You have deactivated the "Supply voltage L+ connected" option, but you have 
connected the supply voltage in the actual configuration.

● Power budget check during configuration:
The power budget changes in accordance with the parameter setting: Either the interface 
module feeds power into the backplane bus or it draws power from the backplane bus.

The default ("Supply voltage L+ connected" option is activated) means that the front of the 
interface module is supplied with 24 V DC and the power is stored in the backplane bus.

If the "Supply voltage L+ connected" option is deactivated, the interface module may not be 
supplied with 24 V DC on the front. 
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In this case, insert a power supply unit (PS) on the left next to the interface module that supplies 
the interface module and the modules to the right of the interface module. 

 

 Note

We recommend that you always supply the interface module on the front side with 24 V DC. 
If a system power supply unit (PS) is inserted and connected additionally before or on the 
left next to the interface module, both the power from the system power supply unit (PS) as 
well as the power from the integrated power supply of the interface module are then available 
to the configuration. 

In this case, you do not have to change the default setting of the parameter.
 

Configuration control

Operating principle     
Configuration control allows you to operate various real configurations (options) with a single 
configuration of the ET 200MP distributed I/O device.

Configuration control provides you with the option of configuring the ET 200MP distributed I/
O device with its maximum configuration and nevertheless operating it with missing modules. 
If missing modules are retrofitted later, no new configuration is required and the hardware 
configuration does not have to be reloaded either. 

Using control data records, which are transferred to the interface module in the user program, 
you define a current preset configuration. 

We distinguish between the following procedures:

● Configuring configuration control without empty slots (option handling)

● Expanding configuration (step-by-step commissioning)

Requirement
Enable the Configuration control" option of the interface module ("Configuration control" area). 
Control takes place with control data record 196 to specify the required configuration. 
Configuration control is not ready for operation without a control data record. You transfer the 
control data record with the instruction WRREC in the user program. 

Addressing the interface module using the hardware identifier
To transfer data record 196 with the instruction WRREC, you must enter the hardware identifier 
of the interface module as input parameter for the instruction. The system constant of this 
hardware identifier is, for example, "IO-Device._V2 [Head]". The system constants of a 
selected device are, for example, displayed in the network view in the "System constants" tab. 
Use the associated value for addressing.
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More information and examples 
For information on the rules for configuration control, the structure of the control data record 
and the behavior during operation, as well as examples of the structure of the control data 
record for various configurations, refer to the IM 155-5 PN ST interface module manual (http://
support.automation.siemens.com/WW/view/en/67295970). 

Input module parameters

Parameters of the analog input modules

Missing supply voltage L+
Enabling of the diagnostics for missing or insufficient supply voltage L+.

Wire break
Enabling of the diagnostics if the module has no current flow or the current is too weak for the 
measurement at the corresponding configured input or the applied voltage is too low.

Current limit for wire break diagnostics
Threshold at which a wire break is reported. The value can be set to 1.185 mA or 3.6 mA, 
depending on the sensor used.

Overflow
Enabling of the diagnostics if the measured value exceeds the overrange.

Underflow
Enabling of the diagnostics if the measured value undershoots the underrange.

Common mode error
Enable diagnostics if the valid common mode voltage is exceeded.

Reference channel error (only for AI 8xU/I/RTD/TC ST) 
● Enable diagnostics on error at the temperature compensation channel, e.g. wire break.

● Dynamic reference temperature compensation type is configured and no reference 
temperature has been transferred to the module yet.
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Temperature coefficient
The temperature coefficient depends on the chemical composition of the material. In Europe, 
only one value is used per sensor type (default value). 

The correction factor for the temperature coefficient (α value) specifies how much the 
resistance of a certain material changes when the temperature is raised by 1 °C.

The further values facilitate a sensor-specific setting of the temperature coefficient and 
enhance accuracy.

Interference frequency suppression
At analog input modules, this suppresses interference caused by the frequency of AC mains. 

The frequency of the AC network may interfere with measured values, particularly for 
measurements within low voltage ranges and when thermocouples are being used. With this 
parameter, you define the mains frequency in your system.

Smoothing
The individual measured values are smoothed using filtering. Smoothing can be set in 4 stages 
for the analog input modules AI 8xU/I/RTD/TC ST and AI 8xU/I HS.

Smoothing time = number of module cycles (k) x cycle time of the module.

The figure below shows the number of module cycles after which the smoothed analog value 
is almost 100%, depending on the set smoothing. Is valid for each signal change at the analog 
input.

3

4

2

1

① None (k = 1)
② Weak (k = 4)
③ Medium (k = 16)
④ Strong (k = 32)
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Reference junction (only for AI 8xU/I/RTD/TC ST)
The following settings can be configured for the reference junction parameter:

Table 8-78 Possible parameter assignments for the reference junction parameter

Setting Description
Fixed reference temperature The reference junction temperature is configured and stored in the module as 

a fixed value.
Dynamic reference temperature The reference junction temperature is transferred in the user program from the 

CPU to the module by data records 192 to 199 using the WRREC (SFB 53) 
instruction.

Internal reference junction The reference junction temperature is determined using an integrated sensor 
of the module.

Reference channel of the module The reference junction temperature is determined using an external resistance 
thermometer (RTD) at the reference channel (COMP) of the module. 

 

 Note
Fixed reference temperature

During parameter assignment of a thermocouple Type B, only the setting "Fixed reference 
temperature" with a temperature of 0 °C is possible.

 

Enable hardware interrupt 1 or 2
Enable a hardware interrupt if high limit 1 or 2 is exceeded, or low limit 1 or 2 is violated.

Low limit 1 or 2
Specifies the low limit threshold that triggers hardware interrupt 1 or 2.

High limit 1 or 2
Specifies the high limit threshold that triggers hardware interrupt 1 or 2.

Temperature compensation for thermocouples

Introduction       
You have several options of measuring the reference junction temperature in order to obtain 
an absolute temperature value as a function of the temperature difference between the 
reference junction and the measuring point.
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You can use various compensation options depending on the required location of the reference 
junction.

 

 Note

During parameter assignment of a thermocouple Type B, only the setting "Fixed reference 
temperature" with a temperature of 0 °C is possible.

 

Options of compensating for the reference junction temperature

Compensation options Explanation Application case
Internal reference junction With this compensation, the reference junction 

temperature is determined using an integrated 
sensor of the module.
Procedure
Connect the thermocouple to the I/O module 
directly or with compensating lines. 

● For the connection, you use 
compensating lines matching the 
thermocouple material.

● If the reference junction temperature 
and the module temperature are 
identical in your system, you may 
also use lines made from a different 
material.

Reference channel of the 
module
 

The reference junction temperature is determined 
using an external resistance thermometer (RTD).
Procedure
Connect the thermocouple to the supply lines at the 
reference junction, either directly or with 
compensating lines. You connect the supply lines 
to the appropriate terminals of the module.
Connect the resistance thermometer (RTD) to the 
reference channel of the module. The resistance 
thermometer (RTD) must be placed in the area of 
the reference junction. 

● You want to measure the 
temperature directly at the reference 
junction.

● The measured temperatures of all 
channels that you have configured 
for this compensation type is 
corrected automatically by the 
temperature value of the reference 
junction.

● You can use inexpensive lines, e.g., 
copper lines, from the reference 
junction to the module.
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Compensation options Explanation Application case
Dynamic reference 
temperature

The temperature of the reference junction is 
determined via a module. This temperature value 
is transferred to other modules via a data record in 
the user program.
Procedure
Connect the resistance thermometer (RTD) for the 
reference junction to any channel.
The reference junction temperature is 
communicated from the CPU to the module by data 
records 192 to 199 using the WRREC instruction. 

● You use multiple modules at the 
reference junction and can therefore 
compensate all channels using a 
common temperature value.

● You require only one resistance 
thermometer (RTD) to acquire the 
temperature value.

● You can use inexpensive lines, e.g., 
copper lines, from the reference 
junction to the module.

Fixed reference temperature The reference junction temperature is stored in the 
module as a fixed value. 
Procedure
Connect the thermocouple to the supply lines at the 
reference junction, either directly or with 
compensating lines. You connect the supply lines 
to the appropriate terminals of the module.
When configuring the module, specify a fixed 
temperature value for the reference junction (e.g. 
20 °C). 

● You keep the reference junction 
temperature constant and know the 
temperature value.

● You can use inexpensive lines, e.g., 
copper lines, from the reference 
junction to the module.

Output module parameters

Parameters of the analog output modules

Missing supply voltage L+
Enabling of the diagnostics, with missing or too little supply voltage L+.

Short-circuit to ground
Enabling of the diagnostics if a short-circuit of the actuator supply to ground occurs.

Wire break
Enabling diagnostics if the line to the encoder is interrupted.

Overflow
Enabling of the diagnostics if the measured value exceeds the overflow range.

Underflow
Enabling of the diagnostics if the measured value falls below the underflow range.
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Reaction to CPU STOP
Determines the reaction of the output to the CPU going into STOP state.

Substitute value
The substitute values are values that the outputs (the output) issue in the event of a CPU STOP.

 

ET 200M

Configuring an ET 200M

Introduction
For the ET 200M series, you can find a wide range of modules in the hardware catalog under 
"Distributed I/O". 

Configuration and parameter assignment
Information on configuration and parameter assignment can be found in the following sections.

ET 200M configuration

Definition
The distributed IO device, ET 200M, is a modular DP slave with an IP 20 degree of protection.     

The ET 200M has the configuration technology of the S7‑300 automation system and consists 
of an IM 153‑x and I/O modules of the S7‑300.

ET 200M supports communication with:

● all DP masters compliant with IEC 61784-1:2002 Ed1 CP 3/1

● all IO controllers compliant with IEC 61158
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Configuration of the ET 200M (example)
 

1 2 3 

① Power supply module PS 307 
② Interface module IM 153‑x
③ up to 12 I/O modules (SM / FM / CP)

Configuration of the 'Module replacement during operation' function

Introduction     
The ET 200M supports the "Replace modules during operation" function and the associated 
pull/plug interrupt. 

The "Replace modules during operation" function makes it possible for you to pull modules 
from or plug modules into the ET 200M rack during operation. 

Requirement
You have configured an interface module that supports replacing modules during operation. 
(as of IM 153-1, order no. 153-1AA02-0XB0).

In addition, the configured CPU must also support the function, e.g. for PROFIBUS an S7-400 
with DP interface. 

You must use the active backplane bus (bus rail with slots) for the hardware configuration. The 
conventional profile rail with bus connectors between the modules does not support this 
function.

Configuring 
If the configuration requirements have been met, the "Replace modules during operation" 
parameter is available for selection in the inspector window's "Module parameters" area. Below 
this parameter, a table for the configured modules is displayed, which shows the required 
active bus modules for the hardware configuration. 

For a PROFIBUS configuration, the "Startup if preset configuration does not match actual 
configuration" option is displayed. This option is automatically enabled if "Replace modules 
during operation" is enabled. 
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Configuring HART variables

Introduction     
Numerous HART field devices make available additional measured quantities (e.g. sensor 
temperature). These can be read if they are set accordingly in the field device configuration. 
Using the HART variables. it is possible to apply the set measured values directly from the 
field device into the I/O area of your automation system.

Regardless of the number of configured channels, a maximum of 8 HART variables can be 
assigned for HART modules and no more than 4 HART variables per channel. You assign the 
HART variables to a channel in the properties for the module ("HART variable settings" area).

Requirement
The HART module is plugged into an ET 200 M (as of IM 153-2, 6ES7 153-2BA02-0AB0).

Address assignment 
The HART module occupies 16 input/output bytes. If you configure HART variables, the 
module occupies an additional 5 bytes for each HART variable.

If you use all 8 HART variables, the HART input module occupies a total of 56 input/output 
bytes (16 bytes + 8 x 5 bytes = 56 bytes).

The "None" configuration occupies no additional input bytes.

Configuration of HART variables
You can configure up to 4 HART variables for a channel 

● PV (Primary Variable)

● SV (Secondary Variable)

● TV (Tertiary Variable)

● QV (Quaternary)

CiR is a placeholder that reserves the address space for a HART variable. You must configure 
the HART variables you are not using with the "None" parameter.

Configuration of HART variables  
The HART variables are structured as follows:
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Structure of the "Quality-Code" byte    
The Quality-Code (QC) can assume the following values: 

Quality-Code (QC) Meaning
0x4C or 0 Initialization: 0 value of IM and 4C of module
0x18 Communication cancelled / no communication
0x0C Fault in HART device
0x47 HART device is busy
0x84 OK "Configuration changed"
0x80 OK

See also
Documentation for HART analog modules (http://support.automation.siemens.com/WW/view/
en/22063748)

Signal modules for process automation

Fundamentals

Introduction
Signal modules for the process automation are S7-300 models, such as SM 321; DI 
16xNAMUR or SM 322; DO 16x24VDC/0.5A. 

They are being operated in a DP slave (IM 153-2).

Unlike standard modules, they offer the following additional technical functions, such as pulse 
extension and chatter monitoring. 

See also
Changeover contact (Page 1190)

Technological parameters (Page 1191)

Changeover contact

"Changeover contact" sensor type
If the digital inputs of a channel group are configured as "changeover contacts", the module 
runs diagnostics for the changeover contact sensor type for this channel group. 
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Changeover contact 
A changeover contact is an auxiliary switch with only one moving switch element with one 
close setting each for closed and open switching device. 

Remember the following rule:

● Always connect a normally open contact to the "even" channel

● Always connect a normally closed contact to the "odd" channel.

The tolerated switchover time between the two channels is fixed at 300 ms.

If the result of the check is negative, then

● the module identifies the value status of the normally open channel as "invalid"

● the module generates a diagnostic entry for the normally open channel

● triggers a diagnostic interrupt (if diagnostic interrupts have been enabled)

The digital input signal and the value status are updated only for the normally open channel. 
For the normally closed channel, the digital input signal is set permanently to "zero" and the 
value status to "invalid" since this channel is used only to check the sensor.

Diagnostics depends on the "Selection" parameter (of the sensor). You should also note the 
special features of diagnostics with the changeover contact sensor type in the "Signal Modules 
for Process Automation" manual.

See also
Documentation on modules for process automation (http://support.automation.siemens.com/
WW/view/de/7215812/0/en)

Technological parameters

Pulse extension and flutter monitoring
Pulse extension is a function for changing a digital input signal. A pulse at a digital input is 
extended to at least the length set in the parameters. If the input pulse is already longer than 
the specified length, it is not changed. 

If you want the pulse to be extended, click in the box to select the time. If you do not want the 
pulses to be extended, select the "---" entry.

Flutter monitoring is a process control function for digital input signals. It detects and reports 
signal changes that are unexpected in process control, for example when an input signal 
fluctuates too often between "0" and "1". 

Flutter monitoring is possible only when group diagnostics has also been enabled for this input. 

Monitoring window and number of signal changes
Flutter monitoring works with aid of the two parameters Monitoring window and Number of 
signal changes.
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The first time the signal changes, the time set as the monitoring window is started. If the signal 
changes more often during this time than allowed by the number of signal changes parameter, 
this is signaled as a flutter error. If no flutter error is detected during the monitoring window 
time, the monitoring window can be restarted at the next signal change.

 

 Note

If you set pulse extension for an input channel, this also affects the flutter monitoring enabled 
for this channel. The "extended pulse" signal is the input signal for the flutter monitoring. You 
should therefore make sure that the values set for pulse extension and flutter monitoring are 
compatible with each other. 

 

See also
Documentation on modules for process automation (http://support.automation.siemens.com/
WW/view/de/7215812/0/en)

IQ Sense module

Properties of 8 IQ-SENSE

Properties   
The 8 IQ-SENSE module has the following properties:

● Connection of sensors with IQ-SENSE®, photoelectric proximity switches: for example, 
reflex sensors, diffuse sensors, and laser sensors.

● It can be used centrally in an S7-300 or distributed in an ET 200M.

● You can connect up to 8 sensors to every module. Each sensor requires a two-wire cable.

● Function reserve that can be assigned parameters.

● Time functions, switching hysteresis, synchronous mode that can be assigned parameters

● Sensitivity and distance values can be specified (IntelliTeach using the "IQ-SENSE Opto" 
FB)

● Teach-in

● Sensors can be removed and inserted during operation (automatic reassignment of 
parameters)

Anti-interference group
Only for optical IQ Sense devices (IQ profile ID 1). 

For IQ Sense devices with IQ profile ID 128 (ultrasound), see "Multiplex/synchronous mode" 
under the channel-specific parameters.

Prevention of interference (e.g., scattered light) by assigning an anti-interference group. This 
means:
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● Anti-interference group: None (= default)
Optical sensors on one or more modules can mutually influence each other when 
unfavorably arranged.

● Anti-interference group: 3 or 4
Optical sensors on the same module with anti-interference group 3 or 4 cannot mutually 
influence each other. Similarly, optical sensors on different modules with anti-interference 
group 3 or 4 cannot mutually influence each other. You need not maintain minimum 
clearance between the IQ Sense devices and can, for example, align two retroreflective 
sensors on a single reflector.

Operating principle
The diagram below explains the functioning of the anti-interference group parameter:

Mutual interference is only possible between the optical sensors of the modules in slot 5, 6, 7 
and 9 because they are in the same anti-interference group 3 or "None" is set. 

 

 Note

Sensors in the same anti-interference group must be installed to maintain the minimum 
clearance (see sensor package insert) and to prevent mutual interference.

 

Encoder type
This parameter is used to set the sensor type per channel:

● Reflex sensor or

● Diffuse sensor or

● Disabled
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Diffuse sensor

Table 8-79 Diffuse sensor

Diffuse sensor Object  
Transmitter
Receiver

Circuit state 0: No object detected, which 
means the object is not in the beam. The 
receiver does not see any light.

Transmitter
Receiver

Circuit state 1: Object detected, which 
means the object is in the beam. The 
receiver does not see any light.

Reflex sensor

Table 8-80 Reflex sensor

Reflex sensor Object  
Transmitter
Receiver

Circuit state 0: No object detected, which 
means the object is not in the beam. The 
receiver sees light.

Transmitter
Receiver

Circuit state 1: Object detected, which 
means the object is in the beam. The 
receiver does not see any light.

Switching hysteresis
Faults with the diffuse sensor or in the production process can result in signal wobbles. The 
measured value then changes the switching threshold by 100 % (object detected - object not 
detected). You can prevent this switching threshold wobble using the switching hysteresis 
parameter. This will ensure a stable output signal on the sensor.

You can assigned parameters to 5 %/10 %/20 %/50 % for switching hysteresis.

Requirements
You can only set the switching hysteresis parameter for diffuse sensors with background 
fadeout.
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Operating principle

Figure 8-7 Switching hysteresis parameter

Time function,time value
These parameters can be used to set the electronic module for its specific application.
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Operating principle

Figure 8-8 Time functions, time values parameters

Multiplex/synchronous mode
For the prevention of mutual influence between IQ Sense ultrasound devices in spatial 
proximity (devices with IQ profile ID 128), use the "Multiplex/synchronous operation" 
parameter. 

Settings for the multiplex/synchronous mode parameter   
Disabled: Mutual influence between IQ Sense ultrasound sensors in spatial proximity is 
possible (default). The cycle time is determined by the IQ Sense ultrasound sensor.

Multiplex: The IQ Sense ultrasound sensors determine the process value (distance) one after 
another, preventing them from affecting one another. The cycle time here is the sum of the 
configured synchronous cycle times of the IQ Sense ultrasound sensors that are to be 
multiplexed.

Synchronization: The IQ Sense ultrasound sensors determine the process value (distance) at 
exactly the same time, preventing them from affecting one another. The cycle time here 
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corresponds to the greatest configured synchronous cycle time from among the IQ Sense 
ultrasound sensors that are to be synchronized.

You can, for example, use synchronous operation for a curtain function in which several IQ 
Sense ultrasound sensors aligned in parallel share a single extended detection area. The 
sensors simultaneously emit an ultrasound impulse. When an object enters the detection area, 
the sensor nearest to the object receives the echo most quickly. The object can therefore not 
only be detected, it can be located as well.

AFI value
Using the AFI value (application series identifier, as defined in the ISO 15693-3 international 
standard), transponders can be selected for different applications. Only transponders whose 
AFI value coincides with the value set on the sensor are processed. If a transponder has the 
AFI value "0", it can be identified and processed regardless of the AFI value of the sensor.

This parameter is only important if it is supported by the ident system, otherwise any value 
(normally "0") may be assigned.

Transponder type
Depending on the type of the transponder, you must configure whether it is an ISO transponder 
or a vendor-specific type.

For transponders in accordance with international standard ISO 15693, the value "1" should 
be selected; for all other types "0" is set. Based on this setting, one of the two possible air 
interface drivers is selected in the sensor. 

This parameter is only important if it is supported by the ID system, otherwise any value 
(normally "0") may be assigned.

ET 200S

Configuring an ET 200S

Introduction
For the ET 200S series, you can find a wide range of modules in the hardware catalog under 
"Distributed I/O". 

Assigning parameters
For information on configuration and parameter assignment, refer to "See also".
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Frequency converters

Use of the frequency converter

Frequency converters
The frequency converter ICU24 and ICU24F ( as fail-safe version) are modular design 
frequency converters that are completely embedded in the distributed I/O system ET 200S. 
For parameterization of both modules, please see the following.

Message frame
The message frame number and the operating mode of the module are only displayed and 
cannot be modified.

Application ID
You indicate the saved parameters in the frequency converter as a whole with the application 
ID. Enter an application ID from the value range 0 to 65535. During startup (or pull/plug), this 
ID is compared with the application ID stored on the converter.

Converters that work with identical applications are usually also identically parameterized and 
should be identified with the same application ID. Converters with the same application ID may 
be exchanged between each other. Copying of the complete parameterization of a converter 
to another converter, for example, via an MMC, is only accepted, if both have the same 
application ID.

Converters that work with different applications and are parameterized differently must be 
identified by different application IDs. This prevents a converter with unsuitable 
parameterization from starting on an incorrect slot, i.e. on the wrong application. This also 
prevents the parameterization that is saved in the converter from being accidently overwritten 
with any parameteriation that is stored on an MMC.

Enable diagnostic interrupt
You can enable the diagnostic interrupt for the frequency converter. If diagnostic interrupt is 
enabled, an OB 82 must be available in a CPU to process the diagnostic events.

See also
Documentation for the frequency converter (http://support.automation.siemens.com/WW/view/
en/26291825/0/en)
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ET 200pro

Use of the frequency converter

Frequency converters
The frequency converters ET 200pro FC and ET 200pro F-FC (as fail-safe version) are 
modularly design frequency converters that are completely embedded in the distributed I/O 
system ET 200pro. The following section describes how to configure the two modules.

Message frame
The message frame number and the operating mode of the module are only displayed and 
cannot be modified.

Application ID
You indicate the saved parameters in the frequency converter as a whole with the application 
ID. Enter an application ID from the value range 0 to 65535. During startup (or pull/plug), this 
ID is compared with the application ID stored on the converter.

Converters that work with identical applications are usually also identically configured and 
should be identified with the same application ID. Converters with the same application ID may 
be exchanged between each other. Copying of the complete configuration of a converter to 
another converter, for example, via an MMC, is only applied, if both have the same application 
ID.

Converters that work with different applications and are configured differently must be identified 
by different application IDs. This prevents a converter with unsuitable configuration from 
starting on an incorrect slot, in other words on the wrong application. This also prevents the 
configuration that is saved in the converter from being accidently overwritten with any 
configuration that is stored on an MMC.

Enable diagnostic interrupt
You can enable the diagnostic interrupt for the frequency converter. If diagnostic interrupt is 
enabled, an OB 82 must be available in a CPU to process the diagnostic events.

8.1.6.4 IPv6 configuration

IPv6 protocol
The Internet Protocol version 6 - called IPv6 below - extends the Internet Protocol version 4 
(IPv4) that is used predominantly at the current time.
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Address format IPv6: Notation
IPv6 addresses consist of 8 fields each with four-character hexadecimal numbers (128 bits in 
total). The fields are separated by a colon.

Example:

fd00:ffff:ffff:ffff:ffff:ffff:2f33:8f21

Rules / simplifications:

● Leading zeros within a field can be omitted.
Example: fd01:0:ffff::2d12:7d23

● If one or more fields have the value 0, a shortened notation is possible. 
The address fd00:0:0:0:0:0:0:0:8f21 can also be shortened and written as follows:
fd00::8f21
To ensure uniqueness, this shortened form can only be used once within the entire address.

● Decimal notation with periods
The last 2 fields or 4 bytes can be written in the normal decimal notation with periods.
Example: The IPv6 address fd00::ffff.125.1.0.1 is equivalent to fd00::ffff:7d01:1

Entry and appearance
The entry of IPv6 addresses is possible in the notations described above. IPv6 addresses are 
always shown in the same notation in which they were entered.

See also
IPv6 with the CP 1543-1 (Page 1200)

IPv6 with the CP 1543-1

Use of IPv6 with the CP 1543-1
The CP supports the Internet Protocol version 4 (IPv4) for all IP services

The additional specification of addresses in IPv6 format can be used with the CP for the 
following services and applications:

● FETCH/WRITE
Direct write/read access by PC stations, SIMATIC S5 or third-party devices

● FTP client
FTP access from the S7-1500 CPU to an FTP server with the program block FTP_CMD

● FTP server
FTP access from an FTP client to data areas of the S7-1500 CPU

● SNMP
Data query using MIB objects according to SNMP

● E-mail
Data transfer from the S7-1500 CPU using the program block T_Mail
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8.2 Device and network diagnostics

8.2.1 Hardware diagnostics

8.2.1.1 Overview of hardware diagnostics

Principal methods of hardware diagnostics

Principal methods of hardware diagnostics  
Hardware diagnostics can be performed as follows:

● Using the Online and Diagnostics view

● Using the "Online Tools" task card

● Using the "Diagnostics > Device Info" area of the Inspector window

● Using diagnostics icons, for example, in the device view and the project tree

Structure of the Online and Diagnostics view  
The Online and Diagnostics view consists of two windows alongside each other:

● The left window shows a tree structure with folders and - when you open the folder - groups.

● The right window contains detailed information on the selected folder or selected group.

The "Online access" group and the "Diagnostics" and "Functions" folders are located here:

● "Online access" group: Displays whether or not there is currently an online connection with 
the associated target. In addition, you can establish or disconnect the online connection.

● "Diagnostics": Contains several diagnostics groups for the selected module.

● "Functions": Contains several groups, in which you can make settings for the selected 
module or issue commands to the module.

Function and structure of the "Online Tools" task card  
For modules with their own operating mode (such as CPUs), the "Online tools" task card allows 
you to read current diagnostics information and commands to the module.

If you selected a module without its own operating mode or if you selected several modules 
before activation of the "Online Tools" task card, the task card relates to the relevant CPU.

The "Online Tools" task card consists of the following panes:
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● CPU control panel

● Cycle time

● Memory
 

  Note

A pane is filled with content only if the module controls the associated functions and an 
online connection exists.

If there is no online connection to the respective module, the display "No online 
connection" appears in blue. If an existing online connection was disconnected, then "This 
target is not available" will be displayed.

 

Structure or the "Diagnostics" tab of the Inspector window  
The "Diagnostics" tab of the Inspector window itself consists of several tabs: Of these tabs, 
the following is relevant for the hardware diagnostics.

● Device information
This tab relates to all CPUs of the project to which the online connection is established. 
Alarms are reported here if one or more CPUs are defective or are not in RUN mode.

See also
Basics on task cards (Page 321)

Inspector window (Page 319)

Determination of which of the devices that are connected online are defective

Overview of the defective devices 
In the "Diagnostics > Device Info" area of the Inspector window you will obtain an overview of 
the defective devices that are or were connected online. 

The "Diagnostics> Device Info" area of the Inspector window consists of the following elements:

● Header line with the number of defective devices

● Table with detailed information on each defective device

If you originate the establishment of an online connection to a device which is not reachable 
or reports one or more faults or is not in RUN mode, it will rank as defective.

Structure of the table with detailed information on the defective devices
The table consists of the following columns:

● Online status: Contains the online status as a diagnostic symbol and in words

● Operating mode: Contains the operating mode as a symbol and in words

● Device / module: Name of the affected device or the affected module
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● Message: explains the entry of the previous column

● Details: The link opens the online and diagnostics view for the device, and places it in the 
foreground. If an online connection does not exist any longer, the link will open the 
connection establishment dialog.

● Help: The link supplies further information on the defect that has occurred.

See also
Displaying diagnostics status and comparison status using icons (Page 1203)

Displaying diagnostics status and comparison status using icons

Determining diagnostics status online and displaying using icons   
When the online connection to a device is established, the diagnostics status of the device 
and, if applicable, its lower-level components is determined. The operating state of the device 
is also determined, where applicable.

The following is a description of which icons are displayed in specific views.
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● Device view

– The associated diagnostic icon is displayed for every hardware component (except the 
signal board on the CPU).

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostic icon appears as follows: The 
hardware component's diagnostic icon has a pale appearance and the diagnostic icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– For hardware components with their own operating state, the operating state icon is also 
displayed to the left of or above the diagnostic icon.

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: No diagnostic icons are displayed (due to the configuration as GSDML device).

● Device overview

– The associated diagnostic icon is displayed for every hardware component.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostic icon appears as follows: The 
hardware component's diagnostic icon has a pale appearance and the diagnostic icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: For modules assigned to the CPU, the associated diagnostic icon is displayed 
(modules that are not assigned do not receive a diagnostic icon). The associated 
diagnostic icon is displayed for plug-in submodules of an assigned module (submodules 
that are not pluggable are not visible and therefore do not receive a diagnostic icon).

● Network view

– The associated diagnostic icon is displayed for every device.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostic icon appears as follows: The 
hardware component's diagnostic icon has a pale appearance and the diagnostic icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: A diagnostic icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.
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● Network overview

– The associated diagnostic icon is displayed for every hardware component.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostic icon appears as follows: The 
hardware component's diagnostic icon has a pale appearance and the diagnostic icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: A diagnostic icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.

● Topology view

– The associated diagnostic icon is displayed for every device.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostic icon appears as follows: The 
hardware component's diagnostic icon has a pale appearance and the diagnostic icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The associated diagnostic icon is displayed for every port. The meaning of the individual 
colors is described further below.

– Each cable between two online ports is assigned the color associated with its diagnostics 
status. 
The color of the cable between two ports depends on the status of the individual ports:
 

Color of the first port Color of the second port Color of the connecting cable
green green green
green gray gray
green red red
gray red red

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: A diagnostic icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.

● Topological overview

– The associated diagnostic icon is displayed for every hardware component.

– For a hardware component with lower-level components, if there is a hardware error in 
at least one lower-level component, the diagnostic icon appears as follows: The 
hardware component's diagnostic icon has a pale appearance and the diagnostic icon 
"Hardware error in lower-level component" is also shown in the lower right corner.

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: A diagnostic icon is displayed. It belongs to that part of the station that is assigned 
to the CPU.
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● Project tree

– The associated diagnostic icon is displayed behind every hardware component.

– For a hardware component with lower-level components (e.g., distributed I/O, Slave_1), 
if there is a hardware error in at least one lower-level component, the diagnostic icon 
appears as follows: The hardware component's diagnostic icon has a pale appearance 
and the diagnostic icon "Hardware error in lower-level component" is also shown in the 
lower right corner.

– For hardware components with their own operating state, the operating state icon is also 
displayed in the top right corner of the diagnostic icon.

– If forcing is active on a CPU, a red F is displayed at the left margin of the diagnostic icon.

– The diagnostic icon "Hardware error in lower-level component" is displayed behind the 
"Local modules" folder when there is a hardware error in at least one of the associated 
modules.

– The diagnostic icon "Hardware error in lower-level component" is displayed behind the 
"Distributed I/O" folder when there is a hardware error in at least one of the associated 
modules.

– The diagnostic icon "Hardware error in lower-level component" is displayed behind the 
project folder when the "Hardware error in lower-level component" diagnostic icon is 
displayed behind at least one of the "Local modules" or "Distributed I/O" folders. 

– The following applies to modules or submodules of a shared device with an S7-1500 
CPU: The associated diagnostic icon is displayed for modules assigned to the CPU 
(modules that are not assigned are grayed out and do not receive a diagnostic icon). 
The associated diagnostic icon is displayed for plug-in submodules of an assigned 
module (submodules that are not pluggable are not visible and therefore do not receive 
a diagnostic icon).

 

 Note

If the diagnostic for a hardware component is "not reachable from the CPU", the diagnostic 
icon "Hardware error in lower-level component" is not additionally shown.

 

Diagnostic icons for modules and devices   
The following table shows the available icons and their respective meaning.

Icon Meaning
The connection with a CPU is currently being established.

The CPU is not reachable at the set address.

The configured CPU and the CPU actually present are of incompatible types.

On establishment of the online connection to a protected CPU, the password dialog 
was terminated without specification of the correct password.
No fault
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Icon Meaning
Maintenance required

Maintenance demanded

Error

The module or device is deactivated.

The module or the device cannot be reached from the CPU (valid for modules and 
devices below a CPU).
Diagnostics data are not available because the current online configuration data 
differ from the offline configuration data.
The configured module or device and the module or device actually present are 
incompatible (valid for modules or devices under a CPU).
The configured module does not support display of the diagnostics status (valid for 
modules under a CPU).
The connection is established, but the module status has not yet been determined 
or is unknown.
The configured module does not support display of the diagnostics status.

Hardware error in lower-level component: A hardware error is present in at least one 
lower-level hardware component. (occurs as a separate icon only in the project tree)

 

 Note

Some modules, for example, the FM 450-1, are only indicated as having a problem in the 
case of an error if you have enabled the diagnostic interrupt when assigning the module 
property parameters.

 

Icons for the comparison status   
The diagnostic icons can be combined at the bottom right with additional smaller icons that 
indicate the result of the online/offline comparison. The following table shows the available 
comparison icons and their meaning.

Icon Meaning
Hardware error in lower-level component: The online and offline versions differ (only 
in the project tree) in at least one lower-level hardware component.
Software error in lower-level component: The online and offline versions differ (only 
in the project tree) in at least one lower-level software component.
Online and offline versions of the object are different

Object only exists online

Object only exists offline

Online and offline versions of the object are the same
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 Note

If both a comparison icon and the "Error in lower-level component" diagnostic icon are to be 
displayed at the bottom right in the device view, the following rule applies: The diagnostic 
icon for the lower-level hardware component has a higher priority than the comparison icon. 
This means that a comparison icon is only displayed if the lower-level hardware components 
have no errors.

 

Display of software errors in the project tree
● The associated comparison icon is shown behind each block.

● Behind each folder, under which exclusively blocks are contained, the diagnostic icon 
"Software error in lower-level component" is displayed when there is a software error in at 
least one of the associated blocks.

● For a hardware component with lower-level software components, if there is no hardware 
error and there is an error in at least one lower-level software component, the diagnostic 
icon appears as follows: The hardware component's diagnostic icon has a pale appearance 
and the diagnostic icon "Software error in lower-level component" is also shown in the lower 
right corner.

Combined diagnostics and comparison icons
The following table shows examples of icons that are displayed in the diagnostics icon.     

Icon Meaning
Folder contains objects whose online and offline versions differ (only in the project 
tree)
Object only exists online

Operating state icons for CPUs and CPs   
The following table shows the available icons and their respective operating states.

Icon Operating state
RUN

STOP

STARTUP

HOLD

DEFECTIVE
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Icon Operating state
Unknown operating state

The configured module does not support display of the operating state.

 

 Note

If forcing is active on a CPU, a red F is displayed on a pink background at the bottom right 
of the operating state icon.

 

Color marking of ports and Ethernet cables     
The following table shows the available colors and their respective meaning.

Color Meaning
No fault or maintenance required

Maintenance demanded

Communication error or topological error

no diagnostic capability

Start online and diagnostics view

Overview of possible ways of starting the Online and Diagnostics view
You can start the Online and Diagnostics view of a module to be diagnosed at the following 
locations:

● Overview

● Project tree

● Device view

● Device overview

● Network view

● Network overview

● Topology view

In the following, examples are used to show how to proceed. 
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Requirement
The project with the module to be diagnosed is open.  

 

 Note

This requirement does not apply if you call the online and diagnostics view from the project 
tree after you have identified the accessible devices.

 

Procedure
To start the online and diagnostics view of a module, follow these steps:  

1. In the project tree, open the respective device folder.

2. Double click on "Online & Diagnostics".

Or:

1. In the project tree, select the respective device folder.

2. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. In the project tree, open the "Online access" folder.

2. Open the folder for the interface with which you want to establish the online connection.

3. Double click on "Show/Update accessible devices".

4. Select the module to be diagnosed.

5. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. In the project tree, open the "Local modules" folder.

2. Select the respective device or the module that is to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the main menu.

Or:

1. Open the device view in the device configuration.

2. Select the module to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

1. Open the device view in the device configuration.

2. Establish an online connection to the module to be diagnosed.

3. Double-click on the diagnostics icon above the module.

Or:
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1. Open the network view in the device configuration.

2. Select the station with the module to be diagnosed.

3. Select the "Online & Diagnostics" command in the shortcut menu or the "Online" main menu.

Or:

Result
The online and diagnostics view of the module to be diagnosed will be started. If an online 
connection to the associated CPU had previously been created, the header bar of the Online 
and Diagnostics view will now have an orange background.

 

 Note

If no online connection exists when the online and diagnostics view is started, no online 
information is displayed and the display fields remain empty.

 

Activation of the "Online Tools" task card

Activation of the "Online Tools" task card    
You can activate this task card as follows:

1. Start the online and diagnostics view.

2. Click on the "Online Tools" task card.

Or:

1. Start the device view.

2. Click on the "Online Tools" task card.

Or:

1. Start the network view.

2. Click on the "Online Tools" task card.

8.2.1.2 Showing non-editable and current values of configurable module properties

Showing general properties and system-relevant information for a module

Where do I find the information I need?
The general properties and system-relevant information for a module can be found in the 
"General" group in the "Diagnostics" folder in the online and diagnostics view of the module 
to be diagnosed.   
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Structure of the "General" group
The "General" group consists of the following areas:

● Module

● Module information

● Vendor information

"Module" area
This area shows the following data of the module:

● Short designation, for example, CPU 1214C DC/DC/DC

● Order no.

● Hardware

● Firmware

● Racks

● Slot

"Module information" area
This area shows the following data of the module that you configured during hardware 
configuration:

● Module name

● Installation date (not displayed for all modules)

● Additional information (not displayed for all modules)

"Manufacturer information" area
This area shows the following data of the module:

● Manufacturer

● Serial number

● Profile: Profile ID as hexadecimal number
 

  Note

You will find the corresponding profile name in the profile ID table for PROFIBUS 
International (see "www.profibus.com").

 

● Profile details: Profile-specific type as hexadecimal number
 

  Note

You will find the corresponding profile-specific type name in the profile-specific type table 
for PROFIBUS International (see "www.profibus.com").
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Display configured cycle times

Where do I find the information I need?  
The required information can be found in the following places:

● In the "Cycle time" group of the "Diagnostics" folder in the Online and Diagnostics view of 
the module to be diagnosed.

● In the "Cycle time" pane of the "Online Tools" task card

Structure of the "Cycle time" group in the "Diagnostics" folder of the Online and Diagnostics view
The "Cycle time" group consists of the following areas:

● Cycle time diagram (graphical display of the assigned and measured cycle times)

● Cycle time configured (display of the assigned cycle times as absolute values)

● Cycle times measured (display of the measured cycle times as absolute values)

Structure of the "Cycle time" pane of the "Online Tools" task card
The "Cycle time" pane displays the cycle time diagram and below it the measured cycle times 
as absolute values.

Assigned cycle times
The following assigned cycle times are displayed in the cycle time diagram and in the "Cycle 
time configured" area.

● Minimum cycle time

● Maximum cycle time

In the cycle time diagram, the minimum cycle time and the maximum cycle time correspond 
to the two markings on the time axis.

In the "Cycle time configured" area, the assigned cycle times are displayed as absolute values.
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Show interfaces and interface properties of a module

Where do I find the information I need?
The interfaces and interface properties of a module can be found in the "Diagnostics" folder 
in the online and diagnostics view of the module to be diagnosed in the following group:     

● PROFINET interface

"PROFINET interface" group   
This group is divided into the following areas:

● "Ethernet address" with the "Network connection" and "IP Parameters" subareas

● "Ports"

"Network connection" subarea of the "Ethernet address" area
This subarea shows the following data for the module:

● MAC Address:
MAC address of the interface.
The MAC address consists of two parts. The first part ("Basic MAC address") identifies the 
manufacturer (Siemens, 3COM, ...). The second part of the MAC address differentiates 
between the various Ethernet devices. Each Ethernet module is assigned a unique MAC 
address.

"IP Parameters" subarea of the "Ethernet address" area   
This subarea shows the following data for the module:

● IP address:
Internet protocol address of the device on the bus (TCP/IP)

● Subnet mask:
The subnet mask shows which part of the IP address determines the membership of a 
particular sub-network.

● Default router:
If the subnet is connected via a router to other subnets, the IP address of the default router 
must be known. This is the only way a datagram can be forwarded with a non-matching 
subnet address.

● IP settings:
Identifier for the path by which the device has obtained its IP settings (IP address, subnet 
mask, default router).

Identifier Meaning
0 IP address is not initialized
1 By configuration (i.e., by the configuration loaded to the device from the device or 

network view)
2 Via the "Assign IP address" group of the online and diagnostics view
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Identifier Meaning
3 Via the DHCP server (i.e., the IP parameters are obtained by a special service from a 

DHCP server (Dynamic Host Configuration Protocol) and assigned for a limited time)
4 IP address is set by a user program
5 Source of IP address unknown

 

● IP setting time:
Time stamp of the last change to the IP address directly through the Ethernet connection 
of the module

"Ports" area
This area shows the following data for the module:

● Ethernet ports
Physical properties of the PROFINET interface

Properties of the 
PROFINET interface

Meaning

Port no. Port number The short description of interface (X + interface no.) and port 
(P + port no.) is specified in parentheses. An "R" in the short description of 
a port means that it is a ring port.

Status Displays the status of the port LINK LED.
● Status "OK" means another device (such as a switch) is connected to 

the port and the physical connection is available.
● Status "disconnected" means no other device is connected to the port.
● Status "deactivated" means that access to the port is blocked.

Settings ● "Automatic" for automatic network settings of the device
● Network settings for speed and transmission method for manual 

network settings of the device
Operating mode Network settings for speed and transmission method

If you select a line in the port table, additional help information will be provided for the 
corresponding port.
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Displaying IO controllers that access modules of a Shared Device

Where do I find the information I need?
The display of those IO controllers that access the modules of a Shared Device can be found 
in the Online and Diagnostics view of the interface module of the Shared Device in the 
"Diagnostics" folder in the following area of the "PROFINET interface" group:

● IO controller 

 Displaying sync domain properties of a PROFINET device

Where do I find the information I need?
The sync domain properties of a PROFINET device can be found in the following area of the 
"PROFINET interface" group in the "Diagnostics" folder of the Online and Diagnostics view of 
the device to be diagnosed:

● Domain 

"Domain" area
This area is divided into the following subareas:

● Sync domain

● MRP domain

What is a sync domain?
A sync domain is a group of PROFINET devices that are synchronized to a common clock. 
Exactly one device has the role of the sync master (clock generator); all other devices assume 
the role of a sync slave. The sync master is usually an IO controller or a switch.

Non-synchronized PROFINET devices are not part of a sync domain.

"Sync domain" subarea of the "Domain" area   
This subarea shows the following properties of the sync domain:

● Name:
Name of sync domain

● Role:
Role of the PROFINET device in the sync domain. The following roles are possible:

– Sync master

– Sync slave

● Synchronization interval:
Interval at which the synchronization is performed
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● Send clock
Smallest possible send interval for the data exchange

● Jitter accuracy of the send clock

● Reserved bandwidth for cyclic communication
 

Displaying MRP domain properties of a PROFINET device

Where do I find the information I need?
The MRP domain properties of a PROFINET device can be found in the following area of the 
"PROFINET interface" group in the "Diagnostics" folder of the Online and Diagnostics view of 
the device to be diagnosed:

● Domain 

"Domain" area
This area is divided into the following subareas:

● Sync domain

● MRP domain

What is an MRP domain?
The Media Redundancy Protocol (MRP) enables redundant networks to be structured. 
Redundant transmission paths (ring topology) ensure that, if one transmission path fails, an 
alternative communication path is available. The PROFINET devices that are part of this 
redundant network form an MRP domain.

"MRP domain" subarea of the "Domain" area   
This subarea shows the following properties of the MRP domain:

● Name:
Name of MRP domain

● Role:
Role of the PROFINET device in the MRP domain. The following roles are possible:

– Manager

– Manager (Auto)

– Client

– Not a device of the ring

● Ring port 1:
The port of the PROFINET device that has the "Ring port 1" property
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● Ring port 2:
The port of the PROFINET device that has the "Ring port 2" property

● Status of the MRP ring:
Indicates whether the ring is interrupted ("open" status) or not ("closed" status).

Displaying current firmware of a module

Displaying firmware
You can display the currently installed firmware of a module.

Requirements
● The module supports a firmware update.

● The module is connected online.

Procedure
To display the current firmware, follow these steps:

1. Open the module in the Online and Diagnostics view.

2. Select the "Firmware update" group in the "Functions" folder.

3. You read off the current firmware in the "Online data" area under "Firmware".

 

8.2.1.3 Showing the current values of dynamic modules properties

Display measured cycle times

Where do I find the information I need?
The measured cycle times can be found at each of the following places:  

● In the "Cycle time" group of the "Diagnostics" folder in the Online and Diagnostics view of 
the module to be diagnosed.

● In the "Cycle time" pane of the "Online Tools" task card

Structure of the "Cycle time" group in the "Diagnostics" folder of the Online and Diagnostics view
The "Cycle time" group consists of the following areas:

● Cycle time diagram (graphical display of the assigned and measured cycle times)

● Cycle time configured (display of the assigned cycle times as absolute values)

● Cycle times measured (display of the measured cycle times as absolute values)
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Structure of the "Cycle time" pane of the "Online Tools" task card
The "Cycle time" pane displays the cycle time diagram and below it the measured cycle times 
as absolute values.

Graphical display of the measured cycle times
The following measured cycle times are displayed in the cycle time diagram:

● Shortest cycle time: Duration of the shortest cycle since the last transition from STOP to 
RUN
This corresponds to the dashed gray arrow on the left in the diagram.

● Current / last cycle time: Duration of the last cycle
This corresponds to the green arrow in the diagram. If the current / last cycle time exceeds 
the maximum cycle time, the arrow will turn red.

 

  Note

If the duration of the last cycle comes close to the maximum cycle time, it may be possible 
that it will be exceeded. Depending on the CPU type, parameter assignment and your 
user program, the CPU can switch to STOP mode. If for instance you are monitoring the 
tags in your program, this will increase the cycle time.

If the cycle lasts longer than double the maximum cycle time, and you do not restart the 
maximum cycle time in the user program (by calling the extended RE_TRIGR) instruction, 
the CPU will switch to STOP mode.

 

● Longest cycle time: Duration of the longest cycle since the last transition from STOP to 
RUN.
This corresponds to the dashed blue arrow on the right in the diagram.

A blue band extends between the two dashed lines; this band corresponds to the entire range 
of the measured cycle times. If a measured cycle time is greater than the maximum cycle time, 
the portion of the band that lies outside the assigned limits will be colored red.

Display of the measured cycle times as absolute values
The following measured times are displayed in the "Cycle times measured" area and in the 
"Cycle time" pane.

● Shortest cycle time since the last transition from STOP to RUN.

● Current/last cycle time:

● Longest cycle time since the last transition from STOP to RUN.

Showing the current status of the LEDs of a CPU

Where do I find the information I need?
The current status of the LEDs of a CPU can be found in the display area of the "CPU control 
panel" pane of the "Online tools" task card.   

Editing devices and networks
8.2 Device and network diagnostics

WinCC Professional V13.0
System Manual, 02/2014 1219



Display area of the "CPU control panel" pane of the "Online Tools" task card   
This area contains the following displays:

● Station name and CPU type (short designation)

● RUN / STOP (corresponds to the "RUN / STOP" LED of the CPU)

● ERROR (corresponds to the "ERROR" LED on the CPU)

● MAINT (corresponds to the "MAINT" LED on the CPU)

 

Showing fill levels of all types of memory on a CPU

Where do I find the information I need?     
The fill levels of all types of memory on a CPU can be found on the following two pages:

● In the display area of the "Memory" group in the "Diagnostics" folder in the online and 
diagnostics view of the module to be diagnosed

● In the display area of the "Memory" pane on the "Online Tools" task card

Display area of the "Memory" group in the "Diagnostics" folder of the online and diagnostics view
This area contains the current memory utilization of the associated module and details of the 
individual memory areas.

The memory utilization is shown both as a bar diagram and as a numerical value (percentage).

The following memory utilizations are shown:

● Load memory
If no memory card is inserted, the internal load memory is displayed.
If a memory card is inserted, the operating system only uses the inserted load memory as 
the load memory. This is displayed here.

● Work memory

● Retentive memory

Display area of the "Memory" pane of the "Online Tools" task card
This area contains the current memory utilization of the associated module. The available 
memory is shown both as a bar diagram and as a numerical value (percentage). The numerical 
value is rounded to an integer value.

 

 Note

If less than 1% of a memory area is utilized, the available portion of this memory area is 
shown as "99%".

 

The following memory utilizations are shown:
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● Load memory
If no memory card is inserted, the internal load memory is displayed.
If a memory card is inserted, the operating system only uses the inserted load memory as 
the load memory. This is displayed here.

● Work memory

● Retentive memory

See also
Load memory (Page 1073)

Work memory (Page 1073)

Retentive memory areas (Page 1075)

Displaying fill level of all types of memory of an S7-1500 CPU

Where do I find the information I need?     
The fill levels of all types of memory of an S7-1500 CPU can be found at the following two 
places:

● In the display area of the "Memory" group in the "Diagnostics" folder in the online and 
diagnostics view of the module to be diagnosed

● In the display area of the "Memory" pane on the "Online Tools" task card

Display area of the "Memory" group in the "Diagnostics" folder of the online and diagnostics view
This area contains the current memory utilization of the associated module and details of the 
individual memory areas.

The memory utilization is shown both as a bar diagram and as a numerical value (percentage).

The following memory utilizations are shown:

● Load memory
 

  Note

The load memory is located on the SIMATIC memory card.
 

● Code work memory: work memory for program code

● Data work memory: work memory for data blocks

● Retentive memory
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Display area of the "Memory" pane of the "Online Tools" task card
This area contains the current memory utilization of the associated module. The available 
memory is shown both as a bar diagram and as a numerical value (percentage). The numerical 
value is rounded to an integer value.

 

 Note

If less than 1% of a memory area is utilized, the available portion of this memory area is 
shown as "99%".

 

The following memory utilizations are shown:

● Load memory
 

  Note

The load memory is located on the SIMATIC memory card.
 

● Code work memory: work memory for program code

● Data work memory: work memory for data blocks

● Retentive memory

8.2.1.4 Checking a module for defects

Determining the diagnostic status of a module

Where is the diagnostics status of a module displayed?     
The diagnostic status of a module is displayed in the "Diagnostic status" group in the 
"Diagnostics" folder in the online and diagnostics view of the module to be diagnosed.

The "Diagnostics status" group consists of the following areas:

● Status

● Standard diagnostics (for S7-300 and S7-400 only for non-CPU modules)
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"Status" area
The following status information is displayed in this area:

● Status of the module as viewed by the CPU, for example:

– Module available and OK.

– Module defective.
If the module experiences a fault and you have enabled the diagnostic error interrupt 
during configuration, the "Module defective" status is displayed.   

– Module configured, but not available.
Example: Diagnostics data is not available because the current online configuration 
differs from the offline configuration.

● Detected differences between the configured and the inserted module. Provided it can be 
ascertained, the order number will be displayed for the set and actual type.

The scope of the displayed information depends on the selected module.

"Standard diagnostics" area
The following diagnostics information for non-CPU modules is displayed in this area:

● Internal and external faults that relate to the overall module

● Associated diagnostics events

Examples of such diagnostics information are:

● Entire backup failed

● Module defective
 

  Note
Diagnostic interrupts

A diagnostic interrupt can be reported to the CPU only if the module has diagnostic 
interrupt capability and the diagnostic interrupt has been enabled.

The display of the diagnostic interrupt is a snapshot. Sporadic module defects can be 
identified in the diagnostics buffer of the respective CPU.

 

 

Reading out the diagnostics buffer of a CPU

Where do you read out the diagnostics buffer of a CPU?     
You read out the diagnostics buffer of a CPU in the "Diagnostics buffer" group in the 
"Diagnostics" folder in the Online and Diagnostics view.
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Structure of the "Diagnostics buffer" group
The "Diagnostics buffer" group consists of the following areas:

● "Events"

● "Settings"

Diagnostics buffer
The diagnostics buffer is used as a log file for the diagnostics events that occurred on the CPU 
and the modules assigned to it. These are entered in the order of their occurrence, with the 
latest event shown at the top.

"Events" area
The "Events" area consists of the following elements:

● Check box "CPU time stamp takes into account local PG/PC time"

● Event table

● "Freeze display" or "Cancel freeze" button

● Details of the event: Event no., event ID, description, time stamp, incoming/outgoing 
information

● "Help on event", "Open in editor", "Save as ..." buttons

Check box "CPU time stamp takes into account local PG/PC time"
If you have not activated the check box, the diagnostics buffer entries are shown with the 
module time.

If you have activated the check box, the diagnostics buffer entries are shown with the time 
given by the following formula:

Displayed time = module time + time zone offset on your programming device / PC

This requires the module time to be identical to UTC.

You should use this setting if you wish to see the times of the diagnostics buffer entries for the 
module expressed in the local time of your programming device / PC.

Selecting or clearing the check box immediately changes the times displayed for the 
diagnostics buffer entries.

 

 Note

If you use the "WR_SYS_T" instruction in your program or if you set the real-time clock of the 
CPU using an HMI device instead of using UTC, we recommend that you clear the "CPU time 
stamp takes into account local PG/PC time" check box. In this case, the module time is the 
sole time of concern.
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Event table
The following information is displayed in the table for each diagnostics event:

● Sequential number of the entry
The first entry contains the latest event.

● Date and time of the diagnostics event
If no date and time are shown, the module has no integral clock.

● Short name of the event and, if applicable, the reaction of the CPU
 

  Note

If an individual parameter of a text cannot be determined, the character string "###" is 
shown in its place.

If no display text is yet available for new modules or new events, the numbers of the events 
and the individual parameters are stated as hexadecimal values.

 

● Icon for information related to incoming/outgoing status
The following table shows the available icons and their respective meaning.

Icon Meaning
Incoming event

Outgoing event

Incoming event to which there is no independent outgoing event

User-defined diagnostics event

● Only for S7-1200 and S7-1500 CPUs: Icon for the severity of the event
The following table shows the available icons and their respective meaning.

Icon Meaning
No maintenance and/or no fault

Maintenance required

Maintenance demanded

Error

You can change the order of the columns, adjust the column widths and remove and add 
individual columns in the event table. In addition, you can sort as follows: by sequential number, 
by "Date and time" and by "Event".

"Freeze display" or "Cancel freeze" button
The "Freeze display" or "Cancel freeze" button is only enabled when there is an online 
connection to the CPU.

The default setting is "Freeze display".

The following happens when you click the "Freeze display" button:
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● The current display of the diagnostics buffer entries is frozen.

● The labeling of the button changes to "Cancel freeze".

If an error has occurred in your system, diagnostics events can occur very quickly in 
succession. This produces a high update rate on the display. Freezing the display allows you 
to calmly examine the situation in more detail.

If the display is frozen and you click the "Cancel freeze" button, the following happens:

● The display of the diagnostics buffer entries is updated again.

● The labeling of the button changes to "Freeze display".
 

 Note

If you freeze the diagnostics buffer display, the CPU continues to enter events in the 
diagnostics buffer.

 

Details of the event
If you select a line in the list of events, you obtain detailed information on the respective event:

● Sequential number of the event in the diagnostics buffer

● Event ID

● Description of the event with event-dependent additional information. Examples of this 
additional information:

– Command that caused the event

– Operating mode switch caused by the diagnostics event

● Time stamp

● Only for S7-1200 and S7-1500 CPUs: Associated I&M data (module, rack/slot, plant 
designation, location designation)

● Priority of the event

● Information on whether the event is an incoming or outgoing event

"Help on event" button
If you click on this button, the selected event is explained in more detail and any remedies 
given.

 

 Note

For a small number of events, the "Help on event" button is grayed out.
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"Open in editor" button
The following table shows if the "Open block" button is active and which function it conceals.

When is the "Open in editor" button enabled? What happens when you click this button?
If the diagnostics event references the relative address of a 
block.
This is the address of the command that caused the event.

The "Open in editor" function opens the referenced block in 
the offline view at the programming instruction that causes 
the error. This allows you to check and, if necessary, change 
the source code of the block at the specified place and then 
download it again to the CPU.

If the diagnostics event was triggered by a module. The "Open in editor" function opens the Device view of the 
module involved.

"Save as ..." button
If you click this button, the content of the diagnostics buffer is saved in a text file. "Diagnostics", 
depending on the language, with the extension ".txt" is suggested as the file name. You can 
however change this name.

"Settings" area
The "Settings" area consists of the following elements:

● "Display events" list

● "Apply settings as default" button

● "Output event information in hexadecimal format" check box

"Display events:" list
There is an check box in this list for every event class (default setting: all check boxes are 
selected). If you clear a check box, the events of that event class is no longer displayed in the 
"Events" area. Reselecting the check box displays the associated events once again.

"Apply settings as default" button
If you click this button, the settings are also applied to future occasions when the "Events" tab 
is opened.

"Output event information in hexadecimal format" check box
If you select the check box, the event IDs in the Events list of the "Events" area is displayed 
in hexadecimal format. If you clear the check box, the event information is given in text form.

 

See also
Basic information on the diagnostics buffer  (Page 1245)
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Saving service data

Purpose
In the event of servicing it may be possible that the SIEMENS Customer Support requires very 
special information about the state of a module of your system for diagnostic purposes.

If such a case occurs in your system, you will be asked by Customer Support to save the 
service data of the module and send the resulting file to them.

Where do you carry out the saving of service data of a module?
You carry out the saving of service data of a module in its online and diagnostics view at the 
following points: In the "Functions" folder in the "Save service data" group"

The "Save service data" group consists of the following areas:

● Online data

● Saving service data

"Online data" area
This area shows the following data for the module:

● Order number

● Firmware version

● Module name (you configured this while configuring the hardware.)

● Rack

● Slot

"Save service data" area
Proceed as follows to create and save a file with special service data:

1. Select the point in the file system at which you want to save the file:

– You use the path preset in the "Path" field.

– Click the three-dot (browse) button. In the dialog that opens specify the desired path 
and enter the file name.

2. Click the "Save data" button.
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8.2.1.5 Changing the properties of a module or the programming device/PC

Changing the mode of a CPU

Requirement  
There is an online connection to the CPU whose mode you want to change.

Procedure
To change the mode of the CPU, follow these steps:

1. Enable the "Online tools" task card of the CPU.

2. Click the "RUN" button in the "CPU control panel" pane if you want to change the CPU to 
RUN mode or the "STOP" button if you want to change the CPU to STOP mode.

 

  Note

The only button active is the one that can be selected in the current operating mode of 
the CPU.

 

3. Acknowledge the confirmation prompt with "OK".

Or:

1. Open the "Online" menu.

2. Choose the "Start CPU" menu command if you want to set the CPU to RUN mode and 
"Stop CPU" if you want to set the CPU to STOP mode.

 

  Note

The only button that is active is the one that can be chosen in the current operating mode 
of the CPU.

 

3. Acknowledge the confirmation prompt with "OK".

Or:

1. Click the "Start CPU" button in the toolbar if you want to set the CPU to RUN mode and the 
"Stop CPU" button if you want to set the CPU to STOP mode.

 

  Note

The only button that is active is the one that can be chosen in the current operating mode 
of the CPU.

 

2. Acknowledge the confirmation prompt with "OK".

 

Result
The CPU will be switched to the required operating mode.
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Performing a memory reset

Requirement   
● There is an online connection to the CPU on which the memory reset is to be performed.

● The CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the memory reset, you can place it in STOP 
mode after acknowledging a confirmation prompt.

 

Procedure
To perform a memory reset on a CPU, follow these steps:

1. Enable the "Online Tools" task card of the CPU.

2. Click the "MRES" button in the "CPU control panel" pane.

3. Acknowledge the confirmation prompt with "OK".

Result
The CPU is switched to STOP mode, if necessary, and the memory reset is performed on the 
CPU.

See also
Basics of a memory reset (Page 1071)

Determining and setting the time of day on a CPU

Where do I find the functions I need? 
You determine and change the time of day on a CPU in the "Set time of day" group in the 
"Functions" folder of the Online and Diagnostics view. This requires an online connection. 

Structure of the "Set time of day" group
The "Set time of day" group consists of the following areas:

● Area for reading out and setting the time of day

● Time system (This area does not exist for S7-1200 and will not be examined here.)

Editing devices and networks
8.2 Device and network diagnostics

WinCC Professional V13.0
1230 System Manual, 02/2014



Structure of the area for reading out and setting the time of day
This area consists of the following parts:

● Programming device / PC time
Here the time zone setting, the current date and the current time setting of your 
programming device / PC are displayed.

● Module time
Here the date and time values currently read from the module (for example the CPU), are 
converted to local time and date and displayed.
If the "Take from PG/PC" check box is selected, when you click the "Apply" button, the date 
and the PG/PC time converted to UTC are transferred to the module.
If the "Take from PG/PC" check box is not selected, you can assign the date and time for 
the integrated clock of the module. After clicking the "Apply" button, the date and the time 
recalculated to UTC time are transferred to the module.

Updating the firmware of a module

Performing a firmware update   
Using firmware files, you can update the firmware of a module.

Requirements
● The module is connected online.

● The module supports a firmware update.

● For those modules that require a supply voltage to perform the firmware update correctly: 
The supply voltage of the module is secured. For details, see the documentation of the 
module.

Procedure
To perform a firmware update, follow these steps:

1. Open the module in the Online and Diagnostics view.

2. Select the "Firmware update" group in the "Functions" folder.
 

  Note

For S7-1500-CPUs, this group is subdivided into "PLC" and "Display".
 

3. Click the "Browse" button in the "Firmware update" area in order to select the path to the 
firmware update files.

4. Select one of these files. The table then lists all modules for which an update is possible 
with the selected firmware file.
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5. Optional: Select the "Run firmware after update" check box to reset the module after the 
load operation and to start the new firmware.

6. Click the "Start update" button. If the selected file can be interpreted by the module, it is 
downloaded to the module. If the mode of the CPU needs to be changed, you will be 
prompted to do this in dialogs.

 

 WARNING

Invalid plant states possible

An S7-1500 CPU immediately goes to STOP mode when you start the firmware update, 
which can have an effect on the operation of an online process or a machine.
Unexpected operation of a process or a machine can result in severe or fatal injuries and/or 
damage to property.

 

 Note

After you have run a firmware update, you will need to replace the module involved with the 
same module with the current firmware version in the hardware configuration of your project. 
The engineering configuration then matches the actual physical configuration again.

 

"Run firmware after update" check box
If you have not selected the "Run firmware after update" check box, the previous firmware 
remains active until the module is reset (for example by cycling power). The new firmware only 
becomes active after the module has been reset.

If you have selected the check box, the module is automatically reset after the firmware has 
been downloaded and it then continues with the new firmware.

Activating the firmware following the update has the following consequences:

● A station executes a restart. This means that all modules in the station become unavailable.

● If the corresponding CPU is in RUN, activating the firmware can lead to access errors or 
other problems in the user program and might even mean that the CPU remains 
permanently in STOP.

 

  Note

For some CPUs, the "Run firmware after update" check box is grayed out and deactivated. 
In this case, you must restart the CPU manually.

For S7-1500 CPUs, the "Run firmware after update" check box is grayed out and selected. 
In this case, the new firmware is activated immediately after the download operation.

 

 

See also
Replacing a hardware component (Page 539)
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Resetting an S7-1200 CPU to factory settings

Requirement
● There is no memory card inserted in the CPU.

● There is an online connection to the CPU that you want to reset to the factory settings.

● The CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the reset operation, you can place it in STOP 
mode by answering the security prompt with yes.

 

Procedure 
To reset an S7-1200 CPU to factory settings, follow these steps:

1. Open the Online and Diagnostics view of the CPU.

2. Select the "Reset to factory settings" group in the "Functions" folder.

3. Select the "Keep IP address" check box if you want to keep the IP address or the "Delete 
IP address" check box if you want to delete the IP address.

 

  Note

The two check boxes mentioned are only available if the module to be reset is able to 
choose whether to retain or delete the IP address.

 

4. Click the "Reset" button.

5. Acknowledge the confirmation prompt with "OK".

Result
The module is switched to STOP mode if necessary and the settings are then reset to factory 
settings. This means:

● The work memory and the internal load memory and all operand areas are cleared.

● All parameters are reset to their defaults.

● The diagnostic buffer is cleared.

● The time is reset.

● The IP address is kept or deleted depending on which setting you made.
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Resetting an S7-1500 CPU to factory settings

Requirement
● If you start a reset to factory settings from the project context, an online connection to the 

relevant CPU must exist.

● The relevant CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start the reset operation, you can place it in STOP 
mode after acknowledging a confirmation prompt.

 

Procedure   
To reset an S7-1500 CPU to factory settings, follow these steps:

1. Open the Online and Diagnostics view of the CPU (either from the project context or via 
"Accessible devices").

2. Select the "Reset to factory settings" group in the "Functions" folder.

3. Select the "Keep IP address" check box if you want to keep the IP address or the "Delete 
IP address" check box if you want to delete the IP address.

 

  Note

With "Delete IP address", all IP addresses are deleted. This applies regardless of how 
you created the online connection.

If a memory card is inserted, selecting the "Delete IP address" option causes the following: 
The IP addresses are deleted and the CPU is reset to factory settings. Then, the 
configuration (including IP addresses) that is stored on the memory card is transferred 
into the CPU (see below). If the memory card was formatted before resetting to factory 
settings or if it is empty, no IP address is transferred into the CPU.

 

4. Click the "Reset" button.

5. Acknowledge the confirmation prompt with "OK".

Result
The module is switched to STOP mode if necessary and the settings are then reset to factory 
settings. This means:

● The work memory and the internal retentive system memory and all operand areas are 
cleared.

● All parameters are reset to their defaults.

● The diagnostic buffer is cleared.

● The time of day is reset.

● The I&M data are deleted except for I&M0 data.
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● The runtime meters are reset.

● The IP address is kept or deleted depending on which setting you made.

● If a memory card was inserted prior to the reset to factory settings, the configuration 
contained on the memory card (hardware and software) is downloaded to the CPU.

Formatting an S7-1500 memory card

Requirement
● If you start the formatting of the memory card from the project context, an online connection 

to the relevant CPU must exist.

● The relevant CPU is in STOP mode.
 

  Note

If the CPU is still in RUN mode and you start a formatting operation, you can place it in 
STOP mode after acknowledging a confirmation prompt.

 

Procedure  
To format an S7-1500 memory card, follow these steps:

1. Open the Online and Diagnostics view of the CPU (either from the project context or via 
"Accessible devices").

2. Select the "Format memory card" group in the "Functions" folder.

3. Click the "Format" button.

4. Answer the safety prompt with "Yes".

Result
● The memory card is formatted.

● The CPU is temporarily unavailable.

● The project data on the CPU are deleted with the exception of the IP address.

● If you start the formatting of the memory card from the project context, the Online and 
Diagnostics view remains open. If formatting is started via "Accessible devices", the Online 
and Diagnostics view will close.
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Assigning an IP address to a PROFINET IO device

Basic information on assigning an IP address to a PROFINET IO device

Overview 
All PROFINET IO devices work with the TCP/IP protocol and therefore require an IP address 
for operation on Industrial Ethernet. Once an IP address has been assigned to an IO device, 
it can be accessed via this address. You can then download configuration data or perform 
diagnostics, for example.

Requirement
● The Ethernet LAN connection must already be established.

● The Ethernet interface of your programming device or PC must be accessible.

● The IO device that is to be assigned an IP address must be in the same IP band as the 
programming device or PC.

Starting the address assignment via "Accessible devices"

Requirement
● You have opened the Online and Diagnostics view of the PROFINET IO device using 

"Update accessible devices" (in the project tree) or "Accessible devices..." ("Online" menu).

Procedure 
1. Open the "Functions" folder and the "Assign IP address" group inside this folder. The "MAC 

address" field displays the MAC address of the PROFINET IO device. The "Accessible 
devices" button is grayed out.

2. Enter the desired IP address.

3. Enter the subnet mask.

4. If a router is to be used, select the "Use router" check box and enter its IP address.

5. Click the "Assign IP address" button.
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Result
The IP address is permanently assigned to the IO device or to the relevant PROFINET interface 
of the IO device. It is retained even through a startup or a power failure.

 

 Note

For an S7-1500 CPU, you can also use the above-described method to change the IP address 
of a PROFINET interface, if a project has already been downloaded to the CPU via this 
interface. This overwrites the IP address downloaded via the project.

 

See also
Retentivity of IP address parameters and device names (Page 1031)

Starting the address assignment from the project context

Requirement
● An online connection to the PROFINET IO device exists.

● You have opened the Online and Diagnostics view of the PROFINET IO device from the 
project context.

● The PROFINET IO device is not assigned to any IO controller.

Procedure 
1. Open the "Functions" folder and the "Assign IP address" group inside this folder.

2. Click the "Accessible devices" button in order to identify the devices that can be accessed.
Note: For an S7-1500 CPU, there are two entries here because it has two PROFINET 
interfaces.

3. Select the IO device. The "IP address" field, "Subnet mask" field, "Use router" check box 
and "Router address" field are grayed out and contain the node properties you used to 
establish the current online access.

4. Click the "Assign IP address" button.

Result
The IP address is permanently assigned to the IO device or to the relevant PROFINET interface 
of the IO device. It is retained even through a startup or a power failure.

See also
Retentivity of IP address parameters and device names (Page 1031)
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Assigning a PROFINET device name

Basic information on assigning a name to a PROFINET IO device

Device name   
Before an IO device can be addressed by an IO controller, it must have a device name. This 
procedure was chosen for PROFINET because names are easier to handle than complex IP 
addresses.

Assigning a device name to a PROFINET IO device is comparable to setting the PROFIBUS 
address for a DP slave.

An IO device has no device name in its delivery state. For an IO controller to address an IO 
device, it must first be assigned a device name using the programming device or PC. It is now 
ready to transfer the configuration information including the IP address during startup or 
exchange user data in cyclic operation. 

Rules for the device name
The device name is subject to the following limitations:

● Restricted to a total of 240 characters (lower case letters, numbers, dash, or dot)

● A name component within the device name, which is a character string between two dots, 
must not exceed 63 characters.

● No special characters such as umlauts, brackets, underscore, slash, blank space, etc. The 
only special character permitted is the dash.

● The device name must not begin or end with the "-" character.

● The device name must not begin with a number.

● The device name form n.n.n.n (n = 0, ... 999) is not permitted.

● The device name must not begin with the string "port-xyz" or "port-xyz-abcde" (a, b, c, d, 
e, x, y, z = 0, ... 9).

Where do I find the function I am seeking?
You can assign the name of a PROFINET IO device at the following places:

● In the online and diagnostics view of the device in the "Assign name" group of the 
"Functions" folder. The user interface for this group differs depending on how you open the 
online and diagnostics view:

– Open via "Accessible devices"

– Open from the project context

● In the "Assign PROFINET device name" dialog
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See also
Assigning a name in the online and diagnostics view opened via "Accessible devices" 
(Page 1239)

Assigning a name in the online and diagnostics view opened from the project context 
(Page 1239)

Assigning a name in the "Assign PROFINET device name" dialog (Page 1240)

Assigning a name in the online and diagnostics view opened via "Accessible devices"

Requirement   
● You have opened the online and diagnostics view of the PROFINET IO device using 

"Update accessible devices" (in the project tree) or "Accessible devices..." ("Online" menu).

Procedure
1. Open the "Functions" folder and the "Assign name" group inside this folder. The "Type" 

field displays the module type of the PROFINET IO device.

2. Enter the required device name in the "PROFINET device name" input box.

3. Optional: Select the "Flash LED" check box in order to run an LED flash test on the 
PROFINET IO device. In this way, you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

The LED flash test runs until you cancel it. This is done, for example, by clearing the "Flash 
LED" check box or by closing the online and diagnostics view.

4. Click "Assign name".

Result
The entered name is assigned to the PROFINET IO device.

 

Assigning a name in the online and diagnostics view opened from the project context

Requirement   
● You have opened the online and diagnostics view of the PROFINET IO device from the 

project context.

● The PROFINET IO device can be accessed using at least one PG/PC interface.
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Procedure
1. Open the "Functions" folder and the "Assign name" group inside this folder. The 

"PROFINET device name" drop-down list displays the current name in the offline project, 
and the "Type" box shows the module type of the PROFINET IO device.

 

  Note

For CPUs with several PROFINET interfaces, the names of all existing PROFINET 
interfaces are displayed in the offline project.

 

2. Choose a different name from the drop-down list, if necessary.
 

  Note

In steps 3 to 5, you determine the IO devices that are present in the PROFINET subnet.
 

3. In the "PG/PC interface for assignment" drop-down list, select the PG/PC interface you 
want to use to establish the online connection.

4. Optional: Use the three check boxes to make a selection from all IO devices available online.

5. Click the icon for determining the IO devices present in the PROFINET subnet. The table 
is then updated.

6. Select the desired IO device in the table.

7. Optional: Select the "Flash LED" check box in order to run an LED flash test on the 
PROFINET IO device. In this way, you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

The LED flash test runs until you cancel it. This is done, for example, by clearing the "Flash 
LED" check box, by selecting another IO device in the table, or by closing the online and 
diagnostics view.

8. Click "Assign name".

Result
The selected name is assigned to the PROFINET IO device or one of its PROFINET interfaces.

Assigning a name in the "Assign PROFINET device name" dialog

Requirement   
● You have opened the "Assign PROFINET device name" dialog from the network view (from 

the shortcut menu of a PN/IE connection).

● The PROFINET IO device can be accessed using at least one PG/PC interface.
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Procedure
1. The following is displayed in the "PROFINET device name" drop-down list:

– the name of the interface that was used to open the project in the current offline project

– the names of those IO devices that are connected by means of this interface

The "Type" field displays the module type of the PROFINET IO device.
Choose a different name from the drop-down list, if necessary.

 

  Note

In steps 2 to 4, you determine the IO devices that are present in the PROFINET subnet.
 

2. In the "PG/PC interface for assignment" drop-down list, select the PG/PC interface you 
want to use to establish the online connection.

3. Optional: Use the three check boxes to make a selection from all IO devices available online.

4. Click the icon for determining the IO devices present in the PROFINET subnet. The table 
is then updated.

5. Select the desired IO device in the table.

6. Optional: Select the "Flash LED" check box in order to run an LED flash test on the 
PROFINET IO device. In this way, you verify that you are naming the desired IO device.

 

  Note

The LED flash test is not supported by all PROFINET IO devices.
 

The LED flash test runs until you cancel it. This is done, for example, by clearing the "Flash 
LED" check box or by selecting another IO device in the table.

7. Click "Assign name".

Result
The selected name is assigned to the PROFINET IO device or the interface that was used to 
open the dialog.

Calibrating an S7-1500 analog module

Calibrating an S7-1500 analog module - Overview

Where do you calibrate an S7-1500 analog module? 
You calibrate an S7-1500 analog module in its Online and Diagnostics view in the "Calibrate" 
group of the "Functions" folder.
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Overview of the function scope of the calibrating function
You can perform the following functions for an S7-1500 analog module in the "Calibrate" group:

● Specifying the current calibration of all channels

● Calibrating a channel

● Canceling a running calibration

● Resetting the calibration of a channel to the factory settings

Requirement for the calibrating function described below
The following is required for the calibrating function described below:

● You have opened the Online and Diagnostics view from the project context (thus not from 
the project tree or via the "Online" menu).

● There is an online connection to the analog module that is to be calibrated.

● Offline and online configuration are identical.

Calibrating an S7-1500 analog module

Overview of the calibration of a channel of an S7-1500 analog module 
The calibration of a channel of an S7-1500 analog module consists of the following steps:

1. Start calibration

2. Perform the second step up to the next to last step of the calibration

3. Complete calibration

These steps are described in more detail in the following section.

Requirement
● You have opened the Online and Diagnostic view of the S7-1500 analog module from the 

project context and are in the "Calibrate" group of the "Functions" folder.

● The associated CPU is online.

● No calibration is currently running on the analog module (if you want to start the calibration) 
or the last step initiated has been performed successfully (if you want to resume or complete 
the calibration).

Procedure for starting the calibration
To start the calibration, follow these steps:

1. In the overview table, select the line that belongs to the channel to be calibrated.

2. Click the "Start manual calibration" button.

The user interface then changes as follows: 
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● The overview table and the "Start manual calibration" button and "Set to factory settings" 
buttons become inactive.

● The step display is activated and displays the numbers of the current and last steps.

● The "Command" field becomes active and indicates what the user must do in the next 
calibration step.

● The "Status" field becomes active and shows the current status of the calibration, e.g., 
"Calibration successfully started".

● The "Measured value" field becomes active. For an input module a value is displayed here; 
you must enter a value here for an output module.

● The "Cancel" button becomes active.

● The "Next" button becomes active. This button can be used to advance to the next step of 
the calibration.

Procedure for the second to the next to last step of the calibration
Follow these steps:

1. Click the "Next" button.

The fields of the user interface described above are then updated.

Procedure for the last step of the calibration
Follow these steps:

1. Click the "Next" button.

The user interface then changes as follows:

● The overview table becomes active.

● The calibration display of the calibrated channel is updated.

● The "Start manual calibration" button and "Set to factory settings" buttons become active.

● The step display is deactivated and the numbers of the current step and last steps are 
empty.

● The "Command" field becomes inactive and is empty.

● The "Status" field becomes inactive and shows the last status of the calibration, e.g., 
"Calibration successfully finished".

● The "Measured value" field becomes inactive and is empty.

● The "Cancel" button becomes inactive.

● The "Next" button becomes inactive.

Error occurrence
If an error occurs during the calibration, the module cancels the calibration. Afterwards, the 
channel that was to be calibrated has the same settings as before the start of the calibration.
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Except for the "Status" field, the user interface appears the same after the occurrence of an 
error as before the calibration. The "Status" field displays the error that the module detected 
during the calibration.

Canceling a running calibration of an S7-1500 analog module

Requirement
● You have opened the Online and Diagnostic view of the S7-1500 analog module from the 

project context and are in the "Calibrate" group of the "Functions" folder.

● The associated CPU is online.

● A calibration is currently running on the analog module.

Procedure 
To cancel a running calibration, follow these steps:

1. Click the "Cancel" button.

Result
The running calibration is canceled, and afterwards the channel to be calibrated has the same 
settings as before the calibration.

All operator controls in the user interface are deactivated until the cancelation is complete. 
Except for the "Status" field, the user interface appears the same afterwards as before the 
calibration. The "Status" field displays the result of the cancelation.

 

Resetting an S7-1500 analog module to factory settings

Requirement
● You have opened the Online and Diagnostic view of the S7-1500 analog module from the 

project context and are in the "Calibrate" group of the "Functions" folder.

● The associated CPU is online.

Procedure 
To reset a channel of an S7-1500 analog module to factory settings, follow these steps:

1. Select the line associated with the channel to be reset in the overview table.

2. Click the "Set to factory settings" button.
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Result
All operator controls in the user interface are deactivated until the reset operation is complete. 
Except for the "Status" field, the user interface appears the same afterwards as before the 
reset operation. The "Status" field displays the result of the reset operation.

8.2.1.6 Diagnostics in STOP mode

Basic information on the diagnostics buffer 

Function 
The operating system of the CPU enters the errors detected by the CPU and the diagnostics-
capable modules into the diagnostics buffer in the order in which they occurred. This includes 
the following events:

● Every mode change of the CPU (POWER UP, change to STOP mode, change to RUN 
mode)

● Every hardware and diagnostic error interrupt

The top entry contains the most recent event. The entries in the diagnostics buffer are stored 
permanently. They are retained even if the power supply fails and can only be deleted by 
resetting the CPU to factory settings.

A diagnostics buffer entry contains the following elements:

● Time stamp

● Error ID

● Additional information specific to the error ID

Advantages of the diagnostics buffer
The diagnostics buffer offers the following advantages:

● After the CPU has changed to STOP mode, you can evaluate the last events prior to the 
STOP so that you can locate and identify the cause of the STOP.

● You can detect and eliminate the causes of errors more quickly and thus increase the 
availability of the system.

● You can evaluate and optimize the dynamic system response.

Organization of the diagnostics buffer
The diagnostics buffer is a ring buffer. The maximum number of entries for the S7-1200 CPUs 
is 50. When the diagnostics buffer is full and a further entry needs to be made, all existing 
entries are shifted by one position (which means that the oldest entry is deleted) and the new 
entry is made at the top position that is now free (FIFO principle: first in, first out).
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Evaluation of the diagnostics buffer
The contents of the diagnostics buffer can be accessed as follows: 

● Using the Online and Diagnostics view

The evaluation of events occurring prior to the error event (e.g., transition to STOP mode) 
allows you to obtain a picture of the possible causes or to zero in more closely or specify in 
more detail the possible causes (depending on the error type).

Read the detailed information about the events carefully and use the "Help on event" button 
to obtain additional information and possible causes of individual entries.

 

 Note

To make the best use of the time stamp information on the diagnostics buffer entries in time-
critical systems, it is advisable to check and correct the date and time of day on the CPU 
occasionally.

Alternatively, it is possible to perform a time-of-day synchronization using an NTP time server.
 

See also
Resetting an S7-1200 CPU to factory settings (Page 1233)

Determining the cause of a STOP of a CPU (Page 1246)

Determining and setting the time of day on a CPU (Page 1230)

Assigning the clock parameters (Page 1095)

Determining the cause of a STOP of a CPU

Requirement
The CPU you want to analyze is in STOP mode.

Procedure
To find out the reason why a CPU changed to STOP, follow these steps:

1. Open the online and diagnostics view of the CPU.

2. Select the "Diagnostics buffer" group from the "Diagnostics" folder.

3. Evaluate the events occurring prior to the transition to STOP mode. Use this to obtain a 
picture of the possible causes or to zero in on or specify in more detail the possible causes 
(depending on the error type).
Read the detailed information about the events carefully and use the "Help on event" button 
to obtain additional information and possible causes of individual entries.
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Result
You were able to zero in on or determine in more detail the cause of the CPU STOP.

 

 Note

If the analysis does not enable you to overcome the problem, contact Customer Support. In 
this case, use the "Save as" button to back up the content of the diagnostics data to a text 
file and submit it to Customer Support.

 

See also
Reading out the diagnostics buffer of a CPU (Page 1223)

8.2.1.7 Online accesses in the Online and Diagnostics view

Displaying status of the online connection

Requirement   
● The associated device can be accessed using at least one PG/PC interface.

Procedure
1. Open the online and diagnostics view for the device whose online connection status you 

want to display.

2. Select the "Online access" group.
 

  Note

The "Online access" group exists only for CPUs and some CPs. However, if you have 
opened the online and diagnostics view using the "Show/update accessible devices" 
function, it is not displayed.

 

Result
The status of the online connection is displayed in the "Status" area both graphically and in 
text form.

Specifying a PG/PC interface, going online

Requirement   
● The associated device can be accessed using at least one PG/PC interface.

● There is currently no online connection to the relevant device.
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Procedure
1. Open the Online and Diagnostics view of the device to which you want to establish an online 

connection.

2. Choose the "Online access" group and the "Online access" area within this group.
 

  Note

The "Online access" group exists only for CPUs and some CPs. If you have opened the 
Online and Diagnostics view using the "Show/update accessible devices" function, it is 
not displayed.

 

3. If an online connection was established previously for the device, the associated data for 
this online connection is preset in the drop-down lists. In this case, you can immediately 
continue with the last step of this operation, provided you have not changed the IP address 
in the meantime using the Online and Diagnostics view.

4. Choose the interface type in the "Type of PG/PC interface" drop-down list.
The "PG/PC interface for online access" drop-down list then shows only the interfaces of 
the programming device or PC that match the selected interface type.

5. In the "PG/PC interface for online access" drop-down list, select the programming device 
or PC interface via which you want to establish the online connection.

6. Optional: Click the "Properties" button to change the properties of the associated CP.

7. In the "Connection to subnet" drop-down list, select the subnet via which the device is 
connected to the PG/PC interface.

 

  Note

The PG/PC interface is connected to an interface of a device.

If you only want to access this device, select the setting "Directly at slot <interface name>" 
in the drop-down list.

If you want to access another device by means of routing, however, create a subnet at 
this interface in the hardware configuration and then select this subnet in the drop-down 
list.

 

8. If the device is accessible via a gateway, select the gateway that connects the two subnets 
involved in the "1st gateway" drop-down list.

9. In the "Device address" entry field, enter the IP address of the device to which you want to 
establish an online connection, if necessary.

 

  Note

For CPUs with multiple IP addresses, select the IP address of the PROFINET interface 
you want to use to establish an online connection from the "Device address" drop-down 
list.

 

10.Alternatively: Click the "Show accessible devices" button and choose the device from the 
list of accessible devices to which you want to establish an online connection.

11.Click the "Go online" button.
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Result
The online connection to the desired device is established.

Going offline

Requirement   
● There is currently an online connection to the relevant device.

Procedure
1. Open the online and diagnostics view of the device for which you want to disconnect the 

online connection.

2. Choose the "Online access" group and the "Online access" area within this group.
 

  Note

The "Online access" group exists only for CPUs and some CPs. However, if you have 
opened the online and diagnostics view using the "Show/update accessible devices" 
function, it is not displayed.

 

3. Click the "Go offline" button.

Result
The online connection to the desired device will be disconnected.

Performing the flash test for a device with an online connection

Requirement   
● There is currently an online connection to the relevant device.

● The FORCE function is not active.
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Procedure
1. Open the online and diagnostics view of the device for which you want to perform a flash 

test.

2. Choose the "Online access" group and the "Status" area within this group.
 

  Note

The "Online access" group exists only for CPUs and some CPs. However, if you have 
opened the online and diagnostics view using the "Show/update accessible devices" 
function, it is not displayed.

 

3. Select the "LED flash test" check box.

Result
● On an S7-1200 CPU, the RUN/STOP, ERROR and MAINT LEDs flash.

● On an S7-1500 CPU, the RUN/STOP, ERROR, and MAINT LEDs flash.

● On an S7-300 or S7-400 CPU, the FRCE LED flashes.

The LEDs flash until you cancel the flash test. This is done, for example, by clearing the "LED 
flash test" check box, by changing to another group of the online and diagnostics view, or by 
changing settings in the "Online access" area.

8.2.1.8 Checking PROFIBUS DP subnets for faults

Basic information on the diagnostic repeater

What is the diagnostic repeater?  
The diagnostic repeater is a repeater that can monitor a segment of an RS 485 PROFIBUS 
subnet (copper cable) during operation and signal line errors to the DP master via a diagnostics 
message frame.

The diagnostic repeater detects, localizes and visualizes line errors during operation at an 
early stage. As a result, problems in the system are identified early and production downtimes 
will be minimized.

Function of the diagnostic repeater
The diagnostic repeater can perform line diagnostics on the DP2 and DP3 segments because 
it has a measuring circuit for these segments.

The line diagnostics run in two steps:
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●  Step 1: Topology determination
You start the topology determination by calling the "DP_TOPOL" instruction in your program.
The diagnostic repeater then determines the PROFIBUS addresses and the distance of 
the devices and creates a topology table.

●  Step 2: Error localization
The diagnostic repeater checks the lines during operation. It determines the distance to the 
point of the error and the reason for the error; it then issues a diagnostics alarm with relative 
information on the error location.

Display of detailed information on the determined error location
You receive detailed information on the determined error location in the Online and Diagnostics 
view of the diagnostic repeater.

● By means of icons

● By means of a display with graphics and text

See also
Displaying the status of the segment diagnostics using icons (Page 1251)

Displaying the status of the segment diagnostics using graphics and text (Page 1252)

Displaying the status of the segment diagnostics using icons

Where do I find the information I need?  
The icons for the status of the segment diagnostics are available:

● In the expanded "Segment diagnostics" folder in the navigation pane of the Online and 
Diagnostics view of the relevant diagnostic repeater.

The diagnostics icon associated with the segment will be displayed behind the segment 
designation. It must be noted here that line errors will be displayed for the DP2 and DP3 
segments only. The DP1 and programming device segments do not display errors in the form 
of a diagnostics icon; rather, they signal only a few bus errors.

Diagnostics icons
The following table shows the available icons and their meaning.

Icon Meaning
Segment is error-free

Segment contains errors

Segment is deactivated
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Displaying the status of the segment diagnostics using graphics and text

Where is the status of the segment diagnostics displayed with graphics and text?
The status of the segment diagnostics will be displayed using graphics and text in the "DP1", 
"DP2", "DP3", and "PG" groups of the "Segment diagnostics" folder in the Online and 
Diagnostics view of the relevant diagnostic repeater.

Structure of the "DP1", "DP2" "DP3", and "PG" groups
The "DP1", "DP2", "DP3", and "PG" groups consist of the following elements:

● "Error location" field

● "Error" field

● "Resolution" field

● "Help on event" button

● "Freeze display" or "Cancel freeze" button

"Error location" field
This field displays the error location graphically, provided the diagnostic repeater can 
determine the location.

The following picture shows an example for a line error occurring in the DP2 segment.

In this example, the diagnostic repeater has the PROFIBUS address 2, and a line error has 
occurred between the devices with PROFIBUS addresses 16 and 17. This line error is located 
25 m from device 16, 4 m from device 17, and 72 m from the diagnostic repeater.

"Error" field
The error is explained in plain text in this field.

"Resolution" field
Here, you will find actions for resolving the error.
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"Help on event" button
Click this button to obtain a more detailed explanation of the error and additional details on 
resolving the error, if applicable.

"Freeze display" or "Cancel freeze" button
The "Freeze display" or "Cancel freeze" button is only enabled when there is an online 
connection to the diagnostic repeater.

The default setting is "Freeze display".

The following happens when you click the "Freeze display" button:

● The current display of the segment diagnostics is frozen.

● The labeling of the button changes to "Cancel freeze".

If the display is frozen and you click the "Cancel freeze" button, the following happens:

● The display of the segment diagnostics is updated again.

● The labeling of the button changes to "Freeze display".

8.2.2 Connection diagnostics

8.2.2.1 Overview of connection diagnostics

Basics  
Connection diagnostics, as described below, refers to the diagnostics of communication 
connections.

The connection diagnostics is started each time an online connection is established to a 
module (CPU or CP) that participates in one or more communication services. The connection 
status is updated automatically in the background.

In the case of one-way connections, an online connection must exist to the communication 
partner that has established the communication connection.

On connections configured at both ends, a distinction between the following two situations 
must be made:

● If there is an online connection to only one connection endpoint, only the part of the 
connection belonging to this connection endpoint can be diagnosed.

● If there is an online connection to both connection endpoints, both parts of the connection 
(and therefore the entire connection) can be diagnosed.
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Basic connections diagnostics options
Connection diagnostics can be performed as follows:

● Using icons on the connection status display
This display is generated in the connection table.

● Through detailed connection diagnostics
This step is available in the "Diagnostics > Connection information" area of the Inspector 
window.

Requirement for the connection diagnostics described below
You can display the details of either all the communication connections created in the project 
(default) or selected communication connections in the connection table.

The connection diagnostics described in the following assume that you display the details of 
selected communication connections. To do this, clear the "Show all connections" option in 
the shortcut menu.

8.2.2.2 Displaying the connection status using icons

Content of connection table without an online connection
● For a CPU or CP, the connection table lists the communication connections (including 

properties) configured offline, if an online connection is not established.

Content of connection table with an online connection   
After the online connection has been established, the properties of the communication 
connections listed offline will be expanded to include diagnostics icons for the connection 
status ("Online status" column).

In addition, entries for all communication connections that exist online only (e.g., connections 
for the instructions for Open User Communication, programming device and OP connections, 
connections for web server access) will now be added to the connection table.

For connections that exist online or offline only, the diagnostics icon at the bottom right is 
combined with a smaller additional comparison status icon.

Diagnostics icons for communication connections   
The following table shows the diagnostics icons for communication connections.

Icon Meaning
Connection setup

Connection not setup / is being setup

Connection not available
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Diagnostics icons for the comparison status   
The diagnostic icons for communication connections can be combined at the bottom right with 
additional smaller icons that indicate the result of the online/offline comparison. The following 
table shows the available comparison icons and their meaning.

Icon Meaning
Connection exists online only

Connection exists offline only

8.2.2.3 Detailed connection diagnostics

Detailed connection diagnostics - overview

Where do I perform detailed connection diagnostics?   
To perform detailed connection diagnostics, go to the "Diagnostics > Connection" information 
of the Inspector window.

How do I open the "Diagnostics > Connection information" area of the Inspector window?
The following options are available for opening the "Connection information" tab of the 
Inspector window.

● Select the line of the relevant connection in the connection table. Click the "Diagnostics" 
and "Connection information" tabs one after the other in the Inspector window.

● Double-click the diagnostics icon of the relevant connection in the connection table.

● This step takes you to the programming editor for a S7 communication instruction or open 
user communication instruction. Double-click the diagnostic icon of the instruction 
(stethoscope).

Structure or the "Diagnostics > Connection information" area of the Inspector window   
Requirements: the content of the "Connection information" tab has been filled, and an online 
connection to at least one end point of the relevant connection has been established.

If a module has been selected (network view), the tab will contain the following group:

● Connection resources (for S7-1200 and S7-1500)

If a connection has been selected (connection table), it will contain the following groups:

● Connection details

● Address details of the connection (for S7-1200 and S7-1500)
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Determining online connection resources for S7-1200

Where do you determine the online connection resources?  
The online connection resources are obtained in the "Connection resources" group. This group 
is located in the "Diagnostics > Connection information" area of the Inspector window. It is 
displayed only if you have selected a module in the network view to which an online connection 
exists.

Number of connection resources
● Maximum number: Specifies the maximum number of available connection resources of 

the module.

● Not assigned: Indicates how many connection resources are not yet assigned. If connection 
resources are already reserved for certain types of communication, then the unreserved 
connection resources cannot always be used for the various connection types.

Reserved and currently assigned connection resources
For the communication types indicated below, the connection resources that are reserved and 
currently assigned by the module will be displayed.

Communication type Meaning
PG communication Resources for connections between the module and programming devices (for 

example, for the establishment of a connection from the project tree, for online 
diagnostics, etc.)

HMI communication Resources for connections between the module and HMI devices
Open User Communication Resources for connection of open user communication instructions
S7 communication Resources for configured S7 connections, through which data can be exchanged by 

calling instructions in the user program.
Other communication Specifies other assigned connection resources for which connection resources are not 

reserved.

 

 

Determining online connection resources for S7-1500

Where do you determine the online connection resources?   
The online connection resources are obtained in the "Connection resources" group. This group 
is located in the "Diagnostics > Connection information" area of the Inspector window. It is 
displayed only if you have selected a module in the network view to which an online connection 
exists.
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Description of the detailed display of the connection resources
The detailed display of the connection resources includes:

● Number of available connection resources

● Number of configured connection resources

● Number of connection resources still available

For a description of these, go to here .

Determining connection details

Where do I determine the connection details?   
The connection details are obtained in the "Connection details" group. This group is located 
in the "Diagnostics > Connection information" area of the Inspector window.

When is the "Connection details" group filled in?
The following requirements must be met to fill in the "Connection details" group on the 
"Connection information" tab:

● An online connection to the end point of the relevant connection must exist.

● You have selected a line in the connection table.

Structure of the "Connection details" group
The "Connection details" group consists of the following elements:

● Local ID (hex)

● Connection type (for S7-1200 and S7-1500)

● Protocol

● Connection status: icon and description

● Details

● Last status change (for S7-300 and S7-400 only)

Determining the address details of a connection

Where do I determine the address details of a connection?   
The address details of a connection are obtained in the "Connection address details" group. 
This group is located in the "Diagnostics > Connection information" area of the Inspector 
window.
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For which CPUs is the "Connection address details" group available?
The "Connection address details" group of the "Connection information" tab is available for 
S7-1200 and S7-1500 CPUs.

When is the "Connection address details" group filled in?
The following requirements must be met to fill in the "Connection address details" group on 
the "Connection information" tab:

● An online connection to the end points of the relevant connection must exist.

● You have selected a line in the connection table.

Structure of the "Connection address details" group
The address details relevant to the connection type are specified for the two communication 
partners.
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Programming the PLC 9
9.1 Creating the user program

9.1.1 Programming basics

9.1.1.1 Operating system and user program

Operating system

Function   
The operating system is contained in every CPU and organizes all CPU functions and 
sequences that are not associated with a specific control task. 

The tasks of the operating system, for example, include the following:

● Processing a warm restart 

● Updating the process image of the inputs and outputs

● Calling the user program

● Detecting interrupts and calling interrupt OBs

● Detecting and handling errors

● Managing memory areas

The operating system is a component of the CPU and is already installed there upon delivery.

See also
User program (Page 1259)

User program

Function 
The user program contains all functions that are necessary for processing your specific 
automation task. 

The tasks of the user program include:
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● Checking the requirements for a (warm) restart using startup OBs, for example, limit switch 
in correct position or safety relay active. 

● Processing process data, e.g. linking binary signals, reading in and evaluating analog 
values, defining binary signals for output, and outputting analog values

● Reaction to interrupts, for example, diagnostic error interrupt if the limit value of an analog 
expansion module is overshot.

● Error handling in normal program execution

You write the user program and load it into the CPU.

See also
Operating system (Page 1259)

9.1.1.2 Blocks in the user program

Linear and structured programming

Linear programming 
Solutions for small automation tasks can be programmed linearly in a program cycle OB. This 
is only recommended for simple programs. 

The following figure shows a linear program schematically: The "Main1" program cycle OB 
contains the complete user program. 

Structured programming 
Complex automation tasks can be more easily handled and managed by dividing them into 
smaller sub-tasks that correspond to the technological functions of the process or that can be 
reused. These sub-tasks are represented in the user program by blocks. Each block is then 
an independent section of the user program.
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Structuring the program offers the following advantages:

● Extensive programs are easier to program through the structure.

● Individual program sections can be standardized and used repeatedly with changing 
parameters.

● Program organization is simplified.

● Changes to the program can be made more easily.

● Debugging is simplified since separate sections can be tested.

● Commissioning is simplified.

The following figure shows a structured program schematically: The "Main1" program cycle 
OB calls subprograms one after the other that execute defined subtasks.

Overview of the block types

Block types   
Different BLOCK types are available to perform tasks within an automation system. The 
following table shows the available block types:

Block type Brief description
Organization blocks  (Page 1262) (OB) Organization blocks define the structure of the user program.
Functions  (Page 1262) (FC) Functions contain program routines for recurring tasks. They have no 

"memory".
Function blocks  (Page 1263) (FB) Function blocks are code blocks that store their values permanently in 

instance data blocks, so that they remain available even after the block has 
been executed.

Instance data blocks (Page 1265) Instance data blocks are assigned to a function block when it is is called for 
the purpose of storing program data.

Global data blocks (Page 1264) Global data blocks are data areas for storing data that can be used by any 
blocks.
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Organization blocks (OB)

Definition    
Organization blocks (OBs) form the interface between the operating system and the user 
program. They are called by the operating system and control, for example, the following 
operations:

● Startup characteristics of the automation system

● Cyclic program processing

● Interrupt-driven program execution

● Error handling

You can program the organization blocks and at the same time determine the behavior of the 
CPU. Various organization blocks are available to you depending on the CPU used. 

For more information on organization blocks, refer to the descriptions of the modes of operation 
of CPUs in the "Additional information on configurations" chapter in "Configuring Hardware 
and Networks".

Start information of organization blocks
When certain organization blocks are started, the operating system provides information that 
can be evaluated in the user program. Refer to the descriptions of the organization blocks to 
find out which information is provided, if any. 

 

See also
Creating organization blocks (Page 1448)

Functions (FCs)

Definition     
Functions (FCs) are code blocks without memory. You have no data memory in which values 
of block parameters can be stored. Therefore, when a function is called, all formal parameters 
must be assigned actual parameters. 
Functions can use global data blocks to store data permanently.

Application
A function contains a program that is executed when the function is called by another code 
block. Functions can be used, for example, for the following purposes:

● To return function values to the calling block, e.g. for mathematical functions

● To execute technological functions, e.g. individual controls using bit logic operations
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A function can also be called several times at different points in a program. As a result, they 
simplify programming of frequently recurring functions.

 

 Note
Parameter transfer when calling functions

To avoid errors when working with functions, observe the information in chapter "Auto-
Hotspot". 

 

See also
Creating functions and function blocks (Page 1449)

Function blocks (FB)

Definition       
Function blocks are code blocks that store their input, output and in-out parameters 
permanently in instance data blocks, so that they remain available even after the block has 
been executed. Therefore they are also referred to as blocks "with memory".

Function blocks can also operate with temporary tags. Temporary tags are will not be stored 
in the instance DB, but are available for one cycle only.

Application
Function blocks contain subroutines that are always executed when a function block is called 
by another code block. A function block can also be called several times at different points in 
a program. As a result, they simplify programming of frequently recurring functions.

Instances of function blocks
A call of a function block is referred to as an instance. An instance data block is required for 
each instance of a function block; it contains instance-specific values for the formal parameters 
declared in the function block. 

The function block can store its instance-specific data in its own instance data block or in the 
instance data block of the calling block. 
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Access modes
S7-1200 and S7-1500 offer two different access options for the instance data blocks, which 
can be assigned to a function block when this is called: 

● Data blocks with optimized access
Data blocks with optimized access have no firmly defined memory structure. The data 
elements contain only a symbolic name in the declaration, no fixed address within the block.

● Data blocks with standard access (compatible with S7-300/400)
Data blocks with standard access have a fixed memory structure. The declaration elements 
contain both a symbolic name in the declaration and a fixed address within the block.

 

 Note

To avoid errors when working with function blocks, refer to the section "Auto-Hotspot".
 

 

See also
Creating functions and function blocks (Page 1449)

Multi-instances (Page 1275)

Instance data blocks (Page 1265)

Basics of block access (Page 1267)

Global data blocks (DB)

Definition     
Data blocks are used to store program data. Data blocks thus contain variable data that is 
used by the user program. Global data blocks store data that can be used by all other blocks.

The maximum size of data blocks varies depending on the CPU. You can define the structure 
of global data blocks anyway you please.

You also have the option of using PLC data types (UDT) as a template for creating global data 
blocks.

Global data blocks in the user program
Every function block, function, or organization block can read the data from a global data block 
or can itself write data to a global data block. This data remains in the data block even after 
the data block is exited. A global data block and an instance data block can be open at the 
same time. 

The following figure shows the different accesses to data blocks:
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Access modes
S7-1200 and S7-1500 offer two different access options for global data blocks: 

● Data blocks with optimized access
Data blocks with optimized access have no fixed defined structure. In the declaration, the 
data elements are assigned only a symbolic name and no fixed address within the block.

● Data blocks with standard access (compatible with S7-300/400)
Data blocks with standard access have a fixed structure. In the declaration, the data 
elements are assigned both a symbolic name and a fixed address within the block.

ARRAY data blocks (S7-1500)
ARRAY data blocks are a particular type of global data block. These consist of an ARRAY of 
any data type. For example, an ARRAY of a PLC data type (UDT) is possible. The DB contains 
no other elements besides the ARRAY. Because of their flat structure, ARRAY data blocks 
facilitate access to the ARRAY elements and their transfer to called blocks.

The "Optimized block access" attribute is always enabled for ARRAY data blocks. ARRAY 
data blocks with standard access are not possible.

The "Move operations" section of the "Instructions" task card offers options for addressing of 
ARRAY DBs. 

 

See also
Creating data blocks (Page 1450)

Basics of block access (Page 1267)

Instance data blocks

Definition       
The call of a function block is referred to as an instance. The data with which the instance 
works is stored in an instance data block. 
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The maximum size of instance data blocks varies depending on the CPU. The tags declared 
in the function block determine the structure of the instance data block. 

Access modes
S7-1200 and S7-1500 offer two different access options for the instance data blocks, which 
can be assigned to a function block when this is called: 

● Data blocks with optimized access
Data blocks with optimized access have no firmly defined structure. The declaration 
elements contain only one symbolic name in the declaration, and no fixed address within 
the block.

● Data blocks with standard access (compatible with S7-300/400)
Data blocks with standard access have a fixed structure. The declaration elements contain 
both a symbolic name in the declaration and a fixed address within the block.

 

See also: Auto-Hotspot

See also
Creating data blocks (Page 1450)

Basics of block access (Page 1267)

CPU data blocks

Definition  
CPU data blocks are generated by the CPU at runtime. To this purpose, insert the 
"CREATE_DB" instruction into your user program. You can use the data block that is generated 
at runtime to save your data. 

CPU data blocks are indicated by means of a small CPU icon in the "Program blocks" folder 
of an available node.  You can monitor the values of the variables of a CPU data block in online 
mode, similar to those of a different data block type.

You cannot create CPU data blocks in your offline project.

Loading CPU data blocks
The CPU data block that the user program has generated by means of the "CREATE_DB" 
instruction is initially only available on the device in online mode.  All CPU data blocks will be 
included with the other blocks the next time you perform a complete download from the device 
to the project. The CPU data blocks are marked with a small CPU icon in the process. However, 
you cannot upload these CPU data blocks to your device again.
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Restrictions on CPU data blocks in the project
Once the CPU data blocks have been loaded into your offline project, you can open and view 
their content. However, note that the CPU data blocks in the project are write-protected. The 
CPU data blocks in the project are therefore subject to the following restrictions: 

● You cannot edit CPU data blocks, or convert these into a different data block type.

● CPU data blocks cannot be assigned a know-how protection.

● You cannot change the programming language of a CPU data block.

● CPU data blocks cannot be compiled or downloaded to a device.

Comparing CPU data blocks
Once the CPU data blocks have been loaded into your offline project, you can run an online/
offline comparison for the CPU DBs loaded. The comparison editor provides you with a 
corresponding overview of the differences. It is possible to synchronize the online and off-line 
version of CPU data blocks if differences are found, but not by downloading the offline version 
to the device.

Deleting CPU data blocks
You can delete CPU data blocks both from the project and from the CPU. 

 

See also
Deleting CPU data blocks (Page 1469)

Blocks with optimized access

Basics of block access

Introduction         
STEP 7 offers data blocks with different access options: 

● Data blocks with optimized access (S7-1200/S7-1500)

● Data blocks with standard access (S7-300 / S7-400 / S7-1200 / S7-1500)

Within one program you can combine the two types of blocks. 

Data blocks with optimized access
Data blocks with optimized access have no fixed defined structure. In the declaration, the data 
elements are assigned only a symbolic name and no fixed address within the block. The 
elements are saved automatically in the available memory area of the block so that there are 
no gaps in the memory. This makes for optimal use of the memory capacity. 
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Tags are identified by their symbolic names in these data blocks. To address the tag, enter its 
symbolic name. For example, you access the "Fill Level" tag in the "Data" DB as follows: 
"Data".Fill Level
Blocks with optimized access offers the following advantages:

● You can create data blocks with any structure without paying attention to the physical 
arrangement of the individual data elements.

● Quick access to the optimized data is always available because the data storage is 
optimized and managed by the system.

● Access errors, as with indirect addressing or from the HMI, for example, are not possible. 

● You can define specific individual tags as retentive.

● Optimized blocks are equipped with a memory reserve by default which lets you expand 
the interfaces of function blocks or data blocks during operation. You can download the 
modified blocks without setting the CPU to STOP and without affecting the values of already 
loaded tags. 

 

 Note

The "Optimized block access" attribute is always enabled for the following blocks and cannot 
be deselected.
● GRAPH blocks
● ARRAY data blocks

 

Data blocks with standard access
Data blocks with standard access have a fixed structure. In the declaration, the data elements 
are assigned both a symbolic name and a fixed address within the block. The address is shown 
in the "Offset" column.

Tags in these data blocks can be addressed in both symbolic and absolute form. 
"Data".Fill Level
DB1.DBW2

Setting Retentivity for Optimized Access or Standard Access
If you define data as retentive, its values are retained even after a power failure or a network 
off. A retentive tag is not initialized after the hot restart but retains the value it had prior to the 
power failure. If a DB tag is defined as retentive, it is stored in the retentive memory area of 
the data block. 

The options for setting the retentivity depend on the access type of the block.
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● In data blocks with standard access, you cannot set the retentive behavior of individual 
tags. The retentivity setting is valid for all tags of the data block.

● In data blocks with optimized access you can define the retentive behavior of individual 
tags. 
For structured data type tags, the retentivity setting always applies to the entire structure. 
You cannot make any individual retentivity setting for separate elements within the data 
type. 

Setting Addressing Options for Optimized Access or Standard Access
Blocks with optimized access permit only "type-safe" access. Type-safe access addresses 
tags by their symbolic name only. This means even changes to the block or the block interface 
will not result in inconsistencies in the program or access errors.

The following table shows the permitted addressing options for optimized data:

 

Addressing Block with standard access Block with optimized access
Symbolic addressing x x
Indexed addressing of ARRAYs  x
Slice access x x
Overlapping with AT x -
Absolute addressing x -
Indirect addressing via ANY x -
Indirect addressing via POINTER and 
VARIANT

x with symbolic notation only

See also
Setting up block access (Page 1269)

Setting up block access

Introduction         
Block access is set up automatically when you create a block:

● Blocks created on CPUs of the S7-1200/1500 product range provide optimized access by 
means of a default setting.

● New blocks created on CPUs of the S7-300/S7-400 product range provide standard access 
by means of a default setting.

Access to a block that you copy or migrate to a CPU of a different product range is not converted 
automatically. However, in certain situations it may be useful to change block access in manual 
mode, e.g., in order to utilize the full functional scope of the CPU. 
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In most cases, you will have to recompile and load the program after block access has been 
converted.

 

 NOTICE

Optimized block access for GRAPH blocks

The "Optimized block access" attribute is always enabled for GRAPH blocks in S7-1500 and 
cannot be deselected.

 

Procedure
To set the block access, proceed as follows:

1. Open the "Program blocks" folder in the project tree.

2. Right-click on the block whose block access you want to change.

3. Select the "Properties" command in the shortcut menu.
The properties dialog box of the block opens.

4. Click "Attributes" in the area navigation.

5. Enable or disable the "Optimized block access" option.

6. Confirm your entries with "OK".

Restrictions and special features
As a matter of principle, you can only convert block access on CPUs of the S7-1200/1500 
product range, as only these support the "optimized" access mode.

The following restrictions or special features apply in this context:

● Instance data blocks
The block access of instance data blocks is always determined by the assigned function 
block and cannot be changed in manual mode. If you change the access mode on a function 
block, you also need to update the assigned instance data blocks. This update procedure 
adapts the access mode of the instance data block.

● System blocks and know-how protected blocks
You cannot manually edit the block access for system blocks and know-how protected 
blocks. 

● Organization blocks
The start information of an OB with standard access is always stored in the first 20 bytes 
of the "Temp" section in the block interface. By contrast, the start information of an OB with 
optimized access is always written to the "Input" section. For this reason, the block interface 
of OBs will also change whenever you convert block access. Additional information is 
provided in the following sections.

Converting block access from "standard" to "optimized".
A block copied from the CPU of the S7-300/400 product range to a CPU of the S7-1200/1500 
product range will initially retain the "standard" access mode. However, you can significantly 
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increase the performance of program execution by using blocks with optimized access, which 
is why it may be useful to modify the access mode manually.

The blocks are adapted as follows in the course of conversion:

● Function blocks
All interface parameters are assigned the "Non-retain" retentivity setting. 

● Global data blocks
The retentivity setting that was assigned centrally to the entire data block is transferred to 
the individual interface parameters. It is now possible to manipulate the retentivity setting 
of the various parameters. 
However, the following rule will still apply: For structured data type tags, the retentivity 
setting always applies to the entire structure. You cannot assign separate retentivity settings 
to the various elements within a structured data type. It therefore follows that you cannot 
assign individual retentivity settings to the tags of data blocks that are based on PLC data 
types.

● Organization blocks
All interface parameters that are stored in the first 20 bytes of the "Temp" section will be 
deleted. New CPU-specific start information is entered in the "Input" section. Naming 
conflicts with user-defined interface parameters occurring in the process are resolved by 
renaming the user-defined interface parameters.

 

 CAUTION

The conversion of the block access has the following consequences:
● Absolute addressing of the interface parameters of the block is no longer possible after 

conversion of block access to the "optimized mode.
Example: #L0.1 is no longer valid. 

● Since conversion to the "optimized" block access mode of organization blocks also 
modifies the OB interface,

you may possibly have to adapt, recompile and load the program again due to these changes.

See also: Auto-Hotspot
 

Converting block access from "optimized" to "standard".
If you want to copy or move a block from the CPU of the S7-300/400 product range to a CPU 
of the S7-1200/1500 product range, you first need to set the "standard" access mode.

The blocks are adapted as follows in the course of conversion:
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● Function blocks and global data blocks.
You can no longer set a retentivity in the function block. The corresponding setting is made 
in the instance data block. 
All interface parameters in the instance DB or global DB are assigned the same retentivity 
setting. The conversion is subject to the following rule:

– If all interface parameters in the original block were retentive, the entire block will be 
retentive after conversion.

– If all interface parameters in the original block were non-retentive, the entire block will 
be non-retentive after conversion.

– If the interface parameters in the original block had different retentivity settings, the entire 
block will be non-retentive after conversion.

● Organization blocks
All interface parameters stored in the "Input" section will be deleted. New CPU-specific start 
information is entered in the "Temp" section. This data is written to the first 20 bytes. Naming 
conflicts with user-defined interface parameters occurring in the process are resolved by 
renaming the user-defined interface parameters.

 

 CAUTION

The conversion of the block access has the following consequences:

Since a conversion to "standard" block access mode might change the retentivity settings of 
the interface parameters, you may possibly have to adapt, recompile and load the program 
again due to these changes.

 See also: Auto-Hotspot
 

See also
Basics of block access (Page 1267)

9.1.1.3 Block calls

Principles of block calls

Function of block calls  
For your blocks to be executed in the user program, they need to be called from another block. 

When one block calls another block, the instructions of the called block are executed. Only 
when execution of the called block has been completed does execution of the calling block 
resume. The execution is continued with the instruction that follows on the block call.

The following figure shows the sequence of a block call within a user program:
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Parameter transfer
When a block is called, you must assign values to the parameters in the block interface. By 
providing input parameters you specify the data with which the block is executed. By providing 
the output parameters you specify where the execution results are saved.

See also
Call hierarchy (Page 1273)

Principles for single instances and multi-instances (Page 1274)

Call hierarchy

Definition    
The order and nesting of block calls is referred to as the call hierarchy. The permissible nesting 
depth depends on the CPU. 

The following figure shows an example of the order and nesting of block calls within an 
execution cycle:
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See also
Principles for single instances and multi-instances (Page 1274)

Principles of block calls (Page 1272)

Call function blocks as single or multi-instances

Principles for single instances and multi-instances

Use of single instances and multiple instances   
Function blocks (FBs) store their data in instance data blocks. Instance data blocks store the 
values of the block parameters and the static local data of the function blocks.

You can assign instance data blocks as follows:

● Single instance:
One instance data block for each instance of a function block 

● Multiple instance:
An instance data block for the instance of a function block and all instances of function 
blocks called in it.

See also
Principles of block calls (Page 1272)

Multi-instances (Page 1275)

Single instances (Page 1275)

Call hierarchy (Page 1273)
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Single instances

Definition   
The call of a function block, which is assigned its own instance data block, is called a single 
instance data block.

By assignment of the instance data block, you specify where the instance data of the FB is to 
be stored. By assigning a different instance data block to each call, you can use the same FBs 
several times with different instance data in each case.

Example of a single instance  
You can control several motors using one function block. For this purpose, you assign a 
different instance data block for each function block call for motor control.

The different data for the various motors, such as speed, ramp-up time, total operating time, 
are saved in the different instance data blocks. A different motor will be controlled, depending 
on the instance data block assigned. 

The following figure shows the control of three motors using one function block and three 
different data blocks:

 

See also
Principles for single instances and multi-instances (Page 1274)

Multi-instances (Page 1275)

Multi-instances

Definition   
Multi-instances enable a called function block to store its data in the instance data block of the 
calling function block.
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This allows you to concentrate the instance data in one instance data block and thus make 
better use of the number of instance data blocks available.

One instance data block for the instances of different function blocks
The following figure shows how multiple different function blocks store their data in a calling 
block. The FB_Workpiece calls the following on after the other: FB_Grid, FB_Punch and 
FB_Conveyor. The called blocks store their data in the DB_Workpiece, the instance data block 
of the calling block.
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One instance data block for multi-instances of a function block
The following figure shows how a function block that is called in multi-instances stores the data 
for all the instances in one instance data block.

The function block FB_Motors calls three instances of the FB_Motor. The instances are 
"Motor_1", "Motor_2" and "Motor_3". Each call uses different instance data. However, all 
instance data are located in a single instance data block, DB_MotorData. 

See also
Principles for single instances and multi-instances (Page 1274)

Single instances (Page 1275)

Parameter transfer at block call

Basics of block parameters

Introduction     
The calling block gives the called block the values with which it is to work. These values are 
referred to as block parameters. The input parameters provide the called block with the values 
that it has to process. The block returns the results via the output parameters.

Block parameters are therefore the interface between the calling and the call block. 

You use input parameters when you want to only query or read values, and output parameters 
when you want to set or write these values. If block parameters are read and written you have 
to create these as in-out parameters.
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Formal and actual parameters
The block parameters are defined in the interface of the called block. These parameters are 
referred to as formal parameters. They are placeholders for the parameters that are transferred 
to the block when it is called. The parameters transferred to the block when it is called are 
referred to as actual parameters. 

Rules for using the block parameters
The following rules apply to the use of block parameters within the block:

● Input parameters may only be read.

● Output parameters may only be written.

● In/out parameters may be read and written.

See also
Parameter assignment to function blocks (Page 1281)

Parameter assignment to functions (Page 1279)

General rules for assigning parameters (Page 1278)

Using tags within the program (Page 1295)

Keywords (Page 1289)

Supplying block parameters during call

General rules for assigning parameters

Introduction
When you call a block with block parameters, assign actual parameters to its formal 
parameters. The rules described below apply here.

Compatible data types
The data types of actual and formal parameters must be identical or convertible according to 
the rules of data type conversion.

Transferring ARRAYs
You can transfer ARRAYs as parameters. If a block has an input parameter of ARRAY type, 
you must transfer as actual parameter an ARRAY with identical structure. You can also transfer 
individual elements of an ARRAY as actual parameter if the element corresponds to the data 
type of the formal parameter.
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Transferring PLC data types
You can also transfer tags that are declared as PLC data type as actual parameters. If the 
formal parameter is declared as PLC data type in the tag declaration, you must transfer a tag 
that has the same PLC data type as actual parameter.

An element of a tag declared by means of PLC data type can also be transferred as actual 
parameter at block call, provided that the data type of the element of the tag matches the data 
type of the formal parameter.

Transferring structures (STRUCT)
You can transfer structures as parameters. If a block has an input parameter of the STRUCT 
type, you must transfer as actual parameter a STRUCT with identical structure. This means 
that the names and data types of all structure components have to be identical. 

You can also transfer individual elements of an STRUCT as actual parameter if the element 
corresponds to the data type of the formal parameter.

 

 Note

We recommend programming structures as PLC data types. PLC data types make 
programming easier, since they can be used multiple times and modified centrally.

 

See also
Parameter assignment to function blocks (Page 1281)

Parameter assignment to functions (Page 1279)

Basics of block parameters (Page 1277)

Parameter assignment to functions

Parameters of functions (FC)     
Functions have no data memory in which values of block parameters can be stored. Therefore, 
when a function is called, all formal parameters must be assigned actual parameters. 

Input parameters (Input)
Input parameters are read only once per cycle, namely before the block call. Therefore, the 
rule is that writing an input parameter within the block does not affect the actual parameter. 
Only the formal parameter is written.

Output parameters (Output)
Output parameters are read only once per cycle, namely after the block call. Therefore, the 
rule is that output parameters should not be read within the block. If you nevertheless read an 
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output parameter, please note that only the value of the formal parameter is read. The value 
of the actual parameter cannot be read within the block. 

If an output parameter of a function is not written in this function, the value that is predefined 
for the specified data type is used. For example, the value "false" is predefined for BOOL. 
However, structured output parameters are not pre-assigned with a value.

To prevent unintentional further processing of the predefined value or an undefined value, note 
the following when programming the block:

● Make sure that the output parameters are written with values for all possible program paths 
within the block. In doing so, note that jump commands may skip instruction sequences in 
which outputs are set, for example. 

● Note that the set and reset commands are dependent on the result of the logic operation. 
If the value of an output parameter is determined with these commands and RLO = 0, a 
value will not be generated. 

● If possible, assign a default value for the output parameters of functions.

In/out parameters (InOut)
In/out parameters are read before the block call and written after the block call. If you read or 
write the parameter within the block, you only access its formal parameter. 

An exception is in/out parameters with a structured data type. Structured data types consist 
of several data elements, for example ARRAY or STRUCT. These are passed to the called 
block through a POINTER. You therefore always access the actual parameter when you read 
or write a structured in/out parameter within a block.

When an in/out parameter of a function is not written to this function, the old output value or 
the input value is used as a value. Nevertheless, you should observe the information provided 
above for output parameters so that old values are not inadvertently processed further.

Temporary local data (Temp)
Temporary local data is only available within a cycle. It is treated differently depending on the 
block type:

● Standard access
The following rule applies to code blocks with standard access as well as to all tags with 
retentivity setting "Set in IDB": 
If you use temporary local data, you have to make sure that the values are written within 
the cycle in which you want to read them. Otherwise, the values will be random. Temporary 
data of the STRING data type is an exception: It is automatically pre-assigned the correct 
length information.

● Optimized access
The following rule applies to code blocks with optimized access:
If a temporary tag is not written within a function, the value that is predefined for the specified 
data type is used. For example, the value "false" is predefined for BOOL. Elements of the 
PLC data types are pre-assigned with the default value that is specified in the declaration 
of the PLC data type (UDT). ARRAY elements are pre-assigned with the value "0", even if 
they are used within a PLC data type. Strings are pre-assigned the correct length 
information.
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Function value (Return)
Functions normally calculate a function value. This function value can be returned to the calling 
block via the RET_VAL output parameter. For this, the RET_VAL  output parameter must be 
declared in the interface of the function. RET_VAL is always the first output parameter of a 
function. All data types are permitted for the RET_VAL parameter except ARRAY and 
STRUCT, as well as parameter types TIMER and COUNTER.

In the SCL programming language functions can be call directly in an expression. The result 
of the expression is then formed with the calculated function value. Therefore, the data type 
ANY is not permitted in SCL for the function value.

See also
Parameter assignment to function blocks (Page 1281)

Basics of block parameters (Page 1277)

General rules for assigning parameters (Page 1278)

Calling functions (Page 1622)

Examples for calling functions in SCL (Page 1625)

Parameter assignment to function blocks

Supplying parameters of function blocks (FB)     
In the case of function blocks the parameter values will be stored in the instance data. 

If the input, output, or in-out parameters of a function block were not assigned with values, the 
stored values are used. 

In some cases, it is mandatory to specify an actual parameter.

The following table shows which parameters of a function block must be assigned actual 
parameters: 

Parameter Elementary data type Structured data type Parameter type
Input (Input) optional optional required
Output (Output) optional optional required
In-out (InOut) optional required Permitted with S7-1200 only, 

parameter assignment 
required

Temporary (Temp) required
S7-1500: Optional with 
optimized block access

required
S7-1500: Optional with 
optimized block access

required
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See also
Basics of block parameters (Page 1277)

General rules for assigning parameters (Page 1278)

Parameter assignment to functions (Page 1279)

Access to block parameters during program execution

Introduction
Block parameters of functions and function blocks are processed differently during program 
execution. The type of access varies depending on the CPU family, block type and data type 
of the block parameter. 

We generally distinguish between the two following types of access:

● Parameters are transferred as parameter pointers
A parameter pointer is transferred to the called block. 
This means that the called block can directly access the operand that is specified as actual 
parameter. Writing a parameter in the called block results in a change of the actual 
parameter in the calling block. Read access to a block parameter reads the actual 
parameter directly.

● Parameters are transferred as copy 
The value of the actual parameter is copied to the temporary data of the called blocks during 
a block call. 
This means that the called block always works with the value that the actual parameter had 
at the block call. It cannot directly access the operand that is specified as actual parameter.  
Writing a parameter in the called block does not result in a change of the actual parameter 
in the calling block. During read access, the formal parameter and not the actual parameter 
is accessed. 
The procedure for copying is as follows:

– Input parameter: 
The value of the actual parameter is copied to the formal parameter of the called blocks 
during a block call.

– Output parameter: 
The value of the formal parameter is copied to the actual parameter after leaving the 
block.

– In/out parameter: 
The value of the actual parameter is copied to the formal parameter of the called block 
prior to the block call and copied back to the actual parameter after exiting the function. 

Parameter transfer for elementary data types
The following table shows how the different CPU families transfer block parameters with 
elementary data type. Elementary data types are, for example, Bool, Int, Byte.
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Called block Actual parameter in the area S7-300/400 S7-1500
FC I, Q, M, P, L Pointer Pointer

Partially qualified DB address (e.g. 
DBW 2)

Pointer Partially qualified DB 
addresses are not supported 
in S7-1500.

Fully qualified DB address (e.g. 
"MyDB".value), 
forwarded parameters of the caller, 
static parameters of the caller  

Copy Copy

FB All actual parameters Copy Copy

Parameter transfer for structured data types
The following table shows how the different CPU families transfer block parameters with 
structured data type. Structured data types are data types that consist of several data elements, 
e.g. ARRAY or STRUCT.

 

Called block Actual parameter in the area S7-300/400 S7-1500
FC IN, OUT, InOut Pointer Pointer
FB IN, OUT  Copy Copy

 InOut Pointer Pointer

Forwarding of block parameters

Basic information on forwarding block parameters

Introduction     

Definition
The "Forwarding" of block parameters is a special type of parameter use. In this case the block 
parameters of the calling block are forwarded to the parameters of the called block. The called 
block uses the values that are currently present at the block parameters of the calling block 
as the actual parameters.

The following figure shows how the parameters of the function FC_10 are forwarded to the 
function FC_12:
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Rules for LAD/FBD
The following general rules apply in LAD and FBD:

● Input parameters can only be forwarded to input parameters.

● Output parameters can only be forwarded to output parameters.

● In/out parameters can be forwarded to all parameter types.

● In S7-300/400, the two block parameters must have the same data type.

● In S7-1200/1500, the parameters can also be converted according to the rules of implicit 
conversion.

Rules for STL
The following general rules apply in STL:

● Input parameters can only be forwarded to input parameters.

● Output parameters can only be forwarded to output parameters.

● In/out parameters can be forwarded to all parameter types.

● Both block parameters must have the same data type. In STL, this rule applies to all CPU 
families.

Rules for SCL
The rules for SCL are less stringent. So that programs from previous SCL versions can be 
taken over more easily, additional parameter transfer options are permissible, but subject to 
warning. You can, for example, forward an in/out parameter to an input parameter, but a 
warning is output as the transferred in/out parameter cannot be written by the program.

Additional rules are described in detail in the following chapters.
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See also
Calling a function by another function (Page 1285)

Call of a function by a function block (Page 1286)

Call of a function block by a function (Page 1287)

Call of a function block by another function block (Page 1288)

Calling a function by another function

Permissible data types for the call of a function by another function     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FC calls FC Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 
STRING, 

WSTRING, 
DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-1500 S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1283)
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Call of a function by a function block

Permissible data types for the call of a function by a function block     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FB calls FC Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 
STRING, 

WSTRING, 
DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-1500 S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1283)
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Call of a function block by a function

Permissible data types for the call of a function block by a function     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FC calls FB Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 
STRING, 

WSTRING, 
DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-300/400
S7-1500

S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1283)
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Call of a function block by another function block

Permissible data types for the call of a function block by another function block     
Specific rules apply to the forwarding of formal parameters. The following table shows the rules 
according to which parameters can be forwarded in the various CPU families:

FB calls FB Data types
Actual 

parameter 
(calling 
block)

Formal 
parameter

s
(called 
block)

Standard data 
types

ARRAY, 
STRUCT, 
STRING, 

WSTRING, 
DT

ANY, 
POINTER

VARIANT Parameter types 
(TIMER, 

COUNTER, 
BLOCK_XX)

DB_Any

Input Input S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

S7-300/400
S7-1500

S7-1200 as 
of V2
S7-1500

Output Output S7-300/400
S7-1200
S7-1500

S7-300/400
S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut Input S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

InOut Output S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

- S7-1200
S7-1500

- -

InOut InOut S7-300/400
S7-1200
S7-1500

S7-1200
S7-1500

S7-1500 S7-1200
S7-1500

- -

 

See also
Basic information on forwarding block parameters (Page 1283)
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9.1.1.4 Using and addressing operands

Basic information about operands

Introduction   
When you program instructions you must specify which data values the instruction should 
process. These values are referred to as operands. You can, for example, use the following 
elements as operands:

● PLC tags

● Constants

● Tags in instance data blocks

● Tags in global data blocks

Absolute address and symbolic name
Operands are identified by means of an absolute address and a symbolic name. You define 
the names and addresses in the PLC tag table or in the tag declaration of the blocks.

Data blocks with optimized access (S7-1200, S7-1500)
Data elements in data blocks with optimized access only receive a symbolic name and no 
absolute address in the declaration. For more information on this, refer to "See also". 

See also
Displaying symbolic and absolute addresses (Page 1480)

Basics of block access (Page 1267)

Keywords
SIMATIC recognizes a range of key words whose definitions are fixed and which have a certain 
meaning in the program. You should not use these keywords as names for tags or constants. 

Table of keywords       
The following table shows all keywords.

Keywords 
German mnemonics

Keywords 
English mnemonics

Description

& & And logical operation of logical 
expressions

A Q Output, bit
A1 CC1 Condition code bit
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

A0 CC0 Condition code bit
AB QB Output, byte
AD QD Output, double word
AND AND And logical operation of logical 

expressions
ANY ANY Data type, pointer
AR1 AR1 Address Register 1
AR2 AR2 Address Register 2
ARRAY ARRAY Introduces the specification of 

an array and is followed by the 
index list between "[" and "]"

AT AT Overlaying tag declaration
AUTHOR AUTHOR Name of the author, company 

name, department name, or 
other name (max. 8 characters, 
no spaces) 

AW QW Output, word
B B Byte
BEGIN BEGIN Introduces the instruction part for 

code blocks or initialization part 
for a data block

BIE BR Binary result
BLOCK_FB BLOCK_FB Parameter type for specification 

of an FB
BLOCK_FC BLOCK_FC Parameter type for specification 

of an FC
BLOCK_SDB BLOCK_SDB Parameter type for specification 

of an SDB
BOOL BOOL Data type
BY BY Increment of the FOR loop
BYTE BYTE Data type
CALL CALL Call
CASE CASE Introduction to the CASE 

statement
CHAR CHAR Elementary data type
CODE_VERSION1 CODE_VERSION1 Label, whether an FB is multiple 

instance capable or not. If you 
want to declare multiple 
instances, the FB must not have 
this characteristic.

CONST CONST Start of the constant declaration
CONTINUE CONTINUE Instruction to exit a loop in SCL
COUNTER COUNTER Parameter type for specification 

of a counter
DATA_BLOCK DATA_BLOCK Introduces the data block
DATE DATE Data type
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

DATE_AND_TIME DATE_AND_TIME Data type
DB DB Data block
DB_ANY DB_ANY Data type
DBB DBB Data block, data byte
DBD DBD Data block, data double word
DBLG DBLG Data block length
DBNO DBNO Data block number
DBW DBW Data block, data word
DBX DBX Data block, data bit
DI DI Instance data block
DIB DIB Instance data block, data byte
DID DID Instance data block, data double 

word
DILG DILG Instance data block length
DINO DINO Instance data block number
DINT DINT Data type
DIW DIW Instance data block, data word
DIX DIX Instance data block, data bit
DO DO Introduction of the instruction 

part in FOR and WHILE 
instruction

DT DT Data type
DTL DTL Data type
DWORD DWORD Data type 
E I Input (via process image), bit
EB IB Input (via process image), byte
ED ID Input (via process image), 

double word
ELSE ELSE Alternative branch in IF and 

CASE statement
ELSIF ELSIF Alternative condition of the IF 

instruction
EN EN System operand of the EN/ENO 

mechanism
ENO ENO System operand of the EN/ENO 

mechanism
END_CASE END_CASE End of the CASE statement
END_DATA_BLOCK END_DATA_BLOCK Ends the data block
END_FOR END_FOR End of the FOR statement
END_FUNCTION END_FUNCTION Ends the function
END_FUNCTION_BLOCK END_FUNCTION_BLOCK Ends the function block
END_IF END_IF End of the IF instruction
END_ORGANIZATION_BLOCK END_ORGANIZATION_BLOCK Ends the organization block
END_REPEAT END_REPEAT End of the REPEAT statement
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

END_STRUCT END_STRUCT Ends the specification of a 
structure

END_SYSTEM_FUNCTION END_SYSTEM_FUNCTION Ends the system function 
END_SYSTEM_FUNCTION_BL
OCK

END_SYSTEM_FUNCTION_BL
OCK

Ends the system function block

END_TYPE END_TYPE Ends the PLC data type
END_VAR END_VAR Ends a declaration block
END_WHILE END_WHILE End of the WHILE instruction
EW IW Input (via process image), word
EXIT EXIT Instruction to exit a loop in SCL
FALSE FALSE Predefined Boolean constant: 

Logical condition false, value 
equal to 0

FAMILY FAMILY Block family name: e.g. controller
FB FB Function block
FC FC Function
FOR FOR Introduction of the FOR 

statement
FUNCTION FUNCTION Introduces the function
FUNCTION_BLOCK FUNCTION_BLOCK Introduces the function block
GOTO GOTO Introduction of the GOTO 

statement
IF IF Introduction of the IF instruction
INSTANCE INSTANCE Data type
INT INT Data type
KNOW_HOW_PROTECT KNOW_HOW_PROTECT Block protection 
L L Local data bit
LB LB Local data byte
LD LD Local data double word
LDT LDT Data type
LINT LINT Data type
LTIME LTIME Data type
LTOD LTOD Data type
LW LW Local data word
LWORD LWORD Data type
M M Memory bit
MB MB Memory byte
MD MD Memory double word
MOD MOD Modulo operator
MW MW Memory word
NAME NAME Block name 
NETWORK NETWORK Network
NOT NOT Logic inversion
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

NULL NULL Zero pointer
OB OB Organization block
OF OF Introduction of the data type 

specification / Introduction of the 
instruction part of the CASE 
statement

OR OR Or logical operation of logical 
expressions

ORGANIZATION_BLOCK ORGANIZATION_BLOCK Introduces the organization block
OS OS Save overflow
OV OV Overflow
PA PQ Output (direct peripherals), bit
PAB PQB Output (direct peripherals), byte
PAD PQD Output (direct peripherals), 

double word
PAW PQW Output (direct peripherals), word
PE PI Input (direct peripherals), bit
PEB PIB Input (direct peripherals), byte
PED PID Input (direct peripherals), double 

word
PEW PIW Input (direct peripherals), word
POINTER POINTER Data type
READ_ONLY READ_ONLY Write protection for data blocks
REAL REAL Data type
REPEAT REPEAT Introduction of the REPEAT 

statement
RET_VAL RET_VAL Return value
RETURN RETURN RETURN statement in SCL
S5T S5T Syntax for data type S5TIME
S5TIME S5TIME Data type
S7_ S7_ Keywords for system attributes
SDB SDB System data block
SFB SFB System function block
SFC SFC System function
SINT SINT Data type
STRING STRING Data type
STRUCT STRUCT Introduces the specification of a 

structure and is followed by a list 
of components

STW STW Status word
SYSTEM_FUNCTION SYSTEM_FUNCTION System function
SYSTEM_FUNCTION_BLOCK SYSTEM_FUNCTION_BLOCK System function block
T T Time element (timer)
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Keywords 
German mnemonics

Keywords 
English mnemonics

Description

THEN THEN Introduction of the instruction 
part of an IF instruction

THIS THIS Syntax for access to an ARRAY 
data block

TIME TIME Elementary data type for time 
information

TIME_OF_DAY TIME_OF_DAY Data type
TIMER TIMER Parameter type for specification 

of a timer
TITLE TITLE Optional block title or network 

title
TO TO Definition of the full-scale value 

of a FOR statement
TOD TOD Data type
TRUE TRUE Predefined Boolean constant: 

Logical condition true, value not 
equal to 0

TYPE TYPE Introduction of the PLC data type
UDT UDT Global or PLC data type
UDINT UDINT Data type
UINT UINT Data type
ULINT ULINT Data type
UNLINKED UNLINKED Marking 'non runtime-related'
UNTIL UNTIL End of the instruction part of a 

REPEAT statement
USINT USINT Data type
UO UO Query after (Q1=1) AND (Q0=1)
VAR VAR Introduces a declaration block
VAR_IN_OUT VAR_IN_OUT Introduces a declaration block
VAR_INPUT VAR_INPUT Introduces a declaration block
VAR_OUTPUT VAR_OUTPUT Introduces a declaration block
VAR_TEMP VAR_TEMP Introduces a declaration block
VARIANT VARIANT Data type
VERSION VERSION Version number of the block
VOID VOID Function has no return value
WCHAR WCHAR Data type
WSTRING WSTRING Data type
WHILE WHILE Introduction of a WHILE 

instruction
WORD WORD Data type
XOR XOR Logic operation
Z C Counter
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Using tags within the program

Definition     
A variable is a placeholder for a data value that can be changed in the program. The format 
of the data value is defined. The use of variables makes your program more flexible. For 
example, you can assign different values to variables that you have declared in the block 
interface for each block call. As a result, you can reuse a block you have already programmed 
for various purposes.

A variable consists of the following elements:

● Name

● Data type

● Absolute address

– PLC tags and DB tags in blocks with standard access have an absolute address.

– DB variables in blocks with optimized access have no absolute address.

● Value (optional)

Declaring Variables       
You can define variables with different scopes for your program:

● PLC tags that apply in all areas of the CPU

● DB variables in global data block that can be used by all blocks throughout the CPU.

● DB tags in instance data blocks that are predominantly used within the block in which they 
are declared.

The following table shows the difference between the variable types:

 PLC tags Variables in instance DBs Variables in global DBs
Range of 
application

● Are valid throughout the entire CPU.
● Can be used by all blocks on the CPU.
● The name is unique within the CPU.

● Are predominantly used 
in the block in which they 
are defined.

● The name is unique 
within the instance DB.

● Can be used by all blocks 
on the CPU.

● The name is unique 
within the global DB.

Permissible 
characters

● Letters, numbers, special characters
● Quotation marks are not permitted.
● Reserved keywords are not permitted.

● Letters, numbers, special 
characters

● Reserved keywords are 
not permitted.

● Letters, numbers, special 
characters

● Reserved keywords are 
not permitted.

Use ● I/O signals (I, IB, IW, ID, Q, QB, QW, 
QD)

● Bit memory (M, MB, MW, MD)

● Block parameters   (input, 
output and in-out 
parameters),

● Static data of a block

● Static data

Location of 
definition

PLC tag table Block interface Declaration table of the 
global DB
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See also
Keywords (Page 1289)

Basic information about operands (Page 1289)

Displaying symbolic and absolute addresses (Page 1480)

Valid names of PLC tags (Page 1423)

Permissible addresses and data types of PLC tags (Page 1424)

Constants

Basics of constants

Definition     
Constants are data with a fixed value that you cannot change during program runtime. 
Constants can be read by various program elements during the execution of the program but 
cannot be overwritten. There are defined notations for the value of a constant, depending on 
the data type and data format. A distinction is made between the typed and non-typed notation.

Non-typed constants
In the non-typed notation, you only enter the value of the constant without a data type. Non-
typed constants do not receive their type until the first arithmetic or logical operation in which 
they are used. 

The example below shows the non-typed notation:

SCL  
#My_Int1 := #My_Int2 + 12345 (*The data type of the constant "12345"

results from the addition with My_Int 2. "12345" 
receives the data type INT.*)

#My_Real1 := #My_Real2 + 12345 (*The data type of the constant "12345" results 
from the addition with My_Real2. "12345" 
receives the data type REAL.*)

Typed constants
In the typed notation, you specify a data type in addition to the value of the constant. 

The example below shows the typed notation:

SCL  
#My_Int1 :=  INT#12345 (*The data type of the constant is always 

INT.*)
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 Note
Constants of the BOOL type

Constants of the BOOL type may not be used as inputs in LAD or FBD in S7-300/400.
 

Additional information
Additional information on the data types of constants, their input formats and value ranges:

Data types

See also
Layout of the block interface (Page 1491)

Declaration of symbolic names for constants

Symbolic constants     
You have the option of declaring symbolic names for constants and thus making constant 
values available under a name in the program. This makes a program more readable and 
easier to maintain when changing constant values.

A symbolic constant consists of the following elements:

● Name

● Data type
Symbolic constants always have a data type; non-typed notation is not possible for symbolic 
constants.

● Constant value
You can select any value from the value range of the specified data type as constant value. 
For information on the value ranges, refer to the "Data types" chapter.

Declaration of constants
You can define constants with different scopes of validity:

● Global constants that apply to all areas of the CPU

● Local constants that only apply within a block

The table below shows the difference between the constant types:
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 Global constants Local constants
Scope of validity ● Are valid throughout the 

entire CPU
● The name is unique within 

the CPU.

● Are valid only in the block in 
which they were declared.

● The name is unique within 
the block.

Permitted characters ● The permitted characters in 
constant names are letters, 
digits and special characters.

● The permitted characters in 
constant names are letters, 
digits and special characters.

Location of definition "Constants" tab from the PLC tag 
table

Block interface

Representation In quotation marks, for example.:
"Glob_Const"

Prefixed with a number sign, for 
example:
#Loc_Const

 

 Note
Downloading constant declarations (S7-300/400)

Local and global constant declarations are not downloaded into the CPU. If you download a 
program from a device, the constant declarations may no longer be available.

 

Additional information
Additional information on the procedure for declaring constants:

Auto-Hotspot

Auto-Hotspot

Auto-Hotspot

Data types of constants

Permitted data types    
For constants, all basic data types as well as all derived data types are permitted:

● Binary numbers

● Bit strings

● Integers

● Floating-point numbers

● Timers

● Date and time

●  Character strings

All general rules for explicit and implicit type conversion apply.
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Data types of non-typed constants
Non-typed constants do not contain an explicit type specification. They do not receive their 
type until the first arithmetic or logical operation in which they are used. 

The example below shows how non-typed constants are used:

SCL  
#My_Int1 := #My_Int2 + 12345 (*The data type of the constant "12345"

results from the addition with My_Int 2. "12345" 
receives the data type INT.*)

#My_Real1 := #My_Real2 + 12345 (*The data type of the constant "12345" results 
from the addition with My_Real2. "12345" 
receives the data type REAL.*)

 
 

 Note
STEP 7 always uses the data type with the highest possible precision

Unless the data type of a constant can be clearly defined in an expression, the data type with 
the highest precision available on the current CPU is used.

Example:
#My_Real := #My_Int / 3.5
In this expression an integer tag is combined with a non-typed floating point constant. In 
S7-300/400 the right part of the assignment is calculated in the REAL format. In 
S7-1200/1500, calculation is performed using the highest possible precision, which in this 
case means LREAL. As a result, the assignment to a REAL tag is invalid or generates a 
warning.

To precisely define the data type of a constant, use the typed notation.

Example: 

#My_Real := #My_Int / REAL#3.5
 

 

Additional information
Additional information on the data types of constants, their input formats and value ranges:

Data types

Examples of using constants

Use in instructions, assignments and expressions
Constants can be used in place of tags in instructions or assignments. You can also use 
constants in expressions in SCL. But because constants cannot be written, they may only be 
used as inputs.
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The example below shows possible uses of constants:

SCL  
#My_Int :=   3;  
#My_Real1 := #My_Real2 * 3;  
#My_Real1 := #My_Real2 * #My_local_const;  
#My_Real1 := #My_Real2 * "My_global_const";  

Use as a default value
You can also use a constant as the default value of a tag. To do so, enter either the value or 
the symbolic name of the constant in the "Default value" column of the block interface. The 
data type of the constant must match the data type of the tag or be convertible with it according 
to the implicit conversion with IEC check.

Name conflicts can occur if you have declared a local and a global constant with the same 
symbolic name and have used this doubly specified name as the default value of a tag. In this 
case, the local constant is automatically used.

Use as an ARRAY limit
Local constants of data type INT or DINT can also be used as ARRAY limits.

The example below shows the use of local constants as ARRAY limits:

SCL  
Array[My_local_const1..My_local_const1] of REAL  

 

 
 

 Note
Constants as ARRAY limits

Note the following information on the topic of "Constants as ARRAY limits":
● Global constants are not permitted as ARRAY limits.
● Local constants which are used as ARRAY limits cannot be changed if the memory reserve 

of the block is activated.
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Addressing operands

Addressing global variables

Addressing global variables
To address a global PLC variable, you can use the absolute address or the symbolic name. 

 

 Note

The LWORD, LINT, ULINT, LREAL, LTIME, LTOD and LDT data types can only be addressed 
by means of their symbolic name.

 

Addressing global variables in symbolic form       
When you use addressing in symbolic form, you enter the variable name from the PLC tag 
table. The symbolic name of global variables are automatically enclosed in quotation marks. 

You address structured tags that are based on a PLC data type with the symbolic name of the 
PLC tag. You can also indicate the names of the individual components separated by a dot. 

Addressing global variables in absolute form
When you use addressing in absolute form, you enter the address of the variables from the 
PLC tag table. The absolute address uses numerical addresses starting with zero for each 
operand range. The address identifier % is set automatically as prefix for the absolute address 
of global tags.

Examples
The following examples show applications of symbolic and absolute addressing:

Addressing Description
%Q1.0 Absolute address: Output 1.0
%I16.4 Absolute address: Input 16.4
%IW4 Absolute address: Input word 4
"Motor" Symbolic address "Motor"
"Value" Symbolic address "Value"
"Structured_Tag" Symbolic address of a tag that is based on a PLC 

data type
"Structured_Tag".Component Symbolic address of the component of a structured 

tag.

See also: Permissible addresses and data types of PLC tags (Page 1424) 
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See also
Displaying symbolic and absolute addresses (Page 1480)

Accessing I/O devices (Page 1302)

Accessing I/O devices

Description         
The process image of the CPU is updated once in a cycle. In time-critical applications, however, 
it can be that the current state of a digital input or output has to be read or transferred more 
often than once per cycle. For this purpose you can use a suffix for I/O access identifiers on 
the operand to directly access the I/O.

If you want to read the input directly from the peripherals, use the peripheral inputs memory 
area (PI) instead of the process input image (I). The peripherals memory area can be read as 
a bit, byte, word, or double word. 

If you want to write directly to the output, use the peripheral output (PQ) memory area instead 
of the process output image (Q). The peripheral output memory area can be written as a bit, 
byte, word, or double word. 

To read or write a signal directly from a peripheral input, you can add the suffix for I/O access 
":P", to the operand.

Components of structured PLC tags can also be addressed with ":P". However, access to the 
higher-level tag with ":P" is not possible.

 

 WARNING

Direct writing of the I/O

Immediate writing to the I/O can lead to hazardous states, for example when writing multiple 
times to an output in one program cycle. 

 

Syntax
<Operand>:P

Example
The following example shows applications of I/O access identifiers:

Addressing Description
"Motor" Addresses the "Motor" tag in the process image.
"Motor":P Addresses the "Motor" tag in the I/O memory area (PI 

or PQ).
"Structured_Tag".Component Addresses the component of a structured PLC tag in the 

process image.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1302 System Manual, 02/2014



Addressing Description
"Structured_Tag".Component:P Addresses the component of a structured PLC tag in the 

I/O memory area (PI or PQ).

 

See also
Addressing global variables (Page 1301)

Addressing variables in data blocks

Addressing variables in global data blocks

Description
Tags in global data blocks can be addressed in symbolic or absolute form. For symbolic 
addressing, you use the name of the data block and the name of the tag, separated by a dot. 
The name of the data block is enclosed in quotation marks.

For absolute addressing, you use the number of the data block and the absolute address of 
the tags in the data block, separated by a dot. The address identifier % is set automatically as 
prefix for the absolute address.

The S7-1200/1500 provides you with an option of accessing a data block that is not yet known 
during programming. For this purpose, create a block parameter of data type DB_Any in the 
block interface of the accessing block. The data block name or data block number is transferred 
to this parameter during runtime. In order to access the internal tags of the data block, use the 
name of the block parameter of data type DB_Any and the absolute address of the tag, 
separated by a dot.

 

 Note

Absolute addressing is not possible for the following tags:
● Tags in blocks with optimized access.
● Tags of data type LWORD, LINT, ULINT, LREAL, LTIME, LTOD and LDT.

Best practice is to use the more convenient symbolic addressing for these tags.
 

ARRAY data blocks
ARRAY data blocks are a particular type of global data block. These consist of an ARRAY of 
any data type. For example, an ARRAY of a PLC data type (UDT) is possible. 

You address elements in ARRAY data blocks with the help of the keyword "THIS". The index 
is then specified in square brackets. The index can be a constant as well as a tag. Integers 
with a width of up to 32 bits are permitted as tags for the index.
Extended options for addressing ARRAY DBs are available in the "Move" section of the 
"Instructions" task card. These instructions give you the option, for example, to also address 
the DB name indirectly.
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Syntax
"<DBname>".TagName
%<DBnumber>.absoluteAddress
#<DBAny_name>.%absoluteAddress
"<ArrayDBname".THIS[#i].<Component>.<ComponentElement>
SCL:
"<ArrayDBname"."THIS"[#i].<Component>.<ComponentElement>
The following table show the possible absolute addresses of tags in data blocks:

Data type Absolute address Example Description
BOOL %DBn.DBXx.y %DB1.DBX1.0 Data bit 1.0 in DB1
BYTE, CHAR, SINT, 
USINT

%DBn.DBBy %DB1.DBB1 Data bit 1 in DB1

WORD, INT, UINT %DBn. DBWy %DB1.DBW1 Data word 1 in DB1
DWORD, DINT, 
UDINT, REAL, TIME

%DBn.DBDy %DB1.DBD1 Data double word 1 in 
DB1

Example
The following examples show the addressing of tags in global data blocks:
 

Addressing Description
"Motor".Value Symbolic addressing of the "Value" tag in the 

"Motor" global data block.
%DB1.DBX1.0 Absolute addressing of the "DBX1.0" tags in the 

"DB1" global data block.
#MyDBAny.%DBX30.0 Absolute addressing of the "DBX30.0" tag in the 

global DB that is transferred at runtime at the 
"MyDBany" parameter.

"MyARRAY_DB".THIS[#MyIndex].MyCom
ponent.MyComponentElement

Addressing an ARRAY data block. The ARRAY index 
is specified with the "MyIndex" tag. The ARRAY 
element has two additional substructures: 
"MyComponent" and "MyComponentElement".

See also
Addressing structured variables (Page 1306)

Addressing areas of a tag with slice access (Page 1308)

Basics of indirect addressing (Page 1312)

Addressing instance data (Page 1305)

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1304 System Manual, 02/2014



Addressing instance data

Description         
You can address data elements from the interface of the current block. These tags are stored 
in the instance data block. 

 

 Note

Tags in blocks with optimized access can only be addressed in symbolic form. 
 

To address a tag from the interface of the current block, enter the character # followed by the 
symbolic tag name.

You can also access the tags of a multiple instance block. Within the multiple instance block, 
also use the character # followed by the tag name to address the data. You access the data 
of the multiple instance block from the calling block using #<Multiple 
instanceName.TagName>.

Syntax
Use the following syntax for addressing tags in instance data blocks:
#<TagName>
#<Multiple instanceName.TagName>

Examples
The following examples show the addressing of tags in instance data blocks:

Addressing Description
#Value Addressing the "Value" tag in the instance data block.
#On Addressing the "On" tag within the multiple instance block
#Multi.On Addressing the "On" tag of the multiple instance block from the 

calling block

See also
Addressing variables in global data blocks (Page 1303)

Addressing structured variables (Page 1306)

Addressing areas of a tag with slice access (Page 1308)

Basics of indirect addressing (Page 1312)

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1305



Addressing structured variables

Addressing data elements of an ARRAY
You access an element in an ARRAY using the syntax ArrayName[i,j,k...]. 

The index of the element is specified in square brackets. The index includes an integer value 
(-2147483648 ... 2147483647) for each ARRAY dimension. 

Access errors result when you access an element during runtime which is located outside the 
declared ARRAY limits. The various CPU families react differently to violations of the ARRAY 
limits:

● S7-300/400

– The CPU changes to "STOP" mode.

– You can program the program execution error OB (OB 85) to prevent this. 

– In SCL, you also have the option of enabling the attribute "Check ARRAY limits" in the 
block properties. This causes the enable output ENO to be set to FALSE in the case of 
ARRAY access errors.

● S7-1200

– The CPU generates a diagnostic buffer entry and remains in "RUN" mode.

● S7-1500

– The CPU changes to "STOP" mode.

– You can program the programming error OB (OB 121) to prevent this. 

– You also have the option of programming the local error handling with the instructions 
"GET_ERROR: Get error locally" or "GET_ERROR_ID: Get error ID locally".

 

 Note
Monitoring ARRAY access errors with ENO

The enable output ENO is not set to the signal state FALSE if the ARRAY limits are violated 
during execution of an instruction. The only exception is SCL blocks on CPUs of the 
S7-300/400 series for which the block property "Check ARRAY limits" is set.

 

See also:

Auto-Hotspot

Indirect indexing of ARRAY components (Page 1314)

Addressing ARRAY data blocks
ARRAY data blocks are a particular form of the ARRAY. ARRAY data blocks are global data 
blocks that consist of exactly one ARRAY. You address elements in ARRAY data blocks using 
the following syntax:
 "<GlobArrayDBname".THIS[#i].<componentname>."<elementname>"
SCL:
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"<GlobArrayDBname"."THIS"[#i].<componentname>."<elementname>". 
The "Move" section of the "Instructions" task card offers extended options for addressing 
ARRAY DBs. These instructions give you the option, for example, to also address the DB name 
indirectly.

Addressing data elements in structures
You access individual elements in a structure using StructureName.ElementName.

See also: 

Auto-Hotspot

Addressing data elements of an PLC data type
The syntax PLCDataTypeName.ElementName is used to access elements of a PLC data 
type.

See also:

Auto-Hotspot

Addressing individual characters of a STRING or WSTRING
Use the syntax StringName[i] to access an individual character of a STRING or WSTRING 
tag. The counting index "i" begins with "1". Thus, you access the first character of the string 
with StringName[1]. 

You cannot access individual characters of a STRING or WSTRING constant.  

Errors result when you access a character during runtime which is located outside the STRING 
length. The various CPU families react differently to violations of the STRING length:

● S7-300/400

– If the instruction has the enable output ENO, ENO is set to the signal state FALSE.

– If the instruction does not have an enable output ENO, violation of the STRING length 
is not monitored:
If access takes place outside the STRING, the wrong memory area is accessed. 
If the access takes place outside the data block, the CPU goes to STOP. You can 
program the program execution error OB (OB 85) to prevent this. 

● S7-1200/1500

– If the access takes place outside the declared length, the CPU goes to STOP. You can 
choose whether you want to respond to violations with the global error handing of the 
CPU or with separate local error handling.

– If the access is located within the declared STRING length but outside the actual 
STRING length, violation of the STRING length is not monitored and the CPU does not 
go to STOP. You receive the character '$00' or '$0000' with read access; write access 
is not executed. 
If the instruction has the enable output ENO, ENO is set to the signal state FALSE.

See also:
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Auto-Hotspot

Examples:
The following examples show the addressing of structured data type tags:

Addressing Description
Motor.Value_1x3[2] Addressing of a one-dimensional array
Motor.Value_2x4[2,4] Addressing of a two-dimensional array
Motor.Value_4x7[2,4,1,3] Addressing of a four-dimensional array
Batch_1.Temperature Addressing of the element "Temperature" in the 

structure "Batch_1"
Values.Temperature Addressing of the "Temperature" element in the "Values" 

tag, which is based on a PLC data type.
STRING[3] Addresses the third character of the string.

See also
Basics of indirect addressing (Page 1312)

Addressing areas of a tag with slice access

Description       
You have the option to specifically address areas within declared tags. You can access areas 
of the 1-bit, 8-bit, 16-bit, or 32-bit width. The type of access is referred to as "slice access".

Constants cannot be addressed by slice access.

Syntax
The following syntax is used for addressing: 
<Tag>.X<Bit number>
<Tag>.B<BYTE number>
<Tag>.W<WORD number>
<Tag>.D<DWORD number>
 

The syntax has the following components:

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1308 System Manual, 02/2014



Part Description
<Tag> Tag that you access. The tag must be of the "Bit string" data type. In the 

case of activated IEC check, the access to tags of the "Integer" data type 
is also possible.

X
B
W
D

ID for the access width "Bit (1Bit)"
ID for the access width "Byte (8 Bit)"
ID for the access width "Word (16 Bit)"
ID for access width "DWord (32-bit)"

<BIT number> Bit number within <tag> that is accessed. Number 0 accesses the least 
significant BIT.

<BYTE number> Byte number within <tag> that is accessed.
The number 0 accesses the least significant BYTE.

<WORD number> Word number within <tag> that is accessed.
The number 0 accesses the least significant WORD.

<DWORD number> DWord number within <tag> that is accessed.
The number 0 accesses the least significant DWORD.

Examples
The following examples show the addressing of individual bits:

Addressing Description
"Engine".Motor.X0
"Engine".Motor.X7

"Motor" is a tag of the BYTE, WORD, DWORD or LWORD data 
type in the global data block "Engine".
X0 addresses the bit address 0, X7 the bit address 7 
within "Motor". 

"Engine".Speed.B0
"Engine".Speed.B1

"Speed" is a tag of the WORD, DWORD or LWORD data type in 
the global data block "Engine".
B0 addresses the byte address 0, B1 the byte address 1 
within "Speed".

"Engine".Fuel.W0
"Engine".Fuel.W1

"FUEL" is a tag of the DWORD or LWORD data type in the 
global data block "Engine".
W0 addresses the word address 0, W1 the word address 1 
within "Fuel".

"Engine".Data.D0
"Engine".Data.D1

"Data" is a tag of the LWORD data type in the global data 
block "Engine".
D0 addresses the double word address 0, D1 the double word 
address 1 within "Data".

Overlaying tags with AT

Description             
To access data areas within a declared tag, you can overlay the declared tags with an 
additional declaration. This provides you with the option of addressing an already declared tag 
with a different data type. You can, for example, address the individual bits of a tag of WORD 
data type with an ARRAY of BOOL.
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Rules
The following general rules are valid for tag overlaying:

● Overlaying is possible in S7-1200 and S7-1500 in STL, LAD, FBD and GRAPH.

● SCL supports overlaying in all CPU families.

● Overlaying of tags is possible in the following blocks:

– In code blocks with standard access

– In code blocks with optimized access for tags with the retain setting "Set in IDB"

● The data width of the overlaying tag must be equal to or less than that of the overlaid tag.

● It is not possible to overlay tags of the VARIANT and INSTANCE data types.

● Blocks from libraries which are declared as parameters in the interface cannot be overlaid.

● Structured PLC tags that are declared as parameters in the interface cannot be overlaid.

 
 

 Note
S7-1200/1500: Using AT in FCs

The data widths of the overlaying tag and the overlaid tag must be identical for FCs in 
S7-1200/1500. If this is not possible in your program, you can also address areas within 
existing tags with the .X, .B, .W or .D syntax.

See also: Addressing individual areas of a tag (Page 1308)
 

The following combination rules are also valid:

 Overlaying tag Overlaid tag
Elementary Structured * Any/Pointer DB_ANY
FB Input Elementary x x  x

Structured * x x x x
Any/Pointer  x   

Temp Elementary x x   
Structured x x x  
Any/Pointer  x   

Static, Output Elementary x x  x
Structured x x  x
Any/Pointer     

InOut Elementary x   x
Structured  x   
Any/Pointer     

FC Temp Elementary x x   
Structured x x x  
Any/Pointer  x   
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 Overlaying tag Overlaid tag
Input, Output, 
InOut 

Elementary
(both tags must 
have the same bit 
width)

x   x

Structured  x x  
Any/Pointer     

OB Temp Elementary x x   
Structured x x x  
Any/Pointer  x   

* Structured data types consist of several data elements, e.g. ARRAY or STRUCT.

Declaration
To overlay a tag, declare an additional tag directly after the tag that is to be overlaid and identify 
it with the keyword "AT". 

Example
The following figure shows the declaration of an overlaid tag in the interface of a FB:

When a block is called with the shown tag declaration, the "MyByte" tag is assigned. Within 
the block there are now two options for interpreting the data:

● as a byte

● As one-dimensional ARRAY of BOOL
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Addressing operands indirectly

Basics of indirect addressing

Introduction    
Indirect addressing offers the option of addressing operands whose address is not calculated 
until during runtime. With indirect addressing, program sections can be executed several times 
and a different operand can be used during each run. 

 
 

 WARNING

Risk of access errors

Since operands are only calculated during runtime with indirect addressing, there is a risk 
that access errors may occur and that the program will operate with incorrect values. In 
addition, memory areas may inadvertently be overwritten with incorrect values. The 
automation system can then react in unexpected manner.

Therefore, use indirect addressing only with caution.
 

Indirect addressing

Basics of indirect addressing

General indirect addressing options in S7-1200 and S7-1500     
The following indirect addressing options are available in all programming languages:

● Indirect addressing via pointer

● Indirect indexing of ARRAY components

● Indirect addressing of a data block via DB_ANY data type. 
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Language-specific options of indirect addressing
The following specific addressing options are also available in the various programming 
languages:

● In STL, you can address operands indirectly via the address register.

● In SCL, you can read or write a variable memory area with the following instructions:

– POKE - Write memory address

– POKE_BOOL - Write memory bit

– PEEK - Read memory address

– PEEK_BOOL - Read memory bit

– POKE_BLK - Write memory area

For a detailed description of these addressing options, refer to "See also".

See also
Addressing variables in global data blocks (Page 1303)

POKE: Write memory address (Page 2513)

POKE_BOOL: Write memory bit (Page 2515)

PEEK: Read memory address (Page 2509)

PEEK_BOOL: Read memory bit (Page 2511)

POKE_BLK: Write memory area (Page 2516)

Indirect addressing via pointer (Page 1313)

Indirect indexing of ARRAY components (Page 1314)

Indirect addressing in STL (Page 1318)

Indirect addressing via pointer

Description    
For indirect addressing, a special data format is required that contains the address and possibly 
also the range and the data type of an operand. This data format is referred to as pointer. The 
following types of pointers are available to you: 

● POINTER (S7-1500)

● ANY (S7-1500, only for blocks with standard access)

● VARIANT (S7-1200/1500)

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1313



For more information on the pointer data types, refer to "See also".
 

 Note

In SCL the use of the POINTER is restricted. The only option available is to forward it to the 
called block.

 

Example
The following example shows an indirect addressing with an area-internal pointer:

Addressing in STL Explanation
L P#10.0 // Load pointer (P#10.0) in accumulator 1
T MD20 // Transfer pointer to the operand MD20
L MW [MD20] // Load MW10 in accumulator 1  
.... // Any program
L MD [MD20] // Load MD10 in accumulator 1
.... // Any program
= M [MD20] // If RLO=1, set the memory bit M10.0

 

The pointer P#10.0 is transferred to the operand MD20. If the operand MD20 in square brackets 
is programmed, this will be replaced in runtime by the address that is contained in the pointer. 

See also
Basics of indirect addressing (Page 1312)

Indirect indexing of ARRAY components

Description
For addressing the components of an ARRAY, you can specify tags of the integer data type 
as well as constants as the index. Integers with a length of up to 32 bits are allowed here. 
When tags are used, the index is calculated during runtime. You can, for example, use a 
different index for each cycle in program loops.

 

 Note

When you call a block and transfer an indirectly indexed ARRAY component ("<Data 
block>".<ARRAY>["i"]) to it as in/out parameter (InOut), you cannot change the value of the 
index tag [i] while the block is being executed. The value is therefore always written back to 
the same ARRAY component from which it was read.
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Syntax
The following syntax is used for the indirect indexing of a ARRAY:
"<Data block>".<ARRAY>["i"] // one-dimensional ARRAY
"<Data block>".<ARRAY>["i"] // one-dimensional ARRAY of STRUCT
"<Data block>".<ARRAY>["i"] // multidimensional ARRAY
"<Data block>".<ARRAY>["i"] // multidimensional ARRAY of STRUCT
 

The syntax has the following components:

Part Description
Data block Name of the data block in which the ARRAY is located
ARRAY Tag of the ARRAY data type
i, j PLC tags of the integer data type that are used as pointers
a Additional partial tag of the structure

Examples
The following example shows indirect array indexing of an ARRAY component in STL: 

Several axes traverse at different angles. The values for axis number and angle are stored in 
the two-dimensional ARRAY "control_axis".

You can use the "SEL" instruction to select the components of the "control_axis" ARRAY to 
be written at the "#out" output parameter. 

The axis number is defined by the constants "Constant_Axis_NoX" and "Constant_Axis_NoY"; 
the angle is defined by the "#Angle" tag.

Addressing in STL  
CALL  SEL  
    value_type:=Int  
    G   :="Select"  
    IN0 :=#control_axis["Constant_Axis_NoX", #Angle]  
    IN1 :=#control_axis["Constant_Axis_NoY", #Angle]  
    OUT :=#out  

The following examples are based on SCL and demonstrate indirect indexing of an ARRAY 
component. "MOTOR" is a one-dimensional ARRAY_of_INT with three rows. "VALUES" is a 
PLC tag of data type "Integer".

Addressing in SCL Explanation
MOTOR[2] := VALUES; (*Direct addressing: Assignment of 

VALUES to the second row of the ARRAY 
MOTOR*)

MOTOR["Tag_1"] := VALUES; (*Indirect addressing: Assignment of 
VALUES  to the rows of ARRAY MOTOR*) 
specified by "Tag_1"
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Addressing in SCL Explanation
#MOTOR["Tag_2"+"Tag_3"] := #Values; (*Indirect addressing: Assignment of 

VALUES to the row of the MOTOR*) ARRAY 
specified by the expression 
"Tag_2"+"Tag_3"

 

The following example shows the indirect indexing of an ARRAY component as an example 
of LAD. "ARRAY" is a three-dimensional ARRAY. "Tag_1", " "Tag_2" and ""Tag_3" are PLC 
tags of the "Integer" data type. Depending on their values, one of the "ARRAY" components 
will be copied to the "MyTarget" tag.

 

Indexing ARRAY components using the "FieldRead" and "FieldWrite" instructions
You may also use the following instructions for indirect indexing of ARRAY components in LAD 
and FBD:

● FieldWrite - Write field

● FieldRead - Read field
For more information on these instructions, refer to the "References" chapter.

Additional information
For more information on the ARRAY data type, refer to "See also".

See also
Basics of indirect addressing (Page 1312)

Addressing structured variables (Page 1306)

Indirect addressing of individual characters of a STRING

Description       
For addressing the individual characters of a STRING or WSTRING, you can specify constants 
and also tags as the index. The tags must be of the Integer data type. When tags are used, 
the index is calculated during runtime. You can, for example, use a different index for each 
cycle in program loops.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1316 System Manual, 02/2014



If you transfer a STRING or WSTRING with variable index to an in/out parameter during a 
block call, please note that: The index tag [i] is read once at the start of the block call and 
cannot be changed by the called block while it is being executed.

 

 Note
Monitoring STRING access in runtime

When a STRING or WSTRING that exceeds the defined length is written in runtime, unwanted 
reactions may occur in the program. Violation of the STRING or WSTRING length is 
monitored in S7-1200/1500. You can choose whether you want to respond to violations with 
the global error handing of the CPU or with separate local error handling.

 

Syntax
The following syntax is used for the indirect indexing of a STRING or WSTRING:
"<Data block>".<STRING>["i"] 
"<Data block>".<WSTRING>["i"]

Example
The indirect indexing of a STRING is illustrated below based on the example of SCL. "STRING" 
is a tag of the STRING data type. "Tag_1" is a PLC tag of the "Integer" data type.

Addressing in SCL Description
STRING["Tag_1"] := CHARACTER; (*Indirect addressing: Assignment of 

"CHARACTER" to the characters of the *) 
STRING specified by "Tag_1"

Additional information
For additional information on the STRING data type, refer to "See also".

See also
STRING (Page 1347)

Indirect addressing in STL

Basic information about address registers

Introduction       
Two address registers are available for the indirect addressing of operands: address register 
1 (AR1), and address register 2 (AR2). The address registers are equal and are 32 bits in 
length. You can store area-internal and cross-area pointers in the address registers. To define 
the address of an operand, you can call the stored data in the program.
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Data is exchanged between the registers and the other available memory areas with the 
assistance of load and transfer instructions. 

 

 Note

In S7-1500, special rules apply to data exchange via address register and data block register: 
● The values in the registers do not remain in existence beyond the block limits.
● The registers are reset when the language is changed within a block.
● You can only reference data in blocks with optimized access if these have the retain setting 

"Set in IDB".
● It is not possible to reference local data in blocks with optimized access with the help of 

the address registers (across areas). 
 

Additional information
For more information on the statements that address registers use and on indirect addressing, 
refer to "See also".

See also
Indirect addressing in STL (Page 1318)

Addressing areas of a tag with slice access (Page 1308)

Indirect addressing in STL
In STL, the following options are available for indirect addressing:

● Memory-indirect addressing

● Register-indirect area-internal addressing

● Register-indirect cross-area addressing

Memory-indirect addressing
In the case of memory-indirect addressing, you store the address in a tag. The tag can be of 
WORD or DWORD data type. The tag can be located in the memory areas "Data" (DB or DI), 
"Bit memory" (M) or "Temporary local data" (L). In S7-1500, FB parameters can also be used 
to store the address. If the tag is located in a data block, it must be a data black with standard 
access.

The following example shows applications of memory-indirect addressing:

Addressing in STL Explanation
U E [MD 2] // Execute an AND logic operation with a variable input 

bit. The address of the input bit is located in the 
memory double word MD2.

= DIX [DBD 2] // Assign the RLO to a variable data bit. The address of 
the data bit is located in the data double word DBD2.
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Addressing in STL Explanation
L EB [DID 4] // Load a variable input byte to ACCU 1. The address of 

the input byte is located in the instance double word 
DID4.

AUF DB [LW 2] // Open a variable data block. The number of the data 
block is located in the local data word LW2.

 

Register-indirect area-internal addressing
Register-indirect addressing uses one of the address registers (AR1 or AR2) to pick up the 
address of the operand. 

In the case of register-indirect, area-internal addressing, you index only the bit address and 
the byte address via the address register (e.g. P#10.0). You do not enter the memory area 
for which the address in the address register is to apply until during programming of the 
instruction. The address in the address register then moves to the memory area specified in 
the instruction. 

Possible memory areas are "Inputs" (I), "Outputs" (Q), "I/O" (PI or PQ), "Bit memory" (M), 
"Temporary local data" (L) and "Data" (DB or DI). If the operand is located in a data block, it 
must be a data black with standard access.

When you enter register-indirect, area-internal addressing, specify an offset after the 
specification of the address register. This offset is added to the contents of the address register 
without changing the address register. This offset also has the format of a pointer. The 
specification of a pointer is mandatory and must be entered as constant (e.g. P#0.0 or 
P#2.0). 

The following example shows an application of register-indirect area-internal addressing:

STL Explanation
LAR1 P#10.0 // Load pointer (P#10.0) to address register 1
L IW [AR1, P#2.0] // Increase contents of address register 1 (P#10.0) by offset 

P#2.0. 
// Load contents of input word IW12 into accumulator 1

L IW [AR1, P#0.0] // Increase contents of address register 1 (P#10.0) by offset 
P#0.0. 
// Load contents of input word IW10 into accumulator 1

 

Register-indirect cross-area addressing
In the case of register-indirect, cross-area addressing, use the address register to index the 
entire address of the operand, in other words, the bit address and byte address, as well as the 
memory area. Possible memory areas are "Inputs" (I), "Outputs" (Q), "I/O" (P), "Bit memory" 
(M), "Temporary local data" (L) and "Data" (DB or DI). If the operand is located in a data block, 
it must be a data black with standard access or the operand must have the retain setting "Set 
in IDB".
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In the instruction, program only the operand width. Possible operand widths are bit, byte, word, 
and double word.

The following example shows an application of register-indirect cross-area addressing:

  
LAR1 P#M10.0 // Load cross-area pointer (P#M10.0) to address register 1
L W [AR1, P#2.0] // Increase contents of address register 1 (P#M10.0) by offset 

P#2.0.
// Load contents of memory word "MW12" into accumulator 1

LAR1 P#A10.0 // Load cross-area pointer (P#A10.0) to address register 1
L W [AR1, P#2.0] // Add contents of address register 1 (P#A10.0) by offset P#2.0

// Load contents of output word QW12.0 into accumulator 1

 
 

 Note
Special features in S7-1500

In S7-1500, special rules apply to data exchange via address register and data block register: 
● The values in the registers do not remain in existence beyond the block limits. The 

registers are also reset when the language is changed within a block. 
● If you access an operand of the BYTE, WORD or DWORD type using register-indirect 

addressing, the address must begin at a byte limit.
Examples: 
LAR1    P#0.0                                                                                           
L MW [AR1, P#0.0]   // P#0.0 + P#0.0 = P#0.0 - The addressing is allowed, because P#0.0 
points to a byte limit. 
L MW [AR1, P#2.1]  //  P#0.0 + P#2.1 = P#2.1 - The addressing is not allowed, because 
P#2.1 does not point to a byte limit.

 

See also
Basics of indirect addressing (Page 1312)

Addressing structured variables (Page 1306)

Basic information about address registers (Page 1317)

9.1.1.5 Data types

Overview of the valid data types

Validity of data type groups
The data type groups define the properties of the data, for example, the representation of the 
contents and the valid memory areas. In the user program, you can use predefined data type 
or also data types that you have defined.
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The following tables show the availability of predefined data types in the various S7-CPUs:

Table 9-1 Binary numbers

Binary numbers S7-300/400 S7-1200 S7-1500
BOOL (Page 1324) X X X
Bit strings
BYTE (Page 1325) X X X
WORD (Page 1326) X X X
DWORD (Page 1327) X X X
LWORD (Page 1327) - - X

Table 9-2 Integers

Integers S7-300/400 S7-1200 S7-1500
SINT (Page 1328) - X X
INT (Page 1330) X X X
DINT (Page 1332) X X X
USINT (Page 1329) - X X
UINT (Page 1331) - X X
UDINT (Page 1332) - X X
LINT (Page 1333) - - X
ULINT (Page 1335) - - X

Table 9-3 Floating-point numbers

Floating-point numbers S7-300/400 S7-1200 S7-1500
REAL (Page 1336) X X X
LREAL (Page 1337) - X X

Table 9-4 Timers

Timers S7-300/400 S7-1200 S7-1500
S5TIME (Page 1339) X - X
TIME (Page 1341) X X X
LTIME (Page 1341) - - X

Table 9-5 Date and time

Date and time S7-300/400 S7-1200 S7-1500
DATE (Page 1342) X X X
TIME_OF_DAY (TOD) (Page 1343) X X X
LTOD (LTIME_OF_DAY) (Page 1343) - - X
DT (DATE_AND_TIME) (Page 1344) X - X
LDT (Page 1345) - - X
DTL (Page 1345) - X X
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Table 9-6 Character

Character S7-300/400 S7-1200 S7-1500
CHAR (Page 1346) X X X
WCHAR (Page 1347) - - X
STRING (Page 1347) X X X
WSTRING (Page 1349) - - X

Table 9-7 Array

Array S7-300/400 S7-1200 S7-1500
ARRAY [….] OF <type> (Page 1351) X X X

Table 9-8 Structures

Structures S7-300/400 S7-1200 S7-1500
STRUCT (Page 1355) X X X

Table 9-9 Pointer

Pointer S7-300/400 S7-1200 S7-1500
POINTER (Page 1356) X - X
ANY (Page 1358) X - X
VARIANT (Page 1361) - X X

Table 9-10 Parameter types

Parameter types S7-300/400 S7-1200 S7-1500
TIMER (Page 1363) X - X
COUNTER (Page 1363) X - X
BLOCK_FC (Page 1363) X - X
BLOCK_FB (Page 1363) X - X
BLOCK_DB (Page 1363) X - -
BLOCK_SDB (Page 1363) X - -
BLOCK_SFB (Page 1363) X - -
BLOCK_SFC (Page 1363) X - -
BLOCK_OB (Page 1363) X X X
VOID (Page 1363) X X X

Table 9-11 PLC data types

PLC data types S7-300/400 S7-1200 S7-1500
PLC data type (Page 1364) X X X
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Table 9-12 System data types

System data types S7-300/400 S7-1200 S7-1500
IEC_TIMER (Page 1365) X1) X X
IEC_LTIMER (Page 1365) - - X
IEC_SCOUNTER (Page 1365) - X X
IEC_USCOUNTER (Page 1365) - X X
IEC_COUNTER (Page 1365) X2) X X
IEC_UCOUNTER (Page 1365) - X X
IEC_DCOUNTER (Page 1365) - X X
IEC_UDCOUNTER (Page 1365) - X X
IEC_LCOUNTER (Page 1365) - - X
IEC_ULCOUNTER (Page 1365) - - X
ERROR_STRUCT (Page 1365) - X X
NREF (Page 1365) - X X
CREF (Page 1365) - X X
FBTREF (Page 1365) - - -
VREF (Page 1365) - - -
STARTINFO (Page 1365) X - X
SSL_HEADER (Page 1365) X - X
CONDITIONS (Page 1365) - X X
TADDR_Param (Page 1365) - X X
TCON_Param (Page 1365) - X X
1) For S7-300/400 CPUs, the data type is represented by TP, TON and TOF.
2) For S7-300/400 CPUs, the data type is represented by CTU, CTD and CTUD.

Table 9-13 Hardware data types

Hardware data types S7-300/400 S7-1200 S7-1500
REMOTE (Page 1367) - X X
GEOADDR (Page 1367) - - X
HW_ANY (Page 1367) - X X
HW_DEVICE (Page 1367) - X X
HW_DPMASTER (Page 1367) - - X
HW_DPSLAVE (Page 1367) - X X
HW_IO (Page 1367) - X X
HW_IOSYSTEM (Page 1367) - X X
HW_SUBMODULE (Page 1367) - X X
HW_MODULE (Page 1367) - - X
HW_INTERFACE (Page 1367) - X X
HW_IEPORT (Page 1367) - X X
HW_HSC (Page 1367) - X X
HW_PWM (Page 1367) - X X
HW_PTO (Page 1367) - X X
AOM_AID (Page 1367) - X X

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1323



Hardware data types S7-300/400 S7-1200 S7-1500
AOM_IDENT (Page 1367) - X X
EVENT_ANY (Page 1367) - X X
EVENT_ATT (Page 1367) - X X
EVENT_HWINT (Page 1367) - X X
OB_ANY (Page 1367) - X X
OB_DELAY (Page 1367) - X X
OB_TOD (Page 1367) - X X
OB_CYCLIC (Page 1367) - X X
OB_ATT (Page 1367) - X X
OB_PCYCLE (Page 1367) - X X
OB_HWINT (Page 1367) - X X
OB_DIAG (Page 1367) - X X
OB_TIMEERROR (Page 1367) - X X
OB_STARTUP (Page 1367) - X X
PORT (Page 1367) - X X
RTM (Page 1367) - X X
PIP (Page 1367) - - X
CONN_ANY (Page 1367) - X X
CONN_PRG (Page 1367) - X X
CONN_OUC (Page 1367) - X X
CONN_R_ID (Page 1367) - - X
DB_ANY (Page 1367) - X X
DB_WWW (Page 1367) - X X
DB_DYN (Page 1367) - X X

 

 Note

Depending on the CPU version, the actually valid data types can deviate slightly from the 
table.

 

Binary numbers

BOOL (bit)

Description
An operand of data type BOOL represents a bit value and contains one of the following values:

● TRUE

● FALSE

The following table shows the properties of data type BOOL:

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1324 System Manual, 02/2014



Length (bits) Format Range of values Examples of value input 
1 Boolean FALSE or TRUE

BOOL#0 or BOOL#1
BOOL#FALSE or 
BOOL#TRUE

TRUE
BOOL#1
BOOL#TRUE

Unsigned integers 0 or 1 1
Binary numbers 2#0 or 2#1 2#0
Octal numbers 8#0 or 8#1 8#1
Hexadecimal numbers 16#0 or 16#1 16#1

 

 Note
Applies to CPUs of the S7-1500 series

For a block with the block property "Optimized block access", the bit has a length of 1 byte.
 

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Bit strings

BYTE (byte)

Description
An operand of data type BYTE is a bit string of 8 bits.

The following table shows the properties of data type BYTE:

Length 
(bits)

Format Value range Examples of value input

8 Unsigned integers1) -128 to +127 or 0 to +255 15, BYTE#15, B#15
Binary numbers 2#0 to 2#11111111 2#00001111, 

BYTE#2#00001111, 
B#2#00001111

Octal numbers 8#0 to 8#377 8#17, BYTE#8#17, B#8#17
Hexadecimal numbers B#16#0 to B#16#FF, 16#0 

to 16#FF
16#0F, BYTE#16#0F, 
B#16#0F

1) The value range depends on the relevant interpretation or conversion.
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 Note

The BYTE data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the SINT and USINT data types.

 

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

WORD

Description
An operand of data type WORD is a bit string of 16 bits.

The following table shows the properties of data type WORD:

Length 
(bits)

Format Value range Examples of value input

16 Unsigned integers -32768 to 65535 61680, WORD#61680, 
W#61680

Binary numbers 2#0 to 2#1111111111111111 2#1111000011110000, 
WORD#2#11110000111100
00, 
W#2#1111000011110000

Octal numbers 8#0 to 8#177777 8#170360, 
WORD#8#170360, 
W#8#170360

Hexadecimal numbers W#16#0 to W#16#FFFF, 16#0 
to 16#FFFF

16#F0F0, WORD#16#F0F0, 
W#16#F0F0

BCD C#0 to C#999 C#55
Decimal sequence B#(0, 0) to B#(255, 255) B#(127, 200)

 

 Note

The WORD data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the INT and UINT data types.

 

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)
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DWORD

Description
An operand of data type DWORD is a bit string of 32 bits.

The following table shows the properties of data type DWORD:

Length 
(bits)

Format Value range Examples of value input

32 Unsigned integers -2147483648 to 4294967295 15793935, DWORD#15793935, 
DW#15793935

Binary numbers 2#0 to 
2#11111111111111111111
111111111111

2#0000000011110000111111110
0001111, 
DWORD#2#00000000111100001
111111100001111, 
DW#2#000000001111000011111
11100001111

Octal numbers 8#0 to 8#37777777777 8#74177417, 
DWORD#8#74177417, 
DW#8#74177417

Hexadecimal 
numbers

DW#16#00000000 to 
DW#16#FFFFFFFF, 
16#00000000 to 
16#FFFFFFFF

16#00F0FF0F, 
DWORD#16#00F0FF0F, 
DW#16#00F0FF0F

Decimal sequence B#(0, 0, 0, 0) to B#(255, 255, 
255, 255)

B#(127, 200, 127, 200)

 

 Note

The DWORD data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the DINT and UDINT data types.

 

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

LWORD

Description
An operand of data type LWORD is a bit string of 64 bits.

The following table shows the properties of data type LWORD:
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Length 
(bits)

Format Value range Examples of value input

64 Unsigned integers -9223372036854775808 to 
18446744073709551615

26123590360715, 
LWORD#26123590360715, 
LW#26123590360715

Binary numbers 2#0 to 
2#11111111111111111111
1111111111111111111111
1111111111111111111111

2#0000000000000000000101111
100001001011110101001011011
11010001011, 
LWORD#2#00000000000000000
001011111000010010111101010
0101101111010001011, 
LW#2#000000000000000000010
111110000100101111010100101
101111010001011

Octal numbers 8#0 to 
8#17777777777777777777
77

8#13724557213, 
LWORD#8#13724557213, 
LW#8#13724557213

Hexadecimal 
numbers

LW#16#00000000 to 
LW#16#FFFFFFFFFFFFFF
FF, 16#00000000 to 
16#FFFFFFFFFFFFFFFF

16#000000005F52DE8B, 
LWORD#16#000000005F52DE8
B, LW#16#000000005F52DE8B

Decimal sequence B#(0, 0, 0, 0, 0, 0, 0, 0) to 
B#(255, 255, 255, 255, 255, 
255, 255, 255)

B#(127, 200, 127, 200, 127, 200, 
127, 200)

 

 Note

The LWORD data type cannot be compared for more than or less than. It can only be supplied 
with the same decimal data that can be processed by the LINT and ULINT data types.

 

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Integers

SINT (8-bit integers)

Description
An operand of data type SINT (Short INT) has a length of 8 bits and consists of two 
components: a sign and a numerical value in the two's complement. The signal states of bits 
0 to 6 represent the number value. The signal state of bit 7 represents the sign. The sign may 
assume "0" for the positive, or "1" for the negative signal state.

An operand of data type SINT occupies one BYTE in the memory.

The following table shows the properties of data type SINT:
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Length 
(bits)

Format Range of values Examples of value input

8 Signed integers -128 to 127 +44, SINT#+44
Binary numbers 2#0 to 2#01111111 2#00101100, 

SINT#2#00101100
Octal numbers (only 
positive)

8#0 to 8#177 8#54, SINT#8#54

Hexadecimal numbers 
(only positive)

16#0 to 16#7F 16#2C, SINT#16#2C

Example
The following figure shows the integer +44 as a binary number:

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

USINT (8-bit integers)

Description
An operand of data type USINT (Unsigned Short INT) has a length of 8 bits and contains 
unsigned numerical values:

An operand of data type USINT occupies one BYTE in the memory.

The following table shows the properties of data type USINT:

Length 
(bits)

Format Range of values Examples of value input

8 Unsigned integers 0 to 255 78, USINT#78
Binary numbers 2#0 to 2#11111111 2#01001110, 

USINT#2#01001110
Octal numbers 8#0 to 8#377 8#116, USINT#8#116
Hexadecimal numbers 16#0 to 16#FF 16#4E, USINT#16#4E
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Example
The following figure shows the integer 78 as a binary number:

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

INT (16-bit integers)

Description
An operand of data type INT has a length of 16 bits and consists of two components: a sign 
and a numerical value in the two's complement. The signal states of bits 0 to 14 represent the 
number value. The signal state of bit 15 represents the sign. The sign may assume "0" for the 
positive, or "1" for the negative signal state.

An operand of data type INT occupies two BYTE in the memory.

The following table shows the properties of data type INT:

Length 
(bits)

Format Range of values Examples of value input

16 Signed integers -32768 to 32767 +3785, INT#+3785
Binary numbers (only 
positive)

2#0 to 
2#0111111111111111

2#0000111011001001, 
INT#2#0000111011001001

Octal numbers 8#0 to 8#77777 8#7311, INT#8#7311
Hexadecimal numbers (only 
positive)

16#0 to 16#7FFF 16#0EC9, INT#16#0EC9

Example
The following figure shows the integer +3785 as a binary number:
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See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

UINT (16-bit integers)

Description
An operand of data type UINT (Unsigned INT) has a length of 16 bits and contains unsigned 
numerical values.

An operand of data type UINT occupies two BYTE in the memory.

The following table shows the properties of data type UINT:

Length 
(bits)

Format Range of values Examples of value input

16 Unsigned integers 0 to 65535 65295, UINT#65295
Binary numbers 2#0 to 2#1111111111111111 2#1111111100001111, 

UINT#2#1111111100001111
Octal numbers 8#0 to 8#177777 8#177417, UINT#8#177417
Hexadecimal 
numbers

16#0 to 16#FFFF 16#FF0F, UINT#16#FF0F

Example
The following figure shows the integer 65295 as a binary number:

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)
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DINT (32-bit integers)

Description
An operand of data type DINT (Double INT) has a length of 32 bits and consists of two 
components: a sign and a numerical value in the two's complement. The signal states of bits 
0 to 30 represent the number value. The signal state of bit 31 represents the sign. The sign 
may assume "0" for the positive, or "1" for the negative signal state. 

An operand of data type DINT occupies four BYTE in the memory.

The following table shows the properties of data type DINT:

Length 
(bits)

Format Range of values Examples of value input

32 Signed integers -2147483648 to +2147483647 125790, DINT#125790, L#275
Binary numbers (only 
positive)

2#0 to 
2#0111111111111111111111
1111111111

2#0000000000000001111010
1101011110, 
DINT#2#00000000000000011
110101101011110

Octal numbers (only 
positive)

8#0 to 8#17777777777 8#365536, DINT#8#365536

Hexadecimal 
numbers

16#00000000 to 
16#7FFFFFFF

16#0001EB5E, 
DINT#16#0001EB5E

Example
The following figure shows the integer +125790 as a binary number:

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

UDINT (32-bit integers)

Description
An operand of data type UDINT (Unsigned Double INT) has a length of 32 bits and contains 
unsigned numerical values.
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An operand of data type UDINT occupies four BYTE in the memory.

The following table shows the properties of data type UDINT:

Length 
(bits)

Format Range of values Examples of value input

32 Unsigned integers 0 to 4294967295 4042322160, 
UDINT#4042322160

Binary numbers 2#0 to 
2#111111111111111111
11111111111111

2#1111000011110000111100001
1110000, 
UDINT#2#111100001111000011
11000011110000

Octal numbers 8#0 to 8#37777777777 8#36074170360, 
UDINT#8#36074170360

Hexadecimal numbers 16#00000000 to 
16#FFFFFFFF

16#F0F0F0F0, 
UDINT#16#F0F0F0F0

Example
The following figure shows the integer 4042322160 as a binary number:

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

LINT (64-bit integers)

Description
An operand of data type LINT (Long INT) has a length of 64 bits and consists of two 
components: a sign and a numerical value in the two's complement. The signal states of bits 
0 to 62 represent the number value. The signal state of bit 63 represents the sign. The sign 
may assume "0" for the positive, or "1" for the negative signal state. 

An operand of data type LINT occupies eight BYTE in the memory.

The following table shows the properties of data type LINT:
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Length (bits) Format Range of values Examples of value input
64 Signed integers -9223372036854775808 to 

+9223372036854775807
+154325790816159, LINT#
+154325790816159

Binary numbers (only 
positive)

2#0 to 
2#0111111111111111111111111111
111111111111111111111111111111
111111

2#0000000000000000100011000101
101111000101111100001111011110
011111, 
LINT#2#00000000000000001000110
001011011110001011111000011110
11110011111

Octal numbers 8#0 to 8#777777777777777777777 8#4305570574173637, 
LINT#8#4305570574173637

Hexadecimal numbers 
(only positive)

16#0 to 16#7FFFFFFFFFFFFFFF 16#00008C5BC5F0F79F, 
LINT#16#00008C5BC5F0F79F

Example
The following figure shows the integer +154325790816159 as a binary number:

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)
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ULINT (64-bit integers)

Description
An operand of data type ULINT (Unsigned Long INT) has a length of 64 bits and contains 
unsigned numerical values.

An operand of data type ULINT occupies eight BYTE in the memory.

The following table shows the properties of data type ULINT:

Length (bits) Format Value range Examples of value input
64 Unsigned integers 0 to 18446744073709551615 154325790816159, 

ULINT#154325790816159
Binary numbers 2#0 to 

2#1111111111111111111111111111
111111111111111111111111111111
111111

2#0000000000000000100011000101
101111000101111100001111011110
011111, 
ULINT#2#000000000000000010001
100010110111100010111110000111
1011110011111

Octal numbers 8#0 to 8#1777777777777777777777 8#4305570574173637, 
ULINT#8#4305570574173637

Hexadecimal numbers 16#0 to 16#FFFFFFFFFFFFFFFF 16#00008C5BC5F0F79F, 
ULINT#16#00008C5BC5F0F79F

Example
The following figure shows the integer 154325790816159 as a binary number:
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See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Floating-point numbers

REAL

Description
Operands of the data type REAL have a length of 32 bits and are used to display floating-point 
numbers. An operand of the REAL data type consists of the following three components:

● Sign: The sign is determined by the signal state of bit 31. The bit 31 assume the value "0" 
(positive) or "1" (negative).

● 8-bit exponents to basis 2: The exponent is increased by a constant (base, +127), so that 
it has a value range of 0 to 255.

● 23-bit mantissa: Only the fraction part of the mantissa is shown. The integer part of the 
mantissa is always 1 with normalized floating-point numbers and is not stored.

The REAL data type is processed with a precision of 7 digits after the decimal point.

The following figure shows the structure of the REAL data type:

 

 Note

With floating-point numbers, only the precision defined by the IEEE754 standard is stored. 
Additionally specified decimals are rounded off according to IEEE754.

The number of decimal places may decrease for frequently nested arithmetic calculations.

If more decimal places are specified than can be stored by the data type, the number is 
rounded to the corresponding value of the precision allowed by this value range .

 

The following table shows the properties of data type REAL:
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Length 
(bits)

Format Value range Examples of value input

32 Floating-point 
numbers according 
to IEEE754

-3.402823e+38 to -1.175495e-38
±0.0
+1.175495e-38 to +3.402823e+38

1.0e-5, REAL#1.0e-5

Floating-point 
numbers

1.0, REAL#1.0

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

LREAL

Description
Operands of the data type LREAL have a length of 64 bits and are used to represent floating-
point numbers. An operand of the LREAL data type consists of the following three components:

● Sign: The sign is determined by the signal state of bit 63. The bit 63 assumes the value "0" 
(positive) or "1" (negative).

● 11-bit exponents to base 2: The exponent is increased by a constant (base, +1023), so that 
it has a value range of 0 to 2047.

● 52-bit mantissa: Only the fraction part of the mantissa is shown. The integer part of the 
mantissa is always 1 with normalized floating-point numbers and is not stored.

The LREAL data type is processed with a precision of 15 digits after the decimal point.

The following figure shows the structure of the LREAL data type:

The following table shows the properties of data type LREAL:

Length 
(bits)

Format Value range Examples of value input

64 Floating-point 
numbers according 
to IEEE754

-1.7976931348623158e+308 to 
-2.2250738585072014e-308
±0.0
+2.2250738585072014e-308 to 
+1.7976931348623158e+308

1.0e-5, LREAL#1.0e-5

Floating-point 
numbers

1.0, LREAL#1.0
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 Note

With floating-point numbers, only the precision defined by the IEEE754 standard is stored. 
Additionally specified decimals are rounded off according to IEEE754.

The number of decimal places may decrease for frequently nested arithmetic calculations.

If more decimal places are specified than can be stored by the data type, the number is 
rounded to the corresponding value of the precision allowed by this value range .

 

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Invalid floating-point numbers

Description
We distinguish between four number ranges for data types REAL and LREAL:

● normalized numbers stored with full accuracy

● denormalized numbers not stored with full accuracy

● Infinite numbers: +Inf/-Inf (infinity)

● Invalid numbers: NaN (Not a Number)
 

 Note

Floating-point numbers are stored as specified by the IEEE754 standard. Results of 
conversion or arithmetic functions with a denormalized, infinite or NaN (Not a Number) floating 
point depend on the CPU. 

 

If you are not working with normalized floating-point numbers in mathematical functions, the 
result will show significant differences depending on the series of the CPU which you are using.

A CPU cannot calculate with denormalized floating-point numbers, with the exception of older 
CPU versions of the S7-300 and S7-400 series. The bit pattern of a denormalized number is 
interpreted as a zero. If the result of calculation falls into this range, it is continued with zero; 
the status bits OV and OS are set (number range undershoot).

Even though the values of invalid floating-point numbers can only be displayed with limited 
accuracy for mathematical functions, numbers with an exponent of -39 (e.g., 2.4408e-039) can 
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be monitored in the TIA Portal and therefore do not necessarily represent a faulty result. This 
means that floating-point values may be located outside the range of valid numerical values.

 

 Note
The following applies to CPUs of the series S7-1200 V1, V2 and V3:

The comparison operation "Equal" uses the bit pattern of the invalid floating-point number. If 
two "NaN numbers" with the same bit pattern are compared, the output of the "Equal" 
comparison operation returns the result TRUE.

 

 Note
The following applies to CPUs of the S7-1200 V4 and S7-1500 series:

If two invalid numbers (NaN) are compared with each other, the result is always FALSE, 
regardless of the bit pattern of the invalid number or the relation (>, >, ...).

 

 Note
Comparison of denormalized floating-point numbers

For the comparison operation "Equal" with two denormalized floating-point numbers, the 
output for CPUs of the S7-300/400 series is set to the signal state "0" and for CPUs of the 
S7-1200/1500 series to the signal state "1".

 

If the input variables of a mathematical function represent an invalid floating-point number, an 
invalid floating-point number will also be output as result.

You have the following options to evaluate possible errors caused by invalid floating-point 
numbers:

● In LAD/FBD and SCL, you can query the enable output ENO for FALSE

● In STL, you can evaluate the status bit OV

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Timers

S5TIME (duration)

Format
Data type S5TIME stores the duration in BCD format. The duration is the product from a time 
in the range 0 to 999 and a time basis. The time basis indicates the interval at which a timer 
decrements the time value by one unit until it reaches "0". The resolution of the times can be 
controlled via the time basis.
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The following table shows the range of values for data type S5TIME:

Length 
(bits)

Format Range of values Examples of value input

16 S7 time in 
increments of 10 
ms (default value)

S5T#0MS to 
S5T#2H_46M_30S_0MS

S5T#10s, S5TIME#10s

Hexadecimal 
numbers

16#0 to 16#3999 16#2

The following table shows the time base coding for S5TIME:

Time basis Binary code for time basis
10 ms 00
100 ms 01
1 s 10
10 s 11

Always observe range limits and the resolution of time values when using data type S5TIME 
with timers. The table below specifies the range associated with each resolution:

Resolution Range
0.01 s 10 ms to 9 s 990 ms
0.1 s 100 ms to 1 min 39 s 900 ms
1 s 1 s to 16 min 39 s
10 s 10 s to 2 h 46 min 30 s

Values that exceed 2h46m30s are not accepted.

Example
The following figure shows the content of the time operand for a time value of 127 and a time 
base of 1 s:
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See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

TIME (IEC time)

Description
The contents of an operand of the data type TIME is interpreted as milliseconds. The 
representation contains information for days (d), hours (h), minutes (m), seconds (s) and 
milliseconds (ms).

The following table shows the properties of data type TIME:

Length 
(bits)

Format Value range Examples of value input

32 Signed duration T#-24d20h31m23s648ms to 
T#+24d20h31m23s647ms

T#10d20h30m20s630ms, 
TIME#10d20h30m20s630ms

Hexadecimal 
numbers

16#00000000 to 
16#7FFFFFFF

16#0001EB5E

It is not necessary to specify all time units. T#5h10s is a valid entry, for example. If only one 
unit is specified, the absolute value of days, hours, and minutes must not exceed the high or 
low limits. When more than one time unit is specified, the value must not exceed 24 days, 23 
hours, 59 minutes, 59 seconds or 999 milliseconds.

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

LTIME (IEC time)

Description
The contents of an operand of data type LTIME is interpreted as nanoseconds. The 
representation contains information for days (d), hours (h), minutes (m), seconds (s) and 
milliseconds (ms), microseconds (us) and nanoseconds (ns).

The following table shows the properties of data type LTIME:
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Length 
(bits)

Format Range of values Examples of value input

64 Signed duration LT#-106751d23h47m16s854ms7
75us808ns to LT#
+106751d23h47m16s854ms775u
s807ns

LT#11350d20h25m14s830ms6
52us315ns, 
LTIME#11350d20h25m14s830
ms652us315ns

Hexadecimal 
numbers

16#0 to 16#8000000000000000 16#2

It is not necessary to specify all time units. LT#5h10s is therefore a valid entry, for example. If 
only one unit is specified, the absolute value of days, hours, and minutes must not exceed the 
high or low limits. When more than one time unit is specified, the value must not exceed 106751 
days, 23 hours, 59 minutes, 59 seconds, 999 milliseconds, 999 microseconds or 999 
nanoseconds.

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Date and time

DATE

Format
The DATE data type saves the date as an unsigned integer. The representation contains the 
year, the month, and the day.

The contents of an operand of DATE data type correspond in hexadecimal format to the 
number of days since 01-01-1990 (16#0000).

The following table shows the properties of data type DATE:

Length 
(bytes)

Format Range of values Examples of value input

2 IEC date
(Year-Month-Day)

D#1990-01-01 to 
D#2168-12-31

D#2009-12-31, DATE#2009-12-31

Hexadecimal 
numbers

16#0000 to 16#FF62 16#00F2

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)
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TIME_OF_DAY (TOD)

Format
Data type TOD (TIME_OF_DAY) occupies a double word and stores the number of 
milliseconds since the beginning of the day (0:00 h) as unsigned integer.

The following table shows the properties of data type TOD:

Length 
(bytes)

Format Range of values Examples of value input

4 Time-of-day 
(hours:minutes:seconds)

TOD#00:00:00.000 to 
TOD#23:59:59.999

TOD#10:20:30.400, 
TIME_OF_DAY#10:20:30.40
0

You always need to specify the hours, minutes and seconds. The specification of milliseconds 
is optional.

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

LTOD (LTIME_OF_DAY)

Format
Data type LTOD (LTIME_OF_DAY) occupies two double words and stores the number of 
nanoseconds since the beginning of the day (0:00 h) as unsigned integer.

The following table shows the properties of data type LTOD:

Length 
(bytes)

Format Range of values Examples of value input

8 Time-of-day 
(hours:minutes:seconds.millis
econds.microseconds.nanose
conds)

LTOD#00:00:00.0000000
00 to 
LTOD#23:59:59.9999999
99

LTOD#10:20:30.400_365_21
5, 
LTIME_OF_DAY#10:20:30.4
00_365_215

You always need to specify the hours, minutes and seconds. The specification of milliseconds, 
microseconds and nanoseconds is optional.

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)
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DATE_AND_TIME (date and time of day) 

Format
The DT (DATE_AND_TIME) data type saves the information on date and time of day in BCD 
format. 

The following table shows the properties of data type DT:

Length 
(bytes)

Format Range of values Example of value input

8 Date and time
(year-month-day-
hour:minute:second:millisecond 
3))

Min.: 
DT#1990-01-01-00:0
0:00.000
Max.: 
DT#2089-12-31-23:5
9:59.999

DT#2008-10-25-8:12:34.567, 
DATE_AND_TIME#2008-10-25
-08:12:34.567

The following table shows the structure of the DT data type:

Byte Contents Range of values
0 Year 0 to 99

(Years 1990 to 2089)
BCD#90 = 1990
...
BCD#0 = 2000
...
BCD#89 = 2089

1 Month BCD#0 to BCD#12
2 Day BCD#1 to BCD# 31
3 Hour BCD#0 to BCD#23
4 Minute BCD#0 to BCD#59
5 Second BCD#0 to BCD#59
6 The two most significant digits of MSEC BCD#0 to BCD#999
7 (4MSB) 1) The least significant digit of MSEC BCD#0 to BCD#9
7 (4LSB) 2) Weekday BCD#1 to BCD#7

BCD#1 = Sunday
...
BCD#7 = Saturday

1) MSB: Most significant bit
2) LSB: Least significant bit
3) Fixed point number
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See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

LDT (DATE_AND_LTIME) 

Format
Data type LDT (DATE_AND_LTIME) stores the date and time-of-day information in 
nanoseconds since 01/01/1970 0:0.

The following table shows the properties of data type LDT:

Length 
(bytes)

Format Range of values Example of value input

8 Date and time
(Year-Month-Day-
Hour:Minute:Second)

Min.: 
LDT#1970-01-01-0:0:0.0000
00000
Max.: 
LDT#2200-12-31-23:59:59.9
99999999

LDT#2008-10-25-8:12:34.567

Hexadecimal numbers 16#0 to 
16#7FFF_FFFF_FFFF_FFF
F

16#7FFF

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

DTL

Description
An operand of data type DTL has a length of 12 bytes and stores date and time information in 
a predefined structure.

The following table shows the properties of data type DTL:

Length 
(bytes)

Format Value range Example of value input

12 Date and time
(Year-Month-Day-
Hour:Minute:Second.Nanos
econds)

Min.: 
DTL#1970-01-01-00:00:00.0
Max.: 
DTL#2200-12-31-23:59:59.9
99999999

DTL#2008-12-16-20:30:20
.250
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The structure of data type DTL consists of several components each of which can contain a 
different data type and range of values. The data type of a specified value must match the data 
type of the corresponding components.

The following table shows the structure components of data type DTL and their properties:

Byte Component Data type Value range
0 Year UINT 1970 to 2200
1
2 Month USINT 1 to 12
3 Day USINT 1 to 31
4 Weekday USINT 1(Sunday) to 7(Saturday)

The weekday is not considered in the value 
entry.

5 Hour USINT 0 to 23
6 Minute USINT 0 to 59
7 Second USINT 0 to 59
8 Nanosecond UDINT 0 to 999999999
9
10
11

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Character strings

CHAR (character)

Description
An operand of data type CHAR has a length of 8 bits and occupies one BYTE in the memory.

The CHAR data type stores a single character in ASCII format. You can find information on 
the encoding of special characters under "See also > STRING".

The following table shows the value range of the CHAR data type:

Length 
(bits)

Format Value range Example of value inputs

8 ASCII characters ASCII character set 'A', CHAR#'A'
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See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

STRING (Page 1347)

WCHAR (character)

Description
An operand of data type WCHAR (Wide Characters) has a length of 16 bits and occupies two 
BYTE in the memory.

The WCHAR data type saves a single character of an expanded character set which is stored 
in Unicode format. However, only a subset of the entire Unicode range is covered. When a 
control character is entered, it is represented with a dollar sign.

The following table shows the value range of the WCHAR data type:

Length (bits) Format Range of values Example of value input
16 Unicode $0000 - $D7FF WCHAR#'a'

See also
Overview of the valid data types (Page 1320)

STRING

Description
An operand of the STRING data type saves several characters in a character string that can 
consist of up to 254 characters. In a character string, all characters of the ASCII code are 
permitted. The characters are specified in single quotation marks.

The following table shows the properties of a STRING tag:

Length (bytes) Format Value range Example of value input
n + 2 * ASCII character string 

incl. special characters
0 to 254 characters 'Name', STRING#'NAME'

* An operand of the STRING data type occupies two bytes more than the specified maximum length 
in the memory.

A character string can also contain special characters. The escape character $ is used to 
identify control characters, dollar signs and single quotation marks.

The table below shows examples for the notation of special characters:
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Character Hex Meaning Example
$L or $l 0A Line feed '$LText', '$0AText'
$N 0A and 0D Line break

The line break occupies 2 characters 
in the character string.

'$NText', '$0A$0DText'

$P or $p 0C Page feed '$PText', '$0CText'
$R or $r 0D Carriage return (CR) '$RText','$0DText'
$T or $t 09 Tab '$TText', '$09Text'
$$ 24 Dollar sign '100$$t', '100$26'
$' 27 Single quotation mark '$'Text$'','$27Text$27'

The maximum length of the character string can be specified during the declaration of an 
operand using square brackets after the keyword STRING (for example,  STRING[4]). If the 
specification of the maximum length is omitted, the standard length of 254 characters is set 
for the respective operand.

If the actual length of a specified character string is shorter than the declared maximum length, 
the characters are written to the character string left-justified and the remaining character 
spaces remain undefined. Only occupied character spaces are considered in the value 
processing.

 

 Note

For S7-300/400 CPUs, please note: If a temporary tag of the STRING data type was defined, 
you must describe the BYTE "Max. length of string" with the defined length before you use 
the tags in the user program.

 

Example
The example below shows the byte sequence if the STRING[4] data type is specified with 
output value 'AB':

See also
Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)
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WSTRING

Description
An operand of data type WSTRING (Wide String) stores several Unicode characters of data 
type WCHAR in one character string. If you do not specify a length, the character string has 
a preset length of 254 characters. In a character string, all characters of the Unicode format 
are permitted. This means you can also use Chinese characters in a character string.

When declaring an operand of data type WSTRING you can define its length using square 
brackets (for example WSTRING[10]). If you do not specify a length, the length of the 
WSTRING is set to 254 characters by default. You can declare a length of up to 16382 
characters (WSTRING[16382]).

 

 Note
Use in the watch table

If you wish to monitor or control a tag with data type WSTRING in the watch table, it cannot 
contain more than 254 characters.

 

The specification of the characters occurs in single quotes and always with the qualifier 
WSTRING#.

The table below shows the properties of a WSTRING tag:

Length (WORD) Format Range of values Example of value input
n + 2 * Unicode character 

string;
n specifies the length of 
the character string.

Preset value: 0 to 254 
characters
Max. possible value: 0 
to 16382

WSTRING#'Hello 
World'

* An operand of the WSTRING data type occupies two WORDs more in the memory than the specified 
maximum length.

A character string can also contain special characters. The escape character $ is used to 
identify control characters, dollar signs and single quotation marks.

The table below shows examples for the notation of special characters:

Character Hex Meaning Example
$L or $l 000A Line feed '$LText', '$000AText'
$N 000A and 000D Line break

The line break occupies 2 characters 
in the character string.

'$NText', '$000A
$000DText'

$P or $p 000C Page feed '$PText', '$000CText'
$R or $r 000D Carriage return (CR) '$RText','$000DText'
$T or $t 0009 Tab '$TText', '$0009Text'
$$ 0024 Dollar sign '100$$t', '100$0024t'
$' 0027 Single quotation mark '$'Text$'','$0027Text

$0027'
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The maximum length of the character string can be specified during the declaration of an 
operand using square brackets after the keyword WSTRING (for example, WSTRING[4]). If 
the specification of the maximum length is omitted, the standard length of 254 characters is 
set for the respective operand.

If the actual length of a specified character string is shorter than the declared maximum length, 
the characters are written to the character string left-justified and the remaining character 
spaces remain undefined. Only occupied character spaces are considered in the value 
processing.

 

 Note
Conversion of WSTRING tags

Implicit conversion of the WSTRING data type is not possible. Explicit conversion from the 
WSTRING data type to STRING is generally possible. However, normally only the conversion 
of characters in the code range from 0 - 127 will work in all Windows code pages. For all 
characters outside this range, the code page character and the Unicode character must be 
in exactly the same position for the conversion to work without errors.

 

Access to block parameters of data type WSTRING
Operands of the data type WSTRING can be transferred as parameters up to the maximum 
length for blocks with "optimized" access.

For function blocks (FB) with "standard" access, operands of the data type WSTRING can be 
declared as parameters in all sections of the block interface except in the section "InOut". For 
a function (FC) with "standard" access, only operands of the data type STRING can be 
transferred as parameters.

The function value of an FC in the "Return" section and expressions in the SCL programming 
language are another exception to this rule. In these cases, the WSTRING tag must not be 
longer than 1022 characters. If you need a WSTRING tag with more than 1022 characters, 
declare a tag of the data type "WSTRING" with the required character length in the section 
"Temp" and assign the function value to the tag.

Example
The example below shows the byte sequence if the WSTRING[4] data type is specified with 
output value 'AB':
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See also
Overview of the valid data types (Page 1320)

Array

Format of array (16-bit limits)

Description
The Array data type represents a data structure that consists of a fixed number of components 
of the same data type. All data types except Array are permitted.

A tag with the Array data type always starts at a WORD limit.

The array components are addressed by means of an index. In the array declaration, the index 
limits are defined in square brackets after the keyword Array. The low limit must be smaller 
than or equal to the high limit. An array may contain up to six dimensions, the limits of which 
can be specified separated by a comma.

The following table shows the property of the Array data type:

Length Format Index limits Data type
Number of 
components * length 
of the data type

Array [low limit...high 
limit] of <data type>

[-32768..32767] of 
<data type>

Bit strings, integers, 
floating-point numbers, 
timers, character 
strings, structures 

Example
The following example shows how operands of data type Array can be declared:

Name Declaration Comment
Measured value Array[1..20] of REAL One-dimensional array with 20 components
Time-of-day Array[-5..5] of INT One-dimensional array with 11 components
Character Array[1..2, 3..4] of CHAR Two-dimensional array with 4 components

Maximum array limits
The maximum Array limits depend on the following factors:

● Data type of the Array elements

● Maximum storage capacity of the CPU (you can find more information in the relevant device 
manual)
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See also
Overview of the valid data types (Page 1320)

Indirect indexing of ARRAY components (Page 1314)

Format of array (32-bit limits)

Description
The Array data type represents a data structure that consists of a fixed number of components 
of the same data type. All data types except Array are permitted.

The array components are addressed by means of an index. In the array declaration, the index 
limits are defined in square brackets after the keyword Array. The low limit must be smaller 
than or equal to the high limit. An array may contain up to six dimensions, the limits of which 
can be specified separated by a comma.

 

 Note

Depending on the CPU, the storage capacity of a data block is limited and the number of 
components of the Array is therefore also limited. However, you may initialize the addressing 
of the array components at any position within index limits.

 

The following table shows the property of the Array data type:

Length Format Index limits Data type
Number of 
components * length 
of the data type

Array [low limit...high 
limit] of <data type>

[-2147483648..214748
3647] of <data type>

Bit strings, integers, 
floating-point numbers, 
timers, character 
strings, structures 

 

 Note

The length of the array depends on whether the block was created with the "Standard" or 
"with optimized access" block property.

 

 Note
Applies to CPUs of the S7-1500 series

For a block with the block property "Optimized block access", a bit requires 1 byte of memory. 
This is also true when you use an ARRAY of <data type>. An ARRAY [0..1] of BOOL, for 
example, thus requires 2 bytes in an optimized block.
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Example
The following example shows how operands of data type Array can be declared:

Name Declaration Comment
Measured value Array[1..20] of REAL One-dimensional array with 20 components
Time-of-day Array[-5..5] of INT One-dimensional array with 11 components
Character Array[1..2, 3..4] of CHAR Two-dimensional array with 4 components

Maximum array limits
The maximum array limits depend on the following factors:

● Data type of the array elements

● Memory reserve (only in blocks with optimized access)
You can find additional information on this topic in the section "Loading block changes 
without reinitialization".

● Maximum size of a data block for a CPU (you can find more information in the respective 
device manual)

● The entire length of the array is available within a data block. Within a program block (OB, 
FB or FC), the possible length is reduced by the memory capacity required by the program 
code.

Example based on a CPU of the S7-1200 series
The following table shows the maximum number of elements within a block with the "with 
optimized access" block property:

Data type width (bits) Maximum number of elements Note
1 524272 = 65534*8
8 65534 Refer to the respective device 

manual of the CPU for the value.
16 32767 = 65534/2 (integer division, 

remainder 0)
32 16383 = 65534/4 (integer division, 

remainder 2)
64 8191 = 65534/8 (integer division, 

remainder 6)

Due to various technical/internal constraints, the actual usable memory area may be 
approximately 70 - 100 bytes less. The memory area may be further restricted due to a default 
setting, for example, by the "Load without reinitialization" block property.

See also
Overview of the valid data types (Page 1320)

Indirect indexing of ARRAY components (Page 1314)
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Example of a one-dimensional array

Declaration
The following table shows the declaration of a one-dimensional Array tag:

Name Data type Comment
Op_Temp Array[1..3] of INT One-dimensional array tag with 3 components.

The following figure shows the structure of the declared array tag:

Access to ARRAY components
The individual array components are accessed via an index.. The index of the first ARRAY 
component is [1], of the second [2], and of the third [3]. To access the value of the second 
ARRAY component, you need to declare "Op_Temp[2]" in the program.

Example of a multi-dimensional array

Declaration
The following table shows the declaration of a two-dimensional Array tag:

Name Data type Value Comment
Betr_Temp Array[1..2, 1..3] of INT 1,1,4(0) Two-dimensional array 

tag with 6 components. 
The first two 
components are 
assigned the value "1". 
The remaining four 
components are 
assigned the value "0".

The following figure shows the structure of the declared array tag:
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Access to the array components
The values of the individual array components are accessed via an index. The index of the 
first array component is, for example, [1,1] and the index of the fourth array component is [2,1]. 
For example, you need to declare "Betr_Temp[2,1]" in the program to enable access to the 
value of the fourth array component.

Additional access option
You can also declare the "Betr_Temp" TAG as a six-dimensional array. The following table 
shows an example of the declaration of a six-dimensional Array tag:

Name Data type Value Comment
Betr_Temp Array[1..3, 1..2, 1..3, 

1..4, 1..3, 1..4] of INT
- Six-dimensional array 

tag

The index of the first array component is in this case [1,1,1,1,1,1] and the index of the last 
component is [3,2,3,4,3,4]. Intermediate values are accessed by entering the corresponding 
value for each dimension.

Structures

STRUCT

Description
Data type STRUCT represents a data structure that consists of a fixed number of components 
of various data types. Components of STRUCT or ARRAY data type can also be nested in a 
structure. The nesting depth is hereby limited to eight levels. Structures can be used to group 
data according to the process control system and to transfer parameters as one data unit.

You can create up to 65534 structures for a CPU of the S7-1200 or S7-1500 series. Each of 
these structures can include up to 252 components. In addition, you can create up to 65534 
function blocks, 65535 functions and 65535 organization blocks with up to 252 components 
each.

A component of the ARRAY data type always starts at a WORD limit.

The following table shows the properties of data type STRUCT:

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1355



Length Format Range of values Example of value input
A STRUCT variable 
starts with one byte with 
even address and 
occupies the memory 
up to the next word limit.

STRUCT The value ranges 
of the used data 
types apply.

The value input rules of the used data 
types apply.

Example
The following figure shows an example of the structure of a STRUCT variable:

See also
Overview of the valid data types (Page 1320)

Pointer

POINTER

Description
A parameter of the type POINTER is a pointer that can point to a specific tag. It occupies 6 
bytes (48 bits) in memory and may contain the following tag information:

● DB number, or 0 if the data is not stored in a DB

● Memory area in the CPU

● Tag address

The following figure shows the structure of parameter type POINTER:
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Types of pointer
Depending on the information, you can use parameter type POINTER to declare the following 
four types of pointer:

● Area-internal pointer:
An area-internal pointer contains information on the address of a tag.

● Cross-area pointer:
A cross-area pointer contains information on the memory area and the address of a tag.

● DB pointer:
You can use a DB pointer to point to a data block tag. A DB pointer also contains a data 
block number in addition to the memory area and the address of a tag.

● Zero pointer:
Use the zero pointer to indicate a missing value. A missing value may indicate that no value 
exists, or that the value is not yet known. A zero value represents the absence of a value, 
but is also a value.

The following table shows the formats for the declaration of various pointer types:

P#ByteRepresentation Format Example of value 
input

Description

Symbolic P#Byte.Bit "MyTag" Area-internal pointer
P#OperandAreaByte.Bit "MyTag" Cross-area pointer
P#Data_block.Data_oper
and

"MyDB"."MyTag" DB pointer

P#Zero value - Zero pointer
Absolute P#Byte.Bit P#20.0 Area-internal pointer

P#OperandAreaByte.Bit P#M20.0 Cross-area pointer
P#Data_block.Data_oper
and

P#DB10.DBX20.0 DB pointer

P#Zero value P#0.0, ZERO Zero pointer
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You can enter a parameter of the type POINTER without prefix (P#). The entry is then 
automatically converted to the POINTER format.

 

 Note

If you use the prefix P#, you can only point to memory areas with "standard" access mode.
 

Memory areas
The following table shows the hexadecimal codes of the memory areas for parameter type 
POINTER:

Hexadecimal code Memory area Description
B#16#801) P Peripherals on a CPU 

S7-300/400
16#1 P Peripheral inputs on a CPU 

S7-1500
16#2 P Peripheral outputs on a CPU 

S7-1500
B#16#81 I Memory area of inputs
B#16#82 Q Memory area of outputs
B#16#83 M Memory area of bit memory
B#16#84 DBX Data block
B#16#85 DIX Instance data block
B#16#86 L Local data
B#16#87 V Previous local data
1) These data types can only be used for the POINTER pointer on a CPU S7-300/400.

See also
Basics of indirect addressing (Page 1312)

Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

ANY

Description
An ANY type parameter points to the start of a data area and specifies its length. An ANY 
pointer occupies 10 bytes of memory and may contain the following information:

● Data type:
Data type of the elements of the data area

● Repetition factor:
Number of elements of the data area
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● DB number:
Data block that contains the declaration of data area elements.

● Memory area:
Memory area of the CPU that stores the data area elements.

● Start address of the data in the format "byte.bit":
Data area start identified by the ANY pointer.

● Zero pointer:
Use the zero pointer to indicate a missing value. A missing value may indicate that no value 
exists, or that the value is not yet known. A zero value represents the absence of a value, 
but is also a value.

 

 Note
Memory area

For an S7-1500 CPU, the ANY pointer can also only point to memory areas with "Standard" 
access mode.

 

The following figure shows the structure of the ANY pointer:

An ANY pointer cannot identify structures. It can only be assigned to local tags.

The following table shows the formats for the declaration of an ANY pointer:

Representation Format Example of value input Description
Symbolic P#DataBlock.MemoryA

rea DataAddress Type 
Number

"MyDB".StructTag.Initia
lComponents

Area with 10 words in 
global DB11 starting 
with DBB20.0

P#MemoryArea 
DataAddress Type 
Number

"MyMarkerTag" Area with 4 bytes 
starting with MB 20.0

"MyTag" Input I1.0
P#Zero value - Zero value

Absolute P#DataBlock.MemoryA
rea DataAddress Type 
Number

P#DB11.DBX20.0 INT 
10

Area with 10 words in 
global DB11 starting 
with DBB20.0
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Representation Format Example of value input Description
P#MemoryArea 
DataAddress Type 
Number

P#M20.0 BYTE 10 Area with 10 bytes 
starting with MB 20.0

P#E1.0 BOOL 1 Input I1.0
P#Zero value P#0.0 VOID 0, ZERO Zero value

Coding of data types
The following table lists the coding of data types for the ANY pointer:

Hexadecimal code Data type Description
B#16#00 NIL Null pointer
B#16#011) BOOL Bits
B#16#02 BYTE bytes, 8 bits
B#16#03 CHAR 8-bit characters 
B#16#04 WORD 16-bit words
B#16#05 INT 16-bit integers 
B#16#06 DWORD 32-bit words
B#16#07 DINT 32-bit integers
B#16#08 REAL 32-bit floating-point numbers
B#16#0B TIME Time duration
B#16#0C S5TIME Time duration
B#16#09 DATE Date
B#16#0A TOD Date and time
B#16#0E DT Date and time
B#16#13 STRING Character string
B#16#171) BLOCK_FB Function block
B#16#181) BLOCK_FC Function
B#16#191) BLOCK_DB Data block
B#16#1A1) BLOCK_SDB System data block
B#16#1C1) COUNTER Counter
B#16#1D1) TIMER Timer
1) These data types can only be used for the ANY pointer on a CPU S7-300/400.

Coding of the memory area
The following table lists the coding of the memory areas for the ANY pointer:

Hexadecimal code Area Description
B#16#801) P I/O
B#16#81 I Memory area of inputs
B#16#82 Q Memory area of outputs
B#16#83 M Memory area of bit memory
B#16#84 DBX Data block

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1360 System Manual, 02/2014



Hexadecimal code Area Description
B#16#85 DIX Instance data block
B#16#86 L Local data
B#16#87 V Previous local data
1) These memory areas can only be used for the ANY pointer on an S7-300/400 CPU.

See also
Basics of indirect addressing (Page 1312)

Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

VARIANT

Description
A parameter of the VARIANT type is a pointer that can point to tags of different data types 
other than an instance. The VARIANT pointer can be an object of an elementary data type, 
such as INT or REAL. It can also be a STRING, DTL, array of STRUCT, UDT, or array of UDT. 
The VARIANT pointer can recognize structures and point to individual structure components. 
An operand of data type VARIANT occupies no space in the instance DB or L stack. However, 
it will occupy memory space on the CPU.

A tag of the VARIANT type is not an object but rather a reference to another object. Individual 
elements of the VARIANT type can only be declared within the block interface of a function. 
For this reason, it cannot be declared in a data block or in the static section of the block interface 
of a function block, for example, because its size is unknown. The size of the referenced objects 
can change.

The VARIANT data type can only be defined on formal parameters in the block interface of a 
block.

 

 Note

You can only point to a complete data block if it was originally derived from a user-defined 
data type (UDT).

 

The following table shows the properties of the VARIANT pointer:

Length 
(bytes)

Representat
ion

Format Example of value input

0 Symbolic Operand "TagResult"
NameDataBlock.NameOperand.Component "Data_TIA_Portal".StructVariable.FirstCompon

ent
Absolute Operand %MW10
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Length 
(bytes)

Representat
ion

Format Example of value input

DataBlockNumber.Operand Type Length
(valid only for blocks with standard access)

P#DB10.DBX10.0 INT 12

P#Zero value P#0.0 VOID 0, ZERO
 

 Note

If you use the prefix P#, you can only point to memory areas with "standard" access mode.
 

Coding of data types
If you use absolute addressing with P#, the following data types are permitted:

Hexadecimal code Data type Description
B#16#00 NIL Null pointer
B#16#01 BOOL Bits
B#16#02 BYTE bytes, 8 bits
B#16#03 CHAR 8-bit characters 
B#16#04 WORD 16-bit words
B#16#05 INT 16-bit integers
B#16#06 DWORD 32-bit words
B#16#07 DINT 32-bit integers
B#16#08 REAL 32-bit floating-point numbers
B#16#0B TIME Time duration
B#16#0C S5TIME Time duration
B#16#09 DATE Date
B#16#0A TOD Date and time
B#16#0E DT Date and time
B#16#13 STRING Character string
B#16#17 BLOCK_FB Function block
B#16#18 BLOCK_FC Function
B#16#19 BLOCK_DB Data block
B#16#1A BLOCK_SDB System data block
B#16#1C COUNTER Counter
B#16#1D TIMER Timer

Example
The following example shows how VARIANT works using the "MOVE: Move value" instruction 
of STL:

STL Description
CALL MOVE // The "Move value" instruction is called.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1362 System Manual, 02/2014



STL Description
VARIANT // Data type of the instruction
IN := 
"Data_TIA_Portal".StructVariable.FirstComponent

// The contents of the "FirstComponent" operand 
are moved from the "Data_TIA_Portal" DB.

OUT := "MotorDB".StructResult.TagResult // And transferred to the "TagResult" operand from 
the "MotorDB" DB.

See also
Basics of indirect addressing (Page 1312)

Overview of the valid data types (Page 1320)

Basics of constants (Page 1296)

Basics of block access (Page 1267)

Principles of block calls (Page 1272)

Using VARIANT instructions (Page 290)

Parameter types

Parameter types

Description
The parameter types are data types for formal parameters that are transferred to called blocks. 
A parameter type can also be a PLC data type.

The following table shows the available parameter data types and their purpose:

Parameter type Length (bits) Description
TIMER 16 Is used to specify a timer that is used in the called code block. 

If you supply a formal parameter of the TIMER parameter type, 
the associated actual parameter must be a timer.
Example: T1

COUNTER 16 Is used to specify a counter that is used in the called code block. 
If you supply a formal parameter of the COUNTER parameter 
type, the associated actual parameter must be a counter.
Example: C10

BLOCK_FC 16 Is used to specify a block that is used as input in the called code 
block.
The declaration of the parameter determines the block type (for 
example FB, FC, DB) that is to be used.
If you supply a formal parameter of the BLOCK parameter type, 
specify a block address as the actual parameter.
Example: DB3

BLOCK_FB 16
BLOCK_DB 16
BLOCK_SDB 16
BLOCK_SFB 16
BLOCK_SFC 16
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Parameter type Length (bits) Description
BLOCK_OB 16
VOID - The VOID parameter type does not save any values. This 

parameter type is used if the return values of an output are not 
required. The VOID parameter type can be specified at the 
STATUS output, for example, if no error information is required.

See also
Overview of the valid data types (Page 1320)

Basics of PLC data types (Page 1667)

PLC data types

PLC data types

Description
PLC data types are data structures that you define and that can be used multiple times within 
the program. The structure of a PLC is made up of several components, each of which can 
contain different data types. You define the type of components during the declaration of the 
PLC data type.

You can create up to 65534 PLC data types for a CPU of the S7-1200 or S7-1500 series. Each 
of these PLC data types can include up to 252 components.

PLC data types can be used for the following applications:

● PLC data types can be used as data types for variables in the variable declaration of logic 
blocks or in data blocks.

● PLC data types can be used as templates for the creation of global data blocks with identical 
data structures.

● PLC data types can be used in S7-1200 and S7-1500 as a template for the creation of 
structured PLC tags.

See also
Addressing structured variables (Page 1306)

Example of a PLC data type

Example
You can declare PLC data types as the type when creating data blocks. Based on this type 
you can create a number of data blocks, all of which have the same data structure. These data 
blocks can be adapted by entering different actual values for the corresponding task.
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For instance, create a PLC data type for a recipe for blending paints. You can then assign this 
data type to several data blocks, each of which contains other quantity information. 

The following figure shows this application:

System data types

System data types

Description
The system data types (SDT) are made available by the system and have a predefined 
structure. The structure of a system data type consists of a fixed number of components that 
can have various data types. It is not possible to change the structure of a system data type.

The system data types can only be used for specific instructions. The following table shows 
the available system data types and their purpose:

System data type Length (bytes) Description
IEC_TIMER 16 Structure of a timer whose timer values are of TIME data type.

This data type is used for the "TP", "TOF", "TON", "TONR", 
"RT" and "PT" instructions, for example.

IEC_LTIMER 32 Structure of a timer whose timer values are of LTIME data 
type.
This data type is used for the "TP", "TOF", "TON", "TONR", 
"RT" and "PT" instructions, for example.

IEC_SCOUNTER 3 Structure of a counter whose count values are of SINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_USCOUNTER 3 Structure of a counter whose count values are of USINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.
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System data type Length (bytes) Description
IEC_COUNTER 6 Structure of a counter whose count values are of INT data 

type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_UCOUNTER 6 Structure of a counter whose count values are of UINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_DCOUNTER 12 Structure of a counter whose count values are of DINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_UDCOUNTER 12 Structure of a counter whose count values are of UDINT data 
type.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_LCOUNTER 24 Structure of a counter with count values of data type UDINT.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

IEC_ULCOUNTER 24 Structure of a counter with count values of data type UINT.
This data type is used for the "CTU", "CTD" and "CTUD" 
instructions, for example.

ERROR_STRUCT 28 Structure of an error information to a programming or I/O 
access error.
This data type is used, for example, for the "GET_ERROR" 
instruction.

CREF 8 Components of the ERROR_STRUCT data type, in which 
information about the address of a block is saved.

NREF 8 Components of the ERROR_STRUCT data type, in which 
information about the address of an operand is saved.

VREF 12 Is used for storage of a VARIANT pointer.
This data type is, for example, used for instructions from 
S7-1200 Motion Control.

STARTINFO 12 Specifies the data structure in which the start information is 
saved. 
This data type is used, for example, for the "RD_SINFO" 
instruction.

SSL_HEADER 4 Specifies the data structure in which information about the 
data records are saved during the reading of the system 
status lists. This data type is used, for example, for the 
"RDSYSST" instruction.

CONDITIONS 52 User-defined data structure defining the conditions for start 
and end of a data reception.
This data type is used, for example, for the "RCV_CFG" 
instruction. 
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System data type Length (bytes) Description
TADDR_Param 8 Specifies the structure of a data block which stores 

descriptions of connections for Open User Communication 
via UDP.
This data type is used for the "TUSEND" and "TURSV" 
instructions, for example.

TCON_Param 64 Specifies the structure of a data block which stores 
descriptions of connections for Open User Communication 
via Industrial Ethernet (PROFINET).
This data type is used for the "TSEND" and "TRSV" 
instructions, for example.

See also
Overview of the valid data types (Page 1320)

Hardware data types

Hardware data types

Description
The hardware data types are made available by the CPU. The number of available hardware 
data types depends on the CPU.

Constants of a specific hardware data type are stored based on the modules set in the 
hardware configuration. When an instruction for controlling or activating a configured module 
is inserted in the user program, the available constants can be used for the parameters.

The following table shows the available hardware data types and their purpose:

Data type Basic data type Description
REMOTE ANY Serves to specify the address of a remote CPU.

This data type is used, for example, for the "PUT" and 
"GET" instructions.

GEOADDR HW_IOSYSTEM Geographical address information
HW_ANY WORD Identification of any hardware component, e.g. a 

module.
HW_DEVICE HW_ANY Identification of a DP slave/PROFINET IO device
HW_DPMASTER HW_INTERFACE Identification of a DP master
HW_DPSLAVE HW_DEVICE Identification of a DP slave
HW_IO HW_ANY Identification number of the CPU or the interface

The number is automatically allocated and is stored 
in the properties of the CPU or of the interface in the 
hardware configuration.

HW_IOSYSTEM HW_ANY Identification of a PN/IO system or DP master system
HW_SUBMODULE HW_IO Identification of a central hardware component
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Data type Basic data type Description
HW_MODULE HW_IO Identification of a module
HW_INTERFACE HW_SUBMODULE Identification of an interface component
HW_IEPORT HW_SUBMODULE Identification of a port (PN/IO)
HW_HSC HW_SUBMODULE Identification of a high-speed counter

This data type is used, for example, for the 
"CTRL_HSC" instruction.

HW_PWM HW_SUBMODULE Identification of a pulse width modulation
This data type is used, for example, for the 
"CTRL_PWM" instruction.

HW_PTO HW_SUBMODULE Identification of a pulse encoder
This data type is used for Motion Control.

AOM_AID DWORD Is used only in connection with a system function 
block.

AOM_IDENT DWORD Identification of an object in the runtime system of the 
AS

EVENT_ANY AOM_IDENT Used to identify any event
EVENT_ATT EVENT_ANY Is used to specify an event that can be assigned 

dynamically to an OB
This data type is used, for example, for the "ATTACH" 
and "DETACH" instructions.

EVENT_HWINT EVENT_ATT Is used to specify a hardware interrupt event
OB_ANY INT Serves to specify any organization block.
OB_DELAY OB_ANY Used to specify an organization block that is called 

when a time-delay interrupt occurs.
This data type is used, for example, for the 
"SRT_DINT" and "CAN_DINT" instructions.

OB_TOD OB_ANY Specifies the number of a time-of-day interrupt OB.
This data type is used, for example, for the 
"SET_TINT", "CAN_TINT", "ACT_TINT" and 
"QRY_TINT" instructions.

OB_CYCLIC OB_ANY Is used to specify an organization block that is called 
when a watchdog interrupt occurs.

OB_ATT OB_ANY Is used to specify an organization block that can be 
assigned dynamically to an event.
This data type is used, for example, for the "ATTACH" 
and "DETACH" instructions.

OB_PCYCLE OB_ANY Is used to specify an organization block that can be 
assigned to an event of the "Cyclic program" event 
class.

OB_HWINT OB_ATT Is used to specify an organization block that is called 
when a hardware interrupt occurs.

OB_DIAG OB_ANY Is used to specify an organization block that is called 
when a diagnostic interrupt occurs.

OB_TIMEERROR OB_ANY Is used to specify an organization block that is called 
when a time error occurs.

OB_STARTUP OB_ANY Is used to specify an organization block that is called 
when a startup event occurs.
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Data type Basic data type Description
PORT HW_SUBMODULE Serves to specify a communication port.

This data type is used for point-to-point 
communication.

RTM UINT Serves to specify the number of an operating hours 
counter.
This data type is used, for example, for the "RTM" 
instruction.

PIP UINT Is used to create and connect a "Synchronous Cycle" 
OB. This data type is used for the SFCs 26, 27, 126 
and 127.

CONN_ANY WORD Serves to specify any connection.
CONN_PRG CONN_ANY Serves to specify a connection for open 

communication over UDP.
CONN_OUC CONN_ANY Used to specify a connection for open communication 

over Industrial Ethernet (PROFINET).
CONN_R_ID DWORD Data type for the R_ID parameter on the S7 

communication blocks.
DB_ANY UINT Identification (number) of any DB

The data type "DB_ANY" has the length 0 in the 
section "Temp".

DB_WWW DB_ANY Number of a DB generated via the Web application 
(for example, "WWW" instruction)
The data type "DB_WWW" has the length 0 in the 
section "Temp".

DB_DYN DB_ANY Number of a DB generated by the user program

See also
Overview of the valid data types (Page 1320)

Data type conversion

Data type conversion

Overview of data type conversion

Introduction
If you link several operands in an instruction, you must make sure that the data types are 
compatible. This applies also for assignments or for supplying block parameters. If the 
operands are not the same data type, a conversion has to be carried out. 

There are two options for the conversion:
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● Implicit conversion
The conversion take place automatically when the instruction is executed.

● Explicit conversion
You use an explicit conversion instruction before the actual instruction is executed.

 

 Note

The data type conversion options described always refer to the latest version of the CPU (V.
4) Conversions marked as possible may not be available in CPU versions 1 - 3.

 

 Note
Converting bit strings in SCL

All bit strings (BYTE, WORD, DWORD and LWORD) are handled like the corresponding 
unsigned integers (USINT, UINT, UDINT and ULINT) in expressions. Therefore, implicit 
conversion from DWORD to REAL is carried out like a conversion from UDINT to REAL, for 
example.

 

Implicit conversion
An implicit conversion is executed automatically if the data types of the operands are 
compatible. This compatibility test can be carried out according to criteria that are more or less 
strict:

● With IEC check (default)
If IEC check is set, the following rules are applied:

– Implicit conversion of BOOL to other data types is not possible.

– Only the REAL, BYTE, WORD, DINT, INT, SINT, UDINT, UINT, USINT, TIME, DT, 
STRING and CHAR data types can be converted implicitly.

– The bit length of the source data type must not exceed the bit length of the target data 
type. An operand of data type WORD, for example, cannot be declared at a parameter 
at which data type BYTE is expected.

● Without IEC check
If IEC check is not set, the following rules are applied:

– Implicit conversion of BOOL to other data types is not possible.

– Only the REAL, LREAL, BYTE, WORD, DWORD, SINT, INT, DINT, USINT, UINT, 
UDINT, TIME, DTL, TOD, DATE, STRING and CHAR data types can be converted 
implicitly.

– The bit length of the source data type must not exceed the bit length of the target data 
type. An operand of data type DWORD, for example, cannot be declared at a parameter 
at which data type WORD is expected.

– The bit length of an operand entered in-out parameters InOut) must be the same as the 
programmed bit length for the parameter in question.
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 Note
Implicit conversion without IEC check

The programming editor uses a gray rectangle to mark operands that are implicitly converted. 
The dark gray rectangle signals that an implicit conversion is possible without any accuracy 
loss, for example, if you convert the data type SINT to INT. A light gray rectangle signals that 
implicit conversion is possible, but errors could occur during runtime. If, for example, you are 
converting the data type DINT to INT and an overflow occurs, the enable output ENO is set 
to "0".

 

For more information about the setting of the IEC check and the implicit conversion, refer to 
"See also".

Explicit conversion
If the operands are not compatible and an implicit conversion is therefore not possible, you 
can use an explicit conversion instruction. You can find the conversion instructions in the 
"Instructions" task card.

A possible overflow is displayed at the ENO enable output. An overflow is created, for example, 
if the value of the source data type is greater than the value of the target data type.

For more information about explicit conversion, refer to "See also".

The following figure shows an example in which an explicit data type conversion must be 
carried out:

The "Block" function block expects a tag of the INT data type at the "IN_INT" input parameter. 
Therefore, the value of the "IN_DINT" tag must first be converted from DINT to INT. If the value 
of the "IN_DINT" tag is within the permitted value range of the INT data type, the conversion 
takes place. Otherwise, an overflow is signaled. A conversion still takes place even in case of 
an overflow, but the values are cut off and the enable output ENO is set to "0".

See also
Setting and canceling the IEC check (Page 1372)
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Implicit conversion

Setting and canceling the IEC check
The data types of the operands used are check for compatibility. This compatibility test can 
be carried out according to criteria that are more or less strict. If "IEC check" is activated, stricter 
criteria are applied. 

You can set the IEC check centrally for all new blocks of the project or for individual blocks.

Setting IEC check for new blocks   
To set the IEC check for all new blocks in the project, proceed as follows:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "PLC programming > General" group in the area navigation.

3. Select or clear the "IEC check" check box in the "Default settings for new blocks" group.
The IEC check is enabled or disabled for all new blocks in the program.

Setting IEC check for a block
To set the IEC check for a block, proceed as follows:

1. Open the block.

2. Open the "Properties" tab in the Inspector window.

3. Select the "Attributes" group in the area navigation.

4. Select or clear the "IEC check" check box.
The IEC check is enabled or disabled for this block. The setting is stored together with the 
project.

Binary numbers

Implicit conversion of BOOL

Options for implicit conversion         
The implicit conversion of the BOOL data type is not possible.

See also
BOOL (bit) (Page 1324)
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Bit strings

Implicit conversion of BYTE

Options for implicit conversion         
The following table shows the options for implicit conversion of the BYTE data type:

Source Target With
IEC check

Without
IEC check

Description

BYTE BOOL - - No implicit conversion
WORD x x The bit pattern of the source value is transferred unchanged right-

justified to the target data type.DWORD x x
SINT - x
USINT - x
INT - x
UINT - x
DINT - x
UDINT - x
REAL - - No implicit conversion
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - x The bit pattern of the source value is transferred unchanged to the 

target data type.
x: Conversion possible
-: Conversion not possible

See also
BYTE (byte) (Page 1325)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of BYTE (Page 1390)
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Implicit conversion of WORD

Options for implicit conversion         
The following table shows the options for implicit conversion of the WORD data type:

Source Target With
IEC check

Without
IEC check

Description

WORD BOOL - - No implicit conversion
BYTE - X The least significant byte is transferred to the target data type, while 

the most significant byte is ignored.
DWORD X X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
SINT - X The least significant byte is transferred to the target data type, while 

the most significant byte is ignored.
USINT - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.INT - X
UINT - X
DINT - X
UDINT - X
REAL - - No implicit conversion
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - X The bit pattern of the source value is transferred unchanged to the 

target data type.
STRING - - No implicit conversion
CHAR - X The bit pattern of the source value is transferred unchanged to the 

target data type.
x: Conversion possible
-: Conversion not possible

See also
WORD (Page 1326)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of WORD (Page 1391)
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Implicit conversion of DWORD

Options for implicit conversion         
The following table shows the options for implicit conversion of the DWORD data type:

Source Target With
IEC check

Without
IEC check

Description

DWORD BOOL - - No implicit conversion
BYTE - X The right bytes are transferred to the target data type; the left bytes 

are ignored.WORD - X
SINT - X
USINT - X
INT - X
UINT - X
DINT - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.UDINT - X
REAL - X The value is converted to the format of the target data type. (The 

value "-1", for example, is converted to the value "-1.0".)
LREAL - - No implicit conversion
TIME - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DTL - - No implicit conversion
TOD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DATE - - No implicit conversion
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
DWORD (Page 1327)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of DWORD (Page 1393)
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Integers

Implicit conversion of SINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the SINT data type:

Source Target With
IEC check

Without
IEC check

Description

SINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type. The remaining bits are filled with "0".WORD - X
DWORD - X
USINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value transfer from SINT #-1 -> 
INT #-1, not filled with "0".)

INT X X
UINT - X
DINT X X
UDINT - X
REAL X X The value is converted to the format of the target data type. (The 

value "-1", for example, is converted to the value "-1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
SINT (8-bit integers) (Page 1328)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of SINT (Page 1396)
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Implicit conversion of USINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the USINT data type:

Source Target With
IEC check

Without
IEC check

Description

USINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type. The remaining bits are filled with "0".WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from USINT #10 
-> DINT #10 or USINT #128 -> SINT #-128)

INT X X
UINT X X
DINT X X
UDINT X X
REAL X X The value is converted to the format of the target data type. (The 

value "1", for example, is converted to the value "1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
USINT (8-bit integers) (Page 1329)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of USINT (Page 1398)
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Implicit conversion of INT

Options for implicit conversion         
The following table shows the options for implicit conversion of the INT data type:

Source Target With
IEC check

Without
IEC check

Description

INT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from INT #-1 -> 
SINT #-1, or INT #-32 767 -> UINT #32 769)

USINT - X
UINT - X
DINT X X
UDINT - X
REAL X X The value is converted to the format of the target data type. (The 

value "-1", for example, is converted to the value "-1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
STRING - - No implicit conversion
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
INT (16-bit integers) (Page 1330)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of INT (Page 1399)
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Implicit conversion of UINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the UINT data type:

Source Target With
IEC check

Without
IEC check

Description

UINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from UINT #100 
-> DINT #100 or UINT #60 000 -> INT #-5536)

USINT - X
INT - X
DINT X X
UDINT X X
REAL X X The value is converted to the format of the target data type. (The 

value "1", for example, is converted to the value "1.0".)LREAL X X
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
STRING - - No implicit conversion
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
UINT (16-bit integers) (Page 1331)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of UINT (Page 1401)
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Implicit conversion of DINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the DINT data type:

Source Target With
IEC check

Without
IEC check

Description

DINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> SINT #-1 or DINT #-1 -> USINT #255)

USINT - X
INT - X
UINT - X
UDINT - X
REAL - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> REAL #-1.0, but there is a loss in accuracy for numbers with an 
absolute value greater than 8 388 608)

LREAL X X The value is converted to the format of the target data type. (The 
value "-1", for example, is converted to the value "-1.0".)

TIME - X The bit pattern of the source value is transferred unchanged right-
justified to the target data type.

DTL - - No implicit conversion
TOD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DATE - - No implicit conversion
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
DINT (32-bit integers) (Page 1332)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of DINT (Page 1403)
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Implicit conversion of UDINT

Options for implicit conversion         
The following table shows the options for implicit conversion of the UDINT data type:

Source Target With
IEC check

Without
IEC check

Description

UDINT BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.WORD - X
DWORD - X
SINT - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> SINT #-1 or DINT #-1 -> USINT #255)

USINT - X
INT - X
UINT - X
DINT - X
REAL - X The bit pattern of the source value is converted and transferred to 

the target data type. (for example, value conversion from DINT #-1 
-> REAL #-1.0, but there is a loss in accuracy for numbers with an 
absolute value greater than 8 388 608)

LREAL X X The value is converted to the format of the target data type. (The 
value "1", for example, is converted to the value "1.0".)

TIME - X The bit pattern of the source value is transferred unchanged right-
justified to the target data type.

DTL - - No implicit conversion
TOD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
DATE - - No implicit conversion
STRING - -
CHAR - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
x: Conversion possible
-: Conversion not possible

See also
UDINT (32-bit integers) (Page 1332)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of UDINT (Page 1405)
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Floating-point numbers

Implicit conversion of REAL

Options for implicit conversion         
The following table shows the options for implicit conversion of the REAL data type:

Source Target With
IEC check

Without
IEC check

Description

REAL BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type.
SINT - X The bit pattern of the source value is rounded off and converted and 

transferred to the target data type. (for example, rounding off and 
value conversion of REAL #2.5 -> INT #2 or negative number REAL 
#-2.5 -> INT #-2 -> USINT #254. With an overflow, the remainder is 
determined REAL #305.5 -> INT #306 -> USINT #50)

USINT - X
INT - X
UINT - X
DINT - X
UDINT - X
LREAL X X The value  is transferred to the target data type.
TIME - - No implicit conversion
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
REAL (Page 1336)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of REAL (Page 1406)
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Implicit conversion of LREAL

Options for implicit conversion
The following table shows the options for implicit conversion of the LREAL data type:

Source Target With
IEC check

Without
IEC check

Explanation

LREAL BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - -
SINT - X The bit pattern of the source value is rounded off and converted and 

transferred to the target data type. (for example, rounding off and 
value conversion of REAL #2.5 -> INT #2 or negative number REAL 
#-2.5 -> INT #-2 -> USINT #254. With an overflow, the remainder is 
determined REAL #305.5 -> INT #306 -> USINT #50)

USINT - X
INT - X
UINT - X
DINT - X
UDINT - X
REAL - - No implicit conversion
TIME - -
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
Explicit conversion of LREAL (Page 1408)
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Timers

Implicit conversion of TIME

Options for implicit conversion         
The following table shows the options for implicit conversion of the TIME data type:

Source Target With
IEC check

Without
IEC check

Description

TIME BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion shows the duration in 
milliseconds.

SINT - - No implicit conversion
USINT - -
INT - -
UINT - -
DINT - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion shows the duration in 
milliseconds.

UDINT - X

REAL - - No implicit conversion
LREAL - -
DTL - -
TOD - X The bit pattern of a source value that is less than 24 h (86 400 00 

ms) is transferred without changes to the target data type. No further 
changes are made to the target value. The result of the conversion 
shows the time that has passed since midnight.

DATE - - No implicit conversion
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
TIME (IEC time) (Page 1341)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of TIME (Page 1409)
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Date and time

Implicit conversion of DTL

Options for implicit conversion         
The DTL data type cannot be implicitly converted.

See also
Explicit conversion of DTL (Page 1412)

Implicit conversion of TOD

Options for implicit conversion         
The following table shows the options for implicit conversion of the TOD data type:

Source Target With
IEC check

Without
IEC check

Description

TOD BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of milliseconds since the start of day (0:00 hrs).

SINT - - No implicit conversion
USINT - -
INT - -
UINT - -
DINT - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of milliseconds since the start of day (0:00 hrs).

UDINT - X

REAL - - No implicit conversion
LREAL - -
TIME - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of milliseconds since the start of day (0:00 hrs).

DTL - - No implicit conversion
DATE - -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
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See also
TIME_OF_DAY (TOD) (Page 1343)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of TOD (Page 1411)

Implicit conversion of DATE

Options for implicit conversion         
The following table shows the options for implicit conversion of the DATE data type:

Source Target With
IEC check

Without
IEC check

Description

DATE BOOL - - No implicit conversion
BYTE - -
WORD - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of days since 01-01-1990.

DWORD - - No implicit conversion
SINT - -
USINT - -
INT - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of days since 01-01-1990.

UINT - X

DINT - - No implicit conversion
UDINT - -
REAL - -
LREAL - -
TIME - -
DTL - X The bit pattern of the source value is transferred unchanged to the 

target data type. The result of the conversion corresponds to the 
number of days since 01-01-1990.

TOD - - No implicit conversion
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
DATE (Page 1342)

Setting and canceling the IEC check (Page 1372)
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Overview of data type conversion (Page 1369)

Explicit conversion of DATE (Page 1410)

Character strings

Implicit conversion of CHAR

Options for implicit conversion         
The following table shows the options for implicit conversion of the CHAR data type:

Source Target With
IEC check

Without
IEC check

Description

CHAR BOOL - - No implicit conversion
BYTE - X The bit pattern of the source value is transferred unchanged right-

justified to the target data type. The remaining bits are filled from the 
left with "0".

WORD - X
DWORD - X
SINT - X
USINT - X
INT - X
UINT - X
DINT - X
UDINT - X
REAL - - No implicit conversion
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
STRING X X The STRING is shortened to length 1 and includes the character.

x: Conversion possible
-: Conversion not possible

See also
CHAR (character) (Page 1346)

Setting and canceling the IEC check (Page 1372)

Overview of data type conversion (Page 1369)

Explicit conversion of CHAR (Page 1413)
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Implicit conversion of STRING

Options for implicit conversion         
The following table shows the options for implicit conversion of the STRING data type:

Source Target With
IEC check

Without
IEC check

Description

STRING BOOL - - No implicit conversion
BYTE - -
WORD - -
DWORD - -
SINT - -
USINT - -
INT - -
UINT - -
DINT - -
UDINT - -
REAL - -
LREAL - -
TIME - -
DTL - -
DATE - -
TOD - -
CHAR - X The first character of the STRING is returned if the STRING includes 

one or more characters. Otherwise, the character is output with 
coding $00.

x: Conversion possible
-: Conversion not possible

See also
Explicit conversion of STRING (Page 1414)
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Explicit conversion

Binary numbers

Explicit conversion of BOOL

Options for explicit conversion           
The following table shows the options and instructions for the explicit conversion of the BOOL 
data type:

Source Target Conversion Description Mnemonics of the instruction
BOOL BYTE X Only the LSB (Least Significant Bit) 

is set in the target data type. The 
enable output ENO is always "1". 

BOOL_TO_BYTE
WORD X BOOL_TO_WORD
DWORD X BOOL_TO_DWORD
SINT X BOOL_TO_SINT
USINT X BOOL_TO_USINT
INT X BOOL_TO_INT
UINT X BOOL_TO_UINT
DINT X BOOL_TO_DINT
UDINT X BOOL_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
STRING - -
CHAR - -

x: Conversion possible
- : Conversion not possible

See also
BOOL (bit) (Page 1324)

Implicit conversion of BYTE (Page 1373)

Overview of data type conversion (Page 1369)
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Bit strings

Explicit conversion of BYTE

Options for explicit conversion
The following table shows the options and instructions for the explicit conversion of the BYTE 
data type:

Source Target Conversion Description Mnemonics of 
Instruction

BYTE1) BOOL X The following scenarios are possible:
● If the source is "0", the target data type 

is also "0" and enable output ENO is 
"1".

● If only the LSB (Least Significant Bit) 
"1" is set in the source value, the target 
data type is also "1" and enable output 
ENO is "1".

● If bits are not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output 
ENO is "0".

BYTE_TO_BOOL

WORD1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

BYTE_TO_WORD
DWORD1) X BYTE_TO_DWORD
SINT X BYTE_TO_SINT
USINT X BYTE_TO_USINT
INT X BYTE_TO_INT
UINT X BYTE_TO_UINT
DINT X BYTE_TO_DINT
UDINT X BYTE_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type.

BYTE_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type.

BYTE_TO_TOD
DATE X BYTE_TO_DATE

STRING - No explicit conversion -
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Source Target Conversion Description Mnemonics of 
Instruction

CHAR X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

BYTE_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) are interpreted as an unsigned integer with the same bit length.. Data type BYTE is 
interpreted as USINT, WORD as UINT and DWORD as UDINT.

See also
BYTE (byte) (Page 1325)

Implicit conversion of BYTE (Page 1373)

Overview of data type conversion (Page 1369)

Explicit conversion of WORD

Options for explicit conversion
The following table shows the options and instructions for the explicit conversion of the WORD 
data type:

Source Target Conversion Description Mnemonics of the instruction
WORD1) BOOL X The following scenarios are possible:

● If the source is "0", the target data 
type is also "0" and enable output 
ENO is "1".

● If only the LSB (Least Significant Bit) 
"1" is set in the source value, the 
target data type is also "1" and 
enable output ENO is "1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output 
ENO is "0".

WORD_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to 
the target data type.

WORD_TO_BYTE
DWORD1) X WORD_TO_DWORD
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Source Target Conversion Description Mnemonics of the instruction
SINT X ENO = TRUE

#sint1 := WORD_TO_SINT(16#FFFF); // 
-1 to
#sint1 := WORD_TO_SINT(16#FF80); // 
-128
#sint1 := WORD_TO_SINT(16#0); // 0 to
#sint1 := WORD_TO_SINT(16#007F); // 
127
 
ENO = FALSE
#sint1 := WORD_TO_SINT(16#FF7F); // 
-129 to
#sint1 := WORD_TO_SINT(16#8000); // 
-32768
#sint1 := WORD_TO_SINT(16#0080); // 
128 to
#sint1 := WORD_TO_SINT(16#7FFF); // 
32767

WORD_TO_SINT

USINT X The bit pattern of the source value is 
transferred unchanged right-justified to 
the target data type.

WORD_TO_USINT
INT X WORD_TO_INT
UINT X WORD_TO_UINT
DINT X WORD_TO_DINT
UDINT X WORD_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME X The bit pattern of the source value is 

transferred unchanged right-justified to 
the target data type.

WORD_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to 
the target data type.

WORD_TO_TOD
DATE X WORD_TO_DATE

STRING - No explicit conversion -
CHAR X The bit pattern of the source value is 

transferred unchanged right-justified to 
the target data type.

WORD_TO_CHAR

WORD_BCD16 INT X The value to be converted has data type 
WORD and is accepted as a BCD-coded 
value between -999 and +999. The 
result is available after conversion as an 
integer (in binary notation) of the type 
INT. A real conversion takes place. If the 
bit pattern includes an invalid tetrad, a 
synchronous error is not triggered but 
only the status bit OV is set instead.

WORD_BCD16_TO_INT
BCD16 INT X BCD16_TO_INT

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) are interpreted as an unsigned integer with the same bit length.. Data type BYTE is 
interpreted as USINT, WORD as UINT and DWORD as UDINT.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1392 System Manual, 02/2014



See also
WORD (Page 1326)

Implicit conversion of WORD (Page 1374)

Overview of data type conversion (Page 1369)

Explicit conversion of DWORD

Options for explicit conversion
The following table shows the options and instructions for the explicit conversion of the 
DWORD data type:

Source Target Conversion Description Mnemonics of the instruction
DWORD1) BOOL X The following scenarios are possible:

● If the source is "0", the target data 
type is also "0" and enable output 
ENO is "1".

● If only the LSB (Least Significant 
Bit) "1" is set in the source value, 
the target data type is also "1" and 
enable output ENO is "1".

● If bit is not equal to LSB in the 
source value, the target data type 
is set according to LSB and enable 
output ENO is "0".

DWORD_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_BYTE
WORD1) X DWORD_TO_WORD
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Source Target Conversion Description Mnemonics of the instruction
SINT X ENO = TRUE

#sint1 := 
DWORD_TO_SINT(16#FFFF_FFFF);
 // -1 bis
#sint1 := 
DWORD_TO_SINT(16#FFFF_FF80); 
// -128
#sint1 := DWORD_TO_SINT(16#0); // 
0 bis
#sint1 := 
DWORD_TO_SINT(16#0000_007F); /
/ 127
 
ENO = FALSE
#sint1 := 
DWORD_TO_SINT(16#FFFF_FF7F); 
// -129
#sint1 := 
DWORD_TO_SINT(16#8000_0000); /
/ -2147483648
#sint1 := 
DWORD_TO_SINT(16#0000_0080); /
/ 128 bis
#sint1 := 
DWORD_TO_SINT(16#7FFF_FFFF); 
// 2147483647

DWORD_TO_SINT

USINT X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_USINT
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Source Target Conversion Description Mnemonics of the instruction
INT X ENO = TRUE

#int1 := 
DWORD_TO_INT(16#FFFF_FFFF); //
 -1 bis
#int1 := 
DWORD_TO_INT(16#FFFF_8000); // 
-32768
#int1 := DWORD_TO_INT(16#0); // 0 
bis
#int1 := 
DWORD_TO_INT(16#0000_7FFF); // 
32767
 
ENO = FALSE
#int1 := 
DWORD_TO_INT(16#FFFF_7FFF); //
 -32769
#int1 := 
DWORD_TO_INT(16#8000_0000); // 
-2147483648
#int1 := 
DWORD_TO_INT(16#8000); // 32768 
bis
#int1 := 
DWORD_TO_INT(16#7FFF_FFFF); //
 2147483647

DWORD_TO_INT

UINT X The bit pattern of the source value is 
transferred unchanged right-justified 
to the target data type.

DWORD_TO_UINT
DINT X DWORD_TO_DINT
UDINT X DWORD_TO_UDINT
REAL X The bit pattern of the source value is 

transferred unchanged right-justified 
to the target data type. If no errors 
occur during the conversion, the 
signal state of ENO = 1; if an error 
occurs during processing, the signal 
state of ENO = 0.

DWORD_TO_REAL

LREAL - No explicit conversion -
TIME X The bit pattern of the source value is 

transferred unchanged right-justified 
to the target data type.

DWORD_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified 
to the target data type.

DWORD_TO_TOD
DATE X DWORD_TO_DATE

STRING - No explicit conversion -
CHAR X The bit pattern of the source value is 

transferred unchanged right-justified 
to the target data type.

DWORD_TO_CHAR

DWORD_BCD32 DINT X The value to be converted has data 
type DWORD and is accepted as a 
BCD-coded value between -9999999 

DWORD_BCD32_TO_DINT
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Source Target Conversion Description Mnemonics of the instruction
BCD32 DINT X and +9999999. The result is available 

after conversion as an integer (in 
binary notation) of the type DINT. A 
real conversion takes place. If the bit 
pattern includes an invalid tetrad, a 
synchronous error is not triggered but 
only the status bit OV is set instead.

BCD32_TO_DINT

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) are interpreted as an unsigned integer with the same bit length.. Data type BYTE is 
interpreted as USINT, WORD as UINT and DWORD as UDINT.

See also
DWORD (Page 1327)

Implicit conversion of DWORD (Page 1375)

Overview of data type conversion (Page 1369)

Integers

Explicit conversion of SINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the SINT data 
type:

Source Target Conversion Description Mnemonics of the 
instruction

SINT BOOL X The following scenarios are possible:
● If the source is "0", the target data type is also 

"0" and enable output ENO is "1".
● If only the LSB (Least Significant Bit) "1" is set 

in the source value, the target data type is also 
"1" and enable output ENO is "1".

● If bit is not equal to LSB in the source value, the 
target data type is set according to LSB and 
enable output ENO is "0".

SINT_TO_BOOL

BYTE1) X The bit pattern of the source value is transferred 
unchanged right-justified to the target data type. If a 
negative value is converted to an unsigned target 
data type, the enable output ENO is set to "0".

SINT_TO_BYTE
WORD1) X SINT_TO_WORD
DWORD1) X SINT_TO_DWORD

USINT X The bit pattern of the source value is converted and 
transferred to the target data type. (The value "-1" 
(16#FF) becomes the value "-1" (16#FFFFFFFF). 

SINT_TO_USINT
INT X SINT_TO_INT
UINT X SINT_TO_UINT
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Source Target Conversion Description Mnemonics of the 
instruction

DINT Enable output ENO is set to "0" if a negative value 
is converted to an unsigned target data type.

X SINT_TO_DINT
UDINT X SINT_TO_UDINT
REAL X The value is converted into the format of the target 

data type (the value "-1" will be converted into the 
value "-1.0" with the "Convert value" (CONVERT) 
instruction.

SINT_TO_REAL, 
NORM_X

LREAL X SINT_TO_LREAL, 
NORM_X

TIME X The value is transferred to the target data type and 
interpreted as milliseconds.

SINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is converted and 

transferred to the target data type. (The value "-1" 
(16#FF) becomes the value "-1" (16#FFFFFFFF). 
Enable output ENO is set to "0" if a negative value 
is converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0)

SINT_TO_TOD

DATE X The bit pattern of the source value is converted and 
transferred to the target data type. (The value "-1" 
(16#FF) becomes the value "-1" (16#FFFFFFFF). 
Enable output ENO is set to "0" if a negative value 
is converted to an unsigned target data type. 
(interpretation in days since 1990-1-1)

SINT_TO_DATE

STRING X The value is converted to a character string. The 
character string is shown preceded by a sign. If the 
permitted length of the character string is violated, 
the enable output ENO is set to "0".

SINT_TO_STRING, 
S_CONV, VAL_STRG

CHAR1) X The bit pattern of the source value is transferred 
unchanged to the target data type. If negative values 
are converted, the enable output ENO is set to "0".

SINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including sign, and 
then the bits are copied. The source type determines the interpretation.

See also
SINT (8-bit integers) (Page 1328)

Implicit conversion of SINT (Page 1376)

Overview of data type conversion (Page 1369)
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Explicit conversion of USINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the USINT 
data type:

Source Target Conversion Description Mnemonics of the instruction
USINT BOOL X The following scenarios are possible:

● If the source is "0", the target data type is 
also "0" and enable output ENO is "1".

● If only the LSB (Least Significant Bit) "1" 
is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

USINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

USINT_TO_BYTE
WORD1) X USINT_TO_WORD
DWORD1) X USINT_TO_DWORD
SINT X The bit pattern of the source value is 

transferred unchanged to the target data 
type. If the sign is changed during the 
conversion, the enable output ENO is set to 
"0".

USINT_TO_SINT

INT X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

USINT_TO_INT
UINT X USINT_TO_UINT
DINT X USINT_TO_DINT
UDINT X USINT_TO_UDINT
REAL X The value is converted into the format of the 

target data type (the value "1" will be 
converted into the value "1.0" with the 
"Convert value" (CONVERT) instruction.

USINT_TO_REAL, NORM_X
LREAL X USINT_TO_LREAL, NORM_X

TIME X The value is transferred to the target data 
type and interpreted as milliseconds.

USINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type.

USINT_TO_TOD
DATE X USINT_TO_DATE

STRING X The value is converted to a character string. 
If the permitted length of the character string 
is violated, the enable output ENO is set to 
"0".

USINT_TO_STRING, 
S_CONV, VAL_STRG
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Source Target Conversion Description Mnemonics of the instruction
CHAR1) X The bit pattern of the source value is 

transferred unchanged to the target data type.
USINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width (the non-existing sign 
is replaced with zeros) and then the bits are copied. The source type determines the interpretation.

See also
USINT (8-bit integers) (Page 1329)

Implicit conversion of USINT (Page 1377)

Overview of data type conversion (Page 1369)

Explicit conversion of INT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the INT data 
type:

Source Target Conversion Description Mnemonics of the 
instruction

INT BOOL X The following scenarios are possible:
● If the source is "0", the target data type is 

also "0" and enable output ENO is "1".
● If only the LSB (Least Significant Bit) "1" is 

set in the source value, the target data type 
is also "1" and enable output ENO is "1".

● If bit is not equal to LSB in the source value, 
the target data type is set according to LSB 
and enable output ENO is "0".

INT_TO_BOOL

BYTE1) X The bit pattern of the source value is transferred 
unchanged right-justified to the target data type. 
If a negative value is converted to an unsigned 
target data type, the enable output ENO is set 
to "0".

INT_TO_BYTE
WORD1) X INT_TO_WORD
DWORD1) X INT_TO_DWORD

SINT X The bit pattern of the source value is converted 
and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type.

INT_TO_SINT
USINT X INT_TO_USINT
UINT X INT_TO_UINT
DINT X INT_TO_DINT
UDINT X INT_TO_UDINT
REAL X The value is converted to the format of the 

target data type (the value "-1", for example, is 
converted with the instruction "Convert value" 
(CONVERT) to the value "-1.0").

INT_TO_REAL, NORM_X
LREAL X INT_TO_LREAL, NORM_X
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Source Target Conversion Description Mnemonics of the 
instruction

TIME X The value is transferred to the target data type 
and interpreted as milliseconds.

INT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is converted 

and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type. (interpretation in 
milliseconds since 0:0; check for 24h limit)

INT_TO_TOD

DATE X The bit pattern of the source value is converted 
and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type. (interpretation in 
days since 1990-1-1; check for negative value)

INT_TO_DATE

STRING X The value is converted to a character string. 
The character string is shown preceded by a 
sign. If the permitted length of the character 
string is violated, the enable output ENO is set 
to "0".

INT_TO_STRING, 
S_CONV, VAL_STRG)

CHAR1) X The bit pattern of the source value is converted 
and transferred to the target data type. (The 
value "-1" (16#FF) becomes the value "-1" 
(16#FFFFFFFF). Enable output ENO is set to 
"0" if a negative value is converted to an 
unsigned target data type.

INT_TO_CHAR

BCD16 X The value to be converted has type INT and is 
accepted as an integer with a value between 
-999 and +999. The result is available after 
conversion as a BCD-coded number of the type 
WORD. A real conversion takes place. If the 
value is outside the target area, a synchronous 
error is not triggered, but rather only the status 
bit OV is set.

INT_TO_BCD16
BCD16_WORD X INT_TO_BCD16_WORD

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including sign, and 
then the bits are copied. The source type determines the interpretation.

See also
INT (16-bit integers) (Page 1330)

Implicit conversion of INT (Page 1378)

Overview of data type conversion (Page 1369)
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Explicit conversion of UINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the UINT data 
type:

Source Target Conversion Description Mnemonics of the instruction
UINT BOOL X The following scenarios are possible:

● If the source is "0", the target data type is 
also "0" and enable output ENO is "1".

● If only the LSB (Least Significant Bit) "1" 
is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

UINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type. If bits are lost in the process, 
the enable output ENO is set to "0".

UINT_TO_BYTE
WORD1) X UINT_TO_WORD
DWORD1) X UINT_TO_DWORD
SINT X UINT_TO_SINT
USINT X UINT_TO_USINT
INT X The bit pattern of the source value is 

transferred unchanged to the target data 
type. If the sign bit is changed during the 
conversion, the enable output ENO is set to 
"0".

UINT_TO_INT

DINT X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type.

UINT_TO_DINT
UDINT X UINT_TO_UDINT

REAL X The value is converted to the format of the 
target data type (the value "1", for example, 
is converted with the instruction "Convert 
value" (CONVERT) to the value "1.0").

UINT_TO_REAL, NORM_X
LREAL X UINT_TO_LREAL, NORM_X

TIME X The value is transferred to the target data 
type and interpreted as milliseconds.

UINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0; 
check for 24h limit)

UINT_TO_TOD
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Source Target Conversion Description Mnemonics of the instruction
DATE X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in days since 1990-1-1; check 
for negative value)

UINT_TO_DATE, T_CONV

STRING X The value is converted to a character string. 
If the permitted length of the character string 
is violated, the enable output ENO is set to 
"0".

UINT_TO_STRING, S_CONV, 
VAL_STRG

CHAR1) X The bit pattern of the source value is 
transferred unchanged to the target data 
type. The enable output ENO is set to "0" in 
the event of overflow.

UINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD, LWORD) and the data type CHAR are initially extended to the necessary width (the 
non-existing sign is replaced with zeros) and then the bits are copied. The source type determines the interpretation.

See also
UINT (16-bit integers) (Page 1331)

Implicit conversion of UINT (Page 1379)

Overview of data type conversion (Page 1369)
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Explicit conversion of DINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the DINT data 
type:

Source Target Conversio
n

Description Mnemonics of the instruction

DINT BOOL X The following scenarios are possible:
● If the source is "0", the target data type is 

also "0" and enable output ENO is "1".
● If only the LSB (Least Significant Bit) "1" 

is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

DINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to the 
target data type. If a negative value is 
converted to an unsigned target data type, 
the enable output ENO is set to "0".

DINT_TO_BYTE
WORD1) X DINT_TO_WORD
DWORD1) X DINT_TO_DWORD

SINT X The bit pattern of the source value is 
converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type.

DINT_TO_SINT
USINT X DINT_TO_USINT
INT X DINT_TO_INT
UINT X DINT_TO_UINT
UDINT X DINT_TO_UDINT
REAL X The value is converted to the format of the 

target data type (the value "-1", for example, 
is converted with the instruction "Convert 
value" (CONVERT) to the value "-1.0").

DINT_TO_REAL, NORM_X
LREAL X DINT_TO_LREAL, NORM_X

TIME X The value is transferred to the target data 
type and interpreted as milliseconds.

DINT_TO_TIME, T_CONV

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0)

DINT_TO_TOD
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Source Target Conversio
n

Description Mnemonics of the instruction

DATE X The bit pattern of the source value is 
converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in days since 1990-1-1)

DINT_TO_DATE

STRING X The value is converted to a character string. 
The character string is shown preceded by a 
sign. If the permitted length of the character 
string is violated, the enable output ENO is 
set to "0".

DINT_TO_STRING, S_CONV, 
VAL_STRG

CHAR1) X The bit pattern of the source value is 
converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type.

DINT_TO_CHAR

BCD32 X The value to be converted has type DINT and 
is accepted as an integer with a value 
between –999999 and +9999999. The result 
is available after conversion as a BCD-coded 
number of the type DWORD. The enable 
output is set to "0" in the event of overflow. A 
real conversion takes place. If the value is 
outside the target area, a synchronous error 
is not triggered, but rather only the status bit 
OV is set.

DINT_TO_BCD32
BCD32_DWORD X DINT_TO_BCD32_DWORD

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including sign, and 
then the bits are copied. The source type determines the interpretation.

See also
DINT (32-bit integers) (Page 1332)

Implicit conversion of DINT (Page 1380)

Overview of data type conversion (Page 1369)
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Explicit conversion of UDINT

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the UDINT 
data type:

Source Target Conversion Description Mnemonics of the instruction
UDINT BOOL X The following scenarios are possible:

● If the source is "0", the target data type is 
also "0" and enable output ENO is "1".

● If only the LSB (Least Significant Bit) "1" 
is set in the source value, the target data 
type is also "1" and enable output ENO is 
"1".

● If bit is not equal to LSB in the source 
value, the target data type is set 
according to LSB and enable output ENO 
is "0".

UDINT_TO_BOOL

BYTE1) X The bit pattern of the source value is 
transferred unchanged to the target data 
type. If bits are lost in the process, the enable 
output ENO is set to "0".

UDINT_TO_BYTE
WORD1) X UDINT_TO_WORD
DWORD1) X UDINT_TO_DWORD
SINT X UDINT_TO_SINT
USINT X UDINT_TO_USINT
INT X UDINT_TO_INT
UINT X UDINT_TO_UINT
DINT X The bit pattern of the source value is 

transferred unchanged to the target data 
type. If the sign bit is changed during the 
conversion, the enable output ENO is set to 
"0".

UDINT_TO_DINT

REAL X The value is converted to the format of the 
target data type (the value "1", for example, 
is converted with the instruction "Convert 
value" (CONVERT) to the value "1.0").

UDINT_TO_REAL, NORM_X
LREAL X UDINT_TO_LREAL, NORM_X

TIME X The bit pattern of the source value is 
transferred unchanged right-justified and 
interpreted as milliseconds to the target data 
type.

UDINT_TO_TIME

DTL - No explicit conversion -
TOD X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in milliseconds since 0:0; 
check for 24h limit)

UDINT_TO_TOD, T_CONV
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Source Target Conversion Description Mnemonics of the instruction
DATE X The bit pattern of the source value is 

converted and transferred to the target data 
type. (The value "-1" (16#FF) becomes the 
value "-1" (16#FFFFFFFF). Enable output 
ENO is set to "0" if a negative value is 
converted to an unsigned target data type. 
(interpretation in days since 1990-1-1; check 
for negative value)

UDINT_TO_DATE

STRING X The value is converted to a character string. 
If the permitted length of the character string 
is violated, the enable output ENO is set to 
"0".

UDINT_TO_STRING, 
S_CONV, VAL_STRG

CHAR1) X The bit pattern of the source value is 
transferred unchanged to the target data 
type. The enable output ENO is set to "0" in 
the event of overflow.

UDINT_TO_CHAR

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD, LWORD) and the data type CHAR are initially extended to the necessary width (the 
non-existing sign is replaced with zeros) and then the bits are copied. The source type determines the interpretation.

See also
UDINT (32-bit integers) (Page 1332)

Implicit conversion of UDINT (Page 1381)

Overview of data type conversion (Page 1369)

Floating-point numbers

Explicit conversion of REAL

Options for explicit conversion
The following table shows the options and instructions for explicit conversion of the REAL data 
type:

Source Target Conversion Description Mnemonics of the instruction
REAL BOOL - No explicit conversion

 
-

BYTE - -
WORD - -
DWORD X The bit pattern of the source value is 

transferred unchanged to the target data type.
REAL_TO_DWORD

SINT X The value is converted to the target data type. 
The result of the conversion depends on the 
instruction used. Enable output ENO is set to 
"0" if the valid range of values of the target 

REAL_TO_SINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X
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Source Target Conversion Description Mnemonics of the instruction
USINT data type is exceeded during conversion, or 

if the value to be converted is an invalid 
floating-point number.

X REAL_TO_USINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

INT X REAL_TO_INT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

UINT X REAL_TO_UINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

DINT X REAL_TO_DINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

UDINT X REAL_TO_UDINT, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

LREAL X The value is converted to the target data type. 
The result of the conversion depends on the 
instruction used, e.g. TRUNC(2.5) = 2.0; 
CEIL(2.5) = 3.0

REAL_TO_LREAL, ROUND, 
CEIL, FLOOR, TRUNC, 
NORM_X, SCALE_X

TIME - No explicit conversion -
DTL - -
TOD - -
DATE - -
STRING X The value is converted to a character string. 

Enable output ENO is set to "0" if the 
character string length is exceeded, or if the 
value to be converted is an invalid floating-
point number. The string has a minimum 
length of 14 characters.

REAL_TO_STRING, 
S_CONV, VAL_STRG

CHAR - No explicit conversion -
x: Conversion possible
-: Conversion not possible

See also
REAL (Page 1336)

Implicit conversion of REAL (Page 1382)

Overview of data type conversion (Page 1369)
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Explicit conversion of LREAL

Options for explicit conversion
The following table shows the options and instructions for explicit conversion of the LREAL 
data type:

Source Target Conversion Description Mnemonics of the instruction
LREAL BOOL - No explicit conversion

 
-

BYTE - -
WORD - -
DWORD - -
SINT X The value is converted to the target data 

type. The result of the conversion 
depends on the instruction used. Enable 
output ENO is set to "0" if the valid range 
of values of the target data type is 
exceeded during conversion, or if the 
value to be converted is an invalid 
floating-point number.

LREAL_TO_SINT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

USINT X LREAL_TO_USINT, ROUND, 
CEIL, FLOOR, TRUNC, NORM_X, 
SCALE_X

INT X LREAL_TO_INT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

UINT X LREAL_TO_UINT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

DINT X LREAL_TO_DINT, ROUND, CEIL, 
FLOOR, TRUNC, NORM_X, 
SCALE_X

UDINT X LREAL_TO_UDINT, ROUND, 
CEIL, FLOOR, TRUNC, NORM_X, 
SCALE_X

REAL X The value is converted to the target data 
type. Enable output ENO is set to "0" if 
the valid range of values of the target 
data type is exceeded during 
conversion, or if the value to be 
converted is an invalid floating-point 
number. A loss in accuracy is tolerated.

LREAL_TO_LREAL, ROUND, 
CEIL, FLOOR, TRUNC, NORM_X, 
SCALE_X

TIME - No explicit conversion -
DTL - -
TOD - -
DATE - -
STRING X The value is converted to a character 

string. Enable output ENO is set to "0" if 
the character string length is exceeded, 
or if the value to be converted is an 
invalid floating-point number. The string 
has a minimum length of 21 characters.

REAL_TO_STRING, S_CONV, 
VAL_STRG
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Source Target Conversion Description Mnemonics of the instruction
CHAR - No explicit conversion -

x: Conversion possible
-: Conversion not possible

See also
LREAL (Page 1337)

Overview of data type conversion (Page 1369)

Timers

Explicit conversion of TIME

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the TIME data 
type:

Source Target Conversion Description Mnemonics of the instruction
TIME BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value is 
transferred unchanged to the target data type.

TIME_TO_BYTE
WORD1) X TIME_TO_WORD
DWORD1

)
X TIME_TO_DWORD

SINT X The bit pattern of the source value is 
transferred unchanged right-justified and 
interpreted as milliseconds to the target data 
type.

TIME_TO_SINT
USINT X TIME_TO_USINT
INT X TIME_TO_INT
UINT X TIME_TO_UINT
DINT X The bit pattern of the source value is 

transferred unchanged to the target data type. 
The result of the conversion shows the 
duration in milliseconds. 

TIME_TO_DINT, T_CONV

UDINT X The bit pattern of the source value is 
transferred unchanged right-justified and 
interpreted as milliseconds to the target data 
type. Enable output ENO is set to "0" if the sign 
changes.

TIME_TO_UDINT

REAL - No explicit conversion -
LREAL - -
DTL - -
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Source Target Conversion Description Mnemonics of the instruction
TOD X The bit pattern of the source value is 

transferred unchanged right-justified to the 
target data type. If the source value exceeds 
the range of values of TOD, the target data 
type remains unchanged.

TIME_TO_TOD

DATE - No explicit conversion -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
TIME (IEC time) (Page 1341)

Implicit conversion of TIME (Page 1384)

Overview of data type conversion (Page 1369)

Clock and calendar

Explicit conversion of DATE

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the DATE data 
type:

Source Target Conversion Description Mnemonics of the instruction
DATE BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value 
is transferred unchanged right-
justified to the target data type.

DATE_TO_BYTE
WORD1) X DATE_TO_WORD
DWORD1) X DATE_TO_DWORD
SINT X The number of days since 1/1/1990 

is returned as result.
DATE_TO_SINT

USINT X DATE_TO_USINT
INT X DATE_TO_INT
UINT X DATE_TO_UINT
DINT X DATE_TO_DINT
UDINT X DATE_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME - -
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Source Target Conversion Description Mnemonics of the instruction
DTL X The bit pattern of the source value 

is transferred unchanged right-
justified to the target data type.

DATE_TO_DTL

TOD - No explicit conversion -
STRING - -
CHAR - -

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
DATE (Page 1342)

Implicit conversion of DATE (Page 1386)

Overview of data type conversion (Page 1369)

Explicit conversion of TOD

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the TOD data 
type:

Source Target Conversion Description Mnemonics of the instruction
TOD BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value 
is transferred unchanged to the 
target data type.

TOD_TO_BYTE
WORD1) X TOD_TO_WORD
DWORD1) X TOD_TO_DWORD
SINT X The number of milliseconds since 

midnight is returned as result.
TOD_TO_SINT

USINT X TOD_TO_USINT
INT X TOD_TO_INT
UINT X TOD_TO_UINT
DINT X TOD_TO_DINT
UDINT X The result of the conversion 

corresponds to the number of 
milliseconds since the start of day 
(0:00 hrs).

TOD_TO_UDINT, T_CONV

REAL - No explicit conversion -
LREAL - -
TIME X The duration since midnight is 

returned as result.
TOD_TO_TIME

DTL X The date is set to 1.1.1970 as a 
result.

TOD_TO_DTL
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Source Target Conversion Description Mnemonics of the instruction
DATE - No explicit conversion -
STRING - -
CHAR - -

x: Conversion possible
-: Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width including the sign and 
then the bits are copied. The source type determines the interpretation.

See also
TIME_OF_DAY (TOD) (Page 1343)

Implicit conversion of TOD (Page 1385)

Overview of data type conversion (Page 1369)

Explicit conversion of DTL

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the DTL data 
type:

Source Target Conversion Description Mnemonics of the instruction
DTL BYTE - No explicit conversion -

WORD - -
DWORD - -
SINT - -
USINT - -
INT - -
UINT - -
DINT - -
UDINT - -
REAL - -
LREAL - -
TIME - -
TOD X During the conversion, the time-of-day is 

extracted from the DTL format and written 
to the target data type.

DTL_TO_TOD, T_CONV

DATE X During the conversion, the date is 
extracted from the DTL format and written 
to the target data type. The enable output 
ENO is set to "0" in the event of overflow.

DTL_TO_DATE, T_CONV

STRING - No explicit conversion -
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Source Target Conversion Description Mnemonics of the instruction
CHAR - -

x: Conversion possible
-: Conversion not possible

See also
DTL (Page 1345)

Overview of data type conversion (Page 1369)

Character strings

Explicit conversion of CHAR

Options for explicit conversion           
The following table shows the options and instructions for explicit conversion of the CHAR data 
type:

Source Target Conversion Description Mnemonics of the instruction
CHAR BOOL - No explicit conversion -

BYTE1) X The bit pattern of the source value is 
transferred unchanged right-justified to 
the target data type.

CHAR_TO_BYTE
WORD1) X CHAR_TO_WORD
DWORD1) X CHAR_TO_DWORD
SINT X CHAR_TO_SINT
USINT X CHAR_TO_USINT
INT X CHAR_TO_INT
UINT X CHAR_TO_UINT
DINT X CHAR_TO_DINT
UDINT X CHAR_TO_UDINT
REAL - No explicit conversion -
LREAL - -
TIME - -
DTL - -
TOD - -
DATE - -
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Source Target Conversion Description Mnemonics of the instruction
STRING X The value is converted to the first 

character in the character string 
(STRING). If the length of the character 
string is not defined, the length "1" is set 
after the conversion. If the length of the 
character string is defined, this remains 
unchanged after the conversion.

CHAR_TO_STRING

x: Conversion possible
- : Conversion not possible
1) Bit strings (BYTE, WORD, DWORD) and data type CHAR are first extended to the necessary width and then the bits are 
copied. The source type determines the interpretation.

See also
CHAR (character) (Page 1346)

Implicit conversion of CHAR (Page 1387)

Overview of data type conversion (Page 1369)

Explicit conversion of STRING

Options for explicit conversion
The following table shows the options and instructions for explicit conversion of the STRING 
data type:

Source Target Conversion Description Mnemonics of the instruction
STRING BOOL - No explicit conversion -

BYTE - -
WORD - -
DWORD - -
SINT X Conversion begins with the first character in 

the character string (STRING) and stops at 
the end of the string or at the first inadmissible 
character. The following characters are 
permitted for conversion:
● Digit
● Sign
● Dot
The first character of the string may be a sign 
(+, -) or a number. Leading spaces will be 
ignored. The dot is used as separation for the 
conversion of floating-point numbers. The 
exponential notation "e" or "E" is not 
permitted. The comma as thousand 
separator is permitted to the left of the 
decimal point but will be ignored. If the layout 
of the character string is invalid for the 

STRING_TO_SINT, 
S_CONV, STRG_VAL

USINT X STRING_TO_USINT, 
S_CONV, STRG_VAL

INT X STRING_TO_INT, S_CONV, 
STRG_VAL

UINT X STRING_TO_UINT, 
S_CONV, STRG_VAL

DINT X STRING_TO_DINT, 
S_CONV, STRG_VAL

UDINT X STRING_TO_UDINT, 
S_CONV, STRG_VAL

REAL X STRING_TO_REAL, 
S_CONV, STRG_VAL
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Source Target Conversion Description Mnemonics of the instruction
LREAL X conversion or an overflow occurs, then the 

enable output ENO will be set to "0".
STRING_TO_LREAL, 
S_CONV, STRG_VAL

TIME - No explicit conversion -
DTL - -
TOD - -
DATE - -
CHAR1) X The first character in the character string 

(STRING) is transferred to the destination 
data type. If the string is empty, then the value 
"0" will be written in the destination data type.

STRING_TO_CHAR, 
S_CONV

x: Conversion possible
- : Conversion not possible

See also
STRING (Page 1347)

Overview of data type conversion (Page 1369)

9.1.1.6 Program flow control

EN/ENO mechanism

Basics of the EN/ENO mechanism

Introduction
Runtime errors that require a program abort can occur during the processing of instructions. 
You can use the EN/ENO mechanism to avoid such program aborts. This mechanism can be 
used at two levels:

● EN/ENO mechanism for individual instructions

● EN/ENO mechanism for block calls

EN/ENO mechanism for instructions in LAD/FBD
In LAD and FBD, certain instructions have an enable input EN and an enable output ENO. 

You can use the enable input EN to make the execution of the instruction dependent on 
conditions. The instructions are only executed if the signal state is "1" at the enable input EN. 

You can use the enable output ENO to query runtime errors in instructions and react to these.

The enable output ENO returns the signal state "1" if one of the following conditions applies:

● No error occurred during processing.

The enable output ENO returns signal state "0" if one of the following conditions applies:
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● The EN input has signal state "0".

● An error occurred during processing.

The EN/ENO mechanism is used for the following basic instructions:

● Mathematical functions

● Move operations

● Conversion operations

● Word logic operations

● Shift + rotate

In LAD and FBD, you can switch the evaluation of the enable output ENO on and off by means 
of the shortcut menu specifically for certain instructions.

EN/ENO mechanism for block calls in LAD/FBD
All blocks that you call in LAD or FBD are provided with an enable input EN and an enable 
output ENO when called. This applies to all called blocks, regardless of the programming 
language in which they were created.

You can use the enable input EN to call the block depending on conditions. The block is only 
executed if the signal state is "1" at the enable input EN. 

You can query the error status of the block with the enable output ENO. It has signal "1" as 
soon as the execution of the block starts. If you do not explicitly set the output ENO to "0" in 
the program code, it retains signal "1".
However, you can explicitly set it to "0" to return an error statement to the called block. In LAD 
or FBD, the output ENO is set with the instruction "RET: Return".

See also:

Example of the use of the EN/ENO mechanism in LAD (Page 1418)

Example of the use of the EN/ENO mechanism in FBD (Page 1418)

EN/ENO mechanism for STL
In STL, the EN/ENO mechanism is not required for individual instructions. This function is 
mapped by language-specific instruction sequences.

Blocks that you call from an STL block are not provided with the EN and ENO parameters. 
Regardless of the programming language in which they were created, you can transfer an 
error statement to the calling STL block using the BR bit of the status word.

In STL, you can evaluate the error status of the called block by linking the BR bit of the status 
word with the RLO. It has signal "1" as soon as the execution of the block starts. If you do not 
explicitly set it to "0" in the program code, it retains signal "1".
However, you can explicitly set it to "0" to return an error statement to the calling block. In STL, 
the error statement is set with the instructions "SAVE" or "JNB".

See also: Example of the simulation of the EN/ENO mechanism in STL (Page 1420)
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EN/ENO mechanism in SCL
With SCL, the use of the EN/ENO mechanism for instructions is optional. You can activate it 
with the block property "Set ENO automatically". If the property is active, all blocks implicitly 
receive an error handling.

You can implement a conditional block call with the enable input EN. Use the enable input EN 
in the parameter list as a normal input parameter. If EN has signal "1" or when EN is not used, 
the block is called. If EN has signal "0", the block is not called. 

 

 Note

When you call functions in SCL, you cannot use the release mechanism via EN. Use an IF 
statement instead to call functions conditionally.

 

You can query the error status of the block with the enable output ENO. If the ENO has signal 
"1", the block was processed without errors. If the ENO has signal "0", an error occurred during 
processing. To query the state of the enable output, insert an additional output parameter with 
the name ENO in the parameter list during a block call. 

See also: Example of the use of the EN/ENO mechanism in SCL (Page 1419)

ENO in GRAPH (S7-1500)
In GRAPH, you can use the ENO operand to evaluate whether an action has been completed 
successfully. You can select the "Set ENO automatically" option for this.

● Select the option in the program properties in order for it to be used as the default setting 
for new GRAPH blocks.

● Select the option in the block properties in order for it to be used for specific blocks. 

If this option is selected, the ENO operand is displayed when testing with program status. This 
operand has the value "TRUE" if the action was successful and "FALSE" if the action failed. 

The ENO operand can be used in the following cases:

● When blocks are called that have the enable output ENO.

● For instructions in which errors can occur, e.g., conversions or mathematical functions.

EN/ENO mechanism for memory and I/O access errors
You cannot evaluate memory and I/O access errors with the EN/ENO mechanism. You do this 
either with the global troubleshooting via OBs (S7-300/400 and S7-1200/1500) or local 
troubleshooting using the "GetError" instruction (S7-1200/1500 only). If a memory access error 
occurred for an instruction, you can evaluate the associated ENO.

See also
Enabling and disabling the EN/ENO mechanism (Page 1545)
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Example of the use of the EN/ENO mechanism in LAD

Description  
The following figure shows an ADD instruction with EN and ENO protective circuit:

After the normally open contact, the RLO contains the previous result of logic operation: 

● If "TagIn" signal is "0", the addition is not executed. EN and ENO both lead to the signal 
state "0".

● If "TagIn" signal is "1", EN is also "1" and the addition is executed. If no errors occur during 
the processing of the instruction, the output ENO also has the signal state "1" and the output 
""TagOut"" is set.

See also
Basics of the EN/ENO mechanism (Page 1415)

ADD: Add (Page 1964)

Example of the use of the EN/ENO mechanism in FBD

Description  
The following figure shows an ADD instruction with EN and ENO protective circuit:

 

● If "TagIn" signal is "1", EN is also "1" and the addition is executed. If no errors occur during 
the processing of the instruction, the output ENO also has the signal state "1" and the output 
""TagOut"" is set.

● If "TagIn" signal is "0", the addition is not executed. EN and ENO both lead to the signal 
state "0".
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See also
Basics of the EN/ENO mechanism (Page 1415)

Example of the use of the EN/ENO mechanism in SCL

Example of the EN/ENO mechanism for basic instructions  
To use the EN/ENO mechanism for instructions in SCL, you have to activate the block property 
"Set ENO automatically". The following example shows the use of the enable output ENO for 
the "a/b" instruction. 

SCL
"MyoutputREAL" :=a/b;
IF ENO
    THEN "MyOutputBool":=1;
    ELSE "MyOutputBool":=0;
END_IF;

If the "a/b" instruction is executed error-free, MyOutputBool has signal "1". 

Example of the use of the EN/ENO mechanism in block calls
The following example shows the use of the enable output ENO for a block call. 

SCL
"MyDB"."MyFB"(EN:="MyTag1">"MyTag2",
              in1:="MyInputBool1",
              in2:="MyInputBool1",
              EN0=>"MyOutputBool");

If MyTag1 is not greater than MyTag2 the block call is not processed. EN and ENO both lead 
to the signal state "0".

If MyTag1 is greater than MyTag2, EN has signal "1" and the block call is executed.

If all instructions within MyFB are executed error-free, MyOutputBool has signal "1".

See also
Basics of the EN/ENO mechanism (Page 1415)
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Example of the simulation of the EN/ENO mechanism in STL

Description 
The following example shows an program section for adding values with EN and ENO 
connected:

 STL Description
A"Tag_Input_1" // Query whether the signal state of the operand 

is "1" and AND with current RLO
JNBMyLABEL // Evaluation of the EN input

// If RLO="0" jump to jump label "MyLABEL" and 
save the current RLO in the BR
// Execute next instruction if RLO="1"

L"Tag_Input_2" // Load first value of addition
L"Tag_Input_3" // Load second value of addition
+I // Add values
T "Tag_Result" // Transfer sum to the operand "Tag_Result"
AN OV // Query if errors occurred
SAVE // Transfer signal state of the RLO to the BR bit
CLR // Reset RLO to "0"
MyLABEL: U BR // Jump label "MyLABEL"

// Query BR and AND with RLO
= "Tag_Output" // Assign signal state of the RLO to the operand 

"Tag_Output" 

 

The query of the operand "U" Tag_Input_1"" provides the result of the preceding logic operation 
(RLO). The instruction "Jump at RLO = 0 and save RLO (SPBNB)" saves the RLO to the BR. 
The instruction "Jump if RLO = 0 and save RL0" also evaluates the RLO and executes one of 
the following actions depending on the evaluation: 

● If the RLO is "0", the processing of the program is continued at the jump label "MyLABEL" 
with the query of the BR. The addition is not executed. Assign the current RLO to the 
operand "Tag_Output".

● If the RLO is "1", the addition is executed. A query of the overflow bit (OV) shows if an error 
occurred during the addition. The query result is saved in the BR. The operation "CLR" 
resets the RLO to "0". The BR is then queried for "1" and AND'd with the current RLO. The 
result is assigned to the operand "Tag_Output". The signal state of the BR and of the 
operand "Tag_Output" shows if the addition was carried out with any error

See also
Basics of the EN/ENO mechanism (Page 1415)

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1420 System Manual, 02/2014



9.1.2 Declaring PLC tags

9.1.2.1 Overview of PLC tag tables

Introduction     
PLC tag tables contain the definitions of the PLC tags and symbolic constants that are valid 
throughout the CPU. A PLC tag table is created automatically for each CPU used in the project. 
You can create additional tag tables and use these to sort and group tags and constants.

In the project tree there is a "PLC tags" folder for each CPU of the project. The following tables 
are included:

● "All tags" table

● Standard tag table

● Optional: Other user-defined tag tables

All tags
The "All tags" table gives an overview of all PLC tags, user constants and system constants 
of the CPU. This table cannot be deleted or moved.

Standard tag table
There is one standard tag table for each CPU of the project. It cannot be deleted, renamed or 
moved. The default tag table contains PLC tags, user constants and system constants. You 
can declare all PLC tags in the default tag table, or create additional user-defined tag tables 
as you want.

User-defined tag tables
You can create multiple user-defined tag tables for each CPU to group tags according to your 
requirements. You can rename, gather into groups, or delete user-defined tag tables. User-
defined tag tables can contain PLC tags and user constants.

 

 

See also
Structure of the PLC tag tables (Page 1422)

Using tags within the program (Page 1295)

Basics of constants (Page 1296)
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9.1.2.2 Structure of the PLC tag tables

Introduction       
Each PLC tag table contains a tab for tags and a tab for user constants. The default tag table 
and the "All tags" table also have a "System constants" tab. 

Structure of the "PLC tags" tab
In the "Tags" tab you declare the global PLC tags that you require in the program. The following 
figure shows the tab structure. The number of columns shown may vary.

 

The following table shows the meaning of the individual columns. The number of columns 
shown may vary. You can show or hide the columns as required.

Column Description
Symbol you can click on to drag-and-drop a tag to a program for use 
as an operand.

Name Unique name for the constants throughout the CPU.
Data type Data type of the tags.
Address Tag address.
Retain Marks the tag as retentive.

The values of retentive tags are retained even after the power supply 
is switched off. 

Accessible from HMI Shows whether HMI can access this tag during runtime.
Visible in HMI Shows whether the tag is visible by default in the operand selection 

of HMI.
Monitor value Current data value in the CPU. 

This column only appears if an online connection is established and 
you select the "Monitor all" button.

Tag table Shows which tag table includes the tag declaration.
This column is only available in the "All tags" table.

Comment Comment to document the tags.

Structure of the "User constants" and "System constants" tabs
In the "User constants" you define symbolic constants that are valid throughout the CPU. The 
constants required by the system are shown in the "Systems constants" tab. System constants 
can be hardware IDs, for example, which can be used for identification of modules. 

The following figure shows the structure of both tabs. The number of columns shown may vary.
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The following table shows the meaning of the individual columns. You can show or hide the 
columns as required.

Column Description
Symbol you can click to move a tag into a network via a drag-and-
drop operation for use as an operand.

Name Unique name for the constants throughout the CPU.
Data type Data type of the constants
Value Value of the constants
Tag table Shows which tag table includes the constant declaration.

This column is only available in the "All tags" table.
Comment Comments to document the tags.

 

 

See also
Using tags within the program (Page 1295)

Basics of constants (Page 1296)

Overview of PLC tag tables (Page 1421)

Show and hide table columns (Page 1443)

Editing tables (Page 342)

9.1.2.3 Rules for PLC tags

Valid names of PLC tags

Permissible characters
The following rules apply to the use of names for PLC tags:

● Letters, numbers, special characters are permitted.

● Quotation marks are not permitted.
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Unique tag names
The names of the PLC tags must be unique throughout the CPU, even if the tags are located 
in different tag tables of a CPU. A name that is already used for a block, another PLC tag or 
a constant within the CPU, cannot be used for a new PLC tag. The uniqueness check does 
not differentiate between use of small and capital letters. 

If you enter an already assigned name another time, a sequential number is automatically 
appended to the second name entered. For example, if you enter the name "Motor" a second 
time, the second entry is changed to "Motor(1)".

Unique table names
The names of the PLC tag tables must also be unique throughout the CPU. A unique name is 
automatically suggested when user-defined PLC tag tables are being created.

 

See also
Using tags within the program (Page 1295)

Permissible addresses and data types of PLC tags (Page 1424)

Keywords (Page 1289)

Permissible addresses and data types of PLC tags
The addresses of PLC tags are made up of the particulars of the operand area and the address 
within this area. 

The addresses must be unique throughout the CPU. If you enter an address that is already 
assigned to another tag, the address will be highlighted at both places in yellow and an error 
message will be issued. 
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Operand areas
The following table shows the possible operand areas. The available data types depend on 
the CPU you use:

Operand area Description Data type Format Address area:
Internatio
nal 
mnemoni
cs

German 
mnemoni
cs

S7-1200 S7-300/400 S7-1500

I E Input bit BOOL I x.y
E x.y

0.0..1023.7 0.0..65535.7 0.0..32767.7

I E Input (64-bit) LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT, 
LREAL, PLC 
data type

I x.0
E x.0

- - 0.0..32760.0

IB EB Input byte BYTE, 
CHAR, SINT, 
USINT, PLC 
data type

IB x
EB y

0..1023 0..65535 0..32767

IW EW Input word WORD, INT, 
UINT, DATE, 
S5TIME, 
PLC data 
type

IW x
EW y

0..1022 0..65534 0..32766

ID ED Input double 
word

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD, PLC 
data type

ID x
ED y

0..1020 0..65532 0..32764

Q A Output bit BOOL Q x.y 
A x.y

0.0..1023.7 0.0..65535.7 0.0..32767.7

Q A Output (64-
bit)

LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT, 
LREAL, PLC 
data type

Q x.0 
A x.0

- - 0.0..32760.0

QB AB Output byte BYTE, 
CHAR, SINT, 
USINT, PLC 
data type

QB x 
AB y

0..1023 0..65535 0..32767

QW AW Output word WORD, INT, 
UINT, DATE, 
S5TIME, 
PLC data 
type

QW x 
AW y

0..1022 0..65534 0..32766
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Operand area Description Data type Format Address area:
Internatio
nal 
mnemoni
cs

German 
mnemoni
cs

S7-1200 S7-300/400 S7-1500

QD AD Output 
double word

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD, PLC 
data type

QD x 
AD y 

0..1020 0..65532 0..32764

M M Memory bit BOOL M x.y 0.0..8191.7 0.0..65535.7 0.0..16383.7
M M Bit memory 

(64-bit)
LREAL M x.0 0.0..8184.0 - 0.0..16376.0

M M Bit memory 
(64-bit)

LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT

M x.0 - - 0.0..16376.0

MB MB Memory byte BYTE, 
CHAR, SINT, 
USINT

MB x 0..8191 0..65535 0..16383

MW MW Memory word WORD, INT, 
UINT, DATE, 
S5TIME

MW x 0..8190 0..65534 0..16382

MD MD Memory 
double word

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD

MD x 0..8188 0..65532 0..16380

T T Time function 
(for 
S7-300/400 
only)

Timer T n - 0..65535 0..2047

C Z Counter 
function (for 
S7-300/400 
only)

Counter Z n
C n

- 0..65535 0..2047

Addresses
The following table shows the possible addresses of tags:

Data type Address Example
BOOL Tags with BOOL data type are addressed with a byte number and a 

bit number. The numbering of the bytes begins for each operand area 
at 0. The numbering of the bits goes from 0 to 7.

A 1.0

BYTE, 
CHAR, SINT, 
USINT

Tags with BYTE, CHAR, SINT, and USINT data type are addressed 
with a byte number.

MB 1
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Data type Address Example
WORD, INT, 
UINT, DATE, 
S5TIME

Tags with WORD, INT, UINT, DATE, S5TIME data type consist of two 
bytes. They are addressed with the number of the lowest byte.

IW 1

DWORD, 
DINT, 
UDINT, 
REAL, TIME, 
TOD

Tags with DWORD, DINT, UDINT, REAL, TIME, TOD data type 
consist of four bytes. They are addressed with the number of the 
lowest byte.

AD 1

LWORD, 
LINT, ULINT, 
LTIME, 
LTOD, LDT, 
LREAL

Tags of data type LWORD, LINT, ULINT, LTIME, LTOD, LDT, and 
LREAL consist of eight bytes. They are addressed with it number 0 
and the number of the lower byte.
 

I 1.0

Mnemonics used
The addresses that you enter in the PLC tag table are automatically adapted to the set 
mnemonics. 

See also
Setting the mnemonics (Page 1480)

Using tags within the program (Page 1295)

Valid names of PLC tags (Page 1423)

Overview of the valid data types (Page 1320)

9.1.2.4 Creating and managing PLC tag tables

Creating a PLC tag table
You can created multiple user-defined PLC tag tables in a CPU. Each tag table must have 
have a unique name throughout the CPU.

Requirement
The project view is open.

Procedure   
To created a new PLC tag table, follow these steps:

1. Open the "PLC tags" folder under the CPU in the project tree.

2. Double-click the "Add new tag table" entry.
A new PLC tag table with the default name "TagTable_x" is created.

3. Select the PLC tag table in the project tree.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1427



4. Select the "Rename" command in the shortcut menu.

5. Type in a name that is unique throughout the CPU.

Result
A new PLC tag table is created. You can now declare tag and constants in this table.

See also
Overview of PLC tag tables (Page 1421)

Structure of the PLC tag tables (Page 1422)

Grouping PLC tag tables
You can gather the user-defined tag tables of the CPU into groups. You cannot, however, 
move the standard tag table and the "All tags" table into a group.

Requirement
Multiple user-defined tag tables are contained in the "PLC tags" folder of the CPU.

Procedure  
To gather multiple PLC tag tables into a group, follow these steps:

1. Select the "PLC tags" folder under the CPU in the project tree.

2. Select the "Insert > Group" menu command.
A new group with the standard name "Group_x" is inserted.

3. Select the newly inserted group in the project tree.

4. Select the "Rename" command in the shortcut menu.

5. Assign the new group a unique name throughout the CPU.

6. Drag to the new group the tables you want to group together.

Result
The tag tables are gathered in the new group.

See also
Overview of PLC tag tables (Page 1421)

Structure of the PLC tag tables (Page 1422)
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Opening the PLC tag table

Procedure 
To open the PLC tag table in a CPU, proceed as follows:

1. Open the "PLC tags" folder under the CPU in the project tree.

2. Double-click the PLC tag table in the folder.

3. Select the desired tab in the upper corner.

Result
The PLC tag table associated with the CPU opens. You can declare the required tags and 
constants.

See also
Overview of PLC tag tables (Page 1421)

Structure of the PLC tag tables (Page 1422)

9.1.2.5 Declaring PLC tags

Entering a PLC tag declaration

Declaring tags in the PLC tag table

Requirements
The "Tags" tab of the PLC tag table is open.  

Procedure
To define PLC tags, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input.
An address corresponding to the data type is automatically appended.

3. Optional: Click on the arrow key in the "Address" column and enter an operand identifier, 
an operand type, an address and a bit number in the dialog which then opens.

4. Optional: Enter a comment in the "Comments" column.

5. Repeat steps 1 to 4 for all the tags you require.

See also: Permissible addresses and data types of PLC tags (Page 1424) 
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Syntax check
A syntax check is performed automatically after each entry, and any errors found are displayed 
in red. You do not have to correct these errors immediately - you can continue editing and 
make any corrections later. As long as the tag declaration contains syntax errors and the tag 
is used in the program, you will not be able to compile the program. 

See also
Valid names of PLC tags (Page 1423)

Declaring PLC tags in the program editor (Page 1430)

Structure of the PLC tag tables (Page 1422)

Editing tables (Page 342)

Declaring PLC tags in the program editor

Requirement  
● The program editor is open.

Procedure
To declare operands as global PLC tags, follow these steps:

1. Insert an instruction in your program.
The "<???>", "<??.?>" or "..." strings represent operand placeholders.

2. Replace an operand placeholder with the name of the PLC tag to be created.

3. Select the tag name.
If you want to declare multiple PLC tags, select the names of all the tags to be declared.

4. Select the "Define tag" command in the shortcut menu.
The "Define tag" dialog box opens. This dialog displays a declaration table in which the 
name of the tag is already entered.

5. Click the arrow key in the "Section" column and select one of the following entries:

– Global Memory

– Global Input

– Global Output

6. In the other columns, enter the address, data type, and comments.
See also: Permissible addresses and data types of PLC tags (Page 1424) 

7. If the CPU contains multiple PLC tag tables, you can use an entry in the "PLC tag table" 
column to indicate in which table the tag is to be inserted. If you make no entry in the column, 
the new tag will be inserted in the default tag table.

8. Click the "Define" button to complete your entry.

 

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1430 System Manual, 02/2014



Result
The tag declaration is written to the PLC tag table and is valid for all blocks in the CPU.

See also
Valid names of PLC tags (Page 1423)

Editing tables (Page 342)

Declaring tags in the PLC tag table (Page 1429)

Setting the retentivity of PLC tags

Retentive behavior of PLC tags

Retentive PLC tags       
Each CPU has a memory area whose content remains available even after the supply voltage 
has been switched off. This area is referred to as retentive memory area.

To avoid data loss during power failure, you can save specific PLC tags to this memory area. 
You specify the retain setting of PLC tags in the PLC tag table. 

Depending on the CPU family, the retentive memory area can accommodate various type of 
PLC tags. The following table provides an overview of the options of the various CPUs:

CPU type Retentive bit memories Retentive SIMATIC timers Retentive SIMATIC counters
S7-300/400 series ✓ - -
S7-1200 series ✓ - -
S7-1500 series ✓ ✓ ✓

See also
Setting the retentive behavior of PLC tags (Page 1431)

Setting the retentive behavior of PLC tags

Introduction       
In the PLC tag table you can specify the width of the retentive memory area for PLC tags. All 
tags with addresses in this memory area are then designated as retentive. You can recognize 
the retentivity setting of a tag by the check mark set in the "Retain" column of the PLC tag 
table. 

Requirement
The "PLC tags" tab of the PLC tag table is open.
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Procedure
To define the width of the retentive memory area for PLC tags, follow these steps:

1. On the toolbar, click the "Retain" button.
The "Retain memory" dialog will open.

2. Specify the width of the retentive memory area by entering the number of retentive bytes, 
timers or counters in the input field.

3. Click the "OK" button.

Result
The width if the retentive memory area is defined. In the "Retain" column of the tag table a 
check mark is automatically set for all tags that are located within the retentive memory area.

See also
Retentive behavior of PLC tags (Page 1431)

Editing tables (Page 342)

9.1.2.6 Grouping PLC tags for inputs and outputs in structures

Other useful information regarding structured PLC tags

Use of structured PLC tags (S7-1200 V4 and higher/S7-1500)
To make your program easier to view, you can group several input or output addresses in a 
higher-level PLC tag. The higher-level PLC tag represents a structure that contains several 
logically related inputs or outputs. When the block is called, you transfer the higher-level tag 
and thus need only an input or output parameter for all associated inputs or outputs.

Principle of operation
To create a structured PLC tag, you initially define a PLC data type (UDT). In it you declare 
the necessary data elements and specify their names and data types.

Then, you switch to the PLC tag table and specify the higher-level PLC tag there. As a data 
type for the tag, you select your PLC data types. The system now reserves a certain number 
of input or output addresses starting from the start address of the higher-level tag. The number 
of reserved addresses depends on the length of your PLC data type. 

If you call a block that requires the reserved inputs or outputs for program execution, you 
transfer the higher-level tag as a block parameter.

You can address the individual PLC tags like structure elements in the program code.

A detailed description of the individual handling steps can be found in the following chapters.
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Application example
You can use structured PLC tags in order to group the inputs or outputs of a function module. 
The following figure shows the schematic representation of a motor: A component was created 
in the "Datatype_Motor" PLC data type for each of the three inputs. 

The memory areas of the declared tags must not overlap. In the example, you see that the 
"Speed" component has the data type "Integer" and therefore must start at a word address. 
For this reason, the first input word has been filled with the "Dummy" fill tag. This means that 
"Speed" is located on the second input word.

 

 

The following figure shows the higher-level "Motor" PLC tag that is based on the "Data 
type_Motor" data type. With the declaration of "Motor", the addresses IW0 and IW1 are 
reserved on the input module.

 

 

The following figure shows the transfer of the "Motor" PLC tag as an input parameter of the 
"Motor_Control" block.

You can address the individual components of the tag in the "Motor_Control" block.
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Addressing Description
"Motor" Addressing the higher-level PLC tag.
"Motor".On Addressing a component of a structured PLC tag.
"Motor".On:P Addressing an I/O input or output (PI or PO).

Rules for use of structured PLC tags
Note the following rules when creating and using structured PLC tags.

● Structured PLC tags can be used in the "Inputs" and "Outputs" operand areas.

● Structured tags are not permitted in the bit memory address area.

● Structured PLC tags cannot be addressed from HMI.

Observe the following rules when creating the PLC data type that is to serve as the basis for 
a PLC tag:

● The memory areas of the individual elements must not overlap.
See also: Permissible addresses and data types of PLC tags (Page 1424)

● Do not group inputs and outputs in one PLC data type but create different PLC data types 
for inputs and outputs.

● Do not group inputs or outputs from different modules in a PLC data type because it is not 
guaranteed that the process images of the modules are updated synchronously.

● In the lower-level PLC data types, all data types are permitted except for the "STRING" 
data type.

See also
Creating structured PLC tags (Page 1434)

Creating structured PLC tags

Rules
Note the following rules when creating structured PLC tags:

● Use separate PLC data types for the "Inputs" and "Outputs" operand areas. 

● Structured tags are not permitted in the bit memory address area.

● Do not group inputs or outputs from different modules in a PLC data type because it is not 
guaranteed that the process images of the modules are updated synchronously.
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Procedure
To create a structured PLC tag, follow these steps:

1. Double-click the "Add new data type" command in the "PLC data types" folder in the project 
tree.
A new declaration table for creating a PLC data type will be created and opened.

2. Declare all the necessary components in the PLC type. All data types except the "STRING" 
data type are permitted.

3. Select the PLC data type in the project tree and select the "Compile > Software (only 
changes)" command from the shortcut menu.
The PLC data type is compiled and can then be used in the PLC tag table.
Even when you make changes to existing PLC data types, you must recompile the program. 
This updates all locations of use of the PLC data type.

4. Open a PLC tag table within the same CPU.

5. Declare a new tag or select an existing tag.

6. In the "Data type" column, select the PLC data type and assign it to the PLC tag.
The PLC tag receives the structure of the PLC data type. A suitable address is assigned 
automatically. Structured PLC tags always start at word addresses.
The highest structure element is displayed without its subelements in the table.

 

 Note
Assignment rules and default values
● For the declaration of the PLC data type, note that the memory areas of the individual tags 

must not overlap. For example, tags of data type "Integer" must start at a word limit. If 
necessary, insert "fill tags" to prevent overlaps.
See also: Permissible addresses and data types of PLC tags (Page 1424)

● It is not possible to assign default values for the individual components. Values that you 
enter in the "Default value" column are not evaluated. Tags of data types "DT" and "DTL" 
may therefore contain invalid values.

 

See also
Other useful information regarding structured PLC tags (Page 1432)

9.1.2.7 Declaring global constants

Rules for global constants

Permitted characters
Names of global constants may consist of the following characters:

● Letters, numbers, special characters are permitted.

● Quotation marks are not permitted.
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Unique constant names
The names of global constants must be unique throughout the CPU, even if the constants are 
located in different tag tables of a CPU. A name that is already used for a block, a PLC tag or 
another constant within the CPU, cannot be used for new constant. The uniqueness check 
does not differentiate between use of small and capital letters. 

If you enter an already assigned name another time, a sequential number is automatically 
appended to the second name entered. For example, if you enter the name "Motor" a second 
time, the second entry is changed to "Motor(1)".

Permitted data types   
For constants, all data types supported by the CPU are permitted, with the exception of 
structured data types.

Permitted values
You can select any value from the value range of the specified data type as constant value. 
For information on the value ranges, refer to the "Data types" chapter.

See also: Auto-Hotspot 

See also
Basics of constants (Page 1296)

Declaring global constants (Page 1436)

Declaring global constants

Introduction   
You declare constants in the "User constants" tab of a PLC tag table. During declaration you 
have to to enter a symbolic name, a data type and a fixed value for each constant. You can 
select any value from the value range of the specified data type as constant value. For 
information on the value ranges, refer to the "Data types" chapter.

See also: Auto-Hotspot 

Procedure
To declare constants, follow these steps:

1. Open a PLC tag table.

2. Open the "User constants" tab.
The constants table opens.

3. Enter a constant name in the "Name" column.

4. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input.
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5. Enter a constant value in the "Value" column; this constant value must be valid for the 
selected data type.

6. If you want, enter comments on the constants in the "Comments" column. The entry of a 
comment is optional.

7. If you want to declare additional constants, place the cursor in the next row and repeat 
steps 3 to 6.

Syntax check
A syntax check is performed automatically after each entry, and any errors found are displayed 
in red. You do not have to correct these errors immediately - you can continue editing and 
make any corrections later. As long as the tag declaration contains syntax errors and the 
constant is used in the program, you will not be able to compile the program.

See also
Opening the PLC tag table (Page 1429)

Inserting a table row in the PLC tag table (Page 1440)

Structure of the PLC tag tables (Page 1422)

Rules for global constants (Page 1435)

Editing tables (Page 342)

9.1.2.8 Editing properties

Editing the properties of PLC tags

Properties of PLC tags

Overview   
The following table provides an overview of the properties of PLC tags. The display of 
properties may vary depending on the CPU type.

Group Property Description
General Name A unique name within the CPU.

Data type Data type of the tags.
Address Tag address.
Retain Shows whether the tag is in the retentive memory area.
Comment Comment on the tag.

History Date created Time when the tag was created (cannot be changed).
Last modified Time when the tag was last changed (cannot be changed).
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Group Property Description
Usage Visible in HMI Shows whether the tag is visible by default in the HMI 

selection list.
Accessible from HMI Shows whether HMI can access this tag during runtime.

See also
Editing the properties of PLC tags (Page 1438)

Editing the properties of PLC tags

Editing properties in a PLC tag table  
To edit the properties of one or more tags, follow these steps:

1. In the project tree, double-click the PLC tag table that contains the tags.
The PLC tag table opens.

2. Change the entries in the columns.

Editing addresses in the program editor
To edit the address of a tag in the program editor, follow these steps:

1. Select the tag name.

2. Select the "Rewire tag" command in the shortcut menu.
The "Rewire tag" dialog will open. The dialog shows a declaration table.

3. Enter the new address in the "Address" column.

4. Click the "Change" button to confirm the input.

Editing names in the program editor
To edit the name of a tag in the program editor, follow these steps:

1. Select the tag name.

2. Select the "Rename tag" command in the shortcut menu.
The "Rename tag" dialog opens. The dialog shows a declaration table.

3. Enter the new name in the "Name" column.

4. Click the "Change" button to confirm the input.

Effect in the program
In the case of a change of the tag's name, data type or address, each location of use of the 
tag is automatically updated in the program. 
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See also
Properties of PLC tags (Page 1437)

Editing properties of global constants

Properties of global constants

Overview   
The following table gives an overview of the properties of constants:

Group Property Description
General Name A unique name within the table

Data type Data type of the constants
Value Value that you defined for the constants. 

This value must be compatible with the declared data 
type. 
See also: Auto-Hotspot 

Comment Comment on the constants
History Date created Time when the constant was created (cannot be changed)

Last modified Time when the constant was last changed (cannot be 
changed)

Editing properties of global constants

Editing properties in a PLC tag table  
To edit the properties of one or more constants, follow these steps: 

1. In the project tree, double-click the PLC tag table that contains the constants.
The PLC tag table opens.

2. Open the "User constants" tab.

3. Change the entries in the "Name", "Data type", "Value", or "Comments" column.

Effect in the program
In the case of a change of a constant's name, data type or value, each location of use of the 
constant is automatically updated in the program. 

 

See also
Editing tables (Page 342)
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9.1.2.9 Monitoring of PLC tags

Monitoring of PLC tags
You can monitor the current data values of the tags on the CPU directly in the PLC tag table.

Requirements  
An online connection to the CPU is available.

Procedure
To monitor the data values, proceed as follows:

1. Open a PLC tag table.

2. Start monitoring by clicking the "Monitor all" button.
The additional "Monitor value" column is displayed in the table. This shows the current data 
values. 

3. End the monitoring by clicking the "Monitor all" button again.
 

 Note

You also have the option of copying PLC tags to a monitor or force table so that you can 
monitor, control or force them in the table.

 

See also
Structure of the PLC tag tables (Page 1422)

Introduction to testing with the watch table (Page 1771)

Introduction for testing with the force table (Page 1798)

Copying entries in the PLC tag table (Page 1441)

9.1.2.10 Editing PLC tag tables

Inserting a table row in the PLC tag table

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.
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Result
A new row is inserted above the selected row. 

See also
Editing tables (Page 342)

Copying entries in the PLC tag table
You can copy PLC tags within a table or to other tables. 

Procedure  
To copy a tag, follow these steps:

1. Select the tags you want to copy.
You can also select several tags by clicking on them one after the other while holding down 
the <Ctrl> key or by pressing and holding down <Shift> and clicking on the first and last 
tag.

2. Select "Copy" in the shortcut menu.

3. Position the insertion pointer at the location where you want to insert the tags.

4. Select "Paste" in the shortcut menu.

Or

1. Select the tag.

2. Hold down the left mouse button.

3. At the same time, press <Ctrl>.

4. Drag the tag to the destination.

Result
● The tag is copied to the destination.

● If there is a name conflict, a number is automatically appended to the tag name. For 
example, "Tag" becomes "Tag(1)".

● All other properties of the tag remain unchanged.

See also
Editing tables (Page 342)
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Deleting entries in the PLC tag table

Procedure   
Follow the steps below to delete elements:

1. Select the row with the element to be deleted. You can also select several rows by clicking 
on them one after the other while holding down the <Ctrl> key or by pressing and holding 
down <Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.

See also
Editing tables (Page 342)

Sorting rows in the PLC tag tables
You can sort the rows in the tables alphanumerically by name, data type, or address.

Procedure     
To sort the table rows, follow these steps:

1. Select the column by which you want to sort.

2. Click the column header.
The column will be sorted in order of increasing values.
An up arrow shows the sort sequence.

3. In order to change the sort sequence, click the arrow.
The column will be sorted in order of decreasing values. A down arrow shows the sort 
sequence.

4. To restore the original sequence, click a third time on the column header.

See also
Editing tables (Page 342)

Automatically filling in cells in the PLC tag table
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

If you fill the cells in the column "Address" automatically, the addresses will be increased 
depending on the indicated data type.
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Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. If entries are already present in the cells that are to be 
automatically updated, a dialog appears in which you can indicate whether you want to 
overwrite the existing entries or whether you want to insert new rows for the new tags.

See also
Editing tables (Page 342)

Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

See also
Editing tables (Page 342)

Editing PLC tags with external editors

Basics for importing and exporting

Introduction  
You can export PLC tag tables to a standardized XLSX format for editing with external table 
editors. Similarly, you can import PLC tag tables created with external table editors to the TIA 
Portal.
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Overwriting existing PLC tags and constants during import
Existing entries of the same name will be overwritten during import if they have the same name 
as the entries that will be imported. 

Link to existing objects
References to PLC tags or constants that already exist in the project are updated automatically 
during import. The update is executed based on the name of the PLC tags and constants. 

 

See also
Format of the export file (Page 1444)

Exporting PLC tags (Page 1445)

Importing PLC tags (Page 1445)

Format of the export file

Introduction   
During the export of PLC tag tables, a standardized XSLX format will be generated that you 
can edit with external table editors. 

This format is also expected during the import of tables.

Format of the export file
The sheet is always named "PLC Tags". This sheet can contain the displayed columns. The 
sorting order of columns can vary. The sheet does not necessarily have to include all columns. 
During import, the following values will be identified by a <no value> entry. 

The names of the column headers are also clearly defined and are always expected in English. 

The following table specifies the contents expected for the individual columns:

Element Explanation
Name Name of the tags
Path Group and name of the PLC tag table
Data Type The notation of the data type corresponds to the 

notation used in the PLC tag table.
Logical Address The address can be specified with German or 

international mnemonics.
Comment Free-form comments
Hmi Visible The value TRUE or FALSE is expected.
Hmi Accessible The value TRUE or FALSE is expected.
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See also
Basics for importing and exporting (Page 1443)

Exporting PLC tags (Page 1445)

Importing PLC tags (Page 1445)

Exporting PLC tags

Requirement  
A PLC tag table is open.

Procedure
To export PLC tags and constants, follow these steps:

1. In the PLC tag table, click the "Export" button.
The "Export to Excel" dialog opens.

2. Select the path to which you want to save the export file.

3. Select whether to export tags and/or constants.

4. Click the "OK" button.

Result
The export file will be generated. Errors and warnings generated during export are indicated 
in the "Info" tab of the Inspector window.

See also
Basics for importing and exporting (Page 1443)

Format of the export file (Page 1444)

Importing PLC tags (Page 1445)

Importing PLC tags

Requirement  
A table exists and it conforms to format specifications.
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Procedure
To import a PLC tag table, follow these steps:

1. Open the "All tags" table.

2. Click the "Import" button.
The "Import from Excel" dialog opens.

3. Select whether to import PLC tags and/or constants.

4. Select the table you want to import.

5. Click the "OK" button.

Result
The PLC tag table will be imported. 

Errors and warnings generated during export are indicated in the "Info" tab of the Inspector 
window.

See also
Basics for importing and exporting (Page 1443)

Format of the export file (Page 1444)

Exporting PLC tags (Page 1445)

Editing individual PLC tags with external editors
To edit individual PLC tags in external editors outside the TIA portal, you can export or import 
these tags using copy and paste. However, you cannot copy structured tags to an editor.

Requirement
A PLC tag table and an external editor are opened.

Procedure
To export and import individual PLC tags, follow these steps:

1. Select one or more PLC tags.

2. Select "Copy" in the shortcut menu.

3. Switch to the external editor and paste the copied tags.

4. Edit the tags as required.

5. Copy the tags in the external editor.

6. Switch back to the PLC tag table.

7. Select "Paste" in the shortcut menu.
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 Note

You also have the option of export or importing PLC tags as mass data. 

See also: Auto-Hotspot
 

9.1.3 Creating and managing blocks

9.1.3.1 Creating blocks

Block folder

Function    
You can find a "Program blocks" folder in the project tree, in which you can create and manage 
the following blocks:

● Organization blocks (OB)

● Function blocks (FB)

● Functions (FCs)

● Data blocks (DB)

A "System blocks" subfolder containing another subfolder, "Program resources", is also 
created in the "Program blocks" folder the first time you drag an instruction to your program 
which is an internal system function block. The instance data block of the internal system 
function block is also pasted to the "Program resources" folder. You can move or copy such 
instance data blocks from the "Program resources" folder to any other folder and rename or 
delete them. You can also move your blocks into the "Program resources" folder. Blocks in 
the "Program resources" folder that are not required to run the user program are removed 
during the next compilation. If the "Program resources" folder contains no more blocks then it 
is also deleted with the "System blocks" folder.

A program cycle OB is automatically generated for each device and inserted in the "Program 
blocks" folder. 

See also
Creating functions and function blocks (Page 1449)

Creating data blocks (Page 1450)

Creating organization blocks (Page 1448)

Using blocks from libraries (Page 1451)

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1447



Creating organization blocks

Requirement 
The "Program blocks" folder in the project tree is open.

Procedure
To create an organization block, follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Organization block (OB)" button.

3. Select the type of new organization block.

4. Enter a name for the new organization block.

5. Enter the properties of the new organization block.

6. To enter additional properties for the new organization block, click "Additional information".
An area with further input fields is displayed.

7. Enter all the properties you require.

8. Activate the "Add new and open" check box if the organization block does not open as soon 
as it is created.

9. Confirm your entries with "OK".

Result
The new organization block is created. You can find the organization block in the project tree 
in the "Program blocks" folder. You can assign additional parameters to some organization 
blocks in the inspector window or device view after they have been created. The organization 
block description will state whether the newly created organization block has additional 
parameters. 

See also
Organization blocks (OB) (Page 1262)

Block folder (Page 1447)

Creating functions and function blocks (Page 1449)

Creating data blocks (Page 1450)

Using blocks from libraries (Page 1451)

Entering a block title (Page 1457)

Entering a block comment (Page 1458)
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Creating functions and function blocks

Requirement   
The "Program blocks" folder in the project tree is open.

Procedure
To create a function (FC) or a function block (FB), follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Function block (FB)" or "Function (FC)" button.

3. Enter a name for the new block.

4. Enter the properties of the new block.

5. To enter additional properties for the new block, click "Additional information".
An area with further input fields is displayed.

6. Enter all the properties you require.

7. Activate the "Add new and open" check box if the block does not open as soon as it is 
created.

8. Confirm your entries with "OK".

Result
The new block is created. You can find the block in the project tree in the "Program blocks" 
folder.

See also
Function blocks (FB) (Page 1263)

Functions (FCs) (Page 1262)

Basics of block access (Page 1267)

Block folder (Page 1447)

Creating organization blocks (Page 1448)

Creating data blocks (Page 1450)

Using blocks from libraries (Page 1451)

Entering a block title (Page 1457)

Entering a block comment (Page 1458)
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Creating data blocks

Requirement
The "Program blocks" folder in the project tree is open.

Procedure
To create a data block, follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Data block (DB)" button.

3. Select the type of the data block. You have the following options available to you:

– To create a global data block, select the list entry "Global DB".

– To create an ARRAY data block, select the "ARRAY DB" entry in the list.

– To create an instance data block, select the function block to which you want to assign 
the instance data block from the list. The list contains only the function blocks that were 
previously created for the CPU.

– To create a data block based on a PLC data type, select the PLC data type from the 
list. The list contains only the PLC data types that were previously created for the CPU.

– To create a data block based on a system data type, select the system data type from 
the list. The list contains only those system data types that have already been inserted 
to program blocks in the CPU.

4. Enter a name for the data block.

5. Enter the properties of the new data block. 

6. If you have selected an ARRAY DB as the data block type, enter the ARRAY data type and 
the high limit for the ARRAY. 
You can change the high limit for the ARRAY at any time in the property window of the 
created block. The ARRAY data type cannot be changed subsequently.

7. To enter additional properties of the new data block, click "Additional information".
An area with further input fields is displayed.

8. Enter all the properties you require.

9. Activate the "Add new and open" check box if the block does not open as soon as it is 
created.

10.Confirm your entry with "OK".

Result
The new data block is created. You can find the data block in the project tree in the "Program 
blocks" folder.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1450 System Manual, 02/2014



See also
Global data blocks (DB) (Page 1264)

Instance data blocks (Page 1265)

Block folder (Page 1447)

Creating organization blocks (Page 1448)

Creating functions and function blocks (Page 1449)

Using blocks from libraries (Page 1451)

Basics of block access (Page 1267)

System data types (Page 1365)

Using blocks from libraries
You can save blocks in the project library or in a global library, so that you can use them more 
than once within a user program. You can insert the blocks as master copies or as types.

See also: Library basics (Page 441)

Requirement   
● The "Libraries" task card is displayed.

● No write protection is set for global libraries.

Adding blocks as master copies to the project library or to a global library
To add new blocks as master copies to the project library or to a global library, follow these 
steps:

1. Maximize the project library or the global library.

2. Use drag-and-drop to move the block you wish to add to the library to the "Master copies" 
folder or any one of the "Master copies" subfolders in the project library or a global library. 
Do not release the left mouse button until a small plus sign appears underneath the mouse 
pointer. 

Or:

1. Copy the element you want to add as master copy.

2. Maximize the project library or the global library.

3. Right-click the "Master copies" folder or any of its subfolders.

4. Select "Paste" in the shortcut menu.
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Adding blocks as types to the project library or to a global library
To add new blocks as types to the project library or to a global library, follow these steps:

1. Maximize the project library or the global library.

2. Drag-and-drop the element you want to add as a type into the "Types" folder or any of its 
subfolders in the project library or a global library. Do not release the left mouse button until 
a small plus sign appears underneath the mouse pointer.

Or:

1. Copy the element you want to add as a type.

2. Maximize the project library or the global library.

3. Right-click the "Types" folder or any of its subfolders.

4. Select "Paste" in the shortcut menu.

Using blocks of the project library or a global library
To use a block from the project library or a global library in your project, follow these steps:

1. Maximize the project library or the global library so that you can see the block you wish to 
use.

2. Use a drag-and-drop operation to move the block to the CPU block folder. If the selected 
insertion points is not allowed, the mouse pointer will appear as a circle with a slash. 

 

 Note

If you derive an instance from a type in a global library, the type is also inserted into the project 
library. The instance is then only linked to the type in the project library.

 

See also
Using libraries (Page 441)
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Copying and pasting blocks

Basics of copying and pasting blocks

Function
You can also create new blocks by copying existing blocks and pasting the copy. Note the 
following principles when copying to CPUs of the same device family:

● You can copy organization blocks (OBs), functions (FCs), function blocks (FBs), and global 
data blocks (DBs) without restriction.

● You can copy instance data blocks only for the same function block, since the assignment 
to the function block cannot be changed afterwards. However, the assignment is canceled 
if you copy the instance data block to a different CPU. If a function block with the same 
name exists there, the instance data block will be assigned to this function block. If you 
copy the instance data block together with the function block into the other CPU, the 
instance data block is assigned to the copy of the function block.

The various device families sometimes support different blocks, especially in the case of 
organization blocks. However, function blocks and functions can also be programmed on the 
various devices with different access types. Therefore, not all blocks are supported on all 
devices. Note the following principles when copying to a different device family:
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● Copying to an S7-1200 CPU:

– Organization blocks with "Optimized" access type can be copied to an S7-1200. If the 
copied OB type is supported by the S7-1200 CPU, the copied OB retains the properties 
of its event. You must, however, compile it again.

– Although organization blocks with the "Standard" access type can be copied to an 
S7-1200, they are not supported by the CPU.

– Function blocks (FBs), functions (FCs) and global data blocks (DBs) with "Optimized" 
access type can be copied to an S7-1200. However, they must be recompiled after this.

– Although function blocks (FBs), functions (FCs) and global data blocks (DBs) with 
"Standard" access type can be copied to an S7-1200, they are not supported by the 
CPU. 

– Instance data blocks: If there is a function block in the target CPU with the name that 
was assigned to the instance data block in the source CPU, the instance data block is 
assigned to the function block in the target CPU. If you copy the instance data block 
together with the function block to which it was assigned in the source CPU into the 
target CPU, the instance data block is assigned to the copy of the function block.

● Copying to an S7-1500 CPU:

– Organization blocks with "Optimized" access type can be copied to an S7-1500. If the 
copied OB type is supported by the S7-1500 CPU, the copied OB retains the properties 
of its event. You must, however, compile it again. OB types that are not supported 
receive a no parking symbol.

– Organization blocks with "Standard" access type can be copied to an S7-1500. If the 
OB derives from an S7-300/400 CPU, it receives the standard event of the 
corresponding OB type. If the OB derives from an S7-1200/1500 CPU, it receives the 
properties of its event. However, it must be compiled again.

– Function blocks (FBs), functions (FCs) and global data blocks (DBs) with "Optimized" 
access type can be copied to an S7-1500. However, they must be recompiled after this.

– Although function blocks (FBs), functions (FCs) and global data blocks (DBs) with 
"Standard" access type can be copied to an S7-1500, they are not supported by the 
CPU. 

– Instance data blocks: If there is a function block in the target CPU with the name that 
was assigned to the instance data block in the source CPU, the instance data block is 
assigned to the function block in the target CPU. If you copy the instance data block 
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together with the function block to which it was assigned in the source CPU into the 
target CPU, the instance data block is assigned to the copy of the function block.

● Copying to S7-300/400 CPUs:

– Organization blocks can be copied as required between S7-300 and S7-400. 

– Although organization blocks from S7-1200/1500 CPUs can be copied to S7-300/400 
CPUs, they are not supported by the target CPU.

– Function blocks (FBs), functions (FCs) and global data blocks (DBs) can be copied as 
required between S7-300 and S7-400.

– Although function blocks (FBs), functions (FCs) and global data blocks (DBs) can be 
copied from S7-1200/1500 CPUs to S7-300/400 CPUs, they are not supported by the 
target CPU. 

– Instance data blocks: If there is a function block in the target CPU with the name that 
was assigned to the instance data block in the source CPU, the instance data block is 
assigned to the function block in the target CPU. If you copy the instance data block 
together with the function block to which it was assigned in the source CPU into the 
target CPU, the instance data block is assigned to the copy of the function block.

In the project tree, blocks that are not supported are indicated by the no parking symbol. Blocks 
with a no parking symbol cannot be edited, but only used again as copy source.

Copying data
With paste, all the block data is copied and forwarded to the copy. This data includes:

● Block interface tags

● All networks

● Comments in all existing compilations

● Messages defined in the block

● The entire program code of the copied block including the call instructions contained in the 
block.
However, called blocks and their associated instance data blocks are not copied.

Avoiding name conflicts during pasting 
When pasting copied blocks with identical names to already existing blocks, the following 
mechanisms are used to avoid name conflicts:

● Pasting the copied block into the same CPU:
The copy of the block gets a name that is extended by a number. For example, if block "A" 
is copied, a possible name for the copy is "A_1". Consecutive numbering is not used, but 
rather the smallest free number. The copy of block "A" can also get the name "A_25", if no 
lower number is available.

● Pasting the copied block into another CPU:
A dialog box opens in which you can select whether the block with the same name will be 
replaced or the copied block will be pasted with a duplicate designation (Name_Number).
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 Note
Number conflicts

Number conflicts may occur, if the pasted block has the same block number as an existing 
block. The block number is not automatically changed during pasting. This double number 
may have an effect on block calls. When you copy blocks you should therefore check the 
block number carefully and correct duplicate block numbers manually or using the block 
properties. Duplicate block numbers lead to a compilation error.

 

See also
Copying blocks (Page 1456)

Pasting blocks (Page 1456)

Copying blocks

Requirement
The "Program blocks" folder is opened in the project tree.

Procedure
To copy a block, follow these steps:

1. Right-click the block that you want to copy.

2. Select "Copy" in the shortcut menu.

Result
A copy of the block is now on the clipboard and can be pasted either into the same CPU or 
into another one. 

See also
Basics of copying and pasting blocks (Page 1453)

Pasting blocks (Page 1456)

Pasting blocks

Requirement
You have copied a block.
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Procedure 
To paste a copied block and its data into a CPU, follow these steps:

1. In the project tree, open the folder structure for the CPU into which you want to paste the 
copied block.

 

  Note

Please note that you can only paste the copied block into a CPU which supports the block 
programming language and type.

 

2. Right-click on the "Program blocks" folder.

3. Select "Paste" in the shortcut menu.

– If you are pasting the block into the same CPU as the original block, "_<consecutive 
number>" will be appended to the name of the copy.

– If you are pasting the block into a different CPU where a block of the same name already 
exists, the "Paste" dialog box opens. Select the required option and confirm with "OK".

 

See also
Basics of copying and pasting blocks (Page 1453)

Copying blocks (Page 1456)

Entering a block title
The block title is the title of the block. It is not the same thing as the block name, which was 
assigned when the block was created. The length of the block title is restricted to one row. You 
can enter the block title for open and closed blocks.

Requirement  
A code block is available.

Enter block title for open block
To insert the block title in an open block, follow these steps:

1. Click on the title bar of the block in the program editor.

2. Enter the block title.

Enter block title for closed blocks
To insert the block title in a closed block, follow these steps:

1. Right-click the block in the project tree.

2. Select the "Properties" command in the shortcut menu.
The dialog with the properties of the block opens.
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3. Select the entry "Information" in the area navigation.

4. Enter the block title in the "Title" input field.

5. Confirm your entry with "OK".

See also
Creating organization blocks (Page 1448)

Creating functions and function blocks (Page 1449)

Entering a block comment (Page 1458)

Entering a block comment
You can use the block comment to document the entire code block. For example, you can 
indicate the purpose of the block or draw attention to special characteristics. You can enter 
the block comment for open and closed blocks.

Requirement  
A code block is available.

Enter block comment for open blocks
To insert a block comment in an open block, proceed as follows:

1. Click the small arrow in front of the block title.
The right arrow becomes a down arrow, and the comment area is displayed.

2. Click "Comment" in the comment area.
The "Comment" text passage is selected.

3. Enter the block comment.

Enter block comments for closed blocks
To insert the block comment in a closed block, follow these steps:

1. Right-click the block in the project tree.

2. Select the "Properties" command in the shortcut menu.
The dialog with the properties of the block opens.

3. Select the entry "Information" in the area navigation.

4. Enter the block comment in the "Comment" input field.

5. Confirm your entry with "OK".
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See also
Creating organization blocks (Page 1448)

Creating functions and function blocks (Page 1449)

Entering a block title (Page 1457)

9.1.3.2 Specifying block properties

Basics of block properties 

Block properties  
Each block has certain properties, which you can display and edit. These properties are used 
amongst other things to:

● Identify the block

● Display the memory requirements and the compilation status of the block

● Display the time stamp

● Display the reference information

● Specify the access protection

See also
Overview of block properties (Page 1459)

Block time stamps (Page 1462)

Displaying and editing block properties  (Page 1464)

Setting the mnemonics (Page 1480)

Overview of block properties

Overview
The properties of the blocks are block and CPU-specific. Not all properties are therefore 
available for all blocks or in all CPU families. The following table gives an overview of block 
properties:

Group Property Description
General Name Unique block name within the station 

Constant name Name of the constant pasted for the OB in the PLC tag table 
Type Block type (cannot be changed)
Number Block number
Event class Event class of an OB (cannot be changed)
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Group Property Description
Language Programming language of the block
Language in networks Language used to program conditions in GRAPH blocks.
Process image partition number Display of the process image partitions that are assigned to the 

organization block (cannot be changed)
ARRAY data type Data type of an ARRAY data block (cannot be changed)
ARRAY limit High limit of an ARRAY data block

The "Move operations" section of the "Instructions" task card 
offers options for addressing of ARRAY data blocks.

Information Title Block title
Comment Block comment
Version Version number of the block
Family Block family name
Author Name of the author, company name, department name, or other 

names
User-defined ID ID created by the user

Time stamps Block Times of creation and time of change of the block (cannot be 
changed)

Interface Time of creation of the block interface (cannot be changed)
Code Code modification time (non-editable)
Data Data modification time (non-editable)

Compilation Status Details of the last compilation run (cannot be changed)
Lengths Details of the block lengths (cannot be changed)

Protection Protection Setting up know-how protection and copy protection for the block
See also: Protecting blocks

Attributes Optimized block access The tag declaration for blocks with optimized access contains 
only the symbolic names of the data elements. The system 
automatically optimizes and manages the addresses. The CPU 
performance increases and access errors, for example, from 
SIMATIC HMI, are prevented.
See also: Auto-Hotspot

IEC check The compatibility of the operands in comparison operations and 
arithmetic operations are tested according to IEC 61131. You 
have to explicitly convert non-compatible operands.
See also: Overview of data type conversion (Page 1369)

Handle errors within block Troubleshooting inside the block with the GET_ERROR or 
GET_ERR_ID instruction (cannot be changed).
See also: Auto-Hotspot

Create extended status 
information

Allows you to monitor all tags in an SCL block. This option does, 
however, increase the program memory space required and the 
execution times.

Check ARRAY limits Checks whether array indexes are within the range declared for 
an ARRAY during the runtime of an SCL block. The block enable 
output ENO is set to "0" if an array index is outside of the permitted 
range.

Set ENO automatically Checks whether errors occur in the processing of certain 
instructions during the runtime of an SCL block. The block enable 
output ENO is set to "0" if a runtime error occurs.
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Group Property Description
Create minimized DB Creates instance data blocks for GRAPH blocks of the S7-300 

and S7-400 in minimized format. This option reduces the GRAPH 
FB memory space required, however you will only receive limited 
program status information.

Skip steps If the transitions before and after a step become valid 
simultaneously in a GRAPH block, the step will not be activated 
and will be skipped.

Acknowledge supervision alarms Any supervision error which occurs during the operation of a 
GRAPH block must be acknowledged before the program can 
continue.

Permanent processing of all 
interlocks in manual mode

Permanently monitors all interlock conditions in a GRAPH block 
in manual mode. 

Lock operating mode selection Prevents a GRAPH block operating mode being selected.
Data block write-protected in the 
device

Indicates whether the data block is read-only in the target system, 
and cannot be overwritten while the program is running (for data 
blocks only)

Only store in load memory On activation the data block is stored only in the load memory, 
occupies no space in the work memory, and is not linked into the 
program. The "Move operations" section of the "Instructions" task 
card offers options for transferring data blocks to the work 
memory (for data blocks only).

Start information Here you specify the structure of the start information of the OB 
for S7-1500 CPUs:  either like for S7-300 and S7-400 CPUs or 
optimized start information.

Priority Shows the priority set for organization blocks. The CPU family 
used and the type of the organization block determine whether 
you can change the priority.

Parameter assignment by means 
of registers

Enables parameter input by means of registers in an STL block 
of S7-1500. This feature allows you to use the "Conditional call 
of blocks" (CC) and "Unconditional call of blocks" (UC) 
instructions in the block.

Block can be used as know-how 
protected library item

Shows whether or not the block in the library can be used with 
know-how protection.

Enable readback Enables you to mark individual parameters of the block for 
readback. The "Tag readback" function is relevant if the block is 
used in a CFC chart.

Block representation Specifies how the block is represented in a CFC chart.
Time-of-day interrupt Time-of-day interrupt Parameters of the time-of-day interrupt OB: active (yes or no), 

execution, start date and time, local time or system time 
Cyclic interrupt Cyclic interrupt Cycle time and phase shift of the cyclic interrupt OB
Triggers Triggers Display of start events of the hardware interrupt OB
Isochronous mode Isochronous mode Parameters of the isochronous mode interrupt OB: application 

cycles, automatic setting (yes or no), delay time.
Also indicated is the PROFINET IO system or DP master system 
whose IO devices or DP slaves are assigned to the isochronous 
mode interrupt OB.

Download without re-
initialization

Reserve in volatile memory Defines the reserve in volatile memory that can be used for 
interface extensions.
The number of currently available bytes is displayed in 
parentheses. This information is updated with each compilation.
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Group Property Description
Activate download without re-
initialization for retentive tags

Enables definition of a reserve in retentive memory.

Reserve in retentive memory Defines the reserve in retentive memory that can be used for 
interface extensions.
The number of currently available bytes is displayed in 
parentheses. This information is updated with each compilation.

See also
Basics of block properties  (Page 1459)

Block time stamps (Page 1462)

Displaying and editing block properties  (Page 1464)

Basics of block access (Page 1267)

Block time stamps

Introduction  
Blocks receive a number of different time stamps which show you when the block was created 
and when it was last changed. These time stamps are also used for automatic consistency 
checks before compilation. 

Code block time stamps
The following time stamps are generated for code blocks (OBs, FBs, FCs):

● Block: Created on, Modified on

● Interface: Modified on

● Code/data: Modified on

A time stamp conflict is displayed during compilation if the time stamp for the block calling is 
older than that of the interface for the block called.

Time stamps for code blocks are updated as follows:

● Block: The time stamp for the last block modification is always the same as the time stamp 
either of the interface or of the code depending on which area was modified last.

● Interface: The interface time stamp is updated each time the interface is modified. Even if 
you manually undo a change to the interface, for example change the name back, that is 
also a change which updates the time stamp. However, if you undo the change using the 
"Undo" function, the time stamp will be reset to the value it had before the undone change.

● Code/data: The code time stamp is updated each time the block code is changed. Even if 
you manually undo a change to the code, for example remove an instruction, that is also a 
change which will update the time stamp. However, if you undo the change using the "Undo" 
function, the time stamp will be reset to the value it had before the undone change.
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Global data block time stamps
The following time stamps are generated for global data blocks:

● Block: Created on, Modified on

● Interface: Modified on

● Data: Modified on

Time stamp conflict is reported during compilation of a global data block based on a PLC data 
type if the time stamp of the global data block is older than the time stamp of the PLC data 
type used.

The time stamps for global data blocks are updated as follows:

● Block: The time stamp for the last change to a global data block is always the same as the 
time stamp for the interface and the data.

● Interface and data: The interface time stamps and the data are updated each time the global 
data block is changed. Even if you manually undo a change, for example remove a tag, 
that is also a change which will update the time stamp. However, if you undo the change 
using the "Undo" function, the time stamps will be reset to the value they had before the 
undone change.

Instance data block time stamps
The following time stamps are generated for instance data blocks:

● Block: Created on, Modified on

● Interface: Modified on

● Data: Modified on

A time stamp conflict will be reported during compilation of an instance data block if the 
interface time stamps of the instance data block are not identical to those of the function block. 

The time stamps for instance data blocks are updated as follows:

● Block: The time stamp for the last change to an instance data block is always the same as 
the time stamp for the interface and the data.

● Interface and data: The interface time stamps and the data are updated each time the 
instance data block is changed. Even if you manually undo a change, for example cancel 
the tag retain setting, that is also a change which will update the time stamps. However, if 
you undo the change using the "Undo" function, the time stamps will be reset to the value 
they had before the undone change.

PLC data type time stamps
The following time stamps are generated for PLC data types:

● Block: Created on, Modified on

● Interface: Modified on

The time stamps for PLC data types are updated as follows:
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● Block: The time stamp for the last change to a PLC data type is always the same as the 
interface time stamp.

● Interface: The interface time stamp is updated each time the PLC data type is changed. 
Even if you manually undo a change, for example delete the content of a PLC data type, 
that is also a change which will update the time stamp. However, if you undo the change 
using the "Undo" function, the time stamp will be reset to the value it had before the undone 
change.

 

See also
Basics of block properties  (Page 1459)

Overview of block properties (Page 1459)

Displaying and editing block properties  (Page 1464)

Basic information on compiling blocks (Page 1710)

Displaying and editing block properties 
The properties of the blocks are block and CPU-specific. Not all properties are therefore 
available for all blocks or in all CPU families. Properties that can only be displayed are write-
protected.

Displaying and editing properties of a closed block     
To display and edit the properties of a closed block, follow these steps:

1. Open the "Program blocks" folder in the project tree.

2. Right-click the block whose properties you want to display or edit.

3. Select the "Properties" command in the shortcut menu.
The properties dialog box of the block opens.

4. In the area navigation, click a group whose properties you want to display or edit.

5. Change the relevant property.

6. Confirm your entries with "OK".

Displaying and editing properties of an open block
To display or edit the properties of an open block, follow these steps:

1. Select the "Inspector window" check box in the "View" menu.
The Inspector window opens.

2. Click the "Properties" tab.
The properties of the block are shown in the "Properties" tab of the Inspector window.

3. In the area navigation, click a group whose properties you want to display or edit.

4. Change the relevant property.
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Result
The properties of the block will be changed. The changes are not saved until the project is 
saved. 

See also
Basics of block properties  (Page 1459)

Overview of block properties (Page 1459)

Block time stamps (Page 1462)

9.1.3.3 Managing blocks

Opening blocks
You can open a block in several different ways:

● Open block directly
You can open a block directly if the corresponding block folder is open in the project tree 
or in the overview window.

● Find and open block
You can look for blocks within a project, a device or the "Program blocks" folder and then 
open them.

Open block directly
To open a block directly, follow these steps:

1. Open the folder with the block you wish to open in the project tree or in the overview window.

2. Double-click on the block you wish to open.

Find and open block
To find and then open a block, follow these steps:

1. Right-click on the project, a device, the "Program blocks" folder or a lower-level folder of 
"Program blocks" in the project tree.

2. Select the "Search in PLC and open" command from the shortcut menu.
The "Search in PLC and open" dialog box is displayed.

3. Enter the name, the address or the type of block you are looking for. 
The block list is filtered further with each letter entered. The block list is closed if there is 
no block that matches the input. You can show the complete block list at any time by clicking 
the button to the right of the text box. Keep in mind that there is no filtering in this case. If 
you want to filter for your inputs again, click the button once again.

4. In the block list, click the block you wish to open.
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Result
The block will open in the program editor. 

See also
Saving blocks (Page 1466)

Closing blocks (Page 1466)

Renaming blocks (Page 1467)

Deleting blocks offline (Page 1468)

Deleting blocks online (Page 1468)

Opening know-how protected blocks (Page 1730)

Saving blocks
Blocks are always saved together with the project. Faulty blocks can also be saved. This allows 
the error to be resolved at a convenient time. 

Procedure 
To save a block, follow these steps:

1. Select the "Save" or "Save as" command in the "Project" menu.
See also: Saving projects (Page 364)

See also
Opening blocks (Page 1465)

Closing blocks (Page 1466)

Renaming blocks (Page 1467)

Deleting blocks offline (Page 1468)

Deleting blocks online (Page 1468)

Closing blocks

Procedure
To close a block, follow these steps:

1. Click the "Close" button in the title bar of the program editor.
 

 Note

Note that the block will not be saved on closing.
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See also
Opening blocks (Page 1465)

Saving blocks (Page 1466)

Renaming blocks (Page 1467)

Deleting blocks offline (Page 1468)

Deleting blocks online (Page 1468)

Renaming blocks

Requirement
The "Program blocks" folder is opened in the project tree.

Procedure
To change the name of a block, follow these steps:

1. Right-click the block that you want to rename.

2. Select the "Rename" command in the shortcut menu.
The block name in the project tree changes to an input field.

3. Input the new name for the block.

4. Confirm your entry with the Enter key.

Result
The name of the block is now changed at all points of use in the program.

 

See also
Opening blocks (Page 1465)

Saving blocks (Page 1466)

Closing blocks (Page 1466)

Deleting blocks offline (Page 1468)

Deleting blocks online (Page 1468)
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Deleting blocks offline

Requirement   
The "Program blocks" folder opens in the project tree.

Procedure
To delete a block that exists offline, proceed as follows:

1. In the project tree in the "Program blocks" folder, right-click on the block that you want to 
delete.

2. Select the "Delete" command in the shortcut menu.

3. Confirm the safety prompt with "Yes".
The block is deleted offline from the project.

 

 Note

If you are deleting organization blocks, note that events may be assigned to these blocks. If 
you delete such organization block the program cannot respond to parameterized events.

 

See also
Opening blocks (Page 1465)

Saving blocks (Page 1466)

Closing blocks (Page 1466)

Renaming blocks (Page 1467)

Deleting blocks online (Page 1468)

Deleting blocks online

Requirement   
The "Program blocks" folder in the project tree is open.

Procedure
To delete a block that exists online, follow these steps:

1. In the "Program blocks" folder in the project tree, right-click on the block that you wish to 
delete from the device.

2. Select the "Delete" command from the shortcut menu.
The "Delete" dialog opens.
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3. Select the "Delete from device" check box.

4. Click "Yes".
The block will be deleted from the device online. 

See also
Opening blocks (Page 1465)

Saving blocks (Page 1466)

Closing blocks (Page 1466)

Renaming blocks (Page 1467)

Deleting blocks offline (Page 1468)

Deleting CPU data blocks
You may delete CPU data blocks both in offline and online mode. 

Deleting CPU data blocks in offline mode  
Proceed as follows to delete a CPU data block from the offline project:

1. Right-click the CPU data blocks that you want to delete in the project navigation, "Program 
blocks" folder.

2. Select the "Delete" command from the shortcut menu.

3. Confirm the safety prompt with "Yes".
The CPU data block is deleted from the offline project.

Deleting CPU data blocks in online mode
Proceed as follows to delete a CPU data block from the online project:

1. Establish an online connection to the device containing the CPU data block that you want 
to delete.

2. Right-click the CPU data block that you want to delete from the device in the project 
navigation, "Program blocks" folder.

3. Select the "Delete" command from the shortcut menu.
The "Delete" dialog opens.

4. Select the "Delete from device" check box.

5. Click "Yes".
The CPU data block is deleted from the online device. 

 

See also
CPU data blocks (Page 1266)
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9.1.4 Programming blocks

9.1.4.1 Program editor

Overview of the program editor

Function of the program editor  
The program editor is the integrated development environment for programming functions, 
function blocks, and organization blocks. If offers comprehensive support for programming 
and troubleshooting. 

The appearance and functionality of the program editor can vary depending on the CPU, 
programming language and block type used. 
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Structure of the program editor  
Using LAD as an example, the following figure shows the components of the program editor:

① Toolbar 
② Block interface 
③ "Favorites" pane in the "Instructions" task card and favorites in the program editor 
④ Programming window 
⑤ "Instructions" task card 
⑥ "Testing" task card 
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Toolbar  
The toolbar allows you to access the principal functions of the program editor, such as:

● Show and hide absolute operands

● Showing and hiding favorites

● Skip to syntax errors

● Update block calls

● Show and hide program status

The functions available in the toolbar can vary depending on the programming language used. 

Block interface  
The block interface contains the declarations for local tags used solely within the block. The 
sections available depend on the block type.

Favorites  
You can save frequently used instructions as favorites. These favorites are then displayed in 
the "Instructions" task card and the "Favorites" pane. You can also display favorites in the 
program editor using the program editor toolbar. This allows you to access your favorites even 
when the "Instructions" task card is not visible.

Programming window  
The programming window is the work area of the program editor. You can enter the program 
code in this window. The appearance and functionality of the program window can vary 
depending on the programming language used. 

"Instructions" task card  
The "Instructions" task card offers you easy access to all instructions available for creating 
your program. The instructions are broken down by area into a number of different palettes. 
You can show additional information on the instructions via the "Show column headers and 
additional columns" button in the task card toolbar. You can modify the arrangement of columns 
by clicking a column header and moving the column to the new position by means of drag-and-
drop.

If an instruction profile is active, the offered instructions may vary.
See also: Using instruction profiles

"Testing" task card  
You can set settings in the "Testing" task card for troubleshooting using the program status. 
The functions of the "Testing" task card are only available in online mode. It contains the 
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following panes, which are displayed depending on the selected CPU and the configured 
programming language of the block:

● CPU operator panel
The CPU operator panel allows you to switch the CPU operating mode. 

● Breakpoints
You can test blocks you created in the textual programming languages STL and SCL in 
single step mode. To do this, set breakpoints in the program code.
In the "Breakpoints" pane, you can find all breakpoints that you have set and you can 
activate, delete, navigate to, or set the call environment for the individual breakpoints.

● PLC register
This pane allows you to read off the values for the PLC registers and the accumulators.

● Sequence control
In this pane you can set the operating mode for testing sequencers for GRAPH blocks.

● Test settings
This pane allows you to specify the test settings for the GRAPH block.

● Call environment
This pane allows you to specify the call environment for the block.

● Call hierarchy
In this pane, you can trace the call hierarchy of the blocks. You only see the call hierarchy 
during block monitoring.

 

See also
Layout of the block interface (Page 1491)

Enlarging the programming window (Page 1478)

Using the keyboard in the program editor

Navigating in the editor

Function Shortcut key
Open "Instructions" task card <Ctrl+Shift+C>
Open "Testing" task card <Ctrl+Shift+O>
Add new block <Ctrl+N>
Expand all networks <Alt+F11>
Collapse all networks <Alt+F12>
Navigate to the next point of use of the selected block or operand <Ctrl+Shift+F>
Navigate to the previous point of use of the selected block or 
operand

<Ctrl+Shift+G>

Navigate to the next read/write access <Alt+F8>
Navigate to the previous read/write access <Alt+F9>
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Navigating in the program code (LAD/FBD)

Function Selected object Shortcut key
Navigating between objects in the network Object in the network Arrow keys
Navigate to the first element of the network Object in the network <Home>
Navigate to the last element of the network Object in the network <End>
Navigate to the next element of the network Object in the network <Tab>
Navigate to the previous element of the network Object in the network <Shift+Tab>
Insert network Any <Ctrl+R>

Navigating in the program code (STL/SCL) 

Function Position of the cursor Shortcut key
Navigating in the program code Line Arrow keys
One word to the right/left Line <Ctrl+arrow keys>
Cursor to start of line Line <Home>
Cursor to end of line Line <End>
Cursor to start of code section Line <Ctrl+Home>
Cursor to end of code section Line <Ctrl+End>
To the next network (STL only) Network title <Down arrow>
To the next network (STL only) Line <Tab>

Repeat the shortcut keys 
until the insertion point is 
in the next network.

To the previous network (STL only) Network title <Up arrow>
To the previous network (STL only) Line <Shift+Tab>

Repeat the shortcut keys 
until the insertion point is 
in the previous network.

Insert network Any <Ctrl+R>

Inserting instructions (LAD)

Function Selected object Shortcut key
Insert normally open contact Rung <Shift+F2>
Insert normally closed contact Rung <Shift+F3>
Insert empty box Rung <Shift+F5>
Insert assignment Rung <Shift+F7>
"Insert "Open branch" Rung <Shift+F8>
"Insert "Close branch" Rung <Shift+F9>
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Inserting instructions (FBD)

Function Selected object Shortcut key
Insert assignment Network, input or 

output
<Shift+F7>

Insert empty box Network <Shift+F5>
"Insert "Open branch" Connection line 

between two boxes
<Shift+F8>

Invert RLO Network, input or 
output

<Ctrl+Shift+4>

Insert input Network, input or 
output

<Ctrl+Shift+3>

Entering operands (LAD/FBD/GRAPH)

Function Selected object Shortcut key
Activate the input field for the first operand of the 
instruction

Instruction <Return>
Or
<Any letters/numbers> 
An empty input field opens 
on <Return>, any letters or 
numbers will be entered in 
the input field.

Activate input field for the operand Operand <F2>
Delete operand Operand <Del>
Define tag Operand <Ctrl+Shift+I>
Rewire tag Operand <Ctrl+Shift+P>
Rename tag Operand <Ctrl+Shift+T>
Entering operands Input field for 

operands
<Any letters/numbers>

Confirm entry of the operand Input field for 
operands

<Return>

Open autocompletion
 

Input field for 
operands

<Ctrl+I>

Discard current change Input field for 
operands

<Esc> 
The input field is 
deactivated and the 
previous contents restored.
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Process instructions (STL/SCL)

Function Selected object Shortcut key
Indent line (SCL only) Line <Tab> or

<Ctrl+R>
Outdent line (SCL only) Line <Shift+Tab> or

<Ctrl+Shift+R>
Automatically formatting selected text (SCL only)  <Ctrl+Shift+W>
Open "Call options" dialog Cursor after block call <Return>
Define tag Operand <Ctrl+Shift+I>
Rewire tag Operand <CtrlShift+P>
Rename tag Operand <Ctrl+Shift+T>
Expand/collapse parameter list (SCL only) Operand <Ctrl+Shift+Space>
Expand/collapse code section Insertion mark within 

the code section
<Ctrl+Shift+Num+>
<Ctrl+Shift+Num->

Expand/collapse all code sections Any <Ctrl+Shift+Num*>
<Ctrl+Shift+Num/>

Open autocompletion
 

Any <Ctrl+I> or <Ctrl+Spacebar>

Set/delete bookmarks  <Ctrl+Shift+M>
To the next bookmark  <Ctrl+Shift+6>
To the previous bookmark  <Ctrl+Shift+5>
Comment out selection Line <Ctrl+Shift+Y>
Remove comment Line <Ctrl+Shift+U>

Programming window of GRAPH
 

Function Area Shortcut key
Page Up/Down Navigation view, 

single step view, 
sequence view, 
permanent 
instructions

<Page Up>/
<Page Down>

Navigate in the navigation view Navigation view <Up arrow>
<Down arrow>

Expand/collapse object Navigation view <+> or <Right arrow>
<-> or <Left arrow>

Switch between single step view and sequence 
view when a step or a transition is selected

Navigation view <Return>

Switch between navigation view and work area Navigation view, 
single step view, 
sequence view, 
permanent 
instructions

<ALT+F6>
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Function Area Shortcut key
Go to first element in a network Single step view <Home>
Go to last element in a network Single step view <End>
Switch to interlock Single step view <Ctrl+Home>
Switch to transition Single step view <Ctrl+End>
Navigate in the structure Sequence view Arrow keys
Go to first step Sequence view <Home> or <Ctrl+Home>
Go to last step Sequence view <End> or <Ctrl+End>
Open branch Sequence view <Shift+F8>
Close branch Sequence view <Shift+F9>
Insert sequence end Sequence view <Shift+F7>
Insert jump Sequence view <Shift+F12>
Insert step and transition Sequence view <Shift+F5>
Delete element Sequence view <Del>
Go to first editable element Permanent 

instructions
<Home>

Go to next editable element Permanent 
instructions

<Tab>

Go to last editable element Permanent 
instructions

<End>

Go to previous editable element Permanent 
instructions

<Shift+Tab>

Jump to the start of the "Action" cell Actions <Home>
Jump to the end of the "Action" cell Actions <End>
Insert new action Actions <Return>

Monitor program 

Function Shortcut key
Set/remove breakpoint (STL, SCL) <Ctrl+Shift+F9>
Step over breakpoint (STL, SCL) <Ctrl+Shift+F10>
Jump to lower-level block (STL, SCL) <Ctrl+Shift+F11>
Return to calling block (STL, SCL) <Ctrl+Shift+F12>
Run program up to marker (cursor position) (STL, SCL) <Ctrl+F3>
Display program status (SCL, STL) <Ctrl+T>
Enable all breakpoints (STL, SCL) <Ctrl+Shift+F2>
Disable all breakpoints (STL, SCL) <Ctrl+Shift+F3>
Modify to 0 (LAD, FBD) <Ctrl+Shift+9>
Modify to 1 (LAD, FBD) <Ctrl+Shift+1>
Modify operand (LAD, FBD) <Ctrl+Shift+2>
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See also
Keyboard operation in the TIA Portal (Page 334)

Using project-related functions (Page 336)

Arranging windows (Page 336)

Editing tables (Page 342)

Text editing (Page 341)

Enlarging the programming window

Introduction 
The programming window is relatively small when all components of the application are shown. 
If the program code is large, you may find you have to rearrange the work area constantly. To 
avoid this problem, you can hide or minimize the display of the following components of the 
application and of the program editor:

● Project tree

● Task cards

● Block interface

● Favorites

● Comments

● Networks
 

 Note

You can also use the "Reduce automatically" option for the task cards, project tree, and 
Inspector window. These windows will then be minimized automatically when you do not need 
them. 

See also: Maximizing and minimizing the work area
 

Hiding and showing the project tree  
The project tree allows you to access all areas of the project. You can hide the project tree 
while you are creating a program so you have more space for the programming window. 

To show and hide the project tree, follow these steps:

1. To hide the project tree, deselect the "Project tree" check box in the "View" menu, or click 
on "Collapse" on the project tree title bar.

2. To show the project tree, select the "Project tree" check box in the "View" menu or click on 
"Extend" on the project tree title bar.
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Opening and closing task cards
The task cards are located at the right-hand edge of the programming window. 

To open or close the task cards, follow these steps:

1. To close the task cards, deselect the "Task card" check box in the "View" menu or click 
"Collapse" on the task cards title bar.

2. To open the task cards, select the "Task card" check box in the "View" menu or click 
"Expand" on the task cards title bar.

Hiding and showing the block interface  
The block interface is shown in the upper section of the program editor. During programming 
you can show and hide it as required.

To show and hide the block interface, follow these steps:

1. In the lower part of the interface within the window splitter, click on the Up arrow or Down 
arrow.

Showing and hiding favorites  
To hide or show the favorites in the program editor, follow these steps:

1. Click the "Display favorites in the editor" button in the program editor toolbar.

Showing and hiding comments    
Within a block you can enter a comment for the block or for each network. These two types of 
comments are shown and hidden differently.

To show or hide a block comment, follow these steps:

1. Click the the triangle at the start of the line with the block title.

To show or hide network comments, follow these steps:

1. Click "Network comments on/off" on the program editor toolbar.
 

 Note

The comments available can vary depending on the programming language used. 
 

Opening and closing networks
Some programming languages use networks. You can open or close these networks as 
required.

To open or close networks, follow these steps: 

1. If you want to open a network, click the right arrow in front of the network title. If you want 
to close a network, click the down arrow in front of the network title.

To open and close all networks, follow these steps:
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1. Click "Open all networks" or "Close all networks" in the program editor toolbar.
 

 Note

Networks are not used in every programming language. 
 

See also
Overview of the program editor (Page 1470)

Maximizing and minimizing the work area (Page 313)

Setting the mnemonics
You can program blocks using German or international mnemonics. If you open the TIA portal 
for the first the international mnemonics is set as default. You can change the mnemonics at 
any time.

Procedure  
To set the mnemonics, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General" group in the area navigation.

3. In the "General settings" group, select the mnemonics that you want to use.
The mnemonics is changed in all blocks.

Displaying symbolic and absolute addresses
You have the following options for displaying operands in the program editor:

● Symbolic representation
The symbolic operands are displayed in the program. The corresponding absolute 
addresses are shown in tooltips if you hold the mouse pointer over the operand.

● Absolute representation
The absolute addresses are displayed in the program. The corresponding symbolic 
operands are displayed in tooltips.

● Symbolic and absolute representation
Symbolic operands and absolute addresses are displayed in program.

Requirement
The program editor is open.
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Procedure 
To change the representation of the operands, follow these steps:

1. Click the "Absolute/symbolic operands" button in the program editor toolbar.
Each time you click the button, the representation and the symbol on the button change.

Or:

1. Click the small arrow next to the "Absolute/symbolic operands" button in the program editor 
toolbar.
A drop-down list is displayed.

2. Select the required representation from the drop-down list.
The symbol on the button changes. 

 

See also
Basic information about operands (Page 1289)

Use instruction versions

Basic information on instruction versions
The instructions available to you for programming the user program are managed in system 
libraries. If a new version of a system library is installed by an update, the newer versions of 
the instructions of this system library may also be installed. 

If there are several versions for an instruction, these are listed in the "Instructions" task card 
after the respective instruction. If the instruction versions are not shown, you can show them 
via the "Show column headers and additional columns" button in the toolbar of the 
"Instructions" task card. You can then select the versions of the instructions to be used in the 
program from the dropdown-list box of the "Version" column. If you do not select any versions, 
the most recent versions are used. 

 

 Note

Note the following information:
● You can only ever use the same version of an instruction within a device.
● If you change the version of an instruction that other instructions depend on, the versions 

of the dependent instructions are also changed.
● If you select a version for an instruction that can not be run on the CPU used, the instruction 

is shaded out. This means that you cannot use this instruction in this version with your 
CPU.

● When you change the version of an instruction, you must compile the block before the 
new version number is displayed in the properties of the instruction. 

● If an instruction is a block within the system, the block also receives its own block version 
number. This version number can be different from the instruction version and can vary 
on different CPU types.
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Changes in the versions
New versions can be main versions or secondary versions. New versions, such as 2.0 or 3.0, 
have more substantial changes to them. New main versions may therefore result in changes 
to the block interface. New secondary versions, such as 1.3 or 1.4, contain lesser changes or 
remedies to errors. 

Using instruction versions
You can decide within a device which version of an instruction you want to use. If you select 
another version for an instruction, the new version is specified for all locations of use of this 
instruction within your program. These instructions are identified in the program by a red frame. 
You must then download your program to the device to use the new instruction version. 

Using instruction profiles

Basics of instruction profiles

Introduction 
The TIA Portal provides you with numerous instructions that you can use to program the user 
program. However, you may filter out specific instructions that you do not want to use. To this 
end you can create instruction profiles in which you can explicitly specify the instructions to be 
listed in the "Instructions" task card. However, although you may create several instruction 
profiles in a project, only one of these profiles may be active at any given time. You can 
exchange instruction profiles with other users by means of shared libraries.

 

 Note

Please note the following:
● The use of instructions that are not allowed in the active profile in a block will trigger the 

output of a block compilation error. Such a situation may be triggered if you drag-and-drop 
a block from the library to your program.

● Instructions of a profile that are not supported by the currently installed products are 
deleted from the profile the next time it is edited. If you transfer this profile to an engineering 
system in which these instructions are supported by the installed products, the instructions 
are again present in the profile but they are disabled. You can enable these instructions 
as required at any time.

● If you want to make changes to the active profile, you must recompile the blocks in the 
project. This is also necessary when you disable or delete the active profile or when you 
enable a profile.

 

See also
Creating new instruction profiles (Page 1483)

Opening and editing instruction profiles (Page 1484)
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Activating and deactivating instruction profiles (Page 1485)

Deleting instruction profiles (Page 1486)

Creating new instruction profiles

Requirement
The "Common data > Instruction profiles" folder is open in the project navigation.

Procedure
Proceed as follows to create a new instruction profile:

1. Double-click the "Add new profile" command.
The Instruction Profile Editor opens and displays the new instruction profile. All instructions 
are activated for the new instruction profile.

2. Edit the new instruction profile to suit your requirements.

If necessary, you can rename the new instruction profile. To do this, follow these steps:

1. Right-click on the new instruction profile.

2. Select the "Rename" command in the shortcut menu.

3. Enter a name for the new instruction profile. 
 

 Note

The first instruction profile that you create will be used as active profile. In this case, compile 
all blocks in the project. If other instruction profiles are already available you must explicitly 
activate the new one in order to use it as active profile. You can identify the active profile by 
its icon in the project navigation.

 

See also
Basics of instruction profiles (Page 1482)

Opening and editing instruction profiles (Page 1484)

Activating and deactivating instruction profiles (Page 1485)

Deleting instruction profiles (Page 1486)
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Opening and editing instruction profiles
Once you have opened an instruction profile, you can edit it as follows: 

● Activating and deactivating instructions
You can explicitly specify the instructions to be allowed in the instruction profile.

 

  Note

Note that dependencies exist between some instructions. As a result, it is possible that 
several instructions may be activated or deactivated by an action. The check box icon 
indicates the folders in which instructions are deactivated.

 

● Activating and deactivating instruction versions
Certain instructions are available with different versions. You can explicitly specify the 
instruction versions to be allowed in the instruction profile.

● Renumbering blocks
An instruction representing an internal function block (FB) or function (FC) in the system is 
assigned a specific block number by the system. You can replace this block number with 
your own block number. Within a version, there are several implementations for certain 
instructions. The block numbers in such instructions can only be changed for the specific 
implementation. 

 

  Note

If an instruction from the instruction profile is used in the program and the specified block 
number is already in use by a different block, the specified block number of the instruction 
will be replaced by a free block number. 

 

Requirement
The "Common data > Instruction profiles" folder is open in the project navigation.

Opening instruction profiles
Proceed as follows to open an instruction profile:

1. Double-click the instruction profile that you want to edit.
The  instruction profile opens in the Instruction Profile Editor.

Editing instruction profiles
Proceed as follows to edit an instruction profile in the Instruction Profile Editor:

1. Select the device that you want to edit from the "Device family"  drop-down list box.

2. Select the programming language for which you want to edit the instruction profile from the 
"Language" drop-down list box.

3. Deactivate the instructions or instruction versions that you want to exclude from the 
instruction profile. You can deactivate a folder to deactivate all subordinate instructions.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1484 System Manual, 02/2014



4. Activate the instructions or instruction versions that you want to allow in the instruction 
profile.

5. You may assign your own block numbers.
 

  Note

You can assign the number up to 65535 for CPUs of the S7-1200/1500 series. For CPUs 
of the S7300/400 series you find the restrictions of the number ranges in the respective 
CPU manual.

 

 

 Note

A new compilation process is required for all blocks in the project when you change the active 
profile.

 

See also
Basics of instruction profiles (Page 1482)

Creating new instruction profiles (Page 1483)

Activating and deactivating instruction profiles (Page 1485)

Deleting instruction profiles (Page 1486)

Use instruction versions (Page 1481)

Activating and deactivating instruction profiles
You first need to activate an instruction profile in order to include filtering of its instructions. 
You can always deactivate the instruction profile to reset the instructions task card to the default 
scope of instructions.

 

 Note

A new compilation process is required for all blocks in the project.
 

Requirement
The "Common data > Instruction profiles" folder is open in the project navigation.

Activating instruction profiles   
Proceed as follows to activate an instruction profile:

1. Right-click on the instruction profile that you want to activate.

2. Select the "Activate profile" command from the shortcut menu.
The selected instruction profile is now active. Instructions can now only be used in 
accordance with the settings of this profile.
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Deactivating instruction profiles 
Proceed as follows to deactivate the instruction profile:

1. Right-click on the instruction profile that you want to deactivate.

2. Select the "Deactivate profile" command from the shortcut menu.
No instruction profile is active and the "Instructions" task card once again shows all 
instructions that are available for use.

See also
Basics of instruction profiles (Page 1482)

Creating new instruction profiles (Page 1483)

Opening and editing instruction profiles (Page 1484)

Deleting instruction profiles (Page 1486)

Deleting instruction profiles

Requirement
The "Common data > Instruction profiles" folder is open in the project tree.

Procedure
Proceed as follows to delete an instruction profile:

1. Right-click on the instruction profile that you want to delete.

2. Select the "Delete" command in the shortcut menu.
 

 Note

A new compilation process is required for all blocks in the project when you delete the active 
profile.

 

Result
The selected instruction profile is deleted. If you deleted the active instruction profile, no more 
active profiles are available and the "Instructions" task card once again shows all instructions 
that are available for use. 

See also
Basics of instruction profiles (Page 1482)

Creating new instruction profiles (Page 1483)
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Opening and editing instruction profiles (Page 1484)

Activating and deactivating instruction profiles (Page 1485)

Using autocompletion

Basics of autocompletion

Function   
You can use autocompletion in the program window of the program editor as an easy way to 
access available tags or instructions during programming. Autocompletion means a context-
specific list appears in a dialog from which you can select the tags or instructions you need.

See also
Using autocompletion in graphic programming languages (Page 1487)

Using autocompletion in textual programming languages (Page 1488)

Using autocompletion in graphic programming languages

Inserting tags using autocompletion
To insert tags in graphic programming languages using autocompletion, follow these steps:

1. Select an operand of the instruction to which you wish to assign a tag.
The input field for the operand opens. The autocompletion button will appear beside the 
input field.

2. Either click the autocompletion button or use the shortcut <Ctrl+l>.
Autocompletion opens. It contains only the local and global tags, data blocks and multiple 
instances which are admissible for the operand in the given context. You can exit 
autocompletion at any time by pressing <Esc>.
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3. Select the required tag from the list. If necessary, you can also filter the list:

– For example, enter the first few letters of the name of the tag or instruction you wish to 
insert. Autocompletion will be filtered further with each letter entered. If there is no tag 
or instruction starting with the letters entered, autocompletion will remain at the last 
match. 

– Enter # to access the local tags from the block interface.

– Enter " to access the global tags.

– Enter % to access absolute addresses.

If the tag is a structured tag, a data block or a multiple instance, then an arrow is displayed 
at the end of the row. Click on the arrow to display the lower-level elements. You can 
navigate to the very last level in this way. If a structure is allowed as a data type for the 
operand, you can choose "None" from the list. This assigns the entire structure to the 
operand as a tag. Use the <Backspace> key to return to the previous level.

4. Press the <Return> key to apply the tag.

 

See also
Basics of autocompletion (Page 1487)

Using autocompletion in textual programming languages (Page 1488)

Using autocompletion in textual programming languages

Inserting tags and instructions using autocompletion
To insert tags and instructions in textual programming languages using autocompletion, follow 
these steps:

1. Enter the first few letters of the name of the tag or instruction you wish to insert. If necessary, 
you can directly filter the kind of tags:

– Enter # to access the local tags from the block interface.

– Enter " to access the global tags.

– Enter % to access absolute addresses.

Autocompletion opens. It contains only the local and global tags, data blocks, multiple 
instances and instructions which are admissible at the current position. You can exit 
autocompletion at any time by pressing <Esc>. 

2. Enter more letters of the name of the tag or instruction you wish to insert. You can use 
<Enter> or <Tab> to apply the tag or instruction and close autocompletion.
Autocompletion will be filtered further with each letter entered. If there is no tag or instruction 
starting with the letters entered, autocompletion only contains the previous matches. 
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3. Select the tag or instruction required from the list.
If a tag is a structured tag, a data block or a multiple instance, first select the tag, the data 
block or multiple instance from the autocompletion and apply the selection with <Enter>. 
To select the additional components of the structure, data block, or multiple instance, enter 
a period. Autocompletion then reopens and you can select the next component.

4. Press the <Return> key to apply the tag.

See also
Basics of autocompletion (Page 1487)

Using autocompletion in graphic programming languages (Page 1487)

General settings for the PLC programming

Overview of the general settings

Overview
The following table shows the general settings that you can make:

Group Setting Description
View With comments Network comments are shown.

Tag information Additional information for the tags used 
is displayed in the program editor. When 
you select the option "Tag information 
with hierarchy", the comments of the 
higher structure levels are also 
displayed for structured tags.

Compilation Delete actual parameters on interface 
update

Actual parameters are deleted if the 
associated formal parameters were 
deleted in the called block, and you run 
the "Update block call" function or 
compile the block.

Default settings for new blocks IEC check The compatibility of operands in 
comparison operations and arithmetic 
operations are tested according to IEC 
rules. You have to explicitly convert non-
compatible operands.

Additional settings Set network title automatically Sets the title of a network based on the 
comment of the output parameter of the 
first writing instruction in the network.
See also: Inserting network title 
(Page 1521)

Show autocompletion list The autocompletion list is displayed.
Mnemonics German or international designation of 

operations and operands
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Group Setting Description
Download without reinitialization Memory reserve Defines the size of reserve in volatile 

memory that can be used for interface 
extensions.

Block interface / data blocks Set "HMI accessible" for new elements 
and ARRAY data blocks

Enables the option "HMI accessible" for 
new tags in the block interface and in 
data blocks. The use of this option 
makes sense especially when working 
with large amounts of data in ARRAY 
data blocks.
See also: Basic principles for 
programming of data blocks 
(Page 1639)

See also
Layout of the block interface (Page 1491)

Changing the settings (Page 1490)

Permissible addresses and data types of PLC tags (Page 1424)

Overview of the print settings (Page 302)

Basics of block access (Page 1267)

Setting and canceling the IEC check (Page 1372)

Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the general settings (Page 1489)
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9.1.4.2 Programming code blocks

Declaring the block interface

Layout of the block interface

Introduction         
The interface contains the declarations of local tags and constants that are used within the 
block. The tags are subdivided into two groups:

● Block parameters that form the block interface when it is called in the program.

● Local data that are used for storage of intermediate results.

You use the tag declaration to define the call interface of a block in the program and the names 
and data types of tags and constants that you want to use in the block.

The interface of function blocks also defines the structure of the instances that are assigned 
to the function block.

Layout of the block interface       
The following figure shows the structure of the block interface. The number of columns and 
sections varies depending on the type of block. 

Block parameters
The following table shows the types of block parameters:

Type Section Function Available in
Input parameters Input Parameters whose values are read by the 

block. 
Functions, function blocks and 
some types of organization 
blocks

Output parameters Output Parameters whose values are written by the 
block.

Functions and function blocks
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Type Section Function Available in
In/out parameters InOut Parameters whose values are read by the 

block when it is called, and whose values are 
written again by the block after execution.

Functions and function blocks

Return value Return Value that is returned to the calling block. Functions

Depending on the type of block opened, additional sections may be displayed.

Local data
The following table shows the types of local data:

Type Section Function Available in
Temporary local data Temp Tags that are used to store temporary 

intermediate results. Temporary local data 
are retained for only one cycle. If you use 
temporary local data, you have to make sure 
that the values are written within the cycle in 
which you want to read them. Otherwise the 
values will be random.

Functions, function blocks and 
organization blocks
Note:
Temporary local data is not 
shown in instance data blocks.

Static local data Static Tags that are used for storage of static 
intermediate results in the instance data 
block. Static data is retained until 
overwritten, which may be after several 
cycles. The names of the blocks, which are 
called in this code block as multiple instance, 
will also be stored in the static local data.

Function blocks

Constant Constant Constants with declared symbolic names 
that are used within the block.

Functions, function blocks and 
organization blocks
Note:
Local constants are not shown 
in instance data blocks.

Meaning of the columns
The following table shows the meaning of the individual columns. You can show or hide the 
columns as required. The number of columns displayed varies depending on the CPU series 
and the type of the open object.

Column Description
Symbol you can click on to drag-and-drop an element to a program 
for use as an operand.

Name Name of the element. 
Data type Data type of the element.
Offset Relative address of a tag. The column is only visible in blocks with 

standard access.
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Column Description
Default value Value with which you can pre-assign specific tags in the interface of 

the code block, or the value of a local constant.
Specification of the default value is optional for tags. If you do not 
specify any value the predefined value for the indicated data type is 
used. For example, the value "false" is predefined for BOOL.
The default value of a tag is applied as the start value in the 
corresponding instance data block. You can replace these values with 
instance-specific start values in the instance data block.
Constants always have the default value declared in the block 
interface. They are not shown in instance data blocks and cannot be 
assigned instance-specific values there.

Retentivity Marks a tag as retentive. 
The values of retentive tags are retained even after the power supply 
is switched off. 
This column is only visible in the interface of the function block with 
optimized access.

Visible in HMI Shows whether a tag is visible by default in the HMI selection list.
Accessible from HMI Shows whether HMI can access this tag during runtime.
Setting value Marks a tag as a setpoint. Setting values are the values that will 

probably have to be fine tuned during commissioning. 
The column is only available in the interface of function blocks.

Comment Comments on documentation of the element.

See also
Using tags within the program (Page 1295)

Keywords (Page 1289)

Valid data types in the block interface (Page 1495)

Setting the retentivity of local tags (Page 1507)

Basics of constants (Page 1296)

Rules for declaring the block interface

General rules for declaring the block interface

Using POINTER
The following rules apply to the use of block parameters within the block:

● Input parameters may only be read.

● Output parameters may only be written.

● In/out parameters may be read and written.
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Assigning default values to block parameters
You can assign default values to specific parameters in the function block interface. The 
possibility of the assignment depends on the declaration subsection and data type of the 
parameter.

The following table shows which parameters can be assigned a default value:

Parameter type Section Assignment of a default value is possible
Elementary data types Structured data types Parameter types

Input parameters Input X X -
Output parameters Output X X -
In/out parameters InOut X - (1) -
Static local data Static X X -
Temporary local data Temp - - -
Constants Constant X - -

(1) Exception: In blocks with optimized access, you have the option to use PLC data types as 
default values under certain conditions. 

See also: Declaring PLC data types (UDT) as actual parameters for in-out parameters. 
(Page 1510)

 

See also
Using tags within the program (Page 1295)

Keywords (Page 1289)

Valid data types in the block interface

Valid data types in the block interface in S7-300/400     
The following table shows which data types you can assign to the parameters in the individual 
sections of the interface.

Section Standard
Data types

ARRAY
STRUCT
STRING
DT

Parameter 
types

VOID POINTER ANY

Organization block
Temp X X - - - X
Constant X X(3) - - - -
Function block
Input X X X - X X
Output X X - - - -

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1494 System Manual, 02/2014



Section Standard
Data types

ARRAY
STRUCT
STRING
DT

Parameter 
types

VOID POINTER ANY

InOut X X (1) - - X X
Static X X - - - -
Temp X X - - - X
Constant X X(3) - - - -
Function
Input X X (1) X - X X
Output X X (1) - - X X
InOut X X (1) - - X X
Temp X X - - - X
Return X X - X X X (2)

Constant X X(3) - - - -
(1) STRING can only be defined in the standard length of 254 characters.
(2) In SCL, ANY is not permitted as a function value.
(3) Constants with the ARRAY or STRUCT data type are not permitted.

Valid data types in the block interface

Valid data types in the block interface in S7-1200
The following table shows which data types you can assign in the parameters in the individual 
sections of the interface.

Section Standard
Data types

ARRAY
STRUCT
STRING
DT

VOID VARIANT

Organization block
Temp X X - X
Constant X X(2) - -
Function block
Input X X - X
Output X X - -
InOut X X(1) - X
Static X X - -
Temp X X - X
Constant X X(2) - -
Function
Input X X(1) - X
Output X X(1) - X
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Section Standard
Data types

ARRAY
STRUCT
STRING
DT

VOID VARIANT

InOut X X(1) - X
Temp X X - X
Return X X X -
Constant X X(2) - -
(1) STRING can only be defined in the standard length of 254 characters.
(2) Constants with the ARRAY or STRUCT data type are not permitted.

Valid data types in the block interface in S7-1500     
The following table shows which data types you can assign in the parameters in the individual 
sections of the interface.

Section Standard
Data 
types

ARRAY
STRUCT
STRING / 
WSTRING
DT

Paramete
r types

VOID DB_ANY POINTER ANY VARIANT

Organization block
Temp X X -(4) - X - X(3) X
Constant X X(5) - - - - - -
Function block
Input X X X - X X X X
Output X X - - X - - -
InOut X X(1) -(4) - X X X X
Static X X - - X - - -
Temp X X -(4) - - - X(3) X
Constant X X(5) - - - - - -
Function
Input X X(1) X - X X X X
Output X X(1) - - X X X X
InOut X X(1) -(4) - X X X X
Temp X X -(4) - X - X(3) X
Return X X - X X X x(2) -
Constant X X(5) - - - - - -
(1) You cannot make length declarations for STRING and WSTRING in these sections. Here, STRINGs always have the 
standard length 254, WSTRINGs the standard length 16832. A declaration in the format MyString[3] would not be permitted. 
WSTRING is only permitted in blocks with optimized access in these sections. 
(2) In SCL, ANY is not permitted as a function value.
(3) ANY can only be used in blocks with standard access in the "Temp" section.
(4) The "INSTANCE" parameter type is the only exception permissible in the "TEMP" and "InOut" sections.
(5) Constants with the ARRAY or STRUCT data type are not permitted.
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Declaring local tags and constants

Declaring local tags and constants in the block interface

Requirement     
The block interface is open.

Procedure
To declare a tag or constant of the elementary data type, follow these steps:

1. Select the appropriate declaration section in the interface.

2. Enter a name for the element in the "Name" column.

3. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input.

4. For constants, enter a value in the "Default value" column.

5. Optional: Change the properties that are displayed in the other columns of the block 
interface.

Result
The element is created. 

Syntax check
A syntax check is performed after each entry, and any errors found are displayed in red. You 
do not have to correct these errors immediately - you can continue editing and make any 
corrections later. However, you will not be able to compile the program if the tag declaration 
contains syntax errors. 

 

 Note

If you change the interface of a block, the calls of the block in the program will possibly become 
inconsistent. The call locations are automatically updated, if possible.

If an automatic updating is not possible, the inconsistent blocks have to be updated manually. 

See also:

Updating block calls in LAD (Page 1534) 

Updating block calls in FBD (Page 1576) 
 

See also
Editing tables (Page 342)

Basic information on start values (Page 1649)
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Using tags within the program (Page 1295)

Keywords (Page 1289)

Properties of local tags and constants (Page 1506)

Setting the retentivity of local tags (Page 1507)

Declaring a local tag in the program editor

Requirement
The program editor is open. 

Procedure
To declare a local tag, follow these steps:

1. Insert an instruction in your program.
The "<???>", "<??.?>" or "..." strings represent operand placeholders.

2. Replace an operand placeholder with the name of the tag to be created.

3. Select the name of the element.
If you want to declare multiple elements, select the names of all the elements to be declared.

4. Select the "Define tag" command in the shortcut menu.
The "Define tag" dialog box opens. It displays a declaration table in which the name of the 
element is already entered.

5. To declare a local tag, select one of the following sections:

– Local In

– Local Out

– Local InOut

– Local Static

– Local Temp

6. In the other columns, enter data type and comments.

7. Click the "Define" button to complete your entry.
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Result
The declaration is written directly into the block interface and is valid within the entire block.

 

 Note

If you change the interface of a block, the calls of the block in the program will possibly become 
inconsistent. The call locations are automatically updated, if possible.

If an automatic updating is not possible, the inconsistent blocks have to be updated manually. 

See also:

Updating block calls in LAD (Page 1534) 

Updating block calls in FBD (Page 1576) 
 

See also
Editing tables (Page 342)

Using tags within the program (Page 1295)

Keywords (Page 1289)

Basic information on start values (Page 1649)

Properties of local tags and constants (Page 1506)

Setting the retentivity of local tags (Page 1507)

Declaring tags of the ARRAY data type

Requirement     
The block interface is open.

Procedure
To declare a tag of the ARRAY data type, follow these steps:

1. Select the appropriate declaration section in the interface.

2. Enter a tag name in the "Name" column.

3. In the "Data type" column, click the button for the data type selection.
A list of the permissible data types is opened.

4. Select the "Array" data type.
The "Array" dialog opens.

5. In the "Data type" text box, specify the data type of the array elements.
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6. In the "ARRAY limits" text box, specify the high and low limit for each dimension.
Example of a one-dimensional ARRAY:
[0..3]
Example of a three-dimensional ARRAY:
[0..3, 0..15, 0..33]

7. Confirm your entry.

8. Optional: Change the properties of the tags that are displayed in the other columns of the 
block interface.

Result
The tag of ARRAY data type is created. 

 

 Note

You cannot define specific default values for ARRAY elements. However, you can assign 
them start values in the instance.

 

See also
Using tags within the program (Page 1295)

Keywords (Page 1289)

Properties of local tags and constants (Page 1506)

Setting the retentivity of local tags (Page 1507)

Editing tables (Page 342)

Declaring tags of STRUCT data type

Requirement    
The block interface is open.

Procedure
To declare a tag of the STRUCT data type, follow these steps:

1. Select the appropriate declaration section in the interface:

2. Enter a tag name in the "Name" column.

3. Enter "Struct" in the "Data type" column. You will be supported by autocompletion during 
input.
An empty, indented row is inserted after the new tag.

4. Insert the first structural element in the first empty row.
An additional empty row is inserted after the element.

5. Select a data type for the structure element.
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6. Optional: Change the properties of the structural element that is displayed in the other 
columns of the block interface.

7. Repeat the step 4 to 7 for all additional structure elements.
It is not necessary to end the structure explicitly. The structure ends with the last element 
that is entered.

8. To insert a new tag after the structure, leave a blank row after the end of the structure and 
then start the new tag in the second empty row.

Result
The tag of STRUCT data type is created. 

See also
Using tags within the program (Page 1295)

Keywords (Page 1289)

Properties of local tags and constants (Page 1506)

Setting the retentivity of local tags (Page 1507)

Editing tables (Page 342)

Declaring tags based on a PLC data type

Requirement    
A PLC data type is declared in the current CPU.

Procedure
To declare a tag based on a PLC data type, follow these steps:

1. Select the appropriate declaration section in the interface:

2. Enter the PLC data type in the "Data type" column. You will be supported by Autocomplete 
during input.

Result
The tag is created.
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 Note

You define the default values of tags within a PLC data type when the PLC data type is 
created. You cannot change these values at the point of use of the PLC data type. 

If you change or delete PLC data types that are used in the block interface, the interface 
becomes inconsistent. To remedy this inconsistency, the interface has to be updated.

See also: Updating the block interface (Page 1503)
 

See also
Editing tables (Page 342)

Basics of PLC data types (Page 1667)

Declaring higher-level tags

Introduction     
To access data areas within a declared tag, you can overlay the declared tags with an 
additional declaration. This provides you with the option of addressing an already declared tag 
with a different data type. You can, for example, address the individual bits of a tag of WORD 
data type with an ARRAY of BOOL.

Overlaying tags
To overlay a tag with a new data type, follow these steps:

1. Open the block interface.

2. In the interface, select the tag that you want to overlay with a new data type.

3. Click "Add row" in the toolbar.
A row is inserted after the tag to be overlaid. The overlaying tag must be declared in the 
row directly after the tag that is to be overlaid.

4. Enter a tag name in the "Name" column.

5. Enter the "AT" entry in the "Data type" column. You will be supported by Autocomplete in 
this step.
The following is added to the entry in the "Name" column.
"AT<Name of the higher-level tag>"

6. Click the data type selection button again and select the data type for the new tag.
The tag is created. It points to the same data as the higher-level tag, however interprets 
this data with the new data type.
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Removing overlay
To remove the overlay of a tag, follow these steps:

1. Select the overlaid tag that you want to remove.

2. Select the "Delete" command in the shortcut menu.

3. The overlay is removed.

See also
Editing tables (Page 342)

Overlaying tags with AT (Page 1309)

Declaring multi-instances

Requirement    
● The function block to be called exists in project tree and is multi-instance capable.

● The block interface of the calling function block is open.

Procedure
To declare a function block to be called as a multi-instance, follow these steps:

1. In the "Name" column of the "Static" section, enter a designation for the block call.

2. In the "Data type" column, enter the symbolic name for the function block to be called.
 

 Note

The program editor will declare the multi-instance automatically if you program a block call 
in a network and then specify in the "Call options" dialog that you want to call the block as a 
multiple instance.

 

See also
Updating the block interface (Page 1503)

Updating the block interface

Introduction   
If you change or delete PLC data types or multiple instances that are used in the block interface, 
the interface will become inconsistent. To remedy this inconsistency, the interface has to be 
updated.

You have two options for updating the block interface:
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● Explicit updating of the block interface.
The used PLC data types and multiple instances will be updated. The instance data blocks 
that belong to the block are not implicitly updated during this process.

● Implicit updating during compilation.
All used PLC data types and multiple instances as well as the related instance data blocks 
will be updated.

Explicit updating of the block interface
To explicitly update the block interface, follow these steps:

1. Open the block interface.

2. Select the "Update" command in the shortcut menu.

Implicit Updating during Compilation
Proceed as follows to implicitly update all uses of PLC data types and multiple instances as 
well as the instance data blocks during compilation:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Basics of PLC data types (Page 1667)

Declaring tags based on a PLC data type (Page 1501)

Editing tables (Page 342)

Basic information on start values (Page 1649)

Using tags within the program (Page 1295)

Keywords (Page 1289)

Properties of local tags and constants (Page 1506)

Setting the retentivity of local tags (Page 1507)

Updating block calls in LAD (Page 1534)

Declaring multi-instances (Page 1503)

Extending the block interface

Description
In order to enable the editing of PLC programs that have already been commissioned and that 
are running without error on a system, CPUs of the S7-1500 series and most CPUs of the 
S7-1200 V4 series support the option of extending the interfaces of function blocks during 
runtime. 
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You can download the modified blocks without setting the CPU to STOP and without affecting 
the values of already loaded tags. 

This is a simple means of implementing program changes. This load process (download 
without reinitialization) will not have a negative impact on the controlled process. 

Principle of operation
Each function block is always assigned a default memory reserve. The memory reserve is not 
used initially. Activate the memory reserve if you decide on loading interface changes after 
having compiled and downloaded the block. All tags that you subsequently declare will be 
saved to the memory reserve. The subsequent download does not influence any tags that are 
already loaded or have a negative impact on runtime.

If you decide to review your program at a later time while the plant is not in operation, you are 
also provided an option of reworking the memory layout of individual or several blocks in a 
single pass. With this action, you move all tags from the reserve area to the regular area. The 
memory reserve is now cleared and made available for further interface extensions.

Requirements
This "Download without reinitialization" function is available if the following requirements are 
met:

● The project is in the "TIA Portal V12" format or a higher version.

● You are working with a CPU that supports "Download without reinitialization".

● The blocks were created in LAD, FBD, STL, or SCL.

● The blocks were created by the user, i.e. they are not included with the blocks delivered in 
your package.

● These blocks are assigned the optimized access attribute.

Basic steps
Perform the following steps if you want to extend the interface of a function block and then 
load the block without re-initialization.

1. All blocks have a default memory reserve of 100 bytes. You can adapt this memory reserve 
to suit your requirements.

2. Activate the memory reserve.

3. Extend the block interface.

4. Compile the block.

5. Download the block to the CPU as usual.
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For more information on the various steps, refer to chapter "Loading blocks (S7-1200/1500) ".
 

 Note

The full scope of the "Download without reinitialization" function is only available on CPUs of 
the S7-1500 and S7-1200 V4 series. 

However, all CPU families support the option of extending the interface of function blocks 
and downloading newly declared tags without repercussion:
● You may add new tags in the "Temp" section and download these without influencing the 

process.
● You may create new tags of a structured data type in the "InOut" section and download 

these without influencing the process.
 

Editing the properties of local tags and constants

Properties of local tags and constants

Properties     
The table below provides an overview of the properties of local tags and constants:

Group Property Description
General Name Name of the element.

Data type Data type of the element.
Default value Value with which you can pre-assign specific tags in the 

interface of the code block, or the value of a local constant. 
Specification of the default value is optional for tags. If you 
do not specify any value the predefined value for the 
indicated data type is used. For example, the value "false" 
is predefined for BOOL.
The default value of a tag is applied as the start value in 
the corresponding instance. You can then replace these 
adopted values with instance-specific start values.

Comment Comment for the element.
Attributes Retain Marks the tag as retentive. 

The values of retentive tags are retained even after the 
power supply is switched off. 
This attribute is only available in the interface of the 
function block with optimized access.
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Group Property Description
Accessible from HMI Indicates whether the tag can be used in HMI.

When the attribute is set, you have read or write access 
to the tag from the HMI.
When the attribute is not set, you cannot access the tag 
from the HMI. Please note, however, that you cannot 
implement general access protection for the tag with the 
"Accessible from HMI" attribute. Read or write access 
from other applications is possible even if the attribute is 
not enabled.

Visible in HMI Shows whether the tag is visible by default in the HMI 
selection list.

Hidden parameter Indicates whether the tag should be hidden for the block 
call. This is only possible if you have specified a valid 
predefined actual parameter beforehand.

Predefined actual 
parameter

Defines a parameter that is to be used as actual parameter 
during the block call.

Configurable Indicates whether a parameter is configurable in CFC.
For test Indicates whether a parameter is registered for the CFC 

test mode.
Visible Indicates whether a parameter is visible in CFC.
Interconnectable Indicates whether a parameter is interconnectable in CFC.
Enable tag readback Indicates whether a parameter is relevant for the "Read 

back chart" function in CFC. 
Enumeration texts Assigns a parameter to an enumeration in CFC.
Engineering unit Assigns a parameter to a unit in CFC.
Low limit Defines the low limit for the parameter in CFC.
High limit Defines the high limit for the parameter in CFC.

See also
Setting the retentivity of local tags (Page 1507)

Changing properties of local tags and constants (Page 1508)

Keywords (Page 1289)

Setting the retentivity of local tags

Introduction       
Function blocks store their data in an instance. To prevent data loss in the event of power 
failure, you can mark the data as retentive. This data is stored in a retentive memory area. The 
option of setting the retentivity depends on the set access type of the function block. 
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Retentive behavior in blocks with standard access
In blocks with standard access you cannot set the retentive behavior of individual tags. You 
can only define them as retentive in the assigned instance. All tags contained in the block are 
then considered as retentive.

Retentivity for optimized block access
In data blocks with optimized access you can define the retentive behavior of individual tags. 

For structured data type tags, the retentivity setting always applies to the entire structure. You 
can make no individual retentivity setting for individual elements within the structure. 

You cannot create retentive tags of the structured data type in the "InOut" section. In/out 
parameters with structured data type, for example ARRAY, STRUCT, or STRING, are always 
non-retentive.

The following settings are available:

● Retentive
The values of the tags or the structure are available even after a power failure.

● Non-retentive
The values of the tags or the structure are lost in the event of a power failure.

● Set in IDB
The retentivity can be set in the instance data block. The setting that is made in the instance 
data block than applies, however, centrally to all tags that are selected with "Set in IDB".

See also
Properties of local tags and constants (Page 1506)

Basics of block access (Page 1267)

Changing properties of local tags and constants

Editing properties of an element in the block interface     
To edit the properties of an element in the block interface, follow these steps:

1. Open the block interface.

2. Select the required element in the table.

3. Change the entries in the columns.

Editing properties of several elements in the block interface
You can also simultaneously set or reset the "Retain", "Visible in HMI", "Accessible in HMI" 
and "Setpoint" columns for one or more selected elements.  

To change one of these properties for several elements, follow these steps:
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1. Open the block interface.

2. Hold down the CTRL key.

3. In the required column, select each of the table cells whose value you want to change.

4. Select the "Set <property>" or "Reset <property>" command in the shortcut menu.

Editing properties in the properties window
To edit the properties of an individual tag or constant, follow these steps:

1. Select an element in the table.
The properties of the element are shown in the Inspector window.

2. Change the entries in the inspector window.

Renaming tags directly in the program editor
To rename one or more elements, follow these steps:

1. Select one or more elements in the program.

2. Select the "Rename tag" command in the shortcut menu.
The "Rename tag" dialog opens. It displays a declaration table with the selected elements.

3. Change the entries in the "Name" column.

4. Confirm the input by clicking the "Change" button.

Editing the data type or comment in the program editor
Proceed as follows to edit the data type or tag comment in the program editor:

1. Select the name of the tag.

2. Select the "Rewire tag" command in the shortcut menu.
The "Rewire tag" dialog will open. The dialog shows a declaration table.

3. Change the entry in the "Data type" or "Comment" columns.

4. Click the "Change" button to confirm the input.

Effect in the program
In case of a change of the name, data type or address of a tag or constant, each location of 
use of the tag is automatically updated in the program. 
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 Note

If you change the interface of a block, the program may become inconsistent. The 
inconsistencies are automatically updated, if possible.

If an automatic updating is not possible, the inconsistent calls are marked in red. You than 
have to manually updated the inconsistencies. 

See also: 

Updating block calls in LAD (Page 1534) 

Updating block calls in FBD (Page 1576) 
 

 

See also
Layout of the block interface (Page 1491)

Editing tables (Page 342)

Properties of local tags and constants (Page 1506)

Setting the retentivity of local tags (Page 1507)

Basic information on start values (Page 1649)

Using tags within the program (Page 1295)

Keywords (Page 1289)

Updating the block interface (Page 1503)

Declaring PLC data types (UDT) as actual parameters for in-out parameters.

Use of PLC data types as predefined actual parameters 
In blocks with optimized access, you have the option to use PLC data types as actual 
parameters for in/out parameters (InOut) under certain conditions. This can be useful if you 
are using program blocks as library elements and want to store information about the actual 
parameters to be used along with the library element.

Additionally, you have the option of hiding in/out parameters that have a vaild predefined actual 
parameter when the block is called. Hidden parameters are not visible initially when the block 
is called but can be displayed via a small arrow at the bottom edge of the box.
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Requirements
● The in/out parameter (InOut) is based on a PLC data type or a system data type.

● The in/out parameter has the retentivity setting "Retain" or "Non-retain". For in/out 
parameters with setting "Set in IDB", it is not possible to predefine actual parameters.

● The program block is a block with optimized access.

Procedure
To predefine the actual parameter of an in/out parameter, follow these steps:

1. Open the block interface.

2. Select an in/out parameter (InOut) in the block interface.

3. Open the "Properties" tab in the Inspector window.

4. Select the "Attributes" group in the area navigation.

5. Enter the required actual parameter in the "Predefined actual parameter" input box.

6. Select the "Hidden parameter" check box (optional).

Result
● An actual parameter is predefined. If you save the program block as a library element, it 

thus also contains information about the actual parameter to be used.

● If the library element is used in the program, a check is made to determine whether the 
actual parameter you have predefined can be addressed. If so, it is automatically used as 
the actual parameter. 

● If the actual parameter is not found in the program, a syntax error is signaled. The parameter 
is not hidden and the parameter must be initialized manually.

Editing the block interface

Inserting table rows

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.

Result
A new row is inserted above the selected row. 
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See also
Editing tables (Page 342)

Inserting table rows

Procedure  
Proceed as follows to insert a row below the selected row:

1. Select the row below which you want to insert a new row.

2. Click the "Add row" button on the table toolbar.

Result
A new empty row will be inserted below the selected row.

See also
Editing tables (Page 342)

Deleting tags

Procedure   
Follow the steps below to delete elements:

1. Select the row with the element to be deleted. You can also select several rows by clicking 
on them one after the other while holding down the <Ctrl> key or by pressing and holding 
down <Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.

See also
Editing tables (Page 342)

Automatically filling in successive cells
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

You can define individual or more cells as well as entire rows as source area.

If less rows exist in the open table than you want to fill, then you will first have to insert additional 
empty rows. 
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Requirement
● The table is open.

● Sufficient declaration rows are available.

Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. 

5. If entries are already present in the cells that are to be automatically filled in, a dialog 
appears. In this dialog you can indicate whether you want to overwrite the existing entries 
or insert new rows for the new tags.

See also
Editing tables (Page 342)

Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

Editing tags with external editors
To edit individual tags in external table editors, such as Excel, you can export or import these 
tags using copy and paste. However, you cannot copy structured tags to an editor.

Requirements   
The block interface and an external editor are opened.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1513



Procedure
To export individual tags to an external editor and import them again, follow these steps:

1. Select one or more tags.

2. Select "Copy" in the shortcut menu.

3. Switch to the external editor and paste the copied tags.

4. Edit the tags as required.

5. Copy the tags in the external editor.

6. Select the tags in the external editor.

7. Switch back to the block interface.

8. Select "Paste" in the shortcut menu.

Creating program code

Creating LAD programs

Basic information on LAD

LAD programming language

Overview of the Ladder Logic (LAD) programming language       
LAD is a graphical programming language. The representation is based on circuit diagrams. 

The program is mapped in one or more networks. A network contains a power rail on the left 
where the rungs originate. The binary signal scans are arranged in the form of contacts on the 
rungs. The serial arrangement of the elements on a rung creates a series connection; 
arrangement on simultaneous branches creates a parallel connection. Complex functions are 
represented by boxes. 

Example of networks in LAD
The following figure shows a LAD network with two normally open contacts, one normally 
closed contact and one coil:
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Overview of the LAD elements

LAD elements
A LAD program consists of separate elements that you can arrange in series or parallel on the 
power rail of a network. Most program elements must be supplied with tags. 

There is at least one rung from the power rail. Network programming starts at the left edge of 
the rung. You can expand the power rail by several rungs and branches. 

For example, the following figure shows elements of a LAD network:

1) Power rail

2) Rung

3) Branch

4) Contact

5) Coil

6) Box

Power rail
Each LAD network consists of a power rail that contains at least one rung. A network can be 
extended by adding additional rungs. You can use branches to program parallel connections 
in the specific rungs.

Contacts
You can use contacts to create or interrupt a current-carrying connection between two 
elements. The current is relayed from left to right. You can use contacts to query the signal 
state or the value of an operand and control it depending on the result of the current flow.

The following types of contact are available to you in a LAD program:
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● Normally open contact: 
Normally open contacts forward the current if the signal state of a specified binary operand 
is "1".

● Normally closed contacts: 
Normally closed contacts forward the current if the signal state of a specified binary operand 
is "0".

● Contact with additional function: 
Contacts with additional function forward the current if a specific condition is met. With these 
contacts you can also execute an additional function, such as an RLO edge detection and 
a comparison.

Coils
You can use coils to control binary operands. Coils can set or reset a binary operand depending 
on the signal state of the result of logic operation.

The following types of coils are available to you in a LAD program:

● Standard coils: 
Standard coils set a binary operand if current flows in the coil. The "Assignment" instruction 
is an example of a standard coil.

● Coils with additional function:
These coils have additional functions in addition to the evaluation of the logic operation 
result. Coils for RLO edge detection and program control are examples of coils with 
additional function. 

Boxes
Boxes are LAD elements with complex functions. The empty box is an exception. You can use 
the empty box as a placeholder in which you can select the required instruction.

The following types of boxes are available to you in a LAD program:

● Boxes without EN/ENO mechanism:
A box is executed depending on the signal state at the box inputs. The error status of the 
processing cannot be queried.

● Boxes with EN/ENO mechanism:
A box is only executed if the enable input "EN" carries the signal state "1". If the box is 
processed correctly, the "ENO" enable output has signal state "1". If an error occurs during 
the processing, the "ENO" enable output is reset.

Calls of code block are also shown in the network as boxes with EN/ENO mechanism.

See also
Rules for the use of LAD elements (Page 1525)
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Settings for LAD

Overview of the settings for LAD

Overview  
The following table shows the settings that you can make:

Group Setting Description
Font Font size Font size in program editor
View Layout Compact or wide

Changes the vertical spacing between 
operands and other objects (such as 
operand and contact). The change 
becomes visible once the block is 
reopened.

With absolute information Additional display of the absolute 
addresses

Operand field Maximum width Maximum number of characters that 
can be entered horizontally in the 
operand field. This setting recalculates 
the layout of the networks.

Maximum height Maximum number of characters that 
can be entered vertically in the operand 
field. This setting recalculates the layout 
of the networks.

See also
Changing the settings (Page 1517)

Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.
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See also
Overview of the settings for LAD (Page 1517)

Working with networks

Using networks

Function 
The user program is created in the block within networks. For a code block to be programmed, 
it must contain at least one network. To achieve a better overview of the user program, you 
can also subdivide your program into several networks.

See also
Inserting network title (Page 1521)

Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Inserting networks

Requirement 
A block is open.

Procedure
To insert a new network, follow these steps:

1. Select the network after which you want to insert a new network.

2. Select the "Insert network" command in the shortcut menu.

Result
A new empty network is inserted into the block. 

See also
Selecting networks (Page 1519)

Copying and pasting networks (Page 1519)

Deleting networks (Page 1520)

Expanding and collapsing networks (Page 1521)

Inserting network title (Page 1521)
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Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Selecting networks

Requirements
A network is available.

Selecting a network
To select a network, follow these steps:

1. Click the title bar of the network that you want to select.

Selecting several networks
Proceed as follows to select several individual networks:

1. Press and hold down the <Ctrl> key.

2. Click all the networks that you want to select.

To select several successive networks, follow these steps:

1. Press and hold down the <Shift> key.

2. Click the first network that you want to select.

3. Click the last network that you want to select.
The first and last networks and all those in between are selected. 

See also
Inserting networks (Page 1518)

Copying and pasting networks (Page 1519)

Deleting networks (Page 1520)

Expanding and collapsing networks (Page 1521)

Inserting network title (Page 1521)

Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Copying and pasting networks
Copied networks can be pasted within the block or in another block. Networks that were created 
in LAD or FBD can also be inserted in blocks of the respective other programming language.
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Requirement     
A network is available.

Procedure
To copy and paste a network, follow these steps:

1. Select the network or networks to be copied.

2. Select "Copy" in the shortcut menu.

3. Select the network after which you want to paste in the copied network.

4. Select "Paste" in the shortcut menu.

See also
Inserting networks (Page 1518)

Selecting networks (Page 1519)

Deleting networks (Page 1520)

Expanding and collapsing networks (Page 1521)

Inserting network title (Page 1521)

Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Deleting networks

Requirement
A network is available.

Procedure
To delete a network, follow these steps:

1. Select the network that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Inserting networks (Page 1518)

Selecting networks (Page 1519)

Copying and pasting networks (Page 1519)

Expanding and collapsing networks (Page 1521)

Inserting network title (Page 1521)
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Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Expanding and collapsing networks

Requirements  
A network is available.

Opening and closing a network
To open a network, follow these steps:

1. Click on the right arrow in the network title bar.

To close a network, follow these steps:

1. Click on the down arrow in the network title bar.

Opening and closing all networks
To open and close all networks, follow these steps:

1. In the toolbar, click "Open all networks" or "Close all networks".

See also
Inserting networks (Page 1518)

Selecting networks (Page 1519)

Copying and pasting networks (Page 1519)

Deleting networks (Page 1520)

Inserting network title (Page 1521)

Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Inserting network title
The network title is the header of a network. The length of the network title is limited to one 
line. You can enter the title manually or set it automatically. When you set it automatically, you 
can do this for individual networks or use the settings to specify that the network title is always 
set automatically. 

For automatic insertion of the network title, the comment of the operand in one of the following 
instructions in the network is evaluated:
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● Assignment

● Set output

● Reset output

The instruction that is listed first in the network is used.

The network title is only inserted automatically when the following conditions are fulfilled:

● The network does not have a title yet.

● The operand of the instruction used for the comment has a comment.
 

 Note

Note the following restrictions for automatic insertion of the network title:
● The network title is not adapted if you change the comment of the operand at a later time.
● The network title is not adapted if you change the operand of the instruction.
● The network title is only set by the writing instructions listed above.
● If the operand is of the data type array, the comment of the array is used and not the 

comments of the array elements.
● Comments of invalid operands are not taken into consideration.

 

Entering the network title manually
To enter a network title, follow these steps:

1. Click on the title bar of the network.

2. Enter the network title.

Setting the network title automatically
To specify that the network titles are always set automatically, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Select the "Set network title automatically" check box in the "Additional settings" group.
The network titles are set automatically as of this time if the conditions listed above are 
fulfilled.

To set an individual network title automatically, follow these steps:

1. Right-click "Network <Number of the network>" in the title bar of a network.

2. Select the "Set network title automatically" command in the shortcut menu.
The title of the selected network is set based on the comment of the operand if the conditions 
listed above are fulfilled.
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See also
Using networks (Page 1518)

Inserting networks (Page 1518)

Selecting networks (Page 1519)

Copying and pasting networks (Page 1519)

Deleting networks (Page 1520)

Expanding and collapsing networks (Page 1521)

Entering a network comment (Page 1523)

Navigating networks (Page 1524)

Entering a network comment
You can use network comments to provide comments on the program contents of individual 
networks. For example, you can indicate the function of the network or draw attention to special 
characteristics. 

Requirement  
A network is available.

Procedure
To enter a network comment, follow these steps:

1. Click on the right arrow before the network title.

2. If the comment area is not visible, click "Network comments on/off" in the toolbar.
The comment area is displayed.

3. Click "Comment" in the comment area.
The "Comment" text passage is selected.

4. Enter the network comment.

 

See also
Using networks (Page 1518)

Inserting networks (Page 1518)

Selecting networks (Page 1519)

Copying and pasting networks (Page 1519)

Deleting networks (Page 1520)

Expanding and collapsing networks (Page 1521)
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Inserting network title (Page 1521)

Navigating networks (Page 1524)

Navigating networks
You can navigate straight to a specific position within a block.

Procedure 
To navigate to a specific position within a block, follow these steps:

1. Right-click in the code area of the programming window.

2. Select the "Go to > Network/line" command in the shortcut menu.
The "Go to" dialog will open.

3. Enter the network to which you want to navigate.

4. Enter the line number of the network to which you want to navigate.

5. Confirm your entry with "OK".

Result
The relevant line will be displayed if this is possible. If the network or line requested does not 
exist, the last existing network or the last existing line in the network requested will be displayed. 

See also
Using networks (Page 1518)

Inserting networks (Page 1518)

Selecting networks (Page 1519)

Copying and pasting networks (Page 1519)

Deleting networks (Page 1520)

Expanding and collapsing networks (Page 1521)

Inserting network title (Page 1521)

Entering a network comment (Page 1523)
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Inserting LAD elements

Rules for the use of LAD elements

Rules   
Note the following rules when inserting LAD elements:

● Every LAD network must terminate with a coil or a box. However, the following LAD 
elements must not be used to terminate a network:

– Comparator boxes

– Instructions for positive and negative RLO edge detection

● The starting point of the branch for a box connection must always be the power rail. Logic 
operations or other boxes can be present in the branch before the box.

● Only contacts can be inserted into simultaneous branches with preceding logic operations. 
The contact for negating the result of logic operation (-|NOT|-) is an exception here. The 
contact for negating the result of logic operation, as well as coils and boxes, can be used 
in simultaneous branches if they originate directly from the power rail.

● Constants (e.g. TRUE or FALSE) cannot be assigned to normally closed or normally open 
contacts. Instead, use operands of the BOOL data type.

● Only one jump instruction can be inserted in each network.

● Only one jump label can be inserted in each network.

● Instructions with positive or negative edge detection may not be arranged directly at the 
left margin of the rung as they requires a prior logic operation.

Placement rules for S7-1200/1500 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonics Name

SET_BF Set bit field No
RESET_BF Reset bit field No
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
JMP_LIST Define jump list No
SWITCH Jump distributor No
RET Return No
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Placement rules for S7-300/400 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonic

s
Name

S Set output Yes
R Reset output Yes
SP Start pulse timer Yes
SE Start extended pulse timer Yes
SD Start on-delay timer Yes
SS Start retentive on-delay timer Yes
SF Start off-delay timer Yes
SC Set counter value Yes
CU Count up Yes
CD Count down Yes
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
RET Return No
OPN Open global data block No
OPNI Open instance data block No
CALL Call block No
SAVE Save RLO in BR bit No
MCRA Enable MCR range No
MCRD Disable MCR range No
MCR< Open MCR ranges No
MCR> Close MCR ranges No

See also
Prohibited interconnections in LAD (Page 1527)

Overview of the LAD elements (Page 1515)
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Prohibited interconnections in LAD

Power flow from right to left 
No branches can be programmed that could result in a power flow in the reverse direction.

Short-circuit
No branches may be programmed that would cause a short-circuit.

Logic operations
The following rules apply to logic operations:

● Only Boolean inputs can be combined with preceding logic operations.

● Only the first Boolean output can be combined with a further logic operation.

● Only one complete logical path can exist per network. Paths that are not connected can be 
linked.

See also
Rules for the use of LAD elements (Page 1525)

Inserting LAD elements using the "Instructions" task card

Requirement   
A network is available.
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Procedure
To insert a LAD element into a network using the "Instructions" task card, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to the LAD element that you want to insert.

3. Use drag-and-drop to move the element to the desired place in the network.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Or:

1. Select the point in the network at which you want to insert the element.

2. Open the "Instructions" task card.

3. Double-click on the element you want to insert.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Result
The selected LAD element is inserted with placeholders for the parameters. 

Inserting LAD elements using an empty box

Requirement  
A network is available.

Procedure  
To insert an LAD element into a network using an empty box, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Empty box" in the "Basic instructions" palette.

3. Use a drag-and-drop operation to move the "Empty box" element to the desired place in 
the network.
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4. Position the cursor over the triangle in the top right-hand corner of the empty box.
A drop-down list is displayed.

5. Select the required LAD element from the drop-down list.
If the element is an internal system function block (FB), the "Call option" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multi-instance", these 
are located in the block interface in the "Static" section.

Result
The empty box is changed to the respective LAD element. Placeholders are inserted for the 
parameters.

Selecting the data type of a LAD element

Selecting a data type

Introduction
Some instructions can be executed with several different data types. If you use one of these 
instructions in the program, you have to specify a valid data type for the instruction at the 
specific point in the program. For some instructions, you have to select the data types for the 
inputs and outputs separately. 

 

 Note

The valid data type (BOOL) for the tags on the enable input EN and the enable output ENO 
is predefined by the system and cannot be changed. 

 

The valid data types for an instruction are listed in the instruction drop-down list. You specify 
the data type of the instruction by selecting an entry from the drop-down list. If the data type 
of an operand differs from the data type of the instruction and cannot be converted implicitly, 
the operand is displayed in red and a rollout with the corresponding error message appears. 

Data type selection of mathematical instructions
Some mathematical instructions provide you with the option of having the data type 
automatically set corresponding to the data types of the operand. In the drop-down list for data 
type selection, these instructions have the entry "Auto" in addition to the actual data types. If 
you select this entry and then allocate the first operand, the data type of the operand is selected 
as data type for the instruction. The entry in the drop-down list changes to "Auto (<Data type>)", 
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e.g. "Auto (Real)". If you allocate additional operands, the automatically set data type of the 
instruction is adjusted according to the following criteria:

● You supply all other operands with tags of the same data type: 
The data type of the instruction is not changed.

● You supply all other operands with tags whose data type is smaller than the data type of 
the instruction: 
The data type of the instruction is not changed. For the operand with the smaller data type, 
an implicit conversion is conducted if necessary.

● You supply an additional operand with a tag whose data type is greater than the data type 
of the instruction:
The data type of the instruction is changed to the larger data type. An implicit conversion 
is performed, if necessary, for operands that deviate from the newly set data type of the 
instruction.

Each change in the data type of an operand can result in a change of the data type of the 
instruction. Other operands may possibly be implicitly converted as a result. Operands for 
which an implicit conversion is performed are marked with a gray square.

 

 Note

Please also observe the information on data type conversion for your device and, in particular, 
the notes on the IEC check. 

See also: Data type conversion
 

See also
Defining the data type of an instruction (Page 1530)

Defining the data type of an instruction

Introduction
Some instructions can be executed with several different data types. When you insert such 
instructions into your program, you must specify the data type for these instructions at the 
actual point in the program. 

Specifying the data type by means of the drop-down list
To define the data type of an instruction using the drop-down list, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Click the triangle in the upper corner of the drop-down list.
The drop-down list will open to display the data types valid for the instruction.
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3. Select a data type from the drop-down list.
The selected data type is displayed.

4. If the instruction has two drop-down lists, select the data type for the instruction inputs in 
the left-hand drop-down list and the data type for the instruction outputs in the right-hand 
drop-down list.

Specifying data type by assigning tags
To define the data type of an instruction by assigning tags, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. At an input or output, specify a valid tag, the data type of which is to be applied as the 
instruction data type.
The data type of the tag is displayed in the drop-down list.

3. Enter a valid tag at an input and a valid tag at an output if data types need to be defined 
for both the inputs and outputs of the instruction. The tag specified at the input determines 
the data type of the inputs; the tag specified at the output determines the data type of the 
outputs of the instruction.

Automatically specifying the data type of mathematical instructions
To automatically specify the data type for mathematical instructions, follow these steps:

1. Insert the mathematical instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Select the "Auto" entry from the drop-down list.

3. Enter a valid tag at an input or output. 
The data type of the tag is applied as data type of the instruction. The entry in the drop-
down list changes to "Auto (<Data type>)".

See also: Selecting a data type (Page 1529)

See also
Selecting a data type (Page 1529)

Using favorites in LAD

Adding LAD elements to Favorites

Requirement  
● A block is open.

● The multipane mode is set for the "Instructions" task card or the Favorites are also displayed 
in the editor.
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Procedure
To add SCL instructions to the Favorites, follow these steps:

1. Open the "Instructions" task card.

2. Maximize the "Basic instructions" pane.

3. Navigate in the "Basic instructions" pane to the instruction that you want to add to the 
Favorites.

4. Drag-and-drop the instruction into the "Favorites" pane or into the Favorites area in the 
program editor.

 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Removing LAD elements from Favorites (Page 1533)

Overview of the program editor (Page 1470)

Inserting LAD elements using favorites

Requirement  
● A block is open.

● Favorites are available.

Procedure
To insert an instruction into a program using Favorites, follow these steps:

1. Drag-and-drop the desired instruction from Favorites to the desired position.

Or:

1. Select the position in the program where you want to insert the instruction.

2. In the Favorites, click on the instruction you want to insert.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.
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See also
Removing LAD elements from Favorites (Page 1533)

Overview of the program editor (Page 1470)

Removing LAD elements from Favorites

Requirement
A code block is open. 

Procedure
To remove instructions from Favorites, follow these steps:

1. Right-click on the instruction you want to remove.

2. Select the "Remove instruction" command in the shortcut menu.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Adding LAD elements to Favorites (Page 1531)

Inserting LAD elements using favorites (Page 1532)

Overview of the program editor (Page 1470)

Insert block calls in LAD

Inserting block calls using a drag-and-drop operation
You can insert calls for existing functions (FC) and function blocks (FB) using a drag-and-drop 
operation from the project tree. If you call function blocks from other function blocks, you can 
either call them as single-instance or multi-instance blocks. If a function block is called as single 
instance, it will store its data in a data block of its own. If a function block is called as multi-
instance, it will store its data in the instance data block of the calling function block.

Requirement    
● A network is available.

● The block that is to be called is available.
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Inserting a call of a function (FC)
To insert a call of a function (FC) into a network using a drag-and-drop operation, follow these 
steps:

1. Drag the function from the project tree to the required network.

Inserting a call for a function block (FB)
To insert a call for a function block (FB), follow these steps:

1. Drag the function block from the project tree to the required network.
The "Call options" dialog opens.

2. Enter in the dialog whether you wish to call the block as single or multi-instance.

– If you click on the "Single instance" button, you will have to enter a name in the "Name" 
text box for the data block that you want to assign to the function block.

– If you click on the "Multi-instance" button, you will have to enter the name of the tag in 
the "Name in the interface" text box; this is the name that you use to enter the called 
function block as a static tag in the interface of the calling block.

3. Confirm your entries with "OK".

Result
The function or the function block is inserted with its parameters. You can then assign the 
parameters. 

See also: Auto-Hotspot 
 

 Note

If when calling a function block you specify an instance data block that does not exist, it will 
be created. If you have called a function block as a multi-instance, this will be entered as a 
static tag in the interface.

 

 

See also
Updating block calls in LAD (Page 1534)

Changing the instance type (Page 1535)

Single instances (Page 1275)

Multi-instances (Page 1275)

Updating block calls in LAD
If interface parameters of a called block are changed, the block call can no longer be executed 
correctly. You can avoid such inconsistent block calls by updating the block calls.

You have two options to update the block calls:
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● Explicit updating in the program editor.
The block calls in the open block will be updated. 

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types will be updated.

Update blocks in the program editor  
To update a block call within a block, follow these steps:

1. Open the block in the program editor.

2. Click "Update inconsistent block calls" in the toolbar.

Or:

1. Open the block in the program editor.

2. Right-click on the instruction with the block call.

3. Select the "Update" command in the shortcut menu.
The "Interface update" dialog opens. This dialog shows the differences between the block 
interface in use and the changed interface of the called block.

4. If you want to update the block call, click "OK". To cancel the update, click "Cancel".

Update block calls during compilation
Follow these steps to update all block calls and uses of PLC data types during compilation 
implicitly:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Inserting block calls using a drag-and-drop operation (Page 1533)

Changing the instance type (Page 1535)

Changing the instance type

Instance type
There are two ways of calling function blocks:

● As a single instance

● As a multiple instance

See also: Auto-Hotspot 

You can modify a defined instance type at any time.
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Requirement       
The user program contains a block call.

Procedure
To change the instance type of a function block, follow these steps:

1. Open the code block and select the block call.

2. Select the "Change instance" command in the shortcut menu.
The "Call options" dialog opens.

3. Click the "Single instance" or "Multi instance" button.

– If you select the "Single instance" instance type, enter a name for the data block that is 
to be assigned to the function block.

– If you select "Multiple instance" as the instance type, enter in the "Name in the interface" 
text field the name of the tag with which the called function block is to be entered as a 
static tag in the interface of the calling block.

4. Confirm your entries with "OK".
 

 Note

The previous single and multiple instances will not be deleted automatically.
 

See also
Inserting block calls using a drag-and-drop operation (Page 1533)

Updating block calls in LAD (Page 1534)

Inserting complex LAD instructions

Using the "Calculate" instruction

Requirement    
A network is available.

Procedure
Proceed as follows to use the "Calculate" instruction:

1. Open the "Instructions" task card.

2. Navigate to "Math functions > CALCULATE" in the "Basic instructions" pane.
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3. Use drag-and-drop to move the element to the desired place in the network.
The instruction "Calculate" will be inserted for the data type with a placeholder expression 
and question mark.

4. Enter the data type for the calculation.

5. Enter the operands for the calculation.
 

  Note

The calculation is run with the inputs of the "Calculate" instruction. If you want to use 
constants you must also insert appropriate inputs for them. 

 

6. Click on the "Edit 'Calculate' instruction" button to replace the placeholder expression with 
the correct expression.
The "Edit 'Calculate' instruction" dialog will open.

7. Enter the required expression in the "OUT:= " text box.
 

  Note

In the "Example" area you can find an example of a valid expression and possible 
instructions that you can use. 

To determine a value with the help of Pythagoras' theorem, for example, enter "OUT := 
SQRT (SQR (IN1) + SQR (IN2))".

 

8. Confirm your entry with "OK".

See also
CALCULATE: Calculate (Page 1961)

Using free-form comments

Basic information on using free-form comments in LAD

Introduction  
Free-form comments allow you to add comments to the source code for graphic programming 
languages similar to line comments for textual languages.

Free-form comments can be used for the following elements:

● Boxes

● Coils
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See also
Inserting free-form comments (Page 1538)

Editing free-form comments (Page 1538)

Deleting free-form comments (Page 1540)

Inserting free-form comments

Requirement
A network with instructions is available.

Procedure  
To insert a free comment on an instruction, proceed as follows:

1. If necessary, activate the "Free-form comments on/off" button in the toolbar.

2. Right-click on the instruction for which you want to insert a free-form comment.

3. Select the "Insert comment" command in the shortcut menu.
A comment box with a standard comment opens. The comment box is connected by an 
arrow to the corresponding instruction.

4. Enter the required comment in the comment box.

See also
Basic information on using free-form comments in LAD (Page 1537)

Editing free-form comments (Page 1538)

Deleting free-form comments (Page 1540)

Editing free-form comments

Introduction  
Free-form comments can be edited as follows:

● Changing the comment text

● Changing the position and size of the comment box

● Attaching a comment to another element

● Showing and hiding free comments
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Changing the comment text
To change the text of free-form comments, follow these steps:

1. Click on the comment box.

2. Enter the desired text.

Changing the position of the comment box
To change the positioning of the comment box, follow the steps below:

1. Left-click the comment box and keep the mouse button pressed.

2. Drag the comment box to the desired location.

Changing the size of the comment box
To change the size of the comment box, follow the steps below:

1. Click on the comment box.

2. Drag the comment box on the move handle in the lower right corner to the desired size.

Attaching a comment to another element
To attach a free-form comment to another element, follow these steps:

1. Left-click the point of the arrow that links the comment box with the instruction and keep 
the mouse button pressed.

2. Drag the arrow to the element to which you want to attach the comment. Possible insertion 
points are marked with a green square.

3. Release the mouse button.

Showing and hiding free comments
To show or hide a free-form comments, follow these steps:

1. Click the "Free-form comment on/off" button in the toolbar.

See also
Basic information on using free-form comments in LAD (Page 1537)

Inserting free-form comments (Page 1538)

Deleting free-form comments (Page 1540)
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Deleting free-form comments

Procedure  
To delete a free-form comment, proceed as follows:

1. Right-click on the free-form comment that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Basic information on using free-form comments in LAD (Page 1537)

Inserting free-form comments (Page 1538)

Editing free-form comments (Page 1538)

Editing LAD elements

Selecting LAD elements
You can select several individual elements or all elements in a network.

Requirement  
LAD elements are available

Selecting several individual LAD elements
To select several individual LAD elements, follow these steps:

1. Press and hold down the <Ctrl> key.

2. Click on all the LAD elements you wish to select.

3. Now release the <Ctrl> key.

Selecting all LAD elements in a network
To select all LAD elements in a network, follow these steps:

1. Go to the network whose elements you wish to select.

2. Select the "Select all" command in the "Edit" menu or press <Ctrl A>.
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See also
Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)

Copying LAD elements

Requirement 
An LAD element is available.

Procedure
To copy a LAD element, follow these steps:

1. Right-click the LAD element that you want to copy.

2. Select "Copy" in the shortcut menu.

Result
The LAD element will be copied and saved to the clipboard.

See also
Selecting LAD elements (Page 1540)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)
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Cutting LAD elements

Requirement 
An LAD element is available.

Cutting
To cut a LAD element, follow these steps:

1. Right-click the LAD element that you want to cut.

2. Select "Cut" in the shortcut menu.

Result
The LAD element will be cut and saved to the clipboard.

See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)

Pasting an LAD element from the clipboard

Requirement
An LAD element is available.

Procedure
To paste an LAD element from the clipboard, follow these steps:

1. Copy a LAD element or cut a LAD element.

2. Right-click the point in the network where you want to paste the element.

3. Select "Paste" in the shortcut menu.
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See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)

Replacing LAD elements
You can easily exchange LAD elements with other LAD elements of the same type. This has 
the advantage that the parameters are retained and need not be entered again. For example, 
you can exchange normally open contacts and normally closed contacts or RS FlipFlop and 
SR FlipFlop.

Requirements 
A network with at least one LAD element is present.

Procedure
To replace an LAD element with another LAD element, follow these steps:

1. Select the LAD element that you want to replace.

2. Position the cursor over the triangle in the top right-hand corner of the LAD element.
A drop-down list is displayed.

3. From the drop-down list, select the LAD element that you want to use to replace the existing 
LAD element.

See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)
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Inserting additional inputs and outputs in LAD elements

Introduction   
You can expand LAD elements which execute commutative arithmetic instructions by adding 
additional inputs. Such elements are, for example, the instructions "Add" (ADD) and "Multiply" 
(MUL). You can expand the MOVE and DEMUX instruction boxes by adding additional outputs.

Requirement
An LAD element is available that permits the insertion of additional inputs and outputs.

Inserting an additional input
To add an additional input to the box of a LAD element, follow these steps:

1. Right-click on an existing input of the LAD element.

2. Select "Insert input" in the shortcut menu.
An additional input is added to the box of the LAD element.

Or:

1. Click on the yellow star symbol beside the last input in the instruction box.
An additional input is added to the box of the LAD element.

Inserting an additional output
To add an additional output to the box of a LAD element, follow these steps:

1. Right-click on an existing output of the LAD element.

2. Select "Insert output" from the shortcut menu.
An additional output is added to the box of the LAD element.

Or:

1. Click on the yellow star symbol beside the last input in the instruction box.
An additional output is added to the box of the LAD element.

See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)
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Removing inputs and outputs

Introduction   
Inputs and outputs which you have added to an instruction can be removed.

Requirement
An LAD element is available to which you have added additional inputs and outputs.

Remove input
To remove an input, follow these steps:

1. Select the input that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The input of the LAD element is removed.

Remove output
To remove an output, follow these steps:

1. Select the output that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The output of the LAD element will be removed.

 

See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Deleting LAD elements (Page 1547)

Enabling and disabling the EN/ENO mechanism
In LAD and FBD, certain instructions have an enable output ENO and thus use the EN/ENO 
mechanism. This allows you to query runtime errors in instructions and react to them. In order 
to increase the performance of the CPU, the EN/ENO mechanism is disabled in the default 
setting. This means that you are not initially able to react to runtime errors of the instruction 
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using the ENO value. However, you can enable the EN/ENO mechanism again at any time, if 
required.

You can enable the EN/ENO mechanism individually for each instruction in order to generate 
the ENO. If you enable the EN/ENO mechanism for an instruction, other instructions that you 
subsequently add to your program are also inserted with the EN/ENO mechanism enabled. 
You can disable the EN/ENO mechanism again at any time if you do not want to use the 
evaluation of ENO for an instruction. Further instructions that you subsequently add to your 
program will then be inserted without the EN/ENO mechanism.

See also: Basics of the EN/ENO mechanism (Page 1415) 

Activating the EN/ENO mechanism
Proceed as follows to activate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to activate the EN/ENO 
mechanism.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is again generated for the instruction. Other instructions are inserted with 
the enable output.

Deactivating the EN/ENO mechanism
Proceed as follows to deactivate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to deactivate the EN/ENO 
mechanism.

2. Select the "Do not generate ENO" command from the shortcut menu.
The ENO value is no longer generated for the instruction. Other instructions are inserted 
without enable output.

See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Deleting LAD elements (Page 1547)
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Deleting LAD elements

Requirement
An LAD element is available.

Procedure
To delete a LAD element, follow these steps:

1. Right-click the LAD element that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Selecting LAD elements (Page 1540)

Copying LAD elements (Page 1541)

Cutting LAD elements (Page 1542)

Pasting an LAD element from the clipboard (Page 1542)

Replacing LAD elements (Page 1543)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Enabling and disabling the EN/ENO mechanism (Page 1545)

Inserting operands into LAD instructions

Inserting operands
The character strings "<???>", "<??.?>" and "..." are inserted as placeholders for the 
parameters when an LAD element is inserted. The "<???>" and "<??.?>" strings displayed in 
red indicate parameters that need to be connected. The "..." string displayed in black indicates 
parameters that may be connected. "<??.?>" stands for Boolean placeholders.

 

 Note

If you position the cursor over the placeholder, the expected data type will be displayed.
 

Requirement   
An LAD element is available.
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Procedure
To connect the parameters of a LAD element, follow these steps:

1. Double-click the placeholder of the parameter.
An entry field opens, and the placeholder is selected.

2. Enter the appropriate parameter.
 

  Note

If you enter the absolute address of a parameter that has already been defined, this 
absolute address will be changed to the symbolic name of the parameter as soon as the 
input is confirmed. If you have not yet defined the parameter, a new tag with this absolute 
address and the default name "Tag_<n>" will be entered in the PLC tag table. When you 
confirm your input, the absolute address will be replaced with the symbolic name 
"Tag_<n>".

 

3. Confirm the parameter with the Enter key.

4. If you have not yet defined the parameter, you can define it directly in the program editor 
using the shortcut menu.
See also: 
Declaring PLC tags in the program editor (Page 1430)
Declaring local tags in the program editor (Page 1498)

Or drag from it the PLC tag table:

1. In the project tree, select the "PLC tags" folder or open the PLC tag table.

2. If you have opened the PLC tag table, drag the symbol from the first column of the desired 
tag to the appropriate place in your program. If you have not opened the PLC tag table yet, 
open the detail view now. Drag the desired tag from the detail view to the appropriate place 
in your program.

Or drag from it the block interface:

1. Open the block interface.

2. Drag the required operand from the block interface to the instruction window.

 

Result
● If the syntax is error-free, the displayed parameter is black. The editor then jumps to the 

next placeholder.

● If there is an error in the syntax, the cursor stays in the entry field and a corresponding error 
message is displayed in the status line. If you press the Enter key again, the entry field is 
closed and the faulty entry is displayed in red italics.
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Wiring hidden parameters

Introduction  
Depending on the CPU used, you can use complex instructions in your program that are 
dispatched with the TIA portal. These instructions can contain parameters that are declared 
as hidden. 

If an instruction contains hidden parameters, the instruction box has a small arrow on the lower 
edge. You can recognize hidden parameters by their white font. 

You can show and wire the hidden parameters at any time.

Showing or hiding hidden parameters
To show or hide hidden parameters, follow these steps:

1. Click on the down arrow at the bottom edge of the instruction box to show hidden 
parameters.

2. Click on the up arrow at the bottom edge of the instruction box to hide hidden parameters.

Wiring hidden parameters
To wire parameters, follow these steps:

1. Wire the hidden parameters like normally visible parameters.
The hidden parameter is transformed into a visible parameter.

See also
Using libraries (Page 441)

Displaying or hiding variable information

Introduction
You can display the following information about the tags to be used in the Program editor:

● Name of the tag

● Address of the tag

● Simple or hierarchical comments for tag documentation

The information is taken from the block interface for local tags and DB tags and from the PLC 
tag table for tags that are valid CPU-wide. 

You can display the tag information either for all the blocks or for individually opened blocks. 
If you display the tag information for all the blocks, the tag information for all the blocks currently 
opened and opened in future is shown.

You can hide the tag information at any time again. If you have hidden the tag information for 
all blocks, you can display it again for individual blocks that are open.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1549



When you select the display of tag information with hierarchical comments, the comments of 
the higher structure levels are also displayed for structured tags. The comments are shown in 
brackets after the tag comment; the comments of the individual levels are separated by a dot. 
If there is no comment for a tag on a structure level, it is not displayed. This is indicated by two 
successive dots.

Displaying or hiding tag information for all the blocks
Proceed as follows to display or hide the tag information for all the blocks:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. If you want to display the tag information, select the "Show" option or the "Tag information 
with hierarchical comments" option in the drop-down list, depending on whether you want 
to display simple or hierarchical comments.

4. If you want to hide the tag information, select the option "Collapse" in the "Tag information" 
drop-down list.
The tag information is displayed or hidden for all the blocks. When you open additional 
blocks, the tag information is displayed or hidden depending on the selected setting. 

Displaying or hiding tag information for an opened block
Proceed as follows to display or hide the tag information for an opened block:

1. If you want to display the tag information, select the "Show tag information" option or the 
"Tag information with hierarchical comments" option in the "Shows the tag information" 
drop-down list, depending on whether you want to display simple or hierarchical comments.

2. If you want to hide the tag information, select the option "Hide tag information" in the "Shows 
the tag information" drop-down list.
The tag information is displayed or hidden. 

Branches in LAD

Basic information on branches in LAD

Definition  
You use branches to program parallel circuits with the Ladder Logic (LAD) programming 
language. Branches are inserted in the main rung. You can insert several contacts into the 
branch and thus achieve a parallel circuit of series connections. This allows you to program 
complex ladder logic.

The figure below shows an example of the use of branches:
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MOTOR carries signal 1, if one of the following conditions is fulfilled:

● Signal 1 is pending on S2 or S4

● Signal 0 is pending on S5.

See also
Rules for branches in LAD (Page 1551)

Inserting branches into the LAD network (Page 1552)

Closing branches in the LAD network (Page 1552)

Deleting branches in LAD networks (Page 1553)

Rules for branches in LAD

Rules  
The following rules apply to simultaneous branches:

● A simultaneous branch can only be inserted if the main branch already contains an LAD 
element.

● Simultaneous branches are opened downwards or are connected directly to the power rail. 
They are terminated upwards.

● Simultaneous branches are opened after the selected LAD element.

● Simultaneous branches are terminated after the selected LAD element.

● To delete a simultaneous branch, you must delete all LAD elements of this branch. When 
the last LAD element is removed from the branch, the rest of the branch is also removed. 

See also
Basic information on branches in LAD (Page 1550)

Inserting branches into the LAD network (Page 1552)

Deleting branches in LAD networks (Page 1553)

Closing branches in the LAD network (Page 1552)
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Inserting branches into the LAD network
You can create several branches in a network.

Requirement  
● A network is available.

● The network contains elements.

Procedure
To insert a new branch in a network, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Open branches" in the "Simple instructions" palette.

3. Use drag-and-drop to move the element to the desired place in the network.
If you want to connect the new branch directly to the power rail, drag the element to the 
power rail. 

See also
Basic information on branches in LAD (Page 1550)

Rules for branches in LAD (Page 1551)

Deleting branches in LAD networks (Page 1553)

Closing branches in the LAD network
Branches must be closed again at suitable places. If necessary, branches will be arranged so 
that they do not cross each other.

Requirement
A branch is available.

Procedure
To close an open branch, follow these steps:

1. Select the open branch.

2. Press and hold down the left mouse button.
A dashed line will appear as soon as the cursor is moved. 

3. Drag the dashed line to a suitable place on the network. Permissible connections are 
indicated by green lines.

4. Release the left mouse button.
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See also
Basic information on branches in LAD (Page 1550)

Rules for branches in LAD (Page 1551)

Deleting branches in LAD networks

Requirement
A branch is available.

Procedure
To delete a branch, follow these steps:

1. Select the connection line that links the branch to the main branch.

2. Select the "Delete" command in the shortcut menu.

See also
Basic information on branches in LAD (Page 1550)

Rules for branches in LAD (Page 1551)

Inserting branches into the LAD network (Page 1552)

Crossings in LAD

Basic information on crossings in LAD

Definition
A crossing is a place in a LAD network where one branch is closed and at the same time 
another branch is opened.

"TagOut" receives signal 1, if the following two conditions are met:

● "TagIn_1" or "TagIn_3" has signal 1

● "TagIn_2" or "TagIn_4" has signal 0
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Inserting crossings
You can insert crossings in a LAD network by creating connections between the main branch 
and an additional branch or between different branches. 

Requirements  
A branch is available.

Procedure
To insert a new crossing in an LAD network, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Open branches" in the "Simple instructions" palette.

3. Drag the element behind the existing branch.

4. Insert any element into the open branch.

5. Click the arrow of the open branch after the inserted element.

6. Hold down the left mouse button and drag the dashed connecting line to the main branch.

7. Release the left mouse button.

See also
Rearranging crossings (Page 1554)

Deleting crossings (Page 1555)

Inserting branches into the LAD network (Page 1552)

Rearranging crossings

Requirement
A crossing is available.

Procedure
To rearrange a connection, follow these steps:

1. Select the connection line that defines the crossings in the respective branches.

2. Select the "Delete" command in the shortcut menu.

3. Open the "Instructions" task card.

4. Navigate to "General > Open branches" in the "Simple instructions" palette.

5. Use a drag-and-drop operation to move the element to the place in the network where you 
want to insert the new crossing.

6. Click on the arrow for the open branch.
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7. Hold down the left mouse button and drag the dashed connecting line to the subsidiary 
branch in which you wish to insert the new crossing.

8. Release the left mouse button.

 

See also
Inserting crossings (Page 1554)

Deleting crossings (Page 1555)

Deleting crossings

Requirement
A crossing is available.

Procedure
To delete a crossing, follow these steps:

1. Select the connection line that defines the crossings in the respective branches.

2. Select the "Delete" command in the shortcut menu.

See also
Inserting crossings (Page 1554)

Rearranging crossings (Page 1554)

Rungs in LAD

Basic information on rungs in LAD

Using rungs  
The program is mapped in one or more networks. A network contains a power rail on the left 
where one or more rungs originate. The binary signal scans are arranged in the form of contacts 
on the rungs. The serial arrangement of the elements on a rung creates a series connection; 
arrangement on simultaneous branches creates a parallel connection. A rung is closed by a 
coil or a box in which the result of logic operation will be written.

The figure below shows an example of the use of several rungs within a network:
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Rules
Remember the following rules when using several rungs:

● Connections are not permitted between rungs.

● Only one jump instruction is permissible per network. The positioning rules for jump 
instructions remain valid.

Running rungs
Rungs and networks are executed from top to bottom and from left to right. This means that 
the first instruction in the first rung of the first network is processed first. All instructions of this 
rung are then processed. After this come all other rungs of the first network. The next network 
is processed only after all rungs have first been run.

Differences between branches and rungs
The difference between branches and rungs is that the rungs are independent branches that 
can also stand in a different network. Branches, on the other hand, permit the programming 
of a parallel connection.

See also
Insert rung (Page 1556)

Deleting a rung (Page 1557)

Insert rung

Requirement
● A block is open.

● A network is available.
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Procedure  
To insert a new rung in a network, proceed as follows:

1. Insert any coil on the power rail.
A new rung will be inserted and the coil positioned at the end of the rung.

2. Insert additional instructions in the new rung.

See also
Basic information on rungs in LAD (Page 1555)

Deleting a rung (Page 1557)

Deleting a rung

Requirement
A rung is available.

Procedure   
To delete a rung, proceed as follows:

1. Hold down the left mouse button and draw a frame around the rung. At the same time, 
make sure that you select all instructions. Alternatively, you can hold down the <Shift> key 
and select the first the last instruction of the rung.

2. Right-click on one of the instructions in the rung.

3. Select the "Delete" command in the shortcut menu.

See also
Basic information on rungs in LAD (Page 1555)

Insert rung (Page 1556)

Creating FBD programs

Basic information on FBD

FBD programming language

Overview of the Function Block Diagram (FBD) programming language    
FBD is a graphical programming language. The representation is based on electronic circuit 
systems.
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The program is mapped in one or more networks. A network contains one or more logic 
operation paths. The binary signal scans are linked by boxes. The representation of the logic 
is based on the graphical logic symbols used in Boolean algebra.

Example of networks in FBD
The following figure shows an FBD network with AND and OR boxes and an assignment:

Overview of the FBD elements

FBD elements
An FBD program consists of separate elements that are linked by means of a binary signal 
flow. Most program elements must be supplied with tags. 

A FBD network is programmed from left to right.

For example, the following figure shows elements of an FBD network:

1) Binary function

2) Standard box

3) Complex box
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Binary functions
You can use binary functions to query binary operands and to combine their signal states. The 
following operations are examples of binary functions: "AND operation", "OR operation" and 
"EXCLUSIVE OR operation".

Standard boxes:
You can use standard boxes to control binary operands, perform RLO edge detection or 
execute jump functions in the program. Standard boxes generally have only one single input.

Complex boxes
Complex boxes represent program elements with complex functions. The empty box is an 
exception. You can use the empty box as a placeholder in which you can select the required 
instruction.

The following types of boxes are available to you in an FBD program:

● Complex boxes without EN/ENO mechanism:
A box is executed independently of the signal state at the box inputs. The error status of 
the processing cannot be queried.

● Complex boxes with EN/ENO mechanism:
A box is only executed if the enable input "EN" has the signal state "1". If the box is 
processed correctly, the "ENO" enable output has signal state "1". If an error occurs during 
processing, the "ENO" output is reset.
If the EN enable input is not interconnected, the box is always executed.

Calls of code block are also shown in the network as complex boxes with EN/ENO mechanism. 

 

Settings for FBD

Overview of the settings for FBD

Overview  
The following table shows the settings that you can make:

Group Setting Description
Font Font size Font size in program editor
View Layout Compact or wide

Changes the vertical spacing between 
operands and other objects (such as 
operand and contact). The change 
becomes visible once the block is 
reopened.

With absolute information Additional display of the absolute 
addresses
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Group Setting Description
Operand field Maximum width Maximum number of characters that 

can be entered horizontally in the 
operand field. This setting recalculates 
the layout of the networks.

Maximum height Maximum number of characters that 
can be entered vertically in the operand 
field. This setting recalculates the layout 
of the networks.

See also
Changing the settings (Page 1560)

Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the settings for FBD (Page 1559)

Working with networks

Using networks

Function 
The user program is created in the block within networks. For a code block to be programmed, 
it must contain at least one network. To achieve a better overview of the user program, you 
can also subdivide your program into several networks.
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See also
Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Inserting networks

Requirement 
A block is open.

Procedure
To insert a new network, follow these steps:

1. Select the network after which you want to insert a new network.

2. Select the "Insert network" command in the shortcut menu.

Result
A new empty network is inserted into the block. 

See also
Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Selecting networks

Requirements
A network is available.
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Selecting a network
To select a network, follow these steps:

1. Click the title bar of the network that you want to select.

Selecting several networks
Proceed as follows to select several individual networks:

1. Press and hold down the <Ctrl> key.

2. Click all the networks that you want to select.

To select several successive networks, follow these steps:

1. Press and hold down the <Shift> key.

2. Click the first network that you want to select.

3. Click the last network that you want to select.
The first and last networks and all those in between are selected. 

See also
Inserting networks (Page 1561)

Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Copying and pasting networks
Copied networks can be pasted within the block or in another block. Networks that were created 
in LAD or FBD can also be inserted in blocks of the respective other programming language.

Requirement     
A network is available.

Procedure
To copy and paste a network, follow these steps:

1. Select the network or networks to be copied.

2. Select "Copy" in the shortcut menu.

3. Select the network after which you want to paste in the copied network.

4. Select "Paste" in the shortcut menu.
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See also
Inserting networks (Page 1561)

Selecting networks (Page 1561)

Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Deleting networks

Requirement
A network is available.

Procedure
To delete a network, follow these steps:

1. Select the network that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Inserting networks (Page 1561)

Selecting networks (Page 1561)

Copying and pasting networks (Page 1562)

Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Expanding and collapsing networks

Requirements  
A network is available.

Opening and closing a network
To open a network, follow these steps:

1. Click on the right arrow in the network title bar.

To close a network, follow these steps:
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1. Click on the down arrow in the network title bar.

Opening and closing all networks
To open and close all networks, follow these steps:

1. In the toolbar, click "Open all networks" or "Close all networks".

See also
Inserting networks (Page 1561)

Selecting networks (Page 1561)

Copying and pasting networks (Page 1562)

Deleting networks (Page 1563)

Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Inserting network title
The network title is the header of a network. The length of the network title is limited to one 
line. You can enter the title manually or set it automatically. When you set it automatically, you 
can do this for individual networks or use the settings to specify that the network title is always 
set automatically. 

For automatic insertion of the network title, the comment of the operand in one of the following 
instructions in the network is evaluated:

● Assignment

● Set output

● Reset output

The instruction that is listed first in the network is used.

The network title is only inserted automatically when the following conditions are fulfilled:

● The network does not have a title yet.

● The operand of the instruction used for the comment has a comment.
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 Note

Note the following restrictions for automatic insertion of the network title:
● The network title is not adapted if you change the comment of the operand at a later time.
● The network title is not adapted if you change the operand of the instruction.
● The network title is only set by the writing instructions listed above.
● If the operand is of the data type array, the comment of the array is used and not the 

comments of the array elements.
● Comments of invalid operands are not taken into consideration.

 

Entering the network title manually
To enter a network title, follow these steps:

1. Click on the title bar of the network.

2. Enter the network title.

Setting the network title automatically
To specify that the network titles are always set automatically, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Select the "Set network title automatically" check box in the "Additional settings" group.
The network titles are set automatically as of this time if the conditions listed above are 
fulfilled.

To set an individual network title automatically, follow these steps:

1. Right-click "Network <Number of the network>" in the title bar of a network.

2. Select the "Set network title automatically" command in the shortcut menu.
The title of the selected network is set based on the comment of the operand if the conditions 
listed above are fulfilled.

See also
Using networks (Page 1560)

Inserting networks (Page 1561)

Selecting networks (Page 1561)

Copying and pasting networks (Page 1562)

Deleting networks (Page 1563)

Expanding and collapsing networks (Page 1563)
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Entering a network comment (Page 1566)

Navigating networks (Page 1566)

Entering a network comment
You can use network comments to provide comments on the program contents of individual 
networks. For example, you can indicate the function of the network or draw attention to special 
characteristics. 

Requirement  
A network is available.

Procedure
To enter a network comment, follow these steps:

1. Click on the right arrow before the network title.

2. If the comment area is not visible, click "Network comments on/off" in the toolbar.
The comment area is displayed.

3. Click "Comment" in the comment area.
The "Comment" text passage is selected.

4. Enter the network comment.

 

See also
Using networks (Page 1560)

Inserting networks (Page 1561)

Selecting networks (Page 1561)

Copying and pasting networks (Page 1562)

Deleting networks (Page 1563)

Expanding and collapsing networks (Page 1563)

Inserting network title (Page 1564)

Navigating networks (Page 1566)

Navigating networks
You can navigate straight to a specific position within a block.
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Procedure 
To navigate to a specific position within a block, follow these steps:

1. Right-click in the code area of the programming window.

2. Select the "Go to > Network/line" command in the shortcut menu.
The "Go to" dialog will open.

3. Enter the network to which you want to navigate.

4. Enter the line number of the network to which you want to navigate.

5. Confirm your entry with "OK".

Result
The relevant line will be displayed if this is possible. If the network or line requested does not 
exist, the last existing network or the last existing line in the network requested will be displayed. 

See also
Using networks (Page 1560)

Inserting networks (Page 1561)

Selecting networks (Page 1561)

Copying and pasting networks (Page 1562)

Deleting networks (Page 1563)

Expanding and collapsing networks (Page 1563)

Inserting network title (Page 1564)

Entering a network comment (Page 1566)

Inserting FBD elements

Rules for the use of FBD elements

Rules   
Note the following rules when inserting FBD elements:

● An FBD network can consist of several elements. All elements of a logic path must be linked 
to each other according to IEC 61131-3.

● Standard boxes (flip flops, counters, timers, math operations, etc.) can be added as output 
to boxes with binary logic operations (for example, AND, OR). Comparison boxes are 
excluded from this rule.

● Only Boolean inputs in an instruction can be combined with preceding logic operations.

● Only the bottom Boolean output in an instruction can be combined with an additional logic 
operation.
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● Enable input EN or enable output ENO can be connected to boxes, but this is not mandatory.

● Constants (for example, TRUE or FALSE) cannot be assigned to binary logic operations. 
Instead, use tags of the BOOL data type.

● Only one jump instruction can be inserted in each network.

● Only one jump label can be inserted in each network.

● Instructions for positive or negative RLO edge detection may not be arranged right at the 
left of the network as this requires a prior logic operation.

Placement rules for S7-1200/1500 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonics Name

SET_BF Set bit field No
RESET_BF Reset bit field No
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
JMP_LIST Define jump list No
SWITCH Jump distributor No
RET Return No

Placement rules for S7-300/400 CPUs
The following table sets out the instructions that can only be positioned at the end of the 
network:

Instruction Preceding logic operation 
requiredMnemonic

s
Name

S Set output Yes
R Reset output Yes
SP Start pulse timer Yes
SE Start extended pulse timer Yes
SD Start on-delay timer Yes
SS Start retentive on-delay timer Yes
SF Start off-delay timer Yes
SC Set counter value Yes
CU Count up Yes
CD Count down Yes
JMP Jump if RLO = 1 No
JMPN Jump if RLO = 0 Yes
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Instruction Preceding logic operation 
requiredMnemonic

s
Name

RET Return No
OPN Open global data block No
OPNI Open instance data block No
CALL Call block No
SAVE Save RLO in BR bit No
MCRA Enable MCR range No
MCRD Disable MCR range No
MCR< Open MCR ranges No
MCR> Close MCR ranges No

Inserting FBD elements using the "Instructions" task card

Requirement   
A network is available.

Procedure
To insert FBD elements into a network using the "Instructions" task card, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to the FBD element that you want to insert.

3. Use drag-and-drop to move the element to the desired place in the network.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.

Or:

1. Select the point in the network at which you want to insert the element.

2. Open the "Instructions" task card.

3. Double-click on the element you want to insert.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multiple instance", 
these are located in the block interface in the "Static" section.
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Result
The selected FBD element is inserted with dummy entries for the parameters. 

See also
Rules for the use of FBD elements (Page 1567)

Inserting FBD elements using an empty box

Requirement  
A network is available.

Procedure  
To insert FBD elements into a network using an empty box, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Empty box" in the "Basic instructions" palette.

3. Use a drag-and-drop operation to move the "Empty box" element to the desired place in 
the network.

4. Position the cursor over the triangle in the top right-hand corner of the empty box.
A drop-down list is displayed.

5. Select the desired FBD element from the drop-down list.
If the element is an internal system function block (FB), the "Call options" dialog opens. In 
this dialog you can create an instance data block of the single-instance or multiple-instance 
type for the function block in which the data of the inserted element will be saved. You will 
find the new instance data block created in the project tree in the "Program resources" 
folder under "Program blocks > System blocks". If you have selected "multi-instance", these 
are located in the block interface in the "Static" section.

Result
The empty box is changed to the respective FBD element. Placeholders are inserted for the 
parameters. 

Selecting the data type of an FBD element

Selecting a data type

Introduction
Some instructions can be executed with several different data types. If you use one of these 
instructions in the program, you have to specify a valid data type for the instruction at the 
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specific point in the program. For some instructions, you have to select the data types for the 
inputs and outputs separately. 

 

 Note

The valid data type (BOOL) for the tags on the enable input EN and the enable output ENO 
is predefined by the system and cannot be changed. 

 

The valid data types for an instruction are listed in the instruction drop-down list. You specify 
the data type of the instruction by selecting an entry from the drop-down list. If the data type 
of an operand differs from the data type of the instruction and cannot be converted implicitly, 
the operand is displayed in red and a rollout with the corresponding error message appears. 

Data type selection of mathematical instructions
Some mathematical instructions provide you with the option of having the data type 
automatically set corresponding to the data types of the operand. In the drop-down list for data 
type selection, these instructions have the entry "Auto" in addition to the actual data types. If 
you select this entry and then allocate the first operand, the data type of the operand is selected 
as data type for the instruction. The entry in the drop-down list changes to "Auto (<Data type>)", 
e.g. "Auto (Real)". If you allocate additional operands, the automatically set data type of the 
instruction is adjusted according to the following criteria:

● You supply all other operands with tags of the same data type: 
The data type of the instruction is not changed.

● You supply all other operands with tags whose data type is smaller than the data type of 
the instruction: 
The data type of the instruction is not changed. For the operand with the smaller data type, 
an implicit conversion is conducted if necessary.

● You supply an additional operand with a tag whose data type is greater than the data type 
of the instruction:
The data type of the instruction is changed to the larger data type. An implicit conversion 
is performed, if necessary, for operands that deviate from the newly set data type of the 
instruction.

Each change in the data type of an operand can result in a change of the data type of the 
instruction. Other operands may possibly be implicitly converted as a result. Operands for 
which an implicit conversion is performed are marked with a gray square.

 

 Note

Please also observe the information on data type conversion for your device and, in particular, 
the notes on the IEC check. 

See also: Data type conversion
 

See also
Defining the data type of an instruction (Page 1572)
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Defining the data type of an instruction

Introduction
Some instructions can be executed with several different data types. When you insert such 
instructions into your program, you must specify the data type for these instructions at the 
actual point in the program. 

Specifying the data type by means of the drop-down list
To define the data type of an instruction using the drop-down list, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Click the triangle in the upper corner of the drop-down list.
The drop-down list will open to display the data types valid for the instruction.

3. Select a data type from the drop-down list.
The selected data type is displayed.

4. If the instruction has two drop-down lists, select the data type for the instruction inputs in 
the left-hand drop-down list and the data type for the instruction outputs in the right-hand 
drop-down list.

Specifying data type by assigning tags
To define the data type of an instruction by assigning tags, follow these steps:

1. Insert the instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. At an input or output, specify a valid tag, the data type of which is to be applied as the 
instruction data type.
The data type of the tag is displayed in the drop-down list.

3. Enter a valid tag at an input and a valid tag at an output if data types need to be defined 
for both the inputs and outputs of the instruction. The tag specified at the input determines 
the data type of the inputs; the tag specified at the output determines the data type of the 
outputs of the instruction.

Automatically specifying the data type of mathematical instructions
To automatically specify the data type for mathematical instructions, follow these steps:

1. Insert the mathematical instruction at the required point in the program using drag-and-drop.
The entry "???" (undefined) is displayed in the drop-down list of the inserted instruction.

2. Select the "Auto" entry from the drop-down list.

3. Enter a valid tag at an input or output. 
The data type of the tag is applied as data type of the instruction. The entry in the drop-
down list changes to "Auto (<Data type>)".

See also: Selecting a data type (Page 1570)
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See also
Selecting a data type (Page 1570)

Using favorites in FBD

Adding FBD elements to Favorites

Requirement  
● A block is open.

● The multipane mode is set for the "Instructions" task card or the Favorites are also displayed 
in the editor.

Procedure
To add SCL instructions to the Favorites, follow these steps:

1. Open the "Instructions" task card.

2. Maximize the "Basic instructions" pane.

3. Navigate in the "Basic instructions" pane to the instruction that you want to add to the 
Favorites.

4. Drag-and-drop the instruction into the "Favorites" pane or into the Favorites area in the 
program editor.

 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Removing FBD elements from Favorites (Page 1574)

Overview of the program editor (Page 1470)

Inserting FBD elements using favorites

Requirement  
● A block is open.

● Favorites are available.
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Procedure
To insert an instruction into a program using Favorites, follow these steps:

1. Drag-and-drop the desired instruction from Favorites to the desired position.

Or:

1. Select the position in the program where you want to insert the instruction.

2. In the Favorites, click on the instruction you want to insert.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

See also
Overview of the program editor (Page 1470)

Removing FBD elements from Favorites (Page 1574)

Removing FBD elements from Favorites

Requirement
A code block is open. 

Procedure
To remove instructions from Favorites, follow these steps:

1. Right-click on the instruction you want to remove.

2. Select the "Remove instruction" command in the shortcut menu.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Adding FBD elements to Favorites (Page 1573)

Inserting FBD elements using favorites (Page 1573)

Overview of the program editor (Page 1470)
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Inserting block calls in FBD

Inserting block calls using a drag-and-drop operation
You can insert calls for existing functions (FC) and function blocks (FB) using a drag-and-drop 
operation from the project tree. If you call function blocks from other function blocks, you can 
either call them as single-instance or multi-instance blocks. If a function block is called as single 
instance, it will store its data in a data block of its own. If a function block is called as multi-
instance, it will store its data in the instance data block of the calling function block.

Requirement    
● A network is available.

● The block that is to be called is available.

Inserting a call of a function (FC)
To insert a call of a function (FC) into a network using a drag-and-drop operation, follow these 
steps:

1. Drag the function from the project tree to the required network.

Inserting a call for a function block (FB)
To insert a call for a function block (FB), follow these steps:

1. Drag the function block from the project tree to the required network.
The "Call options" dialog opens.

2. Enter in the dialog whether you wish to call the block as single or multi-instance.

– If you click on the "Single instance" button, you will have to enter a name in the "Name" 
text box for the data block that you want to assign to the function block.

– If you click on the "Multi-instance" button, you will have to enter the name of the tag in 
the "Name in the interface" text box; this is the name that you use to enter the called 
function block as a static tag in the interface of the calling block.

3. Confirm your entries with "OK".

Result
The function or the function block is inserted with its parameters. You can then assign the 
parameters. 

See also: Auto-Hotspot 
 

 Note

If when calling a function block you specify an instance data block that does not exist, it will 
be created. If you have called a function block as a multi-instance, this will be entered as a 
static tag in the interface.
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See also
Updating block calls in FBD (Page 1576)

Changing the instance type (Page 1577)

Single instances (Page 1275)

Multi-instances (Page 1275)

Updating block calls in FBD
If interface parameters of a called block are changed, the block call can no longer be executed 
correctly. You can avoid such inconsistent block calls by updating the block calls.

You have two options to update the block calls:

● Explicit updating in the program editor.
The block calls in the open block will be updated. 

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types will be updated.

Update blocks in the program editor  
To update a block call within a block, follow these steps:

1. Open the block in the program editor.

2. Click "Update inconsistent block calls" in the toolbar.

Or:

1. Open the block in the program editor.

2. Right-click on the instruction with the block call.

3. Select the "Update" command in the shortcut menu.
The "Interface update" dialog opens. This dialog shows the differences between the block 
interface in use and the changed interface of the called block.

4. If you want to update the block call, click "OK". To cancel the update, click "Cancel".

Update block calls during compilation
Follow these steps to update all block calls and uses of PLC data types during compilation 
implicitly:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.
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See also
Inserting block calls using a drag-and-drop operation (Page 1575)

Changing the instance type (Page 1577)

Changing the instance type

Instance type
There are two ways of calling function blocks:

● As a single instance

● As a multiple instance

See also: Auto-Hotspot 

You can modify a defined instance type at any time.

Requirement       
The user program contains a block call.

Procedure
To change the instance type of a function block, follow these steps:

1. Open the code block and select the block call.

2. Select the "Change instance" command in the shortcut menu.
The "Call options" dialog opens.

3. Click the "Single instance" or "Multi instance" button.

– If you select the "Single instance" instance type, enter a name for the data block that is 
to be assigned to the function block.

– If you select "Multiple instance" as the instance type, enter in the "Name in the interface" 
text field the name of the tag with which the called function block is to be entered as a 
static tag in the interface of the calling block.

4. Confirm your entries with "OK".
 

 Note

The previous single and multiple instances will not be deleted automatically.
 

See also
Inserting block calls using a drag-and-drop operation (Page 1575)

Updating block calls in FBD (Page 1576)
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Inserting complex FBD instructions

Using the "Calculate" instruction

Requirement    
A network is available.

Procedure
Proceed as follows to use the "Calculate" instruction:

1. Open the "Instructions" task card.

2. Navigate to "Math functions > CALCULATE" in the "Basic instructions" pane.

3. Use drag-and-drop to move the element to the desired place in the network.
The instruction "Calculate" will be inserted for the data type with a placeholder expression 
and question mark.

4. Enter the data type for the calculation.

5. Enter the operands for the calculation.
 

  Note

The calculation is run with the inputs of the "Calculate" instruction. If you want to use 
constants you must also insert appropriate inputs for them.

 

6. Click on the "Edit 'Calculate' instruction" button to replace the placeholder expression with 
the correct expression.
The "Edit 'Calculate' instruction" dialog will open.

7. Enter the required expression in the "OUT:= " text box.
 

  Note

In the "Example" area you can find an example of a valid expression and possible 
instructions that you can use. 

To determine a value with the help of Pythagoras' theorem, for example, enter "OUT := 
SQRT (SQR (IN1) + SQR (IN2))".

 

8. Confirm your entry with "OK".

See also
CALCULATE: Calculate (Page 2239)

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1578 System Manual, 02/2014



Using free-form comments

Basic information on using free comments in FBD 

Introduction   
Free-form comments allow you to add comments to the source code for graphic programming 
languages similar to line comments for textual languages.

Free-form comments can be used for all non-binary boxes.

See also
Inserting free-form comments (Page 1579)

Editing free-form comments (Page 1580)

Deleting free-form comments (Page 1581)

Inserting free-form comments

Requirement
A network with instructions is available.

Procedure  
To insert a free comment on an instruction, proceed as follows:

1. If necessary, activate the "Free-form comments on/off" button in the toolbar.

2. Right-click on the instruction for which you want to insert a free-form comment.

3. Select the "Insert comment" command in the shortcut menu.
A comment box with a standard comment opens. The comment box is connected by an 
arrow to the corresponding instruction.

4. Enter the required comment in the comment box.

See also
Basic information on using free comments in FBD  (Page 1579)

Editing free-form comments (Page 1580)

Deleting free-form comments (Page 1581)
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Editing free-form comments

Introduction  
Free-form comments can be edited as follows:

● Changing the comment text

● Changing the position and size of the comment box

● Attaching a comment to another element

● Showing and hiding free comments

Changing the comment text
To change the text of free-form comments, follow these steps:

1. Click on the comment box.

2. Enter the desired text.

Changing the position of the comment box
To change the positioning of the comment box, follow the steps below:

1. Left-click the comment box and keep the mouse button pressed.

2. Drag the comment box to the desired location.

Changing the size of the comment box
To change the size of the comment box, follow the steps below:

1. Click on the comment box.

2. Drag the comment box on the move handle in the lower right corner to the desired size.

Attaching a comment to another element
To attach a free-form comment to another element, follow these steps:

1. Left-click the point of the arrow that links the comment box with the instruction and keep 
the mouse button pressed.

2. Drag the arrow to the element to which you want to attach the comment. Possible insertion 
points are marked with a green square.

3. Release the mouse button.
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Showing and hiding free comments
To show or hide a free-form comments, follow these steps:

1. Click the "Free-form comment on/off" button in the toolbar.

See also
Basic information on using free comments in FBD  (Page 1579)

Inserting free-form comments (Page 1579)

Deleting free-form comments (Page 1581)

Deleting free-form comments

Procedure  
To delete a free-form comment, proceed as follows:

1. Right-click on the free-form comment that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Basic information on using free comments in FBD  (Page 1579)

Inserting free-form comments (Page 1579)

Editing free-form comments (Page 1580)

Editing FBD elements

Selecting FBD elements
You can select several individual elements or all elements in a network.

Requirement  
FBD elements are available

Selecting several individual FBD elements
To select several individual FBD elements, follow these steps:

1. Press and hold down the <Ctrl> key.

2. Click on all the FBD elements you wish to select.

3. Now release the <Ctrl> key.
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Selecting all FBD elements in a network
To select all FBD elements in a network, follow these steps:

1. Go to the network whose elements you wish to select.

2. Select the "Select all" command in the "Edit" menu or press <Ctrl+A>.

See also
Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Copying FBD elements

Requirement 
An FBD element is available.

Procedure
To copy an FBD element, follow these steps:

1. Right-click the FBD element that you want to copy.

2. Select "Copy" in the shortcut menu.

Result
The FBD element will be copied and saved to the clipboard.

See also
Selecting FBD elements (Page 1581)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)
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Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Cutting FBD elements

Requirement 
An FBD element is available.

Cutting
To cut an FBD element, follow these steps:

1. Right-click the FBD element that you want to cut.

2. Select "Cut" in the shortcut menu.

Result
The FBD element will be cut and saved to the clipboard.

See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Pasting an FBD element from the clipboard

Requirement
An FBD element is available.
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Procedure
To paste an FBD element from the clipboard, follow these steps:

1. Copy an FBD element or cut an FBD element.

2. Right-click the point in the network where you want to paste the element.

3. Select "Paste" in the shortcut menu.

See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Replacing FBD elements 
You can easily exchange FBD elements with other FBD elements of the same type. This has 
the advantage that the parameters are retained and need not be entered again. For example, 
you can exchange OR and AND, RS-FlipFlop and SR-FlipFlop, comparison functions or jump 
instructions.

Requirements 
A network with at least one FBD element is present.

Procedure
To replace an FBD element with another FBD element, follow these steps:

1. Select the FBD element that you want to replace.
If elements compatible with the selected FBD element are available, a triangle will appear 
in the upper right-hand corner of the element.

2. Position the cursor above the triangle of the FBD element.
A drop-down list is displayed.

3. From the drop-down list, select the FBD element that you want to use to replace the existing 
FBD element.

 

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1584 System Manual, 02/2014



See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Adding additional inputs and outputs to FBD elements

Introduction   
You can expand several FBD elements with additional inputs that execute arithmetic or binary 
operations. Such elements are, for example, the instructions "Add" (ADD), "Multiply" (MUL), 
AND or OR. You can expand the "MOVE value" (MOVE) and "Demultiplex" (DEMUX) 
instruction boxes by adding additional outputs.

The name of the new inputs and outputs is comprised of the type of inserted element and a 
consecutive number. The name of a new input is may be "IN2"; the name of a new output may 
be "OUT2".

Requirements
An FBD element is available that permits the insertion of additional inputs and outputs.

Inserting an additional input
To add an additional input to the box of an FBD element, follow these steps:

1. Right-click on an existing input of the FBD element.

2. Select "Insert input" in the shortcut menu.
An additional input is added to the box of the FBD element.

Or:

1. Click on the yellow star symbol beside the last input in the instruction box.
An additional input is added to the box of the FBD element.

Inserting an additional output
To add an additional output to the box of an FBD element, follow these steps:

1. Right-click on an existing output of the FBD element.

2. Select "Insert output" from the shortcut menu.
An additional output is added to the box of the FBD element.
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Or:

1. Click on the yellow star symbol beside the last output of the instruction box.
An additional output is added to the box of the FBD element.

See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Removing instruction inputs and outputs (Page 1586)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Removing instruction inputs and outputs

Introduction  
Inputs and outputs which you have added to an instruction can be removed.

Requirement
An FBD element is available, which you have expanded with additional inputs or outputs.

Remove input
To remove an input, follow these steps:

1. Select the input that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The input of the FBD element is removed.

Remove output
To remove an output, follow these steps:

1. Select the output that you want to remove.

2. Select the "Delete" command in the shortcut menu.
The output of the FBD element will be removed.
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See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Deleting FBD elements (Page 1588)

Enabling and disabling the EN/ENO mechanism
In LAD and FBD, certain instructions have an enable output ENO and thus use the EN/ENO 
mechanism. This allows you to query runtime errors in instructions and react to them. In order 
to increase the performance of the CPU, the EN/ENO mechanism is disabled in the default 
setting. This means that you are not initially able to react to runtime errors of the instruction 
using the ENO value. However, you can enable the EN/ENO mechanism again at any time, if 
required.

You can enable the EN/ENO mechanism individually for each instruction in order to generate 
the ENO. If you enable the EN/ENO mechanism for an instruction, other instructions that you 
subsequently add to your program are also inserted with the EN/ENO mechanism enabled. 
You can disable the EN/ENO mechanism again at any time if you do not want to use the 
evaluation of ENO for an instruction. Further instructions that you subsequently add to your 
program will then be inserted without the EN/ENO mechanism.

See also: Basics of the EN/ENO mechanism (Page 1415) 

Activating the EN/ENO mechanism
Proceed as follows to activate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to activate the EN/ENO 
mechanism.

2. Select the "Generate ENO" command from the shortcut menu.
The ENO value is again generated for the instruction. Other instructions are inserted with 
the enable output.

Deactivating the EN/ENO mechanism
Proceed as follows to deactivate the EN/ENO mechanism of an instruction:

1. In your program, right-click the instruction at which you want to deactivate the EN/ENO 
mechanism.

2. Select the "Do not generate ENO" command from the shortcut menu.
The ENO value is no longer generated for the instruction. Other instructions are inserted 
without enable output.
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See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Deleting FBD elements (Page 1588)

Deleting FBD elements

Requirement
An FBD element is available.

Procedure
To delete an FBD element, follow these steps:

1. Right-click the FBD element that you want to delete.

2. Select the "Delete" command in the shortcut menu.

See also
Selecting FBD elements (Page 1581)

Copying FBD elements (Page 1582)

Cutting FBD elements (Page 1583)

Pasting an FBD element from the clipboard (Page 1583)

Replacing FBD elements  (Page 1584)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Enabling and disabling the EN/ENO mechanism (Page 1587)

Inserting operands in FBD instructions

Inserting operands
The character strings "<???>", "<??.?>" and "..." are inserted as placeholders for the 
parameters when a FBD element is inserted. The "<???>" and "<??.?>" strings displayed in 
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red indicate parameters that need to be connected. The "..." string displayed in black indicates 
parameters that may be connected. "<??.?>" stands for Boolean placeholders.

 

 Note

To display the available data types in a tooltip, move the cursor over the placeholder.
 

Requirement   
An FBD element is available.

Procedure
To connect the parameters of an FBD element, follow these steps:

1. Click the placeholder of the parameter.
An input field is opened.

2. Enter the corresponding parameters, for example a PLC tag, a local tag or a constant.
 

  Note

If you enter the absolute address of a parameter that has already been defined, this 
absolute address will be changed to the symbolic name of the parameter as soon as the 
input is confirmed. If you have not yet defined the parameter, a new tag with this absolute 
address and the default name "Tag_1" will be entered in the PLC tag table. When you 
confirm your input, the absolute address will be replaced with the symbolic name "Tag_1".

 

3. Confirm the parameter with the Enter key.

4. If you have not yet defined the parameter, you can define it directly in the program editor 
using the shortcut menu.
See also: "Declaring PLC tags in the program editor (Page 1430)".

Or drag from it the PLC tag table:

1. In the project tree, select the "PLC tags" folder and open the PLC tag table.

2. If you have opened the PLC tag table, drag the desired tag to the corresponding location 
in your program. If you have not opened the PLC tag table yet, open the detail view now. 
Drag the desired tag from the detail view to the appropriate place in your program.

Or drag from it the block interface:

1. Open the block interface.

2. Drag the desired operand from the block interface to the corresponding location in your 
program.
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Result
● If the syntax is error-free, the displayed parameter is black.

● If there is an error in the syntax, the cursor stays in the input field and a corresponding error 
message is displayed in the inspector window in the "Info > Syntax" register.

Wiring hidden parameters

Introduction  
Depending on the CPU used, you can use complex instructions in your program that are 
dispatched with the TIA portal. These instructions can contain parameters that are declared 
as hidden. 

If an instruction contains hidden parameters, the instruction box has a small arrow on the lower 
edge. You can recognize hidden parameters by their white font. 

You can show and wire the hidden parameters at any time.

Showing or hiding hidden parameters
To show or hide hidden parameters, follow these steps:

1. Click on the down arrow at the bottom edge of the instruction box to show hidden 
parameters.

2. Click on the up arrow at the bottom edge of the instruction box to hide hidden parameters.

Wiring hidden parameters
To wire parameters, follow these steps:

1. Wire the hidden parameters like normally visible parameters.
The hidden parameter is transformed into a visible parameter.

See also
Using libraries (Page 441)

Displaying or hiding variable information

Introduction
You can display the following information about the tags to be used in the Program editor:

● Name of the tag

● Address of the tag

● Simple or hierarchical comments for tag documentation
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The information is taken from the block interface for local tags and DB tags and from the PLC 
tag table for tags that are valid CPU-wide. 

You can display the tag information either for all the blocks or for individually opened blocks. 
If you display the tag information for all the blocks, the tag information for all the blocks currently 
opened and opened in future is shown.

You can hide the tag information at any time again. If you have hidden the tag information for 
all blocks, you can display it again for individual blocks that are open.

When you select the display of tag information with hierarchical comments, the comments of 
the higher structure levels are also displayed for structured tags. The comments are shown in 
brackets after the tag comment; the comments of the individual levels are separated by a dot. 
If there is no comment for a tag on a structure level, it is not displayed. This is indicated by two 
successive dots.

Displaying or hiding tag information for all the blocks
Proceed as follows to display or hide the tag information for all the blocks:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. If you want to display the tag information, select the "Show" option or the "Tag information 
with hierarchical comments" option in the drop-down list, depending on whether you want 
to display simple or hierarchical comments.

4. If you want to hide the tag information, select the option "Collapse" in the "Tag information" 
drop-down list.
The tag information is displayed or hidden for all the blocks. When you open additional 
blocks, the tag information is displayed or hidden depending on the selected setting. 

Displaying or hiding tag information for an opened block
Proceed as follows to display or hide the tag information for an opened block:

1. If you want to display the tag information, select the "Show tag information" option or the 
"Tag information with hierarchical comments" option in the "Shows the tag information" 
drop-down list, depending on whether you want to display simple or hierarchical comments.

2. If you want to hide the tag information, select the option "Hide tag information" in the "Shows 
the tag information" drop-down list.
The tag information is displayed or hidden. 
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Branches in FBD

Basic information on branches in FBD

Definition
You can use the Function Block Diagram (FBD) programming language to program parallel 
branches. This is done using branches that are inserted between the boxes. You can insert 
additional boxes within the branch and in this way build up complex function block diagrams.

The figure below shows an example of the use of branches:

See also
Rules for branches in FBD (Page 1592)

Inserting branches in FBD networks  (Page 1593)

Deleting branches in FBD networks  (Page 1593)

Rules for branches in FBD

Rules  
The following rules apply to the use of branches in FBD:

● Branches are opened downward.

● Branches can be inserted only between FBD elements.

● To delete a branch, you must delete all FBD elements, including the branch itself.

● If you delete the connection between two branches, the FBD elements of the interrupted 
branch will be positioned freely in the network.

See also
Basic information on branches in FBD (Page 1592)

Inserting branches in FBD networks  (Page 1593)

Deleting branches in FBD networks  (Page 1593)
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Inserting branches in FBD networks 

Requirement  
A network is available.

Procedure
To insert a new branch in a network, follow these steps:

1. Open the "Instructions" task card.

2. Navigate to "General > Branch" in the "Basic instructions" palette.

3. Drag the element from the "Elements" pane to the a required location on a connection line 
between two boxes.

See also
Rules for branches in FBD (Page 1592)

Basic information on branches in FBD (Page 1592)

Deleting branches in FBD networks  (Page 1593)

Deleting branches in FBD networks 

Requirement
A branch is available.

Procedure
To delete a branch, follow these steps:

1. Select the connection line that links the branch to the main branch.

2. Select the "Delete" command in the shortcut menu.

Result
The branch is now deleted. Boxes connected to the deleted branch are placed freely within 
the network. 

See also
Rules for branches in FBD (Page 1592)

Basic information on branches in FBD (Page 1592)

Inserting branches in FBD networks  (Page 1593)
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Logic paths in FBD

Basic information on logic paths in FBD

Use of logic paths  
The user program will be mapped in one or more networks. The networks can contain one or 
more logic paths on which the binary signals are arranged in the form of boxes. 

The following figure shows an example of the use of several logic paths within a network:

Rules
Remember the following rules when using logic paths:

● Connections are not permitted between logic paths.

● Only one jump instruction is permissible per network. The positioning rules for jump 
instructions remain valid.

Executing logic paths
Logic paths are executed from top to bottom and from left to right. This means that the first 
instruction in the first logic path of the first network is executed first. All instructions of this logic 
path are then executed. After this come all other logic paths of the first network. The next 
network is executed only after all logic paths have first been executed. 

When jumps are used the regular execution of the logic paths is circumvented and the 
instruction is executed at the jump destination.

Differences between branches and logic paths
The difference between branches and logic paths is that the logic paths are independent 
branches that can also stand in a different network. Branches, on the other hand, permit the 
programming of a parallel connection and have a common preceding logic operation.

See also
Inserting a logic path (Page 1595)

Deleting a logic operation path (Page 1595)
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Inserting a logic path

Requirement
● A block is open.

● A network is available.

Procedure  
To insert a new logic path in a network, follow these steps:

1. Insert any instruction in a network in such a way that it has no connection to existing 
instructions.
A new logic path is inserted.

2. Insert an assignment at the end of the new logic path.

3. Insert additional instructions in the new logic path.

 

See also
Basic information on logic paths in FBD (Page 1594)

Deleting a logic operation path (Page 1595)

Deleting a logic operation path

Requirement
A logic path is available.

Procedure   
To delete a logic path, proceed as follows:

1. Hold down the left mouse button and draw a frame around the logic path. At the same time, 
make sure that you select all instructions of the logic path. Alternatively, you can hold down 
the <Shift> key and select the first the last instruction of the logic path.

2. Right-click on one of the instructions in the logic path.

3. Select the "Delete" command in the shortcut menu.

See also
Basic information on logic paths in FBD (Page 1594)

Inserting a logic path (Page 1595)
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Creating SCL programs

Basics of SCL

Programming language SCL

Programming language SCL  
SCL (Structured Control Language) is a high-level programming language based on PASCAL. 
The language is based on DIN EN 61131-3 (international IEC 1131-3).

The standard standardizes programming languages for programmable logic controllers. The 
SCL programming language fulfills the PLCopen Basis Level of ST language (Structured Text) 
defined in this standard. 

Language elements
SCL also contains higher programming languages in addition to the typical elements of the 
PLC, such as inputs, outputs, timers or memory bits.

● Expressions

● Value assignments

● Operators

Program control
SCL provides convenient instructions for controlling the program allowing you, for example, to 
create program branches, loops or jumps.

Application 
SCL is therefore particularly suitable for the following areas of application: 

● Data management

● Process optimization

● Recipe management

● Mathematical / statistical tasks

Expressions

Description  
Expressions are calculated during the runtime of the program and return a value. An expression 
consists of operands (such as constants, tags or function calls) and optionally out of operators 
(such as *, /, + or -). Expressions can be linked together or nested within each other by 
operators. 
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Evaluation order
The evaluation of the expression occurs in a specific order that is defined by the following 
factors:

● Priority of the operators involved

● Left-to-right order

● Brackets

Types of expressions
The following expression types are available depending on the operator:

● Arithmetic expressions
Arithmetic expressions consist of either a numerical value or combine two values or 
expressions with arithmetic operators.

● Relational expressions
Relational expressions compare the values of two operands and yield a Boolean value. 
The result is TRUE if the comparison is true, and FALSE if it is not met.

● Logical expressions
Logical expressions combine two operands with logical operators (AND, OR, XOR) or 
negating operands (NOT).

How expressions are used
You can use the result of an expression in different ways:

● As a value assignment for a tag

● As as a condition for a control instruction

● As a parameter for a calling a block or instruction

See also
Operators and operator precedence (Page 1602)

Arithmetic expressions (Page 1597)

Relational expressions (Page 1600)

Logical expressions (Page 1601)

Arithmetic expressions

Description
Arithmetic expressions consist of either a numerical value or combine two values or 
expressions with arithmetic operators. 

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1597



Arithmetic operators can process the data types that are allowed in the CPU in use. If two 
operands are involved in the operation, the data type of the result is determined based on the 
following criteria:

● If both operands are integers with sign and have different lengths, the result receives the 
data type of the longer integer (e. g. INT + DINT = DINT).

● If both operands are integers without sign and have different lengths, the result receives 
the data type of the longer integer (e. g. USINT + UDINT = UDINT).

● If one operand is an integer with sign and the other integer is an operand without sign, the 
result receives the next larger data type with sign that covers the integer without sign (e. 
g. SINT + USINT = INT).
You can only execute an operation with such operands if the IEC check is not set.

● If one operand is an integer and the other operand is a floating-point number, the result 
receives the data type of the floating-point number (e. g. INT + REAL = REAL).

● If both operands are floating-point numbers and have different lengths, the result receives 
the data type of the longer floating-point number (e. g. REAL + LREAL = LREAL).

● The data type of the result of an operation that involves operands of the data type groups 
"Times" and "Date and time" can be found in the table in section "Data types of arithmetic 
expressions".
You cannot use data types of the data type groups "Times" and "Date and time" when the 
IEC check is set.

Data types of arithmetic expressions
The following table shows the data types you can use in arithmetic expressions:

Operation Operator 1st Operand 2nd Operand Result
Power ** Integer/floating-point 

number
Integer/floating-point 
number

Integer/floating-point 
number

Unary plus + Integer/floating-point 
number
TIME, LTIME

- Integer/floating-point 
number
TIME, LTIME

Unary minus - Integer/floating-point 
number
TIME, LTIME

- Integer/floating-point 
number
TIME, LTIME

Multiplication * Integer/floating-point 
number

Integer/floating-point 
number

Integer/floating-point 
number

TIME, LTIME Integer TIME, LTIME
Division / Integer/floating-point 

number
Integer/floating-point 
number (not equal 0)

Integer/floating-point 
number

TIME, LTIME Integer TIME, LTIME
Modulo 
function

MOD Integer Integer Integer

Addition + Integer/floating-point 
number

Integer/floating-point 
number

Integer/floating-point 
number

TIME TIME TIME
TIME DINT TIME
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Operation Operator 1st Operand 2nd Operand Result
LTIME TIME, LTIME LTIME
LTIME LINT LTIME
TOD TIME TOD
TOD DINT TOD
LTOD TIME, LTIME LTOD
LTOD LINT LTOD
DATE LTOD DTL
DATE TOD ● S7-300/400: DT

● S7-1200/1500: 
DTL

DT TIME DT
LDT TIME, LTIME LDT
DTL TIME, LTIME DTL

Subtraction - Integer/floating-point 
number

Integer/floating-point 
number

Integer/floating-point 
number

TIME TIME TIME
TIME DINT TIME
LTIME 1) TIME, LTIME LTIME
LTIME LINT LTIME
TOD TIME TOD
 DINT TOD
LTOD TIME, LTIME LTOD
LTOD LINT LTOD
DATE DATE ● S7-300/400/1200: 

TIME
● S7-1500: LTIME

DT TIME DT
LDT TIME, LTIME LDT
DTL TIME, LTIME DTL
DTL DTL ● S7-1200: TIME

● S7-1500: LTIME
1) Combinations between nanoseconds and milliseconds are not possible within expressions.

For additional information on valid data types, refer to "See also".

Example
The following example shows an arithmetic expression:

SCL
"MyTag1":= "MyTag2" * "MyTag3";
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See also
Expressions (Page 1596)

Operators and operator precedence (Page 1602)

Relational expressions

Description   
Relational expressions compare the values of two operands and yield a Boolean value. The 
result is TRUE if the comparison is true, and FALSE if it is not met.

Relational operators can process the data types that are allowed in the CPU in use. The data 
type of the result always is BOOL.

Note the following rules when forming relational expressions: 

● All tags are comparable within the following data type groups:

– Integers/floating-point numbers

– Binary numbers

– String

● With the following data types/data groups, only tags of the same type can be compared:

– TIME, LTIME

– Date and time

● The comparison of strings is based on the ASCII character set. The length of the tags and 
the numerical value of each ASCII character are used for the comparison.

● S5TIME tags are not permitted as comparison operands. An explicit conversion from 
S5TIME to TIME or LTIME is necessary.

Data types of relational expressions
The following table shows the data types/data type groups you can use in relational 
expressions:

Operation Operator 1st Operand 2nd Operand Result
Compare for 
equal, not equal

=, <> Integer/floating-
point number

Integer/floating-
point number

BOOL

Binary number Binary number BOOL
String String BOOL
TIME, LTIME TIME, LTIME BOOL
Date and time Date and time BOOL

Compare for less 
than, less than-
equal to, greater 
than, greater than 
or equal to

<, <=, >, >= Integer/floating-
point number

Integer/floating-
point number

BOOL

Bit strings 
(S7-1200/1500 
only)

Bit strings
(S7-1200/1500 
only)

BOOL
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Operation Operator 1st Operand 2nd Operand Result
String String BOOL
TIME, LTIME TIME, LTIME BOOL
Date and time Date and time BOOL

For additional information on valid data types, refer to "See also".

Example
The following example shows a relational expression:

SCL  
IF a > b THEN c:= a;  
IF A > 20 AND B < 20 THEN C:= TRUE;  
IF A<>(B AND C) THEN C:= FALSE;  

 

 Note

The comparison for STRING and DT are executed internally in the S7-300/400 by extended 
instructions. The following operands are not permitted for these functions: 
● Parameter of a FC
● In-out parameter of an FB of type STRUCT or ARRAY

 

See also
Expressions (Page 1596)

Operators and operator precedence (Page 1602)

Logical expressions

Description   
Logical expressions combine two operands with logical operators AND OR XOR or negating 
operands NOT.

Logical operators can process the data types that are allowed in the CPU in use. The result 
of a logical expression is of BOOL data type, if both operands are of BOOL data type. If at 
least one of both operands is a bit string, then the result is also a bit string and is determined 
by the type of the highest operand. For example, when you link a BYTE type operand to a 
WORD type operand, the result is type WORD.

To link a BOOL type operand with a bit string, you must first explicitly convert it to a bit string.
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Data types of logical expressions
The following table shows the data types you can use in logical expressions:

Operation Operator 1st Operand 2nd Operand Result
Negation NOT BOOL - BOOL
AND logic 
operation

AND or & BOOL BOOL BOOL
Bit string Bit string Bit string

OR logic operation OR BOOL BOOL BOOL
Bit string Bit string Bit string

EXCLUSIVE OR 
logic operation

XOR BOOL BOOL BOOL
Bit string Bit string Bit string

Example
The following example shows a logical expression:

SCL  
IF "MyTag1" AND NOT "MyTag2" THEN c:=a;  
MyTag:=ALPHA OR BETA;  

See also
Expressions (Page 1596)

Operators and operator precedence (Page 1602)

Operators and operator precedence

Operators and their order of evaluation
Expressions can be linked together or nested within each other by operators. 

The order of evaluation for expressions depends on the precedence of operators and brackets. 
The following basic rules apply:

● Arithmetic operators are evaluated before relational operators and relational operators are 
evaluated before logical operators.

● Operators with no precedence are evaluated according to their occurrence from left to right.

● Operations in brackets are evaluated first.

The following table provides an overview of the operators and their precedence:

Operator Operation Precedence
Arithmetic expressions
+ (Page 1597) Unary plus 2
- (Page 1597) Unary minus 2
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Operator Operation Precedence
** (Page 1597) Power 3
* (Page 1597) Multiplication 4
/ (Page 1597) Division 4
MOD (Page 1597) Modulo function 4
+ (Page 1597) Addition 5
- (Page 1597) Subtraction 5
Relational expressions
< (Page 1600) Less than 6
> (Page 1600) Greater than 6
<= (Page 1600) Less than or equal 6
>= (Page 1600) Greater than or equal 6
= (Page 1600) Equal 7
<> (Page 1600) Not equal 7
Logical expressions
NOT (Page 1601) Negation 3
AND (Page 1601) or & 
(Page 1601)

Boolean AND 8

XOR (Page 1601) Exclusive OR 9
OR (Page 1601) Boolean OR 10
Miscellaneous operations
( ) (Page 1596) Brackets 1
:= (Page 1603) Assignment 11

Value assignments

Definition
You can use a value assignment to assign the value of an expression to a tag. On the left side 
of the assignment is the tag that takes the value of the expression on the right. 

The name of a function can also be specified as an expression. The function is called by the 
value assignment and returns its function value to the tag on the left.

The data type of value assignment is defined by the data type of the tag on the left. The data 
type of the expression on the right must match this type. 

For additional information on compatibility and conversion of data types, refer to "See also".

Value assignments for STRUCT data type or PLC data types
An entire structure can be assigned to another if the structures are identically organized and 
the data types as well as the names of the structural components match.

You can assign a tag, an expression or another structural element to an individual structural 
element.
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Value assignments for the ARRAY data type
An entire ARRAY can be assigned to another ARRAY if both the data types of the ARRAY 
elements as well as the ARRAY limits match. 

You can assign a tag, an expression or another ARRAY element to an individual ARRAY 
element.

Value assignments for the STRING data type
An entire STRING can be assigned to another STRING.

You can assign another STRING element to an individual STRING element.

Value assignments for the ANY data type
You can assign a tag with the ANY data type only to the following objects:

● Input parameters or temporary local data of FBs that also have the data type ANY.

● Temporary local data of FCs that also have the data type ANY.

Note that you can only point to memory areas with "standard" access mode with the ANY 
pointer.

Value assignments for the POINTER data type
You cannot use POINTER in value assignments in SCL.

Examples
The following table shows examples for value assignments:

SCL  
"MyTag1" := "MyTag2"; (* Assignment of a tag*)
"MyTag1" := "MyTag2" * "MyTag3"; (* Assignment of an expression*)
"MyTag" := "MyFC"(); (* Call for a function that assigns its 

function value to the "MyTag" tag*)
#MyStruct.MyStructElement := "MyTag"; (* Assignment of a tag to a structure 

element*)
#MyArray[2] := "MyTag"; (* Assignment of a tag to an ARRAY 

element*)
"MyTag" := #MyArray[1,4]; (* Assignment of an ARRAY element to a 

tag*)
#MyString[2] := #MyOtherString[5]; (* Assignment of a STRING element to 

another STRING element*)

See also
Operators and operator precedence (Page 1602)
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Settings for SCL

Overview of the settings for SCL

Overview
The following tables show the settings you can make for SCL:

Editor settings

Group Setting Description
View Keyword highlighting Notation used to represent the keywords of the programming 

language. You can choose between uppercase and lowercase 
letters or a notation corresponding to the conventions of the 
Pascal programming language.

Default settings for new blocks
If you create new blocks, the following settings are set as default values. You can change 
these in the block properties at a later point in time.

Group Setting Description
Compile Create extended status information Allows all tags in a block to be monitored. The memory 

requirements of the program and execution times increase, 
however, with this option. 

Check ARRAY limits1) Checks at runtime whether array indices are within the declared 
range for an ARRAY. If an array index exceeds the permissible 
range, the enable output ENO of the block is set to "0".

Set ENO automatically Checks at runtime whether errors occur in the processing of 
certain instructions. If a runtime error occurs, the enable output 
ENO of the block is set to "0".

1)For CPUs of the S7-300/400 series: When the ARRAY limits are violated, the enable output ENO is set to FALSE.
For CPUs of the S7-1200/1500 series: When the ARRAY limits are violated, the enable output ENO is not set to FALSE. 
See "Addressing structured variables (Page 1306)" for error query options.

See also
Changing the settings (Page 1606)
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Changing the settings

Procedure
To change the settings, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. Change the settings.

Result
The change will be loaded directly, there is no need to save it explicitly.

See also
Overview of the settings for SCL (Page 1605)

The programming window of SCL

Overview of the programming window

Function 
The programming window is the work area, where you enter the SCL program. 

The following figure shows the programming window of SCL:

The programming window consists of the following sections:
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Section Meaning
① Sidebar You can set bookmarks and breakpoints in the sidebar.
② Line numbers The line numbers are displayed to the left of the program 

code.
③ Outline view The outline view highlights related code sections.
④ Code area You edit the SCL program in the code area.
⑤ Display of the absolute operands This table shows the assignment of symbolic operands 

to absolute addresses.

See also
Customizing the programming window (Page 1607)

Formatting SCL code (Page 1608)

Expanding and collapsing sections of code (Page 1609)

Customizing the programming window

Introduction  
You can customize the appearance of the programming window and the program code in the 
following way:

● By setting the font, size and color

● By setting the tab spacing

● By displaying the line numbers

● By showing or hiding the absolute operands

Setting the font, size and color  
To set the font, size and color, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General > Script/text editors" group.

3. Select the desired font and font size or choose a font color for the individual language 
elements.

Setting the tab spacing  
To provide a better overview of the program, lines are indented according to syntax. Define 
the depth of indentation with the tab spacing. 

To set the tab spacing, follow these steps:
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1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General > Script/text editors" group.

3. Set the tab spacing.

Show line numbers  
To display the line numbers, follow these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "General > Script/text editors" group.

3. Select the "Show line numbers" option.

Show or hide the absolute operands  
You can show the assignment of symbolic and absolute operands in a table next to the program 
code, if required.

To hide or show the display of the absolute operands, follow these steps:

1. Click the "Absolute/symbolic operands" icon in the toolbar.
The display of the absolute operands appears.

2. To move the display, click the table and drag it to the desired position while holding down 
the mouse button.

3. To change the width of the table, click on the right or left table border and drag it to the right 
or left while holding down the mouse button.

See also
Overview of the programming window (Page 1606)

Formatting SCL code (Page 1608)

Expanding and collapsing sections of code (Page 1609)

Formatting SCL code

Introduction
To make the program clearer, you can indent or outdent individual lines manually or format 
code sections. Note the following information about formatting code sections:

● The type of formatting is based on the general settings for indents, but at least the line or 
the section is always indented. If you selected the setting "Smart", unnecessary spaces 
within the SCL instruction are also removed.

● Only syntactically correct code sections can be formatted.
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● If you place the insertion point in the first or last line of an instruction for program control, 
for example in an IF instruction in the line with the "IF", the entire instruction is formatted. 

● If you select text, only the selected text is formatted. 

Indenting or outdenting lines
To indent or outdent individual lines, follow these steps:

1. Click on the line you want to indent or outdent. 

2. Press the "Indent text", "Outdent text" button into the toolbar of the programming editor.
 

 Note

You can set the width of the indent in "Options > Settings".
 

Formatting code sections
To format code sections, follow these steps:

1. Select the text that you want to format or place the insertion point in the appropriate line. 

2. Select the "Format selected text automatically" button into the toolbar of the programming 
editor.

See also
Overview of the programming window (Page 1606)

Customizing the programming window (Page 1607)

Expanding and collapsing sections of code (Page 1609)

Overview of the script and text editor settings (Page 301)

Expanding and collapsing sections of code

Introduction
SCL instructions can span several lines. Examples for this are program control instructions or 
block calls. 

These instructions are identified as follows:

● An outline view between the display line number and the program code marks the entire 
code section. 

● When you select the opening keyword, the closing keyword is automatically highlighted.
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Procedure
To expand or collapse the code section, follow these steps:

1. Click the minus sign in the outline view.
The code section closes.

2. Click the plus sign in the outline view.
The code section opens.

See also
Overview of the programming window (Page 1606)

Customizing the programming window (Page 1607)

Formatting SCL code (Page 1608)

Using bookmarks

Basics of bookmarks

Function
You can use bookmarks to mark program locations in extensive programs so that you can find 
them quickly later if they need revising. Bookmarks are displayed in the sidebar of the 
programming window. You can navigate between multiple bookmarks within a block using 
menu commands.

Bookmarks are saved with the project and are therefore available for anyone who wants to 
edit the block. However, they are not loaded to a device. 

Bookmarks are not evaluated when blocks are compared. 

See also
Setting bookmarks (Page 1610)

Navigating between bookmarks (Page 1611)

Deleting bookmarks (Page 1612)

Setting bookmarks

Requirement
The SCL block is open.
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Procedure 
To set a bookmark, follow these steps:

1. Right-click on the desired line in the sidebar.

2. Select the "Bookmarks > Set" command in the shortcut menu.

Or:

1. Click on the line in which you want to place the bookmark.

2. Click the "Set/delete bookmark" button in the toolbar.

Or:

1. Hold down the <Ctrl> key.

2. Click on the line in the sidebar in which you want to place the bookmark.

Result
A bookmark is placed in the program code. 

 

See also
Basics of bookmarks (Page 1610)

Navigating between bookmarks (Page 1611)

Deleting bookmarks (Page 1612)

Navigating between bookmarks

Requirement
Several bookmarks are set in a block.

Procedure 
To navigate between bookmarks, follow these steps:

1. Set the insertion cursor in the program code.

2. In the "Edit" menu, select the "Go to > Next bookmark" or "Go to > Previous bookmark" 
command.

Or:

1. Set the insertion cursor in the program code.

2. In the toolbar of the programming editor, click the "Go to next bookmark", "Go to previous 
bookmark" button. 

Or:
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1. Click in the sidebar.

2. Select the "Bookmarks > Next" or "Bookmarks > Previous" command in the shortcut menu.

Result
The line with the bookmark is highlighted. 

See also
Basics of bookmarks (Page 1610)

Setting bookmarks (Page 1610)

Deleting bookmarks (Page 1612)

Deleting bookmarks
You can delete individual bookmarks or all bookmarks from the block or the CPU.

Deleting individual bookmarks 
To delete an individual bookmark, follow these steps:

1. Right-click in the sidebar on the line in which you want to delete the bookmark.

2. Select the "Bookmarks > Remove" command in the shortcut menu.

Or:

1. Click on the line in which you want to delete the bookmark.

2. In the "Edit" menu, select the "Bookmarks > Remove" command.

Or:

1. Click on the line in which you want to delete the bookmark.

2. Click the "Set/delete bookmark" button in the toolbar.

Deleting all bookmarks from the block
To delete all bookmarks from the block, follow these steps:

1. Right-click in the sidebar.

2. Select the "Bookmarks > Delete all from block" command in the shortcut menu.

Or:

1. In the "Edit" menu, select the "Bookmarks > Delete all from block" command.
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See also
Basics of bookmarks (Page 1610)

Setting bookmarks (Page 1610)

Navigating between bookmarks (Page 1611)

Entering SCL instructions

Rules for SCL instructions

Instructions in SCL     
SCL recognizes the following types of instructions: 

● Value assignments
Value assignments are used to assign a tag a constant value, the result of an expression 
or the value of another tag. 

● Instructions for program control
Instructions for program control are used to implement program branches, loops or jumps.

● Additional instructions from the "Instructions" task card
The "Instructions" task card offers a wide selection of standard instructions that you can 
use in your SCL program.

● Block calls
Block calls are used to call up subroutines that have been placed in other blocks and to 
further process their results.

Rules
You need to observe the following rules when entering SCL instructions:

● Instructions can span several lines.

● Each instruction ends with a semicolon (;).

● No distinction is made between upper and lower case.

● Comments serve only for documentation of the program. They do not affect the program 
execution.

Examples
The following examples shows the various types of instructions:

SCL
// Example of a value assignment 
"MyTag":= 0;
// Example of a block call
"MyDB"."MyFB" (ParamInput:= 10);
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SCL
// Example of a program control instruction 
WHILE "Counter" < 10 DO 
    "MyTAG" := "MyTag" + 2;
END_WHILE;

Entering SCL instructions manually

Requirement
An SCL block is open.

Procedure
To enter SCL instructions, follow these steps:

1. Enter the syntax of the instruction using the keyboard.
You are supported by the auto-complete function when performing this task. It offers all the 
instructions and operands that are allowed at the current location.

2. Select the required instruction or the desired operand from the auto-complete function.
If you select an instruction that requires specification of operands, placeholders for the 
operands are inserted into the program. The placeholders for the operands are highlighted 
in yellow. The first placeholder is selected.

3. Replace this placeholder with an operand.

4. Use the <TAB> key to navigate to all other placeholders and replace them with operands.
 

 Note

You can also drag-and-drop a defined operand from the PLC tag table or from the block 
interface into the program. To replace an operand that has already been inserted, hover the 
mouse pointer briefly over the operand to be replaced before releasing the mouse button. 
This selects the operand and when you release the mouse button it is replaced by the new 
operand.

 

Result
The instruction is inserted. 

The programming editor performs a syntax check. Incorrect entries are displayed in red and 
italics. In addition, you also receive a detailed error message in the inspector window.

See also
Using autocompletion in textual programming languages (Page 1488)

Expanding and reducing the parameter list (Page 1629)
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Inserting SCL instructions using the "Instructions" task card
The "Instructions" task card offers a wide selection of instructions that you can use in your SCL 
program. The SCL-specific instructions for program control are available in the "Instructions" 
task card.

Requirement     
An SCL block is open.

Procedure
To insert SCL instructions into a program using the "Instructions" task card, follow these steps:

1. Open the "Instructions" task card.

2. To insert the instruction, select one of the following steps:

– Navigate to the SCL instruction you want to insert and drag-and-drop it to the required 
line in the program code. The insertion location is highlighted by a green rectangle.

– Select the location in the program code where you want to insert the instruction and 
then double-click on the instruction you want to insert.

The instruction is inserted in the program. The placeholders for the operands are highlighted 
in yellow. The first placeholder is selected.

3. Replace this placeholder with an operand. You can also drag a tag from the interface or 
the PLC tag table with drag-and-drop to the placeholder.

4. Use the <TAB> key to navigate to all other placeholders and replace them with operands.

Result
The instruction is inserted. 

The programming editor performs a syntax check. Incorrect entries are displayed in red and 
italics. In addition, you also receive a detailed error message in the inspector window.

See also
Using autocompletion in textual programming languages (Page 1488)

Expanding and reducing the parameter list (Page 1629)

Defining the data type of an SCL instruction

Basic information on the data types of SCL instructions

Introduction
The SCL instructions that you employ for block programming use specific data types to 
calculate function values. Certain SCL instructions only support the use of a specific data type. 
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You cannot change the data type for these instructions. However, most of the SCL instructions 
support the use of different data types. We differentiate between the following two types of 
such instructions:

● Instructions for which the data type of the function value is determined by the data type of 
the input parameters. This is the case for most instructions.

● Instructions with default data type. The instructions listed in the following table are of this 
type.

You will have to change the default data type if this is incompatible with the data type of the 
input parameter used. You can always change the data type based on the following syntax:
_<data type>

SCL instructions with default data type
The following table lists the SCL instructions with default data types:

Instruction Default data type
CEIL DINT
DECO DWORD
FLOOR DINT
NORM_X REAL
PEEK BYTE
SCALE_X INT
TRUNC DINT
CONCAT STRING

See also
Changing the data type of an SCL instruction (Page 1616)

Example for changing the data type of an SCL instruction (Page 1617)

Changing the data type of an SCL instruction

Procedure    
Proceed as follows to insert an SCL instruction and change its data type:

1. Insert the instruction at the required point in the program using drag-and-drop.

2. Specify the operands for the instruction.
The data type of the function value is specified based on the input parameters, or the default 
data type of the instruction is used.

3. Append the "_<data type>" string to the instruction name. 
"<data type>" represents the data type you need for the instruction.
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See also
Basic information on the data types of SCL instructions (Page 1615)

Example for changing the data type of an SCL instruction (Page 1617)

Modifying the data types of IEC timers and IEC counters
IEC timers and IEC counters are internal system function blocks and require an instance data 
block. You can create the instance data blocks either as single or multi-instance. The data 
type of the instance data block is determined according to the associated instruction. For CPUs 
of the S7-1200 and S7-1500 series, you can, however execute the instructions with different 
data types, depending on your requirements.

If the newly set data type of the instance data block does not match the data type of the input 
parameter, an implicit conversion takes place if possible. If the conversion is not possible, you 
will receive an error message.

Procedure 
To change the data type of an IEC timer or IEC-counter instance data block, proceed as follows:

1. Open the block in which you call the IEC timer or IEC counter.
Depending on the instance type of the instance data block, there is a green-bordered box 
before (multi-instance) or after (single instance) the name of the instance data block.

2. Click the green-bordered box.
A drop-down list box with the valid data types for the instance data block is opened.

3. Select the desired data type.

Example for changing the data type of an SCL instruction

Changing the default data type of the "Decode" instruction (DECO)
Data type DWORD is set as default if you insert the "Decode" instruction in the program.
"Tag_Result" := DECO(IN := "Tag_Value");
Modify the program code as follows to convert the data type from DWORD to BYTE:
"Tag_Result_BYTE" := DECO_BYTE(IN := "Tag_Value");

See also
Basic information on the data types of SCL instructions (Page 1615)

Changing the data type of an SCL instruction (Page 1616)
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Displaying or hiding tag information

Introduction
Regardless of whether the operands are represented in absolute or symbolic form, you can 
show and hide simple or hierarchical comments used to document global tags. This information 
is taken from the PLC tag table. 

You can display the tag information either for all the blocks or for individually opened blocks. 
If you display the tag information for all the blocks, the tag information for all blocks currently 
opened and opened in future is shown.

You can hide the tag information at any time again. If you have hidden the tag information for 
all blocks, you can display it again for individual ones that you have opened.

If you select the display of tag information with hierarchical comments, the comments of the 
higher structure levels of structured tags will also be displayed. The display is in brackets after 
the comment of the tags; the comments of the individual levels are separated by a period. If 
there is no comment at a structure level for a tag, it is omitted in the display and this is 
recognizable because there are two periods.

Displaying or hiding tag information for all blocks
Follow the steps below to display or hide the tag information for all blocks:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. In the area navigation, select the "PLC programming" group.

3. If you want to show the tag information, either select the "Expand" option in the "Tag 
information" drop-down list or the "Tag information with hierarchy" depending on whether 
you want to display simple or hierarchical comments.

4. If you want to hide the tag information, select the "Collapse" option in the "Tag information" 
drop-down list.
The tag information is displayed or hidden for all blocks. When you open further blocks, the 
tag information is displayed or hidden depending on the selected setting.

Displaying or hiding tag information for an opened block
Follow the steps below to display or hide the tag information for an opened block:

1. If you want to show the tag information, either select the "Show tag information" option in 
the "Shows the tag information" drop-down list or the "Tag information with hierarchy" 
depending on whether you want to display simple or hierarchical comments.

2. If you want to hide the tag information, select the "Hide tag information" option in the "Hides 
tag information" drop-down list.
The tag information is displayed or hidden. 
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Using Favorites in SCL

Adding SCL instructions to the Favorites

Requirement  
● A block is open.

● The multipane mode is set for the "Instructions" task card or the Favorites are also displayed 
in the editor.

Procedure
To add SCL instructions to the Favorites, follow these steps:

1. Open the "Instructions" task card.

2. Maximize the "Basic instructions" pane.

3. Navigate in the "Basic instructions" pane to the instruction that you want to add to the 
Favorites.

4. Drag-and-drop the instruction into the "Favorites" pane or into the Favorites area in the 
program editor.

 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

 

See also
Overview of the program editor (Page 1470)

Inserting SCL instructions using Favorites (Page 1619)

Removing SCL instructions from the Favorites (Page 1620)

Inserting SCL instructions using Favorites

Requirement  
● A block is open.

● Favorites are available.
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Procedure
To insert an instruction into a program using Favorites, follow these steps:

1. Drag-and-drop the desired instruction from Favorites to the desired position.

Or:

1. Select the position in the program where you want to insert the instruction.

2. In the Favorites, click on the instruction you want to insert.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.

 

See also
Overview of the program editor (Page 1470)

Adding SCL instructions to the Favorites (Page 1619)

Removing SCL instructions from the Favorites (Page 1620)

Removing SCL instructions from the Favorites

Requirement
A code block is open. 

Procedure
To remove instructions from Favorites, follow these steps:

1. Right-click on the instruction you want to remove.

2. Select the "Remove instruction" command in the shortcut menu.
 

 Note

To additionally display the Favorites in the program editor, click the "Display favorites in the 
editor" button in the program editor toolbar.
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See also
Overview of the program editor (Page 1470)

Adding SCL instructions to the Favorites (Page 1619)

Inserting SCL instructions using Favorites (Page 1619)

Insert block calls in SCL

Basic information on the block call in SCL

Calling function blocks

Syntax of a call     
The following syntax is used to call a function block as a single or multi-instance:

● Single instance:

– If the function block originates from the project:
<DBName> (Parameter list)

– If the function block originates from the "Instructions" task card:
<DB name>.<Instruction name> (Parameter list)

● Multi-instance
<#Instance name> (Parameter list)

Calling as single instance or multi-instance
Function blocks can be called either as a single instance or a multi-instance.

● Calling as a single instance
The called function block stores its data in a data block of its own. 

● Calling as a multi-instance
The called function block stores its data in the instance data block of the calling function 
block.

For additional information on the types of calls, refer to "See also".

Parameter list
If you call another code block from a SCL block, you can supply the formal parameters of the 
called block with actual parameters.

The specification of the parameters has the form of a value assignment. This value assignment 
enables you to assign values (actual parameters) to the parameters you have defined in the 
called block.

The formal parameters of the called code block are listed in brackets directly after the call. 
Input and in-out parameters have the assignment identifier ":=", output parameters have the 
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assignment identifier "=>". A placeholder placed after the parameter shows the required data 
type and the type of the parameter. 

Rules for supplying parameters
The following rules apply to supplying parameters:

● Constants, tags and expressions can be used as actual parameters.

● The assignment order is not of importance.

● The data types of formal and actual parameters must match.

● The individual assignments are separated by commas.

● If the called block has only one parameter, it is sufficient to specify the actual parameter in 
the brackets. The formal parameter need not be specified.

See also
Manually inserting block calls (Page 1626)

Inserting block calls with drag-and-drop (Page 1627)

Examples for calling a function block in SCL (Page 1624)

Calling functions

Syntax of a call     
The following syntax is used to call a function:
<Function name> (Parameter list);     //Standard call
<Operand>:=<Function name> (Parameter list); // Call in an expression

Function value
Functions that provide a return value can be used in any expression in place of an operand. 
For this reason, the return value is also known as the "function value" in SCL. 

The call options of functions depend on whether the function returns a function value to the 
calling block.

The function value is defined in the RET_VAL parameter. If the RET_VAL parameter is of the 
VOID data type, then the function will not return a value to the calling block. If the RET_VAL 
parameter has another data type, then the function returns a function value of this data type.

In SCL, all data types are permitted for the RET_VAL parameter except ANY, ARRAY, 
STRUCT and VARIANT, as well as the parameter types TIMER and COUNTER.
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Call options
There are two possibilities for calling functions in SCL:

● Standard call for functions with and without a function value
With a standard call, the results of the function is made available as an output and in-out 
parameter.

● Call in an expression for functions with a function value
Functions that return a function value can be used in any expression in place of an operand, 
for example, a value assignment. 
The function calculates the function value, which has the same name as the function and 
returns it to the calling block. There the value replaces the function call. 
Following the call, the results of the function is made available as a function value or as an 
output and in-out parameter.

Parameter list
If you call another code block from a SCL block, you need to supply the formal parameters of 
the called block with actual parameters.

The specification of the parameters has the form of a value assignment. This value assignment 
enables you to assign values (actual parameters) to the parameters you have defined in the 
called block.

The formal parameters of the called code block are listed in brackets directly after the call. 
Input and in-out parameters have the assignment identifier ":=", output parameters have the 
assignment identifier "=>". A gray placeholder placed after the parameter shows the required 
data type and the type of the parameter. 

Rules for supplying parameters
The following rules apply to supplying parameters to functions:

● All parameters of the function must be supplied.

● The assignment order is not of importance.

● Constants, tags and expressions can be used as actual parameters.

● The data types of formal and actual parameters must match.

● The individual assignments are separated by commas.

● If the called block has only one parameter, it is sufficient to specify the actual parameter in 
the brackets. The formal parameter need not be specified.

● When you call functions in SCL, you cannot use the release mechanism via EN. Use an IF 
statement instead to call functions conditionally.
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See also
Manually inserting block calls (Page 1626)

Inserting block calls with drag-and-drop (Page 1627)

Examples for calling functions in SCL (Page 1625)

Examples for calling a function block in SCL

Calling as a single instance     
The following example shows the call of an FB as a single instance:

SCL 
// Call as a single instance 
"MyDB" (MyInput:=10, MyInout:= "Tag1"); 

Result
After the call is executed, the value determined for the "MyInout" in/out parameter is available 
in "Tag1" in the "MyDB" data block.

Calling as a multi-instance
The following example shows the call of an FB as a multi-instance:

SCL 
// Call as a multi-instance 
"MyFB" (MyInput:= 10, MyInout:= "Tag1"); 

Result
After the "MyFB" block is executed, the value determined for the "MyInout" in-out parameter 
is made available in "Tag1" in the data block of the calling code block.

See also
Calling function blocks (Page 1621)

Manually inserting block calls (Page 1626)

Inserting block calls with drag-and-drop (Page 1627)
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Examples for calling functions in SCL

Standard call  
The following example shows a standard function call:

SCL 
// Standard function call 
"MyFC" (MyInput := 10, MyInOut := "Tag1"); 

Result
After the "MyFC" block is executed, the value determined for the "MyInOut" in/out parameter 
is available in "Tag1" in the calling block and needs to be further processed there.

Call in a value assignment
The following example shows a function call in a value assignment:

SCL 
(*Call in a value assignment, a function value was defined for "MyFC" *)
#MyOperand := "MyFC" (MyInput1 := 3, MyInput2 := 2, MyInput3 := 8.9, 
MyInOut := "Tag1"); 

Result
The function value of "MyFC" is transferred to "#MyOperand". 

Call in an arithmetic expression
The following example shows a function call in an arithmetic expression:

SCL 
(*Call in a mathematical expression, a function value was defined for 
"MyFC"  *)
#MyOperand := "Tag2" + "MyFC" (MyInput1 := 3, MyInput2 := 2, MyInput3 := 
8.9); 

Result
The function value of "MyFC" will be added to "Tag2" and the result will be transferred to 
"MyOperand".
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See also
Calling functions (Page 1622)

Manually inserting block calls (Page 1626)

Inserting block calls with drag-and-drop (Page 1627)

Manually inserting block calls
You can insert calls for functions (FCs) and function blocks (FBs).   

Inserting a call for a function (FC)
Proceed as follows to insert a function call:

1. Enter the function name.

2. Confirm your entry with the Return key.
The syntax for the function call including the parameter list is added to the SCL program. 
The placeholders for the actual parameters are highlighted in yellow. The first placeholder 
is selected.

3. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

4. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.

Inserting a call for a function block (FB)
To insert a call for a function block (FB), follow these steps:

1. Enter the name of the function block.

2. Confirm your entry with the Return key.
The "Call options" dialog opens.

3. In the dialog, specify whether you want to call the block as a single or multi-instance.

– If you click the "Single instance" button, in the "Name" field enter a name for the data 
block to be assigned to the call.

– If you click the "Multi-instance" button, in the "Name in the interface" field enter a name 
of the tag with which the called function block is to be entered as a static tag in the 
interface of the calling block.

4. Confirm your entries with "OK".
The syntax for the function block call including the parameter list is added to the SCL 
program. The placeholders for the actual parameters are highlighted in yellow. The first 
placeholder is selected.

5. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

6. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.
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Result
The block call is inserted. 

If you specify an instance data block that does not exist when calling a function block, it is 
created. 

See also
Updating block calls (Page 1628)

Expanding and reducing the parameter list (Page 1629)

Using autocompletion in textual programming languages (Page 1488)

Inserting block calls with drag-and-drop
You can insert calls for existing functions (FC) and function blocks (FB) using a drag-and-drop 
operation from the project tree. 

Requirement   
The function to be called (FC) or the function block (FB) to be called is present.

Inserting a call for a function (FC)
To insert a function call using drag-and-drop, follow these steps:

1. Drag the function from the project tree into the program.
The syntax for the function call including the parameter list is added to the SCL program. 
The placeholders for the actual parameters are highlighted in yellow. The first placeholder 
is selected.

2. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

3. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.

Inserting a call for a function block (FB)
To insert a call for a function block (FB) using drag-and-drop, follow these steps:

1. Drag the function block from the project tree and drop it into the program.
The "Call options" dialog opens.

2. In the dialog, specify whether you want to call the block as a single or multi-instance.

– If you click the "Single instance" button, in the "Name" field enter a name for the data 
block to be assigned to the call.

– If you click the "Multi-instance" button, in the "Name in the interface" field enter a name 
of the tag with which the called function block is to be entered as a static tag in the 
interface of the calling block.
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3. Confirm your entries with "OK".
The syntax for the function block call including the parameter list is added to the SCL 
program. The placeholders for the actual parameters are highlighted in yellow. The first 
placeholder is selected.

4. Replace this placeholder with an actual parameter. You can also drag a tag from the 
interface or the PLC tag table with drag-and-drop to the placeholder.

5. Use the <TAB> key to navigate to all other placeholders and replace them with actual 
parameters.

Result
The block call is inserted. 

If you specify an instance data block that does not exist when calling a function block, it is 
created. 

See also
Updating block calls (Page 1628)

Expanding and reducing the parameter list (Page 1629)

Using autocompletion in textual programming languages (Page 1488)

Updating block calls
If interface parameters of a called block are changed, the block call can no longer be executed 
correctly. You can avoid such inconsistent block calls by updating the block calls.

You have two options to update the block calls:

● Explicit updating in the program editor.
The inconsistencies within the open block are displayed and can be updated. 

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types will be updated.

Update blocks in the program editor  
To update a block call within a block, follow these steps:

1. Open the block in the program editor.

2. Click "Update inconsistent block calls" in the toolbar.
Inconsistent calls are displayed.

3. Correct the inconsistencies.
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Update block calls during compilation
Proceed as follows to update all block calls and uses of PLC data types during compilation 
implicitly:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebulid all blocks)" in the shortcut menu.

See also
Manually inserting block calls (Page 1626)

Inserting block calls with drag-and-drop (Page 1627)

Expanding and reducing the parameter list
In SCL, if you call blocks or insert instructions that are system-internal function blocks, the 
syntax and the parameter list with the placeholders for the actual parameters are inserted in 
the SCL program. To make the program code easier to read, the unused optional parameters 
are removed from the parameter list when you edit other instructions. You can restore these 
at any time. You can also explicitly reduce the parameter list when you have finished assigning 
the parameters.

Expanding the parameter list
To expand the parameter list, follow these steps:

1. Right-click in the block call or the instruction.

2. Select the "Expand parameter list" command from the shortcut menu or press the key 
combination <Ctrl+Shift+Space bar>. 
The parameter list is displayed in full again.

Reducing the parameter list
To reduce the parameter list, follow these steps:

1. Right-click in the block call or the instruction.

2. Select the "Reduce parameter list" command from the shortcut menu or press the key 
combination <Ctrl+Shift+Space bar>.  
All unused optional parameters are hidden.

See also
Entering SCL instructions manually (Page 1614)

Inserting SCL instructions using the "Instructions" task card (Page 1615)

Manually inserting block calls (Page 1626)

Inserting block calls with drag-and-drop (Page 1627)
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Inserting comments

Commenting program code   
You have various options for commenting SCL programs:

● Line comment
A line comment starts with "//" and extends to the end of the line.

● Comment section
A comment section is started with "(* and completed by "*)". It can span several lines.

Inserting a line comment
To insert line comments, follow these steps:

1. Type "//" at the position where you want to place the comment. This does not have to be 
the beginning of the line.

2. Enter the comment text.

Inserting a comment section
To insert a comment section, follow these steps:

1. Type "(*" at the position where you want to place the comment. This does not have to be 
the beginning of the line.

2. Enter the comment text.

3. Complete the comment with "*)".

Disabling one or more lines with comments
To disable program code with comments, follow these steps:

1. Select the code lines you want to comment out.

2. Click the "Comment selection" button in the editor.
"//" is inserted at the beginning of the line in the selected lines. The code that follows is 
interpreted as a comment. If lines already containing a line comment are disabled, "//" is 
inserted as well. If these lines are enabled again, the original comments are retained.

Enabling comment lines
To enable lines that have been commented out to be enabled as code again, proceed as 
follows:

1. Select the code lines you want to enable.

2. Click the "Remove comment" button in the editor.
The "//" mark for line comments at the beginning of the line is removed.
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Example
The following code contains comment sections and line comments

(*************************************************************************************
  A description of the instructions that follow can be placed here
**************************************************************************************)
IF "MyVal1" > 0 THEN //No division by 0
    "MyReal" := "MyVal2" (* input value *) / "MyVal1" (* measured value *);
END_IF;
//Data type conversion
"MyInt" := REAL_TO_INT("MyReal");

 

Editing SCL instructions

Selecting instructions
You can select individual instructions or all instructions of a block.

Requirement   
An SCL block is open.

Selecting individual instructions
To select individual instructions, follow these steps:

1. Set the insertion mark before the first character that you want to select.

2. Press and hold down the left mouse button.

3. Move the cursor to a position after the last character that you want to select.

4. Release the left mouse button.

Selecting all the instructions of a program
To select all instructions, follow these steps:

1. In the "Edit" menu, select the "Select All" command or use the keyboard shortcut <Ctrl+A>.
 

 Note

When you select the opening keyword of an instructing, the closing keyword is automatically 
highlighted.
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Copying, cutting and pasting instructions

Copying an instruction
To copy an instruction, follow these steps:

1. Select the instruction you want to copy.

2. Select "Copy" in the shortcut menu.

Cutting an instruction
To cut an instruction, follow these steps:

1. Select the instruction you want to cut.

2. Select the "Cut" command in the shortcut menu.

Inserting an instruction from the clipboard
To insert an instruction from the clipboard, follow these steps:

1. Copy or cut an instruction.

2. Click on the position at which you want to insert the instruction.

3. Select "Paste" in the shortcut menu.

 

 

Deleting instructions

Requirement
An SCL block is open.  

Procedure
To delete an instruction, follow these steps:

1. Select the instruction you want to delete.

2. Select the "Delete" command in the shortcut menu.
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Eliminating syntax errors in the program

Basic information on syntax errors

Syntax errors  
Below are some examples of syntax errors:

● Missing separators or the use of too many separators

● Incorrect keyword spelling

● Incorrect jump label spelling/notation

● Notation which does not match the set mnemonics (for example, "I2.3" instead of "E2.3")

● The use of key words as operands

Identification of syntax errors
Syntax errors are underlined in red or appear in red type.

This identification allows you to recognise incorrect inputs at a glance and jump from error to 
error to eliminate them. Syntax errors are also listed in the "Info" tab of the inspector window 
with an error message.

 

See also
Finding syntax errors in the program (Page 1633)

Finding syntax errors in the program

Procedure   
To find syntax errors in the program, follow these steps:

1. Select the position in the program in which you wish to look for errors.

2. Click "Go to next error" in the toolbar.
The first error after the position you have selected will be marked.

You can use "Go to next error" and "Go to previous error" in the toolbar to find and correct all 
errors in the block.

Or:
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1. Open the error list in the inspector window with "Info > Syntax".
All syntax errors are listed in the table with a short description of the error.

2. If there are any errors, click on the blue question mark next to the error text to obtain 
information on eliminating the problem.

3. Double-click the error you want to correct.
The corresponding error is highlighted.

 

See also
Basic information on syntax errors (Page 1633)

Changing the programming language

Rules for changing the programming language

Rules
Observe the following rules if you want to change the programming language for a block:

● All CPU series:

– You can only change the programming language of entire blocks. The programming 
language cannot be changed for individual networks.

– You cannot switch blocks programmed in the programming languages SCL or GRAPH. 
In GRAPH blocks, however, you can change between LAD and FBD as network 
languages.

● S7-300/400: 

– You can only change between the programming languages LAD, FBD and STL.

– You can create networks within a block using another programming language and then 
copy them into the desired block.

– If the language of individual networks of the block cannot be changed, these networks 
is displayed in their original language.

● S7-1200/1500: 

– You can change between the programming languages LAD and FBD.

● S7-1500:

– You can create STL networks within the LAD and FBD blocks. However, you cannot 
copy between STL and LAD/FBD.
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Change the programming language

Procedure 
To change the programming language, follow these steps:

1. Right-click the block in the project tree.

2. Select the "Properties" command in the shortcut menu.
The dialog with the properties of the block opens.

3. Select the "General" entry in the area navigation.

4. Select the new programming language in the "Language" drop-down list.

5. Confirm your selection with "OK".

See also
Rules for changing the programming language (Page 1634)

Handling program execution errors

Basics of error handling

Introduction
Program execution errors are programming or I/O access errors.  You have a number of 
different options for responding to program execution errors depending on the CPU used.

Handling program execution errors in S7-300/400
You can program the program execution error OB (OB 85) for S7-300/400 CPUs. If a program 
execution error occurs and you do not use the program execution error OB, the CPU will switch 
to "STOP" mode. 

You will find additional information about the program execution error OB in the description of 
the mode of operation of S7-300/400 CPUs.
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Handling program execution errors in S7-1200/1500
You can select the type of error handling for CPUs of the S7-1200 and S7-1500 series. You 
have the following two options:

● Use the CPU's global troubleshooting:

– S7-1200: The CPU generates a diagnostic buffer entry and remains in "RUN" mode.

– S7-1500: You can program the programming error OB (OB 121) and the I/O access 
error OB (OB 122) for S7-1500 CPUs. If no programming error OB exists in the CPU, 
the CPU switches to "STOP" mode when a programming error occurs. In the event of 
an I/O access error, the CPU always remains in "RUN" mode, regardless of whether 
the I/O access error OB is present. 
Please note, however, that an existing I/O access or programming error OB is not called 
synchronously to the error. Therefore, depending on the selected priority, the execution 
of I/O access or programming error OBs may be delayed instead of taking place 
immediately when the error occurs. If other errors occur before execution of the I/O 
access or programming error OB is complete, no further I/O access or programming 
error OB is called. If you want to prevent I/O access or programming error OBs from 
being discarded, set the priority correspondingly high. 
You can use the enable output ENO to detect I/O access and programming errors for 
the instructions "Read field" (FieldRead), "Write field" (FieldWrite) , "Read memory 
address" (PEEK) and "Write memory address" (POKE).
You can find more information about these error OBs in the description of the mode of 
operation of S7-1500 CPUs.

● You use separate local error handling. Local error handling is error handling within a block. 
Local error handling has the following advantages:

– The error information is stored in the system memory, which you can query and evaluate.

– You can use the error information to program a response in the block to the error that 
has occurred.

– Programmed error evaluation and error reactions do not interrupt the program cycle.

– The system performance is not unnecessarily burdened by the local error handling. If 
no errors occur, programmed error analyses and reactions are not executed.
Local error handling applies only to blocks for which it has been set explicitly. If local 
error handling is set for a block, no global error handling is conducted for errors in this 
block. 

 

 Note

Note the following information:
● All memory access errors and I/O access errors must be captured either by global or local 

error handling.
● If the parameters of an instruction do not cause any memory access errors, you can query 

the associated ENO.
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See also
GET_ERROR: Get error locally (Page 2360)

GET_ERR_ID: Get error ID locally (Page 2364)

GET_ERROR: Get error locally (Page 2077)

GET_ERR_ID: Get error ID locally (Page 2080)

Querying and fixing errors in the program code (Page 286)

Local error handling

Principles of local error handling

Introduction
Local error handling makes it possible to query the occurrence of errors within a block and 
evaluate the associated error information. You can set local error handling for organization 
blocks (OBs), function blocks (FBs), and functions (FCs). If local error handling is enabled, the 
system reaction is ignored.

Local error handling applies only to blocks for which it has been set explicitly. The local error 
handling setting is not assumed by a calling block, nor is it transferred to called blocks. For 
higher-level blocks and lower-level blocks, the system settings still apply provided dedicated 
error handling has not been programmed for these blocks.

General procedure for local error handling
When errors occur while a block is being executed with local error handling, a predefined 
response is initiated based on the following error types: 

● Write errors: These errors are ignored, and program execution simply continues.

● Read errors: Program execution continues with the substitute value "0".

● Execution errors: Execution of the instruction is aborted. Program execution resumes with 
the next instruction.

Information about the first error that occurs is stored in the system memory. This information 
can be queried and output with an instruction (GET_ERROR or GET_ERR_ID). Error 
information is output in a format that can undergo additional processing. You can use additional 
instructions to analyze error information and program a reaction to the error based. 

When information about the first error is queried, the error memory space in the system memory 
is enabled. Then, when additional errors occur, information about the next error is output. 

Instructions for local error handling
You can use the following instructions for local error handling:

● GET_ERROR: Get error locally

● GET_ERR_ID: Get error ID locally
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The instructions differ in the amount of error information that is output with each one. 

For additional information on the instructions, refer to "See also".

See also
GET_ERROR: Get error locally (Page 2360)

GET_ERR_ID: Get error ID locally (Page 2080)

GET_ERR_ID: Get error ID locally (Page 2364)

GET_ERROR: Get error locally (Page 2077)

Error output priorities

Overview of the priorities   
In local error handling, information about the first error that occurred is displayed. If multiple 
errors occur at the same time while an instruction is being executed, these errors are displayed 
according to their priority. The following table shows the priority of different types of errors.

Priority Error type
1 Error in the program code
2 Missing reference 
3 Invalid range
4 DB does not exist
5 Operands are not compatible
6 Width of specified area is not sufficient 
7 Timers or counters do not exist
8 No write access to a DB
9 I/O error
10 Instruction does not exist
11 Block does not exist
12 Invalid nesting depth

 

The highest priority is 1 and the lowest priority is 12.

See also
GET_ERROR: Get error locally (Page 2360)

GET_ERR_ID: Get error ID locally (Page 2080)

GET_ERR_ID: Get error ID locally (Page 2364)

GET_ERROR: Get error locally (Page 2077)
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Enabling local error handling for a block

Introduction
Local error handling is enabled for a block if you insert one of the following instructions in a 
network.

● GET_ERROR: Get error locally

● GET_ERR_ID: Get error ID locally

For additional information on the instructions, refer to "See also".

If local error handling is enabled for a block, the system reactions for this block are ignored.

Requirement
● The block is open.

● Die "Instructions" task card is open.

Procedure
To enable local error handling for a block, proceed as follows:

1. Navigate to the "Basic instructions" pane of the "Instructions" task card.

2. Open the "Program Control" folder.

3. Drag the instruction "Get error locally" (GET_ERROR) or "Get error ID locally" 
(GET_ERR_ID) to the required network.

Result
Local error handling is enabled for the open block. The "Handle errors within block" check box 
is selected in the Inspector window under "Properties > Attributes". This setting cannot be 
edited in the Inspector window. Local error handling can be deactivated by deleting the inserted 
instructions on local error handling.

See also
GET_ERROR: Get error locally (Page 2360)

GET_ERR_ID: Get error ID locally (Page 2080)

GET_ERR_ID: Get error ID locally (Page 2364)

GET_ERROR: Get error locally (Page 2077)

9.1.4.3 Programming data blocks

Basic principles for programming of data blocks
A data block (DB) is used to save the values that are written during execution of the program. 
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In contrast to the code block, the data block contains only tag declarations. It contains no 
networks or instructions. The tag declarations define the structure of the data block.   

Types of data blocks
There are two types of data blocks:

● Global data blocks
The global data block is not assigned to a code block. You can access the values of a global 
data block from any code block. A global data block contains only static tags. 
The structure of the global data block can be freely defined. In the declaration table for data 
blocks, you declare the data elements that are to contained in the global data block. 

● Instance data blocks
The instance data block is assigned directly to a function block (FB). The structure of an 
instance data block cannot be freely defined, but is instead determined by the interface 
declaration of the function block. The instance data block contains exactly those block 
parameters and tags that are declared there. 
However, you can define instance-specific values in the instance data block, for example, 
start values for the declared tags.

ARRAY data blocks (S7-1500)
ARRAY data blocks are global data blocks that consist of an ARRAY. This ARRAY can be 
based on any data type. For example, an ARRAY of a PLC data type (UDT) is possible. The 
DB contains no other elements besides the ARRAY. Because of their flat structure, ARRAY 
data blocks facilitate access to the ARRAY elements and their transfer to called blocks.

The "Move operations" section of the "Instructions" task card offers options for addressing of 
ARRAY DBs. 

PLC data types as a template for global data blocks 
PLC data types can be used as templates for the creation of global data blocks with identical 
data structures. You create the structure as PLC data type only once and then generate the 
required data blocks by assigning the PLC data type. 

System data types as a template for global data blocks 
System data types can also be used as templates for creating global data blocks with identical 
data structure. System data types already have a pre-defined structure. You insert the system 
data type in the program only once and then generate additional data blocks with an identical 
structure by assigning the system data type.
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Access modes
There are two different modes of accessing data values in data blocks:

● Data blocks with optimized access (only S7-1200)
Data blocks with optimized access have no fixed defined structure. In the declaration, the 
data elements are assigned only a symbolic name and no fixed address within the block. 
You access the data values in these block via symbolic names.
The "Optimized block access" attribute is always enabled for ARRAY data blocks. 

● Data blocks with standard access (all CPU families)
Data blocks with standard access have a fixed structure. In the declaration, the data 
elements are assigned both a symbolic name and a fixed address within the block. You 
can access the data values in these blocks via symbolic names or the address.
ARRAY data blocks with standard access are not possible.

Retentivity of data values
To prevent data loss in the event of power failure, you can store the data values in a retentive 
memory area.

See also
Creating data blocks (Page 1450)

Global data blocks (DB) (Page 1264)

Instance data blocks (Page 1265)

Structure of the declaration table for data blocks

Structure of the declaration table for data blocks   
The figure below shows the structure of the declaration table for data blocks. The display will 
vary depending on type of block and type of access. 

Display of instance-specific values
In instance data blocks, you can apply the already defined values from the interface of the 
assigned function block or define instance-specific start values. Values that are applied from 
the function block cannot be edited. You can replace the grayed-out values with instance-
specific values. Values that were already changed instance specific are not grayed out.
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Meaning of the columns
The following table shows the meaning of the individual columns. You can show or hide the 
columns as required. The number of columns displayed varies depending on the CPU series.

Column Explanation
Symbol you can click to move or copy the tag. You can, for example, drag-
and-drop the tag into a program and use it there as operand.

Name Name of the tags. 
Data type Data type of the tags.
Offset Relative address of the tags. 

The column is only visible in data blocks with standard access.
Default value Default value of the tag in the interface of a higher-level code block or in a 

PLC data type. 
The values contained in the "Default value" column can only be changed in 
the higher-level code block or PLC data type. The values are only displayed 
in the data block. 

Start value Value that the tag should assume at startup.
The default values defined in a code block are used as start values during the 
creation of the data block. You can then replace these adopted values with 
instance-specific start values. 
Specification of an start value is optional. If you do not specify any value, the 
tag assumes the default value at startup. If a default is not defined either, the 
default value valid for the data type is used. For example, the value "FALSE" 
is specified as standard for BOOL.

Monitor value Current data value in the CPU. 
This column only appears if an online connection is available and you click 
"Monitor".

Snapshot Shows values that were loaded from the device.
Retentivity Marks the tag as retentive. The values of retentive tags are retained even 

after the power supply is switched off.
Visible in HMI Shows whether the tag is visible by default in the HMI selection list.
Accessible from HMI Shows whether HMI can access this tag during runtime.
Setting value Setting values are the values that will probably have to be fine tuned during 

commissioning. After commissioning, the values of these tags can be 
transferred to the offline program as start values and stored there. 

Comment Comment to document the tags.

See also
Creating data blocks (Page 1450)

Basic information on start values (Page 1649)
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Creating data blocks

Requirement
The "Program blocks" folder in the project tree is open.

Procedure
To create a data block, follow these steps:

1. Double-click the "Add new block" command.
The "Add new block" dialog box opens.

2. Click the "Data block (DB)" button.

3. Select the type of the data block. You have the following options available to you:

– To create a global data block, select the list entry "Global DB".

– To create an ARRAY data block, select the "ARRAY DB" entry in the list.

– To create an instance data block, select the function block to which you want to assign 
the instance data block from the list. The list contains only the function blocks that were 
previously created for the CPU.

– To create a data block based on a PLC data type, select the PLC data type from the 
list. The list contains only the PLC data types that were previously created for the CPU.

– To create a data block based on a system data type, select the system data type from 
the list. The list contains only those system data types that have already been inserted 
to program blocks in the CPU.

4. Enter a name for the data block.

5. Enter the properties of the new data block. 

6. If you have selected an ARRAY DB as the data block type, enter the ARRAY data type and 
the high limit for the ARRAY. 
You can change the high limit for the ARRAY at any time in the property window of the 
created block. The ARRAY data type cannot be changed subsequently.

7. To enter additional properties of the new data block, click "Additional information".
An area with further input fields is displayed.

8. Enter all the properties you require.

9. Activate the "Add new and open" check box if the block does not open as soon as it is 
created.

10.Confirm your entry with "OK".

Result
The new data block is created. You can find the data block in the project tree in the "Program 
blocks" folder.
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See also
Instance data blocks (Page 1265)

Global data blocks (DB) (Page 1264)

Overview of block properties (Page 1459)

Updating data blocks

Introduction  
Changes in the interface of a function block or a PLC data type can lead to the corresponding 
data blocks becoming inconsistent. These inconsistencies are marked in red in the declaration 
table and at the call point of the block. To remedy these inconsistencies, the data blocks must 
be updated.

You have three options to update block calls:

● Explicit updating in the declaration table for data blocks.
The data block is updated. Changes from the interface of the assigned function block and 
changes to the used PLC data types are applied. 

● Explicit updating in the program editor.
The block calls in the open block will be updated. The associated instance data block is 
also adjusted in the process.

● Implicit updating during compilation.
All block calls in the program as well as the used PLC data types and the corresponding 
instance data blocks are updated.

Explicit Updating in the Declaration Table for Data Blocks
To explicitly update an individual data block, follow these steps:

1. Open the data block.

2. Select "Update interface" in the shortcut menu.

Explicit Updating in the Program Editor
To update all block calls or a specific call within a block, follow these steps:

1. Open the block in the program editor.

2. Right-click on the instruction with the block call.

3. Select the "Update" command in the shortcut menu.

4. The "Interface update" dialog opens. This dialog shows the differences between the block 
interface in use and the changed interface of the called block.

5. If you want to update the block call, click "OK". To cancel the update, click "Cancel".
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Implicit Updating during Compilation
To implicitly update all block calls and uses of PLC data types as well as the instance data 
blocks during the compiling, follow these steps:

1. Open the project tree.

2. Select the "Program blocks" folder.

3. Select the command "Compile > Software (rebuild all blocks)" in the shortcut menu.

See also
Changing the properties of tags in instance data blocks (Page 1656)

Extending data blocks

Description   
In order to enable the editing of PLC programs that have already been commissioned and that 
are running without error on a system, CPUs of the S7-1500 series and most CPUs of the 
S7-1200 V4 series support the option of extending global data blocks during runtime. 

You can download the modified blocks without setting the CPU to STOP and without affecting 
the values of already loaded tags. 

This is a simple means of implementing program changes. This load process (download 
without reinitialization) will not have a negative impact on the controlled process. 

Principle of operation
Each data block is always assigned a default memory reserve. The memory reserve is not 
used initially. Activate the memory reserve if you decide on loading interface changes after 
having compiled and downloaded the block. All tags that you subsequently declare will be 
saved to the memory reserve. A subsequent download has no impact on the values of tags 
that have already been loaded.

If you decide to review your program at a later time while the plant is not in operation, you are 
also provided an option of reworking the memory layout of individual or several blocks in a 
single pass. With this action, you move all tags from the reserve area to the regular area. The 
memory reserve is now cleared and made available for further interface extensions.

Requirements
This "Download without reinitialization" function is available if the following requirements are 
met:

● The project is in the "TIA Portal V12" format or a higher version.

● You are working with a CPU that supports "Download without reinitialization".

● The blocks were created in LAD, FBD, STL, or SCL.
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● The blocks were created by the user, i.e. they are not included with the blocks delivered in 
your package.

● These blocks are assigned the optimized access attribute.

Basic steps
Perform the following steps if you want to extend the data block and then load the block without 
re-initialization. 

1. All blocks have a default memory reserve of 100 bytes. You can adapt this memory reserve 
to suit your requirements.

2. Activate the memory reserve.

3. Extend the block interface.

4. Compile the block.

5. Download the block to the CPU as usual.

Reference
For more information on the various steps, refer to chapter "Loading blocks (S7-1200/1500) ".

Creating a data structure for global data blocks

Declaring tags of elementary data type

Requirement  
A global data block is open. 

 

 Note

You cannot change the structure of instance data blocks and of data blocks based on a PLC 
data type directly, since the structures of these blocks are defined by the respective function 
block or the PLC data type. 

The type of the data block is entered in the block properties.
 

 

Procedure
To declare a tag of the elementary data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. In the "Data type" column, click the button for the data type selection.
A list of the permissible data types is opened.

3. Select the desired data type.
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4. Optional: Change the properties of the tags that are displayed in the other columns.

5. Repeat steps 1 to 4 for all tags that are to be declared.

 

See also
Displaying and editing block properties  (Page 1464)

Declaring tags of the ARRAY data type (Page 1647)

Declaring tags of STRUCT data type (Page 1648)

Editing tables (Page 342)

Declaring tags of the ARRAY data type

Requirement       
A global data block is open.

Procedure
To declare a tag of the ARRAY data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the "Array" data type in the "Data type" column. You will be supported by 
autocompletion in this step.
The "Array" dialog opens.

3. In the "Data type" text box, specify the data type of the array elements.

4. In the "ARRAY limits" text box, specify the high and low limit for each dimension.
Example of a one-dimensional ARRAY:
[0..3]
Example of a three-dimensional ARRAY:
[0..3, 0..15, 0..33]

5. Confirm your entry.

6. Optional: Change the properties of the tags that are displayed in the other columns.

The tag is created but remains collapsed. To expand the ARRAY, click the triangle in front of 
the tag. Not that you cannot expand very large ARRAYs for reasons of clarity.

Entering start values of ARRAY elements
To set default start values for the individual elements of an ARRAY, follow these steps:

1. Click the triangle in front of the ARRAY data type tags.
The ARRAY opens and the individual ARRAY elements are shown in separate rows. 

2. Enter the required value in the "Start value" column.
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Declaring tags of STRUCT data type

Requirement   
A global data block is open.

Procedure
To declare a tag of the STRUCT data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter "Struct" in the "Data type" column. You will be supported by autocompletion during 
input.
An empty, indented row is inserted after the new tag.

3. Insert the first structural element in the first empty row.
An additional empty row is inserted after the element.

4. Select a data type for the structure element.

5. Optional: Change the properties of the structural element that is displayed in the other 
columns of the block interface.

6. Repeat the step 4 to 7 for all additional structure elements.
It is not necessary to end the structure explicitly. The structure ends with the last element 
that is entered.

7. To insert a new tag after the structure, leave a blank row after the end of the structure and 
then start the new tag in the second empty row.

Result
The tag of STRUCT data type is created. 

Enter start values of structure elements
To set default start values for the individual elements of a structure, follow these steps:

1. Click the triangle in front of the STRUCT data type tags.
The structure opens and the individual structure elements are shown in separate rows. 

2. Enter the required value in the "Start value" column.

See also
STRUCT (Page 1355)
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Declaring tags based on a PLC data type

Requirements    
● A global data block is open. 

● A PLC data type is declared in the current CPU.

Procedure
To declare a tag based on a PLC data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the PLC data type in the "Data type" column. You will be supported by autocompletion 
during input.

3. Optional: Change the properties of the tags that are displayed in the other columns of the 
table.

Result
The tag is created.

See also
Layout of the block interface (Page 1491)

Define start values

Basic information on start values

Definition of "Start value" 
The start value of a tag is a value defined by you which the tag assumes after a CPU startup. 

The retentive tags have a special status. Their values take the defined start value only after a 
"cold restart". After a "warm restart", they retain their values and are not reset to the start value.

Definition of "Default value" 
The structure of the data blocks can be derived from higher-level elements.

● An instance data block is based, for example, on the interface of a higher-level code block.

● A global data block can be based on a predefined PLC data type.

In this case you can define a default value for each tag in the higher-level element. These 
default values are used as start values during the creation of the data block. You can then 
replace these values with instance-specific start values in the data block. 
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Specification of an start value is optional. If you do not specify any value, the tag assumes the 
default value at startup. If a default is not defined either, the default value valid for the data 
type is used. For example, the value "FALSE" is specified as standard for BOOL.

 

See also
Define start values (Page 1650)

Structure of the declaration table for data blocks (Page 1641)

Declaring local tags and constants in the block interface (Page 1497)

Applying values from the online program as start values (Page 1665)

Define start values

Define start values   
To define the start values for the tags of a data block, follow these steps:

1. Open the data block.
The "Default value" column shows the default values that were defined for the tags in the 
interface of a higher-level code block or in a PLC data type.

2. Click the "Expanded mode" button to show all elements of structured data types.

3. Enter the desired start values in the "Start value" column. The value must match the data 
type of the tag and should not exceed the range of the data type.
The start values are defined. The tag takes the defined value at startup, provided it was 
not declared as retentive. 

Resetting a tag to the default value
To reset a tag for which you have defined a start value to the default value, follow these steps:

1. Select a modified value in the table.

2. Delete the value.
The default value is entered. The default value is displayed.
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Resetting all tags to the default value
To reset to the default value all tags for which you have defined an start value, follow these 
steps:

1. Select the "Reset start values" icon in the toolbar.
The default values are transferred to the "Start value" column. Write-protected start values 
are not overwritten.

See also
Basic information on start values (Page 1649)

Applying values from the online program as start values (Page 1665)

Loading changed values

Introduction
To apply the changed start values from the offline program to the online program, you must 
load the changes. The following cases must be distinguished: 

● Loading changed start values of non-retentive tags

● Loading changed start values of retentive tags

● Loading changed start values of setting values

Requirement
The start values in the offline program were changed.

Procedure
To load changed start values of non-retentive tags, follow these steps:

1. Select the blocks to be loaded in the project tree.

2. Select the "Download to device > Software (only changes)" command from the shortcut 
menu.
The blocks are compiled and loaded. 
The start values of the newly defined tags are placed in the load memory of the CPU. The 
program runs with the new start values at the next transition from STOP to RUN.

 

To load changed start values of retentive tags, follow these steps:

1. Select the blocks to be loaded in the project tree.

2. Select the "Compile > Software (rebuild all blocks)" command in the shortcut menu.

3. In the "Online" menu, select the "Download and reset PLC program" command.
The online blocks are deleted and replaced with the new blocks. This reinitializes all tags, 
including the retentive tags. 
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Information about loading changed setting values and general information about loading can 
be found under "See also".

See also
Initializing setting values in the online program (Page 1664)

Setting retentivity

Retentivity of tags in data blocks

Retentive behavior    
To prevent data loss in the event of power failure, you can mark the data as retentive. This 
data is stored in a retentive memory area. The options for setting the retentivity depend on the 
type of data block and the type of block access that is set.

See also
Setting retentivity in an instance data block (Page 1652)

Setting retentivity in a global data block (Page 1653)

Setting retentivity in an instance data block

Introduction    
In an instance data block, the editability of the retentive behavior depends on the type of access 
of the higher-level function block: 

● Function block with standard access
You can define the instance data both as retentive or non-retentive. Individual retentivity 
settings are not possible for individual tags. 

● Function block with optimized access
In the instance data block, you can define the retentivity settings of the tags that are selected 
in the block interface with "Set in IDB". With these tags also, you cannot individually set the 
retentive behavior for each tag. The retentivity setting has an impact on all tags that are 
selected in the block interface with "Set in IDB".
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Setting Retentivity for Standard Access
To centrally set the retentivity of all tags in the data block with standard access, follow these 
steps:

1. Open the instance data block.

2. Select the check box in the "Retain" column of a tag.
All tags are defined as retentive.

3. To reset the retentivity setting for all tags, clear the check box in the "Retain" column of a 
tag.
All tags will be defined as non-retentive.

Setting Retentivity for Optimized Access
To set the retentive behavior of the tags that are selected with "Set in IDB" in data blocks with 
optimized access, follow these steps:

1. Open the instance data block.

2. Select the check box in the "Retain" column of a tag.
All tags selected with "Set in IDB" in the data block interface are defined as retentive.

3. To reset the retentivity setting for the tags, clear the check box in the "Retain" column of a 
tag.
All tags selected with "Set in IDB" in the data block interface will be defined as non-retentive.

See also
Basics of block access (Page 1267)

Retentivity of tags in data blocks (Page 1652)

Setting retentivity in a global data block

Introduction       
In a global data block, the editability of the retentive behavior depends on the type of access: 

● Global data block with standard access
You can define the data both as retentive or non-retentive. Individual retentivity settings 
are not possible for individual tags. 

● Global data block with optimized access
You can individually define the retentivity settings of the tags. For tags with structured data 
types, retentivity settings are transferred for all tag elements.
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Setting Retentivity for Standard Access
To centrally set the retentivity of all tags in the data block with standard access, follow these 
steps:

1. Open the global data block.

2. Select the check box in the "Retain" column of a tag.
All tags are defined as retentive.

3. To reset the retentivity setting for all tags, clear the check box in the "Retain" column of a 
tag.
All tags are defined as non-retentive.

Setting Retentivity for Optimized Access
To individually set the retentivity of all tags in data blocks with optimized access, follow these 
steps:

1. Open the global data block.

2. In the "Retain" column, select the check box for the tags for which you want to set a retentive 
behavior.
The selected tag is defined as retentive.

3. To reset the retentivity setting for the tags, clear the check box in the "Retain" column of a 
tag.
All selected tags are defined as non-retentive.
 

See also
Basics of block access (Page 1267)

Retentivity of tags in data blocks (Page 1652)

Editing the properties of tags in data blocks

Properties of the tags in data blocks

Properties     
The following table provides an overview of the properties of tags in data blocks:

Group Property Description
General Name Name of the tags.

Data type Data type of the tags.
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Group Property Description
Default value Default value of the tag in the interface of a higher-level 

code block or in a PLC data type. 
The values contained in the "Default value" column can 
only be changed in the higher-level code block or PLC 
data type. The values are only displayed in the data block. 

Start value Value that the tag should assume at CPU startup.
The default values defined in a code block are used as 
start values during the creation of the data block. You can 
then replace these adopted values with instance-specific 
start values. 
Specification of an start value is optional. If you do not 
specify any value, the tag assumes the default value at 
startup. If a default is not defined either, the default value 
valid for the data type is used. For example, the value 
"FALSE" is specified as standard for BOOL.

Comment Comment on the tag.
Attributes Retain Marks the tag as retentive. 

The values of retentive tags are retained even after the 
power supply is switched off. 
This attribute is only available in the interface of the 
function block with optimized access.

Accessible from HMI Indicates whether the tag can be used in HMI.
When the attribute is set, you have read or write access 
to the tag from the HMI.
When the attribute is not set, you cannot access the tag 
from the HMI. Please note, however, that you cannot 
implement general access protection for the tag with the 
"Accessible from HMI" attribute. Read or write access 
from other applications is possible even if the attribute is 
not enabled.

Visible in HMI Shows whether the tag is visible by default in the HMI 
selection list.

Hidden parameter Indicates whether the tag should be hidden for the block 
call. This is only possible if you have specified a valid 
predefined actual parameter beforehand.

Predefined actual 
parameter

Defines a parameter that is to be used as actual parameter 
during the block call.

Visible Indicates whether a parameter is visible in CFC.
Configurable Indicates whether a parameter is configurable in CFC.
For test Indicates whether a parameter is registered for the CFC 

test mode.
Interconnectable Indicates whether a parameter is interconnectable in CFC.
Enable tag readback Indicates whether a parameter is relevant for the "Read 

back chart" function in CFC.
Enumeration texts Assigns a parameter to an enumeration in CFC.
Engineering unit Assigns a parameter to a unit in CFC.
Low limit Defines the low limit for the parameter in CFC.
High limit Defines the high limit for the parameter in CFC.
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See also
Changing the properties of tags in instance data blocks (Page 1656)

Changing the properties of tags in global data blocks (Page 1657)

Changing the properties of tags in instance data blocks

Instance-specific tag properties
Two options are available for defining the tag properties:

● The tag properties are applied from the interface of the assigned function block.
Properties that are applied from the function block are displayed grayed out out in the 
columns of the declaration table. The "Name" and "Data type" properties are always applied.

● You define instance-specific properties.
You can change some properties instance specific. Changeable values are, for example, 
"Comment" or "Visible in HMI". Properties that were changed instance specific are not 
grayed out in the columns of the declaration table. The instance-specific changes are 
retained, even if the interface of the higher-level function block is changed and the instance 
data blocks are subsequently updated.

Editing properties of an element in the declaration table     
To edit the properties of an element, follow these steps:

1. Open the instance data block.

2. Select the required element in the table.

3. Change the entries in the columns.

Editing properties of several elements in the declaration table
You can also simultaneously set or reset the "Retain", "Visible in HMI", "Accessible in HMI" 
and "Setpoint" columns for one or more selected elements.  

To change one of these properties for several elements, follow these steps:

1. Open the data block.

2. Hold down the CTRL key.

3. In the required column, select each of the table cells whose value you want to change.

4. Select the "Set <property>" or "Reset <property>" command in the shortcut menu.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
1656 System Manual, 02/2014



Editing properties in the properties window
To edit the properties of an individual tag, follow these steps:

1. Select a tag in the table.

2. Select the "Properties" command in the shortcut menu.
The properties window opens. It shows the properties of the tag in the "General" and 
"Attributes" areas.

3. Select the required area in the area navigation.

4. Change the entries in the text boxes.

Reset individual properties to the default value.
To reset individual tag properties to the value that was defined as default in the function block, 
follow these steps:

1. Select an instance-specific, modified value in the table.

2. Delete the value.
The instance-specific value will be deleted and the default value from the interface of the 
function block entered. The default value is displayed grayed out.

See also
Updating data blocks (Page 1644)

Properties of the tags in data blocks (Page 1654)

Changing the properties of tags in global data blocks

Introduction
Two options are available for defining the tag properties:

● The tag properties are applied from the PLC data type.
Properties that are applied from the PLC data type are shown grayed out in the columns 
of the declaration table. The "Name" and "Data type" properties are always applied.

● You define specific properties.
You can change some properties in the global data block. Changeable values are, for 
example, "Comment" or "Visible in HMI". Properties that were changed are not grayed out 
in the columns of the declaration table. The changes are retained, even if the PLC data 
type changes and the global data block is subsequently updated.

Editing properties of an element in the declaration table     
To edit the properties of an element, follow these steps:

1. Open the global data block.

2. Select the required element in the table.

3. Change the entries in the columns.
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Editing properties of several elements in the declaration table
You can also simultaneously set or reset the "Retain", "Visible in HMI", "Accessible in HMI" 
and "Setpoint" columns for one or more selected elements.  

To change one of these properties for several elements, follow these steps:

1. Open the data block.

2. Hold down the CTRL key.

3. In the required column, select each of the table cells whose value you want to change.

4. Select the "Set <property>" or "Reset <property>" command in the shortcut menu.

Editing properties in the properties window
To edit the properties of an individual tag, follow these steps:

1. Select a tag in the table.

2. Select the "Properties" command in the shortcut menu.
The properties window opens. It shows the properties of the tag in the "General" and 
"Attributes" areas.

3. Select the required area in the area navigation.

4. Change the entries in the text boxes.

Reset individual properties to the default value.
To reset individual tag properties to the value that was defined as default in the PLC data type, 
follow these steps:

1. Select a modified value in the table.

2. Delete the value.
The default value from the PLC data type is entered. The default value is displayed grayed 
out.

See also
Properties of the tags in data blocks (Page 1654)

Editing the declaration table for data blocks

Inserting table rows

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.
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Result
A new row is inserted above the selected row. 

See also
Editing tables (Page 342)

Inserting table rows

Procedure  
Proceed as follows to insert a row below the selected row:

1. Select the row below which you want to insert a new row.

2. Click the "Add row" button on the table toolbar.

Result
A new empty row will be inserted below the selected row.

See also
Editing tables (Page 342)

Deleting tags

Requirements
A global data block is open.

Procedure  
To delete a tag, follow these steps:

1. Select the row with the tag to be deleted. You can also select several rows by clicking on 
them one after the other while holding down the <Ctrl> key or by pressing and holding down 
<Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.
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 Note

You cannot directly change the structure of instance data blocks and of global data blocks 
based on a PLC data type, since the structures of these blocks are defined in the higher-level 
object. 

The type of the data block is entered in the block properties.

See also: Displaying and editing block properties  (Page 1464) 
 

 

See also
Editing tables (Page 342)

Automatically filling in successive cells
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

You can define individual or more cells as well as entire rows as source area.

If less rows exist in the open table than you want to fill, then you will first have to insert additional 
empty rows. 

Requirement
● The table is open.

● Sufficient declaration rows are available.

Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. 

5. If entries are already present in the cells that are to be automatically filled in, a dialog 
appears. In this dialog you can indicate whether you want to overwrite the existing entries 
or insert new rows for the new tags.
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Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

Editing tags with external editors
To edit individual tags in external editors outside the TIA portal, you can export or import these 
tags using copy & paste. However, you cannot copy structured tags to an editor.

Requirement   
The data block and an external editor are opened.

Procedure
To export and re-import individual tags by drag-and-drop operation, follow these steps:

1. Select one or more tags.

2. Select "Copy" in the shortcut menu.

3. Switch to the external editor and paste the copied tags.

4. Edit the tags as required.

5. Copy the tags in the external editor.

6. Switch back to the declaration table.

7. Select "Paste" in the shortcut menu.

Monitoring data values online

Monitoring data values in data blocks online
You can monitor the current data values of the tags in the CPU directly in the declaration table.

Requirement   
● An online connection is available.

● The data block has been loaded to the CPU.
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● The program execution is active (CPU in "RUN").

● The data block is open.

Procedure
To monitor the data values, proceed as follows:

1. Start monitoring by clicking the "Monitor all" button.
The additional "Monitor value" column is displayed in the table. This shows the current data 
values. 
See also: Structure of the declaration table for data blocks (Page 1641) 

2. End the monitoring by clicking the "Monitor all" button again.

 

Displaying data values loaded from the device
During the loading of a data block from a device, the current tag values are also loaded. You 
can display these values. 

Requirement
A data block was loaded from the device.

Procedure
To display the current values, follow these steps:

1. Open the data block.

2. Click a column header.

3. In the shortcut menu, select the "Show/hide columns" command.
The selection of available columns is displayed.

4. Select the check box in the "Snapshot" column.

Result
The current values will be applied in the "Snapshot" column.

 

 Note

If you subsequently change the structure of the data block, the display of the current values 
gets lost. The "Snapshot" column will then be empty.
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Setting data values during commissioning

Basic information on adjusting data values during commissioning

Introduction  
During commissioning of a plant, data values have to be frequently adjusted in order to 
optimally adapt the program to the general operating conditions on site. The declaration table 
for data blocks offers the following functions for this purpose:

● Initialize data values in "RUN" mode
This function enables you to change data values online in order to quickly determine the 
optimum tag values.

● Transfer tag values from the online program to the offline program as start values
When you have determined the optimum tag values, you can apply these as start values 
in the offline program. This allows you to ensure that the program starts with the optimized 
values the next time it is loaded.

To use the function, first define specific tags as "Setting values" in the program. Setting values 
are the values that will probably have to be fine tuned during commissioning. 

 

Marking data as values that can be set
You can mark specific tags in the program as "Setting values". Setting values are the values 
that will probably have to be fine tuned during commissioning.

Rules  
You can mark tags as "Setting value" in the following block types:

● In function blocks (FB), but only in the "Static" section

● in global data blocks (DB)

● in PLC data types (UDT)
In the case of PLC data types (UDT), however, the setting is only effective, if the UDT is 
used in the "Static" section of a function block or data block.

It is not possible to define setting values in the following block types:

● In data blocks based on a PLC data type, and in instance data blocks. These inherit the 
setting from the higher-level FB or UDT.

● You cannot mark tags as a "Setting value" in ARRAY data blocks.

● You also cannot mark tags as a "Setting value" at the call point of a multi-instance. You 
have to make the setting in the interface of the function block that is called as multiple 
instance.

● You cannot change the "Setting value" marking in know-how-protected blocks. To do so, 
you must first remove the know-how protection.

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1663



Requirement
A function block, a global data block or a PLC data type (UDT) is open.

Procedure
To mark a tag as "Setting value", follow these steps:

1. Select a tag from the "Static" section.

2. Select the check box in the "Setting value" column.

– You cannot define the higher-level element of a structure or a PLC data type as "Setting 
value". You have to make the setting for the lower-level elements individually.

– In the case of ARRAYs, you can only mark the higher-level element as "Setting value". 
The lower-level elements inherit the setting.

– For ARRAYs of STUCT, you can only mark the elements below the first structure as 
setting values. The elements of other structures inherit the setting.

Result
The tags are marked as setting values. During commissioning, these tags can be initialized 
online. You do not need to set the CPU to "STOP" mode; it can remain in "RUN". In addition, 
the current tag values can be transferred as start values to the offline program and saved there.

Initializing setting values in the online program

Basics on initializing setting values
You can initialize all tags marked as a "Setting value" with new values in the online program. 
At the same time, the start values will be loaded from the offline program to the online program. 
The CPU remains in "RUN" mode. All tags that are marked as a setting value are initialized 
once at the next cycle control point. This applies both to retentive and non-retentive tags. The 
program execution is then continued with the new tag values.

 

 DANGER

Danger when changing tag values

Changing the tag values while the plant is operating can cause serious damage to property 
or injury to persons if there are functional disturbances or program errors!

Make sure that no dangerous situations can arise before you re-initialize the setting values.
 

Requirement
● An online connection to the CPU exists.

● The structure of the data block is identical offline and online.

● One or more tags are marked as a "Setting value".
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Procedure
To initialize all setting values of the data block, follow these steps:

1. Open a global data block or an instance data block.

2. Enter the desired values in the "Start value" column. The start values must correspond to 
the indicated data type.

3. Click the "Initialize setting values" button.

Result
The setting values in the online program are initialized with the start values from the offline 
program at the next cycle control point.

The maximum number of tags that can be initialized is dependent on the CPU. If too many 
setting values are marked, an alarm informs you about this. In this case, you can insert the 
tags in a watch table and initialize them using the "Modify" function in the watch table. 
Alternatively, you can also load the entire data block. For more information on this, refer to 
"See also".

See also
Loading changed values (Page 1651)

Applying values from the online program as start values
In order to apply tag values from the online program to the offline program as start values, first 
create a snapshot of the tag values from the online program. You can then apply them to the 
offline program. Note that the values from the snapshot are always copied. There is no check 
to determine whether all values originate from the same cycle. 

Write-protected start values are not overwritten.

You have the following basic options for applying the values:

● Applying the values of an open data block
You can apply all values or only the values of the tags marked as a "setting value" as start 
values in an open data block.

● Applying the values of multiple blocks in the project tree
You can either apply all setting values or all retentive values as start values in the project 
tree.

Requirement  
● An online connection to the CPU is available.

● As least one data block has been loaded to the CPU.
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Procedure
In order to apply all values or only the values of the tags marked as a "setting value" in a data 
block, follow these steps:

1. Open the data block.

2. Start monitoring by clicking the "Monitor all" button.
The "Monitor value" column is displayed in the table. This shows the current data values. 

3. On the toolbar, click "Snapshot of monitored values".
The latest monitored values will be applied in the "Snapshot" column.

4. Click one of the following buttons on the toolbar:

– "Apply setting values from the snapshot as start values"

– "Apply all values from the snapshot as start values"

The values from the "Snapshot" column are applied to the "Start value" column. 

 

To apply the monitored values of multiple data blocks in the project tree, follow these steps:

1. Select the blocks in the project tree.

2. Select the "Snapshot of the monitored values" command in the shortcut menu.
The current monitored values of all selected blocks will be applied in the "Snapshot" column.
An alarm is shown in the Inspector window after the operation is complete.

3. Then select one of the following commands in the shortcut menu:

– "Apply monitor values as start values > Only setpoints"

– "Apply monitor values as start values > Only retain values"

The values from the "Snapshot" column are applied to the "Start value" column.

Result
The new start values are stored in the offline program. 

 

 Note
Applying values of individual tags 

You can also transfer the values of individual tags that were not marked as a setting value 
beforehand from the "Snapshot" column to the "Start values" column. Use the "Copy" and 
"Paste" commands from the shortcut menu to copy the values and insert them in the "Start 
value" column. Note that only the values that are currently located in the visible area of the 
table are copied. 

 

See also
Basic information on start values (Page 1649)

Define start values (Page 1650)
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9.1.4.4 Programming PLC data types

Basics of PLC data types

Description
PLC data types are data structures that you define and that can be used multiple times within 
the program. The structure of a PLC is made up of several components, each of which can 
contain different data types. You define the type of components during the declaration of the 
PLC data type.

You can create up to 65534 PLC data types for a CPU of the S7-1200 or S7-1500 series. Each 
of these PLC data types can include up to 252 components.

PLC data types can be used for the following applications:

● PLC data types can be used as data types for variables in the variable declaration of logic 
blocks or in data blocks.

● PLC data types can be used as templates for the creation of global data blocks with identical 
data structures.

● PLC data types can be used in S7-1200 and S7-1500 as a template for the creation of 
structured PLC tags.

See also
Creating PLC data types (Page 1668)

Structure of the declaration table for PLC data types

Structure of the declaration table for PLC data types   
The figure below shows the structure of the declaration table for PLC data types.
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Meaning of the columns
The following table shows the meaning of the individual columns. You can show or hide the 
columns as required. The number of columns displayed varies depending on the CPU 
series.

Column Explanation
Symbol you can click to move or copy the tag. 

Name Name of the tags.
Data type Data type of the tags.
Default value Value with which you predefine the tag in the declaration of the PLC data type.

Specification of the default value is optional. If you do not specify any value the 
predefined value for the indicated data type is used. For example, the value "false" 
is predefined for BOOL.

Visible in HMI Shows whether the tag is visible by default in the HMI selection list.
Accessible from 
HMI

Shows whether HMI can access this tag during runtime.

Setting value Setting values are the values that will probably have to be fine tuned during 
commissioning. After commissioning, the values of these tags can be transferred 
to the offline program as start values and stored there. 

Comment Comment to document the tags.

See also
Creating PLC data types (Page 1668)

Show and hide table columns (Page 1675)

Creating PLC data types

Requirement  
The "PLC data types" folder opens in the project tree.

Procedure
To create a PLC data type, proceed as follows:

1. In the "PLC data types" folder, click the "Add new data type" command.
A new declaration table for creating a PLC data type will be created and opened.

2. Select the PLC data type and select the "Rename" command in the shortcut menu.

3. Enter the name of the PLC data type.

Result
The new PLC data type is created. You can find the PLC data type in the project tree in the 
"PLC data types" folder.
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See also
Structure of the declaration table for PLC data types (Page 1667)

Basics of PLC data types (Page 1667)

Delete PLC data types

Requirement
The PLC data type you want to delete is not open.

Procedure  
To delete a PLC data type, follow these steps:

1. In the project tree, open the "PLC data types" folder.

2. Select the PLC data type to be deleted. You can also select several PLC data types by 
clicking on them one after the other while holding down the <Ctrl> key or by pressing and 
holding down <Shift> and clicking on the first and last data type.

3. Select the "Delete" command in the shortcut menu.
 

 Note

If you delete a PLC data type, the blocks that use the data type will become inconsistent. 
These inconsistencies are marked in red in the block used. To remedy these inconsistencies, 
the data blocks have to be updated.

See also:

Updating the block interface (Page 1503)

Updating data blocks (Page 1644)
 

Programming the structure of PLC data types

Declaring tags of elementary data type

Requirement  
A PLC data type is open. 
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Procedure
To declare a tag, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the required data type in the "Data type" column. You will be supported by 
autocompletion during input. 

3. Optional: Change the properties of the tags that are displayed in the other columns.

4. Repeat steps 1 to 3 for all tags that are to be declared.

See also
Editing tables (Page 342)

Declaring tags of the ARRAY data type

Requirement   
A PLC data type is open. 

Procedure
To declare a tag of the ARRAY data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the "Array" data type in the "Data type" column. You will be supported by 
autocompletion in this step.
The "Array" dialog opens.

3. In the "Data type" text box, specify the data type of the array elements.

4. In the "ARRAY limits" text box, specify the high and low limit for each dimension.
Example of a one-dimensional ARRAY:
[0..3]
Example of a three-dimensional ARRAY:
[0..3, 0..15, 0..33]

5. Confirm your entry.

6. Optional: Change the properties of the tags that are displayed in the other columns.
 

 Note

You cannot define specific default values for ARRAY elements. You can, however, assign 
them start values at the usage point in the data block.

 

See also
Structure of the declaration table for PLC data types (Page 1667)
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Declaring tags of STRUCT data type 

Requirements   
A PLC data type is open. 

Procedure
To declare a tag of the STRUCT data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter "Struct" in the "Data type" column. You will be supported by autocompletion during 
input.
An empty, indented row is inserted after the new tag.

3. Insert the first structural element in the first empty row.
An additional empty row is inserted after the element.

4. Select a data type for the structure element.

5. Optional: Change the properties of the structural element that is displayed in the other 
columns.

6. Repeat steps 3 to 5 for all additional structure elements.
It is not necessary to end the structure explicitly. The structure ends with the last element 
that is entered.

7. To insert a new tag after the structure, leave a blank row after the end of the structure and 
then start the new tag in the second empty row.

Result
The tag of STRUCT data type is created.

See also
STRUCT (Page 1355)

Structure of the declaration table for PLC data types (Page 1667)

Declaring tags based on a different PLC data type

Requirements  
● A global data block is open. 

● A PLC data type is declared in the current CPU.
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Procedure
To declare a tag based on a different PLC data type, follow these steps:

1. Enter a tag name in the "Name" column.

2. Enter the PLC data type in the "Data type" column. You will be supported by autocompletion 
during input.

Result
The tag is created.

 

 Note

You define the default values of tags within a PLC data type when the PLC data type is 
created. You cannot change these values at the point of use of the PLC data type.

 

See also
Basics of PLC data types (Page 1667)

Structure of the declaration table for PLC data types (Page 1667)

Editing tag properties in PLC data types

Properties of tags in PLC data types

Properties   
The following table gives an overview of tag properties in PLC data types:

Group Property Description
General Name Name of the tags.

Data type Data type of the tags.
Default value Default value of the tag in the interface of a higher-level 

code block or in a PLC data type. 
The values contained in the "Default value" column can 
only be changed in the higher-level code block or PLC 
data type. The values are only displayed in the data block. 

Start value Not relevant in PLC data types
Comment Comment on the tag.

Attributes Retain Not relevant in PLC data types
Visible Indicates whether a parameter is visible in CFC.
Configurable Indicates whether a parameter is configurable in CFC.
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Group Property Description
For test Indicates whether a parameter is registered for the CFC 

test mode.
Interconnectable Indicates whether a parameter is interconnectable in CFC.

See also
Changing the properties of tags in PLC data types (Page 1673)

Basics of PLC data types (Page 1667)

Structure of the declaration table for PLC data types (Page 1667)

Changing the properties of tags in PLC data types

Editing general properties in the declaration table   
To edit the general properties of one or more tags, follow these steps:

1. Open the PLC data type.

2. Change the entries in the columns.

Editing detailed properties in the properties window
To edit the detailed properties of an individual tag, follow these steps:

1. Select a tag in the table.

2. Select the "Properties" command in the shortcut menu.
The inspector window shows the properties of the tag in the "General" and "Attributes" 
areas.

3. Select the required area in the area navigation.

4. Change the entries in the text boxes.

See also
Updating the block interface (Page 1503)

Updating data blocks (Page 1644)
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Editing the declaration table for PLC data types

Inserting table rows

Procedure  
Proceed as follows to insert a row above the selected row: 

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button on the toolbar of the table.

Result
A new row is inserted above the selected row. 

Inserting table rows

Procedure  
Proceed as follows to insert a row below the selected row:

1. Select the row below which you want to insert a new row.

2. Click the "Add row" button on the table toolbar.

Result
A new empty row will be inserted below the selected row.

Deleting tags

Procedure   
Follow the steps below to delete elements:

1. Select the row with the element to be deleted. You can also select several rows by clicking 
on them one after the other while holding down the <Ctrl> key or by pressing and holding 
down <Shift> and clicking on the first and last row.

2. Select the "Delete" command in the shortcut menu.

See also
Updating the block interface (Page 1503)

Updating data blocks (Page 1644)
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Automatically filling in successive cells
You can load the contents of one or several table cells into the cells below, automatically filling 
in the successive cells. 

If you automatically fill in cells in the "Name" column, a consecutive number will be appended 
to each name. For example, "Motor" will become "Motor_1".

You can define individual or more cells as well as entire rows as source area.

If less rows exist in the open table than you want to fill, then you will first have to insert additional 
empty rows. 

Requirement
● The table is open.

● Sufficient declaration rows are available.

Procedure  
To automatically fill in successive cells, follow these steps:

1. Select the cells to be loaded.

2. Click the "Fill" symbol in the bottom right corner of the cell.
The mouse pointer is transformed into a crosshair.

3. Keep the mouse button pressed and drag the mouse pointer downwards over the cells that 
you want to fill in automatically.

4. Release the mouse button.
The cells are filled in automatically. 

5. If entries are already present in the cells that are to be automatically filled in, a dialog 
appears. In this dialog you can indicate whether you want to overwrite the existing entries 
or insert new rows for the new tags.

Show and hide table columns
You can show or hide the columns in a table as needed.

Procedure     
To show or hide table columns, follow these steps:

1. Click a column header.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.
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9.1.4.5 Using external source files

Basics of using external source files

Function 
The textual programming languages STL and SCL allow you to enter the program code in any 
ASCII editor and save it as an external source file. This enables you to perform a range of 
tasks, for example:

● Declaring tags

● Specify block properties

● Programming blocks

You can import these source files to your project and use them to generate blocks. You can 
generate a number of different blocks from one source file. Observe the following special 
features when generating blocks from a source file:

● A block that exists under the same name in the project will be overwritten.

● Always name organization blocks according to their type, e.g., "Main" or "Cyclic interrupt" 
so that the event assignment is retained. If you are using multiple organization blocks of 
the same type, you can add underscores and numbers to the name, e.g., "Main_2" or 
"Main_2_1".

● If a block was programmed with its absolute block number instead of a symbolic name in 
the source file and this number is already assigned by a block in the project, the new 
generated block is initially assigned the next free symbolic name.

● If you have not explicitly defined the access mode for a block in the external source file, 
the block access mode is set depending on the CPU series used:

– Blocks generated for a CPU of the S7-1200/1500 series are assigned "optimized" 
access mode by default.

– Blocks generated for a CPU of the S7-300/400 product range are assigned "standard" 
access mode by default.

Organization blocks are the exception in this case, as they are always assigned the 
"standard" access mode by default, regardless of the CPU series. You have the option of 
changing the block access mode manually.

● It is possible that not all comments from the source file will be applied in the block. 

● If you use absolute addressing in the external source file, a symbolic tag is created for each 
absolute address during the generation of the block. The names of these tags are made 
up of "Tag_" and a time stamp. This may result in relatively long tag names, which you can 
change manually if required.

● If you are using instructions in a different version in the external source file than in the target 
device, this may result in compilation errors. Correct the respective instructions in this case 
and start the compilation process once again. You can also select a different version for 
the target device.

You also have the option of saving existing blocks as external source files. 
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See also
Rules for programming external source files  (Page 1677)

Saving blocks as external source files (Page 1678)

Inserting external source files (Page 1679)

Opening and editing external source files (Page 1679)

Generating blocks from external source files (Page 1680)

Rules for programming external source files 
An external source file basically consists of continuous text. To compile the source into blocks, 
certain structures and syntax rules must however be adhered to.

Syntax rules   
The syntax of the instructions in external source files is very similar to that in the creation of 
user programs in the program editor with STL or SCL. Note, however, the following additional 
syntax rules:

● Block call
When calling a block, transfer the parameters in the defined order in the ASCII editor. If 
you do not, the comment assignments for these lines may not match.
Enter the parameters in brackets. The individual parameters are separated by a comma. 

● Upper or lower case
The program editor generally disregards upper or lower case. Jump labels are an exception 
to this. Character string entries are also case-sensitive ("STRING" data type). Keywords 
are displayed in upper case. For compilation purposes, however, case is disregarded; you 
can therefore specify keywords in upper or lower case or a mixture of the two.

● Semicolon
Mark the end of every instruction and every tag declaration with a semicolon. You can enter 
several instructions per line.

● Forward slashes
Begin every comment with two forward slashes (//) and end the comment with the <Enter> 
key.

 

See also
Basics of using external source files (Page 1676)

Saving blocks as external source files (Page 1678)

Inserting external source files (Page 1679)

Opening and editing external source files (Page 1679)

Generating blocks from external source files (Page 1680)
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Saving blocks as external source files
Depending on the programming language used for the block, you have the following options 
for storing blocks as external source files:

● STL and SCL: copy a block as text

● SCL: generate external source file from one or more blocks

Copying a block as text     
To copy a block as text and export it to an external source file, follow these steps:

1. In the project tree, right-click on the block you want to export to an external source file.

2. Select the "Copy as text" command in the shortcut menu.

3. Open an external text editor.

4. Paste the copied text from the clipboard.

5. Save the file with one of the following file name extensions:

– ".scl" if you wish to generate a source file for SCL

– ".stl" if you wish to generate a source file for STL

Generating an external source file from SCL blocks
To generate an external source file from SCL blocks, follow these steps:

1. In the project tree or in the overview window, select the SCL blocks from which you want 
to generate an external source file.

2. Select the "Generate source from blocks" command from the shortcut menu.
The "Generate source from blocks" dialog opens.

3. Specify a path and a name for the external source.

4. Click "OK".

You can also generate an external source file from an open SCL block. To do this, follow these 
steps:

1. Click on the "Generate source from block" button in the programming editor.
The "Generate source from blocks" dialog opens.

2. Specify a path and a name for the external source.

3. Click "OK".

Result
The block has been saved as an external source file. You can include this source file in a 
project in the TIA portal and use it to generate other blocks. However, please note that you 
can use STL source files only in S7-300/400/1500 CPUs. 
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See also
Basics of using external source files (Page 1676)

Rules for programming external source files  (Page 1677)

Inserting external source files (Page 1679)

Opening and editing external source files (Page 1679)

Generating blocks from external source files (Page 1680)

Inserting external source files

Requirement
● An external source file is available and complies with the syntax and structure rules.

● The "External source files" folder is open in the project tree.

Procedure
Follow these steps to insert an external source file:

1. Double-click on the "Add new external file" command.
The "Open" dialog box is opened.

2. Navigate to and select existing external source files.

3. Confirm your selection with "Open".

Result
The new source file will be added to the "External source files" folder. 

See also
Basics of using external source files (Page 1676)

Rules for programming external source files  (Page 1677)

Saving blocks as external source files (Page 1678)

Opening and editing external source files (Page 1679)

Generating blocks from external source files (Page 1680)

Opening and editing external source files
By linking the files with the file name extensions "stl" and "scl" to an editor you will be able to 
open and edit external source files with these formats directly. Use Notepad as editor because 
other text editors may not let you open several sources at the same time. 

This means you do not need to insert the external source files again after editing.
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Linking files with the file name extensions "stl" and "scl" file types to an editor
Proceed as follows to link files with the file name extensions "stl" and "scl" to an editor:

1. Open Windows Explorer.

2. Right-click on an STL file.

3. Select "Properties" in the shortcut menu.
The "Properties" dialog box opens.

4. Click "Change" in the "File type" area on the "General" tab.
The "Open with" dialog box opens.

5. Select the text editor you want to link to the "stl" file type.

6. Confirm your selection with "OK".

7. Close the "Properties" dialog with "OK".

8. Repeat steps 2 to 7 with an SCL file.

Opening and editing an external source file
To open an external source file, follow these steps:

1. Open the "External source files" folder in the project tree.

2. Double-click on the external source file you want to open.
The external source file will open in the linked editor and can be edited. 

See also
Basics of using external source files (Page 1676)

Rules for programming external source files  (Page 1677)

Saving blocks as external source files (Page 1678)

Inserting external source files (Page 1679)

Generating blocks from external source files (Page 1680)

Generating blocks from external source files

Requirement   
● The "External source files" folder is open in the project tree.

● An external source file is available.

Procedure
To generate blocks from an external source file, follow these steps:

1. Open the external source file from which you wish to generate blocks.

2. Select the "Generate blocks from source" command in the "Edit" menu.
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3. A prompt will appear telling you any existing blocks will be overwritten.

4. Confirm the safety prompt with "Yes".

Result 
The external source file blocks will be generated and inserted in the "Program blocks" folder 
in the project tree. In the event of errors, information about the errors which have occurred will 
be displayed in the inspector window. This information, however, relates to the external source 
file and not to the block generated.

See also
Basics of using external source files (Page 1676)

Rules for programming external source files  (Page 1677)

Saving blocks as external source files (Page 1678)

Inserting external source files (Page 1679)

Opening and editing external source files (Page 1679)

9.1.5 Comparing PLC programs

9.1.5.1 Basic information on comparing PLC programs

Introduction to comparing PLC programs

Function
You can compare the following objects of a PLC program in order to detect any differences: 

● Code blocks with other code blocks

● Data blocks with other data blocks

● PLC tags of a PLC tag table with the PLC tags of another PLC tag table

● PLC data types with other PLC data types
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Types and levels of comparison
Two different basic types of comparison can be used:

● Online/offline comparison:
The objects in the project are compared with the objects of the corresponding device. An 
online connection to the device is necessary for this comparison. 

● Offline/offline comparison:
The objects of two devices either within a project or from different projects or libraries are 
compared. No online connection is required for this comparison.

Please note that you cannot carry out an unlimited number of comparisons at the same time, 
but only one comparison per comparison type (online/offline or offline/offline).

You can choose between the following levels of comparison depending on how in-depth an 
object comparison you require:

● Compare editor

● Detailed comparison

When you start a comparison, you will first receive an overview in the compare editor. For 
some comparison objects, you can then start a detailed comparison in which the objects 
compared will be opened side-by-side, each in its own program editor instance. Any differences 
will be highlighted. 

The table below gives an overview of the types and levels of comparison you can apply for 
each object:

Object Online/offline Offline/offline
Compare editor Detailed 

comparison
Compare editor Detailed comparison

LAD block X X X X
FBD block X X X X
STL block1 X X X X
SCL block X X3 4 X X
GRAPH block2 X X4 X X5

Global data block X X X X
Instance data 
block

X X X X

PLC tags - - X X
PLC data type X4 X4 X X
Legend:
X: available
-: not available
1: STL is not available for S7-1200
2: GRAPH is not available for S7-1200
3: not for S7-1200 prior to version 2.0
4: not for S7-300/400
5: only comparable with a GRAPH block from the same CPU family
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 Note
Please note the following:
● You cannot perform a detailed comparison for know-how protected blocks.
● If the detail comparison detects differences only with respect to the data types of local 

tags, with offline being an interrupt data type (C_ALARM C_ALARM_S C_ALARM_8 
C_ALARM_8P C_ALARM_T C_AR_SEND C_NOTIFY C_NOTIFY_8P) and online a 
DWORD, this difference is not marked as such.

● You cannot run a detailed comparison for types and master copies from libraries.
 

 

See also
Basics of project data comparison (Page 389)

Comparison of code blocks (Page 1683)

Comparison of data blocks (Page 1684)

Comparing PLC tags and PLC data types (Page 1685)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Comparison of code blocks

Introduction
The blocks to be compared in a code block comparison are assigned for comparison on the 
basis of the following criteria:

● Online/offline comparison: Addresses, e.g. FB100

● Offline/offline comparison: Symbolic names of the blocks

The comparison involves an evaluation of the block time stamps. The results are displayed as 
an overview in the comparison editor. You can then use actions to define what is to be done 
about the differences. You can also start detailed comparisons for the individual blocks. The 
versions of a block compared are opened beside each other and the differences are highlighted.

For the comparison of code blocks, both the block interfaces and the individual networks are 
compared. Any differing tag names are also determined. All comments and other block 
attributes are excluded from an online/offline comparison.

If the block interface changes, the time stamp of the code block interface will also change. This 
change means a change in the time stamp of the program code. The first step in comparing 
block interfaces is therefore a comparison of the program code time stamps. If these time 
stamps are the same, it is assumed that the interfaces are the same. If the time stamps of the 
interfaces differ, the next step is to compare the data types of the interfaces, section by section. 
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Multiple instances and PLC data types are included in the comparison. If the data types in the 
sections are the same, the start values of the tags are compared. All differences are displayed. 

When networks are compared, first inserted or deleted networks are detected. Then the other 
networks are compared. Instructions are the same if the operator and operand are the same. 
The first difference in each instruction is displayed. However, several differences per network 
can be displayed. 

See also
Introduction to comparing PLC programs (Page 1681)

Comparison of data blocks (Page 1684)

Comparing PLC tags and PLC data types (Page 1685)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Comparison of data blocks

Introduction   
The blocks to be compared in a data block comparison are assigned for comparison on the 
basis of the following criteria:

● Online/offline comparison: Addresses, e.g. DB100

● Offline/offline comparison: Symbolic names of the blocks

The first step in data block comparison is comparing the time stamps of the data block. If these 
time stamps are the same, it is assumed that the data structures are the same. If the time 
stamps differ, the structures are then compared until the first difference is found. If the data 
structures in the sections are the same, the initial and current values of the tags are then 
compared. All differences are displayed. Any differing tag names are also determined. 
Comments and PLC data type structures used in the data block are not included in the 
comparison. 

See also
Introduction to comparing PLC programs (Page 1681)

Comparison of code blocks (Page 1683)

Comparing PLC tags and PLC data types (Page 1685)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)
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Comparing PLC tags and PLC data types

Introduction
The device PLC tag tables and the device PLC data types will also be shown in the comparison 
editor if you carry out an offline/offline comparison.  The PLC tag tables and the PLC data 
types will be matched by name and you will receive the following information:

● Status: A symbol shows whether the PLC tags/PLC data types are identical or differ.

● Missing PLC tag tables / PLC data types: You can see at a glance whether the PLC tag 
tables / PLC data types are available in both devices.

You obtain the following information with an online/offline comparison of CPUs of the 
S7-1200/1500 series:

● PLC tags: A symbol shows whether the PLC tags are identical or differ. Because PLC tag 
tables are not downloaded to the device during loading, they cannot be displayed during 
an online/offline comparison.

● PLC data types: You receive the status symbol for each PLC data type. You can see at a 
glance whether the PLC data types are available in both devices.

See also
Introduction to comparing PLC programs (Page 1681)

Comparison of code blocks (Page 1683)

Comparison of data blocks (Page 1684)

Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

9.1.5.2 Comparing blocks

Comparing blocks in the compare editor
You have the following options for comparing blocks in the compare editor:

● Online/offline comparison
The blocks in the project are compared with the blocks of the selected device.

● Automatic offline/offline comparison
All blocks of the selected devices are compared offline. 

● Manual offline/offline comparison
The selected blocks of the devices are compared offline.
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Carrying out an online/offline comparison of blocks
To perform an online/offline comparison, follow these steps:

1. In the project tree, select a device that allows online/offline comparison.

2. Select the "Compare > Offline/online" command in the shortcut menu.

3. If you have not already established an online connection to this device, the "Go online" 
dialog opens. In this case, set all the necessary parameters for the connection and click 
"Connect". 
The online connection is established and the compare editor opens.

4. Open the "Program blocks" folder.
You can identify the status based on the symbols in the status and action area. You can 
define certain actions depending on the status of the objects. Note, however, that you can 
only perform actions in one direction in a synchronization action.

Carrying out an automatic offline/offline comparison of blocks
To perform an automatic offline/offline comparison of blocks, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. Open the "Program blocks" folder.
You can identify the status of the objects based on the symbols in the status and action 
area. You can define certain actions depending on the status of the objects. When you 
select an object, the object's properties and the corresponding object of the assigned device 
are clearly shown in the properties comparison.

You can drag any other device to the drop area at any time to perform further comparisons.

Carrying out a manual offline/offline comparison of blocks
To perform a manual offline/offline comparison of blocks, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane. The device to be 
compared can originate from the same project, a reference project or the library.

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the objects that you want to compare. 
The properties comparison is displayed. You can identify the status of the objects based 
on the symbols. You can define certain actions depending on the status of the objects.

You can drag any other device to the drop area at any time to perform further comparisons.
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See also
Introduction to comparing PLC programs (Page 1681)

Using the compare editor  (Page 391)

Comparing PLC tags (Page 1707)

Comparing PLC data types (Page 1708)

Performing detailed block comparisons

Starting a detailed comparison 
You can start a detailed comparison for blocks.  The versions of a block compared are opened 
beside each other and the differences highlighted. 

 

 Note

Please note the following:
● For blocks that are created in the programming language SCL, the detail comparison is 

not available for S7-1200 series CPUs with a version older than 2.0.
● You can only start the detailed comparison with the compare editor for blocks created in 

the GRAPH programming language.
 

 

Starting detailed comparisons using the compare editor 
To start a detailed comparison for a block using the compare editor, follow these steps:

1. First, perform an online/offline or an offline/offline comparison.
The compare editor opens.

2. In the compare editor, select the block for which you want to perform a detailed comparison.

3. Click the "Start detailed comparison" button in the toolbar.

Starting detailed comparisons in the program editor
For the comparison type online/offline, you can start the detailed comparison directly in the 
programming editor.  To do this, follow these steps:

1. Open the block for which you wish to carry out a detailed comparison.

2. Establish an online connection.
See also: Go online and Go offline

 

  Note

Please note that the block must be available online in order for you to be able to start the 
detailed comparison for the block within the programming editor.
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3. Click the "Detailed comparison" button in the toolbar.

4. Confirm the dialog for closing the block with "Yes".

Result
One instance of the program editor will be opened for each version of the block compared and 
the two instances are displayed side by side. Any differences will be highlighted. 

If there are structural differences for GRAPH blocks, the comparison results are only displayed 
up to the first structural difference in the sequence view.

See also
Carrying out offline/offline comparisons (Page 390)

Carrying out an online/offline comparison (Page 390)

Using the compare editor  (Page 391)

Visualization of the comparison result for LAD/FBD (Page 1688)

Navigating in the detailed comparison (Page 1704)

Changing blocks during detailed comparison (Page 1705)

Updating comparison results (Page 1706)

Visualization of the comparison result

Visualization of the comparison result for LAD/FBD

Introduction
The detailed comparison allows you to identify the exact places where versions of a block 
differ. The following color coding allows you to find these places as quickly as possible:

● The lines where there are differences are highlighted in gray.

● Differing operands and instructions are highlighted in green.

● If the number of networks differs, pseudo-networks are added to allow the display of 
identical networks to be synchronized. These pseudo-networks are highlighted in gray and 
contain the text "No corresponding network found" in the title bar of the network. Pseudo-
networks cannot be edited.

For the sake of clarity, not all the differences are highlighted but rather the first difference of 
an operation in each case. For example, if all the inputs in an instruction with multiple inputs 
are different in the offline and online versions of the block, only the first input is highlighted as 
a difference. You can resolve this difference and update the comparison list. The next input 
will then be highlighted as a difference.

The number of differences highlighted within a network therefore depends on the number of 
instructions.
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Structure of the detailed comparison
The following figure shows an example of the online/offline detailed comparison for the LAD 
programming language:

① Toolbar of the detailed comparison for LAD

② Reference block

③ Compared block

④ Comparison result in the Inspector window

The following figure shows an example of the online/offline detailed comparison for the FBD 
programming language:
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① Toolbar of the detailed comparison for FBD

② Reference block

③ Compared block

④ Comparison result in the Inspector window
 

 Note

Display of the symbolic names of the online version of the block is only possible for S7-1200 
and S7-1500.
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Toolbar of the detailed comparison
With the toolbar, you can access the following functions:

● General functions

– Insert network

– Delete network

– Insert row

– Add row

– Open all networks

– Close all networks

● Comparison-specific functions

– Position on first difference

– Position on previous difference

– Position on next difference

– Position on last difference

– Synchronize scrolling between editors

– Update comparison results

Reference block
The reference block is displayed in the left window. In an online/offline comparison, the 
reference block is the offline version of the block.

Compared block
The compared block is displayed in the right window. In an online/offline comparison, the 
compared block is the online version of the block.

Comparison result in the Inspector window
The differences are displayed in the form of a table in the "Info > Comparison result" tab of the 
Inspector window. Double-click on a row to navigate to the corresponding difference in the 
block.

See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Navigating in the detailed comparison (Page 1704)
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Changing blocks during detailed comparison (Page 1705)

Updating comparison results (Page 1706)

Visualization of the comparison result for STL

Introduction
The detailed comparison allows you to identify the exact places where versions of a block 
differ. The following color coding allows you to find these places as quickly as possible:

● The lines where there are differences are highlighted in gray.

● Differing operands and instructions are highlighted in green.

● If the number of networks differs, pseudo-networks are added to allow the display of 
identical networks to be synchronized. These pseudo-networks are highlighted in gray and 
contain the text "No corresponding network found" in the title bar of the network. Pseudo-
networks cannot be edited.
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Structure of the detailed comparison
The following figure shows an example of the online/offline detailed comparison for the STL 
programming language:

① Toolbar of the detailed comparison for STL

② Reference block

③ Compared block

④ Comparison result in the Inspector window
 

 Note

The display of the symbolic names of the online version of the block is only possible for 
S7-1500.
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Toolbar of the detailed comparison
With the toolbar, you can access the following functions:

● General functions

– Insert network

– Delete network

– Insert row

– Add row

– Open all networks

– Close all networks

● Comparison-specific functions

– Position on first difference

– Position on previous difference

– Position on next difference

– Position on last difference

– Synchronize scrolling between editors

– Update comparison results

Reference block
The reference block is displayed in the left window. In an online/offline comparison, the 
reference block is the offline version of the block.

Compared block
The compared block is displayed in the right window. In an online/offline comparison, the 
compared block is the online version of the block.

Comparison result in the Inspector window
The differences are displayed in the form of a table in the "Info > Comparison result" tab of the 
Inspector window. Double-click on a row to navigate to the corresponding difference in the 
block.

See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Navigating in the detailed comparison (Page 1704)
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Changing blocks during detailed comparison (Page 1705)

Updating comparison results (Page 1706)

Visualization of the comparison result for SCL

Introduction
The detailed comparison allows you to identify the exact places where versions of a block 
differ. The following color coding allows you to find these places as quickly as possible:

● The lines where there are differences are highlighted in gray.

● Differing operands and instructions are highlighted in green.
 

 Note

The online/offline detailed comparison is not available for the CPU families S7-300/400 and 
for S7-1200 with a version less than 2.0.
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Structure of the detailed comparison
The following figure shows an example of the online/offline detailed comparison for the SCL 
programming language:

① Toolbar of the detailed comparison for SCL

② Reference block

③ Compared block

④ Comparison result in the Inspector window
 

 Note

The display of the symbolic name of the online version of the block is only possible for S7-1200 
and S7-1500.
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Toolbar of the detailed comparison
With the toolbar, you can access the following functions:

● General functions

– Insert row

– Add row

● Comparison-specific functions

– Position on first difference

– Position on previous difference

– Position on next difference

– Position on last difference

– Synchronize scrolling between editors

– Update comparison results

Reference block
The reference block is displayed in the left window. In an online/offline comparison, the 
reference block is the offline version of the block.

Compared block
The compared block is displayed in the right window. In an online/offline comparison, the 
compared block is the online version of the block.

Comparison result in the Inspector window
The differences are displayed in the form of a table in the "Info > Comparison result" tab of the 
Inspector window. Double-click on a row to navigate to the corresponding difference in the 
block.

See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Navigating in the detailed comparison (Page 1704)

Changing blocks during detailed comparison (Page 1705)

Updating comparison results (Page 1706)
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Visualization of the comparison result for GRAPH

Introduction
The detailed comparison allows you to identify the exact places where versions of a block 
differ. When you start a detailed comparison for a GRAPH block, navigation is opened first. 
Use the dividers to toggle between the navigation and the currently set view. You can select 
other views with the toolbar of the detailed comparison.

The result of the comparison is indicated by the comparison symbols.

See also: Overview of the comparison editor (Page 391)

Structure of the detailed comparison
The following figure shows an example for the navigation view with an online/offline detailed 
comparison for the GRAPH programming language:
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① Toolbar of the detailed comparison for GRAPH

② Reference block

③ Compared block

④ Navigation toolbar

⑤ Dividers

⑥ Comparison result in the Inspector window

The following figure shows an example for the sequence view with an online/offline detailed 
comparison for the GRAPH programming language:

① Toolbar of the detailed comparison for GRAPH

② Reference block

③ Compared block

④ Dividers
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⑤ Comparison result in the Inspector window
 

 Note

If there are structural differences between the blocks, the comparison results are only 
displayed up to the first structural difference in the sequence view.

 

The following figure shows an example for the single step view with an online/offline detailed 
comparison for the GRAPH programming language:

① Toolbar of the detailed comparison for GRAPH

② Reference block

③ Compared block

④ Dividers
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⑤ Comparison result in the Inspector window
 

 Note

The result of the comparison refers to the complete network Differences within the networks 
are not identified.

 

The following figure shows an example for the view of permanent instructions with an online/
offline detailed comparison for the GRAPH programming language:

① Toolbar of the detailed comparison for GRAPH

② Reference block

③ Compared block

④ Dividers
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⑤ Comparison result in the Inspector window
 

 Note

The result of the comparison refers to the complete network Differences within the networks 
are not identified.

 

The following figure shows an example for the alarm view with an online/offline detailed 
comparison for the GRAPH programming language:

① Toolbar of the detailed comparison for GRAPH

② Reference block

③ Compared block

④ Dividers

⑤ Comparison result in the Inspector window
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Toolbars
With the toolbar of the detailed comparison, you can access the following functions:

● General functions

– Change to permanent pre-instructions

– Change to sequence view

– Change to single step view

– Change to permanent post-instructions

– Change to alarm view

– Open all networks

– Close all networks

● Comparison-specific functions

– Position on first difference

– Position on previous difference

– Position on next difference

– Position on last difference

– Synchronize scrolling between editors

– Update comparison results

The navigation has its own toolbar with the following functions:

● Zoom in or zoom out of elements within the navigation

● Synchronize navigation

Reference block
The reference block is displayed in the left window. In an online/offline comparison, the 
reference block is the offline version of the block.

Compared block
The compared block is displayed in the right window. In an online/offline comparison, the 
compared block is the online version of the block.

Dividers
You can click the dividers to toggle quickly between the navigation and the current view.

Comparison result in the Inspector window
The differences are displayed in the form of a table in the "Info > Comparison result" tab of the 
Inspector window. Double-click on a row to navigate to the corresponding difference in the 
block.
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See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Navigating in the detailed comparison (Page 1704)

Changing blocks during detailed comparison (Page 1705)

Updating comparison results (Page 1706)

Navigating in the detailed comparison

Requirement
You have run a detailed comparison.

Navigate to the differences   
To navigate to a difference between the two blocks, follow these steps:

1. Open the list of results for the detailed comparison under "Info > Comparison result" in the 
Inspector window.

2. Double-click a difference.
The difference is selected in both editors.

Or:
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1. Click one of the following navigation buttons on the toolbar:

– Position on first difference
Navigates to the first difference in the block, and displays the difference in both editors. 

– Position on previous difference
Navigates to the previous difference starting from the current position, and displays the 
difference in both editors. 

– Position on next difference
Navigates to the next difference starting from the current position, and displays the 
difference in both editors. 

– Position on last difference
Navigates to the last difference in the block, and displays the difference in both editors. 

Switching off/on the synchronization of the vertical scrolling between the editors   
The scrolling for both editors is synchronized to ensure that the corresponding networks are 
visible parallel to each other during vertical scrolling. You can switch this mode off and on. To 
do this, follow these steps:

1. To switch off synchronized scrolling, click the "Synchronize scrolling between editors" 
button in the toolbar.

2. To switch on synchronized scrolling again, click the "Synchronize scrolling between editors" 
button one more time in the toolbar.

See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Visualization of the comparison result for LAD/FBD (Page 1688)

Changing blocks during detailed comparison (Page 1705)

Updating comparison results (Page 1706)

Changing blocks during detailed comparison

Changing offline blocks  
You can change offline blocks that serve as a reference block of the comparison at any time. 
The compared block, on the other hand, is write protected and cannot be changed.

Changing online blocks
You cannot change online blocks. 

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1705



See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Visualization of the comparison result for LAD/FBD (Page 1688)

Navigating in the detailed comparison (Page 1704)

Updating comparison results (Page 1706)

Updating comparison results
As soon as you change an object, the comparison results are no longer valid and must be 
updated.

Requirement
You have run a detailed comparison.

Procedure
To update the comparison results, follow these steps:

1. Click "Update the comparison result" in the toolbar.

See also
Carrying out an online/offline comparison (Page 390)

Carrying out offline/offline comparisons (Page 390)

Using the compare editor  (Page 391)

Starting a detailed comparison  (Page 1687)

Visualization of the comparison result for LAD/FBD (Page 1688)

Navigating in the detailed comparison (Page 1704)

Changing blocks during detailed comparison (Page 1705)
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9.1.5.3 Comparing PLC tags
You have the following options for comparing PLC tags:

● Automatic offline/offline comparison in the compare editor
The PLC tag tables of the selected devices are compared offline. 

● Manual offline/offline comparison in the compare editor
The selected PLC tag tables of the devices are compared offline.

● Detailed comparison
Use the detailed comparison to determine differences within the PLC tag tables.

Performing automatic offline/offline comparison in the compare editor
To perform an automatic offline/offline comparison of PLC tag tables, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. Open the "PLC tags" folder.
You can identify the status of the PLC tag tables based on the symbols in the status and 
action area. You can define certain actions depending on the status. 

You can drag any other device to the drop area at any time to perform further comparisons.

Performing manual offline/offline comparison in the compare editor
To perform a manual offline/offline comparison of PLC tag tables, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the PLC tag tables that you want to compare. 
The properties comparison is displayed. You can identify the status based on the symbols.

You can drag any other device to the drop area at any time to perform further comparisons.
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Running a detailed comparison
To start a detailed comparison for a PLC tag table, follow these steps:

1. Perform an automatic or manual offline/offline comparison.

2. For an automatic offline/offline comparison in the compare editor, select the PLC tag table 
for which you want to run a detailed comparison. Note that two PLC tag tables must be 
selected for comparison for a manual offline/offline comparison.

3. Click the "Start detailed comparison" button in the toolbar.
A separate compare editor opens. All existing PLC tags of the selected PLC tag tables are 
displayed depending on the settings of the compare editor. User and system constants are 
not shown, however. You can identify the status of the PLC tags based on the symbols. 
You can define certain actions depending on the status of the PLC tags. 

See also
Introduction to comparing PLC programs (Page 1681)

Using the compare editor  (Page 391)

Comparing PLC data types (Page 1708)

9.1.5.4 Comparing PLC data types
You have the following options for comparing PLC data types:

● Online/offline comparison (S7-1200/1500 only)
The PLC data types in the project are compared with the PLC data types of the selected 
device.

● Automatic offline/offline comparison in the compare editor
The PLC data types of the selected devices are compared offline. 

● Manual offline/offline comparison in the compare editor
The selected PLC data types of the devices are compared offline.

● Detailed comparison
Use the detailed comparison to determine differences between PLC data types.

Performing online/offline comparison of PLC data types
To perform an online/offline comparison, follow these steps:

1. In the project tree, select a device that allows online/offline comparison.

2. Select the "Compare > Offline/online" command in the shortcut menu.
If you have not already established an online connection to this device, the "Go online" 
dialog opens. In this case, set all the necessary parameters for the connection and click 
"Connect". 
The online connection is established and the compare editor opens.

3. Open the "PLC data types" folder.
You can identify the status based on the symbols in the status and action area. When you 
select an object, the properties of the PLC data type and the corresponding PLC data type 
of the assigned device are displayed in the properties comparison.
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Performing automatic offline/offline comparison in the compare editor
To perform an automatic offline/offline comparison of PLC tag tables, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. Open the "PLC data types" folder.
You can identify the status of the PLC tag tables based on the symbols in the status and 
action area. You can define certain actions depending on the status. 

You can drag any other device to the drop area at any time to perform further comparisons.

Performing manual offline/offline comparison in the compare editor
To perform a manual offline/offline comparison of PLC data types, follow these steps:

1. Select a device in the project tree that allows offline/offline comparison.

2. Select the "Compare > Offline/offline" command in the shortcut menu.
The compare editor opens and the selected device is displayed in the left area.

3. Drag-and-drop an additional device to the drop area of the right pane.  The device to be 
compared can originate from the same project, a reference project or the library. 

4. In the status and action area, click on the button for switching between automatic and 
manual comparison.

5. Select the PLC data types that you want to compare. 
The properties comparison is displayed. You can identify the status based on the symbols.

You can drag any other device to the drop area at any time to perform further comparisons.

Running a detailed comparison
To start a detailed comparison for a PLC data type, follow these steps:

1. Perform an offline/offline comparison. You can also perform an online/offline comparison 
for CPUs of the S7-1200/1500 series. 

2. For an automatic offline/offline comparison in the compare editor, select the PLC data type 
for which you want to run a detailed comparison. Note that two PLC data types must be 
selected for comparison with a manual offline/offline comparison.

3. Click the "Start detailed comparison" button in the toolbar.
The two PLC data types are opened next to each other so that you can easily identify the 
differences. 
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See also
Introduction to comparing PLC programs (Page 1681)

Using the compare editor  (Page 391)

Comparing PLC tags (Page 1707)

9.1.6 Compiling and downloading blocks

9.1.6.1 Compiling blocks

Basic information on compiling blocks

Introduction
A user program must first be compiled before the CPU can execute it. You need to recompile 
your program each time you make a change.

The following procedures take place during compilation:

● The user program is checked for syntax errors.

● Unneeded instructions are removed from the user program.

● All the block calls within the compiled blocks are checked. In case of changes to the 
interface of called blocks, errors will be shown in the "Compilation" tab of the information 
window. You have to correct these errors first.

● The blocks must be numbered uniquely in the user program. If more than one block has 
the same number, the blocks with number conflicts are renumbered automatically during 
compilation. A block will not be renumbered in the following cases:

– The block was selected either individually or as part of a multiselection for the 
compilation. 

– The block is know-how protected.

– The number assignment is set to "manual" in the properties of the block.

Number conflicts that cannot be resolved by automatic renumbering must be corrected 
manually. Note the messages in the Inspector window for this. You can only correct know-
how-protected blocks manually if you know the password since the blocks must then be 
recompiled.

● Finally, the user program is compiled into a code that can be read by the CPU.
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Compilation methods
You can start compilation in the following windows or editors:

● Compiling blocks in the project tree
Serves to compile individual blocks or the simultaneous compilation of one or several blocks 
in the "Program blocks" folder. 

● Compiling blocks in the program editor
This is intended for compilation of a single open block.

● Compiling blocks in the call or dependency structure
Used to compile individual blocks.
See also: Call structure (Page 1742), Dependency structure (Page 1749)

Compilation options
If you are compiling blocks in project tree, you have further options:

● Software (changes only)
All program changes of the selected blocks are compiled. If you have selected a block 
folder, all program changes to the bocks contained in the folder are compiled.

● Software (compile all blocks)
All blocks are compiled. This is recommended for the first compilation and after major 
revisions. 

● Software (reset memory reserve)
All tags declared in the reserve area of the interface of selected blocks are moved to the 
standard area of the interface. Memory reserve is now available for further interface 
extensions.

 

  Note

This option is only available for CPUs of the S7-1500 and S7-1200 V4 series.
 

Consistency check 
Changing the interfaces of blocks called or PLC data types used can result in inconsistencies 
between calling blocks and called blocks or between the PLC data types and the global data 
blocks which use these PLC data types. 

To avoid such inconsistencies in the user program, the system performs an automatic 
consistency check before each compilation process.  The time stamps are compared and 
compilation is then either carried out or canceled depending on the results of the comparison.

● The calling block can only be compiled if the time stamps of the interfaces of the called 
blocks are older than those of the calling block.

● A global data block based on a PLC data type can only be compiled correctly if the time 
stamp of the global data block is newer than the time stamp of the PLC data type used.

● The instance data block can only be compiled correctly if the interface time stamps for the 
interface of the instance data block are identical to those of the assigned function block.

If the compilation process is cancelled, an alarm is displayed in the inspector window. Update 
the block calls in the relevant blocks and the PLC data types in the global data blocks and then 

Programming the PLC
9.1 Creating the user program

WinCC Professional V13.0
System Manual, 02/2014 1711



restart compilation. The consistency check also finds know-how protected blocks which cannot 
be compiled. The corresponding messages will also be shown in the inspector window.

If you start loading immediately instead of first compiling, the blocks selected will be 
automatically compiled and the block call and global data blocks implicitly updated. Please 
note the following differences between the CPU families:

● S7-1200/1500: All blocks affected are loaded to ensure no inconsistencies can arise.

● S7-300/400: Only the block selected is loaded.

 

See also
Compiling blocks in the project tree (Page 1712)

Compiling blocks in the program editor (Page 1713)

Correcting compilation errors (Page 1714)

Block time stamps (Page 1462)

Updating block calls in LAD (Page 1534)

Updating block calls in FBD (Page 1576)

Compiling project data (Page 379)

Compiling blocks in the project tree
You can compile one block, multiple blocks or all of the blocks in the project tree.

For CPUs of the S7-1500 and S7-1200 V4 series, you can also reset the memory layout of 
blocks with memory reserve by running a compilation. For more information on memory 
reserve, refer to chapter "Loading blocks (S7-1200/1500) > Loading block changes without 
reinitialization".

Requirement
The project tree is open. 

Compiling one or more blocks in the project tree     
To compile multiple blocks in the project tree, follow these steps:

1. Open the "Program blocks" folder in project tree.

2. Select the blocks you want to compile.

3. Select the "Compile > Software (only changes)" command from the shortcut menu.
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Compiling all blocks in the project tree
To compile all blocks in the "Program blocks" folder in project tree, follow these steps:

1. Select the "Program blocks" folder in the project tree.

2. You can select one of two different options for the compilation:

– If you want to compile only the changes since the last compilation, select the "Compile 
> Software (only changes)" command in the shortcut menu.

– If you want to compile all blocks completely, select the "Compile > Software (compile 
all blocks)" command in the shortcut menu.

Resetting memory layout (S7-1500/S7-1200 V4)
Proceed as follows to reset the memory layout of blocks:

1. Select the "Program blocks" folder, or specific blocks in this folder.

2. Select the "Compile > Software (Reset memory reserve)" command from the shortcut menu.

Result
The code for the blocks will be generated if the consistency check has been successful. 
Instance data blocks generated by the system which are no longer needed will be deleted.

The message under "Info > Compilation" in the inspector window reports whether the 
compilation was successful. 

See also
Basic information on compiling blocks (Page 1710)

Compiling blocks in the program editor (Page 1713)

Correcting compilation errors (Page 1714)

Finding syntax errors in the program (Page 1633)

Compiling blocks in the program editor
 

 Note

Note that the block is recompiled even if you have not made any changes and the time stamp 
of the block is modified.

 

Requirement  
The block to be compiled is open.
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Procedure
To compile a block in the program editor, follow these steps:

1. Right-click in the instruction window of the programming editor.

2. Select the "Compile" command in the shortcut menu.

Result
The code for the block is generated. Instance data blocks generated by the system which are 
no longer needed will be deleted. 

The message under "Info > Compilation" in the inspector window reports whether the 
compilation was successful. 

See also
Basic information on compiling blocks (Page 1710)

Compiling blocks in the project tree (Page 1712)

Correcting compilation errors (Page 1714)

Correcting compilation errors
 In the Inspector window in "Info > Compile", you can see whether any compilation was 
successful or whether errors were detected in the program. If errors occur, you will need to 
correct them and then start the compilation again. 

Procedure
To correct errors following compilation, follow these steps:

1. Open the error list in the Inspector window with "Info > Compile".

2. If there is one, click on the blue question mark next to the error text for information on 
remedying errors.

3. Double-click the error you want to correct.
The corresponding error is highlighted.

4. Correct the error.

5. Restart compilation. 

See also
Basic information on compiling blocks (Page 1710)

Compiling blocks in the program editor (Page 1713)

Compiling blocks in the project tree (Page 1712)
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9.1.6.2 Downloading blocks

Introduction to downloading blocks

Downloading blocks to device  
So that the CPU can execute the user program, the program must first be compiled and then 
downloaded to the device. The following options are available for downloading:

● Downloading blocks to the program editor
You can load a single open block in the program editor.

● Downloading blocks to the project tree
You can download several or all of the blocks in the block folder via the project tree.

During the loading operation, all information that is required for the reconstruction of the 
program, including symbolic information such as the names and comments for code and data 
blocks, is also loaded in the current project language. If you change the project language, you 
must therefore re-load the program. 

The symbolic information is not loaded to the work memory, but rather to the load memory. 

After the data has been loaded from a device, the symbolic information is available again in 
your program, which increases the readability of your program code. Please note, however, 
that loading to and from a device is not a substitute for storing data in an offline project, as 
watch tables or multi-language capability of projects cannot be reproduced by loading to and 
from a device.

After loading from a device, you can only display all data from know-how-protected blocks by 
entering the correct password.

 

 Note

To avoid inconsistencies between calling and called blocks, all blocks affected are compiled 
and loaded after each global change, such as a change in the block interface.

 

 
 

 Note
S7-1200 Version 1.0

If you download an element of your project to the CPU, for example a program block, a data 
block or the hardware configuration, the CPU runs a cold restart the next time it changes to 
RUN mode. Apart from deleting the inputs, initializing the outputs and deleting the non-
retentive memory, cold restart also deletes the retentive memory areas. All subsequent 
changes from STOP to RUN are warm restarts in which the retentive memory is not deleted.

 

 Note
S7-1500

The load memory of S7-1500 series CPUs is on the SIMATIC memory card. Therefore, a 
SIMATIC memory card absolutely must be inserted in order to operate the CPU.
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Uploading blocks from device
You can load the blocks of a device to your project. This is necessary, for example, if you want 
to edit blocks that only exist in this device. You have the option of loading either all available 
blocks (organization blocks, function blocks, functions and data blocks) and global PLC tags 
or individual blocks to the project.

Uploading blocks from or downloading blocks to a memory card
Memory cards are plug-in cards used with an S7-1200 series CPU, for example, to replace 
the load memory of a device. In the case of S7-1500 series CPUs, they contain the load 
memory. Only Siemens SD cards can be used for devices of the S7-1200 and S7-1500 product 
range.

To use a memory card as load memory, you must download the user program or individual 
blocks to a memory card. You can just as well upload blocks from a memory card back into 
the project. 

 

 Note
S7-1200

Note the following when uploading to or downloading from a memory card:
● If the CPU contains no previous program and you insert an empty memory card in the 

CPU the program will be loaded from the PG/PC to the memory card and not to the CPU.
● If you insert an empty memory card prior to the startup of the CPU, the program that is on 

the CPU will be transferred automatically to the memory card. The program on the CPU 
will then be deleted.

● If you insert a memory card with a program in the CPU prior to the startup of the CPU and 
the CPU already contains a program, the program on the memory card will be executed 
and not the program on the CPU. The program on the CPU will be deleted.

 

Loading GRAPH function blocks
If you load a GRAPH function block together with its instance data block, the processing of the 
sequencer starts over at the initial step. As a result, problems may occur when synchronizing 
the sequencer with the process. You can avoid these problems by switching off the sequencer 
before loading.

Loading block changes without reinitialization
It often proves necessary to edit or expand a PLC program that was already commissioned 
and that is running on the plant without error. Such operations should be performed without 
causing any major interruptions of current operations.

S7-1500 therefore offers the option of extending the interfaces of function or data blocks during 
runtime and loading the modified blocks without setting the CPU to STOP or affecting the value 
of tags that are already loaded. This is a simple means of implementing program changes. 
This load process (download without reinitialization) will not have a negative impact on the 
controlled process.
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Effects of a load operation on the tag values of a data blocks 
When data blocks are downloaded to a device in STOP mode, the next transition of the device 
to RUN affects the current tag values as follows:

● Tags not marked as being retentive retain their defined start values.

● Retentive tags of the S7-1200 only retain their values if the following conditions are met:

– You loaded the data block by means of "Download to device > Software (changes only)". 

– You made no changes to the DB structure. 

Otherwise the retentive tags will also retain their defined start values.

● Retentive tags of the S7-1500 only retain their values if the following conditions are met: 

– You loaded the data block by means of "Download to device > Software (changes only)". 

– You made no changes to the structure of the data block or modified it within the memory 
reserve.

Otherwise the retentive tags will also retain their defined start values.

Loading blocks with synchronization
In team engineering, it is possible for several users to work on one project with several 
engineering systems at the same time and access one S7-1500 CPU. To ensure consistency 
within the shared project, it is necessary to synchronize the changed data prior to loading so 
that nothing gets overwritten unintentionally.

If differences are determined between the online and offline data management within the 
shared project during loading that were caused by a different engineering system, automatic 
synchronization of the data to be loaded is offered during loading.

In this case, the "Synchronization" dialog displays the data to be synchronized with the current 
status (online-offline comparison) and the possible actions.

The following options are available for synchronization:

Application case Recommendation Synchronization
One or more blocks on the CPU (online) 
are more recent than in the engineering 
system (offline).

These blocks should be downloaded 
from the CPU to the engineering system 
before loading.

Automatic synchronization is possible:
The blocks in the engineering system 
are updated prior to loading.

One or more new blocks have been 
created and exist only in the CPU 
(online).

These blocks should be downloaded 
from the CPU to the engineering system 
before loading.

Automatic synchronization is possible:
The new blocks are added prior to the 
download in the engineering system.

One or more blocks on the CPU have 
been deleted.

The blocks should also be deleted prior 
to the download in the engineering 
system.

Automatic synchronization is not 
possible.
The blocks deleted on the CPU should 
be manually deleted in the offline project 
in the engineering system.
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Application case Recommendation Synchronization
One or more blocks on the CPU and in 
the engineering system are different.
This is the case when a different user 
has changed blocks to which you have 
also made corrections and has already 
downloaded them to the CPU. 

These blocks with competing changes 
must be adapted manually. You decide 
in this case which changes you are 
going to accept.
If the blocks on the CPU are to be 
retained, you should accept these 
blocks prior to download from the CPU 
to your engineering system.
If the blocks that you have changed are 
to be applied, you can continue with the 
download without synchronization. 

Automatic synchronization is not 
possible:
The affected blocks on the CPU or in the 
engineering system must be adapted 
manually. One of the existing block 
versions (online or offline) will be 
overwritten in the process.

There are differences in the hardware 
configuration on the CPU (online) and in 
the engineering system (offline).

Differences in the hardware 
configuration must be adapted 
manually. You decide in this case which 
hardware configuration you are going to 
accept.
If the existing hardware configuration on 
the CPU is to be retained, you should 
apply these in your engineering system 
prior to loading.
If you want to apply the changed 
hardware configuration, you can 
continue with the download without 
synchronization.

Automatic synchronization is not 
possible:
The hardware configuration must be 
adapted manually.
One of the existing hardware 
configurations (online or offline) will be 
overwritten in the process.

You can use the "Force download to device" command to download blocks without 
synchronization, if desired. 

Downloading blocks in the "RUN" operating mode to the device

Basics on downloading blocks in the "RUN" operating mode       
When you download modified blocks to the device, it is not always necessary to switch the 
device to the "STOP" operating mode. Prior to a download operation, the Engineering System 
checks whether the device must be stopped before downloading. The result of this check is 
displayed in the "Load preview" dialog. If it is necessary to change to the "STOP" operating 
mode, you cannot continue the download process until you have set the appropriate option. 

 

 Note

Actual parameters are not overwritten by a download process in the "RUN" operating mode. 
Changes to the actual parameters will not become effective until the next time you change 
the operating mode from "STOP" to "RUN".

 

The following table shows the actions after which you can execute the download process in 
the "RUN" operating mode:
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Action Download in "RUN" operating mode possible 
 S7-1200 S7-1500
Downloading individual blocks Yes Yes
Downloading all blocks No No
Adding or deleting OBs No Yes
Adding or deleting DBs, FCs or FBs Yes Yes
Changing block interfaces for FBs No Only within the 

memory reserve
Changing block interfaces for FCs Yes Yes
Changing the structure of a DB or an instance DB No Only within the 

memory reserve
Changing the hardware configuration No No
Changing the retentivity settings of bit memories and 
DBs

No No

Changing the program code of FC, FB or OB Yes Yes
Changing the attributes of OBs Yes Yes
Adding comments Yes Yes
Adding input, output or bit memory areas Yes Yes
Changing tag names Yes Yes
Maximum number of blocks that can be downloaded 
for the device used in "RUN" not exceeded

Yes Yes

See also
Downloading blocks from program editor to device (Page 1719)

Downloading blocks from the project tree to the device (Page 1721)

Downloading project data to a device (Page 383)

Downloading blocks from program editor to device

Requirement 
The block to be downloaded is open.
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Procedure 
To download a block from the program editor to the device, follow these steps:

1. Right-click in the instruction window of the programming editor.

2. Select the "Download to device" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog opens. In this case, set all parameters required for the connection and 
click "Load". You have the option of showing all compatible devices by selecting the 
corresponding option and clicking the "Start search" command. You can also open the 
"Extended download to device" dialog explicitly via the "Online" menu.
See also: Go online and Go offline 

– If you have already specified an online connection, then the project data is compiled if 
necessary and the "Load preview" dialog opens. This dialog displays messages and 
proposes actions necessary for loading.

3. Check the messages and, where necessary, enable the actions in the "Action" column.
 

  Note
Actions

Performing the proposed actions during ongoing plant operation can cause serious 
damage to property or injury to persons if there are functional faults or program errors.

Make sure that no dangerous situations can arise before you start the actions.
 

As soon as downloading becomes possible, the "Load" button is enabled.

4. Click "Load".
If there is a need for synchronization, the system automatically displays the 
"Synchronization" dialog. This dialog displays messages and suggests actions that are 
needed for the synchronization. You have the option of performing these actions or forcing 
the download without synchronization by clicking "Force download to device". If you have 
performed the suggested actions, you will be asked whether you want to continue with the 
download. Click "Continue download" in order to download the block. The "Load results" 
dialog then opens and shows you the status and the actions after the download operation.

5. If you want to start the modules again directly after downloading, select the "Start all" check 
box.

6. To close the "Load results" dialog box, click "Finish".

Result
The code for the block will be downloaded to the device. If the changes affect additional blocks, 
these will be compiled and also downloaded to the device. Blocks that only exist online in the 
device are deleted. Existing CPU data blocks are retained, however. Inconsistencies between 
the blocks in the user program are avoided by loading all blocks affected and deleting the 
unneeded blocks in the device.

The messages under "Info > General" in the Inspector window show whether the downloading 
process was successful. 
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See also
Downloading blocks from the project tree to the device (Page 1721)

Downloading project data to a device (Page 383)

Downloading blocks in the "RUN" operating mode to the device (Page 1718)

Downloading blocks from the project tree to the device
In the project tree you can download one block, multiple blocks or all blocks to a device.

Downloading one or more blocks from the project tree to the device   
To download one block or multiple blocks to the device from the project tree, follow these steps:

1. Open the "Program blocks" folder in project tree.

2. Select the blocks you want to download.

3. Select the "Download to device > Software (only changes)" command from the shortcut 
menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog opens. In this case, set all parameters required for the connection and 
click "Load". You have the option of showing all compatible devices by selecting the 
corresponding option and clicking the "Start search" command. You can also open the 
"Extended download to device" dialog explicitly via the "Online" menu.
See also: Go online and Go offline 

– If you have already specified an online connection, then the project data is compiled if 
necessary and the "Load preview" dialog opens. This dialog displays messages and 
proposes actions necessary for loading.

4. Check the messages and, where necessary, enable the actions in the "Action" column.
 

  Note

Performing the proposed actions during ongoing plant operation can cause serious 
damage to property or injury to persons if there are functional faults or program errors.

Make sure that no dangerous situations can arise before you start the actions.
 

As soon as downloading becomes possible, the "Load" button is enabled.

5. Click "Load".
If there is a need for synchronization, the system automatically displays the 
"Synchronization" dialog. This dialog displays messages and suggests actions that are 
needed for the synchronization. You have the option of performing these actions or forcing 
the download without synchronization by clicking "Force download to device". If you have 
performed the suggested actions, you will be asked whether you want to continue with the 
download. Click "Continue download" in order to download the block. The "Load results" 
dialog then opens and shows you the status and the actions after the download operation.

6. If you want to start the modules again directly after downloading, select the "Start all" check 
box.

7. To close the "Load results" dialog box, click "Finish".
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Downloading blocks from the project tree to the device
To download all blocks in the "Program blocks" folder to the device from the project tree, follow 
these steps:

1. Select the "Program blocks" folder in the project tree.

2. Select the "Download to device" submenu in the shortcut menu.

3. If you only want to download the changes since the last download, select the "Software 
(only changes)" option. If all blocks are to be fully loaded and all values are to be reset to 
their start values, select "Download PLC program to the device and reset".

– If you have not already established an online connection, the "Extended download to 
device" dialog opens. In this case, set all parameters required for the connection and 
click "Load". You have the option of showing all compatible devices by selecting the 
corresponding option and clicking the "Start search" command. You can also open the 
"Extended download to device" dialog explicitly via the "Online" menu.
See also: Go online and Go offline 

– If you have already specified an online connection, then the project data is compiled if 
necessary and the "Load preview" dialog opens. This dialog displays messages and 
proposes actions necessary for loading.

4. Check the messages and, where necessary, enable the actions in the "Action" column.
 

  Note

Performing the proposed actions during ongoing plant operation can cause serious 
damage to property or injury to persons if there are functional faults or program errors.

Make sure that no dangerous situations can arise before you start the actions.
 

As soon as downloading becomes possible, the "Load" button is enabled.

5. Click "Load".
If there is a need for synchronization, the system automatically displays the 
"Synchronization" dialog. This dialog displays messages and suggests actions that are 
needed for the synchronization. You have the option of performing these actions or forcing 
the download without synchronization by clicking "Force download to device". If you have 
performed the suggested actions, you will be asked whether you want to continue with the 
download. Click "Continue download" in order to download the block. The "Load results" 
dialog then opens and shows you the status and the actions after the download operation.

6. If you want to start the modules again directly after downloading, select the "Start all" check 
box.

7. To close the "Load results" dialog box, click "Finish".

Result
The code for the blocks is downloaded to the device. If the changes affect additional blocks, 
these will be compiled and also downloaded to the device. Blocks that only exist online in the 
device are deleted. Inconsistencies between the blocks in the user program are avoided by 
loading all blocks affected and deleting the unneeded blocks in the device.

The messages under "Info > General" in the Inspector window show whether the downloading 
process was successful. 
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See also
Downloading blocks from program editor to device (Page 1719)

Downloading project data to a device (Page 383)

Downloading blocks in the "RUN" operating mode to the device (Page 1718)

Uploading blocks from device
You can load either all blocks or individual blocks from a device into your project.

 

 Note

Note the following information:
● Please note that when you load individual blocks, no tags or other required blocks to which 

you may refer are loaded together with the individual blocks. During the loading operation, 
reference to tags and blocks are reassigned where possible based on the names. After 
the loading operation, check whether these assignments are correct.

● S7-1500: When GRAPH function blocks are loaded from a device to your project, the step-
specific alarm texts for the interlock and supervision alarms are not loaded.

 

Requirement
The online and offline versions of a block to be loaded are different or the blocks only exists 
online.

Uploading all blocks from a device
To upload all blocks from a device, follow these steps:

1. Establish an online connection with the device from which you want to upload the blocks.
See also: Establishing and terminating an online connection 

2. In the project tree, select the device folder from which you want to upload blocks.

3. In the "Online" menu, select the "Upload from device" command.
The "Upload preview" dialog box opens. This dialog displays alarms and proposes actions 
necessary for loading.

4. Check the alarms and, where necessary, enable the actions in the "Action" column.
The "Upload from device" button will be enabled as soon as uploading becomes possible.

5. Click on the "Upload from device" button.
The load is executed. 

Uploading individual blocks from a device
To upload individual blocks from a device, follow these steps:

1. Establish an online connection with the device from which you want to upload the blocks.
See also: Establishing and terminating an online connection 

2. In the project tree, select the blocks that you want to upload from the device.
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3. In the "Online" menu, select the "Upload from device" command.
The "Upload preview" dialog box opens. This dialog displays alarms and proposes actions 
necessary for loading.

4. Check the alarms and, where necessary, enable the actions in the "Action" column.
The "Upload from device" button will be enabled as soon as uploading becomes possible.

5. Click on the "Upload from device" button.
The load is executed. 

Result
The blocks will be uploaded from the device to the project. You can edit them as normal, 
recompile them and download them to the device again. 

Downloading blocks to a memory card

Requirement   
● The memory card is marked as a program card.

● The "Program blocks" folder of the memory card is open.

Procedure   
To download blocks to a memory card, follow these steps:

1. Open the "Program blocks" folder of the device in the project tree.

2. Select the blocks you want to download to the memory card.

3. Drag the blocks in project tree to the "Program blocks" folder of the memory card.
The "Load preview" dialog opens. This dialog displays messages and proposes actions 
necessary for loading. 

4. Check the messages and, where necessary, enable the actions in the "Action" column. 

5. As soon as downloading becomes possible, the "Load" button is enabled.

6. Click the "Load" button.
If there is a need for synchronization, the system automatically displays the 
"Synchronization" dialog. This dialog displays messages and suggests actions that are 
needed for the synchronization. You have the option of performing these actions or forcing 
the download without synchronization by clicking "Force download to device". If you have 
performed the suggested actions, you will be asked whether you want to continue with the 
download. Click "Continue download" in order to download the block. The "Load results" 
dialog then opens and shows you the status and the actions after the download operation.

7. Click "Finish".

Result
The block is downloaded to the memory card If the changes affect additional blocks, these will 
also be downloaded to the memory card. Blocks that exist only on the memory card are deleted. 
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Inconsistencies between the blocks in the user program are avoided by downloading all 
affected blocks and the deleting of the non-required blocks on the memory card.

The messages under "Info > General" in the Inspector window show whether the downloading 
process was successful.

See also
Uploading blocks from a memory card (Page 1725)

Accessing memory cards (Page 440)

Uploading blocks from a memory card
You can only upload all blocks from one memory card back into your project. 

Requirement
The memory card is displayed.

See also: Accessing memory cards (Page 440)

Procedure     
To upload blocks from a memory card to your project, follow these steps:

1. In the project tree, drag the folder of the memory card to the folder of the device in the 
project.
The "Upload preview" dialog box opens. This dialog displays alarms and proposes actions 
necessary for loading.

2. Check the alarms and, where necessary, enable the actions in the "Action" column.
The "Upload from device" button will be enabled as soon as uploading becomes possible.

3. Click on the "Upload from device" button.

See also
Downloading blocks to a memory card (Page 1724)

Switching off the sequencer prior to loading a GRAPH DB
You can specify the switching off of the sequencer prior to loading an instance data block either 
globally or during the load operation. 
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Globally switching off the sequencer
To switch off the sequencer globally for each loading operation of an instance data block, follow 
these steps:

1. Select the "Settings" command in the "Options" menu.
The "Settings" window is displayed in the work area.

2. Select the "PLC programming > GRAPH" group in the area navigation.

3. Select the "Turn off sequence before downloading DB" check box.
For future loading operations, the sequencer is switched off prior to loading of the instance 
data block.

Switching off the sequencer during the loading operation
To switch off the sequencer during the loading operation, follow these steps:

1. Load the GRAPH function block to the device.
During the loading operation, the "Load preview" dialog opens. This dialog displays alarms 
and suggests the required actions for loading. If the instance data block must be loaded 
together with the GRAPH function block, the "Load preview" dialog suggests the action 
"Turn off sequence before downloading the DB".

2. Select the "Turn off sequence before downloading DB" check box.

9.1.7 Protecting blocks

9.1.7.1 Protecting blocks

Introduction
You can use a password to protect one or more blocks of the OB, FB, FC type and global data 
blocks from unauthorized access. Note the following particularities:

● You can not manually protect instance data blocks; they depend on the know-how 
protection of the assigned FB. This means that when you create an instance data block for 
a know-how protected FB, the instance data block also receives this know-how protection. 
This is independent of whether you explicitly create the instance data block or if it is created 
by a block call. 

● The know-how protection acts as write protection in global blocks and in instance data 
blocks.

● You cannot provide ARRAY data blocks with know-how protection.

If a block is know-how protected, only the following data is readable without the correct 
password:

● Interface parameters Input, Output, InOut, Return, Static

● Block title

● Block comment
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● Block properties

● Tags of global data blocks without specification of the location of use

The following actions can be performed with a know-how protected block:

● Copying and deleting

● Calling in a program

● Online/offline comparison

● Load

The code of the block, on the other hand, is protected from unauthorized reading and 
modification. For S7-1200/1500 CPUs, you can also set up copy protection which binds 
execution of the block to the CPU, or to the SD card with the defined serial number.

 

 Note

Note the following information:
● S7-1200 version 1.0 and S7-300/400 (only GRAPH and SCL blocks): If you download a 

know-how-protected block to a device, no restore information is loaded along with it. This 
means that you cannot open a know-how-protected block again even with the correct 
password if you upload it from the device.

● Only the non-protected data is compared in offline-online comparison of know-how 
protected blocks.

● You will no longer be able to access the block if you do not have the password.
● If you add a know-how-protected block to a library, the master copy created will also be 

know-how protected. 
● For S7-1500, you can select the "Block can be used as know-how protected library item" 

check box in the block properties to obtain the information on whether or not the block 
can be used as protected library item. For this purpose, the block cannot use any tags 
from the operand areas Output (Q), Input (I), Bit memory (M), Timer function (T) or Count 
function (C), and cannot access data blocks.

● Cross references to used tags, bit memories, inputs and outputs in know-how protected 
blocks are not displayed even after the correct password is entered.. 

● If you change the number of a block, the loadable binary component of the block is out of 
date. This means that the block must be recompiled before loading it to a device. For know-
how-protected blocks, this is only possible with the correct password. Keep this in mind 
particularly if you want to copy a know-how-protected block to another device in which 
there is already a block with the same number.

● Always pass on a project that includes know-how-protected blocks as a project archive 
or library archive. In this way, you ensure that the know-how protection cannot be 
bypassed.

● If you wish to assign know-how protection to several blocks using multiple selection, no 
instance data block can be included in the selection. Otherwise, it will not be possible to 
set know-how protection.

● You cannot change the know-how protection settings for an open, know-how protected 
block. 
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See also
Setting up and removing block copy protection (Page 1728)

Setting up block know-how protection (Page 1729)

Opening know-how protected blocks (Page 1730)

Printing know-how protected blocks (Page 1731)

Removing block know-how protection (Page 1732)

Changing a password (Page 1732)

Archiving projects (Page 375)

Archiving global libraries (Page 463)

9.1.7.2 Setting up and removing block copy protection
For S7-1200 /1500 CPUs, you can set up copy protection which binds execution of the block 
to a specific CPU or SD card. The block can then only be executed if it is in the device with 
the set serial number. 

It is important that you also know-how-protect any block for which you have set up copy 
protection. If you do not, anyone can reset the copy protection. 

 

 Note

S7-1500 and S7-1200 V2.2 and higher: If you download a copy protected block to a device 
that does not match the specified serial number, the entire download operation will be 
rejected. This means that blocks without copy protection, too, will not be downloaded.

 

Setting up copy protection
To set up copy protection for a block, follow these steps:

1. Open the block you wish to copy-protect.

2. Open the "Properties" tab in the inspector window.

3. Select "Protection" in the area navigation in the inspector window.

4. Select either "Bind to serial number of the CPU" or "Bind to serial number of the memory 
card" from the drop-down list in the "Copy protection" area.

5. Enter the serial number of the CPU or the memory card for a S7-1500 CPU. You can either 
enter the serial number directly for a S7-1200 CPU or enable the option "Serial number 
inserted when downloading to a device or memory card" if the serial number is to be inserted 
automatically during loading.

6. You can now set up the know-how protection for the block in the "Know-how protection" 
area, if the block does not already have know-how protection.
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Removing copy protection
To remove copy protection, follow these steps:

1. Open the block for which you wish to remove copy protection.

2. Open the "Properties" tab in the inspector window.

3. Select "Protection" in the area navigation in the inspector window.

4. Select "No binding" in the drop-down list in the "Copy protection" area.

 

See also
Protecting blocks (Page 1726)

Setting up block know-how protection (Page 1729)

Opening know-how protected blocks (Page 1730)

Printing know-how protected blocks (Page 1731)

Removing block know-how protection (Page 1732)

Changing a password (Page 1732)

9.1.7.3 Setting up block know-how protection
You can set up know-how protection for blocks in the devices in your project. 

Procedure  
To set up block know-how protection, follow these steps:

1. Select the blocks with no know-how protection which you want to protect.

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click "Define".
The "Define password" dialog box opens.

4. Enter a password in the "New" field.

5. Enter the same password in the "Confirm" field.

6. Confirm your entries with "OK".

7. Close the "Know-how protection" dialog by clicking on "OK".

Result
The blocks selected will be know-how-protected. Know-how protected blocks are marked with 
a lock in the project tree. The password entered is valid for all blocks selected. 
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See also
Protecting blocks (Page 1726)

Setting up and removing block copy protection (Page 1728)

Opening know-how protected blocks (Page 1730)

Printing know-how protected blocks (Page 1731)

Removing block know-how protection (Page 1732)

Changing a password (Page 1732)

9.1.7.4 Opening know-how protected blocks
You can only open multiple know-how protected blocks at once if they are protected with the 
same password.

Procedure   
To open a know-how protected block, follow these steps:

1. Double-click on the block you wish to open.
The "Access protection" dialog will open.

2. Enter the password for the know-how protected block.

3. Confirm your entry with "OK".

Result
The know-how protected block will open provided you have entered the correct password. 
However, the block will remain know-how protected. If you copy the block or add it to a library, 
for example, the copies will also be know-how protected.

Once you have opened the block, you can edit the program code and the block interface of 
the block for as long as the block or TIA portal is open. The password must be entered again 
the next time the block is opened. If you close the "Access protection" dialog with "Cancel", 
the block will open but the block code will not be displayed and you will not be able to edit the 
block. 

See also
Protecting blocks (Page 1726)

Setting up and removing block copy protection (Page 1728)

Setting up block know-how protection (Page 1729)

Printing know-how protected blocks (Page 1731)

Removing block know-how protection (Page 1732)

Changing a password (Page 1732)
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9.1.7.5 Printing know-how protected blocks
You can only print complete know-how protected blocks if they have been opened with the 
correct password. If you print a closed block or if the block was not opened with the correct 
password, only the non-protected block data will be printed.

Procedure   
To print a know-how protected block in full, follow these steps:

1. Open the know-how protected block you wish to print.
See also: Opening know-how protected blocks (Page 1730)

2. Select the "Print" command in the "Project" menu.
The "Print" dialog will open.

3. Select the printer in the "Name" field.

4. Click "Advanced" to modify the Windows printer settings.

5. Select the documentation information set in the "Document information" drop-down list that 
you want to use for the frame layout.

6. Under "Print objects/area" select whether you want to print all objects or the complete area, 
or only a selection.

7. Under "Properties" select the print scope.

– Select "All" to print the complete block.

– Choose "Visible" to print all the information within the block that is visible on the screen.

– Select "Compact" to print a shortened form of the block.

8. Click "Preview" to generate a print preview in advance.
A print preview is created in the work area.

9. Click "Print" to start the printout.

See also
Printing project contents (Page 406)

Protecting blocks (Page 1726)

Setting up and removing block copy protection (Page 1728)

Setting up block know-how protection (Page 1729)

Removing block know-how protection (Page 1732)

Changing a password (Page 1732)
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9.1.7.6 Changing a password

Procedure   
To change the password, follow these steps:

1. Select the know-how protected blocks for which you want to change the password.
 

  Note

You can only change the password for several blocks at once if all blocks selected have 
the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click the "Change" button.

4. Enter the old password in the "Old" field.

5. Enter the new password in the "New" field.

6. Enter the new password again in the "Confirm" field.

7. Confirm your entries with "OK".

8. Close the "Know-how protection" dialog by clicking on "OK".

See also
Protecting blocks (Page 1726)

Setting up and removing block copy protection (Page 1728)

Setting up block know-how protection (Page 1729)

Opening know-how protected blocks (Page 1730)

Printing know-how protected blocks (Page 1731)

Removing block know-how protection (Page 1732)

9.1.7.7 Removing block know-how protection

Procedure  
To remove block know-how protection, follow these steps:

1. Select the blocks for which you want to remove know-how protection.
 

  Note

You can only remove know-how protection for several blocks at once if all blocks selected 
have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.
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3. Deactivate the check box "Hide code (know-how protection)".

4. Enter the password.

5. Confirm your entries with "OK".

Result
Know-how protection will be disabled for the blocks selected. 

See also
Protecting blocks (Page 1726)

Setting up and removing block copy protection (Page 1728)

Setting up block know-how protection (Page 1729)

Opening know-how protected blocks (Page 1730)

Printing know-how protected blocks (Page 1731)

Changing a password (Page 1732)

9.2 Displaying program information

9.2.1 Overview of available program information

Program information       
The program information of a user program contains the view specified in the following table. 

View Application
Assignment list (Page 1734) Provides an overview of the address bits for the I, 

Q, and M memory areas already allocated within 
the user program.
Also indicates if an address has been allocated by 
access from an S7 program or if the address has 
been assigned to a SIMATIC S7 module.

Call structure (Page 1742) Shows the call structure of the blocks within the 
user program and provides an overview of the 
blocks used and their relationships.
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View Application
Dependency structure  (Page 1749) Shows the list of blocks used in the user program. 

A block is shown at the first level and blocks that 
call or use this block are indented below it. In 
contrast to the call structure, instance blocks are 
listed separately.

Resources (Page 1754) Shows the hardware resources of the CPU for 
objects (OB, FC, FB, DB, user-defined data types 
and PLC tags), for CPU memory areas and for the 
existing I/O modules.

Displaying several views simultaneously
You can generate and display several views for one or more user programs to facilitate testing 
and changing your user program.

Displaying multiple views, for example, enables you to:

● Display all program information for a user program next to one another

● Compare different user programs

 

9.2.2 Displaying an assignment list

9.2.2.1 Introduction to the assignment list

Program information in the assignment list   
The assignment list shows if an address has been allocated by access from an S7 program 
or if the address has been assigned to a SIMATIC S7 module. It is therefore an important basis 
for locating errors or changes in the user program.

In the assignment list, you have a CPU-specific overview of which bit is used in which byte of 
the memory areas listed below:

● Input (I)

● Output (O)

● Bit memory (M)

● Timer (T)

● Counter (C)

● I/O (P)

Display of the assignment list
The assignment list of inputs, outputs, and bit memory is displayed in several separate work 
windows.
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Filters
You can filter the display within the assignment list. You can use predefined filters or create 
your own. 

Displaying cross-reference information
You have the option of displaying cross-reference information for selected addresses in the 
assignment list.

You can display the cross-references for a selected address in the Inspector window using the 
"Cross-reference information" shortcut menu command. The command "Tools > Cross-
references" allows you to also open the cross-reference list for the selected object.

Displaying the PLC tag table
You can open the PLC tag table from the assignment list and edit the properties of the tags 
used. 

To do this select an address of the assignment list and select the "Open editor" command in 
the shortcut menu.

Enabling the display of retentivity
You can enable and disable the display of the retentive state of bit memory by selecting the 
"Hide/show retain area" toolbar button. 

See also
Symbols in the assignment list (Page 1736)

Layout of the assignment list (Page 1735)

9.2.2.2 Layout of the assignment list

Layout of the assignment list      
Depending on the CPU, the assignment list is displayed in several work windows with the 
following operands.

For S7-300/400 CPUs:

● Inputs

● Outputs

● Bit memory

● Timers

● Counters

For S7-1200 CPUs:

Programming the PLC
9.2 Displaying program information

WinCC Professional V13.0
System Manual, 02/2014 1735



● Inputs

● Outputs

● Bit memory

Displaying inputs, outputs, bit memory, timers and counters
It shows all operands used and their assignment in the S7 program. 

For all displayed operands, each line in the assignment list is dedicated to a byte of the memory 
area, in which the corresponding eight bits from 7 to 0 are labeled according to their access. 
In conclusion, a "bar" indicates if access is made by a byte (B), word (W) or double word (D).

You can find an explanation of the symbols in the assignment list here. (Page 1736) 

See also
Introduction to the assignment list (Page 1734)

9.2.2.3 Symbols in the assignment list

Meaning of the symbols in the assignment list   
The following table shows the meaning of the symbols in the assignment list: 

Symbol Meaning
Indicates the address assignment in the selected state.
Indicates the address assignment in the non-selected state.

Indicates that a pointer start address and a tag address access the 
same address range and that they are selected.
Indicates that a pointer start address and a tag address access the 
same address range and that they are not selected.
Indicates the pointer assignment in the selected state.

Indicates the pointer assignment in the non-selected state.

Indicates that the byte is in use with byte access and the 
corresponding tag is selected. The shortcut menu allows you to 
display cross-reference information for the selected variables as 
well as the PLC tag table. 
Indicates that the byte is in use with byte access and the 
corresponding tag is not selected.
Indicates that the byte is in use with word access and the 
corresponding tag is selected. The shortcut menu allows you to 
display cross-reference information for the selected variables as 
well as the PLC tag table.
Indicates that the byte is in use with word access and the 
corresponding tag is not selected.
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Symbol Meaning
Indicates that the byte is in use with double word access and the 
corresponding tag is selected. The shortcut menu allows you to 
display cross-reference information for the selected variables as 
well as the PLC tag table.
Indicates that the byte is in use with double word access and the 
corresponding tag is not selected.

Background color: gray Indicates that a byte is in use with byte, word or double word access 
and that the address is also in use by the hardware. The gray 
background color indicates overlapping memory access.

Background color: yellow Indicates that the address is not in use by the hardware.
Indicates that the memory area has been defined as system 
memory.
Indicates that the memory area has been defined as clock memory.

 

 

See also
Layout of the assignment list (Page 1735)

Introduction to the assignment list (Page 1734)

9.2.2.4 Displaying an assignment list

Requirement  
A project has been created with programmed blocks.

Procedure
Proceed as follows to display the assignment list:

1. Select the "Program blocks" folder or one or more of the blocks it contains.

2. Select the "Assignment list" command in the "Tools" menu.

Result
The assignment list for the selected program is displayed.

View options in the assignment list
Refer to view respective view options that are set to display the desired information in the 
assignment list.

 

Programming the PLC
9.2 Displaying program information

WinCC Professional V13.0
System Manual, 02/2014 1737



See also
Setting the view options for the assignment list (Page 1738)

Layout of the assignment list (Page 1735)

9.2.2.5 Setting the view options for the assignment list

Introduction
The following view options are available for the assignment list:

● Used addresses:
When this check box is activated, the addresses, I/Os and pointers used in the program 
are displayed.

● Free hardware addresses:
When this check box is activated, only the free hardware addresses are displayed.

Requirement   
● A project has been created with programmed blocks.

● The assignment list is open.

Procedure
Proceed as follows to set the view options for the assignment list:

1. Click on the arrow of the  symbol ("View options") in the task bar.
The view options for the assignment list are opened. Check marks are set in front of the 
activated view options.

2. If you want to activate or deactivate a view option, click on the respective check box and 
set or remove the check mark.

Result
The view options are set and the desired information is displayed in the assignment list.
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9.2.2.6 Filter options in the assignment list

Filter settings   
You can define your own filter settings for the assignment list. The following options are 
available for defining filters:

● Display all addresses of the address areas specified.

● Display of single, defined addresses from the selected address area, for example, "0" and 
"200".

● Display of complete areas from the selected address area, for example, "0 - 256".

The following table provides an overview of all available options:

Selection in the Selection Symbol Meaning
Address area All CPU-dependent displayed 

addresses (I, O, M, T, C) can be 
activated as they are by default, or 
individual address areas can be 
activated.

Check box is activated Only the activated address 
areas (I, O, M, T, C) are shown 
in the assignment list.

Filter area Show assignment for all addresses * Displays the assignment of all 
addresses of the enabled 
address areas (I, Q, M).

Show assignment for selected 
addresses, for example, for the 
inputs "IB 0" and "IB 256"

0;256
Separate individual addresses 
and areas by a semicolon.

Assignments of selected 
addresses for the activated 
address areas (I) are shown.

Show assignment for selected 
areas, for example, for the inputs 
"IB 0 to IB 100" and "IB 200 to IB 
256". 

0-100;200-256
Contiguous areas should be 
connected by a hyphen.

Assignments of selected areas 
for the activated address areas 
(I) are shown.

9.2.2.7 Defining filters for assignment list

Requirement       
● A project has been created with programmed blocks.

● The assignment list is open.

Defining filter
Proceed as follows to define a filter for the assignment list:

1. Click on the  symbol ("Filter") in the task bar.
The "Assignment List Filter" dialog opens. 

2. Click on the  symbol ("Create new filter") in the task bar.
A new filter is created with the name "Filter_1". The check boxes for all addresses (inputs, 
outputs, memory bits, timers and counters) are activated by default for the filter.
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3. If you want to change the name of the filter, click on the drop-down list in the task bar and 
enter a new filter name.

4. Deactivate the check boxes of addresses that are not to be affected by the filter.

5. Enter one of the following options in the filter area of the activated address:

– Show all addresses used = "*"

– Show single, defined addresses, for example, IB 0" and IB 25 = "0.25". Individual 
addresses and address areas are separated by commas or semicolons.

– Show complete address areas, for example, IB 0 to IB 256 = "0-256". Complete address 
areas should be connected by a hyphen.

6. Confirm your entries with "OK".
The newly defined filter is shown in the task bar of the assignment list under the specified 
name.

Delete filter
Proceed as follows to delete a filter:

1. Click on the  symbol ("Filter") in the task bar.
The filter dialog for the assignment list opens. 

2. In the drop-down list of the task bar, select the filter you want to delete.

3. Click on the  symbol ("Delete selected filter") in the task bar.
The selected filter is deleted. 
 

See also
Filter options in the assignment list (Page 1739)

Displaying an assignment list (Page 1737)

Introduction to the assignment list (Page 1734)

9.2.2.8 Filtering an assignment list

Requirement
● A project has been created with programmed blocks.

● The assignment list is open.

Procedure
1. Click on the arrow on the drop-down list.

The available filter are displayed.

2. Select the desired filter.
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Result
The assignment list is filtered according to the settings of the selected filter. 

 

 Note

The filter settings are saved when the project is closed.
 

9.2.2.9 Defining retentive memory areas for bit memories

Introduction
In the assignment list you can define the width of the retentive memory area for bit memories. 
The content of tags which are addressed in retentive memory is retained after power off and 
at the STOP to RUN transition after power on. 

The display of retentive bit memories can be enabled and disabled in the assignment list. If 
their display is enabled, retentive bit memories are identified by an icon in the "Address" 
column. 

Requirement
The assignment list is open.

Procedure
Proceed as follows to define the width of the retentive memory area for bit memories:

1. Click "Retain" in the toolbar.
The "Retain memory" dialog will open.

2. Starting at the count of 0, define the width of the retentive memory area by entering the last 
byte of this area in the input field. Watch out for any addresses of tags already assigned to 
the retentive area.

3. Load the block to the target system. Select the "Program blocks" folder in the Project tree 
and select the "Download to device" submenu in the shortcut menu.

Result
The width of the retentive memory area is defined. If enabled in the assignment list, an icon 
will indicate the retentive state of all tags in the "Address" column. 
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9.2.2.10 Enabling the display of retentive bit memories

Introduction      
In the assignment list you can enable and disable the display of retentive bit memories. The 
retentive bit memories are identified by means of an icon in the "Address" column if the display 
of retentivity is enabled. 

Requirement
The assignment list is open.

Procedure
Proceed as follows to enable and disable the display of retentive bit memories:

1. Click "Display/hide retentivity" in the toolbar.

Result
The retentive tags are identified by means of an icon in the "Address" column of the bit memory 
area if the display of retentivity is enabled. The icons in the "Address" column are hidden if the 
display of retentivity is disabled. 

 

 

 

9.2.3 Displaying the call structure

9.2.3.1 Introduction to the call structure

Call structure    
The call structure describes the call hierarchy of the block within an S7 program. 

It provides an overview of:

● The blocks used

● Jumps to the places of use of the blocks

● Relationships between blocks

● Local data requirements of the blocks

● Status of the blocks
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Information in the call structure
Displaying the call stucture provides you with a list of the blocks used in the user program. The 
first level of the call structure is highlighted in color and shows the blocks that are not called 
by any other block in the program. Organization blocks are always shown on the first level of 
the call structure. Functions, function blocks and data blocks are only shown on the first level 
if they are not called by an organization block. When a block calls other blocks or functions, 
they are listed indented under the calling block. Instructions and blocks are shown in the call 
structure only if they are called by a block. 

View options
The following view options are available for the call structure:

● Show conflicts only:
When this check box is activated, only the conflicts within the call structure are displayed.

● Group multiple calls together:
When this check box is activated, several block calls are grouped together. The number of 
block calls is displayed in the "Call frequency" column. The links to the various call locations 
are offered in a drop-down list in the "Details" column.

Displaying the block calls
You can display the block calls in a block by clicking on the arrow in front of the block title. To 
display the call information of all blocks, click on the "Expand list" icon in the toolbar.

You can hide the total overview by clicking the "Collapse list" icon.

Displaying cross-reference information
You can display the cross-reference information for a block in the Inspector window by right-
clicking on the relevant block and selecting the "Cross-reference information" command from 
the shortcut menu. 

To open the "Cross-references" view, click the "Cross-references" command in the shortcut 
menu.

Displaying blocks in the program editor
You can open the program editor and edit blocks there from the call structure.

To do this select the required block in the call structure and select the "Open editor" command 
in the shortcut menu.
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Displaying deleted blocks
The rows belonging to deleted blocks are identified by an icon. 

 

 Note

Please note that any existing local data can only be displayed or updated after compiling a 
block.

 

See also
Symbols in the call structure (Page 1744)

9.2.3.2 Symbols in the call structure

Meaning of the symbols in the call structure     
The following table shows the meaning of the symbols in the call structure: 

Symbol Meaning
Indicates an organization block (OB).

Indicates a function block (FB).

Indicates a function (FC).

Indicates a data block (DB).

Indicates that the block is declared as a multiinstance.

The object has an interface dependency to an object connected to the left.

 
Indicates that the block needs to be compiled again.

Indicates that the data block needs to be compiled again.

Indicates that the object is not available.

Indicates that the interface causes a time stamp conflict.

Indicates that the variable causes a time stamp conflict.

Indicates that the block is not called directly or indirectly from an OB.

Indicates that an object has know-how protection.
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Symbol Meaning
Indicates that the block is normally called recursively.

Indicates that a tag declaration in the interface has a recursive dependency:
● Scenario 1: FB1 calls FB2 and this then calls FB1. The instance data blocks 

of these FBs have a recursion in the interface.
● Scenario 2: A multiple instance FB uses the instance DB of its parent FB as 

a global DB.

9.2.3.3 Layout of the call structure

Layout of the call structure     
The view of the call structure consists of the following columns:

Column Content/meaning
Call structure Shows an overview of the blocks called 

If the viewing option "Group multiple calls together" is 
enabled, several block calls are grouped together and the 
"Number of calls" column is displayed.

Call type (!) Shows the type of call, for example recursive block call. 
Address Shows the absolute address of the block. With a function 

block, the absolute address of the corresponding instance 
data block is also shown. 

Call frequency Indicates the number of multiple calls of blocks.
Details Shows the network or interface of the calling block. All 

information are offered as a link in this column. With this link, 
you can jump to the location of the block call in the program 
editor. If the viewing option "Group multiple calls together" 
option is enabled, the calls are grouped together and are 
available as links in a drop-down list.

Local data (in path) Indicates the local data requirement of the full path.
Blocks with optimized access have higher local data 
requirements because the information for the symbolic 
addressing is stored with them.
Please note that any existing local data can only be displayed 
or updated after compiling a block.

Local data (for blocks) Show the local data requirements of the block. 
Blocks with optimized access have higher local data 
requirements because the information for the symbolic 
addressing is stored with them.
Please note that any existing local data can only be displayed 
or updated after compiling a block.
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See also
Symbols in the call structure (Page 1744)

Introducing the consistency check in the call structure (Page 1747)

9.2.3.4 Displaying the call structure

Requirement   
A project has been created with blocks.

Procedure
Proceed as follows to display the call structure:

1. Select the "Program blocks" folder or one or more of the blocks it contains.

2. Select the "Call structure" command in the "Tools" menu.

Result
The call structure for the selected program is displayed.

 

 Note

Please note that any existing local data can only be displayed or updated after compiling a 
block.

 

See also
Setting the view options for the call structure (Page 1747)
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9.2.3.5 Setting the view options for the call structure

Introduction   
The following view options are available for the call structure:

● Show conflicts only:
Only the blocks causing conflicts within the call structure are displayed if this check box is 
activated. 
The following blocks cause conflicts:

– Blocks executing any calls with older or newer code time stamps.

– Blocks calling a block with modified interface.

– Blocks using a tag with modified address and/or data type.

– Block called neither directly, nor indirectly by an OB.

– Blocks calling a block which no longer exists.

● Group multiple calls together:
When this viewing option is enabled, several block calls and data block accesses are 
grouped together. The number of block calls is displayed in the "Call frequency" column. 
The links to the various call locations are offered in a drop-down list in the "Details" column.

Requirement
● A project has been created with programmed blocks.

● The call structure is open.

Procedure
Proceed as follows to set the view options for the call structure:

1. Click on the arrow of the  symbol ("View options") in the task bar.
The view options for the call structure opens. Check marks are set in front of the activated 
view options.

2. If you want to activate or deactivate a view option, click on the respective check box and 
set or remove the check mark.

Result
The view options are set and the required information is displayed in the call structure.

9.2.3.6 Introducing the consistency check in the call structure

Consistency check
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Changing the time stamp of a block during or after the program is generated can lead to time 
stamp conflicts, which in turn cause inconsistencies among the blocks that are calling and 
being called. 

Using the consistency check
The "Consistency check" function is used to visualize inconsistencies when time stamp 
conflicts occur. Whe the consistency check is performed, the inconsistent blocks are shown 
in the call structure and marked with the correspoinding symbols. 

● Most time stamp and interface conflicts can be rectified by recompiling the blocks.

● If compilation fails to clear up inconsistencies you can use the link in the "Details" column 
to go to the source of the problem in the program editor and manually eliminate any 
inconsistencies.

● The blocks marked in red must be recompiled.

See also
Symbols in the call structure (Page 1744)

9.2.3.7 Checking block consistency in the call structure

Requirement        
● A project has been created with programmed blocks.

● The call structure is open.

Procedure
Proceed as follows to check the block consistency:

1. Click on the  symbol ("Consistency check") in the task bar.
The block consistency is checked. Blocks found to be inconsistent are marked accordingly 
by a symbol.

2. If a block is inconsistent, click on the arrow in front of the block title in the call structure.
The inconsistent blocks are displayed. The exact problem locations are listed as links in 
the "Details" column. 

3. Click on the respective link in the "Details" column to jump to the location in the block 
requiring correction.

4. Check and correct the inconsistencies in the blocks.

5. Recompile the blocks by selecting the required blocks and clicking on the command 
"Compile" in the shortcut menu.

6. Download the corrected blocks to the target system by clicking the command "Download 
to device" in the shortcut menu.
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Result
The block consistency is checked. The inconsistencies in the blocks are corrected. The 
corrected blocks are loaded to the target system. 

See also
Symbols in the call structure (Page 1744)

9.2.4 Displaying the dependency structure

9.2.4.1 Introduction to the dependency structure

Introduction    
The dependency structure shows the dependencies each block has to other blocks in the 
program. 

Information in the dependency structure
Displaying the dependency structure provides you with a list of the blocks used in the user 
program. A block is shown at the far left and blocks that call or use this block are indented 
below it. 

The dependency structure also shows the status of the individual blocks using symbols.

Objects causing a time stamp conflict and perhaps leading to an inconsistency in the program 
are marked with various symbols.

The dependency structure is an extension of the cross-reference list for objects.

View options
The following view options are available for the dependency structure:

● Show conflicts only:
When this check box is activated, only the conflicts within the dependency structure are 
displayed.

● Group multiple calls together:
When this check box is activated, several block calls are grouped together. The number of 
block calls is shown numerically in the "Dependency structure" column. The links to the 
various call locations are offered in a drop-down list in the "Details" column.

Displaying the dependency structure
Clicking on the arrow in front of the block title displays the blocks that call or use this block. To 
display the dependencies of all blocks, 

click the "Expand list" icon in the toolbar. 
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You can hide the total overview by clicking the "Collapse list" icon.

Displaying cross-reference information
You can display the cross-reference information for a block in the Inspector window by right-
clicking on the respective block and selecting the "Display Usage" command from the shortcut 
menu. 

Displaying blocks in the program editor
You can open the program editor and edit blocks there from the dependency structure. To do 
this select the required block in the dependency structure and select the "Open editor" 
command in the shortcut menu.

9.2.4.2 Layout of the dependency structure

Layout of the dependency structure   
The view of the dependency structure consists of the following columns:

Column Content/meaning
Dependency It indicates the dependencies between each block and the 

other blocks in the program.
Call type (!) Shows the type of call, for example recursive block call. 
Address Shows the absolute address of the block. 
Call frequency Indicates the number of multiple calls of blocks.
Details Shows the network or interface of the called block. All 

information are offered as a link in this column. With this link, 
you can jump to the location of the block call in the program 
editor. If the viewing option "Group multiple calls together" 
option is enabled, the calls are grouped together and are 
available as links in a drop-down list.

See also
Symbols in the dependency structure (Page 1751)
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9.2.4.3 Symbols in the dependency structure

Meaning of the symbols in the dependency structure     
The following table shows the meaning of the symbols in the dependency structure:

Symbol Meaning
Indicates an organization block (OB).

Indicates a function block (FB).

Indicates a function (FC).

Indicates a data block (DB).

The object has an interface dependency to an object connected to the left.

 

Indicates that the block needs to be compiled again.

Indicates that the data block needs to be compiled again.

Indicates that there is an inconsistency with this object.

Indicates that an object has know-how protection.

Indicates that a tag declaration in the interface has a recursive dependency:
● Scenario 1: FB1 calls FB2 and this then calls FB1. The instance data blocks 

of these FBs have a recursion in the interface.
● Scenario 2: A multiple instance FB uses the instance DB of its parent FB as 

a global DB.

9.2.4.4 Displaying the dependency structure

Requirement  
A project has been created with programmed blocks.

Procedure
Proceed as follows to display the dependency structure:

1. Select the block folder or one or more of the blocks contained therein.

2. Select the "Dependency structure" command in the "Tools" menu.

Result
The dependency structure for the selected program is displayed.
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See also
Setting the view options for the dependency structure (Page 1752)

9.2.4.5 Setting the view options for the dependency structure

Introduction    
The following view options are available for the dependency structure:

● Show conflicts only:
When this check box is activated, only the conflicts within the dependency structure are 
displayed.
The following blocks cause conflicts:

– Blocks executing any calls with older or newer code time stamps.

– Blocks called by a block with modified interface.

– Blocks using a tag with modified address and/or data type.

– Block called neither directly, nor indirectly by an OB.

● Group multiple calls together:
When this check box is activated, several block calls are grouped together. The number of 
block calls is shown in the relevant column. The links to the various call locations are offered 
in a drop-down list in the "Details" column.

Requirement
● A project has been created with programmed blocks.

● The dependency structure is open.

Procedure
Proceed as follows to set the view options for the dependency structure:

1. Click on the arrow of the  symbol ("View options") in the task bar.
The view options for the dependency structure are opened. Check marks are set in front 
of the activated view options.

2. If you want to activate or deactivate a view option, click on the respective check box and 
set or remove the check mark.

Result
The view options are set and the required information is displayed in the dependency structure. 

 

Programming the PLC
9.2 Displaying program information

WinCC Professional V13.0
1752 System Manual, 02/2014



9.2.4.6 Introducing the consistency check in the dependency structure

Consistency check
       

Changing the time stamp of a block during or after the program is generated can lead to time 
stamp conflicts, which in turn cause inconsistencies among the blocks that are calling and 
being called. 

Using the consistency check
The "Consistency check" function is used to visualize inconsistencies. Whe the consistency 
check is performed, the inconsistent blocks are shown in the dependency structure and marked 
with the correspoinding symbols. 

● Most time stamp and interface conflicts can be rectified by recompiling the blocks.

● If compilation fails to clear up inconsistencies you can use the link in the "Details" column 
to go to the source of the problem in the program editor and manually eliminate any 
inconsistencies.

● The blocks marked in red must be recompiled.

See also
Layout of the dependency structure (Page 1750)

Symbols in the dependency structure (Page 1751)

9.2.4.7 Checking block consistency in the dependency structure

Requirement    
● A project has been created with programmed blocks.

● The dependency structure is open.

Procedure
Proceed as follows to check the block consistency:

1. Click on the  symbol ("Consistency check") in the task bar.
The block consistency is checked. Blocks found to be inconsistent are marked accordingly 
by a symbol.

2. If a block is inconsistent, click on the arrow in front of the block title in the dependency 
structure.
The inconsistent blocks are displayed. The exact problem locations are listed as links in 
the "Details" column.

3. Check and correct the inconsistencies in the blocks.
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4. Recompile the blocks by selecting the required blocks and clicking on the command 
"Compile" in the shortcut menu.

5. Download the corrected blocks to the target system by clicking the command "Download 
to device" in the shortcut menu.

Result
The block consistency is checked. The inconsistencies in the blocks are corrected. The 
corrected blocks are loaded to the target system.

See also
Symbols in the dependency structure (Page 1751)

9.2.5 Displaying CPU resources

9.2.5.1 Introducing resources

Introduction                       
The "Resources" tab indicates the hardware resources of the configured CPU for:

● the used programming objects,

● the assignment of the different memory areas within the CPU and

● the assigned inputs and outputs of the existing input and output modules.

Information provided in the "Resources" tab
The resources tab provides an overview of the hardware resources. The display in this tab 
depends on the CPU which you are using. The following information is displayed:

● the programming objects used in the CPU (e.g. OB, FC, FB, DB, data types and PLC tags)

● the memory areas available on the CPU (load memory, work memory - divided into code 
work memory and data work memory depending on the CPU -, retentive memory), their 
maximum size and utilization by the programming objects stated above

● the I/O of modules which can be configured for the CPU (I/O modules, digital input modules, 
digital output modules, analog input modules, and analog output modules), including the I/
O already in use.

Display of the maximum available load memory
The maximum size of available load memory can be selected from a drop-down list box in the 
"Total" row of the "Load memory" column.
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Display of the maximum available work memory
The maximum size of available work memory is displayed in the "Work memory" column or in 
the "Code work memory" and "Data work memory" columns in the "Total" row.

Display of the maximum available retentive memory
The maximum size of available retentive memory can be selected from a drop-down list box 
in the "Total" row of the "Retentive memory" column.

 

 Note
Retentive memory data

All bit memories and data blocks specified as retentive will be integrated in the calculation of 
the retentive data.

 

Updating the display in the "Resources" tab
Click the "Update view" toolbar button to update the display of objects.

Benefits of the display in the "Resources" tab
The "Resources" tab of the program information dialog provides a detailed list of all objects 
and of the corresponding memory area used. 

The tab also indicates shortage of resources and helps to avoid such states. 

Blocks which are not compiled can be identified as their size is indicated by a question mark.

 

See also
Layout of the "Resources" tab (Page 1756)

Displaying resources (Page 1757)

Selecting the maximum load memory available (Page 1758)
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9.2.5.2 Layout of the "Resources" tab

Layout of the "Resources" tab in the program information     
The view of the "Resources" tab consists of the following columns:

Column Content/meaning
Objects The "Details" area provides an overview of the programming 

objects available in the CPU, including their memory 
assignments.

Load memory Displays the maximum load memory resources of the CPU 
as a percentage and as absolute value.
The values displayed under "Total" provide information on 
the maximum memory available in the load memory.
The values displayed under "Used" provide information on 
the memory actually used in the load memory.
If a value is displayed in red, the available memory capacity 
has been exceeded.

Work memory
or 
code and data work memory

Displays the maximum work memory resources of the CPU 
as a percentage and as absolute value.
The work memory depends on the CPU and is divided into 
"Code work memory" and "Data work memory" for a CPU 
from the S7-400 or S7-1500 series, for example.
The values displayed under "Total" provide information on 
the maximum memory available in the work memory.
The values displayed under "Used" provide information on 
the memory space actually used in the work memory.
If a value is displayed in red, the available memory capacity 
has been exceeded.

Retentive memory Displays the maximum resources for retentive memory in the 
CPU as a percentage and as absolute value.
The values displayed under "Total" provide information on 
the maximum memory available in the retentive memory.
The values displayed under "Used" provide information on 
the memory actually used in the retentive memory. 
If a value is displayed in red, the available memory capacity 
has been exceeded.
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Column Content/meaning
I/O Displays the I/Os which are available on the CPU, including 

their module-specific availability in the next columns. 
The values displayed at "Configured" provide information 
about the maximum number of I/O available.
The values displayed under "Used" provide information on 
the actually used inputs and outputs.

DI / DQ / AI / AQ Displays the number of configured and used inputs/outputs:
DI = Digital inputs
DQ = Digital outputs
AI = Analog inputs
AQ = Analog outputs
The values displayed at "Configured" provide information 
about the maximum number of I/O available.
The values displayed under "Used" provide information on 
the actually used inputs and outputs.

See also
Displaying resources (Page 1757)

Selecting the maximum load memory available (Page 1758)

Introducing resources (Page 1754)

9.2.5.3 Displaying resources

Requirement     
A project with programmed blocks has been created.

Procedure
Proceed as follows to display the resources of the respective CPU memory areas:

1. Select the block folder below the relevant CPU, or one or several of the blocks contained 
therein.

2. Select the "Resources" command in the "Tools" menu.

Result
The memory resources of the assigned CPU are displayed.
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9.2.5.4 Selecting the maximum load memory available

Requirement         
A project with programmed blocks has been created.

Procedure
Proceed as follows to display the available maximum of load memory resources:

1. Select the block folder below the relevant CPU, or one or several of the blocks contained 
therein.

2. Select the "Resources" command in the "Tools" menu.

3. In the dialog that is displayed, open the drop-down list in the "Total" field of the "Load 
memory" column by clicking the icon.

4. Select a corresponding value for the CPU used by clicking it in the drop-down list box.

Result
The "Total" field displays the selected maximum memory resources.

 

 Note
Display of maximum memory resources

If a value is displayed in red for the maximum memory resources, the available memory 
capacity has been exceeded.

In this case, adapt the memory capacity as described above.
 

9.3 Displaying cross-references

9.3.1 General information about cross references

Introduction     
The cross-reference list provides an overview of the use of operands and tags within the user 
program.
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Uses of cross-references
The cross-reference list offers you the following advantages:

● When creating and changing a program, you retain an overview of the operands, tags and 
block calls you have used.

● From the cross-references, you can jump directly to the point of use of operands and tags.

● During a program test or when troubleshooting, you are informed of the following:

– Which operand is processed by which command in which block.

– Which tag is used in which picture.

– Which block is called by which other block.

– Cross-reference information for subordinate and higher-level structures.

● As part of the project documentation, the cross-references provide a comprehensive 
overview of all operands, memory areas, blocks, tags and pictures used.

See also
Structure of the cross-reference list (Page 1759)

Displaying the cross-reference list (Page 1760)

Displaying cross-references in the Inspector window (Page 1762)

9.3.2 Structure of the cross-reference list

Views of the cross-reference list        
There are two views of the cross-reference list. The difference between the two views is in the 
objects displayed in the first column:

● Used by:
Display of the referenced objects. Here, you can see where the object is used.

● Used:
Display of the referencing objects. Here, you can see the users of the object.

The assigned tool tips provide additional information about each object.

Structure of the cross-reference list
The cross-reference list has the following structure:

Column Content/meaning
Object Name of the object that uses the lower-level objects or that is being 

used by the lower-level objects.
Number Number of uses
Point of use Each point of use, for example, network
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Column Content/meaning
Property Special properties of referenced objects, for example, the tag names 

in multi-instance declarations.
as Shows additional information about the object, e.g., that an instance 

DB is used as template or as multiple instance.
Access Type of access, whether access to the operand is read access (R) and/

or write access (W).
Address Address of the operand
Type Information on the type and language used to create the object 
Path Path of object in project tree

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references. 

Settings in the cross-reference list
You can make the following settings using the buttons in the toolbar of the cross-reference list:

● Update cross-reference list
Updates the current cross-reference list.

● Making settings for the cross-reference list
Here, you select check boxes to specify whether all used, all unused, all defined or all 
undefined objects will be displayed. If the "Undefined objects" option is enabled, references 
to previously deleted objects are also displayed.

● Collapse entries
Reduces the entries in the current cross-reference list by closing the lower-level objects.

● Expand entries
Expands the entries in the current cross-reference list by opening the low-level objects.

Sorting in the cross-reference list
You can sort the entries in the "Object" column, including other product-specific columns, in 
ascending or descending order. To do this, click on the relevant column title.

See also
General information about cross references (Page 1758)

Displaying the cross-reference list (Page 1760)

9.3.3 Displaying the cross-reference list

Requirements
You have created a project.
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Introduction
There are several ways of displaying cross-references depending on whether you are in the 
Portal view or in the Project view and which object you have selected in the project tree. 

In the Portal view, you can only display cross-references for the entire CPU; in the Project 
view, you can, for example, display cross-references for the following objects:

● "PLC tags" folder

● "PLC data types" folder

● "Program blocks" folder

● "Tags and connections" folder

● Individual tags

● Individual PLC data types

● Individual blocks

● Technological objects

● Watch tables

Displaying cross-references           
Proceed as follows to display cross-references:

1. Select the required action in the Portal view, for example "PLC programming" and the "Show 
cross-references" command or select one of the objects listed above in the Project view 
and select the "Cross-references" command in the "Tools" menu.
The cross-reference list is displayed.

2. Click the "Used by" button to display where the objects shown in the cross-reference list 
are used.

3. Click the "Uses" button to view the users of the objects displayed in the cross-reference list.

4. You can perform the following actions using the buttons in the toolbar:

– Update cross-reference list

– Making settings for the cross-reference list

– Collapse entries

– Expand entries

5. You can sort the entries in the "Object" and "Address" columns in ascending or descending 
order by clicking on the relevant column title.

6. To go to the point of use of the object, click on the displayed link.

See also
General information about cross references (Page 1758)

Structure of the cross-reference list (Page 1759)
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9.3.4 Displaying cross-references in the Inspector window

Introduction
The Inspector window displays cross-reference information about an object you have selected 
in the "Info > Cross-references" tab. This tab displays the instances where a selected object 
is being used and the other objects using it. 

The Inspector window also includes blocks which are only available online in the cross-
references.

You can use the "Show overlapping access..." shortcut menu command to also have 
overlapping access across block borders displayed for selected objects.

Structure
The Inspector window displays the cross-reference information in tabular format. Each column 
contains specific and detailed information on the selected object and its application. The table 
below shows the additional information listed in the "Info > Cross-reference" tab:

Column Meaning
Object Name of the object that uses the lower-level 

objects or that is being used by the lower-level 
objects.

Number Number of uses
Point of use Each location of use, for example, network
Property Special properties of referenced objects, for 

example, the tag name in multi-instance 
declarations

as Shows additional information about the object, 
e.g., that an instance DB is used as template or as 
multiple instance.

Access Access mode
Shows whether the operand is accessed by a read 
(R) and/or write (W) operation.

Address Address of the operand
Monitor value This column will only be displayed when the 

program editor is open. 
Type Information about the type and language used to 

create the object
Path Path of object in project tree

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references.
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9.4 Testing the user program

9.4.1 Basics of testing the user program

Functions  
You have the option of testing the running of your user program on the device. You can then 
monitor signal states and values of tags and can assign values to tags to simulate certain 
situations in the running of the program.

Requirement
There must be an executable program loaded on the device.

Test options
The following test options are available:

● Testing with program status
The program status allows you to monitor the running of the program. You can display the 
values of operands and the results of logic operations (RLO) allowing you to recognize and 
fix logical errors in your program.

● Testing in single step mode (S7-300/400 only)
You can test blocks you created in STL or SCL in the single step mode. You do this by 
setting breakpoints in the program code at which program execution stops. You can then 
continue to run the program one step at a time. Within a CPU, you can test either with 
program status or in single step mode. You cannot, however, use both test options at the 
same time within a CPU.

● Testing with the watch table
With the watch table, you can monitor and modify the current values of individual tags in 
the user program or on a CPU. You can assign values to individual tags for testing and run 
the program in a variety of different situations. You can also assign fixed values to the I/O 
outputs of a CPU in STOP mode, for example to check the wiring. 

● Testing with the force table
With the force table, you can monitor and force the current values of individual tags in the 
user program or on a CPU. When you force, you overwrite individual tags with specified 
values. This allows you to test your user program and run through various situations.
When forcing, make sure that you keep to the necessary safety measures for forcing 
(Page 1816)! 

See also
Introduction to testing with program status (Page 1764)

Introduction to testing with the watch table (Page 1771)

Introduction for testing with the force table (Page 1798)
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9.4.2 Testing with program status

9.4.2.1 Introduction to testing with program status

Program Status function
If you display the program status, you can monitor the execution of the program. This provides 
you with an overview of the values of the individual operands and the results of the logic 
operations and you can check whether the components of the automation system are correctly 
controlled. 

The display of the program execution in the program status can differ slightly, depending on 
the CPU family used. 

Testing with program status for S7-300/400
During testing with program status, the CPU cycle time can become extended in test mode 
because the recording of all test data can deviate from the duration of the programmed 
instructions due to the CPU capacity and therefore not run in realtime.

During the execution of the following test functions an alarm indicating the danger of a time-
out is displayed once for each online session. 

● During testing with call conditions

● During testing with breakpoints

You can only perform these test functions after you have acknowledged the alarm.
 

 Note

With older CPUs from the S7-300/400 CPU family, you will need to change the operating 
response using the hardware configuration and then download the hardware configuration 
to the device. You have the option to set the "Process operation" or "Test operation" operating 
response.

 

Restrictions with the "Program status" function
The monitoring of loops can increase the cycle time significantly, depending in each case on 
the number of tags to be monitored and on the actual number of loops processed.

To ensure that the cycle time is influenced as little as possible, the "Program status" function 
is restricted as follows:
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● The status display of a programmed loop is stopped at the return point.
 

 WARNING

Testing with program status

A test with the "Program status" function can cause serious damage to property or injury to 
persons if there are functional disturbances or program errors.

Make sure that no dangerous situations can arise before you conduct a test with the "Program 
status" function.

 

9.4.2.2 Switching test with program status on/off
You can monitor all blocks by switching on the program status of the block. This function is 
available to you for all code blocks, regardless of the programming language used. For blocks 
that were programmed with LAD or FBD, you can also enable the program status from a 
specific position or for a specific selection. You can switch on the program status for an open 
block directly, or open a block from the calling block and view the program status.

 

 Note

The resources for testing with program status are limited. If there are not enough resources 
for the current test, earlier tests will be terminated.

 

Requirement
The identical block exists in the device.

Switching the program status on or off directly in the block
To switch the program status for a block on or off directly in the block, follow these steps:

1. Open the block for which you wish to switch on the program status.

2. Click the "Monitoring on/off" button in the toolbar.
If you have not already established an online connection, the "Go online" dialog opens. In 
this dialog, you can establish an online connection.
See also: Establishing and terminating an online connection

3. Click the "Monitoring on/off" button in the toolbar again to switch the program status off.

Switching on or off program status starting at a specific point in a network
To start the program status for LAD and FBD at a specific point, follow these steps:

1. Open the block for which you wish to switch on the program status.

2. Click the "Monitoring on/off" button in the toolbar.

3. Right-click on the tag you want program status to start from.
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4. Select "Modify > "Monitor from here" in the shortcut menu.

5. Click the "Monitoring on/off" button in the toolbar again to switch the program status off.

Switching on or off program status for selected tags
To start the program status for LAD and FBD for selected tags, follow these steps:

1. Open the block for which you wish to switch on the program status.

2. Click the "Monitoring on/off" button in the toolbar.

3. Select the tags for which you want to start the program status.

4. Select "Modify > Monitor selection" in the shortcut menu.

5. Click the "Monitoring on/off" button in the toolbar again to switch the program status off.

Switching on program status from the calling block
To switch on the program status for a block from the calling block (e.g. OB1), follow these 
steps:

1. Open the calling block.

2. Right-click on the block call.

3. Select the command "Open and monitor" in the shortcut menu.
The block will open in the program editor. An online connection is established and the 
program status is displayed. 

 

  Note

If the calling block is programmed in SCL and the called block is an FB, the FB is opened 
with "Open and monitor". To monitor the FB, you then need to switch on the program 
status directly in the FB.

 

Result
If you enable the display of the program status, an online connection is established and the 
program status is displayed. When you turn off the display of the program status, you can 
terminate the online connection at the same time.

The call path of the block is shown under the block interface. For S7-300/400 and S7-1500 
CPUs, you can change the call condition if required using the button on the right edge.

9.4.2.3 Editing blocks during the program test
If you edit blocks while the test with program status is still running, online monitoring will be 
interrupted and you will be able to edit the block offline. If the block is not available offline in 
the project, you will first have to load it from the device to the project. After editing the block, 
you will also have to compile and download it again.
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Procedure
To edit blocks while the test with program status is still running, follow these steps:

1. Edit the block as necessary.
The test with program status is interrupted and the block is switched offline assuming it 
exists offline.

2. If the block does not exist offline, load it to the project from the device.

3. Compile the block.
See also: Auto-Hotspot

4. Download the block to the device.
See also: Auto-Hotspot

Result
The block now contains your modifications both online and offline. The online connection is re-
established and testing with program status continues.

 

9.4.2.4 Modifying tags in the program status
While testing with the program status, you have the option of modifying tags to the following 
values once and immediately:

● Modify to 1
Modifies tags of the "Bool" data type to the value "True".

● Modify to 0
Modifies tags of the "Bool" data type to the value "False"

● Modify operand
You can enter a modify value for tags that do not belong to the "Bool" data type.

Note that you cannot modify peripheral inputs, for example, via TagName:P.

Procedure  
To modify tags during testing with the program status, proceed as follows:

1. Right-click on the tag you want to modify.

2. Select one of the following commands in the shortcut menu:

– "Modify > Modify to 1"

– "Modify > Modify to 0"

– "Modify > Modify operand"

3. If you select "Modify operand", the "Modify operand" dialog opens. Enter the value you 
require in the "Modify value" box and confirm with "OK".
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9.4.2.5 Switching display formats in the program status

Introduction
The display formats for tags are generally displayed in "integer" form. In the program status, 
you have the option of switching the current display format by means of the shortcut menu. 
The possible display formats for a tag are offered in a list. This is useful, for example, when 
you need a hexadecimal display in order to search for a hexadecimal error code.

 

Procedure
To switch the display format, follow these steps:

1. Open the desired block in the programming editor.

2. Switch on the program status by clicking "Monitoring on/off" in the toolbar.
If you have not already established an online connection, the "Go online" dialog opens. In 
this dialog, you can establish an online connection.

3. Select the tags for which you want to start the program status.

4. Select "Modify > Monitor selection" in the shortcut menu to start monitoring this tag.

5. Select the desired tag at the corresponding block output and then select the desired display 
format in the shortcut menu, for example, "Modify > Display format > Hexadecimal".

Result
The display format for the selected tag is shown in hexadecimal form. 

 

 Note
Switching the display format in the program status

Please note that it is not possible to switch the display format for unconnected outputs, as 
no monitoring value is output in this case.

 

 

9.4.2.6 Examples of program status display

Program status display for LAD programs

Displays in program status 
The display of the program status is updated cyclically. 

The following figure shows an example of the program status display for LAD:
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Representation of the program status
You can recognize the status of individual instructions and lines of a network quickly based 
on the color and type of lines and symbols. The following table shows the relationship between 
representation and status:

Representation Status
Green solid Satisfied
Blue dashed Not satisfied
Gray solid Unknown or not executed
Black Not interconnected
Parameter in a frame with a saturation of 100 % Value is current
Parameter in a frame with a saturation of 50 % Value originates from an earlier cycle. The point 

in the program was not executed in the current 
cycle.

Program status display for FBD programs

Displays in program status     
The display of the program status is updated cyclically. 

The following figure shows an example of the program status display for FBD:
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Representation of the program status
You can recognize the status of individual instructions and lines of a network quickly based 
on the color and type of lines and symbols. The following table shows the relationship between 
representation and status:

Representation Status
Green solid Satisfied
Blue dashed Not satisfied
Gray solid Unknown or not executed
Black Not interconnected
Parameter in a frame with a saturation of 100 % Value is current
Parameter in a frame with a saturation of 50 % Value originates from an earlier cycle. The point 

in the program was not executed in the current 
cycle.

The values of the operands are displayed above the relevant operand name in a gray box. 
 

 Note
Program status display for outputs which are not interconnected

Please note that a monitor value cannot be displayed for outputs which are not interconnected.
 

Program status display for SCL programs

Displays in program status   
The display of the program status is updated cyclically and shown in a table. The table is 
displayed immediately beside the SCL program and you can see the program status for each 
line of the program. The table contains the following information:

● Tag names

● Value

You can move the table to the left or right at any time.

The following figure shows an example of the program status display for SCL: 

In the first column, you can see the name of the tag for which the current value is being 
displayed. If the line includes the "IF", "WHILE" or "REPEAT" instruction, the result of the 
instruction is displayed in the line as "True" or "False". If the line contains more than one tag, 
the value of the first tag is displayed. In both cases, all tags of these lines are displayed with 
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their values in a separate list as soon as you select a line. If you place the cursor in a tag in 
the program code, this is shown in bold face in the list. You can also display the other tags of 
a line explicitly by clicking the arrow right located in front of lines containing more than one tag.

If the code of the line is not executed, the tag name is displayed in the values table in gray 
text. 

The current values of the tags are displayed in the last column. If no values can be displayed 
for a tag, the line has a yellow background and three question marks are shown. In this case, 
select the "Create extended status information" check box in the properties of the block and 
download the block to the device again. All values are then displayed. 

9.4.3 Testing with the watch table

9.4.3.1 Introduction to testing with the watch table

Overview     
The following functions are available in the watch table:

● Monitoring tags
This displays the current values of the individual tags of a user program or a CPU on the 
programming device or PC.

● Modifying tags
You can use this function to assign specific values to the individual tags of a user program 
or CPU. Modifying is also possible with Test with program status .

● "Enable peripheral outputs" and "Modify now"
These two functions enable you to assign specific values to individual peripheral outputs 
of a CPU in STOP mode. You can also use them to check your wiring.

Monitoring and modifying tags
The following tags can be monitored and modified:

● Inputs, outputs, and bit memory

● Contents of data blocks

● I/O

Possible applications
The advantage of the watch table is that a variety of test environments can be stored. This 
enables you to reproduce tests during commissioning or for service and maintenance 
purposes. 
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See also
Creating and editing watch tables (Page 1775)

Layout of the watch table (Page 1772)

Basic mode and expanded mode in the watch table (Page 1773)

Icons in the watch table (Page 1774)

9.4.3.2 Layout of the watch table

Introduction
A watch table contains the tags you defined for the entire CPU. A "Watch and force tables" 
folder is automatically generated for each CPU created in the project. You create a new watch 
table in this folder by selecting the "Add new Watch table" command.

Layout of the watch table         
The columns displayed in the watch table depend on the mode you are working in: basic mode 
or expanded mode. 

The following additional columns are shown in expanded mode:

● Monitor with trigger

● Modify with trigger

The names of the columns can also be changed dynamically based on the action.

Meaning of the columns 
The following table shows the meaning of the individual columns in basic mode and expanded 
mode:

Mode Column Meaning
Basic mode Identifier column

Name Name of the inserted tag
Address Address of the inserted tag
Display format Selected display format
Monitor value Values of the tags, depending on the selected display 

format.
Modify value Value with which the tag is modified.

Select the tag to be modified by clicking the corresponding 
check box.

Comment Comment for documentation of the tags
The following additional 
columns are shown in 
expanded mode:

Monitor with trigger Display of selected monitoring mode
Modify with trigger Display of selected modify mode
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See also
Icons in the watch table (Page 1774)

9.4.3.3 Basic mode and expanded mode in the watch table

Difference between basic mode and expanded mode in the watch table   
Depending on the mode specified, the watch table displays different columns and column 
headings that can be used to perform different actions.

You will find a detailed list of the columns in Layout of the watch table (Page 1772).

Switching between basic mode and expanded mode
You have the following options of toggling between the basic and expanded mode:

● Click the icon "Show/hide advanced setting columns". Click this icon again to return to the 
basic mode.
Or:

● Activate the check box for the "Expanded Mode" command in the "Online" menu. Deactivate 
this check box to return to the basic mode.

Functionality in expanded mode
The following functionality is only possible in expanded mode:

● Monitor with trigger

● Modify with trigger

● Enable peripheral outputs

● Monitoring peripheral inputs

● Controlling peripheral outputs
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs and controlling peripheral outputs

Note that the monitoring of peripheral inputs and the controlling of peripheral outputs in the 
watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

See also
Setting the monitoring and modify mode (Page 1786)
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9.4.3.4 Icons in the watch table

Meaning of the icons     
The following table shows the meaning of the icons in the watch table:

Icon Meaning
Identifies a table inside the project tree as a watch table. 

Shows information in the identifier column.

Inserts a row before the selected row.

Inserts a row after the selected row.

Modifies the addresses of all selected tags immediately and once. This 
command is executed once and as quickly as possible without reference 
to a defined trigger point in the user program.
Modifies the addresses of all selected tags with reference to a defined 
trigger point in the user program.
Disables the command output disable of the peripheral outputs. You can 
then modify the peripheral outputs when the CPU is in STOP mode.
Displays all columns of expanded mode. If you click this icon again, the 
columns of expanded mode will be hidden.
Displays all modify columns. If you click this icon again, the modify columns 
will be hidden. 
Starts monitoring of the visible tags in the active watch table. The default 
setting for the monitoring mode in basic mode is "permanent". In expanded 
mode, you can set defined trigger points for the monitoring of tags. 
Starts monitoring of the visible tags in the active watch table. This command 
is executed immediately and the tags are monitored once.
Displays the check box for the selection of tags to be modified.

Indicates that the value of the selected tag has been modified to "1". 

Indicates that the value of the selected tag has been modified to "0". 

Indicates that the address is being used multiple times.

Indicates that the substitute value is being used. Substitute values are 
values that are output to the process in case of signal output module faults 
or are used instead of a process value in the user program in case of signal 
input module faults. The substitute values can be assigned by the user 
(e.g., retain old value).
Indicates that the address is blocked because it is already being modified.

Indicates that the address cannot be modified.

Indicates that the address cannot be monitored.

Indicates that an address is being forced.

Indicates that an address is being partly forced.
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Icon Meaning
Indicates that an associated I/O address is being fully or partly forced.

Indicates that an address cannot be fully forced. Example: It is indeed 
possible to force the address QW0:P, but it is not possible to force the 
address QD0:P since this address area is eventually not available on the 
CPU.
Indicates that a syntax error occurred.

Indicates that the address is selected but at the moment e.g. has not yet 
been modified.

See also
Layout of the watch table (Page 1772)

9.4.3.5 Creating and editing watch tables

Creating a watch table

Introduction
The watch table allows you to monitor and modify tags in the user program. Once you have 
created a watch table, you can save it, duplicate it, and print it and use it again and again to 
monitor and modify tags.

Requirement   
A project is open.

Procedure
To create a watch table, follow these steps:

1. Click "Project view" in the status bar.
The project view is displayed.

2. In the project tree, double-click the CPU for which you want to create a watch table.

3. Double-click the "Watch and force tables" folder and then the "Add new watch table" 
command.
A new watch table is added.

4. In the "Name" column or in the "Address" column, enter the name or the absolute address 
for the tags that you want to monitor or modify.

5. You can select a display format from the drop-down list in the "Display format" column if 
you want to change this default setting.

6. Now decide whether you want to monitor or modify the entered tags and, if applicable, enter 
the desired values for modifying.
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Opening a watch table

Requirement  
A watch table has been created.

Procedure
To open a watch table, follow these steps:

1. Open the "Watch and force tables" folder below the desired CPU.

2. Double-click on the required watch table in the folder.

Result
The selected watch table opens.

Copying and pasting a watch table

Requirement  
A watch table has been created.

Procedure
To copy a watch table, follow these steps:

1. Right-click the watch table that you want to copy.

2. In the context menu, select "Copy".

3. In the project tree, open the folder structure for the CPU in which you want to paste the 
copied watch table.

4. Right-click on the "Watch and force tables" folder.

5. In the context menu, select "Paste".

6. Alternatively, you can select the entire contents of the watch table and Drag & Drop  it onto 
another watch table.

Result
A copy of the selected watch table is placed in the "Watch and force tables" folder of the 
relevant CPU. 
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Saving a watch table

Prerequisite  
A watch table has been created.

Procedure
To save a watch table, follow these steps:

1. In the project tree select the watch table you want to save.

2. If you wish to change the preset name of the table, select the "Rename" command in the 
context menu and enter a new name for the table.

3. In the "Project" menu, select "Save". Note that this save operation will save the entire project.

Result
The contents of the watch table and the project are saved.

 

 Note

You can reuse saved watch tables to monitor and modify tags when retesting your program. 
 

9.4.3.6 Entering tags in the watch table

Basic information on entering tags in the watch table

Recommended procedure     
● Select the tags whose values you want to monitor or modify, and enter them in the watch 

table.

● When entering tags into the watch table, please note that these tags must be previously 
defined in the PLC tag table.

● When entering tags, work from the outside to the inside. This means that you start by 
entering the tags for the inputs in the watch table. Then, you enter the tags that are affected 
by the inputs or that affect the outputs. Finally, you enter the tags for the outputs.

Example of filling out a watch table
● Enter the absolute address to be monitored or modified in the "Address" column.

● Enter the symbolic name for the tag in the "Name" column.
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● Select the display format you require from the drop-down list in the "Display format" column, 
if you do not want to use the default setting.

● Now decide whether you want to monitor or modify the entered tags. Enter the desired 
values for modifying as well as a comment in the corresponding columns of the watch table.

Create comment row
If required, you can create a comment row by entering the string "//" in the "Name" column.

Syntax check
When you enter the tags in the watch table, the syntax of each cell is checked when you exit 
the cell. Incorrect entries are marked in red.

 

 Note

When you place the mouse pointer in a cell marked in red, brief information is displayed with 
additional notes on the error. 

 

See also
Permitted operands for the watch table (Page 1778)

Permissible modify values for the watch table (Page 1779)

Permitted operands for the watch table

Permissible operands for the watch table     
The following table shows the operands that are permitted for the watch table:

Permitted operand Example of data 
type

Example (International 
mnemonics)

Input/output/bit memory BOOL I1.0, Q1.7, M10.1
I0.0:P; Q0.0:P

Input/output/bit memory BYTE IB1/QB10/MB100
IB1:P; QB1:P

Input/output/bit memory WORD IW1; QW10; MW100
IW2:P; QW3:P

Input/output/bit memory DWORD ID4; QD10; MD100
ID2:P; QD1:P

Timers TIMER T1
Counters COUNTER C1
Data block BOOL DB1.DBX1.0
Data block BYTE DB1.DBB1
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Permitted operand Example of data 
type

Example (International 
mnemonics)

Data block WORD DB1.DBW1
Data block DWORD DB1.DBD1

 

 
 

 Note
Please observe the following notes to work with the watch table.
● You cannot enter "DB0..." because it is used by the system!
● Peripheral outputs can be modified but not monitored.
● Peripheral inputs can be monitored but not modified.

 

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs and controlling peripheral outputs

Note that the monitoring of peripheral inputs and the controlling of peripheral outputs in the 
watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

See also
Basic information on entering tags in the watch table (Page 1777)

Permissible modify values for the watch table

Entry of modify values in the watch table    
The following table shows the operands that are permitted for the entry of modify values in the 
watch table:

Table 9-14 Bit operands

Possible bit operands Example for permitted modify values
I1.0 True
M1.7 False
Q1.0 0
Q1.1:P 1
DB1.DBX1.1 2#0
M1.6 2#1

Programming the PLC
9.4 Testing the user program

WinCC Professional V13.0
System Manual, 02/2014 1779



Table 9-15 Byte operands

Possible byte operands Example for permitted modify values
IB1 2#00110011
MB12 B#16#1F
QB10 1F
QB11:P 'a'
DB1.DBB1 10

Table 9-16 Word operands

Possible word operands Example for permitted modify values
IW1 2#0011001100110011
MW12 W#16#ABCD
MW14 ABCD
QW10 B#(12, 34)
QW12:P 12345
DB1.DBW1 'ab'
MW16 S5T#9s_340ms
MW18 C#123
MW9 D#2006-12-31

Table 9-17 Double word operands

Possible double word operands Example for permitted modify values
ID1 2#00110011001100110011001100110011
QD10 Dw#16#abcdef10
QD12:P ABCDEF10
DB1.DBD2 b#(12,34,56,78)
MD8 L#-12
MD12 L#12
MD16 123456789
MD20 123456789
MD24 T#12s345ms
MD28 Tod#1:2:34.567
MD32 P#e0.0

Table 9-18 Timers

Possible operands of the 
"Timer" type

Permitted control values Explanation

T1 0 ms Time value in milliseconds (ms)
T12 20 ms Time value in milliseconds (ms)
T14 12345 ms Time value in milliseconds (ms)
T16 S5t#12s340ms Time value 12s 340 ms
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Table 9-19 Counters

Possible operands of the "Counter" type Permitted control values
C1 0
C14 20
C16 C#123

Notes on timers and counters
● Timers 

 

  Note

Modifying a timer influences only the value, not the status. Timer T1 can be modified to 
the value "0", but the result of logic operation for A T1 is not changed.

The time sequences "s5t" and "s5time" can be written in both lower-case and upper-case 
characters.

 

● Counter
 

  Note

Modifying a counter influences only the value, not the status. Counter C1 can be changed 
to the value "0", but the result of the logic operation for A C1 is not changed.

 

Overview of the display formats

Display formats in the watch table     
The display format you select specifies the representation of a tag value. 

When entering the address a display format is automatically preset. If you want to change this, 
you can select a display format from the drop-down list in the "Display formats" column. The 
drop-down list only offers the display formats which are valid for this data type. The display 
format that appears first in the list is the pre-selected format.

Example
The following table shows the 32-bit data types permitted for all CPU families in the watch 
table and their possible display formats:

Data type Possible display formats
BOOL Bool, Hex, BCD, Octal, Bin, Dec, Dec+/-
BYTE Hex, BCD, Octal, Bin, Dec, Dec+/-, Character
WORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, 

Unicode_Character, SIMATIC_Timer, Date, Counter
DWORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, 

Unicode_Character, Floating-point number, Time of day, Timer, Pointer
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Data type Possible display formats
SINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
INT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
DINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
USINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
UINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
UDINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
REAL Floating-point number, Hex, BCD, Octal, Bin, Character, 

Unicode_Character,Dec,
Dec+/-, Dec_Sequence, Time of day, Timer, Pointer

DATE Date, Dec, Hex, BCD, Bin
TIME_OF_DAY Time of day, Dec, Hex, BCD, Bin
TIME Timer, Hex, BCD, Bin
DATE_AND_TIME Date and time,
TIMER SIMATIC_Timer, Hex, BCD, Bin
CHAR Character, Hex, BCD, Octal, Bin, Dec, Dec+/- 
WCHAR Unicode_Character, Character, Hex, BCD, Octal, Bin, Dec, Dec+/-
STRING Character string
WSTRING Unicode_character string
POINTER Pointer, Hex, BCD, Octal, Bin, Character, Unicode_Character, Dec, Dec+/-,

Dec_Sequence, Floating-point number, Time of day, Timer, Block number
COUNTER Counter, Hex, BCD, Bin
S5TIME SIMATIC_Timer, Hex, BCD, Bin

 

For the S7-1200 CPU family, all 32-bit data types are permitted (see table above), as well as 
the 64-bit data type LREAL with the following possible display formats:

Data type Possible display formats
LREAL In a project created with TIA Portal < V12: 

Floating-point number 
Note: The display of LREAL is limited to 13 digits plus exponent.

LREAL In a project created with TIA Portal >= V12: 
Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 
Dec, 
Dec+/-, Dec_Sequence, Time of day, Timer, Date and time
Note: The display of LREAL is limited to 13 digits plus exponent.

 

For the S7-1500 CPU family, in addition to 32-bit data types, the 64-bit data types listed in the 
table are also permitted with the following possible display formats:
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Data type Possible display formats
LWORD Hex, Octal, BCD, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Date and time
LINT Dec+/-, Dec, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
ULINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
LREAL Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec,
Dec+/-, Dec_Sequence, Time of day, Timer, Date and time

LTIME Timer, Dec+/-, Dec, Hex
LTOD Time of day, Dec, Hex, BCD, Bin
LDT Date and time, Dec, Hex

For more information, refer to the description of the valid data types.

 
 

 Note
Rounding of floating-point numbers

In the watch table, floating-point numbers are stored as binary numbers in IEEE format. 
Because not every floating point number (real, longreal) that can be displayed on the user 
interface can be mapped to the IEEE format, there is a possibility that floating-point numbers 
will be rounded. If a rounded floating-point number in the watch table is copied and, in turn, 
inserted in another input field, the rounding may cause a slight difference.

 

 
 

 Note
Only symbolic addressing is possible

In the watch table, LongDataTypes such as LWORD or LREAL can only be addressed 
symbolically.
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Selecting the display format for tags

Procedure
To select the display format of the tags, follow these steps:

1. Enter the desired address in the watch table.

2. Click the desired cell in the "Display format" column, and open the drop-down list.
The permissible display formats are shown in the drop-down list.

3. Select the desired display format from the drop-down list.
 

  Note

If the selected display format cannot be applied, then the last selected display format will 
be displayed automatically.

 

Creating and editing comment lines

Basic principles of comment lines
In addition to the row related comments in the comment column, you can now also create 
complete comment lines to enhance the structure of the watch table.

The contents of the comment line are stored in the "Languages & Resources" folder in the 
"Project texts" tab and can be compiled in other project languages.

Creating comment lines
To create comment lines, follow these steps:

1. Open the watch table and enter the required addresses.

2. To create a comment line, enter the character string "//" in the "Name" column. No comment 
lines can be created in the other columns. 

3. Enter the required comment in the comment line. The entered comment is shown in green. 

4. To show all comments you entered, double-click "Project texts" in the project tree under 
"Languages & Resources".

5. If you are working in multi-lingual projects and want your comment to be translated into 
other languages, you can set the project languages required in addition to the editing 
language in the project tree under "Languages & Resources > Project languages".
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Deleting comment lines
To delete comment lines, follow these steps:

1. Open a watch table containing comment lines.

2. Delete the entire comment including the introductory string "//", if you no longer required 
this.

3. Alternatively, delete only the introductory string "//". In this case the existing comment is 
retained and is displayed in the "Comment" column in the watch table. 

 

  Note
Deleting comment lines

When you delete comment lines the project languages and any existing translations for 
these comments are also deleted.

 

9.4.3.7 Monitoring tags in the watch table

Introduction to monitoring tags in the watch table

Introduction
The watch table allows you to monitor the tags of the configured input and output modules in 
the CPU, depending on the monitoring and modify mode (Page 1786) selected. To monitor 
tags, an online connection to the CPU must exist.

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs

Note that the monitoring of peripheral inputs can result in a time-out.

The CPU assumes the "STOP" mode.
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Options for monitoring tags
The following options are available for monitoring tags:

● Monitor now
This command starts the monitoring of the visible tags in the active watch table immediately 
and once only.

● Monitor all
This command starts the monitoring of all visible tags in the active watch table, depending 
on the selected watch mode:

– In basic mode, the monitoring mode is set to "permanent" by default.

– In expanded mode, you can specify defined trigger points for the monitoring of tags.
 

  Note

If the monitoring mode is changed while in expanded mode and then a switch is made 
to basic mode, the monitoring mode set before will also be applied in basic mode.

 

 

CPU-specific limitations when monitoring tags
The following CPU-specific differences exist:

● CPU S7-300/400:
CPUs from this family can only monitor the first 30 characters of a string.

● CPU S7-1200/1500:
CPUs from this family can monitor a string up to the total size of 254 characters.

 

Setting the monitoring and modify mode

Introduction             
By selecting the monitoring and modify mode, you specify the trigger point and the duration of 
the tag monitoring in the watch table and the force table.

Possible monitoring and modify modes (duration of monitoring or modifying)
The following monitoring and modifying modes are available:

● Permanent

● Once only, at start of scan cycle

● Once only, at end of scan cycle

● Permanently, at start of scan cycle

● Permanently, at end of scan cycle
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● Once only, at transition to STOP

● Permanently, at transition to STOP

Special features when using "Permanent" mode
The "Permanent" mode is executed differently for the monitoring and modifying of tags.

● Monitoring: The inputs are monitored at the end of the cycle and the outputs at the start of 
the cycle.

● Modifying: The inputs are monitored at the start of the cycle and the outputs at the end of 
the cycle.

Selecting the trigger point
The trigger points "Beginning of scan cycle", "End of scan cycle", and "Switch to stop" specify 
the time at which the tags are to be read from the CPU or updated in the CPU. 

The following diagram shows the position of these trigger points:
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Position of the trigger points
From the position of the trigger points, it follows that:

● Modifying of inputs is only appropriate at the beginning of the scan cycle (corresponding 
to the beginning of the user program OB 1), because otherwise the process image input is 
updated again after modifying and is thus overwritten.

● Modifying of outputs is only appropriate at the end of the scan cycle (corresponding to the 
end of the user program OB 1), because otherwise the process image output can be 
overwritten by the user program.

● The modified value is displayed in the "Monitor value" column, provided that monitoring is 
active and the modified value is not overwritten by the user program.

Monitoring of tags
When tags are being modified, the following applies to the trigger points:

● If you have specified the modify mode as "once only", you will receive a message if the 
selected tags cannot be modified.

● In "permanent" modify mode, you do not receive a message.

Note regarding the "Modify now" command
You can modify the values of selected tags immediately using the "Online > Modify >Modify 
now" command. This command is executed once only and as quickly as possible without 
reference to a defined position (trigger point) in the user program. This function is used mainly 
for modifying when the CPU is in STOP mode.

"Monitor all" command for tags

Introduction  
The "Monitor all" command allows you to start monitoring the visible tags in the active watch 
table. The default setting for the monitoring mode in basic mode of the watch table is 
"permanent". In expanded mode, you can specify defined trigger points for the monitoring of 
tags. In this case, the tags are monitored with reference to the specified trigger points.

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs

Note that the monitoring of peripheral inputs can result in a time-out.

The CPU assumes the "STOP" mode.
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Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To execute the "Monitor all" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the watch table.

2. Switch to expanded mode by clicking
the icon "Show/hide advanced setting columns" in the toolbar.

3. If you want to change the default monitoring mode for a tag, click the appropriate cell in the 
"Monitor with trigger" column and select the desired monitoring mode from the drop-down 
list.

4. Click the "Monitor all" icon in the toolbar.

Result
The tags of the active watch table are monitored using the monitoring mode selected. 

See also
Icons in the watch table (Page 1774)

Entering tags in the watch table (Page 1777)

Basic mode and expanded mode in the watch table (Page 1773)

"Monitor now" command for tags

Introduction    
The "Monitor now" command starts the monitoring of tags immediately without reference to 
defined trigger points. The tag values are read out once only and displayed in the watch table.

 
 

 NOTICE

Danger of a time-out while monitoring peripheral inputs

Note that the monitoring of peripheral inputs can result in a time-out.

The CPU assumes the "STOP" mode.
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Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To execute the "Monitor now" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the watch table.

2. Click the "Monitor now" icon in the toolbar.

Result
The tags of the active watch table are monitored immediately and once only. 

See also
Icons in the watch table (Page 1774)

Entering tags in the watch table (Page 1777)

Basic mode and expanded mode in the watch table (Page 1773)

9.4.3.8 Modifying tags in the watch table

Introduction to modifying tags

Introduction 
The watch table allows you to modify the tags of the configured input and output modules in 
the CPU, depending on the monitoring and modify mode (Page 1786) selected. To monitor 
the tags, an online connection to the CPU must exist.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.
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 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Options for modifying tags
The following options are available for modifying tags:

● Modify to "0"
This command modifies the selected address to the modify value "0".

● Modify to "1"
This command modifies the selected address to the modify value "1".

● Modify once only and immediately
This command modifies all selected addresses in the active watch table "once only and 
immediately".

● Modify with trigger
This command modifies all selected addresses in the active watch table using the 
monitoring and modify mode (Page 1786) selected. 
The "Modify with trigger" function is only available in expanded mode. You will not receive 
a message indicating whether or not the selected addresses were actually modified with 
the specified value. You should use the "Modify once only and immediately" function if you 
require such a confirmation.

● Enable peripheral outputs
This command disables the command output disable.
This function can only be executed in expanded mode, when the CPU is in STOP and the 
option Force (Page 1815) of tags is not enabled. If desired, deactivate this function in the 
force table.
 

 

  Note
When modifying, note the following:

Modifying can not be undone.
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Modify tags to "0"

Introduction
You can assign one-time values to tags independent of the monitoring and modify mode and 
modify them. The modify command is executed as fast as possible, similar to a "Trigger now" 
command, without reference to a defined position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To modify tags to "0", follow these steps:

1. Enter the desired address in the watch table.

2. Select the "Online > Modify > Modify to 0" command in order to modify the selected address 
with the specified value.

Result
The selected address is modified to "0".

 

 Note
When modifying, note the following:

Modifying can not be undone!
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Modify tags to "1"

Introduction
You can assign one-time values to tags independent of the monitoring and modify mode and 
modify them. The modify command is executed as fast as possible, similar to a "Trigger now" 
command, without reference to a defined position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To modify tags to "1", follow these steps:

1. Enter the desired address in the watch table.

2. Select the "Online > Modify > Modify to 1" command in order to modify the selected address 
with the specified value.

Result
The selected address is modified to "1". 

 

 Note
When modifying, note the following:

Modifying can not be undone!
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"Modify now" command for tags

Introduction
You can assign one-time values to tags independent of the monitoring and modify mode and 
modify them immediately. The modify command is executed as fast as possible, similar to a 
"Trigger now" command, without reference to a defined position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

Procedure
To modify tags immediately, follow these steps:

1. Enter the desired addresses and modify values in the watch table.

2. Select the addresses to be modified by selecting the check boxes for modifying in the 
column after the "Modify value". 
A yellow triangle appears behind the selected check box, indicating that the address is now 
selected for modifying but has not yet been modified.

3. Select the "Online > Modify > Modify once and now" command in order to immediately 
modify the selected address once only with the specified value.
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Result
The selected addresses are modified immediately and once only.

 

 Note
When modifying, note the following:

Modifying can not be undone!
 

"Modify with trigger" command for tags

Introduction
You can assign values to addresses dependent on the defined monitoring and modify mode 
and modify them. The modify command is executed as specified in the monitoring and modify 
mode, with reference to the defined trigger position in the user program.

 

 DANGER

Danger when modifying:

Serious personal injury and material damage can result from changes in the tags or 
addresses during plant operation in the event of malfunctions or program errors! 
Make sure that dangerous conditions cannot occur before you execute the "Modify" function.

 

 
 

 NOTICE

Danger of a time-out while controlling peripheral outputs

Note that the controlling of peripheral outputs in the watch table can result in a time-out.

The CPU assumes the "STOP" mode.
 

Requirements
● A watch table has been created.

● An online connection to the CPU exists.

● The watch table has to be in expanded mode.
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Procedure
To modify tags "with trigger", follow these steps:

1. Enter the desired addresses and modify values in the watch table.

2. Select the addresses to be modified by selecting the check boxes for modifying in the 
column after the "Modify value". 
A yellow triangle appears behind the selected check box, indicating that the address is now 
selected for modifying but has not yet been modified.

3. Switch to expanded mode using the icon "Show/hide advanced settings columns" in the 
toolbar or the "Online > Expanded mode" command.
The "Monitor with trigger" and "Modify with trigger" columns are displayed.

4. In the "Modify with trigger" column, select the desired modify mode from the drop-down list 
box. The following options are available:

– Permanent

– Permanently, at start of scan cycle

– Once only, at start of scan cycle

– Permanently, at end of scan cycle

– Once only, at end of scan cycle

– Permanently, at transition to STOP

– Once only, at transition to STOP

5. Start modifying using the "Online > Modify > Modify with trigger" command.

6. Confirm the prompt with "Yes" if you want to start modifying with trigger.

Result
The selected tags are modified using the selected monitoring and modify mode. The yellow 
triangle is no longer displayed. 

 

 Note
When modifying, note the following:

Modifying can not be undone!
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Enable peripheral outputs

Introduction
The "Enable peripheral outputs" function deactivates the command output disable of the 
peripheral outputs. You can then modify the peripheral outputs when the CPU is in STOP 
mode. This function is available in the watch table in "Expanded mode" only. 

 

 DANGER

Danger when enabling the peripheral outputs:

Attention, the enabling of the peripheral outputs can cause serious personal injury and 
material damage! 
Make certain that dangerous conditions cannot occur before you execute the "Enable 
peripheral outputs" function.

 

Prerequisites
● A watch table has been created.

● An online connection to the CPU exists.

● The CPU is in STOP mode before you can enable the peripheral outputs.

● The watch table has to be in expanded mode.

● The option Force (Page 1815) of tags must not be enabled.
 

 Note
"Enable peripheral outputs" function
● This function is possible only in STOP mode. The function is exited by an operating state 

change of the CPU and by the termination of the online connection.
● While the function is enabled, forcing is not possible.

 

 

Procedure
To enable the peripheral outputs in STOP mode, follow these steps:

1. Enter the desired addresses and modify values in the watch table.

2. Select the addresses to be modified by selecting the check boxes for modifying in the 
column after the "Modify value". 
A yellow triangle appears behind the selected check box, indicating that the address is now 
selected for modifying but has not yet been modified.

3. Switch to expanded mode using the icon "Show/hide advanced settings columns" in the 
toolbar or the "Online > Expanded mode" command.
The "Monitor with trigger" and "Modify with trigger" columns are displayed.
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4. Change the relevant CPU to STOP using the operator panel.

5. Right-click to open the shortcut menu and select "Enable peripheral outputs".

6. Confirm the prompt with "Yes" if you want to unlock the command output disable for the 
peripheral outputs.

7. Modify the peripheral outputs using the "Online > Modify > Modify now" command.

Result
The peripheral outputs are modified with the selected modify values. The yellow triangle is no 
longer displayed.

Enabling the peripheral outputs
The "Enable peripheral outputs" function remains active until:

● The "Enable peripheral outputs" command is deactivated again via the shortcut menu or 
via the "Online > Modify > Enable peripheral outputs" command.

● The CPU is no longer in STOP mode.

● The online connection is terminated.
 

  Note
When modifying, note the following:

Modifying can not be undone!
 

9.4.4 Testing with the force table

9.4.4.1 Introduction for testing with the force table

Overview           
You can use the force table to assign permanent values to individual tags

of the user program. This action is referred to as "forcing". 

The following functions are available in the force table:

● Monitoring tags
This displays the current values of the individual tags of a user program or a CPU on the 
programming device or PC. Tags can be monitored with or without a trigger condition.

● Forcing tags
This function lets you assign a permanent value to individual peripheral tags of the user 
program.
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Monitoring and forcing tags
The monitoring and forcing of tags is always dependent on the operand scope of the CPU 
used.

The following tags can be monitored:

● Inputs, outputs, and bit memories

● Contents of data blocks

● Peripheral inputs

The following tags can be forced:

● Peripheral inputs

● Peripheral outputs

Example
● Independent of the CPU used, only I/O can be forced, such as: "Tag_1":P or "QW0:P" or 

"IW0:P". Note that "Tag_1":P must not be the symbolic name of a bit memory.

Possible applications
One advantage of the force table is that you can simulate different test environments and 
overwrite tags in the CPU with a permanent value. This enables you to intervene in the ongoing 
process for regulating purposes.

 

See also
Layout of the force table (Page 1800)

Basic mode and expanded mode in the force table (Page 1801)

Icons in the force table (Page 1802)

Open and edit force table (Page 1803)
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9.4.4.2 Safety precautions when forcing tags

Safety precautions when forcing tags   
Because the forcing function allows you to intervene permanently in the process, observance 
of the following notices is essential:

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

 CAUTION

Prevent personal injury and material damage!
● Before you start the "Force" function, you should ensure that no one else is currently 

executing this function on the same CPU.
● Forcing can only be stopped by clicking the "Stop forcing" icon or using the "Online > 

Force > Stop forcing" command. Closing the active force table does not stop the forcing!
● Forcing can not be undone!
● Review the differences between " modifying tags" (Page 1790) and "forcing tags" 

(Page 1815).
● If a CPU does not support the "Force" function, the relevant icons cannot be selected.
● If the function "Enable peripheral outputs" is active on your CPU, then forcing is not 

possible on this CPU. If desired, deactivate this function in the watch table.

 
 

 

9.4.4.3 Layout of the force table

Introduction       
In the force table, enter the CPU-wide tags that you have defined and selected and which are 
to be forced in the allocated CPU. Only peripheral inputs and peripheral outputs can be forced.

For each CPU created in the project, a force table will automatically be created in the "Watch 
and force tables" folder. Only one force table can be allocated to a CPU. This force table 
displays all the addresses forced in the allocated CPU.
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Layout of the force table 
The columns displayed in the force table depend on the mode you are working in: basic mode 
or expanded mode. 

In expanded mode the "Monitor with trigger" column is also displayed. 

Meaning of the columns 
The following table shows the meaning of the individual columns in basic mode and expanded 
mode:

Mode Column Meaning
Basic mode Identification column

Name Name of the inserted tag
Address Address of the inserted tag
Display format Selected display format
Monitor value Values of the tags, dependent on the selected display 

format.
Force value Value with which the tag is forced.

 ("Force") Select the tag to be forced by activating the corresponding 
check box.

Comment Comment for documentation of the tags
The following additional 
column is shown in 
expanded mode:

Monitor with trigger Display of selected monitoring mode

See also
Icons in the force table (Page 1802)

Basic mode and expanded mode in the force table (Page 1801)

9.4.4.4 Basic mode and expanded mode in the force table

Difference between basic mode and expanded mode in the force table         
In expanded mode the "Monitor with trigger" column is also displayed in the force table. 

You will find a detailed list of the columns under Layout of the force table (Page 1800).
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Switching between basic mode and expanded mode
You have the following options of toggling between the basic and expanded mode:

● Click the icon "Show/hide advanced setting columns". Click this icon again to return to the 
basic mode.
Or:

● Activate the check box for the "Expanded mode" command in the "Online" menu. Deactivate 
this check box to return to the basic mode.

Functionality in expanded mode
The following functionality is only possible in expanded mode:

● Monitor with trigger

● Monitor peripheral inputs

 

9.4.4.5 Icons in the force table

Meaning of the icons     
The following table shows the meaning of the icons in the force table:

Icon Meaning
Identifies a table inside the project tree as a force table. 

Identification column

Inserts a row before the selected row.

Inserts a row after the selected row.

Displays all columns of expanded mode. If you click this icon again, the 
columns of the expanded mode will be hidden.
Starts forcing for all addresses of the selected tags. If forcing is already 
running, the previous action is replaced without interruption.
Stops forcing of addresses in the force table.

Starts monitoring of the visible tags in the force table. The default setting for 
monitoring in basic mode is "permanent". In expanded mode an additional 
column is shown and you can set certain trigger points for monitoring tags.
Starts monitoring of the visible tags in the force table. This command is 
executed immediately and the tags are monitored once.
Displays the check box for the selection of tags to be forced.

Indicates that an address cannot be forced.

Indicates that an address cannot be fully forced. Example: It is possible to 
force the address QW0:P, but it is not possible to force the address QD0:P 
because this address area is potentially not available on the CPU.
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Icon Meaning
Indicates that an address cannot be monitored.

Indicates that an address is being forced.

Indicates that an address is being partly forced.

Indicates that the associated peripheral address is being forced.

Indicates that a syntax error occurred.

Indicates that the address is selected but has not been forced yet.

See also
Layout of the force table (Page 1800)

9.4.4.6 Open and edit force table

Display force table

Introduction
You cannot create a new force table; one force table already exists for each CPU. It is 
permanently allocated to this CPU and cannot be copied or duplicated. 

Requirements
A project with an allocated CPU has to be open.

Displaying a force table   
The force table is always displayed below a CPU in the "Watch and force tables" folder.

Open force table

Requirements   
A project with an allocated CPU must be created.

Procedure
Proceed as follows to open a force table:

1. Open the "Watch and force tables" folder below the desired CPU.

2. Double-click the "Force table" in this folder.
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Result
The selected force table opens.

Save force table

Requirements   
A project with an allocated CPU has been created. 

Procedure
Proceed as follows to save a force table:

1. Enter the desired changes in the force table.

2. Select the "Save" command in the "Project" menu or click the "Save project" icon in the 
toolbar. Note that this save operation will save the entire project.

Result
The contents of the force table and the associated project are saved.

 

 Note

You cannot rename a force table.
 

9.4.4.7 Entering tags in the force table

Basic principles for entering tags in the force table

Recommended procedure  
Select the tags whose values you want to monitor or force, and enter them in the force table.

When entering tags in the force table, please note that these tags must be previously defined 
in the PLC tag table. 

Example of filling out a force table
● You can enter the absolute address that is to be forced or monitored in the "Address" column 

or you can enter the symbolic name of the tag in the "Name" column.

● Select the display format you require from the drop-down list in the "Display format" column, 
if you do not want to use the default setting.
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● Now you have to decide whether you want to monitor or force the entered tags. Enter the 
required force value and a comment in the appropriate columns of the force table.

● Note that only peripheral inputs and peripheral outputs can be forced and review the Safety 
precautions when forcing tags (Page 1816).

Create comment line
If required, you can create a comment row by entering the string "//" in the "Name" column.

Syntax check
When you enter tags in the force table, the syntax of each cell will be checked when you exit 
the cell. Incorrect entries are marked in red.

 

 Note

When you place the mouse pointer in a cell marked in red, brief information is displayed with 
additional notes on the error. 

 

 

Permitted operands for the force table

Permitted operands for the force table     
The following table shows the operands that are permitted for forcing in the force table:

Permitted operand Example of data 
type

Example (International 
mnemonics)

Peripheral input/peripheral output BOOL I0.0:P; Q0.0:P
Peripheral input/peripheral output BYTE IB1:P; QB1:P
Peripheral input/peripheral output WORD IW2:P; QW3:P
Peripheral input/peripheral output DWORD ID2:P; QD1:P

 

The following table shows the operands that are permitted for monitoring in the force table:

Permitted operand Example of data 
type

Example (International 
mnemonics)

Input/output/bit memory BOOL I1.0, Q1.7, M10.1
I0.0:P

Input/output/bit memory BYTE IB1/QB10/MB100
IB1:P

Input/output/bit memory WORD IW1; QW10; MW100
IW2:P
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Permitted operand Example of data 
type

Example (International 
mnemonics)

Input/output/bit memory DWORD ID4; QD10; MD100
ID2:P

Timers TIMER T1
Counters COUNTER C1
Data block BOOL DB1.DBX1.0
Data block BYTE DB1.DBB1
Data block WORD DB1.DBW1
Data block DWORD DB1.DBD1

 
 

 Note

You cannot enter "DB0..." because it is used by the system!
 

 

Permitted force values for the force table

Entering force values in the force table    
The following table shows the operands that are permitted for entering force values in the force 
table:

Table 9-20 Bit operands

Possible bit operands Example for permitted force values
I1.0:P True
I1.1:P False
Q1.0P 0
Q1.1:P 1
I2.0:P 2#0
I2.1:P 2#1

Table 9-21 Byte operands

Possible byte operands Example for permitted force values
IB1:P 2#00110011
IB2:P B#16#1F
QB14:P 1F
QB10:P 'a'
IB3:P 10
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Table 9-22 Word operands

Possible word operands Example for permitted force values
IW0:P 2#0011001100110011
IW2:P W#16#ABCD
QW10:P ABCD
QW12:P B#(12, 34)
IW4:P 'ab'
IW6:P 12345
IW8:P S5T#9S_340ms
IW10:P C#123
IW12:P D#2006-12-31

Table 9-23 Double word operands

Possible double word operands Example for permitted force values
ID0:P 2#00110011001100110011001100110011
ID4:P 1.2 
QD10:P 1.234.e4
QD14:P Dw#16#abcdef10
ID8:P 16#ABCDEF10
ID12:P b#(12,34,56,78)
ID16:P L#-12
ID20:P L#12
ID24:P 123456789
ID28:P 123456789
ID32:P T#12s345ms
ID36:P Tod#14:20:40.645
ID40:P P#e0.0

 

Overview of the display formats

Display formats in the force table     
The display format you select specifies the representation of a tag value. 

When entering the address a display format is automatically preset. If you want to change this, 
you can select a display format from the drop-down list in the "Display formats" column. The 
drop-down list only offers the display formats which are valid for this data type. The display 
format that appears first in the list is the pre-selected format.
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Example
The following table shows the 32-bit data types permitted for all CPU families in the force table 
and their possible display formats:

Data type Possible display formats
BOOL Bool, Hex, BCD, Octal, Bin, Dec, Dec+/-
BYTE Hex, BCD, Octal, Bin, Dec, Dec+/-, Character
WORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, 

SIMATIC_Timer, Date, Unicode_Character, Counter
DWORD Hex, BCD, Octal, Bin, Dec, Dec+/-, Dec_Sequence, Character, Floating-point 

number, Time of day, Timer, Pointer, Unicode_Character 
SINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
INT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
DINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
USINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character
UINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, SIMATIC_Timer, Counter, Date
UDINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Floating-point number, Time of day, Timer, Pointer
REAL Floating-point number, Hex, BCD, Octal, Bin, Character, 

Unicode_Character,Dec,
Dec+/-, Dec_Sequence, Time of day, Timer, Pointer

DATE Date, Dec, Hex, BCD, Bin
TIME_OF_DAY Time of day, Dec, Hex, BCD, Bin
TIME Timer, Hex, BCD, Bin
DATE_AND_TIME Date and time,
TIMER SIMATIC_Timer, Hex, BCD, Bin
CHAR Character, Hex, BCD, Octal, Bin, Dec, Dec+/- 
WCHAR Unicode_Character, Character, Hex, BCD, Octal, Bin, Dec, Dec+/-
STRING Character string
WSTRING Unicode_character string
POINTER Pointer, Hex, BCD, Octal, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Number
COUNTER Counter, Hex, BCD, Bin
S5TIME SIMATIC_Timer, Hex, BCD, Bin

 

For the S7-1200 CPU family, all 32-bit data types are permitted (see table above), as well as 
the 64-bit data type LREAL with the following possible display formats:
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Data type Possible display formats
LREAL In a project created with TIA Portal < V12: 

Floating-point number 
Note: The display of LREAL is limited to 13 digits plus exponent.

LREAL In a project created with TIA Portal >= V12: 
Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 
Dec,
Dec+/-, Dec_Sequence, Time of day, Timer, Date and time
Note: The display of LREAL is limited to 13 digits plus exponent.

 

For the S7-1500 CPU family, in addition to 32-bit data types, the 64-bit data types listed in the 
table are also permitted with the following possible display formats: 

Data type Possible display formats
LWORD Hex, Octal, BCD, Bin, Character, Unicode_Character, Dec, Dec+/-, 

Dec_Sequence, Floating-point number, Time of day, Timer, Date and time
LINT Dec+/-, Dec, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
ULINT Dec, Dec+/-, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec_Sequence, Time of day, Timer, Date and time
LREAL Floating-point number, Hex, BCD, Octal, Bin, Character, Unicode_Character, 

Dec,
Dec+/-, Dec_Sequence, Time of day, Timer, Date and time

LTIME Timer, Dec+/-, Dec, Hex
LTOD Dec, Hex, BCD, Bin, Time of day
LDT Dec, Hex, Date and time

 

For more information, refer to the description of the valid data types.

 
 

 Note
Rounding of floating-point numbers

In the force table, floating-point numbers are stored as binary numbers in IEEE format. 
Because not every floating point number (real, longreal) that can be displayed on the user 
interface can be mapped to the IEEE format, there is a possibility that floating-point numbers 
will be rounded. If a rounded floating-point number in the force table is copied and, in turn, 
inserted in another input field, the rounding may cause a slight difference.
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 Note
Only symbolic addressing is possible

In the force table, LongDataTypes such as LWORD or LREAL can only be addressed 
symbolically.

 

 

Selecting the display format for tags

Procedure
To select the display format of the tags, follow these steps:

1. Enter the desired address in the force table.

2. Click the desired cell in the "Display format" column, and open the drop-down list.
The permitted display formats are shown in the drop-down list.

3. Select the desired display format from the drop-down list.
 

  Note

If the selected display format cannot be applied, then the last selected display format will 
be displayed automatically.

 

 

 

 

Creating and editing comment lines

Basic principles of comment lines
In addition to the row-related comments in the comment column, you can now also create 
complete comment lines to enhance the structure of the force table.

The contents of the comment line are stored in the "Languages & Resources" folder in the 
"Project texts" tab and can be compiled in other project languages.

Creating comment lines
To create comment lines, follow these steps:

1. Open the force table and enter the required addresses.

2. To create a comment line, enter the character string "//" in the "Name" column. No comment 
lines can be created in the other columns. 
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3. Enter the required comment in the comment line. The entered comment is shown in green. 

4. To show all comments you entered, double-click "Project texts" in the project tree under 
"Languages & Resources".

5. If you are working in multi-lingual projects and want your comment to be translated into 
other languages, you can set the project languages required in addition to the editing 
language in the project tree under "Languages & Resources > Project languages".

Deleting comment lines
To delete comment lines, follow these steps:

1. Open a force table containing comment lines.

2. Delete the entire comment including the introductory string "//", if you no longer require this.

3. Alternatively, delete only the introductory string "//". In this case the existing comment is 
retained and is displayed in the "Comment" column in the force table. 

 

  Note
Deleting comment lines

When you delete comment lines the project languages and any existing translations for 
these comments are also deleted.

 

9.4.4.8 Monitoring tags in the force table

Introduction to monitoring tags in the force table

Introduction
Use the force table to monitor the tags of the configured input and output modules in the CPU, 
dependent on the monitoring mode (Page 1812) you have selected. An online connection to 
the CPU must exist to monitor tags.
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Options for monitoring tags
The following options are available for monitoring tags:

● Monitor all
This command starts the monitoring of all visible tags in the active force table, dependent 
on the selected monitoring mode:

– In basic mode, the monitoring mode is set to "permanent" by default.

– In expanded mode, you can specify defined trigger points for the monitoring of tags.
 

  Note

If the monitoring mode is changed while in expanded mode and then a switch is made 
to basic mode, the monitoring mode set before will also be applied in basic mode.

 

● Monitor now
This command starts the monitoring of the visible tags in the active force table immediately 
and once only.

CPU-specific limitations when monitoring tags
The following CPU-specific differences exist:

● CPU S7-300/400:
CPUs from this family can only monitor the first 30 characters of a string.

● CPU S7-1200:
CPUs from this family can monitor a string up to the total size of 254 characters.

Setting the monitoring mode in the force table

Introduction
By selecting the monitoring mode, you specify the trigger point and the duration of tag 
monitoring in the force table.

Possible monitoring mode (duration of monitoring)
The following selection options are available:

● Permanent

● Once only, at start of scan cycle

● Once only, at end of scan cycle

● Permanently, at start of scan cycle

● Permanently, at end of scan cycle

● Once only, at transition to STOP

● Permanently, at transition to STOP
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Special features when using "Permanent" mode
The "Permanent" mode is executed as follows for the monitoring of tags: The inputs are 
monitored at the end of the cycle and the outputs at the start of the cycle.

Selecting the trigger point
The trigger points "Beginning of scan cycle", "End of scan cycle", and "Switch to stop" specify 
the time at which the tags are to be read from the CPU or updated in the CPU. 

The following diagram shows the position of these trigger points:

 

"Monitor all" command for tags

Introduction  
Use the "Monitor all" command to start monitoring the visible tags in the active force table. In 
basic mode of the force table, the default setting for the monitoring mode is "permanent". In 
expanded mode, you can specify defined trigger points for the monitoring of tags. In this case, 
the tags are monitored with reference to the specified trigger points.

Requirements
An online connection to the CPU exists.

Programming the PLC
9.4 Testing the user program

WinCC Professional V13.0
System Manual, 02/2014 1813



Procedure
To execute the "Monitor all" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the force table.

2. Switch to expanded mode by clicking
the icon "Show/hide advanced setting columns" in the toolbar.

3. If you want to change the default monitoring mode for a tag, click the appropriate cell in the 
"Monitor with trigger" column and select the desired monitoring mode from the drop-down 
list.

4. Click the "Monitor all" icon in the toolbar.

Result
The tags of the active force table will be monitored using the set monitoring mode. 

"Monitor now" command for tags

Introduction   
The "Monitor now" command starts the monitoring of tags immediately without reference to 
defined trigger points. The tag values are read out only once and displayed in the force table.

Requirements
An online connection to the CPU exists.

Procedure
To execute the "Monitor now" command, follow these steps:

1. Enter the tags to be monitored and the corresponding addresses in the force table.

2. Click the "Monitor now" icon in the toolbar.

Result
The tags of the active force table are monitored immediately and once only. 
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9.4.4.9 Forcing tags in the force table

Introduction to forcing tags

Introduction
You can use the force table to assign permanent values to individual tags of the user program. 
This action is referred to as forcing. Only peripheral inputs and peripheral outputs can be forced.

To use the forcing function, you must have an online connection to the CPU and the utilized 
CPU must support this functionality. 

If you open a force table in the "Watch and force tables" folder below a CPU, all values forced 
in the allocated CPU will be displayed in this force table, provided that an online connection 
to the CPU exists.

Possible applications
By permanently assigning defined values to tags, you can specify defined default settings for 
your user program and, thus, test the programmed functions. Forcing is possible in basic mode 
and in expanded mode (Page 1801).

Caution when forcing tags
Before forcing, you must review the safety precautions (Page 1816) for this procedure.

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.

 
 

Options for forcing tags
The following options are available for forcing tags:

● Force to "0"
This command forces the selected address in the CPU to the force value "0".

● Force to "1"
This command forces the selected address in the CPU to the force value "1".

● Force all
This command starts the forcing of enabled addresses in the active force table or replaces 
an existing force job without interruption. 

● Stop forcing
This command stops the forcing of all addresses in the active force table.
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Constraints when forcing tags
Note the following constraints when forcing:

● Forcing is always dependent on the operand scope of the CPU used.

● In principle, only peripheral inputs and peripheral outputs can be forced.

● If the function "Enable peripheral outputs" is active on your CPU, then forcing is not possible. 
If desired, deactivate this function in the watch table.

Unique aspects when forcing tags
Note that forcing of tags will overwrite values in the CPU and will continue even after the online 
connection to the CPU is terminated. 

● Stop forcing
Terminating the online connection is not sufficient to stop the forcing operation! To stop 
forcing, you must select the "Online > Force > Stop forcing" command. Only then will the 
tags that are visible in the active force table no longer be forced.

● Stop forcing of individual tags
The "Online > Force > Stop forcing" command always applies to all tags displayed in the 
force table. To stop forcing individual tags, you must clear the check mark for forcing of 
these tags in the force table and restart forcing using the "Online > Force > Force all" 
command.

 

Safety precautions when forcing tags

Safety precautions when forcing tags   
Because the forcing function allows you to intervene permanently in the process, observance 
of the following notices is essential:

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Harm persons or pose a health hazard.
● Cause damage to machinery or the entire plant.
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 CAUTION

Prevent personal injury and material damage!
● Before you start the "Force" function, you should ensure that no one else is currently 

executing this function on the same CPU.
● Forcing can only be stopped by clicking the "Stop forcing" icon or using the "Online > 

Force > Stop forcing" command. Closing the active force table does not stop the forcing!
● Forcing can not be undone!
● Review the differences between " modifying tags" (Page 1790) and "forcing tags" 

(Page 1815).
● If a CPU does not support the "Force" function, the relevant icons cannot be selected.
● If the function "Enable peripheral outputs" is active on your CPU, then forcing is not 

possible on this CPU. If desired, deactivate this function in the watch table.

 
 

 

Force tags to "0"

Introduction
You can use the force function to assign permanent values to individual tags of a user program. 

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1816). 

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Pose a risk to the life or health of persons.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table. 

Programming the PLC
9.4 Testing the user program

WinCC Professional V13.0
System Manual, 02/2014 1817



Procedure
To force tags to "0", follow these steps:

1. Open the force table.

2. Enter the desired address in the force table.

3. Select the "Online > Force> Force to 0" command in order to force the selected address 
with the specified value.

4. Confirm the next dialog with "Yes".

Result
The selected address is forced to "0". The yellow triangle is no longer displayed. A red "F" is 
displayed in the first column, for example, indicating that the tag is being forced.

Stop forcing
To stop forcing, follow these steps: 

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command.

3. Confirm the next dialog with "Yes".

Result
Forcing of the selected values is stopped. The red "F" in the first column is no longer displayed. 
The yellow triangle reappears behind the check box again to indicate that the address is 
selected for forcing but is not being forced at the moment.

 

 Note
When forcing, note the following:
● Forcing cannot be undone!
● Terminating the online connection does not stop the forcing!
● To stop forcing, the forced address must be visible in the active force table.

 
 

 

Force tags to "1"

Introduction
You can use the force function to assign permanent values to individual tags of a user program.
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Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1816).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Endanger the life or health of personnel
● Cause damage to machinery or the entire plant.

 
 

Requirements
● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.

Procedure
To force tags to "1", follow these steps:

1. Open the force table.

2. Enter the desired address in the force table.

3. Select the "Online > Force> Force to 1" command in order to force the selected address 
with the specified value.

4. Confirm the next dialog with "Yes".

Result
The selected address is forced to "1". The yellow triangle is no longer displayed. A red "F" is 
displayed in the first column, for example, indicating that the tag is being forced.

Stop forcing
To stop forcing, follow these steps:

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command.

3. Confirm the next dialog with "Yes".
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Result
Forcing of the selected values is stopped. The red "F" in the first column is no longer displayed. 
The yellow triangle reappears behind the check box again to indicate that the address is 
selected for forcing but is not being forced at the moment.

 

 Note
When forcing, note the following:
● Forcing cannot be undone!
● Terminating the online connection does not stop the forcing!
● To stop forcing, the forced address must be visible in the active force table.

 
 

"Force all" command for tags

Introduction   
You can use the force function to assign permanent values to individual tags of a user program.

If forcing is already active, this forcing operation is replaced without interruption by the "Online 
> Force > Force all" command. Any forced addresses that are not selected will no longer be 
forced.

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1816).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when executing the "Force" function can:
● Pose a risk to the life or health of persons.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.
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Procedure
To force tags with the "Online > Force > Force all" command, follow these steps:

1. Open the force table.

2. Enter the desired addresses and force values in the force table.

3. Select the addresses to be forced by selecting the check boxes for forcing in the column 
after the "Force value". 
A yellow triangle appears behind the selected check box, indicating that the address is 
selected for forcing but is not being forced at the moment.

4. Select the "Online > Force> Force all" command in order to force the selected addresses 
with the specified values.

5. Confirm the next dialog with "Yes".

Result
The selected addresses are forced to the specified values. The yellow triangle is no longer 
displayed. A red "F" is displayed in the first column, for example, indicating that the tag is being 
forced.

Stop forcing
To stop forcing, follow these steps: 

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command.

3. Confirm the next dialog with "Yes".

Result
Forcing of the selected addresses is stopped. The red "F" in the first column is no longer 
displayed. The yellow triangle reappears behind the check box again to indicate that the 
address is selected for forcing but is not being forced at the moment.

 

 Note
When forcing, note the following:
● Forcing cannot be undone!
● Terminating the online connection does not stop the forcing!
● To stop forcing, the forced address must be visible in the active force table.
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9.4.4.10 Stop forcing tags

Stop forcing all tags

Introduction     
Note the following before you stop forcing tags:

● Stopping forcing cannot be undone!

● Terminating the online connection does not stop the forcing!

● To stop forcing, the forced address must be visible in the active force table.

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1816).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when stopping the "Force" function can:
● Pose a risk to the life or health of persons.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● Tags are forced in a force table.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.

Procedure
Proceed as follows to stop forcing all tags :

1. Open the force table.

2. Select the "Online > Force > Stop forcing" command in order to stop forcing the displayed 
addresses.

3. Confirm the "Stop forcing" dialog with "Yes".
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Result
The forcing of all tags is stopped. The red "F" in the first column is no longer displayed. The 
yellow triangle reappears behind the check box again to indicate that the address is flagged 
for forcing but is not being forced at the moment.

Stop forcing individual tags

Introduction     
Note the following before you stop forcing tags:

● Stopping forcing cannot be undone!

● Terminating the online connection does not stop the forcing!

● To stop forcing, the forced address must be visible in the active force table.

Caution when forcing tags
Before forcing, you must review the safety precautions when forcing tags (Page 1800).

 

 DANGER

Prevent personal injury and material damage!

Note that an incorrect action when stopping the "Force" function can:
● Pose a risk to the life or health of persons.
● Cause damage to machinery or the entire plant.

 
 

Requirements
● Tags are forced in a force table.

● An online connection to the CPU exists.

● The utilized CPU supports the force function.

● The "Enable peripheral outputs" function is not enabled on the CPU on which the tags are 
to be forced. If desired, deactivate this function in the watch table.

Procedure
Proceed as follows to stop forcing individual tags :

1. Open the force table.

2. Deactivate the check boxes for the addresses that are no longer to be forced.

3. Reselect the "Online > Force" command.
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Result
Forcing of the disabled addresses will be stopped. The red "F" in the first column is no longer 
displayed. The yellow triangle reappears behind the check box again to indicate that the 
address is flagged for forcing but is not being forced at the moment.

9.5 Using Team Engineering

9.5.1 Exchanging data with Inter Project Engineering (IPE)

9.5.1.1 Basics of Inter Project Engineering (IPE)

Introduction to Inter Project Engineering (IPE)
The functionality of Inter Project Engineering, hereinafter referred to as IPE, is used to 
exchange the controller data in a source project between different projects with the help of a 
device proxy. 

You can then transfer this data to other projects, for visualization in HMI, for example, and use 
it there for further configuration.

Inter Project Engineering gives you a simple way of providing controller data from a PLC 
programming across multiple projects for an HMI configuration.

Using the object "Device Proxy Data", you exchange controller data across multiple projects 
consistently and easily without redundant configuration overheads.

This makes it possible for HMI project engineers to work on a project without the hardware 
configuration having to be present in their project. This means they can work on the PLC project 
and on the HMI project at the same time.

You can exchange the following controller data between projects via the device proxy:

● Program blocks

● Technological objects

● PLC tags

● PLC alarms

The following data is automatically included in the exchange:

● Controller interfaces

● Configured communication processors and communication modules

This automatic data exchange ensures that the interfaces and the configured communication 
processors and modules are transferred along with the data you selected. This data is required 
to allow you to continue working consistently and without problems in your target project.
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Cross-project data exchange
The following options are available for cross-project data exchange with Inter Project 
Engineering:

● Exchanging controller data via IPE file

● Exchanging controller data via project file

Exchanging controller data via IPE file
The figure below shows cross-project data exchange via an IPE file.

The PLC controller data from the source project is transferred to the PLC in the target project 
via the object "Device Proxy Data". 

Controller data that is exchanged via an IPE file must originate from TIA Portal Projects V13 
or higher.

Exchanging controller data via a project file
  The figure below shows cross-project data exchange via a project file.
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The PLC controller data from the source project is transferred to the PLC in the target project 
via a project file. 

You can easily transfer and continue to use controller data from older TIA Portal projects as 
well as STEP 7 Classic projects that are not integrated in TIA Portal in your current TIA Portal 
projects. 

9.5.1.2 Requirements for Inter Project Engineering (IPE)

Software and hardware requirements
To use the functionality of Inter Project Engineering, the minimum software and hardware 
requirements for the installation of TIA Portal V13 or higher must be met. 

The following requirements also apply:

● You have installed TIA Portal V13 or higher and the "SIMATIC STEP 7 Professional" 
software package.

● You are using a CPU of the S7-1200/1500 or S7-300/400 series.

● The same software version must be installed on all involved controllers.

Requirements for IPE
The requirements for accepting controller data from projects are as follows:

● You have created a project with hardware configuration and PLC data that can be 
transferred to another project. 

● You have made sure that the project is consistent before you transfer the controller data 
by means of the device proxy data.

● You are familiar with the defined procedures for Inter Project Engineering. 

Notes on compatibility mode
The functions for Inter Project Engineering are not available in compatibility mode.
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9.5.1.3 Procedure for working with Inter Project Engineering (IPE)

Exchanging controller data across projects
You can use the functionality of Inter Project Engineering to exchange existing controller data 
between different projects with the help of a device proxy and to continue using this data in 
another project. The device proxy provides you with a consistent and convenient way of 
exchanging data between projects without redundant configuration overheads.

Procedure for exchanging controller data via an IPE file 
To exchange data via an IPE file, follow these steps:

1. Using TIA Portal V13 or higher, create a project with all required controller data and an 
executable user program.

2. Configure the hardware required for the project.

3. Compile the project to ensure consistency in your project.

4. In your project, create the object "Device Proxy Data" below the required CPU by clicking 
the corresponding command "Add device proxy data" in the "Device Proxy Data" folder.
Result: The "Device Proxy Data" object has been created.

5. Select the required device proxy data in the project tree and double-click the object to open 
it in the editor.

6. Enter the required data for the device proxy data in the editor under "General" or apply the 
default setting. You can change the name and enter a comment for export of the controller 
data.
In the "Define content" area of the editor select which of the existing controller data you 
wish to export as IPE file and click "Export device proxy data".

7. In the subsequent dialog, enter the name and storage location for the IPE file to be created 
and click "Save". You will be notified as soon as the export has been completed 
successfully. 
Result: The selected controller data are exported as IPE file.

8. In your target project, create a device proxy to be able to import the controller data contained 
in the IPE file. To do so, click the command "Add new device" and select the required device 
proxy in the dialog that opens.

9. Click the newly created device proxy and select the "Initialize device proxy" command from 
the shortcut menu. 

10.Select the previously created IPE file to be used for the initialization, and confirm the 
selection in the following dialog with "OK". This starts the initialization.
Result: The controller data from the source project contained in the IPE file is transferred 
to the device proxy in the target project.

After the successful exchange of controller data, you can continue with the configuration in 
your target project and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.
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Procedure for exchanging controller data via a project file
When exchanging controller data via a project file, device proxy data can either be predefined 
in the source project or it can be defined and selected from the target project.

Follow these steps to exchange data via a project file:

1. Using TIA Portal V13 or higher, create a project with all required controller data and an 
executable user program.

2. Configure the hardware required for the project.

3. Compile the project to ensure consistency in your project.

4. Open the TIA Portal project from which you want to import the controller data into the target 
project.

5. In your project, create the object "Device Proxy Data" below the required CPU by clicking 
the corresponding command "Add device proxy data" in the "Device Proxy Data" folder.
Result: The "Device Proxy Data" object has been created.

6. Enter the required data for the device proxy data in the editor under "General" or apply the 
default setting. You can change the name and enter a comment for the device proxy data.

7. In the "Define content" area of the editor select which of the existing controller data you 
want to provide by means of the device proxy data.

8. Click "Save" to save the changes in the project.  
Result: You have successfully saved the selected controller data in your device proxy data.

9. In your target project, create a device proxy to import the controller data contained in the 
project file. To do so, click the command "Add new device" and select the required device 
proxy in the dialog that opens.

10.Click the newly created device proxy and select the "Initialize device proxy" command from 
the shortcut menu.

11.Select the previously created project file with the prepared device proxy data to be used 
for the initialization, and confirm the selection in the following dialog with "OK". This starts 
the initialization.
Result: The controller data from the source project contained in the project file is transferred 
to the device proxy in the target project.

 After the successful exchange of controller data, you can continue with the configuration in 
your target project and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.

Procedure for updating already transferred controller data
System requirements for the update:

The following requirements must be met for updating already transferred controller data with 
the help of the already created "Device Proxy Data" object:

● You are using the same project for the update as for the previous transfer of the controller 
data.

● You are using the already created "Device Proxy Data" for transfer of the controller data.

● You have not made any changes to the hardware configuration or the communication 
interfaces in the meantime. You can add new hardware components. 
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Updating procedure:

1. Open the TIA Portal project from which you want to update the controller data in the target 
project.

2. Double-click the existing "Device Proxy Data" object and select under content which 
controller data you want to make available for the update.

3. Save the project or export the IPE file once again.  

4. Open the required target project in the TIA Portal.

5. Click the existing device proxy in the target project and select the "Update device proxy" 
command from the shortcut menu. 

6. Select the source which is to be used for the update, and confirm the selection.

7. In the following dialog, select under "Device" the CPU that was previously used as source, 
from which the controller data is to be re-imported.

8. Under "Defined device proxy data", select the required object and exit the dialog with "OK". 

9. The update is then started and the selected device proxy data is transferred from the source 
project to the device proxy in the target project.

After the successful update of the controller data, you can continue with the configuration in 
your target object and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.

9.5.1.4 Creating device proxy data

Creating device proxy data
To create a device proxy data, follow these steps:

1. Open the folder "Device Proxy Data" below the CPU to which you want to create a device 
proxy data.

2. Click the command "Add new device proxy data".

 

Result
The new device proxy data is created and displayed in the project tree.

 

See also
Basics of Inter Project Engineering (IPE) (Page 1824)

Requirements for Inter Project Engineering (IPE) (Page 1826)

Procedure for working with Inter Project Engineering (IPE) (Page 1827)
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Opening device proxy data (Page 1830)

Exchange of controller data via IPE file (Page 1830)

9.5.1.5 Opening device proxy data

Opening device proxy data 
To open a device proxy data in the editor, follow these steps:

1. Open the required "Device Proxy Data" with a double-click in the "Device Proxy Data" folder 
in the project tree below the CPU.

Result
The device proxy data is opened in the editor and displays the controller data assigned to it.

You can either apply the defaults displayed in the editor or customize them as needed.

See also
Exchange of controller data via IPE file (Page 1830)

Creating device proxy data (Page 1829)

Basics of Inter Project Engineering (IPE) (Page 1824)

Requirements for Inter Project Engineering (IPE) (Page 1826)

Procedure for working with Inter Project Engineering (IPE) (Page 1827)

9.5.1.6 Exchange of controller data via IPE file

Exchange of controller data via "IPE file"
To export the controller data of the higher-level CPU displayed in the device proxy data, follow 
these steps:

1. Open the TIA Portal project from which you want to import the controller data into the target 
project.

2. Compile the project to ensure consistency in your project.

3. In your project, create the object "Device Proxy Data" below the required CPU by clicking 
the corresponding command "Add Device Proxy Data" in the "Device Proxy Data" folder.
Result: The "Device Proxy Data" object has been created.

4. Select the device proxy data in the project tree and double-click the object to open it in the 
editor.

5. Enter the required data for the device proxy data in the editor under "General" or apply the 
default setting. You can change the name and enter a comment.
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6. In the "Define content" area of the editor select which of the existing controller data you 
want to provide by means of the device proxy data.

7. Click the command "Export device proxy data" to export.

8. In the subsequent dialog, enter the name and storage location for the data to be exported 
and click "Save". The ".ipe" format is automatically specified as file format for the device 
proxy data file during the export.

Result
The selected device proxy data is exported and a progress bar for the export is displayed. 

You receive a message as soon as the export is successfully completed.

The controller data of the selected CPU were stored in the saved ".ipe" file and can be 
conveniently forwarded, for example, by e-mail. The controller data can be imported in other 
devices without additional configuration, for example, for visualization and can be used further.

See also
Basics of Inter Project Engineering (IPE) (Page 1824)

Requirements for Inter Project Engineering (IPE) (Page 1826)

Procedure for working with Inter Project Engineering (IPE) (Page 1827)

Creating device proxy data (Page 1829)

Opening device proxy data (Page 1830)

9.5.1.7 Exchange of controller data via project file

Exchange of controller data via a project file
 

When exchanging controller data via a project file, device proxy data must be predefined in 
the source project. To export the controller data of the higher-level CPU displayed in the device 
proxy data as project file, follow these steps:

1. Open the TIA Portal project from which you want to import the controller data into the target 
project.

2. Compile the project to ensure consistency in your project.

3. In your project, create the object "Device Proxy Data" below the required CPU by clicking 
the corresponding command "Add Device Proxy Data" in the "Device Proxy Data" folder.
Result: The "Device Proxy Data" object has been created.

4. Select the device proxy data in the project tree and double-click the object to open it in the 
editor.

5. Enter the required data for the device proxy data in the editor under "General" or apply the 
default setting. You can change the name and enter a comment.
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6. In the "Define content" area of the editor select which of the existing controller data you 
want to provide by means of the device proxy data.

7. Click "Save" to save the changes in the project.  
Result: You have successfully saved the selected controller data in your device proxy data.

8. Open the target project into which the controller data are to be imported. In your target 
project, create a device proxy to import the controller data contained in the project file. To 
do so, click the command "Add new device" and select the required device proxy in the 
dialog that opens.

9. Click "Save" to save the changes in the project.  

10.Click the newly created device proxy and select the "Initialize device proxy" command from 
the shortcut menu.

11.Select the previously created project file with the prepared device proxy data to be used 
for the initialization, and confirm the selection in the following dialog with "OK". 

12.In the following dialog, select the required CPU and select the prepared device proxy data. 
Confirm the dialog with "OK". This starts the initialization.
Result: The controller data from the source project contained in the project file is transferred 
to the device proxy in the target project. 

After the successful exchange of controller data, you can continue with the configuration in 
your target project and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.

 

9.6 Programming examples

9.6.1 LAD programming examples

9.6.1.1 Example of controlling a conveyor belt 

Controlling a conveyor belt   
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 

Programming the PLC
9.6 Programming examples

WinCC Professional V13.0
1832 System Manual, 02/2014



There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
StartSwitch_Left (S1) BOOL Start switch on the left side of the 

conveyor belt
StopSwitch_Left (S2) BOOL Stop switch on the left side of the 

conveyor belt
StartSwitch_Right (S3) BOOL Start switch on the right side of 

the conveyor belt
StopSwitch_Right (S4) BOOL Stop switch on the right side of 

the conveyor belt
MOTOR_ON BOOL Turn on the conveyor belt motor

The following networks show the LAD programming for solving this task:

Network 1:

The conveyor belt motor is switched on when Start switch "S1" or "S3" is pressed.

Network 2:

The conveyor belt motor is switched off when Stop switch "S2" or "S4" is pressed.
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9.6.1.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt     
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RIGHT BOOL Display during movement to right
LEFT BOOL Display during movement to left
CM1 BOOL Edge bit memory 1
CM2 BOOL Edge bit memory 2

The following networks show the LAD programming for solving this task:

Network 1:

If the signal state changes from "0" to "1" (positive edge) at photoelectric barrier "PEB1" and, 
at the same time, the signal state at "PEB2" is "0", the object on the belt is moving to the left.
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Network 2:

If the signal changes from "0" to "1" (positive edge) at photoelectric barrier "PEB2" and, at the 
same time, the signal state at "PEB1" is "0", the object on the belt is moving to the right.

9.6.1.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area   
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 
area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.
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Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RESET BOOL Reset counter 
LOAD BOOL Set counter to value of "PV" 

parameter
STOCK INT Stock at restart
PACKAGECOUNT INT Number of packages in the 

storage area (current count 
value)

STOCK_PACKAGES BOOL Is set if the current count value 
is greater than or equal to the 
value of the tag "STOCK".

STOR_EMPTY BOOL Display lamp: Storage area 
empty

STOR_NOT_EMPTY BOOL Display lamp: Storage area not 
empty

STOR_50%_FULL BOOL Display lamp: Storage area 50% 
full

STOR_90%_FULL BOOL Display lamp: Storage area 90% 
full

STOR_FULL BOOL Display lamp: Storage area full
VOLUME_50 INT Comparison value: 50 packages
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Name Data type Description
VOLUME_90 INT Comparison value: 90 packages
VOLUME_100 INT Comparison value: 100 

packages

The following networks show the LAD programming for activating the lamps:

Network 1:

When a package is delivered to the storage area, the signal state at "PEB1" switches from "0" 
to "1" (positive signal edge). On a positive signal edge at "PEB1", the "Up" counter is enabled, 
and the current count value of "PACKAGECOUNT" is increased by one. 

When a package is delivered from the storage area to the loading dock, the signal state at 
"PEB2" switches from "0" to "1" (positive signal edge). On a positive signal edge at "PEB2", 
the "Down" counter is enabled, and the current count value of "PACKAGECOUNT" is 
decreased by one.

If there are no packages in the storage area ("PACKAGECOUNT" = "0"), the "STOR_EMPTY" 
tag is set to signal state "1", and the "Storage area empty" lamp is switched on.

The current count value can be reset to "0" if the "RESET" tag is set to signal state "1".

If the "LOAD" tag is set to signal state "1", the current count value is set to the value of the 
"STOCK" tag. If the current count value is greater than or equal to the value of the "STOCK" 
tag, the "STOCK_PACKAGES" tag supplies the signal state "1".

Network 2:

As long as there are packages in the storage area, the "STOR_NOT_EMPTY" tag is set to 
signal state "1", and the "Storage area not empty" lamp is switched on.

Network 3:

If the number of packages in the storage area is greater than or equal to 50, the lamp for 
the•"Storage area 50% full" message switches on.
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Network 4:

If the number of packages in the storage area is greater than or equal to 90, the "Storage area 
90% full" lamp switches on.

Network 5:

If the number of packages in the storage area reaches 100, the lamp for the "Storage area 
full" message switches on.

9.6.1.4 Example of controlling room temperature

Controlling room temperature  
In a cold room, the temperature must be maintained below zero degrees Celsius. Any 
temperature fluctuations are monitored by a sensor. If the temperature rises above zero 
degrees Celsius, the cooling system switches on for a preset time. The "Cooling system On" 
lamp is lit during this time.

The cooling system and the lamp are turned off if one of the following conditions is met:

● The sensor reports a temperature fall below zero degrees Celsius.

● The preset cooling time has elapsed.

● The pushbutton switch "STOP" has been pressed.

If the preset cooling time has expired and the temperature in the cold room is still too high, the 
cooling system can be restarted by means of the pushbutton switch "RESET".
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Implementation
The following table shows the definition of the tags used:

Name Data type Comment
Sensor BOOL Temperature sensor signal
RESET BOOL Restart
STOP BOOL The cooling system is switched 

off.
MaxCoolTime TIME Preset cooling time

This tag is defined in the 
"DB_Cool" data block.

CurrCoolTime TIME Currently elapsed cooling time
This tag is defined in the 
"DB_Cool" data block.

Cooling system BOOL The cooling system is switched 
on.

Lamp BOOL The lamp for the "Cooling 
system on" message is switched 
on.

TempVariable BOOL Temporary tag
This tag stores the signal state 
of the IEC time TP.

The following network shows the LAD programming for controlling room temperature:

Network 1:

Network 2:

When the temperature in the cold room rises above zero degrees Celsius, the signal state at 
the "Sensor" operand switches from "0" to "1" (positive signal edge). In the case of a positive 
signal edge at the input IN of the time function, the preset cooling time is started and the 
"TempVariable" receives the signal state "1". The signal state "1" of the "TempVariable" has 
the result in network 2 that the cooling system as well as the display lamp are turned on. The 
outputs "Sensor", "Cooling system" and "Lamp" must be programmed in network 2, because 
you can program only one coil at output Q of the time function.
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If the temperature in the cold room falls below zero degrees Celsius, the signal state of the 
sensor switches back to "0". This switches the cooling system and lamp off.

If the sensor does not signal a temperature drop, the cooling system and lamp are switched 
off after the preset cooling time has elapsed, at the latest. In this case, the cooling process 
can be restarted by pressing the "RESET" pushbutton switch. Pressing and releasing the 
pushbutton switch generates a new positive signal edge at input IN, which restarts the cooling 
system.

Using the pushbutton switch "STOP", the cooling system and the display lamp can be turned 
off at any time.

9.6.2 FBD programming examples

9.6.2.1 Example of controlling a conveyor belt 

Controlling a conveyor belt     
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 
There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
StartSwitch_Left (S1) BOOL Start switch on the left side of the 

conveyor belt
StopSwitch_Left (S2) BOOL Stop switch on the left side of the 

conveyor belt
StartSwitch_Right (S3) BOOL Start switch on the right side of 

the conveyor belt
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Name Data type Description
StopSwitch_Right (S4) BOOL Stop switch on the right side of 

the conveyor belt
MOTOR_ON BOOL Turn on the conveyor belt motor

The following networks show the FBD programming for solving this task:

Network 1:

The conveyor belt motor is switched on when Start switch "S1" or "S3" is pressed.

Network 2:

The conveyor belt motor is switched off when stop switch "S2" or "S4" is pressed.

9.6.2.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt    
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.
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Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RIGHT BOOL Display during movement to right
LEFT BOOL Display during movement to left
CM1 BOOL Edge bit memory 1
CM2 BOOL Edge bit memory 2

The following networks show the FBD programming for solving this task:

Network 1:

If the signal state changes from "0" to "1" (positive edge) at photoelectric barrier "PEB1" and, 
at the same time, the signal state at "PEB2" is "0", the object on the belt is moving to the left.

Network 2:

If the signal changes from "0" to "1" (positive edge) at photoelectric barrier "PEB2" and, at the 
same time, the signal state at "PEB1" is "0", the object on the belt is moving to the right.

9.6.2.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area    
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 
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area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.

Implementation
The following table shows the definition of the tags used:

Name Data type Description
PEB1 BOOL Photoelectric barrier 1
PEB2 BOOL Photoelectric barrier 2
RESET BOOL Reset counter
LOAD BOOL Set counter to value of "CV" 

parameter
STOCK INT Stock at restart
PACKAGECOUNT INT Number of packages in the 

storage area (current count 
value)

STOCK_PACKAGES BOOL Is set if the current count value 
is greater than or equal to the 
value of the tag "STOCK".

STOR_EMPTY BOOL Display lamp: Storage area 
empty

STOR_NOT_EMPTY BOOL Display lamp: Storage area not 
empty

STOR_50%_FULL BOOL Display lamp: Storage area 50% 
full
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Name Data type Description
STOR_90%_FULL BOOL Display lamp: Storage area 90% 

full
STOR_FULL BOOL Display lamp: Storage area full
VOLUME_50 INT Comparison value: 50 packages
VOLUME_90 INT Comparison value: 90 packages
VOLUME_100 INT Comparison value: 100 

packages

The following networks show the FBD programming for activating the lamps:

Network 1:

When a package is delivered to the storage area, the signal state at "PEB1" switches from "0" 
to "1" (positive signal edge). On a positive signal edge at "PEB1", the "Up" counter is enabled, 
and the current count value of "PACKAGECOUNT" is increased by one.

When a package is delivered from the storage area to the loading dock, the signal state at 
"PEB2" switches from "0" to "1" (positive signal edge). On a positive signal edge at "PEB2", 
the "Down" counter is enabled, and the current count value of "PACKAGECOUNT" is 
decreased by one.

If there are no packages in the storage area ("PACKAGECOUNT" = "0"), the "STOR_EMPTY" 
tag is set to signal state "1", and the "Storage area empty" lamp is switched on.

The current count value can be reset to "0" if the "RESET" tag is set to signal state "1".

If the "LOAD" tag is set to signal state "1", the current count value is set to the value of the 
"STOCK" tag. If the current count value is greater than or equal to the value of the "STOCK" 
tag, the "STOCK_PACKAGES" tag supplies the signal state "1".

Network 2:

As long as there are packages in the storage area, the "STOR_NOT_EMPTY" tag is set to 
signal state "1", and the "Storage area not empty" lamp is switched on.

Network 3:
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If the number of packages in the storage area is greater than or equal to 50, the lamp for the 
"Storage area 50% full" message switches on.

Network 4:

If the number of packages in the storage area is greater than or equal to 90, the "Storage area 
90% full" lamp switches on.

Network 5:

If the number of packages in the storage area reaches 100, the lamp for the "Storage area 
full" message switches on.

9.6.2.4 Example of controlling room temperature

Controlling room temperature  
In a cold room, the temperature must be maintained below zero degrees Celsius. Any 
temperature fluctuations are monitored by a sensor. If the temperature rises above zero 
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degrees Celsius, the cooling system switches on for a preset time. The "Cooling system on" 
lamp is lit during this time.

The cooling system and the lamp are turned off if one of the following conditions is met:

● The sensor reports a temperature fall below zero degrees Celsius.

● The preset cooling time has elapsed.

● The pushbutton switch "Stop" has been pressed.

If the preset cooling time has expired and the temperature in the cold room is still too high, the 
cooling system can be restarted by means of the pushbutton switch "RESET".

Implementation
The following table shows the definition of the tags used:

Name Data type Comment
Sensor BOOL Temperature sensor signal
RESET BOOL Restart
STOP BOOL The cooling system is switched 

off.
MaxCoolTime TIME Preset cooling time

This tag is defined in the 
"DB_Cool" data block.

CurrCoolTime TIME Currently elapsed cooling time
This tag is defined in the 
"DB_Cool" data block.

Cooling system BOOL The cooling system is switched 
on.

Lamp BOOL The lamp for the "Cooling 
system on" message is switched 
on.

TempVariable BOOL Temporary tag
This tag stores the signal state 
of the IEC time TP.

The following network shows the FBD programming for controlling room temperature:

Network 1:
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Network 2:

When the temperature in the cold room rises above zero degrees Celsius, the signal state at 
the "Sensor" operand switches from "0" to "1" (positive signal edge). In the case of a positive 
signal edge at the input IN of the time function, the preset cooling time is started and the 
"TempVariable" receives the signal state "1". The signal state "1" of the "TempVariable" has 
the result in network 2 that the cooling system as well as the display lamp are turned on. The 
outputs "Sensor", "Cooling system" and "Lamp" must be programmed in network 2, because 
you can program only one coil at output Q of the time function.

If the temperature in the cold room falls below zero degrees Celsius, the signal state of the 
sensor switches back to "0". This switches the cooling system and lamp off.

If the sensor does not signal a temperature drop, the cooling system and lamp are switched 
off after the preset cooling time has elapsed, at the latest. In this case, the cooling process 
can be restarted by pressing the pushbutton switch "RESET". Pressing and releasing the 
pushbutton switch generates a new positive signal edge at input IN, which restarts the cooling 
system.

Using the pushbutton switch "STOP", the cooling system and the display lamp can be turned 
off at any time.

9.6.3 SCL programming examples

9.6.3.1 Example: Bit logic instructions

Controlling a conveyor belt
The following figure shows a conveyor belt that can be activated electrically. There are two 
pushbutton switches at the beginning of the conveyor belt: S1 for START and S2 for STOP. 
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There are also two pushbutton switches at the end of the conveyor belt: S3 for START and 
S4 for STOP. It is possible to start and stop the conveyor belt from either end.

Implementation
The following table shows the definition of the tags used:

Operand Declaration Data type Description
StartSwitch_Left (S1) Input BOOL Start switch on the left 

side of the conveyor belt
StopSwitch_Left (S2) Input BOOL Stop switch on the left 

side of the conveyor belt
StartSwitch_Right (S3) Input BOOL Start switch on the right 

side of the conveyor belt
StopSwitch_Right (S4) Input BOOL Stop switch on the right 

side of the conveyor belt
MOTOR_ON Output BOOL Turn on the conveyor 

belt motor
MOTOR_OFF Output BOOL Turn off the conveyor 

belt motor

The following SCL program shows how to implement this task:

SCL
IF "StartSwitch_Left" OR "StartSwitch_Right" THEN
"MOTOR_ON" := 1;
END_IF;
IF "StopSwitch_Left" OR "StopSwitch_Right" THEN 
"MOTOR_OFF" := 1;
END_IF;

The conveyor belt motor is switched on when start switch "StartSwitch_Left" or 
"StartSwitch_Right" is pressed. The conveyor belt motor is switched off when stop switch 
"StopSwitch_Left" or "StopSwitch_Right" is pressed.
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9.6.3.2 Example of detecting the direction of a conveyor belt

Detecting the direction of a conveyor belt
The following figure shows a conveyor belt that is equipped with two photoelectric barriers 
(PEB1 and PEB2). The photoelectric barriers are designed to detect the direction in which an 
object is moving on the conveyor belt.

Implementation
The following table shows the definition of the tags used:

Name Declaration Data type Description
Photoelectric barrier 
LS1

Input BOOL Photoelectric barrier 1

Photoelectric barrier 
LS2

Input BOOL Photoelectric barrier 2

RIGHT Output BOOL Display for movement 
to the right

LEFT Output BOOL Display for movement 
to the left

The following SCL program shows how to implement this example:

SCL
IF "LS1" = 1 AND NOT "LS2" = 0
THEN "LEFT" = 1;
IF "LS2" = 1 AND NOT "LS1" = 0
THEN "RIGHT" := 1;
IF "LS2" = 0 
THEN "RIGHT" := 0;
IF "LS1" = 0
THEN "LEFT" = 0;

If the photoelectric barrier "PEB1" has signal state "1" and the photoelectric barrier "PEB2" 
has signal state "0" at the same time, the object on the belt is moving to the left. If the 
photoelectric barrier "PEB2" has signal state "1" and the photoelectric barrier "PEB1" has signal 
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state "0" at the same time, the object on the belt is moving to the right. The displays for a 
movement to the left or right will be turned off when the signal state at both photoelectric 
barriers is "0".

9.6.3.3 Example of detecting the fill level of a storage area 

Detecting the fill level of a storage area   
The following figure shows a system with two conveyor belts and a temporary storage area 
between them. Conveyor belt 1 delivers packages to the storage area. A photoelectric barrier 
at the end of conveyor belt 1 near the storage area detects how many packages are delivered 
to the storage area. Conveyor belt 2 transports packages from the temporary storage area to 
a loading dock onto which the packages are loaded for delivery to customers by truck. A 
photoelectric barrier at the storage area exit detects how many packages leave the storage 
area to be transported to the loading dock. Five display lamps indicate the capacity of the 
temporary storage area.

When a conveyor belt is restarted, the current count value is set to the number of packages 
available in the storage area.

Implementation
The following table shows the definition of the tags used:

Name Declaration Data type Description
PEB1 Input BOOL Photoelectric barrier 1
PEB2 Input BOOL Photoelectric barrier 2
RESET Input BOOL Reset counter
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Name Declaration Data type Description
LOAD Input BOOL Set counter to value of 

"CV" parameter
STOCK Input INT Stock at restart
PACKAGECOUNT Output INT Number of packages in 

the storage area 
(current count value)

STOCK_PACKAGES Output BOOL Is set if the current 
count value is greater 
than or equal to the 
value of the tag 
"STOCK".

STOR_EMPTY Output BOOL Display lamp: Storage 
area empty

STOR_NOT_EMPTY Output BOOL Display lamp: Storage 
area not empty

STOR_50%_FULL Output BOOL Display lamp: Storage 
area 50% full

STOR_90%_FULL Output BOOL Display lamp: Storage 
area 90% full

STOR_FULL Output BOOL Display lamp: Storage 
area full

VOLUME_50 Input INT Comparison value: 50 
packages

VOLUME_90 Input INT Comparison value: 90 
packages

VOLUME_100 Input INT Comparison value: 100 
packages

The following SCL program shows how to implement this example:

When a package is delivered to the storage area, the signal state at "PEB1" switches from "0" 
to "1" (positive signal edge). On a positive signal edge at "PEB1", the "Up" counter is enabled, 
and the current count value of "PACKAGECOUNT" is increased by one.

When a package is delivered from the storage area to the loading dock, the signal state at 
"PEB2" switches from "0" to "1" (positive signal edge). On a positive signal edge at "PEB2", 
the "Down" counter is enabled, and the current count value of "PACKAGECOUNT" is 
decreased by one.

If there are no packages in the storage area ("PACKAGECOUNT" = "0"), the "STOR_EMPTY" 
tag is set to signal state "1", and the "Storage area empty" lamp is switched on.

The current count value can be reset to "0" if the "RESET" tag is set to signal state "1".

If the "LOAD" tag is set to signal state "1", the current count value is set to the value of the 
"STOCK" tag. If the current count value is greater than or equal to the value of the "STOCK" 
tag, the "STOCK_PACKAGES" tag supplies the signal state "1".

SCL
"CTUD_DB".CTUD(CU := "PEB1",
               CD := "PEB2",
               R  := "RESET",
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SCL
               LD := "LOAD",
               PV := "STOCK",
               QU := "STOCK_PACKAGES",
               QD := "STOR_EMPTY",
               CV := "PACKAGECOUNT");

As long as there are packages in the storage area, the "STOR_NOT_EMPTY" tag is set to 
signal state "1", and the "Storage area not empty" lamp is switched on.

SCL
"STOR_NOT_EMPTY" := NOT "STOR_EMPTY"

If the number of packages in the storage area is greater than or equal to 50, the lamp for 
the•"Storage area 50% full" message switches on.

SCL
IF "PACKAGECOUNT" >= "VOLUME_50" THEN "STOR_50%_FULL" := 1;
IF "PACKAGECOUNT" <= "VOLUME_90" THEN "STOR_50%_FULL" := 1;

If the number of packages in the storage area is greater than or equal to 90, the "Storage area 
90% full" lamp switches on.

SCL
IF "PACKAGECOUNT" >= "VOLUME_90" THEN "STOR_90%_FULL" := 1;
IF "PACKAGECOUNT" <= "VOLUME_100" THEN "STOR_90%_FULL" := 1;

If the number of packages in the storage area reaches 100, the lamp for the "Storage area 
full" message switches on.

SCL
IF "PACKAGECOUNT" >= "VOLUME_100" THEN "STOR_FULL" := 1;

9.7 References

9.7.1 General parameters of the instructions

9.7.1.1 Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous instructions

Asynchronous instructions
For instructions that work asynchronously, the function is executed with several calls.
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Identification of the job
If you use asynchronous instructions to trigger a process interrupt, output control commands 
to DP slaves, start a data transfer, or abort a non-configured connection with one of the SFCs 
listed above and then call the same SFC again before the current job is completed, then the 
reaction of the SFC will depend on whether the second call involves the same job. 

Parameter REQ
The input parameter REQ (request) is used solely to start the job:

● If you call the instruction for a job that is not currently active, the job is started with REQ = 
1 (case 1).

● If a particular job has been started and not yet completed and you call the instruction again 
to perform the same job (for example, in a cyclic interrupt OB), then REQ is not evaluated 
by the instruction (case 2).

Parameter RET_VAL and BUSY
The output parameters RET_VAL and BUSY indicate the status of the job. 

Pay attention to the note in section: Evaluating errors with output parameter RET_VAL 
(Page 1854) 

● In case 1 (first call with REQ=1), the input parameter will be entered in 
RET_VALW#16#7001 if system resources are available and supply is correct. BUSY will 
be set.
If the required system resources are currently being used or the input parameters have 
errors, the corresponding error code is entered in RET_VAL and BUSY has the value 0.

● In case 2 (interim call) W#16#7002 will be entered in RET_VAL (this corresponds to a 
warning: Job still being processed!), and BUSY will be set.

● The following applies to the last call for a job:

– For instruction "DPNRM_DG", the number of data in bytes will entered as integer in 
RET_VAL in case there are no errors in data transmission. BUSY has the value "0" in 
this case.
If there is an error, then the error information will be entered in RET_VAL and you should 
not evaluate BUSY in this case.

– For all other instructions, "0" will be entered in RET_VAL if the job was executed without 
errors and BUSY has the value "0" in this case. If there is an error, the error code is 
entered in RET_VAL and BUSY has the value "0" in this case.

 

  Note

If the first and last call coincide, the reaction is the same for RET_VAL and BUSY as 
described for the last call.
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Overview
The following table provides you with an overview of the relationships explained above. In 
particular, it shows the possible values of the output parameters if the execution of the job is 
not completed after an instruction call has been completed. 

 

 Note

Following every call, you must evaluate the relevant output parameters in your program.
 

Relationship between call, REQ, RET_VAL and BUSY during execution of a "running" job.

Number of the 
call

Type of call REQ RET_VAL BUSY

1 First call 1 W#16#7001 1
   Error code 0
2 to (n - 1) Intermediate call irrelevant W#16#7002 1
n Last call irrelevant W#16#0000, if no errors have occurred. 0
   Error code if errors occurred 0

9.7.1.2 Evaluating errors with output parameter RET_VAL

Types of error information 
An executed instruction indicates in the user program whether or not the CPU was able to 
execute the function of the instruction successfully. 

You can obtain information about any errors that occurred in two ways:

● In the BR bit of the status word

● in the output parameter RET_VAL (return value).
 

  Note

Before evaluating the output parameters specific to an instruction, you should always 
follow the steps below:
● First, evaluate the BR bit of the status word.
● Then check the output parameter RET_VAL.

If the BR bit indicates that an error has occurred or if RET_VAL contains a general error 
code, you should not evaluate the instruction-specific output parameters.

 

Error information in the return value
An instruction indicates that an error occurred during its execution by entering the value "0" in 
the binary result bit (BR) of the status word. Some instructions provide an additional error code 
at an output parameter known as the return value (RET_VAL). If a general error is entered in 
the output parameter RET_VAL (see below for explanation), this is only indicated by the value 
"0" in the BR bit of the status word. 
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The return value is of the data type integer (INT). The relationship of the return value to the 
value "0" indicates whether or not an error occurred during execution of the function. 

CPU execution of the 
instruction

BR Return value Sign of the integer

With error(s) 0 less than "0" negative 
(sign bit is "1") 

Without error 1 greater than or
 equal to "0"

positive 
(sign bit is "0")

Reacting to error information
There are two types of error codes in RET_VAL:

● A general error code that all instructions can output and

● A specific error code that an instruction can output and which relates to its specific function.

You can write your program so that it reacts to the errors that occur during execution of an 
instruction. This way you prevent further errors occurring as a result of the first error.

General and specific error information
The return value (RET_VAL) of an instruction provides one of the two following types of error 
codes:

● A general error code that relates to errors that can occur in any instruction.

● A specific error code that relates only to the particular instruction.

Even though the data type of the output parameter RET_VAL is an integer (INT), the error 
codes for the instruction are grouped according to hexadecimal values. If you want to examine 
a return value and compare the value with the error codes listed in this documentation, then 
display the error code in hexadecimal format.

The figure below shows the structure of a system function error code in hexadecimal format.
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General error information
The general error code indicates errors that can occur in all instructions. A general error code 
consists of the following two numbers:

● A parameter number from 1 to 111, where 1 indicates the first parameter of the called 
instruction, 2 the second parameter, and so forth.

● An event number from 0 to 127. The event number indicates that a synchronous error 
occurred.

The following table lists the codes for general errors and an explanation of each error.

 

 Note

If a general error code was entered in RET_VAL, then the following situations are possible:
● The action associated with the instruction may have been started or already completed.
● A specific instruction error may have occurred when the action was performed. As a result 

of a general error that occurred later, the specific error could, however, no longer be 
indicated.

 

Specific error information
Some instructions have a return value that provides an error code specific for the instruction. 
A specific error code indicates errors that can occur only in specific instructions.
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A specific error code consists of the following two numbers: 

● An error class from 0 to 7.

● An error number from 0 to 15.

General error codes
The following table explains the general error codes of a return value. The error code is shown 
in hexadecimal format. The letter x in each code number is simply a place holder and 
represents the number of the system function parameter that caused the error.

General error codes

Error code

(W#16#...)

Explanation

8x7F Internal error
This error code indicates an internal error at parameter x.

8x01 Illegal syntax ID at an VARIANT parameter
8x22 Range length error when reading a parameter.
8x23 Range length error when writing a parameter.

This error code indicates that the parameter x is located either entirely or partly outside 
the range of an address, or that the length of a bit range is not a multiple of 8 with an 
VARIANT parameter.

8x24 Range error when reading a parameter.
8x25 Range error when writing a parameter.

This error code indicates that the parameter x is located in a range that is illegal for 
the system function. Refer to the descriptions of the individual functions for information 
about the illegal ranges.

8x26 The parameter contains a timer cell number that is too high.
This error code indicates that the timer cell specified in parameter x does not exist.

8x27 The parameter contains a counter cell number that is too high (counter number error).
This error code indicates that the counter cell specified in parameter x does not exist.

8x28 Alignment error when reading a parameter.
8x29 Alignment error when writing a parameter.

This error code indicates that the reference to parameter x is an operand with bit 
address that is not equal to 0.

8x30 The parameter is located in a read-only global DB.
8x31 The parameter is located in a read-only instance DB.

This error code indicates that parameter x is located in a read-only data block. If the 
data block was opened by the system function itself, the system function always 
returns the value W#16#8x30.
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Error code

(W#16#...)

Explanation

8x32 The parameter contains a DB number that is too high (DB number error).
8x34 The parameter contains an FC number that is too high (FC number error).
8x35 The parameter contains an FB number that is too high (FB number error).

This error code indicates that parameter x contains a block number higher than the 
highest permitted number.

8x3A The parameter contains the number of a DB that is not loaded.
8x3C The parameter contains the number of an FC that is not loaded.
8x3E The parameter contains the number of an FB that is not loaded.
8x42 An access error occurred while the system was attempting to read a parameter from 

the peripheral input area.
8x43 An access error occurred while the system was attempting to write a parameter to the 

peripheral output area.
8x44 Error in the nth (n > 1) read access after an error occurred.
8x45 Error in the nth (n > 1) write access after an error occurred.

This error code indicates that access to the required parameter is denied.

9.7.2 Basic instructions

9.7.2.1 LAD

 

---|   |---: Normally open contact

Description   
The activation of the normally open contact depends on the signal state of the associated 
operand. When the operand has signal state "1", the normally open contact closes and the 
signal state at the output is set to the signal state of the input.

When the operand has signal state "0", the normally open contact is not activated and the 
signal state at the output of the instruction is reset to "0".

Two or more normally open contacts are linked bit-by-bit by AND when connected in series. 
With a series connection, power flows when all contacts are closed.

The normally open contacts are linked by OR when connected in parallel. With a parallel 
connection, power flows when one of the contacts is closed.
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Parameter
The following table shows the parameters of the instruction:

Paramete
r

Declaratio
n

Data 
type

Memory area Description
S7-1200 S7-1500

<Operan
d>

Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Operand whose 
signal state is 
queried.

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "1".

See also
Overview of the valid data types (Page 1320)

---| / |---: Normally closed contact

Description   
The activation of the normally closed contact depends on the signal state of the associated 
operand. When the operand has signal state "1", the normally closed contact opens and the 
signal state at the output of the instruction is reset to "0".

When the operand has signal state "0", the normally closed contact is not enabled and the 
signal state of the input is transferred to the output.

Two or more normally closed contacts are linked bit-by-bit by AND when connected in series. 
With a series connection, power flows when all contacts are closed.

The normally closed contacts are linked by OR when connected in parallel. With a parallel 
connection, power flows when one of the contacts is closed.
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Parameter
The following table shows the parameters of the instruction:

Parameter Declaratio
n

Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Operand 
whose signal 
state is 
queried.

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Overview of the valid data types (Page 1320)

--|NOT|--: Invert RLO

Description       
You use the "Invert RLO" instruction to invert the signal state of the result of logic operation 
(RLO). If the signal state is "1" at the input of the instruction, the output of the instruction has 
signal state "0". If the signal state is "0" at the input of the instruction, the output has the signal 
state "1".
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Example
The following example shows how the instruction works:

Operand "TagOut" is reset when one of the following conditions is fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The signal state of the operands "TagIn_2" and "TagIn_3" is "1".

---(   )---: Assignment

Description     
You can use the "Assignment" instruction to set the bit of a specified operand. If the result of 
logic operation (RLO) at the input of the coil has signal state "1", the specified operand is set 
to signal state "1". If the signal state is "0" at the input of the coil, the bit of the specified operand 
is reset to "0".

The instruction does not influence the RLO. The RLO at the input of the coil is sent directly to 
the output.

Parameter
The following table shows the parameters of the "Assignment" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the RLO is 
assigned.

Example
The following example shows how the instruction works:

The "TagOut_1" operand is set when one of the following conditions is fulfilled:
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● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

The "TagOut_2" operand is set when one of the following conditions is fulfilled:

● Operands "TagIn_1", "TagIn_2", and "TagIn_4" have signal state "1".

● The signal state of the "TagIn_3" operand is "0" and the signal state of the "TagIn_4" 
operand is "1".

See also
Overview of the valid data types (Page 1320)

--( / )--: Negate assignment

Description     
The "Negate assignment" instruction inverts the result of logic operation (RLO) and assigns it 
to the specified operand. When the RLO at the input of the coil is "1", the operand is reset. 
When the RLO at the input of the coil is "0", the operand is set to signal state "1".

Parameter
The following table shows the parameters of the "Negate assignment" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the RLO is 
assigned.

Example
The following example shows how the instruction works:

Operand "TagOut_1" is reset when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

Programming the PLC
9.7 References

WinCC Professional V13.0
1862 System Manual, 02/2014



See also
Overview of the valid data types (Page 1320)

---( R )---: Reset output

Description     
You can use the "Reset output" instruction to reset the signal state of a specified operand to 
"0".

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If power flows to the coil (RLO = "1"), the specified operand is reset to "0". If the RLO at 
the input of the coil is "0" (no signal flow to the coil), the signal state of the specified operand 
remains unchanged.

Parameter
The following table shows the parameters of the "Reset output" instruction:

Parameter Declaration Data type Memory area  
S7-1200 S7-1500 Description

<Operand> Output BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Operand that 
is reset when 
RLO = "1".

Example
The following example shows how the instruction works:

Operand "TagOut" is reset when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1320)
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---( S )---: Set output

Description     
You can use the "Set output" instruction to set the signal state of a specified operand to "1".

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If power flows to the coil (RLO = "1"), the specified operand is set to "1". If the RLO at the 
input of the coil is "0" (no signal flow to the coil), the signal state of the specified operand 
remains unchanged.

Parameter
The following table shows the parameters of the "Set output" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand which is 

set with RLO = "1".

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The signal state of the operand "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1320)

SET_BF: Set bit field

Description       
You use the instruction "Set bit field" to set multiple bits starting from a certain address.

You determine the number of bits to be set using the value of <Operand1>. The address of 
the first bit to be set is defined by <Operand2>. If the value of <Operand1> is greater than the 
number of bits in a selected byte, then the bits of the next byte will be set. The bits remain set 
until they are explicitly reset, for example, by another instruction.
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The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If the RLO at the input of the coil is "0", the instruction does not execute.

Parameter
The following table shows the parameters of the "Set bit field" instruction:

Parameter Declaration Data type Memory area Description
<Operand2> Output BOOL I, Q, M

In the case of a DB 
or an IDB, an 
element of an 
ARRAY[..] of 
BOOL

Pointer to the first 
bit to be set.

<Operand1> Input UINT Constant Number of bits to 
be set.

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are set starting at the 
address of the operand "MyDB".MyBoolArray[4]

See also
Overview of the valid data types (Page 1320)

RESET_BF: Reset bit field

Description       
You use the "Reset bit field" instruction to reset several bits starting from a certain address.

You specify the number of bits to be reset using the value of <Operand1>. The address of the 
first bit to be reset is specified by <Operand2>. If the value of <Operand1> is greater than the 
number of bits in a selected byte, the bits of the next byte will be reset. The bits remain reset 
until they are explicitly set, for example, by another instruction.

The instruction is only executed if the result of logic operation (RLO) at the input of the coil is 
"1". If the RLO at the input of the coil is "0", the instruction does not execute.
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Parameter
The following table shows the parameters of the "Reset bit field" instruction:

Parameter Declaration Data type Memory area Description
<Operand2> Output BOOL I, Q, M

In the case of a DB 
or an IDB, an 
element of an 
ARRAY[..] of 
BOOL

Pointer to the first 
bit to be reset.

<Operand1> Input UINT Constant Number of bits to 
be reset.

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are reset starting at 
the address of the operand "MyDB".MyBoolArray[4]

See also
Overview of the valid data types (Page 1320)

SR: Set/reset flip-flop

Description       
Use the instruction "Set/reset flip-flop" to set or reset the bit of the specified operand, depending 
on the signal state of the inputs S and  R1. If the signal state is "1" at input S and "0" at input 
R1, the specified operand is set to "1". If the signal state is "0" at input S and "1" at input R1, 
the specified operand will be reset to "0".

Input R1 takes priority over input S. When the signal state is "1" on both inputs S and R1, the 
signal state of the specified operand is reset to "0".

The instruction is not executed if the signal state at the two inputs S and R1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.
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Parameter
The following table shows the parameters of the "Set/reset flip-flop" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

S Input BOOL I, Q, M, D, L I, Q, M, D, L Enable setting
R1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 

C
Enable 
resetting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is set or reset.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:

The operands "TagSR" and "TagOut" are set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagSR" and "TagOut" are reset when one of the following conditions is fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1320)

RS: Reset/set flip-flop

Description       
You can use the "Reset/set flip-flop" instruction to reset or set the bit of a specified operand 
based on the signal state of the inputs R and S1. If the signal state is "1" at input R and "0" at 
input S1, the specified operand will be reset to "0". If the signal state is "0" at input R and "1" 
at input S1, the specified operand is set to "1".

Input S1 takes priority over input R. When the signal state is "1" at both inputs R and S1, the 
signal state of the specified operand is set to "1".
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The instruction is not executed if the signal state at the two inputs R and S1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.

Parameter
The following table shows the parameters of the "Reset/set flip-flop" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

R Input BOOL I, Q, M, D, L I, Q, M, D, L Enable 
resetting

S1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable setting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is reset or set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:

The operands "TagRS" and "TagOut" are reset when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagRS" and "TagOut" are set when one of the following conditions is fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1320)
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--|P|--: Scan operand for positive signal edge

Description
You can use the "Scan operand for positive signal edge" instruction to determine if there is a 
"0" to "1" change in the signal state of a specified operand (<Operand1>). The instruction 
compares the current signal state of <Operand1> with the signal state of the previous scan 
that is saved in an edge memory bit (<Operand2>). If the instruction detects a change in the 
result of logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a positive edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Scan operand for positive signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Signal to be 
scanned

<Operand2> InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory bit 
in which the 
signal state of 
the previous 
query is saved.

Example
The following example shows how the instruction works:

Operand "TagOut" is set when the following conditions are fulfilled:
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● The operands "TagIn_1", "TagIn_2", and "TagIn_3" have signal state "1".

● There is a rising edge at operand "TagIn_4". The signal state of the previous scan is stored 
in the edge memory bit "Tag_M".

● The signal state of the operand "TagIn_5" is "1".

See also
Overview of the valid data types (Page 1320)

--|N|--: Scan operand for negative signal edge

Description
You can use the "Scan operand for negative signal edge" instruction to determine if there is a 
"1" to "0" change in the signal state of a specified operand (<Operand1>). The instruction 
compares the current signal state of <Operand1> with the signal state of the previous scan 
that is saved in an edge memory bit <Operand2>. If the instruction detects a change in the 
result of logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a negative signal edge is detected, the output of the instruction has the signal state "1". In 
all other cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Scan operand for negative signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1
>

Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Signal to be 
scanned

<Operand2
>

InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory bit 
in which the 
signal state of the 
previous query is 
saved.
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Example
The following example shows how the instruction works:

Operand "TagOut" is set when the following conditions are fulfilled:

● The operands "TagIn_1", "TagIn_2", and "TagIn_3" have signal state "1".

● There is a negative signal edge at operand "TagIn_4". The signal state of the previous scan 
is stored in the edge memory bit "Tag_M".

● The signal state of the operand "TagIn_5" is "1".

See also
Overview of the valid data types (Page 1320)

--(P)--: Set operand on positive signal edge

Description
You can use the "Set operand on positive signal edge" instruction to set a specified operand 
(<Operand1>) when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand2>). If the instruction detects a change in the RLO from "0" 
to "1", there is a positive signal edge.

When a positive signal edge is detected, <Operand1> is set to signal state "1" for one program 
cycle. In all other cases, the operand has the signal state "0".

Specify the operand to be set (<Operand1>) in the operand placeholder above the instruction. 
Specify the edge memory bit (<Operand2>) in the operand placeholder below the instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.
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Parameter
The following table shows the parameters of the "Set operand on positive signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
<Operand1> Output BOOL I, Q, M, D, L Operand which is 

set by a positive 
edge.

<Operand2> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows how the instruction works:

Operand "TagOut" is set for one program cycle, when the signal state at the input of the coil 
switches from "0" to "1" (positive signal edge). In all other cases, the operand "TagOut" has 
the signal state "0".

See also
Overview of the valid data types (Page 1320)

--(N)--: Set operand on negative signal edge

Description
You can use the "Set operand on negative signal edge" instruction to set a specified operand 
(<Operand1>) when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand2>). If the instruction detects a change in the RLO from "1" 
to "0", there is a negative edge.

When a negative signal edge is detected, <Operand1> is set to signal state "1" for one program 
cycle. In all other cases, the operand has the signal state "0".
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Specify the operand to be set (<Operand1>) in the operand placeholder above the instruction. 
Specify the edge memory bit (<Operand2>) in the operand placeholder below the instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Set operand on negative signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
<Operand1> Output BOOL I, Q, M, D, L Operand which is 

set by a negative 
edge.

<Operand2> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows how the instruction works:

Operand "TagOut" is set for one program cycle, when the signal state at the input of the coil 
switches from "1" to "0" (negative signal edge). In all other cases, the operand "TagOut" has 
the signal state "0".

See also
Overview of the valid data types (Page 1320)

P_TRIG: Scan RLO for positive signal edge

Description
Use the "Scan RLO for positive signal edge" instruction to query a "0" to "1" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query, which is saved in an edge memory 
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bit (<operand>). If the instruction detects a change in the RLO from "0" to "1", there is a positive 
signal edge.

If a positive edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Scan RLO for positive signal edge" instruction:

Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the previous query is saved in the edge memory bit "Tag_M". If a "0" to "1" change 
is detected in the signal state of the RLO, the program jumps to jump label CAS1.

See also
Overview of the valid data types (Page 1320)
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N_TRIG: Scan RLO for negative signal edge

Description
Use the "Scan RLO for negative signal edge" instruction to query a "1" to "0" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query, which is saved in an edge memory 
bit (<operand>). If the instruction detects a change in the RLO from "1" to "0", there is a negative 
edge.

If a negative signal edge is detected, the output of the instruction has the signal state "1". In 
all other cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the bit memory is overwritten. This step influences the edge evaluation and the 
result is therefore no longer unique. The memory area of the edge memory bit must be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameter
The following table shows the parameters of the "Scan RLO for negative signal edge" 
instruction:

Parameters Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the previous query is saved in the edge memory bit "Tag_M". If a "1" to "0" change 
is detected in the signal state of the RLO, the program jumps to jump label CAS1.
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See also
Overview of the valid data types (Page 1320)

R_TRIG: Set tag on positive signal edge

Description
You can use the "Set tag on positive signal edge" instruction to set a specified tag in the 
instance DB when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the RLO 
from "0" to "1", there is a positive signal edge.

If a positive edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameter
The following table shows the parameters of the instruction "Set tag on positive signal edge":

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CLK Input BOOL I, Q, M, D, L or 

constant
Incoming signal, 
the edge of which 
is to be queried.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation
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Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "R_TRIG_DB". If a change is the 
signal state of the RLO from "0" to "1" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut_Q" has signal state "1".

See also
Overview of the valid data types (Page 1320)

F_TRIG: Set tag on negative signal edge

Description
You can use the "Set tag on negative signal edge" instruction to set a specified tag in the 
instance DB when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the RLO 
from "1" to "0", there is a negative edge.

If a negative edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameter
The following table shows the parameters of the instruction "Set tag on negative signal edge":

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L or 

constant
Incoming signal, 
the edge of which 
is to be queried.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "F_TRIG_DB". If a change is the 
signal state of the RLO from "1" to "0" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut_Q" has signal state "1".

See also
Overview of the valid data types (Page 1320)

Timer operations

IEC Timers

TP: Generate pulse

Description
You can use the "Generate pulse" instruction to set the output Q for a programmed duration. 
The instruction is started when the result of logic operation (RLO) at input IN changes from "0" 
to "1" (positive signal edge). The programmed time PT begins when the instruction starts. 
Output Q is set for the duration PT, regardless of the subsequent course of the input signal. 
Even if a new positive signal edge is detected, the signal state at the output Q is not affected 
as long as the PT time duration is running.
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You can scan the current time value at the ET output. The time value starts at T#0s and ends 
when the value of duration PT is reached. When the duration PT is reached and the signal 
state at input IN is "0", the ET output is reset.

Each call of the "Generate pulse" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, the ET output 
returns a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TP_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME or IEC_TIMER in the "Static" 
section of a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TP_TIME or TP_LTIME 
that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multi-instance) in the block interface. If you create a separate data block, you will find it 
in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate pulse" instruction requires a preceding logic operation. It can 
be placed within or at the end of the network.
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Parameters
The following table shows the parameters of the "Generate pulse" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Duration of 
the pulse
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Pulse output

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate pulse" instruction:

See also
Overview of the valid data types (Page 1320)
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TON: Generate on-delay

Description
You can use the "Generate on-delay" instruction to delay setting of the Q output by the 
programmed duration PT. The instruction is started when the result of logic operation (RLO) 
at input IN changes from "0" to "1" (positive signal edge). The programmed time PT begins 
when the instruction starts. When the duration PT expires, the output Q has the signal state 
"1". Output Q remains set as long as the start input is still "1". When the signal state at the 
start input changes from "1" to "0", the Q output is reset. The timer function is started again 
when a new positive signal edge is detected at the start input.

The current time value can be queried at the ET output. The time value starts at T#0s and 
ends when the value of duration PT is reached. The ET output is reset as soon as the signal 
state at the IN input changes to "0".

Each call of the "Generate on-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, the ET output 
returns a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TON_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TON_TIME or 
TON_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multi-instance) in the block interface. If you create a separate data block, you will find it 
in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.
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The execution of the "Generate on-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Generate on-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Duration of 
the on-delay
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate on-delay" instruction:
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See also
Overview of the valid data types (Page 1320)

TOF: Generate off-delay

Description
You can use the "Generate off-delay" instruction to delay resetting of the Q output by the 
programmed duration PT. The Q output is set when the result of logic operation (RLO) at input 
IN changes from "0" to "1" (positive signal edge). When the signal state at input IN changes 
back to "0", the programmed time PT starts. Output Q remains set as long as the duration PT 
is running. When duration PT expires, the Q output is reset. If the signal state at input IN 
changes to "1" before the PT time duration expires, the timer is reset. The signal state at the 
output Q continues to be "1".

The current time value can be queried at the ET output. The time value starts at T#0s and 
ends when the value of duration PT is reached. When the time duration PT expires, the ET 
output remains set to the current value until the IN input changes back to "1". If input IN switches 
to "1" before the duration PT has expired, the ET output is reset to the value T#0s.

Each call of the "Generate off-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, the ET output 
returns a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TOF_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TOF_TIME or 
TOF_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multi-instance) in the block interface. If you create a separate data block, you will find it 
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in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate off-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Generate off-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Duration of 
the off delay
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Output that 
is reset 
when the 
timer PT 
expires.

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate off-delay" instruction:

See also
Overview of the valid data types (Page 1320)

TONR: Time accumulator

Description
The "Time accumulator" instruction is used to accumulate time values within a period set by 
the PT parameter. When the signal state at input IN changes from "0" to "1" (positive signal 
edge), the instruction executes and the duration PT starts. While the duration PT is running, 
the time values are accumulated that are recorded when the IN input has signal state "1". The 
accumulated time is written to output ET and can be queried there. When the duration PT 
expires, the output Q has the signal state "1". The Q parameter remains set to "1", even when 
the signal state at the IN parameter changes from "1" to "0" (negative signal edge).

The R input resets the outputs ET and Q regardless of the signal state at the start input.

Each call of the "Time accumulator" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC timer is a structure of the data type IEC_TIMER or TONR_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)
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For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TONR_TIME or 
TONR_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multi-instance) in the block interface. If you create a separate data block, you will find it 
in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the Time accumulator" instruction requires a preceding logic operation. It can 
be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Time accumulator" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Start input

R Input BOOL BOOL I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Reset input

PT Input TIME TIME, LTIME I, Q, M, D, 
L or 
constant

I, Q, M, D, L, 
P or constant

Maximum 
duration of 
time 
recording
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, LTIME I, Q, M, D, 
L

I, Q, M, D, L, 
P

Accumulated
 time

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Time accumulator" instruction:

See also
Overview of the valid data types (Page 1320)

---( TP )---: Start pulse timer

Description
Use the "Start pulse timer" instruction to start an IEC timer with a specified duration as pulse. 
The IEC timer is started when the result of logic operation (RLO) changes from "0" to "1" 
(positive signal edge). The IEC timer runs for the specified duration regardless of any 
subsequent changes in the RLO. The run of the IEC timer is also not affected by the detection 
of a new positive signal edge. As long as the IEC timer is running, the querying of the timer 
status for "1" returns the signal state "1". When the IEC timer has expired, the timer status 
returns the signal state "0".

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER or 
TP_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_LTIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TP_TIME or TP_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the Q structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the "Start pulse timer" instruction assumes a preceding logic operation. It can 
be placed only at the end of the network.

Parameter
The following table shows the parameters of the "Start pulse timer" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TP_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start pulse timer" instruction is executed when the signal state of the operand "Tag_Input" 
changes from "0" to "1". The timer "DB1".MyIEC_TIMER is started for the time stored in the 
operand "TagTime".

As long as the timer "DB1". MyIEC_TIMER is running, the timer status 
("DB1".MyIEC_TIMER.Q) has signal state "1" and the operand "Tag_Output" is set. When the 
IEC timer has expired, the signal state of the time status changes back to "0" and the 
"Tag_Output" operand is reset.

See also
Overview of the valid data types (Page 1320)

---( TON )---: Start on-delay timer

Description
Use the "Start on-delay timer" instruction to start an IEC timer with a specified duration as on-
delay. The IEC timer is started when the result of logic operation (RLO) changes from "0" to 
"1" (positive signal edge). The IEC timer runs for the specified time. The output returns the 
signal state "1" if the RLO at the input of the instruction has the signal state "1". If the RLO 
changes to "0" before the time expires, the IEC timer is reset. In this case, querying the timer 
status for "1" returns signal state "0". The IEC timer restarts when the next positive signal edge 
is detected at the input of the instruction.

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start on-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TON_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start on-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TON_TIME or TON_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the ET structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the "Start on-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameter
The following table shows the parameters of the "Start on-delay timer" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TON_TIME

IEC_TIMER, 
IEC_LTIMER, 
TON_TIME, 
TON_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start on-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "0" to "1". The "MyIEC_TIMER timer is started for the time stored 
in the "TagTime" operand.

If the timer "MyIEC_TIMER" has expired and the operand "Tag_Input" has the signal state "1", 
querying the timer status ("MyIEC_TIMER).Q) returns signal state "1" and the "Tag_Output" 
operand is set. When the signal state of the operand "Tag_Input" changes to "0", the querying 
of the timer status returns the signal state "0" and the operand "Tag_Output" is reset.

See also
Overview of the valid data types (Page 1320)

---( TOF )---: Start off-delay timer

Description
Use the "Start off-delay timer" instruction to start an IEC timer with a specified duration as on-
delay. The query of the timer status for "1" returns the signal state "0" if the result of logic 
operation (RLO) at the input of the instruction has the signal state "1". When the RLO changes 
from "1" to "0" (negative signal edge), the IEC timer starts with the specified time. The timer 
status remains at signal state "1" as long as the IEC timer is running. When the timer has run 
out and the RLO at the input of the instruction has the signal state "0", the timer status is set 
to the signal state "0". If the RLO changes to "1" before the time expires, the IEC timer is reset 
and the timer status remains at signal state "1".

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start off-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TOF_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start off-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TOF_TIME or TOF_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the ET structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the "Start off-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameters
The following table shows the parameters of the "Start off-delay timer" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TOF_TIME

IEC_TIMER, 
IEC_LTIMER, 
TOF_TIME, 
TOF_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start off-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "1" to "0". The timer #MyIEC_TIMER is started for the time stored 
in the operand "TagTime".

As long as timer #MyIEC_TIMER is running, the query of the time status (#MyIEC_TIMER.Q) 
returns the signal state "1" and operand "Tag_Output" is set. If the timer has expired and the 
operand "Tag_Input" has the signal state "0", the query of the timer status returns the signal 
state "0". If the signal state of the operand "Tag_Input" changes to "1" before timer 
#MyIEC_TIMER expires, the timer is reset. When the signal state of the operand "Tag_Input" 
is "1", the query of the timer status returns the signal state "1".

See also
Overview of the valid data types (Page 1320)

---( TONR )---: Time accumulator

Description
You can use the "Time accumulator" instruction to record how long the signal is at the input 
of instruction "1". The instruction is started when the result of logic operation (RLO) changes 
from "0" to "1" (positive signal edge). The time is recorded as long at the RLO is "1". If the RLO 
changes to "0", the instruction is halted. If the RLO changes back to "1", the time recording is 
continued. The query of the timer status for "1" returns the signal state "1" if the recorded time 
exceeds the value of the specified duration and the RLO at the input of coil is "1".

The timer status and the currently expired timer can be reset to "0" using the "Reset timer" 
instruction.

 

 Note

You can start and query the IEC timer at various execution levels, as each querying of the 
outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER 
or TONR_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TONR_TIME or TONR_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
assigned timer is accessed.

The current timer status is stored in the ET structure component of the IEC timer. You can use 
a normally open contact to query timer status for "1" or a normally closed contact for "0". The 
query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER 
structure.

The execution of the Time accumulator" instruction requires a preceding logic operation. It can 
be placed only at the end of the network.

Parameter
The following table shows the parameters of the "Time accumulator" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> InOut IEC_TIMER, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TONR_TIME, 
TONR_LTIME

D, L IEC timer that 
is started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Time accumulator" instruction executes on a positive signal edge in the RLO. The time 
is recorded as long as the operand "Tag_Input" has the signal state "1".

If the recorded time exceeds the value of the operand "TagTime", then the query of the timer 
status ("MyIEC_TIMER".Q) will return the signal state "1" and the operand "Tag_Output" will 
be set.

See also
Overview of the valid data types (Page 1320)

---( RT )---: Reset timer

Description     
You can use the "Reset timer" instruction to reset an IEC timer to "0". The instruction is only 
executed if the result of logic operation (RLO) at the input of the coil is "1". If current is flowing 
to the coil (RLO is "1"), the structure components of the timer in the specified data block are 
reset to "0". If the RLO at the input of the instruction is "0", the timer remains unchanged.

The instruction does not influence the RLO. The RLO at the input of the coil is sent directly to 
the output of the coil.

You assign the "Reset timer" instruction an IEC timer that has been declared in the program.

The instruction data is updated only when the instruction is called and not each time the 
assigned IEC timer is accessed. Querying the data is only identical from the call of the 
instruction to the next call of the instruction.
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Parameters
The following table shows the parameters of the "Reset timer" instruction":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<IEC timer> Output IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC timer that 
is reset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The timer stored in the "TON_DB" instance data block starts 
running for the time duration specified by operand "Tag_PT".

If operands "Tag_Input_2" and "Tag_Input_3" have the signal state "1", the "Reset timer" 
instruction is executed and the timer stored in the "TON_DB" data block.

See also
Overview of the valid data types (Page 1320)

---( PT )---: Load time duration

Description   
You can use the "Load time duration" instruction to set the time for an IEC timer. The instruction 
is executed in every cycle when the result of logic operation (RLO) at the input of the instruction 
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has the signal state "1". The instruction writes the specified time to the structure of the specified 
IEC timer.

 

 Note

If the specified IEC timer is running while the instruction executes, the instruction overwrites 
the current time of the specified IEC timer. This can change the timer status of the IEC timer.

 

You assign an IEC timer declared in the program to the "Load time duration" instruction.

The instruction data is updated only when the instruction is called and each time the assigned 
IEC timer is accessed. The query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) 
updates the IEC_TIMER structure.

Parameter
The following table shows the parameters of the "Load time duration" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Time 
duration>

Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
timer runs.

<IEC timer> Output IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC timer, the 
duration of 
which is set.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The IEC timer stored in the instance data block "TON_DB" 
is started with the time duration that is specified by the operand "Tag_PT".
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The "Load time duration" instruction is executed when the operand "Tag_Input_2" has the 
signal state "1". The instruction writes the time duration "Tag_PT_2" in the instance data block 
"TON_DB" and at the same time overwrites the value of the operand "Tag_PT" within the data 
block. The signal state of the timer status may therefore change at the next query or when 
"MyTimer".Q or "MyTimer".ET are accessed.

See also
Overview of the valid data types (Page 1320)

SIMATIC Timers

S_PULSE: Assign pulse timer parameters and start

Description
The "Assign pulse timer parameters and start" instruction starts a programmed timer when a 
change from "0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV) as soon as the signal state 
at input S is "1". If the signal state at input S changes to "0" before the programmed duration 
expires, the timer is stopped. In this case, the signal state at output Q is "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1" then the current time value 
and the time base are also set to zero. If the timer is not running, the signal state "1" at the R 
input has no effect.

The "Assign pulse timer parameters and start" instruction requires a preceding logic operation 
for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the instruction "Assign pulse timer parameters 
and start":

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the instruction "Assign pulse timer 
parameters and start":

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" as long as the 
operand "TagIn_1" has the signal state "1". If the signal state of the operand "TagIn_1" changes 
from "1" to "0" before the timer expires, the timer "Timer_1" is stopped. The operand "TagOut" 
is reset to "0" in this case.
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The operand "TagOut" has the signal state "1" as long as the timer is running and the operand 
"TagIn_1" has the signal state "1". When the timer expires or is reset, the operand "TagOut" 
is reset to "0".

See also
Overview of the valid data types (Page 1320)

S_PEXT: Assign extended pulse timer parameters and start

Description
The "Assign extended pulse timer parameters and start" instruction starts a programmed timer 
when a change from "0" to "1" (positive signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV), even if the signal state 
at input S changes to "0". As long as the timer is running, the output Q has the signal state "1". 
When the timer expires, the output Q is reset to "0". If the signal state at input S changes from 
"0" to "1" while the timer is running, the timer is restarted with the duration programmed at 
input TV.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1" then the current time value 
and the time base are also set to zero. If the timer is not running, the signal state "1" at the R 
input has no effect.

The "Assign extended pulse timer parameters and start" instruction requires a preceding logic 
operation for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameter
The following table shows the parameters of the instruction "Assign extended pulse timer 
parameters and start":

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
1902 System Manual, 02/2014



Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign extended pulse timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" without being 
affected by a negative edge at input S. If the signal state of the operand "TagIn_1" changes 
from "0" to "1" before the timer expires, the timer is restarted.
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The operand "TagOut" has the signal state "1" as long as the timer is running. When the timer 
expires or is reset, the operand "TagOut" is reset to "0".

See also
Overview of the valid data types (Page 1320)

S_ODT: Assign on-delay timer parameters and start

Description
The "Assign on-delay timer parameters and start" instruction starts a programmed timer when 
a change from "0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV) as soon as the signal state 
at input S is "1". If the timer expires correctly and input S still has signal state "1" then output 
Q returns signal state "1". If the signal state at input S changes from "1" to "0" while the timer 
is running, the timer is stopped. In this case, output Q is reset to signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

If the time is running and the signal state at input R changes from "0" to "1" then the current 
time value and the time base are also set to zero. In this case, the signal state at output Q is 
"0". The timer is reset if the signal state is "1" at the R input even if the timer is not running and 
the RLO at input S is "1".

Specify the timer of the instruction in the placeholder above the box. The timer must be declared 
with the data type TIMER.

The "Assign on-delay timer parameters and start" instruction requires a preceding logic 
operation for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Programming the PLC
9.7 References

WinCC Professional V13.0
1904 System Manual, 02/2014



Parameter
The following table shows the parameters of the "Assign on-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign on-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number". If the timer 
expires and the operand has the signal state "1", the operand "TagOut" is set to "1". If the 
signal state of the operand "TagIn_1" changes from "1" to "0" before the timer expires, the 
timer is stopped. The operand "TagOut" has the signal state "0" in this case.
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See also
Overview of the valid data types (Page 1320)

S_ODTS: Assign retentive on-delay timer parameters and start

Description
The "Assign retentive on-delay timer parameters and start" instruction starts a programmed 
timer when a change from "0" to "1" (positive signal edge) is detected in the result of logic 
operation (RLO) at input S. The timer expires with the programmed duration (TV), even if the 
signal state at input S changes to "0". If the timer expires, the "Q" output returns signal state 
"1" regardless of the signal state at input "S". If the signal state at input S changes from "0" to 
"1" while the timer is running, the timer is restarted with the duration programmed at input (TV).

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0" regardless of the 
signal state at start input S. In this case, the signal state at output Q is "0".

The "Assign retentive on-delay timer parameters and start" instruction requires a preceding 
logic operation for edge evaluation and can be placed within or at the end of the network.

The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Assign retentive on-delay timer parameters 
and start" instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
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Parameter Declaration Data type Memory area Description
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign retentive on-delay timer 
parameters and start" instruction:
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number", even if the 
signal state of the operand "TagIn_1" changes to "0". When the timer expires, the operand 
"TagOut" is set to "1". If the signal state of the operand "TagIn_1" changes from "0" to "1" while 
the timer is running, the timer is restarted.

See also
Overview of the valid data types (Page 1320)

S_OFFDT: Assign off-delay timer parameters and start

Description
The "Assign off-delay timer parameters and start" instruction starts a programmed timer when 
a change from "1" to "0" (negative signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV). As long as the timer is running 
or input S returns signal state "1", then output Q has signal state "1". When the timer expires 
and the signal state at input S is "0", output Q is reset to the signal state "0". If the signal state 
at input S changes from "0" to "1" while the timer is running, the timer is stopped. The timer is 
only restarted after a falling signal edge is detected at input S.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
towards zero. The time base indicates the time period with which the time value is changed. 
The current time value is output BI-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0". In this case, the 
signal state at output Q is "0".

The "Assign off-delay timer parameters and start" instruction requires a preceding logic 
operation for edge evaluation and can be placed within or at the end of the network.
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The instruction data is updated at every access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Assign off-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, D, L Start input
TV Input S5TIME, WORD I, Q, M, D, L or 

constant
Preset time value

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(BI-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L Status of the timer

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
1910 System Manual, 02/2014



Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign off-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"1" to "0". The timer expires with the time value of the operand "TagIn_Number". The operand 
"TagOut" is set to "1" when the timer is running and when the operand "TagIn_1" has the signal 
state "0". If the signal state of the operand "TagIn_1" changes from "0" to "1" while the timer 
is running, the timer is reset.

See also
Overview of the valid data types (Page 1320)
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---( SP ): Start pulse timer

Description
The "Start pulse timer" instruction starts a programmed timer when a change from "0" to "1" 
(positive signal edge) is detected in the result of logic operation (RLO). The time runs with the 
specified duration as long as the RLO has the signal state "1". As long as the timer is running, 
the querying of the timer status for "1" returns the signal state "1". If there is a change from "1" 
to "0" in the RLO before the time value has elapsed, the timer stops. In this case, the querying 
of the timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start pulse timer" instruction requires a preceding logic operation for edge evaluation and 
can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Start pulse timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" as long as the 
signal state of the operand "TagIn_1" is "1". If the signal state of the operand "TagIn_1" changes 
from "1" to "0" before the timer expires, the timer is stopped. As long as the timer is running, 
the operand "TagOut" has the signal state "1". A signal state change of the operand "TagIn_1" 
from "0" to "1" resets the timer, which stops the timer and sets the current time value to "0".

See also
Overview of the valid data types (Page 1320)

---( SE ): Start extended pulse timer

Description
The "Start extended pulse timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO). The timer 
expires with the specified duration, even if the RLO changes to the signal state "0". As long 
as the timer is running, the querying of the timer status for "1" returns the signal state "1". If 
the RLO changes from "0" to "1" while the timer is running, the timer is restarted with the 
programmed duration. The querying of the timer status for "1" returns the signal state "0" when 
the timer expires.

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed. 
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The "Start extended pulse timer" instruction requires a preceding logic operation for edge 
evaluation and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Start extended pulse timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number" without being 
affected by a negative edge in the RLO. As long as the timer is running, the operand "TagOut" 
has the signal state "1". If the signal state of the operand "TagIn_1" changes from "0" to "1" 
before the timer expires, the timer is restarted.
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See also
Overview of the valid data types (Page 1320)

---( SD ): Start on-delay timer

Description
The "Start on-delay timer" instruction starts a programmed timer when a change from "0" to 
"1" (positive signal edge) is detected in the result of logic operation (RLO). The timer runs for 
the specified duration as long as the RLO is "1". If the timer expires and the RLO still has the 
signal state "1", the query of the timer status for "1" returns the signal state "1". If the RLO 
changes from "1" to "0" while the timer is running, the timer is stopped. In this case, the querying 
of the timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start on-delay timer" instruction requires a preceding logic operation for edge evaluation 
and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Start on-delay timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number". If the timer 
expires and the RLO has the signal state "1", the operand "TagOut" is set to "1". If the signal 
state of the operand "TagIn_1" changes from "1" to "0" before the timer expires, the timer is 
stopped. If the signal state of the operand "TagIn_2" is "1", the timer "Timer_1" is reset, which 
stops the timer and sets the current time value to "0".

See also
Overview of the valid data types (Page 1320)

---( SS ): Start retentive on-delay timer

Description
The "Start retentive on-delay timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO). The timer 
expires with the specified duration, even if the RLO changes to the signal state "0". When the 
timer expires, the querying of the timer status for "1" returns the signal state "1". After expiry 
of the timer, the timer can only be restarted if it is explicitly reset.

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start retentive on-delay timer" instruction requires a preceding logic operation for edge 
evaluation and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.
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You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Start retentive on-delay timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"0" to "1". The timer expires with the time value of the operand "TagIn_Number". When the 
timer expires, the operand "TagOut" is set to "1". If the signal state of the operand "TagIn_1" 
changes from "0" to "1" while the timer is running, the timer is restarted. If the signal state of 
the operand "TagIn_2" is "1", the timer "Timer_1" is reset, which stops the timer and sets the 
current time value to "0".

See also
Overview of the valid data types (Page 1320)
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---( SF ): Start off-delay timer

Description
The "Start off-delay timer" instruction starts a programmed timer when a change from "1" to 
"0" (negative signal edge) is detected in the result of logic operation (RLO). The timer expires 
with the specified duration. As long as the timer is running, the querying of the timer status for 
"1" returns the signal state "1". If the RLO changes from "0" to "1" while the timer is running, 
the timer is reset. The timer is always restarted when the RLO changes from "1" to "0".

The duration is made up internally of a time value and a time base. When the instruction is 
started, the programmed time value is counted down towards zero. The time base indicates 
the time period with which the time value is changed.

The "Start off-delay timer" instruction requires a preceding logic operation for edge evaluation 
and can only be placed at the right side of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameter
The following table shows the parameters of the "Start off-delay timer" instruction:

Parameter Declaration Data type Memory area Description
<Time duration> Input S5TIME, WORD I, Q, M, D, L or 

constant
Duration with 
which the timer 
expires.

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
1918 System Manual, 02/2014



Example
The following example shows how the instruction works:

The timer "Timer_1" is started when the signal state of the operand "TagIn_1" changes from 
"1" to "0". The timer expires with the time value of the operand "TagIn_Number". As long as 
the timer is running, the operand "TagOut" is set to "1". If the signal state of the operand 
"TagIn_1" changes from "1" to "0" while the timer is running, the timer is restarted. If the signal 
state of the operand "TagIn_2" is "1", the timer "Timer_1" is reset, which stops the timer and 
sets the current time value to "0".

See also
Overview of the valid data types (Page 1320)

Counter operations

IEC Counters

CTU: Count up

Description
You can use the "Count up" instruction to increment the value at output CV. When the signal 
state at the CU input changes from "0" to "1" (positive signal edge), the instruction is executed 
and the current counter value at the CV output is incremented by one. When the instruction 
executes for the first time, the current counter value at the CV output is set to zero. The counter 
is incremented each time a positive signal edge is detected, until it reaches the high limit for 
the specified data type at output CV. When the high limit is reached, the signal state at the CU 
input no longer has an effect on the instruction.

You can scan the counter status at the Q output. The signal state at the Q output is determined 
by the PV parameter. If the current counter value is greater than or equal to the value of the 
PV parameter, the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0".
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The value at the CV output is reset to zero when the signal state at input R changes to "1". As 
long as the R input has the signal state "1", the signal state at the CU input has no effect on 
the instruction.

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Each call of the "Count up" instruction must be assigned to an IEC counter in which the 
instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● CTU_LINT / CTU_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTU_<Data type> or IEC_<Counter> in the "Static" 
section of a block (for example #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multi-instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".
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If you create the IEC counter in a separate data block (single instance), the instance data block 
is created by default with "optimized block access" and the individual tags defined as retentive. 
For additional information on setting retentivity in a instance data block, refer to "See also".

If you create the IEC counter as local tag (multi-instance) in a function block with "optimized 
block access", this is defined as retentive in the block interface.

The execution of the "Count up" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table lists the parameters of the "Count up" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CU Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count input

R Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Reset input

PV Input Integers I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Value at which 
the output Q is 
set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Counter status
CV Output Integers, 

CHAR, DATE
I, Q, M, D, L, 
P

I, Q, M, D, L, P Current counter 
value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count up" 
instruction executes and the current counter value of the "Tag_CV" operand is incremented 
by one. With each additional positive signal edge, the counter value is incremented until the 
high limit of the data type (INT = 32767) is reached.

The value of the PV parameter is adopted as the limit for determining the "TagOut" output. 
The "TagOut" output has signal state "1" as long as the current counter value is greater than 
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or equal to the value of the "Tag_PV" operand. In all other cases, the "TagOut" output has 
signal state "0".

See also
Overview of the valid data types (Page 1320)

Setting the retentivity of local tags (Page 1507)

Setting retentivity in an instance data block (Page 1652)

CTD: Count down

Description
You can use the "Count down" instruction to decrement the value at output CV. When the 
signal state at the CD input changes from "0" to "1" (positive signal edge), the instruction is 
executed and the current counter value at the CV output is decremented by one. When the 
instruction executes the first time, the counter value of the CV parameter is set to the value of 
the PV parameter. Each time a positive signal edge is detected, the counter value is 
decremented until it reaches the low limit of the specified data type. When the low limit is 
reached, the signal state at the CD input no longer has an effect on the instruction.

You can scan the counter status at the Q output. If the current counter value is less than or 
equal to zero, the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0".

The value at the CV output is set to the value of the PV parameter when the signal state at the 
LD input changes to "1". As long as the LD input has the signal state "1", the signal state at 
the CD input has no effect on the instruction.

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Each call of the "Count down" instruction must be assigned an IEC counter in which the 
instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
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For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● CTD_LINT / CTD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTD_<Data type> or IEC_<Counter> in the "Static" 
section of a block (for example #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multi-instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

If you create the IEC counter in a separate data block (single instance), the instance data block 
is created by default with "optimized block access" and the individual tags defined as retentive. 
For additional information on setting retentivity in a instance data block, refer to "See also".

If you create the IEC counter as local tag (multi-instance) in a function block with "optimized 
block access", this is defined as retentive in the block interface.

The execution of the "Count down" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table lists the parameters of the "Count down" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CD Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count input

LD Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Load input

PV Input Integers I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Value at which 
the output Q is 
set.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Counter status
CV Output Integers, 

CHAR, DATE
I, Q, M, D, L, 
P

I, Q, M, D, L, P Current 
counter value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count down" 
instruction executes and the value at the "Tag_CV" output is decremented by one. With each 
additional positive signal edge, the counter value is decremented until the low limit of the 
specified data type (INT = -32768) is reached.

The "TagOut" output has signal state "1" as long as the current counter value is less than or 
equal to zero. In all other cases, the "TagOut" output has signal state "0".

See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

CTUD: Count up and down

Description
You can use the "Count up and down" instruction to increment and decrement the counter 
value at the CV output. If the signal state at the CU input changes from "0" to "1" (positive 
signal edge), the current counter value is incremented by one and stored at the CV output. If 
the signal state at the CD input changes from "0" to "1" (positive signal edge), the counter 
value at the CV output is decremented by one. If there is a positive signal edge at the CU and 
CD inputs in one program cycle, the current counter value at the CV output remains unchanged.
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The counter value can be incremented until it reaches the high limit of the data type specified 
at the CV output. When the high limit is reached, the counter value is no longer incremented 
on a positive signal edge. When the low limit of the specified data type is reached, the counter 
value is not decremented any further.

When the signal state at the LD input changes to "1", the counter value at the CV output is set 
to the value of the PV parameter. As long as the LD input has the signal state "1", the signal 
state at the CU and CD inputs has no effect on the instruction.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", a change in the signal state of the CU, CD and LD inputs 
has no effect on the "Count up and down" instruction.

You can scan the current status of the up counter at the QU output. If the current counter value 
is greater than or equal to the value of the PV parameter, the QU output is set to signal state 
"1". In all other cases, the QU output has signal state "0".

You can scan the current status of the down counter at the QD output. If the current counter 
value is less than or equal to zero, the QD output is set to signal state "1". In all other cases, 
the QD output has signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Each call of the "Count up and down" instruction must be assigned an IEC counter in which 
the instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
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For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● CTUD_LINT / CTUD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTUD_<Data type> or IEC_<Counter> in the "Static" 
section of a block (for example #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multi-instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

If you create the IEC counter in a separate data block (single instance), the instance data block 
is created by default with "optimized block access" and the individual tags defined as retentive. 
For additional information on setting retentivity in a instance data block, refer to "See also".

If you create the IEC counter as local tag (multi-instance) in a function block with "optimized 
block access", this is defined as retentive in the block interface.

The execution of the "Count up and down" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table lists the parameters of the "Count up and down" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CU Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count up input

CD Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count down 
input

R Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Reset input

LD Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Load input
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

PV Input Integers I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Value at which 
the output QU 
is set.

QU Output BOOL I, Q, M, D, L I, Q, M, D, L Status of the up 
counter

QD Output BOOL I, Q, M, D, L I, Q, M, D, L Status of the 
down counter

CV Output Integers, 
CHAR, DATE

I, Q, M, D, L, 
P

I, Q, M, D, L, P Current 
counter value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the signal state at the "TagIn_1" or "TagIn_2" input changes from "0" to "1" (positive signal 
edge), the "Count up and down" instruction is executed. When there is a positive signal edge 
at the "TagIn_1" input, the current counter value is incremented by one and stored at the 
"Tag_CV" output. When there is a positive signal edge at the "TagIn_2" input, the counter value 
is decremented by one and stored at the "Tag_CV" output. When there is a positive signal 
edge at the CU input, the counter value is incremented until it reaches the high limit of 32767. 
If input CD has a positive signal edge, the counter value is decremented until it reaches the 
low limit of INT = -32768.

The "TagOut" output has signal state "1" as long as the current counter value is greater than 
or equal to the value at the "Tag_PV" input. In all other cases, the "TagOut" output has signal 
state "0".

The "TagOut_QD" output has signal state "1" as long as the current counter value is less than 
or equal to zero. In all other cases, the "TagOut_QD" output has signal state "0".
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See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

SIMATIC Counters

S_CUD: Assign parameters and count up / down

Description
You can use the "Assign parameters and count up / down" instruction to increment or 
decrement the value of a counter. If the signal state at the CU input changes from "0" to "1" 
(positive signal edge), the current counter value is incremented by one. If the signal state at 
the CD input changes from "0" to "1" (positive signal edge), the counter value is decremented 
by one. The current counter value is output as a hexadecimal value at output CV and BCD-
coded at output CV_BCD. If there is a positive signal edge at the CU and CD inputs in one 
program cycle, the counter value remains unchanged.

The counter value can be incremented until the high limit of "999" is reached. When the high 
limit value is reached, the counter value is no longer incremented on a positive signal edge. 
When the low limit "0" is reached, the counter value is not decremented any further.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO is "1" at the inputs CU and CD, the counter 
counts accordingly in the next scan cycle, even if no change in the signal edge was detected.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU, CD and S 
inputs has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

The "Assign parameters and count up / down" instruction requires a preceding logic operation 
for edge evaluation and can be placed within or at the end of the network.
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Parameters
The following table shows the parameters of the "Assign parameters and count up / down" 
instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L Count up input
CD Input BOOL I, Q, M, D, L, T, C 

or constant
Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

BI Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the signal state at the "TagIn_1"" or "TagIn_2" input changes from "0" to "1" (positive signal 
edge), the "Assign parameters and count up / down" instruction is executed. When there is a 
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positive signal edge at the "TagIn_1" input and the current counter value is less than "999", 
the counter value is incremented by one. When there is a positive signal edge at the "TagIn_2" 
input and the current counter value is greater than "0", the counter value is decremented by 
one. 

When the signal state at input "TagIn_3" changes from "0" to "1", the counter value is set to 
the value of the operand "TagPresetValue". The counter value is reset to "0" when the 
"TagIn_4" operand has signal state "1".

The current counter value is saved as a hexadecimal value in the operand "TagValue_1" and 
BCD-coded in the operand "TagValue_2".

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1320)

S_CU: Assign parameters and count up

Description
You can use the "Assign parameters and count up" instruction to increment the value of a 
counter. If the signal state at the CU input changes from "0" to "1" (positive signal edge), the 
current counter value is incremented by one. The current counter value is output as a 
hexadecimal value at output CV and BCD-coded at output CV_BCD. The counter value can 
be incremented until the limit of "999" is reached. When the limit is reached, the counter value 
is no longer incremented on a positive signal edge.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CU is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU and S inputs 
has no effect on the counter value. 

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

The "Assign parameters and count up" instruction requires a preceding logic operation for edge 
evaluation and can be placed within or at the end of the network.
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Parameter
The following table shows the parameters of the "Assign parameters and count up" instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L Count up input
S Input BOOL I, Q, M, D, L, T, C 

or constant
Input for 
presetting counter

PV Input WORD I, Q, M, D, L or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is less than "999", the counter value is incremented by one. When 
the signal state at input "TagIn_2" changes from "0" to "1", the counter value is set to the value 
of the operand "TagPresetValue". The counter value is reset to "0" when the "TagIn_3" operand 
has signal state "1".
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The current counter value is saved as a hexadecimal value in the operand "TagValue_1" and 
BCD-coded in the operand "TagValue_2".

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1320)

S_CD: Assign parameters and count down

Description
You can use the "Assign parameters and count down" instruction to decrement the value of a 
counter. If the signal state at the CD input changes from "0" to "1" (positive signal edge), the 
counter value is decremented by one. The current counter value is output as a hexadecimal 
value at output CV and BCD-coded at output CV_BCD. The counter value is decremented until 
the low limit of "0" is reached. When the low limit is reached, the counter value is no longer 
decremented on a positive signal edge. 

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CD is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CD and S inputs 
has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

The "Assign parameters and count down" instruction requires a preceding logic operation for 
edge evaluation and can be placed within or at the end of the network.
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Parameter
The following table shows the parameters of the "Assign parameters and count down" 
instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CD Input BOOL I, Q, M, D, L or 
constant

Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is greater than "0", the counter value is decremented by one. When 
the signal state at input "TagIn_2" changes from "0" to "1", the counter value is set to the value 
of the operand "TagPresetValue". The counter value is reset to "0" when the "TagIn_3" operand 
has signal state "1".
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The current counter value is saved as a hexadecimal value in the operand "TagValue_1" and 
BCD-coded in the operand "TagValue_2".

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1320)

---( SC ): Set counter value

Description
You can use the "Set counter value" instruction to set the value of a counter. The instruction 
is executed when the result of logic operation (RLO) at the input changes from "0" to "1". When 
the instruction is executed, the counter is set to the specified counter value.

The "Set counter value" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

Parameter
The following table lists the parameters of the "Set counter value" instruction:

Parameter Declaration Data type Memory area Description
<Count value> Input WORD I, Q, M, D, L or 

constant
Value with which 
the counter is 
preset in the BCD 
format.
(C#0 to C#999)

<Counter> InOut/Input COUNTER C Counter that is 
preset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

the counter "Counter_1" starts with the value "100" when the signal state of the "TagIn" operand 
changes from "0" to "1".
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See also
Overview of the valid data types (Page 1320)

---( CU ): Count up

Description
With the "Count up" instruction you can increment the value of the specified counter by one if 
there is a positive signal edge in the result of logic operation (RLO). The counter value can be 
incremented until the limit of "999" is reached. When the limit is reached, the counter value is 
no longer incremented on a positive signal edge. 

The "Count up" instruction requires a preceding logic operation for edge evaluation and can 
only be placed at the right side of the network.

Parameter
The following table shows the parameters of the "Count up" instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter whose 

value is 
incremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

The value of the counter "Counter_1" is incremented by one when the signal state of the 
operand "TagIn_2" changes from "0" to "1".

When the operand "TagIn_3" has the signal state "1", the value of the counter "Counter_1" is 
reset to "0".
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See also
Overview of the valid data types (Page 1320)

---( CD ): Count down

Description
With the "Count down" instruction you can increment the value of the specified counter by one 
if there is a positive signal edge in the result of logic operation (RLO). The counter value can 
be decremented until the limit of "0" is reached. When the limit is reached, the counter value 
is no longer changed on a positive signal edge. 

The "Count down" instruction requires a preceding logic operation for edge evaluation and can 
only be placed at the right side of the network.

Parameter
The following table shows the parameters of the "Count down" instruction:

Parameter Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter whose 

value is 
decremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

The value of the counter "Counter_1" is decremented by one when the signal state of the 
operand "TagIn_2" changes from "0" to "1". 

When the operand "TagIn_3" has the signal state "1", the value of the counter "Counter_1" is 
reset to "0".
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See also
Overview of the valid data types (Page 1320)

 

CMP ==: Equal

Description
You can use the "Equal" instruction to determine if a first comparison value (<Operand1>) is 
equal to a second comparison value (<Operand2>).

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'AA' 'AA' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0

You can also use the "Equal" instruction to compare individual characters of a string. The 
number of the character to be compared is specified in square brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

If IEC check is enabled, the operands to be compared must be of the same data type. If IEC 
check is not enabled, the width (length) of the operands must be the same. When floating-point 
numbers are compared, the operands to be compared must have the same data type 
regardless of the setting for the IEC Check.

 

 Note
Comparison of floating-point numbers

If you want to compare the data types REAL or LREAL, instead of the instruction "CMP ==: 
Equal", use the instruction "IN_RANGE: Value within range".
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 Note
Comparison of the data type PORT

To be able to compare the operands of the PORT data type with the "Equal" instruction, you 
need to select the WORD data type from the drop-down list of the instructions box.

 

Parameters
The following table lists the parameters of the "Equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" = "Tag_Value2".
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See also
Overview of the valid data types (Page 1320)

CMP <>: Not equal

Description
You can use the "Not equal" instruction to determine if a first comparison value (<Operand1>) 
is not equal to a second comparison value (<Operand2>).

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'AA' 'aa' 1
'Hello World' 'HelloWorld' 1
'AA' 'AA' 0

You can also use the "Not equal" instruction to compare individual characters of a string. The 
number of the character to be compared is specified in square brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

If IEC check is enabled, the operands to be compared must be of the same data type. If IEC 
check is not enabled, the width (length) of the operands must be the same. If the floating-point 
numbers are being compared, the operands to be compared must be of the same data type 
regardless of the IEC check setting.

 

 Note
Comparison of the data type PORT

To be able to compare the operands of the PORT data type with the "Not equal" instruction, 
you need to select the WORD data type from the drop-down list of the instructions box.
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Parameters
The following table lists the parameters of the "Not equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" <> "Tag_Value2".

See also
Overview of the valid data types (Page 1320)
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CMP >=: Greater or equal

Description
You can use the "Greater or equal" instruction to determine if a first comparison value 
(<Operand1>) is greater than or equal to a second comparison value (<Operand2>). Both 
values to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the longer string is considered greater.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'Hello World' 'Hello World' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0
'AAA' 'a' 0

You can also use the "Greater or equal" instruction to compare individual characters of a string. 
The number of the character to be compared is specified in square brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is greater (more recent) than or equal to the point of time at <Operand2>.
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Parameters
The following table lists the parameters of the "Greater or equal" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" >= "Tag_Value2".

See also
Overview of the valid data types (Page 1320)

Example of detecting the fill level of a storage area  (Page 1835)
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CMP <=: Less or equal

Description
You can use the "Less or equal" instruction to determine if a first comparison value 
(<Operand1>) is less than or equal to a second comparison value (<Operand2>). Both values 
to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the shorter string is considered smaller.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'AA' 'aa' 1
'AAA' 'a' 1
'Hello World' 'Hello World' 1
'HelloWorld' 'Hello World' 0
'BB' 'AA' 0
'AAA' 'AA' 0

You can also use the "Less or equal" instruction to compare individual characters of a string. 
The number of the character to be compared is specified in square brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is less (less recent) than or equal to the point of time at <Operand2>.
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Parameters
The following table lists the parameters of the "Less or equal" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" <= "Tag_Value2".

See also
Overview of the valid data types (Page 1320)
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CMP >: Greater than

Description
You can use the "Greater than" instruction to determine if a first comparison value 
(<Operand1>) is greater than a second comparison value (<Operand2>). Both values to be 
compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the longer string is considered greater.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'AA' 'aa' 0
'AAA' 'a' 0

You can also use the "Greater than" instruction to compare individual characters of a string. 
The number of the character to be compared is specified in square brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is greater (more recent) than the point of time at <Operand2>.
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Parameters
The following table lists the parameters of the "Greater than" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" > "Tag_Value2".

See also
Overview of the valid data types (Page 1320)
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CMP <: Less than

Description
You can use the "Less than" instruction to determine if a first comparison value (<Operand1>) 
is less than a second comparison value (<Operand2>). Both values to be compared must be 
of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify the first comparison value (<Operand1>) at the operand placeholder above the 
instruction. Specify the second comparison value (<Operand2>) at the operand placeholder 
below the instruction.

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the shorter string is considered smaller.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'AA' 'aa' 1
'AAA' 'a' 1
'BB' 'AA' 0
'AAA' 'AA' 0

You can also use the "Less than" instruction to compare individual characters of a string. The 
number of the character to be compared is specified in square brackets next to the operand 
name. "MyString[2]", for example, compares the second character of the "MyString" string.

When time values are compared, the RLO of the instruction is "1" if the point of time at 
<Operand1> is less (less recent) than the point of time at <Operand2>.
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Parameters
The following table lists the parameters of the "Less than" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

<Operand2> Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" < "Tag_Value2".

See also
Overview of the valid data types (Page 1320)

Example of detecting the fill level of a storage area  (Page 1835)
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IN_RANGE: Value within range

Description     
You can use the "Value within range" instruction to determine if the value at the VAL input is 
within a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value within range" 
instruction compares the value at the VAL input with the values of the MIN and MAX inputs 
and sends the result to the box output. If the value at the VAL input fulfills the comparison MIN 
<= VAL or VAL <= MAX, the box output has the signal state "1". If the comparison is not fulfilled, 
the box output has the signal state "0".

If the box input has the signal state "0", the "Value within range" instruction is not executed.

The comparison function can only execute if the values to be compared are of the same data 
type and the box input is interconnected.

Parameters
The following table shows the parameters of the "Value within range" instruction:

Parameter Declaration Data type Memory area Description
Box input Input BOOL I, Q, M, D, L Result of the 

previous logic 
operation

MIN Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:
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The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The value of the operand "Tag_Value" is within the value range that is specified by the 
current values of the operands "Tag_Min" and "Tag_Max" (MIN <= VAL or VAL <= MAX).

● The operand "TagIn_3" has the signal state "1".

See also
Overview of the valid data types (Page 1320)

OUT_RANGE: Value outside range

Description     
You can use the "Value outside range" instruction to determine if the value at the VAL input is 
outside a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value outside 
range" instruction compares the value at the VAL input with the values of the MIN and MAX 
inputs and sends the result to the box output. If the value at the VAL input fulfills the comparison 
MIN > VAL or VAL > MAX, the box output has the signal state "1". The box output also has 
the signal state "1" if a specified operand with the REAL data type shows an invalid value. 

The box output returns the signal state "0", if the value at input VAL does not satisfy the MIN 
> VAL or VAL > MAX  condition.

If the box input has the signal state "0", the "Value outside range" instruction is not executed.

The comparison function can only execute if the values to be compared are of the same data 
type and the box input is interconnected.

Parameters 
The following table shows the parameters of the "Value outside range" instruction:

Parameter Declaration Data type Memory area Description
Box input Input BOOL I, Q, M, D, L Result of the 

previous logic 
operation

MIN Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison
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You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The value of the operand "Tag_Value" is outside the value range that is specified by the 
values of the operands "Tag_Min" and "Tag_Max" (MIN > VAL or VAL > MAX).

● The operand "TagIn_3" has the signal state "1".

See also
Overview of the valid data types (Page 1320)

----I OK I----: Check validity

Description     
You can use the "Check validity" instruction to check if the value of an operand (<operand>) 
is a valid floating-point number. The query is started in each program cycle when the signal 
state at the input of the instruction is "1".

The output of the instruction has signal state "1" when the value of the operand is a valid 
floating-point number at the time of the query and the input of the instruction has signal state 
"1". In all other cases, the signal state at the output of the "Check validity" instruction is "0".

You can use the "Check validity" instruction together with the EN mechanism. If you connect 
the instruction box to an EN enable input, the enable input is set only when the result of the 
validity query of the value is positive. You can use this function to ensure that an instruction is 
enabled only when the value of the specified operand is a valid floating-point number.
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Parameters
The following table shows the parameters of the "Check validity" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

queried.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the values of the operands "Tag_Value1" and "Tag_Value2" show valid floating-point 
numbers, the "Multiply" (MUL) instruction is activated and the ENO output is set. During the 
execution of the "Multiply" (MUL) instruction, the value of the operand "Tag_Value1" is 
multiplied with the value of the operand "Tag_Value2". The product of the multiplication is then 
stored in the operand "Tag_Result". If the instruction is executed without errors, the ENO and 
"TagOut" outputs are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

----I NOT_OK I----: Check invalidity

Description     
You can use the "Check invalidity" instruction to check if the value of an operand (<operand>) 
is an invalid floating-point number. The query is started in each program cycle when the signal 
state at the input of the instruction is "1".

The output of the instruction has signal state "1" when the value of the operand is an invalid 
floating-point number at the time of the query and the input of the instruction has signal state 
"1". In all other cases, the signal state at the output of the "Check invalidity" instruction is "0".
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Parameters
The following table shows the parameters of the "Check invalidity" instruction:

Parameter Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

queried.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the value of operand "TagIn_Value" is an invalid floating-point number, the "Move value" 
(MOVE) instruction will not be executed. The "TagOut" output is reset to signal state "0".

See also
Overview of the valid data types (Page 1320)

VARIANT instructions

EQ_Type: Compare data type  for EQUAL with the data type of a tag

Description
You can use the "Compare data type for EQUAL with the data type of a tag" instruction to 
query the data type of a tag to which a VARIANT points. You compare the data type of the tag 
(<Operand1>) to the data type of a tag (<Operand2>) that you have declared in the block 
interface to determine if they are "Equal".

<Operand1> must have the VARIANT data type. <Operand2> can be an elementary data type 
or a PLC data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify <Operand1> at the operand placeholder above the instruction. Specify <Operand2> 
at the operand placeholder below the instruction.
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Parameters
The following table lists the parameters of the "Compare data type for EQUAL with the data 
type of a tag" instruction:

Parameters Declaration Data type Memory area Description
<Operand1> Input VARIANT L First operand
<Operand2> Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

NE_Type: Compare data type for UNEQUAL with the data type of a tag

Description
You can use the "Compare data type for EQUAL with the data type of a tag" instruction to 
query the data type of a tag to which a VARIANT points. You compare the data type of the tag 
(<Operand1>) to the data type of a tag (<Operand2>) that you have declared in the block 
interface to determine if they are "Not equal".

<Operand1> must have the VARIANT data type. <Operand2> can be an elementary data type 
or a PLC data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:
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● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify <Operand1> at the operand placeholder above the instruction. Specify <Operand2> 
at the operand placeholder below the instruction.

Parameters
The following table lists the parameters of the "Compare data type for UNEQUAL with the data 
type of a tag" instruction:

Parameters Declaration Data type Memory area Description
<Operand1> Input VARIANT L First operand
<Operand2> Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is not equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

EQ_ElemType: Compare element data type for EQUAL with the data type of a tag

Description
You can use the "Compare element data type for EQUAL with the data type of a tag" instruction 
to query the data type of a tag to which a VARIANT points. You compare the data type of the 
tag (<Operand1>) to the data type of a tag (<Operand2>) that you have declared in the block 
interface to determine if they are "Equal".
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<Operand1> must have the VARIANT data type. <Operand2> can be an elementary data type 
or a PLC data type.

If the data type of the VARIANT tag (<Operand1>) is an ARRAY, the data type of the ARRAY 
elements is compared.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify <Operand1> at the operand placeholder above the instruction. Specify <Operand2> 
at the operand placeholder below the instruction.

Parameters
The following table lists the parameters of the "Compare element data type for EQUAL with 
the data type of a tag" instruction:

Parameters Declaration Data type Memory area Description
<Operand1> Input VARIANT L First operand
<Operand2> Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)
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NE_ElemType: Compare element data type for UNEQUAL with the data type of a tag

Description
You can use the "Compare element data type for UNEQUAL with the data type of a tag" 
instruction to query the data type of a tag to which a VARIANT points. You compare the data 
type of the tag (<Operand1>) to the data type of a tag (<Operand2>) that you have declared 
in the block interface to determine if they are "Not equal".

<Operand1> must have the VARIANT data type. <Operand2> can be an elementary data type 
or a PLC data type.

If the data type of the VARIANT tag (<Operand1>) is an ARRAY, the data type of the ARRAY 
elements is compared.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0". The RLO 
of the instruction is logically combined with the RLO of the entire rung as follows:

● By AND, when the comparison instruction is connected in series.

● By OR, when the comparison instruction is connected in parallel.

Specify <Operand1> at the operand placeholder above the instruction. Specify <Operand2> 
at the operand placeholder below the instruction.

Parameters
The following table lists the parameters of the "Compare element data type for UNEQUAL with 
the data type of a tag" instruction:

Parameters Declaration Data type Memory area Description
<Operand1> Input VARIANT L First operand
<Operand2> Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:
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● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is not equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

IS_NULL: Compare for EQUALS ZERO

Description
You can use the instruction "Compare for EQUALS ZERO" to query whether the VARIANT 
does not point to an object.

The <Operand> must have the VARIANT data type.
 

 Note
VARIANT tag points to an ANY pointer

If the VARIANT tag points to an ANY pointer, the instruction always returns the result RLO 
= "0" even if the ANY pointer is ZERO.

 

Parameters
The following table lists the parameters of the "Compare for EQUALS ZERO" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input VARIANT L Operand that is 

compared for EQUAL 
ZERO

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:
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● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand" operand 
does not point to an object.

See also
Overview of the valid data types (Page 1320)

NOT_NULL: Compare for UNEQUALS ZERO

Description
You can use the instruction "Compare for UNEQUALS ZERO" to query whether the VARIANT 
points to an object.

The <Operand> must have the VARIANT data type.
 

 Note
VARIANT tag points to an ANY pointer

If the VARIANT tag points to an ANY pointer, the instruction always returns the result RLO 
= "1" even if the ANY pointer is ZERO.

 

Parameters
The following table lists the parameters of the "Compare for UNEQUALS ZERO" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input VARIANT L Operand that is 

compared for NOT 
EQUAL ZERO

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:
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● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand" operand 
points to an object.

See also
Overview of the valid data types (Page 1320)

IS_ARRAY: Check for ARRAY

Description
You can use the instruction "Check for ARRAY" to query whether the VARIANT points to a tag 
of the ARRAY data type.

The <Operand> must have the VARIANT data type.

Parameters
The following table lists the parameters of the "Check for ARRAY" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input VARIANT L Operand that is query 

for ARRAY

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_VARIANTToArray" 
operand has the ARRAY data type.

See also
Overview of the valid data types (Page 1320)
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CALCULATE: Calculate

Description
The "Calculate" instruction is used to define and execute an expression for the calculation of 
mathematical operations or complex logic operations depending on the selected data type.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. Depending on the data type selected, you can combine the functions of certain instructions 
to perform a complex calculation. The expression to be calculated is specified via a dialog you 
can open via the "Calculator" icon at the top of the instruction box. The expression can contain 
names of input parameters and the syntax of the instructions. Operand names and operand 
addresses cannot be specified.

In its initial state, the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box.

The values of the inputs are used to execute the specified expression. Not all of the defined 
inputs have to be used in the expression. The result of the instruction is transferred to the 
output OUT.

 

 Note

If one of the mathematical operations fails in the expression, no result is transferred to the 
output OUT and the enable output ENO returns the signal state "1".

 

If you use inputs in the expression that are not available in the box, they are inserted 
automatically. This requires that there are no gaps in the numbering of the inputs to be newly 
defined in the expression. For example, you cannot use the IN4 input in the expression unless 
the IN3 input has been defined.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the "Calculate" instruction is outside the range permitted for the data type 
specified at the OUT output.

● A floating-point number has an invalid value.

● An error occurred during execution of one of the instructions in the expression.

The following table shows the instructions that can be executed together in the expression of 
the instruction "Calculate", depending on the selected data type:

Data type Instruction Syntax Example
Bit strings AND: AND logic operation AND IN1 AND IN2 OR IN3

OR: OR logic operation OR
XOR: EXCLUSIVE OR logic operation XOR
INV: Create ones complement NOT
SWAP: Swap 1) SWAP
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Data type Instruction Syntax Example
Integers ADD: Add + (IN1 + IN2) * IN3;

(ABS(IN2)) * 
(ABS(IN1))

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
MOD: Return remainder of division MOD
INV: Create ones complement NOT
NEG: Create twos complement -(in1)
ABS: Form absolute value ABS( )

Floating-point numbers ADD: Add + ((SIN(IN2) * SIN(IN2) 
+ (SIN(IN3) * 
SIN(IN3)) / IN3));
(SQR(SIN(IN2)) + 
(SQR(COS(IN3)) / 
IN2))

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
EXPT: Exponentiate **
ABS: Form absolute value ABS( )
SQR: Form square SQR( )
SQRT: Form square root SQRT( )
LN: Form natural logarithm LN( )
EXP: Form exponential value EXP( )
FRAC: Return fraction FRAC( )
SIN: Form sine value SIN( )
COS: Form cosine value COS( )
TAN: Form tangent value TAN( )
ASIN: Form arcsine value ASIN( )
ACOS: Form arcosine value ACOS( )
ATAN: Form arctangent value ATAN( )
NEG: Create twos complement -(in1)
TRUNC: Truncate numerical value TRUNC( )
ROUND: Round numerical value ROUND( )
CEIL: Generate next higher integer from floating-
point number

CEIL( )

FLOOR: Generate next lower integer from floating-
point number

FLOOR( )

1) Not possible for data type BYTE.

Parameters
The following table shows the parameters of the "Calculate" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameters Declaration Data type Memory area Description
IN1 Input Bit strings, 

integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

First available 
input

IN2 Input Bit strings, 
integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Second available 
input

INn Input Bit strings, 
integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Additionally 
inserted inputs

OUT Output Bit strings, 
integers, floating-
point numbers

I, Q, M, D, L, P Output to which 
the end result is to 
be transferred.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value_1 4
IN2 Tag_Value_2 4
IN3 Tag_Value_3 3
IN4 Tag_Value_4 2
OUT Tag_Result 12

If the "Tag_Input" input has the signal state"1", the "Calculate" instruction is executed. The 
value of operand "Tag_Value_1" is added to the value of operand "Tag_Value_2". The sum is 
multiplied with the value of operand "Tag_Value_3". The product is divided by the value of 
operand "Tag_Value_4". The quotient is transferred as end result to the operand "Tag_Result" 
at the OUT output of the instruction. If the instruction is executed without errors, the enable 
output ENO and operand "Tag_Output" are set to "1".
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See also
Using the "Calculate" instruction (Page 1536)

Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

ADD: Add

Description
You can use the "Add" instruction to add the value at input IN1 and the value at input IN2 and 
query the sum at output OUT (OUT := IN1+IN2).

In its initial state, the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. When 
the instruction is executed, the values of all available input parameters are added. The sum is 
stored at the OUT output.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Add" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

First number to be 
added

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Second number to 
be added

INn Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Optional input 
values that are 
added.

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Sum

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":
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Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Add" instruction is executed. The value of 
operand "Tag_Value1" is added to the value of operand "Tag_Value2". The result of the 
addition is stored in operand "Tag_Result". If the instruction is executed without errors, the 
ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1529)

Inserting additional inputs and outputs in LAD elements (Page 1544)

SUB: Subtract

Description     
You can use the "Subtract" instruction to subtract the value at input IN2 from the value at input 
IN1 and query the difference at output OUT (OUT := IN1-IN2).

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Subtract" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Minuend
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Parameter Declaration Data type Memory area Description
IN2 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Subtracting

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Difference

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Subtract" instruction is executed. The value of 
operand "Tag_Value2" is subtracted from the value of operand "Tag_Value1". The result of 
the subtraction is stored in operand "Tag_Result". If the instruction is executed without errors, 
the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1529)

MUL: Multiply

Description     
You can use the "Multiply" instruction to multiply the value at input IN1 with the value at input 
IN2 and query the product at output OUT (OUT := IN1*IN2).

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are multiplied. The product is stored at the OUT output.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN input has the signal state "0".

● The result is outside the range permitted for the data type specified at output OUT.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Multiply" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Multiplier

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Number being 
multiplied

INn Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Optional input 
values that can be 
multiplied.

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Product

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Multiply" instruction is executed. The value of 
operand "Tag_Value1" is multiplied by the value of operand "Tag_Value2". The result of the 
multiplication is stored in operand "Tag_Result". If the instruction is executed without errors, 
the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1529)

Inserting additional inputs and outputs in LAD elements (Page 1544)
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DIV: Divide

Description     
You can use the "Divide" instruction to divide the value at input IN1 by the value at input IN2 
and query the quotient at output OUT (OUT := IN1/IN2).

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Divide" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers, floating-

point numbers
I, Q, M, D, L, P or 
constant

Dividend

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Divisor

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Quotient value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Divide" instruction is executed. The value of 
operand "Tag_Value1" is divided by the value of operand "Tag_Value2". The division result is 
stored in operand "Tag_Result". If the instruction is executed without errors, the ENO enable 
output has the signal state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1529)

MOD: Return remainder of division

Description     
You can use the "Return remainder of division" instruction to divide the value at input IN1 by 
the value at input IN2 and query the remainder of division at output OUT.

Parameters
The following table shows the parameters of the "Return remainder of division" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Integers I, Q, M, D, L, P or 

constant
Dividend

IN2 Input Integers I, Q, M, D, L, P or 
constant

Divisor

OUT Output Integers I, Q, M, D, L, P Remainder of 
division

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Return remainder of division" instruction is 
executed. The value of operand "Tag_Value1" is divided by the value of operand "Tag_Value2". 
The remainder is stored in operand "Tag_Result". If the instruction is executed without errors, 
the ENO enable output has the signal state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1529)

NEG: Create twos complement

Description       
You can use the "Create twos complement" instruction to change the sign of the value at the 
IN input and query the result at the OUT output. If there is a positive value at input IN, for 
example, the negative equivalent of this value is sent to output OUT.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at the 
OUT output.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Create twos complement" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input SINT, INT, 

DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

Input value

OUT Output SINT, INT, 
DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P Twos 
complement of 
the input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Create twos complement" instruction is 
executed. The sign of the value at input "TagIn_Value" is changed and the result is provided 
at "TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

INC: Increment

Description     
You can use the "Increment" instruction to change the value of the operand at the IN/OUT 
parameter to the next higher value and query the result. The "Increment" instruction is only 
started when the signal state at the EN enable input is "1". If no overflow error occurs during 
the execution, the ENO enable output also has the signal state "1".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Increment" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L Value to be 

incremented.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the value of operand 
"Tag_InOut" is incremented by one and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DEC: Decrement

Description     
You can use the "Decrement" instruction to change the value of the operand at the IN/OUT 
parameter to the next lower value and query the result. The "Decrement" instruction is only 
started when the signal state at the EN enable input is "1". If the range of values of the selected 
data type is not exceeded during processing, the ENO output also has the signal state "1".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● A floating-point number has an invalid value.

Parameter
The following table shows the parameters of the "Decrement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L Value to be 

decremented.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the value of operand 
"Tag_InOut" is decremented by one and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ABS: Form absolute value

Description         
You can use the "Form absolute value" instruction to calculate the absolute value of the value 
specified at input IN. The result of the instruction is sent to the OUT output and can be queried 
there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Form absolute value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input SINT, INT, 

DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

Input value

OUT Output SINT, INT, 
DINT, floating-
point numbers

SINT, INT, 
DINT, LINT, 
floating-point 
numbers

I, Q, M, D, L, P Absolute value 
of the input 
value
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You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value -6.234
OUT TagOut_Value 6.234

If operand "TagIn" has the signal state "1", the "Form absolute value" instruction is executed. 
The instruction calculates the absolute value of the value at input "TagIn_Value" and sends 
the result to output "TagOut_Value". If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MIN: Get minimum

Description
The "Get minimum" instruction compares the values at the available inputs and writes the 
lowest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

A minimum of two and a maximum of 100 inputs must be specified for the execution of the 
instruction.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Get minimum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

First input value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Second input 
value

INn Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Additionally 
inserted inputs 
whose values 
are to be 
compared

OUT Output Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Result

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 12222

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get minimum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
lowest value ("TagIn_Value1") to output "TagOut_Value". If the instruction is executed without 
errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Basics of the EN/ENO mechanism (Page 1415)

MAX: Get maximum

Description
The "Get maximum" instruction compares the values at the available inputs and writes the 
highest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

A minimum of two and a maximum of 100 inputs must be specified for the execution of the 
instruction.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Get maximum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

First input value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Second input 
value

INn Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Additionally 
inserted inputs 
whose values 
are to be 
compared

OUT Output Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Result

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
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Parameter Operand Value
IN3 TagIn_Value3 13333
OUT TagOut_Value 14444

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get maximum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
highest value ("TagIn_Value2") to output "TagOut_Value". If the instruction is executed without 
errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

LIMIT: Set limit value

Description
You can use the "Set limit value" instruction to limit the value at input IN to the values at the 
inputs MN and MX. If the value at the IN input meets the condition MN <= IN <= MX, it is copied 
to the OUT output. If the condition is not fulfilled and the input value IN is below the low limit 
MN, the output OUT is set to the value of the MN input. If the MX high limit is exceeded, the 
OUT output is set to the value of the MX input.

If the value at the MN input is greater than at the MX input, the result is undefined and the 
enable output ENO is "0".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The specified tags are not of the same data type.

● An operand has an invalid value.

● The value at the MN input is greater than the value of the MX input.

Parameters
The following table shows the parameters of the "Set limit value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output

Programming the PLC
9.7 References

WinCC Professional V13.0
1978 System Manual, 02/2014



Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

MN Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Low limit

IN Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Input value

MX Input Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

High limit

OUT Output Integers, 
floating-
point 
numbers, 
TIME, TOD, 
DATE

Integers, 
floating-point 
numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Result

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MN Tag_MN 12000
IN Tag_Value 8000
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Parameter Operand Value
MX Tag_MX 16000
OUT Tag_Result 12000

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Set limit value" instruction 
is executed. The value of operand "Tag_Value" is compared with the values of operands 
"Tag_MN" and "Tag_MX". Since the value of operand "Tag_Value" is less than the low limit, 
the value of operand "Tag_MN" is copied to the "Tag_Result" output. If the instruction is 
executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SQR: Form square

Description     
You can use the "Form square" instruction to square the value at the IN input and query the 
result at the OUT output.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form square" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Square of the 
input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 5.0
OUT Tag_Result 25.0

If operand "TagIn" has the signal state "1", the "Form square" instruction is executed. The 
instruction squares the value of operand "Tag_Value" and sends the result to the "Tag_Result" 
output. If the instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SQRT: Form square root

Description     
You can use the "Form square root" instruction to  find the square root of the value at the IN 
input and query the result at the OUT output. The instruction outputs a positive result if the 
input value is greater than zero. If input values are less than zero, the OUT output returns an 
invalid floating-point number. If the value at input IN is "0", then the result is also "0".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is negative.

Parameters
The following table shows the parameters of the "Form square root" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Square root of the 
input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 25.0
OUT Tag_Result 5.0

If operand "TagIn" has the signal state "1", the "Form square root" instruction is executed. The 
instruction finds the square root of the value of operand "Tag_Value" and stores the result in 
the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" output is 
set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

LN: Form natural logarithm

Description     
You can use the "Form natural logarithm" instruction to calculate the natural logarithm to base 
e (e = 2.718282) of the value at input IN. The result is sent to the OUT output and can be 
queried there. The instruction outputs a positive result if the input value is greater than zero. 
If input values are less than zero, the OUT output returns an invalid floating-point number.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:
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● The enable input EN has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is negative.

Parameters
The following table shows the parameters of the "Form natural logarithm" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Natural logarithm 
of the input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Form natural logarithm" instruction is executed. 
The instruction forms the natural logarithm of the value at the "Tag_Value" input and stores 
the result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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EXP: Form exponential value

Description     
You can use the "Form exponential value" instruction to calculate the exponent from the base 
e (e = 2.718282) and the value specified at input IN. The result is provided at output OUT and 
can be queried there  (OUT = eIN).

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form exponential value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Exponential value 
of input value IN

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Form exponential value" instruction is executed. 
The instruction calculates the exponent from base e and the value of operand "Tag_Value" 
and sends the result to the "Tag_Result" output. If the instruction is executed without errors, 
the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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SIN: Form sine value

Description     
Use the "Form sine value" instruction to calculate the sine of the angle. The size of the angle 
is specified in radians at the IN input. The result of the instruction is sent to the OUT output 
and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form sine value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Size of angle in 
radians

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Sine of the 
specified angle

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 1.0

If operand "TagIn" has the signal state "1", the "Form sine value" instruction is executed. The 
instruction calculates the sine of the angle specified at the "Tag_Value" input and stores the 
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result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

COS: Form cosine value

Description     
Use the "Form cosine value" instruction to calculate the cosine of the angle. The size of the 
angle is specified in radians at the IN input. The result of the instruction is sent to the OUT 
output and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form cosine value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Size of angle in 
radians

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Cosine of the 
specified angle

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 0

If operand "TagIn" has the signal state "1", the "Form cosine value" instruction is executed. 
The instruction calculates the cosine of the angle specified at the "Tag_Value" input and stores 
the result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

TAN: Form tangent value

Description     
Use the "Form tangent value" instruction to calculate the tangent of the angle. The size of the 
angle is specified in radians at the IN input. The result of the instruction is sent to the OUT 
output and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form tangent value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Size of angle in 
radians

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Tangent of the 
specified angle

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value +3.141593 (π)
OUT Tag_Result 0

If operand "TagIn" has the signal state "1", the "Form tangent value" instruction is executed. 
The instruction calculates the tangent of the angle specified at the "Tag_Value" input and stores 
the result in the "Tag_Result" output. If the instruction is executed without errors, the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ASIN: Form arcsine value

Description     
You can use the "Form arcsine value" instruction to calculate the size of the angle from the 
arcsine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at the IN input. The calculated angle size 
is output in radians at the OUT output and can range in value from -π/2 to +π/2. 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is outside the permitted value range (-1 to +1).
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Parameters
The following table shows the parameters of the "Form arcsine value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Sine value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Size of angle in 
radians

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +1.570796 (π/2)

If operand "TagIn" has the signal state "1", the "Form arcsine value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the sine value at the 
"Tag_Value" input. The result of the instruction is stored in the "Tag_Result" output. If the 
instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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ACOS: Form arccosine value

Description     
You can use the "Form arccosine value" instruction to calculate the size of the angle from the 
cosine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at the IN input. The calculated angle size 
is output in radians at the OUT output and can range in value from 0 to +π. 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

● The value at the IN input is outside the permitted value range (-1 to +1).

Parameters
The following table shows the parameters of the "Form arccosine value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Cosine value 

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Size of angle in 
radians

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value 0
OUT Tag_Result +1.570796 (π/2)

If operand "TagIn" has the signal state "1", the "Form arccosine value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the cosine value at the 
"Tag_Value" input. The result of the instruction is stored in the "Tag_Result" output. If the 
instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ATAN: Form arctangent value

Description     
You can use the "Form arctangent value" instruction to calculate the size of the angle from the 
tangent value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers may be specified at the IN input. The calculated angle size is output in radians at the 
OUT output and can range in value from -π/2 to +π/2.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the IN input is not a valid floating-point number.

Parameters
The following table shows the parameters of the "Form arctangent value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Tangent value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Size of angle in 
radians

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +0.785398 (π/4)

If operand "TagIn" has the signal state"1", the "Form arctangent value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the tangent value at the 
"Tag_Value" input. The result of the instruction is stored in the "Tag_Result" output. If the 
instruction is executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

FRAC: Return fraction

Description
You can use the "Return fraction" instruction to determine the decimal places of the value at 
the IN input. The result of the query is stored at the OUT output and can be queried there. If, 
for example, the IN input has the value 123.4567, the OUT output returns the value 0.4567.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at input IN is not a valid floating-point number.
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Parameters
The following table shows the parameters of the "Return fraction" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Value, whose 
decimal places 
are to be 
determined.

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Decimal places of 
the value at the IN 
input

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 2.555
OUT Tag_Result 0.555

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Return fraction" instruction 
is started. The decimal places from the value of operand "Tag_Value" are copied to operand 
"Tag_Result". If the instruction is executed without errors, the ENO output has the signal state 
"1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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EXPT: Exponentiate

Description     
You can use the "Exponentiate" instruction to raise the value at the IN1 input to a power 
specified with the value at the IN2 input. The result of the instruction is provided at the OUT 
output and can be queried there (OUT =IN1IN2).

The IN1 input can only be assigned valid floating-point numbers. Integers can also be assigned 
to the IN2 input.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● Errors occur during execution of the instruction, for example, an overflow occurs.

Parameters
The following table shows the parameters of the "Exponentiate" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Base value

IN2 Input Integers, floating-
point numbers

I, Q, M, D, L, P or 
constant

Value with which 
the base value is 
exponentiated

OUT Output Floating-point 
numbers

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Exponentiate" instruction 
is started. The value of operand "Tag_Value1" is raised to a power specified with the value of 
operand "Tag_Value2". The result is stored in the "Tag_Result" output. If the instruction is 
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executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Move operations

MOVE: Move value

Description
You use the "Move value" instruction to transfer the content of the operand at the IN input to 
the operand at the OUT1 output. The transfer is always made in the direction of ascending 
address.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The data type at the IN parameter does not correspond to the specified data type at the 
OUT1 parameter.

The following table lists the possible transfers for the S7-1200 CPU series:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE ,TOD, CHAR

WORD WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD, CHAR

DWORD DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, REAL, TIME, DATE, TOD, CHAR

SINT SINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

USINT USINT, UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

INT INT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UINT UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

DINT DINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UDINT UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

REAL REAL DWORD, REAL
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

LREAL LREAL LREAL
TIME TIME BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TIME
DATE DATE BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, DATE
TOD TOD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, CHAR, Character of a 

string1)

Character of a 
string1)

Character of a string Character of a string CHAR

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

The following table lists the possible transfers for the S7-1500 CPU series:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD, 
LWORD

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE ,TOD, LTOD, CHAR

WORD WORD, DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, S5TIME, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

DWORD DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, REAL, TIME, 
LTIME, LDT, DATE, TOD, LTOD, CHAR

LWORD LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, LREAL, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

SINT SINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

USINT USINT, UINT, UDINT, 
ULINT

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

INT INT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

UINT UINT, UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD. LTOD

DINT DINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

UDINT UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

LINT LINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

ULINT ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

REAL REAL DWORD, REAL
LREAL LREAL LWORD, LREAL
S5TIME S5TIME WORD, S5TIME
TIME TIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TIME
LTIME LTIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTIME
DATE DATE BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, DATE
DT DT DT
LDT LDT BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LDT
TOD TOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TOD
LTOD LTOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, LWORD, CHAR, Character 

of a string1)

WCHAR WCHAR BYTE, WORD, DWORD, LWORD, CHAR, WCHAR, 
Character of a string1)

Character of a 
string1)

Character of a string CHAR, WCHAR, Character of a string
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
COUNTER COUNTER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
TIMER TIMER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_LTIMER IEC_LTIMER IEC_LTIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

IEC_LCOUNTE
R

IEC_LCOUNTER IEC_LCOUNTER

IEC_ULCOUNT
ER

IEC_ULCOUNTER IEC_ULCOUNTER

1) You can also use the "Move value" instruction to transfer individual characters of a string to 
operands of the CHAR or WCHAR data type. The number of the character to be transferred 
is specified in square brackets next to the operand name. "MyString[2]", for example, transfers 
the second character of the "MyString" string. It is also possible to transfer from operands of 
the data type CHAR to the individual characters of a string. You can also replace a specific 
character of a string with the character of another string.
2) Transferring entire arrays (ARRAY) is possible only when the array components of the 
operands at input IN and at output OUT1 are of the same data type.

If the bit length of the data type at input IN exceeds the bit length of the data type at output 
OUT1, the higher-order bits of the source value are lost. If the bit length of the data type at 
input IN is less than the bit length of the data type at output OUT1, the higher-order bits of the 
destination value will be overwritten with zeros.

In its initial state, the instruction box contains 1 output (OUT1). The number of outputs can be 
extended. The added outputs are numbered in ascending order on the box. During the 
execution of the instruction, the content of the operand at the input IN is transferred to all 
available outputs. The instruction box cannot be extended if structured data types (DTL, 
STRUCT, ARRAY) or characters of a string are transferred.

You can also use the "Move block" (MOVE_BLK) and "Move block uninterruptible" 
(UMOVE_BLK) instructions to move operands of the ARRAY data type. You can move 
operands of the STRING data type with the instruction "Move character string" (S_MOVE).
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Parameter
The following table lists the parameters of the "Move value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers, 
floating-point 
numbers, 
DATE, TIME, 
TOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, IEC 
data types, 
PLC data type 
(UDT)

Bit strings, 
integers, 
floating-point 
numbers, 
DATE, DT, 
LDT, S5TIME, 
TIME, LTIME, 
TOD, LTOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L or 
constant

Source value

OUT1 Output Bit strings, 
integers, 
floating-point 
numbers, 
DATE, TIME, 
TOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, IEC 
data types, 
PLC data type 
(UDT)

Bit strings, 
integers, 
floating-point 
numbers, 
DATE, DT, 
LDT, S5TIME, 
TIME, LTIME, 
TOD, LTOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L Operands to 
which in the 
source value is 
transferred.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0011 1111 1010 1111
OUT1 TagOut_Value 0011 1111 1010 1111

If the operand "TagIn" has the signal state "1", the "Move value" instruction is executed. The 
instruction copies the contents of operand "TagIn_Value" to operand "TagOut_Value" and sets 
output "TagOut" to signal state "1".

See also
Overview of the valid data types (Page 1320)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

MOVE_BLK: Move block (Page 2010)

UMOVE_BLK: Move block uninterruptible (Page 2016)

S_MOVE: Move character string (Page 2637)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Deserialize: Deserialize

Description
You can use the "Deserialize" instruction to convert the sequential representation of a PLC 
data type (UDT) back to a PLC data type and to fill its entire contents.

The memory area in which the sequential representation of a PLC data type is located must 
have the ARRAY of BYTE data type and be declared with standard access. Make sure that 
there is enough memory space prior to the conversion.
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The instruction enables you can convert multiple sequential representations of converted PLC 
data types back to their original state step-by-step.

 

 Note

If you only want to convert back a single sequential representation of a PLC data type (UDT), 
you can also direct the instruction "TRCV: Receive data via communication connection".

 

Parameters
The following table lists the parameters of the "Deserialize" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC_ARRA
Y

Input VARIANT I, Q, D, L Global data block in which the generated data stream is stored

DEST_VARI
ABLE

InOut VARIANT I, Q, D, L Tag in which the returned converted PLC data type (UDT) is 
stored

POS InOut DINT I, Q, M, D, L Number of bytes that the converted PLC data types use. The POS 
parameter is calculated zero-based.

RET_VAL Output INT I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B0 The memory areas for the SRC_ARRAY and 

DEST_VARIABLE parameters overlap.
8136 The data block at the DEST_VARIABLE parameter is not a 

block with standard access.
8150 The VARIANT data type at the SRC_ARRAY parameter 

contains no value.
8151 Code generation error at the SRC_ARRAY parameter
8153 There is not enough free memory available at the 

SRC_ARRAY parameter.
8250 The VARIANT data type at the DEST_VARIABLE parameter 

contains no value.
8251 Code generation error at the DEST_VARIABLE parameter
8254 Invalid data type in the DEST_VARIABLE parameter.
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Error code*
(W#16#...)

Explanation

8382 The value at the POS parameter is outside the limits of the 
array.

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

Network 1:

The "Move value" instruction copies the value "0" to the "#BufferPos" operand. The 
"Deserialize" instruction deserializes the sequential representation of the customer data from 
the "Buffer" data block and writes it to the "Target" data block. The number of bytes that show 
the converted customer data is stored in the "#BufferPos" operand.

Network 2:

The "Deserialize" instruction deserializes the sequential representation of the separator sheet, 
which was saved with the sequential representation after the customer data, from the "Buffer" 
data block and writes the characters to the "#Label" operand. The characters are compared 
using comparison instructions "arti" and "Bill". If the comparison for "arti" = TRUE, then this is 
article data that has been deserialized and written to the "Target" data block. If the comparison 
for "Bill" = TRUE, then this is billing data that has been deserialized and written to the "Target" 
data block.
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The following table lists the declaration of the operands:

Operand Data type Declaration
DeliverPos INT In the "Input" section of the block interface
BufferPos DINT In the "Temp" section of the block interface
Error INT In the "Temp" section of the block interface
Label STRING[4] In the "Temp" section of the block interface

The following table lists the declarations of the PLC data types:

Name the PLC data types Name Data type
Article Number DINT

Declaration STRING
Colli INT

Client Title INT
First name STRING[10]
Surname STRING[10]

The following table lists the declaration of the data blocks:

Name of the data blocks Name Data type
Target Client "Client" (PLC data type)

Article Array[0..] of "Article" (PLC data type)
Bill Array[0..10] of INT

Buffer Field Array[0..294] of BYTE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

PLC data types (Page 1364)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Serialize: Serialize

Description
You can use the "Serialize" instruction to convert several PLC data types (UDT) to a sequential 
representation without losing parts of their structure.

You can use the instruction to cache multiple structured data from your program in a buffer, 
which is preferably in a global data block, and send it to another CPU. The memory area in 
which the converted PLC data types must be stored must have the ARRAY of BYTE data type 
and be declared with standard access. Make sure that there is enough memory space prior to 
the conversion.
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The operand at the POS parameter contains information about how many bytes the converted 
PLC data types occupy.

 

 Note

If you want to send a single PLC data type (UDT), you can directly call the instruction "TSEND: 
Send data via communication connection".

 

Parameters
The following table lists the parameters of the "Serialize" instruction:

Parameters Declarati
on

Data 
type

Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC_VARI
ABLE

Input VARIA
NT

I, Q, D, L PLC data type (UDT) that is converted to sequential representation.

DEST_ARR
AY

InOut VARIA
NT

I, Q, D, L Data block in which the generated data stream is stored.

POS InOut DINT I, Q, M, D, L Number of bytes that the converted PLC data types use. The POS 
parameter is calculated zero-based.

RET_VAL Output INT I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B0 The memory areas for the SRC_VARIABLE and 

DEST_ARRAY parameters overlap.
8150 The VARIANT data type at the SRC_VARIABLE parameter 

contains no value.
8152 Code generation error at the SRC_VARIABLE parameter
8236 The data block at the DEST_ARRAY parameter is not a block 

with standard access.
8250 The VARIANT data type at the DEST_ARRAY parameter 

contains no value.
8252 Code generation error at the DEST_ARRAY parameter
8253 There is not enough free memory available at the 

DEST_ARRAY parameter.
8254 Invalid data type in the DEST_ARRAY parameter.
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Error code*
(W#16#...)

Explanation

8382 The value at the POS parameter is outside the limits of the 
array.

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

Network 1:

The "Move value" instruction copies the value "0" to the "#BufferPos" operand. The "Serialize" 
instruction serializes the customer data from the "Source" data block and writes it in sequential 
representation to the "Buffer" data block. The number of bytes occupied by the sequential 
representation is stored in the "#BufferPos" operand. 

Network 2:

A kind of separator sheet is inserted now to later make it easier to deserialize the sequential 
representation. The "Move string" instruction copies the "arti" characters to the "#Label" 
operand. The "Serialize" instruction writes these characters after the customer data to the 
"Buffer" data block. The number of bytes that the characters need in addition to the number 
already stored are added to the "#BufferPos" operand.

Network 3:
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The "Serialize" instruction serializes the data of a specific article, which is calculated in runtime, 
from the "Source" data block and writes it in sequential representation to the "Buffer" data block 
after the "arti" characters.

The following table lists the declaration of the operands:

Operand Data type Declaration
DeliverPos INT In the "Input" section of the block interface
BufferPos DINT In the "Temp" section of the block interface
Error INT In the "Temp" section of the block interface
Label STRING[4] In the "Temp" section of the block interface

The following table lists the declarations of the PLC data types:

Name the PLC data types Name Data type
Article Number DINT

Declaration STRING
Colli INT

Client Title INT
First name STRING[10]
Surname STRING[10]

The following table lists the declaration of the data blocks:

Name of the data blocks Name Data type
Source
 

Client "Client" (PLC data type)
Article Array[0..10] of "Article" (PLC data type)

Buffer Field Array[0..294] of BYTE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

PLC data types (Page 1364)

Inserting additional inputs and outputs in LAD elements (Page 1544)
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FieldRead: Read field

Description
You can use the "Read field" instruction to read out a specific component from the field 
specified at input MEMBER and transfer its content to the tag at output VALUE. You specify 
the index of the field component to be read at input INDEX. Specify the first component of the 
field from which reading is to occur at input MEMBER.

The data types of the field component at input MEMBER and the tags at output VALUE must 
correspond to the data type of the instruction "Read field".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The field component specified at input INDEX is not defined in the field specified at output 
MEMBER.

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Read field" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
INDEX Input DINT DINT I, Q, M, D, L, P 

or constant
Index of field 
component 
whose content 
is read out

MEMBER Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR as 
components of 
an ARRAY tag

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR as 
components of 
an ARRAY tag

D, L First 
component of 
the field from 
which reading 
occurs.

VALUE Output Bit strings, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, P Operand to 
which the 
content of the 
field 
component is 
transferred

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2007



For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Tag Value
INDEX a_index 4
MEMBER "DB_1".Main_Field[-10] First component of the "Main_Field[-10..10] of 

REAL" field in the "DB_1" data block
VALUE a_real Component with index 4 of the 

"Main_Field[-10..10] of REAL" field

The field component with index 4 is read from the "Main_Field[-10...10] of REAL" field and 
written to the "a_real" tag. The field component to be read is specified by the value at input 
INDEX.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

FieldWrite: Write field

Description
The "Write field" instruction is used to transfer the content of the tag at the VALUE input to a 
specific component of the field at the MEMBER output. You use the value at the INDEX input 
to specify the index of the field component that is described. At the MEMBER output, enter the 
first component of the field which is to be written to.

The data types of the field component specified at the MEMBER output and the tags at the 
VALUE input have to match the data type of the "Write field" instruction.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:
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● The EN enable input has the signal state "0".

● The field component specified at the input INDEX is not defined in the field specified at the 
output MEMBER.

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Write field" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
INDEX Input DINT DINT I, Q, M, D, L, P 

or constant
Index of the 
field 
component 
that is being 
written with the 
content of 
VALUE.

VALUE Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, P 
or constant

Operand 
whose content 
is copied.

MEMBER Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD and 
CHAR as 
components of 
an ARRAY tag

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD 
and CHAR as 
components of 
an ARRAY tag

D, L First 
component of 
the field to 
which the 
content of 
VALUE is 
written.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
INDEX a_index 4
VALUE a_real 10.54
MEMBER "DB_1".Main_Field[-10] First component of the "Main_Field[-10..10] of 

REAL" field in the "DB_1" data block

The value "10.54" of the "a_real" tag is written to the field component with index 4 of the 
"Main_Field[-10..10] of REAL" field. The index of the field component to which the content of 
the tag "a_real" is transferred is specified by the value at the input INDEX.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MOVE_BLK: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The number of elements to be moved to the 
destination area is specified at input COUNT. The width of the elements to be moved is defined 
by the width of the element at the IN input.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".
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Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
source area 
that is being 
copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
elements to be 
copied from 
the source 
area to the 
destination 
area.

OUT 1) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
destination 
area to which 
the contents of 
the source 
area are being 
copied

1) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Move block" instruction is 
executed. Starting from the third element, the instruction selects three INT elements from the 
#a_array tag and copies their contents to the #b_array output tag, beginning with the second 
element. If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

MOVE_BLK_VARIANT: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). You can copy elements of an array to another array 
of the same data type. The size (number of elements) of the source and destination array may 
be different. You can copy several elements within an array or individual elements.

If you are using the instruction, the array must not yet be known at the time the block is created, 
as the source and the destination are transferred using VARIANT.

The counting at the parameters SRC_INDEX and DEST_INDEX always starts with the low 
limit "0", regardless of the later declaration of the array.

If the VARIANT pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available.

Programming the PLC
9.7 References

WinCC Professional V13.0
2012 System Manual, 02/2014



Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input VARIANT

(array or single 
element)

L Source block from 
which to copy

COUNT Input UDINT I, Q, M, D, L or constant Number of elements 
which are copied
Set the value at the 
parameter COUNT to 
"1", if no Array is 
specified at the 
parameter SRC or the 
parameter DEST.

SRC_INDEX Input DINT I, Q, M, D, L or constant ● The SRC_INDEX 
parameter is 
calculated zero-
based. If an Array 
is specified at 
parameter SRC, 
the integer at the 
SRC_INDEX 
parameter 
specifies the first 
element within the 
source area from 
which copying is to 
take place. This is 
independent of the 
declared array 
limits.

● If no Array is set at 
the SRC parameter 
or only an 
individual element 
of an array is 
specified, assign 
the SRC_INDEX 
parameter the 
value "0".
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Parameter Declaration Data type Memory area Description
DEST_INDEX Input DINT I, Q, M, D, L or constant ● The DEST_INDEX 

parameter is 
calculated zero-
based. If an Array 
is specified at the 
DEST parameter, 
the integer at the 
DEST_INDEX 
parameter 
specifies the first 
element within the 
destination area to 
which copying is to 
take place. This is 
independent of the 
declared array 
limits.

● If no Array is 
specified at the 
DEST parameter, 
assign the 
DEST_INDEX 
parameter the 
value "0".

DEST Output VARIANT L Destination area into 
which the contents of 
the source block are 
copied.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during the execution of 
the instruction, an error 
code is output at the 
RET_VAL parameter.

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table lists the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
8151 Access to the SRC parameter is not possible.
8152 The operand at the SRC parameter is not typed.
8153 Code generation error at the SRC parameter
8154 The operand at the SRC parameter has the data type BOOL.
8281 The COUNT parameter has an invalid value
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Error code*
(W#16#...)

Explanation

8382 The value at the SRC_INDEX parameter is outside the limits of the 
VARIANT.

8383 The value at the SRC_INDEX parameter is outside the high limit of the array.
8482 The value at the DEST_INDEX parameter is outside the limits of the 

VARIANT.
8483 The value at the DEST_INDEX parameter is outside the high limit of the 

array.
8534 The DEST parameter is write protected
8551 Access to the DEST parameter is not possible.
8552 The operand at the DEST parameter is not typed.
8553 Code generation error at the DEST parameter
8554 The operand at the DEST parameter has the data type BOOL.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
SRC #SrcField The local operand #SrcField 

uses a UDT that was still 
unknown at the time when the 
block was programmed. (Array 
[0 to 10] of "MOVE_UDT"

COUNT Tag_Count 2
SRC_INDEX Tag_Src_Index 3
DEST_INDEX Tag_Dest_Index 3
DEST #DestField The local operand #DestField 

uses a UDT that was still 
unknown at the time when the 
block was programmed. (Array 
[10 to 20] of "MOVE_UDT"
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If the operand "TagIn" has the signal state "1", the "Move block" instruction is executed. 2 
elements are copied from the source area into the destination area beginning with the fourth 
element of the array of UDT. The copies are inserted in the array of UDT beginning with the 
fourth element. If the instruction is executed without errors, the ENO enable output has the 
signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VariantGet: Read out VARIANT tag value (Page 2035)

Inserting additional inputs and outputs in LAD elements (Page 1544)

UMOVE_BLK: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The number of elements to be moved 
to the destination area is specified with the COUNT parameter. The width of the elements to 
be moved is defined by the width of the element at the IN input.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the interrupt reaction times of the CPU increase during the execution of the "Move block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.
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Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
source area 
that is being 
copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
elements to be 
moved from 
the source 
area to the 
destination 
area.

OUT 1) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
TOD, LTOD

D, L The first 
element of the 
destination 
area to which 
the contents of 
the source 
area are being 
copied

1) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Move block uninterruptible" 
instruction is executed. Starting from the third element, the instruction selects three INT 
elements from the #a_array tag and copies their contents to the #b_array output tag, beginning 
with the second element. The copy operation cannot be interrupted by other operating system 
activities. If the instruction is executed without errors, the ENO output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

FILL_BLK: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the value 
of the IN input.  The destination area is filled starting from the address specified at the OUT 
output. The number of repeated copy operations is specified with the COUNT parameter. When 
the instruction is executed, the value at the IN input is selected and copied to the destination 
area as often as specified by the value in the COUNT parameter.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".
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Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area
 
 

Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD, CHAR

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

I, Q, M, D, L, P 
or constant

Element used 
to fill the 
destination 
area

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
repeated move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD, CHAR

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

D, L Address in 
destination 
area from 
which filling 
starts.

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Fill block" instruction is 
executed. The instruction copies the third element (#a_array[2]) of the #a_array tag three times 
to the #b_array output tag. If the instruction is executed without errors, the ENO and "TagOut" 
enable outputs are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

UFILL_BLK: Fill block uninterruptible

Description
You can use the "Fill block uninterruptible" instruction to fill a memory area (destination area) 
with the value of the IN input without interruption.  The destination area is filled starting from 
the address specified at the OUT output. The number of repeated copy operations is specified 
with the COUNT parameter. When the instruction is executed, the value at the IN input is 
selected and copied to the destination area as often as specified by the value in the COUNT 
parameter.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Fill block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available at the IN input or OUT output.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the ARRAY structure is exceeded. If the byte limit of the ARRAY structure is 
exceeded by the value at the COUNT input, the ENO enable output is reset to "0".
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You can use the "Fill block uninterruptible" instruction to move a maximum of 16 KB. Note the 
CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Fill block uninterruptible" instruction:

Parameter Declaration Data type Memory area
 

Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN 1) Input Binary 

numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

I, Q, M, D, L, P 
or constant

Element used 
to fill the 
destination 
area.

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L, P 
or constant

Number of 
repeated move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-point 
numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

D, L Address in 
destination 
area from 
which filling 
begins.

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If operands "TagIn_1" and "TagIn_2" have the signal state "1", the "Fill block uninterruptible" 
instruction is executed. The instruction copies the third element (#a_array[2]) of the #a_array 
tag three times to the #b_array output tag. The copy operation cannot be interrupted by other 
operating system activities. If the instruction is executed without errors, the ENO and "TagOut" 
enable outputs are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

SWAP: Swap

Description
You can use the "Swap" instruction to change the order of the bytes at input IN and query the 
result at output OUT.

The following figure shows how the bytes of an operand of the DWORD data type are swapped 
using the "Swap" instruction:
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Parameter
The following table lists the parameters of the "Swap" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input WORD, 

DWORD
WORD, 
DWORD, 
LWORD

I, Q, M, D, L or, 
P constant

Operand 
whose bytes 
are swapped.

OUT Output WORD, 
DWORD

WORD, 
DWORD, 
LWORD

I, Q, M, D, L, P Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0000 1111 0101 0101
OUT TagOut_Value 0101 0101 0000 1111

If operand "TagIn" has the signal state "1", the "Swap" instruction is executed. The order of 
the bytes is changed and stored in operand "TagOut_Value".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

ARRAY DB instructions

ReadFromArrayDB: Read from array data block

Description
You can use the "Read from array data block" instruction to read data from an array DB and 
write them to a destination area.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Read from array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block that is 

read
INDEX Input DINT I, Q, M, D, L, P or 

constant
Element that is 
read
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Parameter Declaration Data type Memory area Description
VALUE Output VARIANT L Value that is read 

and output
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The array DB contains invalid values
8154 The data type is not correctly declared
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
DB ArrayDB The data type of the ArrayDB 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE TargetField[10].Data2[1] The data type of the TargetField 

operand is Array [10 to 20] of 
"MOVE_UDT".

If the "TagIn1" operand has the signal state "1", the "Read from the ARRAY data block" 
instruction is executed. The third element is read from "ArrayDB" and written to the 
"TargetField[10].Data2[1]" operand. If the instruction is executed without errors, the ENO 
enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

WriteToArrayDB: Write to array data block

Description
You can use the "Write to array data block" instruction to write data to an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Write to array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block to 

which data is 
written
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Parameter Declaration Data type Memory area Description
INDEX Input DINT I, Q, M, D, L, P or 

constant
Element in the DB 
to which data is 
written

VALUE Input VARIANT L Value to be written
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
DB ArrayDB The data type of the ArrayDB 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE SourceField[1].Data1[6] The data type of the SourceField 

operand is Array [0 to 10] of 
"MOVE_UDT".

If the "TagIn1" operand has the signal state "1", the "Write to the ARRAY data block" instruction 
is executed. From the "SourceField" operand, the "Data1[6]" element from the second element 
is written to the "ArrayDB". The third element is written to the "ArrayDB". If the instruction is 
executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Inserting additional inputs and outputs in LAD elements (Page 1544)

ReadFromArrayDBL: Read from array data block in load memory

Description
You can use the "Read from array data block in load memory" instruction to read data from an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". The instruction is terminated if a negative 
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signal edge is detected at the BUSY parameter. The DONE parameter has the signal state "1" 
for one program cycle and the read value is output at the VALUE parameter within this cycle. 
With all other program cycles, the value at the VALUE parameter is not changed.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".

 

 Note

The array DB must be located in a data block with the block property "Optimized".
 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table lists the parameters of the "Read from array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = "1": 
Starting with the 
reading of the 
array DB

DB Input DB_ANY I, Q, M, D, L Data block that is 
read

INDEX Input DINT I, Q, M, D, L, P or 
constant

Element that is 
read

BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 
array DB is still 
being read

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully
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Parameter Declaration Data type Memory area Description
VALUE InOut VARIANT D, L Value that is read 

and output
ERROR Output INT I, Q, M, D, L, P Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
ERROR 
parameter.

For additional information on valid data types, refer to "See also".

ERROR parameter
The following table shows the meaning of the values of the ERROR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
80C3 Too many concurrent calls
8132 The data block does not exist or is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

You can find descriptions of the error codes triggered by the instructions "READ_DBL: Read 
from data block in the load memory" and "WRIT_DBL: Write to data block in the load memory" 
under "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
REQ TagReq BOOL
DB ArrayDB The data type of the ArrayDB 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE SourceTargetField[1].Data1[6] The data type of the 

SourceTargetField operand is 
Array [0 to 10] of "MOVE_UDT".

BUSY TagBusy BOOL
DONE TagDone BOOL

If the "TagIn1" operand has the signal state "1" and a positive edge is detected at the 
"TagReq"operand, the "Read from ARRAY data block in load memory" instruction is executed. 
The third element is read from "ArrayDB" and written to the "SourceTargetField[1].Data1[6]" 
operand. As soon as a negative signal edge is detected at the "TagBusy" operand, the 
instruction is terminated and the value at the VALUE parameter is no longer changed. If the 
instruction is executed without errors, the ENO enable output has the signal state "1" and the 
"TagOut" output is set. After the instruction has been processed, the "TagDone" operand the 
signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

READ_DBL: Read from data block in the load memory (Page 2914)

WRIT_DBL: Write to data block in the load memory (Page 2916)

Inserting additional inputs and outputs in LAD elements (Page 1544)
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WriteToArrayDBL: Write to array data block in load memory

Description
You can use the "Write to array data block in load memory" instruction to write data to an array 
DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". If a negative signal edge is detected at the 
BUSY parameter, the instruction is terminated and the value at the VALUE parameter is written 
to the data block. The DONE parameter then has the signal state "1" for one program cycle.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".

 

 Note

The array DB must be located in a data block with the block property "Optimized".
 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table lists the parameters of the "Write to array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = "1": Start 
writing into the 
array DB

DB Input DB_ANY D Data block to 
which data is 
written

INDEX Input DINT I, Q, M, D, L, P or 
constant

Element in the DB 
to which data is 
written
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Parameter Declaration Data type Memory area Description
VALUE Input VARIANT D, L Value to be written
BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 

array DB is still 
being written

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

ERROR Output INT I, Q, M, D, L, P Error information:
If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
ERROR 
parameter.

For additional information on valid data types, refer to "See also".

ERROR parameter
The following table shows the meaning of the values of the ERROR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
80C3 Too many concurrent calls
8132 The data block does not exist or is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

You can find descriptions of the error codes triggered by the instructions "READ_DBL: Read 
from data block in the load memory" and "WRIT_DBL: Write to data block in the load memory" 
under "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
REQ TagReq BOOL
DB ArrayDB The data type of the ArrayDB 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE SourceTargetField[1].Data1[6] The data type of the 

SourceTargetField operand is 
Array [0 to 10] of "MOVE_UDT".

BUSY TagBusy BOOL
DONE TagDone BOOL

If the "TagIn1" operand has the signal state "1" and a positive edge is detected at the 
"TagReq"operand, the "Write to ARRAY data block in load memory" instruction is executed. 
As soon as a negative signal edge is detected at the "TagBusy" operand, the instruction is 
terminated and the value at the VALUE parameter is written in the third element in the 
"ArrayDB". If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set. After the instruction has been processed, the 
"TagDone" operand the signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

READ_DBL: Read from data block in the load memory (Page 2914)

WRIT_DBL: Write to data block in the load memory (Page 2916)

Inserting additional inputs and outputs in LAD elements (Page 1544)
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VARIANT instructions

VariantGet: Read out VARIANT tag value

Description
You can use the "Read out VARIANT tag value" instruction to read the value of the tag that 
points to the VARIANT at the SRC parameter, and write it to the tag at the DST parameter.

The SRC parameter must have the same VARIANT data type. Any data type except for 
VARIANT can be specified at the DST parameter.

The data type of the tag at the DST parameter must match the data type to which the VARIANT 
points.

 

 Note

The tag to which the VARIANT at parameter SRC points must be a PLC data type.

To copy structures and ARRAYs, you can use the "MOVE_BLK_VARIANT: Move block" 
instruction. For additional information, refer to "See also".

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The data types do not correspond. (No value is transferred.)

Parameter
The following table lists the parameters of the "Read out VARIANT tag value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input VARIANT L Tag to be read
DST Output Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY

I, Q, M, D, L Result of the instruction

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the "TagIn" operand has the signal state "1", the "Read out VARIANT tag value" instruction 
is executed. The value of the tag to which the VARIANT at the "#TagIn_Source" operand points, 
is read and written to the "TagOut_Dest" operand.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

MOVE_BLK_VARIANT: Move block (Page 2012)

Inserting additional inputs and outputs in LAD elements (Page 1544)

VariantPut: Write VARIANT tag value

Description
You can use the "Write VARIANT tag value" instruction to write the value of the tag at the SRC 
parameter and to the tag at the DST parameter to which the VARIANT points.

The DST parameter must have the same VARIANT data type. Any data type except for 
VARIANT can be specified at the SRC parameter.

The data type of the tag at the SRC parameter must match the data type to which the VARIANT 
points.

 

 Note

The tag to which the VARIANT at parameter DST points must be a PLC data type.
 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The data types do not correspond. (No value is transferred.)
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Parameters
The following table lists the parameters of the "Write VARIANT tag value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY

I, Q, M, D, L Tag to be read

DST Input VARIANT L Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the "TagIn" operand has the signal state "1", the "Write VARIANT tag value" instruction is 
executed. The value of the "TagIn_Source" operand is written to the tag to which the VARIANT 
at the "#TagIn_Dest" operand points.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

Inserting additional inputs and outputs in LAD elements (Page 1544)

CountOfElements: Get number of ARRAY elements

Description
You can use the "Get number of ARRAY elements" instruction to query how many ARRAY 
elements a tag pointing to an VARIANT has.
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If it is a one-dimensional ARRAY, the difference between the high and low limit +1 is output 
as a result. If it is a multi-dimensional ARRAY, the product of all dimensions is output as the 
result.

The IN parameter must have the same VARIANT data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The VARIANT tag is not an ARRAY. (The result is "0".)

If the VARIANT points to an ARRAY of BOOL, the fill elements are also included in the count. 
(For example, 8 is returned for an ARRAY[0..1] of BOOL)

Parameters
The following table lists the parameters of the "Get number of ARRAY elements" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input VARIANT L Tag to be queried
RET_VAL Output UDINT I, Q, M, D, L Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the "TagIn" operand has the signal state "1", the "Get number of ARRAY elements" instruction 
is executed. The number of ARRAY elements of the tag to which the VARIANT at the 
"#TagIn_Source" operand points is read and output at the "TagOut_RetVal" operand.

See also
Format of array (16-bit limits) (Page 1351)

Format of array (32-bit limits) (Page 1352)

Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Programming the PLC
9.7 References

WinCC Professional V13.0
2038 System Manual, 02/2014



Other

BLKMOV: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The move operation takes place in the direction 
of ascending addresses. You use VARIANT to define the source and destination area.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentivity setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

The following figure shows the principle of the move operation:

Consistency of the source data and the target data
Make sure that the source data remain unchanged during the execution of the "Move block" 
instruction. Otherwise the consistency of the target data cannot be ensured.

Interruptibility
There is no limit to the nesting depth.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2039



Memory areas
You can use the "Move block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the source and destination area have 
different lengths, only the length of the smaller area will be moved.

If the source area is less than the destination area, the entire source area will be written to the 
destination area. The remaining bytes of the destination area remain unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

Rules for moving character strings
You can use the "Move block" instruction to also move source and destination areas of the 
STRING data type. If only the source area is STRING data type, the characters will be moved 
that are actually contained in the character string. Information on the actual and maximum 
length is also written to the destination area. If the source and destination area are each 
STRING data type, the current length of the character string in the destination area is set to 
the number of actually moved characters.

If you want to move the information on the maximum and actual length of a character string, 
specify the areas in bytes to the SRCBLK and DSTBLK parameters.

Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRCBLK Input VARIANT L, P Specifies the memory area to be 

moved 
(source area).
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Parameter Declaration Data type Memory area Description
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs during the 
execution of the instruction, an 
error code is output at the 
RET_VAL parameter.

DSTBLK Output VARIANT L, P Specifies the memory area to 
which the block is to be moved 
(destination area).

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8152 The WSTRING, WCHAR and BOOL data types are not supported.
8092 The source or target area is only available in the load memory.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2080)

Inserting additional inputs and outputs in LAD elements (Page 1544)

UBLKMOV: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The move operation takes place in 
the direction of ascending addresses. You use VARIANT to define the source and destination 
area.
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The move operation cannot be interrupted by other operating system activities. As a result the 
alarm reaction time of the CPU can increase during the execution of the "Move block 
uninterruptible" instruction.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentivity setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

Memory areas
You can use the "Move block uninterruptible" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap during the execution of the "Move block 
uninterruptible" instruction. If the source area is less than the destination area, the entire source 
area will be written to the destination area. The remaining bytes of the destination area remain 
unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a source or destination area defined as a formal parameter is less than a destination or 
source area specified on the SRCBLK or DSTBLK parameter, no data is transferred.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Rules for moving character strings
You can use the "Move block uninterruptible" instruction to also move source and destination 
areas of the STRING data type. If only the source area is STRING data type, the characters 
will be moved that are actually contained in the character string. Information on the actual and 
maximum length are not written in the destination area. If the source and destination area are 
each STRING data type, the current length of the character string in the destination area is 
set to the number of actually moved characters. If areas of the data type STRING are moved, 
you have to specify "1" as area length.
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Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRCBLK Input VARIANT L, P Specifies the memory area to 

be moved (source area).
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs during the 
execution of the instruction, an 
error code is output at the 
RET_VAL parameter.

DSTBLK Output VARIANT L, P Specifies the memory area to 
which the block is to be moved 
(destination area).

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8152 The WSTRING, WCHAR and BOOL data types are not supported.
8091 The source area is in a data block that is not relevant for program execution.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2080)

Inserting additional inputs and outputs in LAD elements (Page 1544)

FILL: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the content 
of another memory area (source area). The "Fill block" instruction moves the content of the 
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source area to the destination area until the destination area is completely written. The move 
operation takes place in the direction of ascending addresses.

You use VARIANT to define the source and destination area.
 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentivity setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

For blocks with the "Optimized block access" attribute, you can use the instruction "FILL_BLK: 
Fill block" instruction.

 

The following figure shows the principle of the move operation:

Example: The contents of the range MW100 to MW118 are to be preassigned with the contents 
of the memory words MW14 to MW20.

Consistency of the source data and the target data
Please note that during execution of the instruction "Fill block" that the source data remain 
unchanged, otherwise the consistency of the target data is not ensured.

Memory areas
You can use the "Fill block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory
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● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the destination block to be preset is not 
an integer multiple of the length of the input parameter BVAL, the destination block is 
nevertheless written up to the last byte.

If the destination area to be preset is smaller than the source area, the function only copies as 
much data as can be written to the destination area.

If the destination or source area actually present is smaller than the assigned memory area 
for the source or destination block (BVAL BLK parameters), no data is transferred.

If the ANY pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

If the destination block is of data type STRING, the instruction describes the entire string 
including the administration information.

Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
BVAL Input VARIANT L, P Specification of the memory area 

(source area) with the content 
used to fill the destination area at 
the BLK parameter.

RET_VAL Output INT I, Q, M, D, L, P Error information:
If an error occurs during the 
execution of the instruction, an 
error code is output at the 
RET_VAL parameter.

BLK Output VARIANT L, P Specification of the memory area 
that is filled with the content of the 
source area.

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8152 The WSTRING, WCHAR and BOOL data types are not supported.
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Error code*
(W#16#...)

Explanation

General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2080)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Conversion operations

CONVERT: Convert value

Description
The "Convert value" instruction reads the content of the IN parameter and converts it according 
to the data types selected in the instruction box. The converted value is sent to the output OUT.

For information on possible conversions, refer to the "Explicit conversion" section at "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Convert value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers, floating-
point numbers, 
CHAR, BCD16, 
BCD32

I, Q, M, D, L, P or 
constant

Value to be 
converted.

OUT Output Bit strings, 
integers, floating-
point numbers, 
CHAR, BCD16, 
BCD32

I, Q, M, D, L, P Result of the 
conversion
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You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

Bit strings (BYTE, WORD, DWORD, LWORD) cannot be selected in the instruction box. If you 
specify an operand of data type BYTE, WORD, DWORD or LWORD at a parameter of the 
instruction, it is interpreted according to the data type of the input or output parameter. Data 
type BYTE is then interpreted as USINT, WORD as UINT, DWORD as UDINT, and LWORD 
as LINT, for example.

 

 Note

For S7-1500 CPU: The data types DWORD and LWORD can be selected, if REAL or LREAL 
is selected as IN data type.

 

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the content of operand "TagIn_Value" is read and 
converted to an integer (32-bit). The result is stored in operand "TagOut_Value". The output 
"TagOut" is set to "1" if the instruction was executed without errors.

See also
Overview of the valid data types (Page 1320)

Explicit conversion of CHAR (Page 1413)

ROUND: Round numerical value

Description     
You can use the "Round numerical value" instruction to round the value at input IN  to the 
nearest integer. The instruction interprets the value at input IN as a floating-point number and 
converts this to an integer of data type DINT. If the input value is exactly between an even and 
odd number, the even number is selected. The result of the instruction is sent to the OUT 
output and can be queried there.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:
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● The enable input EN has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Round numerical value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value to be 
rounded.

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Result of rounding

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 2 -2

If operand "TagIn" has the signal state "1", the "Round numerical value" instruction is executed. 
The floating-point number at input "TagIn_Value" is rounded to the nearest even integer and 
sent to output "TagOut_Value". If the instruction is executed without errors, the "TagOut" output 
is set.

See also
Overview of the valid data types (Page 1320)
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CEIL: Generate next higher integer from floating-point number

Description     
You can use the "Generate next higher integer from floating-point number" instruction to round 
the value at input IN to the next higher integer. The instruction interprets the value at the IN 
input as a floating-point number and converts this number to the next higher integer. The result 
of the instruction is sent to the OUT output and can be queried there. The output value can be 
greater than or equal to the input value.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Generate next higher integer from floating-
point number" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Result with next 
higher integer

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 1 0

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2049



If operand "TagIn" has the signal state "1", the "Generate next higher integer from floating-
point number" instruction is executed. The floating-point number at the "TagIn_Value" input is 
rounded to the next higher integer and sent to the "TagOut_Value" output. If the instruction is 
executed without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

FLOOR: Generate next lower integer from floating-point number

Description     
You can use the "Generate next lower integer from floating-point number" instruction to round 
the value at input IN to the next lower integer. The instruction interprets the value at input IN 
as a floating-point number and converts this to the next lower integer. The result of the 
instruction is sent to the OUT output and can be queried there. The output value can be less 
than or equal to the input value.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The enable input EN has the signal state "0".

● Errors such as an overflow occur during execution.

Parameters
The following table shows the parameters of the "Generate next lower integer from floating-
point number" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Integers, floating-
point numbers

I, Q, M, D, L, P Result with next 
lower integer

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 0 -1

If operand "TagIn" has the signal state "1", the "Generate next lower integer from floating-point 
number" instruction is executed. The floating-point number at input "TagIn_Value" is rounded 
to the next lower integer and sent to output "TagOut_Value". If the instruction is executed 
without errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

TRUNC: Truncate numerical value

Description       
You can use the "Truncate numerical value" instruction to form an integer from the value at 
the IN input. The value at the IN input is interpreted as a floating-point number. The instruction 
selects only the integer part of the floating-point number and sends this to the OUT output 
without decimal places.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN input has the signal state "0".

● Errors such as an overflow occur during execution.
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Parameters
The following table shows the parameters of the "Truncate numerical value" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L or 
constant

Input value

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Integer part of the 
input value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 1 -1

If operand "TagIn" has the signal state "1", the "Truncate numerical value" instruction is 
executed. The integer part of the floating-point number at the "TagIn_Value" input is converted 
to an integer and sent to the "TagOut_Value" output. If the instruction is executed without 
errors, the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)
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SCALE_X: Scale

Description
You can use the "Scale" instruction to scale the value at the VALUE input  by mapping it to a 
specified value range. When the "Scale" instruction is executed, the floating-point value at the 
VALUE input is scaled to the value range that was defined by the MIN and MAX parameters. 
The result of the scaling is an integer, which is stored in the OUT output.

The following figure shows an example of how values can be scaled:

The "Scale" instruction works with the following equation:

OUT = [VALUE ∗ (MAX – MIN)] + MIN

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the MIN input is greater than or equal to the value at the MAX input.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● An overflow occurs.

● The value at the VALUE input is NaN (Not a Number = result of an invalid arithmetic 
operation).

 

 Note

For more information on the converting of analog values, refer to the respective manual.
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Parameters
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE Input Floating-point 
numbers

I, Q, M, D, L or 
constant

Value to be scaled.
If you enter a 
constant, you 
must declare it.

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Result of scaling

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 0.5
MAX Tag_MAX 30
OUT Tag_Result 20

If operand "TagIn" has the signal state "1", the "Scale" instruction is executed. The value at 
the "Tag_Value" input is scaled to the range of values defined by the values at the "Tag_MIN" 
and "Tag_MAX" inputs. The result is stored in the "Tag_Result" output. If the instruction is 
executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.
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See also
Overview of the valid data types (Page 1320)

NORM_X: Normalize (Page 2055)

Declaring global constants (Page 1436)

NORM_X: Normalize

Description
You can use the instruction "Normalize" to normalize the value of the tag at the VALUE input 
by mapping it to a linear scale. You can use the MIN and MAX parameters to define the limits 
of a value range that is applied to the scale. The result at the OUT output is calculated and 
stored as a floating-point number depending on the location of the value to be normalized 
within this value range. If the value to be normalized is equal to the value at the MIN input, the 
OUT output has the value "0.0". If the value to be normalized is equal to the value at input 
MAX, output OUT returns the value "1.0".

The following figure shows an example of how values can be normalized:

The "Normalize" instruction works with the following equation:

OUT = (VALUE – MIN) / (MAX – MIN)

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value at the MIN input is greater than or equal to the value at the MAX input.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● The value at the VALUE input is NaN (result of an invalid arithmetic operation).
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 Note

For more information on the converting of analog values, refer to the respective manual.
 

Parameter
The following table shows the parameters of the "Normalize" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MIN 1) Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE 1) Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Value to be 
normalized.

MAX 1) Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Floating-point 
numbers

I, Q, M, D, L Result of the 
normalization

1) If you use constants in these three parameters, you only need to declare one of them.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 20
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Parameter Operand Value
MAX Tag_MAX 30
OUT Tag_Result 0.5

If operand "TagIn" has the signal state "1", the "Normalize" instruction is executed. The value 
at the "Tag_Value" input is mapped to the range of values that were defined by the values at 
the "Tag_MIN" and "Tag_MAX" inputs. The tag value at the "Tag_Value" input is normalized 
to the defined value range. The result is stored as a floating-point number in the "Tag_Result" 
output. If the instruction is executed without errors, the ENO enable output has the signal state 
"1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

SCALE_X: Scale (Page 2053)

Declaring global constants (Page 1436)

Other

SCALE: Scale

Description
Use the "Scale" instruction to convert the integer at the IN parameter into a floating-point 
number, which can be scaled in physical units between a low limit value and a high limit value. 
You can use the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the 
value range to which the input value is scaled. The result of the instruction is output on the 
OUT parameter.

The "Scale" instruction works with the following equation:

OUT = [((FLOAT (IN) – K1)/(K2–K1)) ∗ (HI_LIM–LO_LIM)] + LO_LIM

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter:

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0,0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "K2", the result 
of the instruction is set to the value of the high limit (HI_LIM) and an error is output. 

When the value at the IN parameter is less than the value of the constant "K1", the result of 
the instruction is set to the value of the low limit value (LO_LIM) and an error is output. 

When the indicated low limit value is greater than the high limit value (LO_LIM > HI_LIM), the 
result is scaled in reverse proportion to the input value. 
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Parameter
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input INT I, Q, M, D, L, P or 

constant
Input value to be 
scaled.

HI_LIM Input REAL I, Q, M, D, L, P or 
constant

High limit 

LO_LIM Input REAL I, Q, M, D, L, P or 
constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

Indicates if the 
value at IN 
parameter is to be 
interpreted as 
bipolar or unipolar. 
The parameter 
can assume the 
following values:
1: Bipolar
0: Unipolar

OUT Output REAL I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P Error information

Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the  IN parameter is greater than the value of the constant "K2" or less than the value of the 

constant "K1"
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 22
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 50.03978588
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2080)

UNSCALE: Unscale

Description
The "Unscale" instruction is used to unscale the floating-point number on the IN parameter 
into physical units between a low limit and a high limit and convert it into an integer. You can 
use the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the value range 
to which the input value is unscaled. The result of the instruction is output on the OUT 
parameter.

The "Unscale" instruction works with the following equation:

OUT = [ ((IN–LO_LIM)/(HI_LIM–LO_LIM)) ∗ (K2–K1) ] + K1

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2059



● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "HI_LIM", the 
result of the instruction is set to the value of the constant (K2) and an error is output. 

When the value at the IN parameter is less than the value of the constant of the low limit 
(LO_LIM), the result of the instruction is set to the value of the constant (K1) and an error is 
output.

Parameters
The following table shows the parameters of the "Unscale" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Input BOOL I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P or 

constant
Input value to be 
unscaled to an 
integer value.

HI_LIM Input REAL I, Q, M, D, L, P or 
constant

High limit

LO_LIM Input REAL I, Q, M, D, L, P or 
constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

Indicates if the 
value at IN 
parameter is to be 
interpreted as 
bipolar or unipolar. 
The parameter 
can assume the 
following values:
1: Bipolar
0: Unipolar

OUT Output INT I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P Error information
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Parameter RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the IN parameter is greater than the value of the high limit (HI_LIM) or less than the value 

of the low limit (LO_LIM).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 50.03978588
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 22
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2080)
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Program control operations

---( JMP ): Jump if RLO = 1

Description     
You can use the "Jump if RLO = 1" instruction to interrupt the linear execution of the program 
and resume it in another network. The destination network must be identified by a jump label 
(LABEL). The name of this jump label is specified in the placeholder above the instruction.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil is permitted within 
a network.

If the result of logic operation (RLO) at the input of the instruction is "1", the jump to the network 
identified by the specified jump label is executed. The jump direction can be towards higher 
or lower network numbers.

If the condition at the input of the instruction is not fulfilled (RLO = 0), execution of the program 
continues in the next network.

Example
The following example shows how the instruction works:

If operand "TagIn_1" has the signal state "1", the "Jump if RLO = 1" instruction is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If the "TagIn_3" input has the signal state "1", the "TagOut_3" 
output is set.
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---( JMPN ): Jump if RLO = 0

Description     
You can use the instruction "Jump if RLO = 0" to interrupt the linear execution of the program 
and resume it in another network, when the result of logic operation at the input of the 
instruction is "0". The destination network must be identified by a jump label (LABEL). The 
name of this jump label is specified in the placeholder above the instruction.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil is permitted within 
a network.

If the result of logic operation (RLO) at the input of the instruction is "0", the jump to the network 
identified by the specified jump label is executed. The jump direction can be towards higher 
or lower network numbers.

If the result of logic operation at the input of the instruction is "1", execution of the program 
continues in the next network.

Example
The following example shows how the instruction works:

If operand "TagIn_1" has the signal state "0", the "Jump if RLO = 0" instruction is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If the "TagIn_3" input has the signal state "1", the "TagOut_3" 
output is set.

See also
Overview of the valid data types (Page 1320)
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LABEL: Jump label

Description       
You can use a jump label to identify a destination network, in which the program execution 
should resume when a jump is executed.

The jump label and the instruction in which the jump label is specified must be located in the 
same block. The name of a jump label can only be assigned once in a block. You can declare 
up to 32 jump labels when you use a CPU S7-1200 and a maximum of 256 jump labels when 
you use a CPU S7-1500.

Only one jump label can be placed in a network. Each jump label can jump to several locations.

Example
The following example shows how the instruction works:

If operand "TagIn_1" has the signal state "1", the "Jump if RLO = 1" instruction is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If the "TagIn_3" input has the signal state "1", the "TagOut_3" 
output is set.

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)
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JMP_LIST: Define jump list

Description
You can use the "Define jump list" instruction to define several conditional jumps and continue 
the program execution in a specific network depending on the value of the K parameter.

You define the jumps with jump labels (LABEL), which you specify at the outputs of the 
instruction box. The number of outputs can be expanded in the instruction box. You can declare 
up to 32 outputs when you use a CPU S7-1200 and a maximum of 99 outputs when you use 
a CPU S7-1500.

The numbering of the outputs begins with the value "0" and continues in ascending order with 
each new output. Only jump labels can be specified at the outputs of the instruction. Instructions 
or operands cannot be specified.

The value of the K parameter specifies the number of the output and thus the jump label where 
the program execution is to be resumed. If the value in the K parameter is greater than the 
number of available outputs, the program execution is resumed in the next network of the block.

The "Define jump list" instruction is only executed if the signal state is "1" at the EN enable 
input.

Parameter
The following table shows the parameters of the "Define jump list" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
K Input UINT I, Q, M, D, L or 

constant
Specifies the 
number of the 
output and thus 
the jump that is to 
be made.

DEST0 - - - First jump label
DEST1 - - - Second jump label
DESTn - - - Optional jump 

labels

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 1
Dest0 LABEL0 Jump to the network that is 

identified with the jump label 
"LABEL0".

Dest1 LABEL1 Jump to the network that is 
identified with the jump label 
"LABEL1".

Dest2 LABEL2 Jump to the network that is 
identified with the jump label 
"LABEL2".

If operand "Tag_Input" has the signal state "1", the "Define jump list" instruction is executed. 
The program execution is resumed according to the value of operand "Tag_Value" in the 
network that is identified with the jump label "LABEL1".

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

SWITCH: Jump distributor

Description       
You can use the "Jump distributor" instruction to define multiple program jumps to be executed 
depending on the result of one or more comparison instructions.

You specify the value to be compared in the K parameter. This value is compared with the 
values that are provided by the various inputs. You can select the comparison method for each 
individual input. The availability of the various comparison instructions depends on the data 
type of the instruction.
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The following table shows the comparison instructions that are available depending on the 
selected data type:

Data type Instruction Syntax
S7-1200 S7-1500
Bit strings Bit strings Equal ==

Not equal <>
Integers, floating-point 
numbers, TIME, 
DATE, TOD

Integers, floating-point 
numbers, TIME, 
LTIME, DATE, TOD, 
LTOD, LDT

Equal ==
Not equal <>
Greater or equal >=
Less or equal <=
Greater than >
Less than <

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. If you select a comparison instruction and the data type of the instruction is not yet defined, 
the "<???>" drop-down list only offers the data types that are permitted for the selected 
comparison instruction.

Execution of the instruction begins with the first comparison and runs until a comparison 
condition is met. If a comparison condition is met, the subsequent comparison conditions are 
not considered. If none of the specified comparison conditions are met, the jump at the ELSE 
output is executed. If no program jump is defined at the ELSE output, execution of the program 
continues in the next network.

The number of outputs can be expanded in the instruction box. The numbering of the outputs 
begins with the value "0" and continues in ascending order with each new output. Specify jump 
labels (LABEL) at the outputs of the instruction. Instructions or operands cannot be specified 
at the outputs of the instruction.

An input is automatically inserted for each additional output. The jump programmed at an 
output is executed if the comparison condition of the corresponding input is fulfilled.

Parameters
The following table shows the parameters of the "Jump distributor" instruction:

Parameter Declarati
on

Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
K Input UINT UINT I, Q, M, D, L or 

constant
Specifies the value to 
be compared.

<Comparison 
values>

Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, DATE, 
TOD

Bit strings, 
integers, 
floating-point 
numbers, 
TIME, 
LTIME, 
DATE, TOD, 
LTOD, LDT

I, Q, M, D, L or 
constant

Input value with 
which the value of the 
K parameter is 
compared.
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Parameter Declarati
on

Data type Memory area Description
S7-1200 S7-1500

DEST0 - - - - First jump label
DEST1 - - - - Second jump label
DEST(n) - - - - Optional jump 

labels(n = 2 to 99)
ELSE - - - - Program jump that is 

executed when none 
of the comparison 
conditions are 
fulfilled.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 23
== Tag_Value_1 20
> Tag_Value_2 21
< Tag_Value_3 19
Dest 0 LABEL0 Jump to jump label "LABEL0", if 

the value of the K parameter 
equals 20.

Dest 1 LABEL1 Jump to jump label "LABEL1" if 
the value of the K parameter is 
greater than 21.
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Parameters Operand/Jump label Value
Dest 2 LABEL2 Jump to jump label "LABEL2", if 

the value of the K parameter is 
less than 19.

ELSE LABEL 3 Jump to jump label "LABEL3", if 
the none of the comparison 
conditions are fulfilled.

If the operand "Tag_Input" changes to signal state "1", the instruction "Jump distributor" is 
executed. The execution of the program is continued in the network that is identified with the 
jump label "LABEL1".

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

--(RET): Return

Description     
You can use the "Return" instruction to stop the execution of a block. The results is three types 
through which the block processing can be completed.

● Without call of the "Return" instruction
The block is exited after execution of the last network. The ENO of the function call is set 
to the signal state "1".

● Call of the "Return" instruction with preceding logic operation (see example)
If the left connector has the signal state "1", the block will be exited. The ENO of the function 
call corresponds to the operand.

● Call of the "Return" instruction without previous logic operation
The block is exited. The ENO of the function call corresponds to the operand.

 

  Note

Only one jumping coil may be used in a network ("Return", "Jump if RLO=1", "Jump if 
RLO=0").

 

If the result of logic operation (RLO) at the input of the "Return" instruction is "1", program 
execution is terminated in the currently called block and resumed after the call function in the 
calling block (for example, in the calling OB). The status (ENO) of the call function is determined 
by the parameter of the instruction. This can assume the following values:

● RLO

● TRUE/FALSE

● <Operand>
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To set the parameter values, double-click the instruction and select the corresponding value 
in the drop-down list.

The following table shows the status of the call function if the "Return" instruction is 
programmed in a network within the called block:

RLO Parameter value ENO of the call function
1 RLO 1

TRUE 1
FALSE 0
<Operand> <Operand>

0 RLO The program execution continues in the 
next network of the called block.TRUE

FALSE
<Operand>

If an OB is completed, another block will be selected and started or executed by the priority 
class system:

● If the program cycle OB was completed, it will be restarted.

● If an OB is completed that has interrupted another block (for example, an alarm OB), then 
the interrupted block (for example, program cycle OB) will be executed.

Parameters
The following table shows the parameters of the "Return" instruction:

Parameter Declaration Data type Memory area Description
Status of the 
calling function 
with RLO = 1:
RLO - -  Is set to the signal 

status of the RLO.
TRUE - -  1
FALSE - -  0
<Operand> Input BOOL I, Q, M, D, L Signal state of the 

specified operand

Example
The following example shows how the instruction works:

If operand "TagIn" has the signal state "1", the "Return" instruction is executed. Program 
execution is terminated in the called block and continues in the calling block. The ENO enable 
output of the call function is reset to signal state "0".
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See also
Overview of the valid data types (Page 1320)

Runtime control

ENDIS_PW: Limit and enable password legitimation

Description
You use the "Limit and enable password legitimation" instruction to specify whether configured 
passwords may be legitimated or not for the CPU. You can prevent legitimated connections, 
even when the correct password is known.

When you call the command and the REQ parameter has the signal state "0", only the currently 
set state is displayed at the output parameters. If changes are made to the input parameters, 
these changes are not transferred to the output parameters.

If the instruction is called and REQ parameter has the signal state "1", the signal state is applied 
from the input parameters (F_PWD, FULL_PWD, R_PWD, HMI_PWD). FALSE means that 
legitimation per password is not permitted; TRUE means the password can be used.

Disable or enabling of the passwords can be allowed or prohibited individually. For example, 
all passwords can be prohibited, except the fail-safe password. You can thus limit access 
options to a small user group. The output parameters (F_PWD_ON, FULL_PWD_ON, 
R_PWD_ON, HMI_PWD_ON) always show the current status of the password use, regardless 
of the REQ parameter.

Non-configured passwords must have the TRUE signal state at the input and return the TRUE 
signal state at the output. The fail-safe password can only be configured for an F-CPU and, 
therefore, must always be interconnected with theTRUE signal state in a standard CPU. If the 
instruction return an error, the call remains without effect, i.e. the previous lock remains in force.

Disabled passwords can be enabled again under the following conditions:

● The CPU is reset to its factory settings.

● The front panel of the S7-1500 CPU supports a dialog that allows you to navigate to the 
appropriate menu in which the passwords can be enabled again.

● When you call the "Limit and enable password legitimation" instruction, the input parameter 
of the desired password has the signal state "1".

● Set the operating mode switch to STOP. The restriction to password legitimation is re-
established as soon as the switch is set back to RUN.

● Inserting an empty memory card (transfer card or program card) into S7-1200 CPU.

● The transition from POWER OFF to POWER ON disables the protection in the S7-1200 
CPU. The "Limit and enable password legitimation" instruction must be called again in the 
program (e.g. in the startup OB).
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 Note

The "Limit and enable password legitimation" instruction blocks access to the HMI system, 
if the HMI password has not been enabled.

 

 Note

Existing legitimized connections retain their access rights and you cannot use the "Limit and 
enable password legitimation" instruction to restrict them.

 

Preventing accidental lockout out with an S7-1500 CPU
The same setting can be made on the front panel of the S7-1500 CPU and the CPU saves the 
most recent setting.

To prevent accidental lockout, the protection can be disabled by setting the mode selector to 
STOP with an S7-1500 CPU. The protection is automatically enabled again by setting mode 
selector to RUN without having to call the "Limit and enable password legitimation" instruction 
again or taking additional actions on the front panel.

Preventing accidental lockout with an S7-1200 CPU
The protection for POWER OFF - POWER ON is disabled because a S7-1200 CPU has no 
operating mode switch. As a result it is possible and advisable to use certain program 
sequences within your program to prevent an accidental lockout.

To do this, program a time control using either a cyclic interrupt OB or a timer in the main OB 
(OB 1). This provides you with the option to call the "Limit and enable password legitimation" 
instruction again without delay in the corresponding OB (e.g. OB 1 or OB 35) after a transition 
from POWER OFF - POWER ON. Call the instruction in the startup OB (OB 100) in order to 
keep as short as possible the time window in which the application is not active and thus ensure 
that no restrictions exist in the password legitimation. This procedure offers you the largest 
possible protection against unauthorized access.

If an unintended lockout occurs you can skip the call in the startup OB (for example, by querying 
an input parameter) and have the set time (for example 10 seconds to 1 minute), to establish 
a connection to the CPU before the lock becomes active again.

If you have set no timer in your program code and are locked out, insert an empty transfer card 
or empty program card into the CPU. The empty transfer card or program card deletes the 
internal load memory of the CPU. You must then load the user program again from STEP 7 
in the CPU.

Procedure for lost passwords with an S7-1200 CPU
If you have lost the password for a password-protected S7-1200 CPU, delete the password-
protected program with an empty transfer card or program card. The empty transfer card or 
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program card deletes the internal load memory of the CPU. You can then load a new user 
program from STEP 7 Basic in the CPU.

 

 WARNING

Inserting empty transfer card

When you insert a transfer card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

After you remove the transfer card the content of the transfer card is in the internal load 
memory. Make sure at this point that the card contains no program.

 

 WARNING

Inserting empty program card

When you insert a program card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

Make sure that the program card is empty. The internal load memory is copied to the empty 
program card. The internal load memory is empty after the removal of the formerly empty 
program card.

 

You must remove the transfer card or program card before you put the CPU into RUN mode.
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Effects of password use on the operating modes
The following table shows what effects the password use by means of the "Limit and enable 
password legitimation" instruction has on the operating modes and the corresponding user 
actions.

Action Password protection by means of the 
instruction

Basic state after
● Operating mode switch to STOP
● Reset memory manually (PG, switch, change of 

MC (Motion Control))
● Reset to factory setting

Not activated
(no restrictions)

Basic state after POWER ON ● S7-1200-CPU:
the lock is disabled and the instruction 
must be called again in the program (in the 
startup OB, for example).

● S7-1500 CPU:
Enabled (if a lock was activated before 
POWER OFF). The option of not allowing 
passwords is retentive.

Operating mode transition RUN/STARTUP/HOLD -> 
STOP (by terminating the instruction, an error or 
communication) or STOP -> STARTUP/RUN/HOLD

Activated
Passwords still cannot be used.

Parameters
The following table shows the parameters of the "Limit and enable password legitimation" 
instruction:

Parameter Declaratio
n

Data type Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L or constant When the REQ parameter has the signal state "0", the 

currently set signal state of the passwords is queried.
F_PWD Input BOOL I, Q, M, D, L or constant Read/write access including fail-safe

● F_PWD = "0": Do not allow password
● F_PWD = "1": Allow password

FULL_PW
D

Input BOOL I, Q, M, D, L or constant Read/write access
● FULL_PWD = "0": Do not allow password
● FULL_PWD = "1": Allow password

R_PWD Input BOOL I, Q, M, D, L or constant Read access
● R_PWD = "0": Do not allow password
● R_PWD = "1": Allow password

HMI_PWD Input BOOL I, Q, M, D, L or constant HMI access
● HMI_PWD = "0": Do not allow password
● HMI_PWD = "1": Allow password
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Parameter Declaratio
n

Data type Memory area Description

F_PWD_O
N

Output BOOL I, Q, M, D, L Read/write access including fail-safe
● F_PWD_ON = "0": Password not allowed
● F_PWD_ON = "1": Password allowed

FULL_PW
D_ON

Output BOOL I, Q, M, D, L Read/write access status
● FULL_PWD_ON = "0": Password not allowed
● FULL_PWD_ON = "1": Password allowed

R_PWD_O
N

Output BOOL I, Q, M, D, L Read-access status
● R_PWD_ON = "0": Password not allowed
● R_PWD_ON = "1": Password allowed

HMI_PWD
_ON

Output BOOL I, Q, M, D, L HMI-access status
● HMI_PWD_ON = "0": Password not allowed
● HMI_PWD_ON = "1": Password allowed

RET_VAL Output WORD I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8090 The "Limit and enable password legitimation" instruction is not supported
80D0 The password for fail-safe is not configured. With standard CPUs, the signal state 

must be TRUE.
80D1 The read/write access is not configured
80D2 The read access is not configured
80D3 The HMI access is not configured
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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RE_TRIGR: Restart cycle monitoring time

Description
You can use the "Restart cycle monitoring time" instruction to restart the cycle time monitoring 
of the CPU. The maximum cycle time then starts over again for the duration you have set in 
the CPU configuration. 

The instruction "Restart cycle monitoring time" can be called regardless of the priority in all 
blocks.

If the instruction is called in a block with a higher priority, such as a hardware interrupt, 
diagnostic error interrupt, or cyclic interrupt, the instruction is not executed and the ENO enable 
output is set to signal state "0".

The instruction "Restart cycle monitoring time" can be called a maximum of 10 times in a 
program cycle.

Parameter
The "Restart cycle monitoring time" instruction has no parameters.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

STP: Exit program

Description       
You use the "Exit program" instruction to set the CPU to STOP mode and therefore to terminate 
the execution of the program. The effects of changing from RUN to STOP depend on the CPU 
configuration.

When the result of logic operation (RLO) at the input of the instruction is "1", the CPU changes 
to STOP mode and program execution is terminated. The signal state at the output of the 
instruction is not evaluated.

When the RLO is "0" at the input of the instruction, then the instruction will not be executed.

Parameters
The "Exit program" instruction has no parameters.

See also
Overview of the valid data types (Page 1320)
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GET_ERROR: Get error locally

Description
The "Get error locally" instruction is used to query the occurrence of errors within a block. This 
is usually to access error. If the system reports an error during the processing of the block, 
detailed information is stored in the operand at the ERROR output for the first error to occur 
during the execution of the block since the last execution of the instruction.

Only operands of the "ErrorStruct" system data type can be specified at the ERROR output. 
The "ErrorStruct" system data type specifies the exact structure in which the information about 
the error is stored. Using additional instructions, you can evaluate this structure and program 
an appropriate response. If several errors occur in the block, the error information about the 
next error to occur in the instruction is output only after the first error that occurred has been 
remedied.

 

 Note

The ERROR output is only changed if error information is present. To set the output back to 
"0" after handling an error, you have the following options:
● Declare the tag in the "Temp" section of the block interface.
● Reset the tag to "0" before calling the instruction.
● Query the enable output ENO.

 

The enable output ENO of the instruction "Get error locally" instruction is set only if the enable 
input EN returns signal state "1" and error information is present. If one of these conditions is 
not fulfilled, the remaining program execution is not affected by the "Get error locally" 
instruction.

You can find an example of how you can implement the instruction in combination with other 
troubleshooting options under "See also".

 

 Note

The "Get error locally" instruction enables local error handling within a block. If "Get error 
locally" is inserted in the program code of a block, any predefined system reactions are 
ignored if errors occur.

 

Parameters
The following table lists the parameters of the "Get error locally" instruction:

Parameter Declaration Data type Memory area Description
ERROR Output ErrorStruct D, L Error information
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Data type "ErrorStruct"
The following table lists the structure of the "ErrorStruct" data type:

Structure component Data type Description
ERROR_ID WORD Error ID
FLAGS BYTE Shows if an error occurred during 

a block call.
16#01: Error during a block call 
16#00: No error during a block call 

REACTION BYTE Default reaction: 
0: Ignore (write error)
1: Continue with substitute value 
"0" (read error)
2: Skip instruction (system error)

CODE_ADDRESS CREF Information about the address and 
type of block

 BLOCK_TYPE BYTE Type of block where the error 
occurred:
1: OB
2: FC
3: FB

 CB_NUMBER UINT Number of the code block
 OFFSET UDINT Reference to the internal memory
MODE BYTE Information about the address of 

an operand
OPERAND_NUMBER UINT Operand number of the machine 

command
POINTER_NUMBER_LOCATION UINT (A) Internal pointer
SLOT_NUMBER_SCOPE UINT (B) Storage area in internal 

memory
DATA_ADDRESS NREF Information about the address of 

an operand
 AREA BYTE (C) Memory area:

L: 16#40 – 4E, 86, 87, 8E, 8F, C0 
– CE
I: 16#81
Q: 16#82
M: 16#83
DB: 16#84, 85, 8A, 8B
Range violations for a directly 
editable tag of data type DINT: 
16#04

 DB_NUMBER UINT (D) Number of the data block
 OFFSET UDINT (E) Relative address of the 

operand
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Structure component "ERROR_ID"
The following table lists the values that can be output at the structure component "ERROR_ID":

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2577 9591 The block property "Parameter passing via registers" is not selected.
2576 9590 Error in the local data distribution
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

An error occurred accessing the "#Field[#index]" tag. The enable output ENO of the "Multiply" 
instruction and the "#TagOut_Enabled" operand have signal state "1" despite the read/access 
error and the multiplication is performed with the value "0.0". If this error scenario occurs, it is 
recommended to program the "Get error locally" instruction after the "Multiply" instruction to 
get the error. The error information supplied by the "Get error locally" instruction is evaluated 
with the comparison instruction "Equal". If the "#Error.REACTION" structure component has 
the value "1", this involves a read/access error and the "#TagOut_Enabled" output is reset.

See also
Overview of the valid data types (Page 1320)

Querying and fixing errors in the program code (Page 286)

GET_ERR_ID: Get error ID locally

Description
The "Get error ID locally" instruction is used to query the occurrence of errors within a block. 
This is usually to access error. If the system reports during the block processing errors within 
the block execution since the last execution of the instruction, the error ID of the first error that 
occurred in the tag is stored at the ID output.
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Only operands of the WORD data type can be specified at the ID output. If several errors occur 
in the block, the error ID of the next error to occur in the instruction is output only after the first 
error that occurred has been remedied.

 

 Note

The ID output is only changed if error information is present. To set the output back to "0" 
after handling an error, you have the following options:
● Declare the tag in the "Temp" section of the block interface.
● Reset the tag to "0" before calling the instruction.
● Query the enable output ENO.

 

The enable output ENO of the instruction "Get error ID locally" instruction is set only if the 
enable input EN returns signal state "1" and error information is present. If one of these 
conditions is not fulfilled, the remaining program execution is not affected by the "Get error ID 
locally" instruction.

You can find an example of how you can implement the instruction in combination with other 
troubleshooting options under "See also".

 

 Note

The "Get error ID locally" instruction enables local error handling within a block. If the "Get 
error ID locally" instruction is inserted in the program code of a block, any predefined system 
reactions are ignored if errors occur.

 

Parameters
The following table lists the parameters of the "Get error ID locally" instruction:

Parameter Declaration Data type Memory area Description
ID Output WORD I, Q, M, D, L Error ID

ID parameter
The following table lists the values that can be output at the ID parameter:

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
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ID*
(hexadecimal)

ID*
(decimal)

Description

2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 The block property "Parameter passing via registers" is not selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:
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An error occurred accessing the "#Field[#index]" tag. The enable output ENO of the "Multiply" 
instruction and the "#TagOut_Enabled" operand have signal state "1" despite the read/access 
error and the multiplication is performed with the value "0.0". If this error scenario occurs, it is 
recommended to program the "Get error ID locally" instruction after the "Multiply" instruction 
to get the error. The error information supplied by the "Get error ID locally" instruction is 
evaluated with the comparison instruction "Equal". If the operand "#TagID" returns the ID 2522, 
this involves a read/access error and the value "100.0" is written to the "#TagOut" output.

See also
Overview of the valid data types (Page 1320)

Querying and fixing errors in the program code (Page 286)

INIT_RD: Initialize all retain data

Description
You can use the "Initialize all retain data" instruction to reset the retain data of all data blocks, 
bit memories and SIMATIC timers and counters at the same time. The instruction can only be 
executed within a startup OB because the execution would exceed the program cycle duration.

Parameter
The following table shows the parameters of the "Initialize all retain data" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L, T, C 

or constant
If the input "REQ" 
has the signal 
state "1", all retain 
data are reset.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during execution 
of the instruction, 
an error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".
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Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B5 The instruction cannot be executed because it was not programmed within a startup OB.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "Tag_REQ" have signal state "1", the instruction is executed. 
The retain data of all data blocks, bit memories and SIMATIC timers and counters are reset If 
the instruction is executed without errors, the ENO enable output has the signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2080)

WAIT: Configure time delay

Description     
The "Configure time delay" instruction is used to halt the execution of the program for a set 
period of time. You indicate the period of time in microseconds on the WT parameter of the 
instruction.

You can configure time delays of up to 32767 microseconds (μs). The smallest possible delay 
time depends on the respective CPU and corresponds to the execution time of the "Configure 
time delay" instruction.

The execution of the instruction can be interrupted by higher priority events.

The "Configure time delay" instruction supplies no error information.
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Parameters
The following table shows the parameters of the "Configure time delay" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
WT Input INT I, Q, M, D, L, P or 

constant
Time delay in 
microseconds (μs)

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

RUNTIME: Measure program runtime

Description
The "Measure program runtime" instruction is used to measure the runtime of the entire 
program, individual blocks or command sequences.

If you want to measure the runtime of your entire program, call the instruction "Measure 
program runtime" in OB1. Measurement of the runtime is started with the first call and the 
output RET_VAL returns the runtime of the program after the second call. The measured 
runtime includes all CPU processes that can occur during the program execution, for example, 
interruptions caused by higher-level events or communication. The instruction "Measure 
program runtime" reads an internal counter of the CPU and write the value to the IN-OUT 
parameter MEM. The instruction calculates the current program runtime according to the 
internal counter frequency and writes it to output RET_VAL.

If you want to measure the runtime of individual blocks or individual command sequences, you 
need three separate networks. Call the instruction "Measure program runtime" in an individual 
network within your program. You set the starting point of the runtime measurement with this 
first call of the instruction. Then you call the required program block or the command sequence 
in the next network. In another network, call the "Measure program runtime" instruction a 
second time and assign the same memory to the IN-OUT parameter MEM as you did during 
the first call of the instruction. The "Measure program runtime" instruction in the third network 
reads an internal CPU counter and calculates the current runtime of the program block or the 
command sequence according to the internal counter frequency and writes it to the output 
RET_VAL.
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The Measure program runtime" instruction uses an internal high-frequency counter to calculate 
the time. If the counter overruns, the instruction returns values <= 0.0. Ignore these runtime 
values.

 

 Note

The runtime of a command sequence cannot be determined exactly, because the sequence 
of instructions within a command sequence is changed during optimized compilation of the 
program.

 

Parameter
The following table lists the parameters of the "Measure program runtime" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MEM InOut LREAL M, D, L Saves the starting 

point of the 
runtime 
measurement.

RET_VAL Output LREAL I, Q, M, D, L Returns the 
measured runtime 
in seconds

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works based on the runtime calculation of a 
program block:

Network 1:

Network 2:

Network 3:

Programming the PLC
9.7 References

WinCC Professional V13.0
2086 System Manual, 02/2014



When the "TagIn1" operand in network 1 has the signal state "1", the instruction is executed. 
The starting point for the runtime measurement is set with the first call of the instruction and 
buffered as reference for the second call of the instruction in the "TagMemory" operand.

The "Best_before_date" program block FB1 is called in network 2.

When the FB1 program block has been executed and the "TagIn1" operand has the signal 
state "1", the instruction in network 3 is executed. The second call of the instruction calculates 
the runtime of the program block and writes the result to the output RET_VAL.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Word logic operations

AND: AND logic operation

Description     
You can use the "AND logic operation" instruction to combine the value at the IN1 input and 
the value at the IN2 input bit-by-bit by AND logic and query the result at the OUT output.

When the instruction is executed, bit 0 of the value at the IN1 input and bit 0 of the value at 
the IN2 input are logically ANDed. The result is stored in bit 0 of output OUT. The same logic 
operation is executed for all other bits of the specified values.

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are combined with AND logic (ANDed). The result is stored in the OUT output.

The result bit has signal state "1" only when both of the bits in the logic operation also have 
signal state "1". If one of the two bits of the logic operation has signal state "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the "AND logic operation" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN1 Input Bit strings I, Q, M, D, L, P or 

constant
First value for logic 
operation

IN2 Input Bit strings I, Q, M, D, L, P or 
constant

Second value for 
logic operation

INn Input Bit strings I, Q, M, D, L, P or 
constant

Other inputs 
whose values are 
logically 
combined.

OUT Output Bit strings I, Q, M, D, L, P Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0000 0000 0000 0101

If operand "TagIn" has the signal state "1", the "AND logic operation" instruction is executed. 
The value of operand "Tag_Value1" and the value of operand "Tag_Value2" are ANDed. The 
result is mapped bit-for-bit and output in operand "Tag_Result". The ENO enable output and 
the "TagOut" output are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)
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OR: OR logic operation

Description     
You can use the "OR logic operation" instruction to combine the value at the IN1 input and the 
value at the IN2 input bit-by-bit by OR logic and query the result at the OUT output.

When the instruction is executed, bit 0 of the value at the IN1 input and bit 0 of the value at 
the IN2 input are combined by OR logic operation. The result is stored in bit 0 of output OUT. 
The same logic operation is executed for all bits of the specified tags.

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are combined with OR logic (ORed). The result is stored in the OUT output.

The result bit has signal state "1" when at least one of the two bits in the logic operation has 
the signal state "1". If both of the bits of the logic operation have signal state "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the "OR logic operation" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P or 

constant
First value for logic 
operation

IN2 Input Bit strings I, Q, M, D, L, P or 
constant

Second value for 
logic operation

INn Input Bit strings I, Q, M, D, L, P or 
constant

Other inputs 
whose values are 
logically 
combined.

OUT Output Bit strings I, Q, M, D, L, P Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1111

If operand "TagIn" has the signal state "1", the "OR logic operation" instruction is executed. 
The value of operand "Tag_Value1" and the value of operand "Tag_Value2" are ORed. The 
result is mapped bit-for-bit and output in operand "Tag_Result". The ENO enable output and 
the "TagOut" output are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)

Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

XOR: EXCLUSIVE OR logic operation

Description     
You can use the "EXCLUSIVE OR logic operation" instruction to combine the value at the IN1 
input and the value at the IN2 input bit-by-bit by EXCLUSIVE OR logic and query the result at 
the OUT output.

When the instruction is executed, bit 0 of the value at the IN1 input and bit 0 of the value at 
the IN2 input are combined by EXCLUSIVE OR logic operation. The result is stored in bit 0 of 
output OUT. The same logic operation is executed for all other bits of the specified value.

The number of inputs can be expanded in the instruction box. The added inputs are numbered 
in ascending order in the box. When the instruction is executed, the values of all available input 
parameters are combined with EXCLUSIVE OR logic. The result is stored in the OUT output.

The result bit has signal state "1" when one of the two bits in the logic operation has the signal 
state "1". If both of the bits of the logic operation have signal state "1" or "0", the corresponding 
result bit is reset.
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Parameters
The following table shows the parameters of the "EXCLUSIVE OR logic operation" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P or 

constant
First value for logic 
operation

IN2 Input Bit strings I, Q, M, D, L, P or 
constant

Second value for 
logic operation

INn Input Bit strings I, Q, M, D, L, P or 
constant

Other inputs 
whose values are 
logically 
combined.

OUT Output Bit strings I, Q, M, D, L, P Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1010

If operand "TagIn" has the signal state "1", the "EXCLUSIVE OR logic operation" instruction 
is executed. The value of operand "Tag_Value1" and the value of operand "Tag_Value2" are 
combined by EXCLUSIVE OR logic. The result is mapped bit-for-bit and output in operand 
"Tag_Result". The ENO enable output and the "TagOut" output are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Inserting additional inputs and outputs in LAD elements (Page 1544)
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Removing inputs and outputs (Page 1545)

Basics of the EN/ENO mechanism (Page 1415)

INV: Create ones complement

Description       
You can use the "Create ones complement" instruction to invert the signal state of the bits at 
the IN input. When the instruction is processed, the value at the IN input and a hexadecimal 
template (W#16#FFFF for 16-bit numbers or DW#16#FFFF FFFF for 32-bit numbers) are 
combined by EXCLUSIVE OR logic. This inverts the signal state of the individual bits that are 
then stored at output OUT.

Parameters
The following table shows the parameters of the "Create ones complement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
I, Q, M, D, L, P or 
constant

Input value

OUT Output Bit strings, 
integers

I, Q, M, D, L, P Ones complement 
of the value at 
input IN

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value W#16#000F W#16#7E
OUT TagOut_Value W#16#FFF0 W#16#81
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If operand "TagIn" has the signal state "1", the "Create ones complement" instruction is 
executed. The instruction inverts the signal state of the individual bits at input TagIn_Value" 
and writes the result to output "TagOut_Value". The ENO enable output and the "TagOut" 
output are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DECO: Decode

Description     
You can use the "Decode" instruction to set a bit in the output value specified by the input 
value.

The "Decode" instruction reads the value at the IN input and sets the bit in the output value 
whose bit position corresponds to the read value. The other bits in the output value are filled 
with zeroes. When the value at the IN input is greater than 31, a modulo 32 instruction is 
executed.

Parameters
The following table shows the parameters of the "Decode" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input UINT I, Q, M, D, L, P or 

constant
Position of the bit 
in the output value 
which is set.

OUT Output Bit strings I, Q, M, D, L, P Output value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If operand "TagIn" has the signal state "1", the "Decode" instruction is executed. The instruction 
reads bit number "3" from the value of the operand "TagIn_Value" at the input and sets the 
third bit to the value of the operand "TagOut_Value" at the output.

If the instruction is executed without errors, the ENO enable output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ENCO: Encode

Description     
You can use the "Encode" instruction to read the bit number of the least significant bit in the 
input value and to send it to the OUT output.

The "Encode" instruction selects the least significant bit of the value at the IN input and writes 
its bit number to the tag in the OUT output.

Parameters
The following table shows the parameters of the "Encode" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output

Programming the PLC
9.7 References

WinCC Professional V13.0
2094 System Manual, 02/2014



Parameter Declaration Data type Memory area Description
IN Input Bit strings I, Q, M, D, L, P or 

constant
Input value

OUT Output INT I, Q, M, D, L, P Output value

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If operand "TagIn" has the signal state "1", the "Encode" instruction is executed. The instruction 
selects the least significant bit at the "TagIn_Value" input and writes bit position "3" to the tag 
in the "TagOut_Value" output.

If the instruction is executed without errors, the ENO enable output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SEL: Select

Description
Depending on a switch (G input), the "Select" instruction selects one of the inputs, IN0 or IN1 
and copies its content to the OUT output. When the G input has the signal state "0", the value 
at the IN0 input is moved. When the G input has the signal state "1", the value at the IN1 input 
is moved to the OUT output.

All tags at all parameters must have the same data type.
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Parameters
The following table shows the parameters of the "Select" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L Enable input

ENO Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L Enable output

G Input BOOL BOOL I, Q, M, D, 
L or 
constant

I, Q, M, D, L, T, 
C or constant

Switch

IN0 Input Bit strings, 
integers, 
floating-point 
numbers, TIME, 
TOD, CHAR, 
DATE

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, LDT, 
CHAR, DATE

I, Q, M, D, 
L, P or 
constant

I, Q, M, D, L, P 
or constant

First input value

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, TIME, 
TOD, CHAR, 
DATE

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, LDT, 
CHAR, DATE

I, Q, M, D, 
L, P or 
constant

I, Q, M, D, L, P 
or constant

Second input value

OUT Output Bit strings, 
integers, 
floating-point 
numbers, TIME, 
TOD, CHAR, 
DATE

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, LDT, 
CHAR, DATE

I, Q, M, D, 
L, P

I, Q, M, D, L, P Result

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
G TagIn_G 0 1
IN0 TagIn_Value0 W#16#0000 W#16#4C
IN1 TagIn_Value1 W#16#FFFF W#16#5E
OUT TagOut_Value W#16#0000 W#16#5E

If operand "TagIn" has the signal state "1", the "Select" instruction is executed. Based on the 
signal state at the "TagIn_G" input, the value at the "TagIn_Value0" or "TagIn_Value1" input 
is selected and copied to the "TagOut_Value" output. If the instruction is executed without 
errors, enable output ENO has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MUX: Multiplex

Description
You can use the "Multiplex" instruction to copy the content of a selected input to the OUT 
output. The number of selectable inputs of the instruction box can be expanded. You can 
declare a maximum of 32 inputs.

The inputs are automatically numbered in the box. Numbering starts at IN0 and continues 
consecutively with each new input. You use the K parameter to define the input whose content 
is to be copied to the OUT output. If the value of the K parameter is greater than the number 
of available inputs, the content of the ELSE parameter is copied to the OUT output and the 
ENO enable output is assigned the signal state "0".

The "Multiplex" instruction can only be executed, when the tags in all inputs and in the OUT 
output have the same data type. The K parameter is an exception, since only integers can be 
specified for it.

The ENO enable output is reset if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value of the K parameter is greater than the number of available inputs.

● Errors occurred during execution of the instruction.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2097



Parameters
The following table shows the parameters of the "Multiplex" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
K Input Integers Integers I, Q, M, D, L, P 

or constant
Specifies the 
input whose 
content is to be 
copied.
● If K = 0 => 

Parameter 
IN0

● If K = 1 => 
Parameter 
IN1, etc.

IN0 Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

First input 
value

IN1 Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Second input 
value

INn Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Optional input 
values
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

ELSE Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Specifies the 
value to be 
copied when K 
> n.

OUT Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Output to 
which the 
value is to be 
copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
K Tag_Number 1
IN0 Tag_Value_0 DW#16#00000000
IN1 Tag_Value_1 DW#16#003E4A7D
ELSE Tag_Value_2 DW#16#FFFF0000
OUT Tag_Result DW#16#003E4A7D

If operand "Tag_Input" has the signal state "1", the "Multiplex" instruction is executed. 
Depending on the value of the operand "Tag_Number", the value at input "Tag_Value_1" is 
copied and assigned to the operand at output "Tag_Result". If the instruction is executed 
without errors, the "ENO" and "Tag_Output" enable outputs are set.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DEMUX: Demultiplex

Description
You can use the "Demultiplex" instruction to copy the content of the IN input to the selected 
output. The number of selectable outputs can be expanded in the instruction box. The outputs 
are automatically numbered in the box. Numbering starts at OUT0 and continues consecutively 
with each new output. You use the K parameter to define the output to which the content of 
the IN input is to be copied. The other outputs are not changed. If the value of the parameter 
K is greater than the number of available outputs, then the content of input IN in the parameter 
ELSE and the enable output ENO will be assigned to the signal state "0".

The "Demultiplex" instruction can only be executed if the tags in the IN input and in all outputs 
have the same data type. The K parameter is an exception, since only integers can be specified 
for it.

The ENO enable output is reset if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The value of the K parameter is greater than the number of available outputs.

● Errors occurred during execution of the instruction.

Parameters
The following table shows the parameters of the "Demultiplex" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
K Input Integers Integers I, Q, M, D, L, P 

or constant
Specifies the 
output to which 
the input value 
(IN) is copied.
● If K = 0 => 

Parameter 
OUT0

● If K = 1 => 
Parameter 
OUT1, etc.
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P 
or constant

Input value

OUT0 Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P First output

OUT1 Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Second output

OUTn Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Optional 
outputs

ELSE Output Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, TIME, 
TOD, DATE

Binary 
numbers, 
integers, 
floating-point 
numbers, 
strings, timers, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, P Output to 
which the input 
value (IN) at K 
> n is copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on available data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following tables show how the instruction works using specific operand values:

Table 9-24 Input values of the "Demultiplex" instruction before network execution

Parameter Operand Values
K Tag_Number 1 4
IN Tag_Value DW#16#FFFFFFFF DW#16#003E4A7D

Table 9-25 Output values of the "Demultiplex" instruction after network execution

Parameter Operand Values
OUT0 Tag_Output_0 Unchanged Unchanged
OUT1 Tag_Output_1 DW#16#FFFFFFFF Unchanged
ELSE Tag_Output_2 Unchanged DW#16#003E4A7D

If the "Tag_Input" input has the signal state"1", the "Demultiplex" instruction is executed. 
Depending on the value of operand "Tag_Number", the value at the IN input is copied to the 
corresponding output.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Shift and rotate

SHR: Shift right

Description
You can use the "Shift right" instruction to rotate the content of the operand at the input INbit-
by-bit to the right and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be shifted.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.
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When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is shifted by the available number of bit positions to the right.

In the case of unsigned values, the freed bit positions in the left area of the operand are filled 
with zeroes when shifting occurs. If the specified value has a sign, the free bit positions are 
filled with the signal state of the sign bit.

The following figure show how the content of an operand of integer data type is shifted four bit 
positions to the right:

Parameters
The following table shows the parameters of the "Shift right" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, 
ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is shifted

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 3
OUT TagOut_Value 0000 0111 1111 0101

If operand "TagIn" has the signal state "1", the "Shift right" instruction is executed. The content 
of operand "TagIn_Value" is shifted three bit positions to the right. The result is sent to the 
"TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SHL: Shift left

Description
You can use the "Shift left" instruction to rotate the content of the operand at the IN input bit-
by-bit to the left and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be shifted.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.

When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is shifted by the available number of bit positions to the left.

The bit positions in the right part of the operand freed by shifting are filled with zeros.

The following figure shows how the content of an operand of the WORD data type is shifted 
by six bit positions to the left:
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Parameters
The following table shows the parameters of the "Shift left" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, 
ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is shifted

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 4
OUT TagOut_Value 1111 1010 1111 0000

If operand "TagIn" has the signal state "1", the "Shift left" instruction is executed. The content 
of operand "TagIn_Value" is shifted four bit positions to the left. The result is sent to the 
"TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ROR: Rotate right

Description
You can use the "Rotate right" instruction to rotate the content of the operand at the IN input 
bit-by-bit to the right and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be rotated. The bit positions freed 
by rotating are filled with the bit positions that are pushed out.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.

When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of DWORD data type is rotated 
three positions to the right:
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Parameters
The following table shows the parameters of the "Rotate right" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
rotated

N Input USINT, 
UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is rotated

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0000 1111 1001 0101
N Tag_Number 5
OUT TagOut_Value 1010 1000 0111 1100

If operand "TagIn" has the signal state "1", the "Rotate right" instruction is executed. The 
content of operand "TagIn_Value" is rotated five bit positions to the right. The result is sent to 
the "TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ROL: Rotate left

Description
You can use the "Rotate left" instruction to rotate the content of the operand at the IN input bit-
by-bit to the left and query the result at the OUT output. You use the N parameter to specify 
the number of bit positions by which the specified value is to be rotated. The bit positions freed 
by rotating are filled with the bit positions that are pushed out.

When the value at the N parameter is "0", the value at the IN input is copied to the operand at 
the OUT output.

When the value at the N parameter is greater than the number of available bit positions, the 
operand value at the IN input is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of DWORD data type is rotated 
three positions to the left:
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Parameters
The following table shows the parameters of the "Rotate left" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
Bit strings, 
integers

I, Q, M, D, L or 
constant

Value to be 
rotated

N Input USINT, 
UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

I, Q, M, D, L or 
constant

Number of bit 
positions by 
which the value 
is rotated

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1010 1000 1111 0110
N Tag_Number 5
OUT TagOut_Value 0001 1110 1101 0101

If the "TagIn" input has the signal state "1", the "Rotate left" instruction is executed. The content 
of operand "TagIn_Value" is rotated five bit positions to the left. The result is sent to the 
"TagOut_Value" output. If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Additional instructions

DRUM: Implement sequencer

Description
You can use the "Implement sequencer" instruction to assign the programmed values of the 
OUT_VAL parameter of the corresponding step to the programmed output bits (OUT1 to 
OUT16) and the output word (OUT_WORD). The specific step must thereby satisfy the 
conditions of the programmed enable mask on the S_MASK parameter while the instruction 
remains at this step. The instruction advances to the next step if the event for the step is true 
and the programmed time for the current step elapses or if the value at the JOG parameter 
changes from "0" to "1". The instruction is reset if the signal state on the RESET parameter 
changes to "1". The current step is hereby equated to the preset step (DSP).

The amount of time spent on a step is determined by the product of the preset timebase (DTBP) 
and the preset counter value (S_PRESET) for each step. At the start of a new step, this 
calculated value is loaded into the DCC parameter, which contains the time remaining for the 
current step. If, for example the value of the DTBP parameter is "2" and the preset value for 
the first step is "100" (100 ms), the DCC parameter has the value "200" (200 ms).
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A step can be programmed with a timer value, an event or both. Steps that have an event bit 
and the timer value "0" advance to the next step as soon as the signal state of the event bit is 
"1". Steps that are programmed only with a timer value start the time immediately. Steps that 
are programmed with an event bit and a timer value greater than "0" start the time when the 
signal state of the event bit is "1". The event bits are initialized with a signal state of "1".

When the sequencer is on the last programmed step (LST_STEP) and the time for this step 
has expired, the signal state on the Q parameter is set to "1"; otherwise it is set to "0". When 
the parameter Q is set, the instruction remains on the step until it is reset.

In the configurable mask (S_MASK) you can selected the separate bits in the output word 
(OUT_WORD) and set or reset the output bits (OUT1 to OUT16) by means of the output values 
(OUT_VAL). If a bit of the configurable mask is in the signal state "1", the value OUT_VAL sets 
or resets the corresponding bit. If the signal state of a bit of the configurable mask is "0", the 
corresponding bit is left unchanged. All the bits of the configurable mask for all 16 steps are 
initialized with a signal state of "1".

The output bit at the OUT1 parameter corresponds to the least significant bit of the output word 
(OUT_WORD). The output bit at the OUT16 parameter corresponds to the most significant bit 
of the output word (OUT_WORD).

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Implement sequencer" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
RESET Input BOOL I, Q, M, D, L or 

constant
The signal state 
"1" indicates the 
reset condition.

JOG Input BOOL I, Q, M, D, L or 
constant

When the signal 
state changes 
from "0" to "1", the 
instruction 
advances to the 
next step.

DRUM_EN Input BOOL I, Q, M, D, L or 
constant

The signal state 
"1" causes the 
sequencer to 
advance based on 
the event and time 
criteria.

LST_STEP Input BYTE I, Q, M, D, L or 
constant

Number of the last 
programmed step.
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Parameter Declaration Data type Memory area Description
EVENT(i),
1 ≤ i ≤ 16

Input BOOL I, Q, M, D, L or 
constant

Event bit (i);
Initial signal state 
is "1".

OUT(j),
1 ≤ j ≤ 16

Output BOOL I, Q, M, D, L Output bit (j)

Q Output BOOL I, Q, M, D, L The signal state 
"1" indicates that 
the time for the 
last step has 
elapsed.

OUT_WORD Output WORD I, Q, M, D, L, P Word address to 
which the 
sequencer writes 
the output values.

ERR_CODE Output WORD I, Q, M, D, L, P Error information
JOG_HIS Static BOOL I, Q, M, D, L JOG parameter 

history bit
EOD Static BOOL I, Q, M, D, L or 

constant
The signal state 
"1" indicates that 
the time for the 
last step has 
elapsed.

DSP Static BYTE I, Q, M, D, L, P or 
constant

Preset step of the 
sequencer

DSC Static BYTE I, Q, M, D, L, P or 
constant

Current step of the 
sequencer

DCC Static DWORD I, Q, M, D, L, P or 
constant

Current numerical 
value of the 
sequencer

DTBP Static WORD I, Q, M, D, L, P or 
constant

Preset timebase 
of the sequencer

PREV_TIME Static DWORD I, Q, M, D, L or 
constant

Previous system 
time

S_PRESET Static ARRAY of WORD I, Q, M, D, L or 
constant

Preset count for 
each step [1 to 16] 
where 1 clock 
pulse = 1 ms.

OUT_VAL Static ARRAY of BOOL I, Q, M, D, L or 
constant

Output values for 
each step [1 to 16, 
0 to 15].

S_MASK Static ARRAY of BOOL I, Q, M, D, L or 
constant

Configurable 
mask for each 
step [1 to 16, 
0 to 15]. Initial 
signal states are 
"1".

For additional information on valid data types, refer to "See also".
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Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

ERR_CODE* Explanation
W#16#0000 No error
W#16#000B The value at the LST_STEP parameter is less than 1 or 

greater than 16.
W#16#000C The value at the DSC parameter is less than 1 or greater than 

the value of the LST_STEP parameter.
W#16#000D The value at the DSP parameter is less than 1 or greater than 

the value of the LST_STEP parameter.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DCAT: Discrete control-timer alarm

Description
The instruction "Discrete control-timer alarm" is used to accumulate the time from the point at 
which the CMD parameter issued the command to open or close. The time is accumulated 
until the preset time (PT) is exceeded or the information is received that the device was opened 
or closed (O_FB or C_FB) within the specified time. If the preset time is exceeded before the 
information on the opening or closing of the device is received, the corresponding alarm is 
activated. If the signal state of the command input changes state before the preset time, the 
time is restarted.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".

The "Discrete control-timer alarm" instruction has the following reactions to the input conditions:

● When the signal state of the CMD parameter changes from "0" to "1", the signal states of 
the parameters Q, CMD_HIS, ET (only if ET < PT), OA and CA are influenced as follows:

– The parameters Q and CMD_HIS are set to "1".

– The parameters ET, OA and CA are reset to "0".

● When the signal state of the parameter CMD changes from "1" to "0", the parameters Q, 
ET (only if ET < PT),  OA, CA and CMD_HIS are reset to "0".
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● When the signal state of the parameters CMD and CMD_HIS is "1" and the parameter O_FB 
is set to "0", the time difference (ms) since the last execution of the instruction is added to 
the value at the parameter ET. If the value of the parameter ET exceeds the value of the 
parameter PT, the signal state on the parameter OA is set to "1". If the value of the ET 
parameter does not exceed the value of the parameter PT, the signal state on the parameter 
OA is reset to "0". The value at the parameter CMD_HIS is reset to the value of the 
parameter CMD.

● If the signal state of the CMD, CMD_HIS and O_FB parameters are set to "1" and the 
parameter C_FB has the value "0", the signal state of the parameter OA is set to "0". The 
value of the parameter ET is set to the value of the parameter PT. If the signal state of the 
O_FB parameter changes to "0", the alarm is set the next time the instruction is executed. 
The value of the parameter CMD_HIS is set to the value of the parameter CMD.

● If the parameters CMD, CMD_HIS and C_FB have the value "0", the time difference (ms) 
since the last execution of the instruction is added to the value of the parameter ET. If the 
value of the ET parameter exceeds the value of the parameter PT, the signal state of the 
parameter CA is reset to "1". If the value at the parameter PT is not exceeded, the parameter 
CA has the signal state "0". The value of the parameter CMD_HIS is set to the value of the 
parameter CMD.

● If the parameters CMD, CMD_HIS and O_FB have the signal state "0" and the parameter 
C_FB is set to "1", the parameter CA is set to "0". The value of the parameter ET is set to 
the value of the parameter PT. If the signal state of the C_FB parameter changes to "0", 
the alarm is set the next time the instruction is executed. The value of the parameter 
CMD_HIS is set to the value of the parameter CMD.

● If the parameters O_FB and C_FB simultaneously have the signal state "1", the signal states 
of both alarm outputs are set to "1".

The "Discrete control-timer alarm" instruction returns no error information.

Parameters
The following table shows the parameters of the "Discrete control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CMD Input BOOL I, Q, M, D, L or constant The signal state "0" 

indicates a "close" 
command.
The signal state "1" 
indicates the "open" 
command.

O_FB Input BOOL I, Q, M, D, L or constant Feedback input when 
opening

C_FB Input BOOL I, Q, M, D, L or constant Feedback input when 
closing

Q Output BOOL I, Q, M, D, L Shows the status of the 
parameter CMD

OA Output BOOL I, Q, M, D, L Alarm output when opening
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Parameter Declaration Data type Memory area Description
CA Output BOOL I, Q, M, D, L Alarm output when closing
ET Static DINT D, L or constant Currently elapsed time, 

where one clock pulse = 1 
ms

PT Static DINT D, L or constant Preset timer value, where 
one clock pulse = 1 ms

PREV_TIME Static DWORD D, L or constant Previous system time
CMD_HIS Static BOOL D, L or constant  CMD history bit

For additional information on valid data types, refer to "See also".

Example
In the following example the parameter CMD changes from "0" to "1". After the execution of 
the instruction the parameter Q is set to "1" and the two alarm outputs OA and CA have the 
signal state "0". The parameter CMD_HIS of the instance data block is set to the signal state 
"1" and the parameter ET is reset to "0".

 

 Note

You can initialize static parameters in the data block.
 

The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:

Parameter Operand Value
CMD Tag_Input_CMD TRUE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
Q Tag_Output_Q FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
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The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#12
PT DBD8 L#222
CMD_HIS DBX16.0 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
Q Tag_Output_Q TRUE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
CMD_HIS DBX16.0 TRUE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MCAT: Motor control-timer alarm

Description
The instruction "Motor control-timer alarm" is used to accumulate the time from the point in 
time as of which one of the command inputs (open or close) is activated. The time is 
accumulated until the preset time is exceeded or the relevant feedback input indicates that the 
device has executed the requested operation within the specified time. If the preset time is 
exceeded before the feedback is received, the corresponding alarm is triggered.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
2116 System Manual, 02/2014



Execution of the "Motor control-timer alarm" instruction
The following table shows the reactions of the "Motor control-timer alarm" instruction to the 
various input conditions:

Input parameters Output parameters
ET O_H

IS
C_H
IS

O_C
MD

C_C
MD

S_C
MD

O_F
B

C_F
B

OO CO OA CA ET O_H
IS

C_H
IS

Q Status

X 1 1 X X X X X 0 0 1 1 PT 0 0 0 Alarm
X X X X X X 1 1 0 0 1 1 PT 0 0 0 Alarm
X X X X X 1 X X 0 0 0 0 X 0 0 1 Stop
X X X 1 1 X X X 0 0 0 0 X 0 0 1 Stop
X 0 X 1 0 0 X X 1 0 0 0 0 1 0 1 Start 

opening
<PT 1 0 X 0 0 0 X 1 0 0 0 INC 1 0 1 Open
X 1 0 X 0 0 1 0 0 0 0 0 PT 1 0 1 Opened
>=P
T

1 0 X 0 0 0 X 0 0 1 0 PT 1 0 0 Opening 
alarm

X X 0 0 1 0 X X 0 1 0 0 0 0 1 1 Start closing
<PT 0 1 0 X 0 X 0 0 1 0 0 INC 0 1 1 Close
X 0 1 0 X 0 0 1 0 0 0 0 PT 0 1 1 Closed
>=P
T

0 1 0 X 0 X 0 0 0 0 1 PT 0 1 0 Closing 
alarm

X 0 0 0 0 0 X X 0 0 0 0 X 0 0 1 Stopped
Legend:
INC Add the time difference (ms) since the last processing of the FB to ET
PT PT is set to the same value as ET
X Cannot be used
<PT ET < PT
>=PT ET >= PT
If the input parameters O_HIS and C_HIS both have the signal state "1", they are immediately set to signal state "0". In this 
case, the last row in the table (X) mentioned above is valid. Because it is therefore no longer possible to check whether the 
input parameters O_HIS and C_HIS have the signal state "1", the output parameters are set as follows in this case: 
OO = FALSE
CO = FALSE
OA = FALSE
CA = FALSE
ET = PT
Q = TRUE

The "Motor control-timer alarm" instruction returns no error information.
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Parameters
The following table shows the reactions of the "Motor control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
O_CMD Input BOOL I, Q, M, D, L or 

constant
"Open" command 
input

C_CMD Input BOOL I, Q, M, D, L or 
constant

"Close" command 
input

S_CMD Input BOOL I, Q, M, D, L or 
constant

"Stop" command 
input

O_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when opening

C_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when closing

OO Output BOOL I, Q, M, D, L "Open" output
CO Output BOOL I, Q, M, D, L "Close" output
OA Output BOOL I, Q, M, D, L Alarm output 

when opening
CA Output BOOL I, Q, M, D, L Alarm output 

when closing
Q Output BOOL I, Q, M, D, L The signal state 

"0" indicates an 
error condition.

ET Static DINT D, L or constant Currently elapsed 
time, where one 
clock pulse = 1 ms

PT Static DINT D, L or constant Preset timer 
value, where one 
clock pulse = 1 ms

PREV_TIME Static DWORD D, L or constant Previous system 
time

O_HIS Static BOOL D, L or constant "Open" history bit
C_HIS Static BOOL D, L or constant "Close" history bit

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
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The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:

Parameter Operand Value
O_CMD Tag_Input_O_CMD TRUE
C_CMD Tag_Input_C_CMD FALSE
S_CMD Tag_Input_S_CMD FALSE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
OO Tag_OutputOpen FALSE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q FALSE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#2
PT DBD8 L#22
O_HIS DBX16.0 TRUE
C_HIS DBX16.1 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:
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Parameter Operand Value
OO Tag_OutputOpen TRUE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q TRUE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
O_HIS DBX16.0 TRUE
CMD_HIS DBX16.1 FALSE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

IMC: Compare input bits with the bits of a mask

Description
The instruction "Compare input bits with the bits of a mask" is used to compare the signal state 
of up to 16 programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of a mask. 
Up to 16 steps with masks can be programmed. The value of the IN_BIT0 parameter  is 
compared with the value of the mask CMP_VAL[x,0], with "x" indicating the step number. On 
the CMP_STEP parameter, you specify the step number of the mask that is used for the 
comparison.  All programmed values are compared in the same manner. Unprogrammed input 
bits or unprogrammed bits of the mask have the default signal state FALSE.

If a match is found in the comparison, the signal state of the OUT parameter is set to "1". 
Otherwise, the OUT parameter is set to "0".

If the value of the CMP_STEP parameter is greater than 15, the instruction is not executed. 
An error message is output at the ERR_CODE parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".
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Parameters
The following table shows the parameters of the "Compare input bits with the bits of a mask" 
instruction:

Paramete
r

Declarati
on

Data type Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or constant Input bit 0 is compared with bit 

0 of the mask.
IN_BIT1 Input BOOL I, Q, M, D, L or constant Input bit 1 is compared with bit 

1 of the mask.
IN_BIT2 Input BOOL I, Q, M, D, L or constant Input bit 2 is compared with bit 

2 of the mask.
IN_BIT3 Input BOOL I, Q, M, D, L or constant Input bit 3 is compared with bit 

3 of the mask.
IN_BIT4 Input BOOL I, Q, M, D, L or constant Input bit 4 is compared with bit 

4 of the mask.
IN_BIT5 Input BOOL I, Q, M, D, L or constant Input bit 5 is compared with bit 

5 of the mask.
IN_BIT6 Input BOOL I, Q, M, D, L or constant Input bit 6 is compared with bit 

6 of the mask.
IN_BIT7 Input BOOL I, Q, M, D, L or constant Input bit 7 is compared with bit 

7 of the mask.
IN_BIT8 Input BOOL I, Q, M, D, L or constant Input bit 8 is compared with bit 

8 of the mask.
IN_BIT9 Input BOOL I, Q, M, D, L or constant Input bit 9 is compared with bit 

9 of the mask.
IN_BIT10 Input BOOL I, Q, M, D, L or constant Input bit 10 is compared with 

bit 10 of the mask.
IN_BIT11 Input BOOL I, Q, M, D, L or constant Input bit 11 is compared with 

bit 11 of the mask.
IN_BIT12 Input BOOL I, Q, M, D, L or constant Input bit 12 is compared with 

bit 12 of the mask.
IN_BIT13 Input BOOL I, Q, M, D, L or constant Input bit 13 is compared with 

bit 13 of the mask.
IN_BIT14 Input BOOL I, Q, M, D, L or constant Input bit 14 is compared with 

bit 14 of the mask.
IN_BIT15 Input BOOL I, Q, M, D, L or constant Input bit 15 is compared with 

bit 15 of the mask.
CMP_ST
EP

Input BYTE I, Q, M, D, L, P or constant The step number of the mask 
used for the comparison.

OUT Output BOOL I, Q, M, D, L The signal state "1" indicates 
that a match was found.
The signal state "0" indicates 
that a match was found.
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Paramete
r

Declarati
on

Data type Memory area Description

ERR_CO
DE

Output WORD I, Q, M, D, L, P Error information 

CMP_VA
L

Static ARRAY OF 
WORD

I, Q, M, D, L or constant Comparison masks [0 to 15, 0 
to 15]: The first number of the 
index is the step number and 
the second number is the bit 
number of the mask.

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000A The value at the CMP_STEP parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SMC: Compare scan matrix

Description
The "Compare scan matrix" instruction is used to compare the signal state of up to 16 
programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of the comparison 
masks for each step. Processing starts at step 1 and is continued until the last programmed 
step (LAST) or until a match is found. The input bit of the IN_BIT0 parameter is compared with 
the value of the mask CMP_VAL[x,0], with "x" indicating the step number. All programmed 
values are compared in the same manner. If a match is found the signal state of the OUT 
parameter is set to "1" and the step number with the matching mask is written in the OUT_STEP 
parameter. Unprogrammed input bits or unprogrammed bits of the mask have the default signal 
state FALSE. If more than one step has a matching mask, only the first one found is indicated 
in the OUT_STEP parameter. If no match is found, the signal state of the OUT parameter is 
set to "0". In this case the value at the OUT_STEP parameter is greater by "1" than the value 
of the LAST parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multi-instance) in the block interface. If you create a separate data 
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block, you will find it in the project tree in the "Program resources" folder under "Program blocks 
> System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Compare scan matrix" instruction:

Paramete
r

Declarati
on

Data type Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or constant Input bit 0 is compared with bit 

0 of the mask.
IN_BIT1 Input BOOL I, Q, M, D, L or constant Input bit 1 is compared with bit 

1 of the mask.
IN_BIT2 Input BOOL I, Q, M, D, L or constant Input bit 2 is compared with bit 

2 of the mask.
IN_BIT3 Input BOOL I, Q, M, D, L or constant Input bit 3 is compared with bit 

3 of the mask.
IN_BIT4 Input BOOL I, Q, M, D, L or constant Input bit 4 is compared with bit 

4 of the mask.
IN_BIT5 Input BOOL I, Q, M, D, L or constant Input bit 5 is compared with bit 

5 of the mask.
IN_BIT6 Input BOOL I, Q, M, D, L or constant Input bit 6 is compared with bit 

6 of the mask.
IN_BIT7 Input BOOL I, Q, M, D, L or constant Input bit 7 is compared with bit 

7 of the mask.
IN_BIT8 Input BOOL I, Q, M, D, L or constant Input bit 8 is compared with bit 

8 of the mask.
IN_BIT9 Input BOOL I, Q, M, D, L or constant Input bit 9 is compared with bit 

9 of the mask.
IN_BIT10 Input BOOL I, Q, M, D, L or constant Input bit 10 is compared with 

bit 10 of the mask.
IN_BIT11 Input BOOL I, Q, M, D, L or constant Input bit 11 is compared with 

bit 11 of the mask.
IN_BIT12 Input BOOL I, Q, M, D, L or constant Input bit 12 is compared with 

bit 12 of the mask.
IN_BIT13 Input BOOL I, Q, M, D, L or constant Input bit 13 is compared with 

bit 13 of the mask.
IN_BIT14 Input BOOL I, Q, M, D, L or constant Input bit 14 is compared with 

bit 14 of the mask.
IN_BIT15 Input BOOL I, Q, M, D, L or constant Input bit 15 is compared with 

bit 15 of the mask.
OUT Output BOOL I, Q, M, D, L The signal state "1" indicates 

that a match was found.
The signal state "0" indicates 
that no match was found. 

ERR_CO
DE

Output WORD I, Q, M, D, L, P Error information 
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Paramete
r

Declarati
on

Data type Memory area Description

OUT_ST
EP

Output BYTE I, Q, M, D, L, P Contains the step number with 
the matching mask or the step 
number which is greater by "1" 
than the value of the LAST 
parameter, provided no match 
is found.

LAST Static BYTE I, Q, M, D, L, P or constant Specifies the step number of 
the last step to be scanned for 
a matching mask.

CMP_VA
L

Static ARRAY OF 
WORD

I, Q, M, D, L or constant Comparison masks [0 to 15, 0 
to 15]: The first number of the 
index is the step number and 
the second number is the bit 
number of the mask.

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000E The value at the LAST parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

LEAD_LAG: Lead and lag algorithm 

Description
The "Lead and lag algorithm" instruction is used to process signals with an analog tag. The 
gain value at the GAIN parameter must be greater than zero. The result of the instruction "Lead 
and lag algorithm" is calculated using the following equation:

The "Lead and lag algorithm" instruction supplies plausible results only when processing is in 
fixed program cycles. The same units must be specified for the LD_TIME, LG_TIME, and 
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SAMPLE_T parameters. At LG_TIME > 4 + SAMPLE_T, the instruction approaches the 
following function:

OUT = GAIN * ((1 + LD_TIME * s) / (1 + LG_TIME * s)) * IN

When the value of the GAIN parameter is less than or equal to zero, the calculation is not 
performed and an error information is output on the ERR_CODE parameter.

You can use the "Lead and lag algorithm" instruction in conjunction with loops as a 
compensator in dynamic feed-forward control. The instruction consists of two operations. The 
"Lead" operation shifts the phase of the OUT output so that the output leads the input. The 
"Lag" operation, on the other hand, shifts the output so that the output lags behind the input. 
Because the "Lag" operation is equivalent to an integration, it can be used as a noise 
suppressor or as a low-pass filter. The "Lead" operation is equivalent to a differentiation and 
can therefore be used as a high-pass filter. The two operations together (Lead and Lag) result 
in the output phase lagging behind the the input at lower frequencies and leading it at higher 
frequencies. This means that the "Lead and lag algorithm" instruction can be used as a band 
pass filter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Lead and lag algorithm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P or 

constant
The input value of 
the current sample 
time (cycle time) to 
be processed.
Constants can 
also be specified 
on the IN 
parameter.

SAMPLE_T Input INT I, Q, M, D, L, P or 
constant

Sample time
Constants can 
also be specified 
on the SAMPLE_T 
parameter.

OUT Output REAL I, Q, M, D, L Result of the 
instruction

ERR_CODE Output WORD I, Q, M, D, L Error information 
LD_TIME Static REAL I, Q, M, D, L, P or 

constant
Lead time in the 
same unit as 
sample time.
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Parameter Declaration Data type Memory area Description
LG_TIME Static REAL I, Q, M, D, L, P or 

constant
Lag time in in the 
same unit as 
sample time.

GAIN Static REAL I, Q, M, D, L, P or 
constant

Gain as % / % (the 
ratio of the change 
in output to a 
change in input as 
a steady state).

PREV_IN Static REAL I, Q, M, D, L, P or 
constant

Previous input

PREV_OUT Static REAL I, Q, M, D, L, P or 
constant

Previous output

For additional information on valid data types, refer to "See also".

Parameter ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0009 The value at the GAIN parameter is less than or equal to zero.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

The following table shows how the instruction works using specific operand values:

Before processing

In this example the following values are used for the input parameters:
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Parameter Operand Value
IN Tag_Input 2.0
SAMPLE_T Tag_InputSampleTime 10

The following values are saved in the instance data block "LEAD_LAG_DB" of the instruction:

Parameter Address Value
LD_TIME DBD12 2.0
LG_TIME DBD16 2.0
GAIN DBD20 1.0
PREV_IN DBD24 6.0
PREV_OUT DBD28 6.0

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
OUT Tag_Output_Result 2.0

The following values are saved in the instance data block "LEAD_LAD_DB" of the instruction:

Parameter Operand Value
PREV_IN DBD24 2.0
PREV_OUT DBD28 2.0

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SEG: Create bit pattern for seven-segment display

Description       
The instruction "Create bit pattern for seven-segment display" is used to convert each of the 
four hexadecimal digits of the specified source word (IN) into an equivalent bit pattern for a 
seven-segment display. The result of the instruction is output in the double word on the OUT 
parameter.

The following relation exists between the hexadecimal digits and the assignment of the 7 
segments (a, b, c, d, e, f, g):
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Input digit
(Binary)

Assignment of 
the segments
‑ g f e d c b a

Display
(Hexadecimal)

Seven-segment display

0000 00111111 0
0001 00000110 1
0010 01011011 2
0011 01001111 3
0100 01100110 4
0101 01101101 5
0110 01111101 6
0111 00000111 7
1000 01111111 8
1001 01100111 9
1010 01110111 A
1011 01111100 B
1100 00111001 C
1101 01011110 D
1110 01111001 E
1111 01110001 F

Parameter
The following table shows the parameters of the "Create bit pattern for seven-segment display" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input WORD I, Q, M, D, L, P or 

constant
Source word with 
four hexadecimal 
digits

OUT Output DWORD I, Q, M, D, L, P Bit pattern for the 
seven-segment 
display
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
Hexadecimal Binary
IN Tag_Input W#16#1234 0001 0010 0011 0100
OUT Tag_Output DW#16065B4F66 000 00110 0101 1011 0100 

1111 0110 0110
Display: 1234

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

BCDCPL: Create tens complement

Description
You can use the "Create tens complement" instruction to create the tens complement of a 
seven-digit BCD number specified in the IN parameter. This instruction uses the following 
mathematical formula to calculate:

10000000 (as BCD)

– 7-digit BCD value

----------------------------------------

Tens complement (as BCD)

Parameters
The following table shows the parameters of the "Create tens complement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN Input Bit strings I, Q, M, D, L, P or 

constant
7-digit BCD 
number

ERR_CODE Output DWORD I, Q, M, D, L, P Result of the 
instruction

Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#01234567
ERR_CODE Tag_Output DW#16#08765433
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

BITSUM: Count number of set bits

Description     
The "Count number of set bits" instruction is used to count the number of bits of an operand 
that is set to the signal state "1". The operand whose bits are to be counted is specified on the  
IN parameter. The result of the instruction is output on the RET_VAL parameter.

Parameters
The following table shows the parameters of the "Count number of set bits" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
IN Input DWORD I, Q, M, D, L, P or 

constant
Operand whose 
set bits are 
counted

RET_VAL Output INT I, Q, M, D, L, P Number of bits to 
be set

Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#12345678
RET_VAL Tag_Output W#16#000D (13 Bits)
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

9.7.2.2 FBD

 

&: AND logic operation

Description     
You can use the instruction "AND logic operation" to query the signal states of two or more 
specified operands and evaluate them according to the AND truth table.

If the signal state of all the operands is "1", then the condition is fulfilled and the instruction 
returns the result "1". If the signal state of one of the operands is "0", then the condition is not 
fulfilled and the instruction generates the result "0".
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Parameters
The following table shows the parameters of the instruction "AND logic operation":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.

Example
The following example shows how the instruction works:

Output "TagOut" is set, when the signal state of the operands "TagIn_1" and "TagIn_2" is "1" 
and reset when the state of the operands "TagIn_1" and "TagIn_2" is "0".

See also
AND truth table (Page 2132)

Example of detecting the direction of a conveyor belt (Page 1841)

Example of controlling room temperature (Page 1845)

Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Insert input (Page 2136)

AND truth table

Results of the logic operation   
The following table shows the results that arise from the AND logic operation of two operands:

Signal state of the first operand Signal state of the second 
operand

Result of the logic operation 

1 1 1
0 1 0
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Signal state of the first operand Signal state of the second 
operand

Result of the logic operation 

1 0 0
0 0 0

See also
&: AND logic operation (Page 2131)

Overview of the valid data types (Page 1320)

>=1: OR logic operation

Description     
You can use the instruction "OR logic operation" to query the signal states of two or more 
specified operands and evaluate them according to the OR truth table.

If the signal state of one of the operands is "1", then the condition is fulfilled and the instruction 
returns the result "1". If the signal state of all the operands is "0", then the condition is not 
fulfilled and the instruction generates the result "0".

Parameters
The following table shows the parameters of the instruction "OR logic operation":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.

Example
The following example shows how the instruction works:

Output "TagOut" is set, when the signal state of the operands "TagIn_1" or "TagIn_2" is "1".
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See also
OR truth table (Page 2134)

Example of controlling a conveyor belt  (Page 1840)

Adding additional inputs and outputs to FBD elements (Page 1585)

Overview of the valid data types (Page 1320)

Insert input (Page 2136)

OR truth table

Results of the logic operation   
The following table shows the results that arise from the OR logic operation of two operands:

Signal state of the first operand Signal state of the second 
operand

Result of the logic operation 

1 0 1
0 1 1
1 1 1
0 0 0

See also
>=1: OR logic operation (Page 2133)

Overview of the valid data types (Page 1320)

X: EXCLUSIVE OR logic operation

Description       
You can use the instruction "EXCLUSIVE OR logic operation" to query the result of a signal 
state query according to the EXCLUSIVE OR truth table.

With an instruction "EXCLUSIVE OR logic operation", the signal state is "1" when the signal 
state of one of the two specified operands is "1". When more than two operands are queried, 
the common RLO is "1" if an odd number of the queried operands returns the result "1".
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Parameters
The following table shows the parameters of the instruction "EXCLUSIVE OR logic operation":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.

Example
The following example shows how the instruction works:

Output "TagOut" is set when the signal state of the operands "TagIn_1" and "TagIn_2" is "1". 
When both operands return the signal state "1" or "0", the output "TagOut" is reset.

See also
EXCLUSIVE OR truth table (Page 2135)

Adding additional inputs and outputs to FBD elements (Page 1585)

Overview of the valid data types (Page 1320)

Insert input (Page 2136)

EXCLUSIVE OR truth table

Results of the logic operation      
The following table shows the results that arise from the EXCLUSIVE OR logic operation of 
two operands:

Signal state of the first operand Signal state of the second 
operand 

Result of the logic operation

1 0 1
0 1 1
1 1 0
0 0 0
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The following table shows the results that arise from the EXCLUSIVE OR logic operation of 
three operands:

Signal state of the first 
operand

Signal state of the 
second operand 

Signal state of the third 
operand 

Result of the logic 
operation

1 0 0 1
0 1 1 0
0 1 0 1
1 0 1 0
0 0 1 1
1 1 0 0
1 1 1 1
0 0 0 0

 
 

See also
X: EXCLUSIVE OR logic operation (Page 2134)

Overview of the valid data types (Page 1320)

Insert input

Description     
The "Insert input" instruction is used to add an input to the box of one of the following 
instructions:

● "AND logic operation"

● "OR logic operation"

● "EXCLUSIVE OR logic operation"

You can query the signal state of several operands by the extension of an instruction box.

Parameters
The following table shows the parameters of the instruction "Insert input":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

The operand 
indicates the 
bit whose 
signal state will 
be queried.
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Example
The following example shows how the instruction works:

The box of the instruction "AND logic operation" was extended by an additional input at which 
the signal state of the operand "TagIn_3" is queried. The output "TagOut" is set, when the 
signal state of the operands "TagIn_1", "TagIn_2" and "TagIn_3" returns the signal state "1".

See also
&: AND logic operation (Page 2131)

>=1: OR logic operation (Page 2133)

X: EXCLUSIVE OR logic operation (Page 2134)

Overview of the valid data types (Page 1320)

Invert RLO

Description     
You use the "Invert RLO" instruction to invert the signal state of the result of logic operation 
(RLO).

Example
The following example shows how the instruction works:

The output "TagOut" is set when the following conditions are fulfilled:

● The input "TagIn_1" and/or "TagIn_2" has signal state "0".

● The input "TagIn_3" and/or "TagIn_4" has signal state "0" or the input "TagIn_5" has signal 
state "1".

See also
Overview of the valid data types (Page 1320)
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=: Assignment

Description   
You can use the instruction "Assignment" to set the bit of a specified operand. If the result of 
logic operation (RLO) at the box input has the signal state "1", the specified operand is set to 
signal state "1". If the signal state at the box input is "0", the bit of the specified operand is 
reset to "0".

The instruction does not influence the RLO. The RLO at the box input is assigned directly to 
the operand above the assignment box.

Parameters
The following table shows the parameters of the instruction "Assignment":

Parameters Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the RLO is 
assigned. 

Example
The following example shows how the instruction works:

The operand "TagOut" is set at the output of the "Assignment" instruction when one of the 
following conditions is fulfilled:

● The inputs "TagIn_1" and "TagIn_2" have the signal state "1".

● The signal state at the input "TagIn_3" is "0".

See also
Overview of the valid data types (Page 1320)

Example of detecting the fill level of a storage area  (Page 1842)

Example of controlling room temperature (Page 1845)
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/=: Negate assignment

Description   
The instruction "Negate assignment" inverts the result of logic operation (RLO) and assigns 
this to the operand above the box. If the RLO at the input of the box is "1", the binary operand 
is reset. If the RLO at the input of the box is "0", the operand is set to signal state "1".

Parameters
The following table shows the parameters of the instruction "Negate assignment":

Parameters Declaration Data type Memory area Description
<Operand> Output BOOL I, Q, M, D, L Operand to which 

the negated RLO 
is assigned.

Example
The following example shows how the instruction works:

The operand "TagOut" is reset when the following conditions are fulfilled:

● The operand "TagIn_1" or "TagIn_2" has the signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Overview of the valid data types (Page 1320)

R: Reset output

Description     
You can use the "Reset output" instruction to reset the signal state of a specified operand to 
"0".

The instruction is only executed if the result of logic operation (RLO) at the box input is "1". If 
the box input has the signal state "1", the specified operand is reset to "0". If there is an RLO 
of "0" at the box input, the signal state of the specified operand remains unchanged.
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Parameters
The following table shows the parameters of the "Reset output" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand> Output BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Operand that 
is reset if 
RLO = "1".

Example
The following example shows how the instruction works:

Operand "TagOut" is reset when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Example of controlling a conveyor belt  (Page 1840)

Example of detecting the direction of a conveyor belt (Page 1841)

Overview of the valid data types (Page 1320)

S: Set output

Description     
You can use the instruction "Set output" to set the signal state of a specified operand to "1".

The instruction is only executed if the result of logic operation (RLO) at the box input is "1". If 
the box input has the signal state "1", the specified operand is set to "1". If there is an RLO of 
"0" at the box input, the signal state of the specified operand remains unchanged.
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Parameters
The following table shows the parameters of the instruction "Set output":

Parameters Declaratio
n

Data type Memory area Description

<Operand> Output BOOL I, Q, M, D, L Operand which is set with 
RLO = "1".

Example
The following example shows how the instruction works:

The "TagOut" operand is set when one of the following conditions is fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "0".

See also
Overview of the valid data types (Page 1320)

SET_BF: Set bit field

Description
You can use the instruction "Set bit field" to set multiple bits starting from a certain address.

You can use the input N to define the number of bits to be set. The address of the first bit to 
be set is defined by (<Operand>). If the value of the N input is greater than the number of bits 
in a selected byte, the bits of the next byte are set. The bits remain set until they are explicitly 
reset, for example, by another instruction.
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Parameters
The following table shows the parameters of the instruction "Set bit field":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

N Input UINT Constant Constant Number of bits 
to be set

<Operand> Output BOOL I, Q, M
In the case 
of a DB or an 
IDB, an 
element of 
an 
ARRAY[..] 
of BOOL

I, Q, M
In the case of a 
DB or an IDB, 
an element of 
an ARRAY[..] 
of BOOL

Pointer to the 
first bit to be set.

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are set starting at the 
address of the operand "MyDB".MyBoolArray[4].

See also
Overview of the valid data types (Page 1320)

RESET_BF: Reset bit field

Description
You can use the instruction "Reset bit field" to reset several bits starting from a certain address.

You can use the value of the N input to define the number of bits to be reset. The address of 
the first bit to be reset is defined by (<Operand>). If the value of the input N is greater than the 
number of bits in a selected byte, the bits of the next byte are reset. The bits remain reset until 
they are explicitly set, for example, by another instruction.
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Parameters
The following table shows the parameters of the instruction "Reset bit field":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

N Input UINT Constant Constant Number of bits 
to be reset.

<Operand> Output BOOL I, Q, M
In the case 
of a DB or an 
IDB, an 
element of 
an 
ARRAY[..] 
of BOOL

I, Q, M
In the case of a 
DB or an IDB, 
an element of 
an ARRAY[..] 
of BOOL

Pointer to the 
first bit to be 
reset.

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", 5 bits are reset starting at 
the address of the operand "MyDB".MyBoolArray[4].

See also
Overview of the valid data types (Page 1320)

SR: Set/reset flip-flop

Description       
You can use the instruction "Set/reset flip-flop" to set or reset the bit of a specified operand 
based on the signal state of the inputs S and R1. If the signal state is "1" at input S and "0" at 
input R1, the specified operand is set to "1". If the signal state is "0" at input S and "1" at input 
R1, the specified operand will be reset to "0".

Input R1 takes priority over input S. When the signal state is "1" on both inputs S and R1, the 
signal state of the specified operand is reset to "0".
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The instruction is not executed if the signal state at the two inputs S and R1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.

Parameters
The following table shows the parameters of the instruction "Set/reset flip-flop":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

S Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable setting

R1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable 
resetting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is set or reset

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:

The operands "TagSR" and "TagOut" are set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagSR" and "TagOut" are reset when one of the following conditions is fulfilled:

● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1320)

Programming the PLC
9.7 References

WinCC Professional V13.0
2144 System Manual, 02/2014



RS: Reset/set flip-flop

Description       
You can use the instruction "Reset/set flip-flop" to reset or set the bit of a specified operand 
based on the signal state of the inputs R and S1. If the signal state is "1" at input R and "0" at 
input S1, the specified operand will be reset to "0". If the signal state is "0" at input R and "1" 
at input S1, the specified operand is set to "1". 

Input S1 takes priority over input R. When the signal state is "1" at both inputs R and S1, the 
signal state of the specified operand is set to "1".

The instruction is not executed if the signal state at the two inputs R and S1 is "0". The signal 
state of the operand then remains unchanged.

The current signal state of the operand is transferred to output Q and can be queried there.

Parameters
The following table shows the parameters of the instruction "Reset/set flip-flop":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

R Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable 
resetting

S1 Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable setting

<Operand> InOut BOOL I, Q, M, D, L I, Q, M, D, L Operand that 
is reset or set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Signal state of 
the operand

Example
The following example shows how the instruction works:

The operands "TagRS" and "TagOut" are reset when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The operand "TagIn_2" has the signal state "0".

The operands "TagRS" and "TagOut" are set when the following conditions are fulfilled:
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● The operand "TagIn_1" has signal state "0" and the operand "TagIn_2" has signal state "1".

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

See also
Overview of the valid data types (Page 1320)

P: Scan operand for positive signal edge

Description
You can use the instruction "Scan operand for positive signal edge" to determine whether there 
is a "0" to "1" change in the signal state of a specified operand (<Operand1>). The instruction 
compares the current signal state of <Operand1> with the signal state of the previous scan, 
which is saved in an edge memory bit (<Operand2>). If the instruction detects a change in the 
result of logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a rising edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the "Scan operand for positive signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Signal to be 
scanned 

<Operand2> InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory 
bit in which the 
signal state of 
the previous 
query is saved.
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Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● There is a rising edge at input "TagIn_1".

● The signal state of the operand "TagIn_2" is "1".

See also
Overview of the valid data types (Page 1320)

Example of detecting the direction of a conveyor belt (Page 1841)

N: Scan operand for negative signal edge

Description
You can use the instruction "Scan operand for negative signal edge" to determine whether 
there is a "1" to "0" change in the signal state of a specified operand (<Operand1>). The 
instruction compares the current signal state of <Operand1> with the signal state of the 
previous scan, which is saved in an edge memory bit (<Operand2>). If the instruction detects 
a change in the result of logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a falling edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

Specify the operand to be queried (<Operand1>) in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.
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Parameters
The following table shows the parameters of the "Scan operand for negative signal edge" 
instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

<Operand1> Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Signal to be 
scanned

<Operand2> InOut BOOL I, Q, M, D, L I, Q, M, D, L Edge memory 
bit in which the 
signal state of 
the previous 
query is saved.

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● There is a falling edge at input "TagIn_1".

● The signal state of the operand "TagIn_2" is "1".

See also
Overview of the valid data types (Page 1320)

P=: Set operand on positive signal edge

Description
You can use the instruction "Set operand on positive signal edge" to set a specified operand 
(<Operand2>) when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
in the edge memory bit (<Operand1>). If the instruction detects a change in the result of logic 
operation (RLO) from "0" to "1", there is a positive, rising edge.

When a positive edge is detected, <Operand2> is set to signal state "1" for one program cycle. 
In all other cases, the operand has the signal state "0".
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You specify the operand (<Operand2>) to be set in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand1>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Set operand on positive signal 
edge":

Parameter Declaration Data type Memory area Description
<Operand2> Output BOOL I, Q, M, D, L Operand which is 

set when there is a 
positive signal 
edge.

<Operand1> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows the parameters of the instruction:

The "TagOut" output is set for one program cycle, when the signal state at the input of the 
instruction box switches from "0" to "1" (positive signal edge). In all other cases, the "TagOut" 
output has signal state "0".

See also
Overview of the valid data types (Page 1320)

N=: Set operand on negative signal edge

Description
You can use the instruction "Set operand on negative signal edge" to set a specified operand 
(<Operand1>) when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO with the RLO from the previous query, which is saved 
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in the edge memory bit (<Operand2>). If the instruction detects a change in the result of logic 
operation (RLO) from "1" to "0", there is a negative, falling edge.

When a negative edge is detected, <Operand1> is set to signal state "1" for one program cycle. 
In all other cases, the operand has the signal state "0".

You specify the operand (<Operand1>) to be set in the operand placeholder above the 
instruction. Specify the edge memory bit (<Operand2>) in the operand placeholder below the 
instruction.

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Set operand on negative signal 
edge":

Parameter Declaration Data type Memory area Description
<Operand1> Output BOOL I, Q, M, D, L Operand which is 

set when there is a 
negative signal 
edge.

<Operand2> InOut BOOL I, Q, M, D, L Edge memory bit

Example
The following example shows how the instruction works:

The operand  "TagOut" is set for one program cycle if the signal state at the input of the 
instruction box changes from "1" to "0" (negative signal edge). In all other cases, the operand 
"TagOut" has the signal state "0".

See also
Overview of the valid data types (Page 1320)
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P_TRIG: Scan RLO for positive signal edge

Description
Use the instruction "Scan RLO for positive signal edge" to query a "0" to "1" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query, which is saved in an edge memory 
bit (<Operand>). If the instruction detects a change in the result of logic operation (RLO) from 
"0" to "1", there is a positive, rising edge.

If a rising edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Scan RLO for positive signal edge":

Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding bit logic operation is saved in the edge memory bit "Tag_M". If a "0" 
to "1" change is detected in the signal state of the RLO, the program jumps to jump label CAS1.
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See also
Overview of the valid data types (Page 1320)

N_TRIG: Scan RLO for negative signal edge

Description
Use the instruction "Scan RLO for negative signal edge" to query a "1" to "0" change in the 
signal state of the result of logic operation (RLO). The instruction compares the current signal 
state of the RLO with the signal state of the previous query saved in the edge memory bit 
(<Operand>). If the instruction detects a change in the result of logic operation (RLO) from "1" 
to "0", there is a negative, falling edge.

If a falling edge is detected, the output of the instruction has the signal state "1". In all other 
cases, the signal state at the output of the instruction is "0".

 

 Note

The address of the edge memory bit must not be used more than once in the program, 
otherwise the memory bit is overwritten. This would influence edge evaluation and the result 
would no longer be unequivocal. The memory area of the edge memory bit has to be located 
in a DB (static area for FB) or in the bit memory area.

 

Parameters
The following table shows the parameters of the instruction "Scan RLO for negative signal 
edge":

Parameter Declaration Data type Memory area Description
CLK Input BOOL I, Q, M, D, L Current RLO
<Operand> InOut BOOL M, D Edge memory bit 

in which the RLO 
of the previous 
query is saved.

Q Output BOOL I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:
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The RLO of the preceding bit logic operation is saved in the edge memory bit "Tag_M". If a "1" 
to "0" change is detected in the signal state of the RLO, the program jumps to jump label CAS1.

See also
Overview of the valid data types (Page 1320)

R_TRIG: Set tag on positive signal edge

Description
You can use the "Set tag on positive signal edge" instruction to set a specified tag in the 
instance DB when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a positive edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find this in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the instruction "Set tag on positive signal edge":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
CLK Input BOOL I, Q, M, D, L or 

constant
I, Q, M, D, L, T, 
C or constant

Incoming 
signal, the 
edge of which 
is to be 
queried.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Result of edge 
evaluation
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Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "R_TRIG_DB". If a change is the 
signal state of the RLO from "0" to "1" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut" has signal state "1".

See also
Overview of the valid data types (Page 1320)

F_TRIG: Set tag on negative signal edge

Description
You can use the "Set tag on negative signal edge" instruction to set a specified tag in the 
instance DB when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "1" to "0", there is a negative, falling edge.

If a negative edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find this in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the instruction "Set tag on negative signal edge":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CLK Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L, T, 
C or constant

Incoming 
signal, the 
edge of which 
is to be 
queried.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Result of edge 
evaluation

Example
The following example shows how the instruction works:

The RLO of the preceding query is saved in the instance DB "F_TRIG_DB". If a change is the 
signal state of the RLO from "1" to "0" is detected in the operands "TagIn_1" and "TagIn_2" or 
in the operand "TagIn_3", the output "TagOut" has signal state "1".

See also
Overview of the valid data types (Page 1320)

Timer operations

 

TP: Generate pulse

Description
You can use the instruction "Generate pulse" to set output Q for the duration PT. The instruction 
is started when the result of logic operation (RLO) at input IN changes from "0" to "1" (positive 
signal edge). The configured time duration PT begins when the instruction starts. Output Q is 
set for the time duration PT, regardless of the subsequent course of the input signal (positive 
edge). Even when a new positive signal edge is detected, the signal state of the Q output is 
not affected as long as the PT duration is running.

The current time value can be queried at the output ET. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. If the configured time duration PT is 
reached and the signal state at input IN is "0", the ET output is reset.
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Each call of the "Generate pulse" instruction must be assigned an IEC Timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TP_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TP_TIME or TP_LTIME 
that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
this in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate pulse" instruction requires a preceding logic operation. It can 
be placed within or at the end of the network.
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Parameters
The following table shows the parameters of the "Generate pulse" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Duration of 
the pulse.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Pulse output

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate pulse" instruction:

See also
Overview of the valid data types (Page 1320)

Example of controlling room temperature (Page 1845)
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TON: Generate on-delay

Description
You can use the instruction "Generate on-delay" to delay setting of the Q output by the time 
configured with the PT time. The instruction is started when the result of logic operation (RLO) 
at input IN changes from "0" to "1" (positive signal edge). The programmed time PT begins 
when the instruction starts. When the duration PT expires, output Q has the signal state "1". 
Output Q remains set as long as the start input is still "1". When the signal state at the start 
input changes from "1" to "0", the Q output is reset. The timer function is started again when 
a new positive signal edge is detected at the start input.

The current time value can be queried at the output ET. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. The ET output is reset as soon as the 
signal state at the IN input changes to "0".

Each call of the "Generate on-delay" instruction must be assigned an IEC Timer in which the 
instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TON_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TON_TIME or 
TON_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, it is saved to 
the "Program resources" folder in the "Program blocks > System blocks" path of the project 
tree. For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.
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The execution of the "Generate on-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Generate on-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Duration of 
the on delay.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate on-delay" instruction:
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See also
Overview of the valid data types (Page 1320)

TOF: Generate off-delay

Description
You can use the "Generate off-delay" instruction to delay setting of the Q output by the time 
configured with the PT time. The output Q is set when the result of logic operation (RLO) at 
input IN changes from "0" to "1" (positive signal edge). When the signal state at input IN 
changes back to "0" (positive signal edge), the configured time duration PT starts. Output Q 
remains set as long as the time duration PT is running. When the PT time duration expires, 
the Q output is reset. If the signal state at input IN changes to "1" before the PT time duration 
expires, the timer is reset. The signal state at the output Q will continue to be "1".

The current time value can be queried at the output ET. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. When the time duration PT expires, 
the ET output remains set to the current value until input IN changes back to "1". If input IN 
changes to "1" before the time duration PT has expired, the ET output is reset to the value 
T#0s.

Each call of the "Generate off-delay" instruction must be assigned to an IEC Timer in which 
the instruction data is stored.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TOF_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TOF_TIME or 
TOF_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
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tag (multiple instance) in the block interface. If you create a separate data block, you will find 
this in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Generate off-delay" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Generate off-delay" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Duration of 
the off delay
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Output that 
is reset 
when the 
timer PT 
expires.

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate off-delay" instruction:

See also
Overview of the valid data types (Page 1320)

TONR: Time accumulator

Description
The instruction "Time accumulator" is used to accumulate time values within a period set by 
the parameter PT. The instruction is executed and the configured time duration PT is started 
when the result of logic operation (RLO) at input IN changes from "0" to "1" (positive edge). 
While the time set at PT is running, the time values are accumulated that are recorded at signal 
state "1" at input IN. The accumulated time is written to output ET and can be queried there. 
When the current time value PT is reached, the output Q has the signal state "1". Output Q 
remains set at "1", even when the signal state at input IN changes to "0".

The R input resets the outputs ET and Q regardless of the signal state at the start input.

Each call of the "Time accumulator" instruction must be assigned to an IEC Timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TONR_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)
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For S7-1500 CPU
An IEC Timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TONR_TIME or 
TONR_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC Timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
this in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

The instruction data is updated both when the instruction is called and also each time the 
outputs Q or ET are accessed.

The execution of the "Time accumulator" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Time accumulator" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C, P

Start input

R Input BOOL BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Reset input

PT Input TIME TIME, 
LTIME

I, Q, M, D, L 
or constant

I, Q, M, D, L, 
P or 
constant

Maximum 
duration of 
time 
recording.
The value of 
the PT 
parameter 
must be 
positive.

Q Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
P

Output that 
is set when 
the time PT 
expires.

ET Output TIME TIME, 
LTIME

I, Q, M, D, L I, Q, M, D, L, 
P

Current time 
value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Time accumulator" instruction:

See also
Overview of the valid data types (Page 1320)

TP: Start pulse timer

Description
Use the instruction "Start pulse timer" to start an IEC Timer with a specified duration as pulse. 
The IEC Timer is started when the result of logic operation (RLO) changes from "0" to "1" 
(positive signal edge). The IEC Timer runs for the specified time duration regardless of the 
subsequent course of the RLO. The expiry of the IEC Timer is also not affected by the detection 
of a new rising edge. As long as the IEC Timer is running, the querying of the timer status for 
"1" returns the signal state "1". When the IEC Timer has expired, the timer status returns the 
signal state "0".

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER or 
TP_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The instruction "Start pulse timer" stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TP_TIME or TP_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME, TP_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components Q of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the instruction "Start pulse timer" assumes a preceding logic operation. It can 
be placed only at the end of the network.

Parameters
The following table shows the parameters of the instruction "Start pulse timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
Timer runs.

<IEC Timer> InOut IEC_TIMER, 
TP_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME

D, L IEC Timer 
which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The instruction "Start pulse timer" is executed when the signal state of the operand "Tag_Input" 
changes from "0" to "1". The timer "DB1".MyIEC_TIMER is started for the time stored in the 
operand "TagTime".

As long as the timer "DB1".MyIEC_TIMER is running, the timer status 
("DB1".MyIEC_TIMER.Q) has signal state "1" and the operand "Tag_Output" is set. When the 
IEC Timer has expired, the signal state of the time status changes back to "0" and the 
"Tag_Output" operand is reset.

See also
Overview of the valid data types (Page 1320)

TON: Start on-delay timer

Description
Use the "Start on-delay timer" instruction to start an IEC Timer with a specified duration as on-
delay. The IEC Timer is started when the result of logic operation (RLO) changes from "0" to 
"1" (positive signal edge). The IEC Timer runs for the specified time duration. The output returns 
the signal state "1" if the RLO at the input of the instruction has the signal state "1". If the RLO 
changes to "0" before the end of the timer, the running IEC Timer is reset. The query of the 
timer status for "1" returns the signal state "0". The IEC Timer restarts when the next rising 
signal edge is detected at the input of the instruction.

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.
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For S7-1200 CPU
The instruction "Start on-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TON_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start on-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TON_TIME or TON_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME, TON_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components ET of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the "Start on-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameters
The following table shows the parameters of the instruction "Start on-delay timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with 
which the IEC 
Timer runs.

<IEC Timer> InOut IEC_TIMER, 
TON_TIME

IEC_TIMER, 
IEC_LTIMER, 
TON_TIME, 
TON_LTIME

D, L IEC Timer 
which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start on-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "0" to "1". The "MyIEC_TIMER" timer is started for the time stored 
in the "Tag_TIME" operand.

If the timer "MyIEC_TIMER" has expired and the operand "Tag_Input" has the signal state "1", 
querying the timer status ("MyIEC_TIMER".Q) returns signal state "1" and the "Tag_Output" 
operand is set. When the signal state of the operand "Tag_Input" changes to "0", the querying 
of the timer status returns the signal state "0" and the operand "Tag_Output" is reset.

See also
Overview of the valid data types (Page 1320)

TOF: Start off-delay timer

Description
Use the "Start off-delay timer" instruction to start an IEC Timer with a specified duration as off-
delay. The query of the timer status for "1" returns the signal state "0" if the result of the logic 
operation (RLO) at the input of the instruction has the signal state "1". When the RLO changes 
from "1" to "0" (negative signal edge), the IEC Timer starts with the specified time duration. 
The timer status remains at signal state "1" as long as the IEC Timer is running. When the 
timer has run out and the RLO at the input of the instruction has the signal state "0", the timer 
status is set to the signal state "0". If the RLO changes to "1" before the end of the timer, the 
running IEC Timer is reset and the timer status remain at the signal state "1".

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.

 

Programming the PLC
9.7 References

WinCC Professional V13.0
2168 System Manual, 02/2014



For S7-1200 CPU
The instruction "Start off-delay timer" stores its data in a structure of the data type IEC_TIMER 
or TOF_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or IEC_TIMER in the "Static" section of a 
block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Start off-delay timer" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TOF_TIME or TOF_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME, TOF_LTIME, IEC_TIMER or IEC_LTIMER 
in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components ET of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the "Start off-delay timer" instruction assumes a preceding logic operation. 
It can be placed only at the end of the network.

Parameters
The following table shows the parameters of the instruction "Start off-delay timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration with which 
the IEC Timer runs.

<IEC Timer> InOut IEC_TIMER, 
TOF_TIME

IEC_TIMER, 
IEC_LTIMER
, TOF_TIME, 
TOF_LTIME

D, L IEC Timer which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Start off-delay timer" instruction is executed when the signal state of the operand 
"Tag_Input" changes from "1" to "0". The #MyIEC_TIMER timer is started for the time stored 
in the operand "Tag_TIME".

As long as timer #MyIEC_TIMER is running, the query of the time status (#MyIEC_TIMER.Q) 
returns the signal state "1" and operand "Tag_Output" is set. If the timer has expired and the 
operand "Tag_Input" has the signal state "0", the query of the timer status returns the signal 
state "0". If the signal state of the operand "Tag_Input" changes to "1" before timer 
#MyIEC_TIMER expires, the timer is reset. When the signal state of the operand "Tag_Input" 
is "1", the query of the timer status returns the signal state "1".

See also
Overview of the valid data types (Page 1320)

TONR: Time accumulator

Description
You can use the "Time accumulator" instruction to record how long the signal is at the input 
of instruction "1". The instruction is started when the result of logic operation (RLO) changes 
from "0" to "1" (positive signal edge). The time is recorded as long at the RLO is "1". If the RLO 
changes to "0", the instruction is halted. If the RLO changes back to "1", the time recording is 
continued. The query of the timer status for "1" returns the signal state "1" if the recorded time 
exceeds the value of the specified time duration and the RLO at the input of coil is "1".

The timer status and the currently expired timer can be reset to "0" using the "Reset timer" 
instruction.

 

 Note

The start and the query of the IEC Timer may be on different expiry levels as each query of 
the outputs Q or ET updates the IEC_TIMER structure.

 

Programming the PLC
9.7 References

WinCC Professional V13.0
2170 System Manual, 02/2014



For S7-1200 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER 
or TONR_TIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or IEC_TIMER in the "Static" section of 
a block (for example, #MyIEC_TIMER)

For S7-1500 CPU
The "Time accumulator" instruction stores its data in a structure of the data type IEC_TIMER, 
IEC_LTIMER, TONR_TIME or TONR_LTIME. You can declare the structure as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME, TONR_LTIME, IEC_TIMER or 
IEC_LTIMER in the "Static" section of a block (for example, #MyIEC_TIMER)

The instruction data is updated both when the instruction is called and also each time the 
specified timer is accessed.

The current timer status is saved in the structure components ET of the IEC Timer. You can 
query the timer status with the help of a binary logic operation. The query for Q or ET (e. g. 
"MyTimer".Q or "MyTimer".ET) updates the IEC_TIMER structure.

The execution of the "Time accumulator" instruction requires a preceding logic operation. It 
can be placed only at the end of the network.

Parameters
The following table shows the parameters of the "Time accumulator" instruction:

Parameters Declaration Data type Memory area Descripti
onS7-1200 S7-1500

VALUE Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Duration 
with 
which 
the IEC 
Timer 
runs.

<IEC Timer> InOut IEC_TIMER, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TONR_TIME, 
TONR_LTIME

D, L IEC 
Timer 
which is 
started.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Time accumulator" instruction is executed if there is a positive signal edge in the RLO. 
The time is recorded as long as the operand "Tag_Input" has the signal state "1".

If the recorded time exceeds the value of the operand "Tag_TIME", then the query of the timer 
status ("MyIEC_TIMER".Q) will return the signal state "1" and the operand "Tag_Output" will 
be set.

See also
Overview of the valid data types (Page 1320)

RT: Reset timer (Page 2172)

RT: Reset timer

Description
You can use the "Reset timer" instruction to reset an IEC Timer to "0". You specify the IEC 
Timer to be reset by entering the name of the data block that contains the structure of the IEC 
Timer in the placeholder above the instruction.

The instruction is only executed if the result of logic operation (RLO) at the box input is "1". 
When the instruction is executed the structure components of the IEC Timer are reset to "0" 
in the specified data block. If the RLO at box input  is "0", the instruction is not executed.

The instruction does not influence the RLO. The RLO at the box input is transferred directly to 
the box output.

You must assign a IEC Timer declared in the program to the "Reset timer" instruction.

The instruction data is updated only when the instruction is called and not each time the 
assigned IEC Timer is accessed. The query of the data is only identical from the call of the 
instruction to the next call of the instruction.
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Parameters
The following table shows the parameters of the instruction "Reset timer":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

<IEC Timer> InOut IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC Timer, 
which is reset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The IEC Timer stored in the instance data block "TON_DB" 
is started with the time duration that is specified by the operand "Tag_PT".

If the operands "Tag_Input_2" and "Tag_Input_3" have the signal state "1", the "Reset timer" 
instruction is executed and the IEC Timer stored in the data block "TON_DB" is reset.

See also
Overview of the valid data types (Page 1320)
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PT: Load time duration

Description     
Use the "Load time duration" instruction to set the time duration of an IEC Timer. The instruction 
is executed in every cycle when the result of logic operation (RLO) at the input of the instruction 
has the signal state "1". The instruction writes the specified time duration to the structure of 
the specified IEC Timer.

 

 Note

If the specified IEC Timer is running during the execution, the instruction overwrites the 
current time duration of the specified IEC Timer. As a result, the timer status of the IEC Timer 
can change.

 

You must assign a IEC Timer declared in the program to the "Load time duration" instruction.

The instruction data is updated when the instruction is called and each time the assigned IEC 
Timer is accessed. The query for Q or ET (e. g. "MyTimer".Q or "MyTimer".ET) updates the 
IEC_TIMER structure.

Parameters
The following table shows the parameters of the instruction "Load time duration":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

PT Input TIME TIME, LTIME I, Q, M, D, L or 
constant

Time duration

<IEC Timer> InOut IEC_TIMER, 
TP_TIME, 
TON_TIME, 
TOF_TIME, 
TONR_TIME

IEC_TIMER, 
IEC_LTIMER, 
TP_TIME, 
TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

D, L IEC Timer, the 
duration of 
which is set.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "Generate on-delay" instruction executes when the signal state of the "Tag_Input_1" 
operand changes from "0" to "1". The IEC Timer stored in the instance data block "TON_DB" 
is started with the time duration that is specified by the operand "Tag_PT".

The "Load time duration" instruction is executed when the operand "Tag_Input_2" has the 
signal state "1". The instruction writes the time duration "Tag_PT_2" in the instance data block 
"TON_DB" and at the same time overwrites the value of the operand "Tag_PT" within the data 
block. As a result, the signal state of the timer status can change at the next query or upon 
access to "MyTimer".Q or "MyTimer".ET.

 

 Note

The "Tag_Input_2" is executed as pulse flag in order that the time duration is loaded only 
throughout one program cycle.

 

See also
Overview of the valid data types (Page 1320)

SIMATIC Timers

S_PULSE: Assign pulse timer parameters and start

Description
The "Assign pulse timer parameters and start" instruction starts a programmed timer when a 
transition from "0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) 
at input S. The timer expires with the programmed duration (TV) as long as the signal state at 
input S is "1". If the signal state at input S changes to "0" before the programmed duration 
expires, the timer is stopped. In this case, the signal state at output Q is "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
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to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1", the current time value and 
the time base are also set to zero. If the timer is not running, the signal state "1" at the R input 
has no effect.

The "Assign pulse timer parameters and start" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Assign pulse timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign pulse timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer runs for the time value of the "TagIn_Number" operand as long as the "TagIn_1" operand 
has the signal state "1". If the signal state of the operand "TagIn_1" changes from "1" to "0" 
before the timer expires, the timer "Timer_1" is stopped. The "TagOut" operand is reset to 
signal state "0".

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2177



The "TagOut" operand has the signal state "1" as long as the timer is running and the "TagIn_1" 
operand has the signal state "1". When the time has expired or is reset, the "TagOut" operand 
is reset to "0".

See also
Overview of the valid data types (Page 1320)

S_PEXT: Assign extended pulse timer parameters and start

Description
The "Assign extended pulse timer parameters and start" instruction starts a programmed timer 
when a transition from "0" to "1" (positive signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV), even if the signal state 
at input S changes to "0". As long as the timer is running, output Q has the signal state "1". 
When the timer has expired, output Q is reset to "0". If the signal state at input S changes from 
"0" to "1" while the timer is running, the timer is restarted with the duration programmed at 
input TV.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

If the timer is running and the signal state at input R changes to "1", the current time value and 
the time base are also set to zero. If the timer is not running, the signal state "1" at the R input 
has no effect.

The "Assign extended pulse timer parameters and start" instruction needs a preceding logic 
operation for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the "Assign extended pulse timer parameters and 
start" instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign extended pulse timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer runs for the time value of the "TagIn_Number" operand without being affected by a 
negative edge at the S input. If the signal state at the "TagIn_1" operand changes from "0" to 
"1" before the timer expires, the timer is restarted.

The "TagOut" operand has the signal state "1" as long as the timer is running. When the time 
has expired or is reset, the "TagOut" operand is reset to "0".
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See also
Overview of the valid data types (Page 1320)

S_ODT: Assign on-delay timer parameters and start

Description
The "Assign on-delay timer parameters and start" instruction starts a programmed timer when 
a transition from "0" to "1" (positive signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV) as long as the signal 
state at input S is "1". If the timer expires correctly and input S still has signal state "1", output 
Q returns signal state "1". If the signal state at input S changes from "1" to "0" while the timer 
is running, the timer is stopped. In this case, output Q is reset to signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

If the time is running and the signal state at input R changes from "0" to "1", the current time 
value and the time base are also set to zero. In this case, the signal state at output Q is "0". 
The timer is reset if the signal state is "1" at the R input even if the timer is not running and the 
RLO at input S is "1".

The "Assign on-delay timer parameters and start" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the "Assign on-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
2182 System Manual, 02/2014



Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign on-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the value of operand "TagIn_Number". If the timer expires and the signal 
state of the operand is "1", the "TagOut" operand is set to "1". If the signal state at the "TagIn_1" 
operand changes from "1" to "0" before the timer expires, the timer is stopped. The "TagOut" 
operand has the signal state "0".
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See also
Overview of the valid data types (Page 1320)

S_ODTS: Assign retentive on-delay timer parameters and start

Description
The "Assign retentive on-delay timer parameters and start" instruction starts a programmed 
timer when a transition from "0" to "1" (positive signal edge) is detected in the result of logic 
operation (RLO) at input S. The timer expires with the programmed duration (TV), even if the 
signal state at input S changes to "0". If the timer expires, the "Q" output returns signal state 
"1" regardless of the signal state at input "S". If the signal state at input S changes from "0" to 
"1" while the timer is running, the timer is restarted with the duration programmed at input (TV).

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0" regardless of the 
signal state at start input S. In this case, the signal state at output Q is "0".

The "Assign retentive on-delay timer parameters and start" instruction needs a preceding logic 
operation for the edge evaluation and can be placed within or at the end of the network.

The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Parameters
The following table shows the parameters of the "Assign retentive on-delay timer parameters 
and start" instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign retentive on-delay timer 
parameters and start" instruction:
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the time value of the "TagIn_Number" operand, even when the signal state 
of the "TagIn_1" operand changes to "0". When the time expires, the "TagOut" operand is reset 
to "1". If the signal state at the "TagIn_1" operand changes from "0" to "1" while the timer is 
running, the timer is restarted.

See also
Overview of the valid data types (Page 1320)

S_OFFDT:  Assign off-delay timer parameters and start

Description
The "Assign off-delay timer parameters and start" instruction starts a programmed timer when 
a transition from "1" to "0" (negative signal edge) is detected in the result of logic operation 
(RLO) at input S. The timer expires with the programmed duration (TV). As long as the timer 
is running or input S returns signal state "1", output Q has signal state "1". If the timer expires 
and the signal state is "0", output Q is reset to signal state "0". If the signal state at input S 
changes from "0" to "1" while the timer is running, the timer is stopped. The timer is only 
restarted after a falling signal edge is detected at input S.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value. The current time value is 
output binary-coded at output BI and BCD-coded at output BCD.

Signal state "1" at input R resets the current time value and time base to "0". In this case, the 
signal state at output Q is "0".

The "Assign off-delay timer parameters and start" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.
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The instruction data is updated with each access. It can therefore happen that the query of the 
data at the start of the cycle returns different values than at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the "Assign off-delay timer parameters and start" 
instruction:

Parameter Declaration Data type Memory area Description
<Timer> InOut/Input TIMER T Time of the 

instruction
The number of 
timers depends on 
the CPU.

S Input BOOL I, Q, M, T, C, D, L, 
P

Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

R Input BOOL I, Q, M, T, C, D, L, 
P or constant

Reset input

BI Output WORD I, Q, M, D, L, P Current time value 
(binary-coded)

BCD Output WORD I, Q, M, D, L, P Current time value 
(BCD format)

Q Output BOOL I, Q, M, D, L, P Status of the timer

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign off-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "1" to "0". The 
timer expires with the value of operand "TagIn_Number". The "TagOut" operand is set to "1" 
if the timer is running or the "TagIn_1" operand has the signal state "0". If the signal state at 
the "TagIn_1" operand changes from "0" to "1" while the timer is running, the timer is reset.

See also
Overview of the valid data types (Page 1320)
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SP: Start pulse timer

Description
The instruction "Start pulse timer" starts a programmed timer when a change from "0" to "1" 
(positive signal edge) is detected in the result of logic operation (RLO) at the start input. The 
timer runs with the specified duration as long as the RLO has the signal state "1". As long as 
the timer is running, the query of timer status "1" returns the signal state "1". If there is a change 
from "1" to "0" in the RLO before the time value has elapsed, the timer stops. In this case, the 
query for timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.

The "Start pulse timer" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start pulse timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2189



Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the time value of the "TagIn_Number" operand as long as the signal state 
of the "TagIn_1" operand is "1". If the signal state at the "TagIn_1" operand changes from "1" 
to "0" before the timer expires, the timer is stopped. As long as the timer is running, the "TagOut" 
operand returns signal state "1". If the signal state of the "TagIn_1" operand changes from "0" 
to "1", the timer is reset, i.e. the timer is stopped and the current time value is set to "0".

See also
Overview of the valid data types (Page 1320)

SE: Start extended pulse timer

Description
The "Start extended pulse timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) at the start 
input. The timer runs for the specified time period even when the RLO changes to signal state 
"0". As long as the timer is running, the query of timer status "1" returns the signal state "1". If 
the RLO changes from "0" to "1" while the timer is running, the timer is restarted with the 
programmed time period. When the timer expires, the query for timer status for "1" returns the 
signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start extended pulse timer" instruction needs a preceding logic operation for the edge 
evaluation and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start extended pulse timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the time value of the "TagIn_Number" operand without being affected by a 
negative edge at the RLO. As long as the timer is running, the "TagOut" operand returns signal 
state "1". If the signal state at the "TagIn_1" operand changes from "0" to "1" before the timer 
expires, the timer is restarted.

See also
Overview of the valid data types (Page 1320)

SD: Start on-delay timer

Description
The "Start on-delay timer" instruction starts a programmed timer when a change from "0" to 
"1" (positive signal edge) is detected in the result of logic operation (RLO) at the start input. 
The timer runs for the specified period of time as long as the RLO is "1". If the timer expires 
and the RLO has the signal state "1", the query timer status "1" returns the signal state "1". If 
the RLO changes from "1" to "0" while the timer is running, the timer is stopped. In this case, 
querying the timer status for "1" returns the signal state "0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start on-delay timer" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start on-delay timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the value of operand "TagIn_Number". If the timer expires and the RLO has 
the signal state "1", the "TagOut" operand is set to "1". If the signal state at the "TagIn_1" 
operand changes from "1" to "0" before the timer expires, the timer is stopped. If the signal 
state of the "TagIn_2" operand changes to "1", "Timer_1" is reset, i.e. the timer is stopped and 
the current time value is set to "0".

See also
Overview of the valid data types (Page 1320)

SS: Start retentive on-delay timer

Description
The "Start retentive on-delay timer" instruction starts a programmed timer when a change from 
"0" to "1" (positive signal edge) is detected in the result of logic operation (RLO) at the start 
input. The timer runs for the specified time period even when the RLO changes to signal state 
"0". When the timer expires, the query for timer status for "1" returns the signal state "1". When 
the timer expires, the timer can only be restarted if it is explicitly reset.

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.
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The "Start retentive on-delay timer" instruction needs a preceding logic operation for the edge 
evaluation and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start retentive on-delay timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "0" to "1". The 
timer expires with the value of operand "TagIn_Number". When the time expires, the "TagOut" 
operand is reset to "1". If the signal state at the "TagIn_1" operand changes from "0" to "1" 
while the timer is running, the timer is restarted. If the signal state of the "TagIn_2" operand 
changes to "1", "Timer_1" is reset, i.e. the timer is stopped and the current time value is set to 
"0".

See also
Overview of the valid data types (Page 1320)

SF: Start off-delay timer

Description
The "Start off-delay timer" instruction starts a programmed timer when a change from "1" to 
"0" (negative signal edge) is detected in the result of logic operation (RLO) at the start input. 
The timer runs for the specified time period. As long as the timer is running, the query of timer 
status "1" returns the signal state "1". If the RLO changes from "0" to "1" while the timer is 
running, the timer is reset. The timer is always restarted when the RLO changes from "1" to 
"0".

The duration is made up internally of a time value and a time base and is programmed at 
parameter TV. When the instruction is started, the programmed time value is counted down 
to zero. The time base determines the time period of the time value.

Programming the PLC
9.7 References

WinCC Professional V13.0
2196 System Manual, 02/2014



The "Start off-delay timer" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Parameters
The following table shows the parameters of the instruction "Start off-delay timer":

Parameter Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L, 

P
Start input

TV Input S5TIME, WORD I, Q, M, D, L or 
constant

Time duration

<Timer> InOut/Input TIMER T Timer which is 
started.
The number of 
timers depends on 
the CPU.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

"Timer_1" starts when the signal state of the "TagIn_1" operand changes from "1" to "0". The 
timer expires with the value of operand "TagIn_Number".  As long as the timer is running, the 
"TagOut" operand is set to "1". If the signal state at the "TagIn_1" operand changes from "1" 
to "0" while the timer is running, the timer is restarted. If the signal state of the "TagIn_2" 
operand changes to "1", "Timer_1" is reset, i.e. the timer is stopped and the current time value 
is set to "0".

See also
Overview of the valid data types (Page 1320)

Counter operations

 

CTU: Count up

Description
You can use the "Count up" instruction to increment the value at output CV. When the signal 
state at the CU input changes from "0" to "1" (positive signal edge), the instruction is executed 
and the current counter value at the CV output is incremented by one. When the instruction 
executes for the first time, the current counter value at the CV output is set to zero. The counter 
is incremented each time a positive signal edge is detected, until it reaches the high limit for 
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the specified data type at output CV. When the high limit is reached, the signal state at the CU 
input no longer has an effect on the instruction.

You can scan the counter status at the Q output. The signal state at the Q output is determined 
by the PV parameter. If the current counter value is greater than or equal to the value of the 
PV parameter, the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0". You can also specify a constant for the PV parameter.

The value at the CV output is reset to "0" and saved to an edge memory bit when the signal 
state at input R changes to "1". As long as the R input has the signal state "1", the signal state 
at the CU input has no effect on the instruction.

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Each call of the "Count up" instruction must be assigned an IEC counter in which the instruction 
data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● CTU_LINT / CTU_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:
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● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTU_<Data type> or IEC_<Counter> in the "Static" 
section of a block (for example #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, it is 
saved to the "Program resources" folder in the "Program blocks > System blocks" path of the 
project tree. For additional information on this topic, refer to "See also".

When you set up the IEC counter in a separate data block (single instance), the instance data 
block is created by default with "optimized block access" and the individual tags are defined 
as retentive. For additional information on setting retentivity in an instance data block, refer to 
"See also".

When you set up the IEC counter as local tag (multiple instance) in a function block with 
"optimized block access", it is defined as retentive in the block interface.

The execution of the "Count up" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count up" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

CU Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count input

R Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Reset input

PV Input Integers I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Value at which 
the output Q is 
set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Counter status
CV Output Integers, 

CHAR, DATE
I, Q, M, D, L, 
P

I, Q, M, D, L, P Current 
counter value 

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
2200 System Manual, 02/2014



Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count up" 
instruction executes and the current counter value of the "Tag_CV" operand is incremented 
by one. With each additional positive signal edge, the counter value is incremented until the 
high limit of the specified data type (INT = 32767) is reached.

The value of the PV parameter is adopted as the limit for determining the "TagOut" output. 
The "TagOut" output has signal state "1" as long as the current counter value is greater than 
or equal to the value of the "Tag_PV" operand. In all other cases, the "TagOut" output returns 
the signal state "0".

See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

CTD: Count down

Description
You can use the "Count down" instruction to decrement the value at output CV. When the 
signal state at the CD input changes from "0" to "1" (positive signal edge), the instruction is 
executed and the current counter value at the CV output is decremented by one. When the 
instruction is executed the first time, the counter value of the CV parameter is set to the value 
of the PV parameter. Each time a positive signal edge is detected, the counter value is 
decremented until it reaches the low limit of the specified data type. When the low limit is 
reached, the signal state at the CD input no longer has an effect on the instruction.

You can scan the counter status at the Q output. If the current counter value is less than or 
equal to "0", the Q output is set to signal state "1". In all other cases, the Q output has signal 
state "0". You can also specify a constant for the PV parameter.
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The value at the CV output is set to the value of the PV parameter and saved to a edge memory 
bit when the signal state at the LD input changes from "0" to "1". As long as the LD input has 
the signal state "1", the signal state at the CD input has no effect on the instruction.

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Each call of the "Count down" instruction must be assigned an IEC counter in which the 
instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● CTD_LINT / CTD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTD_<Data type> or IEC_<Counter> in the "Static" 
section of a block (for example #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, it is 
saved to the "Program resources" folder in the "Program blocks > System blocks" path of the 
project tree. For additional information on this topic, refer to "See also".
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When you set up the IEC counter in a separate data block (single instance), the instance data 
block is created by default with "optimized block access" and the individual tags are defined 
as retentive. For additional information on setting retentivity in an instance data block, refer to 
"See also".

When you set up the IEC counter as local tag (multiple instance) in a function block with 
"optimized block access", it is defined as retentive in the block interface.

The execution of the "Count down" instruction requires a preceding logic operation. It can be 
placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Count down" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

CD Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count input

LD Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Load input

PV Input Integers I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Value at which 
the output Q is 
set.

Q Output BOOL I, Q, M, D, L I, Q, M, D, L Counter status
CV Output Integers, 

CHAR, DATE
I, Q, M, D, L, 
P

I, Q, M, D, L, P Current 
counter value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the "TagIn_1" operand changes from "0" to "1", the "Count down" 
instruction executes and the value at the "Tag_CV" output is decremented by one. With each 
additional positive signal edge, the counter value is decremented until the low limit of the 
specified data type (INT = -32768) is reached.
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The value of the PV parameter is adopted as the limit for determining the "TagOut" output. 
The "TagOut" output has signal state "1" as long as the current counter value is less than or 
equal to "0". In all other cases, the "TagOut" output returns the signal state "0".

See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

CTUD: Count up and down

Description
You can use the "Count up and down" instruction to increment and decrement the counter 
value at the CV output. If the signal state at the CU input changes from "0" to "1" (positive 
signal edge), the current counter value is incremented by one and stored at the CV output. If 
the signal state at the CD input changes from "0" to "1" (positive signal edge), the current 
counter value at the CV output is decremented by one. If there is a positive signal edge at the 
CU and CD inputs in one program cycle, the current counter value at the CV output remains 
unchanged.

The counter value can be incremented until it reaches the high limit of the data type specified 
at the CV output. When the high limit is reached, the counter value is no longer incremented 
on a positive signal edge. When the low limit of the specified data type is reached, the counter 
value is not decremented any further.

When the signal state at the LD input changes to "1", the counter value at the CV output is set 
to the value of the PV parameter and stored in a edge memory bit. As long as the LD input 
has the signal state "1", the signal state at the CU and CD inputs has no effect on the instruction.

The counter value is set to "0" and stored in an edge memory bit when the signal state at input 
R changes to "1". As long as the R input has the signal state "1", a change in the signal state 
of the CU, CD and LD inputs has no effect on the "Count up and down" instruction.

You can scan the current status of the up counter at the QU output. If the current counter value 
is greater than or equal to the value of the PV parameter, the QU output is set to signal state 
"1". In all other cases, the QU output has signal state "0". You can also specify a constant for 
the PV parameter.

You can scan the current status of the down counter at the QD output. If the current counter 
value is less than or equal to zero, the QD output is set to signal state "1". In all other cases, 
the QD output has signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Each call of the "Count up and down" instruction must be assigned an IEC counter in which 
the instruction data is stored. An IEC counter is a structure with one of the following data types:
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For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● CTUD_LINT / CTUD_ULINT
● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTUD_<Data type> or IEC_<Counter> in the "Static" 
section of a block (for example #MyIEC_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, it is 
saved to the "Program resources" folder in the "Program blocks > System blocks" path of the 
project tree. For additional information on this topic, refer to "See also".

When you set up the IEC counter in a separate data block (single instance), the instance data 
block is created by default with "optimized block access" and the individual tags are defined 
as retentive. For additional information on setting retentivity in an instance data block, refer to 
"See also".

When you set up the IEC counter as local tag (multiple instance) in a function block with 
"optimized block access", it is defined as retentive in the block interface.

The execution of the "Count up and down" instruction requires a preceding logic operation. It 
can be placed within or at the end of the network.
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Parameters
The following table shows the parameters of the "Count up and down" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CU Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count up input

CD Input BOOL I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Count down 
input

R Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Reset input

LD Input BOOL I, Q, M, D, L, 
P or constant

I, Q, M, T, C, D, 
L, P or constant

Load input

PV Input Integers I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Value at which 
the output QU 
is set.

QU Output BOOL I, Q, M, D, L I, Q, M, D, L Up-counter 
status

QD Output BOOL I, Q, M, D, L I, Q, M, D, L Down-counter 
status

CV Output Integers, 
CHAR, DATE

I, Q, M, D, L, 
P

I, Q, M, D, L, P Current 
counter value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the signal state at the "TagIn_CU" or "TagIn_CD" input changes from "0" to "1" (positive 
signal edge), the "Count up and down" instruction is executed. When there is a positive signal 
edge at the "TagIn_CU" input, the current counter value is incremented by one and stored at 
the "Tag_CV" output. When there is a positive signal edge at the "TagIn_CD" input, the counter 
value is decremented by one and stored at the "Tag_CV" output. When there is a positive edge 
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at the CU input, the counter value is incremented until it reaches the high limit (INT = 32767). 
If input CD has a positive signal edge, the counter value is decremented until it reaches the 
low limit (INT = -32768).

The "TagOut_GU" output has signal state "1" as long as the current counter value is greater 
than or equal to the value at the "Tag_PV" input. In all other cases, the "TagOut_QU" output 
returns the signal state "0".

The "TagOut_QD" output has signal state "1" as long as the current counter value is less than 
or equal to "0". In all other cases, the "TagOut_QD" output has signal state "0".

See also
Overview of the valid data types (Page 1320)

Example of detecting the fill level of a storage area  (Page 1842)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

SIMATIC counters

S_CUD: Assign parameters and count up / down

Description
You can use the "Assign parameters and count up / down" instruction to increment or 
decrement the value of a counter. If the signal state at the CU input changes from "0" to "1" 
(positive signal edge), the current counter value is incremented by one. If the signal state at 
the CD input changes from "0" to "1" (positive signal edge), the counter value is decremented 
by one. The current counter value is output as a hexadecimal value at output CV and BCD-
coded at output CV_BCD. If there is a positive signal edge at the CU and CD inputs in one 
program cycle, the counter value remains unchanged.

The counter value is incremented until the high limit of "999" is reached. When the high limit 
value is reached, the counter value is no longer incremented on a positive signal edge. When 
the low limit of "0" is reached, the counter value is no longer decremented.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO is "1" at the inputs CU and CD, the counter 
counts accordingly in the next scan cycle, even if no change in the signal edge is detected.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU, CD and S 
inputs has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
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The "Assign parameters and count up / down" instruction needs a preceding logic operation 
for the edge evaluation and can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Assign parameters and count up / down" 
instruction:

Parameters Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L, T, C Count up input
CD Input BOOL I, Q, M, D, L, T, C 

or constant
Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the signal state at the "TagIn_1" or "TagIn_2" input changes from "0" to "1" (positive signal 
edge), the "Assign parameters and count up / down" instruction is executed. When there is a 
positive signal edge at the "TagIn_1" input and the current counter value is less than "999", 
the counter value is incremented by one. When there is a positive signal edge at the "TagIn_2" 
input and the current counter value is greater than "0", the counter value is decremented by 
one.

When the signal state at the "TagIn_3" input changes from "0" to "1", the counter value is set 
to the value of the "TagPresetValue" operand. The counter value is reset to "0" when the 
"TagIn_4" operand has signal state "1".

The current counter value is hexadecimal in the "TagValue_1" operand and BCD-coded in the 
"TagValue_2" operand.

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1320)

S_CU: Assign parameters and count up

Description
You can use the "Assign parameters and count up" instruction to increment the value of a 
counter. If the signal state at the CU input changes from "0" to "1" (positive signal edge), the 
current counter value is incremented by one. The current counter value is output as a 
hexadecimal value at output CV and BCD-coded at output CV_BCD. The count is incremented 
until the limit of "999" is reached. When the limit is reached, the counter value is no longer 
incremented on a positive signal edge.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CU is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.
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The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CU and S inputs 
has no effect on the counter value.

The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

The "Assign parameters and count up" instruction needs a preceding logic operation for the 
edge evaluation and can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Assign parameters and count up" instruction:

Parameters Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CU Input BOOL I, Q, M, D, L, T, C Count up input
S Input BOOL I, Q, M, D, L, T, C 

or constant
Input for 
presetting counter

PV Input WORD I, Q, M, D, L or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is less than "999", the counter value is incremented by one. When 
the signal state at the "TagIn_2" input changes from "0" to "1", the counter value is set to the 
value of the "TagPresetValue" operand. The counter value is reset to "0" when the "TagIn_3" 
operand has signal state "1".

The current counter value is hexadecimal in the "TagValue_1" operand and BCD-coded in the 
"TagValue_2" operand.

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1320)

S_CD: Assign parameters and count down

Description
You can use the "Assign parameters and count down" instruction to decrement the value of a 
counter. If the signal state at the CD input changes from "0" to "1" (positive signal edge), the 
counter value is decremented by one. The current counter value is output as a hexadecimal 
value at output CV and BCD-coded at output CV_BCD. The count is decremented until the 
low limit of "0" is reached. When the low limit is reached, the counter value is no longer 
decremented on a positive signal edge.

When the signal state at input S changes from "0" to "1", the counter value is set to the value 
of the PV parameter. If the counter is set and if RLO at input CD is "1", the counter will count 
accordingly in the next scan cycle, even when no change has been detected in the signal edge.

The counter value is set to zero when the signal state at the R input changes to "1". As long 
as the R input has the signal state "1", processing of the signal state of the CD and S inputs 
has no effect on the counter value.
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The signal state at output Q is "1" if the counter value is greater than zero. If the counter value 
is equal to zero, output Q has the signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

The "Assign parameters and count down" instruction needs a preceding logic operation for the 
edge evaluation and can be placed within or at the end of the network.

Parameters
The following table shows the parameters of the "Assign parameters and count down" 
instruction:

Parameters Declaration Data type Memory area Description
<Counter> InOut/Input COUNTER C Counter of the 

instruction
The number of 
counters depends 
on the CPU.

CD Input BOOL I, Q, M, D, L or 
constant

Count down input

S Input BOOL I, Q, M, D, L, T, C 
or constant

Input for 
presetting counter

PV Input WORD I, Q, M, D, L or 
constant

Preset counter 
value (C#0 to 
C#999)

R Input BOOL I, Q, M, D, L, T, C 
or constant

Reset input

CV Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value 
(hexadecimal)

CV_BCD Output WORD, S5TIME, 
DATE

I, Q, M, D, L Current counter 
value (BCD 
format)

Q Output BOOL I, Q, M, D, L Status of the 
counter

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

When the signal state at the "TagIn_1" input changes from "0" to "1" (positive signal edge) and 
the current counter value is greater than "0", the counter value is decremented by one. When 
the signal state at the "TagIn_2" input changes from "0" to "1", the counter value is set to the 
value of the "TagPresetValue" operand. The counter value is reset to "0" when the "TagIn_3" 
operand has signal state "1".

The current counter value is hexadecimal in the "TagValue_1" operand and BCD-coded in the 
"TagValue_2" operand.

The "TagOut" output has the signal state "1" as long as the current counter value is not equal 
to "0".

See also
Overview of the valid data types (Page 1320)

SC: Set counter value

Description
You can use the "Set counter value" instruction to set the value of a counter. The instruction 
is executed when the result of logic operation (RLO) at the start input of the instruction changes 
from "0" to "1". When the instruction is executed, the counter is set to the specified counter 
value.

The "Set counter value" instruction needs a preceding logic operation for the edge evaluation 
and can only be placed on the right edge of the network.
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Parameters
The following table lists the parameters of the "Set counter value" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L Start input
CV Input WORD I, Q, M, D, L or 

constant
Value with which 
the counter is 
preset in the BCD 
format.
(C#0 to C#999)

<Counter> InOut/Input COUNTER C Counter that is 
preset.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

the counter "Counter_1" starts with the value "100" when the signal state of the "TagIn" operand 
changes from "0" to "1".

See also
Overview of the valid data types (Page 1320)

CU: Count up

Description
You use the "Count up" instruction to increment the value of the specified counter by the count 
of one on a rising edge at the start input. The count is incremented until the limit of "999" is 
reached. When the limit is reached, the counter value is no longer incremented on a positive 
signal edge.

The "Count up" instruction needs a preceding logic operation for the edge evaluation and can 
only be placed on the right edge of the network.
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Parameters
The following table shows the parameters of the "Count up" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L Start input
<Counter> InOut/Input COUNTER C Counter whose 

value is 
incremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the operand "TagIn_1" changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".

The value of "Counter_1" is incremented by the count of one when the signal state of the 
"TagIn_2" operand changes from "0" to "1". 

If the "TagIn_3" operand returns signal state "1", the value of "Counter_1" is reset to "0".

See also
Overview of the valid data types (Page 1320)
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CD: Count down

Description
You use the "Count down" instruction to decrement the value of the specified counter by the 
count of one on a rising edge at the start input. The count is decremented until the limit of "0" 
is reached. When the limit is reached, the counter value is no longer changed on a positive 
signal edge.

The "Count down" instruction needs a preceding logic operation for the edge evaluation and 
can only be placed on the right edge of the network.

Parameters
The following table shows the parameters of the "Count down" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input BOOL I, Q, M, T, C, D, L Start input
<Counter> InOut/Input COUNTER C Counter whose 

value is 
decremented.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

When the signal state of the operand "TagIn_1" changes from "0" to "1" (positive signal edge), 
the counter "Counter_1" is preset with the value "100".
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The value of "Counter_1" is incremented by the count of one when the signal state of the 
"TagIn_2" operand changes from "0" to "1". 

If the "TagIn_3" operand returns signal state "1", the value of "Counter_1" is reset to "0".

See also
Overview of the valid data types (Page 1320)

 

CMP ==: Equal

Description
You can use the "Equal" instruction to query whether the value at input IN1  is equal to the 
value at input IN2.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison.

The following table lists examples of string comparisons:

IN1 IN2 RLO of the instruction
'AA' 'AA' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0

The "Equal" instruction also compares individual characters of a string. The number of the 
character to be compared is specified in square brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

If IEC check is enabled, the operands to be compared must be of the same data type. If IEC 
check is not enabled, the width (length) of the operands must be the same. If the floating-point 
numbers are being compared, the operands to be compared must be of the same data type 
regardless of the IEC check setting.

 

 Note
Comparison of floating-point numbers

If you want to compare the data types REAL or LREAL, instead of the instruction "CMP ==: 
Equal", use the instruction "IN_RANGE: Value within range".
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 Note
Comparison of the data type PORT

To be able to compare the operands of the PORT data type with the "Equal" instruction, you 
need to select the WORD data type from the drop-down list of the instructions box.

 

Parameters
The following table lists the parameters of the "Equal" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" = "Tag_Value2".
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See also
Overview of the valid data types (Page 1320)

CMP <>: Not equal

Description
You can use the "Not equal" instruction to query whether the value at input IN1  is not equal 
to the value at input IN2.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison.

The following table lists examples of string comparisons:

IN1 IN2 RLO of the instruction
'AA' 'aa' 1
'Hello World' 'HelloWorld' 1
'AA' 'AA' 0

The "Not equal" instruction also compares individual characters of a string. The number of the 
character to be compared is specified in square brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

If IEC check is enabled, the operands to be compared must be of the same data type. If IEC 
check is not enabled, the width (length) of the operands must be the same. If the floating-point 
numbers are being compared, the operands to be compared must be of the same data type 
regardless of the IEC check setting.

 

 Note
Comparison of the data type PORT

To be able to compare the operands of the PORT data type with the "Not equal" instruction, 
you need to select the WORD data type from the drop-down list of the instructions box.
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Parameters
The following table lists the parameters of the "Not equal" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Bit strings, 
integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" <> "Tag_Value2".

See also
Overview of the valid data types (Page 1320)
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CMP >=: Greater or equal

Description
You can use the "Greater or equal" instruction to query whether the value at input IN1  is greater 
or equal to the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the longer string is considered greater.

The following table lists examples of string comparisons:

IN1 IN2 RLO of the instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'Hello World' 'Hello World' 1
'Hello World' 'HelloWorld' 0
'AA' 'aa' 0
'AAA' 'a' 0

The "Greater or equal" instruction also compares individual characters of a string. The number 
of the character to be compared is specified in square brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

In comparing timer values, the RLO of the instruction is "1" if the timer at input  IN1 is greater 
(more recent) than or equal to the timer at input IN2.
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Parameters
The following table lists the parameters of the "Greater or equal" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" >= "Tag_Value2".

See also
Overview of the valid data types (Page 1320)

Example of detecting the fill level of a storage area  (Page 1842)
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CMP <=: Less or equal

Description
You can use the "Less or equal" instruction to query whether the value at input IN1  is less or 
equal to the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the shorter string is considered smaller. 

The following table lists examples of string comparisons:

IN1 IN2 RLO of the instruction
'AA' 'aa' 1
'AAA' 'a' 1
'Hello World' 'Hello World' 1
'HelloWorld' 'Hello World' 0
'BB' 'AA' 0
'AAA' 'AA' 0

The "Less or equal" instruction also compares individual characters of a string. The number 
of the character to be compared is specified in square brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

In comparing timer values, the RLO of the instruction is "1" if the timer at input IN1 is smaller 
(less recent) than or equal to the timer at input IN2.
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Parameters
The following table lists the parameters of the "Less or equal" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" <= "Tag_Value2".

See also
Overview of the valid data types (Page 1320)
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CMP >: Greater than

Description
You can use the "Greater than" instruction to query whether the value at input IN1  is greater 
than the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the longer string is considered greater.

The following table lists examples of string comparisons:

IN1 IN2 RLO of the instruction
'BB' 'AA' 1
'AAA' 'AA' 1
'AA' 'aa' 0
'AAA' 'a' 0

The "Greater than" instruction also compares individual characters of a string. The number of 
the character to be compared is specified in square brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.

In comparing timer values, the RLO of the instruction is "1" if the timer at input IN1 is greater 
(more recent) than the timer at input IN2.

Parameters
The following table lists the parameters of the "Greater than" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare
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You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" > "Tag_Value2".

See also
Overview of the valid data types (Page 1320)

CMP <: Less than

Description
You can use the "Less than" instruction to query whether the value at input IN1  is less than 
the value at input IN2. Both values to be compared must be of the same data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

The individual characters are compared by means of their code (for example, 'a' is greater 
than 'A') during the comparison of the strings. The comparison is performed from left to right. 
The first character to be different decides the result of the comparison. If the left part of the 
longer string is identical to the shorter string, the shorter string is considered smaller.

The following table lists examples of string comparisons:

<Operand1> <Operand2> RLO of the instruction
'AA' 'aa' 1
'AAA' 'a' 1
'BB' 'AA' 0
'AAA' 'AA' 0

The "Less than" instruction also compares individual characters of a string. The number of the 
character to be compared is specified in square brackets next to the operand name. 
"MyString[2]", for example, compares the second character of the "MyString" string.
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In comparing timer values, the RLO of the instruction is "1" if the timer at input IN1 is less (less 
recent) than the timer at input IN2 .

Parameters
The following table lists the parameters of the "Less than" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

First 
comparison 
value

IN2 Input Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
DATE, TOD, 
DTL

Integers, 
floating-point 
numbers, 
character 
strings, TIME, 
LTIME, DATE, 
TOD, LTOD, 
DTL, DT, LDT

I, Q, M, D, L, P 
or constant

Second value 
to compare

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn_1" has the signal state "1".

● The condition of the comparison instruction is fulfilled if "Tag_Value1" < "Tag_Value2".

See also
Overview of the valid data types (Page 1320)

Example of detecting the fill level of a storage area  (Page 1842)
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IN_RANGE: Value within range

Description     
You can use the "Value within range" instruction to query whether of the value at input VAL is 
within a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value within range" 
instruction compares the value at input VAL with the values of the inputs MIN and MAX and 
sends the result to the box output. If the value at input VAL satisfies the comparison MIN <= 
VAL or VAL <=MAX, the box output has the signal state "1". If the comparison is not fulfilled, 
the signal state is "0" at the box output.

The comparison function can only execute if the values to be compared are of the same data 
type.

Parameters
The following table shows the parameters of the "Value within range" instruction:

Parameters Declaration Data type Memory area Description
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:
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● The operands "TagIn_1" or "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "1".

● The value of the operand "Tag_Value" is within the value range that is specified by the 
current values of the operands "Tag_Min" and "Tag_Max" (MIN <= VAL or VAL <= MAX).

See also
Overview of the valid data types (Page 1320)

OUT_RANGE: Value outside range

Description     
You can use the "Value outside range" instruction to query whether of the value at input VAL 
is outside a specific value range.

You specify the limits of the value range with the MIN and MAX inputs. The "Value outside 
range" instruction compares the value at input VAL with the values of the inputs MIN and MAX  
and sends the result to the box output. If the value at input VAL satisfies the comparison MIN 
> VAL or VAL >MAX, the box output has the signal state "1". The box output has the signal 
state "1" if a specified operand of data type REAL has an invalid value.

The box output returns the signal state "0", if the value at input VAL does not satisfy the MIN 
> VAL or VAL > MAX  condition.

The comparison function can only execute if the values to be compared are of the same data 
type.

Parameters 
The following table shows the parameters of the "Value outside range" instruction:

Parameters Declaration Data type Memory area Description
MIN Input Integers, floating-

point numbers
I, Q, M, D, L or 
constant

Low limit of the 
value range

VAL Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

Comparison value

MAX Input Integers, floating-
point numbers

I, Q, M, D, L or 
constant

High limit of the 
value range

Box output Output BOOL I, Q, M, D, L Result of the 
comparison

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

Output "TagOut" is set when the following conditions are fulfilled:

● The operands "TagIn_1" and "TagIn_2" have signal state "1".

● The operand "TagIn_3" has the signal state "1".

● The value of the operand "Tag_Value" is outside the value range that is specified by the 
values of the operands "Tag_Min" and "Tag_Max" (MIN > VAL or VAL > MAX).

See also
Overview of the valid data types (Page 1320)

OK: Check validity

Description     
You can use the "Check validity" instruction to check if the value of an operand (<Operand>) 
is a valid floating-point number. The check is performed in every program cycle. If the operand 
value at the time of the query is a valid floating-point number, the output box will return the 
signal state"1". In all other cases, the signal state at the output of the "Check validity" instruction 
is "0".

You can use the "Check validity" instruction together with the EN mechanism. If you connect 
the instruction box to an EN enable input, the enable input is set only when the result of the 
validity query of the value is positive. You can use this function to ensure that an instruction is 
enabled only when the value of the specified operand is a valid floating-point number.

Parameters
The following example shows how the "Check validity" instruction works:

Parameters Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

checked.

For additional information on valid data types, refer to "See also":
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Example
The following example shows how the instruction works:

When the values of the operands "Tag_Value1" and "Tag_Value2" show valid floating-point 
numbers, the "Multiply" (MUL) instruction is activated and the ENO output is set. During the 
execution of the "Multiply" (MUL) instruction, the value of the operand "Tag_Value1" is 
multiplied by the value of operand "Tag_Value2". The product of the multiplication is then stored 
in the operand "Tag_Result". If no errors occur during the execution of the instruction, the 
outputs ENO and "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

NOT_OK: Check invalidity

Description     
You can use the "Check invalidity" instruction to check if the value of an operand (<Operand>) 
is an invalid floating-point number. The check is performed in every program cycle. If the 
operand value at the time of the query is a valid floating-point number, then the output box will 
return the signal state "1". In all other cases, the signal state on the output box is "0".

Parameters
The following table shows the parameters of the instruction "Check invalidity":

Parameters Declaration Data type Memory area Description
<Operand> Input Floating-point 

numbers
I, Q, M, D, L Value to be 

checked.

For additional information on valid data types, refer to "See also":
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Example
The following example shows how the instruction works:

When the value of operand "TagIn_Value" is an invalid floating-point number, the instruction 
"Move value" (MOVE) is not executed. The "TagOut" output is reset to signal state "0".

See also
Overview of the valid data types (Page 1320)

VARIANT instructions

EQ_Type: Compare data type for EQUAL with the data type of a tag

Description
You can use the "Compare data type for EQUAL with the data type of a tag" instruction to 
query the data type of a tag to which a VARIANT points. You compare the data type of the tag 
to the data type of a tag that you have declared in the block interface to determine if they are 
"Equal".

The IN1 parameter must have the same VARIANT data type. The IN2 parameter can be an 
elementary data type or a PLC data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

Parameters
The following table shows the parameters of the "Compare data type for EQUAL with the data 
type of a tag" instruction:

Parameters Declaration Data type Memory area Description
IN1 Input VARIANT L First operand
IN2 Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn" has the signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

NE_Type: Compare data type for UNEQUAL with the data type of a tag

Description
You can use the "Compare data type for UNEQUAL with the data type of a tag" instruction to 
query which data type the tag to which a VARIANT points does not have. You compare the 
data type of the tag to the data type of a tag that you have declared in the block interface to 
determine if they are "Unequal".

The IN1 parameter must have the same VARIANT data type. The IN2 parameter can be an 
elementary data type or a PLC data type.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

Parameters
The following table shows the parameters of the "Compare data type for UNEQUAL with the 
data type of a tag" instruction:

Parameters Declaration Data type Memory area Description
IN1 Input VARIANT L First operand
IN2 Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn" has the signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is not equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

EQ_ElemType: Compare element data type for EQUAL with the data type of a tag

Description
You can use the "Compare element data type for EQUAL with the data type of a tag" instruction 
to query the data type of a tag to which a VARIANT points. You compare the data type of the 
tag to the data type of a tag that you have declared in the block interface to determine if they 
are "Equal".

The IN1 parameter must have the same VARIANT data type. The IN2 parameter can be an 
elementary data type or a PLC data type.

If the data type of the VARIANT tag is an ARRAY, the data type of the ARRAY elements is 
compared.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

Parameters
The following table shows the parameters of the "Compare element data type for EQUAL with 
the data type of a tag" instruction:

Parameters Declaration Data type Memory area Description
IN1 Input VARIANT L First operand
IN2 Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".

Programming the PLC
9.7 References

WinCC Professional V13.0
2234 System Manual, 02/2014



Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn" has the signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

NE_ElemType: Compare element data type for UNEQUAL with the data type of a tag

Description
You can use the "Compare element data type for UNEQUAL with the data type of a tag" 
instruction to query which data type the tag to which a VARIANT points does not have. You 
compare the data type of the tag to the data type of a tag that you have declared in the block 
interface to determine if they are "Unequal".

The IN1 parameter must have the same VARIANT data type. The IN2 parameter can be an 
elementary data type or a PLC data type.

If the data type of the VARIANT tag is an ARRAY, the data type of the ARRAY elements is 
compared.

If the condition of the comparison is fulfilled, the instruction returns the result of logic operation 
(RLO) "1". If the comparison condition is not fulfilled, the instruction returns RLO "0".

Parameters
The following table shows the parameters of the "Compare element data type for UNEQUAL 
with the data type of a tag" instruction:

Parameters Declaration Data type Memory area Description
IN1 Input VARIANT L First operand
IN2 Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY, PLC 
data types

I, Q, M, D, L Second operand

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operand "TagIn" has the signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand1" operand 
is not equal to "Tag_Operand2".

See also
Overview of the valid data types (Page 1320)

IS_NULL: Compare for EQUALS ZERO

Description
You can use the instruction "Compare for EQUALS ZERO" to query whether the VARIANT 
does not point to an object.

The <Operand> must have the VARIANT data type.
 

 Note
VARIANT tag points to an ANY pointer

If the VARIANT tag points to an ANY pointer, the instruction always returns the result RLO 
= "0" even if the ANY pointer is ZERO.

 

Parameters
The following table shows the parameters of the "Compare for EQUALS ZERO" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input VARIANT L Operand that is 

compared for EQUAL 
ZERO

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "Tag_In1" and "Tag_In2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand" operand 
does not point to an object.

See also
Overview of the valid data types (Page 1320)

NOT_NULL: Compare for UNEQUALS ZERO

Description
You can use the instruction "Compare for UNEQUALS ZERO" to query whether the VARIANT 
points to an object.

The <Operand> must have the VARIANT data type.
 

 Note
VARIANT tag points to an ANY pointer

If the VARIANT tag points to an ANY pointer, the instruction always returns the result RLO 
= "1" even if the ANY pointer is ZERO.

 

Parameters
The following table shows the parameters of the "Compare for UNEQUALS ZERO" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input VARIANT L Operand that is 

compared for NOT 
EQUAL ZERO

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "Tag_In1" and "Tag_In2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_Operand" operand 
points to an object.

See also
Overview of the valid data types (Page 1320)

IS_ARRAY: Check for ARRAY

Description
You can use the "Check for ARRAY" instruction to query whether the VARIANT points to a tag 
of the ARRAY data type.

The <Operand> must have the VARIANT data type.

Parameters
The following table shows the parameters of the "Check for ARRAY" instruction:

Parameters Declaration Data type Memory area Description
<Operand> Input VARIANT L Operand that is 

queried for ARRAY

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The "TagOut" output is set when the following conditions are fulfilled:

● The operands "Tag_In1" and "Tag_In2" have signal state "1".

● The condition of the comparison instruction is fulfilled, i.e. the "#Tag_VARIANTToArray" 
operand has the ARRAY data type.

See also
Overview of the valid data types (Page 1320)

 

CALCULATE: Calculate

Description
The "Calculate" instruction is used to define and execute an expression for the calculation of 
mathematical operations or complex logic operations depending on the selected data type.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. Depending on the selected data type, you can combine the functionality of specific 
instructions to execute a complex calculation. The expression to be calculated is specified via 
a dialog you can open via the "Calculator" icon at the top of the instruction box. The expression 
can contain the names of the input parameters and the syntax of the instructions. It is not 
permitted to specify operand names or operand addresses.

In its initial state, the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box.

The values of the inputs are use to execute the specified expression. Not all defined inputs 
have to be used in the expression. The result of the instruction is transferred to the box output 
OUT.

 

 Note

If one of the mathematical operations fails in the expression, then no result is transferred to 
the OUT output and the ENO enable output has the signal state "1".
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If, in the expression, you use inputs that are not available in the box, these inputs are 
automatically inserted. Provided that there are no gaps in the numbering of the inputs that are 
to be newly defined in the expression.  You cannot, for example, use the input IN4 in the 
expression if the input IN3 is not defined.

Enable output ENO has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The result or an interim result of the "Calculate" instruction is outside the range permitted 
for the data type specified at output OUT.

● A floating-point number has an invalid value.

● An error occurred during the execution of one of the instructions specified in the expression.

The following table shows the instructions that, depending on the selected data type, can be 
combined and executed in the expression of the "Calculate" instruction:

Data type Instruction Syntax Example
Bit strings AND: AND logic operation AND IN1 AND IN2 OR IN3

OR: OR logic operation OR
XOR: EXCLUSIVE OR logic operation XOR
INV: Create ones complement NOT
SWAP: Swap 1) SWAP

Integers ADD: Add + (IN1 + IN2) * IN3;
(ABS(IN2)) * 
(ABS(IN1))

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
MOD: Return remainder of division MOD
INV: Create ones complement NOT
NEG: Create twos complement -(in1)
ABS: Form absolute value ABS( )

Floating-point numbers ADD: Add + ((SIN(IN2) * SIN(IN2) 
+ (SIN(IN3) * 
SIN(IN3)) / IN3));
(SQR(SIN(IN2)) + 
(SQR(COS(IN3)) / 
IN2))

SUB: Subtract -
MUL: Multiply *
DIV: Divide /
EXPT: Exponentiate **
ABS: Form absolute value ABS( )
SQR: Form square SQR( )
SQRT: Form square root SQRT( )
LN: Form natural logarithm LN( )
EXP: Form exponential value EXP( )
FRAC: Return fraction FRAC( )
SIN: Form sine value SIN( )
COS: Form cosine value COS( )
TAN: Form tangent value TAN( )
ASIN: Form arcsine value ASIN( )
ACOS: Form arccosine value ACOS( )
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Data type Instruction Syntax Example
ATAN: Form arctangent value ATAN( )
NEG: Create twos complement -(in1)
TRUNC: Truncate numerical value TRUNC( )
ROUND: Round numerical value ROUND( )
CEIL: Generate next higher integer from floating-
point number

CEIL( )

FLOOR: Generate next lower integer from floating-
point number

FLOOR( )

1) Not possible for data type BYTE.

Parameters
The following table shows the parameters of the instruction "Calculate":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings, 

integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

First available 
input

IN2 Input Bit strings, 
integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second 
available input

INn Input Bit strings, 
integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Additionally 
inserted inputs

OUT Output Bit strings, 
integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Output to 
which the end 
result is to be 
transferred.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value_1 4
IN2 Tag_Value_2 4
IN3 Tag_Value_3 3
IN4 Tag_Value_4 2
OUT Tag_Result 12

The "Calculate" instruction is executed when input "Tag_Input" has the signal state "1". The 
value of operand "Tag_Value_1" is added to the value of operand "Tag_Value_2". The sum is 
multiplied with the value of the operand "Tag_Value_3". The product is divided by the value of 
the operand "Tag_Value_4". The quotient is transferred as end result to the operand 
"Tag_Result" at the OUT output of the instruction. If no errors occur during the execution of 
the individual instructions, output ENO and the operand "Tag_Output" are set to "1".

See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

ADD: Add

Description     
You can use the "Add" instruction to add the value at input  IN1 to the value at input IN2 and 
query the sum at output  OUT (OUT := IN1+IN2).

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. 
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During the execution of the instruction, the values of all available input parameters are added. 
The sum is stored at output OUT.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Add":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

First number to 
be added

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second 
number to be 
added

INn Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values, which 
are added.

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Sum

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also":

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Add" instruction is executed. The value of 
operand "Tag_Value1" is added to the value of operand "Tag_Value2". The result of the 
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addition is stored in the operand "Tag_Result". If the instruction is executed without errors, the 
ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1570)

Adding additional inputs and outputs to FBD elements (Page 1585)

SUB: Subtract

Description     
You can use the "Subtract" instruction to subtract the value at input  IN2 from the value at input 
IN1 and query the difference at output  OUT (OUT := IN1-IN2).

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Subtract":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Minuend

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Subtrahend

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Difference

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Subtract" instruction is executed. The value 
of operand "Tag_Value2" is subtracted from the value of operand "Tag_Value1". The result of 
the subtraction is stored in the operand "Tag_Result". If the instruction is executed without 
errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1570)

MUL: Multiply

Description     
You can use the "Multiply" instruction to multiply the value at input  IN1 with the value at input 
IN2 and query the total at output  OUT (OUT := IN1*IN2).

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. When 
the instruction is executed, the values of all available input parameters are multiplied. The 
product is stored at the OUT output.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result is outside the range permitted for the data type specified at output OUT.

● A floating-point number has an invalid value.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2245



Parameters
The following table shows the parameters of the instruction "Multiply":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

First value for 
multiplication

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for 
multiplication

INn Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values, which 
are multiplied.

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Product

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Multiply" instruction is executed. The value 
of operand "Tag_Value1" is multiplied with the value of operand "Tag_Value2". The result of 
the multiplication is stored in the operand "Tag_Result". If the instruction is executed without 
errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)
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Selecting a data type (Page 1570)

Adding additional inputs and outputs to FBD elements (Page 1585)

DIV: Divide

Description     
You can use the "Divide" instruction to divide the value at input  IN1 by the value at input IN2 
and query the quotient at output  OUT (OUT := IN1/IN2).

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Divide":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers, 

floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Dividend

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Divisor

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Quotient value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Divide" instruction is executed. The value 
of operand "Tag_Value1" is divided by the value of operand "Tag_Value2". The result of the 
division is stored in the operand "Tag_Result". If the instruction is executed without errors, the 
ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1570)

MOD: Return remainder of division

Description     
You can use the "Return remainder of division" instruction to divide the value at input  IN1 by 
the value at input IN2 and query the quotient at output  OUT.

Parameters
The following table shows the parameters of the instruction "Return remainder of division":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Integers I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Dividend

IN2 Input Integers I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Divisor

OUT Output Integers I, Q, M, D, L, P I, Q, M, D, L, P Remainder of 
division

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Return remainder of division" instruction 
is executed. The value of operand "Tag_Value1" is divided by the value of operand 
"Tag_Value2". The remainder of division is stored in operand "Tag_Result". If the instruction 
is executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Selecting a data type (Page 1570)

NEG: Create twos complement

Description       
You can use the "Create twos complement" instruction to change the sign of the value at input 
IN and query the result at output OUT. If there is a positive value at input IN, for example, the 
negative equivalent of this value is sent to output OUT.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The result of the instruction is outside the range permitted for the data type specified at 
output OUT.

● A floating-point number has an invalid value.
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Parameters
The following table shows the parameters of the "Create twos complement" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input SINT, INT, 
DINT, 
Floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
Floating-
point 
numbers

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Input value

OUT Output SINT, INT, 
DINT, 
Floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
Floating-
point 
numbers

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Twos 
complement 
of the input 
value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Create twos complement" instruction is 
executed. The sign of the value at input "TagIn_Value" is changed and the result is stored at 
output "TagOut_Value". If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)
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INC: Increment

Description     
You can use the "Increment" instruction to change the value of the operand at parameter IN/
OUT to the next higher value and query the result.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Increment" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L I, Q, M, D, L Value to be 

incremented.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operands TagIn_1 and TagIn_2 have the signal state "1", the value of the operand 
"Tag_InOut" is incremented by one and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)
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DEC: Decrement

Description     
You can use the "Decrement" instruction to change the value of the operand at parameter IN/
OUT to the next lower value and query the result.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Decrement":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN/OUT InOut Integers I, Q, M, D, L I, Q, M, D, L Value to be 

decremented.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have the signal state "1", the value of the operand 
"Tag_InOut" is decremented by one and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)
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ABS: Form absolute value

Description         
You can use the "Form absolute value" instruction to calculate the absolute value of the value 
specified at input IN. The result of the instruction is provided at output OUT and can be queried 
there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the instruction "Form absolute value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input SINT, INT, 
DINT, 
floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
floating-
point 
numbers

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Input value

OUT Output SINT, INT, 
DINT, 
floating-
point 
numbers

SINT, INT, 
DINT, LINT, 
floating-
point 
numbers

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Absolute 
value of the 
input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN TagIn_Value -6.234
OUT TagOut_Value 6.234

If the operand "TagIn" has the signal state "1", the "Form absolute value" instruction is 
executed. The instruction calculates the absolute value of the value at input "TagIn_Value" 
and sends the result to output "TagOut_Value". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)

MIN: Get minimum

Description
The "Get minimum" instruction compares the values at the available inputs and writes the 
lowest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

In its initial state the instruction contains at least two inputs (IN1 and IN2) and no more than 
100 inputs.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Get minimum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN1 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

First input 
value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Second 
input value

INn Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Additionally 
inserted 
inputs 
whose 
values are to 
be compared

OUT Output Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 12222

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get minimum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
lowest value ("TagIn_Value1") to output "TagOut_Value". If the instruction is executed without 
errors, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)

MAX: Get maximum

Description
The "Get maximum" instruction compares the values at the available inputs and writes the 
highest value to the OUT output. The number of inputs can be expanded at the instruction box 
by additional inputs. The inputs are numbered in ascending order in the box.

In its initial state the instruction contains at least two inputs (IN1 and IN2) and no more than 
100 inputs.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:
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● Enable input EN has the signal state "0".

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Parameters
The following table shows the parameters of the "Get maximum" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN1 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

First input 
value

IN2 Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Second 
input value

INn Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Additionally 
inserted 
inputs 
whose 
values are to 
be 
compared.

OUT Output Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 TagIn_Value1 12222
IN2 TagIn_Value2 14444
IN3 TagIn_Value3 13333
OUT TagOut_Value 14444

If the "TagIn_1" and "TagIn_2" operands have signal state "1", the "Get maximum" instruction 
is executed. The instruction compares the values of the specified operands and copies the 
highest value ("TagIn_Value2") to output "TagOut_Value". If no errors occur during the 
execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)

LIMIT: Set limit value

Description 
You can use the "Set limit value" instruction to limit the value at input IN to the values at the 
inputs MN and MX. If the value at the IN input meets the MN condition <= IN <= MX, it is copied 
to the OUT output. If the condition is not fulfilled and the input value IN is below the low limit 
MN, output OUT is set to the value of the input MN. If the high limit MX is exceeded, output 
OUT is set to the value of the input MX.

If the value at input MN is greater than that at input MX, the result is undefined and the enable 
output ENO is "0".

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The specified tags are not of the same data type.

● An operand has an invalid value.

● The value at the MN input is greater than the value at input MX.

Parameters
The following table shows the parameters of the "Set limit value" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

MN Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Low limit

IN Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Input value

MX Input Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

High limit

OUT Output Integers, 
floating-
point 
numbers, 
TIME, 
TOD, 
DATE

Integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
TOD, LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MN Tag_MN 12000
IN Tag_Value 8000
MX Tag_MX 16000
OUT Tag_Result 12000

If the "TagIn_1" and "TagIn_2" operands have the signal state "1", the "Set limit value" 
instruction is executed. The value of operand "Tag_Value" is compared with the values of 
operands "Tag_MN" and "Tag_MX". Since the value at the operand "Tag_Value"  is less than 
the low limit, the value of the operand "Tag_MN" is copied to output "Tag_Result". If the 
instruction is executed without errors, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)

SQR: Form square

Description     
You can use the "Form square" instruction to square the value at input IN and query the result 
at output OUT.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.
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Parameters
The following table shows the parameters of the instruction "Form square":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Square of the 
input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 5.0
OUT Tag_Result 25.0

If the operand "TagIn" has the signal state "1", the "Form square" instruction is executed. The 
instruction squares the value of the operand "Tag_Value" and sends the result to output 
"Tag_Result". If no errors occur during the execution of the instruction, the output "TagOut" is 
set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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SQRT: Form square root

Description     
You can use the "Form square root" instruction to form the square root of the value at input IN 
and query the result at output OUT. The instruction has a positive result if the input value is 
greater than zero. If input values are less than zero, output OUT returns an invalid floating-
point number. If the value at input IN is "0", the result is also "0".

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is negative.

Parameters
The following table shows the parameters of the instruction "Form square root":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L I, Q, M, D, L Square root of 
the input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value 25.0
OUT Tag_Result 5.0

If the operand "TagIn" has the signal state "1", the "Form square root" instruction is executed. 
The instruction calculates the square root of the operand "Tag_Value" and sends the result to 
output "Tag_Result". If no errors occur during the execution of the instruction, the output 
"TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

LN: Form natural logarithm

Description     
You can use the "Form natural logarithm" instruction to calculate the natural logarithm to base 
e (e = 2.718282) of the value at input IN. The result is sent to output OUT and can be queried 
there. The instruction has a positive result if the input value is greater than zero. If input values 
are less than zero, output OUT returns an invalid floating-point number.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is negative.

Parameters
The following table shows the parameters of the instruction "Form natural logarithm":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Natural 
logarithm of 
the input value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Form natural logarithm" instruction is 
executed. The instruction forms the natural logarithm of the value at input "Tag_Value" and 
sends the result to output "Tag_Result". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

EXP: Form exponential value

Description     
You can use the "Form exponential value" instruction to calculate the exponent from the base 
e (e = 2.718282 and the value specified at input IN. The result is provided at output OUTand 
can be queried there  (OUT = eIN).

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form exponential value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Exponential 
value of the 
input value IN
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You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the "Form exponential value" instruction is 
executed. The instruction forms the exponent from base e and the value of the operand 
"Tag_Value" and sends the result to output "Tag_Result". If no errors occur during the 
execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SIN: Form sine value

Description     
You can use the "Form sine value" instruction to calculate the sine of an angle. The size of the 
angle is specified in the radian measure at input IN. The result of the instruction is provided at 
output OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form sine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
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Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Size of angle in 
the radian 
measure

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Sine of the 
specified angle

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 1.0

If the operand "TagIn" has the signal state "1", the "Form sine value" instruction is executed. 
The instruction calculates the sine of the angle specified at input "Tag_Value" and sends the 
result to output "Tag_Result". If no errors occur during the execution of the instruction, the 
output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

COS: Form cosine value

Description     
You can use the "Form cosine value" instruction to calculate the cosine of an angle. The size 
of the angle is specified in the radian measure at input IN. The result of the instruction is 
provided at output OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form cosine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Size of angle in 
the radian 
measure

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Cosine of the 
specified angle

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value +1.570796 (π/2)
OUT Tag_Result 0

If the operand "TagIn" has the signal state "1", the "Form cosine value" instruction is executed. 
The instruction calculates the cosine of the angle specified at input "Tag_Value" and sends 
the result to output "Tag_Result". If no errors occur during the execution of the instruction, the 
output "TagOut" is set.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

TAN: Form tangent value

Description     
You can use the "Form tangent value" instruction to calculate the tangent of an angle. The size 
of the angle is specified in the radian measure at input IN. The result of the instruction is 
provided at output OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form tangent value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Size of angle in 
the radian 
measure

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Tangent of the 
specified angle

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value +3.141593 (π)
OUT Tag_Result 0

If the operand "TagIn" has the signal state "1", the "Form tangent value" instruction is executed. 
The instruction calculates the tangent of the angle specified at input "Tag_Value" and stores 
the result at output "Tag_Result". If no errors occur during the execution of the instruction, the 
output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ASIN: Form arcsine value

Description     
You can use the "Form arcsine value" instruction to calculate the size of the angle from the 
sine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at input IN. The calculated angle size is 
output in radians at output OUT and can range in value from -π/2 to +π/2.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is outside the permitted range (-1 to +1).

Parameters
The following table shows the parameters of the instruction "Form arcsine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Sine value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Size of angle in 
the radian 
measure

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +1.570796 (π/2)

If the operand "TagIn" has the signal state "1", the "Form arcsine value" instruction is executed. 
The instruction calculates the size of the angle corresponding to the sine value at input 
"Tag_Value". The result of the instruction is stored at output "Tag_Result". If no errors occur 
during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ACOS: Form arccosine value

Description     
You can use the "Form arccosine value" instruction to calculate the size of the angle from the 
cosine value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers within the range -1 to +1 can be specified at input IN. The calculated angle size is 
output in radians at output OUT and can range in value from 0 to +π.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

● The value at input IN is outside the permitted range (-1 to +1).
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Parameters
The following table shows the parameters of the instruction "Form arccosine value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Cosine value 

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Size of angle in 
the radian 
measure

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 0
OUT Tag_Result +1.570796 (π/2)

If the operand "TagIn" has the signal state "1", the "Form arccosine value" instruction is 
executed. The instruction calculates the size of the angle corresponding to the cosine value 
at input "Tag_Value". The result of the instruction is stored at output "Tag_Result". If no errors 
occur during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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ATAN: Form arctangent value

Description     
You can use the "Form arctangent value" instruction to calculate the size of the angle from the 
tangent value specified at input IN, which corresponds to this value. Only valid floating-point 
numbers may be specified at input IN. The calculated angle size is output in radians at the 
output OUT and can range in value from -π/2 to +π/2. 

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value at input IN is not a valid floating-point number.

Parameters
The following table shows the parameters of the instruction "Form arctangent value":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Tangent value

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Size of angle in 
the radian 
measure

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameters Operand Value
IN Tag_Value 1.0
OUT Tag_Result +0.785398 (π/4)

If the operand "TagIn" has the signal state "1", the "Form arctangent value" instruction is 
executed. The instruction calculates the size of the angle corresponding to the tangent value 
at input "Tag_Value". The result of the instruction is stored at output "Tag_Result". If no errors 
occur during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

FRAC: Return fraction

Description     
You can use the "Return fraction" instruction to determine the decimal places of the value at 
the IN input. The result of the query is stored at output OUT and can be queried there. If the 
input IN has e.g. the value 123.4567, the output  OUT has the value 0.4567.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors occur during the execution of the instruction, for example there is no valid floating-
point number at the input.

Parameters
The following table shows the parameters of the "Return fraction" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value, 
whose decimal 
places are to 
be determined.

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Decimal 
places of the 
input value at 
input IN

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 2.555
OUT Tag_Result 0.555

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Return fraction" instruction 
is executed. The decimal places from the value at the operand "Tag_Value" are copied to the 
operand "Tag_Result". If the instruction is executed without errors, the ENO enable output has 
the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)

EXPT: Exponentiate

Description     
You can use the "Exponentiate" instruction to raise the value at the input IN1 by a power 
specified with the value at input IN2. The result of the instruction is stored at output OUT and 
can be queried there (OUT = IN1IN2).

The value at input IN1 must be a valid floating-point number. Integers are also allowed for 
setting the input IN2.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors occur during the instruction processing, for example, if there is an overflow.
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Parameters
The following table shows the parameters of the instruction "Exponentiate":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Base value

IN2 Input Integers, 
floating-point 
numbers

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Value with 
which the base 
value is 
exponentiated

OUT Output Floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Exponentiate" instruction 
is executed. The value of operand "Tag_Value1" is raised by the power of the value of the  
operand "Tag_Value2". The result is stored at output "Tag_Result". If the instruction is executed 
without errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Adding additional inputs and outputs to FBD elements (Page 1585)

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2275



Move operations

MOVE: Move value

Description
You use the "Move value" instruction to transfer the content of the operand at the IN input to 
the operand at the OUT1 output. The transfer is always made in the direction of ascending 
address.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The data type at the IN parameter does not correspond to the specified data type at the 
OUT1 parameter.

The following table lists the possible transfers for the S7-1200 CPU series:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE ,TOD, CHAR

WORD WORD, DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD, CHAR

DWORD DWORD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, REAL, TIME, DATE, TOD, CHAR

SINT SINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

USINT USINT, UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

INT INT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UINT UINT, UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

DINT DINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

UDINT UDINT BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 
DINT, UDINT, TIME, DATE, TOD

REAL REAL DWORD, REAL
LREAL LREAL LREAL
TIME TIME BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TIME
DATE DATE BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, DATE
TOD TOD BYTE, WORD, DWORD, SINT, USINT, INT, UINT, 

DINT, UDINT, TOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, CHAR, Character of a 

string1)
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

Character of a 
string1)

Character of a string Character of a string CHAR

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

The following table lists the possible transfers for the S7-1500 CPU series:

Source (IN) Destination (OUT1)
With IEC check Without IEC check

BYTE BYTE, WORD, DWORD, 
LWORD

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE ,TOD, LTOD, CHAR

WORD WORD, DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, S5TIME, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

DWORD DWORD, LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, REAL, TIME, 
LTIME, LDT, DATE, TOD, LTOD, CHAR

LWORD LWORD BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, LREAL, 
TIME, LTIME, LDT, DATE, TOD, LTOD, CHAR

SINT SINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

USINT USINT, UINT, UDINT, 
ULINT

BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

INT INT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

UINT UINT, UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD. LTOD
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

DINT DINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

UDINT UDINT, ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

LINT LINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

ULINT ULINT BYTE, WORD, DWORD, LWORD, SINT, USINT, 
INT, UINT, DINT, UDINT, LINT, ULINT, TIME, LTIME, 
LDT, DATE, TOD, LTOD

REAL REAL DWORD, REAL
LREAL LREAL LWORD, LREAL
S5TIME S5TIME WORD, S5TIME
TIME TIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TIME
LTIME LTIME BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTIME
DATE DATE BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, DATE
DT DT DT
LDT LDT BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LDT
TOD TOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, TOD
LTOD LTOD BYTE, WORD, DWORD, LWORD, SINT, USINT, 

INT, UINT, DINT, UDINT, LINT, ULINT, LTOD
DTL DTL DTL
CHAR CHAR BYTE, WORD, DWORD, LWORD, CHAR, Character 

of a string1)

WCHAR WCHAR BYTE, WORD, DWORD, LWORD, CHAR, WCHAR, 
Character of a string1)

Character of a 
string1)

Character of a string CHAR, WCHAR, Character of a string

ARRAY2) ARRAY ARRAY
STRUCT STRUCT STRUCT
COUNTER COUNTER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
TIMER TIMER, WORD, INT WORD, DWORD, INT, UINT, DINT, UDINT
PLC data type 
(UDT)

PLC data type (UDT) PLC data type (UDT)

IEC_TIMER IEC_TIMER IEC_TIMER
IEC_LTIMER IEC_LTIMER IEC_LTIMER
IEC_SCOUNTE
R

IEC_SCOUNTER IEC_SCOUNTER
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Source (IN) Destination (OUT1)
With IEC check Without IEC check

IEC_USCOUNT
ER

IEC_USCOUNTER IEC_USCOUNTER

IEC_COUNTER IEC_COUNTER IEC_COUNTER
IEC_UCOUNTE
R

IEC_UCOUNTER IEC_UCOUNTER

IEC_DCOUNTE
R

IEC_DCOUNTER IEC_DCOUNTER

IEC_UDCOUN
TER

IEC_UDCOUNTER IEC_UDCOUNTER

IEC_LCOUNTE
R

IEC_LCOUNTER IEC_LCOUNTER

IEC_ULCOUNT
ER

IEC_ULCOUNTER IEC_ULCOUNTER

1) You can also use the "Move value" instruction to transfer individual characters of a string to 
operands of the CHAR or WCHAR data type. The number of the character to be transferred 
is specified in square brackets next to the operand name. "MyString[2]", for example, transfers 
the second character of the "MyString" string. It is also possible to transfer from operands of 
the data type CHAR to the individual characters of a string. You can also replace a specific 
character of a string with the character of another string. 
2) Transferring entire arrays (ARRAY) is possible only when the array components of the 
operands at input IN and at output OUT1 are of the same data type.

If the bit length of the data type at input IN exceeds the bit length of the data type at output 
OUT1, the higher-order bits of the source value are lost. If the bit length of the data type at 
input IN is less than the bit length of the data type at output OUT1, the higher-order bits of the 
destination value will be overwritten with zeros.

In its initial state, the instruction box contains 1 output (OUT1). The number of outputs can be 
extended. The added outputs are numbered in ascending order on the box. During the 
execution of the instruction, the content of the operand at the input IN is transferred to all 
available outputs. The instruction box cannot be extended if structured data types (DTL, 
STRUCT, ARRAY) or characters of a string are transferred.

You can also use the "Move block" (MOVE_BLK) and "Move block uninterruptible" 
(UMOVE_BLK) instructions to move operands of the ARRAY data type. You can move 
operands of the STRING data type with the instruction "Move character string" (S_MOVE).

Parameters
The following table lists the parameters of the "Move value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output
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Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN Input Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, 
TIME, TOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
IEC data 
types, PLC 
data type 
(UDT)

Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, DT, 
LDT, 
S5TIME, 
TIME, 
LTIME, 
TOD, 
LTOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Element 
used to 
overwrite 
the 
destination 
address.

OUT1 Output Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, 
TIME, TOD, 
DTL, CHAR, 
STRUCT, 
ARRAY, 
IEC data 
types, PLC 
data type 
(UDT)

Bit strings, 
integers, 
floating-
point 
numbers, 
DATE, DT, 
LDT, 
S5TIME, 
TIME, 
LTIME, 
TOD, 
LTOD, DTL, 
CHAR, 
STRUCT, 
ARRAY, 
TIMER, 
COUNTER, 
IEC data 
types, PLC 
data type 
(UDT)

I, Q, M, D, L I, Q, M, D, L Destination 
address

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table lists how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0011 1111 1010 1111
OUT1 TagOut_Value 0011 1111 1010 1111

If the operand "TagIn" has the signal state "1", the "Move value" instruction is executed. The 
instruction copies the content of the "TagIn_Value" operand to the "TagOut_Value" operand. 
If the instruction is executed without errors, the ENO and "TagOut" enable outputs are set to 
signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Removing instruction inputs and outputs (Page 1586)

MOVE_BLK: Move block (Page 2291)

UMOVE_BLK: Move block uninterruptible (Page 2297)

S_MOVE: Move character string (Page 2637)

Adding additional inputs and outputs to FBD elements (Page 1585)

Deserialize: Deserialize

Description
You can use the "Deserialize" instruction to convert the sequential representation of a PLC 
data type (UDT) back to a PLC data type and to fill its entire contents.

The memory area in which the sequential representation of a PLC data type is located must 
have the ARRAY of BYTE data type and be declared with standard access. Make sure that 
there is enough memory space prior to the conversion.
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The instruction enables you to convert multiple sequential representations of converted PLC 
data types back to their original state step-by-step.

 

 Note

If you only want to convert back a single sequential representation of a PLC data type (UDT), 
you can also use the instruction "TRCV: Receive data via communication connection" directly.

 

Parameter
The following table shows the parameters of the "Deserialize" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC_ARRA
Y

Input VARIANT I, Q, D, L Global data block in which the generated data stream is stored

DEST_VARI
ABLE

InOut VARIANT I, Q, D, L Tag in which the returned converted PLC data type (UDT) is 
stored

POS InOut DINT I, Q, M, D, L Number of bytes that the converted PLC data types use. The POS 
parameter is calculated zero-based.

RET_VAL Output INT I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B0 The memory areas for the SRC_ARRAY and 

DEST_VARIABLE parameters overlap.
8136 The data block at the DEST_VARIABLE parameter is not a 

block with standard access.
8150 The VARIANT data type at the SRC_ARRAY parameter 

contains no value.
8151 Code generation error at SRC_ARRAY parameter
8153 There is not enough free memory available at the 

SRC_ARRAY parameter.
8250 The VARIANT data type at the DEST_VARIABLE parameter 

contains no value.
8251 Code generation error at DEST_VARIABLE parameter
8254 Invalid data type at the DEST_VARIABLE parameter
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Error code*
(W#16#...)

Explanation

8382 The value at the POS parameter is outside the limits of the 
array.

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

Network 1:

The "Move value" instruction moves the value "0" to the "#BufferPos" operand. The 
"Deserialize" instruction deserializes the sequential representation of the customer data from 
the "Buffer" data block and writes it to the "Target" data block. The number of bytes used by 
the converted customer data is stored in the "#BufferPos" operand.

Network 2:

The "Deserialize" instruction deserializes the sequential representation of the separator sheet, 
which was saved with the sequential representation after the customer data, from the "Buffer" 
data block and writes the characters to the "#Label" operand. The characters are compared 
using comparison instructions for "arti" and "Bill". If the comparison for "arti" = TRUE, these 
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are article data that have been deserialized and written to the "Target" data block. If the 
comparison for "Bill" = TRUE, these are billing data that have been deserialized and written to 
the "Target" data block.

The following table shows the declaration of the operands:

Operand Data type Declaration
DeliverPos INT In the "Input" section of the block interface
BufferPos DINT In the "Temp" section of the block interface
Error INT In the "Temp" section of the block interface
Label STRING[4] In the "Temp" section of the block interface

The following table lists the declarations of the PLC data types:

Name of the PLC data types Name Data type
Article Number DINT

Declaration STRING
Colli INT

Client Title INT
First name STRING[10]
Surname STRING[10]

The following table shows the declaration of the data blocks:

Name of the data blocks Name Data type
Target Client "Client" (PLC data type)

Article Array[0..] of "Article" (PLC data type)
Bill Array[0..10] of INT

Buffer Field Array[0..294] of BYTE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

PLC data types (Page 1364)

Serialize: Serialize

Description
You can use the "Serialize" instruction to convert several PLC data types (UDT) to a sequential 
representation without losing parts of their structure.

You can use the instruction to temporarily save multiple structured data items from your 
program in a buffer, which should preferably be in a global data block, and send them to another 
CPU. The memory area in which the converted PLC data types are stored must have the 
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ARRAY of BYTE data type and be declared with standard access. Make sure that there is 
enough memory space prior to the conversion.

The operand at the POS parameter contains information about the number of bytes used by 
the converted PLC data types.

 

 Note

If you want to send a single PLC data type (UDT), you can directly call the instruction "TSEND: 
Send data via communication connection".

 

Parameters
The following table shows the parameters of the "Serialize" instruction:

Parameters Declarati
on

Data 
type

Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC_VARI
ABLE

Input VARIA
NT

I, Q, D, L PLC data type (UDT) that is converted to sequential representation.

DEST_ARR
AY

InOut VARIA
NT

I, Q, D, L Data block in which the generated data stream is stored.

POS InOut DINT I, Q, M, D, L Number of bytes that the converted PLC data types use. The POS 
parameter is calculated zero-based.

RET_VAL Output INT I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B0 The memory areas for the SRC_VARIABLE and 

DEST_ARRAY parameters overlap.
8150 The VARIANT data type at the SRC_VARIABLE parameter 

contains no value.
8152 Code generation error at SRC_VARIABLE parameter
8236 The data block at the DEST_ARRAY parameter is not a block 

with standard access.
8250 The VARIANT data type at the DEST_ARRAY parameter 

contains no value.
8252 Code generation error at DEST_ARRAY parameter
8253 There is not enough free memory available at the 

DEST_ARRAY parameter.
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Error code*
(W#16#...)

Explanation

8254 Invalid data type at the DEST_ARRAY parameter
8382 The value at the POS parameter is outside the limits of the 

array.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

Network 1:

The "Move value" instruction moves the value "0" to the "#BufferPos" operand. The "Serialize" 
instruction serializes the customer data from the "Source" data block and writes them in 
sequential representation to the "Buffer" data block. The number of bytes used by the 
sequential representation is stored in the "#BufferPos" operand. 

Network 2:

A kind of separator sheet is inserted now to make it easier to deserialize the sequential 
representation later. The "Move character string" instruction moves the "arti" characters to the 
"#Label" operand. The "Serialize" instruction writes these characters after the customer data 
to the "Buffer" data block. The number of bytes that the characters need is added to the number 
already stored in the "#BufferPos" operand.

Network 3:

The "Serialize" instruction serializes the data of a specific article, which is calculated in runtime, 
from the "Source" data block and writes them in sequential representation to the "Buffer" data 
block after the "arti" characters.
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The following table shows the declaration of the operands:

Operand Data type Declaration
DeliverPos INT In the "Input" section of the block interface
BufferPos DINT In the "Temp" section of the block interface
Error INT In the "Temp" section of the block interface
Label STRING[4] In the "Temp" section of the block interface

The following table lists the declarations of the PLC data types:

Name of the PLC data types Name Data type
Article Number DINT

Declaration STRING
Colli INT

Client Title INT
First name STRING[10]
Surname STRING[10]

The following table shows the declaration of the data blocks:

Name of the data blocks Name Data type
Source
 

Client "Client" (PLC data type)
Article Array[0..10] of "Article" (PLC data type)

Buffer Field Array[0..294] of BYTE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

PLC data types (Page 1364)

FieldRead: Read field

Description
You can use the "Read field" instruction to read out a specific component from the field 
specified in the MEMBER parameter and transfer its content to the tag in the VALUE 
parameter. You use the parameter INDEX to define the index of the field components that are 
to be read. At the parameter MEMBER you specify the first component of the field to be read.

The data types of the field component at parameter MEMBER and the tags at parameter 
VALUE must correspond to the data type of the instruction "Read field".

Enable output ENO has the signal state "0" if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The field component specified at the parameter INDEX is not defined in the field specified 
at the parameter MEMBER.

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the instruction "Read field":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

INDEX Input DINT DINT I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Index of field 
components 
whose 
content is 
read out 

MEMBER Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR 
as 
components 
of an 
ARRAY tag

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR 
as 
components 
of an 
ARRAY tag

D, L D, L First 
component 
of the field 
from which 
will be read

VALUE Output Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR

Bit strings, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Operand to 
which the 
contents of 
the field 
component 
are 
transferred.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Tag Value
INDEX a_index 4
MEMBER "DB_1".Main_Field[-10] First component of the field 

"Main_Field[-10..10] of REAL" in the data 
block "DB_1"

VALUE a_real Component with Index 4 of the field 
"Main_Field[-10..10] of REAL"

The field component with index 4 is read out from the field "Main_Field[-10...10] of REAL" and 
written to the tag "a_real". The field component to be read is defined by the value at the 
parameter INDEX.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

FieldWrite: Write field

Description
The "Write field" instruction is used to transfer the content of the tag at the VALUE input to a 
specific component of the field at the MEMBER output. You use the value at the INDEX input 
to specify the index of the field component that is described. At the MEMBER output, enter the 
first component of the field which is to be written to.

The data types of the field component specified at the MEMBER output and the tags at the 
VALUE input have to match the data type of the "Write field" instruction.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The field component specified at the input INDEX is not defined in the field specified at the 
output MEMBER.

● Errors, such as an overflow, occur during execution.
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Parameters
The following table shows the parameters of the instruction "Write field":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

INDEX Input DINT DINT I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Index of field 
component 
that is 
written with 
the content 
of VALUE

VALUE Input Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR

Bit strings, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Operand 
whose 
contents are 
copied

MEMBER Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD 
and CHAR 
as 
components 
of an 
ARRAY tag

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
TOD, LTOD 
and CHAR 
as 
components 
of an 
ARRAY tag

D, L D, L First 
component 
of the field to 
which the 
content of 
VALUE is 
written.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
INDEX a_index 4
VALUE a_real 10.54
MEMBER "DB_1".Main_Field[-10] First component of the field 

"Main_Field[-10..10] of REAL" in the data 
block "DB_1"

The value "10.54" of the "a_real" tag is written to the field component with index 4 of the 
"Main_Field[-10 ... 10] of REAL" field. The index of the field component to which the content 
of the tag "a_real" is transferred is specified by the value at the input INDEX.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MOVE_BLK: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The number of elements to be moved to the 
destination area is specified with the COUNT parameter. The width of the elements to be 
moved is defined by the width of the element at input IN.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".
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Parameters
The following table lists the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the source 
area that is 
being copied

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
elements to 
be copied 
from the 
source area 
to the 
destination 
area

OUT 1) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the 
destination 
area to 
which the 
contents of 
the source 
area are 
being copied

1) The specified data types can only be used as elements of an Array structure.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Move block" instruction is 
executed. Starting from the third element, the instruction selects three INT elements from the 
#a_array tag and copies their contents to the #b_array output tag, beginning with the second 
element. If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MOVE_BLK_VARIANT: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). You can copy elements of an array to another array 
of the same data type. The size (number of elements) of the source and destination array may 
be different. You can copy several elements within an array or individual elements.

If you are using the instruction, the array must not yet be known at the time the block is created, 
as the source and the destination are transferred using VARIANT.
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The counting at the parameters SRC_INDEX and DEST_INDEX always starts with the low 
limit "0", regardless of the later declaration of the array.

If the VARIANT pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is copied than is made available.

Parameters
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input VARIANT

(array or single 
element)

L Source block from 
which to copy

COUNT Input UDINT I, Q, M, D, L or constant Number of elements 
which are copied
Set the value at the 
parameter COUNT to 
"1", if no Array is 
specified at the 
parameter SRC or the 
parameter DEST.
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Parameter Declaration Data type Memory area Description
SRC_INDEX Input DINT I, Q, M, D, L or constant ● The SRC_INDEX 

parameter is 
calculated zero-
based. If an Array 
is specified at 
parameter SRC, 
the integer at the 
SRC_INDEX 
parameter 
specifies the first 
element within the 
source area from 
which copying is to 
take place. This is 
independent of the 
declared array 
limits.

● If no Array is set at 
the SRC parameter 
or only an 
individual element 
of an array is 
specified, assign 
the SRC_INDEX 
parameter the 
value "0".

DEST_INDEX Input DINT I, Q, M, D, L or constant ● The DEST_INDEX 
parameter is 
calculated zero-
based. If an Array 
is specified at the 
DEST parameter, 
the integer at the 
DEST_INDEX 
parameter 
specifies the first 
element within the 
destination area to 
which copying is to 
take place. This is 
independent of the 
declared array 
limits.

● If no Array is 
specified at the 
DEST parameter, 
assign the 
DEST_INDEX 
parameter the 
value "0".
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Parameter Declaration Data type Memory area Description
DEST Output VARIANT L Destination area into 

which the contents of 
the source block are 
copied.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during the execution of 
the instruction, an error 
code is output at the 
RET_VAL parameter.

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
8151 Access to the SRC parameter is not possible.
8152 The operand at the SRC parameter is not typed.
8153 Code generation error at SRC parameter
8154 The operand at the SRC parameter has the data type BOOL.
8281 The COUNT parameter has an invalid value
8382 The value at the SRC_INDEX parameter is outside the limits of the 

VARIANT.
8383 The value at the SRC_INDEX parameter is outside the high limit of the array.
8482 The value at the DEST_INDEX parameter is outside the limits of the 

VARIANT.
8483 The value at the DEST_INDEX parameter is outside the high limit of the 

array.
8534 The DEST parameter is write protected
8551 Access to the DEST parameter is not possible.
8552 The operand at the DEST parameter is not typed.
8553 Code generation error at DEST parameter
8554 The operand at the DEST parameter has the data type BOOL.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
SRC #SrcField The local operand #SrcField 

uses a UDT that was still 
unknown at the time when the 
block was programmed. (Array 
[0 to 10] of "MOVE_UDT"

COUNT Tag_Count 2
SRC_INDEX Tag_Src_Index 3
DEST_INDEX Tag_Dest_Index 3
DEST #DestField The local operand #DestField 

uses a UDT that was still 
unknown at the time when the 
block was programmed. (Array 
[10 to 20] of "MOVE_UDT"

If the operand "TagIn" has the signal state "1", the "Move block" instruction is executed. 2 
elements are copied from the source area into the destination area beginning with the fourth 
element of the array of UDT. The copies are inserted in the array of UDT beginning with the 
fourth element. If the instruction is executed without errors, the ENO enable output has the 
signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VariantGet: Read out VARIANT tag value (Page 2317)

UMOVE_BLK: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The number of elements to be moved 
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to the destination area is specified with the COUNT parameter. The width of the elements to 
be moved is defined by the width of the element at input IN.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The move operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Move block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the source 
area that is 
being copied

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
elements to 
be copied 
from the 
source area 
to the 
destination 
area
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

OUT 1) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L The first 
element of 
the 
destination 
area to 
which the 
contents of 
the source 
area are 
being copied

1) The specified data types can only be used as elements of an array structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Move block uninterruptible" 
instruction is executed. Starting from the third element, the instruction selects three INT 
elements from the #a_array tag and copies their contents to the #b_array output tag, beginning 
with the second element. The move operation cannot be interrupted by other operating system 
activities. If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

FILL_BLK: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the value 
of input IN. The destination area is filled beginning with the address specified at the OUT output. 
The number of repeated move operations is specified with the COUNT parameter. When the 
instruction is executed, the value at the input IN is selected and moved to the destination area 
as often as specified by the value of the COUNT parameter.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".

Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD, 
CHAR

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Element 
used to fill 
the 
destination 
area

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
repeated 
move 
operations
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

OUT 2) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, TOD, 
CHAR

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L Address in 
destination 
area from 
which filling 
starts.

1) The specified data types can also be used as elements of an Array structure.
2) The specified data types can only be used as elements of an Array structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Fill block" instruction is 
executed. The instruction copies the third element (#a_array[2]) of the #a_array tag three times 
to the #b_array output tag. If no errors occur during the execution of the instruction, the outputs 
ENO and "TagOut" are set to signal state "1".
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

UFILL_BLK: Fill block uninterruptible

Description
You can use the instruction "Fill block uninterruptible" to fill a memory area (destination area) 
with the value of input IN uninterruptibly. The destination area is filled beginning with the 
address specified at the OUT output. The number of repeated move operations is specified 
with the COUNT parameter. When the instruction is executed, the value at the input IN is 
selected and moved to the destination area as often as specified by the value of the COUNT 
parameter.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The move operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Fill block 
uninterruptible" instruction.

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● More data is moved than is made available at input IN or output OUT.

When a Array of BOOL is copied, the enable output ENO for an overflow is set to "1" until the 
byte limit of the Array structure is exceeded. If the byte limit of the Array structure is exceeded 
by the value at the COUNT input, the ENO enable output is reset to "0".

You can use the "Fill block uninterruptible" instruction to move a maximum of 16 KB. Note the 
CPU-specific restrictions for this.

Parameters
The following table shows the parameters of the "Fill block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

IN 1) Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Element 
used to fill 
the 
destination 
area

COUNT Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, 
P or constant

Number of 
repeated 
move 
operations

OUT 2) Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
CHAR, TOD

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
timers, 
DATE, 
CHAR, 
TOD, LTOD

D, L D, L Address in 
destination 
area from 
which filling 
starts.

1) The specified data types can also be used as elements of an Array structure.
2) The specified data types can only be used as elements of an Array structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

If the operands "TagIn_1" and "TagIn_2" have signal state "1", the "Fill block uninterruptible" 
instruction is executed. The instruction copies the third element (#a_array[2]) of the #a_array 
tag three times to the #b_array output tag. The move operation cannot be interrupted by other 
operating system activities. If no errors occur during the execution of the instruction, the outputs 
ENO and "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SWAP: Swap

Description       
You can use the instruction "Swap" to change the order of the bytes within the tag at input IN 
and query the result at output OUT.

The following figure shows how the bytes of a DWORD data type operand are swapped using 
the "Swap" instruction:
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Parameters
The following table shows the parameters of the "Swap" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input WORD, 
DWORD

WORD, 
DWORD, 
LWORD

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Operand 
whose bytes 
are 
swapped.

OUT Output WORD, 
DWORD

WORD, 
DWORD, 
LWORD

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0000 1111 0101 0101
OUT TagOut_Value 0101 0101 0000 1111

If the operand "TagIn" has the signal state "1", the "Swap" instruction is executed. The 
arrangement of the bytes is changed and stored in the operand "TagOut_Value".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ARRAY DB instructions

ReadFromArrayDB: Read from array data block

Description
You can use the "Read from array data block" instruction to read data from an array DB and 
write them to a destination area.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameters
The following table shows the parameters of the "Read from array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block that is 

read
INDEX Input DINT I, Q, M, D, L, P or 

constant
Element that is 
read

VALUE Output VARIANT L Value that is read 
and output

RET_VAL Output INT I, Q, M, D, L, P Error information:
If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The array DB contains invalid values
8154 The data type is not correctly declared
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE TargetField[10].Data2[1] The data type of the 

"TargetField" operand is Array 
[10 to 20] of "MOVE_UDT".

If the "TagIn1" operand has the signal state "1", the "Read from array data block" instruction 
is executed. The third element is read from "ArrayDB" and written to the 
"TargetField[10].Data2[1]" operand. If the instruction is executed without errors, the ENO 
enable output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

WriteToArrayDB: Write to array data block

Description
You can use the "Write to array data block" instruction to write data to an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.
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Parameters
The following table shows the parameters of the "Write to array data block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
DB Input DB_ANY I, Q, M, D, L Data block to 

which data is 
written

INDEX Input DINT I, Q, M, D, L, P or 
constant

Element in the DB 
to which data is 
written

VALUE Input VARIANT L Value to be written
RET_VAL Output INT I, Q, M, D, L, P Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE SourceField[1].Data1[6] The data type of the 

"SourceField" operand is Array 
[0 to 10] of "MOVE_UDT".

If the "TagIn1" operand has the signal state "1", the "Write to the ARRAY data block" instruction 
is executed. From the "SourceField" operand, the "Data1[6]" element from the second element 
is written to the "ArrayDB". The third element is written to the "ArrayDB". If the instruction is 
executed without errors, the ENO enable output has the signal state "1" and the "TagOut" 
output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ReadFromArrayDBL: Read from array data block in load memory

Description
You can use the "Read from array data block in load memory" instruction to read data from an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". The instruction is terminated if a negative 
signal edge is detected at the BUSY parameter. The DONE parameter has the signal state "1" 
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for one program cycle and the read value is output at the VALUE parameter within this cycle. 
With all other program cycles, the value at the VALUE parameter is not changed.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, it is saved to the "Program resources" folder in the "Program blocks > System 
blocks" path of the project tree. For additional information on this topic, refer to "See also".

 

 Note

The array DB must be located in a data block with the block property "Optimized".
 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Read from array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = "1": 
Starting with the 
reading of the 
array DB

DB Input DB_ANY I, Q, M, D, L Data block that is 
read

INDEX Input DINT I, Q, M, D, L, P or 
constant

Element that is 
read

BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 
array DB is still 
being read

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully
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Parameter Declaration Data type Memory area Description
VALUE InOut VARIANT D, L Value that is read 

and output
ERROR Output INT I, Q, M, D, L, P Error information:

If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
ERROR 
parameter.

For additional information on valid data types, refer to "See also".

ERROR parameter
The following table shows the meaning of the values of the ERROR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
80C3 Too many concurrent calls
8132 The data block does not exist or is too short
8133 The data block is not located in load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

You can find descriptions of the error codes triggered by the instructions "READ_DBL: Read 
from data block in load memory" and "WRIT_DBL: Write to data block in load memory" under 
"See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
REQ TagReq BOOL
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE SourceTargetField[1].Data1[6] The data type of the 

"SourceTargetField" operand is 
Array [0 to 10] of "MOVE_UDT".

BUSY TagBusy BOOL
DONE TagDone BOOL

If the "TagIn1" operand has the signal state "1" and a positive edge is detected at the 
"TagReq"operand, the "Read from ARRAY data block in load memory" instruction is executed. 
The third element is read from "ArrayDB" and written to the "SourceTargetField[1].Data1[6]" 
operand. As soon as a negative signal edge is detected at the "TagBusy" operand, the 
instruction is terminated and the value at the VALUE parameter is no longer changed. If the 
instruction is executed without errors, the ENO enable output has the signal state "1" and the 
"TagOut" output is set. After the instruction has been processed, the "TagDone" operand the 
signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

WRIT_DBL: Write to data block in the load memory (Page 2916)

READ_DBL: Read from data block in the load memory (Page 2914)
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WriteToArrayDBL: Write to array data block in load memory

Description
You can use the "Write to array data block in load memory" instruction to write data to an array 
DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". If a negative signal edge is detected at the 
BUSY parameter, the instruction is terminated and the value at the VALUE parameter is written 
to the data block. The DONE parameter then has the signal state "1" for one program cycle.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, it is saved to the "Program resources" folder in the "Program blocks > System 
blocks" path of the project tree. For additional information on this topic, refer to "See also".

 

 Note

The array DB must be located in a data block with the block property "Optimized".
 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● If an error occurs during the execution of the instruction.

Parameters
The following table shows the parameters of the "Write to array data block in load memory" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = "1": Start 
writing to the array 
DB

DB Input DB_ANY D Data block to 
which data is 
written

INDEX Input DINT I, Q, M, D, L, P or 
constant

Element in the DB 
to which data is 
written
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Parameter Declaration Data type Memory area Description
VALUE Input VARIANT D, L Value to be written
BUSY Output BOOL I, Q, M, D, L BUSY = "1": The 

array DB is still 
being written

DONE Output BOOL I, Q, M, D, L DONE = "1": The 
instruction was 
executed 
successfully

ERROR Output INT I, Q, M, D, L, P Error information:
If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
ERROR 
parameter.

For additional information on valid data types, refer to "See also".

ERROR parameter
The following table shows the meaning of the values of the ERROR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value at the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

You can find descriptions of the error codes triggered by the instructions "READ_DBL: Read 
from data block in load memory" and "WRIT_DBL: Write to data block in load memory" under 
"See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
REQ TagReq BOOL
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB.THIS[2] Third element of the "ArrayDB"
VALUE SourceTargetField[1].Data1[6] The data type of the 

"SourceTargetField" operand is 
Array [0 to 10] of "MOVE_UDT".

BUSY TagBusy BOOL
DONE TagDone BOOL

If the "TagIn1" operand has the signal state "1" and a positive edge is detected at the 
"TagReq"operand, the "Write to ARRAY data block in load memory" instruction is executed. 
As soon as a negative signal edge is detected at the "TagBusy" operand, the instruction is 
terminated and the value at the VALUE parameter is written in the third element in the 
"ArrayDB". If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set. After the instruction has been processed, the 
"TagDone" operand the signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

WRIT_DBL: Write to data block in the load memory (Page 2916)

READ_DBL: Read from data block in the load memory (Page 2914)
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VARIANT instructions

VariantGet: Read out VARIANT tag value

Description
You can use the "Read out VARIANT tag value" instruction to read the value of the tag to which 
the VARIANT at the SRC parameter points and write it in the tag at the DST parameter.

The SRC parameter must have the VARIANT data type. Any data type except for VARIANT 
can be specified at the DST parameter.

The data type of the tag at the DST parameter must match the data type to which the VARIANT 
points.

 

 Note

The tag to which the VARIANT at parameter SRC points must be a PLC data type.

To copy structures and ARRAYs, you can use the "MOVE_BLK_VARIANT: Move block" 
instruction. For additional information, refer to "See also".

 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The data types do not correspond. (No value is transferred.)

Parameters
The following table shows the parameters of the "Read out VARIANT tag value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input VARIANT L Tag to be read
DST Output Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY

I, Q, M, D, L Result of the instruction

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

If the "TagIn" operand has the signal state "1", the "Read out VARIANT tag value" instruction 
is executed. The value of the tag to which the VARIANT at the "#TagIn_Source" operand points 
is read and written to the "TagOut_Dest" operand.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

MOVE_BLK_VARIANT: Move block (Page 2293)

VariantPut: Write VARIANT tag value

Description
You can use the "Write VARIANT tag value" instruction to write the value of the tag at the SRC 
parameter to the tag at the DST parameter to which the VARIANT points.

The DST parameter must have the VARIANT data type. Any data type except for VARIANT 
can be specified at the SRC parameter.

The data type of the tag at the SRC parameter must match the data type to which the VARIANT 
points.

 

 Note

The tag to which the VARIANT at parameter DST points must be a PLC data type.
 

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The data types do not correspond. (No value is transferred.)
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Parameters
The following table shows the parameters of the "Write VARIANT tag value" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
SRC Input Bit strings, integers, 

floating-point 
numbers, timers, date 
and time, character 
strings, ARRAY

I, Q, M, D, L Tag to be read

DST Input VARIANT L Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the "TagIn" operand has the signal state "1", the "Write VARIANT tag value" instruction is 
executed. The value of the "TagIn_Source" operand is written to the tag to which the VARIANT 
at the "#TagIn_Dest" operand points.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

CountOfElements: Get number of ARRAY elements

Description
You can use the "Get number of ARRAY elements" instruction to query how many ARRAY 
elements a tag pointing to an VARIANT has.

If it is a one-dimensional ARRAY, the difference between the high and low limit +1 is output 
as a result. If it is a multi-dimensional ARRAY, the product of all dimensions is output as the 
result.

The IN parameter must have the same VARIANT data type.
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The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● The VARIANT tag is not an ARRAY. (The result is "0".)

If the VARIANT points to an ARRAY of BOOL, the fill elements are included in the count. (For 
example, 8 is returned for an ARRAY[0..1] of BOOL)

Parameters
The following table shows the parameters of the "Get number of ARRAY elements" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input VARIANT L Tag to be queried
RET_VAL Output UDINT I, Q, M, D, L Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the "TagIn" operand has the signal state "1", the "Get number of ARRAY elements" instruction 
is executed. The number of ARRAY elements of the tag to which the VARIANT at the 
"#TagIn_Source" operand points is read and output at the "TagOut_RetVal" operand.

See also
Format of array (16-bit limits) (Page 1351)

Format of array (32-bit limits) (Page 1352)

Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)
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Other

BLKMOV: Move block

Description
You can use the "Move block" instruction to move the content of a memory area (source area) 
to another memory area (destination area). The move operation takes place in the direction 
of ascending addresses. You use VARIANT to define the source and destination area.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

The following figure shows the principle of the move operation:

Consistency of the source data and the target data
Make sure that the source data remain unchanged during the execution of the "Move block" 
instruction. Otherwise the consistency of the target data cannot be ensured.

Interruptibility
There is no limit to the nesting depth.
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Memory areas
You can use the "Move block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the source and destination area have 
different lengths, only the length of the smaller area will be moved.

If the source area is less than the destination area, the entire source area will be written to the 
destination area. The remaining bytes of the destination area remain unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

Rules for moving character strings
You can use the "Move block" instruction to also move source and destination areas of the 
STRING data type. If only the source area is STRING data type, the characters will be moved 
that are actually contained in the character string. Information on the actual and maximum 
length is also written to the destination area. If the source and destination area are each 
STRING data type, the current length of the character string in the destination area is set to 
the number of actually moved characters.

If you want to move the information on the maximum and actual length of a character string, 
specify the areas in bytes in the SRCBLK and DSTBLK parameters.

Parameters
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
SRCBLK Input VARIANT L, P L, P Specifies the 

memory area to be 
moved 
(source area).
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

RET_VAL Output INT I, Q, M, D, L, P I, Q, M, D, L, P Error information:
If an error occurs 
during the execution 
of the instruction, an 
error code is output 
at the RET_VAL 
parameter.

DSTBLK Output VARIANT L, P L, P Specifies the 
memory area to 
which the block is to 
be moved 
(destination area).

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8152 The data types WSTRING, WCHAR and BOOL are not supported.
8092 The source or target area is only available in the load memory.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2364)

UBLKMOV: Move block uninterruptible

Description
You can use the "Move block uninterruptible" instruction to move the content of a memory area 
(source area) to another memory area (destination area). The move operation takes place in 
the direction of ascending addresses. You use VARIANT to define the source and destination 
area.
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The move operation cannot be interrupted by other operating system activities. As a result the 
interrupt reaction time of the CPU can increase during the execution of the "Move block 
uninterruptible" instruction.

 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

Memory areas
You can use the "Move block uninterruptible" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap during the execution of the "Move block 
uninterruptible" instruction. If the source area is less than the destination area, the entire source 
area will be written to the destination area. The remaining bytes of the destination area remain 
unchanged.

If the destination area is less than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a source or destination area defined as a formal parameter is less than a destination or 
source area specified on the SRCBLK or DSTBLK parameter, no data is transferred.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Rules for moving character strings
You can use the "Move block uninterruptible" instruction to also move source and destination 
areas of the STRING data type. If only the source area is STRING data type, the characters 
will be moved that are actually contained in the character string. Information on the actual and 
maximum length are not written in the destination area. If the source and destination area are 
each STRING data type, the current length of the character string in the destination area is 
set to the number of actually moved characters. If areas of the data type STRING are moved, 
you have to specify "1" as area length.
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Parameters
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
SRCBLK Input VARIANT L, P L, P Specifies the memory 

area to be moved 
(source area).

RET_VAL Output INT I, Q, M, D, L, P I, Q, M, D, L, 
P

Error information:
If an error occurs during 
the execution of the 
instruction, an error 
code is output at the 
RET_VAL parameter.

DSTBLK Output VARIANT L, P L, P Specifies the memory 
area to which the block 
is to be moved 
(destination area).

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code
(W#16#...)

Explanation

0000 No error
8152 The data types WSTRING, WCHAR and BOOL are not supported.
8091 The source area is in a data block that is not relevant for program execution.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2364)
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FILL: Fill block

Description
You can use the "Fill block" instruction to fill a memory area (destination area) with the content 
of another memory area (source area). The "Fill block" instruction moves the content of the 
source area to the destination area until the destination area is completely written. The move 
operation takes place in the direction of ascending addresses.

You use VARIANT to define the source and destination area.
 

 Note

The tags of the instruction can only be used in data blocks in which the "Optimized block 
access" attribute is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

For blocks with the "Optimized block access" attribute, you can use the "FILL_BLK: Fill block" 
instruction.

 

The following figure shows the principle of the move operation:

Consistency of the source data and the target data
Note that while the instruction "Fill block" is being executed, the source data remains 
unchanged; otherwise the consistency of the destination data cannot be guaranteed.
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Memory areas
You can use the "Fill block" instruction to move the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap. If the destination area to be preset is not 
an integer multiple of the length of the input parameter BVAL, the destination area is 
nevertheless written up to the last byte.

If the destination area to be preset is smaller than the source area, the function only copies as 
much data as can be written to the destination area.

If the destination or source area actually present is smaller than the assigned memory area 
for the source or destination area (BVAL, BLK parameters), no data is transferred.

If the ANY pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

If the destination area is of data type STRING, the instruction writes the entire string including 
the administration information.

Parameters
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
BVAL Input VARIANT L, P Specification of the memory 

area (source area) with the 
content used to fill the 
destination area at the BLK 
parameter.

RET_VAL Output INT I, Q, M, D, L, P Error information:
If an error occurs during the 
execution of the instruction, 
an error code is output at the 
RET_VAL parameter.

BLK Output VARIANT L, P Specification of the memory 
area that is filled with the 
content of the source area.
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Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8152 The data types WSTRING, WCHAR and BOOL are not supported.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2364)

Conversion operations

CONVERT: Convert value

Description
The "Convert value" instruction reads the content of the IN parameter and converts it according 
to the data types configured in the instruction box. The converted value is provided at output 
OUT.

For information on possible conversions, refer to section "Explicit conversion" under "See also".

The ENO enable output has the signal state "0" if one of the following conditions is fulfilled:

● The EN enable input has the signal state "0".

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the "Convert value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
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Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Bit strings, 
integers, 
floating-point 
numbers, 
CHAR, 
BCD16, 
BCD32

I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Value to be 
converted.

OUT Output Bit strings, 
integers, 
floating-point 
numbers, 
CHAR, 
BCD16, 
BCD32

I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
conversion

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

Bit strings (BYTE, WORD, DWORD, LWORD) cannot be selected in the instruction box. If you 
specify an operand of data type BYTE, WORD, DWORD or LWORD at a parameter of the 
instruction, it is interpreted according to the data type of the input or output parameter. Data 
type BYTE is then interpreted as USINT, WORD as UINT, DWORD as UDINT, and LWORD 
as LINT, for example.

 

 Note

For S7-1500 CPU: You can select the data types DWORD and LWORD if REAL or LREAL 
were selected as IN data type.

 

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

If the operand "TagIn" has the signal state "1", the content of the operand "TagIn_Value" is 
read and converted to an integer (16 bits). The result is stored in the operand "TagOut_Value". 
The output "TagOut" is set to "1" if the instruction was executed without errors.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ROUND: Round numerical value

Description     
You can use the "Round numerical value" instruction to round the value at input IN  to the 
nearest integer. The instruction interprets the value at input IN as a floating-point number and 
converts this to the nearest integer. If the input value is exactly between an even and odd 
number, then the even number is converted. The result of the instruction is provided at output 
OUT and can be queried there.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the "Round numerical value" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value to 
be rounded.

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
rounding

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 2 -2

If the operand "TagIn" has the signal state "1", the "Round numerical value" instruction is 
executed. The floating-point number at input "TagIn_Value" is rounded to the nearest even 
integer and sent to output "TagOut_Value". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

CEIL: Generate next higher integer from floating-point number

Description     
You can use the "Generate next higher integer from floating-point number" instruction to round 
the value at input IN to the next higher integer. The instruction interprets the value at input IN 
as a floating-point number and converts this to the next higher integer. The result of the 
instruction is provided at output OUT and can be queried there. The output value can be greater 
than or equal to the input value.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.
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Parameters
The following table shows the parameters of the instruction "Generate next higher integer from 
floating-point number":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value as 
floating-point 
number

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result with the 
next higher 
integer

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 1 0

If the operand "TagIn" has the signal state "1", the instruction "Generate next higher integer 
from floating-point number" is executed. The floating-point number at input "TagIn_Value" is 
rounded to the next higher integer and sent to output "TagOut_Value". If no errors occur during 
the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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FLOOR: Generate next lower integer from floating-point number

Description     
You can use the "Generate next lower integer from floating-point number" instruction to round 
the value at input IN to the next lower integer. The instruction interprets the value at input IN 
as a floating-point number and converts this to the next lower integer. The result of the 
instruction is provided at output OUT and can be queried there. The output value can be less 
than or equal to the input value.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the instruction "Generate next lower integer from 
floating-point number":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value as 
floating-point 
number

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L, P I, Q, M, D, L, P Result with the 
next lower 
integer

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2333



Parameters Operand Value
IN TagIn_Value 0.50000000 -0.50000000
OUT TagOut_Value 0 -1

If the operand "TagIn" has the signal state "1", the instruction "Generate next lower integer 
from floating-point number" is executed. The floating-point number at input "TagIn_Value" is 
rounded to the next lower integer and displayed at output "TagOut_Value". If no errors occur 
during the execution of the instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

TRUNC: Truncate numerical value

Description       
You can use the "Truncate numerical value" instruction to form an integer from the value at 
input IN. The value at input IN is interpreted as a floating-point number. The instruction selects 
only the integer part of the floating-point number and sends this to output OUT without decimal 
places.

Enable output ENO has the signal state "0" if one of the following conditions applies:

● Enable input EN has the signal state "0".

● Errors, such as an overflow, occur during execution.

Parameters
The following table shows the parameters of the instruction "Truncate numerical value":

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Floating-point 

numbers
I, Q, M, D, L or 
constant

Input value as 
floating-point 
number

OUT Output Integers, floating-
point numbers

I, Q, M, D, L Result with integer 
part of the floating-
point number

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value 1.50000000 -1.50000000
OUT TagOut_Value 1 -1

If the operand "TagIn" has the signal state "1", the "Truncate numerical value" instruction is 
executed. The integer part of the floating-point number at input "TagIn_Value" is converted to 
an integer and sent to output "TagOut_Value". If no errors occur during the execution of the 
instruction, the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SCALE_X: Scale

Description
You can use the "Scale" instruction to scale the value at the VALUE input  by mapping it to a 
specified value range. When the instruction "Scale" is executed, the floating-point value at 
input VALUE is scaled to the value range, which is defined by the parameters MIN and MAX. 
The result of the scaling is an integer, which is stored at output OUT.

The following figure shows an example of how values can be scaled:
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The "Scale" instruction works with the following equation:

OUT = [VALUE ∗ (MAX – MIN)] + MIN

Enable output ENO has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The value at input MIN is greater than or equal to the value at input MAX.

● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● An overflow occurs.

● The value at input VALUE is NaN (Not a number = result of an invalid arithmetic operation).
 

 Note

For more information on the conversion of analog values, refer to the respective manual.
 

Parameters
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
MIN Input Integers, 

floating-point 
numbers

I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Low limit of the 
value range
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

VALUE Input Floating-point 
numbers

I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Value to be 
scaled.
If you enter a 
constant, you 
must declare it.

MAX Input Integers, 
floating-point 
numbers

I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Integers, 
floating-point 
numbers

I, Q, M, D, L I, Q, M, D, L Result of 
scaling

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 0.5
MAX Tag_MAX 30
OUT Tag_Result 20

If the operand "TagIn" has the signal state "1", the "Scale" instruction is executed. The value 
at input "Tag_Value" is scaled to the range of values defined by the values at inputs "Tag_MIN" 
and "Tag_MAX". The result is stored at output "Tag_Result". If the instruction is executed 
without errors, the ENO enable output has the signal state "1" and the "TagOut" output is set.
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

NORM_X: Normalize (Page 2338)

Declaring global constants (Page 1436)

NORM_X: Normalize

Description
You can use the instruction "Normalize" to normalize the value of the tag at the VALUE input 
by mapping it to a linear scale. You can use the parameters MIN and MAX to define the limits 
of a value range that is applied to the scale. Depending on the location of the normalized value 
in this value range, the result at output OUT is calculated and stored as a floating-point number. 
If the value to be normalized is equal to the value at input MIN, output OUT returns the value 
"0.0". If the value to be normalized is equal to the value at input MAX, output OUT returns the 
value "1.0".

The following figure shows an example of how values can be normalized:

The "Normalize" instruction works with the following equation:

OUT = (VALUE – MIN) / (MAX – MIN)

Enable output ENO has the signal state "0" if one of the following conditions is fulfilled:

● Enable input EN has the signal state "0".

● The value at input MIN is greater than or equal to the value at input MAX.
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● The value of a specified floating-point number is outside the range of the normalized 
numbers according to IEEE-754.

● The value at input VALUE is NaN (result of an invalid arithmetic operation).
 

 Note

For more information on the conversion of analog values, refer to the respective manual.
 

Parameters
The following table shows the parameters of the instruction "Normalize":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
MIN 1) Input Integers, 

floating-point 
numbers

I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Low limit of the 
value range

VALUE 1) Input Integers, 
floating-point 
numbers

I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

Value to be 
normalized.

MAX 1) Input Integers, 
floating-point 
numbers

I, Q, M, D, L 
or constant

I, Q, M, D, L or 
constant

High limit of the 
value range

OUT Output Floating-point 
numbers

I, Q, M, D, L I, Q, M, D, L Result of the 
normalization

1) If you use constants in these three parameters, you only need to declare one of them.

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MIN Tag_MIN 10
VALUE Tag_Value 20
MAX Tag_MAX 30
OUT Tag_Result 0.5

If the operand "TagIn" has the signal state "1", the "Normalize" instruction is executed. The 
value at input "Tag_Value" is assigned to the range of values defined by the values at inputs 
"Tag_MIN" and "Tag_MAX". The tag value at input "Tag_Value" is normalized corresponding 
to the defined value range. The result is stored as a floating-point number at output 
"Tag_Result". If the instruction is executed without errors, the ENO enable output has the signal 
state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SCALE_X: Scale (Page 2335)

Declaring global constants (Page 1436)

Other

SCALE: Scale

Description
Use the Scale instruction to convert the integer at the IN parameter into a floating-point number, 
which can be scaled in physical units between a low limit value and a high limit value. You can 
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use the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the value range 
to which the input value is scaled. The result of the instruction is output at the OUT parameter.

The "Scale" instruction works with the following equation:

OUT = [((FLOAT (IN) – K1)/(K2–K1)) ∗ (HI_LIM–LO_LIM)] + LO_LIM

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "K2", the result 
of the instruction is set to the value of the high limit (HI_LIM) and an error is output. 

When the value at the IN parameter is less than the value of the constant "K1", the result of 
the instruction is set to the value of the low limit value (LO_LIM) and an error is output. 

When the indicated low limit value is greater than the high limit value (LO_LIM > HI_LIM), the 
result is scaled in reverse proportion to the input value. 

Parameters
The following table shows the parameters of the "Scale" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input INT I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Input value to 
be scaled.

HI_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

High limit 

LO_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Indicates if the 
value at IN 
parameter is to 
be interpreted 
as bipolar or 
unipolar. The 
parameter can 
assume the 
following 
values:
1: Bipolar
0: Unipolar
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

OUT Output REAL I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P I, Q, M, D, L, P Error 
information

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the  IN parameter is greater than the value of the "K2" constant or less than the value of the 

"K1" constant.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 22
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 50.03978588
RET_VAL Tag_ErrorCode W#16#0000
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See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2364)

UNSCALE: Unscale

Description
The "Unscale" instruction unscales the floating-point number at the IN parameter into physical 
units between a low limit value and a high limit and converts them into integers. You can use 
the LO_LIM and HI_LIM parameters to specify the low limit and high limit of the value range 
to which the input value is unscaled. The result of the instruction is output at the OUT parameter.

The "Unscale" instruction works with the following equation:

OUT = [ ((IN–LO_LIM)/(HI_LIM–LO_LIM)) ∗ (K2–K1) ] + K1

The values of the constants "K1" and "K2" are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter:

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the constant "HI_LIM", the 
result of the instruction is set to the value of the constant (K2) and an error is output. 

When the value at the IN parameter is less than the value of the constant of the low limit 
(LO_LIM), the result of the instruction is set to the value of the constant (K1) and an error is 
output.

Parameters
The following table shows the parameters of the "Unscale" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Input BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Input value to 
be unscaled to 
an integer 
value.

HI_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

High limit
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

LO_LIM Input REAL I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Low limit

BIPOLAR Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Indicates if the 
value at the IN 
parameter is to 
be interpreted 
as bipolar or 
unipolar. The 
parameter can 
assume the 
following 
values:
1: Bipolar
0: Unipolar

OUT Output INT I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

RET_VAL Output WORD I, Q, M, D, L, P I, Q, M, D, L, P Error 
information

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0008 The value of the IN parameter is greater than the value of the high limit (HI_LIM) or less than the value 

of the low limit (LO_LIM).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:
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The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 50.03978588
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_OutputValue 22
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2364)

Program control operations

JMP: Jump if RLO = 1

Description     
You can use the "Jump if RLO = 1" instruction to interrupt the linear execution of the program 
and resume it in another network. The target network must be identified by a jump label 
(LABEL). The jump label description is entered in the placeholder above the instruction box.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil can occur in a 
network.

If the result of logic operation (RLO) at the input of the instruction is "1", the jump to the network 
identified by the jump label is executed. The jump direction can be towards higher or lower 
network numbers.

If the condition at the input of the instruction is not fulfilled (RLO = 0), execution of the program 
continues in the next network.
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Example
The following example shows how the instruction works:

If the operand "TagIn_1" has the signal state "1", the instruction "Jump if RLO = 1" is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If input "TagIn_3" has the signal state "1", output "TagOut_3" 
is reset.

See also
Overview of the valid data types (Page 1320)

JMPN: Jump if RLO = 0

Description     
You can use the instruction "Jump if RLO = 0" to interrupt the linear execution of the program 
and resume it in another network, when the result of logic operation at the input of the 
instruction is "0". The target network must be identified by a jump label (LABEL). The jump 
label description is entered in the placeholder above the instruction box.

The specified jump label must be in the same block in which the instruction is executed. The 
name you specify can only occur once in the block. Only one jumping coil can occur in a 
network.

If the result of logic operation (RLO) at the input of the instruction is "0", the jump to the network 
identified by the jump label is executed. The jump direction can be towards higher or lower 
network numbers.

If the result of the logic operation RLO at the input of the instruction is "1", execution of the 
program continues in the next network.
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Example
The following example shows how the instruction works:

If the operand "TagIn_1" has the signal state "0", the instruction "Jump if RLO = 0" is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If input "TagIn_3" has the signal state "1", output "TagOut_3" 
is reset.

See also
Overview of the valid data types (Page 1320)

LABEL: Jump label

Description       
The jump label identifies a destination network in which the execution of the program can be 
resumed after the execution of a jump instruction.

The jump label and the instruction in which the jump label is specified must be located in the 
same block. The name of a jump label can only be assigned once in a block. You can declare 
up to 32 jump labels when you use a CPU S7-1200 and a maximum of 256 jump labels when 
you use a CPU S7-1500.

Only one jump label can be placed in a network. Each jump label can jump to several locations.
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Example
The following example shows how the instruction works:

If the operand "TagIn_1" has the signal state "1", the instruction "Jump if RLO = 1" is executed. 
The linear execution of the program is interrupted and continues in Network 3, which is 
identified by the jump label CAS1. If input "TagIn_3" has the signal state "1", output "TagOut_3" 
is reset.

See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

JMP_LIST: Define jump list

Description
You can use the "Define jump list" instruction to define several conditional jumps and continue 
the program execution in a specific network depending on the value of the K parameter.

You define the jumps with jump labels (LABEL), which you specify at the outputs of the 
instruction box. The number of outputs can be expanded in the instruction box. You can declare 
up to 32 outputs when you use a CPU S7-1200 and a maximum of 99 outputs when you use 
a CPU S7-1500.

The numbering of the outputs begins with the value "0" and is continued in ascending order 
with each new output. Only jump labels can be specified at the outputs of the instruction. It is 
not permitted to specify instructions or operands.

The value of the K parameter specifies the number of the output and thus the jump label where 
the program execution is to be resumed. If the value in the K parameter is greater than the 
number of available outputs, the program execution is resumed in the next network of the block.
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The "Define jump list" instruction is only executed if the signal state is "1" at the EN enable 
input.

Parameters
The following table shows the parameters of the "Define jump list" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, L, D Enable input
K Input UINT I, Q, M, L, D or 

constant
Specifies the 
number of the 
output and thus 
the jump that is 
executed.

DEST0 - - - First jump label
DEST1 - - - Second jump label
DESTn - - - Optional jump 

labels

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 1
DEST0 LABEL0 Jump to the network that is 

identified with the jump label 
"LABEL0".

DEST1 LABEL1 Jump in the network that is 
identified with the jump label 
"LABEL1".

DEST2 LABEL2 Jump in the network that is 
identified with the jump label 
"LABEL2".
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If the operand "Tag_Input" has the signal state "1", the instruction "Define jump list" is executed. 
The execution of the program is continued according to the value of the operand "Tag_Value" 
in the network that is identified with the jump label "LABEL1".

See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

SWITCH: Jump distributor

Description       
You can use the "Jump distributor" instruction to define multiple program jumps to be executed 
depending on the result of one or more comparison instructions.

At the parameter K, you specify the value to be compared. This value is compared with the 
values that the individual inputs return. You select the type of comparison for each input. The 
availability of various comparison instructions depends on the data type of the instruction.

The following table shows the comparison instructions that are available depending on the 
selected data type:

Data type Instruction Syntax
S7-1200 S7-1500
Bit strings Bit strings Equal ==

Not equal <>
Integers, floating-point 
numbers, TIME, 
DATE, TOD

Integers, floating-point 
numbers, TIME, 
LTIME, DATE, TOD, 
LTOD, LDT

Equal ==
Not equal <>
Greater or equal >=
Less or equal <=
Greater than >
Less than <

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box. If you select a comparison instruction and the data type of the instruction is not yet defined, 
then the "<???>" drop-down list will only list those data types that are permitted for the selected 
comparison instruction.

The execution of the instruction begins with the first comparison and is executed until a 
comparison condition is fulfilled. When a comparison condition is fulfilled the subsequent 
comparison conditions are not considered. If none of the specified comparison conditions are 
fulfilled, the jump is executed at output ELSE. If not jump label is defined at output ELSE, the 
linear execution of the program is not interrupted but instead continued in the next network.

In its initial state the instruction box contains at least 2 outputs (DEST0 and DEST1). The 
number of outputs can be extended. The numbering of the outputs begins with the value "0" 
and is continued in ascending order with each new output. Specify jump labels (LABEL) at the 
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outputs of the instruction. It is not permitted to specify instructions or operands at the outputs 
of the instruction.

An input is automatically inserted to each additional output. The jump programmed at an output 
is executed when the comparison condition of the corresponding is fulfilled.

Parameters
The following table shows the parameters of the instruction "Jump distributor":

Parameters Declarat
ion

Data type Memory area Description

  S7-1200 S7-1500
EN Input BOOL BOOL I, Q, M, D, L Enable input
K Input UINT UINT I, Q, M, D, L or 

constant
Specifies the value to 
be compared.

<Comparison 
values>

Input Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
DATE, 
TOD

Bit strings, 
integers, 
floating-
point 
numbers, 
TIME, 
LTIME, 
DATE, 
TOD, 
LTOD, LDT

I, Q, M, D, L or 
constant

Input values with 
which the value of the 
parameter K is 
compared.

DEST0 - - - - First jump label
DEST1 - - - - Second jump label
DEST(n) - - - - Optional jump labels

(n = 2 to 99)
ELSE - - - - Program jump which 

is executed if none of 
the comparison 
conditions are fulfilled.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand/Jump label Value
K Tag_Value 23
== Tag_Value_1 20
> Tag_Value_2 21
< Tag_Value_3 19
DEST0 LABEL0 Jump to jump label "LABEL0", if 

the value of parameter K is equal 
to 20.

DEST1 LABEL1 Jump to jump label "LABEL1", if 
the value of parameter K is 
greater than 21.

DEST2 LABEL2 Jump to jump label "LABEL2", if 
the value of parameter K is less 
than 19.

ELSE LABEL 3 Jump to jump label "LABEL3", if 
none of the comparison 
conditions are fulfilled.

If the operand "Tag_Input" changes to signal state "1", the instruction "Jump distributor" is 
executed. The execution of the program is continued in the network that is identified with the 
jump label "LABEL1".

See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)
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RET: Return

Description     
You can use the instruction "Return" to stop the execution of a block. This results in three 
types, in which the block processing can be completed:

● Without call of the "Return" instruction
The block is exited after the execution of the last network. The ENO of the call function is 
set to the signal state "1".

● Call of the "Return" instruction with logic operation (see example)
If the left connector has the signal state "1", then the block is exited. The  ENO of the function 
call corresponds to the operand.

● Call of the "Return" instruction without logic operation
The block is exited. The  ENO of the function call corresponds to the operand.

 

  Note

Only one jumping coil may be used in a network ("Return", "Jump if RLO = 1", "Jump if 
RLO = 0").

 

If the result of logic operation (RLO) at the input of the instruction "Return" is "1", the execution 
of the program is terminated in the currently called block and continued after the call function 
in the calling block (for example, in the calling OB). The status (ENO) of the call function is 
determined by the parameter of the instruction. This can assume the following values:

● RLO

● TRUE/FALSE

● <Operand>

To set the parameter values, double-click the instruction and select the corresponding value 
in the drop-down list.

The following table shows the status of the call function when the instruction "Return" is 
programmed in a network within the called block:

RLO Parameter value ENO of the call function
1 RLO 1

TRUE 1
FALSE 0
<Operand> <Operand>

0 RLO In this case, the execution of the program 
continues in the next network of the called 
block.

TRUE
FALSE
<Operand>

If an OB is completed, another block is selected by the priority class system and started or re-
executed.
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● If the OB program cycle was completed, it is restarted.

● If an OB, which interrupted another block (e.g. an Alarm OB), is completed, then the 
interrupted block (e.g. OB program cycle) is executed.

Parameters
The following table shows the parameters of the instruction "Return":

Parameters Declaration Data type Memory area Description
Status of the 
calling function 
when RLO = 1:
RLO - - - Is set to the signal 

state of the RLO.
TRUE - - - 1
FALSE - - - 0
<Operand> Input BOOL I, Q, M, D, L Signal state of the 

specified operand

Example
The following example shows how the instruction works:

If the operands "TagIn_1" or "TagIn_2" have signal state "1", the instruction "Return" is 
executed. Program execution in the called block is terminated and continues in the calling 
block. The enable output ENO of the call function is reset to signal state "0".

See also
Overview of the valid data types (Page 1320)

Runtime control

ENDIS_PW: Limit and enable password legitimation

Description
You use the "Limit and enable password legitimation" instruction to specify whether passwords 
configured for the CPU are legitimized or not. In this way, you can prevent legitimized 
connections, even if the correct password is known.
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When the instruction is called and the REQ parameter has the signal state "0", the currently 
set state is displayed at the output parameters. If changes have been made to the input 
parameters, these are not transferred to the output parameters.

When the instruction is called and the REQ parameter has the signal state "1", the signal state 
is taken from the input parameters (F_PWD, FULL_PWD, R_PWD, HMI_PWD). FALSE means 
that legitimation per password is not permitted; TRUE means the password can be used.

Disable or enabling of the passwords can be allowed or prohibited individually. For example, 
all passwords can be prohibited except the fail-safe password. You can thus limit access 
options to a small user group. The output parameters (F_PWD_ON, FULL_PWD_ON, 
R_PWD_ON, HMI_PWD_ON) always show the current status of the password use, regardless 
of the REQ parameter.

Passwords that are not configured must have the signal state TRUE at the input and return 
the signal state TRUE at the output. The fail-safe password can only be configured for an F-
CPU and must therefore always be interconnected with the signal state TRUE in a standard 
CPU. If the instruction returns an error, the call has no effect and the previous lock is still in 
effect.

Disabled passwords can be enabled again under the following conditions:

● The CPU is reset to its factory settings.

● The front panel of the S7-1500 CPU supports a dialog that allows you to navigate to the 
appropriate menu in which the passwords can be enabled again.

● When you call the "Limit and enable password legitimation" instruction, the input parameter 
of the desired password has the signal state "1".

● Set the mode selector to STOP. The restriction to password legitimation is re-established 
as soon as the switch is set back to RUN.

● Plugging an empty memory card (transfer module or program card) into an S7-1200 CPU.

● The transition from POWER OFF to POWER ON disables the protection in the S7-1200 
CPU. The "Limit and enable password legitimation" instruction must be called once again 
in the program (e.g. in the startup OB).

 

 Note

The "Limit and enable password legitimation" instruction blocks access from HMI systems if 
the HMI password has not been enabled.

 

 Note

Existing legitimized connections retain their access rights and you cannot use the "Limit and 
enable password legitimation" instruction to restrict them.

 

Preventing unintentional lockout on an S7-1500 CPU
The settings can be made on the front panel of the CPU and the CPU saves the most recent 
setting.

To prevent accidental lockout, the protection can be disabled by setting the mode selector to 
STOP with an S7-1500 CPU. The protection is automatically enabled again by setting mode 
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selector to RUN without having to call the "Limit and enable password legitimation" instruction 
again or taking additional actions on the front panel.

Preventing unintentional lockout on an S7-1200 CPU
Because the S7-1200 CPU does not have a mode switch, protection is disabled with POWER 
OFF - POWER ON. This means that it is possible and advisable to prevent accidental lockout 
with the help of specific program sequences within your program.

To do so, program a time control either by means of a cyclic interrupt OB or a timer in the Main 
OB (OB 1). This gives you the option of calling the "Limit and enable password legitimation" 
instruction in the respective OB (e.g., OB 1 or OB 35) relatively quickly after a transition from 
POWER OFF to POWER ON and the associated disabling of the protection. Call the instruction 
in the startup OB (OB 100) to keep the time window in which the instruction is inactive and 
there are no limitations for password legitimation relatively small. This procedure will give you 
the best possible protection from unauthorized access.

If there has been an accidental lockout, you can skip the call in the startup OB (by querying 
an input parameter, for example) and you have the set time (for example, 10 seconds up to 1 
minute) to establish a connection to the CPU before the lock becomes active once again.

If there is no timer in your program code and a lockout has occurred, insert an empty transfer 
card or an empty program card into the CPU. The empty transfer card or program card deletes 
the internal load memory of the CPU. You must then download the user program once again 
from STEP 7 to the CPU.

Procedure for lost passwords with an S7-1200 CPU
If you have lost the password for a password-protected S7-1200 CPU, delete the password-
protected program with an empty transfer card or program card. The empty transfer card or 
program card deletes the internal load memory of the CPU. You can then load a new user 
program from STEP 7 Basic in the CPU.

 

 WARNING

Inserting an empty transfer card

When you insert a transfer card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

Once you have pulled the transfer card, the content of the transfer card is available in the 
internal load memory. Make sure that the card does not include a program at this point.
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 WARNING

Inserting an empty program card

When you insert a program card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

Make sure that the program card is empty. The internal load memory is copied to the empty 
program card. Once you have pulled the previously empty program card, the internal load 
memory is empty.

 

You must remove the transfer card or program card before you put the CPU into RUN mode.

Effects of password use on the operating modes
The following table shows what effects the password use by means of the "Limit and enable 
password legitimation" instruction has on the operating modes and the corresponding user 
actions.

Action Password protection by means of the 
instruction

Basic state after
● Operating mode switch to STOP
● Reset memory manually (PG, switch, change of 

MC (Motion Control))
● Reset to factory setting

Not activated
(no restrictions)

Basic state after POWER ON ● S7-1200 CPU:
The lock is disabled and the instruction 
must be called once again in the program 
(e.g., in the startup OB).

● S7-1500 CPU:
Enabled (if a lock was activated before 
POWER OFF). The option of not allowing 
passwords is retentive.

Operating mode transition RUN/STARTUP/HOLD -> 
STOP (by terminating the instruction, an error or 
communication) or STOP -> STARTUP/RUN/HOLD

Activated
Passwords still cannot be used.

Parameters
The following table shows the parameters of the "Limit and enable password legitimation" 
instruction:

Parameter Declaratio
n

Data type Memory area Description

EN Input BOOL I, Q, M, D, L Enable input
ENO Output BOOL I, Q, M, D, L Enable output
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Parameter Declaratio
n

Data type Memory area Description

REQ Input BOOL I, Q, M, D, L or 
constant

When the REQ parameter has the signal state "0", the 
currently set signal state of the passwords is queried.

F_PWD Input BOOL I, Q, M, D, L or 
constant

Read/write access including fail-safe
● F_PWD = "0": Do not allow password
● F_PWD = "1": Allow password

FULL_PW
D

Input BOOL I, Q, M, D, L or 
constant

Read/write access
● FULL_PWD = "0": Do not allow password
● FULL_PWD = "1": Allow password

R_PWD Input BOOL I, Q, M, D, L or 
constant

Read access
● R_PWD = "0": Do not allow password
● R_PWD = "1": Allow password

HMI_PWD Input BOOL I, Q, M, D, L or 
constant

HMI access
● HMI_PWD = "0": Do not allow password
● HMI_PWD = "1": Allow password

F_PWD_O
N

Output BOOL I, Q, M, D, L Read/write access including fail-safe
● F_PWD_ON = "0": Password not allowed
● F_PWD_ON = "1": Password allowed

FULL_PW
D_ON

Output BOOL I, Q, M, D, L Read/write access status
● FULL_PWD_ON = "0": Password not allowed
● FULL_PWD_ON = "1": Password allowed

R_PWD_
ON

Output BOOL I, Q, M, D, L Read-access status
● R_PWD_ON = "0": Password not allowed
● R_PWD_ON = "1": Password allowed

HMI_PWD
_ON

Output BOOL I, Q, M, D, L HMI-access status
● HMI_PWD_ON = "0": Password not allowed
● HMI_PWD_ON = "1": Password allowed

RET_VAL Output WORD I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8090 The "Limit and enable password legitimation" instruction is not supported
80D0 The password for fail-safe is not configured. The signal state must be TRUE for 

standard CPUs.
80D1 The read/write access is not configured
80D2 The read access is not configured
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Error code*
(W#16#...)

Explanation

80D3 The HMI access is not configured
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of error handling (Page 1635)

Principles of local error handling (Page 1637)

Error output priorities (Page 1638)

Enabling local error handling for a block (Page 1639)

RE_TRIGR: Restart cycle monitoring time

Description
You can use the "Restart cycle monitoring time" instruction to restart the cycle time monitoring 
of the CPU. The cycle monitoring time then starts over for the duration you have set in the 
CPU configuration. 

The instruction "Restart cycle monitoring time" can be called regardless of the priority in all 
blocks.

If the instruction is called in a block with a higher priority, such as a hardware interrupt, a 
diagnostics interrupt or a cyclic interrupt, the instruction is not executed and the ENO enable 
output is set to signal state "0".

The instruction "Restart cycle monitoring time" can be called a maximum of 10 times in a 
program cycle.

Parameters
The instruction "Restart cycle monitoring time" has no parameters.

See also
Overview of the valid data types (Page 1320)

Basics of error handling (Page 1635)

Principles of local error handling (Page 1637)

Error output priorities (Page 1638)

Enabling local error handling for a block (Page 1639)

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2359



STP: Exit program

Description       
The instruction "Exit program" instruction is used to set the CPU to STOP mode and therefore 
to terminate the execution of the program. The effects of changing from RUN to STOP depend 
on the CPU configuration.

When the (RLO) at the input of the instruction is "1", the CPU changes to STOP mode and the 
execution of the program is terminated. The signal state at the output of the instruction is not 
evaluated.

If the RLO at the input of the instruction is "0", then the instruction will not be executed.

Parameters
The instruction "Exit program" has no parameters.

See also
Overview of the valid data types (Page 1320)

GET_ERROR: Get error locally

Description
The "Get error locally" instruction is used to query the occurrence of errors within a block. This 
is usually to access error. If the system reports an error during the processing of the block, 
detailed information is stored in the operand at the ERROR output for the first error to occur 
during the execution of the block since the last execution of the instruction.

Only operands of the "ErrorStruct" system data type can be specified at the ERROR output. 
The "ErrorStruct" system data type specifies the exact structure in which the information about 
the error is stored. Using additional instructions, you can evaluate this structure and program 
an appropriate response. If several errors occur in the block, the error information about the 
next error to occur in the instruction is output only after the first error that occurred has been 
remedied.

 

 Note

The ERROR output is only changed if error information is present. To set the output back to 
"0" after handling an error, you have the following options:
● Declare the tag in the "Temp" section of the block interface.
● Reset the tag to "0" before calling the instruction.
● Query the enable output ENO.

 

The enable output ENO of the instruction "Get error locally" instruction is set only if the enable 
input EN returns signal state "1" and error information is present. If one of these conditions is 
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not fulfilled, the remaining program execution is not affected by the "Get error locally" 
instruction.

You can find an example of how you can implement the instruction in combination with other 
troubleshooting options under "See also".

 

 Note

The "Get error locally" instruction enables local error handling within a block. If "Get error 
locally" is inserted in the program code of a block, any predefined system reactions are 
ignored if errors occur.

 

Parameters
The following table lists the parameters of the "Get error locally" instruction:

Parameter Declaration Data type Memory area Description
ERROR Output ErrorStruct D, L Error information

Data type "ErrorStruct"
The following table lists the structure of the "ErrorStruct" data type:

Structure component Data type Description
ERROR_ID WORD Error ID
FLAGS BYTE Shows if an error occurred during a 

block call.
16#01: Error during a block call 
16#00: No error during a block call 

REACTION BYTE Default reaction: 
0: Ignore (write error), 
1: Continue with substitute value "0" 
(read error), 
2: Skip instruction (system error)

CODE_ADDRESS CREF Information about the address and 
type of block

 BLOCK_TYPE BYTE Type of block where the error 
occurred:
1: OB
2: FC
3: FB

 CB_NUMBER UINT Number of the code block
 OFFSET UDINT Reference to the internal memory
MODE BYTE Information about the address of an 

operand
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Structure component Data type Description
OPERAND_NUMBER UINT Operand number of the machine 

command
POINTER_NUMBER_LOCATION UINT (A) Internal pointer
SLOT_NUMBER_SCOPE UINT (B) Storage area in internal memory
DATA_ADDRESS NREF Information about the address of an 

operand
 AREA BYTE (C) Memory area:

L: 16#40 – 4E, 86, 87, 8E, 8F, C0 – 
CE
I: 16#81
Q: 16#82
M: 16#83
DB: 16#84, 85, 8A, 8B
Range violations for a directly 
editable tag of data type DINT: 16#04

 DB_NUMBER UINT (D) Number of the data block
 OFFSET UDINT (E) Relative address of the operand

Structure component "ERROR_ID"
The following table lists the values that can be output at the structure component "ERROR_ID":

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
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ID*
(hexadecimal)

ID*
(decimal)

Description

2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 The block property "Parameter passing via registers" is not selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

An error occurred accessing the "#Field[#index]" tag. The enable output ENO of the "Multiply" 
instruction and the "#TagOut_Enabled" operand have signal state "1" despite the read/access 
error and the multiplication is performed with the value "0.0". If this error scenario occurs, it is 
recommended to program the "Get error locally" instruction after the "Multiply" instruction to 
get the error. The error information supplied by the "Get error locally" instruction is evaluated 
with the comparison instruction "Equal". If the "#Error.REACTION" structure component has 
the value "1", this involves a read/access error and the "#TagOut_Enabled" output is reset.
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See also
Overview of the valid data types (Page 1320)

Basics of error handling (Page 1635)

Principles of local error handling (Page 1637)

Error output priorities (Page 1638)

Enabling local error handling for a block (Page 1639)

Querying and fixing errors in the program code (Page 286)

GET_ERR_ID: Get error ID locally

Description
The "Get error ID locally" instruction is used to query the occurrence of errors within a block. 
This is usually to access error. If the system reports during the block processing errors within 
the block execution since the last execution of the instruction, the error ID of the first error that 
occurred in the tag is stored at the ID output.

Only operands of the WORD data type can be specified at the ID output. If several errors occur 
in the block, the error ID of the next error to occur in the instruction is output only after the first 
error that occurred has been remedied.

 

 Note

The ID output is only changed if error information is present. To set the output back to "0" 
after handling an error, you have the following options:
● Declare the tag in the "Temp" section of the block interface.
● Reset the tag to "0" before calling the instruction.
● Query the enable output ENO.

 

The enable output ENO of the instruction "Get error ID locally" instruction is set only if the 
enable input EN returns signal state "1" and error information is present. If one of these 
conditions is not fulfilled, the remaining program execution is not affected by the "Get error ID 
locally" instruction.

You can find an example of how you can implement the instruction in combination with other 
troubleshooting options under "See also".

 

 Note

The "Get error ID locally" instruction enables local error handling within a block. If the "Get 
error ID locally" instruction is inserted in the program code of a block, any predefined system 
reactions are ignored if errors occur.
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Parameters
The following table lists the parameters of the "Get error ID locally" instruction:

Parameter Declaration Data type Memory area Description
ID Output WORD I, Q, M, D, L Error ID

ID parameter
The following table lists the values that can be output at the ID parameter:

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist 
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 The block property "Parameter passing via registers" is not selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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Example
The following example shows how the instruction works:

An error occurred accessing the "#Field[#index]" tag. The enable output ENO of the "Multiply" 
instruction and the "#TagOut_Enabled" operand have signal state "1" despite the read/access 
error and the multiplication is performed with the value "0.0". If this error scenario occurs, it is 
recommended to program the "Get error ID locally" instruction after the "Multiply" instruction 
to get the error. The error information supplied by the "Get error ID locally" instruction is 
evaluated with the comparison instruction "Equal". If the operand "#TagID" returns the ID 2522, 
this involves a read/access error and the value "100.0" is written to the "#TagOut" output.

See also
Overview of the valid data types (Page 1320)

Basics of error handling (Page 1635)

Principles of local error handling (Page 1637)

Error output priorities (Page 1638)

Enabling local error handling for a block (Page 1639)

Querying and fixing errors in the program code (Page 286)
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INIT_RD: Initialize all retain data

Description
The "Initialize all retain data" instruction is used to reset the retentive data of all data blocks, 
bit memories and SIMATIC timers and counters at the same time. The instruction can only be 
executed within a startup OB because the execution exceeds the program cycle duration.

Parameters
The following table shows the parameters of the "Initialize all retain data" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
REQ Input BOOL I, Q, M, D, L, T, C 

or constant
If the input "REQ" 
has the signal 
state "1", all 
retentive data are 
reset.

RET_VAL Output INT I, Q, M, D, L Error information:
If an error occurs 
during the 
execution of the 
instruction, an 
error code is 
output at the 
RET_VAL 
parameter.

For additional information on valid data types, refer to "See also".

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B5 The instruction cannot be executed because it was not programmed within a startup OB.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal values in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

If the operands "TagIn_1" and "Tag_REQ" have signal state "1", the instruction is executed. 
All retentive data of all data blocks, bit memories and SIMATIC timers and counters are reset. 
If the instruction is executed without errors, the ENO enable output has the signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of error handling (Page 1635)

Principles of local error handling (Page 1637)

Error output priorities (Page 1638)

Enabling local error handling for a block (Page 1639)

Basics of the EN/ENO mechanism (Page 1415)

GET_ERR_ID: Get error ID locally (Page 2364)

WAIT: Configure time delay

Description     
The "Configure time delay" instruction is used to halt the execution of the program for a set 
period of time. You indicate the period of time in microseconds on the WT parameter of the 
instruction.

You can configure time delays of up to 32767 microseconds (μs). The smallest possible delay 
time depends on the respective CPU and corresponds to the execution time of the "Configure 
time delay" instruction.

The execution of the instruction can be interrupted by higher priority events.

The "Configure time delay" instruction supplies no error information.
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Parameters
The following table shows the parameters of the "Configure time delay" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
WT Input INT I, Q, M, D, L, P or 

constant
Time delay in 
microseconds (μs)

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

RUNTIME: Measure program runtime

Description
The "Measure program runtime" instruction is used to measure the runtime of the entire 
program, individual blocks or command sequences.

If you want to measure the runtime of your entire program, call the instruction "Measure 
program runtime" in OB1. Measurement of the runtime is started with the first call and the 
output RET_VAL returns the runtime of the program after the second call. The measured 
runtime includes all CPU processes that can occur during the program execution, for example, 
interruptions caused by higher-level events or communication. The instruction "Measure 
program runtime" reads an internal counter of the CPU and write the value to the IN-OUT 
parameter MEM. The instruction calculates the current program runtime according to the 
internal counter frequency and writes it to output RET_VAL.

If you want to measure the runtime of individual blocks or individual command sequences, you 
need three separate networks. Call the instruction "Measure program runtime" in an individual 
network within your program. You set the starting point of the runtime measurement with this 
first call of the instruction. Then you call the required program block or the command sequence 
in the next network. In another network, call the "Measure program runtime" instruction a 
second time and assign the same memory to the IN-OUT parameter MEM as you did during 
the first call of the instruction. The "Measure program runtime" instruction in the third network 
reads an internal CPU counter and calculates the current runtime of the program block or the 
command sequence according to the internal counter frequency and writes it to the output 
RET_VAL.
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The "Measure program runtime" instruction uses an internal high-frequency counter to 
calculate the time. If the counter overruns, the instruction returns values <= 0.0. Ignore these 
runtime values.

 

 Note

The runtime of a command sequence cannot be determined exactly, because the sequence 
of instructions within a command sequence is changed during optimized compilation of the 
program.

 

Parameters
The following table lists the parameters of the "Measure program runtime" instruction:

Parameters Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
MEM InOut LREAL M, D, L Saves the starting 

point of the 
runtime 
measurement.

RET_VAL Output LREAL I, Q, M, D, L Returns the 
measured runtime 
in seconds

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works based on the runtime calculation of a 
program block:

Network 1:

Network 2:

Network 3:
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When the "TagIn1" operand in network 1 has the signal state "1", the instruction is executed. 
The starting point for the runtime measurement is set with the first call of the instruction and 
buffered as reference for the second call of the instruction in the "TagMemory" operand.

The "Best_before_date" program block FB1 is called in network 2.

When the FB1 program block has been executed and the "TagIn1" operand has the signal 
state "1", the instruction in network 3 is executed. The second call of the instruction calculates 
the runtime of the program block and writes the result to the output RET_VAL.

See also
Overview of the valid data types (Page 1320)

Basics of error handling (Page 1635)

Principles of local error handling (Page 1637)

Error output priorities (Page 1638)

Enabling local error handling for a block (Page 1639)

Word logic operations

AND: AND logic operation

Description     
You can use the instruction "AND logic operation" to link the value at input IN1 to the value at 
input IN2 bit-by-bit by AND logic and query the result at the output OUT.

When the instruction is executed, bit 0 of the value at input IN1 is linked by AND logic to bit 0 
of the value at input IN2. The result is stored in bit 0 of output OUT. The same logic operation 
is executed for all other bits of the specified values.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended. The inserted inputs are numbered in ascending order in the box. 
During the execution of the instruction, the values of all available input parameters are linked 
by AND logic. The result is stored at output "OUT".

The result bit has the signal state "1" only when both of the bits in the logic operation also have 
signal state "1". If one of the two bits of the logic operation has signal state "0", the 
corresponding result bit is reset.
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Parameters
The following table shows the parameters of the instruction "AND logic operation":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

First value for 
logic operation

IN2 Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for logic 
operation

INn Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0000 0000 0000 0101

If the operand "TagIn" has the signal state "1", the instruction "AND logic operation" is 
executed. The value of operand "Tag_Value1" is linked by AND to the value of the  operand 
"Tag_Value2". The result is mapped bit-for-bit and sent to the operand "Tag_Result". The 
enable output ENO and the output "TagOut" are set to signal state "1".
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See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

OR: OR logic operation

Description     
You can use the instruction "OR logic operation" to link the value at input IN1 to the value at 
input IN2 bit-by-bit by OR logic and query the result at the output OUT.

When the instruction is executed, bit 0 of the value at input IN1 is linked by OR logic to bit 0 
of the value at input IN2. The result is stored in bit 0 of output OUT. The same logic operation 
is executed for all bits of the specified tags.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended in the instruction box. The inserted inputs are numbered in ascending 
order in the box. During the execution of the instruction, the values of all available input 
parameters are linked by OR logic. The result is stored at output "OUT".

The result bit has the signal state "1" when at least one of the two bits in the logic operation 
has the signal state "1". If both of the bits of the logic operation have signal state "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the instruction "OR logic operation":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

First value for 
logic operation

IN2 Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for logic 
operation

INn Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1111

If the operand "TagIn" has the signal state "1", the instruction "OR logic operation" is executed. 
The value of operand "Tag_Value1" is linked by OR to the value of the  operand "Tag_Value2". 
The result is mapped bit-for-bit and sent to the operand "Tag_Result". The enable output ENO 
and the output "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

XOR: EXCLUSIVE OR logic operation

Description     
You can use the instruction "EXCLUSIVE OR logic operation" to link the value at input IN1 to 
the value at input IN2 bit-by-bit by EXCLUSIVE OR logic and query the result at the output 
OUT.

When the instruction is executed, bit 0 of the value at input IN1 is linked by EXCLUSIVE OR 
logic to bit 0 of the value at input IN2. The result is stored in bit 0 of output OUT. The same 
logic operation is executed for all other bits of the specified value.

In its initial state the instruction box contains at least 2 inputs (IN1 and IN2). The number of 
inputs can be extended in the instruction box. The inserted inputs are numbered in ascending 
order in the box. During the execution of the instruction, the values of all available input 
parameters are linked by EXCLUSIVE OR logic. The result is stored at output "OUT".
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The result bit has the signal state "1" when one of the two bits in the logic operation has the 
signal state "1". If both of the bits of the logic operation have signal state "1" or "0", the 
corresponding result bit is reset.

Parameters
The following table shows the parameters of the instruction "EXCLUSIVE OR logic operation":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN1 Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

First value for 
logic operation

IN2 Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Second value 
for logic 
operation

INn Input Bit strings I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Optional input 
values

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Result of the 
instruction

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN1 Tag_Value1 0101 0101 0101 0101
IN2 Tag_Value2 0000 0000 0000 1111
OUT Tag_Result 0101 0101 0101 1010

If the operand "TagIn" has the signal state "1", the instruction "EXCLUSIVE OR logic operation" 
is executed. The value of operand "Tag_Value1" is linked by EXCLUSIVE OR to the value of 
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the operand "Tag_Value2". The result is mapped bit-for-bit and sent to the operand 
"Tag_Result". The enable output ENO and the output "TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Adding additional inputs and outputs to FBD elements (Page 1585)

Removing instruction inputs and outputs (Page 1586)

Basics of the EN/ENO mechanism (Page 1415)

INV: Create ones complement

Description       
You can use the instruction "Create ones complement" to invert the signal status of the bits at 
input IN. When the instruction is processed, the value at input IN is linked to EXCLUSIVE OR 
by a hexadecimal mask (W#16#FFFF for 16-bit numbers or DW#16#FFFF FFFF for 32-bit 
number). This inverts the signal state of the individual bits that are then stored at output OUT.

Parameters
The following table shows the parameters of the instruction "Create ones complement":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Bit strings, 

integers
I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Input value

OUT Output Bit strings, 
integers

I, Q, M, D, L, P I, Q, M, D, L, P Ones 
complement of 
the value at 
input IN

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN TagIn_Value W#16#000F W#16#7E
OUT TagOut_Value W#16#FFF0 W#16#81

If the operand "TagIn" has the signal state "1", the "Create ones complement" instruction is 
executed. The instruction inverts the signal state of the individual bits at input "TagIn_Value" 
and writes the result to output "TagOut_Value". The enable output ENO and the output 
"TagOut" are set to signal state "1".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DECO: Decode

Description     
You can use the "Decode" instruction to set a bit in the output value specified by the input 
value.

The "Decode" instruction reads the value at the IN input and sets the bit in the output value 
whose bit position corresponds to the read value. The other bits in the output value are filled 
with zeroes. If the value at input IN is greater than 31, a modulo 32 instruction is executed.

Parameters
The following table shows the parameters of the "Decode" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
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Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input UINT I, Q, M, D, L, P 
or constant

I, Q, M, D, L, P 
or constant

Position of the 
bit in the output 
value which is 
set.

OUT Output Bit strings I, Q, M, D, L, P I, Q, M, D, L, P Output value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If the operand "TagIn" has the signal state "1", the "Decode" instruction is executed. The 
instruction reads bit number "3" from the value of the operand "TagIn_Value" and sets the third 
bit to the value of the operand "TagOut_Value".

If no errors occur during the execution of the instruction, the output ENO has the signal state 
"1" and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ENCO: Encode

Description     
The instruction "Encode" is used to read the bit number of the lowest bit in the input value and 
output it to the output OUT.
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The instruction "Encode" selects the least significant bit of the value at the IN input and writes 
its bit number to the tag in the output OUT.

Parameters
The following table shows the parameters of the instruction "Encode":

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

EN Input BOOL I, Q, M, D, L I, Q, M, D, L, T, 
C

Enable input

ENO Output BOOL I, Q, M, D, L I, Q, M, D, L Enable output
IN Input Bit strings I, Q, M, D, L, P 

or constant
I, Q, M, D, L, P 
or constant

Input value

OUT Output INT I, Q, M, D, L, P I, Q, M, D, L, P Output value

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following figure shows how the instruction works using specific operand values:

If the operand "TagIn" has the signal state "1", the "Encode" instruction is executed. The 
instruction selects bit position "3" as the least significant bit at input "TagIn_Value" and writes 
the value "3" to the tag at the output "TagOut_Value.

If the instruction is executed without errors, the ENO enable output has the signal state "1" 
and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)
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SEL: Select

Description
Depending on the signal state at switch (input G), the "Select" instruction selects one of the 
inputs IN0 or IN1 and moves its content to the output OUT. When the input G has the signal 
state "0", the value at the input IN0 is moved. When the input G has the signal state "1", the 
value at the input IN1 is moved to the output OUT.

The instruction can only be executed if the enable input EN has the signal state "1" and the 
tags at all parameters have the same data type.

Parameters
The following table shows the parameters of the "Select" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable input
ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable output
G Input BOOL BOOL I, Q, M, D, L 

or constant
I, Q, M, D, L, T, 
C or constant

Switch

IN0 Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, TOD, 
DATE, CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, DATE, 
CHAR

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

First input value

IN1 Input Bit strings, 
integers, 
floating-point 
numbers, 
TIME, TOD, 
DATE, CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, DATE, 
CHAR

I, Q, M, D, L, 
P or constant

I, Q, M, D, L, P 
or constant

Second input value

OUT Output Bit strings, 
integers, 
floating-point 
numbers, 
TIME, TOD, 
DATE, CHAR

Bit strings, 
integers, 
floating-point 
numbers, 
timers, TOD, 
LTOD, DATE, 
CHAR

I, Q, M, D, L, 
P

I, Q, M, D, L, P Result

You can select the data type of the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
G TagIn_G 0 1
IN0 TagIn_Value0 W#16#0000 W#16#4C
IN1 TagIn_Value1 W#16#FFFF W#16#5E
OUT TagOut_Value W#16#0000 W#16#5E

If the operand "TagIn" has the signal state "1", the instruction "Select" is executed. Based on 
the signal state at the "TagIn_G" input, the value of the "TagIn_Value0" or "TagIn_Value1" 
input is selected and moved to the "TagOut_Value" output. If the instruction is executed without 
errors, the enable output ENO has the signal state "1" and the output "TagOut" is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MUX: Multiplex

Description
You can use the instruction "Multiplex" to copy the content of a selected input to output OUT. 
In its initial state the instruction box contains at least 2 inputs (IN0 and IN1). The number of 
selectable inputs of the instruction box can be expanded. You can declare a maximum of 32 
inputs.

The inputs are numbered automatically in the box. Numbering starts at IN0 and is incremented 
continuously with each new input. You can use the parameter K to determine the input whose 
content should be copied to output OUT. If the value of the parameter K is greater than the 
number of available inputs, the content of the parameter ELSE is copied to output OUT and 
enable output ENO is assigned the signal state "0". 

The "Multiplex" instruction can only be executed if the tags have the same data type in all 
inputs and in the OUT output. The exception here is the parameter K, which can only be 
specified as an integer.

The enable output ENO is reset if one of the following conditions applies:
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● Enable input EN has the signal state "0".

● The value of the parameter K is greater than the number of available inputs.

● Errors occurred during the execution of the instruction.

Parameters
The following table shows the parameters of the "Multiplex" instruction:

Parameter Declaring Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

K Input Integers Integers I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Specifies 
the input 
whose 
content is to 
be copied.
● If K = 0 

=> 
Paramet
er IN0

● If K = 1 
=> 
Paramet
er IN1, 
etc.

IN0 Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

First input 
value

IN1 Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Second 
input value
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Parameter Declaring Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

INn Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Optional 
input values

ELSE Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P or 
constant

I, Q, M, D, L, 
P or 
constant

Specifies 
the value to 
be copied 
when K > n.

OUT Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, L, 
P

I, Q, M, D, L, 
P

Output to 
which the 
value is to 
be copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
K Tag_Number 1
IN0 Tag_ValueI_0 DW#16#00000000
IN1 Tag_Value_1 DW#16#003E4A7D
ELSE Tag_Value_2 DW#16#FFFF0000
OUT Tag_Result DW#16#003E4A7D

If the operand "Tag_Input" has the signal state "1", the "Multiplex" instruction is executed. 
Depending on the value of the operand "Tag_Number", the value at input "Tag_Value_1" is 
copied and assigned to the operand at output "Tag_Result". If no errors occur during the 
execution of the instruction, the outputs ENO and "Tag_Output" are set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DEMUX: Demultiplex

Description
You can use the instruction "Demultiplex" to copy the content of the input IN to a selected 
output. In its initial state the instruction box contains at least 2 outputs (OUT0 and OUT1). The 
number of selectable outputs can be extended in the instruction box. The outputs are numbered 
automatically in the box. Numbering starts at OUT0 and continues consecutively with each 
new output. You can use the parameter K to define the output to which the content of input IN 
will be copied. The other outputs will not be changed. If the value of the parameter K is greater 
than the number of available outputs, then the content of input IN in the parameter ELSE and 
the enable output ENO will be assigned to the signal state "0".

The instruction "Demultiplex" can only be executed if the tags at the input IN and at all outputs 
are of the same data type. The exception here is the parameter K, which can only be specified 
as an integer.
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The enable output ENO is reset if one of the following conditions applies:

● Enable input EN has the signal state "0".

● The value of the parameter K is greater than the number of available outputs.

● Errors occurred during the execution of the instruction.

Parameters
The following table shows the parameters of the instruction "Demultiplex":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, 
L, T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, 
L

I, Q, M, D, L Enable output

K Input Integers Integers I, Q, M, D, 
L, P or 
constant

I, Q, M, D, 
L, P or 
constant

Specifies the 
output to which 
the input value 
(IN) will be copied.
● If K = 0 => 

Parameter 
OUT0

● If K = 1 => 
Parameter 
OUT1, etc.

IN Input Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P or 
constant

I, Q, M, D, 
L, P or 
constant

Input value

OUT0 Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

First output
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Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

OUT1 Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

Second output

OUTn Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

Optional outputs

ELSE Output Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
TIME, TOD, 
DATE

Binary 
numbers, 
integers, 
floating-
point 
numbers, 
strings, 
timers, 
TOD, 
LTOD, 
DATE, LDT

I, Q, M, D, 
L, P

I, Q, M, D, 
L, P

Output to which 
the input value 
(IN) at K > n is 
copied.

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on available data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following tables show how the instruction works using specific operand values:

Table 9-26 Input values of the "Demultiplex" instruction before network execution

Parameter Operand Values
K Tag_Number 1 4
IN Tag_Value DW#16#FFFFFFFF DW#16#003E4A7D

Table 9-27 Output values of the "Demultiplex" instruction after network execution

Parameter Operand Values
OUT0 Tag_Output_0 Unchanged Unchanged
OUT1 Tag_Output_1 DW#16#FFFFFFFF Unchanged
ELSE Tag_Output_2 Unchanged DW#16#003E4A7D

The "Demultiplex" instruction is executed when input "Tag_Input" has the signal state "1". 
Depending on the value of the operand "Tag_Number", the value at input "IN" is copied to the 
corresponding output.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Shift and rotate

SHR: Shift right

Description
You can use the "Shift right" instruction to shift the content of the operand at the input IN bit-
by-bit to the right and query the result at the OUT output. The input N is used to specify the 
number of bit positions by which the specified value should be moved.
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If the value at the input N is "0", the value at input IN is copied unchanged to the operand at 
output OUT.

If the value at the input N is greater than the number of available bit positions, the operand 
value at input IN is shifted to the right by the available number of bit positions.

The freed bit positions in the left area of the operand are filled by zeroes when values without 
signs are shifted. If the specified value has a sign, the free bit positions are filled with the signal 
state of the sign bit.

The following figure show how the content of an integer data type operand is shifted four bit 
positions to the right:

Parameters
The following table shows the parameters of the instruction "Shift right":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
shifted

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
shifted

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction
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You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 3
OUT TagOut_Value 0000 0111 1111 0101

If the operand "TagIn" has the signal state "1", the instruction "Shift right" is executed. The 
content of the operand "TagIn_Value" is shifted three bit positions to the right. The result is 
sent at output "TagOut_Value". If the instruction is executed without errors, the ENO enable 
output has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SHL: Shift left

Description
You can use the "Shift left" instruction to shift the content of the operand at the input IN bit-by-
bit to the left and query the result at the OUT output. The input N is used to specify the number 
of bit positions by which the specified value should be moved.

If the value at the input N is "0", the value at input IN is copied unchanged to the operand at 
output OUT.

If the value at the input N is greater than the number of available bit positions, the operand 
value at input IN is shifted to the left by the available number of bit positions.

The bit positions in the right part of the operand freed by shifting are filled with zeros.
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The following figure show how the content of an operand of the data type WORD is shifted six 
bit positions to the left:

Parameters
The following table shows the parameters of the instruction "Shift left":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
shifted.

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
shifted.

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0011 1111 1010 1111
N Tag_Number 4
OUT TagOut_Value 1111 1010 1111 0000

If the operand "TagIn" has the signal state "1", the instruction "Shift left" is executed. The 
content of the operand "TagIn_Value" is shifted four bit positions to the left. The result is sent 
at output "TagOut_Value". If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ROR: Rotate right

Description
You can use the "Rotate right" instruction to rotate the content of the operand at the input IN 
bit-by-bit to the right and query the result at the OUT output. The input N is used to specify the 
number of bit positions by which the specified value should be rotated. The bit positions freed 
by rotating on the left-hand side are filled true-to-position with the bit positions that are pushed 
out from the left-hand side.

If the value at the input N is "0", the value at input IN is copied unchanged to the operand at 
output OUT.

If the value at the parameter N is greater than the number of available bit positions, the operand 
value at input IN is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the data type DWORD is rotated 
three bit positions to the right:
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Parameters
The following table shows the parameters of the instruction "Rotate right":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
rotated

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
rotated

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 0000 1111 1001 0101
N Tag_Number 5
OUT TagOut_Value 1010 1000 0111 1100

If the operand "TagIn" has the signal state "1", the instruction "Rotate right" is executed. The 
content of the operand "TagIn_Value" is rotated five bit positions to the right. The result is sent 
at output "TagOut_Value". If the instruction is executed without errors, the ENO enable output 
has the signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

ROL: Rotate left

Description
You can use the "Rotate left" instruction to rotate the content of the operand at the input IN bit-
by-bit to the left and query the result at the OUT output. The input N is used to specify the 
number of bit positions by which the specified value should be rotated. The bit positions freed 
by rotating on the right-hand side are filled true-to-position with the bit positions that are pushed 
out from the left-hand side.

If the value at the input N is "0", the value at input IN is copied to the operand at output OUT.

If the value at the parameter N is greater than the number of available bit positions, the operand 
value at input IN is nevertheless rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the data type DWORD is rotated 
three bit positions to the left:
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Parameters
The following table shows the parameters of the instruction "Rotate left":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500 S7-1200 S7-1500

EN Input BOOL BOOL I, Q, M, D, L I, Q, M, D, L, 
T, C

Enable input

ENO Output BOOL BOOL I, Q, M, D, L I, Q, M, D, L Enable 
output

IN Input Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Value to be 
rotated.

N Input USINT, 
UINT, 
UDINT

USINT, 
UINT, 
UDINT, 
ULINT

I, Q, M, D, L 
or constant

I, Q, M, D, L 
or constant

Number of 
bit positions 
by which the 
value is 
rotated.

OUT Output Bit strings, 
integers

Bit strings, 
integers

I, Q, M, D, L I, Q, M, D, L Result of the 
instruction

You can select the data type for the instruction from the "<???>" drop-down list of the instruction 
box.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN TagIn_Value 1010 1000 1111 0110
N Tag_Number 5
OUT TagOut_Value 0001 1110 1101 0101

If input "TagIn" has the signal state "1", the instruction "Rotate left" is executed. The content 
of the operand "TagIn_Value" is rotated five bit positions to the left. The result is sent at output 
"TagOut_Value". If the instruction is executed without errors, the ENO enable output has the 
signal state "1" and the "TagOut" output is set.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

Additional instructions

DRUM: Implement sequencer

Description
You can use the "Implement sequencer" instruction to assign the programmed values of the 
OUT_VAL parameter of the corresponding step to the programmed output bits (OUT1 to 
OUT16) and the output word (OUT_WORD). The specific step must thereby satisfy the 
conditions of the programmed enable mask on the S_MASK parameter while the instruction 
remains at this step. The instruction advances to the next step if the event for the step is true 
and the programmed time for the current step elapses or if the value at the JOG parameter 
changes from "0" to "1". The instruction is reset if the signal state on the RESET parameter 
changes to "1". The current step is hereby equated to the preset step (DSP).

The amount of time spent on a step is determined by the product of the preset timebase (DTBP) 
and the preset counter value (S_PRESET) for each step. At the start of a new step, this 
calculated value is loaded into the DCC parameter, which contains the time remaining for the 
current step. If, for example the value of the DTBP parameter is "2" and the preset value for 
the first step is "100" (100 ms), the DCC parameter has the value "200" (200 ms).
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A step can be programmed with a timer value, an event or both. Steps that have an event bit 
and the timer value "0" advance to the next step as soon as the signal state of the event bit is 
"1". Steps that are programmed only with a timer value start the time immediately. Steps that 
are programmed with an event bit and a timer value greater than "0" start the time when the 
signal state of the event bit is "1". The event bits are initialized with a signal state of "1".

When the sequencer is on the last programmed step (LST_STEP) and the time for this step 
has expired, the signal state on the Q parameter is set to "1"; otherwise it is set to "0". When 
the Q parameter is set, the instruction remains on the step until it is reset.

In the configurable mask (S_MASK), you can selected the individual bits in the output word 
(OUT_WORD) and set or reset the output bits (OUT1 to OUT16) by means of the output values 
(OUT_VAL). If a bit of the configurable mask has signal state "1", the OUT_VAL value sets or 
resets the corresponding bit. If the signal state of a bit of the configurable mask is "0", the 
corresponding bit is left unchanged. All the bits of the configurable mask for all 16 steps are 
initialized with a signal state of "1".

The output bit at the OUT1 parameter corresponds to the least significant bit of the output word 
(OUT_WORD). The output bit at the OUT16 parameter corresponds to the most significant bit 
of the output word (OUT_WORD).

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Implement sequencer" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
RESET Input BOOL I, Q, M, D, L or 

constant
The signal state 
"1" indicates the 
reset condition.

JOG Input BOOL I, Q, M, D, L or 
constant

When the signal 
state changes 
from "0" to "1", the 
instruction 
advances to the 
next step.

DRUM_EN Input BOOL I, Q, M, D, L or 
constant

The signal state 
"1" causes the 
sequencer to 
advance based on 
the event and time 
criteria.

LST_STEP Input BYTE I, Q, M, D, L or 
constant

Number of the last 
programmed step
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Parameter Declaration Data type Memory area Description
EVENT(i),
1 ≤ i ≤ 16

Input BOOL I, Q, M, D, L or 
constant

Event bit (i);
Initial signal state 
is "1".

OUT(j),
1 ≤ j ≤ 16

Output BOOL I, Q, M, D, L Output bit (j)

Q Output BOOL I, Q, M, D, L The signal state 
"1" indicates that 
the time for the last 
step has elapsed.

OUT_WORD Output WORD I, Q, M, D, L, P Word address to 
which the 
sequencer writes 
the output values.

ERR_CODE Output WORD I, Q, M, D, L, P Error information
JOG_HIS Static BOOL I, Q, M, D, L or 

constant
JOG parameter 
history bit

EOD Static BOOL I, Q, M, D, L or 
constant

The signal state 
"1" indicates that 
the time for the last 
step has elapsed.

DSP Static BYTE I, Q, M, D, L, P or 
constant

Preset step of the 
sequencer

DSC Static BYTE I, Q, M, D, L, P or 
constant

Current step of the 
sequencer

DCC Static DWORD I, Q, M, D, L, P or 
constant

Current numerical 
value of the 
sequencer

DTBP Static WORD I, Q, M, D, L, P or 
constant

Preset timebase of 
the sequencer

PREV_TIME Static DWORD I, Q, M, D, L or 
constant

Previous system 
time

S_PRESET Static ARRAY of WORD I, Q, M, D, L or 
constant

Preset count for 
each step [1 to 16]; 
where 1 clock 
pulse = 1 ms.

OUT_VAL Static ARRAY of BOOL I, Q, M, D, L or 
constant

Output values for 
each step [1 to 16, 
0 to 15].

S_MASK Static ARRAY of BOOL I, Q, M, D, L or 
constant

Configurable 
mask for each 
step [1 to 16, 
0 to 15]. Initial 
signal states are 
"1".

For additional information on valid data types, refer to "See also".
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Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

ERR_CODE* Explanation
W#16#0000 No error
W#16#000B The value at the LST_STEP parameter is less than 1 or greater than 16.
W#16#000C The value at the DSC parameter is less than 1 or greater than the value of 

the LST_STEP parameter.
W#16#000D The value at the DSP parameter is less than 1 or greater than the value of 

the LST_STEP parameter.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

DCAT: Discrete control-timer alarm

Description
The "Discrete control-timer alarm" instruction is used to accumulate the time from the point at 
which the CMD parameter issued the command to open or close. The time is accumulated 
until the preset time (PT) is exceeded or the information is received that the device was opened 
or closed (O_FB or C_FB) within the specified time. If the preset time is exceeded before the 
information on the opening or closing of the device is received, the corresponding alarm is 
activated. If the signal state of the command input changes state before the preset time, the 
time is restarted.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The "Discrete control-timer alarm" instruction has the following reactions to the input conditions:

● When the signal state of the CMD parameter changes from "0" to "1", the signal states of 
the parameters Q, CMD_HIS, ET (only if  ET is < PT) OA and CA are influenced as follows:

– The parameters Q and CMD_HIS are set to "1".

– The parameters ET, OA and CA are reset to "0".

● When the signal state of the parameter CMD changes from "1" to "0", the parameters Q, 
ET (only if ET < PT),  OA, CA and CMD_HIS are reset to "0".
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● When the signal state of the CMD and CMD_HIS parameters is "1" and the parameter O_FB 
is set to "0", the time difference (ms) since the last execution of the instruction is added to 
the value at the parameter ET. If the value of the parameter ET exceeds the value of the 
parameter PT, the signal state at the parameter OA is set to "1". If the value of the ET 
parameter does not exceed the value of the PT parameter, the signal state at the OA 
parameter is reset to "0". The value at the parameter CMD_HIS is reset to the value of the 
parameter CMD.

● If the signal state of the CMD, CMD_HIS and O_FB parameters are set to "1" and the 
parameter C_FB has the value "0", the signal state of the parameter OA is set to "0". The 
value of the parameter ET is set to the value of the parameter PT. If the signal state of the 
O_FB parameter changes to "0", the alarm is set the next time the instruction is executed. 
The value of the parameter CMD_HIS is set to the value of the parameter CMD.

● If the CMD, CMD_HIS and C_FB parameters return signal state "0", the time difference 
(ms) since the last execution of the instruction is added to the value of the ET parameter. 
If the value of the ET parameter exceeds the value of the PT parameter, the signal state 
of the parameter CA is reset to "1". If the value at the parameter PT is not exceeded, the 
parameter CA has the signal state "0". The value of the parameter CMD_HIS is set to the 
value of the parameter CMD.

● If the parameters CMD, CMD_HIS and O_FB have the signal state "0" and the parameter 
C_FB is set to "1", the parameter CA is set to "0". The value of the parameter ET is set to 
the value of the parameter PT. If the signal state of the C_FB parameter changes to "0", 
the alarm is set the next time the instruction is executed. The value of the parameter 
CMD_HIS is set to the value of the parameter CMD.

● If the parameters O_FB and C_FB simultaneously have the signal state "1", the signal states 
of both alarm outputs are set to "1".

The "Discrete control-timer alarm" instruction returns no error information.

Parameters
The following table shows the parameters of the "Discrete control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
CMD Input BOOL I, Q, M, D, L or 

constant
The signal state 
"0" indicates a 
"close" 
command.
The signal state 
"1" indicates the 
"open" 
command.

O_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when opening

C_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when closing
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Parameter Declaration Data type Memory area Description
Q Output BOOL I, Q, M, D, L Shows the 

status of the 
parameter CMD

OA Output BOOL I, Q, M, D, L Alarm output 
when opening

CA Output BOOL I, Q, M, D, L Alarm output 
when closing

ET Static DINT D, L or constant Currently 
elapsed time, 
where one count 
= 1 ms.

PT Static DINT D, L or constant Preset timer 
value, where 
one count = 1 
ms.

PREV_TIME Static DWORD D, L or constant Previous system 
time

CMD_HIS Static BOOL D, L or constant  CMD history bit

For additional information on valid data types, refer to "See also".

Example
In the following example the parameter CMD changes from "0" to "1". After the execution of 
the instruction the parameter Q is set to "1" and the two alarm outputs OA and CA have the 
signal state "0". The parameter CMD_HIS of the instance data block is set to the signal state 
"1" and the parameter ET is reset to "0".

 

 Note

You can initialize static parameters in the data block.
 

The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:
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Parameter Operand Value
CMD Tag_Input_CMD TRUE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
Q Tag_Output_Q FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#12
PT DBD8 L#222
CMD_HIS DBX16.0 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
Q Tag_Output_Q TRUE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
CMD_HIS DBX16.0 TRUE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

MCAT: Motor control-timer alarm

Description
The instruction "Motor control-timer alarm" is used to accumulate the time from the point in 
time as of which one of the command inputs (open or close) is activated. The time is 
accumulated until the preset time is exceeded or the relevant feedback input indicates that the 
device has executed the requested operation within the specified time. If the preset time is 
exceeded before the feedback is received, the corresponding alarm is triggered.
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When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

The "Motor control-timer alarm" instruction returns no error information.

Execution of the "Motor control-timer alarm" instruction
The following table shows the reactions of the "Motor control-timer alarm" instruction to the 
various input conditions:

Input parameters Output parameters
ET O_H

IS
C_H
IS

O_C
MD

C_C
MD

S_C
MD

O_F
B

C_F
B

OO CO OA CA ET O_H
IS

C_H
IS

Q Status

X 1 1 X X X X X 0 0 1 1 PT 0 0 0 Alarm
X X X X X X 1 1 0 0 1 1 PT 0 0 0 Alarm
X X X X X 1 X X 0 0 0 0 X 0 0 1 Stop
X X X 1 1 X X X 0 0 0 0 X 0 0 1 Stop
X 0 X 1 0 0 X X 1 0 0 0 0 1 0 1 Start 

opening
<PT 1 0 X 0 0 0 X 1 0 0 0 INC 1 0 1 Open
X 1 0 X 0 0 1 0 0 0 0 0 PT 1 0 1 Opened
>=P
T

1 0 X 0 0 0 X 0 0 1 0 PT 1 0 0 Opening 
alarm

X X 0 0 1 0 X X 0 1 0 0 0 0 1 1 Start closing
<PT 0 1 0 X 0 X 0 0 1 0 0 INC 0 1 1 Close
X 0 1 0 X 0 0 1 0 0 0 0 PT 0 1 1 Closed
>=P
T

0 1 0 X 0 X 0 0 0 0 1 PT 0 1 0 Closing 
alarm

X 0 0 0 0 0 X X 0 0 0 0 X 0 0 1 Stopped
Legend:
INC Add the time difference (ms) since the last processing of the FB to ET
PT PT is set to the same value as ET
X Cannot be used
<PT ET < PT
>=PT ET >= PT
If the input parameters O_HIS and C_HIS both have the signal state "1", they are immediately set to signal state "0". In this 
case, the last row of the above-named table (X) is valid. Because it is therefore no longer possible to check whether the 
input parameters O_HIS and C_HIS have the signal state "1", the output parameters are set as follows in this case: 
OO = FALSE
CO = FALSE
OA = FALSE
CA = FALSE
ET = PT
Q = TRUE
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Parameters
The following table shows the parameters of the "Motor control-timer alarm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
O_CMD Input BOOL I, Q, M, D, L or 

constant
"Open" command 
input

C_CMD Input BOOL I, Q, M, D, L or 
constant

"Close" command 
input

S_CMD Input BOOL I, Q, M, D, L or 
constant

"Stop" command 
input

O_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when opening

C_FB Input BOOL I, Q, M, D, L or 
constant

Feedback input 
when closing

OO Output BOOL I, Q, M, D, L "Open" output
CO Output BOOL I, Q, M, D, L "Close" output
OA Output BOOL I, Q, M, D, L Alarm output when 

opening
CA Output BOOL I, Q, M, D, L Alarm output when 

closing
Q Output BOOL I, Q, M, D, L The signal state 

"0" indicates an 
error condition.

ET Static DINT D, L or constant Currently elapsed 
time, where one 
count = 1 ms

PT Static DINT D, L or constant Preset timer value, 
where one count = 
1 ms

PREV_TIME Static DWORD D, L or constant Previous system 
time

O_HIS Static BOOL D, L or constant "Open" history bit
C_HIS Static BOOL D, L or constant "Close" history bit

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
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The following tables show how the instruction works using specific values.

Before processing

In this example, the following values are used for the input and output parameters:

Parameter Operand Value
O_CMD Tag_Input_O_CMD TRUE
C_CMD Tag_Input_C_CMD FALSE
S_CMD Tag_Input_S_CMD FALSE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
OO Tag_OutputOpen FALSE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q FALSE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#2
PT DBD8 L#22
O_HIS DBX16.0 TRUE
C_HIS DBX16.1 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:
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Parameter Operand Value
OO Tag_OutputOpen TRUE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q TRUE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
O_HIS DBX16.0 TRUE
CMD_HIS DBX16.1 FALSE

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

IMC: Compare input bits with the bits of a mask

Description
The instruction "Compare input bits with the bits of a mask" is used to compare the signal state 
of up to 16 programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of a mask. 
Up to 16 steps with masks can be programmed. The value of the IN_BIT0 parameter  is 
compared with the value of the mask CMP_VAL[x,0], with "x" indicating the step number. At 
the CMP_STEP parameter, specify the step number of the mask that is used for the 
comparison.  All programmed values are compared in the same manner. Unprogrammed input 
bits or unprogrammed bits of the mask have the default signal state FALSE.

If a match is found in the comparison, the signal state of the OUT parameter is set to "1". 
Otherwise, the OUT parameter is set to "0".

If the value of the CMP_STEP parameter is greater than 15, the instruction is not executed. 
An error message is output at the ERR_CODE parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".
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Parameters
The following table shows the parameters of the "Compare input bits with the bits of a mask" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, 

C
Enable input

ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or 

constant
Input bit 0 is compared with 
bit 0 of the mask.

IN_BIT1 Input BOOL I, Q, M, D, L or 
constant

Input bit 1 is compared with 
bit 1 of the mask.

IN_BIT2 Input BOOL I, Q, M, D, L or 
constant

Input bit 2 is compared with 
bit 2 of the mask.

IN_BIT3 Input BOOL I, Q, M, D, L or 
constant

Input bit 3 is compared with 
bit 3 of the mask.

IN_BIT4 Input BOOL I, Q, M, D, L or 
constant

Input bit 4 is compared with 
bit 4 of the mask.

IN_BIT5 Input BOOL I, Q, M, D, L or 
constant

Input bit 5 is compared with 
bit 5 of the mask.

IN_BIT6 Input BOOL I, Q, M, D, L or 
constant

Input bit 6 is compared with 
bit 6 of the mask.

IN_BIT7 Input BOOL I, Q, M, D, L or 
constant

Input bit 7 is compared with 
bit 7 of the mask.

IN_BIT8 Input BOOL I, Q, M, D, L or 
constant

Input bit 8 is compared with 
bit 8 of the mask.

IN_BIT9 Input BOOL I, Q, M, D, L or 
constant

Input bit 9 is compared with 
bit 9 of the mask.

IN_BIT10 Input BOOL I, Q, M, D, L or 
constant

Input bit 10 is compared 
with bit 10 of the mask.

IN_BIT11 Input BOOL I, Q, M, D, L or 
constant

Input bit 11 is compared 
with bit 11 of the mask.

IN_BIT12 Input BOOL I, Q, M, D, L or 
constant

Input bit 12 is compared 
with bit 12 of the mask.

IN_BIT13 Input BOOL I, Q, M, D, L or 
constant

Input bit 13 is compared 
with bit 13 of the mask.

IN_BIT14 Input BOOL I, Q, M, D, L or 
constant

Input bit 14 is compared 
with bit 14 of the mask.

IN_BIT15 Input BOOL I, Q, M, D, L or 
constant

Input bit 15 is compared 
with bit 15 of the mask.

CMP_STEP Input BYTE I, Q, M, D, L, P 
or constant

The step number of the 
mask used for the 
comparison.

OUT Output BOOL I, Q, M, D, L The signal state "1" 
indicates that a match was 
found.
The signal state "0" 
indicates that no match was 
found.
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Parameter Declaration Data type Memory area Description
ERR_CODE Output WORD I, Q, M, D, L, P Error information 
CMP_VAL Static ARRAY OF 

WORD
I, Q, M, D, L or 
constant

Comparison masks [0 to 15, 
0 to 15]: The first number of 
the index is the step number 
and the second number is 
the bit number of the mask.

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000A The value at the CMP_STEP parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SMC: Compare scan matrix

Description
The instruction "Compare scan matrix" is used to compare the signal state of up to 16 
programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bits of the comparison 
masks for each step. Processing starts at step 1 and is continued until the last programmed 
step (LAST) or until a match is found. The input bit of the IN_BIT0 parameter is compared with 
the value of the mask CMP_VAL[x,0], with "x" indicating the step number. All programmed 
values are compared in the same manner. If a match is found, the signal state of the OUT 
parameter is set to "1" and the step number with the matching mask is written to the OUT_STEP 
parameter. Unprogrammed input bits or unprogrammed bits of the mask have the default signal 
state FALSE. If more than one step has a matching mask, only the first one found is indicated 
in the OUT_STEP parameter. If no match is found, the signal state of the OUT parameter is 
set to "0". In this case the value at the OUT_STEP parameter is greater by "1" than the value 
of the LAST parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".
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Parameters
The following table shows the parameters of the "Compare scan matrix" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, 

C
Enable input

ENO Output BOOL I, Q, M, D, L Enable output
IN_BIT0 Input BOOL I, Q, M, D, L or 

constant
Input bit 0 is compared with 
bit 0 of the mask.

IN_BIT1 Input BOOL I, Q, M, D, L or 
constant

Input bit 1 is compared with 
bit 1 of the mask.

IN_BIT2 Input BOOL I, Q, M, D, L or 
constant

Input bit 2 is compared with 
bit 2 of the mask.

IN_BIT3 Input BOOL I, Q, M, D, L or 
constant

Input bit 3 is compared with 
bit 3 of the mask.

IN_BIT4 Input BOOL I, Q, M, D, L or 
constant

Input bit 4 is compared with 
bit 4 of the mask.

IN_BIT5 Input BOOL I, Q, M, D, L or 
constant

Input bit 5 is compared with 
bit 5 of the mask.

IN_BIT6 Input BOOL I, Q, M, D, L or 
constant

Input bit 6 is compared with 
bit 6 of the mask.

IN_BIT7 Input BOOL I, Q, M, D, L or 
constant

Input bit 7 is compared with 
bit 7 of the mask.

IN_BIT8 Input BOOL I, Q, M, D, L or 
constant

Input bit 8 is compared with 
bit 8 of the mask.

IN_BIT9 Input BOOL I, Q, M, D, L or 
constant

Input bit 9 is compared with 
bit 9 of the mask.

IN_BIT10 Input BOOL I, Q, M, D, L or 
constant

Input bit 10 is compared 
with bit 10 of the mask.

IN_BIT11 Input BOOL I, Q, M, D, L or 
constant

Input bit 11 is compared 
with bit 11 of the mask.

IN_BIT12 Input BOOL I, Q, M, D, L or 
constant

Input bit 12 is compared 
with bit 12 of the mask.

IN_BIT13 Input BOOL I, Q, M, D, L or 
constant

Input bit 13 is compared 
with bit 13 of the mask.

IN_BIT14 Input BOOL I, Q, M, D, L or 
constant

Input bit 14 is compared 
with bit 14 of the mask.

IN_BIT15 Input BOOL I, Q, M, D, L or 
constant

Input bit 15 is compared 
with bit 15 of the mask.

OUT Output BOOL I, Q, M, D, L The signal state "1" 
indicates that a match was 
found.
The signal state "0" 
indicates that no match 
was found. 

ERR_CODE Output WORD I, Q, M, D, L, P Error information 
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Parameter Declaration Data type Memory area Description
OUT_STEP Output BYTE I, Q, M, D, L, P Contains the step number 

with the matching mask or 
the step number which is 
greater by "1" than the 
value of the LAST 
parameter, provided no 
match is found.

LAST Static BYTE I, Q, M, D, L, P 
or constant

Specifies the step number 
of the last step to be 
scanned for a matching 
mask.

CMP_VAL Static ARRAY OF WORD I, Q, M, D, L or 
constant

Comparison masks [0 to 
15, 0 to 15]: The first 
number of the index is the 
step number and the 
second number is the bit 
number of the mask.

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000E The value at the LAST parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

LEAD_LAG: Lead and lag algorithm 

Description
The "Lead and lag algorithm" instruction is used to process signals with an analog tag. The 
gain value at the GAIN parameter must be greater than zero. The result of the instruction "Lead 
and lag algorithm" is calculated using the following equation:

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2409



The "Lead and lag algorithm" instruction supplies plausible results only when processing is in 
fixed program cycles. The same units must be specified for the LD_TIME, LG_TIME, and 
SAMPLE_T parameters. At LG_TIME > 4 + SAMPLE_T, the instruction approaches the 
following function:

OUT = GAIN * ((1 + LD_TIME * s) / (1 + LG_TIME * s)) * IN

When the value of the GAIN parameter is less than or equal to zero, the calculation is not 
performed and an error information is output on the ERR_CODE parameter.

You can use the "Lead and lag algorithm" instruction in conjunction with loops as a 
compensator in dynamic feed-forward control. The instruction consists of two operations. The 
"Lead" operation shifts the phase of the OUT output so that the output leads the input. The 
"Lag" operation, on the other hand, shifts the output so that the output lags behind the input. 
Because the "Lag" operation is equivalent to an integration, it can be used as a noise 
suppressor or as a low-pass filter. The "Lead" operation is equivalent to a differentiation and 
can therefore be used as a high-pass filter. The two instructions together (Lead and Lag) result 
in the output phase lagging behind the the input at lower frequencies and leading it at higher 
frequencies. This means that the "Lead and lag algorithm" instruction can be used as a band 
pass filter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find this in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Parameters
The following table shows the parameters of the "Lead and lag algorithm" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input REAL I, Q, M, D, L, P or 

constant
The input value of 
the current sample 
time (cycle time) to 
be processed.

SAMPLE_T Input INT I, Q, M, D, L, P or 
constant

Sample time

OUT Output REAL I, Q, M, D, L, P Result of the 
instruction

ERR_CODE Output WORD I, Q, M, D, L, P Error information 
LD_TIME Static REAL I, Q, M, D, L, P or 

constant
Lead time in the 
same unit as 
sample time.

LG_TIME Static REAL I, Q, M, D, L, P or 
constant

Lag time in the 
same unit as 
sample time
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Parameter Declaration Data type Memory area Description
GAIN Static REAL I, Q, M, D, L, P or 

constant
Gain as % / % (the 
ratio of the change 
in output to a 
change in input as 
a steady state).

PREV_IN Static REAL I, Q, M, D, L, P or 
constant

Previous input

PREV_OUT Static REAL I, Q, M, D, L, P or 
constant

Previous output

For additional information on valid data types, refer to "See also".

Parameters ERR_CODE
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
0009 The value at the GAIN parameter is less than or equal to zero.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

The following table shows how the instruction works using specific operand values: 

Before processing

In this example the following values are used for the input parameters:
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Parameters Operand Value
IN Tag_Input 2.0
SAMPLE_T Tag_InputSampleTime 10

The following values are saved in the instance data block "LEAD_LAG_DB" of the instruction:

Parameters Address Value
LD_TIME DBD12 2.0
LG_TIME DBD16 2.0
GAIN DBD20 1.0
PREV_IN DBD24 6.0
PREV_OUT DBD28 6.0

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameters Operand Value
OUT Tag_Output_Result 2.0

The following values are saved in the instance data block "LEAD_LAD_DB" of the instruction:

Parameters Operand Value
PREV_IN DBD24 2.0
PREV_OUT DBD28 2.0

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

SEG: Create bit pattern for seven-segment display

Description
The instruction "Create bit pattern for seven-segment display" is used to convert each of the 
four hexadecimal digits of the specified source word (IN) into an equivalent bit pattern for a 
seven-segment display. The result of the instruction is output in the double word on the OUT 
parameter.

The following relation exists between the hexadecimal digits and the assignment of the 7 
segments (a, b, c, d, e, f, g):
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Input digit 
(Binary)

Assignment of the 
segments
‑ g f e d c b a

Display
(Hexadecimal)

Seven-segment display

0000 00111111 0
0001 00000110 1
0010 01011011 2
0011 01001111 3
0100 01100110 4
0101 01101101 5
0110 01111101 6
0111 00000111 7
1000 01111111 8
1001 01100111 9
1010 01110111 A
1011 01111100 B
1100 00111001 C
1101 01011110 D
1110 01111001 E
1111 01110001 F

Parameters
The following table shows the parameters of the "Create bit pattern for seven-segment display" 
instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input WORD I, Q, M, D, L, P or 

constant
Source word with 
four hexadecimal 
digits

OUT Output DWORD I, Q, M, D, L, P Bit pattern for the 
seven-segment 
display

Example
The following example shows how the instruction works:
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The following table shows how the instruction functions using specific values:

Parameters Operand Value
Hexadecimal Binary
IN Tag_Input W#16#1234 0001 0010 0011 0100
OUT Tag_Output DW#16065B4F66 00000110 01011011 01001111 

01100110
Display: 1234

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

BCDCPL: Create tens complement

Description
You can use the "Create tens complement" instruction to create the tens complement of a 
seven-digit BCD number specified in the IN parameter. This instruction uses the following 
mathematical formula to calculate:

10000000 (as BCD)

– 7-digit BCD value

----------------------------------------

Tens complement (as BCD)

Parameters
The following table shows the parameters of the "Create tens complement" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input Bit strings I, Q, M, D, L, P or 

constant
7-digit BCD 
number

ERR_CODE Output DWORD I, Q, M, D, L, P Result of the 
instruction
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Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#01234567
ERR_CODE Tag_Output DW#16#08765433
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

BITSUM: Count number of set bits

Description
The "Count number of set bits" instruction is used to count the number of bits of an operand 
that is set to the signal state "1". The operand whose bits are to be counted is specified on the 
IN parameter. The result of the instruction is output at the RET_VAL parameter.

Parameters
The following table shows the parameters of the "Count number of set bits" instruction:

Parameter Declaration Data type Memory area Description
EN Input BOOL I, Q, M, D, L, T, C Enable input
ENO Output BOOL I, Q, M, D, L Enable output
IN Input DWORD I, Q, M, D, L, P or 

constant
Operand whose 
set bits are 
counted.

RET_VAL Output INT I, Q, M, D, L, P Number of bits to 
be set
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Example
The following example shows how the instruction works:

The following table shows how the instruction functions using specific values:

Parameter Operand Value*
IN Tag_Input DW#16#12345678
RET_VAL Tag_Output W#16#000D (13 Bits)
*The error codes can be displayed as integer or hexadecimal value in the program editor. For additional 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

9.7.2.3 SCL

Bit logic operations

R_TRIG: Set tag on positive signal edge

Description
You can use the "Set tag on positive signal edge" instruction to set a specified tag in the 
instance DB when there is a "0" to "1" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "0" to "1", there is a positive, rising edge.

If a positive edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".
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Syntax
The following syntax is used for the "Set tag on positive signal edge" instruction:

SCL
<Instance_DB>(CLK := <Operand>,
             Q => <Operand>)

Parameter
The following table shows the parameters of the instruction "Set tag on positive signal edge":

Parameter Declaration Data type Description
CLK Input BOOL Incoming signal, the 

edge of which is to be 
queried

Q Output BOOL Result of edge 
evaluation

Example
The following example shows how the instruction works:

SCL
"R_TRIG_DB"(CLK := "TagIn",
            Q => "TagOut");

The RLO of the preceding query is saved in the instance DB "R_TRIG_DB". If a change in the 
signal state of the RLO from "0" to "1" is detected in the operand "TagIn", the output "TagOut" 
has signal state "1".

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

F_TRIG: Set tag on negative signal edge

Description
You can use the "Set tag on negative signal edge" instruction to set a specified tag in the 
instance DB when there is a "1" to "0" change in the result of logic operation (RLO). The 
instruction compares the current RLO at the input CLK with the RLO from the previous query, 
which is saved in the specified instance DB. If the instruction detects a change in the result of 
logic operation (RLO) from "1" to "0", there is a negative, falling edge.
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If a negative edge is detected, the tag in the instance DB is set to signal state "1" and the output 
Q returns the signal state "1" In all other cases, the signal state at the output of the instruction 
is "0".

When you insert the instruction in the program, the "Call options" dialog opens automatically. 
In this dialog you can specify whether the edge memory bit is stored in its own data block 
(single instance) or as a local tag (multiple instance) in the block interface. If you create a 
separate data block, you will find it in the project tree in the "Program resources" folder under 
"Program blocks > System blocks". For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Set tag on negative signal edge" instruction:

SCL
<Instance_DB>(CLK := <Operand>,
             Q => <Operand>)

Parameter
The following table shows the parameters of the instruction "Set tag on negative signal edge":

Parameter Declaration Data type Description
CLK Input BOOL Incoming signal, the 

edge of which is to be 
queried

Q Output BOOL Result of edge 
evaluation

Example
The following example shows how the instruction works:

SCL
"F_TRIG_DB"(CLK := "TagIn",
            Q => "TagOut");

The RLO of the preceding query is saved in the instance DB "F_TRIG_DB". If a change in the 
signal state of the RLO from "1" to "0" is detected in the operand "TagIn", the output "TagOut" 
has signal state "1".

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)
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Timer operations

IEC Timers

TP: Generate pulse

Description
You can use the "Generate pulse" instruction to set the Q parameter for the duration PT. The 
instruction starts when the result of logic operation (RLO) of the IN parameter changes from 
"0" to "1" (positive signal edge). The programmed time PT begins when the instruction starts. 
The Q parameter is set for the time PT, regardless of the subsequent changes in the input 
signal. Even when a new positive signal edge is detected, the signal state of the Q parameter 
is not affected as long as the time duration PT is active.

The current time value can be queried in the ET parameter. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. When the time duration PT is reached 
and the signal state at the IN parameter is "0", the ET parameter is reset.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

Each call of the "Generate pulse" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TP_TIME that you can declare as 
follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TP_TIME type in the "Static" section of a block (for example, 
#MyTP_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TP_TIME or TP_LTIME 
that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TP_TIME or TP_LTIME in the "Static" section of a 
block (for example #MyTP_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
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it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Generate pulse" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TP(IN := <Operand>,
                 PT := <Operand>,
                 Q => <Operand>,
                 ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
  S7-1200 S7-1500
IN Input BOOL BOOL Start input
PT Input TIME TIME, LTIME Duration of the 

pulse.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that is 
set for the PT 
duration.

ET Output TIME TIME, LTIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate pulse" instruction:

Example
The following example shows how the instruction works:

SCL
"TP_DB".TP(IN := "Tag_Start",
           PT := "Tag_PresetTime",
           Q => "Tag_Status",
           ET => "Tag_ElapsedTime");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the time period 
programmed for the PT parameter is started and the "Tag_Status" operand is set to "1". The 
current time value is stored in the "Tag_ElapsedTime" operand.

See also
Overview of the valid data types (Page 1320)

TON: Generate on-delay

Description
You can use the "Generate on-delay" instruction to delay the setting of the Q parameter for 
the programmed duration PT. The instruction starts when the result of logic operation (RLO) 
of the IN parameter changes from "0" to "1" (positive signal edge). The programmed time PT 
begins when the instruction starts. When the duration PT has expired, the Q parameter returns 
signal state "1". The Q parameter remains set as long as the start input is still "1". If the signal 
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state of the IN parameter changes from "1" to "0", the parameter Q will be reset. The timer 
function is restarted when a new positive signal edge is detected at the IN parameter.

The current time value can be queried in the ET parameter. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. The ET parameter is reset as soon 
as the signal state of the IN parameter changes to "0".

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

Each call of the "Generate on-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TON_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TON_TIME type in the "Static" section of a block (for 
example, #MyTON_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TON_TIME or 
TON_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TON_TIME or TON_LTIME in the "Static" section of 
a block (for example #MyTON_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Generate on-delay" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TON(IN := <Operand>,
                  PT := <Operand>,
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SCL
                  Q => <Operand>,
                  ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input BOOL BOOL Start input
PT Input TIME TIME, LTIME Duration of the on 

delay.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that is 
set when the timer 
PT expires.

ET Output TIME TIME, LTIME Current time value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Generate on-delay" instruction:
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Example
The following example shows how the instruction works:

SCL
"TON_DB".TON(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the time programmed 
for the PT parameter is started. After the end of the period the "Tag_Status" operand is set to 
the signal state "1". The operand Tag_Status remains set to signal state "1" as long as the 
operand Tag_Start has signal state "1". The current time value is stored in the operand 
"Tag_ElapsedTime". When the signal state at the operand "Tag_Start" changes from "1" to 
"0", the "Tag_Status" operand is reset.

See also
Overview of the valid data types (Page 1320)

TOF: Generate off-delay

Description
You can use the "Generate off-delay" instruction to delay the resetting of the Q parameter for 
the programmed duration PT. The Q parameter is set when the result of logic operation (RLO) 
of the IN parameter changes from "0" to "1" (positive signal edge). When the signal state of 
the IN parameter changes back to "0", the programmed time PT starts. The Q parameter 
remains set as long the time duration PT is running. When the time PT expires, the Q parameter 
is reset. If the signal state of the IN parameter changes to "1" before the time duration PT has 
expired, the timer is reset. The signal state of the Q parameter remains set to "1".

The current time value can be queried in the ET parameter. The time value starts at T#0s and 
ends when the value of the time duration PT is reached. When the time duration PT expires, 
the ET parameter remains set to the current value until the IN parameter changes back to "1". 
If the IN parameter changes to "1" before the time PT has expired, the ET parameter is reset 
to the value T#0s.

 

 Note

If the timer is not called in the program because it is skipped, for example, output ET returns 
a constant value as soon as the timer has expired.

 

Each call of the "Generate off-delay" instruction must be assigned to an IEC timer in which the 
instruction data is stored.
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For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TOF_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TOF_TIME type in the "Static" section of a block (for 
example, #MyTOF_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TOF_TIME or 
TOF_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TOF_TIME or TOF_LTIME in the "Static" section of 
a block (for example #MyTOF_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".

The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Generate off-delay" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TOF(IN := <Operand>,
                  PT := <Operand>,
                  Q => <Operand>,
                  ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input BOOL BOOL Start input
PT Input TIME TIME, LTIME Duration of the off 

delay.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that is 
reset when the 
time PT expires.

ET Output TIME TIME, LTIME Current time value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the instruction "Generate off-delay":

Example
The following example shows how the instruction works:

SCL
"TOF_DB".TOF(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");

With a change in the signal state of the "Tag_Start" operand from "0" to "1", the "Tag_Status" 
operand is set. When the signal state of the "Tag_Start" operand changes from "1" to "0", the 
time programmed for the PT parameter is started. As long as the time is running, the 
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"Tag_Status" operand remains set. When the time has expired, the "Tag_Status" operand is 
reset. The current time value is stored in the operand "Tag_ElapsedTime".

See also
Overview of the valid data types (Page 1320)

TONR: Time accumulator

Description
The "Time accumulator" instruction is used to accumulate time values within a period set by 
the PT parameter. When the signal state of the IN parameter changes to "1", the instruction 
executes and the time duration PT starts. While the time duration PT is running, the time values 
that are recorded when the IN parameter has signal state "1" are accumulated. The 
accumulated time is output in the ET parameter and can be queried there. When the time 
duration PT is reached, the Q parameter has signal state "1". The Q parameter remains set 
to "1", even when the signal state at the IN parameter changes to "0".

The R parameter resets the ET and Q parameters regardless of the signal state at the IN 
parameter.

Each call of the "Time accumulator" instruction must be assigned to an IEC timer in which the 
instruction data is stored.

For S7-1200 CPU
An IEC Timer is a structure of the data type IEC_TIMER or TONR_TIME that you can declare 
as follows:

● Declaration of a data block of system data type IEC_TIMER (for example, "MyIEC_TIMER")

● Declaration as a local tag of the TONR_TIME type in the "Static" section of a block (for 
example, #MyTONR_TIMER)

For S7-1500 CPU
An IEC timer is a structure of the data type IEC_TIMER, IEC_LTIMER, TONR_TIME or 
TONR_LTIME that you can declare as follows:

● Declaration of a data block of system data type IEC_TIMER or IEC_LTIMER (for example, 
"MyIEC_TIMER")

● Declaration as a local tag of the type TONR_TIME or TONR_LTIME in the "Static" section 
of a block (for example #MyTONR_TIMER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC timer is stored in its own data block (single instance) or as a local 
tag (multiple instance) in the block interface. If you create a separate data block, you will find 
it in the project tree in the "Program resources" folder under "Program blocks > System blocks". 
For additional information on this topic, refer to "See also".
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The instruction data is updated both when an instruction is called and also at each access to 
the Q or ET outputs.

Syntax
Use the following syntax for the "Time accumulator" instruction:

● Data block of system data type IEC_Timer (global DB):

SCL
<IEC_Timer_DB> TONR(IN := <Operand>,
                   R := <Operand>,
                   PT := <Operand>,
                   Q => <Operand>,
                   ET => <Operand>)

● Local tag:

SCL
#myLocal_timer(IN := <Operand>,
               R := <Operand>,
               PT := <Operand>,
               Q => <Operand>,
               ET => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input BOOL BOOL Start input
R Input BOOL BOOL Reset of the ET 

and Q parameters
PT Input TIME TIME, LTIME Maximum 

duration of time 
recording.
The value of the 
PT parameter 
must be positive.

Q Output BOOL BOOL Operand that 
remains set when 
the timer PT has 
expired.

ET Output TIME TIME, LTIME Accumulated time

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Time accumulator" instruction:

Example
The following example shows how the instruction works:

SCL
"TONR_DB".TONR(IN := "Tag_Start",
               R := "Tag_Reset",
               PT := "Tag_PresetTime",
               Q => "Tag_Status",
               ET => "Tag_Time");

When the signal state of the "Tag_Start" operand changes from "0" to "1", the time programmed 
for the PT parameter is started. While the timer is running, the time values that are recorded 
at signal state "1" of the operand "Tag_Start" is accumulated. The accumulated times is stored 
in the "Tag_Time" operand. When the time value displayed at the PT parameter is reached, 
the "Tag_Status" operand is set to the signal state "1". The current time value is stored in the 
operand "Tag_Time".

See also
Overview of the valid data types (Page 1320)
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RESET_TIMER: Reset timer

Description
You can use the "Reset timer" instruction to reset an IEC timer to "0". The structure components 
of the timer in the specified data block are reset to "0".

The instruction does not influence the RLO. At the TIMER parameter, the "Reset timer" 
instruction is assigned an IEC timer declared in the program.

The instruction data is updated only when the instruction is called and not each time the 
assigned IEC timer is accessed. Querying the data is only identical from the call of the 
instruction to the next call of the instruction.

Syntax
Use the following syntax for the "Reset timer" instruction:

SCL
RESET_TIMER(TIMER := <IEC timer>)

Parameters
The following table shows the parameters of the "Reset timer" instruction":

Parameter Declaration Data type Description
<IEC timer> Output IEC_TIMER, 

IEC_LTIMER, 
TP_TIME, TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

IEC timer that is reset

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF #started = false THEN
"TON_DB".TON(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");
#started := true;
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SCL
END_IF;
 
IF "TON_DB".ET < T#25s THEN
RESET_TIMER(TIMER := "TON_DB");
#started := false;
END_IF;

When the tag #started has the signal state "0", the instruction "Generate on-delay" is executed 
when there is positive signal edge on the operand "Tag_Start". The IEC timer stored in the 
instance data block "TON_DB" is started with the time duration that is specified by the operand 
"Tag_PresetTime". The operand "Tag_Status" is set if the time duration specified by the 
operand "Tag_PresetTime" has expired. The parameter Q remains set as long as the operand 
"Tag_Start" still has the signal state "1". When the signal state of the start input changes from 
"1" to "0", the operand on the Q parameter is reset.

If the expired time of the IEC timer "TON_DB" is less than 25s, the "Reset timer" instruction is 
executed and the timer stored in the "TON_DB" instance data block is reset.

See also
Overview of the valid data types (Page 1320)

PRESET_TIMER: Load time duration

Description
You can use the "Load time duration" instruction to set the time for an IEC timer. The instruction 
is executed in every cycle when the result of logic operation (RLO) at the input of the instruction 
has the signal state "1". The instruction writes the specified time to the structure of the specified 
IEC timer.

 

 Note

If the specified IEC timer is running while the instruction executes, the instruction overwrites 
the current time of the specified IEC timer. This can change the timer status of the IEC timer.

 

You assign an IEC timer declared in the program to the "Load time duration" instruction.

The instruction data is updated only when the instruction is called and each time the assigned 
IEC timer is accessed. The query on Q or ET (for example, "MyTimer".Q or "MyTimer".ET) 
updates the IEC_TIMER structure.

Syntax
Use the following syntax for the "Load time duration" instruction:

SCL
PRESET_TIMER(PT := <Operand>,
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SCL
              TIMER := <IEC timer)

Parameter
The following table shows the parameters of the "Load time duration" instruction:

Parameter Declaration Data type Description
<Time duration> Input TIME, LTIME Duration with which the 

IEC timer runs.
<IEC timer> Output IEC_TIMER, 

IEC_LTIMER, 
TP_TIME, TP_LTIME, 
TON_TIME, 
TON_LTIME, 
TOF_TIME, 
TOF_LTIME, 
TONR_TIME, 
TONR_LTIME

IEC timer whose 
duration of which is set.

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF #started = false THEN
"TON_DB".TON(IN := "Tag_Start",
             PT := "Tag_PresetTime",
             Q => "Tag_Status",
             ET => "Tag_ElapsedTime");
#started := true;
#preset = true
END_IF;
 
IF "TON_DB".ET < T#10s AND #preset = true THEN
PRESET_TIMER(PT := T#25s,
             TIMER := "TON_DB");
#preset := false;
END_IF;

When the tag #started has the signal state "0" and the operand "Tag_Start" has a positive 
signal edge, the instruction "Generate on-delay" is executed. The IEC timer stored in the 
instance data block "TON_DB" is started with the time duration that is specified by the operand 
"Tag_PresetTime". The operand "Tag_Status" is set if the time duration PT specified by the 
operand "Tag_PresetTime" has expired. The parameter Q remains set as long as the operand 
"Tag_Start" still has the signal state "1". When the signal state of the start input changes from 
"1" to "0", the operand on the Q parameter is reset.
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The instruction "Load time duration" is executed when the expired time of the IEC timer 
"TON_DB" is less than 10s and the tag #preset has the signal state "1". The instruction writes 
the time duration that is specified at the parameter "PT" in the instance data block "TON_DB", 
thereby overwriting the time value of the operand "Tag_PresetTime" within the instance data 
block. The signal state of the timer status may therefore change at the next query or when 
"TON_DB".Q or "TON_DB".ET are accessed.

See also
Overview of the valid data types (Page 1320)

SIMATIC Timers

S_PULSE: Assign pulse timer parameters and start

Description
The "Assign pulse timer parameters and start" instruction starts the time programmed in the 
T_NO parameter when a change from "0" to "1" (positive signal edge) is detected in the result 
of logic operation (RLO) of the S parameter. The timer runs for the programmed time (TV) as 
long as the signal state of the S parameter is "1".

When the signal state of the S parameter changes to "0" before the programmed time has 
expired, the timer is stopped and the "Q" parameter is reset to "0".

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

If the timer is running and the signal state at input R changes to "1" then the current time value 
and the time base are also set to zero. If the timer is not running, the signal state "1" at the R 
input has no effect.

Parameter Q returns signal state "1" as long as the timer is running and the signal state at 
parameter S is "1". When the signal state of the S parameter changes to "0" before the 
programmed time has expired, the Q parameter returns signal state "0". If the timer is reset 
by parameter R or if the timer has expired then parameter Q also returns signal state "0".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".
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Syntax
Use the following syntax for the "Assign pulse timer parameters and start" instruction:

SCL
S_PULSE(T_NO := <Operand>,
        S := <Operand>,
        TV := <Operand>,
        R := <Operand>,
        Q => <Operand>,
        BI => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign pulse timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_PULSE(T_NO := "Timer_1",
                        S := "Tag_1",
                        TV := "Tag_Number",
                        R := "Tag_Reset",
                        Q := "Tag_Status",
                        BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer counts down with the time value of the operand "Tag_Number" until operand "Tag_1" 
returns signal state "1".

If the signal state at the S parameter changes to "0" before the programmed time has elapsed, 
the "Tag_Status" operand is reset to "0". If the timer is reset by the R parameter or if the timer 
has expired, the "Tag_Status" operand also returns signal state "0".
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The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1320)

S_PEXT: Assign extended pulse timer parameters and start

Description
The "Assign extended pulse timer parameters and start" instruction starts a programmed timer 
when a positive signal edge is detected at the S parameter. The timer runs for the programmed 
time (TV) even if the signal state at the S parameter changes to "0". As long as the timer runs, 
parameter Q returns the signal state "1".

When the timer has expired, parameter Q is reset to "0". If the signal state at the S parameter 
changes from "0" to "1" while the timer is running, the timer is restarted with the time 
programmed in the TV parameter.

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

If the timer is running and the signal state at parameter R changes to "1" then the current time 
value and the time base are also set to zero. If the timer is not running then signal state "1" at 
parameter R has no effect.

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign extended pulse timer parameters and start" instruction:

SCL
S_PEXT(T_NO := <Operand>,
       S := <Operand>,
       TV := <Operand>,
       R := <Operand>,
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SCL
       Q => <Operand>,
       BI => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign extended pulse timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_PEXT(T_NO := "Timer_1",
                       S := "Tag_1",
                       TV := "Tag_Number",
                       R := "Tag_Reset",
                       Q := "Tag_Status",
                       BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". As long 
as the timer runs, operand "Tag_Status" returns the signal state "1". When the timer has 
expired, operand "Tag_Status" is reset to "0". If the signal state at the S input changes from 
"0" to "1" while the timer is running, the timer is restarted with the time "Tag_Number".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.
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See also
Overview of the valid data types (Page 1320)

S_ODT: Assign on-delay timer parameters and start

Description
The "Assign on-delay timer parameters and start" instruction starts a programmed timer as on-
delay when a positive signal edge is detected at the S parameter. The timer runs for the 
programmed time (TV) as long as the signal state of the S parameter is "1".

If the timer expires correctly and parameter S still has signal state "1" then parameter Q returns 
signal state "1". If the signal state at the S parameter changes from "1" to "0" while the timer 
is running, the timer is stopped. In this case, output Q is reset to signal state "0".

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

If the time is running and the signal state at input R changes from "0" to "1" then the current 
time value and the time base are also set to zero. In this case, the signal state at parameter 
Q is "0". The timer is reset if the signal state at the R parameter is "1", even if the timer is not 
running and the result of logic operation (RLO) at the S parameter is "1".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign on-delay timer parameters and start" instruction:

SCL
S_ODT(T_NO := <Operand>,
      S := <Operand>,
      TV := <Operand>,
      R := <Operand>,
      Q => <Operand>,
      BI => <Operand>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".

ulse timing diagram
The following figure shows the pulse timing diagram of the "Assign on-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_ODT(T_NO := "Timer_1",
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SCL
                      S := "Tag_1",
                      TV := "Tag_Number",
                      R := "Tag_Reset",
                      Q := "Tag_Status",
                      BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer runs for the duration "Tag_Number" as long as the signal state of operand "Tag_1" is "1".

If the timer expires correctly and operand "Tag_Status" has signal state "1" then operand 
"Tag_Status" is reset to "1". If the signal state of the "Tag_1" operand changes from "1" to "0" 
while the timer is running, the timer is stopped. In this case, operand "Tag_Status" returns 
signal state "0".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1320)

S_ODTS: Assign retentive on-delay timer parameters and start

Description
The "Assign retentive on-delay timer parameters and start" instruction starts a programmed 
timer when a positive signal edge is detected at the S parameter. The timer runs for the 
programmed time (TV) even if the signal state at the S parameter changes to "0".

If the timer expires, the "Q" parameter returns signal state "1" regardless of the signal state of 
the "S" parameter. If the signal state at the S parameter changes from "0" to "1" while the timer 
is running, the timer is restarted with the programmed time TV.

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

Signal state "1" at parameterR resets the current time value and time base to "0", independent 
of the signal state at parameter S. In this case, the signal state at parameter Q is "0".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.
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You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign retentive on-delay timer parameters and start" 
instruction:

SCL
S_ODTS(T_NO := <Operand>,
       S := <Operand>,
       TV := <Operand>,
       R := <Operand>,
       Q => <Operand>,
       BI =><Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".
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Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign retentive on-delay timer 
parameters and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_ODTS(T_NO := "Timer_1",
                       S := "Tag_1",
                       TV := "Tag_Number",
                       R := "Tag_Reset",
                       Q := "Tag_Status",
                       BI := "Tag_Value");

"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer runs for the duration "Tag_Number".

If the timer expires, operand "Tag_Status" returns signal state "1" independent of the signal 
state of operand "Tag_1". If the signal state of the "Tag_1" operand changes from "0" to "1" 
while the timer is running, the timer is restarted with the time "Tag_Number".

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1320)
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S_OFFDT: Assign off-delay timer parameters and start

Description
The "Assign off-delay timer parameters and start" instruction starts a programmed timer when 
a negative signal edge is detected at the S parameter. The timer runs for the programmed 
time (TV). As long as the timer is running or parameter S returns signal state "1", then 
parameter Q has signal state "1".

If the timer expires and the signal state is "0" then parameter Q is reset to signal state "0". If 
the signal state at parameter S changes from "0" to "1" while the timer is running, the timer is 
stopped. The timer is only restarted after a falling signal edge is detected at parameter S.

Internally, the time is made up of a time value and a time base and is programmed in the TV 
parameter. When the instruction starts, the programmed time value counts down to zero. The 
time base specifies the time increment by which the time value changes. The current time 
value is provided at the parameter BI.

Signal state "1" at parameter R resets the current time value and time base to "0". In this case, 
the signal state at parameter Q is "0".

The instruction data is updated with each access. It is therefore possible that the query of the 
data at the start of the cycle returns different values from those at the end of the cycle.

 

 Note

In the time cell, the operating system reduces the time value in an interval specified by the 
time base by one unit until the value equals "0". The decrementation is performed 
asynchronously to the user program. The resulting timer is therefore at maximum up to one 
time interval shorter than the desired time base.

 

You can find an example of how a time cell can be formed under: See also "L: Load timer 
value".

Syntax
Use the following syntax for the "Assign off-delay timer parameters and start" instruction:

SCL
S_OFFDT(T_NO := <Operand>,
        S := <Operand>,
        TV := <Operand>,
        R := <Operand>,
        Q => <Operand>,
        BI =><Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
T_NO Input TIMER, INT The timer that is started.

The number of timers depends on the CPU.
S Input BOOL Start input
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Parameter Declaration Data type Description
TV Input S5TIME, 

WORD
Preset time value

R Input BOOL Reset input
Q Output BOOL Status of the timer
BI Output WORD Current dual-coded timer value
Function value S5TIME Current time value

For additional information on valid data types, refer to "See also".

Pulse timing diagram
The following figure shows the pulse timing diagram of the "Assign off-delay timer parameters 
and start" instruction:

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_OFFDT(T_NO := "Timer_1",
                        S := "Tag_1",
                        TV := "Tag_Number",
                        R := "Tag_Reset",
                        Q := "Tag_Status",
                        BI := "Tag_Value");
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"Timer_1" starts when the signal state of the "Tag_1" operand changes from "0" to "1". The 
timer runs for the duration "Tag_Number". As long as the timer is running or operand "Tag_1" 
returns signal state "1", then operand "Tag_Status" has signal state "1".

If the timer expires and the signal state of operand "Tag_1" is "0" then operand "Tag_Status" 
is reset to signal state "0". If the signal state of the "Tag_1" operand changes from "0" to "1" 
while the timer is running, the timer is reset. The timer is only restarted after a falling edge is 
detected at parameter S.

The current time value is stored both dual-coded at the "Tag_Value" operand and returned as 
a function value.

See also
Overview of the valid data types (Page 1320)

Counter operations

IEC Counters

CTU: Count up

Description
You can use the "Count up" instruction to increment the value at the CV parameter. When the 
signal state at the CU parameter changes from "0" to "1" (positive signal edge), the instruction 
is executed and the current counter value of the CV parameter is incremented by one. When 
the instruction is executed for the first time the current count of the CV parameter is set to zero. 
The counter value is incremented each time a positive signal edge is detected, until it reaches 
the high limit of the data type specified for the CV parameter. When the high limit is reached, 
the signal state of the CU parameter no longer has an effect on the instruction.

You can query the count status of the Q parameter. The signal state of the Q parameter is 
determined by the PV parameter. When the current counter value is greater than or equal to 
the value of the PV parameter, the Q parameter is set to signal state "1". In all other cases, 
the signal state of the Q parameter is "0". You can also specify a constant for the PV parameter.

The value of the CV parameter is reset to zero when the signal state at the R parameter 
changes to "1". As long as the R parameter has the signal state "1", the signal state of the CU 
parameter has no effect on the instruction.

 

 Note

Only use a counter at a single location in the program to avoid counting errors.
 

Each call of the "Count up" instruction must be assigned an IEC counter in which the instruction 
data is stored. An IEC counter is a structure with one of the following data types:
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For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTU_SINT / CTU_USINT
● CTU_INT / CTU_UINT
● CTU_DINT / CTU_UDINT
● CTU_LINT / CTU_ULINT

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTU_<Data type> in the "Static" section of a block 
(for example, #MyCTU_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

When you set up the IEC counter in a separate data block (single instance), the instance data 
block is created by default with "optimized block access" and the individual tags are defined 
as retentive. For additional information on setting retentivity in an instance data block, refer to 
"See also".

When you set up the IEC counter as local tag (multiple instance) in a function block with 
"optimized block access", it is defined as retentive in the block interface.

Syntax
The following syntax is used for the "Count up" instruction:

Table 9-28 Data block of system data type IEC_counter (global DB)

SCL
<IEC_Counter_DB>.CTU(CU := <Operand>,
                    R := <Operand>,
                    PV := <Operand>,
                    Q => <Operand>,
                    CV => <Operand>)
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Table 9-29 Local tag

SCL
#myLocal_counter(CU := <Operand>,
                 R := <Operand>,
                 PV := <Operand>,
                 Q => <Operand>,
                 CV => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
CU Input BOOL Count input
R Input BOOL Reset input
PV Input Integers Value at which the Q 

output is set
Q Output BOOL Counter status
CV Output Integers, CHAR, DATE Current counter value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"IEC_COUNTER_DB".CTU(CU := "Tag_Start",
                     R := "Tag_Reset",
                     PV := "Tag_PresetValue",
                     Q => "Tag_Status",
                     CV => "Tag_CounterValue");

When the signal state at the "Tag_Start" operand changes from "0" to "1", the "Count up" 
instruction is executed and the current counter value of the "Tag_CounterValue" operand is 
incremented by one. With each additional positive signal edge, the counter value is 
incremented until the high limit of the specified data type (INT = 32767) is reached.

The "Tag_Status" output has signal state "1" as long as the current counter value is greater 
than or equal to the value of the "Tag_PresetValue" operand. In all other cases, the 
"Tag_Status" output has signal state "0". The current counter value is stored in the 
"Tag_CounterValue" operand.

See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)
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CTD: Count down

Description
The "Count down" instruction is used to decrement the value at the parameter CV. When the 
signal state at the CD parameter changes from "0" to "1" (positive signal edge), the instruction 
is executed and the current counter value of the CV parameter is decremented by one. When 
the instruction is executed the first time, the counter value of the CV parameter is set to the 
value of the PV parameter. Each time a positive signal edge is detected, the counter value is 
decremented until it reaches the low limit of the specified data type. When the low limit is 
reached, the signal state of the CD parameter no longer has an effect on the instruction.

You can query the count status of the Q parameter. If the current counter value is less than or 
equal to zero, the Q parameter is set to signal state "1". In all other cases, the signal state of 
the Q parameter is "0". You can also specify a constant for the PV parameter.

The value of the CV parameter is set to the value of the PV parameter when the signal state 
of the LD parameter changes to "1". As long as the LD parameter has the signal state "1", the 
signal state of the CD parameter has no effect on the instruction.

 

 Note

Only use a counter at a single location in the program to avoid counting errors.
 

Each call of the "Count down" instruction must be assigned an IEC counter in which the 
instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTD_SINT / CTD_USINT
● CTD_INT / CTD_UINT
● CTD_DINT / CTD_UDINT
● CTD_LINT / CTD_ULINT

You can declare an IEC counter as follows:
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● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTD_<Data type> in the "Static" section of a block 
(for example, #MyCTD_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

When you set up the IEC counter in a separate data block (single instance), the instance data 
block is created by default with "optimized block access" and the individual tags are defined 
as retentive. For additional information on setting retentivity in an instance data block, refer to 
"See also".

When you set up the IEC counter as local tag (multiple instance) in a function block with 
"optimized block access", it is defined as retentive in the block interface.

Syntax
The following syntax is used for the "Count down" instruction:

Table 9-30 Data block of system data type IEC_counter (global DB)

SCL
<IEC_Counter_DB>.CTD(CD := <Operand>,
                    LD := <Operand>,
                    PV := <Operand>,
                    Q => <Operand>,
                    CV => <Operand>)

Table 9-31 Local tag

SCL
#myLocal_counter(CD := <Operand>,
                 LD := <Operand>,
                 PV := <Operand>,
                 Q => <Operand>,
                 CV => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
CD Input BOOL Count input
LD Input BOOL Load input
PV Input Integers Value at which the Q 

output is set
Q Output BOOL Counter status
CV Output Integers, CHAR, DATE Current counter value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"IEC_SCOUNTER_DB".CTD(CD := "Tag_Start",
                      LD := "Tag_Load",
                      PV := "Tag_PresetValue",
                      Q => "Tag_Status",
                      CV => "Tag_CounterValue");

When the signal state at the "Tag_Start" changes from "0" to "1", the "Count down" instruction 
executes and the value of the "Tag_CounterValue" operand is decremented by one. With each 
additional positive signal edge, the counter value is decremented until it reaches the low limit 
of the specified data type (-128).

The operand "Tag_Status" has the signal state "1" as long as the current counter value is less 
than or equal to zero. In all other cases, the "Tag_Status" output has signal state "0". The 
current counter value is stored in the "Tag_CounterValue" operand.

See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

CTUD: Count up and down

Description
Use the "Count up and down" instruction to increment or decrement the counter value at the 
CV parameter. When the signal state at the CU parameter changes from "0" to "1" (positive 
signal edge), the current counter value of the CV parameter is incremented by one. When the 
signal state at the CD parameter changes from "0" to "1" (positive signal edge), the counter 
value of the CV parameter is decremented by one. If there is a positive signal edge at the CU 
and CD inputs in a program cycle, the current counter value of the CV parameter remains 
unchanged.

The counter value can be incremented until it reaches the high limit of the data type specified 
for the CV parameter. When the high limit is reached, the counter value is no longer 
incremented on a positive signal edge. The counter value is no longer decremented once the 
low limit of the specified data type has been reached.

When the signal state at the LD parameter changes to "1", the counter value of the CV 
parameter is set to the value of the PV parameter. As long as the LD parameter has the signal 
state "1", the signal state of the CU and CD parameters has no effect on the instruction.

The counter value is set to zero when the signal state of the R parameter changes to "1". As 
long as the R parameter has signal state "1", a change in the signal state of the CU, CD and 
LD parameters has no effect on the "Count up and down" instruction.
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You can query the status of the up counter at the QU parameter. When the current counter 
value is greater than or equal to the value of the PV parameter, the QU parameter is set to 
signal state "1". In all other cases, the signal state of the QU parameter is "0". You can also 
specify a constant for the PV parameter.

You can query the status of the down counter at the QD parameter. If the current counter value 
is less than or equal to zero, the QD parameter is set to signal state "1". In all other cases, the 
signal state of the QD parameter is "0".

 

 Note

Only use a counter at a single location in the program to avoid counting errors.
 

Each call of the "Count up and down" instruction must be assigned an IEC counter in which 
the instruction data is stored. An IEC counter is a structure with one of the following data types:

For S7-1200 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT

For S7-1500 CPU

Data block of system data type IEC_<Counter> 
(Shared DB)

Local tag

● IEC_SCOUNTER / IEC_USCOUNTER
● IEC_COUNTER / IEC_UCOUNTER
● IEC_DCOUNTER / IEC_UDCOUNTER
● IEC_LCOUNTER / IEC_ULCOUNTER

● CTUD_SINT / CTUD_USINT
● CTUD_INT / CTUD_UINT
● CTUD_DINT / CTUD_UDINT
● CTUD_LINT / CTUD_ULINT

You can declare an IEC counter as follows:

● Declaration of a data block of system data type IEC_<Counter> (for example, 
"MyIEC_COUNTER")

● Declaration as a local tag of the type CTUD_<Data type> in the "Static" section of a block 
(for example, #MyCTUD_COUNTER)

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the IEC counter is stored in its own data block (single instance) or as a 
local tag (multiple instance) in the block interface. If you create a separate data block, you will 
find it in the project tree in the "Program resources" folder under "Program blocks > System 
blocks". For additional information on this topic, refer to "See also".

When you set up the IEC counter in a separate data block (single instance), the instance data 
block is created by default with "optimized block access" and the individual tags are defined 

Programming the PLC
9.7 References

WinCC Professional V13.0
2452 System Manual, 02/2014



as retentive. For additional information on setting retentivity in an instance data block, refer to 
"See also".

When you set up the IEC counter as local tag (multiple instance) in a function block with 
"optimized block access", it is defined as retentive in the block interface.

Syntax
The following syntax is used for the "Count up and down" instruction:

Table 9-32 Data block of system data type IEC_counter (global DB)

SCL
<IEC_Counter_DB>.CTUD(CU := <Operand>,
                     CD := <Operand>,
                     R := <Operand>,
                     LD := <Operand>,
                     PV := <Operand>,
                     QU=> <Operand>,
                     QD := <Operand>,
                     CV => <Operand>)

Table 9-33 Local tag

SCL
myLocal_counter(CU := <Operand>,
                CD := <Operand>,
                R := <Operand>,
                LD := <Operand>,
                PV := <Operand>,
                QU=> <Operand>,
                QD := <Operand>,
                CV => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
CU Input BOOL Count up input
CD Input BOOL Count down input
R Input BOOL Reset input
LD Input BOOL Load input
PV Input Integers Value at which the QU 

output is set.
QU Output BOOL Status of the up counter
QD Output BOOL Status of the down 

counter
CV Output Integers, CHAR, DATE Current counter value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"IEC_COUNTER_DB".CTUD(CU := "Tag_Start1",
                      CD := "Tag_Start2",
                      LD := "Tag_Load",
                      R := "Tag_Reset",
                      PV := "Tag_PresetValue",
                      QU => "Tag_CU_Status",
                      QD => "Tag_CD_Status",
                      CV => "Tag_CounterValue");

If the "Tag_Start1" operand has a positive signal edge in the signal state, the current counter 
value is incremented by one and stored in the "Tag_CounterValue" operand. If the "Tag_Start2" 
operand has a positive signal edge in the signal state, the counter value is decremented by 
one and is also stored in the "Tag_CounterValue" operand. The counter value is incremented 
on the positive signal edge of the CU parameter until it reaches the high limit of the specified 
data type (INT). If the CD parameter has a positive signal edge, the counter value is 
decremented until it reaches the low limit of the specified data type (INT).

The operand "Tag_CU_Status" has the signal state "1" as long as the current counter value is 
greater than or equal to the value of the operand "Tag_PresetValue". In all other cases, the 
"Tag_CU_Status" output has signal state "0".

The operand "Tag_CD_Status" has the signal state "1" as long as the current counter value is 
less than or equal to zero. In all other cases, the "Tag_CD_Status" output has signal state "0".

See also
Overview of the valid data types (Page 1320)

Setting retentivity in an instance data block (Page 1652)

Setting the retentivity of local tags (Page 1507)

SIMATIC Counters

S_CU: Assign parameters and count up

Description
You can use the "Assign parameters and count up" instruction to increment the value of a 
counter. When the signal state of the parameter CU changes from "0" to "1" (positive signal 
edge), the current counter value is incremented by one. The current counter value is provided 
at the parameter CV. The counter value is incremented until the limit of "999" is reached. When 
the limit value is reached, the counter value is no longer incremented on a positive signal edge.

When the signal state of the parameter S changes from "0" to "1", the counter value is set to 
the value of the parameter PV. If the counter is set and if the result of logic operation (RLO) 
at the CU input is "1", the counter counts once in the next cycle, even when no signal edge 
change is detected.
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The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has the signal state "1", a change in the signal state of the parameters 
CU and S has no effect on the counter value.

The signal state at parameter Q is "1" if the counter value is greater than zero. When the 
counter value equals zero, parameter Q returns signal state "0".

 

 Note

Only use a counter at a single point in the program to avoid the risk of counting errors.
 

Syntax
The following syntax is used for the "Assign parameters and count up" instruction:

SCL
S_CU(C_NO := <Operand>,
     CU:= <Operand>,
     S := <Operand>,
     PV := <Operand>,
     R := <Operand>,
     Q => <Operand>,
     CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
C_NO Input COUNTER, INT Counters

The number of counters 
depends on the CPU.

CU Input BOOL Count up input
S Input BOOL Input for presetting the 

counter
PV Input WORD Preset counter value 

(C#0 to C#999) in BCD 
format

R Input BOOL Reset input
Q Output BOOL Status of the counter
CV Output WORD, S5TIME, DATE Current counter value 
Function value WORD, S5TIME, DATE Current counter value in 

BCD format

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_CU(C_NO := "Counter_1",
                     CU := "Tag_Start",
                     S := "Tag_1",
                     PV := "Tag_PresetValue",
                     R := "Tag_Reset",
                     Q => "Tag_Status",
                     CV => "Tag_Value");

If the signal state of the "Tag_Start" parameter changes from "0" to "1" (positive signal edge) 
and the current counter value is less than "999", the counter value is incremented by one. If 
the signal state of the input "Tag_1" changes from "0" to "1", the counter value in BCD format 
is set to the value of the operand "Tag_PresetValue". The counter value is reset to "0" when 
the operand "Tag_Reset" has signal state "1".

The current counter value is stored in hexadecimal form in the operand "Tag_Value".

The output "Tag_Status" has the signal state "1" as long as the current counter value is not 
equal to "0". The current counter value is returned in the "Tag_Value" operand and as a function 
value.

See also
Overview of the valid data types (Page 1320)

S_CD: Assign parameters and count down

Description   
You can use the "Assign parameters and count down" instruction to decrement the value of a 
counter. When the signal state of the parameter CD changes from "0" to "1" (positive signal 
edge), the current counter value is decreased by one. The current counter value is provided 
at the parameter CV. The counter value is decreased until the low limit of "0" is reached. When 
the low limit value is reached, the counter value is no longer decreased on a positive signal 
edge.

When the signal state of the parameter S changes from "0" to "1", the counter value is set to 
the value of the parameter PV. If the counter is set and if the result of logic operation (RLO) 
at the parameter CD is "1", the counter counts once in the next cycle, even when no signal 
edge change is detected.

The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has the signal state "1", a change in the signal state of the parameters 
CD and S has no effect on the counter value.
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The signal state at parameter Q is "1" if the counter value is greater than zero. When the 
counter value equals zero, parameter Q returns signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Syntax
The following syntax is used for the "Assign parameters and count down" instruction:

SCL
S_CD(C_NO:= <Operand>,
     CD:= <Operand>,
     S:= <Operand>,
     PV:= <Operand>,
     R:= <Operand>,
     Q=> <Operand>,
     CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
C_NO Input COUNTER, INT Counters

The number of counters 
depends on the CPU.

CD Input BOOL Count down input
S Input BOOL Input for presetting the 

counter
PV Input WORD Preset counter value 

(C#0 to C#999) in BCD 
format

R Input BOOL Reset input
Q Output BOOL Status of the counter
CV Output WORD, S5TIME, 

WORD
Current counter value 

Function value WORD, S5TIME, DATE Current counter value in 
BCD format

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_CD(C_NO := "Counter_1",
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SCL
                     CD := "Tag_Start",
                     S := "Tag_1",
                     PV := "Tag_PresetValue",
                     R := "Tag_Reset",
                     Q => "Tag_Status",
                     CV => "Tag_Value");

When the signal state of the operand "Tag_Start" changes from "0" to "1" (positive signal edge) 
and the current counter value is greater than "0", the counter value is decreased by one. If the 
signal state of the operand "Tag_1" changes from "0" to "1", the counter value is set to the 
value of the operand "Tag_PresetValue". The counter value is reset to "0" when the operand 
"Tag_Reset" has signal state "1".

The current counter value is stored in the operand "Tag_Value".

The operand "Tag_Status" returns signal state "1" as long as the current counter value is not 
equal to "0". The current counter value is returned in the "Tag_Value" operand and as a function 
value.

See also
Overview of the valid data types (Page 1320)

S_CUD: Assign parameters and count up / down

Description     
You can use the "Assign parameters and count up / down" instruction to increment and 
decrement the value of a counter. When the signal state of the parameter CU changes from 
"0" to "1" (positive signal edge), the current counter value is incremented by one. When the 
signal state of the parameter CD changes from "0" to "1" (positive signal edge), the counter 
value is decreased by one. The current counter value is provided at the parameter CV. If there 
is a positive signal edge at the parameters CU and  CD in one program cycle, the counter 
value remains unchanged.

The counter value is incremented until the high limit value of "999" is reached. When the high 
limit value is reached, the counter value is no longer incremented on a positive signal edge. 
When the low limit value "0" is reached, the counter value is not decremented any further.

When the signal state of the parameter S changes from "0" to "1", the counter value is set to 
the value of the parameter PV. If the counter is set and if the result of logic operation (RLO) 
of the parameters CU and CD is "1", the counter will count once in the next cycle, even if no 
signal edge change was detected.

The counter value is set to zero when the signal state of the parameter R changes to "1". As 
long as the parameter R has the signal state "1", processing of the signal state of the 
parameters CU, CD and S has no effect on the counter value.
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The signal state at parameter Q is "1" if the counter value is greater than zero. When the 
counter value equals zero, parameter Q returns signal state "0".

 

 Note

Only use a counter at a single location in the program to avoid risk of counting errors.
 

Syntax
The following syntax is used for the "Assign parameters and count up / down" instruction:

SCL
S_CUD(C_NO:= <Operand>,
      CU:= <Operand>,
      CD:= <Operand>,
      S:= <Operand>,
      PV:= <Operand>,
      R:= <Operand>,
      Q=> <Operand>,
      CV=> <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
C_NO Input COUNTER, INT Counters

The number of counters 
depends on the CPU.

CU Input BOOL Count up input
CD Input BOOL Count down input
S Input BOOL Input for presetting the 

counter
PV Input WORD Preset counter value 

(C#0 to C#999) in BCD 
format

R Input BOOL Reset input
Q Output BOOL Status of the counter
CV Output WORD, S5TIME, DATE Current counter value 

(hexadecimal)
Function value WORD, S5TIME, DATE Current counter value in 

BCD format

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := S_CD(C_NO := "Counter_1",
                     CU := "Tag_CU",
                     CD := "Tag_CD",
                     S := "Tag_1",
                     PV := "Tag_PresetValue",
                     R := "Tag_Reset",
                     Q => "Tag_Status",
                     CV => "Tag_Value");

When a positive signal edge is detected in the signal state of the operand "Tag_CU" and the 
current counter value is less than "999", the counter value is incremented by one. When a 
positive signal edge is detected in the signal state of the operand "Tag_CD" and the current 
counter value is greater than "0", the counter value is decremented by one.

If the signal state of the operand "Tag_1" changes from "0" to "1", the counter value is set to 
the value of the operand "Tag_PresetValue". The counter value is reset to "0" when the 
operand "Tag_Reset" has signal state "1".

The current counter value is stored in the operand "Tag_Value".

The operand "Tag_Status" returns signal state "1" as long as the current counter value is not 
equal to "0". The current counter value is returned in the "Tag_Value" operand and as a function 
value.

See also
Overview of the valid data types (Page 1320)

Comparator operations

TypeOf: Query data type of a VARIANT tag

Description
You can use the "Check data type of a VARIANT tag" instruction to query the data type of a 
tag to which a VARIANT tag is pointing. You compare the data type of the tag to the data type 
of a tag that you have declared in the block interface to determine whether they are "Equal" 
or "Not equal".

The operand must have the VARIANT data type. The comparison operand can be an 
elementary data type or a PLC data type.

You can only use the "Check data type of a VARIANT tag" instruction within an IF instruction.
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Syntax
The following syntax is used for the "Check data type of a VARIANT tag" instruction:

SCL
TypeOf(<Operand>)

Parameters
The following table shows the parameters of the "Check data type of a VARIANT tag" 
instruction:

Parameter Declaration Data type Description
<Operand> Input VARIANT First operand

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF TypeOf(#TagVARIANT) = TypeOf("TagBOOL") THEN
...;
END_IF;

If the operand to which the VARIANT "#TagVARIANT" is pointing has the BOOL data type, a 
specific command is to be executed.

See also
Overview of the valid data types (Page 1320)

TypeOfElements: Check element data type of a VARIANT tag

Description
You can use the "Check element data type of a VARIANT tag" instruction to query the data 
type of a tag to which a VARIANT is pointing. You compare the data type of the tag to the data 
type of a tag that you have declared in the block interface to determine whether they are "Equal" 
or "Not equal".

The operand must have the VARIANT data type. The comparison operand can be an 
elementary data type or a PLC data type.

If the data type of the VARIANT tag is an ARRAY, the data type of the ARRAY elements is 
compared.
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You can only use the "Check element data type of a VARIANT tag" instruction within an IF 
instruction.

Syntax
The following syntax is used for the "Check element data type of a VARIANT tag" instruction:

SCL
TypeOfElements(<Operand>)

Parameter
The following table shows the parameters of the "Check element data type of a VARIANT tag" 
instruction:

Parameter Declaration Data type Description
<Operand> Input VARIANT First operand

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF TypeOfElements(#Tag_VARIANT) = TypeOf("GlobalDB".Product[1]) THEN
"Tag_Result" := "GlobalDB".Product[1] * 3;
END_IF;

The following table shows how the instruction works using specific operand values:

Operand Value
#Tag_VARIANT 1.5
"GlobalDB".Product[1] 3.5

If the tag to which the VARIANT points and the ""GlobalDB".Product[1]" operand have the 
REAL data type, the "GlobalDB".Product[1]" operand is then multiplied by 3 and the result is 
written to the "Tag_Result" operand.

See also
Overview of the valid data types (Page 1320)
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IS_ARRAY: Check for ARRAY

Description
You can use the "Check for ARRAY" instruction to query whether the VARIANT points to a tag 
of the ARRAY data type.

The <Operand> must have the VARIANT data type.

You can only use the "Check for ARRAY" instruction within an IF instruction.

Syntax
The following syntax is used for the "Check for ARRAY" instruction:

SCL
IS_ARRAY(<Operand>)

Parameter
The following table shows the parameters of the "Check for ARRAY" instruction:

Parameter Declaration Data type Description
<Operand> Input VARIANT Operand that is queried for 

ARRAY
Function value UDINT Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF IS_ARRAY(#Tag_VARIANTToArray) THEN
"Tag_Result" := CountOfElements(#Tag_VARIANT);
END_IF;

If the tag to which the VARIANT points is an ARRAY, the number of ARRAY elements is output.

See also
Overview of the valid data types (Page 1320)
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Math functions

ABS: Form absolute value

Description     
Use the "Form absolute value" instruction to calculate the absolute value of an input value and 
to save the result in the specified operands.

Syntax
Use the following syntax for the "Form absolute value" instruction:

SCL
ABS(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

<Expression> Input SINT, INT, DINT, 
floating-point 
numbers

SINT, INT, DINT, 
LINT, floating-
point numbers

Input value

Function value SINT, INT, DINT, 
floating-point 
numbers

SINT, INT, DINT, 
LINT, floating-
point numbers

Absolute value of 
the input value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"Tag_Result1" := ABS("Tag_Value");
"Tag_Result2" := ABS("Tag_Value1"*"Tag_Value2");

The absolute value of the input value is returned in the format of the input value as a function 
value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value -2
Tag_Result1 2
Tag_Value1 4
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Operand Value
Tag_Value2 -1
Tag_Result2 4

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

MIN: Get minimum

Description
The "Get minimum" instruction compares the values of the available inputs and returns the 
lowest value as the result.

A minimum of two and a maximum of 32 inputs can be specified at the instruction.

The result is invalid if any of the following conditions are met:

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Syntax
The following syntax is used for the "Get minimum" instruction:

SCL
MIN(IN1:= <Operand>,
    IN2 := <Operand>)
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Parameter
The following table shows the parameters of the "Get minimum" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN1 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

First input value

IN2 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Second input value

INn Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Additionally 
inserted inputs 
whose values are 
to be compared

Function value Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Result of the 
instruction

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MIN(IN1 := "Tag_Value1",
                    IN2 := "Tag_Value2",
                    IN3 := "Tag_Value3");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 12222
IN2 Tag_Value2 14444
IN3 Tag_Value3 13333
Function value Tag_Result 12222
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The instruction compares the values of the available inputs and copies the lowest value 
("Tag_Value1") to operand "Tag_Result".

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

MAX: Get maximum

Description
The "Get maximum" instruction compares the values of the available inputs and returns the 
greatest value as the result.

A minimum of two and a maximum of 32 inputs can be specified at the instruction.

The result is invalid if any of the following conditions are met:

● The implicit conversion of the data types fails during execution of the instruction.

● A floating-point number has an invalid value.

Syntax
The following syntax is used for the "Get maximum" instruction:

SCL
MAX(IN1:= <Operand>,
    IN2 := <Operand>)
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Parameters
The following table shows the parameters of the "Get maximum" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN1 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

First input value

IN2 Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Second input value

INn Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Additionally 
inserted inputs 
whose values are 
to be compared

Function value Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Result of the 
instruction

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MAX(IN1 := "Tag_Value1",
                    IN2 := "Tag_Value2",
                    IN3 := "Tag_Value3");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN1 Tag_Value1 12 222
IN2 Tag_Value2 14 444
IN3 Tag_Value3 13 333
Function value Tag_Result 14 444
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The instruction compares the values of the specified operands and copies the greatest value 
("Tag_Value2") to the operand "Tag_Result".

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

LIMIT: Set limit value

Description
The "Set limit value" instruction limits the value of the parameter IN to the values of the 
parameters MN and MX. The value of the parameter MN may not be greater than the value of 
the parameter MX.

If the value of the IN parameter fulfills the MN condition <=IN <= MX, it is returned as the result 
of the instruction. If the condition is not fulfilled and the IN input value is less than the MN low 
limit, the value of the MN parameter is returned as the result. If the high limit MX is exceeded, 
the value of the MX parameter is returned as the result.

If the value of the MN input is greater than the value of the MX input, the result is undefined.

The instruction is only executed if the operands of all parameters are of the same data type.

Syntax
The following syntax is used for the "Set limit value" instruction:

SCL
LIMIT(MN := <Operand>,
      IN := <Operand>,
      MX := <Operand>)

The syntax of the instruction consists of the following parts:
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Parameter
 

Declaration
 

Data type Description
S7-1200 S7-1500

MN Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Low limit

IN Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Input value

MX Input Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

High limit

Function value Integers, floating-
point numbers, 
TIME, TOD, 
DATE, DTL

Integers, floating-
point numbers, 
TIME, LTIME, 
TOD, LTOD, 
DATE, LDT, DT, 
DTL

Result of the 
instruction

The data types TOD, LTOD, DATE, and LDT can only be used if the IEC test is not enabled.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := LIMIT(MN := "Tag_Minimum",
                      IN := "Tag_Value",
                      MX := "Tag_Maximum");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
MN Tag_Minimum 12 000
IN Tag_Value 8 000
MX Tag_Maximum 16 000
Function value Tag_Result 12 000

The value of operand "Tag_Value" is compared with the values of operands "Tag_Minimum" 
and "Tag_Maximum". Because the value of the operand "Tag_Value" is less than the low limit 
value, the value of operand "Tag_Minimum" will be copied to operand "Tag_Result".
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See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

SQR: Form square

Description     
Use the "Form square" instruction to square the input value and save the result in the specified 
operand.

Syntax
Use the following syntax for the instruction "Form square":

SCL
SQR(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
Function value Floating-point numbers Square of the input 

value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := SQR("Tag_Value");
"Tag_Result2" := SQR((SQR("Tag_Value1"))*"Tag_Value2);

The square of the input value is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 2.5
Tag_Result1 6.25
Tag_Value1 6.0
Tag_Value2 2.0
Tag_Result2 5184.0
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See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

SQRT: Form square root

Description       
Use the "Form square root" instruction to calculate the square root of the the input value and 
save the result in the specified operand. The instruction has a positive result if the input value 
is greater than zero. If input values are less than zero, the instruction returns an invalid floating-
point number. If the input value is "-0", the result is also "-0".

Syntax
Use the following syntax for the "Form square root" instruction:

SCL
SQRT(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
Function value Floating-point numbers Square root of the input 

value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := SQRT("Tag_Value");
"Tag_Result2" := SQRT((SQR("Tag_Value1"))+"Tag_Value2");

The square root of the input value is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 4.0
Tag_Result1 2.0
Tag_Value1 3.0
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Operand Value
Tag_Value2 16.0
Tag_Result2 5.0

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

LN: Form natural logarithm

Description     
You can use the "Form natural logarithm" instruction to calculate the natural logarithm to base 
e (e=2.718282) of the input value. The instruction has a positive result if the input value is 
greater than zero. If input values are less than zero, the instruction returns an invalid floating-
point number.

Syntax
Use the following syntax for the "Form natural logarithm" instruction:

SCL
LN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point 

numbers
Input value

Function value Floating-point 
numbers

Natural logarithm of the input 
value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := LN("Tag_Value");
"Tag_Result2" := LN("Tag_Value1"+"Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value 2.5
Tag_Result1 0.916
Tag_Value1 1.5
Tag_Value2 3.2
Tag_Result2 1.548

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

EXP: Form exponential value

Description     
The "Form exponential value" instruction calculates the exponent from the base e (e = 
2.718282) and the input value and saves the result in the specified operand.

Syntax
The following syntax is used for the "Form exponential value" instruction:

SCL
EXP(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
Function value Floating-point numbers Exponential value of the 

input value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := EXP("Tag_Value");
"Tag_Result2" := EXP("Tag_Value1"/"Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.
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The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 20.5
Tag_Result1 799 902 200
Tag_Value1 15.5
Tag_Value2 30.2
Tag_Result2 1.671

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

SIN: Form sine value

Description     
Use the "Form sine value" instruction to calculate the sine of the input value. The input value 
must be given in the radian measure.

Syntax
Use the following syntax for the "Form sine value" instruction:

SCL
SIN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value (size of an 

angle in the radian 
measure)

Function value Floating-point numbers Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SIN("Tag_Value");
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The result of the instruction is returned in the "Tag_Result" operand as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value +1.570796 (π/2)
Tag_Result 1.0

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

COS: Form cosine value

Description     
Use the "Form cosine value" instruction to calculate the cosine of the input value. The input 
value must be given in the radian measure.

Syntax
Use the following syntax for the "Form cosine value" instruction:

SCL
COS(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value (size of an 

angle in the radian 
measure)

Function value Floating-point numbers Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := COS("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.
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The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value +1.570796 (π/2)
Tag_Result 0

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

TAN: Form tangent value

Description     
Use the "Form tangent value" instruction to calculate the sine of the input value. The input 
value must be given in the radian measure.

Syntax
Use the following syntax for the "Form tangent value" instruction:

SCL
TAN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value (size of an 

angle in the radian 
measure)

Function value Floating-point numbers Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"Tag_Result" := TAN("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value +3.141593 (π)
Tag_Result 0

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

ASIN: Form arcsine value

Description     
You can use the "Form arcsine value" instruction to calculate the size of the angle from a sine 
value, which corresponds to this value. Only valid floating-point numbers within the range -1 
to +1 can be specified as input values. The calculated angle size is given in the radian measure 
and can range in value from -π/2 to +π/2.

Syntax
Use the following syntax for the "Form arcsine value" instruction:

SCL
ASIN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Sine value
Function value Floating-point numbers Size of angle in the 

radian measure

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ASIN("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value 1.0
Tag_Result +1.570796 (π/2)

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

ACOS: Form arccosine value

Description     
You can use the "Form arccosine value" instruction to calculate the size of the angle from a 
cosine value, which corresponds to this value. Only valid floating-point numbers within the 
range -1 to +1 can be specified as input values. The calculated angle size is given in the radian 
measure and can range in value from 0 to +π.

Syntax
Use the following syntax for the "Form arccosine value" instruction:

SCL
ACOS(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Cosine value
Function value Floating-point numbers Size of angle in the 

radian measure

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ACOS("Tag_Value");

The result of the instruction is returned in the "Tag_Result" operand as a function value.

The following table shows how the instruction works using specific operand values:

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2479



Operand Value
Tag_Value 0
Tag_Result +1.570796 (π/2)

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

ATAN: Form arctangent value

Description     
You can use the "Form arctangent value" instruction to calculate the size of the angle from a 
tangent value, which corresponds to this value. Only valid floating-point numbers may be 
specified as input values. The calculated angle size is given in the radian measure and can 
range in value from -π/2 to +π/2.

Syntax
Use the following syntax for the "Form arctangent value" instruction:

SCL
ATAN(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Tangent value
Function value Floating-point numbers Size of angle in the 

radian measure

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ATAN("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value 1.0
Tag_Result +0.785398 (π/4)

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

FRAC: Return fraction

Description     
The result of the instruction "Return fraction" returns the decimal places of a value. Input value 
123.4567, for example, returns the value 0.4567.

Syntax
The following syntax is used for the instruction "Return fraction":

SCL
FRAC(<Expression>)
FRAC_<Data type>(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
_<Data type> Floating-point numbers

Default: REAL
Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Floating-point numbers Decimal places of the 
input value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := FRAC("Tag_Value");
"Tag_Result2" := FRAC_LREAL("Tag_Value");

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 2.555 -1.4421
Tag_Result1 0.555 -0.4421

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

Move operations

Deserialize: Deserialization

Description
You can use the "Deserialize" instruction to convert the sequential representation of a PLC 
data type (UDT) back to a PLC data type and to fill its entire contents.

The memory area in which the sequential representation of a PLC data type is located must 
have the ARRAY of BYTE data type and be declared with standard access. Make sure that 
there is enough memory space prior to the conversion.

The instruction enables you to convert multiple sequential representations of converted PLC 
data types back to their original state step-by-step.

 

 Note

If you only want to convert back a single sequential representation of a PLC data type (UDT), 
you can also use the instruction "TRCV: Receive data via communication connection" directly.
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Syntax
The following syntax is used for the "Deserialize" instruction:

SCL
Deserialize(SRC_ARRAY := <Operand>,
            DEST_VARIABLE:= <Operand>,
            POS := <Operand>)

Parameter
The following table shows the parameters of the "Deserialize" instruction:

Parameter Declaration Data type Description
SRC_ARRAY Input VARIANT Global data block in which the generated data stream is stored
DEST_VARIAB
LE

InOut VARIANT Tag in which the returned converted PLC data type (UDT) is stored

POS InOut DINT Number of bytes that the converted PLC data types use. The POS 
parameter is calculated zero-based.

Function value INT Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B0 The memory areas for the SRC_ARRAY and 

DEST_VARIABLE parameters overlap.
8136 The data block at the DEST_VARIABLE parameter is not a 

block with standard access.
8150 The VARIANT data type at the SRC_ARRAY parameter 

contains no value.
8151 Code generation error at SRC_ARRAY parameter
8153 There is not enough free memory available at the 

SRC_ARRAY parameter.
8250 The VARIANT data type at the DEST_VARIABLE parameter 

contains no value.
8251 Code generation error at DEST_VARIABLE parameter
8254 Invalid data type at the DEST_VARIABLE parameter
8382 The value at the POS parameter is outside the limits of the 

array.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
#Tag_RetVal := Deserialize(SRC_ARRAY := "Buffer".Field,
                           DEST_VARIABLE := "Target".Client,
                           POS := #BufferPos);
 
#Tag_RetVal := Deserialize(SRC_ARRAY := "Buffer".Field,
                           DEST_VARIABLE := #Label,
                           POS := #BufferPos);
 
IF #Label = 'arti' THEN
#Tag_RetVal := Deserialize(SRC_ARRAY := "Buffer".Field,
                           DEST_VARIABLE := "Target".Article[#DeliverPos],
                           POS := #BufferPos);
ELSIF #Label = 'Bill' THEN
#Tag_RetVal := Deserialize(SRC_ARRAY := "Buffer".Field,
                           DEST_VARIABLE := "Target".Bill[#DeliverPos],
                           POS := #BufferPos);
;
ELSE
;
END_IF;

The "Move value" instruction moves the value "0" to the "#BufferPos" operand. The 
"Deserialize" instruction deserializes the sequential representation of the customer data from 
the "Buffer" data block and writes it to the "Target" data block. The number of bytes used by 
the converted customer data is stored in the "#BufferPos" operand.

The "Deserialize" instruction deserializes the sequential representation of the separator sheet, 
which was saved with the sequential representation after the customer data, from the "Buffer" 
data block and writes the characters to the "#Label" operand. The characters are compared 
using comparison instructions for "arti" and "Bill". If the comparison for "arti" = TRUE, these 
are article data that have been deserialized and written to the "Target" data block. If the 
comparison for "Bill" = TRUE, these are billing data that have been deserialized and written to 
the "Target" data block.

The following table shows the declaration of the operands:

Operand Data type Declaration
DeliverPos INT In the "Input" section of the block interface
BufferPos DINT In the "Temp" section of the block interface
Error INT In the "Temp" section of the block interface
Label STRING[4] In the "Temp" section of the block interface

The following table lists the declarations of the PLC data types:
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Name of the PLC data types Name Data type
Article Number DINT

Declaration STRING
Colli INT

Client Title INT
First name STRING[10]
Surname STRING[10]

The following table shows the declaration of the data blocks:

Name of the data blocks Name Data type
Target Client "Client" (PLC data type)

Article Array[0..] of "Article" (PLC data type)
Bill Array[0..10] of INT

Buffer Field Array[0..294] of BYTE

See also
Overview of the valid data types (Page 1320)

PLC data types (Page 1364)

Serialize: Serialization

Description
You can use the "Serialize" instruction to convert several PLC data types (UDT) to a sequential 
representation without losing parts of their structure.

You can use the instruction to temporarily save multiple structured data items from your 
program in a buffer, which should preferably be in a global data block, and send them to another 
CPU. The memory area in which the converted PLC data types are stored must have the 
ARRAY of BYTE data type and be declared with standard access. Make sure that there is 
enough memory space prior to the conversion.

The operand at the POS parameter contains information about the number of bytes used by 
the converted PLC data types.

 

 Note

If you want to send a single PLC data type (UDT), you can directly call the instruction "TSEND: 
Send data via communication connection".
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Syntax
The following syntax is used for the "Serialize" instruction:

SCL
Serialize(SRC_VARIABLE := <Operand>,
          DEST_ARRAY := <Operand>,
          POS := <Operand>)

Parameter
The following table shows the parameters of the "Serialize" instruction:

Parameter Declaration Data type Description
SRC_VARIA
BLE

Input VARIAN
T

PLC data type (UDT) that is converted to sequential representation.

DEST_ARRA
Y

InOut VARIAN
T

Data block in which the generated data stream is stored.

POS InOut DINT Number of bytes that the converted PLC data types use. The POS parameter is 
calculated zero-based.

Function value INT Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B0 The memory areas for the SRC_VARIABLE and 

DEST_ARRAY parameters overlap.
8150 The VARIANT data type at the SRC_VARIABLE parameter 

contains no value.
8152 Code generation error at SRC_VARIABLE parameter
8236 The data block at the DEST_ARRAY parameter is not a block 

with standard access.
8250 The VARIANT data type at the DEST_ARRAY parameter 

contains no value.
8252 Code generation error at DEST_ARRAY parameter
8253 There is not enough free memory available at the 

DEST_ARRAY parameter.
8254 Invalid data type at the DEST_ARRAY parameter
8382 The value at the POS parameter is outside the limits of the 

array.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
#Tag_RetVal := Serialize(SRC_VARIABLE := "Source".Client,
                         DEST_ARRAY := "Buffer".Field,
                         POS := #BufferPos);
 
#Label := STRING_TO_WSTRING('arti');
 
#Tag_RetVal := Serialize(SRC_VARIABLE := #Label,
                         DEST_ARRAY := "Buffer".Field,
                         POS := #BufferPos);
 
#Tag_RetVal := Serialize(SRC_VARIABLE := "Source".Article[#DeliverPos],
                         DEST_ARRAY := "Buffer".Field,
                         POS := #BufferPos);

The "Move value" instruction moves the value "0" to the "#BufferPos" operand. The "Serialize" 
instruction serializes the customer data from the "Source" data block and writes them in 
sequential representation to the "Buffer" data block. The number of bytes used by the 
sequential representation is stored in the "#BufferPos" operand.

A kind of separator sheet is inserted now to make it easier to deserialize the sequential 
representation later. The "Move character string" instruction moves the "arti" characters to the 
"#Label" operand. The "Serialize" instruction writes these characters after the customer data 
to the "Buffer" data block. The number of bytes that the characters need is added to the number 
already stored in the "#BufferPos" operand.

The "Serialize" instruction serializes the data of a specific article, which is calculated in runtime, 
from the "Source" data block and writes them in sequential representation to the "Buffer" data 
block after the "arti" characters.

The following table shows the declaration of the operands:

Operand Data type Declaration
DeliverPos INT In the "Input" section of the block interface
BufferPos DINT In the "Temp" section of the block interface
Error INT In the "Temp" section of the block interface
Label STRING[4] In the "Temp" section of the block interface

The following table lists the declarations of the PLC data types:

Name of the PLC data types Name Data type
Article Number DINT

Declaration STRING
Colli INT

Client Title INT
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Name of the PLC data types Name Data type
First name STRING[10]
Surname STRING[10]

The following table shows the declaration of the data blocks:

Name of the data blocks Name Data type
Source
 

Client "Client" (PLC data type)
Article Array[0..10] of "Article" (PLC data type)

Buffer Field Array[0..294] of BYTE

See also
Overview of the valid data types (Page 1320)

PLC data types (Page 1364)

MOVE_BLK: Move block

Description
The instruction "Move block" copies the contents of a memory area (source area) to another 
memory area (destination area). The number of elements to be copied to the destination area 
is specified with the COUNT parameter. The width of the elements to be moved is defined by 
the width of the first element in the source area.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at the IN parameter or OUT parameter.

Syntax
The following syntax is used for the instruction "Move block":

SCL
MOVE_BLK(IN := <Operand>,
         COUNT := <Operand>,
         OUT => <Operand>)
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Parameter
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type  
S7-1200 S7-1500 Description

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the source area 
that is being copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
elements to be 
copied from the 
source area to the 
destination area

OUT 1) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the destination 
area to which the 
contents of the 
source area are 
being copied

1) The specified data types can only be used as elements of an ARRAY structure.

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
MOVE_BLK(IN := #a_array[2],
         COUNT := "Tag_Count",
         OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

Starting from the third element, the instruction selects three INT elements from the #a_array 
tag and copies their contents to the #b_array output tag, beginning with the second element.
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See also
Overview of the valid data types (Page 1320)

MOVE_BLK_VARIANT: Move block

Description
The instruction "Move block" copies the contents of a memory area (source area) to another 
memory area (destination area). You can copy elements of an array to another array of the 
same data type. The size (number of elements) of the source and destination array may be 
different. You can copy several elements within an array or individual elements.

If you are using the instruction, the array must not yet be known at the time the block is created, 
as the source and the destination are transferred using VARIANT.

The counting at the parameters SRC_INDEX and DEST_INDEX always starts with the low 
limit "0", regardless of the later declaration of the array.

The instruction is not executed if more data is copied than is made available.

If the VARIANT pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

Syntax
The following syntax is used for the "Move block" instruction:

SCL
MOVE_BLK_VARIANT(SRC := <Operand>,
                 COUNT := <Operand>,
                 SRC_INDEX := <Operand>,
                 DEST_INDEX := <Operand>,
                 DEST => <Operand>)

Parameter
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Description
SRC Input VARIANT

(array or single element)
Source block from which to 
copy

COUNT Input UDINT Number of elements which 
are copied
Set the value at the 
parameter COUNT to "1", if 
no Array is specified at the 
parameter SRC or the 
parameter DEST.
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Parameter Declaration Data type Description
SRC_INDEX Input DINT ● The SRC_INDEX 

parameter is calculated 
zero-based. If an Array is 
specified at parameter 
SRC, the integer at the 
SRC_INDEX parameter 
specifies the first element 
within the source area 
from which copying is to 
take place. This is 
independent of the 
declared array limits.

● If no Array is set at the 
SRC parameter or only 
an individual element of 
an array is specified, 
assign the SRC_INDEX 
parameter the value "0".

DEST_INDEX Input DINT ● The DEST_INDEX 
parameter is calculated 
zero-based. If an Array is 
specified at the DEST 
parameter, the integer at 
the DEST_INDEX 
parameter specifies the 
first element within the 
destination area to which 
copying is to take place. 
This is independent of the 
declared array limits.

● If no Array is specified at 
the DEST parameter, 
assign the DEST_INDEX 
parameter the value "0".

DEST Output VARIANT Destination area into which 
the contents of the source 
block are copied.

Function value (RET_VAL) INT Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
8151 Access to the SRC parameter is not possible.
8152 The operand at the SRC parameter is not typed.
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Error code*
(W#16#...)

Explanation

8153 Code generation error at SRC parameter
8154 The operand at the SRC parameter has the data type BOOL.
8281 The COUNT parameter has an invalid value
8382 The value at the SRC_INDEX parameter is outside the limits of the 

VARIANT.
8383 The value of the SRC_INDEX parameter is outside the high limit of the array.
8482 The value at the DEST_INDEX parameter is outside the limits of the 

VARIANT.
8483 The value of the DEST_INDEX parameter is outside the high limit of the 

array.
8534 The DEST parameter is write protected
8551 Access to the DEST parameter is not possible.
8552 The operand at the DEST parameter is not typed.
8553 Code generation error at DEST parameter
8554 The operand at the DEST parameter has the data type BOOL.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MOVE_BLK_VARIANT(SRC := #SrcField,
                                 COUNT := "Tag_Count",
                                 SRC_INDEX := "Tag_Src_Index",
                                 DEST_INDEX := "Tag_Dest_Index",
                                 DEST => #DestField);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
SRC #SrcField The local operand #SrcField 

uses a UDT that was still 
unknown at the time when the 
block was programmed. (Array 
[0 to 10] of "MOVE_UDT"

COUNT Tag_Count 2
SRC_INDEX Tag_Src_Index 3
DEST_INDEX Tag_Dest_Index 3
DEST #DestField The local operand #DestField 

uses a UDT that was still 
unknown at the time when the 
block was programmed. (Array 
[10 to 20] of "MOVE_UDT"
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2 elements are copied from the source area into the destination area beginning with the fourth 
element of the array of UDT. The copies are inserted in the array of UDT beginning with the 
fourth element.

See also
Overview of the valid data types (Page 1320)

VariantGet: Read out VARIANT tag value (Page 2525)

UMOVE_BLK: Move block uninterruptible

Description
The instruction "Move block uninterruptible" copies the contents of a memory area (source 
area) to another memory area (destination area) without interruption. The number of elements 
to be copied to the destination area is specified with the COUNT parameter. The width of the 
elements to be moved is defined by the width of the first element in the source area.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the instruction "Move 
block uninterruptible".

 

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at the IN parameter or OUT parameter.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Syntax
The following syntax is used for the instruction "Move block uninterruptible":

SCL
UMOVE_BLK(IN := <Operand>,
          COUNT := <Operand>,
          OUT => <Operand>)
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Parameter
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the source area 
that is being copied

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
elements to be 
copied from the 
source area to the 
destination area

OUT 1) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

The first element 
of the destination 
area to which the 
contents of the 
source area are 
being copied

1) The specified data types can only be used as elements of an ARRAY structure.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
UMOVE_BLK(IN := #a_array[2],
          COUNT := "Tag_Count",
          OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

Starting from the third element, the instruction selects three INT elements from the #a_array 
tag and copies their contents to the #b_array output tag, beginning with the second element. 
The copy operation cannot be interrupted by other operating system activities.
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See also
Overview of the valid data types (Page 1320)

FILL_BLK: Fill block

Description
The "Fill block" instruction is used to copy the content of a memory area (source area) to a 
selected memory area (target area). The number of repeated copy operations is specified with 
the COUNT parameter. When the instruction is executed, the source area is selected and 
moved to the destination area as often as specified by the value of the COUNT parameter.

The instruction can only be executed if the source area and the destination area are of the 
same data type.

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at input IN or output OUT.

Syntax
The following syntax is used for the instruction "Fill block":

SCL
FILL_BLK(IN := <Operand>,
         COUNT := <Operand>,
         OUT => <Operand>)

Parameter
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, TOD, 
DATE, CHAR

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Element used to 
fill the destination 
area

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
repeated copy 
operations
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Parameter Declaration Data type Description
S7-1200 S7-1500

OUT 2) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, TOD, 
DATE, CHAR

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Address in 
destination area 
from which filling 
starts

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.

For more information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
FILL_BLK(IN := #a_array[2],
         COUNT := "Tag_Count",
         OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

The instruction copies the third element (#a_array[2]) of the #a_array tag three times to the 
#b_array output tag.

See also
Overview of the valid data types (Page 1320)

UFILL_BLK: Fill block uninterruptible

Description
The instruction "Fill block uninterruptible" is used to copy the content of a memory area (source 
area) to a selected memory area (target area). The number of repeated copy operations is 
specified with the COUNT parameter. When the instruction is executed, the value at the IN 
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input is selected and copied to the destination area as often as specified by the value in the 
COUNT parameter.

The instruction can only be executed if the source area and the destination area have the same 
data type.

 

 Note

The copy operation cannot be interrupted by other operating system activities. This is why 
the alarm reaction times of the CPU increase during the execution of the "Fill block 
uninterruptible" instruction.

 

The value of the OUT output is invalid if the following condition is met:

● More data is moved than is made available at input IN or output OUT.

You can use the "Fill block uninterruptible" instruction to move a maximum of 16 KB. Note the 
CPU-specific restrictions for this.

Syntax
The following syntax is used for the "Fill block uninterruptible" instruction:

SCL
UFILL_BLK(IN := <Operand>,
          COUNT := <Operand>,
          OUT => <Operand>)

Parameter
The following table shows the parameters of the "Fill block uninterruptible" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN 1) Input Binary numbers, 
integers, floating-
point numbers, 
TIME, DATE, 
CHAR, TOD

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Element used to 
fill the destination 
area

COUNT Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of 
repeated copy 
operations

OUT 2) Output Binary numbers, 
integers, floating-
point numbers, 
TIME, TOD, 
DATE, CHAR

Binary numbers, 
integers, floating-
point numbers, 
timers, DATE, 
CHAR, TOD, 
LTOD

Address in 
destination area 
from which filling 
starts

1) The specified data types can also be used as elements of an ARRAY structure.
2) The specified data types can only be used as elements of an ARRAY structure.
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For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
UFILL_BLK(IN := #a_array[2],
          COUNT := "Tag_Count",
          OUT => #b_array[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN a_array[2] The data type of the a_array 

operand is Array [0..5] of INT. It 
consists of six elements of data 
type INT.

COUNT Tag_Count 3
OUT b_array[1] The data type of the b_array 

operand is Array [0..6] of INT. It 
consists of seven elements of 
data type INT.

The instruction copies the third element (#a_array[2]) of the #a_array tag three times to the 
#b_array output tag. The copy operation cannot be interrupted by other operating system 
activities.

See also
Overview of the valid data types (Page 1320)

SWAP: Swap

Description       
You can use the "Swap" instruction to change the arrangement of the bytes of an input value 
and save the result in the specified operand.

The following figure shows how the bytes of an operand of the DWORD data type are swapped 
using the "Swap" instruction:
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Syntax
The following syntax is used for the "Swap" instruction:

 SCL
SWAP(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

<Expression> Input WORD, DWORD WORD, DWORD, 
LWORD

Input value

Function value WORD, DWORD WORD, DWORD, 
LWORD

Result of the 
instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

 SCL
"Tag_Result" := SWAP("Tag_Value");

The result of the instruction is returned as a function value.

The following table shows how the instruction works using specific operand values:
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Operand Value
Tag_Value 0000 1111 0101 0101
Tag_Result 0101 0101 0000 1111

See also
Overview of the valid data types (Page 1320)

ARRAY DB instructions

ReadFromArrayDB: Read from array data block

Description
You can use the "Read from array data block" instruction to read data from an array DB and 
write them to a destination area.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

Syntax
The following syntax is used for the "Read from array data block" instruction:

SCL
ReadFromArrayDB(DB := <Operand>,
                INDEX := <Operand>,
                VALUE => <Operand>)

Parameter
The following table shows the parameters of the "Read from array data block" instruction:

Parameter Declaration Data type Description
DB Input DB_ANY Data block that is read
INDEX Input DINT Element that is read
VALUE Output VARIANT Value that is read and 

output
Function value (RET_VAL) INT Result of the instruction

For additional information on valid data types, refer to "See also".
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Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The array DB contains invalid values
8154 The data type is not correctly declared
8282 The value at the INDEX parameter is outside the 

limit values of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"TagResult" := ReadFromArrayDB(DB := "ArrayDB",
                               INDEX := "ArrayDB"."THIS"[2],
                               VALUE => "TargetField[10]".Data2[1]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB."THIS"[2] Third element of the "ArrayDB"
VALUE TargetField[10].Data2[1] The data type of the 

"TargetField" operand is Array 
[10 to 20] of "MOVE_UDT".

The third element is read from "ArrayDB" and written to the "TargetField[10].Data2[1]" operand.

See also
Overview of the valid data types (Page 1320)
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WriteToArrayDB: Write to array data block

Description
You can use the "Write to array data block" instruction to write data to an array DB.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

Syntax
The following syntax is used for the "Write to the ARRAY data block" instruction:

SCL
WriteToArrayDB(DB := <Operand>,
               INDEX := <Operand>,
               VALUE := <Operand>)

Parameter
The following table shows the parameters of the "Write to array data block" instruction:

Parameter Declaration Data type Description
DB Input DB_ANY Data block to which 

data is written
INDEX Input DINT Element in the DB to 

which data is written
VALUE Input VARIANT Value to be written
Function value (RET_VAL) INT Result of the instruction

For additional information on valid data types, refer to "See also".

Parameters RET_VAL
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
8132 The data block does not exist or is too short
8133 The data block is located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.

Programming the PLC
9.7 References

WinCC Professional V13.0
2502 System Manual, 02/2014



Error code*
(W#16#...)

Explanation

8282 The value at the INDEX parameter is outside the 
limit values of the array.

8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"TagResult" := WriteToArrayDB(DB := "ArrayDB",
                              INDEX := "ArrayDB"."THIS"[2],
                              VALUE := "SourceField[1]".Data1[6]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB."THIS"[2] Third element of the "ArrayDB"
VALUE SourceField[1].Data1[6] The data type of the 

"SourceField" operand is Array 
[0 to 10] of "MOVE_UDT".

From the "SourceField" operand, the "Data1[6]" element from the second element is written 
to the "ArrayDB". The third element is written to the "ArrayDB".

See also
Overview of the valid data types (Page 1320)

ReadFromArrayDBL: Read from array data block in load memory

Description
You can use the "Read from array data block in load memory" instruction to read data from an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.
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If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". The instruction is terminated if a negative 
signal edge is detected at the BUSY parameter. The DONE parameter has the signal state "1" 
for one program cycle and the read value is output at the VALUE parameter within this cycle. 
With all other program cycles, the value at the VALUE parameter is not changed.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

 

 Note

The array DB must be located in a data block with the block property "Optimized".
 

Syntax
The following syntax is used for the "Read from array data block in load memory" instruction:

SCL
"Instance DB"(REQ := <Operand>,
            DB := <Operand>,
            INDEX := <Operand>,
            BUSY => <Operand>,
            DONE => <Operand>,
            ERROR => <Operand>,
            VALUE := <Operand>)

Parameter
The following table shows the parameters of the "Read from array data block in load memory" 
instruction:

Parameter Declaration Data type Description
REQ Input BOOL REQ = "1": Starting with 

the reading of the array 
DB

DB Input DB_ANY Data block that is read
INDEX Input DINT Element that is read
BUSY Output BOOL BUSY = "1": The array 

DB is still being read
DONE Output BOOL DONE = "1": The 

instruction was 
executed successfully
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Parameter Declaration Data type Description
VALUE InOut VARIANT Value that is read and 

output
ERROR Output INT Error information:

If an error occurs during 
the execution of the 
instruction, an error 
code is output on the 
ERROR parameter.

For additional information on valid data types, refer to "See also".

ERROR parameter
The following table shows the meaning of the values of the ERROR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
80C3 Too many concurrent calls
8132 The data block does not exist or is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value of the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

You can find descriptions of the error codes triggered by the instructions "READ_DBL: Read 
from data block in load memory" and "WRIT_DBL: Write to data block in load memory" under 
"See also".

Example
The following example shows how the instruction works:

SCL
"ReadFromArrayDBL_DB"(REQ := "TagReg",
                      DB := "ArrayDB",
                      INDEX := "ArrayDB"."THIS"[2],
                      BUSY => "TagBusy",
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SCL
                      DONE => "TagDone",
                      ERROR => "TagError",
                      VALUE := "SourceTargetField[1]".Data1[6]);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
REQ TagReq BOOL
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB."THIS"[2] Third element of the "ArrayDB"
VALUE SourceTargetField[1].Data1[6] The data type of the 

"SourceTargetField" operand is 
Array [0 to 10] of "MOVE_UDT".

BUSY TagBusy BOOL
DONE TagDone BOOL

If a positive edge is detected at the "TagReq" operand, the "Read from array data block in load 
memory" instruction is executed. The third element is read from "ArrayDB" and written to the 
"SourceTargetField[1].Data1[6]" operand. As soon as a negative signal edge is detected at 
the "TagBusy" operand, the instruction is terminated and the value at the VALUE parameter 
is no longer changed. After the instruction has been processed, the "TagDone" operand the 
signal state "1".

See also
Overview of the valid data types (Page 1320)

READ_DBL: Read from data block in the load memory (Page 2914)

WRIT_DBL: Write to data block in the load memory (Page 2916)

WriteToArrayDBL: Write to array data block in load memory

Description
You can use the "Write to the array data block in load memory" instruction to write data to an 
array DB in load memory.

An array DB is a data block which consists of exactly one array of [data type]. The elements 
of the array can be UDT data type or any other elementary data type. The counting of the array 
always starts with the low limit "0", regardless of the later declaration of the array.

If the array DB is marked with the "Only store in load memory" block attribute, it is only stored 
in load memory.

The instruction is executed when a positive signal edge is detected at the REQ parameter. 
The BUSY parameter then has the signal state "1". If a negative signal edge is detected at the 
BUSY parameter, the instruction is terminated and the value at the VALUE parameter is written 
to the data block. The DONE parameter then has the signal state "1" for one program cycle.
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When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

 

 Note

The array DB must be located in a data block with the block property "Optimized".
 

Syntax
The following syntax is used for the "Write to ARRAY data block in load memory" instruction:

SCL
"Instance DB"(REQ := <Operand>,
            DB := <Operand>,
            INDEX := <Operand>,
            VALUE := <Operand>,
            BUSY => <Operand>,
            DONE => <Operand>,
            ERROR => <Operand>)

Parameter
The following table shows the parameters of the "Write to the array data block in load memory" 
instruction:

Parameter Declaration Data type Description
REQ Input BOOL REQ = "1": Start writing 

to the array DB
DB Input DB_ANY Data block to which 

data is written
INDEX Input DINT Element in the DB to 

which data is written
VALUE Input VARIANT Value to be written
BUSY Output BOOL BUSY = "1": The array 

DB is still being written
DONE Output BOOL DONE = "1": The 

instruction was 
executed successfully

ERROR Output INT Error information:
If an error occurs during 
the execution of the 
instruction, an error 
code is output on the 
ERROR parameter.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2507



For additional information on valid data types, refer to "See also".

ERROR parameter
The following table shows the meaning of the values of the ERROR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
80B4 Data types do not correspond
80B5 Copying process was interrupted
80C3 Too many concurrent calls
8132 The data block does not exist or is too short
8133 The data block is not located in the load memory
8134 The data block is write protected
8135 The DB is not an array data block.
8282 The value of the INDEX parameter is outside the 

limits of the array.
8350 The VARIANT data type contains no value
8352 Code generation error
8353 Code generation error
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

You can find descriptions of the error codes triggered by the instructions "READ_DBL: Read 
from data block in load memory" and "WRIT_DBL: Write to data block in load memory" under 
"See also".

Example
The following example shows how the instruction works:

SCL
"WriteToArrayDBL_DB"(REQ := "TagReg",
                     DB := "ArrayDB",
                     INDEX := "ArrayDB"."THIS"[2],
                     VALUE := "SourceTargetField[1]".Data1[6],
                     BUSY => "TagBusy",
                     DONE => "TagDone",
                     ERROR => "TagError");

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
REQ TagReq BOOL
DB ArrayDB The data type of the "ArrayDB" 

operand is Array [0 to 10] of INT.
INDEX ArrayDB."THIS"[2] Third element of the "ArrayDB"
VALUE SourceTargetField[1].Data1[6] The data type of the 

"SourceTargetField" operand is 
Array [0 to 10] of "MOVE_UDT".

BUSY TagBusy BOOL
DONE TagDone BOOL

If a positive edge is detected at the "TagReq" operand, the "Write to ARRAY data block in load 
memory" instruction is executed. As soon as a negative signal edge is detected at the 
"TagBusy" operand, the instruction is terminated and the value at the VALUE parameter is 
written in the third element in the "ArrayDB". After the instruction has been processed, the 
"TagDone" operand the signal state "1".

See also
Overview of the valid data types (Page 1320)

READ_DBL: Read from data block in the load memory (Page 2914)

WRIT_DBL: Write to data block in the load memory (Page 2916)

Read/write access

PEEK: Read memory address

Description
The "Read memory address" instruction is used to read a memory address from a memory 
area without specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

Syntax
The following syntax is used for the "Read memory address" instruction:

SCL
PEEK(AREA:= <Operand>,
     DBNUMBER := <Operand>,
     BYTEOFFSET:= <Operand>)
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SCL
PEEK_<Data type>(AREA := <Operand>,
                DBNUMBER := <Operand>,
                BYTEOFFSET:= <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#1: Peripheral 

input (S7-1500 only)
DBNUMBER Input DINT, DB_ANY Number of the data 

block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to read from
Only the 16 least 
significant bits are used.

_<Data type> Bit strings
default: BYTE

Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Bit strings Result of the instruction

For additional information on valid data types, refer to "See also".
 

 Note

If you read the memory address of the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := PEEK(AREA := "Tag_Area",
                      DBNUMBER := "Tag_DBNumber",
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SCL
                      BYTEOFFSET := "Tag_Byte");

 

SCL
"Tag_Result2" := PEEK_WORD(AREA := "Tag_Area",
                           DBNUMBER := "Tag_DBNumber",
                           BYTEOFFSET := "Tag_Byte");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
Function value Tag_Result1 Byte value "20"
Function value Tag_Result2 Word value "20"

The instruction reads the value of address "20" from the "Tag_Byte" operand at data block "5" 
and returns the result as a function value at the "Tag_Result" operand.

See also
Overview of the valid data types (Page 1320)

PEEK_BOOL: Read memory bit

Description
The "Read memory bit" instruction is used to read a memory bit from a memory area without 
specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
 

Syntax
The following syntax is used for the "Read memory bit" instruction:

SCL
PEEK_BOOL(AREA := <Operand>,
          DBNumber := <Operand>,
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SCL
          BYTEEOFFSET := <Operand>,
          BITOFFSET := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#1: Peripheral 

input (S7-1500 only)
DBNUMBER Input DINT, DB_ANY Number of the data 

block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to read from
Only the 16 least 
significant bits are used.

BITOFFSET Input INT Bit to be read from
Function value BOOL Result of the instruction

For additional information on valid data types, refer to "See also".
 

 Note

If you read the memory bit from the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := PEEK_BOOL(AREA := "Tag_Area",
                          DBNUMBER := "Tag_DBNumber",
                          BYTEOFFSET := "Tag_Byte",
                          BITOFFSET := "Tag_Bit");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
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Parameter Operand Value
BITOFFSET Tag_Bit 3
Function value Tag_Result 3

The instruction reads the value of memory bit "3" from the "Tag_Bit" operand at byte "20" of 
data block "5" and returns the result at the "Tag_Result" operand as function value.

See also
Overview of the valid data types (Page 1320)

POKE: Write memory address

Description
The "Write memory address" instruction is used to write a memory address to a memory area 
without specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
 

Syntax
The following syntax is used for the "Write memory address" instruction:

SCL
POKE(AREA := <Operand>,
     DBNUMBER := <Operand>,
     BYTEOFFSET := <Operand>,
     VALUE := <Operand>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#2: Peripheral 

output (S7-1500 
only)

DBNUMBER Input DINT, DB_ANY Number of the data 
block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to be written
Only the 16 least 
significant bits are used.

VALUE Input Bit strings Value to be written

For additional information on valid data types, refer to "See also".
 

 Note

If you write the memory address in the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
POKE(AREA := "Tag_Area",
     DBNUMBER := "Tag_DBNumber",
     BYTEOFFSET := "Tag_Byte"),
     VALUE := "Tag_Value";

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
VALUE Tag_Value 16#11

The instruction overwrites the memory address "20" in the data block "5" with value "16#11".

See also
Overview of the valid data types (Page 1320)
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POKE_BOOL: Write memory bit

Description
The "Write memory bit" instruction is used to write a memory bit to a memory area without 
specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
 

Syntax
The following syntax is used for the "Write memory bit" instruction:

SCL
POKE_BOOL(AREA := <Operand>,
          DBNUMBER := <Operand>,
          BYTEOFFSET := <Operand>,
          BITOFFSET := <Operand>,
          VALUE := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA Input BYTE The following areas can 

be selected:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB
● 16#2: Peripheral 

output (S7-1500 
only)

DBNUMBER Input DINT, DB_ANY Number of the data 
block if AREA = DB, 
otherwise "0"

BYTEOFFSET Input DINT Address to be written
Only the 16 least 
significant bits are used.

BITOFFSET Input INT Bit to be written
VALUE Input BOOL Value to be written
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For additional information on valid data types, refer to "See also".
 

 Note

If you write the memory bit in the input, output or bit memory areas, you need to set the 
"DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
POKE_BOOL(AREA := "Tag_Area",
          DBNUMBER := "Tag_DBNumber",
          BYTEOFFSET := "Tag_Byte",
          BITOFFSET := "Tag_Bit",
          VALUE := "Tag_Value");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA Tag_Area 16#84
DBNUMBER Tag_DBNumber 5
BYTEOFFSET Tag_Byte 20
BITOFFSET Tag_Bit 3
VALUE Tag_Value M0.0

The instruction overwrites the memory bit "3" in data block "5" in byte "20" with the value "M0.0".

See also
Overview of the valid data types (Page 1320)

POKE_BLK: Write memory area

Description
The "Write memory area" instruction copies the content a memory area to a different memory 
area without specifying a data type.

If you specify the 16#84 area at the AREA parameter for a data block, you can only access 
data blocks with the "Standard" block property.

 

 Note

The instruction can only be used to access "Standard" memory areas.
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Syntax
The following syntax is used for the "Write memory area" instruction:

SCL
POKE_BLK(AREA_SRC:= <Operand>,
         DBNUMBER_SRC:= <Operand>,
         BYTEOFFSET_SRC:= <Operand>,
         AREA_DEST:= <Operand>,
         DBNUMBER_DEST:= <Operand>,
         BYTEOFFSET_DEST:= <Operand>,
         COUNT:= <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
AREA_SRC Input BYTE The following areas can 

be selected in the 
source memory area:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB

DBNUMBER_SRC Input DINT, DB_ANY Number of the data 
block in the source 
memory area, if AREA 
= DB, otherwise "0"

BYTEOFFSET_SRC Input DINT Address in the source 
memory area to be 
written
Only the 16 least 
significant bits are used.

AREA_DEST Input BYTE The following areas can 
be selected in the 
destination memory 
area:
● 16#81: Input
● 16#82: Output
● 16#83: Bit memory
● 16#84: DB

DBNUMBER_DEST Input DINT, DB_ANY Number of the data 
block in the destination 
memory area, if AREA 
= DB, otherwise "0"

BYTEOFFSET_DEST Input DINT Address in the 
destination memory 
area to be written
Only the 16 least 
significant bits are used.

COUNT Input DINT Number of bytes which 
are copied
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For additional information on valid data types, refer to "See also".
 

 Note

If you write the memory address in the input, output or bit memory areas, you will need to set 
the "DBNUMBER" parameter with the value "0", as the instruction is faulty otherwise.

 

Example
The following example shows how the instruction works:

SCL
POKE_BLK(AREA_SRC := "Tag_Source_Area",
         DBNUMBER_SRC := "Tag_Source_DBNumber",
         BYTEOFFSET_SRC := "Tag_Source_Byte"),
         AREA_DEST := "Tag_Destination_Area",
         DBNUMBER_DEST := "Tag_Destination_DBNumber",
         BYTEOFFSET_DEST := "Tag_Destination_Byte",
         COUNT := "Tag_Count");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
AREA_SRC Tag_Source_Area 16#84
DBNUMBER_SRC Tag_Source_DBNumber 5
BYTEOFFSET_SRC Tag_Source_Byte 20
AREA_DEST Tag_Destination_Area 16#83
DBNUMBER_DEST Tag_Destination_DBNumber 0
BYTEOFFSET_DEST Tag_Destination_Byte 30
COUNT Tag_Count 100

The instruction writes 100 byte from data block "5" starting with address "20" in the memory 
area of the bit memory starting at address "30".

See also
Overview of the valid data types (Page 1320)

READ_LITTLE: Read data in little endian format

Description
You use the "Read data in little endian format" instruction to read the data to a single tag in 
the little endian byte sequence. With the little endian format, the byte with the least significant 
bits is saved first, which means at the lowest memory address. The memory area that is read 
from must have the data type ARRAY of BYTE.
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The operand at the DEST_VARIABLE parameter must have an elementary data type. The 
operand at the POS parameter determines the position at which the reading starts.

 

 Note
Reading tag of data type VARIANT or BOOL

If you want to read a tag to which a VARIANT points, use the "Serialize" or "Deserialize" 
instructions.

If you want to read a tag of the data type BOOL, use a "Slice access".
 

Syntax
Use the following syntax for the "Read data in little endian format" instruction:

SCL
READ_LITTLE(SRC_ARRAY := <Operand>,
            DEST_VARIABLE => <Operand>,
            POS := <Operand>)

Parameter
The following table shows the parameters of the "Read data in little endian format" instruction:

Parameter Declaration Data type Description
SRC_ARRAY Input ARRAY of BYTE Memory area from which is 

read
DEST_VARIABLE Output Bit strings, integers, floating-

point numbers, timers, LDT, 
TOD, LTOD, DATE, CHAR, 
WCHAR

Read value

POS InOut DINT Determines the position at 
which the reading starts. The 
POS parameter is calculated 
zero-based.

Function value INT Error information

Example
The following example shows how the instruction works:

SCL
#TagResult := READ_LITTLE(SRC_ARRAY := #SourceField,
                          DEST_VARIABLE => #DINTVariable,
                          POS := #TagPos);

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
SRC_ARRAY #SourceField ARRAY[0..3] of BYTE

:= 16#1A, 16#2B, 16#3C, 16#4D
DEST_VARIABLE #DINTVariable 1295788826

16#4D3C2B1A
POS #TagPos 0 => 4

The "Read data in little endian format" instruction reads the integer 1_295_788_826 from the 
memory area "#SourceField" and writes it to the "#DINTVariable" operand in little endian 
format. The data type at the DEST_VARIABLE parameter specifies how many bytes are read. 
The quantity 4 is saved at the "#TagPos" operand.

See also
Overview of the valid data types (Page 1320)

Deserialize: Deserialization (Page 2482)

Serialize: Serialization (Page 2485)

Addressing areas of a tag with slice access (Page 1308)

WRITE_LITTLE: Write data in little endian format

Description
You use the "Write data in little endian format" instruction to write the data of a single tag in 
the little endian byte sequence to a memory area. With the little endian format, the byte with 
the least significant bits is saved first, which means at the lowest memory address. The memory 
area written to must have the data type ARRAY of BYTE.

The operand at the SRC_VARIABLE parameter must have an elementary data type. The 
operand at the POS parameter determines the position at which the writing starts.

 

 Note
Writing tag of data type VARIANT or BOOL

If you want to write a tag to which a VARIANT points, use the "Serialize" or "Deserialize" 
instructions.

If you want to write a tag of the data type BOOL, use a "Slice access".
 

Syntax
Use the following syntax for the "Write data in little endian format" instruction:

SCL
WRITE_LITTLE(SRC_VARIABLE := <Operand>,
             DEST_ARRAY := <Operand>,
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SCL
             POS := <Operand>)

Parameter
The following table shows the parameters of the "Write data in little endian format" instruction:

Parameter Declaration Data type Description
SRC_VARIABLE Input Bit strings, integers, floating-

point numbers, timers, LDT, 
TOD, LTOD, DATE, CHAR, 
WCHAR

Tag whose data are written

DEST_ARRAY InOut ARRAY of BYTE Memory area to which the 
data are written

POS InOut DINT Determines the position at 
which the writing starts. The 
POS parameter is calculated 
zero-based.

Function value INT Error information

Example
The following example shows how the instruction works:

SCL
#TagResult := WRITE_LITTLE(SRC_VARIABLE := #DINTVariable,
                           DEST_ARRAY := #TargetField,
                           POS := #TagPos);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
SRC_VARIABLE #DINTVariable 1295788826

16#4D3C2B1A
DEST_ARRAY #TargetField ARRAY[0..10] of BYTE

= 16#1A, 16#2B, 16#3C, 16#4D
POS #TagPos 0 => 4

The "Write data in little endian format" instruction writes the integer 1_295_788_826 from the 
"#DINTVariable" operand to the "#TargetField" memory area in little endian format. The data 
type at the SRC_VARIABLE parameter specifies how many bytes are written. The quantity 4 
is saved at the "#TagPos" operand.

See also
Overview of the valid data types (Page 1320)

Deserialize: Deserialization (Page 2482)
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Serialize: Serialization (Page 2485)

Addressing areas of a tag with slice access (Page 1308)

READ_BIG: Read data in big endian format

Description
You use the "Read data in big endian format" instruction to read the data to a single tag in the 
big endian byte sequence. With the big endian format, the byte with the most significant bits 
is saved first, which means at the lowest memory address. The memory area that is read from 
must have the data type ARRAY of BYTE.

The operand at the DEST_VARIABLE parameter must have an elementary data type. The 
operand at the POS parameter determines the position at which the reading starts.

 

 Note
Reading tag of data type VARIANT or BOOL

If you want to read a tag to which a VARIANT points, use the "Serialize" or "Deserialize" 
instructions.

If you want to read a tag of the data type BOOL, use a "Slice access".
 

Syntax
Use the following syntax for the "Read data in big endian format" instruction:

SCL
READ_BIG(SRC_ARRAY := <Operand>,
         DEST_VARIABLE => <Operand>,
         POS := <Operand>)

Parameter
The following table shows the parameters of the "Read data in big endian format" instruction:

Parameter Declaration Data type Description
SRC_ARRAY Input ARRAY of BYTE Memory area from which is 

read
DEST_VARIABLE Output Bit strings, integers, floating-

point numbers, timers, LDT, 
TOD, LTOD, DATE, CHAR, 
WCHAR

Read value
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Parameter Declaration Data type Description
POS InOut DINT Determines the position at 

which the reading starts. The 
POS parameter is calculated 
zero-based.

Function value INT Error information

Example
The following example shows how the instruction works:

SCL
#TagResult := READ_BIG(SRC_ARRAY := #SourceField,
                       DEST_VARIABLE => #DINTVariable,
                       POS := #TagPos);

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
SRC_ARRAY #SourceField ARRAY[0..10] of BYTE

:= 16#1A, 16#2B, 16#3C, 16#4D
DEST_VARIABLE #DINTVariable 439041101

16#1A2B3C4D
POS #TagPos 0 => 4

The "Read data in big endian format" instruction reads the integer 439_041_101 from the 
memory area "#SourceField" and writes it to the "#DINTVariable" operand in big endian format. 
The data type at the DEST_VARIABLE parameter specifies how many bytes are read. The 
quantity 4 is saved at the "#TagPos" operand.

See also
Overview of the valid data types (Page 1320)

Deserialize: Deserialization (Page 2482)

Serialize: Serialization (Page 2485)

Addressing areas of a tag with slice access (Page 1308)

WRITE_BIG: Write data in big endian format

Description
You use the "Write data in big endian format" instruction to write the data of a single tag in the 
big endian byte sequence to a memory area. With the big endian format, the byte with the most 
significant bits is saved first, which means at the lowest memory address. The memory area 
written to must have the data type ARRAY of BYTE.
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The operand at the SRC_VARIABLE parameter must have an elementary data type. The 
operand at the POS parameter determines the position at which the writing starts.

 

 Note
Writing tag of data type VARIANT or BOOL

If you want to write a tag to which a VARIANT points, use the "Serialize" or "Deserialize" 
instructions.

If you want to write a tag of the data type BOOL, use a "Slice access".
 

Syntax
Use the following syntax for the "Write data in big endian format" instruction:

SCL
WRITE_BIG(SRC_VARIABLE := <Operand>,
          DEST_ARRAY := <Operand>,
          POS := <Operand>)

Parameter
The following table shows the parameters of the "Write data in big endian format" instruction:

Parameter Declaration Data type Description
SRC_VARIABLE Input Bit strings, integers, floating-

point numbers, timers, LDT, 
TOD, LTOD, DATE, CHAR, 
WCHAR

Tag whose data are written

DEST_ARRAY InOut ARRAY of BYTE Memory area to which the 
data are written

POS InOut DINT Determines the position at 
which the writing starts. The 
POS parameter is calculated 
zero-based.

Function value INT Error information

Example
The following example shows how the instruction works:

SCL
#TagResult := WRITE_BIG(SRC_VARIABLE := #DINTVariable,
                        DEST_ARRAY := #TargetField,
                        POS := #TagPos);

The following table shows how the instruction works using specific operand values:
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Parameter Operand Value
SRC_VARIABLE #DINTVariable 439041101

16#1A2B3C4D
DEST_ARRAY #TargetField ARRAY[0..10] of BYTE

= 16#1A, 16#2B, 16#3C, 16#4D
POS #TagPos 0 => 4

The "Write data in big endian format" instruction writes the integer 439_041_101 from the 
"#DINTVariable" operand to the "#TargetField" memory area in big endian format. The data 
type at the SRC_VARIABLE parameter specifies how many bytes are written. The quantity 4 
is saved at the "#TagPos" operand.

See also
Overview of the valid data types (Page 1320)

Deserialize: Deserialization (Page 2482)

Serialize: Serialization (Page 2485)

Addressing areas of a tag with slice access (Page 1308)

VARIANT instructions

VariantGet: Read out VARIANT tag value

Description
You can use the "Read out VARIANT tag value" instruction to read the value of the tag to which 
the VARIANT at the SRC parameter points and write it in the tag at the DST parameter.

The SRC parameter must have the VARIANT data type. Any data type except for VARIANT 
can be specified at the DST parameter.

The data type of the tag at the DST parameter must match the data type to which the VARIANT 
points.

 

 Note

The tag to which the VARIANT at parameter SRC points must be a PLC data type.

To copy structures and ARRAYs, you can use the "MOVE_BLK_VARIANT: Move block" 
instruction. For additional information, refer to "See also".
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Syntax
The following syntax is used for the "Read out VARIANT tag value" instruction:

SCL
VariantGet(SRC := <Operand>,
           DST => <Operand>)

Parameter
The following table shows the parameters of the "Read out VARIANT tag value" instruction:

Parameter Declaration Data type Description
SRC Input VARIANT Tag to be read
DST Output Bit strings, integers, floating-

point numbers, timers, date 
and time, character strings, 
ARRAY, structures

Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
VariantGet(SRC := #TagIn_Source,
           DST => "TagOut_Dest");

The value of the tag to which the VARIANT at the "#TagIn_Source" operand points is read and 
written to the "TagOut_Dest" operand.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

MOVE_BLK_VARIANT: Move block (Page 2490)

VariantPut: Write VARIANT tag value

Description
You can use the "Write VARIANT tag value" instruction to write the value of the tag at the SRC 
parameter to the tag at the DST parameter to which the VARIANT points.
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The DST parameter must have the VARIANT data type. Any data type except for VARIANT 
can be specified at the SRC parameter.

The data type of the tag at the SRC parameter must match the data type to which the VARIANT 
points.

 

 Note

The tag to which the VARIANT at parameter DST points must be a PLC data type.
 

Syntax
The following syntax is used for the "Write VARIANT tag value" instruction:

SCL
VariantPut(SRC := <Operand>,
           DST := <Operand>)

Parameter
The following table shows the parameters of the "Write VARIANT tag value" instruction:

Parameter Declaration Data type Description
SRC Input Bit strings, integers, floating-

point numbers, timers, date 
and time, character strings, 
ARRAY

Tag to be read

DST Input VARIANT Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
VariantPut(SRC := "TagIn_Source",
           DST => "#TagIn_Dest");

The value of the "TagIn_Source" operand is written to the tag to which the VARIANT at the 
"#TagIn_Dest" operand points.

See also
Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2527



CountOfElements: Get number of ARRAY elements

Description
You can use the "Get number of ARRAY elements" instruction to query how many ARRAY 
elements a tag to which VARIANT is pointing has.

If it is a one-dimensional ARRAY, the difference between the high and low limit +1 is output 
as a result. If it is a multi-dimensional ARRAY, the product of all dimensions is output as the 
result.

The <Operand> must have the VARIANT data type.

The result is "0" if the VARIANT tag is not an ARRAY.

If the VARIANT points to an ARRAY of BOOL, the fill elements are included in the count. (For 
example, 8 is returned for an ARRAY[0..1] of BOOL)

Syntax
The following syntax is used for the "Get number of ARRAY elements" instruction:

SCL
CountOfElements(<Operand>)

Parameter
The following table shows the parameters of the "Get number of ARRAY elements" instruction:

Parameter Declaration Data type Description
<Operand> Input VARIANT Tag to be queried
Function value UDINT Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF IS_ARRAY(#Tag_VARIANTToArray) THEN
"Tag_Result" := CountOfElements(#Tag_VARIANT);
END_IF;

If the tag to which the VARIANT points is an ARRAY, the number of ARRAY elements is output.
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See also
Format of array (16-bit limits) (Page 1351)

Format of array (32-bit limits) (Page 1352)

Overview of the valid data types (Page 1320)

Basics of the EN/ENO mechanism (Page 1415)

VARIANT (Page 1361)

Other

BLKMOV: Move block

Description
The instruction "Move block" copies the contents of a memory area (source area) to another 
memory area (destination area). The move operation takes place in the direction of ascending 
addresses. You use VARIANT to define the source and destination areas.

 

 Note

The tags of the instruction can only be used in data blocks in which the attribute "Optimized 
block access" is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

The following figure shows the principle of the move operation:
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Consistency of source data and destination data
Note that while the instruction "Move block" is being executed, the source data remains 
unchanged; otherwise the consistency of the destination data cannot be guaranteed.

Interruptibility
There is no limit to the nesting depth.

Memory areas
The instruction "Move block" moves the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination areas must not overlap. If the source and destination area have 
different lengths, only the length of the smaller area will be moved.

If the source area is smaller than the destination area, the entire source area will be written to 
the destination area. The remaining bytes of the destination area remain unchanged. 

If the destination area is smaller than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

Rules for moving character strings
You can use the "Move block" instruction to move source and destination areas of the STRING 
data type. If only the source area is of data type STRING, the characters will be moved that 
are actually contained in the character string. Information on the actual and maximum length 
is also written to the destination area. If the source and destination area are both STRING data 
type, the current length of the character string in the destination area is set to the number of 
characters actually moved.

If you want to move the information on the maximum and actual length of a character string, 
specify the areas in bytes in the SRCBLK and DSTBLK parameters. 

Syntax
The following syntax is used for the "Move block" instruction:

SCL
BLKMOV(SRCBLK:= <Operand>,
       DSTBLK => <Operand>)
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Parameter
The following table shows the parameters of the "Move block" instruction:

Parameter Declaration Data type Description
SRCBLK Input VARIANT Specifies the memory 

area to be moved 
(source area).

DSTBLK Output VARIANT Specifies the memory 
area to which the block 
is to be moved 
(destination area).

Function value (RET_VAL) INT Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8152 The data types WSTRING, WCHAR and BOOL are not supported.
8092 The source or target area is only available in the load memory.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

GET_ERR_ID: Get error ID locally (Page 2578)

UBLKMOV: Move block uninterruptible

Description
The instruction "Move block uninterruptible" copies the contents of a memory area (source 
area) to another memory area (destination area). The move operation takes place in the 
direction of ascending addresses. You use VARIANT to define the source and destination 
areas.
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The move operation cannot be interrupted by other operating system activities. As a result the 
interrupt reaction time of the CPU can increase during the execution of the instruction "Move 
block uninterruptible".

 

 Note

The tags of the instruction can only be used in data blocks in which the attribute "Optimized 
block access" is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

 

Memory areas
The instruction "Move block uninterruptible" copies the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

General rules for moving
The source and destination area must not overlap during the execution of the instruction "Move 
block uninterruptible". If the source area is smaller than the destination area, the entire source 
area will be written to the destination area. The remaining bytes of the destination area remain 
unchanged.

If the destination area is smaller than the source area, the entire destination area will be written. 
The remaining bytes of the source area are ignored.

If a source or destination area defined as a formal parameter is less than a destination or 
source area specified at the SRCBLK or DSTBLK parameter, no data is transferred.

If a block of data type BOOL is moved, the tag must be addressed absolutely and the specified 
length of the area must be divisible by 8, otherwise the instruction cannot be executed.

You can use the "Move block uninterruptible" instruction to move a maximum of 16 KB. Note 
the CPU-specific restrictions for this.

Rules for moving character strings
The instruction "Move block uninterruptible" copies source and destination areas of the data 
type STRING. If only the source area is of data type STRING, the characters will be moved 
that are actually contained in the character string. Information on the actual and maximum 
length are not written in the destination area. If the source and destination area are both 
STRING data type, the current length of the character string in the destination area is set to 
the number of characters actually moved. If areas of the STRING data type are moved, specify 
"1" as the area length.
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Syntax
The following syntax is used for the "Move block uninterruptible" instruction:

SCL
UBLKMOV(SRCBLK:= <Operand>,
        DSTBLK => <Operand>)

Parameter
The following table shows the parameters of the "Move block uninterruptible" instruction:

Parameter Declaration Data type Description
SRCBLK Input VARIANT Specifies the memory 

area to be moved 
(source area).

DSTBLK Output ANY Specifies the memory 
area to which the block 
is to be moved 
(destination area).

Function value (RET_VAL) VARIANT Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code
(W#16#...)

Explanation

0000 No error
8152 The data types WSTRING, WCHAR and BOOL are not supported.
8091 The source area is in a data block that is not relevant for program execution.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

GET_ERR_ID: Get error ID locally (Page 2578)
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FILL: Fill block

Description
The instruction "Fill block" fills a memory area (destination area) with the content of another 
memory area (source area). The instruction "Fill block" moves the content of the source area 
to the destination area until the destination area is completely written. The move operation 
takes place in the direction of ascending addresses.

You use VARIANT to define the source and destination areas.
 

 Note

The tags of the instruction can only be used in data blocks in which the attribute "Optimized 
block access" is not set. If the tag with the retentive setting "Set in IDB" has been declared, 
you can also use the tags "with optimized access".

For blocks with the "Optimized block access" attribute, you can use the "FILL_BLK: Fill block" 
instruction.

 

The following figure shows the principle of the move operation:

Example: The contents of the range MW100 to MW118 are to be preassigned with the contents 
of the memory words MW14 to MW20.

Consistency of source data and destination data
Note that while the instruction "Fill block" is being executed, the source data remains 
unchanged; otherwise the consistency of the destination data cannot be guaranteed.
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Memory areas
The instruction "Fill block" copies the following memory areas:

● Areas of a data block

● Bit memory

● Process image of the inputs

● Process image of the outputs

The instruction "Fill block" copies the following memory areas:

● Instructions, system data blocks

● Counters

● Timers

● Memory areas of the I/O area

General rules for moving
The source and destination areas must not overlap. If the destination area to be preset is not 
an integer multiple of the length of the input parameter BVAL, the destination area is 
nevertheless written up to the last byte.

If the destination area to be preset is smaller than the source area, the function only copies as 
much data as can be written to the destination area.

If the destination or source block actually present is smaller than the assigned memory area 
for the source or destination area (BVAL, BLK parameters), no data will be transferred.

If the ANY pointer (source or destination) is of the data type BOOL, it must be addressed 
absolutely and the length specified must be divisible by 8; otherwise the instruction is not 
executed.

If the destination area is STRING data type, the instruction writes the entire string including 
the administration information.

Syntax
The following syntax is used for the instruction "Fill block":

SCL
FILL(BVAL:= <Operand>,
     BLK => <Operand>)
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Parameter
The following table shows the parameters of the "Fill block" instruction:

Parameter Declaration Data type Description
BVAL Input VARIANT Specification of the 

memory area (source 
area) with whose 
content the destination 
area on the BLK 
parameter will be filled.

BLK Output VARIANT Specification of the 
memory area that will 
be filled with the content 
of the source area.

Function value (RET_VAL) INT Error information

For additional information on valid data types, refer to "See also".

BVAL Parameter
When you transfer a structure as an input parameter, remember that the length of a structure 
is always based on an even number of bytes. The structure will need one byte of additional 
memory space if you declare a structure with an odd number of bytes.

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code
(W#16#...)

Explanation

0000 No error
8152 The data types WSTRING, WCHAR and BOOL are not supported.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

GET_ERR_ID: Get error ID locally (Page 2578)
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Conversion operations

CONVERT: Convert value

Description
Use the "Convert value" instruction to program explicit conversions. You determine the data 
types to be converted in a dialogue box with opens automatically when you insert the 
instruction. When executed, the instruction reads the source value and converts it into the 
specified target value.

For information on possible conversions, refer to section "Explicit conversion" under "See also".
 

 Note

For S7-1500 CPU: You can select the data types DWORD and LWORD if REAL or LREAL 
were selected as IN data type.

 

Syntax
The following syntax is used for the "Convert value" instruction:

SCL
<Target_value> := <Conversion_function>(<Source_value>);

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
S7-1200 S7-1500

<Source_value> Input, constant Bit strings, 
integers, floating-
point numbers, 
TIME, DATE, 
TOD, DTL, strings

Bit strings, 
integers, floating-
point numbers, 
TIME, LTIME, 
DATE, TOD, 
LTOD, DTL, 
strings

Value to be 
converted.

<Conversion_function
>

- - - Function that 
specifies the data 
type to be 
converted .

<Target_value> Output Bit strings, 
integers, floating-
point numbers, 
TIME, DATE, 
TOD, DTL, strings

Bit strings, 
integers, floating-
point numbers, 
TIME, LTIME, 
DATE, TOD, 
LTOD, DTL, 
strings

Result of the 
conversion

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_INT" := REAL_TO_INT("Tag_REAL");

The following table shows how the instruction works using specific operand values:

Operand Data type Value
Tag_REAL REAL 20.56
Tag_INT INT 21

During the conversion, the value of the "Tag_REAL" operand will be rounded to the nearest 
integer and saved in the "Tag_INT" operand.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

ROUND: Round numerical value

Description     
The "Round numerical value" instruction is used to round the value at input IN to the nearest 
integer. The instruction interprets the value at input IN as a floating-point number and converts 
it into an integer or floating-point number. If the input value is exactly between an even and 
odd number, the even number is selected.

Syntax
The following syntax is used for the "Round numerical value" instruction:

SCL
ROUND(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value to be 

rounded.
Function value Integers, floating-point 

numbers
Result of the rounding

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ROUND("Tag_Value");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 1.50000000 -1.50000000
Tag_Result 2 -2

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

CEIL: Generate next higher integer from floating-point number

Description     
Use the "Generate next higher integer from floating-point number" instruction to round the 
value to the nearest integer. The instruction interprets the input value as floating-point number 
and converts it to the next higher integer. The function value can be greater than or equal to 
the input value.

Syntax
The following syntax is used for the "Generate next higher integer from floating-point number" 
instruction:

SCL
CEIL(<Expression>)
CEIL_<Data type>(<Expression>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type Description
<Expression> Input Floating-point 

numbers
Input value

_<Data type> Integers, floating-
point numbers. 
Default: DINT

Data type of the function value:
● You do not need to specify the data 

type if using the default.
● Any other valid data type you may use 

must be declared explicitly.
Function value Integers, floating-

point numbers
Input value rounded up

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := CEIL("Tag_Value");
"Tag_Result2" := CEIL_REAL("Tag_Value);

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0.5 -0.5
Tag_Result1 1 0
Tag_Result2 1.0 0.0

The result of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

FLOOR: Generate next lower integer from floating-point number

Description     
Use the "Generate next lower integer from floating-point number" instruction to round the value 
of a floating point number to the next lower integer. The instruction interprets the input value 
as floating-point number and converts it to the next lower integer. The function value can be 
equal or less than the input value.

Programming the PLC
9.7 References

WinCC Professional V13.0
2540 System Manual, 02/2014



Syntax
Use the following syntax for the "Generate next lower integer from floating-point number" 
instruction:

SCL
FLOOR(<Expression>)
FLOOR_<data type>(<expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point 

numbers
Input value

_<Data type> Integers, floating-
point numbers. 
Default: DINT

Data type of the function value:
● You do not need to specify the data 

type if using the default.
● Any other valid data type you may 

use must be declared explicitly.
Function value Integers, floating-

point numbers
Input value rounded

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := FLOOR("Tag_Value");
"Tag_Result2" := FLOOR_REAL("Tag_Value");

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0.5 -0.5
Tag_Result1 0 -1
Tag_Result2 0.0 -1.0

The result of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)
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TRUNC: Truncate numerical value

Description
The "Truncate numerical value" instruction is used to generate an integer from the input value 
without rounding. The instruction selects only the integer part of the input value and returns 
this part without decimal places as the function value.

Syntax
The following syntax is used for the "Truncate numerical value" instruction:

SCL
TRUNC(<Expression>)
TRUNC_<Data type>(<Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Expression> Input Floating-point numbers Input value
_<Data type> Integers, floating-point 

numbers
Default: DINT

Data type of the function value:
● You do not need to specify the 

data type if using the default.
● Any other valid data type you 

may use must be declared 
explicitly.

Function value Integers, floating-point 
numbers

Integer component of the input 
value

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := TRUNC("Tag_Value1");
"Tag_Result2" := TRUNC("Tag_Value2"+"Tag_Value3");
"Tag_Result3" := TRUNC_SINT("Tag_Value4");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value1 -1.5
Tag_Result1 -1
Tag_Value2 2.1
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Operand Value
Tag_Value3 3.2
Tag_Result2 5
Tag_Result3 2
Tag_Value4 2.4

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

SCALE_X: Scale

Description
Use the "Scale" instruction to scale a floating-point number by mapping it to a specific value 
range. You specify the value range with the MIN and MAX parameters. The result of the scaling 
is an integer.

The following figure shows an example of how values can be scaled:

The instruction "Scale" works with the following equation:

OUT = [VALUE ∗ (MAX – MIN)] + MIN
 

 Note

For more information on the conversion of analog values, refer to the respective manual.
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Syntax
The following syntax is used for the "Scale" instruction:

SCL
SCALE_X(MIN := <Operand>,
        VALUE := <Operand>,
        MAX := <Operand>)
SCALE_X_<Data type>(MIN := <Operand>,
                   VALUE := <Operand>,
                   MAX := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
MIN Input Integers, floating-point numbers Low limit of the value 

range
VALUE Input Floating-point numbers Value to be scaled.

If you enter a constant, 
you must declare it.

MAX Input Integers, floating-point numbers High limit of the value 
range

_<Data type> Integers, floating-point numbers
Default: INT

Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Integers, floating-point numbers Result of scaling

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := SCALE_X(MIN := "Tag_Value1",
                         VALUE := "Tag_Real",
                         MAX := "Tag_Value2");
"Tag_Result2" := SCALE_X_REAL(MIN := "Tag_Value1",
                              VALUE := "Tag_Real",
                              MAX := "Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.
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The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Real 0.5
Tag_Value1 10
Tag_Value2 30
Tag_Result1 20
Tag_Result2 20.0

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

Declaring global constants (Page 1436)

NORM_X: Normalize

Description
You can use the instruction "Normalize" to normalize the value of the tag at the VALUE input 
by mapping it to a linear scale. You can use the MIN and MAX parameters to define the limits 
of a value range that is applied to the scale. Depending on the location of the normalized value 
in this value range, the result at output OUT is calculated and stored as a floating-point number. 
If the value to be normalized equals the value at input MIN, the instruction returns returns the 
result "0.0". If the value to be normalized equals the value at input MAX, the instruction returns 
returns the result "1.0".

The following figure shows an example of how values can be normalized:
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The "Normalize" instruction works with the following equation:

OUT = (VALUE – MIN) / (MAX – MIN)
 

 Note

For more information on the conversion of analog values, refer to the respective manual.
 

Syntax
The following syntax is used for the "Normalize" instruction:

SCL
NORM_X(MIN := <Operand>,
       VALUE := <Operand>,
       MAX := <Operand>)
NORM_X_<Data type>(MIN := <Operand>,
                  VALUE := <Operand>,
                  MAX := <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
MIN 1) Input Integers, floating-point 

numbers
Low limit of the value 
range

VALUE 1) Input Integers, floating-point 
numbers

Value to be normalized.

MAX 1) Input Integers, floating-point 
numbers

High limit of the value 
range

_<Data type> Floating-point numbers
Default: REAL

Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Floating-point numbers Result of the 
normalization

1) If you use constants in these three parameters, you only need to declare one of them.

For additional information on valid data types, refer to "See also".

For additional information on declaring constants, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result1" := NORM_X(MIN := "Tag_Value1",
                       VALUE := "Tag_InputValue",
                       MAX := "Tag_Value2");
"Tag_Result2" := NORM_X_LREAL(MIN := "Tag_Value1",
                             VALUE := "Tag_InputValue",
                             MAX := "Tag_Value2");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_InputValue 20
Tag_Value1 10
Tag_Value2 30
Tag_Result1 0.5
Tag_Result2 0.5

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

Declaring global constants (Page 1436)

VARIANT instructions

VARIANT_TO_DB_ANY: Convert VARIANT to DB_ANY

Description
The instruction "Convert VARIANT to DB_ANY" is used to read the number of the data block 
from a VARIANT and convert it to the data type DB_ANY.
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Requirements
If the conditions are met, the instruction is executed. If the conditions are not met, "0" is output 
as data block number.

The output tag... homed... Conversion options
VARIANT ...a data block which is an instance data 

block of an UDT or SDT
The output tag can be converted to a 
data block number.

VARIANT ...an Array DB The output tag can be converted to a 
data block number.

VARIANT ...an object with an elementary data type It is not possible to convert the output 
tag to a database number because a 
data block can never comprise only one 
elementary data type.

VARIANT ...a structure within a data block It is not possible to convert the output 
tags to a database number because it is 
only a part within the data block.

Syntax
The following syntax is used for the "Convert VARIANT To DB_ANY" instruction:

SCL
VARIANT_TO_DB_ANY(IN := <Operand>,
                  ERR => <Operand>)

Parameter
The following table shows the parameters of the "Convert VARIANT to DB_ANY" instruction:

Parameter Declaration Data type Description
IN Input VARIANT Tag to be read
ERR Output INT Error information
Function value DB_ANY Result: Number of the 

DB

For additional information on valid data types, refer to "See also".

ERR parameter
The following table shows the meaning of the values of the ERR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
252C The VARIANT data type has the value "0"
8130 The number of the data block is "0"
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Error code*
(W#16#...)

Explanation

8131 The data block does not exist
8132 The data block is too short
8134 The data block is write protected
8150 The VARIANT data type has the value "0"
8154 The data type is not correctly declared
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := VARIANT_TO_DB_ANY(IN := "Tag_In",
                                  ERR := "Tag_Err");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_In The data type of the Tag_In 

operand is VARIANT. The value 
is read.

<Function value> Tag_Result Number of the block is output.

The third element is read from "Tag_In" operand and written to the "Tag_Result" operand.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

DB_ANY_TO_VARIANT: Convert DB_ANY to VARIANT

Description
The instruction "Convert DB_ANY to VARIANT" is used to read the number of the data block 
from a DB_ANY and convert it to the data type VARIANT.
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Requirements
If the conditions are met, the instruction is executed. If the conditions are not met or the data 
block does not exist, the value "0" is output. All additional accesses to this value "0" fail.

The output tag... homed... Conversion options
DB_ANY ...a data block which is an instance data 

block of an UDT or SDT
It is possible to convert the output tag to 
the VARIANT data type.

DB_ANY ...a DB which is an ARRAY DB It is possible to convert the output tag to 
the VARIANT data type.

DB_ANY ...a data block which is an instance data 
block of a function block or a global data 
block

It is not  possible to convert the output 
tags to the VARIANT data type.

Syntax
The following syntax is used for the "Convert DB_ANY to VARIANT" instruction:

SCL
DB_ANY_TO_VARIANT(IN := <Operand>,
                  ERR => <Operand>)

Parameter
The following table shows the parameters of the "Convert DB_ANY to VARIANT" instruction:

Parameter Declaration Data type Description
IN Input DB_ANY Tag to be read
ERR Output INT Error information
Function value VARIANT Result

For additional information on valid data types, refer to "See also".

ERR parameter
The following table shows the meaning of the values of the ERR parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8130 The number of the data block is "0"
8131 The data block does not exist
8132 The data block is too short
8134 The data block is write protected
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Error code*
(W#16#...)

Explanation

8154 The data type is not correctly declared
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := DB_ANY_TO_VARIANT(IN := "Tag_In",
                                  ERR := "Tag_Err");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_In The data type of the Tag_In 

operand is DB_ANY. The value 
is read.

<Function value> Tag_Result Number of the block is converted 
and output to the VARIANT data 
type.

The third element is read from "Tag_In" operand and written to the "Tag_Result" operand.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

Other

SCALE: Scale

Description
The instruction "Scale" converts the integer on the parameter IN into a floating-point number, 
which can be scaled in physical units between a low and a high limit. You can use the LO_LIM 
and HI_LIM parameters to specify the low limit and high limit of the value range to which the 
input value is scaled. The result of the instruction is output on the OUT parameter.

The instruction "Scale" works with the following equation:

OUT = [((FLOAT (IN) – K1)/(K2–K1)) ∗ (HI_LIM–LO_LIM)] + LO_LIM

The values of the "K1" and "K2" constants are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 
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● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the "K2" constant, the result 
of the instruction is set to the value of the high limit (HI_LIM) and an error is output.

When the value at the IN parameter is less than the value of the "K1" constant, the result of 
the instruction is set to the value of the low limit value (LO_LIM) and an error is output.

When the indicated low limit is greater than the high limit (LO_LIM >HI_LIM), the result is scaled 
in reverse proportion to the input value.

Syntax
The following syntax is used for the "Scale" instruction:

SCL
SCALE(IN:= <Expression>,
      HI_LIM := <Operand>,
      LO_LIM := <Operand>,
      BIPOLAR := <Operand>,
      OUT => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input INT Input value to be scaled.
HI_LIM Input REAL High limit
LO_LIM Input REAL Low limit
BIPOLAR Input BOOL Indicates if the value at 

the IN parameter is to 
be interpreted as 
bipolar or unipolar. The 
parameter can assume 
the following values:
1: Bipolar
0: Unipolar

OUT Output REAL Result of the instruction
Function value (RET_VAL) WORD Error information

For additional information on valid data types, refer to "See also".
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RET_VAL Parameter
The following table shows the meaning of the values of the parameter RET_VAL:

Error code
(W#16#...)

Explanation

0000 No error
0008 The value of the parameter IN is greater than 27 648 or is less than 0 (unipolar) or -27 

648 (bipolar).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

 
"Tag_ErrorCode" := SCALE(IN := "Tag_InputValue",
                         HI_LIM := "Tag_HighLimit"
                         LO_LIM := "Tag_LowLimit"
                         BIPOLAR := "Tag_Bipolar",
                         OUT => "Tag_Result");

The error information is returned in the operand "Tag_ErrorCode" as a function value.

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 22
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
OUT Tag_Result 50.03978588
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

GET_ERR_ID: Get error ID locally (Page 2578)

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2553



UNSCALE: Unscale

Description
The instruction "Unscale" unscales the floating-point number on the IN parameter in physical 
units between a low and a high limit and converts them into an integer. You can use the LO_LIM 
and HI_LIM parameters to specify the low limit and high limit of the value range to which the 
input value is unscaled. The result of the instruction is output on the OUT parameter.

The instruction "Unscale" works with the following equation:

OUT = [((IN–LO_LIM)/(HI_LIM–LO_LIM)) ∗ (K2–K1)] + K1

The values of the "K1" and "K2" constants are determined by the signal state on the BIPOLAR 
parameter. The following signal states are possible on the BIPOLAR parameter: 

● Signal state "1": It is assumed that the value at the IN parameter is bipolar and in a value 
range between -27648 and 27648. In this case the "K1" constant has the value "-27648.0" 
and the "K2" constant the value "+27648.0".

● Signal state "0": It is assumed that the value at the IN parameter is unipolar and in a value 
range between 0 and 27648. In this case the "K1" constant has the value "0.0" and the "K2" 
constant the value "+27648.0".

When the value at the IN parameter is greater than the value of the "HI_LIM" constant, the 
result of the instruction is set to the value of the constant (K2) and an error is output. 

When the value at the IN parameter is less than the value of the constant of the low limit 
(LO_LIM), the result of the instruction is set to the value of the constant (K1) and an error is 
output.

Syntax
The following syntax is used for the instruction "Unscale":

SCL
UNSCALE(IN := <Expression>,
        HI_LIM := <Operand>,
        LO_LIM := <Operand>,
        BIPOLAR := <Operand>,
        OUT => <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input REAL Input value to be 

unscaled to an integer 
value.

HI_LIM Input REAL High limit
LO_LIM Input REAL Low limit
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Parameter Declaration Data type Description
BIPOLAR Input BOOL Indicates if the value at 

the IN parameter is to 
be interpreted as 
bipolar or unipolar. The 
parameter can assume 
the following values:
1: Bipolar
0: Unipolar

OUT Output INT Result of the instruction
Function value (RET_VAL) WORD Error information

For additional information on valid data types, refer to "See also".

RET_VAL Parameter
The following table shows the meaning of the values of the parameter RET_VAL:

Error code
(W#16#...)

Explanation

0000 No error
0008 The value of the IN parameter is greater than the value of the high limit (HI_LIM) or less than the value 

of the low limit (LO_LIM).
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_ErrorCode" := UNSCALE(IN := "Tag_InputValue",
                           HI_LIM := "Tag_HighLimit"
                           LO_LIM := "Tag_LowLimit"
                           BIPOLAR := "Tag_Bipolar",
                           OUT => "Tag_Result");

The error information is returned in the operand "Tag_ErrorCode" as a function value.

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_InputValue 50.03978588
HI_LIM Tag_HighLimit 100.0
LO_LIM Tag_LowLimit 0.0
BIPOLAR Tag_Bipolar 1
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Parameter Operand Value
OUT Tag_Result 22
RET_VAL Tag_ErrorCode W#16#0000

See also
Overview of the valid data types (Page 1320)

Expressions (Page 1596)

Operators and operator precedence (Page 1602)

GET_ERR_ID: Get error ID locally (Page 2578)

Program control operations

IF: Run conditionally

Description
The instruction "Run conditionally" branches the program flow depending on a condition. The 
condition is an expression with Boolean value (TRUE or FALSE). Logical expression or 
comparative expressions can be stated as conditions.

When the instruction is executed, the stated expressions are evaluated. If the value of an 
expression is TRUE, the condition is fulfilled; if the value is FALSE, it is not fulfilled.

Syntax
Depending on the type of branch, you can program the following forms of the instruction:

● Branch through IF:

SCL
IF <Condition> THEN <Instructions>
END_IF;

If the condition is satisfied, the instructions programmed after the THEN are executed. If the 
condition is not satisfied, the execution of the program continues with the next instruction after 
the END_IF.

● Branch through IF and ELSE:

SCL
IF <Condition> THEN <Instructions1>
ELSE <Instructions0>;
END_IF;

If the condition is satisfied, the instructions programmed after the THEN are executed. If the 
condition is not satisfied, the instructions programmed after the ELSE are executed. Then the 
execution of the program continues with the next instruction after the END_IF.
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● Branch through IF, ELSIF and ELSE:

SCL
IF <Condition1> THEN <Instructions1>
ELSIF <Condition2> THEN <Instruction2>
ELSE <Instructions0>;
END_IF;

If the first condition (<Condition1>) is satisfied, the instructions (<Instructions1>) after the 
THEN are executed. After execution of the instructions, the execution of the program continues 
after the END_IF.

If the first condition is not satisfied, the second condition (<Condition2>) is checked. If the 
second condition (<Condition2>) is fulfilled, the instructions (<Instructions2>) after the THEN 
are executed. After execution of the instructions, the execution of the program continues after 
the END_IF.

If none of the conditions are fulfilled, the instructions (<Instructions0>) after ELSE are executed 
followed by the execution of the program after END_IF.

You can nest as many combinations of ELSIF and THEN as you like within the IF instruction. 
The programming of an ELSE branch is optional.

The syntax of the IF instruction consists of the following parts:

Parameter Data type Description
<Condition> BOOL Expression to be evaluated
<Instructions> - Instructions to be executed with satisfied condition. An 

exception are instructions programmed after the ELSE. These 
are executed if no condition within the program loop is satisfied.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
IF "Tag_1" = 1
THEN "Tag_Value" := 10;
ELSIF "Tag_2" = 1
THEN "Tag_Value" := 20;
ELSIF "Tag_3" = 1
THEN "Tag_Value" := 30;
ELSE "Tag_Value" := 0;
END_IF;

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_1 1 0 0 0
Tag_2 0 1 0 0
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Operand Value
Tag_3 0 0 1 0
Tag_Value 10 20 30 0

See also
Operators and operator precedence (Page 1602)

Overview of the valid data types (Page 1320)

CASE: Create multiway branch

Description
The instruction "Create multiway branch" executes one of several instruction sequences 
depending on the value of a numerical expression.

The value of the expression must be an integer. When the instruction is executed, the value 
of the expression is compared with the values of several constants. If the value of the 
expression agrees with the value of a constant, the instructions programmed directly after this 
constant are executed. The constants can assume the following values:

● An integer (for example, 5)

● A range of integers (for example, 15..20)

● An enumeration consisting of integers and ranges (for example, 10, 11, 15..20)

Syntax
The following syntax is used for the "Create multiway branch" instruction:

SCL
CASE <expression> OF
<Constant1>: <Instructions1>
<Constant2>: <Instructions2>
<ConstantX>: <InstructionsX>; // X >=3
ELSE <Instructions0>;
END_CASE;

The syntax of the instruction consists of the following parts:
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Parameter Data type Description
<expression> Integers Value which is compared to the programmed constant values.
<Constant> Integers Constant values which form the condition for the execution of 

an instruction sequence. The constants can assume the 
following values:
● An integer (for example, 5)
● A range of integers (for example, 15..20)
● An enumeration consisting of integers and ranges (for 

example, 10, 11, 15..20)
<Instruction> - Any instructions which are executed if the value of the 

expression agrees with the value of a constant. An exception 
are instructions programmed after the ELSE. These 
instructions are executed if the values do not agree.

For additional information on valid data types, refer to "See also".

If the value of the expression agrees with the value of the first constant (<Constant1>), the 
instructions (<Instructions1>) which are programmed directly after the first constant are 
executed. Program execution subsequently resumes after the END_CASE.

If the value of the expression does not agree with the value of the first constant (<Constant1>), 
this value is compared to the value of the constant which is programmed next. In this way, the 
CASE instruction is executed until the values agree. If the value of the expression does not 
correspond to any of the programmed constant values, the instructions (<Instructions0>) which 
are programmed after the ELSE are executed. ELSE is an optional part of the syntax and can 
be omitted.

The CASE instruction can also be nested by replacing an instruction block with CASE. 
END_CASE represents the end of the CASE instruction.

Example
The following example shows how the instruction works:

SCL
CASE "Tag_Value" OF
     0 :
     "Tag_1" := 1;
     1,3,5 :
     "Tag_2" :=1;
     6..10 :
     "Tag_3" := 1;
     16,17,20..25 :
     "Tag_4" := 1;
ELSE "Tag_5" := 1;
END_CASE;

The following table shows how the instruction works using specific operand values:
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Operand Values
Tag_Value 0 1, 3 , 5 6, 7, 8, 9, 10 16,17, 20, 21, 

22, 23, 24, 25
2

Tag_1 1 - - - -
Tag_2 - 1 - - -
Tag_3 - - 1 - -
Tag_4 - - - 1 -
Tag_5 - - - - 1
1: The operand is set to the signal state "1".
-: The signal state of the operand remains unaltered.

See also
CONTINUE: Recheck loop condition (Page 2565)

Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

EXIT: Exit loop immediately (Page 2566)

FOR: Run in counting loop

Description
The instruction "Run in counting loop" causes repeated execution of a program loop until a 
loop variable lies within a specified value range.

Program loops can also be nested. Within a program loop, you can program additional program 
loops with other loop variables.

The current continuous run of a program loop can be ended by the instruction "Recheck loop 
condition" (CONTINUE). The instruction "Exit loop immediately" (EXIT) ends the entire loop 
execution. For additional information on this topic, refer to "See also".

Limits for FOR statements
To program "safe" FOR statements that do not run endlessly, observe the following rules and 
limits:

Rule
FOR ii := Start TO End BY Step DO

If ... ... then Note
start < end end < (PMAX step) Run tag ii runs in a positive 

direction
start > end AND step < O end > (NMAX step) Run tag ii runs in a negative 

direction
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Limits

Different limits apply to the possible data types:

Data type PMAX NMAX
ii of type SINT 127 -128
ii of type INT 32767 -32768
ii of type DINT 2147483647 -2147483648
ii of type LINT 9223372036854775807 -9223372036854775808

Syntax
The following syntax is used for the "Run in counting loop" instruction:

SCL
FOR<Run_tag> := <Start_value> TO<End_value> BY<Increment> DO<Instructions>
END_FOR;

Parameter
The following table shows the parameters of the "Run in counting loop" instruction:

Parameter Data type Description
S7-1200 S7-1500

<Run tag> SINT, INT, DINT SINT, INT, DINT, 
LINT

Operand whose value is evaluated with the 
loop execution. The data type of the loop 
variable determines the data type of the other 
parameters.

<Start value> SINT, INT, DINT SINT, INT, DINT, 
LINT

Expression whose value is allocated at the 
start of the loop execution of the loop variables.

<End value> SINT, INT, DINT SINT, INT, DINT, 
LINT

Expression whose value defines the last run 
of the program loop. The value of the loop 
variable is checked before each loop:
● End value not reached:

The instructions according to DO are 
executed

● End value is reached:
The FOR loop is executed one last time

● End value exceeded:
The FOR loop is completed

An alteration to the end value is not permitted 
during execution of the instruction.
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Parameter Data type Description
S7-1200 S7-1500

<Increment> SINT, INT, DINT SINT, INT, DINT, 
LINT

Expression by whose value the loop variable 
is increased (positive increment) or decreased 
(negative increment) after each loop. 
Specification of the increment is optional. If no 
increment is given, the value of the loop 
variable is increased by 1 after each loop.
An alteration of the increment is not permitted 
during execution of the instruction.

<Instructions> - - Instructions which are carried out with each 
loop, as long as the value of the loop variable 
lies within the value range. The value range is 
defined by the start and end values.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
FOR i := 2 TO 8 BY 2
    DO "a_array[i] := "Tag_Value"*"b_array[i]";
END_FOR;

The operand "Tag_Value" is multiplied with the elements (2, 4, 6, 8) of the ARRAY tag 
"b_array". The result is read in to the elements (2, 4, 6, 8) of the ARRAY tag "a_array".

See also
CONTINUE: Recheck loop condition (Page 2565)

EXIT: Exit loop immediately (Page 2566)

Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

WHILE: Run if condition is met

Description
The instruction "Run if condition is met" causes a program loop to be repeatedly executed until 
the implementation condition is satisfied. The condition is an expression with Boolean value 
(TRUE or FALSE). Logical expression or comparative expressions can be stated as conditions.

When the instruction is executed, the stated expressions are evaluated. If the value of an 
expression is TRUE, the condition is fulfilled; if the value is FALSE, it is not fulfilled.

Program loops can also be nested. Within a program loop, you can program additional program 
loops with other loop variables.
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The current continuous run of a program loop can be ended by the instruction "Recheck loop 
condition" (CONTINUE). The instruction "Exit loop immediately" (EXIT) ends the entire loop 
execution. For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Run if condition is met" instruction:

SCL
WHILE <Condition> DO <Instructions>
END_WHILE;

The syntax of the WHILE instruction consists of the following parts:

Parameter Data type Description
<Condition> BOOL Expression which is evaluated before each loop.
<Instructions> - Instructions to be executed with satisfied condition. If the 

condition has not been satisfied, program execution continues 
after END_WHILE.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
WHILE
      "Tag_Value1" <> "Tag_Value2"
      DO "Tag_Result"
      := "Tag_Input";
END_WHILE;

As long as the values of the operands "Tag_Value1" and "Tag_Value2" do not match, the value 
of the operand "Tag_Input" is allocated to the operand "Tag_Result".

See also
EXIT: Exit loop immediately (Page 2566)

Operators and operator precedence (Page 1602)

CONTINUE: Recheck loop condition (Page 2565)

Overview of the valid data types (Page 1320)
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REPEAT: Run if condition is not met

Description
The instruction "Run if condition is not met" causes a program loop to be repeatedly executed 
until a termination condition is met. The condition is an expression with Boolean value (TRUE 
or FALSE). Logical expression or comparative expressions can be stated as conditions.

When the instruction is executed, the stated expressions are evaluated. If the value of an 
expression is TRUE, the condition is fulfilled; if the value is FALSE, it is not fulfilled.

The instructions are executed once, even if the termination condition is fulfilled.

Program loops can also be nested. Within a program loop, you can program additional program 
loops with other loop variables.

The current continuous run of a program loop can be ended by the instruction "Recheck loop 
condition" (CONTINUE). The instruction "Exit loop immediately" (EXIT) ends the entire loop 
execution. For additional information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Run if condition is not met" instruction:

SCL
REPEAT <Instructions>
UNTIL <Condition>END_REPEAT;

The syntax of the REPEAT instruction consists of the following parts:

Parameter Data type Description
<Instructions> - Instructions that are executed as long as the programmed 

condition has the value FALSE. The instructions are executed 
once, even if the termination condition is fulfilled.

<Condition> BOOL Expression which is evaluated after each loop. If the expression 
has the value FALSE, the program loop is executed once again. 
If the expression has the value TRUE, the program loop 
continues after END_REPEAT.

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
REPEAT "Tag_Result"
        := "Tag_Value";
UNTIL "Tag_Error"
END_REPEAT;
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As long as the value of the operand "Tag_Error" has the signal state "0", the value of the 
operand "Tag_Value" is allocated to the operand "Tag_Result".

See also
CONTINUE: Recheck loop condition (Page 2565)

EXIT: Exit loop immediately (Page 2566)

Operators and operator precedence (Page 1602)

Overview of the valid data types (Page 1320)

CONTINUE: Recheck loop condition

Description     
The "Recheck loop condition" instruction ends the current program run of a FOR, WHILE or 
REPEAT loop.

After execution of the instruction, the conditions for the continuation of the program loop are 
evaluated again. The instruction affects the program loop which directly contains the instruction.

Syntax
The following syntax is used for the "Recheck loop condition" instruction:

SCL
CONTINUE;

Example
The following example shows how the instruction works:

SCL
FOR i 
     := 1 TO 15 BY 2 DO
     IF (i < 5) THEN
     CONTINUE;
END_IF;
      "DB10".Test[i] := 1;
END_FOR;

For additional information on valid data types, refer to "See also".

If the condition i < 5 is satisfied, then the subsequent value allocation ("DB10".Test[i] := 1) will 
not be executed. The run variable (i) is increased by the increment of "2" and checked to see 
whether its current value lies in the programmed value range. If the run variable lies in the 
value range, the IF condition is evaluated again.
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If the condition i < 5 is not satisfied, then the subsequent value allocation ("DB10".Test[i] := 1) 
will be executed and a new loop started. In this case, the run variable is also increased by the 
increment "2" and checked.

See also
Operators and operator precedence (Page 1602)

EXIT: Exit loop immediately (Page 2566)

Overview of the valid data types (Page 1320)

EXIT: Exit loop immediately

Description     
The instruction "Exit loop immediately" cancels the execution of a FOR, WHILE or REPEAT 
loop at any point regardless of conditions. The execution of the program is continued after the 
end of the loop (END_FOR, END_WHILE, END_REPEAT).

The instruction affects the program loop which directly contains the instruction.

Syntax
The following syntax is used for the "Exit loop immediately" instruction:

SCL
EXIT;

Example
The following example shows how the instruction works:

SCL
FOR i := 15 TO 1 BY -2 DO 
IF (i < 5)
THEN EXIT; 
END_IF;
"DB10".Test[i] := 1;
END_FOR;

For additional information on valid data types, refer to "See also".

If the condition i < 5 is satisfied, then the execution of the loop will be cancelled. Program 
execution resumes after the END_FOR.

If the condition i < 5 is not satisfied, then the subsequent value allocation ("DB10".Test[i] := 1) 
will be executed and a new loop started. The run tag (i) is decreased by the increment of "-2" 
and it is checked whether its current value lies in the programmed value range. If the (i) run 
variable lies within the value range, the IF condition is evaluated again.
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See also
Operators and operator precedence (Page 1602)

CONTINUE: Recheck loop condition (Page 2565)

Overview of the valid data types (Page 1320)

GOTO: Jump

Description     
Use the instruction "Jump" to resume the execution of a program at a given point marked with 
a jump label.

The jump labels and the instruction "Jump" must be in the same block. The name of a jump 
label can only be assigned once within a block. Each jump label can be the target of several 
jump instructions.

A jump from the "outside" into a program loop is not permitted, but a jump from a loop to the 
"outside" is possible.

Syntax
Use the following syntax for the "Jump" instruction:

SCL
GOTO <Jump label>
...
<Jump label>: <Instructions>

The syntax of the GOTO instruction consists of the following parts:

Parameter Data type Description
<jump label> - Jump label to be jumped to
<Instructions> - Instructions which are executed after the jump.

Example
The following example shows how the instruction works:

SCL
CASE "Tag_Value" OF
1 : GOTO MyLABEL1;
2 : GOTO MyLABEL2;
3 : GOTO MyLABEL3;
ELSE GOTO MyLABEL4;
END_CASE;
MyLABEL1: "Tag_1" := 1;
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SCL
MyLABEL2: "Tag_2" := 1;
MyLABEL3: "Tag_3" := 1;
MyLABEL4: "Tag_4" := 1;

Depending on the value of the "Tag_Value" operand, the execution of the program will resume 
at the point identified by the corresponding jump label. If the operand "Tag_Value" has the 
value 2, for example, program execution will resume at the jump label "MyLABEL2". The 
program line identified by the jump label "MyLABEL1" will be skipped in this case. 

See also
Operators and operator precedence (Page 1602)

Overview of the valid data types (Page 1320)

RETURN: Exit block

Description     
The instruction "Exit block" exits the program execution in the currently edited block and 
continues in the calling block.

The instruction can be omitted at the end of the block.

Syntax
The following syntax is used for the "Exit block" instruction:

SCL
RETURN;

Example
The following example shows how the instruction works:

SCL
IF "Tag_Error" <>0 THEN RETURN;
END_IF;

If the signal state of the "Tag_Error" operand is not zero, execution of the program ends in the 
block currently being processed.

See also
Operators and operator precedence (Page 1602)

Overview of the valid data types (Page 1320)
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(*...*): Inserting a comment section

Description   
You can use the "Insert comment section" instruction to add a comment section. The text within 
the parenthesis "(*...*)" is handled as a comment.

Syntax
The following syntax is used for the "Insert comment section" instruction:

SCL
(*...*)

Example
The following example shows how the instruction works:

SCL
(*This is a comment section.*)

See also
Operators and operator precedence (Page 1602)

Overview of the valid data types (Page 1320)

Runtime control

ENDIS_PW: Limit and enable password legitimation

Description
You use the "Limit and enable password legitimation" instruction to specify whether passwords 
configured for the CPU are legitimized or not. In this way, you can prevent legitimized 
connections, even if the correct password is known.

When you call the instruction and the REQ parameter has the signal state "0", the currently 
set state is displayed at the output parameters. If changes have been made to the input 
parameters, these are not transferred to the output parameters.

When you call the instruction and the REQ parameter has the signal state "1", the signal state 
is taken from the input parameters (F_PWD, FULL_PWD, R_PWD, HMI_PWD). FALSE means 
that legitimation per password is not permitted; TRUE means the password can be used.

Disable or enabling of the passwords can be allowed or prohibited individually. For example, 
all passwords can be prohibited except the fail-safe password. You can thus limit access 
options to a small user group. The output parameters (F_PWD_ON, FULL_PWD_ON, 
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R_PWD_ON, HMI_PWD_ON) always show the current status of the password use, regardless 
of the REQ parameter.

Passwords that are not configured must have the signal state TRUE at the input and return 
the signal state TRUE at the output. The fail-safe password can only be configured for an F-
CPU and must therefore always be interconnected with the signal state TRUE in a standard 
CPU. If the instruction returns an error, the call has no effect and the previous lock is still in 
effect.

Disabled passwords can be enabled again under the following conditions:

● The CPU is reset to its factory settings.

● The front panel of the S7-1500 CPU supports a dialog that allows you to navigate to the 
appropriate menu in which the passwords can be enabled again.

● When you call the "Limit and enable password legitimation" instruction, the input parameter 
of the desired password has the signal state "1".

● Set the mode selector to STOP. The restriction to password legitimation is re-established 
as soon as the switch is set back to RUN.

● Plugging an empty memory card (transfer module or program card) into an S7-1200 CPU.

● The transition from POWER OFF to POWER ON disables the protection in the S7-1200 
CPU. The "Limit and enable password legitimation" instruction must be called once again 
in the program (e.g. in the startup OB).

 

 Note

The "Limit and enable password legitimation" instruction blocks access from HMI systems if 
the HMI password has not been enabled.

 

 Note

Existing legitimized connections retain their access rights and you cannot use the "Limit and 
enable password legitimation" instruction to restrict them.

 

Preventing accidental lockout of an S7-1500 CPU
The settings can be made on the front panel of the CPU and the CPU saves the most recent 
setting.

To prevent accidental lockout, the protection can be disabled by setting the mode switch to 
STOP with an S7-1500 CPU. The protection is automatically enabled again by setting mode 
selector to RUN without having to call the "Limit and enable password legitimation" instruction 
again or taking additional actions on the front panel.

Preventing accidental lockout of an S7-1200 CPU
Because the S7-1200 CPU does not have a mode switch, protection is disabled with POWER 
OFF - POWER ON. This means that it is possible and advisable to prevent accidental lockout 
with the help of specific program sequences within your program.
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To do so, program a time control either by means of a cyclic interrupt OB or a timer in the Main 
OB (OB 1). This gives you the option of calling the "Limit and enable password legitimation" 
instruction in the respective OB (e.g., OB 1 or OB 35) relatively quickly after a transition from 
POWER OFF to POWER ON and the associated disabling of the protection. Call the instruction 
in the startup OB (OB 100) to keep the time window in which the instruction is inactive and 
there are no limitations for password legitimation relatively small. This procedure will give you 
the best possible protection from unauthorized access.

If there has been an accidental lockout, you can skip the call in the startup OB (by querying 
an input parameter, for example) and you have the set time (for example, 10 seconds up to 1 
minute) to establish a connection to the CPU before the lock becomes active once again.

If there is no timer in your program code and a lockout has occurred, insert an empty transfer 
card or an empty program card into the CPU. The empty transfer card or program card deletes 
the internal load memory of the CPU. You must then download the user program once again 
from STEP 7 to the CPU.

Procedure for lost passwords with an S7-1200 CPU
If you have lost the password for a password-protected S7-1200 CPU, delete the password-
protected program with an empty transfer card or program card. The empty transfer card or 
program card deletes the internal load memory of the CPU. You can then load a new user 
program from STEP 7 Basic in the CPU.

 

 WARNING

Inserting an empty transfer card

When you insert a transfer card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

Once you have pulled the transfer card, the content of the transfer card is available in the 
internal load memory. Make sure that the card does not include a program at this point.

 

 WARNING

Inserting an empty program card

When you insert a program card in a CPU during runtime, the CPU goes to STOP mode. If 
operating states are unstable, controllers may fail and thus cause the uncontrolled operation 
of the controlled devices. This leads to an unforeseen operation of the automation system 
which can cause deadly or serious injuries and/or damage to property.

Make sure that the program card is empty. The internal load memory is copied to the empty 
program card. Once you have pulled the previously empty program card, the internal load 
memory is empty.

 

You must remove the transfer card or program card before you put the CPU into RUN mode.
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Effects of password use on the operating modes
The following table shows what effects the password use by means of the "Limit and enable 
password legitimation" instruction has on the operating modes and the corresponding user 
actions.

Action Password protection by means of the 
instruction

Basic state after
● Operating mode switch to STOP
● Reset memory manually (PG, switch, change of 

MC (Motion Control))
● Reset to factory setting

Not activated
(no restrictions)

Basic state after POWER ON ● S7-1200 CPU:
The lock is disabled and the instruction 
must be called once again in the program 
(e.g., in the startup OB).

● S7-1500 CPU:
Enabled (if a lock was activated before 
POWER OFF). The option of not allowing 
passwords is retentive.

Operating mode transition RUN/STARTUP/HOLD -> 
STOP (by terminating the instruction, an error or 
communication) or STOP -> STARTUP/RUN/HOLD

Activated
Passwords still cannot be used.

Syntax
The following syntax is used for the "Limit and enable password legitimation" instruction:

SCL
ENDIS_PW(REQ := <Operand>,
         F_PWD := <Operand>,
         FULL_PWD := <Operand>,
         R_PWD := <Operand>,
         HMI_PWD := <Operand>,
         F_PWD_ON => <Operand>,
         FULL_PWD_ON => <Operand>,
         R_PWD_ON => <Operand>,
         HMI_PWD_ON => <Operand>,
         RET_VAL => <Operand>)
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Parameter
The following table shows the parameters of the "Limit and enable password legitimation" 
instruction:

Parameter Declaratio
n

Data type Memory area Description

REQ Input BOOL I, Q, M, D, L When the REQ parameter has the signal state "0", the currently set 
signal state of the passwords is queried.

F_PWD Input BOOL I, Q, M, D, L Read/write access including fail-safe
● F_PWD = "0": Do not allow password
● F_PWD = "1": Allow password

FULL_PW
D

Input BOOL I, Q, M, D, L Read/write access
● FULL_PWD = "0": Do not allow password
● FULL_PWD = "1": Allow password

R_PWD Input BOOL I, Q, M, D, L Read access
● R_PWD = "0": Do not allow password
● R_PWD = "1": Allow password

HMI_PWD Input BOOL I, Q, M, D, L HMI access
● HMI_PWD = "0": Do not allow password
● HMI_PWD = "1": Allow password

F_PWD_O
N

Output BOOL I, Q, M, D, L Read/write access including fail-safe
● F_PWD_ON = "0": Password not allowed
● F_PWD_ON = "1": Password allowed

FULL_PW
D_ON

Output BOOL I, Q, M, D, L Read/write access status
● FULL_PWD_ON = "0": Password not allowed
● FULL_PWD_ON = "1": Password allowed

R_PWD_
ON

Output BOOL I, Q, M, D, L Read-access status
● R_PWD_ON = "0": Password not allowed
● R_PWD_ON = "1": Password allowed

HMI_PWD
_ON

Output BOOL I, Q, M, D, L HMI-access status
● HMI_PWD_ON = "0": Password not allowed
● HMI_PWD_ON = "1": Password allowed

RET_VAL Output WORD I, Q, M, D, L Error information

For additional information on valid data types, refer to "See also".

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code*
(W#16#...)

Explanation

0000 No error
8090 The "Limit and enable password legitimation" instruction is not supported
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Error code*
(W#16#...)

Explanation

80D0 The password for fail-safe is not configured. The signal state must be TRUE for 
standard CPUs.

80D1 The read/write access is not configured
80D2 The read access is not configured
80D3 The HMI access is not configured
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

RE_TRIGR: Restart cycle monitoring time

Description
The instruction "Restart cycle monitoring time" restarts the cycle monitoring of the CPU. The 
cycle time monitoring then restarts with the time you have set in the CPU configuration. 

The instruction "Restart cycle monitoring time" can be called, regardless of the priority, in all 
blocks.

If the instruction is called in a block with a higher priority, such as a hardware interrupt, 
diagnostic interrupt, or cyclic interrupt, the instruction is not executed and the ENO enable 
output is set to signal state "0".

The instruction "Restart cycle monitoring time" can be called a maximum of 10 times in a 
program cycle.

 

 Note

If the instruction "Restart cycle monitoring time" is started more than 30 times within a LOOP 
instruction, the CPU switches to STOP because of a runtime error.

 

Syntax
The following syntax is used for the "Restart cycle monitoring time" instruction:

SCL
RE_TRIGR()

STP: Exit program

Description       
The "Exit program" instruction is used to set the CPU to STOP mode and therefore to terminate 
the execution of the program. The effects of changing from RUN to STOP depend on the CPU 
configuration.
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Syntax
The following syntax is used for the instruction "Exit program":

SCL
STP()

GET_ERROR: Get error locally

Description
The "Get error locally" instruction is used to query the occurrence of errors within a block. This 
is usually to access error. If the system reports an error during the processing of the block, 
detailed information is generated for the first error to occur during the execution of the block 
since the last execution of the instruction.

The error information can only be saved in operands of the "ErrorStruct" system data type. 
The "ErrorStruct" system data type specifies the exact structure in which the information about 
the error is stored. Using additional instructions, you can evaluate this structure and program 
an appropriate response. If several errors occur in the block, the error information about the 
next error to occur in the instruction is output only after the first error that occurred has been 
remedied.

 

 Note

The <Operand> is only changed if error information is present. To set the operand back to 
"0" after handling the error, you have the following options:
● Declare the operand in the "Temp" section of the block interface.
● Reset the operand to "0" before calling the instruction.

 

You can find an example of how you can implement the instruction in combination with other 
troubleshooting options under "See also".

 

 Note

The "Get error locally" instruction enables local error handling within a block. If "Get error 
locally" is inserted in the program code of a block, any predefined system reactions are 
ignored if errors occur.

 

Syntax
The following syntax is used for the "Get error locally" instruction:

SCL
GET_ERROR(<Operand>)
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Parameter
The following table shows the parameters of the "Get error locally" instruction:

Parameter Data type Description
<Operand> ErrorStruct Information about errors that have occurred

Data type "ErrorStruct"
The following table shows the structure of the "ErrorStruct" data type:

Structure component Data type Description
ERROR_ID WORD Error ID
FLAGS BYTE Shows if an error occurred during a 

block call.
16#01: Error during a block call
16#00: No error during a block call

REACTION BYTE Default reaction:
0: Ignore (write error),
1: Continue with substitute value "0" 
(read error),
2: Skip instruction (system error)

CODE_ADDRESS CREF Information about the address and 
type of block

 BLOCK_TYPE BYTE Type of block where the error 
occurred:
1: OB
2: FC
3: FB

 CB_NUMBER UINT Number of the code block
 OFFSET UDINT Reference to the internal memory
MODE BYTE Information about the address of an 

operand
OPERAND_NUMBER UINT Operand number of the machine 

command
POINTER_NUMBER_LOCATION UINT (A) Internal pointer
SLOT_NUMBER_SCOPE UINT (B) Storage area in internal memory
DATA_ADDRESS NREF Information about the address of an 

operand
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Structure component Data type Description
 AREA BYTE (C) Memory area:

L: 16#40 – 4E, 86, 87, 8E, 8F, C0 – 
CE
I: 16#81
Q: 16#82
M: 16#83
DB: 16#84, 85, 8A, 8B
Range violations for a directly 
editable tag of data type DINT: 16#04

 DB_NUMBER UINT (D) Number of the data block
 OFFSET UDINT (E) Relative address of the operand

Structure component "ERROR_ID"
The following table shows the values that can be output at the structure component 
"ERROR_ID":

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 The block property "Parameter passing via registers" is not selected.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2577



ID*
(hexadecimal)

ID*
(decimal)

Description

25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
LABEL: #TagOut := #Field[#index] * REAL#40.5;
 
GET_ERROR(#Error);
 
IF #Error.REACTION = 1 THEN
   GOTO LABEL;
   ;
END_IF;

An error occurred accessing the "#Field[#index]" tag. The "#TagOut" operand returns the signal 
state "1" despite the read/access error and the multiplication is performed with the value "0.0". 
If this error scenario occurs, we recommend that you program the "Get error locally" instruction 
after the multiplication to get the error. The error information supplied by the "Get error locally" 
instruction is evaluated with a comparison. If the "#Error.REACTION" structure component 
has the value "1", there is a read/access error and the program execution begins again at the 
jump label LABEL.

See also
Querying and fixing errors in the program code (Page 286)

GET_ERR_ID: Get error ID locally

Description
The "Get error ID locally" instruction is used to query the occurrence of errors within a block. 
This is usually to access error. If the system reports during the block processing errors within 
the block execution since the last execution of the instruction, the instruction outputs the error 
ID of the first error that occurred.
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The error ID can only be saved in operands of the WORD data type. If several errors occur in 
the block, the error ID of the next error to occur in the instruction is output only after the first 
error that occurred has been remedied.

 

 Note

The <Operand> is only changed if error information is present. To set the operand back to 
"0" after handling the error, you have the following options:
● Declare the operand in the "Temp" section of the block interface.
● Reset the operand to "0" before calling the instruction.

 

The output of the "Get error ID locally" instruction is only set if error information is present. If 
one of these conditions is not fulfilled, the remaining program execution is not affected by the 
"Get error ID locally" instruction.

You can find an example of how you can implement the instruction in combination with other 
troubleshooting options under "See also".

 

 Note

The "Get error ID locally" instruction enables local error handling within a block. If the "Get 
error ID locally" instruction is inserted in the program code of a block, any predefined system 
reactions are ignored if errors occur.

 

Syntax
The following syntax is used for the "Get error ID locally" instruction:

SCL
GET_ERR_ID()

Parameter
The following table shows the parameters of the "Get error ID locally" instruction:

Parameter Data type Description
Function value WORD Error ID

Error ID
The following table shows the values that can be output:

ID*
(hexadecimal)

ID*
(decimal)

Description

0 0 No error
2503 9475 Invalid pointer
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ID*
(hexadecimal)

ID*
(decimal)

Description

2520 9504 Invalid STRING
2522 9506 Read error: Operand outside the valid range
2523 9507 Write error: Operand outside the valid range
2524 9508 Read error: Invalid operand
2525 9509 Write error: Invalid operand
2528 9512 Read error: Data alignment
2529 9513 Write error: Data alignment
252C 9516 Invalid pointer
2530 9520 Write error: Data block
2533 9523 Invalid pointer used
2538 9528 Access error: DB does not exist
2539 9529 Access error: Wrong DB used
253A 9530 Global data block does not exist
253C 9532 Faulty information or the function does not exist
253D 9533 System function does not exist
253E 9534 Faulty information or the function block does not exist
253F 9535 System block does not exist
2550 9552 Access error: DB does not exist
2551 9553 Access error: Wrong DB used
2575 9589 Error in the program nesting depth
2576 9590 Error in the local data distribution
2577 9591 The block property "Parameter passing via registers" is not selected.
25A0 9632 Internal error in TP
25A1 9633 Tag is write-protected
25A2 9634 Invalid numerical value of tag
2942 10562 Read error: Input
2943 10563 Write error: Output
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
#TagOut := #Field[#index] * REAL#40.5;
 
#TagID := GET_ERR_ID();
 
IF #TagID = 16#2522 THEN
   MOVE_BLK(IN := #TagArrayIn[0],
            COUNT := 1,
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SCL
            OUT => #TagArrayOut[1]);
END_IF;

An error occurred accessing the "#Field[#index]" tag. The "#TagOut" operand returns the signal 
state "1" despite the read/access error and the multiplication is performed with the value "0.0". 
If this error scenario occurs, we recommend that you program the "Get error ID locally" 
instruction after the multiplication to get the error. The error ID supplied by the "Get error ID 
locally" instruction is evaluated with a comparison. If the "#TagID" operand returns ID 16#2522, 
there is a read/access error and the value "100.0" of the "#TagArrayIn[0]" operand is written 
to the "#TagArrayOut[1]" operand.

See also
Querying and fixing errors in the program code (Page 286)

INIT_RD: Initialize all retain data

Description
The "Initialize all retain data" instruction is used to reset the retentive data of all data blocks, 
bit memories and SIMATIC timers and counters at the same time. The instruction can only be 
executed within a startup OB because the execution exceeds the program cycle duration.

Syntax
Use the following syntax for the "Initialize all retain data" instruction:

SCL
INIT_RD(REQ := <Operand>
        RET_VAL := <Operand>)

Parameter
The following table shows the parameters of the "Initialize all retain data" instruction:

Parameter Declaration Data type Description
REQ Input BOOL If the input "REQ" has 

the signal state "1", all 
retentive data are reset.

RET_VAL Output INT Error information:
If an error occurs during 
the execution of the 
instruction, an error 
code is output at the 
RET_VAL parameter.

For additional information on valid data types, refer to "See also".
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RET_VAL Parameter
The following table shows the meaning of the values of the parameter RET_VAL:

Error code*
(W#16#...)

Explanation

0000 No error
80B5 The instruction cannot be executed because it was not programmed within a startup OB.
General error 
information

See also: "GET_ERR_ID: Get error ID locally

*The error codes can be displayed as integer or hexadecimal value in the program editor. For information on toggling display 
formats, refer to "See also".

Example
The following example shows how the instruction works:

SCL
INIT_RD(REQ := "Tag_REQ",
        RET_VAL := "Tag_Result");

If the operand "Tag_REQ" has the signal state "1", the instruction is executed. All retentive 
data of all data blocks, bit memories and SIMATIC timers and counters are reset.

See also
Overview of the valid data types (Page 1320)

GET_ERR_ID: Get error ID locally (Page 2578)

WAIT: Configure time delay

Description     
The instruction "Configure time delay" pauses the program execution for a specific period of 
time. You indicate the period of time in microseconds on the WT parameter of the instruction.

You can configure time delays of up to 32 767 microseconds (μs). The shortest possible time 
delay depends on the respective CPU and corresponds to the execution time of the instruction 
"Configure time delay".

The execution of the instruction can be interrupted by higher priority events.

The instruction "Configure time delay" supplies no error information.
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Syntax
The following syntax is used for the instruction "Configure time delay":

SCL
WAIT(WT:= <Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
WT Input INT Time delay in microseconds (μs)

See also
Overview of the valid data types (Page 1320)

RUNTIME: Measure program runtime

Description
The "Measure program runtime" instruction is used to measure the runtime of the entire 
program, individual blocks or command sequences.

If you want to measure the runtime of your entire program, call the instruction "Measure 
program runtime" in OB1. Measurement of the runtime is started with the first call and the 
output RET_VAL returns the runtime of the program after the second call. The measured 
runtime includes all CPU processes that can occur during the program execution, for example, 
interruptions caused by higher-level events or communication. The instruction "Measure 
program runtime" reads an internal counter of the CPU and writes the value to the in/out 
parameter. The instruction calculates the current program runtime according to the internal 
counter frequency and writes it to output RET_VAL.

If you want to measure the runtime of individual blocks or individual command sequences, you 
need three separate networks. Call the instruction "Measure program runtime" in an individual 
network within your program. You set the starting point of the runtime measurement with this 
first call of the instruction. Then you call the required program block or the command sequence 
in the next network. In another network, call the "Measure program runtime" instruction a 
second time and assign the same memory to the in/out parameter as you did during the first 
call of the instruction. The "Measure program runtime" instruction in the third network reads 
an internal CPU counter and calculates the current runtime of the program block or the 
command sequence according to the internal counter frequency and writes it to the output 
RET_VAL.
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The "Measure program runtime" instruction uses an internal high-frequency counter to 
calculate the time. If the counter overruns, the instruction returns values <= 0.0. Ignore these 
runtime values.

 

 Note

The runtime of a command sequence cannot be determined exactly, because the sequence 
of instructions within a command sequence is changed during optimized compilation of the 
program.

 

Syntax
The following syntax is used for the "Measure program runtime" instruction:

SCL
RUNTIME(<Operand>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
<Operand> InOut LREAL Saves the starting point 

of the runtime 
measurement.

Function value
 

LREAL Returns the measured 
runtime in seconds

For additional information on valid data types, refer to "See also".

Example
The following example shows the how the instruction works based on the runtime calculation 
of a program block:

SCL
"Tag_Result" := RUNTIME("Tag_Memory");
 
"Best_before_date_DB" ();
 
"Tag_Result" := RUNTIME("Tag_Memory");

The starting point for the runtime measurement is set with the first call of the instruction and 
buffered as reference for the second call of the instruction in the "TagMemory" operand.

The "Best_before_date" program block FB1 is called.

When the program block FB1 has been processed, the instruction is executed a second time. 
The second call of the instruction calculates the runtime of the program block and writes the 
result to the output "Tag_Result".
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See also
Overview of the valid data types (Page 1320)

Word logic operations

DECO: Decode

Description
The instruction "Decode" sets a bit specified by the input value in the output value.

The instruction "Decode" reads the value of the parameter IN and sets the bit in the output 
value, whose bit position corresponds to the read value. The other bits in the output value are 
filled with zeroes. If the value of the IN parameter is greater than 31, a modulo 32 instruction 
is executed.

Syntax
The following syntax is used for the instruction "Decode":

SCL
DECO(IN := <Expression>)
DECO_WORD(IN := <Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input UINT Position of the bit in the 

output value which is 
set.

_<Data type> Bit strings
default: DWORD

Data type of the 
function value:
● You do not need to 

specify the data 
type if using the 
default.

● Any other valid data 
type you may use 
must be declared 
explicitly.

Function value Bit strings Current output value

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := DECO(IN := "Tag_Value");
"Tag_Result2" := DECO_BYTE(IN := "Tag_Value2");

The following figure shows how the instruction works using specific operand values:

The instruction reads the number "3" from the value of the operand "Tag_Value" and sets the 
third bit to the value of the operand "Tag_Result".

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

ENCO: Encode

Description
The instruction "Encode" reads the bit number of the lowest-value bit set in the input value and 
issues this as a result.

Syntax
The following syntax is used for the instruction "Encode":

SCL
ENCO(IN := <Expression>)

The syntax of the instruction consists of the following parts:

Parameter Declaration Data type Description
IN Input Bit strings Input value
Function value INT Bit number of the bit in 

the input value that is 
read out.

For additional information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ENCO(IN := "Tag_Value");

The following figure shows how the instruction works using specific operand values:

The instruction reads the lowest-value set bit of the operand "Tag_Value" and writes the bit 
position "3" in the operand "Tag_Result".

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

SEL: Select

Description
The instruction "Select" selects one of the parameters IN0 or IN1 depending on a switch (G 
parameter) and issues its content as a result. When the parameter G has the signal status "0", 
the value at parameter IN0 is moved. When the parameter G has the signal status "1", the 
value at parameter IN1 is moved and returned as a function value.

The instruction is only executed if the tags of all parameters have the same data type class.

Syntax
The following syntax is used for the instruction "Select":

SCL
SEL(G:= <Expression>,
    IN0 := <Expression>,
    IN1 := <Expression>)

The syntax of the instruction consists of the following parts:
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Parameter Declaration Data type  
S7-1200 S7-1500 Description

G Input BOOL BOOL Switch
IN0 Input Bit strings, integers, 

floating-point 
numbers, TIME, 
TOD, DATE, CHAR, 
DT

Bit strings, integers, 
floating-point 
numbers, CHAR, 
timers, DATE, 
TOD, LTOD, DT, 
LDT

First input value

IN1 Input Bit strings, integers, 
floating-point 
numbers, TIME, 
TOD, DATE, CHAR, 
DT

Bit strings, integers, 
floating-point 
numbers, CHAR, 
timers, DATE, 
TOD, LTOD, DT, 
LDT

Second input value

Function value Bit strings, integers, 
floating-point 
numbers, TIME, 
TOD, DATE, CHAR, 
DT

Bit strings, integers, 
floating-point 
numbers, CHAR, 
timers, DATE, 
TOD, LTOD, DT, 
LDT

Result of the 
instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SEL(G := "Tag_Value",
                    IN0 := "Tag_0",
                    IN1 := "Tag_1");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Value 0 1
Tag_0 W#16#0000 W#16#4C
Tag_1 W#16#FFFF D#16#5E
Tag_Result W#16#0000 D#16#5E

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)
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MUX: Multiplex

Description
The "Multiplex" instruction copies the value of a selected input parameter and issues it. You 
can use the parameter K to determine the number of the input parameter whose value will be 
moved. Numbering starts at IN0 and is incremented continuously with each new input. You 
can declare a maximum of 32 inputs.

If the value of the K parameter is greater than the number of inputs and the INELSE parameter 
is not set, the instruction function value is invalid and the ENO enable output is set to 0.

Numerical data types and time data types are permitted at the inputs. All tags with assigned 
parameters must be of the same data type.

The function value is invalid if any of the following conditions are met:

● The value of the parameter K is greater than the number of available inputs.

● Errors occurred during the execution of the instruction.

Syntax
The following syntax is used for the "Multiplex" instruction:

SCL
MUX(K := <Expression>,
    IN0 := <Expression>,
    IN1 := <Expression>,
    INELSE := <Expression>)

Parameter
The following table shows the parameters of the "Multiplex" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

K Input Integers Integers Specifies the 
parameter whose 
content is to be 
transferred.
● If K = 0 => 

Parameter IN0
● If K = 1 => 

Parameter 
IN1, etc.

IN0 Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

First input value
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Parameter Declaration Data type Description
S7-1200 S7-1500

IN1 Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Second input value

INn Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Optional input 
values

INELSE Input Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Specifies the 
value to be copied 
when K <> n.

Function value
 

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
DATE, TIME, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, TOD, 
LTOD, DATE, 
timers, DT, LDT

Result of the 
instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := MUX(K := "Tag_Number",
                    IN0 := "Tag_1",
                    IN1 := "Tag_2",
                    INELSE := "Tag_3");

The result of the instruction is returned in the operand "Tag_Result" as a function value.

The following table shows how the instruction works using specific operand values:

Operand Value
Tag_Number 1 4
Tag_1 DW#16#00000000 DW#16#00000000
Tag_2 DW#16#003E4A7D DW#16#003E4A7D
Tag_3 DW#16#FFFF0000 DW#16#FFFF0000
Tag_Result DW#16#003E4A7D DW#16#FFFF0000
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See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

DEMUX: Demultiplex

Description
The "Demultiplex" instruction transfers the value of the input parameter IN to a selected output 
parameter. The selection of the input parameter takes place independent of the parameter 
value K. The K parameter specifies the output parameter number to which the value of the 
input parameter IN is transferred. The other output parameters are not changed. Numbering 
starts at OUT0 and continues consecutively with each new output. You can declare a maximum 
of 32 output parameters.

If the value of the K parameter is greater than the number of output parameters, the value of 
the ENO enable output is set to "0" and the value is transferred to the input parameter IN and 
the output parameter OUTELSE.

The function value is invalid if any of the following conditions are met:

● The value of the K parameter is greater than the number of available outputs.

● Errors occurred during execution of the instruction.

Syntax
The following syntax is used for the instruction "Demultiplex":

SCL
DEMUX(K := <Expression>,
      IN := <Expression>,
      OUT0 := <Operand>,
      OUT1 := <Operand>,
      OUTELSE := <Operand>)
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Parameter
The following table shows the parameters of the instruction "Demultiplex":

Parameter Declaration Data type Description
S7-1200 S7-1500

K Input Integers Integers Specifies the 
output to which the 
input value (IN) 
will be copied.
● If K = 0 => 

Parameter 
OUT0

● If K = 1 => 
Parameter 
OUT1, etc.

IN Input Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Input value

OUT0 Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

First output

OUT1 Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Second output

OUTn Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Optional outputs

OUTELSE Output Binary numbers, 
integers, floating-
point numbers, 
strings, TIME, 
TOD, DATE, DT

Binary numbers, 
integers, floating-
point numbers, 
strings, timers, 
TOD, LTOD, 
DATE, DT, LDT

Output to which 
the value at input 
IN is copied if K > 
n.

For additional information on available data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
DEMUX(K := "Tag_Number",
      IN := "Tag_Value",
      OUT0 := "Tag_1",
      OUT1 := "Tag_2",
      OUTELSE := "Tag_3");

The following tables show how the instruction works using specific operand values:

Input values of the "Demultiplex" instruction before the network execution

Parameter Operand Values
K Tag_Number 2 4
IN Tag_Value DW#16#FFFFFFFF DW#16#003E4A7D

Output values of the "Demultiplex" instruction after the network execution

Parameter Operand Values
OUT0 Tag_1 Unchanged Unchanged
OUT1 Tag_2 DW#16#FFFFFFFF Unchanged
OUTELSE Tag_3 Unchanged DW#16#003E4A7D

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

Shift and rotate

SHR: Shift right

Description
The "Shift right" instruction shifts the contents of the IN  parameter bit-by-bit to the right and 
returns it as a function value. The parameter N is used to specify the number of bit positions 
by which the specified value should be shifted.

If the value of the N parameter is "0", the value of the IN parameter is given as a result.

If the value of the N parameter is greater than the number of available bit positions, then the 
value of the IN parameter is shifted to the right by the available number of bit positions.

The bit positions that are freed by shifting in the left operand area are filled with zeros.

The following figure shows how the content of an integer data type operand is shifted by four 
bit positions to the right:
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Syntax
The following syntax is used for the instruction "Shift right":

SCL
SHR(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Shift right" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bits by 
which the value 
(IN) is shifted

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SHR(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 0011 1111 1010 1111
N Tag_Number 3
Function value Tag_Result 0000 0111 1111 010 1

The content of the "Tag_Value" operand is shifted by three bit positions to the right. The result 
of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

SHL: Shift left

Description
The "Shift left" instruction shifts the contents of the IN parameter bit-by-bit to the left and returns 
it as a function value. The parameter N is used to specify the number of bit positions by which 
the specified value should be shifted.

If the value of the N parameter is "0", the value of the IN parameter is given as a result.

If the value of the N parameter is greater than the number of bit positions, the value of the IN 
parameter is shifted to the left by the available number of bit positions.

The bit positions freed by the shift are filled with zeros in the result value. 

The following figure shows how the content of an operand of the WORD data type is shifted 
six bit positions to the left:
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Syntax
The following syntax is used for the instruction "Shift left":

SCL
SHL(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Shift left" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be shifted

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bits by 
which the value 
(IN) is shifted

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := SHL(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 0011 1111 1010 1111
N Tag_Number 4
Function value Tag_Result 1111 1010 1111 0000

The value of the "Tag_Value" operand is shifted by four bit positions to the left. The result of 
the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

ROR: Rotate right

Description
The "Rotate right" instruction rotates the content of the IN parameter bit-by-bit to the right and 
assigns the result to the specified operand. The parameter N is used to specify the number of 
bit positions by which the specified value should be rotated. The bit positions freed by rotating 
are filled with the bit positions that are pushed out.

If the value of the N parameter is "0", the value at input IN is given as a result.

If the value at the N parameter is greater than the number of available bit positions, the operand 
value at the IN input is still rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the DWORD data type is rotated 
three bit positions to the right:
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Syntax
The following syntax is used for the instruction "Rotate right":

SCL
ROR(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Rotate right" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be rotated

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bit 
positions by which 
the value (IN) is 
rotated

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

SCL
"Tag_Result" := ROR(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
IN Tag_Value 0000 1111 1001 0101
N Tag_Number 5
Function value Tag_Result 1010 1000 0111 1100

The content of the "Tag_Value" operand is rotated by five bit positions to the right. The result 
of the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

ROL: Rotate left

Description
The "Rotate left" instruction rotates the contents of the IN parameter bit-by-bit to the left and 
returns it as a function value. The parameter N is used to specify the number of bit positions 
by which the specified value should be rotated. The bit positions freed by rotating are filled 
with the bit positions that are pushed out.

If the value of the N parameter is "0", the value at input IN is given as a result.

If the value at the N parameter is greater than the number of available bit positions, the operand 
value at the IN input is still rotated by the specified number of bit positions.

The following figure shows how the content of an operand of the DWORD data type is rotated 
three bit positions to the left:
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Syntax
The following syntax is used for the "Rotate left" instruction:

SCL
ROL(IN := <Operand>,
    N := <Operand>)

Parameter
The following table shows the parameters of the "Rotate left" instruction:

Parameter Declaration Data type Description
S7-1200 S7-1500

IN Input Bit strings, 
integers

Bit strings, integers Value to be rotated

N Input USINT, UINT, 
UDINT

USINT, UINT, 
UDINT, ULINT

Number of bit 
positions by which 
the value (IN) is 
rotated

Function value Bit strings, 
integers

Bit strings, integers Result of the 
instruction

For more information on valid data types, refer to "See also".
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Example
The following example shows how the instruction works:

 SCL
"Tag_Result" := ROL(IN := "Tag_Value",
                    N := "Tag_Number");

The following table shows how the instruction works using specific operand values:

Parameters Operand Value
IN Tag_Value 1010 1000 1111 0110
N Tag_Number 5
Function value Tag_Result 0001 1110 1101 0101

The content of the operand "Tag_Value" is rotated five bit positions to the left. The result of 
the instruction is returned in the operand "Tag_Result" as a function value.

See also
Overview of the valid data types (Page 1320)

Operators and operator precedence (Page 1602)

Additional instructions

DRUM: Implement sequencer

Description
The "Implement sequencer" instruction is used to assign the programmed values of the 
OUT_VAL parameter of the corresponding step to the programmed output bits (OUT1 to 
OUT16) and the output word (OUT_WORD). The specific step must thereby satisfy the 
conditions of the programmed enable mask on the S_MASK parameter while the instruction 
remains at this step. The instruction advances to the next step if the event for the step is true 
and the programmed time for the current step elapses, or if the value at the JOG parameter 
changes from "0" to "1". The instruction is reset if the signal state on the RESET parameter 
changes to "1". The current step is hereby equated to the preset step (DSP).

The amount of time spent on a step is determined by the product of the preset timebase (DTBP) 
and the preset counter value (S_PRESET) for each step. At the start of a new step, this 
calculated value is loaded into the DCC parameter, which contains the time remaining for the 
current step. If, for example the value at the DTBP parameter is "2" and the preset value for 
the first step is "100" (100 ms), the DCC parameter has the value "200" (200 ms).

A step can be programmed with a time value, an event, or both. Steps that have an event bit 
and the time value "0" advance to the next step as soon as the signal state of the event bit is 
"1". Steps that are programmed only with a time value start the time immediately. Steps that 
are programmed with an event bit and a time value greater than "0" start the time when the 
signal state of the event bit is "1". The event bits are initialized with a signal state of "1".
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When the sequencer is on the last programmed step (LST_STEP) and the time for this step 
has expired, the signal state on the Q parameter is set to "1"; otherwise it is set to "0". When 
the parameter Q is set, the instruction remains on the step until it is reset.

In the configurable mask (S_MASK) you can selected the separate bits in the output word 
(OUT_WORD) and set or reset the output bits (OUT1 to OUT16) by means of the output values 
(OUT_VAL). If a bit of the configurable mask is in the signal state "1", the value OUT_VAL sets 
or resets the corresponding bit. If the signal state of a bit of the configurable mask is "0", the 
corresponding bit is left unchanged. All the bits of the configurable mask for all 16 steps are 
initialized with a signal state of "1".

The output bit on the OUT1 parameter corresponds to the least significant bit of the output 
word (OUT_WORD). The output bit on the OUT16 parameter corresponds to the most 
significant bit of the output word (OUT_WORD).

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Implement sequencer" instruction:

SCL
<Instance>RESET:= <Operand>,
          JOG := <Operand>,
          DRUM_EN := <Operand>,
          LST_STEP := <Operand>,
          EVENT1 - 16 := <Operand>,
          OUT1 - 16 => <Operand>,
          Q => <Operand>,
          OUT_WORD => <Operand>,
          ERR_CODE => <Operand>)

Parameter
The following table shows the parameters of the "Implement sequencer" instruction:

Parameter Declaration Data type Description
RESET Input BOOL A signal state of "1" 

indicates a reset 
condition.

JOG Input BOOL When the signal state 
changes from "0" to "1", 
the instruction 
advances to the next 
step.
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Parameter Declaration Data type Description
DRUM_EN Input BOOL A signal state of "1" 

allows the sequencer to 
advance based on the 
event and time criteria.

LST_STEP Input BYTE Step number of the last 
step programmed.

EVENT(i),
1 ≤ i ≤ 16

Input BOOL Event bit (i);
Initial signal state is "1".

OUT(j),
1 ≤ j ≤ 16

Output BOOL Output bit (j)

Q Output BOOL A signal state of "1" 
indicates that the time 
for the last step has 
elapsed.

OUT_WORD Output WORD Word address to which 
the sequencer writes 
the output values.

ERR_CODE Output WORD Error information
JOG_HIS Static BOOL JOG parameter history 

bit
EOD Static BOOL A signal state of "1" 

indicates that the time 
for the last step has 
elapsed.

DSP Static BYTE Preset step of the 
sequencer

DSC Static BYTE Current step of the 
sequencer

DCC Static DWORD Current numerical 
value of the sequencer

DTBP Static WORD Preset timebase of the 
sequencer

PREV_TIME Static DWORD Previous system time
S_PRESET Static ARRAY of WORD Count preset for each 

step [1 to 16] where 1 
count = 1 ms.

OUT_VAL Static ARRAY of BOOL Output values for each 
step [1 to 16, 0 to 15].

S_MASK Static ARRAY of BOOL Configurable mask for 
each step [1 to 16, 
0 to 15]. Initial signal 
states are "1".

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.
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ERR_CODE Parameter
The following table shows the meaning of the values of the parameter ERR_CODE:

ERR_CODE* Explanation
W#16#0000 No error
W#16#000B The value at the LST_STEP parameter is less than 1 or greater than 16.
W#16#000C The value at the DSC parameter is less than 1 or greater than the value at 

the LST_STEP parameter.
W#16#000D The value at the DSP parameter is less than 1 or greater than the value at 

the LST_STEP parameter.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

DCAT: Discrete control-timer alarm

Description
The "Discrete control-timer alarm" instruction is used to accumulate the time from the point at 
which the CMD parameter issues the command to open or close. The time is accumulated 
until the preset time (PT) is exceeded or the information is received that the device was opened 
or closed (O_FB or C_FB) within the specified time. If the preset time is exceeded before the 
information on the opening or closing of the device is received, the corresponding alarm is 
activated. If the signal state on the command input changes state before the preset time, the 
time is restarted.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

The "Discrete control-timer alarm" instruction has the following reactions to the input conditions:

● When the signal state of the CMD parameter changes from "0" to "1", the signal states of 
the parameters Q, CMD_HIS, ET (only if ET < PT), OA and CA are influenced as follows:

– The parameters Q and CMD_HIS are set to "1".

– The parameters ET, OA and CA are reset to "0".

● When the signal state on the parameter CMD changes from "1" to "0", the parameters Q, 
ET (only if ET < PT),  OA, CA and CMD_HIS are reset to "0".
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● When the signal state of the parameters CMD and CMD_HIS is "1" and the parameter O_FB 
is set to "0", the time difference (ms) since the last execution of the instruction is added to 
the value at the parameter ET. If the value of the parameter ET exceeds the value of the 
parameter PT, the signal state on the parameter OA is set to "1". If the value of the 
parameter ET does not exceed the value of the parameter PT, the signal state on the 
parameter OA is reset to "0". The value at the parameter CMD_HIS is set to the value of 
the parameter CMD.

● If the signal state of the parameters CMD, CMD_HIS and O_FB are set to "1" and the 
parameter C_FB has the value "0", the signal state of the parameter OA is set to "0". The 
value of parameter ET is set to the value of parameter PT. If the signal state of the parameter 
O_FB changes to "0", the alarm is set the next time the instruction is executed. The value 
of parameter CMD_HIS is set to the value of parameter CMD.

● If the parameters CMD, CMD_HIS and C_FB have the value "0", the time difference (ms) 
since the last execution of the instruction is added to the value of the parameter ET. If the 
value of the parameter ET exceeds the value of the parameter PT, the signal state of the 
parameter CA is set to "1". If the value at the parameter PT is not exceeded, the parameter 
CA has the signal state "0". The value of parameter CMD_HIS is set to the value of 
parameter CMD.

● If the parameters CMD, CMD_HIS and O_FB have the signal state "0" and the parameter 
C_FB is set to "1", the parameter CA is set to "0". The value of parameter ET is set to the 
value of parameter PT. If the signal state of the parameter C_FB changes to "0", the alarm 
is set the next time the instruction is executed. The value of parameter CMD_HIS is set to 
the value of parameter CMD.

● If the parameters O_FB and C_FB simultaneously have the signal state "1", the signal states 
of both alarm outputs are set to "1".

The "Discrete control-timer alarm" instruction has no error information.

Syntax
The following syntax is used for the "Discrete control-timer alarm" instruction:

SCL
<Instance>CMD:= <Operand>,
          O_FB := <Operand>,
          C_FB := <Operand>,
          Q => <Operand>,
          OA => <Operand>,
          CA => <Operand>)

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2605



Parameter
The following table shows the parameters of the instruction:

Parameter Declaration Data type Description
CMD Input BOOL A signal state of "0" indicates a "close" 

command.
A signal state of "1" indicates an "open" 
command.

O_FB Input BOOL Feedback input when opening
C_FB Input BOOL Feedback input when closing
Q Output BOOL Shows the status of the parameter CMD
OA Output BOOL Alarm output when opening
CA Output BOOL Alarm output when closing
ET Static DINT Currently elapsed time, where one count 

= 1 ms.
PT Static DINT Preset time value, where one count = 1 

ms.
PREV_TIME Static DWORD Previous system time
CMD_HIS Static BOOL CMD history bit

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

Example
In the following example the parameter CMD changes from "0" to "1". After the execution of 
the instruction the parameter Q is set to "1" and the two alarm outputs OA and CA have the 
signal state "0". The parameter CMD_HIS of the instance data block is set to the signal state 
"1" and the parameter ET is reset to "0".

 

 Note

You can initialize static parameters in the data block.
 

SCL
"DCAT_DB"(CMD := "Tag_Input_CMD",
          O_FB := "Tag_Input_O_FB",
          C_FB := "Tag_Input_C_FB",
          Q => "Tag_Output_Q",
          OA => "Tag_Output_OA",
          CA => "Tag_Output_CA");

The following tables show how the instruction works using specific values:

Before processing

In this example the following values are used for the input and output parameters:
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Parameter Operand Value
CMD Tag_Input_CMD TRUE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
Q Tag_Output_Q FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#12
PT DBD8 L#222
CMD_HIS DBX16.0 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:

Parameter Operand Value
Q Tag_Output_Q TRUE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE

The following values are saved in the instance data block "DCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
CMD_HIS DBX16.0 TRUE

See also
Overview of the valid data types (Page 1320)

MCAT: Motor control-timer alarm

Description
The "Motor control-timer alarm" instruction is used to accumulate the time from the point at 
which one of the command inputs (opening or closing) is switched on. The time is accumulated 
until the preset time is exceeded or the relevant feedback input indicates that the device has 
executed the requested operation within the specified time. If the preset time is exceeded 
before the feedback is received, the corresponding alarm is triggered.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
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instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For additional information on this topic, refer to "See also".

Execution of the "Motor control-timer alarm" instruction
The following table shows the reactions of the "Motor control-timer alarm" instruction to the 
various input conditions:

Input parameters Output parameters
ET O_H

IS
C_H
IS

O_C
MD

C_C
MD

S_C
MD

O_F
B

C_F
B

OO CO OA CA ET O_H
IS

C_H
IS

Q State

X 1 1 X X X X X 0 0 1 1 PT 0 0 0 Alarm
X X X X X X 1 1 0 0 1 1 PT 0 0 0 Alarm
X X X X X 1 X X 0 0 0 0 X 0 0 1 Stop
X X X 1 1 X X X 0 0 0 0 X 0 0 1 Stop
X 0 X 1 0 0 X X 1 0 0 0 0 1 0 1 Start 

opening
<PT 1 0 X 0 0 0 X 1 0 0 0 INC 1 0 1 Open
X 1 0 X 0 0 1 0 0 0 0 0 PT 1 0 1 Opened
>=P
T

1 0 X 0 0 0 X 0 0 1 0 PT 1 0 0 Opening 
alarm

X X 0 0 1 0 X X 0 1 0 0 0 0 1 1 Start closing
<PT 0 1 0 X 0 X 0 0 1 0 0 INC 0 1 1 Close
X 0 1 0 X 0 0 1 0 0 0 0 PT 0 1 1 Closed
>=P
T

0 1 0 X 0 X 0 0 0 0 1 PT 0 1 0 Closing 
alarm

X 0 0 0 0 0 X X 0 0 0 0 X 0 0 1 Stopped
Legend:
INC Add the time difference (ms) since the last processing of the FB to ET
PT PT is set to the same value as ET
X Cannot be used
<PT ET < PT
>=PT ET >= PT
If the input parameters O_HIS and C_HIS both have the signal state "1", they are immediately set to the signal state "0". In 
this case, the last row in the table (X) mentioned above is valid. Because it is therefore not possible to check whether the 
input parameters O_HIS and C_HIS have the signal state "1", the output parameters are set as follows in this case: 
OO = FALSE
CO = FALSE
OA = FALSE
CA = FALSE
ET = PT
Q = TRUE
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Syntax
The following syntax is used for the "Motor control-timer alarm" instruction:

SCL
<Instance>O_CMD:= <Operand>,
          C_CMD := <Operand>,
          S_CMD := <Operand>,
          O_FB := <Operand>,
          C_FB := <Operand>,
          00 => <Operand>,
          C0 => <Operand>,
          OA => <Operand>,
          CA => <Operand>,
          Q => <Operand>)

Parameter
The following table shows the parameters of the "Motor control-timer alarm" instruction:

Parameter Declaration Data type Description
O_CMD Input BOOL "Open" command input
C_CMD Input BOOL "Close" command input
S_CMD Input BOOL "Stop" command input
O_FB Input BOOL Feedback input when 

opening
C_FB Input BOOL Feedback input when 

closing
OO Output BOOL "Open" output
CO Output BOOL "Close" output
OA Output BOOL Alarm output when 

opening
CA Output BOOL Alarm output when 

closing
Q Output BOOL A signal state of "0" 

indicates an error 
condition.

ET Static DINT Currently elapsed time, 
where one count = 1 ms

PT Static DINT Preset time value, 
where one count = 1 ms

PREV_TIME Static DWORD Previous system time
O_HIS Static BOOL "Open" history bit
C_HIS Static BOOL "Close" history bit

For additional information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2609



Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

SCL
"MCAT_DB"(O_CMD := "Tag_Iput_O_CMD",
          C_CMD := "Tag_Input_C_CMD",
          S_CMD := "Tag_Input_S_CMD",
          O_FB := "Tag_Input_O_FB",
          C_FB := "Tag_Input_C_FB",
          OO => "Tag_OutputOpen",
          CO => "Tag_OutputClosed",
          OA => "Tag_Output_OA",
          CA => "Tag_Output_CA",
          Q => "Tag_Output_Q");

The following tables show how the instruction works using specific values:

Before processing

In this example the following values are used for the input and output parameters:

Parameter Operand Value
O_CMD Tag_Input_O_CMD TRUE
C_CMD Tag_Input_C_CMD FALSE
S_CMD Tag_Input_S_CMD FALSE
O_FB Tag_Input_O_FB FALSE
C_FB Tag_Input_C_FB FALSE
OO Tag_OutputOpen FALSE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q FALSE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#2
PT DBD8 L#22
O_HIS DBX16.0 TRUE
C_HIS DBX16.1 FALSE

After processing

The following values are written to the output parameters after the instruction has been 
executed:
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Parameter Operand Value
OO Tag_OutputOpen TRUE
CO Tag_OutputClosed FALSE
OA Tag_Output_OA FALSE
CA Tag_Output_CA FALSE
Q Tag_Output_Q TRUE

The following values are saved in the instance data block "MCAT_DB" of the instruction:

Parameter Address Value
ET DBD4 L#0
O_HIS DBX16.0 TRUE
CMD_HIS DBX16.1 FALSE

See also
Overview of the valid data types (Page 1320)

IMC: Compare input bits with the bits of a mask

Description
The "Compare input bits with the bits of a mask" instruction is used to compare the signal state 
of up to 16 programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bit of a mask. 
Up to 16 steps with masks can be programmed. The value of the IN_BIT0 parameter  is 
compared with the value of the mask CMP_VAL[x,0], with "x" indicating the step number. On 
the CMP_STEP parameter, you specify the step number of the mask that is used for the 
comparison.  All programmed values are compared in the same manner. Unprogrammed input 
bits or unprogrammed bits of the mask have a default signal state FALSE.

If a match is found in the comparison, the signal state of the OUT parameter is set to "1". 
Otherwise the OUT parameter is set to "0".

If the value of CMP_STEP parameter is greater than 15, the instruction is not executed. An 
error message is output at the ERR_CODE parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Compare input bits with the bits of a mask" instruction:

SCL
<Instance>(IN_BIT0 - 15 := <Operand>,
          CMP_STEP := <Operand>,
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SCL
          OUT => <Operand>,
          ERR_CODE => <Operand>)

Parameters
The following table shows the parameters of the "Compare input bits with the bits of a mask" 
instruction:

Parameter Declaration Data type Description
IN_BIT0 Input BOOL Input bit 0 is compared with bit 0 of the mask.
IN_BIT1 Input BOOL Input bit 1 is compared with bit 1 of the mask.
IN_BIT2 Input BOOL Input bit 2 is compared with bit 2 of the mask.
IN_BIT3 Input BOOL Input bit 3 is compared with bit 3 of the mask.
IN_BIT4 Input BOOL Input bit 4 is compared with bit 4 of the mask.
IN_BIT5 Input BOOL Input bit 5 is compared with bit 5 of the mask.
IN_BIT6 Input BOOL Input bit 6 is compared with bit 6 of the mask.
IN_BIT7 Input BOOL Input bit 7 is compared with bit 7 of the mask.
IN_BIT8 Input BOOL Input bit 8 is compared with bit 8 of the mask.
IN_BIT9 Input BOOL Input bit 9 is compared with bit 9 of the mask.
IN_BIT10 Input BOOL Input bit 10 is compared with bit 10 of the 

mask.
IN_BIT11 Input BOOL Input bit 11 is compared with bit 11 of the 

mask.
IN_BIT12 Input BOOL Input bit 12 is compared with bit 12 of the 

mask.
IN_BIT13 Input BOOL Input bit 13 is compared with bit 13 of the 

mask.
IN_BIT14 Input BOOL Input bit 14 is compared with bit 14 of the 

mask.
IN_BIT15 Input BOOL Input bit 15 is compared with bit 15 of the 

mask.
CMP_STEP Input BYTE The step number of the mask used for the 

comparison.
OUT Output BOOL A signal state of "1" indicates that a match 

was found.
A signal state of "0" indicates that no match 
was found.

ERR_CODE Output WORD Error information 
CMP_VAL Static ARRAY OF WORD Comparison masks [0 to 15, 0 to 15]: The first 

number of the index is the step number and 
the second number is the bit number of the 
mask.

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.
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ERR_CODE Parameter
The following table shows the meaning of the values of the ERR_CODE parameter:

Error code*
(W#16#...)

Explanation

0000 No error
000A The value at the CMP_STEP parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

SMC: Compare scan matrix

Description
You can use the "Compare scan matrix" instruction to compare the signal state of up to 16 
programmed input bits (IN_BIT0 to IN_BIT15) with the corresponding bit of the comparison 
masks for each step. Processing starts at step 1 and is continued until the last programmed 
step (LAST) or until a match is found. The input bit of the IN_BIT0 parameter is compared with 
the value of the mask CMP_VAL[x,0], with "x" indicating the step number. All programmed 
values are compared in the same manner. If a match is found the signal state of the OUT 
parameter is set to "1" and the step number with the matching mask is written in the OUT_STEP 
parameter. Unprogrammed input bits or unprogrammed bits of the mask have a default signal 
state FALSE. If more than one step has a matching mask, only the first one found is indicated 
in the OUT_STEP parameter. If no match is found, the signal state of the OUT parameter is 
set to "0". In this case the value at the OUT_STEP parameter is greater by "1" than the value 
at the LAST parameter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".

Syntax
The following syntax is used for the "Compare scan matrix" instruction:

SCL
<Instance>(IN_BIT0 - 15 := <Operand>,
          OUT => <Operand>,
          OUT_STEP => <Operand>,
          ERR_CODE => <Operand>)
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Syntax
The following table shows the parameters of the "Compare scan matrix" instruction:

Parameter Declaration Data type Description
IN_BIT0 Input BOOL Input bit 0 is compared with bit 0 of the mask.
IN_BIT1 Input BOOL Input bit 1 is compared with bit 1 of the mask.
IN_BIT2 Input BOOL Input bit 2 is compared with bit 2 of the mask.
IN_BIT3 Input BOOL Input bit 3 is compared with bit 3 of the mask.
IN_BIT4 Input BOOL Input bit 4 is compared with bit 4 of the mask.
IN_BIT5 Input BOOL Input bit 5 is compared with bit 5 of the mask.
IN_BIT6 Input BOOL Input bit 6 is compared with bit 6 of the mask.
IN_BIT7 Input BOOL Input bit 7 is compared with bit 7 of the mask.
IN_BIT8 Input BOOL Input bit 8 is compared with bit 8 of the mask.
IN_BIT9 Input BOOL Input bit 9 is compared with bit 9 of the mask.
IN_BIT10 Input BOOL Input bit 10 is compared with bit 10 of the 

mask.
IN_BIT11 Input BOOL Input bit 11 is compared with bit 11 of the 

mask.
IN_BIT12 Input BOOL Input bit 12 is compared with bit 12 of the 

mask.
IN_BIT13 Input BOOL Input bit 13 is compared with bit 13 of the 

mask.
IN_BIT14 Input BOOL Input bit 14 is compared with bit 14 of the 

mask.
IN_BIT15 Input BOOL Input bit 15 is compared with bit 15 of the 

mask.
OUT Output BOOL A signal state of "1" indicates that a match 

was found.
A signal state of "0" indicates that no match 
was found. 

OUT_STEP Output BYTE Contains the step number with the matching 
mask, or the step number which is greater by 
"1" than the value at the LAST parameter, 
provided no match is found.

ERR_CODE Output WORD Error information 
LAST Static BYTE Specifies the step number of the last step to 

be scanned for a matching mask.
CMP_VAL Static ARRAY OF WORD Comparison masks [0 to 15, 0 to 15]: The first 

number of the index is the step number and 
the second number is the bit number of the 
mask.

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.
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ERR_CODE Parameter
The following table shows the meaning of the values of the parameter ERR_CODE:

Error code*
(W#16#...)

Explanation

0000 No error
000E The value at the LAST parameter is greater than 15.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)

LEAD_LAG: Lead and lag algorithm 

Description
Use the "Lead and lag algorithm" instruction to process signals with an analog tag. The gain 
value at the GAIN parameter must be greater than zero. The result of the "Lead and lag 
algorithm" instruction is calculated using the following equation:

The instruction "Lead and lag algorithm" supplies plausible results only when processing is in 
fixed program cycles. The same units must be specified at the parameters LD_TIME, LG_TIME 
and SAMPLE_T. At LG_TIME > 4 + SAMPLE_T, the instruction approaches the following 
function:

OUT = GAIN * ((1 + LD_TIME * s) / (1 + LG_TIME * s)) * IN

When the value of the GAIN parameter is less than or equal to zero, the calculation is not 
performed and an error information is output on the ERR_CODE parameter.

You can use the "Lead and lag algorithm" instruction in conjunction with loops as a 
compensator in dynamic feed-forward control. The instruction consists of two operations. The 
"Lead" operation shifts the phase of output OUT so that the output leads the input. The "Lag" 
operation, on the other hand, shifts the output so that the output lags behind the input. Because 
the "Lag" operation is equivalent to an integration, it can be used as a noise suppressor or as 
a low-pass filter. The "Lead" operation is equivalent to a differentiation and can therefore be 
used as a high-pass filter. The two instructions together (Lead and Lag) result in the output 
phase lagging behind the the input at lower frequencies and leading it at higher frequencies. 
This means that the "Lead and lag algorithm" instruction can be used as a band pass filter.

When you insert the instruction in the program, the "Call options" dialog opens in which you 
can specify whether the block parameters will be stored in a separate data block (single 
instance) or as a local tag (multiple instance) in the block interface. If you create a separate 
data block, you will find it in the project tree in the "Program resources" folder under "Program 
blocks > System blocks". For more information on this topic, refer to "See also".
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Syntax
The following syntax is used for the "Lead and lag algorithm" instruction:

SCL
<Instance>(IN:= <Operand>,
          SAMPLE_T := <Operand>,
          OUT => <Operand>,
          ERR_CODE => <Operand>)

The following table shows the parameters of the instruction:

Parameter Declaration Data type Description
IN Input REAL The input value of the 

current sample time 
(cycle time) to be 
processed.
Constants can also be 
specified on the IN 
parameter.

SAMPLE_T Input INT Sample time
Constants can also be 
specified on the 
SAMPLE_T parameter.

OUT Output REAL Result of the instruction
ERR_CODE Output WORD Error information 
LD_TIME Static REAL Lead time in the same 

unit as sample time.
LG_TIME Static REAL Lag time in the same 

unit as sample time
GAIN Static REAL Gain as % / % (the ratio 

of the change in output 
to a change in input as 
a steady state).

PREV_IN Static REAL Previous input
PREV_OUT Static REAL Previous output

For more information on valid data types, refer to "See also".

The static parameters are not visible when calling the instruction in the program. These are 
saved in the instance of the instruction.
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ERR_CODE Parameter
The following table shows the meaning of the values of the parameter ERR_CODE:

Error code*
(W#16#...)

Explanation

0000 No error
0009 The value at the GAIN parameter is less than or equal to zero.
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more information on toggling 
display formats, refer to "See also".

Example
The following example shows how the instruction works:

 

 Note

You can initialize static parameters in the data block.
 

SCL
"LEAD_LAG_DB"(IN := "Tag_Input",
              SAMPLE_T := "Tag_Input_SAMPLE_T",
              OUT => "Tag_Output_Result",
              ERR_CODE => "Tag_ErrorCode");

The following tables show how the instruction works using specific values:

Before processing

In this example the following values are used for the input parameters:

Parameter Operand Value
IN Tag_Input 2.0
SAMPLE_T Tag_Input_SAMPLE_T 10

The following values are saved in the instance data block "LEAD_LAG_DB" of the instruction:

Parameter Address Value
LD_TIME DBD12 2.0
LG_TIME DBD16 2.0
GAIN DBD20 1.0
PREV_IN DBD24 6.0
PREV_OUT DBD28 6.0

After processing

The following values are written to the output parameters after the instruction has been 
executed:
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Parameter Operand Value
OUT Tag_Output_Result 2.0

The following values are saved in the instance data block "LEAD_LAD_DB" of the instruction:

Parameter Operand Value
PREV_IN DBD24 2.0
PREV_OUT DBD28 2.0

See also
Overview of the valid data types (Page 1320)

SEG: Create bit pattern for seven-segment display

Description
The "Create bit pattern for seven-segment display" instruction is used to convert each of the 
four hexadecimal digits of the specified source word (IN) into an equivalent bit pattern for a 7-
segment display.  The result of the instruction is output in the double word on the OUT 
parameter.

The following relation exists between the hexadecimal digits and the assignment of the 7 
segments (a, b, c, d, e, f, g):

Input digit 
(Binary)

Assignment of the 
segments
‑ g f e d c b a

Display
(Hexadecimal)

Seven-segment display

0000 00111111 0
0001 00000110 1
0010 01011011 2
0011 01001111 3
0100 01100110 4
0101 01101101 5
0110 01111101 6
0111 00000111 7
1000 01111111 8
1001 01100111 9
1010 01110111 A
1011 01111100 B
1100 00111001 C
1101 01011110 D
1110 01111001 E
1111 01110001 F
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Syntax
Use the following syntax for the "Create bit pattern for seven-segment display" instruction:

SCL
SEG(IN := <Operand>,
    OUT => <Operand>)

Parameter
The following table shows the parameters of the "Create bit pattern for seven-segment display" 
instruction:

Parameter Declaration Data type Description
IN Input WORD Source word with four 

hexadecimal digits
OUT Output DWORD Bit pattern for the seven-

segment display
Function value VOID Empty function value

Example
The following example shows how the instruction works:

SCL
SEG(IN := "Tag_Input",
    OUT => "Tag_Output");

The following table shows how the instruction works using specific operand values:

Parameter Operand Value
 Hexadecimal Binary
IN Tag_Input W#16#1234 0001 0010 0011 0100
OUT Tag_Output DW16#065B4F66 00000110 01011011 01001111 

01100110
Display: 1234

See also
Overview of the valid data types (Page 1320)
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BCDCPL: Create tens complement

Description
The "Create tens complement" instruction is used to create the tens complement of a seven-
digit BCD number specified by the operand. This instruction uses the following mathematical 
formula to calculate:

10000000 (as BCD)

– 7-digit BCD value

----------------------------------------

Tens complement (as BCD)

Syntax
The following syntax is used for the "Create tens complement" instruction:

SCL
BCDCPL(<Operand>)

Parameter
The following table shows the parameters of the "Create tens complement" instruction:

Parameter Declaration Data type Description
<Operand> Input Bit strings 7-digit BCD number
Function value DWORD Result of the instruction

For additional information on valid data types, refer to "See also".

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := BCDCPL("Tag_Input");

The following table shows how the instruction functions using specific values:

Operand Value*
Tag_Input DW#16#01234567
Tag_Result DW#16#08765433
*The error codes can be displayed as integer or hexadecimal value in the program editor. For 
information on toggling display formats, refer to "See also".
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See also
Overview of the valid data types (Page 1320)

BITSUM: Count number of set bits

Description
The "Count number of set bits" instruction is used to count the number of bits of an operand 
that are set to the signal state "1".

Syntax
The following syntax is used for the "Count number of set bits" instruction:

SCL
BITSUM(<Operand>)

Parameter
The following table shows the parameters of the "Count number of set bits" instruction:

Parameter Declaration Data type Description
<Operand> Input DWORD Operand whose set bits 

are counted
Function value INT Result of the instruction

Example
The following example shows how the instruction works:

SCL
"Tag_Result" := BITSUM("Tag_Input");

The following table shows how the instruction functions using specific values:

Operand Value*
Tag_Input DW#16#12345678
Tag_Result W#16#000D (13 bits)
*The error codes can be displayed as integer or hexadecimal value in the program editor. For more 
information on toggling display formats, refer to "See also".

See also
Overview of the valid data types (Page 1320)
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9.7.3 Extended instructions

9.7.3.1 Date and time-of-day

T_COMP: Compare time tags

Description
This instruction is used to compare the contents of two tags of the data types "Timers" or "Date 
and time". 

The instruction supports comparisons of the following data types: DATE, TIME, LTIME, TOD 
(TIME_OF_DAY), LTOD (LTIME_OF_DAY), DT (DATE_AND_TIME), LDT 
(DATE_AND_LTIME), DTL, S5Time.

The data types must be the same length and format to carry out the comparison.

The comparison result is output at the OUT parameter as a return value. For this purpose, the 
parameter OUT is set to "1" if the condition used for the comparison is satisfied.

The following comparison options can be used:

Symbol Description
EQ The return value has the signal state “1" if the time is the same at the parameter IN1 and IN2.
NE The return value has the signal state “1" if the time at parameters IN1 and IN2 is not identical.
GE The return value has the signal state "1" if the time at parameter IN1 is greater (more recent) than or equal 

to the time at parameter IN2 .
LE The return value has the signal state "1" if the time at parameter IN1 is less (less recent) than or equal to 

the time at parameter IN2.
GT The return value has the signal state “1" if the time at parameter IN1  is greater (more recent) than the time 

at parameter IN2.
LT The return value has the signal state "1" if the time at parameter IN1  is less (less recent) than the time at 

parameter IN2 .

Parameters
The following table shows the parameters of the instruction "T_COMP":

Parameter Declaration Data type Memory area Description
IN1 Input DATE, TIME, LTIME, 

TOD, LTOD, DT, 
LDT, DTL

I, Q, M, D, L, P or 
constant

First value to be compared.

IN2 Input DATE, TIME, LTIME, 
TOD, LTOD, DT, 
LDT, DTL

I, Q, M, D, L, P or 
constant

Second value to be compared.

OUT Output BOOL I, Q, M, D, L, P Return value

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".
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T_CONV: Convert times and extract

Description
You use the instruction "T_CONV" to convert the data type of the IN input parameter to the 
data type that is output at the OUT output. You select the data formats for the conversion from 
the instruction boxes of the input and output.

Parameters
The following table shows the parameters of the instruction "T_CONV". If an input and output 
parameter of the same data type is used, the instruction copies the corresponding value.

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input Integers, TIME, 
date and time*

WORD, 
integers, 
timers, date 
and time*

I, Q, M, D, L, P or 
constant

Value to be converted

OUT Return Integers, TIME, 
date and time*

WORD, 
integers, 
timers, date 
and time*

I, Q, M, D, L, P Result of the conversion

* The range of supported data types depends on the CPU. Please refer to the overviews of valid data types for information 
on the data types supported by the S7-1200 and S7-1500 modules.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

T_ADD: Add times

Description
You use this instruction to add the time information in the IN1 input to the time information in 
the IN2 input. You can query the result in the OUToutput parameter. You can add the following 
formats:

● Addition of a time period to another time period.
Example: Addition of a TIME data type to another TIME data type.

● Addition of a time period to a time.
Example: Addition of a TIME data type to the DTL data type.

The data type for the value at input parameter IN1 and output parameter OUT is defined by 
the selection in the instruction boxes of the input and output. You can only specify time 
information in TIME format in the IN2 input parameter (for S7-1500 modules also LTIME). 
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Parameters
The following tables show the parameters of the "T_ADD" instruction, according to the possible 
conversions:

Table 9-34 Addition of a time period to another time period

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input
 

TIME TIME, LTIME I, Q, M, D, L, P or 
constant

First number to be added

IN2 Input TIME TIME, LTIME I, Q, M, D, L, P or 
constant

Second number to be added

OUT Return DINT, 
DWORD, 
TIME, TOD

TIME, LTIME, I, Q, M, D, L, P Result of addition
The data type selection depends on 
the data types selected for the IN1 
and IN2 input parameters.

Table 9-35 Addition of a time period to a time

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DTL, TOD DT, TOD, 
LTOD, LDT, 
DTL

I, Q, M, D, L, P or 
constant

First number to be added

IN2 Input TIME TIME, LTIME I, Q, M, D, L, P or 
constant

Second number to be added

OUT Return DINT, 
DWORD, 
TIME, TOD, 
UDINT, DTL

DT, DTL, 
LDT, TOD,  
LTOD

I, Q, M, D, L, P Result of addition
The data type selection depends on 
the data types selected for the IN1 
and IN2 input parameters.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

T_SUB: Subtract times

Description
You use this instruction to subtract the time information in the IN2 input parameter from the 
time information in the IN1 input parameter. You can query the difference in the OUT output 
parameter. You can subtract the following formats:

● Subtraction of a time period from another time period
Example: Subtraction of a time period of the data type TIME from another time period of 
the data type TIME. The result can be output to a tag with the TIME format.

● Subtraction of a time period from a time
Example: Subtraction of a time period of the data type TIME from a time of the data type 
DTL. The result can be output to a tag with the DTL format.
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You decide the formats of the values in the IN1 input parameter and the OUT output parameter 
by selecting the data types for the input and output parameters of the instruction.

Parameters
The following tables show the parameters of the "T_SUB" instruction, according to the possible 
conversions:

Table 9-36 Subtraction of a time period from another time period

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input TIME TIME, LTIME I, Q, M, D, L, P or 
constant

Minuend

IN2 Input TIME TIME, LTIME I, Q, M, D, L, P or 
constant

Subtrahend

OUT Return DINT, DWORD, 
TIME, TOD, 
UDINT

TIME, LTIME I, Q, M, D, L, P Result of subtraction

Table 9-37 Subtraction of a time period from a time

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DTL, TOD TOD, LTOD, DTL, 
DT, LDT

I, Q, M, D, L, P or 
constant

Minuend

IN2 Input TIME TIME, LTIME I, Q, M, D, L, P or 
constant

Subtrahend

OUT Return DTL, DINT, 
DWORD, TIME, 
TOD, UDINT

TOD, LTOD, DTL, 
DT, LDT

I, Q, M, D, L, P Result of subtraction

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

T_DIFF: Time difference

Description
You use this instruction to subtract the time information in the IN2 input parameter from the 
time information in the IN1 input parameter. The result is sent at output parameter OUT.

● If the time information at the IN2 input parameter is greater than the time information at the 
IN1 input parameter, the result is output as a negative value at the OUT output parameter.

● If the result of the subtraction is outside the TIME range, the result is set to "0" (0:00) and 
the enable output ENO = "0".
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Parameters
The following table shows the parameters of the "T_DIFF" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DTL, DATE, 
TOD

DTL, DATE, DT, 
TOD, LTOD, 
LDT

I, Q, M, D, L, P or 
constant

Minuend

IN2 Input DTL, DATE, 
TOD

DTL, DATE, DT, 
TOD, LTOD, 
LDT

I, Q, M, D, L, P or 
constant

Subtrahend

OUT Return TIME, INT TIME, LTIME, 
INT

I, Q, M, D, L, P Difference of input parameters

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

T_COMBINE: Combine times

Description     
The instruction combines the value of a date with the value of a time and converts this into a 
combined date and time value.

● The date is output at the input parameter IN1. A value of between 1990-01-01 and 
2089-12-31 must be used for the data type DATE (this is not checked).

● The time is input at the IN2 input value (TOD/LTOD data type).

● The combined data type for the date and time value is output at the OUT output value.

Parameters
The following table shows the parameters of the instruction "T_COMBINE":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input DATE DATE I, Q, M, D, L, P or 
constant

Input tag of the date

IN2 Input TOD TOD, LTOD I, Q, M, D, L, P or 
constant

Input tag of the time

OUT Return DTL DT, DTL, LDT I, Q, M, D, L, P Return value of the date and time

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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Time-of-day functions

WR_SYS_T: Set time-of-day

Description
You use this instruction to set the date and time-of-day of the CPU clock. Enter the date and 
time-of-day at the input parameter IN . The value must be in the following range:

● With DT: min. DT#1990-01-01-0:0:0, max. DT#2200-12-31-23:59:59.999

● With LDT: min. LDT#1970-1-1-0:0:0.000000000, max. 
LDT#2200-12-31-23:59:99.999999999

● With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2200-12-31-23:59:59.999999999

You can query whether errors have occurred during execution of the instruction in the 
RET_VAL output parameter.

The "WR_SYS_T" instruction cannot be used to pass information about the local time zone or 
daylight saving time.

Parameters
The following table shows the parameters of the "WR_SYS_T" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input DTL DT, DTL, LDT I, Q, M, D, L, P or 
constant *

Date and time

RET_VAL Return INT INT I, Q, M, D, L, P Status of the instruction
* The data types DT and DTL cannot be used for the following memory areas: import, output and bit memory.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*
(W#16#....) 

Description

0000 No error
8080 Error in date
8081 Error in time
8082 Month invalid
8083 Day invalid
8084 Hour information invalid
8085 Minute information invalid
8086 Second information invalid
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Error code*
(W#16#....) 

Description

8087 Nanosecond information invalid
80B0 The real-time clock has failed
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RD_SYS_T: Read time-of-day

Description
You use this instruction to read out the current date and current time-of-day of the CPU clock.

The read out dates are output at the OUT output parameter of the instruction. The provided 
value does not include information about the local time zone or daylight saving time.

You can query whether errors have occurred during execution of the instruction in the 
RET_VALoutput.

Parameters
The following table shows the parameters of the "RD_SYS_T" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

RET_VAL Return INT INT I, Q, M, D, L, P Status of the instruction
OUT Output DTL DT, DTL, LDT I, Q, M, D, L, P Date and time of CPU

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*
(W#16#....) 

Description

0000 No error
8081 Time value specified at the OUT parameter is outside the valid value range:

● With DT: min. DT#1990-01-01-0:0:0, max. DT#2200-12-31-23:59:59.999
● With LDT: min.  LDT#1970-1-1-0:0:0.000000000, max. LDT#2200-12-31-23:59:59.999999999
● With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2200-12-31-23:59:59.999999999

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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RD_LOC_T: Read local time

Description
You use this instruction to read the current local time from the CPU clock and output this at 
the OUT output. Information on the time zone and the start of daylight saving time and standard 
time, which you have set in the configuration of the CPU clock, is used to output the local time.

Parameter
The following table shows the parameters of the "RD_LOC_T" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

RET_VAL Return INT INT I, Q, M, D, L, P Status of the instruction
OUT Output DTL DT, LDT, DTL I, Q, M, D, L, P Local time

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

RET_VAL parameter

Error code*
(W#16#....) 

Description

0000 No error
0001 No error. Local time is output as daylight saving time.
8080 Local time cannot be read.
8081 Time value specified at the OUT parameter is outside the valid value range:

● With DT: min. DT#1990-01-01-0:0:0, max. DT#2089-12-31-23:59:59.999
● With LDT: min. LDT#1970-1-1-0:0:0.000000000, max. LDT#2200-12-31-23:59:99.999999999
● With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2200-12-31-23:59:59.999999999

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

WR_LOC_T: Write local time

Description
The instruction "WR_LOC_T" is used to set the date and time of the CPU clock. Enter the date 
and time-of-day as local time at the input parameter LOCTIME.

The value must be in the following range:
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● With DT: min. DT#1990-01-01-00:00:00, max. DT#2089-12-31-23:59:59.999

● With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2200-12-31-23:59:59.999999999

● With LDT: min. LDT#1970-1-1-0:0:0.000000000, max. 
LDT#2200-12-31-23:59:59.999999999

The granularity of the time information for local time and system time is product-specific and 
is at least one millisecond. Input values at the LOCTIME parameter which are less than those 
supported by the CPU are rounded up during system time calculation.

You can query whether errors have occurred during execution of the instruction in the 
RET_VAL output parameter.

Use of WR_LOC_T during the time change to daylight savings or standard time
● Changeover from standard to daylight saving time

In the following it is assumed that the time of the changeover is 2:00 am, and that the time 
is moved forward by one hour. This means there is no hour between 02:00:00:000000000 
AM and 02:59:59:999999999 AM.
When you specify a corresponding time for LOCTIME, the error code W#16#8089 is 
generated.
DST is irrelevant.

● Changeover from daylight saving to standard time
In the following it is assumed that the time of the changeover is 3:00 am, and that the time 
is moved back by one hour. This means there are two hours between 02:00:00:000000000 
AM and 02:59:59:999999999 AM.
For all times for LOCTIME that are between 02:00:00:000000000 AM and 
02:59:59:999999999 AM, you therefore need to declare whether the time is before or after 
the time changeover. The DST parameter is used for this:

– With DST=TRUE, the time is in the first of the two hours, i.e. still in daylight savings time.

– With DST=FALSE, the time is in the second of the two hours, i.e. in standard time.

For all times for LOCTIME that are outside the double hour, DST is irrelevant.
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Parameters
The following table shows the parameters of the "WR_LOC_T" instruction:

Parameter
 

Declaration Data type Memory area Description
S7-1200 S7-1500

LOCTIME Input DTL DT, DTL, 
LDT

D, L, P or constant Local time

DST Input BOOL BOOL I, Q, M, D, L, P, T, 
C or constant

Daylight Saving Time
Is only evaluated during the "double 
hour" at changeover to standard time.
● TRUE = daylight saving time (first 

hour)
● FALSE = standard time (second 

hour)
RET_VAL Return INT INT I, Q, M, D, L, P Error message (see "RET_VAL 

parameter")

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

RET_VAL parameter

Error code*
(W#16#....) 

Description

0000 No error.
8080 The LOCTIME parameter has an invalid value.
8081 Time value specified at the LOCTIME parameter is outside the valid value range:

● With DT: min. DT#1990-01-01-00:00:00, max. DT#2089-12-31-23:59:59.999
● With DTL: min. DTL#1970-01-01-00:00:00.0, max. DTL#2200-12-31-23:59:59.999999999
● With LDT: min. LDT#1970-1-1-0:0:0.000000000, max. LDT#2200-12-31-23:59:59.999999999

8082** Invalid value specified for the month (byte 2 in DTL format).
8083** Invalid value specified for the day (byte 3 in DTL format).
8084** Invalid value specified for the hour (byte 5 in DTL format).
8085** Invalid value specified for the minute (byte 6 in format DTL).
8086** Invalid value specified for the second (byte 7 in DTL format).
8087** Invalid value specified for the nanosecond (byte 8 to 11 in DTL format).
8089 Time value does not exist (hour already passed upon changeover to daylight saving time).
80B0 The real-time clock has failed.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
** Only for local time information at the LOCTIME parameter in DTL format.
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SET_TIMEZONE: Set time zone

Description
Use the instruction "SET_TIMEZONE" to set the parameter for the local time zone and the 
daylight saving / standard time changeover.

The settings which are carried out with the instruction "SET_TIMEZONE" correspond with the 
settings for the time-of-day in the properties of the CPU. Define the corresponding parameters 
in the system data type TimeTransformationRule for execution of the instruction 
"SET_TIMEZONE".

The local time is calculated based on the system time using the settings for the time zone and 
the daylight saving / standard time changeover. The system time of the CPU is the UTC time. 
The system time is used exclusively for communication within the system.

Parameters
The following table shows the parameters of the "SET_TIMEZONE" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, P or 

constant
Setting the parameters which are stored at 
the parameter TimeZone.

TimeZone Input Time Transformation 
Rule (Page 2633) 

D, L Store the parameters for the local time zone 
and the daylight saving / standard time 
changeover in the system data type 
TimeTransformationRule. 

DONE Output BOOL I, Q, M, D, L, P Status parameter:
● 0: Job not yet started or is still executing
● 1: Job completed error-free

BUSY Output BOOL I, Q, M, D, L, P Status parameter:
● 0: Job not yet started or already 

completed
● 1: Job not yet completed. A new job 

cannot be started.
ERROR Output BOOL I, Q, M, D, L, P Status parameter:

● 0: No error
● 1: Error occurred

STATUS Output DINT, DWORD, 
UDINT, WORD

I, Q, M, D, L, P Detailed error and status information is 
output at the parameter STATUS. The 
parameter is only set for the duration of one 
call. To display the status, you should 
therefore copy the STATUS parameter to a 
free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter STATUS

Error code*
(W#16#....) 

Description

7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
808x Incorrect input at the xth parameter of the system data type TimeTransformationRule.

Example: Error code 8084 corresponds with an incorrect input at the 4th parameter (DaylightStartWeek). 
Only the values 1 to 5 are valid here.

80C3 Temporary resource error: The CPU is currently processing the maximum possible number of 
simultaneous block calls. "SET_TIMEZONE" cannot be executed unless at least one of the block calls is 
finished.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TimeTransformationRule

Description
The times for changeover to daylight saving time and standard time are defined with the system 
data type TimeTransformationRule. 

The following options are available for creating the structure TimeTransformationRule:

● Create a new data block and select  as the type TimeTransformationRule.

● Enter TimeTransformationRule as the Data type in an existing data block or a local interface 
of a function block.

The structure is as follows:

Name Data type Description
TimeTransformationRule STRUCT  
 
 
 
 
 
 
 
 
 
 
 
 
 

Bias INT Time difference between the local time and the system time (UTC) in 
minutes.

DaylightBias INT The time difference between standard and daylight saving time in minutes.
Time specification for change to daylight saving time. The following times always refer to the local time.
DaylightStartMonth USINT Month in which change is made to daylight saving time:

1 = January
2 = February
3 = March
...
12 = December
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Name Data type Description
DaylightStartWeek USINT Week in which change is made to daylight saving time. 

1 = First occurrence of the weekday in the month
...
5 = Last occurrence of the weekday in the month

DaylightStartWeekday USINT Weekday on which change is made to daylight saving time: 
1 = Sunday

DaylightStartHour USINT Hour in which change is made to daylight saving time
DaylightStartMinute USINT Minute in which change is made to daylight saving time
Time when change is made to standard time, the following times always refer to the local time.
StandardStartMonth USINT Month in which change is made to standard time: 

1 = January
2 = February
3 = March
...
12 = December

StandardStartWeek USINT Week in which change is made to standard time:  
1 = First occurrence of the weekday in the month
...
5 = Last occurrence of the weekday in the month

StandardStartWeekday USINT Weekday on which change is made to standard time: 
1 = Sunday

StandardStartHour USINT Hour in which change is made to standard time
StandardStartMinute USINT Minute in which change is made to standard time
TimeZoneName STRING[80] Name of the time zone, for example: "(GMT+01:00) Amsterdam, Berlin, 

Bern, Rome, Stockholm, Vienna"

SNC_RTCB: Synchronize slave clocks

Definition: Synchronization of slave clocks     
The synchronization of clock slaves refers to the transfer of the date and time-of-day from the 
clock master of a bus segment to all clock slaves of this bus segment.

Description
You use this instruction to synchronize all slave clocks present on a bus segment independent 
of the assigned synchronization interval. Successful synchronization is only possible if 
"SNC_RTCB" is called on a CPU whose real-time clock was assigned as the master clock for 
at least one bus segment.
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Parameters
The following table shows the parameters of the "SNC_RTCB" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Output INT I, Q, M, D, L If an error occurs while the instruction is 

being executed, the return value contains 
an error code.

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred during synchronization.
0001 The existing clock was not assigned the master clock function for 

any of the bus segments.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TIME_TCK: Read system time

Description      
With the "TIME_TCK" instruction, you read the system time of the CPU. The system time is a 
time counter that counts from 0 to a maximum of 2147483647 ms. In case of an overflow, the 
system time is counted again starting with "0". The time scale and the accuracy of the system 
time is 1 ms. The system time is only influenced by the operating modes of the CPU. You can 
use the system time, for example, to measure the duration of processes by comparing the 
results of two "TIME_TCK" calls. The instruction does not provide any error information.

The following table provides an overview of how the system time changes depending on the 
operating modes of the CPU.

Mode System time ...
Startup ... is constantly updated
RUN  
STOP ... is stopped and retains the current value
Warm restart ... is deleted and restarts with "0"
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Parameter
The following table shows the parameters of the instruction "TIME_TCK":

Parameters Declaration Data type Memory area Description
RET_VAL Return TIME I, Q, M, D, L The RET_VAL  parameter contains 

the read system time in the range 
from 0 to 231 -1 ms.

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

RTM: Runtime meters

Description
You can use this instruction to set, start, stop, and read out a 32-bit runtime meter of your CPU.

Ensure that the runtime meter can also be stopped or restarted during execution of the user 
program, which may render the saved values incorrect.

Parameters
The following table shows the parameters of the "RTM" instruction:

Parameter Declaration Data type Memory area Description
NR Input RTM I, Q, M, D, L or 

constant
Number of the runtime meter
Numbering starts with 0.
For information on the number of runtime meters 
of your CPU, refer to the technical data.

MODE Input BYTE I, Q, M, D, L or 
constant

Job ID:
● 0: Read out (the status is then written to CQ 

and the current value to CV). After the 
runtime meter has reached (2E31) -1 hours, 
it stops at the highest value that can be 
displayed and outputs an "Overflow" error 
message.

● 1: start (at the last counter value)
● 2: stop
● 4: set (to the value specified in PV)
● 5: set (to the value specified in PV) and then 

start
● 6: set (to the value specified in PV) and then 

stop
PV Input DINT I, Q, M, D, L or 

constant
New value for the runtime meter
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Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 

executed, the return value contains an error 
code.

CQ Output BOOL I, Q, M, D, L Status of the runtime meter (1: running)
CV Output DINT I, Q, M, D, L Current value of the runtime meter

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code
(W#16#...)

Explanation

0000 No error
8080 Wrong number for the runtime meter
8081 A negative value was passed to the PV parameter.
8082 Overflow of the runtime meter
8091 The MODE  input parameter contains an invalid value.
General error 
information

See also: Evaluating errors with GET_ERR_ID (Page 2578) 

9.7.3.2 String + Char

S_MOVE: Move character string

Description
You can use this instruction to move the content of a string (W)STRING. The string in the IN 
input parameter is copied to the OUT output parameter.

The tags at the input parameter IN and the output OUT must have the same data type.

You can use the "MOVE_BLK" and "UMOVE_BLK" instructions to copy tags of data type 
ARRAY.

Parameters
The following table shows the parameters of the "S_MOVE" instruction:

Parameters Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input STRING STRING, 
WSTRING

D, L or constant Source string

OUT Output STRING STRING, 
WSTRING

D, L or constant Destination string
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You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

S_COMP: Compare character strings

Description
The instruction compares the contents of two tags in the STRING  format and outputs the result 
of the comparison as a return value. The tags that are to be compared will be interconnected 
at the IN1 and IN2  inputs. You can only assign a symbolically defined tag for the input 
parameters.

Use the instruction box to select the comparison condition. If the comparison condition (for 
example, greater than or equal to) is satisfied, the signal state is set to "1" at the output 
parameter OUT .

The following comparison options can be used:

Symbol Description
EQ The return value has the signal state "1" if the string at the IN1 parameter is the same as 

the string at the IN2  parameter.
NE The return value has the signal state "1" if the string at the IN1  parameter is not equal to 

the string at the IN2  parameter.
GT (1) The return value has the signal state “1" if the string at the IN1  parameter is greater than 

the string at the IN2  parameter.
LT (1) The return value has the signal state "1" if the string at the IN1  parameter is less than the 

string at the IN2  parameter.
GE (1) The return value has the signal state "1" if the string at the IN1  parameter is greater than 

or equal to the string at the IN2  parameter. 
LE (1) The return value has the signal state "1" if the string at the IN1  parameter is less than or 

equal to the string at the IN2  parameter.
(1) The characters are compared by their ASCII code (for example, 'a' is greater than 'A'), starting from 
the left. The first character to be different decides the result of the comparison. If the first characters 
are the same, the longer string is greater.

Parameters
The following table shows the parameters of the "S_COMP" instruction:

Parameters Declaration Data type Memory area Description
IN1 Input STRING* D, L or constant Input tag in the STRING 

format.
IN2 Input STRING* D, L or constant Input tag in the STRING 

format.
OUT Output BOOL I, Q, M, D, L Result of comparison
* Define the maximum length of the character string if you use the data type STRING in the interface 
declaration for a temporary tag (you will find further information in the description of the data type).
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

S_CONV: Convert character string

Description
You use this instruction to convert the value at the IN input to the data format you have specified 
in the OUT output. You decide the output format of the conversion by selecting a data type for 
the OUT output parameter.

The following conversions are possible:

● Conversion of a character string (STRING) to:

– Numerical value (integer or floating-point number)
The conversion is performed for all characters of the character string specified in the IN 
input parameter. Permitted characters are the digits "0" to "9", the decimal point, and 
the plus and minus signs. The first character of the string may be a valid number or a 
sign. Leading spaces and exponential notations are ignored.

– A character (CHAR)
The first character of the character string is transferred to the parameter OUT when a 
character string is converted to a character (CHAR).

● Conversion of a numerical value or character to a character string (STRING):

– You decide the format of the numeric value to be converted by selecting a data type for 
the IN input. A valid tag of the STRING data type must be specified in the OUT output. 
The length of the character string after conversion depends on the value at the IN input. 

– The conversion result is saved as a string starting at the third byte. The first byte of the 
string records the maximum length and the second byte the actual length of the character 
string. Positive numeric value are output without a sign.

– When you convert zero (e.g. INT_TO_STRING(0)), the string will be 6 characters long.

– The first character of the character string is filled with spaces when converting to a 
numerical value. The number of spaces depends on the length of the numerical value.

– The character is written at the first position in the character string when converting to a 
character (CHAR).

 

  Note
Exponential notation during conversion from floating-point numbers

Do not use exponential notation ("e" or "E") for the conversion from floating-point numbers 
with the instruction "S_CONV". Instead, use the instruction "STRG_VAL (Page 2640)" for 
the conversion of floating-point numbers with exponential notation. You can use the 
FORMAT parameter of the instruction to select exponential notation as input format.

 

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2639



Parameters
The following tables show the parameters of the "S_CONV" instruction, according to the 
possible conversions:

Table 9-38 Parameters for converting a character string to a numeric value:

Parameters Declaration Data type Memory area Description
IN Input STRING D, L or constant Value to be converted
OUT Output CHAR, USINT, 

UINT, UDINT, 
ULINT, SINT, INT, 
DINT, LINT, 
REAL, LREAL

I, Q, M, D, L Result of the conversion

Table 9-39 Parameter when converting a numerical value or character to a character string:

Parameter Declaration Data type Memory area Description
IN Input CHAR, USINT, 

UINT, UDINT, 
ULINT, SINT, INT, 
DINT, LINT, 
REAL, LREAL

I, Q, M, D, L or constant Value to be converted

OUT Output STRING D, L Result of the conversion

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

STRG_VAL: Convert character string to numerical value

Description
The instruction "STRG_VAL" converts a character string to an integer or a floating-point 
number:

● You specify the character string to be converted in the IN input parameter.

● You define the format of the output value by selecting a data type for the OUT output 
parameter.

Permitted characters for the conversion are the digits "0" to "9", the decimal point, the decimal 
comma, notations "E" and "e", and the plus and minus characters. The conversion can be 
interrupted by invalid characters.

The "STRG_VAL" instruction is not supported by the SCL programming language.
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Parameters
The following table shows the parameters of the "STRG_VAL" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input STRING STRING, 
WSTRING

D, L or constant Numeric character string to 
be converted

FORMAT Input WORD WORD I, Q, M, D, L, P or 
constant

Output format of the 
characters

P Input UINT UINT I, Q, M, D, L, P or 
constant

Reference to the first 
character to be converted 
(first character = 1, the value 
"0" or a value > length of the 
string is invalid)

OUT Output USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
REAL, LREAL

USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
ULINT, LINT, 
REAL, LREAL

I, Q, M, D, L, P Result of the conversion

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

FORMAT parameter
You use the FORMAT parameter to specify how the characters of a character string are to be 
interpreted. Exponential values can also be converted and represented with the "STRG_VAL" 
instruction.

The following table shows the possible values of the FORMAT parameter and their meaning:

Value
(W#16#....)

Notation Decimal representation

0000 Decimal fraction "."
0001 ","
0002 Exponential "."
0003 ","
0004 to FFFF Invalid values

P parameter
The conversion starts at the character whose position you specified in the P parameter. If, for 
example, the value "1" is specified in the P parameter, the conversion starts at the first 
character of the specified character string.
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Example
The following table shows examples of the conversion of a character string to a numeric value:

IN (STRING) FORMAT 
(W#16#....)

OUT (data type) OUT (value) ENO status

'123' 0000 INT/DINT 123 1
'-00456' 0000 INT/DINT -456 1
'123.45' 0000 INT/DINT 123 1
'+2345' 0000 INT/DINT 2345 1
'00123AB' 0000 INT/DINT 123 1
'123' 0000 REAL 123.0 1
'-00456' 0001 REAL -456.0 1
'+00456' 0001 REAL 456.0 1
'123.45' 0000 REAL 123.45 1
'123.45' 0001 REAL 12345.0 1
'123,45' 0000 REAL 12345.0 1
'123,45' 0001 REAL 123.45 1
'.00123AB' 0001 REAL 123.0 1
'1.23e-4' 0000 REAL 1.23 1
'1.23E-4' 0000 REAL 1.23 1
'1.23E-4' 0002 REAL 1.23E-4 1
'12,345.67' 0000 REAL 12345.67 1
'12,345.67' 0001 REAL 12.345 1
'3.4e39' 0002 REAL W#16#7F800000 1
'-3.4e39' 0002 REAL W#16#FF800000 1
'1.1754943e-38' 0002 REAL 0.0 1
'12345' -/- SINT 0 0
'A123' -/- -/- 0 0
'' -/- -/- 0 0
'++123' -/- -/- 0 0
'+-123' -/- -/- 0 0

VAL_STRG: Convert numerical value to character string

Description
The "VAL_STRG" instruction is used to convert a numerical value into a character string.

● You specify the value to be converted in the IN input parameter. You decide the format of 
the numeric value by selecting a data type.

● You query the result of the conversion in the OUT output parameter.

Permitted characters for the conversion are the digits "0" to "9", the decimal point, the decimal 
comma, notations "E" and "e", and the plus and minus characters. The conversion can be 
interrupted by invalid characters.
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The "VAL_STRG" instruction is not supported by the SCL programming language.

Parameters
The following table shows the parameters of the "VAL_STRG" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN Input USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
REAL, LREAL

USINT, SINT, 
UINT, INT, 
UDINT, DINT, 
ULINT, LINT, 
REAL, LREAL

I, Q, M, D, L, P or 
constant

Value to be converted

SIZE Input USINT USINT I, Q, M, D, L, P or 
constant

Number of character 
positions

PREC Input USINT USINT I, Q, M, D, L, P or 
constant

Number of decimal places

FORMAT Input WORD WORD I, Q, M, D, L, P or 
constant

Output format of the 
characters

P InOut UINT UINT I, Q, M, D, L, P or 
constant

Character starting at which 
the result is written.

OUT Output STRING STRING, 
WSTRING

D, L Result of the conversion

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

P parameter
With the P parameter, you specify the character in the string starting at which the result is 
written. If, for example, the value "2" is specified in the P parameter, the converted value is 
saved starting at the second character of the string. 

SIZE and P parameters
Use the SIZE parameter to specify how many characters of the character string will be written. 
This is counted starting from the character specified in the P parameter. If the output value is 
shorter than the specified length, the result is written to the character string right-justified. The 
empty character positions are filled with blanks.

FORMAT parameter
Use the FORMAT parameter to specify how the numerical value is interpreted during 
conversion and written to the character string. You can specify only tags of the FORMAT data 
type in the USINT parameter.

The following table shows the possible values of the FORMAT parameter and their meaning: 
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Value
(W#16#....)

Notation Sign Decimal representation

0000 Decimal fraction "-" "."
0001 ","
0002 Exponential "."
0003 ","
0004 Decimal fraction "+" and "-" "."
0005 ","
0006 Exponential "."
0007 ","
0008 to FFFF Invalid values

PREC parameter
Use the PREC parameter to define the number of decimal places when converting floating-
point numbers. A maximum precision of seven numbers is supported for numerical values of 
the REAL data type. If the value to be converted is an integer, you use the PREC parameter 
to specify the position where the decimal point will be placed.

Example
The following table shows examples of the conversion of numeric values to a character string.

IN (value) IN (data type) P SIZE FORMAT (W#16#....) PREC OUT (STRING) ENO status
123 UINT 16 10 0000 0 xxxxxxx123 C 1
0 UINT 16 10 0000 2 xxxxxx0.00 C 1
12345678 UDINT 16 10 0000 3 x12345.678 C 1
12345678 UDINT 16 10 0001 3 x12345.678 C 1
123 INT 16 10 0004 0 xxxxxx+123 C 1
-123 INT 16 10 0004 0 xxxxxx-123 C 1
-0.00123 REAL 16 10 0004 4 xxx-0.0012 C 1
-0.00123 REAL 16 10 0006 4 -1.2300E-3 C 1
-Inf 1) REAL 16 10 -/- 4 xxxxxx-INF C 0
+Inf 2) REAL 16 10 -/- 4 xxxxxx+INF C 0
NaN 3) REAL 16 10 -/- 4 xxxxxxxNaN C 0
12345678 UDINT 16 6 -/- 3 xxxxxxxxxx C 0
"x" represents blanks
1)-Inf: Floating-point number representing a negative infinite value.
2)+Inf: Floating-point number representing a positive infinite value.
3)NaN: Value returned as the result of invalid math operations.
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Strg_TO_Chars: Convert character string to Array of CHAR

Description
Use the instruction to copy a character string (W)STRING into a structure of the data type 
Array of CHAR or  Array of BYTE. Only ASCII characters are valid for the copy process.

● Specify the character string at the input parameter STRG.

● The characters are written to a data type Array of CHAR / BYTE  at the parameter CHARS.

– The number of characters in the structure Array of CHAR / BYTE should be at least the 
same number as were copied from the character string STRING.

– If the structure Array of CHAR / BYTE contains less characters than in the character 
string then the characters are written up to the maximum length of the Array of CHAR / 
BYTE.

– If the character string contains a character "$00" then the copy process is only carried 
out up to the corresponding position.

– The number of copied characters is output at the parameter CNT.

● Use the parameter PCHARS to define the character in the structure after which 
Array of CHAR / BYTE should be written.

– Example: Use the value "2" at the parameter PCHARS if writing should take place after 
the third character:

– The lower index limit of the array is used as the standard ("0") (e.g. CHAR[0] at an Array 
[0..5] of CHAR).

 

 Note
Use of the instruction with S7-1200 V2.0

S7-1200 up to Version 2.0 only supports Array [0 .. n] of CHAR / BYTE. Negative index limits 
(e.g. Array [-3..2] of CHAR) are not permissible. This restriction is not checked by the software.
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Parameters
The following table shows the parameters of the instruction "Strg_TO_Chars":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500   

STRG Input STRING STRING, 
WSTRING

D, L or constant The copy source
Character string with a maximum 
length of 254 characters.

PCHARS Input DINT DINT I, Q, M, D, L, P or 
constant

Position in the structure 
Array of (W)CHAR / BYTE after 
which the characters in the 
character string are written.

CHARS InOut VARIANT VARIANT D, L The copy target
The characters can be copied to a 
structure of the data type 
Array of (W)CHAR or 
Array of BYTE.

CNT Output UINT UINT I, Q, M, D, L, P Number of copied characters.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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Chars_TO_Strg: Convert Array of CHAR to character string

Description
Use the instruction "Chars_TO_Strg" to copy the character from a structure of a data type Array 
of CHAR or Array of BYTE to a character string STRING. Only ASCII characters are valid for 
the copy process.

● At the input parameter CHARS, enter the characters of the structure Array of (W)CHAR / 
BYTE which are to be copied to a character string. 

● The characters are written to a data type STRING at the parameter STRG.

– The number of characters in the character string STRING should be at least the same 
number as were copied from the field Array of CHAR.

– If the character string is shorter than the number of characters in the structure 
Array of CHAR / BYTE, the maximum length of characters is written in the character 
string.

– If the structure Array of CHAR / BYTE contains a character "$00" then the copy process 
is only carried out up to the corresponding position.

● Use the parameter PCHARS to define the position in the structure Array of CHAR / BYTE 
after which the character it to be copied.

– Example: Use the value "2" at the parameter PCHARS if copying is to take place after 
the third character in the structure:

– The lower index limit of the array is used as the standard ("0") (e.g. CHAR[0] at Array 
[0..5] of CHAR).

– If an index is specified at parameter PCHARS and the index is not contained in the copy 
source (e.g. "7" at Array [0..5] of CHAR) then the instruction is not executed.

 

 Note
Use of the instruction with S7-1200 V2.0

S7-1200 up to Version 2.0 only supports Array [0 .. n] of CHAR / BYTE. Negative index limits 
(e.g. Array [-3..2] of CHAR) are not permissible. This restriction is not checked by the software.
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Parameters
The following table shows the parameters of the instruction "Chars_TO_Strg":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

CHARS Input VARIANT VARIANT D, L The copy source
Structure Array of CHAR / BYTE from 
which the character is copied.

PCHARS Input DINT DINT I, Q, M, D, L, P or 
constant

Position in the structure 
Array of (W)CHAR / Array of BYTE 
after which the characters are copied.

CNT Output UINT UINT I, Q, M, D, L, P Number of characters to be copied. 
All characters were copied at "0".

STRG Output STRING STRING, 
WSTRING

D, L The copy target
Character string

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

MAX_LEN: Determine the length of a character string

Description
A tag of the STRING data type contains two lengths: the maximum length and the current 
length (this is the number of currently valid characters). 

● The maximum length of the character string is specified for each tag in the STRING keyword 
in square brackets. The number of bytes occupied by a string is 2 greater than the maximum 
length.

● The current length represents the number of the character places actually used. The current 
length must be less than or equal to the maximum length. 

You use the "MAX_LEN" instruction to query the maximum length of the character string 
specified at the IN input parameter and output this information as a numerical value at the OUT 
output parameter.

If errors occur during processing of the instruction, then an empty string will be output.

 
 

 Note
Reading out the current length

You can also use the LEN (Page 2659) instruction to read out the current length of a string.
 

Programming the PLC
9.7 References

WinCC Professional V13.0
2648 System Manual, 02/2014



Parameter
The following table shows the parameters of the "MAX_LEN" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
OUT Return INT I, Q, M, D, L, P Maximum number of characters

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Join: Join multiple strings

Description
The "JOIN" instruction connects multiple strings into an array.

To convert multiple strings into a single one, the instruction provides the following functions:

● Format selection
You use the first bit in the Mode parameter to select whether you want to use CSV or FSR 
as the format for the array.

– With CSV (Comma Separated Values), the contents of the source strings are written 
consecutively and separated with a delimiter. Example:
1963,Miller,John,CitynameA,Roadname
1974,Jackson,Peter,CitynameB,VeryLongRoadname

– With FSR (Fixed Size Records), a certain number of characters is defined for each value 
(each source character string). If fewer characters are required, the characters are 
padded with delimiters. If more characters are required, the text is truncated. Example:
1963Miller,,,,,,,John,,,,,,CitynameA,,,,Roadname,,,,,,
1974Jackson,,,,,,Peter,,,,,CitynameB,,,,VeryLongRoadna

● Selection of the delimiter for the source strings 
You can use the RecSeparator parameter to select the delimiter to be used for each string. 
You should select a character based on the content of the input strings at the SrcStruct 
parameter. If the input strings contain a comma within a string, for example, the comma 
should not used as a delimiter. The data type that you use for the delimiter must correspond 
to the destination array at the DstArray parameter in order for the delimiter to be included 
in what is written in the array.

● Selection of the delimiter for the end of all source strings
You can use the third bit of the Mode parameter to specify whether an additional character 
should be written as a delimiter at the end of the copied characters in the destination array 
(DstArray parameter). Specify the character to be used as a delimiter at the EndSeparator 
parameter. Make sure to use a character other than the one set for the RecSeparator 
parameter (delimiter for individual strings). If the two delimiters are indistinguishable, you 
will obtain unexpected results if you reverse the conversion using the "SPLIT" instruction.
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● Selection of the source strings
You specify the source strings at the SrcStruct parameter. For the data type, you can use 
Array of STRING or Array of WSTRING or structures which only contain the STRING or 
WSTRING data type. This also applies to user data types or nested structures. You can 
use these as long as they exclusively contain the data type STRING or WSTRING 
respectively.

● Specification of the number of joined strings
If you use an Array of STRING or Array of WSTRING at the SrcStruct parameter (source 
string) (no nested structures), you can use the Count parameter to specify the number of 
source strings that have been joined to form a single string. If you use a data type other 
than Array of (W)STRING at the SrcStruct parameter, the Count parameter is ignored. This 
makes it possible to connect only a part of a large array.

● Selection of a destination area for writing the array
You use the Array of (W)CHAR data type at the DstArray parameter. It is not possible to 
use the STRING or WSTRING data types here, because the length is limited to 256 
characters for STRING.

● Index of the position in the array (DestArray target parameter)
The conversion starts at this position and the instruction reads the Position parameter to 
determine the position at which the conversion is completed. This enables follow-up calls 
of the instruction for filling the array.

Parameters
The following table shows the parameters of the instruction "JOIN":

Parameter Declaration Data type Memory area Description
Mode Input DWORD I, Q, M, D, L or 

constant
Specifies how the merger to string is performed 
(see Mode" parameter).

RecSeparator Input VARIANT I, Q, M, D, L Delimiter for the source strings
● With CSV: Character that is used as a delimiter 

for the individual strings.
● With FSR: Character that is used as a fill 

character for the individual strings.
EndSeparator Input VARIANT I, Q, M, D, L Delimiter for the end of the conversion

Delimiter that is written at the end of the characters 
if bit 3 = 1 has been set for the Mode parameter.

SrcStruct Input VARIANT I, Q, M, D, L Pointer to the source strings.
Count Input UDINT I, Q, M, D, L Number of strings that were joined.

The Count parameter can only be used when an 
Array of (W)STRING has been used at the 
SrcStruct parameter.

DestArray InOut VARIANT I, Q, M, D, L Area in which the characters are written after the 
conversion.
Use the Array [0 .. x] of CHAR/WCHAR data type 
at the DestArray parameter. You can set the length 
(x) of the array based on the length of the source 
strings at the SrcStruct parameter.
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Parameter Declaration Data type Memory area Description
Position InOut UDINT I, Q, M, D, L Index the position in the total string
Ret_Val Return UINT I, Q, M, D, L Status of instruction (see table "RET_VAL 

parameter").

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

Mode parameter

Bit Bit value "0" Bit value "1" Description
0 CSV format (Comma 

Separated Values)
FSR format (Fixed 
Size Record)

Selection of the format:
● With CSV, the source strings are separated by a delimiter in the 

destination array.
● With FSR, the source strings are written into the destination array 

with the fill characters defined at the RecSeparator parameter. 
1 - - Irrelevant for the "JOIN" instruction.
2 - - Reserved (irrelevant for bit value)
3 Write no additional 

delimiters.
Write character 
defined by the 
EndSeparator 
parameter at the end 
of the read 
characters. 

Select whether an additional character is to be written as a delimiter 
at the end of the characters in the array (DestArray parameter).

4 - - Irrelevant for the "JOIN" instruction.

RET_VAL parameter

Error code*
(W#16#...)

Explanation

0000 No error.
0001 Additional characters are ignored.
8190 Selection at the Mode parameter is not supported.
8x20 Source strings invalid.
8x50 VARIANT points to empty content.
8x52 VARIANT points to a block that has not been created with optimized access.
8x53 VARIANT points to data structure that is too short.
8x54 Invalid data type
8882 The value at the Position parameter is outside the source string.
8x84  Found additional characters.
80B4 Different data types at parameters SrcStruct (source) and DestArray (destination) or at separators 

(parameters RecSeparator and EndSeparator).
80B5 Buffer overflow with the instruction. The characters were not fully generated at the DestArray parameter.
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Error code*
(W#16#...)

Explanation

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* Note the following for the error codes:
● The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 

toggling display formats, refer to "See also".
● The "x" in the second position of the listed error codes stands for the parameter that caused the error.

Example: Error code 8352 hex = error occurred at 3rd parameter (EndSeparator), see Parameter table.
● If the error cannot be clearly assigned to a specific parameter, "0" is output.

Example: The CHAR data type is used for the delimiter (RecSeparator parameter). WCHAR is used as data type for the 
array at the DestArray parameter. Error code 80B4 is output in this case.

Split: Splitting an array of characters into multiple strings

Description
The "SPLIT" instruction converts an array (Array of CHAR / WCHAR) into several separate 
strings (Array of STRING / WSTRING or structure).

To convert the array into several strings, specify the following information:

● Selection of array to be read
You specify the array to be read at the SrcArray parameter. Make sure that the data types 
used for the input and output parameters match any other parameters used. If you use an 
array with the CHAR data type at the SrcArray parameter, for example, you must use the 
CHAR data type for the delimiter (Rec/EndSeparator) and the structure must only contain 
strings with the STRING data type at the DestStruct parameter.

● Selection of the format for the array to be read
You use the first bit of the Mode parameter to specify whether the array to be read has the 
CSV or FSR format (for a definition, see the "JOIN (Page 2649)" instruction).

● Delimiter used for the array to be read 

– If the array to be read has CSV format, specify which delimiter was used at the 
RecSeparator parameter. 

– If the array to be read has FSR format, specify which fill character was used at the 
RecSeparator parameter. 

● Selection of the delimiter for the end of the total string
Specify the delimiter after which the reading of the array should stop at the EndSeparator 
parameter. The "SPLIT" instruction stops at this position and outputs the string that has 
been found. It should be noted, that the EndSeparator delimiter is evaluated with higher 
priority than the RecSeparator delimiter. If the delimiter at the EndSeparator parameter is 
used in a string to be read (between two RecSeparator delimiters), all content after the 
EndSeparator delimiter is ignored.
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● Specification of the position starting at which the array is read
The conversion starts at this position in the array and the instruction reads the Position 
parameter to determine the position at which the conversion is completed. This enables 
follow-up calls of the instruction for filling the various strings at the DestStruct parameter.

● Outputting the number of read strings
If you use an Array of STRING at the DestStruct parameter, you can use the Count 
parameter to output the number of read strings. Only strings with content are counted. If 
you use a data type other than Array of STRING at the DestStruct parameter, "0" is output 
at the Count parameter. 

Parameters
The following table shows the parameters of the "SPLIT" instruction:

Parameter Declaration Data type Memory area Description
Mode Input DWord I, Q, M, D, L or constant Specifies how the split into multiple strings 

is performed (see "Mode" parameter).
RecSeparator Input Variant I, Q, M, D, L Delimiter or fill character 

● With CSV: Character that was used in 
the array to be read to identify the 
individual strings.

● With FSR: Character that has been used 
as a fill character in the array to be read.

EndSeparator Input Variant I, Q, M, D, L Delimiter used to define the end of the total 
string in the array to be read.

SrcArray Input Variant I, Q, M, D, L Pointer to the array to be read (Array of 
CHAR/WCHAR)

DestStruct InOut Variant I, Q, M, D, L Structure which includes the converted 
strings (Array of STRING / WSTRING).

Position InOut UDInt I, Q, M, D, L Position from which the array is to be read 
at the SrcArray parameter.

Ret_Val Return Int I, Q, M, D, L Result of instruction execution / error code 
(see table "Ret_Val parameter")

Count Output UDInt I, Q, M, D, L Number of strings that were found.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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Mode parameter

Bit Bit value "0" Bit value "1" Description
0 CSV format (Comma 

Separated Values)
FSR format (Fixed 
Size Record)

Basic mode: Selection of CSV or FSR

1 ● With CSV: 
Additional 
characters are 
written to the 
following string.

● With FSR: Fill 
characters 
remain in string.

● With CSV: 
Additional 
characters are 
removed.

● With FSR: Fill 
characters are 
removed.

Use bit 1 to specify how you want to deal with additional characters:
● With CSV: 

– If the bit is set, additional characters that do not fit in the 
destination string are ignored. 
Example: The instruction writes to a string with a length of 16 
characters (STRING[16] data type). No delimiter is contained 
in the source after the first 16 characters. If bit 1 is set, the 
extra characters are ignored and the instruction continues to 
read the array.

– If the bit is not set, the instruction stops in such a case and 
generates an error message at the Ret_Val parameter.

● With FSR:
– If the bit is set, the fill characters used are not written to the 

destination string. 
– If the bit is not set, the fill characters are written to the 

destination string.
2 - - Reserved for use in future versions.
3 Separator is retained. Separator is removed. Specification of whether the delimiter is removed at the end of the 

total string.
4 Leave unwritten 

strings (STRING) at 
length.

Set unwritten strings 
(STRING) to length 
"0".

Specification of whether unused strings (STRING) at the DestStruct 
parameter are to be set to the length "0".

RET_VAL parameter

Error code*
(W#16#...)

Explanation

0000 No error.
0001 Additional characters are ignored.
8190 Selection at the Mode parameter is not supported.
8x20 Source strings invalid.
8x50 VARIANT points to empty content.
8x52 VARIANT points to a block that has not been created with optimized access.
8x53 VARIANT points to data structure that is too short.
8x54 Invalid data type
8882 The value at the Position parameter is outside the source string.
8x84  Found additional characters.
80B4 Different data types at parameters SrcStruct (source) and DestArray (destination) or at separators 

(parameters RecSeparator and EndSeparator).
80B5 Buffer overflow with the instruction. The strings were not fully generated at the DestArray parameter.
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Error code*
(W#16#...)

Explanation

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* Note the following for the error codes:
● The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 

toggling display formats, refer to "See also".
● The "x" in the second position of the listed error codes stands for the parameter that caused the error.

Example: Error code 8352 hex = error occurred at 3rd parameter (EndSeparator), see Parameter table.
● If the error cannot be clearly assigned to a specific parameter, "0" is output.

Example: The CHAR data type is used for the delimiter (RecSeparator parameter). WCHAR is used as data type for the 
array at the DestArray parameter. Error code 80B4 is output in this case.

ATH: Convert ASCII string to hexadecimal number

Description
You use the instruction "ATH" to convert the ASCII character string specified at the IN input 
parameter into a hexadecimal number. The result of the conversion is output to the OUT output 
parameter.

● You can reference the following data types using the pointer in the IN parameter (ASCII): 
STRING, Array of CHAR, Array of BYTE, WSTRING, Array of WCHAR.

● You can reference the following data types using the pointer in the OUT parameter 
(hexadecimal): Bit strings, integers, STRING, Array of CHAR, Array of BYTE, WSTRING, 
Array of WCHAR.

With the N parameter, you specify the number of ASCII characters to be converted. A maximum 
of 32767 valid ASCII characters can be converted. Only digits "0" to "9", upper case letters "A" 
to "F", and lower case letters "a" to "f" can be interpreted. All other characters are converted 
to zeros.

Since 8 bits are required for the ASCII character and only 4 bits for the hexadecimal digit, the 
output word length is only half of the input word length. The ASCII characters are converted 
and positioned in the output in the same order as they are read in. If there is an odd number 
of ASCII characters, the hexadecimal number is padded with zeros in the nibble to the right of 
the last converted hexadecimal number.

Parameters
The following table shows the parameters of the "ATH" instruction:

Parameter Declaration Data type Memory area Description
IN Input VARIANT I, Q, D, L Pointer to ASCII character string
N Input INT I, Q, M, D, L or 

constant
Number of ASCII characters to be 
converted

RET_VAL Return WORD I, Q, M, D, L Status of the instruction
OUT Output VARIANT I, Q, M, D, L Hexadecimal number
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You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code
(W#16#....)*

Description

0000 No error
0007 Invalid character. Only the following ASCII characters may be used: Digits "0" to "9", 

upper case letters "A" to "F", lower case letters "a" to "f".
8101 Invalid pointer in the IN parameter, e.g., because a non-existing data block is 

referenced.
8182 Input buffer is too small for data in the N parameter.
8120 Invalid format in the IN parameter.
8151 Non-supported data type in the IN parameter.
8401 Invalid pointer in the OUT parameter, e.g., because a non-existing data block is 

referenced.
8482 Output buffer is too small for data in the N parameter.
8420 Invalid format in the OUT parameter.
8451 Non-supported data type in the OUT parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For 
additional information on toggling display formats, refer to "See also".

ASCII characters and hexadecimal values
The following table shows the ASCII characters and the corresponding hexadecimal values:

ASCII character ASCII-coded hexadecimal value Hexadecimal digit
"0" 30 0
"1" 31 1
"2" 32 2
"3" 33 3
"4" 34 4
"5" 35 5
"6" 36 6
"7" 37 7
"8" 38 8
"9" 39 9
"A" 41 A
"B" 42 B
"C" 43 C
"D" 44 D
"E" 45 E
"F" 46 F
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Example
The following table shows examples of the conversion of ASCII character strings to 
hexadecimal numbers:

IN N OUT ENO status
'0123' 4 16#0123 1
'123AFx1a23' 10 16#123AF01a23 0

HTA: Convert hexadecimal number to ASCII string

Description
You use the instruction "HTA" to convert the hexadecimal number specified at the IN input into 
an ASCII character string. The result of the conversion is stored at the address specified in 
the OUT parameter.

● You can reference the following data types using the pointer in the IN parameter 
(hexadecimal): Bit strings, integers, STRING, Array of CHAR, Array of BYTE, WSTRING, 
Array of WCHAR.

● You can reference the following data types using the pointer in the OUT parameter (ASCII): 
STRING, Array of CHAR, Array of BYTE , WSTRING, Array of WCHAR.

With the N parameter, you specify the number of hexadecimal bytes to be converted. Since 8 
bits are required for the ASCII character and only 4 bits for the hexadecimal digit, the output 
value is twice as long as the input value. Each nibble of the hexadecimal number is converted 
to a character while maintaining the original order.

A maximum of 32767 characters can be written to the ASCII character string. The result of the 
conversion is represented by the digits "0" to "9" and upper-case letters "A" to "F".

If the complete result of the conversion cannot be displayed in the OUT parameter, the result 
is will only be partially written to the parameter.

Parameters
The following table shows the parameters of the "HTA" instruction:

Parameter Declaration Data type Memory area Description
IN Input VARIANT I, Q, M, D, L Start address of the hexadecimal 

digits
N Input INT I, Q, M, D, L or 

constant
Number of hexadecimal bytes to 
be converted 

RET_VAL Return WORD I, Q, M, D, L Error message
OUT Output VARIANT I, Q, D, L Address at which the result is 

stored. 

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".
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RET_VAL parameter

Error code*
(W#16#....)

Description

0000 No error
8101 Invalid pointer at the IN parameter, e.g., because a non-existing data block is referenced.
8182 Input buffer is too small for data in the N parameter.
8120 Invalid format in the IN parameter.
8151 Non-supported data type in the IN parameter.
8401 Invalid pointer in the OUT parameter, e.g., because a non-existing data block is referenced.
8482 Output buffer is too small for data in the N parameter.
8420 Invalid format in the OUT parameter.
8451 Non-supported data type in the OUT parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ASCII characters and hexadecimal values
The following table shows the ASCII characters and the corresponding hexadecimal values:

Hexadecimal digit ASCII-coded hexadecimal value ASCII character
0 30 "0"
1 31 "1"
2 32 "2"
3 33 "3"
4 34 "4"
5 35 "5"
6 36 "6"
7 37 "7"
8 38 "8"
9 39 "9"
A 41 "A"
B 42 "B"
C 43 "C"
D 44 "D"
E 45 "E"
F 46 "F"
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Example
The following table shows examples of the conversion of hexadecimal numbers to ASCII 
character strings:

IN N OUT ENO status
W#16#0123 2 '0123' 1
16#123AF01023 4 '123AF010' 0

Other instructions

LEN: Determine the length of a character string

Description     
A tag of the STRING data type contains two lengths: the maximum length and the current 
length (this is the number of currently valid characters). 

● The maximum length of the character string is specified for each tag in the STRING keyword 
in square brackets. The number of bytes occupied by a string is 2 greater than the maximum 
length.

● The current length represents the number of the character places actually used. The current 
length must be less than or equal to the maximum length. 

You use the instruction "LEN" to query the current length of the character string specified at 
the IN input parameter and output this information as a numerical value at the OUT output 
parameter. An empty string ('') has the length zero.

If errors occur during processing of the instruction, then an empty string will be output.
 

 Note
Reading out the maximum length

You can also use the MAX_LEN (Page 2648) instruction to read out the current length of a 
string.

 

Parameters
The following table shows the parameters of the "LEN" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
OUT Return INT, DINT, 

REAL, 
LREAL

I, Q, M, D, L Number of valid characters

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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CONCAT: Combine character strings

Description     
You use the instruction "CONCAT" to combine the character string at the IN1 input parameter 
with the character string at the IN2 input parameter. The result is output in the OUT output 
parameter with the STRING format. If the resulting character string is longer than the tag 
specified in the OUT output parameter, then the resulting character string will be limited to the 
available length.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "CONCAT" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant Character string
IN2 Input STRING D, L or constant Character string
OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

LEFT: Read the left character of a character string

Description     
You use the instruction "LEFT" to extract a partial string beginning with the first character of 
the string at the IN input parameter. You specify the number of characters to be extracted in 
the L parameter. The extracted characters are output in the OUT output parameter with 
STRING format.

If the number of characters to be extracted is greater than the current length of the character 
string, the OUT output parameter returns the input character string as a result. If the L 
parameter contains the value "0" or the input value is an empty string, an empty string will be 
returned. If the value in the L parameter is negative, an empty string will be output.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.
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Parameters
The following table shows the parameters of the "LEFT" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be 
extracted

OUT Return STRING D, L Extracted partial string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

RIGHT: Read the right characters of a character string

Description     
You use this instruction to extract the last L character in a character string in the input parameter 
IN. You specify the number of characters to be extracted in the L parameter. The extracted 
characters are output in the OUT output parameter with STRING format.

If the number of characters to be extracted is greater than the current length of the character 
string, the OUT output parameter returns the input character string as a result. If the L 
parameter contains the value "0" or the input value is an empty string, an empty string will be 
returned. If the value in the L parameter is negative, an empty string will be output.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "RIGHT" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be 
extracted

OUT Return STRING D, L Extracted partial string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

MID: Read middle characters of a character string

Description     
You use this instruction to extract a portion of the character string in the IN input parameter. 
With the P parameter, you specify the position of the first character to be extracted. With the 
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L parameter, you define the length of the character string to be extracted. The extracted partial 
character string is output to the OUT output parameter.

The following rules must be observed when executing the instruction: 

● If the number of characters to be extracted exceeds the current length of the character 
string in the IN input parameter, a partial character string will be output, starting from 
character position P and continuing to the end of the character string.

● If the character position specified in the P parameter falls outside the current character 
string length in the IN input parameter, an empty character string will be output in the OUT 
output parameter.

● If the value of the P or L parameter equals zero or is negative, an empty character string 
will be output in the OUT output parameter.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameters
The following table shows the parameters of the "MID" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, 
USINT

I, Q, M, D, L or 
constant

Length of the string to be extracted

P Input BYTE, INT, 
SINT, 
USINT

I, Q, M, D, L or 
constant

Position of the first character to be 
extracted (first character = 1)

OUT Return STRING D, L Extracted partial string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

DELETE: Delete characters in a character string

Description     
You use this instruction to delete a portion of the character string in the IN input parameter. 
With the P parameter, you specify the position of the first character to be deleted. You specify 
the number of characters to be deleted in the L parameter. The remaining partial character 
string is output to the OUT output parameter with STRING format.

The following rules must be observed when executing the instruction:

● If the value in the P parameter is less than or equals zero, an empty character string will 
be output in the OUT output parameter.

● If the value in the P parameter is greater than the current length of the character string in 
the IN input, the input character string will be returned in the OUT output parameter.
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● If the value in the L parameter equals zero, the input character string will be returned in the 
OUT output parameter.

● If the number of characters to be deleted at the L parameter is greater than the length of 
the character string in the IN parameter, an empty character string will be output.

● If the value in the L parameter is negative, an empty character string will be output.

If errors occur during processing of the instruction and the OUT output parameter can be 
written, an empty string will be output.

Parameter
The following table shows the parameters of the "DELETE" instruction:

Parameter Declaration Data type Memory area Description
IN Input STRING D, L or constant Character string
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be deleted

P Input BYTE, INT, 
SINT, USINT

I, Q, M, D, L or 
constant

Position of first character to be 
deleted

OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

INSERT: Insert characters in a character string

Description     
You use this instruction to insert the character string in the IN2 input parameter to the character 
string in the IN1 input parameter. With the P parameter, you specify the position of the character 
starting at which the characters are inserted. The result is output in the OUT output parameter 
with the STRING format.

The following rules must be observed when executing the instruction:

● If the value in the P parameter exceeds the current length of the character string in the IN1 
input parameter, the character string of the IN2 input parameter will be appended to the 
character string of the IN1 input parameter.

● If the value at the P parameter is zero, the character string at the IN2 parameter followed 
by the character string at the IN1 parameter will be output in the OUT output parameter.

● If the value in the P parameter is negative, an empty character string will be output in the 
OUT output parameter.

● If the resulting character string is longer than the tag specified in the OUT output parameter, 
the resulting character string will be limited to the available length.
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Parameter
The following table shows the parameters of the "INSERT" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant Character string 
IN2 Input STRING D, L or constant String to insert
P Input BYTE, 

INT, SINT, 
USINT

I, Q, M, D, L or 
constant

Insert position

OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

REPLACE: Replace characters in a character string

Description     
You use this instruction to replace a portion of the character string in the IN1 input with the 
character string in the IN2 input. You specify the position of the first character to be replaced 
in the P parameter. You specify the number of characters to be replaced in the L parameter. 
The result is output in the OUT output parameter with the STRING format.

The following rules must be observed when executing the instruction:

● If the value in the P parameter is less than or equals zero, an empty character string will 
be output in the OUT output parameter.

● If the value in the L parameter is less than zero, an empty character string will be output in 
the OUT output parameter.

● If P equals one, the character string in the IN1 input will be replaced beginning with (and 
including) the first character.

● If the value in the P parameter exceeds the current length of the character string in the IN1 
input parameter, the character string of the IN2 input parameter will be appended to the 
character string of the IN1 input parameter.

● If the resulting character string is longer than the tag specified in the OUT output parameter, 
the resulting character string will be limited to the available length.

● If the value at parameter L is zero, characters are not replaced but inserted. The same 
conditions apply as with the instruction INSERT. See also: INSERT: Insert characters in a 
character string (Page 2663)
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Parameters
The following table shows the parameters of the "REPLACE" instruction:

Parameter Declaration Data type Memory area Description
IN1 Input STRING D, L or constant String with characters to be 

replaced.
IN2 Input STRING D, L or constant String with characters to be 

inserted.
L Input BYTE, INT, 

SINT, USINT
I, Q, M, D, L or 
constant

Number of characters to be 
replaced

P Input BYTE, INT, 
SINT, USINT

I, Q, M, D, L or 
constant

Position of first character to be 
replaced

OUT Return STRING D, L Resulting character string

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

FIND: Find characters in a character string

Description
You can use this instruction to search through the character string in the IN1 input parameter 
for a specific character or a specific sequence of characters.

● You specify the value to be searched for in the IN2 input parameter. The search is made 
from left to right.

● The position of the first occurrence is output in the OUT output parameter. If the search 
returns no match, the value "0" will be output in the OUT output parameter.

If an invalid character is specified at the IN2 parameter or if an error occurs during processing, 
the value "0" is output at the OUT parameter.

Parameters
The following table shows the parameters of the "FIND" instruction:

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

IN1 Input STRING STRING, 
WSTRING

D, L or constant String searched through

IN2 Input STRING, 
CHAR

STRING, 
WSTRING, 
CHAR, 
WCHAR

D, L or constant
(For (W)CHAR also I, 
Q, M)

Characters to search for

OUT Return INT INT I, Q, M, D, L Character position

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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Runtime information

GetSymbolName: Read out a tag on the input parameter

Description
The "GetSymbolName" instruction is used to read the name of a tag interconnected at the 
parameter via the input parameter of a block.

If a block is used multiple times in the project and called each time by a different tag, you can 
use the "GetSymbolName" instruction to evaluate the name of the calling tag. The process 
value of the tag is irrelevant in this case.

● You specify the input parameters of the block interface at the VARIABLE parameter. Use 
only an interface parameter for this parameter and no PLC or data block tags.

● You can limit the length of the read tag name using the SIZE parameter. If the name has 
been truncated, this is indicated by the characters "..." (Unicode character 16#2026) 
appears at the end of the name. Note that the "..." character itself has a length of 1. If you 
enter 6 as the maximum length at the SIZE parameter, for example, and read the tag name 
"MyPLCTag" via the block interface, the following is output: "MyPLC...".

● The name read is output at the OUT parameter.

Parameters
The following table shows the parameters of the "GetSymbolName" instruction:

Parameter Declaration Data type Memory area Description
VARIABLE Input PARAMETER L Input parameters of the block interface
SIZE Input UINT I, Q, M, D, L Length limit for the read names
OUT Return WSTRING I, Q, M, D, L Name of the tag that was read via the block interface

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

GetInstanceName: Read out name of the read instance

Description
You can use the "GetInstanceName" instruction to read the name of the instance data block 
within a function block.

● You can specify how many characters of the instance name should be read out using the 
SIZE parameter. If you use the "0" value for SIZE, the entire name is read.

● The name of the instance data block is written to the OUT parameter. If the name of the 
instance data block is longer than the maximum length of WSTRING (254 characters), the 
name is truncated.
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Parameters
The following table shows the parameters of the "GetInstanceName" instruction:

Parameter Declaration Data type Memory area Description
SIZE Input DINT I, Q, M, D, L or 

constant
Number of characters up to which the name of the 
instance data block is to be read

OUT Output WSTRING I, Q, M, D, L Read name of the instance data block

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

GetBlockName: Read out name of the block

Description
You can use the "GetBlockName" instruction to read the name of the block in which the 
instruction is called.

● You can specify how many characters of the block name should be read using the SIZE 
parameter. If you use the "0" value for SIZE, the entire name is read.

● The name of the block is written at the OUT parameter. If the name of the block is longer 
than the maximum length of WSTRING (254 characters), the name is truncated.

Parameter
The following table shows the parameters of the "GetBlockName" instruction:

Parameter Declaration Data type Memory area Description
SIZE Input UINT I, Q, M, D, L or 

constant
Number of characters up to which the name of the 
instance data block is to be read.

RET_VAL Output WSTRING I, Q, M, D, L Read name of the instance data block

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

9.7.3.3 Process image

UPDAT_PI: Update the process image inputs

Description  
With the instruction, you update the OB 1 process image (=process image partition 0) of the 
inputs or a process image partition of the inputs of the inputs defined by configuration.

If you have configured repeated signaling of I/O access errors for the system-side process 
image update, then the selected process image will be updated constantly.
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Otherwise, this update will only be performed if the selected process image partition is not 
updated by the system, in other words:

● If you have not assigned this process image partition to an interrupt OB 
or

● If you selected process image partition 0 and have disabled updating of the OB 1 process 
image partition during configuration.

 

  Note

Each logical address that you have assigned to a process image partition of the inputs 
per configuration no longer belongs to the OB 1 process image of the inputs.

When you update a process image partition with "UPDAT_PI", you must not perform a 
simultaneous update with the "SYNC_PI (Page 2671)" instruction.

 

System-side updating of the OB 1 process image of the inputs and the process image partitions 
of inputs that you have assigned to an interrupt OB takes place independently of "UPDAT_PI" 
calls.

Parameters
The following table shows the parameters of the "UPDAT_PI"instruction:

Parameter Declaration Data type Memory area Description
PART Input PIP I, Q, M, D, L or 

constant
Number of the process image 
partition of the inputs to 
be updated. Maximum value range 
(depending on the CPU): 
0 to 31 (0 means OB 1 process 
image, n where 1 <= n <= 31 means 
process image partition n).

RET_VAL Return INT I, Q, M, D, L, P Error information
FLADDR Output WORD I, Q, M, D, L, P Address of the first byte to cause an 

error 
if an access error has occurred.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Illegal value for PART parameter
8091 The specified process image partition was not yet defined or is not located in the permitted process image 

area on the CPU.
8092 The process image partition is being updated by the system and cannot be used for the PART parameter.
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Error code*
(W#16#...)

Explanation

8093 The process image partition update is being processed in another OB.
80A0 An access error was detected when accessing the I/O.
General error 
information

See also:  GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the instruction for process image partitions of DP standard slaves for which you 
have defined a consistency area greater than 32 bytes, the error codes of the "DPRD_DAT 
(Page 2717)" instruction are also possible.

 

UPDAT_PO: Update the process image outputs

Description
You use the instruction to transfer the signal states of the OB 1 process image (= process 
image partition 0) of the outputs or a process image partition of the outputs defined per 
configuration to the output modules.

If you have specified a consistency range for the selected process image partition, 
corresponding data is transferred as consistent data to the respective I/O module.

 

 Note

Each logical address you have assigned to a process image partition of the outputs during 
configuration no longer belongs to the OB 1 process image of the outputs.

Outputs that you update with "UPDAT_PO" must not be updated simultaneously with the 
"SYNC_PO (Page 2672)" instruction.

 

The OB 1 process image of the outputs and the process image partitions of the outputs that 
you have assigned to an interrupt OB are transferred by the system to the output modules 
independently of "UPDAT_PO" calls.
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Parameters
The following table shows the parameters of the "UPDAT_PO" instruction:

Parameter Declaration Data type Memory area Description
PART Input PIP I, Q, M, D, L or 

constant
Number of the process image partition 
of the outputs to be transferred. 
Maximum value range (depending on 
the CPU): 0 to 31.
(0 means OB 1 process image, n 
where 1 <= n <= 31 means process 
image partition n)

RET_VAL Return INT I, Q, M, D, L, P Error information
FLADDR Output WORD I, Q, M, D, L, P Address of the first byte to cause an 

error 
if an access error has occurred.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Illegal value for PART parameter
8091 The specified process image partition was not yet defined or is not located in the permitted process image 

area on the CPU.
8092 The process image partition is being updated by the system and cannot be used for the PART parameter. 
8093 The process image partition update is being processed in another OB.
80A0 An access error was detected when accessing the I/O.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the instruction for process image partitions of DP standard slaves for which you 
have defined a consistency area greater than 32 bytes, the error codes of the "DPWR_DAT 
(Page 2719)" instruction are also possible.
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SYNC_PI: Synchronize the process image inputs

Description
The "SYNC_PI" is used to update the process image partition of inputs in isochronous mode. 
A user program linked to a DP cycle or PN send cycle can use this instruction to update input 
data acquired in a process image partition of the inputs isochronously and consistently.

Call
"SYNC_PI" is interruptible and can only be called in OBs 61, 62, 63 and 64.

 

 Note

A call of the "SYNC_PI" instruction in OBs 61 to 64 is only permitted if you have assigned the 
affected process image partition to the associated OB in the HW configuration.

A process image partition that you update with "SYNC_PI" must not be updated 
simultaneously with the "UPDAT_PI (Page 2667)" instruction.

 

Parameters
The following table shows the parameters of the "SYNC_PI" instruction:

Parameter Declaration Data type Memory area Range of values Description
PART Input PIP I, Q, M, D, L or 

constant
1 to 31 Number of the process image partition of 

the inputs to be updated isochronously.
RET_VAL Return INT I, Q, M, D, L, P - Error information
FLADDR Output WORD I, Q, M, D, L, P  Address of the first byte to cause an error 

if an access error has occurred.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code 
(W#16#...)*

Explanation

0000 No error occurred.
0001 Consistency warning. The update of the process image partition was distributed over two DP or PN cycles. 

However, the data in one slave or IO device were consistently transferred.
8090 Illegal value on PART parameter or updating the specified process image partition of the inputs is not permitted 

in this OB. The process image partition of the inputs was not updated.
8091 The specified process image partition was not yet defined or is not located in the permitted process image 

area on the CPU. The process image partition of the inputs was not updated.
8092 The process image partition is being updated by the system and cannot be used for the PART parameter. 
8093 The process image partition update is being processed in another OB.
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Error code 
(W#16#...)*

Explanation

80A0 During updating an access error was detected. The affected inputs were set to "0".
80A1 The update time is after the permitted access window. The process image partition of the inputs was not 

updated.
The DP or PN cycle is too short to ensure enough time for processing the instruction. You must therefore 
increase the TDP (also known as T_DC), Ti and To timers.

80A2 Access error with consistency warning
In the case of update of the specified process image partition an access error with simultaneous consistency 
warning was detected.
● The data of the incorrect inputs was not read by the I/O. In the process image partition of the inputs the 

involved inputs are set to zero.
● The update of the process image partition of the not involved by an access error input data was distributed 

over two DP and PN cycles.
80C1 The update time is before the permitted access window. The process image partition of the inputs was not 

updated.
General 
error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the "SYNC_PI" instruction for process image partitions of DP standard slaves for 
which you have defined a consistency area greater than 32 bytes, the error codes of the 
"DPRD_DAT (Page 2717)" instruction are also possible.

 

SYNC_PO: Synchronize the process image outputs

Description
The instruction "SYNC_PO" is used to update a process image partition of outputs in 
isochronous mode. An application program linked to a DP cycle or a PN send cycle can use 
this instruction for the consistent isochronous transfer of the computed output data of a process 
image partition from outputs to the I/O devices.
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Call
"SYNC_PO" is interruptible and can only be called in OBs 61, 62, 63 and 64.

 

 Note

A call of the "SYNC_PO" instruction in OBs 61 to 64 is only permitted if you have assigned 
the affected process image partition to the associated OB in the HW configuration.

A process image partition that you update with "SYNC_PO" must not be updated 
simultaneously with the "UPDAT_PO (Page 2669)" instruction.

 

Parameters
The following table shows the parameters of the "SYNC_PO" instruction:

Parameter Declaration Data type Memory area Range of values Description
PART Input PIP I, Q, M, D, L or 

constant
1 to 31 Number of the process image partition of 

the outputs to be updated isochronously.
RET_VAL Return INT I, Q, M, D, P - If an error occurs while the instruction is 

being executed, the return value contains 
an error code.

FLADDR Output WORD I, Q, M, D, L, P - Address of the first byte that has caused 
the error.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code
(W#16#...)*

Explanation

0000 No error occurred.
0001 Consistency warning. The update of the process image partition was distributed over two DP or PN cycles. 

However, the data in one slave or IO device were consistently transferred.
8090 Illegal value in PART parameter, or updating the specified process image partition of the outputs is not 

permitted in this OB. Outputs were not transferred to the I/O. The process image partition of the outputs 
remains unchanged.

8091 The specified process image partition was not yet defined or is not located in the permitted process image 
area on the CPU. Outputs were not transferred to the I/O. The process image partition of the outputs remains 
unchanged.

8092 The process image partition is being updated by the system and cannot be used for the PART parameter. 
8093 The process image partition update is being processed in another OB.
80A0 In the case of update of the specified process image partition of the outputs an access error was detected. 

Incorrect outputs were not transferred to the I/O. During process image partition of the outputs, these outputs 
remain unchanged.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2673



Error code
(W#16#...)*

Explanation

80A1 Access error with consistency warning
In the case of update of the specified process image partition of the outputs an access error with simultaneous 
consistency warning was detected.
● The data of the incorrect outputs were not transferred to the I/O. During process image partition of the 

outputs, the involved outputs remain unchanged.
● The update of the process image partition of the not involved by an access error input data was distributed 

over two DP and PN cycles.
80A2 The update time is after the permitted access window. Outputs were not transferred to the I/O. The process 

image partition of the outputs remains unchanged.
80C1 The update time is before the permitted access window. Outputs were not transferred to the I/O. The process 

image partition of the outputs remains unchanged.
General error 
information

See also:  GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note

If you use the "SYNC_PO" instruction for process image partitions of DP standard slaves for 
which you have defined a consistency area greater than 32 bytes, the error codes of the 
"DPWR_DAT (Page 2719)" instruction are also possible.

 

9.7.3.4 Distributed I/O

RDREC: Read data record

Description
You use the instruction "RDREC" to read the data record with the number INDEX from the 
module addressed using the ID. This may be a module in a central rack or a distributed module 
(PROFIBUS DP or PROFINET IO).

● Use the parameter  ID to select from which module a data record is to be read.  Use only 
the hardware identifier of the module for the "ID" parameter.

● Use the INDEX parameter to select the information to be read from the module. Which data 
records can be read with which data record number depends on the module. For additional 
information, see the manual to the specific module.

● The data records readable via "RDREC" have a different length. Use MLEN to specify the 
maximum number of data record bytes you want to read. If length "0" is selected at the 
parameter MLEN, the complete data record is written at the parameter RECORD.

● The target range RECORD should have at least the length of MLEN bytes. If you read out 
the full data record with MLEN=0, use the maximum length of the data record for RECORD.  
The structure (configuration, data types and length) that you use at the parameter 
RECORD, also depends on which data record is read out by which module.
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● The value TRUE  for the output parameter VALID indicates that the data record was 
successfully transferred to the target range RECORD. In this case, the LEN output 
parameter contains the length of the read data in bytes.

● If an error has occurred during transfer of the data record, this is indicated by the output 
parameter ERROR. In this case, the output parameter STATUS contains the error 
information.

 

 Note

The interface of the "RDREC" instruction is identical to the "RDREC" FB defined in 
"PROFIBUS Guideline PROFIBUS Communication and Proxy Function Blocks according to 
IEC 61131-3".

 

Functional description
"RDREC" is an instruction that works asynchronously, which means its execution extends over 
multiple calls. You start the data record transfer by calling "RDREC" with REQ= 1.

The job status is displayed via the output parameter BUSY and the two central bytes of output 
parameter STATUS. The two central bytes of STATUS correspond to the RET_VAL output 
parameter of the instructions that operate asynchronously.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

The transfer of the data record is complete when the output parameter BUSY has the value 
FALSE .

Parameter
The following table shows the parameters of the "RDREC" instruction:

Parameter Declaration Data type* Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
REQ = 1: Transfer data record

ID Input HW_IO I, Q, M, L or constant Hardware identifier of the hardware module 
(DP/PROFINET IO)
The number is assigned automatically and is 
stored in the properties of the module or of the 
interface in the hardware configuration.

INDEX Input BYTE, DINT, 
INT, SINT, 
UINT, USINT, 
WORD

I, Q, M, D, L or 
constant

Data record number

MLEN Input BYTE, UINT, 
USINT

I, Q, M, D, L or 
constant

Maximum length in bytes of the data record 
information to be read

VALID Output BOOL I, Q, M, D, L New data record was received and is valid.
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The reading process is not yet 

complete.
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Parameter Declaration Data type* Memory area Description
ERROR Output BOOL I, Q, M, D, L ERROR = 1: An error occurred during the 

reading process.
STATUS Output DWORD I, Q, M, D, L Block status or error information
LEN Output UINT I, Q, M, D, L Length of the read data record information
RECORD InOut VARIANT I, Q, M, D, L Target range for the data record read.
* There is no implicit conversion in STL, which is why the range of valid data types may be limited. During programming in 
STL, please note the valid data types. These are displayed in the parameter tooltip.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

 

 Note

If you use "RDREC" to read a data record for PROFINET IO, then negative values in the 
INDEX, MLEN, and LEN parameters will be interpreted as an unsigned 16-bit integer.

 

Parameter STATUS
For interpretation of the STATUS parameter, see Parameter STATUS (Page 2684).

See also
Basics of block access (Page 1267)

WRREC: Write data record

Description
The instruction "WRREC" is used to transfer the RECORD data record to the component 
addressed using ID. This may be a module in a central rack or a distributed component 
(PROFIBUS DP or PROFINET IO).

● Use LEN to specify the length of the data record to be transmitted in bytes. The selected 
length of the source range RECORD should have at least the length of LEN bytes.

● The value TRUE  at output parameter DONE indicates that the data record has been 
successfully transferred.

● If an error has occurred during transfer of the data record, this is indicated by the output 
parameter ERROR. In this case, the output parameter STATUS contains the error 
information.

 

 Note

The interface of the "WRREC" instruction is identical to the "WRREC" FB defined in 
"PROFIBUS Guideline PROFIBUS Communication and Proxy Function Blocks according to 
IEC 61131-3".
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Functional description
"The WRREC" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the data record transfer by calling "WRREC" with REQ  = 1.

The job status is displayed via the output parameter BUSY and the two central bytes of output 
parameter STATUS. The two central bytes of STATUS correspond to the RET_VAL output 
parameter of the instructions that operate asynchronously.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

Note that you must assign the same value to the actual parameter of RECORD for all "WRREC" 
calls that belong to one and the same job. The same applies to the actual parameters of LEN.

The transfer of the data record is complete when the output parameter BUSY has the value 
FALSE.

Parameter
The following table shows the parameters of the instruction "WRREC":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
REQ= 1: Transfer data record

ID Input HW_IO I, Q, M, L or constant ID number of the hardware component (DP/
PROFINET IO)
The number is assigned automatically and is 
stored in the properties of the component or of 
the interface in the hardware configuration.

INDEX Input DINT I, Q, M, D, L or 
constant

Data record number

LEN Input BYTE, UINT, 
USINT

I, Q, M, D, L or 
constant

(hidden)
Maximum length of the data record to be 
transferred in bytes

DONE Output BOOL I, Q, M, D, L Data record was transferred
BUSY Output BOOL I, Q, M, D, L BUSY= 1: The writing process is not yet 

complete.
ERROR Output BOOL I, Q, M, D, L ERROR = 1: An error occurred during the 

writing process.
STATUS Output DWORD I, Q, M, D, L Block status or error information

For interpretation of the STATUS parameter, 
see Parameter STATUS (Page 2684).

RECORD InOut VARIANT I, Q, M, D, L Data record
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

 

 Note

If you use "WRREC" to write a data record for PROFINET IO, negative values in the INDEX 
and LEN parameters will be interpreted as an unsigned 16-bit integer.

 

STATUS parameter
For interpretation of the STATUS parameter, see Parameter STATUS (Page 2684).

GETIO: Read process image

Description
You use the instruction "GETIO" to consistently read out all inputs of a DP standard slave/
PROFINET IO device. The instruction "GETIO" calls the instruction "DPRD_DAT (Page 2717)". 
If there was no error during the data transmission, the data that have been read are entered 
in the target range indicated by INPUTS .

The target range must have the same length that you configured for the selected component.

If you read from a DP standard slave with a modular configuration or with several DP identifiers, 
you can only access the data of one component/DP identifier at the configured start address 
with a "GETIO" call.

Parameter
The following table shows the parameters of the instruction "GETIO":

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMOD

ULE
I, Q, M, D, L or constant Hardware ID of the DP standard slave / 

PROFINET IO device.
STATUS Output DWORD I, Q, M, D, L Contains the error information of 

"DPRD_DAT (Page 2717)" in the form 
DW#16#40xxxx00.

LEN Output INT I, Q, M, D, L Amount of data read in bytes
INPUTS InOut VARIANT I, Q, M, D Target range for the read data. It must have 

the same length as the range that you 
configured for the selected DP standard 
slave / PROFINET IO device. Only the 
BYTE  data type is permitted.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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STATUS parameter
See also: DPRD_DAT: Read consistent data of a DP standard slave (Page 2717).

SETIO: Transfer process image

Description
You use the instruction "SETIO" to consistently transfer data from the source range defined 
by the parameter OUTPUTS  to the addressed DP standard slave / PROFINET IO device, 
and, if necessary, to the process image (if you have configured the relevant address area of 
the DP standard slave / PROFINET IO device as a consistent range in a process image). 
"SETIO" calls the instruction "DPWR_DAT (Page 2719)".

The source range must have the same length that you configured for the selected component.

In the case of a DP standard slave / PROFINET IO device with modular configuration or with 
several DP identifiers, you can only access one DP identifier / component per "SETIO" call.

Parameters
The following table shows the parameters of the "SETIO" instruction:

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMODU

LE
I, Q, M, D, L or 
constant

Hardware ID of the DP standard slave / 
PROFINET IO device.

STATUS Output DWORD I, Q, M, D, L Contains the error information of 
"DPWR_DAT (Page 2719)" in the form 
DW#16#40xxxx00.

OUTPUTS InOut VARIANT I, Q, M, D Source range for the data to be written. It 
must have the same length as the range 
that you configured for the selected DP 
standard slave / PROFINET IO device. 
Only the BYTE data type is permitted.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS
See also: DPWR_DAT: Write consistent data of a DP standard slave (Page 2719).

GETIO_PART: Read process image area

Description
You use the instruction "GETIO_PART" to consistently read out a related part of the inputs of 
an IO module. "GETIO_PART" calls the instruction "DPWR_DAT (Page 2717)".

Use the ID input parameter to select the IO module by means of the hardware ID.
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You use the OFFSET and LEN parameters to specify the portion of the process image area 
to be read. If the input area spanned by OFFSET and LEN is not completely covered by the 
module, the block returns the error code DW#16#4080B700. 

The length of the target range must be larger than or equal to the amount of bytes to be read:

● If there was no error during the data transmission, ERROR receives the value FALSE. The 
data that are read are written to the target range defined at the INPUTS parameter.

● If there was no error during the data transmission, ERROR receives the value TRUE. The 
STATUS parameter receives the error information from "DPRD_DAT".

● If the target range is greater than LEN, then the first LEN bytes of the target range will be 
written. ERROR receives the value FALSE.

Parameters
The following table shows the parameters of the "GETIO_PART" instruction:

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMOD

ULE
I, Q, M, D, L or constant Hardware identifier of the module

OFFSET Input INT I, Q, M, D, L or constant Number of the first byte to be read in the 
process image for the component 
(smallest possible value: 0).

LEN Input INT I, Q, M, D, L or constant Number of bytes to be read.
STATUS Output DWORD I, Q, M, D, L Contains the error information of 

"DPRD_DAT" in the form 
DW#16#40xxxx00, if ERROR = TRUE.

ERROR Output BOOL I, Q, M, D, L Error display:
ERROR = TRUE if an error occurs when 
"DPRD_DAT" is called.

INPUTS InOut VARIANT I, Q, M, D Target range for read data:
If the target range is greater than LEN, the 
first LEN bytes of the target range are 
written.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS
See "RET_VAL" parameter of the "DPRD_DAT (Page 2717)" instruction.

SETIO_PART: Transfer process image area

Description
You can use the "SETIO_PART" instruction to consistently write data from the source area 
spanned by OUTPUTS to the outputs of an IO module. "SETIO_PART" calls the instruction 
"DPWR_DAT (Page 2719)".
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Use the ID input parameter to select the IO module by means of the hardware ID.
You use the OFFSET and LEN parameters to specify the portion of the process image area 
to be written for the components addressed by means of ID. If the output area spanned by 
OFFSET and LEN is not completely covered by the module, the block returns the error code 
DW#16#4080B700.

The length of the source range must be greater than or equal to the number of bytes to be 
written:

● If there was no error during the data transmission, ERROR receives the value FALSE.

● If there was an error during the data transmission, ERROR receives the value TRUE, and 
STATUS receives the error information of "DPWR_DAT".

● If the source range is greater than LEN, the first LEN bytes from OUTPUTS are transferred. 
ERROR receives the value FALSE.

Parameter
The following table shows the parameters of the instruction "SETIO_PART":

Parameter Declaration Data type Memory area Description
ID Input HW_SUBMO

DULE
I, Q, M, D, L or constant Hardware identifier of the IO module.

OFFSET Input INT I, Q, M, D, L or constant Number of the first byte to be written in the 
process image for the component (smallest 
possible value: 0).

LEN Input INT I, Q, M, D, L or constant Number of bytes to be written.
STATUS Output DWORD I, Q, M, D, L Contains the error information of 

"DPWR_DAT" in the form 
DW#16#40xxxx00, if ERROR = TRUE.

ERROR Output BOOL I, Q, M, D, L Error display:
ERROR = TRUE if an error occurs when 
"DPWR_DAT" is called.

OUTPUTS InOut VARIANT I, Q, M, D Source range for the data to be written:
If the source range is greater than LEN, the 
first LEN bytes are transferred from 
OUTPUTS.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameters STATUS and ERROR
See instruction "DPWR_DAT  (Page 2719)".
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RALRM: Receive interrupt

Description RALRM

Description
The instruction receives an interrupt with all corresponding information from an I/O module 
(centralized configuration) or from a module of a DP slave or PROFINET IO device and 
supplies this information to its output parameters.

The information in the output parameters contains the start information of the called OB as 
well as information of the interrupt source.

For a central configuration, the configuration of the data structure of the target range AINFO 
corresponds to the data structure of PROFINET IO.

Call "RALRM" only within the interrupt OB started by the CPU operating system as a result of 
the I/O interrupt that is to be examined.

 

 Note

If you call "RALRM" in an OB whose start event is not an I/O interrupt, the instruction will 
provide correspondingly reduced information in its outputs.
Make sure to use different instance DBs when you call "RALRM" in different OBs. If you 
evaluate data resulting from an "RALRM" call outside of the associated interrupt OB, you 
should moreover use a separate instance DB per OB start event.

 

 Note

The interface of the "RALRM" instruction is identical to the "RALRM" FB defined in 
"PROFIBUS Guideline PROFIBUS Communication and Proxy Function Blocks according to 
IEC 61131-3".

 

Calling RALRM
"RALRM" can be called in three operating modes (MODE parameter). These are explained in 
the table below.

MODE RALRM ...
0 ... shows the component that triggered the interrupt in the ID output parameter and writes TRUE in the NEW 

output parameter.
1 ... writes all output parameters, independent of the interrupt triggering component.
2 ... checks whether the component specified in the F_ID input parameter has triggered the interrupt.

● If not, NEW  = FALSE
● If yes, NEW  = TRUE and all other output parameters are written.
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Parameters
The following table shows the parameters of the "RALRM" instruction:

Parameter Declaration Data type Memory area Description
MODE Input INT I, Q, M, D, L or 

constant
Mode

F_ID Input HW_IO D, L or constant Hardware identifier of the module.
The number is assigned automatically and is 
stored in the hardware configuration properties 
of the component or interface.

MLEN Input UINT I, Q, M, D, L or 
constant

Maximum length of the interrupt information to 
be received in bytes.
With MLEN = 0, all data specified at the AINFO 
parameter are read.

NEW Output BOOL I, Q, M, D, L A new interrupt was received.
STATUS 
(Page 2684) 

Output DWORD I, Q, M, D, L Error code

ID Output HW_IO I, Q, M, D, L Hardware identifier of the module from which the 
interrupt was received.

LEN Output UINT I, Q, M, D, L Length of the received interrupt information
TINFO 
(Page 2687) 

InOut VARIANT I, Q, M, D, L Destination area for OB start and management 
information

AINFO 
(Page 2700) 

InOut VARIANT I, Q, M, D, L Destination area for header information and 
additional interrupt information
For AINFO , you should provide a length of at 
least MLEN  bytes.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

 

 Note

If you select a target range  (Page 2706)TINFO or AINFO that is too short, RALRM cannot 
enter the full information.
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Parameter STATUS

Description
The STATUS  output parameter contains error information. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num ● B#16#00, if no error

● Function ID from DPV1-PDU:
In the event of an error, B#16#80  is output (in the event of an error reading a 
data record B#16#DE and writing a data record B#16#DF).
If no DPV1 protocol element is used, then B#16#C0 will be output.

STATUS[2] Error_Decode Location of the error ID
STATUS[3] Error_Code_1 Error ID
STATUS[4] Error_Code_2 Manufacturer-specific error ID extension

Field element  STATUS[2]
STATUS[2] can have the following values:

Error_Decode 
(B#16#...)

Source Meaning

00 to 7F CPU No error or no warning
80 DPV1 Error according to IEC 61158-6
81 to 8F CPU B#16#8x shows an error in the xth call parameter of the instruction.
FE, FF DP profile Profile-specific error

Field element  STATUS[3]
STATUS[3] can have the following values:

Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

00 00  No error, no warning
    
70 00 reserved, reject Initial call; no active data record transfer
 01 reserved, reject Initial call; data record transfer has started
 02 reserved, reject Intermediate call; data record transfer already active
    
80 81  The system data type at parameter TINFO does not match 

the call environment of the instruction.
The used system data type must match the organization 
block in the user program (example: for a time-delay 
interrupt OB you need the system data type TI_Delay).

 90 reserved, pass Invalid logical start address
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Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

 92 reserved, pass Illegal type for VARIANT pointer
 93 reserved, pass The DP component addressed via ID or F_ID is not 

configured.
 96  The "RALRM (Page 2682)" cannot supply the OB start 

information, management information, header information, 
or additional interrupt information.
For OBs 4x, 55, 56, 57, 82 and 83, you can use the 
"DPNRM_DG (Page 2732)" instruction to read the current 
diagnostic frame of the relevant DP slave asynchronously 
(address information from OB start information).

 A0 read error Negative acknowledgment while reading the module
 A1 write error Negative acknowledgment when writing 

to the module
 A2 module failure DP protocol error at layer 2 (e.g., slave failure or bus 

problems)
 A3 reserved, pass ● PROFIBUS DP: DP protocol error with Direct-Data-Link-

Mapper or User-Interface/User
● PROFINET IO: General CM error

 A4 reserved, pass Communication on PBUS+ disrupted
 A5 reserved, pass –
 A7 reserved, pass DP slave or module is occupied (temporary error
 A8 version conflict DP slave or module reports non-compatible versions
 A9 feature not 

supported
Function is not supported by DP slave or module

 AA to AF user specific DP slave or module reports a manufacturer-specific error 
in its application. Please check the documentation from the 
manufacturer of the DP slave or module.

 B0 invalid index Data record not known in module

Illegal data record number ≥ 256
 B1 write length error Error at length specification:

● With "RALRM (Page 2682)": length error in AINFO 
(Page 2700)

● With "RDREC (Page 2674)": length error in MLEN
● With "WRREC (Page 2676)": length error in LEN

 B2 invalid slot The configured slot is 
not assigned.

 B3 type conflict Actual module type 
does not match 
specified module type

 B4 invalid area DP slave or module reports access to an invalid area
 B5 state conflict DP slave or module not ready
 B6 access denied DP slave or module denies access
 B7 invalid range DP slave or module reports an invalid range for a parameter 

or value
 B8 invalid parameter DP slave or module reports an invalid parameter
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Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

 B9 invalid type DP slave or module reports an invalid type
With "RDREC (Page 2674)": buffer too small (subsets 
cannot be read)
With "WRREC (Page 2676)": buffer too small (subsets 
cannot be written)

 BA to BF user specific DP slave or module reports a manufacturer-specific error 
when accessing. Please check the documentation from the 
manufacturer of the DP slave or module.

 C0 read constrain 
conflict

With "WRREC (Page 2676)": the data can only be written 
when the CPU is in STOP mode. Note: this means that 
writing by the user program is not possible. You can only 
write the data online with PG/PC.
With "RDREC (Page 2674)": the module routes the data 
record, but either no data is present or the data can only be 
read when the CPU is in STOP mode. Note: if data can only 
be read when the CPU is in STOP mode, then an evaluation 
by the user program is not possible. In this case, you can 
only read the data online with PG/PC.

 C1 write constrain 
conflict

The data of the previous write job on the module for the 
same data record have not yet been processed by the 
module.

 C2 resource busy The module is currently processing the maximum possible 
number of jobs for a CPU.

 C3 resource unavailable The required operating resources are currently occupied.
 C4  Internal temporary error. Job could not be executed.

Repeat the job. If this error occurs often, check your 
installation for sources of electrical interference.

 C5  DP slave or module not available.
 C6  Data record transfer was canceled due to priority class 

cancellation
 C7  Job aborted due to warm or cold restart on the DP master
 C8 to CF  DP slave or module reports a manufacturer-specific 

resource error. Please check the documentation from the 
manufacturer of the DP slave or module.

 Dx user specific DP slave specific. Refer to the description of the DP slave.
    
81 00 to FF  Error in the initial call parameter (with "RALRM 

(Page 2682)": MODE)
 00  Illegal operating mode
    
82 00 to FF  Error in the second call parameter
: :  :
88 00 to FF  Error in the eighth call parameter (with "RALRM 

(Page 2682)": TINFO (Page 2687))
 01  Wrong syntax ID
 23  Quantity structure exceeded or target range too small
 24  Wrong range ID
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Error_Decode
(B#16#...)

Error_Code_1
(B#16#...)

Explanation 
according to DVP1

Meaning

 32  DB/DI no. out of user range
 3A  DB/DI no. is NULL for area ID DB/DI or specified DB/DI 

does not exist
    
89 00 to FF  Error in the ninth call parameter (with "RALRM 

(Page 2682)": AINFO (Page 2700))
 01  Wrong syntax ID
 23  Quantity structure exceeded or target range too small
 24  Wrong range ID
 32  DB/DI no. out of user range
 3A  DB/DI no. is NULL for area ID DB/DI or specified DB/DI 

does not exist
    
8A 00 to FF  Error in the 10th call parameter
: :  :
8F 00 to FF  Error in the 15th call parameter
    
FE, FF 00 to FF  Profile-specific error

Field element  STATUS[4]
With DPV1 errors, the DP master passes on STATUS[4] to the CPU and the instruction. 
Without DPV1 error, this value is set to 0, with the following exceptions for "RDREC":

● STATUS[4]  contains the target range length from RECORD, if MLEN  > the target range 
length from RECORD

● STATUS[4]=MLEN, if the actual data record length  < MLEN < the target range length from 
RECORD

● STATUS[4]=0, if STATUS[4]> 255 would have to be set

In PROFINET IO, STATUS[4] has the value "0".

Parameter TINFO

Data structure of the destination area TINFO
The data structure of the destination area TINFO contains the start information of the 
organization block in which "RALRM" is currently being called.

The TINFO destination area can contain the start information with standard access or 
optimized access. The format of the start information in the TINFO destination area must 
always match the start information of the corresponding organization block.
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● The start information of an OB with standard access is always stored in the first 20 bytes 
of the "Temp" section in the block interface. Use the "TI_Classic" data structure for this.

● The start information of an OB with optimized access is always written to the "Input" section. 
Use a data structure for the specific OB type for these OBs.

Changing the block access (standard/optimized) also changes the block interface.

The following table provides an overview of the data structures that are used depending on 
the organization block at the TINFO parameter.

Name of the data structure S7-1200 
CPUs as 
of version

S7-1500 
CPUs as 
of version

Data structure used for:

Data structure for organization blocks with standard access
 TI_Classic - V1 Organization blocks without optimized block access.
Data structure for organization blocks with optimized block access
 TI_ProgramCycle V2 V1 Cycle OB (program cycle)

TI_Startup V2 V1 Startup OB (startup)
TI_Delay V2 V1 Time delay interrupt
TI_Cyclic V2 V1 Cyclic interrupt OB
TI_HWInterrupt V2 V1 Hardware interrupt OB
TI_TimeError V2 V1 Time error OB
TI_DiagnosticInterrupt V2 V1 Diagnostic error interrupt OB
TI_PlugPullModule V2 V1 Pull/plug of modules OB
TI_StationFailure V2 V1 Rack or station failure OB
TI_ProgIOAccessError V2

 
V1
 

● Programming error OB
● I/O access error OB

TI_TimeOfDay V2 V1 Time-of-day interrupt OB
TI_SynchCycle - V1 Synchronous cycle interrupt OB
TI_Submodule V2 V1 ● Status interrupt OB

● Update interrupt OB
● OB for manufacturer or profile-specific interrupt

Data structure for organization blocks with standard access
The following shows the  TI_Classic data structure:

Parameter Data type Byte Description
TI_Classic Data structure for organization blocks with optimized block access.
 Bytes 0 to 19:  Start information of the OB in which "RALRM" is currently being called.*

EV_CLASS BYTE 0 Event class
Example OB1:
● Bits 0-3: ID of the event (1 = incoming event)
● Bits 4-7: Event class (1 = Event class 1)
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Parameter Data type Byte Description
EV_NUM BYTE 1 Event number (depending on OB type)

Example OB1 (SCAN_1):
● SCAN_1 = 1 for first call
● SCAN_1 = 3 for all additional calls

PRIORITY BYTE 2 Priority class
NUM BYTE 3 OB number
TYP2_3 BYTE 4 Additional information 

Different information is stored in the BYTES "TYP2_3" and "TYPE 1" depending on 
the OB type used.
What these are is described in the documentation for the organization blocks.
Example (OB1):
● TYP2_3: OB1_RESERVED_1 (reserved)
● TYP1: OB1_RESERVED_2 (reserved)

TYP1 BYTE 5

ZI1 WORD 6 to 7 Additional information 
Different information is stored in "ZI1" depending on the OB type used.
What these are is described in the documentation for the organization blocks.
Example (OB1):
● ZI1: OB1_PREV_CYCLE (runtime of previous cycle in ms)

ZI2_3 DWORD 8 to 11 Additional information
Different information is stored in "ZI2_3" depending on the OB type used.
What these are is described in the documentation for the organization blocks.
Example (OB1):
● ZI2: OB1_MIN_CYCLE (minimum cycle time (ms) since the last startup)
● ZI3: OB1_MAX_CYCLE (maximum cycle time (ms) since the last startup)

OB_DATE_
TIME

DATE_AN
D_TIME 
(DT)

12 to 19 Date and time-of-day when the OB was called.

Bytes 20 and 21: Address information
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Parameter Data type Byte Description
address WORD 20 and 

21
Address information like S7-300/400 CPUs:
● In a central configuration, the rack number (0-31):

● For a distributed configuration with PROFIBUS DP: 
– DP master system ID (1-31)
– Station number (0-127).

● In a distributed configuration with PROFINET IO:
– The last two positions in the PROFINET IO system ID (0-15). To obtain the 

complete PROFINET IO system ID, you must add 100 (decimal) to it.
– Station number (0-2047).

Bytes 22 to 31:  Management information
slv_prfl BYTE 22 Slave profile like S7-300/400 CPUs:

● In a central configuration: 0 (data record 0 or data record 1)
● In a distributed configuration:

– Bit 0 to 3: Slave 
type
- 0000: DP (structure data record 0)
- 0001: DPS7 (structure data record 0 or data record 1)
- 0010:  DPS7 V1 (structure data record 0 or data record 1)
- 0011: DPV1 (structure according to PROFIBUS DP standard)
- 0100 – 0111: Reserved
- 1000: PROFINET IO (structure according to PROFINET IO standard)
- from 1001: Reserved

– Bit 4 to 7: Profile type (reserved)
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Parameter Data type Byte Description
intr_type BYTE 23 Interrupt info type like S7-300/400 CPUs:

● In a central configuration: 0
● In a distributed configuration: 

– Bit 0 to 3: Interrupt info type
- 0000: Interrupt comes from a configured remote module
- 0001: Interrupt comes from a non-DPV1 slav / non IO device or a slot that 
is not configured
- 0010: Interrupt generated in the CPU
- from 0011: Reserved

– Bit 4 to 7: Structure version
- 0000: Initial
- from 0001: Reserved

flags1 BYTE 24 Flags of the PROFIBUS DP master interface module / PROFINET IO controller 
interface module like S7-300/400 CPUs:
● In a central configuration: 0
● In a distributed configuration: 

– Bit 0 = 0: Interrupt originating from an integrated interface
 module (PROFINET IO or PROFIBUS DP)

– Bit 0 = 1: Interrupt originating from an external interface module 
(PROFINET IO or PROFIBUS DP)

– Bit 1 to 7: Reserved
flags2 BYTE 25 Flags of the PROFIBUS DP master interface module / PROFINET IO controller 

interface module like S7-300/400 CPUs:
● In a central configuration: 0
● For a distributed configuration with PROFIBUS DP: 

– Bit 0: EXT_DIAG_FLAG from the diagnostics message frame, or 0 if this bit 
does not exist in the interrupt The bit is 1 if the DP slave is faulty.

– Bit 1 to 7: Reserved
● In a distributed configuration with PROFINET IO:

– Bit 0: ARDiagnosisState or 0 if there is no information in the interrupt. The 
bit is 1 if the IO device is faulty.

– Bit 1 to 7: Reserved
id UINT 26 and 

27
Management information
● In a central configuration: 0
● For a distributed configuration with PROFIBUS DP: PROFIBUS ID number as 

unique identifier of the PROFIBUS DP slave
● In a distributed configuration with PROFINET IO: PROFINET IO device ID 

number as unique identifier of the PROFINET IO device
manufacture
r

UINT 28 and 
29

Manufacturer ID (only in a distributed configuration with PROFINET IO).

instance UINT 30 and 
31

Ident number of the instance (only in a distributed configuration with PROFINET 
IO).

*The start information depends on the OB used. You can find the start information of each OB type at the interface or in the 
documentation of the OB.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2691



Data structures for organization blocks with optimized block access
The data structures for organization blocks with optimized block access have the following 
format:

● Bytes 0 to 3:  Format of the start information, class and number of the called OB (same 
structure for all data structures).

● Bytes 4 to 19:  Optimized start information (structure depends on the OB type). The data 
in bytes 4 to 19 correspond to the structure and content of the corresponding OB interface.

● Bytes 20 to 31:  In addition, the address and management information for certain OBs. The 
data in bytes 20 to 31 correspond to the data of 20 to 31 bytes of the  TI_Classic data 
structure.

The format of the data structures is described in the following tables.

Table 9-40 Cycle OB: Data structure TI_ProgramCycle

Parameter Data type Byte Description
TI_ProgramCycle Data structure for cycle OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=1)
OB_Nr UINT 2 OB number (1...32767).
Initial_Call BOOL 4 = TRUE in the first call of this OB:

● Transition from STOP or HOLD to RUN
● After reloading

Remanence BOOL 5 = TRUE, if retentive data are available.

Table 9-41 Startup OB: Data structure TI_Startup

Parameter Data type Byte Description
TI_Startup Data structure for startup OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=100)
OB_Nr UINT 2 OB number (1...32767).
LostRetentive BOOL 4 =TRUE, if the contents of retentive data areas have been lost.
LostRTC BOOL 5 =TRUE, if the time-of-day of the real-time clock has been lost.

Table 9-42 Time delay interrupt OB: Data structurer TI_Delay

Parameter Data type Byte Description
TI_Delay Data structure for time delay interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

Programming the PLC
9.7 References

WinCC Professional V13.0
2692 System Manual, 02/2014



Parameter Data type Byte Description
OB_Class USINT 1 OB class (=20)
OB_Nr UINT 2 OB number (1...32767).
Sign WORD 4 User ID: Input parameter SIGN from the call of the "SRT_DINT (Page 2823)" 

instruction.

Table 9-43 Cyclic interrupt OB: Data structure TI_Cyclic

Parameter Data type Byte Description
TI_Cyclic Data structure for cyclic interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=30)
OB_Nr UINT 2 OB number (1...32767).
Initial_Call BOOL 4 = TRUE in the first call of this OB

● At the transition from STOP or HOLD to RUN
● After reloading

Event_Count INT 6 Number of discarded start events since the last start of this OB.

Table 9-44 Hardware interrupt OB: Data structure TI_HWInterrupt

Parameter Data type Byte Description
TI_HWInterrupt Data structure for hardware interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=40)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_IO 4 Hardware identifier of the module that triggers the hardware interrupt.
USI WORD 6 Identifier for future extensions (not user-relevant).
IChannel USINT 8 Number of the channel that triggered the hardware interrupt.
EventType BYTE 9 Identifier for the event type associated with the event triggering the interrupt (e.g., 

rising edge).
You can find this ID in the description of the respective module.

address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UNIT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UNIT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UNIT 30 See "instance" parameter for the TI_Cassic data structure.
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Table 9-45 Time error OB: Data structure TI_TimeError

Parameter Data type Byte Description
TI_TimeError Data structure for time error OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=80)
OB_Nr UINT 2 OB number (1...32767).
Csg_OBnr OB_ANY 4 Number of the OB that was being executed when the time error occurred.
Fault_ID BYTE 7 Error code. Possible values:

● B#16#01: Cycle time exceeded
● B#16#02: The requested OB is still being processed.
● B#16#05: Expired time-of-day interrupt due to time jump.
● B#16#06: Expired time-of-day interrupt upon re-entry into RUN after HOLD.
● B#16#07: Overflow of the OB request buffer for the current priority class.
● B#16#08: Isochronous mode interrupt - time error.
● B#16#09: Interrupt loss due to high interrupt load
● B#16#0B: Technology synchronization interrupt - time error

Csg_Prio UNIT 8 Priority of the OB that was being executed when the time error occurred.

Table 9-46 Diagnostic interrupt OB: Data structure TI_DiagnosticInterrupt

Parameter Data type Byte Description
TI_DiagnosticInterrupt Data structure for diagnostic interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=82)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_ANY 4 Hardware identifier of the hardware object that triggered the diagnostic interrupt.
IO_State WORD 6 Status of the hardware object:

● Bit 0: Good
● Bit 1: Disabled
● Bit 2: Maintenance required
● Bit 3: Maintenance demanded
● Bit 4: Error
● Bit 5: Not accessible
● Bit 6: Qualified
● Bit 7: Not available

Channel UINT 8 Channel number
MultiError BOOL 10 =TRUE, if there is more than one error.
address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
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Parameter Data type Byte Description
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.

Table 9-47 Pull/plug interrupt OB: Data structure TI_PlugPullModule

Parameter Data type Byte Description
TI_PlugPullModule Data structure for pull/plug interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=83)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_IO 4 Hardware identifier of the affected module or submodule
Event_Class BYTE 6 ● B#16#38: (Sub)module plugged

● B#16#39: (Sub)module pulled or not responding
Fault_ID BYTE 7 Error code

The following table shows the events that cause the start of the pull/plug interrupt 
OB.
● With Event_Class = B#16#38 - (sub-)module plugged:

– B#16#54: PROFINET IO submodule inserted and matches configured 
submodule

– B#16#55: PROFINET IO submodule inserted, but does not match configured 
submodule

– B#16#56: PROFINET IO submodule inserted; but error in module parameter 
assignment

– B#16#57: PROFINET IO submodule or module inserted, but with a problem 
or maintenance

– B#16#58: PROFINET IO submodule, access error corrected
● With Event_Class = B#16#39 - (sub-)module pulled or cannot be reached:

– B#16#51: PROFINET IO module removed
– B#16#54: PROFINET IO submodule removed

address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.
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Table 9-48 Rack error OB: Data structure TI_StationFailure

Parameter Data type Byte Description
TI_StationFailure Data structure for rack error OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=86)
OB_Nr UINT 2 OB number (1...32767).
LADDR HW_Devi

ce
4 Hardware identifier of the defective hardware object.

Event_Class BYTE 6 ● B#16#38: (Sub)module plugged
● B#16#39: (Sub)module pulled or not responding

Fault_ID BYTE 7 Error code
The following table shows the events that cause the start of the pull/plug interrupt 
OB.
● With Event_Class = B#16#38 - (sub-)module plugged:

– B#16#54: PROFINET IO submodule inserted and matches configured 
submodule

– B#16#55: PROFINET IO submodule inserted, but does not match configured 
submodule

– B#16#56: PROFINET IO submodule inserted; but error in module parameter 
assignment

– B#16#57: PROFINET IO submodule or module inserted, but with a problem 
or maintenance

– B#16#58: PROFINET IO submodule, access error corrected
● With Event_Class = B#16#39 - (sub-)module pulled or cannot be reached:

– B#16#51: PROFINET IO module removed
– B#16#54: PROFINET IO submodule removed

address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.

Table 9-49 Programming error OB / I/O access error OB: Data structure TI_ProgIOAccessError

Parameter Data type Byte Description*
TI_ProgIOAccessError Data structure for programming error OB and I/O access error OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 
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Parameter Data type Byte Description*
OB_Class USINT 1 OB class:

● =121 for programming error OB 
● =122 for I/O access error OB

OB_Nr UINT 2 OB number (1...32767).
BlockNr UINT 4 Number of the block in which the programming error occurred.
Reaction USINT 6 ● 0: Ignore error

● 1: Substitute bad value
● 2: Skip command

Fault_ID BYTE 7 Error code
● B#16#21: BCD conversion error
● B#16#22: Area length error when reading
● B#16#23: Area length error when writing
● B#16#24: Range error when reading
● B#16#25: Range error when writing
● B#16#26: Error in timer no.
● B#16#27: Error in counter no.
● B#16#28: Read access to a byte, word or double word with a pointer whose bit 

address is not zero
● B#16#29: Write access to a byte, word or double word with a pointer whose bit 

address is not zero
● B#16#:30: Write access to a write-protected global DB
● B#16#31: Write access to a write-protected instance DB
● B#16#32: DB number error when accessing a global DB
● B#16#33: DB number error when accessing an instance DB
● B#16#34: Number error during FC call
● B#16#35: Number error during FB call
● B#16#42: I/O access error, reading
● B#16#43: I/O access error, writing
● B#16#3A: Access to a DB that is not loaded; the DB number is located in the 

permitted area
● B#16#3C: Access to an FC that is not loaded; the FC number is within the 

permissible range
● B#16#3D: Access to an instruction (SFC) that is not loaded; the SFC number is 

within the permissible range
● B#16#3E: Access to an FB that is not loaded; the FB number is within the 

permissible range
● B#16#3F: Access to an SFB that is not available; the SFB number is within the 

permissible range
BlockType USINT 8 Type of block in which the error has occurred:

● OB: B#16#88
● FC: B#16#8C
● FB: B#16#8E
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Parameter Data type Byte Description*
Area USINT 9 Memory area in which the incorrect access occurred:

● Local data: B#16#40 to 4E, 86, 87, 8E, 8F, C0 to CE
● Process image input: B#16#01
● Process image output: B#16#02
● Technology DB: B#16#04
● I: B#16#81
● Q: B#16#82
● M: B#16#83
● DB: B#16#84, 85, 8A, 8B

DBNr DB_ANY 10 DB no. if AREA = DB (global DB or instance DB)
Only relevant for programming error OB.

Csg_OBNr OB_ANY 12 OB number:
● 121: Programming error OB
● 122: I/O access error OB

Csg_Prio USINT 14 OB priority 
Width USINT 15 Type of access during which the error occurred:

● Bit: B#16#00
● Byte: B#16#01
● Word: B#16#02
● DWord: B#16#03
● LWord: B#16#04

* Only certain output values are possible depending on the OB (I/O access error OB or programming error OB) from which 
information is read.

Table 9-50 Time-of-day interrupt OB: Data structure TI_TimeOfDay

Parameter Data type Byte Description
TI_TimeOfDay Data structure for time-of-day interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class (=10)
OB_Nr UINT 2 OB number (1...32767).
CaughtUp BOOL 4 =TRUE if an OB call was executed subsequently because time was adjusted ahead
SecondTime BOOL 5 =TRUE if an OB was called a second time because time was adjusted back. Note: 

SecondTime is set only once in situations in which the time is set back.

Table 9-51 Isochronous mode interrupt OB: Data structure TI_SynchCycle

Parameter Data type Byte Description
TI_SynchCycle Data structure for isochronous mode interrupt OB
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 
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Parameter Data type Byte Description
OB_Class USINT 1 OB class (=61)
OB_Nr UINT 2 OB number (1...32767).
Initial_Call BOOL 4 = TRUE in the first call of this OB:

● Transition from STOP or HOLD to RUN
● After reloading

IO _System USINT 5 Number of the distributed I/O system triggering the interrupt
Event_Count INT 6 ● = n: Number of lost cycles

● = -1: An unknown number of cycles has been lost (e.g., because cycle has 
changed).

PIP_Input BOOL 10 =TRUE: The associated process image of the inputs is up-to-date
PIP_Output BOOL 11 =TRUE: The associated process image of the outputs was transferred to the outputs 

in good time after the last cycle
SyncCycleTim
e

LTIME 16 Calculated cycle time

Table 9-52 Status interrupt OB / update interrupt OB for manufacturer or profile-specific interrupt: Data structure 
TI_Submodule

Parameter Data type Byte Description
TI_Submodule Data structure for status interrupt OB / update interrupt OB for manufacturer or 

profile-specific interrupt
 SI_Format USINT 0 Format of the start information:

● 16#FF: None
● 16#FE: Optimized start information 

OB_Class USINT 1 OB class
● =55 for status interrupt OB
● =56 for update interrupt OB
● =57 for manufacturer or profile-specific interrupt OB

OB_Nr UINT 2 OB number (1...32767).
LADDR HW_IO 4 Hardware address of the component triggering the interrupt
Slot UINT 6 Slot number of the component triggering the interrupt
Specifier WORD 8 Interrupt specifier from the interrupt frame
address WORD 20 See "address" parameter for the TI_Cassic. data structure 
slv_prfl BYTE 22 See "slv_prfl" parameter for the TI_Cassic data structure.
intr_type BYTE 23 See "intr_type" parameter for the TI_Cassic data structure.
flags1 BYTE 24 See "flags1" parameter for the TI_Cassic data structure.
flags2 BYTE 25 See "flags2" parameter for the TI_Cassic data structure.
id UINT 26 See "id" parameter for the TI_Cassic data structure.
manufacturer UINT 28 See "manufacturer" parameter for the TI_Cassic data structure.
instance UINT 30 See "instance" parameter for the TI_Cassic data structure.
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Parameter AINFO

Data structure of the destination area AINFO with interrupts from PROFIBUS DP

Byte Meaning
0 to 3 Header information, for exact description, see below
4 to 63 Additional interrupt information: data for the respective interrupt:

distributed: ARRAY[0] to ARRAY[59]

 

Structure of the header information with interrupts from PROFIBUS DP

Byte Data type Meaning
0 BYTE Length of the received interrupt information in bytes

central:
distributed:

4 to 224
4 to 63

1 BYTE central: Reserved
distributed: ID for the interrupt type

1:
2:
3:
4:
5:
6:
31

Diagnostics interrupt

Process interrupt

Pull interrupt
Plug interrupt

Status interrupt

Update interrupt

Failure of an expansion device, DP master system or DP 
station

32 to 126: Manufacturer-specific interrupt
2 BYTE Slot number of the component that triggered the interrupt
3 BYTE central: Reserved

distributed: Specifier
Bits 0 and 1: 0: No further information;

1: Incoming event, fault at slot

2: Outgoing event, fault at slot cleared

3: Outgoing event, slot still faulty
Bit 2: Add_Ack
Bits 3 to 7: Sequence number
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Data structure of the destination area AINFO with interrupts from PROFINET IO or central I/O devices

Byte Meaning
0 to 25 Header information, for exact description, see below
26 to 1431 Additional interrupt information: Standardized diagnostic data for the respective interrupt: 

ARRAY[0] to ARRAY[1405]
Note: The additional interrupt information may also be omitted.

 

Structure of the header information with interrupts from PROFINET IO or central I/O devices

Byte Data type Meaning
0 and 1 WORD ● Bits 0 to 7: Block type

● Bits 8 to 15: Reserved
2 and 3 WORD Block length
4 and 5 WORD Version:

● Bits 0 to 7: low byte
● Bits 8 to 15: high byte

6 and 7 WORD ID for interrupt type:
● 1: Diagnostics interrupt (incoming)
● 2: Process interrupt
● 3: Remove module interrupt
● 4: Insert module interrupt
● 5: Status interrupt
● 6: Update interrupt
● 7: Redundancy interrupt
● 8: Controlled by supervisor
● 9: Released by supervisor
● 10: Configured module not inserted
● 11: Return of the sub-module
● 12: Diagnostics interrupt (outgoing)
● 13: Slave-to-slave connection alarm
● 14: Neighborhood change alarm
● 15: Clock synchronization message (bus end)
● 16: Clock synchronization alarm (device end)
● 17: Network component alarm
● 18: Time synchronization alarm (bus end)
● 19 to 31: Reserved
● 32 to 127: Manufacturer-specific interrupt
● 128 to 65535: Reserved

8 to 11 DWORD API (Application Process Identifier)
12 to 13 WORD Slot number of the component triggering the interrupt (value range 0 to 65535)
14 to 15 WORD Submodule slot number of the component triggering the interrupt (value range 0 to 

65535)
16 to 19 DWORD Module identification; specific information on the source of the interrupt
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Byte Data type Meaning
20 to 23 DWORD Submodule identification; specific information on the source of the interrupt
24 to 25 WORD Interrupt specifier:

● Bits 0 to 10: Sequence number (value range 0 to 2047)
● Bit 11: Channel diagnostics:

0: No channel diagnostics available
1: Channel diagnostic information exists

● Bit 12: Status of manufacturer-specific diagnostics:
0: No manufacturer-specific status information available
1: Manufacturer-specific status information available

● Bit 13: Status of diagnostics for sub-module:
0: No status information available, all errors have been corrected
1: At least one item of channel diagnostics and/or status information is available

● Bit 14: Reserved
● Bit 15: Application relationship diagnosis state:

– 0: None of the modules configured within this application relationship reports 
diagnostic information

– 1: At least one of the modules configured in this AR is reporting diagnostic 
information

 

Structure of the additional interrupt information for interrupts from PROFINET IO or central I/O

The additional interrupt information for PROFINET IO depends on the format identifier. It can 
comprise multiple data blocks with the same or different format identifier. The following format 
identifiers are available:
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● W#16#0000 to W#16#7FFF: Manufacturer-specific diagnostics

Byte Data type Meaning
0 to 1 WORD Format identifier for the structure of the following data serving as 

additional interrupt information
W#16#0000 to W#16#7FFF: Manufacturer-specific diagnostics

2 to n BYTE See manufacturer's manual.

● W#16#8000: Channel diagnostics
Channel diagnostics is output in blocks of 6 bytes each. The additional interrupt information 
(without format identifier) is only output for disrupted channels.

Byte Data type Meaning
0 to 1 WORD Format identifier for the structure of the following data serving as 

additional interrupt information
W#16#8000: Channel diagnostics

2 to 3 WORD Channel number of the component triggering the interrupt (value range: 
0 to 65535):
● W#16#0000 to W#16#7FFF: Channel number of the interface module/

sub-module
● W#16#8000: The generic substitute for the entire sub-module
● W#16#8001 to W#16#FFFF: Reserved

4 BYTE Bits 0 to 2: Reserved
Bits 3 to 4: Type of error:

● 0: Reserved
● 1: Incoming error
● 2: Outgoing error
● 3: Outgoing error, other errors present

Bits 5 to 7: Type of channel:
● 0: Reserved
● 1: Input channel
● 2: Output channel
● 3: Input/output channel
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Byte Data type Meaning
5 BYTE Data format:

● B#16#00: Free data format
● B#16#01: Bit
● B#16#02: 2 bits
● B#16#03: 4 bits
● B#16#04: Byte
● B#16#05: Word
● B#16#06: Double word
● B#16#07: 2 double words
● B#16#08 to B#16#FF: Reserved

6 to 7 WORD Type of error:
● W#16#0000: Reserved
● W#16#0001: Short circuit
● W#16#0002: Undervoltage
● W#16#0003: Overvoltage
● W#16#0004: Overload
● W#16#0005: Overtemperature
● W#16#0006: Wire break
● W#16#0007: High limit exceeded
● W#16#0008: Low limit exceeded
● W#16#0009: Error
● W#16#000A to W#16#000F: Reserved
● W#16#0010 to W#16#001F: Manufacturer-specific
● W#16#0020 to W#16#00FF: Reserved
● W#16#0100 to w#16#7FFF: Manufacturer-specific
● W#16#8000: Device diagnostics available
● W#16#8001 to W#16#FFFF: Reserved
Not all channels support every error type. For detailed information, refer 
to the description of the diagnostic data for the specific device.

 

  Note

The section from "channel number" to "type of error" can occur from 0 to n times.
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● W#16#8001: MULTIPLE (different types of diagnostic information are transmitted). In this 
case, the additional interrupt information is transmitted as blocks of variable length.

Byte Data type Meaning
0 to 1 WORD Format identifier for the structure of the following data serving as additional 

interrupt information
W#16#8001: Manufacturer-specific diagnostics and/or channel diagnostics

2 to 3 WORD Block type
4 to 5 WORD Block length
6 BYTE Version: high byte
7 BYTE Version: low byte
8 to 11 DWORD API (only if low byte of version = 1)
12 to 13 WORD Slot number
14 to 15 WORD Subslot number
16 to 17 WORD Channel number
18 to 19 WORD Channel properties
20 to 21 WORD Format identifier:

● W#16#0000 to W#16#7FFF: Manufacturer-specific diagnostics
● W#16#8000: Channel diagnostics
● W#16#8002: Extended channel diagnostics
● W#16#8003: Stepped extended channel diagnostics
● W#16#8004  to W#16#80FF: Reserved

22 to n BYTE Data depend on the format identifier
 

  Note

The section starting from "block type" can occur from 1 to n times.
 

● W#16#8002: Extended channel diagnostics

Byte Meaning
0 to 1 Format identifier W#16#8002
2 to 3 Channel number
4 to 5 Channel properties
6 to 7 Error type
8 to 9 Additional error value
10 to 13 Additional error information
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● W#16#8003: Stepped extended channel diagnostics

Byte Meaning
0 to 1 Format identifier W#16#8003
2 to 3 Channel number
4 to 5 Channel properties
6 to 7 Error type
8 to 9 Additional error value
10 to 13 Additional error information
14 to 17 Qualified channel qualifier

● W#16#8100: Maintenance information

Byte Meaning
0 to 1 Format identifier W#16#8100
2 to 3 Block type
4 to 5 Block length
6 to 7 Block version
8 to 9 Reserved
10 to 13 Maintenance status

 

  Note

You can find more detailed information about the structure of the additional alarm 
information in the Programming Manual SIMATIC PROFINET IO from PROFIBUS DP to 
PROFINET IO and the current version of IEC 61158-6-10-1.

 

Destination area TINFO and AINFO

Destination area TINFO  and AINFO
Depending on the respective OB in which "RALRM (Page 2682)" is called, the destination 
areas TINFO and AINFO are only partially written. Refer to the table below to find out which 
information is entered respectively.

Interrupt type OB 
class

TINFO
OB start 
information

TINFO
Management 
information

AINFO
Header 
information

AINFO
Additional interrupt information

Process interrupt 4x Yes Yes Yes central: No
distributed: as supplied by 

PROFIBUS DP slave/
PROFINET IO device

Status interrupt 55 Yes Yes Yes Yes Yes
Update interrupt 56 Yes Yes Yes Yes Yes
Manufacturer-specific 
interrupt

57 Yes Yes Yes Yes Yes
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Interrupt type OB 
class

TINFO
OB start 
information

TINFO
Management 
information

AINFO
Header 
information

AINFO
Additional interrupt information

I/O
redundancy error

70 Yes Yes No No No

Diagnostics interrupt 82 Yes Yes Yes central: Structure according to 
PROFINET IO 
standard

distributed: as supplied by 
PROFIBUS DP slave/
PROFINET IO device

Insert/remove 
interrupt

83 Yes Yes Yes central: No
distributed: as supplied by 

PROFIBUS DP slave/
PROFINET IO device

Special form of the 
remove module 
interrupt:
Controlled by 
supervisor

83 Yes Yes Yes PROFINET IO only

Special form of the 
insert module interrupt:
Enabled by supervisor

83 Yes Yes Yes PROFINET IO only

Unconfigured module 
inserted

83 Yes Yes Yes PROFINET IO only

Rack failure/
station failure

86 Yes Yes No No

... all other OBs Yes No No No

D_ACT_DP: Enable/disable DP slaves

Description
Use the "D_ACT_DP" instruction to specifically deactivate and reactivate configured DP slaves/
PROFINET IO devices. In addition, you can determine whether each assigned DP slave or 
PROFINET IO device is currently activated or deactivated.

If you use the instruction to deactivate an IE/PB Link PN IO type of gateway, then all connected 
PROFIBUS DP slaves will also cease to function. These failures will be reported.
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The instruction cannot be used on PROFIBUS PA field devices that are connected by a DP/
PA link to a DP master system.

 

 Note

As long as one or more "D_ACT_DP" jobs are active, you cannot load a changed configuration 
from the programming device to the CPU (within the scope of CiR).
If a changed configuration is being loaded from the programming device to the CPU during 
ongoing operation (CiR), the CPU will reject activation of a "D_ACT_DP" job.

Several runs through the cycle control point are required to perform the disabling or enabling 
job. Therefore, you cannot wait for the end of such a job in a programmed loop.

 

Functional description
"D_ACT_DP" is an instruction that works asynchronously, which means its execution extends 
over multiple calls. You start the job by calling D_ACT_DP with REQ = 1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

Application
If you configure DP slaves/PROFINET IO devices in a CPU which are not actually present or 
not currently required, the CPU will nevertheless continue to access these DP slaves/
PROFINET IO devices at regular intervals. After the slaves are deactivated, further CPU 
accessing will stop. With PROFIBUS DP, the fastest possible DP bus cycle can be achieved 
in this manner and the corresponding error events no longer occur.

Examples
From a machine OEM's point of view, there are numerous device options possible in series 
production of machines. However, each delivered machine includes only one combination of 
selected options.

Every one of these possible machine options is configured as a DP slave/PROFINET IO device 
by the manufacturer in order to create and maintain a common user program having all possible 
options. Use "D_ACT_DP" to deactivate all DP slaves/PROFINET IO devices not present at 
machine startup.

A similar situation exists for machine tools having numerous tooling options available but 
actually using only a few of them at any given time. These tools are implemented as DP slaves/
PROFINET IO devices. With "D_ACT_DP", the user program activates the tools currently 
needed and deactivates those required later.

Identification of a job
If you have started a deactivation or activation job and you call "D_ACT_DP" again before the 
job is complete, the behavior of the instruction depends on whether or not the new call involves 

Programming the PLC
9.7 References

WinCC Professional V13.0
2708 System Manual, 02/2014



the same job. If the input parameter LADDR  matches, then the call will be interpreted as a 
follow-on call.

Deactivating DP slaves/PROFINET IO devices
When you deactivate a DP slave/PROFINET IO device with "D_ACT_DP", its process outputs 
are set to the configured substitute values or to 0 (safe state). The assigned DP master/
PROFINET IO controller does not continue to address this component. Deactivated DP slaves/
PROFINET IO devices are not identified as faulty or missing by the error LEDs on the DP 
master/PROFINET IO controller or CPU.

The process image of the inputs of deactivated DP slaves/PROFINET IO devices is updated 
with 0, that is, it is handled just as it is for failed DP slaves/PROFINET IO devices.

If you are using your program to directly access the user data of a previously deactivated DP 
slave/PROFINET IO device, the I/O access error OB is called and the corresponding start 
event is entered in the diagnostics buffer. If you attempt to access a deactivated DP slave/
PROFINET IO device via an instruction (such as "RD_REC (Page 2712)"), you will receive the 
same error information in RET_VAL  as for an unavailable DP slave/PROFINET IO device.

Deactivating a DP slave/PROFINET IO device does not start the program error OB, even if its 
inputs or outputs belong to the system-side process image to be updated. Also there is no 
entry in the diagnostics buffer.

If a DP station/PNIO station fails after you have deactivated it with "D_ACT_DP", the operating 
system does not detect the failure.

Applies to PROFIBUS DP: If you wish to deactivate DP slaves functioning as transmitters in 
slave-to-slave communication, we recommend that you first deactivate the receivers (listeners) 
that detect which input data the transmitter is transferring to its DP master. Deactivate the 
transmitter only after you have performed this step.

Activating DP slaves/PROFINET IO devices
When you reactivate a DP slave/PROFINET IO device with "D_ACT_DP", this component is 
configured and assigned parameters by the associated DP master/PROFINET IO controller 
(as with the return of a failed DP station/PROFINET IO station). This activation is complete 
when the component is able to transfer user data.

Activating a DP slave/PROFINET IO device does not start the program error OB, even if its 
inputs or outputs belong to the system-side process image to be updated. Also there is no 
entry in the diagnostics buffer.

If you try to activate a DP slave/PROFINET IO device with "D_ACT_DP" that cannot be 
accessed (for example, because it was physically separated from the bus), the instruction 
returns the error code W#16#80A7 after expiration of the configured parameter assignment 
time for distributed I/O. The DP slave/PROFINET IO device is activated and the fact that the 
activated DP slave/PROFINET IO device cannot be accessed results in a corresponding 
display in the system diagnostics.
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If the DP slave/PROFINET IO device is accessible again afterwards, this results in standard 
system behavior (for example, a call of the OB configured for this purpose).

 

 Note

Activating a DP slave/PROFINET IO device may be time-consuming. If you wish to cancel a 
current activation job, start "D_ACT_DP" again with the same value for LADDR  and 
MODE = 2. Repeat the call of "D_ACT_DP" with MODE = 2 until successful cancellation of 
the activation job is indicated by RET_VAL  = 0.

 

If you wish to activate DP slaves which take part in the slave-to-slave communication, we 
recommend that you first activate the transmitters and then the receivers (listeners).

Parameters
The following table shows the parameters of the "D_ACT_DP" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Level-triggered control parameter 
REQ=1: Execute activation or deactivation

MODE Input USINT I, Q, M, D, L or 
constant

Job identifier
Possible values:
● 0: Request information on whether the 

addressed component is activated or 
deactivated (output via RET_VAL 
parameter)

● 1: Activate the DP slave/PROFINET IO 
device

● 2: Deactivate the DP slave/PROFINET IO 
device

LADDR Input HW_DEVICE I, Q, M, D, L or 
constant

Hardware identifier of the DP slave 
(HW_DPSlave)/PROFINET IO device 
(HW_Device)
The number can be taken from the properties 
of the DP slave / PROFINET IO device in the 
Network view or from the "System constants" 
tab of the standard tag table.
If both the identifier for the device diagnostics 
as well as the ID for operating state transitions 
are both specified there, you must use the 
code for the device diagnostics.

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L Active code:
● BUSY = 1: The job is still active.
● BUSY = 0: The job was terminated.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".
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RET_VAL parameter

Error code*
(W#16#...)

Explanation

0000 Job completed without error.
0001 The DP slave/PROFINET IO device is active (this error code is possible only with MODE = 0.)
0002 The DP slave/PROFINET IO device is deactivated (this error code is possible only with MODE = 0.)
7000 First call with REQ=0. The job specified with LADDR is not active; BUSY has the value "0".
7001 First call with REQ=1. The job specified with LADDR was initiated. BUSY has the value "1".
7002 Intermediate call (REQ 

irrelevant). The activated job is still active; BUSY has the value "1".
8090 ● You have not configured a module with the address specified in LADDR.

● You operate your CPU as I-Slave and you have specified in LADDR an address of this I-Slave.
8092 The deactivation of the currently addressed DP slave/PROFINET IO device (MODE=2) cannot be 

canceled by being activated (MODE=1). Activate the component at a later time.
8093 No DP slave / PROFINET IO device that can be activated or deactivated is assigned to the address 

specified in LADDR.
8094 You have attempted to activate a device which is potential partner for a tool change port. However, another 

device is already activated on this tool change port at this time. The activated device will remain activated.
80A0 Error during the communication between the CPU and the IO controller.
80A1 Parameters could not be assigned for the addressed component. (This error code is only available when 

MODE = 1.)
Note: "D_ACT_DP" returns this error information only if the activated slaves/devices of this component 
fails again during parameter assignment. If the parameter assignment of a single module was 
unsuccessful, "D_ACT_DP" returns the error information W#16#0000.

80A2 The addressed DP slave does not return an acknowledgment. (This error information is not available with 
PROFINET IO devices. The process is not time-monitored by PROFINET.)

80A3 The DP master/PROFINET IO controller concerned does not support this function.
80A4 The CPU does not support this function for external DP masters/PROFINET IO controller.
80A6 Slot error in the DP slave/PROFINET IO device; not all user data can be accessed (this error code is only 

available when MODE=1).
Note: "D_ACT_DP" returns this error information only if the activated component fails again after 
parameter assignment and before the end of "D_ACT_DP". If only a single module is unavailable, 
"D_ACT_DP" returns the error information W#16#0000.

80A7 Activation of a non-accessible device.
80AA Activation with errors in the DP slave/PROFINET IO device: Differences in the configuration
80AB Activation with errors in the DP slave/PROFINET IO device: Parameter assignment error
80AC Activation with errors in the DP slave/PROFINET IO device: Maintenance required
80C1 "D_ACT_DP" has been started and is being continued with another address (this error code is possible 

when MODE=1 and MODE=2).
80C3 ● Temporary resource error: The CPU is currently processing the maximum possible activation and 

deactivation jobs. (This error code is available only when MODE = 1 and MODE = 2.)
● The CPU is busy receiving a modified configuration. Currently you can not enable/disable DP slaves/

PROFINET IO devices.
80C5 DP: Jobs not collected by the user are discarded at restart.
80C6 PROFINET: Jobs not collected by the user are discarded at restart.
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Error code*
(W#16#...)

Explanation

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Others

RD_REC: Read data record from I/O

Description
Use the instruction to read the data record with the number RECNUM  from the addressed 
module. You start the read process by assigning the value "1" to the input parameter REQ  
during the call. If the read process could be executed immediately, the instruction returns the 
value "0" at the output parameter BUSY . If BUSY has the value "1", reading is not yet complete.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852). The data record read is entered in the target range spanned by the 
RECORD  parameter, providing the data transfer was free of errors.

 

 Note

When you read out a data record with a number greater than one from an FM or a CP you 
have purchased prior to February 1997 (below referred to as "old modules"), "RD_REC" 
responds differently than it does in new modules. This special situation is covered in the 
section "Using old S7-300 FMs and CPs with data record numbers >1" (see below).

If a DPV1 slave is configured via GSD file (GSD rev. 3 and higher) and the DP interface of 
the DP master is set to "S7 compatible", then you may not read any data records from the I/
O modules in the user program with "RD_REC". In this case, the DP master addresses the 
wrong slot (configured slot + 3).

Remedy: Set the interface of the DP master to "DPV1".
 

Parameters
The following table shows the parameters of the "RD_REC" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_IO I, Q, M, D, L or 
constant

Hardware identifier of the module.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number (permitted values: 0 to 240)
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Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 

executed, the return value contains an error 
code. In addition: the length of the data record 
actually transferred in bytes (possible values: +1 
to +240), if the target range is greater than the 
transferred data record and if no error occurred 
during the transfer.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The reading process is not yet 
complete.

RECORD Output ANY I, Q, M, D, L Target range for the data record read. With 
asynchronous execution of "RD_REC", 
make sure that the actual parameters of 
RECORD  have the same length information 
for all calls. Only the BYTE  data type is permitted.
Note: Note that for S7-300 CPUs the parameter 
RECORD always requires the full specification 
of the DB parameters (for example, 
P#DB13.DBX0.0 byte 100). The omission of an 
explicit DB number is only permitted for S7-300 
CPUs and leads to an error message in the user 
program.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RECORD
 

 Note

If you want to ensure that the entire data record is always read, select a target range with a 
length of 241 bytes. If the data transfer is without error, RET_VAL  contains the actual data 
record length.

 

Using old S7-300 FMs and CPs with data record numbers > 1
If you want to use the instruction "RD_REC" to read out a data record with a number greater 
than one from an old S7-300 FM or old S7-300 CP, remember the following points:

● If the target range is greater than the actual length of the required data record, no data is 
entered in RECORD . RET_VAL is written with W#16#80B1.

● If the target range is smaller than the actual length of the required data record, the CPU 
reads as many bytes beginning at the start of the record as are specified in the length 
information of RECORD  and enters this number of bytes inRECORD . RET_VAL has the 
value "0".

● If the length specified in RECORD  is the same as the actual length of the required data 
record, the CPU reads the data record and enters it in RECORD . RET_VAL  is written with 
"0".
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RET_VAL parameter
● If an error has occurred while the function was being executed, the return value contains 

an error code.

● If no error occurred during the transfer, RET_VAL contains the following:

– 0, if the entire target range was filled with data from the selected data record (the data 
record can also be incomplete).

– The length of the data record actually transferred in bytes (possible values: +1 to +240) 
if the target range is greater than the transferred data record.

 

  Note

If the general error W#16#8745 occurs, this only indicates that access to at least one 
byte of the process image was blocked. The data record was read by the module 
correctly and written to the I/O memory area.

 

When looking at the "real" error information (error codes W#16#8xyz) in the following table, 
we distinguish between two cases:

● Temporary errors (error codes W#16#80A2 to 80A3, 80Cx):
This type of error can possibly be eliminated without user action, meaning it is helpful to 
call the instruction again (multiple calls, if necessary).
Example of a temporary error: Resources required are currently in use (W#16#80C3).

● Permanent errors (error codes W#16#809x, 80A0, 80A1, 80Bx):
This type of error does not correct itself. A new call of the instruction will not be successful 
until you have eliminated the error. Example of a permanent error: Wrong length 
specification in RECORD (W#16#80B1).

 

  Note

If you transfer data records to a DPV1 slave with "WR_REC (Page 2716)" or if you read 
data records from a DPV1 slave with RD_REC and if this DPV1 slave operates in DPV1 
mode, the DP master evaluates the error information it received from the slave as follows: 

If the error information lies within the range from W#16#8000 to W#16#80FF or 
W#16#F000 to W#16#FFFF, the DP master passes the error information to the instruction. 
If the error information is outside this range, the DP master passes the value W#16#80A2 
to the instruction and suspends the slave.

For a description of the error information originating from DPV1 slaves, refer to STATUS[3] 
Parameter STATUS (Page 2684).

 

Parameter RET_VAL for WR_REC and RD_REC

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 

0.
-

7001 First call with REQ=1: Data transfer started; BUSY  has the value 1. Distributed I/O
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Error code*
(W#16#...)

Explanation Restriction

7002 Intermediate call (REQ 
irrelevant): Data transfer already active; BUSY has the value 1.

Distributed I/O

8090 Address specified at parameter ADDR is invalid. -
8092 A type other than BYTE is specified in the ANY reference. -
8093 This instruction is not permitted for the module selected by means of 

LADDR  and IOID .
-

80A0 Negative acknowledgment when reading from the module: Module 
was removed during the reading process or is defective

With "RD_REC" only

80A1 Negative acknowledgment when writing to the module: Module was 
removed during the writing process or is 
defective

With "WR_REC (Page 2716)" only

80A2 ● DP protocol error at layer 2 (for example, slave failure or bus 
problems)

● For ET200S, data record cannot be read in DPV0 mode.

Distributed I/O

80A3 DP protocol error with user interface/user Distributed I/O
80A4 Communication on PBUS+ disrupted -
80B0 ● Instruction not possible for module type.

● The module does not recognize the data record.
● Data record number 241 not permitted.
● With "WR_REC (Page 2716)", data records 0 and 1 are not 

permitted.

-

80B1 The length specified in parameter RECORD is incorrect. ● With "WR_REC (Page 2716)": 
Length incorrect

● With "RD_REC" 
(only when using old 
S7-300 FMs and S7-300 
CPs): specified length > data 
record length

● With DPNRM_DG: specified 
length < data record length

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not match 
specified module type

-

80B7 DP slave or module reports an invalid range for a parameter or value. With "RD_REC" only
80C0 With "WR_REC (Page 2716)": the data can only be written when the 

CPU is in STOP mode. Note: this means that writing by the user 
program is not possible. You can only write the data online with PG/
PC.
With "RD_REC": the module routes the data record, but either no data 
is present or the data can only be read when the CPU is in STOP 
mode. Note: if data can only be read when the CPU is in STOP mode, 
then an evaluation by the user program is not possible. In this case, 
you can only read the data online with PG/PC.
With "DPNRM_DG (Page 2732)": There are no diagnostic data 
available.

With "WR_REC (Page 2716)" or 
"RD_REC" or "DPNRM_DG 
(Page 2732)"
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Error code*
(W#16#...)

Explanation Restriction

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

-

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available. Distributed I/O
80C6 Data record transfer stopped due to priority class abort (restart or 

background)
Distributed I/O

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

WR_REC: Write data record to I/O

Description
Use the instruction "WR_REC" to transfer the data record RECORD to the addressed module. 

The data to be transferred are read from the RECORD parameter during the first call. If the 
transfer of the data record takes longer than the duration of one call, the contents of the 
RECORD parameter are no longer relevant for the subsequent instruction calls (for the same 
job).

You start the writing process by assigning the value "1" to the input parameter REQ during the 
call. If the writing process could be executed immediately, the instruction returns the value "0" 
at the output parameter BUSY. If BUSY has the value "1", writing is not yet complete.

Parameters
The following table shows the parameters of the instruction "WR_REC":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
REQ = 1: Write request

LADDR Input HW_IO I, Q, M, D, L or 
constant

Hardware identifier of the module.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number

RECORD Input VARIANT I, Q, M, D, L Data record
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Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 

executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The writing process is not yet 
completed.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL
See also: RD_REC: Read data record from I/O (Page 2712) 

 

 Note

If the general error W#16#8544 occurs, it only indicates that access to at least one byte of 
the I/O memory area containing the data record was denied. The data transfer was continued.

 

DPRD_DAT: Read consistent data of a DP standard slave

Description
Use the instruction "DPRD_DAT" to read out consistent data from an I/O module. 

The instruction can be used for the central modules as well as for the DP standard slaves and 
PROFINET IO devices.

You require "DPRD_DAT" because you can only read out a maximum of four continuous bytes 
using the load commands that access the I/O or the process image input table. If required, you 
can also read consistent data via the process image of the inputs. Refer to the related 
documentation to find out if your CPU supports this functionality. For additional information on 
consistent data of a DP standard slave/PROFINET IO device, refer to Section "Data 
consistency (Page 3190)". 

If necessary, the instruction "DPRD_DAT" can also be used for a data area of 1 byte or larger. 
For information on the maximum length of the data, refer to the documentation of your CPU 
(e.g. 64 bytes for an S7-1214). 
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● Use the parameter LADDR to select the module of the DP normslave/PROFINET IO device. 
If an access error occurs, the error code W#16#8090 is output.

● Use the RECORD parameter to define the target range of the read data:

– The target range has to be at least as long as the inputs of the selected module. Only 
the inputs are transferred, the other bytes are not considered. If you read from a DP 
standard slave with a modular configuration or with several DP identifiers, you can only 
access the data of a module of the configured hardware identifier per "DPRD_DAT" call. 
If you select a target range that is too small, the error code 80B1 is output at the 
RET_VAL parameter. 

– All bit strings and all integers can be used as data type. It is also possible to use these 
data types in a data structure of the ARRAY type . The data type STRING is not 
supported.

● If there was no error during the data transmission, the data that have been read are entered 
in the target range defined at the RECORD  parameter.

Parameters
The following table shows the parameters of the instruction "DPRD_DAT":

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, L or 

constant
Hardware ID of the module from which the data 
is to be read.
The hardware ID can be found in the properties 
of the module in the device view or system 
constants.

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error code.

RECORD Output VARIANT I, Q, M, D, L Destination area for the user data that were read.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0000 No error occurred.
8090 ● You have not configured a module for the specified hardware identifier or

● You have ignored the restriction concerning the length of consistent data, or
● you have not specified a hardware identifier as an address at parameter LADDR .

8092 A data type other than (Array of)  bit string or integer was specified at the RECORD parameter.
8093 No DP module/PROFINET IO device from which you can read consistent data exists for the hardware 

identifier specified in LADDR . This error code also occurs if the module addressed by means of LADDR 
does not have inputs.

80A0 An access error was detected when accessing the I/O.
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Error code* 
(W#16#...)

Explanation

80B1 The length of the specified target range at parameter RECORD is shorter than the configured user data 
length.

80C0 The data have not been read yet.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Parameter STATUS (Page 2684)

DPWR_DAT: Write consistent data of a DP standard slave

Description
Use the instruction "DPWR_DAT" to transfer the data at the parameters RECORD  consistently 
to the addressed module of the central module or of the DP standard slave/PROFINET IO 
device and if necessary to the process image (i.e. if the affected address range of the DP 
standard slaves is projected as consistency range in a process image). 

You require "DPWR_DAT" because you can only write a maximum of four continuous bytes 
using the transfer commands that access the I/O or process image output. If required, you can 
also write consistent data via the process image outputs. Refer to the related documentation 
to find out if your CPU supports this functionality. Do not use both possibilities concurrently 
when writing consistent data: Either use "DPWR_DAT" or write via the process image output 
table. For additional information on consistent data of a DP standard slave/PROFINET IO 
device, refer to Section "Data consistency (Page 3190)". If the DP standard slave has a 
modular design, you can only access one module of the DP slave.

 

 CAUTION

I/O access

When using "DPWR_DAT", avoid accessing I/O areas that have process image partitions 
with OB6x connections (isochronous mode interrupts) assigned to them.

 

If necessary, the instruction "DPRD_DAT" can also be used for a data area of 1 byte or larger. 
For information on the maximum length of the data, refer to the documentation of your CPU 
(e.g. 64 bytes for an S7-1214). 
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● Use the LADDR parameter to select the DP standard slave / PROFINET IO device. If an 
access error occurs on the addressed module, the error code 8090 is output.

● Use the RECORD parameter to define the source range of the data to be written:

– The source range has to be at least as long as the outputs of the selected module. Only 
the outputs are transferred, the other bytes are not considered. If the source range at 
parameter RECORD is longer than the outputs of the configured module, only the data 
up to the maximum length of the outputs is transferred. If the source range at parameter 
RECORD is shorter than the outputs of the configured module, the error code 80B1 is 
output. 

– The following data types can be used:  Byte, Char, Word, LWord, DWord, Int, UInt, 
USInt, SInt, LInt, ULInt, DInt, UDInt.  The use of these data types in a data structure of 
the type ARRAY or STRUCT is also permissible.

– The data type STRING is not supported.

The data is transferred synchronously, that is, the write process is completed when the 
instruction is completed.

Parameters
The following table shows the parameters of the instruction "DPWR_DAT":

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, L or constant Hardware ID of the module to which the data 

is to be written.
The hardware ID can be found in the properties 
of the module in the device view or system 
constants.

RECORD Input VARIANT I, Q, M, D, L Source area for the user data to be 
written.

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0000 No error occurred.
8090 ● You have not configured a module for the specified hardware identifier or

● You have ignored the restriction concerning the length of consistent data, or
● you have not specified a hardware identifier at parameter LADDR .

8092 A data type other than (Array of) bit string or integer was specified at the RECORD parameter.
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Error code* 
(W#16#...)

Explanation

8093 No DP module /PROFINET IO device to which you can write consistent data exists at the HW ID specified 
in LADDR . This error code also occurs if the DP standard slave / PROFINET IO device addressed via 
LADDR does not have outputs.

80A1 Access error detected while I/O devices were being accessed.
80B1 The length of the specified source range at the RECORD parameter is shorter than the outputs of the 

configured DP standard slave / PROFINET IO device.
80C1 The data of the previous write job have not yet been processed by the DP standard slave / PROFINET IO 

device.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Parameter STATUS (Page 2684)

iDevice / iSlave

RCVREC: Receive data record

Description
An I-device can receive a data record from a superordinate controller. The receipt takes place 
in the user program with the instruction "RCVREC" (receive record).

The instruction has the following operating modes:

● Check whether the I-device has a request for a data record receipt.

● Make the data record available to the output parameters.

● Send an answer to the superordinate controller.

You can determine the operating mode executed by the instruction using the input parameter 
MODE (see below).

The I-device must be in the RUN or STARTUP mode.

With MLEN, you specify the maximum number of bytes you want to receive. The selected 
length of the target range RECORD should have at least the length of MLEN bytes.

If a data record was received (MODE=1 or MODE=2), the output parameter NEW will indicate 
that the data record was stored in RECORD. Note that RECORD has a sufficient length. The 
output parameter LEN contains the actual length of the data record received in bytes.
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Set CODE1 and CODE2 to zero for the positive answer to the superordinate controller. If the 
received data record is to be rejected, enter the negative answer to the superordinate controller 
in Error Code 1 of the CODE1 and in Error Code 2 of the CODE2.

 

 Note

If the I-device has received a request for a data record receipt, you must recognize the delivery 
of this request within a certain duration. After recognition, you must send an answer to the 
superordinate controller within this time period. Otherwise the I-device will experience a 
timeout error which causes the operating system of the I-device to send a negative answer 
to the superordinate controller. For information on the value for the time period, refer to the 
specifications of your CPU.

 

The output parameter STATUS receives the error information after the occurrence of an error.

Operating modes
You can determine the operating mode of the instruction "RCVREC" with the input parameter 
MODE. This step will be explained in the following table.

MODE Meaning
0 Check whether a request for a data record receipt exists

If a data record from a higher-level controller exists on the I-device, the instruction will only write the output 
parameters NEW, SLOT, SUBSLOT, INDEX and LEN. If you call the instruction several times with MODE=0, 
then the output parameter will only refer to one and the same request.

1 Receiving a data record for any subslot of the I-device
If a data record from a superordinate controller exists on the I-device for any subslot of the I-device, the instruction 
will write the output parameter and transfer the data record to the parameter RECORD.

2 Receiving a data record for a specific subslot of the I-device
If a data record from a superordinate controller exists on the I-device for a specific subslot of the I-device, the 
instruction will write the output parameter and transfer the data record to the parameter RECORD.

3 Sending a positive answer to the superordinate controller
The instruction checks the request of the superordinate controller to receive a data record, accepts the existing 
data record and sends a positive acknowledgment to the superordinate controller.

4 Sending a negative answer to the superordinate controller
The instruction checks the request of the superordinate controller to receive a data record, rejects the existing 
data record and sends a negative acknowledgment to the superordinate controller. Enter the reason for the 
rejection in the input parameters CODE1 and CODE2.

 

 Note

After the receipt of a data record (NEW=1) you must call "RCVREC" twice to ensure complete 
processing. You must do this in the following order:
● First call with MODE=1 or MODE=2
● Second call with MODE=3 or MODE=4
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Parameters
The following table shows the parameters of the "RCVREC" instruction:

Parameter Declaration Data type Memory area Description
MODE Input INT I, Q, M, D, L or 

constant
Mode

F_ID Input HW_SUBMO
DULE

I, Q, M, D, L or 
constant

Subslot in the transfer area of the I-device for 
the data record to be received (only relevant 
for MODE=2). The high word is always set to 
zero.

MLEN Input INT* I, Q, M, D, L or 
constant

Maximum length of the data record to be 
received in bytes

CODE1 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 1 
(forMODE=4)

CODE2 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 2 
(forMODE=4)

NEW Output BOOL I, Q, M, D, L ● MODE = 0: New data record was received
● MODE=1 or 2: Data record was transferred 

to RECORD
STATUS Output DWORD I, Q, M, D, L Error information
SLOT Output HW_SUBMO

DULE
I, Q, M, D, L Identical to F_ID

SUBSLOT Output HW_SUBMO
DULE

I, Q, M, D, L Identical to F_ID

INDEX Output UINT I, Q, M, D, L Number of the data record received
LEN Output UINT I, Q, M, D, L Length of the data record received
RECORD InOut VARIANT I, Q, M, D, L Target range for the data record received.

Note: Note that for S7-300 CPUs the 
parameter RECORD always requires the full 
specification of the DB parameters (for 
example, P#DB13.DBX0.0 Byte 100). The 
omission of an explicit DB number is not 
permitted for S7-300 CPUs and results in an 
error message in the user program.

* Use the data type UINT in the STL programming language.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS
For interpretation of the parameter STATUS refer to section: Parameter STATUS 
(Page 2684) 
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PRVREC: Make data record available

Description
An I-device can receive a request from a superordinate controller to make a data record 
available. The I-device makes the data record available in the user program with the instruction 
"PRVREC" (provide record).

The instruction has the following operating modes:

● Check whether the I-device has a request for making a data record available.

● Transfer the requested data record to the superordinate controller.

● Sending an answer to the superordinate controller.

You can determine the operating mode executed by the instruction using the input parameter 
MODE (see below).

The I-device must be in the RUN or STARTUP mode.

Enter the maximum number of bytes the data record to be sent should have with LEN. The 
selected length of the target range RECORD should have at least the length of LEN bytes.

If a request to make a data record available exists, (MODE=0), the output parameter NEW will 
be set to TRUE.

If the request for making a data record available is accepted, write RECORD for the positive 
answer to the superordinate controller with the requested data record and write zero for CODE1 
and CODE2. If the request for making a data record available is to be rejected, enter the 
negative answer to the superordinate controller in Error Code 1 of the CODE1 and in Error 
Code 2 of theCODE2.

 

 Note

If the I-device has received a request for making a data record available, you must recognize 
the delivery of this request within a certain time period. After recognition, you must send an 
answer to the superordinate controller within this time period. Otherwise the I-device will 
experience a timeout error which causes the operating system of the I-device to send a 
negative answer to the superordinate controller. For information on the value for the time 
period, refer to the specifications of your CPU.

 

The output parameter STATUS receives the error information after the occurrence of an error.
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Operating modes
You can determine the operating mode of the instruction "PRVREC" with the input parameter 
MODE. This step will be explained in the following table.

MODE Meaning
0 Check whether a request for making a data record available exists

If a request from a higher-level controller for making a data record available exists on the I-device, the instruction 
will only write the output parameters NEW, SLOT, SUBSLOT, INDEX and RLEN. If you call the instruction several 
times with MODE=0, then the output parameter will only refer to one and the same request.

1 Receiving a request for making a data record available for any subslot of the I-device
If such a request from a superordinate controller for any subslot of the I-device exists on the I-device, the 
instruction will write the output parameter.

2 Receiving a request for making a data record available for a specific subslot of the I-device
If such a request from a superordinate controller for a specific subslot of the I-device exists on the I-device, the 
instruction will write the output parameter.

3 Make the data record available and send a positive answer to the superordinate controller
The instruction checks the request of the superordinate controller to make a data record available, makes the 
request data record available to RECORD and sends a positive acknowledgement to the superordinate controller.

4 Sending a negative answer to the superordinate controller
The instruction checks the request of the superordinate controller to make a data record available, rejects this 
request and sends a negative acknowledgement to the superordinate controller. Enter the reason for the rejection 
in the input parameters CODE1 and CODE2.

 

 Note

After the receipt of a request (NEW=1) you must call the instruction twice to ensure complete 
processing. You must do this in the following order:
● First call with MODE=1 or MODE=2
● Second call with MODE=3 or MODE=4

 

Parameters
The following table shows the parameters of the "PRVREC" instruction:

Parameter Declaration Data type Memory area Description
MODE Input INT I, Q, M, D, L or 

constant
Mode

F_ID Input HW_SUBMO
DULE

I, Q, M, D, L or 
constant

Subslot in the transfer area of the I-device for the 
data record to be sent (only relevant for 
MODE=2). The high word is always set to zero.

CODE1 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 1 
(forMODE=4)

CODE2 Input BYTE I, Q, M, D, L or 
constant

Zero (for MODE=3) and/or Error Code 2 
(forMODE=4)

LEN Input UINT I, Q, M, D, L or 
constant

Maximum length of the data record to be sent in 
bytes
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Parameter Declaration Data type Memory area Description
NEW Output BOOL I, Q, M, D, L The new data record was requested by the 

superordinate controller.
STATUS Output DWORD I, Q, M, D, L Error information
SLOT Output HW_SUBMO

DULE
I, Q, M, D, L Identical to F_ID

SUBSLOT Output HW_SUBMO
DULE

I, Q, M, D, L Identical to F_ID

INDEX Output UINT I, Q, M, D, L Number of the data record to be sent
RLEN Output UINT I, Q, M, D, L Length of the data record to be sent
RECORD InOut VARIANT I, Q, M, D, L Data record made available

Note: Note that for S7-300 CPUs the parameter 
RECORD always requires the full specification of 
the DB parameters (for example, 
P#DB13.DBX0.0 Byte 100). The omission of an 
explicit DB number is not permitted for S7-300 
CPUs and results in an error message in the user 
program.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS
For interpretation of the parameter STATUS refer to section: Parameter STATUS 
(Page 2684) 

PROFIBUS

DPSYC_FR: Synchronize DP slaves / Freeze inputs

Description       
You use the instruction to synchronize one or more groups of DP slaves.

The function involves sending one of the control commands below, or a combination of them, 
to the relevant groups:

● SYNC (simultaneous output and freezing of output states on the DP slaves)

● UNSYNC (cancels the SYNC control command)

● FREEZE (freeze the input states on the DP slaves and read in the frozen inputs)

● UNFREEZE (cancels the FREEZE control command)
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Before you send the control commands listed above, you must assign the DP slaves to groups 
per configuration. You must know which DP slave is assigned to which group, with which 
number and know the reactions of the various groups to SYNC/FREEZE.

 

 Note

Note that the control commands SYNC and FREEZE also remain valid when you perform a 
warm/cold restart.

Please note also that you may initiate only one SYNC/UNSYNC job or only one FREEZE/
UNFREEZE job at a time.

 

Functional description
"DPSYC_FR" works asynchronously, that is, its execution extends over multiple calls. You 
start the job by calling "DPSYC_FR" with REQ=1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

Identification of a job
If you have triggered a SYNC/FREEZE job and called "DPSYC_FR" again before the first job 
was completed, the response of the instruction depends on whether the new call is for the 
same job. If the input parameters LADDR, GROUP  and MODE  match, the call is interpreted 
as a follow-on call.

Writing outputs of DP modules
The writing of outputs of DP modules is triggered as follows:

● By transfer commands to the DP I/O

● By writing the process image of the outputs to the modules (by the operating system at the 
end of OB 1 or by calling the instruction "UPDAT_PO (Page 2669)")

● Calling the "DPWR_DAT (Page 2719)" instruction.

In normal operation, the DP master transfers the output bytes cyclically (within the cycle of the 
PROFIBUS DP bus) to the outputs of the DP slaves.

If you want to have certain output data (possibly distributed on several slaves) applied to the 
outputs to the process at exactly the same time, you can send the SYNC control command to 
the relevant DP master using the "DPSYC_FR" instruction.

What are the effects of SYNC?
With the SYNC control command, the DP slaves of the selected groups are switched to Sync 
mode. In other words, the DP master transfers the current output data and instructs the DP 
slaves involved to freeze their outputs. With the following output message frames, the DP 
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slaves enter the output data in an internal buffer and the state of the outputs remains 
unchanged.

Following each SYNC control command, the DP slaves of the selected groups apply the output 
data of their internal buffer to the outputs on the process.

The outputs are only updated cyclically again when you send the UNSYNC control command 
using the "DPSYC_FR" instruction.

 

 Note

If the DP slaves of the selected group(s) are not currently connected to the network or have 
failed when the control command was sent, they will not be switched to SYNC mode. This 
information will not be communicated in the return value of the instruction.

 

Reading input data of DP modules
The input data of the DP modules are read as follows:

● Using load commands to the DP I/O

● When the process image of the inputs is updated (by the operating system at the start of 
OB 1 or by calling the "UPDAT_PI (Page 2667)" instruction)

● By calling the "DPRD_DAT (Page 2717)" instruction.

In normal operation, the DP master receives this input data cyclically (within the cycle of the 
PROFIBUS DP bus) from its DP slaves and makes them available to the CPU.

If you want to have certain input data (possibly distributed on several slaves) to be read from 
the process at exactly the same time, send the FREEZE control command to the relevant DP 
master using the "DPSYC_FR" instruction.

What are the effects of FREEZE?
With the FREEZE control command, the DP slaves involved are switched to Freeze mode, in 
other words the DP master instructs the DP slaves to freeze the current state of the inputs. It 
then transfers the frozen data to the input area of the CPU. 

Following each FREEZE control command, the DP slaves freeze the state of their inputs again.

The DP master only receives the current state of the inputs cyclically again after you have sent 
the UNFREEZE control command with the "DPSYC_FR" instruction.

 

 Note

If the DP slaves of the selected group(s) are not currently connected to the network or have 
failed when the control command has been sent, they will not be switched to FREEZE mode. 
This information will not be communicated in the return value of the instruction.
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Data consistency
Because the DPSYC_FR functions are asynchronous and can be interrupted by higher priority 
classes, you should make sure that the process images are consistent with the actual inputs 
and outputs of the I/O when using the "DPSYC_FR" instruction.

This is guaranteed if you comply with the following consistency rules:

● Define suitable process image partitions for the "SYNC outputs" and the "FREEZE inputs" 
(only possible on the S7-400). Call the "UPDAT_PO (Page 2669)" instruction immediately 
before each first call of a SYNC job. Call the "UPDAT_PI (Page 2667)" instruction 
immediately after the respective last call of a FREEZE job.

● As an alternative: Use only direct I/O access for outputs involved in a SYNC job and for 
inputs involved in a FREEZE job. Do not write to these outputs when a SYNC job is active 
and do not read in these inputs when a FREEZE job is active.

Use of DPWR_DAT and DPRD_DAT
If you use the "DPWR_DAT (Page 2719)" instruction, it must be complete before you send a 
SYNC job for the outputs involved.

If you use the "DPRD_DAT (Page 2717)" instruction, it must be complete before you send a 
FREEZE job for the inputs involved.

Startup and "DPSYC_FR"
The user alone must take responsibility for sending the SYNC and FREEZE control commands 
in the startup OBs.

If you want the outputs of one or more groups to be in SYNC mode when the user program 
starts, you must initialize these outputs during startup and completely execute the 
"DPSYC_FR" instruction with the SYNC control command.

If you want the inputs of one or more groups to be in FREEZE mode when the user program 
starts, you must execute the "DPSYC_FR" instruction with the FREEZE control command 
completely for these inputs during startup.

Parameters
The following table shows the parameters of the "DPSYC_FR" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Level-triggered control parameter REQ = 1: 
Triggering of the SYNC/FREEZE job

LADDR Input HW_DPMAST
ER

I, Q, M, D, L or 
constant

Hardware identifier of the DP master interface
The number can be taken from the properties of the 
DP master interface in the Network view or from the 
"System constants" tab of the standard tag table.
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Parameter Declaration Data type Memory area Description
GROUP Input BYTE I, Q, M, D, L or 

constant
Group selection
Bit 0 = 1: group 1 selected
Bit 1 = 1: group 2 selected
:
Bit 7 = 1: group 8 selected
You can select several groups per job. The value 
B#16#0 is invalid.

MODE Input BYTE I, Q, M, D, L or 
constant

Job ID (coding complies with EN 50 170 Volume 2, 
PROFIBUS)
Bit 0: reserved (value 0)
Bit 1: reserved (value 0)
Bit 2:
● = 1: UNFREEZE will be executed
● = 0: no meaning
Bit 3:
● = 1: FREEZE will be executed
● = 0: no meaning
Bit 4:
● = 1: UNSYNC will be executed
● = 0: no meaning
Bit 5:
● = 1: SYNC will be executed
● = 0: no meaning
Bit 6: reserved (value 0)
Bit 7: reserved (value 0)
 
Possible values:
● with exactly one ID per job:

– B#16#04 (UNFREEZE)
– B#16#08 (FREEZE)
– B#16#10 (UNSYNC)
– B#16#20 (SYNC)

● with more than one ID per job:
– B#16#14 (UNSYNC, UNFREEZE)
– B#16#18 (UNSYNC, FREEZE)
– B#16#24 (SYNC, UNFREEZE)
– B#16#28 (SYNC, FREEZE)

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error code.
Make sure that you evaluate RET_VAL  each time 
the block has been executed.

BUSY Output BOOL I, Q, M, D, L BUSY=1:
The SYNC/FREEZE job is not yet complete.
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You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter
 

 Note

If you access DPV1 slaves, error information of these slaves can be forwarded from the DP 
master to the instruction. For a description of this error information, refer to STATUS[3], 
STATUS (Page 2684) parameter.

 

Error code*
(W#16#...)

Explanation

0000 Job completed without error.
7000 First call with REQ=0. The job specified with LADDR, GROUP  and MODE  is not active; BUSY  has the 

value 0.
7001 First call with REQ=1. The job specified with LADDR, GROUP  and MODE was triggered; BUSY  has the 

value 1.
7002 Intermediate call (REQ 

irrelevant). The activated SYNC/FREEZE job is still running; BUSY  has 
the value 1.

8090 The module selected with LADDR  is not a DP master.
8093 This instruction is not permitted for the module selected with LADDR  (configuration or version of the DP 

master).
8094 GROUP  parameter is incorrect
8095 MODE  parameter is incorrect
80B0 The group selected with GROUP  is not configured.
80B1 The group selected with GROUP  is not assigned to this CPU.
80B2 The SYNC job specified with MODE  is not permitted on the group selected 

with GROUP.
80B3 The FREEZE job specified with MODE  is not permitted on the group selected 

with GROUP .
80C2 Temporary shortage of resources on the DP master: The DP master is 

currently processing the maximum number of jobs for a CPU.
80C3 This SYNC/UNSYNC job cannot be activated at present because only one 

SYNC/UNSYNC job can be triggered at a time. Check your user 
program.

80C4 This FREEZE/UNFREEZE job cannot be activated at present because only one 
FREEZE/UNFREEZE job can be triggered at a time. Check your user 
program.

80C5 Short circuit directly at DP interface
80C6 Job aborted due to I/O disconnection by CPU
80C7 Job aborted due to warm or cold restart on the DP master
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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DPNRM_DG: Read diagnostics data from a DP slave

Description
You use the "DPNRM_DG" instruction to read the current diagnostic data of a DP slave in the 
form specified in EN 50 170 Volume 2, PROFIBUS. 

Refer to the following table for the basic structure of the slave diagnostic data and to the 
manuals of the DP slaves for further information.

Byte Meaning
0 Station status 1
1 Station status 2
2 Station status 3
3 Master station number
4 Vendor ID (high byte)
5 Vendor ID (low byte)
6 ... Additional slave-specific diagnostic information

The data that has been read is entered in the target range indicated by RECORD following 
without error data transfer. You start the read process by assigning the value "1" to the REQ 
input parameter when the "DPNRM_DG" instruction is called.

Functional description
The reading process is executed asynchronously, in other words, it can extend over several 
calls. The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

Parameters
The following table shows the parameters of the "DPNRM_DG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_DPSLAVE I, Q, M, D, L or 
constant

Configured diagnostic address of the DP 
slave
Note: Address must be specified in hexadecimal 
form, for example, diagnostic address 1022 means: 
LADDR:=W#16#3FE.

RET_VAL Return DINT, INT, 
LREAL, REAL

I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error code. 
If no error has occurred, the length of 
the data actually transferred is entered in RET_VAL
.
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Parameter Declaration Data type Memory area Description
RECORD Output VARIANT I, Q, M, D, L Destination area for the diagnostic data that were 

read. Only the BYTE data type is permitted. The 
minimum length of the data record to be read or the 
target range is 6. The maximum length of the data 
record to be sent is 240. Standard slaves can 
provide more than 240 bytes of diagnostic data up 
to a maximum of 244 bytes. In this case, the first 
240 bytes are transferred to the target range and 
the overflow bit is set in the data.

BUSY Output BOOL I, Q, M, D, L BUSY = 1:
The reading process is not yet complete.

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

You can find information on data type conversion in the different programming languages under 
"Auto-Hotspot".

RECORD parameter
The CPU evaluates the actual length of the read diagnostic data:

If the length specified for RECORD

● is less than the number of data bytes supplied, the data is discarded and a corresponding 
error code is entered in RET_VAL.

● is greater than or equal to the number of data bytes supplied, the data is accepted in the 
destination area and the actual length is entered in RET_VAL as a positive value.

 

  Note

You must ensure that the actual parameters of RECORD correspond in all calls belonging 
to a job.

A job is uniquely identified by the LADDR input parameter.
 

Standard slaves with more than 240 bytes of diagnostic data
With standard slaves on which the number of standard diagnostic data is between 241 and 
244 bytes, note the following points:

If the length specified for RECORD

● is less than 240 bytes, the data is discarded and a corresponding error code is entered in 
RET_VAL.

● If the length specified for RECORD is greater than or equal to 240 bytes, the first 240 bytes 
of the standard diagnostic data is transferred to the target range and the overflow bit is set 
in the data.
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RET_VAL parameter
● If an error occurs while the function is being executed, the return value contains an error 

code.

● If no errors have occurred during data transfer, RET_VAL contains the length of the data 
read in bytes as a positive number.

 

  Note

The amount of data read in a DP slave depends on its diagnostics status.
 

For the evaluation of the error information of the RET_VAL parameter, refer to the following 
table.

Error code 
(W#16#...)

Explanation Restriction

7000 First call with REQ = 0: No data transfer active; BUSY has the value "0". -
7001 First call with REQ = 1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ irrelevant): Data transfer already active; BUSY 

has the value "1".
Distributed I/O

8090 Address specified at parameter LADDR is invalid. -
8093 This instruction is not permitted for the module selected by means of 

LADDR and IOID.
-

80A2 ● DP protocol error at layer 2 (for example, slave failure or bus 
problems)

● For ET200S, data record cannot be read in DPV0 mode.

Distributed I/O

80A3 DP protocol error with user interface/user Distributed I/O
80A4 Communication on PBUS+ disrupted Distributed I/O
80B0 ● Instruction not possible for module type.

● The module does not recognize the data record.
● Data record number 241 not permitted.
● With "WR_REC (Page 2676)", data records 0 and 1 are not 

permitted.

-

80B1 The length specified in parameter RECORD is incorrect. specified length < data record 
length

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not match 
specified module type

-

80C0 There are no diagnostic data available. -
80C1 The data of the previous write job on the module for the same data record 

have not yet been processed by the module.
-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

-
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Error code 
(W#16#...)

Explanation Restriction

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available. Distributed I/O
80C6 Data record transfer stopped due to priority class abort (restart or 

background)
Distributed I/O

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DP_TOPOL: Determine topology for DP master system

Description     
You use the instruction to trigger the topology determination for a selected DP master system. 
Calling the instruction will address all diagnostics repeaters on a DP master system.

 

 Note

The topology can only be determined for one DP master system at a time.
 

Topology determination is the prerequisite for the detailed display of the error location if line 
errors occur. After configuration and after every change to the physical configuration of a DP 
master system, you must repeat the topology determination with "DP_TOPOL".

Changes to the physical configuration are:

● Changes in line lengths

● Adding or removing stations or components with repeater function

● Changing station addresses

If an error is reported by a diagnostics repeater, "DP_TOPOL" writes the DPR  and DPRI  
outputs for the duration of one "DP_TOPOL pass. If errors are reported by multiple diagnostics 
repeaters of the selected DP master system, "DP_TOPOL" writes DPR  and DPRI  with 
information regarding the first diagnostics repeater reporting the error. You can read out the 
entire diagnostic information on the programming device or using the "DPNRM_DG 
(Page 2732)" instruction. If no diagnostics repeater reports an error, the DPR and DPRI  
outputs have the value NULL.

If you want to repeat a topology determination after an error occurs, you must first reset 
"DP_TOPOL". This is done by calling "DP_TOPOL" with REQ=0  and R=1.

Functional description
"DP_TOPOL" works asynchronously, that is, its execution extends over multiple calls. You 
start determining the bus topology by calling "DP_TOPOL" with REQ=1 . If you want to cancel 
the process, call "DP_TOPOL" with R=1 .
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The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

 

 Note

Determining the topology may take several minutes.
 

Identification of a job
The input parameter DP_ID uniquely specifies a job. 

If you have called "DP_TOPOL" and you call this instruction again before the topology is re-
determined, the manner in which the instruction reacts depends on whether the new call 
involves the same job: If the DP_ID parameter matches a job that has not yet been completed, 
then the call is interpreted as a follow-up call and the value W#16#7002 will be entered in 
RET_VAL. On the other hand, if another job is involved, the CPU rejects it.

Parameters
The following table shows the parameters of the "DP_TOPOL" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ=1: Trigger topology determination

R Input BOOL I, Q, M, D, L or 
constant

R=1: Cancel topology determination

DP_ID Input HW_IOSYST
EM

I, Q, M, D, L or 
constant

DP master system ID of those master systems 
for which the topology will be determined

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L BUSY=1: Topology determination is not yet 
complete.

DPR Output BYTE I, Q, M, D, L PROFIBUS address of the diagnostics repeater 
reporting the error.

DPRI Output BYTE I, Q, M, D, L Measuring segment diagnostics repeater 
reporting the error:
● Bit 0 = 1: Temporary faults on segment DP2
● Bit 1 = 1: Permanent faults on segment DP2
● Bit 4 = 1: Temporary faults on segment DP3
● Bit 5 = 1: Permanent faults on segment DP3

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL
When looking at the "real" error information (error codes W#16#8xyz) in the following table, 
we distinguish between two cases:

● Temporary errors (error codes W#16#80A2 to 80A4, 80C3, 80C5):
It is possible to eliminate this type of error without user action; in other words, it is advisable 
to call "DP_TOPOL" again (multiple calls, if necessary).
Example of a temporary error: Resources required are currently in use (W#16#80C3).

● Permanent errors (error codes W#16#8082, 80B0, 80B2):
This type of error does not correct itself. A new call of "DP_TOPOL" is only advisable after 
you have eliminated the error. Example of a permanent error: The DP master/CPU does 
not support this service. (W#16#80B0).

Error code*
(W#16#...)

Explanation

0000 Job completed without error.
7000 First call with REQ=0. Topology determination is not triggered. BUSY has the value "0".
7001 First call with REQ=1. The request to execute topology determination was sent. BUSY  has the value "1".
7002 Intermediate call (REQ 

irrelevant): Topology determination is not yet complete. BUSY  has the value "1".
7010 You have attempted to cancel topology identification. But there is no running job with the specified DP_ID. 

BUSY  has the value "0". 
7011 First call with R=1. The cancellation of the topology determination was triggered. BUSY  has the value 

"1".
7012 Intermediate call: The cancellation of the topology determination is not yet complete. BUSY  has the value 

"1".
7013 Final call: The topology determination was cancelled. BUSY  has the value "0".
8082 No DP master system is configured with the specified DP_ID.
80A2 Error during topology determination; for more detailed information, refer to output parameters DPR  and 

DPRI.
80A3 Error during topology determination: Monitoring time has elapsed (timeout). 
80A4 Communication on PBUS+ disrupted
80B0 The DP master/CPU does not support this service.
80B2 Error during topology determination: No diagnostics repeater was found at the selected DP master system.
80C3 Resources required are currently in use. Possible cause: You have initiated a second topology 

determination (only one topology determination is permitted at one time).
80C5 The DP master system is currently not available.
General error 
information

See also:  GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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ASi

ASI_CTRL: Controlling ASi master behavior

Description of ASI_CTRL

Description
Using the instruction "ASI_CTRL", you can control the behavior of the AS-i master from the 
user program of the PLC. The instruction processes the command protocol automatically. It 
also enables parameter assignment on SIMATIC AS-i masters and reading out information 
data. The functions and operation of the command interface are detailed in the manual for the 
AS-i master.

Both centrally inserted AS-i masters and distributed AS-i masters via PROFIBUS DP are 
supported. Combinations with PROFINET IO (e.g. IE/PB Link PN IO) are also possible.

The schematic diagram below shows the functions of the "ASI_CTRL" instruction:

Start
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Read data 

record

Command no. / job 
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① Start of processing at the REQ parameter.
② The program sends the required command to the AS-i master via the instruction 

"RDREC".
③ The AS-i master processes the command.
④ The current status of the AS-i master is stored in the input area of the binary data 

(logical start address).
⑤ The instruction "ASI_CTRL" cyclically queries and evaluates the 4 status bits.
⑥ Once command processing is complete, the command job is completed with 

"RDREC". Depending on the command, the data field of "RDREC" may contain the 
response data for the command or additional status information.
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Differences in the command call between IE/ AS-i Link and DP/AS-i Links
There are significant differences in how a controller exchanges commands with an AS-i master.

● IE/AS-i Link (PROFINET) used the data record interface. The different commands are 
called with either "Write data record" ("WRREC" instruction) or "Read data record" 
("RDREC" instruction) by various data record numbers.

● DP/AS-i Links (PROFIBUS) use the command interface. All commands are called by data 
record number 2 with "Write data record" ("WRREC" instruction) plus "Read data record" 
("RDREC" instruction). The type of command is defined by the data content in the write job.

Changes compared to the instruction "ASi_3422".
The instruction "ASI_CTRL" is a revised version of the instruction "ASi_3422" (S7-300/400) 
and provides improved functionality and compatibility. The specific changes are as follows:

● For writing and reading diagnostic data records, the instructions "WR_REC (Page 2716)" 
and "RD_REC (Page 2712)" have been replaced by the instructions "RDREC (Page 2674)" 
and "WRREC (Page 2676)". Their function is identical; however, they support data transfer 
via PROFINET IO.

● The block type of the instruction has been changed from a function (FC) to a function block 
(FB). "ASI_CTRL" has an instance data block and is multi-instance-capable.

● The designation of the formal parameters of "ASI_CTRL" complies with the SIMATIC 
system blocks. There is no STARTUP input parameter. The definition of the STATUS 
parameter is based on the instructions "RDREC (Page 2674)" and "WRREC (Page 2676)". 
The status identifiers for the parameter DONE and the new parameter BUSY have also 
been adjusted.

Operation of the "ASI_CTRL" instruction
The instruction "ASI_CTRL" is an asynchronous function block; in other words, its processing 
extends over multiple calls.

● A job is started with REQ = TRUE.

● The job status is displayed via the BUSY output parameters and the two central bytes of 
the output parameter STATUS.

● The BUSY parameter is set during job processing. Upon the first call, STATUS is assigned 
the value 00700100H. Upon all subsequent calls for this job, it is assigned the value 
00700200H. When the job is complete, the result is output at the parameters DONE or 
ERROR.

– If no errors have occurred, DONE is set. For jobs with response data from the AS-i 
master, this data is provided in the specified receive buffer. In such cases, the STATUS 
parameter also displays the volume of data supplied in bytes. For jobs without response 
data, the value 00000000H is entered in STATUS.

– If an error occurs during job processing, ERROR is set. The content of the receive buffer 
is invalid in such a case. An error code is entered in the STATUS parameter for a more 
detailed description of the error which has occurred.
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Number of command calls
If you use the instruction "ASI_CTRL" to send commands, you may not simultaneously send 
other commands to the same AS-i master with "RDREC (Page 2674)" or "WRREC 
(Page 2676)". This also applies to multiple calls of the instruction for the same AS-i master.

The instruction "ASI_CTRL" cannot be run with interruptions. Calls therefore cannot be 
programmed in program priority classes which interrupt each other (for example with calls in 
OB 1 and in OB 35).

Parameter
The following table shows the parameters of the instruction "ASI_CTRL":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, constant REQ = TRUE starts a new job unless a job is 

already in progress. No edge evaluation takes 
place.

LADDR Input WORD I, Q, M, D, L, constant Start address of the AS-i master in the S7 
address space (logical base address). The 
start address is defined in the hardware 
configuration when the master is configured.

SD Input VARIANT I, Q, M, D, L Send buffer
The parameter refers to a memory area in 
which the command is to be specified (see " 
ASi commands (Page 2741)").
Example: P#DB101.DBX 0.0 BYTE 223

RD Input VARIANT I, Q, M, D, L Receive buffer
This buffer is only relevant for commands 
which deliver answer data. The parameter 
refers to a memory area in which a command 
response is stored (see "ASi commands 
(Page 2741)").
Example: P#DB102.DBX 224.0 BYTE 221

DONE Output BOOL Q, M, D, L DONE = TRUE: Job completed without errors.
BUSY Output BOOL Q, M, D, L BUSY = TRUE: Job in progress.
ERROR Output BOOL Q, M, D, L ERROR = TRUE: Job aborted with error.
STATUS Output DWORD M, D Job status / error code

See the "STATUS parameter" description.

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

 

 Note
Parameters LADDR, SD, and RD

The parameters LADDR, SD, and RD must not be changed in any block cycle when a job is 
in progress: they must remain constant.
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STATUS parameter
The following table shows the possible STATUS displays dependent upon DONE and ERROR.

DONE ERROR STATUS Meaning
0 0 00700000H First call with REQ = FALSE; no active job.
0 0 00700100H First call with REQ = TRUE; job has started.
0 0 00700200H Subsequent call (REQ irrelevant); job is still in progress.
1 0 00000000H Job completed without errors. No response data.
1 0 0000xx00H Job completed without errors. Number of xx bytes of response data.
0 1 C0818400H Data type of formal operand RD invalid.
0 1 C0818500H Error in communication with AS-i master (incorrect address configured at the LADDR 

parameter).
0 1 C0838100H Incorrect AS-i slave address.
0 1 C0838200H AS-i slave is not enabled (not in LAS).
0 1 C0838300H Error at the AS interface (the SD parameter may have been set too small).
0 1 C0838400H The command is not valid with the current AS-i master status.
0 1 C0838500H There is no AS-i slave with the address "0".
0 1 C0838600H The AS-i slave has invalid configuration data (I/O or ID codes).
0 1 C083A100H The AS-i slave addressed has not been found at the AS interface.
0 1 C083A200H There is no AS-i slave with the address "0".
0 1 C083A300H There is already an AS-i slave with the new address at the AS interface.
0 1 C083A400H The AS-i slave address cannot be deleted.
0 1 C083A500H The AS-i slave address cannot be set.
0 1 C083A600H The AS-i slave address cannot be permanently saved.
0 1 C083A700H Error during reading of the extended ID1 code.
0 1 C083A800H The target address is not plausible (e.g. a B slave address has been used for a standard 

slave).
0 1 C083B100H A length error has occurred during string transfer.
0 1 C083B200H A protocol error has occurred during string transfer.
0 1 C083F800H Unknown job number or job parameter.
0 1 C083F900H The AS-i master has detected an EEPROM error.

 

ASi commands

Description
The command interface allows the controller and AS-i master to exchange parameter 
assignment and information data.

These commands
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● provide the complete functionality of the M4 master profile of the AS-i master specifications.

● enable the AS-i master to be completely configured from the controller.
 

  Note
AS-i commands supported

Please see the manual of the relevant AS-i master for the AS-i commands supported and 
a detailed description.

 

General structure of the send buffer
The general structure of the send buffer for commands and job data is set out in the table 
below. The area for the command number must always be filled. The number of bytes for the 
job data can be found in the description of the command (see AS-i master documentation). 
"q" is the start address of the send buffer.

Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Meaning

q + 0 Command number
q + 1 Job data
q + 2 Job data
q + ... Job data

General structure of the receive buffer
The general structure of the receive buffer for the command response data is set out in the 
table below. The number of bytes for the response data depends on the command. Some 
commands do not return response data, and therefore only require the definition of a virtual 
receive buffer which is not filled with data. "n" is the start address of the receive buffer.

Byte Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
Meaning

n + 0 Command number (echo)
n + 1 Response data
n + 2 Response data
n + ... Response data

Programming the PLC
9.7 References

WinCC Professional V13.0
2742 System Manual, 02/2014



 
 

 CAUTION

Memory areas can be overwritten

If the receive buffer of the "ASI_CTRL" instruction is too short, neighboring memory areas 
may be overwritten. The length specified in the ANY pointer of the RD parameter when the 
instruction "ASI_CTRL" is called is irrelevant. The required length for the receive buffer can 
be found in the description of the command.

The following applies for command numbers 39H, 41H, 42H, 43H and 44H:

The receive buffer must be 221 bytes long (bytes 0 to 220), even if the command returns less 
data. Depending on the command, the highest bytes in the receive buffer may be overwritten 
with zero values by the AS-i master.

 

AS-i commands
A selection of possible AS-i commands is set out in the table below.

Name Parameter Return Coding
Set_permanent_parameter
(Set_Permanent_Parameter)

Slave address, parameter  00 H

Get_permanent_parameter
(Get_Permanent_Parameter)

Slave address Parameter 01 H

Write_parameter
(Write_Parameter)

Slave address, parameter Parameter echo 02 H

Read_parameter
(Read_Parameter)

Slave address Parameter value 03 H

Store_actual_parameters
(Store_Actual_Parameters)

  04 H

Set_configuration_data Slave address, 
configuration

 25 H

Get_configuration_data Slave address set configuration data 26 H
Store_actual_configuration
(Store_Actual_Configuration)

  07 H

Get_actual_configuration Slave address Actual configuration 
data

28 H

Configure_LPS LPS  29 H

Set_offline_mode Mode  0AH

Select_auto-program Mode  0B H

Set_mode Mode  0C H
Change_AS–iSlave_address
(Change_AS–iSlave_Address)

Address1, Address2  0D H

Get_AS-iSlave_status Slave address Error record of the AS-i 
slave

0F H

Read_lists_and_flags  LDS, LAS, LPS, flags 30 H
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Name Parameter Return Coding
Get_overall_configuration  Actual configuration 

data, current 
parameters, LAS, flags

39 H

Set_overall_configuration Overall configuration  3A H

Write_parameter_list Parameter list  3C H
Read_parameter_echo_list  Parameter echo list 33 H

Write_CTT2_request Slave address
CTT2 string

CTT2 string 44 H

Read_version_identifier  Version string 14 H

Read_AS-i_slave Slave address ID code 17 H

Read_AS-i_slave_extended_ID1 Slave address Extended ID1 code 37 H

Write_AS-iSlave_extended_ID1 Extended ID1 code  3F H
Read_AS-iSlave_extended_ID2 Slave address Extended ID2 code 38 H

Read_AS-iSlave_IO Slave address I/O configuration 18 H

Read_I/O_error_list  LPF 3E H
Write_AS–i-slave_parameter_string Slave address, parameter 

string
 40 H

Read_AS–iSlave_parameter_string Slave address Parameter string 41 H
Read_AS-iSlave_ID_string Slave address ID string 42 H

Read_AS-iSlave_diagnostic_string Slave address Diagnostic string 43 H

Read_AS-i_line_error_counter   4A H
Read_and_clear_AS-i_line_error_counter   4B H
Read_AS-iSlave_error_counter Slave address  4C H

Read_and_clear_AS-iSlave_error_counter Slave address  4D H

Additional command for DP/ AS-i F-Link:
AS–i_status/diag_of_F_slaves  Status/diagnostics of 

all AS-i safe slaves
51 H

 
 

 Note
Re-initializing the AS-i master command interface

Another command which is not mentioned in the table is command 77 H. This call re-initializes 
the command interface of the AS-i master. Any command which the AS-i master specified is 
currently processing will be terminated.

As of version V2.1.20 of DP/AS-i LINK Advanced, command 0E H is also available. This call 
enables you to release and block the ground fault monitoring function for a line.
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9.7.3.5 PROFIenergy

Description of PROFIenergy

PROFIenergy
PROFIenergy is a manufacturer- and device-neutral profile for energy management with 
PROFINET. PROFIenergy enables central, coordinated device shutdown to reduce electricity 
consumption during breaks in production and unplanned interruptions.

The PROFINET devices/power modules are switched off via special commands in the user 
program of the PROFINET IO controller. No additional hardware is required. The PROFINET 
devices interpret the PROFIenergy commands directly. 

PROFIenergy controller (PE controller)
The PE controller is a PLC which enables/disables the idle state in lower-level devices. 
Individual production components and entire production lines are switched off and reactivated 
from the user program. Commands (e.g. "Start_Pause" and "End_Pause") are sent to the lower-
level device using corresponding instructions (function blocks). The commands are sent via 
the PROFINET communication protocol.

PROFIenergy entity (PE entity)
The PE entity receives the PROFIenergy commands of the PE controller and executes these 
accordingly (for example, by returning a measured value or activating an energy saving mode). 
Implementation of the PE entity in a PROFIenergy-capable device is device- and manufacturer-
specific.

The PE entity can, for example, be executed:

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2745



● Within the proxy of a submodule: The PE commands are valid for the addressed submodule 
and any existing lower-level submodules.

● Within the proxy of a module: The PE commands are valid for different submodules within 
the module.

● For networked submodules without a proxy function: The PE commands in this case are 
only valid for the respective submodule.

PROFIenergy instructions
● Instructions for IO controller

– The "PE_START_END (Page 2747)" instruction represents the simplest way to activate 
or deactivate the idle state of the PROFINET devices (PROFIenergy commands 
"Start_Pause" and "End_Pause"). This is done using a positive and negative signal edge 
in the instruction.

– The "PE_CMD (Page 2751)" instruction allows you to transmit all PROFIenergy 
commands, including "Start_Pause" and "End_Pause". With other commands, you can 
query the current status of the PROFINET devices or the behavior during breaks, for 
example.

– The instruction "PE_DS3_Write_ET200S (Page 2757)" is used to define the switching 
characteristic of up to 8 slots of ET 200S. The instruction is not a PROFIenergy 
instruction; however, it supplements the PROFIenergy functions for an ET 200S.

● Instruction for iDevices
The "PE_I_DEV (Page 2781)" instruction allows you to implement PROFIenergy on 
iDevices as well. The instruction receives PROFIenergy commands on the iDevice and 
forwards these to the user program for processing. After processing the command, the user 
program calls the "PE_I_DEV (Page 2781)" instruction again in order to send the 
acknowledgement to the IO controller. For these replies, each command offers you a 
corresponding auxiliary block that supplies the response data to the instruction 
"PE_I_DEV (Page 2781)".
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PROFIenergy commands (PE commands)
The PE controller transmits PE commands to the PE entity. The PE command can be either 
a control command to switch a PE entity to the energy-saving mode, or a command to read a 
status or measured value:

● PI commands for control
PROFIenergy supports two control commands that can be executed using either the 
"PE_Start_End (Page 2747)" instruction or the "PE_CMD (Page 2751)" instruction:

– Start_Pause: Starting a suitable energy-saving mode (PE Energy-saving mode)

– End_Pause: Exiting the energy-saving mode (switch to PE_ready_to_operate mode)

● PI commands for reading a status or measured value
Certain condition information can be read by the control system using the following status 
commands with the instruction "PE_CMD (Page 2751)":

– PE_Identify: Read out which PE commands are supported by the PE entity.

– PEM_Status: Read out the currently active mode of a PE entity (e. g. 
PE_ready_to_operate).

– Query_Modes: Output an overview of all supported energy-saving modes, including the 
time and energy information

– Query_Measurement: Output the measured values of a PE entity

Example applications
Examples for use of PROFIenergy instructions can be found in the Industry Online Support in 
the entry "PROFIenergy - Saving Energy with SIMATIC S7 (http://
support.automation.siemens.com/WW/view/en/41986454)".

See also
Service and Support (http://support.automation.siemens.com/)

IO controller

PE_START_END: Start and exit energy-saving mode

Description
The instruction "PE_START_END" is used to start and exit the energy-saving mode of a 
specified PE entity (e.g. ET 200S). 

The instruction "PE_START_END" is used in the PE controller, preferably when only field 
devices from which energy data does not need to be read out are connected to the 
corresponding PE devices. Alternatively, the instruction "PE_CMD (Page 2751)" can be used 
to read energy data.
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The energy-saving modes are configured in the user program of the PE controller. On 
completion of the "PE_START_END" instruction, the PE entity reports its current energy-saving 
mode and outputs this data at parameter PE_MODE_ID.

Write and read jobs of the "PE_START_END" instruction.
The instruction "PE_START_END" sends a PROFIenergy command internally as a write job 
to the PE entity using "WRREC (Page 2676)". "PE_START_END" then waits for 
acknowledgment from the PE entity. The acknowledgment data record is read with the 
instruction "RDREC (Page 2674)" every 100 milliseconds. Until acknowledgment is received 
from the PE entity, the function repeats the read job for 10 seconds at intervals of 
100 milliseconds. The response data of the PE entity is also read with the instruction 
"RDREC (Page 2674)".

Below is a flowchart of the write and read jobs:
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Parameter
The following table shows the parameters of the instruction "PE_START_END":

Parameter Declaration Data type Memory area Description
START Input BOOL I, Q, M, D, L or 

constant
Transmitting the PE command "Start_Pause" 
to the PE entity with the address set at 
parameter ID.

END Input BOOL I, Q, M, D, L or 
constant

Transmitting the PE command "End_Pause" 
to the PE entity with the address set at 
parameter ID.

ID Input HW_
SUBMODULE

I, Q, M, D, L or 
constant

Address of the PE entity
Use the hardware ID of the head module for a 
PROFINET IO device. Refer to the system 
constants of the assigned IO controller for the 
hardware ID. The name of the head module is 
composed of the name of the IO device and 
the suffix [Head] (example: 
"IO_Device_1[Head]").

PAUSE_TIME Input TIME I, Q, M, D, L, P or 
constant

Planned pause duration.
● Range:

T#1MS to T#24D20H31M23S647MS
● Start value:

T#0MS
VALID Output BOOL I, Q, M, D, L PE command successfully sent.
BUSY Output BOOL I, Q, M, D, L PE command still being processed.
ERROR Output BOOL I, Q, M, D, L Error occurred during processing. The error 

message is output at the STATUS parameter.
STATUS Output DWORD I, Q, M, D, L, P Block status / error number (see "STATUS 

parameter")
PE_MODE_ID Output BYTE I, Q, M, D, L, P Identification number of energy-saving mode 

(energy-saving level for the duration of the 
pause).

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

PAUSE_TIME parameter
The parameter PAUSE_TIME is used to set the default duration of the energy-saving period 
at the PE entity. The PE entity checks whether the pause period is of sufficient length and 
whether it can be implemented. The minimum pause duration (Time_min_Pause) must be 
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greater than the sum of the times the device needs to switch to energy-saving mode 
(Time_to_Pause) and to switch back to operating mode (Time_to_Operate).

ET 200S checks whether the scheduled pause duration is greater than or equal to the minimum 
pause duration (PM-E_Pause_Min) saved on the ET 200S. This is fixed at 10 seconds. If a 
shorter pause is used, the power modules (PM-E) of the ET 200S will remain on.

The module does not switch back on automatically at the end of the pause; it remains in OFF 
mode until the "END" command is sent. This prevents uncoordinated switch-on, which can 
cause undesired peak loads.

STATUS parameter
Error information is output at the STATUS output parameter. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num Cause of the error

● B#16#00: No error
● B#16#DE: Error during reading of data record
● B#16#DF: Error during writing of data record
● B#16#C0: Error message from the instruction or from the communication 

instructions "RDREC (Page 2674)" and "WRREC (Page 2676)" used internally.
STATUS[2] Error_Decode Location of the error ID

● 80: DPV1 error as defined in IEC 61158-6 or application-specific
● FE: DP/PNIO profiles - PROFIenergy-specific error
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Field element Name Meaning
STATUS[3] Error_Code_1 Error ID

● When Error_Decode = 80:
– 80: Simultaneous positive edge at the input parameters START and END.
– 81: Length conflict at the CMD_PARAM and CMD_PARAM_LEN 

parameters.
– 82-8F: Other error messages (reserved)

● When Error_Decode = FE:
– 01: "Service Request ID" invalid
– 02: Incorrect "Request_Reference"
– 03: "Modifier" invalid
– 04: "Data Structure Identifier RQ" invalid
– 05: "Data Structure Identifier RS" invalid
– 06: "PE energy-saving modes" are not supported
– 07: "Response" is too long (maximum transmissible length exceeded)
– 08: "Count" invalid
– 50: No suitable "energy mode" is available.
– 51: Time value specified is not supported.
– 52: "PE_Mode_ID" invalid

STATUS[4] Error_Code_2 Manufacturer-specific error ID extension
 

 Note
Error messages of the instructions RDREC and WRREC

The instruction "PE_START_END" uses the instructions "WRREC (Page 2676)" and 
"RDREC (Page 2674)" for communication. Error messages for these instructions are output 
in the field elements STATUS[1] to STATUS[4].

Please see the description of the corresponding STATUS (Page 2684) parameter for an 
explanation of the error codes of the "WRREC (Page 2676)" and "RDREC (Page 2674)" 
instructions.

 

See also
Description of PROFIenergy (Page 2745)

PE_CMD: Start and exit energy-saving mode / Read out status information

Description
The instruction "PE_CMD" is used in the PE controller to start or terminate a pause in the 
energy-saving mode in the PE entity. Additional information and energy measurements can 
also be read out from a PE entity using "PE_CMD".

The instruction is best used with PE controllers to which assigned PE devices are connected 
from which energy measurements are to be read out. If this is not the case, the instruction 
"PE_START_END (Page 2747)" can also be used to start and end the pauses.
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Transfer of the PROFIenergy commands (PE commands)
The instruction "PE_CMD" transfers a PROFIenergy command to a PE entity.

The instruction can also be used if additional commands are to be added to the PROFIenergy 
profile in future. The commands which can be used with the current PROFIenergy profile are 
listed in the description of the CMD and CMD_MODIFIER parameters (see the "CMD and 
CMD_MODIFIER parameters" table).

● The individual PE commands which are transferred to the PE entity using the instruction 
are assigned defined "Service_Request_IDs". The Service_Request_IDs 01 to 05 and 16 
are assigned at the CMD parameter.

● The two PE commands 04 (Query_Modes) and 16 (Query_Measurement) are defined in 
more detail with the CMD_MODIFIER parameter.

● Additional values are transferred at the CMD_PARA parameter for individual PE commands 
(see the description of the individual PE commands). The parameter CMD_PARA_LEN 
defines the length of the data at the parameter CMD_PARA.

The commands are transferred without plausibility test. The response data of the PE entity is 
saved to the RESPONSE_DATA data area that is addressed by VARIANT pointer (for 
information about the response frame contents, refer to the description of the respective PE 
command).

Write and read jobs of the "PE_CMD" instruction.
The instruction "PE_CMD" uses "WRREC (Page 2676)" internally to transmit a PROFIenergy 
command as a write job to the PE entity. "PE_CMD" then waits for the acknowledgment from 
the PE entity. The acknowledgment data record is read with the instruction "RDREC 
(Page 2674)" every 100 milliseconds. Until acknowledgment is received from the PE entity, 
the function repeats the read job for 10 seconds at intervals of 100 milliseconds. The response 
data of the PE entity is also read with the instruction "RDREC (Page 2674)".

Below is a flowchart of the write and read jobs:
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Parameter
The following table shows the parameters of the instruction "PE_CMD":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts transferring the PE command upon 
a positive edge.

ID Input HW_
SUBMODULE

I, Q, M, D, L or 
constant

Address of the PE entity
Use the hardware ID of the head module 
for a PROFINET IO device. Refer to the 
system constants of the assigned IO 
controller for the hardware ID. The name 
of the head module is composed of the 
name of the IO device and the suffix 
[Head] (example: "IO_Device_1[Head]").
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Parameter Declaration Data type Memory area Description
CMD Input BYTE I, Q, M, D, L, P or 

constant
Service-Request-ID of the PROFIenergy 
command in accordance with the 
PROFIenergy profile (see "CMD and 
CMD_MODIFIER parameters").
Further service request IDs are possible 
following extensions of the PROFIenergy 
profile.

CMD_MODIFIER Input BYTE I, Q, M, D, L, P or 
constant

PROFIenergy sub-command
(only when CMD=3 or CMD=16, see 
"CMD and CMD_MODIFIER parameters")
Further sub-commands are possible 
following extensions of the PROFIenergy 
profile.

CMD_PARA Input VARIANT I, Q, M, D, L Parameters for the PE commands:
● Get mode: PE_mode_ID
● Get measurement values: List of 

Measurement_Ids
The complete Service Data Request is 
entered.

CMD_PARA_LEN Input INT I, Q, M, D, L, P or 
constant

The actual length of the command 
parameters (<= length defined in 
CMD_PARA; is verified by the instruction).

RESPONSE_DATA InOut VARIANT I, Q, M, D, L PROFIenergy information 
May be complete response frame 
including block header, depending on the 
command.
Note: If the buffer is too small, only the 
number of bytes which is specified in the 
VARIANT pointer will be entered.

VALID Output BOOL I, Q, M, D, L Command successfully sent.
BUSY Output BOOL I, Q, M, D, L Command still being processed.
ERROR Output BOOL I, Q, M, D, L Error occurred during processing.
STATUS Output DWORD I, Q, M, D, L Block status / error number (see 

"STATUS parameter"):

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters CMD and CMD_MODIFIER

CMD CMD_
MODIFIER

PROFIenergy command Description

01 0 Start_Pause (Page 2771) Start energy-saving mode or switch to a different energy-
saving mode.

02 0 End_Pause (Page 2771) End energy-saving mode.
03 1 Query_Modes - List of energy-

saving modes (Page 2772) 
Output the energy-saving modes supported.
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CMD CMD_
MODIFIER

PROFIenergy command Description

2 Query_Modes - Get mode 
(Page 2773) 

Output attributes of the energy-saving mode currently 
enabled.

04 0 PEM_Status (Page 2775) Query status of energy-saving mode.
05 0 PE_Identify (Page 2776) Read out the number and description of PE commands 

supported.
16 1 Query_Measurement - 

Get_Measurement_List 
(Page 2777) 

List of measured values supported by the PE entity.

2 Query_Measurement - 
Get_Measurement_Values 
(Page 2779) 

Output the measured values of the PE entity.

STATUS parameter
Error information is output at the STATUS output parameter. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num Cause of the error

● B#16#00: No error
● B#16#DE: Error during reading of data record
● B#16#DF: Error during writing of data record
● B#16#C0: Error message from the internal communication instructions 

"RDREC (Page 2674)" and "WRREC (Page 2676)".
STATUS[2] Error_Decode Location of the error ID

● 80: DPV1 error as defined in IEC 61158-6 or application-specific
● FE: DP/PNIO profiles - PROFIenergy-specific error
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Field element Name Meaning
STATUS[3] Error_Code_1 Error ID

● When Error_Decode = 80:
– 81: Length conflict at the CMD_PARA and CMD_PARA_LEN parameters, 

or maximum data record length (4095 bytes) exceeded.
– 82-8F: Other error messages (reserved)

● When Error_Decode = FE:
– 01: "Service Request ID" invalid
– 02: Incorrect "Request_Reference"
– 03: "Modifier" invalid
– 04: "Data Structure Identifier RQ" invalid
– 05: "Data Structure Identifier RS" invalid
– 06: "PE energy-saving modes" are not supported
– 07: "Response" is too long (maximum transmissible length exceeded)
– 08: "Count" invalid
– 50: No suitable energy-saving mode (energy mode) is available.
– 51: Time value specified is not supported.
– 52: "PE_Mode_ID" invalid

STATUS[4] Error_Code_2 Manufacturer-specific error ID extension
 

 Note
Error messages of the instructions RDREC and WRREC

The instruction "PE_CMD" uses the instructions "WRREC (Page 2676)" and "RDREC 
(Page 2674)" for communication. Error messages for these instructions are output in the field 
elements STATUS[1] to STATUS[4].

Please see the description of the corresponding STATUS (Page 2684) parameter for an 
explanation of the error codes of the "WRREC (Page 2676)" and "RDREC (Page 2674)" 
instructions.

 

See also
Description of PROFIenergy (Page 2745)
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PE_DS3_Write_ET200S: Set power module switching behavior

Description
The instruction "PE_DS3_Write_ET200S" sends basic settings for power module switching 
behavior to the ET 200S. The switching behavior of up to 8 slots in the ET 200S (e.g. for power 
modules) can be defined with the instruction "PE_DS3_Write_ET200S".

 

 Note

This instruction is not part of the PROIenergy profile but instead supplements SIMATIC-
specific functions.

 

Parameter
The following table shows the parameters of the instruction "PE_DS3_Write_ET200S":

Parameter Declaration Data type Memory area Description
ENABLE Input BOOL I, Q, M, D, L or 

constant
A positive edge triggers the transfer of the data 
record. The data record must be transferred 
again after voltage OFF/ON.

ID Input HW_SUBMODU
LE

I, Q, M, D, L or 
constant

Address of the ET 200S
The address may be taken from the hardware 
configuration.

SLOT_NO_X Input INT I, Q, M, D, L, P or 
constant

Slot number of switchable power module X.

FUNC_X Input INT I, Q, M, D, L, P or 
constant

Function of the module in this slot. Use the 
parameter FUNC_X to define the switching 
behavior of the PM-E (power module of the 
ET 200S):
● FALSE:

– With "PAUSE_START":
-No effect on PM-E
-PM-E remains on

– With "PAUSE_STOP":
-Switches PM_E back on

● TRUE:
– With "PAUSE_START":

-Switches PM_E off
– With "PAUSE_STOP":

-Switches PM-E back on
BUSY Output BOOL I, Q, M, D, L Transfer not yet complete.
DONE Output BOOL I, Q, M, D, L Transfer completed without errors.
ERROR Output BOOL I, Q, M, D, L Transfer completed with error.
STATUS Output DWORD I, Q, M, D, L, P Error number (see STATUS parameter of the 

instruction "PE_Start_End (Page 2747)")
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For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

See also
Description of PROFIenergy (Page 2745)

PE_WOL: Starting and stopping energy-saving mode via WakeOnLan

Description PE_WOL

Description
The "PE_WOL" instruction sends the PROFIenergy commands "Start_Pause" and 
"End_Pause" to multiple PROFIenergy-enabled devices in the PROFINET I/O systems.

Multiple PE devices can be coordinated via the instruction provided that the PE devices support 
the "Wake on LAN" function over a UDP connection.

The "PE_WOL" instruction can only be executed on a CPU with and integrated Ethernet 
interface. This CPU should be able to load blocks with a size of about 400 KB. You cannot use 
the block with PROFINET I/O systems that are connected via an Ethernet CP.

The instruction "PE_WOL" is executed asynchronously.

Definition: Wake on LAN
The Wake on LAN function allows data processing equipment to resume working from a state 
near total shutdown when a special Ethernet packet is received. 

For this procedure to work, the data processing equipment must have a network controller that 
is capable of receiving such a packet.

This packet (Magic Packet™) has a special format. It contains the MAC address of the network 
adapter 15 times.

Selection of devices
The devices are selected using the user data block at the parameter PENERGY (Type: 
"PE_PLUS"). The user DB represents the database for processing multiple devices.

Prior to initialization of "PE_WOL", you must store at least the following information in the user 
DB:

● ID of the PROFINET I/O system

● Data of the connection which is used for "Wake On LAN".
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● Port number which is used for "Wake On LAN".

● For each device

– Pause time (PauseTime)

– Switching of the device to the PE_SLEEP_MODE (EnableSleep)

You initialize the "PE_WOL" instruction with the COM_RST parameter. The jobs stored in the 
user DB are processed one after the other after initialization.

The graphic below illustrates how the PE command "Start_Pause" is transmitted to several 
devices:

 
 

 
 

 

   

   

  

   

Diag. 

addr.

Start bit End bit

8081

8082

8083

8048

...

1

0

1

1

...

0

0

0

0

...

Diag. 

Adr.

8081

8083

8048

(1) Step 1: The bit "CmdStartPause" of the devices to be shut down is set to "1" by the user.
(2) Step 2: The diagnostic addresses of the devices to be shut down (CmdStartPause = "1") are 

linked to the queue.
(3) Step 3: The bit "CmdStartPause" is reset automatically once the jobs have been linked.
(4) Step 4: The instruction "PE_WOL" processes the jobs as soon as they are linked.

A PROFIenergy command "CmdStartPause" or "CmdEndPause" can be sent for all recognized 
devices in the PROFINET IO system via the START and END parameters.

The status of the job processing as well as possible errors during processing are output by the 
STATUS parameter.

Operation of the instruction using the user DB
The operation of the instruction "PE_WOL" can only take place via the user DB. A basic 
procedure applies in this case:

1. Selection of the command to be executed for a device:

– START_PAUSE ("CmdStartPause" in user DB) 

– ENDE_PAUSE ("CmdEndPause" in user DB)

– UPDATE_STATUS ("CmdUpdateStatus" in user DB)

2. Setting the bit for updating ("Update" in the header of the user DB)
At least one CPU cycle should pass with an "Update" = False between two updates; 
otherwise, edge detection cannot be guaranteed.
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Prioritizing the PE commands
The graphic below shows the chronological sequence of three possible commands. 

CmdStartPause 

CmdEndPause 

CmdUpdateStatus 

Update 

These are processed one after the other, regardless of whether the previous command call 
was successful or completed with an error.

Only one command is executed if you set two commands, such as "CmdEndPause" and 
"CmdUpdateStatus" simultaneously. A prioritization is present within the block:

● The command "CmdStartPause" has the highest priority and is therefore always executed 
if selected.

● The command "CmdEndPause" has the second highest priority.

● The command "CmdUpdateStatus" has the lowest priority.

If all three commands are set at the same time, the commands that are not executed remain 
preselected. In this case, the next rising edge executes the next command.

Parameters
The following table shows the parameters of the "PE_WOL" instruction:

Parameter Declaration Data type Memory area Description
COM_RST 
(Page 2761)

Input BOOL I, Q, M, D, L Resets the block and performs a re-initialization. As 
long as True is set here, the initialization is started but 
not yet fully completed. 
Only the falling edge continues the initialization and 
switches to the normal operating mode after 
initialization.

START 
(Page 2762)

Input BOOL I, Q, M, D, L A rising edge performs a "CmdStartPause" 
PROFIenergy command for all detected devices that 
support this function.

END 
(Page 2763)

Input BOOL I, Q, M, D, L A rising edge performs a "CmdEndPause" 
PROFIenergy command for all detected devices that 
support this function.
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Parameter Declaration Data type Memory area Description
PENERGY 
(Page 2763)

InOut PE_PLUS D Pointer to the user DB that contains the database for 
processing multiple devices.

STATUS 
(Page 2767)

Output DWORD I, Q, M, D, L Status/error number for the current status of the 
instruction (see "STATUS parameter").

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter COM_RST

Sequence of the initialization routine
You start the initialization of the "PE_WOL" instruction with the COM_RST parameter.

The following flow diagram shows the initialization routine.

START

Resetting the job queue

No

Yes

END

(Error)

END

(Initialized)

Determining the diagnostic 

addresses

Reading the OrderID

Reading the configured devices 

of the PROFINET I/O system

Setup of the WoL connection

Identification of the supported PE 

commands for each device

User DB

Clean Queue

Config Devices

No. of 

Devices 

> 0

Dev. Diag.

Order ID

Connection 

setup

PE_Identify
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Parameter START

Sequence of the CmdStartPause command
The flow diagram shows the internally used functions and interaction with a device when 
executing the CmdStartPause command.
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Parameter END

Sequence of the CmdEndPause command
The flow diagram shows the internally used functions and interaction with a device when 
executing the CmdEndPause command.

PENERGY parameter

Data block at the PENERGY parameter
The user DB for the "PE_WOL" PROFIenergy instruction represents a data base for processing 
multiple devices.

The data block is usually divided into two parts. These are:
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● Header 110 bytes

● Device section for a maximum of 256 devices each with 100 bytes (Device). These include:

– Device-specific data (Device)

– PROFIenergy-specific data (PE)

– Data for the job processing (Task)

– User data (UserData)

The data block operates with optimized access.

Connection parameter "Connection"
The "PE_WOL" instruction reserves a connection resource in the area of "Open User 
Communication". This is used as a UDP connection. The following parameters must be defined 
in the data block for this:

● Connection ID ("Connection.id" parameter)
The connection ID is an integer within the range of 1 to 32. The default setting is 31. It is 
used to identify the communication resources allocated by the firmware, for example the 
send and receive buffers. 
The connection ID must be unique throughout the CPU.

● Port number that is used for the "Wake on LAN" function ("Header.PortNo" parameter)
Number of the UDP port via which a "Wake On LAN" packet is sent. These port numbers 
are part of the communication resources, which are identified and provided by the firmware 
through the connection ID. The default setting for port 2189 used here is currently not 
assigned by IANA. The port number is transferred to the connection configuration. This 
affects the "Connection.local_tsap_id[1]" and "Connection.rem_tsap_id[1]" parameters.

● Interface ID ("Connection.local_device_id" parameter)
The interface ID is also part of the connection description. This ID identifies the CPU 
interface to use for this connection. There are several possible valid values. 
However, these need to be adapted to the employed CPU and interface:

– B#16#01 for ET200S CPU or WinAC RTX with Ethernet interface in subslot IF1

– B#16#02 for CPU 315(F)-2PN/DP or CPU 317(F)-2PN/DP

– B#16#03 for CPU 319(F)-2PN/DP

– B#16#05 for CPU 41x(F)-3PN/DP

– B#16#06 for WinAC RTX with Ethernet interface in subslot IF2

– B#16#0B for WinAC RTX with Ethernet interface in subslot IF3

– B#16#0F for WinAC RTX with Ethernet interface in subslot IF4
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Structure of the data block
The data block has the following structure:

Name Data type Offset Comment
Header PE_HEADER - Header information
 Update (1) BOOL - Signal for indicating a change in the data area.

● True= indicates a change by the user.
● False = indicates the application of changes.

Initialized BOOL - Signal indicating the completed initialization.
● True=Initialization finished.
● False= indicates that the block is not initialized.

LinkUp BOOL - Indicates successful configuration of the Ethernet interface.
● True=interface ready for use.
● False=interface not yet configured.

LinkDown BOOL - Indicates an unconfigured interface.
● True=interface is not yet configured.
● False=interface is currently being configured or is now 

configured.
PROFINET_ID (1) INT - ID of the PROFINET I/O system
Reserved ARRAY [1..37] OF 

BYTE
- Reserved

LastDeviceID INT - Contains the highest Device-ID in this PROFINET I/O 
system.

PortNo (1) WORD - Port number that is used for the "Wake on LAN" function 
(default= 2189).

Connection TCON_Param - Contains the connection configuration of the "Wake on 
LAN" connection.

 BLOCK_LENGTH UInt - Length of the structure (always B#16#40).
ID (1) CONN_OUC - Connection ID
CONNECTION_TYPE (1) USINT - Connection type (UDP = B#16#13)
ACTIVE_EST (1) BOOL - Active connection establishment (always passive for UDP)
LOCAL_DEVICE_ID (1) USINT - Contains the interface ID (CPU dependent)
LOCAL_TSAP_ID_LEN 
(1)

USINT - Contains the length in bytes of the own/local UDP port

REM_SUBNET_ID_LEN 
(1)

USINT - Unused (always B#16#00)

REM_STADDR_LEN (1) USINT - Contains the length of the remote IP address or B#16#00.
REM_TSAP_ID_LEN (1) USINT - Contains the length in bytes of the remote UDP port.
NEXT_STADDR_LEN (1) USINT - Contains the length of the default router address (not 

relevant).
LOCAL_TSAP_ID (1) ARRAY[1..16] OF 

BYTE
- Contains the own/local port number.

REM_SUBNET_ID (1) ARRAY[1..6] OF 
USINT

- Unused (always B#16#00)

REM_STADDR (1) ARRAY[1..6] OF 
USINT

- Contains the remote IP address.
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Name Data type Offset Comment
REM_TSAP_ID (1) ARRAY[1..16] OF 

BYTE
- Contains the remote UDP port number.

NEXT_STADDR (1) ARRAY[1..6] OF 
BYTE

- irrelevant

SPARE (1) WORD -  
Device ARRAY[1..256] 

OF PE_DEVICE
- Array of devices

 Device PE_DEV - Contains data for each device
 DiagID HW_IO - Diagnostic address of the device. Assigned by the 

hardware configuration.
InterfaceID WORD - Diagnostic address of the device interface. Assigned by the 

hardware configuration.
MACAdr ARRAY[1..6] OF 

BYTE
- Contains the MAC address of the device.

IPAdr ARRAY[1..4] OF 
BYTE

- Contains the IP address of the device.

OrderID_MxLen Byte - Contains the maximum length of the OrderID.
OrderId_ActLen Byte  Contains the actual length of the OrderID.
OrderID_Data ARRAY[1..20] OF 

CHAR
 Contains the OrderID of the device.

 PE PE_PE - PROFIenergy-specific data.
 ModeID BYTE - PE_MODE_ID according to Profienergy specification.

Result BYTE - PE ErrorCode according to PROFIenergy specification.
PauseTime (1) TIME - Contains the idle time in ms.
TimeToPause TIME - Contains the time it takes for the device to go into Pause 

mode.
TimeToOperate TIME - Contains the time it takes for the device to go into operating 

mode.
MinSleepTime TIME - Contains the minimum time of the device in 

PE_SLEEP_MODE.
SleepToOperate TIME - Contains the time it takes for the device to go from 

PE_SLEEP_MODE into operating mode.
StatusOperate BOOL - Indicates the operating mode of the device.
StatusPause BOOL - Indicates the device is in Pause mode.
StatusSleep BOOL - Indicates the PE_SLEEP_MODE of the device.
StatusTransitOK BOOL - Indicates the transition from one energy state to another.
StatusInTransit BOOL - Indicates a current state transition.
StatusTransitNOK BOOL - Indicates that the state change was not successful.
StatusError BOOL - Indicates an error with the device.
StatusRetryEx BOOL - Indicates an unsuccessful execution of a command. No 

more attempts will be made to execute this command.
CmdStartPause (1) BOOL - Places a START_PAUSE command for this device in the 

queue.
CmdEndPause (1) BOOL - Places a END_PAUSE command for this device in the 

queue.
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Name Data type Offset Comment
CmdUpdateStatus (1) BOOL - Places a PEM_STATUS command for this device in the 

queue.
EnableSleep (1) BOOL - Allows PE_SLEEP_MODE for this device.

● True= device should go to PE_SLEEP_MODE if idle 
time is sufficient

● False=device may not go into PE_SLEEP_MODE.
Services WORD - Shows all supported PROFIenergy services.

 UserData (2) ARRAY[1..24] OF 
BYTE

- User-defined data

 Task PE_TASK - Job processing
 Cmd BYTE - Internal bits for job processing

CmdJ BYTE - Internal bits for job processing
TimeStart BOOL - Starts a delay time.
TimeStarted BOOL - The delay time has just started.
TimeDone BOOL - Shows the expiration of the delay time.
Done BOOL - Indicates that this job has been completed.
DelayedCmd BOOL - Indicates that a delayed command is still pending.
IsV1_0 BOOL - Indicates that this device is a Spec. V1.0 device.
IsWakeOnLAN BOOL - Indicates that this device is woken up by "Wake On LAN".
RetryCount BYTE - Repetition counter for PE_COMMANDS
Duration TIME - Contains the value for the delay in ms.
StartTime TIME - Contains the start time for the delay time.
MachineState INT - Contains the internal status of the job.

(1) To be filled in by the user.
(2) Available for use by the user.

Parameter STATUS

Parameter STATUS
The output value at the STATUS parameter is divided into three areas:

● Bits 31 to 24: MESSAGE

● Bit 23 to 16: LOCATION

● Bit 15 to 0: INFORMATION

You can learn the meaning of each error code for the three areas in the following tables:

Table 9-53 Possible values for MESSAGE

Error code

(W#16#...)

Description

00 No error.
50 Instruction initialized.
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Error code

(W#16#...)

Description

51 Determining configuration of the PROFINET I/O system.
52 The instruction could not determine any configured devices in the PROFINET I/O system.
53 Determining the logical addresses of configured devices.
54 Reading interface information out of the devices.
55 Determining I&M data (data record 0 only) of the configured devices.
56 Configuring PROFINET interface for sending the "Wake on LAN" MagicPaket™ via UDP.
57 Determining PROFIenergy capabilities of the connected devices.
62 Invalid PROFINET I/O system ID detected. The causative number is displayed in the INFORMATION field.
70 The instruction is initiated and processing jobs. The value in the INFORMATION field contains the number 

of currently active jobs.
80 The instruction has lost the initialization during processing of jobs. This generally occurs when either the 

instance DB or the user DB has been reloaded.
FF Unknown error has occurred.

Table 9-54 Possible values for LOCATION

Error code

(W#16#...)

Description

00 The instruction is either not initialized or it is idle.
70 The instruction is waiting for jobs.
71 The instruction has appended a job to the job list.
72 The instruction is preparing to send a job.
73 The instruction is sending a job to a device.
74 The instruction is waiting for a response from the device.
75 The instruction is evaluating the response of the device.
76 The instruction is removing the job from the job list.
FF Unknown error has occurred.

Table 9-55 Possible values for INFORMATION

Error code

(W#16#...)

Description

0000 No additional information available and no jobs active.
0001 -00FF 1 – 255 jobs are currently being processed.
8001 Error at parameter 1 
8002 Error at parameter 2
8003 Error at parameter 3
8004 Error at parameter 4

Programming the PLC
9.7 References

WinCC Professional V13.0
2768 System Manual, 02/2014



Error code

(W#16#...)

Description

8005 Error at parameter 5. This error is reported if there is no interconnection or an invalid interconnection to the 
user DB.
Possible causes:
● The user DB is too small.
● The user DB is write-protected.
● There is no user DB in the RAM.
● The user DB is invalid for the employed CPU.

8100 An attempt has been made to place more than the maximum of 256 possible jobs. This is a temporary error, 
which is resolved by completing a few jobs. The placed jobs are not accepted and must be placed again.

8200 An attempt has been made to send an invalid or an unsupported PROFIenergy command (PE_COMMAND).
84xx A communication error has occurred. The number of the device that generated the error is output to "xx".
85xx An error has been returned from device xx. The number of the device that generated the error is output to 

"xx".
8600 The requested wake-up method is currently not supported.
FFFF Unknown error has occurred.

PROFIenergy commands

Structure of the message frames

Structure of the response frame in accordance with the PROFIenergy profile
The table below shows the basic structure of the response frame in accordance with the 
PROFIenergy profile. The response frame consists of a general section (Header) and a specific 
section (Service Data Response). The contents of the specific section of the response frame 
can be found in the description of the relevant PROFIenergy command.

Block definition Attributes Value Data type Description
BlockHeader BlockType 801 hex WORD  

BlockLength  WORD Number of bytes without consideration of 
the fields BlockType and BlockLength.

BlockVersionHigh 1 hex BYTE  
BlockVersionLow 0 hex BYTE  
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Block definition Attributes Value Data type Description
Response Header Service_Request_ID 1hex to FF hex BYTE ID of the PI command executed. The ID of 

the PE command processed by the PE 
entity is returned in the response frame:
● 01: Start_Pause
● 02: End_Pause
● 03: Query_Modes
● 04: PEM_Status
● 05: PE_Identify
● 06 to 09: Reserved
● 16: Query_Measurement
● 11 to CF: Reserved
● D0 to FF: Manufacturer-specific

Request_Reference 1hex to FF hex BYTE Unique number to identify the query/
response pair (returned by the server in the 
response).

Service Header 
Response

Status 1hex to FF hex BYTE Information whether or not the PI command 
was executed:
● 00: Reserved
● 01: Completed
● 02: Completed with error
● 03: Data incomplete
● 04 to CF: Reserved
● D0 to FF: Depends on the 

Service_Request_ID
Data_Structure_
Identifier_RS

1hex to FF hex BYTE ● 00: Reserved
● 01 to FF: Data structure depends on the 

Service_Request_ID
● 0xFF - Error

Service Data 
Response

   Depends on the Service-Request-ID:
● For the service request IDs, see the 

CMD and CMD_MODIFIER parameters 
of the instruction "PE_CMD 
(Page 2751)".

● The specific contents of the response 
frame can be found in the description of 
the PE command (see for example the 
"Start_Pause (Page 2771)" command).
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PI Command "Start_Pause"

Description
Use the PE command "Start_Pause" to start the energy-saving mode. The command 
Start_Pause can be used to:

● Switch the PE from "ready" state (PE_ready_to_operate) to an energy-saving mode 
(PE_energy_saving_mode).

● The PE entity can automatically switch between the energy-saving modes.
Energy consumption can increase or decrease when you switch energy-saving mode.

Calling the PI command "Start_Pause"
The command "Start_Pause" is called with the instruction "PE_CMD (Page 2751)" with the 
following parameters:

Parameter Value Description
CMD 1 Call of PE command "Start_Pause".
CMD_MODIFIER 0 There are no additional specifications of the command call for 

command "Start_Pause".
CMD_PARA_LEN 4 Length of the CMD_PARA parameter of 4 bytes.
CMD_PARA VARIANT VARIANT pointer to the value for "Pause_Time" (TIME).

Response frame (Service Data Response)
The following response frame data of the PE entity is written to the data block that is referenced 
at parameter RESPONSE_DATA (see instruction "PE_CMD (Page 2751)"):

Attribute Value Data type Description
PE_Mode_ID 1 to 255 BYTE Identification number of the energy-saving 

mode
Reserved 0 BYTE -

 

PI Command "End_Pause"

Description
The PE command "End_Pause" is used to end the energy-saving mode of the PE entity.
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Calling the PE command "End_Pause"
The command "End_Pause" is called with the instruction "PE_CMD (Page 2751)" with the 
following parameters:

Parameter Value Description
CMD 2 Call of PE command "End_Pause".
CMD_MODIFIER 0 There are no additional specifications of the command call for 

command "End_Pause".
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
Time_to_operate - DWORD Expected time it takes to switch to the 

"PE_ready_to_operate" mode.

PI command "Query_modes" - "List_Energy_Saving_Modes"

Description
Use PE command "Query_modes" and sub-command (modifier) "List_Energy_Saving_Modes" 
to output all energy-saving modes (PE_Mode_ID) supported by the PE entity.

The query result is written in the form of a response frame to the data block referenced by 
theRESPONSE_DATA parameter. 

Calling the PE command "Query_modes" - "List_Energy_Saving_Modes"
The command "List_Energy_Saving_Modes" is called with the instruction "PE_CMD 
(Page 2751)" with the following parameters:

Parameter Value Description
CMD 3 Call of PE command "Query_modes".
CMD_MODIFIER 1 Specification of the command call: Select the sub-command 

"List_Energy_Saving_Modes" to output the number and types 
of energy-saving modes supported.

CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Programming the PLC
9.7 References

WinCC Professional V13.0
2772 System Manual, 02/2014



Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
Number_of_PE_
Mode_IDs

1 BYTE The number of energy-saving modes.

PE_Mode_IDs - Array [...] of 
BYTE

Array with the IDs of the supported energy-
saving modes. The meaning of the 
individual IDs depends on the PE entity.

 

PI command "Query_modes" - "Get_Mode"

Description
You use the PE command "Query_modes" and the sub-command (modifier) "Get_Mode" to 
output the attributes of the energy-saving mode which is currently enabled.

Calling the PE command "Query_modes" - "Get_Mode"
The call of the command with the instruction "PE_CMD" occurs with the following parameters:

Parameter Value Description
CMD 3 Call of the PE command "Query_modes"
CMD_MODIFIER 2 Specification of the command call: Select the sub-command "Get_Mode" to output 

the status of the mode which is currently enabled.
CMD_PARA_LEN 1 Length of the CMD_PARA parameter of 1 byte.
CMD_PARA VARIANT VARIANT pointer to the value for PE_MODE_ID.
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Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
PE_Mode_ID ● 0

"PE_power_off" mode
● 1...254 

Energy-saving mode of the PE 
entity (manufacturer-specific)

● 255
"PE_ready_to_operate" mode

BYTE ID of the energy-saving mode currently 
enabled.

PE_Mode_Attributes Bit 0:
● = 0: Only static energy consumer 

and time values are available.
● = 1: Dynamic energy consumer 

and time values are available.
Bit 1 to 7:
● Reserved

BYTE  

Time_min_Pause 1 Time difference without date DWORD Minimum pause time for the PI mode. The 
minimum pause time is the sum of the 
values of the following attributes:
● Time_to_Pause
● Time_to_operate
● Time_min_length_of_stay
See the description "PAUSE_TIME 
parameter" of the instruction 
"PE_START_END: Start and exit energy-
saving mode (Page 2747)".

Time_to_Pause 1 Time difference without date DWORD Switch off time: Duration from call of 
energy-saving mode to start of energy-
saving mode (transition duration of 
PE_ready_to_operate to 
PE_energy_saving_mode). The switch-off 
time depends on the PE entity.

Time_to_operate 1 Time difference without date DWORD Switch-on time: Duration of the transition 
from energy-saving mode 
(PE_energy_saving_mode) to ready to 
operate mode (PE_ready_to_operate).
The PE entity calculates the duration 
dynamically in the output operation.

Time_min_length_
of_stay 1

 DWORD Minimum active period of the energy-
saving mode on the PE entity.

Time_max_length_
of_stay 1

 DWORD Maximum active period of the energy-
saving mode on the PE entity.

Mode_Power_
Consumption 2

 REAL Power consumption of the PE entity in 
active energy-saving mode.
Unit: kW
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Attribute Value Data type Description
Energy_
Consumption_
to_pause 2

 REAL Energy consumption of the PE entity 
during transition from ready-to-operate 
mode (PE_ready_to_operate) to energy-
saving mode (PE_energy_saving_mode)
Unit: kWh

Energy_
Consumption_
to_operate 2

 REAL Energy consumption of the PE entity 
during transition from energy-saving mode 
(PE_energy_saving_mode) to ready-to-
operate mode (PE_ready_to_operate) 
Unit: kWh

1 If the duration is infinite, 0xFFFFFFFF will be output. If the duration is zero, "0" will be output.
2 If the data for energy and power consumption is not defined by the PE entity, "0.0" will be output as the value.

PI command "PEM_Status"

Description
The PE command "PEM_Status" is used to query the status of a PE entity energy-saving mode 
that is currently enabled.

Calling the PE command "PEM_Status"
The command "PEM_Status" is called with the instruction "PE_CMD" with the following 
parameters:

Parameter Value Description
CMD 4 Call of PE command "PEM_Status".
CMD_MODIFIER 0 There are no other specifications of the command call for command 

"PEM_Status".
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -
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Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
PE_Mode_ID_
Source

● 0
"PE_power_off" mode

● 1 to 254
Energy-saving mode of the PE 
entity (manufacturer-specific)

● 255
"PE_ready_to_operate" mode

BYTE Mode of the PE entity before a PE 
command is sent.

PE_Mode_ID_
Destination

● 0
"PE_power_off" mode

● 1 to 254
Energy-saving mode of the PE 
entity (manufacturer-specific)

● 255
"PE_ready_to_operate" mode

BYTE Mode of the PE entity after a PE 
command is executed.

Time_to_operate Time difference without date DWORD Switch-on time: Duration of the transition 
from energy-saving mode 
(PE_energy_saving_mode) to ready to 
operate mode (PE_ready_to_operate).
The PE entity calculates the duration 
dynamically during output.

Remaining_time_to_
destination

Time difference without date DWORD Remaining time to switch to another 
mode.

Mode_Power_
Consumption

 REAL Power consumption of the PE entity in 
active energy-saving mode.
Unit: kW

Energy_
Consumption_
to_Destination

 REAL Energy consumption for the current PI 
transition
Unit: kWh

Energy_
Consumption_
to_operate

 REAL Energy consumption of the PE entity 
during transition from energy-saving 
mode (PE_energy-saving mode) to ready-
to-operate mode (PE_ready_to_operate) 
Unit: kWh

 

PI command "PE_Identify"

Description
The PE command "PE_Identify" is used to read out the number and description of PE 
commands supported by the PE entity. The number of specific commands supported depends 
on the PE entity. As PE_Identify is itself a PE command, at least three supported PE commands 
will be output upon a positive response: Start_Pause, End_Pause and PE_Identify.
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Calling the PE command "PE_Identify"
The command "PE_Identify" is called with the instruction "PE_CMD (Page 2751)" with the 
following parameters:

Parameter Value Description
CMD 5 Call of the command "PE_Identify".
CMD_MODIFIER 0 There are no other specifications of the command call for command 

"PE_Identify".
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
Count 1 6 BYTE Number of supported PROFIenergy commands
Start_Pause 1 BYTE First PE command supported (Service_Request_ID)
End_Pause 2 BYTE ...
Query_Modes 3 BYTE ...
PEM_Status 4 BYTE ...
PE_Identify 5 BYTE ...
Query_Measurement 16 BYTE Last PE command supported (Service_Request_ID)
1 The number of commands supported is manufacturer-specific and depends on the PE entity used. The values given are 
an example of a response frame where all 6 PE commands are supported.

 

PI Command "Query_Measurement" - "Get_Measurement_list"

Description
Use the PE command "Query_Measurement" and sub-command (modifier) 
"Get_measurement_list" to query the specific measured values supported by the PE entity. 
The supported measured values are output as a list in the data block referenced by the 
RESPONSE_DATA parameter.
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Calling the PE command "Query_Measurement" - "Get_Measurement_list"
The command is called with the instruction "PE_CMD (Page 2751)" with the following 
parameters:

Parameter Value Description
CMD 16 Call of the command "Query_Measurement".
CMD_MODIFIER 1 Specification of the command call: Select the sub-command 

"Get_Measurement_List" to output a list of supported measured values.
CMD_PARA_LEN 0 Length of the CMD_PARA parameter of 0 bytes.
CMD_PARA irrelevant -

Response frame (Service Data Response)
The following data of the PE entity response frame is written to the data block referenced at 
the RESPONSE_DATA parameter (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
Count - BYTE Number of measurement IDs
reserved - BYTE  
...    
Measurement_ID - WORD First supported Measurement_ID The Measurement_ID is 

manufacturer-specific. For more information, refer to the manual of 
the respective PE entity.

Accuracy_Domain - BYTE See "accuracy domain" table.
Accuracy_Class - BYTE See "accuracy classes" table.
Range - REAL Specifies the scale end value of the measured value (only for 

accuracy domain 1). The attribute range uses the same unit as 
defined using attribute Measurement_ID (only one unit is used for 
each Measurement_ID). 

...    
Measurement_ID - WORD Last supported Measurement_ID
Accuracy_Domain - BYTE See "accuracy domain" table.
Accuracy_Class - BYTE See "accuracy classes" table.
Range - REAL Specifies the scale end value of the measurement value (only for 

accuracy domain 1). The attribute range uses the same unit as 
defined using attribute Measurement_ID (only one unit is used for 
each Measurement_ID).

Accuracy domains

Accuracy domain Description
0 Reserved
1 The accuracy deviation is output in percentages of the scale end value. The percentage of the 

possible deviation is divided into accuracy classes (see table: Accuracy classes of the accuracy 
domains 1 and 2).
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Accuracy domain Description
2 The accuracy deviation is output in percentages of the current measurement value. The percentage 

of the possible deviation is divided into accuracy classes (see table: Accuracy classes of the accuracy 
domains 1 and 2).

3 The measuring accuracy adheres to the standard IEC 61557-12. 
The function performance classes for performance measurement and monitoring devices (PMD) 
without external sensors, and the system performance classes for PMD with external sensors, are 
coded as set out in the "Accuracy classes of accuracy domain 3" table.

4 The entry of the accuracy adheres to the standard EN 50470-3, chapter 8 (see also table: Accuracy 
classes of accuracy domain 4).

Accuracy classes

Table 9-56 Accuracy classes of the accuracy domains 1 and 2

Accuracy class 0 1 2 3 4 5 6 7 8
Meaning Reserved 0.01% 0.02% 0.05% 0.1% 0.2% 0.5% 1% 1.5%
 
Accuracy class 9 10 11 12 13 14 15 >15
Meaning 2% 2.5% 3% 5% 10% 20% >20% Not defined

 

Table 9-57 Accuracy classes of accuracy domain 3

Accuracy class 0 1 2 3 4 5 6 7 8
Meaning Reserved 0,02 0,05 0,1 0,2 0,5 1 1,5 2
 
Accuracy class 9 10 11 12 13 14 >13
Meaning 2,5 3 5 10 20 20% Not defined

 

Table 9-58 Accuracy classes of accuracy domain 4

Accuracy class 0 1 2 3 4 5 6 >7
Meaning Reserved 0,5 1,0 1,5 2,0 2,5 3,0 Not defined

 

PI Command "Query_Measurement" - "Get_Measurement_values"

Description
Use the PE command "Query_Measurement" and sub-command (modifier) 
"Get_measurement_values" to output a list of measured values supported by the PE entity. 
The measured values are output as a list in the data block referenced by the 
RESPONSE_DATA parameter.
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Calling the PE command "Query_Measurement" - "Get_Measurement_values"
The command is called with the instruction "PE_CMD (Page 2751)" with the following 
parameters:

Parameter Value Description
CMD 16 Call of the command "Query_Measurement".
CMD_MODIFIER 2 Specification of the command call: Select the command 

"Get_Measurement_Values" to output a list of supported measurement values.
CMD_PARA_LEN 0 Depends on the number of measurement values. The length of the parameters 

results from the attribute count and the sum of the lengths of the attributes for the 
transferred measurement values.

CMD_PARA VARIANT VARIANT pointer to data structure with list of measured values to be queried (see 
"CMD_PARA parameter").

 

Parameter CMD_PARA

The structure specified with the VARIANT pointer at the CMD_PARA parameter must have 
the following setup:

Attribute Value Data type Description
Count - BYTE Number of measured values (Measurement-IDs)
reserved 0 BYTE Not used
Measurement_ID - WORD First measured value queried
...    
Measurement_ID - WORD Last measured value queried

Response frame (Service Data Response)
The following response frame data of the PE entity is written to the data block that is referenced 
at parameter RESPONSE_DATA (see "PE_CMD (Page 2751)"):

Attribute Value Data type Description
Count 1 - BYTE Number of measured values (Measurement-IDs)
reserved 0 BYTE Not used
    
Length_of_Structure 2 to 65535 WORD Length of the structure in bytes
Measurement_Data_
Structure_ID

1 = simple value BYTE Defines the following structure.

Measurement_ID 0 to 65535 WORD ID of the supported measurement value.
Status_of_
Measurement_Value

1 to 3 BYTE Status of the measurement value:
● 1: Valid
● 2: Not supported
● 3: Invalid

Transmission_Data_
Type

- REAL  
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Attribute Value Data type Description
End_of_demand - TOD Optional time stamping with data type TimeOfDay.
...    
Length_of_Structure - WORD Length of the structure in bytes
Measurement_Data_
Structure_ID

- BYTE Defines the following structure.

Measurement_ID - WORD ID of the supported measurement value.
Status_of_Measurem
ent_Value

- BYTE Status of the measurement value:
● 1: Valid
● 2: Not supported
● 3: Invalid

Transmission_Data_
Type

- REAL  

End_of_demand - TOD Optional time stamping with data type TimeOfDay.
1 If the data length of the measurement values queried exceeds the size of the PDU (Protocol Data Unit) of the protocol layer, 
the data will not be completely transferred and only the supported measurement values will be output.

iDevice / iSlave

PE_I_DEV: Control PROFIenergy commands in the I-Device

Description
The instruction "PE_I_DEV" is used to process the PROFIenergy profile in the intelligent IO 
device (iDevice). The functions which are executed by the firmware in standard PROFIenergy-
compatible IO devices, such as the ET 200S, are implemented in the iDevice by the instruction 
"PE_I_DEV" and the corresponding auxiliary blocks:

● The instruction "PE_I_DEV" is called cyclically by the user program of the iDevice and 
receives all PROFIenergy commands.

● The PROFIenergy response is generated by configuring an auxiliary block. The response 
in the pause is fully programmable. The response data must be provided within 10 seconds; 
otherwise, "State conflict 0x80B5" will occur at the STATUS parameter of the instruction in 
the IO controller.

No specific knowledge of the PROFIenergy standard is required to use the instruction. 
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PROFIenergy auxiliary blocks (PE auxiliary blocks)
The PE auxiliary blocks are used to generate the response frame. Enter the response data (in 
plain text) at the input parameters of the relevant block.

● For each PROFIenergy command, there is a corresponding auxiliary block for a positive 
response:

– PE command "Start_Pause": PE_Start_RSP (Page 2786)

– PE command "End_Pause": PE_End_RSP (Page 2788)

– PE command "Query_modes" - "List_Energy_Saving_Modes": PE_List_Modes_RSP 
(Page 2789)

– PE command "Query_modes" - "Get_Mode": PE_Get_Mode_RSP (Page 2790)

– PE command "PEM_Status": PE_PEM_Status_RSP (Page 2792)

– PE command "PE_Identify": PE_Identify_RSP (Page 2794)

– PE command "Query_Measurement" - "Get_Measurement_list": 
PE_Measurement_List_RSP (Page 2795)

– PE command "Query_Measurement" - "Get_Measurement_values": 
PE_Measurement_Value_RSP (Page 2797)

● Irrespective of the PROFIenergy command, there is an additional shared auxiliary block 
for a negative response (see PE_Error_RSP (Page 2785)).

Interconnection of the auxiliary blocks
The instruction "PE_I_DEV" and the auxiliary blocks are coordinated. Some of the parameters 
are simply interconnected. The diagram below shows which of the parameters need to be 
interconnected.
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Parameters
The following table shows the parameters of the instruction "PE_I_DEV":

Parameter Declaration Data type Memory area Description
RESET Input BOOL I, Q, M, D, L or 

constant
Resets the instruction.

ID Input HW_SUBMODU
LE

I, Q, M, D, L or 
constant

Address of the iDevice
The address may be taken from the hardware 
configuration.

VALID Input BOOL I, Q, M, D, L or 
constant

The response data for the PROFIenergy 
controller is ready and can be sent.

CMD_PARA Output VARIANT I, Q, M, D, L Parameters for:
● Get mode: PE_mode_ID
● Get measurement values: List of 

Measurement_IDs (list of IDs of the tags to 
be read; either one tag or multiple tags may 
be read at any given time).

Maximum length: 234 bytes
DATA_ERRO
RRSP

InOut VARIANT I, Q, M, D, L Pointer to the data area containing the 
acknowledgment data for the PROFIenergy 
controller.
This must correspond to the pointer which is 
also used with the auxiliary blocks.

INDEX Output INT I, Q, M, D, L Data record number of the PROFIenergy 
record (set at 0x80A0)

CMD Output INT I, Q, M, D, L Service-Request-ID of the PROFIenergy 
command in accordance with the 
PROFIenergy profile (see "CMD and 
CMD_MODIFIER parameters").
Further PE commands (Service-Request-IDs) 
are possible following extensions of the 
PROFIenergy profile.

CMD_
MODIFIER

Output INT I, Q, M, D, L PROFIenergy sub-command:
● Only when CMD=3 or CMD=16; see "CMD 

and CMD_MODIFIER parameters".
● For all other commands: "0".
Further sub-commands are possible following 
extensions of the PROFIenergy profile.

NEW Output BOOL I, Q, M, D, L New data available from the PROFIenergy 
controller.

ERROR Output BOOL I, Q, M, D, L Command completed with error.
STATUS Output DWORD I, Q, M, D, L Error information (see "STATUS parameter").

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameters CMD and CMD_MODIFIER

CMD CMD_
MODIFIER

PROFIenergy command Description

01 0 Start_Pause Start energy-saving mode or switch to a different energy-
saving mode.

02 0 End_Pause End energy-saving mode.
03 1 Query_Modes - List energy 

saving Modes 
Output the energy-saving modes supported.

2 Query_Modes - Get Mode Output attributes of the energy-saving mode currently 
enabled.

04 0 PEM_Status Query status of energy-saving mode.
05 0 PE_Identify Read out the number and description of PE commands 

supported.
16 1 Query_Measurement - 

Get_Measurement_List 
List of measured values supported by the PE entity.

2 Query_Measurement - 
Get_Measurement_Values 

Output of the measured values of the PE entity.

STATUS parameter
Error information is output at the STATUS output parameter. If it is interpreted as 
ARRAY[1...4] of BYTE, the error information has the following structure:

Field element Name Meaning
STATUS[1] Function_Num Cause of the error

● B#16#00: No error
● B#16#DE: Error during reading of data record
● B#16#DF: Error during writing of data record
● B#16#C0: Error message from the instruction "PE_I_DEV" or from the internal 

communication instructions "RDREC (Page 2674)" and "WRREC (Page 2676)".
STATUS[2] Error_Decode Location of the error ID

● 80: DPV1 error as defined in IEC 61158-6 or application-specific
STATUS[3] Error_Code_1 Error ID (when Error_Decode = 80):

● B1: Write length error (error in write length or insufficient length information with 
the data type VARIANT).

STATUS[4] Error_Code_2 For PROFINET errors: Output of IO controller error message If no PROFINET error 
has occurred, the value in STATUS[4] = "0".
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 Note
Error messages of the instructions RDREC and WRREC

The instruction "PE_I_DEV" uses the instructions "WRREC (Page 2676)" and "RDREC 
(Page 2674)" for communication. Error messages for these instructions are output in the field 
elements STATUS[1] to STATUS[4].

Please see the description of the corresponding STATUS (Page 2684) parameter for an 
explanation of the error codes of the "WRREC (Page 2676)" and "RDREC (Page 2674)" 
instructions.

 

See also
Description of PROFIenergy (Page 2745)

Auxiliary blocks of the instruction PE_I_DEV

PE_Error_RSP: Generate negative answer to command

Description
The auxiliary block "PE_Error_RSP" (Response with failure) generates a negative response if 
the command requested is not supported (either in general or temporarily). Response 
generation does not depend on the command requested.

Parameter
The following table shows the parameters of the "PE_Error_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL I, Q, M, D, L or 

constant
The parameter must be interconnected with 
the NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

ERROR_CODE Input BYTE I, Q, M, D, L or 
constant

Error number

ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is 
then reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2781)" 
instruction.
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Parameter Declaration Data type Memory area Description
VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with 

the VALID input of the "PE_I_DEV 
(Page 2781)" instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for 
transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_Start_RSP: Generate answer to command at start of pause

Description
The auxiliary block "PE_Start_RSP" (Start Pause) generates the response to the PE command 
Start_Pause (Page 2771). The instruction returns the energy-saving mode to which the device 
has switched (PE_MODE_ID parameter).

If the response differs depending on the length of the pause, you can return this fact in the 
feedback on the energy-saving mode (PE_Mode_ID = 1 for a brief pause, PE_Mode_ID = 2 
for a longer pause, etc.).
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Parameter
The following table shows the parameters of the "PE_Start_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL I, Q, M, D, L or 
constant

The parameter must be interconnected with 
the NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
the CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

PE_MODE_ID Input BYTE I, Q, M, D, L or 
constant

PE mode that the process assumes

ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is 
then reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2781)" 
instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with 
the VALID input of the "PE_I_DEV 
(Page 2781)" instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for 
transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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PE_End_RSP: Generate answer to command at end of pause

Description
The auxiliary block "PE_End_RSP" generates the response to the PE command End_Pause 
(Page 2771). The response returned is the time required to switch from the current mode to 
"Ready_To_Operate" mode.

Parameter
The following table shows the parameters of the "PE_End_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL I, Q, M, D, L or 

constant
The parameter must be interconnected with 
the NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
the CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

Time_to_Operate Input DWORD I, Q, M, D, L or 
constant

Time required to switch from the current mode 
to "Ready_To_Operate".

ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is 
then reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2781)" 
instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with 
the VALID input of the "PE_I_DEV 
(Page 2781)" instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for 
transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L ● "0": No error

● "1": Error occurred.
STATUS Output WORD I, Q, M, D, L ● "0": No error

● "0x80B1": Error in VARIANT setting, e.g. 
incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_List_Modes_RSP: Generate queried energy savings modes as answer

Description
The auxiliary block "PE_List_Modes_RSP" generates the response to the PE command 
List_Energy_Saving_Modes (Page 2772). The response generated includes the number and 
the IDs of energy-saving modes supported.

Parameter
The following table shows the parameters of the "PE_List_Modes_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL I, Q, M, D, L or 

constant
The parameter must be interconnected with the 
NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with the 
CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

CMD_MODIFIER Input INT I, Q, M, D, L or 
constant

PROFIenergy sub-command (evaluated only if 
CMD=3, or CMD=16). The parameter must be 
interconnected with the CMD_MODIFIER output 
parameter of the "PE_I_DEV" instruction.

Number_of_PE_
Mode_IDs

Input BYTE I, Q, M, D, L or 
constant

Number of energy-saving modes supported.
Permitted values: 1 to 254

PE_MODE_ID Input VARIANT I, Q, M, D, L Points to the area in which the IDs of the energy-
saving modes supported (PE_Mode_ID) are 
stored.
Valid range: 1 to 254.
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Parameter Declaration Data type Memory area Description
ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 

the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is then 
reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter NEW 
of the "PE_I_DEV (Page 2781)" instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with the 
VALID input of the "PE_I_DEV (Page 2781)" 
instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_Get_Mode_RSP: Generate queried energy data as answer

Description
The auxiliary block "PE_Get_Mode_RSP" generates the response to the command 
Get_Mode (Page 2773). The response frame contains the time, performance, or energy data 
of an energy-saving mode.
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Parameter
The following table shows the parameters of the "PE_Get_Mode_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL I, Q, M, D, L or 

constant
The parameter must be interconnected with 
the NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
the CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

CMD_MODIFIER Input INT I, Q, M, D, L or 
constant

PROFIenergy sub-command (evaluated only if 
CMD=3, or CMD=16). The parameter must be 
interconnected with the CMD_MODIFIER 
output parameter of the "PE_I_DEV" 
instruction.

PE_Mode_ID Input BYTE I, Q, M, D, L or 
constant

ID of the energy-saving mode currently 
enabled.

Time_min_Pause Input DWORD I, Q, M, D, L or 
constant

Minimum pause duration for this PE energy-
saving mode.
This is the sum of the following three 
parameters:
● Time_to_Pause
● Time_to_operate
● Time_min_length_of_stay

Time_to_Pause Input DWORD I, Q, M, D, L or 
constant

Time between the edge at the START 
parameter (see "PE_I_DEV (Page 2781)") and 
the requested PE energy-saving mode being 
reached.

Time_to_Operate Input DWORD I, Q, M, D, L or 
constant

Maximum switch-on time to 
"PE_ready_to_operate". The 
"Time_to_operate" parameter can be used 
directly for the relevant calculations. The value 
may be a static maximum, or be calculated 
dynamically by the PE entity.

Time_min_Lenght_
of_stay

Input DWORD I, Q, M, D, L or 
constant

Minimum dwell time of the PE entity in this PE 
mode.

Time_max_Lenght_o
f_stay

Input DWORD I, Q, M, D, L or 
constant

Maximum dwell time of the PE entity in this PE 
mode.

Mode_Power_
Consumption

Input DWORD I, Q, M, D, L or 
constant

Energy consumption in the current PE mode in 
[kW].

Energy_Consum_
to_Pause

Input DWORD I, Q, M, D, L or 
constant

Energy consumption from 
"PE_ready_to_operate" to the current PE 
mode in [kWh].

Energy_Consum_
to_operate

Input DWORD I, Q, M, D, L or 
constant

Energy consumption from the current PE mode 
to "PE_ready_to_operate" in [kWh].
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Parameter Declaration Data type Memory area Description
ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 

the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is 
then reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2781)" 
instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with 
the VALID input of the "PE_I_DEV 
(Page 2781)" instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for 
transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_PEM_Status_RSP: Generate PEM status as answer

Description
The auxiliary block "PE_PEM_Status_RSP" generates the response to the command 
PEM_Status (Page 2775).
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Parameter
The following table shows the parameters of the "PE_PEM_Status_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NEW Input BOOL I, Q, M, D, L or 

constant
The parameter must be interconnected with the 
NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with the 
CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

PE_MODE_ID_
Source

Input BYTE I, Q, M, D, L or 
constant

Source and Destination for PEM_STATUS.
Values:
● 0x00: PE_POWER_OFF
● 0x01 – 0xFE: manufacturer-specific
● 0xFF: PE_READY_TO_OPERATE

PE_MODE_ID_
Destination

Input BYTE I, Q, M, D, L or 
constant

Time_to_Operate1 Input DWORD I, Q, M, D, L or 
constant

Maximum switch-on time to 
"PE_ready_to_operate".
"Time_to_operate" can be used directly for the 
relevant calculations. The value may be a static 
maximum, or be calculated dynamically by the 
PE entity.

Remaining_time_
to_destination1

Input DWORD I, Q, M, D, L or 
constant

Optional: Time remaining until the requested PE 
mode. Dynamic value or static maximum value

Mode_Power_
Consumption2

Input DWORD I, Q, M, D, L or 
constant

Energy consumption in the current PE mode in 
[kW].

Energy_
Consumption_
to_Destination2

Input DWORD I, Q, M, D, L or 
constant

Energy consumption in the time until the 
requested PE mode in [kW].

Energy_
Consumption_
to_operate2

Input DWORD I, Q, M, D, L or 
constant

Energy consumption from the current PE mode 
to "PE_ready_to_operate" in [kWh].

ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is then 
reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter NEW 
of the "PE_I_DEV (Page 2781)" instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with the 
VALID input of the "PE_I_DEV (Page 2781)" 
instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for transmission.
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Parameter Declaration Data type Memory area Description
DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range
1 If the time period is unlimited, the maximum value "0xFFFFFFFF" can be specified. If the time period is "Zero", "0x00" can 
be used.
2 If no energy consumption value has been defined, "0.0" can be specified.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_Identify_RSP: Generate supported PROFIenergy commands as answer

Description
The auxiliary block "PE_Identify_RSP" generates the response to the command PE_Identify 
(Page 2776). In the response to the command, specify which PROFIenergy commands are 
supported. Please note that PE_IDENTIFY is itself a PE command and has to be included in 
the response.

Parameter
The following table shows the parameters of the "PE_Identify_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL I, Q, M, D, L or 
constant

The parameter must be interconnected with 
the NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
the CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

Start_Pause Input BOOL I, Q, M, D, L or 
constant

One parameter for each of the relevant 
PROFIenergy commands:
● 0: PE command is not supported
● 1: PE command is supported

End_Pause Input BOOL I, Q, M, D, L or 
constant
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Parameter Declaration Data type Memory area Description
Query_Modes Input BOOL I, Q, M, D, L or 

constant
PEM_Status Input BOOL I, Q, M, D, L or 

constant
PE_Identify Input BOOL I, Q, M, D, L or 

constant
Query_
Measurement

Input BOOL I, Q, M, D, L or 
constant

ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is 
then reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2781)" 
instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with 
the VALID input of the "PE_I_DEV 
(Page 2781)" instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for 
transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_Measurement_List_RSP: Generate list of supported measured values as answer

Description
The auxiliary block "PE_Measurement_List_RSP" generates the response to the command 
Get_measurement_list (Page 2777). In the response, specify which measured values 
(Measurement-IDs) are supported.
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Parameter
The following table shows the parameters of the "PE_Measurement_List_RSP" auxiliary block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL I, Q, M, D, L or 
constant

The parameter must be interconnected with 
the NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with 
the CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

CMD_MODIFIE
R

Input INT I, Q, M, D, L or 
constant

PROFIenergy sub-command (evaluated only 
if CMD=3, or CMD=16). The parameter must 
be interconnected with the CMD_MODIFIER 
output parameter of the "PE_I_DEV" 
instruction.

Count Input BYTE I, Q, M, D, L or 
constant

Number of measured values supported 
(measurement IDs)

Measurement_
List

Input VARIANT D Pointer to the array with the Measurement_IDs 
supported.
For information on the structure of the array in 
accordance with the PROFIenergy profile, 
see: PI Command "Query_Measurement" - 
"Get_Measurement_list" (Page 2777) 

ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 
the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is 
then reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter 
NEW of the "PE_I_DEV (Page 2781)" 
instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with 
the VALID input of the "PE_I_DEV 
(Page 2781)" instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for 
transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L ● "0": No error

● "1": Error occurred.
STATUS Output WORD I, Q, M, D, L ● "0": No error

● "0x80B1": Error in VARIANT setting, e.g. 
incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

PE_Measurement_Value_RSP: Generate queried measured values as answer

Description   
The auxiliary block "PE_Measurement_Value_RSP" generates the response to the command 
Get_measurement_values (Page 2779). In the response, return the values of the requested 
measurements.

Parameter
The following table shows the parameters of the "PE_Measurement_Value_RSP" auxiliary 
block:

Parameter Declaration Data type Memory area Description
PE_I_DEV_NE
W

Input BOOL I, Q, M, D, L or 
constant

The parameter must be interconnected with the 
NEW output parameter of the "PE_I_DEV 
(Page 2781)" instruction. The auxiliary block is 
only processed if the parameter value is set to 
"1".

CMD Input INT I, Q, M, D, L or 
constant

Service-Request-ID of the PROFIenergy 
command 
The parameter must be interconnected with the 
CMD output parameter of the "PE_I_DEV 
(Page 2781)" instruction.

CMD_MODIFIE
R

Input INT I, Q, M, D, L or 
constant

PROFIenergy sub-command (evaluated only if 
CMD=3, or CMD=16). The parameter must be 
interconnected with the CMD_MODIFIER output 
parameter of the "PE_I_DEV" instruction.

Count Input BYTE I, Q, M, D, L or 
constant

Number of measured values 
(Measurement_Values).

Measurement_V
alues

Input VARIANT D Pointer to the array with the measured values 
(Measurement_IDs).
For information on the structure of the array in 
accordance with the PROFIenergy profile, see PI 
Command "Query_Measurement" - 
"Get_Measurement_values" (Page 2779) 
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Parameter Declaration Data type Memory area Description
ACTIVATE InOut BOOL I, Q, M, D, L The instruction copies the input parameters to 

the DATA_ERROR_RSP data area at a rising 
edge at input ACTIVATE. The parameter is then 
reset by the instruction.
The parameter must be set within 10 seconds 
after a rising edge is detected at parameter NEW 
of the "PE_I_DEV (Page 2781)" instruction.

VALID InOut BOOL I, Q, M, D, L The parameter must be interconnected with the 
VALID input of the "PE_I_DEV (Page 2781)" 
instruction. 
The auxiliary block sets the parameter as soon 
as the response data for the PROFIenergy 
controller is available and ready for transmission.

DATA_
ERRORRSP

InOut VARIANT D Pointer on the data area in which the response 
data is stored. The parameter is identical to the 
pointer for DATA_ERRORRSP of the 
"PE_I_DEV (Page 2781)" instruction. The 
addressed data area contains the complete 
PROFIenergy frame. 
Minimum length: 244 bytes

ERROR Output BOOL I, Q, M, D, L ● "0": No error
● "1": Error occurred.

STATUS Output WORD I, Q, M, D, L ● "0": No error
● "0x80B1": Error in VARIANT setting, e.g. 

incorrect range

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

9.7.3.6 Module parameter assignment

Writing and reading data records

Principle
Some modules have a write-only system data area to which your program can transfer data 
records. This area contains data records with numbers from 0 to a maximum of 240. Not every 
module contains all of the data records (see following table).

Modules can also have a read-only system data area in which your program can read data 
records. This area contains data records with numbers from 0 to a maximum of 240. Not every 
module contains all of the data records (see following table).

 

 Note

There are modules that have both system data areas. These are physically separate areas 
and the only thing they have in common is their logical structure.
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Write-only system data area
The following table shows the structure of the write-only system data area. This table also 
shows how the permitted size of the individual data records and which instructions can be used 
to write them.

Data record 
number

Contents Size Can be written with 
instruction

0 Parameter - WR_DPARM (Page 2806)
1 Parameter - WR_DPARM (Page 2806)
2 to 127 User data Each ≤ 240 bytes WR_DPARM (Page 2806)

WR_REC (Page 2716)
128 to 240 Parameter Each ≤ 240 bytes WR_DPARM (Page 2806)

WR_REC (Page 2716)

Read-only system data area
The following table shows the structure of the read-only system data area. This table also 
shows the permitted size of the individual data records and which instructions can be used to 
read them.

Data record 

number

Contents Size Can be read with instruction

0 Module-specific 
diagnostics data (set as 
standard for the entire 
system)

4 bytes RD_REC (Page 2712)

1 Channel-specific 
diagnostics data
(incl. data record 0)

4 to 220 Bytes RD_REC (Page 2712)

2 to 127 User data Each ≤ 240 bytes RD_REC (Page 2712)
128 to 240 Diagnostics data Each ≤ 240 bytes RD_REC (Page 2712)

System resources
If you start several asynchronous data record transfers one after the other with only short 
intervals between them, the allocation of system resources by the operating system ensures 
that all the jobs are executed and that they do not interfere with each other.

If the limits of the system resources are reached, this is indicated in RET_VAL. You can remedy 
this temporary error situation by simply repeating the job.

The maximum number of "simultaneously" active jobs of a single instruction type depends on 
the CPU.
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RD_DPAR: Read module data record

Description
You use the instruction to read the data record with the number INDEX of the addressed 
component from the configured system data. This may be a module in a central rack or a 
distributed component (PROFIBUS DP or PROFINET IO).

The value TRUE for the output parameter VALID  indicates that the data record was 
successfully transferred to the target range RECORD. In this case, the LEN output parameter 
contains the length of the read data in bytes.

If an error has occurred during transfer of the data record, this is indicated by the output 
parameter ERROR . In this case, the output parameter STATUS contains the error information.

Functional description
The "RD_DPAR" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the data record transfer by calling "RD_DPAR" with REQ = 1.

The output parameter BUSY  and bytes 2 and 3 of the output parameter STATUS  show the 
status of the job. Bytes 2 and 3 of STATUS  match the output parameter RET_VAL of the 
instructions that operate asynchronously.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

The transfer of the data record is complete when the output parameter BUSY has the value 
FALSE.

Parameter
The following table shows the parameters of the instruction "RD_DPAR":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_IO I, Q, M, D, L or 
constant

Identification number of the CPU or the 
interface.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface of the hardware configuration.

INDEX Input INT I, Q, M, D, L or 
constant

Data record number

RECORD InOut VARIANT I, Q, M, D, L Target range for the read data record
VALID Output BOOL I, Q, M, D, L New data record was received and is valid
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The job is not yet completed.
ERROR Output BOOL I, Q, M, D, L ERROR = 1: An error occurred during the 

reading process.
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Parameter Declaration Data type Memory area Description
STATUS Output DWORD I, Q, M, D, L ● Call ID (bytes 2 and 3) or error code

● Byte 1: B#16#00, if no error. Otherwise 
function ID from DPV1-PDU: In the case of 
error for data record reading B#16#DE, in 
the case of error for data record writing 
B#16#DF. If no DPV1 protocol element is 
used: B#16#C0.

● Byte 4: Manufacturer-specific error ID 
extension

LEN Output INT I, Q, M, D, L Length of the read data record information

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

STATUS parameter

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value "0". -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Address specified at parameter LADDR is invalid. -
8092 A data type other than (Array of) bit string or integer was specified at 

the RECORD parameter.
-

8093 This instruction is not valid for the module selected with LADDR. -
80A1 Negative acknowledgment during sending of data record to module 

(module defective or unplugged during sending).
-

80A2 DP protocol error at layer 2, possible hardware/interface error in DP 
slave.

Distributed I/O

80A3 DP protocol error at user interface/user. Distributed I/O
80A4 Communication problem on com bus. Error occurs between CPU and 

external DP 
interface module

80B0 Instruction for module type not possible, or module does not recognize 
the data record.

-

80B1 The length of the data 
record to be sent is 
incorrect. 

-

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not correspond to 
specified module type.

-

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-
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Error code*
(W#16#...)

Explanation Restriction

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

 

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available or deactivated. Distributed I/O 
80C6 Data record transfer cancelled due to priority class abort (restart or 

background).
Distributed I/O 

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
RD_DPARM: Read data record from configured system data (Page 2804)

RD_DPARA: Read module data record asynchronously

Description
You use the instruction to read the data record with the number RECNUM  of a selected module 
from the configured system data. The read data record is entered in the target range defined 
by the parameter RECORD .

Functional description
The "RD_DPARA" instruction works asynchronously, that is, its execution extends over 
multiple calls. You start the reading process by calling the instruction with REQ = 1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).
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Parameters
The following table shows the parameters of the instruction "RD_DPARA":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

LADDR Input HW_IO I, Q, M, D, L or 
constant

Identification number of the CPU or the 
interface.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface of the hardware configuration.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number (permitted values: 0 to 
240)

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.
If no error occurred during the transmission, 
the following cases are distinguished:
● RET_VAL  contains the length of the 

actually read data record in bytes if the 
target range is larger than the read data 
record.

● RET_VAL  contains "0" if the length of the 
read data record is equal to the length of 
the target range.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The job is not yet completed.
RECORD Output VARIANT I, Q, M, D, L Target range for the data record read.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 0. -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Specified logical base address invalid. -
8092 A data type other than (Array of) bit string or integer was specified at 

the RECORD parameter.
-

8093 This instruction is not valid for the module selected with LADDR. -
80A1 Negative acknowledgment during sending of data record to module 

(module defective or unplugged during sending).
-

80A2 DP protocol error at layer 2, possible hardware/interface error in DP 
slave.

Distributed I/O
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Error code*
(W#16#...)

Explanation Restriction

80A3 DP protocol error at user interface/user. Distributed I/O
80A4 Communication on PBUS+ disrupted -
80B0 Instruction for module type not possible, or module does not recognize 

the data record.
-

80B1 The length of the data 
record to be sent is 
incorrect. With RD_DPARM (Page 2804): The target range 
spanned by RECORD  is too short.

-

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not correspond to 
specified module type.

-

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

 

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available or deactivated. Distributed I/O 
80C6 Data record transfer cancelled due to priority class abort (restart or 

background).
Distributed I/O 

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RD_DPARM: Read data record from configured system data

Description
You use instruction to read the data record with the number RECNUM of the addressed module 
from the configured system data. The read data record is entered into the target range spanned 
by the RECORD parameter.
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Parameters
The following table shows the parameters of the instruction "RD_DPARM":

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or 

constant
Address area identifier:
● B#16#54 = Peripheral input (PI)
● B#16#55 = Peripheral output (PQ)
If the module is a mixed module, the area 
identifier of the lower address must be 
specified. If the addresses are identical, 
specify B#16#54.

LADDR Input HW_IO I, Q, M, D, L or 
constant

Hardware ID of the CPU or the interface.
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface in the hardware configuration.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number (permitted values: 0 to 
240)

RET_VAL Return INT I, Q, M, D, L Length of the data record read in bytes if 
the read data record fits in the target range 
and no error occurred in the transfer.
If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

RECORD Output VARIANT I, Q, M, D, L Target range for the data record read.

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value "0". -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Specified logical base address invalid. -
8092 A type other than BYTE  is specified in the VARIANT reference at the 

RECORD parameter.
-

8093 This instruction is not valid for the module selected with LADDR. -
80B1 The target range 

spanned by RECORD  is too short.
-

80C3 The required resources (memory, etc.) are currently 
occupied.

-

80D0 There is no entry for the module. -
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Error code*
(W#16#...)

Explanation Restriction

80D1 The data record number is not configured for the module (data record 
numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

WR_DPARM: Transfer data record

Description
You use the instruction "WR_DPARM" to transfer the data record with the number RECNUM 
from the configuration data to the addressed module. With this instruction, it is irrelevant 
whether the data record is static or dynamic.

Parameters
The following table shows the parameters of the instruction "WR_DPARM":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L REQ = 1: Write request
LADDR Input HW_IO I, Q, M, D, L or 

constant
Hardware ID of the CPU or of the interface. 
The number is assigned automatically and is 
stored in the properties of the CPU or of the 
interface in the hardware configuration.

RECNUM Input BYTE I, Q, M, D, L or 
constant

Data record number

RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is being 
executed, the return value contains an error 
code.

BUSY Output BOOL I, Q, M, D, L BUSY = 1: The writing process is not yet 
completed.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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RET_VAL parameter

Error code*
(W#16#...)

Explanation Restriction

0000 No error -
7000 First call with REQ=0: No data transfer active; BUSY has the value 0. -
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1". Distributed I/O
7002 Intermediate call (REQ 

irrelevant): Data transfer already active; BUSY has the value "1".
Distributed I/O

8090 Address specified at parameter LADDR is invalid. -
8093 This instruction is not valid for the module selected with LADDR. -
80A1 Negative acknowledgment during sending of data record to module 

(module defective or unplugged during sending).
-

80A2 DP protocol error at layer 2, possible hardware/interface error in DP 
slave.

Distributed I/O

80A3 DP protocol error at user interface/user. Distributed I/O
80A4 Communication on PBUS+ disrupted -
80B0 Instruction for module type not possible, or module does not recognize 

the data record.
-

80B1 The length of the data 
record to be sent is 
incorrect. 

-

80B2 The configured slot is 
not assigned.

-

80B3 Actual module type 
does not correspond to 
specified module type.

-

80C1 The data of the previous write job on the module for the same data 
record have not yet been processed by the module.

-

80C2 The module is currently processing the maximum possible 
number of jobs for a CPU.

-

80C3 The required resources (memory, etc.) are currently 
occupied.

 

80C4 Internal temporary error. Job could not be executed.
Repeat the job. If this error occurs often, check your installation for 
sources of electrical interference.

-

80C5 Distributed I/O not available or deactivated. Distributed I/O 
80C6 Data record transfer cancelled due to priority class abort (restart or 

background).
Distributed I/O 

80D0 There is no entry for the module. -
80D1 The data record number is not configured for the module (data record 

numbers > 
241 are rejected).

-

80D2 The module cannot be assigned parameters according to its type 
identifier.

-

80D5 The data record is static. -
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Error code*
(W#16#...)

Explanation Restriction

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) -

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.7 Interrupts

ATTACH: Attach an OB to an interrupt event

Description
You use the instruction "ATTACH" to assign an organization block (OB) to an event.

You enter the symbolic or numeric name of the organization block in the OB_NR parameter. 
This will then be assigned to the event specified in the EVENT parameter.

If the event in the EVENT parameter occurs following error-free execution of the "ATTACH" 
instruction, the organization block in the OB_NR parameter will be called and its program 
executed.

With the ADD parameter, you specify whether previous assignments of the organization block 
to other events should be canceled or retained. If the ADD parameter has the value "0", the 
existing assignments will be replaced by the current assignment.

Parameters
The following table shows the parameters of the "ATTACH" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_ATT I, Q, M, D, L or constant Organization block (numbers up to 32767 

are supported.)
EVENT Input EVENT_ATT D, L or constant Event, e.g., creation of a process event 

(failure of a hardware module; read 
hardware ID (16#C0xxyyzz) and query at 
block)

ADD Input BOOL I, Q, M, D, L or constant Effects on previous assignments:
● ADD=0 (default): This event replaces all 

previous event assignments for this OB.
● ADD=1: This event is added to the 

previous event assignments for this OB.
RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL

Error code*
(W#16#....) 

Description

0 No error
8090 OB does not exist
8091 OB is incorrect type
8093 Event does not exist
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DETACH: Detach an OB from an interrupt event

Description
You use this instruction to cancel the existing assignment of an organization block to one or 
more events during runtime.

● If you have selected a single event, the assignment of the OB to this event will be cancelled. 
All other currently existing assignments remain active. You can select an individual event 
using the drop-down list of the operand placeholder at the EVENT parameter.

● If you have not selected an event, all currently existing assignments of the organization 
block to events will be canceled.

You enter the symbolic or numeric name of the organization block in the OB_NR parameter. 
The assignment of this organization block to the event specified in the EVENT parameter will 
then be canceled.

Parameters
The following table shows the parameters of the "DETACH" instruction:

Parameters Declaration Data type Memory area Description
OB_NR Input OB_ATT I, Q, M, D, L or constant Organization block (numbers up to 32767 

are supported.)
EVENT Input EVENT_ATT D, L or constant Event
RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL

Error code*
(W#16#....) 

Description

0 No error
1 No assignment exists (warning)
8090 OB does not exist
8091 OB has incorrect type
8093 Event does not exist
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Cyclic interrupt

SET_CINT: Set cyclic interrupt parameters

Description       
You use this instruction to set the parameters for a cyclic interrupt OB. The start time for a 
cyclic interrupt OB is generated from the respective time interval of the OB and the phase 
offset.

● The time interval of an OB is the interval at which the OB is periodically called. For example, 
if the time interval is 100 μs, the OB will be called every 100 μs during program execution.

● The phase offset is a time interval by which the call of a cyclic interrupt OB is offset. You 
can use the phase offset to process low priority organization blocks in a precise time base.

If the OB does not exist or if the time interval used is not supported, a corresponding error 
alarm is output in the RET_VAL parameter.

A time interval in the CYCLE parameter of "0" means that the OB will not be called.

Functional description
If a lower priority OB and a higher priority OB are called in the same time interval, the lower 
priority OB will only be called once the higher priority OB has been executed. The call time for 
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the lower priority OB can be offset according to the length of time to execute the higher-priority 
OB.

If a phase offset is configured for the lower priority OB and the phase offset is greater than the 
current execution time of the respective higher priority OB, then the block will be called in a 
fixed time base.

Parameters
The following table shows the parameters of the "SET_CINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_CYCLIC I, Q, M, D, L or constant OB number (<32768)
CYCLE Input UDINT I, Q, M, D, L or constant Time interval in microseconds
PHASE Input UDINT I, Q, M, D, L or constant Phase offset
RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL

Error code*
(W#16#....) 

Description

0 No error
8090 OB does not exist or is of the wrong type
8091 Incorrect time interval
8092 Incorrect phase offset
80B2 No event assigned to OB
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

QRY_CINT: Query cyclic interrupt parameters

Description   
You can use this instruction to query the current parameters of a cyclic interrupt OB. The cyclic 
interrupt OB is identified using the OB_NR parameter.

The values of the queried cyclic interrupt parameters correspond to those at the time the 
"QRY_CINT" instruction is executed.

Parameters
The following table shows the parameters of the "QRY_CINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_CYCLIC 

(INT)
I, Q, M, D, L or constant OB number (<32768) or symbolic 

addressing via the name of the OB (e.g. 
OB_MyOB)

CYCLE Output UDINT I, Q, M, D, L Time interval in microseconds
PHASE Output UDINT I, Q, M, D, L Phase offset
STATUS Output WORD I, Q, M, D, L Status of the cyclic interrupt:

● Bit 0 to bit 4: see parameter STATUS
● Other bits: Always "0"

RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Bit Value Meaning
0 0 Not used (always "0").
1 0 The cyclic interrupt is enabled.
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Bit Value Meaning
1 The cyclic interrupt is delayed.

2 0 The cyclic interrupt is not enabled or has expired.
1 The cyclic interrupt is enabled.

3 0 Not used (always "0").
4 0 An OB with the specified number does not exist.

1 An OB with the specified number exists.
Other bits Not used (always "0").

Parameter RET_VAL
If an error occurs, the relevant error code will be displayed in the RET_VAL parameter and the 
STATUS parameter is set to "0".

Error code*
(W#16#....) 

Description

0 No error.
8090 OB does not exist or is of the wrong type
80B2 No result assigned to OB.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Time-of-day interrupt

SET_TINT: Set time-of-day interrupt

Description
The instruction "SET_TINT" is used to set the start data and time of the time-of-day interrupt 
organization blocks from the user program, without having to make settings in the hardware 
configuration.

● Enter the number of the time-of-day interrupt-OBs at the parameter OB_NR for which you 
would like to set the start date and the time-of-day.

● Use the parameter SDT and PERIOD to specify when and how often the time-of-day 
interrupt OB should be called:

– One-time call: Enter at the parameter SDT the date and the time-of-day and use the 
value "0" at the parameter PERIOD.

– Repeated call: Enter the date and the time-of-day of the first call at the parameter SDT. 
Use the parameter PERIOD to define the time interval in which subsequent calls of the 
OBs should take place. 

Observe the following when setting the start date and start time:
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● The date and the time-of-day specification at the parameter SDT refers to the system time.

● The seconds and milliseconds specification is ignored and set to "0" at the start time.

● Only the starting date days 1, 2, ... 28 are possible if you want to specify a monthly time-of-
day interrupt OBs. This restriction prevents skipping the monthly call (e.g. 30-day months 
or in February).
The setting "end of the month" (W#16#2001) can be used at the parameter PERIOD as an 
alternative to the 29th 30th and the 31st of the month.

After setting the time-of-day interrupt with "SET_TINT" it still must be activated with the 
instruction "ACT_TINT".

 

 Note
Additional information about time-of-day interrupt OBs

Other special features for the use of time-of-day interrupt OBs can be found in the descriptions 
of the organization blocks of the respective CPU:

For the S7-1200: Auto-Hotspot

For the S7-1500: Auto-Hotspot

The settings at the parameters SDT and PERIOD coincide with the settings for time-of-day 
interrupt in the properties of the time-of-day interrupt OBs.

 

Parameters
The following table shows the parameters of the "SET_TINT" instruction:

Parameters Declaration Data type Memory area Description
OB_NR Input OB_TOD I, Q, M, D, L or 

constant
Number of the time-of-day interrupt OBs
● The numbers 10 to 17 are available for the 

time-of-day interrupt OBs.
● An OB number starting with 123 can also 

be assigned as an alternative.
The OB number is displayed in the program 
block folder and in the system constants.

SDT Input DT D, L or constant Start date and start time
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Parameters Declaration Data type Memory area Description
PERIOD Input WORD I, Q, M, D, L or 

constant
Execution intervals from the starting point SDT 
to:
● W#16#0000 = single execution
● W#16#0201 = once every minute
● W#16#0401 = once hourly
● W#16#1001 = once daily
● W#16#1201 = once weekly
● W#16#1401 = once monthly
● W#16#1801 = once yearly
● W#16#2001 = at month's end

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

RET_VAL parameter

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Error at the parameter OB_NR (no time-of-day interrupt OB addressed).
8091 Error at the parameter SDT (invalid date and time-of-day specification).
8092 Incorrect input at the parameter PERIOD.
80A1 The set start time is in the past. This error code only occurs at PERIOD = W#16#0000.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
ACT_TINT: Enable time-of-day interrupt (Page 2819)
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SET_TINTL: Set time-of-day interrupt

Description
The instruction "SET_TINTL" is used to set the start data and time of the time-of-day interrupt 
organization blocks from the user program, without having to make settings in the hardware 
configuration.

● Enter the number of the time-of-day interrupt-OBs at the parameter OB_NR for which you 
would like to set the start date and the time-of-day.

● Use the parameter SDT and PERIOD to specify when and how often the time-of-day 
interrupt OB should be called:

– One-time call: Enter at the parameter SDT the date and the time-of-day and use the 
value "0" at the parameter PERIOD.

– Repeated call: Enter the date and the time-of-day of the first call at the parameter SDT. 
Use the parameter PERIOD to define the time interval in which subsequent calls of the 
OBs should take place.

● Use the parameter LOCAL to select whether the time specified at the parameter SDT refers 
to the local time or the system time.

● With the ACTIVATE parameter, you specify whether the settings made for the organization 
block are to be applied directly (ACTIVATE = true) or only after "ACT_TINT (Page 2819)" 
for the time-of-day interrupt organization block is called (ACTIVATE = false).

Observe the following when setting the start date and start time:

● The seconds and milliseconds specification is ignored and set to "0" at the start time.

● Only the starting date days 1, 2, ... 28 are possible if you want to specify a monthly time-of-
day interrupt OBs. This restriction prevents skipping the monthly call (e.g. 30-day months 
or in February).
The setting "end of the month" (W#16#2001) can be used at the parameter PERIOD as an 
alternative to the 29th 30th and the 31st of the month.

Please observe the following during the use of local time:

● Changeover from daylight saving to standard time: When calling time-of-day interrupt 
organization blocks with a start time within the second hour during changeover from daylight 
saving time to standard time, also use a time-delay interrupt during the first hour of the time 
changeover.

● Changeover from standard to daylight saving time: If you specify the skipped hour as the 
time-of-day for the daylight saving time changeover day, the error code 16#8091 will be 
output at a single execution (PERIOD = W#16#0000).
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 Note
Additional information about time-of-day interrupt OBs

Other special features for the use of time-of-day interrupt OBs can be found in the descriptions 
of the organization blocks of the respective CPU:

For the S7-1200: Auto-Hotspot

For the S7-1500: Auto-Hotspot

The settings at the parameters SDT and PERIOD coincide with the settings for time-of-day 
interrupt in the properties of the time-of-day interrupt OBs.

 

Parameters
The following table shows the parameters of the "SET_TINTL" instruction:

Parameters Declaration Data type Memory area Description
OB_NR Input OB_TOD I, Q, M, D, L or 

constant
Number of the time-of-day interrupt OBs
● The numbers 10 to 17 are available for the 

time-of-day interrupt OBs.
● An OB number starting with 123 can also be 

assigned as an alternative.
The OB number is displayed in the program 
block folder and in the system constants.

SDT Input DTL D, L or constant Start date and start time
LOCAL Input BOOL I, Q, M, D, L or 

constant
● true: Use local time
● false: Use system time

PERIOD Input WORD I, Q, M, D, L or 
constant

Execution intervals from the starting point SDT 
to:
● W#16#0000 = single execution
● W#16#0201 = Once every minute
● W#16#0401 = once hourly
● W#16#1001 = once daily
● W#16#1201 = once weekly
● W#16#1401 = once monthly
● W#16#1801 = once yearly
● W#16#2001 = at month's end

ACTIVATE Input BOOL I, Q, M, D, L or 
constant

● true: set and activate the time-of-day 
interrupt

● false: set the time-of-day interrupt and only 
activate at call of "ACT_TINT (Page 2819)"

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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RET_VAL parameter

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Error at the parameter OB_NR (no time-of-day interrupt OB addressed).
8091 Error at the parameter SDT (invalid date and time-of-day specification).
8092 Incorrect input at the parameter PERIOD.
80A1 The set start time is in the past. This error code only occurs at PERIOD = W#16#0000.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

CAN_TINT: Cancel time-of-day interrupt

Description
The instruction "CAN_TINT" is used to delete the start data and start time of a specified time-
of-day interrupt organization block. This deactivates the time-of-day interrupt, and the 
organization block is no longer called.

If you want to reuse the time-of-day interrupt, the start time must be reset (instruction 
"SET_TINTL (Page 2816)" or "SET_TINT (Page 2813)").

Thereafter, you must reactivate the time-of-day interrupt:

● If you use the instruction "SET_TINT (Page 2813)" or "SET_TINTL (Page 2816)" with 
parameter ACTIVE=false to set the time-of-day interrupt, call "ACT_TINT (Page 2819)".

● By using the instruction "SET_TINTL (Page 2816)" you can also activate the time-of-day 
interrupt directly with the parameter ACTIVE=true. 

Parameters
The following table shows the parameters of the instruction "CAN_TINT":

Parameters Declaration Data type Memory area Description
OB_NR Input OB_TOD I, Q, M, D, L or constant Number of the time-of-day interrupt OB, 

whose starting date and time-of-day are to 
be deleted.

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of 
RET_VAL contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
8090 Error at the parameter OB_NR.
80A0 No starting date/time-of-day defined for the affected time-of-day interrupt OB.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ACT_TINT: Enable time-of-day interrupt

Description
With the instruction "ACT_TINT" you can activate a time-of-day interrupt organization block 
from the user program. A prerequisite for the execution of the instruction is that the starting 
date and time-of-day are already set for the time-of-day interrupt OB.

Parameters
The following table shows the parameters of the instruction "ACT_TINT":

Parameters Declaration Data type Memory area Description
OB_NR Input OB_TOD I, Q, M, D, L or 

constant
Number of the time-of-day interrupt OBs
● The numbers 10 to 17 are available for the 

time-of-day interrupt OBs.
● An OB number starting with 123 can also 

be assigned as an alternative.
The OB number is displayed in the program 
block folder and in the system constants.

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Error at the parameter OB_NR (no time-of-day interrupt OB addressed).
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Error code*
(W#16#...)

Description

80A0 Start date and time-of day not set for the relevant time-of-day interrupt OB.
80A1 The activated time is in the past. The error only occurs if the time-of-day interrupt is only to be executed 

once.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

QRY_TINT: Query status of time-of-day interrupt

Description
You can use this instruction to display the status of a time-of-day interrupt organization block 
in the STATUS output parameter. 

Parameters
The following table shows the parameters of the "QRY_TINT" instruction:

Parameters Declaration Data type Memory area Description
OB_NR Input OB_TOD I, Q, M, D, L or constant Number of the time-of-day interrupt OB 

whose status is queried 
The OB number is displayed in the program 
block folder and in the system constants.

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of 
RET_VAL contains an error code.

STATUS Output WORD I, Q, M, D, L Status of the time-of-day interrupt (see 
below)

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
Exception: Status message "0" on bit 4 (no OB with this number created).

8090 Error at the parameter OB_NR. Possible causes:
● The value at the parameter OB_NR is not an OB number (<1 or > 32767) supported by the CPU.
● The OB number does not address a time-of-day interrupt OB.
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Error code*
(W#16#...)

Description

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS
If an error occurs (see RET_VAL parameter), "0" is output in the STATUS parameter.

Bit Value Meaning
0 0 In Run.
 1 During startup.
1 0 The time-of-day interrupt is enabled.
 1 The time-of-day interrupt is disabled.
2 0 Time-of-day interrupt is not activated or has elapsed.
 1 The time-of-day interrupt is activated.
4 0 An OB with an OB number as specified at OB_NR parameter does not exist.
 1 An OB with an OB number as specified at OB_NR parameter does exist.
6 0 The time-of-day interrupt is based on the system time
 1 The time-of-day interrupt is based on the local time
Other Always "0"

Time-delay interrupt

Using time-delay interrupts

Definition  
After you have called the "SRT_DINT (Page 2823)" instruction, the operating system generates 
an interrupt after the specified delay time has elapsed, in other words, the assigned time-delay 
interrupt OB is called.

Prerequisites for the call
Before a time-delay interrupt can be called by the operating system, the following conditions 
must be met:

● The time-delay interrupt OB must be started by the "SRT_DINT (Page 2823)" instruction.

● The time-delay interrupt OB must not be deselected during configuration.

● The time-delay interrupt OB must exist in the CPU.
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Purpose of the instructions "SRT_DINT", "CAN_DINT" and "QRY_DINT"
You use the instructions to

● Start time-delay interrupts ("SRT_DINT (Page 2823)")

● Cancel time-delay interrupts ("CAN_DINT (Page 2824)")

● Query time-delay interrupts ("QRY_DINT (Page 2824)")

Effects on the time-delay interrupt
The following table lists a number of different situations and explains the effect they have on 
a time-delay interrupt.

If ... and ... Then ...
A time-delay interrupt is 
started (by calling 
"SRT_DINT (Page 2823)")

The time-delay interrupt has 
already started,

The delay time is overwritten; the 
time-delay interrupt is started 
again.

 The time-delay interrupt OB 
does 
not exist at the time of the 
call,

The operating system generates 
a priority class error (calls OB 85). If OB 
85 does not exist, the CPU 
changes to STOP.

 The interrupt is started in a 
startup 
OB and the delay time 
elapses 
before the CPU changes to 
RUN,

The call of the time-delay interrupt 
OB is delayed until the CPU is in 
RUN mode.

The delay time has elapsed, A previously started time-
delay 
interrupt OB is still being 
executed,

The operating system generates a 
time error (calls OB 80). If OB 80 
does not exist, the CPU changes 
to STOP.

Response to warm restart and cold restart 
During a warm restart or a cold restart, all the time-delay interrupt settings made in the user 
program by means of instructions are cleared.

Starting in a startup OB
A time-delay interrupt can be started in a startup OB. Two conditions must be satisfied to call 
the time-delay OB:

● The delay time must have elapsed.

● The CPU must be in the RUN mode.

If the delay time has elapsed and the CPU is not yet in the RUN mode, the time-delay interrupt 
OB call is delayed until the CPU is in RUN mode. The time-delay interrupt OB is then called 
before the first instruction in OB Main [OB 1] is executed.
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SRT_DINT: Start time-delay interrupt

Description
The instruction "SRT_DINT" is used to start a time-delay interrupt, which calls a time-delay 
interrupt OB after the expiry of the delay time specified at the parameter DTIME. The delay 
time is started when a negative edge is generated in the EN enable input. The signal state of 
enable input EN must be "0" during delay time countdown. If the delay time countdown is 
interrupted, the OB configured in the OB_NR parameter is not executed.

Accuracy
The maximum time between the call of the "SRT_DINT" instruction and the start of the time-
delay interrupt OB is one millisecond longer than the configured delay time, provided that no 
interruption events delay the call.

Parameters
The following table shows the parameters of the instruction "SRT_DINT":

Parameter Declaration Data type Memory area Description
OB_NR Input OB_DELAY 

(INT)
I, Q, M, D, L or constant Number of the OB to be executed after a 

delay time 
DTIME Input TIME I, Q, M, D, L or constant Delay time (1 to 60000 ms)

You can realize longer times, for example, 
by using a counter in a time-delay 
interrupt OB.

SIGN Input WORD I, Q, M, D, L or constant Identifier that appears when the time-
delay interrupt OB is called in the start 
event information of the OB.

RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*

(W#16#...)

Description

0000 No error 
8090 Incorrect parameter OB_NR
8091 Incorrect parameter DTIME
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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CAN_DINT: Cancel time-delay interrupt

Description
You use this instruction to cancel a started time-delay interrupt and, thus, also cancel the call 
of the time delay interrupt OB that is to be executed after the configured delay time. You specify 
the number of the organization block whose call is to be canceled in the OB_NR parameter.

Parameters
The following table shows the parameters of the "CAN_DINT" instruction:

Parameter Declaration Data type Memory area Description
OB_NR Input OB_DELAY 

(INT)
I, Q, M, D, L or constant Number of the OB whose call will be 

canceled 
RET_VAL Return INT I, Q, M, D, L Status of the instruction

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*

(W#16#...)

Description

0000 No error 
8090 Incorrect parameter OB_NR
80A0 Time-delay interrupt has not started.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

QRY_DINT: Query time-delay interrupt status

Description
The instruction "QRY_DINT" is used to query the status of the time-delay interrupt.
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Parameters
The following table shows the parameters of the instruction "QRY_DINT":

Parameter Declaration Data type Memory area Description
OB_NR Input OB_DELAY 

(INT)
I, Q, M, D, L or 
constant

Number of the OB whose status is being 
queried.

RET_VAL Return INT I, Q, M, D, L If an error occurs during execution of the 
instruction, the actual parameter of RET_VAL 
contains an error code. The value "0" is 
displayed in the STATUS parameter.

STATUS Output WORD I, Q, M, D, L Status of the time-delay interrupt, see 
following table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Bit Value Meaning
0 0 Operating system in RUN
 1 Operating system in startup
1 0 Time-delay interrupt is enabled by the operating system.
 1 Time-delay interrupt is disabled.
2 0 Time-delay interrupt is not activated or has elapsed.
 1 Time-delay interrupt is activated.
3 - -
4 0 Time-delay interrupt OB with the specified number does not exist.
 1 Time-delay interrupt OB with the specified number exists.
Other bits Always "0"

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred. 
8090 Incorrect information in the OB_NR parameter
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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Synchronous errors

Mask synchronous error events

Introduction
Synchronous errors are programming and access errors. Such errors occur as a result of 
programming with incorrect operand areas or numbers, or incorrect addresses. Masking these 
synchronous errors means the following:

● Masked synchronous errors do not trigger an error OB call and do not lead to a programmed 
alternative reaction.

● The CPU "records" the masked errors that have occurred in an error status register.

Masking is carried out by calling the "MSK_FLT (Page 2831)" instruction.

Unmasking errors means canceling a previously set mask and clearing the corresponding bit 
in the event status register of the current priority class. Masking is canceled as follows: 

● By calling the "DMSK_FLT (Page 2832)" instruction.

● Once the current priority class has been completed.

If an error event occurs after it has been unmasked, then the operating system will start the 
associated error OB.

You can use the "READ_ERR (Page 2833)" instruction to read the masked errors that have 
occurred.

 

 Note

Regardless of masking or unmasking of the error events for the S7-1500, the error event is 
entered in the diagnostic buffer and the group error LED of the CPU lights up.

 

Programming the PLC
9.7 References

WinCC Professional V13.0
2826 System Manual, 02/2014



Handling errors in general
Different actions are possible if programming and I/O area access errors occur in a user 
program:

● You can program an error OB that is called by the operating system when the corresponding 
error occurs.

● You can disable the error OB call individually for each priority class. In this case, the CPU 
does not change to STOP when an error of this type occurs in the particular priority class. 
The CPU enters the error in an error register. From this entry, however, you cannot 
recognize when or how often the error occurred.

Synchronous errors are assigned to a particular bit pattern known as the error filter. You can 
find this error filter in the input and output parameters of the "MSK_FLT (Page 2831)", 
"DMSK_FLT (Page 2832)", and "READ_ERR (Page 2833)" instructions.

Synchronous errors are divided into programming and access errors which you can mask in 
two error masks. The error filters are illustrated in the following figures.
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Programming error filter
The following figure shows the bit pattern of the error filter for programming errors. The error 
filter for the programming errors is available in the "PRGFLT_..." parameters (see below 
"Programming errors, Low-Word" or "Programming errors, High-Word").

The non-relevant bits "x" are set to "0" for the input and output parameters of the instructions 
"MSK_FLT (Page 2831)", "DMSK_FLT (Page 2832)", "READ_ERR (Page 2833)".
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Access error mask
The following figure shows the bit pattern of the error mask for access errors. The error mask 
for access errors is located in the parameters ACCFLT_...

Example: The following figure shows how the low word of the error mask for access errors 
appears with all masked errors.

● As input parameters for "MSK_FLT (Page 2831)"

● As output parameters for "MSK_FLT (Page 2831)"

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2829



Programming error low word
The following table lists the errors assigned to the low word of the error filter for programming 
errors. The possible causes of the errors are also listed.

Error Event ID
(W#16#...)

Possible cause of error

BCD conversion error 2521 The value to be converted is not a BCD number (e.g. 5E8).
Area length error when reading 2522 An addressed operand is not located entirely within the possible operand 

range.
Example: MW 320 should be read although the memory area 
is only 256 bytes long.

Area length error when writing 2523 An addressed operand is not located entirely within the possible operand 
range.
Example: A value should be written to MW 320 although the 
memory area is only 256 bytes long.

Range error when reading 2524 An incorrect range identifier for the operand was specified during indirect, 
overlapping range addressing.
Example: 
● Correct: LAR1 P#E 12.0

L W[AR1, P#0.0]
● Incorrect: LAR1 P#12.0

L W[AR1, P#0.0] The range error is reported during this operation.
Range error when writing 2525 An incorrect range identifier for the operand was specified during indirect, 

overlapping range addressing.
Example: 
● Correct: LAR1 P#E 12.0

T W[AR1, P#0.0]
● Incorrect: LAR1 P#12.0

T W[AR1, P#0.0]  The range error is reported during this operation. 
Timer number error 2526 A non-existent timer is accessed.

Example:
● SI T [MW 0] with MW 0 = 129; the timer 129 should be started 

although there are only 128 timers available.
Counter number error 2527 A non-existent counter is accessed.

● Example: ZV Z [MW 0] with MW 0 = 600; the counter 600 is accessed 
although only 512 counters are available.

Alignment error when reading 2528 A byte, word or double word operand with a bit address ≠ 0 is addressed.
Example: 
● Correct: LAR1 P#M12.0

L B[AR1, P#0.0]
● Incorrect: LAR1 P#M12.4

L B[AR1, P#0.0]
Alignment error when writing 2529 A byte, word or double word operand with a bit address ≠ 0 is addressed.

Example: 
● Correct: LAR1 P#M12.0

T B[AR1, P#0.0]
● Incorrect: LAR1 P#M12.4

T B[AR1, P#0.0]

Programming the PLC
9.7 References

WinCC Professional V13.0
2830 System Manual, 02/2014



Programming error high word
The following table lists the errors assigned to the high word of the error filter for programming 
errors. The possible causes of the errors are also listed.

Error Event ID
(W#16#...)

Possible cause of error

Write error data block 2530 The data block to be written to is write-protected.
Write error instance data block 2531 The instance data block to be written to is write-protected.
Block number error DB 2532 The number of the data block is greater than the highest permissible 

number.
Block number error DI 2533 The number of the instance data block is greater than the highest 

permissible number.
Block number error FC 2534 The number of a called function (FC) is greater than the highest 

permissible number.
Block number error FB 2535 The number of a called function block (FB) is greater than the highest 

permissible number.
DB not loaded 253A The data block is not loaded.
Instruction not loaded 253C to 

253F
The instruction to be called is not loaded.

Access error
The following table contains the errors that are assigned to the error mask for access errors. 
The possible causes of the errors are also listed.

Error Event ID
(W#16#...)

Possible cause of error

I/O access error 
when reading

2942 ● The address in the I/O area has no assigned signal module.
● Access to this I/O area was not acknowledged within the specified 

module monitoring time (timeout).
 

I/O access error 
when writing

2943

MSK_FLT: Mask synchronous error events

Description     
You use the instruction to control the reaction of the CPU to synchronous errors. This is done 
by masking the respective synchronous errors (for error filters, see Mask synchronous error 
events (Page 2826)). When you call "MSK_FLT", you mask the synchronous errors in the 
current priority class.

If you set individual bits of the synchronous error filter to "1" in the input parameters, other bits 
that were set previously retain their value of "1". You obtain new error filters that you can read 
out using the output parameters. The synchronous errors you have masked do not call an OB 
but are simply entered in an error register. You can read the error register with the 
"READ_ERR (Page 2833)" instruction. 
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Parameters
The following table shows the parameters of the instruction "MSK_FLT":

Parameter Declaration Data type Memory area Description
PRGFLT_SET_MASK Input DWORD I, Q, M, D, L or constant Programming error to be 

masked
ACCFLT_SET_MASK Input DWORD I, Q, M, D, L or constant Access error to be masked
RET_VAL Return INT I, Q, M, D, L Error information
PRGFLT_MASKED Output DWORD I, Q, M, D, L Masked programming errors
ACCFLT_MASKED Output DWORD I, Q, M, D, L Masked access errors

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 None of the errors were already masked.
0001 At least one of the errors was already masked. Nevertheless the other errors will be masked.
- General error information

See also: Getting error ID locally with GetErrorID (Page 2578)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Evaluating errors with output parameter RET_VAL (Page 1854)

DMSK_FLT: Unmask synchronous error events

Description     
You use the instruction to unmask the errors masked with "MSK_FLT (Page 2831)". To do 
this, you must set the corresponding bits of the error filter to "1" in the input parameters. With 
the "DMSK_FLT" call, you unmask the corresponding synchronous errors of the current priority 
class. At the same time, the queried entries are cleared in the error register. You can read out 
the new error filters using the output parameters.
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Parameters
The following table shows the parameters of the instruction "DMSK_FLT":

Parameter Declaration Data type Memory area Description
PRGFLT_RESET_
MASK

Input DWORD I, Q, M, D, L or constant Programming errors to be 
unmasked

ACCFLT_RESET_
MASK

Input DWORD I, Q, M, D, L or constant Access errors to be 
unmasked

RET_VAL Return INT I, Q, M, D, L Error information
PRGFLT_MASKE
D

Output DWORD I, Q, M, D, L Still masked programming 
errors

ACCFLT_MASKE
D

Output DWORD I, Q, M, D, L Still masked access errors

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 All specified errors were unmasked.
0001 At least one of the errors was not masked. Nevertheless the other errors will be unmasked.
- General error information

See also: GET_ERR_ID: Get error ID locally (Page 2578)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

READ_ERR: Read out event status register

Description     
You use the instruction to read the error register. The structure of the error register corresponds 
to that of the programming and access error filters, which you can program as input parameters 
with "MSK_FLT (Page 2831)" and "DMSK_FLT (Page 2832)".

In the input parameters, you enter the synchronous errors you want to read from the error 
register. When you call "READ_ERR", you read the required entries from the error register and 
at the same time clear these entries.

The error register contains information that tells you which of the masked synchronous errors 
in the current priority class occurred at least once. If a bit is set, this means that the 
corresponding masked synchronous error occurred at least once.
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Parameters
The following table shows the parameters of the instruction "READ_ERR":

Parameter Declaration Data type Memory area Description
PRGFLT_QUERY Input DWORD I, Q, M, D, L or constant Query programming error
ACCFLT_QUERY Input DWORD I, Q, M, D, L or constant Query access error
RET_VAL Return INT I, Q, M, D, L Error information
PRGFLT_CLR Output DWORD I, Q, M, D, L Programming errors that occurred
ACCFLT_CLR Output DWORD I, Q, M, D, L Access errors that occurred

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 All queried errors are masked.
0001 At least one of the queried errors is not masked.
- General error information

See also: Getting error ID locally with GetErrorID (Page 2578)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Evaluating errors with output parameter RET_VAL (Page 1854)

Asynchronous error event

DIS_IRT: Disable interrupt event

Description
The instruction "DIS_IRT" is used to disable the processing of new interrupts and 
asynchronous error events. Disabling means that if an interrupting event occurs, the operating 
system of the CPU reacts as follows:

● It neither calls an interrupt OB nor an asynchronous error OB,

● nor does it trigger the normal reaction if an interrupt OB or asynchronous error OB is not 
programmed.

If you disable interrupts and asynchronous error events, this remains in effect for all priority 
classes. The disable can only be canceled with the "EN_IRT (Page 2836)" instruction or by a 
warm or a cold restart.
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Whether the operating system writes interrupts and asynchronous error events to the 
diagnostics buffer when they occur depends on the input parameter setting you select for 
MODE.

 

 Note

Remember that when you program the "DIS_IRT" instruction, all interrupts that occur will be 
discarded.

 

Parameters
The following table shows the parameters of the instruction "DIS_IRT":

Parameter Declaration Data type Memory area Description
MODE Input BYTE I, Q, M, D, L or constant Specifies which interrupts and 

asynchronous 
errors are disabled.

OB_NR Input INT I, Q, M, D, L or constant OB number
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction is 

being executed, the return value contains 
an error code.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter MODE

MODE 
(B#16#...)

Meaning

00 All newly occurring interrupts and asynchronous error events are disabled. (Synchronous errors 
are not disabled.) Assign the value "0" to the OB_NR  parameter. Entries continue to be made in the 
diagnostics buffer.

01 All newly occurring events belonging to a specified interrupt class are disabled. Identify the interrupt class 
by specifying it as follows:
● Time-of-day interrupts: 10
● Time-delay interrupts: 20
● Cyclic interrupts: 30
● Process interrupts: 40
● Interrupts for DPV1: 50
● Multicomputing interrupt: 60
● Redundancy error interrupts: 70
● Asynchronous error interrupts: 80
Entries continue to be made in the diagnostics buffer.

02 All new occurrences of a specified interrupt are disabled. You designate the interrupt 
using the OB number. Entries continue to be made in the diagnostics buffer.
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Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
8090 The OB_NR  input parameter contains an invalid value.
8091 The MODE  input parameter contains an invalid value.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

EN_IRT: Enable interrupt event

Description       
You use the instruction to enable the processing of new interrupts and asynchronous error 
events that you have previously disabled with the "DIS_IRT (Page 2834)" instruction. This 
means that if an interrupting event occurs, the operating system of the CPU reacts in one of 
the following ways:

● It calls an interrupt OB or asynchronous error OB.
or

● It triggers the standard reaction if the interrupt OB or asynchronous error OB is not 
programmed.

Parameters
The following table shows the parameters of the instruction "EN_IRT":

Parameter Declaration Data type Memory area Description
MODE Input BYTE I, Q, M, D, L or constant Specifies which interrupts and 

asynchronous error events will be 
enabled.

OB_NR Input INT I, Q, M, D, L or constant OB number
RET_VAL Return INT I, Q, M, D, L If an error occurs while the instruction 

is being executed, the return value 
contains an error code.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter MODE

MODE Meaning
0 All newly occurring interrupts and asynchronous error events are enabled.
1 All newly occurring events belonging to a specified interrupt class are enabled. Identify the interrupt class by 

specifying it as follows:
● Time-of-day interrupts: 10
● Time-delay interrupts: 20
● Cyclic interrupts: 30
● Process interrupts: 40
● Interrupts for DPV1: 50
● Multicomputing interrupt: 60
● Redundancy error interrupts: 70
● Asynchronous error interrupts: 80

2 All newly occurring events of a specified interrupt are enabled. You designate the interrupt 
using the OB number.

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error occurred.
8090 The OB_NR  input parameter contains an invalid value.
8091 The MODE  input parameter contains an invalid value.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DIS_AIRT: Delay execution of higher priority interrupts and asynchronous error events

Description       
You use "DIS_AIRT" to delay the processing of interrupt OBs whose priority are higher than 
the priority of the current organization block. 

You can call "DIS_AIRT" multiple times in an organization block. The "DIS_AIRT" calls are 
counted by the operating system. Processing is delayed more and more each time "DIS_AIRT" 
is executed. To cancel a delay, you must execute the "EN_AIRT (Page 2838)" instruction. To 
cancel all delays, the number of "EN_AIRT (Page 2838)" executions must be equal to the 
number of "DIS_AIRT" calls.

You can query the number of delays in the RET_VAL parameter of the "DIS_AIRT" instruction. 
If the value in the RET_VAL parameter is "0", there are no delays.
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Parameters
The following table shows the parameters of the "DIS_AIRT" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L Number of delays

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

EN_AIRT: Enable execution of higher priority interrupts and asynchronous error events

Description       
You use "EN_AIRT" to enable processing of organization blocks when interrupts occur that 
have been delayed by the "DIS_AIRT (Page 2837)" instruction. 

When "EN_AIRT" is executed, you cancel a processing delay that was registered by the 
operating system when "DIS_AIRT (Page 2837)" was called. To cancel all delays, the number 
of "EN_AIRT" executions must be equal to the number of "DIS_AIRT (Page 2837)" calls. If, for 
example, you have called "DIS_AIRT (Page 2837)" five times and thereby also delayed the 
processing five times, you must call the "EN_AIRT" instruction five times in order to cancel all 
five delays.

You can query the number of interrupt delays that have not yet been enabled after the 
execution of "EN_AIRT" in the RET_VAL parameter of the "EN_AIRT" instruction. The value 
"0" in the RET_VAL parameter means that all delays enabled by "DIS_AIRT (Page 2837)" have 
been cancelled. 

Parameters
The following table shows the parameters of the "EN_AIRT" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L Number of configured delays

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

9.7.3.8 Alarms

Program_Alarm: Generate program alarm with associated values

Description
The instruction "Program_Alarm" monitors a signal and generates a program alarm when a 
signal change occurs at the SIG parameter (for definition, see also: Auto-Hotspot). An incoming 
program message is generated with a signal change from 0 to 1 and an outgoing program 
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message is generated with a signal change from 1 to 0. The program alarm is triggered 
synchronously to program execution.

You can append up to ten associated values to the program alarm at the parameters SD_i (0 
≤ i ≤10). The associated values are detected at the time of signal change at parameter SIG 
and assigned to the program alarm. For more information on configuring associated values, 
refer to the following sections: Auto-Hotspot, Auto-Hotspot.

Each incoming or outgoing alarm is assigned a time stamp:

● The current system time of the PLC when the signal change occurs is used by default 
(default value at the TIMESTAMP parameter).

● If you wish to specify a different time stamp, you can create one at the TIMESTAMP 
parameter.
The time value must always be specified in system time (i.e. UTC) as this is the time used 
for time synchronization throughout the plant.

● If an alarm is to be time-stamped with a local time, a conversion module, which converts 
the local time to system time, must be connected in series. This is the only way to make 
sure that the time stamp is shown properly in the alarm display.

To use the current system time of the CPU, set the TIMESTAMP parameter to its default value 
(LDT#1970-1-1-0:0:0.0).

Calling the "Program_Alarm" instruction
The instruction "Program_Alarm" can only be called in a function block (FB). 

Once the instruction has been inserted in the FB, a multi-instance of the data type 
"Program_Alarm" is created in the "Static" section of the FB interfaces. You can choose any 
name for this multi-instance in the dialog which appears. The name of the multi-instance is 
also the name of the program alarm.

Finally, add the parameters of the "Program_Alarm" instruction in line with your requirements 
(see the "Parameters" table).

Configuring the program alarm
The program alarm settings are displayed in the "Properties" window when you select the 
name of the program alarm in the "Static" section or in the network of the FB. In this window, 
you can select the alarm class, priority, etc. and edit the alarm text.

The settings that are made here can be edited in the project tree. Go to "PLC alarms" and 
open the "Program alarms" tab. All existing program alarms are then displayed in the "Alarm 
types" table.
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Parameters
The following table shows the parameters of the "Program_Alarm" instruction:

Parameter Declaration Data type Memory area Description
SIG Input BOOL I, Q, M, D, L, T, C or 

constant
The signal to be monitored.

TIMESTAMP Input LDT M, D, L or constant This parameter is used to assign an alarm a 
time stamp, for example, from an input signal 
with a distributed stamp. The time value must 
always be specified in system time (i.e. UTC), 
as this is the time used for time 
synchronization throughout the plant.
● "Not assigned" means that the system time 

of the CPU will be used as the interrupt 
time stamp when a signal change occurs 
(default).

● Any system time input will be used as the 
interrupt time stamp when a signal change 
occurs.

Note: If an interrupt is to be time-stamped with 
a local time, a conversion module must be 
connected in series to convert the local time to 
system time. This is the only way to make sure 
that the time stamp is shown correctly in the 
interrupt display.

SD_i
 
 

Input LREAL, REAL, 
DINT, INT, 
SINT, UDINT, 
UINT, USINT, 
DWORD, 
WORD, BYTE, 
BOOL, 
WSTRING, 
STRING, 
WCHAR, CHAR

I, Q, M, D, L i-th associated value (0 ≤ i ≤ 10)

ERROR Output BOOL I, Q, M, D, L Status parameter ERROR
ERROR = TRUE indicates that an error has 
occurred during processing. The possible 
error cause is displayed at the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter STATUS
Display of error information (see "ERROR  and 
STATUS parameters").

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

Programming the PLC
9.7 References

WinCC Professional V13.0
2840 System Manual, 02/2014



ERROR and STATUS parameters
The following table contains all specific error information that can be output via the ERROR  
and STATUS  parameters.

ERROR STATUS* Explanation
0 0000 No error
1 0085 "Only information" alarm type.
1 8001 Invalid static alarm information.
1 8002 No valid static alarm information.
1 8004 Maximum size of 512 bytes reached for the associated values of the alarm.
1 8005 Incoming alarm.
1 8007 Outgoing alarm, preceded by no incoming alarm.
1 8087 Deactivate static alarms.
1 8089 Length of the alarm is too large.
1 80Ax The SD_i parameter has an invalid value.
1 80C1 The CPU cannot generate any alarms at this time because initialization routines are running (this 

is the case after download in RUN, for example). Try again later.
1 80C2 The maximum number of alarms per time unit has been sent. Try again later.
1 80C3 All dynamic alarm instances are being used. Try again later.
1 80C4 Alarm is being output and cannot be overwritten. Try again later.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Get_AlarmState: Output alarm status

Description
The "Get_AlarmState" instruction outputs the alarm status of a program alarm. The output of 
the alarm status always refers to a program alarm that was created using the 
"Program_Alarm (Page 2838)" instruction.

The program alarm is selected with the Alarm input parameter. Specify the instance DB of the 
"Program_Alarm" instruction at the Alarm parameter.

The alarm status is returned in a byte via the AlarmState output parameter. The meaning of 
the individual bits is shown in the following figure:
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You can find more information about the possible alarm states in the section "Auto-Hotspot". 

The execution status of the instruction is shown with the output parameters ERROR and 
STATUS. 

Parameters
The following table shows the parameters of the "Get_AlarmState" instruction:

Parameter Declaration Data type Memory area Description
Alarm Input ALARM_BASE D Instance of the "Program_Alarm (Page 2838)" 

instruction. 
AlarmState Output BYTE I, Q, M, D, L Status of the alarm as a bit array.
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy STATUS to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter STATUS

Error code* 
(W#16#...)

Explanation

8001 Invalid static alarm instance.
8002 ID of the alarm is invalid.
8003 No active alarms within the message class.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Gen_UsrMsg: Generate user diagnostic alarms

Description
You can use the "Gen_UsrMsg" instruction to create a message for entry into the diagnostic 
buffer.

You can use the Mode parameter to select whether an incoming or an outgoing message is 
to be generated:

● With Mode = 0: Create an incoming message.

● With Mode = 1: Create an outgoing message.

● Regardless of whether an incoming or outgoing message is generated, the message always 
has the attribute "Information only".

The content of the message is defined with a text list:

● Specify the text list you want to use with the parameter TextListID. For this purpose open 
the dialog "Text lists" in the project navigation. Show the column "ID" in the dialog "Text 
lists". Apply the ID at the parameter TextListID.

● Use the parameter TextID  to select the text list entry you want to write in the diagnostic 
buffer. For this purpose select an entry from the "Text lists entries" dialog by applying a 
number from the columns "Range from / range to" at the parameter TextID. The same 
number must be used from both the "Range from" and "Range to" columns for the text list 
entry.

● Additional information about text lists can be found here: Text lists (Page 435)

New associated values can be defined in the text entry and then added to the message:

● Associated values are defined by adding the following information in the text list entry: 
@<Nr. des Begleitwertes><Formatangabe>@

● Use the system data type AssocValues to specify which associated value is added when 
generating the message.

● Additional information on the structure of associated values can be found here: Auto-
Hotspot

The entry in the diagnostic buffer is created synchronously. Message transmission is 
asynchronous.

If an error occurs during the execution of an instruction, it is output via the parameter RET_VAL.
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Parameters
The following table shows the parameters of the "Gen_UsrMsg" instruction:

Parameter Declaration Data type Memory area Description
Mode Input UInt I, Q, M, D, L or 

constant
Parameters for selecting the status of the 
message:
● 1: incoming message
● 2: outgoing message

TextID Input UInt I, Q, M, D, L or 
constant

ID of the text list entry that should be used for 
the message text.

TextListID Input UInt I, Q, M, D, L or 
constant

ID of the text list that contains text list entry.

Ret_Val Return Int I, Q, M, D, L Error code of the instruction.
AssocValues InOut VARIANT I, Q, M, D, L Pointer to the system data type AssocValues 

that allows you to define the associated values
.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

AssocValues parameter
Use the system data type AssocValues to define which associated values will be sent. A 
maximum of 8 associated values are possible. The structure of the system data type is created 
by entering the data type "AssocValues" as a data block. 

The associated values are selected by entering the numbers of the associated values for the 
parameters Value[x]. The associated value must be used in the selected text list entry 
(parameter TextID). Note the following: 

● The values for TextID and TextListID are treated by the instruction as the associated values 
to be sent. This means that the digits "1" and "2" can not be used as a numbers for 
associated values.

● Therefore, use "3" as the first number at the parameter Value [0] and "4" at the parameter 
Value [1] etc.

Byte Parameters Data type Start value Description
0..1 Value[1] UINT 0 First associated value 

of the message.
2..3 Value[2] UINT 0 Second associated 

value of the message.
4..5 Value[3] UINT 0 ...
6..7 Value[4] UINT 0 ...
8..9 Value[5] UINT 0 ...
10..11 Value[6] UINT 0 ...
12..13 Value[7] UINT 0 ...
14..15 Value[8] UINT 0 Eighth associated 

value of the message.
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RET_VAL parameter
The following table contains all specific error information that can be output via the RET_VAL  
parameter.

Error code* 
(W#16#...)

Explanation

0000 No error
8080 Value in the Mode parameter is not supported.
80C1 Resource bottleneck due to too many parallel calls. 
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.9 Diagnostics

RD_SINFO: Read current OB start information

Description
You use the instruction "RD_SINFO" to read the start information

● of the last OB called that has not yet been completely executed, and

● of the last startup OB started.

There is no time stamp in either case. If the call is in OB 100, OB 101 or OB 102, two identical 
start information messages will be returned.

Parameter
The following table shows the parameters of the "RD_SINFO" instruction:

Parameter Declaration Data type Memory area Description
RET_VAL Return INT I, Q, M, D, L Error information
TOP_SI Output VARIANT D, L Start information of the current OB
START_UP_SI Output VARIANT D, L Start information of the startup OB 

last started

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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SDTs of the TOP_SI parameter
The following table shows the possible SDTs for the TOP_SI parameter:

Organization blocks (OB) System data types (SDT) System data type numbers
Any SI_classic 592
 SI_none 593
ProgramCycleOB SI_ProgramCycle 594
TimeOfDayOB SI_TimeOfDay 595
TimeDelayOB SI_Delay 596
CyclicOB SI_Cyclic 597
ProcessEventOB SI_HWInterrupt 598
ProfileEventOB
StatusEventOB
UpdateEventOB

SI_Submodule 601

SynchronousCycleOB SI_SynchCycle 602
IOredundancyErrorOB SI_IORedundancyError 604
CPUredundancyErrorOB SI_CPURedundancyError 605
TimeErrorOB SI_TimeError 606
DiagnosticErrorOB SI_DiagnosticInterrupt 607
PullPlugEventOB SI_PlugPullModule 608
PeripheralAccessErrorOB SI_AccessError 609
RackStationFailureOB SI_StationFailure 610
ServoOB SI_Servo 611
IpoOB SI_Ipo 612
StartupOB SI_Startup 613
ProgrammingErrorOB
IOaccessErrorOB

SI_ProgIOAccessError 614

SDTs of the START_UP_SI parameter
The following table shows the possible SDTs for the START_UP_SI parameter:

 

System data types (SDT) System data type numbers
SI_classic 592
SI_none 593
SI_Startup 613

Structures
The following tables set out the meaning of the structure elements of the individual structures:

Programming the PLC
9.7 References

WinCC Professional V13.0
2846 System Manual, 02/2014



Table 9-59 SI_classic structure

Structure element Data type Description
EV_CLASS BYTE ● Bits 0 to 3: Event ID

● Bits 4 to 7: Event class
EV_NUM BYTE Event number
PRIORITY BYTE Priority class number

(Meaning of B#16#FE: OB not available or disabled or cannot be started in 
current operating mode)

NUM BYTE OB number
TYP2_3 BYTE Data ID 2_3: 

Identifies the information entered in ZI2_3
TYP1 BYTE Data ID 1: 

Identifies the information entered in ZI1
ZI1 WORD Additional information 1
ZI2_3 DWORD Additional information 2_3

Table 9-60 SI_none structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)

Table 9-61 SI_ProgramCycle structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 1 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
Remanence BOOL For OB_Class = 1

Table 9-62 SI_TimeOfDay structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 10 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
CaughtUp BOOL For OB_Class = 10
SecondTime BOOL For OB_Class = 10
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Table 9-63 SI_Delay structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 20 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Sign WORD For OB_Class = 20

Table 9-64 SI_Cyclic structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 30 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92

Table 9-65 SI_HWInterrupt structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 40 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
USI WORD For OB_Class = 40
IChannel USINT For OB_Class = 40
EventType BYTE For OB_Class = 40

Table 9-66 SI_Submodule structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Slot UINT For OB_Class = 55, 56, 57
Specifier WORD For OB_Class = 55, 56, 57
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Table 9-67 SI_SynchCycle structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 61 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
PIP_Input BOOL For OB_Class = 61, 91, 92
PIP_Output BOOL For OB_Class = 61, 91, 92
IO_System USINT For OB_Class = 61, 91, 92
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92
SyncCycleTime LTIME Calculated cycle time

Table 9-68 SI_IORedundancyError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 70 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_ANY For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86

Table 9-69 SI_CPURedundancyError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 72 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Switch_Over BOOL For OB_Class = 72

Table 9-70 SI_TimeError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 80 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86
Csg_OBnr OB_ANY For OB_Class = 80
Csg_Prio UINT For OB_Class = 80
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Table 9-71 SI_DiagnosticInterrupt structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 82 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
IO_State WORD For OB_Class = 82
LADDR HW_ANY For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Channel UINT For OB_Class = 82
MultiError BOOL For OB_Class = 82

Table 9-72 SI_PlugPullModule structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 83 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86

Table 9-73 SI_AccessError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 85 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86
IO_Addr UINT For OB_Class = 85
IO_LEN UINT For OB_Class = 85

Table 9-74 SI_StationFailure structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 86 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LADDR HW_IO For OB_Class = 40, 51, 55, 56, 57, 70, 82, 83, 85, 86, 91, 92
Event_Class BYTE For OB_Class = 70, 83, 85, 86
Fault_ID BYTE For OB_Class = 70, 80, 83, 85, 86
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Table 9-75 SI_Servo structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 91 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
PIP_Input BOOL For OB_Class = 61, 91, 92
PIP_Output BOOL For OB_Class = 61, 91, 92
IO_System USINT For OB_Class = 61, 91, 92
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92
Synchronous BOOL  

Table 9-76 SI_Ipo structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 92 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
Initial_Call BOOL For OB_Class = 1, 30, 52, 61, 65
PIP_Input BOOL For OB_Class = 61, 91, 92
PIP_Output BOOL For OB_Class = 61, 91, 92
IO_System USINT For OB_Class = 61, 91, 92
Event_Count INT For OB_Class = 30, 51, 52, 61, 65, 91, 92
Reduction UINT For OB_Class = 92

Table 9-77 SI_Startup structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT := 100 OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
LostRetentive BOOL For OB_Class = 100
LostRTC BOOL For OB_Class = 100

Table 9-78 SI_ProgIOAcessError structure

Structure element Data type Description
SI_Format USINT ● 16#FF = No information

● 16#FE = Optimized start information
OB_Class USINT OB class for "No information" or "Optimized start information"
OB_Nr UINT OB number (1 ... 32767)
BlockNr UINT For OB_Class = 121, 122
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Structure element Data type Description
Reaction USINT For OB_Class = 121, 122
Fault_ID BYTE For OB_Class = 121, 122
BlockType USINT For OB_Class = 121, 122
Area USINT For OB_Class = 121, 122
DBNr DB_ANY For OB_Class = 121, 122
Csg_OBNr OB_ANY For OB_Class = 121, 122
Csg_Prio USINT For OB_Class = 121, 122
Width USINT For OB_Class = 121, 122

 

 Note

The structure elements specified for the SI_classic structure are identical in content to the 
temporary tags of any OB created with the block property "Default".

Please note, however, that temporary tags of the individual OBs can have different names 
and different data types. Also note that the call interface of each OB includes additional 
information regarding the date and the time of the OB request.

 

Bits 4 to 7 of the EV_CLASS structure element contain the event class. The following values 
are possible here:

● 1: Start events from standard OBs

● 2: Start events from synchronous error OBs

● 3: Start events from asynchronous error OBs

The PRIORITY structure element supplies the priority class belonging to the current OB.

Apart from these two elements, NUM  is also relevant. NUM  contains the number of the current 
OB or the startup OB that was started last.

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code* 
(W#16#...)

Explanation

8080 Start information of the current OB does not correspond to the specified user-defined data type
8081 Start information of the current OB does not correspond to the specified system data type
8082 Start information of the last startup OB started does not correspond to the specified user-defined data type
8083 Start information of the last startup OB started does not correspond to the specified system data type

Example
OB 80 is the OB that was called last and that has not yet been completely processed and OB 
100 is the start-up OB that was started last.

The following table shows the assignment between the structure elements of the TOP_SI 
parameter of the "RD_SINFO" instruction and the associated local tags of OB 80.
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TOP_SI
structure element

Data type OB 80 - Associated local tag Data type

EV_CLASS BYTE OB80_EV_CLASS BYTE
EV_NUM BYTE OB80_FLT_ID BYTE
PRIORITY BYTE OB80_PRIORITY BYTE
NUM BYTE OB80_OB_NUMBR BYTE
TYP2_3 BYTE OB80_RESERVED_1 BYTE
TYP1 BYTE OB80_RESERVED_2 BYTE
ZI1 WORD OB80_ERROR_INFO WORD
ZI2_3 DWORD OB80_ERR_EV_CLASS BYTE

OB80_ERR_EV_NUM BYTE
OB80_OB_PRIORITY BYTE
OB80_OB_NUM BYTE

The following table shows the assignment between the structure elements of the 
START_UP_SI  parameter of the "RD_SINFO" instruction and the associated local tags of 
OB 100.

START_UP_SI
structure element

Data type OB 100 - Local tag Data type

EV_CLASS BYTE OB100_EV_CLASS BYTE
EV_NUM BYTE OB100_STRTUP BYTE
PRIORITY BYTE OB100_PRIORITY BYTE
NUM BYTE OB100_OB_NUMBR BYTE
TYP2_3 BYTE OB100_RESERVED_1 BYTE
TYP1 BYTE OB100_RESERVED_2 BYTE
ZI1 WORD OB100_STOP WORD
ZI2_3 DWORD OB100_STRT_INFO DWORD

See also
Evaluating errors with output parameter RET_VAL (Page 1854)

RT_INFO: Read out runtime statistics

Description
Use the instruction "RT_INFO" to generate statistics on the runtime of specific organization 
blocks, communication or the user program.

Use the MODE parameter to select which information is going to be output:
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● MODE 1 to 3 return the data on the runtime of a specific organization block whose number 
was specified at the OB parameter.

● MODE 10 and 11 return the proportions of runtime used for communication and the user 
program.

● MODE 30 to 32 return data on configured settings of the user program.

All measurements are started once again when the CPU transitions from startup to RUN. 

Parameters
The following table shows the parameters of the instruction "RT_INFO":

Parameter Declaration Data type Memory area Description
MODE Input UINT I, Q, M, D, L or 

constant
Use the MODE parameter to select the 
information you want to read out (see table 
"MODE parameter").

OB Input OB_ANY I, Q, M, D, L or 
constant

Use the OB parameter to select the OB for 
which you want to read out information.

RET_VAL Return INT I, Q, M, D, L Error information (see " RET_VAL 
parameter").

INFO InOut VARIANT I, Q, M, D, L Pointer to the area to which the read data is 
to be written. The data type required for 
INFO depends on the MODE parameter 
(see table "MODE parameter").

You can find additional information on valid data types in "Overview of the valid data types 
(Page 1320)".

MODE parameter
The following table shows which information is returned for the values at the MODE parameter.

MODE 
(decimal
)

Description Note Value at 
OB 
parameter

Data type 
of INFO

Available 
as of CPU 
version

1 Runtime of a specific OB The runtime information always refers to 
the specified OB. Processes, such as 
interruptions by OBs of a higher priority or 
communication, are not included.
You can use the instruction "RUNTIME" to 
measure the runtime of the entire program.

OB 
number

LTIME S7-1500 
V1.5

2 Maximum runtime of a 
specific OB

OB 
number

LTIME S7-1500 
V1.5

3 Minimum runtime of a 
specific OB

OB 
number

LTIME S7-1500 
V1.5
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MODE 
(decimal
)

Description Note Value at 
OB 
parameter

Data type 
of INFO

Available 
as of CPU 
version

10 Percentage of total runtime 
used by higher-priority OBs
The runtime of all OBs used 
in the user program with a 
higher priority than cyclical 
program OBs is output 
(ProgramCycle). These 
usually include all OB types 
except startup OBs.
The CPU determines which 
OBs can be used and their 
priority. This information is 
included in the basic 
chapters on programming.

The percentages of MODE 10, 11 and 12 
always add up to 100 (=total runtime).
 
 
 

Not 
relevant

UINT S7-1500 
V1.5

11 Percentage of total runtime 
used by communication
The percentage of 
communication processes 
in the total runtime of the 
user program is output.

Not 
relevant

UINT S7-1500 
V1.5

30 Output of the warning limit 
from which a time error OB 
is called.
The warning limit is the 
maximum permitted number 
of requested but not yet 
completely processed 
requirements of an OB. 

 Not 
relevant

LTIME S7-1500 
V1.5

31 Output of the configured 
minimum cycle time for the 
user program

 Not 
relevant

UINT S7-1500 
V1.5

32 Output of the configured 
maximum communication 
load

 Not 
relevant

UINT S7-1500 
V1.5

RET_VAL parameter
The following table shows the meaning of the values of the RET_VAL parameter:

Error code* 
(W#16#...)

Explanation

0 No error
8080 Selection for MODE parameter is not supported.
8081 Organization block selected at OB parameter does not exist in the user program.
80C3 Insufficient resources. Try to call the instruction again at a later time.
8452 Data type at INFO parameter is incorrect. Check whether the correct data type was selected depending on the 

MODE parameter.
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See also
Evaluating errors with output parameter RET_VAL (Page 1854)

LED: Read LED status

Description       
You can use the "LED" instruction to read out the status (e.g., "On" or "Off") of a particular 
module LED.

● With the LADDR parameter, you address the CPU or the interface.

● With the LED parameter, you select the module LED whose current status is to be read out 
using the instruction.

● The RET_VAL parameter outputs the status of the selected LED when the instruction is 
called. Depending on the LED selected, only certain status information may be displayed. 
For example, some LEDs have only color information. Refer to the hardware documentation 
of the respective module for the available status information of a particular LED.

Parameters
The following table shows the parameters of the "LED" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, L or constant Identification number of the CPU or interface. 

The number is automatically assigned and 
stored in the CPU properties or the interface 
in the hardware configuration.

LED Input UINT I, Q, M, D, L or 
constant

Identification number of the LED:
● 1: STOP/RUN
● 2: ERROR
● 3: MAINT (maintenance)
● 4: Redundant
● 5: Link (green)
● 6: Rx/Tx (yellow)

RET_VAL Return INT I, Q, M, D, L Status of LED

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL

RET_VAL Description
0 to 9 LED status:

● 0 = LED does not exist
● 1 = Permanently switched off
● 2 = Color 1 (e.g., for LED STOP/RUN: green) permanently ON
● 3 = Color 2 (e.g., for LED STOP/RUN: orange) permanently ON
● 4 = Color 1 flashing at 2 Hz
● 5 = Color 2 flashing at 2 Hz
● 6 = Colors 1 and 2 flashing alternately at 2 Hz
● 7 = LED is active, color 1
● 8 = LED is active, color 2
● 9 = LED exists, but status information not available

8091 Module addressed with the LADDR parameter does not exist.
8092 A module that does not support LEDs was addressed with the LADDR parameter.
8093 The identification number specified in the LED parameter is not defined.
80Bx The CPU specified in the LADDR parameter does not support the "LED" instruction.

Get_IM_Data: Reading identification and maintenance data

Description
The "Get_IM_Data" instruction reads the identification and maintenance data (I&M) data from 
a device. Use the LADDR parameter to select the device from which you want to read the I&M 
via the hardware identifier.

You select the data to be read via the instruction using the IM_TYPE parameter:

● IM_TYPE = 0: I&M 0 data
The I&M 0 data are the device-specific basic information of a device and contain information 
such as the manufacturer ID, order number, serial number and the hardware and firmware 
version. Only read access is possible to the I&M 0 data. The information is also displayed 
in the TIA Portal with the "Online & Diagnostics" view of a device. 

● IM_TYPE = 11: I&M 1 data from the parameter assignment data of the CPU 
The I&M 1 data contains a functional description of the device and the location ID, i.e. the 
information about how the device is designated within the plant.

● IM_TYPE = 12: I&M 2 data from the parameter assignment data of the CPU
The I&M 2 data includes the date of installation, i.e. the information about when the device 
was installed in the plant.

● IM_TYPE = 13: I&M 3 data from the parameter assignment data of the CPU 
The I&M 3 data contains additional information about the installed device. The additional 
information is free text and can be assigned as desired.

The I&M data read is written to the addressed area defined at the DATA parameter. 

The execution status of the read job is displayed via the BUSY, DONE, ERROR output 
parameters and the two middle bytes of the STATUS output parameter. 
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Definition: Identification and maintenance data (I&M)
Identification and maintenance (I&M) data refers to information stored in a module, which 
assists you in checking the plant configuration, locating hardware changes in a plant and 
eliminating errors.

● Identification data (I data) are static information about a device that can only be read.

● Maintenance data (M-data) refers to plant-dependent information, such as the installation 
location or date. Maintenance data are created during configuration and written to the 
module.

Parameters
The following table shows the parameters of the "Get_IM_Data" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, D, L or 

constant
Hardware ID of the device The number is 
assigned automatically and is stored in the 
properties of the device or in the hardware 
configuration.

IM_TYPE Input UINT I, Q, M, D, L or 
constant

Identification and maintenance data number
Possible values:
● 0:  I&M 0 data
● 11: I&M 1 data from the parameter 

assignment data of the CPU
● 12: I&M 2 data from the parameter 

assignment data of the CPU
● 13: I&M 3 data from the parameter 

assignment data of the CPU
DATA InOut VARIANT I, Q, M, D, L Area for storing the read identification and 

maintenance data (see DATA parameter).
DONE Output BOOL I, Q, M, D, L The instruction was executed successfully. The 

I&M data were transferred to the DATA 
parameter.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: Execution of the instruction complete or 

not yet started.
● 1: Execution of the instruction not yet 

complete.
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error.
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter 
The parameter is only set for the duration of one 
call. To display it, you should therefore copy 
STATUS to a free data area.
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You can find more information on the data types in "Overview of the valid data types 
(Page 1320)".

DATA parameter
You can use a string (STRING), an array (ARRAY of CHAR/BYTE) or a data structure 
(STRUCT) to store the I&M data:

● If you address a string (STRING data type) at the the DATA parameter, the length of the 
string automatically adjusts the length of the read I&M data (up to 254 characters).

● If you address a data structure (ARRAY of CHAR/BYTE or STRUCT) a the DATA 
parameter, the I&M data read are written to the individual components of the data type 
used. If the addressed data structure is longer than the read data, the remaining 
components are filled with zeros.

● If you crate a data structure with a STRUCT data type at the DATA parameter, use a data 
block without optimized block access (see category "Attributes" of the block properties).

If a data type other than STRING, ARRAY of BYTE/CHAR or STRUCT is used at the DATA 
parameter, the STATUS parameter generates error code 8093. There is an exception for I&M 
0 data (IM_TYPE parameter = 0). For I&M 0 data, the following "IuM0_data" structure can also 
be used at the DATA parameter:

Parameter Data type Bytes Description
Manufacturer_ID UINT 2 Manufacturer ID (e.g. "42" for SIEMENS)
Order_ID CHAR[20] 20 Order number
Serial_Number CHAR[16] 16 Serial number
Hardware_Revision UNIT 2 Hardware revision
Software_Revision STRUCT 4 Firmware revision
 Type CHAR 1 -

Functional UNIT8 1 -
Bugfix UNIT8 1 -
Internal UINT8 1 -

Revision_Counter UINT 2 Revision counter
Profile_ID UNIT 2 Profile
Profile_Specific_Type UNIT 2 Device class
IM_Version UNIT 2 I&M version
I&M_Supported UNIT 2 I&M data (I&M 0-I&M 4) supported at the device 

end

STATUS parameter

Error code* 
(W#16#...)

Description

0 No error
7000 No job in progress.
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Error code* 
(W#16#...)

Description

7001 First call of the asynchronous instruction "Get_IM_Data". Execution of the instruction not yet complete (BUSY 
= 1, DONE = 0).

7002 Additional call of the asynchronous instruction "Get_IM_Data". Execution of the instruction not yet complete 
(BUSY = 1, DONE = 0).

807F Maximum of 10 parallel executions of the instances exceeded:
● Avoid more than 10 parallel calls of the instruction. 
● Repeat the call at a later time, as this is a temporary error.

8091 The device addressed at the LADDR parameter does not exist.
8092 LADDR addresses a device that does not support the output of the I&M data.
8093 Data type at the DATA parameter is not supported.
80B1 The "Get_IM_Data" instruction is not supported by the CPU used.
80B2 Invalid value at the IM_TYPE parameter or the selected IM_TYPE is not supported by the CPU or the 

addressed device.
8752 The memory area specified at the  DATA parameter is too small to store all the I&M data. The read I&M data 

are stored only up to the maximum length of the specified memory area.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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GET_NAME: Reading the name of a module

Description
The instruction "GET_NAME" reads the name of an IO device. The name is displayed in the 
network view and in the properties of the IO device:

You select the IO device by using the hardware identifier of the PROFINET IO system (at the 
LADDR parameter) and the device number of the IO device (STATION_NR parameter).

Once the instruction has been executed, the name of the IO device is written to the area 
addressed with the DATA parameter.

The name that is read depends on the type of IO device:

● For a DP slave or IO device, the name of the head module is output.

● For an I-slave or I-device, the name of the interface module is output.

● The station name is output for an HMI panel.

● The name of the interface module is output for a PC station.

● The name of the Device Access Point (DAP) is displayed (name of the interface or head 
module) for GSD devices.

The length of the name is output at the LEN parameter. If the name is longer than the area 
specified at the DATA parameter, only that section which corresponds to the maximum length 
of the addressed area will be written.
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The maximum length for a name is 128 characters.
 

 Note
Name of the CPU readout (Version 1.1)

If you assign a "0" at each of the parameters LADDR and STATION_NR the instruction will 
output the name of the CPU.

 

Parameters
The following table shows the parameters of the "GET_NAME" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IOSYSTEM I, Q, M, D, L or 

constant
Hardware identifier of the PROFINET IO 
system. The number can be taken from the 
system constants or the properties of the IO 
system.

STATION_NR Input UINT I, Q, M, D, L or 
constant

Device number of the IO device. The device 
number can be applied in the Network view 
from the properties of the IO device under 
"Ethernet addresses".

DATA InOut VARIANT I, Q, M, D, L Pointer to the area to which the name of the 
module is written.

DONE Output BOOL I, Q, M, D, L The instruction was executed successfully. 
Name of the module transferred to the area at 
the DATA parameter.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: Execution of the instruction complete.
● 1: Execution of the instruction not yet 

complete.
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error.
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

LEN Output DINT I, Q, M, D, L Length of the name of the IO device (number 
of characters).

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy STATUS to a free data area. 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error
7000 No job in progress.
7001 First call of the asynchronous instruction "GET_NAME". Execution of the instruction not yet complete (BUSY 

= 1, DONE = 0).
7002 Additional call of the asynchronous instruction "GET_NAME". Execution of the instruction not yet complete 

(BUSY = 1, DONE = 0).
8090 The LADDR input parameter contains an invalid value. Possible causes:

● The specified number is not a hardware identifier of a PROFINET IO system. 
● You have not specified a number at the LADDR parameter.

8092 The value at the LADDR parameter does not address a PROFINET IO system.
8093 Instruction does not support data type at the DATA parameter.
8095 Device number (STATION_NR parameter) does not exist in the selected PROFINET IO system.
80B1 The CPU used does not support the instruction.
80C3 Temporary resource error: The CPU is currently processing the maximum possible number of simultaneous 

block calls. "GET_NAME" cannot be executed unless at least one of the block calls is finished.
8852 The area specified at the DATA parameter is too short for the full name of the IO device. The name will be 

written up to the maximum possible length.
To read the full name, use a longer data area at the DATA parameter. The area must have at least as many 
characters as there are at the LEN parameter.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
The following example shows how you can read out the station name of a HMI panel.

Configuration of the HMI panel:

● The HMI panel with the station name "HMI_IO-Device" is created in the network view and 
assigned to the same PROFINET IO system as the CPU.

● The operating mode "IO device" was activated in the properties of the hardware 
configuration for the HMI panel and the CPU was assigned as the IO controller.

● The device number "20" assigned in the properties under "Ethernet addresses".
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Assigning parameters to the instruction "GET_NAME":

● The hardware ID (258) of the IO system was specified at the parameter LADDR.

● The device number (20) of the HMI panel was specified at the parameter STATION_NR.

● A tag was connected with the data type STRING of a data block at the parameter DATA.

● PLC tags (memory area, flags) were defined for the output parameters of the instruction.

Execution of the instruction:

● After execution of the instruction, the name of the station of the HMI panels (HMI_IO-Device) 
is written into the data block at the parameter DATA.

● The number of characters of the name is output (13) at the parameter LEN.

GetStationInfo: Read information of an IO device

Description
You can use the "GetStationInfo" instruction to read information of a PROFINET IO device. 
The instruction also enables you to read the information of an IO device located in a lower-
level IO system (connected via CP/CM). 
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The IO device is addressed via the hardware identifier of the station at the LADDR parameter. 
The hardware identifier is displayed in the "Devices & Networks" view in the station properties.

Use the MODE parameter to select the information to be read. The instruction supports reading 
the IP address parameters according IPv4 in TIA V12 SP1 (MODE = 1).

At the DATA parameter, specify the data area to which you want to write the read address 
data. Use the "IF_CONF_v4" structure to store the IP address.

Enable reading of the address data using the REQ control parameter. This requires the IO 
device to be accessible.

The execution status of the read job is displayed via the BUSY, DONE, ERROR output 
parameters and the STATUS output parameter. 

 

 Note
Address the IO device using only the hardware identifier of the station

The station, the IO device and PROFINET interface have their own hardware identifier. Use 
only the hardware identifier of the station for the "GetStationInfo" instruction.

If a PROFINET is addressed via the LADDR parameter, for example, the address data is not 
read and the error code 8092 is generate.

To read the address data of an integrated PROFINET interface or a CM/CP in the central 
configuration, use the "RDREC" instruction.

 

Parameters
The following table shows the parameters of the "GetStationInfo" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Control parameter Request

Activates the reading of the information 
with REQ = "1".

LADDR Input HW_DEVICE I, Q, M, D, L or 
constant

Hardware identifier of the station of the 
IO device
The number can be taken from the 
properties of the station in the Network 
view or from the "System constants" 
tab of the standard tag table.

DETAIL Input HW_SUBMO
DULE

I, Q, M, D, L or 
constant

The DETAIL parameter is not used. 
Leave the parameter unconnected.

MODE Input UNIT I, Q, M, D, L or 
constant

Selection of address data to be read
Connect the MODE parameter with "1" 
(read address parameter according to 
IPv4).

DATA InOut VARIANT D, L Pointer to the area to which the 
address data of the IO device is written. 
Use the "IF_CONF_v4" structure for 
MODE = 1.
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L The instruction was executed 

successfully. The address data was 
transferred to the DATA parameter.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: Execution of the instruction 

complete.
● 1: Execution of the instruction not 

yet complete.
ERROR Output BOOL I, Q, M, D, L Status parameter

● 0: No error.
● 1: An error occurred during 

execution of the instruction.
Detailed information is output via the 
STATUS parameter.

STATUS Output WORD I, Q, M, D, L Status parameter 
The parameter is only set for the 
duration of one call. To display the 
status, you should therefore copy 
STATUS to a free data area.

You can find more information on the data types in "Overview of the valid data types 
(Page 1320)".

Parameter DATA 
Use the "IF_CONF_v4" structure at the DATA parameter to store the address parameter 
according to IPv4.

Byte Parameter Data type Start value Description
0 … 1 Id UINT 30 ID of the "IF_CONF_v4" structure.
2 … 3 Length UNIT 18 Length of data read in BYTE.
4 ... 5 Mode UNIT 0 Not relevant for the "GetStationInfo" 

instruction (left at "0").
6 ... 9 InterfaceAddress ARRAY 

[1..4] of 
BYTE

- IP address of the IO device in the format 
IP_V4, e.g. for 192.168.3.10:
● addr[1] = 192 
● addr[2] = 168 
● addr[3] = 3 
● addr[4] = 10 
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Byte Parameter Data type Start value Description
10 … 
13

SubnetMask ARRAY 
[1..4] of 
BYTE

- Subnet mask of the IO device in the format 
IP_V4, e.g. for 255.255.255.0: 
● addr[1] = 255
● addr[2] = 255
● addr[3] = 255
● addr[4] = 0

14 ... 
17

DefaultRouter ARRAY 
[1..4] of 
BYTE

- IP address of the router in the format IP_V4, 
e.g. for 192.168.3.1:
● addr[1] = 192 
● addr[2] = 168 
● addr[3] = 3 
● addr[4] = 1 

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error
7000 No job in progress.
7001 First call of the asynchronous instruction "GetStationInfo". Execution of the instruction 

not yet complete (BUSY = 1, DONE = 0).
7002 Additional call of the asynchronous instruction "GetStationInfo". Execution of the 

instruction not yet complete (BUSY = 1, DONE = 0).
8080 Value at the MODE parameter is not supported.
8090 The hardware identifier specified at the LADDR parameter is not configured.
8092 The LADDR parameter does not address a PROFINET IO device.
8093 Invalid data type at the DATA parameter.
80A0 Cannot read requested information.
80C0 Addressed IO device is not reachable.
80C3 The maximum number of simultaneous calls of the "GetStationInfo" instruction (10 

instances) has been reached.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For 
additional information on toggling display formats, refer to "See also".

DeviceStates: Read module status information in an IO system

Description
You use the instruction "DeviceStates" to query specific status information for all modules in 
an IO system, which means:

● Either for all IO devices in a PROFINET IO system

● Or for all DP slaves in a DP master system
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The Boolean value that is output indicates the modules to which the selected status applies. 
You can, for example, read which IO devices are currently disabled in a PROFINET IO system.

Information is also displayed as to whether the status information to be read applies to at least 
one of the IO devices or DP slaves.

The instruction can be called in a cyclic OB as well as in an interrupt OB (e.g. OB82 - diagnostic 
interrupt).

Parameters
The following table shows the parameters of the "DeviceStates" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IOSYSTEM I, Q, M, L or constant Hardware identifier of the PROFINET IO 

or DP master system (see description 
below)

MODE Input UINT I, Q, M, D, L or constant Selection of status information to be read 
(see description below)

RET_VAL Return INT I, Q, M, D, L Status of instruction (see description 
below)

STATE InOut VARIANT I, Q, M, D, L Buffer for status of the IO devices or the 
DP slaves (see description below)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter LADDR
You select the PROFINET IO or DP master system at the LADDR parameter by means of the 
hardware identifier.

The hardware identifier is available:

● Either in the Network view of the properties of the PROFINET IO or DP master system.

● Or in the PLC tag table in the listed system constants with the data type HW_IOSYSTEM.

Parameter MODE
You use the MODE parameter to read out status information. You can read out one of the 
following status information items for the entire PROFINET IO or DP master system:

● 1: IO devices/DP slaves are configured

● 2: IO devices/DP slaves are faulty

● 3: IO devices/DP slaves are disabled
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● 4: IO devices/DP slaves exist

● 5: IO devices/DP slaves for which a problem has occurred. For example:

– Maintenance demanded or recommended

– Not accessible

– Not available

– Error occurred

Parameter STATE
With the STATE parameter, the status of the IO devices/DP slaves that was selected with the 
MODE parameter is output. 

If the status selected using MODE applies to an IO device/DP slave, the following bits are set 
to "1" at the STATE parameter:

● Bit 0 = 1: Group display. The bit n of at least one IO device/DP slave was set to "1".

● Bit n = 1: The status selected with MODE applies to the IO device/DP slave. 

– With a PROFINET IO system, bit n corresponds to the device number of the respective 
IO device (see properties of the PROFINET interface in the device view and network 
view)

– With a PROFIBUS DP system, bit n corresponds to the PROFIBUS address of the DP 
slave (see properties of the DP slave in the device view and network view)

Use "BOOL" or "Array of BOOL" as data type:

● To only output the bit for group display of the status information, you can use the data type 
BOOL at the STATE parameter.

● To output the status information for all IO devices/DP slaves, use Array of BOOL with the 
following length:

– With PROFINET IO system: 1024 bits

– With DP master system: 128 bits

Parameter RET_VAL

Error code*
(W#16#...)

Description

0 No error
8091 Hardware identifier of the LADDR parameter does not exist. Check (for example, in the system constants) 

whether the value for LADDR exists in the project.
8092 LADDR does not address a PROFINET IO or DP master system.
8093 Invalid data type at the STATE parameter.
80B1 Instruction "DeviceStates" is not supported by the CPU.
80B2 The selected MODE parameter is not supported by the used CPU for the IO system specified in the LADDR 

parameter.
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Error code*
(W#16#...)

Description

8452 The complete status information does not fit in the tag configured in the STATE parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example - Reading the faulty stations of a PROFINET IO master system
A PROFINET IO system consists of 4 IO devices with the device numbers 1, 2, 3 and 4. The 
IO device with number 2 is faulty.

The instruction "DeviceStates" is executed for the PROFINET IO system with MODE = 2 (faulty/
not faulty). 

The following bits are set in the STATE parameter:

● Bit 0 = 1: A fault exists for at least one of the IO devices.

● Bit 1 = 0: IO device with device number 1 is not faulty.

● Bit 2 = 1: IO device with device number 2 is faulty.

● Bit 3 = 0: IO device with device number 3 is not faulty.

● Bit 4 = 0: IO device with device number 4 is not faulty.

● Bit 5 = 0: irrelevant

● Bit 6 = 0: irrelevant

● ...

Example - Reading the faulty stations of a PROFIBUS DP master system
A DP master system consists of 4 DP slaves with the PROFIBUS addresses 3, 4, 5 and 6. 
The DP slave with address 4 is faulty.

The instruction "DeviceStates" is executed for the DP master system with MODE = 2 (faulty/
not faulty). 

The following bits are set in the STATE parameter:

● Bit 0 = 1: A fault exists for at least one of the DP slaves.

● Bit 1 = 0: irrelevant

● Bit 2 = 0: irrelevant

● Bit 3 = 0: DP slave with address 3 is not faulty.

● Bit 4 = 1: DP slave with address 4 is faulty.

● Bit 5 = 0: DP slave with address 5 is not faulty.

● Bit 6 = 0: DP slave with address 6 is not faulty.

● Bit 7 = 0: irrelevant

● Bit 8 = 0: irrelevant

● ...
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ModuleStates: Read module status information of a module

Description
You can use the "ModuleStates" instruction to read the status information of the modules of a 
PROFINET IO device or PROFIBUS DP slave. 

The Boolean value that is output indicates the modules to which the selected status applies. 
You can, for example, read which modules are currently disabled in a PROFINET IO device.

Information is also displayed as to whether the status information to be read applies to at least 
one of the modules.

The instruction can be called in a cyclic OB as well as in an interrupt OB (e.g. OB82 - diagnostic 
interrupt).

Parameters
The following table shows the parameters of the "ModuleStates" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_DEVICE I, Q, M, D, L or 

constant
Hardware identifier of the station (see 
description below)

MODE Input UINT I, Q, M, D, L or 
constant

Selection of module status information to be 
read (see description below)

RET_VAL Return INT I, Q, M, D, L Status of instruction (see description below)
STATE InOut VARIANT I, Q, M, D, L Buffer for the module status (see description 

below)

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter LADDR
You select the IO device or the DP slave at the LADDR parameter by means of the hardware 
identifier of the station.

The hardware identifier is available:

● Either in the network view of the properties of the IO device station or DP slave station.

● Or in the PLC tag table for the listed system constants with the data type HW_DEVICE (for 
an IO device) or with the data type HW_DPSLAVE (for a DP slave).

Parameter MODE
You use the MODE parameter to read out status information. One of the following status 
information items can be read for the modules:

● 1: Modules are configured

● 2: Modules are faulty

● 3: Modules are disabled
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● 4: Modules exist

● 5: There is a problem in the modules. For example:

– Maintenance demanded or recommended

– Not accessible

– Not available

– Error occurred

Parameter STATE
The STATE parameter outputs the status of the modules selected with the MODE parameter. 

If the status selected using MODE applies to a module, the following bits are set to "1":

● Bit 0 = 1: Group display. The bit n of at least one module was set to "1".

● Bit n = 1: The status selected with MODE applies to the module in slot n-1 (example: bit 3 
= slot 2). 

Use "BOOL" or "Array of BOOL" as data type:

● To only output the bit for group display of the status information, you can use the data type 
BOOL at the STATE parameter.

● To output the status information for all modules, use Array of BOOL with a length of 128 
bits.

Parameter RET_VAL

Error code*
(W#16#...)

Description

0 No error
8091 Hardware identifier of the LADDR parameter does not exist. Check (for example, in the system constants) 

whether the value for LADDR exists in the project.
8092 LADDR does not address an IO device or DP slave.
8093 Invalid data type at the STATE parameter.
80B1 The instruction "ModuleStates" is not supported by the CPU.
80B2 The selected MODE parameter is not supported by the used CPU for the IO device/the DP slave in the 

LADDR parameter.
8452 The complete status information does not fit in the tag configured in the STATE parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
An IO device includes 4 modules in slots 1 to 4. The module in slot 2 is faulty. 

The instruction "ModuleStates" is executed for the IO device with MODE = 2 (faulty/not faulty). 

The following bits are set in the STATE parameter:
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● Bit 0 = 1: A fault exists for at least one module.

● Bit 1 = 0: Slot number 0 (used by IO device)

● Bit 2 = 0: Module in slot number 1 is not faulty.

● Bit 3 = 1: Module in slot number 2 is faulty.

● Bit 4 = 0: Module in slot number 3 is not faulty.

● Bit 5 = 0: Module in slot number 4 is not faulty.

● Bit 6 = 0: irrelevant

● Bit 7 = 0: irrelevant

GEN_DIAG: Generate diagnostics information

Description
The "GEN_DIAG" instruction generates diagnostics information for hardware components from 
other manufacturers for use in TIA Portal diagnostics. The GSD(GSDL/GSDML) file supplied 
by the manufacturer must first be installed before the instruction can be used.

The instruction generates all diagnostic events (including those for maintenance).

● Use the LADDR parameter to select the hardware component for which you want to 
generate a diagnostic event.

● Use the MODE parameter to specify whether the event is to be outgoing or incoming.

● Use the DiagEvent parameter to define the diagnostic event in the DiagnosticDetail 
structure. The structure is created automatically in the local interface of the block when you 
define a tag at the DiagEvent parameter.

The diagnostics information is provided synchronously. Diagnostics information transfer and 
alarm output are asynchronous.

 
 

 NOTICE

Failsafe-specific errors messages are not valid

If you define failsafe-specific diagnostics information at the DiagEvent parameter, the 
instruction will check this information and output the error code 80A1.
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Parameters
The following table shows the parameters of the "GEN_DIAG" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_ANY I, Q, M, D, L or 

constant
Identification number of the hardware 
component

MODE Input UINT I, Q, M, D, L or 
constant

Selection of incoming/outgoing information:
● 1: The diagnostic event specified is an 

incoming event
● 2: The diagnostic event specified is an 

outgoing event
● 3: All diagnostic events are outgoing. 

There are therefore no hardware 
component faults (green diagnostics 
symbol). The DiagEvent parameter is not 
evaluated when MODE = 3.

DiagEvent InOut DiagnosticDetail L Specifies the diagnostic event (see 
"DiagEvent parameter"). 

RET_VAL Return INT I, Q, M, D, L Status of instruction / error message (see 
"RET_VAL parameter")

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

DiagEvent parameter
The structure DiagnosticDetail is a system data type for specifying the diagnostic event. Its 
structure is as follows:

Parameter Data type Description
DiagnosticDet
ail

Struct  

 ChannelI
nfo

WORD Channel properties (0...7)

ALID UINT Local ID of the alarm. The ID uniquely identifies the alarm.
TextID UINT ID of an alarm text in a text list.
Channel
Number

UINT Manufacturer-specific channel number (0x0000 — 0x7FFF)

Addval_0 DWORD Placeholder for additional information The value / list of values depends on the connection 
error.

TextID2 UINT Texts for CPU response (mode, OB calls, etc.).
LADDR HW_ANY Identical to the LADDR parameter.
TextListI
d

UINT ● 0: No text list
● ≠0: ID of the text list
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Parameter Data type Description
Channel
Direction

UINT ● 0000: irrelevant
● FFF1: Input
● FFF2: Output
● FFF3: Input/Output

Addval_1 DWORD Placeholder for additional information on the channel error (depends on the GSD file).
For channel error types, see also: IEC 61158 (PROFINET IO Type 10 and PROFIBUS 
DP Type 3).

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error
8080 Value in the MODE parameter is not supported.
8090 Identification for hardware component not available at the LADDR parameter.
8091 Diagnostics information cannot be generated for the hardware component addressed at the LADDR 

parameter.
80A1 ● Content of the DiagnosticsDetail structure at the DiagEvent parameter is invalid or inconsistent.

● Failsafe-specific diagnostics information defined at the DiagEvent parameter (not valid).
80A4 Hardware component addressed cannot be accessed.
80C1 Insufficient resources for parallel execution.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

GET_DIAG: Read diagnostic information

Description
You can use the "GET_DIAG" instruction to read out the diagnostic information of a hardware 
object. The hardware object is selected using the parameter LADDR. With the MODE 
parameter, you select which diagnostic information is to be read out.

Parameters
The following table shows the parameters of the "GET_DIAG" instruction:

Parameter Declaration Data type Memory area Description
MODE Input UINT I, Q, M, D, L or constant Use the MODE parameter to select which 

diagnostic data is to be output.
LADDR Input HW_ANY 

(WORD)
I, Q, M, L or constant Hardware identifier of the device.

RET_VAL Return INT I, Q, M, D, L Status of the instruction
CNT_DIAG Output UINT I, Q, M, D, L Number of output diagnostic details
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Parameter Declaration Data type Memory area Description
DIAG InOut VARIANT I, Q, M, D, L Diagnostic information corresponds to the 

selected mode, see table below
DETAIL InOut VARIANT I, Q, M, D, L Diagnostics details correspond with the 

selected mode.
Parameter is hidden (only used for  
MODE = 3).

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

MODE parameter
Depending on the value at the MODE parameter, different diagnostic data is output at the 
DIAG, CNT_DIAG and DETAIL output parameters.

MODE Description DIAG CNT_DIAG DETAIL
0 Output of all supported 

diagnostic information for a 
module as DWORD, where Bit 
X=1 indicates that mode X is 
supported.

Bit string of the supported 
modes as DWORD, where 
Bit X=1 indicates that mode 
X is supported.

0 -

1 Output of the inherent status of 
the addressed hardware 
object.

Diagnostics status.
Output of the inherent status 
of the addressed hardware 
object in accordance with 
the DIS structure.

0 -

2 Output of the status of all 
subordinate modules of the 
addressed hardware object. 

Diagnostics status. Output 
in accordance with the DNN 
structure.

0 -

3 * Output of the inherent status of 
the addressed hardware 
object and detailed 
information on channel 
diagnostics.

Output of the inherent status 
of the addressed hardware 
object in accordance with 
the DIS structure.

Number of module 
status information.

Module status 
information in 
accordance with the 
DiagnosticDetail 
structure.

* Not supported by CPU S7-1200.

DIS structure
With parameter MODE = 1 or = 3, the diagnostic information is output in accordance with the 
DIS structure. In this case, enter the system data type "DIS" as data type for the tag declaration.

The following table shows the meaning of the individual parameter values.

Parameter Data type Value Description
MaintenanceState DWORD Enum  

0 No maintenance required
1 The module or device is disabled.
2 -
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Parameter Data type Value Description
3 -
4 -
5 Maintenance required
6 Maintenance demanded
7 Error
8 Status unknown / error in subordinate module
9 -
10 Inputs/outputs are not available.

ComponentStateD
etail

DWORD Bit array Status of the module sub-modules:
● Bit 0 to 15: Status message of the module
● Bit 16 to 31: Status message of the CPU

0 to 2 
(enum)

Additional information:
● Bit 0: No additional information
● Bit 1: Transfer not permitted

3 Bit 3 = 1: At least one channel supports qualifiers for diagnostics
4 Bit 4 = 1: Maintenance required for at least one channel or one 

component.
5 Bit 5 = 1: Maintenance demanded for at least one channel or one 

component.
6 Bit 6 = 1: Error in at least one channel or one component.
7 to 10 Reserved (always = 0)
11 to 14 ● Bit 11 = 1: PNIO - sub-module correct

● Bit 12 = 1: PNIO - replacement module
● Bit 13 = 1: PNIO - incorrect module
● Bit 14 = 1: PNIO - module disconnected

15 Reserved (always = 0)
16 to 31 Status information for modules generated by the CPU:

● Bit 16 = 1: Module disabled
● Bit 17 = 1: CiR operation active
● Bit 18 = 1: Input not available
● Bit 19 = 1: Output not available bit 
● 20 = 1: Overflow diagnostics buffer bit 
● 21 = 1: Diagnostics not available bit 
● 22 - 31: Reserved (always 0)

OwnState UINT Enum The value of the parameter Ownstate describes the maintenance status 
of the module.

0 No fault
1 The module or device is disabled.
2 Maintenance required
3 Maintenance demanded
4 Error
5 The module or the device cannot be reached from the CPU (valid for 

modules and devices below a CPU).
6 Inputs/outputs are not available.
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Parameter Data type Value Description
7 -

IOState WORD Bit array I/O status of the module
0 Bit 0 = 1: No maintenance required
1 Bit 1 = 1: The module or device is disabled.
2 Bit 2 = 1: Maintenance required
3 Bit 3 = 1: Maintenance demanded
4 Bit 4 = 1: Error
5 Bit 5 = 1: The module or the device cannot be reached from the CPU 

(valid for modules and devices below a CPU).
6 Inputs/outputs are not available.
7 Qualifier; bit 7 = 1, if bit 0, 2, or 3 are set
8 to 15 Reserved (always = 0)

OperatingState UINT Enum  
0 -
1 In STOP / Firmware update
2 In STOP / reset memory
3 In STOP / self start
4 In STOP
5 Memory reset
6 In START
7 In RUN
8 -
9 In HOLD
10 -
11 -
12 Module defective
13 -
14 No power
15 CiR
16 In STOP / without ODIS
17 In 
18  
19  
20  

DNN structure
With parameter MODE = 2, the diagnostic information details are output in accordance with 
the DNN structure. In this case, enter the system data type "DNN" as data type for the tag 
declaration.

The following table shows the meaning of the individual parameter values.
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Parameter Data type Value Description
SubordinateState UINT Enum Status of the subordinate module (see parameter OwnState of the 

DIS structure)
SubordinateIOState WORD Bitarray Status of the inputs and outputs of the subordinate module (see 

parameter IO State of the DIS structure)
DNNmode WORD Bitarray ● Bit 0 = 0: Diagnostics enabled

● Bit 0 = 1: Diagnostics disabled
● Bit 1 to 15: Reserved

DiagnosticDetail structure
With parameter MODE = 3, the diagnostic information details are output in accordance with 
the DiagnosticDetail structure. In this case, enter the system data type "DiagnosticDetail" as 
data type for the tag declaration.

The following table shows the meaning of the individual parameter values.

Parameter Data type Description
ChannelInfo WORD Channel properties (0...7)
ALID UInt Identification ID of alarm
TextID UNIT ID of an alarm text in a text list.
ChannelNumber UINT Manufacturer-specific channel number (0x0000 — 0x7FFF)
Addval_0 DWORD Placeholder for additional information The value / list of values depends on the 

connection error.
TextID2 UInt Texts for CPU response (mode, OB calls, etc.).
LADDR HW_ANY Identical to the LADDR parameter.
TextListId UInt ● 0: No text list

● ≠0: ID of the text list
ChannelDirection UInt ● 000: Manufacturer-specific

● 001: Input
● 002: Output
● 003: Input/Output
● 004 - 007: Reserved

AddVal_1 DWORD Placeholder for additional information on the channel error (depends on the GSD 
file).
For channel error types, see also: IEC 61158 (PROFINET IO Type 10 and 
PROFIBUS DP Type 3).

RET_VAL parameter

Error code*

(W#16#...)

Description

0 No error
n The data area at the DETAIL parameter is too small. Not all details of the diagnostic data can be output.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2879



Error code*

(W#16#...)

Description

8080 Value in the MODE parameter is not supported.
8081 Type at the DIAG parameter is not supported with the selected mode (parameter MODE).
8082 Type at the DETAIL parameter is not supported by the selected mode (parameter MODE).
8090 LADDR does not exist
80C1 Insufficient resources for parallel execution.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.10 Pulse

CTRL_PWM: Pulse-width modulation

Description
You can use the "CTRL_PWM" instruction to enable and disable a pulse output supported by 
the CPU using the software.

● Enter the hardware ID of the pulse generator that you want to control with the instruction 
at the input PWM.

● The pulse output is enabled when the bit in the ENABLE input of the instruction is set. 

– If ENABLE has a value of TRUE the pulse generator will generate a pulse with the 
properties defined in the device configuration. 

– When the bit in the ENABLE input is reset or the CPU changes to STOP, the pulse 
output is disabled and no more pulses are generated.

BUSY always has the value of FALSE for S7-1200 since S7-1200 activates the pulse generator 
if the instruction "CTRL_PWM" is executed.

The ENO enable output is set only when the EN enable input has signal state "1" and no errors 
have occurred during execution of the instruction.

 

 Note
Use of the force table for PWM and PTO

Digital inputs and outputs that are used for PWM and PTO cannot be forced. Digital inputs 
and outputs that were assigned via device configuration cannot be controlled by either the 
force table or the monitoring table.

 

Requirement
A prerequisite for the correct execution of the instruction is that the specified pulse generator 
is activated in the hardware configuration. 
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Open the properties of the module in the device view. Go to "Pulse generators (PTO/PWM)", 
open the desired PTO/PWM and activate the function the "Activate this pulse generator" under 
"General".

Go to "Assigning parameters" and set the Pulse options. 
 

 Note

Pulse output parameters are assigned exclusively in the device configuration and not using 
the "CTRL_PWM" instruction. Any change of parameters that is intended to have an effect 
on the CPU must therefore be made while the CPU is in STOP mode. Changing the duration 
of the pulse is an exception.

 

Changing the pulse duration from the user program
The pulse duration setting made in the dialog "Pulse options" can be changed from the user 
program.

The value set for "Initial pulse duration" is written in the output bytes of the pulse generator. 
The start address and the end address are displayed in the properties of the pulse generator 
under "I/O-addresses".

To change the pulse duration, write the desired values in the output word address specified 
in the device configuration. 

Example: 

● A value of 500 (decimal) is used for the "Initial pulse duration". The start address of the 
PTO/PWM is "1000" and the end address is "1001". 

● The binary value of "0000000111110100" (=500 decimal) is written in both of the output 
bytes.

– Start address (AB1000): 0000_0001 (BIN)

– End address (AB1001): 1111_0100 (BIN)

Please note that the pulse duration always depends on the parameters set for the Pulse 
duration format (hundredths, thousandths, ...).

Parameters
The following table shows the parameters of the "CTRL_PWM" instruction:

Parameters Declaration Data type Memory area Description
PWM Input HW_PWM I, Q, M, D, L or 

constant
Hardware ID of the pulse generator
The hardware ID can be found in the properties 
of the pulse generator in the Device view. The 
hardware IDs of the pulse generators are also 
listed in the system constants.

ENABLE Input BOOL I, Q, M, D, L or 
constant

The pulse output is enabled when ENABLE = 
TRUE and disabled when ENABLE = FALSE.
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Parameters Declaration Data type Memory area Description
BUSY Output BOOL I, Q, M, D, L Processing status
STATUS Output WORD I, Q, M, D, L Status of the instruction (see below).

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No errors
80A1 Hardware ID of the pulse generator is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

9.7.3.11 Recipes and data logging

Recipe functions

RecipeExport: Exporting recipes

Description
The "RecipeExport" instruction exports the recipe data from a data block to a CSV file on the 
memory card of the CPU.

The export is triggered by the "REQ" parameter. The BUSY parameter is set to "1" during the 
export. During the export, the CSV file is created in the "Recipes" folder in the main directory 
of the memory card. The name of the data block is used as file name of the created CSV file. 
If a CSV file with an identical name already exists, it must be deleted before this export.

After the execution of the instruction, BUSY is reset to  "0" and the completion of the operation 
is indicated with "1" at the DONE parameter. If an error occurs during execution, this is signaled 
by the parameters ERROR and STATUS.
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Parameters
The following table shows the parameters of the "RecipeExport" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Control parameter REQUEST: Activates the 
export on a rising edge.

RECIPE_DB InOut VARIANT D Pointer to the recipe data block. For 
information on the structure of the data block, 
refer to: Structure of a recipe DB (Page 2886)

DONE Output BOOL I, Q, M, D, L Status parameter
● 0: Job not yet started or still executing.
● 1: Job executed without errors.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: The instruction is not executed.
● 1: The instruction is executed.

ERROR Output BOOL I, Q, M, D, L Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS 

supplies detailed information on the type of 
error.

STATUS Output WORD I, Q, M, D, L Status parameter
See the "STATUS" parameter table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error occurred
7000 No job processing active
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8090 File name of the CSV file contains invalid characters. The file name of the CSV file is identical to the name 

of the data block.
8091 The data structure referenced with RECIPE_DB cannot be processed.
8092 Data structure at RECIPE_DB parameter exceeds 5000 bytes.
80B3 Insufficient memory space on the memory card or the internal load memory.
80B4 The memory card is write-protected.
80C0 CSV files is temporarily locked.
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Error code* 
(W#16#...)

Explanation

80C1 Data block temporarily locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

RecipeImport: Importing recipes

Description
The "RecipeImport" instruction imports the recipe data from a CSV file on the memory card 
into the data block at the RECIPE_DB parameter. The values in the data block are overwritten 
in the process.

Note the following when importing the CSV file:

● The CSV file must be located in the  "Recipes" directory of the memory card.

● The name of the CSV file must match the name of the data block at the RECIPE_DB 
parameter.

● The first line (header) of the CSV file contains the name of the recipe components (see 
also: Structure of a recipe DB (Page 2886)). The first line is ignored during import. The 
names of the recipe components in the CSV file and the data block are not reconciled during 
import.

● In each case the first value in each line of the CSV file is the index number of the recipe. 
The individual recipes are imported in the order of the index. For this, the index in the CSV 
file has to be in ascending order and may contain no gaps (if this is not the case, the error 
message 80B0 is output at the STATUS parameter.

● The CSV file may not contain more recipe data records than provided for in the data block. 
The maximum number of data records is indicated by the array limits in the data  block.

The import is triggered by the "REQ" parameter. The BUSY parameter is set to "1" during the 
import. After the execution of the instruction, BUSY is reset to "0" and the completion of the 
operation is indicated with "1" at the DONE parameter. If an error occurs during execution, this 
is signaled by the parameters ERROR and STATUS.

Parameters
The following table shows the parameters of the "RecipeImport" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Control parameter REQUEST: Activates the 
import on a positive edge.

RECIPE_DB InOut VARIANT D Pointer to the recipe data block. For 
information on the structure of the data block, 
refer to: Structure of a recipe DB (Page 2886)
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L Status parameter

● 0: Job not yet started or still executing.
● 1: Job executed without errors.

BUSY Output BOOL I, Q, M, D, L Status parameter
● 0: The instruction is not executed.
● 1: The instruction is executed.

ERROR Output BOOL I, Q, M, D, L Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS 

supplies detailed information on the type of 
error.

STATUS Output WORD I, Q, M, D, L Status parameter
See the "STATUS" parameter table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0 No error occurred
7000 No job processing active
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8090 The file name contains invalid characters.
8092 No matching CSV file found for the import. Possible cause: The name of the CSV file does not match the 

name of the recipe DB.
80C0 CSV file is temporarily locked.
80C1 Data block is temporarily locked.
80B0 Numbering in the index of the CSV file is not continuous, not ascending or exceeds the maximum number 

(array limit) in the data block.
80B1 Structure of the recipe data block and the CSV file do not match: The CSV file contains too many fields.
80B2 Structure of the recipe data block and the CSV file do not match: The CSV file contains too few fields.
80D0 +n Structure of the recipe data block and the CSV file do not match: Data type in field n does not match (n<=46).
80FF Structure of the recipe data block and the CSV file do not match: Data type in field n does not match (n>46).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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Structure of a recipe DB

Introduction
The following sections describes the structure of a recipe DB based on a simple example. The 
recipe DB consists of five data records, three of which are used. The fourth and fifth data 
records are left free for later expansions. Each data record contains one recipe, which is made 
up of the recipe name and eight ingredients. 

product
name

water barley wheat hops yeast waterT
mp

mashT
mp

mashTi
me

QTest

Pils 10 9 3 280 39 40 30 100 0
Lager 10 9 3 150 33 50 30 120 0
BlackBe
er

10 9 3 410 47 60 30 90 1

Not_use
d

0 0 0 0 0 0 0 0 0

Not_use
d

0 0 0 0 0 0 0 0 0

Structure of the recipe data block
The recipe data are implemented as follows in a global data block:

● The template for all recipes is the PLC data type "Beer_Recipe" with the recipe components 
"procutname", "water", etc. with the corresponding data types.

● In a global data block, the PLC data type is used as Array [1.. 5] of "Beer_Recipe". The 
array limits (1 to 5 in this case) indicate the maximum number of recipes that the DB may 
contain.

● The values for the recipe components are added as start value in the data block.

● The global DB is interconnected with the instruction via the InOut parameter RECIPE_DB.
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Exporting to CSV file
After the execution of the "RecipeExport (Page 2882)" instruction the data of the DB are written 
to a CSV file with the following structure:

Recipe_DB.csv
index,productname,water,barley,wheat,hops,yeast,waterTmp,mashTmp,mashTime,QTest
1,”Pils”,10,9,3,280,39,40,30,100,0
2,”Lager”,10,9,3,150,33,50,30,120,0
3,”BlackBeer”,10,9,3,410,47,60,30,90,1
4,”Not_used”,0,0,0,0,0,0,0,0,0
5,”Not_used”,0,0,0,0,0,0,0,0,0

Display in Excel

The CSV file can be opened in Excel to make reading and editing easier. If the commas are 
not recognized as separators when you open the file, use the Excel import function to output 
the data in structured form:

Editing the CSV file
The CSV file can be uploaded to the PC/programming device by means of the Web server 
and edited. After editing, the modified file can be reloaded in the CPU. You can use the 
"RecipeImport (Page 2884)" instruction to re-import the modified data from the CSV file into 
the data block.

Note that the modified data must still be compatible with the data block. In other words:

● No changes may be made to the structure in the table (for example, by adding ingredients 
in a new column).

● If you add data records to the file, make sure when importing into the data block that the 
array limits through which you specify the maximum number of data records correspond to 
at least the number of data records.

● An index is automatically generated during export to the CSV file. If you create additional 
data records, add consecutive index numbers accordingly.

● The values in the table cells must correspond to the data types used in the data block with 
respect to format as well as length.

– Example 1: If data type INT was used in the data block, you can only use integers in the 
table.

– Example 2: If data type SINT was used in the data block, you can only use integers with 
the values -128 to +127 in the table.

Always keep in mind the permitted data types and data areas as listed in the table below 
when you make changes in the table.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2887



Data type Format Note
Floating-
point 
numbers

LReal +9.9999999999999E
+999

Always written exponentially

Real +9.999999E+99 Always written exponentially 
Signed 
integers

LInt +9999999999999999999 Value range for signed integers: -9223372036854775808 .. 
+9223372036854775807

DInt +9999999999 Value range of integers: -2147483648 to +2147483647
Int +99999 Value range of integers: -32768 to +32767
SInt +999 Value range of integers: -128 to +127

Unsigned 
integers

ULInt +9999999999999999999
9

Value range of integers: 0 to +18446744073709551615

UDInt +9999999999 Value range of integers: 0 to +4294967295
UInt +99999 Value range of integers: 0 to + 65535
USInt +999 Value range of integers: 0 to +255

Binary 
numbers

LWord +9999999999999999999
9

Value range of integers: +00000000000000000000 to 
+18446744073709551615

DWord +9999999999 Value range of integers: +0000000000 to +4294967295
Word +99999 Value range of integers: +00000 to + 65535
Byte +999 Value range of integers: +000 to +255
Bool 9 Range of values: 0 or 1

Date and 
time

LTIME hhh:mm:ss.999 ISO format with milliseconds
TIME hhh:mm:ss.999 ISO format with milliseconds
S5TIME hhh:mm:ss.999 ISO format with milliseconds
LDT YYYY-MM-DD hh:mm:ss.

999
ISO format with milliseconds

DTL YYYY-MM-DD hh:mm:ss.
999

ISO format with milliseconds

DT YYYY-MM-DD hh:mm:ss.
999

ISO format with milliseconds

DATE YYYY-MM-DD ISO format
LTime_Of_
Day

hh:mm:ss.999_999_999 ISO format

TOD hh:mm:ss.999 ISO format
Character String "abcd" The string must be in double quotation marks.

Char "a" Individual character in double quotation marks.

Data logging

Data logging - Overview

Saving process values
The data logging instructions are used in the user program to save process values to data 
logs. Data logs can be saved on the Memory Card (MC) or in the internal load memory. The 
data logs are saved in CSV format (Comma Separated Value).
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The data logging instructions are used in your program to create or open a data log, to write 
an entry and to close the data log file. 

You decide by the creation of the data buffer which program values are stored in the data log 
during the creation of the data buffer. The data buffer is used as a memory for new data log 
entries. New values have to be written to the buffer before "DataLogWrite (Page 2903)" is 
called. During execution of the "DataLogWrite (Page 2903)" instruction, data is written from 
the buffer to a data log record.

Data log files can be copied to the PC as follows:

● If the PROFINET interface is connected to the PC, you use a Web browser to access the 
data logs via the Web server. The CPU can be in RUN or STOP mode for this. If the CPU 
is in "RUN" mode, the program continues running while the Web server is transferring data.

● If there is a memory card in the CPU, you can remove this card and insert it into a standard 
slot for SD (Secure Digital) cards or MMC (MultiMediaCard) cards on a PC or programming 
device. Use File Manager to transfer the data log files from the memory card to the PC. 
The CPU goes to "STOP" when you remove the memory card.

Properties of the data log
Writing of the data records of a data log is carried out in accordance with the principle of a ring 
buffer. New data records are added until the maximum number of data records is reached 
(RECORD parameter). The next data record then overwrites the "oldest" data record of the 
data log. 

If you want to prevent data records from being overwritten, use the "DataLogNewFile 
(Page 2908)" instruction to create a new data log file based on the current data log. New data 
records are then written into the new data log. 
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Creating data logs
With the "DataLogCreate (Page 2891)" instruction, you can create a new data log file in the 
""\DataLogs" directory of the load memory.

● The name assigned at the NAME parameter is the designation for the data log and is also 
used the file name for the CSV file. The file is stored in the directory "DataLogs".

● The block parameter DATA specifies the data buffer for the new data log object and the 
columns and data types in the data log. The columns and data types of a data record in 
the data log are generated by the elements in the structure declaration or the array 
declaration of this data buffer. Each element of a structure or of an array corresponds to a 
column in a line in the data log.

● You can use the HEADER block parameter to assign a header text in the header to each 
column.

● The "DataLogCreate (Page 2891)" instruction returns an ID. This ID is used by the other 
data logging instructions as a reference for the created data log.

Opening data logs
You use the instruction "DataLogOpen" (S7-1200 and S7-1500) to open an existing data log 
on the memory card. A data log must be open before you can write new data records to it. 

Data log opens automatically when you execute the instructions "DataLogCreate (Page 2891)" 
and "DataLogNewFile (Page 2908)". 

Up to 10 data logs can be open simultaneously. You can select the data log to be opened 
using the ID or name of the data log.

● If you specify the ID and the name of the data log in the ID and NAME parameters, 
respectively, the data log will be identified based on the ID. The data log name will not be 
compared.

● If you select the data log using the NAME parameter and no ID is specified, the ID will be 
displayed in the ID parameter when the data log is opened.

● If you select the data log using the ID parameter and no name is specified, the name will 
be displayed in the NAME parameter when the data log is opened.

You use the MODE parameter to specify whether the data records of the data log are to be 
deleted upon opening.

Writing to data logs
A data log must be open ("DataLogOpen (Page 2898)" instruction) before a data record can 
be written to a data log. The "DataLogWrite (Page 2903)" instruction writes a data record to 
the data log.

Closing data logs
You use the "DataLogClose (Page 2905)" instruction to close an open data log. You select the 
data log using the ID parameter.

The data log is closed automatically when the CPU switches to STOP and upon restart.
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Deleting data logs
You use the instruction "DataLogDelete (Page 2907)" (S7-1500) to delete a data log file from 
the memory card. The data log and the data records it contains can only be deleted if the log 
was created with the instruction "DataLogCreate (Page 2891)".

Select the data log to be deleted using the NAME and ID  parameters. The  ID  parameter is 
evaluated first. If there is a data log with the relevant ID, the NAME parameter will not be 
evaluated. If the value "0" is used at the ID parameter, a value with the data type STRING 
must be used at the NAME parameter.

Clearing data logs
You use the instruction "DataLogClear (Page 2901)" (S7-1500) to delete all the data records 
in an existing data log. The instruction does not delete the optional header of the CSV file (see 
the description of the HEADER parameter of the instruction "DataLogCreate (Page 2891)").

You use the  ID parameter to select the data log whose data records are to be deleted. Before 
you can delete data records, the data log must be open.

New file for data logs
You use the instruction "DataLogNewFile (Page 2908)" (S7-1200) or "DataLogTypedNewFile 
(Page 2910)" (S7-1500) to create a new data log with the same properties as an existing data 
log. This allows you to retain the contents of an existing data log.

When called, the instruction creates a new data log on the memory card or in the internal load 
memory with the name defined at the NAME parameter. You use the ID parameter to specify 
the ID of the old data log whose properties you want to apply to the new data log. The ID of 
the new data log is then output via the ID parameter.

You specify the file size of the new data log with the RECORDS parameter of the instruction. 

You can run a consistency check for "DataLogTypedNewFile (Page 2910)" (S7-1500).

DataLogCreate: Create data log

Description
With the "DataLogCreate" instruction you create a data log.

The data log is saved on the memory card or in the internal load memory in the directory 
"\DataLogs".  The amount of data that can be stored in a data log is dependent on the available 
space on the memory card or the storage space in the internal load memory of the CPU.

You specify the maximum number of data records that can be stored in a data log in the 
RECORDS parameter. If the specified maximum number of data records in the data log is 
reached, the oldest data record will be overwritten. To avoid overwriting of existing data 
records, use the "DataLogNewFile (Page 2908)" instruction. The instruction can be used to 
create a new data log with the same structure when the number specified at the RECORDS 
parameter is reached (return value 1 at the STATUS parameter of the "DataLogWrite 
(Page 2903)" instruction). The data records are then saved in the new data log.
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You can specify the name for the data log in the NAME parameter. The data log is created in 
CSV (Comma Separated Value) format. With the HEADER parameter, you can create an 
(optional) header for the data log.

Once the data log is created, it is opened automatically. This means that data can be written.

Parameters
The following table shows the parameters of the "DataLogCreate" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execution of the instruction
The data log is created with a rising edge at the 
parameter REQ.

RECORDS Input UDInt I, Q, M, L, D or 
constant

Maximum number of data records in the data log
If the instruction "DataLogWrite (Page 2903)" writes 
more records than specified in this parameter, the 
oldest record is overwritten.

FORMAT Input UInt I, Q, M, L, D or 
constant

Data format:
● 0: Internal (not supported)
● 1: CSV (Comma separated values)

TIMESTAMP Input UInt I, Q, M, L, D or 
constant

Time stamp:
● 0: No time stamp
● 1: Date and time
The extra columns in the header are automatically 
added if time-stamping is activated.

NAME Input VARIANT L, D Name of the data log
The specified name is also used as a file name for 
the csv file.
The restrictions for Windows file names apply when 
assigning the name. The following characters must 
not be used:
"\", "/", ":", "*", "?", "<", ">", "|", "space"

ID InOut DWORD I, Q, M, L, D Object ID of the data log (only output)
The ID of the data log is required for further data 
logging instructions to address the created data log.

HEADER InOut VARIANT L, D Header of the data log (optional)
The parameter is hidden after the instruction is 
added.
The header is written as the first line in the CSV file.

DATA InOut VARIANT L, D Pointer to the data structure that is to be written as 
data record when executing the instruction 
"DataLogWrite (Page 2903)".

Programming the PLC
9.7 References

WinCC Professional V13.0
2892 System Manual, 02/2014



Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, L, D Status parameter:

● 0: Processing not yet complete.
● 1: Processing of instruction finished 

successfully.
BUSY Output BOOL I, Q, M, L, D Status parameter:

● 0: Processing of the instruction has not started, 
completed, or canceled.

● 1: Processing of the instruction is in progress.
ERROR Output BOOL I, Q, M, L, D Status parameter:

● 0: No error.
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Detailed status information:
Detailed error and status information is output at 
the parameter STATUS. The parameter is only set 
for the duration of one call. To display the status, 
you should therefore copy the STATUS parameter 
to a free data area.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

HEADER parameter
The HEADER parameter is a VARIANT pointer to a data block that defines a header for the 
CSV file (header). The header is always the first line in the CSV file representation. 

● When creating a header, remember that the individual columns must be separated by a 
comma (S7-1200) or a semicolon (S7-1500). 

● A STRING, Array of BYTE, or Array of CHAR data type can be used for the individual 
column names. A longer character string is possible with the Array [...] of type data type 
than with the STRING data type. When the STRING data type is used, the length is limited 
to 254 bytes. 

If no header is to be created, do not specify a value in the HEADER parameter.

DATA parameter
The DATA parameter is a VARIANT pointer to a structure or an array in a data block. An 
element of a structure or an array corresponds to a column in the data log with a specific data 
type.

Note the following when creating the data block:

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2893



● The number of columns must correspond to the number of columns defined in the HEADER 
parameter.

● Each element of the structure or the array corresponds to a column entry in the CSV file. 
Therefore, no nesting structures (STRUCT in STRUCT) may be used when using the data 
type STRUCT.

● The data structure can contain up to 256 elements. If there are more than 256 elements, 
error code 8C52 is output at the STATUS parameter.

● The tags of the data block can be set as retentive or non-retentive tags. However, the 
retentivity setting must be the same for all tags of the data block.

STATUS (S7-1200) parameter

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 Invalid file name (see description of the NAME parameter).
8093 Data log already exists.
8097 File length exceeds the file system limit.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C1 Too many data logs are open.
80C3 Resources are not sufficient. Possible causes:

● Multiple calling of instructions with different parameters.
● More than 10 data logs open simultaneously. At least one data log must be closed in order to continue 

because the instruction "DataLogCreate" automatically opens the the log that is being created.
8453 Invalid format selection.
8553 Invalid time stamp.
8B51 Invalid data type at HEADER parameter.
8C20 String with length specification other than 254 used.
8C51 Invalid data type at DATA parameter.
8C52 Structure at the parameter DATA contains more than 256 elements.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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STATUS (S7-1500) parameter

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
8070 Complete internal instance memory is assigned.
8090 Invalid file name (see description of the NAME parameter).
8091 "NAME" parameter is not a string.
8093 Data log already exists.
8097 File length exceeds the file system limit.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C0 Access currently not possible.
80C1 Too many data logs are open.
80C3 Resources are not sufficient. Possible causes:

● Multiple calling of instructions with different parameters.
● More than 10 data logs open simultaneously. At least one data log must be closed in order to continue 

because the instruction "DataLogCreate" automatically opens the the log that is being created.
8253 The  RECORDS parameter has an invalid value.
8353 Invalid format selection.
8453 Invalid time stamp.
8B51 Invalid data type at HEADER parameter.
8C51 Invalid data type at DATA parameter.
8C52 Structure at the parameter DATA contains more than 256 elements.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Example
In the following example, a simple data log is created with a time stamp and three process 
values.

 

Tags in the global data block

The values for the input parameters of the data log are stored in the global data block 
"DataLogDB":

● DataLogName (String): The tag contains the name of the data log which is also used as 
the file name for the CSV file.

● DataLogID (DInt): The ID of the data log is written in this tag when the instruction is called. 

– The ID is automatically assigned by the instruction.

– Use the tag "DataLogID" in other DataLog instructions in order to address this data log.
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● MyHeader (String): This tag contains the header of the DataLog, i.e. the column headings 
for the process values. A semicolon is used as a delimiter for the columns when using a 
S7-1500.

● MyData (Struct): This tag contains the three process values that are written in the data log. 
Each time a record is written (instruction "DataLogWrite (Page 2903)") the current values 
are written in a new record.

 

Calling the "DataLogCreate" instruction

The instruction is called with the following input parameters:

● REQ (BOOL): With REQ = "1" the data log is created.

● RECORD (3): A maximum of three data records can be written in the data log. Thereafter, 
the oldest data record is overwritten.

● FORMAT (1): The data log is created as a CSV file.

● TIMESTAMP (1): Activated. Two additional columns are automatically created (date and 
time) for the data log. The current time stamp is written in the data record each time 
"DataLogWrite (Page 2903)" is executed.

● NAME (VARIANT): Pointer to the tag "DataLogName" in the data block "DataLogDB".

● ID (VARIANT): Pointer to the tag "DataLogID" in the data block "DataLogDB".

● HEADER (VARIANT): Pointer to the tag "MyHeader" in the data block "DataLogDB".

● DATA (VARIANT): Pointer to the tag "MyData" in the data block "DataLogDB".
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Readout of the data log via the web server

You can readout the created data log with the web server:

● Activate the web server in the properties of the CPU. The authorization "...to read files" 
must be activated for the web server in order to readout the data log.

● You can access the web server via the Internet browser by entering the IP address of the 
CPU as a URL.

● Under "Filebrowser" the directory "\DataLogs" was automatically created which contains 
the data log.

● The DataLog only contains one entry "//END" if the instruction "DataLogWrite (Page 2903)" 
has still not been executed. The first data record is written after the initial execution of 
"DataLogWrite (Page 2903)".

See also
Data logging - Overview (Page 2888)
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DataLogOpen: Open data log

DataLogOpen: Open data log

Description     
You use the "DataLogOpen" instruction to open an existing data log on the memory card. A 
data log must be open before you can write new data records to it. 

Data log opens automatically when you execute the instructions "DataLogCreate (Page 2891)" 
and "DataLogNewFile (Page 2908)". 

Up to 10 data logs can be open simultaneously. You can select the data log to be opened 
using the ID or name of the data log.

● If you specify the ID and the name of the data log in the ID and NAME parameters, 
respectively, the data log will be identified based on the ID. The data log name will not be 
compared.

● If you select the data log using the NAME parameter and no ID is specified, the ID will be 
displayed in the ID parameter when the data log is opened.

● If you select the data log using the ID parameter and no name is specified, the name will 
be displayed in the NAME parameter when the data log is opened.

You use the MODE parameter to specify whether the data records of the data log are to be 
deleted upon opening.

Parameters
The following table shows the parameters of the "DataLogOpen" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D or 

constant
Execution of the instruction upon a rising edge.

MODE Input UInt I, Q, M, L, D or 
constant

Mode for opening the data log:
● MODE= "0"

Data records of the data log are retained
● MODE= "1"

Data records of the data log are deleted, but the 
header is retained

NAME Input VARIANT L, D (File) name of the data log.
ID InOut DWORD I, Q, M, L, D Object ID of the data log.
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No errors.
2 Warning: Data log file has already been opened by this application.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 There are inconsistencies between the data log definition and existing data log data.
8091 A data type other than String was used at the NAME parameter.
8092 Data log does not exist.
80B4 The memory card is write-protected.
80C0 The data log file is locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2888)

DataLogOpen: Open data log

Description
You use the "DataLogOpen" instruction to open an existing data log on the memory card. A 
data log must be open to write new data records to it. 

Data log opens automatically when you execute the instructions "DataLogCreate (Page 2891)" 
and "DataLogNewFile (Page 2908)".
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Up to 10 data logs can be open simultaneously. You can select the data log to be opened 
using the ID or name of the data log.

● If you specify the ID and the name of the data log in the ID and NAME parameters, 
respectively, the data log will be identified based on the ID. The data log name will not be 
compared.

● If you select the data log using the NAME parameter and no ID is specified, the ID will be 
displayed in the ID parameter when the data log is opened.

● If you select the data log using the ID parameter and no name is specified, the name will 
be displayed in the NAME parameter when the data log is opened.

You use the MODE parameter to specify whether the data records of the data log are to be 
deleted upon opening.

The parameter DATA enables a consistency check between the data log to be opened and 
the definition of the data log of the instruction "DataLogCreate (Page 2891)". The consistency 
check can only be executed if the data log was created with the instruction "DataLogCreate 
(Page 2891)":

● If you are using the same pointer at the DATA parameter as at the DATA parameter of the 
"DataLogCreate (Page 2891)" instruction, a check is performed to determine whether the 
data types match. If the data types do not match, the error code W#16#80A0 is output at 
the STATUS parameter.

● If the data log to be opened was not created with "DataLogCreate (Page 2891)", a 
consistency check is not possible. In this case, enter the value "NULL" in the DATA 
parameter.

Parameters
The following table shows the parameters of the "DataLogOpen" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execution of the instruction upon a rising edge.

MODE Input UInt I, Q, M, L, D or 
constant

Mode for opening the data log:
● MODE= "0"

Data records of the data log are retained
● MODE= "1"

Data records of the data log are deleted, but the 
header is retained

NAME Input VARIANT L, D (File) name of the data log.
ID InOut DWORD I, Q, M, L, D Object ID of the data log.
DATA InOut VARIANT L, D With consistency check: Pointer to the data area at 

the DATA parameter of the "DataLogCreate 
(Page 2891)" instruction.

DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code* 
(W#16#...)

Description

0 No errors.
2 Warning: Data log file has already been opened by this application.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 There are inconsistencies between the data log definition and existing data log data.
8091 A data type other than String was used at the NAME parameter.
8092 Data log does not exist.
80A0 Data types inconsistent. The data log at the ID parameter uses different data types than specified in the 

DATA parameter.
80B4 The memory card is write-protected.
80C1 Too many files open.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2888)

DataLogClear: Empty data log

Description
The "DataLogClear" instruction deletes all data records in an existing data log. The instruction 
does not delete the optional header of the CSV file (see the description of the HEADER 
parameter of the instruction "DataLogCreate (Page 2891)").
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You use the ID parameter to select the data log whose data records are to be deleted.

Requirement
Before you can delete data records, the data log must be open (see "DataLogOpen 
(Page 2898) instruction").

Parameters
The following table shows the parameters of the "DataLogClear" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execution of the instruction upon a rising edge.

ID InOut DWORD I, Q, M, D, L Object ID of the data log
DONE Output BOOL I, Q, M, D, L Instruction was executed successfully.
BUSY Output BOOL I, Q, M, D, L Execution of the instruction not yet complete.
ERROR Output BOOL I, Q, M, D, L ● 0: No error.

● 1: An error occurred during execution of the 
instruction. 

Detailed information is output at the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy the STATUS parameter to a 
free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code* 
(W#16#...)

Explanation

0000 No error.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8080 The data log file selected with the ID parameter cannot be processed with the "DataLogClear" instruction.
8092 Data log does not exist.
80B0 Data log is not open.
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Error code* 
(W#16#...)

Explanation

80B4 The memory card is write-protected.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2888)

DataLogWrite: Write data log

Description     
The instruction "DataLogWrite" is used to write a data record to an existing data log. The ID 
parameter is used to select the data log to which the data record is to be written. To create a 
new data record, the data log must be open. The instruction creates a new data record in the 
format that was specified in the DATA parameter when the data log was created.

Before calling the "DataLogWrite" instruction, transfer the data to the tag that you 
interconnected at the DATA parameter of the "DataLogCreate" instruction. When the 
"DataLogWrite" instruction is executed, the transferred data is copied to the data log.

 

 NOTICE

Data log data loss when the power supply to the CPU is interrupted

If the power supply is interrupted during execution of the "DataLogWrite" instruction, the data 
record to be transferred is lost.

 

Parameters
The following table shows the parameters of the "DataLogWrite" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execution of the instruction upon a rising edge.

ID InOut DWORD I, Q, M, L, D Object ID of the data log
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS (S7-1200)

Error code*
(W#16#...)

Description

0 No errors
0001 Last possible data record created at the end of the file. Creating another data record will overwrite an 

older data record.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8092 Data log does not exist.
80B0 Data log is not open.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C0 Data log is locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (S7-1500)

Error code*
(W#16#...)

Description

0 No errors
0001 Last possible data record created at the end of the file. Creating another data record will overwrite an 

older data record.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
8070 Complete internal instance memory is assigned.
8092 Data log does not exist.
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Error code*
(W#16#...)

Description

80B0 Data log is not open.
80B3 Insufficient memory space on the memory card.
80B4 The memory card is write-protected.
80C0 Data log is locked.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Data logging - Overview (Page 2888)

DataLogClose: Close data log

Description     
You use the "DataLogClose" instruction to close an open data log. You select the data log 
using the ID parameter.

 

 Note
Closing data logs automatically

The data log is closed automatically when the CPU goes to STOP or if there is a restart.
 

Parameters
The following table shows the parameters of the "DataLogClose" instruction:

Parameters Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execute function on a rising edge.

ID InOut DWORD I, Q, M, L, D Object ID of the data log
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2905



Parameters Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter
The parameter is only set for the duration of one 
call. To display the status, you should therefore 
copy the STATUS parameter to a free data area.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

STATUS (S7-1200) parameter

Error code*
(W#16#...)

Description

0 No errors
1 Data log is not open
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8092 Data log does not exist.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

STATUS (S7-1500) parameter

Error code*
(W#16#...)

Description

0 No errors
1 Data log is not open
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
8070 Complete internal instance memory is assigned.
8092 Data log does not exist.
80B4 The memory card is write-protected.
80C0 Access currently not possible.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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DataLogDelete: Delete data log

Description
You use the "DataLogDelete" instruction to delete a data log file from the memory card. The 
data log and the data records it contains can only be deleted if it was created with the 
"DataLogCreate" or "DataLogNewFile" instruction.

Parameters
The following table shows the parameters of the "DataLogDelete" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execution of the instruction upon a rising edge.

NAME Input VARIANT L, D File name of the data log
DELFILE Input BOOL I, Q, M, D, L ● 0: Data log is retained.

● 1: Data log is deleted.
Detailed information is output at the STATUS 
parameter.

ID InOut DWORD I, Q, M, D, L Object ID of the data log
DONE Output BOOL I, Q, M, D, L Instruction was executed successfully.
BUSY Output BOOL I, Q, M, D, L Deletion of the data log is not yet complete.
ERROR Output BOOL I, Q, M, D, L ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output at the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter
The parameter is only set for the duration of 
one call. To display the status, you should 
therefore copy the STATUS parameter to a 
free data area.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

NAME and ID parameters
Select the data log to be deleted using the NAME and ID parameters. The ID parameter is 
evaluated first. If there is a data log with the relevant ID, the NAME parameter will not be 
evaluated. If the value "0" is used at the ID parameter, a value with the data type STRING 
must be used at the NAME parameter.
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RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0 No error.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8091 A data type other than STRING is being used at the NAME parameter.
8092 Data log does not exist.
80A2 Write error
80B4 The memory card is write-protected.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
DataLogCreate: Create data log (Page 2891)

DataLogNewFile: Data log in new file

DataLogNewFile: Data log in new file

Description
You use the "DataLogNewFile" instruction to create a new data log with the same properties 
as an existing data log. This allows the contents of an existing data log to be retained.

When called, the instruction creates a new data log on the memory card or in the internal load 
memory with the name defined at the NAME parameter. You use the ID parameter to specify 
the ID of the old data log whose properties you want to apply to the new data log. The ID of 
the new data log is then output via the ID parameter.

You specify the file size of the new data log with the RECORDS parameter of the instruction.

Once the new data log is created, it is opened automatically. This means that data can be 
written.
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Parameters
The following table shows the parameters of the "DataLogNewFile" instruction:

Parameters Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D or 

constant
Execution of the instruction upon a rising edge.

RECORDS Input UDInt I, Q, M, L, D or 
constant

Number of data records in the data log.

NAME Input VARIANT L, D File name of the new data log.
ID InOut DWORD I, Q, M, L, D Object ID of the data log

● In: ID of the existing data log
● Out: ID of the new data log

DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one call. 
To display the status, you should therefore copy the 
STATUS parameter to a free data area.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 Invalid file name.
8091 Path does not exist.
8092 Source data log does not exist.
8093 New data log already exists.
8097 File length exceeds the file system limit.
80B3 Load memory not sufficient.
80B4 The memory card is write-protected.
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Error code*
(W#16#...)

Description

80C1 Too many files open.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DataLogNewFile: Data log in new file

Description
You use the "DataLogNewFile" instruction to create a new data log with the same properties 
as an existing data log. This allows the contents of an existing data log to be retained.

When called, the instruction creates a new data log on the memory card or in the internal load 
memory with the name defined at the NAME parameter. You use the ID parameter to specify 
the ID of the old data log whose properties you want to apply to the new data log. The ID of 
the new data log is then output via the ID parameter.

You specify the file size of the new data log with the RECORDS parameter of the instruction.

The parameter DATA enables a consistency check between the new data log to be created 
and the definition of the data log of the instruction "DataLogCreate (Page 2891)". The 
consistency check can only be executed if the data log was created with the instruction 
"DataLogCreate (Page 2891)":

● If you are using the same pointer at the DATA parameter as at the DATA parameter of the 
"DataLogCreate (Page 2891)" instruction, a check is performed to determine whether the 
data types match. If the data types do not match, the error code W#16#80A0 is output at 
the STATUS parameter.

● If the data log to be opened was not created with "DataLogCreate (Page 2891)", a 
consistency check is not possible. In this case, enter the value "NULL" in the DATA 
parameter.

Once the new data log is created, it is opened automatically. This means that data can be 
written.

Parameters
The following table shows the parameters of the "DataLogNewFile" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, L, D, T, C or 

constant
(T and C are only 
available in LAD and 
FBD with S7-1500)

Execution of the instruction upon a rising edge.

RECORDS Input UDInt I, Q, M, L, D or 
constant

Number of data records in the data log.

NAME Input VARIANT L, D File name of the new data log.
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Parameter Declaration Data type Memory area Description
ID InOut DWORD I, Q, M, L, D Object ID of the data log

● In: ID of the existing data log
● Out: ID of the new data log

DATA InOut VARIANT L, D Data type for consistency check
DONE Output BOOL I, Q, M, L, D Instruction was executed successfully.
BUSY Output BOOL I, Q, M, L, D Execution of the instruction not yet complete.
ERROR Output BOOL I, Q, M, L, D ● 0: No error.

● 1: An error occurred during execution of the 
instruction.

Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, L, D Status parameter 
The parameter is only set for the duration of one call. 
To display the status, you should therefore copy the 
STATUS parameter to a free data area.

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

STATUS parameter

Error code*
(W#16#...)

Description

0 No errors.
7000 No job processing active.
7001 Start of job processing. Parameter BUSY = 1, DONE = 0
7002 Intermediate call (REQ 

irrelevant): Instruction already active; BUSY has the value "1".
8070 Complete internal instance memory is assigned.
8090 ● Invalid file name.

● Data types inconsistent. The data log at the ID parameter uses different data types than specified in the 
DATA parameter.

8091 Path does not exist.
8092 Source data log does not exist.
8093 New data log already exists.
8097 File length exceeds the file system limit.
80B3 Load memory not sufficient.
80B4 The memory card is write-protected.
80C0 Access currently not possible.
80C1 Too many files open.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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9.7.3.12 Data block functions

CREATE_DB: Create data block

Description
The instruction "CREATE_DB" is used to create a new data block in the load and/or work 
memory.

The instruction "CREATE_DB" does not change the checksum of the user program.

Number of the data block
The data block created is assigned a number from the range defined at the LOW_LIMIT (low 
limit) and UP_LIMIT (high limit) parameters. "CREATE_DB" assigns the smallest possible 
number from the specified range to the DB. You cannot assign the numbers of the DBs already 
contained in the user program.

To create a DB with a specific number, enter the same number for the high and low limit of the 
range to be specified. If a DB with the same number already exists in the work memory and/
or load memory, or if the DB exists as a copied version, the instruction will be terminated and 
an error message will be generated at the RET_VAL parameter.

Start values of the data block
Using the SRCBLK parameter, you can define start values for the DB to be created. The 
SRCBLK parameter is a pointer to a DB or a DB area from which you apply the start values. 
The DB addressed at the SRCBLK parameter must have been generated with standard access 
("Optimized block access" attribute disabled).

● If the area specified at the SRCBLK parameter is larger than the DB generated, the values 
up to the length of the DB generated will be applied as start values.

● If the area specified at the SRCBLK parameter is smaller than the DB generated, the 
remaining values will be filled with "0".

To ensure data consistency, you must not change this data area while "CREATE_DB" is being 
executed (which means as long as the BUSY parameter has the value TRUE).

Parameters
The following table shows the parameters of the "CREATE_DB" instruction:

Parameter Declarati
on

Data 
type

Memory area Description

REQ Input BOOL I, Q, M, D, L or 
constant

REQ= 1: Request to create the DB

LOW_LIMIT Input UINT I, Q, M, D, L or 
constant

Low limit of the area ### used by "CREATE_DB" to assign a 
number to your DB 60000)

UP_LIMIT Input UINT I, Q, M, D, L or 
constant

High limit of the area ### used by "CREATE_DB" to assign a 
number to your DB (largest possible DB number: 60999)
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Parameter Declarati
on

Data 
type

Memory area Description

COUNT Input UDINT I, Q, M, D, L or 
constant

The count value specifies the number of bytes which you want 
to reserve for the DB generated. The number of bytes must be 
an even number. The maximum length is 65534 bytes.

ATTRIB Input BYTE I, Q, M, D, L or 
constant

The first 4 bits of the byte at the ATTRIB parameter define the 
properties of the data block:
● Bit 0 = 0: DB only in the work memory
● Bit 0 = 1: DB only in the load memory
● Bit 1 = 0: DB is not write-protected.
● Bit 1 = 1: DB is write-protected
● Bit 2 = 0: DB is retentive (only for DBs generated in the load 

memory)
● Bit 2 = 1: DB is not retentive
● Bit 3= 0: DB generated either in load or in work memory
● Bit 3= 1: DB generated both in load and in work memory
To ensure compatibility with STEP7 V5.x, bits 1 and 3 must be 
used in combination:
Bit 0 Bit 3 DB generation
0 0 In work memory only
1 0 In load memory only
0 1 Work and load memory
1 1 Work and load memory
● Bit 4 = 0 - No start values specified (input values at the 

SRCBLK parameter will be ignored).
● Bit 4 = 1 - Specify start values (values correspond to the DB 

addressed by the SRCBLK parameter).
SRCBLK Input VARIAN

T
D Pointer to the data block whose values will be used to initialize 

the data block to be generated.
RET_VAL Return INT I, Q, M, D, L Error information
BUSY Output BOOL I, Q, M, D, L BUSY= 1: The process is not yet complete.
DB_NUM Output DB_DY

N (UINT)
I, Q, M, D, L Number of the DB created.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error
0081 The target range is greater than the source range. 

The complete source range is written to the target range. The remaining bytes of the target range are filled 
with 0.

7000 First call with REQ = 0: No data transfer active; BUSY has the value "0".
7001 First call with REQ = 1: Data transfer triggered; BUSY has the value "1".
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Error code*
(W#16#...)

Description

7002 Intermediate call (REQ 
irrelevant): Data transfer already active; BUSY has the value "1".

8081 The source range is larger than the target range. 
The complete target range is written. The remaining bytes of the source range are ignored.

8092 The "Create data block" function is currently unavailable because
● The "Compress user memory" function is currently active.
● The maximum number of blocks on your CPU has already been reached.

8093 No data block or a data block that is not in the work memory is specified for the SRCBLK parameter.
8094 A not yet supported attribute was specified for the ATTRIBparameter.
80A1 DB number error:

● The number is "0"
● Low limit > high limit

80A2 DB length error:
● The length is "0"
● The length is an odd number
● The length is greater than permitted by the CPU

80A3 The data block at the SRCBLK parameter was not created with standard access.
80B1 There is no DB number free.
80B2 Not enough work memory.
80B4 The memory card is write-protected.
80BB Not enough load memory.
80C0 The destination is currently being processed by another instruction or a communication function.
80C1 A DB with this DB number is currently being deleted.
80C3 The maximum number of simultaneously active "CREATE_DB" instructions has already been reached.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

READ_DBL: Read from data block in the load memory

Description
With the instruction you copy a DB or an area of a DB in load memory (Micro Memory Card) 
to the data area of a destination DB. The destination DB must be relevant for execution; that 
is, it must not be created with the attribute UNLINKED. The content of the load memory is not 
changed during the copy process.

To ensure data consistency, you must not change the target range while "READ_DBL" is being 
executed (i.e., as long as the BUSY parameter has the value TRUE).

The following restrictions apply to the SRCBLK and DSTBLK parameters (source and 
destination blocks):
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● You must be able to divide the length of the VARIANT pointer by eight.

● For a VARIANT pointer of type STRING, the length must be equal to 1.

● The source and destination block must have been created with the same block access, i.e. 
both must use either the access type "Optimized" or "Standard".

 

  Note

""READ_DBL" is processed asynchronously. Therefore, it is not suitable for frequent (or 
cyclical) reading of tags in the load memory. 

Once started, a job is always completed. If the maximum number of simultaneously active 
"READ_DBL" instructions is reached and you call "READ_DBL" once again at this time in 
a priority class having higher priority, error code W#16#80C3 will be returned. 
Consequently it does not make sense to restart the high-priority job right away.

 

Functional description
The "READ_DBL" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the job by calling "READ_DBL" with REQ = 1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852) 

Parameters
The following table shows the parameters of the "READ_DBL" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Read request

SRCBLK Input VARIANT D Pointer to data block in the load memory that 
is to be read from

RET_VAL Return INT I, Q, M, D, L Error information
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The reading process is not yet 

complete.
DSTBLK Output VARIANT D Pointer to the data block in the work memory 

that is to be written to

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".
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Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error
0081 The target range is greater than the source range. The source range is written completely to the target 

range; the remaining bytes of the target range will not be changed.
7000 First call with REQ = 0: No data transfer active; BUSY  has the value "0".
7001 First call with REQ=1: Data transfer triggered; BUSY has the value "1".
7002 Intermediate call (REQ  

irrelevant): Data transfer already active; BUSY has the value "1".
8081 The source range is larger than the target range. 

The complete target range is written. The remaining bytes of the source range are ignored.
8082 Destination DB type different from source DB type (optimized/standard access).
8093 No data block or a data block that is not in the work memory is specified for the DSTBLK  parameter.
80B1 No data block is specified for the SRCBLK  parameter, or the data block specified there is not a load 

memory object.
80B4 DB with F-attribute must not be read.
80C3 The maximum number of simultaneously active "READ_DBL" instructions has already been reached.
80C0 The destination DB is currently being processed by another instruction or a communication function.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
GET_ERR_ID: Get error ID locally (Page 2578)

WRIT_DBL: Write to data block in the load memory

Description
The instruction "WRIT_DBL" is used to transfer the contents of a DB or a DB area from the 
work memory to a DB or a DB area in the load memory (Micro Memory Card). The source DB 
must be relevant for execution, which means it must not be created with the attribute 
UNLINKED.

To ensure data consistency, it is not permitted to change the source range while "WRIT_DBL" 
is being executed (i.e., as long as the BUSY parameter has the value TRUE).

The following restrictions apply to the SRCBLK and DSTBLK parameters (source and 
destination blocks):

● For a VARIANT pointer of type BOOL, the length must be divisible by 8.

● For a VARIANT pointer of type STRING, the length must be equal to 1.

●  The source and destination block must have been created with the same block access, 
i.e. both must use either the access type "Optimized" or "Standard - compatible with 
S7-300/400".
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The "WRIT_DBL" instruction does not change the checksum of the user program if you write 
a DB that was created using an instruction. However, when a loaded DB is written, the first 
entry in this DB changes the checksum of the user program.

 

 Note

"WRIT_DBL" is not suitable for frequent (or cyclical) writing of tags in the load memory. This 
is because the Micro Memory Card technology limits the number of write accesses that can 
be made to a Micro Memory Card.

 

Functional description
The "WRIT_DBL" instruction works asynchronously, that is, its execution extends over multiple 
calls. You start the job by calling "WRIT_DBL" with REQ=1.

The output parameters RET_VAL and BUSY indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

Parameters
The following table shows the parameters of the instruction "WRIT_DBL":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
REQ = 1: Write request

SRCBLK Input VARIANT D Pointer to the DB in the work memory that is 
to be read from

RET_VAL Return INT I, Q, M, D, L Error information
BUSY Output BOOL I, Q, M, D, L BUSY = 1: The writing process is not yet 

completed.
DSTBLK Output VARIANT D Pointer to the data block in the load memory 

that is to be written to

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Description

0000 No error
0081 The target range is greater than the source range. The source range is written completely to the target 

range; the remaining bytes of the target range will not be changed.
7000 First call with REQ = 0: No data transfer active; BUSY has the value "0".
7001 First call with REQ = 1: Data transfer triggered; BUSY has the value "1".
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Error code*
(W#16#...)

Description

7002 Intermediate call (REQ 
irrelevant): Data transfer already active; BUSY has the value "1".

8081 The source range is larger than the target range.
The complete target range is written. The remaining bytes of the source range are ignored.

8082 Destination DB type different from source DB type (optimized/non-optimized access).
8092 Incorrect operating mode: While "WRIT_DBL" was active, the CPU went into STOP mode. This error code 

is supplied at the next transition to RUN. Call "WRIT_DBL" again.
8093 No data block or a data block that is not in the work memory is specified for the SRCBLK parameter.
80B1 No data block has been specified for the DSTBLK parameter, or the data block specified there is not a 

load memory object.
80B4 ● DB with F-attribute must not be read.

● The memory card is write-protected.
80BB Insufficient load memory available.
80C3 The maximum number of simultaneously active "WRIT_DBL" instructions has already been reached.
80C0 The destination DB is currently being processed by another instruction or a communication function.
General error 
codes

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

ATTR_DB: Read data block attribute

Description
You use the instruction "ATTR_DB" to obtain information about a data block (DB) located in 
the work memory of the CPU. The instruction determines the attributes set at the ATTRIB 
parameter for the DB selected.

The length cannot be read out for data blocks with optimized access, the DB_LENGH 
parameter contains the length "0" for DBs with optimized access.

Data blocks for Motion Control cannot be read out with the "ATTR_DB" instruction. The error 
code 80B2 is output for this.

Parameters
The following table shows the parameters of the "ATTR_DB" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or constant REQ  = 1: Read request for block attributes
DB_NUMBE
R

Input DB_ANY 
(UINT)

I, Q, M, D, L or constant Number of the DB to be tested

RET_VAL Output INT I, Q, M, D, L Error information
DB_LENGTH Output UDINT I, Q, M, D, L Number of data bytes which the selected DB 

contains.
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Parameter Declaration Data type Memory area Description
ATTRIB Output BYTE I, Q, M, D, L DB properties:

● Bit 0*= 0: LINKED - The DB only exists in the work 
memory

● Bit 0*= 1: UNLINKED - The DB only exists in the 
load memory

● Bit 1 = 0: READ_ONLY - The DB is not write-
protected.

● Bit 1 = 1: READ_ONLY - The DB is write-protected.
● Bit 2 = 0: RETAIN - The DB is retentive.
● Bit 2 = 1: NON_RETAIN - The DB is not retentive.
● Bit 3*= 0: The DB exists either in the load or the 

work memory
● Bit 3*= 1: The DB is generated in both the load and 

the work memory
* The relationship between bit 0 and bit 3 is explained in the parameters of the instruction "CREATE_DB: Create data 
block (Page 2912)".

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
80A1 Error in input parameter DB_NUMBER: the actual parameter selected

● Is "0"
● Is greater than the maximum permitted DB number for the CPU used.

80B1 The DB with the specified number does not exist on the CPU.
80B2 Data blocks of Motion Control technology objects cannot be read out with the "ATTR_DB" instruction.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

DELETE_DB: Delete data block

Description
You use the instruction "DELETE_DB" to delete a data block (DB) that was created from the 
user program by calling the instruction "CREATE_DB (Page 2912)". 

If the data block was not created with "CREATE_DB", the error code W#16#80B5 is output at 
the RET_VAL parameter.

The DB to be deleted may not be located in the current or in a lower priority class. Otherwise, 
the CPU starts OB 121 when the "DELETE_DB" instruction is called. If OB 121 is not present, 
the CPU switches to STOP mode. The instruction "DELETE_DB" can be interrupted by higher 
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priority classes. If the instruction is called again there, then this second call will be aborted and 
W#16#8091 will be entered in RET_VAL .

Parameters
The following table shows the parameters of the "DELETE_DB" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or constant REQ =1: Request to delete the DB with the 

number in parameter DB_NUMBER
DB_NUMBER Input UINT I, Q, M, D, L or constant Number of the DB to be 

deleted
RET_VAL Output INT I, Q, M, D, L Error information (see "RET_VAL parameter")
BUSY Output BOOL I, Q, M, D, L BUSY= 1: The process is not yet complete.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8091 "DELETE_DB" calls were nested and the maximum nesting level of the CPU used was exceeded.
8092 The instruction can currently not be executed because:

● The "Compress user memory" function is currently active.
● You are copying the DB to be deleted from the CPU to an offline project.

80A1 Error in input parameter DB_NUMBER:
● The value at the parameter is "0".
● The value at the parameter is greater than the maximum permitted DB number for the CPU used.

80B1 The DB with the specified number does not exist on the CPU.
80B4 The DB cannot be deleted because the memory card of the CPU is write-protected.
80B5 The DB was not created using "CREATE_DB".
80BB Not enough load memory.
80C1 The "Delete a DB" function cannot be executed at this time due to a temporary resource bottleneck.
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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9.7.3.13 Addressing

Instructions for address conversion

Description
There are different options for addressing a module (IO address, hardware identifier, slot). 

You can convert the address data with the following instructions:

● GEO2LOG: Determine hardware identifier from slot (Page 2922)

● LOG2GEO: Determine slot from hardware identifier (Page 2924)

● LOG2MOD: Determine the hardware identifier from addressing of STEP 7 V5.5 SPx 
(Page 2925)

● IO2MOD: Determine hardware identifier from an IO address (Page 2926)

● RD_ADDR: Determine IO addresses from the hardware identifier (Page 2927)

The following instructions are supported in addition for migrated projects:

● GEO_LOG: Determine hardware identifier from slot (Page 2929)

● LOG_GEO: Determine slot from hardware identifier (Page 2930)

● RD_LGADR: Determine IO addresses from the hardware identifier (Page 2932)

● GADR_LGC: Determine hardware identifier from slot and offset in the user data address 
area (Page 2933)

● LGC_GADR: Determine slot from hardware identifier (Page 2934)
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Type of address conversion
The figure below shows which instruction runs which address conversion.

GEO2LOG: Determine hardware identifier from slot

Description
You use the "GEO2LOG" instruction to determine hardware identifier based on slot information 
that you define using the system data type GEOADDR.

Depending on the type of hardware you define at the parameter HWTYPE the following 
information is evaluated from the other parameters GEOADDR:

● With HWTYPE = 1 (PROFINET IO system): 

– Only IOSYSTEM is evaluated. The other parameters of GEOADDR are not taken into 
consideration. 

– The hardware identifier of the PROFINET IO system is output. 

● With HWTYPE = 2 (PROFINET IO device): 

– IOSYSTEM and STATION are evaluated. The other parameters of GEOADDR are not 
taken into consideration. 

– The hardware identifier of the PROFINET IO device is output.

● With HWTYPE = 3 (rack):

– Only IOSYSTEM and STATION are evaluated. The other parameters of GEOADDR are 
not taken into consideration. 

– The hardware identifier of the rack is output.
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● With HWTYPE = 4 (module):

– IOSYSTEM, STATION and SLOT are evaluated. The SUBSLOT parameter of 
GEOADDR is not taken into consideration. 

– The hardware identifier of the module is output.

● With HWTYPE = 5 (submodule):

– All parameters of GEOADDR are evaluated.

– The hardware identifier of the submodule is output.

The AREA parameter of the GEOADDR system data type is not evaluated.

Parameter
The following table shows the parameters of the "GEO2LOG" instruction:

Parameter Declaration Data type Memory area Description
GEOADDR Input VARIANT D, L Pointer to the structure of the GEOADDR 

system data type.
The system data type contains the slot 
information from which the hardware ID is 
determined.
See also: System data type GEOADDR 
(Page 2928)

RET_VAL Return INT I, Q, M, D, L Output of error information.
LADDR Output HW_ANY I, Q, M, D, L Hardware identifier of the assembly or the 

module.
The number is automatically assigned and is 
stored in the properties in the hardware 
configuration.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8091 Invalid value for in GEOADDR for HWTYPE.
8094 Invalid value for in GEOADDR for IOSYSTEM.
8095 Invalid value for in GEOADDR for STATION.
8096 Invalid value for in GEOADDR for SLOT.
8097 Invalid value for in GEOADDR for SUBSLOT.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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See also
Instructions for address conversion (Page 2921)

LOG2GEO: Determine slot from hardware identifier

Description
You use the "LOG2GEO" instruction to determine the module slot belonging to a hardware 
identifier.

Parameters
The following table shows the parameters of the "LOG2GEO" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_ANY I, Q, M, D, L or 

constant
Hardware identifier of the module whose slot 
you want to find.
The hardware ID is assigned automatically 
and is stored in the properties of the module in 
the hardware configuration and the system 
constants.

RET_VAL Output INT I, Q, M, D, L Output of error information.
GEOADDR InOut VARIANT D Pointer to the GEOADDR system data type.

The slot information is written in the system 
data type GEOADDR.
See also: System data type GEOADDR 
(Page 2928) 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8090 The address specified at the LADDR parameter is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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LOG2MOD: Determine the hardware identifier from addressing of STEP 7 V5.5 SPx

Description 
You use the "LOG2MOD" instruction to determine the hardware identifier for an IO (sub)module 
from the addressing of STEP 7 5.5 SPx (IO data address or diagnostic address).

The hardware identifier is used at the LADDR input parameter for addressing of various 
instructions. You can convert the addressing parameters from STEP 7 5.5 SPx by calling 
"LOG2MOD" beforehand.

Parameter
The following table shows the parameters of the "LOG2MOD" instruction:

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or 

constant
Identifier of the address area as in STEP 7 5.5 
SPx:
● B#16#00: Bit15 of ADDR specifies whether 

an input (Bit15=0) or output address 
(Bit15=1) exists.

● B#16#54= Peripheral input (PI)
● B#16#55= Peripheral output (PQ)

ADDR Input WORD I, Q, M, D, L or 
constant

Logical address of the IO data of the module 
as offset (corresponding addressing in STEP 
7 5.5 SPx) or diagnostic address.

RET_VAL Return INT I, Q, M, D, L Error code of the instruction.
HWID Output HW_IO I, Q, M, D, L Determined hardware identifier (logical 

address) of the IO (sub)module.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8093 ● Specified address is not used by any hardware components.

● Specified value at IOID parameter is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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IO2MOD: Determine hardware identifier from an IO address

Description
The "IO2MOD" instruction determines the hardware identifier of the module from an IO address 
(I, Q, PI, PQ) of a (sub)module.

Enter the IO address at the ADDR parameter. If a series of IO addresses is used at this 
parameter, only the first address is evaluated to determine the hardware identifier. If the first 
address is correctly specified, the length for the address specification at the ADDR is of no 
significance. If an address area is used that encompasses several modules or non-used 
addresses, the hardware  identifier of the first module can also be determined.

If no IO address of a sub(module) is specified at the ADDR parameter, the error code 8090 is 
output at the RET_VAL parameter.

 

 Note
Input of IO address in SCL

You cannot program using the IO access ID "%QWx:P" in SCL. In this case, use the symbolic 
tag name or the absolute address in the process image.

 

Parameters
The following table shows the parameters of the "IO2MOD" instruction:

Parameter Declaration Data type Memory area Description
ADDR Input VARIANT I, Q, M, D, L IO address (I, Q, PI, PQ) within a (sub)module.

Make sure that slice access is not used for the 
parameter ADDR. If this is the case, incorrect 
values are output at the LADDR parameter.

RET_VAL Return INT I, Q, M, D, L Error code of the instruction.
LADDR Output HW_IO I, Q, M, D, L Determined hardware identifier (logical 

address) of the IO (sub)module.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

RET_VAL parameter

Error code* 
(W#16#...)

Explanation

0  No error occurred.
8090 IO address specified at ADDR parameter is not used by any hardware component.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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RD_ADDR: Determine IO addresses from the hardware identifier

Description
The "RD_ADDR" instruction determines the length and the start address of the inputs or 
outputs based on the hardware identifier of a sub(module).

● Use the LADDR parameter to select the input or output module based on the hardware 
identifier.

● The following output parameters are used depending on whether it is an input module or 
output module:

– In the case of an input module the determined values are output at the PIADDR and 
PICOUNT parameters.

– In the case of an output module the determined values are output at the PQADDR and 
PQCOUNT parameters.

● The PIADDR and PQADDR parameters each contain the start address of the I/O addresses 
of the module.

● The PICOUNT and PQCOUNT parameters each contain the number of bytes of the inputs 
our outputs (1 byte for 8 inputs/outputs, 2 bytes for 16 inputs/outputs).

 

 Note
Addressing packed modules

If packed modules (not the first module of the packed module group) are addressed, the 
displayed data deviates from the hardware configuration. "0" is returned for PIADDR or 
PQADDR and PICOUNT or PQCOUNT. RET_VAL does not indicate an error (16#0000).

 

Parameters
The following table shows the parameters of the "RD_ADDR" instruction:

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, D, L or 

constant
Hardware identifier of the (sub)module.

RET_VAL Return INT I, Q, M, D, L Error code of the instruction.
PIADDR Output UDINT I, Q, M, D, L Start address of the input module.
PICOUNT Output UINT I, Q, M, D, L Number of bytes of the inputs.
PQADDR Output UDINT I, Q, M, D, L Start address of the output module.
PQCOUNT Output UINT I, Q, M, D, L Number of bytes of the outputs.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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Parameter RET_VAL

Error code* 
(W#16#...)

Explanation

0 No error occurred.
8090 Hardware identifier of the module at the LADDR parameter is invalid.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

System data type GEOADDR

Geographical address
The system data type GEOADDR contains the geographical address of a module, i.e. the slot 
information.

● Geographical address for PROFINET IO
For PROFINET IO the geographical address was composed of the ID of the PROFINET 
IO system, the device number, the slot number and the submodule (if a sub-module is used).

● Geographical address for PROFIBUS DP
For PROFIBUS DP, the geographical address consists of the ID of the DP master system, 
the station number and the slot number.

The slot information of the modules can be found in the hardware configuration of each module.

System data type GEOADDR
The structure GEOADDR is automatically created if you enter "GEOADDR" as the data type 
in a data block.

The system data type GEOADDR has the following structure:

Parameter name Data type Description
GEOADDR STRUCT  
 HWTYPE UINT Hardware type:

● 1: IO system (PROFINET/PROFIBUS)
● 2: IO device/DP slave
● 3: Rack
● 4: Module
● 5: Submodule
If a hardware type is not supported by the instruction, a HWTYPE "0" is output.

AREA UINT Area ID: 
● 0 = CPU
● 1 = PROFINET IO
● 2 = PROFIBUS DP
● 3 = AS-i

IOSYSTEM UINT PROFINET IO system (0=central unit in the rack)
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Parameter name Data type Description
STATION UINT ● Number of the rack if area identifier AREA = 0 (central module).

● Station number if area identifier AREA > 0.
SLOT UINT Slot number
SUBSLOT UINT Number of the submodule. This parameter has the value "0" if no submodule is 

available or can be plugged.

Other

GEO_LOG: Determine hardware identifier from slot

Description
The corresponding module slot of a signal module is known. Use the "GEO_LOG" instruction 
to determine the corresponding hardware identifier of the module from this.

Parameters
The following table shows the parameters of the instruction "GEO_LOG":

Parameter Declaration Data type Memory area Description
MASTER Input INT I, Q, M, D, L or 

constant
Area ID:
● 0, if the slot is located in a centralized 

configuration.
● 1 to 32: DP master system ID of the 

associated field device if the slot is located 
in a field device on PROFIBUS

● 100 to 115: PROFINET IO system ID of the 
associated field device if the slot is located 
in a field device on PROFINET

STATION Input INT I, Q, M, D, L or 
constant

● If MASTER = 0: Number of the rack
● If MASTER > 0: Station number of the field 

device
SLOT Input INT I, Q, M, D, L or 

constant
Slot number

SUBSLOT Input INT I, Q, M, D, L or 
constant

The parameter SUBSLOT is not evaluated by 
the instruction.

RET_VAL Return INT I, Q, M, D, L Error information
LADDR Output HW_IO I, Q, M, D, L Hardware identifier of the module

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8094 No subnet was configured with the specified SUBNETID .
8095 Illegal value for STATION parameter
8096 Illegal value for SLOT parameter
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2921)

LOG_GEO: Determine slot from hardware identifier

Description
You use the "LOG_GEO" instruction to determine the module slot belonging to a hardware 
identifier.

Parameters
The following table shows the parameters of the instruction "LOG_GEO":

Parameter Declaration Data type Memory area Description
LADDR Input HW_IO I, Q, M, D, L or constant Hardware identifier of the module for 

which the slot is to be determined.
RET_VAL Return INT I, Q, M, D, L Error information
AREA Output INT I, Q, M, D, L Area ID: indicates how the remaining 

output parameters are to be interpreted:
● 0: central device
● 2: PROFIBUS DP / PROFINET IO
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Parameter Declaration Data type Memory area Description
MASTER Output INT I, Q, M, D, L With AREA = 0:

● 0: If the slot is located in one of the 
racks (central device).

With AREA = 2:
● 1 to 32: DP master system ID of the 

associated field device if the slot is 
located in a field device on 
PROFIBUS

● 100 to 115: PROFINET IO system ID 
of the associated field device if the 
slot is located in a field device on 
PROFINET

STATION Output INT I, Q, M, D, L ● With MASTER = 0: Number of the rack
● With MASTER > 0: Station number of 

the field device
SLOT Output INT I, Q, M, D, L Slot number
SUBSLOT Output INT I, Q, M, D, L The SUBSLOT parameter is not output 

by the instruction (always "0").
OFFSET Output INT I, Q, M, D, L The OFFSET parameter is not output by 

the instruction (always "0").

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Specified logical address invalid
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2921)
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RD_LGADR: Determine IO addresses from the hardware identifier

Description
Based on the hardware identifier, you can determine the logical addresses of a module, a 
central submodule or a submodule for PNIO with the "RD_LGADR" instruction.

● You can specify the hardware ID of the submodule at the LADDR parameter.

● The addresses are written to the PEADDR and PAADDR parameters is ascending order.

– For an input module, only the PEADDR parameter is written. For an output module, the 
PAADDR parameter is written.

– An Array of WORD is used to store the addresses in each case. 

● The number of addresses is output at the PECOUNT parameter (for an input module) and 
PACOUNT parameter (for an output module).

Parameters
The following table shows the parameters of the instruction "RD_LGADR":

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or constant Address area identifier:

● B#16#54 = Peripheral input (PI)
● B#16#55  = Peripheral output (PQ)

LADDR Input HW_ANY I, Q, M, D, L or constant Hardware identifier of the module or the 
submodule.

RET_VAL Return INT I, Q, M, D, L Error information
PEADDR Output ANY I, Q, M, D, L Field for the PI addresses with the Array of 

WORD data type
PECOUNT Output INT I, Q, M, D, L Number of returned PI addresses
PAADDR Output ANY I, Q, M, D, L Field for the PQ addresses with the Array of 

WORD data type
PACOUNT Output INT I, Q, M, D, L Number of returned PQ addresses

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

RET_VAL parameter

Error code
(W#16#...)

Explanation

0000 No error occurred.
8090 Specified logical address invalid or illegal value for the IOID parameter.
80A0 Error in the output parameter PEADDR: The data type of the array elements is 

not WORD.
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Error code
(W#16#...)

Explanation

80A1 Error in the output parameter PAADDR: The data type of the array elements is 
not WORD.

80A2 Error in the output parameter PEADDR: The specified array could not 
accommodate all the logical addresses.

80A3 Error in the output parameter PAADDR: The specified array could not 
accommodate all the logical addresses.

General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

See also
Instructions for address conversion (Page 2921)

GADR_LGC: Determine hardware identifier from slot and offset in the user data address area

Description
You use the "GADR_LGC" instruction to determine the hardware identifier of a signal module. 
The hardware identifier is determined from the module slot and the offset in the user data 
address area of the module. 

If you use the "GADR_LGC" instruction on power modules or modules with packed addresses 
(ET 200S), then the diagnostics address will be returned.

Parameters
The following table shows the parameters of the instruction "GADR_LGC":

Parameter Declaration Data type Memory area Description
SUBNETID Input BYTE I, Q, M, D, L or constant Area ID:

● 0: If the slot is located in the central 
module

● 1 to 32: DP master system ID of the 
corresponding distributed I/O system if 
the slot is in a 
distributed I/O device.

● 100 to 115: PROFINET IO system ID of 
the associated field device if the slot is 
located in a field device on PROFINET

RACK Input WORD I, Q, M, D, L or constant ● Number of the rack, if area identifier is 0
● Device number of the distributed I/O 

device if the area identifier > 0
SLOT Input WORD I, Q, M, D, L or constant Slot no.
SUBSLOT Input BYTE I, Q, M, D, L or constant Sub-module slot (if no sub-module can be 

inserted, 0 must be entered here)
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Parameter Declaration Data type Memory area Description
SUBADDR Input WORD I, Q, M, D, L or constant Offset in the user data address area of the 

module
RET_VAL Return INT I, Q, M, D, L Error information
IOID Output BYTE I, Q, M, D, L The IOID output parameter is not written 

(always "0").
LADDR Output HW_MODUL

E
I, Q, M, D, L Hardware identifier of the module

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8093 Illegal value for SUBNETID parameter
8094 No subnet was configured with the specified SUBNETID .
8095 Illegal value for RACK parameter.
8096 Illegal value for SLOT parameter.
8097 Illegal value for SUBSLOT parameter.
8098 Illegal value for SUBADDR parameter.
8099 The slot is not configured.
809A The sub-address of the selected slot is not configured (only possible with central I/O for CPU and IM).
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2921)

LGC_GADR: Determine slot from hardware identifier

Description
You use the "LGC_GADR" instruction to determine the module slot belonging to a hardware 
identifier.

 

 Note

The "LGC_GADR" instruction cannot be used on a module with packed addresses (ET 200S).
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Parameters
The following table shows the parameters of the instruction "LGC_GADR":

Parameter Declaration Data type Memory area Description
IOID Input BYTE I, Q, M, D, L or constant Is not evaluated.
LADDR Input HW_MODUL

E
I, Q, M, D, L or constant Hardware identifier of the module

RET_VAL Return INT I, Q, M, D, L Error information
AREA Output BYTE I, Q, M, D, L Area ID: indicates how the remaining output 

parameters are to be interpreted:
● 0: Central module
● 2: PROFIBUS DP

RACK Output WORD I, Q, M, D, L Rack number:
● With central module AREA= 0):

– Rack number
● For PROFIBUS DP (AREA=2):

– Low byte: Station number
– High byte: DP master system ID

SLOT Output WORD I, Q, M, D, L Slot number:
● With central module AREA= 0):

– Slot number
● For PROFIBUS DP (AREA=2):

– Slot no. in the station
SUBADDR Output WORD I, Q, M, D, L Is not output (always "0").

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter RET_VAL

Error code*
(W#16#...)

Explanation

0000 No error occurred.
8090 Specified logical address invalid or illegal value for the IOID parameter.
8093 This instruction is not permitted for the module selected by the parameters IOID and LADDR .
General error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080) 

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
Instructions for address conversion (Page 2921)
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9.7.4 Technology

9.7.4.1 S7-1200 Motion Control

S7-1200 Motion Control V4

MC_Power

MC_Power: Enable, disable axis V4

Description
The Motion Control instruction "MC_Power" enables or disables an axis.   

Requirements
● The positioning axis technology object has been configured correctly.

● There is no pending enable-inhibiting error.

Override response
Execution of "MC_Power" cannot be aborted by a Motion Control command.

Disabling the axis (input parameter "Enable" = FALSE) aborts all Motion Control commands 
for the associated technology object in accordance with the selected "StopMode".

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis - Axis technology object
Enable INPUT BOOL FALSE TRUE The axis is enabled. 

FALSE All current jobs are interrupted in accordance with 
the "StopMode" configured. The axis is stopped 
and disabled.

StopMode INPUT INT 0 0 Emergency stop
If a request to disable the axis is pending, the axis 
brakes at the configured emergency stop 
deceleration. The axis is disabled after reaching 
standstill.

1 Immediate stop
If a request to disable the axis is pending, this axis 
is disabled without deceleration. The pulse output 
is stopped immediately.
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Parameter Declaration Data type Default value Description
2 Emergency stop with jerk control

If a request to disable the axis is pending, the axis 
brakes at the configured emergency stop 
deceleration. If the jerk control is activated, the 
configured jerk is taken into account. The axis is 
disabled after reaching standstill.

Status OUTPUT BOOL FALSE Status of axis enable
FALSE The axis is disabled.

The axis does not execute Motion Control 
commands and does not accept any new 
commands (exception: MC_Reset command).
The axis is not homed.
Upon disabling, the status does not change to 
FALSE until the axis reaches a standstill.

TRUE The axis is enabled.
The axis is ready to execute Motion Control 
commands.
Upon axis enabling, the status does not change to 
TRUE until the signal "Drive ready" is pending. If 
the "Drive ready" drive interface was not configured 
in the axis configuration, the status changes to 
TRUE immediately.

Busy OUTPUT BOOL FALSE TRUE "MC_Power" is active.
Error OUTPUT BOOL FALSE TRUE An error occurred in Motion Control instruction 

"MC_Power" or in the associated technology 
object. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

 

 Note

If the axis is switched off due to an error, it will be enabled again automatically after the error 
has been eliminated and acknowledged. This requires that the input parameter "Enable" has 
retained the value TRUE during this process.

 

Enabling an axis with configured drive interface
To enable the axis, follow these steps:

1. Check the requirements indicated above.

2. Initialize input parameter "StopMode" with the desired value. Set the input parameter 
"Enable" to TRUE.
The enable output for "Drive enabled" changes to TRUE to enable the power to the drive. 
The CPU waits for the "Drive ready" signal of the drive.
When the "Drive ready" signal is available at the configured ready input of the CPU, the 
axis is enabled. Output parameter "Status" and tag of technology object <Axis 
name>.StatusBits.Enable indicate the value TRUE.
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Enabling an axis without configured drive interface
To enable the axis, follow these steps:

1. Check the requirements indicated above.

2. Initialize input parameter "StopMode" with the desired value. Set the input parameter 
"Enable" to TRUE. The axis is enabled. The output parameter "Status" and the tag of the 
technology object <Axis name>.StatusBits.Enable indicate the value TRUE.

Disabling an axis
To disable an axis, you can follow the steps described below:

1. Bring the axis to a standstill.
You can identify when the axis is at a standstill in the tag of the technology object <Axis 
name>.StatusBits.StandStill.

2. Set input parameter "Enable" to FALSE after standstill is reached.

3. If output parameters "Busy" and "Status" and tag of technology object <Axis 
name>.StatusBits.Enable indicate the value FALSE, disabling of the axis is complete.

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_Power: Function chart V4 (Page 2939)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)
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MC_Power: Function chart V4

Function chart 

① An axis is enabled and then disabled again. When the drive has signaled "Drive ready" back to the CPU, the successful 
enable can be read out via "Status_1".

② Following an axis enable, an error has occurred that caused the axis to be disabled. The error is eliminated and 
acknowledged with "MC_Reset". The axis is then enabled again.

See also
MC_Power: Enable, disable axis V4 (Page 2936)
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MC_Reset

MC_Reset: Acknowledge fault V4

Description
Motion Control instruction "MC_Reset" can be used to acknowledge "Operating error with axis 
stop" and "Configuration error". The errors that require acknowledgement can be found in the 
"List of ErrorIDs and ErrorInfos" under "Remedy".   

The axis configuration can be downloaded to the work memory after a download in RUN 
operating mode.

Requirements
● The positioning axis technology object has been configured correctly.

● The cause of a pending configuration error requiring acknowledgement has been eliminated 
(for example, acceleration in positioning axis technology object has been changed to a valid 
value).

Override response
The MC_Reset command cannot be aborted by any other Motion Control command.

The new MC_Reset command does not abort any other active Motion Control commands.

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Restart INPUT BOOL FALSE TRUE Download the axis configuration from the load 

memory to the work memory. The command can 
only be executed when the axis is disabled.
Refer to the notes on Download to the CPU 
(Page 7870).

FALSE Acknowledges pending errors
Done OUTPUT BOOL FALSE TRUE Error has been acknowledged.
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"
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Acknowledging an error requiring acknowledgement with MC_Reset
To acknowledge an error, follow these steps:

1. Check the requirements indicated above.

2. Start the acknowledgement of the error with a rising edge at input parameter "Execute".

3. If output parameter "Done" indicates the value TRUE and tag of technology object <Axis 
name>.StatusBits.Error the value FALSE, the error has been acknowledged.

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

Download to CPU (Page 7870)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)
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MC_Home

MC_Home: Home axes, set reference point V4

Description
Motion Control instruction "MC_Home" is used to match the axis coordinates to the real, 
physical drive position. Homing is required for absolute positioning of the axis. The following 
types of homing can be executed:   

● Active homing (Mode = 3)
The homing procedure is executed automatically.

● Passive homing (Mode = 2)
During passive homing, the "MC_Home" Motion Control instruction does not carry out any 
homing motion. The traversing motion required for this must be implemented by the user 
via other Motion Control instructions. When the homing switch is detected, the axis is 
homed.

● Direct homing absolute (Mode = 0)
The current axis position is set to the value of parameter "Position".

● Direct homing relative (Mode = 1)
The current axis position is offset by the value of parameter "Position".

Requirements
● The positioning axis technology object has been configured correctly.

● The axis is enabled.

● No MC_CommandTable command may be active upon start with Mode = 0, 1, or 2.

Override response
The override response depends on the selected mode:

Mode = 0, 1

The MC_Home command cannot be aborted by any other Motion Control command.

The MC_Home command does not abort any active Motion Control commands. Position-
related motion commands are resumed after homing according to the new homing position 
(value at input parameter: "Position").

Mode = 2

The MC_Home command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 2, 3

The new MC_Home command aborts the following active Motion Control command:

● MC_Home command Mode = 2

Position-related motion commands are resumed after homing according to the new homing 
position (value at input parameter: "Position").
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Mode = 3

The MC_Home command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_Home command aborts the following active Motion Control commands:

● MC_Home command Mode = 2, 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Position INPUT REAL 0.0 ● Mode = 0, 2, and 3

Absolute position of axis after completion of the 
homing operation

● Mode = 1
Correction value for the current axis position

Limit values:
-1.0e12 ≤ Position ≤ 1.0e12

Mode INPUT INT 0 Homing mode
0 Direct homing (absolute)

New axis position is the position value of 
parameter "Position".

1 Direct homing (relative)
New axis position is the current axis 
position + position value of parameter 
"Position".
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Parameter Declaration Data type Default value Description
2 Passive homing

Homing according to the axis 
configuration. Following homing, the 
value of parameter "Position" is set as the 
new axis position.

3 Active homing
Homing procedure in accordance with the 
axis configuration. Following homing, the 
value of parameter "Position" is set as the 
new axis position.

Done OUTPUT BOOL FALSE TRUE Command completed
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was 

aborted by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

 

 Note

Axis homing is lost under the following conditions:
● Disabling of axis by the "MC_Power" Motion Control instruction
● Changeover between automatic mode and manual control
● Upon start of active homing. After successful completion of the homing operation, axis 

homing is again available.
● After POWER OFF -> POWER ON of the CPU
● After CPU restart (RUN-STOP -> STOP-RUN)

 

Homing an axis
To home the axis, follow these stops:

1. Check the requirements indicated above.

2. Initialize the necessary input parameters with values, and start the homing operation with 
a rising edge at input parameter "Execute"

3. If output parameter "Done" and technology object tag <Axis 
name>.StatusBits.HomingDone indicate the value TRUE, homing is complete.

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)
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MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)

MC_Halt

MC_Halt: Halt axes V4

Description
The "MC_Halt" Motion Control instruction stops all movements and brings the axis to a 
standstill with the configured deceleration. The standstill position is not defined.  

Requirements
● The positioning axis technology object has been configured correctly.

● The axis is enabled.

Override response
The MC_Halt command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_Halt command aborts the following active Motion Control commands:
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● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters  

Parameter Declaration Data type Default value Description
Axis INPUT TO_SpeedAxis - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Done OUTPUT BOOL FALSE TRUE Zero velocity reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_Halt: Function chart V4 (Page 2947)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)
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MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)

MC_Halt: Function chart V4

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 5.0
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① The axis is braked by an MC_Halt command until it comes to a standstill. The axis standstill is signaled via "Done_2".
② While an MC_Halt command is braking the axis, this command is aborted by another motion command. The abort is 

signaled via "Abort_2".

See also
MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute

MC_MoveAbsolute: Absolute positioning of axes V4

Description
The "MC_MoveAbsolute" Motion Control instruction starts an axis positioning motion to move 
it to an absolute position.   

Requirements
● The positioning axis technology object has been configured correctly.

● The axis is enabled.

● The axis is homed.

Override response
The MC_MoveAbsolute command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveAbsolute command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command
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● MC_MoveJog command

● MC_CommandTable command

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Positioning

Axis
- Axis technology object

Execute INPUT BOOL FALSE Start of the command with a positive edge
Position INPUT REAL 0.0 Absolute target position

Limit values: 
-1.0e12 ≤ Position ≤ 1.0e12

Velocity INPUT REAL 10.0 Velocity of axis
This velocity is not always reached on account of the 
configured acceleration and deceleration and the 
target position to be approached.
Limit values:
Start/stop velocity ≤ Velocity ≤ maximum velocity

Done OUTPUT BOOL FALSE TRUE Absolute target position reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_MoveAbsolute: Function chart V4 (Page 2950)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)
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MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)

MC_MoveAbsolute: Function chart V4

Function chart  
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The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0

① An axis is moved to absolute position 1000.0 with an MC_MoveAbsolute command. When the axis reaches the target 
position, this is signaled via "Done_1". When "Done_1" = TRUE, another MC_MoveAbsolute command, with target 
position 1500.0, is started. Because of the response times (e.g., cycle time of user program, etc.), the axis comes to a 
standstill briefly (see zoomed-in detail). When the axis reaches the new target position, this is signaled via "Done_2".

② An active MC_MoveAbsolute command is aborted by another MC_MoveAbsolute command. The abort is signaled via 
"Abort_1". The axis is then moved at the new velocity to the new target position 1500.0. When the new target position 
is reached, this is signaled via "Done_2".

See also
MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative

MC_MoveRelative: Relative positioning of axes V4

Description
The "MC_MoveRelative" Motion Control instruction starts a positioning motion relative to the 
start position.  

Requirements
● The positioning axis technology object has been configured correctly.

● The axis is enabled.

Override response
The MC_MoveRelative command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveRelative command aborts the following active Motion Control commands:
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● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters  

Parameter Declaration Data type Default value Description
Axis INPUT TO_Positioning

Axis
- Axis technology object

Execute INPUT BOOL FALSE Start of the command with a positive edge
Distance INPUT REAL 0.0 Travel distance for the positioning operation

Limit values: 
-1.0e12 ≤ Distance  ≤ 1.0e12

Velocity INPUT REAL 10.0 Velocity of axis
This velocity is not always reached on account of the 
configured acceleration and deceleration and the 
distance to be traveled.
Limit values:
Start/stop velocity ≤ Velocity ≤ maximum velocity

Done OUTPUT BOOL FALSE TRUE Target position reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_MoveRelative: Function chart V4 (Page 2954)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)
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MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)
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MC_MoveRelative: Function chart V4

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0
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① The axis is moved by an MC_MoveRelative command by the distance ("Distance") 1000.0. When the axis reaches the 
target position, this is signaled via "Done_1". When "Done_1" = TRUE, another MC_MoveRelative command, with travel 
distance 500.0, is started. Because of the response times (e.g., cycle time of user program, etc.), the axis comes to a 
standstill briefly (see zoomed-in detail). When the axis reaches the new target position, this is signaled via "Done_2".

② An active MC_MoveRelative command is aborted by another MC_MoveRelative command. The abort is signaled via 
"Abort_1". The axis is then moved at the new velocity by the new distance ("Distance") 500.0. When the new target 
position is reached, this is signaled via "Done_2".

See also
MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity

MC_MoveVelocity: Move axes at preset rotational speed V4

Description
The Motion Control instruction "MC_MoveVelocity" moves the axis constantly at the specified 
velocity.   

Requirements
● The positioning axis technology object has been configured correctly.

● The axis is enabled.

Override response
MC_MoveVelocity can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveVelocity command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command
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● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters 

Parameter Declaration Data type Default value Description
Axis INPUT TO_SpeedAxis - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Velocity INPUT REAL 10.0 Velocity specification for axis motion

Limit values:
Start/stop velocity ≤ |Velocity ≤ maximum velocity
(Velocity = 0.0 is permitted)

Direction INPUT INT 0 Direction specification
0 Direction of rotation corresponds to the sign 

of the value in parameter "Velocity"
1 Positive direction of rotation

(The sign of the value in parameter 
"Velocity" is ignored)

2 Negative direction of rotation
(The sign of the value in parameter 
"Velocity" is ignored)

Current INPUT BOOL FALSE Maintain current velocity
FALSE "Maintain current velocity" is deactivated. 

The values of parameters "Velocity" and 
"Direction" are used.

TRUE "Maintain current velocity" is activated. The 
values in parameters "Velocity" and 
"Direction" are not taken into account.
When the axis resumes motion at the 
current velocity, the "InVelocity" parameter 
returns the value TRUE.

InVelocity OUTPUT BOOL FALSE TRUE ● "Current" = FALSE:
The velocity specified in parameter 
"Velocity" was reached.

● "Current" = TRUE:
The axis travels at the current velocity at 
the start time.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"
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 Note
PLCopen Version 2.0

The Motion Control instruction "MC_MoveVelocity" is compatible to PLCopen Version 2.0 as 
of V4.

The "InVelocity" and "Busy" parameters show their status regardless of the "Execute" 
parameter until the command is overridden or stopped by an error. For more information, 
refer to the section " Tracking active commands (Page 7902).

 

Behavior with zero setpoint velocity (Velocity = 0.0)
An MC_MoveVelocity command with "Velocity" = 0.0 (such as an MC_Halt command) aborts 
active motion commands and stops the axis with the configured deceleration.

When the axis comes to a standstill, output parameter "InVelocity" indicates TRUE for at least 
one program cycle. 

"Busy" indicates the value TRUE during the deceleration process and changes to FALSE 
together with "InVelocity". If parameter "Execute" = TRUE is set, "InVelocity" and "Busy" are 
latched.

When the "MC_MoveVelocity" command is started, status bit "SpeedCommand" is set in the 
technology object. Status bit "ConstantVelocity" is set upon axis standstill. Both bits are 
adapted to the new situation when a new motion command is started.

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_MoveVelocity: Function chart V4 (Page 2958)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)
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MC_MoveVelocity: Function chart V4

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0

① An active MC_MoveVelocity command signals via "InVel_1" that its target velocity has been reached. It is then aborted 
by another MC_MoveVelocity command. The abort is signaled via "Abort_1". When the new target velocity 15.0 is 
reached, this is signaled via "InVel_2". The axis then continues moving at the new constant velocity.

② An active MC_MoveVelocity command is aborted by another MC_MoveVelocity command prior to reaching its target 
velocity. The abort is signaled via "Abort_1". When the new target velocity 15.0 is reached, this is signaled via "InVel_2". 
The axis then continues moving at the new constant velocity.
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See also
MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog

MC_MoveJog: Move axes in jog mode V4

Description
Motion control instruction "MC_MoveJog" moves the axis constantly at the specified velocity 
in jog mode. You use this Motion Control instruction, for example, for testing and 
commissioning purposes.   

Requirements
● The positioning axis technology object has been configured correctly.

● The axis is enabled.

Override response
The MC_MoveJog command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveJog command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command
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Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_SpeedAxis - Axis technology object
JogForward INPUT BOOL FALSE As long as the parameter is TRUE, the axis moves in 

the positive direction at the velocity specified in 
parameter "Velocity".

JogBackward INPUT BOOL FALSE As long as the parameter is TRUE, the axis moves in 
the negative direction at the velocity specified in 
parameter "Velocity".

If both parameters are simultaneously TRUE, the axis stops with the configured deceleration. An error is indicated in 
parameters "Error", "ErrorID", and "ErrorInfo".
Velocity INPUT REAL 10.0 Preset velocity for jog mode

Limit values:
Start/stop velocity ≤ velocity ≤ maximum velocity

InVelocity OUTPUT BOOL FALSE TRUE The velocity specified in parameter 
"Velocity" was reached.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_MoveJog: Function chart V4 (Page 2961)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)
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MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)

MC_MoveJog: Function chart V4

Function chart 

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 5.0

① The axis is moved in the positive direction in jog mode via "Jog_F". When the target velocity 50.0 is reached, this is 
signaled via "InVel_1". After "Jog_F" is reset, the axis is braked to a standstill.

② The axis is moved in the negative direction in jog mode via "Jog_B". When the target velocity -50.0 is reached, this is 
signaled via "InVel_1". 
When "Jog_B" is set, the value at parameter "Velocity" changes to 25.0. "InVel_1" is reset and the axis is braked. When 
the new target velocity -25.0 is reached, this is signaled via "InVel_1". After "Jog_B" is reset, the axis is braked to a 
standstill. 
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See also
MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable

MC_CommandTable: Run axis commands as motion sequence V4

Description
The Motion Control instruction "MC_CommandTable" combines multiple individual axis control 
commands in one movement sequence.   

Requirements
● The positioning axis technology object has been inserted and correctly configured.

● The command table technology object has been inserted and correctly configured.

● The axis is enabled.

Override response
The MC_CommandTable command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_CommandTable command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The active Motion Control command is cancelled by the start of the first "Positioning Relative", 
"Positioning Absolute", "Velocity set point" or "Halt" command.
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Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_SpeedAxis - Axis technology object
CommandTab
le

INPUT TO_CommandT
able

- Command table technology object

Execute INPUT BOOL FALSE Command table start with positive edge
StartStep INPUT INT 1 Defines the step at which the execution of the command 

table should begin
Limit values:
1 ≤ StartStep ≤ EndStep

EndStep INPUT INT 32 Defines the step up to which the execution of command 
table should take place
Limit values:
StartStep ≤ EndStep ≤ 32

Done OUTPUT BOOL FALSE TRUE Command table has been successfully executed
Busy OUTPU BOOL FALSE TRUE The command table is being executed.
CommandAb
orted

OUTPUT BOOL FALSE TRUE The command table was cancelled by another 
command.

Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 
command table. The cause of the error can be 
found in parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"
CurrentStep OUTPUT INT 0 Step in command table currently being executed
StepCode OUTPUT WORD 16#0000 User-defined numerical value / bit pattern of the step 

currently being executed

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)
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MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)

MC_ChangeDynamic

MC_ChangeDynamic: Change dynamic settings of axis V4

Description
Motion Control instruction "MC_ChangeDynamic" allows you to change the following settings 
of the axis:   

● Change the ramp-up time (acceleration) value

● Change the ramp-down time (deceleration) value

● Change the emergency stop ramp-down time (emergency stop deceleration) value

● Change the smoothing time (jerk) value

For the effectiveness of the change, refer to the description of the tag (Page 7938).

Requirements
The positioning axis technology object has been configured correctly.

Override response
A MC_ChangeDynamic command cannot be aborted by any other Motion Control command.

A new MC_ChangeDynamic command does not abort any active Motion Control commands.

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_SpeedAxis - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
ChangeRa
mpUp

INPUT BOOL FALSE TRUE Change ramp-up time in line with input parameter 
"RampUpTime"

RampUpTi
me

INPUT REAL 5.00 Time (in seconds) to accelerate axis from standstill to 
configured maximum velocity without jerk limit.
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Acceleration. For the effectiveness 
of the change, refer to the description of this tag.

ChangeRa
mpDown

INPUT BOOL FALSE TRUE Change ramp-down time to correspond to input 
parameter "RampDownTime"
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Parameter Declaration Data type Default value Description
RampDown
Time

INPUT REAL 5.00 Time (in seconds) to decelerate axis from the configured 
maximum velocity to standstill without jerk limiter.
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Deceleration . For the effectiveness 
of the change, refer to the description of this tag.

ChangeEm
ergency

INPUT BOOL FALSE TRUE Change emergency stop ramp-down time in line 
with input parameter "EmergencyRampTime"

Emergency
RampTime

INPUT REAL 2.00 Time (in seconds) to decelerate the axis from configured 
maximum velocity to standstill without jerk limiter in 
emergency stop mode. 
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.EmergencyDeceleration . For the 
effectiveness of the change, refer to the description of this 
tag.

ChangeJer
kTime

INPUT BOOL FALSE TRUE Change smoothing time according to the input 
parameter "JerkTime"

JerkTime INPUT REAL 0.25 Smoothing time (in seconds) used for the axis acceleration 
and deceleration ramps
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Jerk . For the effectiveness of the 
change, refer to the description of this tag.

Done OUTPUT BOOL FALSE TRUE The changed values have been written to the 
technology data block. The description of the tags 
will show when the change becomes effective.

Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 
command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

 

 Note

At the input parameters "RampUpTime", "RampDownTime", "EmergencyRampTime" and 
"JerkTime", values can be entered which exceed the admissible limits of the resulting 
parameters: "Acceleration", "Deceleration", "Emergency stop deceleration" and "Jerk".

Ensure that your inputs are within the valid range, taking into consideration the equations 
and limits in section "Dynamic (Page 7837)".

 

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

Changing the configuration of dynamics in the user program (Page 7843)

Changing the homing configuration in the user program (Page 7850)

Tags of the positioning axis technology object as of V4 (Page 7938)

MC_Power: Enable, disable axis V4 (Page 2936)
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MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

S7-1200 Motion Control V1...3 (Page 2969)

MC_ReadParam

MC_ReadParam: Continuously read motion data of a positioning axis V4

Description
Motion Control instruction "MC_ReadParam" enables continuous reading of motion data of an 
axis. The current value of the corresponding tag is determined at the start of the command.

The following motion data can be read:   

● Current position of the axis

● Current velocity of the axis

● Current distance of axis from target position

● Target position of the axis

Requirements
The positioning axis technology object has been configured correctly.

Override response
A MC_ReadParam command cannot be aborted by any other Motion Control command.

A new MC_ReadParam command does not abort any active Motion Control commands.
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Parameters   

Parameter Declaration Data type Default value Description
Enable INPUT BOOL FALSE TRUE Read the tag specified with the "Parameter" and 

store the value in the destination address specified 
with "Value".

FALSE Do not update assigned motion data
Parameter INPUT VARIANT 

(REAL)
- VARIANT pointer to the value to be read. The following tags 

are permitted: 
● <Axis name>.Position
● <Axis name>.Velocity
● <Axis name>.StatusPositioning.Distance
● <Axis name>.StatusPositioning.TargetPosition

Value INOUT VARIANT 
(REAL)

- VARIANT pointer to the target tag or destination address to 
which the read value is to be written.

Valid OUTPUT BOOL FALSE TRUE The read value is valid.
FALSE The read value is invalid.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

S7-1200 Motion Control V1...3 (Page 2969)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_WriteParam: Write tag of positioning axis V4 (Page 2968)
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MC_WriteParam

MC_WriteParam: Write tag of positioning axis V4

Description
Motion Control instruction "MC_WriteParam" enables the writing of tags of the positioning axis 
technology object in the user program. In contrast to the value assignment of the tags in the 
user program, "MC_WriteParam" can also change values of read-only tags. 

You can learn about the tags, the conditions under which they can be written and the time at 
which they take effect in the description of the technology object tags (Page 7938). 

Requirements
● The positioning axis technology object has been configured correctly. 

● To write tags that are read-only in the user program, the axis must be disabled.

Override response
A MC_WriteParam command cannot be aborted by any other Motion Control command.

A new MC_WriteParam command does not abort any active Motion Control commands.

Parameters

Parameter Declaration Data type Default value Description
Parameter INPUT VARIANT (BOOL, INT, 

DINT, REAL)
- VARIANT pointer to the technology object 

tag (Page 7938) positioning axis 
(destination address) to be written

Value INPUT VARIANT (BOOL, INT, 
DINT, REAL)

- VARIANT pointer to the value to be written 
(source address)

Execute INPUT BOOL FALSE Start of the command with a positive edge
Done OUTPUT BOOL FALSE TRUE Value was written
Busy OUTPUT BOOL FALSE TRUE The command is being 

executed.
Error OUTPUT BOOL FALSE TRUE An error occurred during 

execution of the command. 
The cause of the error can be 
found in parameters "ErrorID" 
and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7928) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7928) for parameter 

"ErrorID"
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See also
Overview of the Motion Control statements (Page 7892)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

Tags of the positioning axis technology object as of V4 (Page 7938)

S7-1200 Motion Control V1...3 (Page 2969)

MC_Power: Enable, disable axis V4 (Page 2936)

MC_Reset: Acknowledge fault V4 (Page 2940)

MC_Home: Home axes, set reference point V4 (Page 2942)

MC_Halt: Halt axes V4 (Page 2945)

MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948)

MC_MoveRelative: Relative positioning of axes V4 (Page 2951)

MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955)

MC_MoveJog: Move axes in jog mode V4 (Page 2959)

MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

S7-1200 Motion Control V1...3

MC_Power

MC_Power: Enable, disable axis V1...3

Description
The Motion Control instruction "MC_Power" enables or disables an axis.   

Requirements
● The axis technology object has been configured correctly.

● There is no pending enable-inhibiting error.

Override response
Execution of "MC_Power" cannot be aborted by a Motion Control command.

Disabling the axis (input parameter "Enable" = FALSE) aborts all Motion Control commands 
for the associated technology object in accordance with the selected "StopMode".
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Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Enable INPUT BOOL FALSE TRUE Motion Control attempts to enable the axis. 

FALSE All current jobs are interrupted in accordance with 
the "StopMode" configured. The axis is stopped 
and disabled.

StopMode INPUT INT 0 0 Emergency stop
If a request to disable the axis is pending, the axis 
brakes at the configured emergency stop 
deceleration. The axis is disabled after reaching 
standstill.

1 Immediate stop
If a request to disable the axis is pending, this axis 
is disabled without deceleration. The pulse output 
is stopped immediately.

2 Emergency stop with jerk control
If a request to disable the axis is pending, the axis 
brakes at the configured emergency stop 
deceleration. If the jerk control is activated, the 
configured jerk is taken into account. The axis is 
disabled after reaching standstill.

Status OUTPUT BOOL FALSE Status of axis enable
FALSE The axis is disabled.

The axis does not execute Motion Control 
commands and does not accept any new 
commands (exception: MC_Reset command).
The axis is not homed.
Upon disabling, the status does not change to 
FALSE until the axis reaches a standstill.

TRUE The axis is enabled.
The axis is ready to execute Motion Control 
commands.
Upon axis enabling, the status does not change to 
TRUE until the signal "Drive ready" is pending. If 
the "Drive ready" drive interface was not configured 
in the axis configuration, the status changes to 
TRUE immediately.

Busy OUTPUT BOOL FALSE TRUE "MC_Power" is active.
Error OUTPUT BOOL FALSE TRUE An error occurred in Motion Control instruction 

"MC_Power" or in the associated technology 
object. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"
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 Note

If the axis is switched off due to an error, it will be enabled again automatically after the error 
has been eliminated and acknowledged. This requires that the input parameter "Enable" has 
retained the value TRUE during this process.

 

Enabling an axis with configured drive interface
To enable the axis, follow these steps:

1. Check the requirements indicated above.

2. Initialize input parameter "StopMode" with the desired value. Set the input parameter 
"Enable" to TRUE.
The enable output for "Drive enabled" changes to TRUE to enable the power to the drive. 
The CPU waits for the "Drive ready" signal of the drive.
When the "Drive ready" signal is available at the configured Ready input of the CPU, the 
axis is enabled. The output parameter "Status" and the tag of the technology object <Axis 
name>.StatusBits.Enable indicate the value TRUE.

Enabling an axis without configured drive interface
To enable the axis, follow these steps:

1. Check the requirements indicated above.

2. Initialize input parameter "StopMode" with the desired value. Set the input parameter 
"Enable" to TRUE. The axis is enabled. The output parameter "Status" and the tag of the 
technology object <Axis name>.StatusBits.Enable indicate the value TRUE.

Disabling an axis
To disable an axis, you can follow the steps described below:

1. Bring the axis to a standstill.
You can identify when the axis is at a standstill in the tag of the technology object <Axis 
name>.StatusBits.StandStill.

2. Set input parameter "Enable" to FALSE after standstill is reached.

3. If output parameters "Busy" and "Status" and the tag of technology object <Axis 
name>.StatusBits.Enable indicate the value FALSE, disabling of the axis is complete.

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_Power: Function chart V1...3 (Page 2972)

MC_Reset: Acknowledge fault V1...3 (Page 2973)
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MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)

MC_Power: Function chart V1...3

Function chart 
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① An axis is enabled and then disabled again. When the drive has signaled "Drive ready" back to the CPU, the successful 
enable can be read out via "Status_1".

② Following an axis enable, an error has occurred that caused the axis to be disabled. The error is eliminated and 
acknowledged with "MC_Reset". The axis is then enabled again.

See also
MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset

MC_Reset: Acknowledge fault V1...3

Description
Motion Control instruction "MC_Reset" can be used to acknowledge "Operating error with axis 
stop" and "Configuration error". The errors that require acknowledgement can be found in the 
"List of ErrorIDs and ErrorInfos" under "Remedy".   

From version V3.0, the axis configuration can be downloaded to the work memory in RUN 
operating mode.

Requirements
● The axis technology object has been configured correctly.

● The cause of a pending configuration error requiring acknowledgement has been eliminated 
(for example, acceleration in positioning axis technology object has been changed to a valid 
value).

Override response
The MC_Reset command cannot be aborted by any other Motion Control command.

The new MC_Reset command does not abort any other active Motion Control commands.

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Restart INPUT BOOL FALSE (From version V3.0)

TRUE Download the axis configuration from the load 
memory to the work memory. The command can 
only be executed when the axis is disabled.
Refer to the notes on Download to the CPU 
(Page 7870).
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Parameter Declaration Data type Default value Description
FALSE Acknowledges pending errors

Done OUTPUT BOOL FALSE TRUE Error has been acknowledged.
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

Acknowledging an error requiring acknowledgement with MC_Reset
To acknowledge an error, follow these steps:

1. Check the requirements indicated above.

2. Start the acknowledgement of the error with a rising edge at input parameter "Execute".

3. If output parameter "Done" indicates the value TRUE and tag of technology object <Axis 
name>.StatusBits.Error the value FALSE, the error has been acknowledged.

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

Download to CPU (Page 7870)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)

Programming the PLC
9.7 References

WinCC Professional V13.0
2974 System Manual, 02/2014



MC_Home

MC_Home: Home axes, set reference point V1...3

Description
Motion Control instruction "MC_Home" is used to match the axis coordinates to the real, 
physical drive position. Homing is required for absolute positioning of the axis. The following 
types of homing can be executed:   

● Active homing (Mode = 3)
The homing procedure is executed automatically.

● Passive homing (Mode = 2)
During passive homing, the "MC_Home" Motion Control instruction does not carry out any 
homing motion. The traversing motion required for this must be implemented by the user 
via other Motion Control instructions. When the homing switch is detected, the axis is 
homed.

● Direct homing absolute (Mode = 0)
The current axis position is set to the value of parameter "Position".

● Direct homing relative (Mode = 1)
The current axis position is offset by the value of parameter "Position".

Requirements
● The axis technology object has been configured correctly.

● The axis is enabled.

● No MC_CommandTable command may be active upon start with Mode = 0, 1, or 2.

Override response
The override response depends on the selected mode:

Mode = 0, 1

The MC_Home command cannot be aborted by any other Motion Control command.

The MC_Home command does not abort any active Motion Control commands. Position-
related motion commands are resumed after homing according to the new homing position 
(value at input parameter: "Position").

Mode = 2

The MC_Home command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 2, 3

The new MC_Home command aborts the following active Motion Control command:

● MC_Home command Mode = 2

Position-related motion commands are resumed after homing according to the new homing 
position (value at input parameter: "Position").
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Mode = 3

The MC_Home command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_Home command aborts the following active Motion Control commands:

● MC_Home command Mode = 2, 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Position INPUT REAL 0.0 ● Mode = 0, 2, and 3

Absolute position of axis after completion of the 
homing operation

● Mode = 1
Correction value for the current axis position

Limit values:
-1.0e12 ≤ Position ≤ 1.0e12

Mode INPUT INT 0 Homing mode
0 Direct homing absolute

New axis position is the position value of 
parameter "Position".

1 Direct homing relative
New axis position is the current axis 
position + position value of parameter 
"Position".
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Parameter Declaration Data type Default value Description
2 Passive homing

Homing according to the axis 
configuration. Following homing, the 
value of parameter "Position" is set as the 
new axis position.

3 Active homing
Homing procedure in accordance with the 
axis configuration. Following homing, the 
value of parameter "Position" is set as the 
new axis position.

Done OUTPUT BOOL FALSE TRUE Command completed
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was 

aborted by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

 

 Note

Axis homing is lost under the following conditions:
● Disabling of axis by the "MC_Power" Motion Control instruction
● Changeover between automatic mode and manual control
● Upon start of active homing. After successful completion of the homing operation, axis 

homing is again available.
● After POWER OFF -> POWER ON of the CPU
● After CPU restart (RUN-STOP -> STOP-RUN)

 

Homing an axis
To home the axis, follow these stops:

1. Check the requirements indicated above.

2. Initialize the necessary input parameters with values, and start the homing operation with 
a rising edge at input parameter "Execute"

3. If output parameter "Done" and technology object tag <Axis 
name>.StatusBits.HomingDone indicate the value TRUE, homing is complete.

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)
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ErrorIDs and ErrorInfos (Page 7973)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)

MC_Halt

MC_Halt: Halt axes V1...3

Description
The "MC_Halt" Motion Control instruction stops all movements and brings the axis to a 
standstill with the configured deceleration. The standstill position is not defined.  

Requirements
● The axis technology object has been configured correctly.

● The axis is enabled.

Override response
The MC_Halt command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_Halt command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command
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● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters  

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Done OUTPUT BOOL FALSE TRUE Zero velocity reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_Halt: Function chart V1...3 (Page 2980)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)
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MC_Halt: Function chart V1...3

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 5.0

① The axis is braked by an MC_Halt command until it comes to a standstill. The axis standstill is signaled via "Done_2".
② While an MC_Halt command is braking the axis, this command is aborted by another motion command. The abort is 

signaled via "Abort_2".
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See also
MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute

MC_MoveAbsolute: Absolute positioning of axes V1...3

Description
The "MC_MoveAbsolute" Motion Control instruction starts an axis positioning motion to move 
it to an absolute position.   

Requirements
● The axis technology object has been configured correctly.

● The axis is enabled.

● The axis is homed.

Override response
The MC_MoveAbsolute command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveAbsolute command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command
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Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Position INPUT REAL 0.0 Absolute target position

Limit values: 
-1.0e12 ≤ Position ≤ 1.0e12

Velocity INPUT REAL 10.0 Velocity of axis
This velocity is not always reached on account of the 
configured acceleration and deceleration and the 
target position to be approached.
Limit values:
Start/stop velocity ≤ Velocity ≤ maximum velocity

Done OUTPUT BOOL FALSE TRUE Absolute target position reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_MoveAbsolute: Function chart V1...3 (Page 2983)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)
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MC_MoveAbsolute: Function chart V1...3

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0
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① An axis is moved to absolute position 1000.0 with an MC_MoveAbsolute command. When the axis reaches the target 
position, this is signaled via "Done_1". When "Done_1" = TRUE, another MC_MoveAbsolute command, with target 
position 1500.0, is started. Because of the response times (e.g., cycle time of user program, etc.), the axis comes to a 
standstill briefly (see zoomed-in detail). When the axis reaches the new target position, this is signaled via "Done_2".

② An active MC_MoveAbsolute command is aborted by another MC_MoveAbsolute command. The abort is signaled via 
"Abort_1". The axis is then moved at the new velocity to the new target position 1500.0. When the new target position 
is reached, this is signaled via "Done_2".

See also
MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative

MC_MoveRelative: Relative positioning of axes V1...3

Description
The "MC_MoveRelative" Motion Control instruction starts a positioning motion relative to the 
start position.  

Requirements
● The axis technology object has been configured correctly.

● The axis is enabled.

Override response
The MC_MoveRelative command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveRelative command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command
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● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters  

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Distance INPUT REAL 0.0 Travel distance for the positioning operation

Limit values: 
-1.0e12 ≤ Distance  ≤ 1.0e12

Velocity INPUT REAL 10.0 Velocity of axis
This velocity is not always reached on account of the 
configured acceleration and deceleration and the 
distance to be traveled.
Limit values:
Start/stop velocity ≤ Velocity ≤ maximum velocity

Done OUTPUT BOOL FALSE TRUE Target position reached
Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_MoveRelative: Function chart V1...3 (Page 2986)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)
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MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)

MC_MoveRelative: Function chart V1...3

Function chart  

The following values were configured in the configuration window Dynamics > General:
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● Acceleration: 10.0

● Deceleration: 10.0

① The axis is moved by an MC_MoveRelative command by the distance ("Distance") 1000.0. When the axis reaches the 
target position, this is signaled via "Done_1". When "Done_1" = TRUE, another MC_MoveRelative command, with travel 
distance 500.0, is started. Because of the response times (e.g., cycle time of user program, etc.), the axis comes to a 
standstill briefly (see zoomed-in detail). When the axis reaches the new target position, this is signaled via "Done_2".

② An active MC_MoveRelative command is aborted by another MC_MoveRelative command. The abort is signaled via 
"Abort_1". The axis is then moved at the new velocity by the new distance ("Distance") 500.0. When the new target 
position is reached, this is signaled via "Done_2".

See also
MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity

MC_MoveVelocity: Move axes at preset rotational speed V1...3

Description
Motion control instruction "MC_MoveVelocity" moves the axis constantly at the specified 
velocity.   

Requirements
● The axis technology object has been configured correctly.

● The axis is enabled.

Override response
MC_MoveVelocity can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveVelocity command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command
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● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

Parameters 

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
Velocity INPUT REAL 10.0 Velocity specification for axis motion

Limit values:
Start/stop velocity ≤ |Velocity ≤ maximum velocity
(Velocity = 0.0 is permitted)

Direction INPUT INT 0 Direction specification
0 Direction of rotation corresponds to the sign 

of the value in parameter "Velocity"
1 Positive direction of rotation

(The sign of the value in parameter 
"Velocity" is ignored)

2 Negative direction of rotation
(The sign of the value in parameter 
"Velocity" is ignored)

Current INPUT BOOL FALSE Maintain current velocity
FALSE "Maintain current velocity" is deactivated. 

The values of parameters "Velocity" and 
"Direction" are used.

TRUE "Maintain current velocity" is activated. The 
values in parameters "Velocity" and 
"Direction" are not taken into account.
When the axis resumes motion at the 
current velocity, the "InVelocity" parameter 
returns the value TRUE.

InVelocity OUTPUT BOOL FALSE TRUE ● "Current" = FALSE:
The velocity specified in parameter 
"Velocity" was reached.

● "Current" = TRUE:
The axis travels at the current velocity at 
the start time.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
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Parameter Declaration Data type Default value Description
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

Behavior with zero setpoint velocity (Velocity = 0.0)
An MC_MoveVelocity command with "Velocity" = 0.0 (such as an MC_Halt command) aborts 
active motion commands and stops the axis with the configured deceleration.

When the axis comes to a standstill, output parameter "InVelocity" indicates TRUE for at least 
one program cycle. 

"Busy" indicates the value TRUE during the deceleration process and changes to FALSE 
together with "InVelocity". If parameter "Execute" = TRUE is set, "InVelocity" and "Busy" are 
latched.

When the "MC_MoveVelocity" command is started, status bit "SpeedCommand" is set in the 
technology object. Status bit "ConstantVelocity" is set upon axis standstill. Both bits are 
adapted to the new situation when a new motion command is started.

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_MoveVelocity: Function chart V1...3 (Page 2990)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)
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MC_MoveVelocity: Function chart V1...3

Function chart  

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 10.0

① An active MC_MoveVelocity command signals via "InVel_1" that its target velocity has been reached. It is then aborted 
by another MC_MoveVelocity command. The abort is signaled via "Abort_1". When the new target velocity 15.0 is 
reached, this is signaled via "InVel_2". The axis then continues moving at the new constant velocity.

② An active MC_MoveVelocity command is aborted by another MC_MoveVelocity command prior to reaching its target 
velocity. The abort is signaled via "Abort_1". When the new target velocity 15.0 is reached, this is signaled via "InVel_2". 
The axis then continues moving at the new constant velocity.
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See also
MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog

MC_MoveJog: Move axes in jog mode V1...3

Description
Motion control instruction "MC_MoveJog" moves the axis constantly at the specified velocity 
in jog mode. You use this Motion Control instruction, for example, for testing and 
commissioning purposes.   

Requirements
● The axis technology object has been configured correctly.

● The axis is enabled.

Override response
The MC_MoveJog command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_MoveJog command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command
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Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
JogForward INPUT BOOL FALSE As long as the parameter is TRUE, the axis moves in 

the positive direction at the velocity specified in 
parameter "Velocity".

JogBackward INPUT BOOL FALSE As long as the parameter is TRUE, the axis moves in 
the negative direction at the velocity specified in 
parameter "Velocity".

If both parameters are simultaneously TRUE, the axis stops with the configured deceleration. An error is indicated in 
parameters "Error", "ErrorID", and "ErrorInfo".
Velocity INPUT REAL 10.0 Preset velocity for jog mode

Limit values, instruction version V1.0:
Start/stop velocity ≤ |Velocity ≤ maximum velocity
Limits, instruction version V2.0:
Start/stop velocity ≤ velocity ≤ maximum velocity

InVelocity OUTPUT BOOL FALSE TRUE The velocity specified in parameter 
"Velocity" was reached.

Busy OUTPUT BOOL FALSE TRUE The command is being executed.
CommandAborted OUTPUT BOOL FALSE TRUE During execution the command was aborted 

by another command.
Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 

command. The cause of the error can be 
found in parameters "ErrorID" and 
"ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_MoveJog: Function chart V1...3 (Page 2993)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)
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MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)

MC_MoveJog: Function chart V1...3

Function chart 

The following values were configured in the configuration window Dynamics > General:

● Acceleration: 10.0

● Deceleration: 5.0

① The axis is moved in the positive direction in jog mode via "Jog_F". When the target velocity 50.0 is reached, this is 
signaled via "InVelo_1". After " Jog_F" is reset, the axis brakes again until it comes to a standstill.

② The axis is moved in the negative direction in jog mode via "Jog_B". When the target velocity 50.0 is reached, this is 
signaled via "InVelo_1". After " Jog_B" is reset, the axis brakes again until it comes to a standstill.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 2993



See also
MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable

MC_CommandTable: Run axis commands as motion sequence V2...3

Description
The Motion Control instruction "MC_CommandTable" combines multiple individual axis control 
commands in one movement sequence.   

Requirements
● The axis technology object has been inserted in V2 and correctly configured.

● The command table technology object has been inserted and correctly configured.

● The axis is enabled.

Override response
The MC_CommandTable command can be aborted by the following Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The new MC_CommandTable command aborts the following active Motion Control commands:

● MC_Home command Mode = 3

● MC_Halt command

● MC_MoveAbsolute command

● MC_MoveRelative command

● MC_MoveVelocity command

● MC_MoveJog command

● MC_CommandTable command

The active Motion Control command is cancelled by the start of the first "Positioning Relative", 
"Positioning Absolute", "Velocity set point" or "Halt" command.
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Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
CommandTab
le

INPUT TO_CommandT
able_1

- Command table technology object

Execute INPUT BOOL FALSE Command table start with positive edge
StartStep INPUT INT 1 Defines the step at which the execution of the command 

table should begin
Limit values:
1 ≤ StartStep ≤ EndStep

EndStep INPUT INT 32 Defines the step up to which the execution of command 
table should take place
Limit values:
StartStep ≤ EndStep ≤ 32

Done OUTPUT BOOL FALSE TRUE Command table has been successfully executed
Busy OUTPU BOOL FALSE TRUE The command table is being executed.
CommandAb
orted

OUTPUT BOOL FALSE TRUE The command table was cancelled by another 
command.

Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 
command table. The cause of the error can be 
found in parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"
CurrentStep OUTPUT INT 0 Step in command table currently being executed
StepCode OUTPUT WORD 16#0000 User-defined numerical value / bit pattern of the step 

currently being executed

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)

MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_ChangeDynamic: Change dynamic settings of axis V2...3 (Page 2996)
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MC_ChangeDynamic

MC_ChangeDynamic: Change dynamic settings of axis V2...3

Description
Motion Control instruction "MC_ChangeDynamic" allows you to change the following settings 
of the axis:   

● Change the ramp-up time (acceleration) value

● Change the ramp-down time (deceleration) value

● Change the emergency stop ramp-down time (emergency stop deceleration) value

● Change the smoothing time (jerk) value

For the effectiveness of the change, refer to the description of the tag (Page 7986).

Requirements
● The axis technology object has been inserted in Version V2.

● The axis technology object has been configured correctly.

Override response
A MC_ChangeDynamic command cannot be aborted by any other Motion Control command.

A new MC_ChangeDynamic command does not abort any active Motion Control commands.

Parameters   

Parameter Declaration Data type Default value Description
Axis INPUT TO_Axis_1 - Axis technology object
Execute INPUT BOOL FALSE Start of the command with a positive edge
ChangeRa
mpUp

INPUT BOOL FALSE TRUE Change ramp-up time in line with input parameter 
"RampUpTime"

RampUpTi
me

INPUT REAL 5.00 Time (in seconds) to accelerate axis from standstill to 
configured maximum velocity without jerk limit.
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Acceleration. For the effectiveness 
of the change, refer to the description of this tag.

ChangeRa
mpDown

INPUT BOOL FALSE TRUE Change ramp-down time in line with input 
parameter "RampDownTime"

RampDown
Time

INPUT REAL 5.00 Time (in seconds) to decelerate axis from the configured 
maximum velocity to standstill without jerk limiter.
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Deceleration . For the effectiveness 
of the change, refer to the description of this tag.
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Parameter Declaration Data type Default value Description
ChangeEm
ergency

INPUT BOOL FALSE TRUE Change emergency stop ramp-down time in line 
with input parameter "EmergencyRampTime"

Emergency
RampTime

INPUT REAL 2.00 Time (in seconds) to decelerate the axis from configured 
maximum velocity to standstill without jerk limiter in 
emergency stop mode. 
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.EmergencyDeceleration . For the 
effectiveness of the change, refer to the description of this 
tag.

ChangeJer
kTime

INPUT BOOL FALSE TRUE Change smoothing time according to the input 
parameter "JerkTime"

JerkTime INPUT REAL 0.25 Smoothing time (in seconds) used for the axis acceleration 
and deceleration ramps
The change will influence the tag <Axis name>. 
Config.DynamicDefaults.Jerk . For the effectiveness of the 
change, refer to the description of this tag.

Done OUTPUT BOOL FALSE TRUE The changed values have been written to the 
technology data block. The description of the tags 
will show when the change becomes effective.

Error OUTPUT BOOL FALSE TRUE An error occurred during execution of the 
command. The cause of the error can be found in 
parameters "ErrorID" and "ErrorInfo".

ErrorID OUTPUT WORD 16#0000 Error ID (Page 7973) for parameter "Error"
ErrorInfo OUTPUT WORD 16#0000 Error info ID (Page 7973) for parameter "ErrorID"

 

 Note

At the input parameters "RampUpTime", "RampDownTime", "EmergencyRampTime" and 
"JerkTime", values can be entered which exceed the admissible limits of the resulting 
parameters: "Acceleration", "Deceleration", "Emergency stop deceleration" and "Jerk".

Please note the equations and limits in  "Axis technology object" -> "Configuring the 
technology object" -> "Dynamics" and ensure that the values you input are within the valid 
range.

 

See also
Overview of the Motion Control statements (Page 7892)

S7-1200 Motion Control V4 (Page 2936)

ErrorIDs and ErrorInfos (Page 7973)

Tag of the axis technology object V1...3 (Page 7986)

MC_Power: Enable, disable axis V1...3 (Page 2969)

MC_Reset: Acknowledge fault V1...3 (Page 2973)

MC_Home: Home axes, set reference point V1...3 (Page 2975)

MC_Halt: Halt axes V1...3 (Page 2978)
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MC_MoveAbsolute: Absolute positioning of axes V1...3 (Page 2981)

MC_MoveRelative: Relative positioning of axes V1...3 (Page 2984)

MC_MoveVelocity: Move axes at preset rotational speed V1...3 (Page 2987)

MC_MoveJog: Move axes in jog mode V1...3 (Page 2991)

MC_CommandTable: Run axis commands as motion sequence V2...3 (Page 2994)

9.7.4.2 High-speed counters

CTRL_HSC: Control high-speed counters

Parameter

Parameter Declaration Data type Memory area Description
EN INPUT BOOL I, Q, M, D, L, T, C Enable input
ENO OUTPUT BOOL I, Q, M, D, L Enable output
HSC INPUT HW_HSC I, Q, M or constant Hardware address 

of the high-speed 
counter (HW-ID)

DIR INPUT BOOL I, Q, M, D, L or constant Enables the new 
count direction 
(see NEW_DIR) 

CV INPUT BOOL I, Q, M, D, L or constant Enables the new 
count value (see 
NEW_CV)

RV INPUT BOOL I, Q, M, D, L or constant Enables the new 
reference value 
(see NEW_RV)

PERIOD INPUT BOOL I, Q, M, D, L or constant Enables the new 
period of a 
frequency 
measurement (see 
NEW_PERIOD)

NEW_DIR INPUT INT I, Q, M, D, L or constant Count direction 
loaded when DIR = 
TRUE. 

NEW_CV INPUT DINT I, Q, M, D, L or constant Count value loaded 
when CV = TRUE.

NEW_RV INPUT DINT I, Q, M, D, L or constant Reference value 
loaded when RV = 
TRUE.

NEW_PERIOD INPUT INT I, Q, M, D, L or constant Period of the 
frequency 
measurement 
loaded when 
PERIOD = TRUE. 
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Parameter Declaration Data type Memory area Description
BUSY OUTPUT BOOL I, Q, M, D, L Processing status 
STATUS OUTPUT WORD I, Q, M, D, L Status of the 

operation

Description
With the "Control high-speed counter" instruction, you can make parameter settings and control 
the high-speed counters supported by the CPU by loading new values into the counter. 
Execution of the instruction requires that the high-speed counter to be controlled is enabled. 
You cannot execute multiple "Control high-speed counter" instructions simultaneously in the 
program for a given high-speed counter.

You can load the following parameter values into a high-speed counter using the "Control high-
speed counter" instruction:

● Count direction (NEW_DIR): The count direction defines whether a high-speed counter 
counts up or down. The count direction is defined by the following values at the NEW_DIR 
input: 1 = up, -1 = down. 
A change to the count direction with the "Control high-speed counter" instruction is only 
possible when direction control is set in the parameters by the program. The count direction 
specified at the NEW_DIR input is loaded into a high-speed counter when the bit at the DIR 
input is set.

● Count value (NEW_CV): The count value is the initial value at which a high-speed counter 
starts counting. The count value can be in the range -2147483648 to 2147483647.
The count value specified at the NEW_CV input is loaded into a high-speed counter when 
the bit at the CV input is set.

● Reference value (NEW_RV): You can compare the reference value with the current counter 
value to trigger an alarm. Similar to the counter value, the reference value can be in the 
range -2147483648 to 2147483647.
The reference value specified at the NEW_RV input is loaded into a high-speed counter 
when the bit at the RV input is set.

● Period of the frequency measurement (NEW_PERIOD): The period of the frequency 
measurement is specified by the following values at the NEW_PERIOD input: 10 = 0.01s, 
100 = 0.1s, 1000 = 1s. 
The time period can be updated if the "Measure frequency" function for the specified high-
speed counter is configured. The time period specified at the NEW_PERIOD input is loaded 
into a high-speed counter when the bit at the PERIOD input is set.

The "Control high-speed counter" instruction is only executed if the signal state at the EN input 
is "1". As long as the operation is executing, the bit at the BUSY output is set. Once the 
operation has executed completely, the bit at the BUSY output is reset.

The ENO enable output is set only when the EN enable input has signal state "1" and no errors 
occur during execution of the operation.

When inserting the "Control high-speed counter" instruction, an instance data block is created 
in which the operation data is saved.
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Parameter STATUS
At the STATUS output, you can query whether errors occurred during execution of the "Control 
high-speed counter" instruction. The following table shows the meaning of the values output 
at the STATUS output:

Error code (hexadecimal) Description
0 No error
80A1 Hardware identifier of the high-speed counter invalid
80B1 Count direction (NEW_DIR) invalid
80B2 Count value (NEW_CV) invalid
80B3 Reference value (NEW_RV) invalid
80B4 Period of the frequency measurement (NEW_PERIOD) invalid
80C0 Multiple access to the high-speed counter
80D0 The high-speed counter (HSC) is not enabled in the CPU hardware 

configuration.
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9.7.4.3 PID Control

PID_Compact

New features of PID_Compact

PID_Compact V2.2
● Use with S7-1200

As of PID_Compact V2.2, the instruction with V2 functionality can also be used on S7-1200 
with firmware version 4.0 or higher.

PID_Compact V2.0
● Reaction to error

The reaction to error has been completely overhauled. PID_Compact now reacts in a more 
fault-tolerant manner in the default setting. This reaction is set when copying PID_Compact 
V1.X from an S7-1200 CPU to an S7-1500 CPU.

 

 
 NOTICE

Your system may be damaged.

If you use the default setting, PID_Compact remains in automatic mode when the process 
value limits are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to 
protect your system from damage. 

 

The Error parameter indicates if an error is pending. When the error is no longer pending, 
Error = FALSE. The ErrorBits parameter shows which errors have occurred. Use ErrorAck 
to acknowledge the errors and warnings without restarting the controller or clearing the 
integral action. Switching operating modes no longer clears errors that are no longer 
pending. 
You can configure the reaction to error with SetSubstituteOutput and ActivateRecoverMode.

● Substitute output value
You can configure a substitute output value that is to be output if an error occurs.

● Switching the operating mode
You specify the operating mode at the Mode in/out parameter and use a rising edge at 
ModeActivate to start the operating mode. The sRet.i_Mode tag has been omitted. 

● Multi-instance capability
You can call up PID_Compact as multi-instance DB. No technology object is created in this 
case and no parameter assignment interface or commissioning interface is available. You 
must assign parameters for PID_Compact directly in the multi-instance DB and commission 
it via a watch table.

● Startup characteristics
The operating mode specified at the Mode parameter is also started on a falling edge at 
Reset and during a CPU cold restart, if RunModeByStartup = TRUE.
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● ENO characteristics
ENO is set depending on the operating mode.
If State = 0, then ENO = FALSE.
If State ≠ 0, then ENO = TRUE. 

● Setpoint value specification during tuning
You configure the permitted fluctuation of the setpoint during tuning at the 
CancelTuningLevel tag.

● Value range for output value limits
The value 0.0 no longer has to fall within the output value limits.

● Pre-assigning the integral action
Using the tags IntegralResetMode and OverwriteInitialOutputValue, you can determine the 
pre-assignment of the integral action when switching from "Inactive" operating mode to 
"Automatic mode".

● Switching a disturbance variable on
You can switch a disturbance variable on at the Disturbance parameter.

● Default value of PID parameters
The following default settings have been changed:

– Proportional action weighting (PWeighting) from 0.0 to 1.0

– Derivative action weighting (DWeighting) from 0.0 to 1.0

– Coefficient for derivative delay (TdFiltRatio) from 0.0 to 0.2

● Renaming tags
The static tags have been given new names that are compatible with PID_3Step. 

PID_Compact V1.2
● Manual mode on CPU startup

If ManualEnable = TRUE when the CPU starts, PID_Compact starts in manual mode. A 
rising edge at ManualEnable is not necessary. 

● Pretuning
If the CPU is switched off during pretuning, pretuning starts again when the CPU is switched 
back on.

PID_Compact V1.1
● Manual mode on CPU startup

When the CPU starts up, PID_Compact only switches to manual mode with a rising edge 
at ManualEnable. Without rising edge, PID_Compact starts in the last operating mode in 
which ManualEnable was FALSE.

● Reaction to reset
A rising edge at Reset resets the errors and warnings and clears the integral action. A falling 
edge at Reset triggers a switchover to the most recently active operating mode.

● Default of process value high limit
The default value of r_Pv_Hlm has been changed to 120.0.
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● Monitoring the sampling time

– An error is no longer output when the current sampling time is >= 1.5 x current mean 
value or when the current sampling time is <= 0.5 x current mean value. The sampling 
time may deviate much more in automatic mode.

– PID_Compact is compatible with FW, V2.0 or higher.

● Access to tags
The following tags can now be used in the user program.

– i_Event_SUT

– i_Event_TIR

– r_Ctrl_Ioutv

● Troubleshooting
PID_Compact now outputs the correct pulses when the shortest ON time is not equal to 
the shortest OFF time.

Compatibility with CPU and FW
The following table shows which version of PID_Compact can be used on which CPU.

CPU FW PID_Compact
S7-1200 V4.x V2.2

V1.2
S7-1200 V3.X V1.2

V1.1
S7-1200 V2.X V1.2

V1.1
S7-1200 V1.X V1.0
S7-1500 V1.1 V2.2

V2.1
V2.0

S7-1500 V1.0 V2.0

PID_Compact V2

Description of PID_Compact V2

Description 
The PID_Compact instruction provides a PID controller with integrated tuning for actuators 
with proportional action.

The following operating modes are possible:
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● Inactive

● Pretuning

● Fine tuning

● Automatic mode

● Manual mode

● Substitute output value with error monitoring

For a more detailed description of the operating modes, see the State parameter.

PID algorithm
PID_Compact is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The PID algorithm operates according to the following equation:

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
TD Derivative action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
c Derivative action weighting
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Block diagram of PID_Compact

Block diagram of PIDT1 with anti-windup
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Call
PID_Compact is called in the constant time scale of a cycle interrupt OB.

If you call PID_Compact as a multi-instance DB, no technology object is created. No parameter 
assignment interface or commissioning interface is available. You must assign parameters for 
PID_Compact directly in the multi-instance DB and commission it via a watch table.

Download to device
The actual values of retentive variables are only updated when you download PID_Compact 
completely. 

Downloading technology objects to device (Page 7715)

Startup
When the CPU starts up, PID_Compact starts in the operating mode that is saved in the Mode 
in/out parameter. To switch to "Inactive" operating mode during startup, set 
RunModeByStartup = FALSE.

Reaction to error
In automatic mode and during commissioning, the reaction to error depends on the 
SetSubstituteOutput and ActivateRecoverMode variables. In manual mode, the reaction is 
independent of SetSubstituteOutput and ActivateRecoverMode. If ActivateRecoverMode = 
TRUE, the reaction additionally depends on the error that occurred.

SetSubstituteOu
tput

ActivateReco
verMode

Configuration editor 
> output value 
> Set Output to

Reaction

Not relevant FALSE Zero (inactive) Switch to "Inactive" mode (State = 0)
The value 0.0 0 is transferred to the actuator.

FALSE TRUE Current output value while error is 
pending

Switch to "Substitute output value with error 
monitoring" mode (State = 5)
The current output value is transferred to the 
actuator while the error is pending.

TRUE TRUE Substitute output value while error 
is pending

Switch to "Substitute output value with error 
monitoring" mode (State = 5)
The value at SubstituteOutput is transferred to the 
actuator while the error is pending.

In manual mode, PID_Compact uses ManualValue as output value, unless ManualValue is 
invalid. If ManualValue is invalid, SubstituteOutput is used. If ManualValue and 
SubstituteOutput are invalid, Config.OutputLowerLimit is used.

The Error parameter indicates if an error is pending. When the error is no longer pending, Error 
= FALSE. The ErrorBits parameter shows which errors have occurred. ErrorBits is reset by a 
rising edge at Reset or ErrorAck.
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PID_Compact V2 mode of operation

Monitoring process value limits
You specify the high limit and low limit of the process value in the Config.InputUpperLimit and 
Config.InputLowerLimit tags. If the process value is outside these limits, an error occurs 
(ErrorBits = 0001h).

You specify a high and low warning limit of the process value in the Config.InputUpperWarning 
and Config.InputLowerWarning tags. If the process value is outside these warning limits, a 
warning occurs (Warning = 0040h), and the InputWarning_H or InputWarning_L output 
parameter changes to TRUE. 

Limiting the setpoint 
You specify a high limit and low limit of the setpoint in the Config.SetpointUpperLimit and 
Config.SetpointLowerLimit tags. PID_Compact automatically limits the setpoint to the process 
value limits. You can limit the setpoint to a smaller range. PID_Compact checks whether this 
range falls within the process value limits. If the setpoint is outside these limits, the high or low 
limit is used as the setpoint, and output parameter SetpointLimit_H or SetpointLimit_L is set 
to TRUE.

The setpoint is limited in all operating modes.

Limiting the output value
You specify a high limit and low limit of the output value in the Config.OutputUpperLimit and 
Config.OutputLowerLimit tags. Output, ManualValue, and SubstituteOutput are limited to these 
values. The output value limits must match the control logic.

The valid output value limit values depend on the Output used.

Output -100.0 to 100.0%
Output_PER -100.0 to 100.0%
Output_PWM 0.0 to 100.0%

Rule:

OutputUpperLimit > OutputLowerLimit

Substitute output value
In the event of an error, PID_Compact can output a substitute output value that you define at 
the tag SubstituteOutput. The substitute output value must be within the output value limits.

Monitoring signal validity
The values of the following parameters are monitored for validity when used:

● Setpoint

● Input
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● Input_PER

● Disturbance

● ManualValue

● SubstituteOutput

● Output

● Output_PER

● Output_PWM

Monitoring of the sampling time PID_Compact
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_Compact 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. Too great a difference between the current sampling time and 
this mean value triggers an error (Error = 0800h).

The error occurs during tuning if: 

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

The error occurs in automatic mode if: 

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value

If you deactivate the sampling time monitoring (CycleTime.EnMonitoring = FALSE), you can 
also call PID_Compact in OB1. You must then accept a lower control quality due to the 
deviating sampling time.

Sampling time of the PID algorithm
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.

If you use Output_PWM, the accuracy of the output signal is determined by the ratio of the PID 
algorithm sampling time to the cycle time of the OB. The cycle time should be at least 10 times 
the PID algorithm sampling time.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_Compact does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 
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Input parameters of PID_Compact V2

Table 9-79    

Parameter Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A tag of the user program is used as the source of the 

process value. 
If you are using the Input parameter, then 
Config.InputPerOn = FALSE must be set.

Input_PER INT 0 An analog input is used as the source of the process 
value.
If you are using the Input_PER parameter, then 
Config.InputPerOn = TRUE must be set.

Disturbance REAL 0.0 Disturbance variable or precontrol value
ManualEnable BOOL FALSE ● A FALSE -> TRUE edge activates "manual mode", 

while State = 4, Mode remain unchanged.
As long as ManualEnable = TRUE, you cannot 
change the operating mode via a rising edge at 
ModeActivate or use the commissioning dialog.

● A TRUE -> FALSE edge activates the operating 
mode that is specified by Mode.

We recommend that you change the operating mode 
using ModeActivate only.

ManualValue REAL 0.0 Manual value
This value is used as the output value in manual mode.
Values from Config.OutputLowerLimit to 
Config.OutputUpperLimit are permitted.

ErrorAck BOOL FALSE ● FALSE -> TRUE edge
ErrorBits and Warning are reset.

Reset BOOL FALSE Restarts the controller.
● FALSE -> TRUE edge

– Switch to "Inactive" mode
– ErrorBits and Warnings are reset.
– Integral action is cleared

(PID parameters are retained)
● As long as Reset = TRUE, PID_Compact remains 

in "Inactive" mode (State = 0).
● TRUE -> FALSE edge

PID_Compact switches to the operating mode that 
is saved in the Mode parameter.

ModeActivate BOOL FALSE ● FALSE -> TRUE edge
PID_Compact switches to the operating mode that 
is saved in the Mode parameter.
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Output parameters of PID_Compact V2

Table 9-80    

Parameter Data type Default Description
ScaledInput REAL 0.0 Scaled process value
The "Output", "Output_PER", and "Output_PWM" outputs can be used concurrently.
Output REAL 0.0 Output value in REAL format
Output_PER INT 0 Analog output value 
Output_PWM BOOL FALSE Pulse-width-modulated output value

The output value is formed by by variable On and Off times.
SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the absolute setpoint high limit 

is reached (Setpoint ≥ Config.SetpointUpperLimit).
The setpoint is limited to Config.SetpointUpperLimit .

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the absolute setpoint low limit 
has been reached (Setpoint ≤ Config.SetpointLowerLimit).
The setpoint is limited to Config.SetpointLowerLimit .

InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached 
or exceeded the warning high limit.

InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached 
or fallen below the warning low limit.

State INT 0 The State parameter (Page 3020) shows the current 
operating mode of the PID controller. You can change the 
operating mode using the input parameter Mode and a rising 
edge at ModeActivate. 
● State = 0: Inactive
● State = 1: Pretuning
● State = 2: Fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode
● State = 5: Substitute output value with error monitoring

Error BOOL FALSE If Error = TRUE, at least one error message is pending in 
this cycle.

ErrorBits DWORD DW#16#0 The ErrorBits parameter (Page 3024) shows which error 
messages are pending. ErrorBits is retentive and is reset 
upon a rising edge at Reset or ErrorAck.
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In/out parameters of PID_Compact V2

Table 9-81  

Parameter Data type Default Description
Mode INT 4 At Mode, specify the operating mode to 

which PID_Compact is to switch. Options 
are:
● Mode = 0: Inactive
● Mode = 1: Pretuning
● Mode = 2: Fine tuning
● Mode = 3: Automatic mode
● Mode = 4: Manual mode
The operating mode is activated by:
● Rising edge at ModeActivate
● Falling edge at Reset
● Falling edge at ManualEnable
● Cold restart of CPU if 

RunModeByStartup = TRUE
Mode is retentive.
A detailed description of the operating 
modes can be found in Parameters State 
and Mode V2 (Page 3020).

See also
Parameters State and Mode V2 (Page 3020)
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Static tags of PID_Compact V2
You must not change variables that are not listed. These are used for internal purposes only.

Table 9-82    

Tag Data type Default Description
IntegralResetMode INT 1 The tag IntegralResetMode determines how 

PIDCtrl.IntegralSum is pre-assigned when switching 
from "Inactive" operating mode to "Automatic mode". 
This setting only works for one cycle.
Options are:
● IntegralResetMode = 0: Smoothing

The value of IntegralSum is pre-assigned so that the 
switchover is bumpless.

● IntegralResetMode = 1: Deleting
The value of IntegralSum is deleted. Any control 
deviation will cause a jump change of the output 
value.

● IntegralResetMode = 2: Holding
The value of IntegralSum is not changed. You can 
define a new value using the user program.

● IntegralResetMode = 3: Pre-assigning
The value of IntegralSum is automatically pre-
assigned so that Output is calculated with reference 
to the value OverwriteInitialOutputValue. This 
setting is useful, for example, for an override 
controller. 

OverwriteInitialOutputValue REAL 0.0 If IntegralResetMode = 3, the value of IntegralSum is 
automatically pre-assigned so that Output = 
OverwriteInitialOutputValue in the next cycle. 

RunModeByStartup BOOL TRUE Activate operating mode at Mode parameter after CPU 
restart
If RunModeByStartup = TRUE, PID_Compact starts in 
the operating mode saved in the Mode parameter after 
CPU startup.
If RunModeByStartup = FALSE, PID_Compact remains 
in "Inactive" mode after CPU startup.

LoadBackUp BOOL FALSE If LoadBackUp = TRUE, the last set of PID parameters 
is reloaded. The set was saved prior to the last tuning. 
LoadBackUp is automatically set back to FALSE.

PhysicalUnit INT 0 Unit of measurement of the process value and setpoint, 
e.g., ºC, or ºF.

PhysicalQuantity INT 0 Physical quantity of the process value and setpoint, 
e.g., temperature.

ActivateRecoverMode BOOL TRUE The Tag ActivateRecoverMode V2 (Page 3026) 
determines the reaction to error.

Warning DWORD 0 Tag Warning V2 (Page 3028) shows the warnings since 
Reset = TRUE or ErrorAck =TRUE. Warning is 
retentive.

Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
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Tag Data type Default Description
CurrentSetpoint REAL 0.0 CurrentSetpoint always displays the current setpoint. 

This value is frozen during tuning.
CancelTuningLevel REAL 10.0 Permissible fluctuation of setpoint during tuning. Tuning 

is not canceled until:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel

SubstituteOutput REAL 0.0 Substitute output value
When the following conditions are met, the substitute 
output value is used:
● An error has occurred in automatic mode.
● SetSubstituteOutput = TRUE
● ActivateRecoverMode = TRUE

SetSubstituteOutput BOOL TRUE If SetSubstituteOutput = TRUE and 
ActivateRecoverMode = TRUE, the substitute output 
value configured is output as long as an error is pending.
If SetSubstituteOutput = FALSE and 
ActivateRecoverMode = TRUE, the actuator remains at 
the current output value as long as an error is pending.
If ActivateRecoverMode = FALSE, SetSubstituteOutput 
is not effective.
If SubstituteOutput is invalid (ErrorBits = 20000h), the 
substitute output value cannot be output.

Config.InputPerOn BOOL TRUE If InputPerOn = TRUE, the Input_PER parameter is 
used. If InputPerOn = FALSE, the Input parameter is 
used.

Config.InvertControl BOOL FALSE Invert control logic
If InvertControl = TRUE, an increasing control deviation 
causes a reduction in the output value.

Config.InputUpperLimit REAL 120.0 High limit of the process value
Input and Input_PER are monitored to ensure 
adherence to this limit.
At the I/O input, the process value can be a maximum 
of 18% higher than the standard range (overrange). 
This pre-assignment ensures that an error is no longer 
signaled due to a violation of the "Process value high 
limit". Only a wire-break and a short-circuit are 
recognized and PID_Compact reacts according to the 
configured reaction to error.
InputUpperLimit > InputLowerLimit

Config.InputLowerLimit REAL 0.0 Low limit of the process value
Input and Input_PER are monitored to ensure 
adherence to this limit.
InputLowerLimit < InputUpperLimit
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Tag Data type Default Description
Config.InputUpperWarning REAL 3.402822e+38 Warning high limit of the process value

If you set InputUpperWarning outside the process value 
limits, the configured absolute process value high limit 
is used as the warning high limit. 
If you configure InputUpperWarning within the process 
value limits, this value is used as the warning high limit.
InputUpperWarning > InputLowerWarning
InputUpperWarning ≤ InputUpperLimit

Config.InputLowerWarning REAL -3.402822e
+38

Warning low limit of the process value
If you set InputLowerWarning outside the process value 
limits, the configured absolute process value low limit 
is used as the warning low limit. 
If you configure InputLowerWarning within the process 
value limits, this value is used as the warning low limit.
InputLowerWarning < InputUpperWarning
InputLowerWarning ≥ InputLowerLimit

Config.OutputUpperLimit REAL 100.0 High limit of output value
For details, see OutputLowerLimit
OutputUpperLimit > OutputLowerLimit

Config.OutputLowerLimit REAL 0.0 Low limit of output value 
For Output and Output_PER, the range of values from 
-100.0 to +100.0, including zero, is valid. At -100.0, 
Output_PER = -27648; at +100.0, Output_PER = 27648.
For Output_PWM, the value range 0.0 to +100.0 
applies.
The output value limits must match the control logic.
OutputLowerLimit < OutputUpperLimit

Config.SetpointUpperLimit REAL 3.402822e+38 High limit of setpoint
If you configure SetpointUpperLimit outside the process 
value limits, the configured absolute process value high 
limit is used as the setpoint high limit. 
If you configure SetpointUpperLimit within the process 
value limits, this value is used as the setpoint high limit.

Config.SetpointLowerLimit REAL -3.402822e
+38

Low limit of the setpoint
If you set SetpointLowerLimit outside the process value 
limits, the configured process value absolute low limit 
is used as the setpoint low limit.
If you set SetpointLowerLimit within the process value 
limits, this value is used as the setpoint low limit.

Config.MinimumOnTime REAL 0.0 The minimum ON time of the pulse width modulation in 
seconds is rounded to
MinimumOnTime = n×CycleTime.Value

Config.MinimumOffTime REAL 0.0 The minimum OFF time of the pulse width modulation 
in seconds is rounded to
MinimumOffTime = n×CycleTime.Value
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Tag Data type Default Description
Config.InputScaling.UpperPointIn REAL 27648.0 Scaling Input_PER high

Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

Config.InputScaling.LowerPointIn REAL 0.0 Scaling Input_PER low
Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

Config.InputScaling.UpperPointOut REAL 100.0 Scaled high process value 
Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

Config.InputScaling.LowerPointOut REAL 0.0 Scaled low process value 
Input_PER is converted to percent based on the two 
value pairs UpperPointOut, UpperPointIn and 
LowerPointOut, LowerPointIn.

CycleTime.StartEstimation BOOL TRUE If CycleTime.StartEstimation = TRUE, the automatic 
determination of the cycle time is started. 
CycleTime.StartEstimation = FALSE once 
measurement is complete.

CycleTime.EnEstimation BOOL TRUE If CycleTime.EnEstimation = TRUE, the PID_Compact 
sampling time is calculated. 
If CycleTime.EnEstimation = FALSE, the PID_Compact 
sampling time is not calculated and you need to correct 
the configuration of CycleTime.Value manually.

CycleTime.EnMonitoring BOOL TRUE If CycleTime.EnMonitoring = FALSE, the PID_Compact 
sampling time is not monitored. If it is not possible to 
execute PID_Compact within the sampling time, no 
error (ErrorBits=0800h) is output and PID_Compact 
does not switch to "Inactive" mode.

CycleTime.Value REAL 0.1 PID_Compact sampling time in seconds
CycleTime.Value is determined automatically and is 
usually equivalent to the cycle time of the calling OB.

CtrlParamsBackUp.Gain REAL 1.0 Saved proportional gain
You can reload values from the CtrlParamsBackUp 
structure with LoadBackUp = TRUE.

CtrlParamsBackUp.Ti REAL 20.0 Saved integral action time [s]
CtrlParamsBackUp.Td REAL 0.0 Saved derivative action time [s]
CtrlParamsBackUp.TdFiltRatio REAL 0.2 Saved derivative delay coefficient
CtrlParamsBackUp.PWeighting REAL 1.0 Saved proportional action weighting factor
CtrlParamsBackUp.DWeighting REAL 1.0 Saved derivative action weighting factor
CtrlParamsBackUp.Cycle REAL 1.0 Saved sampling time of PID algorithm
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Tag Data type Default Description
PIDSelfTune.SUT.CalculateParams BOOL FALSE The properties of the controlled system are saved 

during tuning. If SUT.CalculateParams = TRUE, the 
parameters for pretuning are recalculated according to 
these properties. This enables you to change the 
parameter calculation method without having to repeat 
controller tuning.
SUT.CalculateParams is set to FALSE after the 
calculation.

PIDSelfTune.SUT.TuneRule INT 0 Methods used to calculate parameters during pretuning:
● SUT.TuneRule = 0: PID according to Chien, Hrones 

and Reswick
● SUT.TuneRule = 1: PI according to Chien, Hrones 

and Reswick
PIDSelfTune.SUT.State INT 0 The SUT.State tag indicates the current phase of 

pretuning:
● State = 0: Initialize pretuning
● State = 100: Calculate standard deviation
● State = 200: Determine point of inflection
● State = 9900: Pretuning successful
● State = 1: Pretuning not successful

PIDSelfTune.TIR.RunIn BOOL FALSE With the RunIn tag, you can specify that fine tuning can 
also be performed without pretuning.
● RunIn = FALSE

Pretuning is started when fine tuning is started from 
inactive or manual mode. If the requirements for 
pretuning are not met, PID_Compact reacts as 
when RunIn = TRUE.
If fine tuning is started from automatic mode, the 
system uses the existing PID parameters to control 
to the setpoint.
Only then will fine tuning start. If pretuning is not 
possible, PID_Compact switches to the mode from 
which tuning was started.

● RunIn = TRUE
The pretuning is skipped. PID_Compact tries to 
reach the setpoint with minimum or maximum 
output value. This can produce increased 
overshoot. Fine tuning then starts automatically.
RunIn is set to FALSE after fine tuning.

PIDSelfTune.TIR.CalculateParams BOOL FALSE The properties of the controlled system are saved 
during tuning. If TIR.CalculateParams = TRUE, the 
parameters for fine tuning are recalculated according 
to these properties. This enables you to change the 
parameter calculation method without having to repeat 
controller tuning.
TIR.CalculateParams is set to FALSE after the 
calculation.
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Tag Data type Default Description
PIDSelfTune.TIR.TuneRule INT 0 Methods used to calculate parameters during fine 

tuning:
● TIR.TuneRule = 0: PID automatic
● TIR.TuneRule = 1: PID rapid
● TIR.TuneRule = 2: PID slow
● TIR.TuneRule = 3: Ziegler-Nichols PID
● TIR.TuneRule = 4: Ziegler-Nichols PI
● TIR.TuneRule = 5: Ziegler-Nichols P

PIDSelfTune.TIR.State INT 0 The TIR.State tag indicates the current phase of fine 
tuning:
● State = -100 Fine tuning is not possible. Pretuning 

will be performed first.
● State = 0: Initialize fine tuning
● State = 200: Calculate standard deviation
● State = 300: Attempt to reach the setpoint
● State = 400: Attempt to reach the setpoint with 

existing PID parameters
(if pretuning was successful)

● State = 500: Determine oscillation and calculate 
parameters

● State = 9900: Fine tuning successful
● State = 1: Fine tuning not successful

PIDCtrl.IntegralSum REAL 0.0 Current integral action
Retain.CtrlParams.Gain REAL 1.0 Active proportional gain

To invert the control logic, use the Config.InvertControl 
tag. Negative values at Gain also invert the control 
logic. We recommend you use only InvertControl to set 
the control logic. The control logic is also inverted if 
InvertControl = TRUE and Gain < 0.0. 
Gain is retentive.

Retain.CtrlParams.Ti REAL 20.0 ● CtrlParams.Ti > 0.0: Active integral action time
● CtrlParams.Ti = 0.0: Integral action is deactivated
Ti is retentive.

Retain.CtrlParams.Td REAL 0.0 ● CtrlParams.Td > 0.0: Active derivative action time
● CtrlParams.Td = 0.0: Derivative action is 

deactivated
Td is retentive.
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Tag Data type Default Description
Retain.CtrlParams.TdFiltRatio REAL 0.2 Active derivative delay coefficient

The derivative delay coefficient delays the effect of the 
derivative action. 
Derivative delay = derivative action time × derivative 
delay coefficient
● 0.0: Derivative action is effective for one cycle only 

and therefore almost not effective.
● 0.5: This value has proved useful in practice for 

controlled systems with one dominant time constant.
● > 1.0: The greater the coefficient, the longer the 

effect of the derivative action is delayed.
TdFiltRatio is retentive.

Retain.CtrlParams.PWeighting REAL 1.0 Active proportional action weighting
The proportional action may weaken with changes to 
the setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Proportional action for setpoint change is fully 

effective
● 0.0: Proportional action for setpoint change is not 

effective
The proportional action is always fully effective when 
the process value is changed.
PWeighting is retentive.

Retain.CtrlParams.DWeighting REAL 1.0 Active derivative action weighting
The derivative action may weaken with changes to the 
setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Derivative action is fully effective upon setpoint 

change
● 0.0: Derivative action is not effective upon setpoint 

change
The derivative action is always fully effective when the 
process value is changed.
DWeighting is retentive.

Retain.CtrlParams.Cycle REAL 1.0 Active sampling time of the PID algorithm
CtrlParams.Cycle is calculated during tuning and 
rounded to an integer multiple of CycleTime.Value.
Cycle is retentive.

 

 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller.
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See also
Tag ActivateRecoverMode V2 (Page 3026)

Tag Warning V2 (Page 3028)

Downloading technology objects to device (Page 7715)

Changing the PID_Compact V2 interface
The following table shows what has changed in the PID_Compact instruction interface.

 

PID_Compact V1 PID_Compact V2 Change
Input_PER Input_PER Data type from Word to Int
 Disturbance New
 ErrorAck New
 ModeActivate New
Output_PER Output_PER Data type from Word to Int
Error ErrorBits Renamed
 Error New
 Mode New
sb_RunModeByStartup RunModeByStartup Function
 IntegralResetMode  
 OverwriteInitialOutputValue New
 SetSubstituteOutput New
 CancelTuningLevel New
 SubstituteOutput New

The following table shows which variables have been renamed.

PID_Compact V1.x PID_Compact V2
sb_GetCycleTime CycleTime.StartEstimation
sb_EnCyclEstimation CycleTime.EnEstimation
sb_EnCyclMonitoring CycleTime.EnMonitoring
sb_RunModeByStartup RunModeByStartup
si_Unit PhysicalUnit
si_Type PhysicalQuantity
sd_Warning Warning
sBackUp.r_Gain CtrlParamsBackUp.Gain
sBackUp.r_Ti CtrlParamsBackUp.Ti
sBackUp.r_Td CtrlParamsBackUp.Td
sBackUp.r_A CtrlParamsBackUp.TdFiltRatio
sBackUp.r_B CtrlParamsBackUp.PWeighting
sBackUp.r_C CtrlParamsBackUp.DWeighting
sBackUp.r_Cycle CtrlParamsBackUp.Cycle
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PID_Compact V1.x PID_Compact V2
sPid_Calc.r_Cycle CycleTime.Value
sPid_Calc.b_RunIn PIDSelfTune.TIR.RunIn
sPid_Calc.b_CalcParamSUT PIDSelfTune.SUT.CalculateParams
sPid_Calc.b_CalcParamTIR PIDSelfTune.TIR.CalculateParams
sPid_Calc.i_CtrlTypeSUT PIDSelfTune.SUT.TuneRule
sPid_Calc.i_CtrlTypeTIR PIDSelfTune.TIR.TuneRule
sPid_Calc.r_Progress Progress
sPid_Cmpt.r_Sp_Hlm Config.SetpointUpperLimit
sPid_Cmpt.r_Sp_Llm Config.SetpointLowerLimit
sPid_Cmpt.r_Pv_Norm_IN_1 Config.InputScaling.LowerPointIn
sPid_Cmpt.r_Pv_Norm_IN_2 Config.InputScaling.UpperPointIn
sPid_Cmpt.r_Pv_Norm_OUT_1 Config.InputScaling.LowerPointOut
sPid_Cmpt.r_Pv_Norm_OUT_2 Config.InputScaling.UpperPointOut
sPid_Cmpt.r_Lmn_Hlm Config.OutputUpperLimit
sPid_Cmpt.r_Lmn_Llm Config.OutputLowerLimit
sPid_Cmpt.b_Input_PER_On Config.InputPerOn
sPid_Cmpt.b_LoadBackUp LoadBackUp
sPid_Cmpt.b_InvCtrl Config.InvertControl
sPid_Cmpt.r_Lmn_Pwm_PPTm Config.MinimumOnTime
sPid_Cmpt.r_Lmn_Pwm_PBTm Config.MinimumOffTime
sPid_Cmpt.r_Pv_Hlm Config.InputUpperLimit
sPid_Cmpt.r_Pv_Llm Config.InputLowerLimit
sPid_Cmpt.r_Pv_HWrn Config.InputUpperWarning
sPid_Cmpt.r_Pv_LWrn Config.InputLowerWarning
sParamCalc.i_Event_SUT PIDSelfTune.SUT.State
sParamCalc.i_Event_TIR PIDSelfTune.TIR.State
sRet.i_Mode sRet.i_Mode has been omitted. The operating 

mode is changed using Mode and ModeActivate.
sRet.r_Ctrl_Gain Retain.CtrlParams.Gain
sRet.r_Ctrl_Ti Retain.CtrlParams.Ti
sRet.r_Ctrl_Td Retain.CtrlParams.Td
sRet.r_Ctrl_A Retain.CtrlParams.TdFiltRatio
sRet.r_Ctrl_B Retain.CtrlParams.PWeighting
sRet.r_Ctrl_C Retain.CtrlParams.DWeighting
sRet.r_Ctrl_Cycle Retain.CtrlParams.Cycle

Parameters State and Mode V2

Correlation of the parameters
The State parameter shows the current operating mode of the PID controller. You cannot 
change the State parameter. 
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With a rising edge at ModeActivate, PID_Compact switches to the operating mode saved in 
the Mode in-out parameter.

When the CPU is switched on or switches from Stop to RUN mode, PID_Compact starts in the 
operating mode that is saved in the Mode parameter. To leave PID_Compact in "Inactive" 
mode, set RunModeByStartup = FALSE.

Meaning of values

State / Mode Description of operating mode
0 Inactive

In "Inactive" operating mode, the output value 0.0 is always output, regardless of Config.OutputUpperLimit 
and Config.OutputLowerLimit. Pulse width modulation is off.

1 Pretuning
The pretuning determines the process response to a jump change of the output value and searches for the 
point of inflection. The PID parameters are calculated from the maximum rate of rise and dead time of the 
controlled system. You obtain the best PID parameters when you perform pretuning and fine tuning.
Pretuning requirements:
● Inactive (State = 0), manual mode (State = 4), or automatic mode (State = 3)
● ManualEnable = FALSE
● Reset = FALSE
● The process value must not be too close to the setpoint.

|Setpoint - Input| > 0.3 * | Config.InputUpperLimit - Config.InputLowerLimit| and
|Setpoint - Input| > 0.5 * |Setpoint|

● The setpoint and the process value lie within the configured limits.
The more stable the process value is, the easier it is to calculate the PID parameters and the more precise 
the result will be. Noise on the process value can be tolerated as long as the rate of rise of the process value 
is significantly higher compared to the noise. 
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
Before the PID parameters are recalculated, they are backed up and can be reactivated with LoadBackUp.
The controller switches to automatic mode following successful pretuning. If pretuning is unsuccessful, the 
switchover of the operating mode is dependent on ActivateRecoverMode.
The phase of pretuning is indicated with PIDSelfTune.SUT.State.
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State / Mode Description of operating mode
2 Fine tuning

Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are recalculated 
based on the amplitude and frequency of this oscillation. PID parameters from fine tuning usually have better 
master control and disturbance characteristics than PID parameters from pretuning. You obtain the best PID 
parameters when you perform pretuning and fine tuning.
PID_Compact automatically attempts to generate an oscillation greater than the noise of the process value. 
Fine tuning is only minimally influenced by the stability of the process value. 
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
Before the PID parameters are recalculated, they are backed up and can be reactivated with LoadBackUp.
Requirements for fine tuning:
● No disturbances are expected.
● The setpoint and the process value lie within the configured limits.
● ManualEnable = FALSE
● Reset = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started from:
● Automatic mode (State = 3)

Start fine tuning from automatic mode if you wish to improve the existing PID parameters through tuning.
PID_Compact controls the system using the existing PID parameters until the control loop has stabilized 
and the requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual mode (State = 4)
If the requirements for pretuning are met, pretuning is started. The determined PID parameters will be 
used for control until the control loop has stabilized and the requirements for fine tuning have been met. 
If the process value for pretuning is already too near the setpoint or PIDSelfTune.TIR.RunIn = TRUE, an 
attempt is made to reach the setpoint with the minimum or maximum output value. This can produce 
increased overshoot. 
Only then will fine tuning start.

The controller switches to automatic mode following successful fine tuning. If fine tuning is unsuccessful, the 
switchover of the operating mode is dependent on ActivateRecoverMode.
The "Fine tuning" phase is indicated with PIDSelfTune.TIR.State.

3 Automatic mode
In automatic mode, PID_Compact corrects the controlled system in accordance with the parameters specified. 
The controller switches to automatic mode if one the following requirements is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Changing of the Mode in-out parameter to the value 3 and a rising edge at ModeActivate.
The switchover from automatic mode to manual mode is only bumpless if carried out in the commissioning 
editor.
The ActivateRecoverMode tag is taken into consideration in automatic mode.
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State / Mode Description of operating mode
4 Manual mode

In manual mode, you specify a manual output value in the ManualValue parameter.
You can also activate this operating mode using ManualEnable = TRUE. We recommend that you change 
the operating mode using Mode and ModeActivate only.
The switchover from manual mode to automatic mode is bumpless. Manual mode is also possible when an 
error is pending.

5 Substitute output value with error monitoring
The control algorithm is deactivated. The SetSubstituteOutput tag determines which output value is output in 
this operating mode.
● SetSubstituteOutput = FALSE: Last valid output value
● SetSubstituteOutput = TRUE: Substitute output value
You cannot activate this operating mode using Mode = 5. 
In the event of an error, it is activated instead of "Inactive" operating mode if all the following conditions are 
met:
● Automatic mode (Mode = 3)
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode is effective.
As soon as the errors are no longer pending, PID_Compact switches back to automatic mode.

ENO characteristics
If State = 0, then ENO = FALSE.

If State ≠ 0, then ENO = TRUE. 

Automatic switchover of operating mode during commissioning
Automatic mode is activated following successful pretuning or fine tuning. The following table 
shows how Mode and State change during successful pretuning.

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning successfully completed
n 3 3 Automatic mode is started

PID_Compact automatically switches the operating mode in the event of an error. The following 
table shows how Mode and State change during pretuning with errors. 

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
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Cycle no. Mode State Action
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning canceled
n 4 4 Manual mode is started

If ActivateRecoverMode = TRUE, the operating mode that is saved in the Mode parameter is 
activated. At the start of pretuning or fine tuning, PID_Compact has saved the value of State 
in the Mode in/out parameter. PID_Compact therefore switches to the operating mode from 
which tuning was started.

If ActivateRecoverMode = FALSE, the system switches to "Inactive" operating mode.

See also
Output parameters of PID_Compact V2 (Page 3010)

Parameter ErrorBits V2
If several errors are pending simultaneously, the values of the ErrorBits are displayed with 
binary addition. The display of ErrorBits = 0003h, for example, indicates that the errors 0001h 
and 0002h are pending simultaneously.

In manual mode, PID_Compact uses ManualValue as output value. The exception is Errorbits 
= 10000h.

ErrorBits
 (DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > Config.InputUpperLimit or
● Input < Config.InputLowerLimit
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
remains in automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0004 Error during fine tuning. Oscillation of the process value could not be maintained.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0008 Error at start of pretuning. The process value is too close to the setpoint. Start fine tuning.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.
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ErrorBits
 (DW#16#...)

Description

0010 The setpoint was changed during tuning.
You can set the permitted fluctuation of the setpoint at the CancelTuningLevel tag.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0020 Pretuning is not permitted during fine tuning.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact remains in fine tuning mode.

0080 Error during pretuning. Incorrect configuration of output value limits.
Check whether the limits of the output value are configured correctly and match the control logic.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0100 Error during fine tuning resulted in invalid parameters.
If ActivateRecoverMode = TRUE before the error occurred, PID_Compact cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0200 Invalid value at "Input" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0400 Calculation of output value failed. Check the PID parameters.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

0800 Sampling time error: PID_Compact is not called within the sampling time of the cyclic interrupt OB.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
remains in automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_Compact 
outputs the configured substitute output value. As soon as the error is no longer pending, PID_Compact 
switches back to automatic mode.
If pretuning or fine tuning mode was active before the error occurred and ActivateRecoverMode = TRUE, 
PID_Compact switches to the operating mode that is saved in the Mode parameter.

10000 Invalid value at ManualValue parameter. Value has an invalid number format.
If ActivateRecoverMode = TRUE  before an error occurred, PID_Compact uses SubstituteOutput as the 
output value. As soon as you specify a valid value in ManualValue, PID_Compact uses it as the output 
value.
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ErrorBits
 (DW#16#...)

Description

20000 Invalid value at SubstituteOutput tag. Value has an invalid number format.
PID_Compact uses the output value low limit as the output value. 
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_Compact switches back to automatic mode.

40000 Invalid value at Disturbance parameter. Value has an invalid number format.
If automatic mode was active and ActivateRecoverMode = TRUE before the error occurred, Disturbance 
is set to zero. PID_Compact remains in automatic mode.
If pretuning or fine tuning mode was active and ActivateRecoverMode = TRUE before the error occurred, 
PID_Compact switches to the operating mode saved in the Mode parameter. If Disturbance in the current 
phase has no effect on the output value, tuning is not be canceled. 

Tag ActivateRecoverMode V2
The ActivateRecoverMode tag determines the reaction to error. The Error parameter indicates 
if an error is pending. When the error is no longer pending, Error = FALSE. The ErrorBits 
parameter shows which errors have occurred. 

Automatic mode
 

 NOTICE

Your system may be damaged.

If ActivateRecoverMode = TRUE, PID_Compact remains in automatic mode even if there is 
an error and the process limit values are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 
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ActivateRecover
Mode

Description

FALSE PID_Compact automatically switches to "Inactive" mode in the event of an error. The controller is only 
activated by a falling edge at Reset or a rising edge at ModeActivate.

TRUE If errors occur frequently in automatic mode, this setting has a negative effect on the control response, 
because PID_Compact switches between the calculated output value and the substitute output value at 
each error. In this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more of the following errors occur, PID_Compact stays in automatic mode:
● 0001h: The "Input" parameter is outside the process value limits.
● 0800h: Sampling time error
● 40000h: Invalid value at parameter Disturbance. 
If one or more of the following errors occur, PID_Compact switches to "Substitute output value with error 
monitoring" mode:
● 0002h: Invalid value at Input_PER parameter.
● 0200h: Invalid value at Input parameter.
● 0400h: Calculation of output value failed.
● 1000h: Invalid value at Setpoint parameter. 
If the following error occurs, PID_Compact switches to "Substitute output value with error monitoring" 
mode and moves the actuator to Config.OutputLowerLimit:
● 20000h: Invalid value at SubstituteOutput tag. Value has an invalid number format.
This characteristics are independent of SetSubstituteOutput. 
As soon as the errors are no longer pending, PID_Compact switches back to automatic mode.

Pretuning and fine tuning

ActivateRecover
Mode

Description

FALSE PID_Compact automatically switches to "Inactive" mode in the event of an error. The controller is only 
activated by a falling edge at Reset or a rising edge at ModeActivate.

TRUE If the following error occurs, PID_Compact remains in the active mode:
● 0020h: Pretuning is not permitted during fine tuning.
The following errors are ignored:
● 10000h: Invalid value at ManualValue parameter.
● 20000h: Invalid value at SubstituteOutput tag. 
When any other error occurs, PID_Compact cancels the tuning and switches to the mode from which 
tuning was started.

Manual mode
ActivateRecoverMode is not effective in manual mode.
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Tag Warning V2
If several warnings are pending simultaneously, the values of the Warning tag are displayed 
with binary addition. The display of warning 0003h, for example, indicates that the warnings 
0001h and 0002h are pending simultaneously.

Warning
(DW#16#....)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0004 The setpoint was limited to the configured limits.
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. 

Instead, the PID parameters were calculated using the TIR.TuneRule = 3 method.
0010 The operating mode could not be changed because Reset = TRUE or ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
0080 Invalid value at Mode. The operating mode is not switched.
0100 The manual value was limited to the limits of the controller output.
0200 The specified rule for tuning is not supported. No PID parameters are calculated.
1000 The substitute output value cannot be reached because it is outside the output value limits.

The following warnings are deleted as soon as the cause is eliminated:

● 0001h

● 0004h

● 0008h

● 0040h

● 0100h

All other warnings are cleared with a rising edge at Reset or ErrorAck.

PID_Compact V1

Description of PID_Compact V1

Description   
The PID_Compact instruction provides a PID controller with integrated tuning for automatic 
and manual mode.

Call
PID_Compact is called in the constant interval of the cycle time of the calling OB (preferably 
in a cyclic interrupt OB).
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Download to device
The actual values of retentive tags are only updated when you download PID_Compact 
completely.

Downloading technology objects to device (Page 7715)

Startup
At the startup of the CPU, PID_Compact starts in the operating mode that was last active. To 
retain PID_ Compact in "Inactive" mode, set sb_RunModeByStartup = FALSE.

Monitoring of the sampling time PID_Compact
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_Compact 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. If the current sampling time deviates too much from this mean 
value, Error = 0800 hex occurs and PID_Compact switches to "Inactive" mode.

PID_Compact, Version 1.1 or higher is set to "Inactive" mode during controller tuning under 
the following conditions:

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

In automatic mode, PID_Compact, Version 1.1 or higher, is set to "Inactive" mode under the 
following conditions:

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value

During controller tuning and in automatic mode, PID_Compact 1.0 is set to "Inactive" operating 
mode under the following conditions:

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

● Current sampling time >= 1.5 x current mean value

● Current sampling time <= 0.5 x current mean value

Sampling time of the PID algorithm
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.
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PID algorithm
PID_Compact is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The following equation is used to calculate the output value.

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (T1 = a × TD)
 Derivative action time
c Derivative action weighting

Block diagram of PID_Compact
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Block diagram of PIDT1 with anti-windup

Reaction to error
If errors occur, they are output in parameter Error, and PID_Compact changes to "Inactive" 
mode. Reset the errors using the Reset parameter.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_Compact does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 

See also
Controller type (Page 7754)

Input parameters of PID_Compact V1

Table 9-83    

Parameter Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A variable of the user program is used as source for the process value. 

If you are using parameter Input, then 
sPid_Cmpt.b_Input_PER_On = FALSE must be set.
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Parameter Data type Default Description
Input_PER WORD W#16#0 Analog input as the source of the process value 

If you are using parameter Input_PER, then 
sPid_Cmpt.b_Input_PER_On = TRUE must be set.

ManualEnable BOOL FALSE ● A FALSE -> TRUE edge selects "Manual mode", while State = 4, 
sRet.i_Mode remains unchanged.

● A TRUE -> FALSE edge selects the most recently active operating 
mode, State =sRet.i_Mode

A change of sRet.i_Mode will not take effect during ManualEnable = 
TRUE. The change of sRet.i_Mode will only be considered upon a 
TRUE -> FALSE edge at ManualEnable .
PID_Compact V1.2 und PID_Compact V1.0
If at start of the CPU ManualEnable = TRUE, PID_Compact starts in 
manual mode. A rising edge (FALSE > TRUE) at ManualEnable is not 
necessary.
PID_Compact V1.1
At the start of the CPU, PID_Compact only switches to manual mode 
with a rising edge (FALSE->TRUE) at ManualEnable . Without rising 
edge, PID_Compact starts in the last operating mode in which 
ManualEnable was FALSE.

ManualValue REAL 0.0 Manual value
This value is used as the output value in manual mode.

Reset BOOL FALSE The Reset parameter (Page 3041) restarts the controller.

Output parameters of PID_Compact V1

Table 9-84

Parameter Data type Default Description
ScaledInput REAL 0.0 Output of the scaled process value
Outputs "Output", "Output_PER", and "Output_PWM" can be used concurrently.
Output REAL 0.0 Output value in REAL format
Output_PER WORD W#16#0 Analog output value 
Output_PWM BOOL FALSE Pulse-width-modulated output value

The output value is formed by minimum On and Off times.
SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the setpoint absolute high limit is reached. 

The setpoint in the CPU is limited to the configured setpoint absolute 
high limit. The configured process value absolute high limit is the 
default for the setpoint high limit.
If you set sPid_Cmpt.r_Sp_Hlm  to a value within the process value 
limits, this value is used as the setpoint high limit.

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the setpoint absolute low limit has been 
reached. In the CPU, the setpoint is limited to the configured setpoint 
absolute low limit. The configured process value absolute low limit is 
the default setting for the setpoint low limit.
If you set sPid_Cmpt.r_Sp_Llm  to a value within the process value 
limits, this value is used as the setpoint low limit.
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Parameter Data type Default Description
InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached or 

exceeded the warning high limit.
InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached or fallen 

below the warning low limit.
State INT 0 The State parameter (Page 3038) shows the current operating mode 

of the PID controller. To change the operating mode, use variable 
sRet.i_Mode. 
● State = 0: Inactive
● State = 1: pretuning
● State = 2: fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode

Error DWORD W#16#0 The Error parameter (Page 3041) indicates the error messages. 
Error = 0000: No error pending.

Static tags of PID_Compact V1
You must not change tags that are not listed. These are used for internal purposes only.

Table 9-85    

Tag Data type Default Description
sb_GetCycleTime BOOL TRUE If sb_GetCycleTime = TRUE, the automatic 

determination of the cycle time is started. 
CycleTime.StartEstimation = FALSE once 
measurement is complete.

sb_EnCyclEstimation BOOL TRUE If sb_EnCyclEstimation = TRUE, the sampling time 
PID_Compact is calculated. 

sb_EnCyclMonitoring BOOL TRUE If sb_EnCyclMonitoring = FALSE, the sampling time 
PID_Compact is not monitored. If it is not possible to 
execute PID_Compact within the sampling time, an 
0800 error is not output and PID_Compact does not 
change to "Inactive" mode.

sb_RunModeByStartup BOOL TRUE Activate Mode after CPU restart
If sb_RunModeByStartup = FALSE, the controller will 
remain inactive after a CPU startup. 
After a CPU startup and if sb_RunModeByStartup = 
TRUE, the controller will return to the most recently 
active operating mode.

si_Unit INT 0 Unit of measurement of the process value and 
setpoint, e.g., ºC, or ºF.

si_Type INT 0 Physical quantity of the process value and setpoint, 
e.g., temperature.

sd_Warning DWORD DW#16#0 Variable sd_warning (Page 3043) displays the 
warnings generated since the reset, or since the last 
change of the operating mode.
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Tag Data type Default Description
sBackUp.r_Gain REAL 1.0 Saved proportional gain

You can reload values from the sBackUp structure 
with sPid_Cmpt.b_LoadBackUp = TRUE.

sBackUp.r_Ti REAL 20.0 Saved integral action time [s]
sBackUp.r_Td REAL 0.0 Saved derivative action time [s]
sBackUp.r_A REAL 0.0 Saved derivative delay coefficient
sBackUp.r_B REAL 0.0 Saved proportional action weighting factor
sBackUp.r_C REAL 0.0 Saved derivative action weighting factor
sBackUp.r_Cycle REAL 1.0 Saved sampling time of PID algorithm
sPid_Calc.r_Cycle REAL 0.1 Sampling time of the PID_Compact instruction

r_Cycle is determined automatically and usually 
equivalent to the cycle time of the calling OB.

sPid_Calc.b_RunIn BOOL FALSE ● b_RunIn = FALSE
Pretuning is started when fine tuning is started 
from inactive or manual mode. If the requirements 
for pretuning are not met, PID_Compact reacts like 
b_RunIn = TRUE.
If fine tuning is started from automatic mode, the 
system uses the existing PID parameters to control 
to the setpoint.
Only then will fine tuning start. If pretuning is not 
possible, PID_Compact will change to "Inactive" 
mode.

● b_RunIn = TRUE
The pretuning is skipped. PID_3Compact tries to 
reach the setpoint with minimum or maximum 
output value. This can produce increased 
overshoot. Fine tuning then starts automatically.
b_RunIn is set to FALSE after fine tuning.

sPid_Calc.b_CalcParamSUT BOOL FALSE The parameters for pretuning will be recalculated if 
b_CalcParamSUT = TRUE. This enables you to 
change the parameter calculation method without 
having to repeat controller tuning.
b_CalcParamSUT will be set to FALSE after 
calculation.

sPid_Calc.b_CalcParamTIR BOOL FALSE The parameters for fine tuning will be recalculated if 
b_CalcParamTIR = TRUE. This enables you to 
change the parameter calculation method without 
having to repeat controller tuning.
b_CalcParamTIR  will be set to FALSE after 
calculation.

sPid_Calc.i_CtrlTypeSUT INT 0 Methods used to calculate parameters during 
pretuning:
● i_CtrlTypeSUT = 0: PID according to Chien, 

Hrones and Reswick
● i_CtrlTypeSUT = 1: PI according to Chien, Hrones 

and Reswick

Programming the PLC
9.7 References

WinCC Professional V13.0
3034 System Manual, 02/2014



Tag Data type Default Description
sPid_Calc.i_CtrlTypeTIR INT 0 Methods used to calculate parameters during fine 

tuning:
● i_CtrlTypeTIR = 0: PID automatic
● i_CtrlTypeTIR = 1: PID rapid
● i_CtrlTypeTIR = 2: PID slow
● i_CtrlTypeTIR = 3: Ziegler-Nichols PID
● i_CtrlTypeTIR = 4: Ziegler-Nichols PI
● i_CtrlTypeTIR = 5: Ziegler-Nichols P

sPid_Calc.r_Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
sPid_Cmpt.r_Sp_Hlm REAL +3.402822e

+38
High limit of setpoint
If you set sPid_Cmpt.r_Sp_Hlm outside the process 
value limits, the configured process value absolute 
high limit is used as the setpoint high limit. 
If you set sPid_Cmpt.r_Sp_Hlm  within the process 
value limits, this value is used as the setpoint high limit. 

sPid_Cmpt.r_Sp_Llm REAL -3.402822e
+38

Low limit of the setpoint
If you set sPid_Cmpt.r_Sp_Llm outside the process 
value limits, the configured process value absolute low 
limit is used as the setpoint low limit.
If you set sPid_Cmpt.r_Sp_Llm  within the process 
value limits, this value is used as the setpoint low limit. 

sPid_Cmpt.r_Pv_Norm_IN_1 REAL 0.0 Scaling Input_PER low
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Pv_Norm_IN_2 REAL 27648.0 Scaling Input_PER high
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Pv_Norm_OUT_1 REAL 0.0 Scaled low process value 
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Pv_Norm_OUT_2 REAL 100.0 Scaled high process value 
Input_PER is converted to percent based on the two 
value pairs r_Pv_Norm_OUT_1, r_Pv_Norm_IN_1 and 
r_Pv_Norm_OUT_2, r_Pv_Norm_IN_2 from the 
sPid_Cmpt structure.

sPid_Cmpt.r_Lmn_Hlm REAL 100.0 Output value high limit for output parameter "Output"
sPid_Cmpt.r_Lmn_Llm REAL 0.0 Low output value limit for output parameter "Output"
sPid_Cmpt.b_Input_PER_On BOOL TRUE If b_Input_PER_On = TRUE, then parameter 

Input_PER is used. If b_Input_PER_On = FALSE, then 
parameter Input is used.
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Tag Data type Default Description
sPid_Cmpt.b_LoadBackUp BOOL FALSE Activate the back-up parameter set. If an optimization 

has failed, you can reactivate the previous PID 
parameters by setting this bit.

sPid_Cmpt.b_InvCtrl BOOL FALSE Invert control logic
With b_InvCtrl = TRUE, a rising control deviation 
reduces the output value.

sPid_Cmpt.r_Lmn_Pwm_PPTm REAL 0.0 The minimum ON time of the pulse width modulation 
in seconds is rounded to
r_Lmn_Pwm_PPTm = r_Cycle or 
r_Lmn_Pwm_PPTm = n*r_Cycle

sPid_Cmpt.r_Lmn_Pwm_PBTm REAL 0.0 The minimum OFF time of the pulse width modulation 
in seconds is rounded to
r_Lmn_Pwm_PBTm = r_Cycle or 
r_Lmn_Pwm_PBTm = n*r_Cycle

sPid_Cmpt.r_Pv_Hlm REAL 120.0 High limit of the process value
At the I/O input, the process value can be a maximum 
of 18% higher than the standard range (overrange). 
An error is no longer reported for a violation of the 
"Process value high limit". Only a wire-break and a 
short-circuit are recognized and the PID_Compact 
switches to "Inactive" mode.
r_Pv_Hlm > r_Pv_Llm

sPid_Cmpt.r_Pv_Llm REAL 0.0 Low limit of the process value
r_Pv_Llm < r_Pv_Hlm

sPid_Cmpt.r_Pv_HWrn REAL +3.402822e
+38

Warning high limit of the process value
If you set r_Pv_HWrn outside the process value limits, 
the configured process value absolute high limit is 
used as the warning high limit. 
If you set r_Pv_HWrn within the process value limits, 
this value is used as the warning high limit.
r_Pv_HWrn > r_Pv_LWrn
r_Pv_HWrn ≤ r_Pv_Hlm

sPid_Cmpt.r_Pv_LWrn REAL -3.402822e
+38

Warning low limit of the process value
If you set r_Pv_LWrn outside the process value limits, 
the configured process value absolute low limit is used 
as the warning low limit. 
If you set r_Pv_LWrn within the process value limits, 
this value is used as the warning low limit.
r_Pv_LWrn < r_Pv_HWrn
r_Pv_LWrn ≥ r_Pv_LWrn

sParamCalc.i_Event_SUT INT 0 Variable i_Event_SUT (Page 3044) indicates the 
current phase of "pretuning":

sParamCalc.i_Event_TIR INT 0 Variable i_Event_TIR (Page 3044) indicates the 
current phase of "fine tuning": 
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Tag Data type Default Description
sRet.i_Mode INT 0 The operating mode is changed edge-triggered.

The following operating mode is enabled on a change 
to
● i_Mode = 0: "Inactive" (controller stop)
● i_Mode = 1: "Pretuning" mode
● i_Mode = 2: "Fine tuning" mode
● i_Mode = 3: "Automatic mode"
● i_Mode = 4: "Manual mode"
i_Mode is retentive.

sRet.r_Ctrl_Gain REAL 1.0 Active proportional gain
Gain is retentive.

sRet.r_Ctrl_Ti REAL 20.0 ● r_Ctrl_Ti > 0.0: active integral action time
● r_Ctrl_Ti = 0.0: Integral action is disabled
r_Ctrl_Ti is retentive.

sRet.r_Ctrl_Td REAL 0.0 ● r_Ctrl_Td > 0.0: Active derivative action time
● r_Ctrl_Td = 0.0: Derivative action is disabled
r_Ctrl_Td is retentive.

sRet.r_Ctrl_A REAL 0.0 Active derivative delay coefficient
r_Ctrl_A is retentive.

sRet.r_Ctrl_B REAL 0.0 Active proportional action weighting
r_Ctrl_B is retentive.

sRet.r_Ctrl_C REAL 0.0 Active derivative action weighting
r_Ctrl_C is retentive.

sRet.r_Ctrl_Cycle REAL 1.0 Active sampling time of the PID algorithm
r_Ctrl_Cycle is calculated during controller tuning and 
rounded to an integer multiple of r_Cycle.
r_Ctrl_Cycle is retentive.

 
 

 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller. The "Inactive" mode is forced by setting variable "sRet.i_Mode" to "0".

 

See also
Downloading technology objects to device (Page 7715)
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Parameters State and sRet.i_Mode V1

Correlation of the parameters
The State parameter indicates the current operating mode of the PID controller. You cannot 
modify the State parameter. 

You need to modify the sRet.i_Mode tag to change the operating mode. This also applies when 
the value for the new operating mode is already in sRet.i_Mode. First set sRet.i_Mode = 0 and 
then sRet.i_Mode = 3. Provided the current operating mode of the controller supports this 
change, State is set to the value of sRet.i_Mode.

When PID_Compact automatically switches the operating mode, the following applies: State !
= sRet.i_Mode.

Examples:

● Successful pretuning
State = 3 and sRet.i_Mode = 1

● Error
State = 0 and sRet.i_Mode remains at the same value, e.g sRet.i_Mode = 3

● ManualEnalbe = TRUE
State = 4 and sRet.i_Mode remain at the previous value, for example, sRet.i_Mode = 3

 

  Note

You wish to repeat successful fine tuning without exiting automatic mode with i_Mode = 0.

Setting sRet.i_Mode to an invalid value such as 9999 for one cycle has no effect on State. 
Set Mode = 2 in the next cycle. You can generate a change to sRet.i_Mode without first 
switching to "inactive" mode.
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Meaning of values

State / 
sRet.i_Mode

Description of the operating mode

0 Inactive
The controller is switched off. 
The controller was in "inactive" mode before pretuning was performed.
The PID controller will change to "inactive" mode when running if an error occurs or if the "Deactivate 
controller" icon is clicked in the commissioning window.

1 Pretuning
The pretuning determines the process response to a jump of the output value and searches for the point of 
inflection. The optimized PID parameters are calculated as a function of the maximum rate of rise and dead 
time of the controlled system. 
Pretuning requirements:
● The controller is in inactive mode or manual mode
● ManualEnable = FALSE
● The process value must not be too close to the setpoint.

|Setpoint - Input| > 0.3 * |sPid_Cmpt.r_Pv_Hlm - sPid_Cmpt.r_Pv_Llm| and
|Setpoint - Input| > 0.5 * |Setpoint|

● The setpoint may not be changed during pretuning.
The higher the stability of the process value, the easier it is to calculate the PID parameters and increase 
precision of the result. Noise on the process value can be tolerated as long as the rate of rise of the process 
value is significantly higher compared to the noise. 
PID parameters are backed up before they are recalculated and can be reactivated with 
sPid_Cmpt.b_LoadBackUp.
There is a change to automatic mode following successful pretuning and to "inactive" mode following 
unsuccessful pretuning.
The phase of pretuning is indicated with Tag i_Event_SUT V1 (Page 3044).
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State / 
sRet.i_Mode

Description of the operating mode

2 Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are optimized 
based on the amplitude and frequency of this oscillation. The differences between the process response 
during pretuning and fine tuning are analyzed. All PID parameters are recalculated on the basis of the findings. 
PID parameters from fine tuning usually have better master control and disturbance behavior than PID 
parameters from pretuning.
PID_Compact automatically attempts to generate an oscillation greater than the noise of the process value. 
Fine tuning is only minimally influenced by the stability of the process value. 
PID parameters are backed up before they are recalculated and can be reactivated with 
sPid_Cmpt.b_LoadBackUp.
Requirements for fine tuning:
● No disturbances are expected.
● The setpoint and the process value lie within the configured limits.
● The setpoint may not be changed during fine tuning.
● ManualEnable = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started in:
● Automatic mode (State = 3)

Start fine tuning in automatic mode if you wish to improve the existing PID parameters using controller 
tuning.
PID_Comact will regulate using the existing PID parameters until the control loop has stabilized and the 
requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual (State = 4) mode
If the requirements for pretuning are met, pretuning is started. The PID parameters established will be 
used for adjustment until the control loop has stabilized and the requirements for fine tuning have been 
met. Only then will fine tuning start. If pretuning is not possible, PID_Compact will change to "Inactive" 
mode.
An attempt is made to reach the setpoint with a minimum or maximum output value if the process value 
for pretuning is already too near the setpoint or sPid_Calc.b_RunIn = TRUE. This can produce increased 
overshoot.

The controller will change to "automatic mode" after successfully completed "fine tuning" and to "inactive" 
mode if "fine tuning" has not been successfully completed.
The "Fine tuning" phase is indicated with Tag i_Event_TIR V1 (Page 3044).

3 Automatic mode
In automatic mode, PID_Compact corrects the controlled system in accordance with the parameters specified. 
The controller changes to automatic mode if one the following conditions is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Change of variable sRet.i_Mode to the value 3.
After CPU startup or change from Stop to RUN mode, PID_Compact will start in the most recently active 
operating mode. To retain PID_Compact in "Inactive" mode, set sb_RunModeByStartup = FALSE.

4 Manual mode
In manual mode, you specify a manual output value in the ManualValue parameter.
This operating mode is enabled if sRet.i_Mode = 4, or at the rising edge on ManualEnable. If ManualEnable 
changes to TRUE, only State will change. sRet.i_Mode will retain its current value. PID_Compact will return 
to the previous operating mode upon a falling edge at ManualEnable.
The change to automatic mode is bumpless.
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See also
Output parameters of PID_Compact V1 (Page 3032)

Pretuning (Page 7764)

Fine tuning (Page 7766)

"Manual" mode (Page 7767)

Tag i_Event_SUT V1 (Page 3044)

Tag i_Event_TIR V1 (Page 3044)

Parameter Error V1
If several errors are pending simultaneously, the values of the error codes are displayed with 
binary addition. The display of error code 0003, for example, indicates that the errors 0001 
and 0002 are pending simultaneously.

Error
 (DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > sPid_Cmpt.r_Pv_Hlm or
● Input < sPid_Cmpt.r_Pv_Llm
You cannot move the actuator again until you eliminate the error.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
0004 Error during fine tuning. Oscillation of the process value could not be maintained.
0008 Error at start of pretuning. The process value is too close to the setpoint. Start fine tuning.
0010 The setpoint was changed during tuning.
0020 Pretuning is not permitted in automatic mode or during fine tuning.
0080 Incorrect configuration of output value limits.

Check whether the limits of the output value are configured correctly and match the control logic.
0100 Error during tuning resulted in invalid parameters.
0200 Invalid value at "Input" parameter: Value has an invalid number format.
0400 Calculation of output value failed. Check the PID parameters.
0800 Sampling time error: PID_Compact is not called within the sampling time of the cyclic interrupt OB.
1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.

See also
Output parameters of PID_Compact V1 (Page 3032)

Parameter Reset V1
The response to Reset = TRUE depends on the version of the PID_Compact instruction.
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Reset response PID_Compact V.1.1 or higher
A rising edge at Reset resets the errors and warnings and clears the integral action. A falling 
edge at Reset triggers a change to the most recently active operating mode.

① Activation
② Error
③ Reset
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Reset response PID_Compact V.1.0
A rising edge at Reset resets the errors and warnings and clears the integral action. The 
controller is not reactivated until the next edge at i_Mode. 

① Activation
② Error
③ Reset

 

Tag sd_warning V1
If several warnings are pending, the values of variable sd_warning are displayed by means of 
binary addition. The display of warning 0003, for example, indicates that the warnings 0001 
and 0002 are also pending.

sd_warning
(DW#16#....)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0002 Oscillation increased during fine tuning.
0004 The setpoint was outside the set limits.
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. The 

PID parameters were instead calculated using the "i_CtrlTypeTIR = 3" method.
0010 The operating mode could not be changed because ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 3043



The following warnings are deleted as soon as the cause is dealt with:

● 0004

● 0020

● 0040

All other warnings are cleared with a rising edge at Reset.

Tag i_Event_SUT V1

i_Event_SUT Name Description
0 SUT_INIT Initialize pretuning

100 SUT_STDABW Calculate the standard deviation
200 SUT_GET_POI Find the point of inflection

9900 SUT_IO Pretuning successful
1 SUT_NIO Pretuning not successful

See also
Static tags of PID_Compact V1 (Page 3033)

Parameters State and sRet.i_Mode V1 (Page 3038)

Tag i_Event_TIR V1

i_Event_TIR Name Description
-100 TIR_FIRST_SUT Fine tuning is not possible. Pretuning will be executed first.

0 TIR_INIT Initialize fine tuning
200 TIR_STDABW Calculate the standard deviation
300 TIR_RUN_IN Attempt to reach the setpoint
400 TIR_CTRLN Attempt to reach the setpoint with the existing PID parameters 

(if pretuning has been successful)
500 TIR_OSZIL Determine oscillation and calculate parameters

9900 TIR_IO Fine tuning successful
1 TIR_NIO Fine tuning not successful

See also
Static tags of PID_Compact V1 (Page 3033)

Parameters State and sRet.i_Mode V1 (Page 3038)

Programming the PLC
9.7 References

WinCC Professional V13.0
3044 System Manual, 02/2014



PID_3Step

New features of PID_3Step

PID_3Step V2.2
●  Use with S7-1200

As of PID_3Step V2.2, the instruction with V2 functionality can also be used on S7-1200 
with firmware version 4.0 or higher.

PID_3Step V2.0
● Reaction to error

The reaction to ActivateRecoverMode = TRUE has been completely overhauled. 
PID_3Step reacts in a more fault tolerant manner in the default setting.

 

 
 NOTICE

Your system may be damaged.

If you use the default setting, PID_3Step remains in automatic mode even if the process 
value limits are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to 
protect your system from damage. 

 

You use the ErrorAck input parameter to acknowledge the errors and warnings without 
restarting the controller or clearing the integral action.
Switching operating modes does not acknowledge errors that are no longer pending.

● Switching the operating mode
You specify the operating mode at the Mode in/out parameter and use a rising edge at 
ModeActivate to start the operating mode. The Retain.Mode tag has been omitted. 
The transition time measurement can no longer be started with GetTransitTime.Start, but 
only with Mode = 6 and a rising edge at ModeActivate.

● Multi-instance capability
You can call up PID_3Step as multi-instance DB. No technology object is created in this 
case and no parameter assignment interface or commissioning interface is available. You 
must assign parameters for PID_3Step directly in the multi-instance DB and commission it 
via a watch table.

● Startup characteristics
The operating mode specified at the Mode parameter is also started on a falling edge at 
Reset and during a CPU cold restart, if RunModeByStartup = TRUE.

● ENO characteristics
ENO is set depending on the operating mode.
If State = 0, then ENO = FALSE.
If State ≠ 0, then ENO = TRUE. 
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● Manual mode
The Manual_UP and Manual_DN input parameters no longer function as edge-triggered 
parameters. Edge-triggered manual mode continues to be possible using the 
ManualUpInternal and ManualDnInternal tags.
In "Manual mode without endstop signals" (Mode = 10), the endstop signals Actuator_H 
and Actuator_L are ignored even though they are activated.

● Default value of PID parameters
The following default settings have been changed:

– Proportional action weighting (PWeighting) from 0.0 to 1.0

– Derivative action weighting (DWeighting) from 0.0 to 1.0

– Coefficient for derivative delay (TdFiltRatio) from 0.0 to 0.2

● Limiting of motor transition time
You configure the maximum percentage of the motor transition time that the actuator will 
travel in one direction in the Config.VirtualActuatorLimit tag.

● Setpoint value specification during tuning
You configure the permitted fluctuation of the setpoint during tuning at the 
CancelTuningLevel tag.

● Switching a disturbance variable on
You can switch a disturbance variable on at the Disturbance parameter.

● Troubleshooting
If the endstop signals are not activated (ActuatorEndStopOn = FALSE), ScaledFeedback 
is determined without Actuator_H or Actuator_L. 

PID_3Step V1.1
● Manual mode on CPU startup

If ManualEnable = TRUE when the CPU starts, PID_3Step starts in manual mode. A rising 
edge at ManualEnable is not necessary. 

● Reaction to error
The ActivateRecoverMode tag is no longer effective in manual mode.

● Troubleshooting
The Progress tag is reset following successful tuning or transition time measurement.

Compatibility with CPU and FW 
The following table shows which version of PID_3Step can be used on which CPU.

CPU FW PID_3Step
S7-1200 V4.X V2.2

V1.1
S7-1200 V3.X V1.1

V1.0
S7-1200 V2.X V1.1

V1.0
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CPU FW PID_3Step
S7-1200 V1.X -
S7-1500 V1.1 V2.2

V2.1
V2.0

S7-1500 V1.0 V2.0

PID_3Step V2

Description of PID_3Step V2

Description   
You use the PID_3Step instruction to configure a PID controller with self tuning for valves or 
actuators with integrating behavior. 

The following operating modes are possible:

● Inactive

● Pretuning

● Fine tuning

● Automatic mode

● Manual mode

● Approach substitute output value

● Transition time measurement

● Error monitoring

● Approach substitute output value with error monitoring

● Manual mode without endstop signals

For a more detailed description of the operating modes, see the State parameter.
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PID algorithm
PID_3Step is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The PID algorithm operates according to the following equation:

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
Δy Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
TD Derivative action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
c Derivative action weighting
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Block diagram without position feedback
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Block diagram with position feedback
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Block diagram of PIDT1 with anti-windup

Call
PID_3Step is called in the constant time scale of a cycle interrupt OB.

If you call PID_3Step as a multi-instance DB, no technology object is created. No parameter 
assignment interface or commissioning interface is available. You must assign parameters for 
PID_3Step directly in the multi-instance DB and commission it via a watch table.

Download to device
The actual values of retentive tags are only updated when you download PID_3Step 
completely.

Downloading technology objects to device (Page 7715)

Startup
When the CPU starts up, PID_3Step starts in the operating mode that is saved in the Mode in/
out parameter. To leave PID_3Step in "Inactive" mode, set RunModeByStartup = FALSE.

Reaction to error
In automatic mode and during commissioning, the reaction to error depends on the 
ErrorBehaviour and ActivateRecoverMode tags. In manual mode, the reaction is independent 
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of ErrorBehaviour and ActivateRecoverMode. If ActivateRecoverMode = TRUE, the reaction 
additionally depends on the error that occurred.

ErrorBeha
viour

ActivateRecov
erMode

Configuration editor 
> actuator setting
> Set Output to

Reaction

FALSE FALSE Current output value Switch to "Inactive" mode (State = 0)
The actuator remains in the current 
position. 

FALSE TRUE Current output value while 
error is pending

Switch to "Error monitoring" mode 
(State = 7)
The actuator remains in the current 
position while the error is pending.

TRUE FALSE Substitute output value Switch to "Approach substitute output 
value" mode (State = 5)
The actuator moves to the configured 
substitute output value.
Switch to "Inactive" mode (State = 0)
The actuator remains in the current 
position. 

TRUE TRUE Substitute output value while 
error is pending

Switch to "Approach substitute output 
value with error monitoring" mode 
(State = 8)
The actuator moves to the configured 
substitute output value.
Switch to "Error monitoring" mode 
(State = 7)

In manual mode, PID_3Step uses ManualValue as output value, unless the following errors 
occur:

● 2000h: Invalid value at Feedback_PER parameter.

● 4000h: Invalid value at Feedback parameter.

● 8000h: Error during digital position feedback.

You can only change the position of the actuator with Manual_UP and Manual_DN, not with 
ManualValue.

The Error parameter indicates whether an error has occurred in this cycle. The ErrorBits 
parameter shows which errors have occurred. ErrorBits is reset by a rising edge at Reset or 
ErrorAck.

See also
Parameters State and Mode V2 (Page 3068)

Parameter ErrorBits V2 (Page 3073)

Configuring PID_3Step V2 (Page 7769)
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Mode of operation of PID_3Step V2

Monitoring process value limits
You specify the high limit and low limit of the process value in the Config.InputUpperLimit and 
Config.InputLowerLimit variables. If the process value is outside these limits, an error occurs 
(ErrorBits = 0001h).

You specify a high and low warning limit of the process value in the Config.InputUpperWarning 
and Config.InputLowerWarning variables. If the process value is outside these warning limits, 
a warning occurs (Warning = 0040h), and the InputWarning_H or InputWarning_L output 
parameter changes to TRUE. 

Limiting the setpoint 
You specify a high limit and low limit of the setpoint in the Config.SetpointUpperLimit and 
Config.SetpointLowerLimit variables. PID_3Step automatically limits the setpoint to the 
process value limits. You can limit the setpoint to a smaller range. PID_3Step checks whether 
this range falls within the process value limits. If the setpoint is outside these limits, the high 
or low limit is used as the setpoint, and output parameter SetpointLimit_H or SetpointLimit_L 
is set to TRUE.

The setpoint is limited in all operating modes.

Limiting the output value
You specify a high limit and low limit of the output value in the Config.OutputUpperLimit and 
Config.OutputLowerLimit variables. The output value limits must be within "Low endstop" and 
"High endstop".

● High endstop: Config.FeedbackScaling.UpperPointOut

● Low endstop: Config.FeedbackScaling.LowerPointOut

Rule:

UpperPointOut ≥ OutputUpperLimit > OutputLowerLimit ≥ LowerPointOut

The valid values for "High endstop" and "Low endstop" depend upon:

● FeedbackOn

● FeedbackPerOn

● OutputPerOn

OutputPerOn FeedbackOn FeedbackPerOn LowerPointOut UpperPointOut
FALSE FALSE FALSE Cannot be set (0.0%) Cannot be set (100.0%)
FALSE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
FALSE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%
TRUE FALSE FALSE Cannot be set (0.0%) Cannot be set (100.0%)
TRUE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
TRUE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%
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If OutputPerOn = FALSE  and FeedbackOn = FALSE, you cannot limit the output value. 
Output_UP and Output_DN are then reset at Actuator_H = TRUE or Actuator_L = TRUE. If 
endstop signals are also not present, Output_UP and Output_DN are reset after a travel time 
of Config.VirtualActuatorLimit × Retain.TransitTime/100.

The output value is 27648 at 100% and -27648 at -100%. PID_3Step must be able to close 
the valve completely.

Substitute output value
If an error has occurred, PID_3Step can output a substitute output value and move the actuator 
to a safe position that is specified in the SavePosition tag. The substitute output value must 
be within the output value limits.

Monitoring signal validity
The values of the following parameters are monitored for validity when used:

● Setpoint

● Input

● Input_PER

● Input_PER

● Feedback

● Feedback_PER

● Disturbance

● ManualValue

● SavePosition

● Output_PER

Monitoring the PID_3Step sampling time
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_3Step 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. Too great a difference between the current sampling time and 
this mean value triggers an error (ErrorBits = 0800h).

The error occurs during tuning if: 

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

The error occurs in automatic mode if: 

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value
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If you deactivate the sampling time monitoring (CycleTime.EnMonitoring = FALSE), you can 
also call PID_3Step in OB1. You must then accept a lower control quality due to the deviating 
sampling time.

Sampling time of the PID algorithm 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_3Step are executed at every call.

Measuring the motor transition time
The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. The actuator is moved in one direction for a maximum time of 
Config.VirtualActuatorLimit × Retain.TransitTime/100. PID_3Step requires the motor transition 
time to be as accurate as possible for good controller results. The data in the actuator 
documentation contains average values for this type of actuator. The value for the specific 
actuator used may differ. You can measure the motor transition time during commissioning. 
The output value limits are not taken into consideration during the motor transition time 
measurement. The actuator can travel to the high or the low endstop.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_3Step does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 

See also
Configuring PID_3Step V1 (Page 7786)

Changing the PID_3Step V2 interface
The following table shows what has changed in the PID_3Step instruction interface.

 

PID_3Step V1 PID_3Step V2 Change
Input_PER Input_PER Data type from Word to Int
Feedback_PER Feedback_PER Data type from Word to Int
 Disturbance New
Manual_UP Manual_UP Function
Manual_DN Manual_DN Function
 ErrorAck New
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PID_3Step V1 PID_3Step V2 Change
 ModeActivate New
Output_PER Output_PER Data type from Word to Int
 ManualUPInternal New
 ManualDNInternal New
 CancelTuningLevel New
 VirtualActuatorLImit New
Config.Loadbackup Loadbackup Renamed
Config.TransitTime Retain.TransitTime Renamed and retentivity added 
GetTransitTime.Start  Replaced by Mode and ModeActivate
SUT.CalculateSUTPara
ms

SUT.CalculateParams Renamed

SUT.TuneRuleSUT SUT.TuneRule Renamed
TIR.CalculateTIRParams TIR.CalculateParams Renamed
TIR.TuneRuleTIR TIR.TuneRule Renamed
Retain.Mode Mode Function

Declaration of static for in-out parameters

Input parameters of PID_3Step V2

Table 9-86    

Parameter Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A tag of the user program is used as the source of the process 

value. 
If you are using the Input parameter, then 
Config.InputPerOn = FALSE must be set.

Input_PER INT 0 An analog input is used as the source of the process value.
If you are using the Input_PER parameter, then 
Config.InputPerOn = TRUE must be set.

Actuator_H BOOL FALSE Digital position feedback of the valve for the high endstop
If Actuator_H = TRUE, the valve is at the high endstop and is 
no longer moved towards this direction.

Actuator_L BOOL FALSE Digital position feedback of the valve for the low endstop 
If Actuator_L = TRUE, the valve is at the low endstop and is no 
longer moved towards this direction.

Feedback REAL 0.0 Position feedback of the valve
If you are using the Feedback parameter, then 
Config.FeedbackPerOn = FALSE must be set.
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Parameter Data type Default Description
Feedback_PER INT 0 Analog position feedback of a valve

If you are using the Feedback_PER parameter, then 
Config.FeedbackPerOn = TRUE must be set.
Feedback_PER is scaled based on the tags:
● Config.FeedbackScaling.LowerPointIn
● Config.FeedbackScaling.UpperPointIn
● Config.FeedbackScaling.LowerPointOut
● Config.FeedbackScaling.UpperPointOut

Disturbance REAL 0.0 Disturbance tag or precontrol value
ManualEnable BOOL FALSE ● A FALSE -> TRUE edge activates "manual mode", while 

State = 4, Mode remain unchanged.
As long as ManualEnable = TRUE, you cannot change the 
operating mode via a rising edge at ModeActivate or use 
the commissioning dialog.

● A TRUE -> FALSE edge activates the operating mode that 
is specified by Mode.

We recommend that you change the operating mode using 
ModeActivate only.

ManualValue REAL 0.0 In manual mode, the absolute position of the valve is specified. 
ManualValue is only evaluated if you are using Output_PER, 
or if position feedback is available.

Manual_UP BOOL FALSE ● Manual_UP = TRUE
The valve is opened even if you are using Output_PER or 
a position feedback. The valve is no longer moved if the 
high endstop has been reached. 
See also Config.VirtualActuatorLimit

● Manual_UP = FALSE
If you are using Output_PER or a position feedback, the 
valve is moved to ManualValue. Otherwise, the valve is no 
longer moved.

If Manual_UP and Manual_DN are set to TRUE simultaneously, 
the valve is not moved.

Manual_DN BOOL FALSE ● Manual_DN = TRUE
The valve is closed even if you are using Output_PER or a 
position feedback. The valve is no longer moved if the low 
endstop has been reached. 
See also Config.VirtualActuatorLimit

● Manual_DN = FALSE
If you are using Output_PER or a position feedback, the 
valve is moved to ManualValue. Otherwise, the valve is no 
longer moved.

ErrorAck BOOL FALSE ● FALSE -> TRUE edge
ErrorBits and Warning are reset.
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Parameter Data type Default Description
Reset BOOL FALSE Restarts the controller.

● FALSE -> TRUE edge
– Switch to "Inactive" mode
– ErrorBits and Warning are reset.
– Integral action is cleared

(PID parameters are retained)
● As long as Reset = TRUE, PID_3Step remains in "Inactive" 

mode (State = 0).
● TRUE -> FALSE edge

PID_3Step switches to the operating mode that is saved in 
the Mode parameter.

ModeActivate BOOL FALSE ● FALSE -> TRUE edge
PID_3Step switches to the operating mode that is saved in 
the Mode parameter.

Output parameters of PID_3Step V2

Table 9-87    

Parameter Data type Default Description
ScaledInput REAL 0.0 Scaled process value 
ScaledFeedback REAL 0.0 Scaled position feedback

For an actuator without position feedback, the position of the 
actuator indicated by ScaledFeedback is very imprecise. 
ScaledFeedback may only be used for rough estimation of the 
current position in this case.

Output_UP BOOL FALSE Digital output value for opening the valve
If Config.OutputPerOn = FALSE, the Output_UP parameter is 
used.

Output_DN BOOL FALSE Digital output value for closing the valve
If Config.OutputPerOn = FALSE, the Output_DN parameter is 
used.

Output_PER INT 0 Analog output value
If Config.OutputPerOn = TRUE, Output_PER is used.

SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the absolute setpoint high limit is 
reached (Setpoint ≥ Config.SetpointUpperLimit).
The setpoint is limited to Config.SetpointUpperLimit .

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the absolute setpoint low limit has 
been reached (Setpoint ≤ Config.SetpointLowerLimit).
The setpoint is limited to Config.SetpointLowerLimit .

InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached or 
exceeded the warning high limit.

InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached or 
fallen below the warning low limit.
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Parameter Data type Default Description
State INT 0 The State parameter (Page 3068) shows the current operating 

mode of the PID controller. You can change the operating 
mode using the input parameter Mode and a rising edge at 
ModeActivate.
● State = 0: Inactive
● State = 1: Pretuning
● State = 2: Fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode
● State = 5: Approach substitute output value
● State = 6: Transition time measurement
● State = 7: Error monitoring
● State = 8: Approach substitute output value with error 

monitoring
● State = 10: Manual mode without end stop signals

Error BOOL FALSE If Error = TRUE, at least one error message is pending in this 
cycle.

ErrorBits DWORD DW#16#0 The ErrorBits parameter (Page 3073) shows which error 
messages are pending. ErrorBits is retentive and is reset upon 
a rising edge at Reset or ErrorAck.

See also
Parameters State and Mode V2 (Page 3068)

Parameter ErrorBits V2 (Page 3073)
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In-out parameters of PID_3Step V2

Table 9-88    

Parameter Data type Default Description
Mode INT 4 At the Mode parameter, you specify the operating mode to 

which PID_3Step is to switch. Options are:
● Mode = 0: Inactive
● Mode = 1: Pretuning
● Mode = 2: Fine tuning
● Mode = 3: Automatic mode
● Mode = 4: Manual mode
● Mode = 6: Transition time measurement
● Mode = 10: Manual mode without endstop signals
The operating mode is activated by:
● Rising edge at ModeActivate
● Falling edge at Reset
● Falling edge at ManualEnable
● Cold restart of CPU if RunModeByStartup = TRUE
Mode is retentive.
A detailed description of the operating modes can be found in 
Parameters State and Mode V2 (Page 3068).

Static tags of PID_3Step V2
You must not change tags that are not listed. These are used for internal purposes only.

Tag Data type Default Description
ManualUpInternal BOOL FALSE In manual mode, each rising edge opens the valve by 5% of the total 

control range or for the duration of the minimum motor transition 
time. ManualUpInternal is only evaluated if you are not using 
Output_PER or a position feedback. This tag is used in the 
commissioning dialog.

ManualDnInternal BOOL FALSE In manual mode, every rising edge closes the valve by 5% of the 
total control range or for the duration of the minimum motor transition 
time. ManualDnInternal is only evaluated if you are not using 
Output_PER or position feedback. This tag is used in the 
commissioning dialog.

ActivateRecoverMode BOOL TRUE The ActivateRecoverMode V2 (Page 3076) tag determines the 
reaction to error.

RunModeByStartup BOOL TRUE Activate operating mode at Mode parameter after CPU restart
If RunModeByStartup = TRUE, PID_3Step starts in the operating 
mode saved in the Mode parameter after CPU startup.
If RunModeByStartup = FALSE, PID_3Step remains in "Inactive" 
mode after CPU startup. 

LoadBackUp BOOL FALSE If LoadBackUp = TRUE, the last set of PID parameters is reloaded. 
The set was saved prior to the last tuning. LoadBackUp is 
automatically set back to FALSE.
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Tag Data type Default Description
PhysicalUnit INT 0 Unit of measurement of the process value and setpoint, e.g., ºC, or 

ºF.
PhysicalQuantity INT 0 Physical quantity of the process value and setpoint, e.g., 

temperature
ErrorBehaviour BOOL FALSE If ErrorBehaviour = FALSE and an error has occurred, the valve 

stays at its current position and the controller switches directly to 
"Inactive" or "Error monitoring" mode.
If ErrorBehaviour = TRUE and an error occurs, the actuator moves 
to the substitute output value and only then switches to "Inactive" or 
"Error monitoring" mode.
If the following errors occur, you can no longer move the valve to a 
configured substitute output value.
● 2000h: Invalid value at Feedback_PER parameter.
● 4000h: Invalid value at Feedback parameter.
● 8000h: Error during digital position feedback.
● 20000h: Invalid value at SavePosition tag.

Warning DWORD DW#16#
0

The Warning tag (Page 3068) shows the warnings since Reset = 
TRUE or ErrorAck =TRUE. Warning is retentive.
Cyclic warnings (for example, process value warning) are shown 
until the cause of the warning is removed. They are automatically 
deleted once their cause has gone. Non-cyclic warnings (for 
example, point of inflection not found) remain and are deleted like 
errors.

SavePosition REAL 0.0 Substitute output value
If ErrorBehaviour = TRUE, the actuator is moved to a position that 
is safe for the plant when an error occurs. As soon as the substitute 
output value has been reached, PID_3Step switches the operating 
mode according to ActivateRecoverMode.

CurrentSetpoint REAL 0.0 Currently active setpoint. This value is frozen at the start of tuning.
CancelTuningLevel REAL 10.0 Permissible fluctuation of setpoint during tuning. Tuning is not 

canceled until:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel

Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
Config.InputPerOn BOOL TRUE If InputPerOn = TRUE, the Input_PER parameter is used. If 

InputPerOn = FALSE, the Input parameter is used.
Config.OutputPerOn BOOL FALSE If OutputPerOn = TRUE, the Output_PER parameter is used. If 

OutputPerOn = FALSE, the Ouput_UP and Output_DN parameters 
are used.

Config.InvertControl BOOL FALSE Invert control logic
If InvertControl = TRUE, an increasing control deviation causes a 
reduction in the output value.

Config.FeedbackOn BOOL FALSE If FeedbackOn = FALSE, a position feedback is simulated.
Position feedback is generally activated when 
FeedbackOn = TRUE. 
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Tag Data type Default Description
Config.FeedbackPerOn BOOL FALSE FeedbackPerOn is only effective when FeedbackOn = TRUE.

If FeedbackPerOn = TRUE, the analog input is used for the position 
feedback (Feedback_PER parameter).
If FeedbackPerOn = FALSE, the Feedback parameter is used for 
the position feedback.

Config.ActuatorEndStopOn BOOL FALSE If ActuatorEndStopOn = TRUE, the digital position feedback 
Actuator_L  and Actuator_H  are taken into consideration.

Config.InputUpperLimit REAL 120.0 High limit of the process value
Input and Input_PER are monitored to ensure adherence to this limit.
At the I/O input, the process value can be a maximum of 18% higher 
than the standard range (overrange). An error is no longer signaled 
due to a violation of the "Process value high limit". Only a wire-break 
and a short-circuit are recognized and PID_3Step reacts according 
to the configured reaction to error.
InputUpperLimit > InputLowerLimit

Config.InputLowerLimit REAL 0.0 Low limit of the process value
InputLowerLimit < InputUpperLimit

Config.InputUpperWarning REAL +3.40282
2e+38

Warning high limit of the process value
If you set InputUpperWarning outside the process value limits, the 
configured absolute process value high limit is used as the warning 
high limit. 
If you configure InputUpperWarning within the process value limits, 
this value is used as the warning high limit.
InputUpperWarning > InputLowerWarning
InputUpperWarning ≤ InputUpperLimit

Config.InputLowerWarning REAL -3.40282
2e+38

Warning low limit of the process value
If you set InputLowerWarning outside the process value limits, the 
configured absolute process value low limit is used as the warning 
low limit. 
If you configure InputLowerWarning within the process value limits, 
this value is used as the warning low limit.
InputLowerWarning < InputUpperWarning
InputLowerWarning ≥ InputLowerLimit

Config.OutputUpperLimit REAL 100.0 High limit of output value
For details, see OutputLowerLimit

Config.OutputLowerLimit REAL 0.0 Low limit of output value
If OutputPerOn = TRUE or FeedbackOn = TRUE, the range of 
values from -100% to +100%, including zero, is valid. At -100%, 
Output = -27648; at +100% Output = 27648
If OutputPerOn = FALSE, the range of values from 0% to 100% is 
valid. The valve is completely closed at 0% and completely opened 
at 100%.

Config.SetpointUpperLimit REAL +3.40282
2e+38

High limit of setpoint
If you set SetpointUpperLimit outside the process value limits, the 
configured absolute process value high limit is preassigned as the 
setpoint high limit. 
If you configure SetpointUpperLimit within the process value limits, 
this value is used as the setpoint high limit.

Programming the PLC
9.7 References

WinCC Professional V13.0
3062 System Manual, 02/2014



Tag Data type Default Description
Config.SetpointLowerLimit REAL - 

3.402822
e+38

Low limit of the setpoint
If you set SetpointLowerLimit outside the process value limits, the 
configured absolute process value low limit is preassigned as the 
setpoint low limit.
If you set SetpointLowerLimit within the process value limits, this 
value is used as the setpoint low limit. 

Config.MinimumOnTime REAL 0.0 Minimum ON time
Minimum time in seconds for which the servo drive must be switched 
on.

Config.MinimumOffTime REAL 0.0 Minimum OFF time
Minimum time in seconds for which the servo drive must be switched 
off.

Config.VirtualActuatorLimit REAL 150.0 If all the following conditions have been satisfied, the actuator is 
moved in one direction for the maximum period of 
VirtualActuatorLimit × Retain.TransitTime/100 and the warning 
2000h is output:
● Config.OutputPerOn = FALSE
● Config.ActuatorEndStopOn = FALSE
● Config.FeedbackOn = FALSE 
If Config.OutputPerOn = FALSE and Config.ActuatorEndStopOn = 
TRUE or Config.FeedbackOn = TRUE, only the warning 2000h is 
output. 
If Config.OutputPerOn = TRUE, VirtualActuatorLimit is not taken 
into consideration.

Config.InputScaling.UpperPoi
ntIn

REAL 27648.0 Scaling Input_PER high
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntIn

REAL 0.0 Scaling Input_PER low
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.UpperPoi
ntOut

REAL 100.0 Scaled high process value 
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntOut

REAL 0.0 Scaled low process value
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.FeedbackScaling.Uppe
rPointIn

REAL 27648.0 Scaling Feedback_PER high
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointIn

REAL 0.0 Scaling Feedback_PER low
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.
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Tag Data type Default Description
Config.FeedbackScaling.Uppe
rPointOut

REAL 100.0 High endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointOut

REAL 0.0 Low endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

GetTransitTime.InvertDirectio
n

BOOL FALSE If InvertDirection = FALSE, the valve is fully opened, closed, and 
then reopened in order to determine the valve transition time.
If InvertDirection = TRUE, the valve is fully closed, opened, and then 
closed again.

GetTransitTime.SelectFeedba
ck

BOOL FALSE If SelectFeedback = TRUE, then Feedback_PER, or Feedback is 
taken into consideration in the transition time measurement.
If SelectFeedback = FALSE, then Actuator_H and Actuator_L are 
taken into consideration in the transition time measurement.

GetTransitTime.State INT 0 Current phase of the transition time measurement
● State = 0: Inactive
● State = 1: Open valve completely
● State = 2: Close valve completely
● State = 3: Move valve to target position (NewOutput)
● State = 4: Transition time measurement successfully completed
● State = 5: Transition time measurement canceled

GetTransitTime.NewOutput REAL 0.0 Target position for transition time measurement with position 
feedback
The target position must be between "High endstop" and "Low 
endstop". The difference between NewOutput and ScaledFeedback 
must be at least 50% of the permissible control range.

CycleTime.StartEstimation BOOL TRUE If StartEstimation = TRUE, the measurement of the PID_3Step 
sampling time is started. CycleTime.StartEstimation = FALSE once 
measurement is complete.

CycleTime.EnEstimation BOOL TRUE If EnEstimation = TRUE, the PID_3Step sampling time is calculated.
If CycleTime.EnEstimation = FALSE, the PID_3Step sampling time 
is not calculated and you need to correct the configuration of 
CycleTime.Value manually.

CycleTime.EnMonitoring BOOL TRUE If EnMonitoring = TRUE, the PID_3Step sampling time is monitored. 
If it is not possible to execute PID_3Step within the sampling time, 
the error 0800h is output and the operating mode is switched.  
ActivateRecoverMode and ErrorBehaviour determine which 
operating mode is switched to. 
If EnMonitoring = FALSE, the PID_3Step sampling time is not 
monitored, the error 0800h is not output, and the operating mode is 
not switched.

CycleTime.Value REAL 0.1 PID_3Step sampling time in seconds
CycleTime.Value is determined automatically and is usually 
equivalent to the cycle time of the calling OB.
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Tag Data type Default Description
CtrlParamsBackUp.SetByUser BOOL FALSE Saved value of Retain.CtrlParams.SetByUser

You can reload values from the CtrlParamsBackUp structure with 
LoadBackUp = TRUE.

CtrlParamsBackUp.Gain REAL 1.0 Saved proportional gain
CtrlParamsBackUp.Ti REAL 20.0 Saved integral action time in seconds
CtrlParamsBackUp.Td REAL 0.0 Saved derivative action time in seconds
CtrlParamsBackUp.TdFiltRati
o

REAL 0.2 Saved derivative delay coefficient

CtrlParamsBackUp.PWeightin
g

REAL 1.0 Saved proportional action weighting

CtrlParamsBackUp.DWeightin
g

REAL 1.0 Saved derivative action weighting

CtrlParamsBackUp.Cycle REAL 1.0 Saved sampling time of PID algorithm in seconds
CtrlParamsBackUp.InputDead
Band

REAL 0.0 Saved deadband width of the control deviation

PIDSelfTune.SUT.CalculateP
arams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateParams = TRUE, the PID parameters are recalculated on 
the basis of these properties. The PID parameters are calculated 
using the method set in TuneRule. CalculateParams is set to FALSE 
following calculation.

PIDSelfTune.SUT.TuneRule INT 1 Methods used to calculate parameters during pretuning:
● SUT.TuneRule = 0: PID rapid I
● SUT.TuneRule = 1: PID slow I
● SUT.TuneRule = 2: Chien, Hrones and Reswick PID
● SUT.TuneRule = 3: Chien, Hrones, Reswick PI
● SUT.TuneRule = 4: PID rapid II
● SUT.TuneRule = 5: PID slow II

PIDSelfTune.SUT.State INT 0 The SUT.State tag indicates the current phase of pretuning:
● State = 0: Initialize pretuning
● State = 50: Determine start position without position feedback
● State = 100: Calculate standard deviation
● State = 200: Determine point of inflection
● State = 300: Determine rise time
● State = 9900: Pretuning successful
● State = 1: Pretuning not successful
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Tag Data type Default Description
PIDSelfTune.TIR.RunIn BOOL FALSE With the RunIn tag, you can specify that fine tuning can also be 

performed without pretuning.
● RunIn = FALSE

Pretuning is started when fine tuning is started from inactive or 
manual mode. 
If fine tuning is started from automatic mode, the system uses 
the existing PID parameters to control to the setpoint. 
Only then will fine tuning start. If pretuning is not possible, 
PID_3Step switches to the mode from which tuning was started.

● RunIn = TRUE
The pretuning is skipped. PID_3Step attempts to reach the 
setpoint with the minimum or maximum output value. This can 
produce increased overshoot. Only then will fine tuning start.
RunIn is set to FALSE after fine tuning.

PIDSelfTune.TIR.CalculatePar
ams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateParams = TRUE, the PID parameters are recalculated on 
the basis of these properties. The PID parameters are calculated 
using the method set in TuneRule. CalculateParams is set to FALSE 
following calculation.

PIDSelfTune.TIR.TuneRule INT 0 Methods used to calculate parameters during fine tuning:
● TIR.TuneRule = 0: PID automatic
● TIR.TuneRule = 1: PID rapid
● TIR.TuneRule = 2: PID slow
● TIR.TuneRule = 3: Ziegler-Nichols PID
● TIR.TuneRule = 4: Ziegler-Nichols PI
● TIR.TuneRule = 5: Ziegler-Nichols P

PIDSelfTune.TIR.State INT 0 The TIR.State tag indicates the current phase of fine tuning:
● State = -100 Fine tuning is not possible. Pretuning will be 

performed first.
● State = 0: Initialize fine tuning
● State = 200: Calculate standard deviation
● State = 300: Attempt to reach the setpoint with the maximum or 

minimum output value
● State = 400: Attempt to reach the setpoint with existing PID 

parameters
(if pretuning was successful)

● State = 500: Determine oscillation and calculate parameters
● State = 9900: Fine tuning successful
● State = 1: Fine tuning not successful

Retain.TransitTime REAL 30.0 Motor transition time in seconds
Time in seconds the actuating drive requires to move the valve from 
the closed to the opened state. 
TransitTime is retentive.
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Tag Data type Default Description
Retain.CtrlParams.SetByUser BOOL FALSE If SetByUser = FALSE, the PID parameters are determined 

automatically and PID_3Step operates with a deadband at the 
output value. The deadband width is calculated during tuning on the 
basis of the standard deviation of the output value and saved in 
Retain.CtrlParams.OutputDeadBand.
If SetByUser = TRUE, the PID parameters are entered manually 
and PID_3 Step operates without a deadband at the output value. 
Retain.CtrlParams.OutputDeadBand = 0.0
SetByUser is retentive.

Retain.CtrlParams.Gain REAL 1.0 Active proportional gain
To invert the control logic, use the Config.InvertControl tag. 
Negative values at Gain also invert the control logic. We recommend 
you use only InvertControl to set the control logic. The control logic 
is also inverted if InvertControl = TRUE and Gain < 0.0.
Gain is retentive.

Retain.CtrlParams.Ti REAL 20.0 ● Ti > 0.0: Active integral action time in seconds
● Ti = 0.0: Integral action is deactivated
Ti is retentive.

Retain.CtrlParams.Td REAL 0.0 ● Td > 0.0: Active derivative action time in seconds
● Td = 0.0: Derivative action is deactivated
Td is retentive.

Retain.CtrlParams.TdFiltRatio REAL 0.2 Active derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative 
action. 
Derivative delay = derivative action time × derivative delay 
coefficient
● 0.0: Derivative action is effective for one cycle only and therefore 

almost not effective.
● 0.5: This value has proved useful in practice for controlled 

systems with one dominant time constant.
● > 1.0: The greater the coefficient, the longer the effect of the 

derivative action is delayed.
TdFiltRatio is retentive.

Retain.CtrlParams.PWeighting REAL 1.0 Active proportional action weighting
The proportional action may weaken with changes to the setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Proportional action for setpoint change is fully effective
● 0.0: Proportional action for setpoint change is not effective
The proportional action is always fully effective when the process 
value is changed.
PWeighting is retentive.
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Tag Data type Default Description
Retain.CtrlParams.DWeightin
g

REAL 1.0 Active derivative action weighting
The derivative action may weaken with changes to the setpoint.
Values from 0.0 to 1.0 are applicable.
● 1.0: Derivative action is fully effective upon setpoint change
● 0.0: Derivative action is not effective upon setpoint change
The derivative action is always fully effective when the process value 
is changed. 
DWeighting is retentive.

Retain.CtrlParams.Cycle REAL 1.0 Active sampling time of PID algorithm in seconds, rounded to an 
integer multiple of the cycle time of the calling OB.
Cycle is retentive.

Retain.CtrlParams.InputDead
Band

REAL 0.0 Deadband width of the control deviation
InputDeadBand is retentive.

 
 

 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller.

 

See also
Parameters State and Mode V2 (Page 3068)

Tag ActivateRecoverMode V2 (Page 3076)

Downloading technology objects to device (Page 7715)

Parameters State and Mode V2

Correlation of the parameters
The State parameter shows the current operating mode of the PID controller. You cannot 
change the State parameter. 

With a rising edge at ModeActivate, PID_3Step switches to the operating mode saved in the 
Mode in-out parameter.

When the CPU is switched on or switches from Stop to RUN mode, PID_3Step starts in the 
operating mode that is saved in the Mode parameter. To leave PID_3Step in "Inactive" mode, 
set RunModeByStartup = FALSE.
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Meaning of values

State Description of operating mode
0 Inactive

The controller is switched off and no longer changes the valve position.
1 Pretuning

The pretuning determines the process response to a pulse of the output value and searches for the point of 
inflection. The PID parameters are calculated from the maximum rate of rise and dead time of the controlled 
system. You obtain the best PID parameters when you perform pretuning and fine tuning.
Pretuning requirements:
● The motor transition time has been configured or measured.
● Inactive (State = 0), manual mode (State = 4), or automatic mode (State = 3)
● ManualEnable = FALSE
● Reset = FALSE
● The setpoint and the process value lie within the configured limits.
The more stable the process value is, the easier it is to calculate the PID parameters and the more precise 
the result will be. Noise on the process value can be tolerated as long as the rate of rise of the process value 
is significantly higher as compared to the noise. This is most likely the case in operating modes "Inactive" 
and "manual mode".
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
Before the PID parameters are recalculated, they are backed up and can be reactivated with LoadBackUp. 
The controller switches to automatic mode following successful pretuning. If pretuning is unsuccessful, the 
switchover of operating mode is dependent on ActivateRecoverMode and ErrorBehaviour.
The pretuning phase is indicated with the SUT.State tag.
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State Description of operating mode
2 Fine tuning

Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are recalculated 
based on the amplitude and frequency of this oscillation. PID parameters from fine tuning usually have better 
master control and disturbance characteristics than PID parameters from pretuning. You obtain the best PID 
parameters when you perform pretuning and fine tuning.
PID_3Step automatically attempts to generate an oscillation greater than the noise of the process value. Fine 
tuning is only minimally influenced by the stability of the process value. 
The setpoint is frozen in the CurrentSetpoint tag. Tuning is canceled when:
● Setpoint > CurrentSetpoint + CancelTuningLevel

or
● Setpoint < CurrentSetpoint - CancelTuningLevel
The PID parameters are backed up before fine tuning. They can be reactivated with LoadBackUp. 
Requirements for fine tuning:
● The motor transition time has been configured or measured.
● The setpoint and the process value lie within the configured limits.
● ManualEnable = FALSE
● Reset = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started from:
● Automatic mode (State = 3)

Start fine tuning from automatic mode if you wish to improve the existing PID parameters through tuning.
PID_3Step controls the system using the existing PID parameters until the control loop has stabilized and 
the requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual mode (State = 4)
If the requirements for pretuning are met, pretuning is started. The determined PID parameters will be 
used for control until the control loop has stabilized and the requirements for fine tuning have been met.
If PIDSelfTune.TIR.RunIn = TRUE, pretuning is skipped and an attempt is made to reach the setpoint with 
the minimum or maximum output value. This can produce increased overshoot. Fine tuning then starts 
automatically.

The controller switches to automatic mode following successful fine tuning. If fine tuning is unsuccessful, the 
switchover of operating mode is dependent on ActivateRecoverMode and ErrorBehaviour.
The fine tuning phase is indicated with the TIR.State tag.

3 Automatic mode
In automatic mode, PID_3Step controls the controlled system in accordance with the parameters specified.
The controller switches to automatic mode if one the following requirements is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Changing of the Mode in-out parameter to the value 3 and a rising edge at ModeActivate.
The switchover from automatic mode to manual mode is only bumpless if carried out in the commissioning 
editor.
The ActivateRecoverMode tag is taken into consideration in automatic mode.
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State Description of operating mode
4 Manual mode

In manual mode, you specify manual output values in the Manual_UP and Manual_DN parameters or 
ManualValue parameter. Whether or not the actuator can be moved to the output value in the event of an 
error is described in the ErrorBits parameter.
You can also activate this operating mode using ManualEnable = TRUE. We recommend that you change 
the operating mode using Mode and ModeActivate only.
The switchover from manual mode to automatic mode is bumpless. Manual mode is also possible when an 
error is pending.

5 Approach substitute output value
This operating mode is activated in the event of an error, if Errorbehaviour = TRUE and ActivateRecoverMode 
= FALSE..
PID_3Step moves the actuator to the substitute output value and then switches to "Inactive" mode.

6 Transition time measurement
The time that the motor needs to completely open the valve from the closed condition is determined.
This operating mode is activated when Mode = 6 and ModeActivate = TRUE is set.
If endstop signals are used to measure the transition time, the valve will be opened completely from its current 
position, closed completely, and opened completely again. If GetTransitTime.InvertDirection = TRUE, this 
behavior is inverted.
If position feedback is used to measure the transition time, the actuator will be moved from its current position 
to a target position.
The output value limits are not taken into consideration during the transition time measurement. The actuator 
can travel to the high or the low endstop.

7 Error monitoring
The control algorithm is switched off and no longer changes the valve position.
This operating mode is activated instead of "Inactive" mode in the event of an error. 
All the following conditions must be met:
● Automatic mode (Mode = 3)
● Errorbehaviour = FALSE
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 3076) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode. 

8 Approach substitute output value with error monitoring
This operating mode is activated instead of "approach substitute output value" mode when an error occurs. 
PID_3Step moves the actuator to the substitute output value and then switches to "error monitoring" mode.
All the following conditions must be met:
● Automatic mode (Mode = 3)
● Errorbehaviour = TRUE
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 3076) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.

10 Manual mode without endstop signals
The endstop signals are not taken into consideration, even though Config.ActuatorEndStopOn = TRUE. The 
output value limits are not taken into consideration. Otherwise, PID_3Step behaves the same as in manual 
mode.
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ENO characteristics
If State = 0, then ENO = FALSE.

If State ≠ 0, then ENO = TRUE. 

Automatic switchover of operating mode during commissioning
Automatic mode is activated following successful pretuning or fine tuning. The following table 
shows how Mode and State change during successful pretuning.

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning successfully completed
n 3 3 Automatic mode is started

PID_3Step automatically switches the operating mode in the event of an error. The following 
table shows how Mode and State change during pretuning with errors. 

Cycle no. Mode State Action
0 4 4 Set Mode = 1
1 1 4 Set ModeActivate = TRUE
1 4 1 Value of State is saved in Mode parameter

Pretuning is started
n 4 1 Pretuning canceled
n 4 4 Manual mode is started

If ActivateRecoverMode = TRUE, the operating mode that is saved in the Mode parameter is 
activated. At the start of transition time measurement, pretuning, or fine tuning, PID_3Step 
saved the value of State in the Mode in/out parameter. PID_3Step therefore switches to the 
operating mode from which transition time measurement or tuning was started.

If ActivateRecoverMode = FALSE, "Inactive" or "Approach substitute output value" mode is 
activated.

Automatic switchover of operating mode after transition time measurement
If ActivateRecoverMode = TRUE, the operating mode that is saved in the Mode parameter is 
activated after successful transition time measurement. 

If ActivateRecoverMode = FALSE, the system switches to "Inactive" operating mode after 
successful transition time measurement.
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Automatic switchover of operating mode in automatic mode
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour and ActivateRecoverMode on this 
switchover of operating mode.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.

Automatic switchover of operating mode when error is no longer pending.

 

See also
Tag ActivateRecoverMode V2 (Page 3076)

Parameter ErrorBits V2 (Page 3073)

Parameter ErrorBits V2
If several errors are pending simultaneously, the values of the ErrorBits are displayed with 
binary addition. The display of ErrorBits = 0003h, for example, indicates that the errors 0001h 
and 0002h are pending simultaneously.

If there is a position feedback, PID_3Step uses ManualValue as output value in manual mode. 
The exception is Errorbits = 10000h.
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ErrorBits
 (DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > Config.InputUpperLimit or
● Input < Config.InputLowerLimit
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
remains in automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

0004 Error during fine tuning. Oscillation of the process value could not be maintained.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0010 The setpoint was changed during tuning.
You can set the permitted fluctuation of the setpoint at the CancelTuningLevel tag. 
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0020 Pretuning is not permitted during fine tuning.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step remains in fine tuning mode.

0080 Error during pretuning. Incorrect configuration of output value limits.
Check whether the limits of the output value are configured correctly and match the control logic.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0100 Error during fine tuning resulted in invalid parameters.
If ActivateRecoverMode = TRUE before the error occurred, PID_3Step cancels the tuning and switches 
to the operating mode that is saved in the Mode parameter.

0200 Invalid value at "Input" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

0400 Calculation of output value failed. Check the PID parameters.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.
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ErrorBits
 (DW#16#...)

Description

0800 Sampling time error: PID_3Step is not called within the sampling time of the cyclic interrupt OB.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
remains in automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred and ActivateRecoverMode = TRUE, PID_3Step 
switches to "Approach substitute output value with error monitoring" or "Error monitoring" mode. As soon 
as the error is no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

2000 Invalid value at Feedback_PER parameter. 
Check whether an error is pending at the analog input. 
The actuator cannot be moved to the substitute output value and remains in its current position. In manual 
mode, you can change the position of the actuator only with Manual_UP and Manual_DN, and not with 
ManualValue.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode. 
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

4000 Invalid value at Feedback parameter. Value has an invalid number format. 
The actuator cannot be moved to the substitute output value and remains in its current position. In manual 
mode, you can change the position of the actuator only with Manual_UP and Manual_DN, and not with 
ManualValue.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

8000 Error during digital position feedback. Actuator_H = TRUE and Actuator_L = TRUE. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state.
In order to move the actuator from this state, you must deactivate the "Actuator endstop" 
(Config.ActuatorEndStopOn = FALSE) or switch to manual mode without endstop signals (Mode = 10).
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.
If pretuning, fine tuning, or transition time measurement mode and ActivateRecoverMode = TRUE were 
active before the error occurred, PID_3Step switches to the operating mode that is saved in the Mode 
parameter.

10000 Invalid value at ManualValue parameter. Value has an invalid number format.
The actuator cannot be moved to the manual value and remains in its current position. 
Specify a valid value in ManualValue or move the actuator in manual mode with Manual_UP and 
Manual_DN.
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ErrorBits
 (DW#16#...)

Description

20000 Invalid value at SavePosition tag. Value has an invalid number format.
The actuator cannot be moved to the substitute output value and remains in its current position.

40000 Invalid value at Disturbance parameter. Value has an invalid number format.
If automatic mode was active and ActivateRecoverMode = TRUE before the error occurred, Disturbance 
is set to zero. PID_3Step remains in automatic mode.
If pretuning or fine tuning mode was active and ActivateRecoverMode = TRUE before the error occurred, 
PID_3Step switches to the operating mode saved in the Mode parameter. If Disturbance in the current 
phase has no effect on the output value, tuning is not be canceled.
The error has no effect during transition time measurement. 

Tag ActivateRecoverMode V2
The ActivateRecoverMode tag determines the reaction to error. The Error parameter indicates 
if an error is pending. When the error is no longer pending, Error = FALSE. The ErrorBits 
parameter shows which errors have occurred. 

 

 NOTICE

Your system may be damaged.

If ActivateRecoverMode = TRUE, PID_3Step remains in automatic mode even if the process 
limit values are exceeded. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 

 

Programming the PLC
9.7 References

WinCC Professional V13.0
3076 System Manual, 02/2014



Automatic mode

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" mode. 
The controller is only activated by a falling edge at Reset or a rising edge at ModeActivate.

TRUE If errors occur frequently in automatic mode, this setting has a negative effect on the control response, 
because PID_3Step switches between the calculated output value and the substitute output value at each 
error. In this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more of the following errors occur, PID_3Step stays in automatic mode:
● 0001h: The "Input" parameter is outside the process value limits.
● 0800h: Sampling time error
● 40000h: Invalid value at Disturbance parameter.
If one or more of the following errors occur, PID_3Step switches to "Approach substitute output value with 
error monitoring" or "Error monitoring" mode:
● 0002h: Invalid value at Input_PER parameter.
● 0200h: Invalid value at Input parameter.
● 0400h: Calculation of output value failed.
● 1000h: Invalid value at Setpoint parameter.
If one or more of the following errors occur, PID_3Step can no longer move the actuator:
● 2000h: Invalid value at Feedback_PER parameter.
● 4000h: Invalid value at Feedback parameter.
● 8000h: Error during digital position feedback.
● 20000h: Invalid value at SavePosition tag. Value has an invalid number format.
The characteristics are independent of ErrorBehaviour. 
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.

Pretuning, fine tuning, and transition time measurement

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" mode. 
The controller is only activated by a falling edge at Reset or a rising edge at ModeActivate. 
The controller changes to "Inactive" mode after successful transition time measurement.

TRUE If the following error occurs, PID_3Step remains in the active mode:
● 0020h: Pretuning is not permitted during fine tuning.
The following errors are ignored:
● 10000h: Invalid value at ManualValue parameter.
● 20000h: Invalid value at SavePosition tag.
When any other error occurs, PID_3Step cancels the tuning and switches to the mode from which tuning 
was started.

Manual mode
ActivateRecoverMode is not effective in manual mode.
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See also
Static tags of PID_3Step V2 (Page 3060)

Parameters State and Mode V2 (Page 3068)

Tag Warning V2
If several warnings are pending simultaneously, their values are displayed with binary addition. 
The display of warning 0005h, for example, indicates that the warnings 0001h and 0004h are 
pending simultaneously.

Warning
 (DW#16#...)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0004 The setpoint was limited to the configured limits. 
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. 

Instead, the PID parameters were calculated using the TIR.TuneRule = 3 method.
0010 The operating mode could not be changed because Reset = TRUE or ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
0080 Invalid value at Mode. The operating mode is not switched.
0100 The manual value was limited to the limits of the controller output.
0200 The specified rule for tuning is not supported. No PID parameters are calculated.
0400 The transition time cannot be measured because the actuator settings do not match the selected 

measuring method. 
0800 The difference between the current position and the new output value is too small for transition time 

measurement. This can produce incorrect results. The difference between the current output value and 
new output value must be at least 50% of the entire control range.

1000 The substitute output value cannot be reached because it is outside the output value limits.
2000 The actuator was moved in one direction for longer than Config.VirtualActuatorLimit × Retain.TransitTime. 

Check whether the actuator has reached an endstop signal.

The following warnings are deleted as soon as the cause is eliminated:

● 0001h

● 0004h

● 0008h

● 0040h

● 0100h

● 2000h

All other warnings are cleared with a rising edge at Reset or ErrorAck.
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PID_3Step V1

Description PID_3Step V1

Description   
You use the PID_3Step instruction to configure a PID controller with self tuning for valves or 
actuators with integrating behavior. 

The following operating modes are possible:

● Inactive

● Pretuning

● Fine tuning

● Automatic mode

● Manual mode

● Approach substitute output value

● Transition time measurement

● Approach substitute output value with error monitoring

● Error monitoring

For a more detailed description of the operating modes, see the State parameter.
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PID algorithm
PID_3Step is a PIDT1 controller with anti-windup and weighting of the proportional and 
derivative actions. The following equation is used to calculate the output value.

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (T1 = a × TD)
TD Derivative action time
c Derivative action weighting
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Block diagram without position feedback
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Block diagram with position feedback
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Block diagram of PIDT1 with anti-windup

Call
PID_3Step is called in a constant time interval of the cycle time of the calling OB (preferably 
in a cyclic interrupt OB).

Download to device
The actual values of retentive tags are only updated when you download PID_3Step 
completely.

Downloading technology objects to device (Page 7715)

Startup
At the startup of the CPU, PID_3Step starts in the operating mode that was last active. To 
leave PID_3Step in "Inactive" mode, set RunModeByStartup = FALSE.

Reaction to error
If errors occur, these are output in the Error parameter. You configure the reaction of PID_3Step 
using the ErrorBehaviour and ActivateRecoverMode tags. 

ErrorBeha
viour

ActivateRecov
erMode

Actuator setting configuration
Set Output to

Reaction

0 FALSE Current output value Switch to "Inactive" mode (Mode = 0)
0 TRUE Current output value while 

error is pending
Switch to "Error monitoring" mode 
(Mode = 7)
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ErrorBeha
viour

ActivateRecov
erMode

Actuator setting configuration
Set Output to

Reaction

1 FALSE Substitute output value Switch to "Approach substitute output 
value" mode (Mode = 5)
Switch to "Inactive" mode (Mode = 0)

1 TRUE Substitute output value while 
error is pending

Switch to "Approach substitute output 
value with error monitoring" mode 
(Mode = 8)
Switch to "Error monitoring" mode 
(Mode = 7)

The ErrorBits parameter shows which errors have occurred.

See also
Parameter State and Retain.Mode V1 (Page 3096)

Parameter ErrorBits V1 (Page 3103)

Configuring PID_3Step V1 (Page 7786)

Operating principle PID_3Step V1

Monitoring process value limits
You specify the high limit and low limit of the process value in the Config.InputUpperLimit and 
Config.InputLowerLimit tags. If the process value is outside these limits, an error occurs 
(ErrorBits = 0001hex).

You specify a high and low warning limit of the process value in the Config.InputUpperWarning 
and Config.InputLowerWarning tags. If the process value is outside these warning limits, a 
warning occurs (Warnings = 0040hex), and the InputWarning_H or InputWarning_L output 
parameter changes to TRUE. 

Limiting the setpoint 
You specify a high limit and low limit of the setpoint in the Config.SetpointUpperLimit and 
Config.SetpointLowerLimit tags. PID_3Step automatically limits the setpoint to the process 
value limits. You can limit the setpoint to a smaller range. PID_3Step checks whether this range 
falls within the process value limits. If the setpoint is outside these limits, the high or low limit 
is used as the setpoint, and output parameter SetpointLimit_H or SetpointLimit_L is set to 
TRUE.

The setpoint is limited in all operating modes.
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Limiting the output value
You specify a high limit and low limit of the output value in the Config.OutputUpperLimit and 
Config.OutputLowerLimit tags. The output value limits must be within "Low endstop" and "High 
endstop".

● High endstop: Config.FeedbackScaling.UpperPointOut

● Low endstop: Config.FeedbackScaling.LowerPointOut

Rule:

UpperPointOut ≥ OutputUpperLimit > OutputLowerLimit ≥ LowerPointOut

The valid values for "High endstop" and "Low endstop" depend upon:

● FeedbackOn

● FeedbackPerOn

● OutputPerOn

OutputPerOn FeedbackOn FeedbackPerOn LowerPointOut UpperPointOut
FALSE FALSE FALSE Cannot be set (0.0%) Cannot be set (100.0%)
FALSE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
FALSE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%
TRUE FALSE FALSE Cannot be set (100.0%) Cannot be set (100.0%)
TRUE TRUE FALSE -100.0% or 0.0% 0.0% or +100.0%
TRUE TRUE TRUE -100.0% or 0.0% 0.0% or +100.0%

If OutputPerOn = FALSE  and FeedbackOn = FALSE, you cannot limit the output value. The 
digital outputs are reset with Actuator_H = TRUE or Actuator_L = TRUE, or after a travel time 
amounting to 110% of the motor transition time.

The output value is 27648 at 100% and -27648 at -100%. PID_3Step must be able to close 
the valve completely. Therefore, zero must be included in the output value limits.

Substitute output value
If an error has occurred, PID_3Step can output a substitute output value and move the actuator 
to a safe position that is specified in the SavePosition tag. The substitute output value must 
be within the output value limits.

Monitoring signal validity
The values of the following parameters are monitored for validity:

● Setpoint

● Input

● Input_PER

● Feedback

● Feedback_PER

● Output 
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Monitoring the PID_3Step sampling time
Ideally, the sampling time is equivalent to the cycle time of the calling OB. The PID_3Step 
instruction measures the time interval between two calls. This is the current sampling time. On 
every switchover of operating mode and during the initial startup, the mean value is formed 
from the first 10 sampling times. Too great a difference between the current sampling time and 
this mean value triggers an error (ErrorBits = 0800 hex).

PID_3Step is set to "Inactive" mode during tuning under the following conditions:

● New mean value >= 1.1 x old mean value

● New mean value <= 0.9 x old mean value

In automatic mode, PID_3Step is set to "Inactive" mode under the following conditions:

● New mean value >= 1.5 x old mean value

● New mean value <= 0.5 x old mean value

Sampling time of the PID algorithm 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_3Step are executed at every call.

Measuring the motor transition time
The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. The maximum time that the actuator is moved in one direction 
is 110% of the motor transition time. PID_3Step requires the motor transition time to be as 
accurate as possible for good controller results. The data in the actuator documentation 
contains average values for this type of actuator. The value for the specific actuator used may 
differ. You can measure the motor transition time during commissioning. The output value 
limits are not taken into consideration during the motor transition time measurement. The 
actuator can travel to the high or the low endstop.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. For cooling and discharge control systems, it may 
be necessary to invert the control logic. PID_3Step does not work with negative proportional 
gain. If InvertControl = TRUE, an increasing control deviation causes a reduction in the output 
value. The control logic is also taken into account during pretuning and fine tuning. 

See also
Configuring PID_3Step V1 (Page 7786)
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PID_3Step V1 input parameters 

Table 9-89    

Parameters Data type Default Description
Setpoint REAL 0.0 Setpoint of the PID controller in automatic mode
Input REAL 0.0 A variable of the user program is used as source for the process 

value. 
If you are using parameter Input, then 
Config.InputPerOn = FALSE must be set.

Input_PER WORD W#16#0 An analog input is used as source for the process value.
If you are using parameter Input_PER, then 
Config.InputPerOn = TRUE must be set.

Actuator_H BOOL FALSE Digital position feedback of the valve for the high endstop
If Actuator_H = TRUE, the valve is at the high endstop and is 
no longer moved towards this direction.

Actuator_L BOOL FALSE Digital position feedback of the valve for the low endstop 
If Actuator_L = TRUE, the valve is at the low endstop and is no 
longer moved towards this direction.

Feedback REAL 0.0 Position feedback of the valve
If you are using parameter Feedback, then 
Config.FeedbackPerOn = FALSE must be set.

Feedback_PER WORD W#16#0 Analog feedback of the valve position
If you are using parameter Feedback_PER, then 
Config.FeedbackPerOn = TRUE must be set.
Feedback_PER is scaled based on the variables:
● Config.FeedbackScaling.LowerPointIn
● Config.FeedbackScaling.UpperPointIn
● Config.FeedbackScaling.LowerPointOut
● Config.FeedbackScaling.UpperPointOut

ManualEnable BOOL FALSE ● A FALSE -> TRUE edge selects "Manual mode", while State 
= 4, Retain.Mode remains unchanged.

● A TRUE -> FALSE edge selects the most recently active 
operating mode

A change of Retain.Mode will not take effect during 
ManualEnable = TRUE. The change of Retain.Mode will only 
be considered upon a TRUE -> FALSE edge at ManualEnable .
PID_3Step V1.1If at start of the CPU ManualEnable = TRUE, 
PID_3Step starts in manual mode. A rising edge 
(FALSE > TRUE) at ManualEnable is not necessary.
PID_3Step V1.0
At the start of the CPU, PID_3Step only switches to manual 
mode with a rising edge (FALSE->TRUE) at ManualEnable . 
Without rising edge, PID_3Step starts in the last operating 
mode in which ManualEnable was FALSE.

ManualValue REAL 0.0 In manual mode, you specify the absolute position of the valve. 
ManualValue will only be evaluated if you are using OutputPer, 
or if position feedback is available.
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Parameters Data type Default Description
Manual_UP BOOL FALSE In manual mode, every rising edge opens the valve by 5% of 

the total control range, or for the duration of the minimum motor 
transition time. Manual_UP is evaluated only if you are not 
using Output_PER and there is no position feedback available.

Manual_DN BOOL FALSE In manual mode, every rising edge closes the valve by 5% of 
the total control range, or for the duration of the minimum motor 
transition time. Manual_DN is evaluated only if you are not 
using Output_PER and there is no position feedback available.

Reset BOOL FALSE Restarts the controller.
● FALSE -> TRUE edge

– Change to "Inactive" mode
– Intermediate controller values are reset

(PID parameters are retained)
● TRUE -> FALSE edge

Change in most recent active mode

PID_3Step V1 output parameters 

Table 9-90    

Parameter Data type Default Description
ScaledInput REAL 0.0 Scaled process value 
ScaledFeedback REAL 0.0 Scaled position feedback

For an actuator without position feedback, the position of the 
actuator indicated by ScaledFeedback is very imprecise. 
ScaledFeedback may only be used for rough estimation of the 
current position in this case.

Output_UP BOOL FALSE Digital output value for opening the valve
If Config.OutputPerOn = FALSE, the Output_UP parameter is 
used.

Output_DN BOOL FALSE Digital output value for closing the valve
If Config.OutputPerOn = FALSE, the Output_DN parameter is 
used.

Output_PER WORD W#16#0 Analog output value
If Config.OutputPerOn = TRUE, Output_PER is used.

SetpointLimit_H BOOL FALSE If SetpointLimit_H = TRUE, the absolute setpoint high limit is 
reached. In the CPU, the setpoint is limited to the configured 
absolute setpoint high limit. The configured absolute process 
value high limit is the default for the setpoint high limit.
If you configure Config.SetpointUpperLimit to a value within the 
process value limits, this value is used as the setpoint high limit.

SetpointLimit_L BOOL FALSE If SetpointLimit_L = TRUE, the absolute setpoint low limit has 
been reached. In the CPU, the setpoint is limited to the 
configured absolute setpoint low limit. The configured absolute 
process value low limit is the default setting for the setpoint low 
limit. 
If you configure Config.SetpointLowerLimit to a value within the 
process value limits, this value is used as the setpoint low limit.
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Parameter Data type Default Description
InputWarning_H BOOL FALSE If InputWarning_H = TRUE, the process value has reached or 

exceeded the warning high limit.
InputWarning_L BOOL FALSE If InputWarning_L = TRUE, the process value has reached or 

fallen below the warning low limit.
State INT 0 The State parameter (Page 3096) shows the current operating 

mode of the PID controller. You change the operating mode 
with the Retain.Mode tag. 
● State = 0: Inactive
● State = 1: Pretuning
● State = 2: Fine tuning
● State = 3: Automatic mode
● State = 4: Manual mode
● State = 5: Approach substitute output value
● State = 6: Transition time measurement
● State = 7: Error monitoring
● State = 8: Approach substitute output value with error 

monitoring
Error BOOL FALSE If Error = TRUE, at least one error message is pending.
ErrorBits DWORD DW#16#0 The ErrorBits parameter (Page 3103) indicates the error 

messages.

See also
Parameter State and Retain.Mode V1 (Page 3096)

Parameter ErrorBits V1 (Page 3103)

PID_3Step V1 static tags
You must not change tags that are not listed. These are used for internal purposes only.

Table 9-91    

Tag Data type Default Description
ActivateRecoverMode BOOL TRUE The ActivateRecoverMode tag (Page 3104) determines the reaction 

to error.
RunModeByStartup BOOL TRUE Activate Mode after CPU restart

If RunModeByStartup = TRUE, the controller returns to the last 
active operating mode after a CPU restart.
If RunModeByStartup = FALSE, the controller remains inactive after 
a CPU restart. 

PhysicalUnit INT 0 Unit of measurement of the process value and setpoint, e.g., ºC, or 
ºF.

PhysicalQuantity INT 0 Physical quantity of the process value and setpoint, e.g., 
temperature.
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Tag Data type Default Description
ErrorBehaviour INT 0 If ErrorBehaviour = 0 and an error has occurred, the valve stays at 

its current position and the controller switches directly to "Inactive" 
or "Error monitoring" mode.
If ErrorBehaviour = 1 and an error occurs, the actuator moves to the 
substitute output value and only then switches to "Inactive" or "Error 
monitoring" mode.
If the following errors occur, you can no longer move the valve to a 
configured substitute output value.
● 2000h: Invalid value at Feedback_PER parameter.
● 4000h: Invalid value at Feedback parameter.
● 8000h: Error during digital position feedback.

Warning DWORD DW#16#
0

The Warning tag (Page 3096) displays the warnings generated 
since a Reset or since the last switchover of operating mode.
Cyclic warnings (for example, process value warning) are shown 
until the cause of the warning is removed. They are automatically 
deleted once their cause has gone. Non-cyclic warnings (for 
example, point of inflection not found) remain and are deleted like 
errors.

SavePosition REAL 0.0 Substitute output value
If ErrorBehaviour = 1 and an error occurs, the actuator moves to a 
safe position for the plant and only then switches to "Inactive" mode.

CurrentSetpoint REAL 0.0 Currently active setpoint. This value is frozen at the start of tuning.
Progress REAL 0.0 Progress of tuning as a percentage (0.0 - 100.0)
Config.InputPerOn BOOL TRUE If InputPerOn = TRUE, the Input_PER parameter is used. If 

InputPerOn = FALSE, the Input parameter is used.
Config.OutputPerOn BOOL FALSE If OutputPerOn = TRUE, the Output_PER parameter is used. If 

OutputPerOn = FALSE, the Ouput_UP and Output_DN parameters 
are used.

Config.LoadBackUp BOOL FALSE If LoadBackUp = TRUE, the last set of PID parameters is reloaded. 
This set was saved prior to the last tuning operation. LoadBackUp 
is automatically reset to FALSE.

Config.InvertControl BOOL FALSE Invert control logic
If InvertControl = TRUE, an increasing control deviation causes a 
reduction in the output value.

Config.FeedbackOn BOOL FALSE If FeedbackOn = FALSE, a position feedback is simulated.
Position feedback is generally activated when 
FeedbackOn = TRUE. 

Config.FeedbackPerOn BOOL FALSE FeedbackPerOn is only effective when FeedbackOn = TRUE.
If FeedbackPerOn = TRUE, the analog input is used for the position 
feedback (Feedback_PER parameter).
If FeedbackPerOn = FALSE, the Feedback parameter is used for 
the position feedback.

Config.ActuatorEndStopOn BOOL FALSE If ActuatorEndStopOn = TRUE, the digital position feedback 
Actuator_L  and Actuator_H  are taken into consideration.
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Tag Data type Default Description
Config.InputUpperLimit REAL 120.0 High limit of the process value

At the I/O input, the process value can be a maximum of 18% higher 
than the standard range (overrange). An error is no longer signaled 
due to a violation of the "Process value high limit". Only a wire-break 
and a short-circuit are recognized and PID_3Step reacts according 
to the configured reaction to error.
InputUpperLimit > InputLowerLimit

Config.InputLowerLimit REAL 0.0 Low limit of the process value
InputLowerLimit < InputUpperLimit

Config.InputUpperWarning REAL +3.40282
2e+38

Warning high limit of the process value
If you set InputUpperWarning outside the process value limits, the 
configured absolute process value high limit is used as the warning 
high limit. 
If you configure InputUpperWarning within the process value limits, 
this value is used as the warning high limit.
InputUpperWarning > InputLowerWarning
InputUpperWarning ≤ InputUpperLimit

Config.InputLowerWarning REAL -3.40282
2e+38

Warning low limit of the process value
If you set InputLowerWarning outside the process value limits, the 
configured absolute process value low limit is used as the warning 
low limit. 
If you configure InputLowerWarning within the process value limits, 
this value is used as the warning low limit.
InputLowerWarning < InputUpperWarning
InputLowerWarning ≥ InputLowerLimit

Config.OutputUpperLimit REAL 100.0 High limit of output value
For details, see OutputLowerLimit

Config.OutputLowerLimit REAL 0.0 Low limit of output value
If OutputPerOn = TRUE or FeedbackOn = TRUE, the range of 
values from -100% to +100%, including zero, is valid. At -100%, 
Output = -27648; at +100%, Output = 27648
If OutputPerOn = FALSE, the range of values from 0% to 100% is 
valid. The valve is completely closed at 0% and completely opened 
at 100%.

Config.SetpointUpperLimit REAL +3.40282
2e+38

High limit of setpoint
If you set SetpointUpperLimit outside the process value limits, the 
configured absolute process value high limit is preassigned as the 
setpoint high limit. 
If you configure SetpointUpperLimit within the process value limits, 
this value is used as the setpoint high limit.

Config.SetpointLowerLimit REAL - 
3.402822
e+38

Low limit of the setpoint
If you set SetpointLowerLimit outside the process value limits, the 
configured absolute process value low limit is preassigned as the 
setpoint low limit.
If you set SetpointLowerLimit within the process value limits, this 
value is used as the setpoint low limit. 
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Tag Data type Default Description
Config.MinimumOnTime REAL 0.0 Minimum ON time

Minimum time in seconds for which the servo drive must be switched 
on.

Config.MinimumOffTime REAL 0.0 Minimum OFF time
Minimum time in seconds for which the servo drive must be switched 
off.

Config.TransitTime REAL 30.0 Motor transition time
Time in seconds the actuating drive requires to move the valve from 
the closed to the opened state. 

Config.InputScaling.UpperPoi
ntIn

REAL 27648.0 Scaling Input_PER high
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntIn

REAL 0.0 Scaling Input_PER low
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.UpperPoi
ntOut

REAL 100.0 Scaled high process value 
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.InputScaling.LowerPoi
ntOut

REAL 0.0 Scaled low process value
Input_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the InputScaling structure.

Config.FeedbackScaling.Uppe
rPointIn

REAL 27648.0 Scaling Feedback_PER high
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointIn

REAL 0.0 Scaling Feedback_PER low
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Uppe
rPointOut

REAL 100.0 High endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

Config.FeedbackScaling.Lowe
rPointOut

REAL 0.0 Low endstop
Feedback_PER is converted to a percentage based on the two value 
pairs UpperPointOut, UpperPointIn and LowerPointOut, 
LowerPointIn of the FeedbackScaling structure.

GetTransitTime.InvertDirectio
n

BOOL FALSE If InvertDirection = FALSE, the valve is fully opened, closed, and 
then reopened in order to determine the valve transition time.
If InvertDirection = TRUE, the valve is fully closed, opened, and then 
closed again.
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Tag Data type Default Description
GetTransitTime.SelectFeedba
ck

BOOL FALSE If SelectFeedback = TRUE, then Feedback_PER, or Feedback is 
taken into consideration in the transition time measurement.
If SelectFeedback = FALSE, then Actuator_H and Actuator_L are 
taken into consideration in the transition time measurement.

GetTransitTime.Start BOOL FALSE If Start = TRUE, the transition time measurement is started.
GetTransitTime.State INT 0 Current phase of the transition time measurement

● State = 0: Inactive
● State = 1: Open valve completely
● State = 2: Close valve completely
● State = 3: Move valve to target position (NewOutput)
● State = 4: Transition time measurement successfully completed
● State = 5: Transition time measurement canceled

GetTransitTime.NewOutput REAL 0.0 Target position for transition time measurement with position 
feedback
The target position must be between "High endstop" and "Low 
endstop". The difference between NewOutput and ScaledFeedback 
must be at least 50% of the permissible control range.

CycleTime.StartEstimation BOOL TRUE If StartEstimation = TRUE, the measurement of the PID_3Step 
sampling time is started. CycleTime.StartEstimation = FALSE once 
measurement is complete.

CycleTime.EnEstimation BOOL TRUE If EnEstimation = TRUE, the PID_3Step sampling time is calculated. 
CycleTime.EnMonitoring BOOL TRUE If EnMonitoring = TRUE, the PID_3Step sampling time is monitored. 

If it is not possible to execute PID_3Step within the sampling time, 
the error 0800h is output and the operating mode is switched.  
ActivateRecoverMode and ErrorBehaviour determine which 
operating mode is switched to. 
If EnMonitoring = FALSE, the PID_3Step sampling time is not 
monitored, the error 0800h is not output, and the operating mode is 
not switched.

CycleTime.Value REAL 0.1 PID_3Step sampling time in seconds
CycleTime.Value is determined automatically and is usually 
equivalent to the cycle time of the calling OB.

CtrlParamsBackUp.SetByUser BOOL FALSE Saved value of Retain.CtrlParams.SetByUser.
You can reload values from the CtrlParamsBackUp structure with 
Config.LoadBackUp = TRUE.

CtrlParamsBackUp.Gain REAL 1.0 Saved proportional gain
CtrlParamsBackUp.Ti REAL 20.0 Saved integral action time
CtrlParamsBackUp.Td REAL 0.0 Saved derivative action time
CtrlParamsBackUp.TdFiltRati
o

REAL 0.0 Saved derivative delay coefficient

CtrlParamsBackUp.PWeightin
g

REAL 0.0 Saved proportional action weighting

CtrlParamsBackUp.DWeightin
g

REAL 0.0 Saved derivative action weighting

CtrlParamsBackUp.Cycle REAL 1.0 Saved sampling time of PID algorithm
CtrlParamsBackUp.InputDead
Band

REAL 0.0 Saved dead band width of the control deviation
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Tag Data type Default Description
PIDSelfTune.SUT.CalculateS
UTParams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateSUTParams = TRUE, the PID parameters are recalculated 
on the basis of these properties. The PID parameters are calculated 
using the method set in TuneRuleSUT. CalculateSUTParams is set 
to FALSE following calculation.

PIDSelfTune.SUT.TuneRuleS
UT

INT 1 Methods used to calculate parameters during pretuning:
● TuneRuleSUT = 0: PID rapid I
● TuneRuleSUT = 1: PID slow I
● TuneRuleSUT = 2: Chien, Hrones and Reswick PID
● TuneRuleSUT = 3TuneRuleSUT = 3: Chien, Hrones, Reswick 

PI  
● TuneRuleSUT = 4: PID rapid II
● TuneRuleSUT = 5: PID slow II

PIDSelfTune.SUT.State INT 0 The SUT.State tag indicates the current phase of pretuning:
PIDSelfTune.TIR.RunIn BOOL FALSE ● RunIn = FALSE

Pretuning is started when fine tuning is started from inactive or 
manual mode. 
If fine tuning is started from automatic mode, the system uses 
the existing PID parameters to control to the setpoint. 
Only then will fine tuning start. If pretuning is not possible, 
PID_3Step switches to "Inactive" mode.

● RunIn = TRUE
The pretuning is skipped. PID_3Step attempts to reach the 
setpoint with the minimum or maximum output value. This can 
produce increased overshoot. Only then will fine tuning start.
RunIn is set to FALSE after fine tuning.

PIDSelfTune.TIR.CalculateTI
RParams

BOOL FALSE The properties of the controlled system are saved during tuning. If 
CalculateTIRParams = TRUE, the PID parameters are recalculated 
on the basis of these properties. The PID parameters are calculated 
using the method set in TuneRuleTIR. CalculateTIRParams is set 
to FALSE following calculation.

PIDSelfTune.TIR.TuneRuleTI
R

INT 0 Methods used to calculate parameters during fine tuning:
● TuneRuleTIR = 0: PID automatic
● TuneRuleTIR = 1: PID rapid
● TuneRuleTIR = 2: PID slow
● TuneRuleTIR = 3: Ziegler-Nichols PID
● TuneRuleTIR = 4: Ziegler-Nichols PI
● TuneRuleTIR = 5: Ziegler-Nichols P

PIDSelfTune.TIR.State INT 0 The TIR.State tag indicates the current phase of "fine tuning":
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Tag Data type Default Description
Retain.Mode INT 0 A change to the value of Retain.Mode initiates a switch to another 

operating mode.
The following operating mode is enabled upon a change of Mode to:
● Mode = 0: Inactive
● Mode = 1: Pretuning
● Mode = 2: Fine tuning
● Mode = 3: Automatic mode
● Mode = 4: Manual mode
● Mode = 5: Approach substitute output value
● Mode = 6: Transition time measurement
● Mode = 7Mode = 7: Error monitoring  
● Mode = 8: Approach substitute output value with error monitoring
Mode is retentive.

Retain.CtrlParams.SetByUser BOOL FALSE If SetByUser = FALSE, the PID parameters are determined 
automatically and PID_3Step operates with a dead band at the 
output value. The dead band width is calculated during tuning on 
the basis of the standard deviation of the output value and saved in 
Retain.CtrlParams.OutputDeadBand.
If SetByUser = TRUE, the PID parameters are entered manually 
and PID_3 Step operates without a dead band at the output value. 
Retain.CtrlParams.OutputDeadBand = 0.0
SetByUser is retentive.

Retain.CtrlParams.Gain REAL 1.0 Active proportional gain
Gain is retentive.

Retain.CtrlParams.Ti REAL 20.0 ● Ti > 0.0: Active integral action time
● Ti = 0.0: Integral action is deactivated
Ti is retentive.

Retain.CtrlParams.Td REAL 0.0 ● Td > 0.0: Active derivative action time
● Td = 0.0: Derivative action is deactivated
Td is retentive.

Retain.CtrlParams.TdFiltRatio REAL 0.0 Active derivative delay coefficient
TdFiltRatio is retentive.

Retain.CtrlParams.PWeighting REAL 0.0 Active proportional action weighting
PWeighting is retentive.

Retain.CtrlParams.DWeightin
g

REAL 0.0 Active derivative action weighting 
DWeighting is retentive.

Retain.CtrlParams.Cycle REAL 1.0 Active sampling time of PID algorithm in seconds, rounded to an 
integer multiple of the cycle time of the calling OB.
Cycle is retentive.

Retain.CtrlParams.InputDead
Band

REAL 0.0 Dead band width of the control deviation
InputDeadBand is retentive.
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 Note

Change the tags listed in this table in "Inactive" mode to prevent malfunction of the PID 
controller. "Inactive" mode is forced by setting the "Retain.Mode" tag to "0".

 

See also
Parameter State and Retain.Mode V1 (Page 3096)

Tag ActivateRecoverMode V1 (Page 3104)

Downloading technology objects to device (Page 7715)

Parameter State and Retain.Mode V1

Correlation of the parameters
The State parameter shows the current operating mode of the PID controller. You cannot 
change the State parameter. 

To switch from one operating mode to another, you must change the Retain.Mode tag. This 
also applies when the value for the new operating mode is already in Retain.Mode. For 
example, set Retain.Mode = 0 first and then Retain.Mode = 3. Provided the current operating 
mode of the controller permits this switchover, State will be set to the value of Retain.Mode.

When PID_3Step automatically switches from one operating mode to another, the following 
applies: State != Retain.Mode.

Examples:

● After successful pretuning
State = 3 and Retain.Mode = 1

● In the event of an error
State = 0 and Retain.Mode remain at the previous value, for example, Retain.Mode = 3

● ManualEnalbe = TRUE
State = 4 and Retain.Mode remain at the previous value, e.g., Retain.Mode = 3

 

  Note

You want, for example, to repeat successful fine tuning without exiting automatic mode 
with Mode = 0.

Setting Retain.Mode to an invalid value such as 9999 for one cycle has no effect on State. 
Set Mode = 2 in the next cycle. In this way, you can generate a change to Retain.Mode 
without first switching to "Inactive" mode.
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Meaning of values

State / 
Retain.Mode

Description

0 Inactive
The controller is switched off and no longer changes the valve position.

1 Pretuning
The pretuning determines the process response to a pulse of the output value and searches for the point of 
inflection. The optimized PID parameters are calculated as a function of the maximum rate of rise and dead 
time of the controlled system. 
Pretuning requirements:
● State = 0 or State = 4
● ManualEnable = FALSE
● The motor transition time has been configured or measured.
● The setpoint and the process value lie within the configured limits.
The more stable the process value is, the easier it is to calculate the PID parameters and the more precise 
the result will be. Noise on the process value can be tolerated as long as the rate of rise of the process value 
is significantly higher as compared to the noise.
Before the PID parameters are recalculated, they are backed up and can be reactivated with 
Config.LoadBackUp. The setpoint is frozen in the CurrentSetpoint tag.
The controller switches to automatic mode following successful pretuning and to "Inactive" mode following 
unsuccessful pretuning.
The pretuning phase is indicated with the SUT.State tag.
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State / 
Retain.Mode

Description

2 Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters are tuned 
based on the amplitude and frequency of this oscillation. The differences between the process response 
during pretuning and fine tuning are analyzed. All PID parameters are recalculated from the results. PID 
parameters from fine tuning usually have better master control and disturbance characteristics than PID 
parameters from pretuning.
PID_3Step automatically attempts to generate an oscillation greater than the noise of the process value. Fine 
tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before fine tuning. They can be reactivated with Config.LoadBackUp. 
The setpoint is frozen in the CurrentSetpoint tag.
Requirements for fine tuning:
● The motor transition time has been configured or measured.
● The setpoint and the process value lie within the configured limits.
● ManualEnable = FALSE
● Automatic (State = 3), inactive (State = 0) or manual (State = 4) mode
Fine tuning proceeds as follows when started from:
● Automatic mode (State = 3)

Start fine tuning from automatic mode if you wish to improve the existing PID parameters through tuning.
PID_3Step controls the system using the existing PID parameters until the control loop has stabilized and 
the requirements for fine tuning have been met. Only then will fine tuning start.

● Inactive (State = 0) or manual mode (State = 4)
Pretuning is always started first. The determined PID parameters will be used for control until the control 
loop has stabilized and the requirements for fine tuning have been met.
If PIDSelfTune.TIR.RunIn = TRUE, pretuning is skipped and an attempt is made to reach the setpoint with 
the minimum or maximum output value. This can produce increased overshoot. Fine tuning then starts 
automatically.

The controller switches to automatic mode following successful fine tuning. If fine tuning was not successful, 
the controller switches to "Inactive" mode. 
The fine tuning phase is indicated with the TIR.State tag.

3 Automatic mode
In automatic mode, PID_3Step controls the controlled system in accordance with the parameters specified.
The controller switches to automatic mode if one the following requirements is fulfilled:
● Pretuning successfully completed
● Fine tuning successfully completed
● Changing the Retain.Mode tag to the value 3.
When the CPU is switched on or switches from Stop to RUN mode, PID_3Step starts in the most recently 
active operating mode. To leave PID_3Step in "Inactive" mode, set RunModeByStartup = FALSE.
The ActivateRecoverMode tag is taken into consideration in automatic mode.
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State / 
Retain.Mode

Description

4 Manual mode
In manual mode, you specify manual output values in the Manual_UP and Manual_DN parameters or 
ManualValue parameter. Whether or not the actuator can be moved to the output value in the event of an 
error is described in the ErrorBits parameter.
This operating mode is enabled if Retain.Mode = 4, or on a rising edge at ManualEnable. 
If ManualEnable changes to TRUE, only State changes. Retain.Mode retains its current value. On a falling 
edge at ManualEnable, PID_3Step returns to the previous operating mode.
The switchover to automatic mode is bumpless.
PID_3Step V1.1
Manual mode is always possible in the event of an error.
PID_3Step V1.0
Manual mode is dependent on the ActivateRecoverMode tag in the event of an error.

5 Approach substitute output value
This operating mode is activated in the event of an error or when Reset = TRUE if Errorbehaviour = 1 and 
ActivateRecoverMode = FALSE..
PID_3Step moves the actuator to the substitute output value and then switches to "Inactive" mode.

6 Transition time measurement
The time that the motor needs to completely open the valve from the closed condition is determined.
This operating mode is activated when GetTransitTime.Start = TRUE is set.
If endstop signals are used to measure the transition time, the valve will be opened completely from its current 
position, closed completely, and opened completely again. If GetTransitTime.InvertDirection = TRUE, this 
behavior is inverted.
If position feedback is used to measure the transition time, the actuator will be moved from its current position 
to a target position. 
The output value limits are not taken into consideration during the transition time measurement. The actuator 
can travel to the high or the low endstop.

7 Error monitoring
The control algorithm is switched off and no longer changes the valve position.
This operating mode is activated instead of "Inactive" mode in the event of an error. 
All the following conditions must be met:
● Mode = 3 (automatic mode)
● Errorbehaviour = 0
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 3104) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode. 

8 Approach substitute output value with error monitoring
This operating mode is activated instead of "Approach substitute output value" mode in the event of an error. 
PID_3Step moves the actuator to the substitute output value and then switches to "Error monitoring" mode.
All the following conditions must be met:
● Mode = 3 (automatic mode)
● Errorbehaviour = 1
● ActivateRecoverMode = TRUE
● One or more errors have occurred in which ActivateRecoverMode (Page 3104) is effective.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.
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Automatic switchover of operating mode during commissioning 
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour on the switchover of operating mode from 
transition time measurement, pretuning, and fine tuning modes.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.
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Automatic switchover of operating mode in automatic mode (PID_3Step V1.1)
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour and ActivateRecoverMode on this 
switchover of operating mode.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.
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Automatic switchover of operating mode in automatic and manual modes (PID_3Step V1.0)
PID_3Step automatically switches the operating mode in the event of an error. The following 
diagram illustrates the influence of ErrorBehaviour and ActivateRecoverMode on this 
switchover of operating mode.

Automatic switchover of operating mode in the event of an error

Automatic switchover of operating mode once the current operation has been completed.

Automatic switchover of operating mode when error is no longer pending.

 

See also
Tag ActivateRecoverMode V1 (Page 3104)

Parameter ErrorBits V1 (Page 3103)
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Parameter ErrorBits V1
If several errors are pending simultaneously, the values of the error codes are displayed with 
binary addition. The display of error code 0003, for example, indicates that the errors 0001 
and 0002 are pending simultaneously.

ErrorBits

(DW#16#...)

Description

0000 There is no error.
0001 The "Input" parameter is outside the process value limits.

● Input > Config.InputUpperLimit or
● Input < Config.InputLowerLimit
If ActivateRecoverMode = TRUE and ErrorBehaviour = 1, the actuator moves to the substitute output 
value. If ActivateRecoverMode = TRUE and ErrorBehaviour = 0, the actuator stops in its current position. 
If ActivateRecoverMode = FALSE, the actuator stops in its current position. 
PID_3Step V1.1
You can move the actuator in manual mode.
PID_3Step V1.0
Manual mode is not possible in this state. You cannot move the actuator again until you eliminate the 
error.

0002 Invalid value at "Input_PER" parameter. Check whether an error is pending at the analog input.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

0004 Error during fine tuning. Oscillation of the process value could not be maintained.
0020 Pretuning is not permitted in automatic mode or during fine tuning.
0080 Error during pretuning. Incorrect configuration of output value limits.

Check whether the limits of the output value are configured correctly and match the control logic.
0100 Error during fine tuning resulted in invalid parameters.
0200 Invalid value at "Input" parameter: Value has an invalid number format.

If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

0400 Calculation of output value failed. Check the PID parameters.
0800 Sampling time error: PID_3Step is not called within the sampling time of the cyclic interrupt OB.

If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

1000 Invalid value at "Setpoint" parameter: Value has an invalid number format.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

2000 Invalid value at Feedback_PER parameter. 
Check whether an error is pending at the analog input. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state. You must deactivate position feedback (Config. FeedbackOn = FALSE) 
to move the actuator from this state.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.
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ErrorBits

(DW#16#...)

Description

4000 Invalid value at Feedback parameter. Value has an invalid number format. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state. You must deactivate position feedback (Config. FeedbackOn = FALSE) 
to move the actuator from this state.
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

8000 Error during digital position feedback. Actuator_H = TRUE and Actuator_L = TRUE. 
The actuator cannot be moved to the substitute output value and remains in its current position. Manual 
mode is not possible in this state.
In order to move the actuator from this state, you must deactivate the "Actuator endstop" 
(Config.ActuatorEndStopOn = FALSE).
If automatic mode was active before the error occurred, ActivateRecoverMode = TRUE, and the error is 
no longer pending, PID_3Step switches back to automatic mode.

Parameter Reset V1
A rising edge at Reset resets the errors and warnings and clears the integral action. A falling 
edge at Reset triggers a change to the most recently active operating mode.

① Activation
② Error
③ Reset

 

Tag ActivateRecoverMode V1
The effect of the ActivateRecoverMode variable depends on the version of the PID_3Step.
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Behavior in version 1.1
The ActivateRecoverMode variable determines the behavior in the event of an error in 
automatic mode. ActivateRecoverMode is not effective during pretuning, fine tuning and 
transition time measurement.

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" operating 
mode. The controller is activated by a reset or a change in Retain.Mode.

TRUE If errors occur frequently in automatic mode, this setting has a negative effect on the control response. In 
this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more errors occur, PID_3Step switches to "Approach substitute output value with error 
monitoring" or "Error monitoring" mode:
● 0002h: Invalid value at parameter Input_PER.
● 0200h: Invalid value at parameter Input.
● 0800h: Sampling time error
● 1000h: Invalid value at parameter Setpoint.
● 2000h: Invalid value at parameter Feedback_PER.
● 4000h: Invalid value at parameter Feedback.
● 8000h: Error in digital position feedback.
With errors 2000h, 4000h and 8000h, PID_3Step cannot  approach the configured substitute output value.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.
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Behavior in version 1.0
The ActivateRecoverMode variable determines the behavior in the event of an error in 
automatic and manual mode. ActivateRecoverMode is not effective during pretuning, fine 
tuning and transition time measurement.

ActivateRecover
Mode

Description

FALSE In the event of an error, PID_3Step switches to "Inactive" or "Approach substitute output value" operating 
mode. The controller is activated by a reset or a change in Retain.Mode.

TRUE Errors in automatic mode
If errors occur frequently in automatic mode, this setting has a negative effect on the control response. In 
this case, check the ErrorBits parameter and eliminate the cause of the error.
If one or more errors occur, PID_3Step switches to "Approach substitute output value with error 
monitoring" or "Error monitoring" mode:
● 0002h: Invalid value at parameter Input_PER.
● 0200h: Invalid value at parameter Input.
● 0800h: Sampling time error
● 1000h: Invalid value at parameter Setpoint.
● 2000h: Invalid value at parameter Feedback_PER.
● 4000h: Invalid value at parameter Feedback.
● 8000h: Error in digital position feedback.
With errors 2000h, 4000h and 8000h, PID_3Step cannot  approach the configured substitute output value.
As soon as the errors are no longer pending, PID_3Step switches back to automatic mode.
Errors in manual mode
If one or more of the following errors occur, PID_3Step stays in manual mode:
● 0002h: Invalid value at parameter Input_PER.
● 0200h: Invalid value at parameter Input.
● 0800h: Sampling time error
● 1000h: Invalid value at parameter Setpoint.
● 2000h: Invalid value at parameter Feedback_PER.
● 4000h: Invalid value at parameter Feedback.
● 8000h: Error in digital position feedback.
With errors 2000h, 4000h and 8000h, you cannot move the valve to a suitable position.

See also
PID_3Step V1 static tags (Page 3089)

Parameter State and Retain.Mode V1 (Page 3096)
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Tag Warning V1
If several warnings are pending simultaneously, their values are displayed with binary addition. 
The display of warning 0003, for example, indicates that the warnings 0001 and 0002 are 
pending simultaneously.

Warning
 (DW#16#...)

Description

0000 No warning pending.
0001 The point of inflection was not found during pretuning.
0002 Oscillation increased during fine tuning.
0004 The setpoint was limited to the configured limits. 
0008 Not all the necessary controlled system properties were defined for the selected method of calculation. 

The PID parameters were instead calculated using the TuneRuleTIR = 3 method.
0010 The operating mode could not be changed because ManualEnable = TRUE.
0020 The cycle time of the calling OB limits the sampling time of the PID algorithm. 

Improve results by using shorter OB cycle times.
0040 The process value exceeded one of its warning limits.
0080 Invalid value at Retain.Mode. The operating mode is not switched.
0100 The manual value was limited to the limits of the controller output.
0200 The rule used for tuning produces an incorrect result, or is not supported.
0400 Method selected for transition time measurement not suitable for actuator.

The transition time cannot be measured because the actuator settings do not match the selected 
measuring method. 

0800 The difference between the current position and the new output value is too small for transition time 
measurement. This can produce incorrect results. The difference between the current output value and 
new output value must be at least 50% of the entire control range.

1000 The substitute output value cannot be reached because it is outside the output value limits.

The following warnings are deleted as soon as the cause is eliminated:

● 0004

● 0020

● 0040

● 0100

All other warnings are cleared with a rising edge at Reset.

Tag SUT.State V1

SUT.Stat
e

Name Description

0 SUT_INIT Initialize pretuning
50 SUT_TPDN Determine start position without position feedback

100 SUT_STDABW Calculate the standard deviation
200 SUT_GET_POI Find the point of inflection

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 3107



SUT.Stat
e

Name Description

300 SUT_GET_RISETM Determine the rise time
9900 SUT_IO Pretuning successful

1 SUT_NIO Pretuning not successful

Tag TIR.State V1

TIR.State Name Description
-100 TIR_FIRST_SUT Fine tuning is not possible. Pretuning will be executed first.

0 TIR_INIT Initialize fine tuning
200 TIR_STDABW Calculate the standard deviation
300 TIR_RUN_IN Attempt to reach the setpoint with the maximum or minimum output value
400 TIR_CTRLN Attempt to reach the setpoint with the existing PID parameters

(if pretuning has been successful)
500 TIR_OSZIL Determine oscillation and calculate parameters

9900 TIR_IO Fine tuning successful
1 TIR_NIO Fine tuning not successful

9.7.5 Communication

9.7.5.1 Communications processor

Point-to-point

PORT_CFG: Configure communication parameters dynamically

Description 
The instruction "PORT_CFG" allows dynamic configuration of communications parameters for 
a point-to-point communications port.

You set up the original static configuration of the port in the hardware configuration. You can 
change this configuration by executing the "PORT_CFG" instruction. You can also use this 
function to save created blocks in libraries and to avoid configuration in the hardware 
configuration when you reuse it.

With "PORT_CFG" you can influence the following communications parameter settings:

● Parity

● Baud rate

● Number of bits per character
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● Number of stop bits

● Type and properties of flow control

The changes made by the "PORT_CFG" instruction are not stored permanently on the target 
system.

You can transfer serial data via the electrical connections RS-232 (half and full duplex) and 
RS-485 (half duplex).

Parameters
The following table shows the parameters of the "PORT_CFG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Activates the configuration change on a rising edge

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)

PROTOCOL Input UINT I, Q, M, D, L or 
constant

Transmission protocol:
● 0: Point-to-point communication protocol
● 1..n: Future definition for specific transmission 

protocols
BAUD Input UINT I, Q, M, D, L or 

constant
Baud rate of the port:
● 1: 300 baud
● 2: 600 baud
● 3: 1200 baud
● 4: 2400 baud
● 5: 4800 baud
● 6: 9600 baud (default)
● 7: 19200 baud
● 8: 38400 baud
● 9: 57600 baud
● 10: 76800 baud
● 11: 115200 baud

PARITY Input UINT I, Q, M, D, L or 
constant

Parity of the port:
● 1: No parity (default)
● 2: Even parity
● 3: Odd parity
● 4: Mark parity
● 5: Space parity

DATABITS Input UINT I, Q, M, D, L or 
constant

Bits per character:
● 1: 8 bits per character (default)
● 2: 7 bits per character

STOPBITS Input UINT I, Q, M, D, L or 
constant

Number of stop bits:
● 1: 1 stop bit (default)
● 2: 2 stop bits
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Parameter Declaration Data type Memory area Description
FLOWCTRL Input UINT I, Q, M, D, L or 

constant
Data flow control:
● 1: None (default)
● 2: XON/XOFF
● 3: Hardware flow control (RTS always activated)
● 4: Hardware flow control (RTS can be deactivated 

during transmission)
XONCHAR Input CHAR I, Q, M, D, L or 

constant
Indicates the character used as XON character. The 
character DC1 (11H) is set as default.

XOFFCHAR Input CHAR I, Q, M, D, L or 
constant

Indicates the character used as XOFF character. The 
character DC3 (13H) is set as default.

WAITTIME Input UINT I, Q, M, D, L or 
constant

Specifies the wait time for XON or CTS after the start 
of the transmission. 
The specified value must be greater than 0. 2000 
milliseconds are set as default.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

STATUS parameter

Error code*
(W#16#...)

Description

80A0 The specified protocol is invalid.
80A1 The specified baud rate is invalid.
80A2 The specified parity rate is invalid.
80A3 The specified number of bits per character is invalid.
80A4 The specified number of stop bits is invalid.
80A5 The specified type of flow control is invalid.
80A6 Incorrect value at the WAITTIME parameter

When the data flow control is enabled, the value at the WAITTIME parameter must be greater than zero.
80A7 Invalid values at XONCHAR and XOFFCHAR parameters.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".
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SEND_CFG: Configure serial transmission parameters dynamically

Description    
The instruction "SEND_CFG" allows dynamic configuration of serial transmission parameters 
for a point-to-point communications port. All the messages waiting for transfer are discarded 
after execution of SEND_CFG.

You set up the original static configuration of the port in the hardware configuration. You can 
change this configuration by executing the "SEND_CFG" instruction. You can also use this 
function to save created blocks in libraries and to avoid configuration in the hardware 
configuration when you reuse it. With "SEND_CFG" you can influence the following 
transmission parameter settings:

● Time between the activation of RTS (Request to Send) and the start of the transmission

● Time between the end of transmission and the deactivation of RTS

● Define bit times for breaks

The changes made by the "SEND_CFG" instruction are not stored permanently on the target 
system.

You can transfer serial data via the electrical connections RS-232 (half and full duplex) and 
RS-485 (half duplex).

Parameters
The following table shows the parameters of the "SEND_CFG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Activates the configuration change on a rising edge

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)

RTSONDLY Input UINT I, Q, M, D, L or 
constant

The time that should elapse after activating RTS until 
the start of transmission. 
Valid values for this parameter are as follows:
● 0 (default)
● 0 to 65535 ms in steps of 1 ms
This parameter does not apply to RS-485 modules. 

RTSOFFDLY Input UINT I, Q, M, D, L or 
constant

Time that should elapse after the end of transmission 
until deactivation of RTS. 
Valid values for this parameter are as follows:
● 0 (default)
● 0 to 65535 ms in steps of 1 ms
This parameter does not apply to RS-485 modules.

BREAK Input UINT I, Q, M, D, L or 
constant

Specifies the bit times for a break, which are sent at 
the start of the message.
12 bit times are set as default. A maximum of 25000 
bit times can be specified.
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Parameter Declaration Data type Memory area Description
IDLELINE Input UINT I, Q, M, D, L or 

constant
Specifies the bit times for idle line after the break at 
the start of the message.
12 bit times are set as default. A maximum of 25000 
bit times can be specified.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

STATUS parameter

Error code*
(W#16#...)

Description

80B0 The configuration of a transmission interruption is not permitted.
80B1 The specified break time exceeds the permitted maximum of 25000 bit times.
80B2 The specified time for idle line exceeds the permitted maximum of 25000 bit times.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".

RCV_CFG: Configure serial receive parameters dynamically

Description
The instruction "RCV_CFG" allows dynamic configuration of serial receive parameters for a 
point-to-point communications port. You can use this instruction to configure the conditions 
that specify the start and end of the message to be transmitted. The receipt of messages that 
correspond to these conditions can be enabled by the "RCV_PTP (Page 3121)" instruction.

You set up the original static configuration of the port in the properties of the hardware 
configuration. Execute the "RCV_CFG" instruction in your program to change the configuration. 
You can also use this function to save created blocks in libraries and to avoid configuration in 
the hardware configuration when you reuse it. The changes made by the "RCV_CFG" 
instruction are not stored permanently on the target system.

All the messages waiting for transfer are discarded after execution of the "RCV_CFG" 
instruction.
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Parameters
The following table shows the parameters of the "RCV_CFG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Activates the configuration change on a 
rising edge.

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port 
(HW-ID)

CONDITIONS Input CONDITIONS D, L Data structure defining the conditions for 
start and end of data transmission. 

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred.

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Data type CONDITIONS
You can use the CONDITIONS structure to define the start and end conditions for the message 
transmission. The structure CONDITIONS is included in the instance DB of the "RCV_CFG" 
instruction. Use the structure CONDITIONS to define the start and end conditions when the 
transmission of a message is complete and when the next message transfer is to start:

● You define the start conditions for the data transfer in the START structure.

● You define the end conditions for the data transfer in the END structure.

You can define one or more start and end conditions for this. If you specify multiple start or 
end conditions these are linked by an OR logic instruction.

The following table shows the "CONDITIONS" structure:
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Parameters Data type Description
START STRUCT Start conditions
 STARTCOND UINT Specifies the start condition (details, see below).

The start condition can be specified as a 16-bit hexadecimal value. Possible values 
for the start condition are:
● 1: Start character
● 2: Any character (default)
● 4: Line break
● 8: Idle line
● 16: Character string 1
● 32: Character string 2
● 64: Character string 3
● 128: Character string 4
Multiple start conditions can also be defined at the STARTCOND parameter. The 
total from the values of the individual conditions is specified for this. If, for example, 
you want to define "Idle line" OR "Character string 1" OR "Character string 4" as 
start condition, the value "152" must be specified.

IDLETIME UINT Specifies the maximum idle time of the line before receipt is started. 
Valid values for this parameter are as follows:
● 40 bit times (default)
● 0 to 2500 bit times

STARTCHAR BYTE Specifies the start character. This setting is only enabled when the configured start 
condition is "Start character".
Valid values for this parameter are as follows:
● 02 (STX): Default setting
● B#16#00 to B#16#FF

SEQ[1].CTL BYTE Character string 1: Control sequence for each character 
You can use the bit position of the character to define which characters of the 
character string will be considered or ignored. To evaluate the characters, the 
corresponding bits have to be set. 
● Bit 0: 1 character
● Bit 1: 2 characters
● Bit 2: 3 characters
● Bit 3: 4 characters
● Bit 4: 5 characters
A character is ignored when the corresponding bit is reset.

SEQ[1].STR CHAR[5] Character string 1: Start character (5 characters)
SEQ[2].CTL BYTE Character string 2: Ignore/compare control sequence for each character
SEQ[2].STR CHAR[5] Character string 2: Start character (5 characters)
SEQ[3].CTL BYTE Character string 3: Ignore/compare control sequence for each character
SEQ[3].STR CHAR[5] Character string 3: Start character (5 characters)
SEQ[4].CTL BYTE Character string 4: Ignore/compare control sequence for each character
SEQ[4].STR CHAR[5] Character string 4: Start character (5 characters)

END STRUCT End conditions
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Parameters Data type Description
 ENDCOND UINT Specifies the end condition (details, see below).

The end condition can be specified as a 16-bit hexadecimal value. Possible values 
for the end condition are:
● 1: Reply timeout
● 2: Message timeout
● 4: Timeout within the character string
● 8: Maximum length
● 16: N+LEN+M; the information on the message length in integrated in the 

message and will be evaluated.
● 32: Character string 1
Multiple end conditions can also be defined at the ENDCOND parameter. The total 
from the values of the individual end conditions is specified for this. If, for example, 
you want to define the end condition "Maximum length" OR "Sequence 1", the 
value "40" must be specified.

MAXLEN UINT Specifies the maximum number of characters in a message. 
Valid values* for this parameter are as follows:
● 1 character (default)
● 0 to 1024 characters
This setting is only enabled if the "Maximum length" end condition is set at the 
ENDCOND parameter.

N UINT Offset of the length field in the message
Valid values for this parameter are as follows:
● 0 characters (default)
● 0 to 1024 characters
This setting is only enabled if the "N+LEN+M" end condition is set at the 
ENDCOND parameter.

LENGTHSIZE UINT Size of the length field in bytes
Valid values* for this parameter are as follows:
● 0 bytes (default)
● 1 byte
● 2 bytes
● 4 bytes
This setting is only enabled if the "N+LEN+M" end condition is set at the 
ENDCOND parameter.

LENGTHM UINT Specifies the number of end characters that follow the length field but are not 
contained in the length of the message. 
Valid values for this parameter are as follows:
● 0 characters (default)
● 0 to 255 characters
This setting is only enabled if the "N+LEN+M" end condition is set at the 
ENDCOND parameter.
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Parameters Data type Description
RCVTIME UINT Specifies the maximum duration for the receipt of the first character of a message.

Valid values for this parameter are as follows:
● 200 ms (default)
● 0 to 65535 ms in steps of 1 ms
This setting is only enabled if the "Reply timeout" end condition is set at the 
ENDCOND parameter.

MSGTIME UINT Specifies the maximum duration of the receipt of a message. 
Valid values for this parameter are as follows:
● 200 ms (default)
● 0 to 65535 ms in steps of 1 ms
This setting is only enabled if the "Message timeout" end condition is set at the 
ENDCOND parameter. 

CHARGAP UINT Specifies the time interval between received consecutive characters.
Valid values for this parameter are as follows:
● 12 bit times (default)
● 0 to 2500 bit times
This setting is only enabled if the "Timeout within the character string" end 
condition is set at the ENDCOND parameter.

SEQ.CTL BYTE Character string: Control sequence for each character 
You can use the bit position of the character to define which characters of the 
character string will be considered or ignored. To evaluate the characters, the 
corresponding bits have to be set. 
● Bit 0: 1 character
● Bit 1: 2 characters
● Bit 2: 3 characters
● Bit 3: 4 characters
● Bit 4: 5 characters
A character is ignored when the corresponding bit is reset.

SEQ.STR CHAR[5] Character string: Start character (5 characters)
* These value ranges also apply to the corresponding hardware settings for specifying the end of message.

Start conditions for the message receipt (STARTCOND parameter)
The start of the message is recognized by the receiver if a configured start condition applies. 
The following conditions can be defined as start conditions for message receipt:

● Start character: The start of a message is recognized when a certain character occurs. This 
character is stored as first character of the message. All characters received before the 
start character are rejected.

● Any character: Any character can define the start of a message. This character is stored 
as first character of the message.

● Line break: The start of a message is recognized if the received data stream is interrupted 
for longer than one character length.
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● Idle line: The start of a message is recognized when the send transmission line is in the 
idle state for a certain time (specified in bit times) followed by renewed transmission of 
characters.

● Character string (sequence): The start of a message is recognized when a specified 
character sequence occurs in the data stream. You can specify up to four character 
sequences with up to five characters each.
Example: A received hexadecimal message includes the following characters: "68 10 aa 
68 bb 10 aa 16". The configured start character sequences are listed in the following
table. Start character sequences will be evaluated once the first character 68H
has been received successfully. After the fourth character has been received successfully 
(the
second 68H), the start condition "1" has been met. Once the start conditions have been 
met,
evaluation of the end conditions will start.
Processing of the start character sequence can end due to different errors in parity,
framing or time intervals between characters. These errors will prevent
reception of the message, because the start condition has not
been met.

Start condition First character First character +1 First character +2 First character +3 First character +4
1 68H xx xx 68H xx
2 10H aaH xx xx xx
3 dcH aaH xx xx xx
4 e5H xx xx xx xx

End conditions for the message receipt (ENDCOND parameter)
The start of a message is recognized by the receiver if a configured end condition applies. The 
following conditions can be defined as end conditions for message receipt:

● Reply timeout: The receipt of messages will end when the specified maximum duration for 
the receipt of a character is exceeded. The maximum duration is defined at the RCVTIME 
parameter. The defined time starts to run down as soon at the last transmission is completed 
and the RCV_PTP instruction enables the receipt of the message. If no character was 
received within the defined time (RCVTIME), the RCV_PTP instruction reports an error.

● Message timeout: The receipt of messages will end when the specified maximum duration 
for the receipt of a message is exceeded. The maximum duration is defined at the 
MSGTIME parameter. The defined time starts to run down as soon as the first character of 
the message is received.

● Timeout within the character string: The receipt of messages will end when the time interval 
between the receipt of two consecutive characters is longer than the value at the CHARGAP 
parameter.

● Maximum length: The receipt of messages will end when the length of the message defined 
at the MAXLEN  parameter is exceeded.
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● Reading message length (N+LEN+M): The receipt of messages will end when a certain 
message length is reached. This length is calculated by the values of the following 
parameters:

– N: Position of the character in the message from which the length field begins.

– LENGTHSIZE: Size of the length field in bytes

– LENGTHM: Number of end characters that follow the length field. These characters are 
not taken into account in the evaluation of the message length.

● Character string: The receipt of messages will end when a defined character sequence is 
received. The character string can contain a maximum of five characters. For each 
character of the character string, you can use the bit position to define if this will be 
considered or ignored in the evaluation.

STATUS parameter

Error code*
(W#16#...)

Description

80C0 Error in start condition
80C1 ● Error in end condition

● No end condition defined
80C2 Receive interrupt enabled
80C3 A value that is equal to 0 or greater than 4132 was entered at the MAXLEN parameter while the "Maximum 

length" end condition was set.
80C4 A value that is greater than 4131 was entered at the N parameter while the "N+LEN+M" end condition was 

set.
80C5 A value that is equal to 0 or invalid was entered at the LENGTHSIZE parameter while the "N+LEN+M" end 

condition was set.
80C6 A value that is greater than 255 was entered at the LENGTHM parameter while the "N+LEN+M" end condition 

was set.
80C7 A message length greater than 4132 was calculated while the "N+LEN+M" end condition was set.
80C8 A value that is equal to 0 was entered at the RCVTIME parameter while the "Reply timeout" end condition 

was set.
80C9 A value that is equal to 0 or greater than 2500 was entered at the CHARGAP parameter while the "Timeout 

within a character string" end condition was set.
80CA A value that is equal to 0 or greater than 2500 was entered at the IDLETIME parameter while the "Idle line" 

start condition was set.
80CB All characters of the character string are marked as "Don't care" even though "Character string" is set as 

the end condition.
80CC All characters of the character string are marked as "Don't care" even though "Character string" is set as 

the start condition.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".
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SEND_PTP: Transmit send buffer data

Description  
You use the "SEND_PTP" instruction to start the transmission of data. The "SEND_PTP" 
instruction does not execute the actual transmission of the data. The data of the send buffer 
is transmitted to the relevant point-to-point communication module (CM). The CM executes 
the actual transmission.

Parameters
The following table shows the parameters of the "SEND_PTP" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Enables the requested transmission on a rising edge 
of this enable input. The content of buffer is 
transmitted to the point-to-point communication 
module (CM).

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)

BUFFER Input VARIANT I, Q, M, D, L or 
constant

Pointer to the start address of the send buffer. 
Boolean values or Array of BOOL are not supported.

LENGTH Input UINT I, Q, M, D, L or 
constant

Length of the send buffer

PTRCL Input BOOL I, Q, M, D, L or 
constant

This parameter selects the buffer for normal point-to-
point communication or for specific Siemens 
protocols implemented in the connected CM.
FALSE = point-to-point operations controlled by the 
user program (only valid option)

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

STATUS parameter

Error code*
(W#16#...)

Description

7000 The send operation is not active.
7001 The send operation is processing the first call.
7002 The send operation is processing subsequent calls (queries following the first call).
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Error code*
(W#16#...)

Description

8080 The identifier entered for the communications port number is invalid.
8088 The length of the LENGHT parameter does not correspond to the length of data to be sent. See also: 

Parameters LENGHT and BUFFER.
80D0 A new send request was received while a transmission was taking place.
80D1 The transmission was interrupted because the CTS signal was not confirmed within the specified wait 

time.
80D2 The send request was interrupted because the communications partner (DCE) signaled that it was not 

willing to receive (DSR).
80D3 The send request was interrupted because the maximum size of the waiting loop was exceeded (more 

than 1024 Byte).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".

Parameters LENGTH and BUFFER
The minimum data size that can be sent by the "PTP_SEND" instruction is one byte. The 
parameter BUFFER defines the size of the data to be sent. You can use neither the BOOL nor 
the Array of BOOL data type for the BUFFER parameter. 

LENGTH parameter BUFFER parameter Description
LENGTH = 0 Not used The complete data is sent as defined by the BUFFER parameter. If 

LENGTH = 0, you do not need to specify the number of bytes 
transferred.

LENGTH > 0 Elementary data type The LENGTH value must contain the byte count of this data type. 
Otherwise, data is not transferred and error 8088 is output.

STRUCT The LENGTH value can contain a byte count that is smaller than 
the complete byte length of the structure. In this case, only the first 
LENGTH bytes are transferred.

ARRAY The LENGTH value can contain a byte count that is smaller than 
the complete byte length of the field. In this case, only the field 
elements that fit completely in the LENGTH bytes are transferred.
The LENGTH value must be a multiple of the byte count of the data 
elements. Otherwise, STATUS = 8088, ERROR = 1, and no data is 
transferred.

STRING The complete memory arrangement of the character sequence 
format will be transmitted as well as the information about maximum 
length of the character string and the actual length of the character 
string.
The LENGTH value must contain bytes for maximum length, actual 
length, and the characters of the character string. 
With the data type STRING, all lengths and characters have the size 
of one byte.
If a character string is used for the BUFFER parameter, the 
LENGTH value must also contain two bytes for the two length fields.
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RCV_PTP: Enable receive messages

Description
With the RCV_PTP instruction you enable receipt of a sent message. Each message must be 
enabled individually. The sent data is only available in the receive area when the message 
has been acknowledged by the relevant communications partner.

Parameters
The following table shows the parameters of the "RCV_PTP" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Enables receipt on a rising edge 

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)

BUFFER Input VARIANT I, Q, M, D, L or 
constant

Points to the start address of the receive buffer. Do not 
use a tag of the type STRING in the receive buffer.

NDR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
LENGTH Output UINT I, Q, M, D, L Length of the message in the receive buffer

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

STATUS parameter

Error code*
(W#16#....)

Description

80E0 Receipt of messages was terminated because the receive buffer is full.
80E1 Receipt of messages was terminated as a result of a parity error.
80E2 Receipt of messages was terminated as a result of a framing error. 
80E3 Receipt of messages was terminated as a result of an overflow error.
80E4 Receipt of messages was terminated because the calculated message length (N+LEN+M) exceeds the 

size of the receive buffer.
8080 The identifier entered for the communications port number is invalid.
8088 A data type STRING is referenced via the BUFFER parameter. 
0094 Receipt of messages was terminated because the maximum character length was received.
0095 Receipt of messages was terminated as a result of a timeout. 
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Error code*
(W#16#....)

Description

0096 Receipt of messages was terminated because of a timeout within the character string.
0097 Receipt of messages was terminated as a result of a reply timeout.
0098 Receipt of messages was terminated because the "N+LEN+M" length condition has been satisfied.
0099 Receipt of messages was terminated because the character string defined as the end condition was 

received.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".

RCV_RST: Delete receive buffer

Description
With the "RCV_RST" instruction, you delete the receive buffer of a communications partner.

Parameters
The following table shows the parameters of the "RCV_RST" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Enables deleting of the receive buffer on a rising 
edge

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
You will find more detailed information on general 
error codes of the communication instructions in: 
"General status information of the communications 
blocks (Page 3125)".

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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SGN_GET: Query RS-232 signals

Description
With the "SGN_GET" instruction, you query the current state of several signals of an RS-232 
communications module.

Parameters
The following table shows the parameters of the "SGN_GET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Enables the query on a rising edge

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)

NDR Output BOOL I, Q, M, D, L Is set for one cycle if new data are ready for 
sending and the instruction was executed error-
free.

DTR Output BOOL I, Q, M, D, L Data terminal ready, module ready
DSR Output BOOL I, Q, M, D, L Data set ready, communications partner ready
RTS Output BOOL I, Q, M, D, L Send request, module ready to send
CTS Output BOOL I, Q, M, D, L Clear to send, communications partner can 

receive data (reaction to RTS = ON of the 
module).

DCD Output BOOL I, Q, M, D, L Data carrier detect, received signal level
RING Output BOOL I, Q, M, D, L Ring display, display of an incoming call
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

STATUS parameter

Error code*
(W#16#....)

Description

80F0 The communication module is an RS-485 module and no signals are available.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".
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SGN_SET: Set RS-232 signals

Description
With the "SGN_SET" instruction, you set the status of the output signals of an RS-232 
communications module.

Parameters
The following table shows the parameters of the "SGN_SET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Activates the action on a rising edge
Initial value: FALSE

PORT Input PORT I, Q, M, D, L or 
constant

Identification of the communication port (HW-ID)
Initial value: FALSE

SIGNAL Input BYTE I, Q, M, D, L or 
constant

Specifies the signals to be set:
● Set 01H = RTS
● Set 02H = DTR
● Set 04H = DSR
Initial value: FALSE

RTS Input BOOL I, Q, M, D, L or 
constant

Send request, module ready to send
Initial value: FALSE

DTR Input BOOL I, Q, M, D, L or 
constant

Data terminal ready, module ready
Initial value: FALSE

DSR Input BOOL I, Q, M, D, L or 
constant

Data set ready (applies only to interfaces of the 
DCE type)
Initial value: FALSE

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or is still executing
● 1: Job executed without errors
Initial value: FALSE

ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: No error
● 1: Error occurred
Initial value: FALSE

STATUS Output WORD I, Q, M, D, L Status of the instruction
Initial value: 0

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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STATUS parameter

Error code*
 (W#16#...)

Description

80F0 The communication module is an RS-485 module and no signals are available.
80F1 No signals are settable because H/W flow control is enabled.
80F2 The DSR signal cannot be set because the module is a DTE device.
80F3 The DTR signal cannot be set because the module is a DCE device.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

You will find more detailed information on general error codes of the communication 
instructions in: "General status information of the communications blocks (Page 3125)".

General status information of the communications blocks

General information on execution status of the communications blocks
The following table shows which general information can be output at the STATUS parameter 
of the communications blocks:

Error code*
(W#16#....)

Description

8070 All internal instance memory is in use
8080 The identifier entered for the communications port is invalid
8081 Timeout, module error, internal error
8085 Error specifying the length at the LENGHT parameter. The specified length is "0" or greater than the 

maximum permitted value.
8090 Message length invalid, module invalid, message invalid
8091 Incorrect version in parameterization message
8092 Invalid record length in parameterization message
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

USS

Overview of USS instructions

Introduction  
The USS instructions control the operation of drives that support the universal serial interface 
(USS). With the USS instructions, you can communicate with more than one drive via an 
RS-485 connection.
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To do this, you require a CM 1241 RS-485 communications module or a CB 1241 RS-485 
communications board. Up to three CM 1241 RS-485 modules and one CB 1241 RS-485 board 
can be installed in an S7-1200 CPU.

Each RS-485 port can operate up to sixteen drives. 

The USS protocol uses a master/slave network for communication via a serial bus. The master 
uses an address parameter to send a message to a selected slave. A slave itself can never 
send without previously receiving a request. Direct exchange of messages between slaves is 
not possible. USS communication works in half duplex mode.

The following figure shows an example of a USS network diagram:

Requirements for using the USS protocol

General requirements for setting up a drive
● The use of 4 PKW words must be set up for the drives.

● The drives can be configured for 2, 4, 6 or 8 PZD words.

● The number of PZD words in the drive must correspond to the PZD_LEN input of the 
"USS_DRIVE (Page 3131)" instruction of the drive.

● The baud rate of all drives must match the baud rate of the BAUD input parameter of the 
"USS_PORT (Page 3130)" instruction.

● The drive must be set up for remote control.

● USS must be specified for the desired frequency value on the COM connection of the drive.
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● 1 to 16 must be set as the drive address. This address must correspond to the address of 
the DRIVE input parameter of the "USS_DRIVE (Page 3131)" instruction.

● To control the direction of the drive, the polarity of the drive desired value must be set up.

● The RS-485 network must be connected correctly.

Definition: PKW / PZD area
● The PKW area relates to the handling of the parameter-identifier-value interface.

The PKW interface is not a physical interface but describes a mechanism that controls the 
exchange of parameters between two communications partners, in other words, reading 
and writing parameter values, parameter descriptions and corresponding texts and the 
handling of parameter changes due to spontaneous messages. All the tasks handled via 
the PKW interface are essentially tasks for operator control and monitoring, service and 
diagnostics.

● The PZD area includes the signals required for automation:

– Control word(s), and setpoint(s) from the master to the slave

– Status word(s), and actual value(s) from the slave to the master.

Both areas together result in the user data field. This is transferred by the master to the slave 
as a job frame or by the slave to the master as a reply frame.

Description   
Each communication module CM 1241 RS485 supports a maximum of 16 drives. A single 
instance data block contains temporary memory and buffer functions for all drives in the USS 
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network that are connected to a PtP communications module you installed. The USS 
instructions for these drives have shared access to the information in this data block.

 

● All drives (max. 16) that are connected to an  RS485 port are part of the same USS network. 
All drives that are connected to a different RS485 port are part of a different USS network. 
As the S7-1200 supports up to three CM 1241 RS485 modules, you can set up up to three 
USS networks, each having a maximum of 16 drives, thus a total of 48 USS drives are 
supported.

● Each USS network is managed via a unique data block (three data blocks are required for 
three USS networks with three CM 1241 RS485 modules). All instructions that belong to a 
USS network must share this data block. This includes all "USS_DRIVE (Page 3131)", 
"USS_PORT (Page 3130)", "USS_RPM (Page 3133)", and "USS_WPM (Page 3135)" 
instructions for controlling all drives in a USS network.
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● The instruction "USS_DRIVE (Page 3131)" is a function block (FB). When you insert the 
instruction "USS_DRIVE" in the editor, the "Call options" dialog will ask you to assign a DB 
to the instruction.

– If this is the first "USS_DRIVE" instruction in this program for this USS network, you can 
accept the default DB assignment (or, if necessary, change the name) and the new DB 
will be created.

– If, however, this is not the first "USS_DRIVE" instruction for this network, you must select 
the DB that was previously assigned to this USS network in the drop-down list in the 
"Call options" dialog.

● All "USS_PORT (Page 3130), USS_RPM (Page 3133)", and "USS_WPM (Page 3135)" 
instructions are functions (FCs). When you insert these FCs in the editor, no DB is assigned. 
Instead, you have to assign the DB in question to the USS_DB input of these instructions 
(double-click on the parameter field and then on the icon to display the available DBs).

● The instruction "USS_PORT (Page 3130)" controls communication between the CPU and 
the drives via the PtP communications module. Whenever this instruction is called, 
communication with a drive is processed. Your program must call this function quickly 
enough so that the drives do not report a timeout. The instruction can be called from the 
main program or any interrupt OB.

● The function block "USS_DRIVE (Page 3131)" gives your program access to a specified 
drive in the USS network. Its inputs and outputs correspond to the states and operating 
functions of the drive. If there are 16 drives in the network, "USS_DRIVE" must be called 
at least 16 times in your program, i.e., once for each drive. How quickly these blocks are 
called depends on the required speed for controlling drive functions.
You can only call the instruction "USS_DRIVE" from the main program OB.

 

 
 CAUTION

Call "USS_DRIVE", "USS_RPM", "USS_WPM" only from the main program OB. The 
instruction "USS_PORT" can be called from any OB, it is usually called from a time-delay 
interrupt OB. If the instruction "USS_PORT" is interrupted during execution, this may result 
in unexpected errors.

 

The "USS_RPM" and "USS_WPM" instructions are used to read and write the operating 
parameters of the drive. These parameters control the internal mode of operation of the drive. 
A definition of these parameters can be found in the drive manual.

Your program may also contain any number of these instructions; however only one read or 
write request can be active for a drive. You may only call the instructions "USS_RPM" and 
"USS_WPM" from the main program OB.

Calculating the time for communication with the drive
Communication with the drive is runs asynchronous to the cycle of the S7-1200. The S7-1200 
runs through several cycles before communication with a drive is completed.

The interval of "USS_PORT" is the time required for a drive transaction. The following table 
shows the minimum intervals for "USS_PORT" for each baud rate. Calling the "USS_PORT" 
more frequently than the "USS_PORT" interval will not increase the number of transactions. 
The timeout interval of the drive is the period of time available to a transaction if 3 attempts 

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 3129



are required to complete the transaction due to communications errors. By default, up to 2 
further attempts are made for each transaction with the USS protocol.

Baud rate Calculated minimum interval for calling 
USS_PORT (ms) 

Drive message interval timeout per 
drive (ms)

1200 790 2370
2400 405 1215
4800 212.5 638
9600 116.3 349
19200 68.2 205
38400 44.1 133
57600 36.1 109
115200 28.1 85

USS_PORT: Edit communication via USS network

Description     
The "USS_PORT" instruction handles communication over the USS network. In the program, 
use one "USS_PORT" instruction per PtP communications port to control the transmission to 
or from one drive. 

All USS instructions that are assigned to one USS network and one PtP communications port 
must use the same instance data block. 

Call
Your program must execute the "USS_PORT" instruction often enough to prevent timeouts in 
the drive. You should therefore call the "USS_PORT" instruction from a cyclic interrupt OB to 
prevent drive timeouts and keep the most recent USS data updates available for 
"USS_DRIVE (Page 3131)" calls.

Parameters
The following table shows the parameters of the "USS_PORT" instruction:

Parameter Declaration Data type Memory area Description
PORT Input PORT D, L or constant PtP communications port identifier

Constant that can be referenced within the 
"Constants" tab of the default tag table.

BAUD Input DINT I, Q, M, D, L or 
constant

Baud rate for USS communication.

USS_DB InOut USS_BASE D Reference to the instance DB of the "USS_DRIVE 
(Page 3131)" instruction.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L ERROR is set to TRUE if an error occurs. A 

corresponding error code will be output at the 
STATUS output.

STATUS 
(Page 3136) 

Output WORD I, Q, M, D, L Status value of the request. It indicates the result of 
the cycle or initialization. Additional information is 
available in the "USS_Extended_Error (Page 3136)" 
tag for some status codes.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

USS_DRIVE: Swap data with drive

Description     
The "USS_DRIVE" instruction exchanges data with the drive by creating request messages 
and interpreting the drive response messages. A separate instruction must be used for each 
drive, but all USS instructions assigned to one USS network and one PtP communications 
module must use the same instance data block. You must create the DB name when you place 
the first "USS_DRIVE" instruction. Then reuse this DB that was created when the initial 
instruction was inserted.

When the "USS_DRIVE" instruction is executed the first time, the drive indicated by the USS 
address (parameter DRIVE) is initialized in the instance DB. After this initialization, subsequent 
"USS_PORT (Page 3130)" instructions can start communication with the drive at this drive 
number. 

Changing the drive number requires a PLC STOP to RUN mode transition that initializes the 
instance DB. Input parameters are configured in the USS send buffer, and outputs are read 
from a "previous" valid response buffer if any exists. There is no data transmission during 
execution of the "USS_DRIVE" instruction. Communication with the drives takes place when 
"USS_PORT (Page 3130)" is executed. "USS_DRIVE" only configures the messages to be 
sent and interprets data received in a previous request.

You can control the drive direction of rotation using either the DIR (BOOL) input or using the 
sign (positive or negative) at the SPEED_SP (REAL) input. The following table explains how 
these inputs work together to determine the drive direction, assuming the motor is wired for 
forward rotation.

SPEED_SP DIR Direction of rotation of drive
Value > 0 0 Reverse
Value > 0 1 Forward
Value < 0 0 Forward
Value < 0 1 Reverse

Parameters
Expand the box to display all the parameters by clicking the  bottom of the box. The parameter 
connections that are grayed are optional and do not need to be assigned.
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The following table shows the parameters of the "USS_DRIVE" instruction:

Parameter Declaration Data type Memory area Description
RUN Input BOOL I, Q, M, D, L or 

constant
Drive start bit: If this parameter has the value TRUE, 
this input enables the drive to run at the preset speed.

OFF2 Input BOOL I, Q, M, D, L or 
constant

"Electrical stop" bit: If this parameter has the value 
FALSE, this bit cause the drive to coast to a stop 
without braking.

OFF3 Input BOOL I, Q, M, D, L or 
constant

Fast stop bit - If this parameter has the value FALSE, 
this bit causes a fast stop by braking the drive.

F_ACK Input BOOL I, Q, M, D, L or 
constant

Fault acknowledge bit - This bit resets the fault bit on 
a drive. This bit is set after the fault is cleared to 
indicate to the drive that it no longer needs to indicate 
the previous fault.

DIR Input BOOL I, Q, M, D, L or 
constant

Drive direction control - This bit is set to indicate that 
the direction is forward (when SPEED_SP is positive).

DRIVE Input USINT I, Q, M, D, L or 
constant

Drive address: This input is the address of the USS 
drive. The valid range is drive 1 to drive 16.

PZD_LEN Input USINT I, Q, M, D, L or 
constant

Word length - This is the number of words of PZD 
data. Valid values are 2, 4, 6, or 8 words. The default 
is 2.

SPEED_SP Input REAL I, Q, M, D, L or 
constant

Speed setpoint - This is the speed of the drive as a 
percentage of configured frequency. A positive value 
specifies forward direction (when DIR has the value 
TRUE).

CTRL3 Input WORD I, Q, M, D, L or 
constant

Control word 3 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL4 Input WORD I, Q, M, D, L or 
constant

Control word 4 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL5 Input WORD I, Q, M, D, L or 
constant

Control word 5 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL6 Input WORD I, Q, M, D, L or 
constant

Control word 6 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive.

CTRL7 Input WORD I, Q, M, D, L or 
constant

Control word 7 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

CTRL8 Input WORD I, Q, M, D, L or 
constant

Control word 8 - A value written to a user-configurable 
parameter on the drive. The user must configure this 
on the drive. Optional parameter

NDR Output BOOL I, Q, M, D, L New data ready - If this parameter has the value 
TRUE, the bit indicates that the output contains data 
from a new communication request.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L Error occurred - If this parameter has the value TRUE, 

this indicates that an error has occurred and the 
STATUS output is valid. All other outputs are set to 
zero on an error. Communication errors are only 
reported at the ERROR and STATUS outputs of the 
"USS_PORT" instruction.

STATUS 
(Page 3136) 

Output WORD I, Q, M, D, L Status value of the request. It indicates the result of 
the cycle. This is not a status word returned from the 
drive.

RUN_EN Output BOOL I, Q, M, D, L Run enabled - This bit indicates whether the drive is 
running.

D_DIR Output BOOL I, Q, M, D, L Drive direction - This bit indicates whether the drive 
is running forward.

INHIBIT Output BOOL I, Q, M, D, L Drive inhibited - This bit indicates the state of the 
inhibit bit on the drive.

FAULT Output BOOL I, Q, M, D, L Drive fault - This bit indicates that the drive has 
registered a fault. The user must eliminate the fault 
and then set the F_ACK bit to clear this bit.

SPEED Output REAL I, Q, M, D, L Drive current speed (scaled value of drive status word 
2) - The value of the speed of the drive as a 
percentage of configured speed.

STATUS1 Output WORD I, Q, M, D, L Drive status word 1 - This value contains fixed status 
bits of a drive.

STATUS3 Output WORD I, Q, M, D, L Drive status word 3 - This value contains a user-
configurable status word on the drive.

STATUS4 Output WORD I, Q, M, D, L Drive status word 4 - This value contains a user-
configurable status word on the drive.

STATUS5 Output WORD I, Q, M, D, L Drive status word 5 - This value contains a user-
configurable status word on the drive.

STATUS6 Output WORD I, Q, M, D, L Drive status word 6 - This value contains a user-
configurable status word on the drive.

STATUS7 Output WORD I, Q, M, D, L Drive status word 7 - This value contains a user-
configurable status word on the drive.

STATUS8 Output WORD I, Q, M, D, L Drive status word 8 - This value contains a user-
configurable status word on the drive.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

USS_RPM: Readout parameters from the drive

Description
The "USS_RPM" instruction reads a parameter from the drive. All USS functions that are 
assigned to one USS network and one PtP communications module must use the same 
instance data block. "USS_RPM" must be called from the main program OB. 
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Parameter
The following table shows the parameters of the "USS_RPM" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Send request: If this parameter has the value TRUE, 

it indicates that a new read request is desired. This is 
ignored if the request for this parameter is already 
pending. 

DRIVE Input USINT I, Q, M, D, L or 
constant

Drive address: This input is the address of the USS 
drive. The valid range is drive 1 to drive 16.

PARAM Input UINT I, Q, M, D, L or 
constant

Parameter number: This input specifies which drive 
parameter is written. The range of this parameter is 0 
to 2047. See your drive manual for details on how to 
access any parameters above this range.

INDEX Input UINT I, Q, M, D, L or 
constant

Parameter index: This input specifies which drive 
parameter index is to be written. This is a 16-bit value 
where the least significant byte is the actual index 
value with a range of (0 to 255). The most significant 
byte may also be used by the drive and is drive-
specific. See your drive manual for additional 
information.

USS_DB InOut USS_BASE D Reference to the instance DB that is created and 
initialized when a "USS_DRIVE" instruction is 
inserted in your program.

DONE Output BOOL I, Q, M, D, L If this parameter has the value TRUE, it indicates that 
the VALUE output holds the previously requested 
read parameter value. 
This bit is set when the "USS_DRIVE" instruction 
recognizes the read response from the drive. 
This bit is reset when either:
● you request the response data via another 

"USS_RPM" poll
 or 

● the second of the next two calls of "USS_DRIVE 
(Page 3131)" is executed

ERROR Output BOOL I, Q, M, D, L Error occurred - If this parameter has the value TRUE, 
this indicates that an error has occurred and the 
STATUS output is valid. All other outputs are set to 
zero on an error. Communication errors are only 
reported at the ERROR and STATUS outputs of the 
"USS_PORT (Page 3130)" instruction.

STATUS 
(Page 3136) 

Output WORD I, Q, M, D, L This is the status value of the request. It indicates the 
result of the read request. Additional information is 
available in the "USS_Extended_Error (Page 3136)" 
tag for some status codes.

VALUE Output VARIANT I, Q, M, D, L This is the value of the parameter that was read and 
is valid only when the DONE bit has the value TRUE.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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USS_WPM: Change parameters in the drive

Description
The "USS_WPM" instruction modifies a parameter in the drive. All USS functions that are 
assigned to one USS network and one PtP communications module must use the same 
instance data block. "USS_WPM" must be called from the main program OB.

 

 Note
EEPROM write operations

Beware of overusing the EEPROM write operation. Minimize the number of EEPROM write 
operations to extend the EEPROM life. 

 

Parameter
The following table shows the parameters of the "USS_WPM" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Send request: If this parameter has the value TRUE, it 

indicates that a new write request is desired. This is 
ignored if the request for this parameter is already 
pending. 

DRIVE Input USINT I, Q, M, D, L or 
constant

Drive address: This input is the address of the USS 
drive. The valid range is drive 1 to drive 16.

PARAM Input UINT I, Q, M, D, L or 
constant

Parameter number: This input specifies which drive 
parameter is written. The range of this parameter is 0 to 
2047. See your drive manual for details on how to 
access any parameters above this range. 

INDEX Input UINT I, Q, M, D, L or 
constant

Parameter index: This input specifies which drive 
parameter index is to be written. This is a 16-bit value 
where the least significant byte is the actual index value 
with a range of (0 to 255). The most significant byte may 
also be used by the drive and is drive-specific. See your 
drive manual for additional information.

EEPROM Input BOOL I, Q, M, D, L or 
constant

Store to drive EEPROM: If this parameter has the value 
TRUE, values written to the drive parameter will be 
stored in the drive EEPROM. If this parameter has the 
value FALSE, the value written is only temporarily saved 
and will be lost the next time the drive is switched on. 

VALUE Input VARIANT I, Q, M, D, L or 
constant

The value of the parameter that is to be written. It must 
be valid on the transition of REQ.

USS_DB InOut USS_BASE D This is a reference to the instance DB that is created 
and initialized when a "USS_DRIVE (Page 3131)" 
instruction is inserted in your program.
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L If this parameter has the value TRUE, the VALUE input 

was written to the drive. 
This bit is set when the "USS_DRIVE (Page 3131)" 
instruction recognizes the write response from the drive. 
This bit is reset when either:
You request the drive's confirmation that the write 
operation has been completed via another "USS_WPM" 
query or when the second of the next two calls of 
"USS_DRIVE (Page 3131)" is executed.

ERROR Output BOOL I, Q, M, D, L Error occurred: If this parameter has the value TRUE, 
this indicates that an error has occurred and the 
STATUS output is valid. All other outputs are set to zero 
on an error. Communication errors are only reported at 
the ERROR and STATUS outputs of the "USS_PORT 
(Page 3130)" instruction.

STATUS 
(Page 3136) 

Output WORD I, Q, M, D, L This is the status value of the request. It indicates the 
result of the write request. Additional information is 
available in the "USS_Extended_Error (Page 3136)" tag 
for some status codes.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter STATUS of USS instructions

STATUS parameter
The following table contains the status codes of the USS operation that are output at the 
STATUS output of the USS instructions:   

STATUS* 
(W#16#....)

Description

0000 No error
8180 The length of the drive response did not match the characters received from the drive. The drive number 

where the error occurred is returned in the "USS_Extended_Error" tag. See the extended error description 
below this table.

8181 The parameter VALUE is not of the data type WORD, REAL, or DWORD
8182 User supplied a parameter value of the type word and received a DWORD or REAL from the drive in the 

response
8183 User supplied a parameter value of the type DWORD or REAL and received a word from the drive in the 

response
8184 Response telegram from drive had a bad checksum. The drive number where the error occurred is returned 

in the "USS_Extended_Error" tag. See the extended error description below this table.
8185 Illegal drive address (valid drive address range: 1-16)
8186 Speed set point out of valid range (valid speed SP range: -200% to 200%)
8187 Wrong drive number responded to the request sent. The drive number where the error occurred is returned 

in the "USS_Extended_Error" tag. See the extended error description below this table.
8188 Illegal PZD word length specified (valid range = 2, 4, 6 or 8 words)
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STATUS* 
(W#16#....)

Description

8189 Illegal baud rate was specified 
818A Parameter request channel is in use by another request for this drive
818B Drive has not responded to requests and retries. The drive number where the error occurred is returned in 

the "USS_Extended_Error" tag. See the extended error description below this table.
818C Drive returned an extended error on a parameter request operation. See the extended error description 

below this table.
818D Drive returned an invalid access error on a parameter request operation. See your drive manual for 

information of why parameter access may be limited
818E Drive has not been initialized: This error code is output at "USS_RPM (Page 3133)" or "USS_WPM 

(Page 3135)" if the "USS_DRIVE (Page 3131)" instruction has not been called at least once for this drive. 
This prevents the initialization of the first cycle of "USS_DRIVE (Page 3131)" from overwriting a pending 
parameter read or write request since it initializes the drive as a new entry. To eliminate this error, call the 
"USS_DRIVE (Page 3131)" instruction for this drive.

80Ax-80Fx Specific errors returned from PtP (Point-to-Point) communication instructions called by the USS library: 
These error code values are not modified by the USS library and are defined in the PtP instruction 
descriptions.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

USS_Extended_Error - USS drive extended error codes
USS drives support read and write access to a drive’s internal parameters. This feature allows 
distributed control and configuration of the drive. Drive parameter access operations can fail 
due to errors such as values out of range or invalid requests in a drive’s current mode. The 
drive generates an error code that is output in the "USS_Extended_Error" variable in the 
instance DB of the "USS_DRIVE (Page 3131)" instruction. This error code value is only valid 
for the last execution of the "USS_RPM (Page 3133)" or "USS_WPM (Page 3135)" instruction. 
The drive error code is put into the "USS_Extended_Error" tag when the value of STATUS is 
hexadecimal 818C. The error code of "USS_Extended_Error" depends on the drive variant. 
See the drive's manual for a description of the extended error codes for read and write 
parameter operations.

MODBUS (RTU)

MB_COMM_LOAD: Configure port on the PtP module for Modbus RTU

Description    
The "MB_COMM_LOAD" instruction configures a port for communication using the Modbus 
RTU protocol. The following hardware can be used for this:

● Up to three point-to-point modules (PtP) CM 1241 RS485 or CM 1241 RS232

● A communications board CB 1241 RS485 in addition to this

After configuration of the port, you communicate over Modbus by executing the "MB_SLAVE" 
or "MB_MASTER" instruction.
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Call
"MB_COMM_LOAD" must be called once to configure the port for the Modbus RTU protocol. 
On completion of the configuration, the port can be used by the "MB_MASTER (Page 3141)" 
and "MB_SLAVE (Page 3148)" instructions.

"MB_COMM_LOAD" only needs to be called again if one of the communication parameters 
has to be modified. Each "MB_COMM_LOAD" call deletes the communications buffer. To avoid 
data loss during communication, you should not call the instruction unnecessarily.

One instance of "MB_COMM_LOAD" must be used to configure the port of each 
communication module that is used for Modbus communication. You assign a unique 
"MB_COMM_LOAD" instance data block for each port that you use. The S7-1200 CPU is 
limited to three communication modules.

An instance data block is assigned when you insert the "MB_MASTER (Page 3141)" or 
"MB_SLAVE (Page 3148)" instruction. This instance data block is referenced when you specify 
the MB_DB parameter on the "MB_COMM_LOAD" instruction.

Parameters
The following table shows the parameters of the instruction "MB_COMM_LOAD":

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Execution of the instruction upon a rising edge.
PORT Input PORT I, Q, M, D, L or 

constant
ID of the communications port:
After you have inserted the communications 
module in the device configuration, the port ID 
appears in the drop-down list at the PORT box 
connection. This constant can also be referenced 
within the "Constants" tab of the tag table.

BAUD Input UDINT I, Q, M, D, L or 
constant

Baud rate selection:
300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 
57600, 76800, 115200 
All other values are invalid.

PARITY Input UINT I, Q, M, D, L or 
constant

Parity selection:
● 0 – None
● 1 – Odd
● 2 – Even

FLOW_CTRL Input UINT I, Q, M, D, L or 
constant

Flow control selection:
● 0 – (default) No flow control
● 1 – Hardware flow control with RTS always ON 

(does not apply to RS485 ports)
● 2 - Hardware flow control with RTS switched
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Parameter Declaration Data type Memory area Description
RTS_ON_DLY Input UINT I, Q, M, D, L or 

constant
RTS on-delay selection:
● 0 – (default) No delay of RTS active until the first 

character of the message is transmitted.
● 1 to 65535 – Delay in milliseconds of "RTS 

active" until the first character of the message 
is transmitted (does not apply to RS-485 ports). 
RTS delays must be applied independent of the 
FLOW_CTRL selection.

RTS_OFF_DLY Input UINT I, Q, M, D, L or 
constant

RTS off-delay selection:
● 0 – (default) No delay after the last character 

transmitted until "RTS inactive"
● 1 to 65535 – Delay in milliseconds after the last 

character transmitted until "RTS inactive" (does 
not apply to RS-485 ports). RTS delays must be 
applied independent of the FLOW_CTRL 
selection.

RESP_TO Input UINT I, Q, M, D, L or 
constant

Response timeout:
Time in milliseconds allowed by "MB_MASTER 
(Page 3141)" for the slave to respond. If the slave 
does not respond in this time, "MB_MASTER 
(Page 3141)" repeats the request or terminates the 
request with an error if the specified number of 
retries has been sent. 
5 ms to 65535 ms (default = 1000 ms).

MB_DB Input MB_BASE D A reference to the instance data block of the 
"MB_MASTER (Page 3141)" or "MB_SLAVE 
(Page 3148)" instructions. After you insert 
"MB_SLAVE (Page 3148)" or "MB_MASTER 
(Page 3141)" in your program, the DB identifier 
appears in the drop-down list at the MB_DB box 
connection. 

DONE Output BOOL I, Q, M, D, L Execution of instruction completed without error.
ERROR Output BOOL I, Q, M, D, L Error:

● 0 – No error detected
● 1 – Indicates that an error was detected. An 

error code is output in the STATUS parameter.
STATUS Output WORD I, Q, M, D, L Port configuration error code

 

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameter STATUS

Error code*
 (W#16#...) 

Description

0000 No error
8180 Invalid value for the port ID (wrong address for the communications module).
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Error code*
 (W#16#...) 

Description

8181 Invalid baud rate value.
8182 Invalid parity value.
8183 Invalid flow control value.
8184 Invalid value for the timeout of the response (the time before which a timeout is reported must be at least 

25 ms).
8185 Incorrect pointer in the MB_DB parameter to the instance DB of the "MB_MASTER (Page 3141)" or 

"MB_SLAVE (Page 3148)" instruction.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

MB_COMM_LOAD data block tags
The table below shows the public static tags in the instance DB of MB_COMM_LOAD that you 
can use in your program.

Table 9-92 Static tags in the instance DB

Tag Data type Default Description
ICHAR_GAP WORD 0 Delay for the character spacing between characters. This parameter is 

specified in milliseconds and is used to increase the anticipated period 
between the received characters. The corresponding number of bit times for 
this parameter is added to the Modbus standard value of 35 bit times (3.5 
character times).

RETRIES WORD 2 The number of repeated attempts by the master before the error code 
0x80C8 is returned for "No response".

MODE USINT 0 Mode
Permitted modes are: 
● 0 = Full duplex (RS232) 
● 1 = Full duplex (RS422) four-wire mode (point-to-point) 
● 2 = Full duplex (RS422) four-wire mode (multipoint master) 
● 3 = Full duplex (RS422) four-wire mode (multipoint slave)
● 4 = Half duplex (RS485) two-wire mode 

LINE_PRE USINT 0 Receive line initial state
Permitted defaults are:
● 0 = "No" default 
● 1 = Signal R(A)=5V, signal R(B)=0 V (break detection): 

No break detection is possible with this default. 
Can only be selected with: "Full duplex (RS422) four-wire mode (point-to-
point connection)" and "Full duplex (RS422) four-wire mode (multipoint 
slave)".

● 2 = Signal R(A)=0 V, signal R(B)=5 V: 
This default corresponds to the at-rest state (no send process is active). 
No break detection is possible with this default.

CABLE-
BREAK

USINT 0 Activate cable break detection:
● 0 - not activated
● 1 - activated
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MB_MASTER: Communicate via the PtP port as Modbus master

Description of MB_MASTER

Description    
The "MB_MASTER" instruction allows your program to communicate as a Modbus master 
using a port on a point-to-point module (CM) or a communications board (CB). You can access 
data in one or more Modbus slave devices.

Before the "MB_MASTER" instruction can communicate with a port, "MB_COMM_LOAD 
(Page 3137)" must first execute.

An instance DB is created when you insert the "MB_MASTER" instruction in your program. 
You specify this instance DB in the MB_DB input parameter of the "MB_COMM_LOAD 
(Page 3137)" instruction.

Rules for Modbus master communication
● A port used for Modbus master requests cannot be used for "MB_SLAVE".

● A port can be used for one or more "MB_MASTER" calls if the same instance DB is used.

● The Modbus instructions do not use communication interrupt events to control the 
communication process. Your program must poll the "MB_MASTER" instruction for 
completed send and receive operations.

● Calling the instruction:

– Call the "MB_MASTER" instruction if possible in a cyclic program OB. The instruction 
can only be called in a time delay or cyclic interrupt OB.

– Do not call more than one "MB_MASTER" instruction in organization blocks with different 
priority classes. If a "MB_MASTER" instruction executes "preemptively" from a higher 
priority class, the instruction may execute incorrectly.

– Do not call the "MB_MASTER" instruction in a startup, diagnostics or time error OB.

● After a transfer has started, the EN parameter (LAD/FBD) must remain set to the value "1" 
until the DONE or ERROR output parameter is set to "1" by the instruction. A renewed call 
by the REQ parameter while the instruction is executing causes an error. After the 
instruction executes, the bit in the REQ parameter remains set for the time specified by the 
BLOCKED_PROC_TIMEOUT parameter in the instance DB.

● If "MB_MASTER" sends a request to a slave, make sure that "MB_MASTER" continues to 
execute until the response from the slave arrives.
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Parameters
The following table shows the parameters of the "MB_MASTER" instruction:

Parameters Declaration Data type Memory area Description
REQ 
(Page 3144) 

Input BOOL I, Q, M, D, L Request input:
● 0 – No request
● 1 – Request to transmit data to Modbus slave(s)

MB_ADDR Input UINT I, Q, M, D, L or 
constant

Modbus RTU station address: 
● Default address range: 0 to 247
● Extended address range: 0 to 65535
The value "0" is reserved for broadcasting a message 
to all Modbus slaves. Modbus function codes 05, 06, 15, 
and 16 are the only function codes supported for 
broadcast.

MODE 
(Page 3144) 

Input USINT I, Q, M, D, L or 
constant

Mode selection: Specifies the type of request: Read, 
write, or diagnostics: 
Refer to the Modbus functions table for details.

DATA_ADDR 
(Page 3144) 

Input UDINT I, Q, M, D, L or 
constant

Starting address in the slave: Specifies the starting 
address of the data to be accessed in the Modbus slave. 
You will find the valid addresses in the Modbus functions 
table.

DATA_LEN Input UINT I, Q, M, D, L or 
constant

Data length: Specifies the number of bits or words to be 
accessed in this request. You will find the valid lengths 
in the Modbus functions table.

DATA_PTR 
(Page 3145) 

Input VARIANT M, D Points to the DB or bit memory address of the CPU for 
the data to be written or read. For a DB, this must be 
created with the "Standard - compatible with 
S7-300/400" access type.

DONE Output BOOL I, Q, M, D, L ● 0: Transaction not completed
● 1: Transaction completed without error

BUSY Output BOOL I, Q, M, D, L ● 0: No "MB_MASTER" transaction in progress
● 1: "MB_MASTER" transaction in progress

ERROR Output BOOL I, Q, M, D, L ● 0: No error
● 1: Error, the error code is indicated by the STATUS 

parameter
STATUS Output WORD I, Q, M, D, L Execution condition code

 

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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STATUS parameter

Table 9-93 Communications and configuration error messages of the instruction

Error code*
(W#16#....) 

Description

0000 No error
80C8 Slave timeout. Check the baud rate, parity and the connectors on the slave.
80D1 The receiver issued a flow control request to suspend an active transmission and never re-enabled the 

transmission within the wait time.
This error is also generated during hardware flow control if the recipient does not detect CTS within the 
wait time.

80D2 The send request was aborted because no DSR signal is received from the DCE.
80E0 The message was terminated because the receive buffer is full.
80E1 The message was terminated as a result of a parity error.
80E2 The message was terminated as a result of a framing error.
80E3 The message was terminated as a result of an overrun error.
80E4 The message was terminated as a result of the specified length exceeding the total buffer size.
8180 Invalid value for the port ID.
8186 Invalid Modbus station address
8188 The MODE parameter has an invalid value for a broadcast call.
8189 Invalid data address value.
818A Invalid data length value.
818B Invalid pointer to the local data source/destination: Size not correct
818C The DATA_PTR parameter has an invalid pointer. Use a pointer to a bit memory area or a DB with the 

"Standard - compatible with S7-300/400" access type.
8200 Port is busy processing a send request
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

Table 9-94 Error messages of the Modbus protocol

Error code*
(W#16#....)

Response code of 
slave

Description

8380 - CRC error
8381 01 Function code not supported
8382 03 Data length error
8383 02 Error in the data address or address outside the valid range of DATA_PTR
8384 > 03 Data value error
8385 03 Data diagnostic code value not supported (function code 08)
8386 - Function code of the response does not match the function code of the query.
8387 - Response from wrong slave

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 3143



Error code*
(W#16#....)

Response code of 
slave

Description

8388 - The response of the slave to a write call is not correct. The data sent by the slave 
does not match the query from the master.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter REQ

Description
● REQ = FALSE: No request

● REQ = TRUE: Request to transmit data to Modbus slave(s)

You can control this input by means of a level-controlled or edge-controlled contact. 

A state machine is started every time this input is activated to ensure that another instruction 
"MB_MASTER" that uses the same instance DB can only issue a request when the current 
request has been processed. All other input states are recorded and saved internally for the 
current request until the reply has been received or an error has been detected.

If the same instance of "MB_MASTER" is executed again with REQ input = 1 before the current 
request is completely processed, no subsequent transfers are made. However, if the request 
has been processed, a new request is issued at the time when "MB_MASTER" is executed 
again with REQ input = 1.

DATA_ADDR and MODE parameters

Description
You specify the start address for data access to the Modbus slave using the DATA_ADDR 
parameter.

With the MODE parameter and the Modbus address, you specify the function code to be 
transferred to the Modbus slave. The following table shows the relationship between the MODE 
parameter, the function code and Modbus address range.

MODE Modbus 
function

Data length Operation and data Modbus address

0 01 1 to 2000
1 to 1992 (1)

Read output bits:
1 to (1992 or 2000) bits per query

1 to 9999

0 02 1 to 2000
1 to 1992 (1)

Read input bits:
1 to (1992 or 2000) bits per query

10001 to 19999

0 03 1 to 125
1 to 124 (1)

Read holding register:
1 to (124 or 125) WORD per query

40001 to 49999 or
400001 to 465535

0 04 1 to 125
1 to 124 (1)

Read input WORD:
1 to (124 or 125) WORD per query

30001 to 39999
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MODE Modbus 
function

Data length Operation and data Modbus address

1 05 1 Writing an output bit:
One bit per query

1 to 9999

1 06 1 Writing a holding register:
1 WORD per query

40001 to 49999 or
400001 to 465535

1 15 2 to 1968
2 to 1960 (1)

Writing multiple output bits:
2 to (1960 or 1968) bits per query

1 to 9999

1 16 2 to 123
2 to 122 (1)

Writing multiple holding registers:
2 to (122 or 123) WORD per query

40001 to 49999 or
400001 to 465535

2 15 1 to 1968
2 to 1960 (1)

Writing one or more output bits:
1 to (1960 or 1968) bits per query

1 to 9999

2 16 1 to 123
2 to 122 (1)

Writing one or more holding registers:
1 to (122 or 123) WORD per query

40001 to 49999 or
400001 to 465535

11 11 0 Reading out the communications status word of the 
slaves and the event counter:
The status word indicates execution of the 
instruction (0: is not executing; 0xFFFF: is 
executing). The event counter is incremented each 
time a message is transferred successfully.
The DATA_ADDR and DATA_LEN parameters of 
the "MB_MASTER" instruction are ignored with this 
function.

-

80 08 1 Checking the slave status by reading the error code 
(0x0000):
1 WORD per query

-

81 08 1 Resetting the event counter of the slave with the 
diagnostics code 0x000A:
1 WORD per query

-

3 to 10, 12 
to 79, 82 to 
2555

  Reserved -

(1) For the "Extended address range", the maximum data length is reduced by one byte or one WORD depending on which 
data type is used for the function.

 

Parameter DATA_PTR

Description
The DATA_PTR parameter is a pointer to a data block or bit memory from which the data 
should be written or read. If you use a data block, create a global data block with the "Standard 
- compatible with S7-300/400" access type.
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Data block structures for the DATA_PTR parameter
● These data types are valid for reading of words of Modbus addresses 30001 to 39999, 

40001 to 49999, and 400001 to 465536 and also for writing of words to Modbus addresses 
40001 to 49999 and 400001 to 465536.

– Standard array of WORD, UINT, or INT data types (see below).

– Named WORD, UINT, or INT structure where each element has a unique name and 16 
bit data type.

– Named complex structure where each element has a unique name and 16 bit or 32 bit 
data type.

● For reading and writing of bits of Modbus addresses 00001 to 09999 and 10001 to 19999.

– Standard array of Boolean data types.

– Named Boolean structure of uniquely named Boolean variables.

● Although not required, it is recommended that each "MB_MASTER" instruction has its own 
separate memory area in a global data block. The reason for this recommendation is that 
there is a greater possibility of data corruption if multiple "MB_MASTER" instructions are 
reading and writing the same area of a global data block.

● The memory areas for DATA_PTR do not need to be in the same global data block. You 
can create one data block with multiple areas for Modbus read operations, one data block 
for Modbus write operations, or one data block for each slave station.

Instance DB of the "MB_MASTER" instruction

Static variables of the instance DB
The following table describes the static variables of the instance DB of the instruction that you 
can use in the user program.

Variable Data type Description
MB_STATE UINT Internal status of the Modbus instruction
BLOCKED_ 
PROC_TIMEOUT

REAL Time between completion of the instruction call and resetting the 
ACTIVE bit in the instance DB. The time buffer is used to avoid 
execution of the instruction being terminated before a job has been 
sent completely. The default time is 500 ms.

EXTENDED_ 
ADDRESSING

BOOL Configuring addressing:
● 0: Default address area (1 byte)
● 1: Extended address area (2 bytes)
For additional information, refer to the section 
EXTENDED_ADDRESSING: Instance DB of the "MB_SLAVE" 
instruction (Page 3151)
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Sample program for a Modbus master

Networks (LAD)
Network 1: Initialize parameters of the RS-485 module only once during the first cycle.

Network 2: Read 100 words from the holding register of the slave.

Network 3: This is an optional network that displays the values of the first 3 words as soon as 
the read operation has executed.

Network 4: Write 64 bits to the process image output, starting at slave address Q2.0.
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MB_SLAVE: Communicate via the PtP port as Modbus slave

Description of MB_SLAVE

Description
The "MB_SLAVE" instruction allows your program to communicate as a Modbus slave using 
a port on a point-to-point module (PtP) or a communications board (CB). A Modbus RTU master 
can issue a request and then your program responds via "MB_SLAVE" execution.

You must assign a unique instance data block when you insert the "MB_SLAVE" instruction 
in your program. This instance data block is used when you specify it at the MB_DB parameter 
of the "MB_COMM_LOAD (Page 3137)" instruction.

Modbus communication function codes (1, 2, 4, 5, and 15) can read and write bits and words 
directly in the process image input and process image output in the target system. The following 
table shows the mapping of Modbus addresses to the process image in the CPU.

Modbus functions of "MB_SLAVE" S7-1200
Codes Function Data area Address range Data area CPU address
01 Read bits Output 1 to 8192 Process image output Q0.0 to Q1023.7
02 Read bits Input 10001 to 18192 Process image input I0.0 to I1023.7
04 Read words Input 30001 to 30512 Process image input IW0 to IW1022
05 Write bit Output 1 to 8192 Process image output Q0.0 to Q1023.7
15 Write bits Output 1 to 8192 Process image output Q0.0 to Q1023.7

 

Modbus communication function codes (function codes 3, 6, 16) use a separate holding 
register. To do this, you can use bit memory or a data block with the "Standard - compatible 
with S7-300/400" access type.

You specify the type of the holding register using the MB_HOLD_REG parameter of the 
MB_SLAVE instruction. The following table shows the mapping of the Modbus holding register 
to the DB address of MB_HOLD_REG in the target system.
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Modbus functions of "MB_SLAVE" S7-1200
Codes Function Data area Address range

(WORD number)
Address in the DB
(BYTE number)

Bit memory address
(BYTE number)

03 Read words Holding 
register

40001 to 49999 or DW0 to DW19998 or MW0 to CPU limit
400001 to 465535 DW0 to DW131068

06 Write word Holding 
register

40001 to 49999 or DW0 to DW19998 or
400001 to 465535 DW0 to DW131068

16 Write words Holding 
register

40001 to 49999 or DW0 to DW19998 or
400001 to 465535 DW0 to DW131068

The table below shows the supported Modbus diagnostic functions.

S7-1200 "MB_SLAVE" Modbus diagnostic functions 
Codes Subfunction Description
08 0000H Return query data echo test: The "MB_SLAVE" instruction returns the echo of a received data 

word to a Modbus master. 
08 000AH Clear communication event counter: The "MB_SLAVE" instruction clears the communication 

event counter that is used for Modbus function 11.
11 - Get communication event counter: The "MB_SLAVE" instruction uses an internal communication 

event counter for recording the number of successful Modbus read and write requests that are 
sent to the Modbus slave. The counter is not incremented on any Function 8, Function 11, or 
broadcast requests. It is also not incremented on any requests that result in a communication 
error (for example, parity or CRC errors).

The "MB_SLAVE" instruction supports broadcast write requests from Modbus masters as long 
as the requests include access to valid addresses. 

Regardless of the validity of a request, "MB_SLAVE" gives no response to a Modbus master 
as the result of a broadcast request.

Rules of Modbus slave communication
● "MB_COMM_LOAD" must be executed to configure a port, before the "MB_SLAVE" 

instruction can communicate with this port.

● If a port is to respond as a slave to a Modbus master, then that port cannot be used by 
"MB_MASTER (Page 3141)". Only one instance of "MB_SLAVE" can be used with a given 
port.

● The Modbus instructions do not use communication interrupt events to control the 
communication process. Your program must control the communication process by polling 
the "MB_SLAVE" instruction for completed send and receive operations.

● The "MB_SLAVE" instruction must be executed periodically at a rate that allows it to make 
a timely response to incoming requests from a Modbus master. It is therefore advisable to 
call the instruction in a cyclic program OB. Calling the "MB_SLAVE" instruction in an 
interrupt OB is possible but not advisable since it can lead to long delays in execution.
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Frequency of execution of "MB_SLAVE"
The "MB_SLAVE" instruction must be executed periodically to receive each request from the 
Modbus master and to respond as required. The frequency of execution of "MB_SLAVE" is 
dependent upon the specified response timeout period of the Modbus master. This is illustrated 
in the following diagram.

 

The response timeout period is the amount of time a Modbus master waits for the start of a 
response from a Modbus slave. This time period is not defined by the Modbus protocol, but 
rather by a parameter of each Modbus master. The frequency of execution (time between one 
execution and the next execution) of "MB_SLAVE" must be based on the particular parameters 
of your Modbus master. As a minimum, you should execute "MB_SLAVE" twice within the 
response timeout period of the Modbus master.

Parameters
The following table shows the parameters of the "MB_SLAVE" instruction:

Parameter Declaration Data type Memory area Description
MB_ADDR Input USINT I, Q, M, D, L or 

constant
Station address of the Modbus slave (address 
range: 0 to 255)

MB_HOLD_REG Input VARIANT D Pointer to the Modbus holding register DB. The DB 
must be created with the "Standard - compatible 
with S7-300/400" access type.

NDR Output BOOL I, Q, M, D, L New data ready: 
● 0: No new data
● 1: Indicates that new data has been written by 

the Modbus master
DR Output BOOL I, Q, M, D, L Read data: 

● 0: No data read
● 1: Indicates that data has been read by the 

Modbus master
ERROR Output BOOL I, Q, M, D, L ● 0: No error detected

● 1: Error, a corresponding error code is output in 
the STATUS

STATUS Output WORD I, Q, M, D, L Error code

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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STATUS parameter

STATUS* 
(W#16#....)

Description

80C8 The specified response timeout (refer to RCVTIME or MSGTIME) is "0".
80D1 The receiver issued a flow control request to suspend an active transmission and never re-enabled the 

transmission within the wait time.
This error is also generated during hardware flow control if the recipient does not detect CTS within the 
wait time.

80D2 The send request was aborted because no DSR signal is received from the DCE.
80E0 The message was terminated because the receive buffer is full
80E1 The message was terminated as a result of a parity error
80E2 The message was terminated as a result of a message frame error
80E3 The message was terminated as a result of a overrun error
80E4 The message was terminated as a result of the specified length exceeding the total buffer size
8180 Invalid value for the port ID.
8186 Invalid Modbus station address
8187 Invalid pointer to MB_HOLD_REG-DB
818C Pointer to a type safe DB type MB_HOLD_REG (must be a Classic DB type)
 
Response code sent to Modbus master (B#16#...)
8380 No response CRC error
8381 01 Function code not supported or not supported in a broadcast
8382 03 Data length error 
8383 02 Error in the data address or address outside the valid range of MB_HOLD_REG
8384 03 Data value error
8385 03 Data diagnostic code value not supported (function code 08)
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Instance DB of the "MB_SLAVE" instruction

Static variables of the instance DB
The following table describes the static variables of the instance DB of the instruction that you 
can use in the user program. Your program can write values to the HR_Start_Offset and 
Extended_Addressing variables and control the Modbus slave operations.

The other variables can be read to monitor the Modbus status.

Variable Data type Description
HR_Start_Offset WORD Start address of the Modbus holding register (default = " 0")
Extended_ 
Addressing

BOOL Configuring addressing:
● 0: Default address area (1 byte)
● 1: Extended address area (2 bytes)
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Variable Data type Description
Request_Count WORD Total number of queries received by the slave
Slave_Message_
Count

WORD Number of queries sent to this specific slave

Bad_CRC_Count WORD Number of received queries with CRC errors
Broadcast_Count WORD Number of received broadcast queries
Exception_Count WORD Number of Modbus-specific errors that require the return of an 

exception
Success_Count WORD The number of requests received for this specific slave without 

protocol errors

HR_Start_Offset
The addresses of the Modbus holding register start at 40001 or 400001. These addresses 
correspond to the start address of the holding register in the target system memory. Using the 
HR_Start_Offset variable, you can set the offset to a different start address.

Example: A holding register starts at MW 100 and has a length of 100 WORD. With an offset 
of 20 in the HR_Start_Offset parameter, the holding register begins at address 40021 instead 
of 40001. Each address below 40021 and above 400119 causes an addressing error.

 HR_Start_Offset = 0  HR_Start_Offset = 20
 Modbus word 

address
S7-1200 byte 

address
 Modbus word 

address
S7-1200 byte 

address
Minimum 40001 MW100  40021 MW100
Maximum 40099 MW198  40119 MW198

 

Extended_Addressing
To address the Modbus slave, a single byte (default address range) or a double byte (extended 
address range) can be configured. Extended addressing is used to address more than 247 
devices in a single network. If you decide on extended addressing, you can address a 
maximum of 64,000 addresses. Below, you will see a frame of Modbus function 1 as an 
example.

Table 9-95 Slave address with one byte (byte 0)

Function 1 Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5  
Request Slave 

address
F code Start address Length of the coils  

Valid response Slave 
address

F code Length Coil data  

Error response Slave 
address

0x81 E code     
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Table 9-96 Slave address with two bytes (byte 0 and byte 1)

Function 1 Byte 0 Byte 1 Byte 2 Byte 3 Byte 4 Byte 5 Byte 6
Request Slave address F code Start address Length of the coils
Valid response Slave address F code Length Coil data
Error response Slave address 0x81 F code    

Sample program for a Modbus slave

Networks (LAD)
Network 1: Initialize parameters of the RS-485 module only once during the first cycle.

Network 2: Check the requests of the Modbus master in every cycle. 100 words starting at 
MW1000 are configured for the Modbus holding register.
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MODBUS (TCP)

MODBUS (TCP) (S7-1200)

MB_CLIENT: Communicating via PROFINET as a Modbus TCP client

Description of MB_CLIENT

Description
The "MB_CLIENT" instruction communicates as a Modbus TCP client via the PROFINET 
connection of the S7-1200 CPU. To use the instruction, you do not require any additional 
hardware module. With the "MB_CLIENT" instruction, you establish a connection between the 
client and the server, send requests and receive responses and control connection termination 
of the Modbus TCP server.

Parameters
The following table shows the parameters of the "MB_CLIENT" instruction:

Parameter Declaration Data type Description
REQ (Page 3156) Input BOOL Communication request with the Modbus TCP server

The REQ parameter is level-controlled. This means that as long as 
the input is set (REQ=true), the instruction sends communication 
requests.
● The instance DB for other clients is blocked with the 

communications request. 
● Changes to the input parameters will not become effective until 

the server has responded or an error message has been output. 
● If the parameter REQ is set again during an ongoing Modbus 

request, no additional transmission takes place afterwards.
DISCONNECT 
(Page 3156) 

Input BOOL With this parameter, you control the establishment and termination 
of the connection to the Modbus server:
● 0: Establish a communications connection to the specified IP 

address and port number.
● 1: Disconnect the communication connection. No other function 

is executed during connection termination. The value 7003 is 
output at the STATUS parameter after successful connection 
termination.

The request is sent immediately if the REQ parameter is set during 
connection establishment.

CONNECT_ID Input UINT Unique ID to identify the connection. Each instance of the 
instructions "MB_CLIENT" and "MB_SERVER (Page 3161)" must 
be assigned a unique connection ID.

IP_OCTET_1 Input USINT 1. Octet of the IP address* of the Modbus TCP server.
IP_OCTET_2 Input USINT 2. Octet of the IP address* of the Modbus TCP server.
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Parameter Declaration Data type Description
IP_OCTET_3 Input USINT 3. Octet of the IP address* of the Modbus TCP server.
IP_OCTET_4 Input USINT 4. Octet of the IP address* of the Modbus TCP server.
IP_PORT Input UINT IP port number of the server to which the client establishes the 

connection and communicates using the TCP/IP protocol (default 
value: 502).

MB_MODE 
(Page 3157) 

Input USINT Selects the mode of the request (read, write or diagnostics).

MB_DATA_ADDR 
(Page 3157) 

Input UDINT Start address of the data accessed by the "MB_CLIENT" instruction.

DATA_LEN Input UINT Data length: Number of bits or words for the data access (see 
"MB_MODE and MB_DATA_ADDR parameters" - data length). 

MB_DATA_PTR 
(Page 3158)

InOut VARIANT Pointer to the Modbus data register: The register is a buffer for the 
data received from the Modbus server or to be sent to the Modbus 
server. The pointer must reference a global data block with standard 
access.
The number of bits addressed must be divisible by 8.

DONE Out BOOL The bit at output parameter DONE is set to "1" as soon as the last 
job is completed without errors. 

BUSY Out BOOL ● 0: No "MB_CLIENT " job in progress
● 1: "MB_ CLIENT " job in progress

ERROR Out BOOL ● 0: No error
● 1: Error occurred. The cause of error is indicated by the STATUS 

parameter.
STATUS 
(Page 3159) 

Out WORD Error code of the instruction.

* 8-bit long component of the 32-bit IPv4 IP address of the Modbus TCP server.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

 

 Note
Consistent input data during an "MB_CLIENT" call

When a Modbus client calls a Modbus instruction, the status of the input parameters is stored 
internally and then compared at the next call. The comparison is used to determine whether 
this particular call initialized the current request. Several "MB_CLIENT" calls can be executed 
if you use a common instance DB. The values of the input parameters must not be changed 
while an "MB_CLIENT" instance is being executed. If the input parameters are changed 
during execution, "MB_CLIENT" cannot be used to check whether or not the instance is 
currently being executed.

 

Multiple client connections
A Modbus TCP client can support several TCP connections and the maximum number of 
connections depends on the CPU being used. The total number of connections of one CPU, 
including those of the Modbus TCP clients and server must not exceed the maximum number 
of supported connections. Modbus TCP connections can also be shared by client and/or server 
connections.
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With individual client connections, remember the following rules:

● Each "MB_CLIENT" connection must use a unique instance DB.

● For each "MB_CLIENT" connection, a unique server IP address must be specified.

● Each "MB_CLIENT" connection requires a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● Unique numbers for the IP port may or may not be required depending on the server 
configuration.

Static tags of the instruction
The following table describes the editable static tags of the instance data block of the 
"MB_CLIENT" instruction.

Tag Data type Start value Description
Blocked_Proc_Timeo
ut

REAL 3.0 Wait time in seconds before the static tag ACTIVE is reset if there 
is a blocked Modbus instance. This can, for example, occur if a client 
request is output and the execution of the client function aborts 
before the request was fully executed. The maximum wait time is 55 
seconds.

MB_Transaction_ID WORD 1 Transaction ID of the Modbus TCP protocol. The start value of "1" 
should only be changed if the Modbus TCP server requires a 
different value.

MB_Unit_ID BYTE 255 Unit ID of the Modbus protocol. The tag corresponds to the slave 
address of the Modbus RTU protocol. Change this value only if the 
Modbus TCP server can be used as a gateway and is controlled by 
the application program within the Modbus server.

RCV_TIMEOUT REAL 2.0 Time interval in seconds in which the "MB_CLIENT" instruction waits 
for a response from the server.

Connected BOOL 0 Indicates whether the connection to the assigned client has been 
established or not: 1 = connected, 0 = not connected.

See also
MB_CLIENT example 1: Send several requests via a TCP connection (Page 3167)

MB_CLIENT example 2: Send multiple requests via several TCP connections (Page 3168)

MB_CLIENT example 3: Coordinate several requests (Page 3169)

REQ and DISCONNECT parameters

Description
If no instance of the "MB_CLIENT" instruction is executing and if the value of the DISCONNECT 
parameter is "0", a new job executes if REQ=1. If there is not yet a connection, this is 
established during execution.
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If the same instance of the "MB_CLIENT" instruction executes again (DISCONNECT = 0 and 
REQ = 1), before the active job was executed, this is not executed on completion of the active 
job. A new job can only be started on completion of the active job (REQ = 1).

You can monitor the status of execution with the DONE parameter. You can use this to monitor 
the status of execution if the "MB_CLIENT" instruction is executed sequentially.

See also
Description of MB_CLIENT (Page 3154)

MB_MODE and MB_DATA_ADDR parameters

Description
Instead of a function code, the "MB_CLIENT" instruction uses the MB_MODE parameter.  The 
MB_DATA_ADDR parameter is used to specify the Modbus start address of the data you want 
to access. The combination of the parameters MB_MODE and MB_DATA_ADDRdefines the 
function code used in the current Modbus message. 

The following table shows the relationship between the MB_MODE parameter, the Modbus 
function and the address space.

MB_MODE Modbus 
function

Data length Function and data type MB_DATA_ADDR

0 01 1 to 2000 Read output bits: 
1 to 2000 bits per call

1 to 9999

0 02 1 to 2000 Read input bits: 
1 to 2000 bits per call

10001 to 19999

0 03 1 to 125 Read holding register: 
1 to 125 WORD per call

40001 to 49999

0 04 1 to 125 Read input words: 
1 to 125 WORD per call

30001 to 39999

1 05 1 Write an output bit:
One bit per call

1 to 9999

1 06 1 Write a holding register: 
1 WORD per call

40001 to 49999 

1 15 2 to 1968 Write multiple output bits: 
2 to 1968 bits per call

1 to 9999

1 16 2 to 123 Write several holding registers:
2 to 123 WORD per call

40001 to 49999 

2 15 1 to 1968 Write one or more output bits:
1 to 1968 bits per call

1 to 9999

2 16 1 to 123 Write one or more holding registers: 
1 to 123 WORD per call

40001 to 49999 
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MB_MODE Modbus 
function

Data length Function and data type MB_DATA_ADDR

11 11 0 Read status word and event counter of server 
communication:
● The status word reflects the the processing status (0 

- not processing, 0xFFFF - processing).
● The event counter is incremented each time a 

message is sent successfully.
The MB_DATA_ADDR and MB_DATA_LEN parameters 
of the "MB_CLIENT" instruction are not evaluated when 
this function executes.

-

80 08 1 Check the server status with the error code 0x0000 
(return loop test - the server sends the request back):
1 WORD per call

-

81 08 1 Reset the event counter of the server with the error code 
0x000A:
1 WORD per call

 

3 to 10,
12 to 79,
82 to 255

  Reserved  

See also
Description of MB_CLIENT (Page 3154)

MB_DATA_PTR parameter

Description
The MB_DATA_PTR parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. As the data buffer, you can use a global data block or a memory 
area (M).

For a buffer in the memory area (M), use a pointer in the ANY format as follows: "P#bit address" 
"data type" "length" (example: P#M1000.0 WORD 500).

The MB_DATA_PTR parameter uses a communications buffer:

● For the communication functions of the "MB_CLIENT" instruction:

– Reading and writing of 1 bit of data of the Modbus server addresses 00001 to 09999 
and 10001 to 19999.

– Reading of 16-bit WORD data of the Modbus server addresses 30001 to 39999 and 
40001 to 49999.

– Writing 16-bit WORD data of the Modbus server addresses 40001 to 49999.

● During data transmission (length: bit or WORD) from or to the global DB or the memory 
area (M) that you assigned with the MB_DATA_PTR parameter.
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If you use a data block for the buffer in the MB_DATA_PTR parameter, you will need to assign 
data types to the DB elements.

● Use the 1-bit data type BOOL for a Modbus bit address

● Use a 16-bit data type such as WORD, UINT, INT or REAL for a Modbus WORD address.

● Use a 32-bit data type (double word) such as DWORD, DINT or REAL for two Modbus 
WORD addresses.

● With MB_DATA_PTR, you can also access complex DB elements such as:

– Standard arrays

– Structures with unique element names

– Complex structures with unique naming of the elements and data type lengths of 16 or 
32 bits.

● The data areas for the MB_DATA_PTR parameter can also be in different global data blocks 
(or in different memory areas). You can, for example, use a data block for the the read jobs 
and another one for the write jobs or a separate data block for each "MB_CLIENT" station.

See also
Description of MB_CLIENT (Page 3154)

Parameter STATUS 

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active (REQ=0).
7001 First call with REQ=1: Processing started; BUSY has the value 1.
7002 Intermediate call (REQ 

irrelevant). Processing already active; BUSY has the value 1.
7003 Connection is being terminated.
7004 Connection established and monitored. No job processing active.
7005 Data was sent.
7006 Data was received.
80BB Invalid value at ACTIVE_EST parameter (identifier for the type of connection establishment, see 

T_CON_PARAM): 
● Only passive connection establishment permitted for server (ACTIVE_EST = FALSE).
● Only active connection establishment permitted for client (ACTIVE_EST = TRUE).
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STATUS* 
(W#16#)

Description

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (protocol error)

STATUS* 
(W#16#)

Code of the response to the 
Modbus client (B#16#)

Description

8381 01 Function code is not supported.
8382 03 Error in data length.
8383 02 Error in the data address or access outside the address area of 

MB_DATA_PTR (Page 3158).
8384 03 Error in data value.
8385 03 Error codes of diagnostics not supported (function code 08).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)
In addition to the errors listed in the following table, errors are also possible with the 
"MB_CLIENT" instruction caused by the communications instructions ("TCON", "TDISCON", 
"TSEND" and "TRCV").

STATUS* 
(W#16#)

Description

80C8 No response of the server in the defined period. Check the connection to the Modbus server. This error is only 
reported on completion of the configured repeated attempts. 
If the "MB_CLIENT" instruction does not receive an answer with the originally transferred transaction ID 
(MB_TRANSACTION_ID tag) within the defined period, this error code is output.

8188 The MB_MODE parameter has an invalid value.
8189 Invalid addressing of data at the MB_DATA_ADDR parameter.
818A Invalid data length at the MB_DATA_LEN parameter.
818B The MB_DATA_PTR parameter has an invalid pointer. You should also check the values of the 

MB_DATA_ADDR (Page 3157) and MB_DATA_LEN parameters.
818C ● The MB_DATA_PTR (Page 3158) pointer references an an optimized data block. Either use a data block 

with standard access or a memory area
● Timeout at parameter BLOCKED_PROC_TIMEOUT (see static tags of instruction). The limit of 55 seconds 

has been exceeded.
818D The transaction ID (MB_TRANSACTION_ID tag) does not correspond to the one sent originally (see static 

tags of instruction).
8200 ● A further Modbus request is currently being processed via the port.

● Another instance of MB_CLIENT with the same connection parameters is processing an existing Modbus 
request.

8380 Received block of transferred Modbus data is not well-formed or too few bytes were received.
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STATUS* 
(W#16#)

Description

8386 Received function code does not match the one sent originally.
8387 ● The assigned connection ID is different from that used for previous requests. Only one connection ID can 

be used for each instance DB of the "MB_CLIENT" instruction.
● The error code is also output when the ID of the Modbus TCP protocol received by the server is not "0".

8388 The Modbus server sent a different data length than was requested. This error occurs only when using the 
Modbus functions 15 or 16.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions.

With the "MB_CLIENT" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND" and "TRCV") used by the 
instruction can occur.

The error codes are assigned via the instance data block of the "MB_CLIENT" instruction. 
The error codes are displayed for the respective instruction under STATUS in the Static 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.

 

See also
Description of MB_CLIENT (Page 3154)

MB_HOLD_REG parameter (Page 3165)

MB_SERVER: Communicating via PROFINET as a Modbus TCP server

Description of MB_SERVER

Description
The "MB_SERVER" instruction communicates as a Modbus TCP server via the PROFINET 
connection of the S7-1200 CPU. To use the instruction, you do not require any additional 
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hardware module. The "MB_SERVER" instruction processes connection requests of a Modbus 
TCP client, receives requests from Modbus functions and sends responses.

 

 NOTICE

Safety instruction

Note that each client on the network has access to the data of the Modbus instructions.

Although the data block for the Modbus holding register cannot be addressed directly by the 
client, it is possible to indirectly access the data via the offset addresses. The option is 
available to restrict access to an IP address to prevent unauthorized read and write 
operations. Note, however, that the shared address can also be used for unauthorized access.

 

Parameters
The following table shows the parameters of the "MB_SERVER" instruction:

Parameter Declaration Data type Description
DISCONNECT Input BOOL The instruction "MB_SERVER" enters into a passive connection with a 

partner module, which means the server responds to a TCP connection 
request from each requesting IP address. You can use this parameter to 
control when a connection request is accepted:
● 0: A passive connection is established when there is no 

communications connection.
● 1: Initialization of the connection termination.  If the input is set, no 

other operations are executed. The value 7003 is output at the 
STATUS parameter after successful connection termination.

CONNECT_ID Input UINT The parameter uniquely identifies a connection within the CPU. Each 
individual instance of the instructions "MB_CLIENT (Page 3154)" and 
"MB_SERVER" must have a unique CONNECT_ID parameter.

IP_PORT Input UINT Start value = 502. The number of IP ports defines which IP port is 
monitored for connection requests of the Modbus client. 
The following TCP port numbers must not be used for the passive 
connection of the "MB_SERVER" instruction: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964. 

MB_HOLD_REG 
(Page 3165) 

InOut VARIANT Pointer to the Modbus holding register of the "MB_SERVER" instruction: 
Use a global data block with standard access as holding register. The 
holding register contains the values that may be accessed by a Modbus 
client using the Modbus functions 3 (read), 6 (write) and 16 (read).

NDR Output BOOL "New Data Ready":
● 0: No new data
● 1: New data written by the Modbus client written

DR Output BOOL "Data Read":
● 0: No data read
● 1: Data read by the Modbus client
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Parameter Declaration Data type Description
ERROR Output BOOL If an error occurs during the call of the "MB_SERVER" instruction, the 

output of the ERROR parameter is set to TRUE. Detailed information 
about the cause of the problem is indicated by the STATUS parameter. 

STATUS 
(Page 3166) 

Output WORD Error code of the instruction.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Mapping of Modbus addresses to the process image
The "MB_SERVER" instruction allows incoming Modbus functions (1, 2, 4, 5 and 15) direct 
read and write access to the process image input and output of the S7-1200 CPU (use of the 
data types BOOL and WORD). 

For the data transfer of the function codes 3, 6 and 16, the holding register (MB_HOLD_REG 
parameter) must be defined longer than one byte. The following table shows the mapping of 
the Modbus addresses to the process image of the CPU.

Modbus function S7-1200
Code Function Data area Address space Data area CPU address
01 Read: Bits Output 1 to 8192 Process image output Q0.0 to Q1023.7
02 Read: Bits Input 10001 to 18192 Process image input I0.0 to I1023.7
04 Read: WORD Input 30001 to 30512 Process image input IW0 to IW1022
05 Write: Bits Output 1 to 8192 Process image output Q0.0 to Q1023.7
15 Write: Bits Output 1 to 8192 Process image output Q0.0 to Q1023.7

Incoming Modbus messages with the function codes 3, 6 and 16 write to or read from the 
Modbus holding registers (you specify the holding registers with the MB_HOLD_REG 
parameter).

Multiple server connections
You can create multiple Server connections. This allows a single CPU to establish connections 
to more than one Modbus TCP client at the same time.

A Modbus TCP server can support several TCP connections and the maximum number of 
connections depends on the CPU being used.

The total number of connections of one CPU, including those of the Modbus TCP clients and 
server must not exceed the maximum number of supported connections. 

Modbus TCP connections can also be shared by client and/or server connections.

In the case of Server connections, remember the following rules:

● Each "MB_SERVER" connection must use a unique instance DB.

● Each "MB_SERVER" connection must be created with a unique IP port number. Only one 
connection is supported for each port.
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● Each "MB_SERVER" connection must use a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● For each connection, the "MB_SERVER" instruction must be called individually.

Modbus diagnostics functions
The table below contains a description of the Modbus diagnostics functions.

Code Subfunction Description
08 0x0000 Echo test: The "MB_SERVER" instruction receives a data word and returns this unchanged to 

the Modbus master.
08 0x000A Reset event counter: The "MB_SERVER" instruction resets the event counter for communication 

that is used for Modbus function 11.
11 - Fetch event counter of the communication: The "MB_SERVER" instruction uses an internal event 

counter for communication to record the number of successfully executed read and write 
requests sent to the Modbus server.
The event counter is not incremented by the functions 8, 11 or broadcast requests. The same 
applies to requests that result in a communications error (for example parity errors or CRC 
errors). The broadcast function is not available for Modbus TCP because only one client/server 
connection can exist at any one time.

Static tags of the instruction
The following table describes the static tags of the instance data block of the "MB_SERVER" 
instruction used in the program. You can write the HR_Start_Offset tag. You can read the other 
tags to monitor the Modbus status.

Tag Data type Start value Description
HR_Start_Offset WORD 0 Assign the start address of the Modbus holding register.
Request_Count WORD 0 Total number of requests received by the server.
Server_Message_Co
unt

WORD 0 Total number of received messages for the relevant Server.

Xmt_Rcv_Count WORD 0 Counter for detecting the number of transfers during which an error 
occurred. The counter is also incremented if an invalid Modbus message 
is received.

Exception_Count WORD 0 Counter for detecting the number of errors specifically for Modbus cause 
an exception.

Success_Count WORD 0 Counter for detecting the number of requests that contain no error in the 
transferred protocol.

Connected BOOL 0 Indicates whether the connection to the assigned client has been 
established or not: 1 = connected, 0 = not connected.
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Example: Addressing via static tag HR_Start_Offset
The addresses of the Modbus holding register start at 40001. These addresses correspond to 
the address space of the CPU memory area for the holding register. You can also define the 
HR_Start_Offset tag so that the Modbus holding register has a start address other than 40001.

Example: The holding register begins at MW100, and has a length of 100 WORD. An offset 
value in the HR_Start_Offset parameter means that the start address of the holding register is 
moved from 40001 to 40021. Whenever the holding register is addressed below the address 
40021 and above the address 40119, this causes an error.

HR_Start_Offset Address Minimum Maximum
0 Modbus address (WORD) 40001 40099

S7-1200 address MW100 MW298
20 Modbus address (WORD) 40021 40119

S7-1200 address MW100 MW298

See also
MB_SERVER example: Multiple TCP connections (Page 3170)

MB_HOLD_REG parameter

Description
The MB_HOLD_REG parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. As the data buffer, you can use a global data block or a memory 
area (M).

As pointer to a buffer in the memory area (M), use the ANY format as follows: "P#bit address" 
"data type" "length" (example: P#M1000.0 WORD 500).

The following table shows examples of mapping Modbus addresses to the holding register for 
the Modbus functions 3 (read WORD), 6 (write WORD) and 16 (write several WORD). The 
upper limit for the number of addresses in the data block is decided by the maximum work 
memory of the CPU. If you use a memory area, the upper limit for the addresses is decided 
by the size of the memory area of the CPU.

Modbus 
addresses

MB_HOLD_REG parameter - examples

P#M100.0 
WORD 5

P#DB10.DBx0.0 WORD 5 "Recipe".ingredient

40001 MW100 DB10.DBW0 "Recipe".ingredient[1]
40002 MW102 DB10.DBW2 "Recipe".ingredient[2]
40003 MW104 DB10.DBW4 "Recipe".ingredient[3]
40004 MW106 DB10.DBW6 "Recipe".ingredient[4]
40005 MW108 DB10.DBW8 "Recipe".ingredient[5]
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See also
Description of MB_SERVER (Page 3161)

Parameter STATUS

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active (REQ=0).
7001 First call with REQ=1: Processing started; BUSY has the value 1.
7002 Intermediate call (REQ 

irrelevant). Processing already active; BUSY has the value 1.
7003 Connection is being terminated.
7004 Connection established and monitored. No job processing active.
7005 Data was sent.
7006 Data was received.
80BB Invalid value at ACTIVE_EST parameter (identifier for the type of connection establishment, see 

T_CON_PARAM): 
● Only passive connection establishment permitted for server (ACTIVE_EST = FALSE).
● Only active connection establishment permitted for client (ACTIVE_EST = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)

STATUS* 
(W#16#)

Code of the response to 
the Modbus server 
(B#16#)

Description

8187 No response The MB_HOLD_REG parameter has an invalid pointer. Data area is too small.
818C No response ● The MB_HOLD_REG parameter references an an optimized data block. 

Either use a data block with standard access or a memory area
● Error due to timeout of execution (more than 55 seconds).

8381 01 Function code is not supported.
8382 03 Error in data length
8383 02 Error in data address or access outside the address area of the holding register 

(MB_HOLD_REG (Page 3165) parameter).
8384 03 Error in data value
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STATUS* 
(W#16#)

Code of the response to 
the Modbus server 
(B#16#)

Description

8385 03 Value of the diagnostic code is not supported (only with function code 08).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions.

With the "MB_SERVER" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND" and "TRCV") used by the 
instruction can occur.

The error codes are assigned via the instance data block of the "MB_SERVER" instruction. 
The error codes are displayed for the respective instruction under STATUS in the Static 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.

 

See also
Description of MB_SERVER (Page 3161)

Examples

MB_CLIENT example 1: Send several requests via a TCP connection

Description
Several requests of the Modbus Client can be sent via a TCP connection. To do this, use the 
same instance DB, the same connection ID and the same port number.

Only one client can be active at any one time. After processing of a client has been completed, 
the next client is processed. The order of execution must be defined in the program.

In the following sample program, the value of the STATUS output parameter is also copied.
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Network 1: Modbus function 1 - 16 read output bits

Network 2: Modbus function 2 - 32 read input bits

MB_CLIENT example 2: Send multiple requests via several TCP connections

Description
Requests from the Modbus client can be sent via different TCP connections. If you require 
this, use a different instance DB and a different connection ID.

Use a different port number, if the connections are to the same Modbus server. If the 
connections are to different Modbus servers, you can freely assign the port number.
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Network 1: Modbus function 4 - read input (WORD)

Network 2: Modbus function 3 - read holding register (WORD)

MB_CLIENT example 3: Coordinate several requests

Description
Make sure that the individual Modbus requests are executed. You control coordination of 
requests with the program. The following example demonstrates how the output parameters 
of the first and second client request can be used to coordinate execution of the instructions.
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Network 1: Modbus function 3 - read holding register (WORD)

Network 2: Modbus function 3 - read holding register (WORD)

MB_SERVER example: Multiple TCP connections

Description
You can use several Modbus TCP server connections. To do this, the "MB_SERVER" 
instruction must be called independently for each connection. 

Every connection requires the following:

● An independent instance data block of the instruction

● A unique connection ID

● A separate IP port (on the S7-1200, only one connection is permitted per IP port)
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To optimize the performance "MB_SERVER" should be executed once per program cycle for 
each connection.

Network 1: Connection #1 with associated IP port connection ID and instance DB

Network 2: Connection #1 with associated IP port connection ID and instance DB

MODBUS (TCP) (S7-1200, S7-1500)

MB_CLIENT: Communicating via PROFINET as a Modbus TCP client

Description of MB_CLIENT

Description
The "MB_CLIENT" instruction communicates as a Modbus TCP client via the PROFINET 
connection. With the "MB_CLIENT" instruction, you establish a connection between the client 
and the server, send Modbus requests and receive responses and control connection 
termination of the Modbus TCP client.

The "MB_CLIENT" instruction V3.0 can be used for the S7-1500 as well as for the S7-1200 
version 4.0 or higher. The connection can take place via the local interface of the CPU or CM/
CP.

To use the instruction, you do not require an additional hardware module.
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Multiple client connections
A Modbus TCP client can support several TCP connections and the maximum number of 
connections depends on the CPU being used. The total number of connections of one CPU, 
including those of the Modbus TCP clients and server must not exceed the maximum number 
of supported connections. Modbus TCP connections can also be shared by "MB_CLIENT" and/
or "MB_SERVER" instances.

With individual client connections, remember the following rules:

● Each "MB_CLIENT" connection must use a unique instance DB.

● For each "MB_CLIENT" connection, a unique server IP address must be specified.

● Each "MB_CLIENT" connection requires a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● Unique numbers for the IP port may or may not be required depending on the server 
configuration.

Parameters
The following table shows the parameters of the "MB_CLIENT" instruction:

Parameter Declaration Data type Description
REQ (Page 3174) Input BOOL Communication request with the Modbus TCP server

The REQ parameter is level-controlled. This means that as long as 
the input is set (REQ=true), the instruction sends communication 
requests.
● The instance DB for other clients is blocked with the 

communications request. 
● Changes to the input parameters will not become effective until 

the server has responded or an error message has been output. 
● If the parameter REQ is set again during an ongoing Modbus 

request, no additional transmission takes place afterwards.
DISCONNECT 
(Page 3174) 

Input BOOL With this parameter, you control the establishment and termination 
of the connection to the Modbus server:
● 0: Establish communications connection to the connection 

partner configured at the CONNECT parameter (see CONNECT 
parameter).

● 1: Disconnect the communication connection. No other function 
is executed during connection termination. The value 0003 is 
output at the STATUS parameter after successful connection 
termination.

The Modbus request is sent immediately if the REQ parameter is 
set during connection establishment.

MB_MODE 
(Page 3174) 

Input USINT Selects the mode of the Modbus request (read, write or diagnostics).

MB_DATA_ADDR 
(Page 3174) 

Input UDINT Start address of the data accessed by the "MB_CLIENT" instruction.
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Parameter Declaration Data type Description
MB_DATA_LEN Input UINT Data length: Number of bits or words for the data access (see 

"MB_MODE and MB_DATA_ADDR parameters" - data length). 
MB_DATA_PTR 
(Page 3176)

InOut VARIANT Pointer to the Modbus data register: The register is a buffer for the 
data received from the Modbus server or to be sent to the Modbus 
server. The pointer must reference a global data block with 
optimized access.
The number of bits addressed must be divisible by 8.

CONNECT 
(Page 3177)

InOut VARIANT Pointer to the structure of the connection description
The following structures (system data types) can be used:
● TCON_IP_v4: Includes all address parameters required for 

establishing a programmed connection. When using 
TCON_IP_v4, the connection is established when calling the 
instruction "MB_SERVER".

● TCON_Configured: Includes the address parameters of a 
configured connection. When using TCON_Configured, an 
existing connection is used that was created by the CPU after 
download of the hardware configuration.

DONE Out BOOL The bit at output parameter DONE is set to "1" as soon as the last 
job is completed without errors. 

BUSY Out BOOL ● 0: No Modbus request in progress
● 1: Modbus request being processed
The output parameter BUSY is not set during connection 
establishment and termination.

ERROR Out BOOL ● 0: No error
● 1: Error occurred. The cause of error is indicated by the STATUS 

parameter.
STATUS 
(Page 3179) 

Out WORD Detailed status information of the instruction.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

 

 Note
Consistent input data during an "MB_CLIENT" call

When a Modbus client instruction is called, the status of the input parameters is stored 
internally and then compared at the next call. The comparison is used to determine whether 
this particular call initialized the current request. Several "MB_CLIENT" calls can be executed 
if you use a common instance DB. The values of the input parameters must not be changed 
while an "MB_CLIENT" instance is being executed. If the input parameters are changed 
during execution, "MB_CLIENT" cannot be used to check whether or not the instance is 
currently being executed.
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Static tags of the instruction
The following table describes the editable static tags of the instance data block of the 
"MB_CLIENT" instruction.

Tag Data type Start value Description
Blocked_Proc_Timeo
ut

REAL 3.0 Wait time in seconds before the static tag ACTIVE is reset if there 
is a blocked Modbus instance. This can, for example, occur if a client 
request is output and the execution of the client function aborts 
before the request was fully executed. The maximum wait time is 55 
seconds.

MB_Transaction_ID WORD 1 Transaction ID of the Modbus TCP protocol. The start value of "1" 
should only be changed if the Modbus TCP server requires a 
different value.

MB_Unit_ID BYTE 255 Unit ID of the Modbus protocol. The tag corresponds to the slave 
address of the Modbus RTU protocol. Change this value only if the 
Modbus TCP server can be used as a gateway and is controlled by 
the application program within the Modbus server.

RCV_TIMEOUT REAL 2.0 Time interval in seconds in which the "MB_CLIENT" instruction waits 
for a response from the server.

Connected BOOL 0 Indicates whether the connection to the assigned server has been 
established or not: 1 = connected, 0 = not connected.

REQ and DISCONNECT parameters

Description
If no instance of the "MB_CLIENT" instruction is executing and if the value of the DISCONNECT 
parameter is "0", a new job executes if REQ=1. If there is not yet a connection, this is 
established during execution.

If the same instance of the "MB_CLIENT" instruction executes again (DISCONNECT = 0 and 
REQ = 1), before the active job was executed, this is not executed on completion of the active 
job. A new job can only be started on completion of the active job (REQ = 1).

The status of the execution is output by the output parameters. You can use it to monitor the 
execution status when the "MB_CLIENT" instruction is executed sequentially.

MB_MODE and MB_DATA_ADDR parameters

Description
Instead of a function code, the "MB_CLIENT" instruction uses the MB_MODE parameter.  The 
MB_DATA_ADDR parameter is used to specify the Modbus start address of the data you want 
to access. 

The combination of the parameters MB_MODE, MB_DATA_ADDR and MB_DATA_LEN 
defines the function code used in the current Modbus message. For example:
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● Function code 5

– MB_MODE=1

– MB_DATA_ADDR=1

– MB_DATA_LEN=1

● Function code 15

– MB_MODE=1

– MB_DATA_ADDR=1

– MB_DATA_LEN=2

The following table shows the relationship between the input parameters of the "MB_CLIENT" 
instruction and the Modbus function.

MB_MODE MB_DATA_A
DDR

MB_DATA_L
EN

Modbus 
function

Function and data type

0 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 1 to 2000

01 Read input bits: 
● 1 to 2000

0 Start address:
● 10001 to 1

9999

Data length 
(bits) per call:
● 1 to 2000

02 Read input bits: 
● 1 to 2000

0 Start address:
● 40001 to 

49999
● 400001 to 

465535

Data length 
(WORD) per 
call:
● 1 to 125
● 1 to 125

03 Read holding register: 
● 0 to 9998
● 0 to 65534

0 Start address:
● 30001 to 3

9999

Data length 
(WORD) per 
call:
● 1 to 125

04 Read input words: 
● 0 to 9998

1 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 1

05 Writing an output bit:
● 0 to 9998

1 Start address:
● 40001 to 

49999
● 400001 to 

465535

Data length 
(WORD) per 
call:
● 1
● 1

06 Write a holding register: 
● 0 to 9998
● 0 to 65524

1 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 2 to 1968

15 Write multiple output bits: 
● 0 to 9998

1 Start address:
● 40001 to 

49999 
● 400001 to 

465534

Data length 
(WORD) per 
call:
● 2 to 123
● 2 to 123

16 Write multiple holding registers:
● 0 to 9998
● 0 to 65534
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MB_MODE MB_DATA_A
DDR

MB_DATA_L
EN

Modbus 
function

Function and data type

2 Start address:
● 1 to 9999

Data length 
(bits) per call:
● 1 to 1968

15 Write one or more output bits:
● 0 to 9998

2 Start address:
● 40001 to 

49999
● 400001 to 

465535

Data length 
(WORD) per 
call:
● 1 to 123
● 1 to 123

16 Write one or more holding registers: 
● 0 to 9998
● 0 to 65534

11 The MB_DATA_ADDR and 
MB_DATA_LEN parameters 
are not evaluated when this 
function is executed.

11 Read status word and event counter of the server:
● The status word reflects the the processing status (0 - not 

processing, 0xFFFF - processing).
● The event counter is incremented when the Modbus 

request was executed successfully. If an error occurred 
during execution of a Modbus function, a message is sent 
by the server but the event counter is not incremented.

80 - Data length 
(WORD) per 
call:
● 1

08 Check the server status with the diagnostic code 0x0000 
(return loop test - the server sends the request back):
● 1 WORD per call

81 - Data length 
(WORD) per 
call:
● 1

08 Reset the event counter of the server with the diagnostic code 
0x000A:
● 1 WORD per call

3 to 10,
12 to 79,
82 to 255

   Reserved

MB_DATA_PTR parameter

Description
The MB_DATA_PTR parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. As the data buffer, you can use a global data block or a memory 
area (M).

For a buffer in the memory area (M), use a pointer in the ANY format as follows: "P#bit address" 
"data type" "length" (example: P#M1000.0 WORD 500).

The MB_DATA_PTR parameter uses a communications buffer:

The communications buffer is used:
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● For the communication functions of the "MB_CLIENT" instruction:

– Reading and writing of 1 bit of data of the Modbus server addresses 00001 to 09999 
and 10001 to 19999.

– Reading of 16-bit WORD data of the Modbus server addresses 30001 to 39999 and 
40001 to 49999.

– Writing of 16-bit WORD data of the Modbus server addresses 40001 to 49999.

● During data transmission (length: bit or WORD) from or to the global DB or the memory 
area (M) that you assigned with the MB_DATA_PTR parameter.

 

If you use a data block for the buffer in the MB_DATA_PTR parameter, you will need to assign 
data types to the DB elements.

● Use the 1-bit data type BOOL for a Modbus bit address

● Use a 16-bit data type such as WORD, UINT, INT or REAL for a Modbus WORD address.

● Use a 32-bit data type (double word) such as DWORD, DINT or REAL for two Modbus 
WORD addresses.

● With MB_DATA_PTR, you can also access complex DB elements such as:

– Standard arrays

– Structures with unique element names

– Complex structures with unique naming of the elements and data type lengths of 16 or 
32 bits.

● The data areas for the MB_DATA_PTR parameter can also be in different global data blocks 
(or in different memory areas). You can, for example, use a data block for the the read jobs 
and another one for the write jobs or a separate data block for each "MB_CLIENT" station.

CONNECT parameter

Connection descriptions at CONNECT parameter
Two different connection descriptions can be used for the "MB_CLIENT" instruction:

● Programmed connections with the structure TCON_IP_v4
The connection parameters are stored in the TCON_IP_v4 structure and the connection is 
set up with the call of the instruction "MB_CLIENT".

● Configured connections with the structure TCON_Configured
The configured connection has already been established by the CPU. Use the structure 
TCON_Configured to specify which existing connection is to be used for the instruction.

Each instance of the instruction "MB_CLIENT" requires a unique connection. Create a separate 
structure TCON_IP_v4 or TCON_Configured for each instance of the instruction to describe 
the connection.
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Connection description for programmed connections
Use the following structure for connection description to TCON_IP_v4 for programmed 
connections at the CONNECT parameter:

● Make sure that only connections of the type TCP are specified in the TCON_IP_v4 structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

The parameter uniquely identifies a connection within the 
CPU. Each individual instance of the instruction 
"MB_CLIENT" must use a unique ID.

4 ConnectionType BYTE 11 Connection type
Select 11 (decimal) for TCP. Other connection types are not 
permitted. If another connection type (e.g. UDP) is used, a 
corresponding error message is output at the STATUS 
parameter of the instruction.

5 ActiveEstablished BOOL TRUE ID for the manner in which the connection is established
Select TRUE for active connection establishment.

6 … 9 RemoteAddress ARRAY 
[1..4] of 
BYTE

- IP address of the connection partner (Modbus server), for 
example, for 192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1

10 … 
11

RemotePort UINT 502 Port number of the remote connection partner (value range: 
1 to 49151).
Use the IP port number of the server to which the client 
establishes the connection and communicates using the TCP/
IP protocol (default value: 502).

12 … 
13

LocalPort UINT 0 Port number of the local connection partner:
● Port numbers: 1 to 49151
● Any port: "0" 
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 Note
Migration of the instruction "MB_CLIENT" version 2.1

The parameters CONNECT_ID, IP_PORT and IP_OCTET_x are mapped in version 3.0 of 
the "MB_CLIENT" instruction in the TCON_IP_v4 structure:
● The parameter CONNECT_ID of the "MB_CLIENT" V2.1 instruction corresponds to the 

ID parameter of TCON_IP_v4. 
● The parameter IP_PORT of the "MB_CLIENT" V2.1 instruction corresponds to the 

RemotePort parameter of TCON_IP_v4. 
● The four parameters IP_OCTET_x of the "MB_CLIENT" V2.1 instruction correspond to 

the array of the RemoteAddress parameter of TCON_IP_v4.
 

Connection description for configured connections
For programmed connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured.

● Make sure that only connections of the type TCP are specified in the TCON_Configured 
structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceId HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE 0 Connection type

Select 254 (decimal) for a configured connection.

Parameter STATUS 

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active and no connection established (REQ=0).
7001 Connection establishment triggered.
7002 Intermediate call. Connection is being established.
7003 Connection is being terminated.
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STATUS* 
(W#16#)

Description

7004 Connection established and monitored. No job processing active.
7005 Data is being sent.
7006 Data is being received.
80BB Invalid value at ActiveEstablished parameter (identifier for the type of connection establishment, see 

CONNECT parameter (Page 3177)): 
● Only passive connection establishment permitted for server (ActiveEstablished = FALSE).
● Only active connection establishment permitted for client (ActiveEstablished = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (protocol error)

STATUS* 
(W#16#)

Error code in the error 
message from 
MB_SERVER (B#16#)

Description

8381 01 Function code is not supported.
8382 03 Error in data length:

● Invalid length specification in received Modbus frame.
● The length of the Modbus frame in the frame header does not match the 

number of received bytes.
● The number of bytes does not match the number of actually transmitted 

bytes (only functions 1-4).
● The received start address does not match the one sent originally (functions 

5, 6, 15, 16).
● The number of words does not match the number of actually transmitted 

words (only functions 15 and 16).
8383 02 Error reading or writing data or access outside the address area of 

MB_DATA_PTR (Page 3176).
The error can occur locally as well as with the instruction "MB_SERVER".

8384 03 Error in data value:
● Error in data value for function 5 (error on server).
● A different data value was received than was originally sent by the client 

(functions 5 and 6) (local error).
● Invalid exception code received.

8385 03 Diagnostic code is not supported (function code 08). The error can occur locally 
as well as on the server.

8386 - Received function code does not match the one sent originally.
8387 - ● The assigned connection ID is different from that used for previous requests. 

Only one connection ID can be used for each instance DB of the 
"MB_CLIENT" instruction.

● The error code is also output when the protocol ID of the Modbus TCP frame 
received by the server is not "0".
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STATUS* 
(W#16#)

Error code in the error 
message from 
MB_SERVER (B#16#)

Description

8388 15 or 16 The Modbus server sent a different data length than was requested. This error 
occurs only when using the Modbus functions 15 or 16.

* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)

STATUS* 
(W#16#)

Description

80B6 Invalid connection type, only TCP connections are supported.
80C8 No response of the server in the defined period. Check the connection to the Modbus server. This error is only 

reported on completion of the configured repeated attempts. 
If the "MB_CLIENT" instruction does not receive an answer with the originally transferred transaction ID (see 
static MB_TRANSACTION_ID tag) within the defined period, this error code is output.

8188 The MB_MODE parameter has an invalid value.
8189 Invalid addressing of data at the MB_DATA_ADDR parameter.
818A Invalid data length at the MB_DATA_LEN parameter.
818B The MB_DATA_PTR parameter has an invalid pointer. You should also check the values of the 

MB_DATA_ADDR (Page 3176) and MB_DATA_LEN parameters.
818C Timeout at parameter BLOCKED_PROC_TIMEOUT or RCV_TIMEOUT (see static tags of instruction). The 

limit of 55 seconds has been exceeded.
818D The transaction ID (MB_TRANSACTION_ID tag) does not correspond to the one sent originally (see static 

tags of instruction).
8200 ● A different Modbus request is currently being processed via the port.

● Another instance of MB_CLIENT with the same connection parameters is processing an existing Modbus 
request.

* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions

With the "MB_CLIENT" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND", "TRCV", "T_DIAG" and 
"TRESET") used by the instruction can occur.

The error codes are assigned via the instance data block of the "MB_CLIENT" instruction. 
The error codes are displayed for the respective instruction under STATUS in the "Static" 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.
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See also
GET_ERR_ID: Get error ID locally (Page 2080)

MB_SERVER: Communicating via PROFINET as a Modbus TCP server

Description of MB_SERVER

Description
The "MB_SERVER" instruction communicates as Modbus TCP server via a PROFINET 
connection. The "MB_SERVER" instruction processes connection requests of a Modbus TCP 
client, receives and processes Modbus requests and sends responses.

The "MB_SERVER" instruction V3.0 can be used for the S7-1500 as well as for the S7-1200 
version 4.0 or higher. The connection can take place via the local interface of the CPU or CM/
CP.

To use the instruction, you do not require an additional hardware module.
 

 NOTICE

Safety instruction

Note that each client on the network has access to the data of the Modbus instructions.

Although the data block for the Modbus holding register cannot be addressed directly by the 
client, it is possible to indirectly access the data via the offset addresses. The option is 
available to restrict access to an IP address to prevent unauthorized read and write 
operations. Note, however, that the shared address can also be used for unauthorized access.

 

Multiple server connections
You can create multiple Server connections. This allows a single CPU to accept connections 
from multiple Modbus TCP clients at the same time.

A Modbus TCP server can support several TCP connections and the maximum number of 
connections depends on the CPU being used.

The total number of connections of one CPU, including those of the Modbus TCP clients and 
server must not exceed the maximum number of supported connections. 

Modbus TCP connections can also be shared by "MB_CLIENT" and/or "MB_SERVER" 
instances.

In the case of Server connections, remember the following rules:

Programming the PLC
9.7 References

WinCC Professional V13.0
3182 System Manual, 02/2014



● Each "MB_SERVER" connection must use a unique instance DB.

● Each "MB_SERVER" connection must use a unique connection ID.
The relevant individual connection ID must be used for each individual instance DB of the 
instruction. The connection ID and instance DB belong together in pairs and must be unique 
for each connection.

● For each connection, the "MB_SERVER" instruction must be called individually.

Parameters
The following table shows the parameters of the "MB_SERVER" instruction:

Parameter Declaration Data type Description
DISCONNECT Input BOOL The "MB_SERVER" instruction is used to enter into a passive connection 

with a partner module. The server responds to a connection request from 
the IP address which is entered in the SDT "TCON_IP_v4" in the 
CONNECT parameter.  
You can use this parameter to control when a connection request is 
accepted:
● 0: A passive connection is established when there is no 

communications connection.
● 1: Initialization of the connection termination.  If the input is set, no 

other operations are executed. The value 0003 is output at the 
STATUS parameter after successful connection termination.

MB_HOLD_REG 
(Page 3186) 

InOut VARIANT Pointer to the Modbus holding register of the "MB_SERVER" instruction
The holding register contains the values that may be accessed by a 
Modbus client using the Modbus functions 3 (read), 6 (write) and 16 
(read).
As the holding register, use either a global data block with optimized 
access or the memory area of the bit memories.

CONNECT 
(Page 3186)

InOut VARIANT Pointer to the structure of the connection description
The following structures (SDTs) can be used:
● TCON_IP_v4: Includes all address parameters required for 

establishing a programmed connection. The default address is 0.0.0.0 
(any IP address), but you can enter a specific IP address so that the 
server only responds to requests from this address. When using 
TCON_IP_v4, the connection is established when calling the 
instruction "MB_SERVER".

● TCON_Configured: Includes the address parameters of a configured 
connection. When using TCON_Configured, the connection is 
established by the CPU after download of the hardware configuration.

NDR Output BOOL "New Data Ready":
● 0: No new data
● 1: New data written by the Modbus client written

DR Output BOOL "Data Read":
● 0: No data read
● 1: Data read by the Modbus client
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Parameter Declaration Data type Description
ERROR Output BOOL If an error occurs during the call of the "MB_SERVER" instruction, the 

output of the ERROR parameter is set to "1". Detailed information about 
the cause of the problem is indicated by the STATUS parameter. 

STATUS 
(Page 3188) 

Output WORD Detailed status information of the instruction.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Static tags of the instruction
The following table describes the static tags of the instance data block of the "MB_SERVER" 
instruction used in the program. You can write the HR_Start_Offset tag. You can read the other 
tags to monitor the Modbus status.

Tag Data type Start value Description
HR_Start_Offset WORD 0 Assign the start address of the Modbus holding register.
Request_Count WORD 0 Total number of requests received by the server.
Server_Message_Co
unt

WORD 0 Total number of received messages for the relevant Server.

Xmt_Rcv_Count WORD 0 Counter for detecting the number of transfers during which an error 
occurred. The counter is only incremented when an invalid Modbus 
request is received.

Exception_Count WORD 0 Counters for detecting the number of errors specifically for Modbus which 
cause an error message to "MB_CLIENT".

Success_Count WORD 0 Event counter for detecting the number of requests that were 
successfully executed by the server.

Connected BOOL 0 Indicates whether the connection to the assigned client has been 
established or not: 1 = connected, 0 = not connected.

Mapping of Modbus addresses to the process image
The "MB_SERVER" instruction allows incoming Modbus functions (1, 2, 4, 5 and 15) direct 
read and write access to the process image inputs and outputs of the CPU (use of the data 
types BOOL and WORD). 

For the data transfer of the function codes 3, 6 and 16, the holding register (MB_HOLD_REG 
parameter) must be defined longer than one byte. The following table shows the mapping of 
the Modbus addresses to the process image of the CPU.

Modbus function S7-1500, S7-1200 V4.0
Function 
code

Function Data area Address space Data area CPU address

01 Read: Bits Output 1 to 9999 Process image output Q0.0 to Q1249.6
02 Read: Bits Input 1 to 19999 Process image input I0.0 to I1249.6
04 Read: WORD Input 1 to 39999 Process image input IW0 to IW19996
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Modbus function S7-1500, S7-1200 V4.0
05 Write: Bits Output 1 to 9999 Process image output Q0.0 to Q1249.6
15 Write: Bits Output 1 to 9999 Process image output Q0.0 to Q1249.6

Incoming Modbus requests with the function codes 3, 6, 16 and 23 write to or read from the 
Modbus holding register (you specify the holding register with the MB_HOLD_REG parameter).

Example: Addressing via static tag HR_Start_Offset
The addresses of the Modbus holding register start at 40001. These addresses correspond to 
the address space of the CPU memory area for the holding register. You can also define the 
HR_Start_Offset tag so that the Modbus holding register has a start address other than 40001.

Example: The holding register begins at MW100, and has a length of 100 WORD. An offset 
value in the HR_Start_Offset parameter means that the start address of the holding register is 
moved from 40001 to 40021. Whenever the holding register is addressed below the address 
40021 and above the address 40120, this causes an error.

HR_Start_Offset Address Minimum Maximum
0 Modbus address (WORD) 40001 40100

CPU address MW100 MW298
20 Modbus address (WORD) 40021 40120

CPU address MW100 MW298

Modbus diagnostics functions
The table below contains a description of the Modbus diagnostics functions.

Function 
code

Diagnostic 
code

Description

08 0x0000 Echo test: The "MB_SERVER" instruction receives a data word and returns this unchanged 
to the Modbus client.

08 0x000A Reset event counter: The "MB_SERVER" instruction resets the following event counters: 
"Success_Count", "Xmt_Rcv_Count", "Exception_Count", "Server_Message_Co" and 
"Request_Count".

11 - Fetch event counter of the communication: The "MB_SERVER" instruction uses an internal 
event counter for communication to record the number of successfully executed read and 
write requests sent to the Modbus server.
The event counter is not incremented with the functions 8 or 11. The same holds true for 
requests that cause a communications error, for example, if a protocol error has occurred 
(e.g., the function code in the received Modbus request is not supported).
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MB_HOLD_REG parameter

Description
The MB_HOLD_REG parameter is a pointer to a data buffer for storing the data read from or 
written to the Modbus server. You can use a global data block or a bit memory (M) as memory 
area.

● The high limit for the number of addresses in the data block (D) is determined by the 
maximum work memory of the CPU. 

● The high limit for the number of bit memories (M) is determined by the size of the CPU 
memory area.

The following table shows examples of mapping Modbus addresses to the holding register for 
the Modbus functions 3 (read WORD), 6 (write WORD), 16 (write several WORD) and 23 (write 
and read several words). 

Modbus 
addresses

MB_HOLD_REG parameter - examples

40001 MW100 DB10.DBW0 "Recipe".ingredient[1]
40002 MW102 DB10.DBW2 "Recipe".ingredient[2]
40003 MW104 DB10.DBW4 "Recipe".ingredient[3]
40004 MW106 DB10.DBW6 "Recipe".ingredient[4]
40005 MW108 DB10.DBW8 "Recipe".ingredient[5]

CONNECT parameter

Connection descriptions at CONNECT parameter
Two different connection descriptions can be used for the "MB_SERVER" instruction:

● Programmed connections with the structure TCON_IP_v4
The connection parameters are stored in the TCON_IP_v4 structure and the connection is 
set up with the call of the instruction "MB_SERVER".

● Configured connections with the structure TCON_Configured
The configured connection has already been established by the CPU. Use the structure 
TCON_Configured to specify which existing connection is to be used for the instruction.

Each instance of the instruction "MB_SERVER" requires a unique connection. Create a 
separate structure TCON_IP_v4 or TCON_Configured for each instance of the instruction to 
describe the connection.
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Connection description for programmed connections
For programmed connections at the CONNECT parameter, use the following structure for 
connection description to TCON_IP_v4.

● Make sure that only connections of the type TCP are specified in the TCON_IP_v4 structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

The parameter uniquely identifies a connection within the 
CPU. Each individual instance of the instruction 
"MB_SERVER" must use a unique ID.

4 ConnectionType BYTE 11 Connection type
Select 11 (decimal) for TCP. Other connection types are not 
permitted. If another connection type (e.g. UDP) is used, a 
corresponding error message is output at the STATUS 
parameter of the instruction.

5 ActiveEstablished BOOL FALSE ID for the manner in which the connection is established
Select FALSE for passive connection establishment.

6 … 9 RemoteAddress ARRAY 
[1..4] of 
BYTE

0.0.0.0 IP address of the connection partner, for example, for 
192.168.0.1: 
● addr[1] = 192
● addr[2] = 168
● addr[3] = 0
● addr[4] = 1
If the instruction "MB_SERVER" is to accept connection 
requests from any connection partner, use "0.0.0.0" as IP 
address.

10 … 
11

RemotePort UINT 0 Port number of the remote connection partner (value range: 
1 to 49151).
If the instruction "MB_SERVER" is to accept connection 
requests from any remote partner, use "0" as port number.

12 … 
13

LocalPort UINT 502 Port number of the local connection partner (value range: 1 
to 49151).
The number of the IP port defines which IP port is monitored 
for connection requests of the Modbus client. 
The following TCP port numbers must not be used for the 
passive connection of the "MB_SERVER" instruction: 20, 21, 
25, 80, 102, 123, 5001, 34962, 34963 and 34964. 
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 Note
Migration of the instruction "MB_SERVER" version 2.1

The parameters CONNECT_ID and IP_PORT are mapped in version 3.0 of the 
"MB_SERVER" instruction in the TCON_IP_v4 structure:
● The parameter CONNECT_ID of the "MB_SERVER" V2.1 instruction corresponds to the 

ID parameter of TCON_IP_v4. 
● The parameter IP_PORT of the "MB_SERVER" V2.1 instruction corresponds to the 

LocalPort parameter of TCON_IP_v4. 
 

Connection description for configured connections
For configured connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured.

● Make sure that only connections of the type TCP are specified in the TCON_Configured 
structure.

● The connection may not use the following TCP port numbers: 20, 21, 25, 80, 102, 123, 
5001, 34962, 34963 and 34964.

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to this connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE - Connection type

Select 254 (decimal) for a configured connection.

Parameter STATUS

Parameter STATUS (general status information)

STATUS* 
(W#16#)

Description

0000 Instruction executed without errors.
0001 Connection established.
0003 Connection terminated.
7000 No call active (REQ=0).
7001 First call. Connection establishment triggered.
7002 Intermediate call. Connection is being established.
7003 Connection is being terminated.
7005 Data is being sent.
7006 Data is being received.
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STATUS* 
(W#16#)

Description

80BB Invalid value at ActiveEstablished parameter (identifier for the type of connection establishment, see 
CONNECT parameter (Page 3186)): 
● Only passive connection establishment permitted for server (active_established = FALSE).
● Only active connection establishment permitted for client (active_established = TRUE).

8380 Received Modbus frame has incorrect format or too few bytes were received.
* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Parameter STATUS (parameter error)

STATUS* 
(W#16#)

Error code in the error 
message from 
"MB_SERVER" (B#16#)

Description

8187 No response The MB_HOLD_REG parameter has an invalid pointer. Data area is too small.
8381 01 Function code is not supported.
8382 03 Error in data length:

● Invalid length specification in received Modbus frame
● The frame length entered in the header of the Modbus frame does not match 

the number of actually received bytes.
● The number of bytes entered in the header of the Modbus frame does not 

match the number of actually received bytes (functions 15 and 16).
8383 02 Error in data address or access outside the address area of the holding register 

(MB_HOLD_REG (Page 3186) parameter).
8384 03 Invalid data value (function 5).
8385 03 Diagnostic code is not supported (only with function code 08).
* The status codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error codes of internally used communications instructions

With the "MB_SERVER" instruction, in addition to the errors listed in the tables, errors caused 
by the communication instructions ("TCON", "TDISCON", "TSEND", "TRCV", "T_DIAG" and 
"T_RESET") used by the instruction can occur.

The error codes are assigned via the instance data block of the "MB_SERVER" instruction. 
The error codes are displayed for the respective instruction under STATUS in the "Static" 
section.

The meaning of the error codes is available in the documentation of the corresponding 
communications instruction.

 

See also
GET_ERR_ID: Get error ID locally (Page 2080)
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9.7.5.2 S7 communication

Data consistency

Definition
A data block which cannot be modified by concurrent processes is called consistent data area. 
A data block which is larger than the consistent data area can thus be falsified as a whole 
during transmission. This means that a data block which belongs together and which is larger 
than consistent data area can consist in part of new and of old consistent data at the same 
time.

Example
An inconsistency can occur when an instruction for communication is interrupted, for example, 
by a hardware interrupt OB with higher priority. If the user program in this OB now changes 
the data that has already been partly processed by the instruction, the transferred data 
originates:

● In part from the time before the hardware interrupt was processed

● And in part from the time after the hardware interrupt was processed

This means that these data are inconsistent (not coherent).

Ensuring data consistency
If the communication process can be interrupted by an interrupt OB, you must ensure that the 
data is transferred consistently. Make sure that only an image of the data and not the data to 
be transferred is not changed directly by the interrupt OB. Copy the image of the data to the 
transfer area of the communication instruction prior to the next data transfer.

● If the user program contains a communication instruction that accesses common data, 
access to this data area can be coordinated, for example, by means of the DONE 
parameter. The data consistency of the communication areas which are transferred locally 
with a communication instruction can therefore be ensured in the user program.

● In the case of S7 communication instructions "PUT (Page 3197)"/"GET (Page 3194)", the 
size of the consistent data areas must already be taken into consideration during 
programming or configuration, because a communication block is not available in the user 
program of the target device (server) to synchronize communication data to the user 
program.
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● For the S7-300 and C7-300 (exception: CPU 318-2 DP) the communication data are copied 
consistently into the user memory in blocks of 32 bytes in the cycle control point of the 
operating system. Data consistency is not guaranteed for larger data areas. If a defined 
data consistency is required, the communication data in the user program may not exceed 
32 bytes (maximum of 8 bytes, depending on the version).

● In the S7-400 and S7-1500, on the other hand, the communication data in 462-byte blocks 
is not processed at the cycle control point, but in fixed time slices during the program cycle. 
The consistency of a tag is ensured by the system. These communication areas can then 
be accessed consistently using the "PUT (Page 3197)" / "GET (Page 3194)" instructions 
or when reading/writing tags, for example by an OP or an OS.

 

  Note

Additional information on data consistency is provided in the description of the specific 
instructions.

 

Effect on interrupt reaction times
The interrupt reaction times of the CPU are slightly extended by copying the data. The greater 
the quantity of data which must be transferred with absolute consistency, the longer the 
interrupt reaction time of a system.

Common parameters of instructions for S7 communication

Classification
The parameters of the instructions for S7 communication can be divided into the following five 
categories according to their functions:

1. Control parameters are used to activate an instruction.

2. Addressing parameters are used to address the remote communication partner.

3. Send parameters point to the data areas that are to be sent to the remote partner.

4. Receive parameters point to the data areas where the data received from remote partners 
will be entered.

5. Status parameters are used to monitor whether the instruction has completed its task 
without error or for the analysis of any errors that have occurred.

Control parameter
Data exchange will only be activated if the appropriate control parameters have a defined value 
(for example, are set) when the instruction is called or when the value has undergone a specific 
change since the previous call (for example, a positive edge).
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Addressing parameters

Parameter Description
ID Reference to the local connection description (specified by the configuration of the 

connection).
R_ID With the R_ID parameter, you specify that a send and a receive instruction belong 

together: The R_ID parameter must match in the instruction at the sending end and the 
instruction at the receiving end.
This allows the communication of several instruction pairs via the same logic connection.
● R_ID must be specified in the form DW#16#wxyzWXYZ.
● The instruction pairs of a logical connection specified in R_ID must be unique for this 

connection.
 

 Note
Addressing parameters ID and R_ID

You can reassign the addressing parameters ID and R_ID during runtime. The new 
parameters are validated with each new job after the previous job has been closed.

You can use the following options to reduce the number of instance DBs and therefore the 
work memory required:
1. With tag IDs, you can use several connections via one data instance block.
2. With tag R_IDs, you can define several pairs of sending and receiving instructions for one 

job with a single instance.
3. You can combine cases 1 and 2.

Please note that the new parameters are valid after the last job is executed. When you activate 
the sending operation, the R_ID parameter in the instruction at the sending end must match 
its counterpart at the receiving end.

 

Status parameter 
With the status parameters, you monitor whether the instruction has completed its task 
correctly or whether it is still active. The status parameters also indicate errors.

 

 Note

The status parameters are valid for one cycle only, namely from the first command following 
the call until the next call. As a result, you must evaluate these parameters after each 
instruction cycle.
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Send and receive parameters
For communication instructions configured at both ends 

● The number of the SD_i and RD_i parameters used must match at the send and receive 
end.

● The data types of the SD_i and RD_i parameters that belong together must match at the 
send and receive end.

● The amount of data to be sent according to the SD_i parameter must not exceed the range 
made available by the corresponding RD_i (does not apply to "BSEND 
(Page 3202)" / "BRCV (Page 3205)"). The RD_i parameters must (with exception of 
"BSEND"/"BRCV") have the identical data size.

If you do not keep to the rules above, this is indicated by ERROR = 1 and STATUS = 4.
 

 Note
Supplying the send and receive parameters  

With the VARIANT data type, send and receive parameters must always be supplied any 
time a communication instruction is called. It is not possible, for example, to supply the send 
parameters of the communication instructions at startup and to only trigger the send job in 
cyclic operation.

 

User data size
With the "USEND (Page 3199)", "URCV (Page 3201)", "GET (Page 3194)" and "PUT 
(Page 3197)" instructions, the amount of data to be transferred must not exceed a defined user 
data size. The maximum user data size depends on:

● The instruction used

● The communication partner.

The guaranteed minimum size of the user data for an instruction with 1-4 tags is listed in the 
following table:

Instruction Partner: S7-300 Partner: S7-400 Partner: S7-1200 Partner: S7-1500
PUT / GET 160 bytes 400 bytes 160 bytes 880 bytes
USEND / URCV 160 bytes 440 bytes - 920 bytes
BSEND / BRCV 32768/65534 

bytes
65534 bytes - ● 65534 bytes 

with standard 
access

● 65535 bytes 
with optimized 
access

Further information on the user data size can be found in the technical data of the respective 
CPU.
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Exact user data size
If the user data size specified above is insufficient you can determine the maximum byte length 
of the user data as follows:

First read the data block size valid for communication from the following table:

Local CPU Remote CPU Data block size in bytes
S7-1200 Any 240
S7-1500
 

S7-300 240
S7-400 480
S7-1200 240
S7-1500 960

 

Use this value in the following table to read the maximum possible user data length in bytes 
as total of the parameters used. It applies for even lengths of the areas SD_i, RD_i, and 
ADDR_i. 

For each range of uneven length the maximum possible user data length is reduced by one 
byte.

 Number of SD_i, RD_i, ADDR_i parameters used
Data block size Instruction 1 2 3 4
240 (S7-300) PUT/GET/

USEND
160 - - -

240 (S7-300 via 
integrated interface)

PUT 212 - - -
GET 222 - - -
USEND 212 - - -

240 (S7-400) PUT 212 196 180 164
GET 222 218 214 210
USEND 212 - - -

480 (S7-400) PUT 452 436 420 404
GET 462 458 454 450
USEND 452 448 444 440

240 (S7-1200) PUT 212 196 180 164
GET 222 218 214 210

960 (S7-1500) PUT 932 916 900 884
GET 942 938 934 930
USEND 932 928 924 920

GET: Read data from a remote CPU

Description
With the instruction "GET", you can read data from a remote CPU.
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The instruction is started on a positive edge at control input REQ:

● The relevant pointers to the areas to be read out (ADDR_i) are then sent to the partner 
CPU. The partner CPU can be in RUN or STOP mode.

● The partner CPU returns the data:

– If the reply exceeds the maximum user data length, this is displayed with error code "2" 
at the STATUS parameter.

– The received data is copied to the configured receive areas (RD_i) at the next call. 

● Completion of this action is indicated by the status parameter NDR having the value "1". 

Reading can only be activated again after the previous reading process has been completed. 
Errors and warnings are output via ERROR and STATUS if access problems occurred while 
the data was being read or if the data type check results in an error.

Changes in the data areas addressed on the partner CPU are not registered by the "GET" 
instruction. 

Requirements for using the instruction
● The "Permit access with PUT/GET communication from remote partner" function was 

activated in the properties of the partner CPU under "Protection".

● The blocks which you access with the "GET" instruction were created with the access type 
"standard".

● Make sure that the areas defined with the parameters ADDR_i and SD_i match in terms of 
number, length and data type. 

● The area to be read (ADDR_i parameter) cannot be larger than the area for data storage 
(RD_i parameter).

Parameters
The following table shows the parameters of the "GET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the 
data exchange on a positive edge.

ID Input WORD I, Q, M, D, L or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.

NDR Output BOOL I, Q, M, D, L Status parameter NDR: 
● 0: Job not yet started or still running.
● 1: Job successfully completed.

ERROR
 

Output BOOL I, Q, M, D, L Status parameters ERROR and STATUS, 
error code:
● ERROR=0

STATUS has the value:
– 0000H: Neither warning nor error
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Parameter Declaration Data type Memory area Description
STATUS Output WORD I, Q, M, D, L – <> 0000H: Warning, STATUS 

supplies detailed information.
● ERROR=1

An error has occurred. STATUS 
supplies detailed information on the type 
of error.

ADDR_1 InOut REMOTE I, Q, M, D
 

Pointers to the areas on the partner CPU 
that are to be read.
When the REMOTE pointer accesses a DB, 
the DB must always be specified. 
Example: P#DB10.DBX5.0 Byte 10.

ADDR_2 InOut REMOTE
ADDR_3 InOut REMOTE
ADDR_4 InOut REMOTE

RD_1 InOut VARIANT I, Q, M, D, L Pointers to the areas on the local CPU in 
which the read data is entered.RD_2 InOut VARIANT

RD_3 InOut VARIANT
RD_4 InOut VARIANT

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters ERROR and STATUS
The following table contains all specific error information for the "GET" instruction that can be 
output via the ERROR  and STATUS  parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communication problems, for example

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 ● Negative acknowledgment from the partner device. The function cannot be executed.
● Response from the remote station exceeds the maximum user data length (see: Common 

parameters of instructions for S7 communication (Page 3191)).
● Access protection is activated on the partner CPU. Deactivate access protection in the CPU 

settings.
1 4 Error in the pointers to the data storage RD_i:

● Data types of the parameters RD_i and ADDR_i are not compatible with each other.
● The length of the area RD_i is smaller than the length of the data of the ADDR_i parameter 

that is to be read.
1 8 Access error on the partner CPU.
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with low priority (first call).
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 Note
Data consistency

Data is received consistently if you read the part of the receive area RD_i currently being 
used completely before initiating another job.

 

PUT: Write data to a remote CPU

Description
You can write data to a remote CPU with the instruction "PUT". 

The instruction is started on a positive edge at control input REQ:

● The pointers to the areas to be written (ADDR_i) and the data (SD_i) are then sent to the 
partner CPU. The partner CPU can be in RUN or STOP mode.

● The data to be sent is copied from the configured send areas ((SD_i). The partner CPU 
saves the sent data under the addresses supplied with the data and returns an execution 
acknowledgment. 

● If no errors occur, this is indicated at the next instruction call with status parameter DONE 
= "1". The writing process can only be activated again after the last job is complete.

Errors and warnings are output via ERROR and STATUS if access problems occurred while 
the data was being written or if the execution check results in an error.

Requirements for using the instruction
● The "Permit access with PUT/GET communication from remote partner" function was 

activated in the properties of the partner CPU under "Protection".

● The blocks which you access with the "PUT" instruction were created with the access type 
"standard".

● Make sure that the areas defined with the parameters ADDR_i and SD_i match in terms of 
number, length and data type. 

● The area to be written (ADDR_i parameter) must be as large as the send area (SD_i 
parameter).

Parameters
The following table shows the parameters of the "PUT" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the data 
exchange on a positive edge.

ID Input WORD I, Q, M, D, L or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L Status parameter DONE: 

● 0: Job not yet started or still executing
● 1: Job executed without errors.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L Status parameters ERROR and STATUS, 
error code:
● ERROR=0

STATUS has the value:
– 0000H: Neither warning nor error
– <> 0000H: Warning, STATUS supplies 

detailed information.
● ERROR=1

An error has occurred. STATUS supplies 
detailed information on the type of error.

STATUS Output WORD I, Q, M, D, L

ADDR_1 InOut REMOTE I, Q, M, D Pointers to the areas on the partner CPU to 
which the data will be written.
When the REMOTE pointer accesses a DB, 
the DB must always be specified. 
Example: P#DB10.DBX5.0 Byte 10.
When transferring data structures (e.g., Struct) 
the data type CHAR must be used at the 
ADDR_i parameters.

ADDR_2 InOut REMOTE
ADDR_3 InOut REMOTE
ADDR_4 InOut REMOTE

SD_1 InOut VARIANT I, Q, M, D, L Pointers to the areas on the local CPU which 
contain the data to be sent.
Only the data types BOOL, BYTE, CHAR, 
WORD, INT, DWORD, DINT, REAL are 
permitted.
When transferring data structures (e.g., Struct) 
the data type CHAR must be used at the SD_i 
parameters.

SD_2 InOut VARIANT
SD_3 InOut VARIANT
SD_4 InOut VARIANT

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters ERROR and STATUS
The following table contains all specific error information for the "PUT" instruction that can be 
output via the ERROR and STATUS parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communication problems, for example

● Connection description not loaded (local or remote).
● Connection interrupted (for example, cable, CPU off, CP in STOP mode).
● Connection to partner not yet established.
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ERROR STATUS 
(decimal)

Explanation

1 2 ● Negative acknowledgment of partner CPU. The function cannot be executed.
● Access on the partner CPU was not granted. Activate the access in the CPU settings.

1 4 Error in the pointers to the data storage:
● Data types of the parameters SD_i and ADDR_i are not compatible with each other.
● The length of the area SD_i is greater than the length of the data of the ADDR_i parameter 

that is to be written.
● Not possible to access SD_i.
● Maximum user data size exceeded.
● Number of the parameters SD_i and ADDR_i does not match.

1 8 Access error with the partner CPU (e.g. DB not loaded or write-protected).
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with low priority (first call).

Data consistency
When a send operation is activated (positive edge at REQ), the data to be sent from the send 
area SD_i is copied from the user program. After the block call, you can write to these areas 
without corrupting the current send data.

 

 Note

The send operation is only complete when the DONE status parameter has the value "1".
 

Other

USEND: Send data uncoordinated

Description
The "USEND" instruction sends data to a remote partner instruction of type "URCV 
(Page 3201)". The sending process is carried out without coordination with the partner 
instruction. This means that the data transfer is carried out without acknowledgment by the 
partner instruction.

When a send operation is activated (positive edge at REQ), the data to be sent from the send 
areas SD_i are copied from the user program. After the instruction call, you can write to these 
send areas again without corrupting the current send data.

Successful completion of the send operation is indicated by the value of the DONE  status 
parameter being set to "1".
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Parameters
The following table shows the parameters of the "USEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the data 
exchange on a positive edge.

ID Input CONN_PRG I, Q, M, D, L, P or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.

R_ID Input CONN_R_ID I, Q, M, D, L or 
constant

Addressing parameter R_ID for defining the 
instruction pairs "USEND" and "URCV".
See also: Common parameters of instructions for 
S7 communication (Page 3191)

DONE Output BOOL I, Q, M, D, L Status parameter
● 0: Job not yet started or still executing.
● 1: Job executed without errors.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L
 

Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.
SD_i (1≤ i ≤4) InOut VARIANT I, Q, M, D Pointer on the i-th send area.

Only the BOOL  data types are permitted (not 
permitted: bit array), BYTE, CHAR, WORD, INT, 
DWORD, DINT, REAL or STRUCT.
The maximum user data size for SD_i 
parameters depends on the partner CPU 
("URCV" instruction) and on the number of 
parameters used. 
Additional information is available in: Common 
parameters of instructions for S7 
communication (Page 3191)

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters ERROR and STATUS

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established
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ERROR STATUS 
(decimal)

Explanation

1 4 ● Errors in the send area pointers SD_i relating to the data length or the data type.
● Maximum user data length was exceeded.

1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 Value at R_ID parameter already exists in the connection specified at the ID parameter (R_ID value 

must be unique for the connection).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

URCV: Receive data uncoordinated

Description
The "URCV" instruction receives data asynchronously from a remote partner instruction of type 
"USEND (Page 3199)" and copies this data into the configured receive areas.

The instruction is ready to receive if there is a logical 1 at the EN_R input. An active job can 
be canceled with EN_R=0.

The receive data areas are referenced by the parameters RD_1 to RD_4. Make sure that the 
areas defined by the parameters RD_i / RD_1 and SD_i / SD_1 (with the associated partner 
instruction "USEND (Page 3199)") match in terms of number and length.

Successful completion of the copy operation is indicated when the value of the NDR  status 
parameter is set to logical "1". Once the status parameter NDR  has changed to "1", there will 
be new receive data in your receive areas (RD_i). A new block call may cause these data to 
be overwritten with new receive data. If you want to prevent this, call "URCV" (for example, 
during cyclic block processing) with the value 0 at EN_R until you have finished processing 
the received data.

Parameters
The following table shows the parameters of the "URCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Control parameter enabled to receive, signals 
ready to receive if the input is set.

ID Input CONN_PR
G

I, Q, M, D, L, P or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.

R_ID Input CONN_R_I
D

I, Q, M, D, L or 
constant

Addressing parameter for defining the instruction 
pairs "USEND" and "URCV".
See also: Common parameters of instructions for 
S7 communication (Page 3191)

NDR Output BOOL I, Q, M, D, L Status parameter
● 0: Job not yet started or still running.
● 1: Job successfully completed.
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Parameter Declaration Data type Memory area Description
ERROR
 

Output
 

BOOL
 

I, Q, M, D, L
 

Status parameter
● 0: Neither warning nor error
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.
RD_i (1≤ i ≤4) InOut VARIANT I, Q, M, D Pointer to the i-th receive area:

Only the BOOL data types are permitted (not 
permitted: bit array), BYTE, CHAR, WORD, INT, 
DWORD, DINT, REAL or STRUCT.
Additional information is available in: Common 
parameters of instructions for S7 communication 
(Page 3191)

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters ERROR and STATUS

ERROR STATUS 
(decimal)

Explanation

0 9 Warning: older received data were overwritten by newer received data.
0 11 Warning: The received data is already being processed in a priority class with lower priority (error 

can occur when copying data to the receive area).
0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 4 Errors in the receive area pointers RD_i relating to the data length or the data type.
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 Value at R_ID parameter already exists in the connection specified at the ID parameter (R_ID 

value must be unique for the connection).
1 19 The associated "USEND (Page 3199)" instruction sends data faster than it can be copied to the 

receive areas by "URCV".
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

BSEND: Send data in segments

Description
The "BSEND" instruction sends data to a remote partner instruction of type "BRCV 
(Page 3205)". With this type of data transfer, more data can be transported between the 
communication partners than is possible with all other communication instructions for 
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configured S7 connections. In each case, the maximum data volume amounts to 65534 bytes 
(standard access) or 65535 bytes (optimized access) for the integrated interface and for 
SIMATIC Net CP.

Functional description
You specify the instruction pair "BSEND" and "BRCV" with the input parameter R_ID. The R_ID 
parameter must be identical in the related instructions. 

The send job is activated after the instruction is called and a positive edge is detected at control 
input REQ. After the call, "BSEND" is not processed in the background, which means the data 
can only be read within the user program. 

The data area to be transmitted is segmented. Each segment is sent individually to the partner. 
Each segment is acknowledged by the partner after the application of this segment by 
"BRCV (Page 3205)". If the data is segmented, "BSEND" must be called multiple times until 
all segments have been transferred.

The data area of the data to be sent is specified by SD_1. To ensure data consistency, you 
may only write to the part of the currently used sending area SD_1 after the current send 
operation is complete. This is the case when the value of the status parameter DONE changes 
to "1".

The length of the send data is specified by LEN based on the job. With LEN = "0", all data 
addressed with the SD_1 parameter is sent.

If there is a positive edge at control input R, the current sending process is canceled.

Due to the asynchronous data transfer, a new data transfer can only be initiated if the previous 
data has been fetched by a partner instruction call. When the data has been collected, the 
status parameter "NDR" is set in the partner instruction "BRCV".

 
 

 Note
Migration of S7-400 user programs

An S7-400 CPU interprets the parameter SD_1 as pointer and not as data area. 

With S7-1500, LEN may not exceed the area of SD1. This was permitted with S7-400. 
Recommendation: Use the maximum size for the LEN parameter (65534 bytes for the 
integrated interface) as size of the data area at the SD_1 parameter.

 

Parameters
The following table shows the parameters of the "BSEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter request, activates the data 
exchange at a positive edge

R Input BOOL I, Q, M, D, L or 
constant

Control parameter reset, activates an abort of the 
current data exchange at a positive edge
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Parameter Declaration Data type Memory area Description
ID Input CONN_PR

G
I, Q, M, D, L, P or 
constant

Addressing parameters for specifying the connection 
to the partner CPU.

R_ID Input CONN_R_I
D

I, Q, M, D, L or 
constant

Addressing parameter for defining the instruction 
pairs "BSEND" and "BRCV (Page 3205)".
See also: Common parameters of instructions for S7 
communication (Page 3191)

SD_1 InOut VARIANT I, Q, M, D Pointer to send area
LEN InOut WORD I, Q, M, D, L Length of the block of data to be sent in bytes.

With LEN = "0", all data is sent by SD_1.
DONE Output BOOL I, Q, M, D, L Status parameter

● 0: Job not yet started or still executing.
● 1: Job executed without errors.

ERROR Output BOOL I, Q, M, D, L Status parameter
● 0: Neither warning nor error.
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters ERROR and STATUS
The following table contains all specific error information for "BSEND" that can be output via 
the ERROR  and STATUS  parameters.

ERROR STATUS 
(decimal)

Explanation

0 11 Warning: New job not active because the previous job is still busy.
0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 Negative acknowledgment of partner instruction. The instruction cannot be executed.
1 3 R_ID  is unknown on the connection specified by the ID or the receive block 

has not yet been called.
1 4 ● Error in the data length or data type in the send area pointer SD_1.

● Value for LEN is greater than area SD_1.
1 5 Reset request was executed.
1 6 Partner instruction is in DISABLED  status (EN_R  has the value "0"). Also check the input 

parameters of "BRCV (Page 3205)" for consistency with "BSEND".
1 7 "BRCV (Page 3205)" partner instruction not called since the last data transfer.
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ERROR STATUS 
(decimal)

Explanation

1 8 Access to remote object in the user memory was rejected: The destination area for the associated 
"BRCV (Page 3205)" is too small.
ERROR = 1, STATUS = 4 or ERROR = 1, STATUS = 10 reported at the output parameters of 
"BRCV (Page 3205)".

1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 R_ID  already exists in the connection.
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).

BRCV: Receive data in segments

Description
The "BRCV" instruction receives data from a remote partner instruction of type "BSEND 
(Page 3202)". The R_ID parameter must be identical in the related instructions.

The instruction is ready to receive data (STATUS = 25) after it is called with the value "1" at 
control input EN_R. An active job can be canceled with EN_R=0.

The maximum receive area is specified by RD_1. Data will be received consistently if you fully 
evaluate the part of the RD_1 receive area currently in use before calling the block again with 
value 1 at control input EN_R.

After each received data segment, an acknowledgment is sent to the partner instruction. If 
there are multiple segments it will be necessary to call "BRCV" several times until all of the 
segments have been received. Asynchronous data receipt is indicated by STATUS = 17. The 
amount of data currently received is indicated at the parameter LEN. The RD_1 parameter 
must remain constant during the operation.

Value "1" at the NDR  status parameter indicates that all data segments have been received 
without error. The received data remains unchanged until the next call with EN_R=1.

Parameters
The following table shows the parameters of the "BRCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Control parameter enabled to receive, signals 
ready to receive if the input is set.

ID Input CONN_PRG I, Q, M, D, L, P or 
constant

Addressing parameters for specifying the 
connection to the partner CPU.

R_ID Input CONN_R_ID I, Q, M, D, L or 
constant

Addressing parameter for defining the instruction 
pairs "BSEND (Page 3202)" and "BRCV".
See also: Common parameters of instructions for 
S7 communication (Page 3191)

RD_1 InOut VARIANT I, Q, M, D Pointer to the receive area. 
LEN InOut WORD I, Q, M, D, L Length of the data already received in bytes.
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Parameter Declaration Data type Memory area Description
NDR Output BOOL I, Q, M, D, L Status parameter

● 0: Job not yet started or still running.
● 1: Job successfully completed.

ERROR
 

Output
 

BOOL
 

I, Q, M, D, L
 

Status parameter
● 0: Neither warning nor error
● 1: An error has occurred. STATUS supplies 

detailed information on the type of error.
STATUS Output WORD I, Q, M, D, L Status parameter

See "ERROR and STATUS parameters" table.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Parameters ERROR and STATUS
The following table contains all specific error information for "BRCV" that can be output via the 
ERROR  and STATUS  parameters.

ERROR STATUS 
(decimal)

Explanation

0 17 Warning: Instruction receives data asynchronously. The LEN  parameter shows the amount of data 
already received in bytes.

0 25 Communication has started. The job is being processed.
1 1 Communication problem has occurred. Possible causes:

● Connection description not loaded (local or remote)
● Connection interrupted (for example: cable, CPU off, CP in STOP mode)
● Connection to partner not yet established

1 2 Function cannot be executed (protocol error)
1 4 Error in the receive area pointer RD_1 relating to the data length or data type. The block of data 

sent is longer than the receive area.
1 5 Reset request received, incomplete transfer.
1 8 Access error in associated "BSEND (Page 3202)": After the last valid data segment has been sent, 

ERROR  = 1 and STATUS  = 4 or ERROR  = 1 and STATUS  = 10 is reported.
1 10 Access to the local user memory not possible (for example, access to a deleted DB).
1 18 Value at R_ID parameter already exists in the connection specified at the ID parameter (R_ID value 

must be unique for the connection).
1 20 ● Maximum number of parallel jobs exceeded.

● The job is currently being processed in a priority class with lower priority (first call).
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9.7.5.3 Open User Communication

TSEND_C: Send data via Ethernet

TSEND_C: Send data via Ethernet

Description
The "TSEND_C" instruction sets up and establishes a TCP or ISO-on-TCP communication 
connection. Once the connection has been set up and established, it is automatically 
maintained and monitored by the CPU. The connection description specified at the CONNECT 
parameter is used to set up the communication connection.

The instruction is executed asynchronously and has the following functions:

● A communication connection is set up and established:
The communication connection is set up and established with CONT=1. Once the 
connection is successfully established, the DONE parameter is set to "1" for one cycle. An 
existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you 
must execute "TSEND_C" again. For information on the number of possible communication 
connections, refer to the technical specifications for your CPU.

● Sending data via an existing communication connection:
You specify the send area with the DATA parameter. This includes the address and the 
length of the data to be sent. Do not use a data area with the data type BOOL or Array of 
BOOL at the DATA parameter. If you use purely symbolic values at the DATA parameter, 
the LEN parameter must have the value "0".

● The send job is executed when a rising edge is detected at the REQ parameter. With the 
LEN parameter, you specify the maximum number of bytes sent with a send job. When 
sending data (rising edge at the REQ parameter), the CONT parameter must have the 
value "1" in order to establish or maintain a connection. The data to be sent must not be 
edited until the send job is completed. If the send job executes successfully, the DONE 
parameter is set to "1". Signal state "1" at the DONE parameter is not confirmation that the 
data sent has already been read by the communication partner.

● Terminating the communication connection:
The communication connection is terminated when the CONT parameter is set to "0" even 
if an ongoing data transmission is not complete yet. This does not apply if you are using 
an already configured connection for "TSEND_C".

When setting the COM_RST parameter to "1", the currently established connection or a current 
data transmission can be reset at any time. This terminates the existing communication 
connection and a new connection is established. If data is being transferred when it executes 
again, this can lead to a loss of data.

To enable "TSEND_C" again after the execution (DONE = 1), call the instruction once with 
REQ = 0.
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Parameters
The following table shows the parameters of the "TSEND_C" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L Starts the send job on a rising edge.
CONT Input BOOL I, Q, M, D, L Controls the communication connection:

● 0: Disconnect the communication connection
● 1: Establish and maintain the communication 

connection
When sending data (rising edge at the REQ 
parameter), the CONT parameter must have the 
value TRUE in order to establish or maintain a 
connection.

LEN Input UINT I, Q, M, D, L or 
constant

Maximum number of bytes to be sent with the job. 
If you use purely symbolic values at the DATA 
parameter, the LEN parameter must have the value 
"0".

CONNECT InOut TCON_Param D Pointer to the connection description
See also: Auto-Hotspot 

DATA InOut VARIANT I, Q, M, D, L Pointer to the send area containing the address and 
the length of the data to be sent.

COM_RST InOut BOOL I, Q, M, D, L Restarts the instruction:
● 0: Irrelevant
● 1: Complete restart of the instruction causing an 

existing connection to be terminated and a new 
connection to be established.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TSEND_C". The error information is output at the STATUS 
parameter.
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The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is specified in the STATUS parameter.
0 0 0 No new job was assigned.

ERROR and STATUS parameters

ERROR STATUS*
(W#16#...)

Description

0 0000 Job completed without error.
0 0001 The connection establishment is complete.
0 0003 The connection termination is complete.
0 7000 No job processing active.
0 7001 ● Start execution of the job

● Establish connection
● Wait for connection partner

0 7002 Data was sent.
0 7003 Connection is being terminated.
0 7004 Connection established and monitored, no job processing active.
1 80A0 Group error for error codes 80A1 and 80A2.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated. Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A2 Local or remote port is being used by the system.
1 80A3 Attempt being made to terminate a non-existent connection.
1 80A4 IP address of the remote endpoint of the connection is invalid, in other words, it matches the IP 

address of the local partner.
1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 

complete.
1 80AA A connection is currently being established with the same connection ID by another block. 

Repeat the job with a new rising edge at the REQ parameter.
1 80B2 The CONNECT parameter points to a data block that was generated with the attribute "Only 

store in load memory".
1 80B3 Inconsistent parameter assignment: Group error for error codes 80A0 to 80A2, 80A4, 80B4 to 

80B9.
1 80B4 You have violated one or both of the following conditions for passive connection establishment 

(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = 
B#16#12): "local_tsap_id_len >= B#16#02", and/or "local_tsap_id[1] = B#16#E0".

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
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ERROR STATUS*
(W#16#...)

Description

1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 
description.

1 80B7 Error in one of the following parameters of the data block for connection description: 
block_length, local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, 
next_staddr_len.

1 8085 The LEN parameter is larger than the highest permitted value.
1 8086 The ID parameter within the CONNECT parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible.
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA 

parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the 

connection description.
1 809B The ID of the local device in the connection description does not correspond to the CPU.
1 80C3 ● All connection resources are in use.

● A block with this ID is already being processed in a different priority group.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON" instruction.
● The connection used is being terminated by a call with COM_RST= 1.

1 80C6 Remote network error. Remote partner cannot be reached.
1 8722 Parameter CONNECT: The source area is invalid. The area does not exist in the DB.
1 873A Parameter CONNECT: Access to the connection description is not possible (for example, DB 

does not exist).
1 877F Parameter CONNECT: Internal error.
1 8822 Parameter DATA: Invalid source area, the area does not exist in the DB.
1 8824 Parameter DATA: Area error in the VARIANT pointer.
1 8832 Parameter DATA: The DB number is too high.
1 883A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 887F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 893A Parameter DATA: Access to send area not possible (e.g. because the DB does not exist).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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 Note
Error messages of the instructions "TCON", "TSEND", "T_DIAG" and "TDISCON"

Internally, the "TSEND_C" instruction uses the instructions "TCON (Page 3240)", "TSEND 
(Page 3253)", "T_DIAG (Page 3273)", "T_RESET (Page 3272)" and "TDISCON (Page 3248)". 
The error messages of these instructions can also be output at the STATUS parameter. The 
meaning of the error codes is described in the corresponding instructions. In the event of 
identical error codes for internally used instructions with different meanings, the instance data 
block of "TSEND_C" can be used to determine which instruction output the error.

 

TSEND_C: Send data via Ethernet

Description
The "TSEND_C" instruction sets up and establishes a communications connection. Once the 
connection has been set up and established, it is automatically maintained and monitored by 
the CPU. 

The instruction is executed asynchronously and has the following functions:

● Setting up and establishing a communication connection

● Sending data via an existing communication connection

● Terminating or resetting the communication connection

Internally, the instruction "TSEND_C" uses the communication instructions TCON", "TSEND", 
"T_DIAG", "T_RESET" and "TDISCON".

Setting up and establishing a communication connection
The communication connection is set up and established with CONT=1. For information on 
the number of possible communication connections, refer to the technical specifications for 
your CPU. The connection description specified at the CONNECT parameter is used to set up 
the communication connection. The following connection types can be used:

● Programmed connections (structure of connection via "TCON"):

– TCP / UDP: Connection description via the TCON_IP_v4 system data type 

– ISO-on-TCP: Connection description via the TCON_IP_RFC system data type

– ISO: Connection description via the TCON_ISOnative system data type (for CP1543-1 
only)

● Configured connections

– Specify an existing connection in the TCON_Configured system data type.

An existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you must 
execute "TSEND_C" again.
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Sending data via an existing communication connection
The send job is executed when a rising edge is detected at the REQ parameter. As described 
above, the communication connection is established first.

You specify the send area with the DATA parameter. This includes the address and the length 
of the data to be sent. Do not use a data area with the data type BOOL or Array of BOOL at 
the DATA parameter. With the LEN parameter, you specify the maximum number of bytes sent 
with a send job. If you use a send area with optimized access at the DATA parameter, the LEN 
parameter must have the value "0".

The data to be sent must not be edited until the send job is completed.

Terminating and resetting the communication connection
The communication connection is terminated when the CONT parameter is set to "0" even if 
an ongoing data transmission is not complete yet. This does not apply if you are using a 
configured connection for "TSEND_C".

The connection can be reset at any time by setting the parameter COM_RST to "1". This 
terminates the existing communication connection and a new connection is established. If data 
is being transferred at this time, this can lead to data loss.

Parameters
The following table shows the parameters of the "TSEND_C" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L, T, C 

or constant
Starts the send job on a rising edge. 

CONT Input BOOL I, Q, M, D, L Controls the communication connection:
● 0: Disconnect the communication connection.
● 1: Establish and maintain the communication 

connection.
LEN Input UDINT I, Q, M, D, L or 

constant
Optional parameter (hidden)
Maximum number of bytes to be sent with the job. 
If you use a send area with optimized access at the 
DATA parameter, the value "0" must be used at the 
LEN parameter.
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Parameter Declaration Data type Memory area Description
CONNECT InOut VARIANT D Pointer to the structure of the connection 

description:
● Programmed connection:

– For TCP, use the TCON_IP_v4 system data 
type
For description, refer to:Auto-Hotspot

– For ISO-on-TCP, use the TCON_IP_RFC 
system data type
For description, refer to: Auto-Hotspot

– For ISO, use the TCON_ISOnative system 
data type (only for CP1543-1)
For description, refer to instruction "TCON 
(Page 3243)".

● Configured connection:
– For existing connections, use the 

TCON_Configured system data type
For a description see "System data type for 
configured connections" below

DATA InOut VARIANT I, Q, M, D, L Pointer to the send area containing the address and 
the length of the data to be sent.

ADDR InOut VARIANT D Optional parameter (hidden)
Pointer to the address of the recipient.

COM_RST InOut BOOL I, Q, M, D, L Optional parameter (hidden)
Resets the connection:
● 0: Irrelevant
● 1: The existing connection is reset.
The COM_RST parameter is reset after evaluation 
by the "TSEND_C" instruction and should not, 
therefore, be interconnected statically.

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Send job not yet started or still in progress.
● 1: Send job executed without error. This state 

is only displayed for one cycle.
The output parameter DONE is set if an 
intermediate step was completed successfully 
during processing (connection establishment, 
sending, connection termination) and if the 
execution of "TSEND_C" was completed 
successfully.

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Send job not yet started or already completed.
● 1: Send job not yet completed. A new send job 

cannot be started.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred during connection 

establishment, data transmission or connection 
termination.

The output parameter ERROR can be set due to 
an error in the "TSEND_C" instruction or the 
communication instructions used internally.

STATUS Output WORD I, Q, M, D, L Status of instruction (see the "ERROR and 
STATUS" parameters" description).

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

REQ, CONT  and  COM_RST parameters
The parameter CONT controls the connection establishment of the "TSEND_C" instruction 
regardless of the REQ parameter. The behavior of the CONT parameter partially depends on 
whether a programmed or a configured connection is used:

● With CONT = "0": No data is sent (regardless of whether a programmed or a configured 
connection is used).

● When changing CONT = "0" to "1":

– With a programmed connection, it is established with "TCON".

– With a configured connection, it is checked with "T_DIAG".

● With CONT = "1":

– As long as no data is sent (REQ="0"), the connection is checked with "T_DIAG".

– If the internally used communication instructions signal that no connection end point 
exists, the connection is automatically reestablished with "TCON".

● When changing CONT = "1" to "0":

– With a programmed connection, it is terminated with "TDISCON".

– With a configured connection, it is reset with "T_RESET".

The parameter COM_RST resets the connection when changing from "0" to "1":

● If a connection is established, it is reset with "T_RESET" (regardless of whether a 
programmed or configured connection is used).

● If no connection is established, the setting of the parameter has no effect.

The REQ and COM_RST parameters only have an effect if CONT has been set to "1". The 
following table shows the relationship between the  REQ, CONT  and  COM_RST parameters:
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REQ CONT COM_
RST

Status of the 
instruction

Description

irreleva
nt

0 irreleva
nt

Not yet executed No job active (STATUS = 7000).

irreleva
nt

0 irreleva
nt

Initialization Connection is being terminated. The instruction is being reset.

irreleva
nt

0 > 1 irreleva
nt

Connection 
establishment

Connection is being established. Data is not being transferred yet.

0 1 0 Connection 
established

The connection is established and is monitored with the instruction 
"T_DIAG".

irreleva
nt

1 0 > 1 Connection 
established

The connection is interrupted by "T_RESET" briefly and reset.

0 > 1 1 0 Connection 
established

Instruction starts sending.

irreleva
nt

1 0 > 1 Data is being sent Data transmission is interrupted. The connection is being reset.

System data type for configured connections
For configured connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured:

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to the connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE - Connection type

Select 254 (decimal) for a configured connection.

BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a send job executed successfully. The ERROR parameter is set when 
errors occurred during execution of "TSEND_C". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

DONE BUSY ERROR Description
0 0 0 The instruction has not been executed yet (no rising edge at REQ parameter).
0 1 0 The instruction is being executed and calls the internally used communication instructions.
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DONE BUSY ERROR Description
1 0 0 The send job was completed successfully. "0000" is output at the STATUS parameter. 

DONE = "1" is only displayed for one cycle.
0 0 1 The execution of the instruction or an intermediate step during processing was terminated 

with an error. If there is a subsequent error due to an internally used communication 
instruction, the error that occurred first during processing is displayed. This state is only 
displayed for one cycle.

ERROR and STATUS parameters

ERROR STATUS*
(W#16#...)

Description

0 0000 Send job was executed without error.
0 0001 Communication connection established.
0 0003 Communication connection closed.
0 7000 No active send job execution; no communication connection established.
0 7001 Initial call for establishing a connection.
0 7002 Second call for establishing a connection
0 7003 Communication connection is being terminated.
0 7004 Communication connection has been established and is being monitored. No send job execution 

active.
0 7005 Data transmission in progress.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated.

Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A3 The nested "T_DIAG" instruction has reported that the connection has closed.
1 80A4 IP address of the remote endpoint of the connection is invalid or it matches the IP address of 

the local partner.
1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 

complete.
1 80AA A connection is currently being established with the same connection ID by another block. 

Repeat the job with a new rising edge at the REQ parameter.
1 80B4 You have violated one or both of the following conditions for passive connection establishment 

(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = 
B#16#12): 
● local_tsap_id_len >= B#16#02
● local_tsap_id[1] = B#16#E0

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
1 80B7 Error in one of the following parameters of the data block for connection description: 

block_length, local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, 
next_staddr_len.
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ERROR STATUS*
(W#16#...)

Description

1 8085 The LEN parameter is larger than the highest permitted value.
1 8086 The ID parameter within the CONNECT parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible.
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA 

parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the 

connection description.
1 809B InterfaceID is invalid. It is either zero or it does not point to a local CPU interface or a CP.
1 80C3 ● All connection resources are in use.

● A block with this ID is already being processed in a different priority group.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON (Page 3248)" 

instruction.
● The connection used is being terminated by a call with COM_RST = 1.

1 80C6 Remote network error. Remote partner cannot be reached.
1 8722 Parameter CONNECT: The source area is invalid. The area does not exist in the DB.
1 873A Parameter CONNECT: Access to the connection description is not possible (for example, 

because the DB is not available).
1 877F Parameter CONNECT: Internal error.
1 8822 Parameter DATA: Invalid source area, the area does not exist in the DB.
1 8824 Parameter DATA: Area error in the VARIANT pointer.
1 8832 Parameter DATA: The DB number is too high.
1 883A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 887F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 893A Parameter DATA: Access to send area not possible (e.g. because the DB does not exist).
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

 

 Note
Error messages of the instructions "TCON", "TSEND", "T_DIAG", "T_RESET" and 
"TDISCON"

Internally, the "TSEND_C" instruction uses the instructions "TCON (Page 3243)", "TSEND 
(Page 3253)", "T_DIAG (Page 3273)", "T_RESET (Page 3272)" and "TDISCON (Page 3248)". 
The error messages of these instructions can also be output at the STATUS parameter. The 
meaning of the error codes is described in the corresponding instructions. In the event of 
identical error codes for internally used instructions with different meanings, the instance data 
block of "TSEND_C" can be used to determine which instruction output the error.
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TRCV_C: Receive data via Ethernet

TRCV_C: Receive data via Ethernet

Description
The "TRCV_C" instruction is executed asynchronously and has the following functions:

1. Setting up and establishing a communication connection:
"TRCV_C" sets up and establishes a TCP or ISO-on-TCP communication connection. Once 
the connection has been set up and established, it is automatically maintained and 
monitored by the CPU.
The connection description specified at the CONNECT parameter is used to set up the 
communication connection. To establish a connection, the CONT parameter must be set 
to the value "1". Once the connection is successfully established, the DONE parameter is 
set to "1".
An existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you 
must execute "TRCV_C" again.
For information on the number of possible communication connections, refer to the 
technical specifications for your CPU.

2. Receiving data via an existing communication connection:
If the EN_R parameter is set to the value "1", receipt of data is enabled. When receiving 
data (rising edge at the EN_R parameter), the CONT parameter must have the value TRUE 
in order to establish or maintain a connection.
The received data is entered in a receive area. You specify the length of the receive area 
either with the LEN parameter (if LEN <> 0) or with the length information of the DATA 
parameter (if LEN = 0) in accordance with the protocol variant used. If you use purely 
symbolic values at the DATA parameter, the LEN parameter must have the value "0".
After data has been received successfully, the signal state at the DONE parameter is "1". 
If errors occur in the data transfer, the DONE parameter is set to "0".

3. Terminating the communication connection:
The communication connection is terminated immediately when the CONT parameter is 
set to "0".

TRCV_C is executed again when the COM_RST parameter is set. This terminates the existing 
communication connection and a new connection is established. If data is being received when 
it executes again, this can lead to a loss of data.
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Receive modes of TRCV_C
The following table shows how the received data is entered in the receive area.

Protocol variant Availability of data in the receive area connection_type parameter of the 
connection description

LEN parameter

TCP
(Ad-hoc mode)

The data is immediately available. Hexadecimal value: B#16#11
Integer value: 17

0

TCP 
(Receipt of data with 
specified length)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented 
data transfer)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#12
Integer value: 18

● 1 to 1452, if a CP 
is used.

● 1 to 8192, if no 
CP is used.

TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV" instruction.

You set ad-hoc mode by assigning the value "0" to the LEN parameter. All data types can be 
used for data blocks with standard access when you use ad-hoc mode. Only ARRAY of BYTE 
or data types with a length of 8 bits can be used for data blocks with optimized access (e.g., 
CHAR, USINT, SINT, etc.).  The data length actually received is output at the RCVD_LEN 
parameter.

TCP (Receipt of data with specified length)
You use the value of the LEN parameter to specify the length for the data receipt. The data 
receipt is not complete until the length of data specified at the LEN parameter has been 
completely received. Only then is the data available in the receive area (DATA parameter). 
The actually received data length in bytes at the RCVD_LEN parameter corresponds to the 
data length at the LEN parameter after receipt. 

ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. When using ISO on TCP, "TRCV_C" signals 
data receipt as soon as the message block has been completely received. The receive area 
is defined by the LEN and DATA parameters. If the receive buffer (DATA parameter) is too 
small for the sent data, "TRCV_C" signals an error. The actually received data length in bytes 
at the RCVD_LEN parameter corresponds to the data length at the LEN parameter after 
receipt. 
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Parameters
The following table shows the parameters of the "TRCV_C" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L Receive enable
CONT Input BOOL I, Q, M, D, L Controls the communication connection:

● 0: Disconnect the communication connection
● 1: Establish and maintain the communication 

connection
When receiving data (rising edge at the EN_R 
parameter), the CONT parameter must have the 
value TRUE in order to establish or maintain a 
connection.

LEN Input UINT I, Q, M, D, L or 
constant

Maximum length of the data to be received. If you 
use purely symbolic values at the DATA parameter, 
the LEN parameter must have the value "0".

CONNECT InOut TCON_Param D Pointer to the connection description
See also: Auto-Hotspot 

DATA InOut VARIANT I, Q, M, D, L Pointer to the receive area
COM_RST InOut BOOL I, Q, M, D, L Restarts the instruction:

● 0: Irrelevant
● 1: Complete restart of the instruction causing an 

existing connection to be terminated
DONE Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

 

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TRCV_C". The error information is output at the STATUS 
parameter.
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The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

ERROR and STATUS parameters

ERROR STATUS*
(W#16#...)

Description

0 0000 Job completed without error.
0 0001 The connection establishment is complete.
0 0003 The connection termination is complete.
0 7000 No job processing active.
0 7001 ● Start execution of the job

● Establish connection
● Wait for connection partner

0 7002 Data is being received.
0 7003 Connection is being terminated.
0 7004 ● Connection established and monitored

● No job processing active
0 7006 Data is currently being received.
1 8085 ● The LEN parameter is larger than the highest permitted value.

● The value at the LEN or DATA parameter was changed after the first call.
1 8086 The ID parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the connection 

description.
1 809B The ID of the local device (local_device_id) in the connection description does not correspond to 

the CPU.
1 80A0 Group error for error codes W#16#80A1 and W#16#80A2.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated.

Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A2 Local or remote port is being used by the system.
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ERROR STATUS*
(W#16#...)

Description

1 80A3 ● Attempt being made to re-establish an existing connection.
● Attempt being made to terminate a non-existent connection.

1 80A4 IP address of the remote endpoint of the connection is invalid, in other words, it matches the IP 
address of the local partner.

1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 
complete.

1 80B2 The CONNECT parameter points to a data block that was generated with the attribute "Only store 
in load memory".

1 80B3 Inconsistent parameter assignment: Group error for error codes W#16#80A0 to W#16#80A2, 
W#16#80A4, W#16#80B4 to W#16#80B9.

1 80B4 You have violated one or both of the following conditions for passive connection establishment 
(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = B#16#12): 
"local_tsap_id_len >= B#16#02", and/or "local_tsap_id[1] = B#16#E0".

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
1 80B7

 
Error in one of the following parameters of the data block for connection description: block_length, 
local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, next_staddr_len.

1 80C3 ● All connection resources are in use.
● A block with this ID is already being processed in a different priority group.

1 80C4
 

Temporary communication error:
● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON" instruction.
● The connection used is being terminated by a call with COM_RST= 1.

1 80C6 The remote partner cannot be reached (network error).
1 8722 Error in the CONNECT parameter: Invalid source area (area not declared in data block).
1 873A Error in the CONNECT parameter: Access to connection description is not possible (no access to 

data block).
1 877F Error in the CONNECT parameter: Internal error
1 8922 Parameter DATA: Invalid target area; the area does not exist in the DB.
1 8924 Parameter DATA: Area error in the VARIANT pointer.
1 8932 Parameter DATA: The DB number is too high.
1 893A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 897F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 8A3A Parameter DATA: No access to the data area, for example because the data block does not exist.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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 Note
Error messages of the instructions "TCON", "TRCV" and "TDISCON"

Internally, the TRV_C instruction uses the "TCON (Page 3240)", "TRCV (Page 3256)" and 
"TDISCON (Page 3248)" instructions. The error messages of these instructions are contained 
in the respective descriptions.

 

TRCV_C: Receive data via Ethernet

Description
The "TRCV_C" instruction is executed asynchronously and implements the following functions 
in sequence:

● Setting up and establishing a communication connection

● Receiving data via an existing communication connection

● Terminating or resetting the communication connection

Internally, the instruction "TRCV_C" uses the communication instructions TCON", "TRCV", 
"T_DIAG", "T_RESET" and "TDISCON".

Setting up and establishing a communication connection
The communication connection is set up and established with CONT=1. For information on 
the number of possible communication connections, refer to the technical specifications for 
your CPU. The connection description specified at the CONNECT parameter is used to set up 
the communication connection. The following connection types can be used:

● Programmed connections (structure of connection via "TCON"):

– TCP / UDP: Connection description via the TCON_IP_v4 system data type 

– ISO-on-TCP: Connection description via the TCON_IP_RFC system data type

– ISO: Connection description via the TCON_ISOnative system data type (for CP1543-1 
only)

● Configured connections

– Specify an existing connection in the TCON_Configured system data type.

An existing connection is terminated and the connection which has been set up is removed 
when the CPU goes into STOP mode. To set up and establish the connection again, you must 
execute "TRCV_C" again.

Receiving data via an existing communication connection
Receipt of data is enabled when the EN_R parameter is set to the value "1". The received data 
is entered in a receive area. You specify the length of the receive area either with the LEN 
parameter (if LEN <> 0) or with the length information of the DATA parameter (if LEN = 0), 
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depending on the protocol variant being used. If you use purely symbolic values at the DATA 
parameter, the LEN parameter must have the value "0".

Receive modes of TRCV_C:

● TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV_C" instruction.
You set ad-hoc mode by assigning the value "1" to the ADHOC parameter. All data types 
can be used for data blocks with standard access when you use ad-hoc mode. Only ARRAY 
of BYTE or data types with a length of 8 bits can be used for data blocks with optimized 
access (e.g., CHAR, USINT, SINT, etc.). The data length actually received is output at the 
RCVD_LEN parameter.

● TCP (Receipt of data with specified length)
Assign the value "0" to the ADHOC parameter for receipt of data with specified length. If 
ad-hoc mode is disabled, the data receipt is not complete until the length of data specified 
at the LEN parameter has been completely received. Only then is the data available in the 
receive area (DATA parameter). The actually received data length in bytes at the 
RCVD_LEN parameter corresponds to the data length at the LEN parameter after receipt. 

● ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. The receive area is defined by the LEN and 
DATA parameters. If the receive buffer (DATA parameter) is too small for the sent data, 
"TRCV_C" signals an error. The actually received data length in bytes at the RCVD_LEN 
parameter corresponds to the data length at the LEN parameter after receipt. 

The following table shows how the received data is entered in the receive area.

Protocol variant Availability of data in the receive area connection_type parameter of 
the connection description

LEN parameter

TCP
(Ad-hoc mode)

The data is immediately available. Hexadecimal value: B#16#11
Integer value: 17

1 up to maximum 
length (depending on 
the CPU)

TCP 
(Receipt of data with 
specified length)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented 
data transfer)

The data is available as soon as the 
data length specified at the LEN 
parameter has been fully received.

Hexadecimal value: B#16#12
Integer value: 18

1 to 8192

Terminating the communication connection 
The communication connection is terminated when the CONT parameter is set to "0" even if 
an ongoing data transmission is not complete yet. This does not apply if you are using a 
configured connection, however.

The connection can be reset at any time by setting the parameter COM_RST to "1". This 
terminates the existing communication connection and a new connection is established. If data 
is being transferred at this time, this can lead to data loss.
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Parameters
The following table shows the parameters of the "TRCV_C" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L, T, C 

or constant
Receive enable

CONT Input BOOL I, Q, M, D, L Controls the communication connection:
● 0: Disconnect the communication connection.
● 1: Establish communication connection and 

maintain after receipt of data.
LEN Input UDINT I, Q, M, D, L or 

constant
Maximum length of the data to be received. If you 
use a receive area with optimized access at the 
DATA parameter, the value "0" must be used at the 
LEN parameter.

ADHOC Input BOOL I, Q, M, D, L or 
constant

Optional parameter (hidden)
Use ad-hoc mode for the TCP protocol variant.

CONNECT InOut VARIANT D Pointer to the connection description
● Programmed connection:

– For TCP or UDP, use the structure 
TCON_IP_v4
For description, refer to:Auto-Hotspot

– For ISO-on-TCP, use the structure 
TCON_IP_RFC
For description, refer to: Auto-Hotspot

– For ISO, use the structure TCON_ISOnative 
(only for CP1543-1)
For description, refer to instruction "TCON 
(Page 3243)": "Structure of the connection 
description according to  TCON_ISOnative"

● Configured connection:
– For existing connections, use the 

TCON_Configured system data type. For a 
description, see "System data type for 
configured connections" below.

DATA InOut VARIANT I, Q, M, D, L Pointer to the receive area.
ADDR InOut VARIANT D Optional parameter (hidden)

Pointer to the address of the sender with 
connection type UDP.

COM_RST InOut BOOL I, Q, M, D, L Optional parameter (hidden)
Resets the connection:
● 0: Irrelevant
● 1: The existing connection is reset.
The COM_RST parameter is reset after evaluation 
by the "TRCV_C" instruction and should not, 
therefore, be interconnected statically.
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Parameter Declaration Data type Memory area Description
DONE Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: Receipt not yet started or still in progress.
● 1: Receipt executed without error. This state is 

only displayed for one cycle.
The output parameter DONE is set if an 
intermediate step was completed successfully 
during processing (connection establishment, 
receipt, connection termination) and if the 
execution of "TRCV_C" was completed 
successfully.

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Receipt not yet started or already completed.
● 1: Receipt not yet completed. A new send job 

cannot be started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred during connection 

establishment, data receipt or connection 
termination.

The output parameter ERROR can be set due to 
an error in the "TRCV_C" instruction or the 
communication instructions used internally.

STATUS Output WORD I, Q, M, D, L Status of the instruction
RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

EN_R, CONT and COM_RST parameters
The parameter CONT controls the connection establishment of the "TRCV_C" instruction 
regardless of the EN_R parameter. The behavior of the CONT parameter partially depends 
on whether a programmed or a configured connection is used:

● With CONT = "0": No data is received (regardless of whether a programmed or a configured 
connection is used).

● When changing CONT = "0" to "1":

– With a programmed connection, it is established with "TCON".

– With a configured connection, it is checked with "T_DIAG".

● With CONT = "1":

– As long as no data is received (EN_R="0"), the connection is checked with "T_DIAG".

– If the internally used communication instructions signal that no connection end point 
exists, the connection is automatically reestablished with "TCON".

● When changing CONT = "1" to "0":

– With a programmed connection, it is terminated with "TDISCON".

– With a configured connection, it is reset with "T_RESET".
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The parameter COM_RST resets the connection when changing from "0" to "1":

● If a connection is established, it is reset with "T_RESET" (regardless of whether a 
programmed or configured connection is used).

● If no connection is established, the setting of the parameter has no effect.

The EN_R and COM_RST parameters only have an effect if CONT has been set to "1". The 
following table shows the relationship between the  EN_R, CONT  and  COM_RST parameters:

EN_R CONT COM_
RST

Status of the 
instruction

Description

irreleva
nt

0 irreleva
nt

Not yet executed No job active (STATUS = 7000).

irreleva
nt

0 irreleva
nt

Initialization Connection is being terminated. The instruction is being reset.

irreleva
nt

0 > 1 irreleva
nt

Connection 
establishment

Connection is being established. Data is not being transferred yet.

0 1 0 Connection 
established

The connection is established and is monitored with the instruction 
"T_DIAG".

irreleva
nt

1 0 > 1 Connection 
established

The connection is interrupted by "T_RESET" briefly and reset.

0 > 1 1 0 Connection 
established

Instruction starts receiving.

irreleva
nt

1 0 > 1 Data is being 
received

Data transmission is interrupted. The connection is being reset.

System data type for configured connections
For configured connections at the CONNECT parameter, use the following structure for 
connection description to TCON_Configured:

Byte Parameter Data type Start value Description
0 … 1 InterfaceID HW_ANY - Hardware identifier of the local interface (value range: 0 to 

65535).
2 … 3 ID CONN_OUC - Reference to the connection (value range: 1 to 4095).

Enter the connection ID of the existing connection.
4 ConnectionType BYTE - Connection type

Select 254 (decimal) for a configured connection.

BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TRCV_C". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:
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DONE BUSY ERROR Description
0 0 0 The instruction has not been executed yet (no rising edge at EN_R parameter).
0 1 0 The instruction is being executed and calls the internally used communication instructions.
1 0 0 The receipt has been completed successfully. "0000" is output at the STATUS parameter. 

DONE = "1" is only displayed for one cycle.
0 0 1 The execution of the instruction or an intermediate step during processing was terminated 

with an error. If there is a subsequent error due to an internally used communication 
instruction, the error that occurred first during processing is displayed. This state is only 
displayed for one cycle.

ERROR and STATUS parameters

ERROR STATUS
(W#16#...)

Description

0 0000 Receive job executed without error.
0 0001 Communication connection established.
0 0003 Communication connection closed.
0 7000 No job processing active.
0 7001 Initial call for establishing a connection.
0 7002 Second call for establishing a connection.
0 7003 Communication connection is being terminated.
0 7004 Communication connection has been established and is being monitored. No receive job 

processing active.
0 7006 Data is currently being received.
1 8085 ● The LEN parameter is larger than the highest permitted value.

● The value at the LEN or DATA parameter was changed after the first call.
1 8086 The ID parameter is outside the permitted range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8088 The value at the LEN parameter does not correspond to the receive area set at the DATA parameter.
1 8089 The CONNECT parameter does not point to a data block.
1 8091 Maximum nesting depth exceeded.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the connection 

description.
1 809B InterfaceID is invalid. It is either zero or it does not point to a local CPU interface or a CP.
1 80A1 ● Connection or port already being used by user.

● Communication error:
– The specified connection has not yet been established.
– The specified connection is being terminated.

Transfer via this connection is not possible.
– The interface is being re-initialized.

1 80A3 The nested "T_DIAG" instruction has reported that the connection has closed.
1 80A4 IP address of the remote endpoint of the connection is invalid or it matches the IP address of the 

local partner.
1 80A7 Communication error: You called the instruction with COM_RST = 1 before the send job was 

complete.
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ERROR STATUS
(W#16#...)

Description

1 80B4 You have violated one or both of the following conditions for passive connection establishment 
(active_est = FALSE) when using the ISO-on-TCP protocol variant (connection_type = B#16#12): 
"local_tsap_id_len >= B#16#02", and/or "local_tsap_id[1] = B#16#E0".

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error in the connection_type parameter of the data block for connection 

description.
1 80B7

 
Error in one of the following parameters of the data block for connection description: block_length, 
local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, next_staddr_len.

1 80C3 ● All connection resources are in use.
● A block with this ID is already being processed in a different priority group.

1 80C4
 

Temporary communication error:
● The connection cannot be established at this time.
● The interface is receiving new parameters or the connection is being established.
● The configured connection is currently being removed by a "TDISCON" instruction.
● The connection used is being terminated by a call with COM_RST = 1.

1 80C6 The remote partner cannot be reached (network error).
1 8722 Error in the CONNECT parameter: Invalid source area (area not declared in data block).
1 873A Error in the CONNECT parameter: Access to connection description is not possible (no access to 

data block).
1 877F Error in the CONNECT parameter: Internal error
1 8922 Parameter DATA: Invalid target area; the area does not exist in the DB.
1 8924 Parameter DATA: Area error in the VARIANT pointer.
1 8932 Parameter DATA: The DB number is too high.
1 893A Parameter CONNECT: Access to specified connection data not possible (e.g. because the DB 

does not exist).
1 897F Parameter DATA: Internal error, e.g. invalid VARIANT reference.
1 8A3A Parameter DATA: No access to the data area, for example because the data block does not exist.

 

 Note
Error messages of the instructions "TCON", "TRCV" and "TDISCON"

Internally, the TRV_C instruction uses the "TCON (Page 3243)", "TRCV (Page 3256)" and 
"TDISCON (Page 3248)" instructions. The error messages of these instructions are contained 
in the respective descriptions.

 

See also
TSEND_C: Send data via Ethernet (Page 3211)
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TMAIL_C: Transfer email

Description of TMAIL_C

Description
You use the instruction "TMAIL_C" to send an e-mail via the Ethernet interface of the S7-1500 
CPU or S7-1200 V4.0, a communication module (CM), or of a communication processor (CP).

The instruction can only be used once the hardware has been configured and if the network 
infrastructure allows for a communication connection to the mail server.

You define the content of the e-mail, and the connection data, using the following parameters:

● You define the recipient addresses with the parameters TO_S and CC.

● You define the content of the e-mail with the parameters SUBJECT and TEXT.

● You can define an attachment using VARIANT pointers at the ATTACHMENT and 
ATTACHMENT_NAME parameters.

● The connection data is defined, and addressing and authentication for the mail server 
executed, using the system data type Tmail_v4, Tmail_v6 or Tmail_FQDN at the 
MAIL_ADDR_PARAM parameter.

– If you are using the interface of the S7-1500 CPU, the system data type Tmail_v4 must 
be used. In this case, the e-mail can only be sent via SMTP.

– Any of the system data types can be used if you are using the interface of a CM/CP. 
The e-mail can then also be sent via SMTPS.

● You start the sending of an e-mail with an edge change from "0" to "1" for the REQ 
parameter. 

● The job status is indicated by the output parameters "BUSY", "DONE", "ERROR" and 
"STATUS".

You cannot send an SMS directly with the "TMAIL_C" instruction. Whether or not the e-mail 
can be forwarded by the mail server as an SMS depends on your telecommunications provider.

Operation of the instruction
The "TMAIL_C" instruction works asynchronously, which means its execution extends over 
multiple calls. You must specify an instance when you call the instruction "TMAIL_C". 

In the following cases, the connection to the mail server will be lost:

● If the CPU switches to STOP while "TMAIL_C" is active.

● If communication problems occur at the Industrial Ethernet bus. 
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In this case, the transfer of the e-mail will be interrupted and it will not reach its recipient. The 
connection is also canceled once the instruction has been successfully executed and the e-
mail sent.

 

 NOTICE

Changing user programs

You can change the parts of your user program that directly affect calls of "TMAIL_C" only:
● The CPU is in "STOP" mode.
● No e-mail is being sent (REQ = 0 and BUSY = 0).

This relates, in particular, to deleting and replacing program blocks that contain "TMAIL_C" 
calls or calls for the instance of "TMAIL_C".

Ignoring this restriction can tie up connection resources. The automation system can change 
to an undefined status with the TCP/IP communication functions via Industrial Ethernet.

A warm or cold restart of the CPU is required after the changes are transferred.
 

Data consistency
The TO_S, CC, SUBJECT, TEXT, ATTACHMENT and  MAIL_ADDR_PARAM parameters are 
applied by the "TMAIL_C" instruction while it is running, which means that they may only be 
changed after the job has been completed (BUSY = 0).

SMTP authentication 
Authentication refers here to a procedure for verifying identity, for example, with a password 
query. 

If you are using the S7-1500 CPU interface, the instruction "TMAIL_C" supports the SMTP 
authentication procedure AUTH-LOGIN which is required by most mail servers. For information 
about the authentication procedure of your mail server, please refer to your mail server manual 
or the website of your Internet service provider. 

● Before you can use the AUTH-LOGIN authentication procedure, the "TMAIL_C" instruction 
requires the user name with which it is to log on to the mail server. This user name 
corresponds to the user name with which you set up a mail account on your mail server. It 
is transferred via the UserName parameter to the structure at parameter 
MAIL_ADDR_PARAM.
If no user name is specified at the MAIL_ADDR_PARAM parameter, the AUTH-LOGIN 
authentication procedure is not used. The e-mail is then sent without authentication.

● To log on, the "TMAIL_C" instruction also requires the associated password. This password 
corresponds to the password you specified when you set up your mail account. It is 
transferred via the PassWord parameter to the structure at parameter 
MAIL_ADDR_PARAM. 
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Parameters
The following table shows the parameters of the "TMAIL_C" instruction:

Parameter Declaratio
n

Data type Memory area Description

REQ Input BOOL I, Q, M, D, L, 
T, C or 
constant

Control parameter REQUEST: Activates the 
sending of an e-mail upon a rising edge.

TO_S 
(Page 3233)

Input STRING D, L or 
constant

Recipient addresses
STRING with a maximum length of 240 
characters (bytes). 
For the e-mail address format, see the 
example in the parameter description.

CC 
(Page 3233)

Input STRING D, L or 
constant

CC recipient addresses (optional)
STRING with a maximum length of 240 
characters (bytes). 
Same e-mail address format as for the TO_S 
parameter. If an empty string is assigned 
here, the e-mail is not sent to a CC recipient.

SUBJECT Input STRING D, L or 
constant

Subject of the e-mail
STRING with a maximum length of 240 
characters (bytes).

TEXT Input STRING D, L or 
constant

Text of the e-mail (optional)
STRING with a maximum length of 240 
characters (bytes). If an empty string is 
assigned at this parameter, the e-mail is sent 
without text.

ATTACHMEN
T

Input VARIANT D E-mail attachment (optional)
Reference to a byte/word/double word field 
(ArrayOfByte, ArrayOfWord or 
ArrayOfDWord) with a maximum length of 
64 bytes. If no value is assigned, the e-mail 
is sent without an attachment.

ATTACHMEN
T_NAME

Input STRING D, L or 
constant

E-mail attachment name (optional)
Reference to a character string with a 
maximum length of 50 characters (bytes) to 
define the file name of the attachment. If an 
empty string is assigned at this parameter, 
the e-mail attachment will be sent with the 
file name "attachment.bin".

MAIL_ADDR_
PARAM 
(Page 3234)

Input VARIANT D Connection parameter and address of the e-
mail server
To define the connection parameters, use 
the structure Tmail_v4, Tmail_v6 or 
Tmail_FQDN (see parameter description).

DONE 
(Page 3236)

Output BOOL I, Q, M, D, L Status parameter
● DONE = 0: Job not yet started or still 

executing.
● DONE = 1: Job was executed without 

errors.
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Parameter Declaratio
n

Data type Memory area Description

BUSY 
(Page 3236)

Output BOOL I, Q, M, D, L Status parameter
● BUSY=0: The processing of "TMAIL_C" 

was stopped.
● BUSY = 1: E-mail transmission is not yet 

complete.
ERROR 
(Page 3236)

Output BOOL I, Q, M, D, L Status parameter
● ERROR = 0: No error has occurred.
● ERROR = 1: An error occurred during 

processing. STATUS supplies detailed 
information on the type of error.

STATUS 
(Page 3237)

Output WORD I, Q, M, D, L Status parameter
Return value or error information of the 
"TMAIL_C" instruction (see parameter 
description).

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

 

 Note
Optional parameters

The optional parameters CC, TEXT, and ATTACHMENT are only sent with the e-mail if the 
corresponding parameters contain a string of length > 0.

 

TO_S and CC parameters

Description
The TO_S and CC parameters are strings, for example, with the following content:

● <wenna@mydomain.com>, <ruby@mydomain.com>

● <admin@mydomain.com>, <judy@mydomain.com>

 

Note the following rules when entering the parameters:

● A space and an opening pointed bracket "<" must be entered before each address.

● A closing pointed bracket ">" must be entered after each address.

● A comma must be entered between the addresses in TO and CC.

For runtime and memory space reasons, the "TMAIL_C" instruction does not perform a syntax 
check of parameter TO_S or CC.
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MAIL_ADDR_PARAM parameter

Description
At the MAIL_ADDR_PARAM parameter, you define the connection for sending the e-mail in 
the structure Tmail_v4, Tmail_v6 or Tmail_FQDN, and save the e-mail server address and 
login details.

The structure you use at the MAIL_ADDR_PARAM parameter depends on the format in which 
the e-mail server is to be addressed:

● Tmail_v4: Addressing by IP address (IPv4).

● Tmail_v6: Addressing by IP address (IPv6).

● Tmail_FQDN: Addressing by fully qualified domain name (FQDN).

Which structure you can use depends on the interface addressed at the InterfaceId parameter:

● If you want to use the "TMAIL_C" instruction with the internal interface, the structure 
Tmail_v4 must be used at the MAIL_ADDR_PARAM parameter.

● If you are using a communication processor (CP) or communication module (CM), you can 
use all three addressing options (IPv4, IPv6 and FQDN).

Table 9-97 Tmail_v4: Addressing the mail server by IP address (IPv4)

Parameter Data type Description
Tmail_v4 Struct  
 InterfaceId LADDR Hardware identifier of the interface

ID CONN_OUC Connection ID
ConnectionType BYTE Connection type. Select 16#20 as the connection type for 

IPv4.
ActiveEstablished BOOL Status bit. Set to "1" once the connection is established.
CertIndex BYTE ● =0: SMTP used (Simple Mail Transfer Protocol). SMTP 

must be used if the e-mail is being sent via the interface 
of an S7-1500 CPU.

● ≠0: SMTPS used to secure the connection before it is 
established (with CPs/CMs). You use the CertIndex 
parameter to specify the certificate to be used (see 
"Project navigation" > "Global security settings" > 
"Certificate manager").

WatchDogTime TIME Execution watchdog. Use this parameter to define the 
maximum execution time for the send operation.
Note: Connection establishment can take longer (approx. 
one minute) if the connection is slow. When you specify the 
WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
The connection is terminated once the specified time has 
elapsed.

MailServerAddress IP_v4 IP address of the mail server. IPv4 in the following format: 
XXX.XXX.XXX.XXX (decimal). 
Example: 192.142.131.237.

UserName STRING[254] Mail server login name
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Parameter Data type Description
PassWord STRING[254] Mail server password
From EMAIL_ADDR E-mail sender address, which is defined using the following 

two STRING parameters. For example: 
"myname@mymailserver.com".

 LocalPartPlusAtSi
gn

STRING[64] Local part of sender address, including @ sign. Example: 
"myname@".

FullQualifiedDom
ainName

STRING[254] Fully Qualified Domain Name ( FQDN for short) of the mail 
server. Example: "mymailserver.com".

Table 9-98 Tmail_v6: Addressing the mail server by IP address (IPv6)

Parameter Data type Description
Tmail_v6 Struct  
 InterfaceId LADDR Hardware identifier of the interface

ID CONN_OUC Connection ID
ConnectionType BYTE Connection type. Select 16#21 as the connection type for 

IPv6.
ActiveEstablished BOOL Status bit. Set to "1" once the connection is established.
CertIndex BYTE ● =0: SMTP used (Simple Mail Transfer Protocol). SMTP 

must be used if the e-mail is being sent via the interface 
of an S7-1500 CPU.

● ≠0: SMTPS used to secure the connection before it is 
established (with CPs/CMs). You use the CertIndex 
parameter to specify the certificate to be used (see 
"Project navigation" > "Global security settings" > 
"Certificate manager").

WatchDogTime TIME Execution watchdog. Use this parameter to define the 
maximum execution time for the send operation.
Note: Connection establishment can take longer (approx. 
one minute) if the connection is slow. When you specify the 
WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
The connection is terminated once the specified time has 
elapsed.

MailServerAddress IP_v6 IP address of the mail server (IPv6) in the following format: 
XXXX.XXXX.XXXX.XXXX.XXXX.XXXX.XXXX.XXXX 
(hexadecimal). 
The address is divided into 8 blocks of 2 bytes each (16 bytes 
in total). 
Example: 2001:db8:1f11:08d3:290:27ff:0370:2093

UserName STRING[254] Mail server login name
PassWord STRING[254] Mail server password
From EMAIL_ADDR E-mail sender address, which is defined using the following 

two STRING parameters. For example: 
"myname@mymailserver.com".

 LocalPartPlusAtSi
gn

STRING[64] Local part of sender address, including @ sign. Example: 
"myname@".

FullQualifiedDom
ainName

STRING[254] Fully Qualified Domain Name ( FQDN for short) of the mail 
server. Example: "mymailserver.com".
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Table 9-99 Tmail_FQDN: Addressing the mail server by FQDN

Parameter Data type Description
Tmail_v6 Struct  
 Tmail_FQDN LADDR Hardware identifier of the interface

ID CONN_OUC Connection ID
ConnectionType BYTE Connection type. Select 16#22 as the connection type for 

FQDN.
ActiveEstablished BOOL Status bit. Set to "1" once the connection is established.
CertIndex BYTE ● =0: SMTP used (Simple Mail Transfer Protocol). SMTP 

must be used if the e-mail is being sent via the interface 
of an S7-1500 CPU.

● ≠0: SMTPS used to secure the connection before it is 
established (with CPs/CMs). You use the CertIndex 
parameter to specify the certificate to be used (see 
"Project navigation" > "Global security settings" > 
"Certificate manager").

WatchDogTime TIME Execution watchdog. Use this parameter to define the 
maximum execution time for the send operation.
Note: Connection establishment can take longer (approx. 
one minute) if the connection is slow. When you specify the 
WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
The connection is terminated once the specified time has 
elapsed.

MailServerAddress STRING[254] FQDN (Fully Qualified Domain Name) of the mail server. The 
mail server is addressed using the fully qualified domain 
name. 
Example: "www.mymailserver.com.".

UserName STRING[254] Mail server login name
PassWord STRING[254] Mail server password
From Struct E-mail sender address, which is defined using the following 

two STRING parameters. For example: 
"myname@mymailserver.com".

 LocalPartPlusAtSi
gn

STRING[64] Local part of sender address, including @ sign. Example: 
"myname@".

FullQualifiedDom
ainName

STRING[254] Fully Qualified Domain Name ( FQDN for short) of the mail 
server. Example: "mymailserver.com".

DONE, BUSY and ERROR parameters

Description
The output parameters DONE, BUSY and ERROR are each displayed for only one cycle if the 
status of the BUSY output parameter changes from "1" to "0".

The following table shows the relationship between DONE, BUSY, and ERROR. Using this 
table, you can determine the current status of the instruction "TMAIL_C and when the sending 
of the e-mail is complete.
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DONE BUSY ERRO
R

Description

0 1 0 The job is being processed.
1 0 0 Job successfully completed.
0 0 1 The job ended with an error. The cause of the error can be found in the 

STATUS (Page 3237) parameter.
0 0 0 The "TMAIL_C" instruction was not assigned a (new) job.

STATUS parameter

Description
The following table shows the return values of "TMAIL_C" at the STATUS parameter:

Return value
STATUS*
(W#16#...):

Explanation Notes

0000 The processing of "TMAIL_C" was 
completed without errors.

Error-free completion of "TMAIL_C" does not 
mean that the e-mail sent will necessarily 
arrive. 
Incorrectly entering the recipient addresses 
does not generate a status error of the 
"TMAIL_C" instruction. In this case, there is no 
guarantee that the e-mail will be sent to other 
recipients, even if these were entered correctly.

7001 "TMAIL_C" is active (BUSY = 1). First call: Job triggered.
7002 "TMAIL_C" is active (BUSY = 1). Intermediate call: Job already active.
8xxx The processing of "TMAIL_C" was 

completed with an error code of the 
communication instructions called 
internally.

For detailed information, please refer to the 
STATUS parameter descriptions for the 
"TCON (Page 3243)", "TDISCON 
(Page 3248)", "TSEND (Page 3253)" and 
"TRCV (Page 3256)" communication 
instructions.

8010 Error during connection establishment You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the "TCON 
(Page 3243)" instruction.

8011 Error sending the data You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the 
"TSEND (Page 3253)" instruction.

Programming the PLC
9.7 References

WinCC Professional V13.0
System Manual, 02/2014 3237



Return value
STATUS*
(W#16#...):

Explanation Notes

8012 Error receiving the data You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the "TRCV 
(Page 3256)" instruction.

8013 Error during connection establishment You will find further information on evaluation in
the SFB_STATUS parameter of the instance 
data block. The error code displayed at the 
SFB_STATUS parameter is explained in the 
STATUS parameter description for the TCON 
(Page 3243)" and "TDISCON (Page 3248)" 
instructions.

8014 Establishment of a connection is not 
possible.

You may have entered an incorrect mail server 
IP address (MailServerAddress (Page 3234)) 
or too short a time span (WatchDogTime 
(Page 3234)) for connection establishment. It is 
also possible that the CPU has no connection 
to the network or that the CPU configuration is 
incorrect.

8015 Incorrect data type for 
MAIL_ADDR_PARAM

The only valid data types are the system data 
types (structures) Tmail_v4, Tmail_v6 and 
TMail_FQDN.

8016 Incorrect data type for the 
ATTACHMENT parameter

The only valid data types are ArrayOfByte, 
ArrayOfWord and ArrayOfDWord.

8017 Incorrect data length for the 
ATTACHMENT parameter

Data length must be <= 65534 bytes.

8401 No channels available. Possible 
cause: There is already an e-mail 
connection via the CP. A second 
connection cannot be established in 
parallel.

Specific error for CP 1543

8403 A TCP/IP connection to the mail server 
was not possible.

Specific error for CP 1543

8405 Server has denied login request. Specific error for CP 1543
8406 SMTP client has detected an internal 

SSL error or a problem with the 
certificate structure.

Specific error for CP 1543

8407 Request to use SSL denied. Specific error for CP 1543
8408 Client unable to identify socket for 

establishing a TCP/IP connection to 
the mail server.

Specific error for CP 1543

8409 Writing via the connection not 
possible. Possible cause: The 
communication partner has reset the 
connection or the connection has been 
lost.

Specific error for CP 1543
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Return value
STATUS*
(W#16#...):

Explanation Notes

8410 Reading via the connection not 
possible. Possible cause: The 
communication partner has reset the 
connection or the connection has been 
lost.

Specific error for CP 1543

8411 E-mail could not be sent. Cause: 
Insufficient memory space to execute 
the send operation.

Specific error for CP 1543

8412 DNS server configured was unable to 
resolve the specified domain name.

Specific error for CP 1543

8413 An internal error in the DNS 
subsystem prevented domain name 
resolution.

Specific error for CP 1543

8414 Empty character string entered as 
domain name.

Specific error for CP 1543

8415 An internal error has occurred in the 
cURL module. Execution was stopped.

Specific error for CP 1543

8416 An internal error has occurred in the 
SMTP module.  Execution was 
stopped.

Specific error for CP 1543

8417 Request to SMTP on a channel 
already in use or invalid channel ID. 
Execution was stopped.

Specific error for CP 1543

8418 E-mail send job aborted. Possible 
causes: Execution time exceeded 
(WatchDogTime parameter) or CP 
transition from start to stop.

Specific error for CP 1543

8419 Channel interrupted and cannot be 
used before the connection is closed.

Specific error for CP 1543

8420 Server certificate string could not be 
verified with CP root certificate.

Specific error for CP 1543

8421 Internal error occurred. Execution was 
stopped.

Specific error for CP 1543

82xx, 84xx, 
or 85xx

The error message originates from the 
mail server and corresponds, except 
for the "8", to the error number of the 
SMTP protocol.
The following lines list several error 
codes that can occur.

You will find more detailed information on the 
SMTP error code and other error codes in the 
SMTP protocol on the Internet or in the error 
documentation of the mail server. You can also 
view the most recent error message from the 
mail server in your instance DB in the 
BUFFER1 parameter. You will find the last data 
sent by the "TMAIL_C" instruction under 
DATEN in the instance DB.

8450 Action not executed: Mailbox not 
available/cannot be reached

Try again later.

8451 Action aborted: Local processing error Try again later.
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Return value
STATUS*
(W#16#...):

Explanation Notes

8500 Syntax error: Error not recognized. 
This also includes the error when a 
command string is too long. This can 
also occur when the e-mail server 
does not support the LOGIN 
authentication procedure.

Check the parameters of "TMAIL_C". Try to 
send an e-mail without authentication. To do 
this, replace the content of the UserName 
parameter with an empty string. If no user name 
is specified, the LOGIN authentication 
procedure is not used.

8501 Syntax error: Incorrect input at a 
parameter

Possible cause: Incorrect address at the TO_S 
or CC parameter (see also: TO_S and CC 
parameters (Page 3233)).

8502 Command unknown or not 
implemented

Check your entries, in particular the FROM 
parameter. It may be incomplete and you may 
have forgotten the "@" or "." (see also: TO_S 
and CC parameters (Page 3233)).

8504 Command parameters not 
implemented

Check your entries, in particular the FROM 
parameter. It may be incomplete and you may 
have forgotten the "@" or "." (see also: TO_S 
and CC parameters (Page 3233)).

8535 SMTP authentication 
incomplete                        

You have possibly entered an incorrect user 
name or incorrect password.

8550 Mail server cannot be reached. You 
have no access rights.

You may have entered an incorrect user name 
or password, or the mail server may not support 
your login. Another cause of error could be a 
mistake in the domain name after the "@" or a 
missing "." at the TO_S, CC and FROM 
parameters (see also: TO_S and CC 
parameters (Page 3233)).

8552 Action aborted: Assigned memory size 
has been exceeded                         

Try again later.

8554 Transfer failed Try again later.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For 
additional information on toggling display formats, refer to "See also".

Other

TCON: Establishing a communication connection

TCON: Establish communication connection

Description
You use the "TCON" instruction to set up and establish a communication connection. Once 
the connection has been set up and established, it is automatically maintained and monitored 
by the CPU. "TCON" is executed asynchronously.

The connection data specified for the CONNECT and ID parameters are used to set up the 
communication connection. To establish the connection, a rising edge must be detected at the 
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REQ parameter. Once the connection is successfully established, the DONE parameter is set 
to "1".

Number of possible connections
For information on the number of possible communication connections, refer to the technical 
specifications for your CPU.

Connection with TCP and ISO-on-TCP
Both communication partners call the "TCON" instruction to set up and establish the 
communication connection. During parameter assignment, you specify which partner is the 
active communication end point and which is the passive one.

If the connection aborts, for example due to a line break or due to the remote communication 
partner, the active partner attempts to reestablish the configured connection. You do not have 
to call "TCON" again. This applies only if "TCON" has been executed successfully once (DONE 
= 1).

An existing connection is terminated and the connection set up is removed when the 
"TDISCON (Page 3248)" instruction is executed or when the CPU changes to STOP mode. 
To set up and establish the connection again, you will need to execute "TCON" again.

Parameters
The following table shows the parameters of the "TCON" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the job to establish the connection 
specified in the ID upon a rising edge.

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the assigned connection.
Range of values: W#16#0001 to W#16#0FFF

CONNECT InOut TCON_Param D Pointer to the connection description
See also: Auto-Hotspot 

DONE Output BOOL I, Q, M, D, L Status parameter with the following values: 
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot 

be started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. You use the DONE parameter to check 
whether or not a job has been executed successfully. The ERROR parameter is set when 
errors occurred during execution of "TCON". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Connection successfully established.
0 7000 No job processing active
0 7001 Start job execution, establish connection.
0 7002 Connection is being established (REQ irrelevant).
1 8085 Connection ID (ID parameter) is already being used by a configured connection.
1 8086 The ID parameter is outside the valid range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8089 The CONNECT parameter does not point to a data block.
1 809A The CONNECT parameter points to a field that does not correspond to the length of the 

connection description.
1 809B The element InterfaceId within the TCON_xxx structure does not reference a hardware identifier 

of a CPU or CM/CP interface or has the value "0". 
1 80A0 Group error for error codes W#16#80A1 and W#16#80A2.
1 80A2 Local or remote port is being used by the system.
1 80A3 Attempt being made to re-establish an existing connection.
1 80A4 IP address of the remote endpoint of the connection is invalid, in other words, it matches the IP 

address of the local partner.
1 80A5 Connection ID is already in use.
1 80A7 Communication error: You executed "TDISCON (Page 3248)" before "TCON" had completed. 
1 80B2 The CONNECT parameter points to a data block that was generated with the attribute "Only 

store in load memory".
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ERROR STATUS* 
(W#16#...)

Explanation

1 80B4 You have violated one or more of the following conditions for passive connection establishment 
with the ISO-on-TCP protocol variant (connection_type = B#16#12):
● local_tsap_id_len >= B#16#02
● local_tsap_id[1] = B#16#E0
● With local_tsap_id_len >= B#16#03, local_tsap_id[1] is an ASCII character.
● local_tsap_id[1] is an ASCII character and local_tsap_id_len >= B#16#03.

1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP.
1 80B6 Parameter assignment error at the connection_type parameter of the SDT TCON_Param.
1 80B7 Error in one of the following parameters of the data block for connection description: 

block_length, local_tsap_id_len, rem_subnet_id_len, rem_staddr_len, rem_tsap_id_len, 
next_staddr_len.

1 80B8 Connection description of the structure element ID and the block parameter ID are not identical.
1 80C3 All connection resources are in use.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is currently receiving new parameters.
● The configured connection is currently being removed by a "TDISCON (Page 3248)" 

instruction.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TCON: Establish communication connection

Description
You use the "TCON" instruction to set up and establish a communication connection. Once 
the connection has been set up and established, it is automatically maintained and monitored 
by the CPU. "TCON" is executed asynchronously.

The connection data specified for the CONNECT and ID parameters are used to set up the 
communication connection. 

● At the CONNECT parameter, if possible, only use the predefined structures as created by 
the connection parameter assignment in the Inspector window of the program editor. 

● If the CONNECT parameter is not interconnected with a structure listed in the parameter 
table or if the structure includes an error, the error code 8089 is output at the STATUS 
parameter.

To establish the connection, a rising edge must be detected at the REQ parameter. Once the 
connection is successfully established, the DONE parameter is set to "1".

The instruction "TCON" V3.0 can also be used with CPU S7-1200, Version 4.0 or later.

Number of possible connections
For information on the number of possible communication connections, refer to the technical 
specifications for your CPU.
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Connection with TCP and ISO-on-TCP
Both communication partners call the "TCON" instruction to set up and establish the 
communication connection. During parameter assignment, you specify which partner is the 
active communication end point and which is the passive one.

If the connection aborts, for example due to a line break or due to the remote communication 
partner, the active partner attempts to reestablish the configured connection. You do not have 
to call "TCON" again. This applies only if "TCON" has been executed successfully once (DONE 
= 1).

An existing connection is terminated and the connection set up is removed when the 
"TDISCON (Page 3248)" instruction is executed or when the CPU changes to STOP mode. 
To set up and establish the connection again, you will need to execute "TCON" again.

Parameters
The following table shows the parameters of the "TCON" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the job to establish the connection 
specified on a rising edge.
 

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the assigned connection.
Range of values: W#16#0001 to W#16#0FFF

CONNECT InOut VARIANT D Pointer to the connection description
● For TCP or UDP, use the structure 

TCON_IP_v4
For description, refer to: Auto-Hotspot 

● For ISO-on-TCP, use the structure 
TCON_IP_RFC
For description, refer to: Auto-Hotspot

● For ISO, use the structure 
TCON_ISOnative (only for CP1543-1)
For description, refer to: "Structure of the 
connection description according to  
TCON_ISOnative"

DONE Output BOOL I, Q, M, D, L Status parameter with the following values: 
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot 

be started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. You use the DONE parameter to check 
whether or not a job has been executed successfully. The ERROR parameter is set when 
errors occurred during execution of "TCON". The error information is output at the STATUS 
parameter.

The instruction "TCON" generates an error message in version 3.0 if an active connection 
establishment to a remote partner fails. Create a rising edge at the REQ parameter to establish 
a connection once again.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

Structure of the connection description according to TCON_ISOnative
A connection description DB with a structure according to  TCON_ISOnative is used to assign 
the communication connection parameters for ISO. The fixed data structure of the 
TCON_ISOnative contains all parameters that are required to establish the connection. 

Byte Parameter Data type Start value Description
0 … 
1

InterfaceId HW_ANY 64 Hardware identifier of the local interface (value range: 0 to 
65535).

2 … 
3

ID CONN_OUC 1 Reference to this connection (unique ID in the value range: 
1 to 4095).

4 ConnectionType BYTE 16#16 Connection type: ISO
5 ActiveEstablished BOOL TRUE ID for the manner in which the connection is established:

● FALSE: Passive connection establishment
● TRUE: Active connection establishment

8 … 
13

RemoteMacAddress ARRAY [1..6] of 
BYTE

- MAC address of the partner end point, for example, for 
00-74-41-FD-AE-84: 
● MacAddr[1] = 00
● MacAddr[2] = 74
● MacAddr[3] = 41
● MacAddr[4] = FD
● MacAddr[5] = AE
● MacAddr[6] = 84
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Byte Parameter Data type Start value Description
14 ..
. 19

LocalMacAddress ARRAY [1..6] of 
BYTE

- MAC address of the local end point, for example, for 
00-74-41-FD-AE-84: 
● MacAddr[1] = 00
● MacAddr[2] = 74
● MacAddr[3] = 41
● MacAddr[4] = FD
● MacAddr[5] = AE
● MacAddr[6] = 84

20 ..
. 53

RemoteTSelector Struct - TSelector of the remote connection partner:
● Bytes 20 to 21 = TSelLength
● Bytes 22 to 53:  = TSel[1-32]

 TSelLength UINT - Value range from 0 to 32
TSel ARRAY [1..32] 

of BYTE
- Value range in each case 0 to 255 in bytes

54 ..
. 87

LocalTSelector Struct - TSelector of the remote connection partner:
● Bytes 20 to 21 = TSelLength
● Bytes 22 to 53:  = TSel[1-32]

 TSelLength UINT  Value range from 0 to 32
TSel ARRAY [1..32] 

of BYTE
- Value range in each case 0 to 255 in bytes

88 
… 
89

CrRetransmitionTime UINT - Duration until connection attempt is repeated in seconds.

90 ..
. 91

DataRetransmitionTim
e

UINT 100 ms Duration until data transfer is repeated in milliseconds.

92 ..
. 93

MaxRetransmitionCou
nt

UINT - Maximum number of repetitions.

94 ..
. 95

InactivityTime UINT - in seconds

96 ..
. 97

WindowTime UINT  in seconds

ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Connection successfully established.
0 7000 No job processing active
0 7001 Start job execution, establish connection.
0 7002 Connection is being established (REQ irrelevant).
1 8085 Connection ID (ID parameter) is already being used by a configured connection.
1 8086 The ID parameter is outside the valid range.
1 8087 Maximum number of connections reached; no additional connection possible
1 8089 The CONNECT parameter does not point to a connection description or the connection 

description was created manually.
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ERROR STATUS* 
(W#16#...)

Explanation

1 809A The structure at the CONNECT parameter is not supported or the length is invalid.
1 809B The element InterfaceId within the TCON_xxx structure does not reference a hardware identifier 

of a CPU or CM/CP interface or has the value "0". 
1 80A2 Local or remote port is being used by the system. The following ports are reserved locally: 20, 

21, 80, 102, 135, 161, 162, 443, 34962, 34963, 34964 as well as the area 49152 to 65535.
1 80A3 ID is used by a connection created by the user program, which uses the same connection 

description at the CONNECT parameter.
1 80A4 IP address of the remote endpoint of the connection is invalid or it corresponds to the IP address 

of the local partner.
1 80A7 Communication error: You executed "TDISCON (Page 3248)" before "TCON" had completed. 
1 80B4 Only with TCON_IP_RFC: The local T selector was not specified or the first byte does not contain 

the value 0x0E (only with a length of T selector = 2) or the local T selector starts with "SIMATIC-".
1 80B5 Only passive connection establishment is permitted for connection type 13 = UDP (parameter 

ActiveEstablished of the structure TCON_IP_v4 / TCON_PARAM has the value TRUE).
1 80B6 Parameter assignment error in the ConnectionType parameter of the data block for connection 

description.
● Only valid with TCON_IP_v4: 0x11, 0x0B and 0x13.
● Only valid with TCON_IP_RFC: 0x0C and 0x12

1 80B7 With TCON_IP_v4:
● TCP (active connection establishment): Remote port is "0".
● TCP (passive connection establishment): Local port is "0".
● UDP: Local port is "0".
With TCON_IP_RFC: 
● Local (LocalTSelector) or remote (RemoteTSelector) T selector was specified with a length 

of more than 32 bytes.
● For TSelLength of the T selector (local or remote), a length greater than 32 was entered.
● Error in the length of the IP address of the specific connection partner.

1 80B8 Parameter ID in the local connection description (structure at CONNECT parameter) and 
parameter ID of the instruction are different.

1 80C3 All connection resources are in use.
1 80C4 Temporary communication error:

● The connection cannot be established at this time.
● The interface is currently receiving new parameters.
● The configured connection is currently being removed by a "TDISCON (Page 3248)" 

instruction.
1 80C5 The connection partner refuses to establish the connection, has terminated the connection or 

actively ended it.
1 80C6 The connection partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C8 Value at the ID parameter is already being used by a connection that was created using the user 

program. The connection uses the identical ID, but different connection settings at the parameter 
CONNECT.

1 80C9 Validation of the connection partner failed. The connection partner that wants to establish the 
connection does not match the defined partner of the structure at the CONNECT parameter.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80CE The IP address of the local interface is 0.0.0.0.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TDISCON: Terminate communication connection

Description
The "TDISCON" instruction terminates a communications connection from the CPU to a 
connection partner.

Functional description
"The TDISCON" instruction works asynchronously, which means its job processing extends 
over multiple calls. You start the job for terminating a connection by calling the "TDISCON" 
instruction with REQ = 1.

After "TDISCON" has been successfully executed, the ID specified for "TCON" is no longer 
valid and cannot be used for sending or receiving.

The job status is indicated by the output parameters BUSY and STATUS. Here, STATUS 
corresponds to the output parameter RET_VAL of the asynchronous instructions (see also: 
Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous instructions 
(Page 1852)).

The following table shows the relationship between BUSY, DONE and ERROR. Using this 
table, you can recognize the current status of "TDISCON" or when the establishment of the 
connection is completed.

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 Job successfully completed.
0 0 1 The job ended with an error. The cause of the error can be found in the STATUS 

parameter.
0 0 0 The instruction was not assigned a (new) job.
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Parameters
The following table shows the parameters of the instruction "TDISCON":

Parameter Declaration Data type Memory area Description
S7-1200 S7-1500

REQ Input BOOL I, Q, M, D, L or 
constant

I, Q, M, D, L or 
constant

Control parameter REQUEST starts the 
job for terminating the connection 
specified by ID. The job starts on a rising 
edge.

ID Input CONN_OU
C (WORD)

D, L or constant I, Q, M, D, L or 
constant

Reference to the connection to be 
terminated (connection ID)
Range of values: W#16#0001 to 
W#16#0FFF

DONE Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter: 
● 0: Job not yet started or still executing.
● 1: Job executed without errors

BUSY Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter:
● BUSY = 1: The job is not yet 

completed.
● BUSY = 0: The job is completed or has 

not started yet.
ERROR Output BOOL I, Q, M, D, L I, Q, M, D, L Status parameter:

● ERROR=0: No error.
● ERROR=1: Error occurred during 

processing. STATUS supplies 
detailed information on the type of 
error

STATUS Output WORD I, Q, M, D, L I, Q, M, D, L Status parameter: 
Error information (see "Parameters 
ERROR and STATUS")

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameters ERROR and STATUS

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Connection terminated successfully.
0 7000 No job processing active.
0 7001 Start of job processing, connection being terminated.
0 7002 Intermediate call (REQ irrelevant), connection being terminated.
1 8086 The ID parameter is not in the permitted value range.
1 80A3 Attempt is being made to terminate a non-existent connection or the connection is already 

terminated.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80C4 Temporary communication error: New parameters are being assigned to the interface or the 
connection is currently being established.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TSEND: Send data via communication connection

TSEND: Send data via communication connection

Description
The following description of the "TSEND" instruction is valid for the CPU S7-1200 to version 
3.0.

You use the "TSEND" instruction to send data over an existing communication connection. 
"TSEND" is executed asynchronously.

You specify the send area with the DATA parameter. This includes the address and the length 
of the data to be sent. All data types except BOOL and Array of BOOL can be used for the 
data to be sent.

The send job is executed when a rising edge is detected at the REQ parameter.

With the LEN parameter, you specify the maximum number of bytes sent with a send job.

● When data is transferred with TCP (streaming protocol), the "TSEND" instruction provides 
no information about the length of the data sent to "TRCV (Page 3256)".

● When data is transferred with ISO-on-TCP (message-oriented protocol), the length of the 
data sent is communicated to "TRCV (Page 3256)". The amount of data sent with "TSEND" 
as packet must also be received again at the receiving end ("TRCV (Page 3256)"):

– If the receive buffer is too small for the sent data, an error occurs at the receiving end.

– If the receive buffer is sufficiently large, "TRCV" returns with DONE=1 as soon as the 
data packet is received.

The data to be sent must not be edited until the send job is completed. If the send job executes 
successfully, the DONE parameter is set to "1". Signal state "1" at the DONE parameter is not 
confirmation that the data sent has already been read by the communication partner.

Parameters
The following table shows the parameters of the "TSEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the send job on a rising edge.

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the connection established with "TCON".
Range of values: W#16#0001 to W#16#0FFF
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Parameter Declaration Data type Memory area Description
LEN Input UINT I, Q, M, D, L or 

constant
Maximum number of bytes to be sent with the job.

DATA InOut VARIANT I, Q, M, D Pointer to the send area containing the address and 
the length of the data to be sent. The address 
references:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

LEN and DATA parameters
● With LEN = 0 , all the data specified with the DATA parameter is sent.

● If the number of bytes at the LEN parameter is larger than the length of the data to be sent 
that was defined with the DATA parameter, the error code 8088 is output at the STATUS 
parameter (see description of the STATUS parameter below).

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● With data types STRING and WSTRING, all data is transferred if the parameter LEN = 0. 
When LEN > 0, the length must be at least the maximum number of bytes plus two additional 
bytes which contain the length information. You can find more detailed information on the 
structure of the data types in: "Overview of the valid data types (Page 1320)".

● The maximum number of bytes that can be transmitted is 65534.

● When you use structured tags from optimized DBs, the address of the structured tag should 
be interconnected at the DATA parameter and the parameter LEN = 0. This guarantees 
type-safe transmission of the entire structure if the same structure is used at the receiving 
end.
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BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TSEND". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is specified in the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TSEND" is executed asynchronously, you must keep the data in the send area 
consistent until the DONE parameter or the ERROR parameter changes to the value "1".

 

ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Description

0 0000 Send job completed without error.
0 7000 No job processing active.
0 7001 Start of job execution, data is being sent.

When processing this job, the operating system accesses the data in the DATA send area.
0 7002 Job executing (REQ irrelevant).

When processing this job, the operating system accesses the data in the DATA send area.
1 8085 ● The LEN parameter is greater than the highest permitted value (65536).

● DATA and LEN parameters both have the value "0".
1 8086 The ID parameter is outside the permitted address range (1..0xFFF).
1 8088 The LEN parameter is greater than the area specified in DATA.
1 80A1 Communication error:

● The specified connection has not yet been established.
● The specified connection is being terminated. Transfer via this connection is not possible.
● The interface is being re-initialized.

1 80B3 The protocol variant (ConnectionType parameter in the connection description) is set to UDP. Use 
the instruction "TUSEND" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.
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ERROR STATUS* 
(W#16#...)

Description

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 Connection terminated by the communication partner.
1 80C6 Network error. Communication partner cannot be reached.
1 80C7 Execution timeout.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TSEND: Send data via communication connection

Description
The following description of the "TSEND" instruction is valid for the CPU S7-1500 and S7-1200 
V4.0.

You use the "TSEND" instruction to send data over an existing communication connection. 
"TSEND" is executed asynchronously.

You specify the send area with the DATA parameter. This includes the address and the length 
of the data to be sent. All data types except BOOL and Array of BOOL can be used for the 
data to be sent.

The send job is executed when a rising edge is detected at the REQ parameter.

With the LEN parameter, you specify the maximum number of bytes sent with a send job.

● When data is transferred with TCP (streaming protocol), the "TSEND" instruction provides 
no information about the length of the data sent to "TRCV (Page 3256)".

● When data is transferred with ISO-on-TCP (message-oriented protocol), the length of the 
data sent is communicated to "TRCV (Page 3256)". The amount of data sent with "TSEND" 
as packet must also be received again at the receiving end ("TRCV (Page 3256)"):

– If the receive buffer is too small for the sent data, an error occurs at the receiving end.

– If the receive buffer is sufficiently large, "TRCV" returns with DONE=1 as soon as the 
data packet is received.

The data to be sent must not be edited until the send job is completed. If the send job executes 
successfully, the DONE parameter is set to "1". Signal state "1" at the DONE parameter is not 
confirmation that the data sent has already been read by the communication partner.
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Parameters
The following table shows the parameters of the "TSEND" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the send job on a rising edge.

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the connection established with "TCON".
Range of values: W#16#0001 to W#16#0FFF

LEN Input UDINT I, Q, M, D, L or 
constant

Maximum number of bytes to be sent with the job.

DATA InOut VARIANT I, Q, M, D Pointer to the send area containing the address and 
the length of the data to be sent. The address 
references:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

DONE Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started.
ERROR Output BOOL I, Q, M, D, L Status parameter with the following values:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

LEN and DATA parameters
● With LEN = 0 , all the data specified with the DATA parameter is sent.

● If the number of bytes at the LEN parameter is larger than the length of the data to be sent 
that was defined with the DATA parameter, the error code 8088 is output at the STATUS 
parameter (see description of the STATUS parameter below).

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● With data types STRING and WSTRING, all data is transferred if the parameter LEN = 0. 
When LEN > 0, the length must be at least the maximum number of bytes plus two additional 
bytes which contain the length information. You can find more detailed information on the 
structure of the data types in: "Overview of the valid data types (Page 1320)".
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● The maximum number of bytes that can be transmitted depends on the device.

● When you use structured tags from optimized DBs, the address of the structured tag should 
be interconnected at the DATA parameter and the parameter LEN = 0. This guarantees 
type-safe transmission of the entire structure if the same structure is used at the receiving 
end.

BUSY, DONE and ERROR parameters
You can check the status of the job with the BUSY, DONE, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the DONE parameter, you can 
check whether or not a job executed successfully. The ERROR parameter is set when errors 
occurred during execution of "TSEND". The error information is output at the STATUS 
parameter.

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERROR Description
1 0 0 The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is specified in the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TSEND" is executed asynchronously, you must keep the data in the send area 
consistent until the DONE parameter or the ERROR parameter changes to the value "1".

 

ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Description

0 0000 Send job completed without error.
0 7000 No job processing active.
0 7001 Start of job execution, data is being sent.

When processing this job, the operating system accesses the data in the DATA send area.
0 7002 Job executing (REQ irrelevant).

When processing this job, the operating system accesses the data in the DATA send area.
1 8085 ● The LEN parameter is greater than the highest permitted value (65536).

● DATA and LEN parameters both have the value "0".
1 8086 The ID parameter is outside the permitted address range (1..0xFFF).
1 8088 The LEN parameter is greater than the area specified in DATA.
1 80A1 Communication error:

● The specified connection has not yet been established.
● The specified connection is being terminated. Transfer via this connection is not possible.
● The interface is being re-initialized.
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ERROR STATUS* 
(W#16#...)

Description

1 80B3 The protocol variant (ConnectionType parameter in the connection description) is set to UDP. Use 
the instruction "TUSEND" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 Connection terminated by the communication partner.
1 80C6 Network error. Communication partner cannot be reached.
1 80C7 Execution timeout.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TRCV: Receive data via communication connection

TRCV: Receive data via communication connection

Description
The following description of the "TRCV" instruction is valid for the CPU S7-1200 up to version 
3.0.

You use the "TRCV" instruction to receive data over an existing communication connection. 
"TRCV" is executed asynchronously.

Receipt of data is enabled when the EN_R parameter is set to the value "1". The received data 
is entered in a receive area. You specify the length of the receive area either with the LEN 
parameter (if LEN <> 0) or with the length information of the DATA parameter (if LEN = 0), 
depending on the protocol variant being used. 

While data is being received, you cannot make changes to the DATA parameter or the defined 
receive area to ensure consistency of the received data.

After successful receipt of data, the NDR parameter is set to the value "1". You can query the 
amount of data actually received at the RCVD_LEN parameter.
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Receive modes of "TRCV"
The following table shows how the received data is entered in the receive area.

Protocol variant Availability of data in the receive area connection_type* 
parameter of the 
connection description

LEN parameter

TCP
(Ad-hoc mode)

The data is immediately available. Hexadecimal value: 
B#16#11
Integer value: 17

0

TCP 
(Receipt of data with 
specified length)

The data is available as soon as the data 
length specified at the LEN parameter 
has been fully received.

Hexadecimal value: 
B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented data 
transfer)

The data is available as soon as the data 
length specified at the LEN parameter 
has been fully received.

Hexadecimal value: 
B#16#12
Integer value: 18

● 1 to 1452, if a CP is 
used.

● 1 to 8192, if no CP is 
used.

* See "Auto-Hotspot". 

TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV" instruction.

You set ad-hoc mode by assigning the value "0" to the LEN parameter. All data types can be 
used for data blocks with standard access when you use ad-hoc mode. Only ARRAY of BYTE 
or data types with a length of 8 bits can be used for data blocks with optimized access (e.g., 
CHAR, USINT, SINT, etc.). When ad-hoc mode is active, receipt of data is already signaled 
after a received byte at the NDR parameter.

TCP (Receipt of data with specified length)
For receipt of data with a specified length, enter the length of the data at the LEN parameter. 
The data receipt is not complete until the length of data specified at the LEN parameter has 
been completely received. Only then is the data available in the receive area (DATA 
parameter). The receipt of data is signaled by the NDR output parameter. The actually received 
data length in bytes at the RCVD_LEN parameter corresponds to the data length at the LEN 
parameter after receipt. 

ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. When using ISO on TCP, "TRCV" signals data 
receipt as soon as the message block has been completely received. The receive area is 
defined by the LEN and DATA parameters. If the receive buffer (DATA parameter) is too small 
for the sent data, "TRCV" signals an error. The successful receipt of data is signaled by the 
NDR output parameter. The actually received data length in bytes at the RCVD_LEN parameter 
corresponds to the data length at the LEN parameter after receipt. 
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Parameters
The following table shows the parameters of the "TRCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Receive enable

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the connection established with 
"TCON (Page 3240)".
Range of values: W#16#0001 (1) to W#16#0FFF 
(4095)

LEN Input UDINT I, Q, M, D, L or 
constant

Length of the receive area in bytes (hidden). 
If you use a memory area with optimized access at 
the DATA parameter, the LEN parameter must have 
the value "0".

DATA InOut VARIANT I, Q, M, D Pointer to the receive area
NDR Output BOOL I, Q, M, D, L Status parameter (New Data Received):

● 0: Job not yet started or still in progress
● 1: Job completed without error

BUSY Output BOOL I, Q, M, D, L Status parameter:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started
ERROR Output BOOL I, Q, M, D, L Status parameter:

● 0: No error.
● 1: An error occurred during execution of the 

instruction.
Detailed information is output via the STATUS 
parameter.

STATUS Output WORD I, Q, M, D, L Status parameter:
Output of status and error information.

RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

LEN, DATA and RCVD_LEN parameters
● If LEN = 0, the received data is saved in the receive area specified at the DATA parameter. 

The number of bytes received is indicated at the RCVD_LEN parameter.

● If the length specified at the LEN parameter is greater than the length of the data received 
at the DATA parameter, the error code 8088 is output at the STATUS parameter (see 
description of the STATUS) parameter in the following.

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● If the DATA parameter references a data block with optimized access, the LEN parameter 
must be set to "0".
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● If a STRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=2 (LEN = 1 is not permitted).

● If a WSTRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=5.

BUSY, NDR and ERROR parameters
You can check the status of the job with the BUSY, NDR, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the NDR parameter, you can check 
whether or not a job executed successfully. The ERROR parameter is set when errors occurred 
during execution of TRCV. The error information is output at the STATUS parameter.

The following table shows the relationship between the BUSY, NDR and ERROR parameters:

BUSY NDR ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TRCV" is executed asynchronously, the data in the receive area is only consistent 
when the NDR parameter is set to the value "1".

 

ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Job completed successfully. The current length of the received data is output at the RCVD_LEN 
parameter.

0 7000 Block not ready to receive.
0 7001 Block is ready to receive, receive job was activated.
0 7002 Interim call, the receive job is executing.

Note: While the job is being processed, data is written to the receive area. Access to the receive 
area during this time may provide inconsistent data. 

1 8085 ● The LEN parameter is larger than the highest permitted value.
● The value of the LEN or DATA parameter was changed after the first call.
● Both LEN parameters and the DATA parameter have the value "0" or LEN is longer than the 

maximum permitted value (65536).
1 8086 The ID parameter is outside the permitted address range (1 .. 0x0FFF).
1 8088 ● Receive area is too small.

● The value at the LEN parameter is larger than the receive area set at the DATA parameter.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80A1 Communication error:
● The specified connection has not yet been established.
● The specified connection is being terminated. Receive job over this connection is not possible.
● The connection is being re-initialized.

1 80B3 The protocol variant (connection_type parameter in the connection description) is set to UDP. Use 
the instruction "TURCV" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C9 The length of the receive area is smaller than the length of the sent data.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

TRCV: Receive data via communication connection

Description
The following description of the "TRCV" instruction is valid for the CPU S7-1500 and S7-1200 
V4.0.

You use the "TRCV" instruction to receive data over an existing communication connection. 
"TRCV" is executed asynchronously.

Receipt of data is enabled when the EN_R parameter is set to the value "1". The received data 
is entered in a receive area. You specify the length of the receive area either with the LEN 
parameter (if LEN <> 0) or with the length information of the DATA parameter (if LEN = 0), 
depending on the protocol variant being used.

While data is being received, you cannot make changes to the DATA parameter or the defined 
receive area to ensure consistency of the received data.

After successful receipt of data, the NDR parameter is set to the value "1". You can query the 
amount of data actually received at the RCVD_LEN parameter.
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Receive modes of "TRCV"
The following table shows how the received data is entered in the receive area.

Protocol variant ADHOC 
parameter

Availability of data in the 
receive area

connection_type 
parameter of the 
connection description

LEN parameter

TCP
(Ad-hoc mode)

1 (ad-hoc 
activated)

The data is immediately 
available.

Hexadecimal value: 
B#16#11
Integer value: 17

1 up to maximum 
length (depending on 
the CPU)

TCP 
(Receipt of data with 
specified length)

0 (ad-hoc 
deactivated)

The data is available as soon 
as the data length specified at 
the LEN parameter has been 
fully received.

Hexadecimal value: 
B#16#11
Integer value: 17

1 to 8192

ISO on TCP
(Message-oriented 
data transfer)

- The data is available as soon 
as the data length specified at 
the LEN parameter has been 
fully received.

Hexadecimal value: 
B#16#12
Integer value: 18

● 1 to 1452, if a CP is 
used.

● 1 to 8192, if no CP 
is used.

TCP (Ad-hoc mode)
The ad-hoc mode is only available with the TCP protocol variant. You use the ad-hoc mode 
to receive data with dynamic length with the "TRCV" instruction.

You set ad-hoc mode by assigning the value "1" to the ADHOC parameter. All data types can 
be used for data blocks with standard access when you use ad-hoc mode. Only ARRAY of 
BYTE or data types with a length of 8 bits can be used for data blocks with optimized access 
(e.g., CHAR, USINT, SINT, etc.). When ad-hoc mode is active, receipt of data is already 
signaled after a received byte at the NDR parameter. 

TCP (Receipt of data with specified length)
Assign the value "0" to the ADHOC parameter for receipt of data with specified length. If ad-
hoc mode is disabled, the data receipt is not complete until the length of data specified at the 
LEN parameter has been completely received. Only then is the data available in the receive 
area (DATA parameter). The successful receipt of data is signaled by the NDR output 
parameter. The actually received data length in bytes at the RCVD_LEN parameter 
corresponds to the data length at the LEN parameter after receipt. 

ISO on TCP (Message-oriented data transfer)
Complete message blocks are sent via a connection with the protocol variant ISO on TCP; 
these are recognized as such by the recipient. When using ISO on TCP, "TRCV" signals data 
receipt as soon as the message block has been completely received. The receive area is 
defined by the LEN and DATA parameters. If the receive buffer (DATA parameter) is too small 
for the sent data, "TRCV" signals an error. The successful receipt of data is signaled by the 
NDR output parameter. The actually received data length in bytes at the RCVD_LEN parameter 
corresponds to the data length at the LEN parameter after receipt. 
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Parameters
The following table shows the parameters of the "TRCV" instruction:

Parameter Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Receive enable

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the connection established with 
"TCON".
Range of values: W#16#0001 to W#16#0FFF

LEN Input UDINT I, Q, M, D, L or 
constant

Length of the receive area in bytes (hidden).
If you use a receive area with optimized access at 
the DATA parameter, the LEN parameter must have 
the value "0".

ADHOC Input BOOL I, Q, M, D, L or 
constant

Use ad-hoc mode for the TCP protocol variant 
(hidden).

DATA InOut VARIANT I, Q, M, D Pointer to the receive area
NDR Output BOOL I, Q, M, D, L Status parameter (New Data Received):

● 0: Job not yet started or still in progress
● 1: New data received

BUSY Output BOOL I, Q, M, D, L Status parameter with the following values:
● 0: Job not yet started or already completed
● 1: Job not yet completed. A new job cannot be 

started
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:

● 0: No error
● 1: Error occurred

STATUS Output WORD I, Q, M, D, L Status of the instruction
RCVD_LEN Output UDINT I, Q, M, D, L Amount of data actually received in bytes

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".

LEN, DATA and RCVD_LEN parameters
● If LEN = 0, the received data is saved in the receive area specified at the DATA parameter. 

The number of bytes received is indicated at the RCVD_LEN parameter.

● If the length specified at the LEN parameter is greater than the length of the data received 
at the DATA parameter, the error code 8088 is output at the STATUS parameter (see 
description of the STATUS) parameter in the following.

● If a structure (Struct) is referenced via the DATA parameter, LEN can be shorter than the 
structure. In this case, only the data up to the length of the LEN parameter is transferred.

● If the DATA parameter references a data block with optimized access, the LEN parameter 
must be set to "0". If the length of the data does not match for elementary data types, the 
data will not be received and the error code 8088 is output at the STATUS parameter.
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● If a STRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=2 (LEN = 1 is not permitted).

● If a WSTRING data type is referenced via the DATA parameter, the length specified at the 
LEN parameter must be 0 or >=5.

BUSY, NDR and ERROR parameters
You can check the status of the job with the BUSY, NDR, ERROR and STATUS parameters. 
The BUSY parameter indicates the processing status. With the NDR parameter, you can check 
whether or not a job executed successfully. The ERROR parameter is set when errors occurred 
during execution of TRCV. The error information is output at the STATUS parameter.

The following table shows the relationship between the BUSY, NDR and ERROR parameters:

BUSY NDR ERROR Description
1 - - The job is being processed.
0 1 0 The job was completed successfully.
0 0 1 The job ended with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new job was assigned.

 

 Note

Because "TRCV" is executed asynchronously, the data in the receive area is only consistent 
when the NDR parameter is set to the value "1".

 

ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Job completed successfully. The current length of the received data is output at the RCVD_LEN 
parameter.

0 7000 Block not ready to receive.
0 7001 Block is ready to receive, receive job was activated.
0 7002 Interim call, the receive job is executing.

Note: While the job is being processed, data is written to the receive area. Access to the receive 
area during this time may provide inconsistent data. 

1 8085 ● The LEN parameter is larger than the highest permitted value.
● The value of the LEN or DATA parameter was changed after the first call.
● Both LEN parameters and the DATA parameter have the value "0" or LEN is longer than the 

maximum permitted value (65536).
1 8086 The ID parameter is outside the permitted value range (1 .. 0x0FFF).
1 8088 ● Receive area is too small.

● The value at the LEN parameter is larger than the receive area set at the DATA parameter.
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ERROR STATUS* 
(W#16#...)

Explanation

1 80A1 Communication error:
● The specified connection has not yet been established.
● The specified connection is being terminated. Receive job over this connection is not possible.
● The connection is being re-initialized.

1 80B3 The protocol variant (connection_type parameter in the connection description) is set to UDP. Use 
the instruction "TURCV" with a UDP connection.

1 80C3 ● A block with this ID is already being processed in a different priority group.
● Internal lack of resources.

1 80C4 Temporary communication error:
● The connection cannot be established to the partner at this time.
● The interface is receiving new parameter settings or the connection is being established.

1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
1 80C9 The length of the receive area is smaller than the length of the sent data.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
TRCV: Receive data via communication connection (Page 3256)

TCON: Establish communication connection (Page 3243)

Structure of the address information for the remote partner with UDP

Overview
When using a UDP connection, the address information for the remote partner is stored in the 
system data type TADDR_Param:

● By using the instruction "TUSEND (Page 3266)" the address information of the recipient is 
assigned to the parameter ADDR via TADDR_Param.
The stored address data of the remote partner are read from the system data type by the 
instruction.

● By using the instruction "TURCV (Page 3269)" the address of the sender is received at the 
parameter ADDR via TADDR_Param.
The address data is written by the instruction in the system data type.

Structure of the address information according to TADDR_Param
The system data type TADDR_Param contains the address information of the remote partner 
and consists of the IP address and the port number.

The system data type TADDR_Param has the following structure:
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Byte Parameter Data type Start value Description
0 to 3 rem_ip_addr ARRAY [1..4] of 

USINT
B#16#00 ... IP address of the remote partner, e.g. 192.168.002.003:

● rem_ip_addr[1] = B#16#C0 (192)
● rem_ip_addr[2] = B#16#A8 (168)
● rem_ip_addr[3] = B#16#02 (002)
● rem_ip_addr[4] = B#16#03 (003)
The IP address can be taken from the Devices & networks 
view in the interface properties of the remote partner. As an 
alternative these are also displayed in the properties of the 
UDP connection under Address details.

4 to 5 rem_port_nr UINT B#16#00 ... Remote port-number (possible values see: Auto-Hotspot):
● rem_port_nr[1] = high byte of the port no. in hexadecimal 

notation
● rem_port_nr[2] = low byte of port no. in hexadecimal 

notation
The port number can be taken from the Devices & networks 
view in the UDP connection properties. The port number is 
indicated under Address details as a decimal value.
Example: Port number = 2000 (decimal) / W#16#07D0 
(hexadecimal)
● rem_port_nr[1] = 07 (high byte)
● rem_port_nr[2] = D0 (low byte)

6 to 7 reserved WORD B#16#00 ... Not used. Leave the value "0" at this parameter.

Creating TADDR_Param in a data block
You have the following options for creating TADDR_Param:

● Create a new data block and select TADDR_Param as type in the dialog "Add new data 
block".

● Open an existing data block create a new tag and enter in the column Data type 
TADDR_Param.

A data block can contain several system data types TADDR_Param.
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TUSEND: Send data via Ethernet (UDP)

Description
The "TUSEND" instruction sends data to the remote partner addressed by the ADDR 
parameter using UDP.

 

 WARNING

Data transfer via UDP

Data transferred via UDP to RFC 768 to the remote partner are sent without 
acknowledgement and are therefore unsecured. This means the data can be lost without any 
indication at the block.

 

 Note

For sequential send operations to different partners, you only need to adjust the ADDR 
parameter when calling "TUSEND". You do not need to call the "TCON (Page 3240)" and 
"TDISCON (Page 3248)" instructions again. The UDP port must be set up at the specific 
remote partner in order for this partner to receive data. 

 

Functional description
"The TUSEND" instruction works asynchronously, which means its job processing extends 
over multiple calls. Create a rising edge at the REQ parameter to establish a connection once 
again.

The output parameters BUSY, DONE, ERROR and STATUS  indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

The following table shows the relationship between BUSY, DONE and ERROR. Using this 
table, you can determine the current status of "TUSEND" or when the send process is 
concluded.

BUSY DONE ERROR Description
TRUE FALSE FALSE The job is being processed.
FALSE TRUE FALSE Job successfully completed.
FALSE FALSE TRUE The job ended with an error. The cause of the error can be found in the STATUS 

parameter.
FALSE FALSE FALSE The instruction was not assigned a (new) job.

 

 Note

Due to the asynchronous operation of "TUSEND", make sure the data in the send area 
remains consistent until the DONE parameter or the ERROR parameter has the value TRUE.
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Parameters
The following table shows the parameters of the "TUSEND" instruction:

Parameters Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter REQUEST starts the send job on 
a rising edge.
The data is transferred from the area specified by 
DATA and LEN.

ID Input CONN_OU
C

I, Q, M, D, L or 
constant

Reference to the associated connection between 
the user program and the communication layer of 
the operating system. ID must be identical to the 
associated parameter ID in the local connection 
description with the instruction "TCON". 
Range of values: W#16#0001 to W#16#0FFF

LEN Input UINT I, Q, M, D, L or 
constant

Number of bytes to be sent with the job
Range of values: 1 to 1472

DONE Output BOOL I, Q, M, D, L Status parameter DONE: 
● 0: Job not yet started or still executing.
● 1: Job executed without errors. This value is only 

displayed for one cycle.
BUSY Output BOOL I, Q, M, D, L ● BUSY = 1: The job is not yet completed. A new 

job cannot be triggered.
● BUSY = 0: The job is completed.

ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:
● ERROR=1: An error has occurred during 

processing, STATUS supplies detailed 
information on the type of error.

STATUS Output WORD I, Q, M, D, L Status parameter STATUS: Error information
DATA InOut VARIANT I, Q, M, D Send area, contains address and length

The address refers to:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

ADDR InOut VARIANT D Pointer to the system data type TADDR_Param.
Store the address information of the remote partner 
(IP address and port number) in a data block with 
the system data type TADDR_Param.
See also: Structure of the address information for 
the remote partner with UDP (Page 3264)

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 Send job completed without error
0 7000 No job processing active
0 7001 Start of job processing, data being sent

Note: During this processing phase, the operating system accesses the data in the DATA send 
area.

0 7002 Intermediate call (REQ irrelevant), job is being processed
Note: During this processing phase, the operating system accesses the data in the DATA send 
area.

1 8085 The LEN parameter has the value "0" or is greater than the highest permitted value.
1 8086 The ID parameter is not in the permitted value range.
0 8088 The LEN parameter is greater than the memory area specified in DATA.
1 8089 The ADDR parameter does not point to a data block with the TADDR_Param structure.
1 80A1 Communication error:

● The specified connection between user program and communication layer of the operating 
system has not yet been established.

● The specified connection between the user program and the communication layer of the 
operating system is currently being terminated. Transmission over this connection is not 
possible.

● The interface is being reinitialized.
1 80A4 IP address (at the ADDR parameter) of the remote connection end point is invalid; it may 

correspond to the local partner's own IP address.
1 80B3 ● The protocol variant (connection_type parameter in the connection description) is not set to 

UDP. Please use "TSEND (Page 3253)".
● ADDR parameter: Invalid information for port no.

1 80B7 The length of the structure referenced by the parameter ADDR is not 8 bytes.
1 80C3 ● A block with this ID is already being processed in a different priority class.

● Internal lack of resources.
1 80C4 Temporary communication error:

● The connection between the user program and the communication layer of the operating system 
cannot be established at this time.

● New parameter settings are being assigned to the interface.
1 80C5 The remote partner has terminated the connection.
1 80C6 The remote partner cannot be reached (network error).
1 80C7 Execution timeout.
- General 

error 
informatio
n

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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TURCV: Receive data via Ethernet (UDP)

Description
The "TURCV" instruction receives data via UDP. After successful completion of "TURCV", the 
ADDR parameter will show you the address of the remote partner (the sender).

 

 WARNING

Unsecured data transfer

Data transferred via UDP to RFC 768 to the remote partner are sent without 
acknowledgement and are therefore unsecured. This means the data can be lost without any 
indication at the block.

 

Functional description
"The TURCV" instruction works asynchronously, which means its job processing extends over 
multiple calls. You start the receive job by calling "TURCV" with EN_R = 1.

The output parameters BUSY, DONE, ERROR and STATUS  indicate the status of the job.

See also: Meaning of the parameters REQ, RET_VAL and BUSY with asynchronous 
instructions (Page 1852).

The following table shows the relationship between BUSY, NDR and ERROR. Using this table, 
you can determine the current status of TURCV or when the receive process is concluded.

BUSY NDR ERROR Description
TRUE FALSE FALSE The job is being processed.
FALSE TRUE FALSE Job successfully completed. New data was received.
FALSE FALSE TRUE The job ended with an error. The cause of the error can be found in the STATUS 

parameter.
FALSE FALSE FALSE The instruction was not assigned a (new) job.

 

 Note

Due to the asynchronous operation of "TURCV", the data in the receive area is only consistent 
when the NDR parameter has the value TRUE.
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Parameters
The following table shows the parameters of the "TURCV" instruction:

Parameters Declaration Data type Memory area Description
EN_R Input BOOL I, Q, M, D, L or 

constant
Control parameter enabled to receive
When EN_R = 1, "TURCV" is ready to receive. The receive 
job is being processed.

ID Input WORD I, Q, M, D, L or 
constant

Reference to the associated connection between the user 
program and the communication layer of the operating 
system. ID must be identical to the corresponding 
parameter ID in the local connection description.
Value range: W#16#0001 to W#16#0FFF

LEN Input UINT I, Q, M, D, L or 
constant

Length of the receive area in bytes: 0 (recommended) or 
1 to 1472

NDR Output BOOL I, Q, M, D, L Status parameter NDR:
● NDR = 0: Job not yet started or still running
● NDR = 1: Job successfully completed

ERROR Output BOOL I, Q, M, D, L Status parameter ERROR:
● ERROR=1: Error occurred during processing. STATUS 

supplies detailed information on the type of error
BUSY Output BOOL I, Q, M, D, L ● BUSY = 1: The job is not yet completed. A new job 

cannot be triggered.
● BUSY = 0: The job is completed.

STATUS Output WORD I, Q, M, D, L Status parameter STATUS: Error information
RCVD_LEN Output UINT I, Q, M, D, L Amount of data actually received in bytes
DATA InOut VARIANT I, Q, M, D, L Receive area

The address references:
● The process image of the inputs
● The process image of the outputs
● A bit memory
● A data block

ADDR InOut VARIANT D Pointer to the system data type TADDR_Param.
The address information of the remote partner (IP address 
and port number) is written in a data block with the system 
data type TADDR_Param.
See also: Structure of the address information for the 
remote partner with UDP (Page 3264) 

You can find additional information on valid data types under "Overview of the valid data 
types (Page 1320)".
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ERROR and STATUS parameters

ERROR STATUS* 
(W#16#...)

Explanation

0 0000 New data was accepted. The current length of the received data is shown in RCVD_LEN.
0 7000 Block not ready to receive
0 7001 Block is ready to receive, receive job was activated
0 7002 Intermediate call, receive job being processed

Note: During this processing phase, "TURCV" writes data to the receive area. For this reason, an 
error could result in inconsistent data in the receive area.

1 8085 The LEN parameter is greater than the largest permitted value, or you changed the value of the 
LEN or DATA parameter since the first call

1 8086 The ID parameter is not in the permitted value range
1 8088 ● Receive area is too small

● Value in LEN is higher than the receive area specified by DATA
1 8089 The ADDR parameter does not point to a data block with the TADDR_Param structure.
1 80A1 Communication error:

● The specified connection between user program and communication layer of the operating 
system has not yet been established.

● The specified connection between the user program and the communication layer of the 
operating system is currently being terminated. A receive job over this connection is not 
possible.

● New parameter settings are being assigned to the interface.
1 80B3 The protocol variant (connection_type parameter in the connection description) is not set to UDP. 

Please use "TRCV (Page 3256)".
1 80B7 The length at ADDR parameter does not correspond to 8 bytes.
1 80C3 ● A block with this ID is already being processed in a different priority class.

● Internal lack of resources.
1 80C4 Temporary communication error: New parameter settings are being assigned to the interface.
1 80C5 The remote partner has terminated the connection.
1 80C7 Execution timeout.
1 80C9 With RFC1006 / UDP: The received data is longer than expected (size of receive buffer exceeded).
- General 

error 
information

See also: GET_ERR_ID: Get error ID locally (Page 2080)

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

See also
TCON: Establish communication connection (Page 3240)

TDISCON: Terminate communication connection (Page 3248)
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T_RESET: Resetting the connection

Description
The "T_RESET" instruction terminates and then reestablishes an existing connection. 

The local end points of the connection are retained. They are generated automatically:

● If a connection has been configured and loaded to the CPU.

● If a connection has been generated by the user program, for example, by calling the 
instruction "TCON (Page 3240)".

The instruction "T_RESET" can be executed for all connection types (TCP, UDP, ISO-on-TCP, 
etc.). It does not matter whether the local interface of the CPU or the interface of a CM/CP was 
used for the connection.

Once the instruction "T_RESET" has been called using the REQ parameter, the connection 
specified with the ID parameter is terminated and, if necessary, the data send and receive 
buffer cleared. Canceling the connection also cancels any data transfer in progress. There is 
therefore a risk of losing data if data transfer is in progress. The CPU defined as the active 
connection partner will then automatically attempt to restore the interrupted communication 
connection. You therefore do not need to call the "TCON (Page 3240)" instruction to reestablish 
the communication connection.

The output parameters DONE, BUSY and STATUS indicate the status of the job.

Parameters
The following table shows the parameters of the "T_RESET" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter REQUEST starts the job for 
terminating the connection specified by ID. 
The job starts on a rising edge.

ID Input CONN_OUC I, Q, M, D, L or 
constant

Reference to the connection to the passive 
partner ID being interrupted must be identical 
to the corresponding parameter ID in the local 
connection description.
Range of values: W#16#0001 to W#16#0FFF

DONE Output BOOL I, Q, M, D, L Status parameter DONE
● 0: Job not yet started or still executing.
● 1: Job executed without errors

BUSY Output BOOL I, Q, M, D, L Status parameter BUSY
● 0: Job is complete.
● 1: The job is not yet completed.
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Parameter Declaration Data type Memory area Description
ERROR Output BOOL I, Q, M, D, L Status parameter ERROR

● 0: No error occurred.
● 1: Error occurred during processing. The 

STATUS parameter supplies detailed 
information on the type of error

STATUS Output WORD I, Q, M, D, L Status parameter STATUS
Error information (see "STATUS parameter" 
table).

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

Parameter STATUS

STATUS* 
(W#16#...)

Explanation

0000 No error.
0001 Connection has not been established.
7001 Connection termination launched.
7002 Connection being terminated.
8081 Unknown connection specified at the ID parameter.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

T_DIAG: Checking the connection

Description
You use the "T_DIAG" instruction to check the status of a connection and read further 
information on the local end point of this connection. 

● The connection is referenced by the ID parameter. You can read both connection end points 
configured in the connection editor and programmed connection end points (e.g. with the 
"TCON" instruction). 
Temporary connection end points (for example end points created when you connect to an 
engineering station) cannot be diagnosed, as no connection ID is generated in this process.

● The connection information read is stored in a structure referenced by the RESULT 
parameter. 

● The output parameter STATUS indicates whether it was possible to read the connection 
information. The connection information in the structure at the RESULT parameter is only 
valid if the "T_DIAG" instruction has been completed with STATUS = W#16#0000 and 
ERROR = FALSE. 
Connection information cannot be evaluated if an error occurs.
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Possible connection information
Two different structures can be used to read the connection information at the RESULT 
parameter:

● The "TDiag_Status" structure only contains the most important information about a 
connection end point, for example the protocol used, the connection status and the number 
of data bytes sent or received.

● The structure "TDiag_StatusExt" supplies not just the most important information, but also 
the number of connection attempts, the reason for a connection abort, etc. 

The structure and parameters of the two structures are described below (see the 
"TDIAG_Status and TDIAG_StatusExt structures" table).

Parameters
The following table shows the parameters of the "T_DIAG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Starts the instruction to check the connection 
specified in the ID parameter when there is a 
positive edge.

ID Input CONN_OUC 
(WORD)

L, D or constant Reference to the assigned connection. 
Range of values: W#16#0001 to W#16#0FFF

RESULT InOut VARIANT D Pointer to the structure in which the connection 
information is stored. The structure 
TDiag_Status or TDiag_StatusExt can be used 
at the RESULT parameter (for a description, 
see the "TDIAG_Status and TDIAG_StatusExt 
structures" table).

DONE Output BOOL I, Q, M, D, L Status parameter:
● 0: Instruction not yet started or still in 

progress.
● 1: Instruction executed without errors.

BUSY Output BOOL I, Q, M, D, L Status parameter:
● 0: Instruction not yet started or already 

completed.
● 1: Instruction not yet completed. A new job 

cannot be started.
ERROR Output BOOL I, Q, M, D, L Status parameter:

● 0: No error.
● 1: Error occurred.

STATUS Output WORD I, Q, M, D, L Status of the instruction

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".
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Parameters BUSY, DONE and ERROR
You can check the status of "T_DIAG" instruction execution with the BUSY, DONE, ERROR 
and STATUS parameters. The BUSY parameter indicates the processing status. You use the 
DONE parameter to check whether or not an instruction has been executed successfully. The 
ERROR parameter is set if errors occur during execution of "T_DIAG".

The following table shows the relationship between the BUSY, DONE and ERROR parameters:

BUSY DONE ERRO
R

Description

1 - - The instruction is being processed.
0 1 0 The instruction has been executed successfully. The data in the structure referenced by RESULT 

are only valid if this is the case.
0 0 1 Instruction completed with an error. The cause of the error is output at the STATUS parameter.
0 0 0 No new instruction has been assigned.

Parameter STATUS
The following table shows the meaning of the values at the STATUS parameter:

STATU
S* 
(W#16#.
..)

Explanation

0000 The instruction "T_DIAG" has been executed successfully. The data in the structure referenced at the RESULT 
parameter can be evaluated.

7000 No instruction processing active.
7001 Instruction processing launched.
7002 Connection information is being read (REQ parameter irrelevant).
8086 The value at the ID parameter is outside the valid range (W#16#0001 ... W#16#0FFF).
8089 The RESULT parameter points to an invalid data type (structures TDIAG_Status and TDIAG_StatusExt only).
80A3 The ID parameter references a connection end point which does not exist. With programmed connections, this 

error can also occur after the "TDISCON" instruction is called.
80C4 Internal error. Access to the connection end point is temporarily unavailable.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".

Structures TDIAG_Status and TDIAG_StatusExt
The table below details the form of the TDIAG_Status and TDIAG_StatusExt structures:

● From the InterfaceID to the ReceivedBytes parameter, the "TDIAG_StatusExt" and 
"TDIAG_Status" structures are identical.

● The structure TDIAG_StatusExt also includes the parameters ConnTrials to 
LastDisconnTimeStamp.

The value of each element is only valid if the instruction has been executed without errors. If 
an error occurs, the content of the parameters will not change.
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Name Data type Description
The following parameters are in both the TDIAG_Status and the TDIAG_StatusExt structure:
InterfaceID HW_ANY Interface ID (LADDR) of the CPU or the CM/CP.
ID CONN_OU

C
ID of the connection diagnosed. Following a successful call, the value of this element is 
identical to the parameter ID of the "T_DIAG" instruction.

ConnectionType BYTE Protocol type used for connection:
● 0x01: Not used.
● ...
● 0x0B: TCP protocol (IP_v4)
● 0x0C: ISO-on-TCP protocol (RFC1006)
● 0x0D: TCP protocol (DNS)
● 0x0E: Dial-in protocol
● 0x0F: WDC protocol
● 0x10: SMTP protocol
● 0x11: TCP protocol
● 0x12: TCP and ISO-on-TCP protocol (RFC1006)
● 0x13: UDP protocol
● 0x14: Reserved
● 0x15: PROFIBUS bus access protocol (FDL)
● 0x16: ISO 8073 transport protocol (ISO native)
● ...
● 0x20: SMTP or SMTPS protocol - based on IPv4
● 0x21: SMTP or SMTPS protocol - based on IPv6
● 0x22: SMTP or SMTPS protocol - based on FQDN (Fully Qualified Domain Name)
● ...
● 0x70: S7 connection
● Other: Reserved

ActiveEstablished BOOL ● FALSE: Locally, the passive connection end point
● TRUE: Locally, the active connection end point

State BYTE Current status of the connection end point
● 0x00: Not used.
● 0x01: Connection terminated. Temporary status, for example, after the "T_RESET" 

instruction is called. The system then automatically attempts to reestablish the 
connection.

● 0x02: The active connection end point is attempting to establish a connection to the 
remote communication partner.

● 0x03: The passive connection end point is waiting for establishment of the connection 
to the remote communication partner.

● 0x04: Connection established.
● 0x05: The connection is being terminated. This may be because the "T_RESET" or 

"T_DISCON" instruction has been called. Other possible reasons are protocol errors 
and line breaks.

● 0x06..0xFF: Not used.
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Name Data type Description
Kind BYTE Mode of the connection end point:

● 0x00: Not used.
● 0x01: Configured, static connection which has been configured and loaded to the CPU.
● 0x02: Configured, dynamic connection which has been configured and loaded to the 

CPU (not currently supported).
● 0x03: Programmed connection generated in the user program with the instruction 

"TCON". A call of the instruction "TDISCON" or a transition to CPU STOP status has 
destroyed the connection end point.

● 0x04: Temporary, dynamic connection established by the engineering station (ES) or 
operator station (OS), for example. (this connection type cannot currently by diagnosed 
as there is no ID).

● 0x05..0xFF: Not used.
SentBytes UDINT Number of data bytes sent.
ReceivedBytes UDINT Number of data bytes received.
The following parameters only occur in the TDiag_StatusExt structure:
ConnTrials UDINT Number of connection attempts. Once a connection has been established, ConnTrials has 

the value 0. If this element is not equal to 0, there are connection problems. 
Note: With a passive connection end point, this value is never greater than 1.

ConnTrialsSucces
s

UDINT Number of successful connection attempts. This element is never reset during the life cycle 
of a connection end point, and returns to 0 after reaching 0xFFFF FFFF. 
Note: This parameter is 1 if there has never been a problem in this connection.

LastConnErrReas
on

UDINT Error ID output during the last connection attempt with errors (the error messages are 
identical to those at the LastDisconnReason parameter):
● 0x4F01: Remote connection end point cannot be reached (this error usually occurs 

during connection establishment).
● 0x4F02: Connection terminated locally.
● 0x4F03: Connection terminated by remote communication partner.
● 0x4F04: Connection terminated by a protocol error.
● 0x4F05: Connection terminated by a network problem detected locally.
● 0x4F06: Connection terminated by a network problem detected remotely.
● 0x4F07: Connected terminated due to timeout in protocol.
● 0x4F08: Incorrect parameter assignment: Connection to be established to local 

partner's own address.
● 0x4F09: Connection temporarily reset by a call of the instruction "T_RESET".
● 0x4F0A: Insufficient connection resources available (quantity exceeded)
● 0x4F0B: Internal error: Incorrect addressing parameters
● 0x4F0C: Internal CPU communication error
● 0x4F0D: Internal AS communication error between CPU and CM/CP
● 0x4F0E: The local TCP/UDP port (or RFC1006-T selector) specified is already in use.

LastConnErrTime
Stamp

LDT Time of the last connection attempt with errors.
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Name Data type Description
LastDisconnReas
on

UDINT Error ID which led to the last connection termination (the error messages are identical to 
those at the LastConnErrReason parameter):
● 0x4F01: Remote connection end point cannot be reached (this error usually occurs 

during connection establishment).
● 0x4F02: Connection terminated locally.
● 0x4F03: Connection terminated by remote communication partner.
● 0x4F04: Connection terminated by a protocol error.
● 0x4F05: Connection terminated by a network problem detected locally.
● 0x4F06: Connection terminated by a network problem detected remotely.
● 0x4F07: Connected terminated due to timeout in protocol.
● 0x4F08: Incorrect parameter assignment: Connection to be established to local 

partner's own address.
● 0x4F09: Connection temporarily reset by a call of the instruction "T_RESET".
● 0x4F0A: Insufficient connection resources available (quantity exceeded)
● 0x4F0B: Internal error: Incorrect addressing parameters
● 0x4F0C: Internal CPU communication error
● 0x4F0D: Internal AS communication error between CPU and CM/CP
● 0x4F0E: The local TCP/UDP port (or RFC1006-T selector) specified is already in use.
 

LastDisconnTime
Stamp

LDT Time of the last connection termination.

T_CONFIG: Configure interface

Description T_CONFIG

Description
The "T_CONFIG" instruction is used for the program-controlled configuration of the integrated 
PROFINET interfaces of the CPU or the interface of a CP/CM. 

You can change the Ethernet address of the PROFINET device name from the user program 
via the instruction. The existing configuration data is overwritten.

You can make the following changes via the instruction "T_CONFIG":

● Settings for the IP protocol

– IP address

– Subnet mask

– Router address

● Settings for PROFINET

– Assignment of the PROFINET device name
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The settings correspond with the configuration options under "IP protocol" and "PROFINET" 
in the dialog "Ethernet addresses". This is displayed in the view "devices & networks" under 
the properties of the PROFINET interface.

 

 WARNING

Restart of CPU after execution of the "T_CONFIG" instruction

The CPU is restarted after you have executed the instruction to change an IP parameter. The 
CPU goes to STOP mode, a warm restart is carried out and the CPU starts up again (RUN 
mode). 

Make sure that the control process is in a secure operating mode after the CPU has been 
restarted following execution of the instruction. Uncontrolled operation can result in serious 
material damage or personal injury due to malfunctions or programming errors, for example. 
Non-retentive data could be lost.

 

Requirement
In order to use the instruction must be explicitly specified in the hardware configuration that 
the assignment of IP address parameters and device name must be made by the user program.

● For this purpose open the properties of the PROFINET interface in the device view. Activate 
the following options in the dialog "Ethernet addresses":

– In order to change the IP address parameters with "T_CONFIG": Select the setting "Set 
IP address using a different method" under "IP protocol".

– In order to change the PROFINET device name with "T_CONFIG": Select the setting 
"Set PROFINET device name using a different method" under "PROFINET".

● The configuration data must be stored in the following system data types and assigned at 
the parameter CONF_DATA (Page 3282):

– Store the IP address, subnet mask, and the router address in the system data type 
IF_CONF_V4.

– Store the device name in the system type IF_CONF_NOS. Observe the restrictions that 
exist for assigning the name of the device (see parameter CONF_DATA (Page 3282)).

Functional description
The "T_CONFIG" instruction works asynchronously, which means its execution extends over 
multiple calls. The configuration process is started by calling "T_CONFIG" with REQ = 1. Only 
one job can be active at any time.

The block is edge triggered which means that after BUSY= FALSE the block must be re-called 
with REQ=FALSE to enable the instance. 
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Parameters
The following table shows the parameters of the "T_CONFIG" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Calling the instruction with REQ = 1 starts processing 
of the instruction.

INTERFACE Input HW_INTERFA
CE

I, Q, M, D, L or 
constant

Hardware identifier of the interface
The hardware ID is displayed in the properties of the 
interface in the device view, and in the system 
constants of the PLC tags.

CONF_DATA 
(Page 3282) 

Input VARIANT D, L Pointer to the parent structure that contains the 
system data types IF_CONF_HEADER, 
IF_CONF_V4 and  IF_CONF_NOS (see description 
of the parameters CONF_DATA).

DONE 
(Page 3286)

Output BOOL I, Q, M, D, L Status parameter:
● 0: Processing not yet complete.
● 1: Processing of instruction finished successfully.

BUSY 
(Page 3286)

Output BOOL I, Q, M, D, L Status parameter:
● 0: Processing of the instruction has not started, 

completed or canceled yet.
● 1: Processing of instruction is in progress

ERROR 
(Page 3286)

Output BOOL I, Q, M, D, L Status parameter:
● 0: No error
● 1: Error

STATUS 
(Page 3286)

Output DWORD I, Q, M, D, L Detailed status information:
Detailed error and status information in the form of 
an error code are output at the parameter STATUS.

ERR_LOC 
(Page 3286)

Output DWORD I, Q, M, D, L Error location: 
● 0: Error during execution of the instruction or 

when assigning parameters.
● > 0: Errors in the structure or content of the 

configuration data at the parameter 
CONF_DATA.

For additional information on valid data types, refer to "Overview of the valid data types 
(Page 1320)".

Example
In the following example the device name of an IO device is changed with the instruction 
"T_CONFIG".

Call of instruction

● The execution of the instruction is started with REQ=1.

● The hardware ID of the PROFINET interface is specified at the parameter Interface.

● The structure "StructConfigData" is referenced at the parameter CONF_DATA. The 
structure was created in the global data block "DataBlock".
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Parameters CONF_DATA

The structure "StructConfigData" at the parameter CONF_DATA contains the following 
information:

● In the Header (IF_CONF_HEADER).
SubfieldCount = 1: Indicates that only one additional structure (nos) is used below.

● In the structure "nos" (system data type IF_CONF_NOS)

– Lenght = 11: Information on overall length of the structure NOS (5 bytes for the device 
name "myplc" + 6 bytes for the parameters Id, Length and Mode)
Note: Instead of an absolute length, you can use the default start value (Lenght = 0) for 
a dynamic length.

– Mode = 1: Permanent change of the device name in "myplc".

– NOS[1] ... NOS[5]: Device name (1 character / byte)
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See also
Evaluating errors with output parameter RET_VAL (Page 1854)

Parameter CONF_DATA

Structure of the configuration data
The configuration data at the parameter CONF_DATA can be stored in a global data block or 
in the section "Static" of the block interface.

The configuration data must be stored according to the following structure:

Name Data type Description
ConfData Struct Parent structure that is assigned at the parameter CONF_DATA.
 Header IF_CONF_HEAD

ER
The header is used to define the number of these system data types. The system data 
type IF_CONF_HEADER must always be included.

IPData IF_CONF_V4 The IP address, subnet mask and router address are stored in this system data type. Only 
create IF_CONF_V4 if you also want to change the Ethernet address with "T_CONFIG".

NoS IF_CONF_NOS The PROFINET device names are stored in this system data type. Only create 
IF_CONF_NOS if you also want to change the device names with "T_CONFIG".

The system data types IF_CONF_HEADER, IF_CONF_V4 and IF_CONF_NOS are created 
by entering the name of the system data type in the column "data type" of the data block or 
the block interface. The name for the system data types can be freely assigned.
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System data type IF_CONF_Header
Use the system data type IF_CONF_Header to specify the number of system data types 
IF_CONF_V4 and IF_CONF_NOS that are used during the execution of "T_CONFIG".

Byte Parameter Data type Start value Description
0 ... 1 FieldType UINT 0 Field type: Must always have the value "0".
2 ... 3 FieldId UINT 0 Error ID: Must always have the value "0".
4 ... 5 SubfieldCount UINT 0 Number of system data types IF_CONF_V4 and 

IF_CONF_NOS:
● 1: Only one of the system data types is used.
● 2: Both system data types are used 

System data type IF_CONF_V4
The IP address, subnet mask and router address are defined with the system data type 
IF_CONF_V4.

Byte Parameter Data type Start value Description
0 ... 1 Id UINT 30 System data type ID The start value of this 

parameter may not be changed.
2 ... 3 Length UINT 18 Length of the system data type IF_CONF_V4

The start value must be used for the length 
specification since the parameters of IF_CONF_V4 
have a fixed length and structure.

4 ... 5 Mode UINT 0 Validity of addressing:
● 1: Permanent validity of the configuration data
● 2: Temporary validity of the configuration data 

including the deletion of existing permanent 
configuration data

6 ... 9 InterfaceAddress IP_V4 * 0.0.0.0 IP address
10 ... 12 SubnetMask IP_V4 * 0.0.0.0 Subnet mask
14 ... 16 DefaultRouter IP_V4 * 0.0.0.0 Router address
* The data type IP_V4 is a structure of 4 BYTE, which includes the respective address of the respective parameter (e.g. at 
parameter SubnetMask the four-digit address of the subnet mask of the IP protocol).
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Subfield IF_CONF_NOS
Use the subfield IF_CONF_NOS to specify the station name to be assigned during execution 
of the instruction "T_CONFIG".

Byte Parameter Data type Start value Description
0 ... 1 Id UINT 40 System data type ID The start value of this 

parameter may not be changed.
2 ... 3 Length UINT 246 Length of the system data type IF_CONF_NOS in 

bytes. 
● For an absolute length, the value for the Lenght 

parameter consists of:
– 6 bytes for the parameter Id, Length and 

Mode.
– up to 240 bytes for the device name 

(parameter NOS).
Example: An overall length of 10 is the result for 
the device name "plc1" with a length of 4 
characters (=4 bytes).

● Use the default start value 246 at the Lenght 
parameter for a dynamic length. 
Make sure that you enter the value "0" after the 
name (see description for NOS parameter).
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Byte Parameter Data type Start value Description
4 ... 5 Mode UINT 0 Validity of the device name change:

● 1: Permanent validity of the device name.
● 2: Temporary validity of the device name.

6 ... 244 NOS ARRAY 
[1...240] of 
Byte

0 Device name (Name of Station)
● You must occupy the ARRAY from the first byte. 

The station name is deleted if "0" is assigned as 
the first byte.

● The minimum length for the name is 2 bytes. The 
maximum length for a name is 240 bytes.

● If the device name is shorter than specified at 
the parameter Length then a zero byte (16#0 
hex) must be entered after the actual station 
name (according to IEC 61185-6-10). Otherwise 
NOS will be rejected and the instruction 
"T_CONFIG" outputs the error 
codeDW#16#C0809400 at the parameter 
STATUS.

● If the device name is longer than specified at the 
parameter Length then the device name will only 
be written up to to specified length.

 
The following restrictions apply for the device name:
● The name must be specified in ASCII code.
● Only lowercase letters, numbers, hyphen or dots 

may be used for the name. 
– The name may not begin or end with a 

hyphen.
– The name may not begin with numbers.
– The name may not have the form n.n.n.n (n 

= 0, ... 999).
– The name may not begin with the string "port-

xyz" or "port-xyz-abcde" (a, b, c, d, e, x, y, z 
= 0, ... 9).

● A name component between two points may be 
up to 63 characters long.

● No special characters such as umlauts, 
brackets, underscore, slash, blank etc.

The error code C080_9400 is output at the 
parameter STATUS if an invalid character is used.
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DONE, BUSY and ERROR parameters

Description
The following table shows the relationship between BUSY, DONE and ERROR. Using this 
table, you can determine the current status of the instruction and when the transfer of 
configuration data is concluded.

BUSY DONE ERROR Description
TRUE FALSE FALSE The job is being processed.
FALSE TRUE FALSE Job successfully completed.
FALSE FALSE TRUE The job ended with an error. The cause of the error can be found in the 

parameter STATUS (Page 3286).
FALSE FALSE FALSE The instruction was not assigned a (new) job.

Parameter STATUS and ERR_LOC

Description
The status and error messages of the instruction "T_CONFIG" are output at the parameters 
STATUS and ERR_LOC.

● The cause of the error is output at the parameter STATUS.

● The location of the error that occurred is output at the parameter ERR_LOC. The following 
options are available here:

– 16#0000_0000: Error when calling the instruction (e.g. errors when assigning 
parameters to the instruction or in communication with the PROFINET interface).

– 16#0001_0000: Error with the configuration data in the parameters of the system data 
type IF_CONF_HEADER.

– 16#0001_0001: Error with the configuration data in the parameters of the system types 
IF_CONF_V4 or IF_CONF_NOS.

The following table shows the possible values for the parameters STATUS and ERR_LOC:

STATUS* ERR_LOC* Explanation
0000_0000 0000_0000 Order processing completed without errors.
0070_0000 0000_0000 No job processing active.
0070_0100 0000_0000 Start of the order processing.
0070_0200 0000_0000 Intermediate call (REQ irrelevant).
C08x_yy00 0000_0000 General error information. See also: GET_ERR_ID: Get error ID locally (Page 2080) 
C080_8000 0000_0000 Error at call of the instruction:

The hardware ID at the parameter Interface is invalid.
C080_8100 0000_0000 Error at call of the instruction:

The hardware ID at the parameter Interface does not address a PROFINET interface.
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STATUS* ERR_LOC* Explanation
C080_8700 0000_0000 Error at call of the instruction:

Incorrect length of the data block at the parameter CONF_DATA.
C080_8800 0001_0000 Error in the system data type IF_CONF_HEADER:

The parameter FieldType has an invalid value. Use the value "0" for FieldType.
C080_8900 0001_0000 Error in the system data type IF_CONF_HEADER:

The parameter FieldId has an invalid value or was used several times. Use the value "0" for 
FieldId.

C080_8A00 0001_0000 Error in the system data type IF_CONF_HEADER:
Incorrect number at the parameter SubfieldCount. Enter the correct number of system data 
types IF_CONF_V4 and IF_CONF_NOS in use.

C080_8B00 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
The parameter Id has an invalid value. Use  "30" and IF_CONF_NOS "40" for IF_CONF_V4.

C080_8C00 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
Incorrect data type system used, wrong order or multiple use of a system data type.

C080_8D00 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
The parameter Length has an incorrect or invalid value.

C080_8E00 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
The parameter Mode has an incorrect or invalid value. Only the values "1" (permanent) or "2" 
(temporary) are valid.

C080_9000 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
Configuration data cannot be applied. Possible cause: The setting "Set IP address on device" 
or "Set PROFINET device name on device" was not selected in the hardware configuration.

C080_9400 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
A parameter value is undefined or invalid.

C080_9500 0001_0001 Error in the system data type IF_CONF_V4 or IF_CONF_NOS:
The values of two parameters are inconsistent.

C080_C200 0000_0000 Error at call of the instruction:
The configuration data can not be transferred. Possible cause: The PROFINET interface is 
not accessible.

C080_C300 0000_0000 Error at call of the instruction:
Insufficient resources (e.g., multiple calling of "T_CONFIG" with different parameters).

C080_C400 0000_0000 Error at call of the instruction:
Temporary communication error. Time indication for change to daylight saving time.

C080_D200 0000_0000 Error at call of the instruction:
Call not possible. Instruction is not supported by the selected PROFINET interface.

* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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9.7.5.4 Web server

WWW: Synchronizing user-defined web pages

Description   
The instruction WWW initializes the web server of the CPU or synchronizes user-defined web 
pages with the user program in the CPU. 

User-defined web pages together with the web server make it possible for the CPU to access 
freely designed web pages of the CPU with a web browser. 

Use script instructions (such as Javascript) and HTML code in user-defined web pages to 
transfer data via a web browser for further processing to the CPU and to display data from the 
operand area of the CPU in the web browser. Call the WWW instruction in the user program 
for synchronization of the user program and the web server as well as initialization. 

Initialization
User-defined web pages are "packaged" in data blocks for processing by the CPU. You will 
have to generate appropriate data blocks from the source files (HTML files, screens, Javascript 
files, ...) during configuration. The Web Control DB has a special role (default: DB 333). It 
contains status and control information as well as links to additional data blocks with coded 
web pages. The data blocks with coded web pages are called fragment DBs. 

When the data block is downloaded into the CPU, the CPU does not "know" that user-defined 
web pages are coded inside it. The instruction "WWW" in the startup OB, for example, will 
inform the CPU which DB is the Web Control DB. The user-defined web pages can be accessed 
via a web browser after this initialization. 

Synchronization
If you want the user program to interact with the user-defined web pages, then the instruction 
WWW must be used in the cyclical program part. 

Examples of interaction between user program and web page: 

● Check received data

● Assemble and send back data to the web browser making the request

In this case it must be possible to evaluate the current status information and the web server 
must receive control information, such as release of a web page requested by a web browser. 
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Parameter
The following table shows the parameters of the instruction "WWW":

Parameter Declaration Data type Memory area Description
CTRL_DB Input DB_WWW D Data block that describes the user-defined 

web pages (Web Control DB)
RET_VAL Output INT I, Q, M, D, L Error information

For additional information on valid data types, refer to Overview of the valid data types 
(Page 1320).

Parameter RET_VAL

Error code

(W#16#...)

Explanation

0000 No error occurred. There are no web page requests that have to be released by the 
user program. 

00xy x: indicates whether an error has occurred during initialization of the Web Control DB 
(CTRL_DB):
x=0: No errors occurred.
x=1: Error occurred. The error is coded in the byte "CTRL_DB.last_error" of the Web 
Control DB, see description of Web Control DB.
y: Number of the pending request. Several requests are possible (e. g. requests "0" 
and "1" are pending: y="3".
y="1": Request "0"
y="2": Request "1"
y="4": Request "2"
y="8": Request "3"

803A The specified Web Control DB does not exist on the CPU.
8081 Incorrect version or incorrect format of the Web Control DB
80C1 There are no resources to initialize the web application.

See also
Overview of the valid data types (Page 1320)
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9.7.5.5 TeleService

TM_MAIL: Transfer email

Description of TM_MAIL

Description       
The "TM_MAIL" instruction works asynchronously, in other words, its execution extends over 
multiple calls. You must specify an instance when you call the instruction "TM_MAIL". The 
attribute "retentive" may not be set in the instance. This attribute ensures that the instance is 
initialized when the CPU switches from STOP to RUN and that a new e-mail send job can be 
triggered afterwards.

You start the sending of an e-mail with an edge change from "0" to "1" for the REQ parameter. 
The job status is indicated by the output parameters BUSY , "DONE", "ERROR", "STATUS" 
and "SFC_STATUS". "SFC_STATUS" corresponds in this case to the "STATUS" output 
parameter of the called communication blocks. 

The output parameters DONE, ERROR, STATUS, and SFC_STATUS are each displayed for 
only one cycle if the status of the BUSY output parameter changes from "1" to "0". The following 
table shows the relationship between BUSY, DONE, and ERROR. Using this table, you can 
determine the current status of the instruction "TM_MAILand when the sending of the e-mail 
is complete.

DONE BUSY ERROR Description
0 1 0 The job is being processed.
1 0 0 Job successfully completed.
0 0 1 The job ended with an error. The cause of the error can be found in the STATUS and 

SFC_STATUS parameters.
0 0 0 The "TM_MAIL" instruction was not assigned a (new) job.

If the CPU changes to STOP mode while "TM_MAIL" is active, the communication connection 
to the mail server aborts. The communication connection to the mail server will also be lost if 
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communication problems occur on the Industrial Ethernet bus. In this case, the transfer of the 
e-mail will be interrupted and it will not reach its recipient.

 

 NOTICE

Changing user programs

You can change the parts of your user program that directly affect calls of "TM_MAIL" only:
● when the CPU is in "STOP" mode or
● when no mail is being sent (REQ = 0 and BUSY = 0).

This relates, in particular, to deleting and replacing program blocks that contain "TM_MAIL" 
calls or calls for the instance of "TM_MAIL".

Ignoring this restriction can tie up connection resources. The automation system can change 
to an undefined status for the TPC/IP communication functions via Industrial Ethernet.

A warm or cold restart of the CPU is required after the changes are transferred.
 

Data consistency
The ADDR_MAIL_SERVER input parameter of the instruction is taken from the "TM_MAIL" 
instruction again each time the sending of an e-mail is triggered. If a change is made during 
operation, the "new" value only becomes effective once an e-mail is triggered again. 

In contrast, the WATCH_DOG_TIME, TO_S, CC, FROM, SUBJECT, TEXT, ATTACHMENT, 
and, if applicable, USERNAME and PASSWORD parameters are taken from the "TM_MAIL" 
instruction while it is running, which means that they may only be changed after the job is 
complete (BUSY = 0)

Setting the parameters of the TS Adapter IE
On the TS Adapter IE, you need to specify parameters for outgoing calls in such a way as to 
enable the TS Adapter IE to establish a connection to the dial-up server of your service 
provider. 

If you set "When required" for connection establishment, the connection will only be established 
when an e-mail needs to be sent. 

Connection establishment can take longer (approx. one minute) for an analog modem 
connection. When you specify the WATCH_DOG_TIME parameter, remember to allow for the 
time required to establish the connection.
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Parameters
The following table shows the parameters of the "TM_MAIL" instruction:

Parameter Declaration Data type Memory area Description
REQ Input BOOL I, Q, M, D, L or 

constant
Control parameter REQUEST: Activates the sending 
of an e-mail on a rising edge.

ID Input CONN_OU
C (Word)

D, L or constant Reference to the connection to be established. See 
ID parameter of the TCON (Page 3240), TDISCON 
(Page 3248), TSEND (Page 3253), and TRCV 
(Page 3256) instructions. A number that is not used 
for any additional instances of this instruction in the 
user program must be entered here.

TO_S 
(Page 3294) 

Input STRING D Input parameter for receiver addresses:
STRING with a maximum length of 240 characters 
(see example call).

CC (Page 3294) Input STRING D Input parameter for CC recipient addresses 
(optional): STRING with a maximum length of 240 
characters (see example call).
If an empty string is assigned here, the e-mail is not 
sent to a CC recipient.

SUBJECT Input STRING D Input parameter for subject of the e-mail:
STRING with a maximum length of 240 characters.

TEXT Input STRING D Input parameter for text of the e-mail (optional):
Reference to a data string with a maximum length of 
240 characters.
If an empty string is assigned at this parameter, the 
e-mail is sent without text.

ATTACHMENT Input VARIANT I, Q, M, D, L Input parameter for e-mail attachment (optional): 
Reference to a byte/word/double word field with a 
maximum length of 65534 bytes.
If no value is assigned, the e-mail is sent without an 
attachment.

DONE Output BOOL I, Q, M, D, L ● DONE = 0: Job not yet started or still executing.
● DONE = 1: Job was executed without errors.

BUSY Output BOOL I, Q, M, D, L ● BUSY = 1: E-mail transmission is not yet complete.
● BUSY=0: The processing of "TM_MAIL" was 

stopped.
ERROR Output BOOL I, Q, M, D, L ERROR=1: An error occurred during processing. 

STATUS and SFC_STATUS supply detailed 
information about the type of error.

STATUS 
(Page 3295) 

Output WORD I, Q, M, D, L Output/status parameter STATUS:
Return value or error information of the "TM_MAIL" 
instruction.
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Parameter Declaration Data type Memory area Description
ADDR_MAIL_S
ERVER

Static* DWORD I, Q, M, D, L IP address input parameter of the mail server: Specify 
as a data word in HEX format, for example: IP address 
= 192.168.0.200.
ADDR_MAIL_SERVER = DW#16#C0A800C8, 
where:
● 192 = 16#C0,
● 168 =16#A8
● 0 = 16#00 and
● 200 = 16#C8.

WATCH_DOG_
TIME

Static* TIME I, Q, M, D, L Input parameter for max. period of time:
The "TM_MAIL" instruction should establish a 
connection within the period specified by 
WATCH_DOG_TIME. The block is exited with an 
error if this period is exceeded. The time before the 
block is exited and the error is output can exceed the 
WATCH_DOG_TIME because connection 
termination also takes a certain amount of time. To 
begin with, you should set a period of 2 minutes. If 
you have an ISDN telephone connection, a 
significantly shorter period can be selected.

USERNAME Static* STRING D Input parameter for user name:
STRING with a maximum length of 180 characters. A 
user name is an absolute requirement for 
authentication.

PASSWORD Static* STRING D Input parameter for password:
STRING with a maximum length of 180 characters. A 
password is an absolute requirement for 
authentication.

FROM 
(Page 3294) 

Static* STRING D Input parameter for sender address:
STRING with a maximum length of 240 characters 
(see example call).

SFC_STATUS 
(Page 3295) 

Static* WORD I, Q, M, D, L Output/status parameter "SFC_STATUS":
Error information of the called communication blocks.

*The values of the parameter are not modified at every call of the instruction "TM_MAIL". The values are in the static 
parameters of the instance and are only written once at the first call of the instruction.

You will find more detailed information on valid data types in "Overview of the valid data 
types (Page 1320)".

 

 Note
Optional parameters

The optional parameters CC, TEXT, and ATTACHMENT are only sent with the e-mail if the 
corresponding parameters contain a string of length > 0.
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SMTP authentication 
Authentication refers here to a procedure for ensuring an identity, for example, by a password 
query. 

The "TM_MAIL" instruction supports the SMTP authentication procedure AUTH-LOGIN that 
is requested by most mail servers. For information about the authentication procedure of your 
mail server, please refer to your mail server manual or the website of your Internet service 
provider. 

To use the AUTH-LOGIN authentication procedure, the "TM_MAIL" instruction requires the 
user name with which it can log onto the mail server. This user name corresponds to the user 
name with which you set up a mail account on your mail server. It is made available to the 
"TM_MAIL" instruction in the USERNAME parameter. 

To log on, the "TM_MAIL" instruction also requires the associated password. This password 
corresponds to the password you specified when you set up your mail account. It is made 
available to the "TM_MAIL" instruction in the PASSWORD parameter. 

The user name and the password are each transferred to the mail server unencrypted 
(BASE64-coded).

If no user name is specified in the DB, the AUTH-LOGIN authentication procedure is not used. 
The e-mail is then sent without authentication.

Parameters TO_S, CC, and FROM

Description
The TO_S, CC, and FROM parameters are strings with, for example, the following content:

● TO: <wenna@mydomain.com>, <ruby@mydomain.com>,

● CC: <admin@mydomain.com>, <judy@mydomain.com>,

● FROM: <admin@mydomain.com>

Note the following rules when entering the parameters:

● The "TO:", "CC:", and "FROM:" characters must be entered.

● A space and an opening pointed bracket "<" must be entered before each address.

● A closing pointed bracket ">" must be entered after each address.

● A comma must be entered after each address in TO and CC.

● Only one e-mail may be entered in FROM, and there must not be a comma at the end of 
this address

Because of runtime and memory space, the "TM_MAIL" instruction does not perform any 
syntax check of the parameters TO_S, CC and FROM.
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STATUS and SFB_STATUS parameters

Description
The return values of the "TM_MAIL" instruction can be classified as follows:

● W#16#0000: "TM_MAIL" was completed successfully

● W#16#7xxx: Status of "TM_MAIL"

● W#16#8xxx: An error was reported during the internal call of a communication block or from 
the mail server.

The following table shows the return values of "TM_MAIL" except for error codes of the 
internally called communication blocks.

Return value
STATUS*
(W#16#...):

Return value
SFB_STATUS
(W#16#...):

Explanation Notes

0000 - The processing of "TM_MAIL" was 
completed without error.

A without error completion of 
"TM_MAIL" does not mean that the 
sent e-mail will necessarily arrive (see 
below - note on point 1)

7001  "TM_MAIL" is active (BUSY = 1). Initial call; job has started
7002 7002 "TM_MAIL" is active (BUSY = 1). Intermediate call; job already active
8xxx xxxx The processing of "TM_MAIL" was 

completed with an error code of the internally 
called communication instructions.

For detailed information on the 
evaluation of the SFB_STATUS 
parameter, refer to the descriptions of 
the STATUS parameter of the 
communication instructions.

8010 xxxx Error during connection establishment. For further information on the 
evaluation of the SFB_STATUS 
parameter, refer to the descriptions of 
the STATUS parameter of the "TCON 
(Page 3240)" instruction.

8011 xxxx Error sending the data. For further information on the 
evaluation of SFB_STATUS, refer to 
the descriptions of the STATUS 
parameter of the "TSEND (Page 3253)" 
instruction.

8012 xxxx Error receiving the data. For further information on the 
evaluation of SFB_STATUS, refer to 
the descriptions of the STATUS 
parameter of the "TRCV (Page 3256)" 
instruction.

8013 xxxx Error during connection establishment. For further information on the 
evaluation of SFB_STATUS, refer to 
the descriptions of the STATUS 
parameter of the "TCON (Page 3240)" 
and "TDISCON (Page 3248)" 
instructions.
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Return value
STATUS*
(W#16#...):

Return value
SFB_STATUS
(W#16#...):

Explanation Notes

8014 - Establishment of a connection is not possible. You have possibly entered an incorrect 
mail server IP address 
(ADDR_MAIL_SERVER) or a time 
span that is too short 
(WATCH_DOG_TIME) to establish the 
connection. It is also possible that the 
CPU has no connection to the network 
or that the CPU configuration is 
incorrect.

8016 - Error copying the attachment -
82xx, 84xx, or 
85xx

- The error message originates from the mail 
server and corresponds, except for the "8", to 
the error number of the SMTP protocol.
The following columns list several error 
codes that can occur:

See point 2 in the note.

8450 - Action not executed: Mailbox not available/
not reachable.

Try again later.

8451 - Action aborted: Local processing error Try again later.
8500 - Syntax error: Error not recognized. This also 

includes the error when a command string is 
too long. This can also be occur when the e-
mail server does not support the LOGIN 
authentication procedure.

Check the parameters of "TM_MAIL". 
Try to send an e-mail without 
authentication. To do this, replace the 
USERNAME parameter with an empty 
string.

8501 - Syntax error: Parameter or argument 
incorrect

You have possibly entered an incorrect 
address in TO_S or CC.

8502 - Command unknown or not implemented. Check your entries, in particular the 
FROM parameter. This is possibly 
incomplete and you have forgotten "@" 
or ".".

8535 - SMTP authentication incomplete. You have possibly entered an incorrect 
user name or incorrect password.

8550 - Mail server cannot be reached, you have no 
access rights.

You have possibly entered an incorrect 
user name or password, or the mail 
server does not support your LOGIN. 
Another cause of error could be an 
incorrect entry of the domain name 
after the "@" in TO_S or CC.

8552 - Action aborted: Assigned memory size has 
been exceeded

Try again later.

8554 - Transmission failed. Try again later.
* The error codes can be displayed as integer or hexadecimal values in the program editor. For additional information on 
toggling display formats, refer to "See also".
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 Note
Status error
1. An incorrect entry of the recipient addresses does not generate a status error of the 

"TM_MAIL" instruction. In this case, there is no guarantee that the e-mail will be sent to 
other recipients, even if these were entered correctly.

2. You can find more detailed information on the SMTP error code and other error codes in 
SMTP protocol on the Internet or in the error documentation of the mail server. You can 
also view the most recent message from the mail server in your instance DB in the 
BUFFER1 parameter. If you look under "Data", you will find the data most recently sent 
by the "TM_MAIL" instruction.
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Visualize processes 10
10.1 Creating screens

10.1.1 Principles

10.1.1.1 Screen basics

Introduction
In WinCC you create screens that an operator can use to control and monitor machines and 
plants. When you create your screens, the object templates included support you in visualizing 
processes, creating images of your plant, and defining process values.

Application example
The figure shows a screen that was created in WinCC. With the help of this screen, the operator 
can operate and monitor the mixing station of a fruit juice manufacturing system. Fruit juice 
base is supplied from various tanks to a mixing unit. The screen indicates the fill level of the 
tanks. 

Screen design
Insert an object you need to represent a process into your screen. Configure the object to 
correspond to the requirements of your process.

A screen may consist of static and dynamic elements. 
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● Static elements such as text or graphic objects do not change their status in runtime. The 
tank labels (W, K, Z, A) shown in this example of a mixing unit are static elements.

● Dynamic elements change their status based on the process. Visual current process values 
as follows:

– From the memory of the PLC

– From the memory of the HMI device in the form of alphanumeric displays, trends and 
bars.

Input fields on the HMI device are also considered dynamic objects. The fill level values of 
the tanks in our example of a mixing plant are dynamic objects.

Process values and operator inputs are exchanged between the controller and the HMI device 
via tags.

Screen properties
The screen layout is determined by the features of the HMI device you are configuring. It 
corresponds with the layout of the user interface of this device. If the set HMI device has 
function keys, the screen shows these function keys. Other properties such as the screen 
resolution, fonts and colors are also determined by the characteristics of the selected HMI.

Function keys
A function key is a key on the HMI device to which you can assign one or several functions in 
WinCC. The functions are triggered as soon as the operator presses the key on the HMI device. 

A function key can be assigned global or local functions: 

Global function keys always trigger the same action, regardless of the currently displayed 
screen.

Local function keys trigger different actions depending on the currently displayed screen on 
the HMI device. This assignment applies only to the screen in which you have defined the 
function key.

Navigation
You configure a screen navigation to enable the operator to call a screen on the HMI device 
in Runtime. 

● The "Screen" editor is used to configure buttons for calling other screens.

● You use the "Global Screen" editor to configure globally assigned function keys.

See also
Overview of objects (Page 3336)

Basics on text lists (Page 3396)

Basic principles of graphics lists (Page 3406)

Basics on dynamizing screens (Page 3420)
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Basics on libraries (Page 6807)

Basics on faceplates (Page 3478)

Print job/Script diagnostics (Page 3529)

Basics on screen navigation (Page 3651)

10.1.1.2 Screen basics

Introduction
In WinCC you create screens that an operator can use to control and monitor machines and 
plants. When you create your screens, the object templates included support you in visualizing 
processes, creating images of your plant, and defining process values.

Application example
The figure shows a screen that was created in WinCC. With the help of this screen, the operator 
can operate and monitor the mixing station of a fruit juice manufacturing system. Fruit juice 
base is supplied from various tanks to a mixing unit. The fill levels of the tanks are indicated. 

Screen design
Insert an object you need to represent a process into your screen. Configure the object to 
correspond to the requirements of your process.

A screen may consist of static and dynamic elements: 

● Static elements such as text or graphic objects in the screen above do not change their 
status in Runtime. The tank labels (W, K, Z, A) shown in this example of a mixing unit are 
static elements.

● Dynamic elements change their status based on the process. Visual current process values 
as follows:

– From the memory of the PLC

– From the memory of the HMI device in the form of alphanumeric displays, trends and 
bars.

Input fields on the HMI device are also considered dynamic objects. The fill level values of 
the tanks in our example of a mixing plant are dynamic objects.
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Process values and operator inputs are exchanged between the controller and the HMI device 
via tags.

Navigation
You configure a screen navigation to enable the operator to call a screen on the HMI device 
in Runtime.

● You use the "Menus & Toolbars" editor to configure the navigation between the screens.

● The "Screen" editor is used to configure buttons for calling other screens.

10.1.1.3 Device-dependent functional scope of screens

Introduction
The functions of an HMI device determine the display of the device in WinCC and the scope 
of functions of the editors.

The following screen properties are determined by the functions of the selected HMI device:

● Device layout

● Screen resolution

● Number of colors

● Fonts

● Objects available

Device layout
The device layout of a screen forms the image of the HMI device in your configuration. The 
device layout of the screen shows all the function keys available on the HMI device, for 
example.   

Screen resolution
The screen resolution is determined by the different display dimensions of the various operator 
panels. You can only change the screen resolution if you configure the 
"WinCC Runtime Advanced" or "WinCC Runtime Professional" HMI device. 

Number of colors
You can assign colors to the screen objects. The number of possible colors is determined by 
the color depth and specific colors supported on the selected HMI device. 
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Fonts
You can customize the appearance of the texts in all the screen objects that contain static or 
dynamic text. How to highlight individual texts in a screen. Select the font, font style and size, 
and set additional effects such as underscoring, for example.  

The settings for the text markups such as font style and effects always refer to the entire text 
of a screen object. That is, you can display the complete title in bold format, but not its individual 
characters or words, for example. 

Objects available
Some of the screen objects can not be configured globally for all HMI devices. These screen 
objects are not displayed in the "Tools" task card. For a KTP 1000 touch panel unit you can 
not configure a slider, for example. 

10.1.1.4 Elements and Basic Settings

Task cards

Introduction
The following task cards are available in the "Screens" editor:   

● Tools: Display and operating objects

● Animations: Templates for dynamic configuration
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● Layout: Aid for customizing the display

● Libraries: Administration of the project library and of the global libraries
 

  Note
WinCC Basic

The "Animations" task card is not available in WinCC Basic.
 

Tools
The "Tools" task card contains objects in different panes:

● Basic objects

● Elements

● Controls

● User controls (optional)

● Graphics

You paste objects from the palettes into your screens by drag&drop or a double click. The 
objects available for selection are determined by the features of the HMI device you are 
configuring. The following icons are used to change the display mode:

Icon Meaning
Displays the objects as a list.

Displays the objects as a graphic.

Animations
The "Animations" task card contains the possible dynamizations of a screen object in the 
palettes. You paste the animations to a screen object by drag&drop or a double click from the 
"Movements", "Display" and "Tag Binding" palettes.

Layout
The "Layout" task card contains the following panes for displaying objects and elements:

● Layers: Serves to manage screen object layers The layers are displayed in a tree view and 
contain information about the active layer and the visibility of all layers.

● Grid: You specify whether you want to align the objects to a grid or to other objects and set 
the grid size for a grid. 

● Objects out of range: Objects that lie outside the visible area are displayed with name, 
position and type.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3304 System Manual, 02/2014



Libraries
The "Libraries" task card show the following libraries in separate panes:

● Project library: The project library is stored together with the project.

● Global library: The global library is stored in a separate file in the specified path on your 
configuration PC.

Zooming the view

Introduction
To view a small screen section in closer detail, use the zoom tool to magnify the screen in the 
working area. The maximum zoom amounts to 800%.     

You can zoom with the toolbar in the work area or with the "Layout > Zoom" task card.

There are different ways to increase the screen, for example, with the zoom factor or by 
adapting the work area to the height of the screen.

Requirement
The screen is opened.

Procedure
Proceed as follows to zoom a view with the selection frame:

1. Click the  toolbar button.

2. Use the mouse to draw a selection frame in the screen.

After you have released the mouse button, the section enclosed by the selection frame is 
zoomed to fit the complete work area. 

Alternatively, use the slider in the lower right-hand corner of the screen.

Result
The selected screen section is magnified. 

Move view

Introduction
To display only a section of the entire screen in the work area, use the  icon of the "Screens" 
editor:
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Requirement
● A screen is open.

● The view shows only a screen section.

Procedure
To move the view:

1. Click the  icon at the bottom right corner of the work area and press the left mouse button.
A miniature view of the full screen is shown. An orange frame shows the currently selected 
area.

2. Hold down the mouse button and drag the frame to the desired area.
 

  Note

The screen is scrolled when you drag a screen object from the visible to a currently hidden 
section. 

 

10.1.1.5 Working with screens

Steps

Steps
To create screens, you need to take the following initial steps:   

● Plan the structure of the process visualization: Number of screens and their layout
Example: Subprocesses are visualized in separate screens, and merged in a master screen.

● Define your screen navigation control strategies.

● Adapt the templates and the global screen.
You define objects centrally and assign function keys for example. 

● Create the screens. Use the following options of efficient screen creation:

– Working with libraries

– Working with layers

– Working with faceplates
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Steps

Steps
To create screens, you need to take the following initial steps:   

● Plan the structure of the process visualization: Number of screens and their layout Example: 
Subprocesses are visualized in separate screens, and merged in a master screen.

● Define your screen navigation control strategies.
Create the menus and toolbars to navigate between the screens.

● Create the screens. Use the following options to achieve efficient screen configuration:

– Working with libraries

– Working with faceplates

– Working with layers

– Working with designs

See also
Basics on working with designs (Page 3319)

Creating a new screen

Introduction
Create screens to display processes in your system.   

Requirement
● The project has been created.

● The Inspector window is open.
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Procedure
1. Double-click "Screens > Add New Screen" in the project navigation.

The screen is generated in the project and appears in your view. The screen properties are 
shown in the Inspector window.

2. Enter a meaningful name for the screen.

3. Configure the screen properties in the Inspector window:

– Specify whether and on which template the screen is based.

– Set the "Background Color" and the "Screen Number."

– Specify a documenting text under "Tooltip".

– Specify the layers to be displayed under "Layers" in the engineering system.

– Select dynamic screen update under "Animations."

– Select "Events" to define which functions you want to execute in Runtime when you call 
and exit the screen or at other events.

 

  Note

Not all HMI devices support the "Visibility" animation.
 

Result
You created the screen in your project. You can now paste objects and control elements from 
the "Tools" task card and assign function keys in further work steps.

Creating a new screen

Introduction
Create screens to display processes in your system.     

Requirement
● The project has been created.

● The Inspector window is open.

Procedure
To create a new screen:

1. Double-click "Screens > Add New Screen" in the project tree.
The screen is generated in the project and appears in your view. The screen properties are 
shown in the Inspector window.

2. Enter a meaningful name for the screen, such as "Overview_Diagram."
Do not use the special characters ?, . , ", /, \, *, <, >
This name is language-neutral.
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3. If required, enter a descriptive display name to be shown in runtime.
The name is language-specific and can be translated for the required languages.

4. Configure the screen in the Inspector window:

– Set the background color and the grid color under "General."

– Specify a tooltip providing additional information.

– Specify the size of the screen under "Layout."

– Define the pattern and the color of a fill pattern under "Appearance."

– Specify the layers to be displayed under "Layers" in the engineering system.

– Specify the tab sequence for activating the screen objects and selecting the objects to 
be activated under "Miscellaneous."

– Under "Hide/Show" specify whether a size to be defined is used to determine the display 
for layers and/or objects.

– Dynamize the display and operating objects under "Animations."

– Select "Events" to define which functions you want to execute in runtime when you call 
and exit the screen or at other events.

Result
You created the screen in your project. You can now paste objects and control elements from 
the "Toolbox" task card in further work steps.

Managing Screens

Introduction
You can move screens within a project to other groups, or copy, rename, and delete them.          

Moving screens in a group
1. Select the "Screens" folder in the project tree.

2. Select the "Add group" command from the shortcut menu.
A folder called "Group_x" is inserted.

3. Select the screen in the project tree.

4. Drag-and-drop the screen to the required group.
The screen is moved into this group.

Copy screen
1. Select the screen in the project tree.

2. Select the "Copy" command in the shortcut menu to copy the screen to the clipboard.
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3. In the project tree, select the screen insert position.

4. Select "Paste" from the shortcut menu to insert the screen.
A copy of the screen is inserted. A consecutive number is appended to the name of the 
original in the copy. 

Alternatively, press <Ctrl> while you drag the screen to the required position.
 

 Note

If you copy a screen with interconnected template for several devices and projects, the 
template will also be copied. Any existing matching template is not used. This holds 
particularly true when you copy the screens with drag-and-drop.

 

Rename screen
1. Select the screen in the project tree.

2. Select "Rename" from the shortcut menu.

3. Type in a new name.

4. Press <Enter>.

As an option, use the <F2> function key to rename the screen.

Delete screen
1. Select the screen in the project tree.

2. Select "Delete" from the shortcut menu.
The screen and all its objects are deleted from the current project. 

Defining the start screen of the project

Introduction
The start screen is the initial screen opened at the start of project in Runtime. You can define 
a different start screen for each one of the HMI devices. Beginning at this start screen, the 
operator calls the other screens.     

Requirement
The project contains the screen you want to use as the start screen.
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Procedure
1. Double-click "Runtime settings > General" in the project tree.

2. Select the desired screen as "Start screen".

Alternatively select a screen in the project tree and select "Use as start screen" in the shortcut 
menu.

Result
The start screen opens on the HMI at the start of Runtime. 

Defining the start screen of the project

Introduction
The start screen is the initial screen opened at the start of project in Runtime. You can define 
a different start screen for each one of the HMI devices. Beginning at this start screen, the 
operator calls the other screens.     
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Requirement
The project contains the screen you want to use as the start screen.

Procedure
1. Double-click "Runtime settings > General" in the project tree.

2. Select the desired screen as "Start screen".

Alternatively select a screen in the project tree and select "Use as start screen" in the shortcut 
menu.

Result
The start screen opens on the HMI at the start of Runtime. 
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10.1.1.6 Working with templates

Basics on working with templates

Introduction
Configure the objects in a template which are to be displayed in all screens based on this 
template.

Note the following rules:

● A screen must not be based on a template.

● A screen is only based on one template.

● You can create several templates for one device.

● A template cannot be based on another template.

Objects for a template
You determine functions and objects in the template which are to apply for all screens based 
on this template:

● Assignment of function keys: You also assign the function keys in the template for HMI 
devices with function keys. This assignment overwrites a possible global assignment.

● Permanent window: Some devices support a permanent window for all screens in the top 
area of the screen. In contrast to the template, the permanent window occupies an area of 
the screen for itself alone.

● Operator controls: You can paste all screen objects which you also use for a screen into a 
template.

Application examples
● You want to assign the ActivateScreen" function to a function key in the template. The 

operator uses this key to switch to another screen in runtime. This configuration applies to 
all screens that are based on this template.

● A graphic with your company logo can be added to the template. The logo appears on all 
screens that are based on this template.

 

  Note

If an object from the template has the same position as an object in the screen, the 
template object is covered.

 

See also
Configuring a permanent window in the template  (Page 3316)

Using a template in the screen (Page 3318)
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Creating a new template (Page 3315)

Managing a template (Page 3317)

Global screen (Page 3314)

Global screen

Introduction
You define global elements for all screens of an HMI device independently of the used 
template.  

Function keys  
For HMI devices with function keys you assign the function keys globally in the "Global Screen" 
editor. This global assignment applies for all screens of the HMI device.

Proceed as follows to assign function keys locally in screens or templates:

1. Click the function key in your screens or templates.

2. Deactivate "Properties > Properties > General > Use Global Assignment" in the inspection 
window.   

Indicator and control objects for alarms 
The "Alarm window" and "Alarm indicator" objects that are available as global objects are 
configured within the "Global screen" editor.

The "Alarm window" and "Alarm indicator" are always shown in the foreground.

For Comfort Panels you also have the possibility of configuring a "System diagnostic view" in 
the global screen.

 

 Note

If you have configured a permanent window in a template, do not position the alarm window 
and alarm indicator in the area of the permanent window. Otherwise, the alarm window and 
the alarm indicator will not be displayed in Runtime. 

The permanent window is not visible in the "Global screen" editor. 
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Order of configuration of screens  
The following order applies for the configuration:

● The global screen comes before screens and templates

● Screens come before templates

The system layer is not configurable. This contains

● input dialog boxes

● alarms from the operating system

● the direct keys for touch panels

See also
Basics on working with templates (Page 3313)

Creating a new template

Introduction
In a template, you can centrally modify objects and function keys. Changes to an object or of 
a function key assignment in the template are applied to the object in all the screens which 
are based on this template.   

 

 Note
HMI device dependency

Function keys are not available on all HMI devices.
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Requirement
● The project has been created.

● The Inspector window is open.

Procedure
1. Select "Screen management > Templates" in the project tree and then double-click "Add 

new template".
The template is created in the project, and appears in your view. 
The properties of the template are displayed in the Inspector window.

2. Define the name of the template under "Properties > Properties > General" in the Inspector 
window.

3. Specify the layers in the engineering system that are displayed under "Properties 
>Properties >Layers" in the Inspector window.

4. Add the necessary objects from the "Tools" task card.

5. Configure the function keys.

Result
The template is created in your project. 

See also
Basics on working with templates (Page 3313)

Configuring a permanent window in the template 

Introduction
In the permanent window you configure objects which are visible in all screens. In contrast to 
the template, the permanent window occupies an area of the screen for itself alone.
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Configuring permanent windows
Proceed as follows to configure a permanent window:  

1. Open a template for a HMI device with a permanent window.

2. Use the mouse (cursor shape: ) to drag the top edge of the editable screen area down.

3. Configure the desired objects in the area of the permanent window.

The default height of the permanent window is "0". The maximum height is the maximum height 
of the screen minus 10 pixels.

Result
The content of the permanent window appears on every screen, and in the template. The area 
above this line is now used as a permanent window in all the screens of the HMI device. Already 
configured objects in the screens are moved down by the height of the permanent window.

See also
Basics on working with templates (Page 3313)

Managing a template

Introduction
You can move, copy, rename, and delete templates within a project in the Project window.          

Moving a template into a group
1. Select the templates in the project navigation "Screen management > Templates".

2. Select "Add group" in the shortcut menu.
A folder called "Group_x" is inserted.
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3. Select the template in the project navigation.

4. Drag-and-drop the template to the required group.
The template is moved to this group.

Copying templates
1. Select the template in the project navigation.

2. Select "Copy" in the shortcut menu.

3. Select the position in the project navigation where you want to paste the template.

4. Select "Paste" from the shortcut menu to insert the template.
A unique name is assigned automatically to the copy. 

Alternatively, you can hold down the <Ctrl> key, and drag the template into position.

Deleting a template
1. In the project navigation, select the template to be deleted.

2. Select "Delete" in the shortcut menu.
The template, and all its objects are deleted from the current project. 

Assigning a template to a screen
1. In the project navigation, select the screen to which you want to assign the template.

2. In the Inspector window, select "Properties > Properties > General".

3. Select the desired template under "Template."
The selected template and all the objects contained in it are assigned to the screen. 

See also
Basics on working with templates (Page 3313)

Using a template in the screen

Introduction
You use a template in the screen. All the objects configured in the template are also available 
in the screen.

Requirement
A template has been created.

A screen has been created.
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Procedure
Proceed as follows to use a template in a screen:   

1. Double click a screen in the project tree. The screen opens in the work area.

2. Open "Properties > Properties > General" in the inspector window.

3. Select a template that is to be applied to the screen under "Template".

Show template in screen
When you edit a screen, you can show an existing template in the screen. 

Proceed as follows to show a template in the screen:

1. Activate "Extras > Settings > Visualization > Show template in screens" in the menu.

Result
The screen is based on the selected template. All objects which you have configured in the 
template are available in the screen. The template is displayed in the screen. 

See also
Basics on working with templates (Page 3313)

10.1.1.7 Working with designs

Basics on working with designs

What are designs?     
Designs are templates for displaying screens and the objects configured there. A design 
contains, for example, color specifications for foreground, border line, text, etc..

The design is applied to the following objects: 

● Screens

● Menus and toolbars

● Screen objects

Application
To design the user interfaces of several HMI devices in a uniform layout, assign the same 
design to each HMI device.

You can modify the layout of screens and objects by customizing the current design to suit 
your requirements. The new design is activated automatically for all screens and objects of 
the HMI device.
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Managing designs  
You manage designs in the "Designs" editor. 

WinCC features a number of predefined designs such as "WinCC Classic" for user interfaces 
in the classic WinCC layout and "WinCC Glass" for user interfaces in the style of Windows 
Vista. Predefined designs cannot be deleted or changed.

See also
Use default design (Page 3326)

Managing designs (Page 3320)

Applying a design (Page 3324)

Managing designs

Designs editor

Introduction
Designs are project-specific. The "Designs" editor is available in the project tree under 
"Common data".
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Structure of the "Designs" editor  
The "Designs" area lists all designs. The "Preview" area shows how images and objects are 
displayed with the selected design. 

Predefined designs are grayed out and cannot be deleted or manipulated. The default design 
is selected in the "Default" column.

Click the desired design in the "Designs" list for a preview of another design. The "Preview" in 
the right pane is refreshed: 

● The first line offers a preview of the menu layout.

● The icons on the left offer a preview of the layout of the toolbar.

● The objects of the "Tools" task card are grouped by basic objects, elements and controls.

You can find detailed information on which layout properties are specified by the design in the 
Inspector window.
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See also
Basics on working with designs (Page 3319)

Use default design (Page 3326)

Applying a design (Page 3324)

Creating a design (Page 3322)

Changing a design (Page 3322)

Deleting a design (Page 3323)

Creating a design

Requirement
The "Designs" editor is open.

Procedure   
Proceed as follows:

1. Click "Add" in the list of designs.
A new design is created. The WinCC default properties are set for screens, menus, toolbars 
and objects. 

2. Overwrite the suggested name with a meaningful name.

3. Enter a description of the design, e.g. the intended use in the "Comment" column.

4. Configure the design as required.

Result
You have created and configured a new design.

See also
Designs editor (Page 3320)

Changing a design (Page 3322)

Deleting a design (Page 3323)

Basics on working with designs (Page 3319)

Changing a design

Requirement
The "Designs" editor is open.
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Procedure   
Proceed as follows:

1. Select the design you wish to change from the list of designs.
 

  Note

You cannot manipulate the predefined designs of WinCC.
 

2. Make the required changes in the Inspector window.

3. Check the result in the preview.

The changes are effective immediately. 

See also
Designs editor (Page 3320)

Creating a design (Page 3322)

Deleting a design (Page 3323)

Basics on working with designs (Page 3319)

Deleting a design

Requirement
The "Designs" editor is open.

Procedure    
Proceed as follows:

● Select "Delete" from the shortcut menu of the desired design.
 

  Note

You cannot manipulate the predefined designs of WinCC.
 

Result
The design is deleted. WinCC assigns the predefined "WinCC Classic" design as the new 
default design to HMI devices to which the deleted design was assigned as default in the 
Runtime settings.

See also
Designs editor (Page 3320)

Creating a design (Page 3322)
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Changing a design (Page 3322)

Basics on working with designs (Page 3319)

Applying a design

Applying a design

Core message   
In WinCC, every HMI device is assigned a design as a basic design. The following basic design 
specifications are applied to all screens of the HMI device:

● Settings relating to the display of the shadow of an object (if "Shadow" is activated for the 
object)

● Settings relating to the display of elements when the mouse pointer is moved over them 
(hover effect)

● Settings relating to the layout of menus and toolbars

For the individual screens, elements and controls, you also specify in each case whether the 
specifications of the basic design or the individual settings are applied in the Inspector window.

See also
Basics on working with designs (Page 3319)

Designs editor (Page 3320)

Use default design (Page 3326)

Specifying the basic design user interface of an HMI device (Page 3324)

Applying design templates to screens (Page 3325)

Using design templates for basic objects and elements (Page 3325)

Applying design templates to controls (Page 3326)

Specifying the basic design user interface of an HMI device

Procedure
To change the basic design of the user interface of an HMI device, follow the steps below:

1. Open the "Runtime settings" of the HMI device.

2. Under "General > Settings", specify whether the default design or a different design is used 
as the basic design.
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See also
Applying a design (Page 3324)

Applying design templates to screens (Page 3325)

Using design templates for basic objects and elements (Page 3325)

Applying design templates to controls (Page 3326)

Basics on working with designs (Page 3319)

Applying design templates to screens

Procedure 
Proceed as follows to use design templates for the representation of images on a screen:

1. Open the desired screen in the "Screens" editor.

2. Activate "Properties > Properties > Design > Settings > Use color scheme" in the Inspector 
window.

Result
The settings of the design are applied to the screen. 

All the settings that are not predefined by the design are activated and can be changed.

See also
Applying a design (Page 3324)

Specifying the basic design user interface of an HMI device (Page 3324)

Using design templates for basic objects and elements (Page 3325)

Applying design templates to controls (Page 3326)

Basics on working with designs (Page 3319)

Using design templates for basic objects and elements

Procedure  
To apply the design specifications for the layout of basic elements and elements, proceed as 
follows:

1. Open the screen in the "Screens" editor.

2. Click the required object in the work area.

3. Select the group settings "Properties > Properties > Designs" in the Inspector window.

4. Activate "Shadow" to visualize the object with a shadow.

5. Activate "Use color scheme" to to apply the default colors of the design.
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Result
The design settings are applied to the object. In the Inspector window, the fields for setting the 
background color, frame etc. are deactivated. All the settings that are not predefined by the 
design are activated and can be changed.

If the "Shadow" option is deactivated in the design, the object is displayed without a shadow 
in the screen - even if a "shadow" is activated in the object properties.

See also
Applying a design (Page 3324)

Specifying the basic design user interface of an HMI device (Page 3324)

Applying design templates to screens (Page 3325)

Applying design templates to controls (Page 3326)

Basics on working with designs (Page 3319)

Applying design templates to controls

Procedure 
Proceed as follows to apply design templates for visualization of controls:

1. Open the screen in the "Screens" editor.

2. Click the required object in the work area.

3. Deactivate "Properties > Properties > Appearance > Style > Use project settings for design".

4. Select the design from the selection list.

The control is displayed in the style specified in the design. 

See also
Applying a design (Page 3324)

Specifying the basic design user interface of an HMI device (Page 3324)

Applying design templates to screens (Page 3325)

Using design templates for basic objects and elements (Page 3325)

Basics on working with designs (Page 3319)

Use default design

Introduction   
A design is specified as a default design. If you want to design the user interfaces of several 
HMI devices in a uniform layout, specify the desired design as the default design, and assign 
it to the HMI devices as the basic design in the Runtime settings "Default design". 
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If you want to change the layout of the screens and objects, adapt the default design to your 
requirements or configure a different design as the default design. The latter is the actual 
advantage of working with the default design: You can practically change the layout for the 
screens and objects of all the HMI devices at the click of a mouse. 

Configuring a default design
Proceed as follows:

1. Open the "Designs" editor.

2. Select the desired design in the list of designs in the "Default" column in the work area.
Or:
Display a preview of the desired desire in the work area and select "Properties > Properties 
> General > Design > Default" in the Inspector window.

3. If required, adapt the design to your requirements.

Use default design
The default design settings are effective for the objects which satisfy the following conditions:

● "Runtime settings > General > Settings > Use default design" is activated for the HMI device.

● For screens, basic elements and elements: "Properties > Properties> Design > Settings > 
Use color scheme" is selected in the Inspector window.

● For controls: "Properties > Properties > Appearance > Style > Accept project settings" is 
selected in the Inspector window.

See also
Basics on working with designs (Page 3319)

Designs editor (Page 3320)

Applying a design (Page 3324)

10.1.1.8 Working with styles

Basics on working with styles

Introduction
The style editor is a global editor. You define a uniform appearance for display and operating 
elements in the style editor. In this way, you harmonize the display of objects in Runtime. The 
style editor offers predefined styles. You can choose one of the predefined styles or create 
your own style. You use the style editor independently of devices and projects.

Views in the style editor
Objects are grouped in the style editor according to their main visual features.
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The following groups are available:

● Buttons, lines, and polygon-based objects

● Text-based objects

● Trend-based objects, such as trend view

● Graphic or value-based objects, such as value table.

See also
Managing styles (Page 3331)

Defining a style (Page 3329)

Displaying predefined styles (Page 3328)

Displaying predefined styles

Introduction
In the "Style" editor, you see predefined styles and create your own styles for representing 
display and operating objects in Runtime.

Open "Styles" editor
1. Double-click "Common data" in the project navigation.

2. Click the "Styles" editor. The editor opens.
 

  Note
Style editor in the project navigation

The style editor is only visible in the project navigation if a device that supports styles, 
e.g., Comfort Panels, is created in the project.

 

3. The standard styles are displayed in the work area of the "Style" editor:

● WinCC Light

● WinCC Dark

● WinCC Fresh

● WinCC Wireframe.

Result
The settings for the groups and individual objects are displayed in the work area.

You will assign predefined styles or define your own styles in the next steps.

Predefined styles are write-protected and cannot be changed.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3328 System Manual, 02/2014



See also
Basics on working with styles (Page 3327)

Defining a style

Introduction
In the "Styles" editor, you see predefined styles. Predefined styles are write-protected and 
cannot be changed. 

In addition, you have the option of defining your own styles and applying them to individual 
objects, groups, and even projects.

Defining a style
1. Open the "Common data" folder in the project navigation.

2. Open the "Style" editor.

3. Click "Add new type" in the "Styles" area. 
A new style is created.
The library view opens. The version of the type is displayed in the "Types" folder. The 
version 0.0.1 has the status "in progress".
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4. In the Inspector window, select the colors, borders and other settings for individual objects.

5. In order to activate the new style, select the current version "in progress" and select 
"Release version" in the shortcut menu.
The new style appears in the "Styles" editor.

Result
You have added a new style which can be applied to objects or projects.
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Defining a style based on a predefined style 
1. Open the "Common data" folder in the project navigation.

2. Open the "Style" editor.

3. Select a predefined style in the work area. 

4. Select the "Duplicate type" command in the shortcut menu.
The "Duplicate type" dialog opens. 

5. Overwrite the suggested name with a meaningful name.

6. In the "Comment" column, enter a description of the style, e.g. the intended use.

7. Click "OK" to confirm your input.

8. Select the created type in the project library.

9. Select "Edit new type" in the shortcut menu.
The library view opens. The version of the type is displayed in the "Types" folder. The 
version 0.0.2 has the status "in progress".

10.Configure the type as required.

11.Select the "Release version" command from the shortcut menu of the edited version. 

Result
They have configured a new style based on the predefined style of WinCC.

See also
Basics on working with styles (Page 3327)

State of type versions (Page 6825)

Managing styles

Deleting a style
You can delete styles that you have defined yourself.

1. Open the "Common data" folder in the project navigation.

2. Open the "Style" editor.

3. Select the style in the work area that you want to delete.
 

  Note

You cannot delete the predefined styles of WinCC.
 

4. Select the "Delete" command in the shortcut menu.

The style is deleted.
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Editing a style
You can edit styles that you have defined yourself.

1. Open the project library.

2. Select the released version of the style that you want to change.

3. Select "Edit type" in the shortcut menu.
A new version "in progress" is created.

4. Make the required changes in the Inspector window.

5. Select the "Release version" command from the shortcut menu of the edited version to put 
the changes into effect.
The changes made take effect.

Determining a standard style for a project 
A project can be assigned a standard style to achieve a visual conformity of all display objects 
in the project.

1. Open the "Common data" folder in the project navigation.

2. Open the "Style" editor.

3. Activate a style in the work area.

The activated style is used as standard style in the project. When you add a device to the 
project, this device uses the standard style.

Changing the style for a specific device
Within a project, you change the style for a specific device.

1. Open the "Runtime settings" editor of the HMI device.

2. Select a device style under "General".

The selected style is applied to the device. 

If the device style is not assigned, the device uses the standard style of the project.

 

See also
Basics on working with styles (Page 3327)
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10.1.2 Working with Objects

10.1.2.1 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.    

The "Toolbox" task card contains all objects that can be used for the HMI device.

Display the tool window with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example "Trend view" and "Recipe view".

● "User-specific controls"
In this palette you can add ActiveX control to the Toolbox window. Only the ActiveX controls 
that are registered in the Windows operating system on the configuration computer are 
available. From this palette you incorporate ActiveX controls into your project.

● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating objects, the library objects are available. They are 
located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches". 
You may also store customized objects and faceplates in user libraries. Faceplates are 
objects that you create from existing screen objects, and for which you define the 
configurable properties. 
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Basic objects

Icon Object Instructions
"Line" -

"Polyline" The polyline is an open object. Even if the start and end points have 
the same coordinates, the area they enclose cannot be filled in. If 
you want to fill a polygon, select the "Polygon" object.

"Polygon" -

"Ellipsis" -

"Circle" -

"Rectangle" -

"Circular arc" The circular arc is an open object. Even if the start and end points 
have the same coordinates, the area they enclose cannot be filled 
in. If you want to fill a circle, select the "Circle" or "Circle segment" 
object.

"Ellipse arc" An ellipse arc is an open object. Even if the start and end points 
have the same coordinates, the area they enclose cannot be filled 
in. If you want to fill an ellipse, select the "Ellipse" or "Ellipse 
segment" object.

"Circle segment" -

"Ellipse segment" -

"Connector" Connects objects with lines.

"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".

"Pipe" Represents a continuous pipe with several bends in a pipe system.

"Double T-piece" Represents a pipe junction in a pipe system.

 "T piece" Represents a T-shaped pipe connection.

"Pipe bends" Represents a bent section of pipe.

Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. To 
hide the operator input in runtime, configure "Hidden input".

"Button" Executes a list of functions, or a script as configured.

"Round button" Operates processes, such as acknowledge messages.
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Icon Object Instructions
"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A text 

from a text list is displayed in relation to the tag value.
"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A 

graphic from a graphics list is displayed in relation to the tag value.
"Bar" The bar represents a value from the PLC in the form of a scaled 

bar graph.
"Symbol library" Used to add screen objects based on controls of the same name. 

"Slider" Used to display a current value or to enter a numeric value.

"Scroll bar" Enters a numerical value at the PLC. The value can be adjusted 
smoothly.

"Check box" Selects options.

"Option button" Selects an option.

"Gauge" Displays numeric values.
The appearance of the gauge is adjustable.

"Clock" Displays the system time in analog or digital format.

Controls

Icon Object Description
"Screen window" Displays other screens of the object.

"f(t) trend view" Represents multiple curves with values from the PLC, 
or from a log.

"f(x) trend view" Represents the values of a tag as a function of another 
tag.

"Table view" Represents current or archived process data in a table.

"Value table" Represents evaluated data and statistics in a table.

"System diagnostics view" Provides an overview of all diagnostics capable devices.
Displays errors in the plant.

"User view" Allows an administrator to administer users on the HMI 
device.
It also allows an operator without administrator rights to 
change his password.

"HTML browser" Displays HTML pages.

"Print job/Script diagnostics" Displays data of the Global Script application and of the 
log system for editing.

"Recipe view" Used to display and modify recipes.

Media Player Enables video and audio files to be played.

"Memory space view" Shows the existing memory size.
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Icon Object Description
"Channel diagnostics" Allows users to control the active connections.

"Alarm view" Shows currently pending alarms or alarm events from 
the alarm buffer or alarm log.

"PLC Code Display" Displays the PLC programs which have been 
programmed in the LAD or FBD programming 
languages.

"S7-GRAPH Overview" Shows the current status of the program in a sequence 
and single step view.

 

 Note

Some of the toolbox objects are either available with restricted functionality, or not at all. This 
depends on the HMI device you are configuring. Unavailable properties of an object are 
displayed as deactivated, and cannot be selected.

 

See also
Example: Inserting and configuring a rectangle (Page 3392)

10.1.2.2 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.     

The "Tools" task card contains all objects that can be used for the HMI device. Display the 
Task Card with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:

● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example Trend view and Recipe view.
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● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

– Flags

– Buildings

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches".
You can also store customized objects, and faceplates in user libraries.
Faceplates are objects that you create from existing screen objects, and for which you 
define the configurable properties. 

 

  Note
HMI device dependency

Some of the toolbox objects are either available with restricted functionality, or not at all. 
This depends on the HMI device you are configuring. Unavailable properties of an object 
are displayed as deactivated, and cannot be selected. 

 

Basic objects

Icon Object Instructions
"Line" -

"Polyline" The polyline is an open object. Even if the start and end points have 
the same coordinates, the area they enclose cannot be filled in. If you 
want to fill a polygon, select the "Polygon" object.

"Polygon" - 

"Ellipsis" -

"Circle" -

"Rectangle" -

"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".
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Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes 

values to a tag.
You can define limits for the tag values 
shown in the I/O field. To hide the operator 
input in runtime, configure "Hidden input".

"Button" Executes a list of functions, or a script as 
configured.

"Symbolic I/O field" Outputs the values of a tag, and/or writes 
values to a tag. A text from a text list is 
displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes 
values to a tag. A graphic from a graphics 
list is displayed in relation to the tag value.

"Date/time field" Outputs the system date and time, or the 
time and date from a tag. This allows the 
operator to enter new values. The display 
format is adjustable.

"Bar" The bar represents a value from the PLC in 
the form of a scaled bar graph.

"Charge condition" Shows the charge condition of the battery 
for Mobile Wireless 

"Switch" Toggles between two defined states. You 
can label a switch with text, or a graphic.

"Slider" Displays a current value from the PLC, or 
sends a numeric value to the PLC.

"Symbol library" Used to add screen objects based on 
controls of the same name. 

"Effective range 
name"

Shows the name of the effective range.

"Effective range 
name (RFID)"

Displays the name of the effective range 
(RFID).

"Effective range 
signal"

Indicates how accurately the Mobile Panel 
Wireless is positioned within an effective 
range. 

"WLAN reception" Indicates how good the WLAN radio 
connection is.

"Gauge" Displays numeric values.
The appearance of the gauge is adjustable.

"Zone name" Displays the name of the zone.

"Zone signal" Indicates how accurately the Mobile Panel 
Wireless is positioned within a zone.

"Clock" Displays the system time in analog or digital 
format.
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Controls

Icon Object Description
"Alarm view" Shows currently pending alarms or alarm events from 

the alarm buffer or alarm log.
"Trend view" Represents multiple curves with values from the PLC, 

or from a log.
"User view" Allows an administrator to administer users on the HMI 

device.
It also allows an operator without administrator rights 
to change his password.

"HTML browser" Displays HTML pages.

"Status/Force" This function gives the operator direct read / write 
access from the HMI device to individual address 
areas in the connected SIMATIC S7.

"Sm@rtClient view" Allows an operator to monitor and maintain a 
connected device remotely.

"Recipe view" Displays data records, and allows them to be edited.

"f(x) trend view" Represents the values of a tag as a function of another 
tag.

"System diagnostics 
view"

Provides an overview of all diagnostics capable 
devices.
Displays errors in the plant.

"Media Player"  Media files are shown in the media player.

See also
Screen basics (Page 3299)

Rotating an object in runtime (Page 3363)

Flashing (Page 3368)

Inserting multiple objects of the same type (stamping tool) (Page 3369)

Overview of objects (Page 3339)

10.1.2.3 Overview of objects

Introduction
Objects are graphics elements which you use to design the screens of your project.     

The "Tools" task card contains all objects that can be used for the HMI device. Display the 
Task Card with menu command "View" by activating the "Task Card" option. 

The toolbox contains various palettes, depending on the currently active editor. If the "Screens" 
editor is open, the toolbox contains the following palettes:
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● "Basic objects"
The basic objects include basic graphic objects such as "Line", "Circle", "Text field" or 
"Graphic view". 

● "Elements"
The elements include basic control elements, e.g. "I/O field", "Button" or "Gauge".

● "Controls"
The controls provide advanced functions. They also represent process operations 
dynamically, for example Trend view and Recipe view.

● "Graphics"
Graphics are broken down into subjects in the form of a directory tree structure. The various 
folders contain the following graphic illustrations:

– Machine and plant areas

– Measuring equipment

– Control elements

– Flags

– Buildings

You can create links to your own graphic folders. The external graphics are located in these 
folders and subfolders. They are displayed in the toolbox and incorporated into the project 
using links. 

● "Libraries" task card
In addition to the display and operating elements, the library objects are available. They 
are located within the palettes of the "Libraries" task card. A library contains preconfigured 
objects such as graphics of pipes, pumps, or preconfigured buttons. You can also integrate 
multiple instances of library objects into your project without having to reconfigure them.
The WinCC software package includes libraries, e.g. "HMI Buttons & Switches".
You can also store customized objects, and faceplates in user libraries.
Faceplates are objects that you create from existing screen objects, and for which you 
define the configurable properties. 

 

  Note
HMI device dependency

Some of the toolbox objects are either available with restricted functionality, or not at all. 
This depends on the HMI device you are configuring. Unavailable properties of an object 
are displayed as deactivated, and cannot be selected. 

 

Basic objects

Icon Object Instructions
"Line" -

"Ellipse" -

"Circle" -

"Rectangle" -

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3340 System Manual, 02/2014



Icon Object Instructions
"Text field" One or more lines of text. The font and layout are adjustable.

"Graphic view" Displays graphics from external graphic programs, and inserts OLE 
objects. The following graphic formats can be used: "*.emf", "*.wmf", 
"*.dib", "*.bmp", "*.jpg", "*.jpeg", "*.gif" and "*.tif".

Elements

Icon Object Instructions
"I/O field" Outputs the values of a tag, and/or writes values to a tag.

You can define limits for the tag values shown in the I/O field. To 
hide the operator input in runtime, configure "Hidden input".

"Button" Executes a function list, or a script as configured.

"Symbolic I/O field" Outputs the values of a tag, and/or writes values to a tag. A text from 
a text list is displayed in relation to the tag value.

"Graphic I/O field" Outputs the values of a tag, and/or writes values to a tag. A graphic 
from a graphics list is displayed in relation to the tag value.

"Date/time field" Outputs the system date and time, or the time and date from a tag. 
This allows the operator to enter new values. The display format is 
adjustable.

"Bar" The bar represents a value from the PLC in the form of a scaled bar 
graph.

"Switch" Toggles between two defined states. You can label a switch with 
text, or a graphic.

Controls

Icon Object Description
"Alarm view" Shows currently pending alarms or alarm events from 

the alarm buffer or alarm log.
"Trend view" Represents multiple curves with values from the PLC, 

or from a log.
"User view" Allows an administrator to administer users on the HMI 

device.
It also allows an operator without administrator rights 
to change his password.

"Recipe view" Displays data records, and allows them to be edited.
 

"System diagnostics 
view"

Provides an overview of all devices capable of 
diagnostics.
Displays errors in the plant.

See also
Overview of objects (Page 3336)
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10.1.2.4 Options for Editing Objects

Introduction
Objects are graphics elements which you use to design the screens of your project. 

You have the following options for editing objects:

● Copying, pasting or deleting objects using the shortcut menu If you copy an object in a 
screen and the screen already includes an object of the same name, the name of the object 
is changed.

● Maintaining the standard size of the objects you are inserting or customizing their size on 
insertion.    

● Moving an object in front of or behind other objects      

● Rotating objects    

● Mirroring objects    

● Defining the tab sequence for objects  

● Stamping: Inserting several objects of the same type  

● Selecting several objects simultaneously    

● Repositioning and resizing multiple objects  

● You can assign external graphics to objects, e.g. in the Graphic View.
You can view only the images you have previously stored in the graphic browser of your 
WinCC project.   
You can save graphics in the graphic browser:

– Via drag & drop from the "Graphics" object group to the working area

– As graphic files in the following formats: *.bmp, *.dib, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg 
or *.jpg

– As an OLE object
You either create a new OLE object or save an existing graphic file as an OLE object. 
To save an OLE object, an OLE-compatible graphics program must be installed on the 
configuration computer.         

See also
Inserting an object (Page 3343)

Deleting an Object (Page 3345)

Positioning an object (Page 3345)

Resizing an object (Page 3347)

Selecting multiple objects (Page 3348)

Aligning objects (Page 3350)

Moving an object forward or backward (Page 3352)

Show objects outside the screen area (Page 3353)
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Rotating objects (Page 3353)

Flipping objects (Page 3355)

Inserting multiple objects of the same type (stamping tool) (Page 3369)

Repositioning and resizing multiple objects (Page 3371)

Hiding or showing objects (Page 3371)

Managing My Controls (Page 3372)

External graphics (Page 3374)

Managing external graphics (Page 3375)

Storing an external image in the graphics library. (Page 3377)

Example: Inserting and configuring a rectangle (Page 3392)

10.1.2.5 Inserting an object

Introduction     
In the "Screens" or "Reports" editor, insert the objects to the "Toolbox" task card. Use the 
mouse to drag the objects into the work area. You either keep the objects in their original size, 
or scale them up or down when you paste them. 

In addition, you can copy or move objects via the clipboard from one editor to another, for 
example to transfer a screen object to a report. Alternatively, you can also use the mouse 
instead of the clipboard for copying and moving:

● Copying: <Ctrl + Drag&Drop>

● Moving: Drag&drop
 

  Note
Basic Panels

The "Reports" editor is not available for Basic Panels.
 

Requirement
The "Tools" task card is open.

Inserting objects in their standard size
1. In the "Toolbox" task card, select the desired graphic object or the desired graphic in the 

WinCC graphics folder.
When you move the cursor across the work area, it turns into a crosshair with an appended 
object icon. 

2. Click the location in the work area where you want to insert the object or graphic.
The object is inserted with its standard size at the desired position in the work area. 

Alternatively, double-click the object in the "Toolbox" task card.
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Copying an object
1. Select the desired object.

2. Select "Copy" in the shortcut menu.

3. Click the desired location and select "Paste" in the shortcut menu.

WinCC inserts a copy of the object at the desired location. You can only change the properties 
that are appropriate for the relevant context. 

Example: In the "Screens" editor, you can set for I/O fields and the mode for input and output. 
In the "Reports" editor, the mode is set to "Output". 

Original and copy are not interconnected and are configured independently from one another.

Inserting lines
1. Select the desired graphic object in the "Tools" task card.

2. Click on a location in the work area. A line in the standard size is inserted. 

Inserting a polygon or polyline
1. Select the desired object "Polyline" or "Polygon" in the "Tools" task card.

2. Click on a location in the work area. This fixes the starting point of the object.

3. Click another location in the work area. A corner point is set.

4. For every additional corner point, click on the corresponding location in the work area.

5. Double-click on a location in the work area. The last corner point is set.
This fixes all the points of the polygon or polyline.

 

  Note
Basic Panels

The "Polyline" and "Polygon" objects are not available for Basic Panels.
 

 

 Note

If you want to insert several objects of the same type, use the "Stamp" function. This avoids 
having to reselect the object in the "Tools" task card every time before inserting it. To do so, 
select the  icon in the toolbar of the "Tools" task card.

 

 

See also
Moving an object forward or backward (Page 3352)
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10.1.2.6 Deleting an Object

Introduction   
You can delete objects individually or with a multiple selection. 

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to delete.

To delete multiple objects, keep the <Shift> key pressed and select the objects to be deleted 
one after the other. Alternatively, drag and maximize an area around the desired objects 
with the mouse. 

2. Select "Delete" from the shortcut menu.

Result
The selected objects are deleted. 

10.1.2.7 Positioning an object

Introduction
When you select an object, it is enclosed by a rectangle with resizing handles. This rectangle 
is the rectangle which surrounds the object. The position of an object is defined by the 
coordinates of the top left corner of the rectangle surrounding the object.   

 

 Note

If the position is outside the work area the object is not displayed in Runtime.
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Position and align
You have the possibility of having a grid displayed in the work area. You have three options 
for easier positioning of objects:

● "Snap to grid" When you resposition objects, they are automatically snapped and pasted 
to the grid. If you hold down the <Alt> key, the object is no longer snapped to the grid.

● "Snap to objects" When you reposition objects, they are displayed with help lines. You can 
use other objects for orientation during positioning.

● "None": You position the objects in any position. 

You activate and deactivate the grid and options as follows: 

● In the "Options > Settings > Visualization > Screens" menu

● In the "Layout > Grid" task card

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object you want to move.

The selected object is framed by a rectangle with resizing handles.

2. Left-click the object and keep the mouse button pressed.

3. Move the mouse pointer onto the new position.
The contour of the object moves with the mouse and displays the new position for the object.

The object initially remains at its original position.

4. Now release the mouse button.
The object is moved into the position indicated by the contour of the selection rectangle.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the X and Y values for the position under "Position & Size".

Result
The object appears at its new position. 

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3346 System Manual, 02/2014



10.1.2.8 Resizing an object

Introduction
When you select an object, it is enclosed by a rectangle with handles. You have the following 
options of resizing an object: 

● Drag the handles using the mouse.

● Modify the "Size" property in the Inspector window.

Requirement
You have opened the work area containing at least one object.

Procedure     
1. Select the object you want to resize.

The selection rectangle appears. The following figure shows a selected object:

2. Drag a resizing contact of the rectangle to a new position.
The size of the object changes.

– The size of the object is aligned to the grid pattern, provided the "Snap to grid" function 
is set.

– Press <ALT> to disable this function while you drag the object.
In order to scale the object proportionally, keep the <Shift> key pressed while changing 
the size with the mouse.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the size of the object under "Position & Size".

Harmonizing the object size     
1. Select the objects.

2. Now, click one of the following buttons:   or  or  
The size of the selected objects is matched to each other.

The following screen shows how the selected objects are adapted to the height of the reference 
object:
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Icon Description
 Aligns the selected objects to the width of the reference object.

 Aligns the selected objects to the height of the reference object.

 Aligns the selected objects to the width and height of the reference object.

Result
The object now appears with its new size. 

10.1.2.9 Selecting multiple objects

Introduction    
Select all objects you want to align with each other or to change global properties. This 
procedure is called "multiple selection." 

The Inspector window shows all the properties of the selected objects. 

You now have several options of selecting multiple objects:

● Draw a selection frame around the objects.

● Hold down the <Shift> key, and click the required objects.
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Selection frame of a multiple selection
The selection frame surrounds all objects of a multiple selection. The selection frame is 
comparable with the rectangle that surrounds an individual object.

The selection frame is not visible. When you have made your multiple selection, the following 
frame is displayed:

● The reference object is indicated by the rectangle around it.

● The other selected objects are indicated by a dashed-line frame.

Specifying a reference object   
The reference object is the object upon which the other objects are oriented. The reference 
object is framed by a rectangle with handles. The following figure shows a reference object 
with two other selected objects:

You have the following options to specify the reference object:

● Select the objects via multiple selection. The object selected first is then the reference 
object.

● Draw a selection frame around the objects. The reference object compiled automatically. 
If you wish to specify a different object within the selection as the reference object, click on 
the desired object. This action does not cancel your multiple selection.

Requirement
You have opened the work area containing at least two objects.

Selecting multiple objects with a selection frame
1. Position the mouse pointer in the work area close to one of the objects to be selected.

2. Hold down the mouse button, and draw a selection frame around the objects to be selected.

Or:
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1. Hold down the <Shift> key.

2. Click the relevant objects, working in succession.
All the selected objects are identified by frames.
The object selected first is identified as reference object.

 

  Note

To remove an object from the multiple selection, press <SHIFT>, hold it down and then 
click the relevant object once again.

 

Result
Multiple objects are selected. One of those is identified as the reference object. You can now 
perform the following steps:

● Changing the object properties of all the objects

● Resizing all the objects by the same ratio, by dragging the selection frame to increase or 
reduce the size

● Moving all the objects in one group

● Aligning the objects to the reference object

10.1.2.10 Aligning objects

Procedure
1. Select the objects via multiple selection.

2. Specify an object as the reference object.

3. Select the desired command in the toolbar or the shortcut menu - see table below.
The selected objects will be aligned.

Aligning objects flush     
The selected objects will be aligned flush to the reference object. 

Icon Description
Aligns the selected objects to the left edge of the reference object. 
Aligns the selected objects to the vertical center axis of the reference object. 
Aligns the selected objects to the right edge of the reference object. 
Aligns the selected objects to the upper edge of the reference object. 

Aligns the selected objects to the horizontal center axis of the reference object. 
Aligns the selected objects to the lower edge of the reference object. 
Centers the selected objects to the center points of the reference object. 
Centers the selected objects vertically in the screen.
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Snap to object
When you reposition objects, they are displayed with help lines. You can use other objects for 
orientation during positioning.

If you are working with the keyboard, press the Alt key. When you move the selected object 
with the arrow keys, the next anchor point is displayed.

Distributing objects evenly     
You need at least three selected objects. A reference object is not required.

1. Select the objects.

2. Click one of the buttons "Distribute horizontally equal" or "Distribute vertically equal".
The selected objects are distributed at equal distances.

The following screen shows how you align the vertical spacing of the selected objects:

Icon Description
Aligns the horizontal distance between the objects. 
The position of the objects on the extreme left and right side remains unchanged. All 
other objects are distributed evenly between them. 
Aligns the vertical distance between the objects. 
The position of the objects at the extreme top and bottom (right and left) remains 
unchanged. All other objects are distributed evenly between them. 
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10.1.2.11 Moving an object forward or backward

Introduction
You can use the "Order" functions in the shortcut menu of a selected object or in the toolbar 
to move a selected object in front of or behind other objects within an object layer.    

 

 Note

ActiveX controls are always positioned in front of an object layer (.NET property).
 

Requirement
You have opened a screen which contains a layer with multiple objects.

Procedure
1. Select the object you want to move forward or backward.

2. Select the "Sort" command and one of the following commands from the shortcut menu:

Icon Description
Moves the selected object before all the other objects of the same layer
Moves the selected object to the lowest position in the same layer
Moves the selected object up by one position
Moves the selected object down by one position

Alternative procedure
1. Open the "Layers" palette of the "Layout" task card.

2. Navigate to the required object.

3. Hold down the mouse button, and drag the object in the tree topology to the required position 
in the layer.

4. Now release the mouse button.

Result
The object is moved up or down. 

See also
Inserting an object (Page 3343)
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10.1.2.12 Show objects outside the screen area

Introduction 
If you assign objects to positions that are outside the configurable area, these objects will be 
hidden. The functions of the "Objects outside the visible area" palette in the "Layout" task card 
are used to move these objects back into the screen.

Requirement
● You have opened a screen which contains objects that are outside the configurable area.

● The "Layout" task card is open.

Procedure
1. Open the "Layout > Objects outside the area" task card.

This displays a list of objects that are outside the configurable area.

2. Select the the object which you want to move back into the screen from the list.

3. Select "Move to screen" in the object shortcut menu.

Alternatively open the "Layout > Layer" task card. Objects outside the area are indicated by 
the  icon. If you click this icon, the object is moved back into the screen.

Result
The objects are moved to the configurable area.

10.1.2.13 Rotating objects

Introduction   
You can rotate a suitable object clockwise or counterclockwise around its center axis in steps 
of 90°. 

 

 Note

Not all the objects can be rotated. Some objects that can be rotated in screens cannot be 
rotated in reports.

 

You can also rotate multiple objects using the multiple selection function. Certain WinCC 
objects such as buttons cannot be rotated.

The alignment of elements in an object will change in a rotated object. The following figure 
shows how a rectangle and an ellipse behave under the different commands for rotating an 
object:
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Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to rotate.

2. Click one of the following toolbar icons:
, to rotate the object clockwise around its center point. The angle of rotation is 90°.
, to rotate the object counterclockwise around its center point. The angle of rotation is 

90°.
, to rotate the object clockwise by 180°.

Result
The object is shown at its new angle. 
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10.1.2.14 Flipping objects

Introduction
You can flip an object along its vertical or horizontal center axis. The alignment of elements in 
an object will change when you flip an object. The following figure shows how a rectangle and 
an ellipse behave under the different commands for flipping an object.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object that you want to flip.

2. Click the "Flip" command in the shortcut menu and select one of the options displayed:

– , to flip the selected object along its vertical center axis.

– , to flip the selected object along its horizontal center axis.

Result
The object is shown at its flipped position. 

10.1.2.15 Designing an object

Introduction
You design the border and background of an object.           

Requirements
A line has been created in a screen.
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Procedure
1. Select the line on your screen.

2. In the Inspector window, select "Properties > Properties > Appearance":

3. Select "Dash" as the style.

4. To display the dashed line in two colors, select the line width "1".

5. Select the setting "Arrow" in the "Line ends" area.

Result
The line is displayed in two colors as a dashed line. The end of the line is an arrow. 

10.1.2.16 Designing an object

Introduction
You design the border and background of an object.      

Requirement
A circle has been created in a screen.

Procedure
1. Select the circle in the screen.

2. In the Inspector window, select "Properties > Properties > Appearance":

3. Select "Solid" as the background fill pattern.

4. Activate "Fill level".

5. Enter "50" for the fill level.

6. Select "Solid" as the style.

Result
The object is displayed as a semicircle without a border.

10.1.2.17 Designing the fill pattern

Introduction
WinCC lets you design the background color and the fill pattern of an object. The design options 
change in the Inspector window depending on object for which you are making the filling pattern.
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For certain objects, you can not only define the color, but also a transparent background or a 
background with a color gradient.  

 
 

 Note
Device-specific nature of the properties

The fill style that is available depends on the object and the HMI device used.
 

Requirement
The object has been created and selected. 
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Designing the background color of an object
1. In the Inspector window, select "Properties > Properties > Appearance".

2. Select a color for the background of the object, for example, yellow.
The object is filled with the selected color. 
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Designing the fill pattern of an object
1. In the Inspector window, select "Properties > Properties > Appearance".

2. To define a transparent background for the object, select transparent. 
You can find information about designing a fill pattern with a color gradient in the section 
Defining color gradients (Page 3366).
The object is shown as transparent. 
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You can optionally set the fill pattern in the Inspector window under "Properties > Properties 
> Fill Pattern".

See also
Defining color gradients (Page 3366)

10.1.2.18 Using predefined styles

Introduction
You can assign predefined styles to objects and faceplates in runtime. You can change the 
background color of the display and operating elements using predefined styles. In this way, 
you harmonize the display in Runtime.

Requirement
The "Toolbox" task card is open.

Setting predefined styles
1. Select the object that you want to insert in the "Toolbox" task card. 

2. Select one of the following options in the "Toolbox" task card:

– "Default" to use the default style 

– "Use device design" to use the color settings from the current device design

3. Insert the required object in the work area.   
The object is displayed in the selected style.

4. The objects are created in the selected style as long as the style remains activated in the 
toolbar.  
To return to the default style, select the "Default" option in the toolbar.

See also
Working with styles (Page 3327)

10.1.2.19 Formatting graphics in an object

Introduction
WinCC lets you insert graphics into some objects and format them. You can change the size, 
orientation and distances of a graphic to the object border. You change the properties of the 
graphic in the Inspector window of the relevant object.
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Requirement
The selected object is in graphic mode. 

The selected object contains at least one graphic. 

Resizing a graphic
1. In the Inspector window, select "Properties > Properties > Layout".

2. Select "No stretching of picture" or "Stretch picture".
The contained graphic is displayed in its original size or stretched to the size of the object.
 

 

 Note

To adjust the object size to the contained graphic, select "Fit object to contents".
 

Aligning a graphic horizontally and vertically
1. In the Inspector window, select "Properties > Properties > Layout".

2. To determine the horizontal position of the graphic, select "Right", for example. 

3. To determine the vertical position of the graphic, select "Top", for example.
The graphic is then shown at the top right of the object.
   

Defining the distance from the object border
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the value for the distance to the object border, for example, "20" for the top border.
The graphic is shown with a distance of 20 pixels to the top border of the object.
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Icon Description
 Sets the distance from the left border of the object.
 Sets the distance from the right border of the object.
 Sets the distance from the top border of the object.
 Sets the distance from the bottom border of the object.

10.1.2.20 Formatting text in an object

Introduction
Some objects, for example, the I/O field, support text within the object.

You have several options to align text.

Configuring the distance from the object border
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the value "5" for the left border, for example.

The text is aligned five pixels from the left border of the object.

Aligning the text position
1. In the Inspector window, select "Properties > Properties > Text format".

2. Select the horizontal alignment, for example, centered.

3. Select the vertical alignment, for example, top. 
The text is shown at the top center in the object. 

Defining the text orientation
1. In the Inspector window, select "Properties > Properties > Text format".

2. Select the orientation of the text, for example, vertical, right. 
The text flow is shown from bottom to top. 
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10.1.2.21 Rotating an object in runtime

Introduction    
You define the rotation of an object around a reference point. You define the reference point 
with "X", "Y" in the Inspector window in the group "Properties > Properties > Layout". 

The rotation of the object is visible in Runtime only.

X, Y
The attributes "X" and "Y" define the horizontal and vertical distance of the reference point 
from the object origin.

The values are specified as a percentage. The object width or object height correspond to a 
value of 100%. The reference point value can be outside the selection rectangle. This means 
that both negative values and positive values higher than 100% are possible.
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Angle
The angle defines the rotation of an object around the reference point. The angle is specified 
in degrees. The configured start point corresponds to a value of 0°. The position of an object 
deviates from its configured start position by the value of the angle. 

See also
Polygon (Page 3594)

Polyline  (Page 3596)

Overview of objects (Page 3336)

10.1.2.22 Designing table-based objects

Introduction
WinCC offers various properties for designing display and operating objects.

You change the properties of table-based objects in the Inspector window of the relevant object.

Designing colors
Select the colors for font, selections and areas under "Properties > Properties > Appearance".

Figure 10-1 Selecting table properties

 

Designing the border of the table header
1. In the Inspector window, open "Properties > Properties > Table header border".

2. Select "Solid", for example, as the style.

3. Select 5, for example, as the "Width".

4. Select red, for example, as a foreground color.

The border of the table header is shown with a red border and width of 5 pixels.  With "Solid" 
border style, only the foreground color is visible.
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Colors and color gradient in the table header
1. Select the table-based object in the screen.

2. In the Inspector window, open "Properties > Properties > Table header fill pattern".

3. Select the fill pattern, for example "Horizontal gradient".

4. Select a background color, for example, blue, under "Gradient".

5. Activate "Gradient 1".

6. Select a color for "Gradient 1", for example, white.

7. Select a "Width" for the color gradient, for example, 12.

8. Activate Gradient 2.

9. Select a color for Gradient 2, for example, yellow.

10.Select a "Width" for the color gradient, for example, 10

The table header is displayed with a color gradient. 

 

10.1.2.23 Designing a border

Introduction
WinCC offers various properties for designing display and operating objects.

The I/O field example below shows the possible settings for designing borders.

You change the appearance in the Inspector window of the relevant object.

Designing a border
1. Open "Properties > Properties > Appearance".

2. Select the width of the border, e.g. "5".

3. Select the style of the border, e.g. double line.

4. Select the foreground color.

5. Select the background color.

Figure 10-2 "Double line" border style
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Border style
The figure below shows a border in "3D style".

The figure below shows a border in "Solid" style.

 
 

 Note
Device-specific nature of the properties

The border style that is available depends on the object and the HMI device used.
 

10.1.2.24 Defining color gradients

Introduction
For the objects in WinCC, color gradients can be specified as background for various surfaces.

Change the category in the Inspector window, depending on which surface you fill with a color 
gradient.  The procedure remains the same.

The following section describes how to configure the color gradient of buttons.
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Horizontal color gradient with two colors 
1. Select an object with buttons, for example, a button.

2. In the Inspector window, select "Properties > Properties > Fill Pattern".

3. Select "Fill Pattern > Horizontal gradient".

4. Select a background color for the vertical color gradient, for example, orange.

5. Activate "Gradient 1".

6. Select a "Color" for Gradient 1, for example, red.

7. Select a "Width" for Gradient 1, for example, "10".

The background of the button is displayed in orange. 

For the horizontal color gradient, Gradient 1 is shown from the left border. Gradient 1 is 10 
pixels wide.

Vertical color gradient with three colors
1. Select a button in the screen.

2. In the Inspector window, select "Properties > Properties > Fill Pattern".

3. Select the "Vertical gradient" background.

4. Select a background color under "Gradient", for example, orange.

5. Activate "Gradient 1".

6. Select a color for "Gradient 1", for example, red.

7. Select a "Width" for the color gradient, for example, 8.

8. Activate Gradient 2.

9. Select a color for Gradient 2, for example, yellow.

10.Select a "Width" for the color gradient, for example, 10.

← Color Gradient 1
← Background color
← Color Gradient 2

For the vertical color gradient, Gradient 1 is shown from top to bottom. Gradient 1 is 8 pixels 
wide.

The background of the button is displayed in orange. 

Gradient 2 is shown at the bottom border. Gradient 2 is 10 pixels wide. 
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10.1.2.25 Flashing

Introduction   
You want an object to flash in Runtime.

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to flash.

2. In the Inspector window, select the type "Default" under ""Properties > Properties > 
Flashing".

Result
The object flashes in runtime.

See also
Overview of objects (Page 3336)

10.1.2.26 Flashing

Introduction   
You display objects flashing in runtime. You select the flash rate and colors for the object. 

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to flash.

2. In the Inspector window, select the type "Advanced" under ""Properties > Properties > 
Flashing".

3. Activate "Line" to make the line flash in runtime.

4. Activate "Text" to make the text flash in runtime.

5. Activate "Background" to make the background flash in runtime.

6. Select the flash rate.
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7. Select a color for the "OFF" state.

8. Select a color for the "ON" state.
 

  Note

Flashing is only visible in runtime when there is a difference between the two colors. 
 

Result
In runtime, the object flashes in the selected colors and flash rate. 

10.1.2.27 Inserting multiple objects of the same type (stamping tool)

Introduction
WinCC offers the possibility to "stamp" several objects of the same type directly one after the 
other, i.e. paste without having to reselect the object every time. In addition you have the 
possibility of multiplying an object that has already been inserted.         

Requirement
The "Tools" task card is open.

Inserting several objects of one type
1. Select the object that you want to insert in the "Tools" task card.

2. Click the  icon in the toolbar of the "Tools" task card.
The "Stamp" function is activated.

3. To insert the object with its standard size, click the relevant insertion position in the work 
area.
To insert the object with another size, position the mouse pointer at the desired location in 
the work area. Press the left mouse button and drag the object to the required size.
The object is inserted in the work area as soon as you release the mouse button.

4. Repeat step 3 to insert further objects of the same type.

5. Click the  icon again.
The "Stamp" function is deactivated.

 

  Note

You can copy existing objects using the drag-and-drop +<CTRL> function. The existing 
object is not moved in this case. You paste a copy of this object into the new position 
instead.
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Inserting and multiplying an object
1. Insert the desired object from the "Tools" task card.

2. Press the <Ctrl> key and position the cursor on one of the handles displayed in the figure 
shown below.

3. Drag the handles to the right and/or down while keeping the left mouse button pressed.

4. The object is multiplied depending on available space if you keep moving the cursor.

Result
You have pasted and stamped an object in a screen.

See also
Overview of objects (Page 3336)
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10.1.2.28 Repositioning and resizing multiple objects

Possible modifications
After you have selected multiple objects, you edit them:

● Shift using the mouse

– To change the absolute position of the marked objects, position the mouse pointer over 
an object, and shift the multiple selection with the mouse button pressed.

– To resize all the objects by the same ratio, grab the resizing handles of the reference 
object.

● Move over the work area with the icons of the toolbar

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

● Moving with the shortcut menu commands of the work area

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

10.1.2.29 Hiding or showing objects

Introduction
You can hide and show objects from or up to a defined size. This means, for example, that 
objects are only shown if a sufficient size allows the required detail to be displayed.

Requirement
A screen is open.

Procedure
Proceed as follows to hide specific objects in a screen:

1. Click in an area of the screen that does not contain an object.

2. Activate the "Activate for objects" check box under "Hide/Show" in the Inspector window.

3. Specify the minimum and maximum percentage within which the objects in question should 
be displayed. The specified limit values are also still shown.

Result
Those objects are shown whose size lies within the specified range when the object layer is 
visible. The object continues to be displayed as long as either the height or the width lies within 
the specified range. 
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10.1.2.30 Managing My Controls

Introduction
Add standardized or user-defined controls in the "Toolbox > My Controls" task card. All the 
ActiveX controls registered in the operating system and the .Net controls on your system are 
available for use in WinCC.

● ActiveX controls
ActiveX controls are control elements from any providers, which can be used by other 
programs over a defined OLE-based interface.

● .Net controls
.Net controls are control elements from any providers based on the Microsoft .Net 
Framework.

● Specific .Net controls
.Net controls are control elements from any providers based on the Microsoft .Net 
Framework.

When you intend to run external controls in your WinCC project, you need to verify that these 
run on the HMI device you are configuring. If you are using controls from third parties, you 
must first of all add these to the "My controls" palette before you copy the project to different 
PCs.

 

 Note

If you use any controls that are not included in the product package (for example, from third 
parties), errors may occur, for example, reduced performance or system crashes. The user 
of such control software is alone responsible for any problems caused by its use. We therefore 
advise you to closely examine such elements prior to their use.

 

Requirement
● The required  ActiveX control is installed in the PC's operating system.

● The required or specific .Net control is available on the PC in an assembly.

● A screen is open.

● The "Toolbox" task card is open.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3372 System Manual, 02/2014



Adding a new control to the "My controls" group         
1. Open "Toolbox > My controls" in the "Toolbox" task card.

2. Select "Select objects" from the shortcut menu.
A dialog opens. This contains all the controls available on the system. Controls that already 
exist in the "Toolbox" task card are identified by a check mark.

3. Select the desired tab, e.g. ActiveX controls.

4. Activate the required control.

5. Confirm your selection with "OK".

Inserting a specific .Net control in the "My controls" group   
1. Select the "Specific .Net controls" tab. The list is empty the first time you select the tab.

2. Click the "…" button.
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3. Select the folder in which the assembly is contained.

4. Select a file.

5. Click "Open." All the available controls are displayed in the "Specific .Net controls" tab.

6. Activate the required .Net control.

7. Confirm your selection with "OK".

Result
The control now appears in the "Toolbox > My controls" task card and can be configured in a 
screen.

Removing a control from the "My controls" group       
1. Select "Delete" from the shortcut menu for the control concerned.

The control is removed from the "My controls" group. 

10.1.2.31 External graphics

Introduction
You can use graphics created with an external graphic program in WinCC. To use these 
graphics you store them in the graphic browser of the WinCC project. 

You can save graphics in the graphic browser:

● When you drag-and-drop graphics objects from the "Graphics" pane into the work area, 
these are stored automatically in the graphic browser. The graphic names are numbered 
in the order of their creation, for example, "Graphic_1." Use the <F2> function key to rename 
the graphic.

● As a graphic file with the following formats:
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tif, *.png, *.jpeg or *.jpg

● As an OLE object that is embedded in WinCC and is linked to an external graphic editor. 
In the case of an OLE link, you open the external graphic editor from WinCC. The linked 
object is edited using the graphic editor. An OLE link only works if the external graphic 
editor is installed on your PC, and supports OLE.

Use of graphics from the graphic browser
Graphics from the graphic browser are used in your screens:   

● In a Graphic view 

● In a graphics list

● As labeling for a button/function key
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Transparent graphics
In WinCC you also use graphics with a transparent background. When a graphic with a 
transparent background is inserted into a graphic object of WinCC, the transparency is 
replaced by the background color specified for the graphic object. The selected background 
color is linked firmly with the graphic. If you use the graphic in another graphic object of WinCC, 
this object is displayed with the same background color as the graphic object that was 
configured first. If you want to use the graphic with different background colors, include this 
graphic in the graphic browser again under a different name. The additional background color 
is configured when the graphic is used at the corresponding graphic object of WinCC.   

Managing graphics
An extensive collection of graphics, icons and symbols is installed with WinCC, for example:

In the Toolbox window of the "Graphic" pane the graphic objects are structured by topic in the 
"WinCC graphics folder." The link to the WinCC graphics folder cannot be removed, edited or 
renamed.   

The "Graphics" pane is also used to manage the external graphics. The following possibilities 
are available:

● Creating links to graphics folders
The external graphic objects in this folder, and in the subfolders, are displayed in the toolbox 
and are thus integrated in the project. 

● Editing folder links

● You open the program required for editing of the external graphic in WinCC.

 

10.1.2.32 Managing external graphics

Introduction    
External graphics that you want to use in WinCC are managed in the "Screens" editor by using 
the "Tools" task card in the "Graphics" pane.

Requirement
● The "Screens" editor is open.

● The "Tools" task card is open.

● The graphics are available.

● The graphics have the following formats:
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tif, *.jpeg or *.jpg         
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Creating a folder link   
1. Click "My graphics folder."

2. Select "Link" in the shortcut menu.
The "Create link to folder" dialog is opened. The dialog suggests a name for the folder link. 

3. Edit the name as required. Select the path containing the graphic objects.

4. Click "OK" to confirm your input.
The new folder link is added to the "Graphics" object group. The external graphics that are 
located in the target folder and in sub-folders are displayed in the toolbox.

Editing folder links   
1. Select the folder link to edit.

2. Select the "Edit link..." command from the shortcut menu. 
The "Create link to folder" dialog is opened.

3. Edit the name and path of the folder link as required.

4. Click "OK" to confirm your input.

Renaming the folder link  
1. Select the folder link to rename.

2. Select "Rename" from the shortcut menu.

3. Assign a name to the new folder link.

Removing a folder link   
1. Select the folder link you want to delete.

2. Select "Remove" in the shortcut menu.

Edit external graphics
1. Select the graphic you want to edit.

2. Select the "Edit graphic" command from the shortcut menu.
This opens the screen editor associated with the graphic object file.

Editing graphics folders from WinCC
1. Select the graphic you want to edit.

2. Select the "Open parent folder" command from the shortcut menu.
The Windows Explorer opens. 
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10.1.2.33 Storing an external image in the graphics library.

Introduction
To display graphics that have been created in an external graphics program in your screens, 
you will first have to store these graphics in the graphics browser of the WinCC project.      

Requirement
● A screen has been created.

● A Graphic View is inserted in the screen.

● The Inspector window of the Graphic view  is open.

To store an external graphic in the image browser: 

● A graphic is available.

To store an OLE object in the browser: 

● An OLE-compatible graphics program is installed on your configuration computer.

Save graphics file
1. Open the Windows Explorer.

2. Select the graphic that you want to store.

3. Drag-and-drop the graphic into the graphic browser.

Creating and saving a new graphic as an OLE object
1. Select the Graphic view  on your screen.

2. In the Inspector window, select "Properties > Properties > General":

3. Open the graphic selection list.

4. Click .

5. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

6. From the "Insert object" dialog box, select "New" and an object type. The settings in 
"Settings > "OLE settings" determine which object types are shown.

7. Click "OK." The associated graphic program is opened.
When you are finished creating graphics, end the graphic programming software with "File 
> Close" or "File > Close & return to WinCC." 
The graphic will be stored in the graphic programming software standard format and added 
to the graphic browser.
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Inserting created graphics in WinCC
 

 Note

A new graphic object created as OLE object may not be directly accepted in WinCC when 
you save it to an external graphics program. 

 

1. Reopen the dialog for inserting a graphic.

2. From the "Insert object" dialog box, select "Create from file."

3. Click the "Browse" button.

4. Navigate to the created graphic and select it.

Saving an existing graphic object as an OLE object
1. In the Inspector window, select "Properties > Properties > General":

2. Open the graphic selection list.

3. Click .

4. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

5. From the "Insert object" dialog box, select "Create from file."

6. Click the "Browse" button.

7. Use the dialog to help you navigate to the folder in which the graphic file is saved.
 

  Note

To import graphics files, note the following size restrictions:

*.bmp, *.tif, *.emf, *.wmf  ≤4 MB

*.jpg, *.jpeg, *.ico, *.gif "*≤1 MB
 

Result
The image file is now stored in your image browser. It is shown in a screen with a Graphic 
view , or is added as a list element in an image list.

You can double-click OLE objects in your library to open them for editing in the corresponding 
graphic editor. When you have finished editing graphics, end the graphic programming 
software with "File > Close" or "File > Close & return to WinCC." The changes are applied to 
WinCC. 
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10.1.2.34 Working with object groups

Basics on groups

Introduction
Groups are several objects that are grouped together with the "Group" function. You edit a 
group in the same way as any other object. 

Overview
WinCC offers the following methods for editing multiple objects: 

● Multiple selection

● Creating object groups

Editing mode
To edit an individual object in a group, select the object in the "Layout > Layers" task card. 

Alternatively select "Group > Edit group" in the object group's shortcut menu.

Hierarchical groups
You add further objects or groups to extend a group. The group is enlarged by the new objects 
and is structured hierarchically in main and sub-groups. Such hierarchical groups must be 
broken up in stages. You also break up the group in the same order in which you grouped the 
objects or groups. It takes exactly the same number of steps to break up these hierarchical 
groups as it did to create them.

Rectangle surrounding the object
Only one surrounding rectangle is now displayed for the whole group. The surrounding 
rectangles of all objects are displayed for a multiple selection on the other hand.

Layers
All objects of a group are located in the same layer. 

Creating object groups

Introduction
The "Group" command combines multiple objects to form a group.       

You can change the size and position of the group. The following rules apply: 
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● The system automatically adapts the position coordinates of the grouped objects when you 
reposition the group. The relative position of the grouped objects to the group is not affected.

● The system automatically adapts the height and width of the grouped objects in proportion 
to a change of the group size.

● To change the size of the group proportionately, hold down the <Shift> key and drag the 
rectangle around the object until has the required size.

 

  Note

To create a hierarchical group, organize the individual groups like objects. 
 

Requirement
● You have opened a screen which contains at least two objects.

Creating object groups
1. Select all the objects you want to organize in a group.

2. Select the command "Group > Group" from the shortcut menu.

The objects of the group are displayed with a rectangle around the objects.

Grouping objects within a group
1. Select the group you want to edit.

2. Select the command "Group > Edit group" from the shortcut menu.
The group that you are editing is highlighted by a red frame.

3. Select the objects of a group that you want to combine into a subgroup.

4. Select the command "Group > Group" from the shortcut menu.

A subgroup with the objects is created.

Adding objects into an existing group
1. Select the group to which you want to add objects.

2. Press the <Shift> key and select the object you want to add to the group.

3. Select the "Group > Add to group" command from the shortcut menu.

The object is added to this group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.
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Result
The selected objects are combined in a group. The multiple selection rectangle becomes the 
rectangle surroundings the objects in the group. The handles are shown only for the group. 
The group in in the active layer.

See also
Ungrouping (Page 3381)

Adding Objects to the Group (Page 3382)

Removing Objects from the Group (Page 3383)

Editing an Object in a Group (Page 3384)

Example: Inserting and configuring a rectangle (Page 3392)

Ungrouping

Introduction
Select the "Ungroup" command to split a group into the original object fractions.     

Requirement
● You have opened a screen that contains a group.

Ungroup
1. Select the group.

2. Select the "Group > Ungroup" command from the shortcut menu.

Ungrouping a group within a group
1. Select the higher-level group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group that you are editing is highlighted by a red frame.

3. Select the lower-level group.

4. Select the "Group > Ungroup" command from the shortcut menu.

Result
The lower-level group is ungrouped. The objects are assigned to the next higher group.
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Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

See also
Creating object groups (Page 3379)

Adding Objects to the Group (Page 3382)

Removing Objects from the Group (Page 3383)

Editing an Object in a Group (Page 3384)

Example: Inserting and configuring a rectangle (Page 3392)

Adding Objects to the Group

Introduction
The "Add objects to group" command is used to add objects to a group, without ungrouping it 
first.   

Requirements
A screen with one group and at least one other object is opened.

Procedure
1. Select the group.

2. Press the <Shift> key and select the object you want to add to the group.

3. Select the "Group > Add to group" command from the shortcut menu.

Result
The group consists of the original objects, and the newly-added objects. The added objects 
are arranged at the front of the group.

Alternative procedure
You can also edit groups in the "Layout" task card. Using drag&drop you can also easily edit 
hierarchical groups in the "Layers" palette.

 

See also
Example: Inserting and configuring a rectangle (Page 3392)
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Removing Objects from the Group

Introduction
You use the "Remove objects from group" command to remove individual objects from a group, 
without ungrouping it first.    

You do not have to remove the object from the group to edit an object in a group. You can edit 
the objects of a group individually.

Requirement
● You have opened a screen that contains a group.

Removing objects from a group
To remove an object from a group:

1. Select the group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group you want to edit is highlighted by a red frame.

3. Select all objects in the group that you want to remove from the group.

4. Select the "Group > Remove from group" command from the shortcut menu.

The objects are removed from the group.
 

 Note

If there are only two objects in the group, the menu command "Remove from group" is not 
available.

 

Deleting objects from a group
To remove an object from the group, and from the screen:

1. Select the group.

2. Select the command "Group > Edit group" from the shortcut menu.
The group you want to edit is highlighted by a red frame.

3. Select the objects in the group that you want to delete.

4. Select "Delete" from the shortcut menu.
 

  Note

If there are only two objects in the group, the menu command "Delete" is not available.
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Alternative procedure
You can also edit groups in the "Layout" task card. Using drag-and-drop you can also easily 
edit nested groups in the "Layers" pane.

See also
Example: Inserting and configuring a rectangle (Page 3392)

Editing an Object in a Group

Introduction
You can edit the objects of a group individually.       

Requirement
You have opened a screen that contains a group.

Editing grouped objects
1. Select the group.

The properties of the group are displayed in the Inspector window.

2. Change the position and size of the grouped objects in "Properties > Properties >Layout."

3. Change the name of the group in "Properties > Properties > Miscellaneous."
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Modifying the properties of an object within a group
1. Select the group.

2. Select the object whose properties you want to change in the Inspector window.

The properties of the object are displayed.

3. Change the object properties.
 

 Note

The dynamization of properties for all objects of the group which have these properties is not 
possible in a group. You can only dynamize the properties of the objects associated with a 
group for each object itself. 

 

Result
Although you have edited the object, it is still an element of the group. These changes do not 
affect the other objects of the group. 

See also
Example: Inserting and configuring a rectangle (Page 3392)
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10.1.2.35 Configuring the Keyboard Access

Overview of keyboard access

Introduction
For keyboard units without a mouse, the operator activates control objects using the <Tab> 
key. You can set up keyboard input to make the process easier to run, and to make sure that 
the operator enters all the necessary values. If you are using the keyboard, use the <Tab> key 
to activate the objects in a certain order, and to enter the necessary values.

For HMI devices without key, you can simulate the <Tab> key by configuring the 
"SimulateSystemKey" system function to a function key.

Operator authorizations and operator control enables
If you configure an object for operator input with the <Tab> key, the object must have both an 
operator authorization, and an operator control enable. 

Editing the tab sequence
The tab sequence is determined automatically when the control objects are created. The 
numbers of the tab sequence are assigned in the sequence in which the libraries are created.

It makes sense to change the tab sequence in the following cases:

● The operator changes directly to a specific control object.

● The screen requires a specific sequence

Change to the tab sequence mode to change the tab sequence. In this mode, the tab sequence 
number is displayed at the top left of the control objects. The tab sequence numbers of hidden 
objects are also shown. The distribution of these numbers is edited using the mouse.

 

 Note

Other functions are not available in the tab sequence mode.
 

Overview of keyboard access

Introduction
To influence the process, the operator edits operable objects such as I/O fields or buttons in 
Runtime. You set up keyboard input to make the process easier to run, and to make sure that 
the operator enters all necessary values. When the operator makes entries, he uses the <Tab> 
key to activate the objects in a specified order and to enter the necessary values. 
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Keyboard access
There are two methods of mouseless operator input:

● Alpha cursor: The operator uses the <Tab> key in Runtime to activate objects of the "I/O 
field", and "text list" type only.

● Tab cursor: Depending on the settings, the operator uses the <Tab> key in Runtime to 
activate all objects that permit an input.

You define the cursor mode when Runtime starts. You set the cursor mode in the Inspector 
window of the screen.

Combining the Alpha cursor and Tab cursor modes
When you have defined a hotkey, the operator can toggle the cursor mode between the two 
modes during runtime if necessary. In this case you specify the tab sequence for both cursor 
types.

Operation in Runtime
You use the tab sequence to define in which order the operator can activate objects. The 
default setting is operation using the <Tab> key. If required, define operation using a hotkey 
or the mouse. 

See also
Example: Inserting and configuring a rectangle (Page 3392)

Defining cursor mode

Introduction
You define the cursor mode when Runtime starts. The operator can change the cursor mode 
in Runtime as required. You set the cursor mode in the object properties of the screen.   

Requirement
You have opened a screen which contains multiple objects.

Procedure
1. Click on a empty surface on the screen.

2. In the Inspector window, click "Properties > Properties > Miscellaneous".

3. Select the desired cursor mode under "Tab sequence".

Result
The required cursor mode is active when Runtime starts.
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See also
Example: Inserting and configuring a rectangle (Page 3392)

Defining the Operator Authorization and Operator Control Enable for an Object

Introduction
If you configure an object for operator input with the <Tab> key, the object must have both an 
operator authorization, and an operator control enable.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object.

2. Select "Properties > Properties > Security" in the Inspector window.

3. Select the operator authorization under "Authorization."

4. Activate the authorization to operate.

Result
The operator can use the <Tab> key in Runtime to select the object.

See also
Example: Inserting and configuring a rectangle (Page 3392)
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Defining object types for Tab cursor mode

Introduction
In the Inspector window, you can define the object types that the operator activates using the 
<Tab> key in "Tab cursor" mode.

Requirement
● You have opened a screen which contains at least one object.

● The objects have been enabled for use in Runtime, and have operator authorization.

● "Tab cursor" mode is specified.

Procedure
1. Click on a empty surface on the screen.

2. Select the object types to be used in Runtime using the <Tab> key in the inspector window 
under "Properties > Properties > Miscellaneous > Tab sequence object types".

Result
The user can activate all the defined objects in Runtime using the <Tab> key in "Tab cursor" 
mode.
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See also
Example: Inserting and configuring a rectangle (Page 3392)

Setting the tab sequence order

Introduction
All operable objects can be reached in runtime with the <Tab> key. You use the "Tab sequence" 
command to define the order in which the operator can activate objects in runtime. 

 

 Note

You cannot reach objects with the "Output" or "Two states" mode in runtime with the <Tab> 
key.

 

You can operate the screen in runtime:

● Using the <Tab> key

● Using the mouse

● Using a configured hotkey

Requirement
● The active screen contains operable objects.

● No object is selected.

● The objects have been enabled for use in runtime, and have operator authorization.

Procedure
1. Select "Edit tab sequence" in the "Edit" menu.

Tab sequence mode is activated. The tab sequence number is displayed for all objects that 
can be used. The tab sequence number is also displayed for hidden objects.

2. Use edit the tab sequence mode, click the accessible objects in the order in which you want 
them to be activated using <Tab> in runtime.
The following figure shows how the tab sequence is defined in the screen. In runtime, the 
<Tab> key first activates the alarm view (number 1), then the I/O field (number 2), and then 
the button (number 3):
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3. To exclude a screen object from the tab sequence, press the key combination <Shift+Ctrl> 
and click on the desired object.
The tab sequence number is no longer displayed in the screen object. The screen object 
is now excluded from the tab sequence. The remaining tab sequence numbers are 
automatically decreased by 1.

4. To reenter an excluded screen object in the tab sequence, repeat step 3.
The screen object entered as the first object in the tab sequence.

Result
The operator selects the objects in the specified order in Runtime with the <Tab> key.

See also
Example: Inserting and configuring a rectangle (Page 3392)

Setting the tab sequence order

Introduction
Every object can be accessed in Runtime in the mode "Tab cursor". You use the "Tab 
sequence" command to define the order in which the operator can activate objects in Runtime. 
You can operate the process screen in runtime:

● Using the <Tab> key

● Using the mouse

● Using a configured hotkey

Requirement
● You have opened a screen which contains at least one object.

● The objects have been enabled for use in Runtime, and have operator authorization.

● "Tab cursor" or "Alpha cursor" mode is activated.
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Procedure
1. Select "Edit > Tab sequence > Edit tab cursor" or "Edit alpha cursor".

Tab sequence mode is activated. The tab sequence number is displayed for all objects that 
can be used. The tab sequence number is also displayed for hidden objects.

2. Use edit the tab sequence mode, click the accessible objects in the order in which you want 
them to be activated using <Tab> in Runtime.
The following figure shows how the tab sequence is defined in the screen. In Runtime, the 
<Tab> key first activates the I/O field (number 1), and then the button (number 2).

Result
The operator selects the objects in the specified order in Runtime with the <Tab> key. 

See also
Example: Inserting and configuring a rectangle (Page 3392)

10.1.2.36 Examples

Example: Inserting and configuring a rectangle

Task
In this example, you insert a rectangle in a screen. You can configure the following properties:  

● Name = "MyRectangle"

● Position = (20, 20)

● Size = (100,100)

● Color = red

● Black frame 2 pixels wide
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Principle
The rectangle is a closed object which can be filled with a color or pattern. The height and 
width of a rectangle can be adjusted to allow its horizontal and vertical alignment.

 

Overview
Carry out the following steps in order to create a rectangle:

● Inserting a rectangle

● Configuring a rectangle

See also
Overview of objects (Page 3336)

Basics on groups (Page 3379)

Example: Inserting a rectangle (Page 3393)

Example: Configuring a rectangle (Page 3394)

Example: Inserting a rectangle

Task
In this example, you insert and rename a rectangle. Do not use the special characters ?, ", /, 
\, *, <, > for the name.   

Requirement
● A screen is open.

● The Inspector window is open.

● The "Tools" task card is open.

Procedure
1. Click the "Basic objects" palette in the "Tools" task card.

2. Drag the "Rectangle" object into the screen.
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3. In the Inspector window, select "Properties > Properties > Miscellaneous".

4. Type in the new name "MyRectangle".

Result
The rectangle is now inserted and named "MyRectangle". The rectangle has the default 
properties of the "rectangle" object. 

See also
Example: Inserting and configuring a rectangle (Page 3392)

Example: Configuring a rectangle

Task
In this example you configure a rectangle:   

● Color = red

● Black frame 2 pixels wide

● Position = (20, 20)

● Size = (100,100)

Changing the color of the rectangle
To change the color of the rectangle:

1. Select the rectangle.

2. Define the background color in "Properties > Properties > Appearance > Background > 
Color" in the Inspector window.

3. Select "Solid" as the fill pattern.

4. Define the color for the border in "Properties > Properties > Appearance > Border > Color" 
in the Inspector window.

5. Enter the value "2" for "width".

6. Select "Solid" as the "Style".

Interim result
The rectangle is red and has a black frame with a width of two pixels.
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Repositioning and resizing the rectangle
To change the position and size of the rectangle:

1. Select the rectangle.

2. In the Inspector window, select "Properties > Properties > Layout".

3. Set "20" for the both the X and Y coordinates under "Position & Size".

4. Set "100" for the height and for the width.

Result
The rectangle is positioned at the coordinates (20, 20), and has a width and height of 100 pixels. 

See also
Example: Inserting and configuring a rectangle (Page 3392)
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10.1.3 Working with Text Lists and Graphic Lists

10.1.3.1 Working with Text Lists

Basics on text lists

Introduction
Texts are assigned to the values of a tag in a text list. Assign the text list to a symbolic I/O field 
for example in the configuration. This supplies the text to be displayed to the object. The text 
lists are created in the ""Text List" editor. You configure the interface between the text list and 
a tag at the object that uses the text list. 

The selection of objects that can have a text list assigned depends on the Runtime.  

Application
The text list is used, for example, to display a drop-down list in a symbolic I/O field. 

If the symbolic I/O field is a display field, the associated texts will differ according to the value 
of the configured tags. If the symbolic I/O field is an input field, the configured tag assumes 
the associated value when the operator selects the corresponding text in Runtime. 

 

 Note
Display of tag values without text

The display of tag values to which no text has been assigned depends on the Runtime:
● The display and operating object remains empty.
● Three asterisks *** are displayed.

 

Multilingual texts
You can configure multiple languages for the texts in a text list. The texts will then be displayed 
in the set language in Runtime. To this purpose you set the languages in the Project window 
under "Language support > Project languages." 

Configuration steps
The following steps are necessary to display texts in a symbolic I/O field for example:

1. Creating the text list

2. Assignment of the texts to values or value ranges of a text list

3. Assignment of a text list in the display object, e.g. the symbolic I/O field
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See also
Output of texts from a text list in an alarm (Page 3930)

Configuring a text list in the faceplate type  (Page 3493)

Screen basics (Page 3299)

Creating a text list

Introduction
The text list allows you to assign specific texts to values and to output these in Runtime, for 
example in a symbolic I/O field. The type of symbolic I/O field can be specified, for example 
as a pure input field. 

The following types of list are available:  

● Value/Range

● Bit

● Bit Number

Procedure
1. Double-click "Text and graphics lists" in the project window.

2. Open the "Text lists" tab.

3. Click "Add" in the "Text lists" table.
The Inspector window of the text list is open.

4. Assign a name to the text list that indicates its function.
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5. Select the text list type under "Selection":

– Value/Range: Text from the text list is displayed when the tag has a value that lies within 
the specified range.

– Bit (0,1): A text from the text list is displayed when the tag has the value 0. A different 
text from the text list is displayed when the tag has the value 1.

– Bit number (0-31): Text from the text list is displayed when the tag has the value of the 
assigned bit number.

6. Enter a comment for the text list.
 

  Note

You must not use semicolons in the texts in a text list. The semicolon is a control character 
and is automatically deleted from a text. 

 

Result
A text list is created.

See also
Configuring a text list in the faceplate type  (Page 3493)

Assigning texts and values to an area text list

Introduction
For each area text list you specify which texts are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● An area text list has been created and selected.
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Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Range" in "Properties > Properties > General > Value" in the Inspector 
window.

– Enter the value "1" for  "Min" for example.

– Enter the value "20" for  "Max" for example.

– For "Text", enter the text that is displayed in Runtime if the tag is within the specified 
value range.

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. Click "Add" in the "Text list entries" table. A second list entry is created.

4. Select the setting "Range" in "Properties > Properties > General > Value" in the Inspector 
window.

– Enter the value "21" for  "Min" for example.

– Enter the value "40" for  "Max" for example.

– For "Text", enter the text that is displayed in Runtime when the tag is within the specified 
value range.

5. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

Result
An area text list is created. Texts have been assigned to the possible value ranges.     
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Assigning texts and values to an area text list

Introduction
For each area text list you specify which texts are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● An area text list has been created and selected.

Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select one of the following settings in the Inspector window under "Properties > Properties 
> General > Value".

– "Range": Minimum to maximum tag value, for example 1 ≦ Value ≦ 21

– "To": Maximum tag value, e.g. value ≦ 13

– "Individual value": Exactly one tag value, for example Value = 21

– "From": Minimum tag value, e.g. value ≧ 2
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3. Enter the text that is displayed in Runtime when the tag has the specified value or lies within 
the specified range of values under "Text."

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

4. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

5. Create further corresponding list entries for additional value ranges of the same text list.

Result
An area text list is created. Texts that appear in Runtime are assigned to the possible 
values.     

Assigning texts and values to a bit text list

Introduction
For each text list, you specify which text is displayed at which bit value.

Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● A bit text list has been created and selected.
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Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "0" for "Value."

– Enter the text which is displayed in Runtime under "Text" if the bit tag is set to "0".
 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. Click "Add" in the "Text list entries" table. A second list entry is created.

4. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "1" under "Value."

– Enter the text which is to be displayed in Runtime under "Text" if the bit tag is set to "1".

Result
A bit text list is created. Texts that appear in Runtime are assigned to the possible values "0" 
and "1".     

Assigning texts and values to a bit number text list

Introduction
For each bit number text list you specify which texts are displayed at which bit number.
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Requirement
● The "Text and graphics list" editor is open.

● The "Text lists" tab is open.

● A bit number text list has been created and selected.

Procedure
1. Click "Add" in the "Text list entries" table.

The Inspector window for this list entry opens.

2. Select the setting "Single value" in "Properties > Properties > General > Value" in the 
Inspector window.

– Enter "10", for example, for "Value".

– Under "Text", enter the text that is displayed in Runtime when the tag 
has the value "10".

 

  Note

Use a maximum of 255 characters and no semicolons for the text.
 

3. If required, activate the "default entry".
The entered text is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Create further list entries for additional bit numbers of the same text list.

Result
A bit number text list is created. Texts that appear in Runtime are assigned to the specified bit 
numbers.     
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Configuring objects with a text list

Introduction
The output value and value application for text lists are specified in the display and operating 
object that displays the texts of the text list in Runtime. The properties of these objects are 
configured as required.   

Requirement
● A text list is created.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a symbolic I/O field is open. The object is edited.

Procedure
1. Select the text list which you want to have displayed in Runtime in "Properties > Properties 

> General > Text list" in the Inspection window.

2. Select the setting "Output" as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a symbolic I/O field depending on the Runtime.
 

3. Select the tag the value of which determines the display in the symbolic I/O field as "Tag".

Result
The defined texts of the text list are displayed in the symbolic I/O field in Runtime when the 
tag has the specified value. 
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Configuring objects with a text list

Introduction
The output value and value application for text lists are specified in the display and operating 
object that displays the texts of the text list in Runtime. The properties of these objects are 
configured as required.     

Requirement
● A text list is created.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a symbolic I/O field is open. The object is edited.

Procedure
1. Select the text list which you want to have displayed in Runtime in "Properties > Properties 

> General > Text list" in the Inspection window.

2. Select the setting "Output" as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a symbolic I/O field depending on the Runtime.
 

3. Select the tag the value of which determines the display in the symbolic I/O field as "Tag".

Result
The defined texts of the text list are displayed in the symbolic I/O field in Runtime when the 
tag has the specified value. 
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10.1.3.2 Working with Graphic Lists

Basic principles of graphics lists

Introduction
The possible values of a tag are assigned to specific graphics in a graphics list. During 
configuration, you can create a graphics list for a button or a graphic I/O field. This supplies 
the graphics to be displayed to the object. 

The graphics lists are created with the "Text and graphics list" editor. You configure the 
interface between the graphics list and a tag at the object that uses the graphics list. The 
availability of the graphics list is determined by the HMI device used.  

Application
You can configure the graphics list for the following situations: 

● Drop-down list with a graphic I/O field

● State-specific graphic for a button

The graphics in a graphics list can be configured as multilingual. The graphics will then be 
displayed in the set language in runtime. 

Graphic sources
Graphics can be added to the graphics list from the following sources: 

● By selecting from a graphic browser

● By selecting an existing file 
You can use the following file types: 
*.bmp, *.ico, *.emf, *.wmf, *.gif, *.tiff, *.png, *.jpeg and *.jpg.

● By creating a new file

Function
If the graphic I/O field is a display field, the associated graphics will differ according to the value 
of the configured tags. If the graphic I/O field is an input field, the configured tag assumes the 
associated value when the operator selects a graphic in runtime. 

Configuration steps
The following tasks are required to display graphics, for example, in a graphic I/O field:

1. Creating the graphics list

2. Assignment of the graphics to values or value ranges of a graphics list

3. Assigning a graphics list in the display object, for example the graphic I/O field
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See also
Configuring a graphics list in the faceplate type (Page 3494)

Screen basics (Page 3299)

Creating a graphics list (Page 3408)

Creating a graphics list

Introduction
The graphics list allows you to assign specific graphics to variable values and to output these 
in a graphic IO field in Runtime. You can specify the type of graphic I/O field, for example as 
a pure output field.  

Procedure
1. Double-click "Text and graphics lists" in the project window.

2. Open the "Graphics lists" tab.

3. Click "Add" in the "Graphics lists" table. The Inspector window of the graphics list will open 
up.
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4. Assign a name to the graphics list that indicates its function.

5. Select the graphics list type "Bit number (0 - 31)" for example under "Select".

6. Enter a comment for the graphics list.

Result
A graphics list of the type "Range (0 - 31)" is created.  

Creating a graphics list

Introduction
The graphics list allows you to assign specific graphics to variable values and to output these 
in a graphic IO field in Runtime. You can specify the type of graphic IO field, for example as a 
pure output field.  

Procedure
1. Double-click "Text and graphics lists" in the project navigation.

2. Open the "Graphics lists" tab.

3. Click "Add" in the "Graphics lists" table.
The Inspector window of the graphics list will open up.

4. Assign a name to the graphics list that indicates its function.

5. Select the "Value/Range" graphics list type under "Selection."

6. Enter a comment for the graphics list.

Result
An area graphics list is created.  
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See also
Configuring a graphics list in the faceplate type (Page 3494)

Basic principles of graphics lists (Page 3406)

Assigning a graphic and values to an area graphics list

Introduction
For each area graphics list you specify which graphics are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● An area graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Range" in "Properties > Properties > General > Value" in the Inspector 
window:

– Enter the value "1" for  "Min" for example.

– Enter the value "20" for  "Max" for example.

– Select a graphic that is displayed in Runtime when the tag is within the specified value 
range.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. Click "Add" in the "Graphics list entries" table. A further list entry is created.
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4. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "21" for example.

– Select a graphic which is displayed in Runtime if the bit "21" is set in the tag.

5. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

Result
An area graphics list is created. Graphics that appear in Runtime are assigned to the possible 
values.   

Assigning graphics and values to an area graphics list

Introduction
For each area graphics list you specify which graphics are displayed at which value range.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● An area graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "0" for example.

– Select a graphic which is displayed in Runtime if the bit "0" is set.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Activate "Properties > Properties > General > Use transparent color" in the inspector 
window and select a color.

5. Activate "Properties > Properties > Flash > Use flash" in the inspector window.

6. Select "Flash frequency > Slow" for example.

7. Create further list entries for additional bit numbers of the same graphics list.
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Result
An area graphics list is created. Graphics that appear in Runtime are assigned to the specified 
bit numbers. The graphic flashes when the tag has a defined value.     

Assigning graphics and values to a bit graphics list 

Introduction
For each graphics list you specify which graphic is displayed at which bit value.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is opened.

● A bit graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in the inspector window "Properties > Properties > 
General > Value":

– Enter "0" as the value.

– Select a graphic which is displayed in Runtime if the bit "0" is set in the tag.
 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. Click "Add" in the "Graphics list entries" table. A new list entry is created.

4. Select "Properties > Properties > General > Value > Single value": in the Inspector window.

– Enter "1" as the value.

– Select a graphic which is displayed in Runtime if the bit "1" is set in the tag.

Result
A bit graphics list is created. Graphics that appear in Runtime are assigned to the values "0" 
and "1".   

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3414 System Manual, 02/2014



Assigning graphics and values to a bit number graphics list

Introduction
For each bit number graphics list you specify which graphics are displayed at which bit number.

Requirement
● The "Text and graphics list" editor is open.

● The "Graphics list" tab is open.

● A bit number graphics list has been created and selected.
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Procedure
1. Click "Add" in the "Graphics list entries" table.

The Inspector window for this list entry opens.

2. Select the settings "Single value" in "Properties > Properties > General > Value" in the 
Inspector window:

– Enter the value "0" for example.

– Select a graphic which is displayed in Runtime if the bit "0" is set in the tag.

 

  Note

As an alternative to the drop-down menu, you can insert graphics from libraries or from 
your file system:
1. Select a graphic in the library or in your file system.
2. Drag-and-drop the graphic into the "Graphics list entries > Graphic" table.

 

3. If required, activate the "default entry".
The graphic is always displayed when the tag has an undefined value. Only one default 
entry is possible per list.

4. Create further list entries for additional bit numbers of the same graphics list.

Result
A bit number graphics list is created. Graphics that appear in Runtime are assigned to the 
specified bit numbers.   
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Configuring objects with a graphics list

Introduction
The output value and value application for graphics list are specified in the display and 
operating object that displays the graphics of the graphics list in Runtime. The properties of 
these objects are configured as required.  

Requirement
● A graphics list is created. The values have been defined. Graphics have been assigned to 

the values.

● You have created a tag.

● The "Screens" editor is open.

● A screen with a graphics I/O field is open. The object is edited.

Procedure
1. Select the graphics list the graphics of which you want to have displayed in Runtime in 

"Properties > Properties > General > Graphics list" in the inspector window.

2. Select the setting "Input/Output" 

 as the "Mode".
 

  Note
Runtime dependency

Different field types are available for a graphic I/O field depending on the Runtime.
 

3. As "Tag", select the tag whose values are defined by the display in the graphic I/O field.

Result
The defined graphics of the graphics list are displayed in the graphic I/O field in Runtime when 
the tag has the specified value.

10.1.3.3 Working with C text lists

Basics on C text lists

Introduction
Each HMI device is assigned to a C text list. In this list you create multilingual texts, which you 
then reference via the text ID in a C script. You use the C text list exclusively with functions of 
the API.
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Use
You use the C text list, for example, to display texts in a screen object.

Multilingual texts
You can configure multiple languages for the texts in a C text list. The texts will then be 
displayed in the set language in Runtime. To this purpose you set the languages in the Project 
window under "Language support > Project languages". 

Configuration steps
The following steps are necessary to display texts in a screen object, for example:

1. Create entries in the C text list

2. Create a screen object

3. Link C script, for example to an event of the screen object

4. Reference entries in the C script through the corresponding functions

See also
Create entries in the C text list  (Page 3418)

Create entries in the C text list 

Introduction
In the C text list you create multilingual texts, which you then reference via the text ID in a C 
script. You use the C text list exclusively with functions of the API.
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Procedure
To create an entry in the C text list, follow these steps:

1. Double-click "Text and graphics lists" in the project tree.

2. Open the "C text list" tab.

3. Click "Add" in the table.
The Inspector window of the C text list opens.

4. Enter the text and your comment, if needed.
The text ID is created automatically. 

5. Change the ID as needed to identify texts that belong together.
The text ID must be within the number range 1 to 2147483647 and it must be unique. The 
uniqueness is checked by the system. 

 

  Note

If you change the text ID of an entry already referenced, this change is ignored by the 
syntax check in the script editor.

 

 

Result
An entry has been created in the C text list. 

See also
Basics on C text lists (Page 3417)
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10.1.4 Dynamic Screen Control

10.1.4.1 Basics on dynamizing screens

Dynamizing objects   
In WinCC you dynamize objects to map your system and show processes on HMI devices. 

You implement dynamizations by

● Animations

● Tags

● System functions

One example is the mapping of a tank, the liquid level of which rises or falls in relation to a 
process value. 

The options for dynamization depend on the object involved. When you copy an object, its 
dynamization functions are included.

See also
Dynamization in the inspector window (Page 3421)

Dynamization in the inspector window (Page 3423)

Configuring a new animation (Page 3426)

Show overview of the dynamizations (Page 3455)

Basics on dynamization in the property list (Page 3446)

Screen basics (Page 3299)

Basic on events (Page 3453)

10.1.4.2 Basics of dynamizing screens

Dynamizing objects   
In WinCC you dynamize objects to map your system and show processes on HMI devices. 

You implement dynamizations by

● Animations

● System functions

● Tags

● Local scripts

One example is the mapping of a tank, the liquid level of which rises or falls in relation to a 
process value. 
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The options for dynamization depend on the object involved. When you copy an object, its 
dynamization functions are included.

Customized menus and toolbars
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. These 
menus and toolbars are displayed in all screens of your project or in the screen windows. The 
menu entries and icons are connected by means of tags or VB scripts.

Use the customized menus and toolbars, for example, to change from a screen in your project 
to any other screen. 

See also
Dynamization in the inspector window (Page 3421)

Dynamization in the inspector window (Page 3423)

10.1.4.3 Dynamization in the inspector window

Introduction
Basically, you can dynamize all the screen objects which you have configured in a screen. 
Which dynamization possibilities and which events are available depends on the device and 
the selected object.

Animations
WinCC helps you to implement dynamization using predefined animations. If you want to 
animate an object, first configure the desired animation in the object's inspector window. Then 
adapt the animation to the requirements of your project. 

The selection of the supported animations depends on the HMI device and the selected object. 
You choose between the following types of animation: 

● Layout: Appearance, visibility

● Movements: direct, diagonal, horizontal and vertical movement

● Variable binding

You can configure the "Variable binding" type of animation several times for one object.

You configure animations in the "Properties > Animations" inspector window.
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Events
Operable objects also react to events, such as a mouse click. 

You configure a function list with system functions on an event. The system functions are 
processed as a reaction to the triggered event.

You configure events in the "Properties > Events" inspector window.
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You will find further information in "Working with function lists".

See also
Basics on dynamizing screens (Page 3420)

10.1.4.4 Dynamization in the inspector window

Introduction
Basically, you can dynamize all the screen objects which you have configured in a screen. 
Which dynamization possibilities and which events are available depends on the device and 
the selected object.

The inspector window offers you the possibilities for dynamization of screen objects in three 
tabs.

Property list
With the  button you go to the properties list in the "Properties > Properties" inspector 
window.

In the property list, you set any dynamization for the individual object properties using tags or 
local C and VB scripts. You can, for example, dynamically change the background color of an 
object.

In the "Dynamic Value" column you can dynamize the object property of a tag, a C-script or a 
VB-script.
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Whether an object property can be dynamized is indicated in the Property list by means of the 
background color:

● Light gray: Can be dynamized

● Dark gray: Cannot be dynamized

Any animations you have already configured will also appear in the object property list, where 
you can edit the animations. 

The following table shows you how to sort the property list:

Sort by alphabet

Sort by category

With the  button you return to the property pages in the inspector window.   

Animations
You have two different options for animating objects.

You configure animations  

● in the inspector window under "Properties > Animations",

● in the "Animations" task card.

WinCC helps you to implement dynamization using predefined animations. If you want to 
animate an object, first configure the desired animation with the tools of the toolbox or in the 
object's inspector window. Then customize the animation in the Inspector window to suit the 
requirements of your project. 

The selection of the supported animations depends on the device and the selected object. You 
choose between the following types of animation: 
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● Tag binding

● Layout: Appearance, control enable, visibility

● Movements: direct, diagonal, horizontal and vertical movement

● Property animation
 

  Note
HMI device dependency

The "Control enable" animation is not available for every HMI device.
 

You can configure the "Tag binding" and "Property animation" types of animation several times 
for one object.

You configure animations in the "Properties > Animations" inspector window.

 

Events  
Operator control enabled objects also react to events, such as a mouse click. 

You configure a function list with system functions or local scripts on an event. The system 
functions or the local script are processed as a reaction to the triggered event.

You configure events in the "Properties > Events" inspector window.
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You will find further information in "Working with function lists".

See also
Basics on dynamizing screens (Page 3420)

10.1.4.5 Dynamization with animations

Configuring a new animation

Introduction
Use predefined animations to dynamize screen objects. 

Requirement
● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.
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Procedure in the inspector window
1. In the Inspector window, select "Properties > Animations".

2. Select the animation you want to use.

3. Click the button. 

Procedure in the "Animations" task card.
1. Open the object group containing the required animation in the "Animations" task card.

2. Drag the animation onto the object that you want to make dynamic.

Alternatively you select the object in the screen and double click the desired animation in the 
"Animation" task card.

Result
The animation appears in the Inspector window of the object. You configure the animation in 
the following steps. 

In the animations overview the green arrow indicates which animation is already configured. 
The configured animation opens in the inspector window when you click the green arrow.    

See also
Dynamize control enable of a control object (Page 3432)

Dynamizing the visibility of an object (Page 3433)

Basics on dynamizing screens (Page 3420)
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Configuring direct movement (Page 3431)

Configuring animation with tag binding (Page 3434)

Animations of object groups (Page 3443)

Animations of object groups  (Page 3444)

Dynamization with property animations (Page 3435)

Dynamize appearance of an object

Introduction
The appearance of a screen object is controlled by changing the value of a tag in runtime. 
When the tag adopts a certain value, the screen object changes its color or flashing 
characteristics according to the configuration.         

Type
Areas or single values of the tag are observed in Runtime depending on the selection. The 
appearance of the object changes according to the configuration.

Requirement
● A screen is open.

● A dynamic object is contained and selected in the screen.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure
1. In the Inspector window, select "Properties > Animations".

The animations available for the selected object are displayed. 

2. Select the animation "Appearance" and click the  button.
The parameters of the animation are displayed.

3. Select a tag in "Tag > Name".

4. Select "Type > Range" for example.

5. Click "Add" in the table.

6. Enter the tag interval "0 - 20" in the "Range" column for example.

7. For "Foreground color" and "Background color", select the color the object is to acquire in 
Runtime when the tag reaches the interval.
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8. Select a flashing mode for the object from the "Flashing" list.

9. Repeat steps 5 to 8 to create another tag interval, e.g. "21 - 60".

Result
In Runtime, the flashing response, and color of the object change dynamically according to 
the process value returned in the tag. 

Configuring movements

Introduction
You can configure dynamic objects in such a way that they move on a certain track. The 
movement is controlled via tags. The object moves every time the tag is updated.         

You can only program one type of movement for each object. 

Requirement
● You have created a tag.

● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.
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Procedure
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Horizontal movement" and click the  button.
The parameters of the animation are displayed.
A transparent copy of the object is shown in the work area, which is connected to the source 
object by means of an arrow.

4. Select a tag for control of movement.

5. Move the object copy to the relevant destination. The system automatically enters the pixel 
values of the final position in the Inspector window.

6. Customize the range of values for the tag as required.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. The direction of movement corresponds to the configured type of 
movement "horizontal".

 

 Note

You configure vertical and diagonal movements similar to horizontal movements         
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Configuring direct movement

Introduction
The object is moved respectively in x direction and y direction with "Direct movement". Two 
tags define the number of pixels by which the object moves from its original static start 
position.       

Requirement
● Two tags are set up.

● You have opened a screen which contains at least one dynamic object.

● The Inspector window is open.

● The toolbox window is displayed.

Configuring "Direct movement"
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".

3. Select "Direct movement" and click the  button.
The parameters of the animation are displayed.

4. Select a tag for the X position with which the movement in x direction is controlled.

5. Select a tag for the Y position with which the movement in y direction is controlled.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. 
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See also
Configuring a new animation (Page 3426)

Dynamize control enable of a control object

Introduction
You can dynamically change the usability of  an operating element. The object either can, or 
cannot be used in Runtime, depending on the value of a tag.    

You can use this dynamic control to restrict operator access to  an operating element to specific 
situations, such as for maintenance.

Requirement
● You have created a tag.

● A screen with an operating element is open.

● The Inspector window is open.

● The toolbox window is displayed.

Procedure
1. Select the operating element in the screen that you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Control enable" and click the  button.
The parameters of the animation are displayed.

4. Select a tag.
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5. Activate "Range".

– For "From:" enter  e.g. the value "0"

– For "To:" enter  e.g. the value "100"

6. Activate "Control enable > Activated".

Result
The screen object is operator control enabled in Runtime depending on the tag value:

● The object becomes operator control enabled when the tag value is between 0 and 100.

● The object is not operator control enabled if the tag value is outside the range.

See also
Configuring a new animation (Page 3426)

Dynamizing the visibility of an object

Introduction
Dynamization of the "Visibility" property allows you to output an alarm to your screen, which 
is triggered when the tag value exceeds a critical range, for example. The alarm is cleared 
when the tag value returns to the non-critical range.

The "Simple recipe view" and "Simple alarm view" objects are always visible.

Requirement
● You have created a tag.

● You have opened a screen containing an object that you want to show or hide in Runtime.

● The Inspector window is open.

Procedure
1. Select the screen object you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animations".
The animations available for the selected object are displayed. 

3. Select "Visibility" and click the  button.
The parameters of the animation are displayed.

4. Select a tag.

5. Activate "Range".
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6. Select, for example, "from 20" and "to 40"

7. Activate "Visible".

Result
The screen object is shown or hidden in Runtime depending on the tag value.

● If the tag value matches the configured range between 20 and 40, the screen object is 
shown.

● If the tag value is outside the configured range, the screen object is hidden.

See also
Configuring a new animation (Page 3426)

Configuring animation with tag binding

Introduction
When you object property an object property with a tag, the object property is changed in 
Runtime depending on the tag value.       

The following example shows the tag binding in the "Properties > Animations" inspector 
window. If you have configured tag binding it is also visible in the property list or in the property 
pages in the inspector window.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The Inspector window is open.
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Procedure
1. Select the screen object whose properties you want to control dynamically.

The object properties are displayed in the Inspector window.

2. In the Inspector window, select "Properties > Animation".
The animations available for the selected object are displayed. 

3. Select "Tag connection" and click the  button.
The parameters of the animation are displayed.

4. Select the object property that you want to dynamize in "Properties > Animation > Tag 
binding > Property > Name", e.g. "Background color".

5. Select a tag.

Result
You have dynamized the "Background color" property with a tag. The background color of the 
screen object changes in Runtime depending on which value the tag adopts. 

See also
Configuring a new animation (Page 3426)

Dynamization with property animation

Dynamization with property animations

Introduction
With the property animation you dynamize the properties of screens and screen objects 
depending on certain value ranges or tags. You select value ranges and determine how the 
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linked object property changes when the tag adopts a certain value in Runtime. You have the 
option of dynamizing several object properties simultaneously, e.g. the position and the color 
of a screen object. You can also configure several property animations on one object.

 

 Note
Dynamizing several object properties at the same time

You can dynamize multiple object properties with animation. The order of processing in 
runtime is not necessarily the same as the order of property configuration in the Inspector 
window under "Properties > Animation".

 

Type     
The following types are available to define the value range:

● Range 
One or more value ranges of a tag are viewed. You configure different value ranges. You 
define the appropriate values of the object property for every value range. If the value in 
Runtime is within a configured value range, the linked object property is dynamized.
Only define value ranges as integers. A non-integer tag value or expression is rounded up 
or down accordingly.

● Multiple bits  
One or more bit numbers of a tag are viewed. You configure different bit numbers. The 
linked object property is only dynamized if the tag value in Runtime exactly matches one 
of the configured bit numbers. If the variable value does not match, the static value of the 
object property is displayed.

● Single bit  
You select the bit of tab which is to be monitored. If the bit is to be set, you configure the 
value "0". If the bit is not to be set, you configure the value "1".

● Bool (true, false)  
The Boolean tag or an expression which contains a logical comparison is viewed. If the tag 
or return value of the expression returns one of the two values - true or false - the value is 
assigned to the dynamized property.

● Direct 
Unlike the other types, the tag value or expression in the "Direct" type is written directly into 
the object property.

Expression       
You can formulate the expression by using tags, VB-scripts and arithmetic operators. The 
value of the expression is determined in Runtime and compared with the configured value 
ranges. The "Expression" option is only available for the "Range", "Boolean" and "Direct" types.

Evaluation "Quality Code"       
Use "Quality Code" to check the status and quality of a tag. The quality of the entire value 
transmission and value processing of the respective tag is combined in the displayed "Quality 
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Code". The monitoring of the "Quality Code" enables you to draw conclusions about the quality 
of the tags in the process. 

The evaluation of the "Quality Code" has priority over the defined value ranges. 

If you use several tags, the "Quality Code" of the tags is evaluated in the order in which they 
appear from left to right in the expression. The configured values are only viewed if the "Quality 
Code" of the tag is correct.

The figure below shows a selection of the offered "Quality Codes". The "Quality Codes" are 
sorted in descending order of priority in this list.

See also
Configuring property animation of the Range type (Page 3437)

Configuring property animation of the Direct type (Page 3440)

Configuring property animation of the Bool type (Page 3440)

Configuring a new animation (Page 3426)

Configuring property animation of the Range type

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. The following example shows the dynamization of a circle. The 
circle changes color and position depending on a tag.

Requirement
● You have created a "Tag1" tag.

● You have created a screen.

● You have inserted and selected a circle in the screen.

● The Inspector window is open.
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Select animation type, tag and type
1. In the Inspector window, select "Properties > Animation".

The animations available for the selected object are displayed. 

2. Select "Property animation" and click the  button.
The parameters of the animation are displayed.

3. Enter the name "Light" under "Settings > Name".

4. Select "Range" as type".

5. Activate "Process > Tag".

6. Select "Tag1" under "Process > Tag".

Select object properties and ranges
1. Click  "Add property". A drop-down list opens.

2. Select the property "Y position". A column "Y position" is added to the table.

3. Click  "Add property". A drop-down list opens.

4. Select the property "Color background". A column "Color background" is added to the table.

5. Click "Add" in the table.

6. Define the first range from "0 - 49".

7. Click "Add" in the table.

8. Define the second range from "50 - 99".

9. Click "Add" in the table.

10.Define the second range from "100 - 149".
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Assign the background color and position to a range
Define the following settings for the ranges:

● Range 0 - 49: Y position "200"; color "green"

● Range 50 - 99: Y position"220"; color "yellow"

● Range 100 - 149: Y position  "240"; color "red"

Result
Depending on in which range the tag is located in Runtime, the circle changes position and 
background color.

 

 Note

If you use the operands "=", ">", "<", "!=" in the expression and have set the type "Range", 
note the following:

The value for "true" = -1

The value for "false" = 0
 

See also
Dynamization with property animations (Page 3435)
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Configuring property animation of the Direct type

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. The following example shows the dynamization of an I/O field. 
The I/O field changes its output value depending on a tag.

Requirement
● You have created a "Tag1" tag.

● You have created a screen.

● You have inserted and selected an I/O field with the "Output" mode in the screen. 

● The inspector window is open.

Select animation type, tag and type
1. Click "Properties > Animation" in the inspector window.

The animations available for the selected object are displayed. 

2. Select "Property animation" and click the  button.
The parameters of the animation are displayed.

3. Enter the name "Fill level" under "Settings > Name".

4. Select "Direct" as type".

5. Activate "Process > Tag".

6. Select "Tag1" under "Process > Tag".

Result
The tag value in Runtime is written directly into the I/O field. 

See also
Dynamization with property animations (Page 3435)

Configuring property animation of the Bool type

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. In the following example, a button is shown and hidden depending 
on the value of an expression.
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Requirement
● A "TCelsius" tag of the "Uint" type is created.

● You have created a screen.

● You have inserted and selected a button in the screen.

● The inspector window is open.

Select animation type, expression and type
1. Click "Properties > Animation" in the inspector window.

The animations available for the selected object are displayed. 

2. Select "Property animation" and click the  button.
The parameters of the animation are displayed.

3. Enter the name "Visibility" under "Settings > Name".

4. Select "Boolean" as type".

5. Activate "Process > Expression".

6. Enter the following expression in the field: "(('TCelsius’ × 9) / 5) + 32 < 100".
 

  Note

Make sure to write the tag name in single inverted commas in the direct input.
 

Alternatively, enter the expression with the buttons above the field. For example, click the  
button and select a tag from the drop-down list.
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Select object property
1. Click  "Add property". A drop-down list opens.

2. Select the "Visibility" property. A "Visibility" column is added to the table.

3. Activate the "Visibility" property for the "True" value in the table.

Result
The value of the expression is determined in runtime. The button is displayed if the value 
matches the configured "True" value. 

See also
Dynamization with property animations (Page 3435)
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Animations of object groups

Applying animations to object groups
The inspector window shows all objects of a group and their possible animations. The 
animation types which are supported by all objects in the group are also listed separately.

If you configure an animation for an object group, this animation will apply to all individual 
objects that support this animation.

Application example
The "horizontal movement" animation is configured for the object of an object group. The "direct 
movement" animation is configured for the whole object group. Only the animation of the object 
group i.e. "direct movement" is executed in Runtime. This also applies for object groups within 
object groups. Only the animation of the group on the top layer is listed.

 

See also
Configuring a new animation (Page 3426)
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Animations of object groups 

Changing animations of object groups
The inspector window shows all objects of a group and their possible animations. The 
animation types which are supported by all objects in the group are also listed separately.     

If you configure an animation for an object group, this animation will apply to all individual 
objects that support this animation.

Application example
The "horizontal movement" animation is configured for the object of an object group. The "direct 
movement" animation is configured for the whole object group. Both animation types are 
executed in runtime. This also applies for object groups within object groups.

See also
Configuring a new animation (Page 3426)
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Animations in multiple selection

Changing animations for multiple objects  
For a multiple selection, the animations that are configured for the reference object appear in 
the Inspector window. You can change the animations as usual. The changes will apply to all 
the objects in the multiple selection that support the configured animation. This means that 
even objects for which you have not yet configured an animation will have the reference object's 
animation. 

Application example
Select a button, and a circle at the same time. The button is the reference object. The 
"Appearance" animation is already configured for the button, so it appears in the Inspector 
window of the multiple selection. When you activate "Properties > Animations >Appearance > 
Flashing" in the inspector window, the settings of the "Appearance" animation apply for the 
button and for the circle.

Configuring new animations for multiple objects
If you configure a new animation for the objects of a multiple selection, this animation will apply 
to all selected objects that support the configured animation. If the new animation replaces an 
existing animation, a security prompt appears.

Application example
You select a circle, and a rectangle. The "Diagonal movement" animation is already configured 
for the circle. You configure the "Horizontal movement" animation for the multiple selection. 
This animation applies to the rectangle since no animation of the Movement type is yet 
configured for it. For the circle, you are asked to confirm that you want to replace the existing 
"Diagonal movement" animation with the new "Horizontal movement" animation. 
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10.1.4.6 Dynamization in the property list

Basics on dynamization in the property list

Basic principle of dynamization
In the case of an object property that can be dynamized you first specify the type of 
dynamization. The following figure shows the types of dynamization available:

Depending on the type of dynamization you either select a tag using the object list or you create 
a local script. 

Dynamization with tags
If you dynamize an object property with a tag, you can configure a function list additionally on 
the following events:

● Changed

● Tag status changed

● Quality code changed

The tags are updated in the update cycle set for the screen.

The figure below shows the "Radius" object property dynamized with a tag. When the value 
of the tag changes, a function list is executed additionally:
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You can also convert the function list into a local script.

Further information can be found in Auto-Hotspot

Quality Code
Use "Quality Code" to check the status and quality of a tag. The quality of the entire value 
transmission and value processing of the respective tag is combined in the displayed "Quality 
Code". The monitoring of the "Quality Code" enables you to draw conclusions about the quality 
of the tags in the process. 

Dynamization with local scripts
With a local script you dynamize an object property in Runtime by means of the return value 
of the local script. The script is created directly at the instance where it is used. The following 
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figure shows the implementation of a status indicator by dynamizing the background color 
using a VB script:

See also
Dynamizing an object property with a tag (Page 3449)

Dynamizing an object property with local scripts (Page 3452)

Basics on dynamizing screens (Page 3420)

Basics on dynamization in the property list (Page 3448)

Programming a dynamization method for a tag change (Page 3451)

Show overview of the dynamizations (Page 3455)

Basics on dynamization in the property list

Basic principle of dynamization
Select a tag from the object list for a dynamizable object property in the property list. The object 
is dynamized if the tag value changes in Runtime.

Dynamization with tags
You dynamize an object property with a tag and configure a function list. The tags are updated 
in the update cycle set for the screen.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3448 System Manual, 02/2014



The figure below shows the "Radius" object property dynamized with a tag. When the value 
of the tag changes, a function list is executed additionally:

You can also convert the function list into a local script.

You can find additional information under "Basics on the function list (Page 4435)".

See also
Basics on dynamization in the property list (Page 3446)

Dynamizing an object property with a tag

Introduction
When you dynamize an object property with a tag, the object property is changed in Runtime 
depending on the tag value. When you indirectly dynamize the object property, you connect 
the property to a tag that sets the property value in Runtime.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The Inspector window is open.
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Procedure
1. Select the screen object whose properties you want to control dynamically.

The object properties are displayed in the Inspector window.

2. Click the  button in the Inspector window.
The property list is displayed with the properties of the selected object. 

3. Select the property to be dynamized.

4. In the "Dynamization" column, select the entry "HMI_Tag".
A dialog opens.

5. Select a tag.

6. Activate "Use indirect addressing" to dynamize the object property.

Result
The object property changes in Runtime according to how the property list is configured. 

Representation of a multiple selection in the property list
If you selected multiple objects at the same time, the "Object type" column is added to the 
property list. The objects that support the property displayed in the row are displayed in this 
column. Changes to, or dynamization applied to a property affect all the objects displayed in 
the "Object type" column.
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See also
Basics on dynamization in the property list (Page 3446)

Programming a dynamization method for a tag change

Introduction
If you have entered a tag in the "Dynamization" column, you can configure a function list 
additionally on different events.

Requirement
● An object with the property to be dynamized is selected.

● You have created a tag.

● The property list is open in the inspector window.

● An object property is connected with the tag.
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Procedure
1. Extend the property list by clicking next to the property which you have dynamized with a 

tag.

2. Three other lines with the following events are displayed below the property.

– Changed

– Tag status changed

– Quality code changed

3. Configure a function list for the required event.
Alternatively you can convert the function list into a local script.

Result
The object property changes in Runtime according to how the property list is configured. 

See also
Basics on dynamization in the property list (Page 3446)

Dynamizing an object property with local scripts

Introduction
With a local script you dynamize an object property in Runtime by the return value of the script. 
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Requirement
● The object with the property to be dynamized is selected.

● The Inspector window is open.

Procedure    
1. Click  in the Inspector window.

2. Select the object property to be dynamized.

3. Select the "VB script" or "C script" entry in the "Dynamization" column.
A dialog opens.

4. Write the program code.

5. Click " " in the toolbar to change the trigger.

Result
The object property changes in Runtime according to how the property list is configured.

Deleting the dynamization    
1. Select the dynamized object property in the property list.

2. Select the "None" entry in the "Dynamization" column.

See also
Basics on dynamization in the property list (Page 3446)

10.1.4.7 Dynamize with system functions

Basic on events

Introduction
Screen objects react to events. You configure a function list with system functions on the events 
of an object. 

Events 
Which events and system functions are available depends on the object used.

If the operator activates a screen object for example, the configured system function is 
executed.

You can find additional information under "Basics on the function list (Page 4435)".
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See also
Configure system function on the "Click" event (Page 3454)

Example: Configuring a button for language switching (Page 3454)

Basics on dynamizing screens (Page 3420)

Configure system function on the "Click" event

Introduction
You configure a function list on an object event. The linked system function is executed when 
the event occurs in runtime.

Requirements
A screen is open.

A button has been created in the screen.

The inspector window is open.

Procedure
1. Select the button.

2. Click "Properties> Events" in the Inspector window.

3. Select the "Click" event.

4. Click "Add function" in the table.

5. Select the "ShowAlarmWindow" system function.

Result
The alarm window opens in the screen if the operator clicks the button in runtime. 

See also
Basic on events (Page 3453)

Example: Configuring a button for language switching

Introduction
In this example, you configure a button that can be used to toggle between multiple runtime 
languages during runtime.
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Requirements
● You have completed the "Configuring a button in multiple languages" example.

● The "Screen_1" screen is open.

● The button on the screen has been selected.

Procedure
1. In the Inspector window, select "Properties > Events > Press".

2. Click on "Add function" in the table.

3. Select the "SetLanguage" system function and the "Switch" setting.

Result
You have assigned the button the function "SetLanguage". Pressing the button during runtime 
will switch the runtime language. The runtime languages are switched in the order specified 
by the number sequence in the "Languages and fonts" editor. 

See also
Basic on events (Page 3453)

10.1.4.8 Show overview of the dynamizations

Introduction
You can set the update cycle separately for every single dynamization. The number of different 
update cycles is limited to five per project.

Show overview of existing dynamizations
1. Select a screen in the project tree.

2. Select "Overview dynamizations" in the shortcut menu.
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Result
All objects and their dynamizations are shown in the work area in the screen. Under "Cycle" 
you select another update cycle if necessary.

See also
Basics on dynamizing screens (Page 3420)

Basics on dynamization in the property list (Page 3446)

10.1.5 Working with function keys

10.1.5.1 Working with function keys 

Introduction
The function key is a physical key on your HMI device and its functions can be configured. A 
function list can be configured for the events "Key pressed" and "Release key".       

A function key can be assigned global or local functions.
 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Global function keys
Global function keys always trigger the same action, regardless of the displayed screen.

Global function keys are configured in the "Global Screen" editor. The global assignment 
applies for all the screens of the set HMI device. 

Global function keys reduce programming considerably, because there is no need to assign 
these global keys to each individual screen.

Local function keys in screens
Local function keys in screens can trigger a different action in each screen. This assignment 
applies only to the screen in which you have defined the function key.
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Within a screen, a function key has only one function assignment, either a global or local one. 
The project planner specifies which assignment has priority.

 

 Note

If a screen with local function keys is overlapped by an alarm view or an alarm window, then 
the function keys are still active in runtime. This may happen in particular on HMI devices 
with a small display.

 

Local function keys in templates
Local functions keys that are assigned in templates are valid for all the screens based on this 
template. They can trigger a different action in every screen. Function keys for templates are 
assigned in the template of the "Screens" editor.  Within a template, a function key has only 
one function assignment, either a global or local one. The project planner specifies which 
assignment has priority.

Hotkey assignment
You can assign hotkeys, such as buttons, to control objects. The available hotkeys depend on 
the HMI device.

 

 Note

The function key has a local or global action assigned to it. If the function key also has a 
hotkey assigned to it, then the hotkey function will be executed in Runtime.

 

Graphics
When a function key is placed directly next to the display, you can assign a graphic to it to 
make the function of the function key more clear.

Display of assignment

Table 10-1 The following table shows which symbols display the assignment of the function keys:

Function key Description
Not assigned

Global assignment

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
System Manual, 02/2014 3457



Function key Description
Assigned locally in the template

Local assignment

Local assignment (local assignment of the template overwrites global 
assignment)

Local assignment (local assignment overwrites global assignment)

Local assignment (local assignment overwrites local assignment of the template)

Local assignment (local assignment overwrites local assignment of the 
template, which already overwrites global assignment)

Assigning buttons with screen navigation
 

 Note
Basic Panels

The "Screen Navigation" editor is not available for Basic Panels.
 

 

10.1.5.2 Assigning function keys globally

Introduction
You define the global assignment of a function key in the "Global Screen" editor. The global 
assignment applies to all screens of the set HMI device.             

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3458 System Manual, 02/2014



Requirement
● You have opened the project.

● The Inspector window is open.

Procedure
Proceed as follows to assign a screen-based function to a function key:

1. To open the "Global Screen" editor, double-click "Global Screen" in the "Screen 
management" group of the Project window.

2. Select the desired function key.
The properties of the function key are shown in the Inspector window.

3. Under "General", configure a graphic and an operator authorization for the function key.

4. Configure a function list for the required event under "Events".

Result
If a local assignment does not overwrite the global assignment, the assignment of the function 
key changes in all the screens of the set HMI device in accordance with your entry. 
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10.1.5.3 Local assignment of function keys

Introduction
Function keys are assigned globally and locally. A local assignment of the function keys is only 
valid for the screen or the template in which it was defined. The following local function keys 
are available:

● Local function keys of a screen
Different functions are assigned to the function key for each screen. This assignment 
applies only to the screen in which you have defined the function key.

● Local function keys of a template
You assign the function keys in a template. The assignment applies to all the screens that 
are based on this template and are not overwritten by a local assignment in a screen.

A local assignment overwrites the global assignment of a function key.         
 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Using existing assignments
The option for using existing assignments is referred to as follows in the Inspector window:

● In a template: "Use global assignment"

● In a screen:

– Screen based on a template: "Use local template"

– Screen not based on a template: "Use global assignment"

The "Use local template" option includes the use of the local assignment in the template and 
the global assignment.

Requirement
● You have opened the screen or the template in which you want to assign a function key 

locally.

● The Inspector window is open.
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Procedure
Proceed as follows:

1. Select the desired function key in the screen or in the template.
The properties of the function key are shown in the Inspector window.

2. Click "General" in the Inspector window.

3. Disable the "Use local template" or "Use global assignment" option.

4. Under "General", configure a graphic and an operator authorization for the function key.

5. Configure a function list for the required event under "Events".

Result
The function key is assigned the configured function in the screen or in the template. 

10.1.5.4 Assigning a function key to a function

Introduction
A function key can have two states:       

● Pressed: Defined by the "Key pressed" event.

● Released: Defined by the "Release key" event.
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Both of these events are configured in the Inspector window of the function key. You can assign 
any event a function list which contains system functions or scripts. Execution of this function 
list is event-driven in runtime.

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

 Note
Basic Panels

Scripts are not available for Basic Panels.
 

Requirement
To assign the function key a global function: 

● The "Global Screen" editor is open.

To assign the function key a local function: 

● The screen in which you want to assign a function key is open.

If you want to assign a function key locally in a template: 

● The template in which you want to assign a function key is open.

● The Inspector window is open.

Procedure
Proceed as follows:

1. Select the function key you want to define.
The properties of the function key are shown in the Inspector window.

2. Configure the function list for the desired result in the Inspector window under "Properties" 
in the "General" group.

Result
The function list is executed in runtime when the operator presses or releases the function 
key. 

10.1.5.5 Assigning operator authorization for a function key

Introduction
In WinCC you can assign an operator authorization for a function key in runtime. This allows 
you to restrict access to the function keys to specific persons or operator groups when you 
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configure your project. Only authorized personnel can then change important parameters and 
settings in runtime.       

You configure access protection in order to avoid operator errors and increase plant or machine 
security.

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Requirement
● The user groups have been defined.

To protect a global function key: 

● The "Global Screen" editor is open.

If you want to protect a local function key of a screen or of a template: 

● The screen or the template which contains the function key is open.

● The Inspector window is open.

Procedure
Proceed as follows:

1. Select the relevant function key.
The properties of the function key are shown in the Inspector window.

2. Click "General" in the Inspector window.

3. In the "Authorization" list, select the user group you want to allow runtime access to the 
function key.
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Result
The operator authorization is configured. 

10.1.5.6 Assigning a function key to a graphic

Introduction
In order to make the function of a key more clear, you can insert a graphic in the screen 
alongside the function key. Graphics can only be assigned to function keys that border the 
screen margin of the HMI device.       

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Requirement
To assign a graphic to a global function key:

● The "Global Screen" editor is open.

If you want to assign a graphic to a local function key in a screen or template: 

● The screen or the template that contains the corresponding function key is open.

● The Inspector window is open.

● You have created the graphic for the function key.
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Procedure
Proceed as follows:

1. Select the relevant function key.
The properties of the function key are shown in the Inspector window.

2. Click "General" in the Inspector window.
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3. Click in the "Graphic" area of the list.
The graphic browser of your WinCC project appears. The pane on the left side shows the 
external graphics which are stored in the browser. The pane on the right side shows you a 
preview of the graphic you have selected in the browser.

Using the  and  icons, you can display the collection either in form of thumbnails 
or as a list.
In order to open and edit OLE objects with the associated graphics program, double-click 
on the object.

4. In the browser click the desired graphic or store the relevant graphic in the graphic browser.
The graphic preview is shown in the right pane.

5. Click "Select" to add the graphic to the screen.
Click "Clear" to remove the graphic from the screen.

Result
The graphic is displayed next to the function key. 

10.1.5.7 Configuring LED tags

Requirements
● An HMI device with key operation has been created.  

● You have created an LED tag.

Procedure
1. Create a new screen.

2. Click an F-key of the HMI device.
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3. In the Inspector window, click "Properties > Properties > General".

4. Select a tag under "LED tag" in the "General > Settings" area.

5. Under "Bit" enter the correct bit number.
The correct bit number depends on the HMI device and the input and output assignments 
on the HMI device.

Assignment of inputs and outputs
The exact assignment of inputs and outputs can be found under: 

● PROFINET IO direct keys: Inputs and outputs of HMI devices (Page 6553)

● PROFIBUS DP direct keys: Inputs and outputs of HMI devices (Page 6570)
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10.1.5.8 Example: Using function keys for screen navigation

Task
In this example you create a local function key in a screen. When the operator presses this 
function key, a screen change to a predefined screen is triggered, for example "Boiler 2".     

 

 Note
Availability for specific HMI devices

Function keys are not available on all HMI devices.
 

Requirement
● The screen in which you want to assign the function key is open.

● You have created the "Boiler 2" screen.

● The Inspector window is open.

Procedure
Proceed as follows to use the "ActivateScreen" function:

1. Select the desired function key.
The properties of the function key are shown in the Inspector window.

2. Click "General."

3. To overwrite a global assignment, disable the "Use local template" option.

4. Click "Key pressed" under "Events".
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5. Select the "ActivateScreen" system function from the list.
The "ActivateScreen" function appears in the "Function list" dialog box, including the 
"Screen name" and "Object number" parameters.

6. Select the "Boiler 2" screen from the "Screen name" list.

Result
The operator changes to the "Boiler 2" screen in runtime by pressing the selected function key.

10.1.6 Working with Layers

10.1.6.1 Basics on working with layers

Layers
Use layers in order to achieve differentiated editing of the objects in a screen. A screen consists 
of 32 layers that you can give any names. If you assign objects to the layers, you thereby define 
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the screen depth. Objects of layer 0 are located at the screen background, while objects of 
layer 31 are located in the foreground. 

The objects of a single layer are also arranged hierarchically. When you create a screen, the 
object inserted first is located at the rear within the layer. Each further object is placed one 
position towards the front. You can shift objects forwards and backwards within a layer.

Principle of the layer technique
Always one layer of the 32 layers is active. New objects you add to the screen are always 
assigned to the active layer. The number of the active level is displayed in the inspector window 
of the screen and in the "Layout > Layers" task card. 

When you open a screen, all 32 layers of the screen are displayed. You can hide all the layers 
except for the active layer in the inspector window of the screen and in the "Layout > Layers" 
task card. You then explicitly edit objects of the active layer.

In the tree view of the "Layers" palette in the "Layout" task card, you administer layers and 
objects with drag-and-drop and the context menu.

Application examples
Use layers, for example, in the following cases:

● To hide the labeling of objects when editing,

● To hide objects, e.g. alarm windows, while configuring other objects

10.1.6.2 Moving objects between layers

Introduction
By default, a new object is inserted on the active layer. You can, however, assign an object to 
another layer at a later time.     
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Requirement
● A screen with an object is open.

● The Inspector window is open.

Procedure
1. Select the object in the screen.

The object properties are displayed in the Inspector window.

2. Enter the layer to which you want to move the object in "Properties > Properties > 
Miscellaneous > Layer" in the Inspector window.

Alternatively, select the object from the "Layout" task card and drag it to the required layer.

Changing the order of objects
1. Select the object in the screen.

The object properties are displayed in the Inspector window.

2. To move the object to the front or back, select the "Order" > "Move backward" or "Move 
forward" command from the shortcut menu.
Alternatively, use the  or  button in the toolbar.

Result
The object is assigned to the selected layer, and positioned at the top of the layer. 

10.1.6.3 Setting the active layer

Introduction
The screen objects are always assigned to one of the 32 layers. There is always an active 
layer in the screen. New objects you add to the screen are always assigned to the active layer. 

The number of the active layer is indicated in the "Layer" toolbar. The active layer is indicated 
by the  icon in the "Layout > Layers" task card.

Layer 0 is the active layer when you start programming. You can activate a different layer 
during configuration, if necessary.

Requirement
● You have opened a screen which contains at least one object.

● The Inspector window of the active screen is open.

Procedure
1. Click "Properties > Properties > Layers" in the Inspector window of the current screen.

2. Enter the layer number in "Settings > Active layer".
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Alternative procedure
1. Select "Layout > Layers" in the "Layout" task card.

2. Select the "Set to active" command from the shortcut menu of a layer.

Result
The layer with the specified number is now active.

10.1.6.4 Show and hide layers

Introduction
You can show or hide the layers of a screen as required. You specify the layers that are shown 
in the Engineering System. When you open a screen, all the layers are always shown. 

Requirement
● The screen is opened.

● The "Layout" task card is open.
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Procedure
1. Select the layer that you want to hide or show in the "Layout > Layers" task card.

2. Click one of the icons next to the corresponding layer:

–  A shown layer is hidden

–  A hidden layer is shown
 

  Note

The active layer cannot be hidden.
 

Alternative procedure
1. Click in an area of the screen that does not contain an object.

The screen properties are shown in the Inspector window.

2. In the Inspector window, select "Properties > Properties > Layers":

3. In the list, disable the levels you wish to hide.
If you activate "All ES layers" for a layer, the objects in this layer will be shown in the 
Engineering System.

Result
The layers are shown according to your settings. 
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10.1.6.5 Show and hide layers

Introduction
You can show or hide the layers of a screen as required. You define whether the layers are 
displayed in the engineering system, and/or in Runtime. When you open a screen, all the layers 
are always shown.

Requirement
● The screen is opened.

Procedure
1. In the Inspector window, select "Properties > Properties > Layers":

2. Deactivate the layers that are not to be displayed in the Engineering System.

3. Deactivate the layers that are not to be displayed in runtime.

Alternatively you can also activate and deactivate the layers in the "Layer" task card.

Result
The activated layers are displayed in ES and in Runtime. 
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10.1.6.6 Hide layers and objects in Runtime

Introduction
Layers and the objects stored in them can be shown and hidden in Runtime system-
dependently depending on the zoom factor. This means, for example, that a layer is only shown 
if a sufficient zoom factor allows the required detail to also be displayed.

You can hide or show objects depending on the defined pixel size.

Requirement
A screen is open.

Hiding layers
1. Click in an area of the screen that does not contain an object.

2. Activate "Properties > Properties > Hide/Show > Activate for layers" in the Inspector window.

3. In the table enter the minimum and the maximum value for the zoom factor within which 
the respective layer is displayed.
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Hiding objects
1. Click in an area of the screen that does not contain an object.

2. Activate "Properties > Properties > Hide/Show > Activate for layers" in the Inspector window.

3. Enter the minimum size in which the objects are displayed under "Min. pixels."

4. Enter the maximum size in which the objects are displayed under "Max. pixels."

Result
Levels which are outside the zoom factor are not displayed in runtime. Objects which are 
outside the specified size are also not displayed. 

10.1.6.7 Renaming layers

Introduction
When you create a screen, the 32 layers are numbered consecutively by default. To improve 
clarity, you can rename the layers to suit your requirements.
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Requirement
● The screen is opened.

Procedure
1. Click in an area of the screen that does not contain an object.

The screen properties are shown in the Inspector window.

2. In the Inspector window, select "Properties > Properties > Layers".

3. Enter the new layer name.

Result
The layer is displayed with the new name. 
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10.1.7 Working with faceplates

10.1.7.1 Basics on faceplates

Introduction
Faceplates are a configured group of display and operating objects that you manage and 
change centrally in a library. You can use a faceplate in several projects as required. The 
faceplates are stored in the project library. 

Use
You use faceplates to create individually configured display and operating objects. You can 
use faceplates several times in the project or in different projects. All instances of a faceplate 
in the project are changed centrally. This reduces the configuration effort.

Types and instances     
Faceplates are based on a type-instance model to support the central changeability. You 
create central properties for an object in types. The instances represent local points of use of 
the types.

● Faceplate type 
You create a display and operating object according to your requirements and store it in 
the project library. The instances are bound to the respective faceplate type. If you change 
a property of a faceplate type, the property is saved centrally and also changed in all 
instances. In the faceplate type, you define the properties that can be changed on the 
faceplate. You edit a faceplate type in the "Faceplates" editor.

● Faceplate 
The faceplate is an instance of the faceplate type. You use a faceplate in screens as a 
display and operating object. You configure the variable properties of the faceplate type on 
the instance. You assign the tags of your project to the faceplate, for example. If you 
configure properties on the faceplate, you overwrite the properties of the faceplate type. 
The changes on the faceplate are saved at the point of use and have no effect on the 
faceplate type.

The figure below shows the relationships between the faceplate type and the faceplate. The 
background color of the I/O field is configured in the faceplate type in such a way that every 
instance can change the property. Blue is used as the background color in the faceplate type. 
You use yellow as the background color in the faceplate. 
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When you change the background color in the faceplate type, this has no effect on the faceplate 
because the "Background color" property is assigned on an instance-specific basis.

See also
Faceplate editor (Page 3480)

Creating a faceplate type (Page 3483)

Screen basics (Page 3299)

Basics of dynamizing faceplates (Page 3500)

Example: Configuring a faceplate (Page 3501)

10.1.7.2 Device dependency of faceplates

Device dependency of faceplates
Not all HMI devices support every display and operating object. The screen objects that are 
not available in the respective HMI device are not displayed when using the faceplate.

The following devices support faceplates:

Runtimes
● WinCC Runtime Advanced

● WinCC Runtime Professional

Comfort Panels
● KTP 400

● KP 400

● TP 700

● KP 700

● TP 900

● KP 900

● TP 1200

● KP 1200

● TP 1500

● KP 1500

● TP 1900

● TP 2200
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Panels
● TP 277

● OP 277

Mobile Panels
● Mobile Panel 277

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277F IWLAN (RFID Tag)

Multi Panels
● MP 277

● MP 377

10.1.7.3 Faceplate editor

Open
Create faceplate types and edit them in the library view. 

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3480 System Manual, 02/2014



Layout
The library view for faceplate types consists of several editors, e.g. "Screens" and "Tags" which 
are arranged in the work area and the configuration area.
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Work area
In the work area, place the objects contained in the faceplate type as you usually do in the 
"Screens" editor. You can remove objects, or use the "Toolbox" task card to add new objects.

Configuration section
● Properties 

The static and dynamic properties are identified as follows: 

– The  symbol identifies a dynamic property. Dynamic implementation of this property, 
using tags or text and graphic lists.

– The  symbol identifies a static property. You change only the values of a static 
property.
 

 

  Note
Device dependency of static properties

Static properties are only available for panels and RT Advanced.
 

You define the faceplate type properties in the "Properties" tab.
You use the following two lists for this:

– The "Contained objects" list
This list includes the properties of the objects contained in the faceplate type. These 
properties can only be configured in the faceplate type in the "Faceplate" editor.

– The "Interface" list contains the properties and tags of the faceplate type. The "Interface" 
list consists of the pre-defined category "Dynamic properties" and user-defined 
categories.

● Events 
You define the faceplate type events in the "Events" tab. You use the following two lists for 
this:

– The "Contained objects" list contains the events of the objects embedded in the 
faceplate type.

– The "Interface" list contains the events of the faceplate.
You create links between the two lists using a drag and drop operation.

● Tags 
You can also create faceplate tags on the "Tags" tab. The tags are only available within 
the faceplate type. You can interconnect the faceplate type tags directly with an object 
contained in the faceplate type. 
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● Scripts 
In the "Scripts" tab, you can configure scripts for the faceplate type. In the script, you can 
call up system functions or program new functions, for example to convert values. The 
scripts are only available within the faceplate type. They work with VB Script code.

 

  Note

The "Scripts" tab is not available for Runtime Professional.
 

● Text lists 
You can also create and edit texts lists for the faceplate type in the "Text lists" tab. These 
text lists are only available within the faceplate type. You can interconnect the text lists of 
the faceplate type directly with an object contained in the faceplate type, such as a symbolic 
I/O field.

● Graphics lists 
If necessary, you can also create graphics lists for the faceplate type in the "Graphics lists" 
tab. These graphic lists are only available within the faceplate type. You can interconnect 
the graphic lists of the faceplate type directly with an object contained in the faceplate type, 
e.g. a graphic I/O field. 

● User texts 
The "User text" tab shows the contained user text of the opened faceplate type, for example 
entries from text lists. You can enter the compilations for the individual project languages 
directly in the "User text" tab. 

See also
Basics on faceplates (Page 3478)

Example: Configuring a faceplate (Page 3501)

10.1.7.4 Create and manage faceplate types

Creating a faceplate type

Introduction       
Faceplate types are display and operating objects which are made up of several objects, e.g. 
controller modules. 

Requirement
You have opened a screen which contains multiple objects.
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Procedure in the project view
1. Select all the objects that you need for the faceplate type.

2. Select the "Create faceplate type" command in the shortcut menu of the multiple selection.
A dialog opens. 

3. Enter a name for the faceplate. 

4. If necessary, add a comment or change the version number.

Result
The library view opens. Two versions of the type are displayed in the "types" folder. Version 
0.0.1 has been released and contains the currently selected objects. 

The 0.0.2 version has the status "in progress". Edit the faceplate type in version 0.0.2 as 
required.

Procedure in the library view
1. The library view is open.

2. Select the "Add new type" command in the shortcut menu of the project library. A dialog 
opens.

3. Select the runtime for which the faceplate type is to be available. An empty faceplate type 
is created.

4. Drag-and-drop the objects from the "Toolbox" task card to the work area of the faceplate 
type. 

Result
The new faceplate type is created and displayed under the selected name in the project library. 

The faceplate type is assigned the status "in progress" and the version 0.0.1. 

See also
Basics on faceplates (Page 3478)

Configuring a faceplate type  (Page 3485)

Configuring an event in the faceplate type (Page 3490)

Configuring a tag in the faceplate type (Page 3488)

Configuring scripts in the faceplate type (Page 3489)

Creating an instance of the faceplate type (Page 3498)

Editing the faceplate type (Page 3496)

Copy templates and types (Page 6811)

Configuring a graphics list in the faceplate type (Page 3494)

Configuring a text list in the faceplate type  (Page 3493)

Translating texts directly in the faceplate type (Page 3495)
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Editing the category and property of a faceplate type (Page 3487)

Removing faceplate object from faceplate (Page 3499)

Example: Configuring a faceplate (Page 3501)

Configuring an event in the faceplate type  (Page 3491)

Configuring a faceplate type 

Introduction
In the configuration area of the "Faceplates" editor you define which properties and process 
values of the objects contained in the faceplate can be configured in the "Properties" tab. 

Requirement
● The faceplate is generated and is displayed in the "Faceplate" editor.

● The "Properties" tab is open in the configuration area.

Procedure
1. To create a new property, click the "Add property"  button in the interface list.

A new property is displayed in the "Interface" list.

2. To create a new category, click the "Add category"  button in the interface list.
A new category including a new property is displayed in the "Interface" list.

3. Click the name of the property and assign a name, for example, "Color".

4. Select the data type.

Interim result
You have created a new property.

1. Click an object in the "Contained objects" list.

2. Select a property, e.g. "Appearance > Background color".
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3. Move the property from the "Contained objects" list to the desired property in the "Interface" 
list by drag&drop.
The connection is displayed as a colored line.
The system assigns the same data type to the property in the "Interface" list as that of the 
property in the "Contained objects" list.
To change the data type, select the data type from the data types of the connected property. 

4. Repeat step 3 to connect other properties of the contained properties with the interface.
 

  Note

The property from the "Contained objects" list must be in concordance with the data type 
of the already connected property of the "Interface" list.

 

Deleting a connection     
1. Click the connection that you wish to delete.

2. In the shortcut menu select the "Delete" command or use the <DEL> key.
The connection is deleted.

Result
You have created a new property or a new category with a property. You have connected the 
property of the interface with a property of the contained objects. If you use an instance of the 
faceplate type in a screen, you configure the properties of the faceplate which you have created 
in the "Interface" list. 
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 Note
Device dependency of static properties

Static properties are only available for panels and RT Advanced. You work with dynamic 
properties in RT Professional.

 

See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Editing the category and property of a faceplate type

Deleting a property in the "Interface" list   
1. Select "Edit faceplate" in the shortcut menu. The "Faceplates" editor is open.

2. Select the property which you want to delete in the "Interface" list.

3. Select "Delete" in the shortcut menu.

The property is deleted from the "Interface" list. Existing connections to the contained objects 
are deleted. All linked faceplates lose their instance-specific property.

Deleting a category in the "Interface" list   
1. Select "Edit faceplate" in the shortcut menu. The "Faceplates" editor is open.

2. Select the category which you want to delete in the "Interface" list.

3. Select "Delete" in the shortcut menu.

The category including the properties is deleted from the "Interface" list. Existing connections 
to the contained objects are deleted. All linked faceplates lose their instance-specific properties.

Moving a property to another category
1. Select a property in the "Interface" list.

2. Move the property to a new category by "drag&drop".

You have moved the property to a new category.

Changing the data type of a property
1. Select a property in the "Interface" list.

2. Click the second column of the drop-down list.

3. Select a data type.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
System Manual, 02/2014 3487



You have changed the data type of the property in the "Interface" list.

See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Configuring a tag in the faceplate type

Introduction
You connect a tag in the faceplate type directly with the properties of the objects contained in 
the faceplate type. The tags in the faceplate type are a central means of defining dynamic 
properties in the faceplate type.

The tags of a faceplate type have limited functionality. The "Tags" tab of the configuration area 
has the same structure as the "Tags" editor.

Array elements for faceplates
In the following situations you may not assign an array element or a multiplex tag that is 
interconnected with a faceplate to the property of a screen object.  

● The property is configured in a faceplate as parameter of a system function.

● System functions or scripts are assigned in the faceplate to events of the property.

Requirements
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Tags" tab is open in the configuration area.

Procedure
1. Click "Add" in the "HMI tags" table. A new tag is created in the faceplate type.

2. Open "Properties > Events" in the inspector window if necessary. You configure the "Value 
change" event on the tag for example.

3. In the work area, select the object to which you want to assign this tag, e.g. an I/O field.

4. Select the tag in the inspector window of the I/O field "Properties > Properties > General > 
Process > Tag".

 

  Note

Only tags of the faceplate type are displayed in the object list in the "Faceplates" editor.
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Result
You have created a tag in the faceplate type. You are using the tag in the faceplate for scripting, 
for example.

See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Configuring scripts in the faceplate type

Introduction
In the configuration area of the "Faceplates" editor you create scripts which you only use within 
a faceplate type. You can only refer to tags of the faceplate type or properties of the contained 
objects within the script. The script is used as a copy in the instance of the faceplate type. 

Requirement
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● Faceplate tags or dynamic properties have been created.

Procedure
1. Click the "Scripts" tab in the configuration area of the faceplate.

2. Double click "Faceplate scripts > Add VB script".

3. Write the program code.

4. Press the shortcut keys <CTRL+J> to Include tags of the faceplate type in the script. The 
object list opens.

5. Click "HMI tags".
All tags of the faceplate type are displayed in the object list.

6. Select a tag and confirm the selection.

7. Press the shortcut keys <CTRL+J> to use properties of the faceplate type in the script. The 
object list opens.

8. Click "Properties".
All dynamic properties of the "Interface" list for the faceplate type are displayed in the object 
list.

Result
You have created a script in the faceplate type. The instance of the faceplate type uses a copy 
of the script. The script is executed in runtime depending on the configuration. 
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See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Configuring an event in the faceplate type

Introduction
In the configuration area of the "Faceplates" editor you define which events of the objects 
contained in the faceplate can be configured in the "Events" tab. You configure a function list 
on the events of the faceplate in the "Screens" editor.

Requirement
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Events" tab of the configuration area is open.

Procedure
1. Click an object in the "Contained objects" list.

2. Select an event, e.g. "Activate".

3. Move the event from the "Contained objects" list to a new category in the "Interface" list.
The new event is displayed in the "Interface" list.
The connection appears as a colored line.

4. Double-click the event and, if required, change the name of the event.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3490 System Manual, 02/2014



Result
You have created an event in the faceplate type. if you use an instance of the faceplate type, 
you will only be offered the configured events in the inspector window. You configure a function 
list on the event in the faceplate. 

See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Configuring an event in the faceplate type 

Introduction
In the configuration area of the "Faceplates" editor you define which events of the objects 
contained in the faceplate can be configured in the "Events" tab. You configure a function list 
on the events of the faceplate in the "Screens" editor.

Requirement
● The faceplate type is created and is displayed in the "Faceplates" editor.

● The "Events" tab of the configuration area is open.

Procedure
1. Click an object in the "Contained objects" list.

2. Select an event, e.g. "Activate".
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3. Move the event from the "Contained objects" list to a new category in the "Interface" list.
The new event is displayed in the "Interface" list.
The connection appears as a colored line.

4. Double-click the event and, if required, change the name of the event.

Result
You have created an event in the faceplate type. If you use an instance of the faceplate type, 
you will only be offered all default settings for events in the inspector window. In the faceplate 
you configure a function list or a VB-script or C-script on the event. 

See also
Example: Configuring a faceplate (Page 3501)

Creating a faceplate type (Page 3483)
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Configuring a text list in the faceplate type 

Introduction
In a faceplate type, you connect a text list with an object included in the faceplate type. Text 
is assigned to the values of a tag in a text list. The text list is used, for example, to display a 
selection list in a symbolic I/O field contained in the faceplate type. The interface between the 
text list and a tag of the faceplate type is configured at the object that uses the text list.

Requirements
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Text list" tab is open in the configuration range.

● A tag has been created in the faceplate type.

Procedure
1. Click "Add" in the "Text lists" table. A new text list is created in the faceplate type.

2. Assign a name to the text list that indicates its function.

3. Select the text list type, e.g. "Value/Range" under "Select".

4. Click "Add" in the "Text list entries" table.

5. Define the values or range of values for the text list.

6. Enter a text for every value range which is displayed in Runtime when the tag is within the 
specified value range.

7. Select an object, for example a button in the work area of the faceplate type.

8. In the Inspector window of the object, enable "Properties > Properties > General > Label > 
Text list".

9. Select the "Text list" from the selection list.

10.Select a tag of the faceplate type under "Process > Tag".

Result
You have created a text list in the faceplate type. This text list is linked to an object contained 
in the faceplate type. You have configured a faceplate type tag at the object. 

See also
Creating a text list (Page 3397)

Basics on text lists (Page 3396)

Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)
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Configuring a graphics list in the faceplate type

Introduction
In a graphics list, specific graphics are assigned to possible values of a tag. In a faceplate type, 
you connect a graphics list with an object included in the faceplate type. Graphics are assigned 
to the values of a tag in a graphics list. For example, the graphics list is used to display a 
selection list in a graphic I/O field contained in the faceplate type. The interface between the 
graphics list and a tag of the faceplate type is configured at the object that uses the graphics 
list.

Requirements
● The library view is open.

● The faceplate type is created and has the "in progress" status.

● The "Graphics list" tab is open in the configuration range.

● A tag has been created in the faceplate type.

Procedure
1. Click "Add" in the "Graphics lists" table. A new graphics list is created in the faceplate type.

2. Assign a functional name to the graphics list.

3. Select a graphics list type, e.g. "Range (... - ...)", under "Selection".

4. Click "Add" in the "Graphics list entries" table. A new entry is created in the list.

5. Define the values or range of values for the graphics list.

6. Select a graphic for every value or value range which is displayed in runtime when the tag 
is within the specified value range.

7. Select an object, e.g. a graphic I/O field, in the work area of the faceplate type.

8. Activate "Properties > Properties > General > Contents > Graphics list" in the object's 
Inspector window.

9. Select the "Graphics list" from the selection list.

10.Select a tag of the faceplate type in "Process > Tag".

Result
You have created a graphics list in the faceplate type. This graphics list is linked to an object 
contained in the faceplate type. You have configured a faceplate type tag at the object.

See also
Creating a graphics list (Page 3408)

Basic principles of graphics lists (Page 3406)
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Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Translating texts directly in the faceplate type

Translating texts   
If you use several languages in your project, you can translate individual texts directly. As soon 
as you change the language of the software user interface, the translated texts are available 
in the selected language.

Requirements
● A project is open.

● You have opened the "Faceplates" editor.

● You have created a faceplate type.

● The faceplate type contains at least one object with text, e.g. a text field.

Procedure
Proceed as follows to translate individual texts:

1. Open the "Tasks" task card.

2. Click the  button under "Languages & Resources > Editing language". The "Project 
languages" editor opens.

3. Activate at least two project languages.

4. Open the "Texts" tab in the "Faceplates" editor.
A list with the texts in the project is displayed in the work area. There is a separate column 
for each project language.

5. Click on the  button in the toolbar to group identical texts together.

6. To hide texts that do not have a translation, click on the  button in the toolbar.

7. Click on an empty column and enter the translation.
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Result
You have translated individual texts in the "Texts" tab of the faceplate type. The texts will then 
be displayed in the runtime language.

See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Editing the faceplate type

Introduction   
All faceplate types in the project library have a status. You create a faceplate type in the "in 
progress" status. You can edit the faceplate types as required in this status. When editing is 
complete, release the faceplate type.

Requirement
● A faceplate type has been created.

● The faceplate type has the version 0.0.1. and the status "in progress".

● The "Library" task card or the library view is open.

Enable faceplate type   
1. Select version 0.01 of the faceplate type in the project library.

2. Select "Enable faceplate type" in the shortcut menu.

You have released version 0.0.1 of the faceplate type.

Edit faceplate type  
1. Select, for example, the released version 0.0.1 of a faceplate type in the project library.

2. Select "Edit faceplate type" in the shortcut menu. 

The library view opens. The new version 0.0.2 of the faceplate type has been created.

The faceplate type has the "In progress" status. 

Restoring the last version of the faceplate type
The last released version of the faceplate type is version 0.0.2. 

Edit the faceplate type. A new version 0.0.3 is created and the "in progress" status is assigned 
to it.
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1. Select the faceplate type from the project library.

2. Select "Discard changes and restore type" in the shortcut menu.

All changes to the faceplate type since the last enabling operation are rejected. The faceplate 
type is enabled again and has the version 0.0.2. 

See also
Creating a faceplate type (Page 3483)

Resizing a faceplate

Introduction
In the faceplate type, specify the response of the faceplate when it is resized.        

Requirements
● A faceplate type has been created.

● You have opened the "Faceplates" editor.

● The Inspector window is open.

Specifying the response to resizing
1. Activate "Properties > Properties > Layout > Fit to size > Auto-size."

2. Select the "Fixed aspect ratio" setting, for example.
This setting retains the aspect ratio when you resize the faceplate.

3. Click the faceplate in the "Libraries" task card.

4. Select "Enable faceplate type" in the shortcut menu.

Result
You have specified how the faceplate responds when its size in a screen is changed. You can 
change the response for a particular faceplate. 

Select a faceplate in the screen. Select the required setting in "Properties > Properties > Layout 
> Characteristics" in the Inspector window. 
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Creating an instance of the faceplate type

Introduction
The faceplate type is stored in the project library. If you use the faceplate type in a screen, you 
create an instance of the faceplate type.       

 

 Note

Note that a faceplate is always configured for a particular class of HMI devices. For example, 
you cannot use a faceplate type that is configured for "RT Professional" in a screen on an 
"RT Advanced" HMI device.

 

 
 

 Note

The number of faceplate instances per screen is not limited. However, you should be aware 
of the fact that the number of faceplate instances used, or the use of scripts in the faceplate 
instances, will have an impact on performance.

 

Requirement
● A screen is open.

● The "Libraries" task card is opened.

● The project library is open and it contains at least one faceplate type.
 

  Note

Faceplate types are also stored in global libraries. When you add a faceplate type from 
the global library to the screen, the system automatically saves a copy of it to the project 
library.

 

● The Inspector window is open.

Procedure
1. Move the desired faceplate type from a library to the screen by drag&drop.

Result
You have created an instance of the faceplate type. The instance is given the version number 
of the most recently released type.

Configure the properties of the faceplate in the Inspector window as required. To dynamize 
the faceplate, open the interface in the Inspector window.
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See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)

Removing faceplate object from faceplate

Introduction
Cancel application, to remove specified instances from the update of the faceplate type. 

Requirement
● A faceplate type has been created.

● The faceplate must be used in a minimum of one screen.

Disconnect the faceplate object from faceplate type.    
1. Select a faceplate on the screen.

2. In the shortcut menu, select "Disconnect faceplate object from faceplate type".

Result
The faceplate is independent of the associated faceplate type. Changes to the faceplate type 
are not updated in the faceplate. 

See also
Creating a faceplate type (Page 3483)

Example: Configuring a faceplate (Page 3501)
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10.1.7.5 Dynamizing faceplates

Basics of dynamizing faceplates

Application
You can dynamically control events and properties of faceplates in two ways:   

● Dynamically controlling faceplates
You configure the events or dynamic properties individually for the application point on the 
faceplate. To do this, define in the "Faceplates" editor that these properties and events are 
configurable in the faceplate. To dynamize the faceplates in the "Screens" editor, use the 
scripts and tags that are created in the project. 

● Dynamizing the faceplate type 
You dynamize the objects which are contained in the faceplate type in the "Faceplates" 
editor. You configure the individual objects as in the "Screens" editor. Tags and scripts are 
available in the "Faceplates" editor to dynamize properties and events. You do not have 
access to the tags and scripts of the project within the faceplate. 
Every faceplate created with the faceplate type has the same preconfigured dynamization. 
You can edit this dynamic control only in the "Faceplates" editor. 

Animation
WinCC provides preconfigured dynamic control in the "Animations" task card. You use 
animations to dynamize faceplates and faceplate types. 

See also
Dynamizing faceplates (Page 3500)

Basics on faceplates (Page 3478)

Example: Configuring a faceplate (Page 3501)

Dynamizing faceplates

Introduction   
You dynamize a faceplate in exactly the same way as you dynamize an object from the "Tools" 
task card. 

You connect the dynamic properties of the faceplate in the "Screens" editior with a tag or a 
script which supplies values to the property in runtime.

You Include tags and scripts which you have created in the project for the faceplate.
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Requirement
● A faceplate is inserted in the screen.

Procedure
1. Select the faceplate.

2. In the Inspector window, open "Properties > Animation".
The animations available for the selected object are displayed. 

3. Select "Horizontal movement" and click the  button.
The parameters of the animation are displayed.
A transparent copy of the object is shown in the work area, which is connected to the source 
object by means of an arrow.

4. Select a tag for control of movement.

5. Move the object copy to the relevant destination. The system automatically enters the pixel 
values of the final position in the Inspector window.

6. Customize the range of values for the tag as required.

Result
In Runtime, the object moves in response to every change in value of the tag that is used to 
control the movement. The direction of movement corresponds to the configured type of 
movement "horizontal".

See also
Basics of dynamizing faceplates (Page 3500)

Example: Configuring a faceplate (Page 3501)

10.1.7.6 Example: Creating and dynamically controlling faceplates

Example: Configuring a faceplate

Introduction
In this example you create a faceplate in which you can convert the value of a length measuring 
system from kilometers into meters. The length in meters is displayed in an output field.  

Procedures overview
The example is divided into the following steps:

1. Creating a faceplate type

2. Configuring a faceplate type

3. Creating a script in the faceplate type
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4. Connecting a script with the contained objects of the faceplate type

5. Creating a faceplate and connecting with a tag

See also
Example: Creating a faceplate type (Page 3502)

Example: Configuring a faceplate type (Page 3503)

Example: Creating a script in the faceplate type (Page 3504)

Example: Creating an instance of the faceplate type (Page 3506)

Example: Configuring included objects (Page 3507)

Basics on faceplates (Page 3478)

Example: Creating a faceplate type

Task
You create a faceplate type.   

Requirement
● A screen is open.

● The toolbox window is displayed.

Settings
For the example you require objects with the following settings:

Object Object name Properties
Text field Label_Meter Text: Meter
I/O field Output_Meter Mode: Output
Button KM_to_Meter Text OFF: Convert

Procedure
1. In the toolbox, click the individual objects and drag&drop the objects into the screen.

2. Set the properties as shown above.

3. Select all objects.

4. Select the "Create faceplate type" command in the shortcut menu of the multiple selection.
The library view opens.

5. In the Inspector window, click "Properties > Properties > Miscellaneous".

6. Enter "KMtoMeter" as the name.
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Result
The faceplate types appears in the project library under the name "KMtoMeter". The faceplate 
type is assigned the "in progress" status.

See also
Example: Configuring a faceplate (Page 3501)

Example: Configuring a faceplate type

Job
You create the dynamic property and tag of the faceplate type.  

Creating a new property
1. Click "Properties" in the configuration area of the faceplate.

2. In the "Interface" list, click the  icon "Add property".
A new property is added to the "Interface" list.

3. Double click the name of the property and enter "KMToMeter".

4. Click the selection list and select the data type "Int".

Interim result
The "KMToMeter" property is displayed in the "Interface" list. The symbol identifies the dynamic 
property. The property will be linked to a tag in the next step.

Creating a tag in the faceplate type   
1. Click "Tags" in the configuration area.

2. Click "Add" in the "HMI tags" table. A new tag is added to the table. The inspector window 
of the tag is opened.

3. In the Inspector window, select "Properties > Properties > General":

4. Enter "BB_Tag" as the name. Select the "Int" data type.
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Result
The "KMToMeter" property and the "BB_Tag" of the faceplate type are created in the 
configuration area of the "Faceplates" editor.

See also
Example: Configuring a faceplate (Page 3501)

Example: Creating a script in the faceplate type

Task
You create a script that converts the value of a length measuring system from kilometers to 
meters.  

Procedure
1. Click "Scripts > Faceplate scripts" in the configuration area.

2. Double click "Add VB script".

3. Press the shortcut keys <CTRL+J>.
The object list opens. 

4. Click "HMI tags".
The faceplate tag "BB_Tag" is displayed in the object list.

5. Select the faceplate type tag "BB_Tag". Confirm the selection.

6. Insert an "=" sign.

7. Press the shortcut keys <CTRL+J>. The object list is opened.
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8. Click "Properties."
The dynamic property "KMtoMeter" is displayed in the object list.

9. Select the "KMToMeter" dynamic property. Confirm the selection.

10.Enter "*1000" at the end of the code. This corresponds to the conversion factor from 
kilometers to meters.

11.Enter the name "Script_1" under "Properties > Properties > General >Setting > Name" in 
the Inspector window.

Result
The script has been created in the faceplate type. If you use the "KMtoMeter" faceplate type 
in a screen, you assign a tag to the "KMtoMeter" property. The value of this tag is multiplied 
by factor 1000 and assigned to the tag of the faceplate type "BB_Tag" as a new value. In this 
way you supply values to the tags of the faceplate type. 

See also
Example: Configuring a faceplate (Page 3501)
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Example: Creating an instance of the faceplate type

Task
You insert the faceplate type "KMtoMeter" in a screen and assign a tag to the dynamic property 
"KMtoMeter".

Requirement
● The "Screens" editor is open.

● A new screen has been created.

Settings
For the example you require a tag with the following settings:

Name PLC connection Type
Kilometer No ULong

Procedure
1. Create the HMI tag "Kilometer" with the settings named above.

2. Open the  "project library" in the "Libraries" task card.

3. Move the "KMtoMeter" faceplate type into the screen by drag&drop.

4. Click "Properties > Properties > Interface" in the Inspector window.
The table shows all the properties which you can dynamize in the faceplate.

5. Click the "Dynamization" column in the "KMtoMeter" line.

6. Select "HMI tag".

7. Click the "..." button.
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8. Select the tag "Kilometer" from the object list.

9. Confirm the selection.

Result
The dynamic property "KMtoMeter" is linked with the "Kilometer" tag. During runtime the 
dynamic property is supplied with values of the "Kilometer" tag. The values are multiplied by 
factor 1000 in the script of the faceplate type and assigned to the tag in the faceplate as a new 
value.

See also
Example: Configuring a faceplate (Page 3501)

Example: Configuring included objects

Task
You connect the included objects in the faceplate "KMtoMeter" to a faceplate tag and a 
faceplate script. 

You connect the I/O field with the "BB_Var" tag of the faceplate type. You connect the "Click" 
event for a button to the script "Script_1".  

Requirement
The faceplate is displayed in the "Faceplates" editor.

Interconnecting I/O field with a tag
1. Select the "Output_Meter" I/O field in the faceplate.

2. Connect the I/O field with the faceplate tag "BB_Tag" in the "General > Process > Tag" 
inspector window.

Connecting an event to a faceplate script
1. Select the "KM_to_Meter" button in the faceplate.

2. Select "Script_1" in the inspector window under "Events > Click".

Result
The I/O field is connected with the tag of the faceplate type. The button is connected with the 
script of the faceplate type. 

If you click the button of the faceplate during runtime, the script is executed. The value of the 
tag of the faceplate is output in the I/O field. 
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See also
Example: Configuring a faceplate (Page 3501)

10.1.8 Display and Control Objects

10.1.8.1 Device-Specific Nature of the Objects

Objects for Basic Panels

Availability of display and operating objects for Basic Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and operating objects for 
the Basic Panels. 

Overview

 KP300 Basic
KP400 Basic

KTP400 Basic
KTP600 Basic
KTP1000 Basic
TP1500 Basic

KTP700 Basic
KTP900 Basic

Bar Yes Yes Yes
User view Yes Yes Yes1)

Date/time field Yes Yes Yes
I/O field Yes Yes Yes
Ellipse Yes Yes Yes
Graphic view Yes Yes Yes
Graphic I/O field Yes Yes Yes
Help indicator Yes No No
Circle Yes Yes Yes
Trend view Yes Yes Yes1)

Line Yes Yes Yes
Alarm view
Alarm window

Yes Yes Yes1)

Alarm indicator Yes Yes Yes
Rectangle Yes Yes Yes
Recipe view Yes Yes Yes1)

Button Yes Yes Yes
Switch Yes Yes Yes
Symbolic I/O field Yes Yes Yes
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 KP300 Basic
KP400 Basic

KTP400 Basic
KTP600 Basic
KTP1000 Basic
TP1500 Basic

KTP700 Basic
KTP900 Basic

System diagnostics view Yes Yes Yes1)

Text field Yes Yes Yes

1) The objects are displayed on the panels as table-based objects.

See also
Objects for Comfort Panels (Page 3511)

Objects for Multi Panels (Page 3512)

Objects for Mobile Panels (Page 3514)

Objects for WinCC Runtime Advanced (Page 3515)

Objects for WinCC Runtime Professional (Page 3517)

Objects for Panels (Page 3509)

Objects for Panels

Availability of display and operating objects for Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and operating objects for 
the Panels. 

Overview

 OP 73 OP 77A
OP 77B

TP 177A TP 177B
OP 177B

TP 277
OP 277

Bar Yes Yes Yes Yes Yes
User view Simple Simple Simple Yes Yes
Date/time field Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes
Ellipse No No Yes Yes Yes
f(x) trend view No No No No No
Function key only on keyboard units
Graphic view Yes Yes Yes Yes Yes
Graphic I/O field Yes 1) Yes 1) Yes 1) Yes Yes
Handwheel No No No No No
Help indicator Yes No No No No
HTML browser No No No No No
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 OP 73 OP 77A
OP 77B

TP 177A TP 177B
OP 177B

TP 277
OP 277

Circle No No Yes Yes Yes
Trend view No No Yes Yes Yes
Charging condition No No No No No
Illuminated pushbutton No No No No No
Line No No Yes Yes Yes
Media Player No No No No No
Alarm view
Alarm window

Simple Simple Simple Yes Yes

Alarm indicator Simple No Simple Yes Yes
Polygon No No No Yes Yes
Polyline No No No Yes Yes
Rectangle No No Yes Yes Yes
Recipe view No Simple Simple Yes Yes
Button Yes Yes Yes Yes Yes
Switch Yes 2) Yes 2) Yes 2) Yes Yes
Slider No No No Yes Yes
Key switch No No No No No
Sm@rtClient view No No No Yes Yes
Status/Force No No No Yes Yes
Symbol library No No No Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes
System diagnostics view No No No No No
System diagnostics 
window

No No No No No

Text field Yes Yes Yes Yes Yes
Clock No No No No No
Effective range signal No No No No No
Effective range name No No No No No
Effective range name 
(RFID)

No No No No No

WLAN reception No No No No No
Gauge No No Yes Yes Yes
Zone name No No No No No
Zone signal No No No No No

1) Only two different graphics can be used.
2) Only the "Switch with text" and "Switch with graphic" types can be used.

See also
Objects for Basic Panels (Page 3508)
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Objects for Comfort Panels

Availability of display and operating elements for Comfort Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects on 
Comfort Panels. 

Overview

 KP400 Comfort
KTP400 Comfort

KP700 Comfort
TP700 Comfort

KP900 Comfort
TP900 Comfort

KP1200 
Comfort
TP1200 
Comfort

TP1900 Comfort
TP2200 Comfort

Bar Yes Yes Yes Yes Yes
User view Yes Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes Yes
f(x) trend view Yes Yes Yes Yes Yes
Function key only on keyboard units  
Graphic view Yes Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes Yes
Handwheel No No No No No
Help indicator No No No No No
HTML browser No No No No No
Circle Yes Yes Yes Yes Yes
Trend view Yes Yes Yes Yes Yes
Charging condition No No No No No
Illuminated pushbutton No No No No No
Line Yes Yes Yes Yes Yes
Media Player Yes Yes Yes Yes Yes
Alarm view 
alarm window

Yes Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes Yes
Polygon Yes Yes Yes Yes Yes
Polyline Yes Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes Yes
Button Yes Yes Yes Yes Yes
Switch Yes Yes Yes Yes Yes
Slider Yes Yes Yes Yes Yes
KeySwitch No) No No No No
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 KP400 Comfort
KTP400 Comfort

KP700 Comfort
TP700 Comfort

KP900 Comfort
TP900 Comfort

KP1200 
Comfort
TP1200 
Comfort

TP1900 Comfort
TP2200 Comfort

Sm@rtClient view Yes Yes Yes Yes Yes
Status/Force Yes Yes Yes Yes Yes
Symbol library Yes Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes
System diagnostics view Yes Yes Yes Yes Yes
System diagnostics 
window

Yes Yes Yes Yes Yes

Text field Yes Yes Yes Yes Yes
Clock Yes Yes Yes Yes Yes
Effective range signal No No No No No
Effective range name No No No No No
Effective range name 
(RFID)

No No No No No

WLAN reception No No No Yes Yes
Gauge Yes Yes Yes Yes Yes
Zone name No No No No No
Zone signal No No No No No

 

 

See also
Objects for Basic Panels (Page 3508)

Objects for Multi Panels

Availability of display and operating elements for Multi Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Multi Panels. 

Overview

 MP 177 MP 277 MP 377
Bar Yes Yes Yes
User view Yes Yes Yes
Date/time field Yes Yes Yes
I/O field Yes Yes Yes
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 MP 177 MP 277 MP 377
Ellipse Yes Yes Yes
f(x) trend view No No No
Function key only on keyboard units
Graphic view Yes Yes Yes
Graphic I/O field Yes Yes Yes
Handwheel No No No
Help indicator No No No
HTML browser No No No
Circle Yes Yes Yes
Trend view Yes Yes Yes
Charging condition No No No
Illuminated pushbutton No No No
Line Yes Yes Yes
Media Player No No Yes
Alarm view, 
Alarm window

Yes Yes Yes

Alarm indicator Yes Yes Yes
Polygon Yes Yes Yes
Polyline Yes Yes Yes
Rectangle Yes Yes Yes
Recipe view Yes Yes Yes
Button Yes Yes Yes
Switch Yes Yes Yes
Slider Yes Yes Yes
Key switch No No No
Sm@rtClient view Yes Yes Yes
Status/Force Yes Yes Yes
Symbol library Yes Yes Yes
Symbolic I/O field Yes Yes Yes
System diagnostics display No No No
System diagnostics window No No No
Text field Yes Yes Yes
Clock Yes Yes Yes
Effective range signal No No No
Effective range name No No No
Effective range name (RFID) No No No
WLAN reception No No No
Gauge Yes Yes Yes
Zone name No No No
Zone signal No No No
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See also
Objects for Basic Panels (Page 3508)

Objects for Mobile Panels

Availability of display and operating elements for Mobile Panels           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
the Mobile Panels. 

Overview

 Mobile Panel 
177 DP

Mobile Panel 
177 PN

Mobile Panel 
277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN 
V2

Mobile Panel 
277F IWLAN 
(RFID Tag)

Bar Yes Yes Yes Yes Yes Yes
User view Yes Yes Yes Yes Yes Yes
Date/time field Yes Yes Yes Yes Yes Yes
I/O field Yes Yes Yes Yes Yes Yes
Ellipse Yes Yes Yes Yes Yes Yes
f(x) trend view No No No No No No
Function key Yes Yes Yes Yes Yes Yes
Graphic view Yes Yes Yes Yes Yes Yes
Graphic I/O field Yes Yes Yes Yes Yes Yes
Handwheel Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Help indicator No No No No No No
HTML browser No No No No No No
Circle Yes Yes Yes Yes Yes Yes
Trend view Yes Yes Yes Yes Yes Yes
Charging condition No No No Yes Yes Yes
Illuminated pushbutton Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Line Yes Yes Yes Yes Yes Yes
Media Player No No No No No No
Alarm view, 
Alarm window

Yes Yes Yes Yes Yes Yes

Alarm indicator Yes Yes Yes Yes Yes Yes
Polygon Yes Yes Yes Yes Yes Yes
Polyline Yes Yes Yes Yes Yes Yes
Rectangle Yes Yes Yes Yes Yes Yes
Recipe view Yes Yes Yes Yes Yes Yes
Button Yes Yes Yes Yes Yes Yes
Switch Yes Yes Yes Yes Yes Yes
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 Mobile Panel 
177 DP

Mobile Panel 
177 PN

Mobile Panel 
277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN 
V2

Mobile Panel 
277F IWLAN 
(RFID Tag)

Slider Yes Yes Yes Yes Yes Yes
Key switch Yes 1) Yes 1) Yes 1) Yes 1) Yes 1) Yes 1)

Sm@rtClient view No Yes Yes Yes Yes Yes
Status/Force Yes Yes Yes Yes Yes Yes
Symbol library Yes Yes Yes Yes Yes Yes
Symbolic I/O field Yes Yes Yes Yes Yes Yes
System diagnostics 
display

No No No No No No

System diagnostics 
window

No No No No No No

Text field Yes Yes Yes Yes Yes Yes
Clock No No Yes Yes Yes Yes
Effective range signal No No No No Yes Yes
Effective range name No No No No Yes No
Effective range name 
(RFID)

No No No No No Yes

WLAN reception No No No Yes Yes Yes
Gauge Yes Yes Yes Yes Yes Yes
Zone name No No No Yes Yes No
Zone signal No No No Yes Yes No
1) optional operator control

 

 

See also
Objects for Basic Panels (Page 3508)

Objects for WinCC Runtime Advanced

Availability of display and operating elements for WinCC Runtime Advanced           
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following table shows the availability of indicator and control objects for 
WinCC Runtime Advanced. 
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Overview

 WinCC Runtime Advanced
Bar Yes
User view Yes
Date/time field Yes
I/O field Yes
Ellipse Yes
f(x) trend view Yes
Function key No
Graphic view Yes
Graphic I/O field Yes
Handwheel No
Help indicator No
HTML browser Yes
Circle Yes
Trend view Yes
Charging condition No
Illuminated pushbutton No
Line Yes
Media Player No
Alarm view, 
Alarm window

Yes

Alarm indicator Yes
Polygon Yes
Polyline Yes
Rectangle Yes
Recipe view Yes
Switch Yes
Button Yes
Slider Yes
Key switch No
Sm@rtClient view Yes
Status/Force Yes
Symbol library Yes
Symbolic I/O field Yes
System diagnostics display Yes
System diagnostics window Yes
Text field Yes
Clock Yes
Effective range signal No
Effective range name No
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 WinCC Runtime Advanced
Effective range name 
(RFID)

No

WLAN reception No
Gauge Yes
Zone name No
Zone signal No

See also
Objects for Basic Panels (Page 3508)

Objects for WinCC Runtime Professional

Availability of display and operating objects       
Only the objects which can be used for the device you are configuring will be shown in the 
object window. The following tables show the availability of indicator and operating objects for 
WinCC Runtime Professional.

Overview

Table 10-2 WinCC Runtime Professional

 WinCC Runtime Professional
Bar Yes
User view Yes
Screen window Yes
Scroll bar Yes
Date/time field No
Double T-piece Yes
Print job/Script diagnostics Yes
I/O field Yes
Editable text field Yes
Ellipse Yes
Ellipse arc Yes
Ellipse segment Yes
Function key No
f(x) trend view Yes
f(t) trend view Yes
Graphic view Yes
Graphic I/O field Yes
HTML browser Yes
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 WinCC Runtime Professional
Channel diagnostics Yes
Combo box Yes
Check box Yes
Circle Yes
Circular arc Yes
Circle segment Yes
Trend view No
Charging condition No
Illuminated pushbutton No
Line Yes
List box Yes
Media Player Yes
Alarm view
Alarm window

Yes

Alarm indicator No
Option button Yes
PLC code display Yes
Polygon Yes
Polyline Yes
Rectangle Yes
Recipe view Yes
Round button Yes
Pipe Yes
Pipe bends Yes
S7-GRAPH Overview Yes
Switch No
Button Yes
Slider Yes
Sm@rtClient view No
Disk space view Yes
Status/Force No
Symbol library Yes
Symbolic I/O field Yes
System diagnostics view No
System diagnostics window No
Table view Yes
Text field Yes
T piece Yes
Clock Yes
Connector Yes
Value table Yes
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 WinCC Runtime Professional
Effective range name No
Effective range name (RFID) No
Effective range signal No
WLAN reception No
Gauge Yes
Zone name No
Zone signal No

See also
Objects for Basic Panels (Page 3508)

10.1.8.2 Objects

Bar

Application  
The tags are displayed graphically using the "Bar" object. The bar graph can be labeled with 
a scale of values.

Layout  
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Color transition: Specifies the change in color display when limit values are exceeded.

● Displaying the limit lines / limit markers: Shows the configured limit as a line or marker.

● Define bar segments: Defines the gradations on the bar scale.

● Define scale gradation: Defines the subdivisions, scale markings and intervals of a bar 
scale.

Color transition   
You define how the color change is represented in "Properties > Properties > Appearance" in 
the Inspector window.

Color transition Description
"Segmented" If a particular limit was reached, the bar changes color segment by segment. 

With segment by segment representation, you visualize, for example, which 
limits are exceeded by the displayed value.

"Entire bar" If a particular limit was reached, the entire bar changes color.
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Displaying limit lines and limit markers   
You display the configured limit in the bar as a line or marking in Runtime using the "Lines" 
and "Markings" property:

1. In the Inspector window, select "Properties > Properties > Appearance":

2. Activate "Lines" and "Markings".

Define bar segments  
Use the "Subdivisions" property to define the number of segments into which the bar is divided 
by the main gradations on the scale. 

Use the "Interval" property to divide the distance between the main gradations. The value 
appears as the difference in value between two adjacent main gradations:

1. In the Inspector window, select "Properties > Properties > Scales":

2. Activate "Show scale."

3. Select the corresponding value for "Settings > Subdivisions".

4. Select the corresponding value for "Settings > Marks label".

5. Select the corresponding value for "Large interval > Interval".

See also
Device-Specific Nature of the Objects (Page 3508)

Bar

Application  
The tags are displayed graphically using the "Bar" object. The bar graph can be labeled with 
a scale of values.
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Layout  
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Color transition: Specifies the change in color display when limit values are exceeded.

● Displaying the limit markers: Displays the configured limit value as an arrow.

● Define bar segments: Defines the gradations on the bar scale.

● Define scale gradation: Defines the position of the zero point on a bar scale.

Color transition   
You define how the color change is represented in "Properties > Properties > Appearance" in 
the Inspector window.

Color transition Description
"Segmented" If a particular limit was reached, the bar changes color segment by segment. 

With segment by segment representation, you visualize, for example, which 
limits are exceeded by the displayed value.

"Entire bar" If a particular limit was reached, the entire bar changes color.

Displaying the limit markers   
You display the configured limit in the bar as an arrow in Runtime using the "Selections" 
property:

1. In the Inspector window, select "Properties > Properties > Appearance":

2. Activate "Selections".

Define bar segments   
Use the "Scales" property to define the subdivisions into which the bar is divided by the main 
gradations on the scale. 

Use the "Interval" property to divide the distance between the main gradations. The value 
appears as the difference in value between two adjacent main gradations:

1. In the Inspector window, select "Properties > Properties > Scales":

2. Activate "Show scale."

3. Enter the corresponding value for "Large interval > Interval".
 

  Note

Intervals can only be changed if the "Auto-scale" option is disabled.
 

Define scale gradation   
Use the "Zero point" property to define the zero point on the bar graph scale. Enter the value 
as a percentage. The percentage relates to the distance between the end values on the scale. 
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For a value of 0 %, for example, the zero point is represented at the height of the lowest value 
on the scale. The zero point can also be outside the shown area.

The "Zero point" property is only evaluated if the "Bar scaling" property is set to "Auto-scale":

1. In the Inspector window, open "Properties > Properties > Scales"

2. Activate "Auto-size".

3. Enter the required value for "Start values .> Zero point".

See also
Device-Specific Nature of the Objects (Page 3508)

User view

Application 
The "User view" object is used to set up and administer users and authorizations. The user 
view is used, for example, to create new users in runtime and assign them to a user group.

 

 Note

Configure only one user view at a time in one screen on the HMI devices TP 177A 6", TP 
177A 6" (Portrait), OP 73 and OP 77A. Otherwise, a corresponding error message appears 
during generation. 

 

Complex user view   
The complex or simple user view is available for administration of users and authorizations 
depending on the HMI devices.
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Simple user view   

Proceed as follows to configure the appropriate user view:

1. Click "Properties > Properties > Layout > Mode" in the inspector window.

2. Select "Simple" or "Complex".

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Number of lines: Specifies the maximum number of visible entries.

● Columns moveable: Specifies whether the operator can change the sequence of columns 
in Runtime.

Number of lines  
The number of lines in the user view displayed in Runtime is specified in the Inspector window. 
The setting for the number of lines is only effective if "Fit object to contents" is active.

1. Click "Properties > Properties > View" in the Inspector window.

2. Enter an integer value under "Number of lines".

3. In the Inspector window, select "Properties > Properties > Layout".

4. Activate "Fit object to contents."

Columns moveable  
The operator can change the sequence of columns in Runtime with the "Columns movable" 
property.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Columns moveable".

This option is only available at the complex user view.
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See also
Device-Specific Nature of the Objects (Page 3508)

User view (Page 4403)

Creating users (Page 4388)

Managing users in the complex user view (Page 4406)

Screen window

Application
You use the "Screen window" object to represent other screens from the project in the current 
screen. You can make the object dynamic to constantly update the content of a screen window, 
for example. Customized menus and toolbars are used to add specific buttons to the screen 
window.

You can also use independent screen windows independently of the screen in question. With 
appropriate hardware equipment and support by the operating system you can also control 
multiple monitors and map processes in a more comprehensive and differentiated manner.

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Zoom factor: Defines the size of the embedded screen.

● Screen section: Defines the section of the embedded screen that is displayed in the screen 
window. If the embedded screen is larger than the screen window, you configure scroll bars 
for the screen window.

● Independent screen windows: Specified that the screen windows are displayed 
independently from the screen in which they were configured.

 

 Note
Cascading screen windows

Screen windows can also display screens which, in turn, contain screen windows. The ability 
to display cascaded screen windows in runtime depends on the operating system. In the 32-
bit version, 22 cascaded screen windows can be displayed. In the 64-bit version, 14 cascaded 
screen windows can be displayed.
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Matching the size of the embedded screen and screen window
You can match the size of the embedded screen to the size of the screen window in the 
following ways:

● You want the embedded screen to appear smaller.
Enter the required zoom factor under "Properties > Properties > General" in the Inspector 
window.

● You want to scroll to a section of the embedded screen.
In the Inspector window, activate "Properties > Properties > Layout > Scroll bar". 
The user can scroll to details of the embedded screen in Runtime.
You can move the position of the scroll bar horizontally or vertically under "Properties > 
Properties > Layout > Scroll bar position" in the Inspector window. 

● You can adapt the embedded screen to the size of the screen window, or vice versa.
Select either "Size window to screen", or "Size screen to window" in "Properties > Properties 
>" in the Inspector window.

Define screen section
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the values for the horizontal and vertical displacement of the zero point of the screen 
display under "Offset."
The desired section is displayed in the screen window.

3. If you want to scroll from the defined section to other areas of the screen, activate 
"Properties > Properties > Appearance > Scrollbar".

Defining independent screen windows
1. Insert a screen window in the start screen.

2. Select a screen that is displayed in the screen window under "Properties > Properties > 
General > Name".

3. Select "Properties > Properties > General > Independent screen windows".

4. Select "Position and mode":

– As configured: The screen window is displayed in the configured size and at the 
configured position.

– Centered: The screen window is displayed in the configured size in a central position.

– Maximized: The screen window is adjusted to the monitor size.

5. If you are using multiple monitors select the desired monitor for the screen window under 
"Monitor number".

 

  Note

The monitor numbers refer to the number of monitors set in Microsoft Windows: "Control 
Panel > Display > Settings > Display"

 

6. Repeat steps 1 to 5 for all further independent screen windows.
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Define tag prefix
Define a tag prefix to access structure instances in Runtime. The tag prefix is freely definable 
but must match the name of the structure instance.

1. Click "Properties > Properties > General > Contents" in the Inspector window.

2. Enter one of the created structure instances with a period after the name under "Tag prefix", 
e.g. "Motor1.".

The "Temperature" tag is requested on an object in the screen window. If a tag prefix "Motor1." 
is assigned to the screen window, the "Motor1.Temperature" tag is requested.

If the tag prefix for a screen window is set, the tag prefix is prefixed to all tags contained in the 
screen to be displayed. This also applies when the request is made in a function. if a tag or a 
tag prefix is to be read, you must prefix "@NOTP::" to the tag name.

 

 NOTICE

Availability of tag prefixes in indicator and control objects

The tag prefix property is only available for "slider" and "pointer instrument" objects.
 

See also
Device-Specific Nature of the Objects (Page 3508)

Scroll bar

Application
The "Scroll bar" object is used to control processes. The scroll bar allows you to make stepless 
changes to values, for example. To incorporate a scroll bar into the process, dynamize the 
corresponding attribute.

Layout
In the Inspector window, you customize the settings for the object position, style and color. 
You can, in particular, adapt the following properties as required:

● Maximum value and minimum value: Specifies the top and bottom values of the scale.

● Alignment: Defines the horizontal, or vertical alignment.
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Maximum value and minimum value
You define the top and bottom values of the scale in the Inspector window.

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a number under "Maximum static" and "Minimum static". If you select a tag as the 
end value of the scale, the number will be no longer available.

Define alignment
Define whether the scroll bar is aligned vertically or horizontally in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required alignment under "Style."

See also
Device-Specific Nature of the Objects (Page 3508)

Date/time field 

Use   
The "Date/time field" object shows the system time and the system date. The appearance of 
the "Date/time field" depends on the language set on the HMI device.

Layout   
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Display system time: Specifies that the system time is displayed.

● Include tag: Specifies that the time of the connected tag is displayed.

● Long date/time format: This setting defines the format displayed for the data and time.

Display system time     
The time displayed in the "Date/time field" on the HMI device is specified in the inspector 
window.

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "Format > System time".
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Using tags     
The time of the interconnected tag is displayed in the date/time field.

1. In the Inspector window, select "Properties > Properties > General".

2. In the "Format" area, select a tag with the "DateTime" data type, e.g. an internal tag.

Long date/time format     
Visualization of the date and time is specified in the "Format" area under "General" in the 
inspector window.

Option Description
"Enabled" Date and time are displayed in full, e.g. "Sunday, December 31, 2000 10:59:59 

AM"
"Disabled" Date and time are displayed in short form, e.g. "12/31/2000 10:59:59 AM"

See also
Device-Specific Nature of the Objects (Page 3508)

Double T-piece

Application
You use the "Double T-piece" to reproduce a pipe junction. To reproduce a pipe system, 
connect the "Double T-piece" to other objects, e.g. pipe bend or T piece. 

Layout
Customize the object position, color and width in the Inspector view. 

See also
Device-Specific Nature of the Objects (Page 3508)

Pipe (Page 3604)

Pipe bends (Page 3605)

T piece (Page 3635)
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Print job/Script diagnostics

Application   
You use the "Print job/Script diagnostics" object to show content from the "Print jobs" and 
"Scripts" editors. Information is transferred to the "Print job/Script diagnostics" object in runtime 
and to enable an operation. Depending on which windows content and which template you 
use, you can display a preview of the print job, for example.

Layout   
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Window content: Defines the application that is displayed in the "Print job/Script 
diagnostics" object.

● Template: Defines the template in which the window content is displayed in the "Print job/
Script diagnostics" object.
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Templates for using functions     
The following templates are available for functions:

● GSC diagnostics
The "Print job/Script diagnostics" object is supplied by applications of the functions. It 
displays the results from the diagnostic system.

Templates for using print jobs   
The following templates are available for the "Print jobs" window content: 

● All print jobs
The "Print job/Script diagnostics" object is supplied by the print jobs. The available print 
jobs are shown as a list.

● Shortcut menu for all jobs
The "Print job/Script diagnostics" object is supplied by the print jobs. The available print 
jobs are shown as a list. A shortcut menu offers the following actions:

– Print preview

– Print report

● Jobs detailed view
The "Print job/Script diagnostics" object is supplied by the print jobs. There is a menu for 
selecting the available print jobs. Detailed information is displayed for the selected print job.

● Shortcut menu for selected jobs.
The "Print job/Script diagnostics" object is supplied by the print jobs. The available print 
jobs are shown as a list. 
To display print jobs in the list, select "Properties > Properties > General > Display print job/
script diagnostics in Control" in the Print Job editor. A shortcut menu offers the following 
actions:

– Print preview

– Print report

Configure window content
You define the window content of the object in the Inspector window.

1. In the Inspector window, select "Properties > Properties > General".

2. Select the window content, e.g. "Print jobs".
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Configure template
You define the template for the window content of the object in the Inspector window:

1. In the Inspector window, select "Properties > Properties > General".

2. Select a template

Window layout in Runtime
In runtime, the "Print Job/Script Diagnostics" object appears as a standalone window within a 
process picture. Use the attributes under "Window display" to customize the window layout 
features.

See also
Device-Specific Nature of the Objects (Page 3508)
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I/O field

I/O field

Application   
The "I/O field" object is used to enter and display process values.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Display format: Specifies the display format in the I/O field for input and output of values.

● Hidden input: Specifies whether the input value is displayed normally or encrypted during 
input.

 

  Note
Reports

In reports, I/O fields only output data. "Output" mode is preset. Properties for configuring 
input are not available, e.g. "hidden input".

 

Mode     
The response of the I/O field is specified in the Inspector window in "Properties > Properties 
> General > Type".

Mode Description
"Input" Values can only be input into the I/O field in runtime.
"Input/output" Values can be input and output in the I/O field in runtime.
"Output" The I/O field is used for the output of values only.
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Layout   
The "display format" for the input and output of values is specified in "Properties > Properties 
> General > Format" in the Inspector window.

Layout  
"Binary" Input and output of values in binary form
"Date" Input and output of date information. The format depends on the language setting 

on the HMI device.
"Date/time" Input and output of date and time information. The format depends on the 

language setting on the HMI device.
"Decimal" Input and output of values in decimal form
"Hexadecimal" Input and output of values in hexadecimal form
"Time" Input and output of times. The format depends on the language setting on the HMI 

device.
"Character string" Input and output of character strings.

 

 Note
Data formats

Not all data formats are available for selection for Runtime Professional.
 

Hidden input     
In Runtime the input can be displayed normally or encrypted, for example for hidden input of 
a password. A "*" is displayed for every character during hidden input. The data format of the 
value entered cannot be recognized. 

1. In the Inspector window, select "Properties > Properties > Response":

2. Activate "Hidden input".

Avoid overlaps in output fields
If several I/O fields are configured as output fields with a transparent background in a screen, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems in Runtime. In order to avoid such overlaps, set the 
margins of the I/O fields to zero in the object properties under "Properties > Properties > 
Appearance". Activate "Properties > Properties > Layout > Fit object to contents."

Limits
Under "Properties > Properties > Limits" in the Inspector window, set the colors for the values 
that violate the high or low limits.
You define the limits via the properties of a tag. 
In Runtime Professional, you can also define the limit range for the entry in the I/O field via 
"Properties > Properties > Limits".
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See also
Device-Specific Nature of the Objects (Page 3508)

Format

Introduction
Four different display formats are available in WinCC Runtime Professional for the input and 
output of values in an I/O field. Numerical values can be edited in binary, decimal or 
hexadecimal format. The "String" display format must be specified for the I/O field to display 
text.

Various formats can be selected or freely defined based on the display format. 
The definition for a format can be rewritten as a sequence of formatting codes. The formatting 
codes act as placeholders for a specific group of characters. For example, if a formatting code 
for which only the display of the numbers 0-9 is preset for a specific position in the display of 
an I/O field, only letters can be input at this position.

 
 

 Note

If the value you want to display does not correspond exactly to the definition of the format, 
only three asterisks are displayed. This applies for the length of the entire character string 
and also for the type and position of the individual characters.

 

Formatting codes - "Binary" data format

1 Placeholder for the binary values 0 and 1. The number of formatting code "1" specifies 
the number of digits allowed for the display of a binary value.

0 If needed, the binary value is preceded by a leading zero. The format can also begin 
with the format code "0", but it can only include it once.

 

Table 10-3 Example: The eight-digit binary value 10011101 can be displayed as follows:

Format Permissible number of digits Display
11 2 01
011 2 + leading zero 001
1111 4 1101
01111 4 + leading zero 01101
1111111 7 0011101
01111111 7 + leading zero 00011101
1111111111 10 10011101
01111111111 10 + leading zero 010011101
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Formatting codes - "Decimal" data format

9 Placeholder for the binary values 0 and 9. The number of formatting code "9" specifies 
the number of digits allowed for the display of a decimal value. If the actual number of 
decimal places exceeds the number specified in the display format, the displayed value 
is rounded.

, A period defines the location of the decimal point. The formatting code "." may be used 
at any point in the format, but it can only be used once.

s Positive decimal numbers are displayed with a sign. The formatting code "s" should be in 
the first place of the output format and may only be used once.

0 Leading and trailing zeros are displayed, when the actual number of integer or decimal 
places is less than the specified number in the display format. The formatting code "0" 
must be before the first "9" and may only be used once.

e The decimal number is displayed in exponent notation. The formatting code "e" should 
be in the last place of the output format and may only be used once.

 

Table 10-4 Example: The six-digit decimal value 123.456 can be displayed as follows:

Format Permissible number of digits Display
999 3 124
999.9 4 123.5
s999.9 4 + sign +123.5
999,999 6 123.456
09999.9999 8 +  zeros 0123.4560
s09999.9999 8 + sign + zeros +0123.4560
1111111111 10 10011101
9.99999e 6 1.23456e+002

 
 

 Note

When storing a floating-point number in IEEE format of S5, a format for display in an IO field 
should be used that provides for the sign and exponent (e.g. s0999.999e).

 

Formatting codes - "Hexadecimal" data format

f Placeholder for the letters A to F or a to f and numbers 0 to 9, which are used to represent 
hexadecimal numbers. The permitted number of characters is defined by the number of 
the formatting codes "f" in the output format.

0 Leading zeros of the hexadecimal value are displayed if the output format begins with the 
format code "0". The formatting code "0" may only be included once.
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Table 10-5 Example: The eight-digit binary value ABCDEF01 can be displayed as follows:

Format Permissible number of digits Display
ff 2 01
0ff 2 + leading zero 001
ffff 4 EF01
0ffff 4 + leading zero 0EF01
ffffffffff 10 ABCDEF01
0ffffffffff 7 + leading zero 0ABCDEF01

Formatting codes - "String" data format
The allowed length of a character string is defined by the number of formatting codes used 
(exception "*").

* Input of a character string of any length
? Input of any character string
a Lower-case letters, upper-case letters and digits are allowed

no separators or similar.
A Upper-case letters and digits are allowed

no lower-case letters, separators or similar.
b Lower-case letters and upper-case letters are allowed

no digits, separators or similar.
B Only upper-case letters are allowed

no lower-case letters, digits, separators or similar.
1-9 The formatting codes "1", "2", ..., "9" are used as placeholders for digits.

The selected formatting code also defines the actual digits allowed: For example, if 
the "2" is specified, only the digits 0, 1 or 2 can be displayed. The formatting code 
"8" allows all digits except for the 9.

h Only the digits 0 to 9 and the letters A to F or a to f are allowed.
The formatting code "h" allows only characters that are required to display 
hexadecimal numbers.

t The formatting code "t" forces input of a separator at the specified position. These 
separators are valid: Slash, colon, comma, period and space.

Editable text field

Application
The "Editable text field" object enables you to display several lines of text in a rectangle on the 
screen. If the text is larger than the rectangle, WinCC automatically adds a scroll bar to the 
right margin. 

If you allow operation, the operator can edit the text in runtime. You can use the multiple-line 
text for the input or output of text by connecting tags. 
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Layout
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Text: Defines the text for the "Editable text field".

Text 
The text for the "Editable text field" is defined in the inspector window. 

1. Click "Properties > Properties > General" in the inspector window.

2. Enter a text of any length.
For texts over several lines you can set a line break by pressing <Enter>, with the key 
combination <Shift + Enter> or the key combination <Ctrl + Enter>.

See also
Device-Specific Nature of the Objects (Page 3508)

Ellipse

Application 
The "Ellipse" is an enclosed object that can be filled with a color or pattern. 

Layout 
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Horizontal radius: Specifies the horizontal radius of the elliptical object.

● Vertical radius: Specifies the vertical radius of the elliptical object.

Horizontal radius   
The horizontal radius of the "Ellipse" object is specified in the Inspector window. The value is 
entered in pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 under "Horizontal."
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Vertical radius   
The vertical radius of the "Ellipse" object is specified in the Inspector window. The value is 
entered in pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 at "Vertical."

See also
Device-Specific Nature of the Objects (Page 3508)

Elliptical arc  (Page 3538)

Ellipse segment (Page 3539)

Rotating objects (Page 3353)

Flipping objects (Page 3355)

Elliptical arc 

Application
The "Elliptical arc" is an open object. Use the "Ellipse segment" object if you want to fill the 
object with color. By default, an elliptical arc is a quarter ellipse. It can be customized as 
required.   

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:   

● Horizontal and vertical radii: Specifies the horizontal and vertical radius of the elliptical 
object.

● Start and end angle: Specify where the start and end angle lie on a virtual circle of 360°.

Defining radii     
Define the horizontal and vertical radius of the "Elliptical arc" object in the Inspector window. 
Enter the values using Pixels as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Horizontal radius" and "Vertical radius".
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Define start and end angle     
Determine the length of the elliptical arc using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Angle start" and "Angle end".

Alternative procedure
You can also change the start and end points of the elliptical arc using the mouse.

1. Place the cursor on a start or end point of the elliptical arc. The start and end points are 
indicated by small blue squares.
The mouse cursor changes to a cross.

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 3508)

Ellipse (Page 3537)

Ellipse segment

Application
The "Ellipse segment" is a closed object that you can fill with a color or pattern. By default, an 
ellipse segment is a quarter ellipse. It can be customized as required.     

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Horizontal and vertical radii: Specifies the horizontal and vertical radius of the elliptical 
object.

● Start and end angle: Specify where the start and end point lie on a virtual circle of 360°.
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Defining radii     
Define the horizontal and vertical radius of the "Ellipse segment" object in the Inspector 
window. Enter the values using Pixels as the unit:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Horizontal radius" and "Vertical radius" in the "Arc" area.

Define start and end angle     
Determine the size of the ellipse segment using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Start angle" and "End angle" in the "Arc" area.

Alternative procedure
You can also change the start and end points of the ellipse segment using the mouse.

1. Place the cursor on a start or end point of the ellipse segment. The start and end points 
are indicated by small blue squares.
The mouse cursor changes to a cross. 

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 3508)

Ellipse (Page 3537)
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f(t) trend view

Application   
You use the "f(t) trend view" object to display tag values from the current process, or from the 
log in the form of trends as a function of the time. 

Layout   
In the Inspector window, you customize the position, geometry, style, colors and font types of 
the object. You can adapt the following properties in particular:

● Adding and configuring trends

● Configuring a diagram

● Window settings

● Persistence

● Toolbar

Configuring trends
1. Select the data supply for the trend under "Properties > Properties > Trends > Data source".

– "Log tags": The trend window is supplied with values from a data log.

– "User-defined": The trend view is supplied user-defined in Runtime by means of scripts.

– "Tags": The trend window is supplied with values of a tag.

2. Under "Data range", define whether the trend displays the values statically or if the values 
are refreshed.

– "Automatic": The displayed value range is automatically adapted to the current values:

– "Initial value / End value": You define the minimum value and maximum value for the 
value range.
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3. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit.

4. Select "Properties > Properties > Time axis".

5. Configure the "Time range" of the trend display.

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

Configuring a diagram
Configure the display of several trends under "Diagram":

● Common or separate diagrams

● Common or separate axes

● Writing direction of all trends

Window settings
Under "Layout > Window", define whether the user can change the size of the window in 
runtime and can close the window. 

Persistence
Select "Properties > Properties > Security > Persistence" to specify whether or not a user may 
edit trend view configuration in Runtime and the retention period of such changes.

● "No persistence"
The changes to the configuration are not saved. The changes are discarded at the next 
screen change and when Runtime is closed.

● "Persistence"
The changes to the configuration are saved. The changes are retained even after Runtime 
was closed. You may also select "Response at screen change" to discard changes at the 
screen change.

● "Persistence in Runtime"
The changes to the configuration are only saved during Runtime. The changes are 
discarded as soon as you close Runtime. You may also select "Response at screen change" 
to discard changes at the screen change.
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Toolbar       
You define the control elements of the f(t) trend view in Runtime under "Properties > Properties 
> Toolbar" in the Inspector window. The following control elements are available for the f(t) 
trend view:

Button Name Function ID
Online help Opens the online help. 1

Open configuration Opens the configuration dialog. 2

First data record Scroll in the log:
Shows the trend curve starting with the first logged value.

3

Previous data record Scroll in the log:
Shows the trend curve of the previous time interval.

4

Next data record Scroll in the log:
Shows the trend curve of the next time interval.

5

Last data record Scroll in the log:
Shows the trend curve up to the last logged value.

6

Show/ hide ruler Determines the coordination of a point of the trend. 7

Zoom area Increases the size of any section of the trend window. 8

Original view Switches from the magnified trend view back to the normal view 14

Tag selection Opens the dialog for selecting the log and tags. 15

Trend selection Opens the dialog for setting the visibility of trends. 16

Time range selection Opens the dialog for setting the time range displayed in the 
trend window.

17

Previous trend Displays the previous trend in the foreground 18

Next trend Displays the next trend in the foreground 19

Start/end update Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again. 

20

Print log Starts printing the trends shown in the trend window. You define 
the print job under "General > Print > Print job". 

21

Selection of the statistics area Enables you to define a time range for which statistics values 
are determined. Vertical lines which you use to set the time 
range are displayed in the trend window. 

22
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Button Name Function ID
Statistics window Opens a statistics window to display the minimum, maximum, 

means, and standard deviation for the selected time range and 
the selected trend. 

23

Exporting process data in 
runtime as a CSV file 

Opens the dialog for saving the trend data in CSV format. 26

The order of the buttons is fixed. Under "Hotkey" you can set up individual key assignments, 
and shortcuts for every button on the toolbar.

See also
Device-Specific Nature of the Objects (Page 3508)

f(x) trend view (Page 3547)

Table view (Page 3631)

Value table (Page 3638)

Configure trend view (Page 3837)

f(x) trend view

Application   
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. You can also compare the trend to a setpoint trend. 
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Layout   
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Adding and configuring trends

● Configuring a diagram

● Window settings

● Persistence

● Toolbar

Configuring trends
You create and configure trends in the Inspector window "Properties > Properties > Properties 
> Trend".

1. Select the data supply for the trend in the "Data source" column. 

– "Log tag": The trend window is supplied with values from a data log.

– "Tags": The trend view is supplied with current values from the PLC. The values are 
constantly updated.

2. Configure the area of the trend display under "Data area".

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

3. Configure the value range of the trend display under "X axis" and "Y axis".

4. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit, 
uncertain status.

Configuring a diagram
Configure the display of several trends under "Properties > Properties > Appearance":

● Common diagram or separate diagrams

● Common or separate axes

● Writing direction of all trends
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Toolbar       
The control elements of the f(x) trend display are defined in the "Properties > Properties > 
Toolbar" inspector window. The following control elements are available for the f(x) trend view:

Button Name Function
Zoom +/- Increases or decreases the size of the trends in the trend window. 

Increase the size of the trends by left-clicking with the mouse. Hold 
down <Shift> and left-click to decrease the size of the trends.

Zoom area Increases the size of any section of the trend window. Specify an 
area in the trend window by using the mouse. This area of the trend 
window is enlarged.

Zoom X axis Increases or decreases the size of the X axis in the trend window. 
Enlarge the X axis by left-clicking with the mouse. Hold down <Shift> 
and left-click to decrease the size of the X axis.

Zoom Y axis Increases or decreases the size of the Y axis in the trend window. 
Enlarge the Y axis by left-clicking with the mouse. Hold down <Shift> 
and left-click to decrease the size of the Y axis. 

Trend area Shift the trends in the trend window along the X axis and Y axis by 
using this button.

Axis area Shift the trends in the trend window along the value axis by using 
this button.

Original view Switches from the magnified trend view back to the normal view

Start/stop Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again.

Ruler Determines the coordination of a point of the trend. 

The order of the buttons is fixed. The operator can set up individual key assignments, and 
shortcuts for every button on the toolbar.

See also
Device-Specific Nature of the Objects (Page 3508)

Configure trend view (Page 3837)
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f(x) trend view

Use   
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. You can also compare the trend to a setpoint trend. 

Layout   
In the Inspector window, you customize the position, geometry, style, colors and font types of 
the object. You can adapt the following properties in particular:

● Add and configure trends

● Configuring a diagram

● Window settings

● Persistence

● Toolbar
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Configuring trends
1. Select the data supply for the trend under "Properties > Properties > Trends > Data source".

– "Log tags": The trend view is supplied with values from a data log.

– "User-defined": The trend view is supplied user-defined in Runtime by means of scripts.

– "Recipe" The trend view is supplied with values from a recipe.

– "Tags": The trend view is supplied with values of a tag.

2. Configure the area of the trend view under "Data area".

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

– "Start ID" and "Number of data records": With data supply via recipes, you define the 
range by the ID of the first data record and the number of subsequent data records.

3. Configure the value range of the trend display under "X axis" and "Y axis".

– "Automatic": The displayed value range is automatically adapted to the current values.

– "Initial value / End value": You define the minimum value and maximum value for the 
value range.

4. Under "Limits", configure the colored marking of specific values, .e.g.. high and low limit, 
uncertain status.

Configuring a diagram
Configure the display of several trends under "Layout":

● Common diagram or separate diagrams

● Common or separate axes

● Writing direction of all trends

Window settings
Under "Layout > Window", define whether the user can change the size of the window in 
runtime and can close the window. 
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Persistence
Under "Security > Persistence" define how long a user's changes to the trend view in runtime 
are retained.

● "Allow persistence"
Users can change settings. Changes are retained until the next screen change.

● "Persistence until logoff"
User group changes are retained until logoff.

● "Persistence until next loading"
User group changes are retained until the project is updated on the HMI device.

Toolbar       
You define the control elements of the f(x) trend view in Runtime under "Properties > Toolbar" 
in the Inspector window. The following control elements are available for the f(x) trend view:

Button Name Function
Online help Opens the online help.

Configuration dialog box Opens the configuration dialog. 

Zoom +/- Enlarges and/or shrinks the trends in the trend window. You can 
enlarge the trend with the left mouse button. You can reduce the size 
of the trend by holding down <Shift> and left-clicking.

Zoom area Increases the size of any section of the trend window. Use the mouse 
to specify an area in the trend window. This area of the trend window 
is enlarged.

Zoom X axis Enlarges and/or reduces the X axis in the trend window. You can 
enlarge the X axis with the left mouse button. You can reduce the 
size of the X axis by holding down <Shift> and left-clicking.

Zoom Y axis Enlarges and/or reduces the Y axis in the trend window. You can 
enlarge the Y axis by left-clicking. You can reduce the size of Y axis 
by holding down <Shift> and left-clicking.

Move trend range You can move the trends in the trend window along the X axis and 
the Y axis using the button.

Move axis range You can move the trends in the trend window along the value axis 
using the button.

Original view Switches from the magnified trend view back to the normal view

Select data connection Opens a dialog for selecting logs and tags.

Select trends Opens a dialog for setting the visibility of trends.

Select time range Opens a dialog for setting the displayed time range in the trend 
window.
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Button Name Function
Previous trend Displays the previous trend in the foreground.

Next trend Displays the next trend in the foreground.

Start/stop Stops and starts the trend update. The values are buffered and 
updated as soon as you start trend update again.

Print Click this button to print the trend shown in the trend window. The 
print job used during printing is defined in the configuration dialog in 
the "General" tab.

Export data This button is used for exporting all or the selected runtime data to 
a csv file.
If the "Display dialog" option is activated, a dialog opens in which 
you can view the settings for export and start the export. You may 
also select the file and the directory for the export with the 
corresponding authorizations.
If no dialog is displayed, the export of data to the default file begins 
immediately.

Ruler Determines the coordinates of a point of the trend.

Connect backup Opens a dialog in which selected logs are connected to WinCC 
Runtime.

Disconnect backup Opens a dialog in which selected logs are disconnected from WinCC 
Runtime.

The order of the buttons is fixed. The operator can set up individual key assignments, and 
shortcuts for every button on the toolbar.

See also
Device-Specific Nature of the Objects (Page 3508)

f(t) trend view (Page 3541)

Table view (Page 3631)

Value table (Page 3638)

Configure trend view (Page 3837)

Graphic view

Application  
The "Graphic view" object is used to display graphics.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3550 System Manual, 02/2014



Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Graphic: Specifies the graphic file that is displayed in the object.

● Stretch graphic: Specifies the automatic size stretching for objects with graphics.

● Transparent color: Specify whether or not the transparent color is used for the graphic.

Inserting graphics  
The following graphic format is used in the "Graphic view" object: *.bmp, *.tif, *.png, *.ico, *.emf, 
*.wmf, *.gif, *.jpg or *.jpeg. You may also use graphics as OLE objects in the Graphic view .

1. In the Inspector window, select "Properties > Properties > General":

2. Select the graphic that you wish to insert.
The graphic preview is shown in the right pane.

3. Click "Apply" to insert the graphic in the Graphic view .

Stretch graphic  
Whether a graphic displayed in a Graphic view  is stretched to the size of the Graphic view  in 
runtime is specified in the Inspector window.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Select the required size adjustment for the graphic.

Transparent color   
This property defines whether the transparent color is used for the graphic to be displayed. 

1. Click "Properties > Properties > Appearance" in the inspector window:

2. Activate "Background > Transparent".

3. Select a transparent color.
 

  Note

When using bitmaps in WinCC screens the "Transparent color" setting demands a high 
character performance in the layout on the panel. Visualization performance is enhanced 
by disabling the "Transparent" setting in the properties of the relevant display object. This 
restriction applies in particular when bitmaps are used as background image.  

 

  Note
Basic Panels

The "Transparent" property is not available for Basic Panels.
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See also
Device-Specific Nature of the Objects (Page 3508)

Storing an external image in the graphics library. (Page 3377)

Options for Editing Objects (Page 3342)

Overview of objects (Page 3333)

Graphic I/O field

Application  
The "Graphic I/O field" object can be used to configure a list for display and selection of graphic 
files.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Scroll bar type: Specifies the graphic layout of the scroll bar.
 

 Note
Basic Panels

The scroll bar is not available for Basic Panels.
 

 Note
Reports

Graphic I/O fields output exclusively graphics in reports. "Output" mode is preset. Properties 
for configuring the selection of graphics are not available, e.g. "scroll bar".

 

Mode  
The response of the "Graphic I/O field" object is specified under "Properties > Properties > 
General > Type > Mode" in the Inspector window.

Mode Description
"Input" The "Graphic I/O field" object is only used to select graphics.
"Input/output" The "Graphic I/O field" object is used to select and display graphics.
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Mode Description
"Output" The "Graphic I/O field" object is used to display graphics only.
"Two states" The "Graphic I/O field" object is only used to display graphics and can have a 

maximum of two states.
You use no graphics list but insert one graphic each for the "ON" and "OFF" 
state.

Stretch graphic  
Whether a graphic displayed in a graphic I/O field is stretched to the size of the view in runtime 
is specified in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required size adjustment for the graphic.

Scroll bar type
The response for the graphic representation of the scroll bar is specified under "Properties > 
Properties > Appearance > Scroll Bar > Type" in the Inspector window.

Type Description
"Permanent" The scroll bar is always visible.
"No scrollbar" The scroll bar is not visible.
"Visible after clicking" The scroll bar is made visible by a mouse click.

See also
Print job/Script diagnostics (Page 3529)

Device-Specific Nature of the Objects (Page 3508)

Symbolic I/O field (Page 3621)

Graphic I/O field

Application  
With the "Graphic I/O field" object you configure a graphics list which is used to display and 
select graphic files.

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
System Manual, 02/2014 3553



Layout  
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in runtime.

● Fit to size: Specifies the ratio of the display window and the embedded graphic.

Mode  
The response of the "Graphic I/O field" object is specified in the Inspector window in "Properties 
> Properties > General > Mode".

Mode Description
"Output" The "Graphic I/O field" object is used to display graphics only.
"Two states" The "Graphic I/O field" object is only used to display graphics and can have a 

maximum of two states.
You use no graphics list but insert one graphic each for the "ON" and "OFF" 
state.

Fit to size  
The ratio for the graphic representation in the display window is specified under "Properties > 
Properties > Layout > Fit to size" in the Inspector window.

Sizing type Description
"Fit object size to content" The display window is adapted automatically to the size of the 

graphic.
"Fit content to object size" Adjust the graphic to the display window size.

See also
Device-Specific Nature of the Objects (Page 3508)

Symbolic I/O field (Page 3622)
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Handwheel

Application   
The object "Handwheel" is a control element for some SIMATIC Mobile Panels. You can enter 
incremental values in Runtime using the "HandWheel" object. 

Layout   
You can set the following property in the Inspector window:

● Tag: Specifies the tags to which the "HandWheel" object is linked.

Tag     

Global assignment
The "Tag" property is specified in the template for the global assignment of the "HandWheel" 
object. There is only one template for each HMI device. 

1. In the Inspector window, select "Properties > Properties > General":

2. Select a tag from the selection list under "Settings > Tag".

Local assignment
The "HandWheel" object is assigned to another tag. To do so you configure a function that 
assigns the tag to the handwheel in Runtime.

Example for configuration to a button:

1. Open the screen in which the "HandWheel" object is assigned to another tag.

2. Drag the "Button" object from the toolbox to the screen. Select the button on your screen.

3. Click "Properties > Events > Click" in the Inspector window.
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4. The "Function list" dialog box opens. Click the first line of the function list. The list of system 
functions and scripts available in the project appears.

5. Select the system function "SetTagToHandWheel" from the "Other functions" group. Select 
a tag from the combo box at "Value".

 

  Note

The Mobile Panel may ignore the change of the value in the PLC made at another location 
while the handwheel is being operated. The value is the PLC is overwritten again. 

 

See also
Device-Specific Nature of the Objects (Page 3508)

Illuminated pushbutton (Page 3571)

Help indicator

Application  
The object "help indicator" is available for the HMI devices OP 73 and KP300 Basic. If a a 
tooltip exists for the selected object, the help indicator is displayed during runtime. If a tooltip 
was configured for the opened screen, the help indicator always remains visible.

You configure the object "help indicator" exclusively in the global screen.

Layout
You can adapt the following properties in the Inspector window:

● Position: Determines the position of the object "Help indicator."

Position
You can use this property to set the position of the object "Help indicator." 

1. Select the object "Help indicator" in the template.

2. In the Inspector window, select "Properties > Properties > Layout".

3. Enter a value for X and Y. You can also use the cursor keys to position the selected object.

If you have configured a screen object at this position, the visible help indicator covers the 
screen object. The help indicator is covered only by incoming system alarms and dialogs. 

See also
Device-Specific Nature of the Objects (Page 3508)
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HTML browser

Application   
The "HTML Browser" object is designed for the visualization of simple HTML pages. This 
function allows you to draw up machine-specific descriptions which are stored centrally and 
which can then be displayed from different HMI devices.

 

 Note

Changing the functionality of the HTML Browser to that of a file explorer by one of the following 
methods, for example, is not authorized in the context of WinCC:
● Entering a folder or drive, for example "\" or "C:" or
● Connecting to an FTP server, for example "ftp://"

One reason this function is not implemented is to prevent inadvertent changes to files, their 
deletion or execution.     

When configuring, ensure that the operator can only enter valid Internet addresses, for 
example, by using symbolic I/O fields. Configure a password-protected input for service 
purposes.

 

Layout   
Customize the object position and size in the Inspector window. In particular, you can 
customize the following property:

● URL: Specifies which Internet address is opened in the HTML Browser.

Address   
The internet address is specified in "Properties > Properties > General >URL" in the Inspector 
window. 
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Basic procedure
1. Create an internal tag of the "String" data type, for example InternetAddress, in the "Tag" 

editor.

2. Insert the "HTML Browser" object in the screen in the "Screens" editor.

3. In the Inspector window, select "Properties > Properties > General".

4. At "Tag for the URL", select the "InternetAddress" tag from the selection list.

5. Insert an I/O field in the screen in the "Screens" editor.

6. Select "Properties > Properties > General > Tag for URL" in the Inspector window and then 
select the "InternetAddress" tag at "URL tag" from the selection list.

The HTML Browser opens the relevant page after the operator has entered an address.

Control elements       
Control elements are configured buttons in the process screen or softkeys on the HMI device. 

The "HTML Browser" object does not have its own operator control components. Assign the 
system functions used to control the "HTML Browser" object to your configured control 
elements, such as buttons.

1. For example, drag the "Button" object to the screen from the toolbox.

2. Input a text of any length or select a graphic, for example Update.

3. In the Inspector window, select "Properties > Events > Click". 
The "Function list" dialog box is opened.

4. The system functions for controlling the "HTML Browser" object can be found in the list of 
system functions in the "Keyboard online operation for screen objects". 
Select a function from the list, for example, HTMLBrowserRefreshName.

5. Select the object name of the HTML Browser in which the command will be executed from 
the "Screen object" list.
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Comments
The functional scope of the HTML Browser is limited in comparison to the Internet Explorer:

● The HTML Browser will only show pure HTML pages. VBScript, Java, JavaScript, Flash 
and ActiveX controls are not supported. Set up the HTML pages for display in the HTML 
Browser by using a text editor or using a simple HTML editor.

● Links to embedded files, for example *.pdf or *.xls, are not supported.

● Queries and dialogs that are conducted during the access of, for example protected pages 
are not supported. When accessing protected pages enter your user name and password 
in the URL: <http://User_Name:Password@Server_Name> (for example, "http://
Administrator:Admin123@192.168.0.199").

See also
Device-Specific Nature of the Objects (Page 3508)

HTML browser

Application   
The "HTML Browser" object is designed for the visualization of simple HTML pages. This 
function allows you to draw up machine-specific descriptions which are stored centrally and 
which can then be displayed from different HMI devices.

 

 Note

Changing the functionality of the HTML Browser to that of a file explorer by one of the following 
methods, for example, is not authorized in the context of WinCC:
● Entering a folder or drive, for example "\" or "C:" or
● Connecting to an FTP server, for example "ftp://"

One reason this function is not implemented is to prevent inadvertent changes to files, their 
deletion or execution.     

When configuring, ensure that the operator can only enter valid Internet addresses, for 
example, by using symbolic I/O fields. Configure a password-protected input for service 
purposes.
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Layout   
Customize the object position and size in the Inspector window. In particular, you can 
customize the following property:

● Address: Specifies which Internet address is opened in the HTML Browser.

● Toolbar: Specifies whether a navigation toolbar is shown.

Address    
The Internet address is specified in the Inspector window under "Properties > Properties > 
General > Window > URL". 

Basic procedure
1. Create an internal tag of the "String" data type, for example InternetAddress, in the "Tag" 

editor.

2. Insert the "HTML Browser" object in the screen in the "Screens" editor.

3. In the Inspector window, select "Properties > Properties > General".

4. For "Tag for the URL", select the "InternetAddress" tag from the selection list.

5. Insert an I/O field in the screen in the "Screens" editor.

6. Select the "InternetAddress" tag at "URL tag" from the selection list under "Properties > 
Properties > General" in the Inspector window.

When the operator enters or activates an address, the HTML Browser opens the relevant page.
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Comments
The functional scope of the HTML Browser is limited in comparison to the Internet Explorer:

● The HTML Browser will only show pure HTML pages. VBScript, Java, JavaScript, Flash 
and ActiveX controls are not supported. Set up the HTML pages for display in the HTML 
Browser by using a text editor or using a simple HTML editor.

● Links to embedded files, for example *.pdf or *.xls, are not supported.

● Queries and dialogs that are conducted during the access of, for example protected pages 
are not supported. When accessing protected pages enter your user name and password 
in the URL: <http://User_Name:Password@Server_Name> (for example, "http://
Administrator:Admin123@192.168.0.199").

See also
Device-Specific Nature of the Objects (Page 3508)

Channel diagnostics

Application
You use the "Channel Diagnostics" object to monitor the active connections in Runtime. The 
"Channel Diagnostics" object allows you to output the following status, and diagnostic 
information for the channel units:

● Output status/statistical information about the connections in Runtime

● Text output to a logbook file for fault analysis, and troubleshooting

● Text output to a trace file to help the Hotline in pinpointing the cause of connection problems

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. 
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Overview of the status messages
The following statuses are displayed in the "Channel Diagnostics" object:

● Channel / connection ready without restriction

● Channel / connection ready with some restrictions

● No information available about connection status

● Channel / connection failed

Check channel and connection
Use the "Channel Diagnostics" object to output the log, and trace files. To do this, activate 
your project. The following is displayed on the left of the Channels/Connections tab in the 
"Channel Diagnostics" object: Status information about all installed channels, and their 
connections.

1. Check the icons in front of the channel called "System Info", and its connection. If the status 
of a channel, and connection are OK, a green tick is displayed in front the associated entry. 
The meaning of the individual icons is explained in the "Overview of the Status Messages" 
table.

2. If there is no green check mark in front of the channel name and connection, select the 
connection in the left-hand window.

3. In the right-hand window, check the values of the "Address Error", Size Error", and "Type 
Error" counters. These values indicate the errors detected.

4. Check the channel-specific log file. Open the log file from the "Siemens\Automation
\SCADA_2007\WinCC\Diagnose" folder in a text editor.

5. Check the latest entries with the "ERROR" flag. For more information on this topic, refer to 
"Description of the Log File Entries".

6. Activate the trace function.
Contact Customer Support if you are unable to locate the error, even after checking the log 
file. 

See also
Device-Specific Nature of the Objects (Page 3508)
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Combo box

Application
You use the "Combo box" object to present and select entries in a drop-down menu. You 
activate an entry by default so that the operator only changes the preset value if necessary. 
To incorporate combo boxes into the process, dynamize the corresponding properties.

Layout
In the Inspector window, you customize the position, style, colors and font type settings of the 
object. You can adapt the following properties in particular:

● Number of entries: Defines the number of combo boxes.

● Selection of entries: Defines which entry is displayed as activated by default.

Defining the number of entries
1. In the Inspector window, select "Properties > Properties > General".

2. Define the desired number of list boxes under "Label > Entries".

At the same time, the value of the "Entries" attribute specifies the high limit for the "Index" 
property under "Label." Changing the value can have the following effects:

Changing the number
New fields are added under the field with the highest value for the "Index" property if you 
increase the number of entries. 

All fields for which the value of the "Index" property is higher than the new number will be 
deleted if you reduce the number of entries.

See also
Device-Specific Nature of the Objects (Page 3508)

List box (Page 3576)

Check box 

Application
You use the "Check box" object to present and select multiple options. You activate check 
boxes by default so that the operator only changes the preset value if necessary. The operator 
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can select several options in Runtime. To incorporate a check box into the process, dynamize 
the corresponding properties.

Layout
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Number of check boxes: Defines the number of options.

● Check box selection: Defines which options are displayed as activated by default.

Define number of check boxes
1. In the Inspector window, select "Properties > Properties > General".

2. Define the desired number of check boxes under "Label > Entries".

At the same time, the value of the attribute specifies the upper limit for the "Index" property 
under "Label." Changing the value can have the following effects:

● Increases the number
New fields are added under the field with the highest value of the "Index" property. You can 
change the default label for the new field using the "Text" property under "Label."

● Reduces the number
All fields for which the value of the "Index" property is greater than the new number are 
deleted.

Define the default setting of the check boxes
In the table under "Properties > Properties > General > Label > Presetting enabled", you define 
which options are shown activated in a check box list. You can activate multiple options.

Each option is represented by a bit in a 32-bit word. To activate a field, the corresponding bit 
must have the value "1". The 32-bit word contains the information for all options of the check 
box list. The value of the "Presetting enabled" property is specified in hexadecimal format. 

See also
Device-Specific Nature of the Objects (Page 3508)

Option buttons (Page 3592)
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Circle

Application
The "Circle" object is a closed object which can be filled with a color or pattern.

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Radius: Specifies the size of the circle.

Radius
The radius of the "Circle" object is specified in the Inspector window. The value is entered in 
pixels.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value between 0 and 2500 in the "Radius" area.

See also
Device-Specific Nature of the Objects (Page 3508)

Circular arc (Page 3566)

Circle segment (Page 3567)
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Circular arc

Application
The "Circular arc" is an open object. Use the "Circle segment" object if you want to fill the object 
with color. By default, a circular arc is a quarter circle. It can be customized as required.

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Radius: Define the size of the circular arc.

● Start and end angle: Specify where the start and end angle lie on a virtual circle of 360°.

Defining the radius  
Define the horizontal, and the vertical radius of the "Circular arc" object in the Inspector window. 
Enter the values using Pixels as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Radius" in the "Arc" area.

Define start and end angle   
Determine the length of the circular arc using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Start angle" and "End angle" in the "Radii" area.
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Alternative procedure
You can also change the start and end points of the circular arc using the mouse.

1. Place the cursor on a start or end point of the circular arc. The start and end points are 
indicated by small blue squares.
The mouse cursor changes to a cross. 

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 3508)

Circle (Page 3565)

Circle segment (Page 3567)

Circle segment

Application
The "Circle segment" is a closed object that you can fill with a color or pattern. By default, a 
circle segment is a quarter circle. It can be customized as required.

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Radius: Define the size of the circle segment.

● Start and end angle: Specify where the start and end angle lie on a virtual circle of 360°.

Radius  
You define the radius of the "Circle segment" object in the Inspector window. Enter the value 
using Pixels as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Radius" in the "Arc" area.
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Define start and end angle   
Determine the size of the circle segment using the "Start Angle" and "End Angle" attributes. 
Enter the values using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter a value for "Start angle" and "End angle" in the "Radii" area.

Alternative procedure
You can also change the start and end points of the circle segment using the mouse.

1. Place the cursor on a start or end point of the circle segment. The start and end points are 
indicated by small blue squares.
The mouse cursor changes to a cross. 

2. Hold down the mouse button, and drag the start or end point to the desired position.

See also
Device-Specific Nature of the Objects (Page 3508)

Circle (Page 3565)

Circular arc (Page 3566)

Trend view

Application   
The trend view is meant for the graphical representation of tag values from the current process 
or from a log in form of trends.
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Layout   
In the Inspector window, you customize the position, geometry, style, color, and font types of 
the object. You can adapt the following properties in particular:

● Display value table, ruler and grid: Specifies whether a value table, a ruler or a grid is 
displayed in addition to the coordinate system to improve legibility.

● Toolbars: Defines the display of the control elements.

Display value table, ruler and grid
For improved legibility a value table, a ruler and a grid can be displayed in Runtime.

1. Activate "Properties > Properties > Appearance > Show ruler".

2. Activate "Properties > Properties > Table > Show table".

3. Activate "Properties > Properties > Table > Show grid".

Toolbars     
The layout of the control elements is defined in the "Properties > Properties > Toolbar" 
inspector window. 

 

 Note
Basic Panels

As archiving is not possible for Basic Panels, the control elements are not available.
 

Toolbar button Brief description Description
"Go to start" Scrolls back to the beginning of the trend recording. 

The start values with which the trend recording started 
are displayed. 

"Zoom in" Zooms out of the displayed time section

"Zoom out" Zooms into the displayed time section.
"Ruler backward" Moves the ruler back.
"Ruler forward" Moves the ruler forward.
"Backward" Scrolls back one display width.
"Forward" Scrolls forward one display width.
"Ruler" Shows or hides the ruler. The ruler displays the X-

value associated with a Y-value.
"Start/stop" Stops trend recording or continues trend recording.
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Configuration behavior

Displaying column headers
The layout of the table in the trend view depends on the view settings in the Control Panel. 
Depending on the setting, the column headers may be truncated. This setting is found under 
"Display > Appearance" in the control panel. To display column headers correctly, set the 
display in "Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 

Consistency test
If warnings or errors are displayed in the output window during a consistency check in 
connection with trend views, clicking "Go to Error/Tag" on the shortcut menu will not always 
take you to the exact error position. In some cases only the trend view is shown as cause of 
error.

Adding, configuring, and removing trends
The trends of the trend view are managed in the Inspector window under "Properties > 
Properties > Trend". You can copy trends between different trend views. 

See also
Device-Specific Nature of the Objects (Page 3508)

Configuring trend displays for values from the PLC (Page 3825)

Trends (Page 3820)

Creating trends for the trend window. (Page 3841)

Configure trend view (Page 3837)

Charging status

Application
The object "Charging condition" is a control element for some SIMATIC Mobile Panels. The 
"Charging condition" object indicates the charging status of the battery. Charge the battery in 
good time. Alternatively, you can replace the battery with a spare battery.     
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Layout

Symbol Description Charging condition
Battery is charged >20 %

Battery must be charged <20 % and
>6 %

Battery is weak < 6 %

Operation
The object is for display only and cannot be controlled by the operator.   

See also
Device-Specific Nature of the Objects (Page 3508)

Effective range name (Page 3640)

Effective range name (RFID) (Page 3642)

Effective range signal (Page 3644)

WLAN reception (Page 3645)

Zone name  (Page 3649)

Zone signal (Page 3650)

Illuminated pushbutton

Application  
The object "Illuminated pushbutton" is a control element for some SIMATIC Mobile Panels. 
The LEDs can be activated by the PLC. The illuminated LED signals the operator in Runtime 
that the illuminated pushbutton has to be pressed. The illuminated pushbutton is configured 
in the global screen.
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Layout  
You can adapt the following properties in the Inspector window:

● Tag: Specifies the tag in which the status of the illuminated pushbutton is written.

● LED assignment: Specifies the assignment of the LED to the bit in the LED tag.

Tag   
The "Tag" property is used to specify the global assignment of the "Illuminated pushbutton" 
object in the global screen. 

 

 Note
Information for configuring

The current status of the illuminated pushbutton is written to the tag when Runtime is started 
and whenever the button is pressed. This may cause inconsistencies between the status of 
the illuminated pushbutton and the illuminated pushbutton tags.
1. If the tag has a connection to the PLC, the current value is transferred from the PLC to 

the tag after establishment of communication. The tag that contains the current status of 
the key is overwritten by this process. The illuminated pushbutton tag may therefore no 
longer reflect the current value of the illuminated pushbutton, for example if the Mobile 
Panel is switched off while the illuminated pushbutton is pressed.

2. If the illuminated pushbutton is pushed before communication to the PLC could be 
established (for example after a device start-up), it may not be possible to send the value 
of the illuminated pushbutton tag to the PLC. In this case the value of the tag in the PLC 
is different from the current status of the key.

Carry out the following configuration steps so that the illuminated pushbutton always reflects 
the actual state.
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Basic procedure
1. Specify the connection to the PLC in the "Connections" editor. Activate the "Coordination" 

area pointer to ensure that the life bit is available to the PLC side.

2. Open the "HMI tags" editor and create three tags.

– Internal tag: Pushbutton_State

– External tag: BufferTag

– External tag: Pushbutton_PLC

3. Open the Inspector window of the "Pushbutton_State" tag.

4. In the Inspector window, select "Properties > Events > Value change". Click the first line of 
the function list. The list opens, showing the system functions available in the project.

5. Select the "SetTag" system function.

– Select the "Pushbutton_PLC" tag at "Tag (output)".

– Select the "Pushbutton_State" tag at "Value".

The value of the "Pushbutton_PLC" tag is written to the PLC with the "Pushbutton_PLC" 
tag. A program in the PLC evaluates the life bit. If communication is established, the 
current value is written to the "Pushbutton_PLC" tag from the PLC. The "BufferTag" is 
required to transfer the current position of the pushbutton to the PLC.
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6. Open the Inspector window of the "BufferTag" tag.

7. In the Inspector window, select "Properties > Events > Value change".

8. Click the first line of the function list. The list opens, showing the system functions available 
in the project.

9. Select the "SetTag" system function.

– Select the "Pushbutton_PLC" tag at "Tag (output)".

– Select the "Pushbutton_State" tag at "Value".

After establishing communication the current value is written to the "BufferTag" from the 
PLC. The "SetTag" system function is executed by the value change in the auxiliary tag. 
The system function re-allocates the value of the "Pushbutton_State" tag to the 
"Pushbutton_PLC" tag.

10.Open the global screen in the "Screen navigation" editor.

11.Select the illuminated key on the global screen.

12.Select the tag "Pushbutton_State" in "Properties > Properties > General > Settings >Tag" 
in the Inspector window.
If you press the illuminated pushbutton, the value is written to the "Pushbutton_PLC" tag.

LED assignment
To actuate the LED an LED tag or an array tag must be set up in the PLC and specified as an 
LED tag during configuration. The LED tag is specified at "LED tag" in the "Settings" area in 
the "General" group. With "LED bit" the allocated bit is given. When the bit is set the following 
states of the LED can be realized in runtime.

Bit n+1 Bit n LED function
0 0 Off
0 1 Fast flash
1 0 Slow flash
1 1 On permanently
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See also
Device-Specific Nature of the Objects (Page 3508)

Handwheel (Page 3555)

Line

Application  
The "Line" object is an open object. The line length and gradient slope are defined by the height 
and width of the rectangle enclosing the object. 

Layout  
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line style

● Line start and end

Line style 
The representation of the line is specified under "Properties > Properties > Appearance" in the 
Inspector window. The line is shown without interruption if you select "Solid", for example.

 

 Note

The line styles available depend on the selected HMI device.
 

Line start and end     
The start and end points of the line are specified under "Properties > Properties > Appearance 
> Line ends" in the Inspector window. 

Use arrow point, for example, as start and end point. The available start and end points depend 
on the device.

See also
Device-Specific Nature of the Objects (Page 3508)
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List box

Application  
You use the "List box" object to present and select multiple list entries. You activate list entries 
by default so that the operator only changes the preset entry if necessary. If the list box is 
larger than the selection rectangle, WinCC automatically adds a scroll bar to the right margin.

To incorporate list fields into the process, dynamize the corresponding properties.

Layout  
In the Inspector window, you customize the position, style, colors and font type settings of the 
object. You can adapt the following properties in particular:

● Number of entries: Defines the number of list entries.

● Selection of entries: Defines which entry is displayed as activated by default.

Defining the number of entries
1. In the Inspector window, select "Properties > Properties > General".

2. Define the desired number of list entries under "Entries".

At the same time, the value of the "Entries" attribute specifies the upper limit for the "Index" 
property under "Label." Changing the value can have the following effects:

Changing the number
New fields are added under the field with the highest value for the "Index" property if you 
increase the number of entries. You can change the default label for the new field using the 
"Text" property under "Label."

All fields for which the value of the "Index" property is higher than the new number will be 
deleted if you reduce the number of entries.

Specifying the default setting of the list boxes
Specify which list entry is displayed as active with "Properties > Properties > General > 
Presetting enabled".

Each option is represented by a bit in a 32-bit word. To activate a field, the corresponding bit 
must have the value "1". The 32-bit word contains the information for all texts of the list of list 
boxes. The value of the "Selected fields" property is given in hexadecimal notation. 
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See also
Device-Specific Nature of the Objects (Page 3508)

Combo box (Page 3563)

Media Player

Application   
The Media Player is used in Runtime to play back video or audio files.

The Media Player is only available for the following devices:

● MP 377

● Comfort Panels

Layout   
You can set the following properties in the Inspector window:

● Display status bar: Determines whether to display the status bar.

● Display control elements: specifies the control elements during runtime.

● Show seek: establishes, whether a slider is available for the operation.

Control elements   
The control elements that can be used to control the Media Player in Runtime are specified in 
the Inspector window under "Properties > Properties > Appearance > Elements". 
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Supported file formats
The following audio formats are supported by Media Player:

● Moving Picture Experts Group standard 1, Layer 1,2, 3 (.mpa, .mp2, .mp3)

● Windows Media Audio (.wma)

● Waveform Audio (.wav)

The following video formats are supported by Media Player:

● Moving Picture Experts Group standard 1 (.mpg, .mpeg, .mpv, .mpe)

● Advanced Streaming Format (.asf)

● Windows Media Video Format (.wmv)

● Audio-Video Interleaved (.avi)
 

 Note

Media Player does not support the creation and management of favorites. If you create 
favorites before closing the Media Player, they will not reappear when you open it again. 

 

See also
Device-Specific Nature of the Objects (Page 3508)

Alarm view

Use       
Alarms are indicated in the Alarm view or in the Alarm window of the HMI device. The following 
screen contains an alarm view with no content:
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Alarm view       
The following figure shows an alarm view:

 

Alarm line       
The alarm line allows display of the most current pending alarm in Runtime. The following 
figure shows an alarm line:

How to configure the alarm line: 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select "Mode > Alarm line".

Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. 

 

 Note

The fonts available for selection depend on the "Language and fonts" you have configured 
in the device settings and the fonts your HMI device supports.

 

You can adapt the following properties in particular:

● Control elements: Defines the operator controls of the alarm view.

● Alarm classes: This setting defines which alarm classes are displayed in the alarm view.
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● Columns: Specifies the displayed columns in Runtime.

● Sequence of columns: Specifies whether the sequence of columns can be changed in 
Runtime.

● Identification of alarm classes: To be able to distinguish various alarm classes, they are 
identified in the first column of the alarm view.

● Filter: Defines that only alarms that contain a specific character string will be displayed in 
the alarm text.

● Enable sorting: Specifies whether the alarms can be sorted in runtime by date and time.

● Defining display area This setting specifies from which date on alarms are displayed in the 
alarm view.

 

  Note

If you have different alarm classes output, these will be initially sorted into alarm classes 
in runtime, and then by when the alarm occurred.

 

Control elements     
The control elements that can be used to control the alarm view in Runtime are specified in 
the Inspector window under "Properties > Properties > Display > Settings". The following table 
shows the control elements in the alarm view, and what they do:

Button  Function
"Tooltip" Displays a tooltip for an alarm.

"Acknowledge" Acknowledges an alarm.

"Loop-In-Alarm" If a screen change is configured, the display switches to a screen 
containing information about the alarm.

Select alarm classes
1. Click "Properties > Properties > General" in the Inspector window.

2. Under "Alarm classes" activate the alarm classes to be displayed in the alarm view in 
Runtime .

Access protection in Runtime
Configure access protection in the "Properties > Security" group in the properties of the alarm 
view. If a logged-on user has the required authorization, he can acknowledge and edit alarms 
using the operator controls in the alarm view. If the logged-in user does not have the required 
authorization, or if no user is logged in, pressing the "Acknowledge" or "Edit" buttons or double-
clicking an alarm line opens the login dialog.
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Define columns     
Define the columns to be displayed in the alarm view in Runtime in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate the columns that are to be displayed in Runtime under "Columns".

Sequence of columns
If this property is enabled, the column sequence in the alarm view can be changed in Runtime.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Column properties > Column order".

Enable sorting     
If this property is enabled, the alarms displayed in the alarm view in Runtime can be sorted by 
date and time.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Column properties > Sorting by date/time possible".

Filtering alarms
This property is used to define that only alarms that contain a configured string will be displayed 
in the alarm text in runtime for the extended alarm view.

1. In the Inspector window, select "Properties > Properties > Filter.

2. Enter the required term for filtering in the field "Filter string".
Alternatively, you configure a filter tag using the field "Filter tag". The contents of the filter 
tag serve as the filter criterion in runtime.

Identify alarm classes             
An icon is displayed in the first column of the alarm view. This symbol allows the alarm to be 
allocated to an alarm class.

1. In the Inspector window, select "Properties > Properties > Columns".

2. Activate "Columns > Alarm class".

3. Open the "Alarms" editor, and click the "Alarm Classes" tab.

4. Specify an icon for use to identify the alarms of this alarm class for an alarm class in the 
"Display name" column.

 

  Note

The "alarm view" object cannot be grouped. 
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Defining display area
You select a tag which defines the time from which alarms should be displayed. The following 
data types are permitted:

● External tags: Date, Date_and_Time, Time_of_Day

● Internal Tags: DateTime

To define the display area, proceed as follows:

1. Click "Properties > Properties > Display" in the Inspector window.

2. Define the tag in which the time is specified under "Control tag for the display area".

Configuration behavior

Displaying column headers
The layout of the alarm view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Layout tab" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 

Displaying the buttons for operation
The alarm view in the HMI devices OP 73, OP 77A and TP 177A has a button which displays 
the alarm text in a separate window. This button is not shown during configuration.

The display of the buttons for using the alarm view depends on the configured size. You should 
check on the HMI device whether all necessary buttons are available.

See also
Device-Specific Nature of the Objects (Page 3508)

Alarm window (Page 3588)

Alarm indicator  (Page 3590)

Configuring an alarm view for active alarms (Page 3963)
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Alarm view

Application   
The "Alarm view" object displays alarms that occur during the process in a plant. You also use 
the alarm view to visualize alarms in list format. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term). 

Layout   
In the Inspector window, you customize the position, shape, style, color and font type of the 
object. You can adapt the following properties in particular:

● Control elements: Defines the operator controls of the alarm view.

● Status bar: Defines the elements in the status bar.

● Time base: Defines the time basis used to output the alarms.

● AutoScroll: Defines whether it is always the latest alarm that is selected in the alarm view.

● Text format: Defines the font and font size.

● Sorting: Defines whether and how the alarms can be sorted in Runtime.

● Table: Defines the properties of the table in the alarm view.

● Loop-In-Alarm: Defines whether double-clicking an alarm triggers the configured screen 
change.

 

  Note

The "alarm view" object cannot be grouped. 

You only configure a script at the "Incoming" event
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Configuring output of alarms     
● Selection of displays and filters: Defines which alarms are displayed in this alarm view.

● Alarm statistics: Activates the display of a statistical overview for the display duration and 
frequency of the alarms.

● Print: This setting defines which print job is used for the alarm view.

Control elements     
You define the control elements of the alarm view in Runtime, and their operator authorizations, 
under "Properties > Properties > Toolbar" in the inspector window. The following control 
elements are available for the alarm view:

Button Function
Display "Current alarms" Shows the currently active alarms.

Display "Historical alarm 
list" (short-term)

Shows the logged and currently active alarms. 

Display "Historical alarm 
list" (long-term)

Shows the logged alarms. 

Display "Locked alarms" Shows all locked alarms in the system.

Display "Alarm statistics" Displays a statistical overview for the display duration and 
frequency of the alarms.

"Alarm annunciator 
acknowledgment"

Acknowledges a visual, or audible signaling device.

"Single acknowledgment" Acknowledges an individual alarm.

"Group acknowledgment" Acknowledges all active visible alarms in the alarm view that 
require acknowledgment, unless they are subject to single 
acknowledgment.

"Autoscroll" Defines whether it is always the latest alarm that is selected in 
the alarm view. The visible area of the alarm view moves, if 
necessary. 
You can only select individual alarms if "Autoscroll" is not active.

"Filter" Opens a dialog for filtering alarms in the alarm view. Even 
alarms that are not displayed in the filtered view will be logged.

"Display Options" dialog Opens a dialog for defining which alarms are displayed in the 
alarm view. 
If the "All alarms" option is selected, the alarm view displays 
both hidden, and visible alarms.
If the "Visible alarms" option is activated, the alarm view 
contains only visible alarms.
If the "Hidden alarms" option is activated, the alarm view 
contains only hidden alarms.
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Button Function
"Lock dialog" Opens a dialog for locking alarms. Any alarms that meet these 

criteria are neither displayed, nor logged.

"Print alarm report" Prints the alarm report that is configured for the alarm view.

"Print current view" Starts printing the alarms displayed in the alarm view. 

"Emergency 
acknowledgment"

Applies emergency acknowledgment to an alarm that requires 
acknowledgment. The acknowledgment bit for an alarm is sent 
directly to the AS, even if the alarm is not active.

"First alarm" Selects the first of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

"Last alarm" Selects the last of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

"Next alarm" Selects the next alarm in relation to the currently selected 
alarm. The visible area of the alarm view moves, if necessary. 
This button can only be used if the "Autoscroll" function is 
disabled.

"Previous alarm" Selects the previous alarm in relation to the currently selected 
alarm. The visible area of the alarm view moves, if necessary. 
This button can only be used if the "Autoscroll" function is 
disabled.

"Infotext dialog" Opens a dialog to display a tooltip.

"Comment dialog" Opens a text editor where you can enter comments.
This button is not available in the alarm view unless the 
"Historical alarm list (long-term)" display is displayed. 

"Loop-In-Alarm" If a screen change is configured, the display switches to a 
screen containing information about the alarm. 

"Unlock alarm" Unlocks an alarm in the display "Locked alarms."

"Lock alarm" Locks an alarm in the current alarm list, and in the alarm log 
lists. The alarm is added to the display "Locked alarms."

"Sort dialog" Opens a dialog for setting user-defined sort criteria for the 
displayed alarms. 

"Time base dialog" Opens a dialog for selecting the time base for the time data 
displayed in alarms.

"List of hidden alarms" Opens the display "Hidden alarms." 

"Hide alarms" Suppresses the display of an alarm in the displays "Current 
alarms", "Historical alarm list (short-term)" or "Historical alarm 
list (long-term)." The alarm is added to the display "Hidden 
alarms."

'Show alarm" Shows in the display "Hidden alarms" again an alarm in the 
displays "Current alarms", "Historical alarm list (short-term)" or 
"Historical alarm list (long-term)." The alarm is removed from 
to the display "Hidden alarms."
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Status bar   
You define which of the elements of the status bar are displayed using "Properties > Properties 
> Status bar" from the Inspector window. The following display elements are available for the 
alarm view:

Button Function
Date System date
Time System time

Lock is set.
A filter is activated.

List: Number of current alarms
Window: Number of alarms in the window
Ackn: Number of active alarms requiring acknowledgment

Access protection in Runtime   
Configure access protection under "Properties > Properties > Security" in the Inspector 
window. If a logged-on user has the required authorization, he can acknowledge, and edit 
alarms using the control elements in the alarm view.

The logon dialog box is displayed in the following cases:

● The logged-on user attempts to process the alarm but does not have the required 
authorization.

● A user attempts to process an alarm while no user is logged on.

Set timebase     
1. In the Inspector window, select "Properties > Properties > General".

2. Select the required timebase under "Properties > Properties > Miscellaneous > Time base."

3. Under "Time-based standard sort", define whether the alarms are sorted in ascending or 
descending order in Runtime.

Enable Autoscroll     
1. In the Inspector window, activate "Properties > Properties > Layout > Window > Autoscroll".

Define text format     
To format the alarm text:

1. In the Inspector window, select "Properties > Properties > Text format".

2. Click the "..." button in the "Font" area.
A dialog opens.

3. Select the font and size in the dialog.
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Set up sort order     
1. In the Inspector window, select "Properties > Properties > Columns".

2. Select sort criteria and sorting order.

Set to a table in the alarm view     
1. Click "Properties > Properties > Table font" in the Inspector window.

2. Define settings for the rows and cells in the "Table body" area.

– "Optimum line height" activated: The font is aligned to the height of the line.

– "Truncate cell contents": If the text is longer than the cell, the text is displayed truncated.

3. In the "Line numbering" area, define whether each row has a header.

4. Select the column header layout from the "Column headers" area.

Set Loop-In-Alarm   
1. In the Inspector window, click "Properties > Properties > Miscellaneous".

2. Activate the "Loop-In-Alarm with double-click" option.

Displaying column headers
The layout of the alarm view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is available in the Control 
Panel, "Display" > "Appearance" tab. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime. 
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See also
Device-Specific Nature of the Objects (Page 3508)

Configuring an alarm view for active alarms (Page 3963)

Alarm window

Use   
Alarms are indicated in the Alarm view or in the Alarm window of the HMI device. The layout 
and operation of the Alarm window are similar to that of the Alarm view. The Alarm window 
has the following characteristics that are the same as in the Alarm view:

● Alarm window

● Alarm line: The alarm line is not available on Basic Panels.

The Alarm window is configured in the "Global screen" editor. 

The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged. 

 

 Note

In the engineering system you dynamize, for example, the visibility of an object in "Properties 
> Animations" in the Inspector window. In runtime, the "Simple alarm window" object does 
not support animations. If you have configured an animation and, for example, wish to perform 
a consistency check of the project, then an error alarm is issued in the Output window.
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Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You configure the Alarm window in the same way as the Alarm view. In addition 
you adapt the following properties:

● Fixed alarm window: Specifies that the Alarm window retains the focus after a screen 
change.

● Window: You define the operator input and response of the Alarm window in runtime.
 

  Note

If you have different alarm classes output, these will be initially sorted into alarm classes 
in runtime, and then by when the alarm occurred.

 

Operator controls   
The control elements that can be used to control the alarm view in runtime are specified in the 
Inspector window under "Properties >Display > Settings". The following table shows the control 
elements in the Alarm window, and what they do:

Button  Function
"Tooltip" Displays a tooltip for an alarm.

"Acknowledge" Acknowledges an alarm.

"Loop-In-Alarm" If a screen change is configured, the display switches to a screen 
containing information about the alarm.

Access protection in Runtime
Configure access protection under "Properties > Properties > Security" in the Inspector window 
of the alarm view. If a logged-on user has the required authorization, he can acknowledge and 
edit alarms using the operator controls in the alarm view. If the logged-in user does not have 
the required authorization, or if no user is logged in, clicking the "Acknowledge" or "Edit" buttons 
or double-clicking an alarm line opens the login dialog box.

 

 Note
Basic Panels

Access protection is not available for Basic Panels.
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Activating the focus of the Alarm window
Select the following option so that the Alarm window does not lose the focus after a screen 
change:

1. In the Inspector window, select "Properties > Properties > Mode".

2. Enable "Label".

Window
Define the response of the Alarm window under "Properties > Properties > Mode > Window" 
in the Inspector window. The following table shows the possible properties:

Option Function
Automatic display The Alarm window is automatically displayed when a system alarm 

occurs, for example.
Closable The window closes again after a set time has elapsed. You define the 

display duration in the alarm settings. 
Modal The Alarm window is linked to a confirmation, such as: Alarm must be 

acknowledged. If the modal alarm window has the focus, the buttons in 
the screen behind it cannot be used. The functions configured on a 
function key are carried out. 

Sizeable You can change the size of the Alarm window in runtime.

See also
Device-Specific Nature of the Objects (Page 3508)

Alarm view (Page 3578)

Alarm indicator  (Page 3590)

Configuring an alarm window (Page 3969)

Alarm indicator 

Application  
The alarm indicator is a graphic symbol that shows current errors or errors that need to be 
acknowledged, depending on the configuration. The alarm indicator is configured in the "Global 
screen" editor. The following figure shows an alarm indicator:
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Alarm indicator OP 73
A "simple" alarm indicator is available for the HMI OP 73. The following diagram shows the 
alarm indicator for the OP 73 HMI devices:

The "simple" alarm indicator shows alarms to be acknowledged or alarms which have already 
been acknowledged and have not yet gone. Only the position can be defined for the "simple" 
alarm indicator. The alarm indicator is displayed on the device at the selected position. If you 
have configured a screen object at this position, the visible alarm indicator covers the screen 
object. The alarm indicator is covered by system dialogs, such as the login dialog, Help dialog, 
and alarm windows. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Alarm classes: Establishes the alarm classes where the alarm indicator is displayed.

● Operator control in Runtime: Defines the operator actions in Runtime that cause the Alarm 
window to open.

Alarm classes  
You define which alarm classes are shown with an alarm indicator in "General > Alarm classes" 
in the Inspector window. Alarm classes, such as "Warnings" or "Errors".

Define operator control in Runtime  
1. Select the alarm indicator in the screen.

2. Click "Events > Click" or "Click when flashing" in the Inspector window.

3. The "function list" opens. Click the first line of the function list. The list of system functions, 
and scripts available in the project opens.

4. Select the "ShowAlarmWindow". system function under "Alarms."

5. Under "object name" select the name of the Alarm window from the selection list. Under 
"Layout", define whether the Alarm window should be visible, hidden, or should toggle 
between the two states.

See also
Device-Specific Nature of the Objects (Page 3508)

Alarm view (Page 3578)

Alarm window (Page 3588)

Configuring an alarm indicator  (Page 3970)
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Option buttons

Application
You use the "Option button" object to display, and select various options. Only one of these 
options can be selected respectively by the operator. Enable one of the options by default so 
that the operator only changes the default value if necessary. To incorporate an option button 
into the process, dynamize the corresponding attribute.

Layout
In the Inspector window you can customize the settings for the object position, geometry, style, 
frame and color. You can adapt the following properties in particular:

● Number of fields

● Selection of the fields: Specifies which fields are displayed as activated.

Specifying the number of fields
You specify the number of fields in the Inspector window:

1. Click "Properties > Properties > General" in the inspector window.

2. Define the desired number of fields in the area "Label > Number of fields".

The value of the "Number of fields" property also indicates the upper limit value for the "Index" 
property. Changing the value can have the following effects:

● Increasing the number of fields
New fields are added under the field with the highest value of the "Index" property. The 
standard label of the new field is changed with "Font > Text".

● Decreasing the number of fields
All fields for which the value of the "Index" property is greater than the new number are 
removed.

Specifying the default setting of the option buttons
The "Default" property is used to specify which of the fields of the option buttons are to be 
displayed as active. If the default setting for the field is that it is to be activated, activate the 
"Default" field under "General" in the table row. Only one field may be activated at any time. 
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See also
Device-Specific Nature of the Objects (Page 3508)

Check box  (Page 3563)

PLC code display

Application
The "PLC Code Display" object is available for the HMI device, WinCC Runtime Professional. 
It is used to display the current program status of PLC programs, which have been programmed 
in the LAD, FBD or S7-GRAPH programming languages. Errors during execution of an S7-
GRAPH sequencer are displayed directly at the corresponding step.

 
 

 Note

The "PLC Code Display" object cannot be used in groups or faceplates.
 

Layout
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Buttons on the toolbar

Display network
The network to be displayed in the PLC code display is determined by user-defined functions. 
You can find detailed information in the Description of the API Functions.
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Supported instructions
The following FBD instructions are supported in the PLC code display: 

● AND

● OR

● EXCLUSIVE OR

● NOT

● Set output

● Reset output

● Assignment

● Reset/set flip-flop

The following LAD instructions are supported in the PLC code display: 

● Normally open contact

● Normally closed contact

● Negated contact

● NOT

● Set output

● Reset output

● Assignment

● Reset/set flip-flop

Polygon

Application   
The "Polygon" is a closed object which you can fill with a background color. 

Layout     
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. In particular, you can customize the following property:

Geometry: Modifies, deletes or adds corners.
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Geometry         
The corner points are numbered in the order of their creation. You can change, delete, or add 
more corner points:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required corner point in the "Geometry" area. Input a value at "X position " and 
"Y position ".

3. To add a corner point, click the  button.

4. To delete a corner point, click the  button.

Alternative procedure
You can also change, delete, or add new corner points using the mouse:

1. Select the object. Position the mouse cursor on the desired corner. The mouse cursor 
changes to a crosshair.

2. Drag the corner to the desired position while holding down the mouse button.

3. Right-click the position at which you want to insert the corner point. Select "Add point" from 
the shortcut menu.

Configuring Rotation in runtime
You configure the "Polygon" object so that it rotates about a reference point in runtime. The 
rotation in runtime is only possible for devices with Runtime Professional.

Enter the values for the angle of rotation using Degrees as the unit.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter values for the following attributes in the "Rotation" area.

– X

– Y

– Angle

See also
Polyline  (Page 3596)

Rotating an object in runtime (Page 3363)
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Polyline 

Application   
The "Polyline" is an open object. Use the "Polygon" object if you want to fill the object with 
color.

Layout   
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line start and end: Specifies the type of line start and line end.

● Geometry: Modifies, deletes or adds corners.

Line start and end         
You define the start point and the end point of the line under "Properties > Properties 
>"Appearance" in the Inspector window. Use arrow point, for example, as start and end point. 
The available start and end points depend on the device.

Geometry         
The corner points are numbered in the order of their creation. You can change, delete, or add 
more corner points:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the required corner point in the "Geometry" area. Input a value at "X position" and 
"Y position".

3. To add a corner point, click the  button.

4. To delete a corner point, click the  button.

Alternative procedure
You can also change, delete, or add new corner points using the mouse:

1. Select the object. Position the mouse cursor on the desired corner. The mouse cursor 
changes to a crosshair.

2. Drag the corner to the desired position while holding down the mouse button.
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Configuring rotation in Runtime
You configure the "Polyline" object so that it rotates about a reference point in Runtime. The 
rotation in Runtime is only possible for devices with Runtime Professional.

Enter the values for the angle of rotation using Degrees as the unit.

1. Click "Layout" in the Inspector window.

2. Enter values for the following attributes in the "Rotation" area.

– X

– Y

– Angle

Further information can be found in "Device-Specific Nature of the Objects (Page 3508)".

See also
Polygon (Page 3594)

Rectangle

Application 
The "Rectangle" is a closed object which you can fill with a color. 

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Corner radius: Specifies the horizontal and vertical distance between the corner of the 
rectangle and the start point of a rounded corner.

Corner radius   
The corners of the "Rectangle" object can be rounded to suit your requirements. When the 
properties "X" and "Y" are set to the 100 % value, the rectangle is displayed as an ellipse. As 
soon as one of the properties has the value 0%, a normal rectangle without a rounded corner 
is shown.

1. Click "Properties > Properties > Layout" in the inspector window.

2. Enter a value for "X" in the "Corner radius" area.
The input value is the percentage proportion of half the width of the rectangle.

3. Enter a value for "Y" in the "Corner radius" area.
The input value is the percentage proportion of half the height of the rectangle.
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See also
Device-Specific Nature of the Objects (Page 3508)

Recipe view

Application   
The "Recipe view" object is used to display and modify recipes.

Advanced recipe view       
Both the advanced and the "Simple recipe view" can be used to administer and process recipes 
on HMI devices with a display larger than 6".

Configuring the advanced recipe view:

1. Click "Properties > Properties > General" in the Inspector window.

2. Activate "Format > Advanced view" in the "Display type" area.

Simple recipe view       
The "Simple recipe view" is used for display and processing of recipes on HMI devices with a 
display size less than 6". 

 

 Note

Do not use the simple recipe view in a group.
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Configuring the simple recipe view:

1. In the Inspector window, select "Properties > Properties > General".

2. Activate ""Display type" > Basic view".
 

  Note
Behavior for Runtime Professional, Runtime Advanced and Panels

In the Engineering System you can dynamically control the visibility of an object, for 
example, in the "Animations" tab of the Inspector window. In Runtime, the "Simple recipe 
view" does not support animations. If you have configured an animation and, for example, 
want to check the consistency of the project, an error alarm is displayed in the Output 
window. 

 

Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Control elements: Defines the control elements of the recipe view.

● Display number: establishes if the number of the recipe and the number of the recipe data 
record is displayed.

Control elements     
The control elements with which the recipe view is operated in runtime are configured under 
"Properties > Buttons" in the inspector window. In the simple recipe view the operating 
elements are based on the functions of the menu.

Control element  Description
"Tooltip" Calls up the configured tooltip for the selected 

recipe.
"New record" Creates a new recipe data record in the recipe.
"Delete record" Deletes the selected record.
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Control element  Description
"Saving" Saves the modified record with its current name.
"Save as" Saves the modified record with a new name.
"Write to PLC" Sends the current value to the PLC.
"Read from PLC" Reads the current value from the PLC.
"Synchronizing recipe tags" Compares the values of the selected record with 

the values on the PLC.

Display number     
Specifies whether the number of the recipe and the number of the recipe data record are 
displayed during runtime. The number of the recipe uniquely identifies the recipe in the project.

1. Click "Properties > Properties > View" in the Inspector window.

2. Activate "Display > Display numbers".

Configuration behavior

Displaying column headers
The layout of the recipe view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Appearance" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime.

 

See also
Device-Specific Nature of the Objects (Page 3508)

Simple recipe view (Page 4176)

Advanced recipe view (Page 4180)

Recipe view

Use   
The "Recipe view" object is used to display and modify recipes.
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Layout     
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Log/View: Defining a recipe or recipe query

● Toolbar: Defines the control elements of the recipe view.

● Columns: Specifies the columns that are displayed in the recipe data record.

Log/View
Define the recipe or recipe query to be displayed in the recipe view under "Properties > 
Properties > General > Log/View" in the Inspector window.

Toolbar     
The control elements with which the recipe view is operated in Runtime are configured under 
"Properties > Properties > Buttons" in the Inspector window. In the simple recipe view the 
operating elements are based on the functions of the menu.

Control element  Description
"Tooltip" Calls the info text for the recipe display.
"Configuration dialog" Opens the configuration dialog box in which you 

change the properties of the recipe display.
"Select data connection" Opens a dialog for selecting a recipe or recipe 

query. The recipe data are then shown in the table 
of the recipe view.

"First row" The first data record is displayed in the table by 
the button. 

"Previous row" The previous data record is displayed in the table 
by the button.
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Control element  Description
"Next row" The next data record is displayed in the table by 

the button.
"Last row" The last data record is displayed in the table by 

the button.
"Delete row" The content of the marked lines are deleted.
"Cut lines" The content of the marked lines are cut out.
"Copy lines" The content of the marked lines are copied.
"Insert lines" The content of the copied or cut-out lines is 

inserted starting from the marked line.
"Read tags" The contents of the connected WinCC tags are 

read and written into the recipe elements by the 
button. The "Tags" communication type must be 
activated in the displayed recipe to be able to use 
the button. The recipe elements must be 
connected with tags.

"Write tags" The contents of the recipe elements are written 
into the connected WinCC tags. The "Tags" 
communication type must be activated in the 
displayed recipe to be able to use the button. The 
recipe elements must be connected with tags.

"Import Archive" Using a button, a CSV file is imported from the 
"ua" directory of the project folder into the table of 
the recipe view.

"Export archive" The original contents of the table are exported 
with table headers by the button when loading. 
The recipe is stored as a CSV file in the "ua" 
directory of the project folder. 

"Sort dialog" Opens a dialog box for setting a customized 
sorting of the displayed columns.

"Print" Starts the printout of the displayed values. The 
print job used for printing is defined in the 
configuration dialog in the "General" tab. 

"Set time base" Opens a dialog box for setting the time base for 
the used times.

"Export data" Using a button, you can export the recipe or recipe 
query to a CSV file as configured but with the 
current runtime data. If the "Display dialog" option 
is active, a dialog opens in which you can view the 
settings for exporting and can start the export. 
With the appropriate operator authorizations you 
may also select the file and the directory for export.
If no dialog is displayed, export of data to the 
default file is started immediately.

"User-defined" Displays the first button created by the user. The 
function of the button is customized.

Columns
In the Inspector window under "Properties > Properties > Columns > Column properties", you 
define which columns are displayed in the recipe view.
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Configuration behavior
Displaying column headers

The layout of the recipe view is dependent on the view settings in the control panel. Depending 
on the setting, the column headers may be truncated. This setting is found under "Display > 
Appearance" in the control panel. To display column headers correctly, set the display in 
"Windows and buttons" to "Windows Classic" style.

This behavior only occurs during configuration. The column headers are displayed correctly 
in Runtime.

See also
Device-Specific Nature of the Objects (Page 3508)

Displaying recipes (Page 4247)

Properties of the recipe view (Page 4248)

Editing recipe data (Page 4273)

Round button

Application
The "Round button" object is used to control processes. A round button is used, for example, 
to confirm alarms. To incorporate a round button into the process, dynamize the corresponding 
attribute. 

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. In particular, you can customize the following property:

Mode: Specifies whether the round button is shown pressed or as a toggle switch.

Type: The round button can be shown, for example, with text and graphic. 

Show round button pressed
1. In the Inspector window, select "Properties > Properties > General".

2. Activate "Mode > Pressed".

3. To show the round button as two-way switch, activate "Mode > Toggle".
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Specifying the round button type
1. In the Inspector window, select "Properties > Properties > General".

2. Select, for example, "Graphics and text" as "Type".

See also
Device-Specific Nature of the Objects (Page 3508)

Pipe

Application
You reproduce a continuous pipe with several bends with the object "Pipe". To reproduce a 
pipe system, connect the "Pipe" object to other objects, e.g. pipe bend or T piece.  

 

Layout
Customize the object position and color in the Inspector window. You can adapt the following 
properties in particular:

● Geometry: You add additional points and extend the object.

A pipe may have any number of corners. The corner points are numbered in the order of their 
creation. You can move them individually. 

See also
Device-Specific Nature of the Objects (Page 3508)

Double T-piece (Page 3528)

Pipe bends (Page 3605)

T piece (Page 3635)
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Pipe bends

Application
A pipe bend is displayed using the "Pipe bend" object. To reproduce a pipe system, connect 
the "Pipe bend" object to other objects, e.g. pipe bend or double T piece. 

 

Layout
Customize the object position and color in the Inspector window. You can adapt the following 
properties in particular:   

● Angle: You specify the start and end angle of the pipe bend. 

● Radius: You specify the horizontal and vertical radius of the pipe bend. 

The attributes are interdependent. 

● When you change "Start angle" and "End angle", the width and height are also automatically 
changed.
"Horizontal radius " and "Vertical radius" are retained.

● When you change "Horizontal radius" and "Vertical radius", the width and height are also 
automatically changed.
"Start angle" and "End angle" are retained.

● When you change the width and the height, the "Horizontal radius" and "Vertical radius" 
are also automatically changed.
"Start angle" and "End angle" are retained.

 

See also
Device-Specific Nature of the Objects (Page 3508)

Double T-piece (Page 3528)

Pipe (Page 3604)

T piece (Page 3635)
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S7-GRAPH Overview

Use
The "S7-GRAPH Overview" object is available for the HMI device, WinCC Runtime 
Professional. This object is used to display the current program status for executed steps of 
the PLC sequencer. Errors during execution of a program are displayed directly at the 
corresponding step.

The following information is displayed with the "S7-GRAPH Overview" object:

● Name and status of the function block

● Status of initial and simultaneous steps

● Number and name of the first step currently executed step
 

 Note

The "S7-GRAPH Overview" object cannot be used in groups or faceplates.
 

Layout
In the Inspector window, you customize the position, style, colors and font types of the object. 
You can adapt the following properties in particular:

● Assigned GraphDB tag

Display the current program status 
1. In the Inspector window, select "Properties > Properties > General".

2. Open the selection button under the "Assigned GraphDB tag" property.
The "Add new object" dialog opens. 

3. Select the corresponding PLC in the "Program blocks" folder. 

4. Select the interface tag of the S7-GRAPH DB. Make sure that the tag is visible in the HMI 
and accessible from the HMI.
The system checks if there is a connection between the HMI and the selected PLC. If there 
is no connection, it is automatically established. 
In addition, a HMI tag is created which is connected to the control tag. 

You can dynamize the properties in the "S7-GRAPH Overview" object using tags and color-
code the states. You can find a detailed description of dynamizing a property in the section 
Configuring property animation of the Range type (Page 3437).
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See also
Configuring property animation of the Range type (Page 3437)

Objects for WinCC Runtime Professional (Page 3517)

Switch 

Application   
The "Switch" object is used to configure a switch that is used to switch between two predefined 
states in runtime. The current state of the "Switch" object can be visualized with either a label 
or a graphic.

The following figure shows a "Switch" type switch.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. In particular, you can customize the following property:

● Type: Defines the graphic representation of the object.

Type   
Button visualization is specified at "Properties > Properties > General >Type" in the Inspector 
window.

Type Description
"Switch" The two states of the "Switch" are displayed in the form of a switch. The 

position of the switch indicates the current state. The state is changed in 
runtime by sliding the switch. 
You specify the direction of movement of the switch in "Switch orientation" 
with this type.

"Switch with text" The switch is shown as a button. The current state is visualized with a label. 
In runtime click on the button to actuate the switch.

"Switch with graphic" The switch is shown as a button. The current state is visualized with a graphic. 
In runtime click on the button to actuate the switch.

 

 Note
Basic Panels

The "Switch" type is not available for Basic Panels. 
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See also
Device-Specific Nature of the Objects (Page 3508)

Overview of objects (Page 3336)

Button

Application   
The "Button" object allows you to configure an object that the operator can use in runtime to 
execute any configurable function. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Defines the graphic representation of the object.

● Text / Graphic: Defines whether the Graphic view  is static or dynamic.

● Define hotkey: Defines a key, or shortcut that the operator can use to actuate the button.
 

  Note

You can only define a hotkey for HMI devices with keys.
 

Mode     
The button display is defined in "Properties > Properties > General >Mode" in the Inspector 
window.

Mode Description
"Invisible" The button is not visible in runtime.
"Text" The button is displayed with text. This text explains the function of the button.
"Graphic" The button is displayed with a graphic. This graphics represents the function of the 

button.

Depending on the device, further options are available.

Text / Graphic 
The "Mode" property settings are used to define whether the display is static or dynamic. The 
display is defined in "Properties > Properties > General >Text" or "Graphic" in the Inspector 
window.
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You can, for example, select the following options for the "Graphic" or "Text" type.

Type Option Description
"Graphic" "Graphic" Use "Graphic when button is "not pressed"" to specify a graphic displayed 

in the button for the "OFF" state. 
Use "Graphic when button is "pressed"" to specify a graphic for the "ON" 
state.

"Graphics 
list"

The graphic in the button depends on the state. The corresponding entry 
from the graphics list is displayed depending on the state.

"Text" "Text" Use "Text when button is "not pressed"" to specify the text displayed in 
the button for the "OFF" state.
Use "Text when button is "pressed"" to specify text for the "ON" state.

"Text list" The text in the button depends on the state. The entry from the text list 
corresponding to the state is displayed.

Define hotkey     
In the Inspector window, a key or key combination is defined that the operator can use to 
control the button in runtime.

1. In the Inspector window, select "Properties > Properties > General".

2. Select a key or key combination from the selection list in the "Hotkey" area.

 

See also
Device-Specific Nature of the Objects (Page 3508)

Example: Configuring a button for language switching (Page 3454)

Example: Configuring a button with access protection (Page 4422)

Slider

Application   
Process values are monitored and adapted within a defined range with the "Slider" object. The 
monitored range is visualized in the form of a slider. By adjusting the slider, you intervene in 
the process and correct the displayed process value.

 

 Note

Do not configure a system function at the "Change" event for a regulated project if it is used 
to execute a GMP-relevant action. 

Instead configure the system functions at the "Value change" event of the tags in order to 
reduce the number of user actions.
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Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can, in particular, adapt the following properties as required:

● Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.

● Display current value: Specifies whether the current position of the controller appears below 
the slider.

● Display of bars: The sliders above and below the bar can be hidden.

Maximum Value and Minimum Value     
The top and bottom end values of the scale are specified in the Inspector window.

1. In the Inspector window, activate "Properties > Properties > General".

2. Enter a number at "Maximum value" and "Minimum value". If you select a tag as the end 
value of the scale, the number will be no longer available.

Display current value   
Specify that the value of the current position is displayed below the slider in the Inspector 
window.

1. In the Inspector window, activate "Properties > Properties > Layout".

2. Activate "Show current value."

Display bar   
The bar can be hidden.

1. In the Inspector window, activate "Properties > Properties > Layout".

2. Deactivate "Display bar".

See also
Device-Specific Nature of the Objects (Page 3508)
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KeySwitch

Application     
The object "KeySwitch" is an optional control element for the SIMATIC Mobile Panel. The key 
switch is used to lock functions that can be triggered from the Mobile Panel.

You configure the object "key switch" object in the "global screen" or in a template.

Layout     
You can set the following properties in the Properties view:

● Tag: Specifies the tag in which the position of the key switch is written.

Tag     
The "Tag" property is used to specify the "Key switch" object assignment in the global screen 
or template. 

 

 Note
Notes on configuring

When starting runtime and every time the key is pressed the current position of the key switch 
is written to the tag. In doing so it can cause inconsistencies between the position of the key 
switch and the key switch tags.
1. If the tag has a process connection, the current value is transferred from the PLC to the 

tag after establishment of communication. The tag that contains the current position of 
the key is overwritten by this process. It can be that the key switch tag no longer reflects 
the current value of the key switch, e.g. if the Mobile Panel is switched off while the key 
is being turned.

2. If the key switch is pressed before communication with the PLC has been established 
(e.g. after a device start-up), it may not be possible to send the value of the key switch 
tag to the PLC. In this case the value of the tag in the PLC is different from the current 
position of the key.

A specific configuration is required to make sure that the key switch tag reflects the actual 
position of the key switch at all times. See the instructions below for the basic procedure.
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Basic procedure
1. Specify the connection to the PLC in the "Connections" editor. Activate the "Coordination" 

area pointer to ensure that the life bit is available to the PLC side.

2. Create three tags in the "Tag" editor.

– Internal tag: Position_Keyswitch

– External tag: Auxiliary tag

– External tag: Keyswitch_PLC

3. Open the Inspector window of the "Position_KeySwitch" tag.

4. In the Inspector window, select "Properties > Events > Value change".

5. Click the first line of the function list. The list of system functions available in the project 
appears.

6. Select the "SetTag" system function.

– Select the "Keyswitch_PLC" tag at "Tag (output)".

– Select the "Position_Keyswitch" tag at "Value".

The value of the "Keyswitch_PLC" tag is written to the PLC with the "Position_Keyswitch" 
tag. A program in the PLC evaluates the life bit. If communication is established, the 
current value is written to the "Keyswitch_PLC" tag from the PLC. 
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7. Open the Inspector window of the "Auxiliary tag" tags.

8. In the Inspector window, select "Properties > Events > Value change".

9. Click the first line of the function list. The list of system functions available in the project 
appears.

10.Select the "SetTag" system function.

– Select the "Keyswitch_PLC" tag at "Tag (output)".

– Select the "Position_Keyswitch" tag at "Value".

After establishing communication the current value is written to the "Auxiliary Tag" from 
the PLC. The "SetTag" system function is executed by the value change in the auxiliary 
tags. The system function re-allocates the value of the "Position_Keyswitch" tag to the 
"Keyswitch_PLC".

11.Open the global screen or a template in the "Screen navigation" editor.

12.Select the key switch in the screen.

13.Select the "Position_KeySwitch" tag in the Inspector window under "Properties > Properties 
> General > Settings > Tag".
If you press the illuminated pushbutton, the value is written to the "Position_KeySwitch" tag.
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Sm@rtClient view

Application   
The "Sm@rtClient View" object is used to configure a network connection to the remote 
monitoring and remote maintenance of a connected unit.

Layout     
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Connect on start: Establishes whether when opening the Sm@rtClient view the connection 
to the HMI device is automatically created which should be remote-controlled.

● Shared use_ Specifies that an HMI device is shared by several Sm@rtClient Views.

● Local cursor: Specifies whether the cursor data is transferred separately in order to increase 
the performance.

● Use cursor key scroll: For keyboard devices places the control of the horizontal and vertical 
scroll with the cursor keys.

● Show controls: Establishes whether additional fields exist for entering the address and 
password.

● Allow menu: Specifies whether the shortcut menu is enabled to control the Sm@rtClient 
view.

● Connection type: Establishes the expected transfer speed for the remote monitoring.

● Scaling: Specifies whether the Sm@rtClient view can be zoomed in or out.

Connect on start
Establishes whether when opening the Sm@rtClient view the connection to the HMI device is 
automatically created which is remote-controlled. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Connect on start".
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Shared use   
Define whether the HMI device can be used by several Sm@rtClient views under "Properties 
> Properties > General > View > Shared".

Shared use  
Enabled HMI devices on which remote control is activated can access the remote 

HMI device and control the process. Only one HMI device can be active 
at a time in this case. A different HMI device can only assume control when 
there has been no activity on the active HMI device for a specified period 
of time.

Disabled Only one HMI device can use the remote control at any given time. The 
activities can be followed on the other HMI devices. 
Depending on the settings on the Sm@rtServer the following options are 
available if another HMI device logs on:
● The HMI device is rejected.
● The active HMI device is disconnected and the new HMI device is 

connected.

Local cursor   
If this property is set, then the cursor data is transferred separately. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Local cursor".

Display extended objects
If this property is set then there are additional fields for inputting the address and password. 
For the fields to be shown the "Connect on start" option is not activated.

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Show enhanced objects".

Allow menu
If this property is set, then a shortcut menu to control the Sm@rtClient view is opened in 
runtime. 

When operating using the mouse, the left mouse key must remain depressed for a few seconds 
for the shortcut menu to open. 

1. In the Inspector window, select "Properties > Properties > General".

2. Activate "View > Allow Menu".

Connection type
The "Connection type" property establishes the expected transfer speed for the remote 
monitoring. 
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Set the connection type at "Connection type" under "Properties > Properties > General > 
Connection type" in the Inspector window.

Connection type  
LAN Connection via network
Slow Connection with a low transfer speed
Medium Connection with a medium transfer speed
Modem Connection via an analog modem
Very slow Connection with a very low transfer speed 

Scaling
If this property is set, then via "Client scale factor" and "Server scale" you can reduce or enlarge 
the Sm@rtClient view on the HMI device. 

1. In the Inspector window, select "Properties > Properties > Scaling".

2. Activate "Scaling > Scaling".

3. Enter the values for the scaling under "Client scale factor" and "Server scale factor".

Operation behavior
If the program cannot resolve the dynamic address of a Sm@rtClient view after a screen 
change, the system connects to the configured server using the static address of the server. 
If a tag is now set using the dynamic address, you can make a second connection to this server. 
As a remedy preset the tags of the dynamic address for example by means of a script. 

See also
Device-Specific Nature of the Objects (Page 3508)

Memory space view

Application
The "Memory space view" object is used to display the memory space view. You can create 
one memory space display for each drive.
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Layout
In the Inspector window, you customize the settings for the position, shape, style, color, and 
font types of the object. You can adapt the following properties in particular:

● Drive: Defines the drive whose memory assignment is displayed in the memory space 
display.

● Monitoring limits: Defines the values for the monitoring limits.

Define drive
1. In the Inspector window, activate "Properties > Properties > General".

2. Enter the relevant letter in the "Drive letter" area.

Change monitoring limits
Enter the monitoring limits for Alarm, Warning, and Tolerance in the Inspector view. The values 
are specified as a percentage. The percentage of the occupied memory space is monitored 
in relation to the total capacity of the specified drive:

1. In the Inspector window, activate "Properties > Properties > General".

2. Enter the value for each monitoring limit as a percentage in the "Limits" area.

See also
Device-Specific Nature of the Objects (Page 3508)

Status/Force

Application 
The "Status/Force" object is used to configure an editor that will allow you to process single 
address areas of a SIMATIC S7 in runtime.
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 Note

The "Status/Force" object is enabled for the following controllers:
● SIMATIC S7-300
● SIMATIC S7-400

 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● PLC type: Specifies the PLC type in the object for which the address area is output in 
runtime.

● Control elements: Specifies the controls of the object.

● Visible columns: Specifies the displayed columns in runtime.

● Columns moveable: Specifies whether the operator can change the sequence of columns 
in runtime.

Control elements     
Set the control elements that you can use to control the "Status/Force" object in runtime at 
"Properties > Properties > Display" in the "Settings" area of the Inspector window.

 Function
This button refreshes the display in the status value column.

Use this button to accept the new value in the control value column. The control value 
is then written to the PLC.

Visible columns     
The columns that are displayed in runtime are specified in the Inspector window in the 
"General" group in the "Visible columns" area.

Column Description
"Connection" The PLC of which the address areas are displayed.
"Type"
"DB number"
"Offset"
"Bit"

The address area of the operand.

"Data type"
"Format"

The data type of the operand.

"Status value" The value that was read from the specified address of the operand.
"Control value" The value written to the specified address of the operand.
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Sequence of columns     
The operator can use the "Column ordering" property to change the sequence of columns in 
runtime.

1. Select "Properties > Properties > Columns" in the Inspector window.

2. Activate "Properties of columns > Sequence of columns".

Display of the column headers and buttons
The layout of the "Status/Force" object is dependent on the view settings in the control panel. 
Depending on the setting, the column headers may be truncated. This setting is found under 
"Display > Appearance" in the control panel. To display column headers correctly, set the 
display in "Windows and buttons" to "Windows Classic" style. This behavior only occurs during 
configuration. The column headers are displayed correctly in runtime.   

If you change the layout, for example from "Windows Classic" to "Windows XP Style", the 
button in the "Status/Force" object may no longer be displayed. Change the size of the object 
to make the buttons in the engineering system visible again.     

See also
Device-Specific Nature of the Objects (Page 3508)

Symbol library

Application   
The "Symbol library" object contains a large collection of ready-to-use icons. These icons are 
used to represent systems and plant areas in screens.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Select icon: Specifies which library object will be used.

● Fill style: Specifies the graphic design of the object.

● Flip: Specifies the flip type of the library object.
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● Rotate: Specifies the angle around which the library object is rotated.

● Fixed aspect ratio Defines whether the aspect ratio is maintained if the size is changed.

Select symbol
Select the icon at "Properties > Properties > General" in the Inspector window.

Fill style     
Specify the design of the library object at "Properties > Properties > Appearance > Style" in 
the Inspector window.

1 "Hollow" The library object is displayed in outline.
2 "Solid" Black lines remain as outlines. Elements of the icon with a different color are displayed 

as a main color.
3 "Original" The screen object will not be changed.
4 "Shaded" Black lines remain as outlines. Elements of the symbol in other colors are displayed as 

brightness levels of a main color.

At the TP 177B mono and OP 177B mono HMI devices the library object is displayed as an 
outline. "Hollow" is set as the default value for the fill style. 

If you change the setting from "hollow" to "original" or "shaded" then the color of the display 
on the configuration computer will deviate from that on the HMI device. This deviation is caused 
by the different color resolutions. You may also use a graphic object from the "Graphics" object 
group. The graphic objects are structured by topic and by depth of color in the "WinCC graphics 
folder."         

Flip and rotate       
The content of the screen flips around the horizontal or vertical central axis of the icon. The 
icon can be flipped horizontally, vertically or simultaneously horizontally and vertically. 

The screen content rotates around the central point of the icon. The symbol is rotated clockwise 
in increments of 90, 180, or 270 degrees.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select the mirroring mode at "Orientation > Mirror image".

3. Select the angle of rotation at "Orientation > Rotate".
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Fixed aspect ratio     
The smaller page of the library object defines the maximum size of the symbol. If you change 
the size of the library object unproportionally, the symbol is still scaled proportionally. Proceed 
as follows to configure a fixed aspect ratio:

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Form > Fixed aspect ratio".

See also
Device-Specific Nature of the Objects (Page 3508)

Symbolic I/O field

Application   
The "Symbolic I/O field" object can be used to configure a selection list for input and output of 
texts in runtime.

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Mode: Specifies the response of the object in runtime.

● Text list: Specifies the text list that is linked to the object.

● Button for selection list: Specifies that the object has a button to open the selection list.
 

  Note
Reports

In reports, symbolic I/O fields only output data. "Output" mode is preset. Properties for 
configuring the selection of graphics are not available, e.g. "button for selection list".

 

Mode   
The response of the symbolic I/O field is specified in the Inspector window in "Properties > 
Properties > General > Type".

Mode Description
"Output" The symbolic I/O field is used to output values.
"Input" The symbolic I/O field is used to input values.
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Mode Description
"Input/output" The symbolic I/O field is used for the input and output of values.
"Two states" The symbolic I/O field is used only to output values and has a maximum of two 

states. The field switches between two predefined texts. This is used, for 
example, to visualize the two states of a valve: closed or open.

 

 Note

The behavior possible for the symbolic I/O field depends on the Runtime.
 

Text list     
In the Inspector window, you specify which text list is linked to the symbolic I/O field.

1. In the Inspector window, select "Properties > Properties > General".

2. Under "Contents" open the selection list for "Text list".

3. Select a text list.

Button for selection list 
The "Button for selection list" property is used to display a button for opening the selection list.

1. Select "Properties > Properties > Layout" in the Inspector window.

2. Activate "Response > Button for selection list".
 

  Note
Basic Panels

The "Button for selection list" option is not available for Basic Panels.
 

 

See also
Device-Specific Nature of the Objects (Page 3508)

Graphic I/O field (Page 3552)

Symbolic I/O field

Application  
The "Symbolic I/O field" object can be used to configure a selection list for input and output of 
texts in Runtime.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can customize the following properties in particular:

● Mode: Specifies the response of the object in Runtime.

● Text list: Specifies the text list that is linked to the object.

Mode   
The response of the symbolic I/O field is specified in the Inspector window in "Properties > 
Properties > General > Type".

Mode Description
"Output" The symbolic I/O field is used to output values.
"Input" The symbolic I/O field is used to input values.
"Input/output" The symbolic I/O field is used for the input and output of values.
"Two states" The symbolic I/O field is used only to output values and has a maximum of two 

states. The field switches between two predefined texts. This is used, for 
example, to visualize the two states of a valve: closed or open.

Text list   
In the Inspector window you specify which text list is linked to the symbolic I/O field.

1. In the Inspector window, select "Properties > Properties > General":

2. Open the selection list for "Text list".

3. Select a text list.

 

See also
Device-Specific Nature of the Objects (Page 3508)

Graphic I/O field (Page 3553)

System diagnostics view

Introduction
The system diagnostics view offers you an overview of all the available devices in your plant. 
You navigate directly to the cause of the error and to the relevant device. You have access to 
all diagnostics-capable devices which you have configured in the "Devices & networks" editor.
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Use
The system diagnostics view enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostics view. 

● Device view

● Diagnostic buffer view

● Detail view

Device view   
The device view of the system diagnostics view shows all the available connections in tabular 
form. Double-clicking a connection opens the detail view. The device view is only displayed if 
more than one connection has been created in the "Devices & Networks" editor.

Diagnostic buffer view   
In the diagnostic buffer view, the current data from the diagnostic buffer is displayed.

Detail view   
The detail view shows detailed information on the selected connection. You cannot sort error 
texts in the detail view. The detail view is only available if there is an integrated connection to 
an S7 1200 or S7 1500.

Layout
You change the settings for the position, geometry, style, color, and font of the object in the 
Inspector window. You can adapt the following properties in particular:

● Lines per entry: Specifies the number of lines that are shown for an entry.

Configuring the system diagnostics view
1. Drag-and-drop the system diagnostics view from the toolbox.

2. In the Inspector window, select "Properties > Layout".
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3. Enter a number under "Lines per entry", i.e. 5.

4. Select an authorization for operation in "Properties > Properties > Security".

System diagnostics display

Introduction
The system diagnostics view offers you an overview of all the available devices in your plant. 
You navigate directly to the cause of the error and to the relevant device. You have access to 
all diagnostics-capable devices which you have configured in the "Devices & networks" editor.

Use
The system diagnostics view enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostics view. 

● Device view

● Detail view

● Diagnostic buffer view

● Matrix view (only for master systems, PROFIBUS)

Layout
You change the settings for the position, geometry, style, color, and font of the object in the 
Inspector window. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and detail view.

● Show split view: Specifies that the device view and the detail view are shown 
simultaneously.
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Configuring the system diagnostics view
1. Drag-and-drop the system diagnostics view from the toolbox.

2. In the Inspector window, select "Properties > Properties > Columns".

3. Select the columns that you require in the device view for Runtime, e.g., Operating mode, 
Name, Slot.

4. Select the columns which you need in the detail view for runtime, e.g., Operating mode, 
Name, Address.

5. Select the columns that you require in the diagnostic buffer view, e.g., Status, Name, Rack.

6. Customize the column headers, if necessary.

7. Enter "IP" for "Address", for example.
The column header "IP" is displayed in the device view in runtime. 

8. Rename other elements if necessary.

9. Select an authorization for operation in "Properties > Properties > Security".

Showing device view and detail view in a single display
You can split the system diagnostic view and allow the device and detail view to be shown in 
the same window.

1. In the Inspector window, click "Properties > Properties > Layout".

2. Activate "Show split view".

Symbols in the system diagnostic view   

Icon Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required

Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration

Stop e.g. Update, Boot, Own initialization

Stop
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See also
Device-Specific Nature of the Objects (Page 3508)

System diagnostics window (Page 3629)

System diagnostics view

Introduction
The system diagnostic view offers you an overview of all the available devices in your plant. 
You navigate directly to the cause of the error and to the relevant device. You have access to 
all diagnostics-capable devices which you have configured in the "Devices & networks" editor.

Use
The system diagnostic view enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostic view. 

● Device view

● Detail view

● Diagnostic buffer view

Layout
In the Inspector window, you can change the position, geometry, style, color and font of the 
object. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and detail view.

● Show split view: Specifies that the device view and the detail view are shown 
simultaneously.
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Configuring the system diagnostic view
1. Drag-and-drop the system diagnostic view from the toolbox.

2. In the Inspector window, select "Properties > Properties > Columns".

3. Enable the columns that you require in the device view for Runtime, for example: status, 
name, slot.

4. Activate the columns which you need in the detail view for runtime, e.g.: status, name, 
address.

5. Customize the column headers, if necessary.

6. Enter "IP" for "Address", for example.
The column header "IP" is displayed in the device view in runtime. 

7. Rename other elements if necessary.

8. Select an authorization for operation in "Properties > Properties > Security".

Showing device view and detail view in a single display
You can split the system diagnostic view and allow the device and detail view to be shown in 
the same window.

1. In the Inspector window, click "Properties > Properties > Layout".

2. Activate "Show split view".

Single display
1. In the Inspector window, select "Properties > Properties > Layout".

2. Select "Mode > Display type > Single".

Symbols in the system diagnostic view   

Icon Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required

Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration
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Icon Function
Stop e.g. Update, Boot, Own initialization

Stop

 

System diagnostics window

Introduction
The system diagnostics window offers you an overview of all the available devices in your 
plant. You navigate directly to the cause of the error and to the relevant device. You have 
access to all diagnostics-capable devices which you have configured in the "Devices & 
networks" editor.

The system diagnostics window is only available in the global screen.

Use
The system diagnostics window enables you to achieve the maximum level of detail of the 
diagnostics data. A precise diagnosis is possible, as all the available data is displayed. You 
have the system status of the entire plant at one glance.

Three different views are available in the system diagnostics window. 

● Device view

● Detail view

● Diagnostic buffer view

● Matrix view (only for master systems, PROFIBUS)
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Layout
You change the settings for the position, geometry, style, color, and font of the object in the 
Inspector window. You can adapt the following properties in particular:

● Columns: Defines the elements of the device view and detail view.

● Table headers: Specifies the table headers of the view.

● Window: Specifies whether the system diagnostics window can be closed, for example.

Configuring the system diagnostics window
1. Drag and drop the system diagnostics view from the toolbox into the global screen.

2. In the Inspector window, select "Properties > Properties > Columns".

3. Select the columns that you require in the device view for Runtime, e.g., Operating mode, 
Name, Slot.

4. Select the columns that you require in the detail view for Runtime, e.g., Operating mode, 
Name, Plant designation.

5. To change a column heading, click in the field and (for example) enter "IP" for "Address".
The column header "IP" is displayed in the device view in runtime. 

6. Rename other elements if necessary.

7. To be able to close the system diagnostics window in runtime, select "Properties > 
Properties > Window > Closable" in the Inspector window.

Icons in the system diagnostics window

Button Function
Device in operation

Device cannot be accessed
Errors in device

Device deactivated

Maintenance required

Maintenance recommended

Superimposed symbol
Shows the subordinate status 
Current configuration

Stop e.g. Update, Boot, Own initialization

Stop
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See also
Device-Specific Nature of the Objects (Page 3508)

System diagnostics display (Page 3625)

Table view

Application   
You use the "Table view" object to display the tag values in a table. You can display current, 
or logged values in the table. 

Layout   
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Configuring data source and columns

● Configuring a table

● Window settings

● Persistence

● Toolbar

Configuring data source and columns   
1. Open "Properties > Properties > Value column".

2. Select the log tag or compressed log tag that supplies the column with values under "Data 
source".

3. Under "Time column", select the column of the table view in which the data source is to 
displayed.
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4. Select the time range of the table under "Properties > Properties > Time column > Time 
range":

– "Time span": You define the time range using a starting time and a following time span.

– "End time": You define the time range using a starting time and an end time.

– "Measuring points": You define the time range using a starting time and a number of 
measuring points.

5. Use "Format > Update" to specify whether the table displays the values statically or the 
values are refreshed.

6. Under "Style" specify the format for displaying the time and the alignment within the column.

Configuring a table
Under "Properties > Properties > Table", you specify whether the columns of the table have a 
title and whether the grid lines of the table are displayed.

Window settings
Under "Properties > Properties > Layout > Window" you define whether the user can change 
the size of the window and close the window in Runtime.

Persistence
Under "Properties > Properties > Security > Persistence" define how long a user's changes to 
the trend view in runtime are retained.

● "Allow persistence"
Users can change settings. Changes are retained until the next screen change.

● "Persistence until logoff"
User group changes are retained until logoff.

● "Persistence until next loading"
User group changes are retained until the project is updated on the HMI device.

Toolbar       
You define the control elements of the table view in Runtime in the "Properties > Properties > 
Toolbar" inspector window. The following control elements are available for the table view:

Button Name Function
Online help Opens the online help.

Open configuration Opens the configuration dialog. 

First data record Browse the log:
Shows the tag values starting with the first logged value.
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Button Name Function
Previous data record Browse the log:

Shows the tag values in the previous time interval.

Next data record Browse the log:
Shows the tag values in the subsequent time interval.

Last data record Browse the log:
Shows the tag values up to the last logged value.

Edit data Allows the editing of data in any table field that is opened 
when the user double-clicks it.

Tag selection Opens the dialog for selecting the log and tags.

Select column Opens the dialog for setting the visibility of columns.

Time range selection Opens the dialog for setting the time range displayed in 
the table view.

Previous column Displays the previous column in the foreground

Next column Displays the next column in the foreground

Start/end update Stops and starts the column update. The values are 
buffered and updated as soon as you start column 
update again. 

Print log Starts printing the columns displayed in the table view. 
You define the print job under "General > Print > Print 
job". 

Selection of the statistics 
area

Enables you to define a time range for which static 
values are determined.

Statistics window Opens a statistics window to display the minimum, 
maximum, means, and standard deviation for the 
selected time range and the selected column. 

See also
Device-Specific Nature of the Objects (Page 3508)

f(t) trend view (Page 3541)

f(x) trend view (Page 3547)

Value table (Page 3638)

Operating table view in Runtime (Page 3878)

Configuring the Table View (Page 3849)

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
System Manual, 02/2014 3633



Text field

Application   
The "Text field" is a closed object which you can fill with a color. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Text: Specifies the text for the text field.

● Size of text field: Defines whether the size of the object is adapted to the space required 
by the largest list entry.

Text   
Specify the text for the text field in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > General".

2. Enter a text.
For texts over several lines you can set a line break by pressing the key combination <Shift 
+ Enter>.

Size of text field   
In the Inspector window, you can define whether the size of the object is adapted to the space 
required by the largest list entry. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Resize > Fit to contents".

See also
Device-Specific Nature of the Objects (Page 3508)
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T piece

Application
You use the "T piece" object to reproduce a T-shaped pipe junction. To reproduce a pipe 
system, connect the "T piece" object to other objects, e.g. pipe or pipe bend.  

Layout
Customize the object position and color in the Inspector window. You can adapt the following 
properties in particular:

Rotation: Specifies the angle of rotation in degrees of the T piece.

Rotation
You specify by how many degrees the "T piece" is rotated under "Properties > Properties > 
Layout > Rotation" in the Inspector window. The value entered is automatically rounded to a 
multiple of 90.   

● 0: the "leg" of the T piece is pointing downward

● 90: the "leg" of the T piece is pointing to the left

● 180: the "leg" of the T piece is pointing upward

● 270: the "leg" of the T piece is pointing to the right

See also
Device-Specific Nature of the Objects (Page 3508)

Pipe (Page 3604)

Pipe bends (Page 3605)

Double T-piece (Page 3528)
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Clock

Application 
The "Clock" object displays the date and time.

Layout 
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Analog display: Specifies whether the clock is shown as an analog clock or digital clock.

● Display clock dial: Specifies whether hour marks of the analog clock will be displayed.

● Width and length of hands: Specifies the width and length of the hands.

Analog display 
In the Inspector window you can specify whether the clock is displayed as an analog or digital 
clock. The digital clock shows both the time and the date. The display format depends on the 
language set on the HMI device.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "Analog".

Display dial  
In the Inspector window you can specify whether hour marks will be displayed.

1. In the Inspector window, select "Properties > Properties > General":

2. Activate "Analog".

3. Activate "Show dial".

Width and length of hands  
The width of the second hand, minute hand and hour hand is set for the analog display. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter values for "width" and "length".
The values for the length are interpreted as a percentage of the size of the clock. The value 
for the length of the second hand influences the radius of the dial at the same time.
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See also
Device-Specific Nature of the Objects (Page 3508)

Connector

Application
You use the "Connector" object to interconnect several objects using a line.  You can also 
attach multiple connectors to one another.  

There are two types of connector:

● Automatic: The connector consists of horizontal and vertical parts.

● Single: The connecting points are connected by a straight line.

Layout
In the Inspector window, you customize the settings for the object position, shape, style, and 
color. You can adapt the following properties in particular:

● Line style

● Line start and end
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Connecting objects
To connect objects, join the ends of the connectors to the connecting points on the objects.

1. Click the "Connector" object in the "Tools" task card.

2. Click on an object in the screen. The connector is connected to the first object.

3. Click on another object in the screen. 
Both objects are connected to each other.

See also
Device-Specific Nature of the Objects (Page 3508)

Value table

Use
You use the "Value table" object to show evaluated data and statistics in a table. 

● f(t) trend view

● f(x) trend view

● Table view

Layout
In the Inspector window, you customize the position, geometry, style, colors and font types of 
the object. You can adapt the following properties in particular:     

● Data source for displaying the values

● Mode

● Toolbar
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Data source for displaying the values
You define which values are displayed in the value table in the "Properties > Properties > 
General > Data source" inspector window.

Select between the following objects:

● f(t) trend view

● f(x) trend view

● Table view

By default, the configuration for the display format, the format is taken from the connected 
control. The size, value range and zoom factor of the control are taken into account to display 
the optimum number of decimal places. You can configure the display formats for individual 
values in the Inspector window of the value table yourself, for example, to show a precise 
number of decimal places.

Mode
You define the mode in the "Properties > Properties > General > Mode" inspector window. You 
have a choice of three different types depending on the data source.

● The ruler window shows the coordinate values of the trends on the ruler or values of a 
selected line in the table.

● The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. The statistics area window is not 
provided for the object f(x) trend view.

● The statistics window shows the statistical evaluation of the trends between two rulers or 
the selected values in the table. The statistics window is not provided for the object "f(x) 
trend view".

Toolbar    
You define the control elements of the value table in Runtime in the "Properties > Properties 
> Toolbar - Toolbar - Buttons" inspector window. The following control elements are available 
for the recipe data:

Button Brief description Description
Tooltip Calls help for the WinCC value table.
Configuration dialog 
box

Opens the configuration dialog box in which you change the 
properties of the value table.

Ruler window You query the coordinate points of a trend with the button. 
The trend data are displayed in the ruler window.

Define statistics area Enables you to define a time range for which statistics values 
are determined.

Calculating statistics
 

The button shows the statistical values in the statistics 
window. The displayed values refer to a selected trend with 
the configured calculation time period. The button can only 
be pressed if a statistics window is connected with an f(t) 
trend view.
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Printing
 

Start the print-out of the values shown in the table. You define 
the print job to be used in the "Properties > Properties > 
General > Print job" inspector window. 

Exporting data
 

This button is used for exporting all or the selected runtime 
data into a "CSV" file. If the "Properties > Properties > Data 
export > Show dialog" inspector window is activated, a dialog 
box opens in runtime. The dialog box offers you settings for 
the export and starting the export. With the appropriate 
authorizations you can also select the file and the directory 
for the export.
If no dialog box is displayed, the data export to the preset file 
starts immediately.

Customized 1
 

Shows the first key function created by the user. The function 
of the button is user-defined.

See also
Device-Specific Nature of the Objects (Page 3508)

f(t) trend view (Page 3541)

f(x) trend view (Page 3547)

Table view (Page 3631)

Value table basics (Page 3861)

Configuring the value table (Page 3862)

Effective range name

Application  
The "Effective range name" object is a control element for some SIMATIC Mobile Panels. The 
"Effective range name" object shows the names of the effective range in which the HMI device 
is located and also the logon status. 

Layout  

Symbol Meaning Description Logon status
Acknowledgement 
button has no effect

Within the "MixingAxisControl" 
effective range

It is not possible to log on to the 
effective range

Acknowledgement 
button functions

Within the "MixingAxisControl" 
effective range

Logged on to effective range
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Symbol Meaning Description Logon status
Acknowledgement 
button has no effect

Within the "MixingAxisControl" 
effective range

Logon to the effective range is 
rejected because a different 
HMI device is already logged on.
Note:
When using the "Override" 
mode: Although no other HMI 
device is still logged on to the 
effective range, logon is 
rejected because the override 
switch is still set.

Acknowledgement 
button has no effect

Outside of each effective range Note: You can only log on within 
the effective range

In the Inspector window "Properties > Properties > Security", assign an authorization to log on 
to a machine in runtime.

Logon requirements   
● The HMI device is located within the effective range.

● No HMI device is logged on to this effective range.

Logon procedure
1. Click on the "Effective range name" object.

The "Effective range logon" dialog box opens.

2. Read the ID from the machine or plant to be operated.

3. Enter the ID you read.

4. Confirm your entries by clicking "OK".

Result
If the ID and effective range match, the HMI device is logged on to the effective range. 
Successful logon is signaled by an icon on green background. No other HMI device can log 
on to this effective range.

Requirement for logging off
The HMI device is logged on to this effective range.
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Logoff procedure   
Before you leave the effective range or runtime, you must log off from the effective range first. 
If you leave the effective range without logging off, a warning appears.

1. Click on the "Effective range name" object. The "Effective range logoff" dialog box opens.

2. Confirm logoff with "Yes".

Result
The HMI device is no longer logged into the effective range. Other HMI devices can now log 
on to this effective range.

 

 Note

Do not deactivate the "Override" mode again unless you logon a different HMI device.
 

 

See also
Device-Specific Nature of the Objects (Page 3508)

Charging status (Page 3570)

Effective range signal (Page 3644)

WLAN reception (Page 3645)

Zone name  (Page 3649)

Zone signal (Page 3650)

Configuring the effective range name (Page 6086)

Effective range name (RFID)

Application  
The "Effective range name (RFID)" object is a control element for some SIMATIC Mobile 
Panels. The "Effective range name (RFID)" object shows the name of the effective range 
(RFID) in which the HMI device is located and also the logon status. 

 

 Note
RFID tags in the plant area

RFID tags may only be attached in demarcated areas which are secured by additional 
protective measures, e.g. protective fencing. 
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Layout  

Symbol Description Description Logon status
Acknowledgement 
button has no effect

Within the effective 
range (RFID)  
"MixingAxisControl"

It is not possible to log on to the 
effective range (RFID)

Acknowledgement 
button functions

Within the effective 
range (RFID)  
"MixingAxisControl"

Logon to effective range (RFID) 
running

Acknowledgement 
button functions

Within the effective 
range (RFID)  
"MixingAxisControl"

Logged on to the effective 
range (RFID)

In the "Properties > Properties > Security" category of the Inspector window, you can assign 
an authorization for the user group that logs on to the effective range (RFID) during runtime. 

Logon requirements   
● The HMI device is located within the effective range (RFID).

● The machine is demarcated by additional protective measures.

● No HMI device is logged on to this effective range (RFID).

Logon procedure
1. Click on the "Effective range name (RFID)" object.

The "Effective range logon" dialog box opens.

2. Read the ID from the machine or plant to be operated.

3. Enter the ID you read.

4. Confirm your entries by clicking "OK".

Result
If the ID and effective range (RFID)  match, the HMI device is logged on to the machine. 
Successful logon is signaled by an icon on green background. No other HMI device can log 
on to this effective range (RFID) or the machine.

Logoff requirements
The HMI device is logged on to this effective range (RFID).
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Logoff procedure   
Before you exit the effective range (RFID) or runtime, you must first log off from the effective 
range (RFID). If you exit the effective range (RFID) without logging off, a local rampdown is 
executed.

1. Click on the "Effective range name (RFID)" object. The "Effective range (RFID) - logoff" 
dialog box opens.

2. Confirm logoff with "Yes".

Result
The HMI device is no longer logged into the effective range (RFID) or machine. Other HMI 
devices can now log on to this effective range (RFID).

See also
Device-Specific Nature of the Objects (Page 3508)

Charging status (Page 3570)

WLAN reception (Page 3645)

Configuring the effective range name (RFID) (Page 6089)

Effective range signal

Application
The "Effective range signal" object is a control element for some SIMATIC Mobile Panels. The 
"Effective range signal" object indicates how accurately the Mobile Panel Wireless is positioned 
within an effective range.   

Layout

Symbol Description 
Within an effective range

When leaving an effective range
When entering an effective range

Outside of each effective range

Override function is activated:
Within a special security range of the effective range

The "Effective range name" object indicates which effective range this concerns.
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Override function
An effective range, e.g. "robots" is formed outwardly through transponders. However, within a 
special protection zone, e.g. "robot cells", the effective range is not formed by transponders, 
but by alternative restrictions e.g. by railings and a door.

The operator initially logs on to the effective range. An operator who enters the restricted and 
secure zone "robot cells" must press an additional switch to activate the override function:   

● The effective range is allocated and can no longer be established by the transponder.

● Therefore, the quality does not play a role and is no longer displayed.

● The HMI device remains logged into the effective range.

● Other HMI devices can no longer logon to this effective range.

Calculating the signal quality
The quality within an effective range depends, as follows, on the measured distance:

● In the center of the effective range the quality is 100%.  

● On the transponder and on the border of the effective range, the quality is 0%.

Operation
The object is for display only and cannot be controlled by the operator.

See also
Device-Specific Nature of the Objects (Page 3508)

Charging status (Page 3570)

Effective range name (Page 3640)

WLAN reception (Page 3645)

Zone name  (Page 3649)

Zone signal (Page 3650)

Configuring additional Mobile Wireless objects (Page 6087)

WLAN reception

Application
The "WLAN reception" object is a control element for some SIMATIC Mobile Panels. The 
"WLAN reception" object displays the signal strength of the WLAN wireless connection. In 
addition, the signal strength is measured and displayed by means of 5 bars.    
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Layout

Symbol Meaning Signal strength
No wireless connection No signal

Very poor wireless connection =<20 % 

Poor wireless connection >20 %
=<40 %

Wireless connection OK >40 %
=<60 %

Good wireless connection >60 %
=<80 %

Very good wireless connection >80 %

Operation
The object is for display only and cannot be controlled by the operator.

See also
Device-Specific Nature of the Objects (Page 3508)

Charging status (Page 3570)

Effective range name (Page 3640)

Effective range name (RFID) (Page 3642)

Effective range signal (Page 3644)

Zone name  (Page 3649)

Zone signal (Page 3650)

Configuring additional Mobile Wireless objects (Page 6087)
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Gauge

Use       
The "Gauge" object shows numeric values in the form of an analog gauge. For example, a 
glance during Runtime is enough to note that the boiler pressure is in the normal range.

 

 Note

The gauge is for display only and cannot be controlled by the operator.

Configure system functions that are performed at value changes in the tag properties at the 
"Value change" event and not at the "Change" event of the gauge. If your project is to comply 
with Good Manufacturing Practices, and the system function performs a GMP-relevant action. 
e.g. increasing a GMP-relevant tag, every value change of the tag used at the gauge is 
interpreted as a user action.

 

Layout   
In the Inspector window, you customize the position, geometry, style, color and font types of 
the object. You can adapt the following properties in particular:

● Display peak value pointer: Specifies whether the actual measurement range is indicated 
with a slave pointer.

● Maximum Value and Minimum Value: Specifies the top and bottom values of the scale.

● Start value of the danger range and start value of the warning range: Specifies the scale 
value from which the danger range and the warning range start.

● Display normal range: Specifies whether the normal range is shown in color on the scale.

● Color of individual ranges: Different operating modes, such as normal range, warning range 
and danger range, are shown in different colors so that the operator can distinguish them 
easily.
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Display peak value     
The "Display peak value" property can be used to activate a marker function for the maximum 
and minimum pointer movement in Runtime. The actual measurement range is shown with a 
slave pointer.

1. In the Inspector window, activate "Properties > Properties > Appearance > Show peak 
values".

Maximum Value and Minimum Value     
You can set the top and bottom end values of the scale in the Inspector window.

1. In the Inspector window, select "Properties > Properties > General":

2. Enter a number under "Scale > Maximum value" and at "Minimum value".
If you select a tag as the end value of the scale, the number will be no longer available.

 

 Note

Ensure that the minimum value is always less than the maximum value, especially if you 
make the minimum value or maximum value dynamic through a tag. If the minimum value is 
greater than the maximum value, no adjustment is made to the scale end values.

 

Start value of the danger range and start value of the warning range     
Define the scale value at which the danger range and the warning range start in the inspector 
window.

1. Click "Properties > Properties > Areas" in the inspector window.

2. Input the start value at "start value of danger range" and "start value of warning range".

3. Activate "start value of danger range" and "start value of warning range" to display the 
ranges on the scale.

Normal range visible     
In the inspector window, define whether to show the normal range in color.

1. Click "Properties > Properties > Areas" in the inspector window.

2. Activate "Normal".
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Color of individual ranges     
You can display the normal range, the danger range and the warning range in different colors. 
Define the color in the inspector window.

1. In the Inspector window, select "Properties > Properties > Areas".

2. Select a color from the color palette for the three areas.
 

  Note

The following restrictions apply for HMI devices with Windows CE:
● The three ranges (normal / warning / danger) are not visualized in different colors in 

Runtime.
 

See also
Device-Specific Nature of the Objects (Page 3508)

Zone name 

Application
The "Zone name" object is a control element for some SIMATIC Mobile Panels. The "Zone 
name" object shows the names of the zone in which the HMI device is located.   

Layout

Symbol Meaning Description
The "On entry" and "On exit" events of the zone 
and the zone ID can be used in the configuration.

Within the "MixingPlant" zone

– Outside of each zone

Procedure for "On entry" event
1. In the "Zones" or "Zones and effective ranges" editor, configure the function 

"ActivateScreen" on the "On entry" event.

Procedure with zone ID
1. Select an internal tag as the "Zone ID / Connection point ID" in the "Runtime settings > 

General" editor.

2. Animate the visibility of an object, e.g. "I/O field" via the internal tag.
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Operation
The object is for display only and cannot be operated.

See also
Device-Specific Nature of the Objects (Page 3508)

Charging status (Page 3570)

Effective range name (Page 3640)

Effective range signal (Page 3644)

WLAN reception (Page 3645)

Zone signal (Page 3650)

Zone signal

Application
The "Zone signal" object is a control element for some SIMATIC Mobile Panels. The "Zone 
signal" object indicates how well the Mobile Panel is still in a zone. Compared to the "WLAN 
reception" object, it is not the signal strength that is measured, it is calculated from the 
distance.   

Layout

Symbol Meaning Quality
Within one zone >=15 %

When leaving a zone
When entering a zone

<15 % and
>0 %

Outside of each zone =0 %

The "Zone name" object indicates which zone this concerns.

Calculating the signal quality
The quality of the signal within a zone depends, as follows, on the measured distance:  

● In the centre of the zone the quality is 100%.

● To the rear towards the transponder and to the front away from the transponder, the quality 
starts to diminish linearly.

● On the transponder and on the border of the zone, the quality is 0%.
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Operation
The object is for display only and cannot be operated. 

See also
Device-Specific Nature of the Objects (Page 3508)

Charging status (Page 3570)

Effective range name (Page 3640)

Effective range signal (Page 3644)

WLAN reception (Page 3645)

Zone name  (Page 3649)

10.1.9 Configuring screen navigation

10.1.9.1 Basics on screen navigation

Types of navigation for the screen change
For a production process consisting of multiple subprocesses, you will configure multiple 
screens. You have the following options to enable the operator to switch from one screen to 
the next in Runtime:

● Assign buttons to screen changes

● Configuring screen changes at local function keys

Procedure
Before you create a screen change, define the plant structure and derive from it the screen 
changes that you want to configure. 

Create the start screen under "Runtime Settings > General > Start screen". 

See also
Screen basics (Page 3299)

Basics for screen navigation (Page 3652)

Assigning button with screen change (Page 3652)

Assigning screen change to function key (Page 3654)

Overview of working with menus and toolbars (Page 3655)

Creating a menu (Page 3659)
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10.1.9.2 Basics for screen navigation

Types of navigation for the screen change
For a production process consisting of multiple subprocesses, you will configure multiple 
screens. You have the following options to enable the operator to switch from one screen to 
the next in Runtime:

● Assign buttons to screen changes

● Configuring a screen change at a menu and toolbars
 

  Note

For some HMI devices, you can alternatively create buttons for the screen change in the 
permanent window. In this case, the button is incorporated into every screen.

 

Procedure
Before you create a screen change, define the screen hierarchy based on the plant structure 
and derive from it the screen changes that you want to configure. 

Create the start screen under "Runtime Settings > General > Start screen".  

 

See also
Basics on screen navigation (Page 3651)

Example: Configuring toolbars and buttons (Page 3668)

10.1.9.3 Assigning button with screen change

Introduction
Configure a button in the screen to switch between the screens on the HMI device during 
operation. 

 

 Note

If you have set the "Visibility" of animations to "Hidden" in the Inspector window of a screen, 
this screen cannot be called up in Runtime.

 

Requirements
● You have created the project.

● You have created the "Screen_2" screen.

● "Screen_1" is created.
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Procedure
1. Double-click "Screen_1" in the project navigation. The screen is displayed in the work area.

2. Move "Screen_2" from the project tree to the open screen by drag&drop.
A button with the name "Screen_1" is inserted.

3. In the Inspector window, select "Properties > Events > Click".
The "ActivateScreen" system function is displayed in the "Function list". 

4. At the "Object number" attribute, define, if required, the tab sequence number of the object 
on which the focus is to be set after a screen change. You can also specify a tag that 
contains the object number.

Alternative procedure
1. Move a button from the "Tools" task card to "Screen2" by drag&drop.

2. In the Inspector window, select "Properties > Events > Click".

3. Select the "ActivateScreen" system function.

4. Select "Screen_2" for the "Screen number".

Result
The operator goes to "Screen_1 with the button in Runtime. If you have specified an object 
number, the object with this object number has the focus following a screen change. 

See also
Basics on screen navigation (Page 3651)
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10.1.9.4 Assigning screen change to function key

Introduction
Configure a screen change function key in the screen to switch between the screens on the 
HMI device during operation. 

 

 Note

If you have set the "Visibility" of animations to "Hidden" in the inspector window of a screen, 
this screen cannot be called up in Runtime.

 

Requirements
● You have created a project.

● You have created the "Screen_2" screen.

● You have created the "Screen_1" screen.

Procedure
1. Double click "Screen_1" in the project tree. The screen is displayed in the work area.

2. Move "Screen_2" from the project tree to a function key, e.g. "F2".
The configured function key displays a yellow triangle. 

3. Click "Properties > Events > Press key" in the inspector window.
The "ActivateScreen" system function is displayed. 

Result
The operator goes to the specified "Screen_2" with function key "F2" in Runtime. 

See also
Basics on screen navigation (Page 3651)
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10.1.9.5 Menus and toolbars for Runtime Professional

Basics

Overview of working with menus and toolbars

Introduction
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. The 
customized menus and toolbars are displayed in all screens of a project and in the screen 
windows. You connect the menu commands and icons with the local scripts. 

Application
You use customized menus and toolbars, for example to implement a screen navigation. The 
customized menus and toolbars are displayed in each screen of a project or in a screen 
window. You can thus move from any screen to all the screens for which you have configured 
screen changes at menu entries or icons.     

See also
Basics on screen navigation (Page 3651)

Example: Configuring toolbars and buttons (Page 3668)

Menu basics

Introduction
A menu is placed at the top margin of each screen beginning on the left. In a configuration file 
you specify which menu and toolbars are created with this file in screens or screen windows. 
You can configure one menu line for each configuration file.

Menu structure
The configuration options for a menu element depend on the position where the menu is 
located in the menu structure. 

You create the following components for a menu:
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● Main menu command

– Is displayed in the screen.

– Opens a submenu.

● Menu item

– Is displayed in the screen when the main menu opens.

– Executes a defined procedure when clicked.

– You can enter a parameter (for example a screen name) that is to be passed to the 
procedure under "Properties > Events."

– Opens a submenu, if it exists.

● Submenu command

– Is displayed in the screen when the higher-level menu item is open.

● Separator lines between the menu entries

The following figure shows a typical menu structure with different menu elements:

Editing options
You have the following options for configuring a menu:

● Adding a new main menu

● Adding a new menu command / submenu command

● Adding a separator line

● Moving a selected menu command to the left

● Moving a selected menu command to the right

● Changing settings in the Inspector window

See also
Example: Configuring toolbars and buttons (Page 3668)
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Configuration

Introduction
The menus and toolbars that you have configured are combined in the configuration files. Each 
configuration file contains a maximum of one menu, but can contain several toolbars. You can 
create any number of configuration files. A configuration file is selected for the following 
reasons: 

● To add a menu and a toolbar to a screen window

● To add a menu and a toolbar to all the screens of your project

● To exchange the menus and toolbars in Runtime dynamically

Configuring a configuration file
You have the following options for configuration a configuration file:

● Assign authorizations
The elements are automatically disabled if a logged in user does not have the required 
authorization. 

● Hiding or disabling menu entries and icons
You can also exchange the configuration file, for e.g. in case of user change during runtime, 
if you save the modified functional scope in a new configuration file. 

See also
Example: Configuring toolbars and buttons (Page 3668)

"Menus and Toolbars" editor 

Introduction
Use the "Menus and Toolbars" editor to create, configure and edit customized menus and 
toolbars. The customized menus and toolbars are combined in the configuration files and are 
then displayed in all the screens of a project as well as in the screen windows. You connect 
the menu commands and icons with the local scripts. 
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Layout   
The "Menus and Toolbars" editor has three tabs:

● Toolbars

● Menus

● Configurations

You open the editor in the project navigation by double-clicking "Screen management > Menus 
and Toolbars".

 

Visualize processes
10.1 Creating screens

WinCC Professional V13.0
3658 System Manual, 02/2014



Work area
The work area is divided into two sections in the "Toolbars" and "Menus" tabs:

● In the table you define the complete toolbar and/or complete menu.

● The lower section offers you a preview of your toolbars or menus. You create and configure 
the individual icons and/or menu commands and specify the structure, labelling texts and 
symbolizing graphics.

The "Configurations" tab has an undivided work area that contains the table editor for selecting 
the corresponding toolbars and the corresponding menus. 

Inspector window
You configure the menus and toolbars in the Inspector window under "Properties > Properties." 

See also
Example: Configuring toolbars and buttons (Page 3668)

Working with menus and toolbars

Creating a menu

Introduction
In the "Menus and Toolbars" editor you create a menu with main menu commands and the 
corresponding menu commands with up to six hierarchy levels. The menu is shown as it is 
displayed later in the screens or a screen window.

Requirement
● The "Menus and Toolbars" editor is open.

● The "Menus" tab is open.

Creating a menu
1. Double-click "Add" in the "Menus" table.

The first main menu command is created in the preview of the menu commands.

2. Change the name of the menu and enter a comment, if appropriate.
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Creating main menu commands   
1. Click in the preview of the menu on the already created main menu command.

Four yellow stars are displayed around the selection rectangle.

2. Click the yellow star to the right of the standard text.
A further main menu command is created.

3. Enter a name under "Properties > Properties > General >Name" in the Inspector window.

4. Enter a label for the main menu command "Properties > Properties > General >Text" in the 
Inspector window.

1. To display the main menu command as visible in Runtime, activate "Properties > Properties 
> Miscellaneous > Visibility".

2. To define an operator authorization, select an authorization under "Properties > Properties 
> Security".

Creating menu commands   
1. Click in the preview on a main menu command.

Yellow stars are displayed around the selection rectangle.

2. Click the yellow star below the selection rectangle.
A menu command is created under the main menu command.

3. Configure the menu command in the Inspector window like a main menu command.
 

  Note

The authorization, visibility and activation for Runtime can be configured both in the menu 
as well as in each individual menu command. In the case of differing configurations the 
following applies: Menu overwrites menu command.

 

Creating submenu commands   
1. Click in the preview on a menu command.

Yellow stars are displayed around the selection rectangle.

2. Click the yellow star to the right of the menu command.
A submenu command is created.

3. Configure the submenu command in the Inspector window like a main menu command.

Result
The menu is created and can be selected as the menu for a specific configuration file in the 
"Configurations" tab.
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See also
Editing menus and toolbars (Page 3664)

Basics on screen navigation (Page 3651)

Creating a toolbar

Introduction
Use the "Menus and Toolbars" editor to create a toolbar with buttons. The toolbar is shown in 
the preview as it is displayed later in the screens or a screen window.

You can configure any number of toolbars for each configuration. For each toolbar you specify 
the placement position of the toolbar in the screen. Further, you can also define whether the 
user should have the option of freely placing the toolbar. 

 

 Note

Toolbars are device-specific due to the connected scripts. The functionalities are lost when 
they are used for a different device.

 

Requirement
● The "Menus and Toolbars" editor is open.

● The tab "Toolbars" is displayed.

Creating a toolbar
1. Double-click "Add" in the "Toolbars" table.  

A toolbar is created and has a pre-assigned name given to it.
A button is created in the preview of the toolbar.

2. Enter a name to the toolbar in the "Name" column.

3. Select one of the following options as "Button type":

– Text and graphics combined

– Graphics only

– Text only

4. Specify the size of the buttons in the "Screen size" column.
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Adjusting buttons
1. Select the toolbar for which you want to create buttons.

2. Click the already existing button in the preview of the toolbar.  
The button contains a default text and/or a default graphic depending on the type.

The properties are displayed in the Inspector window.

3. Enter a name under "Properties > Properties > General" in the Inspector window.

4. Depending on the button type, select a text and/or a graphic for the button design.

5. To display the button as visible in Runtime, activate "Properties > Properties > 
Miscellaneous > Visibility".

6. To display a tooltip in Runtime, enter a text under "Properties > Properties > Miscellaneous 
> Tooltip".

7. To define an operator authorization, select an authorization under "Properties > Properties 
> Security".

8. To insert further buttons, click in the preview of the toolbar on the  symbol.
 

  Note

The authorization, visibility and activation for Runtime can be configured both in the toolbar 
as well as in each individual button. The following rule is valid for different configurations: 
Toolbar overwrites button.

 

Result
A toolbar with the define toolbars has been created and can be selected as the menu for a 
specific configuration file in the "Configurations" tab.
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See also
Example: Configuring toolbars and buttons (Page 3668)

Creating a configuration file

Introduction
Use a configuration file to display menus and/or toolbars in all screens of your project or in a 
screen window. A configuration file consists of one/no menu and/or any number of toolbars. 

Requirement
● The "Menus and Toolbars" editor is open.

● The "Configurations" tab is displayed.

● Menus and toolbars are required.

Creating a configuration file    
1. Double-click "Add" in the "Configurations" table. A configuration file is created.

2. Change the name of the configuration file and enter a comment, if appropriate.

3. Select a name under "Properties > Properties > Menu >Name" in the Inspector window.

4. Specify whether the menu is to be activated and visible in Runtime and which authorization 
is required for operation.
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5. Select the toolbars you want to add to the configuration file under "Properties > Properties 
> Toolbars" in the Inspector window.

6. Specify for each selected toolbar whether or not the toolbar is to be activated and visible 
in Runtime and which authorization is required for operation.

7. You define the alignment for each toolbar in "Properties > Properties > Toolbars" in the 
Inspector window.

Result
The configuration file can be selected in the project for all screens or in a screen window.

See also
Example: Configuring toolbars and buttons (Page 3668)

Editing menus and toolbars

Introduction
You edit and change already created menus and toolbars in the work are of the "Menus and 
Toolbars" editor". 

Inserting a separation line
1. Open the "Menus" tab or Toolbars" tab.

2. Select the menu command or button in front of which you want to insert a separation line.

3. Click . 
A separation line is shown before the selected menu item. 

You can alternatively insert separation lines by means of the shortcut menu and the command 
"Add separator."
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Moving a menu command / button
1. Open the "Menus" tab or Toolbars" tab.

2. Select the menu command or the button you wish to move.

3. Click one of the symbols  or .
The menu command or button is moved one place to the left or to the right.

Alternatively, you can move a selected element by dragging and dropping it onto the desired 
position. A marking displays the selected target position.

Showing and hiding menus
1. Open the "Menus" tab.

2. To display all the menu commands, click . 

3. To display only the main menu commands, click the  symbol. 
Only the main menu is displayed.

See also
Creating a menu (Page 3659)

Example: Configuring toolbars and buttons (Page 3668)

Configuring menus and toolbars for all the screens

Introduction
In the Runtime settings you can define a configuration file with a user-defined menu and 
toolbars as standard. The customized menu and toolbars are displayed in each screen at the 
configured position. 

You can use VB Script to load other configuration files in Runtime. For e.g. when another user 
logs in, you can load a configuration file with modified scope of customized menus and toolbars. 

Configuring menus and toolbars for all the screens

1. Open the "Runtime settings" editor.

2. Select the configuration file whose menu and toolbars are to be displayed in all the screens 
of your project under "General > Menus and toolbars."

Result
When you activate a project, all customized menus and toolbars will be displayed in all the 
screens of the project. 
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See also
Example: Configuring toolbars and buttons (Page 3668)

How to configure menus and toolbars in a screen window

Introduction
Independent of the start configuration, you can load, in a screen window, an additional 
configuration file with customized menus and toolbars.   

The customized menus and toolbars of the screen window and the start configuration can thus 
be displayed in the screen window. 

Requirement
● You have created a configuration file.

● A screen is open.

How to configure menus and toolbars in a screen window
1. Drag-and-drop the "Screen window" object into the screen.

2. In the Inspector window, select the configuration file in "Properties > Properties > General".

Result
The customized menus and toolbars are displayed in the screen window during runtime. 

See also
Example: Configuring toolbars and buttons (Page 3668)

Adapting menus and toolbars in Runtime

Introduction
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. The 
customized menus and toolbars are displayed in all screens of a project and in the screen 
windows. You connect the menu entries and icons with procedures from the local scripts. 

Example
You can dynamize the "MT configuration" property in a screen window. It is also possible to 
change the configuration of the basic screen and the screen window by means of VB script.

The following example shows a procedure in which the configuration file is transferred as a 
parameter.
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Sub ChangeMenuToolbarConfigFile (ByVal strMTConfigFile)
HMIRuntime.MenuToolBarConfig = strMTConfigFile
End Sub

 

 Note

One menu and several toolbars can be configured in every configuration. 

You can make individual elements of menus or buttons inactive or invisible. This allows 
display of an adapted functional scope in various screens by editing the configuration and 
saving it under a different name.

 

See also
Example: Configuring toolbars and buttons (Page 3668)

Connecting a menu command or icon to a procedure

Introduction
Use the "Menus and Toolbars" editor to configure customized menus and toolbars. The 
customized menus and toolbars are displayed in all the screens of a project and/or also in a 
screen window. The individual menu commands and buttons are connected with a function 
list. Only "Click" is available as an event.     

Requirement
● A "Screen_1" screen has been created.

● A "Screen_2" screen has been created.

● The "Menus and Toolbars" editor is open.

● A button or menu command is created.

Configuring an event with a system function to a button or menu command.
1. Select the button or menu command.

2. In the Inspector window, select "Properties > Events > Click".
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3. Select the "ActivateScreen" system function from the function list.

4. Select "Screen_2" as the "Screen name".

Configuring an event to a button or menu command via scripts.
1. Select the button or menu command.

2. In the Inspector window, select "Properties > Events > Click".

3. Click the icon  "VB script" in the toolbar of the Inspector window.

4. Write the required script.
The "Item" is the object that triggers the event, in this case the button or the menu command. 
It is specified using the "Name" property in the script.

Result
When the operator clicks the button or the menu command, the configured function is executed 
in Runtime. 

See also
Example: Configuring toolbars and buttons (Page 3668)

Example: Configuring a screen change with toolbars

Example: Configuring toolbars and buttons

Introduction
Your process is split into six process image partitions. One screen is the start screen that does 
not have a higher-level screen.
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Requirement
● The screens of the project have been created.

● The "Menus and Toolbars" editor is open.

● The "Toolbars" tab is opened.

Creating a toolbar for a start screen
1. Click "Add" in the "Toolbars" table. An toolbar is created.

2. Enter the name "Screen_Change_Start_Screen" in the column.

3. Select the setting "Combined" as the "Button type".

4. Select the screen size "S48x48".

5. Repeat the procedure: Create a toolbar with a corresponding name for each screen.
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Creating buttons for a start screen
1. Select the first button and select "Properties > Properties > General" in the Inspector 

window.

2. Enter the text "Screen up" under "Text".

3. Select the graphic "Up_Arrow" under "Graphic".

4. To display the button as visible in Runtime, activate "Properties > Properties > 
Miscellaneous > Visibility".

5. Enter the text "Changes to parent screen" under "Properties > Properties > Miscellaneous 
> Tooltip".

6. Click  in the preview of the toolbar.

A button is created.

7. Repeat the procedure for all the buttons with the following properties:

– Button_2: Text: "Screen down"; Graphic: "Down_Arrow".

– Button_3: Text: "Screen left"; Graphic: "Left_Arrow".

– Button_4: Text: "Screen right"; Graphic: "Right_Arrow".

– Button_5: Text: "Start screen"; Graphic: "Home".

Result
A specific toolbar is now available for each screen. 
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Further steps
The following steps are still necessary to use the toolbars for the screen change:

● Assigning system functions to buttons

● Inserting toolbars into a configuration file

● Configuring in the screen window

See also
Basics for screen navigation (Page 3652)

Example: Configuring functions at buttons

Introduction
In order for each button to execute the desired function during a screen change, configure the 
system functions using the function lists.   

Requirement
● The toolbars for all the screens have been created.

● Buttons for the corresponding screens have been created for each toolbar.

● The "Menus and Toolbars" editor is open.

● The "Toolbars" tab is opened.

Configuring system functions at a button of the toolbar.
1. Open the toolbar for the start screen.

2. Select the first button.

3. In the Inspector window, select "Properties > Events > Click".

4. Select the "ActivateScreen" system function from the function list.

5. Enter the name of the screen to which the change is to take place under "Screen name."

6. Enter "2" under "Object number" as the screen object in the screen to which the change is 
to take place. The focus is set to the screen object with the tab sequence number "2."

 

  Note

The object number is defined during the configuration of the tab sequence in the screen. 
The sequence can be displayed in the screen by selecting the menu command "Edit > 
Tab sequence > Edit tab sequence".

 

7. Repeat the procedure for all the buttons of this toolbar:
Always select the screen to be activated with the corresponding button as "Screen name".

8. Repeat the procedure for all the toolbars of the other screens:
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Result
The buttons of all the toolbars are configured with the desired system functions for changing 
the screen.

Further steps
The following steps are still necessary to use the toolbars for the screen change:

● Creating configuration files with toolbars

● Configuring configuration files in the screen window

Example: Creating a configuration file

Introduction
In a configuration you specify which menu and toolbars are created with this file in screens or 
screen windows.

Requirement
● The toolbars for all the screens have been created.

● Buttons are created for every toolbar.

● The "Menus and Toolbars" editor is open.

● The "Configurations" tab is opened.

Defining a configuration
1. Click "Add" in the "Configurations" table. 

A new configuration is created.

2. Enter the name "Configuration_Start_Screen" in the "Name" column.

3. Select the toolbar "Toolbar_start_screen" in the "Toolbars" table.

4. Select the setting "Down" under "Alignment".
The toolbar is displayed in the screen window at the lower margin of the display section.

5. To protect the toolbar with an operator authorization in Runtime, select an authorization.

6. Repeat the procedure for each screen you wish to create:

Result
The configuration files for displaying the toolbars of all screen windows have been created.
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Further steps
The following steps are still necessary to use the toolbars for the screen change:

● Configuring configuration files in the screen window

Example: Configuring a configuration file in the screen window

Introduction
To change from any screen to additional screens, create as many screen windows as you 
require to represent your complete process in an overview screen. Both the corresponding 
screen and the associated configuration are configured in each screen window.

Requirement
● Screens have been created.

● A configuration file is created for each screen.

Configuring a configuration file in a screen window
1. Double-click "Screens > Add Screen" in the project window. A new screen is created.

2. Assign the name "Overview_Screen_Project" to this screen.

3. Drag-and-drop the "Screen window" object into the screen.

4. Enter a name for the title bar under "Properties > Properties > General >Title" in the 
Inspector window.

5. Select a screen that is displayed in the screen window in the Inspector window under 
"Properties > Properties > General > Name".

6. Define the configuration under "Properties > Properties > General > Configurations" in the 
Inspector window.

7. Repeat the procedure for all the screens and configurations.

Result
An overview screen with screen windows is created. A screen and a configuration are defined 
for each screen window. 
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10.2 Working with tags

10.2.1 Basics

10.2.1.1 Basics of tags

Introduction
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

The external tags form the link between WinCC and the automation systems. The values of 
external tags correspond to the process values from the memory of an automation system. 
The value of an external tag is determined by reading the process value from the memory of 
the automation system. It is also possible to rewrite a process value in the memory of the 
automation system.

Internal tags do not have a process link and only convey values within the WinCC. The tag 
values are only available as long as runtime is running.

Tags in WinCC
For external tags, the properties of the tag are used to define the connection that the WinCC 
uses to communicate with the automation system and form of data exchange.   

Tags that are not supplied with values by the process - the internal tags - are not connected 
to the automation system. In the tag's "Connection" property, this is identified by the "Internal 
tag" entry.

You can create tags in different tag tables for greater clarity. You then directly access the 
individual tag tables in the "HMI tags" node in the project tree. The tags from all tag tables can 
be displayed with the help of the table "Show all tags".
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With structures you bundle a number of different tags that form one logical unit. Structures are 
project-associated data and are available for all HMI devices of the project. You use the "Types" 
editor in the project library to create and edit a structure.

See also
Internal Tags (Page 3683)

External tags (Page 3678)

Cycle basics (Page 3736)

Basics on user data types (Page 3729)

Basics on arrays (Page 3722)

Overview of HMI tag tables (Page 3675)

Addressing external tags (Page 3680)

Creating external tags (Page 3685)

Cycle basics (Page 3738)

Basic principles for data logging (Page 3757)

External tags (Page 3677)

Internal Tags (Page 3683)

Outputting tag values in screens (Basic) (Page 3818)

10.2.1.2 Overview of HMI tag tables

Introduction
HMI tag tables contain the definitions of the HMI tags that apply across all devices. A tag table 
is created automatically for each HMI device created in the project.    

In the project tree there is an "HMI tags" folder for each HMI device. The following tables can 
be contained in this folder:

● Default tag table

● User-defined tag tables

● Table of all tags

In the project tree you can create additional tag tables in the HMI tags folder and use these to 
sort and group tags and constants. You can move tags to a different tag table using a drag-
and-drop operation or with the help of the "Tag table" field. Activate the "Tags table" field using 
the shortcut menu of the column headings.

Default tag table
There is one default tag table for each HMI device of the project. It cannot be deleted or moved. 
The default tag table contains HMI tags and, depending on the HMI device, also system tags. 
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You can declare all HMI tags in the standard tags table or, as necessary, additional user-
defined tables of tags.

User-defined tag tables
You can create multiple user-defined tag tables for each HMI device in order to group tags 
according to your requirements. You can rename, gather into groups, or delete user-defined 
tag tables. To group tag tables, create additional subfolders in the HMI tags folder. 

All tags
The "All tags" table shows an overview of all HMI tags and system tags of the HMI device in 
question. This table cannot be deleted, renamed or moved. This table also contains the "Tags 
table" column, which indicates the tag table of where a tag is included. Using the "Tags table" 
field, the assignment of a tag to a tags table can be changed. 

With devices for Runtime Professional, the table "All tags" contain an additional tab "System 
tags". The system tags are created by the system and used for internal management of the 
project. The names of the system tags begin with the "@" character. System tags cannot be 
deleted or renamed. You can evaluate the value of a system tag, but cannot modify it.

Additional tables
The following tables are also available in an HMI tag table:

● Discrete alarms

● Analog alarms

● Logging tags

With the help of these tables you configure alarms and logging tags for the currently selected 
HMI tag. 

Discrete alarms table
In the "Discrete alarms" table, you configure discrete alarms to the HMI tag selected in the 
HMI tag table. When you configure a discrete alarm, multiple selection in the HMI tag table is 
not possible. You configure the discrete alarms for each HMI tag separately.

Analog alarms table
In the "Analog alarms" table, you configure analog alarms to the HMI tag selected in the HMI 
tag table. When you configure an analog alarm, multiple selection in the HMI tag table is not 
possible. You configure the analog alarms for each HMI tag separately.

Logging tags table
In the "Logging tags" table, you configure logging tags to the HMI tag selected in the HMI tag 
table. When you configure a logging tag, multiple selection in the HMI tag table is not possible. 
You configure the logging tags for each HMI tag separately. The "Logging tags" table is only 
available if the HMI device used supports logging. 
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If WinCC Runtime Professional is used, you can also assign several log tags to a tag. With 
the other HMI devices, you can only assign one log tag to a tag.

See also
Basics of tags (Page 3674)

10.2.1.3 External tags

Introduction
External tags allow communication (data exchange) between the components of an 
automation system, for example, between an HMI device and a PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.   

Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.

If you write a PLC control program in STEP 7, the PLC tags created in the control program will 
be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access the 
PLC tags directly via the PLC tag table and connect them to the external tag.

Data types
All the data types which are available at the connected PLC are available at an external tag 
in WinCC. Information about data types which are available for connection to other PLCs can 
be found in the documentation about the respective communication drivers.

See "Basics of communication (Page 6120)" for additional information.
 

 Note

As well as external tags, area pointers are also available for communication between the HMI 
device and PLC. You can set up and enable the area indicators in the "Connections" editor.

 

Synchronization with PLC tags 
A variety of options for synchronizing external tags with the PLC tags are available in the 
Runtime settings under "Settings for tags".

When you perform synchronization, you have the option of automatically applying the tag 
names of the PLC to external tags and reconnecting the existing tags. 

The generated tag name is derived from the position of the data value in the hierarchical 
structure of the data block. 
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Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.     

 

 Note
PLC array elements in conjunction with S7-1200 or S7-1500 

The index of the PLC array elements can begin with any number. In WinCC, indexing always 
starts with 0. 

A PLC tag "Array [1..3] of Int", for example, is mapped to "Array [0..2] of Int" in WinCC.

When you access an array in a script, pay attention to the correct indexing.
 

See also
Basics of communication (Page 6120)

Basics of tags (Page 3674)

10.2.1.4 External tags

Introduction
External tags allow communication (data exchange) between the components of an 
automation system, for example, between an HMI device and a PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.   

Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.

If you write a PLC control program in STEP 7, the PLC tags created in the control program will 
be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access the 
PLC tags directly via the PLC tag table and connect them to the external tag.

Data types
All the data types which are available at the connected PLC are available at an external tag 
in WinCC. If the data type of the PLC tag is not available in WinCC, a compatible data type is 
automatically used at the HMI tag. If you use PLC data types, the data type is adopted by 
WinCC. You can change the data type at the HMI tag, if necessary.
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See "Basics of communication (Page 6120)" for additional information.

Central tag management in STEP 7
You can connect with the HMI tags and DB instances of user-defined PLC data types (UDT).

The PLC data type and the corresponding DB instances are created and updated centrally in 
STEP 7. In WinCC, you can use the following sources as PLC tag (DB instances):

● Data block elements that use a UDT as data type

● Data block instances of a UDT

The data type is taken from STEP 7 and is not converted to an HMI data type. The access 
type is always "Symbolic access". Depending on the release for WinCC in STEP 7, elements 
and structured

elements of the PLC data type are also transferred to WinCC. 
 

 Note
Accessing PLC data types

Access to PLC data types is available only in conjunction with SIMATIC S7-1200 or S7-1500.
 

Synchronization with PLC tags 
A variety of options for synchronizing external tags with the PLC tags are available in the 
Runtime settings under "Settings for tags".

When you perform synchronization, you have the option of automatically applying the tag 
names of the PLC to external tags and reconnecting the existing tags.

The generated tag name is derived from the position of the data value in the hierarchical 
structure of the data block.

 

Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.     
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You can read out the process values directly from the PLC memory, if necessary. Use the 
GetTag functions for this purpose. For more detailed information, refer to the documentation 
for C functions under "Auto-Hotspot".

 

 Note
PLC array elements in conjunction with S7-1200 or S7-1500 

The index of the PLC array elements can begin with any number. In WinCC, indexing always 
starts with 0. 

A PLC tag "Array [1..3] of Int", for example, is mapped to "Array [0..2] of Int" in WinCC.

When you access an array in a script, pay attention to the correct indexing.
 

See also
Basics of tags (Page 3674)

Adapting the data type of a tag (Page 3689)

Basics of communication (Page 6120)

Synchronizing tags (Page 3697)

Settings for synchronization (Page 3696)

User-defined PLC data types (UDT) (Page 3752)

10.2.1.5 Addressing external tags

Introduction
The options for addressing external tags depend on the type of connection between WinCC 
and the PLC in question. A distinction must be made between the following connection 
types:         

● Integrated connection
Connections of devices which are within a project and were created with the "Devices & 
Networks" editor are referred to as integrated connections.

● Non-integrated connection
Connections of devices which were created with the "Connections" editor are referred to 
as non-integrated connections. It is not necessary that all of the devices be within a single 
project.

The connection type can also be recognized by its icon.

Integrated connection
Non-integrated connection

You can find additional information in the section "Basics of communication (Page 6120)".
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Addressing with integrated connections
An integrated connection offers the advantage that you can address a tag both symbolically 
and absolutely.

For symbolic addressing, you select the PLC tag via its name and connect it to the HMI tag. 
The valid data type for the HMI tag is automatically selected by the system. You have to 
distinguish between the following cases when you address elements in data blocks:

Symbolic addressing of data blocks with optimized access and standard access: 

During the symbolic addressing of a data block with optimized access and standard access, 
the address of an element in the data block is dynamically assigned and is automatically 
adopted in the HMI tag in the event of a change. You do not need to compile the connected 
data block or the WinCC project for this step.
For data blocks with optimized access, only symbolic addressing is available.

For symbolic addressing of elements in a data block, you only need to recompile and reload 
the WinCC project in case of the following changes:

● If the name or the data type of the linked data block element or global PLC tag has changed.

● If the name or the data type of the higher level structure node of a linked element in the 
data block element or global PLC tag has changed.

● If the name of the connected data block has changed.

Symbolic addressing is currently available with the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Symbolic addressing is also available if you have an integrated link.

 
 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

You can also use absolute addressing with an integrated connection. You have to use absolute 
addressing for PLC tags from a SIMATIC S7 300/400 PLC. If you have connected an HMI tag 
with a PLC tag and the address of the PLC tag changes, you only have to recompile the control 
program to update the new address in WinCC. Then you recompile the WinCC project and 
load it onto the HMI device.

In WinCC, symbolic addressing is the default method. To change the default setting, select 
the menu command "Options > Settings". Select "Visualization > Tags" in the "Settings" dialog. 
If required, disable the "Symbolic access" option.     

The availability of an integrated connection depends on the PLC used. The following table 
shows the availability:
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PLC Integrated connection Comments
S7 300/400 Yes The linking of tags is not checked in Runtime. If 

the tag address changes in the PLC and the HMI 
device is not compiled again and loaded, the 
change is not registered in runtime.

S7 1200 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

S7 1500 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

Create an integrated connection in the "Devices & Networks" editor. If the PLC is contained in 
the project and integrated connections are supported, you can then also have the connection 
created automatically. To do this, when configuring the HMI tag, simply select an existing PLC 
tag to which you want to connect the HMI tag. The integrated connection is then automatically 
created by the system.

Addressing with non-integrated connections
In the case of a project with a non-integrated connection, you always configure a tag connection 
with absolute addressing. Select the valid data type yourself. If the address of a PLC tag 
changes in a project with a non-integrated connection during the course of the project, you 
also have to make the change in WinCC. The tag connection cannot be checked for validity 
in Runtime, an error message is not issued.

A non-integrated connection is available for all supported PLCs.

Symbolic addressing is not available in a non-integrated connection.

With a non-integrated connection, the control program does not need to be part of the WinCC 
project. You can perform the configuration of the PLC and the WinCC project independently 
of each other. For configuration in WinCC, only the addresses used in the PLC and their 
function have to be known.

See also
Basics of communication (Page 6120)

Basics of tags (Page 3674)
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10.2.1.6 Internal Tags

Introduction
Internal tags do not have any connection to the PLC. Internal tags transport values within the 
HMI device. The tag values are only available as long as runtime is running. 

Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.   

You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
Array One-dimensional array
Bool Binary tag
DateTime Date/time format
DInt Signed 32-bit value
Int Signed 16-bit value
LReal Floating-point number 64-bit IEEE 754
Real Floating-point number 32-bit IEEE 754
SInt Signed 8-bit value
UDnt Unsigned 32-bit value
UInt Unsigned 16-bit value
USInt Unsigned 8-bit value
WString Text tag, 16-bit character set

See also
Basics of tags (Page 3674)

10.2.1.7 Internal Tags

Introduction
Internal tags do not have any connection to the PLC.   
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Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.   

You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
Array One-dimensional array
Bool Binary tag
DateTime Date/time format
DInt Signed 32-bit value
Int Signed 16-bit value
LReal Floating-point number 64-bit IEEE 754
Raw Raw data
Real Floating-point number 32-bit IEEE 754
SInt Signed 8-bit value
String Text tag, 8-bit character set
TextRef Text reference
UDInt Unsigned 32-bit value
UInt Unsigned 16-bit value
USInt Unsigned 8-bit value
WString Text tag, 16-bit character set

See also
Basics of tags (Page 3674)

Adapting the data type of a tag (Page 3689)
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10.2.2 Working with Tags

10.2.2.1 Creating tags

Creating external tags

Introduction
You can access an address in the PLC via a PLC tag using an external tag. The following 
options are available for addressing:

● Symbolic addressing

● Absolute Addressing

You can find further details on symbolic addressing in section "Addressing external tags 
(Page 3680)". If possible, use symbolic addressing when configuring a tag. You create tags 
either in the standard tag table or in a tag table you defined yourself.         

Requirement
● You have opened the project.

● A connection to the PLC is configured.

● The Inspector window is open.

Procedure
To create an external tag, proceed as follows:

1. Open the "HMI tags" folder in the project tree and double-click the standard tag table. The 
tag table open.
Alternatively, create a new tag table and then open it.

2. In the "Name" column, double-click "Add" in the tag table. A new tag is created.

3. Select the "Properties > Properties >General" category in the Inspector window and, if 
required, enter a unique tag name in the "Name" field. The tag name must be unique 
throughout the device.

4. If required, select the "Display name" field to enter a name to be displayed in Runtime. The 
name to be displayed is language-specific and can be translated for the required Runtime 
languages. The display name is available for Basic Panels, Panels and Runtime Advanced.

5. Select the connection to the required PLC in the "Connection" box. If the connection you 
require is not displayed, you must first create the connection to the PLC. You create the 
connection to a SIMATIC S7 PLC in the "Devices & Networks" editor. You create the 
connection to external PLCs in the "Connections" editor.
If the project contains the PLC and supports integrated connections, you can also have the 
connection created automatically. To do this, when configuring the HMI tag, simply select 
an existing PLC tag to which you want to connect the HMI tag. The integrated connection 
is then automatically created by the system.
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6. If you are working with an integrated connection, click the  button in the "PLC tag" field 
and select an already created PLC tag in the object list. Click the  button to confirm the 
selection.

7. If you are working with a non-integrated connection, enter the address from the PLC in the 
"Address" field. The "PLC tag" field remains empty.

8. Configure the other properties of the tag in the inspector window.

You can also configure all tag properties directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.     

You can also create new tags alternatively directly at the application point, e.g. on an I/O field. 
To do this, click the  button in the object list. You then configure the new tag in 
the Inspector window.

Result
An external tag has been created and linked to a PLC tag or an address in the PLC.

 

Alternative procedure
You can also create external HMI tags by dragging and dropping data block elements or global 
PLC tags in an HMI tag table. 

See also
Creating internal tags (Page 3687)

Creating multiple tags (Page 3688)

Addressing external tags (Page 3680)
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Adapting the data type of a tag (Page 3689)

Editing a Tag (Page 3691)

Tag Limits (Page 3699)

Basics of tags (Page 3674)

Creating internal tags

Introduction
You must at least set the name and data type for internal tags. Select the "Internal tag" item, 
rather than a connection to a PLC.               

For documentation purposes, it is a good idea to enter a comment for every tag.

Requirement
You have opened the project.

Procedure
1. Open the "HMI tags" folder in the project tree and double-click the entry "Standard tag 

table". The tag table opens.
Alternatively, create and then open a new tag table.

2. Double-click "Add" in the "Name" column of the tag table. A new tag is created.

3. If the Inspector window is not open, select the "Inspector window" option in the "View" menu.

4. Select the "Properties > Properties >General" category in the Inspector window and, if 
required, enter a unique tag name in the "Name" field. This tag name must be unique 
throughout the project.

5. If required, select the "Display name" field to enter a name to be displayed in Runtime. The 
name to be displayed is language-specific and can be translated for the required Runtime 
languages. The display name is available for Basic Panels, Panels and Runtime Advanced.

6. Select "Internal tag" as the connection in the "Connection" field.

7. Select the required data type in the "Data type" field.

8. In the "Length" field, you must specify the maximum number of characters to be stored in 
the tag according to the selected data type. The length is automatically defined by the data 
type for numerical tags.

9. As an option, you can enter a comment regarding the use of the tag. To do so, click 
"Properties > Properties > Comment" in the Inspector window and enter a text.

You can also configure all tag properties directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.

You can also create new tags alternatively directly at the application point, e.g. on an I/O field. 
Click the  button in the object list. You can then configure the new tag in the 
Properties window that opens.
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Result
An internal tag is created. You can now use this in your project.

In additional steps you can configure the tag, for example, by setting the start value and limits.

See also
Creating external tags (Page 3685)

Creating multiple tags

Introduction
In a tag table, you create additional identical tags by automatically filling the rows of the table 
below a tag.

The tag names are incremented automatically when filling in automatically.

You can also use the auto fill function to fill table cells below a tag with a single tag property 
and thus modify the corresponding tags.

If you apply the automatic filling in to already filled cells of a tab table, you will be asked whether 
you want to overwrite the cells or insert new tags.

If you do not want to overwrite already configured tags, activate insert mode. Activate insert 
mode by keeping the <Ctrl> key pressed during insertion. Already existing entries in the tag 
table are moved down if insert mode is activated.

Requirement
● You have opened the project.

● A tag table is open.

● The tag which is to serve as a template for other tags is configured.
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Procedure
1. If you want to create new tags, mark in the "Name" column the tag that should be used as 

a template for the new tags.
If you want to copy a property of a tag to the tags below it, select the cell which contains 
this property.
The selected cell will be highlighted in color and a small blue square will appear in its bottom 
right corner. If you move the mouse over this square, the cursor will change to a black cross.

2. Hold down the mouse button and drag this square over the cells below that you wish to fill 
automatically.
The marking will be extended to cover this area.

3. Now release the mouse button. All of the marked cells will be filled automatically.
New tags will be created in all empty cells in the marked area.

Result
Depending on which cells were selected, the function may automatically fill individual 
properties or create new tags.

See also
Creating external tags (Page 3685)

Adapting the data type of a tag

Introduction         
When you create a tag, you assign one of the possible data types to the tag. This data type 
depends on the type of data for which you would like to use the tag.

The data types available depend on the connected communication partner, such as a PLC.
 

 Note

If you modify the data type of an existing, external tag, the previously defined tag address is 
identified as invalid. This reason for this is that the PLC address changes when the data type 
is modified.

 

Format adjustment
WinCC sets the data type of an external tag according to the data type of the connected PLC 
tag. If the data type of the PLC tag is not available in WinCC, a compatible data type is 
automatically used at the HMI tag. As required, you can specify that WinCC uses a different 
data type and converts the format of the data type of the PLC tag and the data type of the HMI 
tag.     
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In WinCC, you have access to the following data types:

HMI data type Description Value range
Array Tag with contained elements2)3)  
DateTime Date/time format2)  
SInt Signed 8-bit value -128 ... +127
USInt Unsigned 8-bit value 0 ... 255
Int Signed 16-bit value -32768 ... +32767
UInt Unsigned 16-bit value 0 ... 65535
DInt Signed 32-bit value -2147483648 ... +2147483647
UDInt Unsigned 32-bit value 0 ... 4294967295
Real Floating-point number 32-bit IEEE 754 +-3.402823e+38
LReal Floating-point number 64-bit IEEE 754 +-1.79769313486231e+308
Bool Binary tag 0 ... 1
String Text tag, 8-bit character set  
WString Text tag, 16-bit character set  
TextRef Text reference1  
Raw Raw data type  
1: The "TextRef" data type is only available for internal tags. With tags of the "TextRef" data type, you 
reference an entry in the project texts. If you would like to display a text on an object that changes the 
configured language when the language of a text is changed, use the "TextRef" data type. You assign 
the tag to the project text.
2: Only available in conjunction with S7-1200 or S7-1500 
3: To avoid structural conflicts in runtime, synchronize the tag name and replace the delimiters "[" and 
"]". 

For format adaptation, select the desired PLC data type at the respective external tag. The 
suitable standard data type is then selected automatically in the "HMI data type" field for use 
in WinCC. Change the format adaptation as required. Additional information is available in the 
following section:

● Mapping and coding of data types (Page 3741)

Data types without format adaptation
The data types are shown 1:1 without format adaptation.

SIMATIC S7-300/400 data types without format adaptation

PLC data type Description
Bool No format adaptation
String No format adaptation

OPC-DA data types without format adaptation

OPC-DA data type Description
VT_BSTR No format adaptation
VT_BOOL No format adaptation
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OPC-DA XML data types without format adaptation

OPC-DA data type Description
String No format adaptation
boolean No format adaptation
Base64Binary No format adaptation

See also
Data types (Page 3750)

Creating external tags (Page 3685)

Mapping and coding of data types (Page 3741)

Settings for synchronization (Page 3696)

10.2.2.2 Editing Tags

Editing a Tag

Introduction
You can always rename, copy or delete tags.

When a tag is renamed, the new name must be unique for the whole device.

If you use the "Copy" command to copy a tag to the clipboard, the objects and references 
linked to the tag are copied as well.

If you use the "Insert" command to add a tag to another device, the tag will be added without 
the connected references. Only the object name of the reference will be inserted. If a reference 
of the same name and valid properties exists in the target system, the existing reference will 
then be connected to the copied tag.

If you copy a tag, some of the objects linked to the tag are copied as well. The following objects 
are copied:

● Logging tags

● Cycles

● Alarms

If you add the copied tag to another device, the tag is added together with the linked objects.

Requirement
● The tag which you wish to rename, copy or delete must exist.

● The tag table containing the tag is open.
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Renaming tags
1. In the "Name" field, select the tag in the tag table.  

2. Select "Rename" from the shortcut menu.

3. Type in a new name.
The tag appears under its new name.

Copying tags
1. Mark one or more tags in the tags table.  

2. Select "Copy" from the shortcut menu.

3. Click on the point at which you want to insert the tag. For example, click another tag table 
in the same device or the tag table in a second device.

4. Select "Paste" from the shortcut menu. The tag is inserted as described above.

Deleting a tag
1. Select one or more tags in the tag table.  

2. Select the "Cross-reference" command from the "Tools" menu. In the "Cross-reference" 
editor, check to see where the tags are used. In this manner, you can see what impact the 
deletion of the tag will have on your project.

3. Select "Delete" in the pop-up menu of the tag.
All marked tags will be deleted.

Export and import of tags
WinCC gives you the option to export and import tags. With Export and Import, you have the 
option to export tags from one project and import them into another project. There is also the 
option to create larger numbers of tags outside of WinCC, edit them and subsequently import 
into any WinCC project. For further details, refer to Importing and exporting tags (Page 6852).

See also
Changing the tag configuration (Page 3693)

Configuring multiple tags simultaneously (Page 3693)

Using multiple tags simultaneously in a screen (Page 3694)

Synchronizing tags (Page 3697)

Creating external tags (Page 3685)

Importing and exporting tags (Page 6852)
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Changing the tag configuration

Introduction
You can modify tags at any time to adapt them to changed requirements in the project.   

Changing the tag configuration
if you want to change the configuration of a tag, open the tag table in which the tag is contained. 
Open the "Show all tags" tag table alternatively.

In the tag tables, you can perform such tasks as comparing and adjusting the properties of 
multiple tags or sorting the tags by their properties.

Change the properties either directly in the table or in the inspector window.

If you change a tag property and this change causes a conflict with another property, it will be 
highlighted in color to draw your attention to this fact. This could happen, for example, if you 
connect the tag to another PLC which does not support this data type.

See also
Editing a Tag (Page 3691)

Configuring multiple tags simultaneously

Introduction
In WinCC, you can assign the same properties to multiple tags in a single operation. This 
facilitates efficient programming.   

Requirement
● You created the tags you want to configure.

● The tag table is open.

● The Inspector window is open.

Procedure
1. In the tag table, select all the tags that you want to configure at the same time.

If the selected property is identical for all the tags, the setting for this property will appear 
in the Inspector window. The associated field will remain blank otherwise.

2. You can define the shared properties in the Inspector window or directly in the tag table.

if you change a property commonly on several tags, only this one property is changed. The 
other properties of the tag remain unchanged.
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Result
All marked tags will be reconfigured.

To edit tag properties which differ from one tag to the other, simply clear the multiple selection.

See also
Editing a Tag (Page 3691)

Using multiple tags simultaneously in a screen

Introduction
In WinCC, you can create multiple I/O fields that are linked with tags in one screen in a single 
operation. This facilitates efficient programming.

Requirement
● Several tags are set up.

● A screen is open.
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Procedure
1. In the project tree, select the required tag table under "HMI tags".

2. Select the detail view at the bottom of the project tree. The detail view shows the tags that 
exist in the selected tag group.

3. Mark the tags in the detail window.

4. Drag the tags to the screen. For each tag, this creates an I/O field that is connected to the 
tag.

 

 Note

When you move a PLC tag from the detail window to the work area by drag&drop, a network 
and a connection are created additionally in the "Devices & Networks" editor.

 

 

See also
Editing a Tag (Page 3691)
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Settings for synchronization

Introduction
In WinCC, you can map the location of a data value in the structure of a data block in the 
WinCC tag name. To do this, you synchronize the WinCC tags with the connected PLC tags. 
If necessary, the PLC name is set as a prefix. 

You configure the name matching based on the requirements of your project set under 
"Runtime Settings > Settings for Tags". WinCC offers you several options for this.

You specify whether the names are matched and the conditions for this to occur during 
synchronization.

Settings for tags
To avoid conflicts within complex tag types that you configure under "Settings for tags", the 
delimiters of the path statement from STEP 7 are replaced in WinCC similar to name matching:

● Compatibility mode
In compatibility mode, an underscore is set between the names of the data block and the 
element name of the first hierarchy level. The delimiters in the lower hierarchy levels are 
retained. When you enable this option, all other options are disabled.

● Replace delimiter
Depending on your selection, the delimiters of all hierarchy levels are replaced during 
synchronization.

● PLC prefix
The PLC name is set as a prefix to the WinCC tag name. You set the option for each HMI 
connection.

 

 Note
Duplicate tag names

If the newly generated tag name is already in use, a number is added in parentheses, for 
example, Datablock_1_Static_2{1}(1).

 

Example 
The "PLC1" controller contains the structured data block "DB1". The "Db1.a[1].b.c[3]" data 
block element is used in a picture. Depending on your settings, the WinCC tag name is 
generated as follows:

WinCC tag name Selected option Comment
Db1_a[1].b.c[3] Compatibility mode  
Plc1.Db1.a[1].b.c[3] PLC prefix  
Db1;a(1);b;c(3) Dot and parenthesis replaced with ; ( )  
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WinCC tag name Selected option Comment
Plc1_Db1_a{10}_b_c{3} Dot and parenthesis replaced with _ { }

PLC prefix
 

Db1.a[1].b.c[3] Delimiter replaced without character 
selection

The tag name is enclosed in quotes at 
the point of use in the picture: 
"Db1.a[1].b.c[3]"  

See also
Synchronizing tags (Page 3697)

Synchronizing tags

Introduction
To synchronize the PLC and HMI tags, WinCC offers the following options:

● Synchronizing tags with or without name matching between PLC and WinCC
The following options are available for this:

● Link tags with addresses in the PLC 
This procedure is suitable, for example, if changes were made to the connection between 
the HMI device and the PLC and the tag connections were lost. The function can also be 
used if you have configured the control program and HMI project separately.    

Requirement
● External HMI tags have been created.

● PLC tags have been created.

● An HMI connection to a PLC in the project has been established.
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Procedure
To synchronize HMI tags with PLC tags, follow these steps:

1. In the project tree, select the directory that contains the tags in question.

2. Select "Connect HMI tags to matching PLC tags" from the shortcut  menu.
A dialog opens.

3. Select the option you want to use.
If you want to synchronize the tags without name matching, disable "Replace WinCC tag 
name with PLC tag name".
If you want to connect HMI tags new with absolute access, select "Data type and absolute 
address match". 

4. Confirm with "Synchronize".
The system searches for a suitable PLC tag according to the selected option. 

Result
The external HMI tags are synchronized with the PLC tags. 

If you have selected the option "Data type and absolute address match", the tag connection 
is established as soon as a suitable PLC tag is found.

If you have selected a different option, the WinCC tags are updated accordingly and the PLC 
tag names are applied in WinCC.  

See also
Editing a Tag (Page 3691)

Settings for synchronization (Page 3696)
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10.2.2.3 Configuring Tags

Tag Configuration Basics

Tag Limits

Introduction
You can restrict the value range with limits for numerical tags.

Principle
You can specify a value range defined by a high limit and a low limit for numerical tags.   

If the operator enters a value for the tag that is outside the configured value range, the input 
is rejected. The value is not accepted. You configure a function list when configuring for 
Runtime Advanced and Panels. When the tag value leaves the value range, the function list 
is processed. 

 

 Note

If you want to output an analog alarm when a limit is violated, configure the respective tag in 
the "Analog alarms" tab. You can also configure the analog alarm in the "HMI alarms" editor. 
The values for output of an analog alarm depend on the configured tag limits.

 

Application example
Use the limits to warn the operator when the value of a tag enters a critical range, for example.

See also
Defining Limits for a Tag (Page 3699)

Start value of a tag (Page 3701)

Defining the start value of a tag (Page 3701)

Connecting a tag to another PLC (Page 3702)

Linear scaling of a tag (Page 3703)

Applying linear scaling to a tag (Page 3704)

Defining Limits for a Tag

Introduction
For numerical tags, you can specify a value range by defining a low and high limit.    
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For Runtime Advanced and Panels you can configure the system to process a function list 
whenever a tag value drops below or exceeds its configured value range.

Requirement
● The tag for which you want to set the limits is created.

● The Inspector window with the properties for this tag is open.

Procedure
To define limits for a tag, proceed as follows:

1. In the Inspector window select "Properties > Properties > Limits." If you want to define one 
of the limits as a constant value, select "Constant" using the  button. Enter a number in 
the relevant field.
If you want to define one of the limits as a tag value, select "HMI tag" using the  button. 
Use the object list to define the tag for the limit.

2. To set additional limits for the tag, repeat step 1 with the appropriate settings.

Alternative procedure
You can also configure the high and low limit directly in the tag table. To view hidden columns, 
activate the column titles using the shortcut menu.

Configuring a function list for Runtime Advanced and Panels
When you configure Runtime Advanced and Panels, you can have a function list called up if 
a high or low limit is violated.

1. If you want to start a function list when the value drops below the value range, click 
"Properties > Events > Minimum violated" in the Inspector window. Create a function list in 
this dialog.

2. If you want to start a function list when the value exceeds the value range, click "Properties 
> Events > Maximum violated" in the Inspector window. Create a function list in this dialog.

Result
You have set a value range defined by a high and low limit for the selected tag. If the value 
range is exceeded or undershot, a function list may be carried out.

See also
Tag Limits (Page 3699)
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Start value of a tag

Value of a tag at start of Runtime
You can configure a start value for numeric tags and tags for date/time values. The tag will be 
preset to this value when Runtime starts. In this way, you can ensure that the tag has a defined 
status when Runtime starts.   

For external tags, the start value will be displayed on the HMI device until it is overwritten by 
the PLC or by input.

If no start value was configured, the tag contains the value "0" when starting Runtime.

In WinCC Runtime Professional you can enter a tag value in place of the start value on a tag 
with the "String" data type. The tag value is saved in the "Project texts" editor and is multilingual. 
After the text has been translated, it is displayed in Runtime as a language-dependent start 
value.

Application example
You can assign a default value to an I/O field. Enter the desired default value as start value 
for the tag that is linked to the I/O field. 

See also
Tag Limits (Page 3699)

Defining the start value of a tag (Page 3701)

Defining the start value of a tag

Introduction
In WinCC you can configure a start value for a numeric tag and a tag for date/time values 
which this adopts at Runtime start. 

Requirement
● You have created the tag for which you want to define a start value.

● The Inspector window with the tag properties is open.

Procedure
To configure a start value, proceed as follows:

1. In the Inspector window select "Properties > Properties > Values."

2. Enter the desired "Start value."
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Alternative procedure
You can also configure the start value directly in the tag table. To view hidden columns, activate 
the column titles using the shortcut menu.

Result
The start value you selected for the tag is transferred to the project.

See also
Tag Limits (Page 3699)

Start value of a tag (Page 3701)

Connecting a tag to another PLC

Introduction
In WinCC, you can change the PLC connection of a tag at any time. This is needed when you 
change the configuration of your plant, for example.

Depending on the PLC selected, you may need to modify the configuration of the tag. The tag 
properties which must be changed will be highlighted in color.   

Requirement
● The external tag, whose connection you wish to change, must already exist.

● The connection to the PLC must already exist.

● The Properties window for this tag is open.

Procedure
To change the PLC connection of a tag, proceed as follows:

1. In the Inspector window select "Properties > Properties > General."

2. Select the new connection in the "Connection" field.
The tag properties that you must change will be highlighted in color in the tag table and in 
the Inspector window.

3. Change all highlighted properties of the tag to suit the requirements of the new PLC.

Result
The external tag is connected to the new PLC.

See also
Tag Limits (Page 3699)
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Linear scaling of a tag

Introduction
Numeric data types can be processed with linear scaling. The process values in the PLC for 
an external tag can be mapped onto a specific value range in the project.

Principle
To apply linear scaling to a tag, you must specify one value range on the HMI device and one 
on the PLC. The value ranges will be mapped to each other linearly. 

As soon as data from the HMI device is written to an external tag, it will be automatically 
mapped to the value range of the PLC. As soon as data from the HMI device is read from the 
external tag, a corresponding transformation will be performed in the other direction.

 

 Note

You can also use the system functions "LinearScaling" and "InvertLinearScaling" to 
automatically convert process values.

 

Application example
The user enters length dimensions in centimeters but the PLC is expecting inches. The entered 
values are automatically converted before they are forwarded to the controller. Using linear 
scaling, the value range [0 to 100] on the PLC can be mapped onto the value range [0 to 254] 
on the HMI device.
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See also
Applying linear scaling to a tag (Page 3704)

Tag Limits (Page 3699)

Applying linear scaling to a tag

Introduction
To apply linear scaling to a tag, you must specify one value range on the HMI device and one 
on the PLC. The value ranges will be mapped to each other linearly. 

Requirement
● The external tag to which linear scaling is to be applied must exist.

● The Inspector window with the properties for this tag is open.

Procedure
To apply linear scaling to a tag, follow these steps:

1. In the Inspector window select "Properties > Properties > Linear scaling."

2. Click on "Enable" to switch on linear scaling.
Using this option, you can temporarily switch off linear scaling for testing purposes, for 
example. Settings which were made earlier for linear scaling remain unchanged.

3. In the "PLC" area, enter the start and end values of the value range to be applied to the 
process values on the PLC.

4. In the "HMI device" area, enter the end and start values of the value range to be applied to 
the process values on the HMI device.

Result
In Runtime the data will be automatically mapped from one value range to the other.

 

 Note

You can also use the "LinearScaling" and "InvertLinearScaling" system functions to 
automatically convert process values.

 

See also
Linear scaling of a tag (Page 3703)

Tag Limits (Page 3699)
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Special configuration options

Address multiplexing

Introduction
Using address multiplexing, you can use a single tag to access a multitude of memory locations 
within the PLC's address range. You read and write to the addresses without defining a tag 
for each individual address.

Multiplexing with absolute addressing
When using multiplexing with absolute addressing, you configure tags as placeholders for the 
address in the PLC to be addressed.       

If you want to access, for example, an address of the format "%DBx.DBWy", the expression 
for multiplexing is as follows:

"%DB[HMITag1].DBW[HMITag2]"

In Runtime, you supply the tag "HMITag1" with the required value for the data block you want 
to address. 

In Runtime, you supply the tag "HMITag2" with the required address from the data block.

Tags are supplied with values, for example, with the help of values from the PLC or via a script.

Multiplexing with absolute addresses is supported for the following PLCs and communication 
drivers. 

● SIMATIC S7-300/400

● SIMATIC S7-1200

● SIMATIC S7-1500

Multiplexing with absolute addresses is not available for data blocks with optimized access.

Multiplexing with symbolic addressing
When multiplexing with symbolic addressing, you access an array element of an array tag in 
a data block of the connected PLC by means of a multiplex tag and an index tag. The multiplex 
tag contains the symbolic address of the data block which you want to access. The symbolic 
address also contains the index tag via which you access the index of the array tag.     

If you want to access, for example, the array tag "Arraytag_1" in the data block "Datablock_1", 
the expression for symbolic addressing is as follows:

"Datablock_1.Arraytag_1["HMITag_1"]

You control the access to the index of the array elements with the HMI-Variable "HMITag_1". 
In Runtime, you supply the tag with the index of the array element that you want to access.

Multiplexing with symbolic addressing is only available if the following components support 
symbolic addressing:
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● the HMI device

● PLC

● Communication driver

Symbolic addressing is supported by communication drivers:

● SIMATIC S7-1200 

● SIMATIC S7-1500 

See also
Configuring address multiplexing with absolute addressing (Page 3706)

Configuring address multiplexing with symbolic addressing (Page 3709)

Updating the Tag Value in Runtime (Page 3714)

Indirect addressing of tags (Page 3712)

Addressing tags indirectly (Page 3712)

Using tags to trigger functions (Page 3713)

Defining the acquisition cycle for a tag (Page 3715)

Configuring address multiplexing with absolute addressing

Introduction
When using address multiplexing, you can efficiently access different addresses in the PLC 
with the help of a small number of tags. Instead of the absolute address in the PLC, you use 
tags in order to be able to change the address in Runtime.

Requirement
● The tag for address multiplexing is created and connected to the PLC.

● The Properties window for this tag is open.
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Procedure
1. Select the tag for address multiplexing in the tag table, and select "Properties > Properties 

> General" in the Inspector window. The general properties of the tag are displayed.

2. Select the "Int" data type for this example.

3. Select the access type "Absolute addressing".

4. Click the selection button in the "Address" field. The address dialog opens.

5. Click the selection button in the "DB number" field and select the entry "HMI tag".
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6. In the "DB number" field, click the  button and select a tag for the DB number in the object 
list. Or create a new tag with the help of the object list. Accept the tag by clicking the  
button.

7. Repeat steps 3 and 4 for the "Address" field and configure a further tag for calling the 
address area in the data block.

The selection options in the Address dialog depend on the selected data type of the multiplex 
tag. The Address dialog offers only address settings that can be configured with the selected 
data type. 

Result
In runtime, the multiplex tag is used to access the memory location corresponding to the 
address currently found in the tag. You control access to the data block with the tag in the DB 
number field. You control access to the address in the selected data block with the tag in the 
"Address" field. 

 

 Note

The value in the memory location will only be read at the next update cycle for the addressed 
tag. 

If, for example, you use a multiplex tag in a script, do not attempt to access contents of the 
memory location directly after changing it. 

 

See also
Address multiplexing (Page 3705)

Configuring address multiplexing with symbolic addressing (Page 3709)
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Configuring address multiplexing with symbolic addressing

Introduction
When using address multiplexing, you can efficiently access different addresses in the PLC 
with the help of a small number of tags. Instead of the symbolic address in the PLC, you use 
tags in order to be able to change the address in Runtime.

Requirement
● The tag for address multiplexing is created.

● The Properties window for this tag is open.

● A data block with an array tag is created in the connected PLC.

● The data block was compiled.
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Procedure
1. Select the tag for address multiplexing in the tag table, and select "Properties > Properties 

> General" in the Inspector window. The general properties of the tag are displayed.

2. Select the connection to the PLC via the "Connection" field.

3. Select the access type "Symbolic addressing".
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4. Navigate to the data block of the PLC via the "PLC tag" field and select an array element 
of the array tag.

5. Click the selection button in the "Address" field. The address dialog opens. 

6. Click the selection button in the "Index tag" field and select the entry "HMI tag".

7. In the "Index tag" field, click the  button and select a tag for the array index in the object 
list. Or create a new tag with the help of the object list. Accept the tag by clicking the  
button.

Result
In Runtime, the array element whose index value is contained in the index tag is accessed.
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See also
Address multiplexing (Page 3705)

Configuring address multiplexing with absolute addressing (Page 3706)

Indirect addressing of tags

Principle
In multiplexes, a type of indirect addressing, the tag used is first determined at runtime. A list 
of tags is defined for the multiplex tag. The relevant tag is selected from the list of tags in 
runtime. The selection of the tag depends on the value of the index tag.

In Runtime, the system first reads the value of the index tag. Then the tag which is specified 
in the corresponding place in the tag list is accessed. 

Application example
Using indirect addressing, you could configure the following scenario: 

The operator selects one of several machines from a selection list. Depending on the operator's 
selection, data from the selected machine will be displayed in an output field.

To configure such a scenario, configure the index tag for a symbolic I/O field. Configure the 
multiplex tag at an I/O field. Configure the tag list of the multiplex tag to reflect the structure of 
the selection list.

If the operator selects another machine, the value of the index tag will change. The selection 
field then displays the content of the tag that is pointed to in the tag list in the multiplex tag by 
the new index value.

See also
Addressing tags indirectly (Page 3712)

Address multiplexing (Page 3705)

Addressing tags indirectly

Introduction
With indirect addressing, the tag used is first determined at runtime. Instead of a single tag, a 
list of tags is defined. The list entries consist of an index value and the name of the tag to be 
used. Using an index tag, you can control which entry in the tag list will be accessed.      

Requirement
● The tag which you wish to address indirectly must already exist.

● The index tag must exist.
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● The tags which will be contained in the tag list must already exist.

● The Inspector window with the tag properties is open.

Procedure
To address tags indirectly, proceed as follows:

1. In the Inspector window select "Properties > Properties > Multiplexing".

2. Select the "Multiplexing" option to activate indirect addressing.
Using this option, you can temporarily switch off indirect addressing for testing purposes, 
for example. Settings which were made earlier for indirect addressing remain unchanged. 

3. Select an "Index tag" or define a new tag using the object list.

4. Click the first entry in the "Tags" column in the tag list.

5. Select a tag as a list entry or define a new tag using the object list.
The entry in the "Index" column will be generated automatically.

6. Repeat step 5 for all tags that you wish to add to the tag list.

7. If necessary, you can use drag-and-drop to change the order of the entries in the list.

Result
In runtime, the system will dynamically access the tag in the tag list which has the same index 
value as the value currently in the index tag.

See also
Indirect addressing of tags (Page 3712)

Address multiplexing (Page 3705)

Using tags to trigger functions

Introduction
You can use the values of variables as the triggering event for an action in runtime. To start 
an action in Runtime, configure a function list for a tag. Include one or more system functions 
or VB scripts in the function list. The function list is processed when the configured event 
occurs.     

The following events are available for a tag: 
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● Change in value of the tag
Function list processing is triggered by each change in the value of the variable.
When the tag is defined as an array tag, the function list is processed whenever an array 
element changes.

● Violation of the tag's high limit
The function list is processed when the high limit is violated.

● Violation of the tag's low limit
The function list is processed when the low limit is violated.

Requirement
● The tag whose value you wish to use as an event already exists.

● The Inspector window with the properties for this tag is open.

Procedure
To configure a tag with a function list, proceed as follows:

1. Under "Properties > Events >" in the Inspector window, select the event for which you want 
to create a function list.
The function list associated with the selected event is shown.

2. Click "<Add function>". The second table column contains a selection button.

3. Click the selection button and select a system function.

4. Define the parameter values.

Alternatively, select a script to run in the function list, rather than a system function. The "VB 
scripts" entry is only displayed if there is a script available in the project.

Result
If the configured event occurs in Runtime, the function list or the script is processed.

See also
Address multiplexing (Page 3705)

Updating the Tag Value in Runtime

Introduction
Tags contain process values which change while Runtime is running. Value changes are 
handled differently at internal and external tags.      
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Principle
When Runtime starts, the value of a tag is equal to its start value. Tag values change in 
Runtime.

In Runtime, you have the following options for changing the value of a tag:

● A value change in an external tag in the PLC.

● By input, for example, in an I/O field.

● By running a system function, such as "SetValue."

● A value assignment in a script.

Updating the Value of External Tags
The value of an external tag is updated as follows:      

● Cyclic in operation
If you select the "Cyclic in operation" acquisition mode, the tag is updated in Runtime while 
it is displayed in a screen or is logged. The acquisition cycle determines the update cycle 
for tag value updates on the HMI device. You can either choose a default acquisition cycle 
or define a user-specific cycle.

● Cyclic continuous
If you select the "Cyclic continuous" acquisition mode, the tag will be updated continuously 
in Runtime, even if it is not in the currently-open screen. This setting is activated for tags 
that are configured to trigger a function list when their value changes, for example.   
Only use the "Cyclic continuous" setting for tags that must truly be updated. Frequent read 
operations increase communication load.

● On demand
If you select the "On demand" acquisition mode, the tag is not updated cyclically. It will only 
be updated on demand using the "UpdateTag" system function, for example, or by a script. 

See also
Address multiplexing (Page 3705)

Defining the acquisition cycle for a tag

Introduction
The value of an external tag can be changed in Runtime by the PLC to which the tag is linked. 
To ensure that the HMI device is informed of any changes in tag values by the PLC, the values 
must be updated on the HMI. The value is updated at regular intervals while the tag is displayed 
in the process screen or is logged. The interval for regular updates is set with the acquisition 
cycle. The update can also be made continuous.     
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Requirement
● You have created the tag for which you want to define an acquisition cycle.

● The Inspector window with the tag properties is open.

Procedure
To configure an acquisition cycle for a tag, follow these steps:

1. In the Inspector window select "Properties > Properties > General."

2. If you want to update the tag at regular intervals as long as it is being displayed on the 
screen or logged, select "Cyclic in operation" as the acquisition mode.
Or:
If you want to update the tag at regular intervals even though it is not being displayed on 
the screen or logged, select "Cyclic continuous" as the acquisition mode.
The "Cyclic continuous" setting is selected for a tag, for example, that has a function list 
configured for a change of its value and that is not directly visible in a screen.

3. Select the required cycle time in the "Acquisition cycle" field or define a new acquisition 
cycle using the object list.

Alternatively, you can configure the acquisition cycle directly in the work area of the tag table. 
To view hidden columns, activate the column titles using the shortcut menu.

 

 Note

Only use the "Cyclic continuous" acquisition mode for tags that really have to be continuously 
updated. Frequent read operations generate a heavy communication load.

 

Result
The configured tag is updated in Runtime with the selected acquisition cycle.

See also
Address multiplexing (Page 3705)

Special configuration options

Defining a substitute value

Introduction    
You can define a specific value as a substitute value for a tag.

In the "Use substitute value" area you define when WinCC should use this substitute value. 
The current process value is then not accepted from the automation system.
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You can define a substitute value for the following cases:

● As start value
WinCC sets the substitute value when the project is activated and there is no current 
process value.

● After communication error
WinCC sets the substitute value when the connection to the automation system is disturbed 
and there is no valid process value.

● Maximum exceeded
If you have set an upper limit for the tag, WinCC sets the substitute value as soon as the 
process value exceeds this upper limit.

● Minimum undershot
If you have set a lower limit for the tag, WinCC sets the substitute value as soon as the 
process value falls below this lower limit.

Requirement
● The tag table is open.

● The Inspector window with the tag properties is open.

Procedure
To configure a substitute value, follow these steps:

1. Select the desired tag in the tag table, and select "Properties > Properties > Values" in the 
Inspector window.

2. In the "Use substitute value" segment, select when you want WinCC to use this substitute 
value in the tag.

3. Enter the required substitute value in the "Substitute value" field.
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Result
The configured tag is populated with the substitute value in Runtime once the selected 
condition is fulfilled.

 

 Note

If you have set a high or low limit in an I/O field, you cannot enter any value outside these 
limits.

WinCC ignores incorrect entries and therefore does not set a substitute value. The substitute 
value is only set by WinCC when an incorrect process value is read.

 

See also
Defining the acquisition cycle for a tag (Page 3718)

Tag Limits (Page 3699)

Indirect addressing of tags (Page 3719)

Addressing tags indirectly (Page 3720)

Defining the acquisition cycle for a tag

Introduction   
If you are using tags, you define the acquisition cycle for Runtime Professional at the object 
on which the tag is to be used.

If you are logging a tag, define the acquisition cycle at the connected logging tag. The 
connected tag is updated with this acquisition cycle.

If you use a tag on a graphic object, the tag is updated with the acquisition cycle of the graphic 
object. The graphic objects in a screen are usually updated with the update cycle of the screen. 
You configure the update cycles of the screen and the objects in it in the "Dynamization 
overview" editor. All the objects used in a screen that require a trigger are shown in the 
"Dynamization overview" editor. Select the required acquisition cycle for each object. For a 
high-performance configuration, you should only configure an acquisition cycle for individual 
objects that deviates from the screen cycle if there truly is a need for it.

Requirement
● You have configured a screen.

● The screen contains an object on which a tag is configured.
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Procedure
To define the acquisition cycle, follow these steps:

1. Select the screen from the project tree and select "Dynamization overview" from the 
shortcut menu.
The "Dynamization overview" editor opens.

2. Configure the update cycle for the screen in the upper area of the "Dynamization overview" 
dialog. Select the required update cycle for the screen in the "Cycle" field or define a new 
cycle using the object list. The set cycle time has an effect on all objects whose cycle is set 
to the value "Screen cycle".

3. If you want to configure a different cycle time for an individual object, select the required 
object from the editor table and select the acquisition cycle from the "Cycle" field or define 
a separate cycle using the object list.

If you want to change the acquisition cycle for an individual object only, select this object in 
the screen and select "Dynamization overview" from the shortcut menu.

Result
The configured object is updated in Runtime with the selected cycle.

See also
Defining a substitute value (Page 3716)

Indirect addressing of tags

Introduction
With indirect addressing, the tag used is first determined at runtime. Use a string tag for indirect 
addressing in WinCC Runtime Professional. You also need a series of tags whose values are 
to be displayed in Runtime. In Runtime you enter the name of the tag in the string tag whose 
value you want to display and process.

Application example
The operator enters the name of one or several machines in the input field. Depending on the 
operator input, a process value of the machine is displayed in an output field.

To configure such a scenario, configure the string tag with activation of indirect addressing for 
an I/O field. Use this I/O field to output the values. Configure the same tag to another I/O field 
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without activation of indirect addressing. Use this I/O field to enter the machine names. Also 
configure a series of tags whose values you want to output.

When the operator enters the name of a different machine, the value of the string tag for indirect 
addressing changes. The output field shows the content of the tag whose name is included in 
the string tag.

You can use other mechanisms in WinCC to supply the string tag for indirect addressing, for 
example, a script.

See also
Addressing tags indirectly (Page 3720)

Defining a substitute value (Page 3716)

Addressing tags indirectly

Introduction
With indirect addressing, the tag used is first determined at runtime. Instead of individual tags, 
you define a series of tags. In Runtime the tag name is used to access individual tags.    

Requirement
● The "Temperature_Motor" tag that you want to use for indirect addressing does exist.

● A series of tags is created, for example, the "Motor1", "Motor2" and "Motor3" tags.

● The Inspector window with the tag properties is open.

● You have created a screen and the "Screens" editor is open.
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Procedure
To address tags indirectly, proceed as follows:

1. Add an I/O field to the screen and select the following settings for this example in the 
information window under "Properties > Properties > General":

– Mode: Output

– Display format: Decimal

2. Open the object list in the "Tag" field using the selection button, select the 
"Temperature_Motor" tag and activate the "Use indirect addressing" option.

3. The "Temperature_Motor" tag is configured for indirect addressing. The additional text 
("indirect") is displayed in front of the tag name in the "Tag" field.

4. Add another I/O field to the screen and select the following settings for this example in the 
information window under "Properties > Properties > General":

– Mode: Entry

– Display format: Character string
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5. Open the object list in the "Tag" field using the selection button, select the 
"Temperature_Motor" tag. Do not activate the option "Use indirect addressing".

6. Save the project.

Result
If you enter the name of one of the tags "Motor1", "Motor2" or "Motor3" in the input field in 
Runtime, the value of the respective tag is displayed in the output field.

See also
Indirect addressing of tags (Page 3719)

Defining a substitute value (Page 3716)

10.2.3 Working with Arrays

10.2.3.1 Basics on arrays

Definition
Array data of a uniform data type is successively arranged and is addressed within the address 
space to allow access to these data by means of an index. The individual array elements are 
addressed by means of an integer index. Each array element is assigned the same properties 
which are configured at the array tag.       

Advantages
You can configure numerous array elements with the same properties all at once with a single 
array tag. You can then use each array element as any other tag in your configuration. 

Restrictions
The following restrictions apply to the use of arrays:

● An array may contain only one dimension.

● The lower index of an array must begin with "0".
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Application examples
Array tags can be used in the following situations:

● To group process values in profile trends: You map process values to trends which are 
acquired at different points in time, for example.

● To access specific values which are grouped in trends: For example, display all recorded 
values of the profile trend by gradually increasing the index tag.

● To configure discrete alarms with successive bit number.

● To save the complete machine data records in a recipe.

License rule for runtime
An array tag is counted in WinCC Runtime as 1 PowerTag, regardless of the number of array 
elements.

Special features
 

 WARNING

Increased system load and performance losses

Read or write access to a single array element always includes read or write access to all 
array elements of the array tag. Transfer of the data of large arrays from and to the PLC 
usually takes longer compared to the transfer of a basic data type. This may cause 
communication overload and disruption as a result.

 

Example:
● An array tag which consists of 100 array elements of data type "Real" was configured.

● If an array element with a length of 4 bytes changes, 100 x 4 bytes are written to the PLC.
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Use in scripts
To maintain performance, always use internal arrays to change arrays in scripts.

1. Copy the PLC array to the internal array at the start of the script.

2. Load on data transfer to the PLC is avoided while the script processes the internal array.
 

 
 CAUTION

Data inconsistency at array tags

If the value of a single element must be changed in an array tag, the whole array is read, 
changed and rewritten as a complete array. Changes carried out in the meantime to other 
array elements in the PLC are overwritten during rewriting.

You should always prevent the HMI device and the PLC from concurrently writing values 
to the same array tag. Use synchronous transfer of recipe data records to synchronize an 
array tag with the PLC.

 

See also
Creating array tags (Page 3724)

Examples of arrays (Page 3725)

Basics of tags (Page 3674)

10.2.3.2 Creating array tags

Introduction
Create an array tag to configure a large number of tags of the same data type. The array 
elements are saved to a consecutive address space.

You can create an array tag as an internal tag or as an external tag.

If you want to create an array tag as an external tag, first configure an array tag in a data block 
of the connected PLC. You then connect the array tag to an HMI tag.    

Requirement
● The HMI tag table is open.

Procedure
To create an array tag, follow these steps:

1. Double click <Add> in the "Name" column of the HMI tag table.
A new HMI tag is created.

2. Click  in the Data type column and select the "Array" data type.
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3. Click  in the data type column. The dialog box for configuring the array is opened.

4. Select the desired data type for the array tag in the "Date type" field.

5. Define the number of array elements in the "Array limits" field. The lower limit must begin 
with "0".

6. Click . The settings for the array are saved.

7. Save the project.

Result
An array tag is created. The properties of the array elements are inherited from the parent 
array tag.

See also
Basics on arrays (Page 3722)

10.2.3.3 Examples of arrays

Introduction
Array tags combine a number of tags, e.g. 100 array elements. You use array tags as complete 
arrays in the following places:

● In the "Alarms" editor

● In the "Recipes" editor

● For address multiplexing

● In the trend view
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You use individual array elements everywhere in the configuration like HMI tags.

Examples
You can configure an array tag with the corresponding number of array elements to handle 
multiple tags of the same data type.

● The individual array elements can be accessed indirectly by means of a multiplex index 
tag, for example.

● Use these index tags to operate and monitor the array elements.

See also
Basics on arrays (Page 3722)

10.2.4 Working with Arrays

10.2.4.1 Basics on arrays

Definition
Array data of a uniform data type is successively arranged and is addressed within the address 
space to allow access to these data by means of an index. The individual array elements are 
addressed by means of an integer index. Each array element is assigned the same properties 
which are configured at the array tag. You can enter a comment for an array element. An array 
tag can have up to 2000 elements.      

Advantages
You can configure numerous array elements with the same properties all at once with a single 
array tag. You can then use each array element as any other tag in your configuration. 
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Restrictions
The following restrictions apply to the use of arrays:

● The low limit of an array must begin at "0".

● External array tags are only possible with the S7-1200 and S7-1500 controllers. 
 

  Note
Synchronization

To avoid structural conflicts in runtime, synchronize the tag names and replace the 
delimiters "[" and "]" for external array tags. 

Configure "Settings for tags" for this in the runtime settings. 
 

Special features
Multidimensional arrays are also possible in conjunction with PLC data types (UDT) of the 
S7-1200 and S7-1500 controllers. 

License rule for runtime
In WinCC Runtime, an array element is counted as 1 PowerTag. The array tag itself is not 
considered a PowerTag.

Example for writing an array element in the PLC
● An array tag which consists of 100 array elements of data type "Real" was configured.

● If an array element with a length of 4 bytes changes, 4 bytes are written to the PLC.

See also
Settings for synchronization (Page 3696)

10.2.4.2 Creating array tags

Introduction
Create an array tag to configure a large number of tags of the same data type. The array 
elements are saved to a consecutive address space.

You can create an array tag as an internal tag or as an external tag.

If you want to create an array tag as an external tag, first configure an array tag in a data block 
of the connected PLC. You then connect the array tag to an HMI tag.    
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Requirement
● The HMI tag table is open.

Procedure
To create an array tag, follow these steps:

1. Double click <Add> in the "Name" column of the HMI tag table.
A new HMI tag is created.

2. Click  in the Data type column and select the "Array" data type.

3. Click  in the data type column. The dialog box for configuring the array is opened.

4. Select the desired data type for the array tag in the "Date type" field.

5. Define the number of array elements in the "Array limits" field. The lower limit must begin 
with "0".

6. Click . The settings for the array are saved.

7. Save the project.

Result
An array tag is created. The properties of the array elements are inherited from the parent 
array tag.
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10.2.5 Working with user data types

10.2.5.1 Basics on user data types

Introduction
With user data types you bundle a number of different tags that form one logical unit. You 
create a user data type as a type and use instances of this type in the project. User data types 
are project-associated data and are available for all HMI devices of the project. 

User data types differ in their association to a family of devices. User data types are available 
for the following families of devices:

● WinCC Runtime Advanced and Panels

● WinCC Runtime Professional
WinCC Runtime Professional also supports the connection of PLC data types (UDTs) and 
user data types to HMITags.

User data types also differ in their applicability with a specific communication driver. User data 
types are available for the following communication drivers:

● SIMATIC S7-300/400

● SIMATIC S7-1200

● SIMATIC S7-1500

Create user data types and user data type elements in the project library.           

Principle
For example, the different conditions of a motor can be described using 6 unique Boolean tags.

If the overall condition should be described with a single tag, this tag can be created based on 
a user data type. For each of the individual Boolean tags you create a user data type element 
in the user data type. 

This user data type can then be assigned complete to a faceplate for the motor. The created 
and released version of user data type is displayed at the tag in the "Data type" selection field.

Visualize processes
10.2 Working with tags

WinCC Professional V13.0
System Manual, 02/2014 3729



The configured properties of a user data type are used in the instances of the user data type. 
If required, you change individual properties directly at the point of use, e.g. at a tag. Changing 
a property at the tag does not affect the user data type created.

 

 NOTICE

Availability of user data types

The connection of user data types to faceplates is only supported in WinCC Runtime 
Advanced and Panels.

 

License regulation in Runtime
If you use external tags of the "User data type" data type in a faceplate instance, each user 
data type element is counted as a tag in Runtime.

Example
You have created two screens in the "Screens" editor: Screen_1 and Screen_2.

3 instances of a faceplate type are inserted in Screen_1. 4 instances of a faceplate type are 
inserted in Screen_2. 

Each faceplate instance is connected to an external tag of the "User data type" data type. The 
user data type includes 10 user data type elements.

Screen 1: 3 faceplate instances * 10 user data type elements corresponds to 30 external tags 
= 30 PowerTags.

Screen 2: 4 faceplate instances * 10 user data type elements corresponds to 40 external tags 
= 40 PowerTags.

In Runtime, 70 PowerTags are counted together for both screens. This also applies to the user 
data type elements that are not required.

See also
Creating tags with a user data type data type (Page 3734)

Basics of tags (Page 3674)

Creating user data type elements (Page 3732)

10.2.5.2 Creating a user data type

Introduction
You create a user data type in the project library.         
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Requirement
● A project is open.

● The "Libraries" task card is displayed or the library view is open.

Procedure
To create a user data type, follow these steps:

1. Click the "Libraries" task card.

2. Double-click the "Project library" item. The folder structure of the project library is open.

3. Click the "Create new type" button.
A dialog opens.

4. Click the "HMI UDT" button in the dialog. 

5. In the "Specify device for the new type" area select the HMI device on which the user data 
type is used.

6. Enter a descriptive name in the "Name" field. 

7. Click "OK" to apply your settings. The user data type is created. The library view opens.

 

Result
A user data type with the configured properties is created. Version  0.0.1 of the user data type 
is created and receives the status "in progress". 
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Create the required user data type elements in the next step.

Before you use the version of user data types, for example at a tag, the version must be 
released.

10.2.5.3 Creating user data type elements

Introduction
You define user data type elements in the library view. You add or delete elements in the "HMI 
user data types" table in the work area.

Requirement
● The library view is open.

● A user data type is created and opened in the editor.

Procedure
1. Select a communication driver for the user data type.

● If you select the <Internal communication> entry, you can only assign the user data type 
to the internal tags as the data type.

● If a connection to a PLC is selected as the communication driver, the user data type can 
only be assigned to tags with a connection to this PLC as the data type.

● The communication type set applies to all user data type elements of a user data type. In 
a user data type for the"WinCC Runtime Professional" family of devices, you can define for 
each user data type element whether the configured driver is used for control or internal 
communication.

1. Double-click "Add" in the "Name" column of the table. A new user data type element is 
added to the user data type.

2. Assign a name.

3. Select the required data type in the "Data Type" field.

4. Create as many user data type elements as you need.

5. You configure the user data type elements in the "Properties" group in the Inspector window.

Alternatively, you can configure the properties of the user data type elements directly in the 
table. To view hidden columns, activate the column titles using the shortcut menu.

Result
You have added elements to version 0.0.1 of the user data type. The version 0.0.1 has the 
status "in progress".

To use the version in the project, release the version in the next step.

Visualize processes
10.2 Working with tags

WinCC Professional V13.0
3732 System Manual, 02/2014



See also
Basics on user data types (Page 3729)

10.2.5.4 Managing versions of user data types

Introduction   
All user data types have at least one version. When a user data type is created, a version is 
created at the same time and this version has the status "in progress". You can edit the user 
data type in this status as required. When the editing is complete, you release the version of 
the user data type.

Requirements
● You have created a user data type.

● The user data type has the version 0.0.1. and the status "In progress".

● The "Libraries" task card or the library view is open.

Releasing a version   
1. Select the version 0.0.1 of the user data type in the project library.

2. Select "Release version" in the shortcut menu.
A dialog opens.

3. If necessary, change the properties of the version:

● Enter a name for the type in the "Name" field.

● In the "Version" field, define a main and an intermediate version number for the 
version to be released.

1. Select the options for the release:

● Select the check box "Delete all unused versions of the affected type" to delete all versions 
of 
the same type from the library if these are not assigned any instance in the project and no 
other dependencies exist.

You have released version 0.0.1 of the user data type.

Editing a version  
1. Select, for example, the released version 0.0.1 of a user data type in the project library.

2. Select "Edit type" in the shortcut menu. 

The library view opens. The new version 0.0.2 of the user data type is created.

The version has the status "in progress". 

Visualize processes
10.2 Working with tags

WinCC Professional V13.0
System Manual, 02/2014 3733



Restoring the last version of a user data type
The last released version of the user data type is version 0.0.2. 

You edit the user data type. A new version of the user data type, 0.0.3, is generated and 
receives the status "In progress".

1. Select the version of the user data type in the project library.

2. Select "Discard changes and restore version" in the shortcut menu.

Alternatively

1. If you have opened a version for editing, click "Discard version" in the toolbar.
The version is deleted.

All changes to the user data type since the last release operation are discarded. The user data 
type is released again and has version 0.0.2.

Deleting user data type
To delete a user data type, follow these steps:   

1. In the project library, under "Types", select the user data type you want to delete.

2. Select "Delete" from the shortcut menu. If the user data type is being used in a faceplate, 
a request will be made to confirm deletion of the user data type.

If you delete a user data type, you also delete all user data type elements contained therein. 
The entry remains in the allocated tag. In the "Tags" editor, a colored background appears to 
draw your attention to the fact that an invalid data type has occurred by the deletion. 

If you delete a user data type, all instances and copy templates of this user data type are 
deleted as well. You are informed by a warning message that the deletion action will delete 
existing instances or copy templates. Deletion starts after confirmation of the warning message 
with "OK".

10.2.5.5 Creating tags with a user data type data type

Introduction
When a tag is created, you assign the version of user data type as a data type. In the "Tag" 
editor you can create internal tags or tags with a link to a PLC. A tag has access to all user 
data type versions that use the same communication driver as the tag itself. 
In connection with a PLC, a user data type can only be used if the absolute addressing is 
selected.

Requirement
● A user data type with a user data type element is created.

● The user data type is enabled.

● The tag table is open.

● The Inspector window with the tag properties is open.
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Procedure
To create a tag of the "User data type" data type, follow these steps:

1. In the "Name" column, double-click "Add" in the tag table. A new tag is created.

2. In the Inspector window select "Properties > Properties > General".

3. Enter a unique tag name in the "Name" field.

4. Select the connection to the required PLC in the "Connection" box.

5. Select the desired version of the user data type in the "Data type" field. 
The selected connection determines which user data types will be displayed.
For internal tags, only user data type versions of the <Internal user data type> type are 
available.

For tags with a connection to a PLC, only those user data types that have a link to a PLC 
can be accessed.

6. Enter the address of the PLC that you want to access with the external tags in the "Address" 
field of the "Settings" area. The specified address must always point to the start data bit, 
for example, <DB1.DBX0.0>.
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Result
You have created a tag of the "User data type" data type. In additional steps you can configure 
the tag, for example, by setting the start value and limits.

With tags of the "User data type" data type, you can connect the dynamic properties of a 
faceplate instance, which then supplies these properties with values in Runtime.

If you wish to change the properties of a user data type tag, you must change the properties 
of the user data type element.

Properties such as "Start value", "Use substitute value" or " Linear scaling" can be changed 
in the employed instances of the user data type.

See also
Basics on user data types (Page 3729)

10.2.6 Working with cycles

10.2.6.1 Cycle basics

Introduction
Cycles are used to control actions that regularly occur in runtime. Common applications are 
the acquisition cycle, the logging cycle and the update cycle. You can also define your own 
cycles in addition to those already provided in WinCC.      

Principle
In Runtime, actions that are performed regularly are controlled by cycles. Typical applications 
for cycles:

● Acquisition of external tags
The acquisition cycle determines when the HMI device will read the process value of an 
external tag from the PLC. Set the acquisition cycle to suit the rate of change of the process 
values. The temperature of an oven, for example, changes much more slowly than the 
speed of an electrical drive.
Do not set the acquisition cycle too low, since this will unnecessarily increase the 
communication load of the process.

● Logging process values
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle.

The smallest possible value for the cycle depends on the HMI device that will be used in your 
project. For most HMIs, this value is 100 ms. The values of all other cycles are always an 
integer multiple of the smallest value.
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If the cycles provided in WinCC do not meet the needs of your project, you can define your 
own cycles using the "Cycles" editor. User-defined cycles must always be an integer multiple 
of the smallest value.

 

 Note
Device dependency

You cannot configure self-defined cycle times for Basic Panels.
 

Application example
You can use cycles for the following tasks:

● To regularly log a process.

● To draw attention to maintenance intervals.

See also
Defining cycles (Page 3737)

Basics of tags (Page 3674)

10.2.6.2 Defining cycles

Introduction
Use cycles to control actions that are run at regular intervals in Runtime. You can also define 
your own cycles in addition to those already provided in WinCC.   

Requirement
You have opened the project.

Procedure
1. Double-click the "Cycles" entry in the project navigation.

The "Cycles" editor opens.

2. In the "Name" column of the "Cycles" editor, double-click "Add".
A new cycle time is created.

3. Enter a unique name in the "Name" field.

4. Select the desired cycle unit.
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5. Select the desired value for the cycle time.
The available selection of values varies depending on the cycle unit selected. The smallest 
possible value for the cycle depends on the HMI device that will be used in your project. 
For most HMIs, this value is 100 ms. The available values are always an integer multiple 
of this value.

6. As an option, you can enter a comment regarding the use of the cycle.

Result
The cycle you configured is created and beside the default cycles in WinCC for use during 
configuration.

See also
Cycle basics (Page 3736)

10.2.7 Working with cycles

10.2.7.1 Cycle basics

Introduction
Cycles are used to control actions that regularly occur in runtime. Common applications are 
the acquisition cycle, the logging cycle and the screen cycle. You can also define your own 
cycles in addition to those already provided in WinCC.     

Principle
In Runtime, actions that are performed regularly are controlled by cycles. Typical applications 
for cycles:

● Refreshing screens
The screen cycle determines how often a screen will be refreshed. The screen cycle gives 
you the option to trigger all dynamizations in a screen at the same time. Use the predefined 
cycles in WinCC or self-defined cycles as cycle times. The standard setting for the screen 
cycle is 2 seconds.

● Updating objects
In the standard setting all dynamizations in a screen use the screen cycle. You can use 
other cycles to update individual objects, if necessary. See Basics on dynamization in the 
property list (Page 3446) for additional information.
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● Triggering scheduled tasks
In scheduled tasks you have the option to configure a task with a cyclical trigger. Use the 
cycle time to determine when the scheduled task is executed. See Triggers (Page 6096) 
for additional information.

● Logging process values
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle. See Cycles and 
Events (Page 3783) for additional information.

The smallest value for a cycle in Runtime Professional is 250 ms. The next possible value is 
300 ms; configure all additional value at increments of 100 ms. 

 

 Note
Defining your own cycles

If the cycles predefined in WinCC do not meet the requirements of your project, you can 
define your own cycles using the "Cycles" editor.

You can create and use an unlimited number of cycles. Keep in mind that you can only monitor 
up to 15 different update cycles in Runtime.

 

Starting point
You can define a starting point for every cycle in WinCC. This starting point will also apply to 
the cycles provided with the system. The following starting points are possible:

● Trigger cycle at start of Runtime

● Trigger cycle at system shutdown

● Trigger cycle at user-defined starting point

You can use cycle starting points for the following tasks:

● To synchronize different tasks within the system

● To relieve the load on the communication channels by postponing tasks with a high 
communication load.

Application example
You can use cycles for the following tasks:

● To regularly log a process.

● To draw attention to maintenance intervals.

See also
Defining cycles (Page 3740)

Define starting point (Page 3741)

Basics of tags (Page 3674)
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Cycles and Events (Page 3783)

Basics on dynamization in the property list (Page 3446)

Triggers (Page 6096)

10.2.7.2 Defining cycles

Introduction
Use cycles to control actions that are run at regular intervals in Runtime. You can also define 
your own cycles in addition to those already provided in WinCC.   

Requirement
You have opened the project.

Procedure
1. Double-click the "Cycles" entry in the project navigation.

The "Cycles" editor opens.

2. In the "Name" column of the "Cycles" editor, double-click "Add".
A new cycle time is created.

3. Enter a unique name in the "Name" field.

4. Select the desired cycle unit.

5. Select the desired value for the cycle time.
The available selection of values varies depending on the cycle unit selected. The smallest 
possible value for the cycle depends on the HMI device that will be used in your project. 
For most HMIs, this value is 100 ms. The available values are always an integer multiple 
of this value.

6. As an option, you can enter a comment regarding the use of the cycle.

Result
The cycle you configured is created and beside the default cycles in WinCC for use during 
configuration.

See also
Cycle basics (Page 3738)
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10.2.7.3 Define starting point

Introduction
For cycles, define the starting points to start different cycles at different times. Staggering the 
start of the update processes will also stagger the communication load on the connection to 
the PLC. 

Requirement
● The "Cycles" editor is open.

● The Inspector window with the cycle properties is open.

Procedure
To define the starting point for a cycle, follow these steps:

1. Select the cycle from the table in the "Cycles" editor.

2. Click "Properties > Properties > Starting point" in the Inspector window.
The properties for the starting point of the cycle are displayed.

3. Select the settings for the starting point.

4. Save the project.

Result
The selected cycle is started in Runtime at the configured starting point.

See also
Cycle basics (Page 3738)

10.2.8 Reference

10.2.8.1 Mapping and coding of data types

Introduction
WinCC sets the data type of an external tag according to the data type of the connected PLC 
tag. If the data type of the PLC tag is not available in WinCC, a compatible data type is 
automatically used at the HMI tag. As required, you can specify that WinCC uses a different 
data type and adapts the format of the data type of the PLC tag and the data type of the HMI 
tag. The following sections include the data types that are typically used for mapping. You will 
also find optional mapping versions that you can set yourself.
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Coding of data types
In addition to mapping of data types, you can also change the coding of many mapping 
versions. Coding is used to map and process the binary information of PLC tag according to 
the requirements. The values of the PLC tags can be mapped with the following coding:

BCD

The BCD code is a binary decimal code that maps each individual digit of a number in binary 
form. The value of the digits is according to the number sequence 8-4-2-1. The result is the 
following value table:

Decimal digit BCD code
0 0000
1 0001
2 0010
3 0011
4 0100
5 0101
6 0110
7 0111
8 1000
9 1001

Aiken

The Aiken code is a complementary BCD code. The value of the digits is according to the 
number sequence 2-4-2-1. The result is the following value table:

Decimal digit Aiken code
0 0000
1 0001
2 0010
3 0011
4 0100
5 1011
6 1100
7 1101
8 1110
9 1111

Excess

Excess-3 code is used for Excess coding. The Excess-3 code is a complementary BCD code. 
The value of the digits is according to the number sequence 8-4-(-2)-(-1). The result is the 
following value table:
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Decimal digit Excess code
0 0011
1 0100
2 0101
3 0110
4 0111
5 1000
6 1001
7 1010
8 1011
9 1100

ExtBCD

The "ExtBCD" coding used the BCD code described above for coding. But with "ExtBCD" the 
Most Significant Bit is interpreted as sign. 

MSB

The "MSB" coding uses the binary code standard for coding. But with "MSB" the Most 
Significant Bit is interpreted as sign.

NanoToMilliseconds

The PLC tags with the data types "LTime" and "LTime_Of_Day" contain a number of 
nanoseconds. However, since HMI tags do not process nanoseconds, these are converted 
into milliseconds by the coding "NanoToMilliseconds" in the HMI runtimes:

Value of the PLC tag with 
PLC data type "LTime" or "LTime_Of_Day"

Converted value in the HMI tags with the HMI data 
type "DInt" or "UDInt"

1000000 1
2000000 2
10000000 10
100000000 100
... ...

See also
Coding and value range of data types (Page 3743)

Adapting the data type of a tag (Page 3689)

10.2.8.2 Coding and value range of data types

Coding and value range
Depending on the selected coding, the value ranges listed in the tables are available for the 
different data types.      

PLC data type Byte
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Conversion Value range
Byte to UnsignedByte 0...255
Byte to UnsignedWord 0...255
Byte to UnsignedDword 0...255
Byte to SignedByte 0...127
Byte to SignedWord 0...255
Byte to SignedDword 0...255
Byte to BCDByte 0...99
Byte to BCDWord 0...255
Byte to BCDDword 0...255
Byte to AikenByte 0...99
Byte to AikenWord 0...255
Byte to AikenDword 0...255
Byte to ExcessByte 0...99
Byte to ExcessWord 0...255
Byte to ExcessDword 0...255

PLC data type Char

Conversion Value range
Char to UnsignedByte 0...127
Char to UnsignedWord 0...127
Char to UnsignedDword 0...127
Char to SignedByte -128...+127
Char to SignedWord -128...+127
Char to SignedDword -128...+127
Char to MSBByte -128...+127
Char to MSBWord -128...+127
Char to MSBDword -128...+127
Char to BCDByte 0...99
Char to BCDWord 0...127
Char to BCDDword 0...127
Char to SignedBCDByte -9...+9
Char to SignedBCDWord -128...+127
Char to SignedBCDDword -128...+127
Char to ExtSignedBCDByte -79...+79
Char to ExtSignedBCDWord -128...+127
Char to ExtSignedBCDDword -128...+127
Char to AikenByte 0...99
Char to AikenWord 0...127
Char to AikenDword 0...127
Char to SignedAikenByte -9...+9
Char to SignedAikenWord -128...+127
Char to SignedAikenDword -128...+127
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Conversion Value range
Char to ExcessByte 0...99
Char to ExcessWord 0...127
Char to ExcessDword 0...127
Char to SignedExcessByte -9...+9
Char to SignedExcessWord -128...+127
Char to SignedExcessDword -128...+127
Char to UnsignedByte 0...127
Char to UnsignedWord 0...127
Char to UnsignedDword 0...127

PLC data type Real

Conversion Value range
Real to Real +-1.79769313486231e+308
Real to UnsignedByte 0...255
Real to UnsignedWord 0...65535
Real to UnsignedDword 0...4294967295
Real to SignedByte -128...+127
Real to SignedWord -32768...+32767
Real to SignedDword -2147483647...+2147483647
Real to Float +-3.402823e+38
Real to MSBByte -127...+127
Real to MSBWord -32767...+32767
Real to MSBDword -2147483647...+2147483647
Real to BCDByte 0...99
Real to BCDWord 0...9999
Real to BCDDword 0...99999999
Real to SignedBCDByte -9...+9
Real to SignedBCDWord -999...+999
Real to SignedBCDDword -9999999...+9999999
Real to ExtSignedBCDByte -79...+79
Real to ExtSignedBCDWord -7999...+7999
Real to ExtSignedBCDDword -79999999...+79999999
Real to AikenByte 0...99
Real to AikenWord 0...9999
Real to AikenDword 0...99999999
Real to SignedAikenByte -9...+9
Real to SignedAikenWord -999...+999
Real to SignedAikenDword -9999999...+9999999
Real to ExcessByte 0...99
Real to ExcessWord 0...9999
Real to ExcessDword 0...99999999
Real to SignedExcessByte -9...+9
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Conversion Value range
Real to SignedExcessWord -999...+999
Real to SignedExcessDword -9999999...+9999999
Real to S5Timer 10...9990000
Real to S5Float +-1.701411e+38

PLC data type DWord

Conversion Value range
DWord to UnsignedDword 0...4294967295
DWord to UnsignedByte 0...255
DWord to UnsignedWord 0...65535
DWord to SignedByte 0...127
DWord to SignedWord 0...32767
DWord to SignedDword 0...2147483647
DWord to BCDByte 0...99
DWord to BCDWord 0...9999
DWord to BCDDword 0...99999999
DWord to AikenByte 0...99
DWord to AikenWord 0...9999
DWord to AikenDword 0...99999999
DWord to ExcessByte 0...99
DWord to ExcessWord 0...9999
DWord to ExcessDword 0...99999999
DWord to SimaticTimer 10...9990000
DWord to SimaticBCDTimer 10...9990000
DWord to UnsignedDword 0...4294967295
DWord to UnsignedByte 0...255
DWord to UnsignedWord 0...65535

PLC data type Float

Conversion Value range
Float to Float +-3.402823e+38 (no conversion)
Float to UnsignedByte 0...255
Float to UnsignedWord 0...65535
Float to UnsignedDword 0 to 4.294967e+09
Float to SignedByte -128...+127
Float to SignedWord -32768...+32767
Float to SignedDword -2.147483e+09 to +2.147483e+09
Float to Real +-3.402823e+38
Float to MSBByte -127...+127
Float to MSBWord -32767...+32767
Float to MSBDword -2.147483e+09 to +2.147483e+09

Visualize processes
10.2 Working with tags

WinCC Professional V13.0
3746 System Manual, 02/2014



Conversion Value range
Float to BCDByte 0...99
Float to BCDWord 0...9999
Float to BCDDword 0...9.999999e+07
Float to SignedBCDByte -9...+9
Float to SignedBCDWord -999...+999
Float to SignedBCDDword -9999999...+9999999
Float to ExtSignedBCDByte -79...+79
Float to ExtSignedBCDWord -7999...+7999
Float to ExtSignedBCDDword -7.999999e+07 to +7.999999e+07
Float to AikenByte 0...99
Float to AikenWord 0...9999
Float to AikenDword 0...9.999999e+07
Float to SignedAikenByte -9...+9
Float to SignedAikenWord -999...+999
Float to SignedAikenDword -9999999...+9999999
Float to ExcessByte 0...99
Float to ExcessWord 0...9999
Float to ExcessDword 0...9.999999e+07
Float to SignedExcessByte -9...+9
Float to SignedExcessWord -999...+999
Float to SignedExcessDword -9999999...+9999999
Float to S5Timer 10...9990000
Float to S5Float +-1.701411e+38

PLC data type Long

Conversion Value range
Long to SignedDword -2147483647...+2147483647
Long to UnsignedByte 0...255
Long to UnsignedWord 0...65535
Long to UnsignedDword 0...2147483647
Long to SignedByte -128...+127
Long to SignedWord -32768...+32767
Long to MSBByte -127...+127
Long to MSBWord -32767...+32767
Long to MSBDword -2147483647...+2147483647
Long to BCDByte 0...99
Long to BCDWord 0...9999
Long to BCDDword 0...99999999
Long to SignedBCDByte -9...+9
Long to SignedBCDWord -999...+999
Long to SignedBCDDword -9999999...+9999999
Long to ExtSignedBCDByte -79..+79
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Conversion Value range
Long to ExtSignedBCDWord -7999...+7999
Long to ExtSignedBCDDword -79999999...+79999999
Long to AikenByte 0...99
Long to AikenWord 0...9999
Long to AikenDword 0...99999999
Long to SignedAikenByte -9...+9
Long to SignedAikenWord -999...+999
Long to SignedAikenDword -9999999...+9999999
Long to ExcessByte 0...99
Long to ExcessWord 0...9999
Long to ExcessDword 0...99999999
Long to SignedExcessByte -9...+9
Long to SignedExcessWord -999...+999
Long to SignedExcessDword -9999999...+9999999
Long to SimaticTimer 10...9990000
Long to SimaticBCDTimer 10...9990000

PLC data type Short

Conversion Value range
Short to UnsignedByte 0...255
Short to UnsignedWord 0...32767
Short to UnsignedDword 0...32767
Short to SignedByte -128...+127
Short to SignedWord -32768...+32767
Short to SignedDword -32768...+32767
Short to MSBByte -127...+127
Short to MSBWord -32767...+32767
Short to MSBDword -32768...+32767
Short to BCDByte 0...99
Short to BCDWord 0...9999
Short to BCDDword 0...32767
Short to SignedBCDByte -9...+9
Short to SignedBCDWord -999...+999
Short to SignedBCDDword -32768...+32767
Short to ExtSignedBCDByte -79...+79
Short to ExtSignedBCDWord -7999...+7999
Short to ExtSignedBCDDword -32768...+32767
Short to AikenByte 0...99
Short to AikenWord 0...9999
Short to AikenDword 0...32767
Short to SignedAikenByte -9...+9
Short to SignedAikenWord -999...+999
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Conversion Value range
Short to SignedAikenDword -32768...+32767
Short to ExcessByte 0...99
Short to ExcessWord 0...9999
Short to ExcessDword 0...32767
Short to SignedExcessByte -9...+9
Short to SignedExcessWord -999...+999
Short to SignedExcessDword -32768...+32767
Short to UnsignedByte 0...255
Short to UnsignedWord 0...32767
Short to UnsignedDword 0...32767

PLC data type Word

Conversion Value range
Word to UnsignedWord 0...65535
Word to UnsignedByte 0...255
Word to UnsignedDword 0...65535
Word to SignedByte 0...127
Word to SignedWord 0...32767
Word to SignedDword 0...65535
Word to BCDByte 0...99
Word to BCDWord 0...9999
Word to BCDDword 0...65535
Word to AikenByte 0...99
Word to AikenWord 0...9999
Word to AikenDword 0...65535
Word to ExcessByte 0...99
Word to ExcessWord 0...9999
Word to ExcessDword 0...65535
Word to SimaticCounter 0...999
Word to SimaticBCDCounter 0...999
Word to UnsignedWord 0...65535
Word to UnsignedByte 0...255
Word to UnsignedDword 0...65535

See also
Mapping and coding of data types (Page 3741)
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10.2.8.3 Data types

Data types for SIMATIC S7-300/400

Overview         
The following table shows the data types for SIMATIC S7-300/400 with the corresponding HMI 
data types and value ranges in WinCC. 

PLC data type HMI data type Value range
Bool Bool 0 (FALSE), 1 (TRUE)
Byte USInt 0 … 255
Word UInt 0 … 65 535
DWord UDInt 0 … 4294967295
Char USInt 0 … 255
Int Int −32768 … 32767
DInt DInt −2147483648 … +2147483647
Real Real ±1.17549E-38 to ±3.40282E+38 

and 0.0
Time DInt −2147483648 … +2147483647
Date DateTime/UInt 0 … 65535
Time_of_Day, TOD DateTime/UDInt 0 … 86399999
S5Time UDInt 0 … 9990000
Counter UInt 0 … 999
Timer UDInt 0 … 9990000
String String -

Data types for SIMATIC S7-1200 and S7-1500

Data types for SIMATIC S7-1200 - V2

Overview         
The following table shows the data types for SIMATIC S7-1200 (V2) with the corresponding 
HMI data types and value ranges in WinCC. 

PLC data type HMI data type Value range
Bool Bool 0 (FALSE), 1 (TRUE)
SInt SInt -128 … +127
Int Int -32768 … +32767
DInt DInt −2147483648 … +2147483647
USInt USInt 0 … 255
UInt UInt 0 … 65535
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PLC data type HMI data type Value range
UDInt UDInt 0 … 4294967295
Real Real ±1.17549E-38 to ±-3.40282E

+38 and 0.0
LReal LReal ±1.79769313486231E+308 to 

±2.22507385850720E-308 and 
0.0

Time DInt −2147483648 … +2147483647
Date DateTime/UInt 0 … 65535
DTL DateTime -
Time_of_Day, TOD DateTime/UDInt 0 … 86399999
String String -
Char USInt 0 … 255
Array of Char String -
Byte USInt 0 … 255
Word UInt 0 … 65535
DWord UDInt 0 … 4294967295
PlcUDT PlcUDT  

Data types for SIMATIC S7-1500

Overview         
The following table shows the data types for SIMATIC S7-1500 with the corresponding HMI 
data types and value ranges in WinCC. 

PLC data type HMI data type Value range
Bool Bool 0 (FALSE), 1 (TRUE)
SInt SInt -128 … +127
Int Int -32768 … +32767
DInt DInt −2147483648 … +2147483647
LInt LReal -4,503,599,627,370,495 … 

+4,503,599,627,370,495
USInt USInt 0 … 255
UInt UInt 0 … 65535
UDInt UDInt 0 … 4294967295
ULInt LReal 0 … 4,503,599,627,370,495
Real Real ±1.17549E-38 to ±-3.40282E

+38 and 0.0
LReal LReal ±1.79769313486231E+308 to 

±2.22507385850720E-308 and 
0.0

S5Time UDInt 0 … 9990000
Time DInt −2147483648 … +2147483647
LTime DInt −2147483648 … +2147483647
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PLC data type HMI data type Value range
Date DateTime/UInt 0 … 65535
Time_of_Day, TOD DateTime/UDInt 0 … 86399999
LTime_of_Day, LTOD DateTime/UDInt 0 … 86399999
Date_And_Time, DT DateTime -
LDT DateTime -
DTL DateTime -
String String -
WString WString -
Char USInt 0 … 255
WChar - -
Byte USInt 0 … 255
Word UInt 0 … 65535
DWord UDInt 0 … 4294967295
Timer UDInt 0 … 9990000
Counter UInt 0 … 999
PLCUDT PLCUDT  

User-defined PLC data types (UDT)

Overview         
You can connect with the HMI tags and DB instances of user-defined PLC data types (UDT). 

The PLC data type and the corresponding DB instances are created and updated centrally in 
STEP 7. In WinCC, you can use the following sources as PLC tag (DB instances):

● Data block elements that use a UDT as data type

● Instance data blocks of a UDT

The data type is taken from STEP 7 and is not converted into an HMI data type. The access 
type is always "Symbolic access".

Elements of a PLC data type
You have access to the following elements in WinCC with a structured PLC data type:

● Elements that have been released for WinCC in STEP 7.

● Elements whose data types are supported in WinCC.
 

 Note
Invalid elements of a PLC data type in WinCC 

Invalid elements generate an error in WinCC. 

If you disable the "Accessible from HMI" option for the corresponding elements of the 
associated PLC data type in STEP 7, these elements are excluded in WinCC.
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Naming conventions
The following characters are invalid in the name of the PLC data type and generate an error 
in WinCC:

● Dot: "." 

● Square brackets: "(" and ")"

Properties
The properties of the PLC data type and its elements are adopted in WinCC. Depending on 
the data type used, the properties are read-only or can be written to in WinCC. 

If you change the connection of the PLC data type in WinCC, all elements of the PLC data 
type are deleted and the properties of the newly connected PLC tag are used.

In WinCC, you have access to STEP 7 comments on elements of the PLC data type. 

You have limited access to properties in WinCC for the following elements of PLC data types:

● Elements of the data type "Struct"

● PLC data type

● Multidimensional arrays

● Array of complex data types except "DTL"

Mapping of the data type "DTL"
If a PLC data type contains elements of the data type "DTL", these elements are mapped in 
WinCC without lower-level elements. The data type "DTL" turns into "DateTime" in WinCC. 

Data types for OPC DA

Overview         
The following table shows the data types for OPC DA with the corresponding HMI data types 
and value ranges in WinCC. 

PLC data type HMI data type Value range
VT_EMPTY DInt 4
VT_BOOL Bool 1
VT_I1 SInt 1
VT_UI1 USInt 1
VT_I2 Int 2
VT_UI2 UInt 2
VT_I4 DInt 4
VT_UI4 UDInt 4
VT_R4 Real 4
VT_R8 LReal 8
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PLC data type HMI data type Value range
VT_BSTR WString Number of characters
VT_DATE | VT_ARRAY (Array 
[lo..hi] of VT_DATE)

Raw /  Array [lo..hi] of DateTime -

VT_I1 | VT_ARRAY (Array [lo..hi] 
of VT_I1)

Raw /  Array [lo..hi] of SInt -

VT_UI1 | VT_ARRAY (Array 
[lo..hi] of VT_UI1)

Raw /  Array [lo..hi] of USInt -

VT_I2 | VT_ARRAY (Array [lo..hi] 
of VT_I2)

Raw /  Array [lo..hi] of Int -

VT_UI2 | VT_ARRAY (Array 
[lo..hi] of VT_UI2)

Raw /  Array [lo..hi] of UInt -

VT_I4 | VT_ARRAY (Array [lo..hi] 
of VT_I4)

Raw /  Array [lo..hi] of DInt -

VT_UI4 | VT_ARRAY (Array 
[lo..hi] of VT_UI4)

Raw /  Array [lo..hi] of UDInt -

VT_R4 | VT_ARRAY (Array 
[lo..hi] of VT_R4)

Raw /  Array [lo..hi] of Real -

VT_R8 | VT_ARRAY (Array 
[lo..hi] of VT_R8)

Raw /  Array [lo..hi] of LReal -

Data types for OPC XML DA

Overview         
The following table shows the data types for OPC XML DA with the corresponding HMI data 
types and value ranges in WinCC. 

PLC data type HMI data type Value range
Boolean Bool 0 (FALSE), 1 (TRUE)
Byte SInt -128 … +127
UnsignedByte USInt 0 … 255
Short Int -32768 … +32767
UnsignedShort UInt 0 … 65535
Int DInt −2147483648…+2147483647
UnsignedInt UDInt 0 … 4294967295
Float Real ±1.17549E-38 to ±-3.40282E

+38 and 0.0
Double LReal ±1.79769313486231E+308 to 

±2.22507385850720E-308 and 
0.0

String WString -
Base64Binary Raw -
ArrayOfByte (Array [lo … hi] of 
byte)

Raw -
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PLC data type HMI data type Value range
ArrayOfShort (Array [lo … hi] of 
short)

Raw -

ArrayOfUnsignedShort (Array [lo 
… hi] of unsignedShort)

Raw -

ArrayOfInt (Array [lo … hi] of int) Raw -
ArrayOfUnsignedInt (Array [lo … 
hi] of unsignedInt)

Raw -

ArrayOfLong (Array [lo … hi] of 
long)

Raw -

ArrayOfUnsignedLong (Array [lo 
… hi] of unsignedLong)

Raw -

ArrayOfFloat (Array [lo … hi] of 
float)

Raw -

ArrayOfDecimal (Array [lo … hi] 
of decimal)

Raw -

ArrayOfDouble (Array [lo … hi] of 
double)

Raw -

ArrayOfBoolean (Array [lo … hi] 
of boolean)

Raw -

ArrayOfString (Array [lo … hi] of 
string)

Raw -

ArrayOfDateTime (Array [lo … 
hi] of dateTime)

Raw -

Data types for Allen Bradley Ethernet IP

Overview         
The following table shows the data types for Allen Bradley Ethernet IP with the corresponding 
HMI data types and value ranges in WinCC. 

PLC data type HMI data type Value range
Bool Bool 0 (FALSE), 1 (TRUE)
SInt SInt -128 … +127
USInt USInt 0 … 255
Int Int -32768..+32767
UInt UInt 0 … 65535
DInt DInt −2147483648 … +2147483647
UDInt UDInt 0 … 4294967295
Real Real ±1.17549E-38 to ±-3.40282E

+38 and 0.0
String String Cannot be used
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Data types for Modicon Modbus TCP/IP

Overview         
The following table shows the data types for Modicon Modbus TCP/IP with the corresponding 
HMI data types and value ranges in WinCC. 

PLC data type HMI data type Value range
Bit Bool 0 (FALSE), 1 (TRUE)
+/- Int Int -32768 … +32767
Int UInt 0 … 65535
16 bit group UInt 0 … 65535
+/- Double DInt −2147483648 … +2147483647
Double UDInt 0 … 4294967295
Float Real ±1.17549E-38 to ±-3.40282E

+38 and 0.0
ASCII String Cannot be used

Data types for Mitsubishi MC

Overview 
The following table shows the data types for Mitsubishi MC with the corresponding HMI data 
types and value ranges in WinCC. 

PLC data type HMI data type Value range
Bool Bool 0 (FALSE), 1 (TRUE)
4-bit block USInt 0 … 255
8-bit block USInt 0 … 255
12-bit block UInt 0 … 65535
16-bit block UInt 0 … 65535
Int Int -32768 … +32767
Word UInt 0 … 65535
20-bit block UDInt 0 … 4294967295
24-bit block UDInt 0 … 4294967295
28-bit block UDInt 0 … 4294967295
32-bit block UDInt 0 … 4294967295
DInt DInt −2147483648 … +2147483647
DWord UDInt 0 … 4294967295
Real Real ±1.17549E-38 to ±-3.40282E

+38 and 0.0
String String Cannot be used
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10.2.9 Archive tags

10.2.9.1 Basic principles for data logging

Introduction
Data logging is used to collect, process and log process data from an industrial system. 

When you analyze the logged process data, you can extract important business and technical 
information regarding the operational state of the system. 

Application of the data logging
You can use data logging to analyze error statuses and to document the process. By analyzing 
data logs, you can extract the information necessary to allow you to optimize maintenance 
cycles, increase product quality and ensure that quality standards are met. 

See also
Basics of tags (Page 3674)

Logging Tags (Page 3760)

Data logging (Page 3776)

10.2.9.2 Data logging

Basics

Data logging

Introduction
Data is information that is collected during the process and saved in the memory of one of the 
connected automation systems. They represent the status of a plant in the form of 
temperatures, fill levels or switching states, for example. You define tags for acquiring and 
editing the process values in WinCC.   

External tags are used in WinCC to collect process values and to access a memory address 
in the connected automation system. Internal tags are not connected to any process and are 
only available to the associated HMI device.

Principle
The values of external and internal tags can be saved in data logs. Create a log tag for every 
tag and specify the log in which it is saved.
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Data logging is controlled via cycles and events. Logging cycles are used to ensure continuous 
acquisition and storage of the tag values. You can also trigger tag logging in response to 
events, such as the change in value of a tag. Define these settings independently for each log 
tag.   

In runtime, the tag values which are to be logged are captured, processed and stored in an 
ODBC database or a file.

Logging methods
In WinCC, you have access to the following logging methods:       

● Circular log

● Segmented circular log

● Circular log which sends a system alarm message when it is full

● Circular log which executes system functions when it is full.

Storage media and storage location
The logged data is stored in an ODBC database or in a file. An ODBC database is only available 
on a PC.  

Depending on the hardware configuration of the HMI device, the data logs and alarm logs can 
be saved locally (on the hard disk of the PC or on the memory card on a panel) or, if available, 
on a network drive.

You can further process the saved data in other programs for analysis purposes, for example.

Outputting logged data
In runtime, you can output the logged tag values as trends in the process screens.  
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See also
Logging Tags (Page 3760)

Storage locations of logs (Page 3759)

Storage locations of logs

Storage location of a log
Depending on the HMI device used, you have several options of setting up the storage location 
for a data log you may be using in WinCC flexible.

File - CSV (ASCII)
Data is saved to a CSV file in standard ASCII format.

If you want to read or evaluate logged data without using WinCC Runtime, use the "CSV file" 
storage location.

 

 Note

Double quotation marks or several characters are not permitted as list separators for the 
"CSV file" storage location. You can find the settings for list separators under "Start > Settings 
> Control Panel > Regional and Language Options".

 

File - TXT (Unicode)
Data is stored in Unicode.

This file format supports all characters that can be used in WinCC and WinCC Runtime. For 
editing, you will need software that can save files in Unicode, such as Notepad.

 

 Note

Use "File - TXT (Unicode)" as the storage location to log Asian languages.
 

File - RDB
Data is saved with quick access in a proprietary database. 

If you require maximum read performance in Runtime, use the "RDB file" storage location. 

Logs with checksum
The following files are generated under special circumstances:       

*.keep
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1. If a log is started without checksum and will be continued with a checksum.

2. If you update WinCC with a service pack or a new version and the Audit Trail or the log is 
continued with the checksum.

The content of the keep file will remain the same when compared with the original csv file or 
txt file. 

*.bak

If WinCC Runtime has determined a serious, irregular problem in the file.

Database
Data is saved to a database which is set up for ODBC access by the PC administrator. 

See also
Data logging (Page 3757)

Working with data logs

Logging Tags

Introduction
In Runtime, you store tag values in logs. You can then analyze the logged data at a later date. 
You define the following conditions for logging a tag:       

● The log tag, through which the values of the connected tag are logged.

● The data log in which the tag is stored.

● The cycle or the event with which the tag is stored.

● The value range within which the tag is stored.
 

  Note

You use data logging mainly to log the values of external tags. You can also log the values 
of internal tags.
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Principle
Several steps come together during data logging:

● Creating and configuring the data log
When you create a data log, you define the following settings:

– General settings, such as name, size and storage location

– Runtime start characteristics

– Behavior when the log is full

● Configuring the logging of tags
For every log tag, specify a data log in which the values of the connected tags and other 
information are logged, such as the time of logging.
When and how often the values of a log tag are logged are also defined. You have the 
following options: 

– "On demand":
The tag values are logged by calling the "LogTag" system function.

– "On change":
The tag values are logged as soon as the HMI device detects a change in the value of 
the tag.

– "Cyclic":
The tag values are logged at regular intervals. You can supplement the default cycles 
in WinCC with your own cycles based on the default cycles. The smallest value that can 
be set is 1 s. All other values are integer multiples of this value.
You can also restrict the logging of values within or outside a tolerance band. In this 
way, the logging of values within a relevant range of values is restricted.

 
Note the following points if you want to log a tag on demand:

– Do not log this type of tag in a segmented circular log in which tags are logged in a 
continuous cycle or in response to changes.

Background:

– If logging takes place on demand only rarely, the log segment will be filled by cyclically-
logged values, for example, and the next log segment will be created. If you then attempt 
to access the tag that was logged on demand, it will not be possible to display the tag 
since it is the current log segment that is accessed in Runtime. To remedy this, you 
should create a separate data log for tags that are logged only rarely.

● Further processing logged tag values
You can analyze the logged tag values directly in your project, such as in a trend view, or 
in another user program, such as Excel.

See also
Basic principles for data logging (Page 3757)

Data logging (Page 3757)

Configuring a checksum for a log (Page 3770)
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Evaluating the checksum of log data (Page 3771)

Log response to language switching in runtime (Page 3773)

Creating a data log

Introduction
Data logs are used to store values from external and internal tags in runtime. When you create 
a log, you must give it a name and define its size and storage location. In addition you can 
enter comments for each log.   

Requirement
● A project is open.

● The Inspector window is open.

Procedure
To create a data log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and alarm logs opens.

2. Open the "Data logs" tab and double-click "Add" in the "Name" column of the "Data logs" 
editor.
A new data log is created.

3. In the Inspector window select "Properties > Properties > General."

4. Enter a unique name for the log in the "Name" field.

5. Define the number of data records to be logged in each log in the "Number of data records 
per log" field.
The size of a log is calculated as follows: The number of items * the length of each tag 
value to be logged.
In the Inspector window, the maximum size that the log can reach if the currently selected 
number of data records is observed is displayed beneath the "Number of data records" 
input field.

6. In the "Storage location" field, select whether the logged data should be stored in a file or 
in a database. The log can only be stored in a database on a PC.
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7. If you selected "File" as the storage location, select the storage location for the file in the 
"Path" field.
On PC HMI devices, you save the log on the hard disk or on a network drive, if there is one. 
The syntax for path specification is as follows:

– For hard disk: <C:\My_File_Folder\My_Archives\Machine_1>

– For network drive: <\\My_Fileservername\My_File_Folder\My_Archives\Machine_1>

Select one the following storage location for Panel HMI devices:

– Memory card
Select the path <\Storage Card MMC>. Here, as required, a sub-folder can be specified, 
for example <\Storage Card MMC\My_Archives\TagLogs>

– USB memory 
Select the path <\Storage Card USB>. Here, as required, a sub-folder can be specified, 
for example <\Storage Card USB\My_Archives\TagLogs>

– Network drive
The syntax to specify the path is as follows: <\\My_Fileservername\My_File_Folder
\My_Archives\Machine_1>

The selection available depends on the HMI device in use.

8. If you selected "Database" as the storage location, specify whether the data source name 
from the system should be used or whether you want to enter one yourself. In the latter 
case, enter a name for the data source.

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

 

 Note

The characters which can be used in the name of the data source depend on the storage 
location.

If the "File" storage location is used, the following characters must not be used: \ / * ? : " < > 
|

If the "Database" storage location is used, the following characters may be used: a-z A-Z 0-9 
_ @ # $
However, the characters _ @ # $ may not be used as the first character of the name.   

The names of logs must be unique in a project. Log names must also be unique if different 
storage locations are selected for different logs. You must also assign different names for 
alarm logs and data logs.  

 

Result
The data log is created.

You can now configure tags so that their values are stored in this log.

To continue the log configuration, perform the following steps:
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● Define the restart characteristics of the log when Runtime is started.

● Define how the log should behave when it is full.

● Configure a function list for the "Overflow" event.

Managing logging behavior when Runtime starts

Introduction
When you configure a data log, you define the restart characteristics of the log when Runtime 
is started. You define whether the logging should start when Runtime starts in the log 
properties. You can also define whether an existing log will be continued or overwritten.  

You define the restart characteristics separately for each log.

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
To configure the restart characteristics of a data log, proceed as follows:

1. Select the log for which you want to define the restart characteristics in the "Data Log" editor.

2. In the Inspector window select "Properties > Properties > Restart behavior."

3. If you want logging to start when Runtime starts, enable the "Enable logging at runtime 
start" option in the "Logging" area.
You can also start logging in Runtime using the "StartLogging" system function, for example.

4. Select the restart behavior of the log in the "Log handling at restart" area.

– The logged values are deleted and logging is started again with the option "Reset log".

– The option "Append data to existing log" is used to append the values to be logged to 
the existing log.

Alternatively you can configure the restart characteristics of a log directly in the "Data log" 
editor table. To view hidden columns, activate the column titles using the shortcut menu.

Result
Logging will start in runtime according to your settings. 
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Controlling the Logging in relation to the Fill Level

Introduction
The size of a log is determined by the number of entries. You use the logging method to 
determine how the log responds when it is full.   

Logging methods
The following logging methods are available:

●  Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approx. 20% of the oldest entries are deleted. It is 
therefore not possible to display all the configured entries. During configuration, select an 
appropriate size for the circulation log. Alternatively, configure a segmented circular log.  

●  Segmented circular log
In a segmented circular log, multiple log segments of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.

●  Log that sends a system alarm when it is full
When a defined level is reached, such as 90 %, a system alarm is triggered. When the log 
is 100% full, new tag values are not logged. 

●  Log with level-dependent triggering of an event.
When the log is completely full, the "Overflow" event is triggered. Configure a function list 
for the event that will be carried out when the "Overflow" event occurs. When the configured 
size of the log is reached, new tag values are not logged.
The following system functions are available for further processing of full logs: For further 
details, refer to System functions for logs (Page 3769).

Requirement
● A data log has been created.

● The "Data log" editor is open.

● The Inspector window with the log properties is open.

Procedure
1. Select the log for which you want to define the logging method in the "Data Log" editor.

2. Select "Properties > Properties > Logging method" in the Inspector window and select the 
required logging method.

3. If you have selected the "Segmented circular log" type, enter the number of log segments.
If you selected a log with the "Display system alarm on" setting, specify the level as a 
percentage at which a system alarm is to be triggered.
If you selected the "Trigger event" setting, configure the function list in the "Events" group.

Alternatively you can configure the logging method directly in the "Data log" editor table. To 
view hidden columns, activate the column titles using the shortcut menu.
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The "Overflow" event is not available in the editor table. You must therefore configure the 
function list in the Inspector window.

Result
The selected log responds according to the settings in Runtime.

See also
System functions for logs (Page 3769)

Logging process values

Introduction
You can save the process values of a tag in a data log in Runtime. You define the following 
conditions for logging a tag:

● The log tag, through which the values of the connected tag are logged.

● In which log the values are stored

● The conditions under which the values are stored

● If only process values for a certain range of values are stored          

To log the tag values, assign a logging tag to an HMI tag. The logging tag is stored in the data 
log and logs the values of the connected HMI tag. You can configure logging tags directly in 
the "HMI tags" editor. The " HMI tags" editor contains the "Logging tags" editing table.

If the view of the "Logging tags" table is minimized, click the arrow button below the tag table.
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Figure 10-3 The "Logging tags" table is displayed.

Requirement
● The data log has been created.

● The tag for which you wish to configure the logging must already exist.

● The "Tags" editor is open.

● The "Logging tags" table is displayed.

● The Inspector window with the tag properties is open.

Procedure
To log process values in a tag, proceed as follows:

1. Select a tag in the tag table.

2. Double-click "Add" in the "Name" field in the "Logging tags" table.
A new logging tag is created; it is given the same name as the associated HMI tag.

3. Select the data log in which the values of the tags are to be logged under "Properties > 
Properties > General" in the Inspector window.

4. Select "Properties > Properties > Logging type" in the Inspector window and select the log 
type for logging.

– "Cyclic": The tag values are logged in accordance with the set logging cycle.

– "On change": The tag values are logged, as soon as the operator device detects a 
change in value.

– "On demand": The tag values are logged by calling the "LogTag" system function.

5. If you want to log tag values cyclically, select a cycle time in the "Logging cycle" area. 
Alternatively, you can define your own cycle using the object list. The smallest value that 
can be set is 1 s. All other values are integer multiples of this value.
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6. If you only want to log tag values outside or inside a defined value range, select "Properties 
> Properties > Deadband for logging" in the Inspector window. Define the values for the 
high and low limits.
If you want to configure a dynamic limit, select "HMI tag" using the selection button. In the 
second field, select the tag that contains the limit.
If you want to configure a fixed limit, select "Constant." Enter the limit value in the second 
field.
If you want to leave a limit undefined, select "None".

7. Under "Scope", specify whether tag values are to be logged only if they are within the 
defined limits or only if they are outside the defined limits.

Alternatively, you can configure the logging of a tag directly in the "Logging tags" editor table. 
To view hidden columns, activate the column titles using the shortcut menu.

You can also fully configure a logging tag in the "Historical Data" editor.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

 

 Note

To have the tag values actually logged in runtime, you must ensure that the data log is started. 
Logging can be started automatically at start up or by means of a system function. To 
automatically start the log, use the setting in the log Properties window.

 

Triggering a system function when log is full

Introduction
You can select a logging method that executes a function list as soon as the log is full.  

Application example
You can use system functions, for example, to swap the data from a full log file out to another 
log before the full log is overwritten. You can then continue to process the transferred data in 
another program. Assign the "CopyLog" system function to the "Overflow" event accordingly.  

Requirement
● A log with the "Trigger event" logging method is created.

● The "Data log" editor is open.

● The Inspector window with the data log properties is open.
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Procedure
To configure a system function for the "Overflow" event, proceed as follows:

1. Select the required log in the table in the "Data Log" editor.

2. In the Inspector window select "Properties > Events > Overflow."
The function list will open.

3. Double-click "Add function" and select the desired system function.

4. Configure the required parameters of the selected system function.

Result
During runtime, the function list will be executed as soon as the log is full.

System functions for logs

System functions
The following system functions are available for logging:

Function name How it works
ArchiveLogFile This function moves or copies a log to another storage location for long-

term archiving. Use the system function if you want to move the Audit Trail, 
for example, from a local storage medium to the server.
With Audit Trails, always use the "Move log (hmiMove)" mode, otherwise 
you will be violating the FDA guideline by duplicating the data stored.

LogTag Saves the value of the given tags in the given data log. Use the system 
function to log a process values at a specific time.

StartLogging Starts the logging process in the specified log. You can interrupt logging 
in Runtime by calling the "StopLogging" system function.

StopLogging Stops the logging process in the specified log. To resume logging in 
Runtime, select the "StartLogging" system function.

ClearLog Deletes all entries in the specified log.
StartNextLog Stops the logging process in the specified log. Logging is continued in the 

log segment that has been configured for the given log.
CloseAllLogs Closes all logs. The connection between WinCC and the log files or log 

database is terminated. You can use this system function, for example, to 
enable hot-swapping of the storage medium on the HMI device without 
exiting the Runtime software.

OpenAllLogs Opens all logs to resume logging. The connection between WinCC and 
the log files or log database is restored.

CopyLog Copies the contents of the specified log to another log.

Visualize processes
10.2 Working with tags

WinCC Professional V13.0
System Manual, 02/2014 3769



Configuring a checksum for a log

Introduction
In a regulated project, you have the option of assigning a checksum to the log data of an data 
log or alarm log. This checksum can be used during plant operation to determine if the data 
of this log has subsequently changed. 

Requirement
● GMP compliant configuration is enabled.

● A data log or alarm log has been created.

Procedure
Proceed as follows to configure a data log or alarm log for the use of a checksum:

1. Open the data log or alarm log in the corresponding log editor.

2. In the "Storage location" box, select "File - CSV (ASCII)" or "File - TXT (Unicode)".

3. Under "Properties > Properties > Logging method" in the Inspector window , select the 
option "Display system event at" or "Trigger event".

4. In the editor table activate the option "Activate checksum".
Columns that are not displayed are activated with the shortcut menu of the column title.

5. Save the project.
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Result
The log data of the log is assigned a checksum in runtime.

See also
Logging Tags (Page 3760)

Enabling GMP compliant configuration (Page 7231)

GMP-compliant configuration (Page 7228)

Evaluating the checksum of log data (Page 3771)

Evaluating the checksum of log data

Introduction
If you have configured a data log or alarm log with generation of a checksum, you can check 
if the log data has subsequently changed.

The DOS program "HmiCheckLogIntegrity" is available for checking the integrity of the log 
data.

The "HmiCheckLogIntegrity" program supports verification of the following files:

● Log files of alarm logs, data logs, and Audit in CSV format

● Log files of alarm logs, data logs, and Audit  in TXT format

● Recipe data records in CSV format

● Recipe data records in TXT format

You can find the "HmiCheckLogIntegrity.exe" program in the installation directory of WinCC 
under the folder "WinCC Runtime Advanced", for example <C:\Program Files\Siemens
\Automation WinCC Runtime Advanced>.

 

 Note
Audit Trail and Log with Checksum

Before you update WinCC with a Service Pack or a new version, exit and save the Audit Trail 
or the logs using checksum. After WinCC is updated, the audit trail or logs will be continued 
with new files using checksum. 

Make sure that the logs are started at a defined state with the new version.      
 

Procedure
1. Copy the file to be checked from the HMI device to your configuration computer.

2. Open a command line prompt with "Start > Programs > Accessories > Command Prompt".
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3. Enter the path to "HmiCheckLogIntegrity.exe" followed by a space in the command line 
prompt. After the space, enter the storage location of the file to be checked within quotation 
marks.

4. Press <Enter>.

5. The check is performed.
When the checked data are consistent, the "Consistency check succeeded" message 
appears.

When the checked data are inconsistent, the "Consistency check failed" message appears. 
Information about the first inconsistent line in the file is also displayed.

 

 Note

If there are spaces in the path to the "HmiCheckLogIntegrity.exe" program, you need to 
specify the path in quotation marks.

 

You can also check the integrity of the log data with the AuditViewer.

See also
Logging Tags (Page 3760)

Configuring a checksum for a log (Page 3770)

Enabling GMP compliant configuration (Page 7231)

Evaluating Audit Trails in AuditViewer (Page 7249)
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Log response to language switching in runtime

Introduction
In the Runtime settings of your HMI device, select the language to be used for writing to logs 
in runtime.       

Requirement
● The languages used in your project are activated in the "Project languages" editor, for 

example, "German (Germany)" and "English (USA)" .

Procedure
To determine the startup language, follow these steps:   

1. Select "Runtime settings > Language and fonts" in the project navigation.

2. Activate the runtime language, for example, "German (Germany)" and "English (USA)".

3. Set the "Language switch order". Use 0 to determine the startup language, for example:

– German 0.

– English 1
With "0", German is specified as the "Startup language".

4. Select "Runtime settings > General" in the project navigation.

5. Select the "Logs > Logging language > Startup language".

Result
The project starts after it is transferred. German is specified as the "Startup language" with 
"Language switch order". The logs are now written in German. During runtime, the operator 
switches the runtime language to English. The logs will still to be written in German.

The operator closes runtime. Due to the previously performed language switch, the next time 
the system starts the "startup language" is English. Since English is the startup language, the 
logs are now written in English.

The logging language remains English even when the language is switched again in runtime 
until runtime is closed once again.

If you use another option instead of "Startup language" to select the language, the logs are 
always written in the same language. This is true regardless of the language selected by the 
operator in runtime. 

See also
Logging Tags (Page 3760)
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Logging tags in the "Historical Data" editor

Configuring logging tags

Introduction
You can also create and edit logging tags in the "Historical Data" editor in WinCC. You also 
directly edit the properties of logging tags in the "Historical Data" editor.

 

 Note

If you delete, move or copy in the "Historical Data" editor, the changes also take effect in the 
tag table.

 

Requirement
● The "Data logs" tab is open in the "Historical Data" editor.

● A data log has been created.

Procedure
Proceed as follows to configure a logging tag in the "Historical Data" editor:  

1. Select an existing data log in the "Data logs" table of the editor.
Alternatively, double-click on "Add..." in the "Name" column to create a new data log.

2. Double-click "Add ..." in the "Name" column of the editor "Logging tags" table.

3. Enter a unique name for the logging tag in the "Name" field.
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4. In the "Process tag" field, click on the selection button and select the process tag for logging 
in the object list.

5. Select the desired trigger mode in the "Log type" field:

– "Cyclic": The tag values are logged in accordance with the set logging cycle.

– "On change": The tag values are logged, as soon as the operator device detects a 
change in value.

– "On demand": The tag values are logged by calling the "LogTag" system function.

6. If you want to log tag values cyclically, select the desired cycle time in the "Logging cycle" 
area. Alternatively, you can define your own cycle using the object list. The smallest value 
that can be set is 1 s. All other values are integer multiples of this value.

7. Configure additional parameters for logging in the table of the editor or in the Inspector 
window.

Result
The configured logging tag is created in the "Historical Data" editor and is also displayed in 
the tag table.
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10.2.9.3 Data logging

Data logging

Introduction
The logging system is used for data logging in Runtime. The logging system processes the 
process values cached in the Runtime database and writes them to the logging database.  

The following WinCC subsystems are involved in the data logging: 

● Automation system (AS): Saves the process values that are sent to WinCC via 
communication drivers.

● Data manager (DM): Processes the process values and returns them to the logging system 
via process tags.

● Log system: Processes the acquired process values (by calculating the average, for 
example). The method of processing depends on the configuration of the log.

● Runtime database (DB): Saves the process values that are to be logged.

Term definitions
The question of whether and when process values are acquired and logged is dependent on 
a variety of parameters. The parameters to be configured depend on the applied logging 
method:

● Acquisition cycle: Determines when the value of a process tag is read out in the automation 
system. You can, for example, configure an acquisition cycle for cyclic data logging.

● Logging cycle: Determines when the processed process value is saved in the log database. 
You can, for example, configure a logging cycle for cyclic data logging.

● Start/stop tag: Starts data logging when the assigned binary tag has the value "1". Logging 
stops as soon as the start condition is no longer in effect. You can configure a start/stop 
tag for cyclic-selective data logging. 

● Logging on demand: Process values are logged only upon demand. The request is 
controlled by a binary tag. Use the "Upon demand" trigger mode for the configuration.

● Data logging on change: Process values are logged only when they have changed. Use 
the "On change" trigger mode for the configuration.

See also
Basic principles for data logging (Page 3757)
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Basics

Basic principles for data logging

Introduction
Data logging is used to collect, process and log process data from an industrial system. When 
you analyze the logged process data, you can extract important business and technical 
information regarding the operational state of the system. 

How it works
The process values to be logged are compiled, processed and saved in the log database in 
Runtime. Current or previously logged process values can be output in Runtime as a table or 
trend. In addition, it is possible to print out logged process values as a report. 

Configuration
You configure the logging of process values in the "Historical Data" editor. You create data 
logs and compressed logs. You define the acquisition cycles, logging cycles, and select the 
process values to be logged.

You configure trend views and table views for displaying process data in Runtime in the 
"Screens" editor. These views allow you to output the process data in the form of trends and 
tables.

You configure the output of logged process data in report format in the "Reports" editor. You 
output the process data in the report as a table or a trend.

Application
You can use data logging for the following tasks:

● Early detection of danger and fault conditions

● Increase of productivity

● Increase of product quality

● Optimization of maintenance cycles

● Documentation of process value trends

See also
Telegram Tags (Page 3778)

Structure of a Telegram with Raw Data Tags (Page 3779)
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Logging tags

Introduction
The values of external and internal tags are stored in logging tags in a data log.

Logging tags
There must be one archive tag created in the data log for every tag whose values are to be 
logged. There are suitable types of logging tags for the various tag data types. We distinguish 
between the following types of logging tag:

● An analog archive tag stores numerical process values, such as the fill level of a tank.

● A binary archive tag stores binary process values, such as whether a motor was switched 
on or off.

Archived process values can be compressed. This compression is achieved through the 
application of mathematical functions, for example, averaging. Compressed process values 
of this type are stored in compressed logging tags in a compressed log.

Telegram Tags

Introduction
Telegramtags are needed for the acquisition of quickly changing process values, or if you want 
to combine several measuring points from one plant.

 

 Note

Telegram tags are of the "raw data type" in WinCC and are therefore also referred to a "raw 
data tags". 

 

Principle
In the automation system the process values are written to a binary file, and are sent as a 
telegram to WinCC where they are stored in a raw data tag.

Archiving of Telegrams
If you want the acquired process values belonging to a raw data tag to be archived, you need 
to configure a process-controlled tag in the data log. To enable the archive system to process 
the telegram in the process-controlled tag, select a format DLL. The format DLL is supplied 
with the automation system that you are using and dismantles the telegram, for example, to 
ascertain the process values. The process values are then written to the archive database.

A format DLL for the SIMATIC S7 is included as standard in the scope of delivery of WinCC.

If you want to log a raw data tag, you have to activate the "Archive data link" option in the 
properties of the raw data tag. In the Inspector window, activate the option under "Properties 
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> Properties > Raw data". When the option "Archive data link" is activated, you can select and 
connect the raw data tag at the logging tag under "Properties > General" in the "Process tag" 
field.

See also
Basic principles for data logging (Page 3777)

Structure of a Telegram with Raw Data Tags (Page 3779)

Structure of a Telegram with Raw Data Tags

Introduction
A telegram for the transfer of raw data tags consists of two parts: a header and a body.

Telegram header
The header contains general data, i.e. length of the telegram.  The high byte of data word 0 is 
not used by the system and might thus be assigned by the user as required.
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Telegram body
In the block status word, the format of the measurement values and the format of the 
measurement areas, among other things, are defined. Bit 10 is reserved and will be used in 
future versions for switching daylight saving and standard times (daylight saving time = 1).

Time and date are structured in accordance with the definition of the sequential time indication. 

To transfer a measurement area, 8 data words are necessary. In these words, the upper and 
lower limits of the tag and the archive are specified.

The following section contains a number of sample telegram types.

Type 1

Measured value of a process tag + date and time
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Type 2

n measured values of a process tag + date and time of each measured value

Type 3

n measured values of a process tag with date and time, and sampling cycle

Type 4

n measured values of various process tags with time and date
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Type 5

n measured values of various process tags without time and date

See also
Basic principles for data logging (Page 3777)

Telegram Tags (Page 3778)

Types of Logging

Trigger mode

Introduction
You can use different logging methods to log process values. This will allow you to monitor an 
individual process value at certain times, for example. You make the monitoring dependent 
on certain events. You can log quickly-changing process values without increasing the system 
load as a result. You can also compress existing logged process values to reduce the volume 
of data.
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Logging methods
The logging method is determined by the selected trigger mode. The following logging methods 
are available in Runtime:

● Cyclic data logging: Continuous data logging to monitor a process value, for example.

● Cyclic-selective data logging: Event-controlled, continuous data logging to monitor a 
process value within a specific time period, for example.

● Data logging on demand: Process values are logged only on demand from a trigger tag.

● Data logging on change: Process values are logged only when they have changed.

● Compressed log: Compression of individual logging tags or of entire data logs, such as the 
hourly averaging of process values that were logged every minute.

Cycles and Events

Introduction 
Data logging is controlled via cycles and events. The acquisition and logging cycles allow you 
to continuously acquire and store process values. You can also trigger or end data logging by 
demand or by events. Cycles and events may be combined. For example, a process value 
can be acquired regularly, but the logging will only be triggered by a binary event.          

Acquisition cycle
The acquisition cycle determines the interval at which the process value of a process tag is 
read. The shortest possible value is 500 ms. All other values are integer multiples of this value. 
The start time of an acquisition cycle is determined by the start time of WinCC Runtime.

 

 Note

A short acquisition cycle may lead to a high system load. Make sure that the acquisition cycle 
you select is only as short as you actually need.

 

Logging cycle
The logging cycle determines when a process value is saved in the logging database. The 
logging cycle is always an integer multiple of the acquisition cycle. The start time of the logging 
cycle depends on either the start time of WinCC Runtime or the selected starting point.

When you set the start time, the values will be logged after a delay, which will share out the 
logging load. Examples:
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● Process values are logged in three cycles: every minute, every two minutes, and every 
three minutes. This causes a high logging load every six minutes. You should therefore 
assign a different start time to each of the three cycles.

Logging cycle Selected start time
1 min At the 15th second
2 min At the 30th second
3 min At the 45th second

● Many process values must be logged every ten seconds. To distribute the logging load, 
configure two 10-second cycles with different starting points. Logging is performed at both 
of the selected starting points.
You can configure the starting point for a cycle in the cycle properties in the "Cycles" editor.

The logging load will be distributed by the different starting points.
 

 Note

If the same cycle is used for acquisition and logging, it does not necessarily mean that 
acquisition and logging are started simultaneously.

There might be a system delay of up to the length of one acquisition cycle between the time 
of acquisition and the time of logging.

 

Processing method
All process values read from the process tags during the time period between acquisition and 
logging will be processed by the logging function. There are different processing methods 
available for binary and analog values.

In a data log, use one of the following processing methods for analog values:  

● Current: Saves the last acquired process value.

● Total: Saves the sum of all acquired process values.

● Maximum: Saves the highest of all acquired process values.

● Minimum: Saves the lowest of all acquired process values.

● Average value: Saves the mean of all acquired process values.

● Calculation: The value to be logged is calculated from the most recently acquired process 
value. The calculation is made using a function created in the "Scripts" editor.

In a data log, use one of the following processing methods for binary values:

● 0 to 1: The logging takes place whenever the value changes from 0 to 1.

● 1 to 0: The logging takes place whenever the value changes from 1 to 0.

● On each change: The logging takes place whenever the value changes from 0 to 1 or from 
1 to 0.

● Always: The logging depends on the selected cycle and does not depend on the change 
in value.
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Events
Start events and end data logging. Conditions that trigger an event can be linked to a tag. 
Events are differentiated as follows in WinCC:

● Binary action: Responds to changes in a Boolean tag.
Example: Switching on a motor starts the data logging.

● Deadband criterion: Defines an absolute or percentage value by which the newly acquired 
tag value has to deviate from the old tag value so that the newly acquired tag value will be 
logged. The value change can be absolute or relative.
Example: Logging is triggered in response to temperature fluctuations greater than 2 %.

● Time-controlled event: Responds at a fixed time or when a defined period of time from the 
start of data logging has elapsed.
Example: A log is output after every shift change.

Cyclic data logging

Introduction   
Cyclic data logging begins when Runtime starts. The process values are acquired at fixed 
cycles and stored in the log database. You can also specify limits. The process value is then 
only logged if it is within the defined limits. A comparison of the process value with the limit 
values takes place after acquisition of the process value.

Cyclic data logging ends when Runtime closes.

How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. The acquisition cycle (1) determines when the process value is read from 
the memory of the connected PLC.

The Runtime component of the logging system processes the process value:

● Whether the process value is logged at all will depend on the way you have configured the 
system. For example, the process value may have to change by a certain amount or 
percentage (2).

● The logging function (3) defines how the acquired process values will be processed (by 
averaging, for example).
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The logging cycle (4) determines when the processed process value is written to the log 
database. 

Cyclic-selective data logging

Introduction   
The start of cyclic-selective data logging is controlled by a "Bool" type tag. Logging is started 
as soon as the tag takes the value "1" in Runtime. The process values are subsequently 
acquired at fixed cycles and stored in the log database. You can also specify limits. The process 
value is then only logged if it is within the defined limits. A comparison of the process value 
with the limit values takes place after acquisition of the process value.

Cyclic data logging is ended by the following events:

● When the tag for starting the logging has the value "0".

● When you exit Runtime.

When data logging stops, the most recently acquired process value is also logged.

How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. Data logging starts as soon as the tag for the start of logging has the value 
"1" in Runtime (2). The acquisition cycle (1) determines when the process value is read from 
the memory of the connected PLC.

The Runtime component of the logging system processes the process value:

● Whether the process value is logged at all will depend on the way you have configured the 
system. For example, the process value may have to change by a certain amount or 
percentage (3).

● The logging function (4) defines how the acquired process values will be processed (by 
averaging, for example).

When logging stops (6), the logging cycle (5) determines when the processed process value 
is written to the log database.
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Data logging on demand

Introduction   
Data logging on demand saves the current process value to the logging database only on 
demand in Runtime. The demand is controlled by a trigger tag. The trigger tag is of the data 
type "Bool". Logging takes place every time the status of the trigger tags changes. You can 
also specify limits. The process value is then only logged if it is within the defined limits. A 
comparison of the process value with the limit values takes place after acquisition of the 
process value.

Data logging on demand ends when Runtime closes.

How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. The process value is read from the PLC (1) when a request from the trigger 
tag (2) is received. The Runtime component of the logging system processes the process 
value. The current process value is then written to the logging database (3).

The process value is read anew from the connected PLC (1) with each new request from the 
trigger tag (2), it is processed and logged (3).

Data logging on change

Introduction   
Data logging on change saves the current process value to the log database in Runtime when 
the process value changes. You can also specify limits. The process value is then only logged 
if it is within the defined limits. A comparison of the process value with the limit values takes 
place after acquisition of the process value.

Data logging on change ends when Runtime closes.
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How it works

The external tags in WinCC correspond to a certain process value in the memory of one of the 
connected PLCs. The process value is read cyclically from the memory of the connected PLC 
(1) and monitored for change. The process value is logged when a change (2) occurs of the 
external tag.

The Runtime component of the logging system processes the process value.

The current process value is then written to the logging database (3).

Compressed log

Introduction   
To reduce the volume of data in the logging database, the logging tags for a specified period 
can be compressed. To do this, create a compressed log that will store each logged tag in a 
compressed log tag. The logging tags are retained, but they can also be copied, moved or 
deleted. The compressed log is stored in the log database in the same way as the data log.

How it works
This compression is achieved through the application of mathematical functions. To achieve 
this, one of the following functions is applied to the logged process values from a specified 
period:

● Maximum value: The highest process value is saved in the compressed log tag.

● Minimum value: The lowest process value is saved in the compressed log tag.

● Total: The total of all the process values is saved in the compressed log tag.

● Average value: The average process value is saved in the compressed log tag.

● Average weighted value: The average weighted process value is saved in the compressed 
log tag. The time period in which a tag value has not changed is included in the calculation. 
For tags which are acquired "on change", this function returns more meaningful results than 
the "Average value" function.

What happens to the old, logged process values after compression depends on which method 
of compression is used:
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● Calculate: The process values of the logging tags of the specified period are read out and 
compressed. The process values of the logging tags are retained.

● Calculate and copy: The process values of the logging tags of the specified period are read 
out, compressed and copied to the compressed log.

● Calculate and delete: The process values of the logging tags of the specified period are 
read out, compressed and then deleted.

● Calculate, copy and delete: The process values of the logging tags of the specified period 
are read out, compressed, copied to the compressed log and then deleted.

Example
The following example illustrates the way that the compressed log works:

A process value is archived once every minute and returns 60 values in one hour. The 
compression takes place over the course of one hour by averaging, for example. Accordingly, 
every hour, the average of the 60 values is calculated and is stored in the compressed log tag. 
What happens to the 60 values depends on the compression method described above.

See also
Creating a Compressed Log (Page 3796)

Creating a Compressed Log Tag (Page 3801)

Storing Process Values

Introduction       
Process values can be stored either in the log database on the hard disk or in the main memory 
of the Runtime logging system.

Storing in Archive Database
The process values to be logged are stored in two separate cyclic archives in the log database.

● Fast data log (A)

● Slow data log (B)

Each circular log consists of a configurable number of segments. You define a size in MB and 
a period (such as one day) for the segments.
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The process values are written continuously to the first segment (1). When the configured size 
of the segment is reached or the period is exceeded, the system switches to the next segment 
(2). When all the segments are full, the process data in the first segment is overwritten (3). In 
order that process data is not destroyed by the overwritten process, it can be swapped 
(exported).

The "Fast data log" stores the process values whose acquisition cycle is less than or equal to 
one minute. These process values are initially saved and compressed in a binary file. When 
the binary file has reached a specific size, it is stored in the cyclic archive. 

The "Slow data log" stores the process values whose acquisition cycle is longer than one 
minute. The "Slow data log" also stores the compressed logs. The data is written immediately 
to the circular log and is not compressed.

 

 Note

When starting Runtime, the system tests whether the configured size of a data buffer has 
been calculated to a sufficient size. If the configured size is too small, the system automatically 
adapts to the minimum size. 

 

Saving in Main Memory
In contrast to storage in the log database, process values archived in the main memory are 
only available while Runtime is active. Storing in the main memory has the advantage, 
however, that the values can be written and read very quickly. The process values stored in 
the main memory cannot be swapped out.

 

 Note

Compressed logs cannot be saved in the main memory. 
 

Optimized configuration
Use the available log types and the different storage methods to match logging to the dynamics 
of the changing process values.

Select the logging type depending on the frequency of the value changes of a tag and the 
necessity for logging.
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Combing the logging type with the selection of the matching circular log. Use shorter logging 
types, for example, only for tags whose values change quickly.

Swapping Out Process Values

Introduction      
You can swap out process values from the log database as a backup. All process values 
contained in a log segment are swapped out. A log segment is always swapped out when it is 
full and a new segment is started. A log segment is also swapped out when the time set for a 
segment change is reached and a new segment is started. 

Principle
You configure the swapping out of process values in the log settings. In the settings, you 
configure the size of the log and the log segmentsn as well as the time for the segment change. 
You should also state whether a backup is made in the settings.
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In the lines of the backup configuration you define where the backup is created and whether 
the backup file is signed. 

 

 Note

You can change a displayed process value in Runtime using the table view.

If the process value has already been swapped out of the data log, the modified value will 
not be transferred to the swapped-out log. The change only occurs in the local log segment.

If the log segment has not yet been swapped, the changed value is accepted permanently.
 

 

See also
Logging Settings (Page 3803)

Significance of Archive Value Flags
The data logging sets flags for every value that is written to the log. The flags indicate the state 
of the tags.

The flags are represented by a 2-word value. This value is decimal-coded and is shown in the 
third column of the database log. The flags must be converted to hexadecimal format for 
analysis purposes.

Structure of the 2-word value:

The High word contains the WinCC status flags or the quality code. The Low word contains 
the status flags for the data logging and an identifier for the content of the High word.

Code for High Word Content:

 Meaning
0x0 High word contains WinCC status flags
0x1 High word contains quality code
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Tag logging status flags:

Name of flag Value Meaning
PDE_RT_DAYLIGHT 0x001 Summer time
PDE_RT_SUBSTITUTION 0x002 Substitute value
PDE_RT_TIME_BEVOR_JUMP 0x004 Value prior to time jump
PDE_RT_TIME_BEHIND_JUMP 0x008 Value after time jump
PDE_RT_TIME_OVERLAPPED 0x010 Values during time overlap
PDE_RT_LOAD_SYSTEM 0x020 Value that is initially archived when the log is 

created
PDE_RT_RELOAD_SYSTEM 0x040 Initial value after archiving of RT
PDE_RT_CMPCOPY 0x080 Compressed value
PDE_RT_TIME_CHANGED 0x100 Time change took place
PDE_RT_HAND 0x200 Manual tag supply

Examples

Value in database 16842753
Hexadecimal 
representation

0101 0001

Coding for high word 0: High word contains WinCC status flag
Data logging status flag 001: Summer time
WinCC status flag 0101: Link to partner not established; tag initialization value 

Value in database 266242
Hexadecimal representation 0004 1002
Coding for high word 1: High word contains quality code
Data logging status flag 002: Substitute value
Quality codes 0004: Configuration error, value not accepted
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Working with data logs

Creating a data log

Logging tags

Principle
For the configuration of logs, the system distinguishes between the following log types:

● The data log stores process values in logging tags. When you configure the data log, select 
the process tags that are to be logged and the storage location.

● The compressed log compresses logging tags from data logs. The compressed log can 
further compress other compressed logs. When you configure the compressed log, select 
a calculation method and the compression time period.

Data buffer
For a data log, define whether the data buffer should be created on the hard disk or in the main 
memory.

In contrast to storage in the log database, process values logged in the main memory are only 
available while Runtime is active. Storing in the main memory has the advantage, however, 
that the values can be written and read very quickly. The process values stored in the main 
memory cannot be swapped out.

 

 Note

Compressed logs can only be saved on the hard disk.
 

See also
Logging Settings (Page 3803)

Configuring logging tags (Page 3814)

Creating a data log

Introduction 
The configuration of a data log consists of the following steps:    

● Create a data log.

● Configure the data log, for example, by selecting the storage location.

● Select the tags for logging.
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Requirement
● A project is open.

● The Inspector window is open.

Procedure
To create a data log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and compressed logs opens.

2. Open the "Data logs" tab and double-click "Add" in the "Name" column of the "Data logs" 
editor.
A new data log is created.

3. In the Inspector window select "Properties > Properties > General".

4. Enter a unique name for the log in the "Name" field.

5. In the "Storage location" field, decide whether the process values should be saved in the 
main memory or in a database.

6. If you select "Memory" as the storage location, set the number of data records to be logged 
per logging tag in the "Number of data records" field.

7. In the "Status" area, use the "Locked" option to determine whether the logging process is 
locked at the start of Runtime.
If you want to start logging in Runtime, you will need to deactivate the option again.

8. If the status of the logging lock changes, you can be informed of this via a C function or 
configure subsequent steps. To do this, select an available C function under "Properties > 
Properties > Events" in the Inspector window. The C function is called in Runtime from the 
log server when the "Locked" status changes. You must first write the C function in the 
"Scripts" editor. See "Function for status check of the log lock (Page 3815)" for additional 
information. Only one C function can be run by the "Changed lock" event.

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

Result
The data log is created.
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The next steps are to configure the higher-level logging parameters.
See "Specifying log settings (Page 3803)" for additional information.

 

 Note

The log name can be up to 32 characters long.

Do not use the following characters: '\\','\'', '.', ',', ';', ':', '!', '?', '"', '´', '`', '^', '~', '-', '+', '=', '/', '*', 
'#', '%', '&', '§', '°', '(', ')', '[', ']','{', '}', '<', '>', '|', ' ', 'ä', 'ö', 'ü', 'Ä', 'Ö', 'Ü', 'ß'

Capitalization is ignored.

The characters _ @ # $ cannot be used as the first character of a name.

The following terms may not be used when assigning a name: "times", "userarchives", 
"project", "archives", "defaultarchives", "defaultvariables", "templates", "tabletemplateitems", 
"curvetemplateitems".   

The names of logs must be unique in a project. Log names must also be unique if different 
storage locations are selected for different logs. You must also assign different names for 
alarm logs and data logs.  

 

 

See also
Specifying log settings (Page 3803)

Function for status check of the log lock (Page 3815)

Creating a Compressed Log

Introduction 
The configuration of a compressed log consists of the following steps:    

● Create the new compressed log.

● Configure the compressed log, for example, by selecting the calculation method and the 
time period for the compression.

● Select the logging tags that you want to add to the compressed log.

Requirement
● A project is open.

● The Inspector window is open.

Visualize processes
10.2 Working with tags

WinCC Professional V13.0
3796 System Manual, 02/2014



Procedure
To create a compressed log, proceed as follows:

1. Double-click on the "Historical Data" entry in the project tree.
The editor for data logs and compressed logs opens.

2. Open the "Compressed logs" tab and double-click "Add" in the "Name" column of the 
"Compressed logs" editor.
A new compressed log will be created.

3. In the Inspector window select "Properties > Properties > General".

4. Enter a unique name for the log in the "Name" field.

5. Select the processing method and compression period in the "Compression" area.
All times created in the "Cycles" editor that are >= 1 minute are available as the compression 
time period. If the compression cycle you want is unavailable, configure a new cycle time. 
Then select the new cycle as the compression time period.

6. Use the "Locked" option to determine whether the logging process is locked at the start of 
Runtime.
If you want to start logging in Runtime, you will need to deactivate the option again.

7. If the status of the logging lock changes, you can be informed of this via a C function or 
configure subsequent steps. To do this, select an available C function under "Properties > 
Properties > Events" in the Inspector window. The C function is called in Runtime from the 
log server when the "Locked" status changes. You must first write the C function in the 
"Scripts" editor. See "Function for status check of the log lock (Page 3815)" for additional 
information.

8. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Compressed log" editor. To view 
hidden columns, activate the column titles using the shortcut menu.

Result
The compressed log is created.

 

 Note

The log name can be up to 32 characters long.

Do not use the following characters: '\\','\'', '.', ',', ';', ':', '!', '?', '"', '´', '`', '^', '~', '-', '+', '=', '/', '*', 
'#', '%', '&', '§', '°', '(', ')', '[', ']','{', '}', '<', '>', '|', ' ', 'ä', 'ö', 'ü', 'Ä', 'Ö', 'Ü', 'ß'

Capitalization is ignored.

The characters _ @ # $ cannot be used as the first character of a name.

The following terms may not be used when assigning a name: "times", "userarchives", 
"project", "archives", "defaultarchives", "defaultvariables", "templates", "tabletemplateitems", 
"curvetemplateitems".

The names of logs must be unique in a project. You must also assign different names for 
compressed logs and data logs.  
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See also
Function for status check of the log lock (Page 3815)

Compressed log (Page 3788)

Creating a Logging Tag

Using Logging Tags

Principle
Logging tags are used to save the process values to be logged. Use process tags to specify 
which process data should be logged. The data type is automatically defined by the process 
tag selected. Use the trigger mode to configure whether a tag is to be logged in relation to the 
time or specific events.

In a compressed log, each compressed logging tag is stored in a separate compressed logging 
tag.

Basic procedure
For binary and analog logging tags, specify the trigger mode (cyclic, etc.) as well as the 
acquisition and logging cycles. Select the parameters to start or end logging according to the 
trigger mode. Specify the display limits and parameters for processing the process value 
according to the type of logging tag.

When configuring a compressed logging tag, select the processing method for forming the 
logging tags to be compressed, such as the mean value.

 

 Note

If you delete a logging tag, save the project and then create a new tag with the same name 
as the deleted tag; you can no longer access the previously saved values of the deleted tag 
for display or logging. Reason: The newly created logging tag is assigned a new ID. The ID 
of the deleted logging tag is no longer accessible.

 

Creating binary logging tag

Introduction   
To configure a binary logging tag, first create a logging tag and then connect it to a binary 
process tag. The data type of the logging tag will then be set automatically.

Then define the properties for the logging tag.
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Requirement
● A data log has been created.

● The binary tag for which you want to configure the logging must already exist.

● The "Historical Data" editor is open.

● The Inspector window with the logging tag properties is open.

Procedure
To create a binary logging tag, proceed as follows:

1. Select the data log in which you want to create the logging tag from the table in the "Data 
log" editor.

2. In the "Name" column of the "Logging tags" table, double-click "Add".
An logging tag is created.

3. Select "Properties > Properties > General" in the Inspector window and enter a unique 
name for the logging tag in the "Name" field.

4. In the "Process tags" field, select the binary tags to be linked to the logging tag.
Use the "Locked" option to define whether logging should be enabled or disabled when 
Runtime starts. You will have to deactivate the option once again if you want to start the 
logging in Runtime.

5. To reuse the logged values for other purposes, you can also write the value of the logging 
tag to an internal tag. The update process is determined by the cycle settings for the logging 
tag. Select the required tag from the "Copy logged value to tag" field.

6. Select "Properties > Properties > Logging type" in the Inspector window and select the 
required log type.
See "Trigger mode (Page 3782)" for additional information.

7. Select "Properties > Properties > Processing method" in the Inspector window and select 
the required processing method.
You can find more detailed information on this in the section "Cycles and Events 
(Page 3783)".

8. If necessary, enter a descriptive text under "Comment" to document your project.

You can configure the properties of a logging tag directly in the "Data log" editor. To view 
hidden columns, activate the column titles using the shortcut menu.

You can also configure logging tags in the tag table in the "Logging tags" tab.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

See also
Trigger mode (Page 3782)

Cycles and Events (Page 3783)
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Creating an analog logging tag

Introduction
To configure an analog logging tag, first create a logging tag and then connect it to an analog 
process tag. The data type of the logging tag will then be set automatically.

Then define the properties for the logging tag.   

Requirement
● The data log has been created.

● The analog tag for which you wish to configure the logging must already exist.

● The "Historical Data" editor is open.

● The Inspector window with the logging tag properties is open.

Procedure
To create an analog logging tag, proceed as follows:

1. Select the data log in which you want to create the logging tag from the table in the "Data 
log" editor.

2. In the "Name" column of the "Logging tags" table, double-click "Add".
An logging tag is created.

3. Select "Properties > Properties > General" in the Inspector window and enter a unique 
name for the logging tag in the "Name" field.

4. In the "Process tags" field, select the analog tags to be linked to the logging tag.
Use the "Locked" option to define whether logging should be enabled or disabled when 
Runtime starts. You will have to deactivate the option once again if you want to start the 
logging in Runtime.

5. To reuse the logged values for other purposes, you can also write the value of the logging 
tag to an internal tag. The update process is determined by the cycle settings for the logging 
tag. Select the required tag from the "Copy logged value to tag" field.

6. Select "Properties > Properties > Logging type" in the Inspector window and select the 
required log type.
See "Trigger mode (Page 3782)" for additional information.

7. Select "Properties > Properties > Deadband for logging" in the Inspector window and enter 
the required limits. Open the selection box and select the "Constant" entry to enable the 
input. Then enter the required limit value. Process values outside the limits will not be 
logged.
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8. Select "Properties > Properties > Processing method" in the Inspector window and select 
the required processing method.
For additional information see "Cycles and Events (Page 3783)".
You can specify a C function for converting tag values if you use the "Calculation" 
processing method. You must first write the C function in the "Scripts" editor. For additional 
information see "Converting values from logging tags (Page 3816)".

9. If necessary, enter a descriptive text under "Comment" to document your project.

Alternatively you can configure log properties directly in the "Data log" editor. To view hidden 
columns, activate the column titles using the shortcut menu.

Result
The process values of the configured tag are logged in Runtime according to the selected 
settings.

See also
Trigger mode (Page 3782)

Cycles and Events (Page 3783)

Converting values from logging tags (Page 3816)

Creating a Compressed Log Tag

Introduction
You can save the process values of a logging tag or a compressed tag from another 
compressed log in compressed form in a compressed logging tag. Select the mathematical 
function with which you want to compress the process values it contains.

The following compression functions are available:

● Weighted mean

● Maximum

● Minimum

● Mean value

● Sum

You create a compressed logging tag in the "Compressed log" editor.

Requirement
● You have created a compressed variable.

● You have created the logging tag you want to configure.

● The "Historical Data" editor is open.

● The Inspector window with the logging tag properties is open.
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Procedure
To create a compressed logging tag, proceed as follows:

1. Click the "Compressed logs" tab in the "Historical Data" editor.
The "Compressed logs" editor opens.

2. Select the compressed log in which you want to create the compressed logging tag from 
the table in the "Compressed log" editor.

3. Click on the vertical "Logging tag" tab on the right side of the window. The "Logging tags" 
task card opens. The task card shows all objects you can add to the selected compressed 
log.

4. In the task card, select the objects you want to add to the compressed log. You can select 
the following objects:

– Single or multiple logging tags

– A complete data log

– One or several compressed logging tags

– A complete compressed log

5. Open the shortcut menu of the selected object and select the menu command "Add." A 
compressed logging tag is created for each object selected and linked to the respective 
object. If you have selected a complete data log or a complete compressed log, a 
compressed logging tag is created for each tag contained in this log.
Alternatively, you can drag-and-drop the selected objects into the compressed log selected 
in step 2.

6. Select one or several compressed logging tags in the table of compressed logging tags. 
Specify more properties for the selected tags in the Inspector window.
Use the "Locked" option to define whether logging should be enabled or disabled when 
Runtime starts. If you want to start logging in Runtime, you will need to disable the option 
again.
Select the processing method for the compression in the "Compression" field.

7. If necessary, enter a descriptive text under "Comment" to document your project.
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You can configure the properties of a compressed logging tag directly in the "Compressed log" 
editor. To view hidden columns, select these from the shortcut menu for the column titles.

Result
The compressed logging tags are connected to the selected logging tags. The values from the 
logging tag are compressed using the set parameters in Runtime.

If you have selected the compressed logging tags from another compressed log, they will be 
compressed even further.

See also
Compressed log (Page 3788)

Specifying log settings

Logging Settings

Introduction
You configure the logical organization of data logs and compressed logs in the "Historical Data" 
editor. You can configure the basic properties of logs in Runtime Professional, such as the 
segment size, in the "Runtime settings > Logging" dialog.

You make the settings for data logs separately in the dialog for the "Fast data log" and "Slow 
data log" types.

The following conditions apply if you are using the default settings:

The Fast data log is used to store all values with a logging cycle <= 1 minute.

The Slow data log is used to store all values with a logging cycle > 1 minute.

You can change the cycle limit for allocation to the log type in the "Cycle" field in the "Runtime 
settings > Logging" dialog.

Overview of procedure
You configure the higher-level log configuration in the "Runtime settings > Logging" dialog. 
The following instructions contain a description of the configuration procedure:

Step Description
1 Defining the Log Size and Segmentation (Page 3804) 
2 Configuring the log backup (Page 3808) 
3 Assigning Logging Tags to the Log Types (Page 3810) 
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See also
Defining the Log Size and Segmentation (Page 3804)

Configuring the log backup (Page 3808)

Connecting the log backup (Page 3812)

Disconnecting a log backup (Page 3813)

Assigning Logging Tags to the Log Types (Page 3810)

Logging tags (Page 3794)

Swapping Out Process Values (Page 3791)

Defining the Log Size and Segmentation

Introduction
In the "Runtime settings > Logging" dialog, you define the sizes of the "Fast data log" and 
"Slow data log" types in the database. You can also subdivide the two types of log into 
segments. The size of the individual segments thus also defines the number of individual 
segments.       

The individual segments are filled one after the other in Runtime. Once a segment is totally 
full, it switches to the next segment. You can also configure the segment change at specific 
times. If you define a time for the segment change, the next log segment is filled when the time 
is reached.

 

 Note

Ensure that the log size does not exceed the free memory space available. The system does 
not validate the selected settings. A high number of linked log segments can lead to longer 
waiting periods in the system when starting and ending Runtime.

 

Requirement
A project is open.
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Procedure
To edit the higher-level log settings, proceed as follows:

1. In the project tree, open the folder containing Runtime Professional and double-click the 
"Runtime Settings" entry.
The Runtime settings dialog opens.

2. Click the "Logging" entry in the dialog.
The "Logging" dialog opens.
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3. Enter the required values in the "Time period of all segments" and "Maximum size of all 
segments" fields.

– When you enter the time period across all the segments and the maximum size, you 
also define the size of the logging database. If either of these criteria is violated, a new 
segment is started. When all the segments are filled, the oldest segment is overwritten.

4. Enter the required values in the "Time period contained in a single segment" and "Maximum 
size of a segment" fields.

– When you enter the time period for the single segments and the maximum size, you 
also define the size and number of single segments. If either of these criteria is violated, 
a new individual segment is started. When the criterion for "Time period of all segments" 
is exceeded, the oldest individual segment is also deleted.

5. Enter the start date and start time for the first segment change in the "Time of first segment 
change" field.

6. Continue the configuration from step 2 of the procedural overview and configure the log 
backup. See the "Configuring the log backup" section for additional details.

 

  Note

If you change the log size or the time period in Runtime, the change will not take effect 
until the next segment change.

 

Example
The input was configured:

Property Value
Time period of all segments 1 week
Maximum size of all segments 700 MB
Time period contained in one single segment 1 day
Maximum size of a segment 100 MB
Time of first segment change Friday, 23 November 2010 18:30

With the configuration shown in the table, the started segment will be changed for the first time 
at 18.30 on 23 November 2010. The next time-controlled segment change will take place 
cyclically, after periods of 1 day since the configured time. The segment will also change if the 
configured size of 100 MB is exceeded in the course of one day. The oldest single segment 
will be deleted if the maximum log size of 700 MB is exceeded.

Changing the log type
If the user does not change the relevant settings, the logging tags will be logged with a cycle 
time of <= 1 min in the "Fast data log". Logging tags with a cycle time > 1 min will be logged 
in the"Slow data log". The cycle time of a logging tag must not be changed in Runtime beyond 
the above limits. It is not possible to change of a logging tag from "Fast" to "Slow" log type and 
vice-versa in Runtime.
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After a cycle change or reconfiguration, if tags are to be stored in a different log type, these 
tags will be read from the currently valid log. Previous log values of this tag are not accessible 
in Runtime.

If you reconfigure the logging tags so that their values are stored in a log other than the previous 
log type, more memory will be required in the log concerned. You should therefore adjust the 
log size after making major changes.

 

 Note

Runtime data in the logs will be deleted if you reset the log configuration for data logging. 
Only previously swapped-out databases remain intact.

 

Resetting the log database
Use the "Extended loading" dialog to reset the log database settings. Select the HMI device 
in the project tree for this purpose and use the menu command "Online > Extended download 
to device". Select the interface for your HMI device. Click on "Download". The "Load preview" 
dialog opens. Make the settings for the reset in the "Load preview" dialog.

The reset will be executed when you start the download process.
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Configuring the log backup

Introduction   
Make regular backups of your log data to ensure complete documentation of your process.

 

 Note

The backup normally starts 15 minutes after the first time-related segment change. If the start 
of backup and start of segment should be synchronous with the start of Runtime, define the 
start time for the segment change prior to the start of Runtime.

You can change a displayed process value in Runtime using the table view. If the location of 
the log segment where the process value is stored has already been changed, then the 
modified value is not accepted in the shifted log. The change only occurs in the local log 
segment.

If the log segment has not yet been swapped, the changed value is accepted permanently.
 

Requirement
● Step 1 of the procedural overview is complete - Defining the Log Size and Segmentation 

(Page 3804)

● The "Runtime settings > Logging" dialog is open.

Procedure
Proceed as follows to create a log backup:

1. Activate the "Backup" option in the column containing the type of log for which you want to 
configure the backup, such as the "Fast data log" column.

2. In the same column, in the "Path" field, enter the storage location for the backup or browse 
to find the required storage location in the dialog. A network drive is also possible as the 
storage location.

3. If you want to create a redundant backup, select the "Backup to both paths" option.

4. In the "Alternative path" field, enter an alternative storage location for the backup or browse 
to find the required storage location in the dialog. A network drive is also possible as the 
storage location. The alternative storage location is used in the following situations:

– If the storage space on a backup medium is full.

– If the original storage location is unavailable due to a network failure, for example.

After the corresponding system alarms have been configured, the alarms are output, if the 
specified storage location is not available.
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5. If the log backup file should be signed, select the "Enable signing" option. On reconnecting 
to WinCC, the signature will allow the system to detect whether any changes were made 
to a log backup file after it was swapped out.

6. Continue the configuration from step 3 of the procedural overview and assign the logging 
tags to the log types. See the "Assigning Logging Tags to the Log Types (Page 3810)" 
section for more detailed information.

Structure of the Log Backup File
A log backup consists of two files with the extensions "*.LDF" and "*.MDF". To transfer a log 
backup to another computer, for example, copy the corresponding LDF and MDF files. The 
file name is in the following form: 
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". The type is 
defined by the log type:

● TLG_F: Data log with a logging cycle of one minute or less.

● TLG_S: Data log with a logging cycle of more than one minute.

The time period is specified in the following format: yyyymmddhhmm, e.g. 201012021118 for 
December 2, 2010, 11:18. Underscores "_" in the project name are displayed as "#".

Example:

FLEX-LOG2_WINCC#10#11#29#14#37#40_TLG_F_201011291414_201012030502.ldf

FLEX-LOG2_WINCC#10#11#29#14#37#40_TLG_F_201011291414_201012030502.mdf

Signing of the log backup files
If signing and backup are enabled, each log backup file is signed when it is swapped out. When 
the file is connected to WinCC once more, the signature is used to determine whether the file 
was changed after being swapped out.

If you use log signing, the maximum size of a single segment must not exceed 200 MB.

To verify the data, the "Signing enabled" option must be checked. Connecting "Slow" logs will 
take longer due to the signing.

The following values apply to the logging of signed data:

Logging signed data in Runtime Value/seconds
Fast data log 1,000
Slow data log 500 1)

1) With "Slow" type data logs, expect longer screen selection times for a given amount of data 
as those for "Fast" type data logs.

 

 Note

If you disable signing off to establish a fast connection to the backup files, for example, you 
should avoid segment changes while it is disabled. After the connection has been established, 
signing off should be reactivated in order to enable signing off for logged data.
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Activating and deactivating signing
You activate and deactivate signing in the Runtime settings of the HMI device. 

Activate or deactivate signing. If Runtime is running on the engineering station, recompile the 
project. The change becomes effective after compilation. If Runtime is running on a different 
PC than WinCC ES, you accept the change with online delta transfer. See Overview of online 
delta transfers (Page 7013) for more detailed information.

See also
Defining the Log Size and Segmentation (Page 3804)

Assigning Logging Tags to the Log Types (Page 3810)

Overview of online delta transfers (Page 7013)

Connecting the log backup (Page 3812)

Disconnecting a log backup (Page 3813)

Assigning Logging Tags to the Log Types

Introduction    
Data logging uses two different types of log to store data:

● Fast data log

● Slow data log

The logging tags are automatically allocated to the correct type of log. You can change this 
allocation in the log settings.

In Runtime, a changed assignment will only be accepted when the project has been 
deactivated and Runtime is restarted.

Requirement
● Step 2 of the procedural overview is complete - Configuring the log backup (Page 3808)

● The "Runtime settings > Logging" dialog is open.
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Procedure
To allocate the logging tags to the log types, follow these steps:

1. If you want to log acquired values to the fast data log on demand, activate the "Measured 
values with acquisition mode "On demand"" option in the "Fast data log" column.

2. Activate the "Cyclically measured values with cycles less or equal" option if you want to log 
logging tags to the fast data log with the "cyclic" trigger mode.

3. Select a cycle time as the upper limit of the logging cycle in the "Cycle" field. If necessary, 
select a factor for multiplying the selected cycle time in the "Factor" field.

4. Enable the "Compressed values with shorter or equal cycle" option if you want to log all 
compressed values with a logging cycle that is less than or equal to the limit allocated to 
the Fast data log.

5. Select a cycle time as the upper limit of the logging cycle in the "Cycle" field. If necessary, 
select a factor for multiplying the selected cycle time in the "Factor" field.

6. Save the project.

Result
All logging tags to which these settings apply are logged in the Fast data log. All logging tags 
to which these settings do not apply are logged in the Slow data log.
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Connecting the log backup

Introduction     
In order to access data of a log backup in Runtime, connect the log backup to the project again. 
You can establish a connection using a VB function or establish it directly. You can connect 
all backup segments that were created with each project. A requirement is that you did not 
change the log or the logging tags.

Requirement
● The corresponding LDF and MDF files for the log backup are located in a local folder on 

the configuration computer, such as the hard disk, MOD or CD.

Procedure
Proceed as follows to connect a log backup using a VB function:

1. Configure a button in a process screen and label the button "Connect log backup", for 
example.

2. Write a VB function using the "Restore" method based on this example:
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Restore("D:
\Backup","","2010-11-14",-1) & vbNewLine
See "Auto-Hotspot" for additional details.

3. Configure a list of functions for the "Click" event for the configured button.

4. Select the VB function thus created from the list of functions.

5. Save the project.

Result
The VB function is executed in Runtime when the button is clicked. The log backup is connected 
using the parameters defined in the function.

The logged process values from the log backup are sorted in time-stamp order in the configured 
display.

Connecting "Tag Logging Slow" logs takes longer if signing is enabled.

Automatic linking to a log
1. Insert the log backup files into the "CommonArchiving" folder.

The "CommonArchiving" folder is located in the project folder of your WinCC project.

2. In Runtime, the data log is automatically connected to the project.

If signing is enabled, signed log backup files that are changed will not be connected 
automatically. A WinCC system message is generated and an entry is added to the Windows 
event log in the "Application" section.
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See also
Configuring the log backup (Page 3808)

Disconnecting a log backup (Page 3813)

Disconnecting a log backup

Introduction
If you have connected a log backup in Runtime, you can also disconnect the connection once 
more. You can disconnect using a VB function or manually remove the backup log files from 
the "CommonArchiving" folder.    

Requirement
● The corresponding LDF file and MDF file of the log backup are located in the 

"CommonArchiving" folder in the project folder of the WinCC project.

Procedure
Proceed as follows to disconnect a log backup using a VB function:

1. Configure a button in a process screen and label the button "Disconnect log backup", for 
example.

2. Write a VB function using the "Remove" VBS method based on this example:
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Remove("","2010-11-14",-1) & 
vbNewLine
See "Auto-Hotspot" for additional details.

3. Configure a list of functions for the "Click" event for the configured button.

4. Select the VB function thus created from the list of functions.

5. Save the project.

Result
The VB function is executed in Runtime when the button is clicked. The log backup is 
disconnected from the log database. You will no longer have access to the data from the 
backup file in Runtime.

Alternatively, you can manually remove the backup files from the "CommonArchiving" folder. 
The "CommonArchiving" folder is found in the project folder of your WinCC project.

See also
Configuring the log backup (Page 3808)

Connecting the log backup (Page 3812)
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Logging tags in the "Tags" editor

Configuring logging tags

Introduction
You can also create and edit logging tags in the "HMI tags" editor in WinCC. You also directly 
edit the properties of logging tags in the "Tags" editor.

 

 Note

If you delete, move or copy in the "HMI tags" editor, the changes also take effect in the "Logs" 
editor.

 

Requirement
● The "Logging tags" tab is open in the "HMI tags" editor.

● You have created a tag.

Procedure
Proceed as follows to configure a logging tag in the "HMI tags" editor:  

1. Select an existing tag in the tag table.
Alternatively, double-click "Add" in the "Name" column to create a new tag.

2. Click on "Logging tags" in the lower editor. The editor for logging tags is brought to the 
foreground.
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3. Double-click "Add ..." in the "Name" column of the editor "Logging tag" table. A new logging 
tag is created. The logging tag is linked to the tag selected in the first step. The data type 
of the logging tag is taken automatically from the linked tag.

4. Select the desired logging tag from the "Data log" field. You can also create a new log using 
the object list.

5. Configure additional parameters for logging in the table of the editor or in the Inspector 
window.

Result
The configured logging tag is created in the "Tags" editor and is displayed in various editors.

See also
Logging tags (Page 3794)

Functions for data logging

Function for status check of the log lock

Introduction
You can monitor the "Locked" state of a data log using a C function. You need to create the 
C function in the "Scripts" editor with the correct syntax.

Description
This function is called in Runtime from the log server when triggered by a "Locked" status 
change. You can assign this function to the event "Lock state change" in the "Events" group 
in the "Data logs" or "Compressed logs" editor. The C function is then only displayed under 
the "Lock changed" event when the syntax below is correctly written in the function.
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Syntax
void function name (BOOL fFlag);

Parameters
fFlag

TRUE - log is locked

FALSE - log is released

Example application
You can use this function to receive information about the lock status of a log, for example.

Converting values from logging tags

Description
You can use this C function to convert tag values before logging them. This C function is 
assigned in the "Logging tags" editor in the properties of the logging tag under "Properties > 
Processing method". The C function is then only offered for selection in the "Analog processing 
method" field when the syntax below is correctly written in the function.

Syntax
double function name (double dLastValue,

 double dCurrentValue,

 DWORD dwCount,

 BOOL fArchivingCycle);

Parameters
dLastValue: most recently acquired value (from the most recent acquisition cycle)

dCurrentValue: currently acquired value

dwCount: current acquisition cycle since the most recent log cycle (for example, log cycle is 4 
x 1 seconds of acquisition cycle; the count is then 1 to 4, until the count starts again).

fArchivingCycle: TRUE = cycle is log cycle (default); FALSE = cycle is acquisition cycle

Example application
You can use this function to implement your own mean value calculation. The calculated mean 
value is used instead of the current tag value.

The following function determines the geometric mean value of the acquired process values:
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double CalculateGeometricMean (double dLastValue,double 
dCurrentValue,DWORD dwCount,BOOL fArchivingCycle)
{
 
static double dCurrentProduct = 1.0;
 
    double dReturnValue = 0.0;
 
if (!fArchivingCycle)
 
{
 
// 1. continuously calculate the product of all values with every 
scan cycle
 
dCurrentProduct *= dCurrentValue;
 
printf ("current value=%f current product=%f archiving cycle flag=%d
\r\n",dCurrentValue,dCurrentProduct ,fArchivingCycle);
 
dReturnValue = dCurrentProduct ; // optinonally - the return value 
is actually not of interest in a scan cycle
 
}
 
else
 
{
 
// 2. if this is the archiving cycle, use the product of all scan 
values to calculate
 
// the geometric mean value 
 
dReturnValue = pow (dCurrentProduct ,(double) 1 / dwCount);
 
      printf ("archiving cycle: geometric mean value=%f\r
\n",dReturnValue);
 
         printf ("\r\n");
 
         dCurrentProduct = 1.0; // reset current product
 
// the finally calculated value will be returned - this value will 
be archived
 
// since this is the archiving cycle
 
}
 
return dReturnValue;
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}
 

10.2.10 Displaying Tags

10.2.10.1 Displaying tags with Basic Panels

Outputting tag values in screens (Basic)

Introduction
In runtime you can output tag values in the screens of the operator device in the form of a 
trend. A trend is a graphic representation of the values that a tag takes during runtime. Use 
the "Trend display" graphic object to represent it. Process values for the trend display are 
loaded by the PLC from the ongoing process.     

The values to be displayed are determined individually within a fixed, configurable cycle. 
Cyclically-triggered trends are suitable for representing continuous curves, such as the 
changes in the operating temperature of a motor.

Displayed values
You will need to configure a trend view in a screen so that tag values are displayed on the HMI 
device. When configuring the trend view, specify which tag values are to be displayed.

You can control the updating of the trend display by defining the cycle time.

See also
Configuring trend display for values from the PLC (Basic) (Page 3818)

Basics of tags (Page 3674)

Configuring trend display for values from the PLC (Basic)

Introduction
You use a trend view to graphically represent values that a tag assumes during the 
process.     

Requirement
● A screen is open.

● The Inspector window with the trend view properties is open.
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Procedure
To configure a trend view, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Control" group to the screen.

2. Select the "Trend" category from the "Properties" group in the Inspector window and double-
click "<Add>" in the "Name" column.

3. Assign a name to the trend in the "Name" column.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. Select the number of trend values in the "Trend values" column.

6. In the "Settings" column, use the selection button to open the "Data source" dialog and 
select the tags to supply the trend with values.
Specify the cycle for reading the tags from the PLC.

7. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

  Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is 
activated. You set the column width and the position of the columns in the table header 
of the values table in active mode. In order to activate the trend view the zoom factor has 
to be set to 100 %.
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Result
In runtime, the values of the selected tags are displayed in the configured trend view. 

See also
Outputting tag values in screens (Basic) (Page 3818)

10.2.10.2 Displaying tags with Runtime Advanced and Panels

Trends

Introduction
A trend is a graphic representation of the values that a tag takes during runtime. In order to 
display trends, configure a trend view in a screen of your project.

To configure the trend view, specify a trend type for the values to be displayed.

● Log: For displaying the logged values of a tag

● Cyclical real time: For time-triggered display of values

● Bit-triggered real time: For event-triggered display of values

● Bit-triggered buffer: For event-triggered display with buffered data acquisition

Displaying logged values
In Runtime, the trend view displays the values of a tag from a data log. The trend shows the 
logged values in a particular window in time. The operator can move the time window in 
Runtime to view the desired information from the log.
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Pulse-triggered trends
The values to be displayed are determined individually with a definable time pattern. Cyclically-
triggered trends are suitable for representing continuous curves, such as the changes in the 
operating temperature of a motor.

Bit-triggered trends
The values to be displayed are event-driven by setting a defined bit in "Trend transfer" tags. 
The bit is reset after reading has been completed. Bit-triggered trends are useful for displaying 
fast-changing values, such as the injection pressure for producing plastic parts.

Bit-triggered trends with buffered data acquisition
When you set buffered data acquisition, the values to be displayed are buffered in the PLC 
and read in bit-triggered as a block. These trends are suitable for displaying rapid changes 
when the course of the trend as a whole is interesting and not so much the individual values.

You configure a switch buffer in the PLC so it can continue to write the new values while the 
trend buffer is being read. The switch buffer ensures that the PLC does not overwrite values 
while the operator devices reads the values for the trend.

The switch between the trend buffer and the switch buffer functions as follows:

Whenever the bit assigned to the trend is set in the "Trend transfer 1" tag, all the values are 
read simultaneously from the trend buffer and are displayed as a trend on the HMI device. The 
bit in "Trend Transfer 1" is reset after reading has been completed.

While the operator device is reading the tag values from the trend buffer, the PLC writes the 
new tag values into the switch buffer. When the bit which is assigned to the trend is set in the 
"Trend transfer 2" tag , all the trend values are read from the switch buffer and displayed at 
the operator device. While the operating device is reading the switch buffer, the PLC writes 
again to the trend buffer. 
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The structure of a *.CSV file with tags

Introduction
In the *.csv (comma-separated value) file format, the "Name" and "Value" table columns of the 
entry are separated by semicolons. Each table row ends with a line break.  

Example of a *.CSV file
The example shows a file with logged tag values:  

"VarName";"TimeString";"VarValue";"Validity";"Time_ms"

"Var_107";"01.04.98 11:02:52";66,00;1;35886460322,81

"Var_108";"01.04.98 11:02:55 AM";60.00;1;35886460358.73

"Var_109";"01.04.98 11:02:57 AM";59.00;1;35886460381.22
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Structure of a log file in *.csv format
The following values are entered in the individual columns of a log file:

Parameters Description
VarName Name of the tag from WinCC
Time string Time stamp as a STRING, e.g. readable data format
VarValue Value of the tag
Validity Validity: 

1 = value is valid
0 = an error occurred (e.g. interrupted connection)

Time_ms Specify a time stamp as a decimal value (see below for conversion).
Only needed to display the tag values in a trend.

Conversion of the time stamp decimal value
If the value needs to be processed using a different program, proceed as follows:

1. Divide Time_ms by 1,000,000.
Example: : 36343476928:1 000 000 = 36343,476928

2. The whole number portion (36344) is the date calculated from 31.12.1899.
Example: 36343 results in 02.07.1999
You can now convert the time stamp value to days in Excel by assigning a corresponding 
format from the "Date" group to the cells, which contain the time stamp.
Result: 37986 results in 31.12.2003

3. The value after the comma (0,476928) indicates the time:

– Multiply the value (0.476928) by 24 to obtain the hours (11.446272).

– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632).

– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792).

Result 11:26:46.579
This conversion is supported by Microsoft Excel, for example.

Direct access to the ODBC log database

Introduction
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
you want to use in WinCC from the Windows Start menu under "Settings > Control panel > 
ODBC Data Sources".

To store log data, specify the DSN, rather than a directory name during configuration. With the 
DSN, you are referencing the database and the storage location.
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Application
The entire functional scope of the database is available for additional processing and 
evaluation of log data.

Principle
The data source establishes the connection to the database. You create the data source on 
the same computer that contains the Runtime software. Then enter the DSN configured here 
when you create a log in WinCC.

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

With the "StartProgram" system function, you can also configure a program call (to MS Access, 
for example) on the HMI device. This does not interrupt Runtime.

Outputting tag values in screens

Introduction
In runtime you can output tag values in the screens of the operator device in the form of a 
trend. The process values are loaded by the PLC from the current process or from a log 
database.     

Displayed values
You will need to configure a trend view in a screen so that tag values are displayed on the HMI 
device. When configuring the trend view, specify which tag values are to be displayed.

The following options are available:

● Current values from the PLC
Writing of the trend is continued with individual values from the PLC. The following trigger 
types are available for display in real time:

– Bit-triggered real time: The time of the update can be controlled by setting a bit. Bit-
triggered trends are normally used to visualize rapidly changing values. One example 
might be the injection pressure in the production of plastic parts.

– Cyclical real time: You control the update time with a cycle. Cyclically-triggered trends 
are suitable for representing continuous curves, such as the changes in the operating 
temperature of a motor.

– Bit-triggered buffer: The trend contains values that were stored in a buffer in the period 
between two reads from the PLC. Use this format pattern if the course of the trend as 
a whole is more interesting than the individual values.

● Logged tag values
In runtime, the trend view displays the values of a tag from a data log. The following trigger 
type is available to display logged tag values:

– Data log: The trend shows the logged values in a particular window in time. To obtain 
the requested information from the archive, the operator uses the corresponding 
operator controls in the screen or in the trend view.
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Configuring trend displays for values from the PLC

Introduction
You use a trend view to graphically represent values that a tag assumes during the process.   

Requirement
● A screen is open.

Procedure
To configure a trend view, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Controls" group to the screen.

2. Select "Properties . Properties > Trend" in the Inspector window and double-click "Add" in 
the "Name" field. A new trend is created.

3. If required, enter a unique name for the trend in the "Name" field.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. Select the number of trend values in the "Trend values" column.

6. In the "Trend type" column, select the required trend type. The following entries are 
available:

– "Bit-triggered real time"

– "Cyclical real time"

– "Bit-triggered buffer"

– "Data log"
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7. In the "Settings source" column, use the selection button to open the "Data source" dialog 
and select the tags to supply the trend with values.
If you selected the "Cyclical real time" trend type, specify a cycle for reading the tags from 
the PLC.
Only for bit-triggered trends:

– Under "Bit", specify which bit of the "Trend request" tag and of the "Trend transfer" tags 
are to be assigned to the trend. Select a different value for each trend.

– Enter a tag under "Trend request" which contains at least as many bits as trends are to 
be displayed in the trend view. The status of the bits of these tags specifies which trend 
is currently being displayed at the operator device.

Only for the trend type "Bit-triggered real time":

– Enter a tag under "Trend transfer" which contains at least as many bits as trends are to 
be displayed in the trend view. The status of the bits of these tags specifies for which 
trend values are to be read from the PLC.

Only for the trend type "Bit-triggered buffer":

– Enter a buffer tag for the switch buffer. The tags have to be of the same type and of the 
same length as the trend tag.

– Enter a tag each under "Trend transfer 1" and "Trend transfer 2" which contains at least 
as many bits as trends are to be displayed in the trend view. The status of these tag bits 
specifies the trend for which values will be read from the PLC. "Trend transfer 1" controls 
reading from the trend buffer; "Trend transfer 2" controls reading from the switch buffer.

8. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

 Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is activated. 
You can set the column width and the position of the columns in active mode in the values 
table. In order to activate the trend view the zoom factor has to be set to 100 %.

 

Result
In runtime, the values of the selected tags are displayed in the configured trend view. 

Configuring a trend view for a data log

Introduction
You can use a trend view to display logged tag values in Runtime. The trend view shows the 
logged tag values in a particular window in time. To obtain the requested information from the 
archive, the operator uses the corresponding operator controls in the screen or in the trend 
view.     
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Application example
At the end of a shift, for example, an operator wants information about the process carried out 
during the shift.

Requirement
● A data log has been created.

● A screen is open.

● The Inspector window with the trend view properties is open.

Procedure
To configure a trend view to display values from a data log, follow these steps:

1. Add the "Trend view" object from the toolbox in the "Controls" group to the screen.

2. Select "Properties . Properties > Trend" in the Inspector window and double-click "Add" in 
the "Name" field. A new trend is created.

3. If required, enter a unique name for the trend in the "Name" field.

4. In the "Style" column, use the selection button to open the "Style" dialog and select the 
style of the line.

5. In the "Trend type" column, select the trend type "Data log".

6. In the "Settings" column, use the selection button to open the "Data source" dialog; select 
the data log and the tags to supply the trend with values.

7. You can make other settings in the dialogs of the Inspector window. For example, you can 
select the "Display table" option in the "Table" category to display a value table beneath 
the trend view.

 

  Note

If you hold down the <CTRL> key and double-click the trend view, the trend view is 
activated. You can set the column width and the position of the columns in active mode 
in the values table. In order to activate the trend view the zoom factor has to be set to 100 
%.

 

Result
In runtime, the logged values of the selected tags are displayed in the configured trend view.
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10.2.10.3 Displaying tags with Runtime Professional

Basics

Outputting the tag values

Overview
In Runtime you can output tag values as table or as trend. You can use either process values 
or logged values as source for the tag values.

Use a table, for example, for comparing tag values. In the table you can, for example, compare 
fill levels of supply tanks. 

Use a trend, for example, for graphically displaying tag values. Using a trend you can, for 
example, display the development of an engine temperature. 

Controls for displaying tag values
To display tag values in a table, use the table view. 

To display tag values as a trend, use the trend view. The trend view is available in two versions: 

● With the "f(t) trend view" you display a tag value against the time, e.g. a temperature trend.

● With the "f(x) trend view" you display a tag value against a second tag value, e.g. the engine 
speed against the heat produced.

In addition, the value table is a control with which you can create statistics from the displayed 
values. Furthermore, you can use the value table as reading assistance for the trend view. 

Configuration
In the table and trend view, you configure the following properties:

● Data connection

● Display mode

● Evaluation of data

● Configuration in Runtime

● Persistence of changed properties in Runtime

See also
Table view (Page 3829)

Properties of the trend view (Page 3829)

f(t) trend view (Page 3830)

f(x) trend view (Page 3831)
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Table view

Overview    
The table view in Runtime shows currently pending process values or logged values in a table. 
You can arrange the display of the table as you wish. 

In Runtime, you create statistics from selected data. You also export the data for further use.

The following image shows a table view in which the fill levels of three supply tanks are shown:

See also
Outputting the tag values (Page 3828)

Properties of the trend view

Number of trends
Both in the "f(x) trend view" and the "f(t) trend view" you can display an unlimited number of 
trends. For reasons of clarity, you should not, however, configure more than 8 trends at a time. 

Resolution of Trend Display
The number of trend values that can be displayed on the screen is limited by the screen 
resolution and configured size of the trend view. Therefore it is possible that fewer values are 
displayed in the trend view than actually exist in the period to be represented.
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If, for example, in an area of 100 pixels 200 measured values are archived, each pixel 
represents 2 measured values. The value shown on the screen is that of the most recent data 
(most recent time stamp).

The figure below shows a trend characteristic where each pixel represents a value pair with 2 
measured values:

1
2

3

① Real measured values
② Determined trend
③ Pixels

 

See also
f(t) trend view (Page 3830)

f(x) trend view (Page 3831)

Outputting the tag values (Page 3828)

f(t) trend view

Overview  
With the f(t) trend view you can display currently pending process values or archived values 
in Runtime as a trend against the time. You can create the trend display according to your 
wishes.

The following figure shows an f(t) trend view displaying two trends simultaneously: 
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See also
Properties of the trend view (Page 3829)

Outputting the tag values (Page 3828)

f(x) trend view

Overview   
With the f(x) trend view you can display currently pending process values or archived values 
in Runtime as a trend against another tag. You can create the trend display according to your 
wishes.

The following figure shows an f(x) trend view displaying two trends simultaneously:

Rules for the data source  
The following rules must be observed when displaying trends in the f(x) trend view:

● A trend can represent a maximum of 10000 value pairs

● The following sources are allowed to supply a trend with data:

– Online tags

– Logging tags

– Recipe elements

– User-defined: Data supply of value pairs using a script
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● The value pairs are displayed in the f(x) trend view. For the value pairs to be displayed at 
the same time, update the online tags or logging tags of a trend at the same time in Runtime. 
Use the same update cycle for each tag, for example.

● The logging tags of a trend must have the same update cycle and must be recorded in a 
continuous cycle

See also
Properties of the trend view (Page 3829)

Outputting the tag values (Page 3828)

Representation Trend Lines

Introduction  
In a trend view, you display a trend curve with one of the following display types:

● Dots

● Interpolated

● Stepped

Select "Properties > Properties > Trend > Style" to configure the properties of the trend display 
in the Inspector window.

Dots
Values are shown as dots. The display of the points can be configured as you wish.

The following image shows the trend curve with the display form "Dots":

Interpolated
The trend curve is interpolated on a linear basis from the values. The display of the lines and 
points can be configured as you wish.

The following image shows the trend curve with the display form "Interpolated":
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Stepped
The trend curve is interpolated as a stepped curve from the values. The display of the lines 
and points can be configured as you wish.

The following image shows the trend curve with the display form "Stepped":

Trend curve    
With the "Trend curve" option, you can specify where the current values for all trend windows 
are to be entered. Normally, the current values are written in the trend window from the right. 

You configure the "trend curve" in the Inspector window under "Properties > Properties > 
General > Display".  

See also
Creating trends for the trend window. (Page 3841)

Time range basics

Time range 
The time range is the range from which the values at the HMI device are shown. The time 
range is determined by the start time and the end time. The time range is always in the past. 
If the end time is later than the current system time, the current system time is used as a 
temporary end time. 

A distinction is made between the following time ranges:

● Static time range

● Dynamic time range

Static time range  
The static time range is determined by fixed start and end times. The values are displayed 
within this time range. 

Dynamic time range  
The dynamic time range is determined by a period of time beginning with a fixed start time. 
The end time thus corresponds to the conclusion of the time period.

You set the time period as follows:
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● Duration, e.g. 30 minutes

● The number of measurement points multiplied by the update cycle also produces a duration.

Configuring time range
Configure the time range for all controls. Configure the time range in the time column or in the 
time axis for the table view and the f(t) trend view. Configure the time range directly at the trend 
for the f(x) table view.

See also
Configuring the time axes of the the trend view (Page 3838)

Displaying logged values (Page 3884)

Representation Using Common Axes

Introduction
If you display several trends simultaneously in the trend view, assign each trend its own value 
and time axis. Alternatively, you can assign a shared time and/or value axis to several trends. 

You configure the axes of a trend view in the Inspector window under "Properties > Properties 
> Time axis / Value axis". 

The axes are assigned to the configured trends in the Inspector window under "Properties > 
Properties > Trends". 

Representation Using Different Axes   
If the values to be displayed in a trend view differ greatly, a common value axis makes no 
sense. If you assign each trend its own value axis, they should also display different scales. 
Individual axes can be hidden if required.

The following figure shows two trends with different value axes using an f(t) trend display as 
example: 
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Representation Using Common Axes   
If the comparability of the trend lines is important, common axes in a trend view is sensible. 
Connected trend views can have a common time axis.

If you configure trends with a shared time axis, use tags with the same update cycle for the 
data supply. 

In the case of different updating cycles, the length of the time axis is not identical for all tags. 
Since the trends are updated at different times due to the different updating cycles, a minimal 
different in the end time for the time axis occurs on each change. As a result, the trends 
displayed skip slightly to and fro on each change. 
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Making buttons in the toolbar dynamic

Introduction     
If you do not wish to operate the control via the toolbar, configure any operator control such 
as a script on an event. Each control button has a unique ID.

If you want to use a script to trigger a control button, assign the idea of the button to the 
"ToolbarButtonClick" property. 

If you wish to determine which button of a control has been pressed, configure a VB script or 
a C script at the event "Click toolbar button". The ID of the button is passed on to the script as 
the parameter "toolbarbuttonID".

Example: Opening the configuration dialog for the control using VBS
To open the "Control_1" configuration dialog of the control using VBS, you have the following 
options:

● Call in a script of an operator control event, e.g. a button:
ScreenItems("Control_1").ToolbarButtonClick = 2

● As an alternative to the property "ToolbarButtonClick", there are also methods in VBS for 
operating the toolbar:
Dim obj
Set obj = ScreenItems("Control_1")
obj.ShowPropertyDialog

Example: Opening the configuration dialog for the control using C script
To open the "Control_1" configuration dialog of the control in a C script, you have the following 
options:

● SetPropertyByConstant ("Screen_1", "Control_1", 
"ToolbarButtonClick", "2");

See also
Using the trend and table view in Runtime (Page 3869)
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Output of tag values in the form of a trend

Configure trend view

Introduction
To display tag values graphically in Runtime, add a trend view to a screen. In the "Tools" task 
card, two trend views are contained under "Controls":

● f(x) trend view

● f(t) trend view

The axis designations are different for the two trend views:

● The f(x) trend view has an "X axis" and a "Y axis"

● The f(t) trend view has a "time axis" and a "value axis"

Requirement
● The screen is opened

● The Inspector window is open

Procedure  
To configure a trend view, follow these steps:

1. Add the required trend view to the screen from the "Tools" task card.

2. Configure the appearance of the trend view in the Inspector window:

– Configure the basic properties of the trend view, e.g. "Time base" or "Trend 
characteristic", under "Properties > Properties > General".

– Configure the appearance of the trend view under "Properties > Properties > 
Appearance".

– Configure the properties of the trend view in Runtime under "Properties > Properties > 
Window".

3. Configure additional diagrams, if required.

4. Configure the axes of the trend view in the Inspector window.

– Configure the properties of the axes.

– Assign each axis to a diagram of the trend view.

5. Enter the trends in the Inspector window that are shown in the trend view:

– Define the "data source" for each trend.

– Assign each trend the "diagram" in which it will be displayed.

– Assign the axes to each trend.

– Configure the view of each trend.
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6. Configure the toolbar and status bar of the trend view.

7. If required, configure the data export from the trend view.

8. If required, configure the security settings of the trend view.

Result
The trend view is configured. Define an additional value display if you want to evaluate the 
data of the trend view in Runtime. You can also configure the value display as a "Ruler". 

See also
Configuring the time axes of the the trend view (Page 3838)

Configuring the value axis of the the trend view (Page 3839)

Creating diagrams in the trend view (Page 3840)

Creating trends for the trend window. (Page 3841)

Defining the data source (Page 3842)

Configuring toolbar and status bar (Page 3844)

Configuring the export of Runtime data (Page 3845)

Determining the effect of the online configuration (Page 3846)

Online configuration of the f(t) trend view (Page 3872)

Configuring the time axes of the the trend view

Introduction
The time range for trend display is configured with time axes. In a trend view you can create 
several time axes, which you can assign to one or more diagrams.

If you assign several time axes to a trend view, the sequence of the time axes in the Inspector 
window corresponds to the sequence in the trend view. If several time axes are aligned to the 
same side of a trend display, the first time axis in the list takes the lower left position. The last 
time axis takes the upper right position.

The time axis is available only with the f(t) trend display. 

Requirement
● The trend view is selected in the screen

● The Inspector window is open
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Procedure    
To configure the time axis of a trend view, follow these steps:

1. Double-click "Add" in the Inspector window under "Properties > Properties > Time axis" to 
add a new time axis.

2. Enter the "Name" and "Display name" of the time axis.

3. Configure the "axis style".

4. Select the "diagram" to which the time axis will be assigned.

5. Configure the "time range" and "format" of the time display of the time axis.

6. To always update the trends assigned to the time axis in the trend view, activate "Online".
If you want to compare a current trend display with an earlier trend display, for example, 
supply the comparison trend from a logging tag.

Result
The time axis is configured. Assign the time axis to one or several trends. 

See also
Time range basics (Page 3833)

Structure of the time format specification (Page 3847)

Structure of the date format specification (Page 3848)

Configuring the value axis of the the trend view

Introduction 
In a trend view you can create several value axes, which you can assign to one or more 
diagrams. 

The following properties are set by default with a value axis:

● The value range is based on the current values of the assigned trend

● The value axis scale is linear to the value range

Alternatively, you can configure a logarithmic scale:

● In logarithmic scaling, only positive values are displayed.

● In negative logarithmic scaling, only negative values are displayed.

If you configure a value axis for the f(t) trend view, you can also set up axis sections. A value 
range and a display name are assigned to an axis section. 

In the f(x) trend view, the value axis corresponds to both the "X axis" and the "Y axis". 
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Requirement
● The trend view is selected in the screen

● The Inspector window is open

Procedure         
To configure the value axis of a trend view, follow these steps:

1. Double-click "Add" in the Inspector window under "Properties > Properties > Value axis" to 
add a new value axis.

2. Enter the "Name" and "Display name" of the value axis.

3. Configure the "axis style".

4. Select the "diagram" to which the value axis will be assigned.

5. If required, configure the "value range" of the value axis.

6. If required, configure the "format" of the value axis labels.

7. If required, configure the "scaling" of the value axis.

8. If you configure an f(t) trend view, you can define "axis sections" if necessary:

– Activate "User-defined axis sections".

– To add an axis section, double-click on "Add".

– Enter the "value range" of the axis section.

– Configure the "display range" of the axis section.

– Enter the "display name" of the axis section.

Result
The value axis is configured. Assign the value axis to one or several trends. 

Creating diagrams in the trend view

Introduction   
A trend view is assigned a display range as standard, in which you can configure one or more 
trends. 

Alternatively, you can subdivide the display range into several "diagrams". Each "diagram" 
functions like a standalone trend view. In this way, for example, temperature changes can be 
displayed clearly without overlapping trends. You can set the height of a diagram using "Range 
proportion". The "range proportion" establishes how much room is made available to a diagram 
in the trend view. 
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Calculation of range proportion  
The amount of each range proportion can be calculated from the total number of range 
components. If, for example, you have configured a total of three diagrams, a range proportion 
of "1" each will result in three diagrams of equal size. To increase the size of range components 
in relation to each other, increase the range proportion of one or more diagrams. Changes to 
the range proportions immediately affect the trend view. 

Requirement
● Trend view is selected

● The Inspector window is open

Procedure
Proceed as follows to subdivide a trend view into several diagrams:

1. Double-click on "Add" under "Properties > Properties > Diagrams" in the Inspector window.
The diagram is added.

2. Enter a meaningful "Name" for the diagram.

3. Select the "range proportion" for the diagram in the trend view.

4. Configure the diagram "grid".

5. Configure the diagram "ruler".

Result
The diagram has been created. You can assign one or more trends to each diagram. 

Creating trends for the trend window.

Introduction
A trend allows you to represent values in the trend view. You assign a time axis and value axis 
to each trend. The value axis assigned to the trend determines the trend view in which the 
trend will be displayed. 

By default, the data area is based on the current values of the assigned trend. 

You can also configure the visualization of limits and values with "uncertain status" for a trend. 
If a trend exceeds or falls below a configured limit, the trend is colored. 

If you assign several trends to a trend view, the sequence of the trends in the Inspector window 
corresponds to the sequence in the trend view. 

Requirement
● The trend view is selected in the screen

● Time axes and value axes are configured
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● Tags for the data source are configured

● The Inspector window is open

Procedure   
To add a trend, follow these steps:

1. Double-click on "Add" under "Properties > Properties > Trends" in the Inspector window.

2. Enter a "label" for the trend.

3. If required, configure the "style" of the trend.
The changes are shown in a preview. 

4. Configure the data source.

5. If required, configure the "data area" of the trend.

6. Select the "diagram" in which the trend will be displayed.

7. Assign a "value axis" and "time axis" to the trend.

8. If required, configure the "limits" of the trend.

Result
The trend is configured. 

See also
Representation Trend Lines (Page 3832)

Defining the data source (Page 3842)

Defining the data source

Introduction        
Using the data source, you define the sources from which the values are displayed on the HMI 
device in Runtime. The following sources are available:

● Current process values from tags

● Archived values from logging tags

● Recipe elements (only f(x) trend view)

● Data supply by means of script in Runtime

Requirements
● An online tag or logging tag is configured

● Value column or trend has been created

● The Inspector window is open
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Displaying current process values
Proceed as follows to display current process values:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

– Select the "update cycle".

Displaying values from a log
Proceed as follows to display values from a log:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Logging tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

Displaying values from recipes
Output values from recipes in a f(x) trend view. 

Proceed as follows to display values from a recipe:

1. In the Inspector window, configure the "data source" under "Properties > Properties > 
Trends":

– Select the entry "Recipe" as "Source".

– Under "X values" and "Y values" select one recipe element each.

Setting up user-defined data supply in Runtime
If you want to supply the trend values with data by means of scripts in Runtime, you require a 
script via the API interface.

To create a connection using scripts in Runtime, proceed as follows:
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1. In the Inspector window, configure the "data source" under "Properties > Properties > 
Trends":

– Select the entry "User-defined" as "Source".

– Connect the script via the API interface to the corresponding trend.

Result
The data supply is configured. 

See also
Basics of tags (Page 3674)

Basic principles for data logging (Page 3757)

Configure trend view (Page 3837)

Creating trends for the trend window. (Page 3841)

Configuring toolbar and status bar

Introduction             
You operate the controls in Runtime using the buttons in the toolbar. The status bar displays 
status messages from the control. During configuration, set the content of the toolbar and 
status bar. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Configuring the toolbar
Proceed as follows to configure the toolbar:

1. In the Inspector window, configure the general properties of the toolbar, such as orientation 
and background color, under  "Properties > Properties > Toolbar > Toolbar - General".

2. In the Inspector window, activate the buttons you need in Runtime under  "Properties > 
Properties > Toolbar > Toolbar - Buttons".
For information on the functions of the individual buttons, refer to the description of the 
corresponding WinCC control at "Operation in Runtime".

3. To set the order of the buttons, select the buttons in the list. You can then move the buttons 
to the desired position.

4. If needed, you can define a "hotkey" for the buttons on the toolbar.
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5. If necessary, select the authorization needed to operate the buttons in Runtime.

6. If a button should not be operated in Runtime, unselect "Activate".
You can reactivate a deactivated a button using a script in Runtime, for example. 

Configuring the status bar
Proceed as follows to configure the status bar:

1. In the Inspector window, configure the general properties of the status bar, such as 
orientation and background color, under  "Properties > Properties > Status bar > Status bar 
- General".

2. In the Inspector window, activate the elements you need in Runtime under  "Properties > 
Properties > Status bar > Status bar - Elements".
For further information on status bar elements, refer to the descriptions of the corresponding 
WinCC control at "Operation in runtime".

3. To set the order of the elements, select the element in the list. You can then move the 
element to the desired position.

4. To adjust the width of an element in the status bar, deactivate "Auto-size". You can then 
enter the width in pixels. 

See also
Using the trend and table view in Runtime (Page 3869)

Configure trend view (Page 3837)

Elements of the status bar (Page 3885)

Configuring the export of Runtime data

Introduction       
In Runtime, you can export the displayed data of a control in CSV format. Depending on the 
control used and the configuration, the user exports all data or only the selected data. 

The filename and location of the CSV file are set by the operator on export. Alternatively, you 
can generate the filename automatically from the following wildcards:

● @OBJECTNAME: Object name of the control

● @CURRENTDATE: Current date

● @CURRENTTIME: Current time

Requirement
● The control is selected in the screen

● The Inspector window is open
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Procedure
To configure the export of Runtime data, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Data export".
The data export settings are already configured. 

2. If necessary, enter your own filename and a path for the export file.

3. Select the "scope" of the data export.

4. Configure the "Operation in Runtime".

5. So that the operator can start the data export, activate  "Properties > Properties > Toolbar 
> Toolbar - Buttons > Export Data" in the Inspector window.

Result
In Runtime, the operator can export the data of the control via the toolbar. 

See also
Configure trend view (Page 3837)

Determining the effect of the online configuration

Introduction               
In WinCC you configure the appearance and function of a control in Runtime. In addition, you 
can allow the operator to configure a control in Runtime. You can set whether changes to 
configuration in Runtime are retained, such as after a screen change, in the control under 
"Properties > Properties > Security > Persistence".

● No persistence
The changes to the configuration are not saved. The changes are discarded on the next 
screen change and when the project is rejected. 

● Persistence
The changes to the configuration are saved. The changes are retained even after the project 
is deactivated and activated. You may also select "Response at screen change" to discard 
changes at the screen change.

● Persistence in Runtime
The changes to the configuration are only saved during Runtime. If you deactivate the 
project, the changes are discarded. You may also select "Response at screen change" to 
discard changes at the screen change.

 

  Note

If you change a configured control and load it onto the HMI device, the changes are 
overwritten in Runtime regardless of the settings. 
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Requirement
● A configured control

● The Inspector window is open

Procedure
To configure the persistence of data in Runtime, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Security".

2. Select "Online configuration".

3. If needed, select the authorization.

4. Select the "Behavior on screen change".

Result
The behavior in online configuration is now set. In Runtime, depending on the settings, the 
user can adjust the configuration of the control. 

If several operators are working on the HMI device, the individual configurations are accepted 
on a change of operator only following a screen change. 

See also
Configure trend view (Page 3837)

Online configuration of the f(t) trend view (Page 3872)

Structure of the time format specification

Time format
You can overwrite the default time formats of the selection list. 

If you want to define your own time formats, note the following:

● Spaces that separate values in the format specification are set at the same position in the 
time display.

● Note that the entry is case-sensitive.

● Characters that are set in single quotation marks are set unchanged at the same position 
in the time display.

To set up a format specification, use the following values:

Value Description
h Hours, 12-hour clock, for single-digit hours without leading zero 
hh Hours, 12-hour clock, for single-digit hours with leading zero 
H Hours, 24-hour clock, for single-digit hours without leading zero 
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Value Description
HH Hours, 24-hour clock, for single-digit hours with leading zero 
m Minutes, without leading zero for single-digit minutes
mm Minutes, with leading zero for single-digit minutes
s Seconds, without leading zero for single-digit seconds
ss Seconds, with leading zero for single-digit seconds
t Single-digit AM/PM time identifier: A or P
tt Two-digit AM/PM time identifier: AM or PM

Example
To set up the time display "11:29:40 PM", use the following format specification:

"hh:mm:ss tt"

Structure of the date format specification

Time format
The default date formats of the selection list can be overwritten. 

When you specify your own date formats, note the following:

● Spaces that separate values in the format specification are set in the same position in the 
date display.

● Note that the entry is case-sensitive.

● Characters that are set in single quotation marks are set unchanged at the same position 
in the date display.

To set up a format specification, use the following values:

Value Description
D Day of the month as number, for single-digit days without leading zero 
Dd Day of the month as number, for single-digit days with leading zero 
Ddd Weekday shortened with three letters
Dddd Weekday in full form
M Month as number, for single-digit month without leading zero 
MM Month as number, for single-digit month with leading zero 
MMM Month shortened with three letters
MMM
M

Month in full form

y Year, only the last two numbers, for years under 10 with leading zero, same as "YY" format 
yy Year, only the last two numbers, for years under 10 with leading zero 
yyyy Complete, four-digit year specification
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Example
Use the following format specification to set up the date display "Wed, Aug 31 13":

"Ddd, MMM dd yy"

Output of tag values in tabular format

Configuring the Table View

Introduction
To display tag values in tables in Runtime, add a table view to a screen. A time stamp is 
displayed for each value. The values are displayed in value columns, and the time stamps in 
time columns. Assign the time column to one or several value columns. 

Procedure  
Proceed as follows to configure a table view:

1. Add the required table view to the screen from the "Tools" task card.

2. Configure the appearance of the table view in the Inspector window:

– Configure the basic properties of the table view, e.g. "Time base", under "Properties > 
Properties > General".

– Configure the appearance of the table view under "Properties > Properties > 
Appearance".

– Configure the properties of the table view in Runtime under "Properties > Properties > 
"Window".

3. Configure the columns of the table view in the Inspector window.

– Configure the properties of the columns.

– Configure one or more time columns with the time ranges for the table.

– Configure one or more value columns.

– Define the data connection for each value column.

– Assign time columns to the value columns.

4. Configure the appearance of each trend:

– Configure the "Headers", the "Structure" and the "Grid".

– If needed, configure the settings for "selecting" table entries.

– If needed, configure the settings for sorting table entries.

5. Configure the toolbar and status bar of the table view.

6. If required, configure the data export from the table view.

7. If required, configure the security settings of the table view.
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Result
The table view is configured. Define an additional value table if you want to evaluate the data 
of the table view in Runtime. You can also configure the value table as "Ruler". 

See also
Configuring the time columns of the table view (Page 3850)

Configuring the value columns of the table view (Page 3851)

Configuring the appearance of the table elements (Page 3852)

Configuration of the marking of selected cells and rows (Page 3853)

Configuring table column sorting (Page 3854)

Making buttons in the toolbar dynamic (Page 3836)

Defining the data source (Page 3855)

Configuring toolbar and status bar (Page 3857)

Configuring the export of Runtime data (Page 3858)

Determining the effect of the online configuration (Page 3859)

Online configuration of the table view (Page 3878)

Configuring the time columns of the table view

Introduction 
The time range for the tabular display is configured via time columns. A table can have separate 
time columns for several value columns or a common time column.

If you assign several time columns to a table view, the sequence of the time columns in the 
Inspector window corresponds to the sequence in the table view. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Procedure       
To configure the time column of a table view, follow these steps:

1. Click "Add" in the Inspector window under "Properties > Properties > Time columns" to add 
time columns.

2. Enter the "Name" and "Label" of the time column.

3. Configure the "Style" of the time column.

4. Configure the "time range" and "format" of the time display of the time column.
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5. Configure the appearance of the "Header" and "Cells".

6. If the values of the time column should be updated automatically, activate "Update".

Result
The time column is configured. Assign the time column to one or several value columns. 

See also
Configuring the value columns of the table view (Page 3851)

Structure of the time format specification (Page 3860)

Structure of the date format specification (Page 3860)

Configuring the value columns of the table view

Introduction
You configure the values of the table view via value columns. You can display several value 
columns in a table, e.g. to compare the fill levels of several containers. Every value column is 
connected with a time column. The value columns can have a common time column.

If you assign several value columns to a table view, the sequence of the value columns in the 
Inspector window corresponds to the sequence in the table view. If you assign several value 
columns to the same time column, the value columns in the list are automatically grouped 
according to assigned time column.

Requirement
● The table view is selected in the screen.

● The Inspector window is open

● The time column is created

Procedure 
Proceed as follows to configure a value column:

1. Double-click "Add" in the Inspector window under "Properties > Properties > Value 
columns" to add a new value column.

2. Enter the "Name" and "Label" of the value column.

3. Configure the data source.

4. Assign a time column to the value column. 

5. If required, configure the appearance of the "Header" and "Cells".

6. If required, configure the "Sorting" of the value column. 
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Result
The value column is configured.

See also
Defining the data source (Page 3842)

Configuring the time columns of the table view (Page 3850)

Defining the data source (Page 3855)

Configuring the appearance of the table elements

Introduction
You can adjust the appearance of the table elements to your needs. 

Requirement
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure   
Proceed as follows to configure the colors of the table elements:

1. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Header":

– Visibility of the column headers and row headers

– Alignment of the column headers and row headers

– Color design of column headers

2. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Structure":

– Color design of table content, such as different colors for rows for better differentiation

– Visibility of empty columns and rows

3. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Grid":

– Design of grid lines

– Character spacing in the table cells
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Result
The appearance of the table elements is configured. You can also define further properties:

● Behavior and color design when selecting a table entry

● Table entry sorting

See also
Configuration of the marking of selected cells and rows (Page 3853)

Configuring table column sorting (Page 3854)

Configuration of the marking of selected cells and rows

Introduction 
If, for example, an operator wants to export values from a row, he must select the row. During 
configuration, define the following:

● Selection area
For the selection area, configure the following properties:

– Number of table elements that the operator can select

– Design of selection area

● Color design of selection area
Select the colors individually or use a default system-defined color. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Procedure
To configure the selection area, follow these steps:

1. In the Inspector window, select the "type" of selection area under "Properties > Properties 
> Table > Table - Selection > Selection area".

2. If needed, select the "frame" to be displayed around the selection area. 

3. Choose the colors for the "cells", "rows", and "frame" as needed. 

Result
The selection area of the table view is configured. To export the data from a selected area, 
configure the "data export". To evaluate the data from a selected area, configure a "value 
display". 
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See also
Defining the data source (Page 3855)

Configuring table column sorting

Introduction
If the operator is to be able to sort individual table columns in Runtime, configure the sorting 
within the table. 

Depending on the configuration, the operator can sort a table column as follows:

● Clicking or double-clicking on the column header

● Clicking on a sorting button
The sorting button is used to sort the selected column in the configured order. For the sorting 
button to appear, you must configure a vertical scroll bar. 

Requirement  
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure
To configure the sorting within a table, follow these steps:

1. In the Inspector window, select "Properties > Properties > Table > Table - Sorting > Sort 
by column header", "Sort with double-click", or "Sort with click".

2. Select the "Sorting order" option.

3. If needed, activate "Display sorting icon" and "Display sorting index".

4. If needed, activate "Display sorting button".

5. If you use the sorting button, select "Properties > Properties > Window > Scroll > Vertical 
scrollbar > Always" in the Inspector window.

Result
The sorting of the table columns is configured. 
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Defining the data source

Introduction        
Using the data source, you define the sources from which the values are displayed on the HMI 
device in Runtime. The following sources are available:

● Current process values from tags

● Archived values from logging tags

● Recipe elements (only f(x) trend view)

● Data supply by means of script in Runtime

Requirements
● An online tag or logging tag is configured

● Value column or trend has been created

● The Inspector window is open

Displaying current process values
Proceed as follows to display current process values:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

– Select the "update cycle".
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Displaying values from a log
Proceed as follows to display values from a log:

1. Click "Properties > Properties > Value columns" in the Inspector window to define the data 
source for a table view.

2. Click "Properties > Properties > Trends" in the Inspector window to define the data source 
for a trend view.

3. Configure the "data source":

– Select the entry "Logging tags" as "Source".

– If you configure the trend of an f(x) trend view, select one tag each from "X values" and 
"Y values".

– If you configure the trend of an f(t) trend view or a value column, select a "tag".

Displaying values from recipes
Output values from recipes in a f(x) trend view. 

Proceed as follows to display values from a recipe:

1. In the Inspector window, configure the "data source" under "Properties > Properties > 
Trends":

– Select the entry "Recipe" as "Source".

– Under "X values" and "Y values" select one recipe element each.

Setting up user-defined data supply in Runtime
If you want to supply the trend values with data by means of scripts in Runtime, you require a 
script via the API interface.

To create a connection using scripts in Runtime, proceed as follows:

1. In the Inspector window, configure the "data source" under "Properties > Properties > 
Trends":

– Select the entry "User-defined" as "Source".

– Connect the script via the API interface to the corresponding trend.

Result
The data supply is configured. 

See also
Basics of tags (Page 3674)

Basic principles for data logging (Page 3757)

Configuring the Table View (Page 3849)

Configuring the value columns of the table view (Page 3851)
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Configuring toolbar and status bar

Introduction             
You operate the controls in Runtime using the buttons in the toolbar. The status bar displays 
status messages from the control. During configuration, set the content of the toolbar and 
status bar. 

Requirement
● The table view is selected in the screen.

● The Inspector window is open

Configuring the toolbar
Proceed as follows to configure the toolbar:

1. In the Inspector window, configure the general properties of the toolbar, such as orientation 
and background color, under  "Properties > Properties > Toolbar > Toolbar - General".

2. In the Inspector window, activate the buttons you need in Runtime under  "Properties > 
Properties > Toolbar > Toolbar - Buttons".
For information on the functions of the individual buttons, refer to the description of the 
corresponding WinCC control at "Operation in Runtime".

3. To set the order of the buttons, select the buttons in the list. You can then move the buttons 
to the desired position.

4. If needed, you can define a "hotkey" for the buttons on the toolbar.

5. If necessary, select the authorization needed to operate the buttons in Runtime.

6. If a button should not be operated in Runtime, unselect "Activate".
You can reactivate a deactivated a button using a script in Runtime, for example. 

Configuring the status bar
Proceed as follows to configure the status bar:

1. In the Inspector window, configure the general properties of the status bar, such as 
orientation and background color, under  "Properties > Properties > Status bar > Status bar 
- General".

2. In the Inspector window, activate the elements you need in Runtime under  "Properties > 
Properties > Status bar > Status bar - Elements".
For further information on status bar elements, refer to the descriptions of the corresponding 
WinCC control at "Operation in runtime".

3. To set the order of the elements, select the element in the list. You can then move the 
element to the desired position.

4. To adjust the width of an element in the status bar, deactivate "Auto-size". You can then 
enter the width in pixels. 
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See also
Using the trend and table view in Runtime (Page 3869)

Configuring the Table View (Page 3849)

Elements of the status bar (Page 3885)

Configuring the export of Runtime data

Introduction       
In Runtime, you can export the displayed data of a control in CSV format. Depending on the 
control used and the configuration, the user exports all data or only the selected data. 

The filename and location of the CSV file are set by the operator on export. Alternatively, you 
can generate the filename automatically from the following wildcards:

● @OBJECTNAME: Object name of the control

● @CURRENTDATE: Current date

● @CURRENTTIME: Current time

Requirement
● The control is selected in the screen

● The Inspector window is open

Procedure
To configure the export of Runtime data, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Data export".
The data export settings are already configured. 

2. If necessary, enter your own filename and a path for the export file.

3. Select the "scope" of the data export.

4. Configure the "Operation in Runtime".

5. So that the operator can start the data export, activate  "Properties > Properties > Toolbar 
> Toolbar - Buttons > Export Data" in the Inspector window.

Result
In Runtime, the operator can export the data of the control via the toolbar. 

See also
Configuring the Table View (Page 3849)
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Determining the effect of the online configuration

Introduction               
In WinCC you configure the appearance and function of a control in Runtime. In addition, you 
can allow the operator to configure a control in Runtime. You can set whether changes to 
configuration in Runtime are retained, such as after a screen change, in the control under 
"Properties > Properties > Security > Persistence".

● No persistence
The changes to the configuration are not saved. The changes are discarded on the next 
screen change and when the project is rejected. 

● Persistence
The changes to the configuration are saved. The changes are retained even after the project 
is deactivated and activated. You may also select "Response at screen change" to discard 
changes at the screen change.

● Persistence in Runtime
The changes to the configuration are only saved during Runtime. If you deactivate the 
project, the changes are discarded. You may also select "Response at screen change" to 
discard changes at the screen change.

 

  Note

If you change a configured control and load it onto the HMI device, the changes are 
overwritten in Runtime regardless of the settings. 

 

Requirement
● A configured control

● The Inspector window is open

Procedure
To configure the persistence of data in Runtime, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Security".

2. Select "Online configuration".

3. If needed, select the authorization.

4. Select the "Behavior on screen change".

Result
The behavior in online configuration is now set. In Runtime, depending on the settings, the 
user can adjust the configuration of the control. 

If several operators are working on the HMI device, the individual configurations are accepted 
on a change of operator only following a screen change. 
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See also
Configuring the Table View (Page 3849)

Online configuration of the table view (Page 3878)

Structure of the time format specification

Time format
You can overwrite the default time formats of the selection list. 

If you want to define your own time formats, note the following:

● Spaces that separate values in the format specification are set at the same position in the 
time display.

● Note that the entry is case-sensitive.

● Characters that are set in single quotation marks are set unchanged at the same position 
in the time display.

To set up a format specification, use the following values:

Value Description
h Hours, 12-hour clock, for single-digit hours without leading zero 
hh Hours, 12-hour clock, for single-digit hours with leading zero 
H Hours, 24-hour clock, for single-digit hours without leading zero 
HH Hours, 24-hour clock, for single-digit hours with leading zero 
m Minutes, without leading zero for single-digit minutes
mm Minutes, with leading zero for single-digit minutes
s Seconds, without leading zero for single-digit seconds
ss Seconds, with leading zero for single-digit seconds
t Single-digit AM/PM time identifier: A or P
tt Two-digit AM/PM time identifier: AM or PM

Example
To set up the time display "11:29:40 PM", use the following format specification:

"hh:mm:ss tt"

Structure of the date format specification

Time format
The default date formats of the selection list can be overwritten. 

When you specify your own date formats, note the following:
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● Spaces that separate values in the format specification are set in the same position in the 
date display.

● Note that the entry is case-sensitive.

● Characters that are set in single quotation marks are set unchanged at the same position 
in the date display.

To set up a format specification, use the following values:

Value Description
D Day of the month as number, for single-digit days without leading zero 
Dd Day of the month as number, for single-digit days with leading zero 
Ddd Weekday shortened with three letters
Dddd Weekday in full form
M Month as number, for single-digit month without leading zero 
MM Month as number, for single-digit month with leading zero 
MMM Month shortened with three letters
MMM
M

Month in full form

y Year, only the last two numbers, for years under 10 with leading zero, same as "YY" format 
yy Year, only the last two numbers, for years under 10 with leading zero 
yyyy Complete, four-digit year specification

Example
Use the following format specification to set up the date display "Wed, Aug 31 13":

"Ddd, MMM dd yy"

Configuring the value table

Value table basics

Function
The value table displays values or statistics from a control. You establish the content of the 
value table when you configure it.

Overview of the value table  
You connect the value table with one of the following controls:

● Table view

● f(x) trend view

● f(t) trend view
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A "display mode" is set in the value table. The display mode determines which data are shown 
in the value table. 

Display modes     
Three different display modes are available in the value table.

● Ruler window
The ruler window shows the coordinate values of the trends on a ruler or values of a selected 
line in the table.

● Statistics area window
The statistics area window shows the values of the lower limit and upper limit of the trends 
between two rulers or the selected area in the table. You can only connect the statistics 
area window with the f(t) trend display or the table view.

● Statistics window
The statistics window displays the statistical evaluation of the trends. Among other things, 
the statistics include:

– Minimum

– Maximum

– Average

– Standard deviation

– Integral

All windows can also display additional information on the connected trends or columns, such 
as time stamps. 

See also
Configuring the value table (Page 3862)

Creating statistics for Runtime data (Page 3882)

Determining the coordinates of a point (Page 3876)

Configuring the value table

Introduction
The contents of the value table are shown in columns. The available columns depend on the 
connected control. A block is assigned to each column. You define the alignment and 
appearance of the column headers using the blocks. By default, the format of the connected 
control is used for the display format, such as the time display.

Requirements
● The table view or trend view is selected in the screen

● The Inspector window is open
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Procedure
Proceed as follows to configure a value table:

1. Add the required table view to the screen from the "Tools" task card.

2. Click "Properties > Properties > General > Data source" in the Inspector window to connect 
the value table to the selected control.

3. Select the "mode" of the value table under "Properties > Properties > General".

4. Configure the properties of the value table columns under "Properties > Properties > 
Blocks".

5. Configure the "Properties > Properties > Columns":

– Change the "Visibility", if required

– Change the "Label", if required

– If required, change the sequence of columns using "Up" and "Down"

6. Configure the view of the value table in the Inspector window:

– Configure the view of the value table under "Properties > Properties > Appearance".

– Configure the properties of the value table in Runtime under "Properties > Properties > 
"Window".

Result
The value table is configured. 

See also
Value table basics (Page 3861)

Configuring toolbar and status bar (Page 3863)

Configuring the appearance of the table elements (Page 3865)

Configuring table column sorting (Page 3866)

Configuring the export of Runtime data (Page 3866)

Determining the effect of the online configuration (Page 3867)

Configuring toolbar and status bar

Introduction             
You operate the controls in Runtime using the buttons in the toolbar. The status bar displays 
status messages from the control. During configuration, set the content of the toolbar and 
status bar. 
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Requirement
● The table view is selected in the screen.

● The Inspector window is open

Configuring the toolbar
Proceed as follows to configure the toolbar:

1. In the Inspector window, configure the general properties of the toolbar, such as orientation 
and background color, under  "Properties > Properties > Toolbar > Toolbar - General".

2. In the Inspector window, activate the buttons you need in Runtime under  "Properties > 
Properties > Toolbar > Toolbar - Buttons".
For information on the functions of the individual buttons, refer to the description of the 
corresponding WinCC control at "Operation in Runtime".

3. To set the order of the buttons, select the buttons in the list. You can then move the buttons 
to the desired position.

4. If needed, you can define a "hotkey" for the buttons on the toolbar.

5. If necessary, select the authorization needed to operate the buttons in Runtime.

6. If a button should not be operated in Runtime, unselect "Activate".
You can reactivate a deactivated a button using a script in Runtime, for example. 

Configuring the status bar
Proceed as follows to configure the status bar:

1. In the Inspector window, configure the general properties of the status bar, such as 
orientation and background color, under  "Properties > Properties > Status bar > Status bar 
- General".

2. In the Inspector window, activate the elements you need in Runtime under  "Properties > 
Properties > Status bar > Status bar - Elements".
For further information on status bar elements, refer to the descriptions of the corresponding 
WinCC control at "Operation in runtime".

3. To set the order of the elements, select the element in the list. You can then move the 
element to the desired position.

4. To adjust the width of an element in the status bar, deactivate "Auto-size". You can then 
enter the width in pixels. 

See also
Configuring the value table (Page 3862)

Elements of the status bar (Page 3885)
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Configuring the appearance of the table elements

Introduction
You can adjust the appearance of the table elements to your needs. 

Requirement
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure   
Proceed as follows to configure the colors of the table elements:

1. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Header":

– Visibility of the column headers and row headers

– Alignment of the column headers and row headers

– Color design of column headers

2. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Structure":

– Color design of table content, such as different colors for rows for better differentiation

– Visibility of empty columns and rows

3. Define the following properties in the Inspector window under "Properties > Properties > 
Table > Table - Grid":

– Design of grid lines

– Character spacing in the table cells

Result
The appearance of the table elements is configured. You can also define further properties:

● Behavior and color design when selecting a table entry

● Table entry sorting

See also
Configuring the value table (Page 3862)

Configuring table column sorting (Page 3866)
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Configuring table column sorting

Introduction
If the operator is to be able to sort individual table columns in Runtime, configure the sorting 
within the table. 

Depending on the configuration, the operator can sort a table column as follows:

● Clicking or double-clicking on the column header

● Clicking on a sorting button
The sorting button is used to sort the selected column in the configured order. For the sorting 
button to appear, you must configure a vertical scroll bar. 

Requirement  
● The table view or value table is selected in the screen.

● The Inspector window is open

Procedure
To configure the sorting within a table, follow these steps:

1. In the Inspector window, select "Properties > Properties > Table > Table - Sorting > Sort 
by column header", "Sort with double-click", or "Sort with click".

2. Select the "Sorting order" option.

3. If needed, activate "Display sorting icon" and "Display sorting index".

4. If needed, activate "Display sorting button".

5. If you use the sorting button, select "Properties > Properties > Window > Scroll > Vertical 
scrollbar > Always" in the Inspector window.

Result
The sorting of the table columns is configured. 

See also
Configuring the value table (Page 3862)

Configuring the export of Runtime data

Introduction       
In Runtime, you can export the displayed data of a control in CSV format. Depending on the 
control used and the configuration, the user exports all data or only the selected data. 
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The filename and location of the CSV file are set by the operator on export. Alternatively, you 
can generate the filename automatically from the following wildcards:

● @OBJECTNAME: Object name of the control

● @CURRENTDATE: Current date

● @CURRENTTIME: Current time

Requirement
● The control is selected in the screen

● The Inspector window is open

Procedure
To configure the export of Runtime data, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Data export".
The data export settings are already configured. 

2. If necessary, enter your own filename and a path for the export file.

3. Select the "scope" of the data export.

4. Configure the "Operation in Runtime".

5. So that the operator can start the data export, activate  "Properties > Properties > Toolbar 
> Toolbar - Buttons > Export Data" in the Inspector window.

Result
In Runtime, the operator can export the data of the control via the toolbar. 

See also
Configuring the value table (Page 3862)

Determining the effect of the online configuration

Introduction               
In WinCC you configure the appearance and function of a control in Runtime. In addition, you 
can allow the operator to configure a control in Runtime. You can set whether changes to 
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configuration in Runtime are retained, such as after a screen change, in the control under 
"Properties > Properties > Security > Persistence".

● No persistence
The changes to the configuration are not saved. The changes are discarded on the next 
screen change and when the project is rejected. 

● Persistence
The changes to the configuration are saved. The changes are retained even after the project 
is deactivated and activated. You may also select "Response at screen change" to discard 
changes at the screen change.

● Persistence in Runtime
The changes to the configuration are only saved during Runtime. If you deactivate the 
project, the changes are discarded. You may also select "Response at screen change" to 
discard changes at the screen change.

 

  Note

If you change a configured control and load it onto the HMI device, the changes are 
overwritten in Runtime regardless of the settings. 

 

Requirement
● A configured control

● The Inspector window is open

Procedure
To configure the persistence of data in Runtime, proceed as follows:

1. In the Inspector window, open "Properties > Properties > Security".

2. Select "Online configuration".

3. If needed, select the authorization.

4. Select the "Behavior on screen change".

Result
The behavior in online configuration is now set. In Runtime, depending on the settings, the 
user can adjust the configuration of the control. 

If several operators are working on the HMI device, the individual configurations are accepted 
on a change of operator only following a screen change. 

See also
Configuring the value table (Page 3862)
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Using controls in Runtime

Using the trend and table view in Runtime

Introduction      
You operate the trend and table view using the toolbar buttons. 

To operate a button via a script, transfer the "ID" of the button to the script. Use the symbols 
from the symbol library to label the button. The symbols are available in the "Tools > Graphics" 
task card under "WinCC graphic folder > Runtime control icons > Trend View".

Shared buttons
The following table shows the buttons that are available in trend view and table view:

Icon Name Function ID
"Help" Calls up the control help. 1

"Configuration dialog" Opens the configuration dialog, in which you can change the 
properties of the control.

2

"First Data Record" Displays the course of a tag within a specified period starting with 
the first archived value. 
Requirement: Values come from a process value log.

3

"Previous Data Record" Displays the course of a tag within the previous time interval, 
based on the currently displayed time interval. 
Requirement: Values come from a process value log.

4

"Next Data Record" Displays the course of a tag within the next time interval, based 
on the currently displayed time interval.
Requirement: Values come from a process value log.

5

"Last Data Record" Displays the course of a tag within a specified period ending with 
the last archived value.
Requirement: Values come from a process value log. 

6

"Select Time Range" Opens a dialog in which you configure the time range 11

"Stop" Stops the updated display. 
The data is buffered.

14

"Start" Continues the updated display.
The buffered values are entered. 

14

"Print" Prints the selected values. 
The print job is defined in the configuration dialog on the 
"General" tab.

15
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Icon Name Function ID
"Export data" Exports all or selected data to a *.CSV file. 

Depending on the configuration and the privileges, the following 
options can be available:
● Display export settings and start export
● Select filename and directory

20

"Define statistics area" Defines the timeframe used to calculate the statistics. 16

"Calculate Statistics" Displays the statistical values from a fixed "statistics area" of the 
trend or table view in the statistics window of the value table. 
Only available with a configured value table

17

"Connect backup" Opens a dialog in which you connect selected archives from 
WinCC Runtime

18

"Disconnect backup" Opens a dialog in which you disconnect selected archives from 
WinCC Runtime

19

"User-defined 1"
 

Shows the first button created by the user. 
The function of the button is user-defined

1001

Trend view button
The following table shows the buttons that are available in the trend view:

Icon Name Function ID
"Ruler" Displays a ruler that shows the coordinates of the intersection 

point with a trend in the value table. 
Requirement: The value table is configured with "Ruler window" 
display mode. 

7

"Zoom area" Zooms the trend view area.  You define the area by dragging with 
the mouse. 
Use the "Original view" button to return to the original view. 

8

"Zoom +/-" Zooms in or out on the trends in the trend display. 
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

9

"Zoom time axis +/-" Zooms in or out on the time axis in the trend view.
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

10

"Zoom value axis +/-" Zooms in or out on the value axis in the trend view.
Left-click: Zoom in
<Shift + Left-click>: Zoom out
Use the "Original view" button to return to the original view.

11

"Move trend area" Moves the trend along the value axis and the time axis 12
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Icon Name Function ID
"Move axis range" Moves the trend along the value axis 13

"Original view" Returns to the original view from the zoomed display 14

"Select data connection" Opens a dialog in which you select the data source:
● Process value archive
● Tag
● Recipe (only f(x) trend view)

15

"Select trends" Opens a dialog in which you can hide and show trends.  You can 
also select which trend is to be placed in the foreground. 

16

"Previous trend" Displays the previous trend in the foreground. 18

"Next trend" Displays the next trend in the foreground. 19

"Relative axis" Switches from displaying the absolute values to the percentage 
display of value axis. The high and low limits for the trend 
correspond with a range of 0 to 100%.

27

Table view buttons  
The following table shows the buttons that are available in the table view:

Icon Name Function ID
"Edit" Activates editing of table entries. To edit a value, double-click on 

the desired table cell. 
Requirement: Updated display is stopped.

7

"Copy lines" Copies the content of the selected lines to the clipboard. 
Requirement: Updated display is stopped. 

8

"Select columns" Opens a dialog in which you can show or hide columns and 
change the column sequence. 

10

"Previous column" Moves a value column ahead of the previous value column. 
The function refers to the value columns that are assigned to a 
time axis.

12

"Next column" Moves a value column behind the next value column. 
The function refers to the value columns that are assigned to a 
time axis.

13

"Select data connection" Opens a dialog in which you select the data source:
● Process value archive
● Tag
● Recipe (only f(x) trend view)

15
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Using trend view in Runtime

Online configuration of the f(t) trend view

Introduction  
In Runtime you configure online and thus change the appearance of the trend view. The table 
view configuration specifies whether online configurations are retained or discarded on a 
screen change or after Runtime is ended.

Overview
The following buttons make online configuration possible in the trend view:

● "Configuration dialog" button

● "Select data connection" button

● "Select trends" button

● "Select Time Range" button

Opening the configuration dialog
To open the configuration dialog, proceed as follows:

1. Click  in the toolbar. 

The configuration dialog is opened. You can change the table appearance, for example, in the 
configuration dialog. 

Changing the data connection
The following table shows the configuration options for data connection:

Field Description
Trend Choose one of the configured trends.
Data Source Define whether the selected trend is supplied with a logging tag or online tag.
Tag name Select the tag name for the data connection.

Proceed as follows to change the data connection: 

1. Click  in the toolbar.  
The "Archive/tag selection" dialog is opened. 

2. Choose the "Value column" for which you want to change the data connection.

3. Select the "Data supply" and the "Tag name". 
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Changing a time range
The following table shows the configuration options for the time range:

Field Description
Time axis Select the configured time axis for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

To configure the time range, follow these steps:

1. Click  in the toolbar of the trend view.
The "Time - Selection" dialog opens.

2.  Choose the "Time axis" for which you want to adapt the time range.
If the trends in a trend view are to be displayed with a common time axis, the specified time 
range applies to all trends.

3. Configure the time range.
The entry format of the date and time depends on the Runtime language used.

See also
Trend to Front (Page 3875)

Using the zoom functions in trend windows (Page 3873)

Starting and Stopping Update (Page 3882)

Creating statistics for Runtime data (Page 3882)

Displaying logged values (Page 3884)

Elements of the status bar (Page 3885)

Configure trend view (Page 3837)

Using the zoom functions in trend windows

Introduction
Key functions can be used for zooming in on, zooming out of and returning to the original view 
for trends, axes and various zoom areas of the trend window.
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Overview
The following zoom functions are available in the trend window:

● "Zoom area"

● "Original view"

● "Zoom +/-"

● "Zoom time axis +/-"

● "Zoom value axis +/-"

● "Move trend area"

Requirement
● The trend view is open

● Buttons with zoom functions are configured

● Runtime is activated

Zooming in on a trend view area
Proceed as follows to zoom in on an area of the trend view:

1. Click on .  
The updated display is stopped.

2. Drag with the mouse to draw a box around the area to be zoomed. 
If there are at least two measured values within this area, the area of the trend is zoomed. 

3. To return to the original view of the trend, click . 

4. Click on  to start the update again. 

The default values are used for the axis. 

Zooming in or out on trends
If you zoom in or out on a trend, the 50% value of the trend is always in the middle of the value 
axes.

Proceed as follows to zoom in or out on a trend:

1. Click on . 
The updated display is stopped.

2. To zoom in on a trend, click on the trend with the left mouse button. 

3. To zoom out on a trend, hold down the <Shift> key and click on the trend with the left mouse 
button.

4. To return to the original view of the trend, click . 

5. Click on  to start the update again. 
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The default values are used for the axis. 
 

 Note

If you change the value area of a value axis on the "Value Axis" tab in the configuration dialog 
while zooming, the visible zoom area is set to the new value area.

 

Zooming in on the time axis or value axis
While zooming with time or value axes, the 50% value of the trend is always in the middle of 
the axes.

Proceed as follows to zoom the time axis or value axis:

1. Click  to zoom the time axis.  
The updated display is stopped.

2. Click  to zoom the value axis.  
The updated display is stopped.

3. To zoom in on an axis, click on the trend view with the left mouse button. 

4. To zoom out on an axis, hold down the <Shift> key and click on the trend view with the left 
mouse button.

5. To return to the original view of the trend, click . 

6. Click on  to start the update again. 

The default values are used for the axis. 

Moving a trend area
Proceed as follows to move the trend area:

1. Click on . 
The updated display is stopped.

2. While holding the left mouse button pressed, move the cursor in the desired direction in 
the trend view.
The displayed area in the trend window is adapted on the time axis and on the value axis.

3. Click on  again to return to the original view of the trend window.

See also
Online configuration of the f(t) trend view (Page 3872)

Trend to Front

Introduction 
If more than one trend are to be displayed in a trend window, you can use key functions to 
define which trends will be displayed in the foreground.
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Requirement
● The following buttons are configured:

– "Select trends"

– "Previous trend" 

– "Next trend"

● The project is activated

Procedure
Proceed as follows to display a trend in the foreground:

1. Click on .  
The dialog for displaying or hiding trends is opened. In this dialog you can also define which 
trend is in the foreground. 

 

  Note

The first trend of a trend window cannot be hidden.
 

2. In order to display the next trend in the foreground, click on . 

3. In order to display the previous trend in the foreground, click on .  

See also
Online configuration of the f(t) trend view (Page 3872)

Determining the coordinates of a point

Introduction
The "Ruler" button is used to determine the coordinates of a point on the trend by means of a 
ruler. You can zoom in on an area of the trend to make coordinate finding easier. If you display 
the ruler in the trend view, you can move the ruler at any time. 

If you click on the trend with the mouse, several trend parameters are shown in the tooltip for 
the trend view.

Requirement
● A trend view is configured

● The value table is configured and connected with the trend view

● The "Ruler window" display mode is activated in the value table

● Runtime is activated
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Procedure
Proceed as follows to determine the coordinates of a point:

1. Click on  in the trend view.
The ruler is shown. 

2. Move the ruler to the desired position with the mouse.

3. If you want to zoom in on an area, click on . 

– Move the ruler to the desired position with the mouse.

– Click  to return to the original view.

Result
In the ruler window of the value table, besides the X value/time stamp and the Y value, the 
data that you have configured in the value table is shown in the columns. 

In the value table, the indices "i" and "u" can be displayed in addition to the values:

● "i.": The displayed value is an interpolated value.

● "u.": The displayed value has an uncertain status:

– The initial value after Runtime activation is unknown

– A substitute value is used
 

  Note

You can also identity the "uncertain" status of a value in the displayed trend curve. You 
must activate the "Value with uncertain status" option on the "Trends" tab under "Limit 
values". 

 

The following image shows the coordinates of a point in the ruler window of the value table:
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Alternative procedure
Alternatively, you can also connect the value table to the table display. In the "ruler window" 
display mode, the values of the selected line are displayed in the value table. 

See also
Value table basics (Page 3861)

Operating table view in Runtime

Online configuration of the table view

Introduction    
In Runtime you configure online and thus change the appearance of the table view. The table 
view configuration specifies whether online configurations are retained or discarded on a 
screen change or after Runtime is ended.
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Overview
The following buttons make online configuration possible in table view:

● "Configuration dialog" button

● "Select data connection" button

● "Select columns" button

● "Select Time Range" button

Opening the configuration dialog
To open the configuration dialog, proceed as follows:

Click  in the toolbar. 

The configuration dialog is opened. You can change the table appearance, for example, in the 
configuration dialog. 

Changing the data connection
The following table shows the configuration options for data connection: 

Field Description
Value column Choose the configured value column for which you want to change the data 

connection.
Data Source Define whether the selected value column is supplied with a logging tag or online 

tag.
Tag name Select the tag name for the data connection.

Proceed as follows to change the data connection:

1. Click  in the toolbar.
The "Archive/tag selection" dialog is opened. 

2. Choose the "Value column" for which you want to change the data connection.

3. Select the "Data supply" and the "Tag name".

Showing or hiding columns
To show or hide columns, follow these steps:

1. Click  in the toolbar.
The dialog for showing or hiding columns is opened. 

2. If required, change the sequence of the value columns that are assigned to a time column.

The value columns can only be moved in reference to the anchored time column.
 

 Note

The first column of a table view cannot be hidden.
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Changing a time range
The following table shows the configuration options for the time range:

Field Description
Time column Select the configured time column for which you want to define a time range.
time range Set the time range:

● If you want to define a fixed time interval, select setting "Start to end time". Enter 
the date and time for each.

● If you want to define a time period, select the setting "Time range". Define the date 
and time for the start time. The length of the time interval to be displayed is 
determined by multiplying the "Factor" by the "Time unit".

● If you want to display a certain number of values, select the setting "Number of 
measurement points". Define the date and time for the start time. Enter the desired 
number of measurement points in the input field.

To configure the time range, follow these steps:

1. Click  in the toolbar of the table view.
The "Time - Selection" dialog opens.

2. Choose the "Time column" for which you want to adapt the time range.
If the columns of a table view are to be displayed with a common time axis, the specified 
time range applies to all columns.

3. Configure the time range.
The entry format of the date and time depends on the Runtime language used.

See also
Editing the table field in Runtime (Page 3880)

Moving columns in the table (Page 3881)

Starting and Stopping Update (Page 3882)

Creating statistics for Runtime data (Page 3882)

Displaying logged values (Page 3884)

Elements of the status bar (Page 3885)

Configuring the Table View (Page 3849)

Editing the table field in Runtime

Introduction 
You change the values displayed in the table view manually using the "Edit" button.
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Requirement
● The table view is configured

● The "Edit" button is configured

● Runtime is activated

Procedure
Proceed as follows to edit a table field in Runtime:

1. Click  in the table view.
The updated display is stopped, the process data continues being archived.

2. Click on .

3. Double click on the desired table field of a value column.

4. Enter the new value.
The changed value is archived.

5. In order to continue with the display of Runtime data in the table view, click on .

See also
Online configuration of the table view (Page 3878)

Moving columns in the table

Introduction 
The time column is always shown in the first column in the table. The value columns that are 
assigned to this time column are displayed next. If there are more than one time columns 
configured, the second time column follows with the assigned value columns.

You can change the sequence of the value columns that are assigned with a time column in 
Runtime. The value columns can only be moved in reference to the anchored time column. 
The sequence of the time columns with the assigned value columns are defined on the "Time 
axes" tab.

Requirement
The following buttons are configured:

● "Select columns"

● "Previous column"

● "Next column".
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Procedure
To change the sequence of the columns, follow these steps:

1. Click on .
The dialog for changing the sequence of the columns is opened. 

2. To hide a column, deactivate the option before the column name.

3. To move a value column, select the value value column:
The function refers to the value columns that are assigned to a time column. 

– Click  to move the value column behind the next value column.

– Click  to move the value column in front of the previous value column.

See also
Online configuration of the table view (Page 3878)

Starting and Stopping Update

Introduction     
You can continue the update of the data contained in the control with the "Start/Stop" button. 

Some buttons stop the update automatically, e.g. "Define statistics area"

The appearance of the button indicates whether the update is stopped or not:

● : Update has been stopped. To continue the update, click on the button.

● : The update has been started. To stop the update, click on the button

See also
Online configuration of the f(t) trend view (Page 3872)

Online configuration of the table view (Page 3878)

Creating statistics for Runtime data

Introduction
You can generate an analysis of the process data for the Runtime data in the trend view or 
table view. You can display the evaluated data in the value table.

Requirement
● A trend view or table view is configured

● A value table is configured and connected with the trend view or table view

● Runtime is activated
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Displaying data in a statistics area window 
Requirement: The "Statistics area window" display mode is activated in the value table. 

To display data in the statistics area window of the value table, proceed as follows:

1. In the trend view or table view, click on .
The updated display is stopped, the process data continues being archived.

2. If you wish to evaluate data outside the displayed time range:

– Click 
The "Time - Selection" dialog opens. 

– Enter the required time range.
The data for the defined time range is displayed.

3. If you are using a trend view:

– Click 
In the trend view, two vertical lines are displayed on the right and left edges.

– To define the statistics area, move the two lines to the desired position.

4. If you are using a table view:

– Use the mouse to select the lines for the desired time range in the table.
For different columns with different time frames you can select different time ranges for 
the calculation of statistics.

– Click  in the toolbar

The evaluated data is displayed in the columns that you have configured in the statistics area 
window. The following figure shows the display in the statistics area window, using the trend 
view as an example:
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In order to continue with the display of Runtime data, click .
 

 Note

For additional statistical analysis of process data and archiving of results you can write the 
scripts yourself. 

 

See also
Value table basics (Page 3861)

Online configuration of the f(t) trend view (Page 3872)

Online configuration of the table view (Page 3878)

Displaying logged values

Introduction
Scroll through the displayed data of an archive using the buttons in the toolbar of a trend view 
or table view. If key combinations are configured, you can also use these for scrolling. 
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The buttons for browsing in archive are available only if data is supplied through archive tags.

The archived values of a tag are displayed within a time range in the trend or table view. 

Requirement
● Time range is configured

Buttons for Archived Values
To scroll in archived values, proceed as follows:

1. To display the first data record of the time range, click on .

2. To display the previous data record of the time range, click on .

3. To display the next data record of the time range, click on .

4. To display the last data record of the time range, click on .

See also
Time range basics (Page 3833)

Online configuration of the f(t) trend view (Page 3872)

Online configuration of the table view (Page 3878)

Elements of the status bar

Elements of the status bar
The status bar of the trend view or table view can contain the following elements:

Icon Name Description
Connection status1 No faulty data connections

Faulty data connections exist

All data connections are faulty

"Line 1"2 Selected line Shows the number of the selected line.
"Column 2"2 Selected column Shows the number of the selected column.
"23.02.2010" Date Shows the system date.
"23:59:59" Time Shows the system time.

Time base Shows the time base used in the display of times.
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Icon Name Description
1: If you double-click on the "Connection status" icon, the "Status of the data connections" window 
opens. The following properties of each data connection are listed in the window:
● Name
● Status
● Tag name
2: Only in the table view

See also
Online configuration of the f(t) trend view (Page 3872)

Online configuration of the table view (Page 3878)

Configuring toolbar and status bar (Page 3863)

10.3 Working with alarms

10.3.1 Principles

10.3.1.1 Alarm Logging in WinCC

Introduction
The alarm system allows you to display and record operating states and faults on the HMI 
device that are present or occur in a plant.

An alarm may have the following content:

N
o.

Time Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red

Alarm system in WinCC  
The alarm system processes a variety of alarm types. The alarm procedures can be broken 
down into system-defined alarms and user-defined alarms: 

● User-defined alarms are used to monitor the plant process.

● System-defined alarms monitor the HMI device.

The detected alarm events are displayed on the HMI device. Targeted access to the alarms 
combined with supplementary information about individual alarms ensures that faults are 
localized and cleared quickly. This reduces stoppages or even prevents them altogether.
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The following figure shows the alarm system structure:

10.3.1.2 Alarm Logging in WinCC

Introduction
Alarm logging allows you to display and record operating states and faults on the HMI device 
that are present or occur in a plant.

An alarm may have the following content:

N
o.

Time of 
day

Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red
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Alarm Logging in WinCC
Alarm logging processes various alarm procedures used by the PLC and the HMI device. The 
alarm procedures can be broken down into system-defined alarms and user-defined alarms: 

● User-defined alarms serve to monitor the plant.

● System-defined alarms are used to monitor the HMI device or the PLC.

The detected alarm events are displayed on the HMI device. You can use the alarm logging 
system to log alarms from the ongoing process. Targeted access to the alarms combined with 
supplementary information about individual alarms ensures that faults are localized and 
cleared quickly. This reduces stoppages or even prevents them altogether.

The following figure shows the alarm logging structure:

10.3.1.3 Alarm Logging in WinCC 

Introduction
Alarm logging allows you to display and record operating states and faults on the HMI device 
that are present or occur in a plant.

An alarm may have the following content:
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N
o.

Time of 
day

Date Alarm text Status Alarm class

5 12:50:24
:590

24.02.
2007

Boiler pressure above 
high limit.

Incoming 
Outgoing

Warning:
Color Red

Alarm Logging in WinCC 
Alarm logging processes various alarm procedures used by the PLC and the HMI device. The 
alarm procedures can be broken down into system-defined alarms and user-defined alarms: 

● User-defined alarms serve to monitor the plant.

● System-defined alarms are used to monitor the HMI device or the PLC.

The detected alarm events are displayed on the HMI device. You can use the alarm logging 
system to log alarms from the ongoing process. Targeted access to the alarms combined with 
supplementary information about individual alarms ensures that faults are localized and 
cleared quickly. This reduces stoppages or even prevents them altogether.

The following figure shows the alarm logging structure:
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10.3.1.4 Alarm Procedures

Overview of the alarm types 

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 

Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

System-defined alarms
● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

See also
Analog alarms (Page 3893)

Overview of the alarm types

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 
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Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

● Controller alarms 

– You configure controller alarms in STEP 7.

– You continue to process the controller alarms in WinCC.
 

  Note
Device dependency

The controller alarm is not supported on all HMI devices.
 

System-defined alarms
● System-defined controller alarms       

– System-defined controller alarms consist of diagnostic alarms (SIMATIC S7) and system 
errors (SFM)

– System-defined controller alarms are used to monitor the PLC.
 

  Note
Device dependency

System-defined controller alarms are not supported on all HMI devices.
 

● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

See also
Analog alarms (Page 3893)

Controller alarms (Page 3894)

System-defined controller alarms (Page 3896)

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 3891



Overview of the alarm types

Introduction
The alarm types serve various purposes for monitoring the plant. The alarms from the individual 
alarm types are configured and triggered in different ways. 

Select the relevant tab in the "HMI alarms" editor to configure alarms based on the individual 
alarm types. 

Alarm types in WinCC   
WinCC supports the following alarm types:

User-defined alarms
● Analog alarms    

– Analog alarms are used to monitor limit violations.

● Discrete alarms    

– Discrete alarms are used to monitor states.

● User alarms

– User alarms serve to monitor operator input.  

– User alarms are triggered by means of alarm number and can be also used in scripts 
in Runtime. 

● Controller alarms 

– You configure controller alarms in STEP 7.

– You continue to process the controller alarms in WinCC.
 

  Note
Device dependency

Controller alarms and user alarms are not supported on all HMI devices.
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System-defined alarms
● System-defined controller alarms       

– System-defined controller alarms are used to monitor the PLC.

– Diagnostics alarms (SIMATIC S7) and system alarms (SFM) also belong to the category 
of system-defined controller alarms.

 

  Note
Device dependency

System-defined controller alarms are not supported on all HMI devices.
 

● System events 

– System events belong to the HMI device and are imported into the project.

– System events monitor the HMI device.

Custom alarm classes

Analog alarms

Description
Analog alarms signal limit violations during the process.

Example
The speed of the mixer in a fruit juice mixing plant must not be too high or too low. You can 
configure analog alarms to monitor the speed of the mixer. If the high or low limit for the speed 
of the mixer is violated, an alarm is output on the HMI device containing the following alarm 
text, for example: "Mixer speed is too low".

See also
Configuring Analog Alarms (Page 3922)

Discrete alarms

Description
Discrete alarms indicate a status in the current process.  
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Example  
A fruit juice mixing plant consists of several tanks containing the ingredients. To ensure the 
correct mixing ratio of water, fruit concentrate, sugar, and flavoring, the valves in the intakes 
open and close at the right moment. This operation should be monitored. 

You configure a suitable discrete alarm for all the valve states. If a valve on one of the four 
tanks opens or closes, an alarm is displayed, such as "Water valve closed". 

The operator can thus monitor whether the plant is producing correctly. 

See also
Configuring discrete alarms (Page 3925)

Controller alarms

Example of an alarm
CPU operating mode switch to Stop

Description
The custom controller alarms are created by the control system engineer in STEP 7. The status 
values, such as time stamp and process values, are mapped in the controller alarm. If controller 
alarms are configured in STEP 7, accept them into the integrated WinCC operation as soon 
as a connection is established to the PLC.  

In STEP 7, the controller alarm is assigned to an alarm class. You can import this alarm class 
with the controller alarm as a common alarm class.

Types of controller alarms 
SIMATIC S7 supports different types of controller alarms. WinCC supports different types of 
controller alarms according to which Runtime is used.

Controller alarms for multiple HMI devices
If a PLC is connected to multiple HMI devices, the project engineer assigns display classes to 
the controller alarms in STEP7. The display classes determine the allocation to the HMI device. 
You can activate the display classes for your HMI device that are to be displayed on it. In this 
case, only the controller alarms from this display class will be displayed on the HMI device. 
Up to 17 display classes are possible.

See also
Editing controller alarms (Page 3932)
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User alarms

Description  
User alarms indicate operator actions in Runtime. You can also configure user alarms in 
Runtime scripts for user-defined applications. 

Example
An alarm of alarm class "Errors" is displayed on the HMI device of a plant. The operator 
eliminates this error in the plant and acknowledges the alarm in the alarm view of the HMI 
device. To monitor by whom and when the error was cleared, assign a user alarm to the 
appropriate button of the alarm view. The alarm contains the following information, for example: 

● Type and content of the acknowledged alarm

● Time of acknowledgment

● Operator

● Date

System-defined alarms

System events

Examples for alarms
● "An online connection to the PLC is established."

Description   
A system alarm indicates the status of the system, plus communication errors between the 
HMI device and system.

Under "Runtime settings > Alarms" you specify how long a system alarm is shown on the HMI 
device.

Support
The reference contains a list of the possible system events, along with the cause and possible 
remedies. If you contact online support because of a system alarm on the HMI device, you will 
need the alarm number and tags used in the system alarm.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 3895



System events

Examples of alarms
● "Overflow of the buffer for printing lines in text mode"

● "No printer is installed or a default printer has not been set up."

Description   
A system event indicates the system status, including errors in the communication between 
the HMI device and system. 

The system events depend on the HMI device. 

You can load system events in the "HMI alarms" editor from a an *.xml file. 

Support
The reference contains a list of the possible system events, along with the cause and possible 
remedies. When contacting Online Support because of a system event on the HMI device, you 
need the event number and tags used in the system event.

See also
Editing system events (Page 3931)

System-defined controller alarms

Example of an alarm
Valve open due to overpressure

Description     
System-defined controller alarms are installed with STEP 7 and are only available if WinCC is 
operated in the STEP 7 environment. 

WinCC processes system-defined controller alarms of the type "SIMATIC S7 diagnostic alarm".

S7 diagnostic alarms show states and events in the SIMATIC S7 controllers. You only have 
read access to S7 diagnostic alarms. They are assigned to the "Diagnostics" alarm class by 
the system. S7 diagnostic alarms are not acknowledged or reported. They are for signaling 
purposes only.

See also
Enabling system-defined controller alarms (Page 3933)
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10.3.1.5 Alarm states 

Introduction
An alarm assumes various alarm states in Runtime. The user analyzes and reports on the 
process execution with reference to the alarm states. 

 

 Note

Device dependency

Reporting and logging are not available for all HMI devices.
 

Description
Every alarm has an alarm status. The alarm states are made up of the following events: 

● Incoming       
The condition for triggering an alarm is satisfied. The alarm is displayed, such as "Boiler 
pressure too high".

● Outgoing  
The condition for triggering an alarm is no longer satisfied. The alarm is no longer displayed 
as the boiler was vented.

● Acknowledge   
The operator acknowledges the alarm.

Alarms without acknowledgment
The following table shows the alarm states for alarms that do not have to be acknowledged:

Status Description
Incoming The condition for an alarm is satisfied.
Outgoing The condition for an alarm is no longer satisfied.

Alarms with acknowledgment
The following table shows the alarm states for alarms that have to be acknowledged:

Status Description
Incoming The condition for an alarm is satisfied 
Outgoing,
not acknowledged

The condition for an alarm is no longer satisfied. The operator 
has not acknowledged the alarm.

Outgoing,
and subsequently acknowledged

The condition for an alarm is no longer satisfied. The operator 
has acknowledged the alarm after this time.
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Status Description
Incoming, 
acknowledged

The condition for an alarm is satisfied. The operator has 
acknowledged the alarm.

Outgoing,
but acknowledged first

The condition for an alarm is no longer satisfied. The operator 
acknowledged the alarm while the condition was still satisfied.

Each occurrence of these states can be displayed and logged on the HMI device and a protocol 
printed.

 

 Note

The display text for the states of an alarm is language-specific and configuration-specific.
 

10.3.1.6 Alarm classes

Basics on alarm classes

Introduction
Many alarms occur in a plant. These are all of different importance. You can assign the alarms 
of your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class defines how an alarm is displayed. The alarm class specifies if and how the 
user has to acknowledge alarms of this alarm class. 

A new alarm class with mandatory acknowledgment is generated in WinCC.
 

 Note

The choice of display modes for alarm classes depends on the options on your HMI device.
 

Examples of how to use alarm classes   
● The alarm "Speed of fan 1 in upper tolerance range" has alarm class "Warnings". The alarm 

is displayed with a white background. The alarm does not have to be acknowledged.

● The alarm "Speed of fan 2 has exceeded upper warning range" is assigned to the "Errors" 
alarm class. The alarm is displayed with a red background and flashes at high frequency 
in runtime. The alarm is displayed until the user acknowledges it.
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Using alarm classes  
Use the following alarm classes to define the acknowledgment model and display of alarms 
for your project:

● Predefined alarm classes  
You cannot delete predefined alarm classes and edit them only to a limited extent. 
Predefined alarm classes have been created for each HMI device under "HMI alarms > 
Alarm classes".

● Custom alarm classes  
You can create new alarm classes under "HMI alarms > Alarm classes", configure how you 
want the alarms to be displayed, and define an acknowledgment model for alarms of this 
alarm class. The possible number of custom alarm classes depends on which runtime is 
used in your project.

See also
Creating alarm classes  (Page 3914)

Creating alarm classes (Page 3915)

Predefined alarm classes (Page 3900)

Using common alarm classes (Page 3916)

Basics on alarm classes

Introduction
Many alarms occur in a plant. These are all of different importance. You can assign the alarms 
of your project to alarm classes to clearly show the user which of the alarms are most important. 

Description
The alarm class defines how an alarm is displayed. The alarm class specifies if and how the 
user has to acknowledge alarms of this alarm class. 

A new alarm class with mandatory acknowledgment is generated in WinCC.
 

 Note

The choice of display modes for alarm classes depends on the options on your HMI device.
 

Examples of how to use alarm classes   
● The "Speed of fan 1 in upper tolerance range" alarm has "Warnings" alarm class. The alarm 

is displayed with a white background. The alarm does not have to be acknowledged.

● The "Speed of fan 2 has exceeded upper warning range" alarm is assigned to the "Errors" 
alarm class. The alarm is displayed with a red background and flashes at high frequency 
in runtime. The alarm is displayed until the user acknowledges it.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 3899



Using alarm classes  
Use the following alarm classes to define the acknowledgment model and display of alarms 
for your project:

● Predefined alarm classes  
You cannot delete predefined alarm classes and edit them only to a limited extent. 
Predefined alarm classes have been created for each HMI device under "HMI alarms > 
Alarm classes".

● Custom alarm classes  
You can create new alarm classes under "HMI alarms > Alarm classes", configure how you 
want the alarms to be displayed, and define an acknowledgment model for alarms of this 
alarm class. The possible number of custom alarm classes depends on which runtime is 
used in your project.

● Common alarm classes  
Common alarm classes are displayed under "Shared data > Alarm classes" in the project 
tree and can be used for the alarms of an HMI device. Common alarm classes originate in 
the alarm configuration of STEP 7. If needed, you can create additional common alarm 
classes in WinCC. 

See also
Creating alarm classes  (Page 3914)

Creating alarm classes (Page 3915)

Predefined alarm classes (Page 3900)

Using common alarm classes (Page 3916)

Predefined alarm classes

Predefined alarm classes   
The following alarm classes already created in WinCC for every HMI device:

Alarm classes for user-defined alarms
● "Warnings"

The "Warnings" alarm class is designed to show irregular statuses and routines in the 
process. Users do not acknowledge alarms from this alarm class.

● "Errors"
The "Errors" alarm class is intended to show critical or dangerous states or limit violations 
in the process. The user must acknowledge alarms from this alarm class. 
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Alarm classes for system-defined alarms
● "System"

The "System" alarm class contains alarms that display states of the HMI device and the 
PLCs.

● "Diagnosis Events"
The "Diagnosis Events" alarm class contains alarms that display states and events in 
SIMATIC S7 controllers. Users do not acknowledge alarms from this alarm class.

 

  Note
Device dependency

The "Diagnosis Events" alarm class is not available for all HMI devices.
 

See also
Basics on alarm classes (Page 3899)

Creating alarm classes (Page 3915)

Creating alarm classes  (Page 3914)

Using common alarm classes (Page 3916)

10.3.1.7 Acknowledgement

Acknowledging alarms 

Introduction   
To make sure that an alarm was registered by the plant operator, configure this alarm so that 
it is displayed until acknowledged by the operator. Alarms that display critical or hazardous 
states in the process have to be acknowledged. 

Description
The acknowledgment of an alarm is an event that is logged and reported. Acknowledging an 
alarm changes the alarm status from "Incoming" to "Acknowledged". When the operator 
acknowledges an alarm, the operator confirms that he or she has processed the status that 
triggered the alarm. 

 

 Note
HMI device dependency

Reporting and logging are not available for all HMI devices.
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Triggering acknowledgment of an alarm
In Runtime, you trigger alarm acknowledgments in various ways:

● Acknowledgement by the authorized user at the HMI device

● Automatic acknowledgment by the system without operator action, e.g. by means of

– Tags

– PLC

– System functions in function lists or scripts
 

  Note
HMI device dependency

Scripts are not available for all HMI devices.
 

Acknowledging alarms that belong together
To make the alarm system clearer and easier to use in Runtime, you can configure an alarm 
group. You can acknowledge all alarms belonging to this alarm group in a single pass. 

Acknowledgment by the PLC
Discrete alarms will be automatically acknowledged by the PLC, if necessary. The 
acknowledgment is triggered by a bit in the "Acknowledgment tag PLC". You define the bit and 
tag at the configuration stage. 

Acknowledgment of an alarm on the HMI device
In Runtime, the user acknowledges an alarm in one of the following ways, depending on the 
configuration:

● Using the acknowledgment button <ACK> on the HMI device

● Using the button in the alarm view

● Using configured function keys or buttons in screens
 

  Note
Acknowledgment button <ACK> on the HMI device

To ensure that critical alarms are processed only by authorized users, protect the "ACK" 
button on the HMI devices, including the operating controls and display objects of the 
alarms. Use the appropriate operator authorization for this.

 

  Note
HMI device dependency

The acknowledgement key <ACK> is not available on all HMI devices.
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Reaction to the acknowledgment of alarms of an alarm group
● Alarm acknowledgment by the operator

You acknowledge the alarm of an alarm group, for example, using the <ACK> 
acknowledgment key or a function key. All alarms of the alarm group are acknowledged.

● Alarm acknowledgment by the controller
The controller sets a tag bit to acknowledge the alarm of an alarm group.
The respective alarm is acknowledged.

Acknowledgment model 

Overview 
You define the acknowledgment model for an alarm class. Alarms that are assigned to this 
alarm class will be acknowledged on the basis of this acknowledgment model. The following 
acknowledgment model is used in WinCC:  

● Alarm without acknowledgment 
This alarm comes and goes without having to be acknowledged. There is no visible 
response from the system. 

● Alarm with simple acknowledgment 
This alarm must be acknowledged as soon as the event that triggers the alarm occurs. The 
alarm remains pending until it is acknowledged.

Acknowledgment model

Overview
You define the acknowledgment model for an alarm class. Alarms that are assigned to this 
alarm class will be acknowledged on the basis of this acknowledgment model. The following 
acknowledgment model is used in WinCC:  

● Alarm without acknowledgment   
This alarm comes and goes without having to be acknowledged. There is no visible 
response from the system. 

● Alarm with simple acknowledgment  
This alarm must be acknowledged as soon as the event that triggers the alarm occurs. The 
alarm remains pending until it is acknowledged.

● Alarm with dual-mode acknowledgment  
The alarm requires one acknowledgment as soon as the event that triggers the alarm has 
occurred, and a second acknowledgment when the event that triggers the alarm is no longer 
present. The alarm remains pending until it is acknowledged.

● Alarm without "outgoing" status with acknowledgment 
This alarm is displayed in the alarm view until it is acknowledged. It then disappears from 
the alarm view. The alarm is only logged.
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● Alarm without "outgoing" status without acknowledgment 
This alarm is displayed, and goes out when the event that triggered the alarm is no longer 
present. The alarm is not added to the alarm view. The alarm is only logged.

● First value alarm with flashing and single acknowledgment  
The first value alarm is a form of alarm processing in which the first alarm in a list of alarms 
to undergo a status change since the last acknowledgment is highlighted. Only the first 
alarm in this alarm class is displayed flashing in the alarm window.

● New value alarm with flashing and single acknowledgment  
The new value alarm is a form of alarm processing in which any alarms from a list of alarms 
that have undergone a state change since the last acknowledgment are highlighted.

● New value alarm with flashing and dual-mode acknowledgment 
The alarm flashes if the value being monitored has changed. You acknowledge this alarm 
incoming and outgoing. 

Overview of the Acknowledgment models for Multiple Alarms
● Group Acknowledgment/Single Acknowledgment of Alarms in the Alarm View

The alarm view has a "Group acknowledgment" button . This button triggers the 
acknowledgment of all visible alarms that require acknowledgment and are pending in the 
alarm view. If the "Single acknowledgment" option is enabled for an alarm, you cannot use 
the group acknowledgment function and must acknowledge the alarm separately using the 

 button. 

● Acknowledging Alarms in Alarm Groups
If an alarm group is assigned an acknowledgment tag, use this tag in Runtime for a group 
acknowledgment of all alarms of this alarm group. You can configure suitable buttons or 
function keys for using this tag.

Alarm annunciator acknowledgment model
You can configure the acknowledgment of the alarm annunciator in the following ways:

● You acknowledge the alarm annunciator alongside with the alarm that triggered it.

● To acknowledge the alarm annunciator, use a separate button in the alarm view.

● A specified tag is used to control the alarm annunciator.

Emergency Acknowledgment
In exceptional circumstances, you can acknowledge an alarm with reference to its alarm 
number. The acknowledgment bit is sent to the AS even if the alarm is currently not pending. 

For this reason, the function should only be used in extreme emergency situations.
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10.3.1.8 Alarm groups

Introduction
Many alarms from different areas and processes occur in a plant. You can compile associated 
alarms into alarm groups. 

Alarm groups  
You can use the alarm groups to monitor the parts of the plant and to acknowledge the 
associated alarms together as required. 

Alarm groups can contain alarms from different alarm classes. You only assign alarms that 
require acknowledgment to alarm groups. 

Using alarm groups
It is a good idea to compile alarm groups for alarms such as the following:

● Alarms that are caused by the same fault.

● Alarms of the same type

● Alarms from a machine unit, such as "Fault in drive XY"

● Alarms from an associated part of the process, such as "Fault in cooling water supply"

Display in Runtime
In Runtime, the "Alarm group" column displays the number of the alarm group to which the 
alarm belongs. 

See also
Configuring alarm groups  (Page 3919)

10.3.1.9 Alarm groups

Alarm Group Basics

Introduction  
Many alarms from different areas and processes occur in a plant. You use alarm groups to 
clearly represent the states of the plant areas on the HMI device, and to make the alarm system 
for your project easy to operate. 
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Description
An alarm group is a compilation of single alarms. An alarm group has several tags that address 
a specific property of the it alarms contains. You define the bits of each tag for a group. To 
display an alarm group on the HMI device, configure its visualization individually via the alarm 
group's status tag.

Application
You can use alarm groups for the following purposes, for example:

● To compile alarms that were caused by the same fault,
such as "power failure"

● To compile alarms of the same type,
such as "fuse blown"

● To sort and monitor alarms from a machine unit
such as "fault in drive XY"

● Alarms from an associated part of the process
such as "fault in cooling water supply"

● To process a group of all alarms from a plant area, such as:

– Acknowledging alarms

– Locking alarms

– Suppressing alarm displays

● To visualize the status of plant areas

● To connect plant processes with the acknowledgment of alarms

Alarm Groups in WinCC
In WinCC, you work with two types of alarm group: 

● Custom alarm groups   
You create custom alarm groups as required. These contain alarms that must be 
acknowledged, as well as sublevel alarm groups. You can create a hierarchy of custom 
alarm groups that contains up to five subgroups. 

● Alarm Groups from Alarm Classes
An alarm group is already created for each predefined alarm class. When you create a new 
alarm class, an alarm group is created with the same name. All the alarms from this alarm 
class will also be contained in the alarm group from the alarm class. Any changes to the 
alarm class configuration will be transferred to the "Alarm Groups" tab. The configuration 
for the corresponding alarm group will be updated. You only edit the properties of the alarm 
group for alarm groups from alarm classes. 

 

  Note

An alarm is always contained in an alarm group from alarm classes. An alarm that requires 
acknowledgment can also belong to a custom alarm group. 
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See also
Configuring alarm groups  (Page 3920)

Hierarchical alarm groups

Introduction
WinCC allows you to compile alarms and custom alarm groups hierarchically. In this way, you 
construct a hierarchy of alarms that allows you to clearly and quickly detect and process the 
states of complex plants. 

You can only create this hierarchy from alarms and alarm groups with custom alarm groups.

Structure of Hierarchical Alarm Groups
You compile custom alarm groups and single alarms hierarchically as required. You can also 
subsequently add child alarm groups. 

The following figure shows a hierarchical alarm group in WinCC:

 

 Note

If you subsequently add an alarm group, the numbering will no longer be consecutive.
 

 
 

 NOTICE

When you create a hierarchy of alarm groups, make sure that you do not use them recursively.
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 Note

If you delete an alarm group that contains other alarm groups, all lower-level alarm groups 
will be deleted as well.

 

Components of parent alarm groups
A parent alarm group contains the following elements as required:

● Single alarms

● Child alarm groups

Display suppression tag
You only assign the display suppression tag to alarm groups that contain no alarm subgroups 
and to customized alarm groups.

See also
Configuring alarm groups  (Page 3920)

Tags of an alarm group

Tags of an alarm group     
You can assign the following tags to an alarm group:

Status tag
The status tag stores the alarm states of an alarm group. 

The status tag stores the acknowledgment request. The acknowledgment request is pending 
in an alarm group when at least one of the alarms in the group is queued and this alarm requires 
acknowledgement.  

The status tag is used to visualize the alarm states and the acknowledgment request of an 
alarm group.

The status tag can be checked by other WinCC components.

Lock tag
The lock tag stores the locked status of an alarm group.

The lock tag is used to analyze the locked status of an alarm group.

Acknowledgment tag
The acknowledgment tag stores the "acknowledged" status of an alarm group.
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The acknowledgment tag is used to acknowledge an alarm group.

The acknowledgment tag can be polled by other WinCC components.
 

 Note

The acknowledgment bit of an acknowledgment tag is not automatically reset. You can 
configure a button or function key to do this. Use this button to reset the acknowledgment bit 
of the acknowledgment tag.

The acknowledgment tag of an alarm group does not display the acknowledgment via the 
alarm view.

 

Display suppression tag
The display suppression tag automatically suppresses the display of all the alarms for an alarm 
group in response to a specific plant status.

The display suppression tag returns the current value of the plant status as a value between 
1 and 32. All alarms of the alarm group for which the corresponding bit of the number between 
1 and 32 is set in the display suppression mask are suppressed.

See also
Configuring alarm groups  (Page 3920)

Configuring Alarm Display Suppression (Page 3984)

Bit assignment for lock tags (Page 4120)

Bit assignment for display suppression tags  (Page 4121)

Bit assignment of status tag (Page 4116)

Bit assignment for acknowledgment tags (Page 4119)

10.3.1.10 Alarm number 

Assigning alarm numbers
The system assigns unique alarm numbers within an alarm type. 

 

 Note

When adapting alarm numbers, observe the uniqueness of the alarm number within an alarm 
type.
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10.3.1.11 Alarm number 

Assigning alarm numbers 
The system assigns unique alarm numbers for the project. 

 

 Note

When adapting alarm numbers, observe the inter-project uniqueness of the alarm number.
 

The system event number overrides a custom alarm number. If using the system event number 
for a custom alarm, change the user-defined alarm number accordingly. 

10.3.2 Working with Alarms 

10.3.2.1 Alarm components and properties

Overview   
You configure the components of alarms in WinCC. The following table shows the basic 
components of alarms:

Alarm
 class

Alarm 
number

Time 
of day

Date Alarm 
status 

Alarm text Alarm
 
group

Tooltip Trigger tag Limit 
value

Warni
ng

1 11:09
:14

06.08.2
007

IO Maximum speed 
reached

2 This alarm is ... speed_1 27

Syste
m

110001 11:25
:58

06.08.2
007

I Switch to "Online" 
mode

0 This alarm is ... PLC-
Variable_1

–

Alarm class  
Alarm classes, such as "Warnings" or "Errors". The alarm class defines the following for an 
alarm: 

● Acknowledgment model

● Appearance in Runtime (e.g. color)

● Logging
 

 Note
Device dependency

Logging is not available for all HMI devices.
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Alarm number  
An alarm is identified by a unique alarm number. The alarm number is assigned by the system. 
You can change the alarm number to a sequential alarm number, if necessary, to identify 
alarms associated in your project.

Time and date  
Every alarm has a time stamp that shows the time and date at which the alarm was triggered.

Alarm status  
An alarm has the events "Incoming," "Outgoing," "Acknowledge." For each event, a new alarm 
is output with the current status of the alarm. 

Alarm text  
The alarm text describes the cause of the alarm. 

The alarm text can contain output fields for current values. The values you can insert depend 
on the Runtime in use. The value is retained at the time at which the alarm status changes.

Alarm group  
The alarm group bundles individual alarms. 

Tooltip  
You can configure a separate tooltip for each alarm; the user can display this tooltip in Runtime.

Trigger tag  
Each alarm is assigned a tag as trigger. The alarm is output when this trigger tag meets the 
defined condition, e.g. when its state changes or it exceeds a limit.

Limit value  
Analog alarms indicate limit violations. Depending on the configuration, WinCC outputs the 
analog alarm as soon as the trigger tag exceeds or undershoots the limit value.

See also
Basics on alarm classes (Page 3899)

Alarm states  (Page 3897)

Alarm groups (Page 3905)

Overview of the alarm types (Page 3890)

Overview of the alarm types (Page 3892)

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 3911



10.3.2.2 Configuring Alarms

Overview of alarm configuration tasks

Steps to configure alarms                 
Configuring alarms in WinCC involves the following steps:

1. Edit and create alarm classes
You use the alarm class to define how an alarm will be displayed in runtime and to define 
the acknowledgment model for it. 

2. Creating tags in the "HMI tags" editor

– Configure the tags for your project.

– You create range values for the tags.

3. Creating tags in the "HMI alarms " editor

– Create custom alarms and assign these the tag to be monitored, alarm classes, alarm 
groups, and other properties.

– You can also assign system functions or scripts to the alarm events.

4. Output of configured alarms
To output configured alarms, configure an alarm view or an alarm window in the "Screens" 
editor.

Additional configuration tasks
Additional tasks may be necessary for configuring alarms, depending on the requirements of 
your project:

1. Creating alarm groups
You assign the alarms of your project to alarm groups according to their association, such 
as by the cause of the problem (power failure) or source of the error (Motor 1).

2. Configuring Loop-In-Alarm
A Loop-In-Alarm is configured in order to change to a screen containing relevant information 
on an alarm received.
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Overview of alarm configuration tasks

Steps to configure alarms         
Configuring alarms in WinCC involves the following steps:

1. Edit and create alarm classes
You use the alarm class to define how an alarm will be displayed in runtime and to define 
the acknowledgment model for it. 

2. Creating tags in the "HMI tags" editor

– Configure the tags for your project.

– You create range values for the tags.

1. Creating tags in the "HMI alarms " editor

– Create custom alarms and assign these the tag to be monitored, alarm classes, alarm 
groups, and other properties.

– You can also assign system functions or scripts to the alarm events.

2. Output of configured alarms
To output configured alarms, configure an alarm view or an alarm window in the "Screens" 
editor.

Additional configuration tasks
Additional tasks may be necessary for configuring alarms, depending on the requirements of 
your project:

● Activating and editing system events
You can import system events when you initially open the "System events" tab in the "HMI 
alarms" editor. On completion of the import, you can edit the system events.

● Activating and editing controller alarms
For integrated operation of a project in STEP 7, specify the controller alarms to be displayed 
on your HMI device in the alarm settings.

● Creating alarm groups
Assign the alarms of your project to alarm groups based on their relation, e.g. by error cause 
(e.g. "power failure"), or by error source (e.g. "Motor 1").

● Configuring Loop-In-Alarm
Configure a Loop-In-Alarm in order to change to a screen that contains information about 
an incoming alarm. 

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 3913



Configuring Alarm Classes

Creating alarm classes 

Introduction
Create alarm classes in the "Alarm classes" tab of the "HMI alarms" editor. Some default alarm 
classes are already created for every project. You can create additional custom alarm classes. 
You can create up to 32 alarm classes. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure
To create an alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The predefined and existing custom alarm classes are displayed. The following table lists 
the predefined alarm classes:

1. Double-click "<Add>" in the table.
A new alarm class is created. Each new alarm is automatically assigned a static ID.
The properties of the new alarm class are shown in the Inspector window. 

2. Configure the alarm class under "Properties > Properties >General" in the Inspector window.

– Enter a "Name" and the "Display name".

– Depending on the HMI device, you can also activate logging, or automatic sending of e-
mails.

3. Define the acknowledgment model for the alarm class under "Properties > Properties > 
Acknowledgment" in the Inspector window.

4. Change the default text under "Properties > Properties > Status" in the Inspector window.
This text indicates the status of an alarm in Runtime. 

5. Change the default colors under "Properties > Properties > Colors" in the Inspector window. 
Depending on the HMI device, also change the flashing characteristics.

These settings define how alarms from this alarm class are displayed in Runtime.
 

 Note

To display the alarm classes in color in Runtime, the "Use alarm class colors" option must 
be activated. In the project navigation, enable "Runtime settings > Alarms > General > Use 
alarm class colors" accordingly. This option is selected in a new project in WinCC. 
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See also
Basics on alarm classes (Page 3899)

Predefined alarm classes (Page 3900)

Creating alarm classes

Introduction
Create alarm classes in the "Alarm classes" tab of the "HMI alarms" editor. Some default alarm 
classes are already created for every project. You can create additional custom alarm classes. 
You can configure up to 256 alarm classes per project.

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure
To create an alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The predefined custom alarm classes are displayed. A table of the pre-defined alarm 
classes is shown below:

1. Double-click "<Add>" in the table.
A new alarm class is created. Each new alarm class is automatically assigned a static ID.
The properties of the new alarm class are shown in the Inspector window. 

2. Configure the alarm class under "Properties > Properties >General" in the Inspector window:

– Enter a "Name" and the "Display name".

– Activate the"Log" check box if you want to log the alarms from this alarm class.

3. Select "Properties > Properties > Acknowledgment" in the Inspector window to define the 
acknowledgment model for the alarm class and alarm annunciator.
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4. You can edit the default text under "Properties > Properties > Status" in the Inspector 
window.
This text indicates the status of an alarm in Runtime. 

5. You can also change the default background and foreground colors under "Properties > 
Properties > Colors" in the Inspector window.
These settings define how alarms from this alarm class are displayed in Runtime.

Additional settings for alarm classes
Comments in Runtime     

The user enters a comment for an incoming alarm in Runtime, as required. Using the buttons 
of the alarm view, users can show the comments in the "Historical alarm list" display. You can 
configure this function in the alarm class. Enter the user in the "User name" system block.

Assign comments to defined user

To assign the comments to the user logged on, proceed as follows:

1. Select the alarm class.

2. Enable "Properties > Properties > Acknowledgment > Settings > Assign comments to 
defined user" in the Inspector window.
Any user can enter the first comment if a comment has yet to be entered. 
When the first comment has been entered, all other users have read-only access to it.

Use comment of the incoming alarm

Whenever the status of an alarm changes, for example, from "incoming" to "acknowledged" 
status, the alarm is output once again with another status. The user only assigns comments 
to one incoming alarm. To include comments for alarm output with the new status, proceed as 
follows:

1. Select the alarm class.

2. Enable "Properties > Properties > Acknowledgment > Settings > Use comment of the 
incoming alarm" in the Inspector window.

See also
Configuring alarm acknowledgment (Page 4001)

Configuring acknowledgment of the alarm annunciator (Page 4004)

Basics on alarm classes (Page 3899)

Predefined alarm classes (Page 3900)

Using common alarm classes

Introduction
Project-wide alarm classes are displayed under "Shared data > Alarm classes" in the project 
navigation. Create additional common alarm classes in WinCC. 
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Controller alarms are assigned to common alarm classes. If you work with controller alarms, 
common alarm classes are automatically loaded in WinCC.

Requirements 
● You have created a project.

Creating project-wide alarm class    
To create a project-wide alarm class, proceed as follows:

1. Double-click "Shared data > Alarm classes" in the project navigation.
The "Project-wide message classes" editor opens in the work area.

2. To create a project-wide message class, double-click in the first empty line of the table 
editor.

3. Specify the name and display name of the alarm class.

4. Select "With acknowledgment" if the alarm class requires acknowledgment.

Assign alarms to a common alarm class   
Proceed as follows to assign an analog or discrete alarm to a common alarm class:

1. In the "HMI alarms" editor, select the alarm that you want to assign to the common alarm 
class.

2. Click "General" in the Inspector window.

3. Click "Shared data > Alarm classes" in the project navigation.

4. Select the common alarm class in the detail view.
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5. Drag-and-drop the alarm class to the "Alarm class" selection box or "Alarm class" column 
in the work area of the Inspector window of the alarm.

The system creates a new alarm class that is linked to the common alarm class. The new 
name of the common alarm class is displayed in the "Alarm class" area of the Inspector 
window of the alarm. The display name of the common alarm class is activated for the alarm 
class in your project.

6. Click the "Alarm Class" tab.

7. Check to see whether the display name of the common alarm class is displayed in WinCC.

8. You can change the object name of the alarm class.
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Alternative procedure
To assign an alarm to a common alarm class, proceed as follows:

1. Click the "Alarm Classes" tab.
The alarm classes are displayed. 

2. Click "Shared data > Alarm classes" in the project navigation. The following table shows 
the common alarm classes:

3. Select the common alarm class in the detail view.

4. Drag-and-drop the alarm class to the "Alarm classes" tab of the "HMI alarms" editor
The system creates a new alarm class that is linked to the common alarm class. The new 
name of the new alarm class in your project is displayed in the "Alarm class" tab.

5. Open the tab with the alarm procedure for the required alarm.

6. Under "General" in the Inspector window, select the alarm and the alarm class linked to the 
common alarm class.

 

 Note
Deleting a common alarm class

If you delete a common alarm class, the linked alarm class is maintained. If necessary, link 
the alarm class with another common alarm class or use it as WinCC alarm class.

 

See also
Basics on alarm classes (Page 3899)

Configuring Alarm Groups

Configuring alarm groups 

Introduction
Create alarm groups on the "Alarm Groups" tab in the "HMI alarms" editor. An alarm group is 
a compilation of single alarms. You assign alarms in an alarm group by association, such as 
cause of the problem or source of the error. If you acknowledge an alarm from this alarm group 
in Runtime, all other alarms in the alarm group are acknowledged automatically.
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Requirement
● You have created a project.

● The "HMI alarms" editor is open.

● The Inspector window is open.

Creating a new alarm group     
1. Click the "Alarm Groups" tab.

The existing alarm groups are displayed. 

2. In the work area of the table, double-click "<Add>" in the first free row.
A new alarm group is created. 

3. You can overwrite the proposed "Name".

Result
An alarm group is created. For the group acknowledgment of alarms in Runtime, assign the 
associated alarms that require acknowledgment to an alarm group.

See also
Alarm groups (Page 3905)

Configuring alarm groups 

Introduction
Create custom alarm groups on the "Alarm Groups" tab of the "HMI alarms" editor. The alarm 
groups from alarm classes are already created on a separate tab. You acknowledge alarms 
from an alarm group together in Runtime. Configure a corresponding group acknowledgment 
button for the alarm group, including an additional button for resetting the acknowledgment bit 
of the acknowledgment tag.

Requirements
● You have created a project.

● The "HMI alarms" editor is open.

● The Inspector window is open.
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Creating a new alarm group  
To create an alarm group, proceed as follows:

1. Click the "Alarm Groups" tab.
The existing alarm groups are displayed.

2. Double-click "<Add>" in the table.
A new alarm group is created.
The properties of the new alarm group are shown in the Inspector window. 

3. In the Inspector window, click "Properties > Properties > General" and enter a name for the 
alarm group.

4. In the Properties window, click "Properties > Properties > Tags" to specify the following 
tags and bits:

– Status tag for visualizing the alarm states of the alarm group

– Acknowledgment tag for acknowledging an alarm group

– Lock tag for visualizing the locked status of an alarm group

– Display suppression tag for filtering alarms in Runtime by plant status

Creating a child alarm group  
To create a child alarm group, proceed as follows:

1. Click the "Alarm Groups" tab.

2. In the work area or in the detail view, select the alarm groups you want to insert as a child 
group.

3. Drag and drop the alarm groups onto another alarm group.
The selected alarm groups become a child group in the hierarchy of this alarm group.

If you want to create a parent group for a hierarchy of alarm groups, drag and drop the entire 
hierarchy to this alarm group.
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Alternative procedure
1. Click the "Alarm Groups" tab.

2. Select the alarm groups for which you want to create a subgroup.

3. In the cell on the left of the selected row, open the shortcut menu and select "Insert child 
element".
A new child alarm group is created.

See also
Alarm Group Basics (Page 3905)

Hierarchical alarm groups (Page 3907)

Tags of an alarm group (Page 3908)

Configuring Alarm Display Suppression (Page 3984)

Tag Bit Assignments (Page 4116)

Configure alarms

Configuring Analog Alarms

Introduction
Analog alarms indicate limit violations. For example, if the speed of a motor drops below a 
certain value, an analog alarm is triggered. 

Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● You have created the required alarm classes and alarm groups.
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Procedure       
To configure an analog alarm, proceed as follows:

1. Click the "Analog alarms" tab.

2. To create a new analog alarm, double-click in the table on "<Add>".
A new analog alarm is created. 

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– Enter an alarm text as event text.
Format the text character-for-character using the shortcut menu. 
Using the shortcut menu, you can insert output fields for HMI tags, or text from text lists.

– You can renumber the alarm.

– Select the alarm class and the alarm group, if necessary.

4. Configure the tag that triggers the alarm under "Properties > Properties > Trigger > 
Settings".
Do not use trigger tags for anything else.
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Configure limit values for an analog alarm
1. In the Inspector window, click the button  under "Properties > Properties > Trigger > 

Limit > Value".

– To use a constant as limit value, select "Constant".
Enter the required limit value.

– To use a tag as limit value, select "HMI tag".
The  button is shown. Use this button to select the tag you want to use.

 

  Note

If the required tag does not exist in the selection list yet, create it in the object list and 
change its properties later.

 

2. Select the mode:

– "High limit violation": The alarm is triggered when the limit is exceeded.

– "Low limit violation": The alarm is triggered when the limit is undershot.

Optional settings for analog alarms

Setting the delay time    
To set the delay time, proceed as follows:

● Enter a time period in the Inspector window under "Properties > Properties> Trigger > 
Settings > Delay".
The alarm is only triggered when the trigger condition is still present after the delay time 
has elapsed.

Setting the deadband
 

 Note

If a process value fluctuates around the limit, the alarm associated with this fault may be 
triggered multiple times. To prevent this from happening, configure a deadband or delay 
time.     

 

To enter the deadband, follow these steps:

1. Under "Properties > Properties> Trigger > Deadband > Mode", select the change in alarm 
status for which the deadband is to be taken into account.

2. Enter a constant value under "Value".

3. To define the deadband value as a percentage of the limit, set the "in %" check box.
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Automatic reporting    
To print the alarms continuously:

● Select the "Activate" option under "Properties > Properties > Miscellaneous > Report."
 

  Note

Device dependency

Reporting is not available for all HMI devices.
 

Creating a tooltip    
To configure a tooltip for the alarm, follow these steps:

● Select "Properties > Properties > Tooltip" in the Inspector window and enter your text.

Configuring event-driven tasks  
To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the analog alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Analog alarms (Page 3893)

Output of a tag value in the alarm text (Page 3928)

Configuring trigger for alarm acknowledgment (Page 3999)

Configuring reporting of alarms (Page 3995)

Formatting alarm text (Page 3927)

Output of texts from a text list in an alarm (Page 3930)

Configuring discrete alarms

Introduction
Discrete alarms triggered by the PLC indicate status changes in a plant. They indicate the 
opened or closed state of a valve, for example.

The following sections describes the configuration procedures in the "HMI alarms" editor. You 
can also configure discrete alarms in the "HMI tags" editor.
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Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● You have created the required alarm classes and alarm groups.

Procedure     
To configure a discrete alarm, proceed as follows:

1. Open the "Discrete alarms" tab.

2. To create a new discrete alarm, double-click in the work area on "<Add>".
A new discrete alarm is created.

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– Enter an alarm text as event text.
Use the functions of the shortcut menu to format the text on a character-by-character 
basis, or to insert output fields for HMI tags, or texts from the text lists. 

– You can renumber the alarm.

– Select the alarm class and the alarm group, if necessary.

4. In the Inspector window, select the tag and the bit that triggers the alarm under "Properties 
> Properties > Trigger". Note the following information:

– Use the data types "Int" or "UInt" to select an HMI tag.

– When you select a PLC tag, use the data types "Int" or "Word". The input and output 
area of a PLC tag is unsuitable as trigger.

– Use trigger tag bits only for alarms.

– Do not use trigger tags for anything else.

– If you want to acknowledge the alarm via the PLC, use this tag also as PLC 
acknowledgment tag.

 

 Note

Note the method used to count bits in the utilized PLC when specifying the bit. For more 
information, refer to the "Communication" section in the PLC Online Help.

 

 Note

If the object does not yet exist in the selection list, create it directly in the object list and change 
its properties later.

 

Status-dependent alarm texts
To display a different text independent of the alarm status, link a text list to the alarm text. You 
control the text list with a tag.
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Additional settings for discrete alarms
 

Creating a tooltip    
To configure a tooltip for the alarm, follow these steps:

● Enter your text under "Properties > Properties > Tooltip".

Configuring event-driven tasks    
To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Discrete alarms (Page 3893)

Configuring trigger for alarm acknowledgment (Page 3999)

Configuring reporting of alarms (Page 3995)

Output of texts from a text list in an alarm (Page 3930)

Formatting alarm text (Page 3927)

Formatting alarm text

Requirement
● The "HMI alarms" editor is open.

● An alarm has been created.

Procedure     
To format an alarm text, proceed as follows:

1. Select the alarm to edit.

2. In the Inspector window, select the characters to format under "Properties > Properties > 
General > Alarm text".

3. Select the formatting from the shortcut menu, e.g. "Underscored" or "Uppercase".
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 Note

It is not possible to underline tags and text list entries.
 

Result
The selected characters are displayed in Runtime with the selected formatting. 

Removing format settings     
To remove all text formats, proceed as follows:

1. In the Inspector window, select the characters whose formatting you want to remove in the 
alarm text.

2. Select "Delete formatting characters" from the shortcut menu.

Result
The selected characters are displayed in unformatted notation in Runtime.

See also
Overview of alarm configuration tasks (Page 3912)

Configuring Analog Alarms (Page 3922)

Configuring discrete alarms (Page 3925)

Output of a tag value in the alarm text (Page 3928)

Output of texts from a text list in an alarm (Page 3930)

Output of a tag value in the alarm text

Introduction   
In WinCC, you can insert output fields into the alarm text which display the content of tags.

Requirements
● The "HMI alarms" editor is open.

● The alarm is selected.
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Output of a tag value in the alarm text
To insert an output field for a tag value in the alarm text, proceed as follows:

1. Place the cursor onto the required position in the event text.

2. Select "Insert tag output field" in the shortcut menu.

3. Open the object list under "Tag" and select a tag.
You can also create the tag in the object list.

4. Under "Format", specify the length of the output field and the format for tag value output in 
the alarm text.
Configure an output field of sufficient size. Otherwise, the tag content is not output to the 
full extent in the alarm. 

5. Click  to save your entries.

WinCC inserts a placeholder for the output field into the alarm text: "<tag: n, [tag name]>" 
whereby n = text string length.

Editing output field properties
To edit the properties of an output field, proceed as follows:

● Double-click on the output field in the alarm text and edit the settings.

Deleting an output field from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

 

 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log.

Device dependency

Logging is not available for all HMI devices.
 

See also
Configuring Analog Alarms (Page 3922)

Formatting alarm text (Page 3927)

Output of texts from a text list in an alarm (Page 3930)
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Output of texts from a text list in an alarm

Introduction   
Text lists are used to create dynamic alarm texts. For example, you can configure the output 
of both states of a discrete alarm in an alarm text. 

Insert a corresponding output field in the alarm text and specify the tag that returns the search 
key for the text list. 

Requirements
● A text list is created.

● The "HMI alarms" editor is open

● The alarm is selected

Output of a text list value in an alarm text
To insert an output field for a value from a text list in the alarm text, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. Select "Insert text list output field" command from the shortcut menu.

3. Select the text list under "Text list".

4. Open the object list under "Tag" and select the tag that returns the search key for the text 
list.
You can also create the tag in the object list.

5. Define the length of the output field under "Format".
Configure an output field of sufficient size so that the complete text from the text list is 
displayed in the alarm.

6. Click on the  icon to save your entries.
WinCC inserts a placeholder for the output field into the alarm text: 
""<textlist: n, [textlist name]>" whereby n = text string length.
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Editing output field properties
To edit the properties of an output field, proceed as follows: 

● Double-click on the output field in the alarm text and edit the settings.

Deleting text list from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

See also
Formatting alarm text (Page 3927)

Configuring Analog Alarms (Page 3922)

Configuring discrete alarms (Page 3925)

Output of a tag value in the alarm text (Page 3928)

Editing system events

Editing system events   
When you open the "System events" tab in the "HMI alarms" editor, WinCC prompts you to 
import or update the system events. Import the system events and specify the display period. 
You cannot delete or create new system events. You can only edit the alarm text with system 
events. 

Requirements
● You have imported the system events.

Specifying the display period
To determine the display period, proceed as follows:

1. Double-click "Runtime settings" in the project navigation.

2. Enter a value under "Alarms > System events > Display period".
This value specifies a time in seconds during which the system events are displayed on 
the HMI device. If you want to display system events permanently, enter "0".

Changing the alarm text
To change the alarm text of a system event, follow these steps:

1. Open the "HMI alarms" editor and then click the "System events" tab.

2. Select the system event that you want to edit.
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1. Change the alarm text under "Properties > Properties > Properties > General" in the 
Inspector window.

 

 Note

If you change an alarm text for a system event that contains a placeholder, leave the number 
of placeholders unchanged. A placeholder may be a "%1".

 

Configuring event-driven tasks
The "Incoming" event is available for certain system events, depending on the HMI device. To 
configure event-driven tasks, proceed as follows:

1. Select the system event.

2. Select "Properties > Properties > Incoming" in the inspector window and configure a function 
list.

See also
Overview of alarm configuration tasks (Page 3913)

System events (Page 3896)

Editing controller alarms

Introduction
Controller alarms are configured in STEP 7. Controller alarms are available in WinCC running 
in a STEP 7 environment. 

In WinCC you only edit the properties of controller alarms that are specific to an HMI device. 
Different properties of a controller alarm can be edited, depending on the HMI device and PLC.

You can filter the displayed controller alarms for your project using the display classes that 
were configured on the PLC for controller alarms.

Requirements
● The connection was established to the PLC.

● Alarms were configured in STEP 7.

Editing controller alarms
Proceed as follows to edit controller alarms:

1. Double-click "HMI alarms" in the project navigation.
The "HMI alarms" editor is opened.

2. Open the "Controller alarms" tab.
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3. Select the alarm that you want to change in the work area.

4. Make your changes. Depending on the HMI device, it may not be possible to display or 
enable some of the controller alarm properties.

Editing SIMATIC S7 alarms
You can edit these controller alarms in the STEP 7 alarm configuration system. To do this, 
proceed as follows:

1. Select the alarm that you want to change in the work area.

2. Select "Open in alarm editor of the PLC" from the shortcut menu.
The STEP 7 alarm configuration system is opened.

3. Make your changes.

Filtering the controller alarm using display classes
To filter controller alarms by display classes, proceed as follows:

1. Click "Runtime settings > Alarms" in the project navigation under your HMI device.
One or several connections to a PLC are shown in "Contoller alarms".

2. Select the display classes whose controller alarms you want to display for the connection.

Result
Only those controller alarms whose display class you have enabled for your HMI device will 
be displayed on the "Controller alarms" tab of the "HMI alarms" editor.

See also
Controller alarms (Page 3894)

Enabling system-defined controller alarms

Enabling system-defined controller alarms   
To activate system-defined controller alarms for your HMI device, proceed as follows:

1. Select "Runtime settings > Alarms" in the project navigation.
The alarm settings open.

2. Under "System events" activate the system-defined controller alarms.
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3. To display the system events with alarm text, activate "With text".

4. To display these alarms in Runtime, configure an alarm view that displays alarms from the 
"Diagnosis Events" alarm class.

 

  Note

For HMI devices with small display units, specify to display only the alarm number for 
system-defined controller alarms.

 

 

See also
System-defined controller alarms (Page 3896)

Configure alarms

Configuring alarm blocks

Alarm Text Block Basics

Introduction
An alarm display is made up of alarm text blocks. Each alarm text block corresponds to one 
column in the table in the alarm view.

There are three groups of alarm text blocks:

● System blocks    
System blocks contain system data, such as date, time, alarm number and status.

● User text blocks    
User text blocks contain the alarm text with the description of the cause of a fault and 
additional text with information, for example, the location of a fault.

● Parameter blocks    
Parameter blocks are used to link the alarms to process values, such as current fill levels, 
temperatures or speeds. You can configure up to 10 parameter blocks per alarm.

Configuring Alarm Text Blocks
You enable and edit the alarm text blocks on the "Alarm text blocks" tab. To display alarm text 
blocks in an alarm view, select the alarm text blocks to be displayed and logged from the 
enabled alarm text blocks in the "Screens" editor.

Text length
The maximum text length of a user text block is 255 characters.

The text length of a parameter block can be configured as follows:
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● Controller alarms: up to 32 characters
Set the length of the parameter block to 32 characters to ensure that all characters will be 
displayed.

● Other alarm procedures: up to 255 characters
 

  Note
"Status" system block

The status texts of the alarms are displayed in the "Status" system block. This system 
block must be configured so that it is long enough to display the status texts in full.

 

Flashing
An alarm to be acknowledged or single alarm text blocks can be displayed as flashing in 
Runtime. They have to meet the following requirements:

● The "Flashing" property must be enabled in the alarm class of the alarm. You configure this 
property on the "Alarm classes" tab.

● The "Flashing" option is enabled in the "Alarm text block" area under "General" in the 
Inspector window for alarm text blocks that should flash.

Alignment
On the "Alarm text blocks" tab, you define whether the alarm text block should be right-justified, 
left-justified or centered in an alarm view column. 

Format
For certain alarm text blocks, you can choose between different display formats. 

See also
Setting up flashing alarm text blocks (Page 3936)

Configuring Alarm Text Blocks

Introduction
An alarm is made up of configured alarm text blocks. You enable the alarm text blocks for an 
HMI device on the "Alarm text blocks" tab. Then you select, from the enabled alarm text blocks 
for each alarm view, which enabled alarm text blocks are to be displayed and logged.

Requirements
● The "HMI alarms" editor is open.

● The "Alarm text blocks" tab is selected.
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Activating alarm text blocks     
1. Select the "System blocks", "User text blocks" or "Parameter blocks" tab for the alarm text 

blocks.

2. Select the alarm text block to be displayed on your HMI device.

3. In the Inspector window, select "Properties > Properties > General > Alarm text block > 
Enable".

4. Under "Properties > Properties > General > Alarm text block" in the Inspector window, 
define the text length and alignment of the alarm text block in the alarm view column.

5. In the Inspector window under "Properties > Properties > Settings > Format", select the 
format of the alarm text block. This option is not available for every alarm text block.

Under "Shared data > Text lists" in the project navigation, define the display names for the 
user text blocks. 

Result
The alarm text blocks are enabled and displayed in the Inspector window of the alarm view in 
the "Screens" editor. 

Disabling alarm text blocks
1. Select the tabs for the alarm text blocks that you want to disable.

2. Disable the alarm text blocks that you no longer want to use for alarm view and alarm 
logging.

3. Repeat the process for every alarm text block that you no longer want to display.

See also
Description of the System Blocks (Page 4069)

Setting up flashing alarm text blocks (Page 3936)

Setting up flashing alarm text blocks

Introduction
Whether or not an alarm text block flashes in Runtime depends on the alarm class of the alarm. 
The alarm class determines if the alarms it contains flash when acknowledgment is pending. 

Requirements
● The alarms blocks are enabled for the HMI device.

● The alarms blocks are enabled for the respective alarm.

● The alarm is assigned to an alarm class with an acknowledgment model, which specifies 
whether or not the contained alarms are to flash.
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● The alarm text blocks are activated in the alarm view.

● The "Alarm text blocks" tab is selected.

Procedure
To configure flashing for alarm text blocks in Runtime, proceed as follows:

1. Select the alarm text block to flash in Runtime from the subordinate tabs on the "Alarm text 
blocks" tab.

2. In the Inspector window, select "Properties > Properties > General > Alarm text block > 
Flash".

3. Repeat this step for all the alarm text blocks that you want to flash in Runtime.

Result
These alarm text blocks flash in Runtime when the alarm is queued for acknowledgment. 

See also
Alarm Text Block Basics (Page 3934)

Configuring Alarm Text Blocks (Page 3935)

Configuring analog alarms

Configuring analog alarms

Introduction
In the "HMI alarms" editor, you can configure analog alarms and define their properties. You 
can also configure analog alarms in the "HMI tags" editor. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure         
To configure an analog alarm, proceed as follows:

1. Click the "Analog Alarms" tab.

2. To create a new analog alarm, double-click in the table on "<Add>".
A new analog alarm is created. 
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3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– You can always change the object name of the alarm.

– Select the alarm class and the alarm group, if necessary.

4. To display the CPU number or PLC that sends the alarm, enter this under "Connection to 
the PLC". This option is only active if you have enabled the "CPU/PLC number" alarm text 
block on the "Alarm text blocks > System blocks" tab.

5. In the Inspector window, select the tag that triggers the alarm under "Properties > Properties 
> Trigger". Do not use trigger tags for anything else.

6. To configure the alarm text, select "Properties > Properties > Alarm texts".

– To enter the alarm text, select "Alarm text".

– To create additional alarm texts, select "Additional texts".

– Use the functions of the shortcut menu to format text on a character-by-character basis 
and to insert output fields for system or alarm parameters.

 

  Note

You can only enter additional text in the rows that you have enabled as user text blocks 
on the "Alarm text blocks" tab.
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Defining limits
1. Select the analog alarm to which you want to assign the limits.

2. On the  bottom of the work area, click <Add> under "Limits for analog alarm".

3. To use a constant as limit:

– In the Inspector window, click the button  under "Properties > Properties > Trigger 
> Value" and select "Constant".

– Enter the required limit value.
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4. To use a tag as limit:

– In the Inspector window, click the button  under "Properties > Properties > Trigger 
> Value" and select "HMI tag".

– Click the button. The object list opens.

– Select the tag.

5. Select the trigger mode in the "Mode" field.

– "Equal to limit": The alarm is triggered when the limit is reached.

– "Not equal to limit": The alarm is triggered when the limit is no longer reached.

– "High limit violation": The alarm is triggered if the limit is exceeded.

– "Low limit violation": The alarm is triggered if the limit is undershot.

6. You can create additional limits for the alarm, if necessary.
 

  Note

If the object included in the selection does not yet exist, create it in the object list and 
change its properties later.

 

  Note

If a process value fluctuates around the limit, the alarm associated with this fault may be 
triggered multiple times. In this case, configure a deadband or delay time.

 

Optional settings for analog alarms
Setting the delay time     

To display an alarm after a delay, proceed as follows:

1. Select the analog alarm.

2. In the Inspector window, select "Properties > Properties > Trigger".

3. Enter a time period under "Delay". The trigger condition must be fulfilled within this time for 
the alarm to be triggered.

Setting the deadband     
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Proceed as follows to enter a tolerance range for the arrival or departure of an alarm:

1. Select the limit to which the deadband is to be assigned.

2. In the Inspector window, select "Properties > Properties > Trigger".

3. Under "Deadband > Mode", select the change to the alarm status to include in the evaluation 
of the deadband.

4. Enter a constant under "Deadband > Value".

5. To define the deadband value as a percentage of the limit, activate the "%" check box.

Saving the status of the alarm

To save the alarm states to a tag, proceed as follows: 

1. Select the analog alarm.

2. Under "Properties > Properties > Status" in the Inspector window, select the tag and the 
bit that triggers saving of the incoming/outgoing alarm states and the acknowledgment 
request.

Setting the priority     

To set the priority, proceed as follows:

1. Select the analog alarm.

2. Select a value between 0 and 16 under "Properties > Properties > General > Priority" in 
the Inspector window, .
If you filter the alarm view by priority, the alarm with priority 0 will appear at the top.

Creating an info text     

1. Select the analog alarm.

2. Select "Properties > Properties > Tooltip" in the Inspector window and enter a text.

Configuring event-driven tasks     

To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the analog alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Configuring acknowledgment of the alarm annunciator (Page 4004)

Configuring reporting of alarms (Page 3997)

Configuring alarm acknowledgment (Page 4001)

Parameter output in the analog alarm (Page 3942)

Configuring loop-in alarms (Page 3956)

Alarms in the "HMI tags" Editor (Page 3958)

Configuring Alarm Display Suppression (Page 3984)

Overview of alarm configuration tasks (Page 3913)
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Parameter output in the analog alarm

Introduction
To display system or alarm parameters, insert an appropriate output field in the analog alarm. 

● "Limit", "Deadband" or "Current Value" can be selected as alarm parameters.

● The following system blocks can be selected as system parameters: 

– User Name

– Computer name

– Comments

– Application Name

Requirement
● The "HMI alarms" editor is open.

● The analog alarm is selected.

Procedure    
To output parameters in alarm texts, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. To output an alarm parameter, select "Insert parameter output field in analog alarm" from 
the shortcut menu.
-OR-
Enable the output of system parameters by selecting "Insert system block output field" from 
the shortcut menu.

3. Specify the length, number of decimal places, tolerance, and alignment of the output field 
for alarm parameters.
To display leading zeros in the output field, enable "Leading zeros".

4. Click  to save your entries.

WinCC inserts a placeholder for the output field into the alarm text:
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● For alarm parameters: "<tag: n, [###]>" whereby n = text length in characters.

● For system parameters; "<name of the system parameter>"
 

  Note

If you test a project using the simulator, the output field values are not output in the alarm 
texts.

 

Deleting parameter from the alarm text
To delete an output field from the alarm text, proceed as follows:

● Select the output field in the alarm text and then select the "Delete" command from the 
shortcut menu.

 

 Note

The sequence of output fields in the alarm text depends on the language. The sequence of 
the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log. 

 

Configuring discrete alarms

Configuring discrete alarms

Introduction
Discrete alarms triggered by the PLC indicate status changes in a plant. They indicate the 
opened or closed state of a valve, for example.

The following sections describes the configuration procedures in the "HMI alarms" editor. You 
can also configure discrete alarms in the "HMI tags" editor.

Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.
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Procedure
To configure a discrete alarm, proceed as follows:

1. Click the "Discrete alarms" tab.

2. To create a new discrete alarm, double-click on "<Add>" in the table.
A new discrete alarm is created.

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– You can always change the object name of the alarm.

– Select the alarm class and the alarm group, if necessary.

– To display the CPU number or PLC that sends the alarm, enter these in the "Connection" 
area. This option is only active if you have enabled the "CPU/PLC number" alarm text 
block on the "Alarm text blocks" tab.

4. Select "Properties > Properties > Trigger" in the Inspector window to select the tag and the 
bit that triggers the alarm. Note the following information:

– Use data types "Bool" "USInt", "UInt", or "UDInt".

– Use trigger tag bits only for alarms.

– Do not use trigger tags for anything else.

– The input and output area of a PLC tag is unsuitable as trigger.
 

 Note

If the object does not yet exist in the selection list, create it directly in the object list and change 
its properties later.

 

 Note

The trigger bit is not incremented automatically if you generate a discrete alarm by copying 
an alarm text to a new table row. Avoid any redundant use of the trigger bit. 

 

 Note

Note the method used to count bits in the utilized PLC when specifying the bit. For more 
information, refer to the "Communication" section in the PLC Online Help.
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1. Select "Mode" to specify whether to trigger the alarm at a rising or falling edge.

2. To configure the alarm text, select "Properties > Properties > Alarm texts".

– To enter the alarm text, select "Alarm text".

– To create additional alarm texts, select "Additional texts".

– Use the functions of the shortcut menu to format text on a character-by-character basis 
and to insert parameter output fields.

 

  Note

You can only enter additional text in the rows that you have enabled as user text blocks 
on the "Alarm text blocks" tab.

 

Result
The discrete alarm is created.

Additional settings for discrete alarms
Creating an infotext     

To configure a tooltip for the alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Properties > Infotext" in the Inspector window and enter the required 
tip.

Enabling discrete alarm parameters

To output process values to an output field in the alarm text, assign corresponding tags to the 
parameter blocks. Proceed as follows:     

1. Select the alarm.

2. In the Inspector window, click "Properties > Properties > Alarm parameters".

3. Enter a value for the alarm parameter, or select a tag.

4. You can enter several alarm parameters.
Insert the activated process values as selection box into an alarm text, or show them as 
parameter block in the alarm view. 

 

  Note

To show the process values as parameter blocks, the parameter blocks must be enabled 
in the alarm view.

You only edit parameters that you have enabled under "Parameter blocks" on the "Alarm 
text blocks" tab.

 

Saving the alarm status     

To save the alarm states to a tag, proceed as follows: 
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1. Select the discrete alarm.

2. Under "Properties > Properties > Status" in the Inspector window, select the tag and the 
bit that triggers saving of the incoming/outgoing alarm states and the acknowledgment 
request.

Configuring event-driven tasks     

To configure event-driven tasks, such as a loop-in alarm, follow these steps:

1. Select the discrete alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Alarms in the "HMI tags" Editor (Page 3958)

Configuring Alarm Display Suppression (Page 3984)

Configuring alarm acknowledgment (Page 4001)

Configuring acknowledgment of the alarm annunciator (Page 4004)

Configuring loop-in alarms (Page 3956)

Configuring reporting of alarms (Page 3997)

Overview of alarm configuration tasks (Page 3913)

Parameter output in discrete alarms

Introduction
To display system or alarm parameters, insert an appropriate output field in the analog alarm. 

● You can select the parameters configured in "Properties > Properties > Alarm parameters" 
for use as alarm parameters.

● The following system blocks can be selected as system parameters: 

– User Name

– Computer name

– Comment

– Application Name

Requirement
● The "HMI alarms" editor is open.

● The discrete alarm is selected.
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Procedure    
To output parameters in alarm texts, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. To enable the output an alarm parameter, select "Insert parameter output field" from the 
shortcut menu.
-OR-
Enable the output of system parameters by selecting "Insert system block output field" from 
the shortcut menu.

3. Select the parameter.

4. Moreover, you can specify the following data for alarm parameters:

– The tag that provides the parameter values.
Enter the tag you configured for the parameter in "Properties > Properties > Alarm 
parameters". If you select a different tag, WinCC updates the parameter configuration 
in "Properties > Properties > Alarm parameters" accordingly.

– The length, number of decimal places, precision, and alignment of the output field

– To display leading zeros in the output field, enable "Leading zeros".

5. Click  to save your entries.
 

  Note

If you test a project using the simulator, the output field values are not output in the alarm 
texts.

 

 

 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log. 

 

See also
Configuring discrete alarms (Page 3943)

Configuring discrete alarms (Page 3958)
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Configuring user alarms

Configuring user alarms

Introduction
User alarms serve to to indicate operator actions in Runtime. User alarms are triggered by 
means of alarm number. For other custom applications, configure user alarms that are 
triggered in Runtime by means of scripts. 

Requirement
● The "HMI alarms" editor is open.

● The Inspector window is open.

Procedure
To configure user alarms, proceed as follows:

1. Click the "User alarms" tab.

2. To create a new user alarm, double-click "<Add>" in the table.
A new user alarm is created.

3. To configure the alarm, select "Properties > Properties >General" in the Inspector window:

– You can always change the object name of the alarm.

– Select the alarm class and the alarm group, if necessary.

– To display the CPU number or PLC that sends the alarm, enter these in the "Connection" 
area. This option is only active if you have enabled the "CPU/PLC number" alarm text 
block on the "Alarm text blocks" tab.

4. Click "Alarm texts" in the Inspector window and configure the alarm text.

– Enter the alarm text.

– To create additional alarm texts, select "Additional texts".

– You can insert output fields or or additional text into the alarm text.
 

  Note

You can only enter additional text in the rows that you have enabled as user text blocks 
on the "Alarm text blocks" tab.

 

Result
The user alarm is created.
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Additional settings for user alarms
Creating a tooltip     

To configure a tooltip for the alarm, follow these steps:

1. Select the user alarm.

2. Select "Properties > Properties > Tooltip" in the Inspector window and enter your text.

Enabling user alarm parameters

To output process values to an output field in the alarm text, assign corresponding tags to the 
parameter blocks. Proceed as follows:     

1. Select the alarm.

2. In the Inspector window, click "Properties > Properties > Alarm parameters".

3. You can enter several alarm parameters.
Insert the activated process values as selection box into an alarm text, or show them as 
parameter block in the alarm view. 

 

  Note

To show the process values as parameter blocks, the parameter blocks must be enabled 
in the alarm view.

You only edit parameters that you have enabled under "Parameter blocks" on the "Alarm 
text blocks" tab.

 

Saving the alarm status     

To save the alarm states to a tag, proceed as follows: 

1. Select the user alarm.

2. Select "Properties > Properties > Status" in the Inspector window and select the tag and 
the bit that triggers saving of the incoming/outgoing alarm states and the acknowledgment 
request.

Configuring event-driven tasks     

To configure event-driven tasks, proceed as follows:

1. Select the user alarm.

2. Select "Properties > Events" in the Inspector window and configure a new function list for 
the relevant event.

See also
Configuring acknowledgment (Page 4001)

Configuring alarm blocks (Page 3934)

Configuring Alarm Display Suppression (Page 3984)

Configuring alarm acknowledgment (Page 4001)

Configuring acknowledgment of the alarm annunciator (Page 4004)
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Parameter output in user alarms

Introduction
To display system or alarm parameters, insert an appropriate output field in the user alarm. 

● You can select the parameters configured in "Properties > Properties > Alarm parameters" 
for use as alarm parameters.

● The following system blocks can be selected as system parameters:

– User Name

– Computer name

– Comment

– Application Name

Requirement
● The "HMI alarms" editor is open.

● The user alarm is selected.

Procedure    
To output parameters in alarm texts, proceed as follows:

1. Place the cursor at the required position in the alarm text.

2. To enable the output an alarm parameter, select "Insert parameter output field" from the 
shortcut menu.
-OR-
Enable the output of system parameters by selecting "Insert system block output field" from 
the shortcut menu.

3. Select the parameter.

4. Moreover, you can specify the following data for alarm parameters:

– The tag that provides the parameter values.
Enter the tag you configured for the parameter in "Properties > Properties > Alarm 
parameters". If you select a different tag, WinCC updates the parameter configuration 
in "Properties > Properties > Alarm parameters" accordingly.

– The length, number of decimal places, precision, and alignment of the output field

– To display leading zeros in the output field, enable "Leading zeros".

5. Click  to save your entries.
 

  Note

If you test a project using the simulator, the output field values are not output in the alarm 
texts.
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 Note

The sequence of the tag output fields in the alarm text depends on the language. The 
sequence of the Runtime language is used for logging alarms to a CSV log file.

Changing the tag of an output field in one language causes the modified output field to appear 
at the end of the alarm text in all other languages. This changes the sequence of the output 
fields in the log. 

 

Example: Configuring a trigger for a user alarm

Task         
In the following example, you configure a user alarm that is triggered by a button in runtime. 

To do this, you configure a script at the "Click" event of this button. This script calls up an alarm 
number and sets the associated alarm to the status "Incoming".

Requirements
● The "HMI alarms" editor is open.

● The Inspector window is open.

● A screen with an alarm view and a button is open.

Procedure
1. You configure a user alarm in the "HMI alarms" editor.

The user alarm has the alarm number "17" in this case.

2. You configure the following script in the screen at the "Click" event of the button:

 
Sub onClick(byVal item)
    Dim UserAlarm
    Dim ID_UA
    Dim State_UserAlarm
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    ID_UA = "17"
    State_UserAlarm = "5"
 
    Set UserAlarm = HMIRuntime.Alarms(ID_UA)
    UserAlarm.State = state_UserAlarm
    UserAlarm.Comment = "empty Comment"
    UserAlarm.UserName = "Max Mustermann"
    UserAlarm.Create "MyApplication"
End Sub

Result
If the user clicks on this button in runtime, the configured user alarm is displayed in the alarm 
view.

Configuring alarm text

Introduction
The alarm text for an alarm is made up of the alarm text, additional texts and output fields. The 
alarm text and additional texts are user text blocks. You can use up to 10 user text blocks for 
an alarm.  

Each alarm text contains up to 255 characters and any number of output fields.

Requirements
● The "HMI alarms" editor is open.

● You have enabled user text blocks on the "Alarm text blocks" tab.

● An alarm has been created.

Procedure 
Proceed as follows to assign additional user text blocks to the alarm text for an alarm:

1. Select the alarm that you want to edit on the relevant tab.

2. To enter the alarm text, select "Properties > Properties > Alarm text" in the Inspector 
window. 
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3. You can also add output fields to the alarm text.

4. To enter additional alarm texts, select "Properties > Properties > Alarm text > Additional 
text" in the Inspector window.
Enter more additional texts according to which user text blocks you enabled under "User 
text blocks" on the "Alarm text blocks" tab. 

 

  Note

Use the scroll buttons  to view text that is not fully visible in the text box. The additional 
text lines are displayed.

 

Result
You have configured the alarm text with additional texts for this alarm. To display it in Runtime, 
enable these user text blocks in an alarm view. 

See also
Configuring analog alarms (Page 3937)

Configuring discrete alarms (Page 3943)

Editing system events

Introduction  
System events can only be changed to a limited extent. You cannot delete or create new 
system events. 

Requirements
● You have imported the system events.

● The "HMI alarms" editor is open.

Procedure
To configure system events, proceed as follows:

1. Click the "System events" tab.

2. Select the system event that you want to edit.

3. Change the editable properties in the Inspector window.

4. Select the system event that you want to edit.

5. Change the editable properties in the Inspector window.
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Configuring event-driven tasks
To configure event-driven tasks, proceed as follows:

● To configure a function list for the relevant event, select "Properties > Events".

Editing controller alarms

Introduction
Controller alarms are configured in STEP 7. Controller alarms are available in WinCC running 
in a STEP 7 environment. 

In WinCC you only edit the properties of controller alarms that are specific to an HMI device. 
Different properties of a controller alarm can be edited, depending on the HMI device and PLC.

You can filter the displayed controller alarms for your project using the display classes that 
were configured on the PLC for controller alarms.

Requirements
● The connection was established to the PLC.

● Alarms were configured in STEP 7.

Editing controller alarms
Proceed as follows to edit controller alarms:

1. Double-click "HMI alarms" in the project navigation.
The "HMI alarms" editor is opened.

2. Open the "Controller alarms" tab.

3. Select the alarm that you want to change in the work area.

4. Make your changes. Depending on the HMI device, it may not be possible to display or 
enable some of the controller alarm properties.

Editing SIMATIC S7 alarms
You can edit these controller alarms in the STEP 7 alarm configuration system. To do this, 
proceed as follows:

1. Select the alarm that you want to change in the work area.

2. Select "Open in alarm editor of the PLC" from the shortcut menu.
The STEP 7 alarm configuration system is opened.

3. Make your changes.
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Filtering the controller alarm using display classes
To filter controller alarms by display classes, proceed as follows:

1. Click "Runtime settings > Alarms" in the project navigation under your HMI device.
One or several connections to a PLC are shown in "Contoller alarms".

2. Select the display classes whose controller alarms you want to display for the connection.

Result
Only those controller alarms whose display class you have enabled for your HMI device will 
be displayed on the "Controller alarms" tab of the "HMI alarms" editor.

See also
Controller alarms (Page 3894)

Configuring Operator Input Alarms for an Alarm View

Introduction
Operator input alarms for the alarm view are preconfigured system alarms. Manage system 
alarms using the "HMI alarms" editor.In the "Screens" editor, configure the trigger conditions 
for operator input alarms for the alarm view.

Requirement
● You have imported the system alarms from the HMI device.

● The "Screens" editor is open.

● An "Alarm view" object has been created. 

● Alarm text blocks are activated in the "HMI alarms" editor.

Procedure
To configure operator input alarms for an alarm view, proceed as follows:

1. Select the alarm view.

2. In the Inspector window, click "Properties > Properties > Operator input alarms".

3. Activate the operator action at the alarm view for which an operator input alarm is to be 
output.
The alarm number of the preconfigured operator input alarm for this operator action is 
displayed in the "Alarm number" output field. 

4. To output another alarm for this operator action, enter the alarm number of this alarm.

5. To specify the columns to display in the operator input alarm, click the  button in "Alarm 
text blocks".
A dialog opens. 
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6. To enable the alarm text blocks to be output with the operator input alarm, select "Alarm 
text blocks".

7. Select "Alarm group of operator input alarm" to specify the alarm text blocks to be output 
with the system alarm.Under "Output as", define whether the content of the alarm text block 
should be output as text or as a value.

 

  Note

You will find the system alarm and its alarm number on the "System alarms" tab in the 
"HMI alarms" editor.

 

Result
The configured operator input alarm is displayed when the user performs an action on the 
alarm view in Runtime. 

Configuring loop-in alarms

Introduction
A Loop-In-Alarm is configured in order to change to a screen containing relevant information 
on an alarm received.     

Requirement
● The screen called by the Loop-In-Alarm has been created.

● The "HMI alarms" editor is open.

Procedure
To configure a Loop-In-Alarm for an alarm, proceed as follows:

1. Click the tab that contains the alarm for which you want to configure the Loop-In-Alarm.

2. Select the alarm.

3. In the Inspector window, select "Properties > Events > Loop-In-Alarm".
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4. Select the "ActivateScreen" system function.

5. Select the screen called by the Loop-In-Alarm  as parameter.

 

  Note

To configure the Loop-In-Alarm for an alarm view with an "alarm line" format, use a button 
with the following system functions:
● "EditAlarm" for HMI devices with keys
● "AlarmViewEditAlarm" for HMI devices without keys

The system functions trigger the "Loop-In-Alarm" event. The alarm line has no buttons.
 

Result
If you click on the "Loop-In-Alarm" button of the alarm view in Runtime, a screen is opened 
with information on the selected alarm.

See also
Using the Alarm Window, Alarm View (Page 4039)

Basic alarm view, using the alarm window (Page 4042)

Alarm view (Page 4048)

Configuring analog alarms (Page 3937)

Configuring discrete alarms (Page 3943)
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Alarms in the "HMI tags" Editor

Configuring discrete alarms

Introduction
In WinCC, you can create and edit discrete and analog alarms, including the trigger tags, in 
the "HMI tags" editor. 

 

 Note

If you delete, move or copy objects in the "HMI tags" editor, the changes also take effect in 
the "HMI alarms" editor.

 

Requirements
The "HMI tags" editor is open.

Procedure       
To configure a discrete alarm, proceed as follows:

1. To create a tag, click on "<Add>" in the table at the top of the work area.
A new tag is created. 

2. Configure an internal or external tag as required.

– Use the data types "Int" or "UInt" to select an HMI tag.

– When you select a PLC tag, use the data types "Int" or "Word". The input and output 
area of a PLC tag is unsuitable as trigger.

3. Select the tag at the top of the work area.

4. Click on "<Add>" in the table on the "Discrete alarms" tab at the bottom of the work area.
A new discrete alarm is created for the tag. If you have selected the incorrect data type, 
the tag will be marked in the discrete alarm.

5. Configure the discrete alarm in the Inspector window:

– Enter the alarm text under "Properties > Properties > General > Alarm text".
You can also insert output fields into the alarm text.

– Select an alarm class.

– Select the trigger bit of the tag that triggers the discrete alarm under "Properties > 
Trigger". 

6. You can create additional discrete alarms to monitor the tags.
 

  Note

A tag is monitored using only one alarm type. You should therefore create either analog 
alarms or discrete alarms for a tag.
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Result
The configured discrete alarms are created in the "HMI tags" editor and displayed in the "HMI 
alarms" and "HMI tags" editors. 

See also
Configuring discrete alarms (Page 3925)

Working with Tags (Page 3685)

Parameter output in the analog alarm (Page 3942)

Configuring analog alarms

Introduction
In WinCC, create the discrete and analog alarms, including the trigger tags, in the "HMI tags" 
editor. You can also edit the alarms as in the "HMI alarms" editor. You can create up to two 
range values for a tag. You monitor these limits with analog alarms.

Requirements
The "HMI tags" editor is open.

Procedure   
To configure an analog alarm in the "HMI tags" editor, proceed as follows:

1. To create a tag, click on "<Add>" in the table at the top of the work area.
A new tag is created. 

2. Configure an internal or external tag as required.

3. In the Inspector window, configure the range values of the tags under "Properties > 
Properties > Range":

– Select whether to use a "Constant" or an "HMI tag" as limit value for your range values. 
The object list opens when you select "HMI tag". Select the tag you want to use.
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1. Click the "Analog Alarms" tab at the bottom of the work area.
Create an analog alarm for both range values.

2. Select an analog alarm and configure it in the Inspector window:

– Enter the alarm text under "Properties > Properties > General > Alarm text".

– You can also insert output fields into the alarm text.

– You can change the default alarm class.

3. Configure the analog alarms as in the "HMI alarms" editor.

4. Complete the configuration of all analog alarms.
 

  Note

A tag is monitored using only one alarm type. You should therefore create either analog 
alarms or discrete alarms for a tag.

 

Result
The configured analog alarms are created in the "HMI tags" editor and displayed in the "HMI 
alarms" and "HMI tags" editors. 

See also
Working with Tags (Page 3685)

Parameter output in the analog alarm (Page 3942)

Configuring analog alarms (Page 3937)
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10.3.2.3 Configuring the Outputting of Alarms

Overview of configuring alarm output

Steps to complete when configuring alarm output   
You configure the alarm output in WinCC in the following steps:

1. Create alarm view
Use the display and control objects in the "Screens" editor to display alarms in Runtime. 
You can also configure an alarm view for logged alarms.

2. Configure acknowledgment
In the "Screens" editor, you can set the operator action that will trigger the acknowledgment. 

3. Configure reporting
You can create reports in the "Reports" editor to print alarms in Runtime. In the "Scheduler", 
"Screens", "HMI alarms" or "HMI tags" editors, you define when and how the printing of a 
report is triggered. 

 

  Note

Device dependency

Reporting and logging are not available for all HMI devices.
 

Additional configuration tasks
Additional tasks may be necessary for configuring alarm views, depending on the requirements 
of your project:

1. Setting up authorizations
To make sure only authorized operators process the alarms, assign authorizations for the 
alarm view and the function keys of the HMI device.

2. Configuring the filtering of the alarm view
You configure the filtering of the alarms in Runtime in the "Screens" editor. You can also 
configure alarm views that only display selected alarms.

3. Configure operator input alarms
Configure the operator input alarms on the operator controls of the HMI device in the 
"Screens" editor. A preconfigured operator input alarm is output for an operator action. An 
operator input is, e.g. the acknowledgment of an alarm.

See also
Configuring the alarm view (Page 3962)

Configuring the alarm view (Page 3975)

Reporting Alarms (Page 3995)
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Configuring the alarm view

Displaying Alarms

Options for displaying alarms on the HMI device
WinCC offers the following options for displaying alarms on the HMI device: 

● Alarm view
The alarm view is configured in a screen. More than one alarm can be displayed 
simultaneously, depending on the configured size. You can configure multiple alarm views 
with different contents.

● Alarm window
The Alarm window is configured in the "Global screen" editor. The alarm window can display 
multiple alarms at the same time, depending on the configured size. An event can trigger 
closing and reopening of the alarm window. To hide it during configuration, create an alarm 
window on its own level.

Additional signals
● Alarm indicator

The alarm indicator is a configurable, graphical icon. When an alarm comes in, the alarm 
indicator is displayed on the HMI device. You configure the alarm indicator in the "Global 
screen" editor.
The alarm indicator has two states:

– Flashing: At least one alarm that requires acknowledgment is pending.

– Static: The alarms are acknowledged but at least one of them has not gone out yet.
The alarm indicator also displays the number of pending alarms according to the HMI 
device.

● E-mail notification
To inform someone other than the operator, such as an engineer, when an alarm with a 
specific alarm class arrives, assign the alarm class to an e-mail address.

 

  Note
Device dependency

E-mail notification is not available for all HMI devices.
 

● System functions
You can configure a list of functions for the event associated with an alarm. These functions 
must be executed in Runtime when the event occurs. 
Use system functions for alarms in WinCC to control the alarm view or the alarm window 
other than via the toolbar.
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Displaying the predefined alarm classes in Runtime  
The following table shows the symbols used to display the predefined alarm classes in the 
alarm view:

Alarm class Displayed icon
"Diagnosis Events" S7
"Errors" !
"System" $
"Warnings" <No symbol>

See also
System functions for alarms (Page 4065)

Configuring an alarm view

Configuring an alarm view for active alarms

Introduction
Current alarms are displayed in Runtime in an alarm view or alarm window.

Requirement
● A screen is open in the "Screen" editor.

● The "Tools" task card is open.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 3963



Configuring alarms for the alarm view   
To specify the alarms that will be shown in the alarm view, proceed as follows:

1. Insert an "Alarm view" object from the "Tools" task card into the screen.

2. Select the alarm view.

– In the Inspector window, select "Properties > Properties > General > View > Current 
alarm states".
Set whether to display alarms with and/or without mandatory acknowledgment.

– To display all alarms in the alarm buffer, enable "Alarm buffer".
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3. In the table, activate the alarm classes to be displayed in the alarm view.

4. Under ""Properties > Properties > View > Control tag for display area", define the tag that 
returns the date as of which the alarms will be displayed.

 

  Note
Device dependency

The "Control tag for display area" property is not available for all HMI devices.
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Configuring the layout of the alarm view   
To specify how the alarms are shown in the alarm view, proceed as follows.

1. Under "Properties > Properties > Layout > Settings > Lines per alarm" in the Inspection 
window, specify the number of lines to display for each alarm.

2. In "Properties > Properties > View", select the control elements that are available on the 
HMI device.

3. Configure the columns under "Properties > Properties > Columns":

– Under "Visible columns" select the columns to be output in the alarm view.

– Under "Properties Column", define the properties of the columns.

– Under "Sort", select the sorting order of the alarms.

 

  Note

Select the "Edit" command in the shortcut menu for the alarm view to activate the alarm 
view. You can set the column width and position in active mode. To enable the alarm 
view, set the zoom factor to 100 %.

The alarm view is deactivated as soon as you deselect the object in the screen.
 

Result
Alarms of various alarm classes are output in the alarm view during runtime. 

See also
Creating alarm classes  (Page 3914)

Configuring an alarm window (Page 3969)

Displaying Logged Alarms (Page 3974)
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Alarm view (Page 3578)

Alarm view (Page 3583)

Configuring an alarm view for the S7 diagnostic alarms

Introduction   
To display S7 diagnostic alarms, configure an alarm view or alarm window for the predefined 
"Diagnosis Events alarm class. Activate the diagnostic alarms accordingly in the Runtime 
settings of your HMI device.

 

 Note
HMI device dependency

The "Diagnosis Events" alarm class is not available for all HMI devices.
 

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● A connection to the PLC is set up.

Configuring the display of S7 diagnostic alarms   
To configure the display of S7 diagnostic alarms, follow these steps:

1. Select "Runtime settings > Alarms > System events > S7 diagnostics alarms" in the project 
navigation.

2. To display the S7 diagnostics alarms with text, activate "With text".

3. Open the screen with the alarm view and select the alarm view.
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4. In the Inspector window, select "Properties > Properties > General > Display > Alarm class 
"Diagnosis Events".

5. Continue to configure the alarm view as for the display of current alarms.

Result
In Runtime the alarm view displays the S7 diagnostic alarms of the controller. 

Configuring an alarm view for logged alarms

Introduction
In Runtime, logged alarms are displayed in an alarm view or alarm window.

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● An alarm log was created in the "Log" editor.

● The alarms are assigned the "loggable" attribute in the "HMI alarms" editor.

Configuring an alarm view for logged alarms   
To configure an alarm view for logged alarms, proceed as follows:

1. Open the screen with the alarm view and select the alarm view.

2. In the Inspector window, select "Properties > Properties > General > Alarm log".

3. Click the "...." button and select the alarm log.

4. Continue to configure the alarm view as for the display of current alarms.
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Result
In Runtime, the logged alarms are output in the alarm view. 

Configuring an alarm window

Introduction
The alarm window displays current alarms. The alarm window is configured in the "Global 
screen" editor. The alarm window is not assigned to any screen. Depending on the 
configuration the alarm window is opened when an alarm that belongs to a specific alarm class 
is active. Depending on the configuration, it is not closed until the alarm is acknowledged. The 
HMI device can still be used, even if alarms are pending and displayed. An alarm window is 
displayed and configured like an alarm view.  

To hide an alarm window during configuration, create it on its own level. 

Requirement
● The "Global Screen" editor is open.

● The "Tools" task card is displayed.

● The Inspector window is open.

Procedure   
Proceed as follows to configure an alarm window:

1. Insert an "Alarm window" object from the "Tools" task card into the global screen.

2. Configure the alarm window like an alarm view.

3. Under "Properties > Properties > Mode >  Window" in the Inspector window, select how 
the alarm window reacts and is operated in Runtime.

– Activate "Modal" if the alarm window is to retain the focus in Runtime after a screen 
change.
This option is important, as switching back and forth between the screen and different 
windows with <Ctrl+TAB> is not supported.

Result
During runtime, the alarms of the selected alarm class are displayed in the alarm window. 

See also
Configuring an alarm view for active alarms (Page 3963)

Creating alarm classes  (Page 3914)

Alarm window (Page 3588)
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Configuring an alarm indicator 

Introduction
The alarm indicator uses a warning triangle to indicate that alarms are pending or require 
acknowledgement. If an alarm of the configured alarm class occurs, the alarm indicator is 
displayed.  

The alarm indicator has two states:

● Flashing: At least one alarm that requires acknowledgment is pending.

● Static: At least one of the acknowledged alarms has not gone out yet.

During configuration, specify whether Runtime has to open an alarm window when you operate 
the alarm indicator.

Requirement
● The "Global Screen" editor is open.

● The "Tools" task card is open.

● The Inspector window is open.

Procedure
Proceed as follows to configure the alarm indicator:

1. Insert the "Alarm indicator" object from the "Tools" task card into the work area.

2. Select the alarm indicator.
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3. Under "Properties  > Properties  > General" in the Inspector window, select the alarm 
classes to be displayed by the alarm indicator.
Specify whether to display pending and/or acknowledged alarms in the alarm indicator.

4. Under "Properties > Event", assign system function "ShowAlarmWindow" to an event of 
the alarm indicator.

 

  Note

If you have configured a permanent window in the screen or template, do not position the 
alarm window and alarm indicator in the vicinity of the permanent window. Otherwise the 
alarm window and the alarm indicator are not displayed in Runtime. However, the 
permanent window is not visible in the "Global screen" editor.

 

Result
The alarm indicator is displayed if alarms from the selected alarm class are pending or need 
to be acknowledged in Runtime. The alarm window opens when the user operates the alarm 
indicator. 

See also
Alarm indicator  (Page 3590)
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Configuring alarm filtering

Introduction
You can filter the display of alarms in the enhanced alarm view. The criterion is always a 
character string. There are two ways to filter the alarm view:

● A fixed criterion is configured in WinCC.
In Runtime, all alarms that contain the complete character string in the alarm text are 
displayed.

● You filter the alarm view in Runtime.
In Runtime, a filter tag sets the relevant character string in the alarm view by means of an 
I/O field, e.g. as described below. 
The filter affects the display in the alarm view. All alarms in the alarm buffer are retained. 

Requirement
● The alarm view has been configured.

● The screen with the alarm view is open.

● The Inspector window is open.

Configuring filters for a fixed character string
1. Select the alarm view.

2. In the Inspector window, select "Properties > Properties > Filter".

3. Enter a filter string in "Filter string".
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Result
Only those alarms are displayed in Runtime that contain the complete character string from 
the filter in the alarm text.

Configuring filters for a variable character string       
1. Select the alarm view.

2. In the Inspector window, select "Properties > Properties > Filter".

3. Select a tag from "Filter tag". The tag must be of the "String" type.

4. In the screen, configure an I/O field for entering the filter string in Runtime.

– In the Inspector window, select "Properties > Properties > General > Format > Display 
format > String".

– To link the I/O field to the alarm view, select "Process" to set the filter tag you selected 
for the alarm view.

Result
If you enter a string in the I/O field in Runtime, the alarm view only displays alarms that contain 
the complete string in their alarm text. 
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If a permanently configured character string and a filter tag were configured, the alarms will 
be filtered in Runtime according to the content of the filter tag. If the filter tag is blank, the 
permanently configured character string is used as the filter. 

 

 Note

Filtering is not possible for the following alarm views:
● Simple alarm view
● Alarm line
● Alarm window
● Alarm view for logged alarms

 

See also
I/O field (Page 3532)

Working with Tags (Page 3685)

Displaying Logged Alarms

Introduction
You display logged alarms in Runtime in an alarm view. The alarm view shows the content of 
an alarm log.   

Application
For example, you want to view information about the process at the end of a shift.

Requirements
● An alarm log has been created.

● A screen is open.

● The Inspector window is open.

Procedure
Proceed as follows to configure an alarm view to output an alarm log:

1. Configure an alarm view in a screen.

2. Under "Properties > Properties > General  > Display > Alarm log"" in the Inspector window, 
select the required alarm log.
You can always create a new alarm log.
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Result
During runtime, the alarms logged in the selected alarm log appear in the Alarm view.

 

 Note

In runtime, the alarm texts logged are not displayed but rather the alarm texts in the current 
project. The logged alarm texts are only intended for external evaluation of the log file.

If the alarm log displayed was configured differently, the alarm texts displayed may not 
correspond with those logged. 

 

See also
Configuring an alarm view for active alarms (Page 3963)

Configuring the alarm view

Displaying alarms

Options for displaying alarms on the HMI device
WinCC offers the following options for displaying alarms on the HMI device: 

● Alarm view for pending and outgoing alarms
The alarm view is configured for a screen. More than one alarm can be displayed 
simultaneously, depending on the configured size. You can also configure multiple alarm 
views with different contents and in different screens. Use the "Historical alarm list (short-
term)" and "Historical alarm list (long-term)" views to display outgoing alarms.

● Alarm view for statistical values
The "Alarm statistics" view of the alarm view displays statistical information, such as the 
frequency and display duration of alarms.

● Status tag of an alarm group
You can visualize the changing alarm states of an alarm group using the status tag of that 
alarm group. You can customize the display in the "Screens" editor.

Additional signals
● Alarm annunciator

In addition to the alarm view, WinCC displays an alarm in the form of a visual or audible 
alarm in the plant. The alarm annunciator may be a hooter, or a warning lamp.

● System functions and scripts
You can configure a list of functions for the event associated with an alarm. These functions 
must be executed in Runtime when the event occurs. 
To be able to control the alarm view other than via the toolbar, use system functions for 
alarms in WinCC.
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See also
Bit assignment of status tag (Page 4116)

Tags of an alarm group (Page 3908)

System functions for alarms (Page 4065)

Configuring an alarm view

Introduction
Current, and logged alarms are displayed in the alarm view. Alarms from all alarm classes are 
displayed in an alarm view, if necessary. Configure the criteria for alarm filtering. 

Requirement
● A screen is open.

● The "Tools" task card is open.
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Procedure  
To configure an alarm view, proceed as follows:

1. Insert an "Alarm view" object from the "Tools" task card into the screen.

2. Select the alarm view and click "Properties > Properties > General" in the Inspector window.

– Under "Display > Type", select the type of alarms you want to display as default in the 
alarm view.

– Under "Display > Display" select which alarms are displayed. This shows or hides the 
alarms to be suppressed in the display.

– Double-click of the operator on an alarm in Runtime starts a specific action. Specify this 
action under "Display > Double-click". If you want to trigger the Loop-In-Alarm  not only 
using the "Loop-In-Alarm" button, select "Loop-In-Alarm".

– Select the required time base under "Time base".
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3. To specify the appearance of the alarm view, select "Properties > Properties > Appearance" 
in the Inspector window.

4. To specify the appearance of the headers, content, and table grid in the alarm view, select 
"Properties > Properties > Table" .

– To specify the visualization of selected alarms in Runtime, select "Properties > 
Properties > Table > Table - Select".

– To specify the sorting method for alarms in Runtime, select "Properties > Properties > 
Table > Table - Sorting".

5. To specify the sort order of alarms in Runtime, select "Properties > Properties > Alarm list" .

Enabling alarm text blocks for the alarm view  
1. Select "Properties > Properties > Alarm text blocks > Inherit project settings for alarm text 

blocks" in the Inspector window to specify whether to apply the settings from the "Alarm 
text blocks" tab in the "HMI alarms" editor to this alarm view.

2. Select "Properties > Properties > Alarm text blocks" to enable the alarm text blocks to be 
visualized in the alarm view. You can specify the following properties for each alarm text 
block:

– Name

– Layout of the header

– Layout of content

– Alignment

– Length

– Format

– Flashing

Configuring the toolbar and status bar in the alarm view  
1. To specify the the toolbar layout, select "Properties > Properties > Toolbar > Toolbar - 

General".

2. Select "Properties > Properties > Toolbar > Toolbar - Operator input elements", to enable 
the operator input elements to be included in the alarm view toolbar.

3. To specify the the status bar layout, select "Properties > Properties > Status bar > Status 
bar - General".

4. Select "Properties > Properties > Toolbar > Toolbar - Operator input elements", to enable 
the operator input elements to be included in the status bar of the alarm view.

Result
Alarms of various alarm classes are output in the alarm view during runtime. To change the 
view in Runtime, click the configured buttons on the alarm view toolbar. 
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See also
Configuring filters in the alarm view (Page 3979)

Configuring Alarm Statistics (Page 3981)

Configuring filters in the alarm view

Introduction
WinCC supports the configuration of different filters for the alarm view:

● Standard filters
The operator cannot access standard filters in Runtime. You can copy configured standard 
filter for use in other alarm views.

● Custom filters
The operator can change the custom filter in Runtime. You are using custom filter only in 
a single alarm view.

Requirement
● The screen with the configured alarm view is open in the "Screens" editor.

● The Inspector window is open.

Procedure     
1. Select the alarm view and click "Properties > Properties > Filter > Alarm filter" in the 

Inspector window.

2. To configure a custom filter, click on the "Custom" tab.
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3. Define one or more filters. For each filter, specify one or more filter criteria under 
"Expression" with condition and value.

4. To configure a standard filter, select the "Standard" tab.
You can configure several standard filters and activate these for the respective alarm view. 

5. Enter the name for the standard filter and a comment.

6. To configure the filter, select the criteria, conditions, and the value for the standard filter in 
the "Filter" dialog.

Filter by process values
You cannot enter text as the criterion for a process value. To filter by the text of a parameter 
block, or by the process tag represented, proceed as follows:

1. Insert this process value as the alarm text for a user text block in an alarm.

2. In Runtime, filter the alarms by the text in the "Alarm text" alarm text block using the  
button.

In multi-user systems, make sure that contents displayed in the "Specify selection" dialog on 
a client have the same names on all servers. 

Filter by time
When filtering by time, the start and stop values are not adjusted automatically when the time 
base of the alarm view is changed. 
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Example
At a PC location with time zone "UTC + 1h", the alarm view has the "Local time zone" time 
base. You should filter by the time 10:00 to 11:00. Convert the time base to "UTC". To display 
the same alarms as before, change the start or stop value of the filter to 9:00 and 10:00. 

See also
SQL Statements for Filtering the Alarm View (Page 4072)

Configuring Alarm Statistics

Introduction  
The alarm statistics contain statistical calculations for the logged alarms in the alarm view. The 
alarm statistics also contain a selection of the configured alarm text blocks. If the contents are 
dynamic, the alarm text blocks display the data for the last incoming alarm. You can compile 
the alarm statistics columns individually. 

The alarm statistics contain the following statistical calculations:

● Alarm rate
The system counts how often an alarm with the status "Incoming" is included in the log. If 
the alarm number does not occur, this alarm number is not included in the statistics.

● Total display time of an alarm in seconds.
The following periods between alarm states are available as calculation variables:

– "Incoming/Incoming"(sum +/+),

– "Incoming/Outgoing"(sum +/-)

– "Incoming/Initial acknowledgment"(sum +/*1)

– "Incoming/second acknowledgment"(sum +/*2)

Each type of calculation can be represented in a column in the alarm statistics.

● Average display time of an alarm in seconds
The following periods between alarm states are available as calculation variables:

– "Incoming/Incoming"(mean value +/+),

– "Incoming/Outgoing"(mean value +/-)

– "Incoming/Initial acknowledgment"((mean value +/*1)

– "Incoming/second acknowledgment"((mean value +/*2)

There is one column in the alarm statistics for each type of calculation.

The calculation of the time of acknowledgment includes the "Acknowledged" alarm status. This 
status includes both an emergency acknowledgment and an acknowledgment by the PLC.
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Requirement
● The "Screens" editor is open.

● You have created a screen with an alarm view.

Configuring the alarm statistics functions   
Proceed as follows to configure the functions of the alarm statistics:

1. Select the alarm view and click "Properties > Properties > Alarm statistics - General" in the 
Inspector window.

2. To limit the calculation period, activate the "Use time range" option under "Time range". 
Specify the frequency.

3. To define the maximum number of alarms to be processed in the alarm statistics, enter a 
value at "Data records > Maximum number of data records".
This setting requires the following conditions to be met:

– The number of alarms in the calculation period exceeeds the configured "Maximum 
number of data records which can be read".

– The calculation period is not configured.

4. To output a warning when this number is exceeded, activate the "Warning when limit is 
reached" option.
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Setting up the alarm statistics
Proceed as follows to set the columns of the alarm statistics:

1. Select the alarm view and click "Properties > Properties > Alarm statistics - Elements" in 
the Inspector window.

2. In the table, enable the alarm statistics columns that are to be displayed in Runtime.

3. To specify the arrangement of columns in the alarm view in Runtime, select a row in the 
Inspector window. Move the row to the selected location using the  and  buttons.
The columns of the alarm statistics are displayed in Runtime in the same order as the rows 
are arranged in the Inspector window.

4. Specify the sort direction for each row in "Sort by".

5. Specify the sort order in "Sort order" by assigning values from 1 to 4.
 

  Note

The sort function is only active if the alarm statistics view contains no more than four 
columns.
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Result
In Runtime, the operator clicks the  button in the alarm view to view the "Alarm statistics".

 

 Note

Alarms that have the "acknowledged" and "outgoing" states are only used for the calculation 
if a suitable alarm with "incoming" state was found in the amount of the result .

If you acknowledge an alarm with single acknowledgment or dual acknowledgment only once, 
the "Incoming/First Acknowledgement" and "Outgoing/Second Acknowledgement" alarm 
states are used for the statistical calculation.

If there is an alarm pending at the PLC and Runtime is disabled and enabled several times, 
the alarm is entered several times in the log with "incoming" status. The alarm will also be 
included multiple times in the evaluation. 

 

Configuring Alarm Display Suppression

Overview of Alarm Display Suppression

Introduction                 
Suppress the display of alarms to avoid an excessive burden of information for the plant 
operator. If only selected alarms are shown, the operator will concentrate his attention on 
essential alarms.
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Methods for suppressing alarm displays 
There are two options for suppressing the display of incoming alarms: 

● Automatic display suppression
The alarms are displayed in line with the specific plant status. You can enter these plant 
states as display suppression masks in each alarm. The design engineer specifies the 
values for the plant states. 
To transfer the current plant status to the alarm system, create an alarm group with a display 
suppression tag. This display suppression tag returns the value of the plant states. 
Assign this alarm group the alarms that the system does not display in Runtime at specific 
plant states. 
Example:
In the "Shutdown" plant status you want to suppress the display of alarms that normally 
occur in this status. The "Online connection to the PLC was dropped" alarm will only not 
be displayed during "Shutdown".

 

  Note

If you have specified a display suppression mask for an alarm that is not assigned to an 
alarm group, this alarm will not be suppressed in Runtime.

Alarms with display suppression masks that are not allocated to any alarm group will not 
be suppressed in Runtime. To suppress the display of specific alarms in Runtime, you 
always have to assign these to an alarm group.

 

  Note

You only use display suppression tags only for custom alarm groups.
 

● Manual display suppression
To suppress the display of an alarm in Runtime, the operator can click the  button in 
the alarm view. 
He can view the alarm once again by clicking the  button. 
The system displays the alarms again after a configurable time. 
To enable the reporting of manual display suppression, configure a corresponding user 
alarm that is triggered when the display is suppressed manually. Configure this user alarm 
in the alarm view as an operator input alarm for the "Suppress" operator action.

Properties of alarms whose display is suppressed
The following applies to alarms whose display is suppressed:

● In the following alarm view display modes, you can use the following buttons to show the 
alarms again:

– Display "Current alarms"

– Display "Historical alarm list" (short-term)

– Display "Historical alarm list" (long-term)

● The alarms are recorded and displayed under the "Hidden alarms" display.

● The alarms are also logged.

● If an alarm annunciator is set up for these alarms, it will not be triggered.
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Manual display suppression

The following properties apply only to alarms whose display is suppressed manually.

● The alarms are shown again after a set time.

● An alarm that requires acknowledgment is acknowledged by the manual suppression of its 
display.

● To enable the reporting of manual display suppression, configure a corresponding user 
alarm that is triggered when the display is suppressed manually.

Automatic display suppression

The following properties apply only to alarms whose display is suppressed automatically.

● The display suppression does not trigger an operator input alarm.

● The PLC acknowledges alarms that require acknowledgment.
In the time while alarms requiring acknowledgment are suppressed, the PLC acknowledges 
the outgoing alarms. If an alarm does not have the "Outgoing" status, the PLC 
acknowledges it immediately.

 

 
 WARNING

With automatic display suppression, alarms requiring acknowledgment no longer have to 
be acknowledged. You should therefore only use automatic display suppression for 
alarms that do not require operator actions during the configured plant states.

 

Interaction 
The two methods of suppressing alarm displays interact as follows:

● When an alarm is automatically suppressed, use the  and  buttons to show and 
hide the alarm as required.

● You have manually suppressed the display of an alarm using the  button.
When the plant status changes and the conditions for automatic suppression of this alarm 
display are not fulfilled, the alarm is displayed once more. 
The time defined as the display suppression duration must not have elapsed.

● You have suppressed the alarm by pressing the  button. The status that was defined 
for automatic display suppression using the display suppression tags occurs. After the 
specified display suppression timeout was triggered, the alarm nevertheless remains 
suppressed.

See also
Tags of an alarm group (Page 3908)
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Setting the Display Suppression Timeout

Introduction
You can set the time after which manually-suppressed alarms should be automatically 
displayed once more in the alarm settings.

Requirements
● The project navigator is open.

Procedure   
To set the alarm display suppression timeout, follow these steps:

1. Double-click "Runtime settings > Alarms" in the project navigation.
The alarm settings open.

2. Select "General > Display suppression timeout" to configure the period during which a 
manually suppressed alarm remains hidden.
30 minutes are preset.
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See also
Configuring Automatic Display Suppression (Page 3988)

Configuring Automatic Display Suppression

Introduction
With automatic display suppression, the alarm is displayed in relation to the status of the PLC. 
You define the plant status that causes an alarm to be hidden. Configure automatic display 
suppression using the "HMI alarms" editor.You will need to create an alarm group with a 
displace suppression tag. In the alarm, you assign the plant statuses using the display 
suppression mask. The display suppression tag must assume the value of the display 
suppression mask for an alarm so that it is not displayed in Runtime.

Requirements
● The "HMI alarms" editor is open.

● The "Alarm groups" tab is selected.

● Alarms are set up.

● The display suppression tag must exist.

Creasing an alarm group for display suppression
1. Double-click "Add" in the table.

A new alarm group is created.

2. Enter a name for the new alarm group.

3. Select the display suppression tag under "Tags" in the Inspector window.
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Creating a display suppression mask for the alarm
1. Select the alarm.

2. To select the alarm group for which you created the alarm suppression tag, select 
"Properties > Properties > General" in the Inspector window.

3. To enter the display suppression mask, select "Properties > Properties > Display 
suppression" in the Inspector window.
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Result
The alarm is hidden when the value set in the display suppression mask is activated at the 
display suppression tag.This means that the alarm is hidden when the plant is in the specified 
status.

 

 Note

Alarms with display suppression masks that are not allocated to any alarm group will not be 
suppressed in Runtime. You should therefore always assign alarms to an alarm group if you 
want to suppress them.

If an alarm is hidden, it can be shown once more in Runtime by clicking the  button. 
 

See also
Setting the Display Suppression Timeout (Page 3987)

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
3990 System Manual, 02/2014



Configuring Alarm Alerts

Introduction
In addition to the alarm view, WinCC also supports alarm indication in the plant by means of 
visual or audible signals. The alarm annunciator can be a horn or a warning lamp, for example. 
You can also display and acknowledge the alarm annunciator in a screen.

Requirements
● The "HMI alarms" editor is open.

● Alarms are set up.

● The Inspector window is open.

● Your plant is equipped with an alarm annunciator which is connected to a tag.

Configuring alarms for the alarm annunciator
1. Select the alarm that you want to display using an alarm annunciator.

2. In the Inspector window, select "Properties > Alarm annunciator".

3. In the "Alarm classes" tab, select the alarm class of the alarms for the alarm annunciator.

– To acknowledge the alarm annunciator via the button  of the alarm view, activate 
"Acknowledge > Alarm annunciator > By means of "Acknowledge central annunciator" 
button" in the Inspector window.
Use the  button to switch the alarm annunciator off. The alarm is still pending in 
the alarm view. 

– To acknowledge the alarm via the alarm annunciator, select the tag to which the alarm 
annunciator is connected. 

Configuring alarm annunciator in the screen
1. Open the screen in which you display the alarm annunciator.

2. For example, configure a circle and an associated button with the label "Alarm annunciator".

3. At the event "Click", configure the button that runs a VBS script with the method "QuitHorn".

4. Dynamize the background color of the circle with the tag to which the alarm annunciator is 
connected.

Result
If an alarm is displayed with the alarm annunciator in Runtime, the user acknowledges the 
alarm as follows depending on its configuration:

● Using an  button in the alarm view

● Using the configured "Alarm annunciator" button
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The user can recognize the status of the alarm annunciator from the background color of the 
circle. 

See also
Configuring acknowledgment of the alarm annunciator (Page 4004)

Displaying logged alarms

Introduction
An alarm view displays logged alarms in Runtime according to the configuration. The alarm 
view displays alarms from the log in the "Historical alarm list" (short-term) or "Historical alarm 
list" (long-term) display. The "Historical alarm list" (short-term) also displays the current alarms.

Requirement
● The logged alarms are located on the local log server.

● The screen with the configured alarm view is open.

● The Inspector window is open.

Procedure             
Proceed as follows to configure an "Historical alarm list" (short-term) or "Historical alarm list" 
(long-term) display:

1. Select the alarm view.

2. Select "Properties > Properties > General > Active list > "Historical alarm list" (short-term) 
or "Historical alarm list" (long-term) in the Inspector window.

3. Configure the alarm view similar to an alarm view for active alarms.

Result
In Runtime, you can view logged alarms using the "Historical alarm list" (short-term)  or 
"Historical alarm list" (long-term)  buttons. To visualize only alarms of the "Errors" alarm 
class or alarms at certain plant areas, you can filter or sort the logged alarms.

 

 Note

In the "Historical alarm list" (short-term) display, the new incoming alarms are updated 
immediately. In the "Historical alarm list" (long-term), on the other hand, they are not. You 
cannot enter or view comments in the "Historical alarm list" (short-term). Comments can only 
be entered in the "Historical alarm list" (long-term). 
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Configuring alarm export

Introduction
To export alarms to a "*.csv" file in Runtime, the operator clicks on the  button in the alarm 
view.You can configure this function in the alarm view in the "Screens" editor. 

Requirements
● The screen with the configured alarm view is open.

● The Inspector window is open.

Procedure
To configure the export of alarms, proceed as follows:

1. Select the alarm view and configure data export by selecting "Properties > Properties > 
Data export" in the Inspector window.

– You can specify a custom file name and folder.

– At "Scope", specify the data to be exported from the alarm view.

– at "CSV format", specify the separator to use in the ".csv" file.

2. Select "Operator input in Runtime" to configure the function of the  button in Runtime:

– Select "Display dialog" to open the "Default settings data export" dialog. 

– To export the data directly to the specified export file, disable "Display dialog".

3. Additionally, select "Operator input in Runtime" to specify whether or not the operator is 
allowed to rename the file and/or change the folder in Runtime.

Configuring alarm evaluation in Runtime

Introduction
To enable evaluation of the alarms in Runtime, assign a custom C function to the "Status 
changed" event of an alarm. Edit the function to suit your requirements for evaluation in 
Runtime.

Requirement
● The "HMI alarms" editor is open.

● A custom function for reading the data has been created.
This function must contain a pointer to a string whose data is mapped by scanf to the 
"MSG_RTDATA_STRUCT" structure.
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Procedure   
To configure the evaluation of an alarm in Runtime, proceed as follows:

1. Select the alarm.

2. In the Inspector window, select "Properties > Events > Status changed".

3. Select the custom function for reading the data.

The alarm data is read in Runtime. Alarm data includes,for example, the alarm number, 
time stamp, and alarm state. 

4. In the "Scripts" editor, configure evaluation of the alarm data within the function.

Result
When the alarm state changes, the alarm data is read in Runtime and evaluated according to 
your configuration.

Example
Use the following, user-defined function "state" to read the status of alarms, for example:
Void state (MSG_RTDATA_STRUCT Parameter)
DWORD state;
state = Parameter.dwMsgState;
printf("Status: %d\r\n", state);
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Reporting Alarms

Configuring reporting of alarms

Overview
WinCC can report on all alarms that occur in the system. The following options are available:

● Output an alarm sequence report
In Runtime, the standard printer of the HMI device will continuously print each alarm and 
any changes in its status.

● Output of an alarm report
You configure an alarm report in the "Reports" editor and specify when it is output in 
Runtime: 

– For event-driven output, configure an object that is assigned the "PrintReport" system 
function. The object can be a button or tag.

– For time-driven output, create a "Print job" in the scheduler. Assign an alarm report to 
the job.

 

  Note

In the alarm report, specify whether to output current or logged alarms. 
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Requirements
● A printer was configured on the HMI device.

Activating continuous alarm reporting   
To activate continuous reporting of alarms, follow these steps:

1. Double-click "Runtime settings" in the project navigation.

2. Select "Alarms > General > Report".

Result
The latest alarms are output at the printer of the HMI device. 
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Excluding an alarm from reporting
To exclude specific alarms from reporting, proceed as follows:

1. Open the "HMI alarms" editor.

2. Select the alarm to exclude from reporting on the tab of the selected alarm type.

3. In the Inspector window, disable "Properties > Properties > Miscellaneous > Report".

Result
WinCC does not output these alarms currently on the connected printer. 

See also
Working with reports (Page 4299)

Principles for preparation of reports (Page 4299)

Create a report  (Page 4306)

Report output in Runtime Advanced (Page 4320)

Alarm report (Page 4361)

Configuring reporting of alarms

Overview    
WinCC logs all system alarms as required.The following options are available:

● Output the current display in an alarm view
You can print out a system report. You can also create a custom report, if necessary.In the 
print job, specify the print scope, page area, printer, or target file.

● Output an alarm sequence report
In Runtime, every alarm is continuously output at a printer. 

Requirements
● The "Screens" editor is open.

● Alarms are configured.

● You configured an alarm view with "Print current view"  button.
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Procedure
To configure the outputting of the current display in an alarm view using your own report, 
proceed as follows:

1. Select the required alarm view.

2. To select the print job, select "Properties > Properties > General > Print > Print job" in the 
Inspector window.
The default print job is the system print job. You can also select a customized print job, or 
a modified system print job.

Result
If the user clicks the  button in Runtime, the selected report with the alarms currently 
displayed in the alarm view is output to the printer. 

 

 Note
Printer settings

Configure the printer in the HMI device's Control Panel. The settings will depend on which 
operating system is used on the HMI device. 

For more detailed information, refer to the operating instructions for your HMI device. 
 

See also
Working with reports (Page 4299)

10.3.2.4 Configuring acknowledgment

Configuring alarm acknowledgment by means of alarm class

Introduction
To configure an alarm with alarm acknowledgment, assign it to an alarm class with the "Alarm 
with single acknowledgment" acknowledgment model. 

Requirement   
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.
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Selecting the acknowledgment model for an alarm class
The acknowledgment model for a predefined alarm class has already been set. You can only 
set the acknowledgment model for user-defined alarm classes. Proceed as follows:

1. In the "HMI alarms" editor, click the "Alarm class" tab and select the alarm class.

2. Select the required acknowledgment model under "Properties > Properties > 
Acknowledgment" in the Inspector window.

Assign alarms to an alarm class requiring acknowledgment
Proceed as follows to assign an alarm to an alarm class requiring acknowledgment.

1. In the "HMI alarms" editor, click the tab for the alarm type and select the alarm.

2. Under "Properties > Properties > General" in the Inspector window, select the alarm class 
of the alarm.

Result
The alarm will not disappear in Runtime until it is acknowledged by the operator.

Configuring trigger for alarm acknowledgment

Introduction
You always specify the acknowledgment requirement for an alarm using the alarm class. Then 
the operator acknowledges the alarm using the "ACK" function key of the HMI device or the 
"Acknowledgment" button of the alarm view. 

The following options are also available to trigger acknowledgment:

● Configuring a button to acknowledge an alarm

● Acknowledgment of a Discrete Alarm by the PLC

Requirements     
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.

● An alarm view and a button are created in the "Screens" editor.
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Configuring a button to acknowledge an alarm
To configure a button for acknowledging an alarm, proceed as follows:

1. Select the button in the "Screens" editor.

2. Under "Properties > Events" in the Inspector window, assign the 
"AlarmViewAcknowledgeAlarm" system function to the "Click" event.

3. Select the alarm view as parameter.

Acknowledgment of a Discrete Alarm by the PLC
1. In the "HMI alarms" editor, click the "Discrete alarm" tab and select the discrete alarm.

2. In the Inspector window, select the tag and the bit that acknowledges the PLC alarm under 
"Properties > Properties > Acknowledgment > PLC".

Acknowledging alarms in an alarm group
The various acknowledgment options have the following effect in alarm groups: 

● Operator acknowledges the alarm
You acknowledge the alarm of an alarm group, for example, using the <ACK> 
acknowledgment key or a function key. All alarms of the alarm group are acknowledged.

● The PLC acknowledges the alarm
The alarm of an alarm group is acknowledged by setting a bit in the tag.
Only the alarm to be acknowledged is acknowledged.

See also
Working with screens (Page 3306)
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Sending alarm acknowledgments to the PLC

Requirement     
● The "HMI alarms" editor is open.

● The required alarm has been created and assigned to an alarm class requiring 
acknowledgment.

 

  Note

You cannot send the acknowledgment of analog alarms to the PLC. 
 

Sending alarm acknowledgments to the PLC
To configure that acknowledgment of an alarm is sent to the PLC, follow these steps:

1. In the "HMI alarms" editor, click the "Discrete alarm" tab and select the discrete alarm.

2. In the Inspector window, select "Properties > Properties > Acknowledgment".

3. Under "HMI", select the tag and the bit set by the alarm acknowledgment function.
 

  Note

The HMI device and PLC only have read access to the acknowledgment tag memory area.
 

Result
If the operator acknowledges the alarm in Runtime, the operating step is forwarded to the PLC.

10.3.2.5 Configuring acknowledgment

Configuring alarm acknowledgment

Introduction
The alarm classes define how the alarms from an alarm class are to be acknowledged. When 
you assign an alarm to an alarm class, you define the acknowledgement model for that alarm.

Requirements
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created.
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Procedure
To configure the acknowledgement of an alarm, follow these steps:

1. In the "HMI alarms" editor, click the "Alarm class" tab and select the alarm class.

2. To select the acknowledgment model, select "Properties > Properties > Acknowledgment 
> Settings" in the Inspector window.

– If you enable "Assign comment to defined user", this Runtime user writes a comment 
on the alarm acknowledgment that is written to the log file alongside with the alarm.

– If you enable "Use comment of the incoming alarm", the same comment is attached to 
each status change of this alarm as the one assigned for the "incoming" alarm event.

3. In the "HMI alarms" editor, select the alarm.

4. Select "Properties > Properties > General" in the Inspector window to select the alarm class 
of the alarm.

5. Select "Properties > Properties > Acknowledgement > Settings" in the Inspector window to 
specify the acknowledgment tag to which the alarm acknowledgment is saved, including 
the bit set for this purpose.

6. To exclude the alarm from the group acknowledgment of the alarm view, enable "Single 
acknowledgment".

Acknowledging an alarm via a system function
1. In the "HMI alarms" editor, select the alarm.

2. In the Inspector window, click "Properties > Events > Incoming".
The function list opens.

3. In the "Function list" dialog, assign the "SetBit" system function to the "Incoming" event.

4. Enter the acknowledgment tag of the "BOOL" data type as the "Tag (In/Out)" parameter.
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Configuring display and control objects for alarm acknowledgment
1. Select the button or function key.

2. Assign the "AcknowledgeAlarm" system function to the "Click" event.

See also
Working with screens (Page 3306)

Configuring alarm group acknowledgment

Introduction
You acknowledge an alarm group using the acknowledgment tag. To set and reset the 
acknowledgment bit, configure a display and operating element. 

Requirements
● The "HMI alarms" editor is open.

● You have created the alarm groups.

● The required alarm has been created.

Procedure
To configure the acknowledgement of an alarm group, follow these steps:

1. In the "HMI alarms" editor, select the alarm.

2. Under "Properties > Properties > General" in the Inspector window, select the alarm group 
to which the alarm belongs.

3. Click the "Alarm groups" tab in the "HMI alarms" editor.

4. Select the alarm group.

5. Under "Properties > Properties > Tags > Settings" in the Inspector window, select the 
acknowledgment tag and acknowledgment bit.

6. Open the "Screens" editor and configure a button that sets the acknowledgment bit in 
Runtime for the acknowledgment tag. 

Result
The user monitors the alarms for a given function together in Runtime. If a user identifies the 
cause of a fault, then he or she can acknowledge all alarms for this function using the 
configured operator action. 
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Configuring acknowledgment of the alarm annunciator

Introduction
In addition to the alarm view, WinCC also supports alarm indication in the plant by means of 
visual or audible signals. The alarm annunciator can be a horn or a warning lamp, for example. 
You can acknowledge the alarm annunciator in the following ways:

● Using the  button in the alarm view
This "Acknowledge alarm annunciator" button must be configured in the alarm view. The 
button is always active, even if another option for acknowledging the alarm annunciator 
has been enabled. Use the  button to switch the alarm annunciator off. The alarm is 
still pending in the alarm view. 

● Using a single acknowledgment
You acknowledge the alarm annunciator with the alarm that triggered the alarm 
annunciator. The operator acknowledges an individual alarm by clicking the  "Single 
acknowledgment" button in the alarm view.

● Using a tag
The specified tag is used to control the alarm annunciator.
To acknowledge the alarm annunciator, e.g. with a button, use this option.

Requirements
● The "HMI alarms" editor is open.

● The required alarm class has been created.

● The required alarm has been created, and assigned to the alarm class.

Procedure
To configure the acknowledgment of an alarm annunciator, proceed as follows:

1. Click the "Alarm classes" tab in the "HMI alarms" editor.

2. Select the required alarm class.

3. In the Inspector window, select "Properties > Properties > Acknowledgment > Alarm 
annunciator" to specify how to acknowledge the alarm annunciator.

Result
The operator acknowledges the alarm annunciator in Runtime as specified for the alarm class 
of this alarm. 

Configuring the Group Acknowledgement of Alarms

Introduction
You can use the  button in the alarm view to acknowledge all pending, and visible alarms 
that must be acknowledged in the alarm view. You can exclude individual alarms from group 
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acknowledgment.After group acknowledgment was triggered, the excluded alarms are still 
pending.

Requirement
● A screen is open.

● An alarm view has been created.

Procedure
To set up a group acknowledgement, follow these steps:

1. Open the "Screens" editor, and select the relevant alarm view.

2. In the Inspector window, select "Properties Properties > Toolbar - Buttons > Group 
acknowledgment."
The  button appears in the alarm view. All alarms of an alarm view that are not excluded 
from group acknowledgment are acknowledged when the operator actuates this button.

Configuring a single acknowledgement
1. Open the "HMI alarms" editor and select the tab that contains the relevant alarm type.

2. Select the alarm that you want to exclude from the group acknowledgement.

3. Enable "Properties > Properties > Acknowledgment > Single acknowledgment" in the 
Inspector window.
When you acknowledge all the alarms in an alarm view using the  button, any alarms 
for which the "Single acknowledgement" option is enabled will be excluded. The operator 
acknowledges alarms with "single acknowledgment" option individually.

Configuring the Resetting of the Acknowledgment Bit for Acknowledgment Tags

Introduction    
The operator, or the PLC, resets the acknowledgment bit for acknowledgment tags.The 
acknowledgment bit is reset directly in the PLC or in WinCC Runtime via a script, for example. 
The acknowledgment bit is not automatically reset. 

Resetting of the acknowledgment bit by the PLC 
You can use an external tag as an acknowledgment tag to allow the PLC to reset the 
acknowledgment bit. 

If the alarm is acknowledged in Runtime in WinCC, the defined acknowledgment bit is set in 
the PLC. In the PLC, the acknowledgment bit is processed as required before it is reset once 
more.

In the PLC, an alarm is triggered by a reusable function block or by functions. In this block the 
alarm can also be acknowledged or the acknowledgment bit reset.

Evaluation and resetting of the acknowledgment bit by the PLC has the following advantage:
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It is easy to cause the acknowledgement with external signals, such as pushbutton units in the 
field. 

You can acknowledge externally and via the alarm view. Both methods use the same bit in the 
automation system for acknowledgement.

 

 Note

To ensure that the alarm view in WinCC reliably acquires the external acknowledgement in 
time, configure the resetting by the automation system with a time delay.

 

Resetting of the acknowledgment bit by the WinCC
If you want to acknowledge an alarm via the acknowledgment tag only, reset the 
acknowledgment bit immediately as soon as it is set. 

If you acknowledge an alarm via the alarm view, configure the resetting of the acknowledgment 
tags separately.

You can reset the acknowledgment bit in the following ways in WinCC:

● Button
You can reset the acknowledgment bit using a button. 

● System function
Use the "ResetBitInTag" system function. If the acknowledgment bit is set, it will be 
immediately reset. 

 

  Note

If the acknowledgment tag is of the "BOOL" data type, use the "ResetBit" system function.
 

  Note

If lots of alarms are processed using scripts, this places a heavy load on the work memory. 
The acknowledgment bit should therefore ideally be reset by the PLC. 

 

10.3.2.6 Configuring alarm buffer overflow

Introduction
The size of the alarm buffer depends on the type of HMI device. In WinCC, specify the 
percentage of the alarm buffer to be deleted on alarm buffer overflow.  
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Requirements
● You have created a project.

Procedure
To configure the response to an alarm buffer overflow, follow these steps:

1. Double-click "Runtime settings" in the project navigation under your HMI device.

2. Under "Alarms > General > Buffer clearance in percent upon buffer overflow", enter a value 
between 1 and 100.
This value specifies the percentage of the alarm buffer that is deleted on alarm buffer 
overflow.    

Result
If data in the alarm buffer exceeds the resources of alarm buffer memory, the configured 
percentage of data will be deleted from the oldest alarms in the alarm buffer.

 

 Note

You cannot check the alarm buffer overflow separately by alarm method. You can use the 
"ClearAlarmBuffer" system function to delete specific alarms of specific alarm classes from 
the alarm buffer. 

 

See also
Working with Logs (Page 4155)

10.3.3 Alarm Logging

10.3.3.1 Configuring alarm logging

Basics on alarm logging

Introduction
An alarm log is used to record project alarms.  

 

 Note

Alarm logging is not available for every HMI device.
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Configuration steps
To log an alarm, follow these configuration steps:

1. Creating an alarm log  
You define the following properties for the alarm log:

– Logging method
Behavior of the log when reaching a specific fill level

– Storage location and file format

– Log size

– Runtime start characteristics

– Checksum

2. Assigning an alarm log to an alarm class
You can log the alarms from multiple alarm classes in an alarm log.

3. Assigning an alarm to a loggable alarm class

4. Configure display of logged alarms in an alarm view

Content of the alarm log
All states are logged for configured alarms. The following three entries, for example, are stored 
in the log for an alarm that requires acknowledgment:

● 04.08.2007 10:00:25:520, analog alarm, ID5, K, error, fill level exceeded by 10 %

● 04.08.2007 10:01:20:442, analog alarm, ID5, Q, error, fill level exceeded by 10 %

● 04.08.2007 10:01:30:112, analog alarm, ID5, G, error, fill level exceeded by 10 %

In the example, the alarm states are identified by the following letters:

K = Incoming

Q = Acknowledged

G = Outgoing

All data belonging to an alarm is stored in the alarm log, including configuration data such as 
the alarm class, time stamp, and alarm text.

The potential number of logged alarms depends on the data medium used.
 

 Note

Alarm text and error location are only logged if you have configured such a setting in the log 
properties.

 

 Note

The time stamp of a logged alarm is always specified in standard UTC format (Universal Time 
Coordinated).
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Logging methods
The logging method determines how the alarm log responds when the configured size is 
reached. WinCC supports the following logging methods:   

● Circular log
When the configured log size has been reached, the oldest entries are deleted. When the 
configured log size has been reached, approximately 20% of the oldest entries are deleted. 
It is therefore not possible to display all the configured entries. During configuration, select 
an appropriate size for the circulation log. Alternatively, configure a segmented circular log.

● Segmented circular log
In a segmented circular log, multiple single logs of the same size are filled in succession. 
When all logs are completely full, the oldest log is overwritten.

● Log with level-dependent system alarm
When a defined level is reached, such as 90 %, a system alarm is triggered. When the 
configured size of the log has been reached, new alarm events are not logged.

● Log with level-dependent execution of system functions
When the log is completely full, the "Overflow" event is triggered. You configure a function 
list for the event. 
When the configured size of the log has been reached, new alarm events are not logged.

Checksums in regulated projects  
With WinCC you configure regulated projects as required by FDA guidelines, if necessary. Use 
the "Audit" option to create regulated projects. 

In regulated projects you supply a checksum for the logged data of an alarm log. The operator 
will use this checksum during operation of the plant to see if the data of an alarm log have 
been changed.

For the checksum to be clear, it starts with the first line of an alarm log and integrates the 
previous lines when continuously generating the checksum. This means a checksum can only 
be generated for the following logs:

● Log that sends a system alarm when it is full

● Log with execution of system functions when log is full.

Generation of a checksum is also available for alarm logs that are saved as files of the "*.csv" 
or "*.txt" (Unicode) format.

If you want to continue an existing log without checksum as one with checksum, a backup 
copy of the existing log is created in the "*.keep" file format. A new log with checksums is 
created.

To maintain the validity of checksums, the following limitations apply when using the system 
function "CopyLog":

● You cannot copy a log without checksums into a log with checksums.

● You cannot copy a log with checksums into a log without checksums.
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Storage location and storage medium   
You can save the log data to a file on a data carrier, e.g. MMC, SD, or CF cards. If you are 
using a PC as your HMI device, you may store your information in a database. You can further 
process the saved data in other programs for analysis purposes, for example.  

Displaying logged data
On the HMI device, the logged data is displayed in an alarm view that is configured for this 
purpose.   

See also
Working with Logs (Page 4155)

Storage locations for log files

Introduction
The alarm log is stored in an ODBC database or in a file. Select "Database" or "File" as the 
storage location. 

 

 Note

An "ODBC database" storage location is only available on a PC.
 

Log file
Depending on the configuration of the HMI device, select one of the following storage locations 
for the log file:

● Local hard disk of the PC

● Storage card of the Panel

● Network drive
 

  Note
Logging on network drives

Do not log alarms, tags and Audit Trail directly on a network drive. Power supply can be 
interrupted at any time. This means there is no guarantee for a reliable operation of logs 
and audit trails.

Save the logs on your local hard drive or a local storage card. Use the system function 
"ArchiveLogFile" to save the logs long-term on a network drive. This step ensures reliable 
operation.
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File - CSV (ASCII)
Data is saved to a "*.csv" file in standard ASCII format.

Use the "File - CSV (ASCII)" storage location if you are going to read logged data without using 
WinCC Runtime.

 

 Note

Double quotation marks or several characters are not permitted as list separator for the 
storage site "File - CSV (ASCII)." You can find the settings for list separators under "Start > 
Settings > Control Panel > Regional and Language Options."

 

File - TXT (Unicode)
The log data are saved in Unicode.

This file format supports all characters that can be used in WinCC and WinCC Runtime. For 
editing, use software that can save files in Unicode, such as Notepad.

 

 Note

Use "File - TXT (Unicode)" as the storage location to log Asian languages.
 

File - RDB
Data will be saved with quick access to a proprietary database. 

Use the "File - RDB" storage location if you require maximum read performance in Runtime. 

Data logs of this format can only be read and displayed using WinCC Runtime.

Convert the RDB file to CSV format using the "CopyLog" function to make the data available 
for applications outside WinCC Runtime.

Files of logs with checksums
● *.keep

This file is created in the following cases:

– A log is started without checksum and will be continued with a checksum.

– You update WinCC with a Service Pack or a new version. Writing of the Audit Trail or 
the log with checksum is continued.

The content of the "*.keep" file remains the same when compared with the original "*.csv" 
or *.txt" file. 

● *.bak
This file is created when WinCC Runtime has determined a serious, irregular problem in 
the file.
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Database
Data is saved to a database which is set up for ODBC access by the PC administrator. 

If you have selected an ODBC database as storage location, select one of the following options 
for naming:

● "User-defined name of data source"
You define the name of the data source.

● "System-defined name of data source",
The system defines the name.
You will need a special instance of Microsoft SQL Server on the target system in order to 
do this. Download the free SQL Server 2005 Express from the Internet for this purpose. 

 

  Note
Device dependency

This setting is not available on the Panel PC 477.
 

 

Create an alarm log

Introduction
In Runtime, you save alarms to the alarm logs. Specify the alarm log in the alarm class. An 
alarm log contains the alarms of several alarm classes. Create the alarm log in the "Logs" 
editor. When creating an alarm log, define the following parameters:

● Name

● Size

● Storage location

● Runtime start characteristics

● Log type

● Advanced content

● Checksum

You can also enter comments for each log. 

Requirement
● The "Alarm log" tab is open in the "Log" editor.

● The Inspector window is open.
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Procedure     
To create an alarm log, proceed as follows:

1. Double-click "<Add>" in the table.
A new alarm log is created.

2. Under "Properties > Properties > General" in the Inspector window, enter a unique name 
for the alarm log.

 

 Note

The log names must be unambiguous in a project. The name of a log must always be unique, 
regardless of whether different storage locations are selected for the log. 

 

 Note

The characters which can be used in the name of the data source depend on the storage 
location.

The characters \ / * ? : " < > | are not permitted for the following storage locations:
● File - RDB
● File - CSV (ASCII)
● File - TXT (Unicode)

If the "Database" storage location is used, the following characters may be used: a-z A-Z 0-9 
_ @ # $

The characters _ @ # $ cannot be used as the first character of a name.
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1. Under "Number of data records per log", define the number of alarms to be saved to a log 
file.
The approximate space required on the storage medium is displayed. Memory space 
requirements will increase accordingly if you log alarm texts with tag values. 

2. Under "Storage location", select a file, or an ODBC database.

– If you select a file, enter the corresponding path. Depending on the HMI device, save 
the log files to the hard disk of the PC, to the memory card of a panel, or to a network 
drive.
Different file formats are supported, depending on the HMI device.

– If you select a "Database" storage location, specify the following:
Specify whether the name of the data source is accepted by the system.
Specify whether to select the name of the data source yourself.
Enter a name for the database.
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1. To determine if audit trail data were changed at a later time, activate "Properties > 
Properties > General > Checksum".

 

  Note
Device dependency

The "Checksum" option is only available for display and HMI devices which support logs.
 

Configuring the behavior of the log when it reaches a specific fill level
1. Define how the log should behave when it is full under "Properties > Properties > Logging 

method".

– Specify the number of logs for the "Segmented circular log" log type.

– For the "Display system event on" log type, specify the fill level triggering the system 
event.

– If you selected the "Trigger event" log version, configure a function list under "Properties 
> Events > Overflow". The function list will be processed when the log is full.

2. Under "Properties > Properties > Archiving method > Settings", specify whether to log the 
alarm text and fault location.
Logged alarms that contain alarm text and the fault location exceed the estimated size of 
the configured alarms. Check to see whether the specified specified storage location still 
has sufficient space.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4015



Configuring the behavior of the log when Runtime starts
1. Select "Properties > Properties > Start behavior> Type".

– Define whether to start the log automatically at the start of Runtime.

– To overwrite logged data with new data, activate "Reset log".

– To add the logged data to an existing log, activate "Continue log".
 

  Note

Use system functions to control the restart of a log in Runtime.
 

Configuring a comment
To record a text to document your configuration of a log, follow these steps: 

1. Enter your text under "Properties > Properties > Comment".

Result
The alarm log is created. You can assign one or several alarm classes to this alarm log. 

See also
Logging alarms (Page 4016)

Working with Logs (Page 4155)

Logging alarms

Overview
To log alarms, follow these steps:

● Create an alarm log.

● Assign the created alarm log to an alarm class.

● Assign the alarm class with the created alarm log to an alarm.
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● In the Runtime settings specify the language in which you want to write the logs.

● You evaluate logged alarms.
You can analyze the logged alarms directly in your WinCC project, such as in an alarm 
view, or in another user program, such as Microsoft Excel.

 

  Note
Tag fields in the alarm text

The sequence of tag fields in the alarm text is language dependent. The sequence of the 
Runtime language is used for logging alarms to a "*.csv" log file.

Changing the tag of an output field in one language causes the modified output field to 
appear at the end of the alarm text in all other languages. This means the sequence of 
the output fields in the log file can change.

 

Requirements
● You have created an alarm log.

● The "HMI alarms" editor is open.

Assigning an alarm log to an alarm class
To assign the alarm log to an alarm class, proceed as follows:

1. Open the "Alarm classes" tab in the "HMI alarms" editor.

2. Select the required alarm class.

3. Under "Properties > Properties > General  > Log" in the Inspector window, select the alarm 
log.

Assign alarm to an alarm class
To assign an alarm to the alarm class, proceed as follows:

1. In the "HMI alarms" editor, open the "Analog alarms" tab, or the "Discrete alarms" tab.

2. Select the required alarm.

3. Under "Properties > Properties > General > Alarm class" in the Inspection window, select 
the alarm class for which the alarm log was configured.

Result
The alarm is saved to the configured alarm log. 

See also
Working with Logs (Page 4155)

Create an alarm log (Page 4012)
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Configuring an alarm view for logged alarms

Introduction
In Runtime, logged alarms are displayed in an alarm view or alarm window.

Requirements
● An alarm view or alarm window is configured in the "Screens" editor

● An alarm log was created in the "Log" editor.

● The alarms are assigned the "loggable" attribute in the "HMI alarms" editor.

Configuring an alarm view for logged alarms   
To configure an alarm view for logged alarms, proceed as follows:

1. Open the screen with the alarm view and select the alarm view.

2. In the Inspector window, select "Properties > Properties > General > Alarm log".

3. Click the "...." button and select the alarm log.

4. Continue to configure the alarm view as for the display of current alarms.

Result
In Runtime, the logged alarms are output in the alarm view. 

Direct access to the ODBC log database

Overview
The storage location of a log can be a database or a file.  

The database is addressed by means of its "Data source name" (DSN). Select the database 
to be used in WinCC as follows:

Select the database from the Windows Start menu under "Settings > Control panel > ODBC 
Data Sources".

In your configuration, specify the "Data source name" (DSN) instead of a directory name as 
storage path for log data. With the DSN, you are referencing the database and the storage 
location.

The entire functional scope of the database is available for additional processing and 
evaluation of log data.
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Application
The data source sets up the connection to the database. Create the data source on the same 
PC on which the Runtime software is stored. Then enter the DSN configured on this PC when 
you create a log in WinCC. 

The ODBC interface allows you to use other programs, such as MS Access or MS SQL Server, 
to access the database directly.

In addition, you can use the "StartProgram" system function to configure program calls, e.g. 
MS Access, on the HMI device. Runtime is not interrupted while you configure such calls. 

Setting up the ODBC data source

Introduction
To store process values or alarms in the log database in Runtime, set up the ODBC data 
source.

Requirement
● A log database has been created. 

You create the log database using the SQL Enterprise Manager. You can find more detailed 
information on how to do this from Microsoft.

Procedure
To set up an ODBC data source, follow these steps:

1. In Control Panel, open "Administrative Tools" and select "Data Sources (ODBC)".
The "ODBC Data Source Administrator" dialog is opened. 

2. Click "User DSN > Add".

3. Select the "SQL-Server and click on "Finish". 

4. In the dialog that follows, enter a name for the User DSN and the SQL-Server  and click on 
"Next".

5. In the dialog that follows, define the logon procedure for the SQL database and click on 
"Next".

6. Activate "Change the default database to". 

7. Select the database you have created and click on "Next".

8. In the dialog that follows, click "Finish".
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Configuring a checksum for a log

Introduction
In a regulated project, you have the option of assigning a checksum to the log data of an data 
log or alarm log. This checksum can be used during plant operation to determine if the data 
of this log has subsequently changed. 

Requirement
● GMP compliant configuration is enabled.

● A data log or alarm log has been created.

Procedure
Proceed as follows to configure a data log or alarm log for the use of a checksum:

1. Open the data log or alarm log in the corresponding log editor.

2. In the "Storage location" box, select "File - CSV (ASCII)" or "File - TXT (Unicode)".

3. Under "Properties > Properties > Logging method" in the Inspector window , select the 
option "Display system event at" or "Trigger event".

4. In the editor table activate the option "Activate checksum".
Columns that are not displayed are activated with the shortcut menu of the column title.

5. Save the project.
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Result
The log data of the log is assigned a checksum in runtime.

See also
GMP-compliant configuration (Page 7228)

Enabling GMP compliant configuration (Page 7231)

Evaluating the checksum of log data

Introduction
If you have configured a data log or alarm log with generation of a checksum, you can check 
if the log data has subsequently changed.

The DOS program "HmiCheckLogIntegrity" is available for checking the integrity of the log 
data.

The "HmiCheckLogIntegrity" program supports verification of the following files:

● Log files of alarm logs, data logs, and Audit in CSV format

● Log files of alarm logs, data logs, and Audit  in TXT format

● Recipe data records in CSV format

● Recipe data records in TXT format

You can find the "HmiCheckLogIntegrity.exe" program in the installation directory of WinCC 
under the folder "WinCC Runtime Advanced", for example <C:\Program Files\Siemens
\Automation WinCC Runtime Advanced>.

 

 Note
Audit Trail and Log with Checksum

Before you update WinCC with a Service Pack or a new version, exit and save the Audit Trail 
or the logs using checksum. After WinCC is updated, the audit trail or logs will be continued 
with new files using checksum. 

Make sure that the logs are started at a defined state with the new version.      
 

Procedure
1. Copy the file to be checked from the HMI device to your configuration computer.

2. Open a command line prompt with "Start > Programs > Accessories > Command Prompt".

3. Enter the path to "HmiCheckLogIntegrity.exe" followed by a space in the command line 
prompt. After the space, enter the storage location of the file to be checked within quotation 
marks.
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4. Press <Enter>.

5. The check is performed.
When the checked data are consistent, the "Consistency check succeeded" message 
appears.

When the checked data are inconsistent, the "Consistency check failed" message appears. 
Information about the first inconsistent line in the file is also displayed.

 

 Note

If there are spaces in the path to the "HmiCheckLogIntegrity.exe" program, you need to 
specify the path in quotation marks.

 

You can also check the integrity of the log data with the AuditViewer.

See also
Enabling GMP compliant configuration (Page 7231)

Evaluating Audit Trails in AuditViewer (Page 7249)

Log response to language switching in runtime

Introduction
In the Runtime settings of your HMI device, select the language to be used for writing to logs 
in runtime.       
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Requirement
● The languages used in your project are activated in the "Project languages" editor, for 

example, "German (Germany)" and "English (USA)" .

Procedure
To determine the startup language, follow these steps:   

1. Select "Runtime settings > Language and fonts" in the project navigation.

2. Activate the runtime language, for example, "German (Germany)" and "English (USA)".

3. Set the "Language switch order". Use 0 to determine the startup language, for example:

– German 0.

– English 1
With "0", German is specified as the "Startup language".

4. Select "Runtime settings > General" in the project navigation.

5. Select the "Logs > Logging language > Startup language".

Result
The project starts after it is transferred. German is specified as the "Startup language" with 
"Language switch order". The logs are now written in German. During runtime, the operator 
switches the runtime language to English. The logs will still to be written in German.

The operator closes runtime. Due to the previously performed language switch, the next time 
the system starts the "startup language" is English. Since English is the startup language, the 
logs are now written in English.

The logging language remains English even when the language is switched again in runtime 
until runtime is closed once again.

If you use another option instead of "Startup language" to select the language, the logs are 
always written in the same language. This is true regardless of the language selected by the 
operator in runtime. 

10.3.3.2 Configuring alarm logging

Basics on alarm logging

Introduction
An alarm log is used to record project alarms.Alarm logs are created by the system. For 
example, after an error has occurred, or a limit was exceeded in Runtime, the corresponding 
alarm you configured in the "HMI alarms" editor is output in Runtime.Each alarm event is 
logged, e.g., the transition of the alarm from "incoming" to "acknowledged" status.

You can store the alarm events in a log database and/or log them to hardcopy in an alarm 
report. You can output the alarms stored in the database in Runtime, for example, in an alarm 
view.
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The logged alarms are stored in a circular log that consists of multiple single segments. The 
size of all the segments and of an individual segment is defined under "Alarm log" in the log 
settings. 

You should configure backups to save the data at regular intervals.   

Configuration steps
To log an alarm, follow these configuration steps:

1. Configuring "Log settings"
You define the settings for the alarm logging in the log settings.

2. Enable alarm logging
You specify that alarms of particular alarm classes will be logged.

3. Assigning an alarm to a loggable alarm class

Content of the alarm log
The alarm logs are used to store all alarm data, including configuration data. You can read all 
alarm properties from the log files, e.g. the alarm class, the timestamp, and the alarm texts.A 
new log segment with the new configuration data is generated whenever you edit configuration 
data of an alarm. This function prevents any change from having an influence on alarms logged 
previously.

The possible number of logged alarms depends on the server used.
 

 Note

The time stamp of a logged alarm is always specified in standard UTC format (Universal Time 
Coordinated).

 

As alarm configuration is language-specific, the logs contain a configuration data table for each 
language configured.

Storage media and location
Log data are stored in a database. You can further process the saved data in other programs 
for analysis purposes, for example. 

Backup for log segments
Take backups of your log segments to ensure complete documentation of your process. You 
define the settings under "Log settings".  

Displaying logged data
You can view the logged data on the HMI device.Configure a corresponding alarm view that 
displays the log data, or use buttons to show the "Historical alarm list" (short-term), or the 
"Historical alarm list" (long-term) in Runtime.
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See also
Working with Logs (Page 4158)

Logging alarms

Introduction
Specify the size and time range for the alarm log segments in the log settings.By specifying 
their size, you also define the number of segments.

The segments are filled successively with data in Runtime.The next segment is used on 
overflow of a segment.You can also configure a time-dependent segment change.If you specify 
a time for the segment change, the next log segment is filled after this time was reached.

 

 Note

Ensure that the log size does not exceed memory resources. The log manager does not 
validate the selected settings.A large number of linked log segments might lead to longer 
waiting periods in the system during the startup and shutdown of Runtime.

 

Overview
To log alarms, follow these configuration steps:

● Configure the alarm log in the log settings.
Define the size and segmentation.

● Configure a loggable alarm class.

● Assign the alarm to a loggable alarm class.
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Requirements
● An alarm class has been created.

Configuring an alarm log
To configure the alarm log, proceed as follows:

1. Double-click "Runtime settings" in the project navigation.

2. Double-click "Logging" in the area navigator.
The alarm settings open.

3. Click "Properties > General" in the Inspector window and specify the following:

– Enter the values for "Time period of all segments" and "Maximum size of all segments".
Define the size of the log database by entering the accumulated time period for all 
segments and the maximum segment size.A new segment is started if either one of 
these criteria is exceeded. The oldest segment is overwritten after all segments were 
filled with data.

– Enter your values at "Time period covered by a single segment" and "Maximum size of 
a segment".
You include the size and number of single segments when entering the time period for 
single segments and their maximum size. A new single segment is started if either one 
of those conditions is exceeded. In addition, the oldest single segment is deleted after 
the criterion for "Time period of all segments" is exceeded.

– Select the date and time for the start of the first segment change at "Time of first segment 
change".
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The segment is changed even if the configured size is exceeded after Runtime starts. 
In this case, the oldest individual segment is also deleted.

Create alarm class with logging
To create an alarm class with logging, proceed as follows:

1. Open the "HMI alarms" editor.

2. Click the "Alarm Classes" tab.

3. Select the alarm class whose alarms are logged.

4. In the Inspector window, select "Properties > Properties > General > Settings > Alarm log".

5. Assign the alarm to be logged to this alarm class.

Example for the timing of the first segment change
A segment changes for the first time at 23:59 on January 17. The next time, the segment 
changes at the configured time in the cycle defined in "Time period contained in a single 
segment". If the cycle setting is "1 day", then the change will take place at 23:59 every day. If 
the cycle is set to "1 month", the segment will change at 23.59 on the 17th day of the next 
month. 

See also
Working with Logs (Page 4158)

Logging Settings (Page 3803)

Defining the Log Size and Segmentation (Page 3804)

Configuring the Alarm Log Backup

Principle          
Make regular backups of your log data to ensure complete documentation of your process.

 

 Note

The backup normally starts 15 minutes after the first time-related segment change. To start 
the backup and the segment synchronously with Runtime, define the time for the segment 
change before you start Runtime.

You can enter comments for alarms displayed in the alarm view in Runtime. If the log segment 
in which the alarm is stored has already been swapped out, the comment will not be accepted 
in the swapped-out log. The comment will only be in the local log segment.

If the archive segment has not yet been moved out, then the changed comment is accepted 
permanently.
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Requirement
● The settings for logging are open.

Procedure
To create a backup of the log segments, proceed as follows:

1. Double-click "Logging" in the area navigator.

2. Enable "Alarm log > Backup".

3. In the Inspector window, click "Properties > General > Settings Backup > Path".
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4. Click  and look for an existing folder in which to store the backup file. Use "Make New 
Folder" to create a new folder, if necessary. You can also use a network path as the storage 
location.

5. Activate "Backup" to generate a backup copy of logged data.
Also activate "Backup to both paths" if a backup copy of logged data is to be saved to the 
"Path" and to the "Alternative path" folders. 
You can also use a network path as the storage location.
If the "Backup to both paths" option is not enabled, the second backup file is used in the 
following situations:

– If the storage space on a backup medium is full.

– The original storage location is unavailable due to network failure, for example.

An alarm is output if a storage location was not found, provided you configured 
corresponding system alarms.

6. Activate the "Sign" check box if the backup file must be saved with signature.
When the connection to WinCC is reestablished, the signature is used to detect whether 
any changes have been made to a backup file since it was swapped out. 

 

  Note

The "Sign" option puts a load on the RAM. If you use log signing, the maximum size of a 
single segment must not exceed 200 MB.

 

Result
The log segment backup is stored in the specified location. 
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Structure of the Backup File
A backup file for an alarm log has the following structure:

● Extension
A log segment backup consists of two files in "*.LDF" and "*.MDF" format. To transfer a 
backup to another PC, simply copy both files.

● File name
The file name is in the following form: 
"<Computer_name>_<Project_name>_<Type>_<Time_from>_<Time_to>". 

Component Explanation Example
Computer name  FLEX-LOG2
Project ID The project ID is assigned by the 

system. Underscores are 
replaced with "#".

HMI#4ZQV

Type The type identification of the 
alarm log is "ALG" (Archive Log).

 

Time_from The time period is specified in 
yyyymmddhhmm format.

200812021118 for December 2, 
2008, 11:18.Time_to

Example of the complete file name of a backup file:
FLEX-LOG2_HMI#4ZQV_ALG_200811291414_200812030502.ldf

 

 Note
Assignment to project

The project name cannot be seen in the file name of the generated project ID.

To be able to allocate the backup files to the project, assign a path name to the storage 
location that contains the project name.

 

Signing the Backup File
If signing and backup are enabled, each log backup file is signed when swapped out. When 
the file is reconnected to WinCC, it is thus determined whether the file was changed after being 
swapped out. 

If you use log signing, the maximum size of a single segment must not exceed 200 MB.

The "Enable signing" check box must be enabled for data verification. When signing is enabled, 
it takes longer to link the log backup file to WinCC. Up to 500 values are logged per second.

 

 Note

If you disable signing off to establish a fast connection to the backup files, for example, you 
should avoid segment changes while it is disabled. After having closed the connection, re-
enable signing so that the data to be logged is assigned a signature.
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See also
Working with Logs (Page 4158)

Connecting and Disconnecting the Alarm Log Backup

Introduction     
To access the data in a swapped-out alarm log in Runtime, connect the log backup to the 
project. You can configure an automatic connection or connect the alarm log to the project via 
a script. The archived alarms are displayed in Runtime in the alarm view. 

If you no longer want to access the backup of a log segment in Runtime, disconnect the log 
backup from the project. 

Requirement
● The relevant backup files in "*. ldf" and "*.mdf" format are stored locally.

● The project is in Runtime.

Display Time Range
The alarms are only displayed in Runtime if the time window in the alarm view has been 
configured accordingly. 

Example
You have configured a time window to display only the alarms of the past 24 hours. If you 
connect to a log backup containing alarms that are older than 24 hours, these alarms are not 
included in the alarm view. 

Connecting to the alarm log automatically
To automatically connect to the alarm log backup, proceed as follows:

1. Insert the log backup files in the "RuntimeProjectPath\ProjectName\CommonArchiving" 
folder.

2. In Runtime, the alarm log is automatically connected to the project.

If signing is enabled, signed log backup files that are changed will not be connected 
automatically. A WinCC system alarm is generated and an entry is added to the Windows 
event log in the "Application" section. 

Connecting to the alarm log using a script
Using the "AlarmLogs" VBS object, you can link the log backup files to the project using a 
script. The log segments are then copied with the "Restore" VBS method to the Common 
Archiving folder of the Runtime project. For additional information, see the description of the 
"AlarmLogs" VBS object and the "Remove" VBS method.
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Automatically disconnecting the alarm log         
To automatically disconnect the alarm log backup from the project, proceed as follows:

1. Go to the folder "RuntimeProjectPath\ProjectName\CommonArchiving".

2. Remove the log backup files from the folder.

Disconnecting the alarm log using a script
Using the "AlarmLogs" VBS object, you can disconnect the log backup files from the project 
using a script. The log segments are then removed with the "Remove" VBS method from the 
Common Archiving folder of the Runtime project. For additional information, see the description 
of the "AlarmLogs" VBS object and the "Remove" VBS method.

Accessing the Log Database Directly with C-API/ODK

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also 
allow you to directly access the WinCC log databases. Using direct access you can, for 
example, read process values to process them further in spreadsheet programs.

Accessing the log database with C-API/ODK
You can use the "WinCC Open Development Kit" option to access WinCC data and functions 
via open application programmer interfaces. 

Additional information
You will find further information on this topic in the documentation for the WinCC Open 
Development Kit. 

Accessing the Log Database Directly with ADO/OLE DB 

Introduction
Various providers offer interfaces that you can use to access databases. These interfaces also 
allow you to directly access the WinCC log databases. Using direct access you can, for 
example, read process values to process them further in spreadsheet programs.

Accessing the log databases with ADO/OLE DB
Some process values are stored in the log databases in compressed format. Use the WinCC 
OLE DB Provider to access these compressed process values. For non-compressed data and 
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data from the alarm log, you can also use the Microsoft ADO/OLE DB interfaces, for example. 
You can use Visual Basic, Visual C++, etc., as the programming language. 

 

 Note

If you access the log database directly using ADO/OLE DB, remember that the log structure 
may be different in a new version of WinCC.

 

Additional information
You will find more detailed information on this topic on the Internet at:

msdn.microsoft.com (http://msdn.microsoft.com/en-us/library/default.aspx)

Configuring the Reloading of Alarms after a Power Failure

Introduction
Configure the reloading of alarms so that the most recent alarms are displayed in Runtime 
once more after a power failure. In the event of a power failure, the number of alarms that you 
configured is read from the alarm log. This allows the most recent process image to be 
reconstructed.   

Procedure
To define the number of alarms that are reloaded after a power failure, follow these steps:

1. Double-click "Runtime settings" in the project navigation under your HMI device.

2. Double-click "Alarms" in the area navigator.

3. Select "Properties > General > Number of alarm list entries after power failure" in the 
Inspector window to enter the number of alarms to be reloaded after power failure.

Result
After power failure, the number of alarms you configured is reloaded to the alarm view and 
displayed in Runtime.
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10.3.4 Using Alarms in Runtime

10.3.4.1 Alarms in Runtime

Alarms   
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

● Loop-in-alarm

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes   
Alarms are assigned to various alarm classes.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Error alarms normally indicate critical 
errors within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System alarms provide information on occurrences such as operator errors or 
communication faults. 

● Custom alarm classes
The properties of this alarm class must be defined in the configuration.
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Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.   

Alarm view
The alarm view shows selected alarms or alarm events from the alarm buffer. Whether alarm 
events have to be acknowledged or not is specified in your configuration.

Alarm window
The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active.  

You can configure the order in which the alarms are displayed. You can choose to display the 
alarms in ascending or descending order of their occurrence. The alarm window can also be 
set to indicate the exact location of the fault, including the date and time of the alarm event. 
By means of configuration, the display can be filtered in such a way that only alarms that 
contain a specific character string will be shown.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.   

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

 

10.3.4.2 Alarms in Runtime

Alarms   
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 
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● Date

● Time

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes   
Alarms are assigned to various alarm classes.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Error alarms normally indicate critical 
errors within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System events provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controller.

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

● Custom alarm classes
The properties of this alarm class are defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.   

Alarm report 
When alarm logging is enabled in the project, alarms are output directly to the printer. 

You can set the logging function separately for each alarm. Printing of such an alarm is initiated 
when the "incoming" and "outgoing" alarm events are generated.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be 
able to initiate this print function, you need to configure a corresponding control object in the 
project.
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Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.   

Alarm view
The alarm view shows selected alarms or events from the alarm buffer or alarm log. Whether 
alarm events have to be acknowledged or not is specified in your configuration. By means of 
configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged. 

You can configure the order in which the alarms are displayed. At the first position, the current, 
or the oldest alarm will be displayed. The alarm window can also be set to indicate the exact 
location of the fault, including the date and time of the alarm event. By means of configuration, 
the display can be filtered in such a way that only alarms that contain a specific character string 
will be shown.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.   

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

 

10.3.4.3 Using the Alarm Window or Alarm View

Alarm window, alarm view in Runtime

Application             
Alarms are indicated in the alarm view or in the alarm window on the HMI device. The layout 
and operation of the alarm window correspond to that of the alarm view.

The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged.
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Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed. If a filter is configured, only alarms that contain a 
specific string in the alarm text will be displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Symbol Alarm class
! "Errors"
Empty "Warnings"
depends on the configuration Custom alarm classes
$ "System"
S7 "Diagnosis Event"

Operation         
You use the alarm view as follows, depending on how it is configured:

● Change the order of the columns.

● Change the order in which the alarms are displayed.

● Acknowledging alarms

● Editing alarms

Control elements
The buttons have the following functions:         

Button Function
Displaying a tooltip for an alarm

Editing alarms

Acknowledge alarm

Operation behavior 

Linked alarm window for touch panels
When configuring the alarm window for keyboard units, enable the "Modal" property under 
"Properties > Mode". This ensures that the alarm window does not defocus during screen 
changes. Switching back and forth between the screen and different windows with <Ctrl+TAB> 
is not supported. If the linked alarm window has the focus, then the buttons in the screen behind 
it cannot be operated. The functions configured on a function key are carried out.
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Changing the order of the displayed alarms
When you click on the column, first of all alarms requiring acknowledgement are sorted 
according to date and time. Then those alarms that do not require acknowledgement are sorted 
according to date and time.

Using the Alarm Window, Alarm View

Introduction
As an alternative to using the mouse, you can operate the alarm view and the alarm window 
using the <TAB> key on your HMI device. This allows you to select the button and the most 
recently selected alarm in the alarm view. Depending on the configuration, you can also 
operate the alarm view via the function keys.

Operation using the mouse     
1. Select the alarm to be edited.

2. Click the button whose function you want to run.

Operation using the keyboard     
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the button whose function you wish to use is selected.

4. Press <Enter>.

Change the order of the columns
1. Select the column header, such as the "Date" column header.

2. While holding down the mouse button, drag the column header to the column header "Time".
The "Date" column is in front of the "Time" column.

Change the sorting
You can sort the list according to date or time.

1. Click on the corresponding column header.
The list is sorted in descending or ascending order according to this criterion.

2. Click the same column header again to reverse the sort order.

Acknowledge alarm  
1. Click on the alarm to be edited.

2. Click the button.
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Loop-In-Alarm trigger  
1. Click on the alarm to be edited.

2. Click the button.
The screen containing information about the alarm is displayed.

 

  Note

If you trigger a Loop-In-Alarm  during an unacknowledged alarm, it is acknowledged 
automatically.

 

Displaying configured tooltip  
1. Click on the alarm concerned.

2. Click the  button.
The tooltip configured for the alarm is displayed. 

10.3.4.4 Using the Simple Alarm Window, Alarm View

Basic alarm view, alarm window in Runtime

Application   
The simple alarm view shows selected alarms or alarm events from the alarm buffer. The layout 
and operation of the simple alarm window correspond to that of the simple alarm view.         

 

 Note

The "Single alarm view" object is not assigned dynamic functions by means of scripting. 

In the Engineering System, for example, dynamize the visibility of an object in the 
"Animations" tab of the Inspector window. In Runtime, the "Simple alarm view" does not 
support animations. If you configured an animation and, for example, run a consistency check 
on the project, an error alarm is displayed in the output window.
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Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
empty "Warnings"
depends on the configuration Custom alarm classes
$ "System"

Operation
You use the alarm view as follows, depending on how it is configured:     

● Acknowledging alarms

● Editing alarms

Control elements
The buttons have the following functions:     

Button Function
Acknowledge alarm

Loop-In-Alarm
Changes to the screen that contains information about the error event
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Button Function
Displaying a tooltip for an alarm

Displays the full text of the selected alarm in a separate window, namely the alarm text 
window
In the alarm text window, you can view alarm texts that exceed the space available in 
the Alarm view. Close the alarm text window with the  button.
Scrolls one alarm up.

Scrolls one page up in the alarm view.

Scrolls one page down in the alarm view.

Scrolls one alarm down.

Format of the control elements
The display of the buttons for using the simple alarm view depends on the configured size. 
You should therefore check on the HMI device whether all the required buttons are 
available.       

Basic alarm view, using the alarm window

Introduction
As an alternative to using the mouse, you can operate the simple alarm view using the <TAB> 
key on your HMI device. This allows you to select the button and the most recently selected 
alarm in the alarm view. Depending on the configuration, you can also operate the alarm view 
via the function keys.

Operation using the mouse  
1. Select the alarm to be edited.

2. Click the button whose function you want to run.

Operation using the keyboard  
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the button whose function you wish to use is selected.

4. Press <Enter>.

Acknowledge alarm 
1. Select the alarm to be acknowledged.

2. Click the button.
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Loop-In-Alarm trigger  
1. Select the alarm to be edited.

2. Click the button.
The screen containing information about the alarm is displayed.

Calling the infotext 
1. Select the alarm to be edited.

2. Click the button.

3. To close the window for displaying the operator note, press the  button or use the key 
combination <Alt+F4>.

10.3.4.5 Using the Alarm Indicator

Alarm indicator in Runtime

Application    
The alarm indicator is displayed if alarms of the specified alarm class are pending or require 
acknowledgment.

Layout   
The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

Operation   
Depending on the configuration, when operating the alarm indicator an alarm window is 
opened. The icons from the symbol library can only be operated with a mouse or touch screen. 

 

 Note
Device dependency

Operation with mouse is not available for all HMI devices.
 

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4043



Operating the alarm indicator using the mouse

Operation using the mouse  
1. Click on the alarm indicator with the mouse pointer. Depending on the configuration, the 

Alarm window is open.

2. Click  to close the alarm window. The Alarm window can be opened again by clicking 
on the alarm indicator.

10.3.4.6 Acknowledging alarms

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● Using the "ACK" key on your HMI device

● Using individually-configured function keys or buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To automatically acknowledge alarms in Runtime, use the system functions and scripts, plus 
the "Acknowledgment by the PLC" option.

 

 Note
Device dependency

Scripts are not available for all HMI devices.
 

Acknowledgment variants
You acknowledge individual alarms or multiple alarms together in Runtime. They are 
distinguished as follows:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgment of all the alarms of an alarm group using a button or a function key.
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Requirement
● An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, proceed as follows:

1. Select the alarm.

2. If you are using an alarm view or an alarm window, click the  button.

3. If you are using a simple alarm view or a simple alarm window, click the  button.

4. Press the "ACK" button on your HMI device to acknowledge an alarm in an alarm line.
 

  Note
Device dependency

The extended alarm view or alarm window and the alarm line are not available for all HMI 
devices.

 

Result
The alarm status changes to "Acknowledged". If the condition for triggering an alarm no longer 
applies, the alarm status also changes to "Outgoing", and it is no longer displayed on the HMI 
device. 

10.3.4.7 Filtering alarms

Introduction
The alarm view in Runtime does not contain a control element for entering filter criteria. To 
provide this functionality, configure an I/O field using the "Screens" editor. 

Requirements
● A filter has been configured for the alarm view.

● An I/O field for entering the criterion is displayed.

● Alarms are displayed in Runtime.

Enable filter
1. Enter the filter string in the I/O field.

2. Confirm your input.
The alarm view displays only those alarms that are contained in the specified character 
string. Thereby this distinguishes between upper and lower case letters. 
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Disable filter
1. Delete the string from the I/O field that is used to filter the alarm view.

2. Confirm your input.
All alarms are displayed in the alarm view once more.

10.3.5 Using Alarms in Runtime

10.3.5.1 Alarms in Runtime 

Alarms   
Alarms indicate events and states on the HMI device which have occurred in the system, in 
the process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Location of fault

● Status

● Alarm class

● Alarm number

● Alarm group

Alarm classes   
Alarms are assigned to various alarm classes.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on". Alarms 
in this class do not require acknowledgement.

● "Errors"
Alarms in this class must always be acknowledged. Error alarms normally indicate critical 
errors within the plant such as "Motor temperature too high".
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● "System"
System alarms indicate states or events which occur on the HMI device. 
System events provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controller.

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

● Custom alarm classes
The properties of this alarm class are defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.   

Alarm report 
When alarm logging is enabled in the project, alarms are output directly to the printer. 

You can set the logging function separately for each alarm. Printing of such an alarm is initiated 
when the "incoming" and "outgoing" alarm events are generated.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the content of the alarm buffer to the printer. To be 
able to initiate this print function, you need to configure a corresponding control object in the 
project.

Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.   

Alarm view
The alarm view shows selected alarms or events from the alarm buffer or alarm log. Whether 
alarm events have to be acknowledged or not is specified in your configuration. By means of 
configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
The alarm window is not assigned to any screen. Depending on the configuration the alarm 
window is opened when an alarm that belongs to a specific alarm class is active. Depending 
on the configuration, it is not closed until the alarm is acknowledged. 

You can configure the order in which the alarms are displayed. At the first position, the current, 
or the oldest alarm will be displayed. The alarm window can also be set to indicate the exact 
location of the fault, including the date and time of the alarm event. By means of configuration, 
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the display can be filtered in such a way that only alarms that contain a specific character string 
will be shown.

Alarm indicator
The alarm indicator is a graphic symbol that is displayed on the screen when an alarm of the 
specified alarm class is activated.   

The alarm indicator can have one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number indicates the number of queued alarms.

 

10.3.5.2 Alarm view

Introduction  
The "Alarm view" object displays alarms that occur during the process  in a plant. You also 
use the alarm view to display alarms in list form. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term). 
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In Runtime, you can use the <TAB> key to jump to different objects in succession to enter 
values, or click buttons. Alternatively you can use the alarm view with the mouse.

 

 Note

An alarm appears in the alarm view with the date and time stamp crossed out in the following 
situations:
● A locked alarm is unlocked.
● An alarm is reloaded after a power failure. This applies only to chronological messaging.
● The AS is restarted. This applies only to chronological messaging.

 

Requirement
● Cursor mode is set to "Tab cursor" for the screen.

● The objects are enabled for operation.

● The operator authorization is assigned.

Operation using the mouse   
1. Click on the alarm to be edited.

2. Click on the operator control whose function you wish to use.

Operation using the keyboard    
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Up> and <Down> keys accordingly.

3. Press the <Tab> key until the operator control element you wish to use is selected.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.

Example: Change the order of the columns
The function can be configured. It is only available in Runtime if you have activated the alarm 
view "Font table > Header column > Sort" in the Inspector window.

1. Select the column header, such as the "Date" column header.

2. While holding down the mouse button, drag the column header to the column header "Time".
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Example: Change the order of the columns
The function can be configured. It is only available in Runtime if you have activated the alarm 
view "Font table > Header column > Sort by column headers" in the Inspector window.

1. Click on the column header.

2. Click the same column header again to reverse the sort order.

Example: Loop-In-Alarm
Loop-In-Alarm  triggers the configured change of screen to the screen containing information 
about the alarm. 

1. Click on the alarm to be edited.

2. Click the button.

Operation behavior
When Loop-In-Alarm  is triggered for an unacknowledged alarm, it is acknowledged 
automatically.

10.3.5.3 Alarm View Buttons

Introduction
The alarm view displays specific alarm lists in order to provide a better overview of the active 
alarms. These lists filter, and sort alarms by certain properties. You can individually define 
these properties, and how the lists are presented when you configure the alarm view. 

Lists in the alarm view 
You can display six different lists in the alarm window. To display the alarm lists in the alarm 
view, click the associated button on the alarm view's toolbar.

 List Description
Alarm list Shows the pending alarms.
Short-term archive list Shows the logged alarms. 

The display is updated immediately when new incoming 
alarms occur.

Long-term archive list Shows the logged alarms. 
The display is not updated immediately when new incoming 
alarms occur.

Lock list Shows the locked alarms.
Alarm statistics Shows statistical information.
List of Hidden Alarms Shows the hidden alarms. Hidden alarms are also logged.
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Filtered alarm list   
You use the filter of the alarms view to configure alarm views in which you display specific 
alarm lists. You can configure a filter for any alarm list. Configure a separate alarm view for 
each filtered alarm list. 

 

 Note

An alarm appears in the alarm list with the date and time stamp crossed out in the following 
situations:
● A locked alarm is unlocked.
● An alarm is reloaded after a power failure; for chronological alarms only.
● The AS is restarted; for chronological alarms only.

 

See also
Filtering Alarms in Runtime (Page 4051)

10.3.5.4 Filtering Alarms in Runtime

Introduction      
In Runtime, you can set specific criteria that define the alarms to be displayed in the alarm 
view. In the example below, only alarms that contain the alarm text "Motor on" are displayed. 

Requirement
The "Filter alarms" button  is configured in the alarm view.

Procedure
To filter alarms in the alarm view, proceed as follows:

1. Click  in Runtime.
The "Specify selection" dialog opens.

2. Double-click the "Text Blocks" folder in the tree structure, and click "Alarm Text". In the right 
pane, select the "Search string" option, and double-click "Search string".

3. The "Text input" dialog opens. Enter the search string "Motor on" and click "OK" to confirm.

4. In the "Specify selection" dialog, click "OK" to confirm your entries.
The alarm view only shows the selected alarms.

In the "Specify selection" dialog, specify the start and end times, or search strings, for alarm 
text blocks such as the "Date" and "Time" system blocks. Your input must be in the format 
required in the dialog. 

The following settings are available in the "Specify selection" dialog:
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Field Description
Text filter by 
exact match 

If the "Text filter by exact match" option is not enabled, all text blocks that contain 
the specified string of characters are selected.
If the "Text filter by exact match" option is enabled, all text blocks that correspond 
exactly to the specified string of characters are selected. 

Persistence in 
RT

If the "Persistence in RT" option is enabled, changes to criteria are retained even 
after a screen change.

Persistence in 
CS and RT

If the "Persistence in RT and CS" option is enabled, the modified settings are also 
applied to the Engineering System. To do this, you must open the screen in the 
"Screens" editor, and save it again. The changed settings will also be used when 
you reactivate the project.

Delete filter Use this button to delete all configured criteria.

Filter by process values 
You cannot enter text as the criterion for a process value.

To filter by the text of a process value block, or the process tags it represents, proceed as 
follows:

1. Insert this process value as the alarm text for a user text block in an alarm.

2. In Runtime, filter the alarms by the text in the "Alarm text" text block.
 

  Note

In multi-user systems, make sure that contents displayed in the "Specify selection" dialog 
on a client have the same names on all servers.

When filtering by time, the start and stop values are not adjusted automatically when the 
timebase of the alarm view is changed.

Example: At the PC location with time zone "UTC + 1h", the alarm view has the "Local 
time zone" time base. You should filter by the time 10:00 to 11:00. Change the timebase 
from "Local time zone" to "UTC". If you want to display the same alarms, change the filter 
to 9:00 to 10:00. 

 

10.3.5.5 Sorting Alarms in Runtime

Introduction   
In Runtime, you can sort the alarms in the alarm view by column header. 

Examples for sorting alarms: 
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● In descending order by date, time, and alarm number. The most recent alarm is displayed 
at the top.

● By priority
You must have defined the priority of the alarms in the "HMI alarms" editor and configured 
the "Priority" alarm text block in the alarm view. As a result, in a single-line alarm view, only 
the top-priority alarm appears in the alarm window. A lower-priority alarm will not be 
displayed, even if it is more recent. The alarms are displayed in chronological order.

● The "Alarm status" alarm text block is sorted by the type of state and not by the configured 
status texts. For an ascending sort order, the following order is used:

– Incoming

– Outgoing

– Acknowledged

– Locked

– Enabled

– Automatic acknowledgment 

– Emergency acknowledgment

– Incoming/outgoing
 

  Note
Specifying sorting criteria in the ES for the alarm view

You can set the sort criteria to configure the alarm view as required. In the Inspector 
window of the alarm view, select "Properties > Properties > View > Columns".

 

Sorting alarms
To sort the alarm view by column, define the sort order over up to four columns. An arrow and 
a number are shown on the right in the column header. The arrow indicates the sort order 
(ascending or descending). The number beside the arrow indicates the sort order of the column 
headers.

Requirement
● "Sort by click" or "Sort by double-click" is selected in the alarm view.

Click on "Properties > Properties > Table > Table - Sorting > Settings".

● The "Autoscroll" button is activated in the alarm view. 
Click "Properties > Properties > Toolbar > Toolbar buttons". 
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Procedure
To sort alarms in the alarm view by column, proceed as follows:

1. Click or double-click the column header by which you want to sort the alarms first.
The number "1" is displayed, and the arrow points upwards for ascending sort order.

– If sort order "Up and down" is enabled in the alarm view, each click or double-click in 
the column header toggles the sorting between the ascending and descending mode.

– If sort order "Up, down, none" is enabled, then the sort order is cancelled after the 3rd 
click.

2. If you want to sort by several columns, click the column header in the required order.
 

  Note

Sorting is not affected by events or changes to the alarm text block configuration.

An alarm text block corresponds to a field in an alarm. If you define an alarm text block 
as sorting criterion in the sort dialog and then remove this block from the alarm line under 
"Properties> Properties > Columns", the defined sort order remains unchanged. In the 
sort dialog, a blank field is displayed instead of the deleted alarm text block. 

If you do not define another sort order order and reactivate the removed alarm text block 
in the alarm text block configuration, the alarms will be sorted in the original sort order 
once more. 

 

10.3.5.6 Toggling the Alarm View in Runtime 

Introduction
You filter the alarms to be displayed in the alarm view using preconfigured buttons.
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Requirements
● The six buttons needed to display a certain selection of alarms are configured in the alarm 

view.

Procedure
To display a certain selection of alarms in the alarm view, follow these steps:

● Click on one of the following buttons in the alarm view:
 Alarm list, to view alarms pending
 Historical alarm list (short-term), to view logged alarms

The display is updated immediately when new incoming alarms occur.
 Historical alarm list (long-term), to view logged alarms
 Lock list, to view the locked alarms
 Alarm statistics, to view statistical information
 List of hidden alarms, to view alarms which are logged but not visible.

10.3.5.7 Displaying logged alarms in Runtime

Introduction      
In Runtime, the alarm view displays alarms from the log, in addition to the current alarms. 

Requirements
● All the archived data that you intend to display in Runtime must be stored locally on the 

archive server. The SQL server does not allow access to backup files held elsewhere, such 
as another computer on the network.

● The  and  buttons are configured in the alarm view.

Procedure
To logged alarms in Runtime, follow these steps:

1. In the alarm view, click on the "Short-term archive list"  button to display the logged 
and current alarms. Any new incoming alarms will be immediately updated in the historical 
alarm list (short-term).

-OR-
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1. In the alarm view, click on the "Long-term archive list"  button to display only logged 
alarms. The historical alarm list (long-term) only displays logged alarms. You can enter or 
view comments in the historical alarm list (long-term).

10.3.5.8 Printing Alarms in Runtime

Introduction
You have the following options for printing alarms in Runtime, depending on the settings made 
in the "HMI alarms" and "Reports" editors:

Print alarm sequence report

If the alarm sequence report is activated, all alarm status transitions in Runtime are output 
continuously to a printer. No operator input is needed in Runtime. 

Printing report

The operator input in Runtime depends on your configuration. Your options for printing an 
alarm report in Runtime are as follows:

● Time-driven output

– One-off, time-driven output, e.g. at the start of a shift

– Repeated output at specific intervals, such as every two hours

● Event-driven output

– Change in value of a tag

– By clicking a configured button in a screen

– Click the  button in the alarm view

– Overflow of a log

– Script

Requirement
● Several alarms are displayed on the HMI device.

Procedure
To print the current view in the alarm window in Runtime, follow these steps:

1. Filter the alarm view using the alarm view controls, if necessary.

2. Click the  button in the alarm view.

Result
The alarms displayed in the alarm window are output to the printer that you configured in the 
"Reports" editor.
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Printer settings
Configure the printer in the HMI device's Control Panel. The settings will depend on which 
operating system is used on the HMI device. For detailed information, refer to the operating 
instructions of your HMI device and to the "Reporting alarms" chapter. 

See also
Working with reports (Page 4299)

10.3.5.9 Locking Alarms in Runtime

Locking Single Alarms

Introduction
If you lock an alarm, this alarm will not be displayed, and will not be logged. You can lock single 
alarms, alarm classes or alarm groups as required.

 

 Note
Locked alarm:

Locked alarms are automatically unlocked when WinCC Runtime restarts. Only alarms that 
are locked directly in the AS by means of data blocks will continue to be locked (locking at 
source).
Locked alarm classes / alarm groups:

The locked state of alarm classes and alarm groups is not affected by a restart of WinCC 
Runtime.

 

Requirement
● The alarm view has been configured.

● The alarm view is displayed in Runtime.

● The "Lock alarm / Unlock alarm" button  /  is configured.

● You are authorized to lock, and unlock alarms.
 

  Note

The "Lock alarm", and "Unlock alarm" authorizations must be configured directly one 
above the other. This is necessary because the authorization level used automatically for 
the "Unlock alarms" authorization is directly below the "Lock alarms" authorization.

 

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4057



Procedure
To lock alarms and prevent them being displayed using the button, follow these steps:

1. Select the alarm that you want to lock from the alarm view.

2. Click the button.
The alarm is removed from the alarm list.

3. Click on the  button to view all locked alarms.
The lock list is displayed.

4. Select the alarm that you want to unlock.

5. Click the button.
The alarm is displayed again and removed from the lock list.

 

  Note

Locking/unlocking an Alarm_8(P) alarm by means of S7PMC always causes all 8 alarms 
of this block to be locked, or unlocked. 
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Locking alarms by means of alarm number

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
Proceed as follows to lock alarms and prevent them being displayed using the alarm number:

1. Click the button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.

3. Click the "Add" button. In the subsequent dialog, enter the alarm number that you want to 
lock.

4. You can lock multiple alarms at the same time. To do this, enter the alarm numbers, 
separated by commas. Enter a range of numbers in the format "5-10". Only contiguous 
number ranges are locked. If there are gaps in the specified range, an "Invalid range" 
message is output.

5. To unlock a locked alarm, select the alarm from the list of locked alarms, and click the 
"Delete" button.

 

  Note

You cannot lock, or unlock more than 50 alarms at the same time. 
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Locking Alarms using the Alarm Class or Alarm Group

Introduction
You can also lock alarms to prevent them from being displayed by locking the entire alarm 
class, or the alarm group to which the alarm belongs. None of the alarms from these locked 
alarm groups and alarm classes will be displayed.

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
To lock, or unlock alarms via the alarm class, or the alarm group, proceed as follows:

1. In the alarm view, click the  button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.

3. In the tree structure, select an alarm class or user-defined alarm group that you want to 
lock.

4. Click the "Lock" button.
All alarms from this alarm class or user-defined alarm group are locked.

To unlock the alarms, select the alarm class or user-defined alarm group and click on the 
"Unlock" button.
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Operator input alarm when an alarm is locked
You can define in the alarm view, whether an operator input alarm is generated when an alarm 
is locked or unlocked. You should configure the operator input alarm yourself if needed. The 
operator input alarm contains the following objects by default:

● A time stamp

● The user logged on

The time stamp for the alarm originates as follows:

● From the alarm source (such as an AS) for active locking.

Actively-locked alarms are visible, and can be used on all HMI devices.

10.3.5.10 Acknowledgement of Alarms

Acknowledging alarms 

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● With customized buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To bypass the acknowledgement in Runtime, WinCC contains system functions and scripts 
that allow you to acknowledge alarms automatically.

Acknowledgement variants
You acknowledge individual alarms or multiple alarms together in Runtime. The following 
options are possible:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgement of all the alarms of an alarm group using a button, or a function key.

● Group acknowledgement
Acknowledgement of all pending alarms in the alarm view that require acknowledgement 
using the  button in the alarm view.

● Dual-mode acknowledgment
If an alarm requires dual-mode acknowledgment, you acknowledge both the incoming, and 
the outgoing alarm.
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Requirement
An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, follow these steps:

● Select the alarm.

● Click the  button in the alarm view.

Result
The alarm status is set to "Acknowledged". If the trigger condition for an alarm no longer 
applies, the alarm status is also set to "outgoing" and no longer displayed on the HMI device. 

Group Alarm Acknowledgement

Introduction
The acknowledgement of all pending, and visible alarms in the alarm window that need to be 
acknowledged is known as a group acknowledgement. If the "Single alarm" option is not 
selected for an alarm, you can trigger a group acknowledgment. 

Requirement
There are several alarms that require acknowledgement in the alarm view.

Procedure
To group-acknowledge an alarm, follow these steps:

1. Read the alarm texts of the queued alarms and initiate remedial action, if necessary.

2. In the alarm view, click the  button.

Result
All queued alarms with the following properties are acknowledged:

● Requires acknowledgement

● Does not require acknowledgement

● Visible
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Emergency acknowledgment of alarms

Introduction
In exceptional situations, the operator acknowledges an alarm based on its alarm number. The 
acknowledgment bit is sent to the AS even if the alarm is currently not pending. This function 
is only intended for use in imminent emergency situations. 

Requirement
The  button is configured in the alarm view.

Procedure
To acknowledge an alarm in Runtime using an emergency acknowledgement, follow these 
steps:

1. Click the  button in the alarm view.
The "Emergency Acknowledgment for Alarms" dialog opens.

2. Select a server.

3. To enter the alarm number, select "Alarm number".

4. Click the "Send acknowledge job" button.
The alarm then appears in the alarm view in the color that you defined for an acknowledged 
alarm.

 

  Note

In the dialog for selecting the servers, only server projects whose "Packages" are loaded 
onto the PC are shown. 
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Acknowledging an alarm annunciator

Introduction
The way you acknowledge an alarm annunciator in Runtime will depend on how you configured 
its acknowledgement. 

Requirements
● The alarm annunciator and its acknowledgment are configured.

● The alarm annunciator is triggered.

Acknowledgment using a separate key
● To acknowledge the alarm annunciator, click the  button in the alarm view.

You only acknowledge the alarm annunciator. The alarm that triggered the alarm 
annunciator is still set to "incoming" status.

Single acknowledgment
● To acknowledge the alarm annunciator, select the current alarm, and click the  button 

in the alarm view. 
You thereby acknowledge the alarm annunciator and the alarm that triggered the alarm 
annunciator.

Acknowledgment tag
If the alarm annunciator is acknowledged using a tag, acknowledge the alarm annunciator 
using a customized button or function key, etc.

Result
This sets the acknowledgment bit of the alarm annunciator.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
4064 System Manual, 02/2014



10.3.6 Reference

10.3.6.1 System functions for alarms

System functions
System functions are predefined functions you can use to implement many tasks in runtime, 
even with no programming knowledge. You use system functions in a function list or in a script.   

 

 Note
Device dependency

Scripts are not available for all HMI devices.
 

The table shows all the system functions available for displaying and editing alarms.

System function Effect 
EditAlarm Triggers the Loop-In-Alarm event for all selected 

alarms.
ClearAlarmBuffer Deletes alarms from the alarm buffer on the HMI 

device.
ClearAlarmBufferProtoolLegacy Function such as "ClearAlarmBuffer". This system 

function has been retained to ensure compatibility 
and uses the old ProTool numbering. 

AlarmViewUpdate Updates the alarm view.
AlarmViewEditAlarm Triggers the event Loop-In-Alarm for all alarms 

selected in the specified alarm view.
AlarmViewAcknowledgeAlarm Acknowledges the alarms that are selected in the 

specified alarm view.
AlarmViewShowOperatorNotes Displays the configured tooltip for the alarm 

selected in the specified alarm view.
AcknowledgeAlarm Acknowledges all selected alarms.
SetAlarmReportMode Switches the automatic reporting of alarms on the 

printer on or off.
ShowAlarmWindow Hides or shows the alarm window on the HMI 

device.
ShowSystemEvent Displays the value of the delivered parameter as 

a system event on the HMI device.
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 Note
Device dependency

The following system functions are not available for all HMI devices:
● SetAlarmReportMode
● AlarmViewUpdate
● ShowSystemEvent

 

10.3.6.2 Alarm events 

Alarm events and their display and control objects
In Runtime, the following alarm events are triggered by their display and control objects. You 
can configure a function list for every event.  

Object Configurable events
Alarms Incoming

Outgoing
Acknowledge
Loop-In-Alarm

Alarm view Enabling
Disable
Selection changed

Alarm indicator Click
Click when flashing

 

 Note
Device dependency

The following events in the alarm view are not available for all HMI devices:
● Enabling
● Disable
● Selection changed
● Click
● Click when flashing

 

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
4066 System Manual, 02/2014



10.3.6.3 Alarm events

Alarm events and their display and control objects
In Runtime, the following alarm events are triggered by their display and control objects. You 
can configure a function list for every event.  

Object Configurable events
Alarms Incoming

Outgoing
Acknowledge
Loop-In-Alarm
Status changed

Alarm view Enabling
Loaded
ToolbarButtonClicked
PropertyChanged
ToolbarButtonPropertyChanged
AlarmBlockPropertyChanged
AlarmColumnPropertyChanged
HitlistColumnPropertyChanged
OperatorAlarmPropertyChanged

10.3.6.4 System functions for logs

System functions
The following system functions are available for logging:

Function name Function method
ArchiveLogFile This function moves or copies a log to another storage location for long-

term archiving. Use the system function, for example, to move the audit 
trail from a local storage medium to the server.
When handling audit trails, always use the "Move log (hmiMove)" mode in 
order to avoid noncompliance with FDA guidelines as a result of redundant 
data storage. 

LogTag Saves the value of the given tags in the given data log. Use the system 
function to log a process values at a specific time.

StartLogging Starts the logging process in the specified log. You can interrupt logging 
in Runtime by calling the "StopLogging" system function.

StopLogging Stops the logging process in the specified log. To resume logging in 
Runtime, select the "StartLogging" system function.

ClearLog Deletes all entries in the specified log.
StartNextLog Stops the logging process in the specified log. Logging is continued in the 

sequential log that has been configured for the specified log file.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4067



Function name Function method
CloseAllLogs Closes all logs. The connection between WinCC and the log files or log 

database is terminated. You can use this system function, for example, to 
enable hot-swapping of the storage medium on the HMI device without 
exiting the Runtime software.

OpenAllLogs Opens all logs to resume logging. The connection between WinCC and 
the log files or log database is recovered.

CopyLog Copies the contents of the specified log to another log.

10.3.6.5 Structure of *.csv files that contain alarms

Introduction
You can save an alarm log as a file in "*.csv" format. CSV stands for Comma Separated Value. 
In this format, the table columns that contain the names and the value of the entry are separated 
by semicolons. Each table row terminates with a line break.   

Example of a log file in *.csv format
This example shows a file with logged alarms:   

"Time_ms";"MsgProc";"StateAfter";"MsgClass";"MsgNumber";"Var1";...;"Var8";"TimeString";"
MsgText";"PLC"37986550590,27;1;1;3;110001;"";...;"";"30.06.99 13:12:51";"Change to 
operating mode 'online'";37986550682,87;1;1;3;140010;"";...;"";"30.06.99 
13:12:59";"Connection established: PLC_1, Station 2, Rack 0, Position 2"; 

Structure of a log file in *.csv format
The following values are entered in the log file columns:

Parameters Description
Time_ms Specify a time stamp as a decimal value ( see below for conversion)
Msg_Proc Alarm procedures: 

0 = Unknown alarm procedure
1 = System event
2 = Alarm bit procedure (operating alarms)
3 = Alarm number procedure ALARM_S
4 = Diagnostic event
7 = Analog alarm procedure
100 = Alarm bit procedure (fault alarms)

State after Alarm event: 
0 = Incoming/Outgoing
1 = Incoming
2 = Incoming/Acknowledged/Outgoing
3 = Incoming/Acknowledged
4 = All alarms in the PLC were deleted with SFC106 or after PLC STOP/RUN an 
alarm is pending
6 = Incoming/Outgoing/Acknowledged
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Parameters Description
Msg_Class Alarm class: 

0 = No alarm class
1 = "Errors"
2 = "Warnings"
3 = "System"
4 = "Diagnostic Events"
64 ... = user-configured alarm classes

Msg Number Alarm number
Var1 to Var8 Value of the trigger tag as a STRING
Time string Time stamp, as STRING in legible data format
Msg text Alarm in a readable STRING
PLC Alarm localization (relevant PLC)

Conversion of the time stamp decimal value
To further process the time stamp value using a different program, proceed as follows:

1. Divide Time_ms by 1,000,000.
Example: 37986476928 : 1,000,000 = 37986.476928

2. The whole number portion (37986) is the date calculated from 12/31/1899.
In Excel you can now convert the time stamp into days. To do this, assign to the cell that 
contains the time stamp, a respective format form the "Date" group.
Result: 37986 results in 12/31/2003

3. The value after the point (0.476928) indicates the time:

– Multiply the value (0.476928) by 24 to obtain the hours (11.446272).

– Multiply the remainder (0.446272) by 60 results in the minutes (26.77632).

– Multiply the remainder (0.77632) by 60 results in the seconds (46.5792).

Result 11:26:46.579
This conversion is supported by Microsoft Excel, for example. 

10.3.6.6 Description of the System Blocks

Introduction           
System blocks allow you to specify predefined information that is not freely utilizable, such as 
date, time and duration.

The value of the alarm text block (such as the time of day) is displayed in the alarm. The 
description of the system blocks provides information on the individual system blocks.
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Overview

System block Description Default 
length

Date Date of the "incoming", "outgoing", and "acknowledged" 
alarm statuses.

8

Time Time of the "incoming", "outgoing", and "acknowledged" 
alarm statuses. 
Accuracy of a WinCC time stamp: 1 s. 
Display accuracy: 10 ms.

9

Duration Time period between the "incoming", "outgoing", and 
"acknowledged" statuses. 
There is only one column for duration:
● The column remains blank for alarms with "incoming" 

status.
● For alarms with "outgoing" status, the time that 

elapses between "incoming" and "outgoing" is 
displayed.

● When alarms are acknowledged, the time between 
"incoming" and "outgoing" is displayed.

8

Daylight Saving Time/
Standard Time

Indicates whether daylight saving time is set. 1

Status Indicates the alarm status, such as "Incoming" or 
"Outgoing". 
The letters displayed in this system block to indicate the 
alarm status (such as "Q") are assigned in the alarm class.

1

Acknowledgment status Indicates whether an alarm has been acknowledged. 
The letters that are displayed in this system block to 
indicate the acknowledgment status are configured in the 
alarm class.

1

Number Alarm number 3
Class Alarm class

The text is user-defined.
8

Category Alarm procedures 8
PLC/CPU number
 

Number of the CPU and AS in which the alarm was 
triggered. 
In Runtime, the value of this system block is not taken 
from the AS but rather is taken from the configured data 
for the alarm. The value has no function in communication 
with the AS.

2

Tag The "Tag" system block is not yet supported. 1
Log flag Flag indicating whether the alarm is to be logged. 1
Report flag Flag indicating whether the alarm is to be reported. 

The report flag depends on the alarm number. You only 
have read access to the report flag.

1

Comment Indicates whether there is a comment for this alarm. A 
comment is the users input about an alarm, such as "This 
alarm occurred today because...".

1
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System block Description Default 
length

Tooltip Indicates whether there is a tooltip for this alarm. Tooltips 
contain information about the alarm, limited to 255 
characters, such as "This alarm may occur if ...". Tooltip 
cannot be edited in Runtime.

1

Loop-In-Alarm Indicates whether Loop-In-Alarm function is enabled. 1
Computer Name Indicates the name of the PC:

● If the user has entered a comment in the "Historical 
alarm list" (long-term) and then changed the view, the 
name of the PC used appears in the "Historical alarm 
list" (short-term) and "Historical alarm list" (long-term).

● If an alarm was acknowledged on a PC, the name of 
the PC appears in the "Historical alarm lists" (short 
and long-term) in the operator input alarm. The 
operator input alarm must be enabled under 
"Operator input alarm" in the Inspector window for the 
alarm view.

10

User Name Indicates the name of the user (login name):
● If you enter a comment in the "Historical alarm list" 

(long-term) and then exit the view, your user name is 
displayed in the "Historical alarm list" (short-term) and 
"Historical alarm list" (long-term).

● If an alarm was acknowledged by a user logged on to 
WinCC, the user name is displayed in the "Historical 
alarm lists" (short and long-term) in the operator input 
alarm. The operator input alarm must be enabled 
under "Operator input alarm" in the Inspector window 
for the alarm view.

10

Priority Defines the priority of an alarm. You can sort the alarms 
in the alarm view by priority. By sorting by priority, you 
can ensure that, in a single-line alarm view, the most 
important alarm (high priority) is shown in the display 
area. A lower-priority alarm will not be displayed, even if 
it is more recent.
Value range: 0 - 16 
In WinCC, the value corresponding to the highest priority 
is not specified. In the PCS7 environment, the value 16 
corresponds to the highest priority.

3

 
 

 Note

If you enabled the "Change ISO8601 format on all components" option in the shortcut menu 
of WinCC RT Professional, "Properties > Time settings > Central date and time formatting", 
the date and time are also displayed in the system blocks of the alarms in ISO8601 format.
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10.3.6.7 SQL Statements for Filtering the Alarm View

Introduction  
In the alarm view, you can only use SQL statements that can be generated using the "Specify 
selection" dialog. The following conditions apply to WinCC: 

● Structure: "Field", "Address", and "Value"
Separate individual parameters with spaces. 
Example:
DATETIME >= '2006-12-21 00:00:00' AND MSGNR >= 100 
All alarms from 21.12.2006 with an alarm number greater than or equal to 100

● The following information is entered in single quotes:

– Character strings

– Date

– Time of day

● In the DATETIME argument, the date and time of day are separated by a blank. Regardless 
of the time base setting in the object properties, the output of DATETIME is based on the 
time base Local Time. The exception to this is when "UTC" is set as the time base. In this 
case, output is based on the time base "UTC".

Permissible Arguments

Name SQL name Type Data Example
Date/time DATETIME Date 'YYYY-MM-DD 

hh:mm:ss.msmsms'
DATETIME >= '2007-05-03 
16:00:00.000'
Outputs alarms as of 05/03/2007, 16:00 
hours.

Number MSGNR Integer Alarm number MSGNR >= 10 AND MSGNR <= 12
Outputs the alarms with alarm numbers 
10 - 12.

Class CLASS IN Integer Alarm class ID 1-256 and 
"System" alarm classes 17 + 18

CLASS IN ( 1 )
Outputs alarms of alarm class 1.

Status STATE Integer Value "ALARM_STATE_xx"
Only the operands "=" and "IN(...)" 
are permitted.
ALARM_STATE_1
ALARM_STATE_2
ALARM_STATE_3
ALARM_STATE_4
ALARM_STATE_10
ALARM_STATE_11
ALARM_STATE_16
ALARM_STATE_17

STATE IN(1,2,3)
Outputs all alarms that came in, went out 
and were acknowledged.
Possible values:
1 = incoming alarms
2 = outgoing alarms
3 = acknowledged alarms
4 = blocked alarms
10 = hidden alarms
11 = displayed alarms
16 = alarms acknowledged by the 
system
17 = Emergency-acknowledged alarms
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Name SQL name Type Data Example
Priority PRIORITY Integer Alarm priority 0 - 16 PRIORITY >= 1 AND PRIORITY =< 5

Outputs alarms that have a priority 
between 1 and 5.

Controller 
number

AG_NR Integer Controller number AG_NR >= 2 AND AG_NR <= 2
Outputs alarms with the Controller 
number 2.

CPU number CPU_NR Integer AG sub-number CPU_NR >= 5 AND CPU_NR <= 5
Outputs alarms with AG sub-number 5.

Instance INSTANCE Text Instance -
Block: 1
...
Block: 10

TEXTxx Text Search string for Text1 - Text10 TEXT2 = "Error"
Outputs the alarms whose Text2 
corresponds with "Error".
TEXT2 IN ('Error','Fault')
Outputs the alarms whose Text2 
corresponds with the text "Error" or 
"Fault".
TEXT2 LIKE 'Error'
Outputs the alarms whose Text2 
includes the text "Error".

Process value: 1
...
Process value: 
10

PVALUExx Double Search value for PVALUE1-
PVALUE10

PVALUE1 >= 0 AND PVALUE1 <= 50
Outputs process value 1 with start value 
0 and stop value 50.

Permissible Operands
● >= , <= , = , > , <

● IN(...) : Several values as an array, separated by commas, e.g.: CLASS IN( 1 ,2 ,3 ).

● LIKE : Text must contain string, e.g.: TEXT1 LIKE 'Error' relays alarm where Text1 contains 
the search string "Error". The operand LIKE is only allowed for "text" type arguments.

Illegal arguments and operands 
Only the arguments indicated in the table and operands from the list are permitted.

Grouping arguments, with brackets, for example, is not permitted.

10.3.6.8 System events 

Basics on system events

System events
System events on the HMI device provide information about internal states of the HMI device 
and PLC.
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The following overview illustrates when a system event occurs and how to eliminate the cause 
of error.

 

 Note
HMI device dependency

Some of the system events described in this section apply to the individual HMI devices based 
on their scope of functions.

 

 
 

 Note

System events are output in an alarm view. System events are output in the language 
currently set on your HMI device.

 

System event parameters  
System events may contain encrypted parameters. The parameters are of relevance when 
troubleshooting because they provide a reference to the source code of the Runtime software. 
These parameters are output after the "Error code:" text.

10000 - Printer alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 10-6 10000 - Printer alarms

Number Effect/cause Remedy
10000 The print job could not be started or was canceled 

due to an unknown error. Faulty printer setup. Or: 
No authorization is available for accessing the 
network printer.
Power supply failure during data transfer.

Check the printer settings, cable connections and the 
power supply.
Set up the printer once again. Obtain a network printer 
authorization.
If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not 
been set up.

Install a printer and/or select it as the default printer.

10002 Overflow of the graphics buffer for printing. Up to two 
graphics are buffered.

Allow sufficient intervals between successive print jobs.

10003 Graphics can now be buffered again. --
10004 Overflow of the buffer for printing lines in text mode 

(e.g. alarms). Up to 1000 lines are buffered.
Allow sufficient intervals between successive print jobs.

10005 Text lines can now be buffered again. --
10006 The Windows printing system reports an error. Refer 

to the output text and the error ID to determine the 
possible causes. Nothing is printed or the print is 
faulty.

Repeat the action if necessary. 
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20000 - Global script alarms

Meaning of the system events  
All system events that can be displayed are listed below. The system events are divided into 
different ranges.

Table 10-7 20000 - Global script alarms

Number Effect/causes Remedy
20010 An error has occurred in the specified script line. 

Execution of the script was therefore aborted. Note 
the system event that may have occurred prior to 
this.

Select the specified script line in the configuration. 
Ensure that the tags used are of the allowed types. For 
system functions, verify the correct number of 
parameters and the parameter types.

20011 An error has occurred in a script that was called by 
the specified script. 
Execution of the script was therefore aborted in the 
called script. 
Note the system event that may have occurred prior 
to this. 

In the configuration, select the script that has been 
called directly or indirectly by the specified script. 
Ensure that the tags used are of the allowed types. 
For system functions, verify the correct number of 
parameters and the parameter types.

20012 Inconsistent configuration data. The script could 
therefore not be generated.

Recompile the configuration data.

20013 Incorrect installation of the scripting component of 
WinCC Runtime. Therefore, no scripts can be 
executed.

Reinstall WinCC Runtime on your PC.
Recompile your project using the "Compile > Software 
(compile all)" command from the context-sensitive 
menu and then download the project to the HMI device.

20014 The system function returns a value that is not 
written in any return tag.

Select the specified script in the configuration.
Check whether the script name has been assigned a 
value.

20015 Too many successive scripts have been triggered in 
short intervals. When more than 20 scripts are 
queued for processing, any subsequent scripts are 
rejected. In this case, the script indicated in the 
alarm is not executed.

Check what is triggering the scripts. Extend the times, 
e.g. the acquisition cycle of the tag initiating the script.

30000 - Alarms errors when using system functions

Meaning of the system events
All system events that can be displayed are listed below. The system events are divided into 
different ranges.
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Table 10-8 30000 - Alarms errors when using system functions

Number Effect/causes Remedy
30010 The tag could not accept the function result, e.g. 

when it has exceeded the value range.
Check the tag types of the system function parameters.

30011 A system function could not be executed because 
the function was assigned an invalid value or type in 
the parameter.

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value.

30012 A system function could not be executed because 
the function was assigned an invalid value or type in 
the parameter.

Check the parameter value and tag type of the invalid 
parameter. If a tag is used as a parameter, check its 
value.

40000 - Linear scaling alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. The system alarms are divided into 
different ranges:

Table 10-9 40000 - Linear scaling alarms

Number Effect/causes Remedy
40010 The system function could not be executed since the 

parameters could not be converted to a common tag 
type.

Check the parameter types in the configuration.

40011 The system function could not be executed since the 
parameters could not be converted to a common tag 
type.

Check the parameter types in the configuration.

50000 - Data server alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. The system alarms are divided into 
different ranges:

Table 10-10 50000 - Data server alarms

Number Effect/causes Remedy
50000 The HMI device is receiving data faster than it is 

capable of processing. Therefore, no further data is 
accepted until all current data have been processed. 
Data exchange then resumes.

--

50001 Data exchange has been resumed. --
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60000 - Win32 function alarms

Meaning of the system events 
All system events that can be displayed are listed below. 

Table 10-11 60000 - Win32 function alarms

Number Effect/causes Remedy
60000 This alarm is generated by the "ShowSystemEvent" 

system function. The text to be displayed is 
transferred to the function as a parameter.

--

60010 The file could not be copied in the direction defined 
because one of the two files is currently open or the 
source/target path is not available.
It is possible that the Windows user has no access 
rights to one of the two files.

Restart the system function or check the paths of the 
source/target files. In Windows NT/XP: Users executing 
WinCC Runtime must be granted access to the files.

60011 An attempt was made to copy a file to itself.
It is possible that the Windows user has no access 
rights to one of the two files.

Check the path of the source/target file.
In Windows NT//XP and NTFS file system: Users 
executing WinCC Runtime  must be granted access to 
the files.

70000 - Win32 function alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-12 70000 - Win32 function alarms

Number Effect/causes Remedy
70010 The application could not be started because it could 

not be found in the path specified or there is 
insufficient memory space.

Check whether the application exists in the specified 
path or close other applications.

70011 The system time could not be modified.
The error alarm only appears in connection with area 
pointer "Date/time PLC". Possible causes:
● An invalid time was transferred in the job mailbox.
● The Windows user has no right to modify the 

system time.
If the first parameter in the system event is displayed 
with the value 13, the second parameter indicates 
the byte containing the incorrect value.

Check the time which is to be set.
Using Windows NT/XP: Users running WinCC Runtime 
must be granted the right to set the system time of the 
operating system.

70012 Error when executing the function "StopRuntime" 
with the "Runtime and operating system" option.
Windows and WinCC Runtime are not closed. 
The error was possibly generated because other 
programs cannot be closed. 

Close all programs currently running.
Then close Windows.
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Number Effect/causes Remedy
70013 The system time could not be modified because an 

invalid value was entered. Incorrect separators may 
have been used.

Check the time which is to be set.

70014 The system time could not be modified. Possible 
causes:
● An invalid time was transferred.
● The Windows user has no right to modify the 

system time.
Windows rejects the setting request.

Check the time which is to be set.
Using Windows NT/XP: Users running WinCC Runtime 
must be granted the right to set the system time of the 
operating system.

70015 The system time could not be read because 
Windows rejects the reading function.

--

70016 An attempt was made to select a screen by means 
of a system function or job. This is not possible 
because the screen number specified does not exist.
Or: A screen could not be generated due to 
insufficient system memory.
Or: The screen is blocked.
Or: Screen call has not been executed correctly.

Check the screen number in the function or job with the 
screen numbers configured.
Assign the number to a screen if necessary.
Check the details for the screen call and whether the 
screen is blocked for specific users.

70017 Date/time is not read from the area pointer because 
the address set in the PLC is either not available or 
has not been set up.

Change the address or set up the address in the PLC.

70018 Acknowledgment that the password list has been 
successfully imported.

--

70019 Acknowledgment that the password list has been 
successfully exported.

--

70020 Acknowledgment for activation of alarm reporting. --
70021 Acknowledgment for deactivation of alarm reporting. --
70022 Acknowledgment to starting the Import Password 

List action.
--

70023 Acknowledgment to starting the Export Password 
List action.

--

70024 The range of values of the tag was exceeded in the 
system function.
No calculation of the system function.

Check and correct the calculation.

70025 The range of values of the tag was exceeded in the 
system function.
No calculation of the system function.

Check and correct the calculation.

70026 No other screens are stored in the internal screen 
memory.
No other screens can be selected.

--

70027 The backup of the RAM file system has been started. --
70028 The files from the RAM have been copied in the 

Flash memory.
The files from the RAM have been copied in the 
Flash memory. Following a restart, these saved files 
are copied back to the RAM file system.

--

70029 Backup of the RAM file system has failed.
No backup copy of the RAM file system has been 
made.

Check the settings in the "Control Panel > OP" dialog 
and save the RAM file system using the "Save Files" 
button in the "Persistent Storage" tab.
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Number Effect/causes Remedy
70030 The parameters configured for the system function 

are faulty.
The connection to the new PLC was not established.

Compare the parameters configured for the system 
function with the parameters configured for the PLCs 
and correct them as necessary.

70031 The PLC configured in the system function is not an 
S7 PLC.
The connection to the new PLC was not established.

Compare the S7 PLC name parameter configured for 
the system function with the parameters configured for 
the PLC and correct them as necessary.

70032 The object configured with this number in the tab 
sequence is not available in the selected screen.
The screen changes but the focus is set to the first 
object.

Check the number of the tab sequence and correct it if 
necessary.

70033 An e-mail cannot be sent because a TCP/IP 
connection to the SMTP server no longer exists.
This system event is generated only at the first 
attempt. All subsequent unsuccessful attempts to 
send an e-mail will no longer generate a system 
event. The event is regenerated when an e-mail has 
been successfully sent in the meantime.
The central e-mail component in WinCC Runtime 
attempts to connect to the SMTP server at cyclic 
intervals (1 minute) in order to transmit the remaining 
e-mails.

Check the network connection to the SMTP server and 
re-establish it if necessary.

70034 Following a disruption, the TCP/IP connection to the 
SMTP server could be re-established.
The queued e-mails are then sent.

--

70036 No SMTP server for sending e-mails is configured. 
An attempt to connect to an SMTP server has failed 
and it is not possible to send e-mails.
WinCC Runtime generates the system event after 
the first attempt was made to send an e-mail.

Configure an SMTP server:
In the WinCC Engineering System
using "Device settings > Device settings"
In the Windows CE operating system
using "Control Panel > Internet Settings > E-mail > 
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons.
The contents of the e-mail are lost.

Check the e-mail parameters (recipient etc.).

70038 The SMTP server has rejected sending or 
forwarding an e-mail because the domain of the 
recipient is unknown to the server or because the 
SMTP server requires authentication.
The contents of the e-mail are lost.

Check the domain of the recipient address or disable 
the authentication on the SMTP server if possible. 
SMTP authentication is currently not used in 
WinCC Runtime.

70039 The syntax of the e-mail address is incorrect or 
contains illegal characters.
The contents of the e-mail are discarded.

Check the e-mail address of the recipient.

70040 The syntax of the e-mail address is incorrect or 
contains illegal characters.

--

70041 The import of the user management was aborted 
due to an error.
Nothing was imported.

Check your user administration or download it again to 
the panel.

70042 The range of values of the tag was exceeded while 
executing the system function.
The system function was not calculated.

Check and correct the calculation.

70043 The range of values of the tag was exceeded while 
executing the system function.
The system function was not calculated.

Check and correct the calculation.
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70044 An error occurred while sending the e-mails. The e-

mails were not sent. 
Check the SMTP settings and the error message in the 
system event.

70045 Cannot load a file required for encrypting the e-mail. Update the operating system and Runtime.
70046 The server does not support encryption. Select an SMTP server that supports encryption.
70047 The SSL versions of the HMI device and SMTP 

server may not be compatible.
Contact your network administrator or the operator of 
the SMTP server.

80000 - Log alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-13 80000 - Log alarms

Number Effect/causes Remedy
80001 The log specified is filled to the size defined (in 

percent) and must be stored elsewhere.
You swap out the file or table by executing a ‘move’ or 
‘copy’ function.

80002 A line is missing in the specified log. --
80003 The copying process for logging was not successful.

In this case, it is advisable to check any subsequent 
system events, too.

--

80006 Since logging is not possible, this causes a 
permanent loss of the functionality.

In the case of databases, check whether the 
corresponding data source exists and start up the 
system again.

80009 A copying action has been completed successfully. --
80010 An incorrect storage location was entered in WinCC 

and causes permanent loss of functionality.
Configure the storage location for the respective log 
again and restart the system when the full functionality 
is required.

80012 Log entries are stored in a buffer. If the values are 
read to the buffer faster than they can be physically 
written (using a hard disk, for example), overloading 
may occur and recording is then stopped.

Archive fewer values.
Or:
Increase the logging cycle.

80013 The overload status no longer exists. Archiving 
resumes the recording of all values.

--

80014 The same action was triggered twice in quick 
succession. Since the process is already in 
operation, the action is only carried out once.

--

80015 This system event is used to report DOS or database 
errors to the user.

--

80016 The logs are separated by system function 
"CloseAllLogs" and the incoming entries exceed the 
defined buffer size.
All buffer entries are deleted.

Reconnect the logs.
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80017 The number of incoming entries cause a buffer 

overflow. This can be caused, for example, by 
several copying actions being activated at the same 
time.
All copy jobs in the buffer are deleted.

Stop the copy action. 

80019 The connection between WinCC and all log files was 
shut down, for example, after execution of the 
"CloseAllLogs" system function.
Entries are written to the buffer and written to the 
logs when the connection is recovered. 
There is no connection to the storage location and 
the storage medium can be changed.

--

80020 The maximum number of simultaneously copy 
operations has been exceeded. Copying is not 
executed.

Wait until the current copying actions have been 
completed, then restart the last copy action.

80021 An attempt was made to delete a log which is still 
busy with a copy action. Deletion has not been 
executed.

Wait until the current copying actions have been 
completed, then restart the last action.

80022 An attempt was made to use system function 
"StartSequenceLog" to start a sequence log for a log 
which is not configured as sequence log. No 
sequence log file is created.

In the project, check
● whether the "StartSequenceLog" system function 

was properly configured.
● if the tag parameters are properly provided with data 

on the HMI device.
80023 An attempt was made to copy a log to itself.

The log is not copied.
In the project, check
● whether the "CopyLog" system function was 

properly configured.
● if the tag parameters are properly provided with data 

on the HMI device.
80024 In your configuration, you specified that the 

"CopyLog" system function should not allow copying 
if the destination log already contains data ("Mode" 
parameter). The log is not copied.

Edit the "CopyLog" system function in your 
configuration, if necessary. Before you initiate the 
system function, delete the destination log file.

80025 You have canceled the copy operation.
Data written up to this point are retained. The target 
log file (if configured) was not deleted.
The cancellation is reported by an error entry 
$RT_ERR$  at the end of the target log.

--

80026 This alarm is output after all logs are initialized. 
Values are written to the logs from then on. No 
entries are written to the logs before this time has 
expired, irrespective of the active state of 
WinCC Runtime.

--

80027 The internal Flash memory has been specified as 
the storage location for a log. This is not permissible.
No values are written to this log and the log file is 
not created.

Configure "Storage Card" or network path as the 
storage location.

80028 The alarm serves as status report indicating that the 
logs are currently being initialized. No values are 
logged until the alarm 80026 is output.

--
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80029 The number of logs specified in the alarm could not 

be initialized. Initialization of logs was finished.
 The faulty log files are not available for logging jobs.

Evaluate the additional system events related to this 
alarm. Check the configuration, the ODBC (Open 
Database Connectivity), and the specified drive.

80030 The structure of the existing log file does not match 
the expected structure.
Logging is stopped for this log.

Delete the existing log data manually, in advance.

80031 The log in CSV format is corrupted.
The log cannot be used.

Delete the faulty file.

80032 Logs can be configured with events. These are 
triggered as soon as the log is full. Assuming 
WinCC Runtime is started and the log is already full, 
the event would never be triggered.
The specified log is full and no longer accepts data.

Close WinCC Runtime, delete the log, and restart 
WinCC Runtime.
Or:
Configure a button which contains the same actions as 
the event and press it.

80033 "System Defined" is set in the data log file as the 
data source name. This causes an error. No data is 
written to the database logs, whereas the logging to 
the CSV logs works.

Reinstall SQL Sever 2005 Express.

80034 An error has occurred in the initialization of the logs. 
An attempt has been made to create the tables as a 
backup. This action was successful. A backup copy 
of the tables of the corrupted log file was generated 
and the cleared log restarted.

No action is necessary. However, it is recommended to 
save the backup files or delete them in order to make 
the space available again.

80035 An error has occurred in the initialization of the logs. 
An attempt has been made to create backups of the 
tables and this has failed. No logging or backup has 
been performed.

It is recommended to save the backups or to delete them 
in order to release memory.

80044 The export of a log was interrupted because 
Runtime was closed or due to a power failure. At the 
restart of Runtime, it was detected that the export 
must be resumed.

The export resumes automatically.

80045 The export of a log was interrupted due to an error 
in the connection to the server or at the server itself.

The export is repeated automatically. Check:
● The connection to the server.
● If the server is running.
● If there is enough free space on the server.

80046 The destination file or the associated directory could 
not be created on the server.

Check whether there is enough space on the server and 
it you have permission to create the log file.

80047 The log could not be read while exporting it. Check whether the storage medium is correctly inserted.
80049 The log could not be renamed while preparing to 

export it. 
The job can not be completed."

Check whether the storage medium is correctly inserted 
and if there is sufficient space on the medium.

80050 The log which shall be exported is not closed.
 The job can not be completed.

Make sure to call the "CloseAllLogs" system function 
before using the "ExportLog" system function. Change 
the configuration as required.

80051 The log to be copied contains an invalid checksum.
The log was not copied.

Select a log with a valid checksum. The selected log 
may have been manipulated.

80052 The log cannot be read. Check the log and the specified path.
80053 The closed log cannot be read. Open the log.
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90000 - FDA alarms

Meaning of the system events   
All system events that can be displayed are listed below. 

Table 10-14 90000 - FDA alarms

Number Effect/causes Remedy
90024 No operator actions can be logged due to lack of 

space on the storage medium for log. The operator 
action will therefore not be executed.

Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90025 No user actions can be logged because of error 
state of the archive. Therefore the user action will 
not be executed.

Check whether the storage medium is correctly inserted.

90026 No operator actions can be logged because the log 
is closed. The operator action will therefore not be 
executed.

Before further operator actions are carried out, the log 
must be reopened with the help of system function 
"OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.
90029 Runtime was closed during ongoing operation 

(perhaps due to a power failure) or a storage 
medium in use is incompatible with Audit Trail. An 
Audit Trail is not suitable if it belongs to another 
project or has already been logged.
It could also be that archiving was not stopped 
before automatic execution of the 
"CloseAllArchives" function was started (e.g. by the 
task scheduler). 

Ensure that you are using the correct storage medium.

90030 Runtime was closed during ongoing operation 
(perhaps due to a power failure).

--

90031 Runtime was closed during ongoing operation 
(perhaps due to a power failure).

--

90032 Running out of space on the storage medium for log. Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90033 No more space on the storage medium for log. As 
of now, no more operator actions requiring logging 
will be executed.

Provide more storage space by inserting a blank storage 
medium, or backup the log files to the server using the 
"ExportLog" function.

90039 You do not have the necessary authorization to 
perform this action. 

Adapt or upgrade your authorizations.

90040 Audit Trail is switched off because of a forced user 
action.

Reactivate the "Audit Trail" with the help of system 
function "StartLog".

90041 A user action which has to be logged has been 
executed without a logged on user.

A user action requiring logging should only be possible 
with permission. Change the configuration by setting a 
required authorization for the input object.

90044 A user action which has to be confirmed was 
blocked, because there is another user action 
pending.

Repeat the user action if necessary.

90048 The Audit Trail  cannot be printed while data 
relevant to the audit is being logged.

Stop logging by calling system function "StopLogging".

90049 Access to required file is not possible. Check the network connection or the storage medium.
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90056 The recipe was not imported because the file 

contains no checksum.
Select a file with a checksum.
You can also disable checksum verification by calling 
system function "ImportDataRecords".

90057 The recipe was not imported because the file 
contains an invalid checksum. The selected file may 
have been manipulated.

Select a file with a valid checksum.

110000 - Offline function alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-15 110000 - Offline function alarms

Number Effect/causes Remedy
110000 The operating mode was changed. "Offline" mode 

is now set.
--

110001 The operating mode was changed. "Online" mode 
is now set.

--

110002 The operating mode was not changed. Check the connection to the PLCs.
Check whether the address range for the “Coordination" 
area pointer is present in the PLC.

110003 The operating mode of the specified PLC was 
changed by the "SetConnectionMode" system 
function.
 The "offline" operating mode is now set.

--

110004 The operating mode of the specified PLC was 
changed by the "SetConnectionMode" system 
function.
 The "online" operating mode is now set.

--

110005 An attempt was made to use the 
"SetConnectionMode" system function to set the 
specified PLC to "online" mode, although the entire 
system is in "offline" mode. This changeover is not 
allowed. The PLC remains in "offline" mode.

Switch the complete system to "online" mode and repeat 
execution of the system function.

110006 The content of the "project ID" area pointer does not 
match the project ID configured in WinCC. The 
WinCC Runtime is therefore terminated.

Check:
● the project ID entered on the PLC.
● the project ID entered in WinCC.

120000 - Trend alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 
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Table 10-16 120000 - Trend alarms

Number Effect/causes Remedy
120000 The trend is not displayed because you configured 

an incorrect axis to the trend or an incorrect trend.
Change the configuration.

120001 The trend is not displayed because you configured 
an incorrect axis to the trend or an incorrect trend.

Change the configuration.

120002 The trend is not displayed because the tag assigned 
attempts to access an invalid PLC address.

Check whether the data area for the tag exists in the 
PLC, the configured address is correct and the value 
range for the tag is correct.

130000 - System information alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-17 130000 - System information alarms

Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.

Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. Check the following conditions, for example:

● Access to the correct data carrier?
● Is a data carrier inserted?

130004 The data carrier is write-protected. The operation is 
canceled.

Check whether the correct data medium is being 
accessed. Remove the write-protection if necessary.

130005 The file is read only. The operation is canceled. Check whether the correct file is being accessed. 
Change the file attributes.

130006 No access to the file. The operation is canceled. Check the following conditions, for example:
● Is the correct file being accessed?
● Does the file exist?
● Is another action preventing concurrent access to the 

file?
130007 The network connection is interrupted.

Records cannot be saved or read via the network 
connection.

Check the network connection and eliminate the cause 
of error.

130008 No storage card available.
The specified records cannot be saved to or read 
from Storage Card.

Insert the storage card.

130009 The specified folder does not exist on the storage 
card.
The files stored in this directory are not backed up 
after switching off the HMI device.

Insert the storage card.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4085



Number Effect/causes Remedy
130010 The maximum nesting depth can be exhausted 

when, for example, value changes in a script initiate 
the call of an infinite number of further scripts.  
The configured functionality is not provided.

Check the configuration.

130013 No storage card available.
The specified records cannot be saved to or read 
from Storage Card.

Insert the storage card.

140000 - Connection alarms: Connection + device

Meaning of the system events   
All system events that can be displayed are listed below. 

Table 10-18 140000 - Connection alarms: Connection + device

Number Effect/causes Remedy
140000 An online connection to the PLC is established. --
140001 The online connection to the PLC was shut down. --
140003 No tag update or write operations are executed. Check whether the connection is up and the PLC is 

switched on.
In the Control Panel, check the set parameters using the 
"Set PG/PC interface" function.
Restart the system.

140004 No tag update or write operations are executed due 
to an incorrect access point, or incorrect module 
configuration.

Check the connection and whether the PLC is switched 
on.
Check the access point or the module configuration 
(MPI, PPI, PROFIBUS) in the Control Panel with "Set 
PG/PC interface".
Restart the system.

140005 No tag update or write operations are executed due 
to an incorrect HMI device address (possibly too 
high).

Use a different address for the HMI device.
Check the connection and whether the PLC is switched 
on.
Check the parameters set in the "Set PG/PC interface" 
dialog of the Control Panel.
Restart the system.

140006 No tag update or write operations are executed due 
to an incorrect baud rate setting.

Select a different baud rate in WinCC (according to 
module, profile, communication peer, etc.).
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140007 An incorrect bus profile prevents tag updates or 

write operations (see %1).
The following parameters could not be written to the 
registry database:
1:  Tslot
2:  Tqui
3:  Tset
4:  MinTsdr
5:  MaxTsdr
6:  Trdy
7:  Tid1
8:  Tid2
9:  Gap Factor
10: Retry Limit

Check the custom bus profile.
Check the connection and whether the PLC is switched 
on.
Check the parameters set in the "Set PG/PC interface" 
dialog of the Control Panel.
Restart the system.

140008 An incorrect baud rate prevents tag updates or write 
operations. The following parameters could not be 
written to the registry database: 
0:  General error
1:  Wrong version
2:  Profile cannot be written to the registry database.
3:  The subnet type cannot be written to the registry 
database.
4:  The Target Rotation Time cannot be written to 
the registry database.
5:  Incorrect Highest Station Address (HSA).

Check whether the connection is up and the PLC is 
switched on.
In the Control Panel, check the set parameters using the 
"Set PG/PC interface" function.
Restart the system.

140009 No tag updates or write operations because the S7 
communication module was not found.

To reinstall the module, open the Control Panel and 
select "Set PG/PC interface".

140010 No S7 communication partner found because the 
PLC is shut down.
DP/T:
The option "PG/PC is the only master" is not set in 
the Control Panel under "Set PG/PC interface".

Switch on the PLC.
DP/T:
If only one master is connected to the network, disable 
"PG/PC is the only master" in "Set PG/PC interface".
If several masters are connected to the network, enable 
these. Do not change any settings, for this will cause bus 
errors.

140011 No tag updates or write operations because 
communication is down.

Check the connection and whether the communication 
partner is switched on.

140012 Initialization error (e.g. if WinCC Runtime was 
closed in Task Manager).
Or:
Another application (e.g. STEP 7) with different bus 
parameters is active and the driver cannot be 
started with the new bus parameters (baud rate, for 
example).

Restart the HMI device.
Or:
Start WinCC Runtime and then start your other 
applications.

140013 The MPI cable is disconnected and, therefore, there 
is no power supply.

Check the connections.

140014 The configured bus address is in use by another 
application.

Change the HMI device address in the PLC 
configuration.

140015 Incorrect baud rate
Or: 
Incorrect bus parameters (e.g. HSA)
Or:
OP address > HSA or: Incorrect interrupt vector 
(interrupt not registered by the driver)

Correct the parameters.
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140016 The hardware does not support the configured 

interrupt.
Change the interrupt number.

140017 The set interrupt is in use by another driver. Change the interrupt number.
140018 SIMOTION Scout disabled the consistency check. 

Only a corresponding note appears.
In SIMOTION Scout, reactivate the consistency check 
and once again download the project to the PLC.

140019 SIMOTION Scout is downloading a new project to 
the PLC. Connection to the PLC is canceled.

Wait until the end of the reconfiguration.

140020 Mismatch of the PLC and project (FWX file) 
versions.
The connection to the PLC is canceled.

The following remedies are available:
Download the current version to the PLC using 
SIMOTION Scout.
Recompile the project using WinCC ES, close 
WinCC Runtime, and restart with the new configuration.

140021 Setup of the connection to the PLC failed. Incorrect 
configuration of the "Access password" for the 
connection to the PLC.

Select the "Access password" area in the "Connections" 
editor to check the password entered for the connection 
to the PLC.
Assign the correct password.
The "Password" for the connection to the PLC is 
assigned in the "Security" area of the PLC properties.

140022 Setup of the connection to the PLC failed. 
Incorrect configuration of the access password for 
the connection to the PLC.

Select the "Access password" area in the "Connections" 
editor to check the password entered for the connection 
to the PLC. 
The "Password" for the connection to the PLC is 
assigned in the "Security" area of the PLC properties.

140025 Setup of the connection to the PLC failed. 
The access password of the PLC is disabled in the 
PLC display.

Enable the access password in the PLC display.

160000 - Connection alarms: OPC: Connection

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-19 160000 - Connection alarms: OPC: Connection

Number Effect/causes Remedy
160000 No more data is read or written. Possible causes:

● The cable connection is interrupted.
● The PLC does not respond or has failed, etc.
● The wrong port is used for the connection.
● System overload

Check whether the cable is plugged in and the PLC is 
OK, and whether the correct port is used.
Restart the system if the system event persists.

160001 The connection is recovered because the cause of 
the interruption has been eliminated.

--

160010 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check access rights.
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160011 No connection to the server because the server ID 

(CLS-ID) cannot be determined.
Values cannot be read or written.

Check the following conditions, for example:
● Correct server name?
● Correct station name?
● Is the server registered?

160012 No connection to the server because the server ID 
(CLS-ID) cannot be determined.
Values cannot be read or written.

Check the following conditions, for example:
● Correct server name?
● Correct station name?
● Is the server registered?
Note for advanced users:
Interpret the value from HRESULT. 

160013 The specified server was started as InProc server. 
This has not been released and may lead to 
undefined behavior because the server is running 
in the same process area as WinCC Runtime.

Configure the server as OutProc Server or Local Server.

160014 Only one OPC server project can be started on a 
PC/MP. An alarm is output after an attempt was 
made to start a second project.
The second project has no OPC server functionality 
and cannot be located as an OPC server by external 
sources.

Do not start a second project with OPC server 
functionality on the computer.

170000 - S7 dialog alarms

Meaning of the system alarms
All system alarms that can be displayed are listed below. 

Table 10-20 170000 - S7 dialog alarms

Number Effect/causes Remedy
170000 S7 diagnostics events are not indicated because it 

is not possible to log on to the S7 diagnostics 
functions at this device. The service is not 
supported.

--

170001 The S7 diagnostics buffer cannot be viewed 
because communication with the PLC is shut down.

Set the PLC to online mode.

170002 The S7 diagnostics buffer cannot be viewed 
because reading of the diagnostics buffer (SSL) 
was canceled with error.

--

170003 An S7 diagnostics event cannot be visualized. The 
system returns internal error %2.

--

170004 An S7 diagnostics event cannot be visualized. The 
system returns an internal error of error class %2, 
error number %3.

--

170007 It is not possible to read the S7 diagnostics buffer 
(SSL) because this operation was canceled with an 
internal error of class %2 and error code %3.

--
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180000 - General alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-21 180000 - General alarms

Number Effect/causes Remedy
180000 A component/OCX received configuration data with 

a version ID which is not supported.
Install a newer component.

180001 System overload because too many actions are 
running in parallel. Certain actions can be executed, 
while others are discarded.

Several remedies are available:
● Generate alarms at a slower rate (polling).
● Initiate scripts and functions at greater intervals.
If the alarm appears more frequently:
Restart the HMI device. 

180002 The screen keyboard could not be activated. 
Possible causes:
"TouchInputPC.exe" was not registered due to 
faulty Setup.

Reinstall WinCC Runtime.

190000 - Tag alarms

Meaning of the system events  
All system events that can be displayed are listed below. 

Table 10-22 190000 - Tag alarms

Number Effect/causes Remedy
190000 It is possible that the tag is not updated. --
190001 The tag is updated after the cause of the last error 

state has been eliminated (recovery of normal 
operation).

--

190002 The tag is not updated because communication with 
the PLC is down.

Select system function "SetOnline" to enable 
communication.

190004 The tag is not updated because the address 
configured for this tag does not exist.

Check the configuration.

190005 The tag is not updated because the configured PLC 
type does not exist for this tag.

Check the configuration.

190006 The tag is not updated because it is not possible to 
map the PLC type in the data type of the tag.

Check the configuration.

190007 The tag value is not modified because the 
connection to the PLC is interrupted or the tag is 
offline.

Set online mode or reconnect to the PLC.
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190008 The configured tag limits were violated due to one 

of the following events:
● Value input
● System function
● Script

Observe the configured or current tag limits.

190009 An attempt was made to assign this tag a value that 
is outside the valid range of values for this data type.
For example, input of the value 260 for a byte tag, 
or input of the value -3 for an unsigned word tag.

Observe the range of values for the data type of the tags.

190010 The rate at which values are written to the tag is too 
high (e.g. initiated in a script loop).
Values will be lost because buffer capacity is limited 
to 100 operations.

The following remedies are available:
● Extend the interval between multiple write actions.
● Do not use an array tag longer than 6 words when 

configuring an acknowledgment on the HMI device 
using "HMI acknowledgment tag".

190011 Possible cause 1:
The value entered could not be written to the 
configured PLC tag because the high or low limit 
was exceeded.
The system discarded the entry and restored the 
original value.
Possible cause 2:
The connection to the PLC was interrupted.

 
Note that the value entered must be within the range of 
values of the control tag.
 
 
 
 
Check the connection to the PLC.

190012 It is not possible to convert a value from a source 
format to a target format, for example:
An attempt is being made to write a counter value 
that is outside the valid, PLC-specific range of 
values.
A tag of the type Integer should be assigned a value 
of the type string.

Check the range of values, or the data type of the tag.

190013 You entered a string that exceeds the tag length. 
The string is truncated automatically to a valid 
length.

Always enter strings that do not exceed the valid tag 
length.
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190100 - Area pointer alarms

190100 - Area pointer alarms 

Number Effect/causes Remedy
190100 The area pointer is not updated because the 

address configured for this pointer does not exist.
Type
1  Warnings
2  Errors
3  PLC acknowledgment
4  HMI device acknowledgment
5  LED image
6  Trend request
7  Trend transfer 1
8  Trend transfer 2
No.:
Consecutive number displayed in WinCC ES.

Check the configuration.

190101 The area pointer is not updated because it is not 
possible to map the PLC type to the area pointer 
type.
Parameter type and no.:
see alarm 190100

--

190102 The area pointer is updated after the cause of the 
last error state has been eliminated (recovery of 
normal operation). Parameter type and no.: See 
alarm 190100.

--

200000 - PLC coordination alarms

200000 - PLC coordination alarms

Number Effect/causes Remedy
200000 Coordination is not executed because the address 

configured in the PLC does not exist/is not set.
Change the address or set up the address in the PLC.

200001 Coordination is canceled because the write access 
to the address configured in the PLC is not possible.

Change the address or set the address in the PLC at an 
area which allows write access.

200002 Coordination is not carried out at the moment 
because the address format of the area pointer 
does not match the internal storage format.

Internal error

200003 Coordination can be executed again because the 
last error state is eliminated (return to normal 
operation).

--

200004 The coordination may not be executed. --
200005 No more data is read or written. Possible causes:

● The cable is defective.
● The PLC does not respond, is defective, etc.
● System overload

Ensure that the cable is plugged in and the PLC is 
operational.
Restart the system if the system alarm persists.
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210000 - PLC job alarms

210000 - PLC job alarms

Number Effect/causes Remedy
210000 Jobs are not processed because the configured 

address does not exist/has not been set up in 
the PLC.

Change the address or set up the address in the PLC.

210001 Jobs are not processed because read/write 
access to the configured address is not possible 
in the PLC.

Change the address, or set up the address in a PLC 
area at which read/write access is possible.

210002 Jobs are not executed because the address 
format of the area pointer does not match the 
internal storage format.

Internal error

210003 The job buffer is processed again because the 
last error status has been eliminated (recovery 
of normal operation).

--

210004 The job buffer is possibly not going to be 
processed.

--

210005 A job mailbox with invalid number was initiated. Check the PLC program.
210006 An error occurred while executing the job 

mailbox. As a result, the control job is not 
executed. Observe the next/previous system 
event.

Check the parameters of the control job. Recompile 
the configuration data.

220000 - WinCC communication driver alarms

220000 - WinCC communication driver alarms 

Number Effect/causes Remedy
220001 The tag is not downloaded because write access 

to data type Bool/Bit  is not supported by the 
sublevel communication driver/HMI device.

Change the configuration.

220002 The tag is not downloaded because write access 
to data type Byte  is not supported by the 
sublevel communication driver/HMI device.

Change the configuration.

220003 The communication driver cannot be loaded as 
it is possibly not installed.

Install the driver by reinstalling WinCC Runtime.

220004 Communication is down and no update data is 
transferred because the cable is not connected 
or defective etc.

Check the connection.

220005 Communication is up. --
220006 The connection between the specified PLC and 

the specified port is active.
--
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220007 The connection to the specified PLC is 

interrupted at the specified port.
Check the following:
● Is the cable plugged in?
● Is the PLC OK?
● Is the right port being used?
● Is your configuration OK (port parameters, 

protocol settings, PLC address)?
Restart the system if the system event persists.

220008 The communication driver cannot access or 
open the specified port. This port might be in use 
by another application, or a port that does not 
exist on the target device is being used.
No communication with the PLC.

Close all applications that access the port and restart 
the computer.
Use another port that exists in the system.

230000 - Screen object alarms

230000 - Screen object alarms 

Number Effect/causes Remedy
230000 The value entered could not be used. The system 

discards this entry and restores the previous 
value.
Possible causes:
● The range of values is exceeded.
● You entered invalid characters
● The valid maximum number of users has 

been exceeded.

Enter a practical value, or delete a user that is no 
longer required.

230002 The user currently logged on does not have the 
necessary authorization, so the system discards 
the entry and restores the previous value.

Log on as user with appropriate authorization.

230003 Change to the specified screen failed because 
this screen is not available/configured. The 
current screen remains selected.

Configure the screen and check the selection 
function.

230005 The range of values of the tag has been 
exceeded in the I/O field.
The original tag value is retained.

Observe the range of values for the tag when 
entering a value.

230100 During navigation in the Web browser, the 
system returned a message which may be of 
interest to the user.
The Web browser continues to run but may not 
(fully) show the new page.

Navigate to another page.

230200 The HTTP channel connection was interrupted 
due to an error. This error is explained in detail 
by another system event.
Data is no longer exchanged.

Check the network connection.
Check the server configuration.

230201 The HTTP channel connection is set up.
Data is exchanged.

--
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230202 WININET.DLL has detected an error. Usually, 

this error occurs if it is not possible to connect to 
the server, or the server denies a connection 
because the client lacks proper authorization.
An unknown server certificate may also be the 
cause if the connection is encrypted by means of 
SSL.
The alarm text provides details.
This text is always in the language of the 
Windows installation because it is returned by the 
Windows OS.
Process values are no longer exchanged.
The part of the alarm returned by the Windows 
OS might not be displayed, e.g. "An error has 
occurred". WININET.DLL returns the following 
error: Number: 12055 Text:HTTP: <no error text 
available>."

Depending on the cause:
When an attempt to connect fails, or a timeout occurs:
● Check the network connection and the network.
● Check the server address.
● Check whether the WebServer is actually running 

on the target station.
Incorrect authorization:
● The configured user name and/or password do 

not match the entries on the server. Set 
consistent data.

If the server certificate is rejected:
Certificate signed by an unknown CA ( ):
● Ignore this point, or install a certificate that has 

been signed with one of the root certificates 
known to the client station.

The date of the certificate is invalid:
● Ignore this point, or install a certificate with valid 

date on the server.
Invalid CN (Common Name or Computer Name):
● Ignore this point, or install a certificate with a 

name that corresponds to the server address.
230203 Although a connection can be made to the 

server, the HTTP server refused to connect. 
Possible causes:
● WinCC Runtime does not run on the server
● The HTTP channel is not supported (503 

Service unavailable).
Other errors can only occur if the Webserver 
does not support the HTTP channel. The 
language of the alarm text depends on the 
Webserver.
Data is not exchanged.

On 503 Service unavailable error:
Check whether WinCC Runtime is running on the 
server and whether the HTTP channel is supported.

230301 Internal error. An English text explains the error 
in more detail. The error may be caused by 
insufficient memory.
OCX does not work.

--

230302 The name of the remote server cannot be 
resolved.
An attempt to connect has failed.

Check the configured server address.
Check whether the DNS service is available on the 
network.

230303 The remote server is not running on the 
addressed computer.
incorrect server address.
An attempt to connect has failed.

Check the configured server address.
Check whether the remote server is running on the 
target computer.

230304 The remote server on the addressed computer is 
incompatible with VNCOCX.
An attempt to connect failed.

Use a compatible remote server.

230305 Authentication has failed due to incorrect 
password.
An attempt to connect failed.

Configure the correct password.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4095



Number Effect/causes Remedy
230306 Error in the connection to the remote server. This 

may occur as a result of network problems.
An attempt to connect failed.

Check whether the network cable is plugged in, or 
whether there are network problems.

230307 The connection to the remote server was shut 
down. Possible causes:
● The remote server was shut down
● The user instructed the server to close all 

connections.
The connection is cancelled.

--

230308 This alarm provides information on the 
connection status.
An attempt is made to connect.

--

240000 - Authorization alarms

240000 - Authorization alarms 

Number Effect/causes Remedy
240000 WinCC Runtime is running in demo mode.

You have no authorization, or your authorization 
is corrupted.

Install the authorization.

240001 WinCC Runtime is running in demo mode.
You configured too many tags for the installed 
version.

Load an adequate authorization / powerpack.

240002 WinCC Runtime is running with time-limited 
emergency authorization.

Restore the full authorization.

240004 Error when reading the emergency authorization.
WinCC Runtime is running in demo mode.

Restart WinCC Runtime. Install or repair the 
authorization (see Commissioning Instructions for 
Software Protection).

240005 Automation License Manager has detected an 
internal system error. 
Possible causes:
● Corrupted file
● Faulty installation
● No free memory space for Automation 

License Manager, or similar.

Restart the HMI device/PC. If this procedure does not 
solve the problem, remove and then reinstall 
Automation License Manager.
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250000 - S7 Status/Force alarms

250000 - S7 Status/Force alarms

Number Effect/causes Remedy
250000 The tag in the specified line in "Status Force" is 

not updated because the address configured for 
this tag is not available.

Check the set address and then verify that the 
address is set up in the PLC.

250001 The tag in the specified line in "Status Force" is 
not updated because the PLC type configured 
for this tag does not exist.

Check the set address.

250002 The tag in the specified line in "Status Force" is 
not updated because it is not possible to map the 
PLC type in the tag type.

Check the set address.

250003 An attempt to connect to the PLC failed. The tags 
are not updated.

Check the connection to the PLC. Check that the PLC 
is switched on and is online.

260000 - Password system alarms

260000 - Password system alarms   

Number Effect/causes Remedy
260000 An unknown user or an unknown password has 

been entered in the system.
The current user is logged off from the system.

Log on to the system as a user with a valid password.

260001 The logged in user does not have sufficient 
authorization to execute the protected functions 
on the system.

Log on to the system as a user with sufficient 
authorization.

260002 This alarm output when the "TrackUserChange" 
system function is triggered.

--

260003 The user has logged off from the system. --
260004 The user name entered into the user view 

already exists in the user management.
Select another user name because user names have 
to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.
260006 The entry is discarded. Use a shorter or longer password.
260007 The logoff time entered is outside the valid range 

from 0 to 60 minutes.
The new value entered is discarded and the 
original value is retained.

Enter a logon timeout value between 0 and 60 
minutes.

260008 An attempt was made in WinCC to read a 
PTProRun.pwl file created with ProTool V 6.0.
Reading of the file was canceled due to 
incompatibility of the format.

--

260009 You have attempted to delete the user 
"Administrator" or "PLC User". These users are 
fixed components of the user management and 
cannot be deleted.

If you need to delete a user, because perhaps you 
have exceeded the maximum number permitted, 
delete another user.
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260012 The password entries in the "Change Password" 

dialog and in the confirmation field do not match.
The password is not changed. User will be 
logged off.

You have to log on to the system again. Then enter 
the identical password twice to be able to change the 
password.

260013 The password entered in the "Change 
Password" dialog is invalid because it is already 
in use.
The password is not changed. User will be 
logged off.

You have to log on to the system again. Then enter a 
new password that has not been used before.

260014 You have tried to log on with an incorrect 
password three times in a row.
You will be locked out and assigned to group no. 
0.

You can log on to the system with your correct 
password. Only an administrator can change the 
assignment to a group.

260024 The password you entered does not meet the 
necessary security guidelines.

Enter a password that contains at least one number.

260025 The password you entered does not meet the 
necessary security guidelines.

Enter a password that comprises at least three 
characters.

260028 Upon system start-up, an attempt to log on, or 
when trying to change the password of a 
SIMATIC log-on user, the system attempts to 
access the SIMATIC Logon Server.
If attempting to log on, the new user is not logged 
in. If a different user was logged on before, then 
this user is logged off.

Check the connection to the SIMATIC Logon Server 
and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.

260030 The SIMATIC Logon user could not change his 
password on the SIMATIC Logon Server. The 
new password is possibly noncompliant with 
password rules set on the server, or the user is 
not authorized to change his password.
The old password remains and the user is 
logged off.

Log in again and choose a different password. Check 
the password rules on the SIMATIC Logon Server.

260033 The action change password or log on user 
could not be carried out.

Check the connection to the SIMATIC Logon Server 
and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.

260034 The last logon operation has not yet ended. A 
user action or a logon dialog can therefore not 
be called.
The logon dialog is not opened. The user action 
is not executed.

Wait until the logon operation is complete.

260035 The last attempt to change the password was 
not completed. A user action or a logon dialog 
can therefore not be called.
The logon dialog is not opened. The user action 
is not executed.

Wait until the procedure is complete.
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260036 There are insufficient licenses on the SIMATIC 

Logon Sever. The logon is not authorized.
Check the licensing on the SIMATIC Logon Server.

260037 There is no license on the SIMATIC Logon 
Sever. A logon is not possible.
It is not possible to log on via the SIMATIC Logon 
Server, only via a local user.

Check the licensing on the SIMATIC Logon Server.

260040 The system attempts to access the SIMATIC 
Logon Server upon system start-up or when 
trying to change the password.
If attempting to log on, the new user is not logged 
in. If a different user was logged on before, then 
this user is logged off.

Check connection to the domain and its configuration 
in the Runtime security settings editor.
Or use a local user.

260043 It was not possible to log the user on to the 
SIMATIC Logon Server. The user name or the 
password could be incorrect or the user does not 
have sufficient rights to log on.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Try again. If necessary, check the password data on 
the SIMATIC Logon Server.

260044 It was not possible to log the user on to the 
SIMATIC Logon Server as his account is 
blocked.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Check the user data on the SIMATIC Logon Server.

260045 The SIMATIC Logon user is not associated to 
any or several groups.
The new user is not logged in. If a different user 
was logged on before, then this user is logged 
off.

Check user data on the SIMATIC Logon Server and 
the configuration in your WinCC project. A user may 
only be assigned to one group.

270000 - System alarms

270000 - System Alarms

Number Effect/causes Remedy
270000 The alarm does not indicate the tag because it 

is accessing an invalid address in the PLC.
Check whether the data area for the tag exists on the 
PLC, whether the configured address is correct, and 
whether the value range for the tag is correct.

270001 There is a device-specific limit as to how many 
alarms may be queued for viewing (see the 
operating instructions). This limit has been 
exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm 
buffer.

--
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270002 The view shows alarms of a log for which there 

is no data in the current project.
Placeholders are output for the alarms.

Delete old log data, if necessary.

270003 The service cannot be set up because too many 
devices want to access this service.
A maximum of four devices can execute this 
action.

Reduce the number of HMI devices which want to use 
the service.

270004 Access to the persistent alarm buffer is not 
possible. Alarms cannot be restored or backed 
up.

If the problems persist at the next restart, contact 
Customer Support (delete Flash).

270005 Persistent alarm buffer corrupted: Alarms 
cannot be restored.

If the problems persist at the next restart, contact 
Customer Support (delete Flash).

270006 Project modified: Alarms cannot be restored 
from the persistent alarm buffer.

The project was compiled and downloaded again to 
the HMI device. The error should no longer occur at 
the next restart of the HMI device.

270007 A configuration problem is preventing you from 
the restoring the data (e.g. a DLL was deleted, 
or unknown directory).

Update the operating system and download your 
project again to the HMI device.

290000 - Recipe system alarms

290000 - Recipe system alarms 

Number Effect/causes Remedy
290000 The recipe tag could not be read or written. It is 

assigned the start value.
The alarm can be entered in the alarm buffer for 
up to four more faulty tags. After that, alarm 
290003 is output.

Check the configuration to see whether the address 
has been set up in the PLC.

290001 An attempt was made to assign the recipe tag a 
value that is outside the valid range of values for 
this type.
The alarm can be entered in the alarm buffer for 
up to four more faulty tags if necessary. After 
that, alarm 290004 is output.

Observe the range of values for the tag type.

290002 It is not possible to convert a value from a source 
format to a target format.
The alarm can be entered in the alarm buffer for 
up to four more faulty recipe tags if necessary. 
After that, alarm 290005 is output.

Check the range of values or type of the tag.

290003 This alarm is output after alarm 290000 was 
triggered more than five times.
In this case, no further separate alarms are 
generated.

Check the configuration to see whether the tag 
addresses have been set up in the PLC.

290004 This alarm is output after alarm 290001 was 
triggered more than five times.
In this case, no further separate alarms are 
generated.

Observe the range of values for the tag type.
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290005 This alarm is output after alarm 290002 was 

triggered more than five times.
In this case, no further separate alarms are 
generated.

Check the range of values or type of the tag.

290006 The limits configured for the tag have been 
exceeded by the values entered.

Observe the configured or current tag limits.

290007 There is a difference between the source and 
target structure in the recipe currently being 
processed. The target structure contains an 
additional recipe tag that is not available in the 
source structure.
The recipe tag specified is assigned its start 
value.

Insert the specified recipe tag into the source 
structure.

290008 There is a difference between the source and 
target structure in the recipe currently being 
processed.The source structure contains an 
additional recipe tag that is not available in the 
target structure and cannot be assigned.
The value is discarded.

Remove the specified recipe tag in the specified 
recipe from the project.

290010 The storage location configured for the recipe is 
invalid.
Possible causes:
Invalid characters, write protection, data carrier 
out of space or not available.

Check the configured storage location.

290011 A data record of the specified number does not 
exist.

Check the source for the number (constant or tag 
value).

290012 A recipe of the specified number does not exist. Check the source for the number (constant or tag 
value).

290013 An attempt was made to save a data record 
under a data record number that already exists.
The operation is not executed.

The following remedies are available:
● Check the source for the number (constant or tag 

value).
● First, delete the data record.
● Modify the "Overwrite" function parameter.

290014 The specified import file was not found. Check the following:
● The file name
● Ensure that the file is in the specified directory.

290020 Check back to verify that the download of data 
records from the HMI device to the PLC has 
started. 

--

290021 Check back to verify that the download of 
records from the HMI device to the PLC was 
completed.

--

290022 Check back to indicate that the download of data 
records from the HMI device to the PLC was 
canceled due to an error.

Check the following conditions in the configuration:
● Are the tag addresses configured in the PLC?
● Does the recipe number exist?
● Does the data record number exist?
● Is the "Overwrite" function parameter set?
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290023 Check back to verify that the download of data 

records from the PLC to the HMI device has 
started.

--

290024 Check back to verify that the download of data 
records from the PLC to the HMI device was 
completed.

---

290025 Check back to indicate that the download of data 
records from the PLC to the HMI device was 
canceled due to an error.

Check the following conditions in the configuration:
● Are the tag addresses configured in the PLC?
● Does the recipe number exist?
● Does the data record number exist?
● Is the "Overwrite" function parameter set?

290026 An attempt was made to read/write a data record 
that is not free at present.
This error can occur if recipes were configured 
for download with synchronization.

Set the mailbox status to zero.

290027 Unable to connect to the PLC at present. As a 
result, the data record cannot be read or written.
Possible causes:
No hardware connection to the PLC (no cable 
plugged in, cable is defect), or the PLC is 
switched off.

Check the connection to the PLC.

290030 This alarm is output after you selected screen 
which contains a recipe view in which a data 
record is already selected.

Reload the data record from the storage location, or 
retain the current values.

290031 While saving, it was detected that a data record 
with the specified number already exists.

Overwrite the data record, or cancel the action.

290032 During the export of data records, a file with the 
specified name was found.

Overwrite the file, or cancel the process.

290033 Confirmation prompt before deleting data 
records.

--

290040 A data record error with error code %1 that 
cannot be described in more detail occurred.
The action is canceled.
It is possible that the mailbox was not installed 
correctly on the PLC.

Check the storage location, the data record, the "Data 
record" area pointer, and the connection to the PLC.
Restart the action after a short waiting time.
If the error persists, contact Customer Support. 
Forward the relevant error code to Customer Support.

290041 A data record or file cannot be saved because 
the storage location is out of sufficient space.

Delete files no longer required.

290042 An attempt was made to execute several recipe 
actions simultaneously. The last action is not 
executed.

Retrigger the action after a short waiting time.

290043 Confirmation prompt before saving data records. --
290044 The database for the recipe was corrupted and 

will be deleted.
--

290050 A check back indicates that the export of data 
records was started.

--

290051 A check back indicates successful completion of 
the export of data records.

--
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290052 A check back indicates that the export of data 

records was canceled due to an error.
Ensure that the structure of the data records at the 
storage location and the current recipe structure on 
the HMI device are identical.

290053 A check back indicates that the import of records 
was started.

--

290054 A check back indicates successful completion of 
the import of data records.

--

290055 A check back indicates that the import of data 
records was canceled due to an error.

Ensure that the structure of the data records at the 
storage location and the current recipe structure on 
the HMI device are identical.

290056 Error when reading/writing the value in the 
specified row/column.
The action was canceled.

Check the specified row/column.

290057 The tags of the recipe specified were toggled 
from "offline" to "online" mode.
Each change of a tag in this recipe is now 
immediately transferred to the PLC.

--

290058 The tags of the specified recipe were toggled 
from "online" to "offline" mode.
Modifications to tags in this recipe are no longer 
immediately transferred to the PLC but must be 
transferred there explicitly by downloading a 
data record.

--

290059 A check back indicates that the specified record 
was successfully saved.

--

290060 A check back indicates that the specified data 
record memory was cleared.

--

290061 A check back indicates that deletion of the data 
record memory was canceled due to an error.

--

290062 The data record number exceeds the maximum 
of 65536.
This data record cannot be created.

Select another number.

290063 This occurs when you execute system function 
"ExportDataRecords" while the "Overwrite" 
parameter is set to "No". 
An attempt was made to save a recipe under a 
file name that already exists.
The export is canceled.

Check the parameters of the "ExportDataRecords" 
system function.

290064 A check back indicates that the deletion of data 
records was started.

--

290065 A check back indicates successful completion of 
the deletion of data records.

--

290066 Confirmation prompt before deleting data 
records.

--

290068 Confirmation prompt for deletion of all recipe 
data records.

--

290069 Confirmation prompt for deletion of all recipe 
data records.

--

290070 The data record specified was not found in the 
import file.

Check the source of the data record number, or the 
data record name (constant, or tag value).
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290071 When the editing data record values, you 

entered a value that is below the low limit of the 
recipe tag.
The entry is discarded.

Enter a value within the recipe tag limits.

290072 When editing data record values, you entered a 
value that exceeds the high limit of the recipe tag.
The entry is discarded.

Enter a value within the recipe tag limits.

290073 An action (e.g. saving a record) failed for an 
unknown reason.
The error corresponds to status alarm 
IDS_OUT_CMD_EXE_ERR in the large recipe 
view.

--

290074 While saving, a data record with the specified 
number but with different name was found.

Overwrite the record, change the record number or 
cancel the action.

290075 A data record of this name already exists.
The data record is not saved.

Select a different data record name.

290110 The default values could not be set due to an 
error.

--

290111 The recipes subsystem cannot be used. Recipe 
views have no content and recipe-specific 
functions will not be executed.
Possible causes:
● Error when loading the recipes.
● The recipe structure was changed in the ES. 

The recipes were not included in the latest 
project download. This means that the new 
configuration data no longer matches the old 
recipes on the device.

Download the project to the device again, including 
the recipes (the corresponding check box in the 
download dialog must be check marked).

300000 - Alarm_S alarms

300000 - Alarm_S alarms

Number Effect/causes Remedy
300000 Faulty configuration of process monitoring (e.g. 

using PDiag or S7 Graph): More alarms are 
queued than specified in the specifications of the 
CPU. No further ALARM_S alarms can be 
managed by the PLC and reported to the HMI 
devices.

Change the PLC configuration.

300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S 
service.
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310000 - Reporting alarms

310000 - Reporting alarms

Number Effect/causes Remedy
310000 An attempt is being made to print too many 

reports in parallel.
Only one log file can be output to the printer at 
a given time; the print job is therefore rejected.

Wait until the previous active log was printed.
Repeat the print job if necessary.

310001 An error occurred on triggering the printer. The 
report is either not printed or printed with errors.

Evaluate the additional system alarms related to this 
alarm.
Repeat the print job if necessary.

330000 - Interaction alarms

330000 - Interaction alarms 

Number Effect/causes Remedy
330022 Too many open dialogs on the HMI device. Close all dialogs you do not require on the HMI device.

 

 

350000 - PROFIsafe alarms

350000 - PROFIsafe alarms  

Number Effect/causes Remedy
350000 PROFIsafe packets were not received within the 

specified time.
There is a communication problem with the F-
CPU. 
RT is terminated.

Check the WLAN connection.

350001 PROFIsafe packets were not received within the 
specified time.
There is a communication problem with the F-
CPU.
The PROFIsafe connection is set up again.

Check the WLAN connection.

350002 Internal error.
Runtime is terminated.

Internal error

350003 Check back for indicating the connection setup 
to the F-CPU.
The Emergency-Off buttons are active 
immediately.

--
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Number Effect/causes Remedy
350004 PROFIsafe communication was set up and the 

connection was shut down.
Runtime can be terminated.
The Emergency-Off buttons are deactivated 
immediately.

--

350005 Incorrect address configured for the F-Device.
A PROFIsafe connection cannot be set up.

Check and modify the address of the F-Device in 
WinCC ES.

350006 The project was started. At the start of the 
project, check the proper function of the ACK 
buttons. 

Press the two ACK buttons successively in the 
"Acknowledge" and "Panic" positions.

350008 You configured an incorrect number of failsafe 
buttons.
A PROFIsafe connection cannot be set up.

Modify the number of failsafe buttons in the project.

350009 The device is in Override mode. 
It may no longer be possible to detect the 
location because transponder detection fails.

Exit the override mode.

350010 Internal error: The device has no failsafe buttons. Return the device to Siemens.
Worldwide contact partners

10.3.6.9 System events for Runtime Professional

Introduction  
The system events generated by the various WinCC modules are described below. You can 
integrate these events into your alarm system using the "WinCC - System Events" menu 
command.

 

 Note

You can obtain additional information on the system events in the "Comment" block of the 
active alarm.

 

WinCC system events

Number Error message / description
1000000 WCCRT:Error
1000001 WCCRT:Error on loading the object engine
1000002 WCCRT:Channel could not be loaded
1000003 WCCRT:Tag - Violated lower limit
1000004 WCCRT:Tag - Violated upper limit
1000005 WCCRT:Error on formatting a tag
1000006 WCCRT:Error on scaling a tag
1000100 WCCRT:Driver error
1000200 WCCRT:Status
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Number Error message / description
1000201 WCCRT:Object engine has been loaded
1000202 WCCRT:Runtime has been activated
1000203 WCCRT:Runtime has been deactivated
1000204 WCCRT:Connection not established
1000205 WCCRT:Connection established
1000206 WCCRT:Client connection established
1000207 WCCRT:Client connection disconnected
1000208 WCCRT:Client connection broken
1000209 WCCRT:Connection deleted
1000210 WCCRT:Connection modified
1000211 WCCRT:Connection reestablished
1000300 WCCRT:Driver status
1000800 PACKAGE:Import
1000801 PACKAGE:Export
1000802 PACKAGE:Delete
1000803 PACKAGE:New
1000804 PACKAGE:Reload
1000805 PACKAGE:DefaultServer
1000806 PACKAGE:Implicit update
1000807 PACKAGE:Update
1000900 PERFMON: is low
1000901 PERFMON: is OK
1000902 PERFMON: is high
1000903 PERFMON: is OK
1000904 PERFMON: is low
1000905 PERFMON: is OK
1000906 PERFMON: is high
1000907 PERFMON: is OK
1000908 PERFMON: is low
1000909 PERFMON: is OK
1000910 PERFMON: is high
1000911 PERFMON: is OK
1000912 PERFMON:Redundancy loss of terminal adapter @2%s@
1000913 PERFMON:Redundancy of terminal adapter @2%s@ restored
1000914 PERFMON:Terminal adapter @2%s@ connected.
1000915 Terminal adapter @2%s@ separated. @2%s@: MAC address of the network card
1001000 PDLRT: General error
1001001 PDLRT: Operator action not active
1001002 PDLRT: Wrong picture format
1001003 PDLRT: Picture not found
1001004 PDLRT: No dynamic active in picture
1001005 PDLRT: Tag could not be written
1001006 PDLRT: Dynamic actions in picture are not active
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Number Error message / description
1002000 TLGRT: General error
1002001 TLGRT: Error during initialization
1002002 TLGRT: Error loading the runtime data
1002003 TLGRT: Error changing languages
1002004 TLGRT: Error accessing the database
1002005 TLGRT: Error creating runtime objects
1002006 TLGRT: Error in online configuration
1002007 TLGRT: Error in client/server environment
1002008 TLGRT: Error in memory management
1002009 TLGRT: Error compiling measured values
1002010 TLGRT: Error processing measured values
1002011 TLGRT: Error archiving measured values
1002012 TLGRT: Error in Normalization DLL
1002013 TLGRT: Error in user recipe option
1002014 TLGRT: Error in process controlled archiving
1002015 TLGRT: Error in API
1002016 TLGRT: Error in application window
1002017 TLGRT: System fault
1002018 TLGRT: Error overflow in database queue
1002019 TLGRT: Error overflow in notification queue
1002020 TLGRT: Error overflow of the Normalization DLL queue - loss of data!
1002021 TLGRT:Problem with the connection to the central log server!
1002022 TLGRT:The error in the connection to the central log server has been eliminated
1003018 ALGRT:Alarm does not require acknowledgment.

An attempt was made to acknowledge a alarm that does not require acknowledgment.
1003019 ALGRT:Alarm has already been acknowledged

An attempt was made to acknowledge a alarm that has already been acknowledged.
1003020 ALGRT:Alarm class for the alarm not found

The alarm class associated with the alarm does not exist.
1003021 ALGRT:Alarm status cannot be processed

The alarm status (Incoming, Outgoing, Acknowledged, ...) could not be interpreted.
1003022 ALGRT:Alarm is locked

This alarm occurs if you attempt to trigger a locked alarm via the API.
1003023 ALGRT:Alarm date/time-stamp invalid

The date/time stamp from the AS could not be interpreted.
1003032 ALGRT:Alarm window template name unknown

This error occurs when a alarm window that was previously configured in the Graphics 
Design is deleted subsequently.
In the case of client/server projects, this alarm could also be triggered by a communication 
error in the network.

1003033 ALGRT:Alarm window could not be created
1003034 ALGRT:Alarm window - data invalid

Incorrect project data.
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Number Error message / description
1003048 ALGRT:bit is outside the tag range

For example, an attempt was made to trigger the 18th bit of a 16-bit tag.
1003049 ALGRT:No tag change
1003050 ALGRT:Alarm tag (bit) already occupied by a alarm

The bit of the alarm tag has already been interconnected to a alarm.
1003051 ALGRT:Acknowledgment tag (bit) already occupied by a alarm

The acknowledgment tag bit has already been interconnected to a alarm.
1003052 ALGRT:Status tag already occupied by a alarm

The bit of the status tag has already been interconnected to a alarm.
1003053 ALGRT:Error during conversion of the variant data type
1003054 ALGRT:Alarm tag (bit) already occupied-->different type
1003055 ALGRT:Event - invalid tag or data type

The data type of the alarm tag is invalid. You may have used a tag with sign.
1003056 ALGRT:Invalid acknowledgment tag or data type

The data type of the acknowledgment tag is invalid. You may have used a tag with sign.
1003057 ALGRT:Status - invalid tag or data type

The data type of the status tag is invalid. You may have used a tag with sign.
1003058 ALGRT:Handle invalid

This error message can occur during accesses via the API.
1003059 ALGRT:Selection criteria invalid

This error message can occur during accesses via the API.
1003060 ALGRT:Resources - DLL for language not found

One of the language-dependent files is missing.
1003061 ALGRT:Error while creating the memory mapped files

This internal error indicates a problem involving the memory.
1003062 ALGRT:Error while creating the synchronization mechanism.

This error occurs when the operating system is overloaded.
1003063 ALGRT:Wrong parameter

This error message can occur during accesses via the API.
1003064 ALGRT:Transfer buffer too small

This error message can occur during accesses via the API.
1003065 ALGRT:This function is not available at this time

This error message can occur during accesses via the API.
1003066 ALGRT:Format DLL send data cannot be evaluated
1003067 ALGRT:Format DLL. Do not execute function
1003068 ALGRT:No alarm text blocks in the report

Check the alarm sequence report.
1003069 ALGRT:Invalid reporting
1003070 ALGRT:Report printout is already active

An attempt was made to restart an active report.
1003071 ALGRT:Alarm system runtime <Server> not installed

The server reports that the project was activated without the runtime component of Alarm 
Logging.
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Number Error message / description
1003072 ALGRT:Printout of the alarm sequence report has not been started.
1003073 ALGRT:Printout of the short-term archive report has not been started.
1003074 ALGRT:Printing of the log segment report has not started.
1003075 ALGRT:Maximum number of alarms that can be configured online

The maximum number of alarms that can be configured online (default setting is 600) has 
been exceeded.

1003076 NRMS7:Parameter error for S7 message frame
A parameter error has occurred on the interface to S7.

1003077 NRMS7:Parameter error for ALGRT
A parameter error has occurred on the interface to ALGRT.

1003078 NRMS7:Parameter error for TLGRT
A parameter error has occurred on the interface to TLGRT.

1003079 NRMS7:Parameter error in additional data
The additional data of the alarms are faulty.

1003080 NRMS7:Parameter error in AR_SEND structure
The structure of the AR-SEND user data is faulty.

1003081 NRMS7:General error
An internal error of unknown cause has occurred.

1003082 NRMS7:Alarm loss on the automation system
1003083 NRMS7:Connecting and updating of the automation system is underway
1003084 NRMS7:Connecting and updating of the automation system is finished
1003085 NRMS7:System change during operation (CiR) is underway
1003086 NRMS7:System change during operation (CiR) is finished
1003087 NRMS7:Error while logging on to receive alarm
1003098 ALGRT:Alarm archiving overflow - alarms will be lost
1003099 ALGRT:[Computer Name]:Locked alarms [alarm number] [alarm text of locked alarm]

This alarm occurs when a alarm is locked.
1003100 ALGRT:[Computer Name]:Alarm [alarm number] unlocked [alarm text of unlocked alarm]

This alarm occurs when a alarm is unlocked.
1003101 ALGRT:Acknowledgment request for alarm [alarm number]  was issued

This alarm occurs when a alarm is acknowledged.
1003102 ALGRT:[Computer Name]:Alarm group [alarm group number] locked

This alarm occurs when a alarm group is locked.
1003103 ALGRT:[Computer Name]:Alarm group [alarm group number] unlocked

This alarm occurs when a alarm group is unlocked.
1003104 ALGRT:[Computer Name]:Alarm archiving overflow ended - no further alarms will be lost
1003105 ALGRT:[Computer Name]:Incoming alarm queue has reached critical value
1003106 ALGRT:[Computer Name]:Incoming alarm queue has reached normal value
1003107 ALGRT:[ComputerName]:Alarm [AlarmNumber] hidden:@1%s@
1003108 ALGRT:[ComputerName]:Alarm [AlarmNumber] shown:@1%s@
1003109 ALGRT:Connection to master is down.
1003110 ALGRT:Found incomplete configuration data for alarm @10%d@. Status: @1%d@.
1004000 RPTRT:General error
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Number Error message / description
1004001 RPTRT:PRT_OUT directory full
1004002 RPTRT:Spool directory full
1004003 RPTRT:Report was not printed. PRT_OUT directory full
1004004 RPTRT:Report was not printed. Spool directory full
1004005 RPTRT:Alarm sequence report is reprinted
1004006 RPTRT:Spool directory full
1004007 RPTRT:Hardcopy was not printed. Spool directory full
1005000 TXTRT:General error
1005001 TXTRT:Error while logging off the runtime applications.
1005002 TXTRT:Error while logging on the runtime applications.
1005003 TXTRT:Error during initialization of the MMF.

A memory error has occurred.
1005004 TXTRT:Error while loading the MMF.

Error while accessing the database.
1005005 TXTRT:Error while opening the MMF.

A memory error has occurred.
1005006 TXTRT:Error while creating the service window.
1005007 TXTRT:No language found.
1005008 TXTRT:Text ID not found.

The requested Text ID could not be found in the text library.
1005009 TXTRT:Read access to the MMF refused.
1005010 TXTRT:Language not found

The requested language has not been configured in the text library.
1005011 TXTRT:Language table could not be opened.

Either the data are faulty or the table is locked in the database.
1005012 TXTRT:Text table could not be opened.

Either the data are faulty or the table is locked in the database.
1005013 TXTRT:Invalid language specified

The Language ID specified is invalid.
1005014 TXTRT:DBConnect error

No connection to the database could be set up.
1006000 GSCRT:Error
1007000 SCRIPT:Overflow

Overload: either there are too many actions running in a cycle that is too small, or an action 
is suspended (endless loop, dialog output). All the other actions are in the queue and cannot 
be processed.
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Number Error message / description
1007001 SCRIPT:Action error

One of the following errors has occurred:
● Exception in the action (specific cause unknown)
● Exception when accessing the return result (char* associated memory invalid)
● Stack overflow upon execution of the action
● The action contains a division by 0
● The action contains an access to a non-existing symbol
● The action contains an access violation

In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in 
your script, which allows for a detailed analysis of errors.

1007002 SCRIPT:Overflow
Internal lists have overflowed.

1007003 SCRIPT:Connection error
The connection to the server is broken.

1007004 SCRIPT:Action error 1
The called function is not known. Check the notation of the function call and implementation 
of the function.

1007005 SCRIPT:Action error 2
This error can have several causes:
● The action does not contain a P code. Recompile the action.
● The function could not be loaded, for example, due to incorrect function name.
● The type of return value of the function is invalid.

In WinCC version 4.0 and higher, you can integrate the OnErrorExecute function in 
your script, which allows for a detailed analysis of errors.

1007006 SCRIPT:Tag error
A requested tag was not supplied by WinCC Explorer within 10 seconds. Check the spelling 
of the tag name. In the case of external tags, there may be a communication problem 
between the WinCC Explorer and the PLC.
From WinCC version 4.0, you have the option to incorporate the OnErrorExecute function 
into your script, which allows for a detailed analysis of errors.

1007007 SCRIPT: Info
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1007009 SCRIPT:Error in Thread
Additional information under "Diagnostics of WinCC / Runtime Monitoring for Actions".

1008000 USERT:Connection to the smart card reader interrupted
1008001 USERT:Incorrect login name/password
1008002 USERT:Incorrect login name/password by smart card
1008003 USERT:Manual logon
1008004 USERT:Logon using a smart card
1008005 USERT:Manual logoff
1008006 USERT:Logoff using a smart card
1008007 USERT:Automatic logoff via a timer
1008008 USERT:Authorizations effective for service user/group '@102%s@'
1009000 LBMRT:Error
1009999 LBMRT:Tag @2%s@ does not exist
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Number Error message / description
1010000 STRRT:Error
1010101 CAS:Starts archive service
1010102 CAS:Archive service has been started
1010103 CAS:Archive service could not be started, error
1010104 CAS:Stops archive service
1010105 CAS:Archive service could not be stopped, error
1010106 CAS:Media backup completed successfully
1010107 CAS:Backup process failed, error
1010108 CAS:Backup medium created
1010109 CAS:Backup medium closed
1010110 CAS:Backup connected
1010111 CAS:Backup connection failed, error
1010112 CAS:Backup disconnected
1010113 CAS:Backup disconnection failed, error
1010114 CAS:Import of archive started
1010115 CAS:Import of archive failed, error
1010116 CAS:Import of archive completed
1010117 CAS:Archive failed, error
1010118 CAS:Archive completed
1010119 CAS:Starts processing of log 
1010120 CAS:Data backup started
1010121 CAS:Data backup completed successfully
1010122 CAS:The server station could not be assigned a symbolic name
1010123 CAS:Warning: No license found: SIMATIC PCS7 StoragePlus Server. Historical alarm list 

(long-term) disabled.
1010124 CAS:Log file '@2%s@' could not be verified.
1010130 StoragePlus: Directory cannot be created, error
1010131 StoragePlus: File cannot be moved, error
1011000 CSIG:Group display error at start up
1011001 CSIG:Group display hierarchy not updated
1011002 Group display: Connection fault
1011003 Group display: Tag does not exist
1011101 PTM: Error during start up
1011201 SSM: Error during start up
1011202 The fill level of the project drive is over 80%
1011203 The project was created with the wrong WinCC version
1012001 SYNC:Switched to master operation
1012002 SYNC:Cannot issue time message frame
1012003 SYNC:Time receipt service: Poor or failed signal
1012004 SYNC:Cannot receive time message frame
1012005 SYNC:Cannot receive any time message frame on redundant bus
1012006 SYNC:No time message frame. Switch to redundant device
1012007 SYNC:Can issue time message frame properly
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Number Error message / description
1012008 SYNC:Time reception service functions properly
1012009 SYNC:Can receive time message frame properly
1012010 SYNC:Can receive time message frame properly on redundant bus
1012011 SYNC:Switched to slave operation
1012012 SYNC:Time-of-day synchronization deactivated
1012013 SYNC:Time-of-day synchronization activated
1012014 SYNC:DCF77 client service failure
1012015 SYNC:DCF77 client service functions correctly
1012016 SYNC:@2%s@ switched to master mode @3%s@
1012017 SYNC:@2%s@ switched to slave mode @3%s@
1012018 SYNC:@2%s@ cannot transmit time frame
1012019 SYNC:@2%s@ can successfully transmit the time frame
1012020 SYNC:@2%s@ sets the local time
1012021 SYNC:LAN-Sync: Error in time synchronization with PC @2%s@
1012022 SYNC:LAN-Sync: Time synchronization set on PC @2%s@ 
1012023 SYNC:LAN-Sync: Time synchronization with PC @2%s@ completed
1012024 SYNC:Configured device names of time synchronization do not match the PC installation
1012025 SYNC:LAN-Sync: Time cannot be accepted from connected WinCC Server
1012026 SYNC:Time jump noted - switched to permanent slave mode
1012027 SYNC:Time jump noted - time synchronization permanently disabled
1012028 SYNC:Time receipt service not started
1012029 SYNC:Time receipt service running
1012030 SYNC:Time-of-day synchronization disabled
1012200 REDRT:Partner station has failed
1012201 REDRT:Partner station restarted
1012202 REDRT:Projects are not functionally identical
1012203 REDRT:Archive synchronization failed
1012204 REDRT:Internal error in Redundancy
1012205 REDRT:Connection to partner disturbed
1012206 REDRT:Connection to partner reestablished
1012207 REDRT:Partner server - WinCC has not been started
1012208 REDRT:Archive synchronization starts
1012209 REDRT:Archive synchronization ends
1012210 REDRT:Tag Logging synchronization starts
1012211 REDRT:Tag Logging synchronization ends
1012212 REDRT:Alarm Logging synchronization starts
1012213 REDRT:Alarm Logging synchronization ends
1012214 REDRT:User Archive synchronization starts
1012215 REDRT:User Archive synchronization ends
1012216 REDRT:Synchronization was interrupted
1012217 REDRT:Partner server project not activated
1012218 SWITCH:Client switched automatically
1012219 SWITCH:Client switched manually
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1012220 REDRT:Synchronization not ready for all user archives
1012221 REDRT:Synchronization ready for all user archives
1012222 SWRED:Main connection disturbed
1012223 SWRED:Main connection operational
1012224 SWRED:Backup connection disturbed
1012225 SWRED:Backup connection operational
1012226 REDRT:Partner server project activated
1012227 REDRT:Error: Partner computer is not a server
1012228 REDRT:CAS: Log synchronization starts '@2%s@'
1012229 REDRT:CAS: Log synchronization ends '@2%s@'
1012240 REDRT:RedundancyControl error triggered switching
1012241 REDRT:RedundancyControl: Switch to status
1012242 DELTALOADER:Delta transfer has been started
1012243 DELTALOADER:Delta transfer has been terminated
1012244 REDRT:Overload during online synchronization of Alarm Logging
1012245 REDRT:RedundancyControl: Loss of serial connection
1012246 REDRT:RedundancyControl: Serial connection reestablished
1012247 REDRT: OS server (standby) redundancy error
1012248 REDRT: OS server (standby) redundancy reestablished
1012250 AM:Possible inconsistency of the log databases
1012251 AM:Internal error
1012252 AM:Backup:Error while writing to backup path
1012253 AM:Backup:Insufficient memory space on target drive
1012254 AM:No connection to WriteArchiveServer
1012255 AM:No connection to Microsoft Message Queue
1012256 AM:No connection to WinCC project
1012257 AM:No connection to the database
1012258 AM:No connection to the text library
1012259 AM:Error while creating the TagLogging data
1012260 AM:Error while creating the AlarmLogging data
1012261 AM:Warning: Backup is delayed until partner server restarts.
1012265 AM:Database verification failed
1012301 CA:No access to SQL server (risk of data loss)
1012348 AM:Insufficient free memory space on project drive
1012349 REDRT: Loss of connection via network adapter (MAC) address
1012350 REDRT: Connection reestablished via network adapter (MAC) address
1012351 REDRT:RedundancyControl: System blockage detected. Switch to fault status
1012352 REDRT:RedundancyControl: System blockage detected. Restart the computer as soon as 

possible.
1012400 WEBRT:WebClient @1%s@ Connection is up (User=@2%s@)
1012401 WEBRT:WebClient @1%s@ Connection is down (User=@2%s@)
1900000 ESIG:Electronic signature of user @2%s@ successful.
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1900001 ESIG:Electronic signature of user @2%s@ unsuccessful.
1900002 ESIG:Electronic signature of user @2%s@ cancelled.

 

10.3.6.10 Tag Bit Assignments

Tags for Alarm Groups and Alarms

Bit assignment of status tag

Introduction
In WinCC you can define a status tag for an alarm or an alarm group. The status tag for am 
alarm group represents the states of the alarms and child alarm groups it contains.

Description
The following states of an alarm or alarm group are stored in a status tag:

● Incoming/outgoing alarm (status bit)

● Alarm queued for acknowledgment / acknowledged (acknowledgment bit)

Data type of a status tag
The status tag is an internal or external WinCC tag. You can use the following data types for 
status tags:

● Unsigned 8-bit value
The data type represents the states of up to four alarms.

● Unsigned 16-bit value
The data type represents the states of up to eight alarms.

● Unsigned 32-bit value
The data type represents the states of up to 16 alarms.

Each alarm or alarm group occupies 2 bits in the status tag.
 

 Note

A status bit of a status tag can only be assigned to one alarm. 
 

Acknowledgment bit of the status tag of an alarm
When an incoming alarm is received and is not acknowledged, the acknowledgment bit has 
status "1". 
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If the alarm was acknowledged, the acknowledgment bit status changes to "0".

Alarm event Acknowledgment bit
Incoming alarm was not acknowledged 1
Alarm acknowledged 0

Acknowledgment bit of the status tag of an alarm group
When at least one incoming alarm is received and is not acknowledged, the acknowledgment 
bit status in an alarm group changes to "1". 

If all the alarms for the alarm group were acknowledged, the acknowledgment bit is reset to 
"0".

Status bit for the status tags of an alarm or alarm group
If an incoming alarm or alarm group is received and has not yet gone, the acknowledgment 
bit has status "1". If the alarm has gone, the acknowledgment bit status changes to "0". 

Alarm event Status bit
Incoming alarm or alarm group 1
Alarm gone 0

 
 

 Note

Alarms whose alarm class has the "Alarm without status" property cannot be displayed in a 
status tag.

 

Status tag of a locked alarm
If you lock an alarm in Runtime, the bits in the status tags will be reset or not set, regardless 
of the alarm status. The "locked" status of an alarm is not indicated in the status tag. 

 

 Note

To visualize the locked status of an alarm group, use the locked tag for the alarm group.
 

Status tag for chronological alarms
You can use a structure tag to represent the status of a chronological alarm. In the structure 
tag, the "EventState" element, for example, represents the status of a chronological alarm. 
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Position of the Status and Acknowledgment Bit 
You can define the position of the status bit within a status tag. The acknowledgment bit must 
be a certain distance from this bit. The following definitions apply to the data type:

Data type Position of status bit Distance Position of acknowledgment 
bit

Unsigned 8-bit value 0 - 3 4 4 - 7
Unsigned 16-bit value 0 - 7 8 8 - 15
Unsigned 32-bit value 0 - 15 16 16 - 31

Examples
Status Tag of Data Type "32 Bit Unsigned"

Status bit = Position 9

Distance = 16 positions

Acknowledgment bit = Position 25

Status Tag of Data Type "16 Bit Unsigned"

Status bit = 6

Distance = 8 positions

Acknowledgment bit = Position 14

Status Tag of Data Type "8 Bit Unsigned"

Status bit = 2

Distance = 4 positions

Acknowledgment bit = Position 6

Configuring Function Lists for a Change in Value
You can configure a list of functions for the "Value change" event for the tag. You can hide 
any non-relevant bits of the tag to reduce the number of possible signal states for the tag. You 
can configure the hiding of the non-relevant bits using a C or VB script. 
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It is not necessary to hide the non-relevant bits if the following condition is fulfilled:

● You are using a separate status tag for each alarm.

● The non-relevant bits of these status tags always have the value "0".

See also
Tags of an alarm group (Page 3908)

Bit assignment for acknowledgment tags

Introduction
In WinCC you can define an acknowledgment tag for an alarm or alarm group. 

Description
Use the acknowledgment tag to:

● Acknowledge an alarm

● Acknowledge an alarm group
The acknowledgment tag of an alarm group acknowledges all the alarms and alarm 
subgroups it contains.

● Displaying the acknowledgment status of an alarm group

● Linking the acknowledgment to other WinCC components
You can use the acknowledgment tag to link the acknowledgment to other WinCC 
components.

If the operator acknowledges an alarm or alarm group in Runtime, then the associated 
acknowledgment bit will be set.

Using acknowledgment tags
You have the following options available for configuring acknowledgment tags:

● You can configure a separate acknowledgment tag for each alarm or alarm group.

● You can compile several alarms or alarm groups in an acknowledgment tag. The 
acknowledgment bit allows you to distinguish between alarms and alarm groups.

Each alarm occupies one bit in the acknowledgment tag.

Data Type of an acknowledgment tag
The structure of the acknowledgment tag is not specified. The data type depends on the 
number of alarms that you want to represent in the acknowledgment tag.
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Resetting the Acknowledgment Bit for acknowledgment tags
You configure the setting or resetting of the acknowledgment bit in WinCC using a button or 
via the PLC.

 

 Note

When you acknowledge an alarm group in Runtime, the acknowledgment bit does not indicate 
this acknowledgment in the alarm view.

 

● See also "Resetting the acknowledgment bit"

● See also "Tags of an alarm group"

See also
Tags of an alarm group (Page 3908)

Tags for Alarm Groups

Bit assignment for lock tags

Introduction
In WinCC you can define a lock tag for an alarm group. 

Description
The lock tag of an alarm group is used to evaluate the locked status of that alarm group. You 
can define a lock bit in the lock tag for this purpose.

Using the Lock Tag
You have the following options for configuring lock tags:

● You can configure a separate lock tag for each alarm group.

● You can compile several alarm groups in a lock tag. The lock bit allows you to distinguish 
between alarm groups.

When you lock an alarm group in Runtime, the associated lock bit is set in the configured tag.

Data Type of a Lock Tag
The structure of the lock tag is not specified. The data type depends on the number of alarms 
that you want to represent in the lock tag. 
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See also
Tags of an alarm group (Page 3908)

Bit assignment for display suppression tags 

Introduction
In WinCC you can define a display suppression tag for a custom alarm group. The display 
suppression tag saves the potential plant states. Only one plant state can be active at one 
time. The display suppression tag is therefore set by only one bit.       

Description
In the display suppression mask, you can specify which alarm of an alarm group is to be 
suppressed for specific plant states in Runtime.

Data type of the display suppression tag 
The display suppression tag is an external WinCC tag that stores the plant state. You can use 
the following data types for display suppression tags:

● Unsigned 8-bit value

● Unsigned 16-bit value

● Unsigned 32-bit value

Display suppression mask
In the Inspector window of an alarm, you can use the display suppression mask to define the 
plant states at which the alarm is not shown. The project engineer sets the bits that define 
specific plant states. A plant can have a maximum of 32 states.

You enter the selected plant states as hexadecimal value in the Inspector window of the alarm 
under "Display suppression > Mask".

The display suppression tag saves the plant state. When a plant state listed in the mask occurs, 
the alarm is no longer displayed. To view the alarms currently hidden due to a plant state, you 
can switch the alarm view in Runtime to "Alarms with display suppression".
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Example
Five examples for the display suppression mask are offered below:

● Display suppression mask 0x0. The alarm is displayed.

● Display suppression mask 0x1. If the "1" bit is set in the display suppression tag, the alarm 
is not displayed.

● Display suppression mask 0xD. If the "1", "3" or "4" bit is set in the display suppression tag, 
the alarm is not displayed.

● Display suppression mask 0x80000008. If the "4" or "32" bit is set in the display suppression 
tag, the alarm is not displayed.

● Display suppression mask 0xFFFFFFFF. If any bit is set in the display suppression tags, 
the alarm is not displayed.

See also
Tags of an alarm group (Page 3908)
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10.3.7 Configuring system diagnostics

10.3.7.1 System diagnostics for RT Professional

System diagnostics basics

Introduction
You use system diagnostics to detect problems and errors in any part of your plant. WinCC 
offers two operating elements for quick error localization.

       

System diagnostics view   
The alarm view shows the status of a PLC while the system diagnostics view gives you an 
overview of all devices available in your plant: You navigate directly to the cause of the error 
and to the relevant device. You have access to all diagnostics-capable devices which you have 
configured in the "Devices & networks" editor.

System diagnostics indicator 
The system diagnostics indicator is a predefined graphic symbol of the library which alerts you 
to errors in your system. 

The system diagnostics indicator changes its appearance when an error occurs.

GoTo button 
The GoTo button is a predefined graphic symbol in the library. When diagnostic alarms appear 
in the alarm view, you can use the GoTo function to jump to the error location in the system 
diagnostics view.

System diagnostics views

Introduction
There are four different views available in the system diagnostics view and the system 
diagnostics window. 

● Device view

● Diagnostic buffer view     

● Detail view

● Matrix view (for master systems, PROFIBUS, PROFINET only)
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Device view
The device view shows all the available devices of a layer in a table. Double-clicking on a 
device opens either the child devices or the detail view. Symbols in the first column provide 
information about the current status of the device.

Diagnostic buffer view 
In the diagnostic buffer view, the current data from the diagnostic buffer of the device is 
displayed. The diagnostic buffer view can only be called up in the device view.

To update the diagnostic buffer view, you click 

 . 
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Detail view
The detail view gives detailed information about the selected device and the pending errors. 
Check whether the data is correct in the detail view. You cannot sort error texts in the detail 
view.
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 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7-1200 
and S7-1500 PLCs.

 

Navigation buttons

Button Key Function
Enter key Opens the child devices or the detail view 

if there are no child devices.
Esc key Opens the parent device or the device 

view if there is no parent device.
Home key Opens the device view.

Function key F4. Opens the diagnostic buffer view.
Only visible in the device view.

Function key F5. Updates the diagnostic buffer view.
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Configuring system diagnostics objects

Enabling system diagnostics in the PLC

Introduction
During communication with the SIMATIC S7 1500 and SIMATIC S7 1200 PLCs, system 
diagnostics is automatically activated. 

For other PLCs, the following settings must be implemented in the PLC to enable the PLC to 
transfer error messages to the system diagnostics view.

    

Requirements
● A PLC such as SIMATIC S7 300/400 or ET 200 has been created.

● The "Devices & Networks" editor is open in the "Device view".

Procedure
1. Select the PLC in the selection list.

2. Click on the PLC and select "Properties" in the shortcut menu. The properties of the PLC 
are displayed in the Inspector window.

3. Select "Properties > General > System diagnostics" in the Inspector window.

4. Enable "Activate system diagnostics for this CPU".

5. Select the PLC and then "Compile > Hardware configuration" in the shortcut menu.

Result
The settings will be effective following compilation. The PLC can now transfer error messages 
to the system diagnostics display. 

Configuring the system diagnostic view

Introduction
You add a system diagnostics view to your project to get an overview of all devices available 
in your plant.

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● You have created a PC station with RT Professional.

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
System Manual, 02/2014 4127



● An HMI connection has been established between the PLC and RT Professional.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. Select "Properties > Properties > Columns > Devices/Detail view" in the Inspector window.

3. Activate the columns that you require in the device view for Runtime, e.g. Status, Name, 
Slot.

4. Activate the columns that you require in the device view for Runtime, e.g. Status, Name, 
Plant designation.

5. Activate the columns that you require in the diagnostic buffer view, for example, status, 
name.

6. Select "Properties >Properties > Layout > Column settings > Columns moveable" to enable 
move of the columns in Runtime.

7. You can change the column headers under "Properties > Properties > Column headers", 
if necessary.

Result
The system diagnostics view has been added to the screen. Error for the entire plant are now 
displayed in the system diagnostics view in Runtime. 

Splitting the view in system diagnostics view

Introduction
The system diagnostics view also offers a split view of the display. You have the option to see 
the devices and the associated details at a glance.

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● You have created a PC station with RT Professional.

● You have created a screen.

● The Inspector window is open.
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Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. In the Inspector window, click "Properties > Properties > Layout".

3. Activate "Show split view".

4. You may also change the number of lines for the "Device view" and the "Detail view" if 
required.

Result
The system diagnostics view has been added to the screen. The system diagnostics view is 
split into two areas. 

The top area shows the device view. The bottom view shows the detail view.

If you open the diagnostic buffer view, the top area displays an overview of the diagnostic 
buffer and the bottom area displays the details.

 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.
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Example: System diagnostics with all objects

Example: Procedures overview

Introduction
● A PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on the PLC.

● A connection has been established between the PLC and PC station.

Configuration steps
To get a quick view of errors, create an overview screen with the various objects for displaying 
diagnostic alarms.

The following example shows how to efficiently use the objects of the "Tools" or "Libraries" 
task cards in your project.

The example is divided into several steps:

● Creating screens
The project engineer creates multiple screens for system diagnostics:

– Overview screen with all objects for system diagnostics

– Screen for the alarm view

– Screen for the system diagnostics view

● Inserting objects in the screens
The project engineer inserts various objects in the screens:

– Alarm view in the "Alarm" screen

– Screen window for displaying the alarm view and system diagnostics view

● Configuring objects
The project engineer connects objects to enable targeted navigation to the cause of the 
error in runtime.

– System diagnostic indicator with screen window of the system diagnostics view

– Goto button with the screen window and the alarm view and system diagnostics view.

 

See also
Example: Creating screens (Page 4131)

Example: Inserting objects in the screens (Page 4131)

Example: Adding a system diagnostics indicator (Page 4132)

Example: Inserting a GoTo button (Page 4135)

Visualize processes
10.3 Working with alarms

WinCC Professional V13.0
4130 System Manual, 02/2014



Example: Creating screens

Introduction
In the following, you will create three screens for displaying various objects.

Requirement
A project is open.

You have created a PC station with RT Professional.

Procedure
1. Open the project tree.

2. Click "Add new screen" in the Screens folder.

3. Open the shortcut menu of the screen and assign the name "Overview SysDiag".

4. Create another screen named "Alarm".

5. Open the "Libraries" task card.

6. Open the global library "Buttons and Switches > Kopiervorlagen > DiagnosticsButtons > 
RTProfessional".

7. Click the "DiagnosticScreen" object in the global library.

8. Drag-and-drop the object into the "Screens" folder in the project tree.

Result
You have created three screens in the project tree:

● Overview SysDiag

● Alarm

● SystemDiagnostics

A system diagnostics view has been created in the "SystemDiagnostics" screen.

See also
Example: Procedures overview (Page 4130)

Example: Inserting objects in the screens

Introduction
In the following example, you will insert various objects from the "Tools" task card into the 
screens.
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Requirement
The following three screens have been created:

● Overview SysDiag

● Alarm

● SystemDiagnostics

The "Tools" task card is open.

Procedure
1. Open the "Alarm" screen.

2. Drag-and-drop an "Alarm view" from the "Tools" task card into the screen.

3. Open the screen "Overview SysDiag".

4. Drag-and-drop a "Screen window" from the "Tools" task card into the screen.

5. Enter the name "Alarm" under "Properties > Properties > Miscellaneous > Name" in the 
Inspector window.

6. Select the "Alarm" screen under "Properties > Properties > General > Content > Displayed 
screen".

7. Create a second screen window named "SysDiag".

8. Select the "SystemDiagnostics" screen under "Properties > Properties > General > Content 
> Displayed screen".

Result
You have inserted an alarm view in the "Alarm" screen. The alarm view has the unchanged 
name "Alarm_view_1".

You have created two screen windows in the "Overview SysDiag" screen. The first screen 
window has the name "Alarm" and shows the alarm view. The second screen window has the 
name "SysDiag" and shows the system diagnostics view.

See also
Example: Procedures overview (Page 4130)

Example: Adding a system diagnostics indicator

Introduction
The system diagnostics indicator is a predefined graphic symbol of the library which alerts you 
to errors in your system. 

If an error occurs, the appearance of the object changes. The library object can display two 
states:

- No error
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- Error         

Requirement
● The "Libraries" task card is opened.

● The global library "Buttons and Switches > Master copies > DiagnosticsButtons  > RT 
Professional" is open.

● The following three screens have been created:

– Overview SysDiag

– Alarm

– SystemDiagnostics

● The "SysDiag" screen window has been created and linked with the "DiagnosticScreen" 
screen.

Procedure
1. Select the "DiagnosticsIndicator" object in the library.

2. Drag the library object to the screen "Overview SysDiag".
The library object is inserted.

3. Select the library object.
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4. Click "Properties > Events" in the Inspector window.
Three system functions are preset for the "Click" event.

5. Select "SysDiag" for the "Screen name" parameter in the "ActivateScreenInScreenWindow" 
system function.

6. Select "SysDiag" for the "Screen object" parameter in the "SetPropertyByConstant" system 
function.

Result
The system diagnostics indicator has been added to the project and connected with the 
"SysDiag" screen window.

The system diagnostics indicator changes its appearance if an error message is output in 
Runtime. The SysDiag screen window in which system diagnostics view is configured opens 
when you click the system diagnostics indicator. The system diagnostics view shows the detail 
view of the device concerned. 

See also
Example: Procedures overview (Page 4130)
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Example: Inserting a GoTo button

Requirements
● The "Libraries" task card is opened.

● The global library "Buttons and Switches > Master copies > DiagnosticsButtons  > RT 
Professional" is open.

● The following three screens have been created:

– Overview SysDiag

– Alarm

– SystemDiagnostics

● The "Alarm" screen window has been created and linked with the "Alarm" screen.

● The "SysDiag" screen window has been created and linked with the "DiagnosticScreen" 
screen. 

Configuring a Goto button in the screen
1. Open the screen "SystemDiagnostic".

2. Open the global library "Buttons and Switches > Master copies > DiagnosticsButtons".

3. Select the "DiagnosticsGoto" object in the library.

4. Drag the library object to the screen "Overview SysDiag". The library object is inserted.

5. Select the library object.
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6. Click "Properties > Events" in the Inspector window.
Four system functions are preset for the event.
 

7. Select "SysDiag" for the "Screen name" parameter in the "ActivateScreenInScreenWindow" 
system function.

8. Select "SysDiag" for the "Screen object" parameter in the "SetPropertyByConstant" system 
function.

9. Select the following settings in the "SetPropertyByProperty" system function:

● Screen name: Alarm

● Object: Alarm_view_1

Result
You have configured the Goto button and linked it to the alarm view and the system diagnostics 
view.
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Click on the GoTo button if the alarm view outputs an error message in the "Alarms" screen 
window in runtime. 

A system diagnostics view has been added to the "SysDiag" screen window. The device with 
the associated error is opened in the detail view.

 

See also
Example: Procedures overview (Page 4130)

10.3.7.2 System diagnostics for Panels and RT Advanced

System diagnostics basics

Introduction
You use system diagnostics to detect problems and errors in any part of your plant. WinCC 
has two display and operating elements for quick error localization.

       

System diagnostics view   
The alarm view shows the status of a PLC while the system diagnostics view gives you an 
overview of all devices available in your plant: You navigate directly to the cause of the error 
and to the relevant device. You have access to all diagnostics-capable devices which you have 
configured in the "Devices & networks" editor.

System diagnostics window   
The system diagnostics window is an operating and display element that you can only use in 
the global screen. 

The functions of the system diagnostics window are no different than those of the system 
diagnostics view. Because the system diagnostics window is configured in the global screen, 
you can, for example, also specify if the object is closable in Runtime. 

 

 Note
System diagnostics on Basic Panels

The "System--Diagnostics window" object is not available for Basic Panels.
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System diagnostics views

Introduction
There are four different views available in the system diagnostics view and the system 
diagnostics window. 

● Device view

● Diagnostic buffer view     

● Detail view

● Matrix view (for master systems, PROFIBUS, PROFINET only)

Device view
The device view shows all the available devices of a layer in a table. Double-clicking on a 
device opens either the child devices or the detail view. Symbols in the first column provide 
information about the current status of the device.

Diagnostic buffer view 
In the diagnostic buffer view, the current data from the diagnostic buffer of the device is 
displayed. The diagnostic buffer view can only be called up in the device view.

To update the diagnostic buffer view, you click . 
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Detail view
The detail view gives detailed information about the selected device and the pending errors. 
Check whether the data is correct in the detail view. You cannot sort error texts in the detail 
view.

 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.
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Matrix view
The matrix view is only available for master systems. In the matrix view you can see the status 
of the subdevices of the master system. 

● In PROFIBUS, the numbers assigned by PROFIBUS are used as identification (DP station 
number).

● The IO devices are numbered consecutively beginning with 1 in PROFINET. 

Navigation buttons

Button Key Function
Enter key Opens the child devices or the detail view 

if there are no child devices.

Esc key Opens the parent device or the device 
view if there is no parent device.

Home key Opens the device view.

Configured function key, e.g. F1. Opens the diagnostic buffer view.
Only visible in the device view.

Configured function key, e.g. F2. Updates the diagnostic buffer view.
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 Note
Navigation in the matrix view of Comfort Panels with function keys

The Shift key is additionally used to select PNIO or PROFIBUS slaves in the matrix view. 
 

Language switching in runtime
Switch over the language in runtime before you open the details view. 

If you switch over the runtime language while the details view is opened, you change back to 
the diagnostic buffer view. 

Open the details view again. The selected runtime language is now displayed correctly.

Basic Panel basics

System diagnostics basics

Introduction
Using system diagnostics, you can display the messages from the diagnostic buffer of all 
integrated connections.

       

System diagnostics view   
The system diagnostics display is an operating and display object that you use in a screen. 

You navigate directly to the cause of the error and the associated connection. You have access 
to all integrated connections that you have configured in the "Devices & networks" editor.

System diagnostics views

Introduction
Three different views are available in the simple system diagnostic view. 

● Device view

● Diagnostic buffer view

● Detail view

Device view
The device view is only displayed if more than one integrated connection has been configured.
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The device view shows all available connections in a table. Double-clicking a connection opens 
the diagnostic buffer view. 

Diagnostic buffer view 
The diagnostic buffer view shows the current data from the diagnostic buffer. 

To update the diagnostic buffer view, you click .
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Detail view
The detail view gives detailed information about the selected connection and any pending 
errors. Check whether the data is correct in the detail view. 

 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.

 

Navigation buttons

Button Key Function
Enter key In the device view: 

Opens the diagnostic buffer view of the selected 
device. 
In the diagnostic buffer view:
Opens the detail view. 

Esc key In the diagnostic buffer view: 
Opens the device view.
In the detail view: 
Opens the diagnostic buffer view.

Configured function key, e.g. 
F1.

Updates the diagnostic buffer view.
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Configuring system diagnostics objects

Enabling system diagnostics in the PLC

Introduction
During communication with the SIMATIC S7-1500 and SIMATIC S7-1200 PLCs, system 
diagnostics is automatically activated. 

For other PLCs, the following settings must be implemented in the PLC to enable the PLC to 
transfer error messages to the system diagnostics view.

    

Requirements
● A PLC such as SIMATIC S7-300/400 or ET 200 has been created.

● The "Devices & Networks" editor is open in the "Device view".

Procedure
1. Select the PLC in the selection list.

2. Click on the PLC and select "Properties" in the shortcut menu. The properties of the PLC 
are displayed in the Inspector window.

3. Select "Properties > General > System diagnostics" in the Inspector window.

4. Enable "Activate system diagnostics for this CPU".

5. Select the PLC and then "Compile > Hardware configuration" in the shortcut menu.

Result
The settings will be effective following the next compilation. The PLC can now transfer error 
messages to the system diagnostics display. 

Adding a system diagnostics indicator

Introduction
The system diagnostics indicator is a predefined graphic symbol of the library which alerts you 
to errors in your system. 

If an error occurs, the appearance of the object changes. The library object can display two 
states:

- No error

- Error         
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Requirement
● The "Libraries" task card is opened.

● The global library "Buttons and Switches > Master copies > DiagnosticsButtons" is open.

● A screen is open.

● A system diagnostics window has been created in the global screen.
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Procedure
1. Select the "DiagnosticsIndicator" object in the library.

 
 

  Note
System diagnostics indicator for different device types

When selecting the object ensure that you use the correct object for the device type used 
in the project.

 

2. Drag-and-drop the library object to the position in the work area where you want to insert 
the object.
The library object is inserted.

3. Select the library object.

4. Click "Properties > Events" in the Inspector window.
The system function "ShowSystemDiagnosticsWindow" is preset for the event "Click".
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Result
The status diagnostics indicator has been added to the project and connected with the system 
diagnostics window. 

The system diagnostics indicator changes its appearance if an error message is output in 
Runtime. The system diagnostics window opens when you click on the system diagnostics 
indicator. The system diagnostics window shows the detail view of the affected device. 

Configuring access protection for the system diagnostics window
Configure access protection for the system diagnostics indicator to prevent unauthorized 
access to the system diagnostics window.

1. Select the "DiagnosticsIndicator" object in the screen.

2. Select an authorization in "Properties > Properties > Security in Runtime" in the Inspector 
window.

A logon dialog opens when you click on the system diagnostics indicator in Runtime. The 
system diagnostics window does not open unless you have the required authorization. 

Configuring a system diagnostics window in the global screen

Introduction
The system diagnostics window gives you an overview of all devices available in your plant. 
The system diagnostics window operates like the system diagnostics view, but it is only 
available in the global screen.       

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● A Comfort Panel or WinCC RT Advanced has been created.

● The global screen is open.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics window" object in the "Tools" task card. The object 

is added to the global screen.

2. Select "Properties > Properties > Columns > Devices/Detail view" in the Inspector window.

3. Enable the columns that you require in the device view for Runtime, for example: status, 
name, address.

4. Enable the properties which you require in the detail view for Runtime, for example: status, 
name, plant designation.
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5. Activate the columns that you require in the diagnostic buffer view, for example, status, 
name.

6. Customize the column headers, if necessary.

7. Enable "Properties >Properties > Layout > Column settings > Columns moveable" to move 
the columns in Runtime.

8. Enable "Properties > Properties > Window > Closable" to allow the system diagnostics 
window to be closed in Runtime.

Result
The system diagnostics window has been added to the global screen. The system diagnostics 
window will respond to error messages in the plant and display the device affected.

Configure a system diagnostics indicator in a screen to open the system diagnostics window.

Configuring button as system diagnostics indicator

Introduction
Instead of using the object "DiagnosticsIndicator" from the library, you can configure a button, 
for example, to indicate errors in your plant.         

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● The "Tools" task card is open.

● A bit graphics list has been created with two different graphics for the statuses.

● A screen is open.

● You have created a system diagnostics view.

Procedure
1. Double-click the "Button" object in the "Tools" task card. A button will be added to the screen.

2. In the Inspector window, select "Properties > Properties > General > Mode > Graphic".

3. Select the bit graphics list under "Graphic > Graphics list".

4. Select the "@DiagnosticsIndicatorTag" tag under "Properties > Properties > General > Tag" 
in the Inspector window.

Configuring system function to the button
1. Click "Properties > Events" in the Inspector window.

2. Select the "Click" event.
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3. Click on "Add function" in the table.

4. Select the "ActivateSystemDiagnosticsView" system function.

5. Select the system diagnostics view.

Result
You have now configured a button which will respond to error messages from the PLC. The 
button changes its appearance if an error message is output in Runtime. 

The button has two states:

● Error
The system diagnostics view opens when you click the button. The system diagnostics view 
shows the detail view of the device concerned.

● No error
The system diagnostics view opens when you click the button. The system diagnostics view 
shows the device view. 

Configuring the system diagnostic view

Introduction
You add a system diagnostics view to your project to get an overview of all devices available 
in your plant.

Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● A Comfort Panel or WinCC RT Advanced has been created.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. Select "Properties > Properties > Columns > Devices/Detail view" in the Inspector window.

3. Activate the columns that you require in the device view for Runtime, e.g. Status, Name, 
Slot.

4. Activate the columns that you require in the detail view for Runtime, e.g. Status, Name, 
Plant designation.

5. Activate the columns that you require in the diagnostic buffer view, for example, Status, 
Name.
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6. Enable "Properties >Properties > Layout > Column settings > Columns moveable" to move 
the columns in Runtime.

7. You can change the column headers under "Properties > Properties > Column headers", 
if necessary.

Result
The system diagnostics view has been added to the screen. Error for the entire plant are now 
displayed in the system diagnostics view in Runtime. 

Configuring the system diagnostic view

Introduction
For an overview of all integrated connections, you insert a system diagnostics view in your 
project.

Requirements
● A PLC has been created.

● A Basic Panel has been created.

● An integrated connection has been created in the "Devices & Networks" editor.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. In the Inspector window, select "Properties > Layout".

3. Enter a number under "Lines per entry", i.e. 5.

Result
The system diagnostics view has been added to the screen. 

To obtain the latest alarms, update the diagnostic buffer.

Splitting the view in system diagnostics view

Introduction
The system diagnostics view also offers a split view of the display. You have the option to see 
the devices and the associated details at a glance.
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Requirements
● At least one PLC has been created.

● The option "Activate system diagnostics for this CPU" is activated on each PLC.

● An HMI device has been created, for example, a Comfort Panel.

● You have created a screen.

● The Inspector window is open.

Procedure
1. Double-click the "System diagnostics view" object in the "Tools" task card. The object is 

added to the screen. 

2. In the Inspector window, click "Properties > Properties > Layout".

3. Activate "Show split view".

4. Activate "Sizing > Auto-size"

5. You may also change the number of lines for the "Device view" and the "Detail view" if 
required.

Result
The system diagnostics view has been added to the screen. The system diagnostics view is 
split into two areas. 

The top area shows the device view. The bottom view shows the detail view.
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If you open the diagnostic buffer view, the top area displays an overview of the diagnostic 
buffer and the bottom area displays the details.

 

 Note
Contents of the detail view

The contents of the detail view are only available for integrated connections with S7 1200 
and S7 1500 PLCs.
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10.3.8 Displaying security events

10.3.8.1 Displaying security events on the HMI device

Introduction
You can also view security events on the HMI device for existing alarms from WinCC.

Security events are, for example, an attack on a device via the network.

Security events are detected by the controller and forwarded to the HMI devices. 

A configuration or activation of the security events functionality is not necessary within the 
controller. Security events are automatically detected by the controller. 

Restrictions
You can display security events from the following PLCs on the HMI device:

● SIMATIC S7-1200

● SIMATIC S7-1500

The following HMI devices can display security events from PLCs:

● Comfort Panels

● Panels

Configuring the display of security events
The following steps are required to display security events on the HMI device: 

● Selection of controller alarms

● Creation of an alarm log for controller alarms

For more detailed information about configuration, see: Auto-Hotspot

See also
Configuring the display of security events (Page 4154)

10.3.8.2 Configuring the display of security events

Requirement
A HMI connection is established between the HMI device and PLC.
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Procedure
1. Open the "Runtime settings" of the HMI device.

2. Enable the "Security Events" function under "Alarms".

3. Create a new alarm log in the "Log" editor under "Alarm logs".

4. Open an HMI screen.

5. Create an alarm view.

10.4 Working with logs

10.4.1 Working with Logs

10.4.1.1 Log Basics

Introduction
WinCC provides the following types of log for logging process data for HMI Runtime:

● Data logs

● Alarm logs

A data log is used to log process data from an industrial plant.

An alarm log is used to log alarms that occur in the monitored process.     

Principle
The two types of log both have roughly the same structure and largely work in the same way. 
They are very clear and easy to configure. With both types of log you define the same properties 
for the log. The same logging methods are also available for both types of log.

The following logging methods are available:

● Circular log
If a circular log is totally full, the oldest entries are overwritten.

● Segmented circular log
In a segmented circular log, multiple single logs of the same size are filled in succession. 
When all log segments are filled, the oldest log segment is overwritten.

● Log with level-dependent system alarm
A system alarm is triggered when a defined level is reached.

● Log with level-dependent triggering of an event
The "Overflow" event is triggered when the log is full. The "Overflow" event triggers a system 
function.
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10.4.1.2 Properties of Logs

Introduction
You define the properties of a data log in the "Data logs" editor.

You define the properties of an alarm log in the "Alarm log" editor.

The properties of the data log and alarm log are configured in the same way. You configure 
the properties either directly in the table of the respective editor or in the log properties of the 
Inspector window.

General properties
● Name

You can assign any name to the log. The name must contain at least one letter or one 
number.

● Storage location
The log is stored in a file or a database. You can only save to a database on a PC. Select 
"File" or "Database" as the storage location.
You can specify a folder on the local PC hard disk or a folder on a network drive as the 
storage location, depending on how the HMI device is configured. The following storage 
locations are available for an HMI device:

– Memory card

– USB storage medium

– Network drive

The selection available depends on the HMI device in use.

● Size
The size of a log depends on the type of log and the selected settings.

– Size of a data log
The size of a data log is calculated as follows:
The number of items * the length of each tag value to be logged.
In the "Properties" window, the maximum size that the log accepts for retention of the 
currently selected number of data records is displayed in the input field "Number of data 
records". The maximum log size is limited by the volume of the storage medium.

– Size of an alarm log
The size of an alarm log is calculated from the number of data records and the 
approximate size of an entry. The size of an entry depends on whether the alarm text 
and the associated tag values are to be logged as well.

● Restart characteristics
Under Restart characteristics you can specify that the logging starts when Runtime starts. 
Check the "Enable logging at runtime start" check box.
You can also control the behavior when Runtime starts. Enable "Reset log" if you want to 
overwrite existing logged data with the new data. Select the "Append data to existing log" 
option if you want to retain the existing logged data. This setting adds the data to be logged 
to an existing log.
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See "Basic principles for data logging (Page 3757)" and "Basics on alarm logging 
(Page 4007)" for more details.

 

 Note

You can use system functions to control the restarting of a log in Runtime.
 

Automatic log entries  
In Runtime, the following log entries are created as standard:

Entry File format Log type Meaning
$RT_DIS$ Any Data log Indicates that the connection to the log was 

interrupted at this point in time. 
(A bold line is shown in the trend display for 
this time period.)

$RT_OFF$ Any Data log Indicates that Runtime was shut down at this 
point in time. 
(No line is shown in the trend display for this 
time period.)

$RT_ERR$ Any Data log
Alarm log
AuditTrail

Indicates in the target log that a copy operation 
was not successful or was interrupted.
(The log copy was not fully created.)

$RT_COUNT *.CSV
*. TXT

Data log
Alarm log
AuditTrail

This entry was created at the end of the log 
and serves to increase the system 
performance when Runtime starts.

See also
Log Basics (Page 4155)

Basic principles for data logging (Page 3757)

Basics on alarm logging (Page 4007)
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10.4.2 Working with Logs

10.4.2.1 Log basics

Introduction
WinCC provides the following types of logs for logging process data in Runtime Professional:

● Fast data log

● Slow data log

● Alarm logs

Data logs are used to log process data from an industrial plant.

Alarm logs are used to log alarms that occur in the monitored process.      

Principle
The different types of logs all have roughly the same structure and largely work in the same 
way. They are very clear and easy to configure. With all three types of log you define the same 
properties for the log type.

All three log types can be broken down into individual segments. Segmenting can be made 
based on size or time.

There are two types of logs available for data logs:

● Fast data log
This type of log is used to log process data that change rapidly with a cycle time <= 1 min.

● Slow data logs
This type of log is used to log all process data not covered by the "Fast data log" type. In 
the configuration, you can specify several parameters to define the tag values to be saved 
in a certain type of log.

The alarm log settings are independent of the data log settings.

10.4.2.2 Properties of logs 

Introduction
You can configure the basic properties of logs in Runtime Professional, such as the segment 
size, in the "Runtime settings > Logging" dialog. The settings configured in this dialog apply 
to all the logs in the project.

You configure the special properties for the individual log types either directly in the table of 
the respective editor or in the log properties of the Inspector window.

You configure the logical organization of data logs and compressed logs in the "Historical Data" 
editor. See "Data logging (Page 3776)" for more details.

There are no comparable logical structures within the log for alarm logs. This means there is 
no separate "Alarm log" editor in Runtime Professional. You can only specify whether or not 
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an alarm should be logged. You configure logging of alarms in the "HMI alarms" editor in the 
"Alarms classes" tab. For detailed information, refer to "Basics on alarm logging (Page 4023)".

Properties
The following properties are available for segmenting:

● Time period of all segments

● Maximum size of all segments

● Time period contained in one single segment

● Maximum size of a single segment

● Time of first segment change

You can also specify how and when backups are to be created.
Additional properties are available for the "Fast data" log type which you can use to divide the 
process data between the "Fast" or "Slow" log types.
See "Logging Settings (Page 3803)" for more details.

See also
Data logging (Page 3776)

Configuring alarm logging (Page 4023)

Data logging (Page 3776)

Basics on alarm logging (Page 4023)

Logging Settings (Page 3803)

Log basics (Page 4158)
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10.5 Working with recipes

10.5.1 Working with recipes

10.5.1.1 Basics

Definition and applications

Introduction
Recipes are collections of related data, for example, machine parameterizations or production 
data.   

 

 Note
Restrictions for recipes

Recipes are not available on the HMI device OP 73:
 

Examples:

● Machine parameter settings that are needed to convert production to a different product 
variant.

● Product components that result in different compositions for different end products.

A recipe has a fixed data structure. The structure of a recipe is defined during configuration. 
A recipe contains recipe data records. These differ in terms of their values, but not their 
structure. 

Recipes are stored on the HMI device or on an external storage medium. Recipe data records 
are always transferred complete and in a single pass between the HMI device and the PLC. 
In addition, production data can be imported in runtime, in the form of a CSV file.

 

 Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported using 
ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is interrupted.
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Using recipes
Recipes can be used in the following situations:

● Manual production
You select the required recipe data and display it on the HMI device. You modify the recipe 
data as required and save it on the HMI device. You transfer the recipe data to the PLC. 

● Automatic production
The control program starts transfer of the recipe data between the PLC and HMI device. 
You can also start the transfer from the HMI device. Production is then implemented 
automatically. It is not essential to display or modify the data. 

● Teach-in mode
You optimize production data that was optimized manually on the system, e.g. axis positions 
or filling volumes. The values thus determined are transferred to the HMI device and saved 
in a recipe data record. You can then transfer the saved recipe data back to the PLC at a 
later date.

Entering and modifying the recipe data
You enter the data in the individual recipe data records and modify it as required. The following 
options are available:

● Data entry during configuration
If the production data exists already, you enter the data in the "Recipes" editor during recipe 
configuration.

● Entering the data in Runtime
If you have to frequently modify production data, you can do this directly in Runtime as 
follows:

– Enter the data directly on the HMI device.

– Set the parameters directly on the machine. You then transfer the data from the PLC to 
the HMI device and save it in the recipe.

Visualize processes
10.5 Working with recipes

WinCC Professional V13.0
System Manual, 02/2014 4161



Examples for using recipes
Recipes are used in the manufacturing industry and mechanical engineering, for example. The 
following recipes show typical applications which you can implement with the recipe function 
of WinCC:    

● Machine parameter assignment
One field of application for recipes is the assignment of machine parameters in the 
manufacturing industry: A machine cuts wooden boards to a certain size and drills holes. 
The guide rails and drill have to be moved to new positions according to the board size. 
The required position data are stored as data records in a recipe. You reassign the machine 
parameters using "Teach in" mode if, for example, a new board size is to be processed. 
You transfer the new position data directly from the PLC to the HMI device and save it as 
a new data record. 

● Batch production
Batch production in the food processing industry represents another field of application for 
recipes: A filling station in a fruit juice plant produces juice, nectar, and fruit drinks in a 
variety of flavors. The ingredients are always the same, differing only in their mixing ratios. 
Each flavor corresponds to a recipe. Each mixing ratio corresponds to a data record. All of 
the required data for a mixing ratio can be transferred to the machine control at the touch 
of a button. 

Recipe structure

Introduction
The basic structure of a recipe is illustrated with reference to the filling station in a fruit juice 
plant. 

There may be several different recipes in an HMI device. A recipe can be compared to an 
index card box that contains several index cards. The index card box contains several variants 
for manufacturing a product family. All the data for each manufacturing variant is contained on 
a single index card. 

Example:

In a soft drinks production plant, a recipe is needed for different flavors. Drink variants include 
fruit juice drink, juice and nectar.
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Recipe
The recipe contains all the recipe data records for the different drink variants.
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Recipe data records
Each index card represents a recipe data record needed to manufacture a product variant.

Recipe entries
Each index card in a drawer has the same structure. All the index cards contain fields for the 
different ingredients. Each field corresponds to a recipe entry. All the records of a recipe thus 
contain the same entries. The records differ, however, in the value of the individual entries. 

Example:

All the drinks contain the following ingredients: 

● Water

● Concentrate

● Sugar

● Flavoring

The records for juice drink, fruit juice or nectar differ, however, in the quantity of sugar used 
in production. 

Display of recipes

Introduction
You can display recipes in the following ways:

● Recipe view

● Recipe screen
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Input in the recipe view and recipe screen
You change the values of a recipe in the recipe screen or recipe view and thus modify the 
manufacturing process or a machine.

The recipe view and recipe screen can perform the same functions when using recipes. They 
differ in the following respects:

● Display options

● Operation

● Possibility of transferring data between the PLC and the HMI device

Recipe view  
The recipe view is suitable for viewing simple recipes.

The recipe view is an off-the-shelf WinCC display and operator control object for managing 
recipe data records. The recipe view is always part of a screen. The recipe view shows recipe 
data records in tabular form. You adapt the appearance and the possible operations to suit 
your specific needs.

If you are editing recipes with a recipe view in your project, the values are saved in recipe data 
records. The values are not transferred between the HMI device and PLC until you use the 
relevant operator control object. 
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Recipe screen   
The recipe screen is an individual screen that contains:

● Input fields for recipe variables

● Operator control objects for using the recipes, e.g. "SaveDataRecord"

The recipe screen is suitable in the following situations:

● Large recipes

● Allocation of recipe fields to the graphic display of the relevant plant area

● Breakdown of the recipe data into several screens
 

  Note

The values of recipe variables are transferred between the PLC and recipe screen at the 
following times depending on the configuration:
● Immediately after modification
● When a relevant operator control object is used

 

Synchronizing recipe view and recipe screen  
There may be differences in Runtime between the values displayed in the recipe view and the 
values saved in the associated tags when you edit recipes in both a recipe view and a recipe 
screen. To prevent this, you must synchronize the recipe data record values with the values 
of the recipe tags. 

A complete recipe data record will always be saved or synchronized.
 

 Note

Recipe tags can only be synchronized in the advanced recipe view. Synchronization only 
takes place if the "Synchronize recipe view and recipe tags" setting is activated for the recipe.
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Transferring recipe data records

Flow of data in recipes
The following picture illustrates the flow of data in recipes:   

Interaction between the components
There is interaction between the following components at runtime:

● Recipe view / recipe screen
On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen:

– The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

– The values of the recipe tags are displayed and edited in the recipe screen.

You synchronize the values displayed in the recipe view with the values of recipe tags 
according to the configuration.

● HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.

● Recipe tags
The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe 
values are stored in recipe tags. The point at which the values of the recipe tags are 
exchanged with the PLC depends on the configuration.

 

  Note

You can synchronize the recipe tags with the recipe data records so that the same values 
are saved in both.
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Loading and saving recipe data
Complete recipe data records are loaded from or saved to the recipe memory on the HMI 
device in the recipe view.

The values of the recipe data record are loaded from the recipe memory to the recipe tags in 
the recipe screen. When they are saved, the values of the recipe tags are saved to a recipe 
data record in the recipe memory.

Transferring the recipe values between the HMI device and the PLC
Complete recipe data records are transferred between the recipe view and PLC.

The following transfers are possible between the recipe screen and PLC, depending on the 
configuration:
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● Transferring recipe data records between recipe view and recipe tags

● Immediate transfer of individual modified values between the recipe tags and PLC. The 
following settings are needed in the recipe in order to do this:

– "Synchronizing recipe view and recipe tags" is activated.

– "Manual transfer of individual modified values (teach-in mode)" is deactivated.

Recipe data records can be transferred directly between the HMI device and PLC. In these 
situations, the display on the HMI device is not essential.

Exporting and importing recipe data records
Recipe data records are exported from the HMI device recipe memory and are saved to a CSV 
file on the external storage medium. The records can be reimported from the storage medium 
to the recipe memory.   

The following external storage media may be used, depending on the HMI device:

● No storage medium, for example, for basic panels

● Memory card

● USB stick

● Hard disk
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Configuration of recipes

Introduction
Recipes are configured differently according to the intended use: 

● If you are editing recipes with a recipe view in your project, the values are only saved in 
recipe data records.

● If you are editing recipes in a recipe screen in your project, the values are saved in recipe 
tags.

The following possible settings determine how the recipe data records, recipe tags and PLC 
all interact.

"Synchronizing recipe view and recipe tags" deactivated
The data in a data record is only displayed and can only be edited in the recipe view. If you 
use data outside the recipe view, they are not synchronized with the recipe view.

"Synchronizing recipe view and recipe tags" activated 
There may be differences in Runtime between the values displayed in the recipe view and the 
values saved in the associated tags when you edit recipes in both a recipe view and a recipe 
screen. To prevent this, you must synchronize the recipe data record values with the values 
of the recipe tags. 

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
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The values of the recipe view and the associated recipe tags are not synchronized 
automatically. The recipe tags and the recipe view are not synchronized until you use the 
operating element with the "RecipeViewSynchronizeDataRecordWithTags" function.

"Synchronize recipe view and recipe tags" activated and "Manual transfer of individual modified values 
(teach-in mode)" activated 

With this setting, modified recipe values are not synchronized immediately between the recipe 
tags in the recipe screen of the HMI device,and PLC. 

There must be an operating element with the "SetDataRecordToPLC" and 
"GetDataRecordFromPLC" functions present in order to synchronize the values.

If recipe values are changed in the controller, the modified values are displayed immediately 
in the recipe screen if you use the operating element with the "GetDataRecordFromPLC" 
function. 

"Synchronize recipe view and recipe tags" activated and "Manual transfer of individual modified values 
(teach-in mode)" deactivated 

With this setting, modified recipe values are synchronized immediately between the recipe 
tags on the HMI device and PLC. 

When you change recipe values in the recipe screen, these changes are applied immediately 
by the PLC and immediately influence the process.

If recipe values are changed in the PLC, the changed values are displayed immediately in the 
recipe screen.

Special features of some devices
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Basic panels, OP 77A, TP 177A and TP 177A (Portrait) respond differently to the other HMI 
devices in the following respects:   

● Only the simple recipe view is supported.

● Recipe tags are always synchronized with the recipe view (see figure above): When the 
operator changes a value of the recipe element in recipe view, the value of the associated 
recipe tag will also change.

● Recipe tags are not automatically transferred between the PLC and HMI device when they 
are modified. Recipe tags are always transferred manually in teach-in mode.
There must be an operator control object with the "SetDataRecordToPLC" and 
"GetDataRecordFromPLC" functions present in order to synchronize the values with the 
PLC.

 

  Note
Restrictions for recipe tags

Generally, in Basic Panels and OP77A, TP177A (Portrait) recipe tags cannot be used, 
except in a recipe.

 

  Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported 
using ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is 
interrupted.

 

 
 NOTICE

Data loss with several recipe views in the screen

Applies only to Basic Panels, OP73, OP77A, TP177A and TP177A (Portrait): If two or 
more recipe views show the same recipe in a screen, you have a conflict when accessing 
the data.

The result is data loss and unpredictable status of recipe data.

Make sure the operators do not select and edit the same recipe in different recipe views. 
● Display only one recipe in a recipe view.
● Display a different recipe in each recipe view.
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Interaction between the components
There is interaction between the following components at runtime:

● Recipe view
Recipes are displayed and edited in the recipe view on the HMI device.
The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

● HMI device recipe memory
Recipes are saved in the form of recipe data records in the HMI device's recipe memory.

● Recipe tags
The recipe tags contain the values of recipe elements.

Synchronization of recipe data records with the PLC

Overview
When recipe data records are transferred between the HMI device and PLC, both 
communication peers access common communication areas on the other peer.

Recipe data records are always transferred directly. The values of the tags are written directly 
to or read directly from the configured addresses without being placed on the clipboard.

Data transfer types
There are two ways to transfer recipe data records between the HMI device and PLC:

● Transfer without coordination

● Coordinated transfer via the "Data record" area pointer.
 

  Note
Coordinated transfer

Transfer with coordinated transfer is used to prevent the uncontrolled overwriting of data 
in either direction in your control program.

 

Requirements for coordinated transfer
The following requirements apply to coordinated transfer:

● The "Data record" area pointer must be set up for the required connection in the 
"Communication > Connections" editor.

● In the properties of the recipe "Coordinated transfer of data records" is activated.

● The connection to the PLC is specified in the properties of the recipe with which the HMI 
device coordinates the transfer.
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Coordinated transfer
In the case of coordinated transfer, both the PLC and the HMI device set the status bits in the 
shared data compartment.

Coordinated transfer of recipe data records can be a useful solution in the following cases:

● The PLC is the "active partner" for the transfer of recipe data records.

● The PLC evaluates information about the recipe number and name, as well as the recipe 
data record number and name.

● The transfer of recipe data records is started by the following PLC jobs:

– "Set_data_record_in_PLC"

– "Get_data_record_from_PLC"  

"Recipes" editor

Introduction
You can create, configure and edit recipes, recipe entries and recipe data records in the 
"Recipes" editor. The "Recipes" editor also allows you to enter values in recipe data records. 

Structure of the "Recipes" editor
You create recipes in the top part of the table editor. You can also configure them there or in 
the Inspector window.

The bottom part of the table editor has the following tabs:

● Elements
Define the recipe elements of the selected recipe using the table cells provided here. You 
can move recipe elements within the table with the shortcut menu commands, "Up" and 
"Down".

● Data records
Define the values of the data records of the selected recipe using the table cells provided 
here.
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You can then configure the selected recipe, the recipe element or the recipe data record in the 
Inspector window. You will find further notes on configuring the components of a recipe under 
"Configuring Recipes".

Recipe settings
The following settings are available for recipes:

Setting Description
Name of the recipe This is a unique identification for the recipe within the HMI device. 
Display name Appears in the recipe view, for example, in Runtime. You can configure 

display names in multiple languages. Assign descriptive names or 
designations which the operator can associate directly with a recipe, e.g. "fruit 
juice drink".

Recipe number This is a unique identification for the recipe within the HMI device.
Version Information about the recipe. The date and time of the last change to the 

recipe is set by default.
Path Defines the storage location for recipes. The recipes are stored as a file.
Size type [fixed] The recipe data records are limited to a predetermined number by default.
Number of data 
records [fixed]

Maximum number of data records in a recipe in Runtime. The number is 
limited by the recipe memory of the HMI device.

Communication type 
[fixed]

The recipe data records are written directly to the addresses of the recipe 
tags and read from there.

Tooltip Tooltip for the recipe which is shown to the operator in Runtime.
 

 Note
Path

The storage location depends on the storage media available on the HMI device. 

Basic Panels and OP77A, TP177A (Portrait)

These HMI devices have no external memory. Recipes are always saved in the internal Flash 
memory. The "Path" setting is therefore not available.

 

Recipe element settings
You can make the following settings on the "Elements" tab:

Setting Description
Name of the recipe element Identifies a recipe element uniquely within the recipe. Enter meaningful 

names or labels that you can allocate uniquely, such as axis labels on 
a machine or ingredients such as "Flavoring".

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Assign meaningful names or 
designations which the operator can associate directly, e.g. "fruit juice 
flavoring".
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Setting Description
Recipe tag An assigned tag in Runtime stores the current value of the recipe 

element in the recipe data record.
Data type Data type of the recipe tag.
Data length [fixed] Data length of the recipe tag, depending on the data type.
Text list Text is assigned to a value or range of values in a text list. You can 

display this text in an output field, for example. 
The assigned recipe tag must have the data type of a number. The tag 
value must be within the range of values of the text list.    

Default value This is used as the default entry when you create a new recipe data 
record.

Minimum value [fixed] The smallest representable value of a number-based recipe tag, 
depending on the type of data.

Maximum value [fixed] The largest representable value of a number-based recipe tag, 
depending on the type of data.

Decimal places Determines how many places a decimal number is rounded to, e.g. 3 
decimal places and vice versa by what power of ten an integer value 
is multiplied, e.g. 1,000. 

Tooltip Tooltip about the recipe element which is shown to the operator in 
Runtime.

Recipe data record settings
You can make the following settings on the "Data records" tab:

Setting Description
Name of the recipe data 
record

Identifies a recipe data record uniquely within the recipe. 

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Assign meaningful names or 
product numbers which the operator can associate directly with a 
product, e.g. "yellow fruit juice E231".

Recipe data record number Identifies a recipe data record uniquely within the recipe.
Recipe elements 1 to n You can store various values for each recipe element even during 

configuration. Together with the values of the other recipe elements, a 
value always forms a recipe data record. You can store multiple recipe 
data records.
If enabled in the transfer settings, the recipe data records are 
transferred to the HMI device when downloading the project and 
existing data records on the HMI device are overwritten. 

Comment Comment about the recipe data record

10.5.1.2 Displaying and Editing Recipes in Runtime

Recipe screen and recipe view
You can display and edit recipes on the HMI device with a recipe view or recipe screen.   
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Recipe view
The recipe view is an off-the-shelf WinCC display and operator control object.

The recipe view is available in the following views: 

● As anvanced recipe view

● As simple recipe view
 

  Note
Availability

In basic panels and OP77A, TP177A, only the simple recipe view is available.
 

Recipe screen
The recipe screen contains an individual screen form for entering the recipes. The screen form 
contains I/O fields and other display and operator control objects. The recipe functionality is 
implemented with system functions, e.g. for saving recipe data records.

 

 Note
Availability

In basic panels and OP73, OP77A, TP177A (Portrait), the recipe screens are not available.
 

Simple recipe view

Recipe view  
The simple recipe view is a ready-made display element and operator control that is used to 
manage recipe data records. The recipe view shows recipe data records in tabular form. 

The displayed buttons and information in the columns are adjustable.

The values displayed or entered in the recipe view are saved in recipe data records. The 
displayed recipe data record can be written into the PLC by buttons or values can be read in 
from the PLC. 

Layout of the display   
The simple recipe view consists of three areas:

● Recipe list

● Data record list

● Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on 
the configuration, the simple recipe view starts with the recipe list.

The figure below shows an example of the data record list.
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Display of values  
 

 Note
Processed recipe data record is changed in the background  

Only applies for Basic Panels: if an operator has changed a recipe data record and a PLC 
job wants to read or write any recipe data record of this recipe, the PLC job is stopped and 
a system alarm is output. On the other hand, the changed value is displayed immediately if 
only the PLC job and no operator has changed recipe data.

Does not apply for Basic Panels: If an operator has changed a recipe data record and a PLC 
job has changed the values of the recipe data record concerned, the recipe view is not 
updated automatically. To update the recipe view, reselect the respective recipe data record.

 

See also
Recipe view (Page 3598)

Configuration options of the simple recipe view
The response of the simple recipe view can be defined in the recipe view inspector window.

 

 Note
Validity

Some devices, for example basic panels, only support the simple recipe view.

For all other devices, observe the following:
● In the Inspector window, under "Properties > Display > Mode", select "Simple view" as 

"View type".
● The "Properties > Simple view" area contains additional properties only applicable to the 

simple recipe view.
● All other properties are also applicable to the advanced recipe view.
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Displaying recipe data record values only
To display the recipe data in a recipe view for checking only, proceed as follows: 

1. Deselect "Edit mode" in the "General" group.

You cannot create, rename, edit or delete recipe data.  

Writing a recipe data record number or name to a tag
A tag to each recipe data record can be configured in the advanced recipe view. Depending 
on the "String" or "Int" data type of the tag, the name or number of the recipe data record is 
stored in the tag. Conversely, the tag can also be used to select a recipe data record by entering 
the corresponding value. For example, the tag can be transferred as a parameter for a system 
function. 

Proceed as follows:     

1. Enter a tag of the "Int" type in the field "Tag", under "Properties > General > Recipe data 
record".

The number of the recipe data record is stored in a tag.

Configuring an event on the recipe view    
 

 Note
Events and buttons

The "Events" register is faded out when a minimum of one button is enabled.
 

To configure an event for the recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. Deactivate all buttons under "Properties > Toolbar" and "Properties > Simple view".
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3. In the Inspector window, under "Properties > Events", click the event to be configured, e.g. 
"Enable".

4. Configure a function list for the event.

The function list is processed when the operator enables the recipe view.

Animation properties of the recipe view    
To configure an animation of a recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. Click under "Properties > Animations" in the Inspector window.

3. Link a tag to one or more of the following properties.

– X-Position and y-Position

– Design: Colors, flashing

– Operability

– Visibility
In the "Animations> Overview" area, all animations are summarized in tabular form. 
Under "Animations> Tag links > Tag linkage", as well as visibility and position a tag can 
also be linked to height and width.

 

  Note
Animations and buttons

If all buttons are not disabled, an error message appears whilst compiling the project 
for windows-CE HMI devices.
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Constraints on the simple recipe view  
The following functions are not possible in the simple recipe view:

● Synchronizing recipe view and recipe tags

● Writing a recipe number / name to a tag

● Display status bar

● Display data record number

● Display label

● Display table

Advanced recipe view

Recipe view  
The advanced recipe view is an off-the-shelf display and operator control object that is used 
to manage recipe data records. The recipe view shows recipe data records in tabular form. 

The buttons, headers and information displayed in the columns are variable.

The values displayed or entered in the recipe view are saved in recipe data records.

Layout of the display   
The picture below contains an example of the advanced recipe view:
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Display of values  
 

 Note
Changing the recipe data record in the background  

Applies to the processing of a recipe data record: 
If values of the corresponding recipe data record are changed by a control job, the recipe 
view is not updated automatically. 

To update the recipe view, reselect the respective recipe data record.
 

See also
Recipe view (Page 3598)

Configuration options of the advanced recipe view
The response of the advanced recipe view in the recipe view inspector window can be 
determined.

 

 Note
Validity

The following description also applies to the advanced recipe view. In the Inspector window, 
under "Properties > Display > Mode", select "Advanced view" as "View type".

All properties described for the simple recipe view are also applicable in the advanced recipe 
view, except "Properties > Simple view". The "Simple view" area contains additional 
properties only applicable to the simple recipe view.

Basic Panels, OP77A and TP177A (Portrait) do not support any advanced recipe view.
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Displaying a recipe
To allow access to the recipe data records of a specific recipe only in a screen, proceed as 
follows:  

1. Enter the recipe or select an existing recipe in the "Recipe" field, under "Properties > 
General".

2. When a recipe is entered in the "Recipe" field, you will have to enable the "Selection list" if 
you want to display the recipe name in Runtime.

The selected recipe appears in the recipe view.

Writing a recipe number or name and recipe data record number or name to a tag
Both the recipe and the recipe data record can each be configured to a tag in the recipe view. 
Depending on the "String" or "Int" data type of the tag, the name or number of the recipe or 
recipe data record is stored in the tag. Conversely, the tag can be used to select the recipe or 
recipe data record by entering the corresponding value. For example, the tag can be 
transferred as a parameter for a system function. 

Proceed as follows:     

1. Enter a tag of the "String" type in the field "Recipe tag", under "Properties > General > 
Recipe".

2. Enter a tag of the "Int" type in the field "Tag", under "Properties > General > Recipe data 
record".

The name of the recipe and the number of the recipe data record are each stored in a tag.

Using the recipe view as a drop-down list  
To use the recipe view as a selection field for recipes and recipe data records in a recipe 
screen, proceed as follows:

1. Select the tag for the recipe name under "General > Recipe > Recipe tag".

2. Select the tag for the recipe data record name under "General > Recipe data record >Tag".
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3. Disable the "Edit mode". You cannot create, rename, edit or delete recipe data.

4. In order to select recipes, enable "Show selection list" and make sure that no recipe is 
selected under "Properties > General > Recipe".

5. Deactivate all buttons under "Properties > Toolbar".

Configuring an event on the recipe view    
To configure an event on the recipe view, proceed as follows: 

1. Select the recipe view that was added to the screen in the "Screens" editor.
The properties of the recipe view are shown in the Inspector window.

2. In the Inspector window, click the event you want to configure under "Properties > Events".

3. Configure a function list for the selected event.

The function list is processed when the configured event occurs.

Response of the recipe view in Runtime

Screen change
If you change to another screen and have not yet saved changes to the recipe data in the 
recipe view, you will be prompted to save the recipe data. The recipe name and the name of 
the recipe data record are displayed to show which recipe data have not been saved yet.  

Create, change, copy or delete recipe data records
If you attempt to create a new recipe data record and a recipe data record already exists, a 
system alarm will appear on screen. 
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Operating the recipe view with function keys
The Recipe view can be operated with function keys, e.g. if the HMI device does not have 
touch functionality. You can assign functions such as "SaveDataRecord" to the function keys 
on the HMI device.  

Display after import of recipe data
 

 Note
Availability

Import and export of recipe data is not available for Basic Panels and OP77A, TP177A 
(Portrait).

 

If you open the recipe view during the import of recipe data, only the recipe data that is already 
completely imported will be displayed. The recipe view is not automatically updated with a data 
import. In order to have a complete view of all the recipe data, do not open the recipe view 
until the system prompts you that the recipe data has been imported successfully. Alternatively, 
update the recipe view after successful completion of the import procedure.

Updating tag for recipes and recipe data records
 

 Note
Availability

Tags for recipes and recipe data records are not available for Basic Panels and OP77A, 
TP177A (Portrait).

 

The current recipe data record or its number can be saved to a tag, depending on the 
configuration. The tag will be updated under the following conditions:

● The recipe data record has been loaded.

● The screen with the recipe view was not exited during loading.

This operation may take some time.  

Basics on the recipe screen

Introduction
The recipe screen contains an individual screen form for entering the recipes. The screen form 
contains I/O fields and other display and operator control objects. The recipe functionality is 
implemented with system functions, e.g. for saving recipe data records.

The picture below contains an example of a recipe screen:
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 Note
Availability of recipe screens

Basic Panels and OP73A, OP77A, TP177A (Portrait) do not support any recipe screens.
 

Principle
Configuring a recipe screen allows you to customize the display. You can spread large recipes 
over several screens according to topic and display them clearly using features such as 
graphical display and operator control objects.

● Spreading recipes over several screens according to topic

– You can distribute recipe data records with multiple entries across several screens. For 
example, for each plant area you can configure a screen containing the associated 
screen forms for the recipe data records.

Spreading recipes over several screens is useful for HMI devices with small displays as 
they avoid having to scroll through tables in Runtime. 

● Visual machine simulation
You can visually simulate your machine in a screen using graphical screen objects. This 
enables you to display parameter settings more clearly by positioning I/O fields immediately 
next to machine elements such as axes or guide rails. which produces a direct relationship 
between the values and the machine.  
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Synchronizing recipe values     
To enter recipe data record values outside the advanced recipe view in the configured I/O 
fields, activate "Synchronize recipe view and recipe tags" under "Properties > Synchronization" 
in the recipe properties.

The "Synchronize recipe view and recipe tags" option is not available for the simple recipe 
view.

Transferring recipe values automatically     
If the entered recipe values must be immediately transferred to the connected PLC in Runtime, 
deactivate "Manual transfer of individual modified values (teach-in mode)" under "Properties 
> Options". 

Configure the "SetRecipeTags" system function if you want to enable and disable the 
immediate transfer of entered recipe values in Runtime.

System functions
The following system functions are available for operator control of a recipe screen:

● ImportDataRecords

● ExportDataRecords

● LoadDataRecord

● SaveDataRecord

● SetDataRecordTagsToPLC

● GetDataRecordTagsFromPLC

The following system functions are available for operator control of the recipe view when it is 
being used in the recipe screen:
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● RecipeViewSaveDataRecord

● RecipeViewSaveAsDataRecord

● RecipeViewSynchronizeDataRecordWithTags

● RecipeViewDeleteDataRecord

● RecipeViewNewDataRecord

● RecipeViewGetDataRecordFromPLC

● RecipeViewRenameDataRecord (for simple recipe view only)

● RecipeViewShowOperatorNotes

● RecipeViewMenu (for simple recipe view only)

● RecipeViewOpen (for simple recipe view only)

● RecipeViewBack (for simple recipe view only)

The system functions for loading, saving and transferring recipe data records and recipes are 
located in the "Recipes" group. 

10.5.1.3 Configuring Recipes

General configuration procedure
Carry out the following configuration steps when you create a new recipe:

Step Description
1 Define the structure of the recipe.
2 Create tags according to the recipe structure. 

Assign process names to these tags.
3 Create the recipe.
4 Enter the required properties for the recipe:

● Language-dependent view name of the recipe
● "Coordinated transfer of data records" option
Not for Basic Panels:
● Recipe storage location
● "Synchronize recipe view and recipe tags" option
● "Manual transfer of individual modified values (teach-in mode)" option

5 Create the recipe elements and enter the required properties:
● Language-dependent view name of the recipe elements
● Tag binding of the recipe elements
● Standard values and decimal places (power of ten) for the recipe elements

6 Create the recipe data records.
Enter the language-specific display names for the recipe data records.

7 Configure a screen with recipe view or a recipe screen.
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 Note
Basic Panels and OP77A, TP177A (Portrait)

The selection of the storage location is not available for these devices. The recipes are always 
saved in the internal Flash memory.

Recipe tags cannot be used outside a recipe, e.g. not in I/O fields, not in alarms as trigger 
tags, not in systems functions as parameters, etc.

 

 Note
Restrictions recipe view and recipe image

Only the simple recipe view is available in Basic Panels and OP77A, TP177A. Recipe images 
are not available in Basic Panels and OP73, OP77A, TP177A (Portrait).

 

Creating and Editing Recipes

Creating a new recipe

Introduction
To create a complete recipe, start by creating a new recipe, assign the corresponding recipe 
elements and then define the associated values in a recipe data record.

Requirement
● The tags for the recipe have been created.

● The "Recipes" editor is open.
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Create recipe
Create a recipe as follows:

1. Click "Add" in the first free row of the table in the "Recipes" editor.     
The new recipe is created and displayed on a line.

2. Enter a descriptive name for the recipe under "Name" in the "General" area.
This name identifies the recipe unambiguously within the project.

3. Select "Display name" to enter the language-specific name to be displayed in runtime.

4. Select a recipe number in "Number".
The number identifies the recipe unambiguously within the HMI device.
The recipe is automatically assigned a version that indicates the date and time of the last 
change. As an alternative, you can enter specific information relating to the recipe.

5. Specify the storage location for recipe data records in "Data medium". The options offered 
depend on the specific HMI device used.

 

  Note
Basic Panels and OP77A, TP177A (Portrait)

The selection of the storage location is not available for these devices. The recipes are 
always saved in the internal Flash memory.

Recipe tags cannot be used outside a recipe, e.g. not in I/O fields, not in alarms as trigger 
tags, not in systems functions as parameters, etc.

 

6. Enter a tooltip that is shown to the operator in runtime.
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7. To compare recipe tags which are configured in I/O fields with the recipe view in Runtime, 
activate "Synchronize recipe view and recipe tags" in the Inspector window under 
"Properties > Synchronization".

 

  Note
Basic Panels and OP77A, TP177A (Portrait)

Because the recipe tags cannot be additionally used in I/O fields in screens for Basic 
Panels, the "Synchronize recipe view and recipe tags" is not available; you will also not 
be able to use the "Manual transfer of individual modified values (teach-in mode)" option.

 

8. Deactivate "Manual transfer of individual modified values (teach-in mode)" to specify that 
the recipe tags are automatically transferred to the PLC when editing the I/O fields.

9. Activate "Coordinated transfer of data records" to monitor the transfer of recipe data in 
Runtime using area pointers.

10.Select the appropriate connection to the PLC for coordinated transfer under "Synchronize 
with".

Create recipe element
To create recipe elements, proceed as follows:

1. Click the "Elements" tab.

2. Click "Add" in the first free line of the table editor.
A new recipe element is created.

3. Enter a descriptive name for the element under "Name".
The name identifies the element uniquely within the recipe.

4. Enter a language-specific display name for the element under "Display name".
The display name appears in the recipe view, for example, in runtime.
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5. Select the tag you want to link to the recipe element under "Tag".
The value of the recipe data element is saved in Runtime in this tag, which is stored in a 
recipe data record.

6. Enter a tooltip.
The tooltip is shown to the operator in Runtime.

7. Under "Default value", enter the value that you want to use as the default entry when you 
create a new recipe data record.

8. To assign text to a value or range of values, select the relevant text list here. The assigned 
recipe tag must have the data type of a number. The tag value must be within the range of 
values of the text list.
The text stored in the text list is displayed in an output field, for example, in Runtime.

9. Determine exactly how many places a decimal number is rounded to in the "Decimal places" 
column, e.g. 3 decimal places and vice versa by what power of ten an integer value is 
multiplied, e.g. 1,000.
Examples for 3 decimal places: Entering "5" for a recipe element with the "Integer" data 
type gives the value "5000". Entering "5.6789" for a recipe element with the "Real" data 
type gives the value "5.679".

10.Create as many recipe entries as needed for the recipe. The maximum number of recipe 
entries possible depends on the HMI device being used.
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Create recipe data record with known recipe values
To create recipe elements, proceed as follows:

1. Click the "Data records" tab.

2. Click "Add" in the first free line of the table editor.
A new recipe data record is created. The recipe data record has a separate column for 
every recipe element created in the recipe.

3. Enter a descriptive name under "Name".
The name identifies the data record uniquely within the recipe.

4. Enter a language-specific name under "Display name".
The display name appears in the recipe view, for example, in runtime.

5. Enter a recipe data record number under "Number".
The recipe data record number identifies the recipe data record uniquely within the recipe.

6. If you already know the recipe values at the configuration stage, you can enter the relevant 
value for each recipe element.

7. Create as many data records as you need for the recipe.

Visualize processes
10.5 Working with recipes

WinCC Professional V13.0
4192 System Manual, 02/2014



Enter the values in runtime
The following options are available for entering values in the recipe data records at runtime:

● Transfer data directly from the PLC (Teach-in mode)

● Import of values from a CSV file

● Input values on the HMI device
 

  Note
Basic Panels and OP77A, TP177A (Portrait)

The import of values is not available for these devices.
 

Result
The complete recipe is configured. 

Recipe data records with date or time stamp
If you use date or time data, make sure that the system setting for time and date on the 
configuring computer match those on the target system.  Example: You load a recipe data 
record on the target system at 13:55 in which 14 h is stored as the processing time. If it is 
already 14:05 on the target computer, the recipe will not be processed. If an operator processes 
the recipe, change information will not written back correctly into the database. 

After loading to the target system, check the recipes with date or time stamps on the target 
system.

Editing a recipe

Purpose
You want to modify, extend or delete parts of a recipe. 

Requirement
● You have created at least one recipe.

● The "Recipes" editor is open.

Changing recipe settings
To change the recipe settings, proceed as follows:

1. Select the recipe that you want to change in the "Recipes" editor.
The Inspector window opens.

2. Change the recipe configuration in the Inspector window.

You change recipe elements and recipe data records in the same way.
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Change recipe values
To change recipe values, proceed as follows:

1. Select the recipe whose values you want to change.

2. Click the "Data records" tab.

3. Enter the new values in the value columns.

Adding a recipe element
To add more recipe elements to a recipe, proceed as follows:

1. Select the recipe to which you want to add more elements in the "Recipes" editor.

2. Click the "Elements" tab.

3. Click "Add" in the first free line.
The recipe element is created.

4. Configure the recipe element.

You add recipe data records in the same way.

Managing recipes

Requirement
● You have created a recipe with recipe elements and recipe data record.

● The "Recipes" editor is open.

Renaming recipes
We distinguish between internal names and display names for recipes, recipe entries and 
recipe data records.

To rename recipe elements, proceed as follows:

1. Select the recipe that you want to rename.
The Inspector window opens.

2. Select the "Rename" command from the shortcut menu.

3. Enter the new name.
You rename recipe elements and recipe data records on the relevant tab in the same way.

 

  Note

The view names in the "Recipes" editor can also be renamed under "Languages & 
Resources > Project Texts". This possibility is useful when you have already configured 
in several languages for example.
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Copying and pasting recipes
To copy and paste recipes, proceed as follows:

1. Select the recipe that you want to copy.

2. Select the "Copy" command from the shortcut menu.

3. Select the "Paste" command from the shortcut menu in the first free table row.

The copied recipe is pasted into the table. The recipe elements and recipe data records are 
also copied in the appropriate tab with the recipe.

You also copy the recipe elements and recipe data records on the appropriate tab in the same 
way.

If a recipe data record of the same name already exists, the name of the copied recipe data 
record is extended by one digit. This ensures that the name is unique. Recipe data records 
can only be copied or pasted within the same recipe.

Deleting a recipe
To delete a recipe, proceed as follows:

1. Select the recipe that you want to delete.

2. Select the "Delete" command from the shortcut menu.
The recipe is deleted.

You delete recipe elements and recipe data records on the relevant tab in the same way.
 

 Note

When a recipe is deleted, the recipe data records contained in the recipe are also deleted.
 

 Note

When you delete a recipe element, the associated values in the recipe data records are also 
deleted. The assigned tags are retained.
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Configuring the display of recipes

Configuring the simple recipe view

Requirement
● The recipe has been created.

● The "Screens" editor is open.

● The screen has been created and opened.
 

 
 NOTICE

Data loss with several recipe views in the screen

Applies only to Basic Panels, OP73, OP77A, TP177A and TP177A (Portrait): If two or 
more recipe views show the same recipe in a screen, you have a conflict when accessing 
the data.

The result is data loss and unpredictable status of recipe data.

Make sure the operators do not select and edit the same recipe in different recipe views. 
● Display only one recipe in a recipe view.
● Display a different recipe in each recipe view.

 

Procedure
To configure a simple recipe view, proceed as follows:

1. Paste the recipe view into the screen. You will find the recipe view under "Controls" in the 
"Tools" task card.    

2. Only in devices which also support the extended recipe view: Activate "Simple view" under 
"Properties > Display > Mode".
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3. If you want to display only the recipe data records of a specific recipe in the recipe view, 
select the specific recipe under "Properties > General > Recipe".

4. If you only want to display the recipe data in the recipe view, deactivate "Processing mode" 
in the "Recipe data record" area.

5. You can define additional options for the recipe view under "Properties > Appearance" and 
"Properties > Layout".
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6. Select "Properties > Simple view" to select the position, the field length, and the number of 
lines required.
Select "Position > Top" to display the recipe value in the first line of the recipe entry.
Select "Position > Bottom" to display the recipe value in the last line of the recipe entry. 

7. Under "Properties" > Toolbar" specify which menu commands are available in the recipe 
view in Runtime.

Result
The simple recipe view is configured. You can use the recipe view to display and edit recipe 
data during runtime.

Deactivation of the editing mode in "Properties > Properties > General" has no impact on the 
toolbar icons. The buttons you activated in "Properties > Toolbar" can still be used even if 
editing mode is disabled.
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Configuring the Advanced Recipe View

Requirement
● The recipe has been created.

● The "Screens" editor is open.

● The screen has been created and opened.

Procedure
To configure an advanced recipe view, proceed as follows:

1. Paste the recipe view into the screen. The recipe view is found in the task card "Tools" > 
"Controls".    

2. Select "Properties > Display > Mode > Advanced view" in the Inspector window.

3. Select the required settings from the "General" group in the Inspector window.

– If you want to display only the recipe data records for a particular recipe in the recipe 
view, select the recipe under "Recipe" in the "Recipes" area.

– If you want to save the recipe name or the recipe number in a tag, select the tag under 
"Recipe tag" in the "Recipe" area.

– If you want to save the recipe data record name or number in a tag, select the tag under 
"Tag" in the "Recipe data record" area.

– If you only want to display the recipe data in the recipe view, deselect "Edit mode".

– If you only want to use the recipe view to select recipes, disable "Display table" under 
"Properties > Table".

4. You can define additional options for the recipe view under "Properties > Appearance" and 
"Properties > Layout".
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5. If you want to change the label in the recipe view, enter a suitable text under "Properties" 
> "Label".

6. Under "Properties" > Toolbar" specify which buttons are available in the recipe view in 
Runtime.

 

  Note

If you select the "Edit" command in the context menu of the recipe view, the recipe view 
becomes active. To activate the recipe view, the zoom factor must be set to 100%.

You can set the column width and the position of the "Entry name" and "Value" columns 
in active mode.

 

Result
The recipe view is configured. You can use the recipe view to display and edit recipe data 
during runtime. 

Deactivation of the editing mode in "Properties > Properties > General" has no impact on the 
toolbar icons. The buttons you activated in "Properties > Toolbar" can still be used even if 
editing mode is disabled.

Configuring a recipe screen

Introduction
The recipe screen is a screen in which you configure a customized screen form in the "Screens" 
editor. You create the screen form from input/output fields and other display and operator 
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control objects. System functions are used to configure the recipe functionality, such as saving 
recipe data records.    

 

 Note
Availability

Recipe screens cannot be created for basic panels and OP73, OP77A and TP177A (Portrait).
 

Application
You can spread recipe data records containing lots of entries across several screens. For 
example, for each plant you can configure a screen containing the associated screen forms 
for the recipe data records.

You can visually simulate your machine in a screen using graphical screen objects. This 
enables you to display parameter settings more clearly by positioning I/O fields immediately 
next to machine elements, such as axes or guide rails. You can use this to produce a direct 
reference between the values and the machine.

Requirement
● You have created the recipe.

● The "Screens" editor is open.

Procedure
To configure a recipe screen, proceed as follows:

1. Configure the screen and create the I/O fields for the input mask of the recipe.
You can create multiple screens to suit the size and complexity of the recipe.

2. Configure the I/O fields with the tags you have linked to the recipe element.

3. Configure I/O fields for selecting recipes and recipe data records.

Alternatively:

1. Configure a recipe view as a selection list for recipe data records and recipes.

2. Hide the buttons that are not required in the recipe view.

3. Configure the system functions for editing recipe data records on the configured control 
elements.
Control elements are configured buttons in the screen or function keys on the HMI device.
You will find the system functions for editing recipe data records under "Recipes" and 
"Keyboard operation for screen objects".

Result
The recipe screen is created.
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Importing recipes into the configuration and exporting them

Introduction
You can export recipes as a CSV file and import them again into the configuration. 

Application case
Recipe data is exported for long-term storage and backup on a computer. 

In order to unify and distribute recipe data, export the recipe data to an HMI device. Change 
the CSV file in Microsoft Excel and import the CSV file to all HMI devices that require the same 
recipe data.

You want to exchange recipe data between different projects. You change the recipe data in 
Runtime. To transfer the modified recipe data to WinCC ES, export the recipe data records in 
Runtime and copy the CSV file to the configuring computer. There you import the CSV file 
containing the recipe data records into the recipe. And in the opposite direction, you transfer 
the modified recipe data records to the HMI device in WinCC ES in Runtime.

Requirement
● You have created the recipe.

● The structures of the exported CSV file and the recipe in WinCC ES match; name, number 
and data type of the recipe elements are identical. 

● The "Recipes" editor is open.
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Importing CSV files
To import recipe data records into a recipe, proceed as follows:

1. Select the row which contains the desired recipe in the "Recipes" tab.

2. Select the "Import recipe data" command from the shortcut menu.
The "Import" dialog box opens.

3. To select the desired CSV file, go to "File name".

4. Under "Strategy", specify whether a recipe data record with the same recipe number in 
WinCC ES should be overwritten.

5. Specify the list separator and decimal separator under "Data separation". The list separator 
separates individual recipe elements in the CSV file. The decimal separator separates 
integers and decimal places.

 

  Note

Use the same list separator for import as in the CSV file for export.
 

6. Click "Import" to start the operation.

Result
The recipe will be amended by recipe data records from the CSV file that have not yet been 
entered. If the option is selected, existing recipe data records will be overwritten.

An error message is shown in the "Info" of the Inspector window if the structure of the recipe 
does not match the structure of the CSV file.
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Exporting CSV files  
1. Select the row which contains the recipe to export in the "Recipes" tab.

2. Select the "Export recipe data" command from the shortcut menu.
The "Export" dialog box opens.

3. Under "File name", specify the path of the CSV file.

4. Select all recipe data records under "Selection content", or restrict the selection to specific 
record numbers of the recipe data.

5. Specify the list separator and decimal separator under "Data separation". The list separator 
separates individual recipe elements in the CSV file. The decimal separator separates 
integers and decimal places.

6. Click "Export" to start the operation.

Result
The configuration is exported as a CSV file. 
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10.5.1.4 Using Recipes in Runtime

Simple recipe view

Description of the simple recipe view

Layout
The simple recipe view consists of the following display areas:     

● Recipe list

● Data record list

● Element list

This application is illustrated below:

In the simple recipe view, each area is shown separately on the HMI device. You can use the 
shortcut menu to operate each of these display areas.

The simple recipe view always begins with the recipe list.

Operation     
You have the following options for using the simple recipe view, according to the configuration:

● Create, change, copy or delete recipe data records

● Read recipe data records from the PLC or transfer to the PLC

Using the display area and shortcut menu
Toggle between the display areas and the shortcut menus to operate the simple recipe views.

The table below shows the operation of the display area.

Button Key Function
 <Enter> The next lowest display area is opened, i.e. the data record 

list or the element list.
<Esc> The previous display area opens. 
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Button Key Function
 <INS> Creates a new data record for the selected recipe if the list 

of recipes or recipe data records is displayed. Then changes 
to the list of recipe element.
Requirement: "Properties >General > Processing mode" is 
activated.
The button can be simulated with the "Key 
SimulateSystemKey" function even on devices without keys.

 <DEL> Deletes the selected recipe data record in the list of recipe 
data records.
Requirement: "Properties >General > Processing mode" is 
activated.

 <Up>/<Down> Selects the previous/next entry.
 <Pg Up>/<Pg Down> Moves the display up or down one page.
 <Home>/<End> Selects the first/last entry. The first/last entry is selected.

The table below shows the operation of the shortcut menu:

Button Key Function
<Right> The shortcut menu of the display area opens.

<Esc> The menu is closed. 
The display area opens.

 Input of the number of 
the menu command

The menu command is executed.

Shortcut menus of the simple recipe view     
You can click the  button in each display area to call up a selection of commands. The 
command selection lists those commands that are available in the current display area. A 
number is assigned to each command. The command is executed when you enter this number. 
Alternatively select the command and press the <Return> key.     

Shortcut menus in the recipe list

Menu command Function
New A new recipe data record is created for the selected recipe.

If a start value is configured, it is displayed in the input field.
Display tooltip The tooltip configured for the recipe is displayed.
Open The record list of the selected recipe opens.
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Shortcut menus of the recipe data record list

Menu command Function
New Creates a new recipe data record.

If a start value is configured, it is displayed in the input field.
Deleting The displayed record is deleted.
Save as The selected data record is saved under a different name. A dialog box opens 

where you can enter the name.
Rename Renames the selected data record. A dialog box opens where you can enter 

the name.
Open The element list of the selected data record opens.
Previous The recipe list opens.

Shortcut menus of the recipe element list

Menu command Function
Save The selected data record with the recipe element is saved.
To PLC The displayed values of the selected data record are transferred from the 

HMI device to the PLC.
From PLC The recipe values from the PLC are displayed in the recipe view of the HMI 

device.
Save as The data record is saved under a new name. A dialog box opens where you 

can enter the name.
Display tooltip The tooltip configured for the recipe element is displayed.
Rename The selected recipe element is renamed. A dialog box opens where you can 

enter the name.
Previous The data record list opens.

Shortcut menus in the data record list
 

 Note
HMI device dependency

The following menu commands are configured in Basic Panels and in OP 77A, TP 177A, 
TP 177A (Portrait) and TB 177B.

 

Menu command Function
To PLC The displayed values of the selected data record are transferred from the 

HMI device to the PLC.
From PLC The recipe values from the PLC are displayed in the recipe view of the HMI 

device.
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Using the simple recipe view

Controlling the simple recipe view with mouse or touchpad
To control the simple recipe view with mouse or touchpad, proceed as follows:

1. Select the desired recipe from the recipe view.

2. Click the button.
The shortcut menu is opened.

3. Select the desired menu command.
The menu command is executed.

Controlling the simple recipe view with the keyboard
To control the simple recipe view with the keyboard, proceed as follows:

1. Press the <Tab> key until the simple recipe view is selected.

2. Select the desired recipe with the cursor keys.

3. Press <Right>.
The shortcut menu is opened.

4. Press the <Down> key until the desired menu command is selected.

5. Press <Enter> to confirm the command.

Key shortcuts for the simple recipe view
The following key shortcuts are activated for the simple recipe view in Runtime if "Activate 
keyboard operation" is enabled in the ES. 

Key shortcut Effect Menu command
<Insert> Generates a new recipe data record New
<Del> Deletes the recipe data record displayed. Delete

Managing recipe data records

Recipe data record administration
You have the following options for managing the simple recipe view, according to the 
configuration:

● Creating new recipe data records

● Copy recipe data records

● Edit recipe data records

● Delete recipe data records
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Creating new recipe data records
To create a new recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to create a new recipe data record.

2. Select the "New" command from the shortcut menu for the recipe list.
A new data record with the next available number will be created. 
The element list of the new recipe data record opens.

3. Enter values for the elements of the recipe data record.
The configuration data may already contain default values for the recipe data record. 

4. Select the "Save" command from the shortcut menu for the element list.
The dialog "Save as" opens.

5. Enter the name and number of the recipe data record.

6. Click the "OK" button.

Result
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system event will be output to the screen. 

Copying a recipe data record
To copy a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to copy an existing recipe data record.

2. On the HMI device, select the recipe data record of which you want to save a copy.

3. Select the "Save As" command from the shortcut menu for the data record list.
The dialog "Save as" opens. The recipe data record is automatically given the next free 
recipe data record number.

4. Under name, enter the name of the record.

5. Click the "OK" button.

Result
The recipe data record is stored under the new name.

Modify recipe data record
To change a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to edit an existing recipe data record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Select the recipe data record.
The element list of the recipe data record is displayed.

4. Replace the old values with new ones.

5. Select the "Save" command from the shortcut menu for the element list.

Visualize processes
10.5 Working with recipes

WinCC Professional V13.0
System Manual, 02/2014 4209



Result
The modified values are applied to the recipe data record.

Deleting a recipe data record
To delete a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device from which you want to delete an existing recipe data 
record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Select the "Delete" command from the shortcut menu for the data record list.

4. Confirm this security prompt to delete the data record.

Result
The recipe data record is deleted. 

Read recipe data record from PLC

Introduction
In Runtime, you can change values directly in the plant that are also stored in recipes in the 
HMI device. This applies if a valve was opened further directly in the plant than was specified 
in the recipe. The values of the recipe data records saved in the HMI device possibly no longer 
match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data record. 

The read values are written to the recipe data record that is currently displayed on the HMI 
device.

Procedure
To read a recipe data record from the PLC, proceed as follows:

1. Open the recipe on the HMI device.
The data record list opens.

2. Select the element list of the recipe data record to which you want to apply the values from 
the PLC.

3. Select the "From PLC" command from the shortcut menu for the element list.
The values are read from the PLC and displayed in the current recipe data record.

4. If you want to save the values, select the "Save" or "Save As" command.

Result
The values are read from the PLC, visualized on the HMI device and saved to the recipe data 
record. 
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Transferring a recipe data record to the PLC

Introduction   
For the values of a data record that was changed in the recipe view to take effect, you must 
transfer the values to the PLC.

The values displayed in the recipe view are always transferred to the PLC.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. Open the recipe you want to use.
The data record list opens.

2. Select the element list of the recipe data record whose values you want to transfer to the 
PLC.

3. Select the "To PLC" command from the shortcut menu for the element list.

Result
The values of the recipe data record are transferred to the PLC.

Advanced recipe view

Description of the advanced recipe view

Application
The recipe view is used to display, edit and manage data records.    
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Operation
Depending on the configuration you can:   

● Create, change, copy or delete recipe data records

● Synchronizing recipe data records with the associated recipe tags

● Read recipe data records from or transfer to the PLC

Operating elements
The following operating elements can be configured in the recipe view:   

Operating 
element

Key combination Function

 The configured tooltip is displayed.

<Ctrl+Space 
Bar>

Creates a new recipe data record.
If a start value is configured, it is shown in the input field.

<Ctrl+Enter> Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

<Ctrl+*> The recipe data record is saved under a different name regardless 
of the recipe view. A dialog box opens where you can enter the 
name.

<Ctrl+Del> The displayed recipe data record is deleted.

<Ctrl+=> The system always updates the current value of the recipe view 
with the up-to-date recipe tag value.
When the value shown in the recipe view is more recent than the 
current recipe tag value, the system writes this value to the recipe 
tag.
"Synchronize recipe view and recipe tags" must be activated in the 
recipe properties before this function can be used.

<Ctrl+Down> The values of the set recipe data record displayed in the recipe view 
are transferred to the PLC.

<Ctrl+Up> The recipe values from the PLC are displayed in the recipe view.

Using the advanced recipe view

Introduction
You can control the recipe view using both mouse or touchpad or with the keyboard.
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Controlling the recipe view with mouse or touchpad
To control the recipe view with mouse or touchpad, proceed as follows:  

1. Select the recipe you want to use.
The records for the recipe are displayed.

2. Click on the data record you wish to edit.

3. Click the button whose function you want to run.

Controlling the recipe view with the keyboard
To control the recipe view with the keyboard, proceed as follows:  

1. Press the <Tab> key until the cursor reaches the field for selecting the recipe.

2. Press <Enter>.
The drop-down list box for the recipes opens. 

3. Select a recipe. You navigate between the next or previous entry in the list by using the 
cursor keys <Left>, <Right>, <Up> and <Down>.

4. Select a data record.

5. Press the <Tab> key until the operator control object you wish to use is selected.

Alternatively you can control the recipe view using certain key combinations.

Key shortcuts for the advanced recipe view
The following key shortcuts are activated for the advanced recipe view in Runtime if "Activate 
keyboard operation" is enabled in the ES. 

Keys
shortcut

Effect Menu command Button

<Ctrl
+Space>

Generates a new recipe data record.
Any configured start value is displayed in 
the input field.

Add data record

<Ctrl+Del> Deletes the recipe data record displayed. Delete data record"
<Ctrl+Enter> Saves the edited data record by its current 

name.
Save

<Ctrl+*> Saves the edited data record by a new 
name.

Save as

<Ctrl+=> Compares the values of the selected data 
record with the values on the PLC.
Any value in the recipe view which is more 
recent compared to the current recipe tag 
value is written to the recipe tag.
This function is only available if enabled in 
the ES. 

Synchronizing recipe tags

<Ctrl+Down> Transfers the current value to the PLC. Write to PLC
<Ctrl+Up> Reads the actual value from the PLC. Read from PLC
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Managing recipe data records

Administration of recipe data records
You have the following options for managing recipe data records, according to the 
configuration:

● Create new recipe data records

● Copy recipe data records

● Edit recipe data records

● Delete recipe data records

Creating new recipe data records 
To create a new recipe data record, proceed as follows:      

1. Select the recipe on the HMI device in which you want to create a new recipe data record.

2. Click the  button or press the <Ctrl + Spacebar> keys.
A new recipe data record with the next available number is created.
If you change the new data record number to an existing data record number, the existing 
data record is overwritten.

3. Enter values for the elements of the data record.
The elements of the recipe data record can be assigned default values depending on the 
configuration.

4. Click the  button or press the <Ctrl + *> keys.
The dialog "Save as" opens.

5. Enter a name for the data record.

6. Click on "OK" to confirm your input.
The data record is saved under the new name. 
If the recipe data record already exists, a dialog is opened. In this dialog, specify whether 
the existing data record is to be overwritten.

Result
The new recipe data records will be saved to the selected recipe. If the recipe data records 
already exists, a system alarm will be output to the screen. 

Copying a recipe data record
To copy a recipe data record, proceed as follows:       

1. Select the recipe on the HMI device in which you want to copy an existing recipe data record.

2. Select the recipe data record that you want to copy on the HMI device.

3. Click the  button in the recipe view or press the <Ctrl + *> keys.
The dialog "Save as" opens.
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4. Enter a name for the data record.

5. Click on "OK" to confirm your input.

Result
The recipe data record is stored under the new name.

Modify recipe data record
To change a recipe data record, proceed as follows:            

1. Select the recipe on the HMI device in which you want to edit an existing recipe data record.

2. Select the recipe data record that you want to edit on the HMI device.

3. Replace the old values with new ones.

4. Click the  button in the recipe view or press the <Ctrl + Enter> keys.

Result
The modified values are applied to the recipe data record.

Delete recipe data record      
To delete a recipe data record, proceed as follows:            

1. Select the recipe on the HMI device in which you want to delete an existing recipe data 
record.

2. Select the recipe data record that you want to delete on the HMI device.

3. Click the  button in the recipe view or press the <Ctrl + Del> keys.

Result
The recipe data record is deleted. 

Synchronizing recipe data record

Introduction
Differences between the following values may occur during runtime:

● The values displayed in the recipe view

● The actual values of the recipe tags
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Depending on the configuration, the values displayed in the recipe view are synchronized with 
the recipe tags. Synchronization encompasses all tags of a recipe data record.

 

 Note
Changed tag name

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Requirement
● A recipe data record is displayed in the recipe view.

● The values of recipe tags were modified by teaching, for example.

Procedure
To synchronize a recipe data record, proceed as follows:

1. Click the  button in the recipe view or press the <Ctrl + => keys.

Result
The system always updates the current value of the recipe view with the up-to-date recipe tag 
value.

When the value shown in the recipe view is more recent than the current recipe tag value, the 
system writes this value to the recipe tag. 

Read recipe data record from PLC

Introduction
In Runtime, you can change values directly in the plant which are also stored in recipes in the 
HMI device. This applies if a valve was opened further directly in the plant than was specified 
in the recipe. The values of the recipe data records saved in the HMI device possibly no longer 
match the values in the PLC.

You can read the values of the recipe tags from the PLC and write them to a recipe data record. 

The read values are written to the recipe data record that is currently displayed on the HMI 
device.
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Procedure
To read a recipe data record from the PLC, proceed as follows:

1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to fetch the values from 
the PLC.

3. Click the  button in the recipe view or press the <Ctrl + Up> keys.

Result
The values are read from the PLC and displayed on the HMI device. 

Transferring recipe data records to the PLC

Introduction
For the values of a data record that was changed in the recipe view to take effect, you must 
transfer the values to the PLC.

The values displayed in the recipe view are always transferred to the PLC.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. Select the recipe on the HMI device.

2. On the HMI device, select the recipe data record of which you want to transfer the values 
to PLC.

3. Click the  button in the recipe view, or press the <CTRL+DOWN> shortcut key.

Result
The values of the recipe data record are transferred to the PLC. 
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Exporting and importing recipe data records

Introduction          
Depending on configuration and the HMI device, either export recipe data records to a CSV 
file, e.g. for editing in MS Excel, or import these from a CSV file. The extent to which you can 
influence these processes is determined by the project configuration. 

 

 Note
Restrictions for Import / Export

It is not possible to export or import the recipes for the following HMI devices:
● Basic Panels
● OP 77A
● OP 177A
● TP 177A (Portrait)

Complete recipe data, but not single recipe data records, can be exported and imported using 
ProSave in CSV format and transferred to the HMI device. Thereby, Runtime is interrupted.

 

A list separator is used to separate the data records during importing and exporting.
 

 Note

The list separator used as the default depends on the setting for formats and numbers in the 
operating system. Select "Start > Settings > Control Panel > Regional and Language 
Options". If you want to import or export recipe data records, do not use this list separator in 
the display name of the recipe data records.

 

The following fields can be configured on the user interface, for example, in order to use the 
export/import function:

● Selection field for the recipe

● Selection field for the recipe data record

● Operating element with the "ExportDataRecords" functionality

● Operating element with the "ImportDataRecords" functionality

Export recipe data record
To export a recipe data record, proceed as follows:

1. Select the relevant recipe and recipe data record from the selection boxes.

2. Click the control element with the "ExportDataRecords" functionality.
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Result
The recipe data record are exported to a CSV file. 

 

 Note

New data records created in runtime can be exported to an external file.
 

Importing recipe data records
To import a recipe data record, proceed as follows:

1. Select the relevant recipe and recipe data record from the selection boxes.

2. Click the control element with the "ImportDataRecords" functionality.

Result
The recipe data record are imported. 

Reactions to modifications of the recipe structure

Introduction
Different recipe structures can occur in the following situations:

● In the event of changes during commissioning

● When work is carried out on the machine by the machine manufacturer (retrofit)

● When CSV files are imported, the structure of the CSV file can differ from the recipe 
structure.

Nevertheless, you can still use any recipe data records already created.
 

 NOTICE

When a tag is renamed, the assignment is lost. 
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Effects
Handle any structural differences as follows:

● If the old recipe data record or the CSV file contains additional values, these values will be 
discarded.

● If the old recipe data record or the CSV file contains values of the wrong data type, the 
configured default value will be used in the recipe data record.
Example: The recipe data record contains values that show the tank contents and were 
input as floating point numbers. However, the corresponding recipe tag expects an integer 
value. In this case, the system discards the transferred value and the configured default 
value is used. 

● If the old recipe data record or the CSV file contains too few values, the configured default 
value will also be used in the recipe data record.

10.5.1.5 Examples

Example of creating a recipe

Task
In this example, you create three recipes for a fruit juice mixing machine. The fruit juice mixing 
machine produces drinks with "orange", "apple" and "tropical" flavors. You create a recipe for 
each flavor.

Each recipe contains a recipe data record for the following mixing ratios:

● Beverage

● Nectar

● Juice

Settings
The settings relate to an HMI device which is connected to a SIMATIC S7-300 or 
SIMATIC S7-400.

In this example, you will need the following tags, recipes, recipe entries and recipe data records:

Tags:

Name PLC connection Address Type
Liter water Yes DB 120, DBW 0 Integer
Liter concentrate Yes DB 120, DBW 4 Integer
Kilo sugar Yes DB 120, DBW 8 Integer
Gram flavoring Yes DB 120, DBW 12 Integer

Recipes:
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● Orange

● Apple

● Tropical

Recipe entries:

Recipe element Associated tag
Liter water Liter water
Liter concentrate Liter concentrate
Kilo sugar Kilo sugar
Gram flavoring Gram flavoring

Recipe data records for drink, nectar and juice:

Data record name Liter water Liter concentrate Kilo sugar Gram flavoring
Beverage 30 70 45 600
Nectar 50 50 10 300
Juice 5 95 3 100

Procedure
To create a recipe, proceed as follows:

1. Create the following tags with the settings specified above: "LiterWater", "LiterConcentrate", 
"KiloSugar" and "GramFlavoring".

2. Create the "Orange", "Apple" and "Tropical" recipes with the settings indicated above. 
Create the recipe entries in each recipe.
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3. Not for Basic Panels: Configure each recipe so that you can synchronize the recipe data 
records between the recipe screen and recipe view. The values of the recipe tags should 
not be transferred automatically to the PLC.
You will have to make the following settings in the Properties dialog for the recipe concerned:
Under "Properties > Options":

– Activate the "Synchronize recipe view and recipe tags" option.

– Activate the "Manual transfer of individual modified values (teach-in mode)" option.

4. Create the data records indicated above in each recipe. Enter the values indicated above 
in each of the data records.

Result
The "Orange", "Apple" and "Tropical" recipes have been created.

Example of configuring a recipe screen

Task
In this example, you create a recipe screen for the visualization of values of the fruit juice 
mixing machine. You use a recipe view to select the recipes and their associated recipe data 
records. 

You should be able to use the following functions with the buttons:

● "Load" Button
The selected recipe data record is loaded from the recipe memory on the HMI device and 
displayed in the recipe screen.

● "Save" Button
The displayed recipe tags are saved in the recipe memory of the HMI device.
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● "Data to PLC" button
The displayed tags are transferred to the PLC.

● "Data from PLC" button
The current recipe data record in the PLC is transferred to the recipe variables and 
displayed on the HMI device. 

Requirement
● The "Creating a recipe" sample application has been carried out.

● You have created and opened the "Fruit juice mixing plant" screen.

Settings
In this example, you need the following tags and buttons with the indicated settings:

Tags:

Name PLC connection Type
RecipeNumber No Integer
Data record number No Integer

Buttons:

Labeling Configured event System function
Load Click LoadDataRecord
Save Click SaveDataRecord
Data to PLC Click SetDataRecordTagsToPLC
Data from PLC Click GetDataRecordTagsFromPLC
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Procedure
To configure a recipe screen, proceed as follows:

1. Drag-and-drop the "Liter water", "Liter concentrate", "Kilo sugar" and "Gram flavoring" tags 
from the object view to the "Fruit juice mixing machine" process screen.
Four IO fields are created and linked by the specified tags. 

2. Add a recipe view containing selection fields for the recipe name and data record name 
only.
Make the following settings in the Inspector window for the recipe view:

– Select the "Advanced view" display type under "General".

– Deselect "Edit mode" under "Properties > General" and "Display table" under "Properties 
> Table".

– Connect the "Recipe tag" field to the "RecipeNumber" tag.

– Connect the "Tag" field to the "DataRecordNumber" tag.

– Disable all the buttons under "Properties > Buttons".

3. Assign the above settings to four buttons. Transfer each "Recipe number" and "Data record 
number" tag as a parameter for the recipe number and recipe data record number.

Result
You can select the recipe and the associated recipe data record from the recipe view and 
modify the recipe values at runtime. You can load, save and transfer the recipe data records 
using the buttons. 

Scenario for Entering Recipe Data Records in Runtime

Objective
You want to enter production data on the HMI device without disturbing the process that is 
currently underway. Therefore, the production data should not be transferred to the PLC. 

Requirement
● The recipe has been created.

● The recipe has the following settings:

– "Synchronizing recipe view and recipe tags" is activated or deactivated.

– If "Synchronize recipe view and recipe tags" is activated, "Manual transfer of individual 
modified values (teach-in mode)" has to be activated.
This will prevent the recipe tags being transferred automatically between the HMI device 
and PLC.

● A recipe screen or a screen with recipe view is available.

● There is an operating element for saving the recipe data records.
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Sequence

1. Enter the production data in the recipe view or recipe screen.

2. Save the modified recipe data record.

Transfer the recipe data to the PLC
The configuration may provide operating elements for transferring recipe data to the PLC.

Scenario for a manual production sequence

Objective
A reading device connected to the PLC reads a bar code on the work piece to be processed. 
The recipe data record names correspond to the respective bar code names. This will enable 
the PLC to load the necessary recipe data record from the storage medium of the HMI device. 
The recipe data record is displayed for inspection on screen. 

You want to be able to correct the transferred production data online, if necessary.
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Requirement
● You have created the recipe.

● The recipe has the following settings:

– "Synchronizing recipe view and recipe tags" is activated.

– "Manual transfer of individual modified values (teach-in mode)" is deactivated.
 

  Note

The changes are immediately transferred to the PLC
 

● There is a recipe screen available.
There may also be an operating element for saving the recipe data records in the recipe 
screen.

Sequence

Behavior when the recipe view is used
If the recipe view is used, it is not possible to transfer changes immediately. You must use the 
operating element to transfer the recipe data record to the PLC.
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Scenario for an Automatic Production Sequence

Objective
You want production to be executed automatically. The production data is to be transferred 
directly to the PLC, either from the recipe memory in the HMI device or from an external storage 
medium. The screen display is not necessary.

Requirement
● You have created the recipe.

● The recipe has the following settings:

– "Coordinated transfer of data records" is activated.
The production data is transferred to the PLC, so a coordinated transfer with the PLC 
in necessary to prevent the data from being accidentally overwritten.

Sequence

Implementation
You can control the flow of data in the following ways:

● The control program controls the automatic transfer via control jobs or via WinCC system 
functions, if necessary.
The sequence is controlled via the status information in the mailbox and via return values 
from the functions used.

● One or more scripts control the automatic transfer via WinCC system functions.
The sequence can be checked using the values returned by the functions used.
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You can implement the automatic production sequence with available system functions: 

● "ImportDataRecords"
This function loads data records from a *.CSV file into the recipe memory of the HMI device.

● "SetDataRecordToPLC"
This function transfers a data record from the HMI device's recipe memory to the PLC. 

10.5.2 Working with recipes

10.5.2.1 Principles

Definition and applications

Introduction   
Recipes are collections of related data, for example, machine parameter settings or production 
data.

Examples:

● Machine parameter settings that are needed to convert production to a different product 
variant.

● Product components that result in different compositions for different end products.

● Data from technical processes that is continuously stored at longer intervals.

A recipe has a fixed data structure. The structure of a recipe is defined once at the configuration 
stage. A recipe contains recipe data records. These differ in terms of their values, but not their 
structure. 

The project data is stored in an SQL database. Recipe data records are always transferred 
completely and in a single pass between the HMI device and the PLC. You can import the 
production data in Runtime additionally by a CSV file. 

Using recipes  
Recipes can be used in the following situations:

● Manual production
You select the required recipe data and display it on the HMI device. You modify the recipe 
data as required and save it on the HMI device. You transfer the recipe data to the PLC.

● Automatic production
The control program starts transfer of the recipe data between the PLC and HMI device. 
You can also start the transfer from the HMI device. Production is then implemented 
automatically. It is not essential to display or modify the data.

● Saving project data
You are using a recipe which is not interconnected with the PLC to save project data. Project 
data saved to the recipe can be accessed using scripts in Runtime. 
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Views  
Views relate data from existing recipes that have at least one common feature. They are used 
to compile data from the recipes.

Display recipes and views
The recipes and views can be displayed and edited on the HMI device in the following ways:

● A recipe view within a process screen

● A recipe screen

Entering and modifying the recipe data
You enter the data in the individual recipe data records and modify it as required. The following 
options are available:

● Enter the data during configuration
If the production data exists already, enter it in the "Recipes" editor during recipe 
configuration.

● Entering the data in Runtime
Frequent adaptations of production data should be handled directly in Runtime.

– Enter the data directly on the HMI device.

– Set the parameters directly on the machine. You then transfer the data from the PLC to 
the HMI device and save it in the recipe.

– You import the recipe data from already swapped-out CSV files.

See also
Recipe view in reports (Page 4368)

Recipe report (Page 4369)

Recipe structure

Introduction
The basic structure of a recipe is illustrated with reference to a filling station in a fruit juice 
plant.     

There may be several different recipes in an HMI device. A recipe can be compared to an 
index card box that contains several index cards. The index card box contains several variants 
for manufacturing a product family. The complete data of a manufacturer variant are contained 
on one file card.

Example:

In a soft drinks production plant, a recipe is needed for different flavors. Drink variants include 
fruit juice drink, juice, and nectar.
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Recipe   

 

5 
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80 

15 

35 

20 
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Recipe data records     
Each index card represents a recipe data record needed to manufacture a product variant.

Recipe elements   
Each index card in a drawer is printed identically. All the index cards contain fields for the 
different ingredients. Each field corresponds to a recipe element. Each recipe data record 
contains the same elements. The records differ, however, in the value of the individual 
elements. 

Example:

All beverages contain the same elements: 

● Water

● Concentrate

● Sugar

● Flavoring

The records for juice drink, fruit juice, or nectar differ, however, in the quantity of sugar used 
in production.

Recipe Recipe data record Recipe elements Value
Drinks 1 Item Juice

Water 5
Sugar 30
Flavoring 23
Concentrate 80
Coloring F30
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Recipe Recipe data record Recipe elements Value
2 Item Nectar

Water 15
Sugar 35
Flavoring 20
Concentrate 70
Coloring F35

Recipe queries
A recipe query is a recipe whose elements are made up of various recipes. Example: 
Recipe query Element1 = Recipe1_Recipe element 3
Recipe query Element2 = Recipe3_Recipe element 7
Recipe query Element3 = Recipe2_Recipe element 10
The used recipes must already exist.

A recipe query is displayed in a recipe view. Instead of having its own data records, however, 
a recipe query combines all the recipe data records of the recipes used. Example: If there are 
10 recipe data records for each recipe in the example above, the recipe query covers 10*10*10 
= 1000 data records. You can define a relation in the recipe query to limit these data records. 
Example:
Recipe query Element2 = Recipe query Element3
The relation acts as a filter for the recipe query (see also example below).

Example
A "Label" recipe query is created from the "Drinks" and "Order" recipe for label printing. 

Fill quantity

Data elements

Number

Data elements

Order Customer

Item

Quantity

Fill quantity

RecipeData elements

Drinks

Water

Sugar

Flavoring

Concentrate

Coloring

Best before

Recipe

Item

Label Item

Best before

View

Coloring

Sugar
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The figure below shows the "Label" recipe query. The necessary information for the label is 
contained in the "Drinks" and "Order" recipes. The recipe elements "Article", "Sugar", 
"Colorant" and "Best before" are transferred to the "Label" recipe query from the "Drinks" 
recipe, the recipe elements "Article" and "Net weight" from the "Order" recipe.

The "Article" recipe element is double:
Drinks.Article, Order.Article, Drinks.Water, Order.Net weight...
The recipe view first shows every combination of these data in its own line. However, the recipe 
data of the ordered article and not of another article must be on the label which is ensured by 
the following condition:
Drinks.Article = Order.Article
The recipe view is filtered and only the ordered articles with their recipe data displayed line by 
line.

Displaying Recipes in Runtime
You have the following options of displaying recipe data in Runtime:   

● In I/O fields at any position in plant screens

● In a recipe view in table format

You can connect a recipe view to a selected recipe and/or recipe query during configuration. 
The recipe view can only access this recipe and/or recipe query.   

You can assign various authorizations for access.

Communication with the PLC

Introduction
Data are transmitted in two ways between recipes and the PLC:

● By recipe tags with the aid of control tags

● By message frames with the aid of raw data tags

"Control tags" communication type   
A complete recipe data record is transferred to the recipe tags and vice versa by control tags. 
The recipe tags have a communication connection to the PLC

"Raw data tag" communication type   
The PLC and the HMI device exchange raw data tags as message frames with a fixed structure. 

Raw data tags offer the following advantages:

● Several data records transferred between the PLC and the HMI device.

● Parts of a recipe data record transmitted.

● Use the same raw data tag for several recipes.
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See also
Overview (Page 4255)

"Recipes" Editor

Introduction
You can create, configure and edit the following objects in the "Recipes" editor.

● Recipes and the corresponding recipe elements and recipe data records.

● Recipe queries and the corresponding recipe query elements and relations

The "Recipes" editor also allows you to enter values in recipe data records. 

Structure of the "Recipes" editor
The upper part of the working area in the "Recipes" editor contains the "Recipes" and "Recipe 
queries" tabs.

Create the recipes and/or recipe queries in the "Recipes" and "Recipe queries" tabs and 
configure these in the Inspector window. 

The tab called in the upper area of the working area determines the tabs to display in the 
bottom area of the working area.

"Recipes" tab

● Recipe elements
Define the recipe elements of the selected recipe using the table cells provided here. You 
can move recipe elements within the table with the shortcut menu commands, "Up" and 
"Down".

● Recipe data records
Define the values of the data records of the selected recipe using the table cells provided 
here.

"Recipe queries" tab

● Recipe query elements
Here, you define the recipe query elements of the selected recipe query via the table cells. 
You move recipe queries and recipe query elements within the table using the "Up" and 
"Down" shortcut menu commands.
You define the relations between the recipe query elements in the "Conditions" field.

Inspector window
In the Inspector window, you configure each element that is selected in one of the tables, e.g. 
a recipe query or recipe data record.
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Recipe settings
The following settings are available for recipes:

Setting Description
Recipe name This is a unique identification for the recipe within the HMI device. 
Display name Appears in the recipe view, for example, in Runtime. You can configure 

display names in multiple languages. Enter meaningful names or 
designations which you can assign directly to a product, such as 
"Fruit_juice_Orange".

Recipe number This is a unique identification for the recipe within the HMI device.
For the "Raw data tag" communication type, the "PLC" field in the message 
frame must correspond to a valid recipe number.

Version Information about the recipe. The date and time of the last change to the 
recipe is set by default.

Path Defines the storage location for recipes. The recipes are not saved in a file 
but in a database.

Type You can limit the recipe data records to a maximum number you select 
yourself.

Maximum number of 
data records

Maximum number of data records in a recipe. This limits the required recipe 
memory of the HMI device. The value "0" appears for the "Unlimited" size type.

Communication type Define how the HMI device and PLC exchange recipe data as a rule:
● No communication
● Raw data tags
● Tags

Raw data tag Tag which transfers the recipe data as a frame between the PLC and the HMI 
device in the "raw data tag" communication type.

Control tag task, ID, 
field, value

Four tags which control the data transmission between the recipe and recipe 
tags and therefore the PLC in the "tags" communication type.

For reading
For writing

Name of the authorization which has read, write access to the recipe in 
runtime.

Last modification
Last user

Change information of a recipe is displayed in Runtime.

Tooltip Infotext on recipe for the configuration engineer 

Recipe element settings
The following settings are available for recipe elements:

Setting Description
Recipe element name Identifies a recipe element uniquely within the recipe. Enter meaningful 

names or labels that you can allocate uniquely, such as axis labels on a 
machine or ingredients such as "Flavoring".

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Enter meaningful names or 
designations which you can assign directly to a product, such as 
"Fruit_juice_Orange".
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Setting Description
Recipe tag An assigned tag in Runtime stores the current value of the recipe element in 

the recipe data record.
Data type Data type of the recipe tag.
Data length Data length of the recipe tag, depending on the data type.
Default value This is used as the default entry when you create a new recipe data record.
Minimum value The smallest representable value of a number-based recipe tag, depending 

on the data type.
Maximum value The largest representable value of a number-based recipe tag, depending 

on the data type.
For reading
For writing

Name of the authorization which has read, write access to the recipe in 
runtime.

Value required The recipe element has a value other than zero.
Unique values A value for the recipe element may only occur once in all recipe data records. 

Example recipe element "Order number".
Fast search The value of the recipe element is indexed for faster searching.
Tooltip Infotext on recipe element for the configuration engineer 

Recipe data record settings
The following settings are available for recipe data records:

Setting Description
Recipe data record 
name

Identifies a recipe data record uniquely within the recipe. 

Display name Appears in the recipe view, for example, in Runtime. You can configure 
display names in multiple languages. Enter meaningful names or labels that 
you can assign directly to a product, such as "Product_numbers".

Recipe data record 
number

Identifies a recipe data record uniquely within the recipe.

Recipe element name Name of the created recipe element The values which the recipe element 
has in the different recipe data records (lines) are saved under this name. A 
value forms a recipe data record respectively with the values of the other 
recipe elements in a line. You can already save the values during the 
configuring.

Last modification
Last user

Modification information items of a recipe data record are displayed in 
runtime.

Comment Comment about the recipe data record

AP01421094
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10.5.2.2 Configuring Recipes

General configuration procedure 

Configuring steps
Follow the steps outlined below to create a recipe:

Step Task
1 Define the structure of the recipe.
2 Define the communication mode for the recipe. 
3 Define the control tags or raw data tags according to the communication mode 

selected.
4 Create the recipe and define its properties.
5 Create the recipe elements in accordance with the structure planned.
6 Create the recipe data records.
7 Configure views of multiple recipes, if required.
8 Configure a screen which contains a recipe view and interconnect this recipe 

view with the recipe or view.
Or:
Configure a screen which contains I/O fields and buttons. Configure button 
functions for reading and writing the values of recipe data records. 

 

 Note
Runtime API

Runtime API provides you with extensive uaArchive functions to edit recipes and recipe 
queries (see section "Interfaces > Runtime API", subsection "Auto-Hotspot").

 

Configuring Recipes and Elements

Creating a New Recipe

Introduction
Create the new recipes using the "Recipes" tab of the "Recipes" editor.

Naming the recipe
Do not use keywords or reserved words of the SQL database language for recipe names (see 
subsection "SQL keywords (Page 4291)").
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Recipes with date or time stamp
If you use data or time data, make sure that the system setting for time and date on the 
configuring computer matches that on the target system. Example: You load a recipe data 
record on the target system at 13:55 in which the processing time 14 h is stored. If it already 
14:05 on the target computer, the recipe will not be processed. If an operator processes the 
recipe, modification information is not written back correctly into the database. 

After loading to the target system, check the recipes with date or time stamps on the target 
system.   

Requirement
● You have created the control tags or the raw data tag.

● The "Recipes" editor is open.

Procedure
Create a recipe as follows:

1. Double-click the first empty table row in the "Recipes" tab of the "Recipes" editor.    

2. Select "Properties > General > Settings > Name" in the Inspector window and enter a 
descriptive recipe name.
The name identifies the recipe uniquely within the project.

3. Select the "Display name" field to enter the language-specific name to be displayed in 
Runtime.

4. Define whether or not the recipe data records are limited to a specified maximum number 
in the area "Size" under "Type".

5. If the size type is limited, specify the maximum number of recipe data records of a recipe 
under "Number of data records".
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6. Specify the "Communication type" under "Properties > Communication":

– If you have selected "Raw data tag", create a raw data tag and select it under "Raw data 
tag".

– Select "No communication" if you use the recipe only to save project data.

7. Select the control tags for access to the recipe under "Properties > Control tags" if you have 
selected the "Tags" communication type.
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8. Define under "Properties > Security" which operator authorizations have read and write 
access to the recipe in Runtime.

9. Under "System fields", specify whether to display the "Last modification" and "Last user" 
entries.

Result
You have created the recipe.

Creating Recipe Elements and Data Records

Introduction
Select the "Recipe elements" tab in the bottom area of the "Recipes" editor to set up the 
elements for the selected recipe. You can also enter the recipe element values in the "Recipe 
data records" tab.
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Requirement
● The tags for the recipe have been created.

● You have created the recipe.

● The recipe is selected in the "Recipes" editor.

Procedure
Create a recipe element as follows:

1. Double-click the first empty table row in the "Recipe elements" tab.

2. Select "Properties > General > Settings > Name" in the Inspector window and enter a 
descriptive name for the recipe element. This name must be unique within a recipe.

3. Select the "Display name" to enter the language-specific name to be displayed in Runtime.

4. When the recipe has the "Tags" communication type:
To link the recipe element to a tag, select a tag under "Properties > Basic settings > 
Settings". The data type will be displayed below.

5. For a "String" data type, also specify the maximum length of the string under "Data length". 
The "Settings" area on the right shows the value range for number-based data types, for 
which you can also specify a default value.

6. When the recipe has the "Raw data tag" communication type or "No communication": Select 
the "Data type" and also the "Data length" of the recipe element for the "String" data type.

7. Define under "Properties > Security" which operator authorizations have read and write 
access to the recipe element in Runtime.
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8. Define in "Properties > Extras" which conditions the values of the recipe element must 
satisfy. For faster search, the values can be indexed:

9. Double-click the first empty table row in the "Recipe data records" tab to set up a recipe 
data record.

10.Enter the desired value for the recipe element in the table editor.

Result
The recipe element and a corresponding recipe data record are created with one value. 

Importing recipes into the configuration and exporting them again

Introduction
You can export recipes as a CSV file and import them again into the configuration. 

 

 Note

You cannot import or export data records from recipe queries.
 

Application case
You export recipe data to store and back up recipe data long-term on a computer. 

You export the recipe data to an HMI device to standardize and distribute recipe data. You 
change the CSV file Microsoft Excel and import the CSV file to all HMI devices which require 
the same recipe data.

You want to exchange recipe data between different projects. You change the recipe data in 
Runtime. To transfer the changed recipe data to WinCC ES, export the recipe data records to 
Runtime and copy the CSV file to the configuring computer. There you import the CSV file 
containing the recipe data records into the recipe. And in the opposite direction, you transfer 
the modified recipe data records to the HMI device in WinCC ES in Runtime.
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Requirement
● You have created the recipe.

● The structures of the exported CSV file and the recipe in WinCC ES match; name, number 
and data type of the recipe elements are identical.  

● The "Recipes" editor is open.

Importing CSV files
To import recipe data records into a recipe, proceed as follows:

1. Select the row which contains the desired recipe in the "Recipes" tab.

2. Select the "Import recipe data" command from the shortcut menu.
The "Import" dialog box opens.

3. Select the desired CSV file with the recipe data under "File name".

4. Under "Strategy", define whether a recipe data record in the CSV file overwrites an existing 
recipe data record in WinCC with the same recipe data record number.

5. Click "Import" to start the operation.

Result
The recipe will be amended by recipe data records from the CSV file that have not yet been 
entered. If the option is selected, existing recipe data records will be overwritten.

An error message is shown in the "Info" of the Inspector window if the structure of the recipe 
does not match the structure of the CSV file.
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Exporting CSV files   
1. Select the row which contains the recipe to export in the "Recipes" tab.

2. Select the "Export recipe data" command from the shortcut menu.
The "Export" dialog box opens.

3. Select a path for the CSV file under "File name".

4. Select the desired recipe under "Recipe name".

5. Select all recipe data records or limit the selection to certain recipe data record numbers 
under "Select content".

6. Click "Export" to start the operation.

Result
The configuration is exported as a CSV file. The list separator is the semicolon 
"RecipeElement_1;RecipeElement_2". The decimal separator is a period, e.g. "3.14".

Procedure for changing the recipe structure

Introduction
Different recipe structures can occur in the following situations:

● Due to changes during commissioning

● If a machine is upgraded by the machine manufacturer (retrofit)

● When CSV files are imported, the structure of the CSV file can differ from the recipe 
structure.
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Nevertheless, you can still use any recipe data records already created.
 

 NOTICE

When a tag is renamed, the assignment is lost. 
 

Effects
If the structure of the CSV file differs from the structure of the recipe, deviations are handled 
as follows:

● If the old recipe data record or the CSV file contains additional values, these values will be 
discarded.

● If the old recipe data record or the CSV file contains values of the wrong data type, the 
configured default value will be used in the recipe data record.
Example: The recipe data record contains values that show the tank contents and were 
input as floating point numbers. However, the corresponding recipe tag expects an integer 
value. In this case, the system discards the transferred value and the configured default 
value is used. 

● If the old recipe data record or the CSV file contains too few values, the configured default 
value will also be used in the recipe data record.

Configuring recipe queries

Creating recipe queries

Introduction   
A recipe query is a set of recipe elements from various recipes. Example: Recipe query "Water 
consumption":

● Water from the "Fruit juice drink" recipe

● Water from the "Juice" recipe

● Water from the "Nectar" recipe

You can link recipe elements to form relations, such as "Nectar.Water > 
FruitJuiceDrink.Water". In the recipe query, only the data records that satisfy the relation are 
displayed in Runtime. In the example, these are the records in which the water requirement 
of the "Nectar" recipe is greater than that of "Fruit juice drink".

You can assemble recipe queries from recipe elements in the "Recipes" editor in the "Recipe 
queries" tab. Select the recipe elements from the recipes that are included in the recipe query 
and set their relation. The relation expresses a condition. Only those combinations of recipe 
elements which satisfy the condition (true) are displayed in the recipe view.

You can also edit the recipe query data in Runtime. The data you have edited are applied to 
the original recipe in Runtime.

The recipe query does not support the following actions:   
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● Creating new recipe data

● Deleting recipe data

Requirement
● You have created at least two recipes.

● The recipes are in the same database on the same HMI device.

● The recipes have at least one identical recipe element in the same data format.

Creating recipe queries
Create a recipe query as follows:

1. In the "Recipes" editor, double-click the first empty table row in the "Recipe queries" tab.
A new recipe query is created.     

2. In the inspection window, enter a name for the recipe query under "Properties > General > 
Name " to indicate its function.

3. Select the "Display name" to enter the language-specific name to be displayed in Runtime.

Creating recipe query elements and relations
To create a new element for the recipe query and the relation, follow these steps:

1. Double-click on the first free table row in the "Recipe query elements" tab.

2. Under "Properties > General > Recipe element", select the recipe element to insert into the 
query.

3. Create other recipe query elements as required.

4. Select the recipe query in the "Recipe queries" index.
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5. Select a recipe query element and the desired operator as a left and right operand in the 
Inspector window under "Properties > Relation > Relation".

6. Click the "Add" button.
The relation appears under "Condition". If a condition was already defined there, the new 
relation with the logical operator "AND" is added. You can edit the condition.

7. Change the order of the recipe query elements as required using drag-and-drop.

Result
The recipe query is created and a condition is defined. Only those combinations of recipe 
elements which satisfy the condition are displayed.
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10.5.2.3 Configuring the visualization of recipes 

Displaying recipes

Introduction
Recipes and recipe queries are displayed on the HMI device as follows:

● In a recipe view    

● In individual I/O fields

Recipe view
The recipe view displays the recipes and queries in tabular format. Each recipe data record 
uses one line.

The picture below contains an example of a recipe view.

Operators use the recipe view in Runtime and, for example, create new data records or import 
recipes. You transfer a recipe data record to the recipe tags and vice versa with two buttons 
in the recipe view.

 

 Note

You select a recipe or recipe query when configuring a recipe view. The operator can change 
the selection and other properties in Runtime. 
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 Note
Data source

The recipe view only accesses one recipe or recipe query respectively.
Recipe query

An operator can only change the displayed recipe data in Runtime. The creation and deletion 
of data records and their transfer from/to the PLC is not possible.

 

Recipes in the screen   
You can show recipe elements in I/O fields alternatively instead of a preconfigured recipe 
display. The following screen shows an example for a screen with configured I/O fields in the 
"Tags" communication type.

The blue fields at the top show the values of the recipe tags which have a communication 
connection with the PLC. The yellow fields at the bottom show the contents of the four control 
tags. In the example the blue recipe values were written into recipe data record number 3 (task 
= 6) and the number of errors = 0 returned.

See also
Control tags (Page 4257)

Properties of the recipe view

Introduction
The recipe view visualizes recipe elements in table format on the screens. Operators can edit 
recipe data in the recipe view in Runtime.

Configuration of the recipe view
The following optional recipe view configurations are available:

● General > Display: You select a recipe or recipe query as a data source and define whether 
recipe data records can be edited, inserted or deleted.

● General > Print job
The recipe view is automatically linked by logical operation with the system print job for 
recipe views. Create a logical link to the recipe view for any custom print jobs or system 
print jobs.

● General > Time
Define the time base for the "Last access" display, for example the coordinated universal 
time (UTC). You can include the time base selected for output in Runtime.

● Appearance, layout, text format
You define colors and design, size and position of the recipe display, font type and font size.
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● Window
You define the font size, window header of the recipe display and other window properties.

● Table
You define the appearance of the column headers, table and boundary lines and the 
behavior for selecting and sorting data records.

● Table > Mark
Determine whether lines or only cells can be marked with the mouse.
Configure the properties of the selection rectangle which can be shown around the marked 
cells or lines of the table.
Configure the marking colors for the markable cells and/or lines as required. The color 
defined by the system for the marking is used with the "Automatic coloring" property.

● Table > Sorting
Determine whether sorting is to take place and if so, with click or double-click on the column 
header.  Define the order of sorting which is to run cyclically when clicking or double-clicking 
the column header: either sorting ascending - descending or ascending - descending - no 
sorting
Configure the sorting symbol and sorting index which are to be shown right-justified in the 
column header. You show sorting sequence and sorting order of the columns.
If you activate the "Use sorting key" option, the sorting symbol is displayed as a sorting key 
above the vertical scrollbar. You sort the selected column in the configured sorting order 
with a mouseclick on the sorting key. The sorting key is not displayed if there is no vertical 
scrollbar in the table.

● Columns
You determine which recipe elements are displayed in what order in Runtime. You apply 
write protection to certain elements and determine the width and formatting.
Some columns can also show the content and header as symbols. Determine how these 
columns are displayed in the "Layout" field. The text and symbol can be displayed together.

● Filter
As a filter criterion you define a condition for a recipe element and link several conditions. 
The data record is not displayed until all the filter criteria are satisfied.

● Toolbar
In addition to the appearance of the toolbar you define which buttons are visible in what 
order in Runtime and with what operator authorization they can be operated.
Activate the buttons in the list which you need for operating the WinCC-Control in Runtime. 
Information about the function of the individual buttons can be found in the subsection 
"Operation in Runtime"
Define a hotkey for a button if necessary.
If you assign operator authorizations to the individual buttons, the button is only released 
in Runtime for the users who have the appropriate operator authorization.
If you deactivate the "Active" option for a button, the activated button is displayed in Runtime 
but cannot be operated.

● Status bar
In addition to the appearance of the status line, you define what information is displayed in 
the status line in Runtime, e.g. the recipe data record number.
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● Data export
A standard file name and a standard directory are already entered by switch tags. However, 
you can assign your own file names and directory names.
You can use the following switch tags.
@OBJECTNAME: Object name of the recipe display, see "Properties > Miscellaneous"
@PROJECTPATH: Project directory
@CURRENTDATE: Current date
@CURRENTTIME: Current time

● Safety
You determine whether and how changes to the properties of the recipe display can be 
saved in Runtime and after a screen change and which authorization is necessary for 
changing.

● Miscellaneous
You define the visibility and layer for the recipe display.

Configuring a recipe view

Requirement
● You have created a recipe or a recipe query.

● A screen is created and open in the "Screens" editor.
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Procedure     
Configure a recipe view as follows:

1. Drag the "Recipe display" object from the "Controls" palette of the "Tools" task card into 
the screen.

2. Select the desired recipe or recipe query in the Inspector window under "General > Display".

3. Define the write and read rights for the recipe display in Runtime under "General > Allow 
in Runtime".

4. Select "Appearance," "Layout," and "Text format" to define additional display options for 
the recipe view.
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5. Select "Properties" > Columns" to define the recipe elements which will be visible and write-
protected in Runtime.

6. Select "Toolbar" to define the recipe view buttons to be available in Runtime.
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7. Select "Status bar" to define the scope of information to display in the status bar in Runtime.

8. Select "Filter" to define the filter criteria for recipe elements in Runtime.

9. Select "Sort" to define the sorting criteria for recipe elements in Runtime.

Result
The recipe view is configured.

Exporting recipe data in Runtime

Introduction        
In Runtime you export the recipe data with a button in the recipe display. You configure 
operation of the data export in Runtime.

How to configure the operation of the data export
1. Define a file name and a directory for the export file under "Properties > Data export".

The file name may be made up of names you select yourself and the following switch tags:
@OBJECTNAME: Object name of the recipe display
@PROJECTPATH: Project directory
@CURRENTDATE: Current date
@CURRENTTIME: Current time

1. Define the file extension, e.g. "CSV".

2. Define the scope of the data export:

– All Runtime data are exported.

– Selected Runtime data are exported. 
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3. Configure the operation of the data export during runtime. Define:

– The "Data export defaults" are displayed in runtime.

– The user may change the file name or the directory.

4. If "Show dialog" is deactivated, the data are exported immediately to the defined export file 
on pressing the "Export log" button.

5. Save the project.

6. Activate the "Export log" button under "Properties > Toolbar".

Results
In Runtime you can export all or selected recipe data to a defined file with the  button.

Configuring persistence

Introduction        
A user can configure WinCC-Controls in Runtime. You define what effect the online 
configuration has in Runtime.

The changes configured in Runtime are saved separately from the screen in the engineering 
system. The screen is thus retained in its original configuration.

Procedure
1. Select "Properties > Safety > Persistence > Online configuration" which you can only 

operate in the engineering system. The online configuration can then be defined 
permanently in Runtime:

– "No persistence" The online configurations are not retained in Runtime. This default 
leaves the user no option in Runtime. The online configurations are lost the next time 
the screen changes and with deactivate/activate.

– "Persistence" This default leaves the user the options of "reject", "retain" or "reset". With 
the "retain" option the online configurations are retained the next time the screen 
changes and with deactivate/activate.

– "Persistence in Runtime". This default leaves the user the options of "reject", "retain" or 
"reset". With the "retain" option the online configurations are retained the next time the 
screen changes but are lost when the project is deactivated/activated.

 

  Note

In case of a user change, the different configurations are not saved until you have 
executed a screen change.

 

2. Define what operator authorization the user must have to carry out online configuration.
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3. "Screen change characteristics" can be operated in the engineering system and in Runtime 
with the defaults "Persistence" and "Persistence during Runtime". The "reset" option can 
only be operated in Runtime because the original configuration is in the engineeringm 
system.
Select one of the three effects of the online configuration in the next screen change:

– Activate "Reject changes" so that the online configuration only exists for as long as the 
screen is selected. The changes are rejected at the next screen change. The recipe 
display appears as configured if you select the screen again.

– Activate "Retain changes" so that the online configuration is not lost at the next screen 
change.

– Activate "Reset" so that the configured screen is saved again in Runtime. All online 
configured changes are lost.

 

  Note

The screen is also replaced in Runtime when saving the screen or in Delta compiling 
(change loading). All online configured changes are lost.

 

4. Save the configuration.

10.5.2.4 Data transfer to the PLC

Overview
The options for transferring recipe values between the PLC and HMI device are as follows: 

● No data transfer

● "Tags" communication type

● "Raw data tag" communication type

No data transfer 
The recipe is not used for transferring recipe data to the PLC but as a data memory and user 
log: You store values which belong together in data records to which you have multiple access. 
In the simplest case an operator switches between the recipes in a recipe view. The respective 
recipe data are loaded into the recipe tags and processed further there.   

"Tags" communication type   
Recipe tags transfer the recipe values to the PLC. Vice versa the values from the PLC are 
written into a recipe data record by recipe tags. Control tags control the data transfer. The 
following tasks are started automatically by the desired entry into the corresponding control 
tags.

● Write data records into the recipe tags and therefore into the PLC

● Read data records out of the recipe tags and therefore out of the PLC
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● Delete data records

● Create new data records
 

  Note

A complete data record is always transferred in the "Tags" communication type. You 
cannot transfer recipe data from a recipe query.

 

"Raw data tag" communication type   
The automation system sends the raw data tag as a message frame to the HMI device as an 
active partner. The message frame contains the following: 

● Desired target recipe

● Desired target recipe data records

● Job e.g. "Read", "Write" or "Delete"

● New recipe values, e.g. for "Write" job

The HMI device returns recipe and acknowledgement data as a message frame. 

The "BSEND/BRCV" function of the S7 communication is used for the data exchange. The 
consecutive number of the recipe serves to identify the recipe uniquely in the PLC (PLCID). 

The PLC requires a user program which executes the following in Runtime:

● Collect data if necessary via I/O fields in the HMI device.

● Check data.

● Create raw data tag as a message frame.

● Send message frame.

If you want to start creation of the message frame from the HMI device, you configure functions 
in the screen which start the user program. 

 

 Note

The following is possible in the "Raw data tag" communication type:
● Transfer of an individual recipe element
● Transfer of an entire recipe data record
● Transfer of multiple recipe data records

Data transfer from the recipe view or by control tags is not possible. 
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Control tags

Introduction
With the "Tags" communication type in the recipe, you transfer the recipe data between the 
PLC and the HMI device using recipe tags. The data transfer is controlled by four control tags 
which are assigned fixed to a recipe. Other control tags can be assigned to another recipe.

Data transfer is started automatically once you have entered the required value at the 
corresponding control tag.

 

 Note

All four control tags must always be specified in a recipe to ensure that it works. Do not change 
the data type of the control tags.

 

 Note

You must implement access protection for the control tags of a protected recipe separately 
using the object properties of the screen, I/O field or button, for example.   

 

Control tags

Control tag Required data type Meaning
ID Long Number of the recipe data record within the assigned recipe
Job Long Read out of the recipe tags, write into 

the recipe memory:
6

Read out of the recipe memory, write 
into the recipe tags:

7

Delete in the recipe memory: 8
After the job has been carried out, an error ID can be seen in the "Job" control 
tag:
No error 0
Error -1

Field String The name of the recipe element
Make sure that you do not use the display name. 

Value String The value of the recipe element
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Requirement
● Communication type is set to "Tags" in the recipe.

● You have configured a process screen with all I/O fields required for process tags and 
control tags of the recipe.
Example:

Inserting the control tag
The following control tag combinations are supported:

● "ID" and "Job" control tags
The control tag "ID" indicates the number of the recipe data record which is transferred.
The "Job" control tag indicates whether the selected recipe data record is written, read or 
deleted (6, 7, 8) in the recipe memory of the HMI device.

● "Job", "Field" and "Value" control tags
The recipe data record is selected for the data transfer whose recipe element "Field" has 
the recipe value "Value". Example field = "Water", value = "5 liters".
The "Job" control tag indicates whether the selected recipe data record is written, read or 
deleted (6, 7, 8) in the recipe memory of the HMI device.

 

  Note
Different data records may not contain the same recipe value in the "Field" recipe element

You have to activate the "Unique values" checkbox under "Properties > Options" for the 
recipe element. Otherwise no clear assignment of the recipe data record by the value is 
possible and the first data record which satisfies the "Value in field" condition is used.

If the type "String" is assigned to the element, you must enclose the entry in the "Value" 
I/O field in inverted commas (such as 'Cola Light').
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More combinations of values for the "ID" and "Job" control tags

ID Job = 6 Job = 7 Job = 8
-1 Data record from the recipe tags is 

read and appended to the end in the 
recipe in the recipe memory.

- Data record with the lowest ID is 
deleted in the recipe in the recipe 
memory.

-6 Data record from the recipe tags is 
read and written into the recipe data 
record with the lowest ID in the recipe.

Data record with the lowest ID is 
written in the recipe into the recipe 
tags.

Data record with the lowest ID is 
deleted in the recipe in the recipe 
memory.

-9 Data record from the recipe tags is 
read and written into the recipe data 
record with the highest ID in the recipe.

Data record with the highest ID is 
written in the recipe into the recipe 
tags.

Data record with the highest ID is 
deleted in the recipe in the recipe 
memory.

See also
Displaying recipes (Page 4247)

Using the recipe screen (Page 4280)

Raw data tag

Data Transfer via Raw Data Tags
This section describes the transfer of recipe data between the HMI device, and PLC using raw 
data tags. The BSEND/BRCV function is used in the PLC. The message frame containing the 
raw data tag is actively sent by the PLC.

The message frames may contain one or more write or read jobs.   

Data transfer procedure
1. The PLC sends the message frame to the HMI device.

2. The HMI device returns the following:

– Data, if requested

– A processing acknowledgement

The HMI device returns a separate acknowledgement for every job.
 

 Note

The PLC is the active partner in this data transfer, so it is the PLC that must start the required 
function. On the HMI device, you can start the required function by means of a change in 
value of an external tag, for example, and the corresponding analysis in the PLC.

Do not use the "Job type" parameter to start the data transfer. The "Job type" parameter used 
in the job, or acknowledgement header only works with respect to recipes.
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Message Frame Structure for Jobs

General message frame structure
Structure of a message frame for sending jobs: 

 Length
Message frame header 16 bytes
  
Job header 1 12 bytes
Data for job 1 n bytes
  
Job header 2 12 bytes
Data for job 2 n bytes
  
  
  
Job header n 12 bytes
Data for job n n bytes

Example
The total length of a message frame with a job, and 10 bytes of job data is 38 bytes.

16 bytes +12 bytes +10 bytes = 38 bytes

Structure of the message frame header
16 bytes are needed for a message frame header. 

Function of the field Comment Byte
Message frame length in bytes LSB 1) Max. length 4091 bytes 1
Message frame length in bytes 2
Message frame length in bytes 3
Message frame length in bytes MSB 2) 4
Transfer type "1" from the HMI device 

"2" from the PLC
5

Reserved  6
Number of jobs in the message frame 
LSB 1)

 7

Number of jobs in the message frame 
MSB 2)

 8

Number of the recipe (PLCID) 1. character, in ASCII 9
Number of the recipe (PLCID) 2. character, in ASCII 10
Number of the recipe (PLCID) 3. character, in ASCII 11
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Function of the field Comment Byte
Number of the recipe (PLCID) 4. character, in ASCII 12
Number of the recipe (PLCID) 5. character, in ASCII 13
Number of the recipe (PLCID) 6. character, in ASCII 14
Number of the recipe (PLCID) 7. character, in ASCII 15
Number of the recipe (PLCID) 8. character, in ASCII 16

① Least significant byte
② Most significant byte

 

 Note

The number of the recipe is defined automatically in the "Recipes" editor during configuration, 
but can later be changed as needed. Enter the number in ASCII format in the message frame. 

 

Structure of a job header
12 bytes are needed for a job header. 

Function of the field Comment Byte
Job length in bytes LSB 1)  1
Job length in bytes MSB 2)  2
Job type see 

"Description of job types and error codes"
3

Reserved  4
Field number LSB1)  5
Field number MSB2)  6
Data record number LSB1)  7
Data record number  8
Data record number  9
Data record number MSB2)  10
Selection criterion LSB1) Element value entered or element number as selection 

criterion.
11

Selection criterion MSB2) not if 0 12

① Least significant byte
② Most significant byte

The field number corresponds to the consecutive number of the recipe element. 
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Message Frame Format for Acknowledgements

General Structure of an Acknowledgement Message Frame
Structure of the acknowledgment message frame to the PLC: 

 Length
Acknowledgement header 24 bytes
Acknowledgement data  

Structure of an acknowledgment header
24 bytes are needed for an acknowledgement header 

Function of the field Comment Byte
Message frame length in bytes LSB 1) Max. length 4091 bytes 1
Message frame length in bytes 2
Message frame length in bytes 3
Message frame length in bytes MSB 2) 4
Transfer type "1" from HMI device, 

"2" from the PLC
5

Reserved  6
Job type See 

Description of "Job Types and Error Codes"
7

Error code See 
Description of "Job Types and Error Codes"

8

Reserved  9
Reserved  10
Field number LSB1)  11
Field number MSB2)  12
Data record number LSB1)  13
Record number  14
Record number  15
Data record number MSB2)  16
Number of the recipe (PLCID) 1st character, in ASCII 17
Number of the recipe (PLCID) 2nd character, in ASCII 18
Number of the recipe (PLCID) 3rd character, in ASCII 19
Number of the recipe (PLCID) 4th character, in ASCII 20
Number of the recipe (PLCID) 5th character, in ASCII 21
Number of the recipe (PLCID) 6th character, in ASCII 22
Number of the recipe (PLCID) 7th character, in ASCII 23
Number of the recipe (PLCID) 8th character, in ASCII 24

① Least significant byte
② Most significant byte

Visualize processes
10.5 Working with recipes

WinCC Professional V13.0
4262 System Manual, 02/2014



Acknowledgement data
The acknowledgement can contain the following: 

● The required recipe data record

● The required content of the element

● No data

Configuring raw data tag

Raw data tags of the "SIMATIC S7" channel

Introduction
A tag of the type raw data type is a data telegram on a transport level. The contents of the raw 
data tag are not fixed and therefore only the sender and the receiver can interpret the 
transmitted data. There are no format changes in WinCC for this data type. Maximum length 
is 65535 Byte.

WinCC distinguishes between two types of raw data tags: Raw data tag for free application 
use and raw data tag for handling S7 functions.

Raw data tag for free application use
Raw data tags for free application use are used for transferring user data blocks between 
WinCC and PLC and handle only user data. It distinguishes between:

● Raw data tag as byte array

● Raw data tag for BSEND/BRCV functions

Raw data tag for handling S7 functions
These raw data tags do not have any channel-specific header and are normally used by the 
message system and for process data entry in WinCC.

No further description is needed here as these are tags and functions internal to the channel.
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Creating raw data tag

Procedure
1. Create a new connection, for example, "SIMATICS7".

2. In the "Parameters" tab, select "WinCC RT Prof connection > Send/receive raw data block".

3. Under "Connection", specify the hexadecimal value of the connection ID for the connection 
resource that was assigned during the configuration of the controller.

4. Create a new tag "Raw data tag_1".

5. Select "SIMATICS7" as "Connection".

6. Select the "Raw" "Data type" and specify a sufficient "Length" in bytes.
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7. Select "BSEND / BRCV" under "Raw data."

8. Specify the "R_ID" parameter, which was assigned in the configuration of the controller.

9. Create a new recipe.

10.In the Inspector window under "Properties > Communication" select "Raw data tag" as 
communication type and "Raw data tag_1" as raw data tag.

11.Create the recipe elements and recipe data records. Ensure that the recipe number 
matches the "PLC" field in the message frame.

Raw data tag for BSEND/BRCV functions of S7 communication

Introduction  
Raw data tags for "BSEND/BRCV" functions are used for transferring user data blocks between 
WinCC and AS and handle only user data.

This raw data type can be used to access the "BSEND/BRCV" functions of S7 communication. 
The functions are available in a S7-400 or a S7-300 using CP343. The initiative of data transfer 
always lies with the sending partner; hence "BSEND/BRCV" functions can also be used to 
implement event-controlled or sporadic data block transfers.

For resource reasons, it is advisable to keep the number of BSEND/BRCV raw data tags low.

Resource limitations for using S7 functions "AR_SEND" and "BSEND/BRCV" for 
communication with S7-400
The maximum data volume that can be sent simultaneously using AR_SEND and/or BSEND/
BRCV functions from AS to WinCC is limited to 16 kByte.

Example:
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● 1x BSEND with a max. of 16 Kbytes

● 1x AR_SEND with 8 kBytes + 1x BSEND with 8 kBytes

● 1x AR_SEND with 10 Kbytes + 1x AR_SEND with 2 Kbytes + 1x BSEND with 4 Kbytes
 

  Note

If the data block of a write job is transferred to AS and has not yet been deleted or fully 
deleted from the receiving buffer, then the next write job will be rejected with an error 
message. During such an error display, write jobs with R_ID > 0x8000 0000 are written 
to a connection-specific queue and the system tries to repeat the write job for 6 seconds.

The responsibility for time co-ordination for transfer rests with the user and needs to be 
noted as shorter time intervals for write jobs.

 

Configuring a PBK Connection for Using "BSEND/BRCV" functions
"BSEND/BRCV" functions can only be used via a "hard-configured connection", a so-called 
PBK connection (programmed component communication). To configure a hard-configured 
connection, you must mention a connection resource (hex: 10 ... DF) in the connection 
parameters. This connection resource will be assigned by STEP 7 when the connection is 
configured within the PLC. The connection must be configured in AS as passive connection 
end-point.

A hard-configured connection can also be used to handle "normal" read and write jobs. If very 
large data areas are to be transferred via the connection, then the data blocks are transferred 
in multiple PDUs. For performance reasons, it would therefore be better to create a separate 
connection for "BSEND/BRCV" functions.

Raw data tag for "BSEND/BRCV" functions with the "R_ID" parameter
Raw data tags for transferring "BSEND/BRCV" data blocks are configured as raw data of type 
"BSEND/BRCV" with a "R_ID". The data length is derived implicitly from the sent or received 
data volume.
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A decimal value of 1 to 999999 must be specified for "R_ID". The R_ID is assigned at the time 
of configuration in AS and is used for distinguishing multiple data block transfers over one 
connection. The send and receive calls are always notified with reference to this R_ID in the 
underlying communication sub-system (SIMATIC Device Drivers). A raw data tag is thus 
assigned to one unique R_ID.

Sending a "BSEND/BRCV" raw data tag
Sending a "BSEND/BRCV" raw data tag takes place in the same way as writing a "normal" 
process tag. After sending the data block and receiving a positive acknowledgement from AS, 
the data block is transferred to the image of the Data Manager.

Receiving a "BSEND/BRCV" raw data tag
"BSEND/BRCV" raw data is sproradically sent to the channel on the initiative of the AS. Hence 
it is not possible to explicitly read S7 raw data tags.

The BSEND/BRCV mechanisms do not include any synchronization functions. If no user has 
logged in to receive the data during the start-up phase, the data blocks sent by AS will bounce 
on the receiver side. Hence, the user has to take care of the synchronization and, for e.g., 
release the sending direction on the AS by setting a flag with a data word.

Job types and error codes

Description of the job types

Type Description
4 The existence of the recipe is checked.
5 All data records are deleted from the recipe.
6 The data record is requested from the HMI device and is written to the PLC.
7 The data record from the PLC is written to the required data record.
8 The data record is deleted from the recipe.
9 The element of the required data record is requested from the HMI device and is written 

to the PLC.
10 The element of the required data record is written to the required data record.

Description of the error codes

Group No. Description Possible Fault Causes
General 0 The function has been executed. --
Recipe 2 Data not available No recipe configured with this PLCID.

Data record 101 Data not allowed Recipe structure does not tally, such as 
number or type of fields.
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Failed data record insertion or update.
Possible causes:
● Recipe is of the "limited" type.
● A min. or a max. value is configured 

for a field.
Incorrect criterion

Data record 102 Data not available For job type 6 only:
● No data available
● Criterion is incorrect.

Field 201 Data not allowed For job type 10 only: 
Criterion is incorrect.
Possible causes:
● Field not found.
● A min. or a max. value is configured 

for a field.
Field 202 Data not available For job type 9 only: 

● Criterion is incorrect.
● No field found corresponding to 

criterion.
General 254 Function not found --
General 255 Undefined error --

Differences between data formats

Introduction
The data formats in WinCC conform to the Intel and Microsoft data formats. The least significant 
byte is saved first and the most significant byte is saved last. This data format is very common 
and is generally known as the "Intel format". 

The data formats in WinCC differ fundamentally from the data formats in the PLCs.

Intel format
In the Intel format, the decimal number 300 is stored as follows:

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Binary 0 0 0 0 0 0 0 1 0 0 1 0 1 1 0 0

Hex  0  1  2  C

According to the Intel Format, the decimal number 300 corresponds to the hex-number 12C 
(1*256 + 2*16 + 12*1).
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SIMATIC format
In SIMATIC format, the least significant byte is are stored in the most significant digits. In 
SIMATIC format, decimal number 300 is stored as follows:

Bit 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
Binary 0 0 1 0 1 1 0 0 0 0 0 0 0 0 0 1

Hex 2 C 0 1

According to the SIMATIC format, decimal number 300 corresponds to hex number 2C01.

If hex number 2C01 is interpreted according to Intel format, it corresponds to decimal number 
11265.

There are function blocks that convert the data for PLCs from the SIMATIC S7 series. You 
must always call up the blocks before and after data transfers between the PLC and WinCC. 
The function blocks are available for download from the Siemens Customer Support website 
in the Internet. The compressed file ANSI_S5.EXE is then loaded. ANSI_S5.EXE contains the 
"IEEE:GP" function block.

Active sending is described in the reference manuals for the PLCs or CPs (communication 
processors).

10.5.2.5 Operation in Runtime

Recipe view

Functional scope     
The recipe display offers access to user archives, the recipes and recipe queries. In runtime, 
you can:

● Online configuration of recipe view

● Create, delete or modify new data records

● Scrolling in recipes

● Read and write tags for direct tag link

● Importing and exporting recipes
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● Defining selection criteria to display only a certain part of the recipes

● Defining sorting conditions for the displayed recipe elements

Properties
You connect a recipe view to a recipe or recipe query during the configuration. The online 
configuration and changing of selected recipe values in Runtime can be protected against 
unauthorized access respectively by own operator authorizations. If you cancel the access 
protection, you must reconnect the recipe view with the recipe in the configuration dialog box.

The access protection is queried when the recipe view screen opens.

● If the user has no authorization to read a recipe element, the corresponding column is not 
displayed in the table.

● If the user has no authorization to write a recipe element, the user cannot edit the data of 
the the corresponding column in the table.

Access protection for the control tags must be configured separately by the object properties, 
e.g. of a screen, an I/O field or a button.

Using the Recipe View

Mouse and keyboard operation

Introduction               
You operate the recipe view in Runtime by buttons in the toolbar. If you do not want to use the 
toolbar for operation, you can write the "ID" of the desired button in the "ToolbarButtonClick" 
object property with any dynamization type.
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Overview

Symbol Description ID
"Help"
Calls the help for the recipe view.

1

"Configuration dialog"
Opens the configuration dialog box in which you change the properties of 
the recipe view.

2

"Select data connection"
Opens a dialog for selecting a recipe or recipe query. The recipe data are 
then shown in the table of the recipe view.

3

"First line"
The first data record is displayed in the table by the button. 

4

"Previous line"
The previous data record is displayed in the table by the button.

5

"Next line"
The next data record is displayed in the table by the button.

6

"Last line"
The last data record is displayed in the table by the button.

7

"Delete lines"
The content of the marked lines are deleted.

8

"Cut lines"
The content of the marked lines are cut out.

9

"Copy lines"
The content of the marked lines are copied.

10

"Insert lines"
The content of the copied or cut-out lines is inserted starting from the marked 
line.

11

"Read tags"
The contents of the connected WinCC tags are read and written into the 
recipe elements by the button. The "Tags" communication type must be 
activated in the displayed recipe to be able to use the button. The recipe 
elements must be connected with tags.

12

"Write tags"
The contents of the recipe elements are written into the connected WinCC 
tags. The "Tags" communication type must be activated in the displayed 
recipe to be able to use the button. The recipe elements must be connected 
with tags.

13

"Import Archive"
Using a button, a CSV file is imported from the "ua" directory of the project 
folder into the table of the recipe view.

14

"Export archive"
The original contents of the table are exported with table headers by the 
button when loading. The recipe is stored as a CSV file in the "ua" directory 
of the project folder. 

15

"Sort dialog"
Opens a dialog box for setting a customized sorting of the displayed columns.

16
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"Print"
Starts the printout of the displayed values. The print job used for printing is 
defined in the configuration dialog in the "General" tab. 

18

"Export data"
Using a button, you can export the recipe or recipe query to a CSV file as 
configured but with the current runtime data. If the "Display dialog" option is 
active, a dialog opens in which you can view the settings for exporting and 
can start the export. With the appropriate operator authorizations you can 
also select the file and the directory for the export.
If no dialog box is displayed, the data export to the preset file starts 
immediately.

20

"Time base dialog"
Opens a dialog box for setting the time base for the used times.

19

"User-defined 1"
Displays the first button created by the user. The function of the button is 
customized.

1001

Possible elements of the status bar
The following elements may appear in the status bar of the recipe view:

Symbol Name Description
Archive name Displays the name of the selected recipe or recipe query.
Row Shows the number of the marked line.
column Shows the number of the marked column.
Date Shows the system date.
Time Shows the system time.
Time Base Shows the time base used in the display of times.

Navigation in the table
You can navigate in the table as follows:

● You enter the next cell with the "ENTER" key or with the "Right" cursor key.

● You enter the previous cell with "SHIFT+ENTER" key or with the "Left" cursor key.
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● You enter the next line by clicking with the mouse in the line or with the "Down" cursor key.

● You enter the previous line by clicking with the mouse in the line or with the "Up" cursor 
key.

 

  Note

If the "Error while connecting the data!" error message appears when Runtime starts, the 
recipe view has no connection to a recipe or recipe query. Check the following: 
● The name is specified correctly.
● The configuration is not changed.
● The connected recipe or recipe query still exists.

 

Editing recipe data

Introduction     
You can edit data in the Data recipe view. The following options are available:

● Enter new data

● Change existing data

● Delete lines

● Cut-out, copy and insert lines

Requirement
● You have permitted editing in the configuration dialog in the "General" tab.

● You have deactivated the "Write-protected" property for the column to be edited in the 
configuration dialog in the "Columns" tab.

● The "ID" column cannot be edited.

● If the recipe view is connected to a recipe query, you cannot delete and cut out a row.

Entering new data in the table
1. Click on  to move to the last line. The line is marked.

2. Double-click on the first cell of the marked line. You can also press on "F2", "Alt+Enter" or 
Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the new data 
record is written into the recipe. You move to another line by clicking with the mouse, with 
the "ENTER" key or with the "Up" and "Down" cursor keys.

4. You can copy the data of a marked line with "CTRL+C" or "CTRL+X" into the clipboard. 
The copied data is inserted into a marked line with "CTRL+V".
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Changing existing data in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Double-click on the desired cell of the marked line. You can also press on "F2", "Alt+Enter" 
or Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the changed 
data record is written into the recipe.

Deleting a line in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  to delete the marked line.

Cutting, copying and inserting lines
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  or  to cut or copy the data of the line. As an alternative, you can also use 
key combination "CTRL+ALT+X" or "CTRL+ALT+C".

3. Go to the desired line into which you want to copy the data. Click on  to insert the cut-
out or copied data. If you do not want to overwrite the data of the marked line, move into 
the last line to insert the data.

Selecting and configuring data

Introduction   
The recipe view shows the data of the connected recipe in a table. The displayed content of 
the table is determined by the selected columns and the selection of contents of the columns.

Requirement
● You have created one or more recipes and/or recipe queries.

● You have connected the recipe view to a recipe or recipe query.

Visualize processes
10.5 Working with recipes

WinCC Professional V13.0
4274 System Manual, 02/2014



Configuring the columns
1. Go to the "Columns" tab.

2. In the "Columns" list, you can see the fields of the connected recipe or recipe query. If the 
check box in front of the name of the column is checked, the column is displayed in the 
table. Deactivate the check box if you do not want it to appear.

3. Determine the order of the columns in the table using the "Up" and "Down" buttons.

4. Select a column to configure the properties and the format.

5. If necessary, change the width of the column in the table. Enter a value in the "Length in 
chars" field.
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6. Some columns can also show the content and the header as a symbol. Determine how 
these columns are displayed in the "Display" field. Text and symbols can be displayed at 
the same time.

7. Save the configuration.

Selection of column content that will be displayed in the table
Configure criteria used to display the content in the columns in the "Selection" area.

Procedure
1. Click "Edit...". The selection dialog is opened.

2. Specify the criteria for the display. More information on the selection of columns can be 
found under Select data (Page 4277).

3. Click "OK" to close the selection dialog. The selection is considered at the start of Runtime 
in the table of the recipe view.
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Configuring the Sorting of Columns
You configure the sorting of the columns in the table in the "Sorting" area. You can also specify 
the sorting criteria in Runtime using the key functions.

1. Click "Edit...". The sorting dialog opens.

2. Set a sorting sequence. More information on the sorting of columns can be found under 
Auto-Hotspot.

3. Click "OK" to close the sorting dialog.

4. Save the configuration of the contents.

See also
Select data (Page 4277)

Select data

Introduction    
Which contents of the recipe you want to show or export in the recipe view table can be defined 
in Runtime by the selection dialog box.  In the selection dialog box you defie selection criteria 
with regard to the displayed columns of the recipe.
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Requirement
● The selection dialog is open (see paragraph "Selecting and configuring data (Page 4274)").

Procedure
Proceed as follows:

1. Double-click in the first empty line in the "Criteria" column. The list with the columns of the 
recipe view is shown. Select the desired columns, e.g. "field1".

2. Double-click in the "Operand" column to select an operand.

3. Double-click in the "Setting" column to enter a comparison value.

4. Double click in the "Logic operator" column to select an "AND" or "OR" function.

5. Repeat the procedure if you want to define further criteria.

6. Click "OK" to close the selection dialog. The selection is displayed in the table of the recipe 
view.

 

  Note
Ensuring the display of column content

Make sure of proper use of the settings and connections of criteria. 

Incorrect logical operations can lead to the data of the connected recipe not being 
displayed in the recipe view.

Therefore test every criterion separately before the logical operation and then the logically 
operated criteria respectively. Check that all expected contents are also displayed in 
combination.

This ensures that the selection is displayed completely in the recipe view.
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Sorting data

Introduction    
The data in the recipe view can be sorted by columns in Runtime. You sort the columns either 
via the "Sort dialog" button function or directly via the column headers.

 

 Note

You can define the  sorting criteria already in the configuration in the recipe view by clicking 
the "Edit..." button under "Sorting" on the "Columns" tab.

 

How to sort with the Sort dialog

Requirement
● You have activated the "Sorting dialog" button on the "Toolbar" tab of the UserArchive 

Control.

Procedure
1. Click the "Sort Dialog" button .

2. Select the column of the connected recipe from the "Sort by" list which is to be used for 
sorting first. Select the relevant check box to specify sorting in ascending or descending 
order. If you want to sort by more than one column, select the other columns in the desired 
order in the "Then sort by" lists.
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How to sort the column contents with the column heading 
When sorting using the column header, you are able to specify the sort order for more than 
four columns. A sorting icon and sorting index, displayed with right-justification in the column 
heading, show sorting order and sorting sequence of the column contents.

Requirement
● You have allowed sorting in the list field "Sort by column header" by click or double click 

on the "Parameters" tab of the recipe view.

● You have activated the "Show sorting icon" and "Show sorting index" checkboxes.

Procedure
1. Click the column header of the column you want to sort as first column. The sorting index 

"1" is displayed, and the sorting icon points upwards for ascending sort order.

2. If you want to sort in descending order, click the column header again.

3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the 
column with a third click.

4. If you want to sort several message blocks, click the respective header columns in the 
desired sequence.

Using the recipe screen

Introduction
You use the recipe screen with the control objects you have configured. The paragraph 
describes the operation of the recipe screen with control tags from the section "Control tags 
(Page 4257)".

 

 Note
Runtime API

Runtime API provides you with extensive uaArchive functions to edit recipes and recipe 
queries in Runtime (see section "Interfaces > Runtime API", subsection "Control tags").

 

Requirement
● Communication type is set to "Tags" in the recipe.

● The "Unique values" checkbox is activated under "Options" in the properties of the recipe 
element "Coloring 7".

● Recipe tags and control tags are set up.

● A process picture with the required I/O fields is configured.

● The I/O fields are connected with the recipe tags and control tags.
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Example:

Procedure
To transfer recipe data to the recipe memory of the HMI device, follow these steps:

1. Enter the recipe values displayed in the blue fields "Water", "Sugar", "Aroma", "Coloring 7" 
and "Concentrate". The recipe values form the recipe data record you want to transfer.

2. Enter "3" as "ID" for the target recipe data record.

3. Enter "6" as job for reading in the "Instruction" field.

The entered recipe data are transferred as complete data record. The recipe data record 
number 3 is overwritten in the recipe memory. The job mailbox returns the value "0" (no error) 
in the "Job" control tag.

Alternative procedure
1. Enter new recipe values in the blue fields " Water", "Sugar", "Aroma", "Coloring 7" and 

"Concentrate".

2. Enter the recipe element "Coloring 7" as the "Field".

3. Enter the recipe element "020" as the value in the "Value" field.

4. Enter "6" as job for reading in the "Instruction" field.

The entered recipe data are transferred as complete data record. The recipe data record whose 
recipe element " Coloring 7" has the recipe value "020" - in the example the recipe data record 
number 3 in the recipe memory - will be overwritten. The job mailbox returns the value "0" (no 
error) in the "Job" control tag.
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See also
Displaying recipes (Page 4247)

10.5.2.6 Examples

Example: Creating recipes

Task
In this example, you will create two recipes.

● A "Beverage" recipe for drinks. The drinks mixing plant produces various drinks. You create 
a recipe data record for each item.

● An "Orders" recipe for orders. The orders contain the current order data.

Settings
The settings relate to an HMI device which is connected to a SIMATIC S7-300 or 
SIMATIC S7-400.

In this example, you will need the following tags, recipes, recipe entries and recipe data records:

Tags:

Name PLC connection Address Type
article Yes DB 120, DBW 0 String
litrewater Yes DB 120, DBW 4 Integer
kilosugar Yes DB 120, DBW 8 Integer
gramaroma Yes DB 120, DBW 12 Integer
litreconcentrate Yes DB 120, DBW 16 Integer
coloring Yes DB 120, DBW 20 Integer
customer Yes DB 120, DBW 24 String
numbercustomer Yes DB 120, DBW 28 String
numberorder Yes DB 120, DBW 32 Integer
quantitiy Yes DB 120, DBW 36 Integer
filling Yes DB 120, DBW 40 Integer
dateorder Yes DB 120, DBW 44 Date
status Yes DB 120, DBW 48 Integer

"Beverage" recipe:

Recipe element Associated tag
Article article
Water litrewater
Sugar kilosugar
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Recipe element Associated tag
Aroma gramaroma
Concentrate litreconcentrate
Coloring coloring

Data record ID 1 2 3
Article Juice Nectar Cola Light
Water 5 50 72
Sugar 5 10 35
Aroma 100 300 240
Concentrate 95 50 35
Coloring FS 0063 FS 0063 FS 1007

"Orders" recipe:

Recipe element Associated tag
Customer customer
Number numbercustomer
Order numberorder
Article article
Quantitiy quantitiy
Filling filling
Status status
Date dateorder

Procedure
1. Create the tags listed above with the settings described above.

2. Create the "Beverage" and "Orders" recipes with the settings indicated above.

3. Select the following properties for the recipes:

– Under "General > Size" the "Unlimited" type

– Under "Communication > Communication type" the "Tags" communication type
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4. Create the recipe entries in each recipe.

5. Activate the "Unique values" check box for the following elements in the property window 
under "Extras".

– In the "Beverage" recipe for the "Article" recipe element

– In the "Orders" recipe for the "Order" recipe element

6. Create the data records indicated above in the "Beverage" recipe. Enter the values 
indicated above in each of the data records.

Result
The "Beverage" and "Orders" recipes are created.
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See also
Example: Configuring a recipe view (Page 4286)

Example: Creating recipe queries

Task
In this example, you create the "Label" recipe query. The following recipe elements are 
displayed in the recipe query: 

Recipe element Recipe
Article Beverage, Orders
Customer Orders
Status Orders
Order Orders
Filling Orders
Sugar Beverage
Coloring Beverage

The "Article" recipe element is contained as a common element of both recipes.

Requirements
The "Beverage" and "Orders" recipes are created.
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Procedure
1. Create the "Label" recipe query. Create the elements listed above.

2. Enter the following conditions under "Properties > Relations":
Beverage.Article = Orders.Article

Result
The "Label" recipe query is created.

Example: Configuring a recipe view

Task
In this example, you will add a plant screen with recipe view to the "Label" view.

Requirement
The "Create recipes" and "Create recipe query" examples are created.

You have created and opened the "Drinks mixing plant" process picture.
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Procedure
1. Insert the recipe view in the process picture. You will find the recipe display in the toolbox 

under "Controls".

2. In the Inspector window, use the arrow to select the "Recipe query" type in the "Data source" 
input field of the "General > View" group.

3. Select the "Label" recipe query.

4. Define additional display options for the recipe view in the "Properties" > "Appearance" 
group in the Inspector window.

5. Go to the "Properties" > "Columns" group in the Inspector window.

– Activate the check box in the "Visible" and "Protected" columns for all recipe elements.

6. In the Inspector window, switch to the "Properties" > "Toolbar" group. Activate the check 
box in the "Visible" column for the following buttons under "Toolbar - Buttons".

– "First line"

– "Previous line"

– "Next line"

– "Last line"

– "Sort dialog"

– "Selection dialog"

7. Go to the "Properties" > "Columns" group in the Inspector window. Enter the following 
sorting in the "Sort" column.

– By job number

– Ascending

Result
In Runtime,the recipe view is opened with the "Label" recipe query in the "Drinks mixing plant" 
process picture. The data records are displayed sorted by job number. You can use the buttons 
to switch between the data records.

Use the "Status" data field to display the current job or jobs that have been run.

You can adapt the recipe display to the data records as required with the "Sort dialog" and 
"Selection dialog" buttons.

See also
Example: Creating recipes (Page 4282)

Using control tags

Example for the use of control tags:
You need to perform the following steps to work through the example with the control tags:  
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Requirement
You have created the "Drinks" recipe.

Properties of the "Cola" recipe
Log type "Unlimited"
Communication "Tags"
Data type for the "ID" control tag Long
Data type for the "Job" control tag Long
Data type for the "Field" control tag String (1 character)
Data type for the "Value" control tag String (1 character)

Procedure
1. Create the control tag with the following properties:

Control tag Data Format Output format
ID decimal 0999
Job decimal s9
Field String *
Value String *

1. Select the "Update for changes" object property for each control tag.

2. Connect the control tags to the "Drinks" recipe.

3. Create a new screen and add a recipe view.

– Select the "Drinks" recipe.

– Check the "Paste", "Change" and "Delete" check boxes under "General".

4. Create an I/O field for every configured recipe element.

5. Connect the I/O fields to the associated tags.
For example, connect the I/O field for "Coloring" to the "Coloring" process tag.

– Create a text field for the label of every configured I/O field.
By doing so, you assign the I/O fields to the individual recipe elements in Runtime.

6. Create an I/O field for every control tag.

– Create a text field for the label of every configured I/O field.
By doing so, you assign the I/O fields to the individual control tags in Runtime.

7. Start Runtime or load the project into the HMI device and start the project.

Result
The configuration for the recipe is completed.
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Accessing the recipe
You can now access the recipe in the following ways:

● In the table view of the recipe view

● Using the configured I/O fields

Write the data record to the process tags using the ID
● Enter the ID "3" in the "ID" I/O field and enter a "7" in the "Job" I/O field.

The values of data record "3" will be written to the process tags in the I/O fields and displayed 
in the I/O fields.
If the data record values were read without error from the recipe, error number "0" is 
displayed in the "Job" field.
Error number "-1" is output if an error occurs.
The "Field" and "Value" control tags are not required.

 

  Note

The current contents of the process tags are read into the recipe by entering the ID "-1" 
and the job "6". The new values are appended at the end of the table. The data record 
IDs are continuously incremented. 

 

Read the process tags via the ID
● Change the values in the I/O fields of the process tags and enter a "5" in the "ID" field. Enter 

"6" in the "Job" I/O field.
The changed values of the process tag are written to data record "5" of the recipe. The 
values that were previously contained in this data record are overwritten.
The "Field" and "Value" control tags are not required.

Write a data record to the process tag using the "Field" and "Value" control tags
 

 Note

For an element that is referenced with the "Value" control tag, you must select the "Field must 
posses an unique value" check box under "Properties" > "Memory options". Otherwise it will 
not be possible to create a unique assignment between the recipe data record and the value 
in the element.
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● In the "Field" I/O field, enter the word "Item" and write "Cola Light" to the "Value" I/O field. 
Enter "7" in the "Job" I/O field.
The values of the "Cola Light" data record will be written to the process tags in the I/O fields 
and displayed in the I/O fields.
The "ID" control tag is not needed, so it must be set to 0. 

10.5.2.7 SQL language
SQL (Structured Query Language) is an efficient and widely distributed database language. 
The SQL language is used for database queries in the functions of the WinCC script language. 
You will find further information in the relevant technical manuals.   

In some standard functions and some functions in the "Recipes" editor, you must specify 
conditions in the database language SQL to specify the data records to be edited. A few 
examples of how provide an SQL instruction are given below:

 

 Note
Name convention

Suffixes, extensions and the name of a recipe, recipe query or a recipe element may only 
consist of letters, numbers and underscores "_" and may not exceed a length of 20 characters. 
The first character must always be a letter.

 

● FieldA > '1992-12-31 23:45:12.12'
The instruction selects all data records whose value in the "FieldA" column is greater than 
the specified value. FieldA is is of the data type DB_TYP_TIME.

● FieldB like 'tank%'
Then the data records for which the "FieldB" column contains the value "tank1" or "tank4" 
or "tank12" etc. are selected for example. FieldB is of the data type DB_TYP_CHAR.

● FieldC > 100
With a condition of this type, all data records are selected for which the "FieldC" column 
contains a value greater than 100. FieldC is of the data type DB_TYP_INTEGER.

● BETWEEN FieldC = 20 AND FieldC = 200
The statement selects all data records for which the "FieldC" column contains a value 
between 20 and 200. FieldC is of the data type DB_TYP_INTEGER.

● FieldD
Sorting then takes place by column "FieldD".

● FieldE desc
Sorting then takes place by column "FieldE" in reverse alphabetical order (descending 
order).

See also
SQL keywords (Page 4291)
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10.5.2.8 SQL keywords

SQL keywords
 

 Note

Do not use the following terms and keywords of the SQL language as names for a recipe, 
recipe query or recipe element:
● "Archive"
● "View"
● "Field"
● "ViewCol"

 

Keywords of the SQL language
add all alter and
any as asc begin
between binary break by
call cascade cast char
char_convert character check checkpoint
close comment commit connect
constraint continue convert create
cross current cursor date
dba dbspace deallocate dec
decimal declare default delete
desc distinct do double
drop else elseif encrypted
end endif escape exception
exec execute exists fetch
first float for foreign
from full goto grant
group having holdlock identified
if in index inner
inout insert instead int
integer into is isolation
join key left like
lock long match membership
message mode modify named
natural noholdlock not null
numeric of off on
open option options or
order others out outer
passthrough precision prepare primary
print privileges proc procedure
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Keywords of the SQL language
raiserror readtext real reference
references release remote rename
resource restrict return revoke
right rollback save savepoint
schedule select set share
smallint some sqlcode sqlstate
start stop subtrans subtransaction
synchronize syntax_error table temporary
then time tinyint to
tran trigger truncate tsequal
union unique unknown update
user using validate values
varbinary varchar variable varying
view when where while
with work writetext  

See also
SQL language (Page 4290)

10.6 Working with reports

10.6.1 Basics

10.6.1.1 Reports

Introduction
Reports are used to record process data and processed production cycles. You have the 
opportunity, for example, to create regular shift reports, output batch data, or record the 
production process for quality control (QC). 
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Creating reports 
A report is created and edited in the "Reports" editor. In this editor, you configure the following 
report items:

● Formal appearance
Specify the formal layout of the report in the Inspector window.  In this window, for example, 
you specify the page format, page margins, title page, back page, headers, or footers for 
the report. 
Moreover, you can specify whether to output the different pages with or without watermark 
in the reports for Runtime Professional.

● Content
In the work area, specify the content of the report, for example, the alarms of a shift. To 
this purpose, insert the corresponding objects into the detail page(s). 
You can also design the title page, back page, headers, and footers as you please. For 
watermarked pages, create additional pages to be included as "background image" in the 
output. 

The modular structure lets you configure reports that suit all of your applications. 
 

 Note

The "Reports" editor is not available at HMI devices that do not support reporting.
 

Report output
In Runtime, report output is event-driven or time-driven.

● Time-driven: Automatic print at specific dates, times or intervals.

● Event-driven: Printing is initiated by specific events, e.g. click on a button, or a limit is 
exceeded.

The configuration of report output differs depending on the Runtime version.  

In Runtime Advanced, the configured reports are output on the default printer of the HMI device.

For Runtime Professional, make the following decisions with the help of a print job:

● Output of selected pages, or of all pages of the report

● Output of all data, or only the data of a specific period

● Output of the report to a printer or file

● Whether the operator is allowed to select a printer or modify the scope of pages for report 
output

● Whether the report that is output is displayed in the print job list of an application window 
configured accordingly

Print function of screen objects
Certain screen objects of Runtime Professional, e.g. the alarm view, contain a default button 
function (printer icon) for the report output. WinCC employs predefined system reports for the 
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output. You can can customize these to suit your requirements, or replace them with a report 
of your individual design. 

See also
Structure of reports (Page 4294)

Create a report  (Page 4306)

Print job/Script diagnostics (Page 3529)

Structure of reports (Page 4296)

Principles for preparation of reports (Page 4302)

Principles for report output (Page 4321)

Basics for system traces and system print jobs (Page 4326)

10.6.1.2 Structure of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required. 
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Sections of a report
The following figure shows an example of the different sections of a report in the "Reports" 
editor.

Title page and back page     
The title page contains important information about the report content. The back page is used, 
for example, as Impressum, on which you provide contact information of shift managers or 
service technicians. The title page and back page are output separately on a single page. Each 
of them consist of exactly one page and page breaks are not used. 
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Detail page   
Configure the output of runtime data such as recipe or alarm reports on the detail pages of the 
report. 

Use the shortcut menu on the detail page to insert additional detail pages or change their order. 

Header and footer     
The header and footer are output on each detail page of the report. You typically insert the 
page numbers or the date in the header or footer. 

See also
Create a report  (Page 4306)

Reports (Page 4292)

Principles for preparation of reports (Page 4299)

10.6.1.3 Structure of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.

Visualize processes
10.6 Working with reports

WinCC Professional V13.0
4296 System Manual, 02/2014



Sections of a report
The following figure shows an example of the different sections of a report in the "Reports" 
editor.

Visualize processes
10.6 Working with reports

WinCC Professional V13.0
System Manual, 02/2014 4297



Title page and back page     
The title page contains important information about the report content. The back page is used, 
for example, as Impressum, on which you provide contact information of shift managers or 
service technicians. The title page and back page are output separately on a single page. The 
page has a precise length and no page break, regardless of whether you configured a dynamic 
object to be output on that page. 

Detail page   
Configure the output of runtime data such as recipe or alarm reports on the detail pages of the 
report. 

Use the shortcut menu on the detail page to insert additional detail pages or change their order.

Header and footer     
The header and footer are output on each detail page of the report. You typically insert the 
project name, report name, page numbers or the date in the header or footer.

Watermarks   
The title, detail and back pages can be output with a watermark.  The page is printed with its 
superimposed watermark. 

With the help of a watermark, output an object "A" next to an object of variable length "B" 
without displacing object "A". Example: You want to output an output field (A) next to a table 
(B) on all pages.

The title and back pages, as well as the detail pages have separate watermarks. 

See also
Reports (Page 4292)

Principles for preparation of reports (Page 4302)

Create a report  (Page 4306)
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10.6.2 Working with reports

10.6.2.1 Creating reports

Principles for preparation of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.

● Title page

● Back page

● Detail pages

● Headers and footers for the detail pages
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Procedure    
The following figure shows the general procedure for creating a report: 

1) Settings depend on the report object used. 

Tools for the design of reports
The tools that you can use to design reports are available in the "Tools" task card.

● For graphic design insert "basic objects", "elements" and "graphics" in the different sections 
of the report. For example, for a Logo in the header, separation lines and a page number 
in the footer.

● Using the "Controls" in the detail pages, configure the output of runtime data.
 

  Note

The "Screens" editor provides many objects for designing a report – however, with 
restricted functionality. Data input properties are not available. The I/O fields in the reports, 
for example, serve only to output data.
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Position and size of objects    
Insert the objects at the position where you want them to be output in the report.  The objects 
are output in their configured size and with the following special features: 

On the detail pages, configure "recipe reports" or "alarm reports" that serve to output runtime 
data in tabular format. 

● The width of the table is set up automatically to fit the width of the detail page. You cannot 
modify the width.

● WinCC automatically wraps the height of the table to fit the data content for output in the 
report. The table can be continued on the next page.
In the detail page, WinCC automatically extends tables of dynamic length to the bottom 
margin.

The following figure shows an example of a detail page in the report and its output in Runtime:

Detail page in the report Report output in Runtime

Additional detail pages   
Use the shortcut menu on the detail page to insert additional detail pages or change their order.

See also
Configuring reporting of alarms (Page 3995)

Structure of reports (Page 4294)

Create a report  (Page 4306)

Administration of detail pages (Page 4318)

Objects in reports (Page 4345)
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Principles for preparation of reports

Introduction
A report in WinCC consists of several sections that can be enabled or disabled, as required.

● Title page

● Back page

● Detail pages

● Headers and footers for the detail pages

● Watermarks for title page, back page, detail page

Procedure  
The following figure shows the general procedure for creating a report:

1) Settings depend on the report object used. 
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Tools for the design of reports
The objects that you can use to design the reports are available in the "Tools" task card. 

 

 Note

The "Screens" editor provides many objects for designing a report – however, with restricted 
functionality. Data input properties are not available. The I/O fields in the reports, for example, 
serve only to output data.

 

Positioning objects   
Insert the objects at the position where you want them to be output in the report.  However, 
you should be aware that WinCC ignores white spaces at the start of the detail page when the 
report is output. The top object marks the start of the detail page on the printed copy. 

The following figure shows an example of a detail page in the report and its output in Runtime:

Detail page in the report Report output in Runtime

To include a white space in the output, extend the header accordingly. You can also place an 
"invisible" object on the detail page at the required start. For example a white line that is not 
visible on white paper.

Size of objects   
Objects are output in their configured size. 

On the detail pages, configure "controls" and "report objects" for the output of Runtime data. 
WinCC aligns the Runtime data to fit the object frame – with one special feature: If you configure 
an object like a table with dynamic length, WinCC automatically adjusts the height of the table 
to fit the amount of data to print. The table can be continued on the next page. WinCC adapts 
no more than the object height and places all following objects underneath the the object, as 
configured in the detail page.

The following figure shows an example of a detail page in the report and its output in Runtime:
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Detail page in the report Report output in Runtime

Usually, the "controls" and "report objects" are assigned a dynamic length and output Runtime 
data in tabular format. The following objects are included:

● Recipe report

● Alarm report

● Table view

● ODBC database table

● Alarm sequence report

● CSV provider tables

● Control Hardcopy

● Control Data

● Control information

Objects next to dynamic objects   
In a detail page, do not place other objects next to objects that have a dynamic length. Given 
the fact that the position of the objects cannot be clearly defined, WinCC possibly outputs these 
with errors. Instead, configure the objects as watermark.

The following figure shows an example of a watermark and a detail page in the report and the 
output in Runtime:
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Watermark and detail page in the report Report output in Runtime

Title page and back page    
The title page and back page are output separately on a single  page.  WinCC will not continue 
output on the next page if you configured an object with dynamic length for the title or back 
page.    Runtime data of the object exceeding the output capacity of a single page is not output 
to the full extent in the report. 

Additional detail pages  
Use the shortcut menu on the detail page to insert additional detail pages or change their order. 

See also
Report design tools (Page 4308)

CSV file for trend output (Page 4312)

CSV file for output of a table (Page 4315)

Continuous alarm reporting (Page 4312)

Reports (Page 4292)

Structure of reports (Page 4296)

Create a report  (Page 4306)

Administration of detail pages (Page 4318)

Principles for report output (Page 4321)

Objects in reports (Page 4345)
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Create a report 

Requirement
A project with an HMI device is open. 

Procedure   
To create a report, proceed as follows:

1. Double-click "Add new report" under "Reports" in the project navigation.
A new blank report is displayed in the "Reports" editor. 

2. Select the "Report properties" command in the shortcut menu of the report.

3. In the "Properties > Properties > General" area of the Inspector window, specify whether 
you want to configure the "Title page", "Back page", "Header" and "Footer" in the report.
The report sections are updated accordingly.
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4. Configure the format, the page layout, and the page margins of the report under "Properties 
> Properties > Layout."

5. Enter a meaningful report name under "Properties > Properties > Miscellaneous."

6. Design the report sections as required. 
Drag and drop the necessary basic objects, elements, graphic images and controls from 
the "Tools" task card to the required position.
Alternatively, you can also copy or move objects already configured from a screen to the 
report. 

7. Configure the objects in the Inspector window: 

See also
Report design tools (Page 4308)

CSV file for trend output (Page 4312)

CSV file for output of a table (Page 4315)

Continuous alarm reporting (Page 4312)

Configuring reporting of alarms (Page 3995)

Reports (Page 4292)

Structure of reports (Page 4294)

Structure of reports (Page 4296)

Principles for preparation of reports (Page 4302)
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Working with objects (Page 4330)

Objects in reports (Page 4345)

Report design tools

Tools for the design of reports  
In the "Reports" editor, use the objects in the "Tools" task card to design the reports: 

● For graphic design insert "basic objects", "elements" and "graphics" in the different sections 
of the report. For example, for a Logo in the header, separation lines and a page number 
in the footer.

● Using the "Controls" in the detail pages, configure the output of runtime data.

● If you want to use your own reports instead of the system reports for the print function of a 
screen object, configure the output of Runtime data with the help of the "Report objects".

 

  Note

The "Screens" Editor provides many objects, though with restricted functionality, that you 
can use to design a report. Data input properties are not available. The I/O fields in the 
reports, for example, serve only to output data.

 

Elements   
The following table provides an overview of the objects of the "Elements" panel:

Object Application
Date/time field For output of the current data and time

You can customize the output format. 
I/O field For the output of process values

You can choose between different output formats.
Project name For output of the project name 

The name can be output with or without path definition.
Report name For output of the report name 
Page number For output of the page number and total number of pages

You can customize the output format. 
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Output of data in tabular format   
For a time-driven or event-driven output of data in table form, configure the following controls 
in reports:

Control Use in report
Table view For time-driven output of the values of one or several logging tags 

Each row of the table represents the status of the selected logging tag at a 
specific time.

ODBC database table For the output of data that does not originate from WinCC
The data is output in tabular format via the ODBC interface.

CSV provider tables For the output of data of a CSV file 
The data of a CSV file must conform to a specific structure. You can select 
a CSV file, or configure a tag for dynamic selection of the CSV file.

A print function is already integrated in the "Table view" control in the "Screens" editor (button 
in Runtime). The "Table view" uses preconfigured system reports for printing. You can specify 
in the system reports if you want to output all data or only the current data displayed in the 
object (snapshot). You match system reports to your requirements or use individually designed 
reports instead of the system reports.

Data output in trends   
For a time-driven or event-driven output of data in trend form, configure the following controls 
in reports:

Controls Use in report
f(t) trend view in reports For the output of logging tags as a function of time
f(x) trend view in reports For the output of logging tags as a function of other logging tags, e.g. the 

temperature profile as a function of pressure
You can also compare the trend to a setpoint trend.

CSV provider trends For the output of data of a CSV file 
The data of a CSV file must conform to a specific structure. You can select 
a CSV file, or configure a tag for dynamic selection of the CSV file.

A print function is already integrated in the "f(t) trend view" and "f(x) trend view" controls in the 
"Screens" editor (button in Runtime). For printing, these controls use preconfigured system 
reports that you can customize to suit your requirements.

Output of recipes   
For a time-driven or event-driven output of recipe data, configure the following controls in 
reports:

Control Use in report
Recipe view For the output of recipe elements

A print function is already integrated in the "Recipe view" control in the "Screens" editor (button 
in Runtime). This control uses preconfigured system reports for printing. You can specify in 
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the system reports if you want to output all data or only the current data displayed in the object 
(snapshot). You match system reports to your requirements or use individually designed 
reports instead of the system reports.

Output of alarms   
WinCC offers several options for alarm reporting.

For a time-driven or event-driven output of alarms, configure the following control in reports:

Control Use in report
Alarm view For the output of alarms that occur during the process in a plant.

WinCC outputs current alarms, suppressed alarms or alarms from the 
historical alarm list (short-term), depending on the configuration.

A print function is already integrated in the "Alarm view" control in the "Screens" editor (button 
in Runtime). This control uses preconfigured system reports for printing. You can specify in 
the system reports if you want to output all alarms or only the current alarms displayed in the 
object (snapshot). You match system reports to your requirements or use individually designed 
reports instead of the system reports.

WinCC lets you continuously output alarms after the start of Runtime, for example, to a line 
printer. All you have to do is activate this output. WinCC offers two preconfigured system 
reports that you can adapt to meet your requirements: one for output in the line layout and one 
for output in the page layout. 

Output of a snapshot from Runtime   
To output a snapshot of Runtime in a report, configure the following control in reports:

Control Use in report
Hardcopy For the output of a snapshot from Runtime

WinCC outputs the entire content of the screen, of the active window, or of 
an individually selected screen area, depending on the configuration.

Data output via ODBC interface   
To read data from external sources using the ODBC interface and output them in a report, 
configure the following controls in reports. 

Control Use in report
ODBC database field For the output of data from a field of an external database table
ODBC database table For the output of external database tables 

Report objects   
Certain screen objects, e.g. in the alarm view, contain a default button function (printer icon) 
for the report output. 
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For reports that you want to use for the printing a screen object instead of a preconfigured 
system report, configure the output of Runtime data with the help of the "Report objects".

The following table shows the report objects that you can use in the reports:

Object Use in report
Control Hardcopy To output screen objects as it is displayed in Runtime (snapshot)
Control Data For output of the current data of the screen object

The data is output in tabular format.
Control Information To output the data source, for example, window title, object name or screen 

name

See also
Create a report  (Page 4306)

Principles for preparation of reports (Page 4302)

Control Data (Page 4346)

Control hard copy (Page 4347)

Control Information (Page 4348)

CSV provider trends (Page 4349)

CSV provider tables (Page 4350)

Date/time field (Page 4352)

f(t) trend view in reports (Page 4355)

f(x) trend view in reports (Page 4355)

Hardcopy (Page 4358)

Alarm view in reports (Page 4359)

ODBC database field (Page 4363)

ODBC database table (Page 4364)

Project name (Page 4366)

Report name (Page 4367)

Recipe view in reports (Page 4368)

Page number (Page 4371)

Table view in reports (Page 4372)

Continuous alarm reporting (Page 4312)
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Continuous alarm reporting

Alarm sequence report    
An alarm sequence report outputs alarms that occur on the HMI device continuously in 
chronological order, for example, to a line printer.   

To use the preconfigured alarm sequence report, you only need to activate it. 

If you only want to output specific alarms, for example, adapt the report to match your needs. 

Activation and configuration
The output of the pre-configured alarm sequence report is configured in the "Alarm sequence 
report" system print job. 

To automatically run the system print job at the start of Runtime: 

● In the Runtime settings of the HMI device activate "Services > Start sequence of WinCC 
Runtime  > Alarm sequence report".

The alarm sequence report is output in the default line layout to a line printer. 

To output the alarm report in the page layout:

● Open the "Alarm sequence report" system print job and deactivate the "Use line report" 
option under "Properties > Properties > General".

WinCC assigns the appropriate system report to the system print job. 

Customize the system reports to suit your requirements:

● "@AlarmSequenceReportForPagePrinter" for output in page layout

● "@AlarmSequenceReportForLinePrinter" for output in line layout

See also
Principles for preparation of reports (Page 4302)

Report design tools (Page 4308)

Create a report  (Page 4306)

Alarm sequence report (Page 4360)

Basics for system traces and system print jobs (Page 4326)

Alarm view in reports (Page 4359)

CSV file for trend output

Requirements for a CSV file that is used for the output of trends   
To enable output in a table, the data in the CSV file must have a defined structure.

In the report, the "CSV provider trends" object visualizes the CSV file data in trends. The data 
of a CSV file must conform to the structure described below. 
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The CSV file must contain a paragraph for the different parts of the graphic object. A paragraph, 
in turn, can contain several lines. The following paragraphs are mandatory:

● "Graph": Contains the number of trends and specifications concerning visualization of the 
graphic object

● "Trends": Contains information on the trend visualization

● "Trend values": Contains the values of the trends

The syntax is identical in all paragraphs. The first line marks the beginning of a paragraph and 
defines the interpretation of the paragraph data. The other lines of a paragraph contain the 
actual values of the graphic object or trends.

Use a semicolon to separate the values. Insert line breaks to mark the end of lines.

"Graph" paragraph:
The first line of the "Graph" paragraph must contain the following entry:

#Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize

The second line has to contain the values for the graphic object.

Name Meaning Comment
Name Name of the trend view or file  
Curves Number of trends  
DateFrom Start of the time range Notation: 2000-10-30 

10:15:00.000
DateTo End of the time range Notation: 2000-10-30 

10:15:00.000
Common Y-Axis Common Y axis  
Font Font  
Fontsize Font size  

Example:

Line Content
1 #Trend_T; Name; Curves; DateFrom; DateTo; Common Y-Axis; Font; Fontsize
2 "TrendControl1";3;"2001-10-10 16:30:00.000";"2001-10-10 16:40:00.000";0;"Arial";10

"Trends" paragraph:
The first line of the "Trend" paragraph must contain the following entry:

#Curve; Num; Name; Count; dMin; dMax; Color; Width; CurveType;  Filling

For each trend that is visualized in the graphic object, the paragraph must contain a separate 
line that specifies the trend values.
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Name Meaning Comment
Num Trend number beginning with 0
Name Trend name  
Count Number of values  
dMin Low limit of the trend (for scaling)  
dMax High limit of the trend (for scaling)  
Color Color of the Y axis in hexadecimal notation
Width Line thickness in points e.g. 1.5
CurveType Trend type LINE, DOTS, STEP
Filling Fill color for fields 0=no, 1=yes

Example:

Line Content
1 #Curve; Num; Name; Count; dMin; dMax; Color; Width; CurveType; Filling
2 0;"Temperature";3;10;30;0x00ff0000;1;STEP;0
3 1;"Pressure";5;0;50;0x0000ff00;2;DOTS;0
...  

Structure of the "Trend values" data record
The first line of the "Trend values" paragraph must contain the following entry:

#Data; Num; Date; Value; Flags; Color

For each value that is visualized in the trends, the paragraph must contain a separate line that 
specifies the coordinates. 

Name Meaning Comment
Num Trend number beginning with 0
Date Value on the X axis of the trend Notation: 2000-10-30 

10:15:00.000
Value Value on the Y axis of the trend  
Flags Limits / time overlap  
Color Color of the trend section in hexadecimal notation

If you did not define a color for 
the trend, the color of the 
associated Y axis is applied to 
the trend.

Example:

Line Content
1 #Data; Num; Date; Value; Flags; Color
2 0;"2001-10-10 16:30:00.000";22;0;0x000000FF
3 0;"2001-10-10 16:31:00.000";24;0;
...  
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See also
Create a report  (Page 4306)

Principles for preparation of reports (Page 4302)

CSV provider trends (Page 4349)

CSV file for output of a table

Requirements for a CSV file to be output in tabular format   
In the report, the "CSV provider table" object visualizes the CSV file data in tabular format in 
the report. The data of a CSV file must conform to the structure described below. 

The CSV file must contain a paragraph for the different parts of the table. A paragraph, in turn, 
can contain several lines. The following paragraphs are mandatory:

● "Table": Specifies the number of columns, the font, and the font size

● Columns": Specifies the headers, widths, and alignment of the columns

● "Data" Contains the data

The syntax is identical in all paragraphs. The first line marks the beginning of a paragraph. 
The first line describes how the data of the paragraph are interpreted. The other lines of a 
paragraph contain the actual values of the graphic object or trends.

Use a semicolon to separate the values. Insert line breaks to mark the end of lines.

"Table" paragraph
The first line of the "Table" paragraph must contain the following entry:

#Table; Name; Columns; Font; Fontsize

The second line has to contain the values for the table.

Name Meaning Comment
Name Name of the table view  
Columns Number of columns  
Font Font  
Fontsize Font size  

Example:

Line Content
1 #Table; Name; Columns; Font; Fontsize
2 "Tab_9";4;"Arial";14

"Columns" paragraph
The first line of the "Columns" paragraph must contain the following entry:
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#Column; Num; Header; Width; Alignment 

For each table column to be visualized in the graphic object, the paragraph must contain a 
separate line that specifies the column values.

Name Meaning Comment
Num Column number beginning with 0
Header Column header  
Width Ratio of the width between 

columns 
Example: For a table with three columns, you specify the 
following widths: 2, 4, and 8. 
As a result, the third column is output with twice the width 
of the second and three times the width of the first column.
Column width in characters = [table width in number of 
characters] x [Width] / [Total of Width all values of the 
columns]

Alignment Alignment Left/Central/Right

 

Example:

Line Content
1 #Column; Num; Header; Width; Alignment
2 1;"Number";6;L
3 …
4 …

"Values" paragraph
The first line of the "Values" paragraph must contain the following entry:

#Data; Color; Col1; Col2; Col3; ...

For each line of the table, this paragraph must contain a separate line that specifies the relevant 
column values.

Name Meaning Comment
Color Line color Notation as in HTML as six-digit Hex 

number: 0xbbggrr 
(hex blue blue green green red red)

Col1 Data of column 1  
Col2 Data of column 2  
Col3 Data of column 3  

Example:

Line Content
1 #Data; Color; Col1; Col2; Col3; Col4
2 0xFF00FF;"05/06/02";"15.55.53";86;"+/-"
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Line Content
3 0x32b400;"05/06/02";"15.55.54";87;"+/-"
4 0x32b400;"05/06/02";"16.00.00";82;"+/-"

Preparing data in the spreadsheet program
As demonstrated in the examples above, the first value in the first line of a paragraph 
represents the paragraph identifier, e.g. "#Data" as identifier of the "Values" paragraph. The 
next lines of the paragraph do not contain this identifier.  

If you process the lines of a paragraph (of a CSV file) in a spreadsheet program such as 
Microsoft Excel, the column headers and values will not be congruent.

In order to avoid this effect, insert a semicolon ";" as wildcard at the beginning of the lines that 
contain the actual values:

● The column headers and values are now correctly aligned vertically in Excel.

● WinCC ignores the semicolon ";" at the beginning of the line and outputs the data correctly 
in a trend or table.

Example:

Line Content
1 #Data; Color; Col1; Col2; Col3; Col4
2 ;0xFF00FF;"05/06/02";"15.55.53";86;"+/-"
3 ;0x32b400;"05/06/02";"15.55.54";87;"+/-"

Control characters for formatting values
The control characters are used to specify value attributes such as the color, font style, or the 
alignment. The control characters always lead the value. You can combine several control 
characters: "<B><U>output text", for example, returns the words "output text" in bold and 
underscored format. No distinction is made between upper and lower case text.

The following table provides an overview of the control characters:

<END> Ends a sequence of control characters. The remaining text is applied as 
specified.

<COLOR=#rrggbb> Font color; notation as six-digit Hex number with the following byte 
sequence: #rrggbb 
(red red green green blue blue)

<BGCOLOR=#rrggbb> Background color on hexadecimal notation
<B> Bold font style
<U> Underlined font style
<I> Italic font style
<STRIKE> Strikethrough font style
<ALIGN=left> Text aligned left
<ALIGN=center> Text centered
<ALIGN=right> Text aligned right
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 Note
Different notation for color definitions

Colors are defined by a six-digit hexadecimal number.

In the "Values" paragraph, the line color has the same notation as in HTML, with the following 
byte sequence:

0xbbggrr (blue blue green green red red).

To format a single value, the colors in the control character <Color> are defined by an inverted 
sequence: 

#rrggbb (red red green green blue blue).
 

 

See also
Create a report  (Page 4306)

Principles for preparation of reports (Page 4302)

CSV provider tables (Page 4350)

Administration of detail pages

Adding a detail page    
1. Open the shortcut menu of a detail page.

2. Select the command "Pages > Insert page before" or "Pages > Insert page after."
Depending on the selected command, the new detail page is inserted either before or after 
the existing detail page.

Deleting a detail page     
1. Open the shortcut menu of the detail page that you want to remove.

2. Select the command "Pages > Delete detail page".
The detail page is deleted. 

Sorting detail pages     
1. Open the shortcut menu of the detail page that you want to move.

2. Select the "Pages > Move one page up" or "Pages > Move one page down" command.
Depending on the selected command, the detail page is moved either upward or downward.
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Showing and hiding sections    
1. To show or hide a specific section, click on the plus or minus sign in the title bar of the 

section in the working area. 

2. If you want to show or hide all sections of a report, select the command "Show all pages" 
or "Hide all pages" in the report shortcut menu.

See also
Structure of reports (Page 4294)

Structure of reports (Page 4296)

Principles for preparation of reports (Page 4302)

Principles for preparation of reports (Page 4299)

10.6.2.2 Report output

Overview of report output

Introduction 
In Runtime, report output is event-driven or time-driven.  

You can also display the pending print jobs as a list in Runtime. Operators can use this print 
job list to decide which report they want to output.

Event-driven output   
The report is output after an event was generated.

Examples:

● A tag value changes or exceeds a limit.

● Alarm is incoming, outgoing or acknowledged

● Action by the operator, for example, clicking a button

Time-driven output   
The report is output automatically.

Examples:

● Once at a specified date, e.g. on December 31, 2010 at 6:30 AM

● At intervals, e.g. daily at 8 am, or on Mondays at 6 pm
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Configuration steps 
The configuration of a time-driven or event-driven report output differs depending on the 
Runtime version. 

To display the print job list in Runtime, configure the "Application window" control in screens. 
The application window shows all or only select print jobs, depending on the configuration. 

See also
Planning tasks (Page 6103)

Create a print job (Page 4322)

Configuring automatic start of a print job in the scheduled tasks (Page 4325)

System reports and system print jobs (Page 4326)

Print job/Script diagnostics (Page 3529)

Report output in Runtime Professional (Page 4321)

Report output in Runtime Advanced (Page 4320)

Report output in Runtime Advanced

Introduction   
In Runtime Advanced, report output is event-driven or time-driven. 

Configuration steps  
Configuring event-driven output:

● An event is configured on a button or tag with the "PrintReport" system function.

Configuring time-driven output:

● In the scheduled tasks, configure a "Print job" task and assign it the desired report.
In the task properties, specify the time and frequency of report output.

Output in Runtime
On the control panel of the HMI device, the report is output to the printer that is specified as 
the default printer. 

The default printer enabled for a HMI device can be found in the "Printer list". For further 
information about the "Printer list", refer to the Internet page of Siemens Customer Support 
and the Article ID "11376409".

See also
Configuring reporting of alarms (Page 3995)

Overview of report output (Page 4319)
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Report output in Runtime Professional

Principles for report output

Introduction
In Runtime Professional, report output is event-driven or time-driven.  

Configuration steps  
● Under Reports, create a print job and assign it the desired report.

In the print job properties, specify the number of pages, the time range, and the output 
format (printer or file) of the report.

● To configure a time-driven output, create a task of the type "Print job" in the scheduled 
tasks and assign the desired print job to this task.
In the task properties, specify the time and frequency of report output.

● To configure an event-driven output, configure an event to the selected object to run a C 
Script for calling the "ReportJob" function, e.g.

– ReportJob("<Name of print job>","PRINTJOB");  to output the print job

– ReportJob("<Name of print job>","PREVIEW");  to output a print preview
 

 Note
Screen objects with preconfigured report output

Certain screen objects, e.g. in the alarm view, contain a default button function (printer icon) 
for the report output. You can choose to modify the default system reports, or use a report 
with individual design.

 

Output in Runtime
The report is written as follows depending on the configuration:

● On the printer that is specified as the default printer in the control panel of the HMI device.
The default printer enabled for a HMI device can be found in the "Printer list". For additional 
information about the "Printer list", refer to the Internet page of Siemens Service & Support 
and the Article ID "11376409".

● On a network printer that is available for the HMI device.

● In a file in EMF format.

See also
Reports (Page 4292)

Create a print job (Page 4322)

Configuring automatic start of a print job in the scheduled tasks (Page 4325)
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Overview of objects (Page 3333)

System reports and system print jobs (Page 4326)

Create a print job

Introduction 
You define the following in the print job:

● Scope of the print job: all pages, or specific pages only

● Time period during which report entries are output

● Printer on which the report is printed

● File to which the report is saved

Requirement
The "Print jobs" editor is open.

Procedure     
Proceed as follows to create a new print job:

1. In the "Name" column, double-click in the "<Add>" cell.
A new print job is inserted.

2. In the "Properties > Properties > General" dialog of the Inspector window, enter a "Name" 
for the print job and select the "Report".
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3. Under "Dialog type", specify whether the operator is allowed to modify the report settings 
prior to output.

4. Under "Properties > Properties > Page range", specify whether the print job outputs all or 
only specific pages.

5. Under "Properties > Properties > Time range", specify the time period for the output of 
report entries.

6. If you want to print the report, enable the "Printer" option under "Properties > Properties > 
Output > Print output".
The report is output to the default printer of the HMI device. 
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7. You can select up to three printers if you want to output the report to a different printer.

8. If the report should be exported to a file, select "Properties > Properties > Target file > Print 
to file > Print to file (*.emf)". 
A folder name is created using the information in "Target directory prefix" and the time 
stamp at the time of printing. The reports are created in the runtime project directory under 
"PRT_OUT" in a folder of this name.

Result
The print job is created for the report.

● For time-driven output in Runtime, create a "Print job" task in the scheduled tasks. Assign 
the required print job to this task.

● For event-driven output, assign the object an event that runs a C script for calling the 
"PrintJob" function.
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See also
Principles for report output (Page 4321)

Configuring automatic start of a print job in the scheduled tasks (Page 4325)

Print job/Script diagnostics (Page 3529)

Configuring automatic start of a print job in the scheduled tasks

Introduction
A task of the "print job" type specifies the time and frequency of automatic report output (time-
driven output).

Requirements
● A print job has been created.

Procedure    
To create a task for automatic start of a print job, follow these steps:

1. In the "Runtime settings" of the HMI device activate "Services > Start sequence of WinCC 
Runtime  > Scheduled print jobs in Runtime". 

2. Create a new task in the scheduled tasks.

3. Enter a "Name" for the task under "Properties > Properties > General".

4. Select the "Print job" setting in the "Type" field.

5. Select the required "print job".

6. Under "Start time", specify the time and frequency of report output, for example, daily at 5 
PM:

Result
The task for time-driven report output was created successfully. 
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See also
Principles for report output (Page 4321)

Create a print job (Page 4322)

Printing reports (Page 4344)

System reports and system print jobs

Basics for system traces and system print jobs

System reports and system print jobs for the print function of screen objects
Certain screen objects, e.g. in the alarm view, contain a default button function (printer icon) 
for the report output. 

The "Print" button of the screen object is linked to a preconfigured system print job. The system 
print job, in turn, outputs a preconfigured system report. 

System reports output a "snapshot", or "all data" of the screen object.

● Snapshot: The report outputs the data currently displayed in the screen object.

● All data: The report outputs all data content of the screen object.

The following table identifies the preconfigured system reports and system print jobs for the 
screen objects. 

Screen object Default Print scope System print job System reports
f(t) trend view X Snapshot Function Trend Control - 

Picture
@Function Trend Control - Picture

f(x) trend view X Snapshot Online Trend Control - 
Picture

@Online Trend Control - Picture

Table view  Snapshot Online Table Control – 
Picture

@Online Table Control – Picture

X All data Online Table Control - Table @Online Table Control - Table
Alarm view  Snapshot Alarm Control – Picture @Alarm Control – Picture

X All data Alarm Control - Table @Alarm Control - Table
Recipe view  Snapshot Recipe Control - Picture @Recipe Control - Picture

X All data Recipe Control - Table @Recipe Control - Table
Value table  Snapshot Ruler Control - Picture @Ruler Control - Picture

X All data Ruler Control - Table @Ruler Control - Table

Usually, there is no need to configure the report output.  Customize the system print job or 
system report to suit your requirements: You can also choose to assign a screen object a 
different, preconfigured system print job, or a print job you created for the output of a report 
with individual design.
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System print reports and system print job for alarm sequence reports
The output of an alarm sequence report is configured in a system print job.   If you have 
activated "Properties > Properties > General > Use line report", WinCC uses the alarm 
sequence report with line layout. If you have not activated this option, WinCC uses the alarm 
sequence report with page layout.

Layout System print job System report
Page layout Alarm sequence report @AlarmSequenceReportForPagePrint

er
Line layout Alarm sequence report @AlarmSequenceReportForLinePrinter

See also
Continuous alarm reporting (Page 4312)

Principles for report output (Page 4321)

Changing system reports and system print jobs

Displaying system reports and system print jobs in the project navigation   
The system reports and system print jobs are stored in the project template and not displayed 
automatically in the project navigation. If you want to modify a system report or system print 
job, display these in the project navigation. 

To do this, follow these steps:

● In the project navigation select the command "Add system report" in the shortcut menu of 
the "Reports" folder.

The project navigation also shows the system reports under "Reports". 

The list of "Print jobs" was extended to include system print jobs.
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Changing system print jobs and system reports 
You can modify system print jobs and system reports similar to "normal" print jobs and report, 
however, with the following restrictions: 

● For system print jobs, you cannot rename the report or change its default assignment.

● You cannot add detail pages to system reports.

Validity of changes
In the project, any modification to system reports and system print jobs affect all objects 
assigned the system report or system print job. 

 

 Note
Cancel changes

To restore the preconfigured status of WinCC, for example, after the control for output of data 
was accidentally deleted in the report, first delete the system report or the system print job 
and then select the "Add system reports" command in the shortcut menu of the "Reports" 
folder in the project tree. 

 

Deleting unnecessary system reports and system print jobs   
To only show reports and print jobs used in the project (e. g. after migration), you can delete 
the system reports and system print jobs using the shortcut menu. 

If the deleted report or the deleted print job is used in the project, the system report and the 
system print job preconfigured in WinCC are used.

To display all system reports and system print jobs once again, select the command "Add 
system reports" in the shortcut menu of the "Reports" folder in the project tree.
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● Any deleted system reports and system print jobs will be shown once again. The 
preconfigured WinCC status is restored. The status at the time of deletion is not 
reconstructed.

● All other system reports and system print jobs remain the same.

See also
Basics for system traces and system print jobs (Page 4326)

Creating an individual layout for the report output of a screen object

Introduction
If you do not want to use the default system print job (including the system report) that is linked 
to the screen object for report output, assign this screen object a different system print job, or 
a report with individual layout.

Using a different system print job 
Proceed as follows to assign a different system print job to the screen object:

1. Select the screen object.

2. Select the system print job under "Properties > Properties > General > Print".

Using a report with individual layout
Proceed as follows to use a report with individual layout:

1. Create the report.

2. Define the content of the detail page.

– To output a snapshot of the data currently displayed in the screen object, insert the 
"Control Hardcopy" report object.

– To output all report data in table form that are currently contained in the screen object, 
insert the "Control Data" report object.

– To include the data source in the report, e.g. window title, name of the object or screen, 
insert the "Control Screen" report object.

3. Create a print job and assign it to the report.

4. Select the screen object and then select the print job under "Properties > Properties > 
General > Print". 
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10.6.2.3 Working with objects

Inserting an object

Introduction     
In the "Screens" or "Reports" editor, insert the objects to the "Toolbox" task card. Use the 
mouse to drag the objects into the work area. You either keep the objects in their original size, 
or scale them up or down when you paste them. 

In addition, you can copy or move objects via the clipboard from one editor to another, for 
example to transfer a screen object to a report. Alternatively, you can also use the mouse 
instead of the clipboard for copying and moving:

● Copying: <Ctrl + Drag&Drop>

● Moving: Drag&drop
 

  Note
Basic Panels

The "Reports" editor is not available for Basic Panels.
 

Requirement
The "Tools" task card is open.

Inserting objects in their standard size
1. In the "Toolbox" task card, select the desired graphic object or the desired graphic in the 

WinCC graphics folder.
When you move the cursor across the work area, it turns into a crosshair with an appended 
object icon. 

2. Click the location in the work area where you want to insert the object or graphic.
The object is inserted with its standard size at the desired position in the work area. 

Alternatively, double-click the object in the "Toolbox" task card.

Copying an object
1. Select the desired object.

2. Select "Copy" in the shortcut menu.

3. Click the desired location and select "Paste" in the shortcut menu.

WinCC inserts a copy of the object at the desired location. You can only change the properties 
that are appropriate for the relevant context. 

Example: In the "Screens" editor, you can set for I/O fields and the mode for input and output. 
In the "Reports" editor, the mode is set to "Output". 

Original and copy are not interconnected and are configured independently from one another.
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Inserting lines
1. Select the desired graphic object in the "Tools" task card.

2. Click on a location in the work area. A line in the standard size is inserted. 

Inserting a polygon or polyline
1. Select the desired object "Polyline" or "Polygon" in the "Tools" task card.

2. Click on a location in the work area. This fixes the starting point of the object.

3. Click another location in the work area. A corner point is set.

4. For every additional corner point, click on the corresponding location in the work area.

5. Double-click on a location in the work area. The last corner point is set.
This fixes all the points of the polygon or polyline.

 

  Note
Basic Panels

The "Polyline" and "Polygon" objects are not available for Basic Panels.
 

 

 Note

If you want to insert several objects of the same type, use the "Stamp" function. This avoids 
having to reselect the object in the "Tools" task card every time before inserting it. To do so, 
select the  icon in the toolbar of the "Tools" task card.

 

 

See also
Storing an object in a library (Page 6824)

Inserting a library object (Page 6824)

Deleting an object

Introduction   
You can delete objects individually or with a multiple selection. 

Requirement
You have opened the work area containing at least one object.
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Procedure
1. Select the object that you want to delete.

To delete multiple objects, keep the <Shift> key pressed and select the objects to be deleted 
one after the other. Alternatively, drag and maximize an area around the desired objects 
with the mouse. 

2. Select "Delete" from the shortcut menu.

Result
The selected objects are deleted. 

Inserting several objects of the same type

Introduction
WinCC offers the possibility to "stamp" several objects of the same type directly one after the 
other, i.e. paste without having to reselect the object every time. In addition you have the 
possibility of multiplying an object that has already been inserted.         

Requirement
The "Tools" task card is open.

Inserting several objects of one type
1. Select the object that you want to insert in the "Tools" task card.

2. Click the  icon in the toolbar of the "Tools" task card.
The "Stamp" function is activated.

3. To insert the object with its standard size, click the relevant insertion position in the work 
area.
To insert the object with another size, position the mouse pointer at the desired location in 
the work area. Press the left mouse button and drag the object to the required size.
The object is inserted in the work area as soon as you release the mouse button.

4. Repeat step 3 to insert further objects of the same type.

5. Click the  icon again.
The "Stamp" function is deactivated.

 

  Note

You can copy existing objects using the drag-and-drop +<CTRL> function. The existing 
object is not moved in this case. You paste a copy of this object into the new position 
instead.
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Inserting and multiplying an object
1. Insert the desired object from the "Tools" task card.

2. Press the <Ctrl> key and position the cursor on one of the handles displayed in the figure 
shown below.

3. Drag the handles to the right and/or down while keeping the left mouse button pressed.

4. The object is multiplied depending on available space if you keep moving the cursor.

Result
You have pasted and stamped an object in a screen.

Positioning objects

Introduction
When you select an object, it is enclosed by a rectangle with resizing handles. This rectangle 
is the rectangle which surrounds the object. The position of an object is defined by the 
coordinates of the top left corner of the rectangle surrounding the object.   
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 Note

If the position is outside the work area the object is not displayed in Runtime.
 

Position and align
You have the possibility of having a grid displayed in the work area. You have three options 
for easier positioning of objects:

● "Snap to grid" When you resposition objects, they are automatically snapped and pasted 
to the grid. If you hold down the <Alt> key, the object is no longer snapped to the grid.

● "Snap to objects" When you reposition objects, they are displayed with help lines. You can 
use other objects for orientation during positioning.

● "None": You position the objects in any position. 

You activate and deactivate the grid and options as follows: 

● In the "Options > Settings > Visualization > Screens" menu

● In the "Layout > Grid" task card

Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object you want to move.

The selected object is framed by a rectangle with resizing handles.

2. Left-click the object and keep the mouse button pressed.

3. Move the mouse pointer onto the new position.
The contour of the object moves with the mouse and displays the new position for the object.

The object initially remains at its original position.

4. Now release the mouse button.
The object is moved into the position indicated by the contour of the selection rectangle.
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Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the X and Y values for the position under "Position & Size".

Result
The object appears at its new position. 

Moving an object forward or backward (Basic, Advanced, Professional)

Introduction
You can use the "Order" functions in the shortcut menu of a selected object or in the toolbar 
to move a selected object in front of or behind other objects within an object layer.    

 

 Note

ActiveX controls are always positioned in front of an object layer (.NET property).
 

Requirement
You have opened a screen which contains a layer with multiple objects.

Procedure
1. Select the object you want to move forward or backward.

2. Select the "Sort" command and one of the following commands from the shortcut menu:

Icon Description
Moves the selected object before all the other objects of the same layer
Moves the selected object to the lowest position in the same layer
Moves the selected object up by one position
Moves the selected object down by one position

Alternative procedure
1. Open the "Layers" palette of the "Layout" task card.

2. Navigate to the required object.

3. Hold down the mouse button, and drag the object in the tree topology to the required position 
in the layer.

4. Now release the mouse button.
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Result
The object is moved up or down. 

Resizing objects

Introduction
When you select an object, it is enclosed by a rectangle with handles. You have the following 
options of resizing an object: 

● Drag the handles using the mouse.

● Modify the "Size" property in the Inspector window.

Requirement
You have opened the work area containing at least one object.

Procedure     
1. Select the object you want to resize.

The selection rectangle appears. The following figure shows a selected object:

2. Drag a resizing contact of the rectangle to a new position.
The size of the object changes.

– The size of the object is aligned to the grid pattern, provided the "Snap to grid" function 
is set.

– Press <ALT> to disable this function while you drag the object.
In order to scale the object proportionally, keep the <Shift> key pressed while changing 
the size with the mouse.

Alternative procedure
1. In the Inspector window, select "Properties > Properties > Layout".

2. Enter the size of the object under "Position & Size".

Harmonizing the object size     
1. Select the objects.

2. Now, click one of the following buttons:   or  or  
The size of the selected objects is matched to each other.

The following screen shows how the selected objects are adapted to the height of the reference 
object:
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Icon Description
 Aligns the selected objects to the width of the reference object.

 Aligns the selected objects to the height of the reference object.

 Aligns the selected objects to the width and height of the reference object.

Result
The object now appears with its new size. 

Selecting multiple objects

Introduction    
Select all objects you want to align with each other or to change global properties. This 
procedure is called "multiple selection." 

The Inspector window shows all the properties of the selected objects. 

You now have several options of selecting multiple objects:

● Draw a selection frame around the objects.

● Hold down the <Shift> key, and click the required objects.
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Selection frame of a multiple selection
The selection frame surrounds all objects of a multiple selection. The selection frame is 
comparable with the rectangle that surrounds an individual object.

The selection frame is not visible. When you have made your multiple selection, the following 
frame is displayed:

● The reference object is indicated by the rectangle around it.

● The other selected objects are indicated by a dashed-line frame.

Specifying a reference object   
The reference object is the object upon which the other objects are oriented. The reference 
object is framed by a rectangle with handles. The following figure shows a reference object 
with two other selected objects:

You have the following options to specify the reference object:

● Select the objects via multiple selection. The object selected first is then the reference 
object.

● Draw a selection frame around the objects. The reference object compiled automatically. 
If you wish to specify a different object within the selection as the reference object, click on 
the desired object. This action does not cancel your multiple selection.

Requirement
You have opened the work area containing at least two objects.

Selecting multiple objects with a selection frame
1. Position the mouse pointer in the work area close to one of the objects to be selected.

2. Hold down the mouse button, and draw a selection frame around the objects to be selected.

Or:
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1. Hold down the <Shift> key.

2. Click the relevant objects, working in succession.
All the selected objects are identified by frames.
The object selected first is identified as reference object.

 

  Note

To remove an object from the multiple selection, press <SHIFT>, hold it down and then 
click the relevant object once again.

 

Result
Multiple objects are selected. One of those is identified as the reference object. You can now 
perform the following steps:

● Changing the object properties of all the objects

● Resizing all the objects by the same ratio, by dragging the selection frame to increase or 
reduce the size

● Moving all the objects in one group

● Aligning the objects to the reference object

Repositioning and resizing multiple objects

Possible modifications
After you have selected multiple objects, you edit them:

● Shift using the mouse

– To change the absolute position of the marked objects, position the mouse pointer over 
an object, and shift the multiple selection with the mouse button pressed.

– To resize all the objects by the same ratio, grab the resizing handles of the reference 
object.

● Move over the work area with the icons of the toolbar

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects

● Moving with the shortcut menu commands of the work area

– Change the position of the marked objects with respect to each other

– Align the height and width of the marked objects
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Aligning objects

Procedure
1. Select the objects via multiple selection.

2. Specify an object as the reference object.

3. Select the desired command in the toolbar or the shortcut menu - see table below.
The selected objects will be aligned.

Aligning objects flush     
The selected objects will be aligned flush to the reference object. 

Icon Description
Aligns the selected objects to the left edge of the reference object. 
Aligns the selected objects to the vertical center axis of the reference object. 
Aligns the selected objects to the right edge of the reference object. 
Aligns the selected objects to the upper edge of the reference object. 

Aligns the selected objects to the horizontal center axis of the reference object. 
Aligns the selected objects to the lower edge of the reference object. 
Centers the selected objects to the center points of the reference object. 
Centers the selected objects vertically in the screen.

Snap to object
When you reposition objects, they are displayed with help lines. You can use other objects for 
orientation during positioning.

If you are working with the keyboard, press the Alt key. When you move the selected object 
with the arrow keys, the next anchor point is displayed.

Distributing objects evenly     
You need at least three selected objects. A reference object is not required.

1. Select the objects.

2. Click one of the buttons "Distribute horizontally equal" or "Distribute vertically equal".
The selected objects are distributed at equal distances.
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The following screen shows how you align the vertical spacing of the selected objects:

Icon Description
Aligns the horizontal distance between the objects. 
The position of the objects on the extreme left and right side remains unchanged. All 
other objects are distributed evenly between them. 
Aligns the vertical distance between the objects. 
The position of the objects at the extreme top and bottom (right and left) remains 
unchanged. All other objects are distributed evenly between them. 

Rotating objects

Introduction   
You can rotate a suitable object clockwise or counterclockwise around its center axis in steps 
of 90°. 

 

 Note

Not all the objects can be rotated. Some objects that can be rotated in screens cannot be 
rotated in reports.

 

You can also rotate multiple objects using the multiple selection function. Certain WinCC 
objects such as buttons cannot be rotated.

The alignment of elements in an object will change in a rotated object. The following figure 
shows how a rectangle and an ellipse behave under the different commands for rotating an 
object:
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Requirement
You have opened the work area containing at least one object.

Procedure
1. Select the object that you want to rotate.

2. Click one of the following toolbar icons:
, to rotate the object clockwise around its center point. The angle of rotation is 90°.
, to rotate the object counterclockwise around its center point. The angle of rotation is 

90°.
, to rotate the object clockwise by 180°.

Result
The object is shown at its new angle. 
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Flipping objects

Introduction
You can flip an object along its vertical or horizontal center axis. The alignment of elements in 
an object will change when you flip an object. The following figure shows how a rectangle and 
an ellipse behave under the different commands for flipping an object.

Requirement
You have opened a screen which contains at least one object.

Procedure
1. Select the object that you want to flip.

2. Click the "Flip" command in the shortcut menu and select one of the options displayed:

– , to flip the selected object along its vertical center axis.

– , to flip the selected object along its horizontal center axis.

Result
The object is shown at its flipped position. 

10.6.2.4 Operation in Runtime

Printing reports

Printing a report in Runtime
If you have configured an object with the "PrintReport" system function, the operator can print 
out a report in Runtime. To do this, the operator uses the "Print report" button on a screen. 
The operator can set or change further settings for the report. The report is output to the default 
printer. 
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Printing reports

Starting the report printout in Runtime by the operator    
The operator starts printing of a report by using the "Print" button in the following screen objects 
in Runtime:

● f(x) trend view

● f(t) trend view

● Table view

● Alarm view

● Recipe view

If you have specified in the print job that a dialog is displayed for the selection of a printer or 
to specify properties, the operator changes these settings in Runtime.

If you have configured a button and linked it to an appropriate script, the operator can start the 
report printout using this button.

Automatic start of the report printout
The report printout is started automatically in Runtime in the following situations:

● You have linked a print job with a "Print job" type task.

● You have linked a global script for the report printout with a task.

● Under "Services" in the runtime settings of the HMI device, select the item "Scheduled print 
jobs in Runtime". 

Print job/Script diagnostics
All or selected print jobs are shown in the "Print job/Script diagnostics" object depending on 
the configuration when they are queued in runtime. Depending on the configuration the 
operator can start the report printout, specify the print options and display a print preview in 
the "Print job/Script diagnostics" object. 

See also
Principles for report output (Page 4321)

Print job/Script diagnostics (Page 3529)

Basics for system traces and system print jobs (Page 4326)
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10.6.3 Objects in reports

10.6.3.1 Audit report

Application
With the audit report, the content of the audit trail of a HMI device is output as a report. 

Requirements
The "audit report" object is available only if the following requirements are met:

● The HMI device supports a GMP-compliant configuration.

● GMP-compliant configuration is active in the Runtime settings of the HMI device.

Note that operator actions and system operations are only recorded if a corresponding log is 
configured. 

Layout
In the Inspector window the position, shape, style, color and font types of the object are 
customized. In particular, the following can be adjusted:

● Visibility of the comment

See also
Enabling GMP compliant configuration (Page 7231)

Audit Trail (Page 7233)

Creating an audit trail (Page 7234)

Logging the audit trail (Page 7242)

Reporting an audit trail (Page 7242)

Audit Trail reporting (Page 7243)

Parameters for the audit trail report (Page 7245)

Printing out an audit trail report (Page 7247)
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10.6.3.2 Control Data

Application   
You need report objects if you want to configure a report with individual layout for the report 
output function of a screen object. 

The "Control Data" report object outputs all data contained in the screen object in table form 
– including those data that are currently invisible in the screen object in Runtime.

Layout   
Customize the frame and color settings in the Inspector window. You can adapt the following 
properties in particular:

● Control type whose content is output

● Control objects of the screen object to include in the visualization

● Position & size

Control type
Specify in the Inspector window under "Properties > Properties > General > Control type", if 
the value at the ruler position, the content of the object or the object is output. 

● In the "f(x) trend view" and the "f(t) trend view" select either the "Ruler" or "Other control" 
option.

● For all other screen objects select "Other control".

Control objects of the screen object
In the Inspector window, select "Properties > Properties > General > Content" to specify 
whether to include the toolbar, the status bar and the scroll bar in the screen object.

Size & position
In the Inspector window, select "Properties > Properties > Layout" to specify the size and 
position of the report object.

The table is output in the report in accordance with the width of the report object. Therefore, 
configure a report object with suitable width. 
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See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.3 Control hard copy

Application   
You need report objects if you want to configure a report with individual layout for the report 
output function of a screen object. 

The "Control Hardcopy" object output a snapshot of the screen object. Only the data that is 
visible in the screen object in Runtime is output.

Layout   
Customize the frame and color settings in the Inspector window. 

You can adapt the following properties in particular:

● Control type whose content is output

● Specifies the control objects of the screen objects to include in the visualization.

● Size & position

Control type
Specify in the Inspector window under "Properties > Properties > General > Control type", if 
the value at the ruler position, the content of the object or the object is output. 

● In the "f(x) trend view" and the "f(t) trend view" select either the "Ruler" or "Other control" 
option.

● For all other screen objects select "Other control".

Control objects of the screen object
In the Inspector window, select "Properties > Properties > Content" to specify whether to 
include the toolbar, the status bar and the scroll bar in the screen object.

Visualize processes
10.6 Working with reports

WinCC Professional V13.0
System Manual, 02/2014 4347



Size & position
In the Inspector window, select "Properties > Properties > Layout" to specify the size and 
position of the report object.

In the report, the screen object is resized to fit the frame of the report object. Therefore, 
configure a report object of a suitable size. 

See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.4 Control Information

Application   
You need report objects if you want to configure a report with individual layout for the report 
output function of a screen object.

The "Control Information" report object outputs the window title, the screen object name or the 
screen name. This way you include, for example, the data source in the report. 

Layout   
Customize the frame, color, font, and font size settings in the Inspector window. You can adapt 
the following properties in particular:

● Control type whose content is output

● Content

Control type
Specify in the Inspector window under "Properties > Properties > General > Control type", if 
the value at the ruler position, the content of the object or the object is output.

● In the "f(x) trend view" and the "f(t) trend view" select either the "Ruler" or "Other control" 
option.

● For all other screen objects select "Other control".
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Content
In the Inspector window, select "Properties > Properties > General > Content" to specify the 
information to output with the report object:

● Window title

● Object name

● Screen name

See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.5 CSV provider trends

Application   
The "CSV provider trends" object outputs data from a file in the format "*.csv" as trends in the 
report. 

Page breaks are inserted automatically in the report depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Data source

Data source
Specify the data source under "Properties > Properties > General > Provider". You can select 
a CSV file, or configure an internal tag for dynamic selection of the CSV file. This means that 
the data output is changed directly at the HMI device. The tag must be of data type "String" or 
"WString".

 

 Note

For their visualization in trends, the data in the CSV file must have a defined structure. 
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See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.6 CSV provider tables

Application   
The "CSV provider tables" object outputs data from a CSV file in tabular format in the report. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted automatically.

Layout
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Data source

● Applying fonts from the data source 

Data source 
Specify the data source under "Properties > Properties > General > Provider". You can select 
a CSV file, or configure an internal tag for dynamic selection of the CSV file. This means that 
the data output is changed directly at the HMI device. The tag must be of data type "String" or 
"WString".

 

 Note

To enable output in a table, the data in the CSV file must have a defined structure.
 

Applying fonts from the data source 
Under "Properties > Properties > General > Font", specify whether to apply the font and font 
size from the CSV file for the report output. 

If you deactivate the "Font from data source" and "Font size from data source" options, the 
settings you specified under "Format Text > Style" are used. 
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See also
CSV file for output of a table (Page 4315)

Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.7 Date/time field

Application   
The "Date/time field" object shows the system time of the HMI device or the date and / or time 
of a connected tag. The layout depends on the language setting on the HMI device.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. In the "Properties > Properties > General" dialog, you can adapt the following properties 
in particular:

● Long date/time format: This setting defines the format displayed for the data and / or time.

● System time: Specifies whether to use the system time of the HMI device, or the data and / 
or time of a connected tag.

Long date/time format 

Option Description
"Enabled" Date and / or time is fully displayed, for example "Sunday, December 31, 2000 

10:59:59 AM"
"Disabled" Date and / or time is displayed in abbreviated form, e.g. "12/31/2000 10:59:59 

AM"

System time 

Option Description
"Enabled" The system time of the HMI device is displayed
"Disabled" The date and / or time of the connected tag is displayed

Select a tag of the "DateTime" data type, e.g. an internal tag. Information about 
data types which are available for connection to other PLCs can be found in 
the documentation about the respective communication drivers.
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See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.8 Date/time field

Application   
The "Date/time field" object outputs the date and / or time in an individually configured format 
in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Display format of date and / or time

Display format of date and time
Specify the date and / or time format under "Properties > Properties > General > Format". You 
can combine wildcards and any text.

The following table shows which wildcards you can use:

Wildcards Implementation Example
%a Weekday abbreviated Sun
%A Weekday in full form Sunday
%b Month abbreviated Dec
%B Month in full form December
%c Date and time in standard format 12/31/2000 10:59:59 AM
%d Day as decimal value (01 to 31) 31
%H Hours in 24 hour format (00 to 23) 22
%I Hours in 12 hour format (01 to 12) 10
%j Day of the year as decimal value (000 of 366) 366
%m Month as decimal value (01 to 12) 12
%M Minute as decimal value (00 to 59) 59
%p PM/AM notation for the 12 hour format AM
%S Second as decimal value (00 to 59) 59
%U Week of year as decimal value (01 to 51) 50
%x Date in standard format 12/31/2000
%X Time in standard format 10:59 AM
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Wildcards Implementation Example
%y Year without century as decimal value (00 

to 99)
00

%Y Year with century as decimal value 2000
%z Time zone as name W. European Standard Time
%% Percent character %

Examples
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Date: %x time: %H:%M Date: 12/31/2000 time: 22:59
Printout of %a %c Printout of Sun 12/06/2010 10:59:59 AM

See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.9 I/O field

Application   
The "I/O field" object is used to enter process values.
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Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Display format: Specifies the format in which the values in the I/O field are output.
 

  Note

The "I/O field" object is also available in "Screens" editor. In reports, the object only outputs 
data. Accordingly only configure the output of data for application in reports.

 

Display format  
The "display format" for the output of values is specified in "Properties > Properties > General 
> Format", in the Inspector window.

Layout  
"Binary" Output of values in binary form
"Date" * Output of date specifications. The format depends on the language setting on the 

HMI device.
"Date/time" * Output of date and time specifications. The format depends on the language 

setting on the HMI device.
"Decimal" * Output of values in decimal form.
"Hexadecimal" Output of values in hexadecimal form.
"Time" * Output of time specifications. The format depends on the language setting on the 

HMI device.
"Character string" Output of strings.
*: not in Runtime Professional

Avoid overlaps with output fields 
If several I/O fields are configured as output fields with a transparent background in a report, 
these I/O fields may overlap. The transparent part of the one field covers the digits of the other 
field. This may cause display problems in the report. In order to avoid such overlaps, set the 
margins of the I/O fields to zero in the object properties under "Properties > Properties > 
Appearance". Activate "Properties > Properties > Layout > Fit object to contents."

See also
Report design tools (Page 4308)

Create a report  (Page 4306)
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10.6.3.10 f(t) trend view in reports

Application   
You use the "f(t) trend view" object to visualize logging tag values in the form of trends as a 
function of time. The report displays the status that the trend profile had at the time of the start 
of the print job. 

 

 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

Special features for the output in reports
In contrast to the configuration in the screen, you can dynamize the properties of each trend 
with tags, for example, the display and the data supply. This way you can, for example, use a 
report several times. 

See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.11 f(x) trend view in reports

Application   
You use the "f(x) trend view" object to represent the values of a tag as a function of another 
tag. This means that you can present temperature trends as a function of the pressure, for 
example. The report displays the status that the trend profile had at the time of the start of the 
print job. 
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You can also compare the trend to a setpoint trend. 

 

 Note
Reduced functional scope for the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

Special features for the output in reports
In contrast to the configuration in the screen, you can dynamize the properties of each trend 
with tags, for example, the display and the data supply. This way you can, for example, use a 
report several times. 

See also
f(x) trend view (Page 3547)

Report design tools (Page 4308)

Create a report  (Page 4306)
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10.6.3.12 Graphic view

application  
The "Graphic view" object is used to display graphics.

Layout  
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Graphic: Specifies the graphic file that is displayed in the object.

● Stretch graphic: Specifies the automatic size stretching for objects with graphics.

Inserting graphics  
The following graphic format is used in the "Graphic view" object: *.bmp, *.tif, *.png, *.ico, *.emf, 
*.wmf, *.gif, *.jpg or *.jpeg. You may also use graphics as OLE objects in the Graphic view .

1. In the Inspector window, select "Properties > Properties > General":

2. Select the graphic you want to add in the drop-down list under "Graphic".
The graphic preview is shown in the right pane.

3. Click "Assign" to insert the graphic in the Graphic view .

Stretch graphic  
Whether a graphic displayed in a Graphic view  is stretched to the size of the Graphic view  in 
runtime is specified in the Inspector window.

1. In the Inspector window, select "Properties > Properties > Layout".

2. Select one of the following options from the "Fit to size" area:

– Fit object size to content

– Fit content to object size
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10.6.3.13 Graphic I/O field

Application   
With the "Graphic I/O field" object, the graphics of a graphics list are displayed, depending on 
the tag value. In the Inspector window, the tag and graphics list are configured, under 
"Properties > Properties > General":

 

 Note

The "Graphic I/O field" object is also available in "Screens" editor. In reports, the object only 
outputs data. Accordingly only configure the output of data for application in reports.

 

Layout  
Customize settings for color, frame, position and object size in the inspector window. In 
particular, the "Fit to size" is defined by specifying whether the object is adjusted to the graphics 
during output in the report or the graphic is adjusted in the object. 

See also
Create a report  (Page 4306)

10.6.3.14 Hardcopy

Application
Use the "Hardcopy" object to output a snapshot of the screen content in the report. 
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Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Specifying the range

Specifying the range
Under "Properties > Properties > Range", specify the screen content to output in the report: 

● "Current window (1)": Active window

● "Selected section (2)": Selected section

● "Entire screen (0)": Complete content

You can assign a tag of the "Number" type for dynamic range selection. The settings are made 
as follows:

● 0 = "Entire screen"

● 1 = "Current window"

● 2 = "Selected section"

Specify the following properties for a "Selected section (0)":

● X position of the upper left point of the area

● Y position of the upper left point of the area

● Width in pixels

● Height in pixels

You can assign a dynamic tag to each property. 

See also
Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.15 Alarm view in reports

Application   
The "Alarm view" object displays alarms that occur during the process in a plant. You also use 
the alarm view to visualize alarms in list format. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term). 

The report displays the status that the alarm view had at the time of the start of the print job. 
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 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor. 

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

 

See also
Alarm view (Page 3583)

Report design tools (Page 4308)

Continuous alarm reporting (Page 4312)

Create a report  (Page 4306)

10.6.3.16 Alarm sequence report

Application   
The "Alarm sequence report" object outputs all alarms from the HMI device as of the start of 
Runtime continuously in chronological order. It is only used in the 
"@AlarmSequenceReportForPage" system report that specified the output of the WinCC alarm 
sequence report in page layout. 

You specify which alarms are output in the object properties. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 
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See also
Report design tools (Page 4308)

Continuous alarm reporting (Page 4312)

Create a report  (Page 4306)

10.6.3.17 Alarm report

Application   
Use the "Alarm report" object to output alarms of the selected alarm classes from the alarm 
buffer or alarm log to the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Source

● Alarm classes

● Time range

● Additional settings for the display

● Visible columns
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Specifying the source
Under "Properties > Properties > General > Settings > Source", specify whether to display 
alarms from the alarm buffer, or from the alarm log. Select the alarm log in the "Alarm log" 
dialog.

Specifying alarm classes
Under "Properties > Properties > General > Alarm classes, enable the alarm classes for the 
alarms output to the report. 

Specifying the time range
If you want to restrict alarm output to a specific time range, select the start and end tags for 
the time range in the "Properties > Properties > General > Time range" dialog. The tag must 
be of the "DateTime" type.

Additional settings for the display
Under "Properties > Properties > General > Settings, specify the following settings for the 
display in the alarm report:  

● Under "Sorting", specify whether to start the display with the oldest or most recent alarm.

● Under "Lines per entry", specify the number of lines to be available for each alarm. The 
required number of lines depends on the following factors:

– Number and width of the selected columns for the output

– Font size used

– Paper format of the printer

● Select "Visible heading" to enable the display of column headers.

● Select "Display milliseconds" to enable the display of milliseconds for time data.

Visible columns
Under ""Properties > Properties > Layout > Visible columns", enable the columns to be 
displayed in the alarm report. 

See also
Configuring reporting of alarms (Page 3995)

Create a report  (Page 4306)
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10.6.3.18 ODBC database field

Application   
Using the "ODBC database field" object, you can output data from a single table row in the 
report via the ODBC interface. The ODBC interface is used for the consistent output of data 
that does not originate from WinCC in the report. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Settings for the SQL connection

● Data selection for the SQL statement

Connection settings
Under "Properties > Properties > SQL connection", specify the data source, user name, and 
password for the SQL connection. You can assign dynamic tag to all settings. This means that 
the data output is changed directly at the HMI device.

Data selection
Under "Properties > Properties > SQL statement", specify the data area to visualize in the 
report. Enter "Select-Statement".

Enter the required "Select-Statement" in the text field of the same name or select the "Tag" 
that supplies the Select-Statement. The tag must be of the "String" or "WString" type.

You can dynamize the Select-Statement in the input field of the same name with tags. To do 
so you select "Insert reportfield" at the required text passage in the shortcut menu and then 
select the required tag.

 

 Note

Enter only "Select-Statements".
 

See also
Report design tools (Page 4308)

Create a report  (Page 4306)
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10.6.3.19 ODBC database table

Application     
Using the "ODBC database table" object, you can output data from a table in the report via the 
ODBC interface. The ODBC interface is used for the consistent output of data that does not 
originate from WinCC in the report. 

Page breaks are inserted automatically in the report, depending on the amount of output data. 
The configured width is not changed in the report. Subsequent objects are shifted 
automatically. 

Layout       
In the Inspector window, you customize the position, shape, style, colors and font types of the 
object. You can adapt the following properties in particular:

● Settings for the SQL connection

● Data selection for the SQL statement

● Table layout, e.g. number of columns and circular list

Connection settings
Under "Properties > Properties > SQL connection", specify the data source, user name, and 
password for the SQL connection. You can assign dynamic tag to all settings. This means that 
the data output is changed directly at the HMI device.

Data selection
Under "Properties > Properties > SQL statement", specify the data area to visualize in the 
report. 

Enter the required "Select-Statement" in the text field of the same name or select the "Tag" 
that supplies the Select-Statement. The tag must be of the "String" or "WString" type.

You can dynamize the Select-Statement in the input field of the same name with tags. To do 
so you select "Insert reportfield" at the required text passage in the shortcut menu and then 
select the required tag.

 

 Note

Enter only "Select-Statements".
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Circular list
In the Inspector window, use the "Circular list" option under "Properties > Properties > Table" 
to specify the the way the data is distributed to the table columns. 

● "Circular list" disabled
The table rows are filled in descending order. 
A value is output in the first column of a row. The other columns will stay empty.

● "Circular list" is enabled
The table rows are filled in descending order. 
All columns of a row are filled left to right.

 

  Note

This option is only effective if the data are supplied in one column and if the configured 
table has several columns.

 

Example:
You configure a table with three columns. At the time of report output, the screen object 
contains the following data: A1, A2, A3, B1, B2, B3, C1, C3, D4

The following table shows the result with deactivated "Circular list" option:

Column 1 Column 2 Column 3
A1   
A2   
A3   
B1   
B2   
...   

The following table shows the result with activated "Circular list" option:

Column 1 Column 2 Column 3
A1 A2 A3
B1 B2 B3
C1 C3 D4

See also
Report design tools (Page 4308)

Create a report  (Page 4306)

Visualize processes
10.6 Working with reports

WinCC Professional V13.0
System Manual, 02/2014 4365



10.6.3.20 Project name

Application   
Use the "Project name" object to output the name of the current project in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Format of the project name

Format of the project name
In the "Format" field under "Properties > Text format > Style", specify the output format for the 
project name. You can use a placeholder for the project name and enter any text, if necessary.

The following table shows which wildcards you can use:

Wildcards Value
"%R" Path and project name
"%r" Project name (without path information)

Examples
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Project: %R Project: D:\WinCC\Projects\MP277_Mixing
Created for project "%r" Created for project "MP277_Mixing"

See also
Report design tools (Page 4308)

Create a report  (Page 4306)
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10.6.3.21 Report name

Application   
Use the "Report name" object to output the report name in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Format of the report name

Format of the report name
In the "Format" field under "Properties > Text format > Style", specify the output format for the 
report name. You can use a placeholder for the report name and enter any text, if necessary.

The following table shows which wildcards you can use:

Wildcards Value
"%L" or "%l" Report name

Example
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Report: %L Report: Alarms

See also
Report design tools (Page 4308)

Create a report  (Page 4306)
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10.6.3.22 Recipe view in reports

Application   
Use the "Recipe view" object to display recipe elements in tabular format. The report displays 
the status that the recipe view had at the time of the start of the print job. 

 

 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime. 

 

See also
Report design tools (Page 4308)

Definition and applications (Page 4228)

Create a report  (Page 4306)
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10.6.3.23 Recipe report

application   
Use the "Recipe report" object to output the elements of recipe data records in the report.

Layout    
In the Inspector window, you customize the position, shape, style, color, and font types of the 
object. You can adapt the following properties in particular:

● Recipe

● Data record

● Format

● Visible entries

Selecting a recipe
Specify the recipes to be output in the recipe report under "Properties > Properties > General 
> Recipe". You can define the recipes based on their recipe name, or on a range of recipe 
numbers. Under "First recipe" and "Last recipe", enter a value or select a tag.

You can also choose to display all recipes.

Selecting a data record
Under "Properties > Properties > General > Data record", specify which data records of the 
selected recipes are to be output in the recipe report. You can define the data records based 
on the data record name, or on a range of data record numbers. Under "First recipe" and "Last 
recipe", enter a value or select a tag.

You can also choose to display all data records of the selected recipes.
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Format
In the "Format" field of the "Properties > Properties > Layout > Settings" dialog, specify whether 
to output the data records as a table in column format or line report format.

WinCC updates the preview in the detail page accordingly.

Visible entries
Under ""Properties > Properties > Layout > Visible entries", enable the columns to be displayed 
in the recipe report. Select "Show headings" to enable the display of column headers. 

See also
Definition and applications (Page 4228)

Create a report  (Page 4306)

10.6.3.24 Page number

application   
Use the "Page number" object to output the current page number in the report.

Layout    
In the inspector window, change the settings for color, font, position and object size. In 
particular, specify "Size adaptation":

Fit to size
Under "Properties > Properties > Layout > Fit to size", the "Fit object to content" option is used 
to specify whether WinCC adjusts to the object size of the field content:

● Enabled "Fit object to contents" option:
WinCC automatically adjusts the size of the object to the configured format. The font size 
and field length are defined under "Properties > Properties > General > Text". 
The object can be moved in the working area, however, the size cannot be changed. During 
report output, the entire field content is output at the time of report output.

● Disabled "Fit object to contents" option:
Customize the field size by yourself. WinCC does not resize the field for report output. It 
can be possible that not all content of the field is output in the report. Therefore, configure 
a field of sufficient size. 

See also
Create a report  (Page 4306)
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10.6.3.25 Page number

Application   
The "Page number" object outputs the current page number or the total number of pages in 
the report in the header or footer of the report.

Layout    
In the Inspector window, change the settings for color, font, frame, alignment as well as position 
and object size. In particular you set the format of the page number.

Format 
Under "Properties > General > Text > Format", specify the format of the page numbers to be 
displayed. You can use a wildcard for the page numbers and enter a user-specific text.

The following table shows which wildcards you can use:

Wildcards Value
"%N", or "%n" Current page number
"%T", or "%t" Total number of pages in the report

Examples
The following table shows a few examples of the combination of wildcards and text:  

Format Output example
Page %n of %t Page 2 of 10
%n/%t 2/10

See also
Report design tools (Page 4308)

Create a report  (Page 4306)
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10.6.3.26 Symbolic I/O field

application   
With the "Symbolic I/O field" object, the content of a text list in reports is displayed, depending 
on the tag value. In the inspector window, the tag and text list is configured under "Properties 
> Properties > General":

Layout  
In the inspector window, change the settings for color, frame, font, position and object size. In 
particular, the "Fit to size" is defined, by specifying whether the object size is adjusted to the 
text during output in the report or not.

 

 Note

The "Symbolic I/O field" object is also available in "Screens" editor. In reports, the object only 
outputs data. Accordingly only configure the output of data for application in reports. 

 

See also
Create a report  (Page 4306)

10.6.3.27 Table view in reports

Application   
You use the "Table view" object to display the process data in a table. Each row of the table 
represents the status of the selected process tags at a specific time.

The report displays the status that the table had at the time of the start of the print job. 
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 Note
Reduced functional scope of the output in reports

The configuration of the object in the "Reports" editor differs only slightly compared to its 
configuration in the "Screens" editor.

The functional scope of the object is adapted for the output in reports: In the "Reports" editor, 
for example, it is not possible to configure operating elements in Runtime.

 

Special features for the output in reports
By contrast to the configuration in the screen, you can assign tags with dynamic properties for 
the time and value columns. This way you can, for example, use a report several times. 

See also
Table view (Page 3631)

Report design tools (Page 4308)

Create a report  (Page 4306)

10.6.3.28 Text field

Application   
The "Text field" is a closed object which you can fill with a color. 

Layout   
In the Inspector window, you customize the position, shape, style, color and font types of the 
object. You can adapt the following properties in particular:

● Text: Specifies the text for the text field.

● Size of text field: Defines whether the size of the object is adapted to the space required 
by the largest list entry.
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Text   
Specify the text for the text field in the Inspector window. 

1. In the Inspector window, select "Properties > Properties > General".

2. Enter a text.
For texts over several lines you can set a line break by pressing the key combination <Shift 
+ Enter>.

Size of text field   
In the Inspector window, you can define whether the size of the object is adapted to the space 
required by the largest list entry. 

1. In the Inspector window, select "Properties > Properties > Layout".

2. Activate "Resize > Fit to contents".

10.7 Configuring user administration

10.7.1 Field of application of the user administration

Principle
The access protection controls access to data and functions in Runtime. This feature protects 
your applications against unauthorized operation. Safety-related operations are already limited 
to specific user groups when a project is being created. To this purpose you set up users and 
user groups that you equip with characteristic access rights, so-called authorizations. You then 
configure the authorizations required for operation of safety-related objects. Operators only 
have access, for example, to specific operator controls. Commissioners, for example, have 
unlimited access in Runtime. 

Definition
You administer users, user groups and authorizations centrally in the user administration of 
WinCC. You transfer users and user groups together with the project to the HMI device. The 
users and passwords are managed on the HMI device in the User view. 
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Application example
You configure the "Service" authorization so that only service technicians have access to the 
configuration parameters. You assign the authorization to the "Service technician" user group. 
This allows all members of this group to set the protected configuration parameters.

 

 NOTICE

Access protection does not protect against incorrect operations. It is your job to ensure that 
only authorized personnel with appropriate training will design, commission, operate and 
maintain plants and machines. 

Access protection is not suitable for defining work routines and monitoring their observance. 
 

10.7.2 Form of the user administration

Introduction
In case of a project in manufacturing engineering, the environment at the equipment 
manufacturer has to be differentiated from the environment at the end customer as plant 
operator. 

The equipment manufacturer allows users, for example Mr. Foreman, a specific access within 
the application or HMI device. However, a user Foreman does not exist at the end customer. 
The machine manufacturer cannot know the end users and the tasks they have to perform for 
configuration. The final users are usually set after commissioning at the end customer.
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Principle
To minimize the work required for management, authorizations are assigned via user groups 
and not directly to individual users.

A user group assembles configured authorizations according to common jobs. For example, 
all permissions required for a service job are collected in a "Service technician" group. When 
you create a user who should be responsible for servicing, you simply assign him to the 
"Service technician" group.

The user view enables user administration in Runtime. Use user view to create, delete and 
assign an authorization to users in Runtime.

The user administration separates the administration of the users from the configuration of the 
authorizations. This ensures flexibility at the access protection. 

Defaults can be set for the user administration during the configuration phase in the 
Engineering System. 

10.7.3 Basics

10.7.3.1 User

Introduction
You can create users in the "Users" tab of the "User administration" editor and assign them to 
user groups. The "Users" tab is part of the user administration in WinCC. 

Open
To open the "Users" tab, double-click "User administration" in the project window.

Work area
The users are managed in the work area:

● You create or delete users.

● You assign users to user groups.
 

  Note

You can assign a user to exactly one user group.
 

Inspector window
When you select a user, you can change the password in the "General" group. Under 
"Automatic logoff" you can specify if the user is to be automatically logged off by the HMI device 
when there is no operator activity after the specified time. 
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See also
Settings for the user administration (Page 4381)

10.7.3.2 Users work area

Introduction
The "Users" work area lists the users and user groups in table form. You administrate the users 
and assign them to a user group. 

Principle
The work area consists of the "Users" and "Groups" tables.

The "Users" table shows the existing users. When you select a user in this table, the "Groups" 
table shows the user group to which the user belongs. 

 

 Note

For the user "Administrator", the default password is "administrator". For security reasons, 
you should change the password of this user.

 

See also
Settings for the user administration (Page 4381)

User groups (Page 4378)

User groups work area (Page 4378)

Settings for the user administration (Page 4380)

Settings for the user administration (Page 4384)
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10.7.3.3 User groups

Introduction
You can create users and authorizations in the "User groups" tab of the "User Administration" 
editor. The "User groups" tab is part of the user administration in WinCC.

Open
Double-click the "User administration" in the project window. Open the "User groups" tab.

Work area
The user groups and authorizations are managed in the work area:

● You create new user groups and authorizations or delete them.

● You assign the authorizations to the user groups.

Inspector window
When a user group or an authorization is selected, you can edit the name in the "General" 
group. You can also enter a brief description in the "Comment" group.

See also
Settings for the user administration (Page 4381)

Users work area (Page 4377)

User groups work area (Page 4378)

Settings for the user administration (Page 4380)

Settings for the user administration (Page 4384)

10.7.3.4 User groups work area

Introduction
The "User groups" work area shows a table of the groups and their authorizations. You 
administer the user groups and assign authorizations to them.
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Principle
The work area consists of the "Groups" and "Authorizations" tables.

The "Groups" table shows the existing user groups. When you select a user group in this table, 
the "Active" column of the "Authorizations" table shows the authorizations which were assigned 
to the user group.

The number of the user group and of the authorization is assigned by the user administration. 
The designations and descriptions are assigned by you.

The number of predefined authorizations are fixed. Authorizations that you create can be freely 
edited. Ensure that the assigned numbers are unique.

See also
Settings for the user administration (Page 4381)

Users work area (Page 4377)

User groups (Page 4378)

Settings for the user administration (Page 4380)

Settings for the user administration (Page 4384)
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10.7.3.5 Settings for the user administration

Introduction
In the "Runtime settings > User administration" editor, configure the security settings for users 
and their passwords in runtime.     

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration".

Work area
You carry out the settings for the validity of passwords in runtime in the work area. You 
determine the complexity of the password, for example. 

Effects in Runtime
The security settings have the following effects in runtime, depending on the configuration. 

● "General" group

– "Enable limit for logon attempts" check box selected
The number entered in the "Number of incorrect logon attempts" box defines the number 
of logon attempts a user is allowed before being assigned to the "Unauthorized" group.
"Enable limit for logon attempts" check box not selected
The user has an unlimited number of logon attempts in runtime.

– "Number of incorrect logon attempts" field
If you enter "4" in the field, for example, and the fourth logon attempt fails, the user is 
automatically assigned to the "Unauthorized" group.
You can specify 1 to 9 attempts. 

– "Logon only with password" check box
When the check box is selected, the user will be authenticated by the password. The 
user name is not required. 
To match users to passwords, you cannot configure passwords more than once. 

● "Hierarchy level" group 

– "Group-specific rights for user administration" check box
When this check box is selected, administrators only manage users whose group 
number is less than or equal to their own.
For example, an administrator whose group number is 5 can only manage users whose 
group number is less than or equal to 5. This means that the administrator can assign 
users only to groups with a group number less than or equal to 5. 
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● "Password" group 

– "Enable password aging" checkbox selected
The password expires after the number of days set in the "Validity of the password 
(days)" field. 
The "Password aging" column is selected in the "User groups" editor. This enables you 
to specify group-by-group, if the passwords should expire or if the password generations 
should be saved. Passwords never expire for groups for which password aging is not 
enabled.

– "Prewarning time (days)" field
The user is informed that the password will expire the specified number of days before 
the password expires. 

– "Password generations" field
If the user changes the password, the new password must be different from the specified 
number of previous passwords. The number of password generations ranges from 1 to 
5.

● "Password complexity" group 

– "Must include special characters" check box selected
The user must enter a password containing at least one special character at any position.

– "Must include number" check box selected
The user must enter a password containing at least one number at any position.

– "Minimum password length" field
The user must enter a password with a minimum length, as specified in the "Minimum 
password length" field.
The minimum length of the password is 3 characters. 

See also
Settings for the user administration (Page 4381)

Users work area (Page 4377)

User groups (Page 4378)

User groups work area (Page 4378)

10.7.3.6 Settings for the user administration

Introduction
In the "Runtime settings > User administration" editor, configure the security settings for users 
and their passwords in runtime.     

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration".
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Work area
You carry out the settings for the validity of passwords in runtime in the work area. You 
determine the complexity of the password, for example. 

Effects in Runtime
The security settings have the following effects in runtime, depending on the configuration. 

● "General" group

– "Change initial password" check box selected
The user must change the administrator-assigned password when logging on for the 
first time.

– "Change logoff time" checkbox selected
Simple user rights are sufficient for changing the logoff time. 
The logoff time is the period after which the user administration automatically logs off a 
user when no operator activity is detected in the system.
The logoff time for the SIMATIC Logon user corresponds to the logoff time of the default 
user "Administrator".
Any user changes of the logoff time are logged in the Audit Trail. 

– "Enable limit for logon attempts" check box selected
The number entered in the "Number of incorrect logon attempts" box defines the number 
of logon attempts a user is allowed before being assigned to the "Unauthorized" group.
"Enable limit for logon attempts" check box not selected
The user has an unlimited number of logon attempts in runtime.

– "Number of incorrect logon attempts" field
If you enter "4" in the field, for example, and the fourth logon attempt fails, the user is 
automatically assigned to the "Unauthorized" group.
You can specify 1 to 9 attempts. 

– "Logon only with password" check box
When the check box is selected, the user will be authenticated by the password. The 
user name is not required. 
To match users to passwords, you cannot configure passwords more than once. 

● "Hierarchy level" group 

– "Group-specific rights for user administration" check box
When this check box is selected, administrators only manage users whose group 
number is less than or equal to their own.
For example, an administrator whose group number is 5 can only manage users whose 
group number is less than or equal to 5. This means that the administrator can assign 
users only to groups with a group number less than or equal to 5. 
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● "Password" group

– "Enable password aging" checkbox selected
The password expires after the number of days set in the "Validity of the password 
(days)" field. 
The "Password aging" column is selected in the "User groups" editor. This enables you 
to specify group-by-group, if the passwords should expire or if the password generations 
should be saved. Passwords never expire for groups for which password aging is not 
enabled.

– "Prewarning time (days)" field
The user is informed that the password will expire the specified number of days before 
the password expires. 

– "Password generations" field
If the user changes the password, the new password must be different from the specified 
number of previous passwords. The number of password generations ranges from 1 to 
5.

● "Password complexity" group 

– "Must include special characters" check box selected
The user must enter a password containing at least one special character at any position.

– "Must include number" check box selected
The user must enter a password containing at least one number at any position.

– "Minimum password length" field
The user must enter a password with a minimum length, as specified in the "Minimum 
password length" field.
The minimum length of the password is 3 characters.

● "SIMATIC Logon" group

– "Activate SIMATIC Logon" check box selected
A connection is established to the server. Authorization is performed via SIMATIC Logon.

– "Encrypted transfer" checkbox selected
The data is encrypted before it is transferred to the server. 

See also
Central user administration using SIMATIC Logon (Page 4395)

User (Page 4376)

Users work area (Page 4377)

User groups (Page 4378)

User groups work area (Page 4378)

Settings for the user administration (Page 4380)

Settings for the user administration (Page 4384)
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10.7.3.7 Settings for the user administration

Introduction
In the "Runtime settings > User administration", editor you specify whether users log on 
dynamically to an HMI device in runtime. You can also activate a central user administration 
by means of SIMATIC Logon.      

Open
Double-click the "Runtime settings" editor in the project window. Click "User administration".

 

 Note

The view of the work area depends on the HMI device in use.
 

Work area
In the work area, you can specify how the operator logs on to the HMI device:

● Dynamic logon    
With dynamic logon, you assign a variable to each HMI device. A variable value is assigned 
to a user. The user then logs on in runtime by setting the variable value on an HMI device, 
for example, using a key switch.

● SIMATIC Logon 
When you use SIMATIC Logon, you specify the display name that is shown on the HMI 
device. SIMATIC Logon supports centralized user administration. As soon as you select 
the "SIMATIC Logon" option, the users created in the "User administration" editor will be 
ignored. The "Users" work area is no longer displayed.
Only groups whose settings agree with the names of the Windows groups are important.

 

  Note

If you use SIMATIC Logon , you cannot use the "Automatic Logon" option.
 

Effects in Runtime
With dynamic logon, the user is logged on to the HMI device as soon as the variable contains 
the correct value. 

When SIMATIC Logon is used, the operator logs on to the Windows operating system. The 
user settings, such as the password validity, are read by SIMATIC Logon from the user 
administration of the operating system. 

See also
Settings for the user administration (Page 4381)

Users work area (Page 4377)

Visualize processes
10.7 Configuring user administration

WinCC Professional V13.0
4384 System Manual, 02/2014



User groups (Page 4378)

User groups work area (Page 4378)

10.7.4 Setting up the user administration

10.7.4.1 Basics of user administration

Principle
This section addresses four target groups. The topics are organized correspondingly. The 
target groups serve as examples for different groups of persons who use the user 
administration. 

1. Administrator OEM

2. Administrator RT

3. Planners

4. Operator

As Administrator OEM you create the user groups, users and authorizations for Runtime in 
the Engineering System of, for example, an equipment manufacturer.

As Administrator RT you administer users in Runtime by means of the "User view."

As the project engineer you assign the authorizations to the user groups in the Engineering 
System. In addition, you configure the authorizations for objects. 

As Operator you log on in runtime. You can only access a protected object if you have the 
required authorization.

 

 Note

The Administrator RT target group already exists in the Runtime user administration as the 
predefined user group "Administrator group." For a better understanding the predefined user 
groups and authorizations are not used below. 

 

10.7.4.2 Administering users for Runtime 

Creating an authorization

Introduction
You create an authorization and assign it to one or more user groups.   
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Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Authorizations" table.

2. Enter "Stop runtime" as the name of the authorization.

3. Enter a brief description as the "Comment".

See also
Creating a user group (Page 4386)

Managing user groups (Page 4391)

Changing the number of the user group (Page 4393)

Creating a user group

Introduction
User groups are created so that you do not have to assign an authorization to every single 
user. You create a user group, assign authorizations and then assign users to it.  

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

 
 

 Note
Using SIMATIC Logon

Ensure that the names of the user groups in Windows and WinCC are identical.
 

Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Groups" table.

2. Enter "Operators" as the "Name" of the user group.

3. Change the "Number" of the user group as required.
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4. Enter "Display name" of the "Operators" user group.

5. Enter a brief description as the "Comment".

In runtime, the user view shows the display name of the user group. The display name of the 
user group depends on the language. You can specify the name in several languages and 
switch between languages in runtime. 

See also
Creating an authorization (Page 4385)

Creating a user group

Introduction
User groups are created so that you do not have to assign an authorization to every single 
user. You create a user group, assign authorizations and then assign users to it.   

 

 Note
Using SIMATIC Logon

Ensure that the names of the user groups in Windows and WinCC are identical.
 

 
 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
The "User groups" work area is open.

Procedure
1. Double-click "Add" in the "Groups" table.

2. Enter "Operators" as the name of the user group.

3. Change the "Number" of the user group as required.

4. Enter a brief description as the "Comment."
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Assigning an authorization

Introduction
When you allocate an authorization to a user group, all assigned users have this authorization.  

Requirements
● A "Stop runtime" authorization has been created.

● An "Operators" user group has been created.

● The "User groups" work area is open.

Procedure
1. Click on the "Operators" user group in the "Groups" table. The "Authorizations" table shows 

all authorizations.

2. Enable the "Stop runtime" authorization in the "Authorizations" table.
 

  Note

The "Stop runtime" authorization is only a designation and does not have any relation to 
the function "StopRuntime". You have to establish this relation yourself. To do so, 
configure the "StopRuntime" system functions at a button and select "Stop runtime" as 
the "Authorization".

 

Creating users

Introduction
You create a user so that users can log on with their user names in runtime after loading to 
the device.     

As an alternative, you can create and change users by means of the "User view" in Runtime.

In order for a created user to have authorizations you have to assign him to a user group and 
allocate authorizations to the user group.

The logon is successful when the user name entered during the logon matches a user in 
Runtime. In addition, the entered password must agree with the stored password of the user. 

 

 Note

Note that the entry is case-sensitive.
 

Requirements
The "Users" work area is open.
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Procedure
1. Double-click "Add" in the "Users" table.

2. Enter "Foreman" as the user name.
 

  Note

The user name must be unique within the project. Otherwise the input is not accepted.
 

 
 

  Note

Do not use special characters such as / " § $ % ? when you enter a user name and a 
password. ' &.

 

3. Click the  button in the "Password" column. A dialog box for entering the password is 
displayed.

4. Enter the password of the user.

5. To confirm the password enter it a second time in the lower field.

6. Close the dialog box using the  icon.

7. If a user is to be logged off after a specific time period, activate "Automatic logoff".

8. Click in the "Logoff time" column. The preset value for "Logoff time" is 5 minutes.

9. Enter a brief description as the "Comment".

Assigning a user to a user group

Introduction
When you assign a user to a user group, the user has the authorizations of the user group. 

 

 Note

You have to assign a user to exactly one user group. The assignment is checked during the 
consistency check and generation of the project.

 

Requirements
● The user "Foreman" has been created.

● An "Operators" user group has been created.

● The "Users" work area is open.
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Procedure
1. Click on the "Foreman" user in the "Users" table. The "Groups" table shows all user groups.

2. Activate the "Operators" user group in the "Groups" table.

Managing users

Introduction
In the work area, you can administer users and assign them to user groups.   

Requirements
The "Users" work area is open.

Changing the user name
1. In the "Users" table, double-click the field in the "Name" column to change the user name.  

2. Change the user name.

3. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the user name under "Properties > 
Properties > General" in the Inspector window.

Changing the password of the user
1. Click the  button in the "Password" column of the "Users" table. A dialog for entering the 

password opens.  

2. In the "Enter password" field, enter the new password.

3. Reenter the new password in the "Confirm password" field.

4. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the password under "Properties > 
Properties > General" in the Inspector window.

Displaying invisible columns
1. Position the mouse cursor on the title of the "Users" table.

2. Right-click to open the shortcut menu and enable the display of the "Logoff time" column, 
for example.

Visualize processes
10.7 Configuring user administration

WinCC Professional V13.0
4390 System Manual, 02/2014



Changing the logoff time of the user
1. In the "Users" area, double-click on the field in the "Logoff time" column to change the logoff 

time.

2. Change the logoff time.

3. Confirm your entry with <Return>.

Alternatively, select the user in the work area. Change the logoff time under "Properties > 
Properties > Automatic logoff" in the Inspector window.  

Deleting a user
1. Select the line of the user to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined users cannot be deleted. 
 

Managing user groups

Introduction
In the workplace you administer user groups and assign authorizations for use in runtime.     

Requirements
The "User groups" work area is open.

Changing the name of the user group
1. In the "Groups" table, double-click the field in the "Name" column to change the name of 

the user group.  

2. Change the name of the user group.

3. Confirm your entry with <Return>.

Alternatively, select the user group in the work area. Change the name under "Properties > 
Properties > General" in the Inspector window.

 

 Note

Predefined user groups cannot be deleted.
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Displaying invisible columns
1. Position the mouse cursor on the title of the "Users" table.

2. Right-click to open the shortcut menu and enable the display of the "Display name" column, 
for example.

Changing the displayed name of the user group
1. In the "Groups" table, double-click the field in the "Display name" column to change the 

display name of the user group.  

2. Change the displayed name of the user group.

3. Confirm your entry with <Return>.

Alternatively, select the user group in the work area. Change the display name under 
"Properties > Properties > General" in the Inspector window.

Deleting a user group
1. Mark the line of the user group to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined user groups cannot be deleted.
 

Changing the name of the authorization
1. In the "Authorizations" table, double-click the field in the "Name" column to change the 

name of the authorization.  

2. Change the name of the authorization.

3. Confirm your entry with <Return>.

Alternatively, select the authorization in the work area. Change the name under "Properties > 
Properties > General" in the Inspector window.

Deleting authorizations
1. Mark the line of the authorization to be deleted.  

2. Open the shortcut menu with the right mouse button and select the "Delete" command.
 

  Note

Predefined authorizations cannot be deleted. 
 

See also
Creating an authorization (Page 4385)
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Changing the number of the user group

Introduction
To assign group-specific rights, edit the number of a user group.

Requirements
● In the "Runtime settings> User administration" editor, "Group-specific rights for user 

administration" is selected.

● The "Operator" user group has been created.

● A "User administration" authorization has been assigned.

● The "User groups" work area is open.

Procedure
1. Click on the "Operator" user group in the "Groups" table.

2. Enter "6" in the "Number" column of the user group.

3. Enable the "User administration" authorization in the "Authorizations" table.

Result
The members of the "Operator" user group can only manage users whose group number is 
less than or equal to 6. 

See also
Creating an authorization (Page 4385)

Logging on users dynamically

Introduction
Two configuration steps are required to allow "Dynamic logon":      

1. Assign an HMI device to a configured variable.

2. Assign a specific variable value to a user.
 

  Note

If you have activated SIMATIC Logon, dynamic logon is not possible.
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Requirements
● User administration exists.

● A "Login" variable of the "Byte" type is created.

Procedure
Assignment of the HMI device to the variable

1. Double-click "Runtime settings > User administration" in the project window.

2. Double-click "Add" in the "Dynamic logon" area of the table.

3. Click the  button in the "HMI device" column. A dialog box for selecting the HMI device 
opens.

4. Select an HMI device.

5. Click the  button in the "Variable" column. A dialog box for selecting the variable opens.

6. Select the "Login" variable.

Assignment of the user to the variable value

1. Open the "Users" work area.

2. Position the mouse cursor on the title of the "Users" table.

3. Open the shortcut menu with the right mouse button and activate the display of the 
"Dynamic logon" and "User identification" columns.

4. Double-click "Add" in the "Users" table.

5. Enter "Smith" as the user name.

6. Click the  button in the "Password" column. A dialog box for entering the password is 
displayed.

7. Enter the password of the user.

8. To confirm the password enter it a second time in the lower field.

9. Close the dialog box by using the  icon.

10.Activate the "Dynamic logon" column.

Result
When the variable equals 1, the user "Smith" will be logged on.

 

 Note

The used variable must be of the type "binary" or 8, 16 or 32 bit.
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10.7.4.3 Managing users on the server

Central user administration using SIMATIC Logon

Introduction
To manage users and user groups for several applications or HMI devices, activate SIMATIC 
Logon.      

Principle
SIMATIC Logon is a tool for system-wide user administration. If you use SIMATIC Logon, the 
users are centrally managed outside the application or HMI device. 

You configure the user groups and their permissions as you usually do with the local user 
administration in WinCC. You assign identical names to the user groups on the server and in 
WinCC. Authorizations are assigned in runtime to a user group when the names are identical. 

You do not have to create users in WinCC because they are taken dynamically from Windows 
user management during the logon process. The application or HMI device forwards each 
logon or password change to SIMATIC Logon for processing.

 

 Note

SIMATIC Logon is a product requiring a license. For more information on SIMATIC Logon 
go to <http://support.automation.siemens.com>.

Enter the ID "34519648" in the search field and start searching. The "SIMATIC Logon - 
Electronic Signature" manual is available to download.
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Log on process via SIMATIC Logon Service
The following diagram illustrates the process that runs automatically when a user logs onto 
Runtime.

The application opens the logon dialog box

1. Query: Login and password

The user enters the logon data in the logon dialog box:

<Login>

<Password>

Logon

dialog box

2. Transfer: Logon data

Logon data is verified

3. Query: Does Windows recognize the user?

Logon data is verified

on the local computer or in the domain

4. User authentication in progress 

SIMATIC

Logon

Service

Determining user data:

Operating 

system

User and group 

administration

Transfer of user data:

6. Transfer: full user name,

  group membership,

  password age 

5. Query: Which user data

   is known?

Verifying and transferring user data:

7. Transfer:  full user name,

  group membership

8. Determining roles

9. Setting rights in accordance with role

Results: The user can implement the role functions.

Applications 

which use 

SIMATIC Logon 

functions

See also
Settings for the user administration (Page 4381)

Making settings on the server 

Introduction
Perform the following steps on your sever to ensure correct operation of SIMATIC Logon.
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Procedure
1. Install SIMATIC Logon Services.

2. Create the user group in the user administration of the operating system.

3. Create the users in the user administration of the operating system.
 

  Note

Users of SIMATIC Logon must be members of a user group of the operating system. 
Members of a subgroup cannot be logged on.

 

4. Assign the new users to a group.

5. Transfer the licenses for each HMI device on the server.
 

 Note

You can find more detailed information in the documentation supplied with SIMATIC Logon.
 

 Note

The password policies stored on the server are valid if users are authorized by means of 
SIMATIC Logon.

 

 Note

You can configure the logoff time of the SIMATIC Logon user with "Configure SIMATIC 
Logon" on the server.

 

Logging on using SIMATIC Logon

Requirements
● User administration exists.

● The groups created in WinCC agree with the Windows groups on the server.

● There is a server with SIMATIC Logon Service installed.
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 Note

A user may only be a member of one user group in WinCC. When a user is a member of 
several user groups on the server, only one of these user groups can be made known in 
WinCC.

"Administrators" and "Users" are predefined groups in both Windows and WinCC. Any new 
user created in Windows is automatically a member of the "Users" group. A user will be a 
member of two groups if assigned to a new group, for example, to the "SL user" group.

Remove this user from the "Users" group of the operating system to enable logon of this user 
using SIMATIC Logon. 

A system message in runtime always confirms the successful logon of a user on the server.
 

 
 

 Note

When you use SIMATIC Logon to manage access to a panel or a device with WinCC Runtime 
Advanced, you must note that the characters '/' and '\' cannot be used in the names of 
Windows user groups or Windows users.

 

Procedure
1. Open the "Runtime settings > User administration" editor in the Project window.

2. Select "Enable SIMATIC Logon".

3. Select "Windows domain" or "Windows computer", depending on where you administer 
your users.

4. Enter the name or IP address of the SIMATIC Logon server in the "Server name" text box.
 

  Note

Make sure your SIMATIC Logon Server always has the same IP address if you use IP 
addresses. 

 

5. Enter the port number for TCP/IP communication in the "Port number" text box. The valid 
range of values lies between 1024 and 49151. The preset port number is "16389" and used 
by SIMATIC Logon as the default.
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6. Enter the Windows domain or the logon server with the user data in the "Windows domain" 
text box.
Enter the name of the sever to access users on the logon server.
Enter the name of the domain if the logon sever is in a domain and you wish to access 
users of the domain. 

 

  Note

Local Windows users are not accepted when the logon server is in a domain.
 

7. Activate the "Encrypted transfer" check box in order to encrypt the data before sending it 
to the server.

Emergency user
If the server cannot be accessed, all local users that were created in WinCC user administration 
can also be used as emergency users.

Emergency users have the rights of the user group to which they were assigned.
 

 Note

For additional information, refer to the included SIMATIC Logon documentation. 

This documentation is available at: [SIMATIC Logon installation directory] \manuals
 

Logging on using SIMATIC Logon

Requirements
● User administration exists.

● The groups created in WinCC agree with the Windows groups on the server.

● There is a server with SIMATIC Logon Service installed.
 

 Note

When a user is a member of several user groups, the user is assigned the sum of 
authorizations for the groups. Logon is possible. 

 

Procedure
1. Double-click the "Runtime settings" in the project window.

2. Double-click the "User administration" in the work area.

3. Activate "SIMATIC Logon."
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10.7.4.4 Administering users for Web Client

Administering user groups for Web Client

Introduction
For each user group to be administered for web clients, you must configure the following: 

● A start screen of your choice enabled for web access

● A language of your choice

This allows you to make various sections of a project immediately accessible or inaccessible 
for users.

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
● The "User groups" work area is open.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Procedure
1. Position the mouse cursor on the title bar of the "Groups" table.

2. Open the shortcut menu by right-clicking and activate the display of the "Web start screen" 
and "Web language" columns.

3. Double-click "Add..." in the "Groups" table.

4. Enter "Web operators" as the name of the user group.

5. Click the  button in the "Web start screen" column. A dialog box for selecting the start 
screen opens.

6. Select a start screen for Runtime.

7. Close the dialog box by using the  icon.

8. Click the  button in the "Web language" column. A dialog box for selecting the language 
opens.

9. Select the runtime language.
As an alternative, select the user group in the work area; the properties of the user group 
are then displayed in the Inspector window. 
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10.In the Inspector window, select "Properties > Properties > Web options". 

11.Select the start screen and the language.
 

  Note

The name of the user group is language-dependent. You can specify the name in several 
languages and switch between languages in runtime. 

 

 

Managing users for the Web client 

Introduction
For each user to be logged onto the web client, you must configure the following: 

● A start screen of your choice enabled for web access

● A language of your choice

This allows you to make various sections of a project immediately accessible or inaccessible 
for users.

Requirements
● The "Users" work area is open.

● The user "Foreman" has been created.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Setting the start screen and language
1. Position the mouse cursor on the title of the "Users" table.

2. Open the shortcut menu by right-clicking and activate the display of the "Web start screen" 
and "Web language" columns.

3. Click the  button in the "Master" user row in the "Start screen" column. A dialog box for 
selecting the start screen opens.

4. Select the "Start" screen.

5. Close the dialog box by using the  icon.

6. Click the  button in the "Web language" column. A dialog box for selecting the language 
opens.

7. Select the desired language as the runtime language of the web user.
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As an alternative, select the user in the work area; the properties of the user are then displayed 
in the Inspector window. In the Inspector window, select "Properties > Properties > Web 
options". Select the start screen and the language.

 

 Note

The language setting is retained when a user is moved from one group to another one. The 
start screen will be overwritten.

 

10.7.4.5 Administering users in Runtime

Users in runtime 

Principle
You create users and user groups and assign authorizations to them. You configure objects 
with authorizations. After download to the HMI device, all objects which were configured with 
an authorization are protected against unauthorized access in Runtime.

User view
When you configure a user view in the Engineering System, you administer users in this user 
view following download to the HMI device.  

 

 NOTICE

Changes in the user view are effective immediately in Runtime. Changes in runtime are not 
updated in the engineering system. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Users who have a "User administration" authorization have unlimited access to the user view. 
This allows them to administer all users. Any other user has only limited access to the user 
view for self administration.

See also
User view (Page 4403)

Managing users in the complex user view (Page 4406)

Logging on as a user (Page 4410)
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User view

Purpose
You configure a user view in the engineering system to also administer the users in 
Runtime.   

Structure
The user view shows the following in each line:

● The user

● The encrypted password

● The corresponding user group

● The logoff time

If no user is logged on, the user view is empty. The content of the individual fields is displayed 
after logon.

User view of an administrator

When an administrator is logged on, the user view shows all the users. The administrator 
changes the user name and the password. The administrator creates new users and assigns 
them to an existing user group. 

User view of a user
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When no administrator is logged on, the user view shows only the logged-on user. Users can 
change their own passwords and logoff time.

See also
Users in runtime  (Page 4402)

Logging on as a user (Page 4410)

Configuring a user view

Introduction
You configure a user view in the Engineering System to also administer users in Runtime.  

Requirements
A screen has been created.

Procedure
1. Select the "User view" object from the "Controls" category in the toolbox.

2. Drag-and-drop the "User view" object into the screen.

3. Click on "Properties > Properties" in the Inspector window.

4. Specify the appearance of the "User view".

5. You can, for example, select " "Display mode > Fit to size > Fit object to contents".

Result
You have created a user view in the screen.

See also
Logging on as a user (Page 4410)

Creating users

Introduction
You create a user so that users can log on under their user name in runtime.     

As an alternative, you can create users in the engineering system and download them to the 
HMI device.
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The logon is successful only when the user name entered during the logon matches a user in 
runtime. In addition, the password entered at logon has to match that of the user.

 

 Note

Note that the entry is case-sensitive. 
 

 
 

 Note

Do not use special characters such as / " § $ % ? when you enter a user name and a password. 
' &.

 

You assign the user to a user group. The user then has the authorizations of the user group.
 

 Note

Runtime users must be assigned to a user group. The user group is created in the engineering 
system. The designation of the user group is language-dependent.

 

Requirements
● The user view is open.

● A "Group 2" user group has been created.

Procedure
1. Click "<New User>" in the user view. A dialog opens.

2. Enter "Foreman" as the user name.

3. Press the <Return> button.

4. Click "Password."

5. Enter the password of the user.

6. Press the <Return> button. The password is hidden.

7. Click in the "Group" column.
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8. Select "Group 2" as the "Group".

9. Press the <Return> button.

10.Click in the "Logoff time" column.

11.Enter the time after which the user is logged off automatically.

See also
Logging on as a user (Page 4410)

Managing users in the complex user view

Introduction
If you have configured a user view in the engineering system, the users and user groups can 
be managed in runtime.   

 

 NOTICE

Changes in the user view are effective immediately in runtime. Changes in runtime are not 
updated in the engineering system. When downloading the user administration to the HMI 
device, all changes in the user view are overwritten after a security prompt and based on the 
settings.

 

Requirements
● Runtime is enabled.

● A complex user view has been created.
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● The screen with the user view is open.

● You have the default "User administration" authorization.
 

  Note

If you do not have a "User administration" authorization, you can only change your own 
password and your logoff time.

 

Changing the user name
1. Enter a new user name in the "Users" column in the user display.

2. Confirm your entry with <Return>.  
 

  Note

The user can then no longer log on with his previous password in runtime. If you delete 
the name and press <Return>, the user is deleted.

 

Changing the password of the user
Availability of complex user display in selected devices only.

1. Enter a new password in the "Password" column in the user display.

2. Confirm your entry with <Return>.
 

  Note

The user can then no longer log on with his previous password in runtime.

If you delete the password in the complex user view and press <Return>, the user will be 
deleted. 

 

Changing the logoff time of the user
1. Enter a new logoff time in the "Logoff time" column in the user display.

2. Confirm your entry with <Return>.  

Deleting a user
1. Click the name of the user to be deleted. 

2. Delete the name.

3. Press the <Return> button.
 

  Note

The user can no longer log on in runtime.
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Assigning a user to a different user group
1. Activate the user group field for the corresponding user.  

2. Select a user group.

3. Confirm your selection with <Return>.

See also
Users in runtime  (Page 4402)

Logging on as a user (Page 4410)

Unlock locked out users

Unlock locked out users
The check box "Activate limit for login attempts" is activated in the "Runtime settings > User 
administration". 
The number 3 is entered in the field "Number of invalid login attempts".

If users have three failed attempts at login, e.g. by entering an incorrect password, they are 
assigned to the "Unauthorized" group. The user loses all authorizations. The user can still log 
on, but no longer has any authorizations. Only a user with administrator rights re-assigns the 
unauthorized user to a user group.   

See also
Logging on as a user (Page 4410)

Logging on as a user

Introduction
As a rule you log-on as a user by means of a special button. The logon dialog box is displayed 
to this purpose.     

The logon dialog box is displayed by default during access to a protected object if

● No user is logged on in runtime.

● The logged-on user does not have the required authorization.
 

  Note

The system always opens the logon dialog on the OP 73, OP 77A, TP 177A and Basic 
Panels HMI devices when you press an access-protected button:
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Requirements
● Under "Runtime settings > User administration" the

– "Enable limit for logon attempts" check box has been selected.

– The number 3 is entered in the field "Number of incorrect login attempts".

● The "ShowLogonDialog" system function is configured on a button called "Logon".

Procedure
1. Click the "Logon" button. The logon dialog box is displayed.

2. Enter your user name as it was specified in the user administration, for example "Foreman".
If someone has logged on before you, the name of the user will be displayed.

3. Enter the corresponding password. The input is concealed.

4. Click "OK" to close the dialog box.

Logon was successful
If you have entered the user name "Foreman" and the entered password corresponds with the 
stored password, you are logged on as the user "Foreman" in runtime. You have the 
authorizations of the user "Foreman". 

When the user "Foreman" accesses a protected object such as the "Logging" button, access 
to this protected object will only be authorized if the user "Foreman" has the required 
authorization. The programmed function is executed immediately. 

If you do not have the required authorization after the successful log-on, a corresponding error 
message is displayed. However, you remain logged on in runtime.

Logon was unsuccessful
An error message is displayed.   

In order to maintain security, you or the user logged-on before you no longer has any 
authorizations. However, access to unprotected objects remains possible. The user view does 
not, however, show any entries. The user view and the authorizations change after the next 
successful log-on.
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If the third login attempt has failed, the user will be assigned to the "Unauthorized" group. For 
this reason, do not configure a user group with this display name.   

If the "Log off" function is called up or the logoff time of the user has expired, the user is logged 
off. 

See also
Logging on as a user (Page 4410)

Logging on as a user

Introduction
As a rule you log-on as a user by means of a special button. The logon dialog box is displayed 
to this purpose.   

The logon dialog box is displayed by default during access to a protected object if

● No user is logged on in Runtime.

● The logged-on user does not have the required authorization.

Requirements
● The "ShowLogonDialog" system function is configured on a button called "Logon".

Procedure
1. Click the "Logon" button. The logon dialog box is displayed.

2. Enter your user name as it was specified in the user administration, for example "Foreman".
If someone has logged on before you, the name of the user will be displayed.

3. Enter the corresponding password. The input is concealed.

4. Click "OK" to close the dialog box.

Visualize processes
10.7 Configuring user administration

WinCC Professional V13.0
4410 System Manual, 02/2014



Logon was successful
If you have entered the user name "Foreman" and the entered password corresponds with the 
stored password, you are logged on as the user "Foreman" in Runtime. You have the 
authorizations of the user "Foreman". 

When the user "Foreman" accesses a protected object such as the "Logging" button, access 
to this protected object will only be authorized if the user "Foreman" has the required 
authorization. The programmed function is executed immediately. 

If you do not have the required authorization after the successful log-on, a corresponding error 
message is displayed. However, you remain logged on in Runtime.

Logon was unsuccessful
An error message is displayed.  

In order to maintain security, you or the user logged-on before you no longer has any 
authorizations. However, access to unprotected objects remains possible. The user view does 
not, however, show any entries. The user view and the authorizations change after the next 
successful log-on.

The user will be logged off if the "Log off" function is called or the user logoff time has expired. 

See also
Users in runtime  (Page 4402)

User view (Page 4403)

Configuring a user view (Page 4404)

Creating users (Page 4404)

Managing users in the complex user view (Page 4406)

Unlock locked out users (Page 4408)

Logging on as a user (Page 4408)

Exporting the user administration (Page 4411)

Importing the user administration (Page 4412)

Exporting the user administration

Introduction
The users and user groups are transferred to the HMI device from the Engineering System. If 
you have configured a user view, you can administer the users at the HMI device via the user 
view.     

If a user has access to several HMI devices, the same user and the same password must be 
configured on each HMI device. Create a standard for user administration of the different HMI 
devices. Export the users and passwords on an HMI device to a storage medium, such as a 
floppy, memory card or a network drive. You import the users and passwords from this storage 
medium at all the other HMI devices.
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You program a function which exports the user data at a button.

The system function "ExportImportUserAdministration" is not available on all HMI devices.
 

 NOTICE

When exporting, the user data are encrypted and written from the HMI device to the target 
file. The target file is overwritten

 

Requirements
● An HMI device has been created.

● A screen has been created.

● A button has been created in the screen.

● The Inspector window is open.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Click" in the Inspector window.

3. Click the entry "Add function" in the function list.

4. Select the "ExportImportUserAdministration" system function.

5. Select "Export" as the "Direction". When exporting, the target file is overwritten with the 
user data.

6. Enter the full path of the destination file as the "File name", for example "a:\test
\usersview.txt".

 

  Note

Ensure that the file name is written correctly. If the directory, for example "\test\", does not 
exist, it will be created without a prompt. 

 

See also
Logging on as a user (Page 4410)

Importing the user administration

Introduction
If a user has access to several HMI devices, the same user and the same password must be 
configured on each HMI device. Create a standard for user administration of the different HMI 
devices. Export the users and passwords on an HMI device to a storage medium, such as a 
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floppy, memory card or a network drive. You import the users and passwords from this storage 
medium at all the other HMI devices.     

You configure a function which imports the user data at a command button.

The system function "ExportImportUserAdministration" is not available on all HMI devices.
 

 NOTICE

When importing, the user data are read in from the source file and written into the HMI device. 
The users and passwords currently valid in the HMI device are overwritten. The imported 
users and passwords are valid immediately.

 

Requirements
● A screen has been created.

● A command button has been created in the screen.

● The Inspector window is open.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Click" in the Inspector window.

3. Click the entry "Add function" in the function list.

4. Select the "ExportImportUserAdministration" system function.

5. Select "Import" as the "Direction." When importing, the user data in the HMI device are 
overwritten.

6. Enter the full path of the source file as the "File name", for example "a:\test\usersview.txt".
 

  Note

Ensure that the file name is written correctly. If the folder, for example "\test\", or the file 
does not exist, an error message will be displayed. 

 

See also
Logging on as a user (Page 4410)
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10.7.4.6 Configuring access protection

Access protection

Introduction
You configure an authorization at an object in order to protect it against access. All logged-on 
users who have this authorization can then access the object. If a user does not have 
authorization to operate an object, the logon dialog is displayed automatically.

 

 Note

Several system functions are available under "User administration" so that user, password, 
and user group can be edited, for example, in the PLC. 

 

Configuring operating authorizations

Introduction
You configure the "Stop runtime" authorization on a button. Then only those users who have 
the appropriate authorization have access to this button, for example all the users of the 
"Operators" user group.     

This ensures that access to the command button is protected. If a logged-on user who belongs 
to the "Operators" user group and has the required authorizations clicks the button, runtime is 
stopped. 

An example describes in detail how to configure a command button with access protection.

Requirements
● The "Operators" user group has been created.

● The "Stop runtime" authorization has been created.

● A screen has been created and opened.

● The screen contains a button.

Procedure
1. Click the button in the screen.

2. Click "Properties > Properties > Security" in the Inspector window.

3. Select "Stop runtime" as the "Authorization".

Visualize processes
10.7 Configuring user administration

WinCC Professional V13.0
4414 System Manual, 02/2014



4. In the Inspector window, select "Properties > Events > Click".

5. Select a system function from the function list, for example, "StopRuntime".
 

  Note

The "Enable" and "Disable" events are only used to detect whether an object was selected 
or deselected. The events do not, however, trigger a password prompt.

Do not use the "Enable"or "Disable" event if you want to configure access protection at 
the function call of the object.

 

 

10.7.5 Reference

10.7.5.1 Objects with access protection

Introduction
The following objects can be configured with an authorization:     

● Date/time field

● I/O field

● Graphic I/O field

● Recipe view

● Switch

● Button

● Symbolic I/O field

● System diagnostic view

10.7.5.2 Objects with access protection

Introduction
The following objects can be configured with an authorization:     

● Date/time field

● I/O field

● f(x) trend view

● Graphic I/O field

● HTML Browser

● Alarm view
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● Alarm window

● Recipe view

● Switch

● Button

● Slider

● Symbol library

● Symbolic I/O field

● System diagnostic view

● System diagnostic window

10.7.5.3 Objects with access protection

Introduction
The following objects can be configured with an authorization:   

● Bar

● Scroll bar

● Double T piece

● I/O field

● f(t) trend view

● f(x) Trend View

● Graphic I/O field

● Combo box

● Check box

● List box

● Editable text field

● Alarm window

● Option button

● Pipe

● Pipe bends

● Round button

● Button

● Symbolic I/O field

● T piece

● Connector
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In order to configure the following objects with access control, you additionally link the system 
function "ShowLogonDialog" to an event, for example, Click.

 

● Line

● Polyline

● Polygon

● Ellipse

● Ellipse segment

● Ellipse arc

● Circle segment

● Circle

● Circular arc

● Rectangle

● Text field

● Graphic view

10.7.5.4 Default user groups and authorizations 

Principle
The predefined user groups and authorizations have the following numbers:

User group Number
"Administrator group" 1
"Users" 2

Authorization Number
"User administration" 1
"Monitor" 2
"Operate" 3

10.7.5.5 Default user groups and authorizations

Principle
The predefined user groups and authorizations have the following numbers:

User group:
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● "Administrator group"

● "Users"

Authorization Number
"User administration" 1
"Monitor" 2
"Operate" 3
"Enable remote control" 1000
"Web access - view only" 1002

 

Authorization 1000, "Enable remote control", is practical for client-server projects. 

Authorization 1002, "Web access - view only", is important for the Web Navigator.

10.7.6 Examples

10.7.6.1 Example: Configuring a button with logon dialog box

Task
In the following example, you configure the function "ShowLogonDialog" for a button. A 
different user can then log on in runtime when the shift changes, for example. In the process 
the user previously logged on is logged off.    

 

 Note

In runtime the logon dialog box is not displayed by default until you access a protected object. 
Either no user is logged on or the logged-on user does not have the required authorization.

 

Requirements
● A screen has been created.

● A button has been created in the screen.

Procedure
1. Click the button in the screen.

2. Click "Properties > Events > Release" in the Inspector window.
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3. Click the entry "Add function" in the "Function list" table.

4. Select the system function "ShowLogonDialog" from the "User administration" group.

Result
If the user clicks on the button in runtime, the function "ShowLogonDialog" is called up. When 
the function "ShowLogonDialog" is called up, the logon dialog box is displayed. The user logs 
on with his user name and password. 

10.7.6.2 Example: Logging the logon and logoff events

Task
In the following example, you configure the function "TraceUserChange" to the event "User 
change".   

Principle
The "TraceUserChange" function is called when a user logs on or off. When a function is called 
up, a system message with information about the corresponding user is output. 

This system message can be archived. When archiving, the system message is provided with 
a date stamp and time stamp. This ensures that you can track which user was logged on at 
the HMI device at which time and for how long.
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Requirements
● You have created an HMI device with Runtime Advanced.

● The Inspector window is open.

Procedure
1. Double-click the "Scheduler" in the Project view.

2. Double-click "Add" in the table of the tasks.

3. Enter "Logon-Protocol" as the "Name".

4. Select "User change" as the "Trigger".

5. Open "Properties > Events" in the Inspector window.

6. Click the entry "Add function" in the "Function list" table.

7. Select the "TraceUserChange" system function.

Result
A system message is output when a user logs on or logs off. 

10.7.6.3 Example of a user administration

Example: Structure of user administration

Task
In the following example you set up a user administration for different users and user groups. 
The example orientates itself to a typical requirement profile from manufacturing engineering.  

Principle
Completely different groups of persons are involved in a plant or project. Each group of persons 
protects its respective data and functions against access by others. For this purpose, users 
are created and assigned to a user group. 

You can reproduce different views through user groups. 

Example:

● Organizational view: Commissioners, Operators, Shift I, Shift II

● Technological view: Axis control, Tool changers, Plant North, Plant South

The following example orientates itself to the organizational view.

Every user group has characteristic requirements regarding access protection: A user group 
has operating authorizations for specific application cases. A programmer changes, for 
example, recipe data records. 
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In the example the users Miller, Group Smith and Foreman are created and assigned to 
different user groups.

Ms. Miller works as a programmer in the engineering system. The Group Smith are 
commissioners. Mr. Foreman is an operator.

Requirements
● A new project has been created.

● The "User administration" editor is open.

Procedures overview
Working with user administration has the following procedure in the example:

1. Creating authorizations The planner specifies which authorizations are required for access 
protection.

2. Configuring authorizations: The planner specifies which objects may be operated and which 
functions may be executed.

3. Creating user groups and allocating authorizations: The administrator creates the user 
groups together with the planner. The planner uses the authorizations to specify who may 
operate objects and change parameters.

4. Creating users and assigning them to a user group: The administrator administers the users.

Result
The aim is the following structure of the user administration of users, user groups and 
authorizations:

Users User groups Authorizations
Miller Smith Foreman Roles Changing 

recipe 
records

Changing 
system 
parameters

Changing 
process 
parameters

Managing

   Administrator group    x
X   Programmer X    
 X  Commissioning 

engineers
X X X  

  X Operators x    

The user "Foreman" who belongs to the "Operators" user group has access to the configured 
"To Recipe view" button.

 

 Note

Alternatively, you can create several users as operators with different operating 
authorizations, for example, Operator Level 1, Operator Level 2. 
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Example: Creating and configuring authorizations

Task
The following example shows you how to create the authorizations  

Procedure
1. Open the "User groups" work area.

2. Double-click "Add" in the "Authorizations" table.

3. Enter "Change recipe data records" as the "Name" of the authorization.

4. Repeat steps 2 and 3 to create additional authorizations: "Change system parameters", 
"Change process parameters".

Result

Example: Configuring a button with access protection

Task
In the following example you use a system function to create a button for a screen change. 
You protect the "To Recipe view" button against unauthorized operation. To do so, you 
configure the "Change recipe data records" authorization at the "To Recipe view" button.       
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Requirements
● A "Change recipe data records" authorization has been created.

● A "Recipes" screen has been created.

● A "Start" screen has been created and opened.

● A button has been created and marked in the "Start" screen.

Procedure
1. Click "Properties > Properties > General" in the Inspector window.

2. Enter "To Recipe view" as the text.

3. Click "Properties > Events > Click" in the Inspector window.

4. Click the "Add function" entry in the first line of the "Function list" table.

5. Select the "ActivateScreen" system function in the "Screens" group.

6. Click the  button in the "Screen name" field. A dialog box for selecting the screen opens.

7. Select the "Recipes" screen and use the  button to close the dialog box.

8. Click "Properties > Properties > Security" in the Inspector window.

9. Select "Change recipe data records" as the "Authorization."

Result

Access to the "To Recipe view" button is protected. If, for example, the user "Smith" clicks the 
button in Runtime, the function "Recipe view" screen is called up. Prerequisite is that the user 
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"Smith" has logged on correctly and has the required authorization. The "Recipes" screen 
contains a recipe view and other screen objects. 

If the logged-on user does not have the required authorization or if no user is logged on, the 
"Logon dialog box" is displayed. 

Example: Creating user groups and assigning authorizations:

Task
In the following example you create the user groups and assign authorizations to them.       

Procedure
1. Open the "User groups" work area.

2. Double-click "Add" in the "Groups" table.

3. Enter "Programmer" as the "Name".

4. Repeat steps 2 and 3 to create the "Commissioner" and "Operator" user groups.

5. Click "Administrator" in the "Groups" table.

6. Activate the "Change system parameters" authorization in the "Authorizations" table.

Interim result
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Procedure
1. Click "Operator" in the "Groups" table.

2. Activate the "Change recipe data records" authorization in the "Authorizations" table.

3. Click "Commissioner" in the "Groups" table.

4. Activate the authorizations "Change recipe data records", "Change system parameters" 
and "Change process parameters" in the "Authorizations" table.

5. Click "Programmer" in the "Groups" table.

6. Activate the "Change recipe data records" authorization in the "Authorizations" table.

Result

Example: Creating users and assigning them to a user group

Task
In the following example you create the users and assign user groups to them. The users are 
sorted alphabetically immediately after the name has been entered.    

Procedure
1. Open the "Users" work area.

2. Double-click "Add" in the "Users" table.
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3. Enter "Miller" as the user name.

4. Click the  button in the "Password" column. The dialog box for entering the password is 
displayed.

5. Enter "miller" as the password.

6. To confirm the password enter it a second time in the lower field.

7. Close the dialog box by using the  icon.

8. Activate the "Programmer" user group in the "Groups" table.

Interim result

Procedure
1. Double-click "Add" in the "Users" table.

2. Enter "Smith" as the user name.

3. Click the  button in the "Password" column. The dialog box for entering the password is 
displayed.

4. Enter "smith" as the password.

5. To confirm the password enter it a second time in the lower field.

6. Close the dialog box by using the  icon.

7. Activate the "Commissioner" user group in the "Groups" table.

8. Repeat steps 2 to 6 for the user "Foreman."

9. Activate the "Operators" user group in the "Groups" table.
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Result

10.8 Working with system functions and Runtime scripting

10.8.1 Principles

10.8.1.1 Runtime scripting

Term definition            
The following terms are used in the documentation:

Term  
Runtime scripting Generic term for all activities in user-defined functions and local scripts.
Function Generic term for system functions and user-defined functions.
System functions System functions are all functions supplied with WinCC. The system functions 

are used either in function lists, user-defined functions or local scripts.
User-defined functions User-defined functions are functions written in the "Scripts" editor. For more 

precise specification, the term "User-defined VB function" and "User-defined 
C function" is used in the documentation.
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Term  
Local script A local script is created directly at the point of use, e.g. an object property, 

and has a cyclic or acyclic trigger. For more precise specification, the terms 
"local VB script" and "local C script" are used in the documentation.

VBS/VBScript Abbreviation for Visual Basic Script

Availability

 WinCC RT Advanced and Panels WinCC RT Professional
Customized VB functions X X
Customized C functions -- X
Local VB scripts -- X
Local C scripts -- X

Applying Runtime scripting
The following figure serves as a decision guide for programming tasks at hand:

* Local scripts are not supported in WinCC RT Advanced and Panels.
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Customized function or local script?
Whether you accomplish your programming task with a user-defined function or a local script 
depends on the application purpose and ultimately on the number of user-defined functions 
or local scripts. 

Use local scripts for background activities, e.g. for daily printing or logs, for the monitoring of 
tags or for the execution of calculations. 

Use customized functions to make codes available in several places in your project but only 
create them once. Instead of entering the code several times, you just call the appropriate 
customized function. Your code is clearer and easier to maintain. 

Instruction 1

Instruction 4

Instruction 1

Instruction 2

Instruction 4

Instruction 1

Instruction 2

Instruction 4

Instruction 1

Instruction 2

Instruction 4

Instruction 3 Instruction 3 Instruction 3

Instruction 3

See also
User-defined functions (Page 4432)

Local scripts (Page 4433)
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10.8.1.2 System functions

Applications
● Function lists

When the event occurs, the configured system functions can be performed with the function 
list.       

● User-defined functions
If the HMI device supports user-defined functions, you use system functions in combination 
with instructions and conditions in the code of the user-defined unction. In this way you 
execute a customized function depending on a specific system state. In addition, you can 
evaluate return values of system functions, for example. Depending on the return value, 
you then perform test functions, for example, that in turn affect the function flow.

Application examples of system functions
● Calculations, increase tag value by a defined or variable amount.

● Log function, e.g. to start a process value log.

● Settings, e.g. to switch the PLC or set a bit in the PLC.

● Alarms, e.g after a different user logs on.
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Application
You use system functions in a function list or in a user-defined function. 

● Function list
When configuring a function list, you select the system functions from a selection list that 
is sorted by categories:   

● User-defined functions
If you are using a system function in a user-defined function, you choose it from a selection 
list. To open the selection list, use the key shortcut <Ctrl+Space> or click .

Language dependency
In the function list, the names of the system functions are dependent on the set project 
language. The functionality can then be recognized immediately by the project planner. 

You use the English name of the system function in user-defined functions. You will find the 
English name of the system function in the reference.   

Availability for WinCC Runtime Advanced and Panels
Which system functions are available depends on the selected HMI device.
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HMI device changeover
If you use system functions in a function list that are not available on the set HMI device, these 
system functions are marked in color.

If you use a system function in a user-defined function which is not available on the set HMI 
device, a warning is issued. In addition, the respective system function will be underlined with 
a wavy blue line. 

See also
System functions for logs (Page 3769)

10.8.1.3 User-defined functions

Applications  
You use customized functions for the following for example:

● Configuring a function list
In a customized function you have the option to have customized functions and system 
functions executed depending on conditions or executed repeatedly. You then add the user-
defined function to a function list, for example. 

● Programming new functions
Customized functions are only valid in the project in which they are defined. For user-
defined functions you define transfer parameters and return values, for example, for 
conversion of values. 

 

 Note

You can only use user-defined functions of a programming language in a function list. Your 
selection of the first user-defined function determines whether VB functions or C functions 
can be selected in the function list.

 

Application examples of customized functions
● Convert values

You use functions to convert values between different measurement units, e.g., 
temperatures.

● Evaluating tag values statistically

● Drawing a trend in a f(t) trend view

Properties of customized functions
A customized function has the following properties:

● Name

● Parameter (optional)
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● Return value and type (optional)

● Can be modified centrally

● has no trigger. You have to call the user-defined function explicitly, e.g. in a function list.

Organization of customized functions
You create customized functions with the "Scripts" editor. See ""Scripts" editor (Page 4440)" 
for additional information.

Customized functions are saved in the project. To protect user-defined functions, set up know-
how protection. See Setting up know-how protection (Page 4449) for additional information.

● Project tree
The user-defined functions are listed in the project tree under "VB scripts" or "C scripts".

● Function list
The user-defined functions are listed in a function list under "VB functions" or "C functions".

● User-defined function
If you are using a system function in a user-defined function, you choose it from a selection 
list. To open the selection list, use the key shortcut <Ctrl+Space> or click .

See also
Runtime scripting (Page 4427)

10.8.1.4 Local scripts

Applications
You can use local scripts for the following:

● Dynamizing objects
You use a local script to determine the value of an object property in Runtime. Use this 
approach, for example, to change the color depending on a tag value. 

● Performing tasks at any point in time.
You use a local script to plan jobs, e.g. daily printout of a log at the end of the shift. 
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Application examples of local scripts
● Configuring desired values for tags for operator control of a graphic object, e.g., in order to 

assign a value for the PLC via a mouse click.

● Configuring the Runtime language switch for operator control of a graphic object.

● Status monitoring of tags, e.g. to ensure that a value is valid.

Properties of local scripts
You create a local script directly at the point of use. A local script has the following properties:

● Predefined name

● Predefined parameters

● Predefined return value (optional)

● Can only be changed at the point of use

● has no trigger

● Calling customized functions, system functions

Triggers
Triggers are necessary to execute local scripts in Runtime. The trigger is either determined 
automatically when creating a local script or specified by the project manager.

The following triggers are supported by WinCC:

● Acyclic trigger, e.g. you plan a single ending of Runtime for maintenance work.

● Cyclic trigger, e.g. you plan a job which starts daily printing of a log.

● Events, e.g. when clicking the button.

The following figure shows different types of triggers:
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Triggers are used in the following editors:

● Scheduler
First you need to configure the trigger in the Scheduler. Then connect the trigger to the 
local script or a function list.

● Screens
To dynamize an object property, first configure a local script in the property list of the screen. 
The trigger is determined automatically when creating the local script. You can change the 
trigger, e.g. to tag trigger. 

See also
Runtime scripting (Page 4427)

10.8.2 Working with Function Lists

10.8.2.1 Basics of the function list

Introduction
A function list performs one or more system functions and user-defined functions when the 
configured event occurs.  
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Principle
The function list is configured for an event of an object, for example, for a screen object or a 
task. You can configure a function list precisely on every event. The events which are available 
depend on the selected object and the HMI device.

Events occur only when the project is in Runtime. Events include:

● Execution of a task

● Pressing of a button

● Acknowledging an alarm
 

  Note

The choice of configurable system functions in a function list is dependent on the selected 
HMI device. For additional information, refer to "Availability for specific devices of system 
functions".

 

See also
Function list (Page 6099)

10.8.2.2 Properties of a function list

Status information
During configuration the project data is tested in the background. 

With the following causes the function list is not executed in Runtime and the incorrect entries 
are marked red:
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● At least one system function or one user-defined function is not completely supplied with 
parameters.

● At least one system function or one user-defined function is contained which is not 
supported by the selected HMI device, e.g. by changing the device type.

Processing of system functions and user-defined functions (WinCC Runtime Advanced and Panels)
A function list is executed from top to bottom in Runtime. If a function list includes system 
functions with longer runtime, these are processed asynchronously. You can find additional 
information about this in the sections "Calling system functions (Page 4442)" and "Calling user-
defined functions (Page 4444)".

10.8.2.3 Configuring a function list

Introduction
You configure a function list by selecting the system functions and customized functions from 
a drop-down list. The system functions are arranged in the selection list according to 
categories. 

You only use customized functions of a programming language in a function list. Your selection 
of the first user-defined function determines whether user-defined VB functions or user-defined 
C functions can be selected in the function list. Which programming languages are available 
depends on the selected HMI device.

If you have created a user-defined VB function, for example, the user-defined function is 
available under the entry "VB functions".   

Requirement
Object has at least one configurable event.

Procedure
Proceed as follows to configure a function list:

1. Open the editor in which the object is located.

2. Select the object.

3. Click "Properties > Events" in the Inspector window. Choose the event for which you want 
to configure the function list.

4. Mark the "<Add function>" entry in the inspector window in the drop-down list.
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5. Select the desired system function or the desired user-defined function from the selection 
list. You can also enter the name of the system function or the user-defined function.

The system function or the customized function is entered in the function list. 

6. If the system function or the customized function has parameters, select the appropriate 
values for the parameters.

7. If you want to add other system functions or user-defined functions to the function list, repeat 
steps 4) to 6).

Result
The function list is configured. In addition, to the configured event, the status of the function 
list is displayed in the Inspector window. When the configured event occurs in Runtime, the 
function list is completed from top to bottom. 
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See also
Example: Changing the operating mode on the HMI device with the current display 
(Page 4504)

10.8.2.4 Editing a function list

Introduction
A function list can be edited as follows:   

● Change the order of system functions and user-defined functions.

● Remove system functions or user-defined functions.

Requirement
The function list is configured and opened.

Changing the order of a system function or a customized function
1. Select the desired system function or customized function in the function list.

2. Then click the appropriate direction arrow in the inspector window until the system function 
or customized function is in the desired position.

Changing the order of several system functions and customized functions
1. Hold down the <Shift> key.

2. Click desired system functions or customized functions one after another with the mouse.

3. Move the selection to the desired position by drag&drop.
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Removing a system function or customized function
1. Select the desired system function or customized function in the function list.

2. Select "Delete" in the shortcut menu.

10.8.3 Working with customized functions

10.8.3.1 "Scripts" editor

Introduction
The "Scripts" editor supports you in the creating of user-defined functions with functionalities 
such as auto-completion and syntax highlighting. You can insert code templates for frequently 
used instructions with the "Instructions" task card for example.

Autocompletion and parameter entry         
The "Scripts" editor provides you context-dependent programming support with 
autocompletion parameter entry support. 

When you use system functions, the parameters of the function are shown as a tooltip. 
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<Ctrl+J>
The object list can be called context-specifically by using the shortcut <Ctrl+J>. Use the object 
list to supply values to system functions, methods, and properties: For example, you select 
screens, screen objects, tags, or colors. You transfer a selected object from the object list into 
the code by double-clicking it. 

 

 Note

Tags and screens can also be inserted using a drag-and-drop operation. Use, for example, 
drag-and-drop to assign values to parameters.

 

<Ctrl+Space>
With the key combination <Ctrl+Space> you call a list with the following contents:

● Constants and functions of the programming language used in the "Scripts" editor.

● User-defined functions

● System functions

"Instructions" task card           
The "Instructions" task card contains the "Code templates" and "Function list" palettes.

● Code templates
To insert frequently used instructions, double click the desired instruction in the "Code 
templates" palette. Replace the space holders with the used expressions.

● Function list
In the function list you select the system functions and user-defined functions from a drop-
down list. Proceed as for configuring a function list. To transfer the function list to the code, 
click the "Transfer" button. The function list is automatically converted into the correct 
syntax. 

 

  Note

Not all system functions are available in the "Scripts" editor. For additional information, 
refer to the reference.

 

Edit functions
Use the buttons of the toolbar "Advanced Edit" to make the code more readable by means of 
indentation and the use of comments.

Bookmarks help you keep an overview, even of many lines of code. 

Further information regarding each button can be obtained in the accompanying direct help. 
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Synchronization of tags and objects         
If you change tag names or object names in the project which you use in a user-defined 
function, the names are adapted automatically in the user-defined function. 

If you change the tag name or object name in the function, the tag names or object names are 
not adapted in the project. An appropriate error message is output when executing the user-
defined function.

Syntax highlighting     
Keywords in the "Scripts" editor are highlighted using different colors. Unknown words are 
underlined with a red wavy line. 

The table shows the preset colors for the most important keywords:

Color Meaning Example
Blue Keyword If, Then
Dark violet Function FahrenheitToCelsius
Chocolate System function SetTag
Orange HMI tag Tag_1
Green Comment 'This is a comment'

Adapting display properties   
When you have opened a user-defined function, you can customize the display properties in 
the editor. Select the "Options > Settings" menu command. Click "General > Text editors" in 
the "Settings" editor. For example, you can change the colors for syntax highlighting or adapt 
the indents for code in the work area. 

See also
Create customized VB functions (Page 4454)

Create customized C functions (Page 4463)

Local scripts (Page 4469)

Editor for local scripts (Page 4471)

10.8.3.2 Calling system functions

Introduction
You can call system functions in a customized function. The syntax depends on the used 
programming language. Which programming language is supported depends on the selected 
HMI device.

You have the following options for calling a system function in a customized function:
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● With <Ctrl+Space> or with 

● Direct input

● With the "Function list" palette

With <Ctrl+Space> or with 
Open the selection list with <Ctrl+Space> and select the desired system function.

Direct input
You enter the system functions directly into the code. You use the English name of the system 
function. You can find the English name of the system function in the system function reference 
under "Syntax". The editing language setting is not taken into consideration. 

References to objects, e.g. screens, connections and logs are transferred in inverted commas:

● Calling system functions without return value in VBS

 
SetTag "Tag1",64

● Calling system functions with return value in VBS

 
InverseLinearScaling "Xvalue","Tag1", 0, 1

● Calling system functions without return value in C

 
SetTag ("Tag1",64);

 

● Calling system functions with return value in C

 
InverseLinearScaling ("Xvalue","Tag1", 0, 1);

With the "Function list" palette
Select the desired system function from a drop-down list in the "Function list" palette. Proceed 
as for configuring a function list. You will find further information about this under "Configuring 
a function list". 

To transfer the list to the code, click the "Transfer" button. The list is automatically converted 
into the correct syntax.
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HMI device replacement (Runtime Panels and Advanced)
The code of a customized function depends on the selected HMI device. If you use system 
functions in the customized function which are not supported by the selected HMI device, you 
receive an error message in the output window.     

See also
Configuring a function list (Page 4437)

Create customized VB functions (Page 4454)

Executing customized VB functions (Page 4456)

Executing customized C functions (Page 4466)

10.8.3.3 Calling customized functions

Introduction
You can insert user-defined functions of the same programming language in a user-defined 
function, e.g. only user-defined C functions in a user-defined C function. 

The syntax depends on the used programming language. Which programming language is 
supported depends on the selected HMI device.

You have the following options for calling a customized function in a customized function:

● With <Ctrl+Space> or with 

● Direct input

● With the "Function list" palette

With <Ctrl+Space> or with 
Open the selection list with <Ctrl+Space> or with  and select the desired user-defined 
function.

Direct input
You enter the customized function directly into the code. References to objects, e.g. screens, 
connections and logs are transferred in inverted commas.

Calling customized functions without return value in VBS    

 
Average 4,10
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Calling customized functions with return value in VBS

 
Dim ValueA
ValueA = Average (4,10)

If you do not want to evaluate the return value, use the call as for a customized function without 
return value.

Calling customized functions without return value in C

 
Average(4,10);

Calling customized functions with return value in C

 
SetTagDouble("AverageValue",Average (4, 10));

If you do not want to evaluate the return value, use the call as for a customized function without 
return value. 

With the "Function list" palette
Select the desired customized function from a drop-down list in the "Function list" palette. 

Proceed as for configuring a function list. See "Configuring a function list (Page 4437)" for 
additional information. 

To transfer the list to the code, click the "Transfer" button. The list is automatically converted 
into the correct syntax.

See also
Create customized VB functions (Page 4454)

Executing customized VB functions (Page 4456)

Executing customized C functions (Page 4466)

10.8.3.4 Access to HMI tags

Introduction
With VBS or C you can access the HMI tags which you have created in the project. Change 
or read the value of an HMI tag with a user-defined function in Runtime. 

You can also create local tags as counters or buffers. Every local tag must be initialized to 
prevent errors by writing local tags incorrectly.       

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4445



HMI tags
● WinCC Runtime Advanced and Panels

The tag value which is created in the tag map is saved in the user-defined function. Next, 
the tag value will be updated to the set cycle time. The customized function first accesses 
the tag values which were read at the previous cycle time.
If the tag name matches the VBS name conventions in the project, you can use the tag in 
the user-defined function as follows.
'VBS_Example_03
 If BeltDriveOilTemperature > 100 Then [instruction]
If the tag name in the project does not match the VBS name conventions, you must 
reference the tag with the "SmartTags" list. In the following example, the tag name contains 
the "&" character, which is not allowed according to the VBS naming conventions.
'VBS_Example_04
SmartTags("Test&Trial")= 2005

● WinCC Runtime Professional
You have the same access possibilities as in the HMI devices with WinCC Runtime 
Advanced and Panels. You can also access the tag values asynchronously. The tag value 
in the PLC is accessed directly in asynchronous access. You access the tag value as follows 
in a local script or a user-defined C function:

– SmartTags list (VBS)

– Tags listing with Read-/Write method (VBS)

– GetTag function (C)

– SetTag function (C)

The tag value is read once from the PLC when the method or user-defined function is called. 
The tag value is not updated regularly, in contrast to when it is read from the tag image. 

Figure 10-4 Synchronous: Tag value directly from the PLC
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Figure 10-5 Asynchronous: Tag value from the tag image
 

 Note
Runtime scripting

The index of the PLC array elements can begin with any number. In WinCC, indexing always 
starts with 0. 

A PLC tag "Array [1..3] of Int", for example, is mapped to "Array [0..2] of Int" in WinCC.

When you access an array in a script, pay attention to the correct indexing.
 

Local tags     
You can only use local tags within user-defined functions or local scripts. 

You use local tags for the following:

● Buffers

● Counters, for example For instruction

Initialize every tag according to the programming language syntax.

Example: Dim objTagFillLevel

Initialize every tag with a value to avoid errors due to empty HMI tags. To use the value of the 
local tag outside, link it with an internal or external HMI tag. 

Access to HMI tags with dynamic names (WinCC Runtime Advanced and Panels)
The user-defined VB function accesses the tag value using the tag name. You can specify the 
tag name in such a way that the tag name is composed during the runtime of the user-defined 
function. 
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If you only call the user-defined VB function in a screen in which the HMI tag is also used 
elsewhere, for example in an I/O field, you should for performance reasons configure the HMI 
tag with "Cyclic in operation" acquisition mode.

If the user-defined VB function is accessed and the HMI tag is not being used in the screen 
currently displayed, configure the HMI tag with "Cyclic continuous" acquisition mode. This 
ensures that the current value of the tag is always available.

10.8.3.5 Testing the syntax of customized functions

Introduction
During programming, the code is tested in the background. Syntactical errors are marked with 
a wavy red line. The customized function is checked for correct syntax and valid object 
references. 

Check the syntax in the "Scripts" editor to identify all the errors in the code and output the 
appropriate error messages. In this case, error messages generated by the script parser are 
output. 

Use a separate debugger to check customized VB functions for logical programming errors.   

Error types
The following error types are detected in the syntax test and output in the "output window":

● Unknown string (e.g., not a keyword)

● Assignment of value to a constant

● The name of a local tag created with the Dim instruction is already known, e.g.: as a 
parameter, object, or component of the object model

● Syntax error

Requirements
● Customized function is open.

Procedure
Proceed as follows to check the syntax:

1. Click  to start the syntax check.
The syntax is checked. The result of the syntax check is displayed in the Inspector window 
under "Info > Compilation." Syntax errors are output with the line number. 

2. Correct the errors in the customized function if necessary.
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Special consideration in the syntax checking of customized functions 
Customized functions are not interpreted until in Runtime. When an HMI device is being 
compiled, the system checks its user-defined functions for correct syntax. However, runtime 
errors may occur in certain circumstances. 

10.8.3.6 Protecting user-defined functions

Setting up know-how protection

Procedure  
To set up know-how protection for user-defined functions, follow these steps:

1. Select the user-defined function without know-how protection that you want to protect.

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Click "Define".
The "Define password" dialog box opens.

4. Enter a password in the "New" field.

5. Enter the same password in the "Confirm" field.

6. Confirm your entries with "OK".

7. Close the "Know-how protection" dialog by clicking on "OK".

Result
The user-defined function receives know-how protection. User-defined functions with know-
how protection are marked with a lock in the project tree. The password entered is valid for all 
user-defined functions selected. 

Opening user-defined functions with know-how protection
You can only open multiple user-defined functions with know-how protection at once if they 
are protected with the same password.

Procedure   
To create a user-defined function with know-how protection, follow these steps:

1. Double-click the user-defined function you want to open.
The "Access protection" dialog will open.

2. Enter the password for the user-defined function with know-how protection.

3. Confirm your entry with "OK".
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Result
The user-defined function with know-how protection will open provided you have entered the 
correct password. However, the function will remain know-how protected. 

Once you have opened the user-defined function, you can edit it for as long as the user-defined 
function or TIA portal is open. You must enter the password again the next time you open the 
user-defined function. If you close the "Access protection" dialog with "Cancel" or "Close", the 
user-defined function is opened but the code is not displayed. You cannot edit the user-defined 
function. 

Removing know-how protection

Procedure  
To remove the know-how protection of a user-defined function, follow these steps:

1. Select the user-defined function for which you want to remove know-how protection.
 

  Note

To remove know-how protection for several user-defined functions at once, all selected 
user-defined functions must have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.

3. Deactivate the check box "Hide code (know-how protection)".

4. Enter the password.

5. Confirm your entries with "OK".

Result
Know-how protection will be disabled for the selected user-defined function. 

Changing a password

Procedure  
To change the password, follow these steps:

1. Select the user-defined function with know-how protection for which you want to change 
the password.

 

  Note

To change the password for several user-defined functions at once, all selected user-
defined functions must have the same password.

 

2. Select the command "Know-how protection" in the "Edit" menu.
The "Know-how protection" dialog will open.
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3. Click the "Change" button.

4. Enter the old password in the "Old" field.

5. Enter the new password in the "New" field.

6. Enter the new password again in the "Confirm" field.

7. Confirm your entries with "OK".

8. Close the "Know-how protection" dialog by clicking on "OK".

10.8.3.7 Creating customized VB functions

Accessing objects with VBS

Introduction
The objects of the VBS object model with the appropriate properties and methods are available 
in user-defined VB functions.

The object properties can be read and changed in Runtime. 

Referencing objects
In customized VB functions you reference the objects by the corresponding list. To identify the 
object, use its name or the position number within the list. 

If you access the properties of an object more often, create an object reference. You can 
access object properties with and without object reference.   

With the following instruction the first object is referenced in the "MainScreen":

 
'VBS_Example_01
Dim objObject
'Change to Screen "MainScreen"
HMIRuntime.BaseScreenName = "MainScreen"
Set objObject = HMIRuntime.Screens(1).ScreenItems(1)

 

With the following instruction an object is referenced by its name and an object property is 
changed. You must have created the object with this name in the screen.

 
'VBS_Example_02
Dim objCircle
HMIRuntime.BaseScreenName = "MainScreen"
Set objCircle = HMIRuntime.Screens(1).ScreenItems("Circle_01")
objCircle.BackColor = vbGreen
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Use of VB tags

Definition of VB tags
VB tags are declared by inserting definition lines in front of the function name of a user-defined 
VB function.
Dim objScreen
Dim objScrItem
The validity range of a VB tag depends on where it was declared.

User-defined VB functions
In the "Scripts" editor, lines 1 and 2 are by default the declaration range. You can add any 
number of lines.

You can use a VB tag defined in this manner in user-defined VB functions. When you check 
the syntax in the "Scripts" editor, you receive a message that the VB tag is not known. 

The VB tag is only known in Runtime. It is created as soon as Runtime is started, even if the 
user-defined VB function itself is not called.

To prevent inconsistencies, the VB tags must be unique within the user-defined VB functions. 

Local VB scripts
The declaration area of a local script belongs to the screen.  All scripts can access the tags 
declared in this area within the screen . Whenever a local script is used to copy a screen object 
to a different screen or to the library, the script but not the declaration area is included with the 
copy.

You can show and hide the declaration range in the editor for local VB scripts. For more 
information, refer to "Editor for local scripts (Page 4471)".

● Local VB scripts with acyclic trigger
Every VB tag defined in this manner is automatically transferred to the declaration range 
of every local script with acyclic trigger. The declaration range remains empty for local 
scripts with cyclic trigger.

● Local VB scripts with cyclic trigger
Every VB tag defined in this manner is automatically transferred to the declaration range 
of every local VB script with cyclic trigger. The declaration range remains empty for local 
scripts with acyclic trigger.
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Example
A local VB script is configured for the property "Background color". The local VB script has a 
cyclic trigger. 

The VB tags a and b are declared in the declaration range.

When you configure a local VB script for the "Changed" event, this VB script has an acyclic 
trigger. The declaration range is empty.

When you configure a local VB script with cyclic trigger for a different property, the VB tags a 
and b are already declared in the declaration range.

See also
Editor for local scripts (Page 4471)
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Create customized VB functions

Introduction
When you create a customized VB function, you define the following settings:    

● The name with which you call the user-defined VB function.

● The type of user-defined VB function.

● The parameters which are transferred to the user-defined VB function in Runtime.

Use only the following characters for the name:

● "A" to "Z"

● "a" to "z"

● "0" to "9"

● "_" as a separator
 

  Note

When you change the parameters or the function type, the change is color marked at the 
application point, e.g. in the function list. 

 

Procedure
To create a user-defined VB function, follow these steps:

1. Open "Scripts" in the project tree.

2. Double click "Add new VB function" in the project tree under "VB scripts".

The user-defined VB function is created as a new tab in the work area. The input mask for 
the configuration settings of the user-defined VB function opens in the Inspector window.

3. Configure the user-defined VB function in the Inspector window "Properties > General > 
General".

4. Enter a descriptive "Name" for the user-defined VB function.
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5. Select the "Type" of the user-defined VB function.

– "Function" have a return value.

– "Sub" have no return value.

6. Click "<Add>" in the "Parameters" list to add parameters. Enter the parameter name and 
specify the parameter type.
Further information can be found in "Transfer and return of values in VBS (Page 4458)".

– "ByVal" transfers the parameter value.

– "ByRef" transfers the address of the parameter.

7. Enter its code in the work area.
You will find further information about this in ""Scripts" Editor" (Page 4440)".

Result
The user-defined VB function has been created. The type, name, and function parameters are 
displayed in the title bar. 

The start and end are inserted automatically when the user-defined function is created.

If you have protected the user-defined VB functions by a password, it is saved encrypted in 
the project. For additional information, refer to "Protecting user-defined functions". 

The figure below shows a user-defined VB function which converts the temperature from 
"Fahrenheit" to "Degrees Celsius":

See also
Calling system functions (Page 4442)

Calling customized functions (Page 4444)
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Renaming customized VB functions

Renaming a user-defined VB function in the project tree   
Proceed as follows to rename a user-defined VB function in the project tree:

1. Select the desired user-defined VB function in the project tree.

2. Select the "Rename" (F2) command in the shortcut menu of the user-defined VB function.

3. Enter a new name for the user-defined VB function.

Renaming a user-defined VB function in the Inspector window
Proceed as follows to rename a user-defined VB function in the Inspector window:

1. Open the user-defined VB function in the "Scripts" editor.

2. In the Inspector window, click "Properties > Properties > General".

3. Enter the new function name.

Result
The user-defined VB function is renamed. The application points are adapted automatically.

Executing customized VB functions

Introduction
In WinCC you have the following options to execute a customized function:

● Function list

● Customized VB function

● Local VB script (only for WinCC Runtime Professional)
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Calling a customized VB function in a function list 
1. Add the user-defined VB function to a function list like a system function.

You will find the customized VB functions in the drop-down list under "VB functions". 
You will find further information about this in "Configuring a function list".

2. If the user-defined VB function has parameters, supply the parameters with static values 
or HMI tags.

3. If the user-defined VB function has a return value, select an HMI tag. The value to be 
processed is transferred to the HMI tag.

 

  Note

You can only use customized functions of the same programming language in a function 
list. You specify the programming language with the selection of the first customized 
function. 

 

Calling a customized VB function in a customized VB function 
1. Open the user-defined VB function in which you want to call the user-defined VB function.

2. Call the customized VB function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined VB function has a return value, assign an expression, such as a local 
tag, to the VB function.

 

  Note

You can only call user-defined functions of the same programming language in a user-
defined VB function. 

 

Calling a customized VB function in a local VB function 
1. The function list is converted into a local VB script.

2. Call the customized VB function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined VB function has a return value, assign an expression, such as a local 
tag, to the VB function.

 

  Note

You can only call user-defined functions of the same programming language in a local VB 
script. 

 

See also
Calling system functions (Page 4442)

Calling customized functions (Page 4444)
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Transfer and return of values in VBS

Transfer of a value
The following options are available for transferring parameters.

● "Call by Value" - ByVal
ByVal transfers the parameter value. If you transfer a tag as a parameter, the tag value is 
transferred to the user-defined function when the user-defined function is executed.

● "Call by Reference" - ByRef
ByRef transfers the address of the parameter. If you transfer a tag as a parameter, the tag 
address is transferred to the user-defined function when the user-defined function is 
executed. 
When user-defined functions and system functions are called in user-defined functions, the 
parameter is transferred as ByRef.

Return of a value
Return values can return the result of a calculation (e.g., average value of two numbers). But 
a return value can also give information about whether an instruction was executed correctly.  

Therefore, the system functions that perform file operations such as "Delete" also have return 
values. 

For a user-defined function to return a value, you must set the "Function" type. You assign the 
function name to the return value in the user-defined function:

To form an average value of two numbers, call the user-defined VB function Average and 
transfer the result to the HMI tag for example AverageValue. 

● In a customized VB function

 
SmartTags("AverageValue") = Average ("4", "10")

● In the function list

You can output the value of the HMI tag AverageValue in an I/O field. 
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See also
Create customized VB functions (Page 4454)

Example: Converting Fahrenheit into degrees Celsius (Page 4500)

Example: Converting inches into meters (Page 4502)

10.8.3.8 Creating user-defined C functions

Accessing objects with C

Introduction
To access the object properties, the following system functions are available:

● "GetProp"
System functions which begin with "GetProp" get a value. You can find additional 
information in C scripting under "GetProp (Page 5912)".

● "SetProp"
System functions which begin with "SetProp" set a value. You can find additional 
information in C scripting under "SetProp (Page 5959)".

There is a separate system function with GetProp and SetProp for every data type. 

Addressing an object property
You can open the object list for assigning parameters with <Ctrl+J> and select the available 
objects and properties from the list. The data types of the transferred parameters are checked 
for plausibility in a syntax validation. 

Writing an object property
The following example shows how a circle is moved to layer "4":

SetPropLong("Screen_1", "Circle_1", "Layer", 4); 

See also
Example of accessing objects in the Screens editor (Page 4524)

SetPropLong (Page 5964)

Creating a C-Header

Introduction
Use the "GlobalDefinitions.h" header file to define functions, tags and constants which you 
need in all local C scripts and customized C functions. In this way local C scripts and 
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customized C functions remain slim and you avoid redundancy. Changes are carried out at a 
central point in the header file.

Customized C functions which you have defined in the project are automatically available. You 
do not need to define these C functions in the "GlobalDefinitions.h". 

C libraries such as "Math" are reference by default.

You can also:

● create additional C header files.

● integrate external C header files.

Creating an additional C header file
1. Double click "Add new header" under "Scripts >C headers" in the project tree".

2. Enter a "Name" for the C header in the Inspector window under 
"Properties >General >General".

3. Insert the required declarations of tags and constants in the work area.

Using the C header file in a C function
1. To use the declarations of the C header file in a C function, insert the C header in the global 

area of the C function. C header is integrated with an #include instruction. C header files 
may not be read in several times, to avoid errors in the tag access. Multiple reading of 
header files is prevented for example by the following structure.
#ifndef _myHeader_h
#define _myHeader_h
#include "myheader.h"
#endif

Include path for external C header files
You must specify the Include path to use external C header files. Proceed as follows:

1. Select the required HMI device.

2. Select the "Options > Settings" menu command.

3. Select the path for the additional C header in the area navigation under "Visualization > 
Runtime Scripting".

4. Close WinCC and start it again.

5. Select the "Compile > Software (compile all)" command in the shortcut menu of the HMI 
device.
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 Note
Copying a project in which an external C header file is used

The path specification for the external header file is not saved in the project and is only valid 
on the computer on which it was set. If you copy this project to another computer, you must 
reassign the Include path for external C header files in the copied project.

 

Use of Global C-Tags

Definition of global C tags 
A global C tag is inserted by adding the definition line in front of the function name of a 
function:           

 
int global_a; //The tag global_a is defined as integer
void myfunction()
{
//insert the code starting here
}

Use of global C tags
You use global C tags in user-defined C functions or local C scripts by declaring the C tags 
within the header file "GlobalDefinitions.h" as external:

GlobalDefinitions.h
extern int global_a

Customized C function

 
// Insert the header starting here
#include "GlobalDefinitions.h"
void myFunction()
{
//insert the code starting here
printf ("C2: %i\r\n", ++ global_a);
}

This tells the compiler that it does not need to create the tag global_a, rather that it will be 
created elsewhere in Runtime.

If the value of the tag global_a is now changed, the changed value is available in all user-
defined C functions and local C scripts.
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You can also declare C tags directly within a function. However, for reasons of clarity and to 
avoid duplicate definitions, we recommend defining global C tags in only one location.

 

 Note

A maximum of 64 Kbytes is available to a user-defined function and the global C tag defined 
with it. 

 

Validity range
All tags in GlobalDefinitions.h declared as external are known to all user-defined C functions 
and local C scripts in Runtime. It is created as soon as Runtime is started, even if the user-
defined function itself was not called.

 

 Note

In WinCC service mode, global C tags cannot be exchanged between user-defined C 
functions in the Scheduler and user-defined functions in the Screens Editor.

If you want to address tags via the WebNavigator, you need to call up the C function via the 
globally declared C tag.

 

Calling functions from DLLs in a user-defined C function

Introduction
You can use functions from DLLs in user-defined C functions. This lets you use the range of 
functions from existing DLLs and avoid redundancy. 

 

 Note
Release and debug DLLs

WinCC is supplied as a Release version and therefore uses the Release versions of system 
DLLs. If you want to use your own DLLs in the Debug version, you can also load the Release 
DLL. Always use the Release version of the DLL when using your own DLLs to avoid a system 
overload. 

 

Requirement
DLL is in the "..\Common Files\Siemens\bin" folder or in a folder which is defined in the PATH 
system tag. This tag is specified by the system properties of the operating system.
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Procedure
Proceed as follows to call functions from DLLs:

1. Open the user-defined C function in which you want to call DLL functions.

2. Add the following code to the beginning of the user-defined C function:

 
#pragma code("<Name>.dll")
//Declare functions stored in DLL:
<Return value> <Function name 1>(...);
<Return value> <Function name 2>(...);
...
<Return value> <Function name n>(...);
#pragma code

Result
The functions <Function name 1> ... <Function name n> from <Name.dll> are declared. You 
can call the functions in the user-defined C function. 

Example
The following example shows how to integrate the "kernel32.dll" file and call the 
"GetLocalTime" function:

 
#pragma code("kernel32.dll")
VOID GetLocalTime(LPSYSTEMTIME lpSystemTime);
#pragma code()
 
SYSTEMTIME st;
 
GetLocalTime(&st);

Create customized C functions

Introduction
When you create a customized C function, you define the following settings:    

● The name with which you call the user-defined C function.

● The type of user-defined C function.

● The parameters which are transferred to the user-defined C function in Runtime.
 

  Note

When you change the parameters or the function type, the change is color marked at the 
application point, e.g. in the function list. 
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Use only the following characters for the name:

● "A" to "Z"

● "a" to "z"

● "0" to "9"

● "_" as a separator
 

  Note

Names are not case-sensitive. It is not possible to create two user-defined C functions 
with the same name but different notation.

 

Procedure
Proceed as follows to create a new customized C function:

1. Open "Scripts" in the project tree.

2. Double click "Add new C function" in the project tree under "C scripts".

The user-defined C function is created as a new tab in the work area. The input mask for 
the configuration settings of the function opens in the Inspector window.

3. Configure the function in the Inspector window "Properties > General > General".

4. Enter a descriptive "Name" for the user-defined C function.
Select the "Type" of the user-defined C function. Further information can be found in 
"Transfer and return of values in C".

– Void: Function has no return value.

– Tag: Return value is returned as a tag value.

– Pointer: Return value points on the address of the tag.
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5. Double click "<Add>" in the "Parameters" list to add parameters. Enter the parameter name. 
Further information can be found in "Transfer and return of values in C".

– Tag transfers the parameter value.

– Pointer transfers the address of the parameter.

6. Write the code in the work area.

Result
The user-defined C function is created. The type, name, and function parameters are displayed 
in the title bar. 

The start and end are inserted automatically when the user-defined function is created.

If you have protected the user-defined C function by a password, it is saved encrypted in the 
project. See "Auto-Hotspot" for additional information.

The figure below shows a user-defined C function which converts the temperature from 
"Fahrenheit" to "Degrees Celsius":

See also
"Scripts" editor (Page 4440)
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Renaming customized C functions

Renaming a user-defined C function in the project tree   
Proceed as follows to rename a user-defined C function in the project tree:

1. Select the user-defined C function in the project tree.

2. Select the "Rename" (F2) command in the shortcut menu of the user-defined C function.

3. Enter a new name for the user-defined C function.

Renaming a user-defined C function in the Inspector window
Proceed as follows to rename a user-defined C function in the Inspector window:

1. Open the user-defined C function in the "Scripts" editor.

2. In the Inspector window, click "Properties > General > General".

3. Enter the new function name.

Result
The user-defined C function is renamed. The application points are adapted automatically.

Executing customized C functions

Introduction
In WinCC you have the following options to execute a customized C function:

● Function list

● Customized C function

● Local C script

Calling a customized C function in a function list 
1. Add the user-defined C function to a function list like a system function.

You will find the customized C functions in the drop-down list under "C functions". 
You will find further information about this in "Configuring a function list".

2. Supply the parameters with static values or HMI tags.

3. If the user-defined C function has a return value, select an HMI tag. The value to be 
processed is transferred to the HMI tag.

 

  Note

You can only use customized functions of the same programming language in a function 
list. You specify the programming language with the selection of the first customized 
function. 
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Calling a user-defined C function in a user-defined C function
1. Open the user-defined C function in which you want to call the user-defined C function.

2. Call the customized C function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined C function has a return value, assign an expression, such as a local tag, 
to the function.

 

  Note

You can only call user-defined C functions of the same programming language in a user-
defined C function. 

 

Calling a customized C function in a local C script 
1. The function list is converted into a local C script.

2. Call the customized C function in the syntax of the programming language. You will find 
further information about this in "Calling customized functions".

3. If the user-defined C function has a return value, assign an expression, such as a local tag, 
to the C function.

 

  Note

You can only use user-defined functions of the same programming language in a local C 
script. 

 

 

See also
Calling system functions (Page 4442)

Calling customized functions (Page 4444)
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Transfer and return of values in C

Transfer of a value
You have the following possibilities for transferring parameters:

● Tag (Call by value)
The tag name and the data type are specified to save values in the tag. But this tag is not 
transferred directly but a copy made. When executing the user-defined C function, the tag 
value of the copy is transferred to the C function. If you change the tag value, the change 
is only valid within the user-defined C function.

● Pointer (Call by reference)
A pointer is a tag which points on the address of a tag. Pointers are defined like tags. The 
* character is added to the data type, e.g. Double*. The user-defined C function accesses 
the tag to which the pointer is pointing. If you change the tag value, the changed tag value 
is written into the tag. 

Return of a value
A user-defined C function can execute simple instructions and return no value. The return 
value is then a "void" data type.

If a return value is required, the value can be returned as a tag or a pointer. 

But a return value can also give information about whether an instruction was executed 
correctly. Therefore, the system functions that perform file operations such as write to a file 
also have return values.  

For a user-defined C function to return a value, you must set the "Double" type. The result is 
transferred to the user-defined C function with the return instruction.

To form an average value from two numbers, call the user-defined C function Average and 
transfer the result to the HMI tag, for example, AverageValue. 

● In a customized C function

 
SetTagDouble("AverageValue",Average (4, 5));
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● In the function list

You can output the value of the HMI tag AverageValue in an I/O field. 

10.8.4 Creating local scripts

10.8.4.1 Local scripts

Definition
Local scripts are bound to a single object, such as an object property, and have a cyclic or 
acyclic trigger. A local script is created directly at the point of use: 

● Scheduler

● Screens

– Event (converted function list)

– Object property (property list)

– Property change (property list)

● Menus and toolbars

● Only C script: Reports

– I/O field at the process value property

Local scripts are not displayed in the project navigation and are only available at the point of 
use. 

Application         
Local scripts are used for the following:

● Property list (screen object): Dynamic control of object properties
A local script is used to dynamize an object property in Runtime by means of its return 
value. Example: Changing the object position in dependence of several parameters.

● Function list (screen object): Converting a function list to a local script
Convert a function list to a local script in order to configure conditional instructions or loops 
at an event. 

● Scheduler (task): Execute local script cyclically or acyclically
Use the Scheduler to execute a script at a specified point in time. 

Local scripts are not loaded into the memory of the HMI device until they are used, for example 
when loading a screen. Local scripts thus reduce memory requirements on the HMI device. 
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Programming
When a local script is created at an object property, a local script with return value is generated. 
The return value supplies the value for the object property. 

When a local script is created at an event, a local script without return value is generated. 

The parameters which are transferred to the local script depend on the used programming 
language and the application point.

Typical parameters of a local VB script

Item: Contains the object reference:

● Scheduler (task): No object is transferred.

● Menu & toolbars: The object that triggers the event is transferred.

● Screens (screen object):

– Property list (screen object): In dynamizations, the screen object whose property you 
dynamize is transferred.

– Converted function list (screen object): The screen object whose event you configure is 
transferred.

To access the properties of the transferred screen object, enter "item.". The available 
properties are listed. Use ScreenItems to access another object of the object model.. 
Further information about parameters of events are available in the reference. 

Typical parameters of a local C script

Char* screenName: Contains the name of the screen that contains the object whose property 
is being dynamized. 

Char* objectName: contains the name of the object whose property you dynamize.

Char* propertyName: Contains the property that is being dynamized. 

Further information about parameters of events are available in the reference. 

Execution of local scripts
Local scripts require a trigger. The trigger specifies when the script will be executed. The point 
of use of the local script determines which trigger is used:

● Local scripts of a converted function list are executed when the event occurs, for example, 
printing.

● Local scripts in the property list get the trigger automatically. You can change the trigger, 
e.g. to tag trigger.

● Local scripts of a task are assigned a trigger by the project engineer.

See also
"Scripts" editor (Page 4440)
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10.8.4.2 Editor for local scripts

Properties of the editor for local scripts   
The editor for local scripts has no own setting possibilities but "inherits" the settings from 
"Runtime Scripting".

The editor offers similar functions to the "Scripts" editor. You will find further information in 
""Scripts" editor (Page 4440)".

The following functions are not available in the toolbar:

● Drop-down lists for properties and functions

The editor for local VB scripts contains the following additional icons:

●  Shows declaration range.

●  Hides declaration range.

You define local VB tags in the declaration range. See "Use of VB tags (Page 4452)" for 
additional information.

Availability   
The editor for local scripts can be called in the following places:

● Scheduler

– Event: Execute

● Screens

– Event

– Object property (property list)

– Property change (property list)

● Menus and toolbars

– Event: Click

● Only C script: Reports

– I/O field at the process value property

See also
"Scripts" editor (Page 4440)

10.8.4.3 Converting a function list to a local script

Introduction
When you convert a function list to a local script, you can configure conditional instructions or 
loops for an event. A function list is converted either to a local VB or C script. 
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If the function list does not contain a customized function, the programming language is 
determined by the function. 

If a C function is contained, for example, the function list is converted into a local C script.

Requirement
The function list is opened.

Procedure    
Proceed as follows to convert a function list to a local script:

1. Select the event whose function list you want to convert to a script.

2. Configure system functions at the event as required.

3. To convert the function list to a local script, click  or .

4. Write the program code.

Alternatively you use the "Convert VB script" or "Convert C script" command in the shortcut 
menu.

Result
If the event occurs, the local script is processed automatically.

Deleting a local script    
Proceed as follows to delete a local script:

1. Select the event with the local script.

2. Select "Function list" in the shortcut menu of the event.

The local script is deleted. 

10.8.4.4 Dynamizing an object property with a local script

Introduction
With a local script you dynamize an object property in Runtime by the return value of the script. 

Requirement
● The object with the property to be dynamized is selected.

● The Inspector window is open.
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Procedure    
1. Click  in the Inspector window.

2. Select the object property to be dynamized.

3. Select the "VB script" or "C script" entry in the "Dynamization" column.
A dialog opens.

4. Write the program code.

5. Click " " in the toolbar to change the trigger.

Result
The object property changes in Runtime according to how the property list is configured.

Deleting the dynamization    
1. Select the dynamized object property in the property list.

2. Select the "None" entry in the "Dynamization" column.

10.8.5 Debugging

10.8.5.1 Debugging user-defined VB functions

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.     

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:
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● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE".

 

Microsoft Script Debugger
If you want to use the Microsoft Script Debugger for debugging, the English version 
"scd10en.exe" must be used. The German version "scd10de.exe" may not be installed.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

For tips and tricks on debugging, common sources of errors, and additional information, 
refer to the online help for the Microsoft Script Debugger.

 

The Microsoft Script Debugger is located in the Microsoft Download Center under the following 
URL:

● http://www.microsoft.com/downloads/Search.aspx?
displaylang=en833a6a92-961e-4ce1-9069-528d22605127 

Use the "Search" field to search for "Script Debugger" and select the required download.

Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes.
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Error types
The following error types are distinguished when debugging:           

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 
Example for error handling

 
Sub OnClick(ByVal Item)
'VBS27
  Dim objScreenItem
'
  'Activation of errorhandling:
  On Error Resume Next
  For Each objScreenItem In ScreenItems
    If "HMIRectangle" = objScreenItem.Type Then
    '
      '=== Property "RoundCornerHeight" only available for RoundRectangle
      objScreenItem.RoundCornerHeight = objScreenItem.RoundCornerHeight * 2
      If 0 <> Err.Number Then
        HMIRuntime.Trace objScreenItem.Name & ": no RoundedRectangle" & vbCrLf
        '
        'Delete error message
        Err.Clear
      End If
    End If
  Next
  On Error Goto 0  'Deactivation of errorhandling
End Sub

Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 
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10.8.5.2 Integrating the Debugger

Installing a script debugger for WinCC
A VBScript-capable debugger must be installed to search for errors in user-defined VB 
functions.

The following VBScript-capable debuggers have been tested and released:

● Microsoft Script Editor by Office XP

● Microsoft Script Debugger: The English version "scd10en.exe" must be used. The German 
version "scd10de.exe" may not be installed.

An installed debugger is started as follows:

● If a runtime error occurs during execution

● Via "Online > Simulate Runtime > With script debugger"

Microsoft Script Editor
The Microsoft Office XP component "Microsoft Script Editor" contains a Script Debugger. If 
the default configuration was installed by Microsoft Office Setup, the "Microsoft Script Editor" 
component is not installed until called the first time ("Installed on First Use"). If you wish to 
explicitly install these components, you must specify it in the Microsoft Office setup. Select the 
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component selection menu, click"Web Debugging" component and then select the "Run from 
My Computer" option.

If a project is activated in WinCC via "Online > Simulate Runtime > With script debugger", a 
dialog containing the list of available script debuggers appears when the first user-defined 
function is run.

Other installed script debuggers such as "Microsoft Visual Interdev" or "Microsoft Visual 
Studio .NET" may also appear in the list. Select "Microsoft Script Editor" and confirm your 
selection with "Yes".
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Activate the "Script" program object in the "Step Into Remote Procedure Call" dialog and 
confirm your selection with "OK".
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The "Microsoft Script Editor" is launched. The execution pauses at the first line of the first 
function.
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Microsoft Script Debugger
If a script debugger is not available, download "Microsoft Script Debugger" (scd10en.exe) free 
of charge from Microsoft (www.microsoft.com). It will be started automatically in WinCC once 
it is installed.

 

 Note

The "Microsoft Script Debugger" can no longer be called or installed when another VBScript-
capable script debugger is available on your computer.

 

Script Debugger is not started at the start of Runtime
If you installed a script debugger and the "Start Runtime with Script Debugger" command still 
fails to start it, make the following settings in the Windows registry to set Microsoft Script 
Debugger as default Just-In-Time (JIT) Debugger: 

● "HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}]
(Default)="ScriptDebugSvc Class"
"AppID"="{A87F84D0-7A74-11D0-B216-080000185165}"

● [HKEY_CLASSES_ROOT\CLSID
\{834128A2-51F4-11D0-8F20-00805F2CD064}\LocalServer32]
(Default)="c:\\Program Files\\Microsoft Script Debugger\\msscrdbg.exe"
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● [HKEY_CLASSES_ROOT\CLSID\{834128A2-51F4-11D0-8F20-00805F2CD064}\ProgID]
(Default)="ScriptDebugSvc.ScriptDebugSvc.1"

● [HKEY_CLASSES_ROOT\CLSID
\{834128A2-51F4-11D0-8F2000805F2CD064}\VersionIndependentProgID]
(Default)="ScriptDebugSvc.ScriptDebugSvc"

The "LocalServer32" file path must point to the installation folder of Microsoft Script Debugger. 
If you have installed Microsoft Script Debugger in a different folder, adapt the path information. 

10.8.5.3 Starting and stopping the debugger

Requirement
● VBScript-capable debugger (e.g., MS Script Debugger) and WinCC Runtime are installed 

on the configuration PC.

● Project is open.  

Starting the debugger
To start the debugger, proceed as follows:

1. Select the HMI device and then select the "Online > Simulation > With script debugger" 
menu command.
The Runtime software searches for debuggers installed on the configuration PC. 

2. If several debuggers are found click on the one required.

Or:

1. Click "Start > Run".

2. Enter the following command: "HmiRtm /ScriptDebug /<ProjectFile>".
Further information about the project file can be found in "Starting Runtime Advanced and 
Panels (Page 6995)".

Or:

1. Select the "debug" command in the project file shortcut menu in the Windows Explorer.

Result
The debugger is connected automatically with the runtime software.

Stopping the debugger
The debugger is not closed automatically when you close the Runtime software. Therefore, 
close the debugger separately.   
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10.8.6 Debugging

10.8.6.1 Debugging of VBScript files

Overview             
The following VBScript-capable debuggers have been tested and approved:

● Microsoft Script Debugger (runs with Windows XP and Windows 7): The English version 
"scd10en.exe" must be used. The German version "scd10de.exe" may not be installed.

● Microsoft Script Editor (MSE) Debugger (contained in material supplied with Microsoft 
Office)

● Debugger "InterDev" (contained in scope of installation material supplied with Developer 
Studio )

 

  Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

The following description relates exclusively to handling the Microsoft Script Debugger.

Microsoft Script Debugger
If you want to use the Microsoft Script Debugger for debugging, the English version 
"scd10en.exe" must be used. The German version "scd10de.exe" may not be installed.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

For tips and tricks on debugging, common sources of errors, and additional information, 
refer to the online help for the Microsoft Script Debugger.

 

The Microsoft Script Debugger is located in the Microsoft Download Center under the following 
URL:

● http://www.microsoft.com/downloads/Search.aspx?
displaylang=en833a6a92-961e-4ce1-9069-528d22605127 

Use the "Search" field to search for "Script Debugger" and select the required download.

Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
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step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes.

 

Error types
The following error types are distinguished when debugging:           

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the function 
step by step. In this way, you identify the portion of the function that is not working.

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
In order to intercept runtime errors, you use the "On Error Resume Next" instruction in the 
function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. In order to stop the handling of 
runtime errors in the function again, use the "On Error Goto 0" instruction. 
Example for error handling

 
Sub OnClick(ByVal Item)
'VBS27
  Dim objScreenItem
'
  'Activation of errorhandling:
  On Error Resume Next
  For Each objScreenItem In ScreenItems
    If "HMIRectangle" = objScreenItem.Type Then
    '
      '=== Property "RoundCornerHeight" only available for RoundRectangle
      objScreenItem.RoundCornerHeight = objScreenItem.RoundCornerHeight * 2
      If 0 <> Err.Number Then
        HMIRuntime.Trace objScreenItem.Name & ": no RoundedRectangle" & vbCrLf
        '
        'Delete error message
        Err.Clear
      End If
    End If
  Next
  On Error Goto 0  'Deactivation of errorhandling
End Sub
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Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 

Notes on the MSE Debugger
The following settings must be changed when using the MSE Debugger so that the running 
processes will be displayed:

1. Select Processes > Properties to activate the "Just-in-time debugging" option.

2. Restart the computer.

3. Deactivate the "Disable script debugging" option in MS Internet Explorer. As a result, 
Internet Explorer will not prevent the debugging operation of WinCC.

10.8.6.2 Activating the debugger

Principle       
There are several ways of activating the debugger:

● Automatic call of the debugger after an error has occurred in Runtime.

● Display of an error box in Runtime which is used to call the debugger.

● Starting the debugger from the Start menu and opening an active Runtime script.

Requirement
Microsoft Script Debugger is installed on the configuration PC.

Procedure
Start the debugger in Runtime as follows: 

1. Select the HMI device and then select "Online > Simulation > With script debugger".
The Runtime software searches for debuggers installed on the configuration PC. 

2. If several debuggers are found click on the one required.

Starting the debugger later
As an alternative, run the debugger later and interconnect it with the currently active system. 
To do so, establish a connection in the debugger to the "pdlrt.exe" process for the Graphical 
Runtime System and the "gscrt.exe" process for the Global Runtime System.

Exiting the debuggers
Exit the debugger without closing WinCC Runtime. 
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10.8.6.3 Components of the Microsoft Script Debuggers

Introduction 
Microsoft Script Debugger supports debugging by means of the following components:

● "Command Window"

● "Running Documents" window

● "Call Stack" window

"Command Window"
Open the "Command Window" by selecting the "View" > "Command Window" menu command.

While a VBScript file is running in Runtime, use the "Command Window" of the debugger, for 
example, to identify and edit the values of tags and properties of the active VBScript file. 
Changes made in the "Command Window" have a direct effect on the running VBScript file so 
that planned changes can be tested immediately.

Perform the following actions in the "Command Window":

● Command input
Enter commands directly in VBScript and then execute these.

● Change tag values:
Acquire and edit tag values in the "Command Window". This relates to both local tags in 
VBScript files and HMI tags.

● Modify properties:
You can read and write the properties of all objects of the current script context.

Always use the "Command Window" after a VBScript file has reached a breakpoint or after 
you called other commands at the breakpoint.

 

 Note

Note that any changes made in the "Command Window" do not affect the source code of 
your user-defined function and are only used for test purposes in the debugger.

 

"Running Documents" window
Open "Running Documents" window by selecting the "View > Running Documents" menu 
command.

In the "Running documents" window, you see all user-defined functions currently running in 
WinCC Runtime. The local scripts are divided into scripts from the scheduler ("Global Script") 
and local scripts of the graphical Runtime system ("Graphic). You see all running local scripts 
and user-defined functions of the scheduler. The local scripts in the graphical Runtime system 
are divided into trigger-driven scripts (ScreenName_trigger) and event-driven scripts 
(ScreenName_events).
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"Call Stack" window
Open the "Call Stack" window by selecting the "View" > "Call Stack" menu command.

The "Call Stack" window outputs a list of all current user-defined functions and of local scripts 
called. The name of a local script called is added to the "Call Stack" list, for example. The name 
is removed again from the list after the local script is completed. Select a local script from the 
list to jump to the corresponding script call position in the VBScript file. 

10.8.6.4 Structure of VBScript files

Principle
Event-driven and cyclic/tag-triggered VBScript files are strictly separated during their execution 
to prevent any interference with simultaneous processing of cyclic and event-driven VBScript 
files in the graphical Runtime system. A cyclic local script cannot interfere with the execution 
of a user-defined function which is to be triggered by clicking a button, for example.

The event-driven and cyclic/tag-triggered local scripts are saved to separate VBScript files 
when you save screens to ensure this behavior. Any global screen element you have defined 
for VBScript files in the "Screens" editor is copied to both VBScript files.

 

 Note

Because the two VBScript files are handled separately, they have no common data area. 
Therefore, there is no synchronization of global tags between the two VBScript files. 
Implement any synchronization function which may be required using the DataSet object or 
internal HMI tags.

 

Structure of VBScript files
When VBScript files are debugged with a debugger, the VBScript files always open the different 
Runtime systems.

In the case of the graphical Runtime system, this means that you receive two files per picture:

● <ScreenName>.pdl_events: Contains the event-driven scripts.

● <ScreenName>.pdl_triggers: Contains the cyclic and tag-driven VBScript files.

The following section describes the structure of script files within the graphical Runtime system:
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● Content of the VBScript file <ScreenName>.pdl_events
General code
Event-driven scripts

● Content of the VBScript file <ScreenName>.pdl_triggers
General code
Cyclic or tag-triggered scripts

 

  Note

Note that the local scripts and user-defined functions of the graphical Runtime system are 
not displayed by their names in the VBScript file to which they were saved in WinCC. For 
more information refer to Names in the debugger (Page 4492).

 

10.8.6.5 Selecting a VBScript file for processing

Introduction
You can select a user-defined function or a local script for editing after having opened Microsoft 
Script Debugger from the Windows Start menu while Runtime is active.

Requirement
● Runtime is activated.

● The screen to be debugged is active.

Procedure
1. Go to the Windows Start menu and select "Programs > Accessories > Microsoft Script 

Debugger".

2. Activate the "View > Running Documents" command in the menu bar.
The "Running Documents" window opens. In this window, you see all VBScript files 
currently running in WinCC Runtime. The files are divided into VBScript files from the 
scheduler ("Global Script") and VBScript files of the graphical Runtime system ("Graphic).

3. Double-click the VBScript file to debug in the "Running Documents" window.
The script document opens with write protection in the debugger window. 

10.8.6.6 Executing a VBScript file step-by-step

Introduction
Use Microsoft Script Debugger for step-by-step execution of your VBScript files (user-defined 
function or local script) to systematically isolate logical errors, for example. Simulate the effect 
of each code line in Runtime.
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The Procedure in Principle
1. Activate the document to debug in Runtime.

2. Start the debugger manually from the Start menu and open the required VBScript file or 
activate the debugger in WinCC.
When activated in WinCC, the debugger automatically opens when an attempt is made to 
execute an erroneous VBScript file.

3. Set a breakpoint in the VBScript file. Breakpoints are normally set in front of code lines in 
which errors are suspected.

4. Change to WinCC Runtime and trigger an action that initiates execution of the VBScript 
files.
The debugger stops at the first break point and marks the current line.

5. Select one of the following menu commands for step-by-step simulation of the VBScript 
document:

– "Debug > Step Into": Skip to the next code line. If the script calls a procedure in this line, 
it skips to the procedure using the "Step Into" command. Execute the called function 
step-by-step.

– "Debug > Step Over": Skips the user-defined function called. The user-defined function 
is executed but the debugger does not stop at the individual lines of the function. Instead 
it moves to the next line of the current VBScript file after the function was executed.

6. Select the "Debug" > "Step Out" menu command to cancel step-by-step execution of a user-
defined function.
The debugger then steps to the next action.

7. Step through the document until you reach the end or select the "Debug" > "Run" menu 
command to restart the VBScript file in Runtime. 

10.8.6.7 Setting breakpoints

Introduction
Set breakpoints to stop VBScript file execution at specific points and to start the debugger. Set 
a breakpoint before a line in which you suspect a scripting error, for example.

Use the breakpoints as follows:

● Set breakpoints at specific lines for step-by-step isolation of logical errors in your VBScript 
file.

● Set a breakpoint and call the debugger before the next line of the VBScript file is executed. 
Deploy this procedure to handle "Screen change" events, for example.

When a VBScript file is updated in the debugger, all the breakpoints are lost.

All of the trigger- or event-controlled procedures are stopped in Runtime if you set a breakpoint 
in one of the script files "<ScreenName>.pdl_trigger" or "<ScreenName>.pdl_event".
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Requirement
● Runtime is activated.

● The screen to be debugged is active.

Procedure
1. Start the debugger and select the VBScript file.

If automatic activation of the debuggers in WinCC has been selected, the debugger is called 
in as soon as an erroneous script is executed.

2. Place the cursor in the action in which a breakpoint is to be set.

3. Select "Debug > Toggle Breakpoint" in the menu, or the toolbar icon .
The next executable line is marked with a red dot.

4. Change to WinCC Runtime and execute the VBScript file to be debugged.
The debugger stops at the first breakpoint. The current line is displayed on a yellow 
background.
Simulate the program code step-by-step. 

10.8.6.8 Deleting breakpoints

Introduction
Delete specific or all of the breakpoints in a VBScript file after having successfully cleared an 
error.

Procedure
1. Position the cursor in the line whose breakpoint is to be deleted.

2. Select "Debug > Toggle Breakpoint" in the menu, or the toolbar icon .
The line is again displayed without marker.

3. You delete all breakpoints from a VBScript file by selecting the "Debug > Clear all 
Breakpoints" menu command or by clicking the toolbar icon .

10.8.6.9 Setting a bookmark in the VBScript file

Introduction
Within the debugging session, set bookmarks at the code lines to facilitate retrieval of a specific 
line.
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Setting or deleting bookmarks
1. Position the cursor in the line in which a bookmark is to be set or deleted.

2. Press <Ctrl+F2>.
A bookmark is either set or deleted

Skipping to the next bookmark
Press <F2> to skip to the next bookmark in the VBScript file.

Skipping to the previous bookmark
Press <Shift+F2> to skip to the previous bookmark in the VBScript file. 

10.8.6.10 Acquiring and editing tag and property values

Introduction
Use the "Command Window" of the debugger while a VBScript file is active in Runtime, for 
example, to acquire and edit tag or property values. You reset a process value for the user-
defined function to zero without having to stop the process, for example.

 

 Note

To ascertain the name of a WinCC object in Runtime, click <Ctrl+Alt+Shift> and position the 
mouse over the corresponding object. The screen name and the object name are displayed 
in a tooltip. 

 

Requirement
● The VBScript file runs in Runtime.

● The debugger is open.

Procedure
1. Set at least one breakpoint in the VBScript file.

2. Change to WinCC Runtime and trigger an action that initiates execution of the VBScript file.
The debugger stops at the first breakpoint.

3. Select "View > Command Window".
The "Command Window" opens.

4. Enter the following string to query a tag or property value:

– "?", followed by a space character

– and the name of the tag or property you want to query

– Example: "? myTag"

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4490 System Manual, 02/2014



5. Execute the command by pressing <Enter>.

6. Change the value of a tag/property by assigning it a value in the VBS syntax.

10.8.6.11 Executing script commands

Introduction
Use the "Command Window" of the debugger to directly execute commands while a VBScript 
file is active in Runtime. This is how you can manipulate VBScript file execution. You execute 
the script commands directly for testing without creating the command in a script and then 
executing the script. You control the following commands, for example:

● To retrieve methods

● To retrieve procedures

● To manipulate object properties

The "Command Window" is used to execute all commands which can also be executed in a 
VBScript.

Requirement
● The VBScript file runs in Runtime.

● The debugger is open.

Procedure
1. Set at least one breakpoint in the VBScript file.

2. Change to WinCC Runtime and trigger an action that initiates execution of the VBScript file.
The debugger stops at the first breakpoint.

3. Select "View > Command Window". "Command Window" opens.

4. Enter the required command and confirm with "ENTER".
 

  Note

An error message will not be generated in runtime if you enter an invalid command in the 
"Command Window". The message "<Script Error>" will appear in the Command Window 
instead. 

 

Example

 
Dim i
For i = 1 to 10 
     HMIRuntime.Trace i & vbnewline
Next
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When this VBScript is executed and the debugger is in the loop at the breakpoint, you can use

● ?i
to read out the value of variable i

● i = 5
to set the value of variable i to 5.

10.8.6.12 Names in the debugger

Names in the debugger 
The names of user-defined functions in the debugger differ from the names by which you saved 
your user-defined functions in WinCC.

The function and script names in the script files are compiled according to the following rules:

Action type Name of the script file
Cyclic or tag-triggered scripts at a property ObjectName_PropertyName_Trigger
Mouse events ObjectName_OnClick

ObjectName_OnLButtonDown
ObjectName_OnLButtonUp
ObjectName_OnRButtonDown
ObjectName_OnRButtonUp

Keyboard events ObjectName_OnKeyDown
ObjectName_OnKeyUp

Object events ObjectName_OnObjectChanged
ObjectName_OnSetFocus

Events on properties ObjectName_PropertyName_OnPropertyChanged
ObjectName_PropertyName_OnPropertyStateCha
nged

Picture events Document_OnOpen
Document_OnClosed

Valid length of the script names
The name of scripts in the script files is limited to 255 characters. Each special character used 
in an object name is converted to five characters. The special character appended to the 
leading X is represented as four-digit hexadecimal code. If you configure a button action named 
"PushMe" with mouse click trigger, the "DrXFFFCckMe_OnClick" script is written to the script 
file.
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If the composite object name is too long, the syntax check in WinCC returns an error message. 
Because of this restriction, you cannot configure graphic object names of unlimited length.

 

 Note

To ascertain the name of an object in Runtime, click <Ctrl+Alt+Shift> and position the mouse 
over the corresponding object. The screen name and the object name are displayed in a 
tooltip. 

 

10.8.6.13 Diagnostics

Diagnostics

Introduction   
If you execute your local VB scripts and C scripts in Runtime, you output a quick analysis with 
the aid of the "Print job/Script diagnostics" object.

Diagnostics tools
WinCC provides you with tools to analyze the runtime behavior in local C scripts and VB scripts:

● The print job/script diagnostics "GSC diagnostics" object

● Using a debugger

Application
To use the GSC Diagnostics, you insert the "Print job/Script diagnostics" object in a screen. 
Use the "GSC diagnostics" template.

This can be a dedicated screen which is designed for diagnostics and which is called in 
Runtime.

GSC diagnosis of VBS
GSC diagnostics returns the trace methods contained in the local scripts in the order in which 
they were called. Trace instructions in user-defined VB functions, which are called in local 
scripts, are also output. Explicit implementation of trace instructions, e.g. for output of the tag 
values, enables the tracing of script execution and of the functions called within those scripts. 
You enter the trace instruction in the form "HMIRuntime.Trace(<Output>)". Error situations 
which result in calling of the OnErrorExecute function are also displayed in the diagnostic 
window.

GSC diagnosis of C
GSC diagnosis outputs the printf methods contained in the local scripts in chronological order 
of their being called. printf instructions in user-defined C functions, which are called in local 
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scripts, are also output. By targeted use of printf instructions, e.g. for outputting tag values, 
the sequence of scripts and the functions called in them can be tracked. 

See also
Example of configuring a diagnostics output via a trace (Page 4510)

GSC diagnostics

Introduction
GSC Diagnostics outputs the trace instructions of the scripts to the diagnostics view in the 
chronological order of their call. The application also outputs trace instructions in functions 
which are called in the scripts. Explicit implementation of trace instructions, e.g. for output of 
the tag values, enables the tracing of script execution and of the functions called within those 
scripts. 

Application
Insert the "Print job/Script diagnostics" object of the type GSC Diagnostics in a screen to enable 
the use of GSC Diagnostics. Control the appearance of the GSC Diagnostics window by means 
of the GSC Diagnostics properties.

In the case of a picture change, the content of the GSC Diagnostics window is deleted.
 

 Note

Messages are also displayed in the "GSC Diagnostics" window when the debugger is 
activated. 

 

See also
Print job/Script diagnostics (Page 3529)

Inserting a GSC diagnostics window in a screen 

Introduction          
To use the GSC Diagnostics, you insert the "Print job/Script diagnostics" object in a screen. 
Use either any existing screen, or create a screen that is dedicated to diagnostics functions. 
In the Inspector window of the "Print job/Script diagnostics" object, you specify that the object 
is used for GSC Diagnostics.
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Requirement
● The required screen is open.

● The "Tools" task card is open.

Procedure
Proceed as follows to insert the GSC diagnostics window:

1. Insert the "Print job/Script diagnostics" object from the "Controls" palette of the "Tools" task 
card into the screen.

2. Assign a name to the GSC diagnostics window at "Miscellaneous > Name".

3. Select the "Functions" option in the inspector window under "Properties > Properties > 
General > Content > Window content".

4. Select the "GSC diagnostics" option under "Template".

5. Specify the further settings for the GSC diagnostics window under "General", "Layout", and 
"Miscellaneous".

10.8.7 Runtime behavior in Runtime

10.8.7.1 Executing user-defined functions in Runtime

Principle
Only one user-defined function at a time is executed in Runtime. If several user-defined 
functions are waiting to be executed, they are lined up in a queue and executed one after the 
other. 

 

 Note

A loop in a user-defined function therefore blocks the execution of the other functions in the 
queue even if the functions were initiated asynchronously.

 

WinCC supports a maximum nesting depth of eight user-defined functions. Note that the 
nesting depth is not checked.    

 

 Note

If a user-defined function is configured for the "Runtime stop" event, the only system functions 
that may be used in this user-defined function are those which are available at the "Runtime 
stop" event.

Ensure that the ending of the Runtime is not interfered with by the execution of the user-
defined function. 
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 Note
Configuration of user-defined functions

During configuration make sure that not too many user-defined functions are activated at the 
same time. Avoid a continuous system load of 100%. 

User-defined functions are processed at a lower priority so as not to interfere with the display 
of values and operability. If system utilization is extreme, the user-defined functions to be 
executed are therefore first only reserved for execution. The maximum size of the reservation 
list is dependent on the HMI device and is limited by the maximum permitted number of user-
defined functions. For additional information, see the performance features. If more user-
defined functions are activated at one time than can be reserved, excess calls are discarded 
and a system alarm displayed.

 

HMI device changeover
If you use system functions in a customized function which are not available on the set HMI 
device, you get a warning.  In addition, the corresponding system function in the user-defined 
function will be underlined with a wavy blue line.   

See also
User-defined functions (Page 4432)

10.8.7.2 Executing a function list in Runtime

Principle
A function list is executed from top to bottom in Runtime. A distinction is made between 
synchronous and asynchronous execution, so that no waiting periods ensue during execution. 
The distinction is made by the system by evaluating the different runtimes of the system 
functions. User-defined functions are always executed synchronously independent of the 
runtime. If a system function returns an error status, the execution of the function list is 
cancelled.   

Synchronous execution
During synchronous execution, the system functions in a function list are executed one after 
the other. The previous system function must be finished before the next system function can 
be executed.  

Asynchronous execution
System functions that perform file operations such as saving and reading have a longer runtime 
than system functions that, for example, set a tag value. 

Therefore, system functions with longer runtimes are executed asynchronously. For example, 
while a system function is writing a recipe data record to a storage medium, the next system 
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function is already being executed. Due to the parallel execution of system functions, waiting 
periods at the HMI device are avoided.  

10.8.7.3 Execution of functions and local scripts in Runtime

Processing local scripts in Runtime
Two locale scripts of the same type cannot be executed simultaneously in Runtime. Event-
triggered and cyclic/tag-triggered scripts in screens are executed separately to prevent any 
script from interfering with cyclic scripts.

 

 Note

The script types in WinCC are synchronized exclusively by the DataSet object or internal HMI 
tags. Separate execution prevents the generation of any shared data areas for event-
triggered and cyclic/tag-triggered scripts.

 

If high system load or other scripts interfere with cyclic execution of local scripts in the screens, 
the local script is executed once at the next opportunity. Cycles which are not executed are 
not retained in a queue but rejected.

After a screen change any active scripts are stopped automatically on expiration of 1 minute.

Local scripts which are still active at the end of Runtime are stopped after 5 seconds.

Executing functions in Runtime
Functions are executed successively in Runtime after being triggered. If a function is initiated 
while another is active, the second function is queued until it can be executed.

 

 Note

The local scripts and functions are synchronized exclusively by the DataSet object or internal 
HMI tags. Local scripts and functions do not share any data areas.

 

See also
User-defined functions (Page 4432)

Local scripts (Page 4433)
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10.8.7.4 Processing sequence for user-defined functions and system functions
 

 WARNING

Adherence to the expected processing sequence for user-defined functions and system 
functions in Runtime cannot always be guaranteed. This fact may lead to unexpected 
operating states.

Please note the following description in which the correlations are explained. Instructions for 
a solution are available under "Remedy".

 

Use of user-defined functions for events       
It is not always possible to adhere to the processing sequence for user-defined functions and 
system functions expected in the configuration, for example, when the processing of a user-
defined function lasts beyond the trigger time of a subsequent event. In this case, system 
functions that are configured for the following event may be executed before the system 
functions that were configured with the user-defined function for the same event.

Background
User-defined functions are arranged in a low-priority queue. The queue is processed in 
sequence. If system functions and user-defined functions are configured for an event, all 
system functions and user-defined functions configured for this event are executed in this 
queue.

Example
On a button, you have configured:

 Event Functions
Press User-defined function (1)

SetBit(Tag) (2)

Release ResetBit(Tag) (3)
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A

B

Press

Interrupts

lower priority

program

Release

Press Release

(1) Execution time of the user-defined function
(2) Execution time of system function SetBit(Tag)
(3) Execution time of system function ResetBit(Tag)

A: Expected execution of the user-defined function and system functions in the configuration.

When you press the button, user-defined function (1) and then system function SetBit(Tag) 
(2) are executed. When you release the key, system function ResetBit(Tag) (3) is then 
executed.

B: Processing of the user-defined function is not yet complete when you release the key.

When you press the key, the user-defined function (1) is then executed. The execution of the 
user-defined function (1) is not yet complete and you have already released the key. System 
function ResetBit(Tag) (3) interrupts the execution of the function. In this case, system function 
ResetBit(Tag) (3) is executed before system function SetBit(Tag) (2). As a result, the bit 
remains placed.

System function "SetBitWhileKeyPressed" shows the same behavior, if the system function is 
configured together with user-defined functions.

Remedy
The processing sequence of the previous Example A is adhered to, if you additionally configure 
a user-defined function for the "Release" event. The user-defined function does not require 
functionality for this purpose. 

 Event Functions
Press User-defined function (1)

SetBit(Tag) (2)

Release User-defined function_2 (3)
ResetBit(Tag) (4)
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 Note

Make sure that the user-defined function queue does not overflow; otherwise the system 
function for the following event may not be executed.

An overflow is recognizable by "Overload: Script <name> is rejected" or "Adherence to the 
expected processing order for user-defined functions and system functions in Runtime cannot 
always be ensured". 

 

10.8.7.5 Making object properties dynamic in Runtime

Introduction
You can use user-defined functions to access object properties of screen objects as well as 
tags in Runtime. If you use a user-defined function to change values of object properties, this 
will not affect the project data.    

Changes to object properties
If you use a user-defined function in Runtime to change an object property of a screen element, 
this change will only remain effective while the screen is active. If you change to the screen, 
or reload the screen, the configured object properties are displayed once more. 

Language switching
If you switch the language in Runtime, the foreign language labels are loaded from the project 
data. If you use a user-defined function to change texts, the texts changed by the user-defined 
function are overwritten again.   

10.8.8 Examples of VBS

10.8.8.1 Example: Converting Fahrenheit into degrees Celsius

Scheduled task
In this example, create a user-defined VB function which converts the values of a temperature 
sensor from Fahrenheit to degrees Celsius. The temperature is displayed in an output field on 
the HMI device.   

Settings
For the example you need two HMI tags and a user-defined VB function with the following 
settings:
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HMI tags:

Name PLC connection Type
Fahrenheit Yes Real
Centigrade No Real

User-defined VB function:

Name Type Parameters
FahrenheitToCelsius Function Fahrenheit

Procedure
1. Create the two HMI-tags "Fahrenheit" and "Celsius" with the settings named above.

2. Create the user-defined VB function "FahrenheitToCelsius" with the settings given above.

3. Write the following VBS code:
FahrenheitToCelsius = (Fahrenheit-32) * (5/9)

Interim result
The HMI tags and the VB user-defined function are created.
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Procedure
1. Open the "HMI Tag"editor and click on the "Fahrenheit" tag.

2. Click the "Properties > Events" tab in the Inspector window. Select the "Value change" 
event.

3. Configure the user-defined VB function "FahrenheitToCelsius" to the "Value change" event.

4. Select the tag "Fahrenheit" for the parameter "Fahrenheit".

5. Select the HMI-tag "Celsius" for the return value "Fahrenheit to Celsius".

6. Configure an output field in a screen and connect it with the tag "Celsius".

Alternative procedure
Instead of using a user-defined VB function of the "Function" type, you can also use the "Sub" 
type. In this case, assign the converted value directly to the HMI-tag "Celsius".

SmartTags("Celsius") = (Fahrenheit-32) * (5/9)
In this case the return value of the user-defined VB function is not applicable. 

Result
When the tag value of "Fahrenheit" changes in Runtime, the user-defined VB function 
"Fahrenheit to Celsius" is performed. The converted temperature value is returned to the HMI-
tag "Celsius" and displayed in the output field. 

10.8.8.2 Example: Converting inches into meters

Scheduled task
In this example you create a user-defined VB function that converts the value of a length 
measuring system from inches into meters. The length in meters is displayed on the HMI device 
in an output field. 

Settings
For the example you need two HMI tags and a user-defined VB function with the following 
settings:

HMI tags:

Name PLC connection Type
VarInch Yes Real
VarMeter No Real

Customized VB function
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Name Type Parameters
InchToMeter Sub Inch

Procedure
1. Create the two HMI tags "VarInch" and "VarMeter" with the above settings.

2. Create the user-defined VB function "InchToMeter" with the settings given above.

3. Write the following VBS code:
VarMeter = Inch*0.0254

Interim result
The tags and the user-defined VB function are created.

Procedure
1. Open the "HMI tags" editor and click the "VarInch" tag.

2. Click "Properties> Events" in the Inspector window. Select the "Value change" event.

3. Configure the user-defined VB function "InchToMeter" to the "Value change" event.

4. Select the "VarInch" HMI tag for the "Inch" parameter.

5. Configure an output field in a screen and connect it with the "VarMeter" HMI tag.
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Result
When the tag value of "VarInch" changes in Runtime, the "InchToMeter" user-defined VB 
function is performed. The calculated value is written into the "VarMeter" HMI tag and displayed 
in the output field. 

10.8.8.3 Example: Changing the operating mode on the HMI device with the current display

Scheduled task
In this example, you use the "SetDeviceMode" system function to switch between the "online" 
and "offline" modes on the HMI device. You also display the current set operating mode on 
the HMI device.   

Requirements
A screen has been created.

Settings
For this example you require a HMI-tag and a text list with the following settings:

HMI tag:

Name PLC connection Type
OperatingMode No Bool

Text list:

Name Contains Values
ShowOperatingMode Bit (0/1) 1: Operating mode: "Online"

0: Operating mode: "Offline"
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Procedure
1. Create the "OperatingMode" HMI-tag indicated above.

2. Create the "ShowOperatingMode" text list indicated above.

3. Open the screen and insert a button for which you configure the operating mode change 
to "online".

4. Click "Properties> Events" in the Inspector window. Select the "Press" event.

5. Configure the "SetDeviceMode" system function for the "Press" event. The system function 
is found in the selection list under "Settings".

6. For the "Mode" parameter, select the "Online" entry.

7. Configure the system function "SetBit" on the event "Press". The system function is found 
in the selection list under "Bit processing".

8. Select the HMI-tag "Operating mode" from the selection list for the parameter "Tag".
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9. Add a button in the process screen for which you configure the operating mode change to 
"offline".

10.Repeat steps four to seven. For the "Mode" parameter, select the "Offline" entry. Configure 
the system function "ResetBit" in place of the system function "SetBit."

Interim result
You can toggle the operating mode of the HMI device with the two buttons in Runtime. 

You want to display the current set operating mode in an output field on the HMI device.

Procedure
1. Create a "Symbolic I/O field" in the process image. Click "Properties > Properties" in the 

Inspector window.

2. Make the following settings in the "General" group:

– Select "Output" as the "Mode".

– Select the text list "Show operating mode" as "Text list".

– Select "Operating mode" as "Tag".
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Result
When you change the operating mode with the buttons, the currently set operating mode on 
the HMI device is always shown.

See also
Configuring a function list (Page 4437)

10.8.9 Examples of VBS

10.8.9.1 Overview

Introduction   
You can find the following examples for VBS:

● Access to objects in the "Screens" editor (e.g., color or text change)

● Determining color of objects

● Configuring a language switch

● Deactivating Runtime

● Configuring a screen change via a property

● Configuring diagnostic output via a trace

● Writing tag values

● Reading tag values

● Writing object properties

● Configuring a recipe view

● Configuring an alarm view

● Drawing a trend

● Evaluating tag values statistically

See also
Example of configuring the recipe view (Page 4519)

Example of configuring the alarm view (Page 4521)

Example of statistically evaluating tag values (Page 4522)
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10.8.9.2 Example of accessing objects in the Screens editor

Introduction  
To make the graphic Runtime environment dynamic, you can use VBS scripting to access all 
objects in the "Screens" editor in WinCC. In doing so, you can make graphic objects dynamic 
in response to an operator input, e.g., in response to a mouse click or depending on tag values.

Procedure
In the following example, the radius of a circle is set to 20 in Runtime per mouse click:

 
'VBS121
Dim objCircle
Set objCircle= ScreenItems("Circle1")
objCircle.Radius = 20

See also
Radius (Page 5501)

10.8.9.3 Example of defining object colors

Introduction  
The object colors are defined by means of RGB values (Red/Green/Blue). The color values 
for graphic objects can be set or read. 

Procedure
The following example defines the fill color for "ScreenWindow1" to blue:

 
'VBS122
Dim objScreen
Set objScreen = HMIRuntime.Screens("ScreenWindow1")
objScreen.FillColor = RGB(0, 0, 255)

See also
FillColor (Page 5330)

Screens (Page 5524)
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10.8.9.4 Example of configuring a language switch

Introduction  
The Runtime language can be changed by means of VBS. Use buttons with corresponding 
country markings that you place on the start page of your project.

Using VBS, define the Runtime language by means of country code, e.g., 1031 for German - 
Default, 1033 for English - USA, etc. An overview of all country codes is available in the Basics 
of VBScript, "Regional Scheme ID (LCID) Diagram".

Procedure
Configure a local VBS script for a "Mouse click" event on a button and enter the following code 
to change the Runtime language to German:

 
'VBS123
HMIRuntime.Language = 1031

See also
Language (Page 5385)

10.8.9.5 Example of deactivating Runtime

Introduction  
You can use VBS to exit Runtime, e.g. by means of mouse click, or depending on tag values, 
or on other events.

Procedure
The following example terminates WinCC Runtime:

 
'VBS124
HMIRuntime.Stop

See also
Stop (Page 5886)
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10.8.9.6 Example of configuring a screen change via a property

Introduction 
If using split screens in your configuration, e.g. the title and operating bar for the user interface 
in a basic screen and an embedded screen window for the actual screen display, configure a 
screen change using the properties of the screen window.

The property of screen window "ScreenName" must be changed so that the other screen is 
displayed. The local script and the screen window must be configured in the same screen.

Procedure
In the following example you show the "test" screen in a "ScreenWindow" when executing the 
local VB script:

 
'VBS126
Dim objScrWindow
Set objScrWindow = ScreenItems("ScreenWindow")
objScrWindow.ScreenName = "test"

See also
ScreenName (Page 5524)

10.8.9.7 Example of configuring a diagnostics output via a trace

Introduction   
If you have inserted the Print job/Script diagnostics" object in your screen, you can use the 
trace command to display diagnostics outputs in the diagnostics window in Runtime.

Print job/Script diagnostics returns the trace methods contained in the user-defined functions 
in the order in which they were called. This also applies to trace instructions in functions that 
are called in user-defined functions. The targeted use of trace instructions allows you to trace 
the flow of user-defined functions and the functions called therein. You enter the trace 
instruction in the form "HMIRuntime.Trace<Output>".

The "Print job/Script diagnostics" object displays trace outputs from C and VBS.

Outputting text
The following example writes a text in the diagnostics window:

 
'VBS127
HMIRuntime.Trace "Customized error message"
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Outputting alarms
The following example writes the alarms of a "Control2" alarm view to the diagnostics window:

 
Sub TraceMsg
  Dim objAlarmControl
  Dim lIndex
  Dim lCellIndex
 
  'create reference to the alarm control
  Set objAlarmControl = ScreenItems("Control2")
 
  'enumerate and trace out row numbers 
  For lIndex = 1 To objAlarmControl.GetRowCollection.Count
     HMIRuntime.Trace "Row: " & (objAlarmControl.GetRow(lIndex).RowNumber) & "  "
 
     'enumerate and trace out column titles and cell texts
     For lCellIndex = 1 To objAlarmControl.GetRow(lIndex).CellCount
       HMIRuntime.Trace objAlarmControl.GetMessageColumn(lCellIndex -1).Name & " "
       HMIRuntime.Trace objAlarmControl.GetRow(lIndex).CellText(lCellIndex) & "  "
     Next
     HMIRuntime.Trace vbNewLine
  Next
End Sub

Output information about HMI tags
The following example uses the "VarArch100" log tag to write information to the diagnostics 
window:

 
Sub ReadTagInfo
  Dim Tag
  Set Tag = HMIRuntime.Tags("TagLoggingfast\VarArch100")
 
  HMIRuntime.Trace "Last Error = " + CStr(Tag.LastError) + vbNewLine
  HMIRuntime.Trace "Name = " + Tag.Name + vbNewLine
  HMIRuntime.Trace "QualityCode = " + CStr(Tag.QualityCode) + vbNewLine
End Sub

See also
Trace (Page 5887)

Diagnostics (Page 4493)
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10.8.9.8 Example of writing tag values

Introduction  
You can use VBScript to write the tag value to the PLC, for example, by mouse click on a 
setpoint button or to set internal tag values for triggering other user-defined functions. 

Various write variations are mentioned and explained below.

Simple writing
In the following example, a value is written to the "Tag1" tag:

 
'VBS128
HMIRuntime.Tags("Tag1").Write 6

This is the simplest form of writing since no object reference is generated.

Writing with object reference
In the following example, a local copy of the tag object is generated and a value is written to 
"Tag1":

 
'VBS129
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Write 7

Referencing offers the advantage of being able to work with the tag object before writing. You 
can read the tag value, perform calculations, and write the tag value again.

 
'VBS130
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
objTag.Value = objTag.Value + 1
objTag.Write

Synchronous writing
The value to be written is usually transferred to tag management and execution of the script 
is continued. In certain cases, however, it must be ensured that the value has actually been 
written before script execution continues.

This type of writing is realized by specifying the value 1 for the additional, optional parameters:
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'VBS131
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Write 8.1

or

 
'VBS132
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Value = 8
objTag.Write ,1

 
 

 Note

Note that the call takes longer in comparison to the standard call. The duration is also 
dependent on the channel and AS, among other things.

This type of writing corresponds to the SetTagXXXWait() call in C scripting.
 

Writing with status handling
In order to ensure that a value has been written successfully, you perform an error check or 
evaluate the tag status after the write operation was completed.

This is done by checking the value of the LastError property after writing. The tag status is 
checked if the check was completed successfully, i.e., if the job was successfully output.

In the case of a write job, the current status from the process is not determined. To determine 
this, it is necessary to read the tag. The value specified in the QualityCode property after the 
read process provides an indication of the tag status and, if necessary, makes reference to a 
failed AS connection.

In the following example, the "Tag1" tag is written. If an error occurs during writing, the error 
value and error description appear in the Global Script diagnostics window. Finally, the 
QualityCode is checked. If the QualityCode is not OK (0x80), it will be displayed in the 
diagnostics window.

 
'VBS133
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Write 9
If 0 <> objTag.LastError Then
  HMIRuntime.Trace "Error: " & objTag.LastError & vbCrLf & "ErrorDescription: " & 
objTag.ErrorDescription & vbCrLf
Else
  objTag.Read
  If &H80 <> objTag.QualityCode Then
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     HMIRuntime.Trace "QualityCode: 0x" & Hex(objTag.QualityCode) & vbCrLf
  End If
End If

 
 

 Note

After writing a tag, the QualityCode property of the local tag object is set to "BAD Out of 
Service" because it is not known which QualityCode the tag handles in the process. The new 
QualityCode can be determined by reading again.

The Quality Code cannot be written from VBS.
 

See also
Tags (Page 5605)

Trace (Page 5887)

Read (Page 5858)

Value  (Page 5723)

Write (Page 5890)

10.8.9.9 Example of reading tag values

Introduction   
VBS can be used to read and further process a tag value. This allows you to click a button, for 
example, to obtain information on the system status or to perform calculations.

Various read variations are mentioned and explained below.

Simple reading
In the following example, the value of "Tag1" is read and displayed in the Global Script 
diagnostics window:

 
'VBS134
HMIRuntime.Trace "Value: " & HMIRuntime.Tags("Tag1").Read & vbCrLf

This is the simplest form of reading since no object reference is generated.
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Reading with object reference
In the following example, a local copy of the tag object is created, and the tag value is read 
and displayed in the "Print job/Script diagnostics" object:

 
'VBS135
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
HMIRuntime.Trace "Value: " & objTag.Read & vbCrLf

Referencing offers the advantage of being able to work with the tag object. You can read the 
tag value, perform calculations, and write the tag value again.

 
'VBS136
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
objTag.Value = objTag.Value + 1
objTag.Write

 

Using the Read method, process tags that have been read are added to the image, from this 
moment on they are cyclically requested from the automation system (AS). If the tag is already 
in the image, the value it contains is returned.

When the screen is exited, the tags are logged off.
 

 Note

If a tag is requested in a function, it remains logged on as long as WinCC Runtime is running.
 

Direct reading
Normally, the tag values are read from the tag image. In certain situations, however, it may be 
necessary to read the value directly from the AS, e.g., to synchronize fast processes.

The tag is not logged on cyclically if you set the optional parameter to 1 when reading the 
value. Instead, the value is requested once from the AS.

 
'VBS137
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
HMIRuntime.Trace "Value: " & objTag.Read(1) & vbCrLf
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 Note

Note that the call takes longer in comparison to the standard call. The duration is also 
dependent on the channel and AS, among other things.

This type of call must be avoided in cyclic C scripts as this is the major cause of performance 
problems.

This read mode corresponds to the GetTagXXXWait() call used in C scripting.
 

Reading with status handling
Always validate the value after reading it. This occurs by checking the QualityCode.

In the following example, the "Tag1" tag is read and the QualityCode then checked. When the 
Quality Code does not correspond to OK (0x80) the LastError, ErrorDescription, and 
QualityCode properties are displayed in the Global Script diagnostics window.

 
'VBS138
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
If &H80 <> objTag.QualityCode 
  Then
    HMIRuntime.Trace "Error: " & objTag.LastError & vbCrLf & "ErrorDescription: " & 
objTag.ErrorDescription & vbCrLf & "QualityCode: 0x" & Hex(objTag.QualityCode) & vbCrLf
  Else
    HMIRuntime.Trace "Value: " & objTag.Value & vbCrLf
End If

 
 

 Note

If an error occurs during reading, QualityCode is set to BAD Out of Service". Therefore, it is 
sufficient to check the QualityCode following reading.

 

See also
Tags (Page 5605)

Read (Page 5858)

Trace (Page 5887)
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10.8.9.10 Example of writing object properties

Introduction 
VBS provides access to the properties of all display and operating objects in the "Screens" 
editor. You can read out properties or change them during Runtime.

The following examples illustrate various forms of access.

Simple setting of a property
In the next example, the background color of the "Rectangle1" object in the screen is set to 
red:

 
'VBS139
ScreenItems("Rectangle1").BackColor = RGB(255,0,0)

This is the simplest form of writing since no object reference is generated.
 

 Note

If you are working without an object reference, only the standard properties are provided by 
autocompletion.

The mode of expression used in this example can only be executed in the "Screens" editor. 
By analogy, you address the objects in the scheduler using the HMIRuntime object.

 

Setting a property with object reference
In the following example, a reference is created to the "Rectangle1" object contained in the 
picture and the background is set to red using the VBS standard function RGB():

 
'VBS140
Dim objRectangle
Set objRectangle = ScreenItems("Rectangle1")
objRectangle.BackColor = RGB(255,0,0)

Additional information on RGB is available in "VBScript for Windows".

Referencing is useful if you want to edit several object properties. In this way all of the 
properties of the object will be listed with the autocompletion feature.

 

 Note

The mode of expression used in this example can only be executed in the "Screens" editor. 
By analogy, you address the objects in the scheduler using the HMIRuntime object.

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4517



Setting properties across screen windows
VBS in the "Screens" editor offers two options of global screen addressing:

● Using the screen object of a screen window with "ScreenItems"

● From the root screen with "HMIRuntime.Screens"

Referencing via the screen window
In the following example, the color of a rectangle is changed in an subordinate screen window. 
The user-defined VB function is executed in the "BaseScreen" screen in which 
"ScreenWindow1" is located. The screen window displays a screen, which contains an object 
of the type "Rectangle" with the name "Rectangle1".

 
'VBS199
Sub OnLButtonUp(ByVal Item, ByVal Flags, ByVal x, ByVal y)
  Dim objRectangle
  Set objRectangle = ScreenItems("ScreenWindow1").Screen.ScreenItems("Rectangle1")
  objRectangle.BackColor = RGB(255,0,0)
End Sub

Referencing from the root screen
You can reference the screen with the object to be modified via HMIRuntime.Screens. The 
specification of the screen is defined relative to the root screen via the following access code:

[<Root screen name>.]<Screen window name>[:<Screen name>]... .<Screen window 
name>[:<Screen name>]

In the following example, a reference is created to the "Screen2" object contained in the 
"Rectangle1" picture and the background color is set to red.

The screen "Screen2", in this case, is in "Screen1". "Screen1" is displayed in the "BaseScreen" 
root screen.

 
'VBS141
Dim objRectangle
Set objRectangle = 
HMIRuntime.Screens("BaseScreen.ScreenWindow1:Screen1.ScreenWindow1:Screen2").ScreenItems("
Rectangle1")
objRectangle.BackColor = RGB(255,0,0)

It is not necessary to specify the screen name. It is possible to address a screen uniquely using 
the screen window name. Therefore, it is sufficient to specify the name of the screen window, 
as in the following example:

 
'VBS142
Dim objRectangle
Set objRectangle = 
HMIRuntime.Screens("ScreenWindow1.ScreenWindow2").ScreenItems("Rectangle1")

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4518 System Manual, 02/2014



 
objRectangle.BackColor = RGB(255,0,0)

This type of addressing enables objects in screen windows to be addressed in different 
pictures. This is a particularly interesting aspect for the faceplate system.

Making the property dynamic using the return value
In addition to initiating local scripts for properties by means of an event trigger or cyclic trigger, 
you can also make properties dynamic directly by means of a local script. 

In the next example, the background color of an object made dynamic by means of return 
value. The value transferred can be derived from the evaluation of events in the PLC, for 
example, and can be used for graphic visualization of an operating state:

 
'VBS146
Function BackColor_Trigger(ByVal Item)
  BackColor_Trigger = RGB(125,0,0)
End Function

 
 

 Note

If you use a user-defined function to make an object property dynamic by means of the return 
value of a user-defined function, the value of the object property is only written if it has 
changed compared to the last function session. It is not considered if the value had been 
changed from another location.

For this reason, properties that have been made dynamic by means of the return value with 
user-defined functions must not be changed from another location (e.g. other user-defined 
functions). Incorrect values could be displayed if you ignore this rule. 

 

See also
BackColor (Page 5218)

10.8.9.11 Example of configuring the recipe view

Introduction  
Recipe data records are output in the recipe view.

You can add, copy, edit or delete data records.
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Loading and displaying a recipe
The following example loads the "Juice" recipe in the "Control1" recipe view. The recipe is 
displayed in the recipe view.

 
Sub loadUserArchive()
  Dim objUAC
  Set objUAC = ScreenItems("Control1")
  objUAC.BorderColor = RGB(255,0,0)
  objUAC.BorderWidth = 3
  objUAC.Closeable = False
  objUAC.Datasource = "Juice"
End Sub

Copying a recipe data record
The following example copies the recipe data record of line 3. The copy is inserted at the end 
of the table.

 
Sub CopyRow
  Dim objUAC
  Set objUAC = ScreenItems("Control1")
 
  Dim iRowCount
 
  objUAC.AutoCompleteRows = True
 
  objUAC.SelectRow(3)
  objUAC.CopyRows 
 
  iRowCount = objUAC.GetRowCollection.Count
  objUAC.SelectRow(iRowCount + 1)
  objUAC.PasteRows
  objUAC.SelectRow(1)
  objUAC.UnselectAll
End Sub
 

See also
PasteRows   (Page 5854)

SelectRow (Page 5871)

UnselectAll (Page 5888)

BorderColor (Page 5238)

BorderWidth (Page 5252)

Closable (Page 5272)

Overview (Page 4507)
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10.8.9.12 Example of configuring the alarm view

Introduction  
The alarm view displays alarms. You can show, hide, sort, and filter alarms.

Filtering alarms
In this example, only the alarms of alarm number 2 are displayed in the "Control2" alarm view.

 
Sub Filter
  Dim objAlarmControl
 
  'create reference to AlarmControl
  Set objAlarmControl = ScreenItems("Control2")
 
  'set / reset the filter and create a trace
  If (objAlarmControl.MsgFilterSQL = "") Then
     objAlarmControl.MsgFilterSQL = "MSGNR = 2"
  Else
     objAlarmControl.MsgFilterSQL = ""
  End If
End Sub

Removing alarms
In this example, alarms 1-3 will be removed from the alarm view.

 
Sub ResetAlarm
  Dim objAlarm
  'reset alarm 1 - 3
  Set objAlarm = HMIRuntime.Alarms(1)
  objAlarm.State = 2 'hmiAlarmStateGone
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(2)
  objAlarm.State = 2 'hmiAlarmStateGone
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(3)
  objAlarm.State = 2 'hmiAlarmStateGone
  objAlarm.Create
End Sub

Adding alarms
In this example, alarms 1-3 will be added to the alarm view. Alarms 1-3 must be created.

 
Sub SetAlarm
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  Dim objAlarm
 
  'create Alarm 1 - 3
  Set objAlarm = HMIRuntime.Alarms(1)
  objAlarm.State = 1 'hmiAlarmStateCome
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(2)
  objAlarm.State = 1 'hmiAlarmStateCome
  objAlarm.Create
  Set objAlarm = HMIRuntime.Alarms(3)
  objAlarm.State = 1 'hmiAlarmStateCome
  objAlarm.Create
End Sub 
 

See also
Create (Page 5785)

State (Page 5581)

Overview (Page 4507)

10.8.9.13 Example of statistically evaluating tag values

Introduction  
You can use the value table to display the coordinates of trends and the statistical evaluation 
of tag values in tabular form. You connect the value table to the corresponding object for this 
purpose. The evaluated data can be printed out and exported.

Procedure
In the following example, the tag values of the f(t) trend view "Control2" are statistically 
evaluated. To display the result in the statistics area window of the value table, you set the 
following in the value table properties:

● Data source: "Control2"

● Mode: "Statistic area" window"

Add a new button in f(t) trend view and configure the user-defined VB function for it. 

 
Sub OnToolbarButtonClicked(ByVal Item,  ByVal lId)  
  Dim objTrend
  Set objTrend = ScreenItems("Control2")
  objTrend.CalculateStatistic()
End Sub
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See also
CalculateStatistic (Page 5783)

Overview (Page 4507)

10.8.10 Examples of C

10.8.10.1 Overview

Introduction   
You can find examples for C functions:

● Access to objects in the "Screens"editor (e.g. color or text change)

● Determining color of objects

● Configuring a language switch

● Deactivating Runtime

● Configuring a screen change via a property

● Configuring diagnostic output via a trace

● Writing tag values

● Reading tag values

● Writing object properties

See also
Example of accessing objects in the Screens editor (Page 4524)

Example of defining object colors (Page 4524)

Example of configuring a language switch (Page 4525)

Example of deactivating Runtime (Page 4525)

Example of configuring a screen change via a property (Page 4526)

Example of configuring a diagnostics output via a trace (Page 4526)

Example of writing tag values (Page 4527)

Example of reading tag values (Page 4527)

Example of writing object properties (Page 4528)
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10.8.10.2 Example of accessing objects in the Screens editor

Introduction  
To make the graphic Runtime environment dynamic, you can use C scripting to access all 
objects in the "Screens" editor in WinCC. In doing so, you can make graphic objects dynamic 
in response to an operator input, e.g., in response to a mouse click or depending on tag values.

Procedure
In the following example, the radius of a circle is set to 10 in Runtime per mouse click:

 
'C121
SetPropDouble(screenName,"Kreis_1","Radius",10);

See also
SetPropDouble (Page 5962)

Overview (Page 4523)

10.8.10.3 Example of defining object colors

Introduction  
The object colors are defined by means of RGB values (Red/Green/Blue). The color values 
for graphic objects can be set or read. 

Procedure
The following example defines the fill color for "Roundbutton1" to blue:

 
'C122
SetPropertyByConstant (screenName, " Roundbutton1", "FillPatternColor", "65035");

See also
SetPropertyByConstant (Page 5965)

Overview (Page 4523)
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10.8.10.4 Example of configuring a language switch

Introduction   
The Runtime language can be changed by means of VBS. Use buttons with corresponding 
country markings that you place on the start page of your project.

Define the Runtime language by means of country code, for example, 1031 for German - 
Default, 1033 for English - USA etc. An overview of all country codes is available in the basics 
of VBScript, "Regional Scheme ID (LCID) Diagram".

Procedure
Create a user-defined C function for a button for the "Mouse click" event, and enter the following 
code to switch the Runtime language to German:

 
'C123
SetLanguageByLocaleID(1033);

See also
SetLanguageByLocaleID (Page 5958)

Overview (Page 4523)

10.8.10.5 Example of deactivating Runtime

Introduction 
You can use C functions to exit Runtime, for example, by means of mouse click, or depending 
on tag values, or on other events.

Procedure
The following example terminates WinCC Runtime:

 
'C124
StopRuntime(hmiStopRuntime);

See also
StopRuntime (Page 5996)

Overview (Page 4523)
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10.8.10.6 Example of configuring a screen change via a property

Introduction   
If using split screens in your configuration, for example, the title and operating bar for the user 
interface in a basic screen and an embedded screen window for the actual screen display, 
configure a screen change using the properties of the screen window.

The property of screen window "ScreenName" must be changed so that the other screen is 
displayed. The C function and screen window must be configured in the same screen.

Procedure
In the next example, the "test" screen is displayed in a "ScreenWindow" when you execute 
the C function:

 
'C126
ActivateScreenInScreenWindow (screenName, "ScreenWindow", "test");

See also
ActivateScreenInScreenWindow (Page 5900)

Overview (Page 4523)

10.8.10.7 Example of configuring a diagnostics output via a trace

Introduction   
If you have inserted a GSC diagnostics window in your screen, you can use the trace command 
to display diagnostics outputs in the diagnostics window in Runtime.

GSC diagnostics returns the trace methods contained in the functions in the order in which 
they were called. This also applies to trace instructions in functions that are called in user-
defined functions. The targeted use of trace instructions allows you to trace the flow of user-
defined functions and the functions called therein. You enter the trace instruction in the form 
"printf(<Output>)".

The GSC diagnostics window displays trace outputs of C functions.

Outputting text
The following example writes a text in the diagnostics window:

 
'C127
printf("Customized C script error message\r\n");
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See also
Overview (Page 4523)

10.8.10.8 Example of writing tag values

Introduction   
You can use C functions to write the tag value to the PLC, foe example, by mouse click on a 
setpoint button, or to set internal tag values for triggering other functions. 

Simple writing
In the following example, a value is written to the "Tag1" tag:

 
'C128
int value;
value = 7;
SetTagSDWord("Tag1", value);

See also
Overview (Page 4523)

10.8.10.9 Example of reading tag values

Introduction   
C functions can be used to read and further process a tag value. This allows you to click a 
button, for example, to obtain information on the system status or to perform calculations.

Simple reading
In the following example, the value of "Tag1" is read and displayed in the Global Script 
diagnostics window:

 
'C134
int value;
value = GetTagGetTagSDWord("Tag1");

See also
Overview (Page 4523)
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10.8.10.1
0

Example of writing object properties

Introduction   
C functions provide access to the properties of all display and operating objects in the 
"Screens" editor. You can read out properties or change them during Runtime.

The following example shows how to access a property.

Simple setting of a property
In the next example, the background color of the "Button1" object in the screen is set to red:

 
'C139
SetPropLong("Screen_1","Button1","ForeColor",65333);

See also
SetPropLong (Page 5964)

Overview (Page 4523)

10.8.11 Reference

10.8.11.1 Function list

Device dependency

System functions for Basic Panels

 Availability of system functions
The following table shows the availability of the system functions on the Basic Panels.

Technical data subject to change.     
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Overview

 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

User-defined functions No No No No No No No No
Logoff (Page 4567) Yes Yes Yes Yes Yes Yes Yes Yes
ActivateScreen (Page 4567) Yes Yes Yes Yes Yes Yes Yes Yes
ActivateScreenByNumber 
(Page 4568) 

Yes Yes Yes Yes Yes Yes Yes Yes

ActivateCleanScreen 
(Page 4569) 

No No Yes Yes Yes Yes Yes Yes

ActivateSystemDiagnosticsVie
w (Page 4678) 

No No No No No No No No

ActivatePreviousScreen 
(Page 4570) 

Yes Yes Yes Yes Yes Yes Yes Yes

UpdateTag (Page 4571) Yes Yes Yes Yes Yes Yes Yes Yes
AdjustContrast (Page 4571) Yes No Yes No Yes 1) Yes Yes Yes
Logon (Page 4572) Yes Yes Yes Yes Yes Yes Yes Yes
ArchiveLogFile (Page 4573) No No No No No No No No
LogTag (Page 4574) No No No No No No No No
EditAlarm (Page 4575) Yes Yes Yes Yes Yes Yes Yes No
ScreenObjectCursorDown 
(Page 4575) 

Yes Yes Yes Yes Yes Yes Yes Yes

ScreenObjectCursorUp 
(Page 4576) 

Yes Yes Yes Yes Yes Yes Yes Yes

ScreenObjectPageDown 
(Page 4576) 

Yes Yes Yes Yes Yes Yes Yes Yes

ScreenObjectPageUp 
(Page 4577) 

Yes Yes Yes Yes Yes Yes Yes Yes

Encode (Page 4577) No No No No No No No No
EncodeEx (Page 4578) No No No No No No No No
DirectKey (Page 4579) No No No No No No No No
DirectKeyScreenNumber 
(Page 4582) 

No No No No No No No No

PrintScreen (Page 4582) No No No No No No No No
PrintReport (Page 4583) No No No No No No No No
NotifyUserAction (Page 4584) No No No No No No No No
IncreaseFocusedValue 
(Page 4585) 

Yes Yes Yes Yes Yes Yes Yes No

IncreaseTag (Page 4586) Yes Yes Yes Yes Yes Yes Yes Yes
ExportDataRecords 
(Page 4586) 

No No No No No No No No

ExportDataRecordsWithCheck
sum (Page 4589) 

No No No No No No No No
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 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

ExportImportUserAdministratio
n (Page 4591) 

No No No No No No No No

GoToHome (Page 4592) Yes Yes Yes Yes Yes Yes Yes No
GoToEnd (Page 4593) Yes Yes Yes Yes Yes Yes Yes No
SafelyRemoveHardware 
(Page 4593) 

No No No No No No No No

HTMLBrowserStop 
(Page 4594) 

No No No No No No No No

HTMLBrowserRefresh 
(Page 4594) 

No No No No No No No No

HTMLBrowserForward 
(Page 4595) 

No No No No No No No No

HTMLBrowserBack 
(Page 4595) 

No No No No No No No No

ImportDataRecords 
(Page 4596) 

No No No No No No No No

ImportDataRecordsWithCheck
sum (Page 4597) 

No No No No No No No No

InvertBit (Page 4599) Yes Yes Yes Yes Yes Yes Yes Yes
InvertBitInTag (Page 4600) Yes Yes Yes Yes Yes Yes Yes Yes
InvertLinearScaling 
(Page 4601) 

Yes Yes Yes Yes Yes Yes Yes Yes

CalibrateTouchScreen 
(Page 4602) 

No No Yes Yes Yes Yes Yes Yes

CopyLog (Page 4603) No No No No No No No No
TrendViewScrollForward 
(Page 4604) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewScrollBack 
(Page 4605) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewExtend (Page 4605) Yes Yes Yes Yes Yes Yes Yes Yes
TrendViewCompress 
(Page 4605) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewRulerLeft 
(Page 4606) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewRulerRight 
(Page 4607) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewSetRulerMode 
(Page 4607) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewStartStop 
(Page 4608) 

Yes Yes Yes Yes Yes Yes Yes Yes

TrendViewBackToBeginning 
(Page 4608) 

Yes Yes Yes Yes Yes Yes Yes Yes

LoadDataRecord (Page 4609) No No No No No No No No
GetUserName (Page 4610) Yes Yes Yes Yes Yes Yes Yes Yes
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 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

GetDataRecordFromPLC 
(Page 4610) 

No No No No No No No No

GetDataRecordName 
(Page 4612) 

No No No No No No No No

GetDataRecordTagsFromPLC 
(Page 4614) 

No No No No No No No No

GetGroupNumber (Page 4614) Yes Yes Yes Yes Yes Yes Yes Yes
GetBrightness (Page 4615) No No No No No No No No
GetPassword (Page 4615) Yes Yes Yes Yes Yes Yes Yes Yes
LinearScaling (Page 4617) Yes Yes Yes Yes Yes Yes Yes Yes
ClearLog (Page 4618) No No No No No No No No
ClearDataRecord (Page 4619) No No No No No No No No
ClearDataRecordMemory 
(Page 4620) 

No No No No No No No No

ClearAlarmBuffer (Page 4621) Yes Yes Yes Yes Yes Yes Yes Yes
ClearAlarmBufferProTool 
(Page 4622) 

Yes Yes Yes Yes Yes Yes Yes Yes

AlarmViewUpdate 
(Page 4623) 

No No No No No No No No

AlarmViewEditAlarm 
(Page 4623) 

Yes Yes Yes Yes Yes Yes Yes Yes

AlarmViewAcknowledgeAlarm 
(Page 4624) 

Yes Yes Yes Yes Yes Yes Yes Yes

AlarmViewShowOperatorNote
s (Page 4624) 

Yes Yes Yes Yes Yes Yes Yes Yes

OpenAllLogs (Page 4625) No No No No No No No No
OpenScreenKeyboard 
(Page 4626) 

No No No No No No No No

OpenControlPanelDialog 
(Page 4628)

Yes 2) Yes 2) Yes 2) Yes 2) Yes 2) Yes 2) Yes 2) Yes 2)

OpenCommandPrompt 
(Page 4629) 

No No No No No No No No

OpenInternetExplorer 
(Page 4629) 

No No No No No No No No

OpenControlPanel 
(Page 4630) 

No No No No No No No No

OpenTaskManager 
(Page 4631) 

No No No No No No No No

AcknowledgeAlarm 
(Page 4631) 

Yes Yes Yes Yes Yes Yes Yes No

RecipeViewNewDataRecord 
(Page 4632) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewGetDataRecordFro
mPLC (Page 4632) 

Yes Yes Yes Yes Yes Yes Yes Yes
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 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

RecipeViewClearDataRecord 
(Page 4633) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewMenu (Page 4633) Yes Yes Yes Yes Yes Yes Yes Yes
RecipeViewOpen (Page 4634) Yes Yes Yes Yes Yes Yes Yes Yes
RecipeViewSetDataRecordTo
PLC (Page 4634) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 4635) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewSaveAsDataRecor
d (Page 4635) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewSynchronizeDataR
ecordWithTags (Page 4636) 

No No No No No No No No

RecipeViewRenameDataReco
rd (Page 4636) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewShowOperatorNot
es (Page 4637) 

Yes Yes Yes Yes Yes Yes Yes Yes

RecipeViewBack (Page 4637) Yes Yes Yes Yes Yes Yes Yes Yes
ResetBit (Page 4638) Yes Yes Yes Yes Yes Yes Yes Yes
ResetBitInTag (Page 4639) Yes Yes Yes Yes Yes Yes Yes Yes
PressButton (Page 4640) Yes Yes Yes Yes Yes Yes Yes No
ReleaseButton (Page 4641) Yes Yes Yes Yes Yes Yes Yes No
ShiftAndMask (Page 4642) Yes Yes Yes Yes Yes Yes Yes Yes
CloseAllLogs (Page 4643) No No No No No No No No
SetDataRecordToPLC 
(Page 4644) 

No No No No No No No No

SetDataRecordTagsToPLC 
(Page 4645) 

No No No No No No No No

PageDown (Page 4646) Yes Yes Yes Yes Yes Yes Yes No
PageUp (Page 4646) Yes Yes Yes Yes Yes Yes Yes No
SendEMail (Page 4647) No No No No No No No No
SetAcousticSignal 
(Page 4648) 

No No No No No No No No

SetDisplayMode (Page 4648) No No No No No No No No
SetDeviceMode (Page 4649) Yes Yes Yes Yes Yes Yes Yes Yes
SetBit (Page 4650) Yes Yes Yes Yes Yes Yes Yes Yes
SetBitInTag (Page 4651) Yes Yes Yes Yes Yes Yes Yes Yes
SetBitWhileKeyPressed 
(Page 4652) 

Yes Yes Yes Yes Yes Yes Yes Yes

SetBacklightColor (Page 4654) Yes Yes No No No No No No
SetBrightness (Page 4654) No Yes No No No No No No
SetScreenKeyboardMode 
(Page 4655) 

No No No No No No No No
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 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

SetAlarmReportMode 
(Page 4657) 

No No No No No No No No

SetRecipeTags (Page 4657) No No No No No No No No
SetDaylightSavingTime 
(Page 4659) 

No No No No No No No No

SetLanguage (Page 4659) Yes Yes Yes Yes Yes Yes Yes Yes
SetTag (Page 4661) Yes Yes Yes Yes Yes Yes Yes Yes
SetConnectionMode 
(Page 4662) 

Yes Yes Yes Yes Yes Yes Yes Yes

SetWebAccess (Page 4664) No No No No No No No No
BackupRAMFileSystem 
(Page 4664) 

No No No No No No No No

SimulateSystemKey 
(Page 4665) 

Yes Yes Yes Yes Yes Yes Yes No

SimulateTag (Page 4666) Yes Yes Yes Yes Yes Yes Yes Yes
SmartClientViewRefresh 
(Page 4667) 

No No No No No No No No

SmartClientViewReadOnlyOff 
(Page 4667) 

No No No No No No No No

SmartClientViewReadOnlyOn 
(Page 4668) 

No No No No No No No No

SmartClientViewDisconnect 
(Page 4668) 

No No No No No No No No

SmartClientViewConnect 
(Page 4669) 

No No No No No No No No

SmartClientViewLeave 
(Page 4669) 

No No No No No No No No

SaveDataRecord (Page 4670) No No No No No No No No
StartLogging (Page 4671) No No No No No No No No
StartNextLog (Page 4672) No No No No No No No No
StartProgram (Page 4672) No No No No No No No No
StatusForceGetValues 
(Page 4674) 

No No No No No No No No

StatusForceSetValues 
(Page 4674) 

No No No No No No No No

ControlSmartServer 
(Page 4675) 

No No No No No No No No

ControlWebServer 
(Page 4675) 

No No No No No No No No

StopLogging (Page 4676) No No No No No No No No
StopRuntime (Page 4677) Yes Yes Yes Yes Yes Yes Yes Yes
LookupText (Page 4681) No No No No No No No No
ResetTagToHandWheel 
(Page 4682) 

No No No No No No No No
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 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

SetTagToHandWheel 
(Page 4683) 

No No No No No No No No

TraceUserChange 
(Page 4683) 

Yes Yes Yes Yes Yes Yes Yes Yes

DecreaseFocusedValue 
(Page 4684) 

Yes Yes Yes Yes Yes Yes Yes No

DecreaseTag (Page 4684) Yes Yes Yes Yes Yes Yes Yes Yes
ChangeConnection 
(Page 4685) 

Yes Yes Yes Yes Yes Yes Yes Yes

WinACMPUpdateControllerFor
StartAtBoot (Page 4690) 

No No No No No No No No

WinACMPUpdateKeySwitchSe
tting (Page 4691) 

No No No No No No No No

WinACMPUpdateBUSF1LED 
(Page 4692) 

No No No No No No No No

WinACMPUpdateBUSF2LED 
(Page 4693) 

No No No No No No No No

WinACMPUpdateAverageExe
cTime (Page 4694) 

No No No No No No No No

WinACMPUpdateAverageCycl
eTime (Page 4695) 

No No No No No No No No

WinACMPUpdateEXTFLED 
(Page 4696) 

No No No No No No No No

WinACMPUpdateHMIEnableTi
me (Page 4697) 

No No No No No No No No

WinACMPUpdateINTFLED 
(Page 4698) 

No No No No No No No No

WinACMPUpdateLastCycleTi
me (Page 4699) 

No No No No No No No No

WinACMPUpdateMaximumCy
cleTime (Page 4700) 

No No No No No No No No

WinACMPUpdateMinimumCyc
leTime (Page 4701) 

No No No No No No No No

WinACMPUpdatePowerLED 
(Page 4701) 

No No No No No No No No

WinACMPUpdateSleepTime 
(Page 4702) 

No No No No No No No No

WinACMPUpdateRUNLED 
(Page 4703) 

No No No No No No No No

WinACMPUpdateSTOPLED 
(Page 4704) 

No No No No No No No No

WinACMPArchive (Page 4705) No No No No No No No No
WinACMPGetStartMode 
(Page 4706) 

No No No No No No No No
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 KP300 
Basic PN

KP400 
Basic PN

KTP400 
Basic PN

KTP600 
Basic DP

KTP600 
Basic PN

KTP100
0 Basic 
DP

KTP100
0 Basic 
PN

TP150
0 Basic 
PN

WinACMPGetVersion 
(Page 4706) 

No No No No No No No No

WinACMPClearCycleTimeBuff
er (Page 4707) 

No No No No No No No No

WinACMPSetStartAtBoot 
(Page 4707) 

No No No No No No No No

WinACMPSetKeySwitch 
(Page 4708) 

No No No No No No No No

WinACMPSetHMIEnableTime 
(Page 4708) 

No No No No No No No No

WinACMPSetRestartMethod 
(Page 4709) 

No No No No No No No No

WinACMPSetSleepTime 
(Page 4709) 

No No No No No No No No

WinACMPSetStartMode 
(Page 4710) 

No No No No No No No No

WinACMPStartHistogram 
(Page 4710) 

No No No No No No No No

WinACMPControl (Page 4711) No No No No No No No No
WinACMPStopHistogram 
(Page 4712) 

No No No No No No No No

WinACMPRestore 
(Page 4712) 

No No No No No No No No

ShowLogonDialog 
(Page 4686) 

Yes Yes Yes Yes Yes Yes Yes Yes

ShowOperatorNotes 
(Page 4687) 

Yes Yes Yes Yes Yes Yes Yes Yes

ShowAlarmWindow 
(Page 4688) 

Yes Yes Yes Yes Yes Yes Yes Yes

ShowSoftwareVersion 
(Page 4688) 

No No No No No No No No

ShowSystemDiagnosticsWind
ow (Page 4689) 

No No No No No No No No

ShowSystemAlarm 
(Page 4690) 

No No No No No No No No

1) For KTP600 Basic mono PN only
2) Only for editing the IP settings

System functions for Panels

Availability of system functions
The following table shows the availability of the system functions on the Panels. 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4535



Technical data subject to change.       

Overview

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

User-defined functions No No No No No Yes
Logoff (Page 4567) Yes Yes Yes Yes Yes Yes
ActivateScreen (Page 4567) Yes Yes Yes Yes Yes Yes
ActivateScreenByNumber 
(Page 4568) 

Yes Yes Yes Yes Yes Yes

ActivateCleanScreen (Page 4569) No No No Yes Yes 4) Yes 2)

ActivateSystemDiagnosticsView 
(Page 4678) 

No No No No No No

ActivatePreviousScreen 
(Page 4570) 

Yes Yes Yes Yes Yes Yes

UpdateTag (Page 4571) Yes Yes No Yes Yes Yes
AdjustContrast (Page 4571) Yes Yes Yes Yes Yes No
Logon (Page 4572) Yes Yes Yes Yes Yes Yes
ArchiveLogFile (Page 4573) No No No No No Yes
LogTag (Page 4574) No No No No No Yes
EditAlarm (Page 4575) Yes Yes Yes No Yes Yes 1)

ScreenObjectCursorDown 
(Page 4575) 

Yes Yes Yes Yes Yes Yes

ScreenObjectCursorUp 
(Page 4576) 

Yes Yes Yes Yes Yes Yes

ScreenObjectPageDown 
(Page 4576) 

Yes Yes Yes Yes Yes Yes

ScreenObjectPageUp (Page 4577) Yes Yes Yes Yes Yes Yes
Encode (Page 4577) No No Yes Yes Yes Yes
EncodeEx (Page 4578) No No Yes Yes Yes Yes
DirectKey (Page 4579) No No No No Yes) Yes 2)

DirectKeyScreenNumber 
(Page 4582) 

No No No No Yes) Yes 2)

PrintScreen (Page 4582) No No Yes No Yes Yes
PrintReport (Page 4583) No No Yes No Yes Yes
NotifyUserAction (Page 4584) No No No No No Yes
IncreaseFocusedValue 
(Page 4585) 

Yes Yes Yes No Yes 1) Yes 1)

IncreaseTag (Page 4586) Yes Yes Yes Yes Yes Yes
ExportDataRecords (Page 4586) No No Yes No Yes Yes
ExportDataRecordsWithChecksum 
(Page 4589) 

No No No No No Yes

ExportImportUserAdministration 
(Page 4591) 

No No Yes No Yes Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

GoToHome (Page 4592) Yes Yes Yes No Yes 1) Yes 1)

GoToEnd (Page 4593) Yes Yes Yes No Yes 1) Yes 1)

SafelyRemoveHardware 
(Page 4593) 

No No No No Yes 5) No

HTMLBrowserStop (Page 4594) No No No No No No
HTMLBrowserRefresh (Page 4594) No No No No No No
HTMLBrowserForward (Page 4595) No No No No No No
HTMLBrowserBack (Page 4595) No No No No No No
ImportDataRecords (Page 4596) No No Yes No Yes Yes
ImportDataRecordsWithChecksum 
(Page 4597) 

No No No No No Yes

InvertBit (Page 4599) Yes Yes Yes Yes Yes Yes
InvertBitInTag (Page 4600) Yes Yes Yes Yes Yes Yes
InvertLinearScaling (Page 4601) Yes Yes Yes Yes Yes Yes
CalibrateTouchScreen (Page 4602) No No No Yes Yes Yes 2)

CopyLog (Page 4603) No No No No No Yes
TrendViewScrollForward 
(Page 4604) 

No No No Yes Yes Yes

TrendViewScrollBack (Page 4605) No No No Yes Yes Yes
TrendViewExtend (Page 4605) No No No Yes Yes Yes
TrendViewCompress (Page 4605) No No No Yes Yes Yes
TrendViewRulerLeft (Page 4606) No No No Yes Yes Yes
TrendViewRulerRight (Page 4607) No No No Yes Yes Yes
TrendViewSetRulerMode 
(Page 4607) 

No No No Yes Yes Yes

TrendViewStartStop (Page 4608) No No No Yes Yes Yes
TrendViewBackToBeginning 
(Page 4608) 

No No No Yes Yes Yes

LoadDataRecord (Page 4609) No No No No Yes Yes
GetUserName (Page 4610) Yes Yes Yes Yes Yes Yes
GetDataRecordFromPLC 
(Page 4610) 

No No No No Yes Yes

GetDataRecordName (Page 4612) No No No No Yes Yes
GetDataRecordTagsFromPLC 
(Page 4614) 

No No No No Yes Yes

GetGroupNumber (Page 4614) Yes Yes Yes Yes Yes Yes
GetBrightness (Page 4615) No No No No No No
GetPassword (Page 4615) Yes Yes Yes Yes Yes Yes
LinearScaling (Page 4617) Yes Yes Yes Yes Yes Yes
ClearLog (Page 4618) No No No No No Yes
ClearDataRecord (Page 4619) No No No No Yes Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

ClearDataRecordMemory 
(Page 4620) 

No No No No Yes Yes

ClearAlarmBuffer (Page 4621) Yes Yes Yes Yes Yes Yes
ClearAlarmBufferProTool 
(Page 4622) 

Yes Yes Yes No Yes Yes

AlarmViewUpdate (Page 4623) No No Yes No Yes Yes
AlarmViewEditAlarm (Page 4623) Yes Yes Yes Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 4624) 

Yes Yes Yes Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 4624) 

Yes Yes Yes Yes Yes Yes

OpenAllLogs (Page 4625) No No No No No Yes
OpenScreenKeyboard (Page 4626) No No No No No Yes
OpenControlPanelDialog 
(Page 4628)

No No No No No No

OpenCommandPrompt 
(Page 4629) 

No No No No No Yes

OpenInternetExplorer (Page 4629) No No No No Yes 3) Yes
OpenControlPanel (Page 4630) No No No No Yes Yes
OpenTaskManager (Page 4631) No No No No No Yes
AcknowledgeAlarm (Page 4631) Yes Yes Yes No Yes 1) 4) Yes 1)

RecipeViewNewDataRecord 
(Page 4632) 

No Yes Yes Yes Yes Yes

RecipeViewGetDataRecordFromPL
C (Page 4632) 

No Yes Yes Yes Yes Yes

RecipeViewClearDataRecord 
(Page 4633) 

No Yes Yes Yes Yes Yes

RecipeViewMenu (Page 4633) No Yes Yes Yes Yes Yes
RecipeViewOpen (Page 4634) No Yes Yes Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 4634) 

No Yes Yes Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 4635) 

No Yes Yes Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 4635) 

No Yes Yes Yes Yes Yes

RecipeViewSynchronizeDataRecor
dWithTags (Page 4636) 

No No No No Yes Yes

RecipeViewRenameDataRecord 
(Page 4636) 

No Yes Yes Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 4637) 

No Yes Yes Yes Yes Yes

RecipeViewBack (Page 4637) No Yes Yes Yes Yes Yes
ResetBit (Page 4638) Yes Yes Yes Yes Yes Yes
ResetBitInTag (Page 4639) Yes Yes Yes Yes Yes Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

PressButton (Page 4640) Yes Yes Yes No Yes) Yes)

ReleaseButton (Page 4641) Yes Yes Yes No Yes Yes 1)

ShiftAndMask (Page 4642) Yes Yes Yes Yes Yes Yes
CloseAllLogs (Page 4643) No No No No No Yes
SetDataRecordToPLC (Page 4644) No No No No Yes Yes
SetDataRecordTagsToPLC 
(Page 4645) 

No No No No Yes Yes

PageDown (Page 4646) Yes Yes Yes No Yes 1) 4) Yes 1)

PageUp (Page 4646) Yes Yes Yes No yes 1).4) Yes 1)

SendEMail (Page 4647) Yes Yes Yes No Yes 3) Yes
SetAcousticSignal (Page 4648) No No No No No No
SetDisplayMode (Page 4648) No No No No No No
SetDeviceMode (Page 4649) Yes Yes Yes Yes Yes Yes
SetBit (Page 4650) Yes Yes Yes Yes Yes Yes
SetBitInTag (Page 4651) Yes Yes Yes Yes Yes Yes
SetBitWhileKeyPressed 
(Page 4652) 

Yes Yes Yes Yes Yes Yes

SetBacklightColor (Page 4654) No No No No No No
SetBrightness (Page 4654) No No No No No No
SetScreenKeyboardMode 
(Page 4655) 

No No No No No Yes

SetAlarmReportMode (Page 4657) No No Yes No Yes Yes
SetRecipeTags (Page 4657) No No Yes No Yes Yes
SetDaylightSavingTime 
(Page 4659) 

No No No No No No

SetLanguage (Page 4659) Yes Yes Yes Yes Yes Yes
SetTag (Page 4661) Yes Yes Yes Yes Yes Yes
SetConnectionMode (Page 4662) Yes Yes Yes Yes Yes Yes
SetWebAccess (Page 4664) No No No No Yes Yes
BackupRAMFileSystem 
(Page 4664) 

No No No No No No

SimulateSystemKey (Page 4665) No No Yes No yes 1) 4) Yes 1)

SimulateTag (Page 4666) Yes Yes Yes Yes Yes Yes
SmartClientViewRefresh 
(Page 4667) 

No No No No Yes 3) Yes

SmartClientViewReadOnlyOff 
(Page 4667) 

No No No No Yes 3) Yes

SmartClientViewReadOnlyOn 
(Page 4668) 

No No No No Yes 3) Yes

SmartClientViewDisconnect 
(Page 4668) 

No No No No Yes 3) Yes

SmartClientViewConnect 
(Page 4669) 

No No No No Yes 3) Yes
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

SmartClientViewLeave (Page 4669) No No No No Yes 3) Yes
SaveDataRecord (Page 4670) No No No No Yes Yes
StartLogging (Page 4671) No No No No No Yes
StartNextLog (Page 4672) No No No No No Yes
StartProgram (Page 4672) No No No No No Yes
StatusForceGetValues (Page 4674) No No No No Yes Yes
StatusForceSetValues (Page 4674) No No No No Yes Yes
ControlSmartServer (Page 4675) No No No No Yes 3) Yes
ControlWebServer (Page 4675) No No No No Yes 3) Yes
StopLogging (Page 4676) No No No No No Yes
StopRuntime (Page 4677) Yes Yes Yes Yes Yes Yes
LookupText (Page 4681) No No Yes No Yes Yes
ResetTagToHandWheel 
(Page 4682) 

No No No No No No

SetTagToHandWheel (Page 4683) No No No No No No
TraceUserChange (Page 4683) Yes Yes Yes Yes Yes Yes
DecreaseFocusedValue 
(Page 4684) 

Yes Yes Yes No yes 1)4) Yes 1)

DecreaseTag (Page 4684) Yes Yes Yes Yes Yes Yes
ChangeConnection (Page 4685) Yes Yes Yes Yes Yes Yes
WinACMPUpdateControllerForStart
AtBoot (Page 4690) 

No No No No No No

WinACMPUpdateKeySwitchSetting 
(Page 4691) 

No No No No No No

WinACMPUpdateBUSF1LED 
(Page 4692) 

No No No No No No

WinACMPUpdateBUSF2LED 
(Page 4693) 

No No No No No No

WinACMPUpdateAverageExecTim
e (Page 4694) 

No No No No No No

WinACMPUpdateAverageCycleTim
e (Page 4695) 

No No No No No No

WinACMPUpdateEXTFLED 
(Page 4696) 

No No No No No No

WinACMPUpdateHMIEnableTime 
(Page 4697) 

No No No No No No

WinACMPUpdateINTFLED 
(Page 4698) 

No No No No No No

WinACMPUpdateLastCycleTime 
(Page 4699) 

No No No No No No

WinACMPUpdateMaximumCycleTi
me (Page 4700) 

No No No No No No

WinACMPUpdateMinimumCycleTi
me (Page 4701) 

No No No No No No
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 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

WinACMPUpdatePowerLED 
(Page 4701) 

No No No No No No

WinACMPUpdateSleepTime 
(Page 4702) 

No No No No No No

WinACMPUpdateRUNLED 
(Page 4703) 

No No No No No No

WinACMPUpdateSTOPLED 
(Page 4704) 

No No No No No No

WinACMPArchive (Page 4705) No No No No No No
WinACMPGetStartMode 
(Page 4706) 

No No No No No No

WinACMPGetVersion (Page 4706) No No No No No No
WinACMPClearCycleTimeBuffer 
(Page 4707) 

No No No No No No

WinACMPSetStartAtBoot 
(Page 4707) 

No No No No No No

WinACMPSetKeySwitch 
(Page 4708) 

No No No No No No

WinACMPSetHMIEnableTime 
(Page 4708) 

No No No No No No

WinACMPSetRestartMethod 
(Page 4709) 

No No No No No No

WinACMPSetSleepTime 
(Page 4709) 

No No No No No No

WinACMPSetStartMode 
(Page 4710) 

No No No No No No

WinACMPStartHistogram 
(Page 4710) 

No No No No No No

WinACMPControl (Page 4711) No No No No No No
WinACMPStopHistogram 
(Page 4712) 

No No No No No No

WinACMPRestore (Page 4712) No No No No No No
ShowLogonDialog (Page 4686) Yes Yes Yes Yes Yes Yes
ShowOperatorNotes (Page 4687) Yes Yes Yes Yes Yes Yes
ShowAlarmWindow (Page 4688) Yes Yes Yes Yes Yes Yes
ShowSoftwareVersion (Page 4688) No No No No No Yes
ShowSystemDiagnosticsWindow 
(Page 4689) 

No No No No No No

ShowSystemAlarm (Page 4690) No No Yes No Yes Yes

1) only with keyboard units
2) only with touch screen devices
3) only with PROFINET Bus (PN devices)
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4) only with TP 177B
5) Only for TP 177B 4" PN/DP

System functions for Multi Panels

Availability of system functions
The following table shows the availability of the system functions on the Multi Panels. 

Technical data subject to change.       

Overview

 MP 177 MP 277 MP 377
User-defined functions No Yes Yes
Logoff (Page 4567) Yes Yes Yes
ActivateScreen (Page 4567) Yes Yes Yes
ActivateScreenByNumber (Page 4568) Yes Yes Yes
ActivateCleanScreen (Page 4569) Yes2) Yes2) Yes2)

ActivateSystemDiagnosticsView 
(Page 4678) 

No No No

ActivatePreviousScreen (Page 4570) Yes Yes Yes
UpdateTag (Page 4571) Yes Yes Yes
AdjustContrast (Page 4571) No No No
Logon (Page 4572) Yes Yes Yes
ArchiveLogFile (Page 4573) No Yes Yes
LogTag (Page 4574) No Yes Yes
EditAlarm (Page 4575) No Yes1) No
ScreenObjectCursorDown 
(Page 4575) 

Yes Yes Yes

ScreenObjectCursorUp (Page 4576) Yes Yes Yes
ScreenObjectPageDown (Page 4576) Yes Yes Yes
ScreenObjectPageUp (Page 4577) Yes Yes Yes
Encode (Page 4577) Yes Yes Yes
EncodeEx (Page 4578) Yes Yes Yes
DirectKey (Page 4579) Yes2) Yes2) Yes2)

DirectKeyScreenNumber (Page 4582) Yes2) Yes2) Yes2)

PrintScreen (Page 4582) Yes Yes Yes
PrintReport (Page 4583) Yes Yes Yes
NotifyUserAction (Page 4584) No Yes Yes
IncreaseFocusedValue (Page 4585) Yes1) Yes1) Yes1)

IncreaseTag (Page 4586) Yes Yes Yes
ExportDataRecords (Page 4586) Yes Yes Yes
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 MP 177 MP 277 MP 377
ExportDataRecordsWithChecksum 
(Page 4589) 

Yes Yes Yes

ExportImportUserAdministration 
(Page 4591) 

Yes Yes Yes

GoToHome (Page 4592) Yes1) Yes1) Yes1)

GoToEnd (Page 4593) Yes1) Yes1) Yes1)

SafelyRemoveHardware (Page 4593) No Yes Yes
HTMLBrowserStop (Page 4594) No No No
HTMLBrowserRefresh (Page 4594) No No No
HTMLBrowserForward (Page 4595) No No No
HTMLBrowserBack (Page 4595) No No No
ImportDataRecords (Page 4596) Yes Yes Yes
ImportDataRecordsWithChecksum 
(Page 4597) 

Yes Yes Yes

InvertBit (Page 4599) Yes Yes Yes
InvertBitInTag (Page 4600) Yes Yes Yes
InvertLinearScaling (Page 4601) Yes Yes Yes
CalibrateTouchScreen (Page 4602) Yes2) Yes2) Yes2)

CopyLog (Page 4603) No Yes Yes
TrendViewScrollForward (Page 4604) Yes Yes Yes
TrendViewScrollBack (Page 4605) Yes Yes Yes
TrendViewExtend (Page 4605) Yes Yes Yes
TrendViewCompress (Page 4605) Yes Yes Yes
TrendViewRulerLeft (Page 4606) Yes Yes Yes
TrendViewRulerRight (Page 4607) Yes Yes Yes
TrendViewSetRulerMode (Page 4607) Yes Yes Yes
TrendViewStartStop (Page 4608) Yes Yes Yes
TrendViewBackToBeginning 
(Page 4608) 

Yes Yes Yes

LoadDataRecord (Page 4609) Yes Yes Yes
GetUserName (Page 4610) Yes Yes Yes
GetDataRecordFromPLC (Page 4610) Yes Yes Yes
GetDataRecordName (Page 4612) Yes Yes Yes
GetDataRecordTagsFromPLC 
(Page 4614) 

Yes Yes Yes

GetGroupNumber (Page 4614) Yes Yes Yes
GetBrightness (Page 4615) No No No
GetPassword (Page 4615) Yes Yes Yes
LinearScaling (Page 4617) Yes Yes Yes
ClearLog (Page 4618) No Yes Yes
ClearDataRecord (Page 4619) Yes Yes Yes
ClearDataRecordMemory (Page 4620) Yes Yes Yes
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 MP 177 MP 277 MP 377
ClearAlarmBuffer (Page 4621) Yes Yes Yes
ClearAlarmBufferProTool (Page 4622) Yes Yes Yes
AlarmViewUpdate (Page 4623) Yes Yes Yes
AlarmViewEditAlarm (Page 4623) Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 4624) 

Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 4624) 

Yes Yes Yes

OpenAllLogs (Page 4625) No Yes Yes
OpenScreenKeyboard (Page 4626) No Yes Yes
OpenControlPanelDialog No No No
OpenCommandPrompt (Page 4629) No Yes Yes
OpenInternetExplorer (Page 4629) No Yes Yes
OpenControlPanel Yes Yes Yes
OpenTaskManager (Page 4631) No Yes Yes
AcknowledgeAlarm (Page 4631) Yes1) Yes1) Yes1)

RecipeViewNewDataRecord 
(Page 4632) 

Yes Yes Yes

RecipeViewGetDataRecordFromPLC 
(Page 4632) 

Yes Yes Yes

RecipeViewClearDataRecord 
(Page 4633) 

Yes Yes Yes

RecipeViewMenu (Page 4633) Yes Yes Yes
RecipeViewOpen (Page 4634) Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 4634) 

Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 4635) 

Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 4635) 

Yes Yes Yes

RecipeViewSynchronizeDataRecordW
ithTags (Page 4636) 

Yes Yes Yes

RecipeViewRenameDataRecord 
(Page 4636) 

Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 4637) 

Yes Yes Yes

RecipeViewBack (Page 4637) Yes Yes Yes
ResetBit (Page 4638) Yes Yes Yes
ResetBitInTag (Page 4639) Yes Yes Yes
PressButton (Page 4640) Yes Yes Yes)

ReleaseButton (Page 4641) Yes) Yes) Yes)

ShiftAndMask (Page 4642) Yes Yes Yes
CloseAllLogs (Page 4643) No Yes Yes
SetDataRecordToPLC (Page 4644) Yes Yes Yes
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 MP 177 MP 277 MP 377
SetDataRecordTagsToPLC 
(Page 4645) 

Yes Yes Yes

PageDown (Page 4646) Yes1) Yes1) Yes1)

PageUp (Page 4646) Yes1) Yes1) Yes1)

SendEMail (Page 4647) Yes Yes Yes
SetAcousticSignal (Page 4648) No Yes2) Yes2)

SetDisplayMode (Page 4648) No No No
SetDeviceMode (Page 4649) Yes Yes Yes
SetBit (Page 4650) Yes Yes Yes
SetBitInTag (Page 4651) Yes Yes Yes
SetBitWhileKeyPressed (Page 4652) Yes Yes1) Yes1)

SetBacklightColor (Page 4654) No No No
SetBrightness (Page 4654) No No No
SetScreenKeyboardMode (Page 4655) No Yes Yes
SetAlarmReportMode (Page 4657) Yes Yes Yes
SetRecipeTags (Page 4657) Yes Yes Yes
SetDaylightSavingTime (Page 4659) No Yes Yes
SetLanguage (Page 4659) Yes Yes Yes
SetAndGetBrightness (Page 4660) No No Yes3)

SetTag (Page 4661) Yes Yes Yes
SetConnectionMode (Page 4662) Yes Yes Yes
SetWebAccess (Page 4664) Yes Yes Yes
BackupRAMFileSystem (Page 4664) No Yes Yes
SimulateSystemKey (Page 4665) No Yes1) Yes1)

SimulateTag (Page 4666) Yes Yes Yes
SmartClientViewRefresh (Page 4667) Yes Yes Yes
SmartClientViewReadOnlyOff 
(Page 4667) 

Yes Yes Yes

SmartClientViewReadOnlyOn 
(Page 4668) 

Yes Yes Yes

SmartClientViewDisconnect 
(Page 4668) 

Yes Yes Yes

SmartClientViewConnect (Page 4669) Yes Yes Yes
SmartClientViewLeave (Page 4669) Yes Yes Yes
SaveDataRecord (Page 4670) Yes Yes Yes
StartLogging (Page 4671) No Yes Yes
StartNextLog (Page 4672) No Yes Yes
StartProgram (Page 4672) Yes Yes Yes
StatusForceGetValues (Page 4674) Yes Yes Yes
StatusForceSetValues (Page 4674) Yes Yes Yes
ControlSmartServer (Page 4675) Yes Yes Yes
ControlWebServer (Page 4675) Yes Yes Yes
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 MP 177 MP 277 MP 377
StopLogging (Page 4676) No Yes Yes
StopRuntime (Page 4677) Yes Yes Yes
LookupText (Page 4681) Yes Yes Yes
ResetTagToHandWheel (Page 4682) No No No
SetTagToHandWheel (Page 4683) No No No
TraceUserChange (Page 4683) Yes Yes Yes
DecreaseFocusedValue (Page 4684) Yes1) Yes1) Yes1)

DecreaseTag (Page 4684) Yes Yes Yes
ChangeConnection (Page 4685) Yes Yes Yes
WinACMPUpdateControllerForStartAt
Boot (Page 4690) 

Yes Yes Yes

WinACMPUpdateKeySwitchSetting 
(Page 4691) 

Yes Yes Yes

WinACMPUpdateBUSF1LED 
(Page 4692) 

Yes Yes Yes

WinACMPUpdateBUSF2LED 
(Page 4693) 

Yes Yes Yes

WinACMPUpdateAverageExecTime 
(Page 4694) 

Yes Yes Yes

WinACMPUpdateAverageCycleTime 
(Page 4695) 

Yes Yes Yes

WinACMPUpdateEXTFLED 
(Page 4696) 

Yes Yes Yes

WinACMPUpdateHMIEnableTime 
(Page 4697) 

Yes Yes Yes

WinACMPUpdateINTFLED 
(Page 4698) 

Yes Yes Yes

WinACMPUpdateLastCycleTime 
(Page 4699) 

Yes Yes Yes

WinACMPUpdateMaximumCycleTime 
(Page 4700) 

Yes Yes Yes

WinACMPUpdateMinimumCycleTime 
(Page 4701) 

Yes Yes Yes

WinACMPUpdatePowerLED 
(Page 4701) 

Yes Yes Yes

WinACMPUpdateSleepTime 
(Page 4702) 

Yes Yes Yes

WinACMPUpdateRUNLED 
(Page 4703) 

Yes Yes Yes

WinACMPUpdateSTOPLED 
(Page 4704) 

Yes Yes Yes

WinACMPArchive (Page 4705) Yes Yes Yes
WinACMPGetStartMode (Page 4706) Yes Yes Yes
WinACMPGetVersion (Page 4706) Yes Yes Yes
WinACMPClearCycleTimeBuffer 
(Page 4707) 

Yes Yes Yes
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 MP 177 MP 277 MP 377
WinACMPSetStartAtBoot (Page 4707) Yes Yes Yes
WinACMPSetKeySwitch (Page 4708) Yes Yes Yes
WinACMPSetHMIEnableTime 
(Page 4708) 

Yes Yes Yes

WinACMPSetRestartMethod 
(Page 4709) 

Yes Yes Yes

WinACMPSetSleepTime (Page 4709) Yes Yes Yes
WinACMPSetStartMode (Page 4710) Yes Yes Yes
WinACMPStartHistogram (Page 4710) Yes Yes Yes
WinACMPControl (Page 4711) Yes Yes Yes
WinACMPStopHistogram (Page 4712) Yes Yes Yes
WinACMPRestore (Page 4712) Yes Yes Yes
ShowLogonDialog (Page 4686) Yes Yes Yes
ShowOperatorNotes (Page 4687) Yes Yes Yes
ShowAlarmWindow (Page 4688) Yes Yes Yes
ShowSoftwareVersion (Page 4688) No Yes Yes
ShowSystemDiagnosticsWindow 
(Page 4689) 

No No No

ShowSystemAlarm (Page 4690) Yes Yes Yes

1) only with keyboard units
2) only with touch screen devices
3) only with MP 377 Touch daylight readable

See also
OpenControlPanelDialog (Page 4628)

OpenControlPanel (Page 4630)

System functions for Comfort Panels

Availability of system functions
The following table shows the availability of the system functions on the Comfort Panels. 

Technical data subject to change.       
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Overview

 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

User-defined functions Yes Yes Yes
Logoff (Page 4567) Yes Yes Yes
ActivateScreen (Page 4567) Yes Yes Yes
ActivateScreenByNumber 
(Page 4568) 

Yes Yes Yes

ActivateCleanScreen (Page 4569) Yes 1) Yes No
ActivateSystemDiagnosticsView 
(Page 4678) 

Yes Yes Yes

ActivatePreviousScreen (Page 4570) Yes Yes Yes
UpdateTag (Page 4571) Yes Yes Yes
AdjustContrast (Page 4571) No No No
Logon (Page 4572) Yes Yes Yes
ArchiveLogFile (Page 4573) Yes Yes Yes
LogTag (Page 4574) Yes Yes Yes
EditAlarm (Page 4575) Yes No Yes
ScreenObjectCursorDown 
(Page 4575) 

Yes Yes Yes

ScreenObjectCursorUp (Page 4576) Yes Yes Yes
ScreenObjectPageDown (Page 4576) Yes Yes Yes
ScreenObjectPageUp (Page 4577) Yes Yes Yes
Encode (Page 4577) Yes Yes Yes
EncodeEx (Page 4578) Yes Yes Yes
DirectKey (Page 4579) Yes 1) Yes No
DirectKeyScreenNumber 
(Page 4582) 

Yes 1) Yes No

PrintScreen (Page 4582) Yes Yes Yes
PrintReport (Page 4583) Yes Yes Yes
NotifyUserAction (Page 4584) Yes Yes Yes
IncreaseFocusedValue (Page 4585) Yes No Yes
IncreaseTag (Page 4586) Yes Yes Yes
ExportDataRecords (Page 4586) Yes Yes Yes
ExportDataRecordsWithChecksum 
(Page 4589) 

Yes Yes Yes

ExportImportUserAdministration 
(Page 4591) 

Yes Yes Yes

GoToHome (Page 4592) Yes No Yes
GoToEnd (Page 4593) Yes No Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

SafelyRemoveHardware (Page 4593) Yes Yes Yes
HTMLBrowserStop (Page 4594) No No No
HTMLBrowserRefresh (Page 4594) No No No
HTMLBrowserForward (Page 4595) No No No
HTMLBrowserBack (Page 4595) No No No
ImportDataRecords (Page 4596) Yes Yes Yes
ImportDataRecordsWithChecksum 
(Page 4597) 

Yes Yes Yes

InvertBit (Page 4599) Yes Yes Yes
InvertBitInTag (Page 4600) Yes Yes Yes
InvertLinearScaling (Page 4601) Yes Yes Yes
CalibrateTouchScreen (Page 4602) Yes 1) Yes No
CopyLog (Page 4603) Yes Yes Yes
TrendViewScrollForward (Page 4604) Yes Yes Yes
TrendViewScrollBack (Page 4605) Yes Yes Yes
TrendViewExtend (Page 4605) Yes Yes Yes
TrendViewCompress (Page 4605) Yes Yes Yes
TrendViewRulerLeft (Page 4606) Yes Yes Yes
TrendViewRulerRight (Page 4607) Yes Yes Yes
TrendViewSetRulerMode 
(Page 4607) 

Yes Yes Yes

TrendViewStartStop (Page 4608) Yes Yes Yes
TrendViewBackToBeginning 
(Page 4608) 

Yes Yes Yes

LoadDataRecord (Page 4609) Yes Yes Yes
GetUserName (Page 4610) Yes Yes Yes
GetDataRecordFromPLC 
(Page 4610) 

Yes Yes Yes

GetDataRecordName (Page 4612) Yes Yes Yes
GetDataRecordTagsFromPLC 
(Page 4614) 

Yes Yes Yes

GetGroupNumber (Page 4614) Yes Yes Yes
GetBrightness (Page 4615) Yes Yes Yes
GetPassword (Page 4615) Yes Yes Yes
LinearScaling (Page 4617) Yes Yes Yes
ClearLog (Page 4618) Yes Yes Yes
ClearDataRecord (Page 4619) Yes Yes Yes
ClearDataRecordMemory 
(Page 4620) 

Yes Yes Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

ClearAlarmBuffer (Page 4621) Yes Yes Yes
ClearAlarmBufferProTool 
(Page 4622) 

Yes Yes Yes

AlarmViewUpdate (Page 4623) Yes Yes Yes
AlarmViewEditAlarm (Page 4623) Yes Yes Yes
AlarmViewAcknowledgeAlarm 
(Page 4624) 

Yes Yes Yes

AlarmViewShowOperatorNotes 
(Page 4624) 

Yes Yes Yes

OpenAllLogs (Page 4625) Yes Yes Yes
OpenScreenKeyboard (Page 4626) Yes Yes Yes
OpenControlPanelDialog Yes Yes Yes
OpenCommandPrompt (Page 4629) Yes Yes Yes
OpenInternetExplorer (Page 4629) Yes Yes Yes
OpenControlPanel Yes Yes Yes
OpenTaskManager (Page 4631) Yes Yes Yes
AcknowledgeAlarm (Page 4631) Yes No Yes
RecipeViewNewDataRecord 
(Page 4632) 

Yes Yes Yes

RecipeViewGetDataRecordFromPLC 
(Page 4632) 

Yes Yes Yes

RecipeViewClearDataRecord 
(Page 4633) 

Yes Yes Yes

RecipeViewMenu (Page 4633) Yes Yes Yes
RecipeViewOpen (Page 4634) Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 4634) 

Yes Yes Yes

RecipeViewSaveDataRecord 
(Page 4635) 

Yes Yes Yes

RecipeViewSaveAsDataRecord 
(Page 4635) 

Yes Yes Yes

RecipeViewSynchronizeDataRecord
WithTags (Page 4636) 

Yes Yes Yes

RecipeViewRenameDataRecord 
(Page 4636) 

Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 4637) 

Yes Yes Yes

RecipeViewBack (Page 4637) Yes Yes Yes
ResetBit (Page 4638) Yes Yes Yes
ResetBitInTag (Page 4639) Yes Yes Yes
PressButton (Page 4640) Yes Yes Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

ReleaseButton (Page 4641) Yes Yes Yes
ShiftAndMask (Page 4642) Yes Yes Yes
CloseAllLogs (Page 4643) Yes Yes Yes
SetDataRecordToPLC (Page 4644) Yes Yes Yes
SetDataRecordTagsToPLC 
(Page 4645) 

Yes Yes Yes

PageDown (Page 4646) Yes No Yes
PageUp (Page 4646) Yes No Yes
SendEMail (Page 4647) Yes Yes Yes
SetAcousticSignal (Page 4648) Yes 1) Yes No
SetDisplayMode (Page 4648) No No No
SetDeviceMode (Page 4649) Yes Yes Yes
SetBit (Page 4650) Yes Yes Yes
SetBitInTag (Page 4651) Yes Yes Yes
SetBitWhileKeyPressed (Page 4652) Yes Yes Yes
SetBacklightColor (Page 4654) No No No
SetBrightness (Page 4654) Yes Yes Yes
SetScreenKeyboardMode 
(Page 4655) 

Yes Yes Yes

SetAlarmReportMode (Page 4657) Yes Yes Yes
SetRecipeTags (Page 4657) Yes Yes Yes
SetDaylightSavingTime (Page 4659) Yes Yes Yes
SetLanguage (Page 4659) Yes Yes Yes
SetTag (Page 4661) Yes Yes Yes
SetConnectionMode (Page 4662) Yes Yes Yes
SetWebAccess (Page 4664) Yes Yes Yes
BackupRAMFileSystem (Page 4664) Yes Yes Yes
SimulateSystemKey (Page 4665) Yes No Yes
SimulateTag (Page 4666) Yes Yes Yes
SmartClientViewRefresh (Page 4667) Yes Yes Yes
SmartClientViewReadOnlyOff 
(Page 4667) 

Yes Yes Yes

SmartClientViewReadOnlyOn 
(Page 4668) 

Yes Yes Yes

SmartClientViewDisconnect 
(Page 4668) 

Yes Yes Yes

SmartClientViewConnect 
(Page 4669) 

Yes Yes Yes

SmartClientViewLeave (Page 4669) Yes Yes Yes
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

SaveDataRecord (Page 4670) Yes Yes Yes
StartLogging (Page 4671) Yes Yes Yes
StartNextLog (Page 4672) Yes Yes Yes
StartProgram (Page 4672) Yes Yes Yes
StatusForceGetValues (Page 4674) Yes Yes Yes
StatusForceSetValues (Page 4674) Yes Yes Yes
ControlSmartServer (Page 4675) Yes Yes Yes
ControlWebServer (Page 4675) Yes Yes Yes
StopLogging (Page 4676) Yes Yes Yes
StopRuntime (Page 4677) Yes Yes Yes
LookupText (Page 4681) Yes Yes Yes
ResetTagToHandWheel (Page 4682) No No No
SetTagToHandWheel (Page 4683) No No No
TraceUserChange (Page 4683) Yes Yes Yes
DecreaseFocusedValue (Page 4684) Yes No Yes
DecreaseTag (Page 4684) Yes Yes Yes
ChangeConnection (Page 4685) Yes Yes Yes
WinACMPUpdateControllerForStartA
tBoot (Page 4690) 

No No No

WinACMPUpdateKeySwitchSetting 
(Page 4691) 

No No No

WinACMPUpdateBUSF1LED 
(Page 4692) 

No No No

WinACMPUpdateBUSF2LED 
(Page 4693) 

No No No

WinACMPUpdateAverageExecTime 
(Page 4694) 

No No No

WinACMPUpdateAverageCycleTime 
(Page 4695) 

No No No

WinACMPUpdateEXTFLED 
(Page 4696) 

No No No

WinACMPUpdateHMIEnableTime 
(Page 4697) 

No No No

WinACMPUpdateINTFLED 
(Page 4698) 

No No No

WinACMPUpdateLastCycleTime 
(Page 4699) 

No No No

WinACMPUpdateMaximumCycleTim
e (Page 4700) 

No No No

WinACMPUpdateMinimumCycleTime
 (Page 4701) 

No No No
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 KTP400 
KP400

TP700
TP900
TP1200 
TP1500
TP1900
TP2200

KP700
KP900
KP1200
KP1500

WinACMPUpdatePowerLED 
(Page 4701) 

No No No

WinACMPUpdateSleepTime 
(Page 4702) 

No No No

WinACMPUpdateRUNLED 
(Page 4703) 

No No No

WinACMPUpdateSTOPLED 
(Page 4704) 

No No No

WinACMPArchive (Page 4705) No No No
WinACMPGetStartMode (Page 4706) No No No
WinACMPGetVersion (Page 4706) No No No
WinACMPClearCycleTimeBuffer 
(Page 4707) 

No No No

WinACMPSetStartAtBoot 
(Page 4707) 

No No No

WinACMPSetKeySwitch (Page 4708) No No No
WinACMPSetHMIEnableTime 
(Page 4708) 

No No No

WinACMPSetRestartMethod 
(Page 4709) 

No No No

WinACMPSetSleepTime (Page 4709) No No No
WinACMPSetStartMode (Page 4710) No No No
WinACMPStartHistogram 
(Page 4710) 

No No No

WinACMPControl (Page 4711) No No No
WinACMPStopHistogram 
(Page 4712) 

No No No

WinACMPRestore (Page 4712) No No No
ShowLogonDialog (Page 4686) Yes Yes Yes
ShowOperatorNotes (Page 4687) Yes Yes Yes
ShowAlarmWindow (Page 4688) Yes Yes Yes
ShowSoftwareVersion (Page 4688) Yes Yes Yes
ShowSystemDiagnosticsWindow 
(Page 4689) 

Yes Yes Yes

ShowSystemAlarm (Page 4690) Yes Yes Yes

1) Only on KTP 400 Comfort
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See also
OpenControlPanelDialog (Page 4628)

OpenControlPanel (Page 4630)

System functions for Mobile Panels

Availability of system functions
The following table shows the availability of the system functions on the mobile panels. 

Technical data subject to change.       

Overview

 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

User-defined functions No No Yes
Logoff (Page 4567) Yes Yes Yes
ActivateScreen (Page 4567) Yes Yes Yes
ActivateScreenByNumber (Page 4568) Yes Yes Yes
ActivateCleanScreen (Page 4569) No No No
ActivateSystemDiagnosticsView 
(Page 4678) 

No No No

ActivatePreviousScreen (Page 4570) Yes Yes Yes
UpdateTag (Page 4571) Yes Yes Yes
AdjustContrast (Page 4571) Yes Yes No
Logon (Page 4572) Yes Yes Yes
ArchiveLogFile (Page 4573) No No Yes
LogTag (Page 4574) No No Yes
EditAlarm (Page 4575) Yes Yes Yes
ScreenObjectCursorDown (Page 4575) Yes Yes Yes
ScreenObjectCursorUp (Page 4576) Yes Yes Yes
ScreenObjectPageDown (Page 4576) Yes Yes Yes
ScreenObjectPageUp (Page 4577) Yes Yes Yes
Encode (Page 4577) Yes Yes Yes
EncodeEx (Page 4578) Yes Yes Yes
DirectKey (Page 4579) Yes Yes Yes
DirectKeyScreenNumber (Page 4582) Yes Yes Yes
PrintScreen (Page 4582) No Yes Yes
PrintReport (Page 4583) No Yes Yes
NotifyUserAction (Page 4584) No No Yes
IncreaseFocusedValue (Page 4585) Yes Yes Yes
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

IncreaseTag (Page 4586) Yes Yes Yes
ExportDataRecords (Page 4586) Yes Yes Yes
ExportDataRecordsWithChecksum 
(Page 4589) 

No No Yes

ExportImportUserAdministration 
(Page 4591) 

Yes Yes Yes

GoToHome (Page 4592) Yes Yes Yes
GoToEnd (Page 4593) Yes Yes Yes
SafelyRemoveHardware (Page 4593) No No Yes
HTMLBrowserStop (Page 4594) No No No
HTMLBrowserRefresh (Page 4594) No No No
HTMLBrowserForward (Page 4595) No No No
HTMLBrowserBack (Page 4595) No No No
ImportDataRecords (Page 4596) Yes Yes Yes
ImportDataRecordsWithChecksum 
(Page 4597) 

No No Yes

InvertBit (Page 4599) Yes Yes Yes
InvertBitInTag (Page 4600) Yes Yes Yes
InvertLinearScaling (Page 4601) Yes Yes Yes
CalibrateTouchScreen (Page 4602) Yes Yes Yes2)

CopyLog (Page 4603) No No Yes
TrendViewScrollForward (Page 4604) Yes Yes Yes
TrendViewScrollBack (Page 4605) Yes Yes Yes
TrendViewExtend (Page 4605) Yes Yes Yes
TrendViewCompress (Page 4605) Yes Yes Yes
TrendViewRulerLeft (Page 4606) Yes Yes Yes
TrendViewRulerRight (Page 4607) Yes Yes Yes
TrendViewSetRulerMode (Page 4607) Yes Yes Yes
TrendViewStartStop (Page 4608) Yes Yes Yes
TrendViewBackToBeginning (Page 4608) Yes Yes Yes
LoadDataRecord (Page 4609) Yes Yes Yes
GetUserName (Page 4610) Yes Yes Yes
GetDataRecordFromPLC (Page 4610) Yes Yes Yes
GetDataRecordName (Page 4612) Yes Yes Yes
GetDataRecordTagsFromPLC (Page 4614) Yes Yes Yes
GetGroupNumber (Page 4614) Yes Yes Yes
GetBrightness (Page 4615) No No No
GetPassword (Page 4615) Yes Yes Yes
LinearScaling (Page 4617) No No Yes
ClearLog (Page 4618) Yes Yes Yes
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

ClearDataRecord (Page 4619) Yes Yes Yes
ClearDataRecordMemory (Page 4620) Yes Yes Yes
ClearAlarmBuffer (Page 4621) Yes Yes Yes
ClearAlarmBufferProTool (Page 4622) Yes Yes Yes
AlarmViewUpdate (Page 4623) Yes Yes Yes
AlarmViewEditAlarm (Page 4623) Yes Yes Yes
AlarmViewAcknowledgeAlarm (Page 4624) Yes Yes Yes
AlarmViewShowOperatorNotes (Page 4624) No No Yes
OpenAllLogs (Page 4625) No No Yes
OpenScreenKeyboard (Page 4626) No No Yes
OpenControlPanelDialog No No No
OpenCommandPrompt (Page 4629) No Yes Yes
OpenInternetExplorer (Page 4629) No No Yes
OpenControlPanel No No Yes
OpenTaskManager (Page 4631) Yes Yes Yes
AcknowledgeAlarm (Page 4631) Yes Yes Yes
RecipeViewNewDataRecord (Page 4632) Yes Yes Yes
RecipeViewGetDataRecordFromPLC 
(Page 4632) 

Yes Yes Yes

RecipeViewClearDataRecord (Page 4633) Yes Yes Yes
RecipeViewMenu (Page 4633) Yes Yes Yes
RecipeViewOpen (Page 4634) Yes Yes Yes
RecipeViewSetDataRecordToPLC 
(Page 4634) 

Yes Yes Yes

RecipeViewSaveDataRecord (Page 4635) Yes Yes Yes
RecipeViewSaveAsDataRecord 
(Page 4635) 

Yes Yes Yes

RecipeViewSynchronizeDataRecordWithTa
gs (Page 4636) 

Yes Yes Yes

RecipeViewRenameDataRecord 
(Page 4636) 

Yes Yes Yes

RecipeViewShowOperatorNotes 
(Page 4637) 

Yes Yes Yes

RecipeViewBack (Page 4637) Yes Yes Yes
ResetBit (Page 4638) Yes Yes Yes
ResetBitInTag (Page 4639) Yes Yes Yes
PressButton (Page 4640) Yes Yes Yes
ReleaseButton (Page 4641) Yes Yes Yes
ShiftAndMask (Page 4642) No No Yes
CloseAllLogs (Page 4643) Yes Yes Yes
SetDataRecordToPLC (Page 4644) Yes Yes Yes
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

SetDataRecordTagsToPLC (Page 4645) Yes Yes Yes
PageDown (Page 4646) Yes Yes Yes
PageUp (Page 4646) No Yes Yes
SendEMail (Page 4647) No No No
SetAcousticSignal (Page 4648) No No No
SetDisplayMode (Page 4648) Yes Yes Yes
SetDeviceMode (Page 4649) Yes Yes Yes
SetBit (Page 4650) Yes Yes Yes
SetBitInTag (Page 4651) Yes Yes Yes
SetBitWhileKeyPressed (Page 4652) No No No
SetBacklightColor (Page 4654) No No No
SetBrightness (Page 4654) No No Yes
SetScreenKeyboardMode (Page 4655) No No Yes
SetAlarmReportMode (Page 4657) Yes Yes Yes
SetRecipeTags (Page 4657) Yes Yes Yes
SetDaylightSavingTime (Page 4659) Yes Yes Yes
SetLanguage (Page 4659) Yes Yes Yes
SetTag (Page 4661) Yes Yes Yes
SetConnectionMode (Page 4662) No Yes Yes
SetWebAccess (Page 4664) No No Yes
BackupRAMFileSystem (Page 4664) Yes Yes Yes
SimulateSystemKey (Page 4665) Yes Yes Yes
SimulateTag (Page 4666) No Yes Yes
SmartClientViewRefresh (Page 4667) No Yes Yes
SmartClientViewReadOnlyOff (Page 4667) No Yes Yes
SmartClientViewReadOnlyOn (Page 4668) No Yes Yes
SmartClientViewDisconnect (Page 4668) No Yes Yes
SmartClientViewConnect (Page 4669) No Yes Yes
SmartClientViewLeave (Page 4669) Yes Yes Yes
SaveDataRecord (Page 4670) No No Yes
StartLogging (Page 4671) No No Yes
StartNextLog (Page 4672) No No Yes
StartProgram (Page 4672) Yes Yes Yes
StatusForceGetValues (Page 4674) No Yes Yes
StatusForceSetValues (Page 4674) No Yes Yes
ControlSmartServer (Page 4675) No Yes Yes
ControlWebServer (Page 4675) No No Yes
StopLogging (Page 4676) Yes Yes Yes
StopRuntime (Page 4677) Yes Yes Yes
LookupText (Page 4681) Yes Yes Yes
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

ResetTagToHandWheel (Page 4682) Yes Yes Yes
SetTagToHandWheel (Page 4683) Yes Yes Yes
TraceUserChange (Page 4683) Yes Yes Yes
DecreaseFocusedValue (Page 4684) Yes Yes Yes1)

DecreaseTag (Page 4684) Yes Yes Yes
ChangeConnection (Page 4685) No No No
WinACMPUpdateControllerForStartAtBoot 
(Page 4690) 

No No No

WinACMPUpdateKeySwitchSetting 
(Page 4691) 

No No No

WinACMPUpdateBUSF1LED (Page 4692) No No No
WinACMPUpdateBUSF2LED (Page 4693) No No No
WinACMPUpdateAverageExecTime 
(Page 4694) 

No No No

WinACMPUpdateAverageCycleTime 
(Page 4695) 

No No No

WinACMPUpdateEXTFLED (Page 4696) No No No
WinACMPUpdateHMIEnableTime 
(Page 4697) 

No No No

WinACMPUpdateINTFLED (Page 4698) No No No
WinACMPUpdateLastCycleTime 
(Page 4699) 

No No No

WinACMPUpdateMaximumCycleTime 
(Page 4700) 

No No No

WinACMPUpdateMinimumCycleTime 
(Page 4701) 

No No No

WinACMPUpdatePowerLED (Page 4701) No No No
WinACMPUpdateSleepTime (Page 4702) No No No
WinACMPUpdateRUNLED (Page 4703) No No No
WinACMPUpdateSTOPLED (Page 4704) No No No
WinACMPArchive (Page 4705) No No No
WinACMPGetStartMode (Page 4706) No No No
WinACMPGetVersion (Page 4706) No No No
WinACMPClearCycleTimeBuffer 
(Page 4707) 

No No No

WinACMPSetStartAtBoot (Page 4707) No No No
WinACMPSetKeySwitch (Page 4708) No No No
WinACMPSetHMIEnableTime (Page 4708) No No No
WinACMPSetRestartMethod (Page 4709) No No No
WinACMPSetSleepTime (Page 4709) No No No
WinACMPSetStartMode (Page 4710) No No No
WinACMPStartHistogram (Page 4710) No No No
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 Mobile Panel 177 
DP

Mobile Panel 177 
PN

Mobile Panel 277
Mobile Panel 277 IWLAN
Mobile Panel 277 F IWLAN

WinACMPControl (Page 4711) No No No
WinACMPStopHistogram (Page 4712) No No No
WinACMPRestore (Page 4712) Yes Yes Yes
ShowLogonDialog (Page 4686) Yes Yes Yes
ShowAlarmWindow (Page 4688) Yes Yes Yes
ShowSoftwareVersion (Page 4688) No No Yes
ShowSystemDiagnosticsWindow 
(Page 4689) 

No No No

ShowSystemAlarm (Page 4690) Yes Yes Yes

1) only for Mobile Panel 277
2) Only for Mobile Panel 277, Mobile Panel 277 IWLAN

See also
OpenControlPanelDialog (Page 4628)

ShowOperatorNotes (Page 4687)

System functions for Runtime Advanced

Availability of system functions
The following table shows the availability of the system functions for WinCC RT Advanced. 

Technical data subject to change.       

Overview

 WinCC RT Advanced
User-defined functions Yes
Logoff (Page 4567) Yes
ActivateScreen (Page 4567) Yes
ActivateScreenByNumber (Page 4568) Yes
ActivateCleanScreen (Page 4569) Yes
ActivateSystemDiagnosticsView (Page 4678) No
ActivatePreviousScreen (Page 4570) Yes
UpdateTag (Page 4571) Yes
AdjustContrast (Page 4571) No
Logon (Page 4572) Yes
ArchiveLogFile (Page 4573) Yes
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 WinCC RT Advanced
LogTag (Page 4574) Yes
EditAlarm (Page 4575) Yes
ScreenObjectCursorDown (Page 4575) Yes
ScreenObjectCursorUp (Page 4576) Yes
ScreenObjectPageDown (Page 4576) Yes
ScreenObjectPageUp (Page 4577) Yes
Encode (Page 4577) Yes
EncodeEx (Page 4578) Yes
DirectKey (Page 4579) No
DirectKeyScreenNumber (Page 4582) No
PrintScreen (Page 4582) Yes
PrintReport (Page 4583) Yes
NotifyUserAction (Page 4584) Yes
IncreaseFocusedValue (Page 4585) Yes
IncreaseTag (Page 4586) Yes
ExportDataRecords (Page 4586) Yes
ExportDataRecordsWithChecksum (Page 4589) No
ExportImportUserAdministration (Page 4591) Yes
GoToHome (Page 4592) Yes
GoToEnd (Page 4593) Yes
SafelyRemoveHardware (Page 4593) No
HTMLBrowserStop (Page 4594) Yes
HTMLBrowserRefresh (Page 4594) Yes
HTMLBrowserForward (Page 4595) Yes
HTMLBrowserBack (Page 4595) Yes
ImportDataRecords (Page 4596) Yes
ImportDataRecordsWithChecksum (Page 4597) No
InvertBit (Page 4599) Yes
InvertBitInTag (Page 4600) Yes
InvertLinearScaling (Page 4601) Yes
CalibrateTouchScreen (Page 4602) No
CopyLog (Page 4603) Yes
TrendViewScrollForward (Page 4604) Yes
TrendViewScrollBack (Page 4605) Yes
TrendViewExtend (Page 4605) Yes
TrendViewCompress (Page 4605) Yes
TrendViewRulerLeft (Page 4606) Yes
TrendViewRulerRight (Page 4607) Yes
TrendViewSetRulerMode (Page 4607) Yes
TrendViewStartStop (Page 4608) Yes
TrendViewBackToBeginning (Page 4608) Yes
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 WinCC RT Advanced
LoadDataRecord (Page 4609) Yes
GetUserName (Page 4610) Yes
GetDataRecordFromPLC (Page 4610) Yes
GetDataRecordName (Page 4612) Yes
GetDataRecordTagsFromPLC (Page 4614) Yes
GetGroupNumber (Page 4614) Yes
GetBrightness (Page 4615) No
GetPassword (Page 4615) Yes
LinearScaling (Page 4617) Yes
ClearLog (Page 4618) Yes
ClearDataRecord (Page 4619) Yes
ClearDataRecordMemory (Page 4620) No
ClearAlarmBuffer (Page 4621) Yes
ClearAlarmBufferProTool (Page 4622) Yes
AlarmViewUpdate (Page 4623) Yes
AlarmViewEditAlarm (Page 4623) Yes
AlarmViewAcknowledgeAlarm (Page 4624) Yes
AlarmViewShowOperatorNotes (Page 4624) Yes
OpenAllLogs (Page 4625) Yes
OpenScreenKeyboard (Page 4626) Yes
OpenControlPanelDialog No
OpenCommandPrompt (Page 4629) No
OpenInternetExplorer (Page 4629) No
OpenControlPanel No
OpenTaskManager (Page 4631) Yes
AcknowledgeAlarm (Page 4631) Yes
RecipeViewNewDataRecord (Page 4632) Yes
RecipeViewGetDataRecordFromPLC (Page 4632) Yes
RecipeViewClearDataRecord (Page 4633) Yes
RecipeViewMenu (Page 4633) Yes
RecipeViewOpen (Page 4634) Yes
RecipeViewSetDataRecordToPLC (Page 4634) Yes
RecipeViewSaveDataRecord (Page 4635) Yes
RecipeViewSaveAsDataRecord (Page 4635) Yes
RecipeViewSynchronizeDataRecordWithTags (Page 4636) Yes
RecipeViewRenameDataRecord (Page 4636) Yes
RecipeViewShowOperatorNotes (Page 4637) Yes
RecipeViewBack (Page 4637) Yes
ResetBit (Page 4638) Yes
ResetBitInTag (Page 4639) Yes
PressButton (Page 4640) Yes
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 WinCC RT Advanced
ReleaseButton (Page 4641) Yes
ShiftAndMask (Page 4642) Yes
CloseAllLogs (Page 4643) Yes
SetDataRecordToPLC (Page 4644) Yes
SetDataRecordTagsToPLC (Page 4645) Yes
PageDown (Page 4646) Yes
PageUp (Page 4646) Yes
SendEMail (Page 4647) Yes
SetAcousticSignal (Page 4648) No
SetDisplayMode (Page 4648) Yes
SetDeviceMode (Page 4649) Yes
SetBit (Page 4650) Yes
SetBitInTag (Page 4651) Yes
SetBitWhileKeyPressed (Page 4652) Yes
SetBacklightColor (Page 4654) No
SetBrightness (Page 4654) No
SetScreenKeyboardMode (Page 4655) Yes
SetAlarmReportMode (Page 4657) Yes
SetRecipeTags (Page 4657) Yes
SetDaylightSavingTime (Page 4659) Yes
SetLanguage (Page 4659) Yes
SetTag (Page 4661) Yes
SetConnectionMode (Page 4662) Yes
SetWebAccess (Page 4664) Yes
BackupRAMFileSystem (Page 4664) No
SimulateSystemKey (Page 4665) Yes
SimulateTag (Page 4666) Yes
SmartClientViewRefresh (Page 4667) Yes
SmartClientViewReadOnlyOff (Page 4667) Yes
SmartClientViewReadOnlyOn (Page 4668) Yes
SmartClientViewDisconnect (Page 4668) Yes
SmartClientViewConnect (Page 4669) Yes
SmartClientViewLeave (Page 4669) Yes
SaveDataRecord (Page 4670) Yes
StartLogging (Page 4671) Yes
StartNextLog (Page 4672) Yes
StartProgram (Page 4672) Yes
StatusForceGetValues (Page 4674) Yes
StatusForceSetValues (Page 4674) Yes
ControlSmartServer (Page 4675) Yes
ControlWebServer (Page 4675) Yes
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 WinCC RT Advanced
StopLogging (Page 4676) Yes
StopRuntime (Page 4677) Yes
LookupText (Page 4681) Yes
ResetTagToHandWheel (Page 4682) No
SetTagToHandWheel (Page 4683) No
TraceUserChange (Page 4683) Yes
DecreaseFocusedValue (Page 4684) Yes
DecreaseTag (Page 4684) Yes
ChangeConnection (Page 4685) Yes
WinACMPUpdateControllerForStartAtBoot (Page 4690) No
WinACMPUpdateKeySwitchSetting (Page 4691) No
WinACMPUpdateBUSF1LED (Page 4692) No
WinACMPUpdateBUSF2LED (Page 4693) No
WinACMPUpdateAverageExecTime (Page 4694) No
WinACMPUpdateAverageCycleTime (Page 4695) No
WinACMPUpdateEXTFLED (Page 4696) No
WinACMPUpdateHMIEnableTime (Page 4697) No
WinACMPUpdateINTFLED (Page 4698) No
WinACMPUpdateLastCycleTime (Page 4699) No
WinACMPUpdateMaximumCycleTime (Page 4700) No
WinACMPUpdateMinimumCycleTime (Page 4701) No
WinACMPUpdatePowerLED (Page 4701) No
WinACMPUpdateSleepTime (Page 4702) No
WinACMPUpdateRUNLED (Page 4703) No
WinACMPUpdateSTOPLED (Page 4704) No
WinACMPArchive (Page 4705) No
WinACMPGetStartMode (Page 4706) No
WinACMPGetVersion (Page 4706) No
WinACMPClearCycleTimeBuffer (Page 4707) No
WinACMPSetStartAtBoot (Page 4707) No
WinACMPSetKeySwitch (Page 4708) No
WinACMPSetHMIEnableTime (Page 4708) No
WinACMPSetRestartMethod (Page 4709) No
WinACMPSetSleepTime (Page 4709) No
WinACMPSetStartMode (Page 4710) No
WinACMPStartHistogram (Page 4710) No
WinACMPControl (Page 4711) No
WinACMPStopHistogram (Page 4712) No
WinACMPRestore (Page 4712) No
ShowLogonDialog (Page 4686) Yes
ShowOperatorNotes (Page 4687) Yes
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 WinCC RT Advanced
ShowAlarmWindow (Page 4688) Yes
ShowSoftwareVersion (Page 4688) Yes
ShowSystemDiagnosticsWindow (Page 4689) No
ShowSystemAlarm (Page 4690) Yes

See also
OpenControlPanelDialog (Page 4628)

System functions for Runtime Professional

Availability of system functions
The following table shows the availability of the system functions for WinCC Runtime 
Professional. 

Technical data subject to change.    

Overview

 WinCC RT Professional
User-defined functions Yes
ActivateScreen (Page 4713) Yes
ActivateScreenInCurrentScreenWindow (Page 4714) Yes
ActivateScreenInScreenWindow (Page 4714) Yes
IncreaseTag (Page 4715) Yes
ExportImportUserAdministration (Page 4717) Yes
InvertBit (Page 4718) Yes
InvertBitInTag (Page 4719) Yes
InvertLinearScaling (Page 4720) Yes
LinearScaling (Page 4722) Yes
ResetBit (Page 4723) Yes
ResetBitInTag (Page 4724) Yes
SetBit (Page 4725) Yes
SetBitInTag (Page 4726) Yes
SetPropertyCurrentWindow (Page 4728) Yes
SetPropertyCurrentWindowByProperty (Page 4729) Yes
SetPropertyCurrentWindowByTagIndirect (Page 4729) Yes
SetPropertyByProperty (Page 4730) Yes
SetPropertyByConstant (Page 4731) Yes
SetPropertyByTag (Page 4733) Yes
SetPropertyByTagIndirect (Page 4735) Yes
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 WinCC RT Professional
SetTag (Page 4736) Yes
SetTagByProperty (Page 4737) Yes
SetTagByTagIndirect (Page 4738) Yes
SetTagWithOperatorInputAlarm (Page 4739) Yes
SetTagIndirect (Page 4740) Yes
SetTagIndirectByProperty (Page 4741) Yes
SetTagIndirectByTagIndirect (Page 4743) Yes
SetTagIndirectWithOperatorInputAlarm (Page 4744) Yes
StopRuntime (Page 4746) Yes
DecreaseTag (Page 4744) Yes
ShowLogonDialog (Page 4747) Yes

See also
ActivateScreen (Page 4883)

ActivateScreenInScreenWindow (Page 4884)

SetPropertyByConstant (Page 4899)

SetPropertyByProperty (Page 4900)

SetPropertyByTag (Page 4902)

SetPropertyByTagIndirect (Page 4903)

SetTagIndirect (Page 4908)

SetTagIndirectWithOperatorInputAlarm (Page 4911)

SetTagIndirectByProperty (Page 4909)

SetTagIndirectByTagIndirect (Page 4910)

SetTagWithOperatorEvent (Page 4912)

SetTagByProperty (Page 4906)

SetTagByTagIndirect (Page 4907)

IncreaseTag (Page 4888)

InvertBit (Page 4890)

InvertBitInTag (Page 4891)

InverseLinearScaling (Page 4889)

LinearScaling (Page 4893)

ResetBit (Page 4894)

ResetBitInTag (Page 4895)

SetBit  (Page 4896)

SetBitInTag (Page 4897)
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StopRuntime (Page 4914)

DecreaseTag (Page 4885)

System functions

Logoff

Description
Logs off the current user on the HMI device.       

Use in the function list
Logoff

Use in user-defined functions
Logoff

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 

Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.

 
 
{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}

See also
ActivateScreenByNumber (Page 4568)

ActivateScreenByNumber

Description
Performs a screen change to a screen depending on a tag value.       

The screen is identified by its screen number.
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Use in the function list
ActivateScreenByNumber (Screen number, Object number)

Use in user-defined functions
ActivateScreenByNumber (Screen_number, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Screen number
Tag which contains the screen number of the destination screen.

When a change from the root screen to the permanent window is desired, "0" or "-1" is specified:

0 = Change from root screen to permanent window

-1 = Change from permanent window to root screen

Object number
The number of the screen object which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

See also
ActivateScreen (Page 4566)

ActivateCleanScreen

Description
Activates the clean screen on the HMI device. The display of the HMI device is disabled for 
the given time period.     

When the display of the HMI device is deactivated, it can be cleaned without triggering touch 
functions by mistake.

Use in the function list
ActivateCleanScreen (Time period)
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Use in user-defined functions
--

Parameters

Time period
Time period for which the display is disabled. The time remaining is displayed as a progress 
bar.

Value range in seconds from 10 through 300.
 

 Note

The system function ActivateCleanScreen cannot be simulated.
 

 

See also
Logoff (Page 4566)

ActivatePreviousScreen

Description
Performs a screen change to the screen which was activated before the current screen. The 
screen change is not performed if no screen was activated beforehand.       

The last 10 screens that were called up are saved. A system alarm is output when you change 
to a screen which is no longer saved.

 

 Note

If you want to use the system function, the screen to which you change has to be used in the 
navigation structure.

 

 

Use in the function list
ActivatePreviousScreen

Use in user-defined functions
ActivatePreviousScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
--

UpdateTag

Description
Reads the current value of the tag with the specified Update ID from the PLC.     

Use in the function list
UpdateTag (Update ID)

Use in user-defined functions
-

Parameters

Update ID
Update ID assigned to the tag that will be updated.

See also
Logoff (Page 4566)

AdjustContrast

Description
Changes the contrast of the display one level on the HMI device.     

Use in the function list
AdjustContrast (Adjust)

Use in user-defined functions
-

Parameters

Adjust
Specifies how the contrast is changed:
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0 (hmiDecrease) = Decrease: Decreases the contrast one level.

1 (hmiIncrease) = Increase: Increases the contrast one level.

Application example

Objective
One button each for increasing and decreasing the screen contrast is desired.

Notes on configuring
Configure two buttons and configure the "AdjustContrast" system function on the "Press" event. 
The parameters "Increase" and "Decrease" are allocated.

Procedure on HMI device
When one of the two buttons is pressed in runtime, the contrast is increased or decreased one 
level.

See also
Logoff (Page 4566)

Logon

Description
Logs on the current user on the HMI device.       

Use in the function list
Logon (Password, User name)

Use in user-defined functions
Logon (Password, User_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Password
The tag from which the password for the user logging on is read.

If the user is logged on, the password in the tag is deleted.

User name
The tag from which the user name for the user logging on is read.
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ArchiveLogFile

Description
This system function moves or copies a log to another storage location for long-term logging. 

With Audit Trails, always use the "Move" (hmiMove)" mode, otherwise you will be violating the 
FDA guideline by duplicating the data stored.       

Prior to "ArchiveLogFile" always run the system function "CloseAllLogs".

After this system function, run the "OpenAllLogs" system function.

In "Copy log" mode, the logs are not reopened until the log has been successfully copied, or 
unless a timeout occurs during the copy process. In "Move log" mode, the logs to be moved 
are renamed and the new logs are opened immediately. To move the renamed logs, a job is 
submitted which attempts to move them every 300 seconds if the server cannot be reached. 
The job is also retained after Runtime is restarted until it is executed.

Use in the function list
ArchiveLogFile (Log type, Log, Directory name, Mode)

Use in user-defined functions
ArchiveLogFile (Log_type, Log, Directory_name, Mode) 

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (miAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log available for GMP compliant projects. Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log being archived.

Directory name
Path for saving the log.

Mode
0 (hmiCopy) = Copy log

1 (hmiMove) = Move log

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4572 System Manual, 02/2014



Application example
You want to move a log file from a local storage medium to the server in order to generate a 
backup copy of this file at cyclic intervals.

Notes on configuring

Set up a task in the scheduler which is executed at a specific time on a daily basis. Configure 
the following function list for the task:

Procedure on HMI device

● All log files will be closed.

● The log file you specified is moved to the server.

● All closed log files will be opened again.

LogTag

Description
Saves the value of the given tags in the given data log.     

This system function is used to archive a process value at a certain point in time.

Use in the function list
LogTag (Tag)

Use in user-defined functions
-
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Parameters

Tag
The tag whose value is logged. The tag is stored in the log which is configured for the specified 
tag.

EditAlarm

Description
Triggers the "Edit" event for all selected alarms.       

If the alarms to be edited have not yet been acknowledged, the acknowledgment takes place 
automatically when this system function is called up.

This system function can only be used for function keys.

Use in the function list
EditAlarm

Use in user-defined functions
EditAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ScreenObjectCursorDown

Description
Results in a line-by-line, downward cursor movement in the specified screen object.     

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectCursorDown (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

ScreenObjectCursorUp

Description
 Results in a line-by-line, upward cursor movement in the specified screen object.     

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectCursorUp (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

ScreenObjectPageDown

Description
Results in a page-by-page, downward cursor movement in the specified screen object.     

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view
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Use in the function list
ScreenObjectPageDown (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

ScreenObjectPageUp

Description
Results in a page-by-page, upward cursor movement in the specified screen object.    

The system function can be used for the following screen objects:

● User view

● Alarm view

● Recipe view

Use in the function list
ScreenObjectPageUp (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object in which the key function is triggered.

Encode

Description     
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 
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Use in the function list
Encode (Byte array, String, Coding)

Use in user-defined functions
Encode (Byte_array, String, Encoding)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The Byte array must be twice the size of the string length + 2. The Byte array must contain 
242 array elements if the string has a length of 120 characters.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Encode
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

EncodeEx

Description       
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

By contrast to the Encode system function, you can define the Line break parameter. Using 
the Line break parameter you can delete line breaks or replace these with predefined 
characters.

Use in the function list
EncodeEx (Byte array, String , Encode , Line break)

Use in user-defined functions
EncodeEx (Byte_array, String, Encoding, Line_break)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The byte array must be twice the size of the string length +2. If the string has a length of 120 
characters, the byte array must contain 242 array elements.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Code
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

Line break
All line breaks are either deleted or replaced with predefined characters. Do not replace line 
breaks if set as the default value. 

0 (replace with "\r\n' (0x000D, 0x000A)) - the line break is replaced with "\r\n".

1 (replace with "\n' (0x000A)) - the line break is replaced with "\n".

2 (do not replace) - the line break is not replaced.

3 (remove line breaks) - the line breaks are removed.

DirectKey

Description
Allows rapid operation of keys on an HMI device without having communication caused delays 
occur.     

Use this system function, for example. to set bits in the I/O area of a SIMATIC S7 directly from 
the HMI device.

 

 Note

If you have integrated WinCC in SIMATIC STEP 7 and have configured a DP area in SIMATIC 
STEP 7: When the button on which the system function was configured is activated, a bit is 
set in the IO area of the CPU. Releasing the button resets the bit.
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Notes on configuring the system function
When a button is configured with the "DirectKey" system function, a fixed area of the touch 
display is reserved for DirectKey operation.

Screen objects that are above the button with the "DirectKey" system function in this area in 
runtime will hide the button visually. However, the screen objects do not interfere with the 
triggering of the "DirectKey" system function.

 

 Note

If an external application, such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. The bit for the 
"DirectKeyScreenNumber" function is no longer set and the keys or buttons which are 
assigned the "DirectKey" function no longer to trigger the associated bit in the PLC.

 

 WARNING

Triggering the "DirectKey" system function by mistake will endanger personnel or result in 
damage to the machine.

 

In order to avoid this danger, the following must be observed:

● When the process screen is configured, the button with the "DirectKey" system function 
must not be covered by a screen object.

● The dynamic positioning or display (release) of a screen object in relation to process values 
must not cover the button with the "DirectKey" system function in runtime.

 

  Note

Please observe this guideline during configuration. Check also existing configurations and 
adjust them immediately.

 

In the following cases, the covering of a button with the "DirectKey" system function does not 
lead to the problems described above:

● Operation of the alarm window

● Operation of the Recipe view

● Cancellation of the screen saver

● Use of the screen keyboard

● Running the "ActivateCleanScreen" system function

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4579



Actions of DP direct-keys in offline operation
When the "ChangeConnection" system function is performed with the "Offline" parameter on 
the HMI device, the connection to the specified PLC is disconnected.

 

 Note

Please note the following on the SIMATIC STEP 7 side as well as the WinCC side:

The DP DirectKeys are still active in this case. If you activate a button with the "DirectKey" 
system function in "Offline" operating mode or activate the DirectKey on a keyboard device, 
the corresponding bit is set in the PLC.

 

Use in the function list
DirectKey (Bit)

Use in user-defined functions
-

Parameters

Bit
Specifies the bit which is set. Depending on the HMI device, the bit numbers 0 to 31 or 0 to 
39 are possible.

Application example

Objective
You want to set bits in the IO area of a SIMATIC S7 directly from the HMI device using a button.

Requirement
WinCC integrated in SIMATIC STEP 7 is installed.

During operation, the HMI device is coupled to a SIMATIC S7 through PROFIBUS-DP.

WinCC integrated was installed when you compiled your project.

The bit area for DirectKeys is determined in SIMATIC STEP 7. For configuration see the 
"Communication" user's manual.

Notes on configuring
Configure the button to be used as the DirectKey. Assign the "DirectKey" system function to 
the button. As a parameter, enter the number of the bit which is set when the key is pressed.

Procedure on HMI device
When the DirectKey is touched, the bit is set, and reset when the key is released or the screen 
is exited. 
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DirectKeyScreenNumber

Description
Sets the bit within the given bit area of a DirectKey and transfers it to the S7 controller to which 
the HMI device is connected. This ensures unambiguous allocation of a control bit to screen 
number at all times.     

Without the use of the system function, the S7 controller must distinguish the respective 
functionality by means of the screen number. This delays the updating of the screen number 
after a screen change.

 

 Note

If an external application, such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. Nevertheless, the bit for the 
"DirectKeyScreenNumber" function is set and the keys or buttons with the configured 
"DirectKey" function continue to trigger the associated bit in the PLC.   

 

Use in the function list
DirectKeyScreenNumber (Bit)

Use in user-defined functions
-

Parameters

Bit
Specifies the bit which is set. Depending on the HMI device, the bit numbers 0 to 31 or 0 to 
39 are possible.

PrintScreen

Description
Prints the screen currently being displayed on the HMI device from the printer which is 
connected to the HMI device.       

Opened windows are also printed.
 

 Note

The printer settings are taken over from the current settings in the Windows operation system.
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Use in the function list
PrintScreen

Use in user-defined functions
PrintScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

PrintReport

Description
Prints the given report from the printer which is connected to the HMI device. The report is 
printed in the language which is set on the HMI device.       

 

 Note

If runtime is closed whilst log data are being printed using the system function, the report will 
cease to be supplied with data as soon as runtime stops.

 

Use in the function list
PrintReport (Report)

Use in user-defined functions
PrintReport (Report)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Report
Name of the report to be printed.

 

 Note

If you have set up via the "Function list" dialog box a new report for the "PrintReport" function, 
when compiling, the following warning appears: "The report "Report_1" has no printed pages."

In order to remedy the warning, open the "Report_1" via the project view and recompile the 
project.

 

NotifyUserAction

Description
       

This system function is used to log user actions that are not automatically logged in the audit 
trail. You can also use this system function to require the user to enter an acknowledgment or 
an electronic signature and a comment for the operator action. Requirement for the use of the 
system function is that the GMP-compliant configuration is activated under "Runtime settings".

If you use the "NotifyUserAction" system function in a function, the debugger may open if you 
cancel your input by clicking "Cancel". To compensate for this reaction, you can use the "On 
Error Resume Next" statement in a function. With this instruction, the next instruction is 
executed after a runtime error. If you use the "On Error Resume Next" statement, output of 
system events is also suppressed.

Use in the function list
NotifyUserAction (Confirmation type, Mandatory commenting, Category, Object name, 
Description)

Use in user-defined functions
NotifyUserAction (Confirmation_type, Mandatory_commenting, Category, Object_name, 
Description)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Confirmation type
Establishes how the action must be confirmed

0 = (None): No confirmation required, an entry is created in the audit trail
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1 = (Acknowledgement): Acknowledgment, the user must acknowledge the action; an entry is 
created in the audit trail

2 = (Digital Signature): Electronic signature, a dialog window opens in which the user must 
enter his electronic signature - an entry is created in the audit trail

Mandatory commenting
Establishes if the user has to enter a comment. The comment is logged in the audit trail.

0 = (True): True; a dialog window opens in which the user must enter a comment

1 = (False): False; no mandatory commenting

Category
Category or class name of the modified object

Object name
Name of the modified object

Description
Text which describes the archiving user action.

IncreaseFocusedValue

Description
Adds the given value to the value of the tag which is connected to the input field (drop-down 
list, graphic selection list, slider bar) which has the current focus.       

This system function can only be used for function keys.

Use in the function list
IncreaseFocusedValue (Value)

Use in user-defined functions
-

Parameters

Value
The value which is added to the tag value.
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IncreaseTag

Description
Adds the given value to the value of the tags.       

X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, help tags must be used. You can use the "SetTag" system function 
to assign the tag value to the auxiliary tags.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions 
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the given value is added.

Value
The value that is added.

See also
SetTag (Page 4661)

ExportDataRecords

Description
Exports one or all data records of a recipe to a CSV file.       

One file is created per recipe.
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Use in the function list
ExportDataRecords (Recipe number/name, Data record number/name, File name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
ExportDataRecords (Recipe_number/name,Data_record number/name, File_name, 
Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

File name
Name of the CSV file to which the recipe data records are exported. Enter the file location and 
the file extension (*.csv), for example, "C:\TEMP\Orange.csv".

 

 Note
Storage of the CSV file
● If a storage card is used as storage location, specify the storage location as follows: 

"\StorageCard\<File name>".
● If you only enter one file name and no path, the file will be saved in a system directory, 

for example, "C:\Documents and Settings\[User]".
● When only one path for the export is specified, the file name is automatically created from 

the respective recipe name. It is a requirement that the folder "D:\Temp\", for example, 
has been created. If the folder  "D:\Temp" has not been created, the folder name will be 
used as the prefix of the file name, Temp_Recipe names.csv.

 

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithPrompting) = With confirmation: CSV file is not overwritten until confirmed.
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Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file 
formats.       

Application example
You want to export all data records using a key.

Notes on configuring

Configure the "ExportDataRecords" system function on the "Press" event for the desired key. 
Transfer the following parameters:

● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device
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As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file. If the file already 
exists, it will be overwritten.

After exporting the data records, a system message is output.

ExportDataRecordsWithChecksum

Description
Exports one or all data records of a recipe to a CSV file and generates a checksum for each 
line in the file.       

One file is created per recipe.

Use in the function list
ExportDataRecordsWithChecksum (Recipe number/name, Data record number/name, File 
name, Overwrite, Output status message, Processing status)

Use in user-defined functions
ExportDataRecordsWithChecksum (Recipe_number/name, Data_record number/name, 
File_name, Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

File name
Name of the CSV file to which the recipe data records are exported. Enter the path and the 
file extension e.g. "C:\TEMP\Orange.CSV".

If a storage card is used as storage location, specify the storage location as follows: 
"\StorageCard\<File name>".

If you define only a file name without specifying a path, the file is saved to the directory from 
which Runtime was started. If write access to this directory is not enabled in the Windows 7 
operating system, the file is saved to the "VirtualStore" folder of the user directory.

When only one path for the export is specified, the file name is automatically created from the 
respective recipe name. This requires, for example, that the directory "D:\Temp\" has been 
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created. If the directory  "D:\Temp" does not exist, the directory name is used as the prefix for 
the file name, Temp_Recipe names.csv.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithConfirmation) = With confirmation: CSV file is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file formats.

Application example
Using a key, you want to export all data records and assign a checksum.

Notes on configuring

Configure the "ExportDataRecordsWithChecksum" system function on the "Press" event for 
the desired key. Transfer the following parameters:
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● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file and assigned 
checksums. If the file already exists, it will be overwritten.

After exporting the data records, a system message is output.

ExportImportUserAdministration

Description
Exports all users of the user administration of the currently active project to the given file or 
imports the users from the given file into the currently active project.       

Users, their passwords and rights are saved in the user administration.

All users are overwritten when importing. The imported users are valid immediately.

Use in the function list
ExportImportUserAdministration (File name, Direction)

Use in user-defined functions
ExportImportUserAdministration (File_name, Direction)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

File name
Name of the file which contains the passwords or to which the passwords are written. Enter 
the file location and the file extension (*.txt), for example, "C:\TEMP\Passwords.txt".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Direction
Specifies whether passwords are exported or imported:

0 (hmiExport) = Export: Passwords are exported.

1 (hmiImport) = Import: Passwords are imported.

See also
Exporting the user administration (Page 4411)

Importing the user administration (Page 4412)

GoToHome

Description
Executes the key function <Home> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToHome

Use in user-defined functions
GoToHome

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--
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GoToEnd

Description
Executes the key function <End> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToEnd

Use in user-defined functions
GoToEnd

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

SafelyRemoveHardware

Description
Checks whether there is read or write access to the external storage medium. If there is no 
access, the external storage medium can be removed without data loss.       

Use in the function list
SafelyRemoveHardware(Path, Result)

Use in user-defined functions
SafelyRemoveHardware(Path, Result)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Path
Path of storage medium , e.g. \Storage Card USB\
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Result
The tag in which the result is entered.

TRUE : The storage medium can be removed safely. A corresponding system message will 
be issued.

FALSE : The storage medium can be removed safely. A corresponding system message will 
be issued. 

HTMLBrowserStop

Description
Performs the function "Stop" the HTML browser.     

Use in the function list
HTMLBrowserStop (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.

HTMLBrowserRefresh

Description
Performs the function "Refresh" of the HTML browser.     

Use in the function list
HTMLBrowserRefresh (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Object name of the HTML browser in which the command is performed.

HTMLBrowserForward

Description
Performs the function "Forward" of the HTML browser.     

Use in the function list
HTMLBrowserForward (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.

HTMLBrowserBack

Description
Performs the "Back" function of the HTML browser.     

Use in the function list
HTMLBrowserBack (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Object name of the HTML browser in which the command is performed.
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ImportDataRecords

Description
Imports one or all data records of a recipe from a CSV file.       

When a path is specified, all records of the given directory are imported.

Use in the function list
ImportDataRecords (File name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
ImportDataRecords (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the file location 
and the file extension (*.csv), for example "C:\TEMP\Orange.csv".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data records are not overwritten 
until confirmed.

Output status message
Determines whether a status message is output after the import:
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0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Configurable objects

Object Event
Tag Value change

High limit violated
Low limit violated

Function key (global) Release
Press

Function key (local) Release
Press

Screen Loaded
Cleared

Screen object Press
Release
Click
Change (or toggle for switch)
Switch on
Switch off
Enable
Disable

Scheduler Time expired

 

 

ImportDataRecordsWithChecksum

Description
Imports one or all data records of a recipe from a CSV file with a checksum and verifies the 
checksum.       
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Use in the function list
ImportDataRecordsWithChecksum (File name, Data record number/name, Overwrite, Output 
status message, Processing status, verify checksum)

Use in user-defined functions
ImportDataRecordsWithChecksum (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status, Verify_Checksum)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the path and the 
file extension, for example, "C:\TEMP\Orange.CSV".

If a storage card is used as storage medium, specify the storage location as follows: 
"\StorageCard\<File name>".

If you specify a directory instead of an individual CSV file, all files in the specified directory will 
be imported.

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithConfirmation) = With confirmation: Recipe data records are not 
overwritten until confirmed.

Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for example 
to delay execution of other system functions, until this system function has been successfully 
completed.

2 = System function is being performed.

4 = System function was successfully completed.
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12 = System function was not performed because an error has occurred.

Verify checksum
Determines if the checksum should be verified during import:

0 (hmiFalse) = No: Checksum is not verified.

1 (hmiTrue) = Yes: Checksum is verified.

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.

Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
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  ...
}

InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.
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Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

InvertLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       

The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag that contains the value used for calculation.

b
The value which is subtracted.

a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

CalibrateTouchScreen

Description
Calls a program for calibrating the touch screen.       

During the calibration process, there is a prompt to touch five positions on the screen display. 
Touch the screen display within 30 seconds, to confirm the calibration process. If the calibration 
is not completed within this time span, the calibration settings are discarded. The user prompt 
is in English.

Use this system function the first time you start the HMI device.
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Use in the function list
CalibrateTouchScreen

Use in user-defined functions
CalibrateTouchScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

 

 Note

The CalibrateTouchScreen system function cannot be simulated.
 

CopyLog

Description
Copies the contents of a log to another log. Tag values can only be copied to other data logs 
and alarms only to other alarm logs, however.

 

 Note

If you copy a log using the "CopyLog" system function, it is possible that external applications 
will be unable to read certain country-specific special characters in the logged message text 
of the log copy. This does not apply to WinCC Runtime. WinCC Runtime can read the copied 
log files without errors.

 

Use in the function list
CopyLog (Log type, Destination log, Source log, Mode, Delete source log)

Use in user-defined functions
CopyLog (Log_type, Destination log, Source_log, Mode, Delete_source_log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Destination log
Name of the log into which the entries are copied (Destination log).

Source log
Name of the log from which the entries are copied (Source log).

Mode
Determines what is done with copied entries in the destination log:

0 (hmiOverwrite) = Overwrite: Existing entries are overwritten.

2 (hmiAppend) = Append: The entries are inserted at the end of the destination log. When the 
configured size of the log has been reached, the destination log is treated like a circular log.

Delete source log
Determines whether the source log is deleted after copying.

0 (hmiNo) = No: Is not deleted.

1 (hmiYes) = Yes: Is deleted.

TrendViewScrollForward

Description
Scrolls forward one display width in the Trend view.     

Use in the function list
TrendViewScrollForward (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which is scrolled forward.
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TrendViewScrollBack

Description
Scrolls back one display width to the left in the trend view.     

Use in the function list
TrendViewScrollBack (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which is scrolled back.

TrendViewExtend

Description
Reduces the time period which is displayed in the trend view.     

Use in the function list
TrendViewExtend (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the displayed time period is reduced.

TrendViewCompress

Description
Increases the time period which is displayed in the trend view.     
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Use in the function list
TrendViewCompress (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the displayed time period is increased.

TrendViewRulerLeft

Description
Moves the read-line backwards (to the left) in the trend view.     

 

 Note

In order to be able to move the read-line, the read-line must have been switched on. This is 
done using the "TrendViewSetRulerMode" system function.

 

Use in the function list
TrendViewRulerLeft (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the read-line is moved backwards.

See also
TrendViewSetRulerMode (Page 4607)
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TrendViewRulerRight

Description
Moves the read-line forwards (to the right) in the trend view.     

 

 Note

In order to be able to move the read-line, the read-line must have been switched on. This is 
done using the "TrendViewSetRulerMode" system function.

 

Use in the function list
TrendViewRulerRight (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the read-line is moved forward.

See also
TrendViewSetRulerMode (Page 4607)

TrendViewSetRulerMode

Description
Hides or shows the read-line in the trend view. The read-line displays the Y value belonging 
to the X value.     

 

 Note

To ensure that the ruler is displayed, you have to activate the setting "Show ruler" in the trend 
view properties.

 

Use in the function list
TrendViewSetRulerMode (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the read-line is hidden or shown.

See also
TrendViewRulerRight (Page 4606)

TrendViewRulerLeft (Page 4605)

TrendViewStartStop

Description
Stops the trend recording or continues the trend recording in the trend view.     

Use in the function list
TrendViewStartStop (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which the recording of the trend is started or stopped.

TrendViewBackToBeginning

Description
Scrolls back to the beginning of the display range in the trend view.     

Use in the function list
TrendViewBackToBeginning (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the trend view in which you scroll to the beginning of the display range.

See also
System functions for Runtime Advanced (Page 4559)

LoadDataRecord

Description
Loads the given recipe data record from the memory medium of the HMI device in the recipe 
tags. This system function is used, for example, to display a recipe data record in the recipe 
screen.       

Activate the "Synchronize recipe view and recipe tags" option in the synchronization settings 
of the recipe. If this option is deactivated, the system function has no effect. 

Use in the function list
LoadDataRecord (Recipe number/name, Data record number/name, Processing status)

Use in user-defined functions
LoadDataRecord (Recipe_number/name, Data_record_number/name, Confirmation, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which a recipe data record is loaded.

Data record number/name
Number or name of the recipe data record to be loaded.
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

GetUserName

Description
Writes the user name of the user currently logged on to the HMI device in the given tag.       

If the given tag has a control connection, the user name is also available in the PLC connection. 
This system function makes it possible, for example, to implement a user-dependent release 
of certain functionalities.

Use in the function list
GetUserName (Tag)

Use in user-defined functions
GetUserName (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the user name is written.

GetDataRecordFromPLC

Description
Transfers the selected recipe data record from the PLC to the storage medium of the HMI 
device.       

Use in the function list
GetDataRecordFromPLC (Recipe number/name, Data record number/name, Overwrite, 
Output status message, Processing status)
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Use in user-defined functions
GetDataRecordFromPLC (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are transferred.

Data record number/name
Number or name of the recipe data record which is transferred from the PLC to the data medium 
of the HMI device.

Overwrite
Determines whether an existing recipe data record with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data record is not overwritten. The transfer process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data record is overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data record is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to transfer a data record from the PLC to the data medium of the HMI device using 
a key.

Notes on configuring

Configure the "GetDataRecordFromPLC" system function on the "Press" event for the desired 
key. Transfer the following parameters:
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Recipe number/name = 1

Data record number/name = 1

Overwrite = 1

Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data record is transferred from the PLC.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated and the first data record of Recipe 1 is transferred from the PLC to the data medium 
of the HMI device. If the recipe data record already exists, it will be overwritten.

A system message is output after the transfer.

GetDataRecordName

Description
Writes the name of the given recipe and recipe data record to the given tags.     

 

 Note

If the recipe or the recipe data record do not exist, wildcards ("###") are written to the tags.
 

Use in the function list
GetDataRecordName (Recipe number, Data record number, Recipe name, Data record name, 
Processing status)

Use in user-defined functions
GetDataRecordName (Recipe_number, Data_record_number, Recipe_name, 
Data_record_name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency". 

Parameter

Recipe number
Number of the recipe whose name is written to the given tag.

Data record number
Number of the recipe data record whose name is written to the given tag.   
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Recipe name
The tag to which the recipe name is written. The tag must be of the STRING type.

Data record name
The tag to which the name of the recipe data record is written. The tag must be of the STRING 
type.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to output the names of the displayed recipes and the name of the displayed recipe 
data record on the HMI device.

Configure the following tags:

● "RecNumber" of type INTEGER

● "RecDataNumber" of type INTEGER

● "RecName" of type STRING

● "RecDataName" of type STRING

Configure a recipe view with the tags "RecNumber" for the recipe number and 
"RecDataNumber" for the data record number.

Configure the "GetDataRecordName" system function on the "Press" event for a button and 
pass the following parameters:

● Recipe number: RecNumber

● Data record number: RecDataNumber

● Recipe name: RecName

● Data record name: RecDataName

Configure two output fields and connect these to the "RecName" and "RecDataName" tags.

Select a recipe and a data record number from the recipe view. As soon as the button is 
activated, the system function is triggered and the name of the recipe and the recipe data 
record are displayed in both output fields.
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GetDataRecordTagsFromPLC

Description
Transfers the values of the recipe data record loaded in the PLC to the corresponding recipe 
tags.       

This system function is used, for example, during teach-in mode on a machine.

Use in the function list
GetDataRecordTagsFromPLC (Recipe number/name, Processing status)

Use in user-defined functions
GetDataRecordTagsFromPLC (Recipe_number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe data record whose values are written from the PLC to the tags.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

GetGroupNumber

Description
Reads the number of the group to which the user logged on to the HMI device belongs, and 
writes it to the given tag.       

Use in the function list
GetGroupNumber (Tag)
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Use in user-defined functions
GetGroupNumber (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the number of the group is written.

GetBrightness

Description
Reads the value of the brightness.

       

Use in the function list
GetBrightness (Brightness)

Use in user-defined functions
GetBrightness (Brightness)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
The tag to which the value is written. 

GetPassword

Description
Writes the password of the user currently logged on to the HMI device in the given tag.       

 

 Note

Make sure that the value of the given tag is not displayed in another place in the project.
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 Note

The passwords of SIMATIC Logon users cannot be read. 
 

Use in the function list
GetPassword (Tag)

Use in user-defined functions
GetPassword (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the password is written.

ReadPLCMode

Description
Evaluates the current state of the connected PLC.

The system function "ReadPLCMode" can only be configured for the following PLCs:

● SIMATIC S7-1200

● SIMATIC S7-1500

Use in the function list
ReadPLCMode (connection, mode)

Use in user-defined functions
GetPLCMode (Connection, Mode)

Parameters

Connection
Connection of PLC and HMI device.
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Mode
Evaluates the mode of the connected PLC.
8: RUN = The PLC program is being executed.
4: STOP = The PLC program has been interrupted.
Select a suitable user variable for the evaluation.

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       

The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag that contains the value used for calculation.

b
The value that is added.
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Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
 
printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

ClearLog

Description
Deletes all data records in the given log.       

Use in the function list
ClearLog (Log type, Log)

Use in user-defined functions
ClearLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log: 

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log Available for GMP-compliant projects Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log from which all entries are deleted.
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ClearDataRecord

Description
Deletes a recipe data record.       

Several data records can be deleted from one or more recipes.

Use in the function list
ClearDataRecord (Recipe number/name, Data record number/name, Confirmation, Output 
status message, Processing status)

Use in user-defined functions
ClearDataRecord

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are deleted. "0" is specified if 
you want to delete recipe data records from all available recipes.

Data record number/name
Number or name of the recipe data record to be deleted. "0" is specified if you want to delete 
all recipe data records.

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.
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12 = System function was not performed because an error has occurred.

ClearDataRecordMemory

Description
Deletes all recipes data records from the specified storage medium.       

Use in the function list
ClearDataRecordMemory (Storage location, Confirmation, Output status message, 
Processing status)

Use in user-defined functions
ClearDataRecordMemory (Storage_location, Confirmation, Output_status_message, 
Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Storage location
Determines the storage location:

0 (hmiFlashMemory) = Flash memory: Internal flash memory of the HMI device

1 (hmiStorageCard) = Storage card

2 (hmiStorageCard2) = Storage card 2

3 (hmiStorageCard3) = Storage card MultiMediaCard

4 (hmiStorageCard4) = Storage card USB

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

ClearAlarmBuffer

Description
Deletes alarms from the alarm buffer on the HMI device.       

 

 Note

Alarms which have not yet been acknowledged are also deleted.
 

Use in the function list
ClearAlarmBuffer (Alarm class number)

Use in user-defined functions
ClearAlarmBuffer (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Determines which alarms are to be deleted from the alarm buffer:

0 (hmiAll) = All alarms/events

1 (hmiAlarms) = Alarms of alarm class "Errors"

2 (hmiEvents) = Alarms of alarm class "Warnings"

3 (hmiSystem) = Alarms of alarm class "System"
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4 (hmiS7Diagnosis) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

ClearAlarmBufferProTool

Description
The system function exists to ensure compatibility.

It has the same functionality as the "ClearAlarmBuffer" system function, but uses the old 
ProTool numbering.       

Use in the function list
ClearAlarmBufferProTool (Alarm class number)

Use in user-defined functions
ClearAlarmBufferProtoolLegacy (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Alarm class number whose messages are to be deleted:

-1 (hmiAllProtoolLegacy) = All alarms/events

0 (hmiAlarmsProtoolLegacy) = Alarms of alarm class "Errors"

1 (hmiEventsProtoolLegacy) = Alarms of alarm class "Warnings"

2 (hmiSystemProtoolLegacy) = Alarms of alarm class "System"

3 (hmiS7DiagnosisProtoolLegacy) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
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AlarmViewUpdate

Description
Updates the enhanced alarm view.     

Use in the function list
AlarmViewUpdate (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view which is updated.

AlarmViewEditAlarm

Description
Triggers the event "Edit" for all alarms selected in the given alarm view.     

This system function is used when the integrated button of the ActiveX control should not be 
used.

A system function can in turn be configured on the "Edit" event. For example, it is possible to 
change to the process screen in which the alarm appeared.

 

 Note

If the alarms to be edited have not yet been acknowledged, the acknowledgment takes place 
automatically when this system function is called up.

 

Use in the function list
AlarmViewEditAlarm (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the alarm view in which the event is triggered.

 

 Note

The HMI devices listed below do not support this system function for the "screen" object: OP 
73, OP 77A, TP 177A.

 

AlarmViewAcknowledgeAlarm

Description
Acknowledges the alarms selected in the given alarm view.     

This system function is used when the integrated button of the ActiveX control should not be 
used.

Use in the function list
AlarmViewAcknowledgeAlarm (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view in which the event is triggered.

 

 Note

The HMI devices listed below do not support this system function for the "screen" object: OP 
73, OP 77A, TP 177A.

 

AlarmViewShowOperatorNotes

Description
Displays the configured tooltip of the alarm selected in the given alarm view.     
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Use in the function list
AlarmViewShowOperatorNotes (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the alarm view in which the event is triggered.

 

 Note

The HMI devices listed below do not support this system function for the "screen" object: OP 
73, OP 77A, TP 177A.

 

See also
System functions for Runtime Advanced (Page 4559)

OpenAllLogs

Description
Reestablishes the connection between WinCC and the logs. Logging can be continued.       

 

 Note

Run the "StartLogging" system function in order to restart logging.
 

Use in the function list
OpenAllLogs

Use in user-defined functions
OpenAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--
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Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
Logging will be continued in the specified log. 

OpenScreenKeyboard

Description
Hides or shows the screen keyboard.       

The screen keyboard remains open until the screen keyboard is explicitly closed. In this way, 
the screen keyboard can also be used in other applications.

Use in the function list
OpenScreenKeyboard (Layout)

Use in user-defined functions
OpenScreenKeyboard (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Specifies whether the window is opened minimized or maximized with the screen keyboard:

0 (hmiScreenKeyboardMinimized) = Minimized

1 (hmiScreenKeyboardMaximized) = Maximized
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OpenFileBrowser

Description
Opens a file browser dialog. 

Depending on the mode the user can select a file or a folder.

Use in the function list
OpenFileBrowser (Mask, Output Folder, File, Navigation Back, Navigation Up, New folder, 
Path, Status)

Use in user-defined functions
-

Parameters

Mask
Sets a mask for filtering the displayed files. This parameter is only evaluated in "File" mode. 
The filter criteria must be delimited by ; semicolon. Example: *.htm;*.html

Start folder
Specifies the folder with which the file selection dialog starts.

File
Specifies the mode in which the dialog is opened.

0 = folder search mode 

1 = file search mode

Navigation Back
Specifies whether or not the "Back" button is activated. This button offers simple navigation to 
the last folder you opened.

Navigation Up
Specifies whether or not the "Up" button is activated. This button offers simple navigation to 
the parent folder.

New folder
Specifies whether or not the button can be used to create a new folder.

Path
Contains the path name of the last folder opened after you close the dialog.

Status
Returns information about the dialog closing mode 
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-1 = dialog was canceled

0 = dialog was closed with "OK".

OpenControlPanelDialog

Description
Opens a dialog that you can use to edit selected Control Panel settings.       

This system function lets you set the following on the HMI device:

● Properties and value of the IP address

● User identification on the network

● WinCC Internet settings
 

 Note
Project security

The "OpenControlPanelDialog" system function is used to bypass the SecureMode on the 
HMI device. Take the corresponding precautions to ensure the security of your project.  

 

Use in the function list
OpenControlPanelDialog (Dialog)

Use in user-defined functions
-

Parameters

Dialog
Sets the Control Panel dialog to be opened.

● PROFINET_X1: Setting of the IP address and Ethernet parameters

● PROFINET_X3: Setting of the IP address and Ethernet parameters; only for Comfort Panel 
KP 1500, TP 1500; TP1900, TP2200

● WinCC Internet settings: Setting for Web Server, e-mail notification, provided the HMI 
device supports these functions

● Network ID: Setting for identification on the network, provided the HMI device supports 
these functions
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OpenCommandPrompt

Description
Opens a Windows system prompt.       

This function is used, e.g., to copy files or to call up another application.

Use in the function list
OpenCommandPrompt

Use in user-defined functions
OpenCommandPrompt

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

OpenInternetExplorer

Description
Opens the Internet Explorer on the HMI device.       

If the Internet Explorer is already open, it will be closed and reopened when you call the system 
function.

 

 Note

The Internet Explorer saves data temporarily in the DRAM file system of the HMI device, e.g. 
the last web sites that were be called up.

This data can be saved using the "BackupRAMFileSystem" system function so that it is still 
available when the HMI device is restarted.

 

Use in the function list
OpenInternetExplorer (Start page)

Use in user-defined functions
OpenInternetExplorer (Start_page)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Start page
The page which is loaded when Internet Explorer is started, e.g. "www.siemens.com".

OpenControlPanel

Description
Opens the window that displays the Windows CE control panel. You cannot use this system 
function on a PC.       

This system function enables you to set the following on the Windows CE-based HMI device:

● Select printer

● Select transfer properties

● Configure screen saver

● Configure flash memory
 

  Note
No backup or restore during Runtime

Backup and restore functions may only be executed if Runtime has been terminated. 
Otherwise, this could result in undesired effects, such as display errors.

 

Use in the function list
OpenControlPanel

Use in user-defined functions
OpenControlPanel

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters
--
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OpenTaskManager

Description
Shows the task manager.       

The task manager allows changing to other open applications on the HMI device.
 

 Note

The appearance of the task manager depends on the operating system installed.
 

Use in the function list
OpenTaskManager

Use in user-defined functions
OpenTaskManager

Can be used if the configured device supports user-defined scripts. For additional information, 
refer to "Device dependency".

Parameter
--

AcknowledgeAlarm

Description
Acknowledges all selected alarms.       

This system function is used when the HMI device does not have an ACK key or when the 
integrated key of the alarm view should not be used.

This system function can only be used for function keys.

Use in the function list
AcknowledgeAlarm

Use in user-defined functions
AcknowledgeAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
--

RecipeViewNewDataRecord

Description
Creates a new data record in the given recipe view.     

Use in the function list
RecipeViewNewDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the new recipe data record is created.

RecipeViewGetDataRecordFromPLC

Description
Transfers the data record that is currently loaded in the PLC to the HMI device and displays it 
in the recipe view.     

Use in the function list
RecipeViewGetDataRecordFromPLC (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the recipe data record from the PLC is displayed.
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RecipeViewClearDataRecord

Description
Deletes the data record which is currently displayed in the recipe view.     

Use in the function list
RecipeViewClearDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the displayed recipe data record is deleted.

RecipeViewMenu

Description
Opens the menu of the specified simple recipe view.     

Only use this system function at a simple recipe view.

Use in the function list
RecipeViewMenu (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the menu is to be opened.
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RecipeViewOpen

Description
Displays the data record values in the given recipe view or changes to the next selection field. 
The system function has no effect if the selection field for the recipe data record values is 
displayed on the HMI device.   

Operation sequence of the selection lists in runtime:

● Recipe name

● Data record name

● RecipeDataRecordValues

This system function is used when a simple recipe view has been configured. In the simple 
recipe view, only one selection list is displayed at a time on the HMI device. Use the 
"RecipeViewBack" system function to display the previous selection list.

Use in the function list
RecipeViewOpen (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the command is triggered.

See also
RecipeViewBack (Page 4637)

RecipeViewSetDataRecordToPLC

Description
Transfers the recipe data record which is currently displayed in the recipe view to the PLC.     

Use in the function list
RecipeViewSetDataRecordToPLC (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view from which the recipe data record is transferred to the connected PLC.

RecipeViewSaveDataRecord

Description
Saves the recipe data record which is currently displayed in the recipe view.     

Use in the function list
RecipeViewSaveDataRecord (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the recipe data record is saved.

RecipeViewSaveAsDataRecord

Description
Saves the data record currently being displayed in the recipe view under a new name.     

Use in the function list
RecipeViewSaveAsDataRecord (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Saves the data record currently being displayed in the recipe view under a new name and/or 
new number.

RecipeViewSynchronizeDataRecordWithTags

Description
Synchronizes the values of the data record which is currently displayed in the recipe view with 
their recipe tags. Only use this system function at an advanced recipe view.    

During synchronization, all values of the data record are written to their recipe tags.

Use in the function list
RecipeViewSynchronizeDataRecordWithTags (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the values are synchronized with their tags.

 

 Note

The OP 77A and TP 177A HMI devices do not support this function for the screen object.
 

RecipeViewRenameDataRecord

Description
Renames the selected data record in the given recipe view.     

Only use this system function at a simple recipe view.

Use in the function list
RecipeViewRenameDataRecord (Screen object)
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Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the recipe data record is renamed.

RecipeViewShowOperatorNotes

Description
Displays the configured tooltip of the specified recipe view.     

Use in the function list
RecipeViewShowOperatorNotes (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view whose configured tooltip is displayed.

RecipeViewBack

Description
Returns to the previous selection list in the given recipe view.     

The system function has no effect if the selection field for the recipe is displayed on the HMI 
device. Operation sequence of the selection lists in runtime:

● Recipe name

● Data record name

● RecipeDataRecordValues

This system function is used when a simple recipe view has been configured. In the simple 
recipe view, only one selection list is displayed at a time on the HMI device. Use the 
"RecipeViewOpen" system function to display the recipe data record values or the next 
selection field.
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Use in the function list
RecipeViewBack (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the recipe view in which the command is triggered.

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).

Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
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//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
ResetBitInTag (Page 4639)

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).

Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.
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Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
ResetBit (Page 4637)

PressButton

Description
The system function can only be configured on the function keys of an HMI device and triggers 
the "Press key" event at the specified screen object.     

Use this system function when you want to operate a button in a screen with a function key of 
the HMI device, for example.

 

 Note

The "PressButton" and "ReleaseButton" system functions must always be configured 
together. If you configure the "PressButton" system function on the "Press key" event for a 
function key, the "ReleaseButton" system function is configured on the "Release" event for 
the same function key.

 

Use in the function list
PressButton (Screen object)

Use in user-defined functions
-
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Parameters

Screen object
Name of the screen object on which the event is triggered.

ReleaseButton

Description
The system function can only be configured on the function keys of an HMI device and triggers 
the "Release button" event at the specified screen object.     

Use this system function when you want to operate a button in a screen with a function key of 
the HMI device, for example.

 

 Note

The "PressButton" and "ReleaseButton" system functions must always be configured 
together. If you configure the "PressButton" system function on the "Press key" event for a 
function key, then the "ReleaseButton" system function is configured on the "Release key" 
event for the same function key.

 

Use in the function list
ReleaseButton (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the screen object on which the event is triggered.
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ShiftAndMask

Description
This system function converts the input bit pattern of the source tags into an output bit pattern 
of the target tags. This involves bit shifting and masking.

 

 Note

If the source and target tag have a different number of bits, using the system function in the 
target tag can result in a violation of the value range.

 

Use in the function list
ShiftAndMask (Source tag, Target tag, Bits to shift, Bits to mask)

Use in user-defined functions
ShiftAndMask (Source_tag, Target_tag, Bits_to_shift, Bits_to_mask)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Source tag
The tag includes the input bit pattern. Integer-type tags, e.g. "Byte", "Char", "Int", "UInt", "Long" 
and "ULong" are permitted. 

Example: The actual value 72 is set at the 16-bit integer source tag: 0000000001001000.

Target tag
The output bit pattern is saved in the tag. Integer type tags, e.g. "Byte", "Char", "Int", "UInt", 
"Long" and "ULong" are permitted.

Example: The shifted input bit pattern is multiplied by the bit mask, with bit-by-bit logical AND 
operation: 0000000000001001. The resultant decimal value "8" is saved to the target tag.

Please note the following:

● The source and target tags have the same number of bits.

● The number of bits to shift is less than the number of bits in the source tag and target tag.

● Bits to mask does not have more bits than the source tag and the target tag.

Bits to shift
Number of bits by which the input bit pattern is shifted right. A negative value shifts the input 
bit pattern to the left.

Example: "Bits to shift" has the value "+3". The input bit pattern is shifted right by three bits 
when the system function is called: 0000000000001001.
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Bits to the left are padded with "0". Three bits are truncated on the right. The new decimal 
value is "9".

 

 Note

The left bit is "1" in a source tag of the data type with negative signed integer. This sign bit 
is padded with "0" when the bits are shifted right. The sign changes to "+".

 

Bits to mask
An integer serves as bit mask. The bit pattern is used to multiply the shifted input bit pattern. 
Example: Integer "2478" with the bit pattern "0000100110101110".

You can enter the bit mask in three different ways:

● Hexadecimal: First enter the prefix "0h" or "0H", followed by an optional space for better 
readability. Then group the bit pattern in blocks of four (0000)(1001)(1010)(1110) and set 
each block in hexadecimal code: (0)(9)(A)(E). Only the characters 0-9, A-F, a-f are allowed: 
"0h 09AE".

● Binary: First enter the prefix "0b" or "0B", followed by an optional space for better readability. 
Then group the binary bit pattern into blocks of four 0000 1001 1010 1110 with spaces in 
between as a check. Only the characters "0" or "1" are allowed: "0b 0000 1001 1010 1110".

● Decimal: Enter the value "2478" directly, without a prefix.

CloseAllLogs

Description
Disconnects the connection between WinCC and all logs.       

 

 Note

Before you close a log, the logging function must first be stopped in the log. Use the 
"StopLogging" system function.

 

Use in the function list
CloseAllLogs

Use in user-defined functions
CloseAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
--

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
The logging process will continue in the specified log.

SetDataRecordToPLC

Description
Transfers the given recipe data record directly from the data medium of the HMI device to the 
PLC with which the HMI device is connected.       

 

 Note

The values of the recipe data record don't need to be displayed on the HMI device.
 

Use in the function list
SetDataRecordToPLC (Recipe number/name, Data record number/name, Output status 
message, Processing status)

Use in user-defined functions
SetDataRecordToPLC (Recipe_number/name, Data_record_number/name, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC.

Data record number/name
Number or name of the recipe data record to be transferred to the PLC. 

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SetDataRecordTagsToPLC

Description
Transfers the values of the recipe tags to the PLC. The recipe tags contain the values of the 
data record which is displayed on the HMI device.       

Use in the function list
SetDataRecordTagsToPLC (Recipe number/name, Processing status)

Use in user-defined functions
SetDataRecordTagsToPLC (Recipe_ number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC. 
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

PageDown

Description
Executes the key function <Pagedown> on the HMI device. 

This system function can only be used for function keys.       

Use in the function list
PageDown

Use in user-defined functions
PageDown

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-

PageUp

Description
Executes the key function <PageUp> on the HMI device. 

This system function can only be used for function keys and tasks with a time trigger.       

Use in the function list
PageUp

Use in user-defined functions
PageUp
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-

SendEMail

Description
Sends an e-mail from the HMI device to the given addressee.       

This system function is used, for example, when, in the case of service, the alarm is to be 
passed on directly to the service technician.

 

 Note

To send alarms as e-mails, the HMI system must have an e-mail client at its disposal.
 

Use in the function list
SendEMail (Address, Subject, Text, Return address)

Use in user-defined functions
SendEMail (Address, Subject, Text, Return_address)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Address
The e-mail address of the addressee.

Subject
The subject line of the e-mail.

Text
The text sent in the e-mail.

Return address
The e-mail address to which the addressee of this e-mail should send the reply.
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SetAcousticSignal

Description
Configures the acoustic feedback of touch screen operation on the HMI device.       

 

 Note

The configuration that was set at Switch off is reestablished when restarting the HMI device.
 

Use in the function list
SetAcousticSignal (Volume)

Use in user-defined functions
SetAcousticSignal (Volume)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Volume
Determines whether and how loud an acoustic signal is emitted:

-1 (hmiToggle) = Toggle: Toggles the emission of the acoustic signal as follows: Muted > Quiet 
> Loud.

0 (hmiMuted) = Mute: no acoustic signal

1 (hmiQuiet) = Quiet: quiet acoustic signal

2 (hmiLoud) = Loud: loud acoustic signal

SetDisplayMode

Description
Changes the settings of the screen in which the runtime software runs.       

The runtime software runs in full-screen mode as default. The Windows task switch is disabled.

Use in the function list
SetDisplayMode (Layout)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4647



Use in user-defined functions
SetDisplayMode (Display mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines the settings for the screen in which the runtime software runs.

1 (hmiScreenFull): Full-screen: Title bar of the screen is not visible

2 (hmiScreenMaximized): Maximized

3 (hmiScreenRestore): Restore: The last used screen setting is used. This layout can only be 
used when the window is displayed minimized or maximized.

4 (hmiScreenMinimized): Minimized

5 (hmiScreenAutoAdjust): Automatic: The size of the window is set so that all screen objects 
in it will be visible.

6 (hmiScreenOnTop): Foreground; either the window appears in the foreground or the program 
icon associated with the window flashes on the taskbar depending on the Windows setting. 
The setting can be changed in the Windows configuration and applies to all Windows 
applications.

SetDeviceMode

Description
Toggles the operating mode on the HMI device. The following types of operation are possible: 
"Online", "Offline" and "Load".       

Use in the function list
SetDeviceMode (Operating mode)

Use in user-defined functions
SetDeviceMode (Operating_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Operating mode
Determines the operating mode of the HMI device:
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0 (hmiOnline) = Online: The connection to the PLC is established. The configured connection 
status is always set in this process. The states that were last used in Runtime are not 
considered.

1 (hmiOffline) = Offline: The connection to the PLC is disconnected.

2 (hmiTransfer) = load: A project can be transferred from the configuration computer to the 
HMI device.

 

 Note

If you use a PC as an HMI device, the runtime software will be exited when you change 
operating mode after "Load".

 

See also
SetConnectionMode (Page 4662)

SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
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BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).
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When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.

 

Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
SetBit (Page 4649)

SetBitWhileKeyPressed

Description
Sets the bit of the given tag to 1 (TRUE) as long as the user keeps the configured key 
pressed.     

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC. You should 
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only access tags of the BOOL type with this system function to avoid problems with overlapping 
access to the same tag. 

 

 Note

All functions on the event "Release" are performed immediately by means of a screen change 
configured for a key, even if the key is kept pressed.

If the "SetBitWhileKeyPressed" system function is configured for a function key, the bit will 
be reset immediately following a screen change. This action is necessary since the key 
assignments change after the screen change.

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitWhileKeyPressed (Tag, Bit)

Use in user-defined functions
-

Parameters

Tag
The tag in which a bit is temporarily set to 1 (TRUE). Use only tags of the type BOOL, as far 
as allowed by the PLC.

Bit
The number of the bit that is temporarily set to 1 (TRUE).

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an IO field, or assign 
the function to a screen element such as a button.

If you configured a short event such as the activation of an alarm for the function you can 
only access the actual process values by setting the tag for continuous reading.

 

See also
SetBit (Page 4649)
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SetBacklightColor

Description
Defines the background lighting of the button.     

 

 Note

The configuration that was set at Switch off is reestablished when restarting the HMI device.
 

Use in the function list
SetBacklightColor (Value)

Use in user-defined functions
-

Parameters

Value
Defines the background lighting of the button:

0 (hmiWhite) = White: No color 

1 (hmiGreen) = Green: Green color

2 (hmiYellow) = Yellow: Yellow color

3 (hmiRed) = Red: Red color

SetBrightness

Description
Determines the brightness of the display.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetBrightness (value)
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Use in user-defined functions
SetBrightness (Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Value
New value for the brightness. 

SetScreenKeyboardMode

Description
Enables or disables the automatic display of the screen keyboard on the HMI device.       

This system function is also used to prevent the display of the screen keyboard, e.g. because 
an external keyboard is connected to the HMI device.

 

 Note

To enable the "SetScreenKeyboardMode" ("SetScreenKeyboardMode") system function on 
an HMI other than a Touch Panel device, set the "Use on-screen keyboard" check box in the 
"Runtime settings" dialog of the device settings.

 

Use in the function list
SetScreenKeyboardMode (Mode)

Use in user-defined functions
SetScreenKeyboardMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether the screen keyboard is hidden or shown:

0 (hmiOff) = Off: Screen keyboard is hidden

1 (hmiOn) = On: Screen keyboard is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes.
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SetPLCDateTime

Description
Changes the data and the time of the linked PLC  

The system function "SetPLCDateTime" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Use in the function list
SetPLCDateTime (connection, time)

Use in user-defined functions
SetPLCDateTime (Connection, Time)

Parameters

Connection
Connection of PLC and HMI device.

Time
Transfers the date and the time of the HMI device to the PLC. The PLC applies the date and 
the time of the HMI device.

SetPLCMode

Description
Switches the operating mode of the PLC to one of the following states:  

● RUN

● STOP

The system function "SetPLCMode" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Use in the function list
SetPLCMode (connection, mode)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4655



Use in user-defined functions
SetPLCMode (Connection, Mode)

Parameters

Connection
Connection of PLC and HMI device.

Mode
Specifies the operating mode of the PLC:

RUN = the PLC is switched to the RUN state. The PLC program is executed.

STOP = the PLC is switched to the STOP state. The PLC program is interrupted.

SetAlarmReportMode

Description
Switches the automatic reporting of alarms on the printer on or off.       

Use in the function list
SetAlarmReportMode (Mode)

Use in user-defined functions
SetAlarmReportMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether alarms are reported automatically on the printer:

0 (hmiDisablePrinting) = Reporting off: Alarms are not printed automatically.

1 (hmiEnablePrinting) = Reporting On: Alarms are printed automatically.

-1 (hmiToggle) = Toggle: Toggles between the two modes.

SetRecipeTags

Description
Changes the status of the recipe tags from "Online" to "Offline" and vice versa.       
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This system function is used, for example, when recipe data record values are fine tuned when 
starting up a machine.

Use in the function list
SetRecipeTags (Recipe number/name, Status, Output status message, Processing status)

Use in user-defined functions
SetRecipeTags (Recipe_number/name, Status, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe in which the recipe data record is saved.

Status
Determines the status of the recipe tags:

0 (hmiOnline) = Online: Value changes of the recipe tags are transferred immediately to the 
PLC connected to the HMI device.

1 (hmiOffline) = Offline: Value changes to the recipe tags are only transferred to the PLC 
connected to the HMI device when, for example, the "SetDataRecordTagsToPLC" system 
function is executed.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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SetDaylightSavingTime

Description
The system function "SetDaylightSavingTime" changes the setting of the HMI device from 
daylight saving to standard time and vice versa.

Time settings will take place immediately following system function.     
 

 Note

The "SetDaylightSavingTime" system function does not support time zones without daylight 
saving time. 

 

 Note
Windows 7

The system function "SetDaylightSavingTime" is not supported for PC-based HMI devices 
under Windows 7.

 

Use in the function list
SetDaylightSavingTime(DaylightSavingTime)

Use in user-defined functions
SetDaylightSavingTime (Daylight_saving_time)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Daylight Saving Time
Determines whether Daylight Saving Time is set on the HMI device:

0 = Daylight Saving Time is not activated

1 = Daylight Saving Time is activated

SetLanguage

Description
Toggles the language on the HMI device. All configured text and system events are displayed 
on the HMI device in the newly set language.       
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Use in the function list
SetLanguage (Language)

Use in user-defined functions
SetLanguage (Language)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Language
Determines which language is set on the HMI device. The following specifications are possible:

● -1 (hmiToggle) = Toggle: Changes to the next language. The sequence is determined 
during configuration in the "Project languages" editor.

● Number you have defined under "Languages and fonts" in the "Runtime Settings" editor. 
Changes to the language with the given number.

● Language you have defined under "Languages and fonts" in the "Runtime Settings" editor.

● Language abbreviation in accordance with the VBScript5 reference: This changes to the 
language corresponding to the specified language code, e.g. "de-DE" for German 
(Germany) or "en-US" for English (United States).
An overview of the language abbreviations is available in the basic information of VBScript 
under the topic "Area diagram-ID (LCID) Diagram".

SetAndGetBrightness

Description
Determines the brightness of the MP 377 Touch daylight readable display. The brightness 
value can be interpreted as absolute or relative to the current value.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetAndGetBrightness (Brightness, Mode, Current value)

Use in user-defined functions
SetAndGetBrightness (Brightness, Mode, Actual brightness)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
New value for the brightness.

Mode
Specifies if the new brightness value is set as absolute or relative to the current value.

Current value
Tag in which the current brightness value is stored.

See also
Device dependency (Page 4528)

SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.
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Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
 

Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

SetConnectionMode

Description
Connects or disconnects the given connection.       

 

 Note

A connection to the PLC cannot be established until the operating mode ONLINE has been 
set on the HMI device. Use the "SetDeviceMode" system function for this purpose.
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Use in the function list
SetConnectionMode (Mode, Connection)

Use in user-defined functions
SetConnectionMode (Mode, Connection)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether a connection to the PLC is established or disconnected:

0 (hmiOnline) = Online: Connection is established.

1 (hmiOffline) = Offline: Connection is disconnected.

Connection
The PLC to which the HMI device is connected. You specify the name of the PLC in the 
connection editor.

Multiple use of the system function in a user-defined function
If you use the "SetConnectionMode" system function for different connections, it may be 
possible that not all system functions are executed correctly. Proceed as follows to prevent 
this situation:

1. Create a "BOOL" type tag with the start value "0".

2. Configure the "SetConnectionMode" system function on the "Value change" event of the 
HMI tags. If you want to disconnect three connections, for example, you must configure the 
system function three times.

3. In the user-defined function, apply the "InvertBit" system function to the HMI tag.

Application example
Two typical application examples for this system function are as follows:

● Test
As long as no PLC is connected to the HMI device, no error messages will be output during 
the test on the HMI device. If the HMI device is connected to a PLC, the connection to the 
PLC can be established by pressing a key.

● Commissioning
Several PLCs are to be configured for a system. At first, all PLCs except one are configured 
"Offline". After commissioning of the first PLC, the connection to each of the other PLCs is 
established by pressing a key. In this way, the other PLCs are started up one after another.
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SetWebAccess

Description
Determines the access mode to the runtime application using the Internet.       

Use in the function list
SetWebAccess (Access mode)

Use in user-defined functions
-

Parameters

Access mode
Determines the access mode to the runtime application:

-1 (hmiToggle) = Toggle: Toggles between the two modes.

0 (hmiReadOnly) = Read-only.

1 (hmiReadWrite) = Read-write.

BackupRAMFileSystem

Description
Backs up the RAM file system in the memory medium of the HMI device.       

After restarting the HMI device, the data is automatically reloaded in the RAM file system.

Applications such as the Internet Explorer save data (e.g. the last web sites called up) 
temporarily to the DRAM file system of the HMI device.

Use in the function list
BackupRAMFileSystem

Use in user-defined functions
BackupRAMFileSystem

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
--

SimulateSystemKey

Description
Simulates the behavior of a System Key. Use this system function if a system key, such as 
the "ACK" key, "Input" key or the number pad is not available on the HMI device. 

Use in the function list
SimulateSystemKey (System key)

Use in user-defined functions
-

Parameters

System key
System Key, the behavior for which is to be simulated. 

System key "+/-"
With the SimulateSystemKey system function, the system key "+/-" is only supported for the 
following HMI devices:

● KP300 Basic

● KP400 Basic

● KTP400 Basic mono PN

● KTP400 Basic color PN

● KTP400 Basic color PN Portrait

● KTP600 Basic mono PN

● KTP600 Basic color PN

● KTP600 Basic color DP

● KTP1000 Basic PN

● KTP1000 Basic DP

Use the system keys "+" and "-" separately for all other HMI devices.
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SimulateTag

Description
Simulates the behavior of tags and dynamic objects such as text lists, without having the HMI 
device connected to a PLC.  You can, for example, configure the system function to the 
"Loaded" event of a screen.   

This system function is used, for example, to demonstrate the functionality of a project.

Only tags of the data type Integer can be used for simulation. Tags of the data types Integer 
and Double Integer, however, can be used with OP 73, OP 77A, TP 177A.

 

 Note

If you use the system function "SimulateTag" with a short cycle time on a Basic Panel, the 
HMI device may be overloaded.

 

Use in the function list
SimulateTag (Tag, Cycle, Maximum value, Minimum value, Value)

Use in user-defined functions
-

Parameter

Tag
The tag whose value is changed. 

Cycle
The factor by which the basic cycle of 200 milliseconds is multiplied. The cycle defines when 
the tag value is changed by the specified value. Possible cycles between 1 and 32767.

Maximum value
The maximum value that the tag can assume during simulation. The maximum value must be 
greater than the minimum value but less than / equal to 32767. 

Minimum value
The minimum value that the tag can assume during simulation. The minimum value must be 
lower than the maximum value but greater than / equal to -32768. 

Value
The value by which the tag value is changed during each cycle. Possible values between 
-32768 and 32767.
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● A positive value increases the tag value. When the maximum value is reached, the tag 
value is set to the minimum value after the next update cycle.

● A negative value reduces the tag value. When the minimum value is reached, the tag value 
is set to the maximum value after the next update cycle.

SmartClientViewRefresh

Description
Updates the contents displayed in the Sm@rtClient view.     

Use in the function list
SmartClientViewRefresh (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

SmartClientViewReadOnlyOff

Description
Sets read-only access to "Off" in the Sm@rtClient view.     

This setting allows a distant HMI device to be operated. The "SmartClientViewReadOnlyOn" 
system function is used to switch read-only access on again.

Use in the function list
SmartClientViewReadOnlyOff (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.
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SmartClientViewReadOnlyOn

Description
Sets read-only access to "On" in the Sm@rtClient view.     

This setting allows a distant HMI device to be monitored only. The 
"SmartClientViewReadOnlyOff" system function is used to switch read-only access off again.

Use in the function list
SmartClientViewReadOnlyOn (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

SmartClientViewDisconnect

Description
Executes the "Disconnect" command in the Sm@rtClient view.     

This system function is used when the integrated button of the screen object should not be 
used. 

Use in the function list
SmartClientViewDisconnect (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.
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SmartClientViewConnect

Description
Executes the "Connect" command in the Sm@rtClient view.     

This system function is used when the integrated button of the screen object should not be 
used. The Sm@rtClient view establishes a connection with the configured HMI device.

Use in the function list
SmartClientViewConnect (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.

SmartClientViewLeave

Description
Exits the Sm@rtClient view and returns to operation of the HMI device.     

The connection to the HMI device configured in the smart client view is retained.

Use in the function list
SmartClientViewLeave (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Sm@rtClient view in which the command is triggered.
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SaveDataRecord

Description
Saves the current values of the recipe tags as data record to the memory medium of the HMI 
device.       

This system function is used, for example, to save a recipe data record in the recipe screen.

Use in the function list
SaveDataRecord (Recipe number/name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
SaveDataRecord (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Recipe number/name
Number or name of the recipe to which a recipe data record is saved.

Data record number/name
Number or name of the recipe data record to be saved. A new data record will be created if 
no record of this name or number was found in the recipe, independent of the value at the 
"Overwrite" parameter.

Overwrite
Specifies whether an existing data record is overwritten:

0 (hmiOverwriteForbidden) = No: The recipe data record is not overwritten, the data record is 
not saved.

1 (hmiOverwriteAlways) = Yes: The recipe data record is overwritten without a prompt for 
confirmation.

2 (hmiOverwriteWithPrompting) = With confirmation: The recipe data record is overwritten only 
with confirmation by the user.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

StartLogging

Description
Starts the logging of data or alarms in the specified log. The function can also be applied to 
audit trails.       

You can interrupt logging at runtime using the "StopLogging" system function.

Use in the function list
StartLogging (Log type, Log)

Use in user-defined functions
StartLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log which is started.

See also
Managing logging behavior when Runtime starts (Page 3764)
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StartNextLog

Description
Stops the logging of data or alarms for the given log.

Logging is continued in the next log of the segmented circular log you configured for the 
specified log.

If you did not configure a segmented circular log for the specified log, the system function has 
no effect.       

Use in the function list
StartNextLog (Log type, Log)

Use in user-defined functions
StartNextLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Log
Name of the log for which the logging is stopped and continued in the next log.

StartProgram

Description
Starts the specified program on the HMI device.       

The runtime software continues running in the background. Alarms continue to be output and 
data continues to be updated.

When the given application is exited, the screen which was active during the performance of 
the system function is displayed on the HMI device.
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This system function is used, for example, to edit recipe data records in MS Excel on the HMI 
device.

 

 Note

If Windows CE is installed on the HMI device, during the configuration it must be checked 
whether the desired application can be started with this system function.

This system function allows all applications to be started which can be started in the "Execute" 
dialog of Windows CE.

The application to be started must be installed on the HMI device.
 

Use in the function list
StartProgram (Program name, Program parameters, Layout, Wait for program to end)

Use in user-defined functions
StartProgram (Program_name, Program_parameters, Display_mode, 
Wait_for_program_to_end)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Program name
Name and path of the program which is started. Upper and lower case are taken into account 
in this parameter.

 

 Note

If the path contains spaces, the program can only be started correctly if the path is specified 
in inverted commas, e.g. "C:\Program Files\START\start.exe".

 

Program parameters
The parameters you transfer at the start of the program, for example a file that is opened after 
the start of the program. 

The description of the necessary parameters is found in the documentation of the program to 
be started.

Layout
Determines how the program window is displayed on the HMI device:

0 (hmiShowNormal) = Normal

1 (hmiShowMinimized) = Minimized

2 (hmiShowMaximized) = Maximized
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3 (ShowMinimizedAndInactive) = Minimized and inactive

Wait for program to end
Determines whether there is a change back to the project after the called up program has 
ended:

0 (hmiNo) = No: No change to project

1 (hmiYes) = Yes: Change to project
 

 Note

The "Wait for program to end" parameter is only available for Runtime Advanced and Panels.
 

StatusForceGetValues

Description
Starts or stops the updating of values in the Status/Force display. The values are read from 
the PLC connected to the HMI device until the update is stopped.     

 

 Note

As long as the values are updated, no entries are possible in the input fields of the Status/
Force display.

 

Use in the function list
StatusForceGetValues (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Status/Force display to which data from the PLC is written.

StatusForceSetValues

Description
Writes the values from the Status/Force display to the PLC to which the HMI device is 
connected.    
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Use in the function list
StatusForceSetValues (Screen object)

Use in user-defined functions
-

Parameters

Screen object
Name of the Status/Force display from which data is written to the PLC.

ControlSmartServer

Description
Starts or stops the Sm@rtServer.       

Use in the function list
ControlSmartServer (Mode)

Use in user-defined functions
ControlSmartServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Sm@rtServer is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: Sm@rtServer is stopped

1 (hmiStart) = Start: Sm@rtServer is started

ControlWebServer

Description
Starts or stops the Web server.       

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4674 System Manual, 02/2014



Use in the function list
ControlWebServer (Mode)

Use in user-defined functions
ControlWebServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Web server is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: The Web server is stopped.

1 (hmiStart) = Start: The Web server is started.

StopLogging

Description
Stops the logging of process values or alarms in the specified log. The function can also be 
applied to audit trails.       

The "StartLogging" system function is used to resume logging at runtime.
 

 Note

When logging is stopped, a connection between WinCC and the log files or log database still 
exists. Use the "CloseAllLogs" system function to disconnect this connection.

 

Use in the function list
StopLogging (Log type, Log)

Use in user-defined functions
StopLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4675



Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log that is stopped.

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. The "Open Archive" button opens all logs and 
continues logging in the specified log.

StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)

Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

ActivateSystemDiagnosticsView

Description
Activates the system diagnostics view. The system diagnostics view shows the detail view of 
the device concerned.       

Use in the function list
ActivateSystemDiagnosticsView (Screen name, Object name)

Use in user-defined functions
ActivateSystemDiagnosticsView (Screen_name, Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Screen name
Name of the screen contained in the system diagnostics view.

Object name
Object name of the system diagnostics view.
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SystemDiagnosticsViewRefreshPLCBuffer

Description
Refreshes the data from the diagnostics buffer of the PLC in the system diagnostics view. 

Use in the function list
SystemDiagnosticsViewRefreshPLCBuffer (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view.

SystemDiagnosticsViewDetailView

Description
The detail view returns detailed information about the selected connection and errors 
pending.     

Use in the function list
SystemDiagnosticsViewDetailView (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view that is switched to the detail view.

SystemDiagnosticsViewDiagnosticsBuffer

Description
Opens a view in a system diagnostics for displaying the current data of the diagnostics buffer.     
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Use in the function list
SystemDiagnosticsViewDiagnosticsBuffer (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view that is switched to the detail view.

SystemDiagnosticsViewDeviceView

Description
Opens a view in a system diagnostics for displaying all available connections.     

Use in the function list
SystemDiagnosticsViewDeviceView (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view.

SystemDiagnosticsViewBack

Description
Changes in a system diagnostics to the higher-level view. 

● The function opens the device view if the diagnostics buffer view is set in the system 
diagnostics view.

● The function opens the diagnostics buffer view if the detail view is displayed in the system 
diagnostics view.     
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Use in the function list
SystemDiagnosticsViewBack (Object name)

Use in user-defined functions
-

Parameters

Object name
Name of the system diagnostics view.

LookupText

Description     
Identifies an entry from a text list. The result depends on the value and on the selected runtime 
language. The result is saved to a tag of data type "String".

Use in the function list
LookupText (Output text, Value, Language, Text list)

Use in user-defined functions
LookupText (Output_text, Index, Language, Text_list)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Output text
The tag to which the result is written.

Value
The tag that defines the value of the list entry. 

Language
Defines the runtime language in which the list entry is identified. 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4680 System Manual, 02/2014



● Runtime language
Language code as per VBScript reference, for example, "de-DE" for German (Germany) 
or "en-US" for English (United States of America). The selection depends on the activated 
runtime languages. 

● Tag
The tag that contains the language. Enter the runtime language as decimal value of the 
country ID, for example, 1031 for German - Standard, 1033 for English - USA. Details are 
available in the VBScript basics, "Locale identifier (LCID) diagram".

● Integer
The number that corresponds to the order of runtime languages for language switching. 
The selection depends on the activated runtime languages, for example, "0" for the 
language that appears when you first start runtime. You can find more information under 
the topic of "Languages in Runtime".

Text list
Defines the text list. The list entry is read from the text list.

See also
Languages in runtime (Page 6902)

ResetTagToHandWheel

Description
Separates the tag that is connected with the operating element handwheel, and reconnects 
the handwheel with the global tags.     

Use in the function list
ResetTagToHandWheel

Use in user-defined functions
-

Parameters
--
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SetTagToHandWheel

Description
Connect the tag with the operating device handwheel If the handwheel is operated, the tag 
value changes. The connection can be reset using the "ResetTagToHandWheel" system 
function.    

Use in the function list
SetTagToHandWheel (Value)

Use in user-defined functions
-

Parameters

Value
Tag names which are connected to the operating device handwheel.

TraceUserChange

Description
Outputs a system event that shows which user is currently logged in on the HMI device. 

This system function can only be used in the Scheduler.     

Use in the function list
TraceUserChange

Use in user-defined functions
-

Parameters
--
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DecreaseFocusedValue

Description
Subtracts the specified value from the value of the tag which is connected to the screen object 
and currently has the focus. 

This system function can only be used for function keys. 

Use in the function list
DecreaseFocusedValue (Value)

Use in user-defined functions
-

Parameters

Value
The value which is subtracted from the tag value.

DecreaseTag

Description
Subtracts the given value from the tag value.       

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. The auxiliary tags are assigned to 
the tag value with the "SetTag" system function.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

ChangeConnection

Description
Disconnects the connection to the currently used PLC in use and establishes a connection to 
a PLC with another address. The newly connected PLC must belong to the same device class 
(S7-1200, S7-300, ...etc). With S7-1200, the use of the function is also only permitted for 
absolute addressing.

       
 

 Note

When changing to another address, ensure that the address is not already being used by 
another HMI device.

 

The follows address types are supported:

● IP address

● MPI address

The follows PLC types are supported:

● SIMATIC S7 300/400

● SIMATIC S7-NC

● SIMOTION

Use in the function list
ChangeConnection (Connection, Address, Slot, Rack)

Use in user-defined functions
ChangeConnection (Connection, Address, Slot, Rack)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Connection
Name of the connection that is disconnected. The name is set during configuration, for 
example, in the "Connections" editor.

Address
MPI/PROFIBUS or IP address of the PLC to which the connection will be established.

 

 Note

Set the address by means of a tag. The objects list displays the tags of all data types. Select 
only tags of the following data types:
● Ethernet connection: "String" data type
● MPI connection: "Int" data type

 

Slot
Slot of the PLC to which the connection will be established.

Rack
Rack of the PLC to which the connection will be established.

Application example
You want to operate one HMI device on several machines. Configure the necessary PLCs in 
the project, to which you want to change by pressing a key. When changing the PLC, the 
connection to the PLC in use is disconnected. Then the connection to the new PLC with other 
address parameters is reestablished. To access the values of the new PLC, configure the 
same tags for the PLC used.

The PLC which you have indicated when creating the project will be used as default.

1. Enter the name and address of the PLC in the "Connections" editor.

2. Configure a button in the process screen.

3. Configure the "ChangeConnection" system function on the "Press" event.

4. Enter the name of the connection and address of the PLC as parameters.

ShowLogonDialog

Description
Opens a dialog on the HMI device with which the user can log on to the HMI device.     

Use in the function list
ShowLogonDialog
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Use in user-defined functions
-

Parameters
--

ShowOperatorNotes

Application
Displays the tooltip configured for the selected object.     

If the system function is configured on a function key, the tooltip for the screen object that 
currently has the focus is displayed. If a tooltip is configured for the screen itself, you can switch 
to this text by pressing <Enter> or by double-clicking on the help window.

If the system function is configured on a button, only the tooltip for the current screen is 
displayed. If a tooltip is configured on the button itself, initially only the tooltip for the button is 
displayed. You can press <Enter> or double-click on the help window to switch to the tooltip 
for the current screen.

 

 Note

No other screen object can be used while the help window is open. To use the screen object, 
close the help window.

 

Closing the help window
You can close the help window in the following ways:

Using the keys:

● By pressing the <HELP> key again

● By pressing the <ESC> key

Using the touch screen:

● By pressing the  button

Use in the function list
ShowOperatorNotes (Layout)

Use in user-defined functions
ShowOperatorNotes (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Display mode
Determines whether the configured tooltip is hidden or shown:

0 (hmiOff) = Off: Configured tooltip is hidden

1 (hmiOn) = On: Configured tooltip is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowAlarmWindow

Description
Hides or shows the alarm window on the HMI device.       

Use in the function list
ShowAlarmWindow (Object name, Layout)

Use in user-defined functions
ShowAlarmWindow (Object_name, Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Object name
Name of the alarm view which is hidden or shown.

Layout
Determines whether the alarm window is hidden or shown:

0 (hmiOff) = Off: Alarm view is hidden

1 (hmiOn) = On: Alarm view is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowSoftwareVersion

Description
Hides or shows the version number of the runtime software.       

Use this system function if during servicing, for example, you required the version of the runtime 
software used.
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Use in the function list
ShowSoftwareVersion (Layout)

Use in user-defined functions
ShowSoftwareVersion (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Determines whether the version number is shown:

0 (hmiOff) = Off: Version number is not shown

1 (hmiOn) = On: Version number is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowSystemDiagnosticsWindow

Description
Hides or shows the system diagnostic window on the HMI device. The system diagnostic view 
is only available in the global screen for Comfort Panels and for WinCC Runtime Advanced.       

Use in the function list
ShowSystemDiagnosticsWindow (Screen object)

Use in user-defined functions
ShowSystemDiagnosticsWindow (Target_Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen object
Name of the system diagnostic window which is hidden or shown.
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ShowSystemAlarm

Description
Displays the value of the parameter passed as a system event to the HMI device.       

Use in the function list
ShowSystemAlarm (Text/value)

Use in user-defined functions
ShowSystemAlarm (Text/value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Text/Value
The text or the value, which was output as a system alarm.

Functions for WinAC MP

WinACMPUpdateControllerForStartAtBoot

Description
Reads whether WinAC MP is automatically started after startup of the HMI device. The LED 
display of the "StartAtBoot" button is updated.     

Use in the function list
WinACMPUpdateControllerForStartAtBoot(Start at boot, Action)

Use in user-defined functions
-

Parameters

Start at boot
The tag that contains the value.
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Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: LED display is gray. WinAC MP is not started on startup of the HMI device.

1 (SwitchOn) = On: LED display has the color "cyan". WinAC MP is started automatically on 
startup of the HMI device. 

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateKeySwitchSetting

Description
Updates the status display of the position of the mode selector switch.     

Use in the function list
WinACMPUpdateKeySwitchSetting (Key switch, Action)

Use in user-defined functions
-

Parameters

Key switch
The tag that contains the value of the key switch:

0 (MRES) = MRES: PLC memory reset

1 (STOP) = STOP: STOP mode

3 (RUN) = RUN: RUN mode
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Action
Determines whether the status display will be updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateBUSF1LED

Description
Updates the status display of the BUSF1 LED tag.     

Use in the function list
WinACMPUpdateBUSF1LED(BUSF1, Update)

Use in user-defined functions
-

Parameters

BUSF1
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On
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Update
Defines whether the status display of the BUSF1 LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateBUSF2LED

Description
Updates the status display of the BUSF2 LED tag.       

Use in the function list
WinACMPUpdateBUSF2LED(BUSF2, Update)

Use in user-defined functions
-

Parameters

BUSF2
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On
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Update
Defines whether the status display of the BUSF2 LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateAverageExecTime

Description
Updates the display of the average OB 1 execution time. The OB 1 execution time will be 
displayed in milliseconds.     

Use in the function list
WinACMPUpdateAverageExecTime(Cycle time, Update)

Use in user-defined functions
-

Parameters

Cycle time
Tag that contains the value of the average OB 1 execution time.

Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated.
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Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateAverageCycleTime

Description
Updates the display of the average cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateAverageCycleTime(Cycle time, Action)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the average cycle time.

Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:
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● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

See also
System functions for Runtime Advanced (Page 4559)

WinACMPUpdateEXTFLED

Description
Updates the status display of the EXTF LED tag.       

Use in the function list
WinACMPUpdateEXTFLED(EXTF, Update)

Use in user-defined functions
-

Parameters

EXTF
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the EXTF LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.
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Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateHMIEnableTime

Description
Updates the value of the HMI Enable Time from WinAC MP (in ms).     

Use in the function list
WinACMPUpdateHMIEnableTime(Enable Time, Update)

Use in user-defined functions
-

Parameters

HMI Enable time
The tag that contains the value of the HMI Enable Time.

Action
Determines whether the value is updated: 

0 (SwitchOff) = Off: Value is not updated.

1 (SwitchOn) = On: Value is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:
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● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateINTFLED

Description
Updates the status display of the INTF LED tag.     

Use in the function list
WinACMPUpdateINTFLED(INTF, Update)

Use in user-defined functions
-

Parameters

INTF
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the INTF LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:
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● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateLastCycleTime

Description
Updates the display of the last cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateLastCycleTime (Cycle time , Update)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the last cycle time.

Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".
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● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateMaximumCycleTime

Description
Updates the display of the longest cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateMaximumCycleTime(Cycle time, Update)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the longest cycle time.

Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: Display is not updated.

1 (SwitchOn) = On: Display is updated. 

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4699



WinACMPUpdateMinimumCycleTime

Description
Updates the display of the shortest cycle time. The cycle time is displayed in milliseconds.     

Use in the function list
WinACMPUpdateMinimumCycleTime (Cycle Time, Update)

Use in user-defined functions
-

Parameters

Cycle time
The tag that contains the value of the shortest cycle time.

Action
Determines whether the display is updated: 

0 (SwitchOff) = Off: The display is not updated.

1 (SwitchOn) = On: The display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdatePowerLED

Description
Updates the status display ON/OFF of the Power LED tag.     
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Use in the function list
WinACMPUpdatePowerLED (Power, Update)

Use in user-defined functions
-

Parameters

Power
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Determines whether the status display ON/OFF is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateSleepTime

Description
Updates the value of the HMI Execution Time from WinAC MP (in ms).     
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Use in the function list
WinACMPUpdateSleepTime(SleepTime, Update)

Use in user-defined functions
-

Parameters

SleepTime
The tag that contains the value.

Update
Determines whether the value is updated: 

0 (SwitchOff) = Off: Value is not updated.

1 (SwitchOn) = On: Value is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateRUNLED

Description
Updates the status display of the RUN LED tag.     

Use in the function list
WinACMPUpdateRUNLED(RUN, Update)

Use in user-defined functions
-
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Parameters

RUN
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the RUN LED tag is updated: 

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPUpdateSTOPLED

Description
Updates the status display of the STOP LED tag.     

Use in the function list
WinACMPUpdateSTOPLED (STOP, Update)

Use in user-defined functions
-
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Parameters

STOP
The tag that contains the value of the status display.

0 = Off

1 = Slow flashing

2 = Quick flashing

3 = On

Update
Defines whether the status display of the STOP LED tag is updated:

0 (SwitchOff) = Off: Status display is not updated.

1 (SwitchOn) = On: Status display is updated.

Notes on configuring
You configure this system function on the "Loaded" event or on the "Cleared" event of a screen. 

Note the following during configuration:

● System function on the "Loaded" event
Set the "Update" parameter to "On".

● System function on the "Cleared" event
Set the "Update" parameter to "Off".

● If you call the system function repeatedly in a screen, always use the same tag. Otherwise, 
only the last activated tag will be updated.

● If you want to configure all system functions with the prefix "WinACMPUpdate" in a screen, 
each system function is only permitted once per screen.

WinACMPArchive

Description
Saves the current STEP 7 user program, the current system configuration and the current 
values of the DBs in a log file.     

Use in the function list
WinACMPArchive (File name)

Use in user-defined functions
-
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Parameters

File name
Name of the log file in which the data is saved. Enter the file location and the file extension 
(*.wld), for example, "\flash\AddOn\WinACMP\Default.wld ".

WinACMPGetStartMode

Description
Reads in the 'desired' operating state after startup of the HMI device of WinAC MP.     

Use in the function list
WinACMPGetStartMode (Operating state, Update)

Use in user-defined functions
-

Parameters

Start mode
The tag that defines the value of the operating mode.

Action
Determines whether the operating mode is read out: 

0 (SwitchOff) = Off: Operating mode is not read out.

1 (SwitchOn) = On: Operating mode is read out.

WinACMPGetVersion

Description
Reads out the value of the version number of WinAC MP.       

Use in the function list
WinACMPGetVersion (Version, Action)

Use in user-defined functions
WinACMPGetVersion (Version, Action)
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Can be used if the configured device supports user-defined functions. For more information, 
refer to Device dependency (Page 4528).

Parameters

Version
The tag that contains the value.

Action
Determines whether the version number is read out: 

0 (SwitchOff) = Off: Version number is not read out.

1 (SwitchOn) = On: Version number is read out.

WinACMPClearCycleTimeBuffer

Description
Clears the cycle time data of the histogram.     

Use in the function list
WinACMPClearCycleTimeBuffer

Use in user-defined functions
-

Parameters
--

WinACMPSetStartAtBoot

Description
Determines whether or not WinAC MP is started automatically after startup of the HMI 
device.       

Use in the function list
WinACMPSetStart at boot(Start at boot)
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Use in user-defined functions
WinACMPSetStartAtBoot (Start at boot)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

StartAtBoot
Defines whether WinAC MP is started automatically. 

0 (StartAtBootOff) = Off: WinAC MP is not started on startup of the HMI device.

1 (StartAtBootOn) = On: WinAC MP is started automatically on startup of the HMI device.

WinACMPSetKeySwitch

Description
Sets the mode selector switch to RUN or STOP and is also used for memory reset.     

Use in the function list
WinACMPSetKeySwitch(Key switch)

Use in user-defined functions
-

Parameters

Key switch
Defines the position of the key switch:

0 (MRES) = MRES: PLC memory reset

1 (STOP) = STOP: STOP mode

3 (RUN) = RUN: RUN mode

WinACMPSetHMIEnableTime

Description
Sets the value of the HMI Execution Time of WinAC MP.     
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Use in the function list
WinACMPSetHMIEnableTime(Execution Time)

Use in user-defined functions
-

Parameters

Execution time
The tag that contains the value.

WinACMPSetRestartMethod

Description
Sets the restart method, either cold restart (CRST) or warm restart (WRST).     

Use in the function list
WinACMPSetRestartMethod (Action)

Use in user-defined functions
-

Parameters

Action
Defines the restart action:

0 (WarmRestart) = Warm restart: A warm restart is performed.

1 (ColdRestart) = Cold restart: A cold restart is performed.

WinACMPSetSleepTime

Description
Sets the value of the HMI Execution Time of WinAC MP.     

Use in the function list
WinACMPSetSleeptime (SleepTime)
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Use in user-defined functions
-

Parameters

Sleep time
The tag that contains the value. 

WinACMPSetStartMode

Description
Sets the operating mode of WinAC MP after startup of the HMI device.       

Use in the function list
WinACSetStartMode (Autostart)

Use in user-defined functions
WinACSetStartMode (Autostart)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Action
Defines whether the Autostart function of WinAC MP is activated. 

0 (AutoStartOff) = Off: After startup, WinAC MP remains in the STOP operating mode.

1 (AutoStartOn) = On: After startup, WinAC MP changes to the operating mode it was in before 
it was closed.

WinACMPStartHistogram

Description
Starts the cyclic sending of histogram values and updates the display. The histogram shows 
the percentual distribution of the measured cycle times.     

Use in the function list
WinACMPStartHistogram (Update, Percentage, Cycle time, Y axis, ID)
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Use in user-defined functions
-

Parameters

Action
Defines whether WinAC returns histogram values:

0 (SwitchOff) = Off: The cyclic sending of the histogram values is not started. The display is 
not updated.

1 (SwitchOn) = On: The cyclic sending of the histogram values is started. The display is 
updated. 

Percent
Percentage of the cycles which are performed during the recorded cycle times.

Cycle time
Histogram of cycle times.

Y-axis bounds 
Maximum value of Y axis

ID
Histogram ID

WinACMPControl

Description
Starts or stops WinAC MP.     

Use in the function list
WinACMPControl (WinAC)

Use in user-defined functions
-

Parameters

WinAC
Determines whether WinAC MP is started or stopped. 

0 (ShutdownWinACMP) = Stop: WinAC MP is stopped. 
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1 (StartWinACMP) = Start: WinAC MP is started.

WinACMPStopHistogram

Description
Stops the cyclic sending of histogram data and deletes the history data.     

Use in the function list
WinACMPStopHistogram (ID)

Use in user-defined functions
-

Parameters

ID
Histogram ID

WinACMPRestore

Description
Loads the STEP 7 user program, the system configuration and the DBs from a log file.     

Use in the function list
WinACMPRestore (File name)

Use in user-defined functions
-

Parameters

File name
Name of the log file in which the data is saved. Enter the file location and the log file, for 
example, ""\flash\AddOn\WinACMP\Default.wld ".
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System functions

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 

Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.
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{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}

See also
System functions for Runtime Professional (Page 4564)

ActivateScreenInCurrentScreenWindow

Description
Performs a screen change to the specified screen in the current screen window.   

Use in the function list
ActivateScreenInCurrentScreenWindow (Name of new screen)

Use in user-defined functions
-

Parameters

Name of new screen
Name of the screen to be displayed in the screen window. 

See also
System functions for Runtime Professional (Page 4564)

ActivateScreenInScreenWindow

Description
Performs a screen change to the specified screen in a specified screen window.       

Use in the function list
ActivateScreenInScreenWindow (Screen name, Screen window, New screen name)
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Use in user-defined functions
ActivateScreenInScreenWindow (Screen_name, Screen_window, New_screen_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Screen name
Name of the screen to be displayed in the screen window. 

Screen window
Name of the screen window in which the new screen is to be displayed.

New screen name
Name of the new screen to be displayed in the screen window. 

Example
The ActivateScreenInScreenWindow function is used in the following program code to activate 
the "Screen_2" screen when you click a button.

 
{
// User defined code 
// i.e. when pressing a button 
ActivateScreenInScreenWindow (GetParentScreen(screenName), 
GetParentScreenWindow(screenName), "Screen_2");
...
}

See also
System functions for Runtime Professional (Page 4564)

IncreaseTag

Description
Adds the given value to the value of the tags.       
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X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.

 

If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag
The tag to which the given value is added.

Value
The value that is added.

Example
The following program code increments the value of the varX tag by the value in the value tag. 
The value entered is saved to the old_value tag and output along with the new varX value.

 
{
BYTE varX;
BYTE value;
 
//user input
...
BYTE old_value = varX;
 
//Increase tag
IncreaseTag(varX, value);
 
//print original value and function result   
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printf ("User input: %i\r\n, Result of function IncreaseTag: %i\r\n", old_value, varX);
...
}

See also
System functions for Runtime Professional (Page 4564)

ExportImportUserAdministration

Description
Exports all users of the user administration of the currently active project to the given file or 
imports the users from the given file into the currently active project.       

Users, their passwords and rights are saved in the user administration.

All users are overwritten when importing. The imported users are valid immediately.

Use in the function list
ExportImportUserAdministration (File name, Direction)

Use in user-defined functions
ExportImportUserAdministration (File_name, Direction)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the file which contains the passwords or to which the passwords are written. Enter 
the file location and the file extension (*.txt), for example, "C:\TEMP\Passwords.txt".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Direction
Specifies whether passwords are exported or imported:

0 (hmiExport) = Export: Passwords are exported.

1 (hmiImport) = Import: Passwords are imported.
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InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.

Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)
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InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.

Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
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BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

InvertLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       

The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

X
The tag which is assigned the value calculated from the linear equation.
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Y
The tag that contains the value used for calculation.

b
The value which is subtracted.

a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

ReadPLCMode

Description
Evaluates the current state of the connected PLC.

The system function "ReadPLCMode" can only be configured for the following PLCs:

● SIMATIC S7-1200

● SIMATIC S7-1500

Use in the function list
ReadPLCMode (connection, mode)
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Use in user-defined functions
GetPLCMode (Connection, Mode)

Parameters

Connection
Connection of PLC and HMI device.

Mode
Evaluates the mode of the connected PLC.
8: RUN = The PLC program is being executed.
4: STOP = The PLC program has been interrupted.
Select a suitable user variable for the evaluation.

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       

The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.
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a
The value with which is multiplied.

X
The tag that contains the value used for calculation.

b
The value that is added.

Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
 
printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4722 System Manual, 02/2014



Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).

Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
System functions for Runtime Professional (Page 4564)

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)
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Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).

Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       
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Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       
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After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.

 

Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
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BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

SetPropertyCurrentWindow

Description
Specifies the value of an object property in the current window with a tag value.   

Use in the function list
SetPropertyCurrentWindow (Name of the property, lpvalue)

Use in user-defined functions
-

Parameters

Name of the property
Name of the property that is set with the tag value. 

lpvalue
Name of the tag that contains the value of the property. 

See also
System functions for Runtime Professional (Page 4564)
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SetPropertyCurrentWindowByProperty

Description
Specifies the value of an object property in the current window with another object property.   

Use in the function list
SetPropertyCurrentWindowByProperty (Name of the property, Screen name, Screen object, 
Property name)

Use in user-defined functions
-

Parameters

Name of the property
Name of the property whose property is to be transferred to the destination object.

Screen name
Name of the screen that contains the screen object. 

Screen object
Name of the screen object to which the property is transferred. 

Name of the property
Name of the property that will be changed. 

See also
System functions for Runtime Professional (Page 4564)

SetPropertyCurrentWindowByTagIndirect

Description
Specifies the value of an object property in the current window with a tag. The tag contains 
the tag name that specifies the object property.   

Use in the function list
SetPropertyCurrentWindowByTagIndirect (Name of the property, Tag name)
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Use in user-defined functions
-

Parameters

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that, in turn, contains the name of the tag that specifies the object property. 

See also
System functions for Runtime Professional (Page 4564)

SetPropertyByProperty

Description
Specifies the value of an object property with another object property.       

Use in the function list
SetPropertyByProperty (Screen name, Object, Name of the property, Destination screen 
name, Destination object, Destination property name)

Use in user-defined functions
SetPropertyByProperty (Screen_name, Screen_object, Property_name, 
Source_screen_name, Source_screen_object, Source_property_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen with another screen property, the parameters 
"Object" and "Destination object" must be empty. For this purpose, use the following syntax, 
for example:

SetPropertyByProperty ("<Screen name>","","<Property name>","<Destination_Screen 
name>","","<Destination_Property name>")

Parameters

Screen name
Name of the screen that contains the object. 
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Object
Name of the object whose property is transferred to the destination object. 

Name of the property
Name of the property that will be transferred to the destination object. 

Destination screen name
Name of the screen that contains the destination object. 

Destination object
Name of the destination object to which the property is transferred. 

Destination property name
Name of the property that will be changed. 

Example
The following program code uses the SetPropertyByProperty function to set the property 
"ToolbarButtonClick" of the object "Control_1" in the original screen Trend_1": on the 
corresponding property in the destination screen "Trend_2".

 
{
 
//Name of source picture: Trend_1 
//Name of target picture: Trend_2 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByProperty ("Trend_1", "Control_1", "ToolbarButtonClick", "Trend_2", 
"Control_2", "ToolbarButtonClick");
 
// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetPropertyByConstant

Description
Specifies the value of an object property as a string.       

Use in the function list
SetPropertyByConstant (Screen name, Object, Name of the property, Value)
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Use in user-defined functions
SetPropertyByConstant

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to change the property of a screen, the parameter "Object" must be empty. For this 
purpose, use the following syntax, for example:

SetPropertyByConstant ("<Screen name>","","<Property name>","<Value>")

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property is changed. 

Name of the property
Name of the property that will be changed. 

Value
The value assigned to the property. 

Example
The SetPropertyByConstant function is used in the following program code to change an object 
property: In the "Trends" screen, the "ToolbarButtonClick" property of the "Control_1" object 
is set to the value 26.

 
{
 
//Name of the picture: Trends 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByConstant ("Trends", "Control_1", "ToolbarButtonClick", "26");
 
// User defined code 
...
}
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Example: Changing a screen property
The SetPropertyByConstant function is used in the following program code to change a screen 
property: In the "Trends" screen, the "Backcolor" property is set to the value 255.

 
{
 
//Name of the picture: Trends 
 
SetPropertyByConstant ("Trends", "Trends", "Backcolor", "255");
 
// User defined code 
...
}

Alternatively, use the password ZERO or a space-string instead of the second parameter 
(object). 

See also
System functions for Runtime Professional (Page 4564)

SetPropertyByTag

Description
Specifies the value of an object property with a tag value.       

Use in the function list
SetPropertyByTag (Screen name, Object, Name of the property, Tag name)

Use in user-defined functions
SetPropertyByTag (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen by means of a tag value, the "Object" parameter 
must be empty. For this purpose, use the following syntax, for example:

SetPropertyByTag ("<Screen name>","","<Property name>","<Tag name>")

 

Parameters

Screen name
Name of the screen that contains the object. 
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Object
Name of the object containing the property to be set with the tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that contains the value of the property. 

Example
The SetPropertyByTag function is used in the following program code to change an object 
property: A click on the object transfers the object name and the screen containing the object. 
The CaptionText in the screen window contains the value of the HMI_value_1 tag.

 
{
 
SetPropertyByTag (screenName, objectName, "CaptionText", "HMI_value_1");
 
// User defined code 
...
}

Example
The SetPropertyByTag function is used in the following program code to change an object 
property: In the "Trends" screen, the "ToolbarButtonClick" property of the "Control_1" object 
is set to the value 26.

 
{
 
//Name of the picture: Trends 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByConstant ("Trends", "Control_1", "ToolbarButtonClick", "26");
 
// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)
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SetPropertyByTagIndirect

Description
Specifies the value of an object property with a tag. The tag contains the tag name that specifies 
the object property.       

Use in the function list
SetPropertyByTagIndirect (Screen name, Object, Name of the property, Tag name)

Use in user-defined functions
SetPropertyByTagIndirect (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen by means of a tag, the "Object" parameter must 
be empty. For this purpose, use the following syntax, for example:

SetPropertyByTagIndirect ("<Screen name>","","<Property name>","<Tag name>")

 

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object containing the property to be set with the tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that, in turn, contains the name of the tag that specifies the object property. 

Example
The SetPropertyByTagIndirect function is used in the following program code to change an 
object property: .

 
{
 
SetPropertyByTagIndirect (GetParentScreen(screenName), GetParentScreenWindow(screenName), 
"ScreenName", "HMI_value_1");
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// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
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Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

SetTagByProperty

Description
Specifies a tag value with the value of an object property. The change is also logged in the 
alarm system.       

Use in the function list
SetTagByProperty (Tag name, Screen name, Object, Name of the property, With or without 
operator event)

Use in user-defined functions
SetTagByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)
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Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the tag whose value is specified by the object property.

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property supplies the tag value.

Name of the property
Name of the property that supplies the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
The following program code returns the value of the selected text when you click in a combo 
box.

 
{
char* rt_value;
 
SetTagByProperty (rt_value, screenName, objectName, "SelectedText", 
hmiWithoutOperatorEvent);
 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagByTagIndirect

Description
Sets the tag value to the value of an indirect tag. The change is also logged in the alarm 
system.       
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Use in the function list
SetTagByTagIndirect (Tag name, Tag name, With or without operator event)

Use in user-defined functions
SetTagByTagIndirect (Tag_name, Source_tag_name, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that returns the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event 

1 (hmiWithOperatorEvent) = With operator event

Example
The following program code returns the value of the "@LocalMachineName" tag when you 
click the corresponding button.

 
{
char* rt_value;
 
SetTagByTagIndirect (rt_value, "@LocalMachineName", hmiWithoutOperatorEvent);
 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagWithOperatorInputAlarm

Description
Specifies the value for a tag. The change is also logged in the alarm system.       
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Use in the function list
SetTagWithOperatorInputAlarm (Tag name (output), LpValue)

Use in user-defined functions
SetTagWithOperatorEvent (Tag_name, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag whose value is to be set. 

LpValue
Value written to the tag. 

 

Example
The following program code transfers the value from the "value" tag to the "result" tag when 
you click the corresponding button.

 
{
BYTE result;
BYTE value;
 
SetTagWithOperatorEvent ("result", "value");
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirect

Description
Specifies the indirect name for a tag.       

Use in the function list
SetTagIndirect (Tag name (output), LpValue)
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Use in user-defined functions
SetTagIndirect (Tag_name, Value, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 

Example
The following program code transfers the value from the "value" tag to the "result" tag when 
you click the corresponding button.

 
{
BYTE result;
BYTE value;
 
SetTagIndirect ("result", "value", hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectByProperty

Description
Specifies a tag name with the value of an object property. The change is also logged in the 
alarm system.       

Use in the function list
SetTagIndirectByProperty (Tag name, Screen name, Screen object, Name of the property, 
With or without operator event)
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Use in user-defined functions
SetTagIndirectByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the tag whose tag name is specified by the object property.

Screen name
Name of the screen that contains the object. 

Screen object
Name of the object whose property returns the tag name.

Name of the property
Name of the property that returns the tag name. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
When you click the objectName button, the following program code sets the value of the 
"rt_value_property" tag to the value of the "FlashingEnabled" property.

 
{
Int rt_value_property;
SetTagIndirectByProperty ("rt_value_property", screenName, objectName, "FlashingEnabled", 
hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)
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SetTagIndirectByTagIndirect

Description
Sets the tag value to the value of an indirect tag. The change is also logged in the alarm 
system.       

Use in the function list
SetTagIndirectByTagIndirect (Tag name, Tag name, With or without operator event)

Use in user-defined functions
SetTagIndirectByTagIndirect (Tag_name, Source_tag_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the indirect tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that returns the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
When you click the objectName button, the following program code sets the "rt_value" tag to 
the value of the "value" tag.

 
{
Int rt_value;
Int value;
 
SetTagIndirectByTagIndirect ("rt_value", "value", hmiWithoutOperatorEvent);
...
}
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See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectWithOperatorInputAlarm

Description
Specifies the indirect name for a tag. The change is also logged in the alarm system.       

Use in the function list
SetTagIndirectWithOperatorInputAlarm (Tag name (output), LpValue)

Use in user-defined functions
SetTagIndirectWithOperatorEvent

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 

See also
System functions for Runtime Professional (Page 4564)

DecreaseTag

Description
Subtracts the given value from the tag value.       

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.
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If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

Example
The following program code decrements the value at the varX tag by the value at the value 
tag. The value entered is saved to the old_value tag and output along with the new varX value.

 
{
BYTE varX;
BYTE value;
 
//user input
...
BYTE old_value = varX;
 
//Decrease tag
DecreaseTag(varX, value);
 
//print original value and function result   
printf ("User input: %i\r\n, Result of function DecreaseTag: %i\r\n", old_value, varX);
...
}

See also
System functions for Runtime Professional (Page 4564)
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StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)

Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)
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ShowLogonDialog

Description
Opens a dialog on the HMI device with which the user can log on to the HMI device.    

Use in the function list
ShowLogonDialog

Use in user-defined functions
ShowLogonDialog

Can be used if the configured device supports user-defined functions. Additional information 
is available under "System functions for Runtime Professional (Page 4564)".

Parameters
--

See also
System functions for Runtime Professional (Page 4564)

10.8.11.2 Events

Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.

Icon Editor
Screens
HMI alarms
HMI tags
Scheduler
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1 Cleared (Page 4769) X -- -- --
2 Activate (Page 4770) -- -- -- --
3 Change (Page 4770) -- -- -- --
4 Loaded (Page 4771) X -- -- --
5 Execute (Page 4771) -- -- -- X
6 Selection changed (Page 4771) -- -- -- --
7 In the event of high limit violation (Page 4771) -- -- X --
8 In the event of low limit violation (Page 4772) -- -- X --
9 When dialog is opened (Page 4772) -- -- -- X
10 When dialog is closed (Page 4773) -- -- -- X
11 User change (Page 4773) -- -- -- X
12 Screen change (Page 4773) -- -- -- X
13 Deactivate (Page 4774) -- -- -- X
14 Double-click (Page 4775) -- -- -- --
15 Press (Page 4775) -- -- -- --
16 On Finish Input (Page 4780) -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- --
18 Outgoing (Page 4782) -- X -- --
19 Incoming (Page 4782) -- X -- --
20 Click (Page 4783) -- -- -- --
21 Click when flashing (Page 4783) -- -- -- --
22 Loop-in alarm (Page 4786) -- X -- --
23 Release (Page 4786) -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- X
25 Acknowledge (Page 4789) -- X -- --
26 Reach margin (Page 4789) -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- X
28 Press key (Page 4794) -- -- -- --
29 Release key (Page 4794) -- -- -- --
30 Overflow (Page 4795) -- -- -- --
31 Switch OFF (Page 4796) -- -- -- --
32 Switch ON (Page 4797) -- -- -- --
33 Low free storage space (Page 4798) -- -- -- --
34 Free space critically low (Page 4798) -- -- -- --
35 Value change (Page 4799) -- -- X --
36 Time expired (Page 4800) -- -- -- --
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Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Ellipse
Circle
Rectangle
Text field
Graphic view

 

 

  
1 Cleared (Page 4769) -- -- -- -- -- --
2 Activate (Page 4770) -- -- -- -- -- --
3 Change (Page 4770) -- -- -- -- -- --
4 Loaded (Page 4771) -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- --
6 Selection changed (Page 4771) -- -- -- -- -- --
7 In the event of high limit violation (Page 4771) -- -- -- -- -- --
8 In the event of low limit violation (Page 4772) -- -- -- -- -- --
9 When dialog is opened (Page 4772) -- -- -- -- -- --
10 When dialog is closed (Page 4773) -- -- -- -- -- --
11 User change (Page 4773) -- -- -- -- -- --
12 Screen change (Page 4773) -- -- -- -- -- --
13 Deactivate (Page 4774) -- -- -- -- -- --
14 Double-click (Page 4775) -- -- -- -- -- --
15 Press (Page 4775) -- -- -- -- -- --
16 On Finish Input (Page 4780) -- -- -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- --
18 Outgoing (Page 4782) -- -- -- -- -- --
19 Incoming (Page 4782) -- -- -- -- -- --
20 Click (Page 4783) -- -- -- -- -- --
21 Click when flashing (Page 4783) -- -- -- -- -- --
22 Loop-in alarm (Page 4786) -- -- -- -- -- --
23 Release (Page 4786) -- -- -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- -- --
25 Acknowledge (Page 4789) -- -- -- -- -- --
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26 Reach margin (Page 4789) -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- -- --
28 Press key (Page 4794) -- -- -- -- -- --
29 Release key (Page 4794) -- -- -- -- -- --
30 Overflow (Page 4795) -- -- -- -- -- --
31 Switch OFF (Page 4796) -- -- -- -- -- --
32 Switch ON (Page 4797) -- -- -- -- -- --
33 Low free storage space (Page 4798) -- -- -- -- -- --
34 Free space critically low (Page 4798) -- -- -- -- -- --
35 Value change (Page 4799) -- -- -- -- -- --
36 Time expired (Page 4800) -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
IO field
Button
Symbolic IO field
Graphic IO field
Date/time field
Bar
Switch

  
1 Cleared (Page 4769) -- -- -- -- -- -- --
2 Activate (Page 4770) X X X X -- -- X
3 Change (Page 4770) -- X X -- -- -- X
4 Loaded (Page 4771) -- -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- -- --
6 Selection changed (Page 4771) -- -- -- -- -- -- --
7 In the event of high limit violation (Page 4771) -- -- -- -- -- -- --
8 In the event of low limit violation (Page 4772) -- -- -- -- -- -- --
9 When dialog is opened (Page 4772) -- -- -- -- -- -- --
10 When dialog is closed (Page 4773) -- -- -- -- -- -- --
11 User change (Page 4773) -- -- -- -- -- -- --
12 Screen change (Page 4773) -- -- -- -- -- -- --

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4749



  
13 Deactivate (Page 4774) X X X X -- -- X
14 Double-click (Page 4775) -- -- -- -- -- -- --
15 Press (Page 4775) -- X -- -- -- -- --
16 On Finish Input (Page 4780) -- -- -- -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- -- --
18 Outgoing (Page 4782) -- -- -- -- -- -- --
19 Incoming (Page 4782) -- -- -- -- -- -- --
20 Click (Page 4783) -- X -- -- -- -- --
21 Click when flashing (Page 4783) -- -- -- -- -- -- --
22 Loop-in alarm (Page 4786) -- -- -- -- -- -- --
23 Release (Page 4786) -- X -- -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- -- -- --
25 Acknowledge (Page 4789) -- -- -- -- -- -- --
26 Reach margin (Page 4789) -- -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- -- -- --
28 Press key (Page 4794) -- -- -- -- -- -- --
29 Release key (Page 4794) -- -- -- -- -- -- --
30 Overflow (Page 4795) -- -- -- -- -- -- --
31 Switch OFF (Page 4796) -- -- -- -- -- -- X
32 Switch ON (Page 4797) -- -- -- -- -- -- X
33 Low free storage space (Page 4798) -- -- -- -- -- -- --
34 Free space critically low (Page 4798) -- -- -- -- -- -- --
35 Value change (Page 4799) -- -- -- -- -- -- --
36 Time expired (Page 4800) -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Alarm view/alarm window
Alarm indicator
Trend view
User view
Recipe view
Auxiliary indicator
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1 Cleared (Page 4769) -- -- -- -- -- --
2 Activate (Page 4770) X -- X X -- --
3 Change (Page 4770) -- -- -- -- -- --
4 Loaded (Page 4771) -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- --
6 Selection changed (Page 4771) -- -- -- -- -- --
7 In the event of high limit violation (Page 4771) -- -- -- -- -- --
8 In the event of low limit violation (Page 4772) -- -- -- -- -- --
9 When dialog is opened (Page 4772) -- -- -- -- -- --
10 When dialog is closed (Page 4773) -- -- -- -- -- --
11 User change (Page 4773) -- -- -- -- -- --
12 Screen change (Page 4773) -- -- -- -- -- --
13 Deactivate (Page 4774) X -- X X -- --
14 Double-click (Page 4775) -- -- -- -- -- --
15 Press (Page 4775) -- -- -- -- -- --
16 On Finish Input (Page 4780) -- -- -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- --
18 Outgoing (Page 4782) -- -- -- -- -- --
19 Incoming (Page 4782)       
20 Click (Page 4783) -- X -- -- -- --
21 Click when flashing (Page 4783) -- X -- -- -- --
22 Loop-in alarm (Page 4786) -- -- -- -- -- --
23 Release (Page 4786) -- -- -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- -- --
25 Acknowledge (Page 4789) -- -- -- -- -- --
26 Reach margin (Page 4789) -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- -- --
28 Press key (Page 4794) -- -- -- -- -- --
29 Release key (Page 4794) -- -- -- -- -- --
30 Overflow (Page 4795) -- -- -- -- -- --
31 Switch OFF (Page 4796) -- -- -- -- -- --
32 Switch ON (Page 4797) -- -- -- -- -- --
33 Low free storage space (Page 4798) -- -- -- -- -- --
34 Free space critically low (Page 4798) -- -- -- -- -- --
35 Value change (Page 4799) -- -- -- -- -- --
36 Time expired (Page 4800) -- -- -- -- -- --
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Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.

Icon Editor
Screens
HMI alarms
HMI tags
Logs
Scheduler
Audit Trail

  
1 Cleared (Page 4769) X -- -- -- -- --
2 Activate (Page 4770) -- -- -- -- -- --
3 Change (Page 4770) -- -- -- -- -- --
4 Loaded (Page 4771) X -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- X --
6 Selection changed (Page 4771) -- -- -- -- -- --
7 In the event of high limit violation (Page 4771) -- -- X -- -- --
8 In the event of low limit violation (Page 4772) -- -- X -- -- --
9 When dialog is opened (Page 4772) -- -- -- -- X --
10 When dialog is closed (Page 4773) -- -- -- -- X --
11 User change (Page 4773) -- -- -- -- X --
12 Screen change (Page 4773) -- -- -- -- X --
13 Deactivate (Page 4774) -- -- -- -- -- --
14 Double-click (Page 4775) -- -- -- -- -- --
15 Press (Page 4775) -- -- -- -- -- --
16 On Finish Input (Page 4780) -- -- -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- --
18 Outgoing (Page 4782) -- X -- -- -- --
19 Incoming (Page 4782) -- X -- -- -- --
20 Click (Page 4783) -- -- -- -- -- --
21 Click when flashing (Page 4783) -- -- -- -- -- --
22 Loop-in alarm (Page 4786) -- X -- -- -- --
23 Release (Page 4786) -- -- -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- X --
25 Acknowledge (Page 4789) -- X -- -- -- --
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26 Reach margin (Page 4789) -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- X --
28 Press key (Page 4794) -- -- -- -- -- --
29 Release key (Page 4794) -- -- -- -- -- --
30 Overflow (Page 4795) -- -- -- X -- --
31 Switching (Page 4796) -- -- -- -- -- --
32 Switch OFF (Page 4796) -- -- -- -- -- --
33 Switch ON (Page 4797) -- -- -- -- -- --
34 Low free storage space (Page 4798) -- -- -- X -- X
35 Free space critically low (Page 4798) -- -- -- X -- X
36 Value change (Page 4799) -- -- X -- -- --
37 Time expired (Page 4800) -- -- -- -- -- --

Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Polyline
Polygon
Ellipse
Circle
Rectangle
Text field
Graphic view

 

 

  
1 Cleared (Page 4769) -- -- -- -- -- -- -- --
2 Activate (Page 4770) -- -- -- -- -- -- -- --
3 Change (Page 4770) -- -- -- -- -- -- -- --
4 Loaded (Page 4771) -- -- -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- -- -- --
6 Selection changed (Page 4771) -- -- -- -- -- -- -- --
7 In the event of high limit violation (Page 4771) -- -- -- -- -- -- -- --
8 In the event of low limit violation (Page 4772) -- -- -- -- -- -- -- --
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9 When dialog is opened (Page 4772) -- -- -- -- -- -- -- --
10 When dialog is closed (Page 4773) -- -- -- -- -- -- -- --
11 User change (Page 4773) -- -- -- -- -- -- -- --
12 Screen change (Page 4773) -- -- -- -- -- -- -- --
13 Deactivate (Page 4774) -- -- -- -- -- -- -- --
14 Double-click (Page 4775) -- -- -- -- -- -- -- --
15 Press (Page 4775) -- -- -- -- -- -- -- --
16 On Finish Input (Page 4780) -- -- -- -- -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- -- -- --
18 Outgoing (Page 4782) -- -- -- -- -- -- -- --
19 Incoming (Page 4782) -- -- -- -- -- -- -- --
20 Click (Page 4783) -- -- -- -- -- -- -- --
21 Click when flashing (Page 4783) -- -- -- -- -- -- -- --
22 Loop-in alarm (Page 4786) -- -- -- -- -- -- -- --
23 Release (Page 4786) -- -- -- -- -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- -- -- -- --
25 Acknowledge (Page 4789) -- -- -- -- -- -- -- --
26 Reach margin (Page 4789) -- -- -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- -- -- -- --
28 Press key (Page 4794) -- -- -- -- -- -- -- --
29 Release key (Page 4794) -- -- -- -- -- -- -- --
30 Overflow (Page 4795) -- -- -- -- -- -- -- --
31 Switching (Page 4796) -- -- -- -- -- -- -- --
32 Switch OFF (Page 4796) -- -- -- -- -- -- -- --
33 Switch ON (Page 4797) -- -- -- -- -- -- -- --
34 Low free storage space (Page 4798) -- -- -- -- -- -- -- --
35 Free space critically low (Page 4798) -- -- -- -- -- -- -- --
36 Value change (Page 4799) -- -- -- -- -- -- -- --
37 Time expired (Page 4800) -- -- -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
IO field
Button
Symbolic IO field
Graphic IO field

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4754 System Manual, 02/2014



Icon Object
Date/time field
Bar
Switch
Symbol library
Slider
Gauge
Clock

  
1 Cleared (Page 4769) -- -- -- -- -- -- -- -- -- -- --
2 Activate (Page 4770) X X X X -- -- X X X -- --
3 Change (Page 4770) -- X X -- -- -- X -- X X --
4 Loaded (Page 4771) -- -- -- -- -- -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- -- -- -- -- -- --
6 Selection changed (Page 4771) -- -- -- -- -- -- -- -- -- -- --
7 In the event of high limit violation 

(Page 4771) 
-- -- -- -- -- -- -- -- -- -- --

8 In the event of low limit violation 
(Page 4772) 

-- -- -- -- -- -- -- -- -- -- --

9 When dialog is opened (Page 4772) -- -- -- -- -- -- -- -- -- -- --
10 When dialog is closed (Page 4773) -- -- -- -- -- -- -- -- -- -- --
11 User change (Page 4773) -- -- -- -- -- -- -- -- -- -- --
12 Screen change (Page 4773) -- -- -- -- -- -- -- -- -- -- --
13 Deactivate (Page 4774) X X X X -- -- X X X -- --
14 Double-click (Page 4775) -- -- -- -- -- -- -- X -- -- --
15 Press (Page 4775) -- X -- -- -- -- -- X -- -- --
16 On Finish Input (Page 4780) X  X X -- -- -- -- -- -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- -- -- -- -- -- --
18 Outgoing (Page 4782) -- -- -- -- -- -- -- -- -- -- --
19 Incoming (Page 4782) -- -- -- -- -- -- -- -- -- -- --
20 Click (Page 4783) -- X -- -- -- -- -- X -- -- --
21 Click when flashing (Page 4783) -- -- -- -- -- -- -- -- -- -- --
22 Loop-in alarm (Page 4786) -- -- -- -- -- -- -- -- -- -- --
23 Release (Page 4786) -- X -- -- -- -- -- X -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- -- -- -- -- -- -- --
25 Acknowledge (Page 4789) -- -- -- -- -- -- -- -- -- -- --
26 Reach margin (Page 4789) -- -- -- -- -- -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- -- -- -- -- -- -- --
28 Press key (Page 4794) -- -- -- -- -- -- -- -- -- -- --
29 Release key (Page 4794) -- -- -- -- -- -- -- -- -- -- --
30 Overflow (Page 4795) -- -- -- -- -- -- -- -- -- -- --
31 Switching (Page 4796) -- -- -- -- -- -- -- -- -- -- --
32 Switch OFF (Page 4796) -- -- -- -- -- -- X -- -- -- --
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33 Switch ON (Page 4797) -- -- -- -- -- -- X -- -- -- --
34 Low free storage space (Page 4798) -- -- -- -- -- -- -- -- -- -- X
35 Free space critically low (Page 4798) -- -- -- -- -- -- -- -- -- -- X
36 Value change (Page 4799) -- -- -- -- -- -- -- -- -- -- --
37 Time expired (Page 4800) -- -- -- -- -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Alarm view/alarm window
Alarm indicator
Trend view
User view
HTML browser
Status/Force
Sm@rtClient view
Recipe view
f(x) trend view
System diagnostics view / system diagnostics window
Function key

 

  
1 Cleared (Page 4769) -- -- -- -- -- -- -- -- -- -- --
2 Activate (Page 4770) X -- X X X X X X -- X --
3 Change (Page 4770) -- -- -- -- -- -- -- -- -- -- --
4 Loaded (Page 4771) -- -- -- -- -- -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- -- -- -- -- -- --
6 Selection changed (Page 4771) X -- -- -- -- -- -- -- -- -- --
7 In the event of high limit violation 

(Page 4771) 
-- -- -- -- -- -- -- -- -- -- --

8 In the event of low limit violation 
(Page 4772) 

-- -- -- -- -- -- -- -- -- -- --

9 When dialog is opened (Page 4772) -- -- -- -- -- -- -- -- -- -- --
10 When dialog is closed (Page 4773) -- -- -- -- -- -- -- -- -- -- --
11 User change (Page 4773) -- -- -- -- -- -- -- -- -- -- --
12 Screen change (Page 4773) -- -- -- -- -- -- -- -- -- -- --
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13 Deactivate (Page 4774) X -- X X X X X X -- -- --
14 Double-click (Page 4775) -- -- -- -- -- -- -- -- -- -- --
15 Press (Page 4775) -- -- -- -- -- -- -- -- -- -- --
16 On Finish Input (Page 4780) -- -- -- -- -- -- -- --  -- --
17 Press ESC twice (Page 4781) -- -- -- -- -- -- -- -- -- -- --
18 Outgoing (Page 4782) -- -- -- -- -- -- -- -- -- -- --
19 Incoming (Page 4782) -- -- -- -- -- -- -- -- -- -- --
20 Click (Page 4783) -- X -- -- -- -- -- -- -- -- --
21 Click when flashing (Page 4783) -- X -- -- -- -- -- -- -- -- --
22 Loop-in alarm (Page 4786) -- -- -- -- -- -- -- -- -- -- --
23 Release (Page 4786) -- -- -- -- -- -- -- -- -- -- --
24 Alarm buffer overflow (Page 4787) -- -- -- -- -- -- -- -- -- -- --
25 Acknowledge (Page 4789) -- -- -- -- -- -- -- -- -- -- --
26 Reach margin (Page 4789) -- -- -- -- -- -- -- -- -- -- --
27 Runtime Stop (Page 4791) -- -- -- -- -- -- -- -- -- -- --
28 Press key (Page 4794) -- -- -- -- -- -- -- -- -- -- X
29 Release key (Page 4794) -- -- -- -- -- -- -- -- -- -- X
30 Overflow (Page 4795) -- -- -- -- -- -- -- -- -- -- --
31 Switching (Page 4796) -- -- -- -- -- -- -- -- -- -- --
32 Switch OFF (Page 4796) -- -- -- -- -- -- -- -- -- -- --
33 Switch ON (Page 4797) -- -- -- -- -- -- -- -- -- -- --
34 Low free storage space (Page 4798) -- -- -- -- -- -- -- -- -- -- --
35 Free space critically low (Page 4798) -- -- -- -- -- -- -- -- -- -- --
36 Value change (Page 4799) -- -- -- -- -- -- -- -- -- -- --
37 Time expired (Page 4800) -- -- -- -- -- -- -- -- -- -- --

Overview

Editors

Introduction
The following table shows which events occur in which editor.

Technical data subject to change.

Icon Editor
Screens
HMI alarms
Logs
Scheduler
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1 Play ended (Page 4770) -- -- -- --
2 Activate (Page 4770) X -- -- --
3 Change (Page 4770) -- -- -- --
4 Loaded (Page 4771) X -- -- --
5 Execute (Page 4771) -- -- -- X
6 Selection changed (Page 4771) -- -- -- --
7 Double-click (Page 4775) -- -- -- --
8 Press (Page 4775) -- -- -- --
9 Operator input alarm property changed (Page 4775) -- -- -- --
10 Block property changed (Page 4776) -- -- -- --
11 Property diagram changed (Page 4776) -- -- -- --
12 Property changed (Page 4776) -- -- -- --
13 Trend property changed (Page 4777) -- -- -- --
14 Column property changed (Page 4777) -- -- -- --
15 Alarm statistics column property changed (Page 4777) -- -- -- --
16 Statistics area column name property changed (Page 4778) -- -- -- --
17 Change property status bar element (Page 4778) -- -- -- --
18 Change property toolbar button (Page 4778) -- -- -- --
19 Change property value axis (Page 4779) -- -- -- --
20 Change property value column (Page 4779) -- -- -- --
21 X-axis property changed (Page 4779) -- -- -- --
22 Y-axis property changed (Page 4780) -- -- -- --
23 Change property time axis (Page 4780) -- -- -- --
24 Change property time column (Page 4780) -- -- -- --
25 Outgoing (Page 4782) -- X -- --
26 Incoming (Page 4782) -- X -- --
27 In the alarm range (Page 4782) -- -- -- --
28 In the tolerance range (Page 4782) -- -- -- --
29 In the warning range (Page 4783) -- -- -- --
30 Click (Page 4783) X -- -- --
31 Shortcut menu (Page 4784) -- -- -- --
32 Volume (Page 4784) -- -- -- --
33 Change layout (Page 4785) -- -- -- --
34 Change ruler (Page 4785) -- -- -- --
35 Press left mouse button (Page 4785) X -- -- --
36 Release left mouse button (Page 4785) X -- -- --
37 Loop-in alarm (Page 4786) -- X -- --
38 Release (Page 4786) -- -- -- --
39 Move mouse (Page 4787) -- -- -- --
40 Medium opened (Page 4787) -- -- -- --
41 Medium closed (Page 4788) -- -- -- --
42 Object changed (Page 4788) X -- -- --
43 Pause (Page 4789) -- -- -- --
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44 Acknowledge (Page 4789) X X -- --
45 Press right mouse button (Page 4790) X -- -- --
46 Release right mouse button (Page 4790) X -- -- --
47 Runtime Stop (Page 4791) -- -- -- --
48 Click toolbar button (Page 4791) -- -- -- --
49 Change slider (Page 4791) -- -- -- --
50 StepForward (Page 4792) -- -- -- --
51 StepBack (Page 4792) -- -- -- --
52 Lock changed (Page 4792) -- -- X --
53 Status changed (Page 4793) -- X -- --
54 Stop (Page 4793) -- -- -- --
55 Switch toolbar (Page 4793) -- -- -- --
56 Press key on keyboard (Page 4794) X -- -- --
57 Release key on keyboard (Page 4795) X -- -- --
58 Change video format (Page 4797) -- -- -- --
59 Full screen (Page 4797) -- -- -- --
60 Exit full screen (Page 4798) -- -- -- --
61 Replay (Page 4799) -- -- -- --

Basic objects

Introduction
The following table shows which events occur on which objects.

Technical data subject to change.

Icon Object
Line
Polyline
Polygon
Ellipse
Ellipse segment
Circle segment
Ellipse arc
Circular arc
Circle
Rectangle
Connector
Text field
Graphic view
Pipe
Double T-piece
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Icon Object
T piece
Pipe bends

 

  
1 Play ended 

(Page 4770) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

2 Activate (Page 4770) X X X X X X X X X X X X X X X X X
3 Change (Page 4770) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
4 Loaded (Page 4771) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
6 Selection changed 

(Page 4771) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

7 Double-click 
(Page 4775) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

8 Press (Page 4775) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
9 Operator input alarm 

property changed 
(Page 4775) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

10 Block property 
changed (Page 4776) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

11 Property diagram 
changed (Page 4776) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

12 Property changed 
(Page 4776) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

13 Trend property 
changed (Page 4777) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

14 Column property 
changed (Page 4777) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

15 Alarm statistics 
column property 
changed (Page 4777) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

16 Statistics area column 
name property 
changed (Page 4778) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

17 Change property 
status bar element 
(Page 4778) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

18 Change property 
toolbar button 
(Page 4778) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

19 Change property 
value axis 
(Page 4779) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

20 Change property 
value column 
(Page 4779) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
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21 X-axis property 

changed (Page 4779) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

22 Y-axis property 
changed (Page 4780) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

23 Change property time 
axis (Page 4780) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

24 Change property time 
column (Page 4780) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

25 Outgoing (Page 4782) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
26 Incoming (Page 4782) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
27 In the alarm range 

(Page 4782) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

28 In the tolerance range 
(Page 4782) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

29 In the warning range 
(Page 4783) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

30 Click (Page 4783) X X X X X X X X X X X X X X X X X
31 Shortcut menu 

(Page 4784) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

32 Volume (Page 4784) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
33 Change layout 

(Page 4785) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

34 Change ruler 
(Page 4785) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

35 Press left mouse 
button (Page 4785) 

X X X X X X X X X X X X X X X X X

36 Release left mouse 
button (Page 4785) 

X X X X X X X X X X X X X X X X X

37 Loop-in alarm 
(Page 4786) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

38 Release (Page 4786) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
39 Move mouse 

(Page 4787) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

40 Medium opened 
(Page 4787) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

41 Medium closed 
(Page 4788) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

42 Object changed 
(Page 4788) 

X X X X X X X X X X X X X X X X X

43 Pause (Page 4789) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
44 Acknowledge 

(Page 4789) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

45 Press right mouse 
button (Page 4790) 

X X X X X X X X X X X X X X X X X

46 Release right mouse 
button (Page 4790) 

X X X X X X X X X X X X X X X X X

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4761



  
47 Runtime Stop 

(Page 4791) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

48 Click toolbar button 
(Page 4791) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

49 Change slider 
(Page 4791) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

50 StepForward 
(Page 4792) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

51 StepBack (Page 4792) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
52 Lock changed 

(Page 4792) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

53 Status changed 
(Page 4793) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

54 Stop (Page 4793) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
55 Switch toolbar 

(Page 4793) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

56 Press key on 
keyboard (Page 4794) 

X X X X X X X X X X X X X X X X X

57 Release key on 
keyboard (Page 4795) 

X X X X X X X X X X X X X X X X X

58 Full screen 
(Page 4797) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

59 Exit full screen 
(Page 4798) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

60 Change video format 
(Page 4797) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

61 Replay (Page 4799) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Elements

Introduction
The following table shows which events occur on which elements.

Technical data subject to change.

Icon Object
IO field
Editable text field
List box
Combo box
Button
Round button
Symbolic IO field
Graphic IO field
Bar
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Icon Object
Symbol library 
Slider
Scroll bar
Check box
Option button
Gauge
Clock
Disk space view

 

  
1 Play ended 

(Page 4770) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

2 Activate (Page 4770) X X X X X X X X X X X X X X X X X
3 Change (Page 4770) -- -- -- -- -- -- -- -- -- -- X -- -- -- X -- --
4 Loaded (Page 4771) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
5 Execute (Page 4771) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
6 Selection changed 

(Page 4771) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

7 Double-click 
(Page 4775) 

-- -- -- -- -- -- -- -- -- X -- -- -- -- -- -- --

8 Press (Page 4775) -- -- -- -- -- -- -- -- -- X -- -- -- -- -- -- --
9 Operator input alarm 

property changed 
(Page 4775) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

10 Block property 
changed (Page 4776) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

11 Property diagram 
changed (Page 4776) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

12 Property changed 
(Page 4776) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

13 Trend property 
changed (Page 4777) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

14 Column property 
changed (Page 4777) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

15 Alarm statistics 
column property 
changed (Page 4777) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

16 Statistics area column 
name property 
changed (Page 4778) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

17 Change property 
status bar element 
(Page 4778) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
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18 Change property 

toolbar button 
(Page 4778) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

19 Change property 
value axis 
(Page 4779) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

20 Change property 
value column 
(Page 4779) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

21 X-axis property 
changed (Page 4779) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

22 Y-axis property 
changed (Page 4780) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

23 Change property time 
axis (Page 4780) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

24 Change property time 
column (Page 4780) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

25 Outgoing (Page 4782) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
26 Incoming (Page 4782) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
27 In the alarm range 

(Page 4782) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- X

28 In the tolerance range 
(Page 4782) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- X

29 In the warning range 
(Page 4783) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- X

30 Click (Page 4783) X X X X X X X X X X -- X X X -- -- --
31 Shortcut menu 

(Page 4784) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

32 Volume (Page 4784) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
33 Change layout 

(Page 4785) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

34 Change ruler 
(Page 4785) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

35 Press left mouse 
button (Page 4785) 

X X X X X X X X X -- -- X X X -- -- --

36 Release left mouse 
button (Page 4785) 

X X X X X X X X X -- -- X X X -- -- --

37 Loop-in alarm 
(Page 4786) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

38 Release (Page 4786) -- -- -- -- -- -- -- -- -- X -- -- -- -- -- -- --
39 Move mouse 

(Page 4787) 
-- -- -- -- -- -- -- -- -- X -- -- -- -- -- -- --

40 Medium opened 
(Page 4787) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

41 Medium closed 
(Page 4788) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

42 Object changed 
(Page 4788) 

X X X X X X X X X -- -- X X X -- -- --
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43 Pause (Page 4789) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
44 Acknowledge 

(Page 4789) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

45 Press right mouse 
button (Page 4790) 

X X X X X X X X X -- -- X X X -- -- --

46 Release right mouse 
button (Page 4790) 

X X X X X X X X X -- -- X X X -- -- --

47 Runtime Stop 
(Page 4791) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

48 Click toolbar button 
(Page 4791) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

49 Change slider 
(Page 4791) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

50 StepForward 
(Page 4792) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

51 StepBack 
(Page 4792) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

52 Lock changed 
(Page 4792) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

53 Status changed 
(Page 4793) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

54 Stop (Page 4793) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --
55 Switch toolbar 

(Page 4793) 
-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

56 Press key on 
keyboard 
(Page 4794) 

X X X X X X X X X -- -- X X X -- -- --

57 Release key on 
keyboard 
(Page 4795) 

X X X X X X X X X -- -- X X X -- -- --

58 Change video format 
(Page 4797) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

59 Full screen 
(Page 4797) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

60 Exit full screen 
(Page 4798) 

-- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

61 Replay (Page 4799) -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- -- --

Controls

Introduction
The following table shows which events occur on which controls.

Technical data subject to change.
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Icon Object
Screen window
User view
HTML browser
Print job/Script diagnostics
Recipe view
Alarm view
f(x) trend view
f(t) trend view
Table view
Value table
Media Player
Channel diagnostics

 

  
1 Play ended (Page 4770) -- -- -- -- -- -- -- -- -- -- X --
2 Activate (Page 4770) X X X X X X X X X X X X
3 Change (Page 4770) -- -- -- -- -- -- -- -- -- -- -- --
4 Loaded (Page 4771) -- -- -- -- X X X X X X -- --
5 Execute (Page 4771) -- -- -- -- -- -- -- -- -- -- -- --
6 Selection changed 

(Page 4771) 
-- -- -- -- X -- -- -- -- -- -- --

7 Double-click (Page 4775) -- -- -- -- -- -- -- -- -- -- -- --
8 Press (Page 4775) -- -- -- -- -- -- -- -- -- -- -- --
9 Operator input alarm property 

changed (Page 4775) 
-- -- -- -- -- X -- -- -- -- -- --

10 Block property changed 
(Page 4776) 

-- -- -- -- -- X -- -- -- X -- --

11 Property diagram changed 
(Page 4776) 

-- -- -- -- -- -- X X -- -- -- --

12 Property changed 
(Page 4776) 

-- -- -- -- X X X X X X -- --

13 Trend property changed 
(Page 4777) 

-- -- -- -- -- -- X X -- -- -- --

14 Column property changed 
(Page 4777) 

-- -- -- -- X X -- -- -- X -- --

15 Alarm statistics column 
property changed 
(Page 4777) 

-- -- -- -- -- X -- -- -- -- -- --

16 Statistics area column name 
property changed 
(Page 4778) 

-- -- -- -- -- -- -- -- -- X -- --

17 Change property status bar 
element (Page 4778) 

-- -- -- -- X X X X X X -- --
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18 Change property toolbar 

button (Page 4778) 
-- -- -- -- X X X X X X -- --

19 Change property value axis 
(Page 4779) 

-- -- -- -- -- -- -- X -- -- -- --

20 Change property value 
column (Page 4779) 

-- -- -- -- -- -- -- -- X -- -- --

21 X-axis property changed 
(Page 4779) 

-- -- -- -- -- -- X -- -- -- -- --

22 Y-axis property changed 
(Page 4780) 

-- -- -- -- -- -- X -- -- -- -- --

23 Change property time axis 
(Page 4780) 

-- -- -- -- -- -- -- X -- -- -- --

24 Change property time column 
(Page 4780) 

-- -- -- -- -- -- -- -- X -- -- --

25 Outgoing (Page 4782) -- -- -- -- -- -- -- -- -- -- -- --
26 Incoming (Page 4782) -- -- -- -- -- -- -- -- -- -- -- --
27 In the alarm range 

(Page 4782) 
-- -- -- -- -- -- -- -- -- -- -- --

28 In the tolerance range 
(Page 4782) 

-- -- -- -- -- -- -- -- -- -- -- --

29 In the warning range 
(Page 4783) 

-- -- -- -- -- -- -- -- -- -- -- --

30 Click (Page 4783) -- -- -- -- -- -- -- -- -- -- -- --
31 Shortcut menu (Page 4784) -- -- -- -- -- -- -- -- -- -- X --
32 Volume (Page 4784) -- -- -- -- -- -- -- -- -- -- X --
33 Change layout (Page 4785) -- -- -- -- -- -- -- X -- -- -- --
34 Change ruler (Page 4785) -- -- -- -- -- -- -- X -- -- -- --
35 Press left mouse button 

(Page 4785) 
-- -- -- -- -- -- -- -- -- -- -- --

36 Release left mouse button 
(Page 4785) 

-- -- -- -- -- -- -- -- -- -- -- --

37 Loop-in alarm (Page 4786) -- -- -- -- -- -- -- -- -- -- -- --
38 Release (Page 4786) -- -- -- -- -- -- -- -- -- -- -- --
39 Move mouse (Page 4787) -- -- -- -- -- -- -- -- -- -- -- --
40 Medium opened (Page 4787) -- -- -- -- -- -- -- -- -- -- X --
41 Medium closed (Page 4788) -- -- -- -- -- -- -- -- -- -- X --
42 Object changed (Page 4788) X -- -- X -- -- -- -- -- -- -- --
43 Pause (Page 4789) -- -- -- -- -- -- -- -- -- -- X --
44 Acknowledge (Page 4789) -- -- -- -- -- -- -- -- -- -- -- --
45 Press right mouse button 

(Page 4790) 
-- -- -- -- -- -- -- -- -- -- -- --

46 Release right mouse button 
(Page 4790) 

-- -- -- -- -- -- -- -- -- -- -- --

47 Runtime Stop (Page 4791) -- -- -- -- -- -- -- -- -- -- -- --
48 Click toolbar button 

(Page 4791) 
-- -- -- -- X X X X X X -- --
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49 Change slider (Page 4791) -- -- -- -- -- -- -- -- -- -- X --
50 StepForward (Page 4792) -- -- -- -- -- -- -- -- -- -- X --
51 StepBack (Page 4792) -- -- -- -- -- -- -- -- -- -- X --
52 Lock changed (Page 4792) -- -- -- -- -- -- -- -- -- -- -- --
53 Status changed (Page 4793) -- -- -- -- -- -- -- -- -- -- -- --
54 Stop (Page 4793) -- -- -- -- -- -- -- -- -- -- X --
55 Switch toolbar (Page 4793) -- -- -- -- -- -- -- -- -- -- X --
56 Press key on keyboard 

(Page 4794) 
-- -- -- -- -- -- -- -- -- -- -- --

57 Release key on keyboard 
(Page 4795) 

-- -- -- -- -- -- -- -- -- -- -- --

58 Change video format 
(Page 4797) 

-- -- -- -- -- -- -- -- -- -- X --

59 Full screen (Page 4797) -- -- -- -- -- -- -- -- -- -- X --
60 Exit full screen (Page 4798) -- -- -- -- -- -- -- -- -- -- X --
61 Replay (Page 4799) -- -- -- -- -- -- -- -- -- -- X --

Events

Cleared

Description
Occurs when the active screen on the HMI device is cleared.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)
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Play ended

Description
Occurs when the video or audio file has been played.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Activate

Description
Occurs when the user selects a display or operating object using the configured tab 
sequence.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 Note

If the user e.g. clicks a button with the mouse, the "Click" event is triggered. Users wishing 
to trigger the "Enable" event must select the button using the tab key.

 

The "Enable" event is only used to detect whether an object was selected. The event does not 
trigger a password prompt.

For this reason, do not use the "Enable" event if you want to configure access protection on 
the function call of the object.

Change

Description
Occurs if the status of a display and operator control object changes. 
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The status of an object changes if, for example, the user presses the key. 
 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

Loaded

Description
Occurs if a display or operating object is completely loaded in Runtime.

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

Execute

Description
Occurs when the scheduled task has been executed.   

Selection changed

Description
Occurs when the selection is changed. 

In the event of high limit violation

Description
Occurs when the high limit of a tag is exceeded.   

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)
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Elements (Page 4754)

Controls (Page 4756)

In the event of low limit violation

Description
Occurs when the low limit of a tag is undershot.   

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

When dialog is opened

Description
The event is triggered when a modal dialog opens.  

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)
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When dialog is closed

Description
The event is triggered when a modal dialog closes.  

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

User change

Description
Occurs when a user logs off at an HMI device or another user logs on at the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Screen change

Description
Occurs when all configured display and operating objects are loaded in the screen after a 
screen change. 
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Use the "Loaded" event if you want to perform other system functions during a screen change 
to a certain screen. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Deactivate

Description
Occurs when the user takes the focus from a display and operating object.   

A screen object can be disabled using the configured tab order or by performing another action 
with the mouse.

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

System functions or user-defined functions on the "Deactivate" event of a screen are not 
executed when a screen is being closed.

 

The "Deactivate" event is only used to detect whether an object was deselected. The event 
does not trigger a password prompt.

For this reason, do not use the "Deactivate" event if you want to configure access protection 
on the function call of the object.

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)
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Double-click

Description
Occurs when the user double-clicks on an object from the symbol library. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Press

Description
Occurs when the user clicks on a button with the left mouse button, presses <RETURN> or 
<SPACE>. 

Also occurs when the user right-clicks on an object of the symbol library.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Operator input alarm property changed

Description
Occurs when the property of an operator input alarm is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Block property changed

Description
Occurs when the property of a block, e.g., alarm text block, is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Property diagram changed

Description
Occurs when the property of a trend diagram is changed.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Property changed

Description
Occurs when a property is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Trend property changed

Description
Occurs when the property of the trend is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Column property changed

Description
Occurs when the property of a column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Alarm statistics column property changed

Description
Occurs when the property of the alarm statistics column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Statistics area column name property changed

Description
Occurs when the column name of the statistics area is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property status bar element

Description
Occurs when the property of a status bar element is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property toolbar button

Description
Occurs when the property of a toolbar button is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4777



Change property value axis

Description
Occurs when the property of the value column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property value column

Description
Occurs when the property of the value column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

X-axis property changed

Description
Occurs when the property of the X-axis is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Y-axis property changed

Description
Occurs when the property of the Y-axis is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property time axis

Description
Occurs when the property of the time axis changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change property time column

Description
Occurs when the property of the time column is changed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

On Finish Input

Description
Triggered when you confirm input at an I/O field by pressing ENTER, or by mouse click, or by 
touch screen operation. 
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The "On Finish Input" event is also started if the value of a tag does not change, for example, 
if a value is exceeded, or if a user cancels the dialog to acknowledge a tag (Audit option 
package) that has to be acknowledged.

The event is not triggered, on the other hand, by user logon or by input fields configured with 
an authorization.

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Press ESC twice

Description
Occurs when the user presses the <ESC> key twice at the HMI device. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)
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Outgoing

Description
Occurs when an alarm is deactivated. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

Incoming

Description
Occurs when an alarm is triggered and displayed in the alarm view. 

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

In the alarm range

Description
Occurs if the available storage space has reached the configured monitoring limit "alarm". You 
configure this event in the display and operating object "storage space display".

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

In the tolerance range

Description
Occurs if the available storage space has reached the configured monitoring limit "tolerance". 
You configure this event in the display and operating object "storage space display".

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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In the warning range

Description
Occurs if the available storage space has reached the configured monitoring limit "warning". 
You configure this event in the display and operating object "storage space display".

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Click

Description
Occurs if the user clicks a display and operating object with the mouse or touches the touch 
display with a finger. 

In case you click the incorrect object, prevent processing of configured function list as follows:

● Move the mouse pointer away from the object while keeping the mouse button pressed. 
Release the mouse button as soon as the mouse pointer leaves the object. The function 
list will then not be processed.

● On touch displays, the display must be touched with the finger until a reaction occurs, e.g., 
a screen change.

 

  Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Click when flashing

Description
Occurs when the user clicks a flashing alarm indicator with the mouse or touches it with a 
finger. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Shortcut menu

Description
Ocurs when the shortcut menu opens.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Volume

Description
Occurs when the volume changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)
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Change layout

Description
Activated when a property is changed.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Change ruler

Description
Activated when a property is changed.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Press left mouse button

Description
Occurs when the operator left-clicks on a display and operating object. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Release left mouse button

Description
Occurs when the user releases the left mouse button after clicking.

This event does not occur as long as the left button remains pressed.
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If the operator releases the button after clicking on a button, this event will also occur even if 
the mouse pointer is no longer pointing on the button.

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Loop-in alarm

Description
Occurs as soon as the user selects an alarm in the alarm view and then clicks on the "Loop-
In-Alarm" button or double clicks on the alarm.   

For the "Loop-In-Alarm" event, you configure system functions, such as a change to the screen 
in which the alarm occurred.

You cannot configure local scripts for the "Loop-In-Alarm" event in Runtime Professional.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Release

Description
Occurs when the user releases a button. 

This even does not occur, as long as the button remains pressed.
 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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Alarm buffer overflow

Description
Occurs when the configured size of the alarm buffer is reached. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Move mouse

Description
Occurs when the user moves the mouse.

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Medium opened

Description
Occurs when the medium is opened.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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See also
Elements (Page 4762)

Medium closed

Description
Occurs when the medium is closed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Object changed

Description
Occurs if the user changes a property of a display and operating object in Runtime. 

 

 Note

Every action triggered by this event is logged on individually and then logged off again when 
the screen is changed. This behavior puts a burden on the working memory. Use this event 
only for important changes to properties, e.g., for an I/O field. 

 

 Note

The availability of the event is dependent on the HMI device and object type.
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Pause

Description
Occurs when playing of the video or audio file is paused.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Acknowledge

Description
Occurs when the user acknowledges an alarm. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Reach margin

Description
Occurs when the user reaches the beginning or the end of a scrollable area.   

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 Note

A user-defined function must not be configured for the "Boundary reached" event.
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Configurable objects
The event can only be configured on the <Up> and <Down> keys, or on the keys on which 
you have configured the "ScreenObjectPageUp" or "ScreenObjectPageDown" system 
functions.

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Press right mouse button

Description
Occurs when the user right-clicks on a display and operating object. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Release right mouse button

Description
Occurs when the user releases the right mouse button after clicking.

This event does not occur as long as the right mouse button remains pressed.

If the operator releases the button after clicking on a button, this event will also occur even if 
the mouse pointer is no longer pointing on the button.

 

 Note

Note that the availability of the event depends on the HMI device and object type.
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Runtime Stop

Description
Occurs when the user exits the Runtime software on the HMI device. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 Note

A user-defined function must not be configured for the "Runtime stop" event.
 

 

Click toolbar button

Description
Occurs when the user clicks a button in the toolbar.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Change slider

Description
Occurs when the volume slider changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)
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StepForward

Description
Occurs when the video or audio file goes to the next sequence.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

See also
Elements (Page 4762)

StepBack

Description
Occurs when the video or audio file goes to the previous sequence.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Lock changed

Description
Occurs when the write access for the log is changed, e.g., from locked to released.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4791



Status changed

Description
Occurs when the status of an alarm is changed, e.g., from incoming to outgoing.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

Stop

Description
Occurs when playing of the video or audio file is stopped.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

See also
Elements (Page 4762)

Switch toolbar

Description
Occurs when the property of the time axis changes.     

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

See also
Elements (Page 4762)
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Press key

Description
Occurs when the user presses a function key. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Release key

Description
Occurs when the user releases a function key. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Press key on keyboard

Description
Occurs when the user presses a key on the keyboard. 
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The keys <F10> and <ALT+PRINT> are not used by the operator for process operations.
 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Release key on keyboard

Description
Occurs when the user releases a key on the keyboard. 

The keys <F10> and <ALT+PRINT> are not used by the operator for process operations.
 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

 

Overflow

Description
Occurs when the configured size of the log is reached. You use the log type "Trigger event". 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)
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Switching

Description
Occurs when the user toggles a display and operating object, e.g. a switch from "ON" to "OFF". 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Switch OFF

Description
Occurs when the user moves the display and operating object "Switch" to the OFF position. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)
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Switch ON

Description
Occurs when the user moves the display and operating object "Switch" to the ON position. 

 

 Note

Note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Change video format

Description
Occurs when the video format changes.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Full screen

Description
Occurs when the full screen mode is activated.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4796 System Manual, 02/2014



 

See also
Elements (Page 4762)

Exit full screen

Description
Occurs when the full screen mode is exited.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

 

See also
Elements (Page 4762)

Low free storage space

Description
This event is triggered if the storage space available on the medium to which the Audit Trail 
is less than the configured minimum. 

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Free space critically low

Description
This event is triggered if the storage medium to which an Audit Trail is saved provides 
insufficient storage space due to hardware restrictions. 
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See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Value change

Description
Occurs when the value of a tag or the value of an array element changes. 

The value change of a tag is triggered by the PLC or by the user, e.g. when a new value is 
entered. No event is output if a system function changes the value.

 

 Note

Please note that the availability of the event depends on the HMI device and object type.
 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

Replay

Description
Occurs when the video or audio file has been replayed.   

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.
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See also
Elements (Page 4762)

Time expired

Description
Occurs when the time configured in the scheduler expires. 

 

 Note

Please note that the availability of the event is dependent upon the HMI device and object 
type.

 

See also
Editors (Page 4752)

Basic objects (Page 4753)

Elements (Page 4754)

Controls (Page 4756)

10.8.11.3 VB scripting

System functions

AcknowledgeAlarm

Description
Acknowledges all selected alarms.       

This system function is used when the HMI device does not have an ACK key or when the 
integrated key of the alarm view should not be used.

This system function can only be used for function keys.

Use in the function list
AcknowledgeAlarm

Use in user-defined functions
AcknowledgeAlarm
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ActivatePreviousScreen

Description
Performs a screen change to the screen which was activated before the current screen. The 
screen change is not performed if no screen was activated beforehand.       

The last 10 screens that were called up are saved. A system alarm is output when you change 
to a screen which is no longer saved.

 

 Note

If you want to use the system function, the screen to which you change has to be used in the 
navigation structure.

 

 

Use in the function list
ActivatePreviousScreen

Use in user-defined functions
ActivatePreviousScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 
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Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.

 
 
{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}
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ActivateScreenByNumber

Description
Performs a screen change to a screen depending on a tag value.       

The screen is identified by its screen number.

Use in the function list
ActivateScreenByNumber (Screen number, Object number)

Use in user-defined functions
ActivateScreenByNumber (Screen_number, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Screen number
Tag which contains the screen number of the destination screen.

When a change from the root screen to the permanent window is desired, "0" or "-1" is specified:

0 = Change from root screen to permanent window

-1 = Change from permanent window to root screen

Object number
The number of the screen object which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

ActivateSystemDiagnosticsView

Description
Activates the system diagnostics view. The system diagnostics view shows the detail view of 
the device concerned.       
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Use in the function list
ActivateSystemDiagnosticsView (Screen name, Object name)

Use in user-defined functions
ActivateSystemDiagnosticsView (Screen_name, Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Screen name
Name of the screen contained in the system diagnostics view.

Object name
Object name of the system diagnostics view.

ArchiveLogFile

Description
This system function moves or copies a log to another storage location for long-term logging. 

With Audit Trails, always use the "Move" (hmiMove)" mode, otherwise you will be violating the 
FDA guideline by duplicating the data stored.       

Prior to "ArchiveLogFile" always run the system function "CloseAllLogs".

After this system function, run the "OpenAllLogs" system function.

In "Copy log" mode, the logs are not reopened until the log has been successfully copied, or 
unless a timeout occurs during the copy process. In "Move log" mode, the logs to be moved 
are renamed and the new logs are opened immediately. To move the renamed logs, a job is 
submitted which attempts to move them every 300 seconds if the server cannot be reached. 
The job is also retained after Runtime is restarted until it is executed.

Use in the function list
ArchiveLogFile (Log type, Log, Directory name, Mode)

Use in user-defined functions
ArchiveLogFile (Log_type, Log, Directory_name, Mode) 

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (miAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log available for GMP compliant projects. Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log being archived.

Directory name
Path for saving the log.

Mode
0 (hmiCopy) = Copy log

1 (hmiMove) = Move log

Application example
You want to move a log file from a local storage medium to the server in order to generate a 
backup copy of this file at cyclic intervals.

Notes on configuring

Set up a task in the scheduler which is executed at a specific time on a daily basis. Configure 
the following function list for the task:

Procedure on HMI device
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● All log files will be closed.

● The log file you specified is moved to the server.

● All closed log files will be opened again.

Back up RAM file system

Description
Backs up the RAM file system in the memory medium of the HMI device.       

After restarting the HMI device, the data is automatically reloaded in the RAM file system.

Applications such as the Internet Explorer save data (e.g. the last web sites called up) 
temporarily to the DRAM file system of the HMI device.

Use in the function list
BackupRAMFileSystem

Use in user-defined functions
BackupRAMFileSystem

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

CalibrateTouchScreen

Description
Calls a program for calibrating the touch screen.       

During the calibration process, there is a prompt to touch five positions on the screen display. 
Touch the screen display within 30 seconds, to confirm the calibration process. If the calibration 
is not completed within this time span, the calibration settings are discarded. The user prompt 
is in English.

Use this system function the first time you start the HMI device.

Use in the function list
CalibrateTouchScreen
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Use in user-defined functions
CalibrateTouchScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

 

 Note

The CalibrateTouchScreen system function cannot be simulated.
 

ChangeConnection

Description
Disconnects the connection to the currently used PLC in use and establishes a connection to 
a PLC with another address. The newly connected PLC must belong to the same device class 
(S7-1200, S7-300, ...etc). With S7-1200, the use of the function is also only permitted for 
absolute addressing.

       
 

 Note

When changing to another address, ensure that the address is not already being used by 
another HMI device.

 

The follows address types are supported:

● IP address

● MPI address

The follows PLC types are supported:

● SIMATIC S7 300/400

● SIMATIC S7-NC

● SIMOTION

Use in the function list
ChangeConnection (Connection, Address, Slot, Rack)

Use in user-defined functions
ChangeConnection (Connection, Address, Slot, Rack)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Connection
Name of the connection that is disconnected. The name is set during configuration, for 
example, in the "Connections" editor.

Address
MPI/PROFIBUS or IP address of the PLC to which the connection will be established.

 

 Note

Set the address by means of a tag. The objects list displays the tags of all data types. Select 
only tags of the following data types:
● Ethernet connection: "String" data type
● MPI connection: "Int" data type

 

Slot
Slot of the PLC to which the connection will be established.

Rack
Rack of the PLC to which the connection will be established.

Application example
You want to operate one HMI device on several machines. Configure the necessary PLCs in 
the project, to which you want to change by pressing a key. When changing the PLC, the 
connection to the PLC in use is disconnected. Then the connection to the new PLC with other 
address parameters is reestablished. To access the values of the new PLC, configure the 
same tags for the PLC used.

The PLC which you have indicated when creating the project will be used as default.

1. Enter the name and address of the PLC in the "Connections" editor.

2. Configure a button in the process screen.

3. Configure the "ChangeConnection" system function on the "Press" event.

4. Enter the name of the connection and address of the PLC as parameters.
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ClearAlarmBuffer

Description
Deletes alarms from the alarm buffer on the HMI device.       

 

 Note

Alarms which have not yet been acknowledged are also deleted.
 

Use in the function list
ClearAlarmBuffer (Alarm class number)

Use in user-defined functions
ClearAlarmBuffer (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Determines which alarms are to be deleted from the alarm buffer:

0 (hmiAll) = All alarms/events

1 (hmiAlarms) = Alarms of alarm class "Errors"

2 (hmiEvents) = Alarms of alarm class "Warnings"

3 (hmiSystem) = Alarms of alarm class "System"

4 (hmiS7Diagnosis) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

ClearAlarmBufferProtool

Description
The system function exists to ensure compatibility.

It has the same functionality as the "ClearAlarmBuffer" system function, but uses the old 
ProTool numbering.       
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Use in the function list
ClearAlarmBufferProTool (Alarm class number)

Use in user-defined functions
ClearAlarmBufferProtoolLegacy (Alarm_class_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Alarm class number
Alarm class number whose messages are to be deleted:

-1 (hmiAllProtoolLegacy) = All alarms/events

0 (hmiAlarmsProtoolLegacy) = Alarms of alarm class "Errors"

1 (hmiEventsProtoolLegacy) = Alarms of alarm class "Warnings"

2 (hmiSystemProtoolLegacy) = Alarms of alarm class "System"

3 (hmiS7DiagnosisProtoolLegacy) = Alarms of alarm class "Diagnosis Events"
 

 Note
Device dependency

Alarms of alarm class "Diagnosis Events" are not available on Basic Panels.
 

ClearDataRecord

Description
Deletes a recipe data record.       

Several data records can be deleted from one or more recipes.

Use in the function list
ClearDataRecord (Recipe number/name, Data record number/name, Confirmation, Output 
status message, Processing status)

Use in user-defined functions
ClearDataRecord

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are deleted. "0" is specified if 
you want to delete recipe data records from all available recipes.

Data record number/name
Number or name of the recipe data record to be deleted. "0" is specified if you want to delete 
all recipe data records.

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

ClearDataRecordMemory

Description
Deletes all recipes data records from the specified storage medium.       

Use in the function list
ClearDataRecordMemory (Storage location, Confirmation, Output status message, 
Processing status)

Use in user-defined functions
ClearDataRecordMemory (Storage_location, Confirmation, Output_status_message, 
Processing_status)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Storage location
Determines the storage location:

0 (hmiFlashMemory) = Flash memory: Internal flash memory of the HMI device

1 (hmiStorageCard) = Storage card

2 (hmiStorageCard2) = Storage card 2

3 (hmiStorageCard3) = Storage card MultiMediaCard

4 (hmiStorageCard4) = Storage card USB

Confirmation
Determines whether the operator should confirm the deletion:

0 (hmiOff) = Off: Deletion is begun without confirmation.

1 (hmiOn) = On: The starting of the deletion process must be confirmed.

Output status message
Determines whether a status message is output after the deletion:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

ClearLog

Description
Deletes all data records in the given log.       

Use in the function list
ClearLog (Log type, Log)
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Use in user-defined functions
ClearLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log: 

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail log Available for GMP-compliant projects Additional 
information is available under "Activating GMP-compliant configuration".

Log
Name of the log from which all entries are deleted.

CloseAllLogs

Description
Disconnects the connection between WinCC and all logs.       

 

 Note

Before you close a log, the logging function must first be stopped in the log. Use the 
"StopLogging" system function.

 

Use in the function list
CloseAllLogs

Use in user-defined functions
CloseAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--
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Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
The logging process will continue in the specified log.

ControlSmartServer

Description
Starts or stops the Sm@rtServer.       

Use in the function list
ControlSmartServer (Mode)

Use in user-defined functions
ControlSmartServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Sm@rtServer is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: Sm@rtServer is stopped

1 (hmiStart) = Start: Sm@rtServer is started
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ControlWebServer

Description
Starts or stops the Web server.       

Use in the function list
ControlWebServer (Mode)

Use in user-defined functions
ControlWebServer (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Specifies whether the Web server is started or stopped. 

-1 (hmiToggle) = Toggle: Toggles between the two modes

0 (hmiStop) = Stop: The Web server is stopped.

1 (hmiStart) = Start: The Web server is started.

CopyLog

Description
Copies the contents of a log to another log. Tag values can only be copied to other data logs 
and alarms only to other alarm logs, however.

 

 Note

If you copy a log using the "CopyLog" system function, it is possible that external applications 
will be unable to read certain country-specific special characters in the logged message text 
of the log copy. This does not apply to WinCC Runtime. WinCC Runtime can read the copied 
log files without errors.

 

Use in the function list
CopyLog (Log type, Destination log, Source log, Mode, Delete source log)
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Use in user-defined functions
CopyLog (Log_type, Destination log, Source_log, Mode, Delete_source_log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Destination log
Name of the log into which the entries are copied (Destination log).

Source log
Name of the log from which the entries are copied (Source log).

Mode
Determines what is done with copied entries in the destination log:

0 (hmiOverwrite) = Overwrite: Existing entries are overwritten.

2 (hmiAppend) = Append: The entries are inserted at the end of the destination log. When the 
configured size of the log has been reached, the destination log is treated like a circular log.

Delete source log
Determines whether the source log is deleted after copying.

0 (hmiNo) = No: Is not deleted.

1 (hmiYes) = Yes: Is deleted.

DecreaseTag

Description
Subtracts the given value from the tag value.       

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. The auxiliary tags are assigned to 
the tag value with the "SetTag" system function.
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If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

EditAlarm

Description
Triggers the "Edit" event for all selected alarms.       

If the alarms to be edited have not yet been acknowledged, the acknowledgment takes place 
automatically when this system function is called up.

This system function can only be used for function keys.

Use in the function list
EditAlarm

Use in user-defined functions
EditAlarm

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--
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Encode

Description     
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

Use in the function list
Encode (Byte array, String, Coding)

Use in user-defined functions
Encode (Byte_array, String, Encoding)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The Byte array must be twice the size of the string length + 2. The Byte array must contain 
242 array elements if the string has a length of 120 characters.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Encode
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

EncodeEx

Description       
Adapts the "String" data type of a tag for transfer to the automation system (AS). The tag of 
WinCC data type "String" is converted into the AS data type "Array of byte". The result is written 
to a tag. 

By contrast to the Encode system function, you can define the Line break parameter. Using 
the Line break parameter you can delete line breaks or replace these with predefined 
characters.
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Use in the function list
EncodeEx (Byte array, String , Encode , Line break)

Use in user-defined functions
EncodeEx (Byte_array, String, Encoding, Line_break)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Byte array
The tag that contains the converted value. 

 

 Note

The byte array must be twice the size of the string length +2. If the string has a length of 120 
characters, the byte array must contain 242 array elements.

Characters are either truncated or not converted if the size is insufficient.
 

String
The tag of data type "String" that is converted.

Code
0 (hmiEncodeUTF16LE) - String is encoded in UTF16LE (Unicode 16 Little Endian). 

Line break
All line breaks are either deleted or replaced with predefined characters. Do not replace line 
breaks if set as the default value. 

0 (replace with "\r\n' (0x000D, 0x000A)) - the line break is replaced with "\r\n".

1 (replace with "\n' (0x000A)) - the line break is replaced with "\n".

2 (do not replace) - the line break is not replaced.

3 (remove line breaks) - the line breaks are removed.

ExportDataRecords

Description
Exports one or all data records of a recipe to a CSV file.       

One file is created per recipe.
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Use in the function list
ExportDataRecords (Recipe number/name, Data record number/name, File name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
ExportDataRecords (Recipe_number/name,Data_record number/name, File_name, 
Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

File name
Name of the CSV file to which the recipe data records are exported. Enter the file location and 
the file extension (*.csv), for example, "C:\TEMP\Orange.csv".

 

 Note
Storage of the CSV file
● If a storage card is used as storage location, specify the storage location as follows: 

"\StorageCard\<File name>".
● If you only enter one file name and no path, the file will be saved in a system directory, 

for example, "C:\Documents and Settings\[User]".
● When only one path for the export is specified, the file name is automatically created from 

the respective recipe name. It is a requirement that the folder "D:\Temp\", for example, 
has been created. If the folder  "D:\Temp" has not been created, the folder name will be 
used as the prefix of the file name, Temp_Recipe names.csv.

 

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithPrompting) = With confirmation: CSV file is not overwritten until confirmed.
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Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file 
formats.       

Application example
You want to export all data records using a key.

Notes on configuring

Configure the "ExportDataRecords" system function on the "Press" event for the desired key. 
Transfer the following parameters:

● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device
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As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file. If the file already 
exists, it will be overwritten.

After exporting the data records, a system message is output.

ExportDataRecordsWithChecksum

Description
Exports one or all data records of a recipe to a CSV file and generates a checksum for each 
line in the file.       

One file is created per recipe.

Use in the function list
ExportDataRecordsWithChecksum (Recipe number/name, Data record number/name, File 
name, Overwrite, Output status message, Processing status)

Use in user-defined functions
ExportDataRecordsWithChecksum (Recipe_number/name, Data_record number/name, 
File_name, Overwrite, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which the data records are exported. Specify "0" if recipe 
data records are to be exported from all available recipes.

Data record number/name
Number or name of the recipe data record to be exported. Specify "0" if all recipe data records 
are to be exported.

File name
Name of the CSV file to which the recipe data records are exported. Enter the path and the 
file extension e.g. "C:\TEMP\Orange.CSV".

If a storage card is used as storage location, specify the storage location as follows: 
"\StorageCard\<File name>".

If you define only a file name without specifying a path, the file is saved to the directory from 
which Runtime was started. If write access to this directory is not enabled in the Windows 7 
operating system, the file is saved to the "VirtualStore" folder of the user directory.

When only one path for the export is specified, the file name is automatically created from the 
respective recipe name. This requires, for example, that the directory "D:\Temp\" has been 
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created. If the directory  "D:\Temp" does not exist, the directory name is used as the prefix for 
the file name, Temp_Recipe names.csv.

Overwrite
Determines whether an existing CSV file with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: CSV file will not be overwritten. The export process will not 
be carried out.

1 (hmiOverwriteAlways) = Yes: CSV file is overwritten without a prompt for confirmation.

2 (hmiOverwriteWithConfirmation) = With confirmation: CSV file is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the export:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Export format of the recipe data records
If ".csv" is chosen as a file extension for the export file, then only valid characters from the 
ANSI character set will be supported. This also applies to separators in decimal numbers and 
list elements. The separators used are defined in the country/regional settings of the operating 
system of the exporting computer.

You may also set "Unicode text" (".txt") format for the export file. This file format supports the 
WinCC and WinCC Runtime character set. Again, the separators used are specified in the 
country/regional settings of the operating system of the exporting computer. This file format 
always uses tab separators in list elements.

The corresponding file import function also supports the ".csv" and ".txt" (Unicode) file formats.

Application example
Using a key, you want to export all data records and assign a checksum.

Notes on configuring

Configure the "ExportDataRecordsWithChecksum" system function on the "Press" event for 
the desired key. Transfer the following parameters:
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● Recipe number/name = 1

● Data record number/name = 0

● File name = c:\temp\orange.csv

● Overwrite = 1

● Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data records are exported.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated. All data records of Recipe 1 are exported to the orange.csv file and assigned 
checksums. If the file already exists, it will be overwritten.

After exporting the data records, a system message is output.

ExportImportUserAdministration

Description
Exports all users of the user administration of the currently active project to the given file or 
imports the users from the given file into the currently active project.       

Users, their passwords and rights are saved in the user administration.

All users are overwritten when importing. The imported users are valid immediately.

Use in the function list
ExportImportUserAdministration (File name, Direction)

Use in user-defined functions
ExportImportUserAdministration (File_name, Direction)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

File name
Name of the file which contains the passwords or to which the passwords are written. Enter 
the file location and the file extension (*.txt), for example, "C:\TEMP\Passwords.txt".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Direction
Specifies whether passwords are exported or imported:

0 (hmiExport) = Export: Passwords are exported.

1 (hmiImport) = Import: Passwords are imported.

GetBrightness

Description
Reads the value of the brightness.

       

Use in the function list
GetBrightness (Brightness)

Use in user-defined functions
GetBrightness (Brightness)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
The tag to which the value is written. 
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GetDataRecordFromPLC

Description
Transfers the selected recipe data record from the PLC to the storage medium of the HMI 
device.       

Use in the function list
GetDataRecordFromPLC (Recipe number/name, Data record number/name, Overwrite, 
Output status message, Processing status)

Use in user-defined functions
GetDataRecordFromPLC (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data records are transferred.

Data record number/name
Number or name of the recipe data record which is transferred from the PLC to the data medium 
of the HMI device.

Overwrite
Determines whether an existing recipe data record with the same name is overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data record is not overwritten. The transfer process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data record is overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data record is not overwritten until 
confirmed.

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:
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2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to transfer a data record from the PLC to the data medium of the HMI device using 
a key.

Notes on configuring

Configure the "GetDataRecordFromPLC" system function on the "Press" event for the desired 
key. Transfer the following parameters:

Recipe number/name = 1

Data record number/name = 1

Overwrite = 1

Output status message = 1

Tags can also be specified in place of the constants. Depending on the configuration, the 
operator can enter the desired values in the I/O field or read from the PLC. In this way, the 
operator can determine which recipe data record is transferred from the PLC.

Procedure on HMI device

As soon as the key is activated, the system function is triggered. The constants or tags are 
evaluated and the first data record of Recipe 1 is transferred from the PLC to the data medium 
of the HMI device. If the recipe data record already exists, it will be overwritten.

A system message is output after the transfer.

GetDataRecordName

Description
Writes the name of the given recipe and recipe data record to the given tags.     

 

 Note

If the recipe or the recipe data record do not exist, wildcards ("###") are written to the tags.
 

Use in the function list
GetDataRecordName (Recipe number, Data record number, Recipe name, Data record name, 
Processing status)
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Use in user-defined functions
GetDataRecordName (Recipe_number, Data_record_number, Recipe_name, 
Data_record_name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency". 

Parameter

Recipe number
Number of the recipe whose name is written to the given tag.

Data record number
Number of the recipe data record whose name is written to the given tag.   

Recipe name
The tag to which the recipe name is written. The tag must be of the STRING type.

Data record name
The tag to which the name of the recipe data record is written. The tag must be of the STRING 
type.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Application example
You want to output the names of the displayed recipes and the name of the displayed recipe 
data record on the HMI device.

Configure the following tags:

● "RecNumber" of type INTEGER

● "RecDataNumber" of type INTEGER

● "RecName" of type STRING

● "RecDataName" of type STRING

Configure a recipe view with the tags "RecNumber" for the recipe number and 
"RecDataNumber" for the data record number.

Configure the "GetDataRecordName" system function on the "Press" event for a button and 
pass the following parameters:
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● Recipe number: RecNumber

● Data record number: RecDataNumber

● Recipe name: RecName

● Data record name: RecDataName

Configure two output fields and connect these to the "RecName" and "RecDataName" tags.

Select a recipe and a data record number from the recipe view. As soon as the button is 
activated, the system function is triggered and the name of the recipe and the recipe data 
record are displayed in both output fields.

GetDataRecordTagsFromPLC

Description
Transfers the values of the recipe data record loaded in the PLC to the corresponding recipe 
tags.       

This system function is used, for example, during teach-in mode on a machine.

Use in the function list
GetDataRecordTagsFromPLC (Recipe number/name, Processing status)

Use in user-defined functions
GetDataRecordTagsFromPLC (Recipe_number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe data record whose values are written from the PLC to the tags.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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GetGroupNumber

Description
Reads the number of the group to which the user logged on to the HMI device belongs, and 
writes it to the given tag.       

Use in the function list
GetGroupNumber (Tag)

Use in user-defined functions
GetGroupNumber (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the number of the group is written.

GetPassword

Description
Writes the password of the user currently logged on to the HMI device in the given tag.       

 

 Note

Make sure that the value of the given tag is not displayed in another place in the project.
 

 Note

The passwords of SIMATIC Logon users cannot be read. 
 

Use in the function list
GetPassword (Tag)

Use in user-defined functions
GetPassword (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Tag
The tag to which the password is written.

GetUserName

Description
Writes the user name of the user currently logged on to the HMI device in the given tag.       

If the given tag has a control connection, the user name is also available in the PLC connection. 
This system function makes it possible, for example, to implement a user-dependent release 
of certain functionalities.

Use in the function list
GetUserName (Tag)

Use in user-defined functions
GetUserName (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the user name is written.

GoToEnd

Description
Executes the key function <End> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToEnd

Use in user-defined functions
GoToEnd
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

GoToHome

Description
Executes the key function <Home> on the HMI device.       

This system function is used when the HMI device does not have this functionality by default.

The system function can only be used for the following function keys.

Use in the function list
GoToHome

Use in user-defined functions
GoToHome

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ImportDataRecords

Description
Imports one or all data records of a recipe from a CSV file.       

When a path is specified, all records of the given directory are imported.

Use in the function list
ImportDataRecords (File name, Data record number/name, Overwrite, Output status 
message, Processing status)
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Use in user-defined functions
ImportDataRecords (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the file location 
and the file extension (*.csv), for example "C:\TEMP\Orange.csv".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithPrompting) = With confirmation: Recipe data records are not overwritten 
until confirmed.

Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.
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Configurable objects

Object Event
Tag Value change

High limit violated
Low limit violated

Function key (global) Release
Press

Function key (local) Release
Press

Screen Loaded
Cleared

Screen object Press
Release
Click
Change (or toggle for switch)
Switch on
Switch off
Enable
Disable

Scheduler Time expired

 

 

ImportDataRecordsWithChecksum 

Description
Imports one or all data records of a recipe from a CSV file with a checksum and verifies the 
checksum.       

Use in the function list
ImportDataRecordsWithChecksum (File name, Data record number/name, Overwrite, Output 
status message, Processing status, verify checksum)

Use in user-defined functions
ImportDataRecordsWithChecksum (File_name, Data_record number/name, Overwrite, 
Output_status_message, Processing_status, Verify_Checksum)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

File name
Name of the CSV file from which the recipe data records are imported. Enter the path and the 
file extension, for example, "C:\TEMP\Orange.CSV".

If a storage card is used as storage medium, specify the storage location as follows: 
"\StorageCard\<File name>".

If you specify a directory instead of an individual CSV file, all files in the specified directory will 
be imported.

Data record number/name
Number or name of the recipe data record to be imported. Specify "0" if all recipe data records 
are to be imported.

Overwrite
Determines whether existing recipe data records are to be overwritten:

0 (hmiOverwriteForbidden) = No: Recipe data records are not overwritten. The import process 
will not be carried out.

1 (hmiOverwriteAlways) = Yes: Recipe data records are overwritten without prompting.

2 (hmiOverwriteWithConfirmation) = With confirmation: Recipe data records are not 
overwritten until confirmed.

Output status message
Determines whether a status message is output after the import:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for example 
to delay execution of other system functions, until this system function has been successfully 
completed.

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Verify checksum
Determines if the checksum should be verified during import:

0 (hmiFalse) = No: Checksum is not verified.

1 (hmiTrue) = Yes: Checksum is verified.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4834 System Manual, 02/2014



IncreaseTag

Description
Adds the given value to the value of the tags.       

X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, help tags must be used. You can use the "SetTag" system function 
to assign the tag value to the auxiliary tags.

 

If you configure the system function on the events of an alarm and the tag is not being used 
in the current screen, it is not ensured that the actual value of the tags is being used in the 
PLC. You can improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions 
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Tag
The tag to which the given value is added.

Value
The value that is added.

InverseLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       
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The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag that contains the value used for calculation.

b
The value which is subtracted.

a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
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//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.

Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
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printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
  ...
}

InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.
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Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       

The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag that contains the value used for calculation.

b
The value that is added.

Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
 
printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

LoadDataRecord

Description
Loads the given recipe data record from the memory medium of the HMI device in the recipe 
tags. This system function is used, for example, to display a recipe data record in the recipe 
screen.       

Activate the "Synchronize recipe view and recipe tags" option in the synchronization settings 
of the recipe. If this option is deactivated, the system function has no effect. 

Use in the function list
LoadDataRecord (Recipe number/name, Data record number/name, Processing status)
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Use in user-defined functions
LoadDataRecord (Recipe_number/name, Data_record_number/name, Confirmation, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which a recipe data record is loaded.

Data record number/name
Number or name of the recipe data record to be loaded.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

LogOff

Description
Logs off the current user on the HMI device.       

Use in the function list
Logoff

Use in user-defined functions
Logoff

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--
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Logon

Description
Logs on the current user on the HMI device.       

Use in the function list
Logon (Password, User name)

Use in user-defined functions
Logon (Password, User_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Password
The tag from which the password for the user logging on is read.

If the user is logged on, the password in the tag is deleted.

User name
The tag from which the user name for the user logging on is read.

LookupText

Description     
Identifies an entry from a text list. The result depends on the value and on the selected runtime 
language. The result is saved to a tag of data type "String".

Use in the function list
LookupText (Output text, Value, Language, Text list)

Use in user-defined functions
LookupText (Output_text, Index, Language, Text_list)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Output text
The tag to which the result is written.

Value
The tag that defines the value of the list entry. 

Language
Defines the runtime language in which the list entry is identified. 

● Runtime language
Language code as per VBScript reference, for example, "de-DE" for German (Germany) 
or "en-US" for English (United States of America). The selection depends on the activated 
runtime languages. 

● Tag
The tag that contains the language. Enter the runtime language as decimal value of the 
country ID, for example, 1031 for German - Standard, 1033 for English - USA. Details are 
available in the VBScript basics, "Locale identifier (LCID) diagram".

● Integer
The number that corresponds to the order of runtime languages for language switching. 
The selection depends on the activated runtime languages, for example, "0" for the 
language that appears when you first start runtime. You can find more information under 
the topic of "Languages in Runtime".

Text list
Defines the text list. The list entry is read from the text list.

NotifyUserAction

Description
       

This system function is used to log user actions that are not automatically logged in the audit 
trail. You can also use this system function to require the user to enter an acknowledgment or 
an electronic signature and a comment for the operator action. Requirement for the use of the 
system function is that the GMP-compliant configuration is activated under "Runtime settings".

If you use the "NotifyUserAction" system function in a function, the debugger may open if you 
cancel your input by clicking "Cancel". To compensate for this reaction, you can use the "On 
Error Resume Next" statement in a function. With this instruction, the next instruction is 
executed after a runtime error. If you use the "On Error Resume Next" statement, output of 
system events is also suppressed.

Use in the function list
NotifyUserAction (Confirmation type, Mandatory commenting, Category, Object name, 
Description)
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Use in user-defined functions
NotifyUserAction (Confirmation_type, Mandatory_commenting, Category, Object_name, 
Description)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Confirmation type
Establishes how the action must be confirmed

0 = (None): No confirmation required, an entry is created in the audit trail

1 = (Acknowledgement): Acknowledgment, the user must acknowledge the action; an entry is 
created in the audit trail

2 = (Digital Signature): Electronic signature, a dialog window opens in which the user must 
enter his electronic signature - an entry is created in the audit trail

Mandatory commenting
Establishes if the user has to enter a comment. The comment is logged in the audit trail.

0 = (True): True; a dialog window opens in which the user must enter a comment

1 = (False): False; no mandatory commenting

Category
Category or class name of the modified object

Object name
Name of the modified object

Description
Text which describes the archiving user action.

OpenAllLogs

Description
Reestablishes the connection between WinCC and the logs. Logging can be continued.       

 

 Note

Run the "StartLogging" system function in order to restart logging.
 

Use in the function list
OpenAllLogs
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Use in user-defined functions
OpenAllLogs

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. You open all logs with the "Open Archive" button. 
Logging will be continued in the specified log. 

OpenCommandPrompt

Description
Opens a Windows system prompt.       

This function is used, e.g., to copy files or to call up another application.

Use in the function list
OpenCommandPrompt

Use in user-defined functions
OpenCommandPrompt

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter
--

OpenControlPanel

Description
Opens a dialog that you can use to edit selected Control Panel settings.       

This system function lets you set the following on the HMI device:

● Properties and value of the IP address

● User identification on the network

● WinCC Internet settings
 

 Note
Project security

The "OpenControlPanelDialog" system function is used to bypass the SecureMode on the 
HMI device. Take the corresponding precautions to ensure the security of your project.  

 

Use in the function list
OpenControlPanelDialog (Dialog)

Use in user-defined functions
-

Parameters

Dialog
Sets the Control Panel dialog to be opened.

● PROFINET_X1: Setting of the IP address and Ethernet parameters

● PROFINET_X3: Setting of the IP address and Ethernet parameters; only for Comfort Panel 
KP 1500, TP 1500; TP1900, TP2200

● WinCC Internet settings: Setting for Web Server, e-mail notification, provided the HMI 
device supports these functions

● Network ID: Setting for identification on the network, provided the HMI device supports 
these functions
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OpenInternetExplorer

Description
Opens the Internet Explorer on the HMI device.       

If the Internet Explorer is already open, it will be closed and reopened when you call the system 
function.

 

 Note

The Internet Explorer saves data temporarily in the DRAM file system of the HMI device, e.g. 
the last web sites that were be called up.

This data can be saved using the "BackupRAMFileSystem" system function so that it is still 
available when the HMI device is restarted.

 

Use in the function list
OpenInternetExplorer (Start page)

Use in user-defined functions
OpenInternetExplorer (Start_page)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Start page
The page which is loaded when Internet Explorer is started, e.g. "www.siemens.com".

OpenScreenKeyboard

Description
Hides or shows the screen keyboard.       

The screen keyboard remains open until the screen keyboard is explicitly closed. In this way, 
the screen keyboard can also be used in other applications.

Use in the function list
OpenScreenKeyboard (Layout)
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Use in user-defined functions
OpenScreenKeyboard (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Specifies whether the window is opened minimized or maximized with the screen keyboard:

0 (hmiScreenKeyboardMinimized) = Minimized

1 (hmiScreenKeyboardMaximized) = Maximized

OpenTaskManager

Description
Shows the task manager.       

The task manager allows changing to other open applications on the HMI device.
 

 Note

The appearance of the task manager depends on the operating system installed.
 

Use in the function list
OpenTaskManager

Use in user-defined functions
OpenTaskManager

Can be used if the configured device supports user-defined scripts. For additional information, 
refer to "Device dependency".

Parameter
--

PageDown

Description
Executes the key function <Pagedown> on the HMI device. 
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This system function can only be used for function keys.       

Use in the function list
PageDown

Use in user-defined functions
PageDown

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-

PageUp

Description
Executes the key function <PageUp> on the HMI device. 

This system function can only be used for function keys and tasks with a time trigger.       

Use in the function list
PageUp

Use in user-defined functions
PageUp

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
-
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PrintReport

Description
Prints the given report from the printer which is connected to the HMI device. The report is 
printed in the language which is set on the HMI device.       

 

 Note

If runtime is closed whilst log data are being printed using the system function, the report will 
cease to be supplied with data as soon as runtime stops.

 

Use in the function list
PrintReport (Report)

Use in user-defined functions
PrintReport (Report)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Report
Name of the report to be printed.

 

 Note

If you have set up via the "Function list" dialog box a new report for the "PrintReport" function, 
when compiling, the following warning appears: "The report "Report_1" has no printed pages."

In order to remedy the warning, open the "Report_1" via the project view and recompile the 
project.

 

PrintScreen

Description
Prints the screen currently being displayed on the HMI device from the printer which is 
connected to the HMI device.       
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Opened windows are also printed.
 

 Note

The printer settings are taken over from the current settings in the Windows operation system.
 

Use in the function list
PrintScreen

Use in user-defined functions
PrintScreen

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter
--

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).
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Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).
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Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

SafelyRemoveHardware

Description
Checks whether there is read or write access to the external storage medium. If there is no 
access, the external storage medium can be removed without data loss.       

Use in the function list
SafelyRemoveHardware(Path, Result)

Use in user-defined functions
SafelyRemoveHardware(Path, Result)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Path
Path of storage medium , e.g. \Storage Card USB\
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Result
The tag in which the result is entered.

TRUE : The storage medium can be removed safely. A corresponding system message will 
be issued.

FALSE : The storage medium can be removed safely. A corresponding system message will 
be issued. 

SaveDataRecord

Description
Saves the current values of the recipe tags as data record to the memory medium of the HMI 
device.       

This system function is used, for example, to save a recipe data record in the recipe screen.

Use in the function list
SaveDataRecord (Recipe number/name, Data record number/name, Overwrite, Output status 
message, Processing status)

Use in user-defined functions
SaveDataRecord (Recipe_number/name, Data_record_number/name, Overwrite, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Recipe number/name
Number or name of the recipe to which a recipe data record is saved.

Data record number/name
Number or name of the recipe data record to be saved. A new data record will be created if 
no record of this name or number was found in the recipe, independent of the value at the 
"Overwrite" parameter.

Overwrite
Specifies whether an existing data record is overwritten:

0 (hmiOverwriteForbidden) = No: The recipe data record is not overwritten, the data record is 
not saved.

1 (hmiOverwriteAlways) = Yes: The recipe data record is overwritten without a prompt for 
confirmation.
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2 (hmiOverwriteWithPrompting) = With confirmation: The recipe data record is overwritten only 
with confirmation by the user.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SendEMail

Description
Sends an e-mail from the HMI device to the given addressee.       

This system function is used, for example, when, in the case of service, the alarm is to be 
passed on directly to the service technician.

 

 Note

To send alarms as e-mails, the HMI system must have an e-mail client at its disposal.
 

Use in the function list
SendEMail (Address, Subject, Text, Return address)

Use in user-defined functions
SendEMail (Address, Subject, Text, Return_address)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Address
The e-mail address of the addressee.
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Subject
The subject line of the e-mail.

Text
The text sent in the e-mail.

Return address
The e-mail address to which the addressee of this e-mail should send the reply.

SetAcousticSignal

Description
Configures the acoustic feedback of touch screen operation on the HMI device.       

 

 Note

The configuration that was set at Switch off is reestablished when restarting the HMI device.
 

Use in the function list
SetAcousticSignal (Volume)

Use in user-defined functions
SetAcousticSignal (Volume)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Volume
Determines whether and how loud an acoustic signal is emitted:

-1 (hmiToggle) = Toggle: Toggles the emission of the acoustic signal as follows: Muted > Quiet 
> Loud.

0 (hmiMuted) = Mute: no acoustic signal

1 (hmiQuiet) = Quiet: quiet acoustic signal

2 (hmiLoud) = Loud: loud acoustic signal
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SetAlarmReportMode

Description
Switches the automatic reporting of alarms on the printer on or off.       

Use in the function list
SetAlarmReportMode (Mode)

Use in user-defined functions
SetAlarmReportMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether alarms are reported automatically on the printer:

0 (hmiDisablePrinting) = Reporting off: Alarms are not printed automatically.

1 (hmiEnablePrinting) = Reporting On: Alarms are printed automatically.

-1 (hmiToggle) = Toggle: Toggles between the two modes.

SetAndGetBrightness

Description
Determines the brightness of the MP 377 Touch daylight readable display. The brightness 
value can be interpreted as absolute or relative to the current value.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetAndGetBrightness (Brightness, Mode, Current value)

Use in user-defined functions
SetAndGetBrightness (Brightness, Mode, Actual brightness)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Brightness
New value for the brightness.

Mode
Specifies if the new brightness value is set as absolute or relative to the current value.

Current value
Tag in which the current brightness value is stored.

SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
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//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).
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When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.

 

Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

SetBrightness

Description
Determines the brightness of the display.       

 

 Note

The configuration that is set in the Control Panel will be reestablished when you restart the 
HMI device.

 

Use in the function list
SetBrightness (value)
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Use in user-defined functions
SetBrightness (Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Value
New value for the brightness. 

SetConnectionMode

Description
Connects or disconnects the given connection.       

 

 Note

A connection to the PLC cannot be established until the operating mode ONLINE has been 
set on the HMI device. Use the "SetDeviceMode" system function for this purpose.

 

Use in the function list
SetConnectionMode (Mode, Connection)

Use in user-defined functions
SetConnectionMode (Mode, Connection)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether a connection to the PLC is established or disconnected:

0 (hmiOnline) = Online: Connection is established.

1 (hmiOffline) = Offline: Connection is disconnected.

Connection
The PLC to which the HMI device is connected. You specify the name of the PLC in the 
connection editor.
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Multiple use of the system function in a user-defined function
If you use the "SetConnectionMode" system function for different connections, it may be 
possible that not all system functions are executed correctly. Proceed as follows to prevent 
this situation:

1. Create a "BOOL" type tag with the start value "0".

2. Configure the "SetConnectionMode" system function on the "Value change" event of the 
HMI tags. If you want to disconnect three connections, for example, you must configure the 
system function three times.

3. In the user-defined function, apply the "InvertBit" system function to the HMI tag.

Application example
Two typical application examples for this system function are as follows:

● Test
As long as no PLC is connected to the HMI device, no error messages will be output during 
the test on the HMI device. If the HMI device is connected to a PLC, the connection to the 
PLC can be established by pressing a key.

● Commissioning
Several PLCs are to be configured for a system. At first, all PLCs except one are configured 
"Offline". After commissioning of the first PLC, the connection to each of the other PLCs is 
established by pressing a key. In this way, the other PLCs are started up one after another.

SetDataRecordTagsToPLC

Description
Transfers the values of the recipe tags to the PLC. The recipe tags contain the values of the 
data record which is displayed on the HMI device.       

Use in the function list
SetDataRecordTagsToPLC (Recipe number/name, Processing status)

Use in user-defined functions
SetDataRecordTagsToPLC (Recipe_ number/name, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC. 
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SetDataRecordToPLC

Description
Transfers the given recipe data record directly from the data medium of the HMI device to the 
PLC with which the HMI device is connected.       

 

 Note

The values of the recipe data record don't need to be displayed on the HMI device.
 

Use in the function list
SetDataRecordToPLC (Recipe number/name, Data record number/name, Output status 
message, Processing status)

Use in user-defined functions
SetDataRecordToPLC (Recipe_number/name, Data_record_number/name, 
Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe from which recipe data record is transferred to the PLC.

Data record number/name
Number or name of the recipe data record to be transferred to the PLC. 

Output status message
Determines whether a status message is output after the transfer:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.
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Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

SetDaylightSavingTime

Description
The system function "SetDaylightSavingTime" changes the setting of the HMI device from 
daylight saving to standard time and vice versa.

Time settings will take place immediately following system function.     
 

 Note

The "SetDaylightSavingTime" system function does not support time zones without daylight 
saving time. 

 

 Note
Windows 7

The system function "SetDaylightSavingTime" is not supported for PC-based HMI devices 
under Windows 7.

 

Use in the function list
SetDaylightSavingTime(DaylightSavingTime)

Use in user-defined functions
SetDaylightSavingTime (Daylight_saving_time)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Daylight Saving Time
Determines whether Daylight Saving Time is set on the HMI device:

0 = Daylight Saving Time is not activated

1 = Daylight Saving Time is activated
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SetDeviceMode

Description
Toggles the operating mode on the HMI device. The following types of operation are possible: 
"Online", "Offline" and "Load".       

Use in the function list
SetDeviceMode (Operating mode)

Use in user-defined functions
SetDeviceMode (Operating_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Operating mode
Determines the operating mode of the HMI device:

0 (hmiOnline) = Online: The connection to the PLC is established. The configured connection 
status is always set in this process. The states that were last used in Runtime are not 
considered.

1 (hmiOffline) = Offline: The connection to the PLC is disconnected.

2 (hmiTransfer) = load: A project can be transferred from the configuration computer to the 
HMI device.

 

 Note

If you use a PC as an HMI device, the runtime software will be exited when you change 
operating mode after "Load".

 

SetDisplayMode

Description
Changes the settings of the screen in which the runtime software runs.       

The runtime software runs in full-screen mode as default. The Windows task switch is disabled.

Use in the function list
SetDisplayMode (Layout)
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Use in user-defined functions
SetDisplayMode (Display mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines the settings for the screen in which the runtime software runs.

1 (hmiScreenFull): Full-screen: Title bar of the screen is not visible

2 (hmiScreenMaximized): Maximized

3 (hmiScreenRestore): Restore: The last used screen setting is used. This layout can only be 
used when the window is displayed minimized or maximized.

4 (hmiScreenMinimized): Minimized

5 (hmiScreenAutoAdjust): Automatic: The size of the window is set so that all screen objects 
in it will be visible.

6 (hmiScreenOnTop): Foreground; either the window appears in the foreground or the program 
icon associated with the window flashes on the taskbar depending on the Windows setting. 
The setting can be changed in the Windows configuration and applies to all Windows 
applications.

SetLanguage

Description
Toggles the language on the HMI device. All configured text and system events are displayed 
on the HMI device in the newly set language.       

Use in the function list
SetLanguage (Language)

Use in user-defined functions
SetLanguage (Language)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Language
Determines which language is set on the HMI device. The following specifications are possible:
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● -1 (hmiToggle) = Toggle: Changes to the next language. The sequence is determined 
during configuration in the "Project languages" editor.

● Number you have defined under "Languages and fonts" in the "Runtime Settings" editor. 
Changes to the language with the given number.

● Language you have defined under "Languages and fonts" in the "Runtime Settings" editor.

● Language abbreviation in accordance with the VBScript5 reference: This changes to the 
language corresponding to the specified language code, e.g. "de-DE" for German 
(Germany) or "en-US" for English (United States).
An overview of the language abbreviations is available in the basic information of VBScript 
under the topic "Area diagram-ID (LCID) Diagram".

SetPLCDateTime

Description
Changes the data and the time of the linked PLC  

The system function "SetPLCDateTime" can only be configured for the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Use in the function list
SetPLCDateTime (connection, time)

Use in user-defined functions
SetPLCDateTime (Connection, Time)

Parameters

Connection
Connection of PLC and HMI device.

Time
Transfers the date and the time of the HMI device to the PLC. The PLC applies the date and 
the time of the HMI device.

SetRecipeTags

Description
Changes the status of the recipe tags from "Online" to "Offline" and vice versa.       
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This system function is used, for example, when recipe data record values are fine tuned when 
starting up a machine.

Use in the function list
SetRecipeTags (Recipe number/name, Status, Output status message, Processing status)

Use in user-defined functions
SetRecipeTags (Recipe_number/name, Status, Output_status_message, Processing_status)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Recipe number/name
Number or name of the recipe in which the recipe data record is saved.

Status
Determines the status of the recipe tags:

0 (hmiOnline) = Online: Value changes of the recipe tags are transferred immediately to the 
PLC connected to the HMI device.

1 (hmiOffline) = Offline: Value changes to the recipe tags are only transferred to the PLC 
connected to the HMI device when, for example, the "SetDataRecordTagsToPLC" system 
function is executed.

Output status message
Determines whether a status message is output after saving:

0 (hmiOff) = Off: Status message is not output.

1 (hmiOn) = On: Status message is output.

Processing status
Returns the processing status of the system function. You can use the return value, for 
example, to delay execution of other system functions until this system function has been 
successfully completed:

2 = System function is being performed.

4 = System function was successfully completed.

12 = System function was not performed because an error has occurred.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4868 System Manual, 02/2014



SetScreenKeyboardMode

Description
Enables or disables the automatic display of the screen keyboard on the HMI device.       

This system function is also used to prevent the display of the screen keyboard, e.g. because 
an external keyboard is connected to the HMI device.

 

 Note

To enable the "SetScreenKeyboardMode" ("SetScreenKeyboardMode") system function on 
an HMI other than a Touch Panel device, set the "Use on-screen keyboard" check box in the 
"Runtime settings" dialog of the device settings.

 

Use in the function list
SetScreenKeyboardMode (Mode)

Use in user-defined functions
SetScreenKeyboardMode (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Mode
Determines whether the screen keyboard is hidden or shown:

0 (hmiOff) = Off: Screen keyboard is hidden

1 (hmiOn) = On: Screen keyboard is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes.

SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.
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Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
 

Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}
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The saved return value can be processed in the following code.

ShiftAndMask

Description
This system function converts the input bit pattern of the source tags into an output bit pattern 
of the target tags. This involves bit shifting and masking.

 

 Note

If the source and target tag have a different number of bits, using the system function in the 
target tag can result in a violation of the value range.

 

Use in the function list
ShiftAndMask (Source tag, Target tag, Bits to shift, Bits to mask)

Use in user-defined functions
ShiftAndMask (Source_tag, Target_tag, Bits_to_shift, Bits_to_mask)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Source tag
The tag includes the input bit pattern. Integer-type tags, e.g. "Byte", "Char", "Int", "UInt", "Long" 
and "ULong" are permitted. 

Example: The actual value 72 is set at the 16-bit integer source tag: 0000000001001000.

Target tag
The output bit pattern is saved in the tag. Integer type tags, e.g. "Byte", "Char", "Int", "UInt", 
"Long" and "ULong" are permitted.

Example: The shifted input bit pattern is multiplied by the bit mask, with bit-by-bit logical AND 
operation: 0000000000001001. The resultant decimal value "8" is saved to the target tag.

Please note the following:

● The source and target tags have the same number of bits.

● The number of bits to shift is less than the number of bits in the source tag and target tag.

● Bits to mask does not have more bits than the source tag and the target tag.
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Bits to shift
Number of bits by which the input bit pattern is shifted right. A negative value shifts the input 
bit pattern to the left.

Example: "Bits to shift" has the value "+3". The input bit pattern is shifted right by three bits 
when the system function is called: 0000000000001001.
Bits to the left are padded with "0". Three bits are truncated on the right. The new decimal 
value is "9".

 

 Note

The left bit is "1" in a source tag of the data type with negative signed integer. This sign bit 
is padded with "0" when the bits are shifted right. The sign changes to "+".

 

Bits to mask
An integer serves as bit mask. The bit pattern is used to multiply the shifted input bit pattern. 
Example: Integer "2478" with the bit pattern "0000100110101110".

You can enter the bit mask in three different ways:

● Hexadecimal: First enter the prefix "0h" or "0H", followed by an optional space for better 
readability. Then group the bit pattern in blocks of four (0000)(1001)(1010)(1110) and set 
each block in hexadecimal code: (0)(9)(A)(E). Only the characters 0-9, A-F, a-f are allowed: 
"0h 09AE".

● Binary: First enter the prefix "0b" or "0B", followed by an optional space for better readability. 
Then group the binary bit pattern into blocks of four 0000 1001 1010 1110 with spaces in 
between as a check. Only the characters "0" or "1" are allowed: "0b 0000 1001 1010 1110".

● Decimal: Enter the value "2478" directly, without a prefix.

ShowAlarmWindow

Description
Hides or shows the alarm window on the HMI device.       

Use in the function list
ShowAlarmWindow (Object name, Layout)

Use in user-defined functions
ShowAlarmWindow (Object_name, Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameter

Object name
Name of the alarm view which is hidden or shown.

Layout
Determines whether the alarm window is hidden or shown:

0 (hmiOff) = Off: Alarm view is hidden

1 (hmiOn) = On: Alarm view is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowOperatorNotes

Application
Displays the tooltip configured for the selected object.     

If the system function is configured on a function key, the tooltip for the screen object that 
currently has the focus is displayed. If a tooltip is configured for the screen itself, you can switch 
to this text by pressing <Enter> or by double-clicking on the help window.

If the system function is configured on a button, only the tooltip for the current screen is 
displayed. If a tooltip is configured on the button itself, initially only the tooltip for the button is 
displayed. You can press <Enter> or double-click on the help window to switch to the tooltip 
for the current screen.

 

 Note

No other screen object can be used while the help window is open. To use the screen object, 
close the help window.

 

Closing the help window
You can close the help window in the following ways:

Using the keys:

● By pressing the <HELP> key again

● By pressing the <ESC> key

Using the touch screen:

● By pressing the  button

Use in the function list
ShowOperatorNotes (Layout)
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Use in user-defined functions
ShowOperatorNotes (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Display mode
Determines whether the configured tooltip is hidden or shown:

0 (hmiOff) = Off: Configured tooltip is hidden

1 (hmiOn) = On: Configured tooltip is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes

ShowSoftwareVersion

Description
Hides or shows the version number of the runtime software.       

Use this system function if during servicing, for example, you required the version of the runtime 
software used.

Use in the function list
ShowSoftwareVersion (Layout)

Use in user-defined functions
ShowSoftwareVersion (Display_mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Layout
Determines whether the version number is shown:

0 (hmiOff) = Off: Version number is not shown

1 (hmiOn) = On: Version number is shown

-1 (hmiToggle) = Toggle: Toggles between the two modes
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ShowSystemAlarm

Description
Displays the value of the parameter passed as a system event to the HMI device.       

Use in the function list
ShowSystemAlarm (Text/value)

Use in user-defined functions
ShowSystemAlarm (Text/value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Text/Value
The text or the value, which was output as a system alarm.

ShowSystemDiagnosticsWindow

Description
Hides or shows the system diagnostic window on the HMI device. The system diagnostic view 
is only available in the global screen for Comfort Panels and for WinCC Runtime Advanced.       

Use in the function list
ShowSystemDiagnosticsWindow (Screen object)

Use in user-defined functions
ShowSystemDiagnosticsWindow (Target_Object_name)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen object
Name of the system diagnostic window which is hidden or shown.
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StartLogging

Description
Starts the logging of data or alarms in the specified log. The function can also be applied to 
audit trails.       

You can interrupt logging at runtime using the "StopLogging" system function.

Use in the function list
StartLogging (Log type, Log)

Use in user-defined functions
StartLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log which is started.

StartNextLog

Description
Stops the logging of data or alarms for the given log.

Logging is continued in the next log of the segmented circular log you configured for the 
specified log.

If you did not configure a segmented circular log for the specified log, the system function has 
no effect.       

Use in the function list
StartNextLog (Log type, Log)
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Use in user-defined functions
StartNextLog (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

Log
Name of the log for which the logging is stopped and continued in the next log.

StartProgram

Description
Starts the specified program on the HMI device.       

The runtime software continues running in the background. Alarms continue to be output and 
data continues to be updated.

When the given application is exited, the screen which was active during the performance of 
the system function is displayed on the HMI device.

This system function is used, for example, to edit recipe data records in MS Excel on the HMI 
device.

 

 Note

If Windows CE is installed on the HMI device, during the configuration it must be checked 
whether the desired application can be started with this system function.

This system function allows all applications to be started which can be started in the "Execute" 
dialog of Windows CE.

The application to be started must be installed on the HMI device.
 

Use in the function list
StartProgram (Program name, Program parameters, Layout, Wait for program to end)

Use in user-defined functions
StartProgram (Program_name, Program_parameters, Display_mode, 
Wait_for_program_to_end)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Program name
Name and path of the program which is started. Upper and lower case are taken into account 
in this parameter.

 

 Note

If the path contains spaces, the program can only be started correctly if the path is specified 
in inverted commas, e.g. "C:\Program Files\START\start.exe".

 

Program parameters
The parameters you transfer at the start of the program, for example a file that is opened after 
the start of the program. 

The description of the necessary parameters is found in the documentation of the program to 
be started.

Layout
Determines how the program window is displayed on the HMI device:

0 (hmiShowNormal) = Normal

1 (hmiShowMinimized) = Minimized

2 (hmiShowMaximized) = Maximized

3 (ShowMinimizedAndInactive) = Minimized and inactive

Wait for program to end
Determines whether there is a change back to the project after the called up program has 
ended:

0 (hmiNo) = No: No change to project

1 (hmiYes) = Yes: Change to project
 

 Note

The "Wait for program to end" parameter is only available for Runtime Advanced and Panels.
 

StopLogging

Description
Stops the logging of process values or alarms in the specified log. The function can also be 
applied to audit trails.       
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The "StartLogging" system function is used to resume logging at runtime.
 

 Note

When logging is stopped, a connection between WinCC and the log files or log database still 
exists. Use the "CloseAllLogs" system function to disconnect this connection.

 

Use in the function list
StopLogging (Log type, Log)

Use in user-defined functions
StopLogging (Log_type, Log)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

Log type
Determines the type of log:

0 (hmiTagArchive) = Data log

1 (hmiAlarmArchive) = Alarm log

2 (hmiAudittrailArchive) = Audit trail

Log
Name of the log that is stopped.

Application example
You are in runtime and want to change the data medium on which the process values are 
logged.

Notes on configuring

Configure the "StopLogging" and "CloseAllLogs" system functions on the "Close Archive" 
button.

Configure the "OpenAllLogs" and "StartLogging" system functions on the "Open Archive" 
button.

As parameter transfer the respective name of the log that is to be stopped and started.

Procedure on HMI device

When the button "Close Archive" is pressed, the specified log is stopped and all open logs are 
closed. The data medium can be changed. The "Open Archive" button opens all logs and 
continues logging in the specified log.
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StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)

Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

WinACMPGetVersion

Description
Reads out the value of the version number of WinAC MP.       
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Use in the function list
WinACMPGetVersion (Version, Action)

Use in user-defined functions
WinACMPGetVersion (Version, Action)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Version
The tag that contains the value.

Action
Determines whether the version number is read out: 

0 (SwitchOff) = Off: Version number is not read out.

1 (SwitchOn) = On: Version number is read out.

WinACMPSetStartAtBoot

Description
Determines whether or not WinAC MP is started automatically after startup of the HMI 
device.       

Use in the function list
WinACMPSetStart at boot(Start at boot)

Use in user-defined functions
WinACMPSetStartAtBoot (Start at boot)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

StartAtBoot
Defines whether WinAC MP is started automatically. 

0 (StartAtBootOff) = Off: WinAC MP is not started on startup of the HMI device.

1 (StartAtBootOn) = On: WinAC MP is started automatically on startup of the HMI device.
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WinACSetStartMode 

Description
Sets the operating mode of WinAC MP after startup of the HMI device.       

Use in the function list
WinACSetStartMode (Autostart)

Use in user-defined functions
WinACSetStartMode (Autostart)

Can be used if the configured device supports user-defined functions. For more information, 
refer to Auto-Hotspot.

Parameters

Action
Defines whether the Autostart function of WinAC MP is activated. 

0 (AutoStartOff) = Off: After startup, WinAC MP remains in the STOP operating mode.

1 (AutoStartOn) = On: After startup, WinAC MP changes to the operating mode it was in before 
it was closed.

System functions

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 

Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:

● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.

 
 
{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}

See also
System functions for Runtime Professional (Page 4564)

ActivateScreenInScreenWindow

Description
Performs a screen change to the specified screen in a specified screen window.       
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Use in the function list
ActivateScreenInScreenWindow (Screen name, Screen window, New screen name)

Use in user-defined functions
ActivateScreenInScreenWindow (Screen_name, Screen_window, New_screen_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Screen name
Name of the screen to be displayed in the screen window. 

Screen window
Name of the screen window in which the new screen is to be displayed.

New screen name
Name of the new screen to be displayed in the screen window. 

Example
The ActivateScreenInScreenWindow function is used in the following program code to activate 
the "Screen_2" screen when you click a button.

 
{
// User defined code 
// i.e. when pressing a button 
ActivateScreenInScreenWindow (GetParentScreen(screenName), 
GetParentScreenWindow(screenName), "Screen_2");
...
}

See also
System functions for Runtime Professional (Page 4564)

DecreaseTag

Description
Subtracts the given value from the tag value.       
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X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.

 

If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

Example
The following program code decrements the value at the varX tag by the value at the value 
tag. The value entered is saved to the old_value tag and output along with the new varX value.

 
{
BYTE varX;
BYTE value;
 
//user input
...
BYTE old_value = varX;
 
//Decrease tag
DecreaseTag(varX, value);
 
//print original value and function result   
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printf ("User input: %i\r\n, Result of function DecreaseTag: %i\r\n", old_value, varX);
...
}

See also
System functions for Runtime Professional (Page 4564)

ExportImportUserAdministration

Description
Exports all users of the user administration of the currently active project to the given file or 
imports the users from the given file into the currently active project.       

Users, their passwords and rights are saved in the user administration.

All users are overwritten when importing. The imported users are valid immediately.

Use in the function list
ExportImportUserAdministration (File name, Direction)

Use in user-defined functions
ExportImportUserAdministration (File_name, Direction)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameter

File name
Name of the file which contains the passwords or to which the passwords are written. Enter 
the file location and the file extension (*.txt), for example, "C:\TEMP\Passwords.txt".

 

 Note

If a storage card is used as file location, specify the file location as follows: "\StorageCard
\<File name>".

 

Direction
Specifies whether passwords are exported or imported:

0 (hmiExport) = Export: Passwords are exported.

1 (hmiImport) = Import: Passwords are imported.
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See also
System functions for Runtime Professional (Page 4564)

IncreaseTag

Description
Adds the given value to the value of the tags.       

X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.

 

If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag
The tag to which the given value is added.

Value
The value that is added.

Example
The following program code increments the value of the varX tag by the value in the value tag. 
The value entered is saved to the old_value tag and output along with the new varX value.

 
{

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4887



 
BYTE varX;
BYTE value;
 
//user input
...
BYTE old_value = varX;
 
//Increase tag
IncreaseTag(varX, value);
 
//print original value and function result   
printf ("User input: %i\r\n, Result of function IncreaseTag: %i\r\n", old_value, varX);
...
}

See also
System functions for Runtime Professional (Page 4564)

InverseLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       

The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag that contains the value used for calculation.

b
The value which is subtracted.

a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).
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Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.

Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).
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After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.

Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}
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See also
System functions for Runtime Professional (Page 4564)

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       

The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag that contains the value used for calculation.

b
The value that is added.
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Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
 
printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4893



Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
System functions for Runtime Professional (Page 4564)

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.

 

Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

Tag
The tag in which a bit is set to 0 (FALSE).

Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

SetBit 

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.
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Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.

 

Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}
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See also
System functions for Runtime Professional (Page 4564)

SetPropertyByConstant

Description
Specifies the value of an object property as a string.       

Use in the function list
SetPropertyByConstant (Screen name, Object, Name of the property, Value)

Use in user-defined functions
SetPropertyByConstant

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to change the property of a screen, the parameter "Object" must be empty. For this 
purpose, use the following syntax, for example:

SetPropertyByConstant ("<Screen name>","","<Property name>","<Value>")

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property is changed. 

Name of the property
Name of the property that will be changed. 

Value
The value assigned to the property. 

Example
The SetPropertyByConstant function is used in the following program code to change an object 
property: In the "Trends" screen, the "ToolbarButtonClick" property of the "Control_1" object 
is set to the value 26.

 
{
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//Name of the picture: Trends 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByConstant ("Trends", "Control_1", "ToolbarButtonClick", "26");
 
// User defined code 
...
}

Example: Changing a screen property
The SetPropertyByConstant function is used in the following program code to change a screen 
property: In the "Trends" screen, the "Backcolor" property is set to the value 255.

 
{
 
//Name of the picture: Trends 
 
SetPropertyByConstant ("Trends", "Trends", "Backcolor", "255");
 
// User defined code 
...
}

Alternatively, use the password ZERO or a space-string instead of the second parameter 
(object). 

See also
System functions for Runtime Professional (Page 4564)

SetPropertyByProperty

Description
Specifies the value of an object property with another object property.       

Use in the function list
SetPropertyByProperty (Screen name, Object, Name of the property, Destination screen 
name, Destination object, Destination property name)

Use in user-defined functions
SetPropertyByProperty (Screen_name, Screen_object, Property_name, 
Source_screen_name, Source_screen_object, Source_property_name)
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Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen with another screen property, the parameters 
"Object" and "Destination object" must be empty. For this purpose, use the following syntax, 
for example:

SetPropertyByProperty ("<Screen name>","","<Property name>","<Destination_Screen 
name>","","<Destination_Property name>")

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property is transferred to the destination object. 

Name of the property
Name of the property that will be transferred to the destination object. 

Destination screen name
Name of the screen that contains the destination object. 

Destination object
Name of the destination object to which the property is transferred. 

Destination property name
Name of the property that will be changed. 

Example
The following program code uses the SetPropertyByProperty function to set the property 
"ToolbarButtonClick" of the object "Control_1" in the original screen Trend_1": on the 
corresponding property in the destination screen "Trend_2".

 
{
 
//Name of source picture: Trend_1 
//Name of target picture: Trend_2 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByProperty ("Trend_1", "Control_1", "ToolbarButtonClick", "Trend_2", 
"Control_2", "ToolbarButtonClick");
 
// User defined code 
...
}
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See also
System functions for Runtime Professional (Page 4564)

SetPropertyByTag

Description
Specifies the value of an object property with a tag value.       

Use in the function list
SetPropertyByTag (Screen name, Object, Name of the property, Tag name)

Use in user-defined functions
SetPropertyByTag (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen by means of a tag value, the "Object" parameter 
must be empty. For this purpose, use the following syntax, for example:

SetPropertyByTag ("<Screen name>","","<Property name>","<Tag name>")

 

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object containing the property to be set with the tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that contains the value of the property. 
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Example
The SetPropertyByTag function is used in the following program code to change an object 
property: A click on the object transfers the object name and the screen containing the object. 
The CaptionText in the screen window contains the value of the HMI_value_1 tag.

 
{
 
SetPropertyByTag (screenName, objectName, "CaptionText", "HMI_value_1");
 
// User defined code 
...
}

Example
The SetPropertyByTag function is used in the following program code to change an object 
property: In the "Trends" screen, the "ToolbarButtonClick" property of the "Control_1" object 
is set to the value 26.

 
{
 
//Name of the picture: Trends 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByConstant ("Trends", "Control_1", "ToolbarButtonClick", "26");
 
// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetPropertyByTagIndirect

Description
Specifies the value of an object property with a tag. The tag contains the tag name that specifies 
the object property.       

Use in the function list
SetPropertyByTagIndirect (Screen name, Object, Name of the property, Tag name)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4902 System Manual, 02/2014



Use in user-defined functions
SetPropertyByTagIndirect (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen by means of a tag, the "Object" parameter must 
be empty. For this purpose, use the following syntax, for example:

SetPropertyByTagIndirect ("<Screen name>","","<Property name>","<Tag name>")

 

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object containing the property to be set with the tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that, in turn, contains the name of the tag that specifies the object property. 

Example
The SetPropertyByTagIndirect function is used in the following program code to change an 
object property: .

 
{
 
SetPropertyByTagIndirect (GetParentScreen(screenName), GetParentScreenWindow(screenName), 
"ScreenName", "HMI_value_1");
 
// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)
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SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
 

Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling
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if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

SetTagByProperty

Description
Specifies a tag value with the value of an object property. The change is also logged in the 
alarm system.       

Use in the function list
SetTagByProperty (Tag name, Screen name, Object, Name of the property, With or without 
operator event)

Use in user-defined functions
SetTagByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the tag whose value is specified by the object property.

Screen name
Name of the screen that contains the object. 
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Object
Name of the object whose property supplies the tag value.

Name of the property
Name of the property that supplies the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
The following program code returns the value of the selected text when you click in a combo 
box.

 
{
char* rt_value;
 
SetTagByProperty (rt_value, screenName, objectName, "SelectedText", 
hmiWithoutOperatorEvent);
 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagByTagIndirect

Description
Sets the tag value to the value of an indirect tag. The change is also logged in the alarm 
system.       

Use in the function list
SetTagByTagIndirect (Tag name, Tag name, With or without operator event)

Use in user-defined functions
SetTagByTagIndirect (Tag_name, Source_tag_name, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Tag name
Name of the tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that returns the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event 

1 (hmiWithOperatorEvent) = With operator event

Example
The following program code returns the value of the "@LocalMachineName" tag when you 
click the corresponding button.

 
{
char* rt_value;
 
SetTagByTagIndirect (rt_value, "@LocalMachineName", hmiWithoutOperatorEvent);
 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirect

Description
Specifies the indirect name for a tag.       

Use in the function list
SetTagIndirect (Tag name (output), LpValue)

Use in user-defined functions
SetTagIndirect (Tag_name, Value, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 

Example
The following program code transfers the value from the "value" tag to the "result" tag when 
you click the corresponding button.

 
{
BYTE result;
BYTE value;
 
SetTagIndirect ("result", "value", hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectByProperty

Description
Specifies a tag name with the value of an object property. The change is also logged in the 
alarm system.       

Use in the function list
SetTagIndirectByProperty (Tag name, Screen name, Screen object, Name of the property, 
With or without operator event)

Use in user-defined functions
SetTagIndirectByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Tag name
Name of the tag whose tag name is specified by the object property.

Screen name
Name of the screen that contains the object. 

Screen object
Name of the object whose property returns the tag name.

Name of the property
Name of the property that returns the tag name. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
When you click the objectName button, the following program code sets the value of the 
"rt_value_property" tag to the value of the "FlashingEnabled" property.

 
{
Int rt_value_property;
SetTagIndirectByProperty ("rt_value_property", screenName, objectName, "FlashingEnabled", 
hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectByTagIndirect

Description
Sets the tag value to the value of an indirect tag. The change is also logged in the alarm 
system.       

Use in the function list
SetTagIndirectByTagIndirect (Tag name, Tag name, With or without operator event)
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Use in user-defined functions
SetTagIndirectByTagIndirect (Tag_name, Source_tag_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the indirect tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that returns the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
When you click the objectName button, the following program code sets the "rt_value" tag to 
the value of the "value" tag.

 
{
Int rt_value;
Int value;
 
SetTagIndirectByTagIndirect ("rt_value", "value", hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectWithOperatorInputAlarm

Description
Specifies the indirect name for a tag. The change is also logged in the alarm system.       

Use in the function list
SetTagIndirectWithOperatorInputAlarm (Tag name (output), LpValue)
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Use in user-defined functions
SetTagIndirectWithOperatorEvent

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 

See also
System functions for Runtime Professional (Page 4564)

SetTagWithOperatorEvent

Description
Specifies the value for a tag. The change is also logged in the alarm system.       

Use in the function list
SetTagWithOperatorInputAlarm (Tag name (output), LpValue)

Use in user-defined functions
SetTagWithOperatorEvent (Tag_name, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag whose value is to be set. 

LpValue
Value written to the tag. 
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Example
The following program code transfers the value from the "value" tag to the "result" tag when 
you click the corresponding button.

 
{
BYTE result;
BYTE value;
 
SetTagWithOperatorEvent ("result", "value");
...
}

See also
System functions for Runtime Professional (Page 4564)

ShowLogonDialog

Description
Opens a dialog on the HMI device with which the user can log on to the HMI device.    

Use in the function list
ShowLogonDialog

Use in user-defined functions
ShowLogonDialog

Can be used if the configured device supports user-defined functions. Additional information 
is available under "System functions for Runtime Professional (Page 4564)".

Parameters
--

See also
System functions for Runtime Professional (Page 4564)
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StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)

Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)
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VBScript for Windows

VBScript for Windows

VBScript
If you have worked with Visual Basic or Visual Basic for applications, then VBScript will seem 
familiar to you. If you do not know Visual Basic and are getting familiar with it, then you will 
learn all Visual Basic programming languages at once. The step-by-step guides from Microsoft 
Press are a good introduction to programming.

You will find fundamental information on VBScript language elements on the Microsoft 
homepage:

http://msdn.microsoft.com/en-us/library/t0aew7h6.aspx 

Local ID (LCID)
An overview of all language codes can be found on the Microsoft homepage:

http://msdn.microsoft.com/en-us/goglobal/bb964664

VBScript for Windows CE

VBScript for Windows CE

Attr

Function
This property of the File control returns a number indicating the file mode that was used to 
open the file.

Syntax
file.Attr

Parameters

File
Reference to a File control.
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Return values
The return values listed in the following table indicate the file access mode. If the return value 
is 0, the file is closed.

Constant Value
None 0
fsModeInput 1
fsModeOutput 2
fsModeRandom 4
fsModeAppend 8
fsModeBinary 32

Remarks
The Attr property is read-only. Use the Open method of the File control to set the file mode.

Close

Function
This method closes an open File control.

Syntax
file.Close

Parameters

File
Name of a File control.

Return Values
None.

Remarks
Use the Open method to open a file.
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CreateObject

Function
This function creates a reference to an Automation object.

Syntax
CreateObject (Object)

Parameters

Object
A string containing the ProgID of the object to create.

Return values
Returns a reference to an Automation object.

Remarks
Use CreateObject to create non-visible ActiveX controls at runtime. You cannot use 
CreateObject to create graphical objects such as a TreeView control or a ListView control. 
CreateObject produces objects that cannot respond to events. To produce objects that can 
respond to events, use the CreateObjectWithEvents function. The following table lists the 
ProgIDs for the ActiveX controls without events.

Control ProgID
Microsoft CE File control 6.0 .file
Microsoft CE FileSystem control 6.0 .filesystem
Microsoft CE ImageList control 6.0 CEimageList.imagelistctrl

Example

 
Dim f, fwModeAppend
Set f = CreateObject("FileCtl.File")
fwModeAppend=8
f.Open "\Storage Card\testfile.txt", fwModeAppend
f.Close
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Dir

Function
This method returns the name of a file, directory, or folder that matches a specified pattern or 
file attribute.

Syntax
File.Dir (Pathname,[Attributes])

Parameters

File
Reference to a FileSystem control.

Pathname
Optional. String expression that specifies a file name or path.

Attributes
Optional. Numeric expression whose sum specifies file attributes. If omitted, all files that match 
pathname are returned.

The following table describes the parameter settings of attributes.

Constant Value Description
fsAttrNormal 0 Normal
fsAttrReadOnly 1 Read only
fsAttrHidden 2 Hidden
fsAttrSystem 4 System file
fsAttrVolume 8 Volume label. If specified, all other attributes are ignored.
fsAttrDirectory 16 Directory or folder
fsAttrArchive 32 Logs

Return values
String. File name that matches pathname and attributes. Dir returns a zero-length string ("") if 
pathname is not found.

Remarks
Dir supports the use of multiple-character (*) and single-character (?) wildcards to specify 
multiple files. You must specify pathname the first time you call the Dir method. In addition, if 
you specify file attributes you must include pathname.
The Dir method returns the first file name that matches pathname. To get any additional file 
names that match pathname, call Dir again with no parameters. When no more file names 
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match, Dir returns a zero-length string (" "). Once a zero-length string is returned, you must 
specify pathname in subsequent calls.

EOF

Function
This property returns True when the end of a file opened for random or sequential input is 
reached.

Syntax
File.EOF

Parameters

File
Reference to a File control.

Remarks
Use the EOF property to avoid the error generated by attempting to read past the end of a file.

The EOF property returns False until the end of the file has been reached. For files opened 
with a fsModeRandom or fsModeBinary file mode, EOF returns False until the last executed 
Get statement is unable to read an entire record.

For files opened with a fsModeBinary file mode, an attempt to read through the file using the 
Input function until EOF returns True generates an error. Use the LOF and LOC properties 
instead of EOF when reading binary files with Input, or use Get when using the EOF property. 
For files opened with a fsModeOutput file mode, EOF always returns True.

FileCopy

Function
This method copies an existing file to a new file.

Syntax
Filesystem.FileCopy PathName, NewPathName

Parameters

Filesystem
Reference to a FileSystem object.
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PathName
String that contains the path and file name.

NewPathName
String that contains the file name and path of the new file.

Return Values
None.

Remarks
FileCopy returns an error if the new file does not exist.

FileLen

Function
This method returns a value specifying the length, in bytes, of a file.

Syntax
Filesystem.FileLen(pathname)

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file. The pathname can include a directory or folder.

Return Values
Returns the number of bytes in a file.

Remarks
If the specified file is open when the FileLen method is called, the value returned represents 
the size of the file immediately before it was opened.
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FileDateTime

Function
This method returns a variant (Date) that indicates the date and time when a file was created 
or last modified.

Syntax
filesystem.FileDateTime(pathname)

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file name. The pathname can include a directory 
or folder.

Return Values
Returns the date the file was last modified.

Remarks
FileDateTime returns an error if the new file does not exist.

 

Get

Function
This method reads data from an open disk file into a variable.

Syntax
file.Get Data, [Recnumber]

Parameters

File
Reference to a File control.
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Data
Required. Variant variable into which data is read.

Recnumber
Optional. Variant. Record number at which reading begins. For files opened in binary mode, 
Recnumber specifies the byte position.

Return Values
None

Remarks
Data read with the Get method usually is written to a file with the Put method. The first record 
or byte in a file is at position 1, the second record or byte is at position 2, and so on. If you omit 
Recnumber, the next record or byte following the last Get or Put method (or pointed to by the 
last Seek function) is read.

For files opened in Random mode, the following rules apply:

● If the length of the data being read is less than the length specified in the Len clause of the 
Open method, Get reads subsequent records on record-length boundaries. The space 
between the end of one record and the beginning of the next record is padded with the 
existing contents of the file buffer. Because the amount of padding data cannot be 
determined with any certainty, it is generally advisable to match the record length with the 
length of the data being read.

● If Data is a Variant of numeric type, Get reads 2 bytes identifying the VarType of the Variant 
and then reads the data that goes into the variable. For example, when reading a Variant 
of VarType 3, Get reads 6 bytes: 2 bytes identifying the Variant as VarType 3 (Long) and 
4 bytes containing the Long data. The record length specified by the Len clause in the Open 
method must be at least 2 bytes greater than the actual number of bytes required to store 
the variable.

● You can use the Get method to read a Variant array from a disk, but you cannot use Get 
to read a scalar Variant containing an array. You also cannot use Get to read objects from 
a disk.

● If the variable being read into is a Variant of VarType 8 (String), Get reads 2 bytes identifying 
the VarType and 2 bytes indicating the length of the string. Then it reads the string data. 
The record length specified by the Len clause in the Open method must be at least 4 bytes 
greater than the actual length of the string.

● If the variable being read into is a dynamic array, Get reads a descriptor whose length 
equals 2 plus 8 times the number of dimensions, that is, 2 + 8 * NumberOfDimensions. The 
record length specified by the Len clause in the Open method must be greater than or equal 
to the sum of all the bytes required to read the array data and the array descriptor.

For files opened in Binary mode, the Len clause in the Open method has no effect. Get reads 
all variables from a disk contiguously; that is, with no padding between records.
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GetAttr

Function
This method returns a number representing the attributes of a file, directory, or folder.

Syntax
filesystem.GetAttr(pathname)

Parameters

File system
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file name or directory or a folder name. The 
pathname can include the directory or folder.

Return values
Sum of attribute values. The following table shows the sums that can be returned.

Constant Value Description
vbNormal 0 Normal
VbReadOnly 1 Read only
VbHidden 2 Hidden
VbSystem 4 System
VbDirectory 16 Directory or folder
VbArchive 32 File has changed since last backup

Remarks
To determine which attributes are set, use the And operator to perform a bitwise comparison 
of the value returned by the GetAttr method and the value of the individual file attribute you 
want. If the result is not zero, that attribute is set for the named file.

Input

Function
This method returns a string containing characters from a file opened in Input or Binary mode.
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Syntax
file.Input(number)

Parameters

File
Reference to a File control.

Number
Any valid numeric expression that specifies the number of characters to return.

Return Values
String containing characters read from file.

Remarks
Data read with the Input method usually is written to a file with the LinePrint or Put functions. 
Use this method only with files opened in Input or Binary mode.

Unlike the LineInputString method, the Input method returns all the characters it reads, 
including commas, carriage returns, line feeds, quotation marks, and leading spaces.

With files opened for Binary access, an attempt to read through the file using the Input method 
until the EOF function returns True generates an error. To avoid an error, use the LOF and 
Loc functions instead of EOF when reading binary files with the Input method or use Get when 
using the EOF function.

InputFields

Function
This method reads data from an open sequential file and returns a single dimension Variant 
array.

Syntax
file.InputFields(number)

Parameters

File
Reference to a File control.

Number
Number of comma-delimited fields to read from the file.
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Return values
Array containing the fields read from the file.

Remarks
Data read with the InputFields method usually is written to a file with WriteFields. Use this 
method only with files opened in Input or Binary mode.

InputFields reads standard string or numeric data without modification. The following table 
shows how InputFields reads other input data.

Data Value Assigned to Variable
Delimiting comma or blank line Empty
#ZERO# Zero
#TRUE# or #FALSE# True or False
#yyyy-mm-dd hh:mm:ss# The date and/or time represented by the expression

Double quotation marks ("") within input data are discarded.
If you reach the end of the file while you are inputting a data item, the input is terminated and 
an error occurs.

To correctly read data from a file into variables using InputFields, use the WriteFields method 
instead of the LinePrint method to write the data to the files. Using WriteFields ensures each 
separate data field is properly delimited.

InputB

Function
This method returns bytes from a file opened in Input or Binary mode.

Syntax
file.InputB(number)

Parameters

File
Reference to a File control.

Number
Any valid numeric expression that specifies the number of bytes to return.

Return Values
Array containing bytes read from file.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
4924 System Manual, 02/2014



Remarks
Data read with the InputB method usually is written to a file with the LinePrint or Put functions. 
Use this method only with files opened in Input or Binary mode.

 

Kill

Function
This method deletes files from a disk.

Syntax
filesystem.Kill pathname

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
Required. String expression that specifies one or more file names to be deleted. The pathname 
can include the directory or folder.

Return Values
None.

Remarks
The Kill method supports the use of multiple-character (*) and single-character (?) wildcards 
to specify multiple files.
An error occurs if you try to use Kill to delete an open file.

LineInputString

Function
This method reads a single line from an open sequential file and assigns it to a string variable.

Syntax
file.LineInputString
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Parameters

File
Reference to a File control.

Return Values
None.

Remarks
Data read with LineInputString usually is written from a file with LinePrint.
The LineInputString method reads from a file one character at a time until it encounters a 
carriage return (Chr(13)) or carriage return/line feed (Chr(13) + Chr(10)) sequence. Carriage 
return/line feed sequences are skipped rather than appended to the character string.

LinePrint

Function
This method writes a single line to an open sequential file.

Syntax
file.LinePrint output

Parameters

File
Reference to a File control.

Output
String expression to write to a file.

Return Values
None.

Remarks
Data written with LinePrint is usually read from a file with LineInputString.
A carriage return/line feed (Chr(13) + Chr(10)) sequence is appended to the end of the string.
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Loc

Function
This property returns a number specifying the current read/write position.

Syntax
file.Loc

Parameters

File
Reference to a File control.

Remarks
For files opened with the fsModeRandom file mode, Loc returns the number of the last record 
read or written. For files opened with all other modes, Loc returns the position of the last byte 
read or written.

 

LOF

Function
This property returns a number representing the size, in bytes, of a file.

Syntax
file.LOF

Parameters

File
Reference to a File control.

Remarks
The LOF property can be used with the Loc property to guarantee that a read operation does 
not continue past the end of a file.
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MkDir

Function
This method creates a new directory.

Syntax
filesystem.MkDir PathName

Parameters

Filesystem
Reference to a FileSystem control.

Pathname
String expression that contains the directory name.

Return Values
None.

Remarks
MkDir generates an error if the directory already exists.

MoveFile

Function
This method renames an existing file or a directory, including all its subdirectories.

Syntax
filesystem.MoveFile PathName, NewPathName

Parameters

Filesystem
Reference to a FileSystem control.

PathName
String that contains the file name.
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NewPathName
String that contains the file name to copy to.

Return Values
None.

Open

Function
This method opens a file in either the Input (1), Output (2), Random (4), Append (8), or Binary 
mode (32).

Syntax
file.Open pathname, mode, [access], [lock], [reclength]

Parameters

File
Reference to a File control.

Pathname
String expression that specifies a file name.

Mode
Specifies the file mode: Input (1), Output (2), Random (4) , Append (8), or Binary (32).

Access
Operation permitted on the open file: Read, Write, or ReadWrite [Default]. (1, 2, 3)

Lock
Operations permitted on the open file by other processes: Shared, LockRead, LockWrite 
[Default], and LockReadWrite. (1, 2, 3, 0)

Reclength
Number, in bytes, that is less than 32,767. For files opened for random access, this value is 
the record length. For sequential files, this value is the number of characters buffered.

Return Values
None.
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Remarks
The reclength parameter is ignored if the mode is Binary. When opening a file in Random 
mode, you must specifiy a record size of greater than zero or an error will occur.

 

Put

Function
This method writes data from a variable to a disk file.

Syntax
file.Put data, [recnumber]

Parameters

Data
Required. Variant variable that contains data to be written to disk.

Recnumber
Optional. Variant (Long). Record number (Random mode files) or byte number (Binary mode 
files) at which writing begins.

Return Values
None.

Remarks
Data written with Put usually is read from a file with Get.
The first record or byte in a file is at position 1, the second record or byte is at position 2, and 
so on. If you omit recnumber, the next record or byte after the last Get or Put method or pointed 
to by the last Seek function is written.

For files opened in Random mode, the following rules apply:
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● If the length of the data being written is less than the length specified in the Len clause of 
the Open method, Put writes subsequent records on record-length boundaries. The space 
between the end of one record and the beginning of the next record is padded with the 
existing contents of the file buffer. Because the amount of padding data cannot be 
determined with any certainty, it generally is a good idea to have the record length match 
the length of the data being written. If the length of the data being written is greater than 
the length specified in the Len clause of the Open method, an error occurs.

● If the variable being written is a Variant of a numeric type, Put writes 2 bytes identifying the 
VarType of the Variant and then writes the variable. For example, when writing a Variant 
of VarType 3, Put writes 6 bytes: 2 bytes identifying the Variant as VarType 3 (Long) and 
4 bytes containing the Long data. The record length specified by the Len clause in the Open 
method must be at least 2 bytes greater than the actual number of bytes required to store 
the variable.

You can use the Put method to write a Variant array to disk, but you cannot use Put to write 
a scalar Variant containing an array to disk. You also cannot use Put to write objects to disk.
If the variable being written is a Variant of VarType 8 (String), Put writes 2 bytes identifying 
the VarType and 2 bytes indicating the length of the string. It then writes the string data. The 
record length specified by the Len clause in the Open method must be at least 4 bytes greater 
than the actual length of the string.

If the variable being written is a dynamic array, Put writes a descriptor whose length equals 2 
plus 8 times the number of dimensions, that is, 2 + 8 * NumberOfDimensions. The record length 
specified by the Len clause in the Open method must be greater than or equal to the sum of 
all the bytes required to write the array data and the array descriptor. For example, the following 
array declaration requires 118 bytes when the array is written to disk.

For files opened in Binary mode, the Len clause in the Open method has no effect. Put writes 
all variables to disk contiguously; that is, with no padding between records.

RmDir

Function
This method deletes an existing empty directory.

Syntax
filesystem.RmDir PathName

Parameters

Filesystem
Reference to a FileSystem control.

PathName
String that contains the directory name.
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Return Values
None.

Remarks
The directory must be empty before it can be removed. You must specify a complete file path.

Seek

Function
This property returns and sets the next position in a file that will be read or written.

Syntax
file.Seek [= position]

Parameters

File
Reference to a File control.

Position
Numeric expression that specifies a position within a file.

Remarks
The Seek property specifies the next file position, whereas the Loc property specifies the 
current position. Seek always will be one more than Loc, except when a file is first opened and 
Seek and Loc are both 1.

Negative Seek or 0 causes an error.

 

SetAttr

Function
This method sets attribute data for a file.

Syntax
filesystem.SetAttr pathname, attributes
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Parameters

File system
Reference to a FileSystem control.

Pathname
Required. String expression that specifies a file name.

Attributes
Required. Numeric expression whose sum specifies file attributes. The following table shows 
the parameter settings of attributes.

Constant Value Description
vbNormal 0 Normal (default)
vbReadOnly 1 Read only
vbHidden 2 Hidden
VbSystem 4 System file
VbArchive 32 File has changed since last backup

Return values
None.

Remarks
A run-time error occurs if you try to set the attributes of an open file.

WriteFields

Function
This method writes data to a sequential file.

Syntax
file.WriteFields [data]

Parameters

File
Reference to a File control.

Data
Variant or Variant array of numeric or string expressions to write to a file.
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Prinzip

Return Values
None.

Remarks
Data written with WriteFields is usually read from a file with InputFields.
If you omit d ata, a blank line is printed to the file.

● Numeric data is always written using the period as the decimal separator.

● For Boolean data, either #TRUE# or #FALSE# is printed. The True and False keywords 
are not translated, regardless of locale.

● Date data is written to the file using the universal date format. When either the date or the 
time component is missing or is zero, only the component provided gets written to the file.

● Nothing is written to the file if Data is Empty. However, for Null data, #NULL# is written.

● If d ata is Null, #NULL# is written to the file.

The WriteFields method inserts commas between items and quotation marks around strings 
as they are written to the file. You do not have to put explicit delimiters in the list. WriteFields 
inserts a newline character—that is, a carriage return/line feed (Chr(13) + Chr(10))—after it 
has written the final character in data to the file.

VBS object model

VBS object model

VBS object model in WinCC
The following screen shows the VBS object model in WinCC:
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Use the WinCC object model of the graphic Runtime system to access objects and tags in 
Runtime.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4935



Objects
Objects and lists are provided for access to all the objects in the graphic Runtime systems:

● Display and operating objects

● Screens

● Layers

● Tags

Properties
You can specifically change the display and operating elements and tags in Runtime via the 
properties of the individual objects. For example, you can enable a button with a click or trigger 
a color change by changing a tag value.

Methods
Methods which are applied to individual objects can be used to read out tag values for further 
processing or displaying alarms in Runtime. 

See also
ActiveProject (Page 5188)

ActiveScreen (Page 5188)

ActiveScreenItem (Page 5190)

AlarmLogs (list) (Page 4950)

DataItem (Page 4952)

DataLogs (list) (Page 4953)

DataSet (list) (Page 4955)

Logging (Page 4962)

Screen (Page 4965)

Layer (Page 4960)

Layers (list)  (Page 4961)

ScreenItems (list) (Page 4969)

ScreenItem (Page 4967)

Tag (Page 4976)

Tags (list) (Page 4979)

TagSet (list)  (Page 4980)

HMIRuntime  (Page 4957)

Alarm (Page 4948)

Alarms (list) (Page 4949)
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Processvalue (Page 5497)

Screen object (list) (Page 4971)

Objects

HMIRuntime

Description

Portrays the graphic runtime system. 

The HMIRuntime object contains properties and methods which return the objects to the main 
layer, e.g. returns the ActiveScreen property of a screen object.   

Application
You use the "HMIRuntime" object, e.g. as follows:

● Read or set the current Runtime language ("Language" property).

● Read name of current base screen or trigger a base screen change by setting a new screen 
name (property "BaseScreenName")

● Access tags (List "SmartTags")

● End runtime (Method "Stop")

● Output information on sequence tracing output (Method "Trace")

● Access the screens displayed during runtime (List "Screens")
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See also
ActiveScreen (Page 5189)

Screen (Page 4940)

Screen object (list)

Description

A list of screen objects.

The list contains the following two elements:

● The first element with the index 0 represents the permanent window.

● The second element with the index 1 represents the root screen.

Alternatively, the two elements can be addressed with their their names as follows:

● Permanent window: "Overview"

● Root screen: Name of the screen displayed in the root screen 

If the named screen is not displayed, an error occurs during access.   

Permanent window "Overview" is displayed in the objects list and in Auto complete.
 

 Note

The alarm window and the alarm indicator are not contained in the screens list, even if they 
have the focus in Runtime.
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Application
Use the screen property to return the screen list. In the following example, the background 
color is changed from black to green:

Use the object name as an index.

 
'VBS_Example_BackColor
HMIRuntime.Screens("Rootscreen").BackColor = vbGreen

 

 Note

If you perform a screen change, the open references to the screen that is no longer available 
will become invalid. As a result, it is no longer possible to work with these references.

 

 

See also
Screen (Page 4940)

ScreenItems (Page 4944)

Screen

Description
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Represents the process screen which is being displayed on the HMI device at the moment or 
the permanent window in runtime. The screen object is returned to you as a result of accessing 
the screen list. 

The screen object also contains a list of all graphic objects in the screen that can be addressed 
through the list "ScreenItems".

Application
You can also use the screen object to do the following:

● Read the height and width of a screen (properties "Height" and "Width").

● Change the background color (property "BackColor").

Use the object name as an index.

In the following example, the background color is changed from black to green:

'VBS example background color
HMIRuntime.Screens("Rootscreen").BackColor = vbGreen

See also
ScreenItem (Page 4942)

ScreenItems (Page 4944)

HMIRuntime (Page 4937)

Screen object (list) (Page 4938)
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ScreenItem

Description

Represents an object in the specified screen. The ScreenItem object is an element of the 
ScreenItems list.   

Application
You can use the ScreenItem object to access the properties of graphic objects within a screen, 
depending on certain events.

You use the "ScreenItem" object as follows, for example:

● "Visible" property
Switch the visibility of an object on or off.

● "Height" and "Width" properties
Query the width and height of an object.

● "Top" and "Left" properties
Change the position of an object.

● "ObjectName" property
Read the name of a graphic object

● "Parent" property
Set a reference to the parent screen

Use the ScreenItems property to return an object to the screen. Use the object name as an 
index.
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Example
In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
'VBS_Example_ScreenItems
 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

 
 

 Note

To save memory space in the HMI device, no object names are loaded during transfer of the 
project. If you still want to transfer object names, call up the Runtime settings for the respective 
HMI device in WinCC. You can change the setting under "General". The object name is 
required when the object should be accessed via the object name or for debugging a project.

 

The "ScreenItem" object has different properties depending on its features. The following 
properties are provided for every "ScreenItem" object:

● Enabled

● Height

● Left

● ObjectName

● Parent

● Top

● Type

● Visible

● Width

If a specific object type is addressed, further properties are added to the standard properties. 
The additional properties are provided in the descriptions of the individual object types.

See also
Screen (Page 4939)

Screen object (list) (Page 4938)

ScreenItems (Page 4944)
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ScreenItems

Description

A list of screen item objects with all screen objects of the given process screen. The list has a 
parent property. This property provides a reference to the process screen in which the screen 
object is located. 

Application
By means of the "ScreenItems" list you are able

● To edit or output all objects within the list (that is, all objects within a screen)

● To count the objects of a screen (property "Count").

● To work on a particular object in the list (method "Item").

Use the screen items property to return an object from the process screen. Use the object 
name as an index.

In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen
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See also
Screen (Page 4939)

HMIRuntime (Page 4937)

Screen object (list) (Page 4938)

SmartTags

Description

A list of SmartTag objects which represent all of the tags in WinCC Runtime.   
 

 Note

The SmartTags list has a limited range of functions. You can only use the tag names to access 
a SmartTag object. Access via the index or by using "For each" instruction is not supported.

 

 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 
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Application
Use the SmartTags list to return a SmartTag object. Use the tag name to reference the 
SmartTag object.

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure

In Runtime Advanced and Panels you address the tag directly using its name. If the tag name 
corresponds to the VBS name conventions, you do not need to use the SmartTags list. Follow 
the example below:

 
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(AirPressure)
HMIRuntime.Trace strAirPressure

See also
Access to HMI tags (Page 4445)

SmartTag

Description
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Represents the value of the specified process tag. The SmartTag object is an element of the 
SmartTag list.     

Application
The SmartTag object provides read and write access to the value of the specified process tag. 
The SmartTag object does not return an object reference. Use the SmartTags list to return the 
value of a process tag. Use the tag name as an index.

 

 Note

With the "SmartTags reads values from the cache" setting, values are read from the process 
image (cache) instead of directly from the controller. 

The SmartTag object can also read values directly from the controller. However, you can then 
expect a substantially higher communication load between the HMI device and the controller.

 

Example

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure

 
 

 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

 Note

If you want to return the "TypeName" of a SmartTag object data type with the VBS function 
"TypeName", use the following syntax:

TypeName(SmartTags("FillLevel").value) 
 

Use "SmartTags("<tag>")(index)" to access the value of an array element. Set the number of 
the desired array element for "index", for example, "SmartTags("AirPressure")(2)". 
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Objects

Alarm

Description  

Alarms

The alarm object is used to access the Alarms object list.
 

 Note

The properties of the alarm object are not automatically updated when the values of the 
properties change.

 

See also
Alarms (list) (Page 4949)

HMIRuntime  (Page 4957)

Processvalue (Page 5497)
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Alarms (list)

Description   

Alarms

Use the alarm object to trigger existing messages.

Usage
Using the "Alarms" list you can:

● Access a message in the list (Item method)

● Create a new alarm object (Create method)

● Read the alarm ID of the message (AlarmID attribute)

● Read the status of a message (State property)

● Read the time stamp of the message (Timestamp property)

● Generate an instance of the alarm object (Instance property)

● Read the name of the computer on which the message came (ComputerName property)

● Read or set the name of the user who triggered the message (UserName property)

● Read or set the name of the process value blocks (ProcessValues property)

● Read or set the message commentary (Comment property)

● Read or set the message server prefix (Context property)
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Example
In the following example the alarm with the alarm number "1" configured in the "HMI alarms" 
editor is activated.

 
'VBS360
Dim MyAlarm
Set MyAlarm = HMIRuntime.Alarms(1)
MyAlarm.State = 5 'hmiAlarmStateCome + hmiAlarmStateComment
MyAlarm.Comment = "MyComment"
MyAlarm.UserName = "Hans-Peter"
MyAlarm.ProcessValues(1) = "Process Value 1"
MyAlarm.ProcessValues(4) = "Process Value 4"
MyAlarm.Create "MyApplication"

See also
AlarmID (Page 5198)

Processvalue (Page 5497)

Alarm (Page 4947)

HMIRuntime  (Page 4957)

AlarmLogs (list)

Description

You can use the object to reconnect swapped-out log segments of the alarm log to Runtime 
or to remove previously swapped-in log segments of the alarm log. The log segments to be 
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swapped in are copied to the "Common logging" folder of the WinCC project. The previously 
swapped-in log segments are removed from the "Common logging" folder.

You use parameters to control the location from which log segments are to be swapped in. 
You specify the time period over which the log segments are to be swapped in or removed.

If an error occurs during the operation with log segments, the applied method returns an error 
alarm.

Usage
● "Restore" method

Previously swapped-out log segments of the alarm log are connected to Runtime.

● "Remove" method
Previously swapped-in log segments of the alarm log are removed from the Runtime project.

Example
In the following example, log segments from the alarm log are swapped in and the return value 
is output as a trace.

 
'VBS187
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.AlarmLogs.Restore("D:
\Folder","2004-09-14","2004-09-20",-1) & vbNewLine

See also
Restore (Page 5867)

Remove (Page 5862)

DataLogs (list) (Page 4953)

Logging (Page 4962)
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DataItem

Description

You can use the DataItem object to access the contents of the DataSet list. Values or object 
references are stored in the list as DataItem. 

Access uses the name under which the value was added to the list. Single access using an 
index is not recommended since the index changes during adding or deleting of values. You 
can use the index to output the complete contents of the list. The output is in alphabetical order. 

 

 Note

For object references, ensure that the objects are capable of multi-threading. 
 

Example
The example shows how the value of 'Motor1' is output as a trace.

 
'VBS163
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine

The following example enumerates all DataItem objects of the DataSet list. Name and value 
are output as a trace.

 
'VBS164
Dim data
For Each data In HMIRuntime.DataSet
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HMIRuntime.Trace data.Name & ": " & data.Value & vbNewLine
Next

 
 

 Note

The value may not be output directly for objects.
 

See also
Screen (Page 4965)

HMIRuntime  (Page 4957)

DataSet (list) (Page 4955)

Value  (Page 5723)

Name  (Page 5452)

Screen object (list) (Page 4971)

DataLogs (list)

Description

You can use the object to reconnect swapped-out log segments of the data log to Runtime or 
to delete previously swapped-in log segments of the data log. The log segments to be swapped 
in are copied to the "Common logging" folder of the WinCC project. The previously swapped-
in log segments are removed from the "Common logging" folder.
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You use parameters to control the location from which log segments are to be swapped in. 
You specify the time period over which the log segments are to be swapped in or removed. 
You also set the type of log ("Fast data log", "Slow data log", "Fast data log and Slow data 
log").

If an error occurs during the operation with log segments, the applied method returns an error 
alarm.

Usage
● "Restore" method

Previously swapped out log segments of the data log are connected to Runtime.

● "Remove" method
Previously swapped-in log segments of the data log are removed from the Runtime project.

Example
In the following example, log segments from the Fast data log are swapped in and the return 
value is output as a trace. 

 
'VBS188
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.DataLogs.Restore("D:
\Folder","2004-09-14","2004-09-20",-1,1) & vbNewLine

See also
Restore (Page 5867)

Remove (Page 5862)

AlarmLogs (list) (Page 4949)

Logging (Page 4962)
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DataSet (list)

Description

Using the DataSet object, you can exchange data throughout several actions. 

A DataSet object is global and defined by the screen object. You can can access the data from 
any VBS action. 

You address the screen object according to the screen hierarchy . The DataSet object persists 
as long as the screen is displayed. The global object persists over the entire runtime time 
period. 

Access uses the DataItem object. 
 

 Note

You cannot include objects with the types Screen, Screens, ScreenItem, ScreenItems, Tag 
and TagSet in the DataSet list. 

The DataSet object does not support any classes. 
 

Usage
Use the "DataSet" list as follows:

● Enumeration
Output or process all objects in the list

● "Count" property
Output the number of elements contained
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● "Item" method
Work on a particular object in the list

● "Add" method
Add an object to the list

● "Remove" method
Remove a particular object from the list

● "RemoveAll" method
Remove all objects from the list

Access to list elements is made as follows: 

 
HMIRuntime.DataSet("Itemname")

For a picture-specific list, access is performed as follows: 

 
HMIRuntime.Screens("Screenname").DataSet("Itemname") 

You access the DataSet object of the screen as follows: 

 
DataSet("Itemname")

If upon access the stated name does not exist in the list, VT_Empty is returned and an 
Exception is triggered. 

Example
The example shows how a value can be entered in the list, read and removed from the list 
throughout various actions.

 
'VBS162
HMIRuntime.DataSet.Add "motor1", 23
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine
HMIRuntime.DataSet.Remove("motor1")

See also
RemoveAll  (Page 5866)

Remove (Page 5862)

Item (Page 5843)

Add (Page 5781)

DataItem (Page 4951)

HMIRuntime  (Page 4957)
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Screen (Page 4965)

Screen object (list) (Page 4971)

HMIRuntime 

Description

The HMIRuntime object represents the graphic Runtime environment.
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Usage
You can use the "HMIRuntime" object as follows:

● "Language" property
Read or set the current Runtime language

● "BaseScreenName" property
Read or set the name of the current root screen

● "ActiveProject" property
Read the path of the active Runtime project

● "Tags" property
Accessing tags

● "DataSet" property
Accessing tags in a list

● "Stop" method
Stop Runtime

● "Trace" method
Display messages in a diagnostics window

Example
The following command closes WinCC Runtime:

 
'VBS3
HMIRuntime.Stop

See also
Trace (Page 5887)

Stop (Page 5886)

Logging (Page 4962)

DataSet (list) (Page 4954)

Language (Page 5385)

Tags (Page 5605)

Logging  (Page 5420)

DataSet  (Page 5299)

CurrentContext (Page 5291)

ActiveProject (Page 5188)

MenuToolBarConfig  (Page 5431)

Alarm (Page 4947)

Alarms (list) (Page 4948)
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Tag (Page 4976)

Tags (list) (Page 4979)

DataItem (Page 4951)

Screen (Page 4965)

Screen object (list) (Page 4971)

ActiveScreen (Page 5188)

Item

Description
The Item object provides a reference to the current object.

Usage
Use the Item object, for example, to address the properties of the object currently selected in 
the screen.

Example
In the following example, you set the background color of the object selected in the screen to 
red: 

 
'VBS195
Item.BackColor = RGB(255,0,0)
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Layer

Description

The Layer object returns the result of access to the layers list.

Parent object
Screen in which the screen layer is located

Usage
Depending on certain events, you can use the Layer object to obtain access to the properties 
of a complete layer to hide or display a layer with operating elements according to the operator 
authorization.

You can use the "Layer" object as follows:

● "Visible" property
Activate or deactivate visibility of a layer

● "Name" property
Read the name of a layer

 

  Note

The layer property specifies the layer in which the object is located. The layer "0" is output 
as layer "0".

When accessed, the layers are counted up from 1 in VBS. Therefore, address level "1" 
with "Layers(2)".
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Example
In the following example, Layer 1 is set to "invisible":

 
'VBS4
Layers(2).Visible = vbFalse

See also
Name  (Page 5452)

Layers (list)  (Page 4961)

Screen (Page 4965)

Screen object (list) (Page 4971)

Layers (list) 

Description

Use the layers list to access all 32 layers of the graphical Runtime system.

Parent object
Screen in which the screen layer is located
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Usage
You use the "Layers" list as follows:

● "_NewEnum" property
Process all layers in the list

● "Count" property
Count all layers contained in the list

● "Item" method
Process a layer from the list

The properties represent default properties and methods of a list and are not described in detail 
in the WinCC documentation.

See also
Item (Page 5843)

Layer (Page 4959)

Screen (Page 4965)

Screen object (list) (Page 4971)

Logging

Description

You can use the object to reconnect swapped-out log segments to Runtime or to remove 
previously swapped-in log segments. The log segments to be swapped in are copied to the 
"Common logging" folder of the WinCC project. The previously swapped-in log segments are 
removed from the "Common logging" folder.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4961



You use parameters to control the location from which log segments are to be swapped in. 
You specify the time period over which the log segments are to be swapped in or removed.

If an error occurs during the operation with log segments, the applied method returns an error 
alarm.

Usage
● "Restore" method

Previously swapped out log segments of the alarm log and the data log are connected to 
Runtime.

● "Remove" method
Previously swapped-in log segments of the alarm log and data log are removed from the 
Runtime project.

Example
In the following example, log segments from the alarm log and data log are swapped in and 
the return value is output as a trace. 

 
'VBS189
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Restore("D:
\Folder","2004-09-14","2004-09-20",-1) & vbNewLine

See also
Restore (Page 5867)

Remove (Page 5862)

DataLogs (list) (Page 4952)

AlarmLogs (list) (Page 4949)

DataLogs (Page 5298)

AlarmLogs (Page 5199)

HMIRuntime  (Page 4956)
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Project

Description

Using the object, you can query information from the current Runtime project. 

The project object is returned as the result of ActiveProject.

Usage
You can read the following using the "Project" object: 

● The path of the current Runtime project ("Path" property)

● The name of the current Runtime project, without path or file extension ("Name" property)

Example
The following example returns name and path of the current Runtime project as a trace:

 
'VBS159
HMIRuntime.Trace "Name: " & HMIRuntime.ActiveProject.Name & vbNewLine
HMIRuntime.Trace "Path: " & HMIRuntime.ActiveProject.Path & vbNewLine

See also
ActiveProject (Page 5188)

Name  (Page 5452)

Path  (Page 5482)
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Screen

Description

Represents the screen which is being displayed on the HMI device at the moment or the 
permanent window in Runtime. The screen object is returned as a result of accessing the 
screen list. 

The screen object also contains the following lists:

● You can address all the graphic objects in the addressed screen using the "ScreenItems" 
list.

● You can address all the layers in the addressed screen using the "Layers" object.

Application
You can use the screen object for the following actions, for example:

● "Width" and "Height" properties
Reading the width and height of a screen

● "BackColor" property
Changing the background color

Use the object name as an index.

Example
In the following example, the background color is changed from black to green:

 
'VBS_Example_BackColor
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HMIRuntime.Screens("Rootscreen").BackColor = vbGreen

Parent object
Screen window in which the screen object is embedded.

If the screen object is the root screen, the parent object is not defined and set to zero. 
 

 Note

If you perform a screen change, the open references to screens that are no longer available 
will become invalid. As a result, it is no longer possible to work with these references.

 

Example
In the following example, the width of the first screen is increased by 20 pixels in Runtime:

 
'VBS7
Dim objScreen
Set objScreen = HMIRuntime.Screens(1)
MsgBox "Screen width before changing: " & objScreen.Width
objScreen.Width = objScreen.Width + 20
MsgBox "Screen width after changing: " & objScreen.Width

Notes on Cross References
All the screens you address with the standard formulation are automatically compiled by the 
CrossReference of WinCC and then listed in the screen properties.

 
HMIRuntime.BaseScreenName = "Screenname"

If you call screens with different formulations in the code, you make them known by the 
following section of the CrossReference:

 
' ' WINCC:SCREENNAME_SECTION_START
Const ScreenNameInAction = "ScreenName"
' WINCC:SCREENNAME_SECTION_END
The section can be inserted in VBS actions as often as required.

See also
Refresh (Page 5861)

Activate (Page 5777)
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ObjectSizeDeclutteringEnable (Page 5461)

ObjectSizeDeclutteringMax  (Page 5462)

ObjectSizeDeclutteringMin (Page 5462)

LayerDeclutteringEnable (Page 5399)

Layers (Page 5399)

DataSet  (Page 5299)

ExtendedZoomingEnable  (Page 5328)

AccessPath (Page 5186)

HMIRuntime  (Page 4956)

ScreenItems (list) (Page 4969)

Screen object (list) (Page 4971)

ScreenItem

Description

Represents an object in the specified screen. The ScreenItem object is an element of the 
ScreenItems list.   

Application
You can use the ScreenItem object to access the properties of graphic objects within a screen, 
depending on certain events.

You use the "ScreenItem" object as follows, for example:
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● "Visible" property
Switch the visibility of an object on or off.

● "Height" and "Width" properties
Query the width and height of an object.

● "Top" and "Left" properties
Change the position of an object.

● "ObjectName" property
Read the name of a graphic object

● "Parent" property
Set a reference to the parent screen

Use the ScreenItems property to return an object to the screen. Use the object name as an 
index.

Example
In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
'VBS_Example_ScreenItems
 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

 
 

 Note

To save memory space in the HMI device, no object names are loaded during transfer of the 
project. If you still want to transfer object names, call up the Runtime settings for the respective 
HMI device in WinCC. You can change the setting under "General". The object name is 
required when the object should be accessed via the object name or for debugging a project.

 

The "ScreenItem" object has different properties depending on its features. The following 
properties are provided for every "ScreenItem" object:

● Enabled

● Height

● Left

● ObjectName

● Parent

● Top

● Type
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● Visible

● Width

If a specific object type is addressed, further properties are added to the standard properties. 
The additional properties are provided in the descriptions of the individual object types.

See also
Activate (Page 5777)

Layer (Page 5389)

Screen (Page 4964)

ScreenItems (list) (Page 4969)

Screen object (list) (Page 4971)

ScreenItems (list)

Description

A list of ScreenItem objects with all screen objects of the specified screen. The list has a 
"Parent" property. This "Parent" property provides a reference to the screen in which the screen 
object is located. 
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Usage
You use the "ScreenItems" list as follows:

● To edit or output all objects within the list (that is, all objects within a screen)

● "Count" property
Count the objects of a screen

● "Item" method
Work on a particular object in the list

Use the screen items property to return an object from the screen. Use the object name as an 
index.

Example
In the following example, the background color of the "RootScreen" circle in the "myCircle" 
screen is set to green.

 
Dim objCircle
Set objCircle = HMIRuntime.Screens("RootScreen").ScreenItems("myCircle")
objCircle.BackColor = vbGreen

Peculiarities of the ScreenItem object
If you embed an external control (ActiveX control or OLE object) in WinCC, the properties of 
the embedded control may have the same names as the general properties of the ScreenItem 
object. In this case, the ScreenItem properties take priority.

You can address the properties of the embedded controls, however, via the "object" property. 
The "object" property is only available in ActiveX controls and OLE objects.

Example:

 
'Control1 is an embedded ActiveX-Control with property "type"
'VBS196
Dim Control
Set Control=ScreenItems("Control1")
Control.object.type
 
'Control1 is a WinCC-Control
'VBS197
Dim Control
Set Control=ScreenItems("Control1")
Control.type
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Example
In the following example, you output the name of the objects in the current screen in a message 
box:

 
Sub OnClick(ByVal Item)
'VBS6
Dim lngAnswer
Dim lngIndex
lngIndex = 1
For lngIndex = 1 To ScreenItems.Count
lngAnswer = MsgBox(ScreenItems(lngIndex).Objectname, vbOKCancel)
If vbCancel = lngAnswer Then Exit For
Next
End Sub

See also
Item (Page 5843)

ScreenItem (Page 4966)

Screen (Page 4964)

Screen object (list) (Page 4971)

Screen object (list)

Description
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Several screens can be opened simultaeously in WinCC Runtime by means of the screen 
window technique, whereby there is only one main screen. The "Screens" list allows access 
to all open screens in Runtime using the screen name. The screen list contains all hidden 
screens. 

The access key required in the VBS environment in the HMIRuntime.Screens(<access key>) 
instruction must conform to the following syntax description:

 
[<Root screen name>.]<Screen window name>[:<Screen name>] ...
.<Screen window name>[:<Screen name>]

● The access key represents the screen hierarchy.

● You can omit the screen name at all locations in the key.

● The "AccessPath" property of the "Screen" object corresponds to the full access key.

● The root screen can be addressed via the "" access key.

Examples
The screens are addressed by specifying the hierarchy in the list. You can address the screens 
with or without using the screen names. In the following example, a "BaseScreenName" root 
screen is configured with a "ScreenWindow". The screen window contains a "ScreenName" 
screen.

Addressing using the screen name

 
'VBS8
Set objScreen = HMIRuntime.Screens("BaseScreenName.ScreenWindow:ScreenName")

Addressing without using the screen name

 
'VBS9
Set objScreen = HMIRuntime.Screens("ScreenWindow")

Referencing the root screen in various ways

 
'VBS10
Set objScreen = HMIRuntime.Screens(1)
 
'VBS11
Set objScreen = HMIRuntime.Screens("")
 
'VBS12
Set objScreen = HMIRuntime.Screens("BaseScreenName")
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See also
HMIRuntime  (Page 4956)

Screen (Page 4964)

ScreenItem (Page 4966)

SmartTag

Description

Represents the value of the specified process tag. The SmartTag object is an element of the 
SmartTag list.     

Application
The SmartTag object provides read and write access to the value of the specified process tag. 
The SmartTag object does not return an object reference. Use the SmartTags list to return the 
value of a process tag. Use the tag name as an index.

 

 Note

With the "SmartTags reads values from the cache" setting, values are read from the process 
image (cache) instead of directly from the controller. 

The SmartTag object can also read values directly from the controller. However, you can then 
expect a substantially higher communication load between the HMI device and the controller.
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Example

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure

 
 

 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

 Note

If you want to return the "TypeName" of a SmartTag object data type with the VBS function 
"TypeName", use the following syntax:

TypeName(SmartTags("FillLevel").value) 
 

Use "SmartTags("<tag>")(index)" to access the value of an array element. Set the number of 
the desired array element for "index", for example, "SmartTags("AirPressure")(2)". 

See also
HMIRuntime  (Page 4956)

SmartTags (Page 4975)
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SmartTags

Description

A list of SmartTag objects which represent all of the tags in WinCC Runtime.   
 

 Note

The SmartTags list has a limited range of functions. You can only use the tag names to access 
a SmartTag object. Access via the index or by using "For each" instruction is not supported.

 

 Note

In order to access a tag, which has still not been created in the project, using the SmartTags 
list, no value is returned. Assignment to a non-existing tag is not executed:

Dim intVar
intVar = SmartTags("FillLevel")
"intVar" remains empty when the "FillLevel" tag has not been created. 

 

Application
Use the SmartTags list to return a SmartTag object. Use the tag name to reference the 
SmartTag object.

 
'VBS_Example_SmartTags
'Writes tag value to local tag and returns a user-defined text through the 
operating system channel for debug alarms.
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Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(SmartTags("AirPressure"))
HMIRuntime.Trace strAirPressure

In Runtime Advanced and Panels you address the tag directly using its name. If the tag name 
corresponds to the VBS name conventions, you do not need to use the SmartTags list. Follow 
the example below:

 
Dim strAirPressure
strAirPressure = "Current air pressure: " + CStr(AirPressure)
HMIRuntime.Trace strAirPressure

See also
HMIRuntime  (Page 4956)

SmartTag (Page 4972)

Tag

Description

A tag object is returned via the "Tags" list. A tag object can be used to address all the properties 
and methods of a tag.

When creating a tag object, all the properties are initialized with the following values:

● Value = VT_EMPTY

● Name = Tag name
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● QualityCode = BAD NON-SPECIFIC

● TimeStamp = 0

● LastError = 0

● ErrorDescription = " "
 

  Note

A summary of possible Quality Codes can be found in WinCC Information System under 
key word "Communication" > "Diagnostics" or "Communication" > "Quality Codes".

 

Usage
Use the "Tag" object as follows:

● "Name", "QualityCode", "TimeStamp", "LastError" and "ErrorDescription" properties
Read information on the tag

● "Write" method, "Value" property
Set a value for a tag

● "Read" method, "Value" property
Read a value for a tag

Example
The following example reads the value in the "Tag1" tag:

 
'VBS13
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read()
MsgBox objTag.Value

Declaration of tags in WinCC
Always define internal tags in VB script using the "Dim" instruction in order to prevent writing 
tags wrongly. 

When creating a new action, the "Option explicit" instruction is automatically entered in the 
declaration area and cannot be deleted. 

Do not use the "Option explicit" statement in your code as it can lead to Runtime errors. 

Example
The following example reads the declaration value in the "lngVar" VB Script tag:

 
'VBS14
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Dim lngVar
lngVar = 5
MsgBox lngVar

 

 Note

Tag names must not contain any special characters.

When creating a tag, ensure it does not contain a value (Value = VT_EMPTY). Initialize the 
tags after declaration with the corresponding value.

 

Notes on Cross References
All the pictures which are addressed with the standard formulation 

 
HMIRuntime.Tags("Tagname")

are automatically compiled by the CrossReference of WinCC and then listed in the picture 
properties.

If you address tags with different formulations in the code, you can make them known by the 
following section of the CrossReference:

 
' ' WINCC:TAGNAME_SECTION_START
Const TagNameInAction = "TagName"
' WINCC:TAGNAME_SECTION_END

The section can be inserted in VBS actions as often as required.
 

 Note

Composed tag names may not be recognized by the CrossReference.
 

See also
Name  (Page 5452)

Value  (Page 5723)

ErrorDescription (Page 5320)

LastError (Page 5388)

QualityCode (Page 5500)

Timestamp (Page 5639)

HMIRuntime  (Page 4956)
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Tags (list) (Page 4979)

TagSet (list)  (Page 4980)

Tags (list)

Description    

The "Tags" list enables access to tags in WinCC Runtime. The result of access to the "Tags" 
list is returned by an object of the type "Tag". The Tag object can be used to access all the tag 
properties and methods.

 

 Note

"Tags" is a list with a restricted functional scope. The tags in the list cannot be accessed via 
the index but only by using the tag names. The standard methods get_Count and 
get_NewEnum cannot be used in the Tags list.

 

Application
Tags in the list are accessed via:

 
HMIRuntime.Tags("Tagname")

 

The Tags list is used to declare tags (tag objects) for read and write access. The appropriate 
HMI tags must exist in order for the write and read acccess to be executed without error. 
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You can address HMI tags directly in VBScript and set and read values. If you wish to inquire 
about additional tag properties, such as quality code or time stamp, or wish to execute error 
processing, you must address the tag through tags list. The tag object returned enables access 
to all tag properties and methods.

Using the "CreateTagSet" method, you may generate a TagSet object which allows 
simultaneous access to several tags. 

Example
You use tag names when you set tags.

 
'VBS16
Dim objTag
Set objTag = HMIRuntime.Tags("Tagname")
If you only use the tag name, the "TagPrefix" property is assigned the values from the 
current context (the current screen window).

See also
HMIRuntime  (Page 4956)

Tag (Page 4975)

TagSet (list)  (Page 4980)

TagSet (list) 

Description
The "TagSet" object enables simultaneous access to several tags in one call. Simultaneous 
access demonstrates better performance and lower communication load than single access 
to multiple tags. 

Usage
You can use the TagSet object as follows: 

● "Add" method
Add tags to the list

● "Item" method
Access tag objects contained in the list and their properties

● "Write" method
Write all tags of the list

● "Read" method
Read all tags of the list
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● "Remove" method
Remove single tags from the list

● "RemoveAll" method
Remove all tags from the list

Tags in the list are accessed via:

 
'VBS169
Dim myTags
myTags = HMIRuntime.Tags.CreateTagSet
myTags("Tagname")

 

In order to have error-free read/write access to tags (tag objects) of the list, the respective tags 
must exist in WinCC. 

If a read/write access error has occurred, the method used will return an error message using 
the "LastError" and "ErrorDescription" properties. 

Example
The following example shows how to generate a TagSet object, how to add tags, and how to 
write values.

 
'VBS168
'Build a Reference to the TagSet Object
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
'Add Tags to the Collection
group.Add "Motor1"
group.Add "Motor2"
'Set the Values of the Tags
group("Motor1").Value = 3
group("Motor2").Value = 9
'Write the Values to the DataManager
group.Write

See also
ErrorDescription (Page 5320)

LastError (Page 5388)
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Object types

Objects A-I

AlarmControl

Description

Represents the "Alarm view" object. The AlarmControl object is an element of the ScreenItems 
list.

Type identifier in VBS
HMIAlarmControl     

Example
In the following example, the object with the name "Control1" is moved 10 pixels to the right:

 
'VBS54
Dim objControl
Set objControl = ScreenItems("Control1")
objControl.Left = objControl.Left + 10
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Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-23 Properties

Properties Read Write Description
Activate (Page 5186) P P Specifies whether the data to be visualized is requested by the 

alarm server. 
AlarmListType P P Specifies the alarm classes to be reported in runtime. 
AllServer P P Sets the display of the alarms of all available servers. 
ApplyProjectSettings (Page 5209) P P Specifies whether the project settings from the "HMI alarms" 

editor are applied. 
ApplyProjectSettingsForDesignM
ode 

P P Specifies that the project settings are used for the design. 

AutoCompleteColumns 
(Page 5213) 

P P Specifies whether empty columns are shown if the control is 
wider than the configured columns. 

AutoCompleteRows (Page 5214) P P Specifies whether empty rows are shown if the control is longer 
than the number of configured rows. 

AutoSelectionColors (Page 5215) P P Specifies whether the colors defined by the system are used as 
the selection colors for cells and rows. 

AutoSelectionRectColor 
(Page 5216) 

P P Specifies whether the selection frame is shown with the color 
defined by the system. 

BackColor (Page 5218) P P Specifies the background color of the selected object. 
Blocks P P Sets the alarm blocks. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
Caption (Page 5257) P P Specifies the text that is displayed in the header of the selected 

object. 
CellCut (Page 5261) P P Specifies whether the contents of the cells are abbreviated if the 

cells are too narrow. 
CellSpaceBottom (Page 5262) P P Specifies the bottom margin of the table cells. 
CellSpaceLeft (Page 5263) P P Sets the left indent for the table cells. 
CellSpaceRight (Page 5263) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 5264) P P Specifies the top margin of the table cells. 
Closeable (Page 5272) P P Specifies that the control can be closed in runtime. 
ColumnResize (Page 5279) P P Enables changes to the width of columns. 
ColumnScrollbar (Page 5280) P P Specifies the scroll bar type. 
ColumnTitleAlignment 
(Page 5281) 

P P Specifies the type of column title alignment. 

ColumnTitles (Page 5282) P P Specifies whether the column title is displayed. 
ControlDesignMode (Page 5573) P P Specifies the design. 
DefaultMsgFilterSQL P P Specifies an SQL statement as default for alarm filters. 
DefaultSort P P Specifies the sorting order. 
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Properties Read Write Description
DefaultSort2 P P Specifies the sorting order. 
DefaultSort2Column P P Specifies the sorting order. 
DisplayOptions (Page 5304) P P Specifies the alarms to be displayed. 
DoubleClickAction (Page 5305) P P Specifies the action to be executed in runtime by double-clicking 

an alarm row. 
ExportDirectoryChangeable 
(Page 5322) 

P P Specifies whether the data export directory can be changed in 
runtime. 

ExportDirectoryname 
(Page 5322) 

P P Specifies the target directory for the exported Runtime data. 

ExportFileExtension (Page 5323) P P Specifies the file extension of the export file. Only the "csv" file 
extension is currently supported. 

ExportFilename (Page 5323) P P Specifies the name of the target file for the exported Runtime 
data. 

ExportFilenameChangeable 
(Page 5324) 

P P Specifies whether the export file name can be changed in 
runtime. 

ExportFormatGuid (Page 5325) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 5325) P P Specifies the export file format. Only the "csv" file format is 

currently available for the export. 
ExportParameters (Page 5326) P P Specifies the parameters of the selected format by means of the 

"Properties" dialog. 
ExportSelection (Page 5326) P P Specifies the file extension of the export file. Only the "csv" file 

extension is currently supported. 
ExportShowDialog (Page 5327) P P Specifies whether the data export dialog is shown in runtime. 
Filters P P Specifies database criteria in SQL syntax. 
Font (Page 5347) P P Specifies or returns the font. 
GridLineColor (Page 5359) P P Specifies the color for the grid lines. 
GridLineWidth (Page 5360) P P Specifies the width of the separation lines in pixels. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
HitlistColumnAdd (Page 5366) * P P Transfers the selected alarm block from the list of available alarm 

blocks to the list of selected alarm blocks. 
HitlistColumnCount (Page 5367) * P P Sets the number of selected alarm blocks to be displayed in the 

hitlist in runtime. 
HitlistColumnIndex (Page 5367) P P References an alarm block that is selected for the hitlist. 
HitlistColumnName (Page 5368) * P P Displays the name of the alarm block of the hitlist that is 

referenced by means of the "HitlistColumnIndex" attribute. 
HitlistColumnRemove 
(Page 5368) *

P P Cuts the marked alarm block from the list of selected alarm 
blocks and pastes it into the list of existing alarm blocks. 

HitlistColumnRepos (Page 5368) 
*

P P Changes the sorting order of the alarm blocks. The "Up" and 
"Down" commands move the selected alarm block accordingly 
in the list. 

HitlistColumnSort (Page 5369) * P P Specifies the sorting order in the hitlist for the alarm block that is 
referenced in "MessageColumnIndex". 

HitlistColumnSortIndex 
(Page 5369) *

P P Specifies the sorting order in the hitlist for the alarm block that is 
referenced in "HitlistColumnIndex". 

HitlistColumnVisible (Page 5370) 
*

P P The list displays the selected alarm blocks from the alarm list or 
hitlist that are to be used in the control in runtime. 
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Properties Read Write Description
HitListDefaultSort (Page 5370) P P Sets the default sorting order in the table columns of the hitlist. 
HitListMaxSourceItems 
(Page 5371) 

P P Sets the maximum number of data records from the alarm log 
that are to be used to create the hit list. 

HitListMaxSourceItemsWarn 
(Page 5371) 

P P Sets the output of a warning on reaching the maximum number 
of data records that was specified in "HitlistMaxSourceItems". 

HitListRelTime (Page 5373) P P Sets a time range for the statistics. 
HitListRelTimeFactor P P Sets the time factor that is used in combination with the 

"HitlistRelativeTimeFactorType" to calculate the period for 
creating the hitlist statistics. 

HitListRelTimeFactorType P P Sets the time type that is used in combination with the 
"HitlistRelativeTimeFactor" to calculate the period for creating 
the hitlist statistics. 

HorizontalGridLines (Page 5375) P P Specifies whether horizontal separation lines are displayed. 
IconSpace (Page 5378) P P Specifies the spacing between icons and text in the table cells. 
Layer (Page 5389) P P Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 5414) P P Sets the color of the window separation lines. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
LongTermArchiveConsistency 
(Page 5422) 

P P If "LongTimeArchiveConsistency" is set to "No", 1000 alarms will 
be displayed in the historical alarm list (long-term) on the single 
station, on the server, or on the client for each server or 
redundant server pair. 

MessageBlockAlign (Page 5431) * P P Sets the mode of alignment for the table contents of the selected 
alarm block. 

MessageBlockAutoPrecisions 
(Page 5432) *

P P Enables automatic setting of the number of decimal places. 

MessageBlockCaption 
(Page 5433) *

P P Specifies the caption of the column header in the alarm view for 
the selected alarm block. 

MessageBlockCount (Page 5433) P P Specifies the number of alarm blocks that are available for the 
alarm list and hitlist. 

MessageBlockDateFormat 
(Page 5433) *

P P Specifies the date format for displaying the alarms. 

MessageBlockExponentialFormat
 (Page 5434) *

P P Specifies the exponential notation for visualization of the values 
of a selected alarm block. 

MessageBlockFlashOn 
(Page 5435) *

P P Enables flashing of the selected alarm block in runtime when an 
alarm appears. 

MessageBlockHideText  
(Page 5435) *

P P Enables the textual display of the content of the selected alarm 
block. 

MessageBlockHideTitleText  
(Page 5436) *

P P Specifies textual display of the caption of the selected alarm 
block. 

MessageBlockId (Page 5436) P P Specified assignment of ID number and alarm block in the alarm 
view. 

MessageBlockIndex (Page 5437) P P References an existing alarm block. 
MessageBlockLeadingZeros  
(Page 5437) *

P P Enables the display of the selected alarm block with leading 
zeroes. 

MessageBlockLength  
(Page 5438) *

P P Specifies the length of the selected alarm block based on the 
number of characters. 
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Properties Read Write Description
MessageBlockName (Page 5438) P P Displays the name of the selected alarm block. 
MessageBlockPrecision  
(Page 5439) *

P P Specifies the number of decimal places for the values of the 
selected alarm block. 

MessageBlockSelected  
(Page 5439) *

P P Existing alarm blocks are blocks that are available for use in the 
control in runtime for the alarm list or hitlist. 

MessageBlockShowDate  
(Page 5440) *

P P Specifies whether to display both the date and time in the "Time" 
alarm block. 

MessageBlockShowIcon  
(Page 5440) *

P P Enables the display of the content of the selected alarm block as 
icon. 

MessageBlockShowTitleIcon  
(Page 5441) *

P P Specifies textual display of the caption of the selected alarm 
block. 

MessageBlockTextId 
(Page 5441) 

P P Specifies naming of the selected alarm block by means of a text 
ID that was taken from the text library. 

MessageBlockTimeFormat  
(Page 5442) *

P P Specifies the format for the time or period used to display the 
alarms. 

MessageColumnAdd  
(Page 5443) *

P P Adds the selected alarm block from the list of available alarm 
blocks to the list of selected alarm blocks. 

MessageColumnCount  
(Page 5444) *

P P Specifies the number of alarm blocks to be displayed in the alarm 
list in runtime. 

MessageColumnIndex 
(Page 5444) 

P P References an alarm block selected for the alarm list. 

MessageColumnName  
(Page 5445) *

P P Shows the name of the alarm block from the alarm list, which is 
referenced by means of the "MessageColumnIndex" property. 

MessageColumnRemove  
(Page 5445) *

P P Cuts the marked alarm block from the list of selected alarm 
blocks and pastes it into the list of existing alarm blocks. 

MessageColumnRepos  
(Page 5446) *

P P Changes the sorting order of the alarm blocks. The "Up" and 
"Down" commands move the selected alarm block accordingly 
in the list. 

MessageColumnSort  
(Page 5446) *

P P Specifies the sorting order for the alarm block that is referenced 
in "MessageColumnIndex" . 

MessageColumnSortIndex  
(Page 5447) *

P P Specifies the sorting order for the alarm block that is referenced 
in "MessageColumnIndex". 

MessageColumnVisible 
(Page 5447) *

P P The list shows the selected alarm blocks of the alarm list or hitlist 
that are are used in the alarm view in runtime. 

Moveable (Page 5451) P P Specifies whether the window can be moved in runtime. 
MsgFilterSQL (Page 5452) P P Specifies one or several SQL statements for user-defined 

selection of the alarms. 
Name (Page 5452) P P Returns the object name as STRING. 
OperatorAlarms P P Specifies the operator message settings. 
OperatorMessageId  (Page 5465) 
*

P P Default assignment of the ID number and trigger event in the 
alarm view. 

OperatorMessageIndex  
(Page 5466) *

P P References the operator message event. 

OperatorMessageName  
(Page 5467) *

P P On alarm events, this displays the name that is referenced by 
means of "OperatorMessageIndex" for operator alarms. 

OperatorMessageNumber  
(Page 5467) *

P P Specify an alarm number for the operator message of the 
selected alarm event if you do not use the operator message of 
WinCC. 
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Properties Read Write Description
OperatorMessageSelected  
(Page 5468) *

P P Activate the alarm events of the list that trigger operator 
messages. 

OperatorMessageSource1  
(Page 5468) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 1" of the operator message configured in 
Source. 

OperatorMessageSource10  
(Page 5473) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 10" of the operator message configured in 
Source. 

OperatorMessageSource2  
(Page 5469) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 2" of the operator message configured in 
Source. 

OperatorMessageSource3  
(Page 5469) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 3" of the operator message configured in 
Source. 

OperatorMessageSource4  
(Page 5470) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 4" of the operator message configured in 
Source. 

OperatorMessageSource5  
(Page 5470) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 5" of the operator message configured in 
Source. 

OperatorMessageSource6  
(Page 5471) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 6" of the operator message configured in 
Source. 

OperatorMessageSource7  
(Page 5471) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 7" of the operator message configured in 
Source. 

OperatorMessageSource8  
(Page 5472) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 8" of the operator message configured in 
Source. 

OperatorMessageSource9  
(Page 5472) *

P P Specify the alarm block of the operated alarm to be added to 
"Process value block 9" of the operator message configured in 
Source. 

OperatorMessageSourceType1  
(Page 5473) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType10  
(Page 5478) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType2  
(Page 5474) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType3  
(Page 5474) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType4  
(Page 5475) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType5  
(Page 5475) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType6  
(Page 5476) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType7  
(Page 5476) *

P P Specifies the format of the source content to be transferred. 

OperatorMessageSourceType8  
(Page 5477) *

P P Specifies the format of the source content to be transferred. 
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Properties Read Write Description
OperatorMessageSourceType9  
(Page 5477) *

P P Specifies the format of the source content to be transferred. 

PageMode (Page 5479) P P Sets the page orientation (portrait / landscape). 
PageModeMessageNumber 
(Page 5480) 

P P Defines the number of alarm shown per page when paging the 
historical alarm list (long-term). 

PrintJob P P Specifies a print job 
RowScrollbar (Page 5510) P P Specifies whether row scroll bars are displayed. 
RowTitleAlignment P P Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 5512) P P Specifies how online configurations of WinCC are retained. 
RTPersistenceAuthorization 
(Page 5513) 

P P Specifies the authorization required for online configuration in 
runtime. 

RTPersistenceType (Page 5513) - - Specifies how online configurations of WinCC are retained. 
SelectedCellColor (Page 5528) P P Specifies the background color of the selected cell. 
SelectedCellForeColor 
(Page 5529) 

P P Specifies the font color of the selected cell. 

SelectedRowColor (Page 5530) P P Specifies the background color of the selected row. 
SelectedRowForeColor 
(Page 5530) 

P P Specifies the font color of the selected row. 

SelectedTitleColor (Page 5531) P P Specifies the background color of a selected table header. 
SelectedTitleForeColor 
(Page 5532) 

P P Specifies the font color of the selected table header. 

SelectionColoring (Page 5534) P P Specifies whether selection colors are used for cells or rows. 
SelectionRect (Page 5537) P P Specifies whether a selection frame is used for the selected cells 

or rows. 
SelectionRectColor (Page 5538) P P Specifies the color of the selection rectangle in the alarm window 

if SelectionType equals "1". 
SelectionRectWidth (Page 5539) P P Specifies the line width of the selection rectangle in the alarm 

window if SelectionType equals "1". 
SelectionType (Page 5539) P P Specifies the number of lines you can mark.
ServerNames (Page 5543) P P Specifies the servers of a distributed system that form the data 

source for the alarm view. 
ShowSortButton (Page 5563) P P Specifies whether the sorting button is shown above the vertical 

scroll bar. 
ShowSortIcon (Page 5564) P P Specifies whether the sorting icon is displayed. 
ShowSortIndex (Page 5565) P P Specifies whether the sorting icon is displayed. 
ShowTitle (Page 5569) P P Specifies the representation of the control's window title. 
Sizeable (Page 5573) P P Specifies that the size of an object can be changed in runtime. 
SortSequence (Page 5577) P P Specifies how the sorting order can be changed by mouse click. 
StatusbarBackColor (Page 5582) P P Specifies the background color of the status bar. 
StatusbarElementAdd  
(Page 5582) *

P P Creates a new, user-defined status bar element. 

StatusbarElementAutoSize 
(Page 5583) *

P P Specifies whether the width of the selected status bar element 
is set automatically. 

StatusbarElementCount  
(Page 5583) *

P P Specifies the number of configurable status bar elements. 
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Properties Read Write Description
StatusbarElementIconId  
(Page 5584) *

P P Default assignment of the ID number and icon of a status bar 
element. 

StatusbarElementId  (Page 5584) 
*

P P Unique ID of the selected status bar element. 

StatusbarElementIndex  
(Page 5585) 

P P References a status bar element. You can use this property to 
assign the values of other properties to a specific element of the 
status bar. 

StatusbarElementName  
(Page 5585) *

P P Displays the object name of the selected status bar element. 

StatusbarElementRemove  
(Page 5586) *

P P Removes the selected status bar element. 

StatusbarElementRename  
(Page 5586) *

P P Renames the user-defined status bar element that is referenced 
by means of the "StatusbarElementIndex" property.

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 5586) - - Specifies the elements that are to be shown in the status bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar element. 
StatusbarElementTooltipText  
(Page 5587) *

P P Specifies the tooltip text for the user-defined status bar element. 

StatusbarElementUserDefined  
(Page 5587) *

P P Indicates whether the project engineer has added the toolbar 
button as a new user-defined element. 

StatusbarElementVisible  
(Page 5588) *

P P In the list, activate the status bar elements that you wish to 
display in runtime. 

StatusbarElementWidth  
(Page 5589) *

P P Specifies the width of the selected status bar element in pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 5589) P P Specifies the color of the text in the status bar. 
StatusbarShowTooltips 
(Page 5591) 

P P Specifies whether tooltips are displayed for the elements of the 
status bar in runtime. 

StatusbarText (Page 5592) P P Default text in the status bar. 
StatusbarUseBackColor 
(Page 5593) 

P P Specifies whether the background color of the status bar is 
shown. 

StatusbarVisible (Page 5593) P P Specifies whether the status bar of the control is displayed. 
TableColor P P Specifies the background color of the rows. Use this to open the 

color selection dialog. 
TableColor2 P P Specifies the background color of "Row color 2". 
TableForeColor P P Specifies the font color of "Row color". 
TableForeColor2 P P Specifies the font color of "Row color 2". 
TimeBase (Page 5619) P P Sets the timebase. 
TitleColor P P Specifies the color of the header. 
TitleCut P P Specifies whether the contents of the fields of a header should 

be abbreviated if the column is too narrow. 
TitleDarkShadowColor P P Specifies the color of the dark side of shading. 
TitleForeColor P P Specifies the font color of the table header for the selected status. 
TitleGridLineColor P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor P P Specifies the color of the bright side of shading. 
TitleSort P P Specifies how sorting by column title is triggered. 
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Properties Read Write Description
TitleStyle P P Specifies whether a shading color is used for the table header. 
ToolbarAlignment P P Specifies or returns the position of the toolbar. 
ToolbarBackColor P P Specifies the background color of the toolbar. 
ToolbarButtonActive  * P P Specifies whether the function linked to the button is activated in 

runtime. 
ToolbarButtonAdd  * P P Creates a new, user-defined button function. 
ToolbarButtonBeginGroup  * P P Specifies whether a separator is inserted before the selected 

button function. 
ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  * P P Specifies whether a user-defined toolbar button can be operated. 
ToolbarButtonHotKey  * P P Shows the hotkey for the selected button function. 
ToolbarButtonId  * P P Unique ID number for the selected button function. 
ToolbarButtonIndex P P References a button function. 
ToolbarButtonLocked  * P P Specifies whether the clicked, pressed in state is displayed for a 

user-defined toolbar button. 
ToolbarButtonName  * P P Shows the name of the selected button function. 
ToolbarButtonPasswordLevel  * P P Shows the authorization for the selected button function. 
ToolbarButtonRemove  * P P Removes the selected button function from the list. 
ToolbarButtonRename  * P P Renames the user-defined toolbar element that is referenced by 

means of the "ToolbarButtonIndex" property. 
ToolbarButtonRepos  * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  * P P Specifies the tooltip text for the button. 
ToolbarButtonUserDefined  * P P Indicates whether the project engineer has added the toolbar 

button as a new user-defined button. 
ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips P P Specifies whether the tooltips for the button functions are 

displayed in runtime. 
ToolbarUseBackColor P P Specifies whether the background color for the toolbar is shown. 
ToolbarUseHotKeys P P Specifies whether the hotkeys for the button functions are 

activated in runtime. 
ToolbarVisible P P Specifies whether the toolbar of the control is displayed. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
UseMessageColor (Page 5712) P P Specifies whether scrolling is enabled. 
UseSelectedTitleColor 
(Page 5714) 

P P Specifies whether a selection color is used for the headers of 
selected table cells. 

UseTableColor2 (Page 5715) P P Specifies whether a second row color is used for the 
representation of the table. 

VerticalGridLines (Page 5734) P P Specifies whether vertical separation lines are displayed. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES
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Table 10-24 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 5783) P, A Executes the "Connect backup" button function of the control.
CopyRows (Page 5784) P Executes the "Copy rows" button function of the control.
DeactivateDynamic (Page 5786) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
DetachDB (Page 5789) P, A Executes the "Disconnect backup" button function of the control.
Export (Page 5790) P, A Executes the "Export log" or "Export data" button function of the control.
GetHistlistColumnCollection 
(Page 5793) 

P Returns the list of all column objects of the alarm view hitlist as 
"ICCAxCollection" type.

GetHitlistColumn (Page 5794) P Returns the column object of the alarm view hitlist designated by name 
or index as "ICCAxMessageColumn" type.

GetMessageBlock (Page 5795) P Returns the alarm block object of the alarm view designated by name or 
index as "ICCAxMessageBlock" type.

GetMessageBlockCollection 
(Page 5796) 

P Returns the list of all alarm block objects of the alarm view as 
"ICCAxCollection" type.

GetMessageColumn (Page 5797) P Returns the column object of the alarm view designated by name or index 
as "ICCAxMessageColumn" type.

GetOperatorMessage (Page 5798) P Returns the operator message object of the alarm view designated by 
name or index as "ICCAxOperatorMessage" type.

GetMessageColumnCollection 
(Page 5799) 

P Returns the list of all column objects of the message view as 
"ICCAxCollection" type.

GetOperatorMessageCollection 
(Page 5800) 

P Returns the list of all operator message objects of the alarm view as 
"ICCAxCollection" type.

GetRow (Page 5802) P Returns the row object defined by its row number in the table-based 
controls as "ICCAxDataRow" type.

GetRowCollection (Page 5803) P Returns the list of all row objects of the table-based controls as 
"ICCAxDataRowCollection" type. 

GetSelectedRow (Page 5810) P Returns the selected row object of a table-based control as 
"ICCAxDataRow" type.

GetSelectedRows (Page 5811) P Returns the selected row objects of a table-based control as type 
"ICCAxDataRow" for multiple selection.

GetStatusbarElement (Page 5817) P, A Returns the element of the control's status bar designated by name or 
index as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 5818) 

P, A Returns the list of all status bar elements of the control as 
"ICCAxCollection" type.

GetToolbarButton (Page 5825) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 5826) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

HideAlarm (Page 5842) P Executes the "Hide alarm" button function of the alarm view.
LockAlarm (Page 5845) P Executes the "Disable alarm" button function of the alarm view.
LoopInAlarm (Page 5845) P Executes the "Loop in alarm" button function of the alarm view.
MoveToFirstLine (Page 5847) P Executes the "First alarm" button function of the alarm view.
MoveToFirstPage (Page 5847) P Executes the "First page" button function of the alarm view.
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Methods Valid Description
MoveToLastLine (Page 5848) P Executes the "Last alarm" button function of the alarm view.
MoveToLastPage (Page 5849) P Executes the "Last page" button function of the alarm view.
MoveToNextLine (Page 5850) P Executes the "Next alarm" button function of the alarm view.
MoveToNextPage (Page 5850) P Executes the "Next page" button function of the alarm view.
MoveToPreviousLine (Page 5851) P Executes the "Previous alarm" button function of the alarm view.
MoveToPreviousPage (Page 5852) P Executes the "Previous page" button function of the alarm view.
Print (Page 5855) P, A Executes the "Print" button function of the control.
QuitHorn (Page 5856) P Executes the "Acknowledge central alarm generator" button function of 

the alarm view.
QuitSelected (Page 5856) P Executes the "Single acknowledgment" button function of the alarm view.
QuitVisible (Page 5857) P Executes the "Group acknowledgment" button function of the alarm view.
SelectAll (Page 5870) P Selects all rows in a table-based control.
SelectRow (Page 5871) P Selects a specific row in a table-based control.
ShowComment (Page 5874) P Executes the "Comment dialog" button function of the recipe view.
ShowDisplayOptionsDialog 
(Page 5874) 

P Executes the "Display options dialog" button function of the alarm view.

ShowEmergencyQuitDialog 
(Page 5875) 

P Executes the "Single acknowledgment" button function of the alarm view.

ShowHelp (Page 5875) P, A Executes the "Help" button function of the control.
ShowHideList (Page 5876) P Executes the "List of alarm to hide" button function of the alarm view.
ShowHitList (Page 5876) P Executes the "Hitlist" button function of the alarm view.
ShowInfoText (Page 5877) P Executes the "About dialog" button function of the alarm view.
ShowLockDialog (Page 5877) P Executes the "Lock dialog" button function of the alarm view.
ShowLockList (Page 5878) P Executes the "Lock list" button function of the alarm view.
ShowLongTermArchiveList 
(Page 5878) 

P Executes the "Historical alarm list (long-term)" button function of the alarm 
view.

ShowMessageList (Page 5879) P Executes the "Alarm list" button function of the alarm view.
ShowPropertyDialog (Page 5880) P, A Executes the "Configuration dialog" button function of the control.
ShowSelectionDialog (Page 5881) P Executes the "Selection dialog" button function of the alarm view.
ShowShortTermArchiveList 
(Page 5882) 

P Executes the "Historical alarm list (short-term)" button function of the 
alarm view.

ShowSortDialog (Page 5883) P Executes the "Sorting dialog" button function of the alarm view.
ShowTimebaseDialog (Page 5884) P Executes the "Timebase dialog" button function of the alarm view.
UnhideAlarm (Page 5887) P Executes the "Unhide alarm" button function of the alarm view.
UnlockAlarm (Page 5888) P Executes the "Unlock alarm" button function of the alarm view.
UnselectAll (Page 5888) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 5889) P Removes the selections from a specific cell of a table-based control.

 

See also
Screen object (list) (Page 4970)
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AlarmView

Description

Represents the "Alarm view" object. The MessageView object is an element of the 
ScreenItems list. 

     

If you change the settings for this object with a user-defined function, the changed settings are 
retained even after the screen is called again. 

 

 Note

The object "Simple AlarmView" cannot be dynamized with a user-defined function.
 

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-25 Properties

Properties Read Write Description
AlarmAreaHeight **    
AlarmAreaWidth **    
AlarmClasses - - Specifies the alarm classes to be reported in runtime. 
AlarmLog - - Specifies the alarm types to be displayed in the alarm view. 
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Properties Read Write Description
AlarmSource - - Specifies that alarms should be displayed. 
Authorization (Page 5212) - - Specifies the operating rights of the selected object in runtime.  
BackColor A A Specifies the background color of the selected object. 
ButtonBarElements **   Specifies that the buttons will be displayed. 
ButtonBarStyle - -  
Columns - - Specifies the columns to be displayed. 
ColumnsMoveable - - Specifies that the columns can be moved. 
ColumnTextAckGroup - - Specifies the header for the "AckGroup" column. 
ColumnTextAlarmState - - Specifies the header for the "State" column. 
ColumnTextAlarmText - - Specifies the header for the "Text" column. 
ColumnTextClassName - - Specifies the header for the "Class Name" column. 
ColumnTextDate - - Specifies the header for the "Date" column. 
ColumnTextDevice - - Specifies the header for the "Device" column. 
ColumnTextDiagnosable - - Specifies the header for the "Diagnosable" column. 
ColumnTextNumber - - Specifies the header for the "Number" column. 
ColumnTextTime - - Specifies the header of the "Time" column. 
CountOfLinesPerAlarms - -  
CountOfVisibleAlarms - -  
Enabled (Page 5314) A A Specifies whether the selected object can be operated in runtime.  
FilterTag **   Specifies a tag of the string type for filtering alarm texts. 
FilterText **   Specifies the text for filtering the alarm text. 
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
Flashing - - Specifies that the text block flashes. 
FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 5346) A A Specifies the border width of the specified object when the object 

is in focus.  
ForeColor (Page 5353) - - Specifies the font color of the text for the selected object. 
GridlineColor (Page 5360) A A Specifies the color for the grid lines. 
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalScrollingEnabled - -  
IsRunningUnderCE * - -  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
LineAlarmView **    
Name (Page 5452) A A Returns the object name as STRING. 
PreferredUseOnAck - -  
S7Device - -  
SecurityForSimpleViewEnabled 
**

   

SelectionBackColor (Page 5534) A A Specifies the background color of the selected cells.  
SelectionForeColor (Page 5536) A A Specifies the foreground color of the selected cells.  
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Properties Read Write Description
SeparateLineForAlarmText - -  
ShowAcknowledgeButton - -  
ShowAlarmsFromDate 
(Page 5550) 

A A Specifies that only those message events are displayed that are 
saved in this tag.  

ShowAlarmsToAcknowledge - - Specifies that unacknowledged alarms should be displayed. 
ShowColumnHeaders - -  
ShowHelpButton - -  
ShowHorizontalGridlines - -  
ShowLoopInAlarmButton - - Specifies that the "Loop-In-Alarm" button will be displayed.
ShowMilliseconds - - Display time in milliseconds. 
ShowPendingAlarms - -  
SortByTimeDirection 
(Page 5575) 

- - Specifies whether the last incoming alarm is displayed at the top 
of the "AlarmControl" object. 

SortByTimeEnabled 
(Page 5575) 

A A Specifies whether the sorting order of alarms based on the time 
in the "AlarmControl" object can be changed.  

TableBackColor (Page 5597) A A Specifies the background color of the table cells for the selected 
object.  

TableFont - - Specifies the font in the table. 
TableForeColor (Page 5600) A A Specifies the font color of "Row color". 
TableHeaderBackColor 
(Page 5602) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor 
(Page 5603) 

A A Specifies the text color in the header of the table of the selected 
object. 

Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
VerticalScrollbarEnabled - -  
VerticalScrollingEnabled - -  
ViewType - - Specifies the alarm view type.
ViewTypeForSaveStream **   Specifies the display type for the Save Stream. 
Visible (Page 5735) * A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES, ** no relevant information available

Table 10-26 Methods

Methods Valid Description
Activate (Page 5777) ??? Activates the permanent window or the root screen. 
???   
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Methods Valid Description
   
   
   

 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

Bar

Description

Represents the "Bar" object. The Bar object is an element of the ScreenItems list. 
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Type identifier in VBS
HMIBar     

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-27 Properties

Properties Read Write Description
AlarmLowerLimit (Page 5200) P P Specifies the low limit at which the interrupt is triggered. 
AlarmLowerLimitColor 
(Page 5200) 

P P Specifies the bar color of the "AlarmLowerLimit" limit. 

AlarmLowerLimitEnabled 
(Page 5201) 

P P Specifies whether the "AlarmLowerLimit" limit is monitored. 

AlarmLowerLimitRelative 
(Page 5201) 

P P Specifies whether the low limit at which the interrupt is triggered is 
evaluated as a percentage or an absolute value. 

AlarmUpperLimit (Page 5202) P P Specifies the high limit that triggers the interrupt. 
AlarmUpperLimitColor 
(Page 5202) 

P P Specifies the bar color of the "AlarmUpperLimit" limit. 

AlarmUpperLimitEnabled 
(Page 5203) 

P P Specifies whether the "AlarmUpperLimit" limit is monitored. 

AlarmUpperLimitRelative 
(Page 5204) 

P P Specifies whether the high limit at which the interrupt is triggered 
is evaluated as a percentage or an absolute value. 

Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
AverageLast15Values P P Specifies that the average of the last 15 values is shown. 
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object. 
BackFlashingColorOff 
(Page 5224) *

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 5225) *

P P Specifies the background color for flash state "On". 

BackFlashingEnabled 
(Page 5226) *

P P Specifies whether the background of the specified object flashes 
in runtime. 

BackFlashingRate (Page 5226) * P P Specifies the flash rate of the background for the selected object. 
BarBackColor (Page 5227) P, A P, A Specifies the color of the bar background for the selected object. 
BarBackFillStyle (Page 5228) P P Specifies the fill style for the bar. 
BarBackFlashingColorOff - - Specifies the border background color of the object for the "OFF" 

state. 
BarBackFlashingColorOn - - Specifies the border background color of the object for the "ON" 

state. 
BarBackFlashingEnabled - -  
BarBackFlashingRate - - Specifies the flash rate of the background. 
BarEdgeStyle - - Specifies the style of the border line. 
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Properties Read Write Description
BarOrientation P P Specifies the alignment of the bar. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off". 

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On". 

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object. 

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) - - Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
ColorChangeHysteresis 
(Page 5274) 

P P Specifies the hysteresis as a percentage of the display value. 

ColorChangeHysteresisEnabled 
(Page 5275) 

P P Specifies whether the object is displayed with hysteresis. 

CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object. 
CountDivisions (Page 5288) P P Specifies the number of segments into which the bar will be split 

by means of the large scale tick marks. 
CountSubDivisions (Page 5289) A A Specifies the number of scale tick marks between two main tick 

marks of the "Bar" object. 
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border.

EdgeStyle (Page 5310) P P Specifies the line style of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) * - - Specifies the border line color of the selected object for the flash 

state "Off". 
FlashingColorOn (Page 5338) * - - Specifies the border line color of the selected object for the flash 

state "On". 
FlashingEnabled (Page 5339) * - - Specifies whether the border line of the selected object flashes in 

runtime. 
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 5340) * - - Specifies the flash rate of the border line for the selected object. 
Font (Page 5347) - - Specifies or returns the font. 
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in bold. 
FontName (Page 5350) P P Specifies the font of the selected object. 
FontSize (Page 5351) P P Specifies the font size of the text for the selected object. 
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 4997



Properties Read Write Description
IntegerDigits (Page 5382) P P, A Specifies the number of digits to the left of the decimal point (0 to 

20). 
LargeTickLabelingStep - - Specifies which scale sections are labeled. 
LargeTicksBold (Page 5386) P P Specifies whether the long tick marks of a scale are shown in bold. 
LargeTicksSize (Page 5386) P P Specifies the length of the long tick marks of a scale. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
Limit4LowerLimit (Page 5404) P P Specifies the low limit for "Reserve4". 
Limit4LowerLimitColor 
(Page 5405) 

P P Specifies the color for the "Reserve4" low limit. 

Limit4LowerLimitEnabled 
(Page 5405) 

P P Specifies whether the "Reserve4" low limit is monitored. 

Limit4LowerLimitRelative 
(Page 5406) 

P P Specifies whether the "Reserve4" low limit is evaluated as a 
percentage or an absolute value. 

Limit4UpperLimit (Page 5406) P P Specifies the high limit for "Reserve4". 
Limit4UpperLimitColor 
(Page 5407) 

P P Specifies the color for the "Reserve4" high limit. 

Limit4UpperLimitEnabled 
(Page 5407) 

P P Specifies whether the "Reserve4" high limit is monitored. 

Limit4UpperLimitRelative 
(Page 5408) 

P P Specifies whether the "Reserve4" high limit is evaluated as a 
percentage or an absolute value. 

Limit5LowerLimit (Page 5409) P P Specifies the low limit for "Reserve5". 
Limit5LowerLimitColor 
(Page 5409) 

P P Sets the color for the "Reserve5" low limit. 

Limit5LowerLimitEnabled 
(Page 5410) 

P P Specifies whether the "Reserve5" low limit is monitored. 

Limit5LowerLimitRelative 
(Page 5410) 

P P Specifies whether the "Reserve5" low limit is evaluated as a 
percentage or an absolute value. 

Limit5UpperLimit (Page 5411) P P Specifies the high limit for "Reserve5". 
Limit5UpperLimitColor 
(Page 5412) 

P P Specifies the color for the "Reserve5" high limit. 

Limit5UpperLimitEnabled 
(Page 5412) 

P P Specifies whether the "Reserve5" high limit is monitored. 

Limit5UpperLimitRelative 
(Page 5413) 

P P Specifies whether the "Reserve5" high limit is evaluated as a 
percentage or an absolute value. 

LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line ends. 

MaximumValue (Page 5427) P, A P, A Specifies the maximum value of the scale in the selected object. 
MinimumValue (Page 5448) P, A P, A Specifies the minimum value of the scale in the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
Precision (Page 5494) P P Specifies the number of decimal places (0 to 20). 
ProcessValue (Page 5497) P, A P, A Specifies the default for the value to be displayed. 
ScaleColor (Page 5516) P, A P, A Specifies the color of the scale of the selected object. 
ScaleGradation (Page 5517) P, A P, A Specifies the distance between two large tick marks of the scale. 
ScaleLabelFieldLength * - - Distance to the position of the axis label. 
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Properties Read Write Description
ScaleLabelingDoubleLined - - Specifies that the horizontal bar orientation of the scale has two 

lines. 
ScalePosition (Page 5519) P P Specifies the position of the scale of the selected object. 
ScaleStart - - Specifies the minimum of the scale. 
ScalingType (Page 5523) P P Specifies the type of bar scaling. 
SegmentColoring (Page 5527) P, A P, A Specifies the type of color change to be displayed in the "Bar" 

object if limits are exceeded. 
ShowBadTagState (Page 5551) P P Specifies whether an object is grayed out if its associated tag has 

a bad quality code or tag state.
ShowLargeTicksOnly 
(Page 5556) 

P P Specifies or returns the length of axis sections in pixels. 

ShowLimitLines - - Specifies the display of a line at the limits. 
ShowLimitMarkers (Page 5556) P P Specifies whether the limit values are shown as a scale value. 
ShowScale (Page 5562) P P Specifies whether the values are also shown in a scale. 
ShowSignForPositiveLabel - - Specifies that a "+" is displayed for positive labels. 
ShowTickLabels (Page 5567) - - Specifies whether the label is shown in the scale. 
ShowTrendIndicator 
(Page 5571) 

P P Specifies whether the trend (rising or falling) of the measured value 
to be monitored is indicated by means of a small arrow. 

StartValue (Page 5581) P P Specifies the zero point value for the scale display. 
ToleranceLowerLimit 
(Page 5646) 

P P Specifies whether the "ToleranceLowerLimit" limit is monitored. 

ToleranceLowerLimitColor 
(Page 5646) 

P P Specifies the color for the "ToleranceLowerLimit" low limit. 

ToleranceLowerLimitEnabled 
(Page 5647) 

P P Specifies whether the "ToleranceLowerLimit" limit is monitored. 

ToleranceUpperLimit 
(Page 5648) 

P P Specifies whether the "ToleranceUpperLimit" limit is monitored. 

ToleranceUpperLimitColor 
(Page 5648) 

P P Specifies the color for the "ToleranceUpperLimit" high limit. 

ToleranceUpperLimitEnabled 
(Page 5649) 

P P Specifies whether the "ToleranceUpperLimit" limit is monitored. 

ToleranceUpperLimitRelative 
(Page 5650) 

P P Specifies whether the "ToleranceHigh" low limit is evaluated as a 
percentage or an absolute value. 

ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object. 
TrendIndicatorColor 
(Page 5674) 

P P Specifies the color for the trend view. 

Unit (Page 5700) P, A P, A Specifies the unit of measurement in the "IOField" object. 
UseAutoScaling - - Specifies auto-scaling. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

UseExponentialFormat 
(Page 5710) 

P P Specifies whether the numbers are displayed with exponentials 
(e.g. "1.00e+000"). 
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Properties Read Write Description
Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
WarningLowerLimit (Page 5739) P P Specifies the "WarningLowerLimit" low limit. 
WarningLowerLimitColor 
(Page 5740) 

P P Specifies the color for the "WarningLowerLimit" low limit. 

WarningLowerLimitEnabled 
(Page 5740) 

P P Specifies whether the "WarningLowerLimit" limit is monitored. 

WarningLowerLimitRelative 
(Page 5741) 

P P Specifies whether the "WarningLowerLimit" low limit is evaluated 
as a percentage or an absolute value. 

WarningUpperLimit (Page 5744) P P Specifies the "WarningUpperLimit" high limit. 
WarningUpperLimitColor 
(Page 5744) 

P P Specifies the color for the "WarningUpperLimit" high limit. 

WarningUpperLimitEnabled 
(Page 5745) 

P P Specifies whether the "WarningUpperLimit" limit is monitored. 

WarningUpperLimitRelative 
(Page 5745) 

P P Specifies whether the "WarningUpperLimit" high limit is evaluated 
as a percentage or an absolute value. 

Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 
objects. 

ZeroPoint (Page 5775) P P Specifies the position of the zero point as a percentage of the bar 
height. 

* not visible in the ES

Table 10-28 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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BatteryView

Description

Represents the "Charge condition" object. The BatteryView object is an element of the 
ScreenItems list.     

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-29 Properties

Properties Read Write Description
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5001



Table 10-30 Methods

Methods Valid Description
  Not found
   
   

 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

Button

Description

Represents the "Button" object. The Button object is an element of the ScreenItems list.     

The availability of the following object properties depends on the selected mode of the "button":

Property "Text" "Text list" "Graphic"
TextOff x -- --
TextOn x -- --
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Type identifier in VBS
HMIButton

 

Abbreviation Validity
Pa Panels
A RT Advanced
P RT Professional

 

Table 10-31 Properties

Properties Read Write Description
AdaptBorder (Page 5193) P P Specifies whether the border of the specified object is dynamically 

adapted to the text size.  
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff 
(Page 5224) 

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 5225) 

P P Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 5226) 

P P Specifies whether the background of the specified object flashes in 
runtime. 

BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected object. 
BitNumber (Page 5233) - - Specifies the bit whose status must change to trigger a value 

change.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderBrightColor3D 
(Page 5237) 

P P Specifies the border color of the following border parts in the 3D 
display of the selected object. 

BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderShadeColor3D 
(Page 5248) 

P P Specifies the border color of the following border parts in the 3D 
display of the selected object. 

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
BorderWidth3D (Page 5254) P P Specifies the width of the border for 3D display of the selected object. 
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Properties Read Write Description
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5310) P P Specifies the line style of the selected object.  
Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length in all 

languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 5345) A A Specifies the border width of the specified object when the object is 

in focus.  
Font (Page 5347) - - Specifies or returns the font.  
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in italics. 
FontName (Page 5350) P P Specifies the font of the selected object.  
FontSize (Page 5351) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HorizontalAlignment 
(Page 5374) 

P, A P, A Specifies the horizontal alignment of the text within the selected 
object. 

HotKey (Page 5376) - - Specifies the hotkey. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line ends. 

Mode (Page 5450) P P Specifies the field type of the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
PictureAlignment (Page 5489) P P Specifies or returns the display type of the background image in the 

process picture.  
PictureList - - Specifies the graphic list that supplies the object with values. 
PictureOff (Page 5490) P P Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 5491) P P Specifies the screen to be displayed in the "On" state.  
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Properties Read Write Description
Pressed (Page 5495) P P Specifies whether the selected object is displayed in a pressed 

state.  
ProcessValue (Page 5498) - - Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
StyleSettings (Page 5595) P P Specifies the display style for the object:  
TextList (Page 5608) - - A list that contains the assignments between the output value and 

the output text to be actually output.  
TextOff (Page 5608) P, A P, A Specifies the text to be displayed in the "Off" state of the selected 

object.  
TextOn (Page 5609) A A Specifies the text to be displayed in the "On" state of the selected 

object.  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
Toggle (Page 5644) P P Specifies whether the selected object engages after it has been 

operated in runtime. 
ToolTipText (Page 5661) P P, A Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
TransparentColorPictureOff 
(Page 5669) 

P P Specifies the color to be set to "transparent" for the "Off" state of the 
assigned bitmap object. 

TransparentColorPictureOn 
(Page 5670) 

P P Specifies the color to be set to "transparent" for the "On" state of the 
assigned bitmap object. 

UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

UseTransparentColorPictureOff
 (Page 5718) 

P P Specifies whether  the transparent color defined in the 
"TransparentColorPictureOff" property is used for the "Off" state. 

UseTransparentColorPictureOn
 (Page 5718) 

P P Specifies whether the transparent color defined in the 
"TransparentColorPictureOn" property is used for the "On" state. 

VerticalAlignment (Page 5733) P, A P, A Specifies the vertical alignment of the text for the selected object. 
Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowsStyle (Page 5750) P P Specifies whether the object is displayed in the general Windows 

style. 
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Table 10-32 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 5779) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

ChannelDiagnose

Description

Represents the "ChannelDiagnose" object. The ChannelDiagnose object is an element of the 
ScreenItems list. 
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Type identifier in VBS
HMIChannelDiagnose     

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-33 Properties

Properties Read Write Description
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
Flashing * - - Specifies that the text block flashes. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
Name (Page 5452) P - Returns the object name as STRING. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-34 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5007



CheckBox

Description

Represents the "Check box" object. The CheckBox object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMICheckBox

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-35 Properties

Properties Read Write Description
AdaptBorder (Page 5193) P P Specifies whether the border of the specified object is dynamically 

adapted to the text size.  
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
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Properties Read Write Description
BackFlashingColorOff 
(Page 5224) 

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 5225) 

P P Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 5226) 

P P Specifies whether the background of the specified object flashes 
in runtime. 

BackFlashingRate (Page 5226) P P  Specifies the flash rate of the background for the selected object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CheckmarkAlignment 
(Page 5269) 

P P Specifies whether the fields are right aligned. 

CheckmarkCount (Page 5269) P P Specifies the number of fields. 
CornerStyle (Page 5286) - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5310) - - Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Font (Page 5347) - - Specifies or returns the font.  
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in italics. 
FontName (Page 5350) P P Specifies the font of the selected object.  
FontSize (Page 5351) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 5352) P P Specifies the font color of the text for the selected object. 
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Properties Read Write Description
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalAlignment 
(Page 5374) 

P P Specifies the horizontal alignment of the text within the selected 
object. 

Index (Page 5378) P P Specifies the background for grid control elements. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

- - Specifies the shape of the line ends. 

LogOperation (Page 5420) P P Specifies whether, after operating this object, an alarm is output 
to the alarm system.  

Name (Page 5452) P P Returns the object name as STRING. 
ProcessValue (Page 5497) P P Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowBadTagState (Page 5551) P P Specifies whether an object is grayed out if its associated tag has 

a bad quality code or tag state. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
Text (Page 5607) P P Specifies the label for the text field.  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
Texts - - Specifies the texts for the check boxes. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

VerticalAlignment (Page 5733) P P Specifies the vertical alignment of the text for the selected object. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-36 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime.
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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Circle

Description

Represents the "Circle" object. The Circle object is an element of the ScreenItems list. 

Type identifier in VBS
HMICircle

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-37 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P, A P, A Specifies the line color of the object. 
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Properties Read Write Description
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame 
(Page 5307) 

P P Specifies whether the border line of the selected object with a line 
thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5310) A A Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 

Name (Page 5452) P, A - Returns the object name as STRING. 
Radius (Page 5501) P P, A Specifies the radius of the selected object "Circle". 
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-38 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

CircleSegment

Description

Represents the "CircleSegment" object. The CircleSegment object is an element of the 
ScreenItems list.

Type identifier in VBS
HMICircleSegment
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-39 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for 

the selected object.  
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff (Page 5242) P P Specifies the border line color of the selected object for the 

flash state "Off".  
BorderFlashingColorOn (Page 5243) P P Specifies the border line color of the selected object for the 

flash state "On".  
BorderFlashingEnabled (Page 5244) P P Specifies whether the border line of the selected object 

flashes in runtime. 
BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected 

object.  
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with 

a line thickness greater than 1 should be drawn within the 
border or symmetrically to the border. 

EdgeStyle (Page 5309) P P Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime.  
EndAngle (Page 5316) P P Specifies the angle at which the end point of the selected 

object deviates from the zero position (0°).  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the 

flash state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the 

flash state "On".  
FlashingEnabled P P Specifies whether the border line of the selected object 

flashes in runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected 

object.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
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Properties Read Write Description
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
Name (Page 5452) P - Returns the object name as STRING. 
Radius (Page 5501) P P Specifies the radius of the selected object "Circle". 
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
StartAngle (Page 5578) P P Specifies the SQL statement. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

Table 10-40 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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CircularArc

Description

Represents the "CircularArc" object. The CircularArc object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMICircularArc

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-41 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
Color (Page 5272) P P Specifies the line color of the selected object.  
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
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Properties Read Write Description
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
EndAngle (Page 5316) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°).  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
Radius (Page 5501) P P Specifies the radius of the selected object "Circle". 
StartAngle (Page 5578) P P Specifies the SQL statement. 
Style (Page 5594) P P Specifies the line style of the selected object.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-42 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 4970)

Clock

Description

Represents the "Clock" object. The Clock object is an element of the ScreenItems list. 

Type identifier in VBS
Clock

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-43 Properties

Properties Read Write Description
Analog (Page 5207) P P Specifies whether the clock is displayed as an analog clock.  
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
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Properties Read Write Description
DialColor (Page 5302) P, A P, A Specifies the color of the dial in the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
Flashing - - Specifies that the text block flashes. 
Font (Page 5347) - - Specifies or returns the font.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HourNeedleHeight 
(Page 5376) 

P, A P, A Specifies the length of the hour hand in the "Clock" object. 

HourNeedleWidth 
(Page 5377) 

P, A P, A Specifies the width of the hour hand in the "Clock" object.  

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LockSquaredExtent 
(Page 5419) 

P P Specifies whether the tag values are downloaded from the logs for the 
time range to be displayed when you call a screen. 

MinuteNeedleHeight 
(Page 5449) 

P, A P, A Specifies the length of the minute hand in the "Clock" object.  

MinuteNeedleWidth 
(Page 5450) 

P, A P, A Specifies the width of the minute hand in the "Clock" object.  

Name (Page 5452) P, A - Returns the object name as STRING. 
NeedleBorderColor 
(Page 5455) 

P, A P, A Specifies the name of the data source. 

NeedleColor (Page 5456) P, A P, A Specifies the hand color in the "Clock" object. 
NeedleFillStyle (Page 5456) P P Specifies the fill style for the clock hand. 
Picture (Page 5488) - - Specifies the screen to be displayed in the graphics object in runtime.  
SecondNeedleHeight 
(Page 5526) 

P, A P, A Specifies the length of the seconds hand in the "Clock" object. 

SecondNeedleWidth 
(Page 5526) 

P, A P, A Specifies the width of the seconds hand in the "Clock" object. 

ShowFocusRectangle 
(Page 5555) 

P P Specifies whether the button receives a selection border when it is 
activated in runtime.  

ShowTicks (Page 5568) P, A P, A Specifies whether the tick marks are displayed in the scale of the 
object. 

TicksColor (Page 5612) P, A P, A Specifies the scale display. 
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-44 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

Connector

Description

Represents the "Connector" object. The Connector object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMIConnector
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-45 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BorderEndStyle (Page 5241) P P Specifies the type of line ends for the selected object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
Color (Page 5272) P P Specifies the line color of the selected object.  
ConnectionType (Page 5285) P P Specifies the type of connector. You can select one of two 

connection types.  
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
EndStyle (Page 5318) - - Specifies how the line end of the selected object is displayed. 
FirstConnectedObjectIndex 
(Page 5334) 

P P Specifies the index number of the upper connector point.  

FirstConnectedObjectName 
(Page 5335) 

P P Specifies the name of the object that is docked to the upper 
connector point. 

Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
LastConnectedObjectIndex 
(Page 5387) 

P P Specifies the index number of the connection point to the last 
connected object.  

LastConnectedObjectName 
(Page 5387) 

P P Specifies the name of the object that is docked to the lower connector 
point. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 

LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P P Returns the object name as STRING. 
Points * - - Specifies the corner points. 
StartStyle (Page 5580) - - Specifies how the line start of the selected object is displayed. 
Style (Page 5594) P P Specifies the line style of the selected object.  
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Properties Read Write Description
SwapFirstWithLastConnection 
(Page 5596) 

P P Specifies whether the text in the object is shown horizontally. 

ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies that the font size from the data source should be used. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-46 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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DateTimeField

Description

Represents the "Date/time field" object. The DateTimeField object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIDateTimeField

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-47 Properties

Properties Read Write Description
Authorization (Page 5212) - - Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5219) A A Specifies the background color of the selected object. 
BackFillStyle (Page 5223) - - Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) * - - Specifies the background color of the broken border line for the 

selected object.  
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Properties Read Write Description
BorderColor (Page 5239) A A Specifies the line color of the object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
DisplaySystemTime - - Specifies that the system time is displayed. 
EdgeStyle (Page 5309) - - Specifies the line style of the selected object.  
Enabled (Page 5314) A A Specifies whether the selected object can be operated in runtime.  
FitToLargest - - Specifies that the size of the object depends on the text length in all 

languages. 
Flashing - - Specifies that the text block flashes. 
Font (Page 5347) * - - Specifies or returns the font.  
ForeColor (Page 5353) A A Specifies the font color of the text for the selected object. 
Format - - Specifies that the format of the text block is displayed. 
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HorizontalAlignment 
(Page 5375) 

A A Specifies the horizontal alignment of the text within the selected object. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
LineWrap * - - Specifies the line break within the object. 
LongDateTimeFormat - - Specifies that the date and time are displayed in long format. 
Mode (Page 5450) - - Specifies the field type of the selected object. 
Name (Page 5452) A - Returns the object name as STRING. 
ProcessValue (Page 5497) A A Specifies the default for the value to be displayed.  
ShowDate - - Specifies that the date is to be displayed. 
ShowTime - - Specifies that only the time is displayed.
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
VerticalAlignment (Page 5733) A A Specifies the vertical alignment of the text for the selected object. 
Visible (Page 5735) * A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-48 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)
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ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

DiskSpaceView

Description

Represents the "Disk space view" object. The DiskSpaceView object is an element of the 
ScreenItems list. 

Type identifier in VBS
IXDiskSpaceView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-49 Properties

Properties Read Write Description
Alarm (Page 5196) P P Specifies the limit for the memory space view from which an alarm is 

output.  
AlarmColor (Page 5197) P P Specifies the alarm types to be displayed in the alarm view. 
Drive (Page 5308) P P Specifies the characters of the drive that is to be monitored. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
Free (Page 5356) P P Returns the size of the free memory space.  
FreePercent (Page 5356) P P Returns the measured values for the free disk space as a percentage.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Interval (Page 5382) P P Specifies the time interval for updating the displayed measured values. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
Name (Page 5452) P - Returns the object name as STRING. 
NormalColor P P Specifies the color of the object in the normal range. 
Tolerance (Page 5644) P P Specifies the limit for the storage space display as of which a deviation 

will be reported.  
ToleranceColor (Page 5645) P P Specifies the colors in which the bars of the memory space display are 

shown as soon as the tolerance range is exceeded.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Total (Page 5666) P P Returns the storage capacity.  
Used (Page 5719) P P Specifies whether scrolling is enabled. 
UsedPercent (Page 5720) P P Returns the measured values for the occupied memory space as a 

percentage. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Warning (Page 5738) P P Specifies the limit for the memory space view from which a warning is 

output. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" objects. 

 

Table 10-50 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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Ellipse

Description

Represents the "Ellipse" object. The Ellipse object is an element of the ScreenItems list. 

Type identifier in VBS
HMIEllipse

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-51 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P, A P, A Specifies the line color of the object. 
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Properties Read Write Description
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5309) A A Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 

Name (Page 5452) P, A - Returns the object name as STRING. 
RadiusHeight (Page 5502) P P Specifies the minor axis of the "Ellipsis" object.  
RadiusWidth (Page 5503) P P Specifies the major axis of the "Ellipsis" object.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-52 Method

Method Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

EllipseSegment

Description

Represents the "EllipseSegment" object. The EllipseSegment object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIEllipseSegment
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-53 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash state 
"Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash state 
"On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame 
(Page 5307) 

P P Specifies whether the border line of the selected object with a line 
thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5310) P P Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
EndAngle (Page 5316) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°).  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash state 

"Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash state 

"On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
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Properties Read Write Description
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 

Name (Page 5452) P - Returns the object name as STRING. 
RadiusHeight (Page 5502) P P Specifies the minor axis of the "Ellipsis" object.  
RadiusWidth (Page 5503) P P Specifies the major axis of the "Ellipsis" object.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
StartAngle (Page 5578) P P Specifies the SQL statement. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-54 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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EllipticalArc

Description

Represents the "EllipticalArc" object. The EllipticalArc object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMIEllipticalArc

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-55 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
Color (Page 5272) P P Specifies the line color of the selected object.  
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
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Properties Read Write Description
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
EndAngle (Page 5316) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°).  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) - - Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) - - Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) - - Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) - - Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P - Returns the object name as STRING.
RadiusHeight (Page 5502) P P Specifies the minor axis of the "Ellipsis" object.  
RadiusWidth (Page 5503) P P Specifies the major axis of the "Ellipsis" object.  
StartAngle (Page 5578) P P Specifies the SQL statement. 
Style (Page 5594) P P Specifies the line style of the selected object.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  

 

Table 10-56 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 4970)

ForeignControl

Description     

Object Type of ScreenItem Object. Represents the graphic object "Control"

The control object type always assumes the properties of the control type selected. In the case 
of controls provided by WinCC, the properties are indicated under the description of the 
corresponding control.

In the case of controls from external suppliers, the control properties are supplied and thus not 
a part of this description. However, the control properties can be queried using the "Item" 
property.

Type Identifier in VBS
Special WinCC type descriptions or version-independent ProgID

Use
In the following example, the object with the name "Control1" is moved 10 pixels to the right:

 
'VBS36
Dim objControl
Set objControl = ScreenItems("Control1")
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objControl.Left = objControl.Left + 10

Special feature
The controls provided by WinCC return a special ID as the type. It can be found under the 
topic "Type Identification in VBS" in the individual descriptions of the WinCC controls.

Access to specific properties instead of event parameters of the third-party controls
The parameter list of an event with third-party control is not read in WinCC. To have access 
to custom parameters of control events, you need to implement properties in the control instead 
of parameters. 

The following code example shows the source code of the "UserControlTestModify" control, 
in which the "Title" and "Description" properties are defined instead of parameters.

 
public partial class UserControlTestModify : UserControl
    {
        public event MyEventHandler MyEvent = null;
 
        public string Title
        {
            get;
            private set;
        }
 
        public string Description
        {
            get;
            set;
        }
     
        public UserControlTestModify()
        {
            InitializeComponent();
        }
        private void OnMyEvent(Exception e)
        {
            if (this.MyEvent!= null)
            {
               //  Place place data in Properties before invoking event.
                Title = "title";
                Description = "description"; ";
                this.MyEvent.Invoke();               
            }
        }
 
        private void button1_Click(object sender, EventArgs e)
        {            
            this.OnMyEvent (null);            
        }
    }
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The specific properties of a third-party control are not displayed in WinCC with IntelliSense. 

The following example shows how to access the specific "Title" property of the third-party 
control "FControl" in WinCC :

 
HMIRuntime.Screens("StartScreen").ScreenItems("FControl").Title = "MyForeignControl"

ProgID and UserfriendlyName of third-party controls
The version-independent ProgID is returned as the type if non-WinCC controls are used.

It is possible to determine the version-dependent ProgID or "UserfriendlyName" from the 
ProgID: In the following example, "Control1" is a control embedded in the picture which already 
returns the version-independent ProgID as a result of the Type property.

 

 Note

Since not every control has a version-dependent ProgID, an error handling measure should 
be integrated to query the version-dependent ProgID or UserFriendlyName. If no error 
handling is used, the code is terminated immediately without any result when no ProgID is 
found.

 

Determine the version-dependent ProgID as follows:

 
'VBS37
Dim objControl
Dim strCurrentVersion
Set objControl = ScreenItems("Control1")
strCurrentVersion = CreateObject("WScript.Shell").RegRead("HKCR\" & objControl.Type & 
"\CurVer\")
MsgBox strCurrentVersion

 
 

 Note

In order that example above works, a multimedia control should be inserted in the picture.
 

Determine the UserFriendlyName as follows:

 
'VBS38
Dim objControl
Dim strFriendlyName
Set objControl = ScreenItems("Control1")
strFriendlyName = CreateObject("WScript.Shell").RegRead("HKCR\" & objControl.Type & "\")
MsgBox strFriendlyName
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 Note

In order that example above works, a multimedia control should be inserted in the picture.
 

If a non-WinCC control is used, it is possible that the properties provided by the control have 
the same names as the general ScreenItem properties. In such cases, the ScreenItem 
properties have priority. The "hidden" properties of an external control supplier can be 
accessed using the additional "object" property. Address the properties of an external control 
supplier as follows: 

 
Control.object.type

 

The properties of the ScreenItem object are used in the case of identical names, if you use 
the following form: 

 
Control.type

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-57 Properties

Properties Read Write Description
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
Name (Page 5452) P - Returns the object name as STRING. 
OCXState (Page 5463) * - - Sets the OCX status. 
ProgID (Page 5499) * - - The version-independent ProgID is returned as the type if non-

WinCC controls are used. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES
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Table 10-58 Methods

Methods Valid Description
   
   
   
   

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

FunctionTrendControl

Description

Represents the "f(x)FunctionTrendView" object. The FunctionTrendControl object is an 
element of the ScreenItems list.

Type identifier in VBS
HMIFunctionTrendControl
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-59 Properties

Properties Read Write Description
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime.
Height (Page 5361) P - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
ObjectName (Page 5460) P - Returns the object name as STRING. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Type (Page 5697) P - Returns the type of the specified object as STRING.
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

Table 10-60 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 5783) P, A Executes the "Connect backup" button function of the control.
DeactivateDynamic (Page 5786) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
DetachDB (Page 5789) P, A Executes the "Disconnect backup" button function of the control.
Export (Page 5790) P, A Executes the "Export log" or "Export data" button function of the control.
GetStatusbarElement (Page 5817) P, A Returns the element of the control's status bar designated by name or 

index as "ICCAxStatusbarElement" type.
GetStatusbarElementCollection 
(Page 5818) 

P, A Returns the list of all status bar elements of the control as 
"ICCAxCollection" type.

GetToolbarButton (Page 5825) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 5826) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

GetTrend (Page 5827) P, A Returns the f(t) or f(x) trend view designated by name or index as 
"ICCAxTrend" or "ICCAxFunctionTrend" type.

GetTrendCollection (Page 5828) P, A Returns the list of all trends of the f(t) or f(x) trend view as 
"ICCAxCollection" type.

GetTrendWindow (Page 5830) P, A Returns the trend window object of the f(t) or f(x) trend view designated 
by name or index as "ICCAxTrendWindow" type.
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Methods Valid Description
GetTrendWindowCollection 
(Page 5831) 

P, A Returns the list of all trend window objects of the f(t) or f(x) trend views 
as "ICCAxCollection" type.

GetXAxis (Page 5837) P, A Returns the X axis object of the f(x) trend view designated by name or 
index as "ICCAxValueAxis" type.

GetXAxisCollection (Page 5838) P, A Returns the list of all X axis objects of the f(x) trend view as 
"ICCAxCollection" type.

GetYAxis (Page 5839) P, A Returns the Y axis object of the f(x) trend view designated by name or 
index as "ICCAxValueAxis" type.

GetYAxisCollection (Page 5840) P, A Returns the list of all Y axis objects of the f(x) trend view as 
"ICCAxCollection" type.

MoveAxis (Page 5846) P, A Executes the "Move axes area" button function of the f(t) and f(x) trend 
views.

NextTrend (Page 5853) P, A Executes the "Next trend" button function of the f(t) and f(x) trend views.
OneToOneView (Page 5853) P, A Executes the "Original view" button function of the f(t) and f(x) trend 

views.
PreviousTrend (Page 5855) P, A Executes the "Previous trend" button function of the f(t) and f(x) trend 

views.
Print (Page 5855) P, A Executes the "Print" button function of the control.
ShowHelp (Page 5875) P, A Executes the "Help" button function of the control.
ShowPropertyDialog (Page 5880) P, A Executes the "Configuration dialog" button function of the control.
ShowTagSelection (Page 5884) P, A Executes the "Select data connection" button function of the control.
ShowTimeSelection (Page 5885) P, A Executes the "Select time range" button function of the control.
ShowTrendSelection (Page 5885) P, A Executes the "Select trends" button function of the f(t) and f(x) trend 

views.
StartStopUpdate (Page 5886) P, A Executes the "Start" or "Stop" button function of the control.
ZoomArea (Page 5893) P, A Executes the "Zoom area" button function of the f(t) and f(x) trend views.
ZoomInOut (Page 5894) P, A Executes the "Zoom +/-" button function of the f(t) and f(x) trend views.
ZoomInOutX (Page 5895) P, A Executes the "Zoom X axis +/-" button function of the f(x) trend view.
ZoomInOutY (Page 5896) P, A Executes the "Zoom Y axis +/-" button function of the f(x) trend view.
ZoomMove (Page 5896) P, A Executes the "Move trend area" button function of the f(t) and f(x) trend 

views.

See also
BackColor (Page 5218)

Caption  (Page 5257)

LoadDataImmediately (Page 5417)

Online  (Page 5463)

TimeBase (Page 5619)

ShowRuler  (Page 5560)

Screen object (list) (Page 4970)

ApplyProjectSettings (Page 5209)

BorderColor (Page 5238)
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BorderWidth (Page 5252)

Closable (Page 5272)

ConnectTrendWindows (Page 5285)

ExportDirectoryChangeable (Page 5322)

ExportDirectoryname (Page 5322)

ExportFileExtension (Page 5323)

ExportFilename (Page 5323)

ExportFilenameChangeable (Page 5324)

ExportFormatGuid (Page 5325)

ExportFormatName (Page 5325)

ExportParameters (Page 5326)

ExportSelection (Page 5326)

ExportShowDialog (Page 5327)

Font (Page 5347)

GraphDirection (Page 5358)

Layer (Page 5389)

LineColor (Page 5414)

LineWidth (Page 5416)

Movable (Page 5451)

Name  (Page 5452)

RTPersistence (Page 5512)

RTPersistenceType (Page 5513)

UseTrendNameAsLabel (Page 5719)

ToolbarAlignment (Page 5650)

ToolbarBackColor (Page 5650)

ToolbarButtonActive (Page 5651)

ToolbarButtonAdd (Page 5652)

ToolbarButtonBeginGroup (Page 5652)

ToolbarButtonCount (Page 5653)

ToolbarButtonEnabled (Page 5653)

ToolbarButtonHotKey (Page 5654)

ToolbarButtonID (Page 5654)

ToolbarButtonIndex (Page 5654)

ToolbarButtonLocked (Page 5655)

ToolbarButtonName (Page 5655)
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ToolbarButtonPasswordLevel (Page 5656)

ToolbarButtonRemove (Page 5656)

ToolbarButtonRename (Page 5656)

ToolbarButtonRepos (Page 5657)

ToolbarButtonTooltipText (Page 5657)

ToolbarButtonUserDefined (Page 5658)

ToolbarShowTooltips (Page 5658)

ToolbarUseBackColor (Page 5659)

ToolbarUseHotKeys (Page 5660)

ToolbarVisible (Page 5660)

TrendActualize (Page 5670)

TrendAdd (Page 5671)

TrendBeginTime (Page 5671)

TrendColor (Page 5671)

TrendCount (Page 5672)

TrendEndTime (Page 5672)

TrendExtendedColorSet (Page 5672)

TrendFill (Page 5673)

TrendFillColor (Page 5674)

TrendIndex (Page 5674)

TrendLabel (Page 5675)

TrendLineStyle (Page 5675)

TrendLineType (Page 5676)

TrendLineWidth (Page 5676)

TrendLowerLimit (Page 5677)

TrendLowerLimitColor (Page 5677)

TrendLowerLimitColoring (Page 5677)

TrendMeasurePoints (Page 5678)

TrendName (Page 5678)

TrendPointColor (Page 5678)

TrendPointStyle (Page 5679)

TrendPointWidth (Page 5679)

TrendProvider  (Page 5680)

TrendRangeType (Page 5680)

TrendRemove (Page 5681)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5042 System Manual, 02/2014



TrendRename (Page 5681)

TrendRepos (Page 5682)

TrendSelectTagNameX (Page 5682)

TrendSelectTagNameY (Page 5682)

TrendTagNameX (Page 5683)

TrendTagNameY (Page 5684)

TrendTimeRangeBase (Page 5684)

TrendTimeRangeFactor (Page 5685)

TrendTrendWindow (Page 5685)

TrendUncertainColor (Page 5685)

TrendUncertainColoring (Page 5686)

TrendUpperLimit (Page 5686)

TrendUpperLimitColor (Page 5687)

TrendUpperLimitColoring (Page 5687)

TrendVisible (Page 5687)

TrendWindowAdd (Page 5688)

TrendWindowCoarseGrid (Page 5688)

TrendWindowCoarseGridColor (Page 5689)

TrendWindowFineGrid (Page 5689)

TrendWindowFineGridColor (Page 5690)

TrendWindowForegroundTrendGrid (Page 5690)

TrendWindowGridInTrendColor (Page 5690)

TrendWindowHorizontalGrid (Page 5691)

TrendWindowIndex (Page 5692)

TrendWindowName (Page 5692)

TrendWindowRemove (Page 5692)

TrendWindowRename (Page 5692)

TrendWindowRepos (Page 5693)

TrendWindowRulerColor (Page 5693)

TrendWindowRulerLayer (Page 5693)

TrendWindowRulerStyle (Page 5694)

TrendWindowRulerWidth (Page 5695)

TrendWindowSpacePortion (Page 5695)

TrendWindowVerticalGrid (Page 5695)

TrendWindowVisible (Page 5696)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5043



TrendXAxis (Page 5696)

TrendYAxis (Page 5696)

ShowRulerInAxis (Page 5561)

ShowScrollbars (Page 5562)

ShowTitle (Page 5569)

ShowTrendIcon (Page 5570)

StatusbarBackColor (Page 5582)

StatusbarElementAdd (Page 5582)

StatusbarElementAutoSize (Page 5583)

StatusbarElementCount (Page 5583)

StatusbarElementIconId (Page 5584)

StatusbarElementID (Page 5584)

StatusbarElementIndex (Page 5585)

StatusbarElementName (Page 5585)

StatusbarElementRemove (Page 5586)

StatusbarElementRename (Page 5586)

StatusbarElements (Page 5586)

StatusbarElementTooltipText (Page 5587)

StatusbarElementUserDefined (Page 5587)

StatusbarElementVisible (Page 5588)

StatusbarElementWidth (Page 5589)

StatusbarFontColor (Page 5589)

StatusbarShowTooltips (Page 5591)

StatusbarText (Page 5592)

StatusbarUseBackColor (Page 5593)

StatusbarVisible (Page 5593)

XAxisAdd (Page 5751)

XAxisAutoPrecisions (Page 5752)

XAxisAutorange(i)  (Page 5752)

XAxisBeginValue (Page 5753)

XAxisColor (Page 5754)

XAxisCount (Page 5754)

XAxisEndValue (Page 5756)

XAxisExponentialFormat (Page 5756)

XAxisIndex (Page 5757)
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XAxisInTrendColor (Page 5757)

XAxisName (Page 5759)

XAxisPrecisions (Page 5760)

XAxisRemove (Page 5760)

XAxisRepos (Page 5760)

XAxisTrendWindow (Page 5763)

XAxisVisible (Page 5764)

YAxisAdd (Page 5765)

YAxisAutoPrecisions (Page 5766)

YAxisAutoRange (Page 5767)

YAxisBeginValue (Page 5767)

YAxisColor (Page 5768)

YAxisCount (Page 5768)

YAxisEndValue (Page 5768)

YAxisExponentialFormat (Page 5769)

YAxisIndex (Page 5769)

YAxisInTrendColor (Page 5770)

YAxisLabel (Page 5770)

YAxisName (Page 5770)

YAxisPrecisions (Page 5771)

YAxisRemove (Page 5771)

YAxisRepos (Page 5772)

YAxisScalingType (Page 5772)

YAxisTrendWindow (Page 5773)

YAxisVisible (Page 5773)

SkinName (Page 5573)

RTPersistencePasswordLevel (Page 5513)
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Gauge

Description

Represents the "Gauge" object. The Gauge object is an element of the ScreenItems list. 

Type identifier in VBS
HMIGauge

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-61 Properties

Properties Read Write Description
AngleMax (Page 5207) P, A P, A Specifies the angle for the scale end of the "Gauge" object. 
AngleMin (Page 5208) P, A P, A Specifies the angle for the scale start of the "Gauge" object. 
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackPicture - - Specifies a graphic for the background. 
BorderInnerStyle3D (Page 5246) P P Specifies the representation of the inner part of the object border. 
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Properties Read Write Description
BorderOuterStyle3D 
(Page 5247) 

P P Specifies the representation of the outer part of the object border. 

BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
BorderWidth3D (Page 5254) P P Specifies the width of the border for 3D display of the selected 

object. 
CaptionColor (Page 5259) P, A P, A Specifies the color of the text that is displayed in the header of 

the selected object.  
CaptionFont - - Specifies the character set for the caption. 
CaptionText (Page 5260) P, A P, A Specifies the text that is displayed in the header of the selected 

object. 
CaptionTop (Page 5261) P P Specifies the distance of the instrument label from the top edge 

of the selected object. 
CenterColor (Page 5264) P, A P, A Sets the color for the center point of the "Gauge" object. 
CenterSize (Page 5265) P P Sets the diameter of the round scale center point.  
DangerRangeColor (Page 5295) P, A P, A Sets the color of the danger range on the scale of the "Gauge" 

object. 
DangerRangeStart (Page 5296) P, A P, A Specifies the scale value at which the danger range of the 

"Gauge" object begins.  
DangerRangeVisible 
(Page 5296) 

P, A P, A Specifies whether the danger range is displayed in the scale of 
the "Gauge" object. { 

DialColor (Page 5302) P, A P, A Specifies the color of the dial in the selected object.  
DialFillStyle (Page 5302) P P Specifies the type of background for the selected object. 
DialPicture - - Specifies a graphic for the dial. 
DialSize (Page 5303) P P Specifies the diameter of the scale disc based on the smaller 

value of the "Width" and "Height" geometry attributes.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime.  
Flashing * - - Specifies that the text block flashes. 
Gradation (Page 5357) P, A P, A Specifies the value difference between two main tick marks of 

the "Gauge" object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LockSquaredExtent (Page 5419) P P Specifies whether the tag values are downloaded from the logs 

for the time range to be displayed when you call a screen. 
MaximumValue (Page 5427) P, A P, A Specifies the maximum value of the scale in the selected object.  
MinimumValue (Page 5448) P, A P, A Specifies the minimum value of the scale in the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
NormalRangeColor (Page 5457) P, A P, A Specifies the color of the normal range on the scale of the 

"Gauge" object. " 
NormalRangeVisible 
(Page 5458) 

P, A P, A Specifies whether the normal range in the scale of the "Gauge" 
object will be displayed. 

PointerColor (Page 5493) P, A P, A Specifies the pointer color of the "Gauge" object. 
ProcessValue (Page 5497) P, A P, A Specifies the default for the value to be displayed.  
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Properties Read Write Description
ScaleLabelColor (Page 5518) P, A P, A Specifies the color of the label for the scale tick marks of the 

"Gauge" object. 
ScaleLabelFont - - Specifies the font of the scale label. 
ScaleTickColor (Page 5519) P, A P, A Specifies the color of the scale tick marks of the "Gauge" object. 
ScaleTickLabelPosition 
(Page 5520) 

P P Specifies the diameter of the imaginary circle on which the scale 
tick label is location.  

ScaleTickLength (Page 5520) P P Specifies the length of the main scale ticks.  
ScaleTickPosition (Page 5521) P P Specifies the diameter of the assumed circle on which the scale 

divisions are located. 
ShowDecimalPoint (Page 5554) P P Specifies whether the scale is labeled with decimal figures 

(decimal point and one decimal place) or with whole integers.  
ShowPeakValuePointer 
(Page 5558) 

P, A P, A Specifies whether a slave pointer will be used for the selected 
object. 

Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UnitColor (Page 5700) P, A P, A Specifies the text color for the label of the measurement unit in 

the "Gauge" object. 
UnitFont - - Specifies the font for the unit. 
UnitText (Page 5701) P, A P, A Specifies the text for the measurement unit of the selected object. 
UnitTop (Page 5702) P P Specifies the distance of the measurement unit from the upper 

edge of the selected object. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
WarningRangeColor 
(Page 5742) 

P, A P, A Specifies the color of the warning range on the scale of the 
"Gauge" object. 

WarningRangeStart (Page 5742) P, A P, A Specifies the scale value from which the warning range of the 
"Gauge" object begins. 

WarningRangeVisible 
(Page 5743) 

P, A P, A Specifies whether the warning range is displayed in the scale of 
the "Gauge" object. 

Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 
objects. 

* not visible in the ES

Table 10-62 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 4970)

GraphicIOField

Description

Represents the "Graphic I/O field" object. The GraphicIOField object is an element of the 
ScreenItems list. 

     

The availability of the following object properties depends on the selected mode:

Property "Input" "Output" "Input/Output" "Two states"
BorderColor -- -- -- x
BorderStyle3D x x x --
Enabled x -- x --
FocusColor x -- x --
FocusWidth x -- x --
HelpText x -- x --
TransparentColor x x x --
UseTransparentC
olor

x x x --

Type identifier in VBS
HMIGraphicIOField
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-63 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 5184) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

AdaptPicture - - Specifies that the size of the object is automatically adjusted in 
runtime. 

Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
AutoSizing - - Specifies that the size of the object should be automatically 

adapted to the content. 
BackColor (Page 5218) A A Specifies the background color of the selected object. 
BelowLowerLimitColor 
(Page 5233) 

- - Sets the color of the specified object for the "Low limit violated" 
event. 

BitNumber (Page 5233) - - Specifies the bit whose status must change to trigger a value 
change.  

BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 
selected object.  

BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a 

line thickness greater than 1 should be drawn within the border 
or symmetrically to the border. 

EdgeStyle (Page 5310) P P Specifies the line style of the selected object.  
Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in 

runtime.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes 

in runtime.  
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
FlashTransparentColor 
(Page 5343) 

P P Specifies the color of the bitmap object of a flashing graphic that 
is set to "transparent". 

FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object 
when it is in focus. 

FocusWidth (Page 5345) A A Specifies the border width of the specified object when the object 
is in focus.  

Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 
"Rectangle" objects.  

HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for the 
specified object.  

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line ends. 
Mode (Page 5450) - - Specifies the field type of the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
OnValue - - Specifies the value for the "ON" state in "two-state" mode. 
PictureList - - Specifies the graphic list that supplies the object with values. 
PictureOff (Page 5490) - - Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 5491) - - Specifies the screen to be displayed in the "On" state.  
ProcessValue (Page 5497) P P Specifies the default for the value to be displayed.  
ScrollBarOrientation - - Specifies the orientation of the scroll bar. 
ShowScrollBar - - Specifies the scroll bar type. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
TransparentColor (Page 5668) P, A P, A Specifies which color of the allocated graphic (*.bmp, *dib) of the 

specified object is set to "transparent". 
UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

UseFlashTransparentColor 
(Page 5710) 

P P Specifies whether the color of the bitmap object of a flashing 
graphic is set to "transparent". 

UseTransparentColor 
(Page 5717) 

P, A P, A Specifies whether the color defined with the property 
"TransparentColor" is shown as transparent for the selected 
object. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-64 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 5779) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

GraphicView

Description

Represents the "Graphic view" object. The GraphicView object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIGraphicView
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-65 Properties

Properties Read Write Description
AdaptPicture A - Specifies that the size of the object is automatically adjusted in 

runtime. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
AutoSizing - - Specifies that the size of the object should be automatically 

adapted to the content. 
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff 
(Page 5225) 

P P Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 5224) 

P P Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 5226) 

P P Specifies whether the background of the specified object flashes 
in runtime. 

BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5310) P P Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length in 

all languages. 
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line ends. 
Name (Page 5452) P, A - Returns the object name as STRING. 
Picture (Page 5488) P P Specifies the screen to be displayed in the graphics object in 

runtime.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
TransparentColor (Page 5668) P, A P, A Specifies which color of the allocated graphic (*.bmp, *dib) of the 

specified object is set to "transparent". 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

UseTransparentColor 
(Page 5717) 

P, A P, A Specifies whether the color defined with the property 
"TransparentColor" is shown as transparent for the selected 
object. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-66 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 5779) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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Group

Description

Represents the "Group" object. The Group object is an element of the ScreenItems list.

Type identifier in VBS
HMIGroup

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-67 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
ForeColor (Page 5352) P P Specifies the font color of the text for the selected object. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
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Properties Read Write Description
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
Name (Page 5452) - - Returns the object name as STRING. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-68 Methods

Methods Valid Description
   
   
   
   
   
   

 

See also
Screen object (list) (Page 4970)
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HTMLBrowser

Description

Represents the object "HTML Browser". The HTMLBrowser-object is an element of the 
ScreenItems-list.

Type identifier in VBS
HMIHTMLBrowser

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-69 Properties

Properties Read Write Description
Address (Page 5195) P, A P, A Defines the Web address which is opened in the HTML browser. 
Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in runtime.  
Flashing * - - Specifies that the text block flashes. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
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Properties Read Write Description
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
ShowStatusBar 
(Page 5565) 

P P Specifies whether the status bar is shown.  

ShowToolBar (Page 5569) * - - Specifies whether the toolbar is shown.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-70 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

SetHtml ??  

 

See also
Screen object (list) (Page 4970)
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IOField

Description

Represents the "I/O field" object. The IOField object is an element of the ScreenItems list. 

Type identifier in VBS
HMIIOField

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-71 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 5184) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

AcceptOnExit (Page 5185) P P Specifies whether the input field is confirmed automatically 
when it is left. 

AcceptOnFull (Page 5185) P P Specifies whether the input field will be left and confirmed 
automatically when the defined number of values has been 
entered. 
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Properties Read Write Description
AdaptBorder (Page 5193) P P Specifies whether the border of the specified object is 

dynamically adapted to the text size. 
AskOperationMotive (Page 5210) P P Specifies whether the reason for operating this object is logged. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object. 
BackFlashingColorOff (Page 5224) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 5225) P P Specifies the background color for flash state "On". 
BackFlashingEnabled (Page 5226) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected 

object. 
BelowLowerLimitColor (Page 5233) - - Sets the color of the specified object for the "Low limit violated" 

event. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 5238) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off". 

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On". 

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
BottomMargin - - Sets the margin between the text and the bottom edge of the 

object. 
ClearOnError (Page 5270) P P Specifies whether an invalid input in this object is deleted 

automatically. 
ClearOnFocus (Page 5271) P P Specifies whether the field entry is deleted as soon as the I/O 

field is activated. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object. 
CursorControl (Page 5292) P P Specifies whether the mouse cursor jumps to the next field of 

the TAB sequence after leaving a field. 
DataFormat (Page 5297) P P Returns the data type of the IOField object. 
EdgeStyle (Page 5310) A A Specifies the line style of the selected object. 
EditOnFocus (Page 5312) P P Specifies whether data input is immediately possible if the input 

field is selected using the "Tab" key. 
Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in 

runtime. 
FieldLength (Page 5329) – - Specifies that the "Field length string" field is read-only. 
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object. 
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
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Properties Read Write Description
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off". 
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On". 
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes 

in runtime. 
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object. 
Font (Page 5347) - - Specifies or returns the font. 
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 5350) P P Specifies the font of the selected object. 
FontSize (Page 5351) P P Specifies the font size of the text for the selected object. 
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined. 
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
FormatPattern (Page 5354) P P Specifies the format of the output value. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HiddenInput (Page 5365) P P Specifies whether the input value or a * for each character is 

shown during the input.  
HorizontalAlignment (Page 5374) P, A P, A Specifies the horizontal alignment of the text within the selected 

object. 
InputValue (Page 5380) P P Defines the value entered by the user in the IO field. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left  (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LeftMargin - A Sets the margin between the text and the left edge of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
LogOperation (Page 5420) P P Specifies whether, after operating this object, an alarm is output 

to the alarm system.  
LowerLimit (Page 5422) P P Specifies the low limit for input values. 
Mode  (Page 5450) P P Specifies the field type of the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
ProcessValue (Page 5497) P, A P, A Specifies the default for the value to be displayed. 
RightMargin - - Sets the margin between the text and the right edge of the 

object. 
ShiftDecimalPoint (Page 5549) - - Specifies that the "Shift decimal point" field is read-only. 
ShowBadTagState (Page 5551) P P Specifies whether an object is grayed out if its associated tag 

has a bad quality code or tag state. 
ShowLeadingZeros - - Specifies that leading zeros should be displayed. 
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
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Properties Read Write Description
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top  (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
TopMargin - - Sets the margin between the text and the top edge of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
Unit (Page 5700) P P Specifies the unit of measurement in the "IOField" object. 
UpperLimit (Page 5703) P P Specifies the high limit for input values. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

UseTagLimitColors P P Specifies whether the configured colors are used when limits 
are violated. 

VerticalAlignment (Page 5733) P, A P, A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

 

Table 10-72 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic (Page 5786) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5062 System Manual, 02/2014



Objects K-Z

Line

Description

Represents the "Line" object. The Line object is an element of the ScreenItems list. 

Type identifier in VBS
HMILine

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-73 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BorderEndStyle (Page 5241) P, A P, A Specifies the type of line ends for the selected object. 
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Properties Read Write Description
BorderStyle (Page 5249) P, A P, A Specifies the type of line ends for the selected object.
Color (Page 5272) P, A P, A Specifies the line color of the selected object.  
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
EndLeft - - Specifies the X position of the end point. 
EndStyle (Page 5318) P, A P, A Specifies how the line end of the selected object is displayed. 
EndTop - - Sets the Y position of the end point. 
FillStyle (Page 5333) A A Defines the fill pattern of the specified object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash state 

"Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash state 

"On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 

LineWidth (Page 5416) P, A P, A Specifies the line thickness of the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
RotationAngle (Page 5507) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft 
(Page 5508) 

P P Specifies the X coordinate of the pivot point for the object in runtime. 

RotationCenterTop 
(Page 5509) 

P P Specifies the Y coordinate of the pivot point for the object in runtime. 

StartLeft - - Specifies the X position of the starting point. 
StartStyle (Page 5580) A A Specifies how the line start of the selected object is displayed. 
StartTop (Page 5581) - - Specifies the vertical distance in pixels between the start point and 

the top edge of the screen. 
Style (Page 5594) P, A P, A Specifies the line style of the selected object.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-74 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

Listbox

Description     

Represents the "Listbox" object. The Listbox object is an element of the ScreenItems list.

Type identifier in VBS
HMIListBox
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Application
In the following example, the object with the name "ListBox1" is moved 10 pixels to the right:

 
'VBS21
Dim objListBox
Set objListBox = ScreenItems("ListBox1")
objListBox.Left = objListBox.Left + 10

 

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-75 Properties

Properties Read Write Description
AskOperationMotive (Page 5210) P P Specifies whether the reason for operating this object is logged. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object. 
CountVisibleItems (Page 5290) P P Specifies the number of lines contained in the selection list. 
EdgeStyle (Page 5310) - - Specifies the line style of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime. 
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object. 
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Font (Page 5347) - - Specifies or returns the font. 
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 5350) P P Specifies the font of the selected object. 
FontSize (Page 5351) P P Specifies the font size of the text for the selected object. 
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined. 
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Properties Read Write Description
ForeColor (Page 5352) P P Specifies the font color of the text for the selected object. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
HorizontalAlignment (Page 5374) P P Specifies the horizontal alignment of the text within the selected 

object. 
Index (Page 5378) P P Specifies the background for grid control elements. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
LogOperation (Page 5420) P P Specifies whether, after operating this object, an alarm is output 

to the alarm system. 
Name (Page 5452) P - Returns the object name as STRING. 
SelectedIndex (Page 5530) P P Specifies and returns the index whose associated text is 

highlighted in the combo or list box. 
SelectedText (Page 5528) P P Displays the text that is defined with the "Selected field" 

(SelIndex) attribute and highlighted in the combo box or list box. 
Text (Page 5607) P P Specifies the label for the text field. 
Texts - - Specifies the texts for the check boxes. 
ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

Table 10-76 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5067



ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

MediaPlayer

Description         

Represents the "Media Player" object. The MediaControl object is an element of the 
ScreenItems list.

Type Identifier in VBS
HMIMediaControl

Application
In the following example, the object with the name "Control1" is moved 16 pixels to the right:

 
'VBS60
Dim objControl
Set objControl = ScreenItems("Control1")
objControl.Left = objControl.Left + 16
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-77 Properties

Properties Read Write Description
AspectRatio P P Specifies whether the aspect ratio is maintained when the size is 

changed. 
AutoStart P P Specifies that the Media Player should start automatically. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
FileName P, A P, A Specifies the name of the file to be loaded. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
PictureSizeMode P P Specifies that the status bar is displayed. 
PlayCount A A Plays the files several times. 
PlayEndless P P Specifies that the media file should play endlessly. 
PopupMenuEnabled P P Specifies that the shortcut menu can be used. 
ShowControls P, A P, A Specifies that a toolbar is displayed. 
ShowFeatureBackward P P Specifies that the "Backward" button is displayed in runtime. 
ShowFeatureForward P P Specifies that the "Forward" button is displayed in runtime. 
ShowFeatureFullScreen P P Specifies that the Media Player can be displayed as a full screen. 
ShowFeaturePause P P Specifies that the Media Player can be displayed as a full screen 
ShowFeaturePlay P P Specifies that the "Play" button is displayed in runtime. 
ShowFeatureStop P P Specifies that the "Stop" button is displayed in runtime. 
ShowFeatureVolume P P Sets the volume. 
ShowStatusBar (Page 5565) A A Specifies whether the status bar is shown. 
ShowTracker A A Specifies that the tracker is displayed. 
StepSeconds P P Specifies a time in seconds that is to be skipped when the 

"Forward" or "Backward" button is pressed. 
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-78 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 5779) 

P Dynamically activates a trigger and the specified cycle for a property at 
runtime. 

DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the 
specified property in/during Runtime.

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

MultiLineEdit

Description     

Represents the "MultiLine text" object. The MultiLineEdit object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIMultiLineEdit
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Application
In the following example, the object with the name "MultiLineEdit1" is moved 10 pixels to the 
right:

 
'VBS21
Dim objMultiLineEdit
Set objMultiLineEdit = ScreenItems("MultiLineEdit1")
objMultiLineEdit.Left = objMultiLineEdit.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-79 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
BackColor (Page 5218) P P, A Specifies the background color of the selected object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object. 
BorderColor (Page 5238) P P Specifies the background color of the selected object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object. 
EdgeStyle (Page 5310) - - Specifies the line style of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
Font (Page 5347) - - Specifies or returns the font. 
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in italics. 
FontName (Page 5350) P P Specifies the font of the selected object. 
FontSize (Page 5351) P P Specifies the font size of the text for the selected object. 
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined. 
ForeColor (Page 5352) P P Specifies the font color of the text for the selected object. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
HorizontalAlignment 
(Page 5374) 

P P Specifies the horizontal alignment of the text within the selected 
object. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 
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Properties Read Write Description
Name (Page 5452) P - Returns the object name as STRING. 
Text (Page 5607) P P Specifies the label for the text field. 
ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-80 Methods

Methods Validity Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

GetSelectionText ??  
SetSelection ??  
SetSelectionText ??  

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)
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OLEView

Description

Represents the "OLE object" object. The OLEView object is an element of the ScreenItems 
list.

     

Type identifier in VBS
Version-independent ProgID

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-81 Properties

Properties Read Write Description
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Properties Read Write Description
    
    
    
    
    

 

Table 10-82 Methods

Methods Can be dynamized Validity Description
    
    
    
    
    
    
    
    
    
    
    

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)
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OnlineTableControl

Description

Represents the "Table view" object. The OnlineTableControl object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIOnlineTableControl

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-83 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode 
(Page 5209) 

- - Specifies that the project settings are used for the design. 

AutoCompleteColumns (Page 5213) P P Specifies whether empty columns are shown if the control is 
wider than the configured columns.  

AutoCompleteRows (Page 5214) P P Specifies whether empty rows are shown if the control is 
longer than the number of configured rows.  
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Properties Read Write Description
AutoSelectionColors (Page 5215) P P Specifies whether the colors defined by the system are used 

as the selection colors for cells and rows. 
AutoSelectionRectColor (Page 5216) P P Specifies whether the selection frame is shown with the color 

defined by the system.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
Caption (Page 5257) P P Specifies the text that is displayed in the header of the 

selected object.  
CellCut (Page 5261) P P Specifies whether the contents of the cells are abbreviated 

if the cells are too narrow. 
CellSpaceBottom (Page 5262) P P Specifies the bottom margin of the table cells.  
CellSpaceLeft (Page 5263) P P Sets the left indent for the table cells.  
CellSpaceRight (Page 5263) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 5264) P P Specifies the top margin of the table cells.  
Closeable (Page 5272) P P Specifies that the control can be closed in runtime. 
ColumnResize (Page 5279) P P Enables changes to the width of columns.  
ColumnScrollbar (Page 5280) P P Specifies the scroll bar type. 
ColumnTitleAlignment P P Specifies the type of column title alignment. 
ColumnTitles (Page 5282) P P Specifies whether the column header is displayed. 
ControlDesignMode (Page 5573) P P Specifies the design. 
EnableEdit (Page 5315) P P Specifies whether the data shown can be edited in Runtime. 
ExportDirectoryChangeable 
(Page 5322) 

P P Specifies whether the data export directory can be changed 
in runtime. 

ExportDirectoryname (Page 5322) P P Specifies the target directory for the exported Runtime data.  
ExportFileExtension (Page 5323) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportFilename (Page 5323) P P Specifies the name of the target file for the exported Runtime 

data. 
ExportFilenameChangeable 
(Page 5324) 

P P Specifies whether the export file name can be changed in 
runtime.  

ExportFormatGuid (Page 5325) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 5325) P P Specifies the export file format. Only the "csv" file format is 

currently available for the export. 
ExportParameters (Page 5326) P P Specifies the parameters of the selected format by means of 

the "Properties" dialog. 
ExportSelection (Page 5326) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportShowDialog (Page 5327) P P Specifies whether the data export dialog is shown in runtime. 
Font (Page 5347) - - Specifies or returns the font.  
GridLineColor (Page 5359) P P Specifies the color for the grid lines. 
GridLineWidth (Page 5360) P P Specifies the width of the separation lines in pixels.  
Height (Page 5361) P - Sets the height of the specified "Ellipse", "Circle" and 

"Rectangle" objects.  
HorizontalGridLines (Page 5375) P P Specifies whether horizontal separation lines are displayed.  
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Properties Read Write Description
IconSpace (Page 5378) P P Specifies the spacing between icons and text in the table 

cells. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 5414) P P Sets the color of the window separation lines. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
LoadDataImmediately (Page 5417) P P Specifies whether the tag values are downloaded from the 

logs for the time range to be displayed when you call a 
screen. 

Moveable (Page 5451) P P Specifies whether the window can be moved in runtime.  
Name (Page 5452) P - Returns the object name as STRING. 
Online (Page 5463) P P Specifies the name of the data source. 
PrintJob P P Specifies a print job 
RowScrollbar (Page 5510) P P Specifies whether row scroll bars are displayed.  
RowTitleAlignment P P Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 5512) P P Specifies how online configurations of WinCC are retained. 
RTPersistencePasswordLevel 
(Page 5513)

P P Specifies the authorization required for online configuration 
in runtime. 

RTPersistenceType (Page 5513) - - Specifies how online configurations of WinCC are retained.  
SelectedCellColor (Page 5528) P P Specifies the background color of the selected cell.  
SelectedCellForeColor (Page 5529) P P Specifies the font color of the selected cell.  
SelectedRowColor (Page 5530) P P Specifies the background color of the selected row.  
SelectedRowForeColor (Page 5530) P P Specifies the font color of the selected row.  
SelectedTitleColor (Page 5531) P P Specifies the background color of a selected table header.  
SelectedTitleForeColor (Page 5532) P P Specifies the font color of the selected table header.  
SelectionColoring (Page 5534) P P Specifies whether selection colors are used for cells or rows. 
SelectionRect (Page 5537) P P Specifies whether a selection frame is used for the selected 

cells or rows. 
SelectionRectColor (Page 5538) P P Specifies the color of the selection rectangle in the alarm 

window if SelectionType equals "1".  
SelectionRectWidth (Page 5539) P P  Specifies the line width of the selection rectangle in the alarm 

window if SelectionType equals "1". 
SelectionType (Page 5539) P P Specifies the number of lines you can mark.   
ShowSortButton (Page 5563) P P Specifies whether the sorting button is shown above the 

vertical scroll bar. 
ShowSortIcon (Page 5564) P P Specifies whether the sorting icon is displayed.  
ShowSortIndex (Page 5565) P P Specifies whether the sorting icon is displayed.  
ShowTitle (Page 5569) P P Specifies the layout of the control window's header. 
Sizeable (Page 5573) P P Specifies that the size of an object can be changed in 

runtime. 
SortSequence (Page 5577) P P Specifies how the sorting order can be changed by mouse 

click. 
StatusbarBackColor (Page 5582) P P Specifies the background color of the status bar.  
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Properties Read Write Description
StatusbarElementAdd  (Page 5582) * P P Creates a new, user-defined status bar element.  
StatusbarElementAutoSize (Page 5583) 
*

P P Specifies whether the width of the selected status bar 
element is set automatically.  

StatusbarElementCount  (Page 5583) * P P Specifies the number of configurable status bar elements. 
StatusbarElementIconId  (Page 5584) * P P Default assignment of the ID number and icon of a status bar 

element. 
StatusbarElementId  (Page 5584) * P P Unique ID of the selected status bar element. 
StatusbarElementIndex (Page 5585) P P References a status bar element. You can use this property 

to assign the values of other properties to a specific element 
of the status bar. 

StatusbarElementName  (Page 5585) * P P Displays the object name of the selected status bar element. 
StatusbarElementRemove  (Page 5586) 
*

P P Removes the selected status bar element.  

StatusbarElementRename  (Page 5586) 
*

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 5586) - - Specifies the elements that are to be shown in the status bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar 

element. 
StatusbarElementTooltipText  
(Page 5587) *

P P Specifies the tooltip text for the user-defined status bar 
element. 

StatusbarElementUserDefined  
(Page 5587) *

P P Indicates whether the configuration engineer has added the 
status bar element as a new user-defined element. 

StatusbarElementVisible  (Page 5588) * P P In the list, activate the status bar elements that you wish to 
display in runtime. 

StatusbarElementWidth  (Page 5589) * P P Specifies the width of the selected status bar element in 
pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 5589) P P Specifies the color of the text in the status bar.  
StatusbarShowTooltips (Page 5591) P P Specifies whether tooltips are displayed for the elements of 

the status bar in runtime.  
StatusbarText (Page 5592) P P Default text in the status bar. 
StatusbarUseBackColor (Page 5593) P P Specifies whether the background color of the status bar is 

shown. 
StatusbarVisible (Page 5593) P P Specifies whether the status bar of the control is displayed.  
TableColor (Page 5598) P P Specifies the background color of the rows. Use this to open 

the color selection dialog.  
TableColor2 (Page 5598) P P Specifies the background color of "Row color 2".  
TableForeColor (Page 5599) P P  
TableForeColor2 (Page 5601) P P Specifies the font color of "Row color 2". 
TimeBase (Page 5619) P P Sets the time zone that forms the basis for the display of time 

values.  
TimeColumnActualize  (Page 5620) * P P Specifies whether the values of the selected column are 

updated. 
TimeColumnAdd  (Page 5620) * P P Creates a new time column. 
TimeColumnAlign  (Page 5620) * P P Specifies how the selected time column is aligned. 
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Properties Read Write Description
TimeColumnBackColor  (Page 5622) * P P Specifies the background color of the time column selected. 
TimeColumnBeginTime  (Page 5622) * P P Specifies the starting time of the time range for a selected 

time column.  
TimeColumnCaption  (Page 5623) * P P Specifies the label of the time column. 
TimeColumnCount  (Page 5623) * P P Specifies the number of configured time columns. 
TimeColumnDateFormat  (Page 5623) * P P Specifies which date format is used to display the selected 

time column.  
TimeColumnEndTime  (Page 5624) * P P Specifies the end point of the time range for the selected time 

column. 
TimeColumnForeColor  (Page 5624) * P P Specifies the font color of the time column selected.  
TimeColumnHideText  (Page 5626) * P P Sets text format for displaying the content of a time column. 
TimeColumnHideTitleText  (Page 5626) 
*

P P Sets text format for displaying the time column header. 

TimeColumnIndex (Page 5627) P P References a configured time column. 
TimeColumnLength  (Page 5627) * P P Specifies the width of a selected time column. 
TimeColumnMeasurePoints  
(Page 5627) *

P P Specifies the number of measuring points to be displayed in 
the selected time column.  

TimeColumnName  (Page 5628) * P P Specifies the name of the selected time column. 
TimeColumnRangeType  (Page 5628) * P P Specifies the time range used for the selected time column. 
TimeColumnRemove  (Page 5629) * P P Removes the selected time column from the list. 
TimeColumnRename  (Page 5629) * P P Renames the time column that is referenced by means of the 

"TimeColumnIndex" property. 
TimeColumnRepos  (Page 5630) * P P Changes the sorting order of the time columns, including the 

corresponding value columns. 
TimeColumnShowDate  (Page 5630) * P P Specifies whether the selected time column is displayed with 

date and time. 
TimeColumnShowIcon  (Page 5631) * P P Specifies whether the contents of the time column are shown 

as an icon. 
TimeColumnShowTitleIcon  
(Page 5631) *

P P Specifies whether the values of the selected column are 
updated.  

TimeColumnSort  (Page 5632) * P P Specifies how the time column referenced in 
"TimeColumnIndex" is sorted. 

TimeColumnSortIndex  (Page 5632) * P P Specifies the sorting order of the time column referenced in 
"TimeColumnIndex". 

TimeColumnTimeFormat  (Page 5633) * P P Defines the time format used to display a selected time 
column.  

TimeColumnTimeRangeBase  
(Page 5633) *

P P Specifies the unit of time for calculating the time range. 

TimeColumnTimeRangeFactor  
(Page 5634) *

P P Specifies the factor for calculating the time range. 

TimeColumnUseValueColumnColors  
(Page 5634) *

P P Specifiess whether the selected time column is displayed in 
the value column colors. 

TimeColumnVisible  (Page 5635) * P P The list shows the time columns you have created. 
TimeStepBase P P A time range is set via a base and a factor. 
TimeStepFactor P P A time range is set via a base and a factor. 
TitleColor P P Specifies the color of the header. 
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Properties Read Write Description
TitleCut (Page 5641) P P Specifies whether the contents of the fields of a header 

should be abbreviated if the column is too narrow.  
TitleDarkShadowColor (Page 5641) P P Specifies the color of the dark side of shading. 
TitleForeColor (Page 5641) P P Specifies the font color of the table header for the selected 

status. 
TitleGridLineColor (Page 5642) P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor (Page 5642) P P Specifies the color of the bright side of shading. 
TitleSort (Page 5642) P P Specifies how sorting by column header is triggered.  
TitleStyle (Page 5643) P P Specifies whether a shading color is used for the table 

header. 
ToolbarAlignment (Page 5650) P P Specifies or returns the position of the toolbar. 
ToolbarBackColor (Page 5650) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 5651) * P P Specifies whether the function linked to the button is 

activated in runtime. 
ToolbarButtonAdd  (Page 5652) * P P Creates a new, user-defined button function.  
ToolbarButtonBeginGroup  (Page 5652) 
*

P P Specifies whether a separator is inserted before the selected 
button function.  

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 5653) * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 5653) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 5654) * P P Shows the hotkey for the selected button function.  
ToolbarButtonId  (Page 5654) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 5654) P P References a button function.  
ToolbarButtonLocked  (Page 5655) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 5655) * P P Shows the name of the selected button function.  
ToolbarButtonPasswordLevel  
(Page 5656) *

P P Shows the authorization for the selected button function.  

ToolbarButtonRemove  (Page 5656) * P P Removes the selected button function from the list.  
ToolbarButtonRename  (Page 5656) * P P Renames the user-defined toolbar element that is referenced 

by means of the "ToolbarButtonIndex" property.  
ToolbarButtonRepos  (Page 5657) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  (Page 5657) * P P Specifies the tooltip text for the button. 
ToolbarButtonUserDefined  (Page 5658) 
*

P P Indicates whether the configuration engineer has added the 
toolbar button as a new user-defined button.  

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 5658) P P Specifies whether the tooltips for the button functions are 

displayed in runtime.  
ToolbarUseBackColor (Page 5659) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 5660) P P Specifies whether the hotkeys for the button functions are 

activated in runtime.  
ToolbarVisible (Page 5660) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
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Properties Read Write Description
UseColumnBackColor P P Specifies whether scrolling is enabled. 
UseColumnForeColor P P Specifies the font used for printing. 
UseSelectedTitleColor (Page 5714) P P Specifies whether a selection color is used for the headers 

of selected table cells. 
UseTableColor2 (Page 5715) P P Specifies whether a second row color is used for the 

representation of the table. 
ValueColumnAdd  * P P Adds a value column. 
ValueColumnAlign  * P P Specifies the alignment of a column. 
ValueColumnAutoPrecisions  * P P Specifies whether the number of decimal places to be 

displayed is determined automatically. 
ValueColumnBackColor  * P P Specifies the background color. 
ValueColumnCaption  * P P Specifies a header. 
ValueColumnCount  * P P Displays the number of value columns. 
ValueColumnExponentialFormat  * P P Specifies that exponential notation is used in a column. 
ValueColumnForeColor  * P P Specifies the foreground color for a value column. 
ValueColumnHideText  * P P Specifies whether the text is displayed. 
ValueColumnHideTitleText  * P P Specifies whether the text is displayed. 
ValueColumnIndex P P The index specifies on which column other properties, e.g. 

initial value are based. 
ValueColumnLength  * P P Specifies the number of displayed characters. 
ValueColumnName  * P P Specifies the name of a column. 
ValueColumnPrecisions  * P P Specifies the number of decimal places. 
ValueColumnProvider  * P P  
ValueColumnProviderCLSID  * P P Specifies the provider CLSID of the data for a column. 
ValueColumnRemove  * P P Deletes a value column. 
ValueColumnRename  * P P Renames a value column. 
ValueColumnRepos  * P P Specifies that a value column is repositioned. 
ValueColumnSelectTagName  * P P Specifies a tag. 
ValueColumnShowIcon  * P P Specifies whether an icon is shown. 
ValueColumnShowTitleIcon  * P P Specifies whether an icon is shown in the title. 
ValueColumnSort  * P P Specifies the sorting type of a column. 
ValueColumnSortIndex  * P P Specifies the sorting order. 
ValueColumnTagName  * P P Specifies the names of the tags whose values are displayed 

in a column.  
ValueColumnTimeColumn  * P P Specifies the corresponding time column. 
ValueColumnVisible  * P P Specifies the visibility of a value column. 
VerticalGridLines (Page 5734) P P Specifies whether vertical separation lines are displayed. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P - Sets the width of the specified "Ellipse", "Circle" and 

"Rectangle" objects. 

* not visible in the ES
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Table 10-84 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 5783) P Executes the "Connect backup" button function of the control.
CalculateStatistic (Page 5783) P Executes the "Calculate statistics" button function of the f(t) trend view and 

table view.
CopyRows (Page 5784) P Executes the "Copy rows" button function of the control.
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the 
specified property in/during Runtime.

DetachDB (Page 5789) P, A Executes the "Disconnect backup" button function of the control.
Edit (Page 5789) P Executes the "Edit" button function of the table view.
Export (Page 5790) P, A Executes the "Export log" or "Export data" button function of the control.
GetRow (Page 5802) P Returns the row object defined by its row number in the table-based controls 

as "ICCAxDataRow" type.
GetRowCollection (Page 5803) P Returns the list of all row objects of the table-based controls as 

"ICCAxDataRowCollection" type. 
GetSelectedRow (Page 5810) P Returns the selected row object of a table-based control as "ICCAxDataRow" 

type.
GetSelectedRows (Page 5811) P Returns the selected row objects of a table-based control as type 

"ICCAxDataRow" for multiple selection.
GetStatusbarElement 
(Page 5817) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 5818) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetTimeColumn (Page 5822) P Returns the time column object of the table view designated by name or index 
as "ICCAxTime Column" type.

GetTimeColumnCollection 
(Page 5823) 

P Returns the list of all time column objects of the table view as 
"ICCAxCollection" type.

GetToolbarButton (Page 5825) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 5826) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

GetValueColumn (Page 5834) P Returns the value column object of the f(t) trend view designated by name or 
index as "ICCAxValueColumn" type.

GetValueColumnCollection 
(Page 5835) 

P Returns the list of all value column objects of the f(t) trend view as 
"ICCAxCollection" type.

MoveToFirst (Page 5846) P Executes the "First line" button function of the control.
MoveToLast (Page 5848) P Executes the "Last data record" button function of the control.
MoveToNext (Page 5849) P Executes the "Next data record" button function of the control.
MoveToPrevious (Page 5851) P Executes the "Previous data record" button function of the control.
NextColumn (Page 5852) P Executes the "Next column" button function of the table view.
PreviousColumn (Page 5854) P Executes the "Previous column" button function of the table view.
Print (Page 5855) P, A Executes the "Print" button function of the control.
SelectAll (Page 5870) P Selects all rows in a table-based control.
SelectRow (Page 5871) P Selects a specific row in a table-based control.
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Methods Valid Description
SelectStatisticArea (Page 5871) P Executes the "Set statistics range" button function of the table view.
ShowColumnSelection 
(Page 5873) 

P Executes the "Select columns" button function of the table view.

ShowHelp (Page 5875) P, A Executes the "Help" button function of the control.
ShowPropertyDialog 
(Page 5880) 

P, A Executes the "Configuration dialog" button function of the control.

ShowTagSelection (Page 5884) P, A Executes the "Select data connection" button function of the control.
ShowTimeSelection 
(Page 5885) 

P, A Executes the "Select time range" button function of the control.

StartStopUpdate (Page 5886) P, A Executes the "Start" or "Stop" button function of the control.
UnselectAll (Page 5888) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 5889) P Removes the selections from a specific cell of a table-based control.

See also
Screen object (list) (Page 4970)

OnlineTrendControl

Description

Represents the "f(t) TrendView" object. The OnlineTrendControl object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIOnlineTrendControl     
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-85 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode 
(Page 5209) 

- - Specifies that the project settings are used for the design. 

BackColor (Page 5218) P P Specifies the background color of the selected object. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
Caption (Page 5257) P P Specifies the text that is displayed in the header of the 

selected object.  
Closeable (Page 5272) P P Specifies that the control can be closed in runtime. 
ConnectTrendWindows (Page 5285) P P Specifies whether the configured trend views are connected. 
ControlDesignMode (Page 5573) P P Specifies the design. 
ExportDirectoryChangeable 
(Page 5322) 

P P Specifies whether the data export directory can be changed 
in runtime. 

ExportDirectoryname (Page 5322) P P Specifies the target directory for the exported Runtime data.  
ExportFileExtension (Page 5323) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportFilename (Page 5323) P P Specifies the name of the target file for the exported Runtime 

data. 
ExportFilenameChangeable 
(Page 5324) 

P P Specifies whether the export file name can be changed in 
runtime.  

ExportFormatGuid (Page 5325) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 5325) P P Specifies the export file format. Only the "csv" file format is 

currently available for the export. 
ExportParameters (Page 5326) P P Specifies the parameters of the selected format by means of 

the "Properties" dialog. 
ExportSelection (Page 5326) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported.  
ExportShowDialog (Page 5327) P P Specifies whether the data export dialog is shown in runtime. 
Font (Page 5347) - - Specifies or returns the font.  
GraphDirection (Page 5358) P P Specifies at which border of the trend window the current 

values are displayed. 
Height (Page 5361) P - Sets the height of the specified "Ellipse", "Circle" and 

"Rectangle" objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 5414) P P Sets the color of the window separation lines. 
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Properties Read Write Description
LineWidth (Page 5417) P P Specifies the line thickness of the selected object. 
LoadDataImmediately (Page 5417) P P Specifies whether the tag values are downloaded from the 

logs for the time range to be displayed when you call a screen. 
Moveable (Page 5451) P P Specifies whether the window can be moved in runtime.  
Name (Page 5452) P - Returns the object name as STRING. 
Online (Page 5463) P P Specifies the name of the data source. 
PercentageAxis P P Specifies that an axis with percentage scaling is shown. 
PercentageAxisAlign P P  
PercentageAxisColor P P Specifies the color of the percentage axis. 
PrintJob P P Specifies a print job 
RTPersistence (Page 5512) P P Specifies how online configurations of WinCC are retained. 
RTPersistencPasswordLevel 
(Page 5513) 

P P Specifies the authorization required for online configuration 
in runtime. 

RTPersistenceType (Page 5513) - - Specifies how online configurations of WinCC are retained.  
ShowRuler (Page 5560) P P Specifies whether a scale gradation (auxiliary line) is shown 

for the axis label of the "OnlineTrendControl" object. 
ShowRulerInAxis (Page 5561) P P Specifies whether rulers are also displayed in the time axes.  
ShowScrollbars (Page 5562) P P Specifies the scroll bar type. 
ShowStatisticRuler P P Specifies the SQL statement. 
ShowTitle (Page 5569) P P Specifies the layout of the control window's header. 
ShowTrendIcon (Page 5570) P P Specifies whether an icon is displayed below the value axes.  
Sizeable (Page 5573) P P Specifies that the size of an object can be changed in runtime. 
StatusbarBackColor (Page 5582) P P Specifies the background color of the status bar.  
StatusbarElementAdd  (Page 5582) * P P Creates a new, user-defined status bar element.  
StatusbarElementAutoSize  
(Page 5583) *

P P Specifies whether the width of the selected status bar 
element is set automatically.  

StatusbarElementCount  (Page 5583) 
*

P P Specifies the number of configurable status bar elements. 

StatusbarElementIconId  (Page 5584) 
*

P P Default assignment of the ID number and icon of a status bar 
element. 

StatusbarElementId  (Page 5584) * P P Unique ID of the selected status bar element. 
StatusbarElementIndex (Page 5585) P P References a status bar element. You can use this property 

to assign the values of other properties to a specific element 
of the status bar. 

StatusbarElementName  (Page 5585) 
*

P P Displays the object name of the selected status bar element. 

StatusbarElementRemove 
(Page 5586) *

P P Removes the selected status bar element.  

StatusbarElementRename 
(Page 5586) *

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 5586) - - Specifies the elements that are to be shown in the status bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar element. 
StatusbarElementTooltipText  
(Page 5587) *

P P Specifies the tooltip text for the user-defined status bar 
element. 
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Properties Read Write Description
StatusbarElementUserDefined  
(Page 5587) *

P P Indicates whether the configuration engineer has added the 
status bar element as a new user-defined element. 

StatusbarElementVisible  (Page 5588) 
*

P P In the list, activate the status bar elements that you wish to 
display in runtime. 

StatusbarElementWidth  (Page 5589) 
*

P P Specifies the width of the selected status bar element in 
pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 5589) P P Specifies the color of the text in the status bar.  
StatusbarShowTooltips (Page 5591) P P Specifies whether tooltips are displayed for the elements of 

the status bar in runtime.  
StatusbarText (Page 5592) P P Default text in the status bar. 
StatusbarUseBackColor (Page 5593) P P Specifies whether the background color of the status bar is 

shown. 
StatusbarVisible (Page 5593) P P Specifies whether the status bar of the control is displayed.  
TimeAxes - - Specifies the settings for the time axes. 
TimeAxisActualize  * P P  
TimeAxisAdd  * P P Inserts an axis. 
TimeAxisAlignment  * P P Specifies the alignment of an axis. 
TimeAxisBeginTime  (Page 5614) * P P Specifies the starting time for the display of the selected 

trend.  
TimeAxisColor  * P P Specifies the color of an axis. 
TimeAxisCount  * P P Displays the number of time axes. 
TimeAxisDateFormat  * P P Specifies the date format. 
TimeAxisEndTime  (Page 5614) * P P Specifies the end time for the display of the selected trend. 
TimeAxisIndex P P The index specifies on which axis other properties, e.g. initial 

value are based. 
TimeAxisInTrendColor  * P P Specifies that the color of the trend is used for an axis. 
TimeAxisLabel  (Page 5615) * P P Specifies the header for the time axis. Whether or not the 

information is evaluated depends on the 
"ConfigureTimeAxis(i)" property. 

TimeAxisMeasurePoints  * P P Specifies the measuring points. 
TimeAxisName  * P P Specifies the name of an axis. 
TimeAxisRangeType  * P P Specifies the type of time range. 
TimeAxisRemove  * P P Deletes a time axis 
TimeAxisRename  * P P Renames a time axis. 
TimeAxisRepos  * P P Specifies that the time axis is repositioned 
TimeAxisShowDate  * P P Specifies that the date is to be displayed. 
TimeAxisTimeFormat  (Page 5618) * P P Specifies the time format. 
TimeAxisTimeRangeBase  * P P A time range is set via a base and a factor. 
TimeAxisTimeRangeFactor  * P P A time range is set via a base and a factor. 
TimeAxisTrendWindow  * P P Specifies the trend view. 
TimeAxisVisible  * P P Specifies that the time axis is visible. 
TimeBase (Page 5619) P P Sets the time zone that forms the basis for the display of time 

values.  
ToolbarAlignment (Page 5650) P P Specifies or returns the position of the toolbar. 
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Properties Read Write Description
ToolbarBackColor (Page 5650) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 5651) * P P Specifies whether the function linked to the button is activated 

in runtime. 
ToolbarButtonAdd  (Page 5652) * P P Creates a new, user-defined button function.  
ToolbarButtonBeginGroup  
(Page 5652) *

P P Specifies whether a separator is inserted before the selected 
button function.  

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 5653) * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 5653) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 5654) * P P Shows the hotkey for the selected button function.  
ToolbarButtonId  (Page 5654) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 5654) P P References a button function.  
ToolbarButtonLocked  (Page 5655) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 5655) * P P Shows the name of the selected button function.  
ToolbarButtonPasswordLevel  
(Page 5656) *

P P Shows the authorization for the selected button function.  

ToolbarButtonRemove  (Page 5656) * P P Removes the selected button function from the list.  
ToolbarButtonRename  (Page 5656) * P P Renames the user-defined toolbar element that is referenced 

by means of the "ToolbarButtonIndex" property.  
ToolbarButtonRepos  (Page 5657) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  
(Page 5657) *

P P Specifies the tooltip text for the button. 

ToolbarButtonUserDefined  
(Page 5658) *

P P Indicates whether the configuration engineer has added the 
toolbar button as a new user-defined button.  

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 5658) P P Specifies whether the tooltips for the button functions are 

displayed in runtime.  
ToolbarUseBackColor (Page 5659) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 5660) P P Specifies whether the hotkeys for the button functions are 

activated in runtime.  
ToolbarVisible (Page 5660) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
TrendAdd  (Page 5671) * P P Creates a new trend. 
TrendAutoRangeBeginTagName  * P P Specifies a tag that defines the initial value. 
TrendAutoRangeBeginValue  * P P Specifies the initial value for the automatically adjusted 

display range. 
TrendAutoRangeEndTagName  * P P Specifies a tag that defines the end value. 
TrendAutoRangeEndValue  * P P Specifies a tag that defines the end value. 
TrendAutoRangeSource  * P P Specifies the source of the display range. 
TrendColor  (Page 5672) * P P Specifies or returns the trend view color. 
TrendCount  (Page 5672) * P P Specifies the number of configured trends. 
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Properties Read Write Description
TrendExtendedColorSet  (Page 5672) 
*

P P Specifies whether you can configure the point color and the 
fill color and whether the colors are shown in runtime. 

TrendFill  (Page 5673) * P P Specifies whether the area below the trend is shown filled. 
TrendFillColor  (Page 5674) * P P Sets the fill color of the trend. 
TrendIndex (Page 5674) P P References a configured trend. 
TrendLabel  (Page 5675) * P P Specifies the label of the selected trend. 
TrendLineStyle  (Page 5675) * P P Specifies which line type is used for display of the trend. 
TrendLineType  (Page 5676) * P P Specifies how the trend is displayed. 
TrendLineWidth  (Page 5676) * P P Specifies the line thickness of the line displayed. 
TrendLowerLimit  (Page 5677) * P P Specifies the low limit of a tag. 
TrendLowerLimitColor  (Page 5677) * P P Specifies the color which indicates tag values below the value 

of "TrendLowerLimit". 
TrendLowerLimitColoring  
(Page 5677) *

P P Specifies whether the selection frame is shown with the color 
defined by the system. 

TrendName  (Page 5678) * P P Displays the name of the selected trend. 
TrendPointColor  (Page 5678) * P P Specifies the color of trend points. 
TrendPointStyle  (Page 5679) * P P Specifies how the points are displayed on the trend. 
TrendPointWidth  (Page 5679) * P P Specifies the point width in pixels. 
TrendProvider  (Page 5680) * P P Specifies the data supply for the selected trend. 
TrendProviderCLSID  * P P Specifies the provider CLSID of the data for a trend. 
TrendRemove  (Page 5681) * P P Removes selected trends from the list. 
TrendRename  (Page 5681) * P P Renames the trend that is referenced by means of the 

"TrendIndex" property. 
TrendRepos  (Page 5682) * P P Repositions the selected trend in the sequence in the trend 

window. 
TrendSelectTagName  * P P Specifies a tag. 
TrendTagName  * P P Specifies the name of the tag for the Y direction. 
TrendTimeAxis  * P P Specifies the time axis. 
TrendTrendWindow  (Page 5685) * P P Specifies the trend window in which the selected trend is 

shown. 
TrendUncertainColor  (Page 5685) * P P Values have an uncertain status if the initial value is unknown 

after Runtime has been activated, or if a substitute value is 
used. 

TrendUncertainColoring  (Page 5686) 
*

P P Values have an uncertain status if the initial value is unknown 
after Runtime has been activated, or if a substitute value is 
used. 

TrendUpperLimit  (Page 5686) * P P Specifies the high limit of a tag. If the tag drops below the 
value of "TrendLowerLimit", the values are marked with the 
color set in "TrendUpperLimitColor". 

TrendUpperLimitColor  (Page 5687) * P P Specifies the color which indicates tag values below the value 
of "TrendLowerLimit". 

TrendUpperLimitColoring  
(Page 5687) *

P P Specifies whether the selection frame is shown with the color 
defined by the system. 

TrendValueAxis  * P P Specifies the value axis. 
TrendVisible  (Page 5687) * P P The list contains all the trends that you have created. 
TrendWindowAdd  (Page 5688) * P P Creates a new trend view. 
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Properties Read Write Description
TrendWindowCoarseGrid  
(Page 5688) *

P P Specifies whether grid lines are displayed for the main 
scaling. 

TrendWindowCoarseGridColor  
(Page 5689) *

P P Specifies the color of the grid lines for the main scaling. 

TrendWindowCount  * P P Displays the number of trend views. 
TrendWindowFineGrid  (Page 5689) * P P Specifies whether grid lines are displayed for the secondary 

scaling. 
TrendWindowFineGridColor  
(Page 5690) *

P P Specifies the grid color of the main scaling. 

TrendWindowForegroundTrendGrid  
(Page 5690) *

P P Specifies whether only the grid lines for the foreground trend 
are displayed in the selected trend window. 

TrendWindowGridInTrendColor  
(Page 5690) *

P P Specifies whether the grid lines for the main scaling are 
displayed in the trend color. 

TrendWindowHorizontalGrid  
(Page 5691) *

P P Specifies whether the horizontal grid lines are shown. 

TrendWindowIndex (Page 5692) P P References a configured trend window. 
TrendWindowName  (Page 5692) * P P Specifies the name of the selected trend window. 
TrendWindowRemove  (Page 5692) * P P Removes the selected trend view from the list. 
TrendWindowRename  (Page 5692) * P P Changes the name of the trend window which is referenced 

by the "TrendWindowIndex" property. 
TrendWindowRepos  (Page 5693) * P P Changes the order of the trend view. 
TrendWindowRulerColor  (Page 5693) 
*

P P Specifies the ruler color. 

TrendWindowRulerLayer  
(Page 5693) *

P P Specifies the display layer of the ruler in the trend view. 

TrendWindowRulerStyle  (Page 5694) 
*

P P Specifies the representation of the ruler. 

TrendWindowRulerWidth  
(Page 5695) *

P P Specifies the ruler width in pixels. 

TrendWindows - - Specifies the settings for trend views. 
TrendWindowSpacePortion  
(Page 5695) *

P P Specifies the proportion of the selected trend window for 
display in the control. 

TrendWindowStatisticRulerColor  * P P Specifies the color of the statistics ruler. 
TrendWindowStatisticRulerStyle  * P P Specifies the style of the statistics ruler. 
TrendWindowStatisticRulerWidth  * P P Specifies the width of the statistics ruler. 
TrendWindowVerticalGrid  
(Page 5695) *

P P Specifies whether the vertical grid lines are displayed. 

TrendWindowVisible  (Page 5696) * P P The list contains the trend views that you have created. 
UseTrendNameAsLabel (Page 5719) P P Specifies whether the "Name" or "Label" property is used as 

a designation for the trend in runtime. 
ValueAxes - - Specifies the settings for the value axes. 
ValueAxisAdd  * P P Inserts an axis. 
ValueAxisAlignment  * P P Specifies the alignment of an axis. 
ValueAxisAutoPrecisions  * P P Specifies that the number of decimal places displayed for an 

axis is adjusted automatically. 
ValueAxisAutoRange  * P P Specifies that the value range is determined automatically. 
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Properties Read Write Description
ValueAxisBeginValue  * P P Specifies the initial value of an axis. 
ValueAxisColor  * P P Specifies the color of a value axis. 
ValueAxisCount  * P P Shows the number of value axes. 
ValueAxisEndValue  * P P Specifies the end value of an axis. 
ValueAxisExponentialFormat  * P P Specifies that the label of an axis uses exponential notation. 
ValueAxisIndex P P The index specifies on which axis other properties, e.g. initial 

value are based. 
ValueAxisInTrendColor  * P P Specifies that the color of the trend is used for an axis. 
ValueAxisLabel  (Page 5727) * P P Specifies the label of the value axis. 
ValueAxisName  * P P Specifies the name of an axis. 
ValueAxisPrecisions  * P P Specifies the number of displayed decimal places. 
ValueAxisRemove  * P P Renames an axis. 
ValueAxisRename  * P P Renames an axis. 
ValueAxisRepos  * P P Specifies that the value axis is repositioned. 
ValueAxisScalingType  (Page 5728) * P P Specifies the type of axis scaling. 
ValueAxisTrendWindow  * P P Specifies the trend view. 
ValueAxisVisible  * P P Specifies whether a value axis is visible. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P - Sets the width of the specified "Ellipse", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-86 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
AttachDB (Page 5783) P, A Executes the "Connect backup" button function of the control.
CalculateStatistic (Page 5783) P Executes the "Calculate statistics" button function of the f(t) trend view and 

table view.
DeactivateDynamic (Page 5786) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
DetachDB (Page 5789) P, A Executes the "Disconnect backup" button function of the control.
Export (Page 5790) P, A Executes the "Export log" or "Export data" button function of the control.
GetRulerData (Page 5809) P Returns the value of the called trend at the ruler position.
GetStatusbarElement 
(Page 5817) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 5823) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetTimeAxis (Page 5819) P Returns the time axis object of the f(t) trend view designated by name or index 
as "ICCAxTimeAxis" type.

GetTimeAxisCollection 
(Page 5821) 

P Returns the list of all time axis objects of the f(t) trend view as 
"ICCAxCollection" type.
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Methods Valid Description
GetToolbarButton (Page 5825) P Returns the button function designated by name or index on the control 

toolbar as "ICCAxToolbarButton" type.
GetToolbarButtonCollection 
(Page 5826) 

P Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

GetTrend (Page 5827) P, A Returns the f(t) or f(x) trend view designated by name or index as 
"ICCAxTrend" or "ICCAxFunctionTrend" type.

GetTrendCollection (Page 5828) P, A Returns the list of all trends of the f(t) or f(x) trend view as "ICCAxCollection" 
type.

GetTrendWindow (Page 5830) P, A Returns the trend window object of the f(t) or f(x) trend view designated by 
name or index as "ICCAxTrendWindow" type.

GetTrendWindowCollection 
(Page 5831) 

P, A Returns the list of all trend window objects of the f(t) or f(x) trend views as 
"ICCAxCollection" type.

GetValueAxis (Page 5832) P Returns the value axis object of the f(t) trend view designated by name or 
index as "ICCAxValueAxis" type.

GetValueAxisCollection 
(Page 5833) 

P Returns the list of all value axis objects of the f(t) trend view as 
"ICCAxCollection" type.

MoveAxis (Page 5846) P, A Executes the "Move axes area" button function of the f(t) and f(x) trend views.
MoveToFirst (Page 5846) P Executes the "First line" button function of the control.
MoveToLast (Page 5848) P Executes the "Last data record" button function of the control.
MoveToNext (Page 5849) P Executes the "Next data record" button function of the control.
MoveToPrevious (Page 5851) P Executes the "Previous data record" button function of the control.
NextTrend (Page 5853) P, A Executes the "Next trend" button function of the f(t) and f(x) trend views.
OneToOneView (Page 5853) P, A Executes the "Original view" button function of the f(t) and f(x) trend views.
PreviousTrend (Page 5855) P, A Executes the "Previous trend" button function of the f(t) and f(x) trend views.
Print (Page 5855) P, A Executes the "Print" button function of the control.
ShowHelp (Page 5875) P, A Executes the "Help" button function of the control.
ShowPercentageAxis 
(Page 5879) 

P Executes the "Relative axis" button function of the f(t) trend view.

ShowPropertyDialog 
(Page 5880) 

P, A Executes the "Configuration dialog" button function of the control.

ShowTagSelection (Page 5884) P, A Executes the "Select data connection" button function of the control.
ShowTimeSelection 
(Page 5885) 

P, A Executes the "Select time range" button function of the control.

ShowTrendSelection 
(Page 5885) 

P, A Executes the "Select trends" button function of the f(t) and f(x) trend views.

StartStopUpdate (Page 5886) P, A Executes the "Start" or "Stop" button function of the control.
ZoomArea (Page 5893) P, A Executes the "Zoom area" button function of the f(t) and f(x) trend views.
ZoomInOut (Page 5894) P, A Executes the "Zoom +/-" button function of the f(t) and f(x) trend views.
ZoomInOutTime (Page 5894) P Executes the "Zoom time axis +/-" button function of the f(t) trend view.
ZoomInOutValues (Page 5895) P Executes the "Zoom value axis +/-" button function of the f(t) trend view.
ZoomMove (Page 5896) P, A Executes the "Move trend area" button function of the f(t) and f(x) trend views.
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See also
Screen object (list) (Page 4970)

OptionGroup

Description

Represents the "Option button" object. The OptionGroup object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIOptionGroup

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-87 Properties

Properties Read Write Description
AdaptBorder (Page 5193) P P Specifies whether the border of the specified object is 

dynamically adapted to the text size.  
Authorization (Page 5212) P P Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 5224) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 5225) P P Specifies the background color for flash state "On".   
BackFlashingEnabled (Page 5226) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected 

object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for 

the selected object.  
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P  Specifies the border line color of the selected object for the 
flash state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the 
flash state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object 
flashes in runtime. 

BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected 
object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CheckmarkAlignment (Page 5269) P P Specifies whether the fields are right aligned. 
CheckmarkCount (Page 5269) P P Specifies the number of fields. 
CornerStyle (Page 5286) - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with 

a line thickness greater than 1 should be drawn within the 
border or symmetrically to the border. 

EdgeStyle (Page 5310) - - Specifies the line style of the selected object.  
Enabled (Page 5313) P P  Specifies whether the selected object can be operated in 

runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the 

flash state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the 

flash state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object 

flashes in runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected 

object.  
Font (Page 5347) - - Specifies or returns the font.  
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Properties Read Write Description
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 5350) P P Specifies the font of the selected object.  
FontSize (Page 5351) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is 

underlined.  
ForeColor (Page 5352) P P Specifies the font color of the text for the selected object. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalAlignment (Page 5374) P P Specifies the horizontal alignment of the text within the 

selected object. 
Index (Page 5378) P P Specifies the background for grid control elements. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P  Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) - - Specifies the shape of the line ends. 
LogOperation (Page 5420) P P Specifies whether, after operating this object, an alarm is 

output to the alarm system.  
Name (Page 5452) P - Returns the object name as STRING. 
ProcessValue (Page 5497) P P Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowBadTagState (Page 5551) P P Specifies whether an object is grayed out if its associated tag 

has a bad quality code or tag state. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
Text (Page 5607) P P Specifies the label for the text field.  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
Texts - - Specifies the texts for the check boxes. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663)  P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

VerticalAlignment (Page 5733) P P Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
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Table 10-88 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

Polygon

Description

Represents the "Polygon" object. The Polygon object is an element of the ScreenItems list. 

Type identifier in VBS
HMIPolygon
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-89 Properties

Properties Read Write Description
ActualPointIndex (Page 5191) P P Specifies the number of the current corner point of the selected 

object. 
ActualPointLeft (Page 5191) P P Specifies the X coordinate of the current corner point with reference 

to the screen origin. 
ActualPointTop (Page 5192) P P Specifies the Y coordinate of the current corner point with reference 

to the screen origin. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
EdgeStyle (Page 5310) A A Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
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Properties Read Write Description
LineEndShapeStyle 
(Page 5415) 

P P  Specifies the shape of the line end. 

Name (Page 5452) P, A - Returns the object name as STRING. 
Points - - Specifies the corner points.
PointsCount (Page 5493) P - Specifies the number of corner points of the polyline or of the 

polygon.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
RotationAngle (Page 5507) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft (Page 5508) P P Specifies the X coordinate of the pivot point for the object in runtime. 
RotationCenterTop (Page 5509) P P Specifies the Y coordinate of the pivot point for the object in runtime. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-90 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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Polyline

Description

Represents the "Polyline" object. The Polyline object is an element of the ScreenItems list. 

Type identifier in VBS
HMIPolyline

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-91 Properties

Properties Read Write Description
ActualPointIndex 
(Page 5191) 

P P Specifies the number of the current corner point of the selected object. 

ActualPointLeft (Page 5191) P P Specifies the X coordinate of the current corner point with reference 
to the screen origin. 

ActualPointTop (Page 5192) P P Specifies the Y coordinate of the current corner point with reference 
to the screen origin. 
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Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BorderEndStyle 
(Page 5241) 

P; A P Specifies the type of line ends for the selected object. 

BorderStyle (Page 5249) P, A P Specifies the type of border lines for the selected object. 
Color (Page 5272) P, A P, A Specifies the line color of the selected object.  
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
EndStyle (Page 5318) A A Specifies how the line end of the selected object is displayed. 
FillStyle (Page 5333) A A Defines the fill pattern of the specified object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff 
(Page 5336) 

P P Specifies the border line color of the selected object for the flash state 
"Off".  

FlashingColorOn 
(Page 5338) 

P P Specifies the border line color of the selected object for the flash state 
"On".  

FlashingEnabled 
(Page 5339) 

P P Specifies whether the border line of the selected object flashes in 
runtime.  

FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) 

P P Specifies the shape of the line end. 

LineWidth (Page 5416) P, A P, A Specifies the line thickness of the selected object.
Name (Page 5452) P, A - Returns the object name as STRING. 
Points - - Specifies the corner points. 
PointsCount (Page 5493) P - Specifies the number of corner points of the polyline or of the polygon.  
RotationAngle (Page 5507) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft 
(Page 5508) 

P P Specifies the X coordinate of the pivot point for the object in runtime. 

RotationCenterTop 
(Page 5509) 

P P Specifies the Y coordinate of the pivot point for the object in runtime. 

StartStyle (Page 5580) A A Specifies how the line start of the selected object is displayed. 
Style (Page 5594) A A Specifies the line style of the selected object.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-92 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

ProjectName

Description

Represents the "Project name" object. The ProjectName object is an element of the 
ScreenItems list.
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-93 Properties

Properties Read Write Description
BackColor (Page 5219) - - Specifies the background color of the selected object. 
BackFillStyle (Page 5223) - - Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) - - Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5239) - - Specifies the line color of the object. 
BorderWidth (Page 5253) - - Specifies the line thickness of the object. 
EdgeStyle (Page 5310)  - Specifies the line style of the selected object.  
FillPatternColor (Page 5332) - - Specifies the color of the fill pattern for the selected object.  
Font (Page 5347) - - Specifies or returns the font.  
FontBold (Page 5348) - - Specifies whether the text of the selected object is shown in bold. 
FontItalic (Page 5349) - - Specifies whether the text of the selected object is shown in italics. 
FontName (Page 5350) - - Specifies the font of the selected object.  
FontSize (Page 5351) - - Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) - - Specifies whether the text of the selected object is underlined.  
ForeColor (Page 5353) - - Specifies the font color of the text for the selected object. 
Format - - Specifies that the format of the text block is displayed. 
Height (Page 5361) - - Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalAlignment 
(Page 5375) 

- - Specifies the horizontal alignment of the text within the selected 
object. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) - - Specifies the value of the X coordinate of the object. 
LineWrap - - Specifies the line break within the object. 
Name (Page 5452) - - Returns the object name as STRING. 
Top (Page 5663) - - Specifies the value of the Y coordinate of the object. 
VerticalAlignment (Page 5733) - - Specifies the vertical alignment of the text for the selected object. 
Visible (Page 5735) - - Specifies whether the selected object is visible. 
Width (Page 5746) - - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

None of the properties are visible in the ES.

Table 10-94 Methods

Methods Validity Description
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Methods Validity Description
   
   
   
   
   
   
   
   
   

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

ProtectedAreaName

Description

Represents the "EffectiveRangeName" (RFID)" object. The ProtectedAreaName object is an 
element of the ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-95 Properties

Properties Read Write Description
Authorization (Page 5212) - - Specifies the operating rights of the selected object in runtime.  
Font (Page 5347) - - Specifies or returns the font.  
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-96 Methods

Methods Valid Description
   
   
   

 

See also
Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

RangeLabelView

Description

Represents the "EffectiveRangeName" object. The RangeLabelView object is an element of 
the ScreenItems list.     
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-97 Properties

Properties Read Write Description
Authorization (Page 5212) - -  Specifies the operating rights of the selected object in runtime.  
Font (Page 5347) - -  Specifies or returns the font.  
Height (Page 5361) A A  Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - -  Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A  Specifies the value of the X coordinate of the object. 
Name (Page 5452) A -  Returns the object name as STRING. 
Top (Page 5663) A A  Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A  Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-98 Methods

Methods Valid Description
   
   
   
   
   
   
   
   
   
   
   

 

See also
Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)
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RangeQualityView

Description

Represents the "EffectiveRangeSignal" object. The RangeQualityView object is an element of 
the ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-99 Properties

Properties Read Write Description
Height (Page 5361) A A  Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - -  Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A  Specifies the value of the X coordinate of the object. 
Name (Page 5452) A -  Returns the object name as STRING. 
Top (Page 5663) A A  Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A  Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-100 Methods

Methods Valid Description
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Methods Valid Description
   
   
   
   

 

See also
Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

RecipeView

Description

Represents the "RecipeView" object. The RecipeView object is an element of the ScreenItems 
list. 

If you change the settings for this object with a user-defined function, the changed settings are 
retained even after the screen is called again. 

 

 Note

The object "Simple RecipeView" cannot be dynamized with a user-defined function. 
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-101 Properties

Properties Read Write Description
AllowEdit - - Enables editing. 
Authorization (Page 5212) - - Specifies the operating rights of the selected object in runtime.  
BackButtonVisible - - Enables display of the "Back" button. 
BackColor (Page 5219) A A Specifies the background color of the selected object. 
ComboBoxFont - - Sets the font type for selection list. 
DataRecordNameCaption - - Sets the caption for the name of the data record. 
DataRecordNrCaption - - Sets the caption for the number of the data record. 
Display3D - - Sets the 3D view. 
DisplayButton2Plc - - Enables the display of the "Write to PLC" button. 
DisplayButtonComparison - - Enables the display of the "Synchronization" button. 
DisplayButtonDelete - - Enables the display of the "Delete data record" button. 
DisplayButtonFromPlc - - Enables the display of the "Read from PLC" button. 
DisplayButtonHelp - - Enables the display of the "Tooltip" button. 
DisplayButtonNew - - Enables the display of the "Add data record" button. 
DisplayButtonSave - - Enables the display of the "Save" button. 
DisplayButtonSaveAs - - Enables the display of the "Save As" button. 
DisplayComboBox - - Enables the display of the selection list. 
DisplayGridlines - - Enables the display of grid lines. 
DisplayLabeling - - Enables the display labelings. 
DisplayNumbers - - Enables the display of numbers. 
DisplaySize  * - -  
DisplayStatusBar - - Specifies that the status bar is displayed. 
DisplayTable - - Enablers the display of the table. 
Enabled (Page 5314) A A Specifies whether the selected object can be operated in runtime.  
EntryNameCaption - - Sets the caption for the name of the recipe element. 
EntryValueColFirst - - Sets the "Entry value" column to first place. 
EntryValueFieldLength - - Sets the field length for the element value. 
EntryValuePos - - Sets the position of the first value. 
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
FixedRecipeNumber  * - -  
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 5346) A A Specifies the border width of the specified object when the object 

is in focus.  
Font (Page 5347) - - Specifies or returns the font.  
ForeColor (Page 5353) A A Specifies the font color of the text for the selected object. 
HeaderFont - - Sets the header font. 
Height (Page 5361) A - Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
KeyboardOnline - - Enables the use of key combinations. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
ListAreaHeight - -  
ListAreaWidth - -  
MenuButtonVisible - - Enables visibility of the menu buttons. 
Name (Page 5452) A - Returns the object name as STRING. 
NameColumnWidth - -  
NumberOfLines - - Sets the number of rows of the selection list for the text list object, 

or returns the value.   
Recipe - - Sets the recipe. 
RecipeNameCaption - - Sets the caption for the name of the recipe. 
RecipeNameSelected * - -  
RecipeNrCaption - - Specifies that the "Recipe number" column is in first place. 
RecipeNrColFirst - - Specifies that the "Recipe number" column is in first place. 
RecipeVarSelected * - -  
Record * - -  
RecordNameSelected * - -  
RecordNrColFirst - - Specifies that the "Data record number" column is in first place. 
RecordVarSelected * - -  
RenameButtonVisible - - Enables the display of the "Rename" button. 
SelectionBackColor (Page 5534) A A  Specifies the background color of the selected cells.  
SelectionForeColor (Page 5536) A A Specifies the foreground color of the selected cells.  
StatusFont - -  
TableBackColor (Page 5597) A A Specifies the background color of the table cells for the selected 

object.  
TableForeColor (Page 5600) A A  
TableGridlineColor (Page 5602) A A Specifies the color for the grid lines. 
TableHeaderBackColor 
(Page 5602) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderForeColor 
(Page 5603) 

A A Specifies the text color in the header of the table of the selected 
object. 

Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
ValueCaption - - Sets the labeling for values. 
ValueColumnWidth - -  
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Properties Read Write Description
VerticalScrolling - - Sets the display of a scroll bar for the selected object. 
ViewType - - Specifies the alarm view type. 
ViewTypeForSaveStream * - - Specifies the display type for the Save Stream. 
Visible (Page 5735) A A Specifies whether the selected object is visible. 
VisibleItems - - Sets the maximum number of visible entries. 
Width (Page 5746) A - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-102 Methods

Methods Valid Description
   
   
   
   
   
   
   
   
   
   
   

 

 

 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)
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Rectangle

Description

Represents the "Rectangle" object. The Rectangle object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMIRectangle

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-103 Properties 

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P, A P, A Defines the fill pattern of the specified object.  
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P, A P, A Specifies the line color of the object.
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Properties Read Write Description
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes in 
runtime. 

BorderFlashingRate 
(Page 5245) 

P P Specifies the flash rate of the border line for the selected object.  

BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object.
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 

EdgeStyle (Page 5310) A A Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes in 

runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left  (Page 5401) P, A P, A Specifies the value of the X coordinate of the object.
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
Name (Page 5452) P, A - Returns the object name as STRING. 
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
RoundCornerHeight 
(Page 5509) 

P P Sets or returns the corner radius.  

RoundCornerWidth (Page 5510) P P Sets or returns the corner radius.  
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top  (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object.
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible  (Page 5735) P, A P, A Specifies whether the selected object is visible.
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-104 Methods

Methods Validity Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

     

See also
Screen object (list) (Page 4970)

RoundButton

Description

Represents the "RoundButton" object. The RoundButton object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIRoundButton
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-105 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 5224) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 5225) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 5226) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected 

object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderBrightColor3D (Page 5237) P P Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected object.  
BorderShadeColor3D (Page 5248) P P Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
BorderWidth3D (Page 5254) P P Specifies the width of the border for 3D display of the selected 

object. 
CornerStyle (Page 5286) * - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a 

line thickness greater than 1 should be drawn within the border 
or symmetrically to the border. 

EdgeStyle (Page 5310) P P Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
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Properties Read Write Description
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes 

in runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Font (Page 5347) - - Specifies or returns the font.  
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 5350) P P Specifies the font of the selected object.  
FontSize (Page 5351) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 5352) P P Specifies the font color of the text for the selected object. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalAlignment (Page 5374) P P Specifies the horizontal alignment of the text within the selected 

object. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) * - - Specifies the shape of the line ends. 
Mode (Page 5450) P P Specifies the field type of the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
PictureAlignment (Page 5489) P P Specifies or returns the display type of the background image 

in the process picture.  
PictureDeactivated (Page 5489) P P Specifies the picture that is displayed in the "Disabled" state. 
PictureOff (Page 5490) P P Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 5491) P P Specifies the screen to be displayed in the "On" state.  
Pressed (Page 5495) P P Specifies whether the selected object is displayed in a pressed 

state.  
Radius (Page 5501) P P Sets the radius of the specified "Circle" object. 
RelativeFillLevel (Page 5505) P P  Specifies the fill percentage for the object. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
StyleSettings (Page 5595) P P Specifies the display style for the object:  
Text (Page 5607) P P Specifies the label for the text field.  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
Toggle (Page 5644) P P Specifies whether the selected object engages after it has been 

operated in runtime. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
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Properties Read Write Description
TransparentColorDeactivatedPictu
re (Page 5669) 

P P Specifies the color to be set to "transparent" for the "Off" state 
of the assigned bitmap object.  

TransparentColorPictureOff 
(Page 5669) 

P P Specifies the color to be set to "transparent" for the "Off" state 
of the assigned bitmap object. 

TransparentColorPictureOn 
(Page 5670) 

P P Specifies the color to be set to "transparent" for the "On" state 
of the assigned bitmap object. 

UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

UseTransparentColorDeactivatedP
icture (Page 5717) 

P P Enables the use of the transparency color specified with the 
"TransparentColorDeactivatedPicture" property for the 
"Disabled" state. 

UseTransparentColorPictureOff 
(Page 5718) 

P P Specifies whether the transparent color defined in the 
"TransparentColorPictureOff" property is used for the "Off" 
state. 

UseTransparentColorPictureOn 
(Page 5718) 

P P Specifies whether the transparent color defined in the 
"TransparentColorPictureOn" property is used for the "On" 
state. 

VerticalAlignment (Page 5733) P P Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-106 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the 
specified property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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ScreenWindow

Description

Represents the "ScreenWindow" object. The ScreenWindow object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMIScreenWindow

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-107 Properties

Properties Read Write Description
AdaptScreenToWindow 
(Page 5194) 

- - Specifies whether or not the screen visualized in a screen window 
is adapted to fit the size of the screen window in runtime.  

AdaptWindowToScreen 
(Page 5194) 

- - Specifies whether or not the screen window is adapted to fit the 
screen it visualizes in runtime.  

BorderEnabled (Page 5240) - - TRUE, if the window is visualized with a border in runtime.  
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Properties Read Write Description
CaptionText (Page 5260) P P Specifies the text that is displayed in the header of the selected 

object. 
Flashing * - - Specifies that the text block flashes. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HorizontalScrollbarPosition 
(Page 5376) 

P P Sets horizontal positioning of the scroll bar in a screen window with 
slider, or returns its value. 

IndependentWindow - - Specifies whether the screen window is embedded in a screen or 
displayed as independent screen window. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LeftOffset (Page 5403) P P Sets horizontal shift of the display of a graphic object that is larger 

than the screen window. 
MenuToolBarConfig 
(Page 5431) 

- - Loads the specified configuration file with configured menu and 
toolbars, or returns the name of the configuration file.  

MonitorNumber - - Sets the monitor number. 
Name (Page 5452) P - Returns the object name as STRING. 
ScreenName (Page 5524) P P Specifies the screen to be displayed in the screen window, or 

returns the screen name. 
ShowCaption (Page 5552) - - Hides or shows the caption.  
ShowScrollBars (Page 5562) - - Enables the display of scroll bars.  
TagPrefix (Page 5604) P P Sets the prefix for all tags that exist in the screen. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
TopOffset (Page 5666) P P Sets or returns the offset of the screen from the top edge of the 

screen window. 
VerticalScrollbarPosition 
(Page 5735) 

P P Specifies the vertical positioning of the scroll bar in a screen 
window with slider, or returns its value. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowCloseEnabled 
(Page 5748) 

- - Enables closing of the window in runtime. 

WindowMaximizeEnabled 
(Page 5749) 

- - TRUE, if the window can be maximized in runtime. 

WindowMovingEnabled 
(Page 5749) 

- - TRUE, if the window can be moved in runtime. 

WindowOnTop (Page 5749) - - TRUE, if the object is always in the foreground in runtime. 
WindowSizingEnabled 
(Page 5750) 

- - Enables resizing of the specified object in runtime. 

WindowStartupPosition - - ??
ZoomFactor (Page 5775) P P Sets or reads the zoom factor of a screen or screen window. 

* not visible in the ES
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Table 10-108 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

ScriptDiagnostics

Description

Represents the "ApplicationWindow" object. The ApplicationWindow object is an element of 
the ScreenItems list.     

Type identifier in VBS
HMIApplicationWindow
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-109 Properties

Properties Read Write Description
BorderEnabled (Page 5240) - - TRUE, if the window is visualized with a border in runtime.  
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
Name (Page 5452) P P Returns the object name as STRING. 
ShowCaption (Page 5552) - - Hides or shows the caption.  
Template (Page 5606) - - Returns the templte for displaying the window content of the 

"Application window" object.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowCloseEnabled 
(Page 5748) 

- - Enables closing of the window in runtime. 

WindowMaximizeEnabled 
(Page 5749) 

- - TRUE, if the window can be maximized in runtime. 

WindowMovingEnabled 
(Page 5749) 

- - TRUE, if the window can be moved in runtime. 

WindowOnTop (Page 5749) - - TRUE, if the object is always in the foreground in runtime. 
WindowsContents (Page 5750) - - Returns the content of the application window 
WindowSizingEnabled 
(Page 5750) 

- - Enables resizing of the specified object in runtime. 

 

Table 10-110 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.
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See also
Screen object (list) (Page 4970)

Slider

Description

Represents the "Slider" object. The Slider object is an element of the ScreenItems list. 

Type identifier in VBS
HMISlider

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-111 Properties

Properties Read Write Description
Authorization  (Page 5212) - - Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackPicture - - Specifies a graphic for the background. 
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Properties Read Write Description
BarBackColor (Page 5227) P, A P, A Specifies the color of the bar background for the selected 

object. 
BarColor (Page 5230) P, A P, A Sets the color of the slider in the "Slider" object. 
BorderBrightColor3D (Page 5237) P, A P, A Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderInnerStyle3D (Page 5246) P P Specifies the representation of the inner part of the object 

border. 
BorderInnerWidth3D (Page 5246) P, A P, A Specifies the width of the inner border for 3D presentation of 

the selected object.  
BorderOuterStyle3D (Page 5247) P P Specifies the representation of the outer part of the object 

border. 
BorderOuterWidth3D (Page 5247) P, A P, A Sets the width of the outer border for 3D presentation of the 

selected object.  
BorderShadeColor3D (Page 5248) P, A P, A Specifies the border color of the following border parts in the 

3D display of the selected object. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object. 
Caption (Page 5257) P, A P, A Specifies the text that is displayed in the header of the 

selected object.  
ContinousChange (Page 5286) P P Specifies whether to transfer the value of the "ProcessValue" 

when the mouse button is released, or immediately on a 
change of the slider position in runtime. 

Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in 
runtime.  

Flashing - - Specifies that the text block flashes. 
FocusColor (Page 5344) P, A P, A Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 5345) P, A P, A Specifies the border width of the specified object when the 

object is in focus.  
Font - - Specifies or returns the font.  
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
LabelColor (Page 5384) P, A P, A Sets the color of the scale labeling in the "Slider" object. 
Layer (Page 5389) - - Specifies the value of the X coordinate of the object. 
Left  (Page 5401) P, A P, A Specifies the value of the X coordinate of the object.
MaximumValue (Page 5427) P, A P, A Specifies the maximum value of the scale in the selected 

object.  
MinimumValue (Page 5448) P, A P, A Specifies the minimum value of the scale in the selected 

object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
PositionFont - - Sets the font type for the labeling. 
ProcessValue (Page 5497) P, A P, A Specifies the default for the value to be displayed.  
ShowBar (Page 5551) P, A P, A Specifies whether to display the process value along with a 

filled bar in the "Slider" object. 
ShowPosition (Page 5559) P, A P, A Adds a numerical display of the value of the slider position. 
ShowThumb (Page 5567) P, A P, A Displays the slider of the "Slider" object.  
ShowTickLabels (Page 5567) P, A P, A Specifies whether the label is shown in the scale.
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Properties Read Write Description
ShowTicks (Page 5568) P, A P, A Specifies whether the tick marks are displayed in the scale 

of the object.
ThumbBackColor (Page 5611) P, A P, A Specifies the background color of the slider in the "Slider" 

object. 
ThumbPicture - -  Specifies a graphic object for the slider. 
TickStyle (Page 5613) P P Specifies the scale display.
Top  (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object.
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.

 

 

Table 10-112 Methods

Methods Validity Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic (Page 5786) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.

 

 

     

See also
ObjectName (Page 5460)

Screen object (list) (Page 4970)

Font (Page 5347)
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SmartClientView

Description

Represents the "Sm@rtClient View" object. The SmartClientView object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMISmartClientView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-113 Properties

Properties Read Write Description
AllowMenu (Page 5206) - - Specifies whether the shortcut menu is enabled to control the 

Sm@rtClient view. 
ConnectionType (Page 5285) - - Specifies the type of connector. You can select one of two connection 

types.  
ConnectOnStart - - Sets up the connection at startup. 
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Properties Read Write Description
Enabled (Page 5314) A A Specifies whether the selected object can be operated in runtime.  
Flashing - - Specifies that the text block flashes. 
Font (Page 5347) - - Specifies or returns the font.  
Height (Page 5361) A - Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
LocalCursor (Page 5419) - - Specifies whether the cursor data is transferred separately in order to 

increase the performance. 
MachineName  (Page 5425) A A Sets the network ID of the device that is to be monitored.  
Name (Page 5452) A - Returns the object name as STRING. 
Password  (Page 5482) A A Sets the password for remote monitoring. 
ScaleDenominator 
(Page 5522) 

- - Sets the scaling numerator on the client. 

ScaleNumerator (Page 5518) - - Sets the scaling numerator on the client. 
Scaling (Page 5522) - - TRUE, if an additional scale is used to visualize the values.  
ServerScale (Page 5542) - - Specifies whether the Sm@rtClient view can be zoomed in or out. 
Shared (Page 5548) - - Specifies that an HMI device is shared by several Sm@rtClient Views. 
ShowControls - - Specifies that a toolbar is displayed. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
UseCursorKeyScroll - - Sets the use of the background color of the object for printing. 
ViewOnly  (Page 5735) A A Enables the use of the Sm@rtClient view for remote monitoring or 

remote maintenance. 
Visible (Page 5735) * A A Specifies whether the selected object is visible. 
Width (Page 5746) A - Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-114 Methods

Methods Valid Description
Activate (Page 5777) A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)
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StatusForce

Description

Represents the "Status/Force" object. The StatusForce object is an element of the 
ScreenItems list.     

If you change the settings for this object with a user-defined function, the changed settings are 
retained even after the screen is called again. 

Type identifier in VBS
HMIStatusForce

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-115 Properties

Properties Read Write Description
Appearance - - Specifies the layout for this NC subroutine. 
BackColor (Page 5219) A A Specifies the background color of the selected object. 
ColumnsMoveable - - Specifies that the columns can be moved. 
CountVisibleItems (Page 5290) * - - Specifies the number of lines contained in the selection list.  
Enabled (Page 5314) A A Specifies whether the selected object can be operated in runtime.  
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Properties Read Write Description
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
Flashing - - Specifies that the text block flashes. 
FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object when 

it is in focus. 
FocusWidth (Page 5346) A A Specifies the border width of the specified object when the object 

is in focus.  
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
PLCFilter - - Sets the controller type. 
SelectionBackColor (Page 5534) A A Specifies the background color of the selected cells.  
SelectionForeColor (Page 5536) A A Specifies the foreground color of the selected cells.  
SetOfVisibleColumns - - Sets the visible columns. 
ShowReadButton - - Enables the display of the "Read" button. 
ShowTableGridlines 
(Page 5566) 

A A Enables the display of gridlines in the table of the specified object. 

ShowWriteButton - - Enables the display of the "Write" button. 
TableBackColor (Page 5597) A A Specifies the background color of the table cells for the selected 

object.  
TableFont - - Specifies the font in the table. 
TableForeColor (Page 5600) A A ??
TableHeaderBackColor 
(Page 5602) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor 
(Page 5603) 

A A Specifies the text color in the header of the table of the selected 
object. 

Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) * A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-116 Methods

Methods Valid Description
Activate (Page 5777) A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)
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ScreenItem (Page 4941)

ScreenItems (Page 4943)

Switch

Description

Represents the "Switch" object. The Switch object is an element of the ScreenItems list. 

     

The availability of the following object properties depends on the selected mode:

Property "Switch with text" "Switch with graphic" "Switch"
CaptionColor -- -- x
CaptionText -- -- x
HorizontalAlignment X -- --
InnerBackColorOff -- -- x
InnerBackColorOn -- -- x
TextOn x -- x
TextOff x -- x
VerticalAlignment x -- --

Type identifier in VBS
HMISwitch
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-117 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 5184) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

Authorization (Page 5212) - - Specifies the operating rights of the selected object in runtime.  
AutoSizing - - Specifies that the size of the object should be automatically 

adapted to the content. 
BackColor (Page 5218) A A Specifies the background color of the selected object. 
BackFlashingColorOff 
(Page 5224) *

- - Specifies the background color for flash state "Off". 

BackFlashingColorOn 
(Page 5225) *

- -  Specifies the background color for flash state "On".  

BackFlashingEnabled 
(Page 5226) *

- - Specifies whether the background of the specified object 
flashes in runtime. 

BackFlashingRate 
(Page 5226) *

- - Specifies the flash rate of the background for the selected 
object. 

BelowLowerLimitColor 
(Page 5233) 

- - Sets the color of the specified object for the "Low limit violated" 
event. 

BorderColor (Page 5238) * - - Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) *

- - Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) *

- - Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) *

- - Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate 
(Page 5245) *

- - Specifies the flash rate of the border line for the selected object.  

BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) * - - Specifies the line thickness of the object. 
BorderWidth3D (Page 5254) 
*

- - Specifies the width of the border for 3D display of the selected 
object. 

CaptionColor (Page 5259) A A Specifies the color of the text that is displayed in the header of 
the selected object.  

CaptionFont - - Specifies the character set for the caption. 
CaptionText (Page 5260) A A Specifies the text that is displayed in the header of the selected 

object. 
CornerStyle (Page 5286) * - - Specifies the type of border lines for the selected object.  
EdgeStyle (Page 5309) * - - Specifies the line style of the selected object.  
Enabled (Page 5313) A A Specifies whether the selected object can be operated in 

runtime.  
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Properties Read Write Description
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff 
(Page 5336) *

- - Specifies the border line color of the selected object for the flash 
state "Off".  

FlashingColorOn 
(Page 5338) *

- - Specifies the border line color of the selected object for the flash 
state "On".  

FlashingEnabled 
(Page 5339) *

- - Specifies whether the border line of the selected object flashes 
in runtime.  

FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 5340) * - - Specifies the flash rate of the border line for the selected object.  
FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 5345) A A Specifies the border width of the specified object when the 

object is in focus.  
Font (Page 5347) - - Specifies or returns the font.  
ForeColor (Page 5352) A A Specifies the font color of the text for the selected object. 
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for the 

specified object.  
HorizontalAlignment 
(Page 5374) 

A A Specifies the horizontal alignment of the text within the selected 
object. 

InnerBackColorOff 
(Page 5379) 

A A Sets the color underneath the slider of the "Switch" object for 
the object in OFF state. 

InnerBackColorOn 
(Page 5380) 

A A Sets the color underneath the slider of the "Switch" object for 
the object in ON state. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 
screen. 

Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
LineEndShapeStyle 
(Page 5415) *

- - Specifies the shape of the line end. 

Mode (Page 5450) - - Specifies the field type of the selected object. 
Name (Page 5452) A - Returns the object name as STRING. 
OnValue - - Specifies the value for the "ON" state in "two-state" mode. 
PictureOff (Page 5490) - - Specifies the screen to be displayed in the "Off" state.  
PictureOn (Page 5491) - - Specifies the screen to be displayed in the "On" state.  
ProcessValue (Page 5498) - - Specifies the default for the value to be displayed.  
SwitchOrientation - - Specifies the line color of the object. 
TextOff (Page 5608) A A Specifies the text to be displayed in the "Off" state of the 

selected object.  
TextOn (Page 5609) A A Specifies the text to be displayed in the "On" state of the 

selected object.  
TextOrientation (Page 5610) 
*

- - Specifies the text orientation of the selected object.  

Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
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Properties Read Write Description
VerticalAlignment 
(Page 5733) 

A A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 5735) * A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-118 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 4970)

SymbolicIOField

Description

Represents the "SymbolicIOField" object. The SymbolicIOField object is an element of the 
ScreenItems list. 

     

The availability of the following object properties depends on the selected mode:
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Property "Input" "Output" "Input/Output" "Two states"
BackColor x x x x
BorderColor -- x -- x
BorderWidth -- -- -- x
BorderStyle3D -- x -- --
Enabled x -- x --
HelpText x -- x --
VerticalAlignment -- x -- x
HorizontalAlignment -- x -- x

Type identifier in VBS
HMISymbolicIOField

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-119 Properties

Properties Read Write Description
AboveUpperLimitColor (Page 5184) - - Sets the color of the specified object for the "High limit 

violated" event. 
AcceptOnExit (Page 5185) P P Specifies whether the input field is confirmed automatically 

when it is left. 
AdaptBorder (Page 5193) - - Specifies whether the border of the specified object is 

dynamically adapted to the text size.  
AskOperationMotive (Page 5210) P P Specifies whether the reason for operating this object is 

logged. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in 

runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 5224) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 5225) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 5226) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected 

object. 
BelowLowerLimitColor (Page 5233) - - Sets the color of the specified object for the "Low limit violated" 

event. 
BitNumber (Page 5233) P P Specifies the bit whose status must change to trigger a value 

change.  
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Properties Read Write Description
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for 

the selected object.  
BorderColor (Page 5238) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff (Page 5242) P P Specifies the border line color of the selected object for the 

flash state "Off".  
BorderFlashingColorOn (Page 5243) P P Specifies the border line color of the selected object for the 

flash state "On".  
BorderFlashingEnabled (Page 5244) P P Specifies whether the border line of the selected object 

flashes in runtime. 
BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected 

object.  
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object. 
BottomMargin - - Sets the margin between the text and the bottom edge of the 

object. 
CaptionBackColor (Page 5258) P P Specifies the background color of the caption for the selected 

object. 
CaptionColor (Page 5259) P P Specifies the color of the text that is displayed in the header 

of the selected object.  
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
CountVisibleItems (Page 5290) P P Specifies the number of lines contained in the selection list.  
CursorControl (Page 5292) P P Specifies whether the mouse cursor jumps to the next field of 

the TAB sequence after leaving a field.  
DrawInsideFrame (Page 5307) - - Specifies whether the border line of the selected object with 

a line thickness greater than 1 should be drawn within the 
border or symmetrically to the border. 

EdgeStyle (Page 5310) P P Specifies the line style of the selected object.  
EditOnFocus (Page 5312) P P Specifies whether data input is immediately possible if the 

input field is selected using the "Tab" key.  
Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in 

runtime.  
FieldLength - - Specifies that the "field length string" field is read-only. 
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the 

flash state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the 

flash state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object 

flashes in runtime.  
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected 

object.  
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Properties Read Write Description
FocusColor (Page 5344) - - Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 5345) - - Specifies the border width of the specified object when the 

object is in focus.  
Font (Page 5347) - - Specifies or returns the font.  
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 5350) P P Specifies the font of the selected object.  
FontSize (Page 5351) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined.  
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 5361) P, A P, A  Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for 

the specified object.  
HorizontalAlignment (Page 5374) P, A P, A Specifies the horizontal alignment of the text within the 

selected object. 
InputValue (Page 5380) - - Defines the value entered by the user in the IO field.  
ItemBorderStyle (Page 5383) P P Sets the separation line style in the selection list of the 

specified object. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LeftMargin - - Sets the margin between the text and the left edge of the 

object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
LogOperation (Page 5420) P P Specifies whether, after operating this object, an alarm is 

output to the alarm system.  
Mode (Page 5450) P P Specifies the field type of the selected object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
OnValue - - Specifies the value for the "ON" state in "two-state" mode. 
ProcessValue (Page 5497) P P Specifies the default for the value to be displayed.  
RightMargin - - Sets the margin between the text and the right edge of the 

object. 
SelectBackColor (Page 5528) P P Specifies the background color of the selected cells.  
SelectForeColor (Page 5532) P P Specifies the foreground color of the selected cells.  
SeparatorBackColor (Page 5540) P P Specifies the background color of the broken separation lines 

in the selection list of the specified object. 
SeparatorColor (Page 5540) P P Sets the color of the separation lines in the selection list of the 

specified object.  
SeparatorCornerStyle (Page 5541) P P Sets the shape of corners for the object of the type 

"ScreenItem" with "SymbolicIOField" format. 
SeparatorLineEndShapeStyle 
(Page 5542) 

P P Sets the shape of line ends for the object of the type 
"ScreenItem" with "SymbolicIOField" format. 
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Properties Read Write Description
SeparatorStyle (Page 5541) P P Sets the separation line style in the selection list of the 

specified object.  
SeparatorWidth (Page 5542) P P Sets the width separation lines in the selection list of the 

specified object.  
ShowBadTagState (Page 5551) P P Specifies whether an object is grayed out if its associated tag 

has a bad quality code or tag state. 
ShowDropDownButton - - Sets the display of a button for the selection list. 
ShowDropDownList - - Specifies selection of the entry from a selection list. 
TextList (Page 5608) - - Specifies the label for the text field.  
TextOff (Page 5608) - - Specifies the text to be displayed in the "Off" state of the 

selected object.  
TextOn (Page 5609) - - Specifies the text to be displayed in the "On" state of the 

selected object.  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
TopMargin - - Sets the margin between the text and the top edge of the 

object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

VerticalAlignment (Page 5733) P, A P, A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

 

Table 10-120 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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SymbolLibrary

Description

Represents the "SymbolLibrary" object. The SymbolLibrary object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMISymbolLibrary

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-121 Properties

Properties Read Write Description
AboveUpperLimitColor 
(Page 5184) 

- - Sets the color of the specified object for the "High limit violated" 
event. 

Authorization (Page 5212) - - Specifies the operating rights of the selected object in runtime. 
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object. 
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Properties Read Write Description
BelowLowerLimitColor 
(Page 5233) 

- - Sets the color of the specified object for the "Low limit violated" 
event. 

BlinkColor (Page 5234) P, A P, A Sets the flashing color for the "SymbolLibrary" object. 
BlinkMode (Page 5234) P P Sets the type of flashing graphic for the specified object. 
BlinkSpeed (Page 5235) P P Sets the flash rate. 
ChangeMouseCursor 
(Page 5267) 

P P Specifies the appearance of the cursor after its transformation 
in mouse over icon mode in runtime. 

Enabled (Page 5313) P, A P, A Specifies whether the selected object can be operated in 
runtime. 

FillColorMode (Page 5331) P P Sets the type of foreground for the specified object. 
FixedAspectRatio (Page 5335) P P Specifies whether the aspect ratio should be retained on 

changes of the icon size, or follow the change dynamically. 
Flashing - - Specifies that the text block flashes. 
FlashingOnLimitViolation - - Specifies that flashing is activated when a limit is violated. 
Flip (Page 5343) P P Flips the symbol on the vertical and / or horizontal center axis 

of the icon. 
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
Name (Page 5452) P, A -  Returns the object name as STRING. 
ProcessValue (Page 5498) - - Specifies the default for the value to be displayed. 
Rotation (Page 5507) P P Specifies the angle of rotation in degrees of the selected object. 
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  

 

Table 10-122 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)
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SystemDiagnoseView

Description

Represents the "System diagnostic view" object. The SystemDiagnoseView object is an 
element of the ScreenItems list. 

Type identifier in VBS
HMISysDiagView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-123 Properties

Properties Read Write Description
Authorization (Page 5212) A A Specifies the operating rights of the selected object in 

runtime.  
BackgroundColor A A Specifies the background color.
ComponentInfoText A A Specifies the tooltip of the system diagnostics view in 

runtime.
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Properties Read Write Description
Enabled (Page 5314) A A Specifies whether the selected object can be operated in 

runtime.  
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
InfoArea_BackgroundColor A A Specifies the background for grid control elements. 
InfoArea_ColumnsMovable A A Specifies the mobility of columns.  
InfoArea_DefaultTextColor A A Sets the text color. 
InfoArea_ErrorTextBackgroundColor A A Specifies the background color of a cell in error case. 
InfoArea_ErrorTextColor A A Sets the text color of a cell in error case. 
InfoArea_FocusFrameColor A A Sets the color of the focus frame. 
InfoArea_FocusFrameWidth A A Sets the line thickness of the focus rectangle. 
InfoArea_Font A A Sets the fonts of the grid views. 
InfoArea_ShowGridLines A A Sets the grid lines. 
InfoArea_TableHeaderBackgroundColo
r 

A A Specifies the background color of the table header. 

InfoArea_TableHeaderTextColor A A Sets the text color of the table header. 
InputAddressText A A Sets the input address. 
ItemText_AKZ A A Specifies the header for the "AKZ" column. 
ItemText_Descriptor A A Specifies the header for the "Descriptor" column. 
ItemText_ErrorText A A Specifies the header for the "ErrorText" column. 
ItemText_InstallationDate A A Specifies the header for the "InstallationDate" column. 
ItemText_LADDR A A Specifies the header for the "LADDR" column. 
ItemText_Name A A Sets the labeling of the "Name" column. 
ItemText_OKZ A A Specifies the header for the "OKZ" column. 
ItemText_OperationState A A Specifies the header for the "OperationState" column. 
ItemText_OrderID A A Specifies the header for the "OrderID" column. 
ItemText_Rack A A Specifies the header for the "Rack" column. 
ItemText_Slot A A Specifies the header for the "Slot" column. 
ItemText_SoftwareRevision A A Specifies the header for the "SoftwareRevision" column. 
ItemText_State A A Specifies the header for the "State" column. 
ItemText_Station A A Specifies the header for the "Station" column. 
ItemText_SubAddress A A Specifies the header for the "SubAddress" column. 
ItemText_SubSlot A A Specifies the header for the "SubSlot" column. 
ItemText_SubSystem A A Specifies the header for the "SubSystem" column. 
ItemText_Type A A Specifies the header for the "Type" column. 
IV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
IV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
IV_ShowItem_ErrorText A A Enables the display of the "ErrorText" column. 
IV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
IV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
IV_ShowItem_Name A A Enables the display of the "Name" column. 
IV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
IV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
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Properties Read Write Description
IV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
IV_ShowItem_Rack A A Enables the display of the "Rack" column. 
IV_ShowItem_Slot A A Enables the display of the "Slot" column. 
IV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
IV_ShowItem_State A A Enables the display of the "State" column. 
IV_ShowItem_Station A A Enables the display of the "Station" column. 
IV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
IV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
IV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
IV_ShowItem_Type A A Enables the display of the "Type" column. 
Layer (Page 5389) A - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
NavigationPath_Font A A Sets the font type of the navigation path. 
NavigationPath_TextColor A A Sets the text color of the navigation path. 
ObjectName (Page 5460) A - Returns the object name as STRING. 
OutputAddressText A A Specifies the text for the output address. 
ShowNavigationButtons A A Enables the display of navigation buttons. 
ShowPathInformation A A Enables the display of the navigation path. 
ShowSplittedView A A Enables a split view. 
TableHeaderFont A A Specifies the text color of the header. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Type (Page 5697) A - Returns the type of the specified object as STRING.
Parent (Page 5480) A - Returns the screen in which the specified object is 

embedded. 
UV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
UV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
UV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
UV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
UV_ShowItem_Name A A Enables the display of the "Name" column. 
UV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
UV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
UV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
UV_ShowItem_Rack A A Enables the display of the "Rack" column. 
UV_ShowItem_Slot A A Enables the display of the "Slot" column. 
UV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
UV_ShowItem_State A A Enables the display of the "State" column. 
UV_ShowItem_Station A A Enables the display of the "Station" column. 
UV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
UV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
UV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
UV_ShowItem_Type A A Enables the display of the "Type" column. 
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Properties Read Write Description
Visible (Page 5735) A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Enables the display of the "Slot" column. 

Table 10-124 Methods

Methods Valid Description
Activate (Page 5777) A Activates the permanent window or the root screen. 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

Name  (Page 5452)

SystemDiagnoseWindow

Description

Represents the "System diagnostic window" object. The SystemDiagnoseWindow object is an 
element of the ScreenItems list. 
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Type identifier in VBS
HMISysDiagWindow

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-125 Properties

Properties Read Write Description
Authorization (Page 5212) A A Specifies the operating rights of the selected object in 

runtime.  
BackgroundColor A A Specifies the background color.
Caption (Page 5257) A A Specifies the text that is displayed in the header of the 

selected object.  
CaptionActive A A Enables display of the caption. 
Closable (Page 5272) A A Specifies that the control can be closed in runtime. 
ComponentInfoText A A Specifies the tooltip of the system diagnostics view in 

runtime.
Enabled (Page 5314) A A Specifies whether the selected object can be operated 

in runtime.  
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
InfoArea_BackgroundColor A A Specifies the background for grid control elements. 
InfoArea_ColumnsMovable A A Specifies the mobility of columns.  
InfoArea_DefaultTextColor A A Sets the text color. 
InfoArea_ErrorTextBackgroundColor A A Specifies the background color of a cell in error case. 
InfoArea_ErrorTextColor A A Sets the text color of a cell in error case. 
InfoArea_FocusFrameColor A A Sets the color of the focus frame. 
InfoArea_FocusFrameWidth A A Sets the line thickness of the focus rectangle. 
InfoArea_Font A A Sets the fonts of the grid views. 
InfoArea_ShowGridLines A A Sets the grid lines. 
InfoArea_TableHeaderBackgroundColor A A Specifies the background color of the table header. 
InfoArea_TableHeaderTextColor A A Sets the text color of the table header. 
InputAddressText A A Sets the input address. 
ItemText_AKZ A A Specifies the header for the "AKZ" column. 
ItemText_Descriptor A A Specifies the header for the "Descriptor" column. 
ItemText_ErrorText A A Specifies the header for the "ErrorText" column. 
ItemText_InstallationDate A A Specifies the header for the "InstallationDate" column. 
ItemText_LADDR A A Specifies the header for the "LADDR" column. 
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Properties Read Write Description
ItemText_Name A A Sets the labeling of the "Name" column. 
ItemText_OKZ A A Specifies the header for the "OKZ" column. 
ItemText_OperationState A A Specifies the header for the "OperationState" column. 
ItemText_OrderID A A Specifies the header for the "OrderID" column. 
ItemText_Rack A A Specifies the header for the "Rack" column. 
ItemText_Slot A A Specifies the header for the "Slot" column. 
ItemText_SoftwareRevision A A Specifies the header for the "SoftwareRevision" column. 
ItemText_State A A Specifies the header for the "State" column. 
ItemText_Station A A Specifies the header for the "Station" column. 
ItemText_SubAddress A A Specifies the header for the "SubAddress" column. 
ItemText_SubSlot A A Specifies the header for the "SubSlot" column. 
ItemText_SubSystem A A Specifies the header for the "SubSystem" column. 
ItemText_Type A A Specifies the header for the "Type" column. 
IV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
IV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
IV_ShowItem_ErrorText A A Enables the display of the "ErrorText" column. 
IV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
IV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
IV_ShowItem_Name A A Enables the display of the "Name" column. 
IV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
IV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
IV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
IV_ShowItem_Rack A A Enables the display of the "Rack" column. 
IV_ShowItem_Slot A A Enables the display of the "Slot" column. 
IV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
IV_ShowItem_State A A Enables the display of the "State" column. 
IV_ShowItem_Station A A Enables the display of the "Station" column. 
IV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
IV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
IV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
IV_ShowItem_Type A A Enables the display of the "Type" column. 
Layer (Page 5389) A - Returns the layer that contains an object as LONG in 

the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Modal A A Specifies that you must acknowledge the alarm view 

before continuing with your work. 
NavigationPath_Font A A Sets the font type of the navigation path. 
NavigationPath_TextColor A A Sets the text color of the navigation path. 
ObjectName (Page 5460) A - Returns the object name as STRING. 
OutputAddressText A A Specifies the text for the output address. 
Resizable A A Enables resizing of the window. 
ShowNavigationButtons A A Enables the display of navigation buttons. 
ShowPathInformation A A Enables the display of the navigation path. 
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Properties Read Write Description
ShowSplittedView A A Enables a split view. 
TableHeaderFont A A Specifies the text color of the header. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Type (Page 5697) A - Returns the type of the specified object as STRING.
Parent (Page 5480) A - Returns the screen in which the specified object is 

embedded. 
UV_ShowItem_AKZ A A Enables the display of the "AKZ" column. 
UV_ShowItem_Descriptor A A Enables the display of the "Descriptor" column. 
UV_ShowItem_InstallationDate A A Enables the display of the "InstallationDate" column. 
UV_ShowItem_LADDR A A Enables the display of the "LADDR" column. 
UV_ShowItem_Name A A Enables the display of the "Name" column. 
UV_ShowItem_OKZ A A Enables the display of the "OKZ" column. 
UV_ShowItem_OperationState A A Enables the display of the "OperationState" column. 
UV_ShowItem_OrderID A A Enables the display of the "OrderID" column. 
UV_ShowItem_Rack A A Enables the display of the "Rack" column. 
UV_ShowItem_Slot A A Enables the display of the "Slot" column. 
UV_ShowItem_SoftwareRevision A A Enables the display of the "SoftwareRevision" column. 
UV_ShowItem_State A A Enables the display of the "State" column. 
UV_ShowItem_Station A A Enables the display of the "Station" column. 
UV_ShowItem_SubAddress A A Enables the display of the "SubAddress" column. 
UV_ShowItem_SubSlot A A Enables the display of the "SubSlot" column. 
UV_ShowItem_SubSystem A A Enables the display of the "SubSystem" column. 
UV_ShowItem_Type A A Enables the display of the "Type" column. 
Visible (Page 5735) A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
WindowMode A A Sets the window mode. 

Table 10-126 Methods

Methods Valid Description
Activate (Page 5777) A Activates the permanent window or the root screen. 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

Name  (Page 5452)
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TextField

Description

Represents the "TextField" object. The TextField object is an element of the ScreenItems list. 

Type identifier in VBS
HMITextField

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-127 Properties

Properties Read Write Description
AdaptBorder (Page 5193) P P Specifies whether the border of the specified object is 

dynamically adapted to the text size.  
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P, A P, A Specifies the background color of the selected object. 
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 5224) P P Specifies the background color for flash state "Off". 
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Properties Read Write Description
BackFlashingColorOn (Page 5225) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 5226) P P Specifies whether the background of the specified object 

flashes in runtime. 
BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected 

object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P, A P, A Specifies the line color of the object. 
BorderFlashingColorOff 
(Page 5242) 

P P Specifies the border line color of the selected object for the flash 
state "Off".  

BorderFlashingColorOn 
(Page 5243) 

P P Specifies the border line color of the selected object for the flash 
state "On".  

BorderFlashingEnabled 
(Page 5244) 

P P Specifies whether the border line of the selected object flashes 
in runtime. 

BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderStyle3D (Page 5251) A A Specifies whether the object has a 3D border shading. 
BorderWidth (Page 5252) P, A P, A Specifies the line thickness of the object. 
BottomMargin - - Sets the margin between the text and the bottom edge of the 

object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a 

line thickness greater than 1 should be drawn within the border 
or symmetrically to the border. 

EdgeStyle (Page 5310) A A Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
FitToLargest - - Specifies that the size of the object depends on the text length 

in all languages. 
Flashing - - Specifies that the text block flashes. 
FlashingColorOff (Page 5336) P P Specifies the border line color of the selected object for the flash 

state "Off".  
FlashingColorOn (Page 5338) P P Specifies the border line color of the selected object for the flash 

state "On".  
FlashingEnabled (Page 5339) P P Specifies whether the border line of the selected object flashes 

in runtime.  
FlashingRate (Page 5340) P P Specifies the flash rate of the border line for the selected object.  
Font (Page 5347) - - Specifies or returns the font.  
FontBold (Page 5348) P P Specifies whether the text of the selected object is shown in 

bold. 
FontItalic (Page 5349) P P Specifies whether the text of the selected object is shown in 

italics. 
FontName (Page 5350) P P Specifies the font of the selected object.  
FontSize (Page 5351) P P Specifies the font size of the text for the selected object.  
FontUnderline (Page 5351) P P Specifies whether the text of the selected object is underlined.  
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Properties Read Write Description
ForeColor (Page 5352) P, A P, A Specifies the font color of the text for the selected object. 
Height (Page 5361) P, A P, A Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HorizontalAlignment (Page 5374) P, A P, A Specifies the horizontal alignment of the text within the selected 

object. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P, A P, A Specifies the value of the X coordinate of the object. 
LeftMargin - - Sets the margin between the text and the left edge of the object. 
LineEndShapeStyle (Page 5415) P P Specifies the shape of the line end. 
LineWrap * - - Specifies the line break within the object. 
Name (Page 5452) P, A - Returns the object name as STRING. 
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
RightMargin - - Sets the margin between the text and the right edge of the 

object. 
RotationAngle (Page 5507) P P Specifies the angle of rotation in degrees.  
RotationCenterLeft (Page 5508) P P Specifies the X coordinate of the pivot point for the object in 

runtime. 
RotationCenterTop (Page 5509) P P Specifies the Y coordinate of the pivot point for the object in 

runtime. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
Text (Page 5607) P, A P, A Specifies the label for the text field.  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P, A P, A Specifies the value of the Y coordinate of the object. 
TopMargin - - Sets the margin between the text and the top edge of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the 

object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading 
defined in the active design. 

VerticalAlignment (Page 5733) P, A P, A Specifies the vertical alignment of the text for the selected 
object. 

Visible (Page 5735) P, A P, A Specifies whether the selected object is visible. 
Width (Page 5746) P, A P, A Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 

* not visible in the ES
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Table 10-128 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

TrendRulerControl

Description     

Represents the "Value table" object. The TrendRulerControl object is an element of the 
ScreenItems list. 

Type identifier in VBS
HMITrendRulerControl
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Example
In the following example, the object with the name "Control1" is moved 16 pixels to the right:

 
'VBS60
Dim objControl
Set objControl = ScreenItems("Control1")
objControl.Left = objControl.Left + 16

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-129 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode - - Specifies that the project settings are used for the design. 
AutoCompleteColumns (Page 5213) P P Specifies whether empty columns are shown if the control 

is wider than the configured columns. 
AutoCompleteRows (Page 5214) P P Specifies whether empty rows are shown if the control is 

longer than the number of configured rows. 
AutoPosition P P Sets the automatic repositioning mode. 
AutoSelectionColors (Page 5215) P P Specifies whether the colors defined by the system are 

used as the selection colors for cells and rows. 
AutoSelectionRectColor (Page 5216) P P Specifies whether the selection frame is shown with the 

color defined by the system. 
AutoShow P P Specifies the automatic display of the value table. 
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BlockAlign * P P Sets the alignment. 
BlockAutoPrecisions * P P Specifies that the number of decimal places displayed for 

an axis is adjusted automatically. 
BlockCaption * P P Sets the caption. 
BlockCount * P P Sets the number of blocks. 
BlockDateFormat * P P Specifies the date format. 
BlockExponentialFormat * P P Enables the use of the exponential notation. 
BlockHideText * P P Specifies whether the text is displayed. 
BlockHideTitleText * P P Specifies whether the text is displayed. 
BlockId * P P Sets the ID. 
BlockIndex P P The index specifies the block to which other properties 

such as names are referenced. 
BlockLength * P P Specifies the number of displayed characters. 
BlockName * P P Sets the name of a block. 
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Properties Read Write Description
BlockPrecisions * P P Specifies the number of displayed decimal places. 
Blocks - - Sets the alarm blocks. 
BlockShowDate * P P Specifies that the date is to be displayed. 
BlockShowIcon * P P Specifies the tooltip text. 
BlockShowTitleIcon * P P Enables the display of title as icon. 
BlockTimeFormat * P P Specifies the time format. 
BlockUseSourceFormat * P P Enables the use of the source format. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
Caption (Page 5257) P P Specifies the text that is displayed in the header of the 

selected object. 
CellCut (Page 5261) P P Specifies whether the contents of the cells are abbreviated 

if the cells are too narrow. 
CellSpaceBottom (Page 5262) P P Specifies the bottom margin of the table cells. 
CellSpaceLeft (Page 5263) P P Sets the left indent for the table cells. 
CellSpaceRight (Page 5263) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 5264) P P Specifies the top margin of the table cells. 
Closeable (Page 5272) P P Specifies that the control can be closed in runtime. 
ColumnAdd  * P P Adds a column. 
ColumnCount * P P Displays the number of columns. 
ColumnIndex P P The index specifies on which column other properties, e.g. 

initial value are based. 
ColumnName  * P P Specifies the name of a column. 
ColumnRemove  * P P Removes a column. 
ColumnRepos  * P P Repositions the column. 
ColumnResize (Page 5279) P P Enables changes to the width of columns. 
ColumnScrollbar (Page 5280) P P Specifies the scroll bar type. 
ColumnSort  * P P Sets the type of sorting. 
ColumnSortIndex  * P P Specifies the sorting order. 
ColumnTitleAlignment P P Specifies the type of column title alignment. 
ColumnTitles (Page 5282) P P Specifies whether the column header is displayed. 
ColumnVisible * P P Enables the visibility of a column. 
ControlDesignMode (Page 5573) P P Specifies the design. 
ExportDirectoryChangeable 
(Page 5322) 

P P Specifies whether the data export directory can be 
changed in runtime. 

ExportDirectoryname (Page 5322) P P Specifies the target directory for the exported Runtime 
data. 

ExportFileExtension (Page 5323) P P Specifies the file extension of the export file. Only the "csv" 
file extension is currently supported. 

ExportFilename (Page 5323) P P Specifies the name of the target file for the exported 
Runtime data. 

ExportFilenameChangeable 
(Page 5324) 

P P Specifies whether the export file name can be changed in 
runtime. 

ExportFormatGuid (Page 5325) P P Default assignment of the ID number and export provider. 
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Properties Read Write Description
ExportFormatName (Page 5325) P P Specifies the export file format. Only the "csv" file format 

is currently available for the export. 
ExportParameters (Page 5326) P P Specifies the parameters of the selected format by means 

of the "Properties" dialog. 
ExportSelection (Page 5326) P P Specifies the file extension of the export file. Only the "csv" 

file extension is currently supported. 
ExportShowDialog (Page 5327) P P Specifies whether the data export dialog is shown in 

runtime. 
Font (Page 5347) - - Specifies or returns the font. 
GridLineColor (Page 5359) P P Specifies the color for the grid lines. 
GridLineWidth (Page 5360) P P Specifies the width of the separation lines in pixels. 
Height (Page 5361) P - Sets the height of the specified "Ellipse", "Circle" and 

"Rectangle" objects. 
HorizontalGridLines (Page 5375) P P Specifies whether horizontal separation lines are 

displayed. 
IconSpace (Page 5378) P P Specifies the spacing between icons and text in the table 

cells. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 5414) P P Sets the color of the window separation lines. 
LineWidth (Page 5416) P P  Specifies the line thickness of the selected object. 
Moveable (Page 5451) P P  Specifies whether the window can be moved in runtime. 
Name (Page 5452) P -  Returns the object name as STRING. 
PrintJob P P Specifies a print job 
RowScrollbar (Page 5510) P P Specifies whether row scroll bars are displayed. 
RowTitleAlignment P P Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 5512) P P Specifies how online configurations of WinCC are 

retained. 
RTPersistencePasswordLevel 
(Page 5513) 

P P Specifies the authorization required for online 
configuration in runtime. 

RTPersistenceType (Page 5513) - - Specifies how online configurations of WinCC are 
retained. 

RulerType P P Sets the ruler type. 
SelectedCellColor (Page 5528) P P Specifies the background color of the selected cell. 
SelectedCellForeColor (Page 5529) P P Specifies the font color of the selected cell. 
SelectedRowColor (Page 5530) P P Specifies the background color of the selected row. 
SelectedRowForeColor (Page 5530) P P Specifies the font color of the selected row. 
SelectedTitleColor (Page 5531) P P Specifies the background color of a selected table header. 
SelectedTitleForeColor (Page 5532) P P Specifies the font color of the selected table header. 
SelectionColoring (Page 5534) P P Specifies whether selection colors are used for cells or 

rows. 
SelectionRect (Page 5537) P P Specifies whether a selection frame is used for the 

selected cells or rows. 
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Properties Read Write Description
SelectionRectColor (Page 5538) P P Specifies the color of the selection rectangle in the alarm 

window if SelectionType equals "1". 
SelectionRectWidth (Page 5539) P P Specifies the line width of the selection rectangle in the 

alarm window if SelectionType equals "1". 
SelectionType (Page 5539) P P Specifies the number of lines you can mark. 
ShareSpaceWithSourceControl P P Enables the display of the value table in the visualization 

range of the data source. 
ShowSortButton (Page 5563) P P Specifies whether the sorting button is shown above the 

vertical scroll bar. 
ShowSortIcon (Page 5564) P P Specifies whether the sorting icon is displayed. 
ShowSortIndex (Page 5565) P P  
ShowTitle (Page 5569) P P Specifies the layout of the control window's header. 
Sizeable (Page 5573) P P Specifies that the size of an object can be changed in 

runtime. 
SortSequence (Page 5577) P P Specifies how the sorting order can be changed by mouse 

click. 
SourceControl P P Sets the data source. 
SourceControlType P P Sets the data source type. 
StatusbarBackColor (Page 5582) P P Specifies the background color of the status bar. 
StatusbarElementAdd  (Page 5582) * P P Creates a new, user-defined status bar element. 
StatusbarElementAutoSize 
(Page 5583) *

P P Specifies whether the width of the selected status bar 
element is set automatically. 

StatusbarElementCount  (Page 5583) * P P Specifies the number of configurable status bar elements. 
StatusbarElementIconId  (Page 5584) * P P Default assignment of the ID number and icon of a status 

bar element. 
StatusbarElementId  (Page 5584) * P P Unique ID of the selected status bar element. 
StatusbarElementIndex (Page 5585) P P References a status bar element. You can use this 

property to assign the values of other properties to a 
specific element of the status bar. 

StatusbarElementName  (Page 5585) * P P Displays the object name of the selected status bar 
element. 

StatusbarElementRemove  (Page 5586) 
*

P P Removes the selected status bar element. 

StatusbarElementRename  (Page 5586) 
*

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 5586) - - Specifies the elements that are to be shown in the status 

bar. 
StatusbarElementText P P Specifies the text of the currently selected status bar 

element. 
StatusbarElementTooltipText  
(Page 5587) *

P P Specifies the tooltip text for the user-defined status bar 
element. 

StatusbarElementUserDefined  
(Page 5587) *

P P Indicates whether the configuration engineer has added 
the status bar element as a new user-defined element. 

StatusbarElementVisible  (Page 5588) * P P In the list, activate the status bar elements that you wish 
to display in runtime. 
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Properties Read Write Description
StatusbarElementWidth  (Page 5589) * P P Specifies the width of the selected status bar element in 

pixels. 
StatusbarFont - - Status bar font 
StatusbarFontColor (Page 5589) P P Specifies the color of the text in the status bar. 
StatusbarShowTooltips (Page 5591) P P Specifies whether tooltips are displayed for the elements 

of the status bar in runtime. 
StatusbarText (Page 5592) P P Default text in the status bar. 
StatusbarUseBackColor (Page 5593) P P Specifies whether the background color of the status bar 

is shown. 
StatusbarVisible (Page 5593) P P Specifies whether the status bar of the control is displayed. 
TableColor (Page 5598) P P Specifies the background color of the rows. Use this to 

open the color selection dialog. 
TableColor2 (Page 5598) P P Specifies the background color of "Row color 2". 
TableForeColor (Page 5599) P P  
TableForeColor2 (Page 5601) P P Specifies the font color of "Row color 2". 
TimeBase (Page 5619) P P Sets the timebase. 
TitleColor P P Specifies the color of the header. 
TitleCut (Page 5641) P P Specifies whether the contents of the fields of a header 

should be abbreviated if the column is too narrow. 
TitleDarkShadowColor (Page 5641) P P Specifies the color of the dark side of shading. 
TitleForeColor (Page 5641) P P Specifies the font color of the table header for the selected 

status. 
TitleGridLineColor (Page 5642) P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor (Page 5642) P P Specifies the color of the bright side of shading. 
TitleSort (Page 5642) P P Specifies how sorting by column header is triggered. 
TitleStyle (Page 5643) P P Specifies whether a shading color is used for the table 

header. 
ToolbarAlignment (Page 5650) P P Specifies or returns the position of the toolbar. 
ToolbarBackColor (Page 5650) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 5651) * P P Specifies whether the function linked to the button is 

activated in runtime. 
ToolbarButtonAdd  (Page 5652) * P P Creates a new, user-defined button function. 
ToolbarButtonBeginGroup  (Page 5652) 
*

P P Specifies whether a separator is inserted before the 
selected button function. 

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 5653) * P P Specifies the number of configurable button functions. 
ToolbarButtonEnabled  (Page 5653) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 5654) * P P Shows the hotkey for the selected button function. 
ToolbarButtonId  (Page 5654) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 5654) P P References a button function. 
ToolbarButtonLocked  (Page 5655) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 5655) * P P Shows the name of the selected button function. 
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Properties Read Write Description
ToolbarButtonPasswordLevel  
(Page 5656) *

P P Shows the authorization for the selected button function. 

ToolbarButtonRemove  (Page 5656) * P P Removes the selected button function from the list. 
ToolbarButtonRename  (Page 5656) * P P Renames the user-defined toolbar element that is 

referenced by means of the "ToolbarButtonIndex" 
property. 

ToolbarButtonRepos  (Page 5657) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  (Page 5657) 
*

P P Specifies the tooltip text for the button. 

ToolbarButtonUserDefined  
(Page 5658) *

P P Indicates whether the configuration engineer has added 
the toolbar button as a new user-defined button. 

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 5658) P P Specifies whether the tooltips for the button functions are 

displayed in runtime. 
ToolbarUseBackColor (Page 5659) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 5660) P P Specifies whether the hotkeys for the button functions are 

activated in runtime. 
ToolbarVisible (Page 5660) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
UseSelectedTitleColor (Page 5714) P P Specifies whether a selection color is used for the headers 

of selected table cells. 
UseSourceBackColors P P Specifies the use of the background color of the data 

source. 
UseSourceForeColors P P Specifies the use of the foreground color of the data 

source. 
UseTableColor2 (Page 5715) P P Specifies whether a second row color is used for the 

representation of the table. 
VerticalGridLines (Page 5734) P P Specifies whether vertical separation lines are displayed. 
Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P - Sets the width of the specified "Ellipse", "Circle" and 

"Rectangle" objects. 

* not visible in the ES

Table 10-130 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic (Page 5786) P Deactivates the trigger of the "ActivateDynamic" method used for the 

specified property in/during Runtime.
Export (Page 5790) P, A Executes the "Export log" or "Export data" button function of the control.
GetRow (Page 5802) P Returns the row object defined by its row number in the table-based controls 

as "ICCAxDataRow" type.
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Methods Valid Description
GetRowCollection (Page 5803) P Returns the list of all row objects of the table-based controls as 

"ICCAxDataRowCollection" type. 
GetRulerBlock (Page 5804) P Returns the block object of the evaluation table designated by name or index 

as "ICCAxRulerBlock" type.
GetRulerBlockCollection 
(Page 5805) 

P Returns the list of all block objects of the evaluation table as 
"ICCAxCollection" type.

GetRulerColumn (Page 5807) P Returns the column object of the evaluation table designated by name or 
index as "ICCAxRulerColumn" type.

GetRulerColumnCollection 
(Page 5808) 

P Returns the list of all column objects of the evaluation table as 
"ICCAxCollection" type.

GetSelectedRow (Page 5810) P Returns the selected row object of a table-based control as "ICCAxDataRow" 
type.

GetSelectedRows (Page 5811) P Returns the selected row objects of a table-based control as type 
"ICCAxDataRow" for multiple selection.

GetStatisticAreaColumn 
(Page 5812) 

P Returns the column object of the statistic area window of the evaluation table 
designated by name or index as "ICCAxRulerColumn" type.

GetStatisticAreaColumnCollectio
n (Page 5814) 

P Returns the list of all column objects of the statistic area window of the 
evaluation table as "ICCAxCollection" type.

GetStatisticResultColumn 
(Page 5815) 

P Returns the column object of the statistic window of the evaluation table 
designated by name or index as "ICCAxRulerColumn" type.

GetStatisticResultColumnCollect
ion (Page 5816) 

P Returns the list of all column objects of the statistic window of the evaluation 
table as "ICCAxCollection" type.

GetStatusbarElement 
(Page 5817) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollection 
(Page 5818) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetToolbarButton (Page 5825) P, A Returns the button function designated by name or index on the control 
toolbar as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 5826) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

Print (Page 5855) P, A Executes the "Print" button function of the control.
SelectAll (Page 5870) P Selects all rows in a table-based control.
SelectRow (Page 5871) P Selects a specific row in a table-based control.
ShowHelp (Page 5875) P, A Executes the "Help" button function of the control.
ShowPropertyDialog 
(Page 5880) 

P, A Executes the "Configuration dialog" button function of the control.

UnselectAll (Page 5888) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 5889) P Removes the selections from a specific cell of a table-based control.

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)
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TrendView

Description

Represents the "TrendView" object. The TrendView object is an element of the ScreenItems 
list. 

Type identifier in VBS
HMITrendView

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-131 Properties

Properties Read Write Description
Authorization (Page 5212) - - Specifies the operating rights of the selected object in 

runtime.  
AxisXBunchCount - - Sets the step width of the large ticks for the X axis. 
AxisXMarkCount - - Sets the step width of the ticks for the X axis. 
AxisXNoOfDigits - -  
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Properties Read Write Description
AxisXShowBunchValues - - Enables scale labeling of the interim values for the X axis. 
AxisXStyle * - -  
AxisY1BunchCount - - Sets the step width of the large ticks for the Y axis. 
AxisY1MarkCount - - Sets the step width of the large ticks for the left Y axis. 
AxisY1ShowBunchValues - - Enables scale labeling of the interim values for the left Y axis. 
AxisY2BunchCount - - Sets the step width of the large ticks for the right Y axis. 
AxisY2MarkCount - - Sets the step width of the ticks for the right Y axis. 
AxisY2ShowBunchValues - - Enables scale labeling of the interim values for the right Y 

axis. 
BackColor (Page 5219) A A Specifies the background color of the selected object. 
ColumnsMoveable - - Specifies that the columns can be moved. 
CountVisibleItems (Page 5290) - - Specifies the number of lines contained in the selection list.  
Enabled (Page 5314) A A Specifies whether the selected object can be operated in 

runtime.  
EnableNavigateButtons - -  
EnableNavigateKeys - - Specifies keyboard operation. 
FitToSize - - Specifies that the size of the object should be automatically 

adapted to the content. 
Flashing - - Specifies that the text block flashes. 
FocusColor (Page 5344) A A Specifies the color for the focus frame of the selected object 

when it is in focus. 
FocusWidth (Page 5346) A A Specifies the border width of the specified object when the 

object is in focus.  
Font (Page 5347) - - Specifies or returns the font.  
Height (Page 5361) A - Sets the height of the specified "Ellipsis", "Circle" and 

"Rectangle" objects.  
HelpText (Page 5364) A - Returns the tooltip that is shown in runtime as user help for 

the specified object.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Look3D - - Activates 3D visualization. 
Name (Page 5452) A - Returns the object name as STRING. 
RulerColor (Page 5514) A A Specifies the color of the scale gradation (auxiliary line) of 

the axis labelling in the "OnlineTrendControl" object. 
ScaleColor (Page 5516) A A Specifies the color of the scale of the selected object.  
SelectionBackColor  (Page 5533) * - - Specifies the background color of the selected cells.  
SelectionForeColor (Page 5535) * - - Specifies the foreground color of the selected cells.  
ShowRuler (Page 5561) A A Specifies whether a scale gradation (auxiliary line) is shown 

for the axis label of the "OnlineTrendControl" object. 
ShowTableGridLines (Page 5566) - -- Enables the display of grid lines in the table. 
ShowTimeAxis - - Enables the display of the X axis. 
ShowTimeAxisLabeling - - Enables the display of the X axis labeling. 
ShowValueAxis1 - - Enables the display of the left Y axis. 
ShowValueAxis1Label - - Enables the display of the labeling for left Y axis. 
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Properties Read Write Description
ShowValueAxis2 - - Enables the display of the right Y axis. 
ShowValueAxis2Label - - Sets the window title. 
ShowValueTable - - Enables the display of the table of values. 
ShowY1HlpLine - - Enables the display of the auxiliary line. 
ShowY2HlpLine - - Enables the display of the auxiliary line. 
TableBackColor (Page 5597) A A Specifies the background color of the table cells for the 

selected object.  
TableFont - - Specifies the font in the table. 
TableGridLineColor (Page 5602) A A Sets the color of the gridlines in the table of the specified 

object. 
TableHeaderBackColor (Page 5602) A A Specifies the background color in the header of the table of 

the selected object. 
TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor (Page 5603) A A Specifies the text color in the header of the table of the 

selected object. 
TagForExternalTime - - Sets the tag for the external time. 
TimeAxisBegin - -  Sets the start value for the time axis. 
TimeAxisBeginTime - - Specifies the starting time for the display of the selected 

trend.  
TimeAxisCountPoints - - Sets the number of values for the time axis. 
TimeAxisEnd - - Sets the end value for the time axis. 
TimeAxisMode - - Sets the time axis mode. 
TimeAxisRange (Page 5615) - - Period displayed by the time axis. 
TimeAxisSide - - Sets the page for new values on the time axis. 
ToolbarButtons - - Specifies which buttons are available for the toolbar.  
ToolbarEnabled * - - Enables the use of a toolbar in the trend view. 
ToolbarStyle - - Sets the appearance of the toolbar. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
TrendsForPrinting * - -  
ValueAxis1AutoRange * - - Sets the automatic adaptation of the data area. 
ValueAxis1Begin - - Sets the start value for the axis. 
ValueAxis1End - - Sets the end value for the axis. 
ValueAxis1LabelLength - - Sets the length of axis labeling. 
ValueAxis1Style * - -  
ValueAxis2AutoRange * - - Sets the automatic adaptation of the data area. 
ValueAxis2Begin - - Sets the start value for the axis. 
ValueAxis2End - - Sets the end value for the axis. 
ValueAxis2LabelLength - - Sets the length of axis labeling. 
ValueAxis2Style * - - Sets the automatic adaptation of the data area. 
ValueY1HlpLine - - Sets the value for the auxiliary line. 
ValueY2HlpLine - - Value for the auxiliary line on the right Y axis. 
Visible (Page 5735) A A Specifies whether the selected object is visible. 
Width (Page 5746) A - Sets the width of the specified "Ellipsis", "Circle" and 

"Rectangle" objects. 
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* not visible in the ES

Table 10-132 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 

 

See also
Screen object (list) (Page 4938)

Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

TubeArcObject

Description     

Represents the "TubeArc" object. The TubeArcObject is an element of the ScreenItems list.

Type identifier in VBS
HMITubeArcObject
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Application
In the following example, the object with the name "TubeArcObject1" is moved 10 pixels to the 
right:

 
'VBS24
Dim objTubeArcObject
Set objTubeArcObject = ScreenItems("TubeArcObject1")
objTubeArcObject.Left = objTubeArcObject.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-133 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 5272) P P Specifies the line color of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
EndAngle (Page 5316) P P Specifies the angle at which the end point of the selected object 

deviates from the zero position (0°). 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
RadiusHeight (Page 5502) P P Specifies the minor axis of the "Ellipsis" object. 
RadiusWidth (Page 5503) P P Specifies the major axis of the "Ellipsis" object. 
StartAngle (Page 5578) P P Specifies the SQL statement. 
ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible.
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-134 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

TubeDoubleTeeObject

Description     

Represents the "DoubleTee" object. The TubeDoubleTeeObject is an element of the 
ScreenItems list.
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Type identifier in VBS
HMITubeDoubleTeeObject

Application
In the following example, the object with the name "TubeDoubleTeeObject1" is moved 10 
pixels to the right:

 
'VBS21
Dim objTubeDoubleTeeObject
Set objTubeDoubleTeeObject = ScreenItems("TubeDoubleTeeObject1")
objTubeDoubleTeeObject.Left = objTubeDoubleTeeObject.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-135 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 5272) P P Specifies the line color of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
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Table 10-136 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

TubePolyline

Description     

Represents the "TubePolyline" object. The TubePolyline object is an element of the 
ScreenItems list.
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Type identifier in VBS
HMITubePolyline

Application
In the following example, the object with the name "TubePolyline1" is moved 10 pixels to the 
right: 

 
'VBS24
Dim objTubePolyline
Set objTubePolyline = ScreenItems("TubePolyline1")
objTubePolyline.Left = objTubePolyline.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-137 Properties

Properties Read Write Description
ActualPointIndex (Page 5191) P P Specifies the number of the current corner point of the selected 

object. 
ActualPointLeft (Page 5191) P P Specifies the X coordinate of the current corner point with reference 

to the screen origin. 
ActualPointTop (Page 5192) P P Specifies the Y coordinate of the current corner point with reference 

to the screen origin. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 5272) P P Specifies the line color of the selected object. 
CornerStyle (Page 5286) P P Specifies the type of border lines for the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
Points - - Specifies the corner points. 
PointsCount (Page 5493) P P Specifies the number of corner points of the polyline or of the polygon. 
ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object. 
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Properties Read Write Description
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-138 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at 

runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)
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TubeTeeObject

Description     

Represents the "Tee" object. The TubeTeeObject is an element of the ScreenItems list. 

Object Type of ScreenItem Object. Represents the "T-piece" graphic object.

Type identifier in VBS
HMITubeTeeObject

Application
In the following example, the object with the name "TubeTeeObject1" is moved 10 pixels to 
the right: 

 
'VBS21
Dim objTubeTeeObject
Set objTubeTeeObject = ScreenItems("TubeTeeObject1")
objTubeTeeObject.Left = objTubeTeeObject.Left + 10

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-139 Properties

Properties Read Write Description
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime. 
Color (Page 5272) P P Specifies the line color of the selected object. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
RotationAngle (Page 5507) P P Specifies the angle of rotation in degrees. 
ToolTipText (Page 5661) P P Specifies the tooltip text. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object. 
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined in 
the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-140 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

 

 

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)
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UserArchiveControl

Description 

Displays the "Recipe view" object. The UserArchiveControl object is an element of the 
ScreenItems list.

     

Type identifier in VBS
HMIUserArchiveControl

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-141 Properties

Properties Read Write Description
ApplyProjectSettingsForDesignMode - - Specifies that the project settings are used for the design. 
ArchiveName  * P P Sets the log name. 
ArchiveType P - Sets the log type. 
AutoCompleteColumns (Page 5213) P P Specifies whether empty columns are shown if the control 

is wider than the configured columns.  
AutoCompleteRows (Page 5214) P P Specifies whether empty rows are shown if the control is 

longer than the number of configured rows.  
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Properties Read Write Description
AutoSelectionColors (Page 5215) P P Specifies whether the colors defined by the system are 

used as the selection colors for cells and rows. 
AutoSelectionRectColor (Page 5216) P P Specifies whether the selection frame is shown with the 

color defined by the system.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
Blocks - - Sets the alarm blocks. 
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
Caption (Page 5257) P P Specifies the text that is displayed in the header of the 

selected object.  
CellCut (Page 5261) P P Specifies whether the contents of the cells are abbreviated 

if the cells are too narrow. 
CellSpaceBottom (Page 5262) P P Specifies the bottom margin of the table cells.  
CellSpaceLeft (Page 5263) P P Sets the left indent for the table cells.  
CellSpaceRight (Page 5263) P P Specifies the right indent of the table cells. 
CellSpaceTop (Page 5264) P P Specifies the top margin of the table cells.  
Closeable (Page 5272) P P Specifies that the control can be closed in runtime. 
ColumnAlign  (Page 5277) * P P Specifies how the selected column is aligned.
ColumnAutoPrecisions  * P P Specifies that

the number of decimal places displayed for an axis is 
adjusted automatically. 

ColumnCaption  * P P Sets the caption. 
ColumnCount * P - Displays the number of columns. 
ColumnDateFormat  * - P Sets the display format for date information. 
ColumnExponentialFormat  * P P Specifies that exponential notation is used in a column. 
ColumnHideText  * P P Specifies whether the text is displayed. 
ColumnHideTitleText * P P Specifies whether the text is displayed. 
ColumnIndex P P The index specifies on which column other properties, e.g. 

initial value are based. 
ColumnLeadingZeros  * P P Specifies that leading zeros should be displayed. 
ColumnLength  * P P Specifies the number of displayed characters. 
ColumnName  * P - Displays the name of the selected column. 
ColumnPrecisions  * P P Sets the number of decimal places. 
ColumnReadonly  * P P Sets the read-only mode for the values in the column. 
ColumnRepos  * P P Repositions the column. 
ColumnResize (Page 5279) P P Enables changes to the width of columns.  
ColumnScrollbar (Page 5280) P P Specifies the scroll bar type. 
ColumnShowDate  * P P Specifies that the date is to be displayed. 
ColumnShowIcon  * P P Enables the display of an icon. 
ColumnShowTitleIcon * P P Enables the display of an icon. 
ColumnSort  * P P Sets the type of sorting. 
ColumnSortIndex  * P P Specifies the sorting order. 
ColumnTimeFormat * - P Sets the display format for time information. 
ColumnTitleAlignment P P Specifies the type of column title alignment. 
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Properties Read Write Description
ColumnTitles (Page 5282) P P Specifies whether the column header is displayed. 
ColumnVisible * P P Enables the visibility of a column. 
ControlDesignMode (Page 5573) - P Specifies the design. 
DataSource - - Sets the data source. 
Enabled (Page 5313) P P Specifies whether the selected object can be operated in 

runtime.  
EnableDelete P P Enables the deletion of data. 
EnableEdit (Page 5315) P P Specifies whether the data shown can be edited in runtime. 
EnableInsert P P Enables insertion of data. 
ExportDirectoryChangeable 
(Page 5322) 

P P Specifies whether the data export directory can be 
changed in runtime. 

ExportDirectoryname (Page 5322) P P Specifies the target directory for the exported Runtime 
data.  

ExportFileExtension (Page 5323) P P Specifies the file extension of the export file. Only the "csv" 
file extension is currently supported.  

ExportFilename (Page 5323) P P Specifies the name of the target file for the exported 
Runtime data. 

ExportFilenameChangeable 
(Page 5324) 

P P Specifies whether the export file name can be changed in 
runtime.  

ExportFormatGuid (Page 5325) P P Default assignment of the ID number and export provider. 
ExportFormatName (Page 5325) P P Specifies the export file format. Only the "csv" file format 

is currently available for the export. 
ExportParameters (Page 5326) P - Specifies the parameters of the selected format by means 

of the "Properties" dialog. 
ExportSelection (Page 5326) P P Specifies which runtime data of the control is exported.
ExportShowDialog (Page 5327) P P Specifies whether the data export dialog is shown in 

runtime. 
Filters - - Specifies database criteria in SQL syntax.  
FilterSQL P - Sets an SQL statement for the filter criterion. 
Font (Page 5347) - - Specifies or returns the font.  
GridLineColor (Page 5359) P P Specifies the color for the grid lines. 
GridLineWidth (Page 5360) P P Specifies the width of the separation lines in pixels.  
Height (Page 5361) P P Sets the height of the specified "Ellipse", "Circle" and 

"Rectangle" objects.  
HorizontalGridLines (Page 5375) P P Specifies whether horizontal separation lines are 

displayed.  
IconSpace (Page 5378) P P Specifies the spacing between icons and text in the table 

cells. 
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the 

screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineColor (Page 5414) P P Sets the color of the window separation lines. 
LineWidth (Page 5416) P P Specifies the line thickness of the selected object. 
Moveable (Page 5451) P P Specifies whether the window can be moved in runtime.  
ObjectName (Page 5460) P - Returns the object name as STRING. 
PrintJobName (Page 5496) P P Specifies a print job. 
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Properties Read Write Description
RowScrollbar (Page 5510) P P Specifies whether row scroll bars are displayed.  
RowTitleAlignment P P  Specifies the type of row title alignment. 
RowTitles P P Specifies that row headers will be displayed. 
RTPersistence (Page 5512) P P Specifies how online configurations of WinCC are 

retained. 
RTPersistencePasswordLevel 
(Page 5513) 

P P Specifies the authorization required for online 
configuration in runtime. 

RTPersistenceType (Page 5513) - - Specifies how online configurations of WinCC are 
retained.  

SelectArchiveName * P P Specifies definition of the log by name. 
SelectedCellColor (Page 5528) P P Specifies the background color of the selected cell.  
SelectedCellForeColor (Page 5529) P P Specifies the font color of the selected cell.  
SelectedRowColor (Page 5530) P P Specifies the background color of the selected row.  
SelectedRowForeColor (Page 5530) P P Specifies the font color of the selected row.  
SelectedTitleColor (Page 5531) P P Specifies the background color of a selected table header.  
SelectedTitleForeColor (Page 5532) P P Specifies the font color of the selected table header.  
SelectionColoring (Page 5534) P P Specifies whether selection colors are used for cells or 

rows. 
SelectionRect (Page 5537) P P Specifies whether a selection frame is used for the 

selected cells or rows. 
SelectionRectColor (Page 5538) P P Specifies the color of the selection rectangle in the alarm 

window if SelectionType equals "1".  
SelectionRectWidth (Page 5539) P P Specifies the line width of the selection rectangle in the 

alarm window if SelectionType equals "1". 
SelectionType (Page 5539) P P Specifies the number of lines you can mark.   
ShowSortButton (Page 5563) P P Specifies whether the sorting button is shown above the 

vertical scroll bar. 
ShowSortIcon (Page 5564) P P Specifies whether the sorting icon is displayed.  
ShowSortIndex (Page 5565) P P Specifies whether a sort index is displayed.  
ShowTitle (Page 5569) P P Specifies the layout of the control window's header. 
Sizeable P P Specifies that the size of an object can be changed in 

runtime. 
SortSequence P P Specifies how the sorting order can be changed by mouse 

click. 
StatusbarBackColor (Page 5582) P P Specifies the background color of the status bar.  
StatusbarElementAdd  (Page 5582) * - P Creates a new, user-defined status bar element.  
StatusbarElementAutoSize 
(Page 5583) *

P P Specifies whether the width of the selected status bar 
element is set automatically.  

StatusbarElementCount  (Page 5583) * P - Specifies the number of configurable status bar elements. 
StatusbarElementIconId  (Page 5584) * P P Default assignment of the ID number and icon of a status 

bar element. 
StatusbarElementId  (Page 5584) * P - Returns the ID number of the selected status bar element.
StatusbarElementIndex (Page 5585) P P References a status bar element. You can use this 

property to assign the values of other properties to a 
specific element of the status bar. 
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Properties Read Write Description
StatusbarElementName  (Page 5585) * P P Displays the object name of the selected status bar 

element. 
StatusbarElementRemove  (Page 5586) 
*

P P Removes the selected status bar element.  

StatusbarElementRename  (Page 5586) 
*

P P Renames the user-defined status bar element that is 
referenced by means of the "StatusbarElementIndex" 
property. 

StatusbarElementRepos  * P P Specifies the index that is assigned to the element. 
StatusbarElements (Page 5586) - - Specifies the elements that are to be shown in the status 

bar. 
StatusbarElementText  * P P Specifies the text of the currently selected status bar 

element. 
StatusbarElementTooltipText  
(Page 5587) *

P P Specifies the tooltip text for the user-defined status bar 
element. 

StatusbarElementUserDefined  
(Page 5587) *

P - Indicates whether the configuration engineer has added 
the status bar element as a new user-defined element. 

StatusbarElementVisible  (Page 5588) * P P In the list, activate the status bar elements that you wish 
to display in runtime. 

StatusbarElementWidth  (Page 5589) * P P Specifies the width of the selected status bar element in 
pixels. 

StatusbarFont - - Status bar font 
StatusbarFontColor (Page 5589) P P Specifies the color of the text in the status bar.  
StatusbarShowTooltips (Page 5591) P P Specifies whether tooltips are displayed for the elements 

of the status bar in runtime.  
StatusbarText (Page 5592) P - Returns the standard text of the status bar.
StatusbarUseBackColor (Page 5593) P P Specifies whether the background color of the status bar 

is shown. 
StatusbarVisible (Page 5593) P P Specifies whether the status bar of the control is 

displayed.  
TableColor (Page 5598) P P Specifies the background color of the rows. Use this to 

open the color selection dialog.  
TableColor2 (Page 5598) P P Specifies the background color of "Row color 2".  
TableForeColor (Page 5599) P P  
TableForeColor2 (Page 5601) P P Specifies the font color of "Row color 2". 
TimeBase (Page 5619) P P Sets the timebase. 
TitleColor P P Specifies the color of the header. 
TitleCut (Page 5641) P P Specifies whether the contents of the fields of a header 

should be abbreviated if the column is too narrow.  
TitleDarkShadowColor (Page 5641) P P Specifies the color of the dark side of shading. 
TitleForeColor (Page 5641) P P Specifies the font color of the table header for the selected 

status. 
TitleGridLineColor (Page 5642) P P Specifies the color of separation lines in the table header. 
TitleLightShadowColor (Page 5642) P P Specifies the color of the bright side of shading. 
TitleSort (Page 5642) P P Specifies how sorting by column header is triggered.  
TitleStyle (Page 5643) P P Specifies whether a shading color is used for the table 

header. 
ToolbarAlignment (Page 5650) P P Specifies or returns the position of the toolbar. 
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Properties Read Write Description
ToolbarBackColor (Page 5650) P P Specifies the background color of the toolbar. 
ToolbarButtonActive  (Page 5651) * P P Specifies whether the function linked to the button is 

activated in runtime. 
ToolbarButtonAdd  (Page 5652) * P P Creates a new, user-defined button function.  
ToolbarButtonBeginGroup  (Page 5652) 
*

P P Specifies whether a separator is inserted before the 
selected button function.  

ToolbarButtonClick P P Clicks a toolbar button. 
ToolbarButtonCount  (Page 5653) * P - Returns the number of buttons contained in the toolbar.
ToolbarButtonEnabled  (Page 5653) * P P Specifies whether a user-defined toolbar button can be 

operated. 
ToolbarButtonHotKey  (Page 5654) * P P Shows the hotkey for the selected button function.  
ToolbarButtonId  (Page 5654) * P P Unique ID number for the selected button function. 
ToolbarButtonIndex (Page 5654) P P References a button function.  
ToolbarButtonLocked  (Page 5655) * P P Specifies whether the clicked, pressed in state is displayed 

for a user-defined toolbar button. 
ToolbarButtonName  (Page 5655) * P - Displays the name of the selected button of the toolbar.  
ToolbarButtonPasswordLevel  
(Page 5656) *

P P Shows the authorization for the selected button function.  

ToolbarButtonRemove  (Page 5656) * - P Removes the selected button function from the list.  
ToolbarButtonRename  (Page 5656) * - P Renames the user-defined toolbar element that is 

referenced by means of the "ToolbarButtonIndex" 
property.  

ToolbarButtonRepos  (Page 5657) * P P Changes the sequence of button functions. 
ToolbarButtons - - Specifies which buttons are available for the toolbar. 
ToolbarButtonTooltipText  (Page 5657) 
*

P P Specifies the tooltip text for the button. 

ToolbarButtonUserDefined  
(Page 5658) *

P - Indicates whether the configuration engineer has added 
the toolbar button as a new user-defined button.  

ToolbarButtonVisible  * P P Specifies that the button is visible. 
ToolbarShowTooltips (Page 5658) P P Specifies whether the tooltips for the button functions are 

displayed in runtime.  
ToolbarUseBackColor (Page 5659) P P Specifies whether the background color for the toolbar is 

shown. 
ToolbarUseHotKeys (Page 5660) P P Specifies whether the hotkeys for the button functions are 

activated in runtime.  
ToolbarVisible (Page 5660) P P Specifies whether the toolbar of the control is displayed. 
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
UseSelectedTitleColor (Page 5714) P P Specifies whether a selection color is used for the headers 

of selected table cells. 
UseTableColor2 (Page 5715) P P Specifies whether a second row color is used for the 

representation of the table. 
VerticalGridLines (Page 5734) P P Specifies whether vertical separation lines are displayed. 
Visibility P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipse", "Circle" and 

"Rectangle" objects. 

* not visible in the ES
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Table 10-142 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property with 

VBScript during runtime. 
CopyRows (Page 5784) P Executes the "Copy rows" button function of the control.
CutRows (Page 5786) P Executes the "Cut rows" button function of the recipe view.
DeleteRows (Page 5788) P Executes the "Delete rows" button function of the recipe view.
Export (Page 5790) P, A Executes the "Export log" or "Export data" button function of the control.
GetColumn (Page 5790) P Returns the column object of the recipe view designated by name or index as 

"ICCAxUAColumn" type.
GetColumnCollection 
(Page 5791) 

P Returns the list of all column objects of the recipe view as "ICCAxCollection" 
type.

GetRow (Page 5802) P Returns the row object defined by its row number in the table-based controls 
as "ICCAxDataRow" type.

GetRowCollection (Page 5803) P Returns the list of all row objects of the table-based controls as 
"ICCAxDataRowCollection" type. 

GetSelectedRow (Page 5810) P Returns the selected row object of a table-based control as "ICCAxDataRow" 
type.

GetSelectedRows (Page 5811) P Returns the selected row objects of a table-based control as type 
"ICCAxDataRow" for multiple selection.

GetStatusbarElement 
(Page 5817) 

P, A Returns the element of the control's status bar designated by name or index 
as "ICCAxStatusbarElement" type.

GetStatusbarElementCollectio
n (Page 5818) 

P, A Returns the list of all status bar elements of the control as "ICCAxCollection" 
type.

GetToolbarButton (Page 5825) P, A Returns the button function designated by name or index on the control toolbar 
as "ICCAxToolbarButton" type.

GetToolbarButtonCollection 
(Page 5826) 

P, A Returns the list of all button functions of the control toolbar as 
"ICCAxCollection" type.

MoveToFirst (Page 5846) P Executes the "First line" button function of the control.
MoveToLast (Page 5848) P Executes the "Last data record" button function of the control.
MoveToNext (Page 5849) P Executes the "Next data record" button function of the control.
MoveToPrevious (Page 5851) P Executes the "Previous data record" button function of the control.
PasteRows (Page 5854) P Executes the "Insert rows" button function of the recipe view.
Print (Page 5855) P, A Executes the "Print" button function of the control.
ReadTags (Page 5857) P Executes the "Read tags" button function of the recipe view.
SelectAll (Page 5870) P Selects all rows in a table-based control.
SelectRow (Page 5871) P Selects a specific row in a table-based control.
ServerExport (Page 5872) P Executes the "Export log" button function of the recipe view.
ServerImport (Page 5873) P Executes the "Import log" button function of the recipe view.
ShowHelp (Page 5875) P, A Executes the "Help" button function of the control.
ShowPropertyDialog 
(Page 5880) 

P, A Executes the "Configuration dialog" button function of the control.

ShowSelectArchive 
(Page 5880) 

P Executes the "Select data connection" button function of the recipe view.

ShowSelection (Page 5881) P Executes the "Selection dialog" button function of the recipe view.
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Methods Valid Description
ShowSelectTimeBase 
(Page 5882) 

P Executes the "Timebase dialog" button function of the recipe view.

ShowSort (Page 5883) P Executes the "Sorting dialog" button function of the recipe view.
UnselectAll (Page 5888) P Removes all selections from the cells of a table-based control.
UnselectRow (Page 5889) P Removes the selections from a specific cell of a table-based control.
WriteTags (Page 5893) P Executes the "Write tags" button function of the recipe view.

See also
Screen (Page 4964)

ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

UserView 

Description

Represents the "UserView" object. The UserView object is an element of the ScreenItems list. 

     
 

 Note

The object "Simple UserView" cannot be dynamized with a user-defined function.
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Type identifier in VBS
HMIUserView

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-143 Properties

Properties Read Write Description
Appearance (Page 4964) - - Specifies the layout for this NC subroutine. 
Authorization (Page 5212) * - - Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5219) A A Specifies the background color of the selected object. 
Columns - - Specifies the columns to be displayed. 
ColumnsMoveable - - Specifies that the columns can be moved. 
CountVisibleItems 
(Page 5290) 

- - Specifies the number of lines contained in the selection list.  

Enabled (Page 5314) A A Specifies whether the selected object can be operated in runtime.  
FitToSize - - Specifies that the size of the object should be automatically adapted 

to the content. 
Flashing - - Specifies that the text block flashes. 
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
SelectionBackColor 
(Page 5534) 

A A Specifies the background color of the selected cells.  

SelectionForeColor 
(Page 5536) 

A A Specifies the foreground color of the selected cells.  

ShowTableGridlines 
(Page 5566) 

- - Enables the display of gridlines in the table of the specified object. 

TableBackColor (Page 5597) A A Specifies the background color of the table cells for the selected 
object.  

TableFont - - Specifies the font in the table. 
TableForeColor (Page 5600) A A  
TableGridlineColor 
(Page 5602) 

A A Specifies the color for the grid lines. 

TableHeaderBackColor 
(Page 5602) 

A A Specifies the background color in the header of the table of the 
selected object. 

TableHeaderFont - - Specifies the text color of the header. 
TableHeaderForeColor 
(Page 5603) 

A A Specifies the text color in the header of the table of the selected 
object. 
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Properties Read Write Description
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Visible (Page 5735) * A A Specifies whether the selected object is visible. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

* not visible in the ES

Table 10-144 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic (Page 5779) P Dynamically activates a trigger and the specified cycle for a property at runtime. 
DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
ScreenItem (Page 4966)

ScreenItems (list) (Page 4968)

Screen object (list) (Page 4970)

WindowSlider

Description
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Represents the "Window slider" object. The WindowSlider object is an element of the 
ScreenItems list.

Type identifier in VBS
HMIWindowSlider

     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-145 Properties

Properties Read Write Description
AskOperationMotive (Page 5210) P P Specifies whether the reason for operating this object is logged. 
Authorization (Page 5212) P P Specifies the operating rights of the selected object in runtime.  
BackColor (Page 5218) P P Specifies the background color of the selected object. 
BackColorBottom (Page 5221) P P Specifies the color for the lower / right part of the . 
BackColorTop (Page 5221) P P Sets the color for the upper / left part of the slider.  
BackFillStyle (Page 5222) P P Defines the fill pattern of the specified object.  
BackFlashingColorOff (Page 5224) P P Specifies the background color for flash state "Off". 
BackFlashingColorOn (Page 5225) P P Specifies the background color for flash state "On".  
BackFlashingEnabled (Page 5226) P P Specifies whether the background of the specified object flashes 

in runtime. 
BackFlashingRate (Page 5226) P P Specifies the flash rate of the background for the selected object. 
BorderBackColor (Page 5236) P P Specifies the background color of the broken border line for the 

selected object.  
BorderColor (Page 5238) P P Specifies the line color of the object. 
BorderFlashingColorOff (Page 5242) P P Specifies the border line color of the selected object for the flash 

state "Off".  
BorderFlashingColorOn (Page 5243) P P Specifies the border line color of the selected object for the flash 

state "On".  
BorderFlashingEnabled (Page 5244) P P Specifies whether the border line of the selected object flashes in 

runtime. 
BorderFlashingRate (Page 5245) P P Specifies the flash rate of the border line for the selected object.  
BorderStyle (Page 5249) P P Specifies the type of border lines for the selected object. 
BorderWidth (Page 5252) P P Specifies the line thickness of the object. 
CornerStyle (Page 5286) - - Specifies the type of border lines for the selected object.  
DrawInsideFrame (Page 5307) P P Specifies whether the border line of the selected object with a line 

thickness greater than 1 should be drawn within the border or 
symmetrically to the border. 
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Properties Read Write Description
EdgeStyle (Page 5310) - - Specifies the line style of the selected object.  
Enabled (Page 5313) P P Specifies whether the selected object can be operated in runtime.  
FillPatternColor (Page 5332) P P Specifies the color of the fill pattern for the selected object.  
Flashing - - Specifies that the text block flashes. 
Height (Page 5361) P P Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
HighLimitColor (Page 5366) P P Specifies the color of the top or right scroll button in a scroll bar.  
JumpToLimitsAfterMouseClick 
(Page 5384) 

P P Specifies the length of the long tick marks of a scale. 

Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) P P Specifies the value of the X coordinate of the object. 
LineEndShapeStyle (Page 5415) - - Specifies the shape of the line end. 
LogOperation (Page 5420) P P Specifies whether, after operating this object, an alarm is output 

to the alarm system.  
LowLimitColor (Page 5425) P P Specifies the color of the bottom or left scroll button in a scroll 

bar.  
MarginToBorder (Page 5426) P P Specifies the width of the 3D border in pixels. 
MaximumValue (Page 5427) P P Specifies the maximum value of the scale in the selected object.  
MinimumValue (Page 5448) P P Specifies the minimum value of the scale in the selected object. 
Name (Page 5452) P - Returns the object name as STRING. 
OperationSteps (Page 5465) P P Specifies by how many steps the slider of the scrollbar is moved 

with one mouseclick.  
ProcessValue (Page 5497) P P Specifies the default for the value to be displayed.  
RelativeFillLevel (Page 5505) P P Specifies the fill percentage for the object. 
ShowBadTagState (Page 5551) P P Specifies whether an object is grayed out if its associated tag has 

a bad quality code or tag state. 
ShowFillLevel (Page 5554) P P Specifies whether the selected object is filled.  
StyleSettings (Page 5595) P P Specifies the display style for the object:  
TextOrientation (Page 5610) P P Specifies the text orientation of the selected object.  
ThumbBackColor (Page 5611) P P Specifies the background color of the slider in the "Slider" object. 
ToolTipText (Page 5661) P P Specifies the tooltip text.  
Top (Page 5663) P P Specifies the value of the Y coordinate of the object. 
Transparency (Page 5667) P P Specifies and returns the transparency percentage of the object.  
UseDesignColorScheme 
(Page 5707) 

P P Specifies the font used for printing. 

UseDesignShadowSettings 
(Page 5708) 

P P Specifies whether the object is displayed with the shading defined 
in the active design. 

Visible (Page 5735) P P Specifies whether the selected object is visible. 
Width (Page 5746) P P Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 
WindowsStyle (Page 5750) P P Specifies whether the object is displayed in the general Windows 

style. 
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Table 10-146 Methods

Methods Valid Description
Activate (Page 5777) P, A Activates the permanent window or the root screen. 
ActivateDynamic 
(Page 5779) 

P Dynamically activates a trigger and the specified cycle for a property at runtime. 

DeactivateDynamic 
(Page 5786) 

P Deactivates the trigger of the "ActivateDynamic" method used for the specified 
property in/during Runtime.

 

See also
Screen object (list) (Page 4970)

WLanQualityView

Description

Represents the "WLAN reception" object. The WLanQualityView object is an element of the 
ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-147 Properties

Properties Read Write Description
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
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Properties Read Write Description
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-148 Methods

Methods Valid Description
????   
   

 

See also
Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

ZoneLabelView

Description

Represents the "Zone name" object. The ZoneLabelView object is an element of the 
ScreenItems list.     

 

Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional
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Table 10-149 Properties

Properties Read Write Description
Font (Page 5347) - - Specifies or returns the font.  
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-150 Methods

Methods Valid Description
???   
   

 

See also
Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

ZoneQualityView

Description

Represents the "ZoneSignal" object. The ZoneQualityView object is an element of the 
ScreenItems list.     
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Abbreviation Validity
Pa Panels
A Runtime Advanced
P Runtime Professional

 

Table 10-151 Properties

Properties Read Write Description
Height (Page 5361) A A Sets the height of the specified "Ellipsis", "Circle" and "Rectangle" 

objects.  
Layer (Page 5389) - - Returns the layer that contains an object as LONG in the screen. 
Left (Page 5401) A A Specifies the value of the X coordinate of the object. 
Name (Page 5452) A - Returns the object name as STRING. 
Top (Page 5663) A A Specifies the value of the Y coordinate of the object. 
Width (Page 5746) A A Sets the width of the specified "Ellipsis", "Circle" and "Rectangle" 

objects. 

 

Table 10-152 Methods

Methods Valid Description
?????   
   
   

 

See also
Screen (Page 4939)

ScreenItem (Page 4941)

ScreenItems (Page 4943)

Properties

Properties A

AboveUpperLimitColor

Description
Defines the color of the specified object for the case "High limit exceeded".   
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See also
SymbolLibrary (Page 5135)

GraphicIOField (Page 5049)

Switch (Page 5127)

SymbolicIOField (Page 5130)

IOField (Page 5059)

AcceptOnExit

Description
Specifies whether the input field will be confirmed automatically when it is left. 

Access in Runtime: Read and write

Syntax
Object.AcceptOnExit[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField" or "SymbolicIOField".

BOOLEAN
Optional TRUE, if the input field will be confirmed automatically when it is left.

See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

AcceptOnFull

Description
Specifies whether the input field will be left and confirmed automatically when the set number 
of values have been entered. 

Access in Runtime: Read and write

Syntax
Object.AcceptOnFull[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".
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BOOLEAN
Optional TRUE, if the input field will be left and confirmed automatically when the set number 
of values have been entered. 

See also
IOField (Page 5059)

AccessPath

Description
Returns the storage path of a screen.   

Access during runtime: Read

Syntax
Object.AccessPath

Object
Necessary. A "Screen" object.

Example
In the following example, the path of the picture "ScreenWindow1" is issued:

 
'VBS67
Dim objScreen
Set objScreen = HMIRuntime.Screens("ScreenWindow1")
MsgBox objScreen.AccessPath

See also
Screen (Page 4964)

Activate

Description
Determines whether the data to be displayed are requested by the alarm server.  

Access in Runtime: Read and write
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Syntax
Object.Activate[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the data to be displayed are requested by the alarm server.

See also
AlarmControl (Page 4981)

Active

Description
Specifies whether the data that is to be shown is requested by the log server.   

Access in Runtime: Read and write

Syntax
Object.Active[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl," or 
"OnlineTableControl".

BOOLEAN
Optional TRUE, if the data that is to be shown is requested by the log server.

Comments
The screen opening times are reduced if you do not set this attribute. You can change the 
value dynamically.

To differentiate between the "Activate" property and the "Activate" methods, the property is 
addressed via "Object".

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)
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ActiveProject

Description
Returns the specified project.

Access in Runtime: Read

Syntax
Object.ActiveProject

Object
Required A "HMIRuntime" object.

See also
HMIRuntime  (Page 4956)

Project (Page 4963)

ActiveScreen

Description
Returns an object of type "Screen" which shows the screen that currently has the focus.   

 

 Note

If you query the "ActiveScreen" property in a function, it may be due to a ScreenSavers that 
the property does not return a valid "Screen" object but "Nothing" and a system alarm is 
displayed.

 

Access during runtime: Read

Syntax
Object.ActiveScreen

Object
Necessary. An object of the "HMIRuntime" type.

Comments
Which screen is returned depends on whether the root screen or the permanent window has 
the focus.
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The ActiveScreen property returns NOTHING if no screen has the focus. This is the case, for 
example, if a different window has the focus. With the instruction "If not [printout] Is Nothing" 
you can query whether a screen is going to be returned:

 
'VBS_Example_ActiveScreen
Dim objActiveScreen
Set objActiveScreen = HmiRuntime.ActiveScreen
If Not objActiveScreen Is Nothing Then
'found an active screen
HmiRuntime.Trace("There is an active screen." & vbCrLf)
Else
'found NO active screen
HmiRuntime.Trace("There is NO active screen." & vbCrLf)
End If

ActiveScreen

Description
Returns a "Screen" type object, which represents the screen which has the focus at the 
moment.   

 

 Note

If you query the "ActiveScreen" property in a user-defined function, it may be due to a screen 
saver that the property does not return a valid "screen" object but "Nothing". A system 
message will be issued.

 

Access in Runtime: Read

Syntax
Object.ActiveScreen

Object
Required An object of the "HMIRuntime" type.

Comments
Which screen is returned depends on whether the root screen or the permanent window has 
the focus.

The ActiveScreen property returns NOTHING if no screen has the focus. That is the case, for 
example, when another window has the focus. With the statement "If not [expression] is 
nothing"  you are able to interrogate whether a screen is to be returned:

 
VBS example ActiveScreen
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Dim objActiveScreen
Set objActiveScreen = HmiRuntime.ActiveScreen
If not objActiveScreen is nothing then
'found an active screen
HmiRuntime.Trace("There is an active screen." & vbCrLf)
Else
'found NO active screen
HmiRuntime.Trace("There is NO active screen." & vbCrLf)
End if

ActiveScreenItem

Description
References the screen object that currently has the focus.  

It is only if the screen of the respective "Screen" object is currently selected and has an input 
field that the "ActiveScreenItem" property of the "Screen" object will be occupied with a valid 
"ScreenItem" object. In all other cases if, for example, another screen from the "Screens" list, 
an independent window within WinCC or another application is selected, this property is not 
supplied on the screens, i.e. assigned "Nothing".

Application
You use the "ActiveScreenItem" object to address the properties of the object that has the 
focus in Runtime.

ActiveScreenItem

Description
References the screen object which currently has the focus.   

The "ActiveScreenItem" property of the "Screen" object is only assigned a valid "ScreenItem" 
object if the screen of the corresponding "Screen" object is active and has an input field. In all 
other cases, for example, with a different screen from the "Screens" list, an independent 
window within WinCC or a different application will be selected, this property will not apply to 
the screens and will be occupied with "Nothing".

Application
The "ActiveScreenItem" object is used to address the object property which has the focus in 
runtime.
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ActualPointIndex

Description
Specifies the number of the current corner point of the selected object. 

Access in Runtime: Read and write

Syntax
Object.ActualPointIndex[=Int]

Object
Required A "ScreenItem" object with the formats "Polyline" or "Polygon".

Int
Optional A value or a constant that specifies the number of the current corner point of the 
selected object.

See also
Polyline (Page 5098)

Polygon (Page 5095)

TubePolyline (Page 5162)

ActualPointLeft

Description
Specifies the X coordinate of the current corner point with reference to the screen origin. The 
screen source is at the top left of the object.  Every corner is identified by an index which is 
derived from the number ("PointCount") of the existing corners.

Access in Runtime: Read and write

Syntax
Object.ActualPointLeft[=Int]

Object
Required An object of the "ScreenItem" type with the format "Polyline," or "Polygon".

Int
Optional A value or a constant that specifies the X coordinate of the current corner point with 
reference to the screen origin. 
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Comments
Changing the value can have an effect on the properties "Width" (object width) and "Left" (X 
coordinate of the object position).

See also
Polyline (Page 5098)

Polygon (Page 5095)

TubePolyline (Page 5162)

ActualPointTop

Description
Specifies the Y coordinate of the current corner point with reference to the screen origin. The 
screen source is at the top left of the object. 

Access in Runtime: Read and write

Syntax
Object.ActualPointTop[=Int]

Object
Required An object of the "ScreenItem" type with the format "Polyline," or "Polygon".

Int
Optional A value or a constant that specifies the Y coordinate of the current corner point with 
reference to the screen origin.

Comments
Changing the value can have an effect on the properties "Height" (object height) and "Top" (X 
coordinate of the object position). 

See also
Polyline (Page 5098)

Polygon (Page 5095)

TubePolyline (Page 5162)
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AdaptBorder 

Description
Specifies whether the border of the selected object will be dynamically adapted to the text size. 

Access in Runtime: Read and write

Syntax
Object.AdaptBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Checkbox" or "OptionGroup".

BOOLEAN
Optional TRUE, if the border of the selected object will be dynamically adapted to the text size.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

CheckBox (Page 5008)

OptionGroup (Page 5092)

AdaptFontSizeToLineHeight

Description
Specifies whether the font size will be adapted to the line height.   

Access in Runtime: Read and write

Syntax
Object.AdaptFontSizeToLineHeight[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the font size will be adapted to the line height.
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See also
AlarmControl (Page 4981)

AdaptScreenToWindow

Description
Specifies whether or not the screen displayed in a screen window adapts to the size of the 
screen window in Runtime.   .   

Access in Runtime: Read

Syntax
Object.AdaptScreenToWindow[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE, if the screen adapts to the screen window size.

FALSE, if the screen does not adapt to the screen window size.

See also
AlarmControl (Page 4981)

ScreenWindow (Page 5116)

AdaptWindowToScreen

Description
Specifies whether or not the screen window adapts to the screen it displays in Runtime.      

Access in Runtime: Read

Syntax
Object.AdaptWindowtoScreen[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Screenwindow".

BOOLEAN
TRUE, if the screen window size adapts to the screen.
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FALSE, if the screen window size does not adapt to the screen.

See also
ScreenWindow (Page 5116)

AddAssignment

Description 
Adds an entry. 

Address 

Description
Specifies the web address that will be opened in the HTML browser. 

Access in Runtime: Read and write

Syntax
Object.Address[=STRING]

Object
Required A "ScreenItem" object with the format "HTMLBrowser".

STRING
Optional A value or a constant that contains the web address. 

See also
HTMLBrowser (Page 5057)

AdjustBorder3DWithStyle

Description
Specifies whether the 3D border width will be displayed in the general Windows style. 

Access in Runtime: Read and write

Syntax
Object.AdjustBorder3DWithStyle[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "Button".

BOOLEAN
Optional TRUE, if the 3D border width will be displayed in the general Windows style.

See also
Button (Page 5002)

AdjustRulerWindow

Description
Specifies whether the ruler window is adapted every time the trend view is displayed. 

Access in Runtime: Read and write

Syntax
Object.AdjustRulerWindow[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if the ruler window is adapted every time the trend view is displayed.

Comments
TRUE, if the ruler window will be moved and then shown and hidden, it will be displayed at the 
original position in the original size.

See also
OnlineTrendControl (Page 5083)

Alarm

Description
Specifies the limit for the storage space display as of which an alarm will be reported. 

Access in Runtime: Read and write
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Syntax
Object.Alarm[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that specifies the limit for the storage space display as of which 
an alarm will be reported.

See also
DiskSpaceView (Page 5025)

AlarmColor

Description
Specifies the color in which the bars will be shown as soon as the alarm area is reached. 

Access in Runtime: Read and write

Syntax
Object.AlarmColor[=Color]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Color
Optional A value or a constant that specifies the color in which the bar will be shown as soon 
as the warning area is exceeded.

See also
DiskSpaceView (Page 5025)

AlarmFilter

Description
Specifies a SQL-Statement for selecting the alarms that will be shown in the alarm window. 

Alarm list and hit list filtering and sorting settings

Access in Runtime: Read and write
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Syntax
Object.AlarmFilter[=String]

Object
Required A "ScreenItem" object with the format "AlarmControl".

String
Optional A value or a constant that specifies a SQL-Statement for selecting the alarms that 
will be shown in the alarm window. 

See also
AlarmControl (Page 4981)

AlarmHigh

Description
Defines the top limit value at which an alarm should be triggered or returned. 
The type of evaluation (percentage or absolute) is specified with the "TypeAlarmHigh" 
property.   

Access in Runtime: Write and read

Syntax
Object.AlarmHigh[=REAL]

Object
Required A "ScreenItem" object with the format "Bar".

REAL
Value for the upper limit

See also
Bar (Page 4995)

AlarmID

Description 
Returns the AlarmID of the Alarm object. The AlarmID is unique and is assigned by the system.

AlarmID (readonly)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5196 System Manual, 02/2014



See also
Alarms (list) (Page 4948)

AlarmLogs

Description
Returns an object of type "AlarmLogs".

Access in Runtime: Read

Syntax
Object.AlarmLogs

Object
Required A "Logging" object. 

See also
Logging (Page 4961)

AlarmLow

Description
Defines the bottom limit value at which an alarm should be triggered or returned. 
The type of evaluation (percentage or absolute) is specified with the "TypeAlarmLow" 
property.   

Access in Runtime: Write and read

Syntax
Object.AlarmLow[=REAL]

Object
Required A "ScreenItem" object with the format "Bar".

REAL
Value for the lower limit

 

See also
Bar (Page 4995)
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AlarmLowerLimit

Description
Specifies the upper limit at which the alarm will be triggered. 

Access in Runtime: Read and write

Syntax
Object.AlarmLowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit at which the alarm will be triggered. 

Comments
The type of evaluation (percentage or absolute) is established using the 
"AlarmLowerLimitRelative" property.

The "AlarmLowerLimitEnable" property establishes whether the monitoring of this limit is 
enabled. 

See also
Bar (Page 4995)

AlarmLowerLimitColor

Description
Specifies the bar color of the "AlarmLowerLimit" limit.

The "AlarmLowerLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.AlarmLowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".
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Color
Optional A value or a constant that specifies the bar color for the "AlarmLowerLimit" limit.

See also
Bar (Page 4995)

AlarmLowerLimitEnabled

Description
Specifies whether the "AlarmLowerLimit" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.AlarmLowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "AlarmLowerLimit" limit is to be monitored.

Comments
The following values will be established via the properties "AlarmLowerLimit", 
"AlarmLowerLimitColor" and "AlarmLowerLimitRelative":

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

AlarmLowerLimitRelative

Description
Establish whether the lower limit at which the interrupt is triggered is evaluated as a percentage 
or an absolute value. 

Access in Runtime: Read and write
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Syntax
Object.AlarmLowerLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit at which the interrupt is triggered is evaluated as a percentage.

See also
Bar (Page 4995)

AlarmUpperLimit

Description
Establishes the upper limit at which the interrupt will be triggered. 

Access in Runtime: Read and write

Syntax

Object.AlarmUpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that defines the upper limit at which an interrupt will be triggered. 

Comments
The type of evaluation (percentage or absolute) is defined using the "AlarmUpperLimitRelative" 
property.

The "AlarmUpperLimitEnable" property defines whether or not monitoring of this limit is 
enabled. 

See also
Bar (Page 4995)

AlarmUpperLimitColor

Description
Defines the bar color for the "AlarmUpperLimit" limit. 
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The "AlarmUpperLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.AlarmUpperLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that defines the bar color for the "AlarmUpperLimit" limit.

See also
Bar (Page 4995)

AlarmUpperLimitEnabled

Description
Specifies whether the "AlarmUpperLimit" value is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.AlarmUpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "AlarmUpperLimit" value is monitored. 

Comments
The following values will be defined using the properties "AlarmUpperLimit", 
"AlarmUpperLimitColor" and "AlarmUpperLimitRelative":

Limit

Representation upon reaching the limit

Type of evaluation
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See also
Bar (Page 4995)

AlarmUpperLimitRelative

Description
Establish whether the upper limit at which the interrupt is triggered is evaluated as a percentage 
or an absolute value. 

Access in Runtime: Read and write

Syntax
Object.AlarmUpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit at which the interrupt is triggered is evaluated as a percentage 
or an absolute value. 

See also
Bar (Page 4995)

Alignment

Description
Determines the layout of the scale (left/right or top/bottom) depending on the position of the 
bar object or returns it.   

Access in Runtime: Read and write

Syntax
Object.Alignment[=ScalePosition]

Object
Required An object of the "ScreenItem" type with the format "Bar".

ScalePosition
1: Right or bottom .

0: Left or top.
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See also
Bar (Page 4995)

AlignmentLeft

Description
Defines or returns the horizontal alignment of the text. Value range from 0 to 2.   

Access in Runtime: Read and write

Syntax
Object.AlignmentLeft[=HorizontalAlignment]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "RoundButton", "CheckBox", "OptionGroup", "MultilineEdit", 
"ComboBox", "ListBox".

HorizontalAlignment
0: Alignment left

1: Alignment centered

2: Alignment right

 

AlignmentTop

Description
Defines or returns the vertical alignment of the text. Value range from 0 to 2.

Access in Runtime: Read and write

Syntax
Object.AlignmentTopt[=VerticalAlignment]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "RoundButton", "CheckBox", "OptionGroup".

VerticalAlignment
0: Alignment left

1: Alignment centered
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2: Alignment right

AllowMenu

Description
Establishes whether the shortcut menu should be enabled to control the Sm@rtClient view. 

Syntax
Object.AllowMenu

Object
Required A "ScreenItem" object with the format "SmartClientView".

See also
SmartClientView (Page 5123)

AllowPersistence 

Description
Specifies whether the persistence is adjustable. 

Access in Runtime: Read and write

Syntax
Object.AllowPersistence[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the persistence is adjustable. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)
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Analog

Description
Specifies whether the clock should be shown as an analog clock. 

Access in Runtime: Read and write

Syntax
Object.Analog[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Clock".

BOOLEAN
Optional TRUE, if the clock should be shown as an analog clock.

See also
Clock (Page 5018)

AngleAlpha

Description
Defines or returns depth angle a for the 3D-effect of the "3DBarGraph" object. Value range in 
degrees from 0 to 90.

AngleBeta

Description
Defines or returns depth angle b for the 3D-effect of the "3DBarGraph" object. Value range in 
degrees from 0 to 90.

AngleMax 

Description
Specifies the angle of the scale end of the "Gauge" object.  

Access in Runtime: Read and write

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5205



Syntax
Object.AngleMax[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

DOUBLE
Optional A value or a constant that specifies the angle in degrees.

Comments
The start and end of the scale gradations are described with the properties "AngleMin" and 
"AngleMax" in angle degrees.

The value of the AngleMin property must always be less than the value of the AngleMax 
property. The zero degree angle is located at the 3 o´clock position on the scale. Positive angle 
values are counted clockwise.

See also
Gauge (Page 5046)

AngleMin

Description
Specifies the angle of the scale start of the "Gauge" object. 

Access in Runtime: Read and write

Syntax
Object.AngleMin[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

DOUBLE
Optional A value or a constant that specifies the angle in degrees.

Comments
The start and end of the scale gradations are described with the properties "AngleMin" and 
"AngleMax" in angle degrees.

The value of the AngleMin property must always be less than the value of the AngleMax 
property.
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The zero degree angle is located at the 3 o´clock position on the scale. Positive angle values 
are counted clockwise.

See also
Gauge (Page 5046)

Application

Description
Supplies the content of the application window Read only access.

See also
ScriptDiagnostics (Page 5118)

ApplyProjectSettings

Description
Specifies whether the project settings are applied from the "HMI alarms" editor.   

Access in Runtime: Read and write

Syntax
Object.ApplyProjectSettings[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

BOOLEAN
TRUE: The message blocks configured in the "HMI messages" editor are applied to the 
message view with their properties. The message blocks are displayed with these properties 
in the message view.

FALSE: The properties are not applied.

See also
AlarmControl (Page 4981)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)
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AskOperationMotive

Description
Specifies whether the reason for operating this object will be logged. When operating the 
specified object in Runtime, a dialog opens in which the operator enters the reason for the 
operation in text format. 

Access in Runtime: Read and write

Syntax
Object.AskOperationMotive[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField", "SymbolicIOField" or 
"WindowSlider".

BOOLEAN
Optional TRUE, if the reason for operating this object will be logged.

See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

WindowSlider (Page 5176)

Listbox (Page 5065)

Assignments

Description
A list which contains the assignments between the output value and the output text actually to 
be output. The assignments are dependent on the set list type. You determine the list type 
with the ListType property.

Access in Runtime: Read

Syntax
Object.Assignments

Object
Required A "ScreenItem" object with the format "SymbolicIOField".
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See also
SymbolicIOField (Page 5130)

AssumeOnExit

Description
Specifies whether the entered text is applied after leaving the input field, e.g. with the <TAB> 
key or a mouseclick.   

Access in Runtime: Read and write

Syntax
Object.AssumeOnExit

Object
Required An object of the "ScreenItem" type with the format "IOField", "SymbolicIOField".

See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

AssumeOnFull

Description
Specifies whether the input field is left automatically after a complete input (the specified 
number of characters was entered) and the input is applied.   

Access in Runtime: Read and write

Syntax
Object.AssumeOnFull[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "IOField", "SymbolicIOField".

BOOLEAN
TRUE: is applied.

FALSE: is not applied.
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See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

Authorization 

Description
Specifies the operating rights of the selected object in Runtime.   

Access in Runtime: Read and write

Syntax
Object.Authorization[=HMIRTAuthorization]

Object
Required An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "UserArchiveControl", 
"StatusForce", "Slider", "SymbolLibrary", "OnlineTrendControl", "AlarmControl", "UserView", 
"Checkbox", "OptionGroup", "WindowSlider", "OleView", "Connector" oder "SoftKey".

HMIRTAuthorization
Optional A value or a constant that establishes the operating rights of the specified object in 
Runtime.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)
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Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Slider (Page 5120)

SymbolLibrary (Page 5135)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

Group (Page 5055)

UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

ProtectedAreaName (Page 5102)

RangeLabelView (Page 5103)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

AlarmView (Page 4992)

DateTimeField (Page 5023)

RecipeView (Page 5106)

TrendView (Page 5155)

SystemDiagnoseWindow (Page 5140)

SystemDiagnoseView (Page 5137)

AutoCompleteColumns

Description
Adds empty columns if the Control width is greater than the width of columns configured.   

Access in Runtime: Read and write
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Syntax
Object.AutoCompleteColumns[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The empty columns are displayed.

FALSE: The empty columns are not displayed.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AutoCompleteRows

Description
Enables the insertion of empty rows if the Control length is greater than the number of rows 
configured.   

Access in Runtime: Read and write

Syntax
Object.AutoCompleteRows[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The empty rows are displayed.

FALSE: The empty rows are not displayed.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)
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TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AutoScroll

Description
Specifies how the alarm view behaves when new alarms appear. 

The specific choice of alarm lines is only possible if "AutoScroll" is not enabled. 

The "AutoScroll" property is disabled if the "MsgCtrlFlag" = "-1" attribute is set. The most up-
to-date alarm is then shown at the top of the alarm view. 

Access in Runtime: Read and write

Syntax
Object.AutoScroll[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmView".

BOOLEAN
Optional TRUE, if a new alarm is appended to and chosen from the list shown in the alarm 
window. If necessary, the visible area of the alarm window can be moved. 

FALSE, if a new alarm is not selected. The visible area of the alarm window is not altered.

See also
AlarmControl (Page 4981)

AutoSelectionColors

Description
Enables the display of default system colors as selection color for cells and rows.   

Access in Runtime: Read and write

Syntax
Object.AutoSelectionColors[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".
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BOOLEAN
TRUE: The system color is used.

FALSE: The customized color is used.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

AutoSelectionRectColor

Description
Defines a system color for the selection border.   

Access in Runtime: Read and write

Syntax
Object.AutoSelectionRectColors [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: The system color is used.

FALSE: The customized color is used.

 

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)
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Average

Description
Specifies whether a mean value is shown from the last 15 values.   

Access in Runtime: Read and write

Syntax
Object.Average[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if a mean value is shown from the last 15 values.

Axe property 

Description
Defines or returns the position of the 3D bar in the coordinate system. Value range from 0 to 
2.

0: The 3D-bar is displayed on the X-axis.

1: The 3D-bar is displayed on the Y-axis.

2: The 3D-bar is displayed on the Z-axis.

AxisSection

Description
Defines or returns the distance between two long axis sections. The information on the distance 
is given in scale units and is dependent on the minimum and maximum values configured.

Properties B

BackBorderWidth

Description
Defines or returns the width of the 3D border in pixels. The value for the width is dependent 
on the size of the object.
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BackColor

Description
Specifies the background color of the selected object.   

Access in Runtime: Read and write

Syntax
Object.BackColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllpticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", "IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "GraphicIOField", "GraphicView", "Bar", "UserArchivControl", 
"StatusForce", "Gauge", "Slider", "SymbolLibrary", "RulerTrendControl", 
"OnlineTrendControl", "FunctionTrendControl", "OnlineTableControl", "AlarmControl", 
"UserView", "Checkbox", "OptionGroup", "WindowSlider", "Connector", "Group" or an object 
of the "Screen" type.

Color
Optional A value or a constant that specifies the background color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

The background color is not visible if the "BorderStyle" property has the value "0".

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)
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TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

Group (Page 5055)

Example of writing object properties (Page 4517)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

BackColor

Description
Determines the background color of the given object.   

Access during runtime: Read and Write

Syntax
Object.BackColor  [= Color]
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Object
Required An object of type "ScreenItem" with the characteristic "Line", "Polyline", "Ellipse", 
"Circle", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", "Switch", 
"GraphicIOField", "GraphicView", "Bar", "RecipeView", "StatusForce", "Gauge", "Slider", 
"SymbolLibrary", "TrendView", "MessageView" or "UserView" or an object of type "Screen".

Color
Optional A value or constant which determines the background color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

The background color is not visible if the "BorderStyle" property has the value of "0."

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

TrendView (Page 5155)

StatusForce (Page 5125)

Group (Page 5055)

UserView  (Page 5174)

DateTimeField (Page 5023)

ProjectName (Page 5100)

BackColor2

Description
Defines or returns the bar color for the display of the current value. LONG write-read access.

BackColor3 property 

Description
Defines or returns the color of the bar background. LONG write-read access.
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BackColorBottom

Description
Specifies the color for the lower / right part of the Sliders. 

Access in Runtime: Read and write

Syntax
Object.BackColorBottom[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color for the lower / right part of the Sliders.

See also
WindowSlider (Page 5176)

BackColorTop

Description
Specifies the color for the upper / left part of the Sliders. 

Access in Runtime: Read and write

Syntax
Object.BackColorTop[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color for the upper / left part of the Sliders.

See also
WindowSlider (Page 5176)
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BackFillStyle

Description
Specifies the fill style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BackFillStyle[= THmiFillStyle]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Roundbutton", "GraphicView", "Bar", "Clock", 
"Gauge", "Slider", "SymbolLibrary", "CheckBox", "OptionGroup" or "WindowSlider".

THmiFillStyle
Optional A value or a constant that specifies the fill style.

hmiFillStyleTransparent (65536): Transparent fill 

hmiFillStyleSolid (0): Object is filled with the specified color

Default setting: Solid

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

GraphicView (Page 5052)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)
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CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Listbox (Page 5065)

BackFillStyle

Description
Determines the fill style of the specified object. 

Access during runtime: Read and Write

Syntax
Object.BackFillStyle [= THmiFillStyle]

Object
Required. An object of the "ScreenItem" type with the characteristic "Ellipse," "Circle", 
"Rectangle" or "Polygon".

THmiFillStyle
Optional. A value or constant which determines the fill style.

hmiFillStyleTransparent (65536): Transparent fill

hmiFillStyleTransparent (0): Object is filled with the specified color

Default setting: Solid

See also
DateTimeField (Page 5023)

ProjectName (Page 5100)

BackFillStyleReadOnlySpecial

Description
Specifies that the "Background fill style" can only be read. 

Access in Runtime: Read and write

Syntax
Object.BackFillStyleReadOnlySpecial[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "Background fill style" can only be read. 

See also
IOField (Page 5059)

BackFlashColorOff

Description
Defines or returns the color of the object background for the flash status "Off". LONG write-
read access.

 

 

 

BackFlashColorOn

Description
Defines or returns the color of the object background for the flash status "On". LONG write-
read access.

BackFlashingColorOff

Description
Specifies the color of the background for the flashing status "off". 

Access in Runtime: Read and write

Syntax
Object.BackFlashingColorOff[=Color]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".
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Color
Optional A value or a constant that specifies the color of the background for the flashing status 
"off".

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

BackFlashingColorOn

Description
Specifies the color of the background for the flashing status "on". 

Access in Runtime: Read and write

Syntax
Object.BackFlashingColorOn[=Color]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

Color
Optional A value or a constant that specifies the color of the background for the flashing status 
"on".

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5223



GraphicIOField (Page 5049)

Bar (Page 4995)

BackFlashingEnabled

Description
Specifies whether the background of the specified object will flash in Runtime. 

Access in Runtime: Read and write

Syntax
Object.BackFlashingEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

BOOLEAN
Optional TRUE, if the background of the specified object is flashing in Runtime.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

BackFlashingRate 

Description
Specifies the flash rate of the background for the specified object. 

Access in Runtime: Read and write

Syntax
Object.BackFlashingRate[=FlashingRate]
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Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField" or "Bar".

FlashingRate
hmiFlashingRateSlow ( 0): The length of the flashing rate is 250 ms.

hmiFlashingRateMedium ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast  ( 2): The length of the flashing rate is 1000 ms.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Background

Description
TRUE, when the background of the 3D-bar graph object should be visible. BOOLEAN write-
read access.

BarBackColor 

Description
Specifies the color of the bar background for the selected object. 

Access during runtime: Read and write

Syntax
Object.BarBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Bar," or "Slider".
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Color
Optional A value or a constant that specifies the color of the bar background.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Bar (Page 4995)

Slider (Page 5120)

BarBackFillStyle

Description
Specifies the fill style for the bar. 

Access in Runtime: Read and write

Syntax
Object.BarBackFillStyle[=FillStyle]

Object
Required A "ScreenItem" object with the format "Bar".

FillStyle
hmiFillStyleTransparent ( 65536): Transparent fill style

hmiFillStyleSolid ( 0): Solid fill style

hmiFillStyleBackwardDiagonal ( 131075): Diagonal fill style striped towards the top right

hmiFillStyleCross ( 131076): Checked fill style

hmiFillStyleDiagonalCross ( 131077): Diagonal checked fill style

hmiFillStyleForwardDiagonal ( 131074): Diagonal fill style striped towards the top left

hmiFillStyleHorizontal ( 131072): Horizontal striped fill style

hmiFillStyleVertical ( 131073): Vertical striped fill style

hmiFillStylePattern1 ( 196608): Default fill style

hmiFillStylePattern2 ( 196609): Default fill style

hmiFillStylePattern3 ( 196610): Default fill style

hmiFillStylePattern4 ( 196611): Default fill style
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hmiFillStylePattern5 ( 196612): Default fill style

hmiFillStylePattern6 ( 196613): Default fill style

hmiFillStylePattern7 ( 196614): Default fill style

hmiFillStylePattern8 ( 196615): Default fill style

hmiFillStylePattern9 ( 196616): Default fill style

hmiFillStylePattern10 ( 196617): Default fill style

hmiFillStylePattern11 ( 196618): Default fill style

hmiFillStylePattern12 ( 196619): Default fill style

hmiFillStylePattern13 ( 196620): Default fill style

hmiFillStylePattern14 ( 196621): Default fill style

hmiFillStylePattern15 ( 196622): Default fill style

hmiFillStylePattern16 ( 196623): Default fill style

hmiFillStylePattern17 ( 196624): Default fill style

hmiFillStylePattern18 ( 196625): Default fill style

hmiFillStylePattern19 ( 196626): Default fill style

hmiFillStylePattern20 ( 196627): Default fill style

hmiFillStylePattern21 ( 196628): Default fill style

hmiFillStylePattern22 ( 196629): Default fill style

hmiFillStylePattern23 ( 196630): Default fill style

hmiFillStylePattern24 ( 196631): Default fill style

hmiFillStylePattern25 ( 196632): Default fill style

hmiFillStylePattern26 ( 196633): Default fill style

hmiFillStylePattern27 ( 196634): Default fill style

hmiFillStylePattern28 ( 196635): Default fill style

hmiFillStylePattern29 ( 196636): Default fill style

hmiFillStylePattern30 ( 196637): Default fill style

hmiFillStylePattern31 ( 196638): Default fill style

hmiFillStylePattern32 ( 196639): Default fill style

hmiFillStylePattern33 ( 196640): Default fill style

hmiFillStylePattern34 ( 196641): Default fill style

hmiFillStylePattern35 ( 196642): Default fill style

hmiFillStylePattern36 ( 196643): Default fill style

hmiFillStylePattern37 ( 196644): Default fill style
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See also
Bar (Page 4995)

BarColor

Description
Specifies the color of the slider in the "Slider" object. 

Access during runtime: Read and Write

Syntax
Object.BarColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Slider".

Color
Optional A value or a constant that specifies the color of the slider.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

The range extends from "RangeMin" to the position of the controller.

See also
Slider (Page 5120)

BarDepth

Description
Defines or returns the depth of the bar in pixels.

BarHeight property

Description
Defines or returns the height of the bar in pixels.
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BarStartValue

Description
Specifies the value of the zero point of the scale. 

Access in Runtime: Read and write

Syntax
Object.BarStartValue[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the value of the zero point for the scale.

See also
Bar (Page 4995)

BarWidth

Description
Defines or returns the width of the bar in pixels.

BaseScreenName 

Description
Reads the name of the current root screen or triggers a root screen change by setting a new 
screen name. 

Access in Runtime: Read and write

Syntax
Object.BaseScreenName[= STRING]

Object
Required An "HMIRuntime" object.

STRING
Optional A value or a constant that contains the screen name.
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Comments
You can also use the property to establish which screen is currently being displayed.

BaseX property

Description
Defines or returns the horizontal distance of the right bar edge to the left edge of the object 
field in pixels.

BaseY property

Description
Defines or returns the vertical distance of the bottom bar edge to the top edge of the objet field.

BeginTime(i) 

Description
Specifies the start time of the time range to be shown in the trend view. The property 
"TagProviderType(i)" must have the value -1. 

Access in Runtime: Read and write

Syntax
Object.BeginTime(i)[=Time]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" oder 
"OnlineTableControl".

Time
Optional A value or a constant which determines the start time of the time range to be shown 
in the trend view. 

Comments
The parameter i indicates the number of the trend. 

If "BeginTime(i)" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent an immediate acceptance of the 
change with "FreezeProviderConnections" before changing "BeginTime(i)".
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See also
FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

BelowLowerLimitColor

Description
Defines the color of the specified object for the case "Low limit exceeded".   

See also
SymbolLibrary (Page 5135)

GraphicIOField (Page 5049)

Switch (Page 5127)

SymbolicIOField (Page 5130)

IOField (Page 5059)

BitNumber

Description
Specifies the bit whose status must change to trigger a value change. 

Access in Runtime: Read and write

Syntax
Object.BitNumber[=Int]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button" or 
"GraphicIOField".

Int
Optional Specifies the bit whose status must change to trigger a value change.

Comments
The tag being used must be of type BYTE, WORD or DWORD. 
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See also
SymbolicIOField (Page 5130)

Button (Page 5002)

GraphicIOField (Page 5049)

BlinkColor

Description
Specifies the color in which the "SymbolLibrary" object will flash. 

Access during runtime: Read and Write

Syntax
Object.BlinkColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "SymbolLibrary".

Color
Optional A value or a constant that specifies the flash color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
SymbolLibrary (Page 5135)

BlinkMode

Description
Sets the type of flash picture for the specified object.   

Access during runtime: Read and write

Syntax
Object.BlinkMode[=SymbolLibBlinkMode]
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Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibBlinkMode
hmiSymbolLibraryFlashingNone ( 0): Flashing is switched off.

hmiSymbolLibraryFlashingInvisible ( 1): The flash picture is invisible.

hmiSymbolLibraryFlashingShaded ( 2): The flash picture is given a colored, shaded surface. 
The color of the surface corresponds to the settings in the property "BlinkColor".

hmiSymbolLibraryFlashingSolid ( 3): The flash picture is given a colored, unshaded surface. 
The color of the surface corresponds to the settings in the property "BlinkColor".

See also
SymbolLibrary (Page 5135)

BlinkSpeed

Description
Specifies the flash rate. 

Fast - 250: The length of the flashing rate is 250 ms. Medium - 500: The length of the flashing 
rate is 500 ms.

Slow - 1000: The length of the flashing rate is 1000 ms. The default value is medium - 500. 

Access in Runtime: Read and write

Syntax
Object.BlinkSpeed[=FlashingRate]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

FlashingRate
hmiFlashingRateSlow ( 0): The length of the flashing rate is 250 ms.

hmiFlashingRateMedium ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast ( 2): The length of the flashing rate is 1000 ms.

See also
SymbolLibrary (Page 5135)
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BorderBackColor

Description
Specifies the background color of the broken border line for the specified object. 

Access in Runtime: Read and write

Syntax
Object.BorderBackColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "Button", "Roundbutton", "GraphicView", "Bar", "Checkbox", 
"OptionGroup" or "WindowSlider".

Color
Optional A value or a constant that specifies the background color of the broken border line 
for the specified object.

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

GraphicView (Page 5052)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

MultiLineEdit (Page 5070)

Listbox (Page 5065)
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DateTimeField (Page 5023)

ProjectName (Page 5100)

BorderBrightColor3D

Description
Specifies the frame color of the following frame parts in case of a 3D display of the specified 
object: 

● External frame parts at the top and bottom

● Internal frame parts at the top and right

Access in Runtime: Read and write

Syntax
Object.BorderBrightColor3D[= Color]

Object
Required A "ScreenItem" object with the formats "Button", "Roundbutton" or "Slider".

Color
Optional A value or a constant that specifies the frame color. Default setting is white.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Button (Page 5002)

Slider (Page 5120)

BorderShadeColor3D (Page 5248)

BorderBrightColor3D

Description
Determines the frame color of the following frame parts in the 3D display of the given object: 

● Outer frame parts above and below

● Inner frame parts below and right
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Access during runtime: Read and Write

Syntax
Object.BorderBrightColor3D [= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Slider".

Color
Optional A value or constant which determines the frame color. Default setting is white.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

BorderColor

Description
Specifies the line color of the specified object. 

Access in Runtime: Read and write

Syntax
Object.BorderColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Roundbutton", "Switch", "GraphicView", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup" or "WindowSlider".

Color
Optional A value or a constant that specifies the line color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5236 System Manual, 02/2014



See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

AlarmControl (Page 4981)

Example of configuring the recipe view (Page 4519)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

BorderColor

Description
Specifies the line color of the selected object.     

Access during runtime: Read and Write
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Syntax
Object.BorderColor [= Color]

Object
Necessary. An object of the "ScreenItem" type with the characteristics "Ellipse", "Circle", 
"Rectangle", "Polygon", "TextField", "IOField" or "SymbolicIOField".

Color
Optional A value or constant which determines the line color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

Used for the following object types:
Rectangle

 

See also
DateTimeField (Page 5023)

ProjectName (Page 5100)

BorderColorBottom

Description
Defines or returns the border color for the bottom/right part of the object. LONG write-read 
access.

BorderColorTop

Description
Defines or returns the border color for the top/left part of the object. LONG write-read access.

BorderEnabled

Description
TRUE, when the window is displayed with borders in Runtime. Read only access.
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See also
ScreenWindow (Page 5116)

ScriptDiagnostics (Page 5118)

BorderEndStyle

Description
Specifies the type of line-end shapes for the specified object. 

Access in Runtime: Read and write

Syntax
Object.BorderEndStyle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline" or "Connector".

Int
Optional A value or a constant that specifies the type of line-end shapes for the specified object.

See also
Line (Page 5063)

Polyline (Page 5098)

Connector (Page 5020)

BorderFlashColorOff

Description
Defines or returns the color of the object lines for the flashing status "Off". LONG write-read 
access.

BorderFlashColorOn

Description
Defines or returns the color of the object lines for the flashing status "On". LONG write-read 
access.
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BorderFlashingColorOff

Description
Specifies the color of the border line for the selected object for the flashing status "off". 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingColorOff[=Color]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Kreis", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "off".

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)
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BorderFlashingColorOn

Description
Specifies the color of the border line for the selected object for the flashing status "on". 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingColorOn[=Color]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "on".

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)
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BorderFlashingEnable

Description
Specifies whether the border line of the selected object will flash in runtime. 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

BOOLEAN
Optional TRUE, if the border line of the object is flashing.

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

RoundButton (Page 5112)
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BorderFlashingRate

Description
Specifies the flash rate of the border line for the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderFlashingRate[=FlashingRate]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", "SymbolicIOField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "Checkbox", "OptionGroup" 
or "WindowSlider".

FlashingRate
hmiFlashingRateSlow  ( 0): The length of the flashing rate is 250 ms.

hmiFlashingRateMedium  ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast ( 2): The length of the flashing rate is 1000 ms.

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)
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BorderInnerStyle3D

Description
Specifies the display of the internal part of the object border. 

Access in Runtime: Read and write

Syntax
Object.BorderInnerStyle3D[=GaugeBorder3DStyle]

Object
Required A "ScreenItem" object with the formats "Gauge" or "Slider".

GaugeBorder3DStyle
hmiGaugeBorder3DStyleNone ( 0): There is no internal part of the object border.

hmiGaugeBorder3DStyleRecessed ( 1): The object border is shown in relief.

hmiGaugeBorder3DStyleRaised ( 2): The object border is shown raised.

hmiGaugeBorder3DStyleGray ( 3): The object border has a uniform gray border.

hmiGaugeBorder3DStyleColored ( 4): The object border has a uniform colored border. The 
border color corresponds to the background color.

See also
Gauge (Page 5046)

Slider (Page 5120)

BorderInnerWidth3D 

Description
Specifies the width of the inner border for the 3D presentation of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderInnerWidth3D[= LONG]

Object
Required A "ScreenItem" object with the format "Slider".

LONG
Optional A value or a constant that specifies the width in pixels of the inner border.
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See also
Slider (Page 5120)

BorderOuterStyle3D

Description
Specifies the display of the external part of the object border. 

Access in Runtime: Read and write

Syntax
Object.BorderOuterStyle3D[=GaugeBorder3DStyle]

Object
Required A "ScreenItem" object with the formats "Gauge" or "Slider".

GaugeBorder3DStyle
hmiGaugeBorder3DStyleNone ( 0): There is no internal part of the object border.

hmiGaugeBorder3DStyleRecessed ( 1): The object border is shown in relief.

hmiGaugeBorder3DStyleRaised ( 2): The object border is shown raised.

hmiGaugeBorder3DStyleGray ( 3): The object border has a uniform gray border.

hmiGaugeBorder3DStyleColored ( 4): The object border has a uniform colored border. The 
border color corresponds to the background color.

See also
Gauge (Page 5046)

Slider (Page 5120)

BorderOuterWidth3D 

Description
Specifies the width of the outer border for the 3D presentation of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderOuterWidth3D[= LONG]

Object
Required A "ScreenItem" object with the format "Slider".
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LONG
Optional A value or a constant that specifies the width in pixels of the outer border.

See also
Slider (Page 5120)

BorderShadeColor3D

Description
Specifies the frame color of the following frame parts in case of a 3D display of the specified 
object: 

● Internal frame parts at the top and bottom

● External frame parts at the bottom and right

Access in Runtime: Read and write

Syntax
Object.BorderShadeColor3D[= Color]

Object
Required A "ScreenItem" object with the formats "Button", "Roundbutton" or "Slider".

Color
Optional A value or a constant that specifies the color of the shading. Default setting is

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Button (Page 5002)

Slider (Page 5120)
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BorderShadeColor3D

Description
Determines the frame color of the following frame parts in the 3D display of the given object: 

● Inner frame parts above and below

● Outer frame parts below and right

Access during runtime: Read and Write

Syntax
Object.BorderShadeColor3D [= Color]

Object
Required. An object of the "ScreenItem" type with the characteristic "Slider."

Color
Optional. A value or constant which determines the shade color. Default setting is

Remarks
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the corresponding decimal values (value range from 0 to 255) for each of the 
three RGB values. For example, the color "red" is represented as follows: RGB(255, 0, 0). 
Furthermore, you can use the VBS color constants such as vbRedor vbGreen.

BorderStyle

Description
Specifies the type of border lines for the specified object. 

Access in Runtime: Read-only

Syntax
Object.BorderStyle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Roundbutton", "GraphicView", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup", "WindowSlider", "Connector", 
"PrintRecipe" or "PrintMessage".
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Int
Optional A value or a constant that specifies the type of border lines for the specified object. 

0 = filled line

1 = broken line

2 = dotted line

3 = dashed and dotted line

4 = dash - dot - dot line

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

MultiLineEdit (Page 5070)

Listbox (Page 5065)
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BorderStyle3D 

Description
Specifies whether the selected object has a 3D border shadow.

     

Access during runtime: Read and write

Syntax
Object.BorderStyle3D[= BOOLEAN]

Object
Necessary. A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "GraphicView", "GraphicIOField" or "Bar".

BOOLEAN
Optional TRUE, if the object has a 3D border shadow.

Used for the following object types:
Auto-Hotspot

 

 

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

BorderStyle3D

Description
Determines whether the given object has 3D border shading.

Access during runtime: Read and Write
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Syntax
Object.BorderStyle3D [= BOOLEAN]

Object
Required. An object of the type "ScreenItem" with the characteristic "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "GraphicView", "GraphicIOField" or "Bar".

BOOLEAN
Optional. TRUE, if the object has 3D border shading.

See also
DateTimeField (Page 5023)

BorderWidth

Description
Specifies the line thickness of the selected object.     

Access during runtime: Read and write

Syntax
Object.BorderWidth[= LONG]

Object
Necessary. An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "Button", "Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", 
"Gauge", "Slider", "Checkbox", "OptionGroup" or "WindowSlider".

LONG
Optional A value or a constant that specifies the line weight in pixels.

Used for the following object types:
Rectangle

 

 

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)
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CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Gauge (Page 5046)

Slider (Page 5120)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

AlarmControl (Page 4981)

Example of configuring the recipe view (Page 4519)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

BorderWidth

Description
Determines the LineWidth of the given object. 

Access during runtime: Read and Write

Syntax
Object.BorderWidth [= LONG]
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Object
Required. An object of the type "ScreenItem" with the characteristic "Ellipse", "Circle", "Gauge", 
"Rectangle", "Polygon" or "TextField".

LONG
Optional. A value or constant which determines the line width in pixels.

See also
ProjectName (Page 5100)

BorderWidth3D 

Description
Specifies the width of the border for the 3D representation of the selected object. 

Access in Runtime: Read and write

Syntax
Object.BorderWidth3D [= LONG]

Object
Required A "ScreenItem" object with the format "Roundbutton".

LONG
Optional A value or constant which determines the width of the inner border in pixels.

See also
Switch (Page 5127)

Gauge (Page 5046)

RoundButton (Page 5112)

BottomConnectedConnectionPointIndex

Description
Specifies or sets the index number of the bottom connecting point.

LONG write-read access.
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BottomConnectedObjectName

Description
Specifies or sets the object name of the object which is docked on at the bottom connecting 
point.

LONG write-read access.

BoxAlignment

Description
TRUE, when the fields are arranged aligned to the right. BOOLEAN write-read access. 

BoxCount

Description
Defines or returns the number of fields. Value range from 0 to 31.

BoxType

Description
Defines or returns the field type. Value range from 0 to 2:

● 0: Edition

● 1: Input

● 2: I/O field

Button1Width

Description
Defines or returns the width of the Button 1 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.

Button2Width

Description
Defines or returns the width of the Button 2 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.
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Button3Width

Description
Defines or returns the width of the Button 3 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.

Button4Width

Description
Defines or returns the width of the Button 4 in pixels. 
When the SameSize property is set to TRUE, all the buttons are specified the same width.

ButtonColor

Description
Defines or returns the color of the slider. LONG write-read access.

ButtonCommand 

Description
Specifies the display in the message view. 

Access in Runtime: Read and write

Syntax
Object.ButtonCommand[=Long]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Long
Optional A value or a constant which specifies the display in the message view.

0x00000001; 1; alarm list· 

0x00000002; 2; historical alarm list·(short-term) 

0x00000004; 4; historical alarm list·(long-term) 

0x00200000; 2097152; lock list· 

0x00000008; 8; central annunciator acknowledgement· 

0x00000010; 16; single acknowledgement· 
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0x00000020; 32; group acknowledgement· 

0x00000040; 64; Autoscroll· 

0x00000080; 128; selection dialog· 

0x00000100; 256; block dialog· 

0x00000200; 512; print alarm report· 

0x00000800; 2048; emergency acknowledgement· 

0x00001000; 4096; first alarm· 

0x00002000; 8192; last alarm· 

0x00004000; 16384; next alarm· 

0x00008000; 32768; previous alarm· 

0x00010000; 65536; Infotext dialog· 

0x00020000; 131072; comment dialog· 

0x00040000; 262144; Loop in interrupt· 

0x00100000; 1048576; print current view· 

0x00400000; 4194304; lock / unlock alarm· 

0x00800000; 8388608; sort dialog· 

0x01000000; 16777216; time base dialog· 

0x02000000; 33554432; hit list

See also
AlarmControl (Page 4981)

Properties C

Caption 

Description
Specifies the text that will be displayed in the title line of the selected object. 

Access in Runtime: Read and write

Syntax
Object.Caption[= STRING]

Object
Required An object of the "ScreenItem" type with the format "Slider", "FunctionTrendControl", 
"OnlineTableControl", "AlarmControl", "ScreenWindow" or "UserArchiveControl".
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STRING
Optional A value or a constant that contains the text that will be shown in the title line.

See also
Slider (Page 5120)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

ScreenWindow (Page 5116)

UserArchiveControl (Page 5167)

SystemDiagnoseWindow (Page 5140)

TrendRulerControl (Page 5147)

Caption

Description
Determines the text which is displayed in the caption line of the given object. 

Access during runtime: Read and Write

Syntax
Object.Caption [= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "Slider."

STRING
Optional. A value or a constant which contains the text which is displayed in the caption.

CaptionBackColor

Description
Specifies the background color of the title line for the selected object. 

Access in Runtime: Read and write

Syntax
Object.CaptionBackColor[=Color]
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Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the background color of the title line for the 
selected object.

See also
SymbolicIOField (Page 5130)

CaptionColor

Description
Specifies the color of the text that will be displayed in the title line of the selected object. 

Access in Runtime: Read and write

Syntax
Object.CaptionColor[= Color]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Switch" or "Gauge".

Color
Optional A value or a constant that specifies the text color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
SymbolicIOField (Page 5130)

Switch (Page 5127)

Gauge (Page 5046)
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CaptionColor 

Description
Determines the color of the text which is displayed in the title bar of the given object.   

Access during runtime: Read and Write

Syntax
Object.CaptionColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Switch," or "Gauge".

Color
Optional A value or constant which determines the text color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

CaptionText 

Description
Specifies the text that will be displayed in the title line of the selected object. 

Access in Runtime: Read and write

Syntax
Object.CaptionText[= STRING]

Object
Required A "ScreenItem" object with the formats "Switch" or "Gauge".

STRING
Optional A value or a constant that contains the text that will be shown in the title line.
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See also
Switch (Page 5127)

Gauge (Page 5046)

ScreenWindow (Page 5116)

CaptionTop 

Description
Specifies the distance of the instrument labels to the upper edge of the selected object. You 
can position the instrument labels only in line with the vertical diameter of the scale. The value 
of the attribute refers to the height of the specified object. The height establishes the upper 
edge of the specified object and the lower edge of the lettering. 

Access in Runtime: Read and write

Syntax
Object.CaptionTop[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the distance of the instrument labels to the upper 
edge of the selected object.

Value range from 0 to 1 

0: The lower edge of the lettering is positioned on the upper limit of the selected object. The 
text is no longer visible as it is positioned outside of the selected object.

1: The lower edge of the lettering is positioned on the lower limit of the selected object.

See also
Gauge (Page 5046)

CellCut

Description
Specifies whether the contents of the cells are abbreviated if the cells are too narrow.   

Access in Runtime: Read and write
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Syntax
Object.CellCut [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE, if the contents are abbreviated.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

CellSpaceBottom

Description
Defines the bottom margin of the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceBottom

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)
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CellSpaceLeft

Description
Specifies the cell space left which is used in the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceLeft

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

CellSpaceRight

Description
Defines the right indent of the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceRight

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)
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CellSpaceTop

Description
Defines the top margin of the table cells.   

Access in Runtime: Read

Syntax
Object.CellSpaceTop

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

CenterColor

Description
Specifies the color of the center of the "Gauge" object. 

Access during runtime: Read and Write

Syntax
Object.CenterColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the color of the center.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.
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See also
Gauge (Page 5046)

CenterSize 

Description
Specifies the diameter of the round scale center point. 

Access in Runtime: Read and write

Syntax
Object.CenterSize[=Single]

Object
Required A "ScreenItem" object with the format "Gauge".

Single
Optional A value or a constant that specifies the diameter of the round scale center point. 

Value range from 0.03 to 1 

1: The diameter corresponds to the smaller value of the geometry attribute "Width" or "Height".

See also
Gauge (Page 5046)

CentrePoint

Description
Specifies the position of the center point. 

Access in Runtime: Read and write

Syntax
Object.CentrePoint[=Point]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Point
Optional A value that specifies the position of the center point.
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See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

CentrePointLeft

Description
Specifies the horizontal distance in pixels of the center point from the left edge of the screen.  

Access in Runtime: Read and write

Syntax
Object.CentrePointLeft[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the horizontal distance in pixels of the center point from the left 
edge of the screen. 

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

CentrePointTop

Description
Specifies the vertical distance in pixels of the center point from the upper edge of the screen.  

Access in Runtime: Read and write

Syntax
Object.CentrePointTop[=Int]
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Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the vertical distance in pixels of the center point from the upper 
edge of the screen. 

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

ChangeMouseCursor 

Description
Specifies how the appearance of the mouse cursor changes in Runtime when it is above the 
icon. 

Access in Runtime: Read and write

Syntax
Object.ChangeMouseCursor[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

BOOLEAN
Optional TRUE, if the mouse cursor has the appearance of an arrow even when it is positioned 
above the icon. 

FALSE, if the mouse cursor has the apparance of a 3D arrow with a green lightning symbol. 
This indicates in Runtime that the respective objective can be operated.

See also
SymbolLibrary (Page 5135)
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CheckAlarmHigh

Description
TRUE, when the "AlarmHigh" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "AlarmHigh", "ColorAlarmHigh" and "TypeAlarmHigh" properties. 

CheckAlarmLow

Description
TRUE, when the "AlarmLow" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "AlarmLow", "ColorAlarmLow" and "TypeAlarmLow" properties.

CheckLimitHigh4

Description
TRUE, when the "Reserve 4" upper limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitHigh4", "ColorLimitHigh4" and "TypeLimitHigh4" properties.

CheckLimitHigh5

Description
TRUE, when the "Reserve 5" upper limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitHigh5", "ColorLimitHigh5" and "TypeLimitHigh5" properties.

CheckLimitLow4

Description
TRUE, when the "Reserve 4" lower limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitLow4", "ColorLimitLow4" and "TypeLimitLow4" properties.
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CheckLimitLow5

Description
TRUE, when the "Reserve 5" lower limit value should be monitored. BOOLEAN write/read 
access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "LimitLow5", "ColorLimitLow5" and "TypeLimitLow5" properties.

CheckMarkAlignment 

Description
Specifies whether the fields are right aligned. 

Access in Runtime: Read and write

Syntax
Object.CheckMarkAlignment[=ContentAlignment]

Object
Required A "ScreenItem" object with the formats "Checkbox" or "OptionGroup".

ContentAlignment
 ( 0): The fields are arranged left aligned.

 ( 1): The fields are arranged right aligned.

See also
OptionGroup (Page 5092)

CheckMarkCount

Description
Specifies the number of fields. 

Access in Runtime: Read and write

Syntax
Object.CheckMarkCount[=Int]

Object
Required A "ScreenItem" object with the formats "Checkbox" or "OptionGroup".
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Int
Optional A value or a constant that specifies the number of fields. Value range from 0 to 31

See also
OptionGroup (Page 5092)

CheckToleranceHigh

Description
TRUE, when the "ToleranceHigh" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "ToleranceHigh", "ColorToleranceHigh" and "TypeToleranceHigh" properties. 

CheckToleranceLow

Description
TRUE, when the "ToleranceLow" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "ToleranceLow", "ColorToleranceLow" and "TypeToleranceLow" properties.

CheckWarningHigh

Description
TRUE, when the "WarningHigh" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "WarningHigh", "ColorWarningHigh" and "TypeWarningHigh" properties.

CheckWarningLow

Description
TRUE, when the "WarningLow" limit value is to be monitored. BOOLEAN write/read access.
The limit value, the display on reaching the limit value and the type of evaluation are defined 
by means of the "WarningLow", "ColorWarningLow" and "TypeWarningLow" properties.

ClearOnError 

Description
Specifies whether an invalid input in this object will be deleted automatically. 
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Access in Runtime: Read and write

Syntax
Object.ClearOnError[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if an invalid input in this object will be deleted automatically.

See also
IOField (Page 5059)

ClearOnFocus

Description
Specifies whether the field entry will be deleted as soon as the I/O field is activated. 

Access in Runtime: Read and write

Syntax
Object.ClearOnFocus[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the field entry is deleted as soon as the I/O field is activated.

See also
IOField (Page 5059)

ClearOnNew

Description
TRUE, when the field entry is deleted as soon as the I/O field has the focus. BOOLEAN write-
read access.
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Closable

Description
Specifies whether the window can be closed in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Closable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the window can be closed in Runtime.

See also
AlarmControl (Page 4981)

Example of configuring the recipe view (Page 4519)

UserArchiveControl (Page 5167)

SystemDiagnoseWindow (Page 5140)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

CloseButton

Description
TRUE, when the window is provided with a "Close" button. Read only access.

Color

Description
Specifies the line color of the specified object. 

Access in Runtime: Read and write
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Syntax
Object.Color[= Color]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "EllipticalArc" or 
"CircularArc".

Color
Optional A value or a constant that specifies the line color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Line (Page 5063)

Polyline (Page 5098)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

TubeArcObject (Page 5158)

TubeDoubleTeeObject (Page 5160)

TubePolyline (Page 5162)

TubeTeeObject (Page 5165)

Color

Description
Determines the line color of the given object. 

Access during runtime: Read and Write

Syntax
Object.Color [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Line," or "Polyline".
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Color
Optional A value or constant which determines the line color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

ColorAlarmHigh

Description
Defines or returns the bar color for the "AlarmHigh" limit value. LONG write/read access.
The "CheckAlarmHigh" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorAlarmLow

Description
Defines or returns the bar color for the "AlarmLow" limit value. LONG write/read access.
The "CheckAlarmLow" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorBottom

Description
Defines or returns the color for the bottom/right stop of the slider object. LONG write-read 
access.

ColorChangeHysteresis

Description
Specifies hysteresis as a percentage of the display value. 

The "ColorChangeHysteresisEnable" property must have the value TRUE so that the 
hysteresis can be calculated. 

Access in Runtime: Read and write
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Syntax
Object.ColorChangeHysteresis[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the hysteresis as a percentage of the display 
value.

See also
Bar (Page 4995)

ColorChangeHysteresisEnabled

Description
Determines whether the object will be displayed with a hysteresis. 

Access in Runtime: Read and write

Syntax
Object.ColorChangeHysteresisEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the object will be displayed with a hysteresis.

See also
Bar (Page 4995)

ColorChangeType

Description
TRUE, if the change of color should occur segment by segment in the case of a color change 
(e.g. on reaching a limit value). If set to FALSE, it defines the change of color for the entire 
bar. BOOLEAN write-read access. 
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ColorLimitHigh4

Description
Defines or returns the color for the "Reserve 4" upper limit value. LONG write/read access.
The "CheckLimitHigh4" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorLimitHigh5

Description
Defines or returns the color for the "Reserve 5" upper limit value. LONG write/read access.
The "CheckLimitHigh5" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorLimitLow4

Description
Defines or returns the color for the "Reserve 4" lower limit value. LONG write/read access.
The "CheckLimitLow4" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorLimitLow5

Description
Defines or returns the color for the "Reserve 5" lower limit value. LONG write/read access.
The "CheckLimitLow5" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorToleranceHigh

Description
Defines or returns the color for the "ToleranceHigh" upper limit value. LONG write/read access.
The "CheckToleranceHigh" property must have been set to TRUE if the bar color should 
change on reaching the limit value.
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ColorToleranceLow

Description
Defines or returns the color for the "ToleranceLow" lower limit value. LONG write/read access.
The "CheckToleranceLow" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorTop

Description
Defines or returns the color for the top/left stop of the slider object. LONG write-read access.

ColorWarningHigh

Description
Defines or returns the color for the "WarningHigh" upper limit value. LONG write/read access.
The "CheckWarningHigh" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColorWarningLow

Description
Defines or returns the color for the "WarningLow" lower limit value. LONG write/read access.
The "CheckWarningLow" property must have been set to TRUE if the bar color should change 
on reaching the limit value.

ColumnAlign

Description
Specifies how the selected column is aligned.

The following settings are possible:

Value Description Explanation
0 Left The column selected is displayed left-justified.
1 Centered The column selected is displayed centered.
2 Right The column selected is displayed right-justified.

The attribute can be made dynamic with the name ColumnAlign. The data type is LONG.
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ColumnColor(i)

Description
Determines the color of the i column pair. The parameter i indicates the number of the column 
pair.  

Access in Runtime: Read and write

Syntax
Object.ColumnColor(i)[=Color]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Color
Optional A value or a constant that specifies the color of the i column pair.

See also
OnlineTableControl (Page 5075)

ColumnDisplayName(i)

Description
Specifies the name for the selected column pair. The parameter i indicates the number of the 
column pair. 

Access in Runtime: Read and write

Syntax
Object.ColumnDisplayName(i)[=String]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

String
Optional A value or a constant that specifies the name for the selected column pair. 

See also
OnlineTableControl (Page 5075)
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ColumnResize

Description
Enables changes to the width of columns.   

Access in Runtime: Read and write

Syntax
Object.ColumnResize[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN
TRUE: You can change the width of the columns.

FALSE: You cannot change the width of the columns.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

ColumnSizingEnable

Description
Specifies whether the width of the columns in the alarm window can be changed. The width 
of the columns can be changed only if the "AutoScroll" property is not enabled. 

Access in Runtime: Read and write

Syntax
Object.ColumnSizingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE if the width of the columns in the alarm window can be changed. 
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See also
AlarmControl (Page 4981)

ColumnSrollbar

Description
Enables the display of column scroll bars.   

Access in Runtime: Read

Syntax
Object.ColumnScrollbar[=Scrollbar]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

Scrollbar
0 = (No) The column scrollbars are not displayed.

1 = (if required) The column scrollbars are displayed if the space requirement of the control is 
greater in vertical direction than the available display area. 

2 = (always) The column scrollbars are always displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

ColumnTimeFormat (Professional)

Description
Defines the time format to be used for visualization. The "ColumnIndex" property is used to 
reference the time column of the recipe view. The attribute can be assigned dynamic properties 
by means of the name ColumnTimeFormat.

Access in Runtime: Read and write

Syntax
Object.ColumnTimeFormat(=String)
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Object
Required. An object of the "ScreenItem" type with the characteristic "UserArchiveControl".

String
The following time formats are available:

Value Explanation
HH:mm:ss.ms Hours:Minutes:Seconds, e.g. 15:35:44.240.
hh:mm:ss tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.
hh:mm:ss.ms tt Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

Comments
The time format can be accessed with read access after the first modification only. 

ColumnTitleAlign

Description
Specifies the type of column title alignment.   

Access in Runtime: Read

Syntax
Object.ColumnTitleAlign[=Align]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

Align
0 = The column headers are shown left aligned.

1 = The column headers are shown centered.

2 = The column headers are shown right aligned.

3 = The column headers are aligned as the corresponding content.

See also
AlarmControl (Page 4981)
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ColumnTitles

Description
Enables the display of the column header.   

Access in Runtime: Read

Syntax
Object.ColumnTitle[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl".

BOOLEAN

BOOLEAN
TRUE: The column header is displayed.

FALSEThe column header is not displayed.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

ColumnUpdateEnabled(i) 

Description
Specifies whether the selected column pair will be shown statically or dynamically. 

Access in Runtime: Read and write

Syntax
Object.ColumnUpdateEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE if the column pair is to be shown statically.
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Comments
The "CurrentColumnIndex" property references the column pair that is currently active. 

See also
OnlineTableControl (Page 5075)

Command

Description
Specifies whether there is a forced update of the values displayed in the control.   

Access in Runtime: Read and write

Syntax
Object.Command[=String]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"OnlineTableControl".

String
Optional A value or a constant which specifies whether there is a forced update of the values 
displayed in the control.

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

Comment

Description
Reads or sets the Alarm object comment.

CommonTimeAxisColor

Description
Specifies the color of the mutual X axis. 

Access in Runtime: Read and write
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Syntax
Object.CommonTimeAxisColor[=Color]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

Color
Optional A value or a constant that specifies the color of the common x axis.

See also
OnlineTrendControl (Page 5083)

ComputerName

Description
Returns the name of the computer on which the alarm object was triggered.

ComputerName (readonly)

ConfigureTimeAxis(i) 

Description
Specifies whether a common time axis is used for all the trends in the trend view.   

Access in Runtime: Read and write

Syntax
Object.ConfigureTimeAxis(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if a common axis is used for all the trends in the trend view.

See also
OnlineTrendControl (Page 5083)
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ConnectionType

Description
Specifies the type of connector. It is possible to select between two connection types.   

Access in Runtime: Read and write

Syntax
Object.ConnectionType[=ConnectorConnectionType]

Object
Required An object of the "ScreenItem" type with the format "Connector".

ConnectorConnectionType
( 0): Automatic: Both objects are connected by a polyline made up of horizontal and vertical 
parts.

( 1): Single: Both objects are connected by a straight line between the connecting points. The 
fields are arranged right-justified.

See also
SmartClientView (Page 5123)

Connector (Page 5020)

ConnectTrendWindows

Description
Specifies whether the configured trend views are connected. The requirement is that you have 
configured several trend views.     

The connected trend views have the following properties:

● A common X axis

● A scrollbar

● A ruler

Access in Runtime: Read

Syntax
Object.ConnectTrendWindows[=Boolean]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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Boolean
TRUE = All configured trend views are connected.

FALSE = The trend views are displayed separately.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

Context

Description
Reads or sets the alarm object server prefix.

ContinousChange

Description
Specifies whether the value of the "ProcessValue" property will be transferred when the mouse 
button is released or as soon as the slider position changes in Runtime. 

Access in Runtime: Read and write

Syntax
Object.ContinousChange[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Slider".

BOOLEAN
Optional TRUE, if the value of the property "ProcessValue" will be transferred when the mouse 
button is released or as soon as the slider position changes in Runtime.

See also
Slider (Page 5120)

CornerStyle

Description
Specifies the type of border lines for the specified object.   
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Access in Runtime: Read-only

Syntax
Object.ConerStyle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Roundbutton", "TubePolyLone", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup", "WindowSlider", "Connector", 
"MultiLineEdit" or "ComboBox".

Int
Optional A value or a constant that specifies the type of border lines for the specified object. 

0 = filled line

1 = broken line

2 = dotted line

3 = dashed and dotted line

4 = dash - dot - dot line

See also
TubePolyline (Page 5162)

CheckBox (Page 5008)

GraphicIOField (Page 5049)

Bar (Page 4995)

GraphicView (Page 5052)

WindowSlider (Page 5176)

Switch (Page 5127)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)

Line (Page 5063)

Listbox (Page 5065)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Connector (Page 5020)

Ellipse (Page 5027)

EllipseSegment (Page 5029)
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EllipticalArc (Page 5032)

Polygon (Page 5095)

Polyline (Page 5098)

RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

Count

Description
Returns the number of elements in the specified list.  

Access in Runtime: Read

Syntax
Object.Count

Object
Required A "Collection" object.

CountDivisions 

Description
Specifies the number of segments in which the bar will be divided by the large marking lengths 
of the scale. 

Access in Runtime: Read and write

Syntax
Object.CountDivisions[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the number of segments in which the bar will be 
divided by the large marking lengths of the scale. 

0-100: An object can be divided into a maximum of 100 segments 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5286 System Manual, 02/2014



= 0: The optimum number of segments will be established automatically.

See also
Bar (Page 4995)

CountSubDivisions

Description
Specifies the number of scale marking lengths between two main marking lengths of the "Bar" 
object. 

Access in Runtime: Read and write

Syntax
Object.CountSubDivisions[= LONG]

Object
Required A "ScreenItem" object with the format "Bar".

LONG
Optional A value or a constant that specifies the number of scale segments.

See also
Bar (Page 4995)

CountValueColumns 

Description
Returns the number of configured trends or column pairs (visible and invisible) of the window. 

Access in Runtime: Read and write

Syntax
Object.CountValueColumns[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Int
Optional A value or a constant that returns the number of configured trends or column pairs 
(visible and invisible) of the window. 
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See also
OnlineTableControl (Page 5075)

CountVisibleItems

Description
Specifies how many lines the selection list will contain. If the number of configured texts is 
greater than this value, then the selection list will have a vertical scroll bar. 

Access in Runtime: Read and write

Syntax
Object.CountVisibleItems[=Int]

Object
Required An object of the "ScreenItem" type with the format "SymbolicIOField", "StatusForce", 
"OnlineTrendControl" or "UserArchivControl".

Int
Optional A value or a constant that specifies how many lines the selection list will contain.

See also
SymbolicIOField (Page 5130)

UserView  (Page 5174)

StatusForce (Page 5125)

Listbox (Page 5065)

TrendView (Page 5155)

CurrentColumnIndex

Description
Specifies which settings can be assigned to a selected column pair. The property is evaluated 
by other properties. Valid values for the index have values from 0 to -1. The 
"CountValueColumns" property contains the number of column pairs that are to be shown. 

Access in Runtime: Read and write

Syntax
Object.CurrentColumnIndex[=Int]
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Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Int
Optional A value or a constant that specifies which settings can be assigned to a particular 
column pair.

Comments
The "NumItems" property contains the number of trends / column pairs to be shown.

See also
OnlineTableControl (Page 5075)

CurrentContext

Description
Returns a character string depending on the use of the function.

If the function is contained in a screen in the screen window, CurrentContext returns the 
symbolic server name which supplies the screen. Example: "WinCCProject_MyComputer::"

If the function is contained in the main screen, an empty character string is returned. 

Access in Runtime: Read

Syntax
Object.CurrentContext

Object
Required A "HMIRuntime" object.

See also
HMIRuntime  (Page 4956)

CurrentCurveIndex

Description
Specifies the index for the active trends.   

Access in Runtime: Read and write
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Syntax
Object.CurrentCurveIndex[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTrendControl".

Int
Optional A value or a constant that specifies the index of the trends that are currently active.

Comments
The "CurrentCurveIndex" property is evaluated by other properties so that their settings can 
be assigned to a specific trend. Valid values range from 0 to -1. The "CurvesCount" property 
contains the number of trends to be shown.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

CursorControl 

Description
Specifies whether the mouse cursor jumps to the next field of the TAB order after leaving the 
field. 

Access in Runtime: Read and write

Syntax
Object.CursorControl[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField" or "SymbolicIOField".

BOOLEAN
Optional. TRUE, if the mouse cursor jumps to the next field of the TAB-order after leaving the 
field.

Comments
For this purpose, the "CursorMode" property must be set to TRUE. 
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See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

CurveColor(i)

Description
Specifies the color of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.CurveColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Color
Optional A value or a constant that specifies the color of the selected trend.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

CurveLineWidth(i)  

Description
Specifies the line weight of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.CurveLineWidth(i)[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".
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Int
Optional A value or a constant that specifies the line weight of the selected trend. Value range 
from 0 to 10.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

CurvesCount

Description
Returns the number of configured trends or column pairs (visible and invisible) of the window. 

Access in Runtime: Read and write

Syntax
Object.CurvesCount[=Int]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Int
Optional A value or a constant that returns the number of configured trends or column pairs 
(visible and invisible) of the window.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

CurveUpdateEnabled(i)

Description
Specifies whether the selected trend will be shown statically or dynamically. 

Access in Runtime: Read and write
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Syntax
Object.CurveUpdateEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE if the trend is to be shown statically.

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

Properties D

DangerRangeColor 

Description
Specifies the color of the danger range of the scale of the "Gauge" object. 

The "DangerRangeVisible" property must have the value TRUE so that the danger range is 
displayed.

Access during runtime: Read and write

Syntax
Object.DangerRangeColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the color of the danger range.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.
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See also
Gauge (Page 5046)

DangerRangeVisible (Page 5296)

DangerRangeStart 

Description
Specifies at which scale value the danger range of the "Gauge" object will start. 

The "DangerRangeColor" property must have the value TRUE so that the danger range is 
displayed.

Access in Runtime: Read and write

Syntax
Object.DangerRangeStart[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

DOUBLE
Optional A value or a constant that specifies the scale value for the start of the danger range.

Comments
The range extends from the value "Gefahr" through to the end of the scale.

See also
Gauge (Page 5046)

DangerRangeVisible (Page 5296)

DangerRangeVisible

Description
Specifies whether the danger range in the scale of the "Gauge" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.DangerRangeVisible[= BOOLEAN]
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Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the danger range will be displayed in the scale.

Comments
Specifies the color of the danger range with the "DangerRangeColor" property.

Specifies the start of the danger range with the "DangerRangeStart" property.

See also
Gauge (Page 5046)

DataFormat

Description
Returns the data type of the I/O field object. Read only access.

Value range from 0 to 3.

0: Binary

1: Decimal

2: String 

3: Hexadecimal

See also
IOField (Page 5059)

DataIndex(i) 

Description
Returns the current index for the data of the current trend. 

Access in Runtime: Read and write

Syntax
Object.DataIndex(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".
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Int
Optional A value or a constant that specifies the current index of the data for the current trend.

See also
FunctionTrendControl (Page 5038)

DataLogs

Description
Returns an object of type "DataLogs".

Access in Runtime: Read

Syntax
Object.DataLogs

Object
Required A "Logging" object. 

See also
Logging (Page 4961)

DataLogTag

Description
Specifies which tag is linked with the selected trend.

Access in Runtime: Read and write

Syntax
Object.DataLogTag[=HmiLoggingTag]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"OnlineTableControl".

HmiLoggingTag
Optional A value or a constant that specifies which tags are linked to the selected trend.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5296 System Manual, 02/2014



Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

DataSet 

Description
Returns an object of type "DataSet". 

Access in Runtime: Read

Syntax
Object.DataSet

Object
Required A "Screen" object. 

See also
HMIRuntime  (Page 4956)

Screen (Page 4964)

DataX(i)

Description
Inserts one single data record and must be set prior to the call of "InsertData(i)". 

Access in Runtime: Read and write

Syntax
Object.DataX(i)[=object]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

object
Optional A value or a constant that inserts one single data record.
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See also
FunctionTrendControl (Page 5038)

DataXY(i) 

Description
Inserts several data records as Array with value pairs and must be set before calling 
"InsertData(i)". 

The data in the Array are applied if "DataX(i)" is a VT_EMPTY type. Otherwise, the single value 
pair resulting from "DataX(i)" and "DataY(i)" will be used in the attribute "InsertData(i)". 

Access in Runtime: Read and write

Syntax
Object.DataXY(i)[=object]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

object
Optional A value or a constant which inserts several data records as Array with value pairs.

See also
FunctionTrendControl (Page 5038)

DataY(i)

Description
Inserts one single data record and must be set prior to the call of "InsertData(i)". 

Access in Runtime: Read and write

Syntax
Object.DataY(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Double
Optional A value or a constant that inserts one single data record.
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See also
FunctionTrendControl (Page 5038)

DeleteData(i) 

Description
Specifies which data from the data buffer of the active trend will be deleted. 

TRUE: 

Access in Runtime: Read and write

Syntax
Object.DeleteData(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if all the data of the trend is to be deleted. 

FALSE, if the value pair at position "DataIndex(i)" is to be deleted.

See also
FunctionTrendControl (Page 5038)

DeleteEnable

Description
Specifies whether the recipe view can be cleared in Runtime.   

Access in Runtime: Read and write

Syntax
Object.DeleteEnable[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the recipe view can be cleared in Runtime.
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DialColor 

Description
Specifies the color of the dial for the selected object. 

Access during runtime: Read and Write

Syntax
Object.DialColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Clock," or "Gauge".

Color
Optional A value or a constant that specifies the color of the dial.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 5046)

DialFillStyle

Description
Specifies the type of background of the selected object. 

Access in Runtime: Read and write

Syntax
Object.DialFillStyle[=GaugeBackStyle]

Object
Required A "ScreenItem" object with the format "Gauge".

GaugeBackStyle
hmiGaugeBackStyleSolid ( 0): The rectangular background of the display is filled with the 
specified border color. The scale is filled with the specified background color.
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solid backstyle.

hmiGaugeBackStyleFrameTransparent ( 1): The rectangular background of the Gauge is 
transparent. The scale is filled with the specified background color. As a result, a circular 
display can be shown.

Identifies only frame is transparent.

hmiGaugeBackStyleTransparent ( 2): The rectangular background and the scale are 
transparent.

Identifies a transparent backstyle.

See also
Gauge (Page 5046)

DialSize 

Description
Specifies the diameter of the scale in relation to the smaller value of the geometry attributes 
"Width" and "Height". 

Access in Runtime: Read and write

Syntax
Object.DialSize[=Single]

Object
Required A "ScreenItem" object with the format "Gauge".

Single
Optional A value or a constant that establishes the diameter of the scale in relation to the 
smaller value of the geometry attributes "Width" and "Height".

See also
Gauge (Page 5046)

Direction

Description
Defines or returns the bar direction or the position of the slider object.   

Access in Runtime: Read and write
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Syntax
Object.Direction [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "Bar" or "Slider".

BOOLEAN
0 = top

1 = bottom

2 = left

3 = right

DisplayName(i) 

Description
Specifies the name for the selected trend.

Access in Runtime: Read and write

Syntax
Object.DisplayName(i)[=String]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

String
Optional A value or a constant that specifies the name for the selected trend. 

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 5038)

DisplayOptions

Description
Specifies which messages are displayed.   

Access in Runtime: Read

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5302 System Manual, 02/2014



Syntax
Object.DisplayOptions [=DisplayOption]

Object
Required A "ScreenItem" object with the format "AlarmControl".

DisplayOption
0: All messages

1: Only displayed messages

2: Only hidden messages

See also
AlarmControl (Page 4981)

DoubleClickAction

Description
Sepcifies the action to be executed in Runtime by double-clicking on a message line.   

Access in Runtime: Read

Syntax
Object.DoubleClickAction[=ClickAction]

Object
Required A "ScreenItem" object with the format "AlarmControl".

ClickAction

Value Description Description
0 none No action.
1 Loop-in-alarm Calls the "Loop-in-alarm" function.
2 Open comments dialog Calls the "Comments dialog" button function.
3 Open Infotext dialog Calls the "Infotext dialog" button function.
4 Column-dependent The action is determined by the column in which you 

double-clicked.

See also
AlarmControl (Page 4981)
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DrawAlwaysInsideFrame

Description
Specifies whether the border line of the selected object should be illustrated with a line weight 
greater than 1 within the border or symmetrically to the border. 

Access in Runtime: Read and write

Syntax
Object.DrawAlwaysInsideFrame[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Rectangle".

BOOLEAN
Option TRUE, if the border line of the specified object will be illustrated with a line weight 
greater than 1 within the border.

See also
Rectangle (Page 5110)

DrawEnhancedHTMLBrowser

Description
Specifies the style of the HTML-Browsers. 

Access in Runtime: Read and write

Syntax
Object.DrawEnhancedHTMLBrowser[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "HTMLBrowser".

BOOLEAN
Optional TRUE, if an extended HTML-Browser will be displayed.

See also
HTMLBrowser (Page 5057)
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DrawInsideFrame

Description
Specifies whether the border line of the selected object should be illustrated with a line weight 
greater than 1 within the border or symmetrically to the border. 

Access in Runtime: Read and write

Syntax
Object.DrawInsideFrame[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "GraphicView", "GraphicIOField", "Bar", 
"CheckBox", "OptionGroup", "WindowSlider" or "Connector".

BOOLEAN
Optional TRUE, if the border line of the specified object will be illustrated with a line weight 
greater than 1 within the border.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)
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CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

RoundButton (Page 5112)

DrawStylishButton

Description
Specifies whether the button will be displayed in the general Windows style. 

Access in Runtime: Read and write

Syntax
Object.DrawStylishButton[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Button".

BOOLEAN
Optional TRUE, if the button will be displayed in the general Windows style.

See also
Button (Page 5002)

Drive

Description
Specifies the characters of the drive that is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Drive[=String]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

String
Optional A value or a constant that specifies the characters of the drive that is to be monitored.
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See also
DiskSpaceView (Page 5025)

Properties E-F

EdgeStyle

Description
Determines the line style of the given object. 

Access during runtime: Read and Write

Syntax
Object.EdgeStyle [= THmiLineStyle]

Object
Required. An object of the type "ScreenItem" with the characteristic "Ellipse", "Circle", 
"Rectangle", "Polygon", "TextField" or "IOField".

THmiLineStyle
Optional. A value or constant that defines the line style. Value range from -1 to 4.

The objects "Ellipse", "Circle", "Rectangle" and "Polygon" support the line style:

● hmiLineStyleSolid (0): solid line

● hmiLineStyleDash (1): dashed line

● hmiLineStyleDot (2): dotted line

● hmiLineStyleDashDot (3): dash dot line

● hmiLineStyleDashDotDot (4): dash dot dot line

The objects "TextField" and "IOField" support only the line style:

● hmiLineStyleNone (-1): no line

● hmiLineStyleSolid (0): solid line

Default setting: hmiLineStyleSolid

See also
GraphicIOField (Page 5049)

Switch (Page 5127)

CircleSegment (Page 5013)

DateTimeField (Page 5023)

Ellipse (Page 5027)
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EdgeStyle

Description
Specifies the line style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.EdgeStyle[= THmiLineStyle]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField" "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Roundbutton", "Switch", "GraphicView", 
"GraphicIOField", "Bar", "Checkbox", "OptionGroup" or "WindowSlider".

THmiLineStyle
Optional A value or a constant that specifies the line style. Value range from -1 to 4.

The objects "Ellipse", "Circle", "Rectangle" and "Polygon" support the line styles:

● hmiLineStyleSolid (0): solid line

● hmiLineStyleDash (1): broken line

● hmiLineStyleDot (2): dotted line

● hmiLineStyleDashDot (3): dash - dot line

● hmiLineStyleDashDotDot (4): dash - dot - dot line

The objects "TextField" and "IOField" support only the line styles:

● hmiLineStyleNone (-1): no line

● hmiLineStyleSolid (0): solid line

Default setting: hmiLineStyleSolid

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)
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Button (Page 5002)

RoundButton (Page 5112)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

ProjectName (Page 5100)

Editable(i)

Description
Specifies whether a column pair can be edited. The parameter i indicates the number of the 
column pair.   

Access in Runtime: Read and write

Syntax
Object.Editable(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if the column pair can be edited. The column pair is referenced by the 
parameter i.

See also
OnlineTableControl (Page 5075)

EditAtOnce 

Description
TRUE, if accessing the field with the <TAB> key permits input immediately and without further 
action. BOOLEAN write-read access.
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EditEnabled

Description
Specifies whether edit mode is enabled for a cell, if the property "Editable(i)" has the value 
TRUE. 

Access in Runtime: Read and write

Syntax
Object.EditEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if the edit mode is enabled for a cell if the property "Editable(i)" has the value 
TRUE.

See also
OnlineTableControl (Page 5075)

EditOnFocus 

Description
Specifies whether the data input is immediately possible if the input field is selected using the 
<Tab> key. 

Access in Runtime: Read and write

Syntax
Object.EditOnFocus[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField" or "SymbolicIOField".

BOOLEAN
Optional TRUE, if the data input is immediately possible and the input field has been selected 
using the <Tab> key.
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See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

Enabled 

Description
Specifies whether the selected object can be operated in Runtime.   

Access in Runtime: Read and write

Syntax
Object.Enabled[= BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", "IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "GraphicView", "GraphicIOField", "Bar", "StatusForce", "Clock", 
"Gauge", "Slider", "SymbolLibrary", "OnlineTableControl", "OnlineTrendControll, 
"FunctionTrendControl", "UserView", "HTMLBrowser", "Checkbox", "OptionGroup", 
"WindowSlider", "OleView", "Connector","DiskSpaceView", "ChannelDiagnose" or 
"UserArchiveControl".

BOOLEAN
Optional TRUE, if the specified object can be operated in Runtime.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)
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SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

Group (Page 5055)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

UserArchiveControl (Page 5167)

Enabled 

Description
Determines whether the given object can be operated in runtime. 
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Access during runtime: Read and Write

Syntax
Object.Enabled [= BOOLEAN]

Object
Required. An object of the type "ScreenItem" with the characteristic "IOField", 
"SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", "RecipeView", "StatusForce", 
"Slider", "SymbolLibrary", "TrendView", "MessageView", "UserView" or "BrowserView".

BOOLEAN
Optional. TRUE, if the given object can be operated.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

TrendView (Page 5155)

SmartClientView (Page 5123)

StatusForce (Page 5125)

BatteryView (Page 5001)

RangeLabelView (Page 5103)

RangeQualityView (Page 5105)

WLanQualityView (Page 5179)

ZoneLabelView (Page 5180)

ZoneQualityView (Page 5181)

SystemDiagnoseWindow (Page 5140)

SystemDiagnoseView (Page 5137)

UserView  (Page 5174)

DateTimeField (Page 5023)

EnableEdit

Description
Enables editing of the data displayed during runtime.

Access in Runtime: Read and write
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Syntax
Object.EnableEdit[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl", 
"UserArchiveControl".

BOOLEAN
TRUE: The data can be changed in Runtime.

FALSE: The data cannot be changed.

See also
UserArchiveControl (Page 5167)

OnlineTableControl (Page 5075)

EndAngle

Description
Specifies the angle at which the end point of the selected object deviates from the zero position 
(0°). 

Access in Runtime: Read and write

Syntax
Object.EndAngle[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value or a constant that specifies the angle at which the end point of the selected 
object deviates from the zero position (0°).

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

TubeArcObject (Page 5158)
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EndPoint

Description
Specifies the position of the end point. 

Access in Runtime: 

Syntax
Object.EndPoint[=Point]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Point
Optional A value that specifies the position of the end point.

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

EndPointLeft

Description
Specifies the horizontal distance in pixels of the end point from the left edge of the screen. 

Access in Runtime: Read and write

Syntax
Object.EndPointLeft[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the horizontal distance in pixels of the end point from the left 
edge of the screen.
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See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

EndPointTop

Description
Specifies the vertical distance in pixels of the end point from the upper edge of the screen. 

Access in Runtime: Read and write

Syntax
Object.EndPointTop[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".

Int
Optional A value that specifies the vertical distance in pixels of the end point from the upper 
edge of the screen.

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

EndStyle

Description
Specifies how the line-end shapes of the selected object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.EndStyle[= THmiLineEndStyle]
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Object
Required A "ScreenItem" object with the formats "Line", "Polyline" or "Connector".

THmiLineEndStyle
Optional A value or a constant that specifies the line-end shapes.

hmiLineEndStyleNone (0): The line has no end symbol.

hmiLineEndStyleFilledArrow (2): The line ends with a filled arrowhead.

See also
Line (Page 5063)

Polyline (Page 5098)

Connector (Page 5020)

EndStyle

Description
Determines how the line end of the given object is displayed. 

Access during runtime: Read and Write

Syntax
Object.EndStyle [= THmiLineEndStyle]

Object
Required. An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".

THmiLineEndStyle
Optional. A value or constant which determines the line end.

hmiLineEndStyleNone (0): The line has no end symbol.

hmiLineEndStyleFilledArrow (2): The line ends with a filled arrow.

EndTime(i) 

Description
Specifies the end time of the time range to be shown in the trend view. The property 
"TagProviderType(i)" must have the value -1. 

Access in Runtime: Read and write
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Syntax
Object.EndTime(i)[=Time]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTabelControl".

Time
Optional A value or a constant that specifies the end time of the time range that is to be shown 
in the trend window.

Comments
The parameter i indicates the number of the trend. 

If "EndTime(i)" is changed, illegal combinations with different attributes for the data connection 
could arise. This means you have to prevent an immediate acceptance of the change with 
"FreezeProviderConnections" before changing "EndTime(i)".

See also
FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

ErrorDescription

Description
Returns one of the following error descriptions in English:

 Output Description
" " OK
"Operation Failed" Execution error
"Variable not found" Tag error
"Server down" Server not available.
"An error occured for one or several tags" Multi Tag Error (Error in one or several tags) 

To obtain an error description, first of all carry out the Read method. 
 

 Note

If the error occurs when accessing via the TagSet object, evaluate the ErrorDescription 
property for each tag of the TagSet object. 

 

Access in Runtime: Read
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Syntax
Object.ErrorDescription

Object
Required A "Tag" object. 

Example
The following example shows the error description for the "Tag1" tag:

 
'VBS72
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objtag.Read
MsgBox objTag.ErrorDescription

 

The following example adds two tags to the TagSet list and outputs the ErrorDescription 
property as Trace:

 
'VBS179
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
HMIRuntime.Trace "ErrorDescription: " & group.ErrorDescription & vbNewLine

The ErrorDescription property of a tag contained in the list may be accessed as follows:

 
HMIRuntime.Trace "ErrorDescription: " & group("Motor1").ErrorDescription & vbNewLine

See also
Tag (Page 4975)

TagSet (list)  (Page 4979)

Exponent

Description
TRUE, when the display of numbers should be with exponents (e.g."1.00e+000"). BOOLEAN 
write-read access.
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ExportDirectoryChangeable

Description
Enables changing of the directory for data export in Runtime.     

Syntax
Object.ExportDirectoryChangeable=[Boolean]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE, the directory for the data export can be changed in Runtime.

FALSE, the directory for the data export cannot be changed in Runtime.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportDirectoryname

Description
Defines the directory to which the exported Runtime data is written.     

Access in Runtime: Read and write

Syntax
Object.ExportDirectoryname[=String]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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String
Optional A value or a constant which specifies the directory.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportFileExtension

Description
Specifies the file extension of the export file. Only the file extension "csv" is supported.     

Syntax
Object.ExportFileExtension

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportFilename

Description
Defines the name of the file which is to receive the exported Runtime data.     
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Syntax
Object.ExportFilename

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportFilenameChangeable

Description
Enables renaming of the export file in Runtime.     

Syntax
Object.ExportFilenameChangeable=[Boolean]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE, , the file name of the export file can be changed in Runtime.

FALSE, , the file name of the export file cannot be changed in Runtime.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)
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OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportFormatGuid

Description
Default assignment of the ID number and export provider.     

Syntax
Object.ExportFormatGuid

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

 

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportFormatName

Description
Defines the export file format. Only the "csv" file format is currently available for the export.  

 

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)
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OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportParameters

Description
Specifies the parameters of the selected format by means of the properties dialog.     

Access in Runtime: Read

Syntax
Object.ExportParameters

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

 

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportSelection

Description
Specifies which runtime data of the control is exported.

Syntax
Object.ExportSelection=[Boolean]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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Boolean

Value Description Explanation
0 all All Runtime data of the control is exported.
1 Selection Selected Runtime data of the control is exported.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportShowDialog

Description
Enables the display of the export dialog during runtime.     

Access in Runtime: Read and write

Syntax
Object.ExportShowDialog [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchivControl", "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
Optional TRUE, if the dialog box is shown in Runtime.

.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)
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OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ExportXML

ExportXML
Only used internally.

The attribute can be assigned dynamic properties by means of the name ExportXML.

ExtendedOperation

Description
TRUE, when the slider regulator is set at the respective end value (minimum/maximum value). 
This is done by clicking the mouse in an area outside the current regulator setting. BOOLEAN 
write-read access.

ExtendedZoomingEnable 

Description 
Specifies whether the operator can zoom the screen in or out in runtime by turning the mouse 
wheel. 

Access during runtime: Read and write 

Syntax
Object.ExtendedZoomingEnable[=BOOLEAN]

Object
Necessary. A "Screen" object.

BOOLEAN
Optional TRUE, if the operator can zoom the screen in and out in runtime. 

Example
The following example shows how the extended zoom can be enabled for the NewPDL1 
screen:

 
'VBS155
Dim objScreen
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Set objScreen = HMIRuntime.Screens("NewPDL1")
objScreen.ExtendedZoomingEnable = 1

See also
Screen (Page 4964)

ExtraSpaceForLabelDisplay 

Description
Specifies the extra space required for the label. 

Access in Runtime: Read and write

Syntax
Object.ExtraSpaceForLabelDisplay[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value that specifies the extra space required for the label.

See also
Bar (Page 4995)

FieldLengthReadOnlySpecial 

Description
Specifies that the "field length string" field is read-only.     

Access during runtime: Read and write

Syntax
Object.FieldLengthReadOnlySpecial[=BOOLEAN]

Object
Necessary. A "ScreenItem" object with the format "IOField"".

BOOLEAN
Optional TRUE, if the "field length string" can only be read. 
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Used for the following object types:
IOField

 

See also
IOField (Page 5059)

FillColor

Description  
Defines or returns the fill pattern color for the object. 

Access during runtime: Read and write 

Syntax
Object.FillColor[=LONG]

Object
Necessary. An object of the "ScreenItem" type with the format "Line", "Polyline", "Ellipse", 
"Circle", "EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", 
"Polygon", "TextField", "IOField", "SymbolicIOField", "DateTimeField", "Button", 
"Roundbutton", "Switch", "Bar", "StatusForce", "Clock", "Gauge", "Slider", "Checkbox".

Determination of Color Value
The color is displayed in RGB format (Red, Green, Blue). Enter the appropriate decimal value 
for each of the three RGB values.

Example:

RGB(200, 150, 100)

Example
The following example defines the fill color for "ScreenWindow1" to blue:

 
'VBS73
Dim objScreen
Set objScreen = HMIRuntime.Screens("ScreenWindow1")
objScreen.FillStyle = 131075
objScreen.FillColor = RGB(0, 0, 255)

See also
Example of defining object colors (Page 4508)
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FillColorMode 

Description
Specifies the type of foreground for the selected object. 

Access in Runtime: Read and write

Syntax
Object.FillColorMode[=SymbolLibAppearance]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibAppearance
hmiSymbolLibraryAppearanceOriginal ( 0): The surface is gray.

hmiSymbolLibraryAppearanceShaded ( 1): The display is shaded.

hmiSymbolLibraryAppearanceSolid ( 2): The display is solid.

hmiSymbolLibraryAppearanceTransparent ( 3): The display is gray.

See also
SymbolLibrary (Page 5135)

Filling

Description
TRUE, when the object can be filled by closed border lines (e.g. representing the fill level of a 
tank). BOOLEAN write-read access. 
The fill level of the object is set by means of the "FillingIndex" property.

FillingIndex

Description
Defines the %age value (related to the height of the object) to which the object with closed 
border line is to be filled. 
The fill level is represented by the current background color. The unfilled background is 
transparent.
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FillPatternColor

Description
Specifies the color of the fill pattern for the selected object. 

Access in Runtime: Read and write

Syntax
Object.FillPatternColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "Rectangle", "Polygon", "TextField", "IOField", 
"SymbolicIOField", "Button", "Roundbutton", "GraphicView", "Bar", "Checkbox", 
"OptionGroup" or "WindowSlider".

Color
Optional A value or a constant that establishes the color of the fill pattern for the specified 
object.

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

GraphicView (Page 5052)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Listbox (Page 5065)

ProjectName (Page 5100)
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FillStyle

Description
Specifies the fill style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.FillStyle[= THmiLineFillStyle]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "EllipticalArc" or 
"CircularArc".

THmiLineFillStyle
Optional A value or a constant that specifies the fill style.

hmiLineFillStyleTransparent (0): transparent fill

hmiLineFillStyleSolid (1): object is filled with the specified color

Default setting: hmiLineFillStyleSolid

See also
Line (Page 5063)

Polyline (Page 5098)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

FillStyle

Description
Determines the fill style of the specified object. 

Access during runtime: Read and Write

Syntax
Object.FillStyle [= THmiLineFillStyle]

Object
Required. An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".
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THmiLineFillStyle
Optional. A value or constant which determines the fill style.

hmiLineFillStyleTransparent (0): Transparent fill

hmiLineFillStyleSolid (1): Object is filled with the specified color

Default setting: hmiLineFillStyleSolid

FillStyle2

Description
Defines or returns the fill style of the bar. 

FillstyleAlignment

Description
Specifies the alignment within the specified object.

Filter

Description
Specifies criteria in SQL syntax for the database.   

Access in Runtime: Read and write

Syntax
Object.Filter[=String]

Object
Required A "ScreenItem" object with the format "PrintMessage".

String
Optional A value or a constant which specifies the criteria in SQL syntax for the database.

FirstConnectedObjectIndex 

Description
Specifies the index number of the upper connector point. 

Access in Runtime: Read and write
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Syntax
Object.FirstConnectedObjectIndex[=Int]

Object

Required A "ScreenItem" object with the format "Connector".

Int
Int

See also
Connector (Page 5020)

FirstConnectedObjectName

Description
Specifies the object name of the object that is docked at the upper connector point. 

Access in Runtime: Read and write

Syntax
Object.FirstConnectedObjectName[=String]

Object
Required A "ScreenItem" object with the format "Connector".

String
String

See also
Connector (Page 5020)

FixedAspectRatio 

Description
Specifies whether the aspect ratio should be maintained or changed when the symbol size is 
altered. 

Access in Runtime: Read and write

Syntax
Object.FixedAspectRatio[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "SymbolLibrary".

BOOLEAN
Optional TRUE, if the aspect ratio should be maintained when the symbol size is altered.

See also
SymbolLibrary (Page 5135)

FlashBackColor

Description
TRUE, when flashing of the background is activated. BOOLEAN write-read access

FlashBorderColor

Description
TRUE, when flashing of the object lines is activated. BOOLEAN write-read access.

FlashFlashPicture

Description
TRUE, when flashing of the flash picture is activated. BOOLEAN write-read access.

FlashForeColor

Description
TRUE, when flashing of the text is activated. BOOLEAN write-read access.

FlashingColorOff 

Description
Specifies the color of the border line for the selected object for the flashing status "off". 

Access in Runtime: Read and write
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Syntax
Object.FlashingColorOff[=Color]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "off".

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

Connector (Page 5020)

RoundButton (Page 5112)
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FlashingColorOn 

Description
Specifies the color of the border line for the selected object for the flashing status "on". 

Access in Runtime: Read and write

Syntax
Object.FlashingColorOn[=Color]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

Color
Optional A value or a constant that specifies the color of the border line of the selected object 
for the flashing status "on".

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)
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OptionGroup (Page 5092)

Connector (Page 5020)

RoundButton (Page 5112)

FlashingEnable

Description
Specifies whether the border line of the selected object will flash in runtime. 

Access in Runtime: Read and write

Syntax
Object.FlashingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

BOOLEAN
Optional TRUE, if the border line of the object is flashing.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)
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GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

Connector (Page 5020)

RoundButton (Page 5112)

FlashingRate

Description
Specifies the flash rate of the border line for the selected object.   

Access in Runtime: Read and write

Syntax
Object.FlashingRate[=FlashingRate]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Switch", "GraphicIOField", "Bar", 
"Checkbox", "OptionGroup" or "Connector".

FlashingRate
hmiFlashingRateSlow ( 0): The length of the flashing rate is 1000 ms.

hmiFlashingRateMedium ( 1): The length of the flashing rate is 500 ms.

hmiFlashingRateFast ( 2): The length of the flashing rate is 250 ms.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)
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TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

Connector (Page 5020)

RoundButton (Page 5112)

FlashPicReferenced

Description 
TRUE, when the assigned flash picture is to be saved. Otherwise, only the associated object 
reference is saved. Read only access.

FlashPicture

Description  
Returns the flash picture. Read-only access.
The graphic (*.BMP or *.DIB) must be located in the "GraCS" folder of the current project so 
that it can be integrated. 
In this context, the "FlashPicReferenced" property defines whether the flash picture should be 
saved or referenced together with the object.

FlashRate

Description
Defines or returns the flash frequency. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast
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FlashRateBackColor

Description
Defines or returns the flash frequency for the object background. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashRateBorderColor

Description
Defines or returns the flash frequency for the lines of the object. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashRateFlashPic 

Description 
Defines or returns the flash frequency for the flash picture. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast

FlashRateForeColor

Description
Defines or returns the flash frequency for the object label. Value range from 0 to 2.

0 = slow

1 = medium

2 = fast
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FlashTransparentColor

Description
Specifies the color of the bitmap object of a flashing graphic that is set to "transparent". 

Access in Runtime: Read and write

Syntax
Object.FlashTransparentColor[=Color]

Object
Required A "ScreenItem" object with the format "GraphicIOField".

Color
Optional A value or a constant that specifies the color of the bitmap object of a flashing graphic 
that is set to "transparent".

See also
GraphicIOField (Page 5049)

Flip

Description
Flips the symbol on the vertical and / or horizontal center axis of the symbol. 

Access in Runtime: Read and write

Syntax
Object.Flip[=SymbolLibFlip]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibFlip
hmiSymbolLibraryFlipNone ( 0): The symbol is not flipped.

hmiSymbolLibraryFlipHorizontal ( 1): The symbol is flipped horizontally.

hmiSymbolLibraryFlipVertical ( 2): The symbol is flipped vertically.

hmiSymbolLibraryFlipBoth ( 3): The symbol is flipped horizontally and vertically.
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See also
SymbolLibrary (Page 5135)

FocusColor 

Description
Specifies that the color for the focus border of the selected object is currently active. 

Access in Runtime: Read and write

Syntax
Object.FocusColor[= Color]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button", "Switch", 
"GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView", "MessageView" or 
"AlarmView".

Color
Optional A value or a constant that specifies the frame color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

Slider (Page 5120)

AlarmControl (Page 4981)

FocusColor

Description
Determines the color for the focus frame of the given object that has the focus. 
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Access during runtime: Read and Write

Syntax
Object.FocusColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "Button", "Switch", 
"GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView" or "MessageView".

Color
Optional A value or constant which determines the frame color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

TrendView (Page 5155)

StatusForce (Page 5125)

FocusWidth

Description
Specifies the border width of the specified object if the object is currently active. 

Access in Runtime: Read and write

Syntax
Object.FocusWidth[= LONG]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button", "Switch", 
"GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView", "MessageView" or 
"AlarmView".
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LONG
Optional A value or a constant that specifies the border width in pixels. Value range from 1 to 
10.

See also
SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

Slider (Page 5120)

AlarmControl (Page 4981)

FocusWidth

Description
Determines the border width of the given object if the object has a focus. 

Access during runtime: Read and Write

Syntax
Object.FocusWidth [= LONG]

Object
Required. An object of type "ScreenItem" with the characteristic "SymbolicIOField", "Button", 
"Switch", "GraphicIOField", "RecipeView", "StatusForce", "Slider", "TrendView" or 
"MessageView".

LONG
Optional. A value or constant which determines the border width in pixels. Value range from 
1 to 10.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

TrendView (Page 5155)

StatusForce (Page 5125)

BatteryView (Page 5001)
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Font

Description
Specifies or returns the font.     

The font object has the following sub-properties 

● Size (Font Size)

● Bold (yes/no)

● Name (font name)

● Italic (yes/no)

● Underline (underline yes/no)

● StrikeThrough (yes/no)

If two font properties are directly assigned, only the default property "Name" is assumed.

Access during runtime: Read and write

Syntax
Object.Font [=Font]

Object
Necessary. An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl", "MediaPlayer", 
"FunctionTrendControl" or "Slider".

Font
Font

Example

 
'VBS74
Dim objControl1
Dim objControl2
Set objControl1 = ScreenItems("Control1")
Set objControl2 = ScreenItems("Control2")
objControl2.Font = objControl1.Font ' take over only the type of font

See also
AlarmControl (Page 4981)

ZoneLabelView (Page 5180)

ProtectedAreaName (Page 5102)

RangeLabelView (Page 5103)
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Slider (Page 5120)

SmartClientView (Page 5123)

CheckBox (Page 5008)

Button (Page 5002)

Bar (Page 4995)

Switch (Page 5127)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

Clock (Page 5018)

DateTimeField (Page 5023)

RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

RecipeView (Page 5106)

TrendView (Page 5155)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

FontBold

Description
Specifies whether the text of the selected object should be shown in bold. 

Access in Runtime: Read and write

Syntax
Object.FontBold[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" or "OptionGroup".
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BOOLEAN
Optional TRUE, if the text of the selected object should be shown in bold.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Bar (Page 4995)

CheckBox (Page 5008)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

ProjectName (Page 5100)

FontItalic

Description
Specifies whether the text of the selected object should be shown in italic. 

Access in Runtime: Read and write

Syntax
Object.FontItalic[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" or "OptionGroup".

BOOLEAN
Optional TRUE, if the text of the selected object should be shown in italic.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Bar (Page 4995)
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CheckBox (Page 5008)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

ProjectName (Page 5100)

FontName 

Description
Specifies the font of the selected object. 

Access in Runtime: Read and write

Syntax
Object.FontName[=String]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" or "OptionGroup".

String
Optional A value or a constant that specifies the font of the selected object.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Bar (Page 4995)

CheckBox (Page 5008)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

ProjectName (Page 5100)
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FontSize 

Description
Specifies the font size of the text for the selected object. 

Access in Runtime: Read and write

Syntax
Object.FontSize[=Int]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" oder "OptionGroup".

Int
Optional A value or a constant that specifies the font size of the text for the selected object.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Bar (Page 4995)

CheckBox (Page 5008)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

ProjectName (Page 5100)

FontUnderline

Description
Specifies whether the text of the selected object should be underlined. 

Access in Runtime: Read and write

Syntax
Object.FontUnderline[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Bar", "Checkbox" oder "OptionGroup".

BOOLEAN
Optional TRUE, if the text of the selected object should be shown underlined.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Bar (Page 4995)

CheckBox (Page 5008)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

ProjectName (Page 5100)

ForeColor

Description
Specifies the font color of the text for the selected object. 

Access in Runtime: Read and write

Syntax
Object.ForeColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Switch", "Bar", "RecipeView", "Slider", 
"SymbolLibrary", "MessageView", "Checkbox" or "OptionGroup".

Color
Optional A value or a constant that specifies the font color of the text for the selected object.
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See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

Bar (Page 4995)

Slider (Page 5120)

SymbolLibrary (Page 5135)

CheckBox (Page 5008)

OptionGroup (Page 5092)

Group (Page 5055)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

ForeColor

Description
Determines the text color of the given object. 

Access during runtime: Read and Write

Syntax
Object.ForeColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "Bar", "RecipeView", "Slider" or "SymbolLibrary".

Color
Optional A value or constant which determines the text color.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.
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See also
RecipeView (Page 5106)

AlarmView (Page 4992)

DateTimeField (Page 5023)

ProjectName (Page 5100)

ForeFlashColorOff

Description
Defines or returns the color of the text for flash status "Off". LONG write-read access.

ForeFlashColorOn

Description
Defines or returns the color of the text for flash status "On". LONG write-read access.

FormatPattern

Description
Specifies the format of the output value. 

Access in Runtime: Read and write

Syntax
Object.FormatPattern[=String]

Object
Required A "ScreenItem" object with the format "IOField".

String
Optional A value or a constant that specifies the format of the output value.

See also
IOField (Page 5059)
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FormatPatternReadOnlySpecial

Description
Specifies that the "format pattern" field can only be read. 

Access in Runtime: Read and write

Syntax
Object.FormatPatternReadOnlySpecial[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "format pattern" field can only be read.

See also
IOField (Page 5059)

FormatType

Description
Specifies the data type of the selected object. 

Access in Runtime: Read and write

Syntax
Object.FormatType[=IOFieldDataFormat]

Object
Required A "ScreenItem" object with the format "IOField".

IOFieldDataFormat
hmiOutputFormatString ( 2): String

hmiOutputFormatDecimal ( 1): Decimal

hmiOutputFormatHexadecimal ( 3): Hexadecimal

hmiOutputFormatBinary ( 0): Binary

hmiOutputFormatDate ( 4): Date

hmiOutputFormatTime ( 5): Time

hmiOutputFormatDateTime ( 6): Date and time
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See also
IOField (Page 5059)

Free

Description
Returns the size of the free disk space. 

Access in Runtime: Read and write

Syntax
Object.Free[=Double]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Double
Optional A value or a constant that returns the size of the free disk space.

See also
DiskSpaceView (Page 5025)

FreePercent

Description
Returns the measured values for the free disk space as a percentage. The values can be 
queried in Runtime. The values cannot be predefined. 

Access in Runtime: Read and write

Syntax
Object.FreePercent[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that returns the measured values for the free disk space as a 
percentage. 
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See also
DiskSpaceView (Page 5025)

FreezeProviderConnections

Description
Specifies whether the properties for the data connection ("TagProviderType(i)", "Source.."...) 
can be changed without the change becoming effective immediately. If you change from, for 
example, "XDataLogTag(i)" illegal combinations with "YDataLogTag(i)" could arise. 

This means attributes must have the value TRUE before changing the data connection 
"FreezeProviderConnections". After changing all the properties for the data connection, 
"FreezeProviderConnection" will be set to FALSE and the changes will become effective. 

Access in Runtime: Read and write

Syntax
Object.FreezeProviderConnections[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the properties for the data connection ("TagProviderType(i)", "Source.."...) 
can be changed without the change becoming effective immediately. 

See also
FunctionTrendControl (Page 5038)

Properties G-H

GetSelectionText

Description
Returns the selected text of the "MultiLineEdit" object.   

Gradation

Description
Specifies the value difference between two main marking lengths of the "Gauge" object. 
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Access in Runtime: Read and write

Syntax
Object.Gradation[= LONG]

Object
Required A "ScreenItem" object with the format "Gauge".

LONG
Optional A value or a constant that specifies the value difference.

See also
Gauge (Page 5046)

GraphDirection

Description
Specifies at which border of the trend view the current values are displayed.     

Access in Runtime: Read and write

Syntax
Object.GraphDirection[=Direction]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Direction
0: Positive values run to the right and upwards.

-1: Positive values run to the left and upwards.

-2: Positive values run to the right and upwards.

-3: Positive values run to the right and downwards.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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GridBackColor 

Description
Specifies the background color for the recipe view in Runtime.   

Access in Runtime: Read and write

Syntax
Object.GridBackColor[=Color]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

Color
Optional A value or a constant that specifies the background color in the recipe view in Runtime.

GridForeColor 

Description
Defines the font color for the recipe view. 

Access in Runtime: Read and write

Syntax
Object.GridForeColor[=Color]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

Color
Optional A value or a constant that specifies the font color for the recipe view.

GridLineColor

Description
Specifies the color for the grid lines. 

Access in Runtime: Read and write

Syntax
Object.GridlineColor[=Color]
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Object
Required A "ScreenItem" object with the format "AlarmControl".

Color
Optional A value or a constant that specifies the color of the grid lines.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

GridLineColor

Color of the row divider / content - GridLineColor
Defines the color of row/column dividers in table contents. The button opens the "Color 
selection" dialog. 

The attribute can be assigned dynamic properties by means of the name GridLineColor.

See also
AlarmView (Page 4992)

GridLineWidth

Description
Defines the line weight of the row/column dividers in pixels.   

Access in Runtime: Read and write

Syntax
Object.GridLineWidth[=Width]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Width
Optional A value or a constant which specifies the width of the grid line.
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See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

Height

Description
Specifies the height of the selected objects "Ellipse", "Circle" and "Rectangle".     

Access during runtime: Read and write

The other objects only have read access to the property.

Syntax
Object.Height[= LONG]

Object
Necessary. A "Screen" object or an object of type "ScreenItem". This property is a standard 
property of the ScreenItem-Objekts and is therefore available for all formats.

LONG
Optional A value or a constant that specifies the height in pixels. This parameter can be set 
only for the objects "Ellipse", "Circle" and "Rectangle". 

Example
The following example halves the height of all objects of the image "NewPDL1", whose name 
starts with "Circle":

 
'VBS75
Dim objScreen
Dim objCircle
Dim lngIndex
Dim strName
lngIndex = 1
Set objScreen = HMIRuntime.Screens("NewPDL1")
For lngIndex = 1 To objScreen.ScreenItems.Count
'
'Searching all circles
strName = objScreen.ScreenItems.Item(lngIndex).ObjectName
If "Circle" = Left(strName, 6) Then
'
'to halve the height of the circles
Set objCircle = objScreen.ScreenItems(strName)
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objCircle.Height = objCircle.Height / 2
End If
Next

 

 

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)
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OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

ForeignControl (Page 5034)

ProtectedAreaName (Page 5102)

UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

DateTimeField (Page 5023)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

AlarmView (Page 4992)

BatteryView (Page 5001)

RangeLabelView (Page 5103)

ZoneQualityView (Page 5181)

ZoneLabelView (Page 5180)

WLanQualityView (Page 5179)

TrendView (Page 5155)

SystemDiagnoseWindow (Page 5140)

SystemDiagnoseView (Page 5137)

StatusForce (Page 5125)

SmartClientView (Page 5123)

RecipeView (Page 5106)

RangeQualityView (Page 5105)
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HelpText

Description
Returns the tooltip that is shown in Runtime as an operating aid for the specified object.   

Access in Runtime: Read

Syntax
Object.HelpText

Object
Required An object of the "ScreenItem" type with the format "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "GraphicIOField" or "OnlineTrendControl".

See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

HelpText

Description
Returns the tooltip that is shown in Runtime as an operating aid for the specified object. 

Access in Runtime: Read

Syntax
Object.HelpText

Object
Required An object of the type "ScreenItem" with the characteristic "IOField", 
"SymbolicIOField", "Button", "Switch", "GraphicIOField" or "TrendView".

See also
TrendView (Page 5155)

DateTimeField (Page 5023)
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HiddenInput

Description
Specifies whether the input value or a * for each character will be shown during the input. 

Access in Runtime: Read and write

Syntax
Object.HiddenInput[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the input value is not shown during the input. An * is shown for each character.

See also
IOField (Page 5059)

HideTagNames

Description
Specifies whether the tag name is shown in the f/t() trend view.   

Access in Runtime: Read and write

Syntax
Object.HideTagNames[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if the tag names are displayed.

See also
OnlineTrendControl (Page 5083)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5363



HighLimitColor 

Description
Specifies the color of the top or right scroll button in a scroll bar. 

Access in Runtime: Read and write

Syntax
Object.HighLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color of the top or right scroll button in a scroll 
bar.

See also
WindowSlider (Page 5176)

HitlistColumnAdd

Description
Transfers the selected message block from the list of available message blocks to the list of 
selected message blocks.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnAdd

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)
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HitlistColumnCount

Description
Specifies the number of message blocks displayed in the hitlist in Runtime.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnCount 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

HitlistColumnIndex

Description
References a message block selected for the hitlist. Using this attribute you can assign the 
values of other attributes to a specific message block of the hitlist.

Values between 0 and "HitlistColumnCount" minus 1 are valid for "HitlistColumnIndex". 
Attribute "HitlistColumnCount" defines the number of message blocks selected for the hitlist. 
The "HitlistColumnIndex" attribute can be assigned dynamic properties by means of attribute 
HitlistColumnRepos.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnIndex

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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HitlistColumnName

Description
Displays the name of the message block of the hitlist which is referenced with attribute 
"HitlistColumnIndex". You cannot edit this name.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnName

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 4981)

HitlistColumnRemove

Description
Removes the marked message block from the list of selected message blocks and inserts it 
in the list of existing message blocks.    

Access in Runtime: Read and write

Syntax
Object.HitlistColumnRemove [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 4981)

HitlistColumnRepos

Description
Resorts the message blocks. The "Up" and "Down" commands move the selected message 
block accordingly in the list. This moves the message block in Runtime Control towards the 
front or towards the back.     
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Access in Runtime: Read and write

Syntax
For hitlist: Object.HitlistColumnRepos For message list: Object.MessageColumnRepos

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 4981)

HitlistColumnSort

Description
Defines the sorting order of the message block referenced in "HitlistColumnIndex" in the hitlist.   

Access in Runtime: Read and write

Syntax
Object.HitlistColumnSort [=Sort]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

Sort
0: No sorting.

1: Ascending sorting from the lowest to highest value

2 Descending sorting from the highest to lowest value

See also
AlarmControl (Page 4981)

HitlistColumnSortIndex

Description
Defines the sorting order of the message block referenced in "HitlistColumnIndex" in the hitlist. 
The sorting criterion is removed from "HitlistColumnSort" if you set a "0" value..   

Access in Runtime: Read and write
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Syntax
Object.HitlistColumnSortIndex

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 4981)

HitlistColumnVisible

Description
The selected message blocks of the message list or hitlist which are used in Runtime in the 
control are displayed in the list.     

Access in Runtime: Read and write

Syntax
For hitlist: Object.HitlistColumnVisible For message list: Object.MessageColumnVisible

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

See also
AlarmControl (Page 4981)

HitlistDefaultSort

Description
Defines the default sorting order in the table columns of the hitlist.   

Access in Runtime: Read and write

Syntax
Object.HitlistDefaultSort[=Sort]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".
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Sort
0: The list is sorted in ascending order of frequency.

1:: The list is sorted in descending order of frequency.

See also
AlarmControl (Page 4981)

HitlistMaxSourceItems

Description
Specifies the maximum number of data records that can be used from the alarm log to create 
the hit list. The value can be anything between "0 - 10000". 

Access in Runtime: Read and write

Syntax
Object.HitlistMaxSourceItems[=Long]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Long
Optional A value or a constant that specifies the maximum number of data records that can 
be used from the alarm log to create the hit list. 

See also
AlarmControl (Page 4981)

HitlistMaxSourceItemsWarning

Description
Specifies whether a warning should be given if the maximum number of data records that is 
defined in "HitlistMaxSourceItems" is reached. 

Access in Runtime: Read and write

Syntax
Object.HitlistMaxSourceItemsWarning[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if a warning is given as soon as the maximum number of data records that is 
defined in "HitlistMaxSourceItems" is reached.

See also
AlarmControl (Page 4981)

HitlistRelativeTimeFactor

Description
Specifies the time factor which, alongside the time type "HitlistRelativeTimeFactorType", 
determines the time period in which the statistics of the hit list will be created. 

If you do not wish to specify a period of time, set the time factor to "0".

Access in Runtime: Read and write

Syntax
Object.HitlistRelativeTimeFactor[=Long]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Long
Optional A value or a constant that specifies the time factor.

See also
AlarmControl (Page 4981)

HitlistRelativeTimeFactorType 

Description
Specifies the time type which, alongside the time factor "HitlistRelativeTimeFactor", 
determines the time period in which the statistics of the hit list will be created. 

Access in Runtime: Read and write
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Syntax
Object.HitlistRelativeTimeFactorType[=AlarmViewAdvancedTimeFactorUnit]

Object
Required A "ScreenItem" object with the format "AlarmControl".

AlarmViewAdvancedTimeFactorUnit
hmiAlarmViewAdvancedTimeFactorUnitMinute ( 0): The time range for the statistics will be 
measured in minutes.

hmiAlarmViewAdvancedTimeFactorUnitHour ( 1): The time range for the statistics will be 
measured in hours.

hmiAlarmViewAdvancedFactorUnitDay ( 2): The time range for the statistics will be measured 
in days.

hmiAlarmViewAdvancedTimeFactorUnitWeek ( 3): The time range for the statistics will be 
measured in weeks.

hmiAlarmViewAdvancedTimeFactorUnitMonth ( 4): The time range for the statistics will be 
measured in months.

See also
AlarmControl (Page 4981)

HitListRelTime

Description
Sets a time range for the statistics.   

If you do not wish to specify a period of time, set the time factor to "0".

Access in Runtime: Read and write

Syntax
Object.HitListRelTime[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: If no time range is specified in the selection, the specified time range is used for the 
statistics.

FALSE: The specified time range is not used.
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See also
AlarmControl (Page 4981)

HorizontalAlignment 

Description
Specifies the horizontal alignment of the text within the specified object. 

Access in Runtime: Read and write

Syntax
Object.HorizontalAlignment[= THmiHorizontalAlignment]

Object
Required A "ScreenItem" object with the formats "TextField", "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "CheckBox", "OptionGroup", "PageNumber", 
"ProjectName", "ReportName", "OdbcDatabaseField".

THmiHorizontalAlignment
Optional A value or a constant that specifies the horizontal alignment of the text.

hmiAlignmentLeft (0):The text is arranged flush left in the object.

hmiAlignmentCentered (1): The text is arranged horizontally centered in the object.

hmiAlignmentRight (2): The text is arranged flush right in the object.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

CheckBox (Page 5008)

OptionGroup (Page 5092)

AlarmControl (Page 4981)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)
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HorizontalAlignment 

Description
Determines the horizontal alignment of the text within the given object. 

Access during runtime: Read and Write

Syntax
Object.HorizontalAlignment [= THmiHorizontalAlignment]

Object
Required An object of the "ScreenItem" type with the characteristics "TextField", "IOField", 
"SymbolicIOField", "Button" or "Switch".

THmiHorizontalAlignment
Optional A value or constant which determines the horizontal alignment of the text.

hmiAlignmentLeft (0): The text is aligned left justified in the object.

hmiAlignmentCentered (1): The text is centered horizontally in the object.

hmiAlignmentRight (2): The text is aligned right justified in the object.

See also
DateTimeField (Page 5023)

ProjectName (Page 5100)

HorizontalGridLines

Description
Defines whether horizontal separating lines will be displayed.   

Access in Runtime: Read and write

Syntax
Object.HorizontalGridLines[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: Horizontal grid lines are displayed.

FALSE: Horizontal grid lines are not displayed.
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See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

HorizontalScrollbarPosition

Description
Specifies the horizontal positioning of the scroll bar in a picture window with slider, or returns 
its value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

See also
ScreenWindow (Page 5116)

Hotkey property 

Description
Returns the function key related to the mouse operation in respect of a button object.

Read only access.

See also
Button (Page 5002)

HourNeedleHeight

Description
Specifies the length of the hour hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.HourNeedleHeight[= LONG]
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Object
Required A "ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the length of the hour hand.

Specify the length of the hour hand as a percentage relating to the radius of the clock face.

See also
Clock (Page 5018)

HourNeedleWidth 

Description
Specifies the width of the hour hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.HourNeedleWidth[= LONG]

Object
Required A "ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the width of the hour hand.

Specify the width of the hour hand as a percentage relating to double the length of the clock 
face.

See also
Clock (Page 5018)

Hysteresis property 

Description
TRUE, when the display should appear with hysteresis. BOOLEAN write-read access.
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HysteresisRange

Description
Defines the hysteresis in % of the displayed value or returns it.
The Hysteresis property must be set to TRUE for the hysteresis to be calculated. 

Properties I-J

IconSpace

Description
Defines the spacing between the icons and text in the table cells. The value is active if and 
icon and text are displayed.   

Access in Runtime: Read and write

Syntax
Object.IconSpace[=Space]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

Space
Optional Value which specifies the spacing.

 

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

Index

Description
Specifies the index for the selected text field. 

Access in Runtime: Read and write

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5376 System Manual, 02/2014



Syntax
Object.Index[=Int]

Object
Required A "ScreenItem" object with the formats "Checkbox" or "OptionGroup".

Int
Optional A value or a constant that specifies the index of the selected text field.

See also
OptionGroup (Page 5092)

Listbox (Page 5065)

InnerBackColorOff 

Description
Specifies the color under the slider of the "Switch" object if the object is in OFF status. 

Access during runtime: Read and Write

Syntax
Object.InnerBackColorOff[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Switch".

Color
Optional A value or a constant that specifies the color for the OFF status.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Switch (Page 5127)
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InnerBackColorOn

Description
Specifies the color under the slider of the "Switch" object if the object is in ON status. 

Access during runtime: Read and Write

Syntax
Object.InnerBackColorOn[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Switch".

Color
Optional A value or a constant that specifies the color for the ON status.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Switch (Page 5127)

InputValue

Description  
Defines the value to be entered by the user in the I/O field. The value is not displayed in the I/
O field when the property is set.

If you want the value to be displayed in the I/O field after confirmation with the <Return> key, 
configure a direct connection between the properties "input value" and "output value". The 
direct connection is only practical when no tag is connected to the output value, but the user 
can nevertheless query the specified value, for example, through a script.

LONG write-read access. 

See also
SymbolicIOField (Page 5130)

IOField (Page 5059)
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InsertData(i)

Description
Specifies which data will be inserted for the active trend.   

Access in Runtime: Read and write

Syntax
Object.InsertData(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControi".

BOOLEAN
Optional TRUE, if "DataIndex(i)" is ignored and the data added to the rear of the data buffer. 

FALSE, if the data is inserted at the position "DataIndex(i)" of the data buffer. 

Comments
The trend view is redrawn in every operation with "InsertData(i)".

See also
FunctionTrendControl (Page 5038)

InsertEnable

Description
Specifies whether an entry can be made in the recipe view in Runtime.   

Access in Runtime: Read and write

Syntax
Object.InsertEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if an entry can be made in the recipe view in Runtime.
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Instance

Description
Returns an instance of the alarm object.

IntegerDigits

Description
Establishes the number of integer digits (0 to 20). 

Access in Runtime: Read and write

Syntax
Object.IntegerDigits[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the number of integer digits (0 to 20).

See also
Bar (Page 4995)

Interval

Description
Specifies the time interval for updating the displayed measured value. You enter the value in 
minutes. 

Access in Runtime: Read and write

Syntax
Object.Interval[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that specifies the time interval for updating the measured values. 
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See also
DiskSpaceView (Page 5025)

ItemBorderBackColor

Description
Defines or returns the background color for dividing lines in the selection list of the text list 
object. LONG write-read access. The background color is only visible with the property setting 
ItemBorderStyle > 0. 

ItemBorderColor

Description
Defines or returns the color for deviding lines in the selection list of the text list object. LONG 
write-read access.

ItemBorderStyle

Description
Specifies the line style of the separation lines in the selection list of the selected object.   

Access in Runtime: Read and write

Syntax
Object.ItemBorderStyle[=LineStyle]

 

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

LineStyle
hmiLineStyleNone (-1): The selection list has no separation lines.

hmiLineStyleSolid ( 0): The selection list has solid separation lines.

hmiLineStyleDash ( 1): The selection list has broken separation lines.

hmiLineStyleDot ( 2): The selection list has dotted separation lines.

hmiLineStyleDashDot ( 3): The selection list has dash - dot lines as separation lines.

hmiLineStyleDashDotDot ( 4): The selection list has dash - dot - dot lines as separation lines.
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See also
SymbolicIOField (Page 5130)

ItemBorderWidth

Description
Defines or returns the dividing line weight in pixels in the selection list of the text list object.

JumpToLimitsAfterMouseClick

Description
Specifies whether the slider will be set to the associated end value. The end value is the 
minimum or maximum value. To set the slider to the end value, users click on the area outside 
of the current slider setting. 

Access in Runtime: Read and write

Syntax
Object.JumpToLimitsAfterMouseClick[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "WindowSlider".

BOOLEAN
Optional TRUE, if the slider will be set to the associated end value.

See also
WindowSlider (Page 5176)

Properties K-L

LabelColor

Description
Specifies the color of the scale label in the "Slider" object. 

Access in Runtime: Read and write
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Syntax
Object.LabelColor[= Color]

Object
Required A "ScreenItem" object with the format "Slider".

Color
Optional A value or a constant that specifies the color of the scale label.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Slider (Page 5120)

Language

Description
Determines the current Runtime language. 

Access in Runtime: Read and write

Syntax
Object.Language[= LONG]

Object
Required A "HMIRuntime" object.

LONG
Optional A value or a constant that specifies the national code.

Comments
Specify the Runtime language in VBS with a national code, e.g. 1031 for German, 2057 for 
English etc.. Refer to the VBScript basics under the topic "Current local ID (LCID) diagram" 
for an overview of all the national codes.
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See also
HMIRuntime  (Page 4956)

Example of configuring a language switch (Page 4509)

LanguageSwitch

Description
Returns the value which defines where the language dependent assigned texts are stored. 
Read only access.

TRUE, if the texts are managed in the project texts editor. Translations into other languages 
are made in the project texts editor.

FALSE, when the texts are managed directly in the object. Translations into other languages 
can be made by means of the export/import function.

LargeTicksBold

Description
Specifies whether the long marking lengths of a scale are shown in bold. 

Access in Runtime: Read and write

Syntax
Object.LargeTicksBold[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".

BOOLEAN
Optional. TRUE, if the long marking lengths of a scale are shown in bold.

See also
Bar (Page 4995)

LargeTicksSize

Description
Specifies the length of the long marking lengths of a scale. 

Access in Runtime: Read and write
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Syntax
Object.LargeTicksSize[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the length of the long marking lengths of a scale.

See also
Bar (Page 4995)

LastConnectedObjectIndex

Description
Specifies the index number of the connection point for the last, connected object. 

Access in Runtime: Read and write

Syntax
Object.LastConnectedObjectIndex[=Int]

Object
Required A "ScreenItem" object with the format "Connector".

Int
Int

See also
Connector (Page 5020)

LastConnectedObjectName

Description
Specifies the object name of the object that is docked at the lower connector point. 

Access in Runtime: Read and write

Syntax
Object.LastConnectedObjectName[=String]
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Object
Required A "ScreenItem" object with the format "Connector".

String
String

See also
Connector (Page 5020)

LastError

Description
Returns an error code regarding the success of the last operation, e.g. information on a tag 
write or read process:

 Code in hexadecimal notation Description
0x00000000 OK
0x80040001 Execution error
0x80040002 Tag error
0x80040003 Server not available.
0x80040004 Multi Tag Error; error in one or several tags

To obtain an error description, first of all carry out the Read method. 
 

 Note

If the error occurs when accessing via the TagSet object, evaluate the LastError property for 
each tag of the TagSet object.

 

To obtain a statement about the quality of the supplied value, use the "QualityCode" property. 
To obtain a description of the error, use the "ErrorDescription" property. 

Access during runtime: Read

Syntax
Object.LastError

Object
Necessary. A "Tag" object.
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Example
The following example shows the error code for the "Tag1" tag: 

 
'VBS77
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
MsgBox objTag.LastError

The following example adds two tags to the TagSet list and outputs the LastError property as 
Trace:

 
'VBS178
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
HMIRuntime.Trace "LastError: " & group.LastError & vbNewLine

The LastError property of a tag contained in the list may be accessed as follows:

 
HMIRuntime.Trace "LastError: " & group("Motor1").LastError & vbNewLine

See also
Tag (Page 4975)

TagSet (list)  (Page 4979)

Layer

Description 
Returns the layer that contains an object as LONG in the screen. There is a total of 32 layers 
available, whereby Layer "0" is the bottom layer and Layer "31" the top layer.

The configured objects are initially in the background of a layer.

Access during runtime: Read

Syntax
Object.Layer
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Object
Necessary. A "ScreenItem" object.

 

 Note

The Layer property specifies the layer in which the object is located. The layer "0" is output 
as layer "0".

When accessed, the layers are counted up from 1 in VBS. Therefore, address the level "1" 
with layers(2).

 

Example
The following example displays the name and layer of all objects in the screen "NewPDL1":

 
'VBS78
Dim objScreen
Dim objScrItem
Dim lngAnswer
Dim lngIndex
Dim strName
lngIndex = 1
Set objScreen = HMIRuntime.Screens("NewPDL1")
For lngIndex = 1 To objScreen.ScreenItems.Count
strName = objScreen.ScreenItems.Item(lngIndex).ObjectName
Set objScrItem = objScreen.ScreenItems(strName)
lngAnswer = MsgBox(strName & " is in layer  " & objScrItem.Layer,vbOKCancel)
If vbCancel = lngAnswer Then Exit For
Next

See also
ScreenItem (Page 4966)

HTMLBrowser (Page 5057)

Group (Page 5055)

ForeignControl (Page 5034)

DateTimeField (Page 5023)

ZoneQualityView (Page 5181)

ZoneLabelView (Page 5180)

WLanQualityView (Page 5179)

ProtectedAreaName (Page 5102)

RangeLabelView (Page 5103)

RangeQualityView (Page 5105)

ScreenWindow (Page 5116)
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ScriptDiagnostics (Page 5118)

Slider (Page 5120)

SmartClientView (Page 5123)

StatusForce (Page 5125)

SymbolLibrary (Page 5135)

BatteryView (Page 5001)

ChannelDiagnose (Page 5006)

CheckBox (Page 5008)

GraphicIOField (Page 5049)

Button (Page 5002)

Bar (Page 4995)

WindowSlider (Page 5176)

UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

Switch (Page 5127)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Line (Page 5063)

Listbox (Page 5065)

AlarmView (Page 4992)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

DiskSpaceView (Page 5025)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicView (Page 5052)
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Polygon (Page 5095)

Polyline (Page 5098)

RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

RecipeView (Page 5106)

TrendView (Page 5155)

UserArchiveControl (Page 5167)

SystemDiagnoseWindow (Page 5140)

SystemDiagnoseView (Page 5137)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

Layer00Checked

Description
TRUE, when limit 0 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer00Value and Layer00Color 
properties. 

Layer00Color

Description
Defines or returns the color for limit 0. LONG write/read access.
When monitoring of the limit value is activated (Layer00Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.
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Layer00Value

Description
Determines the value for "Limit 0" or returns it.
Monitoring only takes effect when the Layer00Checked property value is set to TRUE.

Layer01Checked

Description
TRUE, when limit 1 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer01Value and Layer01Color 
properties. 

Layer01Color

Description
Defines or returns the color for limit 1. LONG write/read access.
When monitoring of the limit value is activated (Layer01Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer01Value

Description
Determines the value for "Limit 1" or returns it.
Monitoring only takes effect when the Layer01Checked property value is set to TRUE.

Layer02Checked

Description
TRUE, when limit 2 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer02Value and Layer02Color 
properties. 
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Layer02Color

Description
Defines or returns the color for limit 2. LONG write/read access.
When monitoring of the limit value is activated (Layer02Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer02Value

Description
Determines the value for "Limit 2" or returns it.
Monitoring only takes effect when the Layer02Checked property value is set to TRUE.

Layer03Checked

Description
TRUE, when limit 3 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer03Value and Layer03Color 
properties. 

Layer03Color

Description
Defines or returns the color for limit 3. LONG write/read access.
When monitoring of the limit value is activated (Layer03Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer03Value

Description
Determines the value for "Limit 3" or returns it.
Monitoring only takes effect when the Layer03Checked property value is set to TRUE.
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Layer04Checked

Description
TRUE, when limit 4 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer04Value and Layer04Color 
properties. 

Layer04Color

Description
Defines or returns the color for limit 4. LONG write/read access.
When monitoring of the limit value is activated (Layer04Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer04Value

Description
Determines the value for "Limit 4" or returns it.
Monitoring only takes effect when the Layer04Checked property value is set to TRUE.

Layer05Checked

Description
TRUE, when limit 5 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer05Value and Layer05Color 
properties. 

Layer05Color

Description
Defines or returns the color for limit 5. LONG write/read access.
When monitoring of the limit value is activated (Layer05Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.
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Layer05Value

Description
Determines the value for "Limit 5" or returns it.
Monitoring only takes effect when the Layer05Checked property value is set to TRUE.

Layer06Checked

Description
TRUE, when limit 6 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer06Value and Layer06Color 
properties. 

Layer06Color

Description
Defines or returns the color for limit 6. LONG write/read access.
When monitoring of the limit value is activated (Layer06Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer06Value 

Description
Determines the value for "Limit 6" or returns it.
Monitoring only takes effect when the Layer06Checked property value is set to TRUE.

Layer07Checked

Description
TRUE, when limit 7 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer07Value and Layer07Color 
properties. 
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Layer07Color

Description
Defines or returns the color for limit 7. LONG write/read access.
When monitoring of the limit value is activated (Layer07Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer07Value

Description
Determines the value for "Limit 7" or returns it.
Monitoring only takes effect when the Layer07Checked property value is set to TRUE.

Layer08Checked

Description
TRUE, when limit 8 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer08Value and Layer08Color 
properties. 

Layer08Color

Description
Defines or returns the color for limit 8. LONG write/read access.
When monitoring of the limit value is activated (Layer08Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer08Value

Description
Determines the value for "Limit 8" or returns it.
Monitoring only takes effect when the Layer08Checked property value is set to TRUE.
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Layer09Checked property

Description
TRUE, when limit 9 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer09Value and Layer09Color 
properties. 

Layer09Color

Description
Defines or returns the color for limit 9. LONG write/read access.
When monitoring of the limit value is activated (Layer09Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.

Layer09Value

Description
Determines the value for "Limit 9" or returns it.
Monitoring only takes effect when the Layer09Checked property value is set to TRUE.

Layer10Checked

Description
TRUE, when limit 10 should be monitored. BOOLEAN write/read access.
Limit value and representation are defined with the Layer10Value and Layer10Color 
properties. 

Layer10Color

Description
Defines or returns the color for limit 10. LONG write/read access.
When monitoring of the limit value is activated (Layer10Checked property), the bar turns to 
the color defined by this attribute on reaching the limit value.
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Layer10Value

Description
Determines the value for "Limit 10" or returns it.
Monitoring only takes effect when the Layer10Checked property value is set to TRUE.

LayerDeclutteringEnable

Description 
Indicates whether the layers of a screen can be shown or hidden dependent on the set 
minimum and maximum zoom. 

Access during runtime: Read

Syntax
Object.LayerDeclutteringEnable

Object
Necessary. A "Screen" object. 

Example:
The example outputs the LayerDecluttering property of the "NewPDL1" screen as Trace.

 
'VBS156
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 4964)

Layers

Description
Returns an object of type "Layers".

Access in Runtime: Read
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Syntax
Object.Layers

Object
Required A "Screen" object.

See also
Screen (Page 4964)

LeaveMarginForBorder

Description
Specifies whether an additional margin will be left for borders. 

Access in Runtime: Read and write

Syntax
Object.LeaveMarginForBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if an additional margin is enabled for borders.

See also
Bar (Page 4995)

LeaveMarginForMarkers

Description
Specifies whether an additional margin will be left for markers. 

Access in Runtime: Read and write

Syntax
Object.LeaveMarginForMarkers[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if an additional margin is enabled for markers.

See also
Bar (Page 4995)

Left 

Description
Specifies the value of the X coordinate of the selected object.     

Access during runtime: Read and write

Syntax
Object.Left[= DOUBLE]

Object
Necessary. A "ScreenItem" object. This property is a standard property of the ScreenItem-
Objekts and is therefore available for all formats.

DOUBLE
Optional A value or a constant that contains the value of the X coordinate in pixels (measured 
from the top left edge of the screen).

Comments
The X coordinate refers to the top left corner of the rectangle that surrounds the object. The 
screen limits are also monitored in runtime. If the assigned coordinate value exceeds the 
display size, the user-defined function is interrupted with an error message. 

Used for the following object types:
IOField

Rectangle

Slider

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)
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CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

ForeignControl (Page 5034)

DateTimeField (Page 5023)

ProtectedAreaName (Page 5102)

UserView  (Page 5174)
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TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

AlarmView (Page 4992)

BatteryView (Page 5001)

RangeLabelView (Page 5103)

RangeQualityView (Page 5105)

RecipeView (Page 5106)

SmartClientView (Page 5123)

StatusForce (Page 5125)

SystemDiagnoseView (Page 5137)

SystemDiagnoseWindow (Page 5140)

TrendView (Page 5155)

WLanQualityView (Page 5179)

ZoneLabelView (Page 5180)

ZoneQualityView (Page 5181)

LeftComma property

Description
Defines or returns the number of digits to the left of the decimal point (0 to 20). 

LeftOffset

Description 
Defines or returns the distance of the picture from the left edge of the picture window. 

The picture is displayed as a cutout of the picture window. The picture scroll bars are located 
at the left and upper edge of the picture. If you wish to display the picture in the picture window 
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by using the horizontal and vertical positioning of the picture scroll bars, use the properties 
"HorizontalScrollBarPosition" and "VerticalScrollBarPosition" for such positioning.

See also
ScreenWindow (Page 5116)

LightEffect property

Description
TRUE, when the light effect should be activated. BOOLEAN write-read access.

Limit4LowerLimit 

Description
Specifies the lower limit for ""Reserve4".

The "Limit4LowerLimitEnable" property must be set to TRUE so that the limit "Reserve4"" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit for "Reserve4".

Comments
The "Limit4LowerLimitRelative" property specifies whether the object is evaluated as a 
percentage or absolutely.

See also
Bar (Page 4995)
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Limit4LowerLimitColor 

Description
Specifies the color for the lower limit "Reserve4". 

The "Limit4LowerLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimitColor[=Color]

Object
Required A ""ScreenItem" object with the format "Bar"."

Color
Optional A value or a constant that specifies the color for the lower limit ""Reserve4".

See also
Bar (Page 4995)

Limit4LowerLimitEnabled

Description
Specifies whether the lower limit ""Reserve4"" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit ""Reserve4" is to be monitored.

Comments
The following values will be specified with the properties ""Limit4LowerLimit", 
"Limit4LowerLimitColor" and "Limit4LowerLimitRelative"":

Limit
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Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

Limit4LowerLimitRelative

Description
Specifies whether the lower limit "Reserve4" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit4LowerLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional. TRUE,, if the lower limit "Reserve4" is to be evaluated as a percentage.

See also
Bar (Page 4995)

Limit4UpperLimit 

Description
Specifies the lower limit for "Reserve4".

The "Limit4UpperLimitEnable"" property must be set to TRUE so that the limit ""Reserve4" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".
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Double
Optional A value or a constant that specifies the upper limit for "Reserve4".

Comments
The "Limit4UpperLimitRelative" property specifies whether the object is evaluated as a 
percentage or absolutely.

See also
Bar (Page 4995)

Limit4UpperLimitColor

Description
Specifies the color for the upper limit ""Reserve4". 

The "Limit4UpperLimitEnable"" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the upper limit "Reserve4".

See also
Bar (Page 4995)

Limit4UpperLimitEnabled

Description
Specifies whether the upper limit "Reserve4" is to be monitored. 

Access in Runtime: Read and write
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Syntax
Object.Limit4UpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem"" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit ""Reserve4" is to be monitored.

Comments
The following values will be specified with the properties ""Limit4UpperLimit", 
"Limit4UpperLimitColor" and "Limit4UpperLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

Limit4UpperLimitRelative

Description
Specifies whether the upper limit "Reserve4" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit4UpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit "Reserve4" is to be evaluated as a percentage.

See also
Bar (Page 4995)
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Limit5LowerLimit

Description
Specifies the lower limit for "Reserve5"".

The "Limit5LowerLimitEnable" property must be set to TRUE so that the limit ""Reserve5" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5LowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit for "Reserve5"".

Comments
The "Limit5LowerLimitRelative" property specifies whether the object is evaluated as a 
percentage or absolutely.

See also
Bar (Page 4995)

Limit5LowerLimitColor 

Description
Specifies the color for the lower limit ""Reserve5"". 

The "Limit5LowerLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit5LowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".
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Color
Optional A value or a constant that specifies the color for the lower limit ""Reserve5".

See also
Bar (Page 4995)

Limit5LowerLimitEnabled

Description
Specifies whether the lower limit "Reserve5" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5LowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit ""Reserve5" is to be monitored. 

Comments
The following values will be defined using the properties "Limit5LowerLimit", 
"Limit5LowerLimitColor" and "Limit5LowerLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

Limit5LowerLimitRelative

Description
Specifies whether the lower limit ""Reserve5" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write
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Syntax
Object.Limit5LowerLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem"" object with the format ""Bar"".

BOOLEAN
Optional TRUE, if the lower limit ""Reserve5" is to be evaluated as a percentage.

See also
Bar (Page 4995)

Limit5UpperLimit

Description
Specifies the lower limit for "Reserve5".

The ""Limit5UpperLimitEnable" property must be set to TRUE so that the limit ""Reserve5" can 
be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimit[=Double]

Object
Required A ""ScreenItem"" object with the format "Bar".

Double
Optional A value or a constant that specifies the upper limit for ""Reserve5".

Comments
The "TypeLimitHigh5" property specifies whether the object is evaluated as a percentage or 
absolutely.

See also
Bar (Page 4995)
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Limit5UpperLimitColor

Description
Specifies the color for the upper limit "Reserve5"". 

The "Limit5UpperLimitEnable" property must have the value TRUE if the bar color is to change 
once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the upper limit ""Reserve5".

See also
Bar (Page 4995)

Limit5UpperLimitEnabled

Description
Specifies whether the upper limit "Reserve5" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit ""Reserve5"" is to be monitored.

See also
Bar (Page 4995)
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Limit5UpperLimitRelative

Description
Specifies whether the upper limit "Reserve5" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.Limit5UpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the upper limit "Reserve5" is to be evaluated as a percentage.

See also
Bar (Page 4995)

LimitHigh4 

Description
Determines the upper limit value for "Reserve 4" or returns it.
The CheckLimitHigh4 property must be set to TRUE in order that the "Reserve 4" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitHigh4 property.

LimitHigh5

Description
Determines the upper limit value for "Reserve 5" or returns it.
The CheckLimitHigh5 property must be set to TRUE in order that the "Reserve 5" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitHigh5 property.
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LimitLow4

Description
Determines the lower limit value for "Reserve 4" or returns it.
The CheckLimitLow4 property must be set to TRUE in order that the "Reserve 4" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitLow4 property.

LimitLow5

Description
Determines the lower limit value for "Reserve 5" or returns it.
The CheckLimitLow5 property must be set to TRUE in order that the "Reserve 5" limit value 
can be monitored. 
The type of the evaluation (in percent or absolute) is defined in the TypeLimitLow5 property.

LimitMax

Description
Determines the upper limit value as an absolute value depending on the data format or returns 
it.
If the displayed value exceeds the upper limit value, it is displayed by a sequence of *** (not 
displayable).

LimitMin

Description
Determines the lower limit value as an absolute value depending on the data format or returns it.
If the displayed value exceeds the upper limit value, it is displayed by a sequence of *** (not 
displayable).

LineColor

Description
Specifies the color of the window dividers. The button opens the "Color selection" dialog.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)
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TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

LineendShapeStyle

Description
Specifies the shape of the line end.

See also
CheckBox (Page 5008)

GraphicIOField (Page 5049)

Button (Page 5002)

Bar (Page 4995)

WindowSlider (Page 5176)

Switch (Page 5127)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)

Line (Page 5063)

Listbox (Page 5065)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Connector (Page 5020)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

GraphicView (Page 5052)

Polygon (Page 5095)

Polyline (Page 5098)

RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)
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TextField (Page 5144)

OptionGroup (Page 5092)

LineWidth

Description
Specifies the line weight of the selected object. 

Access in Runtime: Read and write

Syntax
Object.LineWidth [= LONG]

Object
Required A "ScreenItem" object with the formats "Line" "Polyline", "EllipticalArc", "CircularArc" 
or "Connector".

LONG
Optional A value or a constant that specifies the line weight in pixels.

See also
Line (Page 5063)

Polyline (Page 5098)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Connector (Page 5020)

AlarmControl (Page 4981)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)
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LineWidth

Description
Determines the LineWidth of the given object. 

Access during runtime: Read and Write

Syntax
Object.LineWidth [= LONG]

Object
Required. An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".

LONG
Optional. A value or constant which determines the line width in pixels.

See also
OnlineTrendControl (Page 5083)

ListType property

Description
Returns the data type displayed in the case of a text list object. Read only access.

Value range from 0 to 2.

0 = decimal

1 = binary

2 = bit

LoadDataImmediately

Description
Specifies whether in the event of a screen impact the tag values should be downloaded from 
the archives for the time range that is to be shown.     

Access in Runtime: Read and write

Syntax
Object.LoadDataImmediately[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl" (Runtime Professional) or "HMITrendView" 
(Runtime Advanced).

BOOLEAN
Optional TRUE, if in the event of a screen impact the tag values should be downloaded from 
the archives for the time range that is to be shown.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

Localizable

Description
Specifies whether a font should be assigned and can be formatted for each Runtime language. 

Access in Runtime: Read and write

Syntax
Object.Localizable[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "OnlineTableControl", "AlarmControl" or "UserArchiveControl".

BOOLEAN
Optional TRUE, if a font should be assigned and can be formatted for each Runtime language. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)
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LocalCursor

Description
Establishes whether the cursor data is transferred separately in order to increase the 
performance.   

Syntax
Object.LocalCursor

Object
Required A "ScreenItem" object with the format "SmartClientView".

See also
SmartClientView (Page 5123)

LockSquaredExtent 

Description
Specifies whether the size of the clock can be adjusted with the mouse. 

Access in Runtime: Read and write

Syntax
Object.LockSquaredExtent[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Clock" or "Gauge".

BOOLEAN
Optional TRUE, if the size of the clock can be adjusted by dragging the mouse on the selection 
points to the desired aspect ratio.

See also
Clock (Page 5018)

Gauge (Page 5046)
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LockStatus

Description
TRUE, when a locked measuring point should be displayed. BOOLEAN write-read access.

LockText

Description
Defines the label of a button for a locked measuring point.
The LockStatus property must be set to TRUE for the label to be displayed. 

LockTextColor

Description
Defines or returns the color of the button label for a locked measuring point. LONG write/read 
access.
The LockStatus property must be set to TRUE for the background color to be displayed.

Logging 

Description
Returns an object of type "Logging".

Access in Runtime: Read

Syntax
Object.Logging

Object
Required A "HMIRuntime" object. 

See also
HMIRuntime  (Page 4956)

LogOperation 

Description
Specifies whether, after operating this object, an alarm is output on the alarm system. 
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Access in Runtime: Read and write

Syntax
Object.LogOperation[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "IOField", "SymbolicIOField", "CheckBox", 
"OptionGroup" or "WindowSlider".

BOOLEAN
Optional. TRUE, if, after operating this object, an alarm is output on the alarm system.

See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Listbox (Page 5065)

LongStrokesBold

Description
TRUE, when the long sections of a scale should be displayed in bold face. BOOLEAN write-
read access.

LongStrokesOnly

Description
TRUE, when only the long sections of a scale should be displayed . BOOLEAN write-read 
access.

LongStrokesSize

Description
Defines or returns the length of the axis section in pixels. 
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LongStrokesTextEach

Description
Returns the value which defines which sections of the scale displayed should be labeled (1 = 
every section, 2 = every second section, etc.). Read only access

LongTermArchiveConsistency

LongTermArchiveConsistency
If "LongTimeArchiveConsistency" is set to "No", 1000 messages are displayed in the long-term 
archive list on the single-user system, server or client for each server, or for each redundant 
server pair. 

If the "LongTimeArchiveConsistency" is set to "yes", the most recent 1000 messages are 
displayed on the client of all servers or redundant server pair in the long-term archive list.

The attribute can be assigned dynamic properties by means of the name 
LongTimeArchiveConsistency .

See also
AlarmControl (Page 4981)

LowerLimit

Description
Specifies the lower limit for input values. 

Access in Runtime: Read and write

Syntax
Object.LowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "IOField"".

Double
Optional A value or a constant that specifies the lower limit for input values.

See also
IOField (Page 5059)
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LowerLimitColor(i) 

Description
Specifies the color that identifies the tag values for the selected trend and which lie below the 
value of "LowerLimitValue(i)". Whether the information is evaluated depends on the property 
"LowerLimitEnabled(i)".   

Access in Runtime: Read and write

Syntax
Object.LowerLimitColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

Color
Optional A value or a constant which specifies the color which identifies tag values of the 
specified trend which are below the value of "LowerLimitValue(i)".

Comments
The parameter i indicates the number of the trend.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

LowerLimitEnabled(i) 

Description
Specifies whether the information from "LowerLimitColor(i)" is used to identify the tag values 
that lie beneath the value of "LowerLimitValue(i)". 

Access in Runtime: Read and write

Syntax
Object.LowerLimitEnabled(i)[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the information from "LowerLimitColor(i)" is used to identify the tag values 
that lie beneath the value of "LowerLimitValue(i)".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

LowerLimitValue(i)

Description
???Specifies whether the tag values which drop below the value of "LowerLimitValue(i)" are 
marked by the color specified in "LowerLimitColor(i)". Whether the specification is evaluated 
depends on the attribute "LowerLimitEnabled(i)".   

Access in Runtime: Read and write

Syntax
Object.LowerLimitValue(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that determines if the tag values that fall short of the 
"LowerLimitValue(i)" are to be identified with the color specified in "LowerLimitColor(i)". 

Comments
The parameter i indicates the number of the trend. 
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

LowLimitColor

Description
Specifies the color of the bottom or left scroll button in a scroll bar. 

Access in Runtime: Read and write

Syntax
Object.LowLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "WindowSlider".

Color
Optional A value or a constant that specifies the color of the bottom or left scroll button in a 
scroll bar.

See also
WindowSlider (Page 5176)

Properties M-N

MachineName

Description
Specifies the network code of the device that is to be monitored. 

Enter the name or the port of the device as the network code. 

Access in Runtime: Read and write

Syntax
Object.MachineName= [STRING]

Object
Required A "ScreenItem" object with the format "SmartClientView". 
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STRING
Optional A value or a constant that contains the network code.

See also
SmartClientView (Page 5123)

MarginToBorder

Description
Specifies the width of the 3D border in pixels. The value of the width is dependent on the size 
of the object. 

Access in Runtime: Read and write

Syntax
Object.MarginToBorder[=Int]

Object
Required A ""ScreenItem" object with the format "WindowSlider".

Int
Optional A value or a constant that specifies the width of the 3D border in pixels. 

See also
WindowSlider (Page 5176)

Marker property

Description
TRUE, when the limit values should be displayed as scale values. BOOLEAN write-read 
access.

Max property

Description
Defines or returns the absolute value in the case of a full value display. This value is displayed 
if the scale display is active.
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MaximizeButton property

Description
TRUE, when the object can be maximized in Runtime. Read only access. 

MaximumValue

Description
Specifies the maximum value of the scale in the selected object. 

Access in Runtime: Read and write

Syntax
Object.MaximumValue [= DOUBLE]

Object
Required A "ScreenItem" object with the formats "Bar", "Gauge", "Slider" or "WindowSlider".

DOUBLE
Optional A value or a constant that specifies the maximum value.

See also
Bar (Page 4995)

Gauge (Page 5046)

Slider (Page 5120)

WindowSlider (Page 5176)

MaximumValue

Description
Determines the maximum value of the scale in the given object. 

Access during runtime: Read and Write

Syntax
Object.MaximumValue [= DOUBLE]

Object
Required. An object of the type "ScreenItem" with the characteristic "Bar", "Gauge" or "Slider".
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DOUBLE
Optional. A value or constant which determines the maximum value.

MCGUBackColorOff

Description
Defines or returns the background color for flash status "Off" in the case of the "Departed 
Unacknowledged" status. LONG write-read access.

MCGUBackColorOn

Description
Defines or returns the background color for flash status "On" in the case of the "Departed 
Unacknowledged" status. LONG write-read access.

MCGUBackFlash

Description
TRUE, when the background should flash when a message departs unacknowledged. 
BOOLEAN write-read access.

MCGUTextColorOff

Description
Defines or returns the color of the text for flash status "Off" for the "Outgoing unacknowledged" 
status. LONG write-read access.

MCGUTextColorOn

Description
Defines or returns the background color of the text for flash status "On" for the "Outgoing 
unacknowledged" status. LONG write-read access.
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MCGUTextFlash

Description
TRUE, when the font should flash when a message departs unacknowledged. BOOLEAN write-
read access.

MCKOBackColorOff

Description
Defines or returns the background color for flash status "Off" in the case of the "Arrived" status. 
LONG write-read access.

MCKOBackColorOn

Description
Defines or returns the background color for flash status "On" in the case of the "Arrived" status. 
LONG write-read access.

MCKOBackFlash

Description
TRUE, when the background should flash when a message arrives. BOOLEAN write-read 
access.

MCKOTextColorOff

Description
Defines or returns the color of the text for flash status "Off" for the "Incoming" status. LONG 
write-read access.

MCKOTextColorOn

Description
Defines or returns the background color of the text for flash status "On" for the "Incoming" 
status. LONG write-read access.
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MCKOTextFlash

Description
TRUE, when the font should flash when a message arrives. BOOLEAN write-read access.

MCKQBackColorOff

Description
Defines or returns the background color for flash status "Off" in the case of the "Departed 
Acknowledged" status. LONG write-read access.

MCKQBackColorOn

Description
Defines or returns the background color for flash status "On" in the case of the "Departed 
Acknowledged" status. LONG write-read access.

MCKQBackFlash

Description
TRUE, when the background should flash when a message departs acknowledged. BOOLEAN 
write-read access.

MCKQTextColorOff

Description
Defines or returns the color of the text for flash status "Off" for the "Outgoing acknowledged" 
status. LONG write-read access.

MCKQTextColorOn

Description
Defines or returns the background color of the text for flash status "On" for the "Outgoing 
acknowledged" status. LONG write-read access.
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MCKQTextFlash

Description
TRUE, when the font should flash when a message departs acknowledged. BOOLEAN write-
read access.

MCText

Description
Defines or returns the label for the respective message class.

MenuToolBarConfig 

Description
Loads the given configuration file with configured menu and toolbars or returns the name of 
the configuration file. 

Access in Runtime: Read and write

Syntax
Object.MenuToolBarConfig[=STRING]

Object
Required A "HMIRuntime" object. 

STRING
Optional The configuration file with user-defined menu and toolbars.

See also
HMIRuntime  (Page 4956)

ScreenWindow (Page 5116)

MessageBlockAlign

Description
Aligns the contents of a selected message block in the table.   

Access in Runtime: Read and write
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Syntax
Object.MessageBlockAlign [=Align]

Object
Required An object of the "ScreenItem" type with the format "AlarmContro", 
"TrendRulerControl", "OnlineTableControl", "UserArchiveControl".

Align

Value Description Explanation
0 Left Aligns the contents of a selected message block to the left.
1 Centered Aligns the contents of a selected message block to the center.
2 Right Aligns the contents of a selected message block to the right.

See also
AlarmControl (Page 4981)

MessageBlockAutoPrecisions

Description
Enables automatic setting of the number of decimal places.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockAutoPrecisions[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The number of decimal places is specified automatically. 

FALSE: The value in the "Decimal places" field is effective.

See also
AlarmControl (Page 4981)
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MessageBlockCaption

Description
Specifies the caption of the column header in the message view for the selected message 
block. You can only edit the labels after having disabled the "Apply project settings" option. 
The entered caption is effective in all Runtime languages.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockCaption

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

MessageBlockCount

Description
Specifies the number of available message blocks which are available for the message list 
and hit list.   

Access in Runtime: Read

Syntax
Object.MessageBlockCount 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

MessageBlockDateFormat

Description
Defines the date format for displaying messages.   
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Access in Runtime: Read and write

Syntax
Object.MessageBlockDateFormat[=DateFormat]

Object
Required A "ScreenItem" object with the format "AlarmControl".

DateFormat

Value Description
Automatic The date format is set automatically.
dd.MM.yy Day.Month.Year, e.g. 24.12.10.
dd.MM.yyyy Day.Month.Year, e.g. 24.12.2010.
dd/MM/yy Day/Month/Year, e.g. 24/12/10.
dd/MM/yyyy Day/Month/Year, e.g. 24/12/2010.

See also
AlarmControl (Page 4981)

MessageBlockExponentialFormat

Description
Specifies the exponential notation for visualization of the values of a selected message block.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockExponentialFormat[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The values are displayed in exponential format.

FALSE: The values are displayed in decimal format.

See also
AlarmControl (Page 4981)
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MessageBlockFlashOn

Description
Enables flashing of the selected message block in Runtime after a message was activated.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockFlashOn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The content of the message block flashes.

FALSE: The content of the message block does not flash.

See also
AlarmControl (Page 4981)

MessageBlockHideText

Description
Enables the textual display of the content of a selected message block.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockHideText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The content is not shown as a text. The option is not activated.

FALSE: The content is shown as a text. The option is activated.

See also
AlarmControl (Page 4981)
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MessageBlockHideTitleText

Description
Enables the display of the header of a selected message block in text format.   

Syntax
Object.MessageBlockHideTitleText=[BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE : The header is not shown as a text. The option is not activated.

FALSE : The header is shown as a text. The option is activated.

See also
AlarmControl (Page 4981)

MessageBlockId

Description
Specified assignment of ID number and message block in the message view.   

Access in Runtime: Read

Syntax
Object.MessageBlockID

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)
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MessageBlockIndex

Description
References an existing message block. You can assign the values of other attributes to a 
certain message block by using the attribute. Valid values for "MessageBlockIndex" are 
between 0 and "MessageBlockCount" minus 1.   

The "MessageBlockIndex" attribute can be dynamized by the MessageBlockRepos attribute.

Access in Runtime: Read

Syntax
Object.MessageBlockIndex

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

MessageBlockLeadingZeros

Description
Enables the display of selected message blocks with leading zero format.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockLeadingZeros[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: Leading zeros are displayed. The number of leading zeros is specified in the properties.

FALSE: Leading zeros are not displayed.

See also
AlarmControl (Page 4981)
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MessageBlockLength

Description
Defines the length of the message block selected based on the number of characters. You 
can only enter a value if the "Apply project settings" field is disabled.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockLength[=Int]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Int
Value which specifies the length of the message block. 

See also
AlarmControl (Page 4981)

MessageBlockName

Description
Displays the object name of the message block selected. You cannot edit this name.  

Access in Runtime: Read

Syntax
Object.MessageBlockName

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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MessageBlockPrecisions

Description
Specifies the decimal precision of the values of a selected message block. You can only enter 
the value if the "Automatic" option is deactivated.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockPrecisions[=Precision]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Precision
Number of decimal places

See also
AlarmControl (Page 4981)

MessageBlockSelected

Description
The available message block can be used in Runtime control for the message list or hitlist. 

Select the "Message blocks" tab to activate existing message blocks as required in the Control. 
Select the "Hitlist" and "Message list" tabs to configure the hitlist and message list based on 
the available blocks.   

Syntax
Object.MessageBlockSelected]

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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MessageBlockShowDate

Description
Enables the display of a date in the "Time" message block in addition to the time.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockFlashOn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The date and the time are displayed.

FALSE: The time is displayed.

 

See also
AlarmControl (Page 4981)

MessageBlockShowIcon

Description
Enables the display of the content of a selected message block as icon.  

Access in Runtime: Read and write

Syntax
Object.MessageBlockShowIcon[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: The content is shown as an icon.

FALSE: The content is not shown as an icon.

See also
AlarmControl (Page 4981)
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MessageBlockShowTitleIcon

Description
Specifies whether the header of the selected message block is displayed as a text.   

Syntax
Object.MessageBlockShowTitleIcon=[BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE : The header is shown as an icon.

FALSE : The header is not shown as an icon.

See also
AlarmControl (Page 4981)

MessageBlockTextId

Description
Specifies the caption of the selected message block using a Text ID which was derived from 
the text library. The caption is adapted automatically if a user changes the Runtime language. 

You can only enter a text ID after having disabled the "Apply project settings" option.  

Access in Runtime: Read and write

Syntax
Object.MessageBlockTextId

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)
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MessageBlockTimeFormat

Description
Defines which time format or duration format is used for displaying the messages.   

Access in Runtime: Read and write

Syntax
Object.MessageBlockTimeFormat[=TimeFormat]

Object
Required A "ScreenItem" object with the format "AlarmControl".

TimeFormat
The following time formats are available:

Value Explanation
Automatic The time format is set automatically.
HH:mm:ss Hours:Minutes:Seconds, e.g. 15:35:44
HH:mm:ss.ms Hours:Minutes:Seconds.Milliseconds, e.g. 15:35:44.240.
hh:mm:ss tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.
hh:mm:ss.ms tt Hours:Minutes:Seconds.Milliseconds AM/PM, e.g. 03:35:44.240 PM.

The following duration formats are available:

Value Explanation
Automatic The duration format is determined automatically.
d H:mm:ss Day Hours:Minutes:Seconds, e.g. 1 2:03:55.
H:mm:ss. Hours:Minutes:Seconds, e.g. 26:03:55.
m:ss Minutes:Seconds, Example: 1563:55.
s Seconds, e.g. 93835.

See also
AlarmControl (Page 4981)

MessageBlockType

Description
Specifies the number of available message blocks which are available for the message list 
and hit list.   

Access in Runtime: Read and write
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Syntax
Object.MessageBlockType[=BlockType]

Object
Required A "ScreenItem" object with the format "AlarmControl". 

BlockType

Value Description Description
0 System block The message block belongs to the system block category
1 Text block The message block belongs to the user text block category
2 Process value 

block
The message block belongs to the process value block category

3 Hitlist block The message block belongs to the message blocks of the hitlist.

See also
AlarmControl (Page 4981)

MessageClass

Description
Defines the respective limit violation (Alarm High, Alarm Low, Warning High, Warning Low, 
etc.) for which the "Display Text", "Incoming -", "Incoming acknowledged -", and "Outgoing 
unacknowledged -" settings have been configured.

MessageColumnAdd

Description
Adds the selected message block from the list of existing message blocks to the list of selected 
message blocks.   

Access in Runtime: Read

Syntax
Object.MessageColumnAdd

Object
Required A "ScreenItem" object with the format "AlarmControl".
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See also
AlarmControl (Page 4981)

MessageColumnCount

Description
Specifies the number of message blocks to be displayed in the message list in Runtime.  

Access in Runtime: Read

Syntax
Object.MessageColumnCount

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

MessageColumnIndex

Description
References a message block selected for the message list. Using this attribute you can assign 
the values of other attributes to a specific message block of the message list. 

Valid values for "MessageColumnIndex" are between 0 and "MessageColumnCount" minus 
1. The "MessageColumnIndex" attribute can be dynamized by the attribute 
MessageColumnRepos.   

Access in Runtime: Read and write

Syntax
Object.MessageColumnIndex

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)
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MessageColumnName

Description
Shows the name of the message block in the message list which is referenced with the 
"MessageColumnIndex" property. You cannot edit this name.   

Access in Runtime: Read

Syntax
Object.MessageColumnName 

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

MessageColumnRemove

Description
Removes the marked message block from the list of selected message blocks and inserts it 
in the list of existing message blocks.    

Access in Runtime: Read and write

Syntax
Object.MessageColumnRemove

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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MessageColumnRepos

Description
Resorts the message blocks. The "Up" and "Down" commands move the selected message 
block accordingly in the list. This places the message block further forward or back in the 
message view in Runtime.     

Syntax
Object.MessageColumnRepos

Object.HitlistColumnRepos 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

MessageColumnSort

Description
Defines the sorting order of the message block referenced in "MessageColumnIndex" .   

Access in Runtime: Read and write

Syntax
Object.MessageColumnSort [=Sort]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Sort
0: No sorting.

1: Ascending sorting from the lowest to highest value

2 Descending sorting from the highest to lowest value

See also
AlarmControl (Page 4981)
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MessageColumnSortIndex

Description
Defines the sorting order of the message block referenced in "MessageColumnIndex". The 
sorting criterion is removed from "MessageColumnSort" if you set a "0" value.   

Access in Runtime: Read and write

Syntax
Object.MessageColumnSortIndex 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

MessageColumnVisible

Description
The selected message blocks of the message list or hit list which are used in Runtime in the 
message view are displayed in the list.     

Syntax
Object.HitlistColumnVisible

Object.MessageColumnVisible

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

MessageListType

Description
Selection field for defining the active list for picture calls.   
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Syntax
Object.MessageListType=[ListType]

Object
Required A "ScreenItem" object with the format "AlarmControl".

ListType

Value Description Description
0 Message list The currently active messages are displayed after a picture was 

called.
1 Short-term archive list A short-term archive list displays the logged messages after the 

picture was called. The display is updated immediately on activation 
of new messages.

2 Long-term archive list A long-term archive list displays the logged messages after a picture 
was called.

3 Lock list Only the currently locked messages are displayed after a picture 
was called.

4 Hitlist The configured statistics data is displayed after a picture was called.
5 List of messages to be 

hidden
The messages to be hidden are displayed at the call of a picture.

See also
AlarmControl (Page 4981)

Min 

Description
Defines or returns the absolute value in the case of the smallest value display. This value is 
displayed if the scale display is active.

MinimumValue

Description
Specifies the minimum value of the scale in the selected object. 

Access in Runtime: Read and write

Syntax
Object.MinimumValue [= DOUBLE]
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Object
Required A "ScreenItem" object with the formats "Bar", "Gauge", "Slider" or "WindowSlider".

DOUBLE
Optional A value or a constant that specifies the minimum value.

See also
Bar (Page 4995)

Gauge (Page 5046)

Slider (Page 5120)

WindowSlider (Page 5176)

MinimumValue

Description
Determines the minimum value of the scale in the given object. 

Access during runtime: Read and Write

Syntax
Object.MinimumValue [= DOUBLE]

Object
Required. An object of the type "ScreenItem" with the characteristic "Bar", "Gauge" or "Slider".

DOUBLE
Optional. A value or constant which determines the minimum value.

MinuteNeedleHeight

Description
Specifies the length of the minute hand in the ""Clock" object. 

Access in Runtime: Read and write

Syntax
Object.MinuteNeedleHeight[= LONG]

Object
Required A "ScreenItem" object with the format "Clock".
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LONG
Optional A value or a constant that specifies the length of the minute hand.

Specify the length of the minute hand as a percentage relating to the radius of the clock face.

See also
Clock (Page 5018)

MinuteNeedleWidth 

Description
Specifies the width of the minute hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.MinuteNeedleWidth[= LONG]

Object
Required A "ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the width of the minute hand.

Specify the width as a percentage relating to double the length of the minute hand.

See also
Clock (Page 5018)

Mode 

Description
Specifies the field type of the selected object.     

Access during runtime: Read and write

Syntax
Object.Mode[=IOFieldType]

Object
Necessary. A "ScreenItem" object with the formats "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch" or "GraphicIOField".
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IOFieldType
hmiIOFieldInput ( 1): input field

hmiIOFieldOutput ( 0): output field

hmiIOFieldInOutput ( 2): input and output field

Used for the following object types:
IOField

 

See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

DateTimeField (Page 5023)

RoundButton (Page 5112)

Movable

Description
Specifies whether the window can be moved in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Movable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional. TRUE, if the window can be moved in Runtime.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)
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FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

MsgFilterSQL

Description
Specifies one or more SQL statements for the customized selection of the messages. Several 
customized selections are connected with "OR". If you have configured a fixed selection 
"DefaultMsgFilterSQL", the SQL statements of "DefaultMsgFilterSQL" and "MsgFilterSQL" are 
connected with "AND".   

Syntax
Object.MsgFilterSQL 

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

Name 

Description   
Returns the object name as STRING. The returned value is dependent upon the used object. 

Access during runtime: Read

Syntax
Object.Name

Object
Necessary. An object of the "Tag", "Project", "DataItem", "Layer" and "ScreenItem" type with 
the format "FunctionTrendControl"

Comments
Dependent on the specified object, the following object names will be returned:

● Tag: Name of the tag without server and tag prefix.

● Project: Name of the current Runtime project.
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● DataItem: Name of the DataItem object.

● Layer: Name of the layer.

● FunctionTrendControl : Name of the trend referenced by the "Index" property.
 

  Note

Use the "Name" property to address a tag in the Tags" list. Tag names are structured in 
WinCC according to the following scheme:

<Tag prefix><Name of tag>

If you only specify the tag name, the tag prefix is applied from the screen window shortcut.
 

Example
The following example returns the name of the current Runtime project as Trace: 

 
'VBS160
HMIRuntime.Trace "Name: " & HMIRuntime.ActiveProject.Name & vbNewLine

See also
DataItem (Page 4951)

Layer (Page 4959)

Project (Page 4963)

Tag (Page 4975)

HTMLBrowser (Page 5057)

Group (Page 5055)

ForeignControl (Page 5034)

DateTimeField (Page 5023)

WLanQualityView (Page 5179)

ZoneLabelView (Page 5180)

ZoneQualityView (Page 5181)

ProtectedAreaName (Page 5102)

RangeLabelView (Page 5103)

RangeQualityView (Page 5105)

ScreenWindow (Page 5116)

ScriptDiagnostics (Page 5118)

Slider (Page 5120)

SmartClientView (Page 5123)
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StatusForce (Page 5125)

SymbolLibrary (Page 5135)

BatteryView (Page 5001)

ChannelDiagnose (Page 5006)

CheckBox (Page 5008)

GraphicIOField (Page 5049)

Button (Page 5002)

Bar (Page 4995)

WindowSlider (Page 5176)

UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

Switch (Page 5127)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Line (Page 5063)

Listbox (Page 5065)

AlarmView (Page 4992)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

DiskSpaceView (Page 5025)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicView (Page 5052)

Polygon (Page 5095)

Polyline (Page 5098)

RoundButton (Page 5112)
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SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

RecipeView (Page 5106)

TrendView (Page 5155)

UserArchiveControl (Page 5167)

SystemDiagnoseWindow (Page 5140)

SystemDiagnoseView (Page 5137)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

NeedleBorderColor

Description
Specifies the line color of the pointer in the ""Clock"" object. 

Access in Runtime: Read and write

Syntax
Object.NeedleBorderColor[= Color]

Object
Required A "ScreenItem" object with the format "Clock".".

Color
Optional A value or a constant that specifies the line color of the pointer.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen .
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See also
Clock (Page 5018)

NeedleColor

Description
Specifies the hand color of the "Clock" object. 

You must have configured the "NeedleFillStyle" property as "Transparent" for the pointer color 
to be shown.

Access in Runtime: Read and write

Syntax
Object.NeedleColor[= Color]

Object
Required A "ScreenItem" object with the format "Clock".".

Color
Optional A value or a constant that specifies the pointer color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Clock (Page 5018)

NeedleFillStyle 

Description
Specifies whether the pointers are filled or transparent: 

0: The pointers are filled in the pointer fill color and shown with a margin in the foreground 
color. 

1: The pointers appear to be transparent and will be indicated by a margin in the foreground 
color. 

Access in Runtime: Read and write
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Syntax
Object.NeedleFillStyle[=NeedleFillStyle]

Object
Required A "ScreenItem" object with the format ""Clock".

NeedleFillStyle
hmiNeedleFillStyleTransparent ( 1): The pointers are filled in the pointer fill color and shown 
with a margin in the foreground color.

Identifies a transparent clock hand.

hmiNeedleFillStyleSolid  ( 0): The pointers appear to be transparent and will be indicated by 
a margin in the foreground color.

Identifies a opaque clock hand.

See also
Clock (Page 5018)

NormalRangeColor

Description
Specifies the color of the normal range on the scale of the "Gauge" object. 

The "NormalRangeVisible" property must have the value TRUE so that the normal range is 
displayed.

Access during runtime: Read and write

Syntax
Object.NormalRangeColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the color of the normal range.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.
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See also
Gauge (Page 5046)

NormalRangeVisible 

Description
Specifies whether the normal range in the scale of the ""Gauge" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.NormalRangeVisible[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the normal range will be displayed in the scale.

Comments
Specify the color of the normal range with the ""NormalRangeColor" property.

See also
Gauge (Page 5046)

NumberLines

Description
Defines or return the number of lines the text list object should contain. If the amount of 
configured text is larger than this value, the selection list receives a vertical scroll bar.

NumberOfValues(i) 

Description
Specifies the number of values that are shown in the trend window. The property 
"TagProviderType(i)"" must have the value -1. Whether the information is evaluated depends 
on the property "UseMeasurePoints(i)".".

Access in Runtime: Read and write
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Syntax
Object.NumberOfValues(i)[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of values that are shown in the trend 
window. 

Comments
Number of value pairs for trend i (from tag provider)

See also
FunctionTrendControl (Page 5038)

Properties O-P

Object

Description
If you use a Control that is not a standard WinCC control, it could be that the properties provided 
by the Control have the same names as the general ScreenItem properties. In this case, the 
ScreenItem properties take priority. You can access the "hidden" properties of an outside 
provider Controls via the additional ""object" property. 

Syntax
Object.Object

Object
Required A "ScreenItem" object with the format ""ForeignControl".

Application example
To do this, address the properties of an outside provider control in the following way:

Control.object.type

If you are using only the form Control.type, the properties of the ScreenItem object will be used 
in case of identical names.
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ObjectName

Description
Returns the name of the specified object. 

Access in Runtime: Read

Syntax
Object.ObjectName

Object
Required A "ScreenItem" object. This property is a standard property of the ScreenItem object 
and is therefore available for all formats.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)
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OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

ObjectSizeDeclutteringEnable

Description 
Specifies whether only the objects within a set size range are displayed. 

Access during runtime: Read

Syntax
Object.ObjectSizeDeclutteringEnable

Object
Necessary. A "Screen" object. 

Example
The example outputs the Decluttering properties of the screen "NewPDL1" as Trace.

 
'VBS157
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Min: " & objScreen.ObjectSizeDeclutteringMin & vbNewLine
HMIRuntime.Trace "Max: " & objScreen.ObjectSizeDeclutteringMax & vbNewLine
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine
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See also
Screen (Page 4964)

ObjectSizeDeclutteringMax 

Description 
Returns the upper size range for the display suppression of objects of the specified screen as 
LONG. 

Access during runtime: Read

Syntax
Object.ObjectSizeDeclutteringMax

Object
Necessary. A "Screen" object. 

Example
The example outputs the Decluttering properties of the screen "NewPDL1" as Trace.

 
'VBS157
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Min: " & objScreen.ObjectSizeDeclutteringMin & vbNewLine
HMIRuntime.Trace "Max: " & objScreen.ObjectSizeDeclutteringMax & vbNewLine
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 4964)

ObjectSizeDeclutteringMin

Description 
Returns the lower size range for the display suppression of objects of the specified screen as 
LONG. 

Access during runtime: Read

Syntax
Object.ObjectSizeDeclutteringMin
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Object
Necessary. A "Screen" object. 

Example
The example outputs the Decluttering properties of the screen "NewPDL1" as Trace.

 
'VBS157
Dim objScreen
Set objScreen = HMIRuntime.Screens("NewPDL1")
HMIRuntime.Trace "Min: " & objScreen.ObjectSizeDeclutteringMin & vbNewLine
HMIRuntime.Trace "Max: " & objScreen.ObjectSizeDeclutteringMax & vbNewLine
HMIRuntime.Trace "Enable: " & objScreen.LayerDeclutteringEnable & vbNewLine

See also
Screen (Page 4964)

OCXState 

Description
Sepcifies the status of the OCX. 

Access in Runtime: Read and write

Syntax
Object.OCXState[=Stream]

Object
Required A "ScreenItem" object with the format "ForeignControl".

Stream
Optional A value or a constant that specifies the status of the OCX. 

See also
ForeignControl (Page 5034)

Online 

Description
Specifies start and stop of the updating.     
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Access in Runtime: Read and write

Syntax
Object.Online[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl" (Runtime Professional) or "HMITrendView" 
(Runtime Advanced).

BOOLEAN
Optional TRUE, if the updated display should be stopped. The values are stored in the cache 
and when the button is reactivated they are added . FALSE, if the updated display is to be 
continued.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnTop

Description
TRUE, when the object should remain in the foreground in Runtime. Read only access.

OperationMessage property

Description
TRUE, if an alarm should be output when an operation is performed. BOOLEAN write-read 
access.
The operation is sent to the alarm system and is logged. The alarm system can be used to 
output an alarm in an alarm line, for example.

Particularities for I/O field, text list, and slider 
The reason for the operation can only be entered if the "OperationReport" property has been 
set to TRUE. 
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OperationReport property 

Description
TRUE, if the reason for an operation should be recorded. BOOLEAN write/read access.
When the object is used or operated in Runtime, a dialog opens in which the operator can 
input the reason for the operation in the form of text. The operation is sent to the message 
system, and is archived.

OperationSteps

Description
Specifies by how many steps the slider of the scrollbar is moved with one mouseclick. 

Access in Runtime: Read and write

Syntax
Object.OperationSteps[=Int]

Object
Required A ""ScreenItem" object with the format "WindowSlider".

Int
Optional A value or a constant which specifies by how many steps the slider of the scrollbar 
is moved with one mouseclick.

See also
WindowSlider (Page 5176)

OperatorMessageID

Description
Specified assignment of ID number and trigger event in the message view.   

Syntax
Object.OperatorMessageID[=MessageID]

Object
Required A "ScreenItem" object with the format "AlarmControl".
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MessageID

Value Description Description
0 Lock Trigger event "Lock"
1 Unlock "Unlock" Trigger Event
2 Hide Trigger event "Hide"
3 Unhide Trigger event "Unhide"
4 Ackn Trigger event "Acknowledge"

See also
AlarmControl (Page 4981)

OperatorMessageIndex

Description
References an operator message event. You can assign the values of other properties to a 
specific operator message by using the property.   

Syntax
Object.OperatorMessageIndex [=MessageIndex]

Object
Required A "ScreenItem" object with the format "AlarmControl".

MessageIndex

Value Description
0 Message event "Lock"
1 "Unlock" Message Event
2 Message event "Hide"
3 Message event "Unhide"
4 Message event "Acknowledge"

See also
AlarmControl (Page 4981)
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OperatorMessageName

Description
Indicates the name which is referenced with the "OperatorMessageIndex" in message events 
for operator messages. You cannot edit this name.   

Syntax
Object.OperatorMessageName[=Name]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Name

Value Description
Lock Message event "Lock"
Unlock Message event "Enable"
Hide Message event "Hide"
Unhide Message event "Unhide"
Quit Message event "Ackn."

See also
AlarmControl (Page 4981)

OperatorMessageNumber

Description
Specify a message number for the operator message of the selected message event if you do 
not use the operator message of WinCC.   

Syntax
Object.OperatorMessageNumber

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)
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OperatorMessageSelected

Description
Activate the message events which trigger operator messages in the list.   

Syntax
Object.OperatorMessageSelected

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)

OperatorMessageSource1

Description
Define the message block of an operated message to be added to "Process value block 1" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 1" of the operator message. Select "1" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource1

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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OperatorMessageSource2

Description
Define the message block of an operated message to be added to "Process value block 2" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 2" of the operator message. Select "2" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource2

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

OperatorMessageSource3

Description
Define the message block of an operated message to be added to "Process value block 3" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 3" of the operator message. Select "3" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource3

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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OperatorMessageSource4

Description
Define the message block of an operated message to be added to "Process value block 4" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 4" of the locked message, e.g. "Motor faulty" should be displayed in "Process 
value block 4" of the operator message. Select "4" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource4

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

OperatorMessageSource5

Description
Define the message block of an operated message to be added to "Process value block 5" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 5" of the operator message. Select "User text block 1" under process value "5" as 
the message block of the operated message.   

Syntax
Object.OperatorMessageSource5

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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OperatorMessageSource6

Description
Define the message block of an operated message to be added to "Process value block 6" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 6" of the operator message. Select "6" at process value as the message lock of 
the operated message "User text block 1".

Syntax
Object.OperatorMessageSource6

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

OperatorMessageSource7

Description
Define the message block of an operated message to be added to "Process value block 7" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 7" of the operator message. Select "7" at process value as the message lock of 
the operated message "User text block 1".

Syntax
Object.OperatorMessageSource7

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)
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OperatorMessageSource8

Description
Define the message block of an operated message to be added to "Process value block 8" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 8" of the operator message. Select "8" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource8

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

OperatorMessageSource9

Description
Define the message block of an operated message to be added to "Process value block 9" of 
the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 9" of the operator message. Select "9" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource9

Object
Required A "ScreenItem" object with the format "AlarmControl".

See also
AlarmControl (Page 4981)
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OperatorMessageSource10

Description
Define the message block of an operated message to be added to "Process value block 10" 
of the operator message configured in Source.

An operator message is to be generated to indicate that a message was locked. The content 
of "User text block 1" of the locked message, e.g. "Motor faulty", is to be displayed in "Process 
value block 10" of the operator message. Select "10" at process value as the message lock of 
the operated message "User text block 1".   

Syntax
Object.OperatorMessageSource10

Object
Required A "ScreenItem" object with the format "AlarmControl".

 

See also
AlarmControl (Page 4981)

OperatorMessageSourceType1

Description
Specifies the format of the source content for the transfer.   

Syntax
Object.OperatorMessageType1[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Description
0 Text Transfer the source content in text format.
1 Value Transfer the source content as value.

See also
AlarmControl (Page 4981)
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OperatorMessageSourceType2

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType2[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)

OperatorMessageSourceType3

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType1[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)
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OperatorMessageSourceType4

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType4[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)

OperatorMessageSourceType5

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType5[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)
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OperatorMessageSourceType6

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType6[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)

OperatorMessageSourceType7

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType7[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)
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OperatorMessageSourceType8

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType8[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)

OperatorMessageSourceType9

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType9[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)
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OperatorMessageSourceType10

Description
Specifies in what format the content of the source is transferred.   

Syntax
Object.OperatorMessageType10[=Type]

Object
Required A "ScreenItem" object with the format "AlarmControl".

Type

Value Description Explanation
0 Text The content of the source is transferred as a text.
1 Value The content of the source is transferred as a value.

See also
AlarmControl (Page 4981)

Orientation

Description
Specifies the text direction (orientation) of the selected object. 

Access in Runtime: Read and write

Syntax
Object.Orientation[=TextOrientation]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "Bar", "OnlineTrendControl", "FunctionTrendControl", 
"Checkbox", "OptionGroup" or "WindowSlider".

TextOrientation
hmiTextHorizontal ( 0): The text is shown horizontally.

hmiTextRotated90Degree (-1): The text is shown vertically and left justified.

hmiTextRotated270Degree ( 1): The text is shown vertically and right justified.
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See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

Bar (Page 4995)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

OutputFormat

Description
Returns the value for the representation of the output value. The representation is dependent 
on the data format. Read only access.

OutputValue

Description
Determines the default setting for the value to be displayed or returns it.
This value is used in Runtime when the associated tag cannot be connected or updated when 
a picture is started.

PageMode

Description
Enables paging is in the long-term archive list. Allows you to display all messages of the short-
term archive in the long-term archive list. Use the "Messages per page" property to determine 
the number of messages output per page.

The page up/down buttons of the toolbar can be used if paging is enabled.   

Syntax
Object.PageMode[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
TRUE: Scrolling in the long-term log list is possible.

FALSE: Scrolling in the long-term log list is not possible.

See also
AlarmControl (Page 4981)

PageModeMessageNumber

Description
Defines the number of messages shown per page when paging the long-term archive list.   

Syntax
Object.PageModeMessageNumber

Object
Required A "ScreenItem" object with the format "AlarmContro".

BOOLEAN
Optional TRUE, if the dialog box is shown in Runtime.

See also
AlarmControl (Page 4981)

Parent

Description
Returns the screen in which the specified object is embedded. 

Access in Runtime: Read

Syntax
Object.Parent

Object
Required A "ScreenItem" object. This property is a standard property of the ScreenItem object 
and is therefore available for all formats.
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Application example
The following example writes the name of the root screen in "BaseScreenName" tag:

 
'VBS_Example_Parent
Dim objScrItem, BaseScreenName
Set objScrItem = HMIRuntime.Screens(1).ScreenItems(1)
BaseScreenName = "Name of BaseScreen: " & objScrItem.Parent.ObjectName

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)
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CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

Path 

Description 
Returns the path of the current project without the file names as STRING. For a WinCC client 
without its own path, the path is returned in UNC format, otherwise the local path is returned. 

Access during runtime: Read

Syntax
Object.Path

Object
Necessary. A "Project" object. 

Example
The following example returns the project path as Trace:

 
'VBS161
HMIRuntime.Trace "Path: " & HMIRuntime.ActiveProject.Path & vbNewLine

See also
Project (Page 4963)

Password

Description
Determines the password for the loading of the remote monitor. 
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Access during runtime: Read and Write

Syntax
Object.Password = [STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "SmartClientView." 

STRING
Optional. A value or constant which contains the password.

See also
SmartClientView (Page 5123)

PersistentRTAuthorization

Description
Specifies the authorization for operators which is necessary to change the persistence setting 
in Runtime. The value to be entered corresponds to the number which has the desired 
authorization in the user administration. Whether the information is evaluated depends on the 
value of the property "AllowPersistance". This does not apply for the message view.

Access in Runtime: Read and write

Syntax
Object.PersistentRTAuthorization[=RtAuthorization]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "FunctionTrendControl" or "OnlineTableControl".

RtAuthorization
Optional A value or a constant that specifies the authorization for operators to change the 
persistence setting. 

See also
AlarmControl (Page 4981)
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PersistentRTCSAuthorization

Description
Specifies the operator authorization to be able to change the persistence setting in Runtime. 
The value to be entered corresponds to the number which has the desired authorization in the 
user administration. Whether the information is evaluated depends on the value of the property 
"AllowPersistance". This does not apply for the message view.

Access in Runtime: Read and write

Syntax
Object.PersistentRTCSAuthorization[=RtAuthorization]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "FunctionTrendControl" or "OnlineTableControl".

RtAuthorization
Optional A value or a constant that specifies the operator authorization to change the 
persistence setting. 

See also
AlarmControl (Page 4981)

PersistentRuntime

Description
Specifies whether changed settings in the window will also be maintained after a screen 
change. 

Access in Runtime: Read and write

Syntax
Object.PersistentRuntime[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" oder "OnlineTableControl".

BOOLEAN
Optional. TRUE, if changed settings in the window will also be maintained after a screen 
change.
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Comments
The "AllowPersistance" property specifies whether the information will be evaluated.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

PersistentRuntimeAuthorization

Description
Specifies the access authorization to change the persistence setting in Runtime. The value to 
be entered corresponds to the number which has the desired authorization in the user 
administration.   

Access in Runtime: Read and write

Syntax
Object.PersistentRuntimeAuthorization[=HmiRTAuthorization]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

HmiRTAuthorization
Optional A value or a constant that specifies the access authorization required to change the 
persistence setting in Runtime.

Comments
The "AllowPersistance" property specifies whether the information will be evaluated. This does 
not apply for the message view.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)
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PersistentToDownload 

Description
Specifies whether the settings will be maintained until the next ES download. 

Access in Runtime: Read and write

Syntax
Object.PersistentToDownload[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the settings will be maintained until the next ES download.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

PersistentToDownloadAuthorization

Description
Specifies the access authorization required to change the settings until the next ES download. 

Access in Runtime: Read and write

Syntax
Object.PersistentToDownloadAuthorization[=HmiRTAuthorization]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

HmiRTAuthorization
Optional A value or a constant that specifies the access authorization required to change the 
settings until the next ES download.
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

PicAlignment

Description
Specifies the alignment within the specified object.

PicDeactReferenced

Description
TRUE, when the picture assigned for the "Disable" status should be saved in the RoundButton 
object. Otherwise, only the associated object reference is saved. Read only access.

PicDeactTransparent

Description
Defines or returns which color of the bitmap object (.bmp, .dib) assigned to the "Disabled" 
status should be set to "transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicDeactUseTransColor" property is 
"True".

PicDeactUseTransColor

Description
TRUE, when the transparent color defined by the "PicDeactTransparent" property for the 
"Disable" status should be used. BOOLEAN write-read access.

PicDownReferenced

Description
TRUE, when the picture assigned for the "On" status is to be saved. Otherwise, only the 
associated object reference is saved. Read only access.
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PicDownTransparent

Description
Defines or returns which color of the bitmap object (.bmp, .dib) assigned to the "On" status 
should be set to "transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicDownUseTransColor" property is 
"True". 

PicDownUseTransColor

Description
TRUE, when the transparent color defined by the "PicDownTransparent" property for the "On" 
status should be used. BOOLEAN write-read access.

PicReferenced

Description
TRUE, when the assigned picture is references the object and is not saved in it. Read only 
access. 

PicTransColor

Description
Defines or returns which color of the assigned bitmap object (.bmp, .dib) should be set to 
"transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicUseTransColor" property is "True".

Picture

Description
Specifies the screen that will be displayed in the graphics object in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Picture[=Image]

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5486 System Manual, 02/2014



Object
Required A ""ScreenItem" object with the formats "GraphicView", "Clock"" or 
""SymbolLibrary".".

Image
Optional A value or a constant that specifies the screen that will be displayed in the graphics 
object in Runtime.

Comments
The picture (*.BMP or *.DIB) must be located in the "GraCS" folder of the current project so 
that it can be integrated.

See also
GraphicView (Page 5052)

Clock (Page 5018)

SymbolLibrary (Page 5135)

PictureAlignment

Description 
Defines or returns the mode of representation of the background image in the process picture. 

LONG write-read access. 

 

See also
Button (Page 5002)

RoundButton (Page 5112)

PictureDeactivated

Description
Specifies the picture that is displayed in the "Deactivated" state.     

Access during runtime: Read and write

Syntax
Object.PictureDeactivated[=Image]
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Object
Required A ""ScreenItem" object with the format ""Roundbutton".

Image
Optional A value or a constant that specifies the picture that will be displayed in the 
"Deactivated" status. 

Comments
The picture must be located in the "GraCS" folder of the current project in order to integrate it.

PictureName

Description
Defines the path and file name of the background image in the process picture or returns it. 
LONG write-read access. 

PictureOff

Description
Specifies the picture that is displayed in the "Off" status.     

Access during runtime: Read and write

Syntax
Object.PictureOff[=Image]

Object
Required A "ScreenItem"" object with the formats ""Button", ""Roundbutton", "Switch"" or 
"GraphicIOField".

Image
Optional A value or a constant that specifies the picture that will be displayed in the "Off" status.

Comments
The picture (*.BMP or *.DIB) must be in the "GraCS" folder of the current project so that you 
can integrate it.
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See also
Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

PictureOn

Description
Specifies the screen that will be displayed in the "on" state.   

Access in Runtime: Read and write

Syntax
Object.PictureOn[=Image]

Object
Required A "ScreenItem" object with the formats "Button", "Roundbutton", "Switch" or 
"GraphicIOField".

Image
Optional A value or a constant that specifies the screen that will be displayed in the "on" state. 

Comments
The screen (*.BMP or *.DIB) must be in the "GraCS" folder of the current project in order to 
be able to integrate it. 

See also
Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

PictureUp

Description
Defines the picture to be displayed in the "Off" status or returns the picture name. 
The picture (*.BMP or *.DIB) must be located in the "GraCS" folder of the current project so 
that it can be integrated.
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PicUpReferenced

Description
TRUE, when the picture assigned for the "Off" status should be saved in the object. Otherwise, 
only the associated object reference is saved. Read only access.

PicUpTransparent

Description
Defines or returns which color of the bitmap object (.bmp, .dib) assigned to the "Off" status 
should be set to "transparent". LONG Write/Read Access.
The color is only set to "Transparent" if the value of the "PicUpUseTransColor" property is 
"True".

PicUpUseTransColor

Description
TRUE, when the transparent color defined by the "PicUpTransparent" property for "Off" status 
should be used. BOOLEAN write-read access.

PicUseTransColor

Description
TRUE, when the transparent color defined by the "PicDeactTransparent" property for the 
"Disable" status should be used. BOOLEAN write-read access. 

Pinned

Description
Defines whether the display of the picture window in Runtime depends on the process picture 
in which the picture window was configured. 

PointCount

Description
Defines or returns the number of corner points. Each corner point has position coordinates 
and is identified via an index.
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PointerColor

Description
Specifies the pointer color of the "Gauge" object. 

Access during runtime: Read and Write

Syntax
Object.PointerColor[= Color]

Object
Required An object of the ""ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the pointer color.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 5046)

PointsCount

Description
Specifies the number of corner points of the polyline or of the polygon. 

Access in Runtime: Read and write

Syntax
Object.PointsCount[=Int]

Object
Required A "ScreenItem" object with the formats "Polyline" or "Polygon".

Int
Optional A value or a constant that specifies the number of corner points of the polyline.
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See also
Polyline (Page 5098)

Polygon (Page 5095)

TubePolyline (Page 5162)

Position

Description
Defines the presetting for the position of the slider.

This value is used as the start value in Runtime.

To operate the process value linked to this attribute, it is necessary that the process value is 
also linked to the "Position" event. You will find the event "Position" in the "Event" tab, in the 
topic tree under SliderCtrl\Property Topics\Control Properties\Value.

Precision

Description
Specifies the number of decimal places (0 to 20). 

Access in Runtime: Read and write

Syntax
Object.Precision[=Int]

Object
Required A "ScreenItem" object with the format "Bar".

Int
Optional A value or a constant that specifies the number of decimal places (0 to 20).

See also
Bar (Page 4995)

PredefinedAngles

Description
Defines or returns the depth of the display of the 3DBarGraph object. Value range from 0 to 3.

0 = cavalier
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1 = isometric

2 = axionometric

3 = freely defined

Pressed 

Description
Specifies whether the selected object is displayed in a pressed state. 

Access in Runtime: Read and write

Syntax
Object.Pressed[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Roundbutton".

BOOLEAN
Optional TRUE, if the selected object is displayed in a pressed state.

See also
Button (Page 5002)

PrintConfiguration

Description
Specifies the log for the printout.   

Access in Runtime: Read and write

Syntax
Object.PrintConfiguration[=HMIPrintConfiguration]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "OnlineTableControl", "AlarmControl" or "UserArchiveControl".

HMIPrintConfiguration
Optional A value or a constant which specifies the log for the printout. 
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

PrintJobName

Description
Defines the print job triggered by the print function of the "Print" toolbar button. The 
recommended print job is set for the control by default. 

Open the "Select Print Job" dialog using the selection button.   

Syntax
Object.PrintJobName]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"FunctionTrendControl", "OnlineTableControl", "OnlineTrendControl", "TrendRulerControl", 
"UserArchiveControl".

See also
AlarmControl (Page 4981)

PrintVisibleColumnsOnly

Description
Specifies whether only the current visible columns should be output in quick print. 

Access in Runtime: Read and write

Syntax
Object.PrintVisibleColumnsOnly[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if only the current visible columns should be output in quick print.
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Process

Description
Defines or returns presetting for the value to be displayed. 
This value is used in Runtime when the associated tag cannot be connected or updated when 
a picture is started.

Processvalue

Description
Specifies the default for the value to be displayed. 

This value will be used in runtime if the associated tag is not connected or has not been updated 
when the screen starts.   

Access during runtime: Read and write

Syntax
Object.Processvalue[=DOUBLE]

Object
Necessary. A "ScreenItem" object with the formats "IOField", "SymbolicIOField", 
"DateTimeField", "Button", "Switch", "GraphicIOField", "Bar", "Gauge", "Slider", 
"SymbolLibrary", "CheckBox", "OptionGroup"" or "WindowSlider".

DOUBLE
Optional A value or a constant that includes the default value. 

Comments
If you want to assign the "ProcessValue" SmartTags property, then you must formulate the 
assignment as follows:

'Examples for the assignment of SmartTags

 
'Example 1
IOField.ProcessValue = SmartTags("TagName").Value
'Example 2
HmiRuntime.Screens("Screen_1").ScreenItems("IOField_1").ProcessValue = 
SmartTags("Tag_1").Value
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See also
IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicIOField (Page 5049)

Bar (Page 4995)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

DateTimeField (Page 5023)

Processvalue

Description
Defines the presetting for the value to be displayed. 

This value is used in runtime when a screen is started and the associated tag has not been 
connected nor updated. 

Access during runtime: Read and Write

Syntax
Object.Processvalue [=DOUBLE]

Object
Required. An object of the "ScreenItem" type with the characteristic "Bar," "Gauge", "IOField" 
or "Slider". 

DOUBLE
Optional. A value or constant which contains preset the Web address. 

Remarks
To assign SmartTags to the "ProcessValue" property, you must formulate the assignment as 
follows:

Examples of the assignment of SmartTags
'Example 1
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IOField.ProcessValue = SmartTags("TagName").Value
'Example 2
HmiRuntime.Screens("Screen_1").ScreenItems("IOField_1").ProcessValue
 = SmartTags("Tag_1").Value

See also
SymbolLibrary (Page 5135)

Button (Page 5002)

Switch (Page 5127)

ProgID

Description
In the case of non-WinCC controls, the version-independent ProgID is returned as the type.

See also
ForeignControl (Page 5034)

ProjectPath 

Description
Contains the path and name of the associated project. 

Access in Runtime: Read-only

Syntax
Object.ProjectPath[=String]

Object
Required A "ScreenItem" object with the format "AlarmControl".

String
Optional A value or a constant that specifies which path and name the associated project will 
contain. 

See also
AlarmControl (Page 4981)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5497



Properties Q-R

QualityCode

Description 
Returns the quality of a tag value after reading the tag as SHORT. After a tag has been written, 
the value is invalid. 

Access during runtime: Read

Syntax
Object.QualityCode

Object
Necessary. An object of the "HMIRuntime" type. 

Example
The following example indicates the quality of the read value when no errors have occurred 
during the reading process:

 
'VBS83
Dim objTag
Dim lngLastErr
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
lngLastErr = objTag.LastError
If 0 = lngLastErr Then
MsgBox objTag.QualityCode
End If

See also
Tag (Page 4975)

Radius

Description
Determines the radius of the given object "Circle."

Access during runtime: Read and Write
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Syntax
Object.Radius [= LONG]

Object
Required. An object of the "ScreenItem" type with the characteristic "Circle".

LONG
Optional. A value or constant which determines the radius in pixels.

Radius

Description
Specifies the radius of the selected object "Circle".

Access in Runtime: Read and write

Syntax
Object.Radius[= LONG]

Object
Required An object of the "ScreenItem" type with the format "Circle", "CircleSegment", 
"CircularArc" or "Roundbutton".

LONG
Optional A value or a constant that specifies the radius in pixels.

See also
Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Example of accessing objects in the Screens editor (Page 4508)

RadiusHeight

Description
Determines the secondary axis of the object "Ellipse". 

Access during runtime: Read and Write
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Syntax
Object.RadiusHeight

Object
Required. An object of the "ScreenItem" type with the characteristic "Ellipse."

LONG
Optional. A value or constant which determines the secondary axis in pixels.

RadiusHeight 

Description
Specifies the minor axis of the ""Ellipse" object. 

Access in Runtime: Read and write

Syntax
Object.RadiusHeight

Object
Required A "ScreenItem" object with the formats "Ellipse", "EllipseSegment" or "EllipticalArc".

LONG
Optional A value or a constant that specifies the minor axis in pixels.

See also
Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

TubeArcObject (Page 5158)

RadiusWidth

Description
Determines the main axis of the object "Ellipse". 

Access during runtime: Read and Write

Syntax
Object.RadiusWidth
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Object
Required. An object of the "ScreenItem" type with the characteristic "Ellipse."

LONG
Optional. A value or constant which determines the main axis in pixels.

 

RadiusWidth

Description
Specifies the major axis of the "Ellipse" object. 

Access in Runtime: Read and write

Syntax
Object.RadiusWidth

Object
Required A "ScreenItem" object with the formats "Ellipse", "EllipseSegment" or "EllipticalArc".

LONG
Optional A value or a constant that specifies the major axis in pixels.

See also
Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

TubeArcObject (Page 5158)

ReadOnly

Description
Specifies whether the Control has read and write access in Runtime. 

Access in Runtime: Read and write

Syntax
Object.ReadOnly[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the Control has read and write access in Runtime.

RecipeName

Description
Returns the name of the recipe that is currently being displayed in the "RecipeView". 

Access in Runtime: Read

Syntax
Object.RecipeName

Object
Required A "ScreenItem" object with the format "RecipeView".

RecipeNumber

Description
Returns the number of the recipe that is currently being displayed in the "RecipeView". 

Access in Runtime: Read

Syntax
Object.RecipeNumber

Object
Required A "ScreenItem" object with the format "RecipeView"".

RecordName

Description
Returns the name of the recipe data record that is currently being displayed in the 
"RecipeView". 

Access in Runtime: Read
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Syntax
Object.RecordName

Object
Required A "ScreenItem" object with the formats "RecipeView" or "PrintRecipe".

RecordNumber

Description
Returns the number of the recipe data record that is currently being displayed in the 
"RecipeView". 

Access in Runtime: Read

Syntax
Object.RecordNumber

Object
Required A "ScreenItem" object with the format "RecipeView".

ReferenceRotationLeft

Description
Defines or returns the X-coordinate of the reference point about which the object should be 
rotated in Runtime. 
The value of the x coordinate is relative to the object width. Enter the value in percent starting 
from the left edge of the rectangle enclosing the object.

ReferenceRotationTop

Description
Defines or returns the Y-coordinate of the reference point about which the object should be 
rotated in Runtime. 

The value of the Y-coordinate is relative to the object height. Enter the value in percent starting 
from the top edge of the rectangle enclosing the object.

RelativeFillLevel

Description
Specifies the fill percentage for the object. 
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Access in Runtime: Read and write

Syntax
Object.RelativeFillLevel[=Int]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "Button", "Roundbutton", 
"GraphicView", "Checkbox", "OptionGroup" or "WindowSlider".

Int
Optional A value or a constant that specifies the fill percentage of the object.

See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

Button (Page 5002)

GraphicView (Page 5052)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Relevant property 

Description
TRUE, when the object will be taken into account when forming the group display. BOOLEAN 
write-read access.

RemoveAssignment

Description 
Removes an entry. 
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RemoveAllAssignment

Description 
Deletes all entries.

RightComma property 

Description
Defines or returns the number of decimal places (0 to 20).

Rotation

Description
Specifies the angle of rotation in degrees of the selected object. The angle of rotation is 
measured counterclockwise. 

Access in Runtime: Read and write

Syntax
Object.Rotation[=SymbolLibRotation]

Object
Required A "ScreenItem" object with the format "SymbolLibrary".

SymbolLibRotation
hmiSymbolLibraryRotationNone ( 0): The object rotates by 0 degrees.

hmiSymbolLibraryRotation90Degree ( 90): The object rotates by 90 degrees.

hmiSymbolLibraryRotation180Degree ( 180): The object rotates by 180 degrees.

hmiSymbolLibraryRotation270Degree ( 270): The object rotates by 270 degrees.

See also
SymbolLibrary (Page 5135)

RotationAngle

Description
Specifies the angle of rotation in degrees. 

Access in Runtime: Read and write
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Syntax
Object.RotationAngle[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Polygon" or "TextField".

Int
Optional A value or a constant that specifies the angle of rotation in degrees. 

Comments
In Runtime the object rotates clockwise on the reference point.

See also
Line (Page 5063)

Polyline (Page 5098)

Polygon (Page 5095)

TextField (Page 5144)

TubeTeeObject (Page 5165)

RotationCenterLeft

Description
Establishes the X coordinates of the pivot point to rotate the object in Runtime. 

Access in Runtime: Read and write

Syntax
Object.RotationCenterLeft[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Polygon"" or "TextField".

Int
Optional A value or a constant that specifies the X coordinates of the pivot point to rotate the 
object in runtime.

Comments
The value of the X coordinate is relative to the object width. Specify the value as a percentage 
from the left edge of the rectangle that surrounds the object.
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See also
Line (Page 5063)

Polyline (Page 5098)

Polygon (Page 5095)

TextField (Page 5144)

RotationCenterTop

Description
Specifies the Y coordinates of the pivot point to rotate the object in Runtime. 

Access in Runtime: Read and write

Syntax
Object.RotationCenterTop[=Int]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Polygon" or "TextField".

Int
Optional A value or a constant that specifies the Y coordinates of the pivot point to rotate the 
object in Runtime.

Comments
The value of the Y coordinate is relative to the object width. Specify the value as a percentage 
from the upper edge of the rectangle that surrounds the object.

See also
Line (Page 5063)

Polyline (Page 5098)

Polygon (Page 5095)

TextField (Page 5144)

RoundCornerHeight

Description
Defines or returns the corner radius. 
Enter the value as a percentage of half the height of the object.
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See also
Rectangle (Page 5110)

RoundCornerWidth

Description
Defines or returns the corner radius. 
Enter the value as a percentage of half the width of the object. 

See also
Rectangle (Page 5110)

RowNumber

Description
Specifies the row number of the Row object of a Table Control.

See also
AlarmControl (Page 4981)

RowScrollbar

Description
Enables the display of row scroll bars.   

Syntax
Object.RowScrollbar[=ScrollbarVisibility]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl".
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ScrollbarVisibility

Value Description Description
0 no No row scroll bars.
1 as required Row scroll bars are displayed if horizontal space requirements of the 

control are greater than the actually available display area. 
2 always Row scroll bars are always displayed.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

RowSizingEnable 

Description
Specifies whether the row height can be changed. 

The "RowSizingEnable" property is then only disabled if both properties "RowSizingEnable" 
and "AdaptFontSizeToLineHeight" have the value FALSE.   

Access in Runtime: Read and write

Syntax
Object.RowSizingEnable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the row height can be changed.

See also
AlarmControl (Page 4981)

RowTitleAlign

Row label alignment - RowTitleAlign
Specifies the type of row label alignment.
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The following settings are available:

Value Description Description
0 left The row headers are aligned left.
1 centered The row headers are aligned to center.
2 right The row headers are aligned right.

The attribute can be assigned dynamic properties by means of the name RowTitleAlign.

See also
AlarmControl (Page 4981)

RTPersistence

Description
Specifies how online configurations of WinCC are retained.     

Syntax
Object.RTPersistence[=RTPersistence]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl" (Runtime Professional) or 
"HMITrendView" (Runtime Advanced).

RTPersistence

Value Description Explanation
0 Discard The current online configurations are discarded at the next picture change.
1 Retain The current online configurations are retained at the next picture change.
2 Reset All online configurations made are lost. The picture is set to the contents 

found in the configuration system.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)
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RTPersistencePasswordLevel

Description
Displays the authorization for online configuration. You can edit the authorization using the 
selection button. Authorizations are configured in the user administration.     

Syntax
Object.RTPersistencePasswordLevel

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl" (Runtime Professional) or 
"HMITrendView" (Runtime Advanced).

See also
AlarmControl (Page 4981)

RTPersistenceType

Description
Specifies how online configurations of WinCC are retained.     

Syntax
Object.RTPersistenceType[=RTPersistenceType]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTrendControl", "TrendRulerControl" or "OnlineTableControl" (Runtime Professional) or 
"HMITrendView" (Runtime Advanced).

RTPersistenceType

Value Description Explanation
0 Do not retain Online configurations are not retained. These are lost at 

the next picture change.
1 Retain during runtime Online configurations are retained during runtime. These 

are lost on exiting.
2 Retain permanently Online configurations are retained permanently. These 

are also available after restart.
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See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

RulerColor

Description
Specifies the color of the scale gradation (help line) of the axis label in the "OnlineTrendControl" 
object.     

Access in Runtime: Read and Write

Syntax
Object.RulerColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" (Runtime 
Professional) or "HMITrendView" (Runtime Advanced).

Color
Optional A value or a constant that specifies the color of the scale gradation.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
TrendView (Page 5155)

RulerPrecision(i)

Description
Specifies the number of decimal places with which a measurement value of the specified trend 
will be displayed if it is measured via the function "Display value here". 
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Access in Runtime: Read and write

Syntax
Object.RulerPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

Int
Optional A value or a constant that specifies the number of decimal places with which a 
measurement value of the specified trend will be displayed if it is measured via the function 
"Display value here".

See also
OnlineTrendControl (Page 5083)

RulerXPrecision(i)

Description
Specifies the number of decimal places with which a measurement value of the X coordinate 
will be displayed. Whether the information is evaluated depends on the value of the property 
"XAxisMode(i)". 

Access in Runtime: Read and write

Syntax
Object.RulerXPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of decimal places with which a 
measurement value of the X coordinate will be displayed.

Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the X coordinate of the measurement value.

See also
FunctionTrendControl (Page 5038)
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RulerYPrecision(i) 

Description
Specifies the number of decimal places with which a measurement value of the Y coordinate 
will be displayed. Whether the information is evaluated depends on the value of the property 
"XAxisMode(i)".".

Access in Runtime: Read and write

Syntax
Object.RulerYPrecision(i)[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of decimal places with which a 
measurement value of the Y coordinate will be displayed. 

Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the Y coordinate of the measurement value.

See also
FunctionTrendControl (Page 5038)

Properties S

SameSize

Description
TRUE, when all four buttons of a Group Display object have the same size. BOOLEAN write-
read access.

ScaleColor

Description
Specifies the color of the scale of the selected object.     

Access in Runtime: Read and write
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Syntax
Object.ScaleColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "Bar" or "OnlineTrendControl" 
(Runtime Professional) or "HMITrendView" (Runtime Advanced).

Color
Optional A value or a constant that specifies the color of the scale.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBS color 
constants like vbRed or vbGreen.

ScreenItem object with the format "Bar": For the color to be displayed, the property 
""ShowScale" must have the value TRUE.

See also
Bar (Page 4995)

TrendView (Page 5155)

ScaleGradation 

Description
Specifies the distance between two large marking lengths of the scale. 

Access in Runtime: Read and write

Syntax
Object.ScaleGradation[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the distance between two large marking lengths 
of the scale.

See also
Bar (Page 4995)
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ScaleLabelColor

Description
Specifies the color of the label for the scale gradation of the "Gauge" object. 

Access during runtime: Read and Write

Syntax
Object.ScaleLabelColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Gauge".

Color
Optional A value or a constant that specifies the label color of the scale gradation.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Gauge (Page 5046)

ScaleNumerator

Description
Defines the counter for scaling on the client.   

Syntax
Object.ScaleNumerator =[Int]

Object
Required A "ScreenItem" object with the format "SmartClientView".

Int
Optional A value or a constant that specifies the value.
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See also
SmartClientView (Page 5123)

ScalePosition

Description
Specifies the position of the scale of the selected object. The "ShowScale" property must be 
set to TRUE  so that the scale can be displayed. 

Access in Runtime: Read and write

Syntax
Object.ScalePosition[=ScalePosition]

Object
Required A "ScreenItem" object with the format "Bar".

ScalePosition
hmiScalePositionLeftUp ( 0): For a vertical bar the scale will be displayed at the top. For a 
horizontal bar the scale will be shown at the left.

hmiScalePositionRightDown ( 1): For a vertical bar the scale will be displayed at the bottom. 
For a horizontal bar the scale will be shown at the right.

See also
Bar (Page 4995)

ScaleTickColor

Description
Specifies the color of the scale gradation of the "Gauge" object. 

Access in Runtime: Read and write

Syntax
Object.ScaleTickColor[= Color]

Object
Required A "ScreenItem" object with the format "Gauge".

Color
Optional A value or a constant that specifies the color of the scale gradation.
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Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Gauge (Page 5046)

ScaleTickLabelPosition

Description
Specifies the diameter of the assumed circle on which the label of the scale divisions is located. 

Access in Runtime: Read and write

Syntax
Object.ScaleTickLabelPosition[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the diameter of the assumed circle on which the 
label of the scale division is located. 

Value range from 0 to 1

0: The label is located in the center of the scale.

1: The diameter of the assumed circle for the label is the smaller value of the geometry 
properties "Width" and "Height". A part of the label can lie outside the object limits and is 
therefore invisible.

See also
Gauge (Page 5046)

ScaleTickLength

Description
Specifies the length of the main markings for the scale division. The value refers to half the 
smaller value of the geometry properties "Width" and "Height".

The length of the marking lengths for the fine divisions is 0.5* scale width. 
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Access in Runtime: Read and write

Syntax
Object.ScaleTickLength[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the length of the main markings of the scale.

Value range 0 to scale end value 

0: There are no scale divisions. The divisions of the scale in the areas are not visible. 

Scale end value: The scale divsion ranges from the mid point of the scale disc to the value 
specified by the scale end value.

See also
Gauge (Page 5046)

ScaleTickPosition

Description
Specifies the diameter of the assumed circle on which the scale divisions are located. 

The main markings of the scale divisions lie with their outward-facing ends on this circle. 

Access in Runtime: Read and write

Syntax
Object.ScaleTickPosition[=Double]

Object
Required A "ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the diameter of the assumed circle on which the 
scale divisions are located. 

Value range from 0 to 1 

0: The scale divisions are located in the center of the scale. 

1: The diameter of the assumed circle for the label is the scale divisions is the smaller value 
of the geometry properties ""Width" and "Height".
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See also
Gauge (Page 5046)

ScaleTicks

Description
Defines the number of segments into which the bar will be subdivided by large tick marks of 
the scale:
0-100: Object can be divided into a maximum of 100 segments
= 0: The optimum number of segments is set automatically.

ScaleDenumerator

Description
Defines the counter for scaling on the client.   

Syntax
Object.ScaleDenumerator=[Int]

Object
Required A "ScreenItem" object with the format "SmartClientView".

Int
Optional A value or a constant that specifies the value.

See also
SmartClientView (Page 5123)

Scaling

Description
TRUE, when a scale should also be used to represent a value. BOOLEAN write-read access. 

See also
SmartClientView (Page 5123)
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ScalingType 

Description
Specifies the type of bar scaling. 

Access in Runtime: Read and write

Syntax
Object.ScalingType[=BarScalingType]

Object
Required A "ScreenItem" object with the format "Bar"".

BarScalingType
Optional A value or a constant that specifies the type of bar scaling.

● hmiBarScalingLinear ( 0): Linear
The large marks are distributed evenly over the scale. The distance between the large 
marks corresponds to the value of the "axis section" attribute.

● hmiBarScalingLogarithmic ( 1): Logarithmic
The distribution of the large marks on the scale follows a logarithmic function.
The reprsentation of low values is very strongly highlighted.

● hmiBarScalingNegativeLogarithmic ( 2): Negative logarithmic
The distribution of the large marks on the scale follows a negative logarithmic function. The 
representation of high values is very strongly highlighted.

● hmiBarScalingAutomatic ( 3): Automatic
The large marks are distributed evenly over the scale. The distance between the large 
marks is specified automatically.

● hmiBarScalingTangent ( 4): Tangents
The distribution of the large marks on the scale highlights the representation of the low and 
high values.

● hmiBarScalingQuadratic( 5): Square
The distribution of the large marks follows a square function. The representation of high 
values is highlighted.

● hmiBarScalingCubic ( 6): Cubic
The distribution of the large marks on the scale follows a cubic function. This highlights the 
representation of large values.

Comments
For the color to be displayed, the property "ShowScale" must have the value TRUE.

See also
Bar (Page 4995)
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ScreenItems

Description
Returns the ScreenItems list. 

Access in Runtime: Read

Syntax
Object.ScreenItems

Object
Required A "ScreenItems"." object.

ScreenName

Description
Defines the picture to be displayed in the picture window in Runtime or returns the picture 
name. 

 

 Note

Always enter picture names without the extension "PDL" for reasons of compatibility with 
future versions.

 

See also
Example of configuring a screen change via a property (Page 4510)

ScreenWindow (Page 5116)

Screens

Description
Returns the Screens list. The Screens list contains two elements: The first element with the 
index 0 represents the permanent window. The second element with the index 1 represents 
the root screen. Alternatively, the two elements can be addressed by means of their names. 
Use "Overview" for the permanent window and "Base" for the root screen. 

Note

The alarm window and the alarm indicator are not contained in the Screens list, even if they 
have the focus in Runtime.

Access in Runtime: Read
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Syntax
Object.Screens

Object
Required A "Screens" object.

See also
Example of defining object colors (Page 4508)

Scrollable

Description
Specifies whether the DXF screen display supports the Scroll functions in Runtime mode. 

Access in Runtime: Read and write

Syntax
Object.Scrollable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "DXFView".

BOOLEAN
Optional TRUE, if the DXF screen display supports the Scroll functions in Runtime mode.

ScrollBars

Description
TRUE, when the object is equipped with a scroll bar in Runtime. Read only access.

ScrollPositionX

Description
Specifies the horizontal positioning of the scroll bar in a picture window with slider, or returns 
its value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5523



ScrollPositionY

Description
Specifies the vertical positioning of the scroll bar in a picture window with slider, or returns its 
value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

SecondNeedleHeight

Description
Specifies the length of the second hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.SecondNeedleHeight[= LONG]

Object
Required A ""ScreenItem" object with the format "Clock".

LONG
Optional A value or a constant that specifies the length of the second hand.

Specify the length of the second hand as a percentage relating to the radius of the clock face.

See also
Clock (Page 5018)

SecondNeedleWidth

Description
Specifies the width of the second hand in the "Clock" object. 

Access in Runtime: Read and write

Syntax
Object.SecondNeedleWidth[= LONG]
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Object
Required An object of the type "ScreenItem" with the definition "Clock".

LONG
Optional A value or a constant that specifies the width of the second hand. Specify the width 
as a percentage relating to double the length of the second hand.

See also
Clock (Page 5018)

SegmentColoring

Description
Specifies the type of color change that should be displayed in the "Bar" if the limits are 
exceeded. 

Access in Runtime: Read and write

Syntax
Object.SegmentColoring[= THmiBarColorType]

Object
Required A "ScreenItem" object with the format "Bar".

THmiBarColorType
Optional A value or a constant that specifies the type of color change. Value range from 0 to 
1.

hmiBarColorEntire (0): Color change applied to the entire bar.

hmiBarColorSegmented (1): Color change applied to segments.

See also
Bar (Page 4995)

SelBGColor 

Description
Defines or returns the background color of the selected entry in a text list object. LONG write-
read access.
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SelectedText

Description
Shows the text defined with the "Selected field" (SelIndex) attribute which is highlighted in the 
combobox or list box. 

See also
Listbox (Page 5065)

SelectBackColor

Description
Specifies the background color of the selected text entry for the selected object. 

Access in Runtime: Read and write

Syntax
Object.SelectBackColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the background color of the selected text entry 
of the selected object.

See also
SymbolicIOField (Page 5130)

SelectedCellColor

Description
Specifies the background color of a selected cell. You open a color selection dialog box with 
the button.   

Access in Runtime: Read and write

Syntax
Object.SelectedCellColor=[Color]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

Color
Optional A value or a constant which specifies the background color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectedCellForeColor

Description
Specifies the font color of the selected cell. You open a color selection dialog box with the 
button.   

Access in Runtime: Read and write

Syntax
Object.SelectedCellForeColor=[Color]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

Color
Optional A value or a constant which specifies the font color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)
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SelectedIndex

Description
Defines and returns the index of which the associated text is highlighted in the combobox or 
list box. 

The maximum value is the number of lines (NumberLines) of the object. 

See also
Listbox (Page 5065)

SelectedRowColor

Description
Specifies the background color of the selected line. You open a color selection dialog box with 
the button.   

Access in Runtime: Read and write

Syntax
Object.SelectedRowColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the background color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectedRowForeColor

Description
Specifies the font color of the selected row. You open a color selection dialog box with the 
button.   
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Access in Runtime: Read and write

Syntax
Object.SelectedRowForeColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "MessageView",  
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the font color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectedTitleColor

Description
Specifies the background color of a selected table header. You open a color selection dialog 
box with the button. 

The settings are only active in Runtime if the "Marking color" option is enabled.   

Access in Runtime: Read and write

Syntax
Object.SelectedTitleColor[=Color]

 

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the background color.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectedTitleForeColor

Description
Specifies the font color of the marked table header. You open the color selection dialog box 
with the button.

The setting is only effective in Runtime when the "Marking color" option is activated.    

Access in Runtime: Read and write

Syntax
Object.SelectedTitleForeColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

Color
Optional A value or a constant which specifies the font color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectForeColor 

Description
Specifies the color of the selected text entry for the selected object. 

Access in Runtime: Read and write
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Syntax
Object.SelectForeColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the color of the selected text entry of the selected 
object.

See also
SymbolicIOField (Page 5130)

SelectionBackColor

Description
Specifies the background color of the selected cells. 

Access in Runtime: Read and write

Syntax
Object.SelectionBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl", 
"StatusForce", "OnlineTrendControl", "AlarmControl", "UserView".

Color
Optional A value or a constant that sepcifies the background color of the selected row.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
TrendView (Page 5155)
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SelectionBackColor

Description
Determines the background color of the selected cells. 

Access during runtime: Read and Write

Syntax
Object.SelectionBackColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"StatusForce", "MessageView" or "UserView".

Color
Optional A value or constant which determines the background color of the selected row.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

StatusForce (Page 5125)

UserView  (Page 5174)

SelectionColoring

Description
Enables the use of selection colors for cells or rows.   

Access in Runtime: Read and write

Syntax
Object.SelectionColoring[=GridSelectionColoring]
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Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

GridSelectionColoring:

Value Description Description
0 None No selection colors for cells and rows.
1 Cell Selection color for cell.
2 Row Selection color for row.
3 Cell and row Selection colors for cell and row.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectionForeColor

Description
Specifies the foreground color of the selected cells.   

Access in Runtime: Read and write

Syntax
Object.SelectionForeColor

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

Comments
You can use the "RGB" function to specify the color in RGB format (red, green blue). To do 
this, enter the appropriate decimal value for each of the three RGB values (range from 0 to 
255). For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the 
VBS color constants like vbRed or vbGreen.

See also
TrendView (Page 5155)
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SelectionForeColor 

Description
Determines the foreground color of the selected cells. 

Access during runtime: Read and Write

Syntax
Object.SelectionForeColor

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"StatusForce", "MessageView" or "UserView".

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

StatusForce (Page 5125)

UserView  (Page 5174)

SelectionMode

Description
Defines whether and how a message line can be selected.

.  

Access in Runtime: Read and write

Syntax
Object.SelectionMode[=Mode]

Object
Required A "ScreenItem" object with the format "MessageView".
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Mode
0 - NoSelection: Prevents the selection of a message. Acknowledgement affects the oldest 
pending message.

1 - Cell: Enables the selection of fields in the message line. Acknowledgement affects the 
selected message.

2 - Line: Enables the selection of a message line. Acknowledgement affects the selected 
message.

SelectionMode

Description
Specifies whether and how the alarm line can be selected.   

Access in Runtime: Read and write

Syntax
Object.SelectionMode[=AlarmViewAdvancedSelectionMode]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

AlarmViewAdvancedSelectionMode
hmiAlarmViewAdvancedSelectionModeNone ( 0): Prevents the selection of an alarm. An 
acknowledgement always affects the oldest pending alarm.

hmiAlarmViewAdvancedSelectionModeCell ( 1): Enables the selection of fields in the alarm 
line. An acknowledgement always effects the selected alarm.

hmiAlarmViewAdvancedSelectionModeLine ( 2): Enables the selection of an alarm line. An 
acknowledgement always effects the selected alarm.

See also
AlarmControl (Page 4981)

SelectionRect

Description
Enables the use of a selection border for selected cells or rows.   

Access in Runtime: Read and write

Syntax
Object.SelectionRect[=GridSelectionBorder]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

GridSelectionBorder.

Value Description Description
0 None No selection border is drawn for selected cells or rows.
1 Cell A selection border is drawn for the selected cell.
2 Row A selection border is drawn for the selected row.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectionRectColor

Description
Specifies the color of the rectangle in the message window if SelectionType equals "1". 

Access in Runtime: Read and write

Syntax
Object.SelectionRectColor[=Color]

Object
Required A "ScreenItem" object with the format "MessageView".

Color
Optional A value or a constant which specifies the color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)
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SelectionRectWidth

Description
Specifies the line width of the selection rectangle in the message window when the the 
SelectionType is "1".   

Access in Runtime: Read and write

Syntax
Object.SelectionRectWidth[=Int]

Object
Required A "ScreenItem" object with the format "MessageView".

Int
Optional A value or a constant which specifies the line width.

 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SelectionType

Description
Specifies the number of lines you can mark. 

The following settings are available:

Value Description Explanation
0 None No line is marked.
1 Single selection One line can be marked.
2 Multiple selection Several lines can be marked.

The attribute can be made dynamic with the name SelectionType. The data type is LONG.
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SelTextColor

Description
Defines or returns the color of the text of the selected entry in the text list object. LONG write-
read access.

SeparatorBackColor

Description
Specifies the background color of the broken separation lines in the selection list of the 
specified object. 

Access in Runtime: Read and write

Syntax
Object.SeparatorBackColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

Color
Optional A value or a constant that specifies the background color of the broken separation 
lines in the selection list of the specified object.

See also
SymbolicIOField (Page 5130)

SeparatorColor

Description
Specifies the color of the separation lines in the selection list of the specified object. 

Access in Runtime: Read and write

Syntax
Object.SeparatorColor[=Color]

Object
Required A "ScreenItem" object with the format "SymbolicIOField".
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Color
Optional A value or a constant that specifies the color of the separation lines in the selection 
list of the specified object.

See also
SymbolicIOField (Page 5130)

SeparatorCornerStyle

Description
Specifies the shape of the corners for the object of the type "ScreenItem" with the format 
"SymbolicIOField".   

See also
SymbolicIOField (Page 5130)

SeparatorStyle

Description
Specifies the line style of the separation lines in the selection list of the selected object.   

Access in Runtime: Read and write

Syntax
Object.SeperatorStyle[=LineStyle]

 

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

LineStyle
hmiLineStyleNone (-1): The selection list has no separation lines.

hmiLineStyleSolid ( 0): The selection list has solid separation lines.

hmiLineStyleDash ( 1): The selection list has broken separation lines.

hmiLineStyleDot ( 2): The selection list has dotted separation lines.

hmiLineStyleDashDot ( 3): The selection list has dash - dot lines as separation lines.

hmiLineStyleDashDotDot ( 4): The selection list has dash - dot - dot lines as separation lines.
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See also
SymbolicIOField (Page 5130)

SeparatorWidth

Description
Specifies the width of the separation lines in the selection list of the specified object. 

Access in Runtime: Read and write

Syntax
Object.SeparatorWidth[=Int]

Object
Required A "ScreenItem" object with the format "SymbolicIOField"".

Int
Optional A value or a constant that specifies the width of the separation lines in the selection 
list of the specified object.

See also
SymbolicIOField (Page 5130)

SeperatorLineEndShapeStyle

Description
Specifies the shape of the line ends for the object of the type "ScreenItem" with the format 
"SymbolicIOField".

See also
SymbolicIOField (Page 5130)

ServerScale

Description
Establishes whether the Sm@rtClient view should be zoomed in or out.   
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Syntax
Object.ServerScale =[Int]

Object
Required A "ScreenItem" object with the format "SmartClientView".

Int
Optional A value or a constant that specifies the value.

See also
SmartClientView (Page 5123)

ServerNames 

Description
Specifies the servers of a distributed system from which the message view draws data. The 
information is given in form of: NameServer1;NameServer2;NameServer3. 

Access in Runtime: Read-only

Syntax
Object.ServerNames[=String]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl" or "UserName".

String
Optional A value or a constant that specifies the server of a distributed system from which the 
alarm window receives information.

See also
AlarmControl (Page 4981)

ServerPrefix

Description
Defines the server containing the picture to be displayed in the picture window in Runtime or 
returns the server name. 
Enter the server name followed by two colons: "<Servername>::". No check is made as to 
whether the server actually exists.
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SetAllAssignment

Description 
Sets all entries.

SetSelection

Description
Sets a list of the lines which are selected.

SetpointTrendArchiveStartId(i) 

Description
Specifies the starting position from which the values of the setpoint trend will be read from the 
recipe. Whether the information is evaluated depends on the value of the property 
"ShowSetpointTrend(i)".   

Access in Runtime: Read and write

Syntax
Object.SetpointTrendArchiveStartId(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the starting position from which the values of the 
setpoint trend will be read from the recipe.

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 5038)
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SetpointTrendColor(i)

Description
Specifies the color of a setpoint trend. Whether the information is evaluated depends on the 
value of the property "ShowSetpointTrend(i)". 

Access in Runtime: Read and write

Syntax
Object.SetpointTrendColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Color
Optional A value or a constant that specifies the color of a setpoint trend.

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 5038)

SetpointTrendNumberOfValues(i)

Description
Specifies the number of value pairs of a setpoint trend. Whether the information is evaluated 
depends on the value of the property "ShowSetpointTrend(i)". 

Access in Runtime: Read and write

Syntax
Object.SetpointTrendNumberOfValues(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the number of value pairs of a setpoint trend. 
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Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 5038)

SetProps

Description
Sets the value of the property.

ShareTimeAxis

Description
Specifies whether the trends of a trend window are displayed with a shared X axis.

Access in Runtime: Read and write

Syntax
Object.ShareTimeAxis[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional. TRUE, if the trends of the trend window are displayed with a shared X axis.

See also
OnlineTrendControl (Page 5083)

ShareTimeColumn

Description
Specifies whether a shared time column will be used in the table window. 

Access in Runtime: Read and write

Syntax
Object.ShareTimeColumn[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if a shared time column will be used in the table window.

See also
OnlineTableControl (Page 5075)

ShareValueAxis 

Description
Specifies whether the trends of a trend window are displayed with a shared Y axis. 

Access in Runtime: Read and write

Syntax
Object.ShareValueAxis[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrendControl".

BOOLEAN
Optional TRUE, if the trends of the trend window are displayed with a shared Y axis.

See also
OnlineTrendControl (Page 5083)

ShareXAxis

Description
Specifies whether the trends of a trend window are displayed with a shared X axis.   

Access in Runtime: Read and write

Syntax
Object.ShareXAxis[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".
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BOOLEAN
Optional TRUE, if the trends of the trend window are displayed with a shared X axis.

See also
FunctionTrendControl (Page 5038)

ShareYAxis

Description
Specifies whether the trends of a trend window are displayed with a shared Y axis. 

Access in Runtime: Read and write

Syntax
Object.ShareYAxis[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the trends of the trend window are displayed with a shared Y axis.

See also
FunctionTrendControl (Page 5038)

Shared

Description
Specifies that an HMI device is shared by several Sm@rtClient Views.   

Syntax
Object.Shared[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "SmartClientView".

See also
SmartClientView (Page 5123)
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ShiftDecimalPointReadOnlySpecial 

Description
Specifies that the "Shift decimal point" field can only be read. 

Access in Runtime: Read and write

Syntax
Object.ShiftDecimalPointReadOnlySpecial[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "Shift decimal point" field can only be read. 

See also
IOField (Page 5059)

ShortenCellText

Description
Specifies whether the content of the fields of an alarm line should be shortened if the column 
width is too small. 

Access in Runtime: Read and write

Syntax
Object.ShortenCellText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the content of the fields of an alarm line should be shortened if the column 
width is too small.

See also
AlarmControl (Page 4981)
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ShortenColumnHeaderText

Description
Specifies whether the content of the fields of a title line should be shortened if the column width 
is too small. 

Access in Runtime: Read and write

Syntax
Object.ShortenColumnHeaderText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the content of the fields of a title line should be shortened if the column width 
is too small.

See also
AlarmControl (Page 4981)

ShowAlarmsFromDate

Description
Specifies that only those message events are displayed that are saved in this tag.   

Access in Runtime: Read and write

Syntax
Object.ShowAlarmsFromDate[=Tag]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

Tag
Optional A value or a constant which specifies that only those message events are displayed 
that are saved in this tag.

See also
AlarmView (Page 4992)
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ShowBadTagState
Defines whether the object is grayed out when a bad QualityCode or tag status is detected.

Yes If the quality code or the the tag status are poor, the object is grayed out or the 
settings for the grid color are used.

No If the quality code or the the tag status are poor, the object is not grayed out or the 
settings for the grid color are not used.

See also
CheckBox (Page 5008)

Bar (Page 4995)

WindowSlider (Page 5176)

SymbolicIOField (Page 5130)

IOField (Page 5059)

OptionGroup (Page 5092)

ShowBar

Description
Specifies whether the displayed process value in the "Slider" object is also shown by a filled 
bar. 

Access in Runtime: Read and write

Syntax
Object.ShowBar

Object
Required A "ScreenItem" object with the format "Slider".

Optional TRUE, if the process value is also shown by a filled bar.

See also
Slider (Page 5120)

ShowBorder

Description
Specifies whether the window will be shown with a border. 
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Access in Runtime: Read and write

Syntax
Object.ShowBorder[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE if the window is to be shown with a border.

ShowCaption

Description
Specifies whether the title line is hidden or shown. 

+C1763

Access in Runtime: Read and write

Syntax
Object.ShowCaption[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format 
"OnlineTrendControl","FunctionTrendControl", "OnlineTableControl", "AlamControl", 
"ScreenWindow", "ApplicationWindow" or "UserArchiveControl".

BOOLEAN
Optional TRUE, if the title line is shown.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

ScreenWindow (Page 5116)

ScriptDiagnostics (Page 5118)
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ShowColumn(i)

Description
Specifies whether a column pair that is referenced via the "CurrentColumnIndex" property is 
shown. 

Access in Runtime: Read and write

Syntax
Object.ShowColumn(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
Optional TRUE, if a column pair that is referenced via the "CurrentColumnIndex" property is 
shown.

See also
OnlineTableControl (Page 5075)

ShowCurve(i) 

Description
Specifies whether a trend that is referenced via the "CurrentCurveIndex" property is shown. 

Access in Runtime: Read and write

Syntax
Object.ShowCurve(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if a trend that is referenced via the "CurrentCurveIndex" property is shown.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)
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ShowDecimalPoint

Description
Specifies whether the scale is identified with decimal figures (decimal point and one decimal 
place) or with whole integers. 

Access in Runtime: Read and write

Syntax
Object.ShowDecimalPoint[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the scale is identified with decimal figures (decimal point and one decimal 
place).

See also
Gauge (Page 5046)

ShowFillLevel

Description
Specifies whether the selected object is filled. 

Access in Runtime: Read and write

Syntax
Object.ShowFillLevel[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Ellipse", "Circle", "EllipseSegment", 
"CircleSegment", "Rectangle", "Polygon", "TextField", "Button", "Roundbutton", 
"GraphicView", "Checkbox", "OptionGroup"" or "WindowSlider".".

BOOLEAN
Optional TRUE, if the selected object is filled.
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See also
Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

Button (Page 5002)

GraphicView (Page 5052)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

ShowFocusRectangle

Description
Specifies whether the button is given a selection border when it is activated in Runtime. 

Access in Runtime: Read and write

Syntax
Object.ShowFocusRectangle[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Clock".

BOOLEAN
Optional TRUE, if the button is given a selection border when it is activated in Runtime.

See also
Clock (Page 5018)

ShowInputControls

Description
Establishes whether additional fields exist for entering the address and password.   
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Syntax
Object.ShowInputControls

Object
Required A "ScreenItem" object with the format "SmartClientView".

ShowLargeTicksOnly

Description
Defines or returns the length of the axis section in pixels. 

See also
Bar (Page 4995)

ShowLimitMarkers

Description
Specifies whether the limit value is shown as a scale value. 

Access in Runtime: Read and write

Syntax
Object.ShowLimitMarkers[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the limit value is shown as a scale value.

See also
Bar (Page 4995)

ShowMainFrame

Description
Specifies whether the entire bar object is provided with a border. 

Access in Runtime: Read and write
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Syntax
Object.ShowMainFrame[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Option TRUE, if the entire bar object is shown with a border.

See also
Bar (Page 4995)

ShowMessagesAtDate

Description
Determines at which time the alarms will be displayed. 

 

 Note

This function does not filter out alarms, it positions the display range of the alarm list as of 
the specified date.

 

Access during runtime: Read and Write

Syntax
Object.ShowMessagesAtDate [= DATE]

Object
Required. An object of the "MessageView" type.

Remarks

To assign SmartTags to the "ShowMessagesAtDate" property, you must formulate the 
assignment as follows:

'Example 1
HmiRuntime.Screens("Screen_1").ScreenItems("Alarm 
view_1").ShowMessagesAtDate = SmartTags("intern_1").Value
'Example 2
HmiRuntime.Screens("Screen_1").ScreenItems("Alarm 
view_1").ShowMessagesAtDate = CDate(SmartTags("intern_1"))
SmartTag "intern_1" must be of the "DateTime" type.
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See also
AlarmView (Page 4992)

ShowOverflowIndicator

Description
Specifies whether an overflow indicator is shown when the process value exceeds or falls short 
of the limit value. 

Access in Runtime: Read and write

Syntax
Object.ShowOverflowIndicator[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".".

BOOLEAN
TRUE, if an overflow indicator is shown when the process value exceeds or falls short of the 
limit value.

See also
Bar (Page 4995)

ShowPeakValuePointer 

Description
Specifies whether a slave pointer will be used for the selected object. 

The slave pointer shows the maximum pointer deflection provided in Runtime while the process 
screen is loaded. If you reload the process screen, the slave pointer will be reset.

Access in Runtime: Read and write

Syntax
Object.ShowPeakValuePointer[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the slave pointer is used.
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See also
Gauge (Page 5046)

ShowPeakValuePointer

Description
Determines whether a pointer for the given object is to be used. 

The pointer shows the maximum hand deflection in runtime as long as the process screen is 
loaded. When you reload the process screen, the pointer is reset.

Access during runtime: Read and Write

Syntax
Object.ShowPeakValuePointer [= BOOLEAN]

Object
Required. An object of the "ScreenItem" type with the characteristic "Gauge".

BOOLEAN
Optional. TRUE, if the pointer is used.

ShowPosition

Description
Specifies whether the value of the current slider position should also be displayed numerically. 
The value is then displayed beneath the slider. 

Access in Runtime: Read and write

Syntax
Object.ShowPosition[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Slider".

BOOLEAN
Optional TRUE, if the value is also shown.

See also
Slider (Page 5120)
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ShowRowHeaders

Description
Specifies whether the message view contains a column with consecutive numbering of the 
existing messages. 

Access in Runtime: Read and write

Syntax
Object.ShowRowHeaders[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the message view contains a column with consecutive numbering of the 
existing messages.

See also
AlarmControl (Page 4981)

ShowRuler 

Description
Specifies whether a scale division (help line) is displayed for an axis label of the object 
"OnlineTrendControl".   

Access in Runtime: Read and write

Syntax
Object.ShowRuler[= BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"OnlineTrendControl" or "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the scale gradation is shown.
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ShowRuler

Description
Determines whether a scale gradation (help lines) is expanded for the axis label of the object 
"TrendView". 

Access during runtime: Read and Write

Syntax
Object.ShowRuler [= BOOLEAN]

Object
Required. An object of the "ScreenItem" type with the characteristic "TrendView".

BOOLEAN
Optional. TRUE, if the scale gradation is shown.

See also
TrendView (Page 5155)

ShowRulerInAxis

Description
Enables the display of rulers in the time axis.     

Access in Runtime: Read and write

Syntax
Object.ShowRulerInAxis[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The rulers are also displayed in the time axes.

FALSE: The rulers are not displayed in the time axes.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

ShowScale

Description
Specifies whether the values will also be shown in a scale. 

Access in Runtime: Read and write

Syntax
Object.ShowScale[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the values will also be shown in a scale.

See also
Bar (Page 4995)

ShowScrollbars

Description
Scroll bars - ShowScrollbars

Enables the display of scroll bars.     

Access in Runtime: Read and write

Syntax
Object.ShowScrollbars[=ShowScrollbars]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).
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ShowScrollbars

Value Description Explanation
0 no The display of scroll bars is disabled.
1 as required Scroll bars are displayed if space requirements of the control are greater 

than the actual display area. 
2 always The scroll bars are always displayed.

See also
ScreenWindow (Page 5116)

FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

ShowSetpointTrend(i)

Description
Specifies whether a setpoint trend that belongs to a trend that is referenced via 
"CurrentCurveIndex" should be shown. 

Access in Runtime: Read and write

Syntax
Object.ShowSetpointTrend(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if a setpoint trend that belongs to a trend that is referenced via 
CurrentCurveIndex" should be shown.

See also
FunctionTrendControl (Page 5038)

ShowSortButton

Description
Enables the display of a sorting button above the vertical scroll bar. Click this sorting button 
to sort the selected column based on the configured sorting criteria. The sorting button is not 
displayed if the table does not contain a vertical scroll bar.   
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Access in Runtime: Read and write

Syntax
Object.ShowSortButton[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: The sorting key is displayed. You can sort the selected column.

FALSE: The sorting key is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

ShowSortIcon

Description
Enables the display of the sorting icon.   

Access in Runtime: Read and write

Syntax
Object.ShowSortIcon[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: The sorting icon is displayed.

FALSE: The sorting icon is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)
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OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

ShowSortIndex

Description
Specifies whether a sort index is displayed.     

Access in Runtime: Read and write

Syntax
Object.ShowSortIcon[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: A sort index is displayed.

FALSE: A sort index is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

ShowStatusBar

Description
Specifies whether the status bar is shown. 

Access in Runtime: Read and write

Syntax
Object.ShowStatusBar[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl" or "HTMLBrowser".
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BOOLEAN
Optional TRUE, if the status bar is shown.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

MediaPlayer (Page 5068)

ShowTableGridlines

Description
Specifies whether the gridlines are shown in the table of the selected object. 

Access in Runtime: Read and write

Syntax
Object.ShowTableGridlines[= BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "StatusForce", 
"OnlineTrendControl" or "UserView".

BOOLEAN
Optional TRUE, if gridlines are shown.

See also
TrendView (Page 5155)

ShowTableGridlines

Description
Determines whether gridlines are shown in the table of the given object. 

Access during runtime: Read and Write
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Syntax
Object.ShowTableGridlines [= BOOLEAN]

Object
Required. An object of the "ScreenItem" type with the characteristic "StatusForce".

BOOLEAN
Optional. TRUE, if gridlines are displayed.

See also
StatusForce (Page 5125)

UserView  (Page 5174)

ShowThumb

Description
Specifies whether the slider of the "Slider" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.ShowThumb[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Slider".

BOOLEAN
Optional TRUE, if the slider is shown.

See also
Slider (Page 5120)

ShowTickLabels

Description
Specifies whether the label is shown in the scale.     

Access during runtime: Read and write
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Syntax
Object.ShowTickLabels[= BOOLEAN]

Object
Necessary. A "ScreenItem" object with the formats "Bar" or "Slider".

BOOLEAN
Optional TRUE, if the label is shown.

Comments
The increments for the measured value are automatically established dependent upon the 
specified measurement range and the size of the object.

Used for the following object types:
Slider

 

See also
Bar (Page 4995)

Slider (Page 5120)

ShowTicks

Description
Specifies whether the marking lengths are shown in the scale of the selected object.     

Access during runtime: Read and write

Syntax
Object.ShowTicks[= BOOLEAN]

Object
Necessary. A "ScreenItem" object with the formats "Clock" or "Slider".

BOOLEAN
Optional TRUE, if the marking lengths are shown.

Used for the following object types: 
Slider
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See also
Clock (Page 5018)

Slider (Page 5120)

ShowTitle

Description
Defines representation the Control window header.     

Access in Runtime: Read and write

Syntax
Object.ShowTitle[=WindowHeaderStyle]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "FunctionTrendControl", "UserArchiveControl", "TrendRulerControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

WindowHeaderStyle

Value Designation Description
0 No No window title.
1 Normal The window title consists of a WinCC icon and text. The text is entered in the 

"Text" field. 
2 Narrow The window title consists only of text. The text is entered in the "Text" field.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

ShowToolBar

Description
Specifies whether the toolbar is shown. 
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Access in Runtime: Read and write

Syntax
Object.ShowToolBar[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl" or "HTMLBrowser".

BOOLEAN
Optional TRUE, if a toolbar will be displayed.

See also
AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

ShowTrendIcon

Description
Enables the display of an icon below the value axes. The icon indicates the trend currently 
displayed in the foreground.     

Access in Runtime: Read and write

Syntax
Object.ShowTrendIcon[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The icon is displayed.

FALSE: The icon is not displayed.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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ShowTrendIndicator

Description
Specifies whether the tendency (increasing or falling) of the measurement value that is to be 
monitored is shown with a small arrow. 

Access in Runtime: Read and write

Syntax
Object.ShowTrendIndicator[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the tendency (increasing or falling) of the measurement value that is to be 
monitored is shown with a small arrow.

See also
Bar (Page 4995)

ShowVerticalGridlines

Description
Specifies whether the columns of the message view are separated by vertical lines. 

Access in Runtime: Read and write

Syntax
Object.ShowVerticalGridlines[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the columns of the alarm window will be separated by vertical separation 
lines.

See also
AlarmControl (Page 4981)
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ShowXValuesExponential(i) 

Description
Specifies whether a value of the X coordinate is shown in exponential format. Whether the 
information is evaluated depends on the property "XAxisMode(i)".".

Access in Runtime: Read and write

Syntax
Object.ShowXValuesExponential(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if a value of the X coordinate is shown in exponential format.

Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the X coordinate of the measurement value.

See also
FunctionTrendControl (Page 5038)

ShowYValuesExponential(i) 

Description
Specifies whether a value of the Y coordinate is shown in exponential format. Whether the 
information is evaluated depends on the property "XAxisMode(i)". ".

Access in Runtime: Read and write

Syntax
Object.ShowYValuesExponential(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if a value of the Y coordinate is shown in exponential format.
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Comments
The parameter i indicates the number of the trend. 

You use the function "Display value here" to view the Y coordinate of the measurement value.

See also
FunctionTrendControl (Page 5038)

SignificantMask property

Description
Is required in Runtime to display the active message class with the highest priority. 
The value of the SignificantMask property represents an internal system output value does not 
require any specific configuration by the user. Updating is initiated in Runtime by clicking on 
the object.

Sizeable property

Description
TRUE, when it should be possible to change the size of the object in Runtime. BOOLEAN write-
read access.

In the case of application window and picture window: Read only access

See also
TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

SkinName

Description
The control style can be defined in this selection field.     

Access in Runtime: Writing

Syntax
Object.SkinName[=SkinName]
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Object
Required. An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "RecipeView", 
"RulerControl".

SkinName
The following settings are available:

Value Designation Description
 Project setting The style corresponds to the project settings in WinCC 

Explorer. 
0 Classic "Classic" WinCC style
1 Standard New WinCC V7 style

SmallChange

Description
Defines how many steps the controller can be moved with one mouse click or returns the value.

SmartTags

Description
Returns the SmartTags list. 

Access in Runtime: Read

Syntax
Object.SmartTags

Object
Required A ""HMIRuntime" object.

Sort

Description
Specifies the sorting criteria in SQL syntax for the database. 

Access in Runtime: Read and write
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Syntax
Object.Sort[=String]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

String
Optional A value or a constant that specifies the sort criteria in SQL syntax for the database.

SortByTimeDirection

Description
Specifies whether the last incoming message is shown at the top of the "AlarmControl" object 
(ascending sorting order). 

Access in Runtime: Read and write

Syntax
Object.SortByTimeDirection[= BOOLEAN]

Object
Required A "ScreenItems" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the last incoming alarm is shown at the top.

See also
AlarmControl (Page 4981)

AlarmView (Page 4992)

SortByTimeEnable

Description
Specifies whether the sorting direction can be altered in Runtime. 

Access in Runtime: Read and write

Syntax
Object.SortByTimeEnable[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the sorting direction can be altered in Runtime.

See also
AlarmView (Page 4992)

SortByTimeEnabled 

Description
Specifies whether the sorting of the messages can be altered according to the time in the 
"AlarmControl" object. 

Access in Runtime: Read and write

Syntax
Object.SortByTimeEnabled[= BOOLEAN]

Object
Required A "ScreenItems" object with the format "AlarmControl".

BOOLEAN
Optional TRUE, if the sorting can be altered by the device operator.

SortOnColumnHeaderClick

Description
Specifies whether the alarm text blocks can be sorted via the column header of the alarm text 
block. 

Access in Runtime: Read and write

Syntax
Object.SortOnColumnHeaderClick[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".
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BOOLEAN
Optional TRUE, if the message blocks can be sorted by the column header of the message 
blocks.

See also
AlarmControl (Page 4981)

SortSequence

Description
Specifies how to change the sorting order by mouse click.  

Access in Runtime: Read and write

Syntax
Object.SortSequence[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "RecipeView", "RulerControl".

BOOLEAN.

Value Description Description
0 Up/down/none You can toggle between ascending, descending and no sorting by means 

of mouse click.
1 Up/down You can toggle between ascending and descending sorting order by 

means of mouse click.

See also
TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

SortTimeAscending

Description
Determines whether the last message received is displayed on top (ascending sorting order) 
in the  "MessageView" object. 

Access during runtime: Read and Write
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Syntax
Object.SortTimeAscending [= BOOLEAN]

Object
Required. An object of the "MessageView" type.

BOOLEAN
Optional. TRUE, if the last message received is displayed on top.

SortTimeEnable

Description
Determines whether the sorting of messages can be changed according to time in the  
"MessageView" object. 

Access during runtime: Read and Write

Syntax
Object.SortTimeEnable [= BOOLEAN]

Object
Required. An object of the "MessageView" type.

BOOLEAN
Optional. TRUE, if the sorting can be changed by the operator on the device.

StartAngle

Description
Specifies the angle at which the start point of the selected object deviates from the zero position 
(0°). 

Access in Runtime: Read and write

Syntax
Object.StartAngle[=Int]

Object
Required A "ScreenItem" object with the formats "EllipseSegment", "CircleSegment", 
"EllipticalArc" or "CircularArc".
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Int
Optional A value or a constant that specifies the angle at which the start point of the specified 
object deviates from the zero position (0°).

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

TubeArcObject (Page 5158)

StartPoint

Description
Specifies the beginning of the object or returns it.

StartPointLeft

Description
Specifies the horizontal distance in pixels from the left edge of the screen. 

Access in Runtime: Read and write

Syntax
Object.StartPointLeft[=Int]

Object
Required An object of the "ScreenItem type with the format "Line"".

Int
Optional A value that specifies the horizontal distance in pixels of the start point from the left 
edge of the screen. 

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)
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StartStyle

Description
Specifies how the line-start style of the specified object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.StartStyle[= THmiLineEndStyle]

Object
Required A ""ScreenItem" object with the formats ""Line", "Polyline" or ""Connector".

THmiLineEndStyle
Optional A value or a constant that specifies the line-start style. Value range from 0 to 1.

hmiLineEndStyleNone (0): The line has no start symbol.

hmiLineEndStyleFilledArrow (2): The line starts with a filled arrowhead.

See also
Line (Page 5063)

Polyline (Page 5098)

Connector (Page 5020)

StartStyle

Description
Determines how the line start of the given object is displayed. 

Access in Runtime: Read and write

Syntax
Object.StartStyle [= THmiLineEndStyle]

Object
Required An object of the "ScreenItem" type with the characteristic "Line," or "Polyline".

THmiLineEndStyle
Optional A value or constant which determines the line start. Value range from 0 to 2.

hmiLineEndStyleNone (0): The line has no start symbol.

hmiLineEndStyleFilledArrow (2): The line starts with a filled arrow.
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StartTop

Description
Specifies the vertical distance in pixels of the start point from the upper edge of the screen.  

Access in Runtime: Read and write

Syntax
Object.StartTop[=Int]

Object
Required An object of the "ScreenItem" type with the format "Line"".

Int
Optional A value that specifies the vertical distance in pixels of the start point from the upper 
edge of the screen. 

See also
EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Line (Page 5063)

StartValue

Description
Defines the value of the zero point of the scale indicator.

Defines or returns the absolute value for the zero point. 

See also
Bar (Page 4995)

State

Description
Returns the status of a message.

The following table shows the possible states of a message:

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5579



State Alarm Log Status
1 Came In
2 Went Out
5 Came in and comment
6 Gone and comment

See also
Example of configuring the alarm view (Page 4521)

StatusbarBackColor

Description 
Defines the background color of the status bar. You open a color selection dialog box with the 
button.  Enable the "Display" option to active the setting.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementAdd

Description   
Creates a new, user-defined status bar element. You can change the name assigned by 
WinCC in the "Object name" field. 

Access in Runtime: Write

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)
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OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementAutoSize

Description
Enables autosizing of the width of a status bar element selected.     

Access in Runtime: Read and write

Syntax
Object.StatusbarElementAutoSize

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "FunctionTrendControl", "RecipeView", "RulerControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The width of the selected element is set automatically.

FALSE: The width of the selected element is not set automatically.

.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementCount

Description 
Defines the number of configurable status bar elements.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementIconId

Description 
Default assignment of the ID number and icon of a status bar element.

The property can be dynamized for customized elements of the status bar with the 
StatusbarElementIconId name.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementID

Description
Returns the ID number of the selected status bar element.

WinCC sets this read only ID.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)
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OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementIndex

Description 
References a status bar element. You can assign the values of other properties to a specific 
element of the status bar by using this property.

Values between 0 and "StatusbarElementCount" minus 1 are valid for 
"StatusbarElementIndex". Attribute "StatusbarElementCount" defines the number of 
configurable status bar elements.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementName

Description 
Displays the object name of the status bar element selected. You can rename the objects of 
custom status bar elements. The "StatusbarElementName" property for customized elements 
can be dynamized by the " StatusbarElementRename" property. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)
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StatusbarElementRemove

Description 
Removes the selected status bar element. Only customized elements of the status bar can be 
removed from the list.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementRename

Description   
Change the name of the customized element of the status bar that is referenced by the 
"StatusbarElementIndex" property.

The property with the name StatusbarElementRename can be dynamized for customized 
elements. With "StatusbarElementRename" you also dynamize the "StatusbarElementName" 
property.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElements

Description
Specifies the elements that are to be shown in the status bar. 

Access in Runtime: Read and write
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Syntax
Object.StatusbarElements[=Long]

Object
Required A "ScreenItem" object with the format "AlarmView".

Long
Optional A value or a constant that specifies the elements that are shown in the status bar.

See also
AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

StatusbarElementTooltipText

Description 
Defines the tooltip text for the custom status bar element.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementUserDefined

Description
Indicates whether the project engineer has added the status bar element as a new user-defined 
element.     

Access in Runtime: Read 
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Syntax
Object.StatusbarElementUserDefined[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTrendControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"RulerControl".

BOOLEAN
TRUE: The element of the status bar is customized.

FALSE: The element of the status bar is specified by the system.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarElementVisible

Description 
Activate the elements in the list of status bar elements for their display in Runtime.

Click a list entry to adapt the properties, or to change its position in the status bar of the Control 
by means of the "Up" and "Down" buttons. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)
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StatusbarElementWidth

Description 
Shows the width of the status bar element selected in pixels. You can define the width if the 
"Automatic" option is not activated.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarFontColor

Description 
Defines the color of the text in the status bar. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarShowArchiveName

Description
Specifies whether the archive name will be displayed in the status bar. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowArchiveName[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the archive name will be displayed in the status bar.

StatusbarShowColumn

Description
Specifies whether the current number of selected data record columns will be displayed. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowColumn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, specifies whether the current number of selected data record columns will be 
displayed.

StatusbarShowRecord

Description
Specifies whether the field coordinates of the selected data record will be displayed in the 
status bar. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowRecord[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the field coordinates of the selected data record will be displayed in the 
status bar.
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StatusbarShowRow

Description
Specifies whether the current number of selected data record rows will be displayed. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowRow[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the current number of selected data record rows will be displayed.

StatusbarShowText

Description
Specifies whether the current status of the database will be displayed in the status bar. 

Access in Runtime: Read and write

Syntax
Object.StatusbarShowText[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, specifies whether the current status of the database will be displayed in the 
status bar.

StatusbarShowTooltips

Description
Enables the display of tooltips for the status bar elements in Runtime.   

Access in Runtime: Read and write
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Syntax
Object.StatusbarShowTooltips[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "UserArchiveControl", 
"TrendRulerControl".

BOOLEAN
TRUE: The tooltips are displayed.

FALSE: The tooltips are not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarText

Description
Returns the standard text of the status bar.

Access in Runtime: Read

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)
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StatusbarUseBackColor

Description
Sets a background color for the status bar.   

Access in Runtime: Read and write

Syntax
Object.StatusbarUseBackColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "UserArchiveControl", 
"TrendRulerControl".

BOOLEAN
TRUE: The background color of the status bar is displayed.

FALSE: The background color of the status bar is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

StatusbarVisible

Description
Enables the display of the status bar of a control.   

Access in Runtime: Read and write

Syntax
Object.StatusbarVisible[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "RecipeView", 
"RulerControl".
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BOOLEAN
TRUE: The status bar is displayed.

FALSE: The status bar is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

Style

Description
Specifies the line style of the selected object. 

Access in Runtime: Read and write

Syntax
Object.Style[= THmiLineStyle]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "EllipticalArc", "CircularArc" 
or "Connector".

THmiLineStyle
Optional A value or a constant that specifies the line style. Value range from 0 to 4.

hmiLineStyleSolid (0): solid line

hmiLineStyleDash (1): broken line

hmiLineStyleDot  (2): dotted line

hmiLineStyleDashDot (3): dash - dot line

hmiLineStyleDashDotDot (4): dash - dot - dot line

Default setting: hmiLineStyleSolid

See also
Line (Page 5063)

Polyline (Page 5098)
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EllipticalArc (Page 5032)

CircularArc (Page 5016)

Connector (Page 5020)

Style

Description
Determines the line style of the given object. 

Access during runtime: Read and Write

Syntax
Object.Style [= THmiLineStyle]

Object
Required. An object of the "screen item" type with the characteristic "Line," or "Polyline".

THmiLineStyle
Optional. A value or constant that defines the line style. Value range from 0 to 4.

hmiLineStyleSolid (0): solid line

hmiLineStyleDash (1): dashed line

hmiLineStyleDot (2): dotted line

hmiLineStyleDashDot (3): dash dot line

hmiLineStyleDashDotDot (4): dash dot dot line

Default setting: hmiLineStyleSolid

StyleSettings

Description
Defines the style in which the object is displayed. 

User Defined Shows the object according to the respective settings.
Global Shows the object in a globally defined design.
Windows Style Shows the object in Windows style.
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See also
Button (Page 5002)

WindowSlider (Page 5176)

RoundButton (Page 5112)

SwapDimensionsWithOrientation

Description
Specifies whether the values for the height and width of the bar should be automatically 
replaced if the bar alignment is changed. 

Access in Runtime: Read and write

Syntax
Object.SwapDimensionsWithOrientation[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the values for the height and width of the bar should be automatically 
replaced if the bar alignment is changed.

See also
Bar (Page 4995)

SwapFirstWithLastConnection

Description
Specifies whether the text in the object is shown horizontally.

Access in Runtime: Read and write

Syntax
Object.SwapFirstWithLastConnection[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Connector".".

BOOLEAN
Optional TRUE, if the text in the object is shown horizontally.
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See also
Connector (Page 5020)

Properties T

TableBackColor

Description
Specifies the background color of the table cells for the selected object. 

Access in Runtime: Read and write

Syntax
Object.TableBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the format "UserArchivControl", 
"StatusForce", "OnlineTrendControl", "AlarmControl" or "UserView".

Color
Optional A value or a constant that specifies the background color of the table cells.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

TableBackColor

Description
Determines the background color of the table cells of the given object. 

Access during runtime: Read and Write

Syntax
Object.TableBackColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView", 
"StatusForce", "TrendView", "MessageView" or "UserView".
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Color
Optional A value or constant which determines the background color of the table cells.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

TrendView (Page 5155)

StatusForce (Page 5125)

UserView  (Page 5174)

TableColor

Description   
Defines the background color of the rows. You open a color selection dialog box with the button. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TableColor2

Description 
Specifies the background color of "Row color 2". You open a color selection dialog box with 
the button.

The settings are only active in Runtime if the "Row color 2" option is enabled. The background 
colors of "Row color 2" and "Row color 1" are used alternately in this case.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TableFocusOnButtonCommand

Description
Specifies whether by clicking on a Button in a script in Runtime the table of the Controls will 
be activated. 

Access in Runtime: Read and write

Syntax
Object.TableFocusOnButtonCommand[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmView".

BOOLEAN
Optional TRUE, if by clicking on a Button in a script in Runtime the table of the Controls will 
be activated.

See also
AlarmControl (Page 4981)

TableForeColor

Description 
Specifies the font color of the rows. You open a color selection dialog box with the button.

TableForeColor 

Description
Specifies the text color used in the table cells of the selected object. 

Access in Runtime: Read and write
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Syntax
Object.TableForeColor[= Color]

Object
Required A "ScreenItem" object with the formats "RecipeView", ""StatusForce", 
"MessageView" or ""UserView".

Color
Optional A value or a constant that specifies the text color used in the table cells.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TableForeColor

Description
Determines the text color in the table cells of the given object. 

Access during runtime: Read and Write

Syntax
Object.TableForeColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"StatusForce", "MessageView" or "UserView".

Color
Optional A value or constant which determines the text color of the table cells.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
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0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
AlarmView (Page 4992)

RecipeView (Page 5106)

StatusForce (Page 5125)

UserView  (Page 5174)

TableForeColor2

Description 
Specifies the font color of "Row color 2". You open a color selection dialog box with the button. 

The settings are only active in Runtime if the "Row color 2" option is enabled. The font colors 
of "Row color 2" and "Row color 1" are used alternately in this case.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TableGridLineColor 

Description
Specifies the color of the gridlines in the table of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TableGridLineColor[= Color]

Object
Required A "ScreenItem" object with the formats "RecipeView", "TrendView" or "UserView".

Color
Optional A value or a constant that specifies the color of the gridlines in a table.
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Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

TableGridLineColor

Description
Determines the color of the gridlines in the table of the given object. 

Access during runtime: Read and Write

Syntax
Object.TableGridLineColor [= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView," 
"MessageView", "TrendView" or "UserView".

Color
Optional A value or constant which determines the color of the gridlines of the table.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

See also
RecipeView (Page 5106)

TrendView (Page 5155)

UserView  (Page 5174)

TableHeaderBackColor 

Description
Specifies the background color in the header of the table of the selected object. 

Access during runtime: Read and Write
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Syntax
Object.TableHeaderBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView", 
"StatusForce", "TrendView", "MessageView," or "UserView".

Color
Optional A value or a constant that specifies the background color in the header.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
UserView  (Page 5174)

AlarmView (Page 4992)

RecipeView (Page 5106)

StatusForce (Page 5125)

TrendView (Page 5155)

TableHeaderForeColor

Description
Specifies the text color in the header of the table of the selected object. 

Access during runtime: Read and Write

Syntax
Object.TableHeaderForeColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristics "RecipeView", 
"StatusForce", "TrendView", "MessageView" or "UserView".

Color
Optional A value or a constant that specifies the text color in the header.
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Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
UserView  (Page 5174)

AlarmView (Page 4992)

RecipeView (Page 5106)

StatusForce (Page 5125)

TrendView (Page 5155)

TagName

Description
The "Index" property references a trend. "TagName" defines the tag linked to this trend. It is 
specified in the form "Archivname\Variablenname" to display tags in a process value archive 
or "TasgName" to display an internal or external tag which is not stored in an archive.

TagPrefix

Description
A tag prefix can be assigned for a screen window that is prefixed to all tags which are used in 
the screen. In this way, a picture that is embedded in a picture window retains access to its 
own tags while another accesses other tags.

The "TagPrefix" property specifies the prefix that is prefixed to all tags which are available in 
the screen.

The change to the tag prefix does not become effective until the screen is reloaded. This 
happens automatically when changing screens, otherwise the screen name must be 
reassigned.

The prefix is freely definable but must match the name of the structure tag.

Example
The "InOutput" screen should be displayed in the screen window. The "InOutput" screen 
contains 3 I/O fields which are bound to a structure tag. The structure tag consists of the 
elements EA1, EA2, EA3; one element each for every I/O field.

Three such structure tags with the structure names Struct1, Struct2 and Struct3 are defined 
in the project for example.
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The tag prefix is the structure name with a following period in this case. If you specify Struct2., 
for example, as a tag prefix (the period is necessary to address the elements of the structure 
tags syntactically correctly as structure elements), the I/O fields in the "InOutput" screen are 
bound with the elements of structure tag Struct2:

Tag prefix: "Struct2."

● Output value (first I/O field): EA1

● Output value (second I/O field): EA2

● Output value (third I/O field): EA3

The current tag binding in the screen window is therefore

● Output value (first I/O field): Struct2.EA1

● Output value (second I/O field): Struct2.EA2

● Output value (third I/O field): Struct2.EA3

See also
ScreenWindow (Page 5116)

Tags

Description 
Returns an object of type "Tags". 

Access during runtime: Read

Syntax
Object.Tags

Object
Necessary. An object of the "HMIRuntime" type. 

Example
The following example accesses the tag "Tag1":

 
'VBS86
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
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See also
HMIRuntime  (Page 4956)

Example of writing tag values (Page 4512)

Example of reading tag values (Page 4514)

Template

Description
Returns the template for displaying the window content of the "Application Window" object. 
Read only access.

The following templates are possible depending on the property value:

Window Contents = Global Script
"GSC diagnostics"
The application window is supplied by applications of the Global Script. The results of the 
diagnosis system are displayed.

"GSC Runtime"
The application window is supplied by applications of the Global Script. The analysis results 
regarding characteristics in Runtime are displayed.

Window Contents = Print Jobs
"All Jobs": 
The application window is supplied by the logging system. The available reports are displayed 
as a list.

"All Jobs - Context Menu": 
The application window is supplied by the logging system. The available reports are displayed 
as a list. The shortcut menu enables the selection of print options, display of a print preview 
as well as a printout of the log.

"Job Detail View": 
The application window is supplied by the logging system. The available reports are displayed 
in a selection menu. Detailed information is displayed for the selected report.

"Selected Jobs - Context Menu": 
The application window is supplied by the logging system. The available reports are displayed 
as a list. This list only contains reports which you have activated the option "Mark for print job 
list" in the "Print Job Properties" dialog. The shortcut menu enables the selection of print 
options, display of a print preview as well as a printout of the log.

See also
ScriptDiagnostics (Page 5118)
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Text

Description
Specifies the labeling for the text field. 

Access in Runtime: Read and write

Syntax
Object.Text[= STRING]

Object
Required A "ScreenItem" " object with the formats "TextField", "CheckBox" or "OptionGroup".

STRING
Optional A value or a constant that specifies the labeling.

See also
TextField (Page 5144)

CheckBox (Page 5008)

OptionGroup (Page 5092)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

RoundButton (Page 5112)

Text 

Description
Determines the labeling of the text field. 

Access during runtime: Read and Write

Syntax
Object.Text [= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "TextField".

STRING
Optional. A value or constant which determines the label text color.
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TextList

Description
A list which contains the assignments between the output value and the output text actually to 
be output. The assignments are dependent on the set list type. You determine the list type 
with the ListType property.  

Access in Runtime: Read

Syntax
Object.TextList

Object
Required A "ScreenItem" object with the format "SymbolicIOField".

See also
Button (Page 5002)

SymbolicIOField (Page 5130)

TextOff

Description
Specifies the text that will be displayed in the status "off" of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TextOff[= STRING]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", ""Button" or "Switch".

STRING
Optional A value or a constant that specifies the labeling for the status "off".

Comments
The property is only available if the referenced object "SymbolicIOField", "Button" or "Switch" 
is type "Text".
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See also
SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

TextOff 

Description
Determines the text which is displayed in the "Off" status of the given object. 

Access during runtime: Read and Write

Syntax
Object.TextOff[= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "Button," and "Switch".

STRING
Optional. A value or constant which determines the label for the "Off" status.

Remarks
The property is only available if the referenced "Button" or "Switch" object is of the "Text" type.

TextOn

Description
Specifies the text that will be displayed in the status "on" of the selected object. 

Access in Runtime: Read and write

Syntax
Object.TextOn[= STRING]

Object
Required A "ScreenItem" object with the formats "SymbolicIOField", "Button" or ""Switch".

STRING
Optional A value or a constant that specifies the labeling for the status "on".
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Comments
The property is only available if the referenced object "Button" or Switch" is type ""Text".

See also
SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

TextOn

Description
Determines the text which is displayed in the "On" status of the given object. 

Access during runtime: Read and Write

Syntax
Object.TextOn[= STRING]

Object
Required. An object of the "ScreenItem" type with the characteristic "Button," and "Switch".

STRING
Optional. A value or constant which determines the label for the "On" status.

Remarks
The property is only available if the referenced "Button" or "Switch" object is of the "Text" type.

TextOrientation

Description
Specifies the text direction (orientation) of the selected object.   

Access in Runtime: Read and write

Syntax
Object.TextOrientation[=TextOrientation]
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Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "Button", "Switch", "Bar", "OnlineTrendControl", "FunctionTrendControl", 
"Checkbox", "OptionGroup" or "WindowSlider".

TextOrientation
hmiTextHorizontal ( 0): The text is shown horizontally.

hmiTextRotated90Degree (-1): The text is shown vertically and left justified.

hmiTextRotated270Degree ( 1): The text is shown vertically and right justified.

See also
CheckBox (Page 5008)

Button (Page 5002)

WindowSlider (Page 5176)

RoundButton (Page 5112)

Switch (Page 5127)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

ThumbBackColor

Description
Specifies the background color of the slider in the ""Slider" object. 

Access in Runtime: Read and write

Syntax
Object.ThumbBackColor[= Color]

Object
Required A "ScreenItem" object with the formats ""Slider" or "WindowSlider".".

Color
Optional A value or a constant that specifies the background color of the slider.
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Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Slider (Page 5120)

WindowSlider (Page 5176)

ThumbBackColor

Description
Determines the background color of the slider in the "Slider" object. 

Access during runtime: Read and Write

Syntax
Object.ThumbBackColor[= Color]

Object
Required An object of the "ScreenItem" type with the characteristic "Slider".

Color
Optional A value or constant which determines the background color of the slider.

Comments
You can use the "RGB" function to establish the colors in the RGB format (red, green, blue). 
To do this, enter the appropriate decimal value for each of the three RGB values (range from 
0 to 255). For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the 
VBScript color constants such as vbRed or vbGreen.

TicksColor

Description
Specifies the color of the hour markers on the face of the "Clock" object. 

Access during runtime: Read and Write

Syntax
Object.TicksColor[= Color]
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Object
Required An object of the "ScreenItem" type with the characteristic "Clock".

Color
Optional A value or a constant that specifies the color of the hour markers.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as: RGB(255, 0, 0). You can also use the VBScript color 
constants such as vbRed or vbGreen.

See also
Clock (Page 5018)

TickStyle

Description
Specifies the scale display.     

Access during runtime: Read and write

Syntax
Object.TickStyle[=SliderTickStyle]

Object
Necessary. A "ScreenItem" object with the format "Slider"".

SliderTickStyle
hmiSliderTickStyleNone ( 0): The object has no scale.

Identifies no strokes.

hmiSliderTickStyleEffect1 ( 1): The scale consists of main gradations only. The scale is black 
on a white background.

Identifies main strokes (black-white).

hmiSliderTickStyleEffect2 ( 2): The scale consists of main gradations only. The scale is white 
on a black background.

Identifies main strokes (white-black).

hmiSliderTickStyleNormal ( 3): The scale consists of simple gradations.

Identifies normal strokes.
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Comments
Because of the automatic scaling it is possible that in some parts two marking lengths of the 
scale can be positioned directly adjacent to one another (looks like a wider marking length). 
You can correct this effect by slightly lengthening or shortening the slider object.

You you can also completely suppress the display of the scale ("WithAxes").

Used for the following object types:
Slider

 

 

See also
Slider (Page 5120)

TimeAxisBeginTime(i) 

Description
Specifies the start time of the display for the selected trend. Whether the information that is 
evaluated should be dependent on the properties ""UseTimeRange(i)" and "ShareTimeAxis". 

Access in Runtime: Read and write

Syntax
Object.TimeAxisBeginTime(i)[=Time]

Object
Required A "ScreenItem" object with the format "OnlineTrend"".

Time
Optional A value or a constant that specifies the start time of the display for the selected trend. 

See also
OnlineTrendControl (Page 5083)

TimeAxisEndTime 

Description
Specifies the end time of the display for the selected trend. Whether the information is 
evaluated depends on the properties "Autorange", "UseTimeRange(i)" " and "ShareTimeAxis".  

Access in Runtime: Read and write
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Syntax
Object.TimeAxisEndTime[=Time]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

Time
Optional A value or a constant that specifies the end time of the display for the selected trend. 

See also
OnlineTrendControl (Page 5083)

TimeAxisLabel(i) 

Description
Specifies the labeling of the time axis. Whether the information is evaluated depends on the 
property "ConfigureTimeAxis(i)". 

Access in Runtime: Read and write

Syntax
Object.TimeAxisLabel(i)[=String]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

String
Optional A value or a constant that specifies the labeling of the time axis. 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

TimeAxisRange 

Description
Time span that will be displayed by the time axis. 
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Access in Runtime: Read and write

Syntax
Object.TimeAxisRange[=Decimal]

Object
Required A "ScreenItem" object with the format "TrendView".

Decimal
Optional Time span that will be displayed by the time axis.

See also
TrendView (Page 5155)

TimeAxisShowGridLines(i)

Description
Specifies whether the trend window is shown with grid lines that run parallel to the x axis. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisShowGridLines(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

BOOLEAN
Optional TRUE, if the trend window is shown with grid lines that run parallel to the x axis.

Comments
The distance between two grid lines can be altered with the "TimeAxisGridLineInterval(i)" 
property.

See also
OnlineTrendControl (Page 5083)
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TimeAxisShowLargeIncrements(i)

Description
Specifies whether the time axis is scaled with long marking lengths. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisShowLargeIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

BOOLEAN
Optional TRUE, if the time axis is scaled with long marking lengths.

Comments
The distance of two long marking lines can be altered with the 
""TimeAxisLargeIncrementSize(i) property.

See also
OnlineTrendControl (Page 5083)

TimeAxisShowSmallIncrements(i) 

Description
Specifies whether the time axis is scaled with short marking lengths. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisShowSmallIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTrend".

BOOLEAN
Optional TRUE, if the time axis is scaled with short marking lengths.
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Comments
The distance of two short marking lines can be altered with the 
"TimeAxisSmallIncrementSize(i)" property.

See also
OnlineTrendControl (Page 5083)

TimeAxisTimeFormat(i)

Description
Specifies the format of the information along the time axis for the selected trend. 

Access in Runtime: Read and write

Syntax
Object.TimeAxisTimeFormat(i)[=TimeFormat]

Object
Required An object of the "ScreenItem" type with the format 
"OnlineTrendControl","FunctionTrendControl" or "OnlineTableControl".

TimeFormat
( 0): The information is carried out in the form hh:mm.

 ( 1): The information is carried out in the form hh:mm:ss.

 ( 2): The information is carried out in the form hh:mm:ss.ms.

 ( 3): The information is carried out in the form hh:mm (full hours).

 ( 4): The information is carried out in the form hh:mm:ss (full minutes).

 ( 5): The information is carried out in the form hh:mm:ss:ms (full seconds).

 ( 6): The information is carried out in the form dd_mm_yy_hh_mm.

 ( 7): The information is carried out in the form dd_mm_yy_hh_mm (full hours).

 ( 8): The information is carried out in the form dd_mm_yy.

 ( 9): The information is carried out in the form dd_mm_yy_ (full days).

Comments
The parameter i indicates the number of the trend. 
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

TimeBase

Description
Specifies the time zone in which the time values will be displayed.   

Access in Runtime: Read and write

Syntax
Object.TimeBase[=TimeBase]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "OnlineTableControl", "AlarmControl" or "UserArchiveControl".

TimeBase
hmiTimeBaseLocalTimezone ( 0): Local time

hmiTimeBaseServerTimezone ( 1): Time zone of the server

hmiTimeBaseUTC ( 2): UTC (Universal Time Coordinated)

hmiTimeBaseProjectSetting ( 3): Project settings

Comments
Set the time mode in accordance with the computer settings on the properties page of the 
computer in WinCC Explorer. The following selection is offered: 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)
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TimeColumnActualize

Description
Enables the update of values in the selected column.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object

Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The time column is actualized.

FALSE: The time column is not actualized. This setting can be useful when comparing tables.

See also
OnlineTableControl (Page 5075)

TimeColumnAdd

Description   
Creates a new time column.

Syntax
Object.TimeColumnAdd

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 5075)

TimeColumnAlign

Description
Defines the mode of alignment of the time column selected.   

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5618 System Manual, 02/2014



Access in Runtime: Read and write

Syntax
Object.TimeColumnAlign[=HorizontalAlignment]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

HorizontalAlignment

Value Description Description
0 left The time column selected is displayed on the left.
1 Centered The time column selected is aligned to center.
2 right The time column selected is displayed on the right.

See also
OnlineTableControl (Page 5075)

TimeColumnAlignment(i) 

Description
Specifies the alignment of the time column of a column pair i. The parameter i indicates the 
number of the column pair. 

Access in Runtime: Read and write

Syntax
Object.TimeColumnAlignment(i)[=AlignmentHorizontal]

Object
Required A "ScreenItem" object with the format "TableView".".

AlignmentHorizontal
hmiAlignmentLeft ( 0): The text is shown left justified.

hmiAlignmentCentered ( 1): The text is shown centered.

hmiAlignmentRight ( 2): The text is shown right justified.

See also
OnlineTableControl (Page 5075)
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TimeColumnBackColor

Description
Specifies the background color of the time column selected. You open a color selection dialog 
box with the button.

The setting is useful if:

● The "Use value column colors" option is disabled

● The "Font color" option is set in the "Use column color" field of the "General" tab.  

Access in Runtime: Read and write

Syntax
Object.TimeColumnBackColor

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnBeginTime

Description   
Defines the start of the time range for a selected time column. .

Syntax
Object.TimeColumnBeginTime

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 5075)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5620 System Manual, 02/2014



TimeColumnCaption

Description   
Defines the caption of the time column.

Syntax
Object.TimeColumnCaption

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnCount

Description   
Defines the number of time columns configured.

Syntax
Object.TimeColumnCount

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnDateFormat

Description
Defines the date format for visualizing a selected time column.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnDateFormat[=DateFormat]
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Object
Required A "ScreenItem" object with the format "OnlineTableControl".

DateFormat

Value Description
Automatic The date format is set automatically.
dd.MM.yy Day.Month.Year, e.g. 24.12.10.
dd.MM.yyyy Day.Month.Year, e.g. 24.12.2010.
dd/MM/yy Day/Month/Year, e.g. 24/12/10.
dd/MM/yyyy Day/Month/Year, e.g. 24/12/2010.

See also
OnlineTableControl (Page 5075)

TimeColumnEndTime

Description   
Defines the end of the time range of a selected time column.

Syntax
Object.TimeColumnBeginTime

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnForeColor

Description
Specifies the font color of the time column selected. You open a color selection dialog box with 
the button.

The setting is effective:

● When the option "in the colors of the value column" is not activated.

● When the "Font color" option is activated in the "Use column color" area of the "General" 
tab.   
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Access in Runtime: Read and write

Syntax
Object.TimeColumnForeColor

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnFormat(i) 

Description
Specifies the format of the time columns for the selected column pair. The parameter i indicates 
the number of the column pair.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnFormat(i)[=TimeFormat]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeFormat
 ( 0): The information is carried out in the form hh:mm.

 ( 1): The information is carried out in the form hh:mm:ss.

 ( 2): The information is carried out in the form hh:mm:ss.ms.

 ( 3): The information is carried out in the form hh:mm (full hours).

 ( 4): The information is carried out in the form hh:mm:ss (full minutes).

 ( 5): The information is carried out in the form hh:mm:ss:ms (full seconds).

 ( 6): The information is carried out in the form dd_mm_yy_hh_mm.

 ( 7): The information is carried out in the form dd_mm_yy_hh_mm (full hours).

 ( 8): The information is carried out in the form dd_mm_yy.

 ( 9): The information is carried out in the form dd_mm_yy_ (full days).

See also
OnlineTableControl (Page 5075)
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TimeColumnHideText

Description
Sets text format for displaying the content of a time column.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The content is not shown as a text.

FALSE: The content is shown as a text.

See also
OnlineTableControl (Page 5075)

TimeColumnHideTitleText

Description
Sets text format for displaying the time column header.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The header is not shown as a text.

FALSE: The header is shown as a text.

See also
OnlineTableControl (Page 5075)
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TimeColumnIndex

Description   
References a configured time column. You can assign the values of other properties to a 
specific time column by using the property.

Valid values for "TimeColumnIndex" are between 0 and "TimeColumnCount" minus 1. The 
"TimeColumnCount" property indicates the number of configured time columns.

Syntax
Object.TimeColumnIndex

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl"

See also
OnlineTableControl (Page 5075)

TimeColumnLength

Description   
Specifies the width of a selected time column.

Syntax
Object.TimeColumnLength

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 5075)

TimeColumnMeasurePoints

Description   
Defines the number of measurement points to be displayed in the time column selected. 
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Syntax
Object.TimeColumnMeasurePoints

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 5075)

TimeColumnName

Description   
Specifies the name of a selected time column.

Syntax
Object.TimeColumnName

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 5075)

TimeColumnRangeType

Description
Defines the time range setting for the time column selected.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnRangeType[=TimeRangeType]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".
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TimeRangeType

Value Description Description
0 Time range Defines the start time and time range of the time column.
1 Start to end time Defines the start and end time for the time column.
2 Number of measurement 

points
Defines the start time and the number of measurement points 
for the time column. 

See also
OnlineTableControl (Page 5075)

TimeColumnRemove

Description   
Removes the selected time column from the list.

Syntax
Object.TimeColumnRemove

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnRename

Description   
Changes the name of the time column which is referenced by the "TimeColumnIndex" property. 
With "TimeColumnRename" you also dynamize the "TimeColumnName" property.

Syntax
Object.TimeColumnRename

Object
Required A "ScreenItem" object with the format "OnlineTableControl".
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See also
OnlineTableControl (Page 5075)

TimeColumnRepos

Description   
Repositions the order of time columns and of corresponding value columns.  "Up" and "Down" 
move the time column selected up or down in the list. This moves the time column and 
corresponding value columns in the table towards the front or towards the back.

Syntax
Object.TimeColumnRepos

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeColumnShowDate

Description
Enables the display of the date and time in the time column selected.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnShowDate[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The date and the time are displayed. The date format is defined in the "Date format" 
field.

FALSE: The date is not displayed. Only the time is displayed.

See also
OnlineTableControl (Page 5075)
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TimeColumnShowIcon

Description
Enables the display of time column contents as icon.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnActualize[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The content is shown as an icon.

FALSE: The content is not shown as an icon.

See also
OnlineTableControl (Page 5075)

TimeColumnShowTitleIcon

Description
Specifies whether the values of the selected column are updated.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnShowTitleIcon [=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The header is shown as an icon.

FALSE: The header is not shown as an icon.

 

See also
OnlineTableControl (Page 5075)
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TimeColumnSort

Description
Specifies how the time column referenced in "TimeColumnIndex" is sorted.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnSort [=TimeColumnSort]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeColumnSort

Value Description Description
0 no No sorting
1 Ascending Ascending order, starting at the lowest value.
2 Descending Descending order, starting at the highest value.

.

 

See also
OnlineTableControl (Page 5075)

TimeColumnSortIndex

Description   
Specifies the sorting order of the time column referenced in "TimeColumnIndex". If you set the 
value to "0", the sorting criterion is removed in "TimeColumnSort".

Syntax
Object.TimeColumnSortIndex

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl"

See also
OnlineTableControl (Page 5075)
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TimeColumnTimeFormat

Description
Defines the time format for visualizing a selected time column.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnTimeFormat[=TimeFormat]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeFormat

Value Description
Automatic The time format is set automatically.
HH:mm:ss.ms Hours:Minutes:Seconds, e.g. 15:35:44.240.
hh:mm:ss tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44 PM.
hh:mm:ss.ms tt Hours:Minutes:Seconds AM/PM, e.g. 03:35:44.240 PM.

See also
OnlineTableControl (Page 5075)

TimeColumnTimeRangeBase

Description
Defines the time unit for calculating the time range.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnTimeRangeBase[=TimeRangeBase]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

TimeRangeBase

Value Description
500 500 ms
1000 1 second
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Value Description
60000 1 minute
3600000 1 hour
86400000 1 day

See also
OnlineTableControl (Page 5075)

TimeColumnTimeRangeFactor

Description   
Defines the factor for calculating the time range. Only integer factors are valid.

Syntax
Object.TimeColumnTimeRangeFactor

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

 

See also
OnlineTableControl (Page 5075)

TimeColumnUseValueColumnColors

Description
Defines whether the selected time column will be displayed in the value column colors.   

Access in Runtime: Read and write

Syntax
Object.TimeColumnUseValueColumnColors[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

BOOLEAN
TRUE: The selected time column is displayed in the colors of the value column. The settings 
in the "Font color" and "Background color" fields are disabled.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5632 System Manual, 02/2014



FALSE: The selected time column is displayed in the colors which are specified in the "Font 
color" and "Background color" fields.

 

See also
OnlineTableControl (Page 5075)

TimeColumnVisible

Description   
The list shows the time columns you created. Select the time columns to be displayed in the 
table from the list.

Click a time column entry in the list to adapt the properties and to define the time range of the 
time column.

Syntax
Object.TimeColumnVisible

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

See also
OnlineTableControl (Page 5075)

TimeJumpColor(i) 

Description
Specifies the color that is identified in the time jump available in the log. Whether the information 
is evaluated depends on the property "TimeJumpEnabled(i)".".

Access in Runtime: Read and write

Syntax
Object.TimeJumpColor(i)[=Color]

Object
Required A "ScreenItem"" object with the formats ""OnlineTrend" or ""TableView".".
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Color
Optional A value or a constant that specifies the color that identifies the time jump available 
in the log. 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TimeJumpEnabled(i)

Description
Specifies if the time jumps available in the log are identified in the color set up in 
"TimeJumpColor(i)". 

Access in Runtime: Read and write

Syntax
Object.TimeJumpEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or ""TableView".

BOOLEAN
Optional TRUE, if the time jumps available in the log are identified in the color specified in 
"TimeJumpColor(i)".

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TimeOverlapColor(i)

Description
Specifies the color that is identified in the time overlap available in the log. Whether the 
information is evaluated depends on the attribute "TimeOverlapEnabled(i)".".

Access in Runtime: Read and write

Syntax
Object.TimeOverlapColor(i)[=Color]
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Object
Required A "ScreenItem" object with the formats "OnlineTrend" or ""TableView".

Color
Optional A value or a constant that specifies the color that identifies the time overlap available 
in the log.

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TimeOverlapEnabled(i)

Description
Specifies if the time overlaps available in the log are identified in the color set up in 
"TimeOverlapColor(i)". 

Access in Runtime: Read and write

Syntax
Object.TimeOverlapEnabled(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend"" or "TableView".

BOOLEAN
Optional TRUE, if the time jumps overlaps available in the log are identified in the color 
specified in ""TimeOverlapColor(i)"".

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TimeRangeBase(i) 

Description
Specifies the unit for determining the time interval of the selected trend.   

Access in Runtime: Read and write
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Syntax
Object.TimeRangeBase(i)[=TagLoggingTimeUnit]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

TagLoggingTimeUnit
 ( 1): The time intervals are set up in milliseconds.

hmiCurveTimeRangeBase500ms (500): The time intervals are set up in 500 ms.

hmiCurveTimeRangeBaseSecond ( 1000): The time intervals are set up in seconds.

hmiCurveTimeRangeBaseMinute ( 60000): The time intervals are set up in minutes.

hmiCurveTimeRangeBaseHour ( 3600000): The time intervals are set up in hours.

hmiCurveTimeRangeBaseDay ( 86400000): The time intervals are set up in days.

Comments
The time range to be displayed for the trend i is achieved by multiplying the values 
"TimeRangeBase(i)" and "TimeRangeFactor(i)", whereby the value of "TimeRangeBase(i)" is 
interpreted in milliseconds. The "TimeRangeBase(i" and "TimeRangeFactor(i)" properties are 
only evaluated if the "TimeRange" property has the value "-1".

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

TimeRangeFactor(i)

Description
Specifies the factor for determining the time interval of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.TimeRangeFactor(i)[=Int]

Object
Required A "ScreenItem" object with the formats "OnlineTrend", "FunctionTrendView" or 
"TableView".
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Int
Optional A value or a constant that specifies the factor for determining the time interval of the 
selected trend.

Comments
The time range to be displayed for the trend i is achieved by multiplying the values 
""TimeRangeBase(i and "TimeRangeFactor(i)", whereby the value of "TimeRangeBase(i)" is 
interpreted in milliseconds. The "TimeRangeBase(i" and "TimeRangeFactor(i)" " properties 
are only evaluated if the property "TimeRange" has the value "-1".

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

Timestamp

Description
Returns the time stamp of the last read access of a tag in local time as DATE. 

Access in Runtime: Read

Syntax
Object.TimeStamp

Object
Required A "Tag" object. 

Comments
To show the TimeStamp property in plain text, use the VBS function "FormatDateTime(Date[, 
NamedFormat])". The output is dependent on the language setting. To adjust the language, 
use the VBS function "SetLocale´()". 

If you want to return the time stamp sorted by date, day and time, use the NamedFormat 
parameter or the VBS functions like Year, WeekDay, Day, Hour, Minute, Second. The name 
of a week day can be obtained using the VBS function WeekdayName. 
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Examples
The following example issues the time stamp of the tag "Tag11" with the aid of the function 
"FormatDateTime": 

 
'VBS87
Dim objTag
Dim lngCount
lngCount = 0
Set objTag = HMIRuntime.Tags("Tag11")
objTag.Read
SetLocale("en-gb")
MsgBox FormatDateTime(objTag.TimeStamp)    'Output: e.g. 06/08/2002 9:07:50
MsgBox Year(objTag.TimeStamp)    'Output: e.g. 2002
MsgBox Month(objTag.TimeStamp)    'Output: e.g. 8
MsgBox Weekday(objTag.TimeStamp)    'Output: e.g. 3
MsgBox WeekdayName(Weekday(objTag.TimeStamp))    'Output: e.g. Tuesday
MsgBox Day(objTag.TimeStamp)    'Output: e.g. 6
MsgBox Hour(objTag.TimeStamp)    'Output: e.g. 9
MsgBox Minute(objTag.TimeStamp)    'Output: e.g. 7
MsgBox Second(objTag.TimeStamp)    'Output: e.g. 50
For lngCount = 0 To 4
MsgBox FormatDateTime(objTag.TimeStamp, lngCount)
Next
'lngCount = 0: Output: e.g. 06/08/2002 9:07:50
'lngCount = 1: Output: e.g. 06 August 2002
'lngCount = 2: Output: e.g. 06/08/2002
'lngCount = 3: Output: e.g. 9:07:50
'lngCount = 4: Output: e.g. 9:07

The following example issues the time stamp of the tag "Tag1":

 
'VBS88
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Read
MsgBox objTag.TimeStamp

See also
Tag (Page 4975)

TitleBackColor

Description   
Specifies the background color of the table headers for the selected status. You open a color 
selection dialog box with the button.
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TitleCut

Description
Defines whether the content of the fields of a title bar should be shortened if the column width 
is too small. Write/Read access.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TitleDarkShadowColor

Description 
Specifies the color of the dark side of shading. You open a color selection with the button. The 
settings are only active if the "Shading Color" option is enabled.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TitleForeColor

Description   
Specifies the font color of the table headers for the selected status. You open a color selection 
dialog box with the button. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)
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TitleGridLineColor

Description 
Defines the color of row/column dividers in the table header. You open a color selection dialog 
box with the button.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TitleLightShadowColor

Description 
Specifies the color of the bright side of shading. You open a color selection dialog box with the 
button. The setting is only effective when the "Shading color" option is activated.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

Titleline

Description
TRUE, when the control has a title bar and it can be moved in Runtime. BOOLEAN write-read 
access.

TitleSort

Description
Defines how to trigger sorting by column title. You can only sort by column title if the "Auto-
scrolling" option is disabled.   

Access in Runtime: Read and write
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Syntax
Object.TitleSort[=GridSortTrigger]

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl", 
"OnlineTrendControl", "MessageView", "RecipeView".

GridSortTrigger

Value Description Explanation
0 No Sorting by column header is disabled.
1 With click Sorting is triggered by clicking in the column header.
2 With double-click Sorting is triggered by double-clicking in the column title.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

TitleStyle

Description
Specifies whether to set a shading color for the table header.   

Access in Runtime: Read and write

Syntax
Object.TitleStyle[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTableControl", 
"OnlineTrendControl", "MessageView", "RecipeView".

BOOLEAN

Value Description Description
0 Flat Disables the use of shading colors. Flat header style.
1 Button Enables the use of shading colors. 3D representation of the header.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

Toggle

Description
Specifies whether the selected object engages after it has been operated in Runtime. 

Access in Runtime: Read and write

Syntax
Object.Toggle[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Roundbutton".".

BOOLEAN
Optional TRUE, if the selected object engages after it has been operated in Runtime.

See also
Button (Page 5002)

Tolerance

Description
Specifies the limit for the storage space display as of which a deviation will be reported. 

Access in Runtime: Read and write

Syntax
Object.Tolerance[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView"".

Int
Optional A value or a constant that specifies the limit for the storage space display as of which 
a deviation will be reported.
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See also
DiskSpaceView (Page 5025)

ToleranceColor

Description
Specifies the colors in which the bars of the storage space display will be shown as soon as 
the tolerance range is exceeded. 

Access in Runtime: Read and write

Syntax
Object.ToleranceColor[=Color]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Color
Optional A value or a constant that specifies the colors in which the bars of the storage space 
display will be shown as soon as the tolerance range is exceeded.

See also
DiskSpaceView (Page 5025)

ToleranceHigh property

Description
Defines or returns the limit value for "Tolerance high". 
The type of the evaluation (in percent or absolute) is defined in the "TypeToleranceHigh" 
property.
The monitoring of the limit value is only valid if the "CheckToleranceHigh" property is set to 
"TRUE".

ToleranceLow property

Description
Defines or returns the limit value for "Tolerance low". 
The type of the evaluation (in percent or absolute) is defined in the "TypeToleranceLow" 
property.
The monitoring of the limit value is only valid if the "CheckToleranceLow" property is set to 
"TRUE".

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5643



ToleranceLowerLimit 

Description
Specifies whether the "ToleranceLowerLimit"" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies whether the limit "ToleranceLowerLimit" is 
monitored.

See also
Bar (Page 4995)

ToleranceLowerLimitColor

Description
Specifies the color for the lower limit "ToleranceLowerLimit"". 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the lower limit "ToleranceLowerLimit" 
".

Comments
The "ToleranceLowerLimitEnable" property must have the value TRUE if the bar color is to 
change once the limit has been reached.
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See also
Bar (Page 4995)

ToleranceLowerLimitEnabled

Description
Specifies whether the "ToleranceLowerLimit" limit is to be monitored. The limit, the display 
when the limit has been reached, and the type of evaluation are set with the properties 
"ToleranceLowerLimit", "ToleranceLowerLimitColor" and "ToleranceLowerLimitRelative". 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "ToleranceLowerLimit" limit is to be monitored.

See also
Bar (Page 4995)

ToleranceLowerLimitRelative

Description
Specifies whether the lower limit "ToleranceLowerLimit" is to be evaluated as a percentage or 
as an absolute value. 

Access in Runtime: Read and write

Syntax
Object.ToleranceLowerLimitRelative[=BOOLEAN]

Object
Required A ""ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit "ToleranceLowerLimit" is to be evaluated as a percentage or 
an absolute value.
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See also
Bar (Page 4995)

ToleranceUpperLimit 

Description
Specifies whether the "ToleranceUpperLimit" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimit[=Double]

Object
Required A "ScreenItem" object with the format ""Bar".

Double
Optional A value or a constant that specifies whether the limit "ToleranceUpperLimit" is 
monitored.

Comments
The following values will be specified with the properties "ToleranceUpperLimit", 
"ToleranceUpperLimitColor"" and "ToleranceUpperLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

ToleranceUpperLimitColor 

Description
Specifies the color for the upper limit "ToleranceUpperLimit". 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimitColor[=Color]
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Object
Required A "ScreenItem" object with the format "Bar".".

Color
Optional A value or a constant that specifies the color of the upper limit "ToleranceUpperLimit"".

See also
Bar (Page 4995)

ToleranceUpperLimitEnabled

Description
Specifies whether the "ToleranceUpperLimit"" limit is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimitEnabled[=BOOLEAN]

Object
Required A ""ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "ToleranceUpperLimit" limit is to be monitored. 

Comments
The following values will be specified with the properties "ToleranceUpperLimit",", 
"ToleranceUpperLimitColor" and "ToleranceUpperLimitRelative": 

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5647



ToleranceUpperLimitRelative

Description
Specifies whether the lower limit "ToleranzHigh"" is to be evaluated as a percentage or as an 
absolute value. 

Access in Runtime: Read and write

Syntax
Object.ToleranceUpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Bar".

BOOLEAN
Optional TRUE, if the lower limt "ToleranzHigh" is to be evaluated as a percentage or an 
absolute value.

See also
Bar (Page 4995)

ToolbarAlignment

Description   
Defines or returns the position of the toolbar. Write/Read access.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarBackColor

Description
Background color - ToolbarBackColor

Specifies the background color of the toolbar. Open the "Color selection" dialog by clicking the 
button.
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The background color you configured is only displayed if the "Display" option is enabled.   

Access in Runtime: Read and write

Syntax
Object.ToolbarBackColor[=Color]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", 
"RecipeView".

Color
Optional A value or a constant which specifies the background color.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonActive

Description
Activates a button function in Runtime. Clicking the button in Runtime triggers the 
corresponding function.   

Access in Runtime: Read and write

Syntax
Object.ToolbarButtonActive[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", 
"RecipeView".

BOOLEAN
TRUE: The function connected to the key is active.

FALSE: The function connected to the key is not active. You can connect your own functions 
to the key by local scripts.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonAdd

Description  
Creates a new, user-defined button function. The name set by WinCC can be edited in the 
"Object name" field. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonBeginGroup

Description
Inserts a leading separator (vertical line) for the selected button function on the toolbar. These 
separators can be used to group the icons of the button functions.   

Access in Runtime: Read and write

Syntax
Object.ToolbarButtonBeginGroup[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", 
"RecipeView".

BOOLEAN
TRUE: The separator is inserted in front of the selected key function.

FALSE: The separator is not inserted in front of the selected key function.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonCount

Description     
Indicates the number of buttons contained in the toolbar.

 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonEnabled

Description   
Enables operation of custom toolbar buttons. 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)
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ToolbarButtonHotKey

Description
Shows the hotkey for a button function selected. 

You create or edit a hotkey by clicking in the "Hotkey" field and pressing the button or key 
shortcut required.  .

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonID

Description
Unique ID number for the selected button function. WinCC assigns this read only ID number.  .

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonIndex

Description   
References a button function. Using this attribute you can assign the values of other attributes 
to a specific button function. 

Valid values for "ToolbarButtonIndex" are between 0 and "ToolbarButtonCount" minus 1. The 
"ToolbarButtonCount" attribute specifies the number of configurable key functions.
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonLocked

Description 
Enables/disables the display of the pressed state of a user-defined toolbar button.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonName

Description
Returns the name of the selected button. You can change the name for user-defined buttons. 
The "ToolbarButtonName" property for user-defined buttons can be dynamized using the 
"ToolbarButtonRename" property.  

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)
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ToolbarButtonPasswordLevel

Description
Shows the authorization for a button function selected. You can edit the authorization using 
the selection button.   The authorizations are configured in the user administration.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonRemove

Description    
Removes the selected button. Only user-defined buttons can be removed.

Access in Runtime: Write

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonRename

Description     
Returns the name of the user-defined toolbar button that is being referenced via the 
"ToolbarButtonID" property. 

With "ToolbarButtonRename" you also dynamize the "ToolbarButtonName" property.

Access in Runtime: Write
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See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonRepos

Description
Changes the sorting order of button functions. "Up" and "Down" move the button function 
selected up or down in the list. This moves the button function in the toolbar of a Control towards 
the front or towards the back.   

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarButtonTooltipText

Description   
Specifies the tooltip text for the button.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)
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ToolbarButtonUserDefined

Description
Indicates whether the project engineer has added the toolbar button as new user-defined 
button.  

Access in Runtime: Read  

Syntax
Object.ToolbarButtonUserDefined[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"FunctionTrendControl", "TrendRulerControl", "UserArchiveControl".

Boolean
TRUE: The key of the toolbar is customized.

FALSE: The key of the toolbar is specified by the system.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarShowTooltips

Description
Enables the display of tooltips for the button functions in Runtime. The property can be 
dynamized with the ToolbarShowTooltips name. The property for specifying the tooltip text is 
"ToolbarButtonTooltipText".    

Access in Runtime: Read and write

Syntax
Object.ToolbarShowTooltips[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The tooltips are displayed.

FALSE: The tooltips are not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarUseBackColor

Description
Enables the display of the background color for a toolbar.     

Access in Runtime: Read and write

Syntax
Object.ToolbarUseBackColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The background color of the toolbar is displayed.

FALSE: The background color of the toolbar is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)
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OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarUseHotKeys

Description
Activates the hotkeys for button functions in Runtime. Insert the hotkeys for button functions 
in the "Hotkey" field.     

Access in Runtime: Read and write

Syntax
Object.ToolbarUseHotKeys[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "RecipeView", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The hotkeys are activated.

FALSE: The hotkeys are not activated.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarVisible

Description
Specifies whether the toolbar of the control is displayed.     

Access in Runtime: Read and write

Syntax
Object.ToolbarVisible[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"TrendRulerControl", "OnlineTableControl", "FunctionTrendControl", "UserArchiveControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The toolbar is displayed.

FALSE: The toolbar is not displayed.

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

OnlineTrendControl (Page 5083)

ToolbarVisible

Description
Enables the display of the Control toolbar.   

Access in Runtime: Read and write

Syntax
Object.ToolbarVisible[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "MessageView", "RulerControl", 
"OnlineTableControl", "OnlineTrendControl", "FunctionTrendControl", "RecipeView".

BOOLEAN
TRUE: The toolbar is displayed.

FALSE: The toolbar is not displayed.

ToolTipText

Description
Specifies the tooltip text. 

Access in Runtime: Read and write
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Syntax
Object.ToolTipText[=String]

Object
Required A "ScreenItem" object with the formats "Line", "Polyline", "Ellipse", "Circle", 
"EllipseSegment", "CircleSegment", "EllipticalArc", "CircularArc", "Rectangle", "Polygon", 
"TextField", "IOField", "SymbolicIOField", "Button", "Roundbutton", "Switch", "GraphicView", 
"GraphicIOField", "Bar", "StatusForce", "Checkbox", "OptionGroup", "WindowSlider", 
"OleView" or "Connector".

String
Optional A value or a constant that specifies the tooltip text.

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)
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TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

Listbox (Page 5065)

Top 

Description
Specifies the value of the Y coordinate of the selected object.     

Access during runtime: Read and write

Syntax
Object.Top[= DOUBLE]

Object
Necessary. A "ScreenItem" object. This property is a standard property of the ScreenItem 
object and is therefore available for all formats.

DOUBLE
Optional A value or a constant that contains the value of the Y coordinate in pixels (measured 
from the top left edge of the screen).

Comments
The Y coordinate refers to the top left corner of the rectangle that surrounds the object. The 
screen limits are also monitored in runtime. If the assigned coordinate value exceeds the 
display size, the user-defined function is interrupted with an error message. 

Used for the following object types:
IOField

Rectangle

Slider

 

 

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)
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EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

ForeignControl (Page 5034)

DateTimeField (Page 5023)

ProtectedAreaName (Page 5102)
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UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

UserArchiveControl (Page 5167)

SystemDiagnoseView (Page 5137)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

BatteryView (Page 5001)

RangeLabelView (Page 5103)

ZoneQualityView (Page 5181)

ZoneLabelView (Page 5180)

WLanQualityView (Page 5179)

TrendView (Page 5155)

SystemDiagnoseWindow (Page 5140)

StatusForce (Page 5125)

SmartClientView (Page 5123)

RecipeView (Page 5106)

RangeQualityView (Page 5105)

AlarmView (Page 4992)

TopConnectedConnectionPointIndex

Description
Specifies or sets the index number of the top connecting point.

LONG write-read access.
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TopConnectedObjectName

Description
Specifies or sets the object name of the object which is docked on at the bottom connecting 
point.

LONG write-read access.

TopOffset

Description 
Defines or returns the distance of the picture from the top edge of the picture window. 

The picture is displayed as a cutout of the picture window. The picture scroll bars are located 
at the left and upper edge of the picture. If you wish to display the picture in the picture window 
by using the horizontal and vertical positioning of the picture scroll bars, use the properties 
"HorizontalScrollBarPosition" and "VerticalScrollBarPosition" for such positioning.

See also
ScreenWindow (Page 5116)

Total 

Description
Returns the storage capacity. 

Access in Runtime: Read and write

Syntax
Object.Total[=Double]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Double
Optional A value or a constant that returns the storage capacity.

See also
DiskSpaceView (Page 5025)
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Transparency

Description 
Defines and returns the percentage transparency of the object. 

0 = no transparency; 100 = complete transparency (invisible)

The text and fields of the graphic objects are only transparent at "100."

In runtime, a completely transparent object (invisible) is also functional. 

See also
Slider (Page 5120)

CheckBox (Page 5008)

GraphicIOField (Page 5049)

Bar (Page 4995)

WindowSlider (Page 5176)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)

Line (Page 5063)

Listbox (Page 5065)

Button (Page 5002)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicView (Page 5052)

Polygon (Page 5095)

Polyline (Page 5098)
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RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

TransparentColor

Description
Specifies which color of the allocated graphic (*.bmp, *dib) of the specified object will be set 
to "transparent".   

The "UseTransparentColor" property must have the value TRUE so that the color will be shown 
as transparent.

Access in Runtime: Read and write

Syntax
Object.TransparentColor[= Color]

Object
Required An object of type "ScreenItem" with the formats "GraphicView" or "GraphicIOField".

Color
Optional A value or a constant that specifies the color that will be shown transparent.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
GraphicView (Page 5052)

GraphicIOField (Page 5049)

UseTransparentColor (Page 5717)
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TransparentColorDeactivatedPicture

Description
Specifies which color of the allocated bitmap object will be set to "transparent" for the status 
"disabled". 

Access in Runtime: Read and write

Syntax
Object.TransparentColorDeactivatedPicture[=Color]

Object
Required A ""ScreenItem" object with the format ""Roundbutton".

Color
Optional A value or a constant that specifies which color of the allocated bitmap object will be 
set to transparent" for the status "disabled".

Comments
The "PicDeactUseTransColor" property must have the value TRUE so that the color can be 
set to ""transparent".

TransparentColorPictureOff

Description
Specifies which color of the allocated bitmap object will be set to transparent" for the status 
"off". 

Access in Runtime: Read and write

Syntax
Object.TransparentColorPictureOff[=Color]

Object
Required A "ScreenItem" object with the format "Roundbutton".

Color
Optional A value or a constant that specifies which color of the allocated bitmap object will be 
set to transparent" for the status "off".

See also
Button (Page 5002)
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TransparentColorPictureOn

Description
Specifies which color of the allocated bitmap object will be set to transparent" for the status 
"on". 

Access in Runtime: Read and write

Syntax
Object.TransparentColorPictureOn[=Color]

Object
Required A "ScreenItem" object with the format "Roundbutton".

Color
Optional A value or a constant that specifies which color of the allocated bitmap object will be 
set to "transparent" for the status "on".

Comments
The "PicDownUseTransColor"" property must have the value TRUE so that the color can be 
set to "transparent".

See also
Button (Page 5002)

Trend

Description
TRUE, when the tendency (rising or falling) of the measuring value being monitored should 
be displayed by a small arrow. BOOLEAN write-read access. 

TrendActualize

Description
Enables the update of a selected trend.     

Access in Runtime: Read and write

Syntax
Object.TrendActualize[=BOOLEAN]

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5668 System Manual, 02/2014



Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The selected trend is always actualized.

FALSE: The selected trend is not actualized. This setting is useful when a logged trend is 
compared with a current trend.

See also
FunctionTrendControl (Page 5038)

TrendAdd

Description
Creates a new trend.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendBeginTime

Description
Defines the start time of the time range for data transfer to the selected trend.  .

See also
FunctionTrendControl (Page 5038)

TrendColor

Description
Determines the color of the trend display or returns it.
The trend display indicates the tendency (rising or falling) of the measuring value being 
monitored by a small arrow. In order to activate the trend display, the Trend property must be 
set to "True". LONG write-read access. 
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See also
FunctionTrendControl (Page 5038)

TrendColor

Description
Determines the color of the trend display or returns it.
The trend display indicates the tendency (rising or falling) of the measuring value being 
monitored by a small arrow. In order to activate the trend display, the Trend property must be 
set to "True". LONG write-read access. 

See also
OnlineTrendControl (Page 5083)

TrendCount

Description   
Defines the number of configured trends.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendEndTime

Description
Defines the end of the time range for data connections of a selected trend. 

 .

See also
FunctionTrendControl (Page 5038)

TrendExtendedColorSet

Description
Enables configuration of the point and fill colors and the display of colors in Runtime.     
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Access in Runtime: Read and write

Syntax
Object.TrendExtendedColorSet[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The settings in the "Point color" and "Fill color" fields are configurable and effective in 
Runtime.

FALSE: The settings in the "Point color" and "Fill color" fields are not configurable and effective 
in Runtime.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendFill

Description
Specifies if the area beneath the trend is to be filled.     

Access in Runtime: Read and write

Syntax
Object.TrendFill[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The area beneath the trend is shown filled. You can define the trend color as fill color 
if the "Advanced" option is deactivated. 

FALSE: The trend is not shown filled.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendFillColor

Description
Specifies the fill color of the trend. The settings are only active if the "Filled" option is enabled. 
Open the "Color selection" dialog by clicking the button.

The settings are only active if the "Advanced" option is enabled.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendIndex

Description   
References a configured trend. You can assign the values of other properties to a specific 
trend by using the property. The index must always be set before you change the properties 
of a trend in runtime.

Valid values for "TrendIndex" are between 0 and "TrendCount" minus 1. The "TrendCount" 
property indicates the number of configured trends.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendIndicatorColor

Description
Specifies the color for the trend indicator. The trend indicator represents the tendency 
(increasing or falling) of the measurement value that is to be monitored with a small arrow. To 
activate the trend indicator, the property "ShowTrendIndicator" must have the value TRUE. 

Access in Runtime: Read and write

Syntax
Object.TrendIndicatorColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".
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Color
Optional A value or a constant that specifies the color of the trend indicator.

See also
Bar (Page 4995)

TrendLabel

Description
Defines the label of the trend selected. The label is displayed in Runtime if the value at attribute 
"UseTrendNameAsLabel" is "FALSE". 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendLineStyle

Example
Defines the line style for trend visualization.     

Access in Runtime: Read and write

Syntax
Object.TrendLineStyle[=LineStyle]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

LineStyle

Value Description Explanation
0 Solid The trend is visualized as solid line.
1 Dashed The trend is visualized as dashed line.
2 Dotted The trend is visualized as dotted line.
3 Dash dot The trend is visualized as dot-dash line.
4 Dash Dot Dot The trend is visualized as dash-dot-dot line.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendLineType

Description
Defines how to visualize a trend.     

Access in Runtime: Read and write

Syntax
Object.TrendLineType[=LineType]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

LineType

Value Description Explanation
0 None Only the dots are displayed.
1 Line Visualizes a trend with linear interconnection of points. 
2 Stepped Visualizes a stepped trend and its interconnected points.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendLineWidth

Description
Defines the line weight of the line displayed.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendLowerLimit

Description  
Specifies the low limit of a tag. If the tag drops below the value of "TrendLowerLimit", the values 
are marked with the color set in "TrendLowerLimitColor". The specification is effective if the 
"TrendLowerLimitColoring" property has the value "TRUE".

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendLowerLimitColor

Description  
Specifies the color which marks tag values which are below the value of "TrendLowerLimit". 
The setting is effective if the "TrendLowerLimitColoring" attribute has the value "TRUE". 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendLowerLimitColoring

Description
Enables the "TrendLowerLimitColor" attribute for identifying tag values which are less than the 
value at "TrendLowerLimitValue".     

Syntax
Object.TrendLowerLimitColoring [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Boolean
TRUE: The "TrendLowerLimitColor" property is effective.

FALSE: The "TrendLowerLimitColor" property is not effective.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendMeasurePoints

Number of measurement points - TrendMeasurePoints
Defines the number of measurement points for visualization of selected trends. 

Defines the number of value pairs provided to the trend from a user archive.

The attribute can be assigned dynamic properties by means of the name 
TrendMeasurePoints.

See also
FunctionTrendControl (Page 5038)

TrendName

Description
Displays the name of the selected trend. The name is defined on the "Trends" tab. The 
"TrendName" property can be dynamized by the TrendRename property.     

Access in Runtime: Read and write

Syntax
Object.TrendName

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendPointColor

Description
Defines the color of trend points. Open the "Color selection" dialog by clicking the button.
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The settings are only active if the "Advanced" option is enabled. 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendPointStyle

Description
Defines the dot style for trend visualization.     

Access in Runtime: Read and write

Syntax
Object.TrendPointStyle[=PointStyle]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

PointStyle

Value Description Explanation
0 None The points are not displayed.
1 Dots The trend points are visualized with a size of one pixel. The setting 

in the "Dot width" field is deactivated.
2 Squares The dots are displayed as square. The setting in the "Dot width" 

field is active.
3 Circles The dots are displayed as circles. The setting in the "Dot width" field 

is active.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendPointWidth

Description
Sets the dot width in pixels. You can only define the dot width for the "square" and "circular" 
type.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendProvider 

Description
Specifies the data source for a selected trend.     

Access in Runtime: Read and write

Syntax
Object.TrendProvider[=Provider]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Provider

Value Description  Explanation
0 None No data source configured for implementation in Runtime by means of 

a user-defined function.
1 Archive tags Data source with archive tags of a process value archive.
2 HMI tags Data supply with tag values of HMI tags
3 Recipe data Data supply with columns of a recipe

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendRangeType

Description
Defines the time range for providing data to the selected trend. 

You can only define the number of measuring points if you select user archives as the data 
source.     

Access in Runtime: Read and write
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Syntax
Object.TrendRangeType[=RangeType]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

RangeType

Value Description Explanation
0 Time range Defines the start time and the time range for the data 

connection.
1 Start to end time Defines the start and end time for the data connection.
2 Number of measurement 

points
Defines the start time and the number of measurement points 
for the data connection. 

See also
FunctionTrendControl (Page 5038)

TrendRemove

Description
Removes selected trends from the list.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendRename

Description   
Changes the name of the trend which is referenced by the "TrendIndex" property.

With "TrendRename" you also dynamize the "TrendName" property.

 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendRepos

Description
Repositions the trend in the trend window. "Up" and "Down" move the selected trend up or 
down in the list. This moves the trend towards the foreground or background for visualization 
in Runtime. 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendSelectTagNameX

Description   
Opens the dialog box for selecting the tag name for the data supply of the X axis in the f(x) 
trend view. Programmers can use the property to let the user select a tag name with a button 
for example.

See also
FunctionTrendControl (Page 5038)

TrendSelectTagNameY

Description   
Opens the dialog box for selecting the tag name for the data supply of the Y axis in the f(x) 
trend view. Programmers can use the property to let the user select a tag name with a button 
for example.

 

See also
FunctionTrendControl (Page 5038)

TrendTag

Description
Specifies which tag is linked with the selected trend. 
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You enter the value either in the form "archive name/tag name", to show tags of a process 
value archive, or in the form "tag name" to show an internal or an external tag that will now be 
saved in an archive. 

Access in Runtime: Read and write

Syntax
Object.TrendTag[=HmiTag]

Object
Required A ""ScreenItem" object with the format "OnlineTrend".

HmiTag
Optional A value or a constant that specifies which tags are linked with the selected trend. 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

TrendTagNameX

Description
Shows the name of the bound HMI tag or column for the X axis. You select an HMI tag or a 
column with the selection button.     

Access in Runtime: Read and write

Syntax
Object.TrendTagNameX

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
FunctionTrendControl (Page 5038)
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TrendTagNameY

Description
Shows the name of the bound HMI tag or column for the Y axis. You select an HMI tag or a 
column with the selection button.     

Access in Runtime: Read and write

Syntax
Object.TrendTagNameX

Object
Required. An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

See also
FunctionTrendControl (Page 5038)

TrendTimeRangeBase

Description
Defines the time unit for calculating the time range.     

Access in Runtime: Read and write

Syntax
Object.TrendTimeRangeBase[=TimeRangeBase]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

TimeRangeBase

Value Description
500 500 ms
1000 1 second
60000 1 minute
3600000 1 hour
86400000 1 day
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See also
FunctionTrendControl (Page 5038)

TrendTimeRangeFactor

Description
Defines the factor for calculating the time range. Only integer factors are valid.  .

See also
FunctionTrendControl (Page 5038)

TrendTrendWindow

Description
Defines the trend window for visualizing the trend selected. Define the available trend windows 
in the "Trend window" tab.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendUncertainColor

Description   
Value are in uncertain state if the initial value is unknown after runtime has been activated, or 
if a substitute value is used. With the "TrendUncertainColor" property you specify the color 
which is used for marking these values. Whether the information is evaluated depends on the 
"TrendUncertainColoring" property.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendUncertainColoring

Description
Value are in uncertain state if the initial value is unknown after runtime has been activated, or 
if a substitute value is used. The "TrendUncertainColoring" attribute is used to enable 
identification of such values based on the color set in "TrendUncertainColor".     

Access in Runtime: Read and write

Syntax
Object.TrendUncertainColoring[=BOOLEAN]

Object

Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The setting of the "TrendUncertainColor" property is effective.

FALSE: The setting of the "TrendUncertainColor" property is not effective.

 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendUpperLimit

Description   
Specifies the high limit of a tag. If the tag drops below the value of "TrendUpperLimit", the 
values are marked by the color set in "TrendUpperLimitColor". The specification is effective if 
the "TrendUpperLimitColoring" attribute has the value "TRUE".

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendUpperLimitColor

TrendUpperLimitColor
Specifies the color of tag values which are less than the value at "TrendLowerLimit". This 
setting is only active if the value at attribute "TrendUpperLimitColoring" is "TRUE". 

The attribute can be assigned dynamic properties by means of the name 
TrendUpperLimitColor.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendUpperLimitColoring

Description
Specifies whether the selection frame is shown with the specified color.     

Access in Runtime: Read and write

Syntax
Object.TrendUpperLimitColoring[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The setting of the "TrendUpperLimitColor" attribute is effective.

FALSE: The setting of the "TrendUpperLimitColor" attribute is not effective.

 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendVisible

Description
The list shows all trends you created.
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Select the trends to be displayed in the trend window from the list.

Click a trend entry in the list to adapt the properties and to assign axes and trend windows to 
the trend.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowAdd

Description
Create a new trend view.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowCoarseGrid

Description
Enables the display of grid lines for the main scale.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowCoarseGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines for the main scaling are displayed.

FALSE: The grid lines for the main scaling are not displayed.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowCoarseGridColor

Description
Specifies the grid color of the main scale. Open the "Color selection" dialog by clicking the 
button.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowFineGrid

Description
Enables the display of grid lines for the secondary scale.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowFineGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines for the auxiliary scaling are displayed.

FALSE: The grid lines for the auxiliary scaling are not displayed.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5687



TrendWindowFineGridColor

Description
Specifies the grid color of the main scale. Open the "Color selection" dialog by clicking the 
button.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowForegroundTrendGrid

Description
Enables the display of grid lines only for the foreground trend in the trend window.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowForegroundTrendGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines for the foreground trend are displayed.

FALSE: The grid lines for the foreground trend are not displayed.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowGridInTrendColor

Description
Sets the trend color for the visualization of the grid lines for the main scale.     

Access in Runtime: Read and write

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5688 System Manual, 02/2014



Syntax
Object.AutoSelectionRectColors [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The grid lines are displayed in the trend color.

FALSE: The grid lines are displayed with the color set in the "Color" field.

 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowHorizontalGrid

Description
Enables the display of horizontal grid lines.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowHorizontalGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The horizontal grid lines are displayed.

FALSE: The horizontal grid lines are not displayed.

 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendWindowIndex

Description   
References a configured trend view. You can assign the values of other properties to a specific 
trend window by using the property.

Valid values for "TrendWindowIndex" are between 0 and "TrendWindowCount" minus 1. The 
"TrendWindowCount" property indicates the number of configured trend windows.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowName

Description
Defines the name of the trend window selected.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowRemove

Description
Removes the selected trend view from the list.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowRename

Description  
Changes the name of the trend window which is referenced by the "TrendWindowIndex" 
property.

With "TrendWindowRename" you also dynamize the "TrendWindowName" property.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowRepos

Description
Changes the order of the trend view. "Up" and "Down" move the selected trend up or down in 
the list. 

The sorting order in the list defines the position in the Control. The first trend view is shown in 
the lowest position, the last trend view in the highest position.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowRulerColor

Description
Specifies the ruler color. Open the "Color selection" dialog by clicking the button. 

The color can be configured and displayed if "1 - graphic" is set for visualization. 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowRulerLayer

Description
Specifies the display layer of the ruler in the trend view.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowRulerLayer[=RulerLayer]
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Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

RulerLayer 

Value Description Explanation
0 Under grid The ruler is visualized on a layer under the grid.
1 Between grid and 

trend
The ruler is positioned on top of the trend and under the grid.

2 On top of trend The ruler is positioned on top of the trend.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowRulerStyle

Description
Defines the appearance of the ruler.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowRulerStyle [=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl", (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The ruler is displayed as a single black line.

FALSE: The ruler is is displayed in the configured "Color" and "Width".

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)
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TrendWindowRulerWidth

Description
Defines the width of the ruler in pixels.

The width can be configured and displayed if "1 - graphic" is set for visualization. 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowSpacePortion

Description
Specifies the proportion of the trend widow to be used for the selected curve. 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowVerticalGrid

Description
Enables the display of vertical grid lines.     

Access in Runtime: Read and write

Syntax
Object.TrendWindowVerticalGrid[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The vertical grid lines are displayed.

FALSE: The vertical grid lines are not displayed.
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See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendWindowVisible

Description
The trend lines which you have created are listed in the list.

Activate the trend views in the list which you want to display in the control.

Click a list entry to adapt the ruler and grid line properties.

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

TrendXAxis

Description
Defines the X axis to be used for the trend selected. Define the available X axes inn the "X 
Axes" tab.

See also
FunctionTrendControl (Page 5038)

TrendYAxis

Description
Defines the Y axis to be used for the trend selected. Define the available Y axes inn the "Y 
Axes" tab.

See also
FunctionTrendControl (Page 5038)
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Type

Description
Returns the type of the specified object as STRING. Name diagram: Hmi<ObjectName>, e.g. 
HmiCircle for the "circle" screen object. 

Access in Runtime: Read

Syntax
Object.Type

Object
Required A "ScreenItem" object.

TypeAlarmHigh

Description
TRUE, when the upper limit value, at which an alarm is triggered, should be evaluated as a 
percentage. FALSE, when the evaluation should be as an absolute value. BOOLEAN write-
read access. 

TypeAlarmLow

Description
TRUE, when the lower limit value, at which an alarm is triggered, should be evaluated as a 
percentage. FALSE, when the evaluation should be as an absolute value. BOOLEAN write-
read access. 

TypeLimitHigh4

Description
TRUE, when the "Reserve 4" upper limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeLimitHigh5

Description
TRUE, when the "Reserve 5" upper limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5695



TypeLimitLow4

Description
TRUE, when the "Reserve 4" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access.

TypeLimitLow5

Description
TRUE, when the "Reserve 5" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeToleranceHigh

Description
TRUE, when the "Tolerance high" lower limit value should be evaluated as a percentage. 
FALSE, when the evaluation should be as an absolute value. BOOLEAN write-read access.

TypeToleranceLow

Description
TRUE, when the "Tolerance low" lower limit value should be evaluated as a percentage. 
FALSE, when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeWarningHigh

Description
TRUE, when the "Warning high" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 

TypeWarningLow

Description
TRUE, when the "Warning low" lower limit value should be evaluated as a percentage. FALSE, 
when the evaluation should be as an absolute value. BOOLEAN write-read access. 
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Properties U-W

UncertainStateColor(i) 

Description
Specifies the color for the identification of values with an uncertain status. 

Access in Runtime: Read and write

Syntax
Object.UncertainStateColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Color
Optional A value or a constant that specifies the color for the identification of values with an 
uncertain status.

Comments
The parameter i indicates the number of the trend. 

If the start value of a value is not known after Runtime has been activated or a substitute value 
is used, then this value has an uncertain status.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

UncertainStateEnabled(i)

Description
Specifies if values with an uncertain status are identified with the color set up in 
"ReplacementColor(i)"". 

If the start value of a value is not known after Runtime has been activated or a substitute value 
is being used, then this value is considered to have an uncertain status. 

Access in Runtime: Read and write
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Syntax
Object.UncertainStateEnabled(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if values with an uncertain status are identified with the color specified in 
""ReplacementColor(i".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

Unit

Description
Specifies the unit of measurement in the "IOField" object.

See also
Bar (Page 4995)

IOField (Page 5059)

UnitColor

Description
Specifies the text color for the label of the measurement unit in the "Gauge" object 

Access in Runtime: Read and write

Syntax
Object.UnitColor[= Color]

Object
Required A "ScreenItem" object with the format "Gauge".
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Color
Optional A value or a constant that specifies the text color for the measurement unit.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Gauge (Page 5046)

UnitText

Description
Specifies the text for the measurement unit of the selected object. 

Access in Runtime: Read and write

Syntax
Object.UnitText[= STRING]

Object
Required A "ScreenItem" object with the format ""Gauge".

STRING
Optional A value or a constant that specifies the text for the measurement unit.

Comments
Enter a text to show, for example, the physical unit of the displayed value. It is standard for no 
text to be set as a default.

See also
Gauge (Page 5046)
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UnitTop

Description
Specifies the distance of the measurement unit to the upper edge of the selected object. The 
lettering can be positioned only in line with the vertical diameter of the scale. The value of the 
property refers to the height of the selected object and is measured from the upper edge of 
the selected object to the lower edge of the lettering. 

Access in Runtime: Read and write

Syntax
Object.UnitTop[=Double]

Object
Required A ""ScreenItem" object with the format "Gauge".

Double
Optional A value or a constant that specifies the distance of the measurement unit to the upper 
edge of the selected object.

Value range from 0 to 1 

0: The lower edge of the lettering is positioned on the upper limit of the selected object. The 
text is no longer visible as it is positioned outside of the selected object. 

1: The lower edge of the lettering is positioned on the lower limit of the selected object.

See also
Gauge (Page 5046)

UnselBGColor property 

Description
Defines or returns the background color of entries in the text list object which are not selected. 
LONG write-read access.

UnselTextColor property

Description
Defines or returns the color of the text for entries in the text list object which are not selected. 
LONG write-read access.
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UpdateCycle property

Description
Returns the type and frequency of updating the picture window in Runtime. Read only access.

UpdateEnable

Description
Specifies whether the recipe view can be altered in Runtime.   

Access in Runtime: Read and write

Syntax
Object.UpdateEnable[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "UserArchiveControl".

BOOLEAN
Optional TRUE, if the recipe view can be altered in Runtime.

UpperLimit

Description
Specifies the upper limit for input values. 

Access in Runtime: Read and write

Syntax
Object.UpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "IOField".

Double
Optional A value or a constant that specifies the upper limit for input values.

See also
IOField (Page 5059)
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UpperLimitColor(i)

Description
Specifies the color that identifies the tag values that lie above the value of 
""UpperLimitValue(i)". Whether the information is evaluated depends on the value of the 
property ""UpperLimitEnabled(i)". 

Access in Runtime: Read and write

Syntax
Object.UpperLimitColor(i)[=Color]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

Color
Optional A value or a constant that identifies the tag values that lie above the value of 
""UpperLimitValue(i)". 

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

UpperLimitEnabled(i)

Description
Specifies whether the information from "UpperLimitColor(i)" is used to identify the tag values 
that lie above the value of "UpperLimitValue(i)". 

Access in Runtime: Read and write

Syntax
Object.UpperLimitEnabled(i)[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl" or "OnlineTableControl".

BOOLEAN
Optional TRUE, if the information from "UpperLimitColor(i)"" is used to identify the tag values 
that lie above the value of "UpperLimitValue(i)".

Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

UpperLimitValue(i) 

Description
Specifies whether the tag values that exceed the "UpperLimitValue(i)" are to be identified with 
the color specified in "UpperLimitColor(i)"". Whether the information is evaluated depends on 
the value of the property "UpperLimit(i)".".

Access in Runtime: Read and write

Syntax
Object.UpperLimitValue(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies whether the tag values that exceed the 
""UpperLimitValue(i)" value are to be identified with the color specified in UpperLimitColor(i)"".

Comments
The parameter i indicates the number of the trend. 
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

UseAllServers

Description
Specifies whether the data to be shown in the alarm window can be requested from all servers 
in a distributed system. Alarm Logging must be activated on the respective servers. 

Access in Runtime: Read-only

Syntax
Object.UseAllServers[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "AlarmView".

BOOLEAN
Optional. TRUE, if the data to be shown in the alarm window can be requested from all servers 
in a distributed system.

See also
AlarmControl (Page 4981)

UseBarBorderConstraints

Description
Specifies whether the bar border is restricted to specific values. 

Access in Runtime: Read and write

Syntax
Object.UseBarBorderConstraints[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional. TRUE, if the bar border is restricted to specific values.
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See also
Bar (Page 4995)

UseTagLimitColors

Description
Specifies that colors are used.

UseDesignColorShema

Description
Defines whether the colors defined for the current design in the global color scheme will be 
used for this object. 

TRUE if the object is displayed with the colors from the global color scheme defined for this 
object type. 

FALSE if the object is displayed with the colors as per the settings in the object. 

BOOLEAN write-read access. 

See also
Slider (Page 5120)

CheckBox (Page 5008)

Button (Page 5002)

Bar (Page 4995)

WindowSlider (Page 5176)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)

Line (Page 5063)

Listbox (Page 5065)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)
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Connector (Page 5020)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicView (Page 5052)

Polygon (Page 5095)

Polyline (Page 5098)

RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

UseDesignShadowSettings

Description
Defines whether the object will be displayed with the shadowing defined in the active design. 

TRUE if the object is displayed with the global shadow defined for this object type. 

FALSE if no shadow is displayed. 

BOOLEAN write-read access. 

See also
Slider (Page 5120)

CheckBox (Page 5008)

GraphicIOField (Page 5049)

Button (Page 5002)

Bar (Page 4995)

WindowSlider (Page 5176)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

Rectangle (Page 5110)

MultiLineEdit (Page 5070)
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Line (Page 5063)

Listbox (Page 5065)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicView (Page 5052)

Polygon (Page 5095)

Polyline (Page 5098)

RoundButton (Page 5112)

SymbolicIOField (Page 5130)

IOField (Page 5059)

TextField (Page 5144)

OptionGroup (Page 5092)

UseEffectiveProcessValue

Description
Specifies whether an actual percentage made up of maximum value, minimum value, average 
of the last 15 values and hysteresis will be used. 

Access in Runtime: Read and write

Syntax
Object.UseEffectiveProcessValue[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if an actual percentage made up of maximum value, minimum value, average 
of the last 15 values and hysteresis will be used.
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See also
Bar (Page 4995)

UseExponentialFormat 

Description
Specifies whether the figures are shown exponentially (e.g. "1,00e+000"). 

Access in Runtime: Read and write

Syntax
Object.UseExponentialFormat[=BOOLEAN]

Object
Required A "ScreenItem"  object with the format "Bar".

BOOLEAN
Optional TRUE, if the figures are shown exponentially (e.g. "1,00e+000").

See also
Bar (Page 4995)

UseFlashTransparentColor

Description
Specifies whether the color of the bitmap object of a flashing graphic will be set to 
""transparent". 

Access in Runtime: Read and write

Syntax
Object.UseFlashTransparentColor[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "GraphicIOField".

BOOLEAN
Optional TRUE, if the color of the bitmap object of a flashing graphic will be set to "transparent".
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See also
GraphicIOField (Page 5049)

UseGDI 

Description
Specifies whether the ellipse is shown via GDI or GDI+. 

Access in Runtime: Read and write

Syntax
Object.UseGDI[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Ellipse".

BOOLEAN
Optional TRUE, if the ellipse is shown via GDI.

See also
Ellipse (Page 5027)

UseMeasurePoints(i) 

Description
Specifies whether the time range for the selected trend will be determined by measuring points 
or the end time. Whether the information is evaluated depends on the properties 
"TimeAxisEndTime", "TimeAxisBeginTime(i)". 

Define time range for curve i through measure points (TRUE) or end time (FALSE) (for time 
based tag providers)

Access in Runtime: Read and write

Syntax

Object.UseMeasurePoints(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl"or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the time range for the selected trend will be determined by measuring points.
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Comments
The parameter i indicates the number of the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

UseMessageColor

Description
Specifies whether the agreed colors of the message classes are displayed.   

Access in Runtime: Read and write

Syntax
Object.UseMessageColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl".

BOOLEAN
TRUE: The colors are displayed.

FALSE: The color settings specified for the table content on the "Layout" tab are effective.

 

See also
AlarmControl (Page 4981)

UseMultipleLimits

Description
Specifies whether one or more pairs of limits are shown as a selection or a line. 

Access in Runtime: Read and write

Syntax
Object.UseMultipleLimits[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format ""Bar".

BOOLEAN
Optional TRUE, if one or more pairs of limits are displayed as a selection or a line.

See also
Bar (Page 4995)

UseScaleConstraints

Description
Specifies whether the distance between two large marking lengths of the scale are calculated 
from the minimum and maximum values. 

Access in Runtime: Read and write

Syntax
Object.UseScaleConstraints[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the distance between two large marking lengths of the scale are calculated 
from the minimum and maximum values.

See also
Bar (Page 4995)

UseScaledBarBorder 

Description
Specifies whether the rectangle that surrounds the object is shown dependent of the scale or 
as a default. 

Access in Runtime: Read and write

Syntax
Object.UseScaledBarBorder[=BOOLEAN]
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Object
Required A "ScreenItem" object with the format "Bar".".

BOOLEAN
Optional TRUE, if the rectangle that surrounds the object is shown dependent on the scale.

See also
Bar (Page 4995)

UseSelectedTitleColor

Description
Specifies whether to use a selection color for the headers of selected table cells.   

Access in Runtime: Read and write

Syntax
Object.UseSelectedTitleColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "AlarmControl", "TrendRulerControl".

BOOLEAN
TRUE: A marking color is used. The "Background" and "Font" settings are active in Runtime.

FALSE: A marking color is not used. The "Background" and "Font" settings are disabled in 
Runtime.

 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

UseSeparateDiagrams

Description
Specifies whether the trends are shown staggered. 
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Access in Runtime: Read and write

Syntax
Object.UseSeparateDiagrams[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or "FunctionTrendView".

BOOLEAN
Optional TRUE, if the trends are shown staggered.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

UseSimplePresicionOffset

Description
Specifies how the field length will be calculated for the labeling of the scale. 

Access in Runtime: Read and write

Syntax
Object.UseSimplePresicionOffset[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the field length will be calculated for the labeling of the scale.

See also
Bar (Page 4995)

UseTableColor2

Description
Specifies whether to use a second row color for the representation of the table.   

Access in Runtime: Read and write
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Syntax
Object.UseTableColor2[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl", 
"FunctionTrendControl", "AlarmControl", "TrendRulerControl".

BOOLEAN
TRUE: The settings of "RowColor 2" are used in alternation with "RowColor1".

FALSE: The settings of "RowColor 1" are used for all rows.

 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

UseTimeRange(i) 

Description
Specifies how the time range that is to be shown for the selected trend will be defined. 

Access in Runtime: Read and write

Syntax
Object.UseTimeRange(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend","FunctionTrendView" or 
"TableView".

BOOLEAN
Optional TRUE, if the time range that is to be shown is defined by means of a start time 
("TimeAxisBeginTime(i)") and an end time ("TimeAxisEndTime"). 

FALSE,, if the time range that is to be shown is defined by means of a start time 
("TimeAxisBeginTime(i)") and an end time "TimeRangeBase(i)" and "TimeRangeFactor(i)".

Comments
The parameter i indicates the number of the trend. 
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

UseTransparentColor

Description
Specifies whether the color described with the property "TransparentColor" will be shown as 
transparent for the selected object. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColor[= BOOLEAN]

Object
Required A "ScreenItem" object with the formats "GraphicView" or "GraphicIOField".

BOOLEAN
Optional TRUE, if the specified color is to be shown as transparent.

See also
GraphicView (Page 5052)

GraphicIOField (Page 5049)

UseTransparentColorDeactivatedPicture

Description
Specifies if the transparent color defined with the property 
"TransparentColorDeactivatedPicture" for the status "disabled" will be used. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColorDeactivatedPicture[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""Roundbutton".
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BOOLEAN
Optional TRUE, if the transparent color definded with the property 
"TransparentColorDeactivatedPicture" for the status "disabled" will be used.

UseTransparentColorPictureOff

Description
Specifies if the transparent color defined with the property "TransparentColorPictureOff" for 
the status "off" will be used. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColorPictureOff[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Roundbutton".

BOOLEAN
Optional TRUE, if the transparent color defined with the property "TransparentColorPictureOff" 
for the status "off" will be used.

See also
Button (Page 5002)

UseTransparentColorPictureOn

Description
Specifies if the transparent color defined with the property "TransparentColorPictureOn" for 
the status "on" will be used. 

Access in Runtime: Read and write

Syntax
Object.UseTransparentColorPictureOn[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Roundbutton".

BOOLEAN
Optional TRUE, if the transparent color defined with the property "TransparentColorPictureOn" 
for the status "on" will be used.
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See also
Button (Page 5002)

UseTrendNameAsLabel

Description
Specifies whether the "Name" or "Label" property is used as a designation for the trend in 
Runtime.     

Access in Runtime: Read and write

Syntax
Object.UseTrendNameAsLabel[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl", 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

BOOLEAN
TRUE: The name configured under "Properties > Properties > Trends > Name" is used.

FALSE: The name configured under "Properties > Properties > Trends > Label" is used.

 

See also
FunctionTrendControl (Page 5038)

OnlineTrendControl (Page 5083)

Used

Description
Returns the size of the used disk space. 

Access in Runtime: Read and write

Syntax
Object.Used[=Double]

Object
Required A "ScreenItem" object with the format ""DiskSpaceView".
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Double
Optional A value or a constant that returns the size of the used disk space.

See also
DiskSpaceView (Page 5025)

UsedPercent

Description
Returns the measured value for the used disk space as a percentage. The values can be 
queried in Runtime. The values cannot be predefined. 

Access in Runtime: Read and write

Syntax
Object.UsedPercent[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that returns the measured value for the used disk space as a 
percentage.

See also
DiskSpaceView (Page 5025)

UserArchiveNumberOfValues(i) 

Description
Specifies the number of values that are loaded from the recipe. The "TagProviderType(i)"" 
property must have the value -2. 

Access in Runtime: Read and write

Syntax
Object.UserArchiveNumberOfValues(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".
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Int
Optional A value or a constant that specifies the number of values that are loaded from the 
recipe.

Comments
The parameter i indicates the number of the trend. 

If "UserArchiveNumberOfValues(i)"" is changed, illegal combinations with different attributes 
for the data connection could arise. This means you have to prevent immediate acceptance 
of the change with ""FreezeProviderConnections"" before changing 
""UserArchiveNumberOfValues(i)"".

See also
FunctionTrendControl (Page 5038)

UserArchiveStartId(i)

Description
Specifies the data record starting from which the values for the selected trend are loaded from 
the recipe. The "TagProviderType(i)"" property must have the value -2.   

Access in Runtime: Read and write

Syntax
Object.UserArchiveStartId(i)[=Int]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

Int
Optional A value or a constant that specifies the data record starting from which the values for 
the selected trend are loaded from the recipe. 

Comments
The parameter i indicates the number of the trend. 

If "UserArchiveStartId(i)" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent immediate acceptance of the change 
with ""FreezeProviderConnections" before changing ""UserArchiveStartId(i)".

See also
FunctionTrendControl (Page 5038)
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UserData

Description
Specifies the value that is passed to the VB script when a user-defined menu entry or toolbar 
button is executed. 

Use the "Data" field in the "Menus and toolbars" editor to pass a parameter to the procedure. 

Access in Runtime: Read and write

Syntax
Object.UserData[=String]

Object
Required A "Item"-type object.

String
Optional. A value or constant that is passed to the VB script when a user-defined menu entry 
or toolbar button is executed.

UserName

Description
Returns the name of the user who triggered the alarm object.

UserValue1 property

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 

UserValue2 property 

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 
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UserValue3 property 

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 

UserValue4 property

Description
Defines or returns a value. 
The value can be evaluated by a script, for example. This value is neither evaluated nor 
displayed in Runtime. 

ValidateFormatPattern 

Description
Specifies that the "format pattern" field can be checked for specific characters. 

Access in Runtime: Read and write

Syntax
Object.ValidateFormatPattern[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "IOField".

BOOLEAN
Optional TRUE, if the "format pattern" field can be checked for specific characters.

See also
IOField (Page 5059)

Value 

Description   
Specifies a value for the object being used or returns it. 

Access during runtime: Read and write 
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Syntax
Object.Value[=VARIANT]

Object
Necessary. An object of type "Tag", "DataItem" or "ScreenItem" with the format "Gauge". 

VARIANT
Optional The value that is specified dependent on the object being used:

● Tag.Value: returns the tag value for the last read access or specifies the future tag value. 
Use the "Read" method to read the tag value from the "Value" property. You assign a new 
tag value to the "Value" property with the "Write" method.

● Dataset.Value: Specifies a value or returns a copy of the value or the object reference. 
When returning object references, ensure that the object reference is multithread-capable.

● ScreenItem("Gauge_1").Value: Specifies the value to which the pointer points. The value 
range within the values set via the properties "ValueMin",and "ValueMax".

Examples
The following example writes a new value in the "Tag1" tag:

 
'VBS94
Dim objTag
Set objTag = HMIRuntime.Tags("Tag1")
objTag.Value = 50
objTag.Write

The example shows how to add a value to a list of tags and output it as a trace. After that, the 
value is changed, output again and then removed. It make sense to perform this in several 
different actions:

 
'VBS198
HMIRuntime.DataSet.Add "motor1", 23
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine
HMIRuntime.DataSet("motor1").Value = 55
HMIRuntime.Trace "motor1: " & HMIRuntime.DataSet("motor1").Value & vbNewLine
HMIRuntime.DataSet.Remove("motor1")

See also
DataItem (Page 4951)

Tag (Page 4975)

Example of writing tag values (Page 4512)
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ValueAxisAutorange(i)

Description
Specifies whether the value range of the Y axis is determined automatically or via the values 
"ValueAxisBegin(i)" and "ValueAxisEnd(i)". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisAutorange(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
Optional TRUE, if the value range of the Y axis is established automatically or via the values 
"ValueAxisBegin(i)" and "ValueAxisEnd(i)"".

See also
FunctionTrendControl (Page 5038)

ValueAxisBegin(i)

Description
Specifies the lower limit of the value range for the selected trend that is to be displayed. 
Whether the information is evaluated depends on the properties "Autorange" and 
"ShareValueAxis".  

Access in Runtime: Read and write

Syntax
Object.ValueAxisBegin(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the lower limit of the value range of the selected 
trend that is to be shown.
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisDecimalPrecision(i)

Description
Specifies the number of decimal places for the value range of the selected trend. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisDecimalPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the formats "OnlineTrend" or "FunctionTrendView".

Int
Optional A value or a constant that specifies the number of decimal places for the value range 
of the selected trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisEnd(i)

Description
Specifies the upper limit of the value range of the selected trend that is to be displayed. Whether 
the information is evaluated depends on the properties "Autorange" and "ShareValueAxis".  

Access in Runtime: Read and write

Syntax
Object.ValueAxisEnd(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".
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Double
Optional A value or a constant that specifies the upper limit of the value range of the selected 
trend that is to be shown.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisGridLineInterval(i)

Description
Specifies the distance between two grid lines. Whether the information is evaluated depends 
on the properties "ValueAxisShowGridLines(i)" and "TimeAxisShowGridLines(i)".". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisGridLineInterval(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the distance between two grid lines.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisLabel(i)

Description
Specifies the labeling of the value axis. Whether the information is evaluated depends on the 
property "ConfigureTimeAxis(i)". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisLabel(i)[=String]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

String
Optional A value or a constant that specifies the labeling of the value axis. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisLargeIncrementSize(i)

Description
Specifies the distance between two long marking lengths of the scale. Whether the information 
is evaluated depends on the properties "ValueAxisShowLargeIncrements(i)" and 
""TimeAxisShowLargeIncrements(i)".". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisLargeIncrementSize(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the distance between two marking lengths of the 
scale.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisScalingType(i)

Description
Specifies the type of axis scaling. 

Access in Runtime: Read and write
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Syntax
Object.ValueAxisScalingType(i)[=AxisScalingType]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

AxisScalingType
hmiBarScalingLinear ( 0): Linear axis scaling.

hmiBarScalingLogarithmic ( 1): Logarithmic axis scaling

hmiBarScalingNegativeLogarithmic ( 2): Negative logarithmic axis scaling

Comments
The parameter i indicates the number of the trend. The parameter i indicates the number of 
the trend. 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisShowGridLines(i)

Description
Specifies whether the trend window is shown with grid lines that run parallel to the y axis. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisShowGridLines(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the trend window is shown with grid lines that run parallel to the y axis.

Comments
The distance between two grid lines can be altered with the "ValueAxisGridLineInterval(i)" 
property.
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisShowLargeIncrements(i)

Description
Specifies whether the value axis is scaled with long marking lengths. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisShowLargeIncrements(i)[=BOOLEAN]

Object
Required An object of the "ScreenItem" with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the value axis is scaled with long marking lengths.

Comments
The distance of two long marking lines can be altered with the 
"ValueAxisLargeIncrementSize(i)"" property.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisShowSmallIncrements(i)

Description
Specifies whether the value axis is scaled with short marking lengths. 

Access in Runtime: Read and write

Syntax
Object.ValueAxisShowSmallIncrements(i)[=BOOLEAN]
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Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

BOOLEAN
Optional TRUE, if the value axis is scaled with short marking lengths.

Comments
 The distance between two short marking lines can be altered with the 
"ValueAxisSmallIncrementSize(i)" property.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ValueAxisSmallIncrementSize(i)

Description
Specifies the distance between two short marking lengths of the scale. Whether the information 
is evaluated depends on the properties ""ValueAxisShowSmallIncrements(i)")" and 
""TimeAxisShowSmallIncrements(i)".". 

Access in Runtime: Read and write

Syntax
Object.ValueAxisSmallIncrementSize(i)[=Double]

Object
Required An object of the "ScreenItem" type with the format "OnlineTrendControl" or 
"FunctionTrendControl".

Double
Optional A value or a constant that specifies the distance between two short marking lengths 
of the scale.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)
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ValueColumnAlignment(i)

Description
Specifies the alignment of the tag values of this column pair. The parameter i indicates the 
number of the column pair. 

Access in Runtime: Read and write

Syntax
Object.ValueColumnAlignment(i)[=AlignmentHorizontal]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

AlignmentHorizontal
hmiAlignmentLeft ( 0): The text is shown left justified.

hmiAlignmentCentered ( 1): The text is shown centered.

hmiAlignmentRight  ( 2): The text is shown right justified.

See also
OnlineTableControl (Page 5075)

ValueColumnPrecision(i) 

Description
Specifies the number of decimal places that are shown in this value column. The parameter i 
indicates the number of the column pair. A maximum of 16 decimal places can be shown.   

Access in Runtime: Read and write

Syntax
Object.ValueColumnPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "OnlineTableControl".

Int
Optional A value or a constant that specifies the number of decimal places that are shown in 
this value column.
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See also
OnlineTableControl (Page 5075)

VerticalAlignment

Description
Specifies the vertical alignment of the text within the selected object.   

Access in Runtime: Read and write

Syntax
Object.VerticalAlignment[=AlignmentVertical]

Object
Required An object of the "ScreenItem" type with the format "TextField", "IOField", 
"SymbolicIOField", "DateTimeField", "Button", "Switch", "Checkbox" or "OptionGroup".

AlignmentVertical
A value that specifies the vertical alignment.

hmiAlignmentTop ( 0): The text will be shown in the upper margin.

hmiAlignmentMiddle ( 1): The text will be shown in the middle.

hmiAlignmentBottom ( 2): The Text will be shown in the lower margin.

See also
TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

OptionGroup (Page 5092)

DateTimeField (Page 5023)

RoundButton (Page 5112)

VerticalAlignment 

Description
Determines the vertical alignment of the text within the given object. 

Access during runtime: Read and Write
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Syntax
Object.VerticalAlignment [= THmiVerticalAlignment]

Object
Required An object of the "ScreenItem" type with the characteristics "TextField", "IOField", 
"SymbolicIOField", "Button" or "Switch".

THmiVerticalAlignment
Optional A value or constant which determines the vertical alignment of the text.

hmiAlignmentTop (0): The text is aligned at the top of the object.

hmiAlignmentMiddle (1): The text is centered vertically in the object.

hmiAlignmentBottom (2): The text is aligned at the bottom in the object.

See also
ProjectName (Page 5100)

VerticalGridLines

Description
Enables the display of vertical dividers.   

Access in Runtime: Read and write

Syntax
Object.VerticalGridLines[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "AlarmControl", 
"OnlineTableControl", "UserArchiveControl", "TrendRulerControl".

BOOLEAN
TRUE: Vertical grid lines are displayed.

FALSE: Vertical grid lines are not displayed.

 

See also
UserArchiveControl (Page 5167)

TrendRulerControl (Page 5147)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)
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VerticalScrollbarPosition

Description
Specifies the vertical positioning of the scroll bar in a picture window with slider, or returns its 
value.

The picture is displayed in the picture window by positioning the horizontal and vertical scroll 
bars. If you wish to display the picture as a cutout where the scroll bars are located at the left 
and upper edge of the picture, use the properties "OffsetLeft" and "OffsetTop" as the origin of 
this cutout.

See also
ScreenWindow (Page 5116)

ViewOnly 

Description
Specifies whether the Sm@rtClient display will be used for remote monitoring or remote 
maintenance. 

Remote maintenance means that settings can be changed on the monitored device.

Remote monitoring means that settings of the monitored device cannot be changed.

Access in Runtime: Read and write

Syntax
Object.ViewOnly[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "SmartClientView".

BOOLEAN
Optional TRUE, if the Sm@rtClient display is to be used only for remote monitoring.

See also
SmartClientView (Page 5123)

Visible 

Description
Specifies whether the selected object is visible.     
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Access during runtime: Read and write

Syntax
Object.Visible[=BOOLEAN]

Object
Necessary. An object of the type "ScreenItem".

BOOLEAN
Optional TRUE, if the object is visible.

Used for the following object types:
Rectangle 

 

 

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)

SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)
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Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

DateTimeField (Page 5023)

UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

SystemDiagnoseView (Page 5137)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

AlarmView (Page 4992)

RecipeView (Page 5106)

SmartClientView (Page 5123)

StatusForce (Page 5125)

SystemDiagnoseWindow (Page 5140)

TrendView (Page 5155)
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Warning

Description
Specifies the limit for the storage space display as of which a warning will be reported. 

Access in Runtime: Read and write

Syntax
Object.Warning[=Int]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Int
Optional A value or a constant that specifies the limit for the storage space display as of which 
a warning will be reported.

See also
DiskSpaceView (Page 5025)

WarningColor

Description
Specifies the color in which the bar of the storage space display will be shown as soon as the 
warning area is reached. 

Access in Runtime: Read and write

Syntax
Object.WarningColor[=Color]

Object
Required A "ScreenItem" object with the format "DiskSpaceView".

Color
Optional A value or a constant that specifies the color in which the bar of the storage space 
display will be shown as soon as the warning area is exceeded.

See also
DiskSpaceView (Page 5025)
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WarningHigh

Description
Defines or returns the upper limit value for "Warning High". 
In order that the limit value is monitored, the "CheckWarningHigh" property must be set to 
TRUE. 
The display on reaching the limit value and the type of evaluation are defined by means of the 
"ColorWarningHigh" and "TypeWarningHigh" properties.

WarningLow

Description
Defines or returns the lower limit value for "Warning Low". 
In order that the limit value is monitored, the "CheckWarningLow" property must be set to 
TRUE. 
The display on reaching the limit value and the type of evaluation are defined by means of the 
"ColorWarningLow" and "TypeWarningLow" properties.

WarningLowerLimit 

Description
Specifies the lower limit for "WarningLowerLimit". 

The ""WarningLowerLimitEnable" property must have the value TRUE so that the limit is 
monitored. 

Access in Runtime: Read and write

Syntax
Object.WarningLowerLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the lower limit for "WarningLowerLimit".

Comments
The following values will be specified with the properties "WarningLowerLimitColor" and 
"WarningLowerLimitRelative": 

Representation upon reaching the limit

Type of evaluation
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See also
Bar (Page 4995)

WarningLowerLimitColor

Description
Specifies the color for the lower limit ""WarningLowerLimit". 

The ""WarningLowerLimitEnable" property must have the value TRUE if the bar color is to 
change once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.WarningLowerLimitColor[=Color]

Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the lower limit "WarningLowerLimit".

Comments
The following values are specified by the "WarningUpperLimit", "WarningUpperLimitColor" and 
"WarningUpperLimitRelative" properties: 

● Limit

● Representation upon reaching the limit

● Type of evaluation

See also
Bar (Page 4995)

WarningLowerLimitEnabled

Description
Specifies whether the limit ""WarningLowerLimit" is to be monitored. 

Access in Runtime: Read and write
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Syntax
Object.WarningLowerLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the "WarningLowerLimit" limit is to be monitored.

Comments
The following values will be specified with the properties "WarningLowerLimit", 
"WarningLowerLimitColor" and "WarningLowerLimitRelative":

Limit

Representation upon reaching the limit

Type of evaluation

See also
Bar (Page 4995)

WarningLowerLimitRelative

Description
Determines whether the lower limit "WarningLowerLimit" is to be evaluated as a percentage 
or as an absolute value. 

Access in Runtime: Read and write

Syntax
Object.WarningLowerLimitRelative[=BOOLEAN]

Object
Required A ""ScreenItem" object with the format "Bar".

BOOLEAN
Optional TRUE, if the lower limit ""WarningLowerLimit" is to be evaluated as a percentage.

See also
Bar (Page 4995)
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WarningRangeColor 

Description
Specifies the color of the warning range on the scale of the "Gauge" object. 

The "WarningRangeVisible" property must have the value TRUE so that the warning range is 
displayed.

Access in Runtime: Read and write

Syntax
Object.WarningRangeColor[= Color]

Object
Required A "ScreenItem" object with the format "Gauge".

Color
Optional A value or a constant that specifies the color of the warning range.

Comments
Use the "RGB" function to establish the colors in RGB format (red, green blue). To do this, 
enter the appropriate decimal value for each of the three RGB values (range from 0 to 255). 
For example, the color "red" is shown as such: RGB(255, 0, 0). You can also use the VBS 
color constants like vbRed or vbGreen.

See also
Gauge (Page 5046)

WarningRangeStart 

Description
Specifies at which scale value the warning range of the "Gauge" object will start. 

The "WarningRangeVisible" property must have the value TRUE so that the warning range is 
displayed.

Access in Runtime: Read and write

Syntax
Object.WarningRangeStart[= DOUBLE]

Object
Required A "ScreenItem" object with the format "Gauge".

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5740 System Manual, 02/2014



DOUBLE
Optional A value or a constant that contains the scale value for the start of the warning range.

Comments
The range extends from the value "Warning" through to the value "Danger". If no range is 
activated for "Danger", then the range for "Warning" extends to the end of the scale.

See also
Gauge (Page 5046)

WarningRangeVisible

Description
Specifies whether the warning range in the scale of the "Gauge" object will be displayed. 

Access in Runtime: Read and write

Syntax
Object.WarningRangeVisible[= BOOLEAN]

Object
Required A "ScreenItem" object with the format "Gauge".

BOOLEAN
Optional TRUE, if the warning range will be displayed in the scale.

Comments
Specifies the color of the warning range with the ""WarningRangeColor" property.

Specifies the start of the warning range with the "WarningRangeStart"" property.

See also
Gauge (Page 5046)

WarningRangeColor  (Page 5740)

WarningRangeStart  (Page 5740)
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WarningUpperLimit 

Description
Specifies the upper limit for "WarningUpperLimit". 

The "WarningUpperLimitEnable"" property must have the value TRUE so that the limit is 
monitored. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimit[=Double]

Object
Required A "ScreenItem" object with the format "Bar".

Double
Optional A value or a constant that specifies the upper limit for ""WarningUpperLimit".

Comments
The following values will be specified with the properties "WarningUpperLimitColor" and 
"WarningUpperLimitRelative": 

● Representation upon reaching the limit

● Type of evaluation

See also
Bar (Page 4995)

WarningUpperLimitColor

Description
Specifies the color for the upper limit "WarningUpperLimit". 

The ""WarningUpperLimitEnable" property must have the value TRUE if the bar color is to 
change once the limit has been reached. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimitColor[=Color]
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Object
Required A "ScreenItem" object with the format "Bar".

Color
Optional A value or a constant that specifies the color for the upper limit "WarningUpperLimit".

See also
Bar (Page 4995)

WarningUpperLimitEnabled

Description
Specifies whether the limit ""WarningUpperLimit" is to be monitored. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimitEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".".

BOOLEAN
Optional TRUE, if the "WarningUpperLimit" limit is to be monitored.

See also
Bar (Page 4995)

WarningUpperLimitRelative

Description
Determines whether the lower limit "WarningUpperLimit" is to be evaluated as a percentage 
or as an absolute value. 

Access in Runtime: Read and write

Syntax
Object.WarningUpperLimitRelative[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "Bar".
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BOOLEAN
Optional TRUE, if the lower limit "WarningUpperLimit" is to be evaluated as a percentage.

See also
Bar (Page 4995)

Width

Description
Specifies the width of the selected objects "Ellipse", "Circle" and "Rectangle".   

Access in Runtime: Read and write.

The other objects only have read access to the property.

Syntax
Object.Width[=LONG]

Object
Required A "Screen" object or an object of type "ScreenItem". This property is a standard 
property of the ScreenItem-object and is therefore available for all formats.

LONG
Optional A value or a constant that specifies the width in pixels. This parameter can only be 
set for the objects "Ellipse", Circle" and "Rectangle".

See also
Line (Page 5063)

Polyline (Page 5098)

Ellipse (Page 5027)

Circle (Page 5011)

EllipseSegment (Page 5029)

CircleSegment (Page 5013)

EllipticalArc (Page 5032)

CircularArc (Page 5016)

Rectangle (Page 5110)

Polygon (Page 5095)

TextField (Page 5144)

IOField (Page 5059)
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SymbolicIOField (Page 5130)

Button (Page 5002)

Switch (Page 5127)

GraphicView (Page 5052)

GraphicIOField (Page 5049)

Bar (Page 4995)

Clock (Page 5018)

Gauge (Page 5046)

Slider (Page 5120)

SymbolLibrary (Page 5135)

OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

HTMLBrowser (Page 5057)

CheckBox (Page 5008)

OptionGroup (Page 5092)

WindowSlider (Page 5176)

Connector (Page 5020)

ScreenWindow (Page 5116)

DiskSpaceView (Page 5025)

ChannelDiagnose (Page 5006)

ScriptDiagnostics (Page 5118)

Group (Page 5055)

ForeignControl (Page 5034)

DateTimeField (Page 5023)

ProtectedAreaName (Page 5102)

UserView  (Page 5174)

TubeTeeObject (Page 5165)

TubePolyline (Page 5162)

TubeDoubleTeeObject (Page 5160)

TubeArcObject (Page 5158)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)
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UserArchiveControl (Page 5167)

SystemDiagnoseView (Page 5137)

TrendRulerControl (Page 5147)

ProjectName (Page 5100)

AlarmView (Page 4992)

BatteryView (Page 5001)

RangeLabelView (Page 5103)

ZoneQualityView (Page 5181)

ZoneLabelView (Page 5180)

WLanQualityView (Page 5179)

TrendView (Page 5155)

SystemDiagnoseWindow (Page 5140)

StatusForce (Page 5125)

SmartClientView (Page 5123)

RecipeView (Page 5106)

RangeQualityView (Page 5105)

WinCCStyle

Description
Defines the style in which the object is displayed. 

User Defined Shows the object according to the respective settings.
Global Shows the object in a globally defined design.
Windows Style Shows the object in Windows style.

WindowBorder

Description
TRUE, when the window is displayed with borders in Runtime. Read only access.

WindowCloseEnabled 

Description
Specifies whether the window can be closed in Runtime. 

Access in Runtime: Read and write
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Syntax
Object.WindowCloseEnabled[=BOOLEAN]

Object
Required A "ScreenItem"  object with the formats "OnlineTrend", "FunctionTrendView" or 
"TableView".

BOOLEAN
Optional TRUE, if the window can be closed in Runtime.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

WindowMaximizeenabled

Description
TRUE, when the object can be maximized in Runtime. Read only access. 

See also
ScreenWindow (Page 5116)

ScriptDiagnostics (Page 5118)

WindowMovingEnabled

Description
TRUE, when the object can be moved in Runtime. Read only access.

See also
ScreenWindow (Page 5116)

ScriptDiagnostics (Page 5118)

WindowOnTop

Description
TRUE, when the object should remain in the foreground in Runtime. Read only access.
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See also
ScreenWindow (Page 5116)

ScriptDiagnostics (Page 5118)

WindowsContens

Description
Supplies the content of the application window Read only access.

See also
ScriptDiagnostics (Page 5118)

WindowSizingEnabled

Description
Specifies whether the size of the specified object can be changed in Runtime. 

Access in Runtime: Read and write

Syntax
Object.WindowSizingEnabled[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "OnlineTrend", "FunctionTrendView" or 
"TableView".

BOOLEAN
Optional. TRUE, if the size of the selected object can be changed in Runtime.

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OnlineTableControl (Page 5075)

WindowsStyle

Description
Specifies whether the object will be displayed in the general Windows style. 
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Access in Runtime: Read and write

Syntax
Object.WindowsStyle[=BOOLEAN]

Object
Required A "ScreenItem" object with the formats "Button" or "WindowSlider".

BOOLEAN
Optional TRUE, if the object will be displayed in the general Windows style.

See also
Button (Page 5002)

WindowSlider (Page 5176)

Properties X-Z

XAxisAdd

Description
Creates a new X axis.   

Syntax
Object.XAxisAdd

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

XAxisAlign

Description
Defines the alignment mode for a selected axis.   
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Syntax
Object.XAxisAlign[=Alignement]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Alignment

Value Description Description
0 Bottom The X axis selected is displayed below the trend.
1 Top The X axis selected is displayed above the trend.

XAxisAutoPrecisions

Description
Enables automatic setting of the decimal precision.   

Access in Runtime: Read and write

Syntax
Object.XAxisAutoPrecisions[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The number of decimal places is specified automatically.

FALSE: The value configured under "Properties > X axis  > Format > Decimal places" is 
effective.

See also
FunctionTrendControl (Page 5038)

XAxisAutorange(i) 

Description
Specifies whether the value range of the X axis is determined automatically or via the attributes 
"XAxisBegin(i)" and "XAxisEnd(i)". 

Access in Runtime: Read and write
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Syntax
Object.XAxisAutorange(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

BOOLEAN
Optional TRUE, if the value range of the X axis is determined automatically or via the values 
"XAxisBegin(i)" and "XAxisEnd(i)".

See also
FunctionTrendControl (Page 5038)

XAxisBegin(i) 

Description
Specifies the lower limit of the X axis of a trend that has been referenced with the property 
"CurrentCurveIndex". Whether the information is evaluated depends on the properties 
"XAxisAutorange(i)" and "ShareXAxis".   

Access in Runtime: Read and write

Syntax
Object.XAxisBegin(i)[=String]

Object
Required A ""ScreenItem" object with the format ""FunctionTrendView".

String
Optional A value or a constant that specifies the lower limit of the X axis of a trend that has 
been referenced with the property "CurrentCurveIndex".

See also
FunctionTrendControl (Page 5038)

XAxisBeginValue

Description 
Specifies the lower range of values of the axis selected. To configure the value, deactivate the 
"Automatic" option in "Value range".
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See also
FunctionTrendControl (Page 5038)

XAxisColor

Description 
Use this attribute to define the color for the common X-axis. 

Access in Runtime: Read and write

Syntax
Object.XAxisColor[=COLOR]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Color
The color is defined as an RGB value.

See also
FunctionTrendControl (Page 5038)

XAxisCount

Description
Defines the number of X axes configured. 

Syntax
Object.XAxisCount

Object

Required An object of the "ScreenItem" type with the format "FunctionTrendControl"..

See also
FunctionTrendControl (Page 5038)
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XAxisDecimalPrecision(i)

Description
Specifies the number of decimal places with which the scaling value of the X axis will be 
displayed. 

Access in Runtime: Read and write

Syntax
Object.XAxisDecimalPrecision(i)[=Int]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

Int
Optional A value or a constant that specifies the number of decimal places with which the 
scaling value for the X axis will be displayed.

See also
FunctionTrendControl (Page 5038)

XAxisEnd(i) 

Description
Specifies the lower limit of the X axis of a trend that has been referenced with the property 
"CurrentCurveIndex". Whether the information is evaluated depends on the properties 
"XAxisAutorange(i)"" and "ShareXAxis".  

Access in Runtime: Read and write

Syntax
Object.XAxisEnd(i)[=String]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

String
Optional A value or a constant that specifies the upper limit of the X axis of a trend that has 
been referenced with the property "CurrentCurveIndex".

See also
FunctionTrendControl (Page 5038)
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XAxisEndValue

Description   
Specifies the upper range of values of the axis selected. To configure the value, deactivate 
the "Automatic" option in "Value range".

See also
FunctionTrendControl (Page 5038)

XAxisExponentialFormat

Description
Enables the exponential notation for visualization of a selected axis.   

Access in Runtime: Read and write

Syntax
Object.XAxisExponentialFormat [=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The values are displayed in exponential format.

FALSE: The values are displayed in exponential format.

See also
FunctionTrendControl (Page 5038)

XAxisGridLineInterval(i)

Description
Specifies the distance between two grid lines of the X axis. Whether the information is 
evaluated depends on the value of the property ""XAxisShowGridLines(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisGridLineInterval(i)[=Double]
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Object
Required A "ScreenItem" object with the format "FunctionTrendView".".

Double
Optional A value or a constant that specifies the distance between two grid lines of the X axis.

See also
FunctionTrendControl (Page 5038)

XAxisIndex

Description
References a configured X axis. You can assign the values of other properties to a specific X 
axis by using the property.   

Valid values for "Index" are between 0 and "XAxisCount" minus 1. The "ToolbarButtonCount" 
property specifies the number of configured X axes.

See also
FunctionTrendControl (Page 5038)

XAxisInTrendColor

Description 
Enables the display of an axis selected in the trend color. The color of the first trend is activated 
if several trends are displayed in the trend window. The order of the trends is determined in 
the "Trends" properties.   

Access in Runtime: Read and write

Syntax
Object.XAxisInTrendColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl". 

BOOLEAN
TRUE: The selected axis is displayed in the trend color. The setting in the "Color" field is 
disabled.

FALSE: The selected axis is displayed in the color which is set in the "Color" field.
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See also
FunctionTrendControl (Page 5038)

XAxisLabel(i)

Description
Specifies the labeling of the X axis of a trend that has been referenced with the property 
"CurrentCurveIndex", dependent upon the value of "XAxisMode(i)". 

Access in Runtime: Read and write

Syntax
Object.XAxisLabel(i)[=String]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

String
Optional A value or a constant that specifies the labeling of the X axis of a trend that has been 
referenced with the property "CurrentCurveIndex". 

See also
FunctionTrendControl (Page 5038)

XAxisLargeIncrementSize(i) 

Description
Specifies the distance of two long marking lengths of the X axis. Whether the information is 
evaluated depends on the property "XAxisShowLargeIncrements(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisLargeIncrementSize(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

Double
Optional A value or a constant that specifies the distance of two long marking lengths of the 
scaling of the X axis.
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See also
FunctionTrendControl (Page 5038)

XAxisMode(i)

Description
Specifies whether a mutual time axis will be used in the trend window for all trends. 

Specifies time units used by tag logging controls.

Access in Runtime: Read and write

Syntax
Object.XAxisMode(i)[=TrendViewTimeAxisMode]

Object
Required A "ScreenItem" object with the format "FunctionTrendContol".

TrendViewTimeAxisMode
( 1): The time axis will be scaled. 

 ( 2): No time range has been specified. Only a random sample will be displayed.

 ( 3): The time range will be established via tags.

 ( 4): The time range will be defined by constant values.

Comments
Specifies whether a mutual X axis will be used in the trend window for all trends. 

See also
FunctionTrendControl (Page 5038)

XAxisName

Description
Specifies the name of a selected axis.   

Syntax
Object.XAxisName
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Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

XAxisPrecisions

Description   
Specifies the decimal precision for displaying the axis selected. To configure the value, 
deactivate the "Automatic" option in "Format".

See also
FunctionTrendControl (Page 5038)

XAxisRemove

Description
Removes the selected axis from the list.   

Syntax
Object.XAxisRemove

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

XAxisRepos

Description
Changes the sorting order of the axes. "Up" and "Down" move the axis selected up or down 
in the list. The order in the list determines the position of the axis in the trend view in Runtime. 
If the alignment is identical and the axis is further up in the list, it is shown at a position further 
away from the trend.   
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Syntax
Object.XAxisRepos

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

XAxisScalingType(i) 

Description
Specifies the type of scaling for the X axis. Whether the information is evaluated depends on 
the value of the property "XAxisMode(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisScalingType(i)[=AxisScalingType]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

AxisScalingType
hmiBarScalingLinear ( 0): Linear axis scaling.

hmiBarScalingLogarithmic ( 1): Logarithmic axis scaling

hmiBarScalingNegativeLogarithmic ( 2): Negative logarithmic axis scaling

Comments
The parameter i indicates the number of the trend. 

See also
FunctionTrendControl (Page 5038)

XAxisShowGridLines(i)

Description
Specifies whether the trend window is shown with grid lines that run parallel to the X axis. The 
distance between two grid lines can be altered with the ""XAxisGridLineInterval(i)" property. 
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Access in Runtime: Read and write

Syntax
Object.XAxisShowGridLines(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

BOOLEAN
Optional TRUE, if the trend window is shown with grid lines that run parallel to the X axis.

See also
FunctionTrendControl (Page 5038)

XAxisShowLargeIncrements(i)

Description
Specifies whether the X axis is scaled with long marking lengths. The distance of two long 
marking lines can be altered with the "XAxisLargeIncrementSize(i)"" property. 

Access in Runtime: Read and write

Syntax
Object.XAxisShowLargeIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format ""FunctionTrendView".

BOOLEAN
Optional TRUE, if the X axis is scaled with long marking lengths. 

See also
FunctionTrendControl (Page 5038)

XAxisShowSmallIncrements(i) 

Description
Specifies whether the X axis is scaled with short marking lengths. The distance of two short 
marking lines can be altered with the "XAxisSmallIncrementSize(i)" property. 

Access in Runtime: Read and write
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Syntax
Object.XAxisShowSmallIncrements(i)[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

BOOLEAN
Optional TRUE, if the X axis is scaled with short marking lengths. 

See also
FunctionTrendControl (Page 5038)

XAxisSmallIncrementSize(i) 

Description
Specifies the distance of two short marking lengths of the X axis. Whether the information is 
evaluated depends on the property "XAxisShowSmallIncrements(i)".".

Access in Runtime: Read and write

Syntax
Object.XAxisSmallIncrementSize(i)[=Double]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

Double
Optional A value or a constant that specifies the distance of two short marking lengths of the 
X axis scaling.

See also
FunctionTrendControl (Page 5038)

XAxisTrendWindow

Description 
Specifies in which trend view the selected axis is used. The available trend views are specified 
in the properties in "Trends".   

Access in Runtime: Read and write
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Syntax
Object.XAxisTrendWindow

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

XAxisVisible

Description   
The list shows all axes you created.

Activate the axes which are to be displayed in the trend views in the list.

Click an axis in the list to adapt the properties and to assign the axis to a trend view.

See also
FunctionTrendControl (Page 5038)

XDataLogTag(i) 

Description
Specifies the tag that will be shown along the X axis. The property "TagProviderType(i)" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.XDataLogTag(i)[=HmiLoggingTag]

Object
Required A ""ScreenItem" object with the format "FunctionTrendView".

HmiLoggingTag
Optional A value or a constant that specifies which tag will be shown along the X axis.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5762 System Manual, 02/2014



Comments
If "XOnlineTag(i)"" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent mmediate acceptance of the change 
with "FreezeProviderConnections before changing "XOnlineTag(i).

See also
FunctionTrendControl (Page 5038)

XOnlineTag(i) 

Description
Specifies the tag that will be shown along the X axis. The property "TagProviderType(i)"" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.XOnlineTag(i)[=HmiTag]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

HmiTag
Optional A value or a constant that specifies which tag will be shown along the X axis.

Comments
The parameter i indicates the number of the trend. 

If "XOnlineTag(i)" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent an immediate acceptance of the 
change with "FreezeProviderConnections" before changing "XOnlineTag(i)".

See also
FunctionTrendControl (Page 5038)

YAxisAdd

Description
Creates a new X axis.   
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Syntax
Object.YAxisAdd

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

YAxisAlign

Description
Specifies how the selected axis is aligned.   

Syntax
Object.YAxisAlign[=Alignement]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

Alignment

Value Description Explanation
0 Left The X axis selected is displayed on left side of the trend.
1 Right The selected Y axis is displayed to the right of the trend.

YAxisAutoPrecisions

Description
Enables automatic setting of the decimal precision.   

Access in Runtime: Read and write

Syntax
Object.YAxisAutoPrecisions[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".
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BOOLEAN
TRUE: The number of decimal places is specified automatically.

FALSE: The value configured under "Properties > Y axis  > Format > Decimal places" is 
effective.

 

See also
FunctionTrendControl (Page 5038)

YAxisAutoRange

Value range automatic - X/YAxisAutoRange
Enables automatic calculation of the value range of the axis selected.

Value Description
TRUE The range of values is calculated automatically.
FALSE The range of values is calculated based in the values configured in the "from" and "to" fields.

The X axis attribute can be assigned dynamic properties by means of the name 
XAxisAutoRange.

The Y axis attribute can be assigned dynamic properties by means of the name 
YAxisAutoRange.

See also
FunctionTrendControl (Page 5038)

YAxisBeginValue

Description 
Specifies the lower value range of the selected axis. To configure the value, deactivate the 
"Automatic" option in "Value range".

See also
FunctionTrendControl (Page 5038)
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YAxisColor

Description
Specifies the color of the axis selected. Open the "Color selection" dialog by clicking the 
button. . The setting is only active if the "Use trend color" field is disabled.    

Syntax
Object.YAxisColor[=COLOR]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl" or 
"OnlineTrendControl" (Runtime Professional) or "HMITrendView" (Runtime Advanced).

Color
The color is defined as an RGB value.

See also
FunctionTrendControl (Page 5038)

YAxisCount

Description
Defines the number of Y axes configured.   

Syntax
Object.YAxisCount

Object

Required A "ScreenItem" object with the format "FunctionTrendControl".

 

See also
FunctionTrendControl (Page 5038)

YAxisEndValue

Description
Specifies the upper value range of the selected axis. To configure the value, deactivate the 
"Automatic" option in "Value range".
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See also
FunctionTrendControl (Page 5038)

YAxisExponentialFormat

Description
Enables the exponential notation for visualization of a selected axis.   

Access in Runtime: Read and write

Syntax
Object.YAxisExponentialFormat [=BOOLEAN]

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

BOOLEAN
TRUE: The values are displayed in exponential format.

FALSE: The values are displayed in exponential format.

See also
FunctionTrendControl (Page 5038)

YAxisIndex

Description
References a configured Y axis. You can assign the values of other properties to a specific Y 
axis by using the property.   

Valid values for "Index" are between 0 and "YAxisCount" minus 1. The "ToolbarButtonCount" 
property specifies the number of configured Y axes.

 

See also
FunctionTrendControl (Page 5038)
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YAxisInTrendColor

Description 
Enables the display of an axis selected in the trend color. The color of the first trend is activated 
if several trends are displayed in the trend window. The order of the trends is determined in 
the "Trends" properties.   

Access in Runtime: Read and write

Syntax
Object.YAxisInTrendColor[=BOOLEAN]

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl". 

BOOLEAN
TRUE: The selected axis is displayed in the trend color. The setting in the "Color" field is 
disabled.

FALSE: The selected axis is displayed in the color which is set in the "Color" field.

See also
FunctionTrendControl (Page 5038)

YAxisLabel

Description
Defines the label text for a selected axis. 

See also
FunctionTrendControl (Page 5038)

YAxisName

Description
Specifies the name of the selected axis.   

Syntax
Object.XAxisName
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Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

YAxisPrecisions

Description   
Specifies the decimal precision for displaying the axis selected. To configure the value, 
deactivate the "Automatic" option in "Format".

 

See also
FunctionTrendControl (Page 5038)

YAxisRename

Description
Changes the name of the Y axis which is referenced by the "YAxisIndex" property.  

Syntax
Object.YAxisRename

Object
Required An object of the "ScreenItem" type with the format "FunctionTrendControl".

YAxisRemove

Description
Removes the selected axis from the list.   

Syntax
Object.YAxisRemove

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".
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See also
FunctionTrendControl (Page 5038)

YAxisRepos

Description
Changes the order of the axes. "Up" and "Down" move the selected axis up or down in the list. 

The order in the list determines the position of the axis in the trend view in Runtime. The axis 
output position is moved away from the trend if the axis is moved further up in the list and the 
orientation is the same.   

Syntax
Object.YAxisRepos

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

YAxisScalingType

Scaling - X/YAxisScalingType
Defines the scaling mode for a selected axis.

The following settings are available:

Value Description
0 Linear
1 Logarithmic
2 Logarithmically negated

The X axis attribute can be assigned dynamic properties by means of the name 
XAxisScalingType.

The Y axis attribute can be assigned dynamic properties by means of the name 
YAxisScalingType.
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See also
FunctionTrendControl (Page 5038)

YAxisTrendWindow

Description 
Specifies in which trend view the selected axis is used. The available trend views are specified 
in the properties in "Trends".   

Access in Runtime: Read and write

Syntax
Object.YAxisTrendWindow

Object
Required A "ScreenItem" object with the format "FunctionTrendControl".

See also
FunctionTrendControl (Page 5038)

YAxisVisible

Description  
The list shows all axes you created.

Activate the axes which are to be displayed in the trend views in the list.

Click an axis in the list to adapt the properties and to assign the axis to a trend view.

See also
FunctionTrendControl (Page 5038)

YDataLogTag(i) 

Description
Specifies the tag that will be shown along the Y axis. The property "TagProviderType(i)"" must 
have the value -1. 

Access in Runtime: Read and write
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Syntax
Object.YDataLogTag(i)[=HmiLoggingTag]

Object
Required A "ScreenItem" object with the format "FunctionTrendView"".

HmiLoggingTag
Optional A value or a constant that specifies which tag will be shown along the Y axis.

Comments
If "YOnlineTag(i)"" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent immediate acceptance of the change 
with "FreezeProviderConnections" before changing "YOnlineTag(i)"".

See also
FunctionTrendControl (Page 5038)

YOnlineTag(i)

Description
Specifies the tag that will be shown along the Y axis. The property "TagProviderType(i)" must 
have the value -1. 

Access in Runtime: Read and write

Syntax
Object.YOnlineTag(i)[=HmiTag]

Object
Required A "ScreenItem" object with the format "FunctionTrendView".

HmiTag
Optional A value or a constant that specifies which tag will be shown along the Y axis.

Comments
The parameter i indicates the number of the trend. 

If "YOnlineTag(i)"" is changed, illegal combinations with different attributes for the data 
connection could arise. This means you have to prevent immediate acceptance of the change 
with "FreezeProviderConnections" before changing "YOnlineTag(i)".
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See also
FunctionTrendControl (Page 5038)

ZeroPoint 

Description
Specifies the position of the zero point as a percentage of the bar height. The zero point can 
also be located outside of the displayed area. 

The "ScalingType" property must be set to "Auto". 

The "ShowScale" property must be set to "TRUE". 

Access in Runtime: Read and write

Syntax
Object.ZeroPoint[=Int]

Object
Required A ""ScreenItem" object with the format ""Bar".

Int
Optional A value or a constant that specifies the position of the zero point as a percentage of 
the bar height.

See also
Bar (Page 4995)

ZeroPointValue

Description
Defines the value of the zero point of the scale indicator.

Defines or returns the absolute value for the zero point. 

Zoom/Zoomfactor

Description  
Sets or reads the zoom factor of a screen or screen window.

If the indicated zoom factor is smaller than the minimum value, the zoom factor is automatically 
set to the minimum value. If the indicated zoom factor is larger than the minimum value, the 
zoom factor is automatically set to the maximum value. 
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The minimum value of the zoom factor is at 2%, the maximum value at 800%.

With the Screen Object the zoom factor is indicated as a numeric value and with a picture 
window object, it is indicated in percent. 

Zoom: Zoom factor of picture

Zoomfactor: Zoom factor of picture window

Example
The following example doubles the zoom factor of the current picture:

 
'VBS97
HMIRuntime.ActiveScreen.Zoom = HMIRuntime.ActiveScreen.Zoom * 2

See also
ScreenWindow (Page 5116)

Zoomable

Description
Specifies whether the DXF screen display supports the zoom functions in Runtime mode. 

Access in Runtime: Read and write

Syntax
Object.Zoomable[=BOOLEAN]

Object
Required A "ScreenItem" object with the format "DXFView".

BOOLEAN
Optional TRUE, if the DXF screen display supports the zoom functions in Runtime mode.
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Methods

Methods A-G

Activate

Description
Activates the permanent window or the root screen.       

To activate a not selected screen, use the "BaseScreenName" property.

It only makes sense to use the activate method with the following operable screen objects. An 
error message is output at screen objects which cannot be operated, for example rectangles. 

● I/O field

● Switch

● Symbol library

● Trend view

● f(x) trend view

● HTML browser

● Slider

● Graphic I/O field

● Symbolic I/O field

● Button

● Alarm view

● User view

● Recipe view

● Sm@rtClient View

● Status/Force

Syntax
Expression.Activate

Expression
Necessary. An output which returns an object of the "Screen" or "ScreenItem" type.

Parameters
--

 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5775



See also
ScreenItem (Page 4966)

Screen (Page 4964)

ChannelDiagnose (Page 5006)

CheckBox (Page 5008)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

DateTimeField (Page 5023)

DiskSpaceView (Page 5025)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicIOField (Page 5049)

GraphicView (Page 5052)

HTMLBrowser (Page 5057)

IOField (Page 5059)

Rectangle (Page 5110)

ScriptDiagnostics (Page 5118)

Switch (Page 5127)

SymbolicIOField (Page 5130)

SymbolLibrary (Page 5135)

TextField (Page 5144)

TrendView (Page 5155)

TubeArcObject (Page 5158)

TubeDoubleTeeObject (Page 5160)

TubePolyline (Page 5162)

TubeTeeObject (Page 5165)

UserView  (Page 5174)

WindowSlider (Page 5176)

StatusForce (Page 5125)

SmartClientView (Page 5123)
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Slider (Page 5120)

ScreenWindow (Page 5116)

RoundButton (Page 5112)

Polyline (Page 5098)

Polygon (Page 5095)

OptionGroup (Page 5092)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

Line (Page 5063)

Bar (Page 4995)

Button (Page 5002)

OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmView (Page 4992)

AlarmControl (Page 4981)

ActivateDynamic

Description     
Dynamically activates a trigger and the specified cycle for a property at runtime. This requires 
a VB script at the property as well as a trigger set to "On demand". Every time the trigger is 
activated a different activation cycle can be used. 

Syntax
Expression.ActivateDynamic (ByVAl bstrPropertyName As String, ByVal 
bstrCycleName As String)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.  
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Parameters

Parameter Description
bstrPropertyName Name of property to which trigger relates.
bstrCycleName Name of activation cycle, e.g. "CycleTime1s".

See also
ChannelDiagnose (Page 5006)

CheckBox (Page 5008)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

DiskSpaceView (Page 5025)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicIOField (Page 5049)

GraphicView (Page 5052)

HTMLBrowser (Page 5057)

IOField (Page 5059)

Rectangle (Page 5110)

ScriptDiagnostics (Page 5118)

SymbolicIOField (Page 5130)

SymbolLibrary (Page 5135)

TextField (Page 5144)

TubeArcObject (Page 5158)

TubeDoubleTeeObject (Page 5160)

TubePolyline (Page 5162)

TubeTeeObject (Page 5165)

UserView  (Page 5174)

WindowSlider (Page 5176)

Slider (Page 5120)

ScreenWindow (Page 5116)
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RoundButton (Page 5112)

Polyline (Page 5098)

Polygon (Page 5095)

OptionGroup (Page 5092)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

Line (Page 5063)

Bar (Page 4995)

Button (Page 5002)

OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

Add

Description of TagSet Object
Adds a tag to the list. A tag may be added to the tag object by using name or reference.

syntax
Expression.Add [Tag]

Expression
Necessary. An expression which returns an object of type "TagSet". 

Parameters
VARIANT

Parameters Description
Tag Name of a WinCC tag or reference to a tag object 

to be added to the list. 
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Example:
In the following example, a TagSet object is generated and a tag is added. 

 
'VBS170
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"

 

Tag objects may also be added as follows.

 
'VBS171
Dim Tag
Set Tag = HMIRuntime.Tags("Motor2")
Dim group2
Set group2 = HMIRuntime.Tags.CreateTagSet
group2.Add Tag

Description of DataSet Object
Adds a value or object reference to the list.  

 

 Note

The Data Set Object does not support classes.
Objects of type Screen, Screens, ScreenItem, ScreenItems, Tag and TagSet cannot be 
included in the DataSet list.   
For object references it must be ascertained that objects are multiread-enabled. 

 

syntax
Expression.Add [vtName], [vtUserData]

Expression
Necessary. An expression which returns an object of type "DataSet". 

Parameters
VARIANT

Parameters Description
vtName Name by which value or tag are to be added to list. 
vtUserData Value to be added to list.
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Example:
In this example, a value is included in the DataSet list. 

 
'VBS172
HMIRuntime.DataSet.Add "Motor1",23

See also
DataSet (list) (Page 4954)

OnlineTrendControl (Page 5083)

AttachDB method

Description 
Executes the "Connect backup" key function of the control.

Syntax
Ausdruck.AttachDB()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

CalculateStatistic

Description  
Executes the "calculate statistics" key function of the f(t) trend view.
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Syntax
Ausdruck.CalculateStatistic()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
Example of statistically evaluating tag values (Page 4522)

OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

CopyRows

Description
Executes the "Copy lines" key function of the control.

Syntax
Ausdruck.CopyRows()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)
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Create

Description
Creates a new Alarm object.

Syntax
Expression.Create (VARIANT vtApplication)

Expression
Required An expression which returns an object of type "Alarm".  

Parameters
VARIANT

Parameters Description
vtApplication Name of alarm object (optional)

See also
Example of configuring the alarm view (Page 4521)

OnlineTrendControl (Page 5083)

CreateTagSet

Description    
Creates a new TagSet object. This object may be used for optimized multi-tag access.

syntax
Expression.CreateTagSet()

Expression
Necessary. An expression which returns an object of type "TagSet".  

Parameters
VARIANT
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Example:
The following example shows how to create a TagSet object.

 
'VBS168
'Build a Reference to the TagSet Object
Dim group
Set group = HMIRuntime.Tags.CreateTagSet

See also
OnlineTrendControl (Page 5083)

CutRows

Description  
Executes the "Cut rows" key function of the recipe view.

Syntax
Ausdruck.CutRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

UserArchiveControl (Page 5167)

DeactivateDynamic

Description   
Deactivates the trigger of the "ActivateDynamic" method used for the specified property in/
during runtime.

Syntax
Ausdruck.DeactivateDynamic(ByVal bstrPropertyName As String)
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
String

Parameters Description
bstrPropertyName Name of property to which trigger relates.

 

 

 

See also
ChannelDiagnose (Page 5006)

CheckBox (Page 5008)

Circle (Page 5011)

CircleSegment (Page 5013)

CircularArc (Page 5016)

Clock (Page 5018)

Connector (Page 5020)

DiskSpaceView (Page 5025)

Ellipse (Page 5027)

EllipseSegment (Page 5029)

EllipticalArc (Page 5032)

Gauge (Page 5046)

GraphicIOField (Page 5049)

GraphicView (Page 5052)

HTMLBrowser (Page 5057)

IOField (Page 5059)

Rectangle (Page 5110)

ScriptDiagnostics (Page 5118)

SymbolicIOField (Page 5130)

SymbolLibrary (Page 5135)

TextField (Page 5144)

TubeArcObject (Page 5158)
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TubeDoubleTeeObject (Page 5160)

TubePolyline (Page 5162)

TubeTeeObject (Page 5165)

UserView  (Page 5174)

WindowSlider (Page 5176)

Slider (Page 5120)

ScreenWindow (Page 5116)

RoundButton (Page 5112)

Polyline (Page 5098)

Polygon (Page 5095)

OptionGroup (Page 5092)

MultiLineEdit (Page 5070)

MediaPlayer (Page 5068)

Listbox (Page 5065)

Line (Page 5063)

Bar (Page 4995)

Button (Page 5002)

OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

DeleteRows

Description  
Executes the "Delete rows" key function of the recipe view.

Syntax
Ausdruck.DeleteRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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See also
OnlineTrendControl (Page 5083)

UserArchiveControl (Page 5167)

DetachDB

Description
Executes the "Disconnect backup" key function of the control.

Syntax
Ausdruck.DetachDB()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

Edit

Description  
Executes the "Edit" key function of the table view.

Syntax
Ausdruck.Edit()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5787



See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

AlarmControl (Page 4981)

Export

Description
Executes the "Export archive" or "Export data" key function of the control.

Syntax
Ausdruck.Export()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

GetColumn

Description   
Returns the column object of the recipe view designated by name or index as 
"ICCAxUAColumn" type.

Syntax
Ausdruck.GetColumn(ByVal vIndex As Variant)
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the column of the recipe view

Example

 
'VBS312
Dim ctrl
Dim objColumn
Set ctrl = ScreenItems("RecipeControl")
Set objColumn = ctrl.GetColumn("Field1")
objColumn.Length = 30
Set objColumn = ctrl.GetColumn(3)
objColumn.Align = 2

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "Column" listing, for example, you write "objColumn.Align" instead of 
"objColumn.ColumnAlign".

 

 

See also
OnlineTrendControl (Page 5083)

UserArchiveControl (Page 5167)

GetColumnCollection

Description   
Returns the list of all column objects of the recipe view as "ICCAxCollection" type.
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Syntax
Ausdruck.GetColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS313
Dim ctrl
Dim coll
Dim field
Set ctrl = ScreenItems("RecipeControl")
Set coll = ctrl.GetColumnCollection
HMIRuntime.Trace "Number of fields:" & coll.Count & vbCrLf
For Each field In coll
 HMIRuntime.Trace field.Name & vbCrLf
 HMIRuntime.Trace field.Type & vbCrLf
 HMIRuntime.Trace field.Length & vbCrLf
 HMIRuntime.Trace field.Caption & vbCrLf
Next

See also
OnlineTrendControl (Page 5083)

UserArchiveControl (Page 5167)
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GetHistlistColumnCollection

Description   
Returns the list of all column objects of the message view hit list as "ICCAxCollection" type.

Syntax
Expression.GetHitlisteColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS315
Dim ctrl
Dim coll
Dim hitlistcol
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetHitlistColumnCollection
HMIRuntime.Trace "Number of hitlist columns:" & coll.Count & vbCrLf
For Each hitlistcol In coll
 HMIRuntime.Trace hitlistcol.Index & vbCrLf
 HMIRuntime.Trace hitlistcol.Name & vbCrLf
 HMIRuntime.Trace hitlistcol.Sort & vbCrLf
 HMIRuntime.Trace hitlistcol.SortIndex & vbCrLf
Next
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See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetHitlistColumn

Description   
Returns the column object of the message view hit list designated by name or index as 
"ICCAxMessageColumn" type.

Syntax
Expression.GetHitlistColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of hitlist column

Example

 
'VBS314
Dim ctrl
Dim objHitlistColumn
Set ctrl = ScreenItems("AlarmControl")
Set objHitlistColumn = ctrl.GetHitlistColumn("Date")
objHitlistColumn.Sort = 2
Set objHitlistColumn = ctrl.GetHitlistColumn("AverageComeGo")
objHitlistColumn.Visible = FALSE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "HitlistColumn" listing, for example, you write "objHitlistColumn.Visible" instead of 
"objHitlistColumn.HitlistColumnVisible".
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See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetMessageBlock

Description   
Returns the message block of the message view designated by name or index as 
"ICCAxMessageBlock" type.

Syntax
Expression.GetMessageBlock(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of message block.

Example

 
'VBS316
Dim ctrl
Dim objMsgBlock
Set ctrl = ScreenItems("AlarmControl")
Set objMsgBlock = ctrl.GetMessageBlock("Date")
objMsgBlock.Align = 2
Set objMsgBlock = ctrl.GetMessageBlock("Number")
objMsgBlock.LeadingZeros = 4
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "MessageBlock" listing, for example, you write "objMsgBlock.Align" instead of 
"objMsgBlock.MessageBlockAlign".

 

 

See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetMessageBlockCollection

Description   
Returns the list of all message block objects of the message view as "ICCAxCollection" type.

Syntax
Expression.GetMessageBlockCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)
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Example

 
'VBS317
Dim ctrl
Dim coll
Dim msgblock
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetMessageBlockCollection
For Each msgblock In coll
 msgblock.Align = 1
 msgblock.Length = 12
 msgblock.Selected = TRUE
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "MessageBlock" listing, for example, you write "msgblock.Align" instead of 
"msgblock.MessageBlockAlign".

 

See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetMessageColumn

Description   
Returns the column object of the message view designated by name or index as 
"ICCAxMessageColumn" type.

Syntax
Expression.GetMessageColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
VARIANT

Parameters Description
vIndex Index or name of column in message list.

Example

 
'VBS318
Dim ctrl
Dim objMessColumn
Set ctrl = ScreenItems("AlarmControl")
Set objMessColumn = ctrl.GetMessageColumn("Date")
objMessColumn.Visible = FALSE
Set objMessColumn = ctrl.GetMessageColumn("Number")
objMessColumn.Sort = 1

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "MessageColumn" listing, for example, you write "objMessColumn.Visible" instead 
of "objMessColumn.MessageColumnVisible".

 

 

See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetOperatorMessage

Description   
Returns the operator message object of the message view designated by name or index as 
"ICCAxOperatorMessage" type.

Syntax
Expression.GetOperatorMessage(ByVal vIndex As Variant)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5796 System Manual, 02/2014



Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of operator message

Example

 
'VBS320
Dim ctrl
Dim objOpMess
Set ctrl = ScreenItems("AlarmControl")
Set objOpMess = ctrl.GetOperatorMessage(0)
objOpMess.Source1 = "Number"
objOpMess.SourceType1 = 1

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "OperatorMessage" listing, for example, you write "objOpMess.Source1" instead of 
"objOpMess.OperatorMessageSource1".

 

 

See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetMessageColumnCollection

Description   
Returns the list of all column objects of the message view as "ICCAxCollection" type.

Syntax
Expression.GetMessageColumnCollection()
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS319
Dim ctrl
Dim coll
Dim msgcol
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetMessageColumnCollection
HMIRuntime.Trace "Number of message columns:" & coll.Count & vbCrLf
For Each msgcol In coll
 HMIRuntime.Trace msgcol.Index & vbCrLf
 HMIRuntime.Trace msgcol.Name & vbCrLf
 HMIRuntime.Trace msgcol.Sort & vbCrLf
 HMIRuntime.Trace msgcol.SortIndex & vbCrLf
Next

See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)

GetOperatorMessageCollection

Description   
Returns the list of all operator message objects of the message view as "ICCAxCollection" 
type.
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Syntax
Expression.GetOperatorMessageCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS321
Dim ctrl
Dim coll
Dim opmsg
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetOperatorMessageCollection
For Each opmsg In coll
 HMIRuntime.Trace opmsg.Index & vbCrLf
 HMIRuntime.Trace opmsg.Name & vbCrLf
 HMIRuntime.Trace opmsg.Number & vbCrLf
 HMIRuntime.Trace opmsg.Selected & vbCrLf
Next

See also
OnlineTrendControl (Page 5083)

AlarmControl (Page 4981)
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GetRow

Description   
Returns the row object defined by its row number in the table-based controls as 
"ICCAxDataRow" type.

Syntax
Expression.GetRow(ByVal IRow As Long)

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
Long

Parameters Description
IRow Number of the desired line of the control.

Example

 
'VBS356
Dim coll
Dim ctrl
Dim lIndex
Dim lCellIndex 
Set ctrl = ScreenItems("UAControl")
Set coll = ctrl.GetRowCollection
'enumerate and trace out row numbers 
For lIndex = 1 To coll.Count
 HMIRuntime.trace "Row: " & (ctrl.GetRow(lIndex).RowNumber) & "  "
 'enumerate and trace out column titles and cell texts
 For lCellIndex = 1 To ctrl.GetRow(lIndex).CellCount
  HMIRuntime.trace ctrl.GetRow(0).CellText(lCellIndex) & "  "
  HMIRuntime.trace ctrl.GetRow(lIndex).CellText(lCellIndex) & "  "
 Next
 HMIRuntime.trace vbNewLine
Next
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 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Row" listing, for example, you write "objRow.CellCount" instead of 
"objRow.RowCellCount".

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

GetRowCollection

Description 
Returns the list of all row objects of the table-based controls type "ICCAxDataRowCollection". 

Syntax
Expression.GetRowCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Properties of the ICCAxDataRowCollection
The ICCAxDataRowCollection refers to runtime data. The data is read-only. It is not possible 
to add and edit the data.

The following properties are available for the ICCAxDataRowCollection:

● Count - Determines the number of rows in the collection.

● Item - Access to an individual row within the collection via the row number. Numbering runs 
from 1 to Count. A Row object is returned.
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Example

 
'VBS357
Dim ctrl
Dim coll
Dim lIndex
Dim lCellIndex
Set ctrl = ScreenItems("AlarmControl")
Set coll = ctrl.GetRowCollection
HMIRuntime.Trace "Number of message rows:" & coll.Count & vbCrLf
'enumerate and trace out row numbers
For lIndex = 1 To coll.Count
 HMIRuntime.Trace "Row: " & (ctrl.GetRow(lIndex).RowNumber) & "  "
 'enumerate and trace out column titles and cell texts
 For lCellIndex = 1 To ctrl.GetRow(lIndex).CellCount
  HMIRuntime.Trace ctrl.GetMessageColumn(lCellIndex -1).Name & " "
  HMIRuntime.Trace ctrl.GetRow(lIndex).CellText(lCellIndex) & "  "
 Next
 HMIRuntime.Trace vbNewLine
Next

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

GetRulerBlock 

Description   
Returns the block object of the evaluation table designated by name or index as 
"ICCAxRulerBlock" type.

Syntax
Expression.GetRulerBlock(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
VARIANT

Parameters Description
vIndex Index or name of the block in the evaluation table

Example

 
'VBS322
Dim ctrl
Dim objRulerBlock
Set ctrl = ScreenItems("RulerControl")
Set objRulerBlock = ctrl.GetRulerBlock(0)
objRulerBlock.Caption = "RulerBlock1"
Set objRulerBlock = ctrl.GetRulerBlock("Name")
objRulerBlock.Length = 10

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "RulerBlock" listing, for example, you write "objRulerBlock.Caption" instead of 
"objRulerBlock.BlockCaption".

 

 

See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)

GetRulerBlockCollection 

Description   
Returns the list of all block objects of the evaluation table as "ICCAxCollection" type.

Syntax
Expression.GetRulerBlockCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS323
Dim ctrl
Dim coll
Dim rulerblock
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetRulerBlockCollection
For Each rulerblock In coll
 rulerblock.Align = 1
 rulerblock.Length = 12
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "RulerBlock" listing, for example, you write "rulerblock.Align" instead of 
"rulerblock.RulerBlockAlign".

 

 

See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)
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GetRulerColumn

Description   
Returns the column object of the evaluation table designated by name or index as 
"ICCAxRulerColumn" type.

Syntax
Expression.GetRulerColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the column of the evaluation

Example

 
'VBS324
Dim ctrl
Dim objRulercol
Set ctrl = ScreenItems("RulerControl")
Set objRulercol = ctrl.GetRulerColumn("Name")
objRulercol.Sort = 0
Set objRulercol = ctrl.GetRulerColumn("ValueY")
objRulercol.Visible = FALSE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "RulerColumn" listing, for example, you write "objRulercol.Visible" instead of 
"objRulercol.ColumnVisible".
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See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)

GetRulerColumnCollection 

Description   
Returns the list of all column objects of the evaluation table as "ICCAxCollection" type.

Syntax
Expression.GetRulerColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS325
Dim ctrl
Dim coll
Dim rulercol
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetRulerColumnCollection
HMIRuntime.Trace "Number of ruler columns:" & coll.Count & vbCrLf
For Each rulercol In coll
 HMIRuntime.Trace rulercol.Index & vbCrLf
 HMIRuntime.Trace rulercol.Name & vbCrLf
 HMIRuntime.Trace rulercol.Sort & vbCrLf
 HMIRuntime.Trace rulercol.SortIndex & vbCrLf
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Next

See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)

GetRulerData

Description   
Returns the value of the called trend at the ruler position.

Syntax
Expression.GetRulerData(ByVal RulerIndex As Long, pvValue As 
Variant, Optional pvTimeStamp As Variant, Optional pvFlags As 
Varian) Long

Expression
Necessary. An expression which returns an object of the "Trend" type.

Parameters

Parameters Description
RulerIndex 0 =Ruler
pvValue Value of X axis
pvTimeStamp Time or value of the Y axis
pvFlags Qualitycode

Example

 
'VBS326
Dim ctrl
Dim objTrend
Dim objIOField1
Dim objIOField2
Dim rulvalue
Dim rultime
Set ctrl = ScreenItems( "Control1" )
Set objTrend = ctrl.GetTrend( "Trend 1" )
Set objIOField1 = ScreenItems( "I/O Field1" )
Set objIOField2 = ScreenItems( "I/O Field2" )
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objTrend.GetRulerData 0, rulvalue, rultime
objIOField1.OutputValue = rulvalue
objIOField2.OutputValue = rultime

See also
OnlineTrendControl (Page 5083)

GetSelectedRow

Description     
Returns the selected row object of a table-based control as "ICCAxDataRow" type.

Syntax
Expression.GetSelectedRow()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Example

 
'VBS358
Dim ctrl
 Dim lCellIndex
 Dim lCellCount 
 Dim headingRow
 Dim selectedRow
 Set ctrl = ScreenItems("TableControl")
 Set headingRow = ctrl.GetRow(0)
 Set selectedRow = ctrl.GetSelectedRow
 lCellCount = headingRow.CellCount
 'enumerate and trace out column titles and cell texts
 For lCellIndex = 1 To lCellCount
  HMIRuntime.trace headingRow.CellText(lCellIndex) & ":  "
  HMIRuntime.trace selectedRow.CellText(lCellIndex)
    HMIRuntime.trace vbNewLine
 Next
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 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Row" listing, for example, you write "objRow.CellCount" instead of 
"objRow.RowCellCount".

 

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

GetSelectedRows

Description     
Returns the selected row objects of a table-based control as type "ICCAxDataRow" for multiple 
selection.

Syntax
Expression.GetSelectedRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Example

 
'VBS359
Dim ctrl
 Dim lCellIndex
 Dim lCellCount 
 Dim lRowIndex
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 Dim lRowCount
 Dim headingRow
 Dim selectedRow
 Dim selectedRows
 Set ctrl = ScreenItems("TableControl")
 Set headingRow = ctrl.GetRow(0)
 Set selectedRows = ctrl.GetSelectedRows
 lCellCount = headingRow.CellCount
 lRowCount = selectedRows.Count
 'enumerate selected rows
 For lRowIndex = 1 To lRowCount
  Set selectedRow = selectedRows(lRowIndex)
  HMIRuntime.Trace "Row number: " & CStr(lRowIndex) & vbNewLine
  'enumerate and trace out column titles and cell texts
  For lCellIndex = 1 To lCellCount
   HMIRuntime.trace headingRow.CellText(lCellIndex) & ":  "
   HMIRuntime.trace selectedRow.CellText(lCellIndex)
     HMIRuntime.trace vbNewLine
  Next
 Next

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Row" listing, for example, you write "objRow.CellCount" instead of 
"objRow.RowCellCount".

 

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

GetStatisticAreaColumn

Description   
Returns the column object of the statistic area window of the evaluation window designated 
by name or index as "ICCAxRulerColumn" type.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5810 System Manual, 02/2014



Syntax
Ausdruck.GetStatisticAreaColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of column of statistics area window.

Example

 
'VBS327
Dim ctrl
Dim objStatAreaCol
Set ctrl = ScreenItems("RulerControl")
Set objStatAreaCol = ctrl.GetStatisticAreaColumn("DatasourceY")
objStatAreaCol.Visible = FALSE
Set objStatAreaCol = ctrl.GetStatisticAreaColumn("ValueY(LL)")
objStatAreaCol.Sort = 1

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatisticAreaColumn" listing, for example, you write "objStatAreaCol.Visible" instead 
of "objStatAreaCol.ColumnVisible".

 

 

See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)
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GetStatisticAreaColumnCollection

Description   
Returns the list of all column objects of the statistic area window of the evaluation table as 
"ICCAxCollection" type.

Syntax
Ausdruck.GetStatisticAreaColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS328
Dim ctrl
Dim coll
Dim statcol
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetStatisticAreaColumnCollection
HMIRuntime.Trace "Number of statistic Area columns:" & coll.Count & vbCrLf
For Each statcol In coll
 HMIRuntime.Trace statcol.Index & vbCrLf
 HMIRuntime.Trace statcol.Name & vbCrLf
 HMIRuntime.Trace statcol.Sort & vbCrLf
 HMIRuntime.Trace statcol.SortIndex & vbCrLf
Next
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See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)

GetStatisticResultColumn

Description   
Returns the column object of the statistic window of the evaluation window designated by name 
or index as "ICCAxRulerColumn" type.

Syntax
Ausdruck.GetStatisticResultColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of column of statistics window.

Example

 
'VBS329
Dim ctrl
Dim objStatResCol
Set ctrl = ScreenItems("RulerControl")
Set objStatResCol = ctrl.GetStatisticResultColumn("MaxValue")
objStatResCol.Visible = FALSE
Set objStatResCol = ctrl.GetStatisticResultColumn("Average")
objStatResCol.Sort = 2

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatisticResultColumn" listing, for example, you write "objStatResCol.Visible" instead 
of "objStatResCol.ColumnVisible".
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See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)

GetStatisticResultColumnCollection

Description   
Returns the list of all column objects of the statistic window of the evaluation table as 
"ICCAxCollection" type.

Syntax
Ausdruck.GetStatisticResultColumnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS330
Dim ctrl
Dim coll
Dim statcol
Set ctrl = ScreenItems("RulerControl")
Set coll = ctrl.GetStatisticResultColumnCollection
HMIRuntime.Trace "Number of statistic result columns:" & coll.Count & vbCrLf
For Each statcol In coll
 HMIRuntime.Trace statcol.Index & vbCrLf
 HMIRuntime.Trace statcol.Name & vbCrLf
 HMIRuntime.Trace statcol.Sort & vbCrLf
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 HMIRuntime.Trace statcol.SortIndex & vbCrLf
Next

See also
OnlineTrendControl (Page 5083)

TrendRulerControl (Page 5147)

GetStatusbarElement

Description 
Returns the element of the control status bar designated as name or index as type 
"ICCAxStatusbarElement".

Syntax
Ausdruck.GetStatusbarElement(ByVal vIndex As Variant)

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of status bar element.

Example

 
'VBS331
Dim ctrl
Dim objStatusBar
Set ctrl = ScreenItems( "Control1" )
Set objStatusBar = ctrl.GetStatusbarElement(1)
objStatusBar.Visible = FALSE
Set objStatusBar = ctrl.GetStatusbarElement(3)
objStatusBar.Width = 10
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatusbarElement" listing, for example, you write "objStatusBar.Visible" instead of 
"objStatusBar.StatusbarElementVisible".

 

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

GetStatusbarElementCollection

Description 
Returns the list of all status bar elements of the control as type "ICCAxCollection".

Syntax
Ausdruck.GetStatusbarElementCollection()

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:
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● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS332
Dim ctrl
Dim coll
Dim statelement
Set ctrl = ScreenItems.Item("Control1")
Set coll = ctrl.GetStatusbarElementCollection
HMIRuntime.Trace "Number of statusbar elements:" & coll.Count & vbCrLf
For Each statelement In coll
 HMIRuntime.Trace statelement.Name & vbCrLf
 HMIRuntime.Trace statelement.Width & vbCrLf
 HMIRuntime.Trace statelement.Text & vbCrLf
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "StatusbarElement" listing, for example, you write "statelement.Name" instead of 
"statelement.StatusbarElementName".

 

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

GetTimeAxis

Description     
Returns the time object that is specified by name or index for the f(t) trend view as 
"ICCAxTimeAxis" type.
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Syntax
Expression.GetTimeAxis(ByVal vIndex As Variant)

Expression
Necessary. Expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of time axis.

Example

 
'VBS333
Dim ctrl
Dim objTimeAxis
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTimeAxis = ctrl.GetTimeAxis(1)
objTimeAxis.Visible = FALSE
Set objTimeAxis = ctrl.GetTimeAxis("axis 2")
objTimeAxis.Label = "Time axis 2"
objTimeAxis.DateFormat = "dd.MM.yy"
objTimeAxis.TimeFormat = "HH:mm:ss.ms"
objTimeAxis.RangeType = 2
'The format to be used for date and time entries depends on the
'regional settings and language options in the operating system.
objTimeAxis.BeginTime = "06.04.2010 9:33:18"
'objTimeAxis.BeginTime = "04/06/2010 9:33:18"
objTimeAxis.MeasurePoints = 100

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "TimeAxis" listing, for example, you write "objTimeAx.Visible" instead of 
"objTimeAx.TimeAxisVisible".

 

See also
OnlineTrendControl (Page 5083)
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GetTimeAxisCollection

Description     
Returns a list of all time objects of the f(t) trend view as "ICCAxCollection" type.

Syntax
Expression.GetTimeAxisCollection()

Expression
Necessary. Expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for ICCAxCollection:

● Count

● Item

The following functions are available for ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS334
Dim ctrl
Dim objTrendWnd
Dim objTimeAxis1
Dim objTimeAxis2
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objTimeAxis1 = ctrl.GetTimeAxisCollection.AddItem("TimeAxis2010")
Set objTimeAxis2 = ctrl.GetTimeAxisCollection.AddItem("TimeAxis2011")
objTimeAxis1.TrendWindow = objTrendWnd.Name
objTimeAxis1.Label = "2010"
objTimeAxis1.RangeType = 1
'The format to be used for date and time entries depends on the
'regional settings and language options in the operating system.
objTimeAxis1.BeginTime = "01.01.2010 0:00:00"
'objTimeAxis1.BeginTime = "01/01/2010 0:00:00" 
objTimeAxis1.EndTime = "31.12.2010 11:59:59"
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'objTimeAxis1.EndTime = "12/31/2010 11:59:59"
objTimeAxis2.TrendWindow = objTrendWnd.Name
objTimeAxis2.Label = "2011"
objTimeAxis2.RangeType = 1
objTimeAxis2.BeginTime = "01.01.2011 0:00:00" 
'objTimeAxis2.BeginTime = "01/01/2011 0:00:00"
objTimeAxis2.EndTime = "31.12.2011 11:59:59"
'objTimeAxis2.EndTime = "12/31/2011 11:59:59"
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend1")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.TimeAxis = objTimeAxis1.Name
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend2")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.TimeAxis = objTimeAxis2.Name

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "TimeAxis" listing, for example, you write "objTimeAxis1.Label" instead of 
"objTimeAxis1.TimeAxisLabel".

 

 

See also
OnlineTrendControl (Page 5083)

GetTimeColumn

Description   
Returns the time column object of the table view designated by name or index as "ICCAxTime 
Column" type.

Syntax
Ausdruck.GetTimeColumn(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters
VARIANT

Parameters Description
vIndex Index or name of time column.

Example

 
'VBS335
Dim ctrl
Dim objTimeCol
Set ctrl = ScreenItems("TableControl")
Set objTimeCol = ctrl.GetTimeColumn("Timecolumn1")
objTimeCol.ShowDate = FALSE
Set objTimeCol = ctrl.GetTimeColumn("Timecolumn2")
objTimeCol.Visible = FALSE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "TimeColumn" listing, for example, you write "objTimeColumn.ShowDate" instead of 
"objTimeColumn.TimeColumnShowDate".

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

GetTimeColumnCollection

Description     
Returns the list of all time column objects of the table view as "ICCAxCollection" type.

Syntax
Expression.GetTimeColumnCollection()

Expression
Necessary. Expression that returns an object of the "ScreenItem" type.
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Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for ICCAxCollection:

● Count

● Item

The following functions are available for ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS336
Dim ctrl
Dim objTimeCol1
Dim objTimeCol2
Dim coll
Dim timecol
Set ctrl = ScreenItems("TableControl")
Set objTimeCol1 = ctrl.GetTimeColumnCollection.AddItem("TimeColumn2010")
Set objTimeCol2 = ctrl.GetTimeColumnCollection.AddItem("TimeColumn2011")
objTimeCol1.Caption = "2010"
objTimeCol1.RangeType = 1
'The format to be used for date and time entries depends on the
'regional settings and language options in the operating system.
objTimeCol1.BeginTime = "01.01.2010 0:00:00"
'objTimeCol1.BeginTime = "01/01/2010 0:00:00" 
objTimeCol1.EndTime = "31.12.2010 11:59:59"
'objTimeCol1.EndTime = "12/31/2010 11:59:59"
objTimeCol2.Caption = "2011"
objTimeCol2.RangeType = 0
objTimeCol2.BeginTime = "01.01.2011 0:00:00"
'objTimeCol2.BeginTime = "01/01/2011 0:00:00" 
objTimeCol2.TimeRangeFactor = 1
objTimeCol2.TimeRangeBase = 3600000
Set coll = ctrl.GetTimeColumnCollection
For Each timecol In coll
 timecol.Align = 1
 timecol.Length = 12
 timecol.BackColor = RGB(240,240,0)
 timecol.ForeColor = RGB(130,160,255)
Next
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See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

GetToolbarButton

Description     
Returns the button function designated by name or index on the control toolbar as 
"ICCAxToolbarButton" type.

Syntax
Ausdruck.GetToolbarButton(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of toolbar button function.

Example

 
'VBS337
Dim ctrl
Set ctrl = ScreenItems( "Control1" )
Dim toolbu
Set toolbu = ctrl.GetToolbarButton ("ShowHelp")
HMIRuntime.Trace "Name: " & toolbu.Name & vbCrLf
HMIRuntime.Trace "Index: " & toolbu.Index & vbCrLf
HMIRuntime.Trace "Hotkey: " & toolbu.HotKey & vbCrLf

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "ToolbarButton" listing, for example, you write "toolbu.Index" instead of 
"toolbu.ToolbarButtonIndex".
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See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

GetToolbarButtonCollection

Description     
Returns the list of all button functions of the control toolbar as "ICCAxCollection" type.

Syntax
Ausdruck.GetToolbarButtonCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following methods are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS338
Dim ctrl
Dim coll
Dim toolbu
Set ctrl = ScreenItems( "Control1" )
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Set coll = ctrl.GetToolbarButtonCollection
HMIRuntime.Trace "Number of toolbar buttons:" & coll.Count & vbCrLf
For Each toolbu In coll
 HMIRuntime.Trace toolbu.Name & vbCrLf
 HMIRuntime.Trace "Hotkey: " & toolbu.HotKey & vbCrLf
 HMIRuntime.Trace "Authorization: " & toolbu.PasswordLevel & vbCrLf
Next

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

GetTrend

Description     
Returns the f(t) or f(x) trend view designated by name or index as "ICCAxTrend" or 
"ICCAxFunctionTrend" type.

Syntax
Ausdruck.GetTrend(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of curve.

Example for Runtime Professional

 
'VBS339
Dim ctrl
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Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrend = ctrl.GetTrend( "Trend 1" )
objTrend.PointStyle = 1
objTrend.LineWidth = 4
Set objTrend = ctrl.GetTrend(2)
objTrend.Provider = 1
objTrend.TagName = "Archive\ArchiveTag2"

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Trend" listing, for example, you write "objTrend.PointStyle" instead of 
"objTrend.TrendPointStyle".

 

 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

GetTrendCollection

Description     
Returns the list of all trends of the f(t) or f(x) trend view as "ICCAxCollection" type.

Syntax
Ausdruck.GetTrendCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example for Runtime Professional

 
'VBS340
Dim ctrl
Dim objTrendWnd
Dim objTimeAxis
Dim objValAxis
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objTimeAxis = ctrl.GetTimeAxisCollection.AddItem("myTimeAxis")
Set objValAxis = ctrl.GetValueAxisCollection.AddItem("myValueAxis")
objTimeAxis.TrendWindow = objTrendWnd.Name
objValAxis.TrendWindow = objTrendWnd.Name
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend1")
objTrend.Provider = 1
objTrend.TagName = "Archive\ArchiveTag1"
objTrend.TrendWindow = objTrendWnd.Name
objTrend.TimeAxis = objTimeAxis.Name
objTrend.ValueAxis = objValAxis.Name

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "Trend" listing, for example, you write "objTrend.TagName" instead of 
"objTrend.TrendTagName".

 

 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)
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GetTrendWindow

Description     
Returns the trend view object of the f(t) trend view or the f(x) trend view designated by name 
or index as "ICCAxTrendWindow" type.

Syntax
Ausdruck.GetTrendWindow(ByVal vIndex As Variant)

Expression
Required An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of curve window.

Example for Runtime Professional

 
'VBS341
Dim ctrl
Dim objTrendWnd
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindow(1)
objTrendWnd.Visible = FALSE
Set objTrendWnd = ctrl.GetTrendWindow("trend window 2")
objTrendWnd.VerticalGrid = TRUE
objTrendWnd.FineGrid = TRUE

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "TrendWindow" listing, for example, you write "objTrendWnd.Visible" instead of 
"objTrendWnd.TrendWindowVisible".
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

GetTrendWindowCollection

Description     
Returns the list of all trend window objects of the f(t) trend display or the f(x) trend display as 
"ICCAxCollection" type.

Syntax
Ausdruck.GetTrendWindowCollection()

Expression
Required. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example for Runtime Professional

 
'VBS342
Dim ctrl
Dim objTrendWnd
Dim objTimeAxis
Dim objValAxis
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objTimeAxis = ctrl.GetTimeAxisCollection.AddItem("myTimeAxis")
Set objValAxis = ctrl.GetValueAxisCollection.AddItem("myValueAxis")
objTimeAxis.TrendWindow = objTrendWnd.Name

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5829



 
objValAxis.TrendWindow = objTrendWnd.Name

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

GetValueAxis

Description   
Returns the value axis object of the f(t) trend view designated by name or index as 
"ICCAxValueAxis" type.

Syntax
Ausdruck.GetValueAxis(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the value axis

Example

 
'VBS343
Dim ctrl
Dim objValAxis
Set ctrl = ScreenItems("OnlineTrendControl")
Set objValAxis = ctrl.GetValueAxis(1)
objValAxis.Visible = FALSE
Set objValAxis = ctrl.GetValueAxis("axis 2")
objValAxis.Label = "Value axis 2"
objValAxis.ScalingType = 0
objValAxis.Precisions = 2
objValAxis.AutoRange = TRUE
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "ValueAxis" listing, for example, you write "objValueAx.Visible" instead of 
"objValueAx.ValueAxisVisible".

 

 

See also
OnlineTrendControl (Page 5083)

GetValueAxisCollection

Description   
Returns the list of all value axis objects of the f(t) trend view as "ICCAxCollection" type.

Syntax
Ausdruck.GetValueAxisCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)
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Example

 
'VBS344
Dim ctrl
Dim objTrendWnd
Dim objValAxis1
Dim objValAxis2
Dim objTrend
Set ctrl = ScreenItems("OnlineTrendControl")
Set objTrendWnd = ctrl.GetTrendWindowCollection.AddItem("myWindow")
Set objValAxis1 = ctrl.GetValueAxisCollection.AddItem("myValueAxis1")
Set objValAxis2 = ctrl.GetValueAxisCollection.AddItem("myValueAxis2")
objValAxis1.TrendWindow = objTrendWnd.Name
objValAxis1.Label = "Value1"
objValAxis2.TrendWindow = objTrendWnd.Name
objValAxis2.inTrendColor = TRUE
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend1")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.ValueAxis = objValAxis1.Name
Set objTrend = ctrl.GetTrendCollection.AddItem("myTrend2")
objTrend.TrendWindow = objTrendWnd.Name
objTrend.ValueAxis = objValAxis2.Name

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "ValueAxis" listing, for example, you write "objValueAxis1.Label" instead of 
"objValueAxis1.ValueAxisLabel".

 

 

See also
OnlineTrendControl (Page 5083)

GetValueColumn

Description     
Returns the value column object defined by name or index for the tabular view as 
"ICCAxValueColumn" type.

Syntax
Expression.GetValueColumn(ByVal vIndex As Variant)
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Expression
Necessary. Expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of the value column of the f(t) trend view.

Example

 
'VBS345
Dim ctrl
Dim objValueColumn
Set ctrl = ScreenItems("TableControl")
Set objValueColumn = ctrl.GetValueColumn("Valuecolumn1")
objValueColumn.Precisions = 4
Set objValueColumn = ctrl.GetValueColumn(2)
objValueColumn.ExponentialFormat = TRUE

 

 Note

When you use the "Get..." methods to access properties from the control object list rather 
than with the control object, you have to omit the prefix of the property with the name of the 
list.

For the "ValueColumn" listing, for example, you write "objValueColumn.Precisions" instead 
of "objValueColumn.ValueColumnPrecisions".

 

 

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

GetValueColumnCollection

Description   
Returns the list of all value column objects of the f(t) trend view as "ICCAxCollection" type.
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Syntax
Ausdruck.GetValueColulmnCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS346
Dim ctrl
Dim objValCol1
Dim objValCol2
Dim coll
Dim valcol
Set ctrl = ScreenItems("TableControl")
Set objValCol1 = ctrl.GetValueColumnCollection.AddItem("ValueColumn1")
Set objValCol2 = ctrl.GetValueColumnCollection.AddItem("ValueColumn2")
objValCol1.Caption = "Value Archive"
objValCol1.Provider = 1
objValCol1.TagName = "ProcessValueArchive\arch1"
objValCol1.TimeColumn = "TimeColumn1"
objValCol2.Caption = "Value Tag"
objValCol2.Provider = 2
objValCol2.TagName = "tagxx" 
objValCol2.TimeColumn = "TimeColumn2"
Set coll = ctrl.GetValueColumnCollection
For Each valcol In coll
 valcol.Align = 2
 valcol.Length = 10
 valcol.AutoPrecisions = TRUE
Next
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See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

GetXAxis

Description   
Returns the X axis object of the f(x) trend view designated by name or index as 
"ICCAxValueAxis" type.

Syntax
Ausdruck.GetXAxis(ByVal vIndex As Variant)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of X axis.

Example

 
'VBS347
Dim ctrl
Dim objXAx
Set ctrl = ScreenItems("FunctionTrendControl")
Set objXAx = ctrl.GetXAxis(1)
objXAx.Visible = FALSE
Set objXAx = ctrl.GetXAxis("axis 2")
objXAx.Label = "X axis 2"
objXAx.ScalingType = 0
objXAx.Precisions = 2
objXAx.Color = RGB(109,109,109)
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "XAxis" listing, for example, you write "objXAx.Visible" instead of 
"objXAx.XAxisVisible".

 

 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

GetXAxisCollection

Description   
Returns the list of all X axis objects of the f(x) trend view as "ICCAxCollection" type.

Syntax
Ausdruck.GetXAxisCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)
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Example

 
'VBS348
Dim ctrl
Dim objXAxis1
Dim objXAxis2
Dim coll
Dim axes
Set ctrl = ScreenItems("FunctionTrendControl")
Set objXAxis1 = ctrl.GetXAxisCollection.AddItem("myXAxis1")
objXAxis1.Label = "temperature"
Set objXAxis2 = ctrl.GetXAxisCollection.AddItem("myXAxis2")
objXAxis2.Label = "pressure"
Set coll = ctrl.GetXAxisCollection
HMIRuntime.Trace "Number of XAxis:" & coll.Count & vbCrLf
For Each axes In coll
 HMIRuntime.Trace axes.Name & vbCrLf
 HMIRuntime.Trace axes.Label & vbCrLf
Next

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "XAxis" listing, for example, you write "objXAxis1.Label" instead of 
"objXAxis1.XAxisLabel".

 

 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

GetYAxis

Description   
Returns the Y axis object of the f(x) trend view designated by name or index as 
"ICCAxValueAxis" type.

Syntax
Ausdruck.GetYAxis(ByVal vIndex As Variant)
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

Parameters Description
vIndex Index or name of Y axis.

Example

 
'VBS349
Dim ctrl
Dim objYAx
Set ctrl = ScreenItems("FunctionTrendControl")
Set objYAx = ctrl.GetYAxis(1)
objYAx.Visible = FALSE
Set objYAx = ctrl.GetYAxis("axis 2")
objYAx.Label = "Y axis 2"
objYAx.Align = 0
objYAx.Precisions = 3
objYAx.EndValue = 90.000
objYAx.BeginValue = 10.000

 

 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "YAxis" listing, for example, you write "objYAx.Visible" instead of 
"objYAx.YAxisVisible".

 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

GetYAxisCollection

Description   
Returns the list of all Y axis objects of the f(x) trend view as "ICCAxCollection" type.
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Syntax
Ausdruck.GetYAxisCollection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Features and functions of the ICCAxCollection
The following properties are available for the ICCAxCollection:

● Count

● Item

The following functions are available for the ICCAxCollection:

● AddItem(vName) As Object

● RemoveItem(vIndex)

Example

 
'VBS350
Dim ctrl
Dim objYAxis1
Dim objYAxis2
Dim coll
Dim axes
Set ctrl = ScreenItems("FunctionTrendControl")
Set objYAxis1 = ctrl.GetXAxisCollection.AddItem("myYAxis1")
objYAxis1.Label = "temperature"
Set objYAxis2 = ctrl.GetXAxisCollection.AddItem("myYAxis2")
objYAxis2.Label = "pressure"
Set coll = ctrl.GetYAxisCollection
HMIRuntime.Trace "Number of YAxis:" & coll.Count & vbCrLf
For Each axes In coll
 HMIRuntime.Trace axes.Name & vbCrLf
 HMIRuntime.Trace axes.Label & vbCrLf
Next
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 Note

When you use the "Get..." methods to access properties from the Control object list rather 
than with the Control object, you have to omit the prefix of the property with the name of the 
list.

For the "YAxis" listing, for example, you write "objYAxis1.Label" instead of 
"objYAxis1.YAxisLabel".

 

 

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

Methods H-R

HideAlarm

Description     
Executes the "Hide alarm" button function of the alarm view.

Syntax
Expression.HideAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

InsertData

Description
Adds data to the called trend.
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Syntax
Expression.InsertData(dblAxisX As Variant, dblAxisY As Variant)

Expression
Necessary. An expression which returns an object of the "Trend" type.

Parameters

Parameters Description
dblAxisX Value of X axis
dblAxisY Value of Y axis

Example

 
'VBS300
Dim lngFactor
Dim dblAxisX
Dim dblAxisY
Dim objTrendControl
Dim objTrend
Set objTrendControl = ScreenItems("Control1")
Set objTrend = objTrendControl.GetTrend("Trend 1")
For lngFactor = -100 To 100
dblAxisX = CDbl(lngFactor * 0.02)
dblAxisY = CDbl(dblAxisX * dblAxisX + 2 * dblAxisX + 1)
objTrend.InsertData dblAxisX, dblAxisY
Next

Item

Description
Returns an element from a list.     

Syntax
Expression.Item(Index)

Expression
Necessary. An expression which returns a list.
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Parameters

Index
The name or the index number of an element of the list:

● ScreenItems-Listing: Use an object name, e.g. 
"HmiRuntime.Screens(1).ScreenItems("Circle")", or the index number.

● Screens-Listing: Use either the name or the index number.

● SmartTags-Listing: You can only use the tag name as index in the SmartTags list. A 
counting of all tags is not possible.

 

If the transferred value does not correspond with an element in the list, an error occurs. The 
return value has the value "Nothing".

 
On Error Resume Next
Dim screen
Set screen = HmiRuntime.Screens("Screen_1")
If (screen is Nothing) 
then...
Else...
End If

Best practice for optimizing auto-completion support is to use combined addressing by means 
of screen name and object name, e.g. 
"HmiRuntime.Screens("Screen").ScreenItems("Circle")".

Example
The item method is the default method for lists. Therefore, the results are the same for the 
following two examples:

 
'VBS_Example_Item
HMIRuntime.Screens.Item(1)
HMIRuntime.Screens(1)

Both instructions reference the respective base screen.

See also
ScreenItems (list) (Page 4968)

ScreenItem (Page 4966)
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LockAlarm

Description     
Executes the "Disable alarm" button function of the alarm view.

Syntax
Expression.LockAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

LoopInAlarm

Description     
Executes the "Loop in alarm" button function of the alarm view.

Syntax
Expression.LoopInAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5843



MoveAxis

Description     
Executes the "Move axes area" button function of the f(t) and f(x) trend views.

Syntax
Expression.MoveAxis()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

MoveToFirst

Description    
Executes the "First line" button function of the control.

Syntax
Expression.MoveToFirst()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

UserArchiveControl (Page 5167)
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MoveToFirstLine

Description     
Executes the "First alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToFirstLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

MoveToFirstPage

Description     
Executes the "First page" button function of the alarm view.

Syntax
Ausdruck.MoveToFirstPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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MoveToLast

Description    
Executes the "last data record" button function of the control.

Syntax
Ausdruck.MoveToLast()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

UserArchiveControl (Page 5167)

MoveToLastLine

Description     
Executes the "Last alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToLastLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
AlarmControl (Page 4981)
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MoveToLastPage

Description     
Executes the "Last page" button function of the alarm view.

Syntax
Ausdruck.MoveToLastPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

MoveToNext

Description    
Executes the "next data record" button function of the control.

Syntax
Ausdruck.MoveToNext()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

UserArchiveControl (Page 5167)
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MoveToNextLine

Description   
Executes the "Next alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToNextLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

MoveToNextPage

Description     
Executes the "Next page" button function of the alarm view.

Syntax
Ausdruck.MoveToNextPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5848 System Manual, 02/2014



MoveToPrevious

Description     
Executes the "previous data record" button function of the control.

Syntax
Ausdruck.MoveToPrevious()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

UserArchiveControl (Page 5167)

MoveToPreviousLine

Description     
Executes the "Previous alarm" button function of the alarm view.

Syntax
Ausdruck.MoveToPreviousLine()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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MoveToPreviousPage

Description     
Executes the "Previous page" button function of the alarm view.

syntax
Ausdruck.MoveToPreviousPage()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

NextColumn

Description     
Executes the "Next column" button function of the table view.

Syntax
Ausdruck.NextColumn()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 5075)
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NextTrend

Description     
Executes the "Next trend" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.NextTrend()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

OneToOneView

Description     
Executes the "Original view" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.OneToOneView()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)
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PasteRows  

Description     
Executes the "Insert rows" button function of the recipe view.

Syntax
Expression.PasteRows()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
Example of configuring the recipe view (Page 4519)

UserArchiveControl (Page 5167)

PreviousColumn

Description   
Executes the "Previous column" button function of the table view.

Syntax
Ausdruck.PreviousColumn()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 5075)
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PreviousTrend

Description     
Executes the "Previous trend" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.PreviousTrend()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

Print

Description    
Executes the "Print" button function of the control.

Syntax
Ausdruck.Print()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)
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FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

QuitHorn

Description     
Executes the "Acknowledge central alarm generator" button function of the alarm view.

Syntax
Ausdruck.QuitHorn()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

QuitSelected

Description     
Executes the "Single acknowledgment" button function of the alarm view.

Syntax
Ausdruck.QuitSelected()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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QuitVisible

Description     
Executes the "Group acknowledgment" button function of the alarm view.

Syntax
Ausdruck.QuitVisible()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

ReadTags

Description     
Executes the "Read tags" button function of the recipe view.

Syntax
Ausdruck.ReadTags()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)
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Read

Description of Tag Object  
Reads out the status of a tag (tag object) shortly after the moment it was called. At the same 
time, the tag object is provided with the values read. Upon reading a tag, its value, quality code 
and time stamp are determined. The "LastError" property can be used to determine whether 
the call was successful.

The "Name" and "Tagprefix" properties are not changed by this. 

If the value of the tag is read successfully, the properties of the tag object are assigned the 
following values:

Property Allocation
Value Tag values
Name Tag name (unchanged)
QualityCode Quality level
Timestamp Current tag time stamp
LastError 0
ErrorDescription " "

If the value of the tag is not read successfully, the properties of the tag object are assigned 
the following values:

Property Allocation
Value VT_Empty
Name Tag name (unchanged)
QualityCode Bad Out of Service
Timestamp 0
LastError Read operation error codes
ErrorDescription Error description on LastError

syntax
Expression.Read([Readmode])

Expression
Necessary. An expression which returns a tag object. The return value of the Read method is 
the value of the tag read out. 
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Parameters
The optional "Readmode" parameter enables the distinction between two types of reading:

Parameters Description
0 The tag value is read from the process image 

(cache). 0 is the default value.
1 The value of a tag is read directly from AS or 

channel (direct).

If the "Readmode" parameter is omitted, the value is read from the process image by default. 
The return value of the Read method is the tag value read out as VARIANT. 

Reading From the Process Image
When reading from the process image, the tag is logged on and, from that moment, polled 
cyclically from the PLC. The login cycle is dependent on the configured trigger. The value is 
read from the tag image by WinCC. For Close Picture, the tag actions are ended again. The 
call is characterized by the following:

● The value is read by WinCC from the tag image.

● The call is faster in comparison to direct reading (except with the first call: The first call 
basically takes longer because the value from the PLC must be read out and logged on.)

● The duration of the call is not dependent on the bus load or AS.

Behavior in actions with a tag trigger

All of the tags contained in the tag trigger are already known with Open Picture and are 
registered with the defined monitoring time. Since all tags are requested at once, the best 
possible optimization can be targeted from the channel. If a tag, contained in the trigger, is 
requested with Read during an action, the value already exists and is transferred directly to 
the call. If a tag is requested which is not contained in the trigger, the behavior is the same as 
with a standard trigger.

Behavior in actions with a cyclic trigger

tags are registered with half of the cycle time with the first call. For every other call, the value 
is present.

Behavior in event-driven actions

The tag is registered in the "upon change" mode with the first call. Process tags that are 
registered in the "upon change" mode correspond with a cyclic read job with a cycle time of 
1s.

If an event (e.g. mouse click) requests a value asynchronously, the tag is transferred to the 
tag image. The tag is requested cyclically from the AS as of this point in time and therefore 
increases the basic load. To bypass this increase in the basic load, the value can also be read 
synchronously. The synchronous call causes a one-off increase in the communication load 
but the tag is not transferred to the tag image.
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Direct reading
In the case of direct reading, the current value is returned. The tag is not registered cyclically, 
the value is requested from the AS one time only. Direct reading has the following properties:

● The value is read explicitly from the AS.

● The call takes longer compared to reading from the process image.

● The duration of the call is dependent on the bus load and AS, amongst other things.

Example
Reading a tag directly from AS or channel

 
'VBS100
Dim objTag
Dim vntValue
Set objTag = HMIRuntime.Tags("Tagname")
vntValue = objTag.Read(1)    'Read direct
MsgBox vntValue

 

Reading a tag from the process image

 
'VBS101
Dim objTag
Dim vntValue
Set objTag = HMIRuntime.Tags("Tagname")
vntValue = objTag.Read    'Read from cache
MsgBox vntValue

Description of TagSet Object
The TagSet object offers the option of reading several tags in one call. 

Functionality here is mostly identical with that of a tag object. In the following, only deviations 
thereof are described. 

Expression
Necessary. An expression which returns an object of type "TagSet". 

Reading From the Process Image
The TagSet object offers the advantage of requesting several tags in one read command. The 
tags are registered in the process image as a group, improving performance in the process.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5858 System Manual, 02/2014



Direct reading
Since one call may process several read commands, performance is enhanced in comparison 
to single calls. 

Example
The following example shows how tags are included in the TagSet list, how tag values are 
imported and subsequently read. 

 
'VBS174
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
group.Read
HMIRuntime.Trace "Motor1: " & group("Motor1").Value & vbNewLine
HMIRuntime.Trace "Motor2: " & group("Motor2").Value & vbNewLine

 

If the optional parameter "Readmode" is set to 1, the process tags are not registered but read 
directly from AS or channel. 

 
group.Read 1

See also
Example of reading tag values (Page 4514)

Example of writing tag values (Page 4512)

Refresh

Description
Drawing all visible pictures again.

syntax
Expression.Refresh

Expression
Necessary. An expression which returns a "Screens" or "Screen" type object.
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Parameter
--

Examples
The first example forces all visible pictures to be drawn again:

 
'VBS149
HMIRuntime.Screens.Refresh

 

The second example forces the basic picture to be immediately redrawn:

 
'VBS150
HMIRuntime.Screens(1).Refresh

See also
Screen (Page 4964)

HMIRuntime  (Page 4956)

Remove

Description of TagSet Object  
Removes a tag from the TagSet list. The tag may be removed by name or reference to a tag 
object.

Syntax
Expression.Remove [Tag]

Expression
Required An expression that returns an object of type "TagSet". 

Parameters
VARIANT

Parameters Description
Tag Name of a WinCC tag or reference to a tag object 

to be removed from the list. 
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Example
The following example shows how several tags are included in the TagSet list, and how to 
remove a tag again. 

 
'VBS175
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
group.Remove "Motor1"

Description of DataSet Object
Deletes the element specified in parameter "Name" from a list. 

Syntax
Expression.Remove [Name]

Expression
Required An expression which returns an object of type "DataSet". 

Parameters
VARIANT

Parameters Description
Name Name of the object to be removed from the list. 

Example
The example shows how to remove the object "motor1" from the list.

 
'VBS166
HMIRuntime.DataSet.Remove("motor1")

Description of objects Logging, AlarmLogs, DataLogs
The method deletes previously swapped-in log segments from the Runtime project.

Log segments that were deleted using the "Remove" method are removed from the "Common 
logging" folder of the project.

The call may require a somewhat longer time period, depending on the log data. This may 
block the processing of subsequent scripts. Blockage of actions within the picture may be 
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avoided if you start the call in a Global Scripting action, such as starting the action through a 
trigger tag.

The process of disconnecting and clearing logs creates a CPU load. This will affect 
performance.

 

 Note

Calling up the "Remove" method is presently only possible at the server. There is an example, 
however, which shows how the method may be started by the client from a server.

 

Syntax

Objects Logging, AlarmLogs
Expression.Remove [TimeFrom] [TimeTo] [TimeOut] [ServerPrefix]

Expression
Required An expression that returns an object of type "Logging" or "AlarmLogs".

Object DataLogs
Expression.Remove [TimeFrom] [TimeTo] [TimeOut] [Type] [ServerPrefix]

Expression
Required An expression that returns an object of type "DataLogs".

Parameters

TimeFrom
Point in time, from which the logs are to be cleared.
When specifying the time information, a short form is also possible. This is described in the 
"Time format" section. 

TimeTo
Time up to which log segments are to be cleared. 
When specifying the time information, a short form is also possible. This is described in the 
"Time Format" section. 

Timeout
Timeout in milliseconds.
If you enter "-1" as a value, the wait will be infinite. If you enter a value of "0", there will be no 
wait.

Type
Type of log.
The parameter can (optionally) be used only to delete log segments of the tag logging.
The following values can be entered:
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Assigned value Type Description
1 hmiDataLogFast Tag Logging Fast data
2 hmiDataLogSlow Tag Logging Slow data
3 hmiDataLogAll Tag Logging Fast and Slow data

ServerPrefix
Reserved for future versions.

Return value
If an error occurred during deletion of the log segments, the method will return an error alarm. 
Additional information may be found under the subject heading "Error alarms from database 
area".

Time format
The format for specifying time information is defined as follows: YYYY-MM-DD hh:mm:ss, 
where YYYY represents the year, MM the month, DD the day, hh the hour, mm the minute 
and ss the second. For example, the time of 2 minutes and one second past 11 o'clock on July 
26, 2004 is displayed as follows: 2004-07-26 11:02:01.

For parameters "TimeFrom" and "TimeTo" the statement of data and time is also possible in 
short form. Not all format fields must be filled in this case. The short form means that the 
information on date and time may be lacking one or several parameters, beginning with the 
value for seconds. For example, the time may be specified in the "YYYY-MM" or "YYYY-MM-
DD hh" format. Using the statement "TimeFrom" = "2004-09" and "TimeTo" = "2004-10-04" all 
log segments between September 2004 up to and including October 4. 

Example
In the following example, log segments within a certain time period that were swapped in 
(again) after the fact are removed and the return value is output as a trace.

 
'VBS182
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Remove("2004-08-22","2004-09-22",-1) & 
vbNewLine

 

In the following example, all log segments that were swapped-in (again) after the fact are 
removed and the return value is output as a trace.

 
'VBS183
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Remove("","",-1) & vbNewLine

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5863



See also
Logging (Page 4961)

DataSet (list) (Page 4954)

DataLogs (list) (Page 4952)

AlarmLogs (list) (Page 4949)

RemoveAll 

Description of TagSet Object
Deletes all tags from a TagSet list.

syntax
Expression.RemoveAll

Expression
Necessary. An expression which returns an object of type "TagSet". 

Parameters
--

Example:
The following example shows how several tags are included in the TagSet list, and how to 
remove all tags again.

 
'VBS176
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Motor1"
group.Add "Motor2"
group.RemoveAll

Description of DataSet Object
Deletes all values or object references from a DataSet list.  

syntax
Expression.RemoveAll

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5864 System Manual, 02/2014



Expression
Necessary. An expression which returns an object of type "DataSet". 

Parameters
--

Example:
The example shows how all objects are removed from the list. 

 
'VBS167
HMIRuntime.DataSet.RemoveAll

See also
DataSet (list) (Page 4954)

Restore

Description of objects Logging, AlarmLogs, DataLogs  
The method adds swapped-out log segments to the Runtime project.

Upon swapping-in, the log segments are copied to the "Common logging" folder of the project. 
Therefore the appropriate storage capacity must be available.

The call may require a somewhat longer time period, depending on the log data. This may 
block the processing of subsequent scripts. Blockage of actions within the picture may be 
avoided if you start the call in a Global Scripting action, such as starting the action through a 
trigger tag.

The connecting/copying of the logs generates a CPU load because the SQL server 
experiences additional load, especially if signature checking is activated. Copying of log 
segments will slow down hard disk access. 

If signature checking is activated, an error message is returned if an unsigned or modified log 
is to be swapped in. There is always only one error alarm returned, even if several errors 
occurred during a swap-in process. Additionally, a WinCC system alarm is generated for each 
log segment. An entry is added to the Windows event viewer in the "Application" section. This 
provides the opportunity to check which log segments are creating the error.
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● With an unsigned log, the return value "0x8004720F" is returned. The event viewer contains 
the entry "Validation of database <db_name> failed! No signature found!". 
The log is swapped in.

● With a changed log, the return value "0x80047207" is returned. The event viewer contains 
the entry "Validation of database <db_name> failed!". 
The log is not swapped in.

 

  Note

Calling up the "Restore" method is presently only possible at the server. There is an 
example, however, which shows how the method may be started by the client from a 
server. 

 

Syntax

Objects Logging, AlarmLogs
Expression.Restore [SourcePath] [TimeFrom] [TimeTo] [TimeOut] 
[ServerPrefix]

Expression
Required An expression that returns an object of type "Logging" or "AlarmLogs".

Object DataLogs
Expression.Restore [SourcePath] [TimeFrom] [TimeTo] [TimeOut] [Type] 
[ServerPrefix]

Expression
Required An expression that returns an object of type "DataLogs".

Parameters

SourcePath
Path to log data.

TimeFrom
Point in time, from which the logs are to be swapped in.
When specifying the time information, a short form is also possible. This is described in the 
"Time format" section. 

TimeTo
Time up to which log segments are to be swapped in. 
When specifying the time information, a short form is also possible. This is described in the 
"Time Format" section. 
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Timeout
Timeout in milliseconds.
If you enter "-1" as a value, the wait will be infinite. If you enter a value of "0", there will be no 
wait.

Type
Type of log.
The parameter can (optionally) be used only to store log segments of the tag logging.
The following values can be entered:

Assigned value Type Description
1 hmiDataLogFast Tag Logging Fast data
2 hmiDataLogSlow Tag Logging Slow data
3 hmiDataLogAll Tag Logging Fast and Slow data

ServerPrefix
Reserved for future versions.

Return value
If an error occurred while swapping in log segments, the method will return an error message. 
Additional information may be found under the subject heading "Error alarms from database 
area".

Time format
The format for specifying time information is defined as follows: YYYY-MM-DD hh:mm:ss, 
where YYYY represents the year, MM the month, DD the day, hh the hour, mm the minute 
and ss the second. For example, the time of 2 minutes and one second past 11 o'clock on July 
26, 2004 is displayed as follows: 2004-07-26 11:02:01.

For parameters "TimeFrom" and "TimeTo" the statement of data and time is also possible in 
short form. Not all format fields must be filled in this case. The short form means that the 
information on date and time may be lacking one or several parameters, beginning with the 
value for seconds. For example, the statement may be in the form of "YYYY-MM" or "YYYY-
MM-DD hh". Using the statement "TimeFrom" = "2004-09" and "TimeTo" = "2004-10-04" all 
log segments between September 2004 up to and including October 4.

Example
In the following example, all log segments since the start of the specified time period are 
swapped in again, and the return value is output as a trace.

 
'VBS184
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.Restore("D:\Folder","2004-09-14","",-1) & 
vbNewLine
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In the following example, all Tag Logging Slow log segments in the specified time period are 
swapped in again, and the return value is output as a trace.

 
'VBS185
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.DataLogs.Restore("D:\Folder","2004-09-14 
12:30:05","2004-09-20 18:30",-1,2) & vbNewLine

 

In the following example, all Alarm Logging log segments up to the specified time period are 
swapped in again, and the return value is output as a trace.

 
'VBS186
HMIRuntime.Trace "Ret: " & HMIRuntime.Logging.AlarmLogs.Remove("","2004-09-20",-1) & 
vbNewLine

See also
Logging (Page 4961)

DataLogs (list) (Page 4952)

AlarmLogs (list) (Page 4949)

Methods S-Z

SelectAll

Description     
Selects all rows in a table-based control.

Syntax
Expression.SelectAll()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5868 System Manual, 02/2014



See also
OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

SelectedStatisticArea

Description     
Executes the "Set statistics range" button function of the table view.

Syntax
Ausdruck.SelectedStatisticArea()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 5075)

SelectRow

Description     
Selects a specific row in a table-based control.

Syntax
Expression.SelectRow(ByVal IRow As Long, Optional bExtendSelection 
As Boolean)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.
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Parameters

Parameters Description
IRow Number of the row to be selected.
bExtendSelection Indicates as an option whether the current selection will be extended. Is only 

relevant if multiple selections are possible.

Example
● Row 1 is currently selected. If SelectRow( 2, True ) is called, then row 1 and row 2 will be 

selected.

● Row 1 is currently selected. If SelectRow( 2, False ) or SelectRow( 2 ) is called without an 
optional parameter, then only row 2 will be selected.

See also
Example of configuring the recipe view (Page 4519)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

ServerExport

Description     
Executes the "Export log" button function of the recipe view.

Syntax
Ausdruck.ServerExport()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)
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ServerImport

Description     
Executes the "Import log" button function of the recipe view.

Syntax
Ausdruck.ServerImport()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)

ShowColumnSelection

Description     
Executes the "Select columns" button function of the table view.

Syntax
Ausdruck.ShowColumnSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTableControl (Page 5075)
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ShowComment

Description     
Executes the "Comment dialog" button function of the alarm view.

Syntax
Ausdruck.ShowComment()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
AlarmControl (Page 4981)

ShowDisplayOptionsDialog

Description     
Executes the "Display options dialog" button function of the alarm view.

Syntax
Ausdruck.ShowDisplayOptionsDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowEmergencyQuitDialog

Description     
Executes the "Single acknowledgment" button function of the alarm view.

Syntax
Ausdruck.ShowEmergencyQuitDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

ShowHelp

Description    
Executes the "Help" button function of the control.

Syntax
Ausdruck.ShowHelp()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)
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FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

ShowHideList

Description     
Executes the "List of alarm to hide" button function of the alarm view.

Syntax
Ausdruck.ShowHideList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

ShowHitList

Description     
Executes the "Hitlist" button function of the alarm view.

Syntax
Ausdruck.ShowHitList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowInfoText

Description   
Executes the "About dialog" button function of the alarm view.

Syntax
Ausdruck.ShowInfoText()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

ShowLockDialog

Description     
Executes the "Lock dialog" button function of the alarm view.

Syntax
Ausdruck.ShowLockDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowLockList

Description     
Executes the "Lock list" button function of the alarm view.

Syntax
Ausdruck.ShowLockList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

ShowLongTermArchiveList

Description     
Executes the "Historical alarm list (long-term)" button function of the alarm view.

Syntax
Ausdruck.ShowLongTermArchiveList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowMessageList

Description   
Executes the "Alarm list" button function of the alarm view.

Syntax
Ausdruck.ShowMessageList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

ShowPercentageAxis

Description     
Executes the "Relative axis" button function of the f(t) trend view.

Syntax
Ausdruck.ShowPercentageAxis()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 5083)
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ShowPropertyDialog

Description    
Executes the "Configuration dialog" button function of the control.

Syntax
Ausdruck.ShowPropertyDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
VARIANT

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

FunctionTrendControl (Page 5038)

AlarmControl (Page 4981)

ShowSelectArchive

Description     
Executes the "Select data connection" button function of the recipe view.

Syntax
Ausdruck.ShowSelectArchive()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -
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See also
UserArchiveControl (Page 5167)

ShowSelection

Description     
Executes the "Selection dialog" button function of the recipe view.

Syntax
Ausdruck.ShowSelection ()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)

ShowSelectionDialog

Description     
Executes the "Selection dialog" button function of the alarm view.

Syntax
Ausdruck.ShowSelectionDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowSelectTimeBase

Description     
Executes the "Timebase dialog" button function of the recipe view.

Syntax
Ausdruck.ShowSelectTimeBase()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)

ShowShortTermArchiveList

Description     
Executes the "Historical alarm list (short-term)" button function of the alarm view.

Syntax
Ausdruck.ShowShortTermArchiveList()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowSort

Description     
Executes the "Sorting dialog" button function of the recipe view.

Syntax
Ausdruck.ShowSort()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)

ShowSortDialog

Description     
Executes the "Sorting dialog" button function of the alarm view.

Syntax
Ausdruck.ShowSortDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowTagSelection

Description    
Executes the "Select data connection" button function of the control.

Syntax
Ausdruck.ShowTagSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

FunctionTrendControl (Page 5038)

ShowTimebaseDialog

Description     
Executes the "Timebase dialog" button function of the alarm view.

Syntax
Ausdruck.ShowTimebaseDialog()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)
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ShowTimeSelection

Description    
Executes the "Select time range" button function of the control.

Syntax
Ausdruck.ShowTimeSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

FunctionTrendControl (Page 5038)

ShowTrendSelection

Description     
Executes the "Select trends" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ShowTrendSelection()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
-- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

FunctionTrendControl (Page 5038)
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StartStopUpdate

Description    
Executes the "Start" or "Stop" button function of the control.

Syntax
Ausdruck.StartStopUpdate()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

OnlineTableControl (Page 5075)

FunctionTrendControl (Page 5038)

Stop

Description
Closes WinCC Runtime. 

Syntax
Expression.Stop

Expression
Required An expression which returns an "HMIRuntime" type object.

Parameters
--

See also
HMIRuntime  (Page 4956)

Example of deactivating Runtime (Page 4509)
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Trace

Description
Returns a user-defined text through the operating system channel for debug alarms.   

The methods HMIRuntime.Trace works only in a PC-based environment. The text transferred 
as parameter can be displayed using the diagnostics tools "GSC Diagnostics" or "ApDiag". 
You can use the "ShowSystemAlarm" system function if you need to run a trace without using 
external tools.

Syntax
Expression.Trace"STRING"

Expression
Required An expression which returns an "HMIRuntime" type object.

Parameters

STRING
The text which is issued as a debug alarm. The transferred text can be displayed using the 
diagnostics tools "GSC Diagnostics" or "ApDiag". You can use the "ShowSystemAlarm" 
system function if you need to run a trace without using external tools.

Example
In the following example a debug alarm is issued:

'VBS example trace
HMIRuntime.Trace "Customized error message"

See also
HMIRuntime  (Page 4956)

Example of configuring a diagnostics output via a trace (Page 4510)

Example of writing tag values (Page 4512)

Example of reading tag values (Page 4514)

UnhideAlarm

Description     
Executes the "Unhide alarm" button function of the alarm view.
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Syntax
Ausdruck.UnhideAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

UnlockAlarm

Description     
Executes the "Unlock alarm" button function of the alarm view.

Syntax
Ausdruck.UnlockAlarm()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
AlarmControl (Page 4981)

UnselectAll

Description     
Removes all selections from the cells of a table-based control.

Syntax
Expression.UnselectAll()
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Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
Example of configuring the recipe view (Page 4519)

OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

UnselectRow

Description     
Removes the selections from a specific cell of a table-based control.

Syntax
Expression.UnselectRow(ByVal IRow As Long)

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
Long

Parameters Description
IRow Number of the row to be selected.

See also
OnlineTableControl (Page 5075)

TrendRulerControl (Page 5147)

UserArchiveControl (Page 5167)

AlarmControl (Page 4981)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5887



Write

Description of Tag Object  
Writes a value to a tag. The "LastError" property can be used to determine whether the call 
was successful.

If the value of the tag is set successfully, the properties of the tag object are assigned the 
following values:

Property Allocation
Value Tag values set by the user (unchanged)
Name Tag name (unchanged)
QualityCode Bad Out of Service
Timestamp 0
LastError 0
ErrorDescription " "

If the value of the tag is not set successfully, the properties of the tag object are assigned the 
following values:

Property Allocation
Value Tag values set by the user (unchanged)
Name Tag name (unchanged)
QualityCode Bad Out of Service
Timestamp 0
LastError Write operation error codes
ErrorDescription Error description on LastError

syntax
Expression.Write [Value],[Writemode]

Expression
Necessary. An expression which returns a tag object.  

Parameters
The value to be written can be transferred directly to the method as a parameter. If the 
parameter is not specified, the value in the "Value" property is used. The "Writemode" option 
parameter can be used to select whether the tag value should be written synchronously or 
asynchronously. If the "Writemode" parameter is not used, writing is performed asynchronously 
as its default value.

During the writing process, no information is supplied on the status of the tags.

The "Value" property contains the value which was set before or during the writing operation, 
therefore is may not correspond to the real current value of the tag. If the data on the tag should 
be updated, use the Read method.
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Parameters Description
Value (optional) The tag value is specified. The specified value 

overwrites the value in the "Value" property in the 
tag object.
The tag value is not specified. The tag receives the 
current value from the "Value" property of the tag 
object.

Writemode (optional) 0 or empty: The tag value is written 
asynchronously. 0 is the default value.
1: The tag value is written synchronously.

On asynchronous writing, it is written immediately into the tag image. The user does not receive 
any feedback if the value has been written in the programmable controller, too.

In the case of synchronous writing (direct to the PLC), the writing operation actually occurs 
when the PLC is ready to operate. The use receives a check-back message if the writing 
operation was not successful.

Example
Asynchronous writing

 
'VBS104
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Value = 5
objTag.Write
MsgBox objTag.Value

 

or

 
'VBS105
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Write 5
MsgBox objTag.Value

 

Synchronous writing

 
'VBS106
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Value = 5
objTag.Write ,1
MsgBox objTag.Value
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or

 
'VBS107
Dim objTag
Set objTag = HMIRuntime.Tags("Var1")
objTag.Write 5, 1
MsgBox objTag.Value

Description of TagSet Object
The TagSet object offers the option of writing several tags in one call. 

Functionality here is mostly identical with that of a tag object. In the following, only deviations 
thereof are described. 

Expression
Necessary. An expression which returns an object of type "TagSet". 

Parameters
In order to write different values, the "Value" property of individual tag objects must be set, and 
write must be called thereafter without the "Value" parameter. Since the write commands are 
grouped into one call, it results in improved performance compared to single calls. 

In a TagSet object, it is not possible to pass on a value using the "Write" method. Individual 
values must be set using the "Value" property of the individual tag objects.

Example
The following example shows how tags are included in the TagSet list, how tag values are set 
and subsequently written.

 
'VBS173
Dim group
Set group = HMIRuntime.Tags.CreateTagSet
group.Add "Wert1"
group.Add "Wert2"
group("Wert1").Value = 3
group("Wert2").Value = 9
group.Write

 

If you set the optional parameter "Writemode" equal to 1, the process tags are written 
synchronously (directly to AS).
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group.Write 1

See also
Example of writing tag values (Page 4512)

WriteTags

Description     
Executes the "Write tags" button function of the recipe view.

Syntax
Expression.WriteTags()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
UserArchiveControl (Page 5167)

ZoomArea

Description     
Executes the "Zoom area" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ZoomArea()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -
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See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ZoomInOut

Description     
Executes the "Zoom +/-" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ZoomInOut()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)

ZoomInOutTime

Description     
Executes the "Zoom time axis +/-" button function of the f(t) trend view.

Syntax
Ausdruck.ZoomInOutTime()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -
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See also
OnlineTrendControl (Page 5083)

ZoomInOutValues

Description     
Executes the "Zoom value axis +/-" button function of the f(t) trend view.

Syntax
Ausdruck.ZoomInOutValues()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameter
- -

See also
OnlineTrendControl (Page 5083)

ZoomInOutX

Description     
Executes the "Zoom X axis +/-" button function of the f(x) trend view.

Syntax
Ausdruck.ZoomInOutX()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
FunctionTrendControl (Page 5038)
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ZoomInOutY

Description     
Executes the "Zoom Y axis +/-" button function of the f(x) trend view.

Syntax
Ausdruck.ZoomInOutY()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
FunctionTrendControl (Page 5038)

ZoomMove

Description   
Executes the "Move trend area" button function of the f(t) and f(x) trend views.

Syntax
Ausdruck.ZoomMove()

Expression
Necessary. An expression that returns an object of the "ScreenItem" type.

Parameters
- -

See also
OnlineTrendControl (Page 5083)

FunctionTrendControl (Page 5038)
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10.8.11.4 C scripting

System functions

ActivateNextScreen

Description
WinCC saves the names of the screens opened by the user during runtime as well as the 
sequence in which these screens were opened.   

Can only be used in C scripting.

The maximum size of the screen buffer is specified in the "Runtime settings > Screens > Screen 
buffer" editor.

The ActivateNextScreen system function now opens the screen that was opened before the 
last call of ActivatePreviousScreen.

Syntax
BOOL ActivateNextScreen();

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The ActivateNextScreen function is used in the following program code to call the next screen 
and to save the return value to the b_error tag. 

The saved return value can be processed in the following code.

 
{
BOOL b_error;
 
//Open next screen
b_error = ActivateNextScreen();
 
if(b_error) 
 {
   // User defined code if 
   // function succeeds without error 
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   ... 
 } 
 else 
 {
   // User defined code in case of error
   ... 
 } 
... 
}

ActivatePreviousScreen

Description
WinCC saves the names of the screens opened by the user during runtime as well as the 
sequence in which these screens were opened.   

The system function can be used in C scripting only.

The maximum size of the screen buffer is specified in the "Runtime settings > Screens > Screen 
buffer" editor.

The ActivatePreviousScreen system function now opens the screen which was open before 
the currently open screen.

Syntax
BOOL ActivatePreviousScreen();

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The ActivatePreviousScreen function is used in the following program code to call the previous 
screen and to save the return value to the b_error tag. 

The saved return value can be processed in the following code.

 
{
BOOL b_error;
 
//Open previous screen
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b_error = ActivatePreviousScreen();
 
if(b_error) 
 {
   // User defined code if 
   // function succeeds without error 
   ... 
 } 
 else 
 {
   // User defined code in case of error
   ... 
 } 
... 
}

ActivateScreen

Description
Performs a screen change to the given screen.       

Use the "ActivateScreenByNumber" system function to change from the root screen to the 
permanent window or vice versa. 

Use in the function list
ActivateScreen (Screen name, Object number)

Use in user-defined functions
ActivateScreen (Screen_name, Object_number)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Screen name
Name of the screen to which you change.

Object number
The operator control element which receives the focus in the given screen after the screen 
change. The number of the operator control element is to be determined using the tabulator 
sequence during configuration.

When "0" is specified:
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● If the focus is in the permanent window when the system function is called up, the 
permanent window maintains the focus.

● If the focus is in the root screen when the system function is called up, the first operator 
control element in the given screen receives the focus.

 

  Note

If the "Reach margin" event is assigned to the "ActivateScreen" system function, only the 
value "0" is valid for the "Object number" parameter. The active object is not defined by 
the object number, but rather by the X position it had prior to the screen change.

 

Example
The ActivateScreen function is used in the following program code to activate the "Screen_2" 
screen when you click a button.

 
 
{
 
// User defined code 
// i.e. when pressing a button 
ActivateScreen ("Screen_2", 0);
...
}

See also
System functions for Runtime Professional (Page 4564)

ActivateScreenInScreenWindow

Description
Performs a screen change to the specified screen in a specified screen window.       

Use in the function list
ActivateScreenInScreenWindow (Screen name, Screen window, New screen name)

Use in user-defined functions
ActivateScreenInScreenWindow (Screen_name, Screen_window, New_screen_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Screen name
Name of the screen to be displayed in the screen window. 

Screen window
Name of the screen window in which the new screen is to be displayed.

New screen name
Name of the new screen to be displayed in the screen window. 

Example
The ActivateScreenInScreenWindow function is used in the following program code to activate 
the "Screen_2" screen when you click a button.

 
{
// User defined code 
// i.e. when pressing a button 
ActivateScreenInScreenWindow (GetParentScreen(screenName), 
GetParentScreenWindow(screenName), "Screen_2");
...
}

See also
System functions for Runtime Professional (Page 4564)

Example of configuring a screen change via a property (Page 4526)

ActivateStartScreen

Description
Opens the configured start screen.   

Can only be used in C scripting.

Syntax
BOOL ActivateStartScreen();

Return value

TRUE
System function completed without errors.
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FALSE
An error has occurred.

Example
The ActivateStartScreen function is used in the following program code to call the configured 
start screen and to save the return value to the b_error tag. 

The saved return value can be processed in the following code.

 
{
BOOL b_error;
 
//Open start screen
b_error = ActivateStartScreen();
 
if(b_error) 
 {
   // User defined code if 
   // function succeeds without error 
   ... 
 } 
 else 
 {
   // User defined code in case of error
   ... 
 } 
... 
}

ActivateStoredScreen

Description
Opens the screen saved with the StoreScreen system function.   

Can only be used in C scripting.

Syntax
BOOL ActivateStoredScreen();

Return value

TRUE
System function completed without errors.

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5900 System Manual, 02/2014



FALSE
An error has occurred.

Example
The ActivateStoredScreen function is used in the following program code to call the stored 
screen and to save the return value to the b_error tag. 

The saved return value can be processed in the following code.

 
{
BOOL b_error;
 
//Open stored screen
b_error = ActivateStoredScreen();
 
if(b_error) 
 {
   // User defined code if 
   // function succeeds without error 
   ... 
 } 
 else 
 {
   // User defined code in case of error
   ... 
 } 
... 
}

See also
StoreScreen  (Page 5997)

DecreaseTag

Description
Subtracts the given value from the tag value.       

X = X - a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.
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If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode. 

Use in the function list
DecreaseTag (Tag, Value)

Use in user-defined functions
DecreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag
The tag from which the given value is subtracted.

Value
The value which is subtracted.

Example
The following program code decrements the value at the varX tag by the value at the value 
tag. The value entered is saved to the old_value tag and output along with the new varX value.

 
{
BYTE varX;
BYTE value;
 
//user input
...
BYTE old_value = varX;
 
//Decrease tag
DecreaseTag(varX, value);
 
//print original value and function result   
printf ("User input: %i\r\n, Result of function DecreaseTag: %i\r\n", old_value, varX);
...
}

See also
System functions for Runtime Professional (Page 4564)
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GetLocalScreen

Description
Returns a pointer to the screen name. 

Can only be used in C scripting.

Syntax
char* GetLocalScreen(char* Screen name);   

Parameters

Screen name
Pointer to the name of the screen.

Return value
Pointer to the name of the screen.

 

 Note

The syntax of the transferred call parameter Screen name must correspond to that formed 
by the graphics system for the screen paths:

<Screen_name>.<Screen_window_name>:<Screen_name>.<Screen_window_name>:<Scr
een_name>...

 

Principle
A "Screen_A" contains a "Screen_window_B". Another screen is called in the screen window 
and visualized as minimized image, etc.

Calling screens in the screen windows
1. "Screen_window_B" displays "Screen_C".

"Screen_C" contains "Screen_window_D".

2. "Screen_window_D" displays "Screen_E".

Pointer to the screen name
returns system function GetLocalScreen(Screen name) in the next step with the following 
values:

● "Screen_E", if the system function is called in "Screen_E"

● "Screen_C", if the system function is called in "Screen_C"

● "Screen_A", if the system function is called in "Screen_A"
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Example
The following program code saves the return value of the function GetLocalScreen to the 
pszScrName tag. If the return value is valid (not NULL), it is saved with maximum_MAX_PATH 
characters to the szScrName tag.

 
{
char* pszScrName = NULL;
char szScrName[_MAX_PATH+1];
 
//Get the Local Screen
pszScrName = GetLocalScreen(lpszScreenName);
 
//Copy the string
if (pszScrName != NULL)
 {
   strncpy(szScrName,pszScrName,_MAX_PATH);
// print local screen name 
   printf ("Local screen name: %s\r\n", szScrName);
 }
...
}

GetLinkedTag

Description
Returns the name of the tag which is logically linked to the specified object property.   

Can only be used in C scripting.

Syntax
char* GetLinkedTag(char* Screen Name, char* Object, char* Name of Property);

Parameters

Screen Name
Pointer to the name of the screen.

Object
Pointer to the name of the object.

Name of Property
Pointer to the name of the object property.
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Return value
Pointer to the name of the tag which is logically linked to the specified object property.

Example
The following program code reads a tag link and fills the transferred linkinfo structure with 
information from the tag link.

 
{
LINKINFO linkinfo;
 
//Get the linked Tag
GetLinkedTag(lpszScreenName,"Bar1","Process",&linkinfo);
 
// linkinfo.szLinkName is the tag name
// linkinfo.dwCycle is the update cycle
// linkinfo.LinkType is the type of the connection
 
 
//User defined code where the
//user can do something with the returnvalue
...
}

The saved return value can be processed in the following code.

GetLanguageByLocaleID

Description
Determines the current Runtime language.

Can only be used in C scripting.

Syntax
DWORD GetLanguageByLocaleID ();   

Return value
Language ID.

The following assignments apply (hexadecimal language code):

Symbolic name Value(hexadecimal
)

Abbreviation

LANG_ARABIC 0x0401  
LANG_AFRIKAANS 0x0436  
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Symbolic name Value(hexadecimal
)

Abbreviation

LANG_ALBANIAN 0x041C  
LANG_BASQUE 0x042D  
LANG_BULGARIAN 0x0402  
LANG_BYELORUSSIAN 0x0423  
LANG_CATALAN 0x0403  
LANG_CHINESE 0x0404  
LANG_CROATIAN 0x041A  
LANG_CZECH 0x0405 CSY
LANG_DANISH 0x0406 DAN
LANG_DUTCH 0x0413 NLD
LANG_ENGLISH 0x0409 ENU
LANG_ESTONIAN 0x0425  
LANG_FAEROESE 0x0438  
LANG_FARSI 0x0429  
LANG_FINNISH 0x040B FIN
LANG_FRENCH 0x040C FRA
LANG_GERMAN 0x0407 DEU
LANG_GREEK 0x0408  
LANG_HEBREW 0x040D  
LANG_HUNGARIAN 0x040E HUN
LANG_ICELANDIC 0x040F ISL
LANG_INDONESIAN 0x0421  
LANG_ITALIAN 0x0410 ITA
LANG_JAPANESE 0x0411  
LANG_KOREAN 0x0412  
LANG_LATVIAN 0x0426  
LANG_LITHUANIAN 0x0427  
LANG_NORWEGIAN 0x0414 NOR
LANG_POLISH 0x0415 PLK
LANG_PORTUGUESE 0x0416 PTB
LANG_ROMANIAN 0x0418  
LANG_RUSSIAN 0x0419 RUS
LANG_SLOVAK 0x041B SKY
LANG_SLOVENIAN 0x0424  
LANG_SORBIAN 0x042E  
LANG_SPANISH 0x040A ESP
LANG_SWEDISH 0x041D SVE
LANG_THAI 0x041E  
LANG_TURKISH 0x041F TRK
LANG_UKRAINIAN 0x0422  

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5906 System Manual, 02/2014



Example
The following program code reads out the current Runtime language and saves the return 
value in the rt_language tag. 

The saved return value can be processed in the following code (in this case, with printf output).

 
{
DWORD rt_language;
 
//Get the current language
rt_language = GetLanguageByLocaleID ();
 
//print language code 
printf ("Language code: %d\r\n", rt_language);
...
}

GetParentScreen

Description
Returns a pointer to the screen name. 

Can only be used in C scripting.

Syntax
char* GetParentScreen(char* Screen name);   

Parameters

Screen name
Pointer to the name of the screen.

Return value
Name of the current screen if the system function is called in a screen.
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Name path of the higher-level screen if the system function is called in a screen window.
 

 Note

The syntax of the transferred call parameter Screen name must correspond to that formed 
by the graphics system for the screen paths:

<Screen_name>.<Screen_window_name>:<Screen_name>.<Screen_window_name>:<Scr
een_name>...

The characters ":" and "." are used exclusively for the syntax. In names, only "-" and "_" should 
therefore be used as separators.

 

Example
The following program code saves the return value of function GetParentScreen to the 
pszScrName tag. If the return value is valid (not NULL), it is saved with maximum_MAX_PATH 
characters to the szScrName tag.

 
{
char* pszScrName = NULL;
char szScrName[_MAX_PATH+1];
 
//Get the Parent Screen
pszScrName = GetParentScreen(lpszScreenName);
 
//Copy the string
if (pszScrName != NULL)
 {
   strncpy(szScrName,pszScrName,_MAX_PATH);
// print Screen name 
   printf ("Screen name: %s\r\n", szScrName);
 }
...
}

GetParentScreenWindow

Description
Provides a pointer to the name of the screen window.

Can only be used in C scripting.

Syntax
char* GetParentScreenWindow(char* Screen name);   
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Parameters

Screen name
Pointer to the name of the screen.

Return value
Pointer to the name of the screen window if the system function is called in a screen which is 
displayed in the screen window of a parent screen.

The unchanged call parameter "Screen name" if the system function is called in a screen.
 

 Note

The syntax of the transferred call parameter Screen name must correspond to that formed 
by the graphics system for the screen paths:

<Screen_name>.<Screen_window_name>:<Screen_name>.<Screen_window_name>:<Scr
een_name>...

The characters ":" and "." are used exclusively for the syntax. In names, only "-" and "_" should 
therefore be used as separators.

 

Principle
"Screen_1" contains a "Screen_window_1". Another screen is called in the screen window and 
visualized as minimized image, etc.

Calling screens in the screen windows
1. "Screen_window_1" displays "Screen_2".

"Screen_2" contains "Screen_window_2".

2. "Screen_window_2" displays "Screen_3".

Pointer to the screen window name
returns system function GetParentScreenWindow(Screen name) in the next step with 
the following values:

● "Screen_2", if the system function is called in "Screen_3"

● "Screen_window_1", if the system function is called in "Screen_2"

● "Screen_1", if the system function is called in "Screen_1".

Example
The following program code saves the return value of the function GetParentScreenWindow 
to the pszScrName tag. If the return value is valid (not NULL), it is saved with 
maximum_MAX_PATH characters to the szScrName tag.

 
{
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char* pszScrName = NULL;
char szScrName[_MAX_PATH+1];
 
//Get the Parent Screen Window
pszScrName = GetParentScreenWindow(lpszScreenName);
 
//Copy the string
if (pszScrName != NULL)
 {
   strncpy(szScrName,pszScrName,_MAX_PATH);
// print name of the parent screen window 
   printf ("Parent screen window: %s\r\n", szScrName);
 }
...
}

GetProp

GetPropBOOL 

Description
Returns the current status of a property of data type "BOOL". 

Can only be used in C scripting.

Syntax
BOOL GetPropBOOL(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property
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Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The following program code reads out whether the object is visible or not. The value is saved 
to the b_error tag.

 
{
BOOL b_error;
 
//Get the property Visible
b_error = GetPropBOOL("gs_graph_iofield","IOField1","Visible");
 
if(b_error)
{
  // User defined code if the
  // object is visible
  ...
}
else
{
  // User defined code if the
  // object is not visible
  ...
}
}

A specific code is processed, depending on the return value.

GetPropChar

Description
Returns the value of a property of data type "Char". 

Can only be used in C scripting.

Syntax
Char* GetPropChar(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)   
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Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property

Return value
Value of the property in data type "Char".

Example
The following program code reads the tooltip text from the object using the GetPropChar 
function and processes it as follows:

1. Saves the return value in the pszProp tag

2. Validation of the return value: Step 3 follows if the value is valid (not NULL).

3. The first 13 characters of the character sequence are saved in the szProp tag.

 
{
char* pszProp = NULL;
char szProp[14];
 
//Get the property Tooltiptext
pszProp = GetPropChar("lpszScreenName","IOField1","Tooltiptext");
 
if(pszProp != NULL)
 {
//Copy the string and trim
   strncpy(szProp,pszProp,13);
// print trimmed string
   printf ("Short description of tooltip: %s\r\n", szProp);
 }
...
}

The saved return value can be processed in the following code.
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GetPropDouble

Description
Returns the value of a property of data type "Double". 

Can only be used in C scripting.

Syntax
double GetPropDouble(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property

Return value
Value of the property in data type "Double".

Example
The following program code reads the "BackColor" property (background color of the 
"Button_1" object) by means of GetPropDouble function and processes the return value as 
follows:

1. Saving the return value to the szprop tag

2. Validation of the return value: Step 3 follows if the value is valid (not NULL).

3. Output of the background color

 
{
double szProp = NULL;
 
//Get the property of the IO Field 1
szprop = GetPropDouble("Screen_1","Button_1","BackColor");
 
if(szProp != NULL)
  {
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// print output value
     printf ("Background color: %s\r\n", szProp);}
  }
...
}

GetPropLong

Description
Returns the status of a property of data type "long". 

Can only be used in C scripting.

Syntax
long GetPropLong(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property

Return value
Value of the property in data type "long".

Example
The following program code reads the CaptionBackColor property (background color of the 
TemperatureField object) by means of GetPropLong function and processes the return value 
as follows:

1. Saving the return value to the szProp tag

2. Validation of the return value: Step 3 follows if the value is valid (not NULL).

3. Output
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{
long szProp = NULL;
 
//Get the property Tooltiptext
szProp = GetPropLong("Screen_1","TemperatureField","CaptionBackColor");
 
if(szProp != NULL)
 {
// print caption
   printf ("Caption of window: %d\r\n", szProp);
 }
...
}

The saved return value can be processed in the following code.

GetServerTagPrefix

Description
In order for a WinCC client in a distributed system to access tags of the associated server, the 
tag names must be expanded to include the server prefix.

 

 Note

This system function is not supported at present.
 

A pointer of type "char" to server prefix, tag prefix, and window prefix is returned in each case.

The user is not permitted to change the memory (including no strcat) or release it.

Can only be used in C scripting.

Syntax
void GetServerTagPrefix (char** ppszServerPrefix, char** ppszTagPrefix, char** 
ppszWindowPrefix);

Return value

ppszServerPrefix
Pointer to a pointer that references the server prefix

ppszTagPrefix
Pointer to a pointer that references the tag prefix

ppszWindowPrefix
Pointer to a pointer that references the window prefix 
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Example
The following program code retrieves the server prefix, tag prefix and window prefix checks 
their validity. If an error occurs, a text is output and the function is exited. If the check is 
successful a tag name is created and returned. Processing is executed as follows:

1. Declaration of pointer pszServerPrefix, pszTagPrefix and pszWindowPrefix for the three 
prefixes

2. Initialization of the nServerPrefixLen, nTagPrefixLen and nTagLen tags 
They serve as a buffer for the string length of the prefixes to be read out.

3. Initialization of the myTagName tag

4. Reading out of server prefix, tag prefix and window prefix

5. Case distinction: Server prefix

– No server prefix returned: a text is output and the function is exited.

– Server prefix returned: Its length is determined and saved in the nServerPrefixLen tag.

6. If a tag prefix is returned, its length is determined and saved in the nTagPrefixLen tag.

7. Determines the length of the tag name and saves it in the nTagLen tag.

8. Case distinction: Permissible length for tag name

– Permissible length exceeded: a text is output and the function is exited.

– Permissible length not exceeded: The tag name required for a client environment is 
compiled.

 
{
char* pszServerPrefix;
char* pszTagPrefix;
char* pszWindowPrefix;
int nServerPrefixLen = 0;
int nTagPrefixLen = 0;
int nTagLen = 0;
char myTagName[MAX_DM_VAR_NAME+1];
 
//Initialize the return value
memset(myTagName,0,MAX_DM_VAR_NAME + 1);
 
//Get the serverprefix the tagprefix and the windowprefix
GetServerTagPrefix(&pszServerPrefix, &pszTagPrefix, &pszWindowPrefix);
 
//If a serverprefix exists
if (pszServerPrefix)
{
  //Get the length of the string
  nServerPrefixLen = strlen(pszServerPrefix);
}
Else
{
  printf("No server prefix was returned.");
  return;
}
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//If a tagprefix exists
if (pszTagPrefix)
{
  //Get the length of the string
  nTagPrefixLen = strlen(pszTagPrefix);
}
 
//Get the length of the tag
nTagLen = strlen("TagName");
 
//Check if the lenght of the
//ServerPrefix+TagPrefix+VarName + the double points < MAX_DM_VAR_NAME)
if (nServerPrefixLen + nTagPrefixLen + nTagLen+2 < MAX_DM_VAR_NAME)
{
  sprintf(myTagName,"%s::%s%s",pszServerPrefix,pszTagPrefix,"TagName");
  //User defined code where the
  //user can do something with the returnvalue
  ...
}
Else
{
  printf("The resulting string is too long.");
  return;
}
}

GetTag

GetTag functions

Description
The GetTagXXX function calculates the value of a tag of the specified data type. 

Can only be used in C scripting:

The following table shows the different GetTag functions for reading the tag value:

Type Function name Parameters PLC data type HMI data 
type

BOOL GetTagBit   Tag Tag_Name Binary tag Bool
BYTE GetTagByte   Tag Tag_Name Unsigned 8-bit USInt
char* GetTagChar   Tag Tag_Name Text tag 8-bit or 

text tag 16-bit
String or
WString 
 
 

double GetTagDouble   Tag Tag_Name Floating point 64-bit LReal
DWORD GetTagDWord   Tag Tag_Name Unsigned 32-bit UDInt
float GetTagFloat   Tag Tag_Name Floating point 32-bit Real
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Type Function name Parameters PLC data type HMI data 
type

BOOL GetTagRaw   Tag Tag_Name, 
BYTE* pValue, 
DWORD size

Raw data type Raw

signed char GetTagSByte   Tag Tag_Name Signed 8-bit SInt
long int GetTagSDWord   Tag Tag_Name Signed 32-bit DInt
short int GetTagSWord   Tag Tag_Name Signed 16-bit Int
WORD GetTagWord   Tag Tag_Name Unsigned 16-bit UInt

Syntax
<Type><FunctionName><(Parameter)>;

Example: BYTE GetTagByte (Tag Tag_Name);

Parameters

Tag_Name
Tag name

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value
Value of the tags in the specified type.

System function "GetTagChar" returns a pointer to a string that contains the tag value. 

System function "GetTagRaw" returns TRUE or FALSE:

TRUE: System function completed without errors.

FALSE: An error has occurred.

Example
The following program code uses the GetTagByte function to read out the value of the 
gs_tag_byte tag and saves it to the bvalue tag.

 
{
BYTE bvalue;
 
//Get the current value of the tag
bvalue = GetTagByte("gs_tag_byte");
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// print value
   printf ("Value of gs_tag_byte: %d\r\n", bvalue);
...
}

The saved return value can be processed in the following code.

See also
Data types (Page 3750)

Access to HMI tags (Page 4445)

GetTagMultiStateQCWait functions

Description
The values, status, and quality code of several tags are established and saved in the repsective 
addresses in the specified format . The values are read explicitly from the AS.

Two DWORD arrays are transferred, in the member of which the status and quality codes of 
the individual tags will be located after the system function has been called. The size of the 
arrays must be large enough to provide sufficient storage space for the status and quality 
codes.   

Can only be used in C scripting.

Syntax
BOOL GetTagMultiStateQCWait (DWORD* pdwState, DWORD* pdwQualityCode, const 
char* pFormat, ...);

Parameters

pdwState
Field in which the status of the individual tags is created after the system function cycle.

pdwQualityCode
Field in which the quality code of the individual tag is created after the system function cycle.

pFormat
Format description (type) for all requested tags, followed by the name and address of the value 
for each tag.
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Return value

TRUE
System function completed without errors.

FALSE
An error has occurred. 

Example
The following program code uses the GetTagMultiStateQCWait function to read the value from 
the "gs_tag_XXX" tag and saves these values to the Ivalue1,  Ivalue2 tags, etc.

1. Preprocessor definition for "DATA_SIZE" (in this case for 5 tags)

2. Creating the DWord fields

– dwState  Tag status field

– dwQc  Field for quality codes

3. Tag definition for buffering

4. Execution of the function GetTagMultiStateQCWait 
The value read is written to the addresses of the tags.

 
{
#define DATA_SIZE 5
DWORD dwState[DATA_SIZE];
DWORD dwQC[DATA_SIZE];

//define all Datas
BOOL lValue1;
long lValue2 ;
char* szValue3;
double dblValue4 ;
WORD lValue5 ;
 
 
//Set the tags
GetTagMultiStateQCWait(dwState,dwQC,"%d%d%s%f%d",
  "gs_tag_bit",&lValue1,
  "gs_tag_SByte",&lValue2,
  "gs_tag_char",&szValue3,
  "gs_tag_float",&dblValue4,
  "gs_tag_word",&lValue5);
 
//User defined code where the
//user can do something with the returnvalue
...
}

The saved return value can be processed in the following code.
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GetTagMultiStateWait functions

Description
The values and status of several tags are determined and saved in the respective addresses 
in the specified format. The values are read explicitly from the AS. 

The system function must be given a DWORD array, in the member of which the status of the 
individual tags will be located after the system function has been called. The size of the array 
must be large enough to provide sufficient storage space for the status.   

Can only be used in C scripting.

Syntax
BOOL GetTagMultiStateWait(DWORD* pdwState, const char* pFormat);

Parameters

pdwState
Field in which the tag status is saved.

pFormat
Format description (type) for all requested tags, followed by the name and address of the value 
for each tag.

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The following program code uses the GetTagMultiStateWait function to read the value from 
the "gs_tag_XXX" tag and saves these values to the Ivalue1,  Ivalue2 tags, etc.

1. Preprocessor definition for "DATA_SIZE" (in this case for 5 tags)

2. Creating DWord field dwState for the tag status

3. Tag definition for buffering

4. Execution of the function GetTagMultiStateWait 
The value read is written to the addresses of the tags.

 
{
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#define DATA_SIZE 5
DWORD dwState[DATA_SIZE];

//define all Datas
BOOL lValue1;
long lValue2 ;
char* szValue3;
double dblValue4 ;
WORD lValue5 ;
 
 
//Set the tags
GetTagMultiStateWait(dwState,"%d%d%s%f%d",
  "gs_tag_bit",&lValue1,
  "gs_tag_SByte",&lValue2,
  "gs_tag_char",&szValue3,
  "gs_tag_float",&dblValue4,
  "gs_tag_word",&lValue5);
 
//User defined code where the
//user can do something with the returnvalue
...
}

The saved return value can be processed in the following code.

GetTagMultiWait functions

Description
The values of several tags are determined and saved in the respective addresses in the 
specified format. The value is read explicitly from the AS. The system function uses SysMalloc 
to allocate memory to the tag value.   

Can only be used in C scripting.

Syntax
BOOL GetTagMultiWait(const char* pFormat,...);

Parameters

pFormat
Format description for all requested tags along with name and address of the value for each 
tag.
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Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The GetTagMultiWait function is used in the following program code to read several tags of 
different types:

1. Declaration of three tags as memory for three different tag types

2. Declaration of the boolean tag ok for buffering the return value (TRUE/FALSE)

3. Reading the three tags and saving the values to the corresponding addresses. 
The return value of the function is saved to the ok tag.

4. Output of the three tags with tag type prefix

 
DWORD dwVar1Value;
char* szVar2Value; 
//memory for values allocated via SysMalloc 
 
double dbVar3Value;
 
BOOL ok;
 
ok=GetTagMultiWait("%d%s%f", "Ernie_word", &dwVar1Value,
  "Ernie_char", &szVar2Value,
  "Ernie_double", &dbVar3Value);
 
printf("Word %d, String %s, Double %f\r\n",
  dwVar1Value, szVar2Value, dbVar3Value);

GetTagState functions

Description
The GetTagStateXXX function calculates the value of a tag of the specified data type. It also 
returns the status of the tags.

Can only be used in C scripting.

The following table lists the different GetTagStateXXX functions for reading the tag value: 
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Type Function name Parameters PLC data type HMI data 
type

BOOL GetTagBitState   Tag Tag_Name, 
PDWORD lp_dwstate

Binary tag Bool

BYTE GetTagByteState   Tag Tag_Name, 
PDWORD lp_dwstate

Unsigned 8-bit Byte

char* GetTagCharState   Tag Tag_Name, 
PDWORD lp_dwstate

Text tag 8-bit or text tag 16-
bit

String

double GetTagDoubleState 
  

Tag Tag_Name, 
PDWORD lp_dwstate

Floating point 64-bit Double

DWORD GetTagDWordState  
 

Tag Tag_Name, 
PDWORD lp_dwstate

Unsigned 32-bit UInteger

float GetTagFloatState   Tag Tag_Name, 
PDWORD lp_dwstate

Floating point 32-bit Float

BOOL GetTagRawState   Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw

signed 
char

GetTagSByteState   Tag Tag_Name, 
PDWORD lp_dwstate

Signed 8-bit Byte

long int GetTagSDWordStat
e   

Tag Tag_Name, 
PDWORD lp_dwstate

Signed 32-bit Integer

short int GetTagSWordState  
 

Tag Tag_Name, 
PDWORD lp_dwstate

Signed 16-bit Short

WORD GetTagWordState   Tag Tag_Name, 
PDWORD lp_dwstate

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BOOL GetTagBitState (Tag Tag_Name, PDWORD lp_dwstate);

Parameters

Tag_Name
Tag name

lp_dwstate
Pointer to a DWORD to which the tag status is saved on completion of the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes
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Return value
Value of the tags in the specified type.

The system function "GetTagCharState" returns a pointer to a value of the tag of data type 
"char". 

System function "GetTagRawState" returns TRUE or FALSE:

TRUE: System function completed without errors.

FALSE: An error has occurred.

Example
The following program code uses the GetTagBitState function to read out the value of the 
gs_tag_bit tag and saves it to the bValue tag.

The status is stored in the address of the dwState tag.

A specific code will be executed, depending on the return value in bValue (TRUE/FALSE).

 
{
DWORD dwState;
BOOL bValue;
 
dwState = 0xFFFFFFFF;
 
//Get the tag value
//dwstate is the tag state
bValue = GetTagBitState("gs_tag_bit",&dwState);
 
//Create a string which includes the tag value
if (bValue)
{
  // User defined code if the
  // value of the tag is true
  ...
}
else
{
  // User defined code if the
  // value of the tag is false
  ...
}
}

See also
Data types (Page 3750)
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GetTagStateQC functions

Description
The GetTagStateQC function calculates the value of a tag of the specified data type. It also 
returns the status and quality code of the tags.

Can only be used in C scripting.

The following table shows the different GetTagStateQC functions for reading the tag value: 

Type Function name Parameters PLC data type HMI data type
BOOL GetTagBitStateQC   Tag Tag_Name, 

PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Binary tag Bool

BYTE GetTagByteStateQC  
 

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 8-bit UByte

char* GetTagCharStateQC 
  

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Text tag 8-bit or text tag 
16-bit

String

double GetTagDoubleStateQ
C   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Floating point 64-bit Double

DWO
RD

GetTagDWordStateQ
C   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 32-bit UInteger

float GetTagFloatStateQC 
  

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Floating point 32-bit Float

BOOL GetTagRawStateQC  
 

Tag Tag_Name, BYTE 
pValue[], DWORD size, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Raw data type Raw

signed 
char

GetTagSByteStateQ
C   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 8-bit Byte

long int GetTagSDWordState
QC   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 32-bit Integer
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Type Function name Parameters PLC data type HMI data type
short 
int

GetTagSWordStateQ
C   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 16-bit Short

WOR
D

GetTagWordStateQC
   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BOOL GetTagBitStateQC (Tag Tag_Name, PDWORD lp_dwstate, PDWORD 
pdwQualityCode);

Parameters

Tag_Name
Tag name

lp_dwstate
Pointer to a DWORD to which the tag status is saved on completion of the system function 
cycle.

pdwQualityCode
Pointer on a DWORD in which the quality code of the tag is created after the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharStateQC" returns a pointer to a value of the tag of data type 
"char". 

The system function "GetTagRawStateQC" returns TRUE or FALSE:

TRUE: System function completed without errors.

FALSE: An error has occurred.
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Example
The following program code uses the GetTagBitStateQC function to read the value from the 
gs_tag_bit tag and saves it to the ok tag.

The status and quality code is saved to the dwState and dwQC addresses of the tag.

The return value of the ok tag (TRUE/FALSE) determines the specific code that is executed.

 
{
DWORD dwState;
DWORD dwQC;
BOOL ok;
 
dwState = 0xFFFFFFFF;
 
//Get the tag value
//dwstate is the tag state
ok = GetTagBitStateQC("gs_tag_bit",&dwState,&dwQC);
 
//Create a string which includes the tag value
if (ok)
{
  // succeeded, print tag value
   printf ("Value at &dwState,&dwQC: %d\r\n", &dwState);
   printf ("Value at &dwQC: %d\r\n", &dwQC);
  ...
}
else
{
  // failed
  printf ( "Error - function failed." );
}
}

See also
Data types (Page 3750)

GetTagStateQCWait functions

Description
The GetTagStateQCWait function calculates the value of a tag of the specified data type. The 
value is read explicitly from the AS. It also returns the status and quality code of the tags.

Can only be used in C scripting.

The following table lists the different GetTagStateQCWait functions for reading the tag value:
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Type Function name Parameters PLC data type HMI data 
type

BOOL GetTagBitStateQCWait   Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Binary tag Bool

BYTE GetTagByteStateQCWai
t   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 8-bit UByte

char* GetTagCharStateQCWa
it   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Text tag 8-bit or text tag 16-
bit

String

double GetTagDoubleStateQC
Wait   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Floating point 64-bit Double

DWOR
D

GetTagDWordStateQC
Wait   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 32-bit UInteger

float GetTagFloatStateQCWa
it   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Floating point 32-bit Float

BOOL GetTagRawStateQCWai
t   

Tag Tag_Name, BYTE 
pValue[], DWORD size, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Raw data type Raw

signed 
char

GetTagSByteStateQCW
ait   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 8-bit Byte

long int GetTagSDWordStateQ
CWait   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 32-bit Integer

short 
int

GetTagSWordStateQC
Wait   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Signed 16-bit Short

WORD GetTagWordStateQCW
ait   

Tag Tag_Name, 
PDWORD lp_dwstate, 
PDWORD 
pdwQualityCode

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;
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Example: BOOL GetTagBitStateQC (Tag Tag_Name, PDWORD lp_dwstate, PDWORD 
pdwQualityCode);

Parameters

Tag_Name
Tag name

lp_dwstate
Pointer to a DWORD to which the tag status is saved on completion of the system function 
cycle.

pdwQualityCode
Pointer on a DWORD in which the quality code of the tag is created after the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharStateQCWait" returns a pointer to a value of the tag of data 
type "char". 

The system function "GetTagRawStateQCWait" returns TRUE or FALSE: 

TRUE: System function completed without errors.

FALSE: An error has occurred.

Example
The following program code uses the GetTagBitStateQCWait function to read the value from 
the gs_tag_bit tag and saves it to the bValue tag.

The status and quality code is saved to the dwState and dwQC addresses of the tag.

A specific code will be executed, depending on the return value in bValue (TRUE/FALSE).

 
{
DWORD dwState;
DWORD dwQC;
BOOL bValue;
 
dwState = 0xFFFFFFFF;
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//Get the tag value
//dwstate is the tag state
bValue = GetTagBitStateQCWait("gs_tag_bit",&dwState,&dwQC);
 
//Create a string which includes the tag value
if (bValue)
{
  // User defined code if the
  // value of the tag is true
  ...
}
else
{
  // User defined code if the
  // value of the tag is false
  ...
}
}

See also
Data types (Page 3750)

GetTagStateWait functions

Description
The GetTagStateWait function calculates the value of a tag of the specified data type. The 
value is read explicitly from the AS. It also returns the status of the tags.

Can only be used in C scripting.

The following table lists the different GetTagStateWait functions for reading the tag value: 

Type Function name Parameters PLC data type HMI data 
type

BOOL GetTagBitStateWait   Tag Tag_Name, PDWORD 
lp_dwstate

Binary tag Bool

BYTE GetTagByteStateWait  
 

Tag Tag_Name, PDWORD 
lp_dwstate

Unsigned 8-bit UByte

char* GetTagCharStateWait 
  

Tag Tag_Name, PDWORD 
lp_dwstate

Text tag 8-bit or 
text tag 16-bit

String

double GetTagDoubleStateW
ait   

Tag Tag_Name, PDWORD 
lp_dwstate

Floating point 64-
bit

Double

DWORD GetTagDWordStateW
ait   

Tag Tag_Name, PDWORD 
lp_dwstate

Unsigned 32-bit UInteger

float GetTagFloatStateWait 
  

Tag Tag_Name, PDWORD 
lp_dwstate

Floating point 32-
bit

Float
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Type Function name Parameters PLC data type HMI data 
type

BOOL GetTagRawStateWait  
 

Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw

signed char GetTagSByteStateWai
t   

Tag Tag_Name, PDWORD 
lp_dwstate

Signed 8-bit Byte

long int GetTagSDWordState
Wait   

Tag Tag_Name, PDWORD 
lp_dwstate

Signed 32-bit Integer

short int GetTagSWordStateW
ait   

Tag Tag_Name, PDWORD 
lp_dwstate

Signed 16-bit Short

WORD GetTagWordStateWait
   

Tag Tag_Name, PDWORD 
lp_dwstate

Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>

Example: BOOL GetTagBitStateWait (Tag Tag_Name, PDWORD lp_dwstate)

Parameters

Tag_Name
Tag name

lp_dwstate
Pointer to a DWORD to which the tag status is saved on completion of the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value
Value of the tags in the specified type.

The system function "GetTagCharStateWait" returns a pointer to a value of the tag of data type 
"char". 

The system function "GetTagRawState" returns TRUE or FALSE: 

TRUE: System function completed without errors.

FALSE: An error has occurred.
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Example
The following program code uses the GetTagBitStateWait function to read the value from the 
gs_tag_bit tag and saves it to the bValue tag.

The status is stored in the address of the dwState tag.

A specific code will be executed, depending on the return value in bValue (TRUE/FALSE).

 
{
DWORD dwState;
BOOL bValue;
 
dwState = 0xFFFFFFFF;
 
//Get the tag value
//dwstate is the tag state
bValue = GetTagBitStateWait("gs_tag_bit",&dwState);
 
//Create a string which includes the tag value
if (bValue)
{
  // User defined code if the
  // value of the tag is true
  ...
}
else
{
  // User defined code if the
  // value of the tag is false
  ...
}
}

See also
Data types (Page 3750)

GetTagValue functions

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value.   

Can only be used in C scripting.

Syntax
BOOL GetTagValue(LPDM_VARKEY lpdmVarKey, LPDM_VAR_UPDATE_STRUCT 
lpdmresult, LPCMN_ERROR lpdmError);
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Parameters

lpdmVarKey
Pointer to a structure of data type "DM_VARKEY"

lpdmresult
Pointer to a structure of data type "DM_VAR_UPDATE_STRUCT"

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The GetTagValue function is used in the following program code to calculate the value in 
varKey.

A specific code will be executed, depending on the return value in keyFound (TRUE/FALSE).

 
{
DM_VARKEY varKey;
DM_VAR_UPDATE_STRUCT result;
CMN_ERROR error:
 
BOOL keyFound;
 
//Get the tag value
keyFound = GetTagValue(&varKey, &result, &error);
 
if (keyFound)
{
  // print tag value
   printf ("Value of varKey: %d\r\n", &varKey);
  ...
}
else
{
  // failed
  printf ( "Error - function failed." );
  ...
}
}
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GetTagValueStateQC functions

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value. It also returns the status and quality code of the tags.   

The system function can be used in C scripting only.

Syntax
BOOL GetTagValueStateQC (LPDM_VARKEY lpdmVarKey, 
LPDM_VAR_UPDATE_STRUCTEX lpdmresult, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer to a structure of data type "DM_VARKEY"

lpdmresult
Pointer to a structure of data type "DM_VAR_UPDATE_STRUCTEX"

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The GetTagValueStateQC function is used in the following program code to calculate the value 
in varKey.

The status and quality code is saved to the dwState and dwQC addresses of the tag.

A specific code will be executed, depending on the return value in keyFound (TRUE/FALSE).

 
{
DM_VARKEY varKey;
DM_VAR_UPDATE_STRUCTEX result;
CMN_ERROR error:
// to clarify (DM_VAR_UPDATE_STRUCTEX already contains QualityCode)
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DWORD dwState;
DWORD dwQC;
 
BOOL keyFound;
 
//Get the tag value
keyFound = GetTagValueStateQC(&varKey, &result, &error,&dwState,&dwQC);
 
if (keyFound)
{
  // User defined code if the
  // value of the tag is true
  ...
}
else
{
  // User defined code if the
  // value of the tag is false
  ...
}
}

GetTagValueStateQCWait functions

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value. The value is read explicitly from the AS. It also returns the 
status and quality code of the tags.   

Can only be used in C scripting.

Syntax
BOOL GetTagValueStateQCWait (LPDM_VARKEY lpdmVarKey, 
LPDM_VAR_UPDATE_STRUCTEX lpdmresult, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer to a structure of data type "DM_VARKEY"

lpdmresult
Pointer to a structure of data type "DM_VAR_UPDATE_STRUCTEX"

lpdmError
Pointer on the structure that contains the error description.
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Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The following program code uses the function for reading GetTagValueStateQCWait 

The status and quality code is saved to the dwState and dwQC addresses of the tag.

 

A specific code will be executed, depending on the return value in keyFound (TRUE/FALSE).

 
{
DM_VARKEY varKey;
DM_VAR_UPDATE_STRUCTEX result;
CMN_ERROR error:
// to clarify (DM_VAR_UPDATE_STRUCTEX already contains QualityCode)
DWORD dwState;
DWORD dwQC;
 
BOOL keyFound;
 
//Get the tag value
keyFound = GetTagValueStateQC(&varKey, &result, &error,&dwState,&dwQC);
 
if (keyFound)
{
  // User defined code if the
  // value of the tag is true
  ...
}
else
{
  // User defined code if the
  // value of the tag is false
  ...
}
}

GetTagValueWait functions

Description
Enables the transfer of a value in the form of a variant. Determines the pointer on the results 
structure that contains the value. The value is read directly from the AS.   
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Can only be used in C scripting.

Syntax
BOOL GetTagValueWait(LPDM_VARKEY lpdmVarKey, LPDM_VAR_UPDATE_STRUCT 
lpdmresult, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer to a structure of data type "DM_VARKEY"

lpdmresult
Pointer to a structure of data type "DM_VAR_UPDATE_STRUCT"

lpdmError
Pointer on the structure that contains the error description

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.

Example
The GetTagValueWait function is used in the following program code to calculate the value in 
varKey.

A specific code will be executed, depending on the return value in keyFound (TRUE/FALSE).

 
{
DM_VARKEY varKey;
DM_VAR_UPDATE_STRUCT result;
CMN_ERROR error:
 
BOOL keyFound;
 
//Get the tag value
keyFound = GetTagValueWait(&varKey, &result, &error);
 
if (keyFound)
{
  // succeeded, key found
  // print tag value
   printf ("Value of varKey: %d\r\n", &varKey);
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  ...
}
else
{
  // failed
  printf ( "Error - function failed." );
}
  ...
}

GetTagWait functions

Description
The GetTagWaitXXX function calculates the value of a tag of the specified data type. The value 
is read explicitly from the AS. 

Can only be used in C scripting.

The following table shows the different GetTagWait functions for reading the tag value:

Type Function name Parameters PLC data type HMI data type
BOOL GetTagBitWait   Tag Tag_Name Binary tag Bool
BYTE GetTagByteWait   Tag Tag_Name Unsigned 8-bit UByte
char* GetTagCharWait   Tag Tag_Name Text tag 8-bit or text tag 16-

bit
String

double GetTagDoubleWait   Tag Tag_Name Floating point 64-bit Double
DWORD GetTagDWordWait   Tag Tag_Name Unsigned 32-bit UInteger
float GetTagFloatWait   Tag Tag_Name Floating point 32-bit Float
BOOL GetTagRawWait   Tag Tag_Name, 

BYTE* pValue, 
DWORD size

Raw data type Raw

char GetTagSByteWait   Tag Tag_Name Signed 8-bit Byte
long int GetTagSDWordWai

t   
Tag Tag_Name Signed 32-bit Integer

short int GetTagSWordWait   Tag Tag_Name Signed 16-bit Short
WORD GetTagWordWait   Tag Tag_Name Unsigned 16-bit UShort

Syntax
<Type><FunctionName><(Parameter)>;

Example: BYTE GetTagByteWait (Tag Tag_Name);
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Parameters

Tag_Name
Tag name

pValue
Pointer to a byte field containing the value of the raw data tags.

Return value
Value of the tags in the specified type.

System function "GetTagCharWait" returns a pointer to a string that contains the tag value. 

System function "GetTagRawWait" returns TRUE or FALSE:

TRUE: System function completed without errors.

FALSE: An error has occurred.

Example
The following program code uses the GetTagByteWait function to read the value from the 
gs_tag_byte tag and saves it to the bvalue tag.

 
{
BYTE bvalue;
 
//Get the current value of the tag
bvalue = GetTagByteWait("gs_tag_byte");
 
// print value
   printf ("Value of gs_tag_byte: %d\r\n", bvalue);
...
}

The saved return value can be processed in the following code.

See also
Data types (Page 3750)

IncreaseTag

Description
Adds the given value to the value of the tags.       
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X = X + a
 

 Note

The system function uses the same tag as input and output values. When this system function 
is used to convert a value, auxiliary tags must be used. You can use the "SetTag" system 
function to assign the tag value to the auxiliary tags.

 

If you configure the system function for events of an alarm and the tag is not being used in the 
current screen, it is not ensured that the actual tag value is being used in the PLC. You can 
improve the situation by setting the "Cyclic continuous" acquisition mode.

Use in the function list
IncreaseTag (Tag, Value)

Use in user-defined functions
IncreaseTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag
The tag to which the given value is added.

Value
The value that is added.

Example
The following program code increments the value of the varX tag by the value in the value tag. 
The value entered is saved to the old_value tag and output along with the new varX value.

 
{
BYTE varX;
BYTE value;
 
//user input
...
BYTE old_value = varX;
 
//Increase tag
IncreaseTag(varX, value);
 
//print original value and function result   
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printf ("User input: %i\r\n, Result of function IncreaseTag: %i\r\n", old_value, varX);
...
}

See also
System functions for Runtime Professional (Page 4564)

InquireLanguage

Description
Determines all languages configured in the text library for the runtime.

Use Pointer to a counter to specify the storage location for language IDs.

The system function can be used in C scripting only.

Syntax
DWORD* InquireLanguage (DWORD* Pointer to a counter);   

Parameters

Pointer to a counter
Pointer to the number of language IDs found 

Return value
Pointer to a field containing the established language IDs.

The following assignments apply (hexadecimal language code):

Symbolic name Value(hexadecimal
)

Abbreviation

LANG_ARABIC 0x0401  
LANG_AFRIKAANS 0x0436  
LANG_ALBANIAN 0x041C  
LANG_BASQUE 0x042D  
LANG_BULGARIAN 0x0402  
LANG_BYELORUSSIAN 0x0423  
LANG_CATALAN 0x0403  
LANG_CHINESE 0x0404  
LANG_CROATIAN 0x041A  
LANG_CZECH 0x0405 CSY
LANG_DANISH 0x0406 DAN
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Symbolic name Value(hexadecimal
)

Abbreviation

LANG_DUTCH 0x0413 NLD
LANG_ENGLISH 0x0409 ENU
LANG_ESTONIAN 0x0425  
LANG_FAEROESE 0x0438  
LANG_FARSI 0x0429  
LANG_FINNISH 0x040B FIN
LANG_FRENCH 0x040C FRA
LANG_GERMAN 0x0407 DEU
LANG_GREEK 0x0408  
LANG_HEBREW 0x040D  
LANG_HUNGARIAN 0x040E HUN
LANG_ICELANDIC 0x040F ISL
LANG_INDONESIAN 0x0421  
LANG_ITALIAN 0x0410 ITA
LANG_JAPANESE 0x0411  
LANG_KOREAN 0x0412  
LANG_LATVIAN 0x0426  
LANG_LITHUANIAN 0x0427  
LANG_NORWEGIAN 0x0414 NOR
LANG_POLISH 0x0415 PLK
LANG_PORTUGUESE 0x0416 PTB
LANG_ROMANIAN 0x0418  
LANG_RUSSIAN 0x0419 RUS
LANG_SLOVAK 0x041B SKY
LANG_SLOVENIAN 0x0424  
LANG_SORBIAN 0x042E  
LANG_SPANISH 0x040A ESP
LANG_SWEDISH 0x041D SVE
LANG_THAI 0x041E  
LANG_TURKISH 0x041F TRK
LANG_UKRAINIAN 0x0422  

Example
The following program code uses the InquireLanguage function to query the language 
configured at runtime and processes these as follows:

1. Saving the queried language ID to the tag language

2. Saving the number of languages to the tag count

3. Formatted output of the ID and number of languages 
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{
DWORD count;
DWORD* language;
int i;
 
//Count the installed languages
language = InquireLanguage(&count);
 
printf("##################### INQUIRE LANGUAGE ####################");
//Print out the count of languages
printf ( "\r\nCount Languages=%d\r\n", count );
 
//print out which languages are installed
for (i=1;i<=count; i++)
{
printf ("\r\n%d.language=%x", i,*language++);
}
}

The saved return value can be processed in the following code.

InverseLinearScaling

Description
Assigns a value to the tag X, which is calculated from the value of the given tag Y using the 
linear function X = (Y - b) / a.       

The tags X and Y must not be identical. This system function is the inverse of the 
"LinearScaling" system function.

 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used.

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
InvertLinearScaling (X, Y, b, a)

Use in user-defined functions
InverseLinearScaling (X, Y, b, a)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".
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Parameters

X
The tag which is assigned the value calculated from the linear equation.

Y
The tag that contains the value used for calculation.

b
The value which is subtracted.

a
The value through which is divided.

Example
The following program code assigns a value to the varX tag by means of the 
InverseLinearScaling function.

 
{
BYTE varX;
BYTE Yvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
//Inverse linear scaling
 InverseLinearScaling (varX, Yvalue, bvalue, avalue);
 
printf ("varX = %d\r\n, varX); 
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

InvertBit

Description
Inverts the value of the given tag of the "Bool" type:       

● If the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).
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Use in the function list
InvertBit (Tag)

Use in user-defined functions
InvertBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag whose bit is set.

Example
The following program code inverts the value of the boolean tag b_value and outputs the result 
along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Invert variable
invertBit(b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

InvertBitInTag

Description
Inverts a bit in the given tag:       

● If the bit in the tag has the value of 1 (TRUE), it will be set to 0 (FALSE).

● If the bit in the tag has the value of 0 (FALSE), it will be set to 1 (TRUE).
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After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "InvertBit" system 
function instead.

 

Use in the function list
InvertBitInTag (Tag, Bit)

Use in user-defined functions
InvertBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which the given bit is set.

Bit
The number of the bit that is set.

When this system function is used in a user-defined function, the bits in a tag are counted from 
right to left. The counting begins with 0.

Example
The following program code inverts a bit at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Invert bit in bitposition
InvertBitInTag (bvalue, bitposition);
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}
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See also
System functions for Runtime Professional (Page 4564)

IsUserAuthorized

Description
Authentication of users.

Can only be used in C scripting.  

Syntax
BOOL IsUserAuthorized (DWORD AuthorizationNumber);

Parameters

AuthorizationNumber
Authorization (numerical) to be verified. 

Return value

TRUE
The user has the specified authorization.

FALSE
The user does not have the specified authorization.

Example
The following program code authenticates users by means of IsUserAuthorized function and 
writes the value to the boolean tag ok.

 
{
BOOL ok;
DWORD authnumber;
 
//Check authorization and return value
ok = IsUserAuthorized (authnumber);
 
//error handling
if(ok)
{
  // user authorized
  printf ( "User is authorized." );
}
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else
{
  // user not authorized
  printf ( "Authorization failed." );
}
...
}

The return value is output.

LinearScaling

Description
Assigns a value to the tag Y, which is calculated from the value of the given tag X using the 
linear function Y= (a *X) + b.       

The inverse of this function is the "InvertLinearScaling" system function.
 

 Note

The tags X and Y must not be identical. If a tag is to be converted into itself, a auxiliary tag 
must be used. 

The "SetTag" system function can be used to assign the value of the tags to be converted to 
the auxiliary tags.

 

Use in the function list
LinearScaling (Y, a, X, b)

Use in user-defined functions
LinearScaling (Y, a, X, b)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Y
The tag which is assigned the value calculated from the linear equation.

a
The value with which is multiplied.

X
The tag that contains the value used for calculation.
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b
The value that is added.

Example
The following program code uses the LinearScaling function to assign a value to the Yvar tag.

 
{
BYTE Yvar;
BYTE Xvalue = 10;
BYTE bvalue = 3;
BYTE avalue = 4;
 
// linear scaling
 LinearScaling ( Yvar, avalue, Xvalue, bvalue);
 
printf ("Yvar = %d\r\n, Yvar); 
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

ReportJob

Description
A print job, or the preview for a print job is started depending on the value of the Name of 
method parameter.

Can only be used in C scripting.

Syntax
void ReportJob(LPCSTR Print job name, LPCSTR Name of method)   

Parameters

Print job name
Pointer to the name of the print job

Name of method
Defines whether to start the print job or a print job preview:
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● PRINTJOB: Print job is started

● PREVIEW: Print job preview is started

Example
The following program code executes a preview or print job for each content of the printmethod 
tag.

 
{
char* pszPrintjobName;
char* printmethod;
 
//Get the print method
  printf("Input PRINTJOB for printing or PREVIEW for a quick view");
scanf ("%s",&printmethod);
 
//Print job or show preview
ReportJob(&PrintjobName, printmethod);
 
//error handling
if(printmethod=="PRINTJOB")
{
  // message for printing completed
  printf("printing done");
  ...
}
else
{
  // User defined code if the
  // job is a preview or failed
  ...
}
}

ResetBit

Description
Sets the value of a "Bool" type tag to 0 (FALSE).       

Use in the function list
ResetBit (Tag)

Use in user-defined functions
ResetBit (Tag)
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Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 0 (FALSE).

Example
The following program code resets the value of the boolean tag b_value to 0 by means of the 
ResetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 1;
BOOL b_saved = b_value;
 
//Reset bit
  ResetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
System functions for Runtime Professional (Page 4564)

ResetBitInTag

Description
Sets a bit in the specified tag to 0 (FALSE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "ResetBit" system 
function instead.
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Use in the function list
ResetBitInTag (Tag, Bit)

Use in user-defined functions
ResetBitInTag (Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 0 (FALSE).

Bit
The number of the bit that is set to 0 (FALSE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

Example
The following program code sets a bit at the specified bitposition in the bvalue tag to 0 and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
ResetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)
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SetBit

Description
Sets the value of a "Bool" type tag to 1 (TRUE).       

Use in the function list
SetBit (Tag)

Use in user-defined functions
SetBit (Tag)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The BOOL type tag which is set to 1 (TRUE).

Example
The following program code sets the value of the boolean tag b_value to 1 by means of the 
SetBit function and outputs the result along with the original b_saved value.

 
{
BOOL b_value = 0;
BOOL b_saved = b_value;
 
//Set bit
  SetBit (b_value);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",b_value, b_saved); 
...
}

See also
System functions for Runtime Professional (Page 4564)
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SetBitInTag

Description
Sets a bit in the given tag to 1 (TRUE).       

After changing the given bit, the system function transfers the entire tag back to the PLC. It is 
not checked whether other bits in the tags have changed in the meantime. Operator and PLC 
have read-only access to the indicated tag until it is transferred back to the PLC.

 

 Note

If the PLC supports BOOL tags, do not use this system function. Use the "SetBit" system 
function instead.

 

Use in the function list
SetBitInTag (Tag, Bit)

Use in user-defined functions
SetBitInTag(Tag, Bit)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag in which a bit is set to 1 (TRUE).

Bit
The number of the bit that is set to 1 (TRUE).

When this system function is used in a user-defined function, the bits in the specified tag will 
be counted from right to left independent of the PLC used. The counting begins with 0.

 

 Note

The guaranteed update of the tags used with actual process values is absolutely conditional 
in terms of reliable functionality. You should therefore configure the tag in an I/O field or assign 
the system function to a screen object, such as a button.

If you have configured a short event such as the activation of an alarm for the system function 
you can only access the actual process values by setting the tag for continuous reading.
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Example
The following program code sets a bit to 1 at the specified bitposition in the bvalue tag and 
outputs the result along with the original bsaved value.

 
{
BYTE bvalue;
BYTE bsaved = bvalue;
BYTE bitposition = 2;
 
//Reset bit in bitposition
SetBitInTag (bvalue, bitposition);
 
//print current and saved value 
printf ("Current value: %d\r\n, Saved value: %d\r\n",bvalue, bsaved); 
  ...
}

See also
System functions for Runtime Professional (Page 4564)

SetLanguageByLocaleID

Description
Changes the language setting in Runtime.  

Can only be used in C scripting.

Syntax
BOOL SetLanguageByLocaleID (DWORD dwLocaleID);

Parameters

dwLocaleID
Language ID of the language to be set

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred.
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Example
The following program code uses the SetLanguage function to set the current runtime language 
to German and saves the return value to the ok tag. 

 
{
BOOL ok;
DWORD old_language;
DWORD new_language;
 
//Get the current language and save it 
old_language = GetLanguageByLocaleID ();
 
//Set the current language to German
ok = SetLanguage(0x0407);
 
//Get the current language and save it 
new_language = GetLanguageByLocaleID ();
 
//error handling
if(ok)
{
  // succeeded
  printf ( "RT language is now German." );
}
else
{
  // failed
  printf ( "RT language was not updated." );
}
//print language code 
printf ("Former language code: %d\r\n", old_language);
printf ("Current language code: %d\r\n", new_language);
}

The saved return value can be processed in the following code.

See also
Example of configuring a language switch (Page 4525)

GetLanguageByLocaleID (Page 5905)

SetProp

SetPropBOOL

Description
Sets an object property of data type "BOOL".

Can only be used in C scripting.
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Syntax
BOOL SetPropBOOL(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, BOOL Value)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property 

Value
Value assigned to the object property of data type "BOOL". 

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred. 

Example
The following program code uses the SetPropBool function to set the property of the 
gs_graph_iofield object to "Visible". The return value is saved to the ok tag.

 
{
BOOL ok;
 
//Set the visibility TRUE
ok = SetPropBOOL("gs_graph_iofield","IOField1","Visible",TRUE);
 
//error handling
if(ok)
{
  // succeeded
  printf ( "IO field is visible." );
}
else
{
  // failed
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  printf ( "Error - visibility not set" );
}
...
}

The saved return value can be processed in the following code.

SetPropChar

Description
Sets an object property of data type "char".

Can only be used in C scripting.

Syntax
BOOL SetPropChar(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, char* Value)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property

Value
Value assigned to the object property of data type "char". 

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred. 
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Example
The following program code uses the SetPropChar function to set the Tooltiptext property of 
the gs_graph_iofield object to the "Tooltiptext 1" value. The return value is saved to the ok tag.

 
{
BOOL ok;
 
//Set the property Tooltiptext
ok = SetPropChar("gs_graph_iofield","ToolTipText","Tooltiptext 1");
 
//error handling
if(ok)
{
  // succeeded
  printf ( "Property of Tooltiptext is now Tooltiptext 1." );
}
else
{
  // failed
  printf ( "Error - property not set" );
}
...
}

The saved return value can be processed in the following code.

SetPropDouble

Description
Sets an object property of data type "Double".

Can only be used in C scripting.

Syntax
BOOL SetPropDouble(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, double Value)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.
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Name of the Property
Name of the object property

Value
Value assigned to the object property of data type "double". 

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred. 

Example
The following program code accesses an object property in the screenName screen. In this 
example, the SetPropDouble function sets the property (radius) of "Circle_1" to the value 10. 
The return value is saved to the ok tag.

 
{
BOOL ok;
 
 
//Set the property of circle 
ok = SetPropDouble(screenName,"Circle_1","Radius",10);
 
//error handling
if(ok)
{
  // succeeded
  printf ( "Radius was set." );
}
else
{
  // failed
  printf ( "Error - radius not set" );
}
...
}

The saved return value can be processed in the following code.

See also
Example of accessing objects in the Screens editor (Page 4524)
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SetPropLong

Description
Sets an object property of data type "long".

Can only be used in C scripting.

Syntax
BOOL SetPropLong(LPCTSTR Screen name, LPCTSTR Object, LPCTSTR Name of the 
property, long Value)   

Parameters

Screen name
Screen name

Object
Object name You must set the parameter Object = NULL if the function call relates to a screen 
object property.

Name of the Property
Name of the object property

Value
Value assigned to the object property of data type "long". 

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred. 

Example
The following program code uses the SetPropLong function to change the foreground color of 
an object: In "Screen_1", the "ForeColor property of the "Button1" object is set to the value 
65333 (red). The return value is saved to the ok tag.

 
{
BOOL ok;
 
//Set the property Tooltiptext
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ok = SetPropLong("Screen_1","Button1","ForeColor",65333);
 
//error handling
if(ok)
{
  // succeeded
  printf ( "Color was set." );
}
else
{
  // failed
  printf ( "Error - color not set" );
}
...
}

The saved return value can be processed in the following code.

See also
Example of writing object properties (Page 4528)

Accessing objects with C (Page 4459)

SetPropertyByConstant

Description
Specifies the value of an object property as a string.       

Use in the function list
SetPropertyByConstant (Screen name, Object, Name of the property, Value)

Use in user-defined functions
SetPropertyByConstant

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to change the property of a screen, the parameter "Object" must be empty. For this 
purpose, use the following syntax, for example:

SetPropertyByConstant ("<Screen name>","","<Property name>","<Value>")

Parameters

Screen name
Name of the screen that contains the object. 
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Object
Name of the object whose property is changed. 

Name of the property
Name of the property that will be changed. 

Value
The value assigned to the property. 

Example
The SetPropertyByConstant function is used in the following program code to change an object 
property: In the "Trends" screen, the "ToolbarButtonClick" property of the "Control_1" object 
is set to the value 26.

 
{
 
//Name of the picture: Trends 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByConstant ("Trends", "Control_1", "ToolbarButtonClick", "26");
 
// User defined code 
...
}

Example: Changing a screen property
The SetPropertyByConstant function is used in the following program code to change a screen 
property: In the "Trends" screen, the "Backcolor" property is set to the value 255.

 
{
 
//Name of the picture: Trends 
 
SetPropertyByConstant ("Trends", "Trends", "Backcolor", "255");
 
// User defined code 
...
}

Alternatively, use the password ZERO or a space-string instead of the second parameter 
(object). 

See also
System functions for Runtime Professional (Page 4564)

Example of defining object colors (Page 4524)
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SetPropertyByProperty

Description
Specifies the value of an object property with another object property.       

Use in the function list
SetPropertyByProperty (Screen name, Object, Name of the property, Destination screen 
name, Destination object, Destination property name)

Use in user-defined functions
SetPropertyByProperty (Screen_name, Screen_object, Property_name, 
Source_screen_name, Source_screen_object, Source_property_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen with another screen property, the parameters 
"Object" and "Destination object" must be empty. For this purpose, use the following syntax, 
for example:

SetPropertyByProperty ("<Screen name>","","<Property name>","<Destination_Screen 
name>","","<Destination_Property name>")

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object whose property is transferred to the destination object. 

Name of the property
Name of the property that will be transferred to the destination object. 

Destination screen name
Name of the screen that contains the destination object. 

Destination object
Name of the destination object to which the property is transferred. 

Destination property name
Name of the property that will be changed. 
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Example
The following program code uses the SetPropertyByProperty function to set the property 
"ToolbarButtonClick" of the object "Control_1" in the original screen Trend_1": on the 
corresponding property in the destination screen "Trend_2".

 
{
 
//Name of source picture: Trend_1 
//Name of target picture: Trend_2 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByProperty ("Trend_1", "Control_1", "ToolbarButtonClick", "Trend_2", 
"Control_2", "ToolbarButtonClick");
 
// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetPropertyByTag

Description
Specifies the value of an object property with a tag value.       

Use in the function list
SetPropertyByTag (Screen name, Object, Name of the property, Tag name)

Use in user-defined functions
SetPropertyByTag (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen by means of a tag value, the "Object" parameter 
must be empty. For this purpose, use the following syntax, for example:

SetPropertyByTag ("<Screen name>","","<Property name>","<Tag name>")
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Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object containing the property to be set with the tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that contains the value of the property. 

Example
The SetPropertyByTag function is used in the following program code to change an object 
property: A click on the object transfers the object name and the screen containing the object. 
The CaptionText in the screen window contains the value of the HMI_value_1 tag.

 
{
 
SetPropertyByTag (screenName, objectName, "CaptionText", "HMI_value_1");
 
// User defined code 
...
}

Example
The SetPropertyByTag function is used in the following program code to change an object 
property: In the "Trends" screen, the "ToolbarButtonClick" property of the "Control_1" object 
is set to the value 26.

 
{
 
//Name of the picture: Trends 
//Name of the f(t) trend view control: Control_1 
 
SetPropertyByConstant ("Trends", "Control_1", "ToolbarButtonClick", "26");
 
// User defined code 
...
}
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See also
System functions for Runtime Professional (Page 4564)

SetPropertyByTagIndirect

Description
Specifies the value of an object property with a tag. The tag contains the tag name that specifies 
the object property.       

Use in the function list
SetPropertyByTagIndirect (Screen name, Object, Name of the property, Tag name)

Use in user-defined functions
SetPropertyByTagIndirect (Screen_name, Screen_object, Property_name, Tag_name)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

If you want to specify the property of a screen by means of a tag, the "Object" parameter must 
be empty. For this purpose, use the following syntax, for example:

SetPropertyByTagIndirect ("<Screen name>","","<Property name>","<Tag name>")

 

Parameters

Screen name
Name of the screen that contains the object. 

Object
Name of the object containing the property to be set with the tag value. 

Name of the property
Name of the property that is set with the tag value. 

Tag name
Name of the tag that, in turn, contains the name of the tag that specifies the object property. 
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Example
The SetPropertyByTagIndirect function is used in the following program code to change an 
object property: .

 
{
 
SetPropertyByTagIndirect (GetParentScreen(screenName), GetParentScreenWindow(screenName), 
"ScreenName", "HMI_value_1");
 
// User defined code 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTag

SetTag functions

Description
The SetTagXXX function calculates the value of a tag of the specified data type. 

Can only be used in C scripting.

The following table shows the different SetTag functions for setting the tag value:                       

Function name Parameters PLC data type HMI data type
SetTagBit Tag Tag_Name, 

short int value
Binary tag Bool

SetTagByte Tag Tag_Name, 
BYTE value

Unsigned 8-bit USInt

SetTagChar Tag Tag_Name, 
LPSTR value

Text tag 8-bit or text tag 16-bit String or WString

SetTagDouble Tag Tag_Name, 
double value

Floating point 64-bit LReal

SetTagDWord Tag Tag_Name, 
DWORD value

Unsigned 32-bit UDInt

SetTagFloat Tag Tag_Name, 
float value

Floating point 32-bit Real

SetTagRaw Tag Tag_Name, 
BYTE* pValue, 
DWORD size

Raw data type Raw

SetTagSByte Tag Tag_Name, 
char value

Signed 8-bit SInt
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Function name Parameters PLC data type HMI data type
SetTagSDWord Tag Tag_Name, 

long int value
Signed 32-bit DInt

SetTagSWord Tag Tag_Name, 
short int value

Signed 16-bit Int

SetTagWord Tag Tag_Name, 
WORD value

Unsigned 16-bit UInt

Syntax
BOOL<FunctionName><(Parameter)>;

Example: BOOL SetTagBit (Tag Tag_Name, short int value);

Parameters

Tag_Name
Tag name

value
Value of the tags in the specified data type.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors.

FALSE
An error has occurred.

Example
The following program code uses the SetTagBit function to set the value of the gs_tag_bit tag 
to TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
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//Set the tag to true
ok = SetTagBit("gs_tag_bit", TRUE);
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

See also
Data types (Page 3750)

Access to HMI tags (Page 4445)

SetTagMultiStateWait functions

Description
Sets the values of several tags. The system function will end only after the AS has reported 
the acceptance of the value.

The system function can be used in C scripting only.

The system function must be given a DWORD array, in the member of which the status of the 
individual tags will be located after the system function has been called. The size of the array 
must be large enough to provide sufficient storage space for the status.   

Syntax
BOOL SetTagMultiStateWait(DWORD* pdwState, const char* pFormat,...);

Parameters

pdwState
Field in which the tag status is saved.
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pFormat
Format description for all the requested tags along with the name and value for each tag.

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors.

FALSE
An error has occurred.

Example
The following program code uses the SetTagMultiStateWait function to set the value of several 
tags.

1. Creation of a DWord arrays of the necessary size (number of tags)

2. Creation of the tags that will contain the values to be transferred to the WinCC tags by 
means of the SetTagMultiStateWait function

3. Writing the values of the recently declared tags to the WinCC tags:

– gs_tag_bit including the tag value "lValue1"

– gs_tag_SByte including the tag value in the address  "&lValue2"

– etc.

 
{
#define DATA_SIZE 5 
DWORD dwData[DATA_SIZE]; 
 
//define all tags 
BOOL lValue1;
long lValue2; 
char szValue3[_MAX_PATH]; 
float lValue4; 
char lValue5; 
 
// Fill the tags with the values 
// you want to set into the WinCC tags 
... 
 
//Set the WinCC tags 
SetTagMultiStateWait(dwData,"%d%d%s%f%d","gs_tag_bit",lValue1, 
 "gs_tag_SByte",lValue2,
 "gs_tag_char",szValue3,
 "gs_tag_float",lValue4,
 "gs_tag_word",lValue5);
...
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}

The saved return value can be processed in the following code.

SetTagMultiWait functions

Description
The values of several tags are set in the specified format. The system function will end only 
after the AS has reported the acceptance of the value.  

Can only be used in C scripting.

Syntax
BOOL SetTagMultiWait(const char* pFormat,...);

Parameters

pFormat
Format description for all the requested tags along with the name and value for each tag.

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors.

FALSE
An error has occurred.

Example
The following program code uses the SetTagMultiWait function to change the value of several 
tags. The return value is saved to the ok tag.

 
{
BOOL ok; 
//memory for values allocated via SysMalloc 
DWORD dwVar1Value;
char* szVar2Value; 
double dbVar3Value;
 
//settings 
ok=SetTagMultiWait("%d%s%f", "Ernie_word", 16, 
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  "Ernie_char", "Hallo Welt", 
  "Ernie_double", 55.4711);
 
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
 
// Get values and print
GetTagMultiWait("%d%s%f", "Ernie_word", &dwVar1Value,
  "Ernie_char", &szVar2Value,
  "Ernie_double", &dbVar3Value);
 
printf("Word %d, String %s, Double %f\r\n",
  dwVar1Value, szVar2Value, dbVar3Value);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

Example
The GetTagMultiWait function is used in the following program code to read several tags of 
different types:

1. Declaration of three tags as memory for three different tag types

2. Declaration of the boolean tag ok for buffering the return value (TRUE/FALSE)

3. Reading the three tags and saving the values to the corresponding addresses. 
The return value of the function is saved to the ok tag.

4. Output of the three tags with tag type prefix

 
DWORD dwVar1Value;
char* szVar2Value; 
//Speicher für den Variablenwert wird 
//durch die Funktion mit SysMalloc angelegt
double dbVar3Value;
 
BOOL ok;
 
ok=GetTagMultiWait("%d%s%f", "Ernie_word", &dwVar1Value,
  "Ernie_char", &szVar2Value,
  "Ernie_double", &dbVar3Value);
 
printf("Word %d, String %s, Double %f\r\n",
  dwVar1Value, szVar2Value, dbVar3Value);
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SetTagState functions

Description
Sets the value of a tag of a specified data type. It also returns the status of the tags.

Can only be used in C scripting.

The following table lists the different SetTagStateXXX functions for reading the tag value:

Function name Parameters PLC data type HMI data type
SetTagBitState   Tag Tag_Name, short 

int value, PDWORD 
lp_dwstate

Binary tag Bool

SetTagByteStat
e   

Tag Tag_Name, BYTE 
value, PDWORD 
lp_dwstate

Unsigned 8-bit UByte

SetTagCharStat
e   

Tag Tag_Name, LPSTR 
value, PDWORD 
lp_dwstate

Text tag 8-bit or text tag 16-
bit

String

SetTagDoubleSt
ate   

Tag Tag_Name, double 
value, PDWORD 
lp_dwstate

Floating point 64-bit Double

SetTagDWordSt
ate   

Tag Tag_Name, 
DWORD value, 
PDWORD lp_dwstate

Unsigned 32-bit UInteger

SetTagFloatStat
e   

Tag Tag_Name, float 
value, PDWORD 
lp_dwstate

Floating point 32-bit Float

SetTagRawStat
e   

Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw

SetTagSByteSt
ate   

Tag Tag_Name, signed 
char value, PDWORD 
lp_dwstate

Signed 8-bit Byte

SetTagSDWord
State   

Tag Tag_Name, long int 
value, PDWORD 
lp_dwstate

Signed 32-bit Integer

SetTagSWordSt
ate   

Tag Tag_Name, short 
int value, PDWORD 
lp_dwstate

Signed 16-bit Short

SetTagWordSta
te   

Tag Tag_Name, WORD 
value, PDWORD 
lp_dwstate

Unsigned 16-bit UShort

Syntax
BOOL <FunctionName><(Parameter)>;

Example: BOOL SetTagBitState (Tag Tag_Name, short int value, PDWORD lp_dwstate);

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 5975



Parameters

Tag_Name
Tag name

value
Value of the tags of a specified type.

lp_dwstate
Pointer to a DWORD to which the tag status is saved on completion of the system function 
cycle.

pFormat
Format description for all the requested tags along with name and value for each tag.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors. 

FALSE
An error has occurred.

Example
The following program code uses the SetTagBitState function to set the value of the gs_tag_bit 
tag to TRUE and saves the return value to the ok tag. "&dwstate" is the address of the tag to 
which the tag status is saved.

The saved return value can be processed in the following code.

 
{
DWORD dwstate;
BOOL ok;
 
//Load dwState with default values 
dwstate = 0xFFFFFFFF;
//Set the value of the tag to TRUE 
//dwstate is the tag state 
ok = SetTagBitState("gs_tag_bit",TRUE,&dwstate);
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//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
  printf ("Status of gs_tag_bit: %d\r\n", dwstate);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

See also
Data types (Page 3750)

SetTagStateWait functions

Description
Sets the value of a tag of a specified data type. The system function will end only after the AS 
has reported the acceptance of the value. It also returns the status of the tags.

Can only be used in C scripting.

The following table lists the different SetTagStateWait functions for setting the tag value: 

Function name Parameters PLC data type HMI data type
SetTagBitStateWa
it   

Tag Tag_Name, short 
int value, PDWORD 
lp_dwstate

Binary tag Bool

SetTagByteState
Wait   

Tag Tag_Name, BYTE 
value, PDWORD 
lp_dwstate

Unsigned 8-bit UByte

SetTagCharState
Wait   

Tag Tag_Name, 
LPSTR value, 
PDWORD lp_dwstate

Text tag 8-bit or text tag 16-
bit

String

SetTagDoubleStat
eWait   

Tag Tag_Name, double 
value, PDWORD 
lp_dwstate

Floating point 64-bit Double

SetTagDWordStat
eWait   

Tag Tag_Name, 
DWORD value, 
PDWORD lp_dwstate

Unsigned 32-bit UInteger

SetTagFloatState
Wait   

Tag Tag_Name, float 
value, PDWORD 
lp_dwstate

Floating point 32-bit Float
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Function name Parameters PLC data type HMI data type
SetTagRawState
Wait   

Tag Tag_Name, BYTE* 
pValue, DWORD size, 
PDWORD lp_dwstate

Raw data type Raw

SetTagSByteState
Wait   

Tag Tag_Name, char 
value, PDWORD 
lp_dwstate

Signed 8-bit Byte

SetTagSDWordSt
ateWait   

Tag Tag_Name, long 
int value, PDWORD 
lp_dwstate

Signed 32-bit Integer

SetTagSWordStat
eWait   

Tag Tag_Name, short 
int value, PDWORD 
lp_dwstate

Signed 16-bit Short

SetTagWordState
Wait   

Tag Tag_Name, 
WORD value, 
PDWORD lp_dwstate

Unsigned 16-bit UShort

Syntax
BOOL<FunctionName><(Parameter)>;

Example: BOOL SetTagBitStateWait (Tag Tag_Name, short int value, PDWORD lp_dwstate);

Parameters

Tag_Name
Tag name

value
Value of the tags of a specified type.

lp_dwstate
Pointer to a DWORD to which the tag status is saved on completion of the system function 
cycle.

pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors. 
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FALSE
An error has occurred.

Example
The following program code uses the SetTagBitStateWait function to set the value of the 
gs_tag_bit tag to TRUE and saves the return value to the ok tag. "&dwstate" is the address of 
the tag to which the tag status is saved.

The saved return value can be processed in the following code.

 
{
DWORD dwstate;
BOOL ok;
 
//Load dwState with default values 
dwstate = 0xFFFFFFFF;
//Set the value of the tag to TRUE 
//dwstate is the tag state 
ok = SetTagBitStateWait("gs_tag_bit",TRUE,&dwstate);
 
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
  printf ("Status of gs_tag_bit: %d\r\n", dwstate);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

See also
Data types (Page 3750)

SetTagValue functions

Description
Enables the transfer of a value in the form of a variant and sets the pointer to the value of data 
type "Variant".   

Can only be used in C scripting.
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Syntax
BOOL SetTagValue (LPDM_VARKEY lpdmVarKey, LPVARIANT lpdmValue, PDWORD 
dwState, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer to a structure of data type "DM_VARKEY"

lpdmValue
Pointer to a structure of data type "Variant". Refer to relevant technical references for the 
description of data type VARIANT.

lpdmError
Pointer on the structure that contains the error description.

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors.

FALSE
An error has occurred.

Example
The SetTagValue function is used in the following program code to transfer the value in varKey.

A specific code will be executed, depending on the return value in keyFound (TRUE/FALSE).

 
{
// tags for setting the value
DM_VARKEY varKey;
LPVARIANT value;
LPCMN_ERROR error1:
 
// tags for getting the value
DM_VAR_UPDATE_STRUCT result;
CMN_ERROR error:
 
BOOL keyFound;
 
ok = SetTagValue(&varKey, &value, &error1);
 
if (keyFound)
{
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  // succeeded, get the new value
GetTagValue(&varKey, &result, &error);
  // print tag value
   printf ("Value of varKey: %d\r\n", &varKey);
  ...
}
else
{
  // failed
  printf ( "Error - function failed." );
  ...
}
}

SetTagValueWait functions

Description
Enables the transfer of a value in the form of a variant and sets the pointer to the value of data 
type "Variant". The system function will end only after the AS has reported the acceptance of 
the value.   

Can only be used in C scripting.

Syntax
BOOL SetTagValueWait(LPDM_VARKEY lpdmVarKey, LPVARIANT lpdmValue, PDWORD 
dwState, LPCMN_ERROR lpdmError);

Parameters

lpdmVarKey
Pointer to a structure of data type "DM_VARKEY"

lpdmValue
Pointer to a structure of data type "Variant". Refer to relevant technical references for the 
description of data type VARIANT.

dwState
Status of the tags that is returned after the system function cycle.

lpdmError
Pointer on the structure that contains the error description.
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Return value

TRUE
System function completed without errors.

There is no check to see if the tag was written without any errors.

FALSE
An error has occurred. 

Example
The SetTagValueWait function is used in the following program code to transfer the value in 
varKey.

A specific code will be executed, depending on the return value in keyFound (TRUE/FALSE).

 
{
// tags for setting the value
DM_VARKEY varKey;
LPVARIANT value;
LPCMN_ERROR error1:
 
// tags for getting the value
DM_VAR_UPDATE_STRUCT result;
CMN_ERROR error:
 
BOOL keyFound;
 
ok = SetTagValueWait(&varKey, &value, &error1);
 
if (keyFound)
{
  // succeeded, get the new value
GetTagValueWait(&varKey, &result, &error);
  // print tag value
   printf ("Value of varKey: %d\r\n", &varKey);
  ...
}
else
{
  // failed
  printf ( "Error - function failed." );
  ...
}
}
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SetTagWait functions

Description
Sets the value of a tag of a specified data type. The system function will end only after the AS 
has reported the acceptance of the value.

Can only be used in C scripting.

The following table lists the different SetTagWait functions for setting the tag value:

Function name Parameters PLC data type HMI data type
SetTagBitWait   Tag Tag_Name, short 

int value
Binary tag Bool

SetTagByteWait
   

Tag Tag_Name, BYTE 
value

Unsigned 8-bit UByte

SetTagCharWai
t   

Tag Tag_Name, char* 
value

Text tag 8-bit or text tag 16-
bit

String

SetTagDoubleW
ait   

Tag Tag_Name, double 
value

Floating point 64-bit Double

SetTagDWordW
ait   

Tag Tag_Name, 
DWORD value

Unsigned 32-bit UInteger

SetTagFloatWai
t   

Tag Tag_Name, float 
value

Floating point 32-bit Float

SetTagRawWait
   

Tag Tag_Name, BYTE* 
pValue, DWORD size

Raw data type Raw

SetTagSByteW
ait   

Tag Tag_Name, char 
value

Signed 8-bit Byte

SetTagSDWord
Wait   

Tag Tag_Name, long int 
value

Signed 32-bit Integer

SetTagSWordW
ait   

Tag Tag_Name, short 
int value

Signed 16-bit Short

SetTagWordWai
t   

Tag Tag_Name, WORD 
value

Unsigned 16-bit UShort

Syntax
BOOL <FunctionName><(Parameter)>;

Example: BOOL SetTagBitWait (Tag Tag_Name, short int value);

Parameters

Tag_Name
Tag name

value
Value of the tags of a specified type.
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pValue
Pointer to a byte field containing the value of the raw data tags.

size
Length of the byte field in bytes

Return value

TRUE
System function completed without errors.

However, no check is made to verify that the tag was written without any errors.

FALSE
An error has occurred.

Example
The following program code uses the SetTagBitWait function to set the value of the gs_tag_bit 
tag to TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTagBitWait("gs_tag_bit", TRUE);
//error handling
if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBitWait("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

See also
Data types (Page 3750)

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
5984 System Manual, 02/2014



SetTag

Description
Assigns a new value to the given tag.     

 

 Note

This system function can be used to assign strings and numbers, depending on the type of 
tag.

 

Use in the function list
SetTag (Tag, Value)

Use in user-defined functions
SetTag (Tag, Value)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Tag
The tag to which the given value is assigned.

Value
The value which the given tag is assigned.

 

 Note

The "SetTag" system function is only executed after a connection has been established.
 

Example
The following program code uses the SetTag function to set the value of the gs_tag_bit tag to 
TRUE and saves the return value to the ok tag.

 
{
BOOL ok;
BOOL bvalue;
 
//Set the tag to true
ok = SetTag("gs_tag_bit", TRUE);
//error handling
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if(ok)
{
  // succeeded
  printf ( "Function has run through.\r\n" );
bvalue = GetTagBit("gs_tag_bit");
  printf ("Value of gs_tag_bit: %d\r\n", bvalue);
}
else
{
  // failed
  printf ( "Error - function failed." );
}
...
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

SetTagByProperty

Description
Specifies a tag value with the value of an object property. The change is also logged in the 
alarm system.       

Use in the function list
SetTagByProperty (Tag name, Screen name, Object, Name of the property, With or without 
operator event)

Use in user-defined functions
SetTagByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the tag whose value is specified by the object property.

Screen name
Name of the screen that contains the object. 
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Object
Name of the object whose property supplies the tag value.

Name of the property
Name of the property that supplies the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
The following program code returns the value of the selected text when you click in a combo 
box.

 
{
char* rt_value;
 
SetTagByProperty (rt_value, screenName, objectName, "SelectedText", 
hmiWithoutOperatorEvent);
 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagByTagIndirect

Description
Sets the tag value to the value of an indirect tag. The change is also logged in the alarm 
system.       

Use in the function list
SetTagByTagIndirect (Tag name, Tag name, With or without operator event)

Use in user-defined functions
SetTagByTagIndirect (Tag_name, Source_tag_name, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Tag name
Name of the tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that returns the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event 

1 (hmiWithOperatorEvent) = With operator event

Example
The following program code returns the value of the "@LocalMachineName" tag when you 
click the corresponding button.

 
{
char* rt_value;
 
SetTagByTagIndirect (rt_value, "@LocalMachineName", hmiWithoutOperatorEvent);
 
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirect 

Description
Specifies the indirect name for a tag.       

Use in the function list
SetTagIndirect (Tag name (output), LpValue)

Use in user-defined functions
SetTagIndirect (Tag_name, Value, With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 

Example
The following program code transfers the value from the "value" tag to the "result" tag when 
you click the corresponding button.

 
{
BYTE result;
BYTE value;
 
SetTagIndirect ("result", "value", hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectByProperty

Description
Specifies a tag name with the value of an object property. The change is also logged in the 
alarm system.       

Use in the function list
SetTagIndirectByProperty (Tag name, Screen name, Screen object, Name of the property, 
With or without operator event)

Use in user-defined functions
SetTagIndirectByProperty (Tag_name, Screen_name, Screen_object, Property_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".
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Parameters

Tag name
Name of the tag whose tag name is specified by the object property.

Screen name
Name of the screen that contains the object. 

Screen object
Name of the object whose property returns the tag name.

Name of the property
Name of the property that returns the tag name. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
When you click the objectName button, the following program code sets the value of the 
"rt_value_property" tag to the value of the "FlashingEnabled" property.

 
{
Int rt_value_property;
SetTagIndirectByProperty ("rt_value_property", screenName, objectName, "FlashingEnabled", 
hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectByTagIndirect

Description
Sets the tag value to the value of an indirect tag. The change is also logged in the alarm 
system.       

Use in the function list
SetTagIndirectByTagIndirect (Tag name, Tag name, With or without operator event)
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Use in user-defined functions
SetTagIndirectByTagIndirect (Tag_name, Source_tag_name, 
With_or_without_operator_event)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name
Name of the indirect tag whose value is specified by an indirect tag.

Tag name
Name of the indirect tag that returns the tag value. 

With or without operator event
0 (hmiWithoutOperatorEvent) = Without operator event

1 (hmiWithOperatorEvent) = With operator event

Example
When you click the objectName button, the following program code sets the "rt_value" tag to 
the value of the "value" tag.

 
{
Int rt_value;
Int value;
 
SetTagIndirectByTagIndirect ("rt_value", "value", hmiWithoutOperatorEvent);
...
}

See also
System functions for Runtime Professional (Page 4564)

SetTagIndirectWithOperatorInputAlarm

Description
Specifies the indirect name for a tag. The change is also logged in the alarm system.       

Use in the function list
SetTagIndirectWithOperatorInputAlarm (Tag name (output), LpValue)
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Use in user-defined functions
SetTagIndirectWithOperatorEvent

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag to which the tag name is written. 

LpValue
Name of the tag written to the tag. 

See also
System functions for Runtime Professional (Page 4564)

SetTagWithOperatorEvent

Description
Specifies the value for a tag. The change is also logged in the alarm system.       

Use in the function list
SetTagWithOperatorInputAlarm (Tag name (output), LpValue)

Use in user-defined functions
SetTagWithOperatorEvent (Tag_name, Value)

Can be used if the configured device supports user-defined functions. For more information, 
refer to "System functions for Runtime Professional (Page 4564)".

Parameters

Tag name (output)
Name of the tag whose value is to be set. 

LpValue
Value written to the tag. 
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Example
The following program code transfers the value from the "value" tag to the "result" tag when 
you click the corresponding button.

 
{
BYTE result;
BYTE value;
 
SetTagWithOperatorEvent ("result", "value");
...
}

See also
System functions for Runtime Professional (Page 4564)

StartProgram

Description
Starts the specified program with the specified parameters.

The system function can be used in C scripting only

Syntax
void StartProgram(Program_name,Program_parameter,Display_mode, 
Wait_for_program_end);   

Parameters

Program_name
Path and name of the program to be started.

Program_parameters
Parameters to be used for start-up. Information on the possible parameters can be found in 
the description of the program to be started.

Display_mode
Defines the display mode in which the program is started:

0 (hmiShowNormal) = Display in window

1 (hmiShowMinimized) = Display in minimized window

2 (hmiShowMaximized) = Display in maximized window

3 (hmiShowMinimizedAndInaktive) = Display in inactive and minimized window
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Wait_for_program_end
The parameter is not evaluated by WinCC Runtime Professional.

Example
The following program code starts the calc.exe program in the  minimized window.

 
{
BOOL Wait_for_program_end;
float number;
 
//start the program calc.exe
StartProgram("C:\\Winnt\\system32\\calc.exe",number,hmiShowMinimized, 
Wait_for_program_end);
...
}

StopRuntime

Description
Exits the runtime software and thereby the project running on the HMI device.       

Use in the function list
StopRuntime (Mode)

Use in user-defined functions
StopRuntime (Mode)

Can be used if the configured device supports user-defined functions. For additional 
information, refer to "Device dependency".

Parameters

Mode
Determines whether the operating system is shut down after exiting runtime.

0 (hmiStopRuntime) = Runtime: Operating system is not shut down

1 (hmiStopRuntimeAndOperatingSystem) = Runtime and operating system: The operating 
system is shut down (not possible with WinCE)
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Example
The following program code shuts down Runtime and the operating system.

 
{
 
//Stop runtime and shutdown
StopRuntime (hmiStopRuntimeAndOperationSystem);
 
}

The saved return value can be processed in the following code.

See also
System functions for Runtime Professional (Page 4564)

Example of deactivating Runtime (Page 4525)

StoreScreen 

Description
Saves the current screen. This screen can be opened with the ActivateStoredScreen system 
function.

Can only be used in C scripting.

Syntax
BOOL StoreScreen();

Return value

TRUE
System function completed without errors.

FALSE
An error has occurred. 

Example
The following program code writes the return value of the StoreScreen function to the 
screen_stored tag and calls the stored screen, provided that this was saved without errors.

 
{
BOOL screen_stored;
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screen_stored = StoreScreen();
//user defined code
...
//error handling
if(screen_stored)
{
  // succeeded
  ActivateStoredScreen();
  printf ( "Stored screen is now activated.\r\n" );
}
else
{
  // failed
  printf ( "Error - no screen stored." );
}
...
}

See also
ActivateStoredScreen (Page 5900)

TriggerOperatorEvent

Description
The TriggerOperatorEvent system function triggers an operator input alarm.   

Syntax
int TriggerOperatorEvent( DWORD dwFlags, DWORD dwMsgNum, char* lpszObjectName, 
DWORD dwMyTextID, double doValueOld, double doValueNew, char* pszComment ); 

Parameter

dwFlags
 

FLAG_COMMENT_PARAMETER (0x001): Specifies that the comment is input by means of 
the parameter.

FLAG_COMMENT_DIALOG (0x003): Specifies that the comment is input by means of a dialog.

FLAG_TEXTID_PARAMETER (0x100): Specifies that the comment is specified by means of 
a Text ID.

dwMsgNum
Number of the operator input alarm that is triggered.
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lpszObjectName
Pointer to the name of the tag with the old value and the new value.

dwMyTextID
ID of the text to be used as comment.

doValueOld
Old value.

doValueNew
New value.

pszComment
Pointer to the text to be used as comment.

Return value

TRUE
The system function has been completed without any errors.

FALSE
An error has occurred.

UA (Recipe)

uaAddArchive

Description   
Adds a new recipe. This corresponds to the configuration of a new recipe using the "Recipes" 
editor.

Can only be used in C scripting.

Syntax
LONG uaAddArchive ( 
UAHCONFIG hConfig,
UACONFIGARCHIVE* pArchive )

Parameters

UAHCONFIG hConfig
Configuration handle for the recipe. This handle is generated using uaQueryConfiguration.
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UACONFIGARCHIVE* pArchive
Pointer to buffer for the recipe configuration memory

Return value
Index of the new recipe. An error corresponds to "-1".

 

See also
UaQueryConfiguration (Page 6037)

uaAddField

Description   
Adds a new data field.

Can only be used in C scripting.

Syntax
LONG uaAddField ( 
UAHCONFIG hConfig,
long lArchive,
UACONFIGFIELD* pField )

Parameters

UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration .

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

UACONFIGFIELD* pArchive
Pointer to buffer of the field configuration.

Return value
Index of the new field. A value of "-1" indicates an error.
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uaArchiveClose

Description   
Terminates the connection to the current recipe.

Can only be used in C scripting.

Syntax
BOOL uaArchiveClose ( 
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value

TRUE
Successful closing of the recipe

FALSE
Error

uaArchiveDelete

Description  
Deletes the data from a recipe. The configured recipe, however, is retained.

Can only be used in C scripting.

Syntax
BOOL uaArchiveDelete ( 
UAHARCHIVE hArchive,
LPCSTR pszWhere )
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LPCSTR pszWhere
This string contains the SQL selection expression. It defines which data records are to be 
deleted. The expression is equivalent to the SQL instruction "DELETE FROM <archive> 
WHERE pszWhere". 
Warning! If this string is empty, the entire recipe will be deleted.

Return value
TRUE 

Successful deletion of the recipe

FALSE

Error

 

uaArchiveExport

Description:   
Exports the current recipe to a log in CSV format.

Can only be used in C scripting.

Syntax
BOOL uaArchiveExport (
 UAHARCHIVE hArchive,
 LPCSTR pszDestination,
 LONG lType,
 LONG lOptions )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using UaQueryArchive or 
UaQueryArchiveByName. 
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LPCSTR pszDestination
File name of the target archive.

LONG lType
Data format of the target archive. Two formats are available:

● UA_FILETYPE_DEFAULT = 0: Default file format = CSV

● UA_FILETYPE_CSV = 1: CSV file format

LONG lOptions
Reserved for future expansions. Must be 0.

Return value
TRUE

Successful export of the recipe

FALSE 

Error

uaArchiveGetCount

Description   
Reads the number of data records.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetCount(
 UAHARCHIVE hArchive,
 LONG * plCount )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName . 

LONG plCount 
Pointer to a tag in which the number of data records should be stored.

Return value
Number of data records.
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0 = Log is empty or error has occurred. Must be queried by means of uaGetLastError() .

uaArchiveGetFieldLength

Description   
Reads the length of a field in the current data record.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetFieldLength(
 UAHARCHIVE hArchive,
 LONG lField )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

Return value
Length of the current field.

uaArchiveGetFieldName

Description   
Reads the name of a field in the current data record.

Can only be used in C scripting.

Syntax
VOID uaArchiveGetFieldName (
 UAHARCHIVE hArchive,
 LONG lField,
 LPCSTR pszName,
 LONG cMaxLen )
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

LPCSTR pszName
Field Name

LONG cMaxLen
Maximum length

uaArchiveGetFields

Description   
Reads the number of configured data fields, which also includes the "ID", "Last User", and 
"Last Access" fields. In the Runtime calls, the indexes of the configured fields are indicated 1 
to N. The field ID has the index 0. The fields "Last User" and "Last Access" are appended to 
the end of the configured fields.

Can only be used in C scripting.

Syntax
LONG uaArchiveGetFields (
 UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
Number of configured fields. 

uaArchiveGetFieldType 

Description   
Reads the type of a field in the current data record.
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Can only be used in C scripting.

Syntax
LONG uaArchiveGetFieldType (
UAHARCHIVE hArchive,
LONG lField )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

Return value
Type of the current field.

The symbolic definitions of the field types are:

UA_FIELDTYPE_INTEGER

UA_FIELDTYPE_DOUBLE

UA_FIELDTYPE_STRING

UA_FIELDTYPE_DATETIME

uaArchiveGetFieldValueDate

Description   
Reads the date and time of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueDate (
UAHARCHIVE hArchive,
LONG lField, 
LPSYSTEMTIME pstDateTime )
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive  or  
uaQueryArchiveByName . 

LONG lField
Field number, with lField = 1 addressing the first field.

LPSYSTEMTIME pstDateTime
Pointer to a tag of the type SYSTEMTIME

Return value
TRUE 

Successful reading of date and time

FALSE 

Error

uaArchiveGetFieldValueDouble

Description   
Reads the Double value of a field in the current data record.

The system function can be used in C scripting only.

BOOL uaArchiveGetFieldValueDouble (
UAHARCHIVE hArchive,
LONG lField, 
double* pdValue )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

double* pdValue
Pointer to tag for the current field content.
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Return value
TRUE 

Successful reading of field value

FALSE

Error

uaArchiveGetFieldValueFloat

Description   
Reads Float value of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueFloat (
UAHARCHIVE hArchive,
LONG lField, 
FLOAT* pfValue )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

FLOAT* pfValue
Pointer to Float tag for the current field content.

Return value
TRUE

Successful reading of field value

FALSE

Error
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uaArchiveGetFieldValueLong

Description   
Reads the Long Integer value of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueLong (
UAHARCHIVE hArchive,
LONG lField, 
LONG* pdValue )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

LONG* pdValue
Pointer to Long tag for the current field content.

Return value
TRUE 

Successful reading of field value

FALSE 

Error

uaArchiveGetFieldValueString

Description   
Reads the string of a field in the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveGetFieldValueString (
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UAHARCHIVE hArchive,
LONG lField, 
LPSTR pszString,
LONG cMaxLen )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first field.

LPCSTR pszString
Field value as string.

LONG cMaxLen
Maximum length of the string.

Return value
TRUE 

Successful reading of field value

FALSE 

Error

uaArchiveGetFilter

Description   
Reads the filter of the current data record. Additional information can be found in the appendix 
under "SQL Statements". 

Can only be used in C scripting.

Syntax
VOID uaArchiveGetFilter (
 UAHARCHIVE hArchive,
 LPSTR pszFilter,
 LONG cMaxLen )
The system function can be used in C scripting only.
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LPSTR pszFilter
Read filter.

LONG cMaxLen
Maximum length

uaArchiveGetID

Description   
uaArchiveGetID reads the ID of the recipe.

The recipe ID serves internal purposes and may differ from the number given in the recipe. 

Can only be used in C scripting.

Syntax
LONG uaArchiveGetID (
 UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
ID of the recipe.

uaArchiveGetName

Description   
Reads the name of the recipe.

Can only be used in C scripting.
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Syntax
VOID uaArchiveGetName (
UAHARCHIVE hArchive,
LPSTR pszName,
LONG cMaxLen )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LPSTR pszName
Pointer to buffer for recipe name.

LONG cMaxLen
Maximum length

Example
char Filling [40];

uaArchiveGetName( hArchive, bottling, 39 );

uaArchiveGetSor

Description   
uaArchiveGetSort reads the sorting of the recipe. 

Can only be used in C scripting.

Syntax
VOID uaArchiveGetSort (
UAHARCHIVE hArchive,
LPSTR pszSort,
LONG cMaxLen )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 
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LPCSTR pszSort
Sorting

LONG cMaxLen
Maximum length

uaArchiveImport

Description   
uaArchivImport imports a recipe with CSV data format. The structure of the destination recipe 
must be identical to that of the imported recipe.

Syntax
BOOL uaArchiveImport (
UAHARCHIVE hArchive,
LPCSTR pszSource,
LONG lType,
LONG lOptions )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LPCSTR pszSource
File name of the source archive.

LONG lType
Data format of the source archive. Two formats are available:

UA_FILETYPE_DEFAULT = 0: Default file format = CSV

UA_FILETYPE_CSV = 1: CSV file format

LONG lOptions
Reserved for future expansions. Must be 0.

Return value
TRUE 

Successful import of the recipe.

FALSE 
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Error

uaArchiveInsert

Description   
Inserts the local data record buffer into the current database. Before you call uaArchiveInsert, 
use the "uaArchiveSetFieldValue..." system functions to enter the data in the fields of the local 
data buffer so that the new data record contains useful data.
Use system function "uaArchiveSetFieldValueLong" to enter the internal column "ID" in the 
current data record. Can only be used in C scripting.

Syntax
BOOL uaArchiveInsert (
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE 

Successful insertion of the data record.

uaArchiveMoveFirst

Description   
Goes to the first data record. 

Can only be used in C scripting.

Syntax
BOOL uaArchiveMoveFirst (
UAHARCHIVE hArchive )
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE 

Successful jumping in the recipe

FALSE 

Error

uaArchiveMoveLast 

Description   
Goes to the last data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveMoveLast (
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName . 

Return value
TRUE 

Successful jumping in the recipe

FALSE 

Error

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 6013



uaArchiveMoveNext

Description   
Goes to the next data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveMoveNext (
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE 

Successful jumping in the recipe

FALSE 

Error

uaArchiveMovePrevious

Description   
Goes to the previous data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveMovePrevious (
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 
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Return value
TRUE

Successful jumping in the recipe

FALSE

Error

uaArchiveOpen

Description   
uaArchiveOpen opens an existing recipe. It is always necessary to call uaArchiveOpen to run 
read or write operations at this recipe. uaArchiveOpen must be called by the 
uaArchiveMoveFirst, uaArchiveMoveLast, uaArchiveMoveNext, uaArchiveMovePrevious, 
uaArchiveDelete, uaArchiveUpdate, and uaArchiveInsert system functions prior to its call. 

 

 Note
Sort and filter recipes

You may apply the "uaArchiveSetSort" and "uaArchiveSetFilter" system functions to a recipe 
without having to open this recipe by means of "uaArchiveOpen".

 

Can only be used in C scripting.

Syntax
BOOL uaArchiveOpen (
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE 

Successful opening of the recipe

FALSE

Error
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uaArchiveReadTagValues

Description   
Reads the current value from the field tag.

Can only be used in C scripting.

Syntax
BOOL uaArchiveReadTagValues (
UAHARCHIVE hArchive,
LONG* pnFields,
LONG cFields,
LONG lOptions )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG* pnFields
Reserved for future applications (NULL)

LONG cFields
Number of field indices transferred (size of array pnFields).

Reserved for future applications (0)

LONG lOptions
Reserved for future applications (0)

In the case of all other values of lOptions, the data is inserted at the position of the pointer.

Return value
TRUE 

Successful reading in the recipe

FALSE 

Error
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uaArchiveReadTagValuesByName

Description   
Reads the tag values in the current data.

Can only be used in C scripting.

Syntax
BOOL uaArchiveReadTagValuesByName (
UAHARCHIVE hArchive,
LPCSTR pszFields,
LONG lOptions )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using  uaQueryArchive  or 
uaQueryArchiveByName. 

LPCSTR pszFields
Reserved for future applications (NULL)

LONG lOptions
Reserved for future applications (0)

Return value
TRUE 

Successful reading in the recipe

FALSE 

Error
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uaArchiveRequery

Description   
On completion of the call of uaArchiveSetFilter and uaArchiveSetSort, reload the recipe by 
means of uaArchiveRequery. 

 

 Note
Sort and filter recipes

You may apply the "uaArchiveSetSort" and "uaArchiveSetFilter" system functions to a recipe 
without having to open this recipe by means of "uaArchiveOpen". In this case you do no have 
to call the system function "uaArchiveRequery". 

 

Call uaArchiveRequery in the following situations as well:

● If you have made inputs in the recipe view.

● If you have made inputs in the "Recipes" editor that are to be transferred to the table cell.

Syntax
BOOL uaArchiveRequery(
UAHARCHIVE hArchive )
Can only be used in C scripting.

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE

Successful requery

FALSE 

Error

uaArchiveSetFieldValueDate

Description   
Writes the date and time into a field of the current data record.

Can only be used in C scripting.
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Syntax
BOOL uaArchiveSetFieldValueDate (
UAHARCHIVE hArchive,
LONG lField, 
LPSYSTEMTIME pstDateTime )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first configured field. The ID field is addressed 
with lField = 0.

LPSYSTEMTIME pstDateTime
Date and Time

Return value
TRUE

Successful writing of date and time

FALSE

Error

uaArchiveSetFieldValueDouble

Description   
Writes a Double value into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueDouble (
UAHARCHIVE hArchive,
LONG lField, 
double dValue )
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
The field number, where lField = 1 is addressing the first configured field. The ID field is 
addressed with lField = 0.

double dValue
Field value

Return value
TRUE

Successful writing of field value

FALSE

Error

uaArchiveSetFieldValueFloat

Description:   
Writes a Float value into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueFloat (
UAHARCHIVE hArchive,
LONG lField, 
float fValue )

Parameters:

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
Field number, with lField = 1 addressing the first configured field. The ID field is addressed 
with lField = 0.
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float fValue
Field value

Return value:
TRUE

Successful writing of field value

FALSE

Error

uaArchiveSetFieldValueLong

Description   
Writes a Long Integer value into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueLong (
UAHARCHIVE hArchive,
LONG lField, 
LONG dValue )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
The field number, where lField = 1 is addressing the first configured field. The ID field is 
addressed with lField = 0.

LONG dValue
Field value

Return value
TRUE 

Successful writing of field value

FALSE 
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Error

uaArchiveSetFieldValueString 

Description   
Writes a String into a field of the current data record.

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetFieldValueString (
UAHARCHIVE hArchive,
LONG lField, 
LPCSTR pszString )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG lField
The field number, where lField = 1 is addressing the first configured field. The ID field is 
addressed with lField = 0 .

LPCSTR pszString
Field value

Return value
TRUE

Successful writing of field value

FALSE

Error
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uaArchiveSetFilter

Description   
Sets the filter. You can call the system function without having opened the recipe with 
"uaArchiveOpen". 

 

 Note

If you have opened the recipe with "uaArchiveOpen", reload the recipe after filtering by means 
of "uaArchiveRequery". 

 

Can only be used in C scripting.

Syntax
VOID uaArchiveSetFilter (
 UAHARCHIVE hArchive,
 LPSTR pszFilter )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LPSTR pszFilter
Filter to be set.

uaArchiveSetSort

Description   
Sets the sorting of the recipe. You can call the system function without having opened the 
recipe with "uaArchiveOpen". 

 

 Note

If you have opened the recipe with "uaArchiveOpen", reload the recipe after sorting by means 
of "uaArchiveRequery". 

 

Can only be used in C scripting.

Syntax
BOOL uaArchiveSetSort (
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UAHARCHIVE hArchive,
LPSTR pszSort )
The system function can be used in C scripting only.

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LPCSTR pszSort
Sorting

Return value
TRUE

Successful setting of the sorting

FALSE

Error

uaArchiveUpdate

Description   
Updates the open recipe. All data changes of a recipe are transferred to the database. The 
configuration of the recipe remains unchanged.

Can only be used in C scripting.

Syntax
BOOL uaArchiveUpdate (
UAHARCHIVE hArchive )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE 
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Successful update of the recipe

FALSE

"Update_failed" error = 106

This error occurs when there is a consistency violation. Example: The "Field requires a value" 
flag is set in a field, but no value has been entered there.

uaArchiveWriteTagValues

Description   
Writes the values of the current data record into the tags.

Can only be used in C scripting.

Syntax
BOOL uaArchiveWriteTagValues (
UAHARCHIVE hArchive,
LONG* pnFields,
LONG cFields,
LONG lOptions )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

LONG* pnFields
Reserved for future applications (NULL)

LONG cFields
Reserved for future applications (0)

LONG lOptions
Reserved for future applications (0)

Return value
TRUE

Successful reading in the recipe

FALSE

Error
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uaArchiveWriteTagValuesByName

Description   
Writes the values of the current data record into the tags. The access is based on the names 
of the recipe and field.

Can only be used in C scripting.

Syntax
BOOL uaArchiveWriteTagValuesByName (
UAHARCHIVE hArchive,
LPCSTR pszFields,
LONG lOptions )

Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive  or 
uaQueryArchiveByName. 

LPCSTR pszFields
Reserved for future applications (NULL)

LONG lOptions
Reserved for future applications (0)

Return value
TRUE

Successful reading in the recipe

FALSE

Error

uaConnect

Description   
Establishes connection to recipes (Runtime).

Can only be used in C scripting.
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Syntax
BOOL uaConnect (
 UAHCONNECT* phConnect )

Parameters

UAHCONNECT* phConnect
Pointer to handle for newly connected recipe.

Return value
TRUE

Successful connection of a recipe

FALSE

Error

uaDisconnect

Description   
If a connection to recipes (Runtime) exists, it will be disconnected.

Can only be used in C scripting.

Syntax
BOOL uaDisconnect (
 UAHCONNECT hConnect )

Parameters

UAHCONNECT hConnect
Handle for the connected recipe (Runtime). The handle is generated using uaConnect.

Return value
TRUE

Successful disconnection of a recipe

FALSE

Error
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uaGetArchive

Description   
Reads the recipe configuration.

Can only be used in C scripting.

Syntax
BOOL uaGetArchive ( 
UAHCONFIG hConfig,
long lArchive,
UACONFIGARCHIVE* pArchive )

Parameters

UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

UACONFIGARCHIVE* pArchive
Pointer to buffer for receiving the recipe configuration

Return value
TRUE 

Successful access to the recipe

FALSE

Error

uaGetField

Description:   
Reads the field configuration.

Can only be used in C scripting.

Syntax
BOOL uaGetField ( 
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UAHCONFIG hConfig,
long lArchive,
long lField,
UACONFIGFIELD* pField )

Parameters:

UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

long lField,
The field number; if lField = 0 the first field is addressed.

UACONFIGFIELD* pArchive
Pointer to buffer for receiving the field configuration.

Return value
TRUE

Successful access to the recipe

FALSE

Error

uaGetLastError 

Description   
The system functions of the WinCC script language return a BOOL value; TRUE corresponds 
to error-free processing. If FALSE is returned, you can use "uaGetLastError()" and 
"uaGetLastHResult()" to read the error of the last system function.

Can only be used in C scripting.

If you do not call  uaGetLastError() until several system functions have been processed, 
uaGetLastError() will return the most recent error. You should call a "uaGetLastError()" and 
"uaGetLastHResult()" system function whenever FALSE is returned to identify the system 
function that triggered the error.

Example:

if ( uaArchiveGetFieldValueLong ( hArchive, Index, &IntValue ) == 
TRUE )
printf( "Field Value = %u\n", IntValue );
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else
printf("Error calling uaArchiveGetFieldValueLong: %d / %08lx\n", 
uaGetLastError(), uaGetLastHResult());
You should always query system functions that do not return a value (VOID) by calling  
uaGetLastError() .

Example:

   uaArchiveGetFilter(hArchive, pszFilter, cMaxLen);
    INT nUAError = uaGetLastError (  );
    if ( UA_ERROR_SUCCESS != nUAError)
    {
        printf( "Filter = [%s]\n", pszFilter );
    }
    else
    {
        printf("Error calling uaArchiveGetFilter: %d, hr=0x%08lX\n", 
nUAError, uaGetLastHResult());
    }
 

INT uaGetLastError()

Return value
Error status of the last system function executed. uaGetLastError()  can return the following 
errors:

UA_ERROR_SUCCESS

UA_ERROR_GENERIC

UA_ERROR_CONNECT_FAILED

UA_ERROR_OPEN_FAILED

UA_ERROR_CLOSE_FAILED

UA_ERROR_REQUERY_FAILED

UA_ERROR_MOVE_FAILED

UA_ERROR_INSERT_FAILED

UA_ERROR_UPDATE_FAILED

UA_ERROR_DELETE_FAILED

UA_ERROR_IMPORT_FAILED

UA_ERROR_EXPORT_FAILED

UA_ERROR_READ_FAILED
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UA_ERROR_WRITE_FAILED

UA_ERROR_GET_FAILED

UA_ERROR_SET_FAILED

UA_ERROR_INVALID_NAME

UA_ERROR_INVALID_TYPE

UA_ERROR_INVALID_NUMRECS

UA_ERROR_INVALID_COMMTYPE

UA_ERROR_INVALID_LENGTH

UA_ERROR_INVALID_PRECISION

UA_ERROR_NULL_POINTER

UA_ERROR_INVALID_POINTER

UA_ERROR_INVALID_HANDLE

UA_ERROR_INVALID_INDEX

UA_ERROR_SERVER_UNKNOWN

These error constants as well as the predefines of the user archive routines are located in 
CCUACAPI.H.

uaGetLastHResult 

Description   
Reads the last occurred COM error. This system function is used primarily to analyze 
incompatibility in the COM implementation or to identify registry errors and communication 
errors.
This system function must always be called in addition to UAGetLastError if one of the user 
archive system functions (e.g uaConnect) returns the value "FALSE" to signal an error.

Can only be used in C scripting.

Syntax
LONG uaGetLastHResult()

Return value
Last occurred COM error

uaGetNumArchives

Description   
Reads the number of recipes currently configured.
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Can only be used in C scripting.

Syntax
LONG uaGetNumArchives ( 
UAHCONFIG hConfig )

Parameters

UAHCONFIG hConfig
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

Return value
Number of recipes currently configured. In case of an error, -1 will be returned.

uaGetNumFields

Description   
Supplies the number of the configured fields. The "ID", "Last User" and "Last Access" fields 
are not included. Indexes are specified from 0 to uaGetNumFields() -1 in the configuration 
calls.

Can only be used in C scripting.

Syntax
LONG uaGetNumFields ( 
UAHCONFIG hConfig,
long lArchive )

Parameters

UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

Return value
Number of configured fields. In case of an error, -1 will be returned.
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uaQueryArchive 

Description   
Establishes a connection to the recipe for Runtime operation. UaQueryArchive creates the 
UAHARCHIVE handle.

Can only be used in C scripting.

Syntax
BOOL uaQueryArchive (
UAHCONNECT hConnect,
 LONG lArchive,
 UAHARCHIVE* phArchive )

Parameters

UAHCONNECT hConnect
Handle of the connected recipe (Runtime). The handle is generated using uaConnect.

LONG lArchive
Archive index (0... uaGetNumArchives() -1)

UAHARCHIVE* phArchive
Pointer to handle of the recipe

Return value
TRUE

Successful generation of the handle to the recipe.

FALSE

Error

Comment
If you use User Archives functions in a client project that works with redundant server pairs, 
the user archives connection cannot be switched automatically to the new master when 
switching masters. In this case, all user archives calls return the LastError 
UA_ERROR_SERVER_UNKNOWN = 1004, which means that the user programs must 
execute a new uaQueryArchive() or uaQueryArchiveByName() and uaArchiveOpen(). 

Visualize processes
10.8 Working with system functions and Runtime scripting

WinCC Professional V13.0
System Manual, 02/2014 6033



uaQueryArchiveByName 

Description   
Establishes a connection to the recipe for Runtime operation using the recipe name. 
UaQueryArchiveByName creates the UAHARCHIVE handle for the recipe.

Can only be used in C scripting.

Syntax
BOOL uaQueryArchiveByName (
UAHCONNECT hConnect,
 LPCSTR pszName,
 UAHARCHIVE* phArchive )

Parameters

UAHCONNECT hConnect
Handle of the connected recipe (Runtime). The handle is generated using uaConnect.

LPCSTR pszName
Name of the recipe. With a client project, you can add a server prefix with ‘::‘ to the recipe 
name as a separator, if a server other than the default server is used. 

UAHARCHIVE* phArchive
Pointer to handle of the recipe

Return value
TRUE

Successful generation of the handle to the recipe.

FALSE

Error

Comment
If you use User Archives functions in a client project that works with redundant server pairs, 
the user archives connection cannot be switched automatically to the new master when 
switching masters. In this case, all user archives calls return the  LastError 
UA_ERROR_SERVER_UNKNOWN = 1004, which means that the user programs must 
execute a new uaQueryArchive()  or uaQueryArchiveByName()  and uaArchiveOpen(). 
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UaQueryConfiguration

Description   
Establishes a connection to the recipe for the configuration.

Can only be used in C scripting.

Syntax
BOOL uaQueryConfiguration ( 
UAHCONFIG* phConfig )

Parameters

UAHCONFIG* phConfig,
Pointer to handle of the recipe. 

Return value
TRUE

Successful access to recipe

FALSE

Error

See also
uaAddArchive (Page 5997)

uaReleaseArchive

Description   
Releases the connection to the current recipe.

Can only be used in C scripting.

Syntax
BOOL uaReleaseArchive (
 UAHARCHIVE hArchive )
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Parameters

UAHARCHIVE hArchive
Handle of the recipe. This handle is generated using uaQueryArchive or 
uaQueryArchiveByName. 

Return value
TRUE

Successful release of connection to the recipe.

FALSE

Error

Comment
The "hArchive" handle must be set to "NULL" on successful release to make absolutely sure 
that the "UA_ERROR_INVALID_HANDLE" error is triggered on further use of the invalid handle 
and without the respective function dwelling at the COM interface for a longer period of time.

uaReleaseConfiguration 

Description   
Releases connection to recipes (configuration).

Can only be used in C scripting.

Syntax
BOOL uaReleaseConfiguration ( 
UAHCONFIG hConfig,
BOOL bSave )

Parameters

UAHCONFIG hConfig
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

BOOL bSave
Saves changes made to the configuration before releasing the connection to recipes for the 
configuration. 

TRUE = Save Changes, FALSE = Discard Changes

Warning: Save changes (bSave = TRUE) may only be used when Runtime 
is not active! You can check whether Runtime is active by requesting uaIsActive().
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Return value
TRUE

Successful connection release

FALSE

Error

uaRemoveAllArchives 

Description   
Deletes all recipes that are not used in views.

Can only be used in C scripting.

Syntax
BOOL uaRemoveAllArchives
( UAHCONFIG hConfig )

Parameters

UAHCONFIG hConfig
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

Return value
TRUE

Successful deletion

FALSE

Error

Comment
On completion, you can query "uaGetNumArchives()" to verify deletion of all recipes.

uaRemoveAllFields

Description   
Removes all fields.

Can only be used in C scripting.
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Syntax
BOOL uaRemoveAllFields ( 
UAHCONFIG hConfig,
long lArchive )

Parameters

UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

Return value
TRUE

Successful deletion of fields

FALSE

Error

uaRemoveArchive

Description   
uaRemoveArchive deletes the entire configured recipe.

Can only be used in C scripting.

Syntax
BOOL uaRemoveArchive ( 
UAHCONFIG hConfig,
long lArchive )

Parameters

UAHCONFIG hConfig,
Configuration handle of the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))
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Return value
TRUE

Successful deletion of the recipe.

FALSE

Error

uaRemoveField

Description   
Removes a field.

Can only be used in C scripting.

Syntax
BOOL uaRemoveField ( 
UAHCONFIG hConfig,
long lArchive,
long lField )

Parameters

UAHCONFIG hConfig,
Configuration handle for the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

long lField,
Field number, with  lField = 0  addressing the first field.

Return value

TRUE
Successful deletion of field

FALSE
Error
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uaSetArchive

Description:   
Sets the configuration of a recipe.

Can only be used in C scripting.

Syntax
BOOL uaSetArchive ( 
UAHCONFIG hConfig,
long lArchive,
UACONFIGARCHIVE* pArchive
 )

Parameters

UAHCONFIG hConfig,
Configuration handle for the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

UACONFIGARCHIVE* pArchive
Pointer to pArchive buffer with the recipe configuration.

Return value

TRUE
Successful access to recipe.

FALSE
An error has occurred.

uaSetField

Description   
Sets the field configuration.

Can only be used in C scripting.
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Syntax
BOOL uaSetField ( 
UAHCONFIG hConfig,
long lArchive,
long lField,
UACONFIGFIELD* pField )

Parameters

UAHCONFIG hConfig,
Configuration handle for the recipe. This handle is generated using uaQueryConfiguration.

long lArchive,
Archive index (0 to (uaGetNumArchives()-1))

long lField,
Field number, with lField = 0 addressing the first field.

UACONFIGFIELD* pField
Pointer to buffer of the field configuration.

Return value
TRUE 

Successful access to recipe.

FALSE 

Error

C-bib

ctype functions

Function overview
The following ctype functions are available:

● long int isalnum (long int x);

● long int isalpha (long int x);

● long int isdigit (long int x);

● long int isgraph (long int x);

● long int islower (long int x);
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● long int isprint (long int x);

● long int ispunct (long int x);

● long int isspace (long int x);

● long int isupper (long int x);

● long int isxdigit (long int x);

● long int tolower (long int x);

● long int toupper (long int x);

For a description of the ctype functions see the specialist literature on programming language 
C. 

The functions can be used in C scripts only.

 

Function group c_bib

Introduction
The c_bib function group contains C functions from the C library and is divided into: 

● ctype

● math

● memory

● stdio

● stdlib

● string

● time

stdio itself is again divided into:

● char_io

● directio

● error

● file

● file_pos

● output

For a description of these functions see the relevant specialist literature.
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Specific features of WinCC functions
The localtime function behaves as follows when the date is issued:

● The counting of the months begins with 0.

● The years are counted as of 1990, starting with 0.

Only 360 characters of the functions of the C library printf(), sprintf(), fprintf() can be edited in 
WinCC. 

math functions 

Function overview
The following math functions are available:

● double acos (double x);

● double asin (double x);

● double atan (double x);

● double atan2 (double x, double y);

● double ceil (double x);

● double cos (double x);

● double cosh (double x);

● double exp (double x);

● double fabs (double x);

● double floor (double x);

● double fmod (double x, double y);

● double frexp (double x, long int* y);

● double ldexp (double x, long int y);

● double log (double x);

● double log10 (double x);

● double modf (double x, double* y);

● double pow (double x, double y);

● double sin (double x);

● double sinh (double x);

● double sqrt (double x);

● double tan (double x);

● double tanh (double x);

For a description of the math functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.
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memory functions

Function overview
The following memory functions are available:

● long int memcmp (const void* cs, const void* ct, size_t n);

● void* memchr (const void* cs, long int c, size_t n);

● void* memcpy (void* s, const void* ct, size_t n);

● void* memmove (void* s, const void* ct, size_t n);

● void* memset (void* s, long int c, size_t n);

For a description of the memory functions see the specialist literature on programming 
language C.

The functions can be used in C scripts only.

multibyte functions

Function overview
The following multibyte functions are available:

● int _ismbcalnum( unsigned int c )

● int _ismbcalpha( unsigned int c )

● int _ismbcdigit( unsigned int c )

● int _ismbcgraph( unsigned int c )

● int _ismbclower( unsigned int c )

● int _ismbcprint( unsigned int c )

● int _ismbcpunct( unsigned int c )

● int _ismbcspace( unsigned int c )

● int _ismbcupper( unsigned int c )

● int _mbscmp(const unsigned char *string1, const unsigned char *string2 )

● int _mbsncmp( const unsigned char *string1, const unsigned char *string2, size_t count )

● int _mbsrchr( const unsigned char *string, unsigned int c )

● size_t _mbscspn( const unsigned char *string, const unsigned char *strCharSet )

● size_t _mbsspn( const unsigned char *string, const unsigned char *strCharSet )

● size_t _mbstrlen( const char *string )

● size_t _mbslen( const unsigned char *string )
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● unsigned char *_mbscat( unsigned char *strDestination, const unsigned char *strSource)

● unsigned char *_mbschr( const unsigned char *string, unsigned int c )

● unsigned char *_mbscpy( unsigned char *strDestination, const unsigned char *strSource )

● unsigned char *_mbsdec( const unsigned char *start, const unsigned char *current )

● unsigned char *_mbsinc( const unsigned char *current ) size_t _mbclen( const unsigned 
char *c );

● unsigned char *_mbsncat( unsigned char *strDest, const unsigned char *strSource, size_t 
count)

● unsigned char *_mbsncpy( unsigned char *strDest, const unsigned char *strSource, size_t 
count)

● unsigned char *_mbspbrk( const unsigned char*string, const unsigned char *strCharSet )

● unsigned char *_mbsstr( const unsigned char *string, const unsigned char *strCharSet )

● unsigned char *_mbstok( unsigned char*strToken, const unsigned char *strDelimit )

A description of the multibyte functions can be found in the specialist literature on programming 
language C.

The functions can be used in C scripts only.

stdio functions

Function overview
The following stdio functions are available:

● char* fgets (char* s, long int n, FILE* stream);

● char* tmpnam (char* s);

● FILE* fopen (const char* name, const char* mode);

● FILE* freopen (const char* filename, const char* mode, FILE* stream);

● FILE* tmpfile ();

● fprintf();

● long int fclose (FILE* stream);

● long int feof (FILE* stream);

● long int ferror (FILE* stream);

● long int fflush (FILE* stream);

● long int fgetc (FILE* stream);

● long int fgetpos (FILE* stream, fpos_t* ptr);

● long int fputc (long int c, FILE* stream);

● long int fputs (const char* s, FILE* stream);

● long int fseek (FILE* stream, long int offset, long int origin);
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● long int fsetpos (FILE* stream, const fpos_t* ptr);

● long int ftell (FILE* stream);

● long int getc (FILE* stream);

● long int putc (long int c, FILE* stream);

● long int remove (const char* filename);

● long int rename (const char* oldname, const char* newname);

● long int setvbuf (FILE* stream, char* buf, long int mode, size_t size);

● long int ungetc (long int c, FILE* stream);

● long int vfprintf (FILE* stream, const char* format, va_list arg);

● long int vsprintf (char* s, const char* format, va_list arg);

● printf();

● size_t fread (void* ptr, size_t size, size_t nobj, FILE* stream);

● size_t fwrite (void* ptr, size_t size, size_t nobj, FILE* stream);

● void clearerr (FILE* stream);

● void rewind (FILE* stream);

● void setbuf (FILE* stream, char* buf);

For a description of the studio functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

stdlib functions

Function overview
The following stdlib functions are available:

● char* getenv (const char* name);

● div_t div (long int num, long int denom);

● double atof (const char* s);

● double strtod (const char* s, char** endp);

● ldiv_t ldiv (long int num, long int denom);

● long int abs (long int n);

● long int atoi (const char* s);

● long int atol (const char* s);

● long int labs (long int n);

● long int rand ();

● long int srand (unsigned long int seed);
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● long int strtol (const char* s, char** endp, long int base);

● long int system (const char* s);

● unsigned long int strtoul (const char* s, char** endp, long int base);

● void abort ();

● void* bsearch (const void* key, const void* base, size_t n, size_t size, long int(* cmp) (const 

● void* calloc (size_t nobj, size_t size);

● void exit (long int status);

● void free (void* p);

● void* keyval, const void* datum));

● void* malloc (size_t size);

● void qsort (void* base, size_t n, size_t size, long int* cmp, const void* , const void* );

● void* realloc (void* p, size_t size);

For a description of the stdlib functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

string functions

Function overview
The following string functions are available:

● char* strcat (char* s, const char* ct);

● char* strchr (const char* cs, long int c);

● char* strcpy (char* s, const char* ct);

● char* strerror (size_t n);

● char* strncat (char* s, const char* ct, size_t n);

● char* strncpy (char* s, const char* ct, size_t n);

● char* strpbrk (const char* cs, const char* ct);

● char* strrchr (const char* cs, long int c);

● char* strstr (const char* cs, const char* ct);

● char* strtok (char* s, const char* ct);

● long int strcmp (const char* cs, const char* ct);

● long int strncmp (const char* cs, const char* ct, size_t n);

● size_t strcspn (const char* cs, const char* ct);

● size_t strlen (const char* cs);

● size_t strspn (const char* cs, const char* ct);
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For a description of the string functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

time functions 

Function overview
The following time functions are available:

● char* asctime (const struct tm* tp);

● char* ctime (const time_t* tp);

● clock_t clock ();

● double difftime (time_t time2, time_t time1);

● size_t strftime (char* s, size_t smax, const char* fmt, const struct tm* tp);

● struct tm* gmtime (const time_t* tp);

● struct tm* localtime (const time_t* tp);

● time_t mktime (struct tm* tp);

● time_t time (time_t* tp);

For a description of the time functions see the specialist literature on programming language 
C.

The functions can be used in C scripts only.

Structure definition

Structure definition CCAPErrorExecute

 
typedef struct {
DWORD dwCurrentThreadID; Thread ID of the current thread
DWORD dwErrorCode1;      Error code 1
DWORD dwErrorCode2;      Error code 2
BOOL bCycle;             cycle/acycle
char* szApplicationName; Name of the application
char* szFunctionName;    Name of the function
char* szTagName;         Name of the tag
LPVOID lpParam;          Pointer to the action stack
DWORD dwParamSize;       Size of the action stack
DWORD dwCycle;           Cycle of the tag
CMN_ERROR* pError;       Pointer to CMN_ERROR
} CCAPErrorExecute;
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Members
The meaning of the individual error IDs and the structure elements depending on them are 
specified in the following table:

100700
1

0 x x x  x x   Action requires exception

100700
1

1 x x x  x x   Exception when 
accessing the return 
result

100700
1

4097 x x x  x x   Stack overflow while 
executing the action

100700
1

4098 x x x  x x   The action contains a 
division by 0

100700
1

4099 x x x  x x   The action contains an 
access to a non-existing 
symbol

100700
1

4100 x x x  x x   The action contains an 
access violation

100700
4

0 x x x      Function is not known

100700
5

1 x x       Action does not include a 
P code.

100700
5

2 x x       Incorrect function name

100700
5

4 x x x  x x   Return value type is 
invalid

100700
5

32768f
f

x x x  x x   Ciss Compiler error when 
loading the action

100700
6

0 x x x x x x x  Tag is not defined

100700
6

1 x x x x x x x  Tag timeout

100700
6

2 x x x x x x x x Tag cannot be returned in 
the desired format

100700
6

3 x x x x x x x x Tag returns status 
violation, status present 
in 
CMN_ERROR.dwError1 

100700
7

1 x x x  x x  x Error with 
PDLRTGetProp

100700
7

2 x x x  x x  x Error with PDLRTSetProp

100700
7

3 x x x  x x  x Error with DM call
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Error structure
The OnErrorExecute function uses the error structure to evaluate or to output error messages, 
if marked by an "x" in the pError column.

Structure definition CCAPTime

 
typedef struct {
DWORD dwCurrentThreadID; ThreadID of the current Thread
DWORD dwCode;            Code
BOOL bCycle;             cycle/acycle
char* szApplicationName; Name of the Application
char* szFunctionName;    Name of the Function
LPVOID lpParam;          Pointer to the Action-Stack
DWORD dwParamSize;       size of the Action-Stack
double dblTime;
DWORD dwFlags;           flags
} CCAPTime;

 

 

Members

dwCode
The structure element dwCode provides information on calling of OnTime:

dwCode = 113 Call with time definition for each action
dwCode = 114 Call with time monitoring for each action

 

dwFlags
The structure element dwFlags provides information on the output type:

dwFlags = TRUE The results are output to a file
dwFlags = FALSE The results are output to the diagnostics window

Structure definition CMN_ERROR

 
struct CMNERRORSTRUCT {
DWORD       dwError1,
DWORD       dwError2,
DWORD       dwError3,
DWORD       dwError4,
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DWORD       dwError5;
TCHAR       szErrorText[MAX_ERROR_LEN];
}
CMN_ERROR

Description
The extended error structure contains the error code and an error text for the error that has 
occurred. Each application can use the error structure to evaluate or to output error messages.

 

Members

dwError1 .. dwError5
These entries can be used in any way by the API functions.

The API descriptions inform about the values the respective entries contain in case of an error. 
If not specified otherwise, the error codes are present in dwError1.

szErrorText
Buffer for the text description of the error cause

The content is determined from the resources and therefore language-dependent. 

Structure definition DM_TYPEREF

 
typedef struct {
DWORD dwType;
DWORD dwSize;
char szTypeName[MAX_DM_TYPE_NAME + 1];
}
DM_TYPEREF;

Members

dwType
Specifies the tag type

dwType PLC data type HMI data type
DM_VARTYPE_BIT Binary tag Bool
DM_VARTYPE_SBYTE Signed 8-bit value Byte
DM_VARTYPE_BYTE Unsigned 8-bit value UByte
DM_VARTYPE_SWORD Signed 16-bit value Short
DM_VARTYPE_WORD Unsigned 16-bit value UShort
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dwType PLC data type HMI data type
DM_VARTYPE_SDWORD Signed 32-bit value Integer
DM_VARTYPE_DWORD Unsigned 32-bit value UInteger
DM_VARTYPE_FLOAT Floating-point number 32-bit IEEE 754 Float
DM_VARTYPE_DOUBLE Floating-point number 64-bit IEEE 754 Double
DM_VARTYPE_TEXT_8 Text tag, 8-bit character set Char
DM_VARTYPE_TEXT_16 Text tag, 16-bit character set String
DM_VARTYPE_RAW Raw data type Raw
DM_VARTYPE_STRUCT Structure tag Struct
DM_VARTYPE_TEXTREF Text reference tag String

 

dwSize
Specifies the length of the data type in bytes.

szTypeName
In the case of structure tags, contains the name of the structure type

Structure definition DM_VAR_UPDATE_STRUCT

 
typedef struct {
DM_TYPEREF dmTypeRef;
DM_VARKEY dmVarKey;
VARIANT dmValue;
DWORD dwState;
}
DM_VAR_UPDATE_STRUCT;

Members

dmTypeRef
Contains information on the data type. For performance reasons, nothing is entered into this 
structure in case of cyclic requests.

dmVarKey
Specifies the tags to be edited.

dmValue
Tag value

Upon access to the value of the VARIANT a ".u." has to be inserted between the name of the 
VARIANT and the name of the member.

 
Example
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// Supply variant
myVariant.vt = VT_I4;
myVariant.u.lVal = 233;
A description of the data type VARIANT can be found in the associated documentation. The 
VARIANT dmValue must be initialized with VariantInit() before first use and enabled again with 
VariantClear(&dmValue) after use. For this reason, the structure 
DM_VAR_UPDATE_STRUCT must not be deleted with ZeroMemory() or memset().

dwState
Identifies the tag status.

Structure definition DM_VAR_UPDATE_STRUCTEX

 
typedef struct {
DM_TYPEREF dmTypeRef;
DM_VARKEY dmVarKey;
VARIANT dmValue;
DWORD dwState;
DWORD dwQualityCode;
}
DM_VAR_UPDATE_STRUCTEX;

Members

dmTypeRef
Contains information on the data type. For performance reasons, nothing is entered into this 
structure in case of cyclic requests.

dmVarKey
Specifies the tags to be edited.

dmValue
Tag value

Upon access to the value of the VARIANT a ".u." has to be inserted between the name of the 
VARIANT and the name of the member.

 
Example
// Supply variant
myVariant.vt = VT_I4;
myVariant.u.lVal = 233;
A description of the data type VARIANT can be found in the associated documentation. The 
VARIANT dmValue must be initialized with VariantInit() before first use and enabled again with 
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VariantClear(&dmValue) after use. For this reason, the structure 
DM_VAR_UPDATE_STRUCTEX must not be deleted with ZeroMemory() or memset().

dwState
Identifies the tag status.

dwQualityCode
Identifies the QualityCode tag.

Structure definition DM_VARKEY 

 
typedef struct {
DWORD dwKeyType;
DWORD dwID;
char szName[ MAX_DM_VAR_NAME + 1 ];
LPVOID lpvUserData;
}
DM_VARKEY;

Members

dwKeyType
Defines whether the tag is to be addressed by a key ID or by its name.

DM_VARKEY_ID Specification via key ID

DM_VARKEY_NAME Specification via tag name

dwID
Contains the key ID of the tags if dwKey type is set accordingly.

szName
Contains the name of the tag if dwKey type is set accordingly.

lpvUserData
Pointer to application-specific data 

Structure definition LINKINFO

 
typedef struct {
LINKTYPE LinkType;
DWORD dwCycle;
TCHAR szLinkName[256];
}
LINKINFO;
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Members

LinkType
LinkType are enumeration constants defined in the "Trigger.h" file. They are to be integrated 
into your script with the "#include "Trigger.h" command and the corresponding enumeration 
constants.

BUBRT_LT_NOLINK 0 no shortcut
BUBRT_LT_VARIABLE_DIRECT 1 direct tag
BUBRT_LT_VARIABLE_INDIRECT 2 indirect tag
BUBRT_LT_ACTION 3 C action
BUBRT_LT_ACTION_WIZARD 4 Dynamic Dialog
BUB_LT_DIRECT_CONNECTION 5 Direct connection
BUBRT_LT_ACTION_WIZARD_INPROC 6 Dynamic Dialog

For the SetLink function, only the enumeration constants BUBRT_LT_VARIABLE_DIREKT 
and BUBRT_LT_VARIABLE_INDIRECT  may be used. The GetLink function allows to return 
all listed enumeration constants.

dwCycle
Update cycle time

255 Picture cycle
235 Window Cycle
0 Upon change
1 250ms
2 500 ms
3 1 s
4 2 s
5 5s
6 10s
7 1min
8 5min
9 10min
10 1h
11-1
5

User cycle 1-5

szLinkName
Tag name
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Structure definition MSG_FILTER_STRUCT

 
typedef struct {
CHAR        szFilterName[MSG_MAX_TEXTLEN+1];
WORD        dwFilter;
SYSTEMTIME  st[2];
DWORD       dwMsgNr[2];
DWORD       dwMsgClass;
DWORD       dwMsgType[MSG_MAX_CLASS];
DWORD                dwMsgState;
WORD        wAGNr[2];
WORD        wAGSubNr[2];
DWORD       dwArchivMode;
char        szTB[MSG_MAX_TB][
MSG_MAX_TB_CONTENT+1]
DWORD       dwTB;
Double      dPValue[MSG_MAX_PVALUE][2];
DWORD       dwPValue[2];
DWORD       dwMsgCounter[2];
DWORD       dwQuickSelect;
}
MSG_FILTER_STRUCT;

Description
In this structure the criteria are specified.

Members

dwFilter
The filter conditions are defined by means of the following constants from the file "m_global.h":

MSG_FILTER_DATE_FROM Date from
MSG_FILTER_DATE_TO Date to
MSG_FILTER_TIME_FROM Time from
MSG_FILTER_TIME_TO Time to
MSG_FILTER_NR_FROM Message number from
MSG_FILTER_NR_TO Message number to
MSG_FILTER_CLASS Message classes
MSG_FILTER_STATE Message status
MSG_FILTER_AG_FROM AS number from
MSG_FILTER_AG_TO AS number to
MSG_FILTER_AGSUB_FROM AG subnumber from
MSG_FILTER_AGSUB_TO AG subnumber to
MSG_FILTER_TEXT Message texts
MSG_FILTER_PVALUE Process values
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MSG_FILTER_COUNTER_FROM Internal message counter from
MSG_FILTER_COUNTER_TO Internal message counter to
MSG_FILTER_PROCESSMSG Process messages
MSG_FILTER_SYSMSG System messages
MSG_FILTER_BEDMSG Operator messages
MSG_FILTER_DATE Date from to
MSG_FILTER_TIME Time from to
MSG_FILTER_NR Message number from to
MSG_FILTER_VISIBLEONLY Display visible messages
MSG_FILTER_HIDDENONLY Display hidden messages

st
Date/time from - to

Where st[0]  is the start time (from), st[1]  the end time (to)

Assign these fields for the criteria: MSG_FILTER_DATE, MSG_FILTER_DATE_FROM, 
MSG_FILTER_DATE_TO, MSG_FILTER_TIME, MSG_FILTER_TIME_FROM, bzw. 
MSG_FILTER_TIME_TO

If the current time is needed to pass a SYSTEMTIME- parameter, use the GetLocalTime 
function and not GetSystemTime.. There is usually a considerable difference between these 
two functions.

dwMsgNr
Message number from - to

Where dwMsgNr[0]  is start no. (from), dwMsgNr[1] the end no. (to)

Assign these fields for the criteria: MSG_FILTER_NR, MSG_FILTER_NR_FROM bzw. 
MSG_FILTER_NR_TO

dwMsgClass
Message classes bit-coded.

Assign this field for the criterion: MSG_FILTER_CLASS

dwMsgType
Message type per alarm class, bit-coded

Assign this field for the criterion: MSG_FILTER_CLASS

dwMsgState
Message status bit-coded.

Assign this field for the criterion: MSG_FILTER_STATE

wAGNr
AGNr from - to
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Assign these fields for the criteria: MSG_FILTER_AG_FROM or MSG_FILTER_AG_TO

wAGSubNr
AGSubNr from - to

Assign this field for the criteria: MSG_FILTER_AGSUB_FROM or MSG_FILTER_AGSUB_TO

dwArchivMode
Logging / reporting

Must be assigned 0.

szTB
Texts of the text blocks

Assign these fields for the criterion: MSG_FILTER_TEXT

dwTB
Active text blocks (from - to, bit-coded)

Assign this field for the criterion: MSG_FILTER_TEXT

dPValue
Process values from - to

Assign these fields for the criterion: MSG_FILTER_PVALUE

dwPValue
Active process values (from - to, bit-coded)

Assign this field for the criterion: MSG_FILTER_PVALUE

dwMsgCounter
Internal message counter from - to

Assign these fields for the criteria: MSG_FILTER_COUNTER_FROM, 
MSG_FILTER_COUNTER_TO

dwQuickSelect
Quick selection for hour, day, month

The parameter is reserved for future upgrades and must be preset to 0.

Assign this field for the criterion: MSG_FILTER_QUICKSELECT

LOWORD Type:

MSG_FILTER_QUICK_MONTH Quick selection last n months
MSG_FILTER_QUICK_DAYS Quick selection last n days
MSG_FILTER_QUICK_HOUR Quick selection last n hours

HIWORD Number: 1...n
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The end time of the quick selection refers to the current system time of the local computer. 
The start time is calculated back n * ( months, days, hours ). 

Structure definition MSG_RTDATA_STRUCT

 
typedef struct {
DWORD                dwMsgState;
DWORD                dwMsgNr;
SYSTEMTIME           stMsgTime;
DWORD                dwTimeDiff;
DWORD                dwCounter;
DWORD                dwFlags;
WORD                 wPValueUsed;
WORD                 wTextValueUsed;
double               dPValue[MSG_MAX_PVALUE];
MSG_TEXTVAL_STRUCT   mtTextValue[MSG_MAX_PVALUE];
}
MSG_RTDATA_STRUCT;

Members
dwMsgState

Message status

MSG_STATE_COME 0x00000001 Message came in
MSG_STATE_GO 0x00000002 Message went out
MSG_STATE_QUIT 0x00000003 Message acknowledged
MSG_STATE_LOCK 0x00000004 Message locked
MSG_STATE_UNLOCK 0x00000005 Alarm locked
MSG_STATE_QUIT_SYSTEM 0x00000010 Message acknowledged by system
MSG_STATE_QUIT_EMERGENCY 0x00000011 Emergency acknowledgement
MSG_STATE_QUIT_HORN 0x00000012 Alarm alert acknowledgment
MSG_STATE_COMEGO 0x00000013 Message came in and went out, only displayed in the "Current 

messages" display
MSG_STATE_UPDATE 0x00010000 Bit for message update
MSG_STATE_RESET 0x00020000 Bit for message reset
MSG_STATE_SUMTIME 0x00040000 Bit active for daylight savings time
MSG_STATE_INSTANCE 0x00080000 Bit for instance message (n messages of a no.)

dwMsgNr

Message number

stMsgTime

Date/Time: Telegram time depending on the calling function
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dwTimeDiff
Duration coming/Telegram time in seconds

dwCounter

Internal message counter

dwFlags

Message flags in the database

MSG_FLAG_SUMTIME 0x00000001 Daylight savings time active
MSG_FLAG_COMMENT 0x00000002 Message has comments
MSG_FLAG_ARCHIV 0x00000004 Archiving
MSG_FLAG_PROTOCOL 0x00000008 Logging
MSG_FLAG_TEXTVALUES 0x00000010 Message has values accompanying the text
MSG_FLAG_TIMEINVALID 0x00000020 Bit for invalid date/time stamp
MSG_FLAG_INSTANCE 0x00000040 Instance message identification (185269)

wPValueUsed

Process values used, bit-coded. Every bit may only be set in one of the two structure elements 
"wPValueUsed" or  "wTextValueUsed". An accompanying value may either be a number or a 
text.

wTextValueUsed

text values used, bit-coded. Every bit may only be set in one of the two structure elements 
"wPValueUsed" or  "wTextValueUsed". An accompanying value may either be a number or a 
text.

10.9 Mobile Wireless

10.9.1 Field of application of the Mobile Panel Wireless

Introduction
The Mobile Panel Wireless enables you to move through the plant without restrictions and with 
or without security technology. You can operate and monitor moving machine parts or the 
entire plant depending on the situation. You can plan, configure, simulate and extend wireless 
networks quickly and reliably.

The Mobile Panels Wireless are based on standardized WLAN technology and are specially 
tailored to the requirements of automation.
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WLAN area
A WLAN area is the area of the plant in which the HMI device communicates with the PLC 
over a wireless local area network. The wireless coverage of the network has a sufficient signal 
strength in this area.  

The WLAN of a plant is formed by the radio area of one or more Access Points. 

Access Point
The Access Point serves as a gateway between the wireless and hard-wired network. The 
HMI device communicates with an Access Point via WLAN. You can operate the different 
machines or plants without annoying cables. The HMI device is connected to a network in 
which it communicates with a PLC via the access point.  

Effective range
Safety-related operator input is only possible in a limited part of a WLAN area upstream of a 
machine or plant known as the effective range. One exception to this rule is the emergency 
stop, which works in the entire WLAN area.  

The configured effective ranges are stored in the HMI device. The HMI device can only log on 
to a machine within the effective range. This also requires there no other HMI device is logged 
on in the same effective range.

To ensure clear logon and machine operator inputs, one effective range must not overlap 
another effective range.

Tags
Effective ranges are formed by the spatial assignment of tags to a machine or plant. Tags 
create a geometrical space which is relevant for logon to a machine. After logon you operate 
the machine using acknowledgement buttons. 

A distinction is made between two types of tags:   

● Transponder

● RFID tag

Transponder
After successful logon to a machine, the spanned geometrical area will be monitored. The 
distance between the HMI device and the transponder can only be measured if the two devices 
are in the reception range of each other. When you leave the effective range, safety-related 
operator input of the machine with acknowledgment buttons is prevented.  

Zones in the transponder system
Zones are configurable objects within a transponder system. A zone is defined by the maximum 
distance from one or more transponders. In a hard-wired Mobile Panel, the length of the 
connection cable defines a zone around a connection box.  
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Zones are operating areas in which safety-related operator input is not possible. To enter a 
zone, you have to configure a screen change to the correct process picture. 

RFID tag
After successful logon to a machine, the spanned geometrical area is not monitored. Monitoring 
therefore calls for an additional organizational measure, for example: a light barrier or a 
protective fence. The protection area is separated from the plant by a security system. The 
protection area is the area in the plant in which you operate one or more machines in fail-safe 
operation. One or more RFID Tags are distributed within protection zones. The protection area 
is not a configurable object. 

10.9.2 How does the transponder system work?

Overview
To give a basic understanding of all this, the following section describes the interaction 
between:       

● HMI device

● Zone

● Effective range

● Transponder
 

 Note

You should always assign administrator rights or set up encryption to protect the project 
containing a Mobile Panel Wireless for fail-safe operation against unauthorized access.
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Principle of operation in the transponder system
 

1 Access Point
2 WLAN of the Access Point
3 PLC
4 Plant
5 Effective range "Robot 1" with a transponder
6 Effective range "Robot 2" with two transponders
7 Zone "Zone 1" with a transponder
8 Radio area of the HMI device
9 HMI device

 

Example: 
● A screen change is configured for "Zone 1".

● Transponder1 is assigned to the "Robot 2" effective range.

● The operator enters the radio cone of the transponder to receive the transponder ID.
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● To log onto the machine "Robot 2", the operator presses the object "Effective range - Name".

● The "Effective range - Logon" dialog box opens. The operator enters the effective range ID 
and confirms with "OK". The dialog is closed.

● If the logon was successful, then the acknowledgement buttons will be active.

● The HMI device measures the distance from the transponder which is less than the 
configured distance of the effective range.

Result:
The operator is logged onto the machine "Robot 2". The operating element "Effective range - 
Name" is green and shows the name of the effective range "Robot 2".

If the HMI device is logged onto the effective range, then the following will apply:

● The operator may not leave the effective range without logging off. If the operator leaves 
the effective range without logging off for more than 30 seconds, a local rampdown will 
occur.

● No other HMI device can log onto the machine.

To log off from the machine, the operator presses the operating element "Effective range - 
Name". A logoff dialog is displayed. The operator confirms the dialog. 

After successful logoff, another operator can log on to the machine "Robot2". 

When the operator enters "Zone 1", a screen change will take place. 

10.9.3 How does the RFID system work?

Overview
RFID stands for radio frequency identification. RFID allows wireless identification of objects 
without contact or visual sighting.  

For a basic understanding, the following section describes the interaction between:

● HMI device

● Effective range (RFID)

● RFID tag
 

  Note
RFID Tags in the plant area

You may only affix RFID Tags in restricted plant areas that are protected by additional 
protective measures, for example, protective railings. 
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Principle of operation in the RFID system

① Access Point
② WLAN of the Access Point
③ PLC
④ RFID tag with effective range (RFID) for logon to "Robot 1"
⑤ RFID tag with effective range (RFID) for logon to "Robot 2"
⑥ Plant
⑦ Protective area limit of the machine "Robot1"
⑧ Protective area limit of the machine "Robot2"
⑨ Radio area of the HMI device
⑩ HMI device

 

Example: 
● "RFID Tag1" is assigned to the effective range (RFID) "Robot1".

● An operator enters the restricted plant area. The operator manually switches to the screen 
with the configured operating element "Effective range - Name (RFID)".
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● At "RFID Tag1", he presses the "Scan" button.
During the logon operation, the button is yellow and displays the text "Scanning…".

● The "Effective range - Logon" dialog box opens. The operator enters the effective range 
(RFID) ID and confirms it with "OK". The dialog is closed.

● The "Confirmation of logon" dialog box opens. The operator confirms logon with the 
acknowledgment button.

● If logon was successful, the acknowledgement buttons are active.

Result:
The operator is logged on to the machine "Robot 1" and operates the machine within the 
protection area in fail-safe operation. The operating element "Effective range - Name (RFID)" 
is green and shows the name of the effective range (RFID) "Robot1".

If the HMI device is logged on to the machine, the following applies:

● The user may not leave the protection area without logging off from the machine. If the 
operator leaves the protection area without logging off, a local rampdown occurs.

● No other HMI device can log on to this machine.

To log off from the machine, the operator presses the operating element "Effective range - 
Name (RFID)". A logoff dialog is displayed. The operator confirms the dialog. 

After successful logoff, another operator can log on to the machine "Robot 1". 

10.9.4 Configuring the Mobile Panel V2 for fail-safe operation

10.9.4.1 Configuration overview

Introduction
Additional steps in the TIA Portal are necessary before the configuration of the Mobile Panels 
V2 for fail-safe operation. This affects the following HMI devices:

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277F IWLAN (RFID Tag)

Procedures overview
1. Creating PLC for fail-safe operation

2. Installing a general station description (GSD)

3. Creating a module from the GSD file

4. Creating a connection between a module from the GSD file and the PLC

5. Creating Mobile Panel V2 for fail-safe operation
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See also
Creating Mobile Panel (Page 6074)

Creating a module from the GSD file (Page 6070)

Installing a general station description (GSD) (Page 6070)

Creating PLC for fail-safe operation (Page 6069)

Creating a connection between a module and the PLC (Page 6073)

10.9.4.2 Creating PLC for fail-safe operation

Requirement
A project is open

Procedure
1. Click "Add new device" in the project navigation.

2. Click "PLC" in the "Add new device" dialog.

3. Select a PLC for fail-safe operation, for example, CPU-315F-2PN/DP. The "Devices & 
Networks" editor opens.

4. Open the device view.

5. Select the device and click on "Device overview".

6. Select the device.

7. Click "Properties > PROFINET interface [X2] >Ethernet addresses > Interface connected 
with > Add new subnet" in the inspector window.

8. Enter the IP address under "IP protocol > Set IP address in the project".

9. Enter a time for "Properties > PROFINET interface [X2] > F parameter > Set default F 
monitoring time for F I/O of this interface".

10.Specify the properties for fail-safe operation in "Properties > Fail-safe"

– "F-capability activated"

– "Basis for PROFIsafe addresses"

11.Specify further properties for fail-safe operation as usual, for example, protection level.

Result
You have created a PLC in the project and made the settings for fail-safe operation.

See also
Configuration overview (Page 6066)
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10.9.4.3 Installing a general station description (GSD)

Introduction
A GSD file (device master data file) contains all the IO device properties. The language used 
to describe the GSD files is GSDML (Generic Station Description Markup Language). Install 
a GSD file to expand the hardware catalog.

Requirement
● The "Devices & Networks" editor is open.

● The "Network view" is open.

● The GSD file is available on your PC.

The GSD file can be found online:

GSD file of Mobile Panel V2 for fail-safe operation (http://support.automation.siemens.com/
WW/view/de/19241467) 

Procedure
1. Click "Options > Install general station description (GSD)".

2. In the "Install general station description" dialog, choose the directory in which the GSD 
files are located.

3. Select the GSD file from the list.

4. Click the "Install" button.

5. To create a log file for the installation, click on the "Save log file" button.

Result
You have installed the GSD file. You can find the new devices installed by means of the GSD 
files in the hardware catalog under "Additional field devices > PROFINET". Any problems that 
occur during the installation can be traced using the log file.

See also
Configuration overview (Page 6066)

10.9.4.4 Creating a module from the GSD file

Requirements
● A PLC for fail-safe operation is created in the project e.g. CPU-315F-2PN/DP.

● The GSD file is installed.

● The "Network view" is opened in the "Devices & Networks" editor.
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Procedure
1. Open the hardware catalog.

2. Open the directory "Additional field devices > PROFINET-IO > HMI > Siemens AG > 
SIMATIC HMI > 277".

3. Now open the folder of the Mobile Panel V2 for fail-safe operation whose device type you 
also have as hardware:

– Mobile Panel 277F IWLAN V2 or

– Mobile Panel 277F IWLAN V2 (RFID tag)

4. For Mobile Panel 277F IWLAN V2, select the module with the order number
6AV6645-0EC01-0AX1.
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5. For Mobile Panel 277F IWLAN V2 (RFID tag), select the module with the order number
6AV6645-0EF01-0AX1.

 

  Note

The order number of the module in the GSD file has to match the order number of the 
Mobile Panel V2 in the software.

 

Figure 10-6 Left: Mobile Panel in the software. Right: Module in the GSD file

6. Drag-and-drop the desired module into the network view.
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Result
You have created a module from the GSD file in your project.

See also
PROFIsafe address (Page 6090)

Configuration overview (Page 6066)

10.9.4.5 Creating a connection between a module and the PLC

Requirements
● A PLC for fail-safe operation is created in the project e.g. CPU-315F-2PN/DP.

● The GSD file is installed.

● A module from the GSD file has been created.

● The "Devices & Networks" editor is open.

Procedure
1. Open the "Network view".

2. Select the module and right-click on "Not assigned". The shortcut menu is opened.

3. Select "Assign new IO controller". A dialog box opens.

4. Select the IO controller and confirm with OK. A connection is established.

5. Open the device view

6. Click on "Mobile277Failsafe_IO_1" in the device overview.

7. Specify the properties for fail-safe operation in the inspector window under "Properties > 
PROFIsafe":

– "F-block ID"

– "F-Source-Add"

– "F-Dest-Add"

8. Click on the module in the device view.

9. Assign a name under "Properties > General > Name" in the inspector window.

10.Assign an IP address under "PROFINET interface [X1] > Ethernet addresses > IP protocol 
> Set IP address in the project".

Result
The module from the GSD file is connected to the PLC. The module adopts the settings made 
in the PLC for PROFIsafe and PROFINET.
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See also
Configuration overview (Page 6066)

10.9.4.6 Creating Mobile Panel

Requirement
● The inspector window is open.

● A PLC for fail-safe operation is created in the project, for example,  CPU-315F-2PN/DP.

● The GSD device is created in the project.

Inserting Mobile Panel into the project.
1. Click "Add new device" in the project navigation.

2. Click on "HMI" in the "Add new device" dialog.

3. Select a Mobile Panel V2 for fail-safe operation, for example, Mobile Panel 277F IWLAN V2. 
The device is inserted into the project.

 

  Note

Select the corresponding Mobile Panel for the module already installed from the GSD file.
 

Defining properties
1. Open the "Devices and Networks" editor.

2. Open the "Device view".

3. Select the Mobile Panel in the work area.

4. Open "Properties > General" in the inspector window.

5. To facilitate assignment in the project, enter the name of the associated module under 
"Name"

6. Enter the same IP address as in the module under "Set IP address in the project".

7. Activate "Set IP address using a different method".

Result
Entering the same IP address as in the device enables error-free communication. Alternatively, 
you can set the IP address on the Mobile Panel after loading the project.

See also
Configuration overview (Page 6066)

Visualize processes
10.9 Mobile Wireless

WinCC Professional V13.0
6072 System Manual, 02/2014



10.9.5 Basics

10.9.5.1 Zones

Introduction
The following section applies only to the Mobile Panels Wireless, e.g. Mobile Panel 277 IWLAN 
V2 and Mobile Panel 277F IWLAN V2. The "Zones" work area is only visible for these HMI 
devices.   

 

 Note

For more information refer to the operating instructions for the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Depending on the HMI device selected, open the work area in the project window by double-
clicking on "Zones" or "Zones and effective ranges". 

Work area
The "Zones" work area displays the zones that have been set up and the transponders 
assigned to them.

Inspector window
When a zone is selected, you can edit the names, display names and the limits of the zone 
under the "General" category. The zone has the "On entry" and "On exit" zones. Assign the 
"ActivateScreen" system function to the events.

10.9.5.2 Zones working area

Introduction
The "Zones" work area displays the zones and the transponders assigned to them in table 
format. You create a list of transponders and assign certain transponders to a zone. The limit 
of the zone is defined by the maximum distance from the transponders.     
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Principle
The work area consists of the "Zones" and "Transponders" tables.

If you select a zone in the "Zones" table, the "Transponder" table displays the following:

● Transponder enabled: The transponder is assigned to the selected zone.

● Transponder deactivated: The transponder is not yet assigned to any zone.

● Transponder not available: The transponder has already been assigned to another zone. 
To undo the assignment, switch to the relevant zone and deactivate the transponder.

The zone and transponder IDs are initially assigned automatically. They can be changed, 
however. 

Please note the following:

● A maximum of 254 zones may be configured.

● The zone ID must be unique and fall within the range from 1 - 254.

● You can initially configure transponders without assigning them to a zone.

● There may be no more than 255 transponders assigned to a zone.

● The transponder ID must be unique and fall within the range from 1 - 65534.

The transponder IDs are set on the transponder.

 

10.9.5.3 Effective ranges

Introduction
The following section applies only to the Mobile Panels Wireless that support fail-safe 
operation, e.g. Mobile Panel 277F IWLAN V2. The "Effective ranges" work area is only visible 
for these HMI devices.   
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You set up effective ranges in order to control safety related operations. An effective range is 
defined by the maximum distance from one or more transponders.

 

 Note

For more information refer to the operating instructions for the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Open the work area in the project window by double-clicking on "Zones & effective ranges". 
Click the "Effective ranges" tab.

Work area
The "Effective ranges" work area displays the effective ranges that have been set up and the 
transponders assigned to them. 

Inspector window
When an effective range is selected, you can edit the names, display names and the limits of 
the effective range under the "General" category. 

When you select a transponder, you can see both the effective range and the zone that are 
assigned to that transponder. You can only assign a transponder to one effective range so 
that the effective ranges do not overlap.

10.9.5.4 Effective ranges working area

Introduction
The "Effective ranges" work area displays the effective ranges and their transponders in table 
format. You create a list of transponders and assign certain transponders to an effective range. 
The limit of the effective range is defined by the maximum distance from the transponders.           

Visualize processes
10.9 Mobile Wireless

WinCC Professional V13.0
System Manual, 02/2014 6075

http://support.automation.siemens.com/WW/view/en/26268960
http://support.automation.siemens.com/WW/view/en/26268960


Principle
The work area consists of the "Effective ranges" and "Transponders" tables.

The HMI device calculates a checksum from the local data so that the configured effective 
ranges and transponders reliably match those locally on the machine. The project cannot be 
started on the HMI device unless the local checksum agrees with the checksum stored in the 
"Effective ranges" editor.

When you select an effective range from the "Effective ranges" table, the "Transponder" table 
displays the following:

● Transponder enabled: The transponder is assigned to the selected effective range.

● Transponder deactivated: The transponder is not yet assigned to any effective range.

● Transponder not available: The transponder has already been assigned to another effective 
range. To undo the assignment, switch to the relevant effective range and deactivate the 
transponder.

● The zone assigned to the transponder is displayed in addition to the effective range.

The effective range and transponder IDs are initially assigned automatically. They can be 
changed, however. 

Please note the following:

● A maximum of 127 effective ranges may be configured.

● The effective range ID must be unique and fall within the range from 1 - 127.

● The display name of an effective range must not be the same as its ID.

● You can initially configure transponders without assigning them to an effective range.

● There may be no more than 127 transponders assigned to an effective range.

● The transponder ID must be unique and fall within the range from 1 - 65534.

The transponder IDs are set on the transponder.
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Effective range in Runtime
To log on to the effective range in Runtime, only the display name of the effective range appears 
to the operator in the Runtime language. The operator reads the effective range ID in the plant 
and enters it on the HMI device. This ensures that the right machine operated. The 
acknowledgment buttons are activated after successful logon.         

10.9.5.5 Effective ranges (RFID)

Introduction
The following section only applies to the Mobile Panel 277F IWLAN (RFID tag) which supports 
fail-safe operation with RFID. The "Effective ranges (RFID)" work area is only visible with these 
HMI devices.    

To monitor safety-related operator inputs, you set up effective ranges (RFID). 
 

 Note

For more information, refer to the operating instructions of the HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

Open
Open the work area in the project window by double-clicking on "Effective ranges (RFID)". 

Work area
The "Effective ranges (RFID)" work area displays the effective ranges that have been set up 
and the RFID Tags assigned to them. 

Inspector window
When an effective range (RFID) is selected, you can edit the name, display name and ID of 
the effective range under the "General" category. 

10.9.5.6 Work area for effective ranges (RFID)

Introduction
The "Effective ranges (RFID)" work area displays the effective ranges (RFID) and their 
RFID Tags in table format. You create a list of RFID Tags and assign specific RFID Tags to 
an effective range.       
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Principle
The work area consists of the "Effective ranges (RFID)" and "RFID Tags" tables.

The HMI device calculates a checksum from the local data so that the configured effective 
ranges (RFID) and RFID Tags reliably match those locally on the machine. The project cannot 
be started on the HMI device unless the local checksum agrees with the checksum stored in 
the "Effective ranges (RFID)" editor. 

When you select an effective range (RFID) in the "Effective ranges (RFID)" table, the 
"RFID Tags" table displays the following:

● RFID Tag enabled: The RFID Tag is assigned to the selected effective range (RFID).

● RFID Tag disabled: The RFID Tag is not yet assigned to any effective range (RFID).

● RFID Tag not available: The RFID Tag has already been assigned to another effective 
range (RFID). To undo the assignment, switch to the relevant effective range (RFID) and 
deactivate the RFID Tag.

The IDs of the effective ranges (RFID) and RFID Tags are initially assigned automatically. 
They can be changed, however. 

Please note the following:

● A maximum of 127 effective ranges (RFID) may be configured.

● The effective range (RFID) ID must be unique and fall within the range from 1 - 127.

● The display name of an effective range (RFID) must not be the same as its ID.

● You can initially configure RFID Tags without assigning them to an effective range (RFID).

● A maximum of 127 RFID Tags is available to assign to an effective range  (RFID).

● The RFID Tag ID must be unique and fall within the range 1-65534.

The RFID Tag ID is written to the RFID Tag by the HMI device.

Effective range in Runtime
To log on to the effective range (RFID) in Runtime, only the display name of the effective range 
(RFID) is displayed to the operator in the Runtime language. The operator reads the effective 

Visualize processes
10.9 Mobile Wireless

WinCC Professional V13.0
6078 System Manual, 02/2014



range (RFID) ID in the plant and enters it on the HMI device. This ensures that the right machine 
operated. The acknowledgment buttons are activated after successful logon.     

10.9.6 Working with zones

10.9.6.1 Configuring a zone

Validity
The next section applies to all Mobile Panels Wireless, e.g. Mobile Panel 277 IWLAN.  

Introduction
You will have to set up a zone in order to carry out plant-specific operator control and monitoring 
tasks.

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Zones" work area is open.

Procedure
1. Double-click "Add..." in the "Zones" table.

2. Enter the "MixingPlant" zone in the "Name" field.

3. Enter "MixingSystem" as the "Display name" for the zone at runtime. Enter zone "1" in the 
"ID" field.

4. Enter "8" meters as the zone "Limit".

5. Double-click "Add..." in the "Transponders" table.

6. Enter "Transponder 1" as the "Name" of the transponder.

7. Enter transponder "1" in the "ID" field.
Then set transponder IDs on the transponder.

8. Enable the assignment of "Transponder 1".
"Transponder 1" is assigned to the "MixingPlant" zone.

9. Repeat steps 6 to -9 accordingly for "Transponder 2".
"Transponder 2" is assigned to the "MixingPlant" zone.
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Result
The "MixingPlant" zone is configured as two conical areas arranged at a distance of 8 meters, 
regardless of the effective ranges: one area around "Transponder 1" and one around 
"Transponder 2".

The display name designates the zone in the set editing language. An overview of the display 
names can be found in the "Project texts" editor.

 

10.9.6.2 Displaying the screen on entering a zone

Introduction
Configure a screen change when entering and leaving the zone.   

Requirements
● A Mobile Panel which supports zones has been created, for example, Mobile 

Panel 277 IWLAN.

● The "MixingPlant" zone is configured.

● The "Plant_1" screen has been created and opened.

● The "MixingPlant_1" screen has been created and opened.

● The "Zones" work area is open.

Procedure
1. Select the "MixingPlant" zone from the "Zones" table.

2. Click "Properties> Events" in the Inspector window.

3. Click the event "On entry".
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4. Select the "ActivateScreen" system function in the "function list".

5. Select "MixingPlant_1" as the "Screen name".

6. Click the event "On exit".

7. Select the "ActivateScreen" system function in the function list.

8. Select "Plant_1" as the "Screen name".

Result
The "MixingPlant_1" screen is displayed on the HMI device when you enter the "MixingPlant" 
zone. When you exit the zone, the "Plant_1" screen appears once more.

10.9.6.3 Displaying an object in relation to the zone

Validity
The following example is independent of the WLAN and applies to all Mobile Panels. 

Introduction
You configure an I/O field that is only visible within a specific zone.   

Requirements
● A Mobile Panel which supports zones has been created, for example, Mobile 

Panel 277 IWLAN.

● The "Zone_id" variable of the "Int" data type has been created.

● A "Plant_1_Overview" screen has been created.

Procedure
1. Open the "Runtime Settings > General" editor.

2. Select the "Zone_id" tag as the "ID Zone/ Effective range".

3. Open the screen "Plant_1_Overview".

4. Drag and drop the "I/O box" object from the toolbox into the screen.

5. Click "Properties > Animations" in the Inspector window.

6. Click "Layout > Visibility."

7. Select "Zone_id" as the "tag".

8. Select "from" 1 "to" 1 as the "Range".

9. Enable "Visible".

Visualize processes
10.9 Mobile Wireless

WinCC Professional V13.0
System Manual, 02/2014 6081



Result
The IO field is only visible at runtime under the following conditions:

● The hard-wired Mobile Panel is connected to a connection box with ID = 1.

● The Mobile Panel Wireless is located in a zone with ID = 1, for example, the "MixingPlant" 
zone.

 

10.9.7 Working with effective ranges

10.9.7.1 Overview

Introduction
The following configuration guide describes the steps needed to set up an effective range for 
fail-safe operation on a Mobile Panel Wireless.

Procedures overview
1. Configuring the effective range:

You configure the "MixingAxisControl" effective range as a conical area around 
"Transponder1 " at a distance of 5 meters.

2. Configuring the name of the effective range:
To ensure logon to the effective range, configure the object "Effective range - Name".

3. Configuring additional effective range objects:
Configure additional objects for displaying the position and signal strength within an 
effective range.

4. Set parameters for loading:

– PROFIsafe communication

– WLAN network

– Power management

– Interface

5. Configure the data channel

6. Configure network operation

7. Set the transponder

8. Commissioning effective ranges

9. Switching on and Testing the HMI device

10.Start loading manually

11.Acknowledging the effective range at the plant:
You acknowledge the effective ranges and their transponders.
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12.Determine the checksum

13.Load the project once again with checksum:
Enter the checksum you have determined in the project and load the project once again.

14.Test effective range
 

  Note

For detailed information on items 5 to 14, refer to the operating instructions of the HMI 
device.

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/
WW/view/en/26268960)

 

 

10.9.7.2 Configure effective range

Introduction
You set up an effective range in order to control safety related operator input upstream of a 
machine or plant.  

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Effective ranges" work area is open.

Procedure
1. Double-click "Add..." in the "Effective Ranges" table.

2. Enter "MixingAxisControl" as the "Name" of the effective range.

3. Enter "Mixing_axis_PLC" as the "Display name" for the effective range at runtime.

4. Enter effective range "1" in the "ID" field.
Make sure that the effective range ID matches the ID on the machine.

5. Enter "5" meters as the "Limit" of the effective range.

6. Double-click "Add..." in the "Transponders" table.

7. Enter "Transponder 1" as the "Name" of the transponder.

8. Enter transponder "1" in the "ID" field.
Then set transponder IDs on the transponder.

9. Enable the assignment of "Transponder 1".
"Transponder 1" is assigned to the "MixingAxisControl" effective range.
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Result
You configure the "MixingAxisControl" effective range as a conical area around "Transponder 
1" at a distance of 5 meters, regardless of the zones.

The display name designates the effective range in the set editing language. An overview of 
the display names can be found in the "Project texts" editor.

10.9.7.3 Configuring the effective range name

Introduction
Configure at least the "Effective range - Name" object so that an operator can log on and off 
a machine using an effective range. If you do not configure an effective range object for a 
Mobile Panel Wireless for fail-safe operation, a warning appears during generation.         

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range name" object from the "Elements" category in the toolbox.

2. Drag and drop the "Effective range - Name" object from the toolbox into the screen.

Result
If the operator clicks an object during runtime, he initiates logon or logoff of the HMI device to 
a machine that is assigned to an effective range.

See also
Effective range name (Page 3640)
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10.9.7.4 Configuring additional Mobile Wireless objects

Introduction
You will need to configure other objects in order to display further information about the 
effective range during testing, for example.   

Requirements
A screen has been created and opened.

Procedure
1. Select the "Effective range - Signal" object from the "Elements" category in the toolbox.

2. Drag and drop the "Effective range - Signal" object from the toolbox into the screen.

3. Repeat steps 1 and 2 with the "WLAN - Reception" object.

Result
The "Effective range - Signal" object indicates how accurately the Mobile Panel Wireless is 
within an effective range. The "WLAN - Reception Quality" object displays the signal strength 
of the WLAN wireless connection.

See also
WLAN reception (Page 3645)

Effective range signal (Page 3644)

10.9.8 Working with effective ranges (RFID)

10.9.8.1 Overview

Validity
The next section applies only to Mobile Panels Wireless with RFID, for example, 
Mobile Panel 277F IWLAN (RFID Tag).  

Introduction
The following configuration guide describes the steps required to set up an effective range 
(RFID) for fail-safe operation on a Mobile Panel Wireless with RFID.

Visualize processes
10.9 Mobile Wireless

WinCC Professional V13.0
System Manual, 02/2014 6085



Procedures overview
1. Configure effective range (RFID):

You configure the effective range (RFID) "MixingAxisControl".

2. Configuring the name of the effective range (RFID):
To ensure logon to the effective range, configure the object "Effective range - Name (RFID)".

3. Set parameters for loading

4. Configure the data channel

5. Configure network operation

6. Install RFID Tag in the plant

7. Turn on the HMI device and enable loading mode

8. Loading a project

9. Write the suitable IDs to the RFID Tags in the plant

10.Determine the checksum

11.Load the project once again with checksum:
Enter the checksum you have determined in the project and load the project once again.

12.Test effective range (RFID)
 

  Note

For detailed information on items 4 to 12, refer to the operating instructions of the HMI 
device.

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/
WW/view/en/26268960)

 

10.9.8.2 Configuring effective range (RFID)

Introduction
You set up an effective range (RFID) to control safety-related operator input upstream of a 
machine or plant.  

Requirements
● A suitable editing language, e.g. English, must have been set in the "Project languages" 

editor.

● The "Effective ranges (RFID)" work area is open.

Procedure
1. Double-click "Add..." in the "Effective Ranges (RFID)" table.

2. Enter "MixingAxisControl" as the "Name" of the effective range (RFID).
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3. Enter "MixingAxisControl" in the "Display name" field of the effective range (RFID).

4. Enter "1" in the "ID" field of the effective range (RFID). 
Make sure that the effective range (RFID)-ID matches the ID on the machine.

5. Double-click "Add..." in the "RFID Tag table.

6. Enter "RFID Tag 1" as the "Name" of the RFID Tag.

7. Enter "1" as the "ID" of the RFID Tag. Then set the RFID Tag-ID for the RFID Tag.

8. Enable the assignment of "RFID Tag 1".
"RFID Tag 1" is assigned to the effective range (RFID) "MixingAxisControl".

Result
The effective range (RFID) "MixingAxisControl" is configured.

The display name describes the effective range (RFID) in the set editing language. An overview 
of the display names can be found in the "Project texts" editor.

10.9.8.3 Configuring the effective range name (RFID)

Introduction
Configure the "Effective range - Name" object so that an operator can log on and off a machine 
using an effective range (RFID). If you do not configure the "Effective range-Name" object for 
a Mobile Panel Wireless RFID with (RFID), a warning will appear during generation.         

Requirements
A screen has been created and opened.
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Procedure
1. Select the "Effective range - Name (RFID)" object from "<Elements" in the toolbox.

2. Drag and drop the "Effective range - Name (RFID)" object from the toolbox into the screen.

Result
If the operator clicks an object during runtime, he will initiate logon or logoff of the HMI device 
to a machine which has been assigned to an effective range (RFID). 

See also
Effective range name (RFID) (Page 3642)

10.9.9 Reference

10.9.9.1 PROFIsafe address

Validity
The PROFIsafe address is only available for fail-safe operation for the Mobile Panel Wireless. 

 

 Note

Additional information on fail-safe operation can be found in the operating instructions for the 
HMI device:

Complete documentation for Mobile Wireless (http://support.automation.siemens.com/WW/
view/en/26268960)

 

PROFIsafe address
The PROFIsafe address used for fail-safe I/Os in PROFIsafe communication is unique on the 
entire network and on all stations. On the Mobile Panel Wireless, you create a default value 
in the project and load it to the HMI device. You can also store a PROFIsafe address on the 
HMI device.  

The PROFIsafe address fall within the range from 1 to 65534. The two PROFIsafe addresses 
(in the Engineering System and on the HMI device) are checked for formal validity. 

The PROFIsafe address is loaded as follows at the start of Runtime:
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● You programmed a valid PROFIsafe address in the Control Panel.
The HMI loads the PROFIsafe address set in the Control Panel.

● You did not program a valid PROFIsafe address in the Control Panel.
The HMI loads the PROFIsafe address set in the project.

 

  Note

The invalid address 65.535 is programmed by default in the Control Panel of the HMI 
device. The HMI loads the address set in the project. 

 

See also
Power Management (Page 6091)

Zone ID / connection point ID (Page 6092)

10.9.9.2 Power Management

Validity
In the "Runtime Settings > Power Management" editor, configure the energy-saving mode of 
a Mobile Panel. 

Power Management
The Mobile Panel Wireless can save energy in the following ways:   

● Reduce brightness - minimal saving

● Switch off display - significant saving

You can also indicate after how long without operator input the power management function 
is enabled. The communication link is maintained. The time for "Switch monitor off" is longer 
than the time for "Reduce brightness".

See also
PROFIsafe address (Page 6088)
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10.9.9.3 Zone ID / connection point ID

Validity
In the "Runtime Settings > General" configure an internal tag which, depending on the value, 
shows specific information on the display of the HMI device.

 

 Note
Mobile Panels Wireless with RFID

For Mobile Panels Wireless with RFID, the area "Zone ID / Connection point ID" is not 
available.

 

Zone ID / connection point ID
This field is used to configure an internal tag that contains the following value at runtime in 
relation to the type of HMI device:     

● The ID of the connection box or effective range to which the hard-wired Mobile Panel is 
connected.

● The ID of the zone in which the Mobile Panel Wireless is located. If the value is set to 255, 
then the HMI device is not in any zone.

See also
PROFIsafe address (Page 6088)

10.10 Planning tasks

10.10.1 Field of application of the Scheduler

Definition
You can use the Scheduler to configure tasks to run independent of the screen in the 
background. You create tasks by linking system functions or scripts to a trigger. The linked 
functions will be called when the triggering event occurs.  

Example of an application
The Scheduler is used to execute event-controlled tasks automatically. For example, you use 
a task to automate the following:

● Regular swap out of log data

● Printout of an alarm report when an alarm buffer overflow occurs
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● Printout of a report at shift end

● Monitoring a tag

● Monitoring of a user change
 

 Note

The availability of the listed examples is determined by the HMI device. 
 

10.10.2 Working with tasks and triggers

Introduction
A task consists of a trigger and a task type.
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Starting a task
Controlled by a trigger, the Scheduler starts the task linked to the trigger. 

10.10.3 Basics

10.10.3.1 Work area of the "Scheduler" editor

Introduction
Double-click on "Scheduler" to open it in the project view. The work area shows the scheduled 
tasks, which consist of the trigger and the task type, for example, the function list.  

Structure
The work area consists of the table of jobs.
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The table of tasks shows specified tasks with their properties, such as triggers. You select a 
task type and a trigger. You assign a name and a comment to the task. The description provides 
a written summary of the task including the timing for the task.

Inspector window
The "Properties" tab of the Inspector window is split into two parts. 

The "Job" area lists the name of the job and the job type. The "Starting time" area shows the 
trigger. The area is different depending on the trigger selected. 

In the "Events" tab use the function list with system functions that will be executed in the task.
 

 Note

You can obtain more detailed information about the elements of the user interface using the 
tooltips. To do so, move the mouse pointer to the relevant object or press <F1> if the object 
has already been selected.

 

 

10.10.3.2 Triggers

Triggers

Introduction
A trigger is linked to a task and forms the triggering event which will call this task. The task is 
executed when the trigger occurs.   

Event trigger
When a task is linked to a system event, the task will be triggered by the event. System events 
include, for example, Runtime stop, screen change, user change, etc. 

Each system event can only be configured once for each HMI device.   

Deactivating job
If you do not need a certain job temporarily, deactivate the job in the Engineering System. You 
also use the trigger "Deactivated" to make a previously configured system event available once 
again. 
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Example: Task "A" is planned with the system event "Shutdown". This system event is then 
no longer available for another task "B". Select "Disabled" as the trigger for task "A" to make 
the "Runtime stop" system event available again.   

 

 Note

The available triggers depend on the HMI device.
 

Triggers

Introduction
A trigger is linked to a task and forms the triggering event which will call this task. The task is 
executed when the trigger occurs.   

Types of triggers
The Scheduler recognizes different types of triggers:

Acyclic triggers
They consist of a specification for the date and time of day. Tasks with an acyclic trigger are 
performed once by the Scheduler on the specified date and at the specified time.     

Cyclic triggers
Tasks linked to a cyclic trigger occur regularly at a specific point in time.     

● Standard cycle: With a standard cycle, the beginning of the first interval coincides with the 
start of Runtime. The length of the interval is determined by the cycle.  

● Trigger with defined starting time: You specify a start time and a time interval. You can use 
cyclic triggers to perform tasks on a daily or weekly basis, for example. For example, you 
can select a "Weekly" trigger to specify a week as the interval. You specify the beginning 
of the interval with the day of the week and the time of day.  

 

 Note
User-defined cycles

You have defined your own cycles. You can only use cycles in the Scheduler whose maximum 
value amounts to one hour. 

 

Event trigger
When a task is linked to a system event, the task will be triggered by the event. In contrast to 
cyclic triggers, system events usually occur acyclically. A Runtime stop is a system event, for 
example.
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Each system event can only be configured once for each HMI device.       

Deactivating job
If you do not need a certain job temporarily, deactivate the job in the Engineering System. You 
also use the trigger "Deactivated" to make a previously configured system event available once 
again. 

Example: Task "A" is planned with the "User change" system event. This system event is then 
no longer available for another task "B". Select "Disabled" as the trigger for task "A" to make 
the "User change" system event available again.   

 

 Note

The available triggers depend on the HMI device.
 

Timers for cyclic triggers

Timers for cyclic and acyclic triggers
You have the option to change the start time of a task dynamically in Runtime. You can select 
an HMI variable as the timer. The value of the tag determines the start time for the task during 
Runtime.     

 

 Note

An HMI tag must be of the type "DateTime". A PLC tag must be of the type "Date and Time" 
or "DTL".

 

As long as the operator does not change the tag after Runtime starts, the start time configured 
in the task is valid. As soon as the operator enters a change to the tag, the current value of 
the tag is always the start time. To reset the configured time as the start time, the operator has 
to enter the configured time again. 

Tag triggers

Tag triggers
In addition to acyclic, cyclic and event triggers, WinCC offers tag triggers.       

Tag triggers consist of the specification of one or more tags. A task linked to such a trigger is 
only performed when the value of the tag changes. This reduces the load on the system. The 
cycle in which the tag values are scanned can be set individually for each tag. Select a value 
ranging from "250 ms" to once an hour for the scanned cycles. You can also define your own 
user cycles.
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Rules for selecting the trigger
Use the tag trigger instead of the cyclic trigger for tag processing. This reduces the load on 
the system.

● Tag triggers
The task is performed only when the value of the tag changes. 

= task is executed.

● Cyclic triggers
You have selected "10 seconds" as the cyclic trigger. The task will be executed when the 
trigger occurs.

= task is executed.

 

10.10.3.3 Task type

Function list

Function list
A trigger starts the function list. The function list is executed line by line. Each line contains a 
system function. You can configure exactly one function list for each task.     

 

 Note

The choice of configurable system functions in a function list depends on the selected trigger 
and the HMI device. 
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See also
Integrating local VB scripts (Page 6100)

Integrating local C scripts (Page 6102)

Function list

Function list
A trigger starts the function list. The function list is executed line by line. Each line contains a 
system function or a local script. You can configure exactly one function list for each task.

 

 Note

The choice of configurable system functions in a function list depends on the selected trigger 
and the HMI device.

 

Processing of system functions and scripts
System functions and scripts in a function list are processed in Runtime sequentially from top 
to bottom. 

Auto-Hotspot 

Use a script with loops, conditional statements and abort conditions to program non-sequential 
and conditional procedures. 

Print task

Introduction
In addition to the "Function list", WinCC Runtime Professional also includes the "Print job" task 
type.

Print job
You print the report by creating a print job. When a cyclic or acyclic trigger occurs, the 
Scheduler starts the printout of a report. You define the scope of printing and the time range 
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of the report beforehand in the "Print jobs" editor. In addition, you specify whether the report 
will be printed or written into a file.

If you have selected "Print job" as the task type, an additional field will appear in the "Task" 
area. Select the predefined print job for the task in the "Print job" field. 

 

 Note

Activate "Scheduled print jobs in runtime" in the start sequence of WinCC Runtime to use the 
"Print job" job type.

Click on "Runtime settings > Services > Scheduled print jobs in runtime" in the editor.
 

Integrating local VB scripts

Introduction
In addition to the "Function list" and "Print job" task types, Professional Runtime also allows 
you to integrate local VB scripts.
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Integrating local VB scripts
You can create and edit local scripts. You can also convert the system functions offered in the 
function list in a local script and edit the code. The local VB script is stored with the task. 

A trigger starts the script in Runtime. Once you have converted a function list to a VB script, 
you can no longer access the function list for this task. You will have to delete the VB script to 
access the function list once again.

The Scheduler allows you to start VB scripts independent of screens. The VB scripts give you 
access to tags and screens in Runtime. 

There is no common data area between scripts in the Scheduler and screens. Scripts in the 
Scheduler and screens can be synchronized with the DataSet object or tags. The data type of 
VBS variables is always VARIANT. 

The local VB script is not executed simultaneously. The script last triggered is put into a queue 
until it is processed.

 

 Note

When you create a script, the "Option explicit" statement is entered automatically in the 
declaration section and cannot be deleted. The statement is necessary to avoid errors from 
incorrectly spelled tags without declaration. 

The statement requires you to always define tags with the "Dim" statement in your code. Do 
not use the "Option explicit" statement in your code, as it can lead to Runtime errors.

 

Requirement
Enable "Tasks in Runtime" in the startup sequence of WinCC to use the function list and local 
scripts.

Click "Runtime settings > Services > Tasks in Runtime" in the editor.
 

 Note

You cannot call C scripts in VB scripts and vice versa.
 

User cycles as triggers
If you use user cycles as triggers for VB scripts, the scripts are always executed in Runtime 
with a granularity of 250 ms.

See also
Function list (Page 6096)
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Integrating local C scripts

Introduction
In addition to the "Function list" and "Print job" task types, Runtime Professional also allows 
you to integrate local C scripts.

Integrating local C scripts
You can create and edit local scripts. You can also convert the system functions offered in the 
function list in a local C script and edit the code. The local C script is stored with the task. 

A trigger starts the script in Runtime. Once you convert a function list to a C-script, you can no 
longer access the function list for this task. You will have to delete the C script to access the 
function list once again.

A trigger starts the local C script in Runtime. 

The local C script is not executed simultaneously. The script last triggered is put into a queue 
until it is processed.

Requirement
Enable "Tasks in Runtime" in the startup sequence of WinCC to use the function list and local 
scripts.

Click "Runtime settings > Services > Tasks in Runtime" in the editor.
 

 Note

You cannot call C scripts in VB scripts and vice versa.
 

User cycles as triggers
If you use user cycles as triggers for C scripts, the scripts are always executed in Runtime with 
a granularity of 250 ms.

 

See also
Function list (Page 6096)
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10.10.4 Planning tasks

10.10.4.1 Planning tasks with acyclic triggers

Introduction
You are planning a one-time Runtime stop for maintenance work. The task starts a function 
which requires Runtime to stop.       

Requirements
● The "Scheduler" editor is open.

● The Inspector window is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Maintenance at end of year" as the "Name."

3. Select "Once" as the "Trigger."

4. Select "31.12.2008" in the "Properties > Properties > General > on" field of the Inspector 
window.

5. Enter the time "18:00" in the "at" field.

6. Click "Properties > Events" in the Inspector window.
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7. Select the "StopRuntime" system function in the function list.

8. Select "Runtime" as the "Mode".

Result
The task is executed once. Runtime will be stopped at 18:00 on December 31, 2008. 

 

 Note
"StopRuntime" event on RT Professional

Please note that the "StopRuntime" event means runtime is in the process of ending and that 
some functionalities are therefore no longer available. 

 

10.10.4.2 Planning tasks with cyclic triggers

Introduction
You plan a task that starts the daily printout of a report.   
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Requirements
● You have created an HMI device with Runtime Professional.

● The "Daily alarm report" print task has been created.

● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Select "Print task" under "Type."

3. Enter "Daily alarm report printout" as the "Name."

4. Select "Daily" as the "Trigger."

5. In the Inspector window "Properties >Properties > General > at" enter the time "18:00".

6. Select the "Daily alarm report" print task in the "Task" area.

7. Open the "Runtime settings > Services" editor.

8. Enable "Start sequence of WinCC Runtime > Planned print jobs in Runtime".
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Result
The report "Daily alarm report" will be printed every day at 18:00 hours. 

10.10.4.3 Planning tasks with event triggers

Introduction
You plan a task that generates a screen change when the user changes.    

Requirements
● The "Scheduler" work area is open.

● You have created the "Start" screen.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Screen change at user change" as the "Name."

3. Select "User change" as the "Trigger."

4. In the Inspector window, select "Properties > Events".
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5. Select the "Screen/ActivateScreen" system function in the function list.

6. Select the "Start" screen in the screen name field.

Result
The task is executed with the "User change" event. When a new user logs on successfully, 
the "Start" screen is called up. 

10.10.4.4 Administer task

Changing the designation
1. In the work area, double-click the field in the "Name" column. 

2. Change the name of the task.

3. Confirm your entry with <Return>.

As an alternative, you can change the designation in the "Job > Name" box of the Inspector 
window.  

Visualize processes
10.10 Planning tasks

WinCC Professional V13.0
System Manual, 02/2014 6105



Changing triggers
1. In the work area, mark the field in the "Trigger" column. 

2. Open the drop-down list using the  button and select the trigger you require.

You can alternatively change the trigger in the "Starting time" area of the Inspector window.

Deleting a task
1. Select one or more lines for the tasks to be deleted. 

2. Open the shortcut menu with the right button and select the menu command "Delete".

As an alternative, delete one or more tasks by using the <Del> button.

10.10.5 Examples for Runtime Professional

10.10.5.1 Example: Activate the start screen daily 

Introduction
You plan a task that activates the start screen daily with a logon dialog before the shift begins.   

Requirements
● A "start screen" has been created.

● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the "Task" table.

2. Enter "Activate start screen" as the "Name".

3. Select "Function list" as the "Type".

4. Select "Daily" as the "Trigger."

5. In the Inspector window "Properties >Properties > General > at" enter the time "05:30".

6. In the Inspector window, open "Properties > Events".

7. Select the system function "ActivateScreen" from the "Screens" group in the function list.
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8. Enter "Start screen" as the "Screen name".

9. Open the "Runtime settings > Services" editor.

10.Activate "Scheduled tasks in Runtime".

Result
The "Start screen" is activated daily at 5:30 a.m.

10.10.5.2 Example: Printing a report once

Task
You plan a task that prints out a report once at the end of the year. 
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Requirement
● The "Annual overview" print task is created.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Annual summary" as the "Name".

3. Select "Print task" as the "Type".

4. Select "Once" as the "Trigger."

5. Select "31.12.2010" in the "Properties > Properties > General > on" field of the Inspector 
window.

6. Enter the time "22:00" in the "at" field.

7. Select the "Annual overview" print task in the "Task" area.

8. Open the "Runtime settings > Services" editor.

9. Enable "Start sequence of WinCC Runtime > Scheduled print jobs in Runtime".
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Result
The "Annual overview" print job will be started on December 31, 2008 at 10:00 p.m.   

10.10.5.3 Example: Reading the current user name

Introduction
You plan a task that writes the current user into a text field.

Requirements
● A "Screen_1" screen has been created.

● A "Textfield_1" text field has been created in the "Screen_1" screen.

● The "Scheduler" work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Reading the user name" as the "Name".

3. Select "Tag trigger" as the "Trigger".

4. Click "Properties > Properties > General > Add trigger" in the Inspector window.

5. Select the "@CurrentUser" system variable.

6. Select "1 min" as the "Cycle".

7. In the Inspector window, open "Properties > Events".

8. Click  in the "Function list" area. 

9. Enter the following VB script:

 
Sub Action ()
    Dim user
    user = HMIRuntime.Tags("@CurrentUser").Read
    HMIRuntime.Screens("Screen_1").ScreenItems("Textfield_1").Text = user 
End Sub

1. Open the "Runtime settings > Services" editor.

2. Activate "Scheduled tasks in Runtime".

Result
When the tag value changes, the current user is written into the "Textfield_1" text field.   

Visualize processes
10.10 Planning tasks

WinCC Professional V13.0
System Manual, 02/2014 6109



10.10.5.4 Example: Increment a tag

Introduction
You schedule a task that increments the value of a tag by one every hour.

Requirements
● You have created an HMI device with Runtime Professional.

● The "Scheduler" work area is open.

● The "Tag1" tag has been created.

Procedure
1. Click "Add..." in the table of the task area.

2. Select "Function list" as the "Type."

3. Enter "Count up tag" as the "Name."

4. Select "1 hour" as the "Trigger".

5. In the Inspector window, under "Properties > Properties > General > Starting time > at 
minute" enter the value "35:00".

6. In the Inspector window, open "Properties > Events".

7. Click  in the "Function list" area.

8. Enter the following program code in the entry field:

 
Sub Action ()
    Dim objTag1
    Dim lngValue
    Set objTag1 = HMIRuntime.Tags("Tag1")
    lngValue = objTag1.Read
    objTag1.Write lngValue + 1
End Sub

1. Open the "Runtime settings > Services" editor.

2. Select "Scheduled tasks in Runtime".

Result
The tag is incremented cyclically.    
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10.10.6 Examples for Runtime Advanced and Panels

10.10.6.1 Example: Update user following change of user

Task
Configure an I/O field which displays the logged on user. Configure a task which updates the 
I/O field when the logged on user changes.     

Requirements
● A "CurrentUser" tag of the "String" type is created.

● A screen has been created and opened.

● An I/O field is created in the screen.

Procedure
1. Click on the "I/O field" object.

2. In the Inspector window, select "Properties > Properties > General":

– Select "String" as the "Display format."

– Select "CurrentUser" as the "Variable."

– Select "Output" as the mode.

3. Change to the work area of the Scheduler.

4. Click "Add..." in the table of the task area.

5. Enter "CurrentUser" as the "Name".

6. Select "User change" as the "Trigger."

7. In the Inspector window, select "Properties > Events".
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8. Select the system function "ReadUserName" from the "User Management" group in the 
function list.

9. Select "CurrentUser" as the "Variable."

Result
When a new user logs on successfully, the "ReadUserName" function is called up. The 
"CurrentUser" tag is updated and displayed in the I/O field of the newly logged on user. 

If a user does not log on successfully, the logged on user is logged off. The I/O field continues 
to display the user previously logged on until a new user logs on successfully.       

10.10.6.2 Example: Weekly printout of a report

Introduction
You plan a task that starts the weekly printout of a report.

Requirements
● A "Weekly report" report has been created.

● The "Scheduler" work area is open.
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Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Weekly report printout for end of shift" as the "Name."

3. Select "Weekly" as the "Trigger."

4. Select "Properties > Properties > General > on day" "Friday" in the Inspector window.

5. Enter the time "18:00" in the "at" field.

6. In the Inspector window, select "Properties > Events".

7. Select the "Print/PrintReport" system function in the function list.

8. Select "Weekly report" report.

Result
The weekly print task starts on Friday at 18:00.     
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10.10.6.3 Example: Changing the starting point of a task in Runtime

Example: Changing the starting point of a task in Runtime

Introduction
A cyclic trigger, for example "Starting daily at 18:00," is configured in the Engineering System. 
The time "18:00" is fixed as a constant. To change the start time in Runtime, select a tag as 
the "Timer." The value of the tag determines the start time of the task during Runtime.   

Task
You plan a task that swaps out log data daily and has the "LogTime" tag as the timer. You 
configure a "LogTime" tag in an input field.

Requirements
● The "DataLogSource" source log has been created as a data log.

● The "DataLogDestination" destination log has been created as a data log.

● A "ChangeLogTime" screen has been created.

Procedures overview
1. Creating a timer tag: You create a tag with which you change the starting point of the log 

data swap in Runtime.

2. Configuring a Date/time field: The operator changes the starting point of the task by using 
the Date/Time field in Runtime.

3. Configure the task with a timer tag: You create a task whose start time can be changed 
dynamically in Runtime.

Result
If nothing is entered in the "LogDataTimeField" input field, then the task starts daily at 18:00 
by default. The log data are swapped out. If an operator enters 19:00 in the "LogDataTimeField" 
input field, then the log data are swapped out at 19:00. Provided the value of the tag is not 
changed again before the task starts. 

Example: 1. Configuring a tag for Runtime

Task
In the following example you configure the "LogTime" variable.
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Procedure
1. Open the "HMI tags" editor.

2. Click "Add..." in the table of the task area.

3. Enter "LogTime" as the "Name" of the variable.

4. Select "Internal variable" in the "Connection" column.

5. Select "DateTime" in the "Date type" column.

Result
A variable of the "DateTime" type has been created.

Example: 2. Configuring a Date/time field

Task
In the following example you configure a Date/time field. To change the starting point of the 
task in Runtime, link the "LogTime" variable to the Date/time field.

Requirements
● The "LogTime" variable of the "DateTime" type has been created.

● The "ChangeLogTime" screen is open.

Procedure
1. In the toolbox view, drag-and-drop a "Date/time field" from the "Basic objects" category to 

the screen.

2. In the Inspector window, click "Properties >Properties > General".

3. Disable the "System time."

4. Click "Variable" and select "LogTime."

5. Disable "Display date" and enable "Display time."

6. Select "Input/output" as the "Mode."

7. Click "Properties > Miscellaneous."

8. Enter "LogDataTimeField" as the "Name".

Result
The operator enters a time using the created date/time field.
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Example: 3. Configuring archiving with a timer variable

Task
In the following example you configure a task with a timer tag with which you change the starting 
point of the task in Runtime.    

Requirements
● The "LogTime" tag has been created.

● The "DataLogSource" source log has been created as a data log.

● The "DataLogDestination" destination log has been created as a data log.

● The Scheduler work area is open.

Procedure
1. Click "Add..." in the table of the task area.

2. Enter "Swap out log daily at a tag time" as the "Name".

3. Select "Daily" as the "Trigger".

4. In the Inspector window "Properties >Properties > General > at" enter the time "18:00".

5. Select the "LogTime" tag as the "Standard timer".

6. In the Inspector window, open "Properties > Events".
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7. Select the "System functions/Logs/CopyLog" system function in the function list.

8. Select these settings:

– Select "Data log" as the "Log type".

– Select "DataLogDestination" as the "Destination log".

– Select "DataLogSource" as the "Source log".

– Select "Overwrite" as the "Mode".

– Select "Yes" for "Delete source log".

Result
If nothing is entered in the "LogDataTimeField" input field, then the task starts daily at 18:00 
by default. The log data are swapped out. If an operator enters 19:00 in the "LogDataTimeField" 
input field, then the log data are swapped out at 19:00. Provided the value of the tag is not 
changed again before the task starts. 
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10.11 Communicating with PLCs

10.11.1 Basics of communication

10.11.1.1 Communication between devices

Communication
The data exchange between two devices is known as communication. The devices can be 
interconnected directly or via a network. The interconnected devices in communication are 
referred to as communication partners.     

Data transferred between the communication partners may serve different purposes:

● Display processes

● Operate processes

● Output alarms

● Archive process values and alarms

● Document process values and alarms

● Administer process parameters and machine parameters

Communication partners
Communication between the following devices is described in more detail in this section:

● PLC
The PLC controls a process by means of a user program.

● HMI device
You use the HMI device to operate and monitor the process.   
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Basic information for all communication
The basis for all types of communication is a network configuration. In a network configuration, 
you specify the connection that exists between the configured devices. 

With the network configuration, you also ensure the necessary prerequisites for 
communication, in other words:

● Every device in a network is assigned a unique address.

● The devices carry out communication with consistent transmission characteristics.

Automation system
The following characteristics describe an automation system:

● The PLC and HMI device are interconnected

● The network between the PLC and HMI device is configured

Communication between HMI devices
The HTTP protocol is available for communication between HMI devices. 

For more detailed information, refer to the documentation on the SIMATIC HMI HTTP protocol.

Communication via a uniform and vendor-neutral interface
With OPC (Openess Productivity Collaboration), WinCC has a uniform and manufacturer-
neutral software interface. This interface enables standardized data exchange between 
industrial, office, and manufacturing applications. 

For more detailed information, refer to the documentation for OPC.

10.11.1.2 Devices and networks in the automation system

Introduction
To set up an automation system, you must configure, parameterize, and interconnect the 
individual devices.

You insert PLCs and HMI devices into the project in the same way. Likewise, you configure 
the two devices in the same way.

Automation system setup:

1. Insert PLC into the project.

2. Insert HMI device into the project.

3. Network the devices together.

4. Interconnect the devices.
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Inserting devices  
If you have created a project, you can add a device in the portal view or project view. 
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● Portal view

● Project view
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Networking devices
You can network the interfaces of the communication-capable devices conveniently in the 
"Devices & Networks" editor. In the networking step, you configure the physical device 
connections. 

The tabular network overview supplements the graphical network view with the following 
additional functions:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect communication-capable components to 
subnets that have been created.   
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Connecting devices
After you network the devices together, you configure the connection. You configure the "HMI 
connection" connection type for communication with the HMI device.    

10.11.1.3 Data exchange using tags

Communication using tags    
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

Working with tags
See the chapter "Working with tags (Page 3685)" for further information about configuring tags.
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10.11.1.4 Data exchange using area pointers

Communication using area pointers
Area pointers are parameter fields. WinCC receives information from these parameter fields 
in Runtime during the course of the project. This information contains data on the location and 
size of data areas in the PLC.

During communication, the PLC and the HMI device alternately access these data areas for 
read and write operations. 

Based on the evaluation of data stored in the data areas, the PLC and HMI device initiate 
mutually defined actions. 

The area pointers are managed centrally in the "Connections" editor. Area pointers are used 
to exchange data from specific user data areas. 

You use the following area pointers in WinCC:

● Data record

● Date/time

● Coordination

● Job mailbox

● Date/time PLC

● Project ID

● Screen number

The availability of the various area pointers is determined by the HMI device used.                  

10.11.1.5 Communication drivers

Communication drivers
A communication driver is a software component that establishes a connection between a PLC 
and an HMI device. The communication driver thus enables the assignment of process values 
to HMI tags.

The interface as well as the profile and transmission speed can be chosen, depending on the 
HMI device used and the connected communication partner.
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10.11.2 Editors for communication

10.11.2.1 "Devices & networks" editor

Function of the hardware and network editor     
The "Devices & networks" editor is the development environment for networking, configuring 
and assigning parameters to devices and modules.

Configuration     
The "Devices & networks" editor consists of the following components:

1 Device view, network view, topology view
2 Hardware catalog
3  Inspector window 
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The "Devices & networks" editor provides you with three different views of your project. You 
can switch between these three views at any time depending on whether you want to produce 
and edit individual devices and modules, entire networks and device configurations or the 
topological structure of your project.

The inspector window contains information on the object currently marked. Here you can 
change the settings for the object marked.

Drag the devices and modules you need for your automation system from the hardware catalog 
to the network, device or topology view. 

10.11.2.2 Network view

Introduction
The network view is a working area of the hardware and network editor. 

You undertake the following tasks in network view:

● Configuring and assign device parameters

● Networking devices with one another
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Structure     
The following diagram shows the components of the network view:

1 Changeover switch: network view/device view/topology view
2 Toolbar of network view
3 Graphic area of network view
4 Overview navigation
5 Table area of network view

You can use your mouse to change the spacing between the graphic and table areas of the 
network view. 

To do this, click on the upper edge of the table view and expand or contract this by moving the 
mouse with the mouse button held down. 

You can use the two small arrow keys to minimize, maximize or select the latest table structure 
of the table view with just one click.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Mode to network devices.

Mode to create connections.
You can select the connection type using the adjacent drop-down list.
Mode to create relations.

Show interface addresses.

Adjust the zoom setting.
You can select the zoom setting or enter it directly in the adjacent drop-down list. You 
can also zoom in or zoom out the view in steps using the zoom symbol or draw a frame 
around an area to be zoomed in.
Show page breaks
Enables the page break preview. Dashed lines will be displayed at the positions where 
the pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table view 
is stored.

Graphic area
The graphic area of the network view displays any network-related devices, networks, 
connections and relations. In this area, you add devices from the hardware catalog, connect 
them with each other via their interfaces and configure the communication settings.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the network view includes various tables for the devices, connections and 
communication settings present:

● Network overview

● Connections

● I/O communication

You can use the shortcut menu of the title bar of the table to adjust the tabular display.
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10.11.2.3 Network data

Introduction
The "Network view" editor also gives you a tabular view of the "Network data" in addition to 
the graphic network view.

You have the following selections in the "Network data" editor:

● Network overview

● Connections

● VPN

● I/O communication

You open the "Network data" below the graphic network overview.

Basic functions
The network data are displayed in tabular form and support the following basic functions for 
editing a table:

● Displaying and hiding table columns
 Note: The columns of relevance to configuration cannot be hidden. 

● Optimizing column width

● Sorting table

● Displaying the meaning of a column, a row or cell using tooltips.
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Network overview
The tabular network overview adds the following functions to the graphic network view:

● You obtain detailed information on the structure and parameter settings of the devices.

● Using the "Subnet" column, you can connect components capable of communication with 
created subnets.

The 

Connections
You will find additional network data under "Connections".
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10.11.2.4 Diagnostics of online connections

Diagnostics of online connections      
You can read out the diagnostics data of existing connections in the TIA Portal.

The "Diagnostics" function shows the connection data in tabular form in the Inspector window.

Requirements
● Devices must be in "Online" mode.

Device information
The diagnostics data of all devices in "Online" mode is displayed in the "Diagnostics > Device 
information" Inspector window.

The following data is displayed:

● Online status

● Operating mode

● Device / module

● Alarm

● Details

● Help
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Connection information
Use the "Connection information" function to display the diagnostics data of the connection 
selected in the "Devices&Networks" editor.

A graphic displays the communication partners of the connection and by which communication 
driver they are connected with each other.

The following data is displayed:

● End point

● Interface

● Subnet

● Address

● TSAP

● Number of HMI resources

10.11.2.5 Device view

Introduction
The device view is a working area of the hardware and network editor. 

You undertake the following tasks in the device view:

● Configuring and assign device parameters

● Configuring and assign module parameters
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Structure     
The following diagram shows the components of the device view:

1 Changeover switch: network view/device view/topology view
2 Toolbar of device view
3 Graphic area of the device view
4 Overview navigation
5 Table area of device view

You can use your mouse to change the spacing between the graphic and table areas of the 
device view.

To do this, click on the upper edge of the table view and expand or contract this by moving the 
mouse with the mouse button held down. You can use the two small arrow keys to minimize, 
maximize or select the latest table structure of the table view with just one click.
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Toolbar   
The toolbar provides the following functions:

Icon Meaning
Switches to the network view.
Note: The device view can switch between the existing devices using the drop-down 
list.
Show the area of unplugged modules.

Show module labels.
Adjust the zoom setting.
Select the zoom setting or enter it directly in the adjacent drop-down list. You can use 
the Zoom button to zoom in or out incrementally or to drag a frame around an area to 
be enlarged.
You can read the address descriptions of the I/O channels of signal modules at a zoom 
level setting of 200% or higher.
Show page breaks
Enables the page break preview. Dashed lines will be displayed at the positions where 
the pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the device view displays hardware components and if necessary the 
associated modules that are assigned to each other via one or more racks. In the case of 
devices with racks, you have the option of installing additional hardware objects from the 
hardware catalog into the slots on the racks.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
The table area of the device view gives you an overview of the modules used and the most 
important technical and organizational data.

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

10.11.2.6 Topology view

Introduction
The topology view is a working area of the hardware and network editor. 
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You undertake the following tasks in topology view:

● Displaying the Ethernet topology

● Configuring the Ethernet topology

● Identify and minimize differences between the desired and actual topology

Structure     
The following figure provides an overview of the topology view.

1 Changeover switch: device view / network view / topology view
2 Topology view toolbar
3 Graphic area of the topology view
4 Overview navigation
5 Table area of the topology view

You can use your mouse to change the spacing between the graphic and table areas of the 
topology view. 
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To do this, click on the upper edge of the table view and expand or contract this by moving the 
mouse with the mouse button held down. You can use the two small arrow keys to minimize, 
maximize or select the latest table structure of the table view with just one click.

Toolbar   
The toolbar provides the following functions:

Icon Meaning
Adjust the zoom setting.
You can select the zoom setting via the adjacent drop-down list or enter it directly. You 
can also zoom in or zoom out the view in steps using the zoom symbol or draw a frame 
around an area to be zoomed in.
Show page breaks
Enables the page break preview. Dashed lines will be displayed at the positions where 
the pages will break when printed.
Remember layout
Saves the current table view. The layout, width and visibility of columns in the table 
view is stored.

Graphic area
The graphic area of the topology view displays Ethernet modules with their appropriate ports 
and port connections. Here you can add additional hardware objects with Ethernet interfaces.

Overview navigation     
Click in the overview navigation to obtain an overview of the created objects in the graphic 
area. By holding down the mouse button, you can quickly navigate to the desired objects and 
display them in the graphic area.

Table area
This displays the Ethernet or PROFINET modules with their appropriate ports and port 
connections in a table. This table corresponds to the network overview table in the network 
view. 

You can use the shortcut menu of the title bar of the table to adjust the tabular display.

10.11.2.7 Inspector window 
The properties and parameters shown for the object selected can be edited in the inspector 
window.
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Structure     
The inspector window consists of the following components:

1 Switch between various information and work areas
2 Navigation between various pieces of information and parameters
3 Display showing the selected information and parameters

Function
The information and parameters in the inspector window are split into different types of 
information:

● Properties

● Info

● Diagnostics

To display the corresponding information and parameters, click in the area you want. The 
"Properties" area is the most important one for configuring an automation system. This area 
is displayed by default.

The left pane of the inspector window is used for area navigation. Information and parameters 
are arranged there in groups. If you click on the arrow symbol to the left of the group name, 
you can expand the group if sub-groups are available. If you select a group or sub-group, the 
corresponding information and parameters are displayed in the right pane of the inspector 
window and can be edited there too.
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10.11.2.8 Hardware catalog 
The "Hardware catalog" task card gives you easy access to a wide range of hardware 
components.
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Structure         
The "Hardware catalog" task card consists of the following panes:

1

2

3

1 "Catalog" pane, search and filter function
2 "Catalog" pane, component selection
3 "Information" pane
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Search and filter function
The search and filter functions of the "Catalog" pane make it easy to search for particular 
hardware components. You can limit the display of the hardware components to certain criteria 
using the filter function. For example, you can limit the display to objects that you can also 
place within the current context or which contain certain functions.

Objects that can be used in the current context include, for example, interconnectable objects 
in the network view or only modules compatible with the device in the device view.

Component selection
The component selection in the "Catalog" pane contains the installed hardware components 
in a tree structure. You can move the devices or modules you want from the catalog to the 
graphic work area of the device or network view.

Installed hardware components without a license are grayed out. You cannot use non-licensed 
hardware components.

Hardware components belonging to various components groups thematically are partially 
implemented as linked objects. When you click on such linked hardware components, a catalog 
tree opens in which you can find the appropriate hardware components.

Information
The "Information" pane contains detailed information on the object selected from the catalog:

● Schematic representation

● Name

● Order number

● Version number

● Description

10.11.2.9 Information on hardware components
In the hardware catalog, you can display information on selected hardware components in the 
"Information" pane. You can also display further information on the selected hardware 
components using the shortcut menu.

Access to further information
If you select a hardware object in the hardware catalog and open the shortcut menu, you not 
only have the "Copy" function available but also three options for accessing information on 
Service & Support:

● Information regarding product support

● FAQs

● Manuals
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The required information is displayed in the work area of the hardware and network editor.
 

 Note

You can only access Service & Support when you are connected to the Internet and the 
function is enabled. By default, the function is disabled. 

To enable the function, refer to the instructions in the section "Enabling product support".   
 

Information regarding product support   
Here, you have access to general information on hardware and software components. The 
order number of the selected hardware object is entered automatically in the search mask. 
You can, however, also search for other hardware and software components.

FAQs   
Here, you have access to "Frequently Asked Questions" (FAQs). You can view various entries 
on hardware and software questions. Using a detailed search mask, you can filter the required 
topics.

Manuals   
Here, you have access to the manuals of the various hardware components. This is particularly 
useful if the configuration, addressing or parameter assignment you are planning requires more 
detailed knowledge of the hardware you are using.

10.11.3 Networks and connections

10.11.3.1 SIMATIC communication networks

Communication networks

Overview
Communication networks are a central component of modern automation solutions. Industrial 
networks have to fulfill special requirements, for example:

● Coupling of automation systems as well as simple sensors, actuators, and computers.

● The information has to be correct and has to be transferred at the right moment.

● Robust against electromagnetic disturbances, mechanical stresses and soiling

● Flexible adaptation to the production requirements

Industrial networks belong to the LANs (Local Area Networks) and allow communication within 
a limited area. 
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Industrial networks fulfill the following communication functions:

● Process and field communication of the automation systems including sensors and 
actuators

● Data communication between automation systems

● IT communication for integrating the modern information technology

Overview of the networks
This section examines the following networks:

● Industrial Ethernet
The industrial network standard for all levels

● PROFINET
The open Industrial Ethernet standard for automation

● PROFIBUS
The international standard for the field area and market leader at the field busses

● MPI
The integrated interface of the SIMATIC products

● PPI 
The integrated interface specially for the S7-200

PROFINET

Industrial Ehernet

PROFIBUS
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PROFINET and Ethernet

Industrial Ethernet
Industrial Ethernet, which is based on IEEE 802.3, enables you to connect your automation 
system to your office networks. Industrial Ethernet provides IT services that you can use to 
access production data from the office environment.       

Ethernet network
An Ethernet network allows you to interconnect all devices that are connected to the network 
via an integrated Ethernet interface or a communication module. This enables connection of 
multiple HMI devices to one SIMATIC S7 PLC and multiple SIMATIC S7 PLCs to one HMI 
device. The maximum number of communication partners that you can connect to an HMI 
device is dependent on the HMI device used. Additional information is available in the 
documentation for the respective HMI device. 

PROFINET
PROFINET is an open standard for industrial automation defined by IEEE 61158 and based 
on Industrial Ethernet. PROFINET makes use of IT standards all the way to the field level and 
enables plant-wide engineering. 

With PROFINET, you can realize high-performance automation solutions for applications with 
stringent real-time requirements. 

PROFIBUS

PROFIBUS DP
PROFIBUS DP (distributed I/O) is used to connect the following devices: 

● PLCs, PCs, HMI devices

● Distributed I/O devices, e.g., SIMATIC ET 200

● Valves

● Drives

PROFIBUS DP's fast response times make it ideally suited for the manufacturing industry. 

Its basic functionality includes cyclic exchange of process data between the master and 
PROFIBUS DP slaves, as well as diagnostics.

PROFIBUS network
You can connect an HMI device within the PROFIBUS network to any SIMATIC S7 module 
that has an integrated PROFIBUS or PROFIBUS DP interface. You can thereby connect 
multiple HMI devices to one SIMATIC S7 PLC and multiple SIMATIC S7 PLCs to one HMI 
device.
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The maximum number of communication partners that you can connect to an HMI device is 
dependent on the HMI device used. Additional information is available in the documentation 
for the respective HMI device. 

You configure the SIMATIC S7-200 PLC as a passive device in the network. You connect the 
SIMATIC S7-200 using the DP connector or a PROFIBUS communication module.

MPI

MPI
MPI (Multi-Point Interface) is the integrated interface for SIMATIC products: 

● PLCs

● HMI devices

● Programming device/PC

Small subnets with the following characteristics are set up with MPI:

● Short distances

● Few devices

● Small data quantities   

MPI network
You connect the HMI device to the MPI interface of the SIMATIC S7 PLC. This enables 
connection of multiple HMI devices to one SIMATIC S7 PLC and multiple SIMATIC S7 PLCs 
to one HMI device. The maximum number of communication partners that you can connect to 
an HMI device is dependent on the HMI device used. Additional information is available in the 
documentation for the respective HMI device. 

Network architectures
MPI is based on the PROFIBUS standard (IEC 61158 and EN 50170) and supports the 
following bus topologies: 

● Line

● Star

● Tree

An MPI subnet contains a maximum of 127 devices and consists of multiple segments. Each 
segment contains a maximum of 32 devices and is limited by terminating resistors. Repeaters 
are used to connect segments. The maximum cable length without a repeater is 50 m.   
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PPI

Introduction
PPI (point-to-point interface) is an integrated interface that was developed specially for the 
SIMATIC S7-200. A PPI network typically connects S7-200 PLCs. However, other 
SIMATIC PLCs (e.g., S7-300 and S7-400) or HMI devices can communicate with a SIMATIC 
S7-200 in the PPI network. 

PPI network
A PPI connection is a point-to-point connection. The HMI device is the master. The SIMATIC 
S7-200 is the slave. 

You can connect a maximum of one SIMATIC S7-200 to an HMI device. You use the serial 
connector of the CPU to connect the HMI device. You can connect multiple HMI devices to 
one SIMATIC S7-200. From the perspective of the SIMATIC S7-200, only one connection at 
a time is possible.   

 

 Note

The PPI network can contain a maximum of four masters in addition to the HMI device. For 
performance reasons, do not configure more than four devices at a time as a master in the 
PPI network. 

 

Network architectures
PPI is based on the PROFIBUS standard (IEC 61158 and EN 50170) and supports the 
following bus topologies:

● Line

● Star

Multi-master networks with a maximum of 32 masters are set up with PPI:

● An unlimited number of masters can communicate with each slave.

● A slave can be assigned to multiple masters.

The RS 485 repeater can be used to extend the PPI network. Modems can also be connected 
to the PPI network.   

 

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6146 System Manual, 02/2014



10.11.3.2 Configuring networks and connections

Networking devices

Introduction
The "Devices & Networks" editor is provided for configuring connections. You can network 
devices in the editor. You can also configure and assign parameters to devices and interfaces. 
You then configure the required connections between the networked devices.

In the "Devices & Networks" editor you configure HMI connections with the PLCs:

● SIMATIC S7 1500

● SIMATIC S7 1200

● SIMATIC S7 300

● SIMATIC S7 400

You configure the HMI connections to other PLCs in the "Connections" editor of the respective 
HMI device.               

Networking devices
The network view of the "Devices & Networks" editor includes a graphical area and a tabular 
area. You can use the graphical area to network the devices in the project with drag-and-drop. 
The tabular area provides an overview of the devices and their components.       

You can network the following PLCs together with HMI devices in the "Devices & Networks" 
area.

● SIMATIC S7 1500

● SIMATIC S7 1200

● SIMATIC S7 300

● SIMATIC S7 400

All other PLCs are available in the TIA-Portal and are configured "not integrated". You configure 
"not integrated" connections in the "Connections" editor of the HMI device. 
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With the networking step, you configure the physical connection of the communication 
partners. The networking of devices is depicted by lines that are colored according to the 
interface.

Configuring an integrated connection in the "Devices & Networks" editor

Introduction
You configure an HMI connection between the HMI device and a SIMATIC S7 PLC in the 
"Devices & Networks" editor. This HMI connection is the direct connection between the 
communication partners that you have created in a project.                 

Integrated connections
Connections of devices within a project are referred to as integrated connections. In the case 
of integrated connections, you can directly configure addresses of PLC tags.

 

 Note

An HMI connection can be configured in the "Devices & Networks" editor for the following 
PLCs only:
● SIMATIC S7 1500
● SIMATIC S7 1200
● SIMATIC S7 300
● SIMATIC S7 400

You configure the HMI connections to all other PLCs in the "Connections" editor of the HMI 
device.
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Configuring an HMI connection in the "Devices & Networks" editor
1. Insert an HMI device and a SIMATIC S7 PLC in your project.

2. Switch to "Connections" mode.

3. Select the "HMI connection" connection type.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6149



4. Use a drag-and-drop operation to interconnect the two PROFINET interfaces.

5. Change the IP address and subnet mask address parameters according to the 
requirements of your project.

Special considerations of the "Devices & Networks" editor

Introduction
If you are configuring or have already configured networks or HMI connections, the "Devices 
& Networks" editor supports you with the following functions:

● Highlighting of communication partners

● Highlighting of HMI connections

● Automatic creation of subnets

Highlighting of communication partners  
All communication partners for which an HMI connection is possible are highlighted in turquoise 
if you have selected the "HMI connection" type. 

Starting from the interface of a device create an HMI connection to the device of another device 
using a drag-and-drop operation. During the drag-and-drop operation all potential 
communication partners are highlighted in turquoise.

Use the ESC key to stop connecting interfaces using a drag-and-drop operation.
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When the mouse pointer is moved over the interface of a device, the following icons indicate 
whether a connection is possible:

A connection is possible.

A connection is not possible.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6151



Highlighting of HMI connections
A turquoise highlighting of the connection indicates that a HMI connection was created. If 
several HMI connections are created, you can select one of the already created HMI 
connections in a dialog. 

Then you can configure the parameters of the selected HMI connection and the communication 
partners in the inspector window.

Subnets
Subnetworks are automatically created and used under the following conditions:

● If both communication partners are not already interconnected in different networks

● If a free interface is available to both communication partners.

● If a subnetwork already exists then that subnetwork is automatically used for the HMI 
connection.

Configuring a non-integrated connection in the "Connections" editor

Introduction
You use the "Connections" editor of the HMI device to configure a connection between an HMI 
device and a PLC that cannot be configured in the "Devices & Networks" editor.

These connections are referred to as non-integrated connections.       
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Requirements
● A project is open.

● An HMI device has been created.

Configuring a connection in the "Connections" editor
1. Open the "Connections" editor of the HMI device.

2. Create a new connection.
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3. Select the communication driver.

4. Set the connection parameters.

Integrated connections in the "Connections" editor
If you have already configured the integrated connections of the HMI device in the "Devices 
& Networks" editor, they are also displayed in the "Connections" editor.

Meaning of the icons used:
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Integrated connection
Non-integrated connection

10.11.4 Data exchange

10.11.4.1 Data exchange using tags

Basics of tags

Introduction
Process values are forwarded in runtime using tags. Process values are data which is stored 
in the memory of one of the connected automation systems. They represent the status of a 
plant in the form of temperatures, fill levels or switching states, for example. Define external 
tags for processing the process values in WinCC.

WinCC works with two types of tag:

● External tags

● Internal tags

The external tags form the link between WinCC and the automation systems. The values of 
external tags correspond to the process values from the memory of an automation system. 
The value of an external tag is determined by reading the process value from the memory of 
the automation system. It is also possible to rewrite a process value in the memory of the 
automation system.

Internal tags do not have a process link and only convey values within the WinCC. The tag 
values are only available as long as runtime is running.

Tags in WinCC
For external tags, the properties of the tag are used to define the connection that the WinCC 
uses to communicate with the automation system and form of data exchange.   

Tags that are not supplied with values by the process - the internal tags - are not connected 
to the automation system. In the tag's "Connection" property, this is identified by the "Internal 
tag" entry.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6155



You can create tags in different tag tables for greater clarity. You then directly access the 
individual tag tables in the "HMI tags" node in the project tree. The tags from all tag tables can 
be displayed with the help of the table "Show all tags".

With structures you bundle a number of different tags that form one logical unit. Structures are 
project-associated data and are available for all HMI devices of the project. You use the "Types" 
editor in the project library to create and edit a structure.

Overview of HMI tag tables

Introduction
HMI tag tables contain the definitions of the HMI tags that apply across all devices. A tag table 
is created automatically for each HMI device created in the project.    

In the project tree there is an "HMI tags" folder for each HMI device. The following tables can 
be contained in this folder:

● Default tag table

● User-defined tag tables

● Table of all tags

In the project tree you can create additional tag tables in the HMI tags folder and use these to 
sort and group tags and constants. You can move tags to a different tag table using a drag-
and-drop operation or with the help of the "Tag table" field. Activate the "Tags table" field using 
the shortcut menu of the column headings.

Default tag table
There is one default tag table for each HMI device of the project. It cannot be deleted or moved. 
The default tag table contains HMI tags and, depending on the HMI device, also system tags. 
You can declare all HMI tags in the standard tags table or, as necessary, additional user-
defined tables of tags.

User-defined tag tables
You can create multiple user-defined tag tables for each HMI device in order to group tags 
according to your requirements. You can rename, gather into groups, or delete user-defined 
tag tables. To group tag tables, create additional subfolders in the HMI tags folder. 

All tags
The "All tags" table shows an overview of all HMI tags and system tags of the HMI device in 
question. This table cannot be deleted, renamed or moved. This table also contains the "Tags 
table" column, which indicates the tag table of where a tag is included. Using the "Tags table" 
field, the assignment of a tag to a tags table can be changed. 

With devices for Runtime Professional, the table "All tags" contain an additional tab "System 
tags". The system tags are created by the system and used for internal management of the 
project. The names of the system tags begin with the "@" character. System tags cannot be 
deleted or renamed. You can evaluate the value of a system tag, but cannot modify it.
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Additional tables
The following tables are also available in an HMI tag table:

● Discrete alarms

● Analog alarms

● Logging tags

With the help of these tables you configure alarms and logging tags for the currently selected 
HMI tag. 

Discrete alarms table
In the "Discrete alarms" table, you configure discrete alarms to the HMI tag selected in the 
HMI tag table. When you configure a discrete alarm, multiple selection in the HMI tag table is 
not possible. You configure the discrete alarms for each HMI tag separately.

Analog alarms table
In the "Analog alarms" table, you configure analog alarms to the HMI tag selected in the HMI 
tag table. When you configure an analog alarm, multiple selection in the HMI tag table is not 
possible. You configure the analog alarms for each HMI tag separately.

Logging tags table
In the "Logging tags" table, you configure logging tags to the HMI tag selected in the HMI tag 
table. When you configure a logging tag, multiple selection in the HMI tag table is not possible. 
You configure the logging tags for each HMI tag separately. The "Logging tags" table is only 
available if the HMI device used supports logging. 
If WinCC Runtime Professional is used, you can also assign several log tags to a tag. With 
the other HMI devices, you can only assign one log tag to a tag.

External tags

Introduction
External tags allow communication (data exchange) between the components of an 
automation system, for example, between an HMI device and a PLC.

Principle
An external tag is the image of a defined memory location in the PLC. You have read and write 
access to this storage location from both the HMI device and from the PLC.   

Since external tags are the image of a storage location in the PLC, the applicable data types 
depend on the PLC which is connected to the HMI device.

If you write a PLC control program in STEP 7, the PLC tags created in the control program will 
be added to the PLC tag table. If you want to connect an external tag to a PLC tag, access the 
PLC tags directly via the PLC tag table and connect them to the external tag.
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Data types
All the data types which are available at the connected PLC are available at an external tag 
in WinCC. Information about data types which are available for connection to other PLCs can 
be found in the documentation about the respective communication drivers.

See "Communication between devices (Page 6118)" for additional information.
 

 Note

As well as external tags, area pointers are also available for communication between the HMI 
device and PLC. You can set up and enable the area indicators in the "Connections" editor.

 

Synchronization with PLC tags 
A variety of options for synchronizing external tags with the PLC tags are available in the 
Runtime settings under "Settings for tags".

When you perform synchronization, you have the option of automatically applying the tag 
names of the PLC to external tags and reconnecting the existing tags. 

The generated tag name is derived from the position of the data value in the hierarchical 
structure of the data block. 

Update of tag values
For external tags, the current tag values are transmitted in runtime via the communication 
connection between WinCC and the connected automation systems and then saved in the 
runtime memory. Next, the tag value will be updated to the set cycle time. For use in the runtime 
project, WinCC accesses tag values in the runtime memory that were read from the PLC at 
the previous cycle time. As a result, the value in the PLC can already change whilst the value 
from the runtime memory is being processed.     

 

 Note
PLC array elements in conjunction with S7-1200 or S7-1500 

The index of the PLC array elements can begin with any number. In WinCC, indexing always 
starts with 0. 

A PLC tag "Array [1..3] of Int", for example, is mapped to "Array [0..2] of Int" in WinCC.

When you access an array in a script, pay attention to the correct indexing.
 

See also
Communication between devices (Page 6118)
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Addressing external tags

Introduction
The options for addressing external tags depend on the type of connection between WinCC 
and the PLC in question. A distinction must be made between the following connection 
types:         

● Integrated connection
Connections of devices which are within a project and were created with the "Devices & 
Networks" editor are referred to as integrated connections.

● Non-integrated connection
Connections of devices which were created with the "Connections" editor are referred to 
as non-integrated connections. It is not necessary that all of the devices be within a single 
project.

The connection type can also be recognized by its icon.

Integrated connection
Non-integrated connection

You can find additional information in the section "Basics of communication (Page 6118)".

Addressing with integrated connections
An integrated connection offers the advantage that you can address a tag both symbolically 
and absolutely.

For symbolic addressing, you select the PLC tag via its name and connect it to the HMI tag. 
The valid data type for the HMI tag is automatically selected by the system. You have to 
distinguish between the following cases when you address elements in data blocks:

Symbolic addressing of data blocks with optimized access and standard access: 

During the symbolic addressing of a data block with optimized access and standard access, 
the address of an element in the data block is dynamically assigned and is automatically 
adopted in the HMI tag in the event of a change. You do not need to compile the connected 
data block or the WinCC project for this step.
For data blocks with optimized access, only symbolic addressing is available.

For symbolic addressing of elements in a data block, you only need to recompile and reload 
the WinCC project in case of the following changes:

● If the name or the data type of the linked data block element or global PLC tag has changed.

● If the name or the data type of the higher level structure node of a linked element in the 
data block element or global PLC tag has changed.

● If the name of the connected data block has changed.

Symbolic addressing is currently available with the following PLCs:

● SIMATIC S7 1200

● SIMATIC S7 1500

Symbolic addressing is also available if you have an integrated link.
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 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

You can also use absolute addressing with an integrated connection. You have to use absolute 
addressing for PLC tags from a SIMATIC S7 300/400 PLC. If you have connected an HMI tag 
with a PLC tag and the address of the PLC tag changes, you only have to recompile the control 
program to update the new address in WinCC. Then you recompile the WinCC project and 
load it onto the HMI device.

In WinCC, symbolic addressing is the default method. To change the default setting, select 
the menu command "Options > Settings". Select "Visualization > Tags" in the "Settings" dialog. 
If required, disable the "Symbolic access" option.     

The availability of an integrated connection depends on the PLC used. The following table 
shows the availability:

PLC Integrated connection Comments
S7 300/400 Yes The linking of tags is not checked in Runtime. If 

the tag address changes in the PLC and the HMI 
device is not compiled again and loaded, the 
change is not registered in runtime.

S7 1200 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

S7 1500 Yes A validity check of the tag connection is 
performed in runtime during symbolic 
addressing. If an address is changed in the PLC, 
the change is registered and an error message 
is issued. In the case of absolute addressing, the 
following behavior applies to the S7 300/400.

Create an integrated connection in the "Devices & Networks" editor. If the PLC is contained in 
the project and integrated connections are supported, you can then also have the connection 
created automatically. To do this, when configuring the HMI tag, simply select an existing PLC 
tag to which you want to connect the HMI tag. The integrated connection is then automatically 
created by the system.

Addressing with non-integrated connections
In the case of a project with a non-integrated connection, you always configure a tag connection 
with absolute addressing. Select the valid data type yourself. If the address of a PLC tag 
changes in a project with a non-integrated connection during the course of the project, you 
also have to make the change in WinCC. The tag connection cannot be checked for validity 
in Runtime, an error message is not issued.

A non-integrated connection is available for all supported PLCs.
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Symbolic addressing is not available in a non-integrated connection.

With a non-integrated connection, the control program does not need to be part of the WinCC 
project. You can perform the configuration of the PLC and the WinCC project independently 
of each other. For configuration in WinCC, only the addresses used in the PLC and their 
function have to be known.

See also
Basics of communication (Page 6118)

Internal Tags

Introduction
Internal tags do not have any connection to the PLC. Internal tags transport values within the 
HMI device. The tag values are only available as long as runtime is running. 

Principle
Internal tags are stored in the memory of the HMI device. Therefore, only this HMI device has 
read and write access to the internal tags. You can create internal tags to perform local 
calculations, for example.   

You can use the HMI data types for internal tags. Availability depends on the HMI device being 
used.

The following HMI data types are available:

HMI data type Data format
Array One-dimensional array
Bool Binary tag
DateTime Date/time format
DInt Signed 32-bit value
Int Signed 16-bit value
LReal Floating-point number 64-bit IEEE 754
Real Floating-point number 32-bit IEEE 754
SInt Signed 8-bit value
UDnt Unsigned 32-bit value
UInt Unsigned 16-bit value
USInt Unsigned 8-bit value
WString Text tag, 16-bit character set
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10.11.4.2 Data exchange using area pointers

Basic information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. The 
PLC and the HMI device trigger defined interactions based on the evaluation of stored data.

For example, area pointers are required for the following data:

● Recipes

● Job mailboxes

● Sign-of-life monitoring

Area pointer
The following area pointers are supported:

Area pointer
Area pointers can be configured for connections.

● Data record

● Date/time

● Coordination

● Job mailbox

Global area pointers of the HMI device
Global area pointers can be configured to only one connection for each project.

● Screen number

● Date/time PLC

● Project ID

Area pointers for connections

Introduction
Using the "Area pointer" tab of the "Connections" editor, you can configure the usage of the 
available area pointers.

To configure the area pointers, open the "Connections" editor and open the "Area pointer" tab.
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Structure
The "Area pointer" tab contains two tables of area pointers. The top part of the table contains 
the area pointers you can create and enable separately for each available connection.

The "Global area pointers of HMI device" table contains the area pointers which are created 
only once in the project and can be used for only one connection.  
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Use of area pointers

"Area pointer" tab
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You assign the following parameters in the "Area pointer" tab:                

● Active
Enables the area pointer.

● Pointer name
Name of the area pointer specified by WinCC.

● PLC tag
Here you select the PLC tag or the tag array that you have configured as the data area for 
the area pointer.

● Access mode
Here you can select from the following access modes:

– Symbolic access

– Absolute access

● Address
If you selected "Symbolic access", no address is entered in this field.
If you selected "Absolute access", enter the address of a tag in the "Address" field.

● Length
WinCC specifies the length of the area pointer.

● Acquisition cycle
You specify the acquisition cycle in this field for area pointers that are read by the HMI 
device. Note that a very short acquisition time may have a negative impact on HMI device 
performance.

● Comment
Enter a comment, for example, to describe the purpose of the area pointer.
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Accessing data areas

Accessing data areas
The following table shows how HMI devices and PLCs access individual data areas for read 
(R) or write (W) operations.   

Data area Required for HMI device PLC
Screen number Evaluation by the PLC in order to determine the active screen. W R
Data record Transfer of data records with synchronization R/W R/W
Date/time Transfer of the date and time from the HMI device to the PLC W R
Date/time PLC Transfer of the date and time from the PLC to the HMI device R W
Coordination Requesting the HMI device status in the PLC program W R
Project ID Runtime checks for consistency between the WinCC project 

ID and the project in the PLC
R W

Job mailbox Triggering of HMI device functions by the PLC program R/W R/W

Configuring area pointers

Configuration of area pointers

Introduction
You use an area pointer to access a data area in the PLC. The data area is stored in the 
PLC.     

Prior to configuring area pointers
Before you use the area pointer, you must enable and parameterize it under "Connections > 
Area Pointer".

Global data block
To access the data area in the PLC, you have to create a global data block in the PLC program. 
The following example shows the use of a data block. 

Length of area pointers
For area pointers with a length >= 1, you set up the data area as a tag array in a global data 
block or instance data block. 

You also have the option to use a PLC tag for area pointers with a length = 1. 

The configuration of the tags in a data block is dependent on the length of the area pointer you 
want to use. The unit for the length of an area pointer is a 16-bit word. 
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If, for example, you want to use an area pointer with a length of "5", you must create an array 
with 5 array elements of the data type UINT in the data block.     

Alternative procedure
Alternatively, you can also use the absolute access mode to access area pointers. Absolute 
access mode only works on standard PLC data blocks. 

Parameterizing a global data block 

Introduction
To access the data area in the PLC, a global data block for the area pointer must be 
parameterized in the PLC program.  

Requirements
● A PLC is created in the project.

● A connection is configured between the PLC and the HMI device.

● The PLC program contains a global data block.

Procedure
1. Open "PLC > Program blocks" in the project tree.

2. Double-click the global data block you created previously.
The data block opens.

3. Enter a tag name in the "Name" column.

4. Select "Array[lo .. hi] of type" as the data type in the "Data type" column.

5. Replace the "lo" entry by the low value for the dimension of the array.

6. Replace the "hi" entry by the high value for the dimension of the array.
Example: If you configure an area pointer with the length "4", enter the value "0" for "lo" 
and the value "3" for "hi" inside the brackets.
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7. Replace the "type" designation with the "word" data type.
The full data type for an array of 4 tags appears as follows: "Array[0 .. 3] of word".
The tag array is created after the entry is confirmed.

8. Click "Compile".
The project is compiled.

Configuring an area pointer for a connection

Introduction
After you have parameterized the global data block, you now create the area pointer for the 
connection.  

Requirements
● The global data block has been parameterized in the PLC program.

Procedure
1. Open "HMI >Connections" in the project tree.

2. Click the "Area pointer" tab.

3. Enable the required area pointer.
You enable a global area pointer by selecting the connection in the "Connection" field.

4. Click the navigation button in the "PLC tag" field.
The object list opens. 
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5. Navigate to the data block in the object list, and select the tag in the right window.
You do not need an array tag to configure an area pointer with the length of "1". 

6. Select the "Word" data type when creating the tag in the data block.

If required, set additional parameters, such as the acquisition cycle, during configuration.

Result
The area pointer is enabled and connected to the PLC tag in the global data block.

10.11.5 Device dependency

10.11.5.1 Basic Panel

Communication drivers for Basic Panels

SIMATIC communication drivers

Device dependency of the Basic Panels
Various communication drivers are configured for Basic Panels depending on the 
communication.

The following tables show the communication drivers released for integrated and non-
integrated communication.

There are different versions of the HMI devices within the integrated communication.
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Communication drivers for integrated communication (V11.0)

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

KP300 Basic Yes Yes Yes Yes Yes No Yes
KP400 Basic Yes Yes Yes Yes Yes No Yes
KTP400 
Basic PN

Yes Yes Yes Yes Yes No Yes

KTP600 
Basic DP

Yes Yes Yes Yes Yes No Yes

KTP600 
Basic PN

Yes Yes Yes Yes Yes No Yes

KTP1000 
Basic DP

Yes Yes Yes Yes Yes No Yes

KTP1000 
Basic PN

Yes Yes Yes Yes Yes No Yes

TP1500 
Basic PN

Yes Yes Yes Yes Yes No Yes

Communication drivers for integrated communication (V12.0)

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

KP300 Basic No Yes Yes Yes Yes Yes Yes
KP400 Basic No Yes Yes Yes Yes Yes Yes
KTP400 
Basic PN

No Yes Yes Yes Yes Yes Yes

KTP600 
Basic DP

No Yes Yes Yes Yes Yes Yes

KTP600 
Basic PN

No Yes Yes Yes Yes Yes Yes

KTP1000 
Basic DP

No Yes Yes Yes Yes Yes Yes

KTP1000 
Basic PN

No Yes Yes Yes Yes Yes Yes

TP1500 
Basic PN

No Yes Yes Yes Yes Yes Yes
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Communication drivers for integrated communication (V13.0)

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

KTP400 
Basic

No Yes Yes Yes Yes Yes Yes

KTP700 
Basic 

No Yes Yes Yes Yes Yes Yes

KTP900 
Basic

No Yes Yes Yes Yes Yes Yes

KTP1200 
Basic

No Yes Yes Yes Yes Yes Yes

Communication drivers for non-integrated communication

HMI devices SIMATIC 
S7-1200

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC 
LOGO!

SIMATIC HTTP 
protocol

KP300 Basic Yes Yes Yes Yes Yes No
KP400 Basic Yes Yes Yes Yes Yes No
KTP400 Basic 
PN

Yes Yes Yes Yes Yes No

KTP600 Basic 
DP

Yes Yes Yes Yes Yes No

KTP600 Basic 
PN

Yes Yes Yes Yes Yes No

KTP700 Basic 
PN

Yes Yes Yes Yes Yes No

KTP900 Basic 
PN

Yes Yes Yes Yes Yes No

KTP1000 Basic 
DP

Yes Yes Yes Yes Yes No

KTP1000 Basic 
PN

Yes Yes Yes Yes Yes No

TP1500 Basic 
PN

Yes Yes Yes Yes Yes No

Other communication drivers

Device dependency of the Basic Panels
The following table shows which communication drivers you can configure with the various 
Basic Panels.                                         
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Communication drivers

HMI 
devices

OPC Allen-
Bradley 
EtherNet/IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubishi 
FX

Modicon 
Modbus 
TCP/IP

Modicon 
Modbus 
RTU

Omron 
Host Link

KP300 
Basic

No Yes No Yes No Yes No No

KP400 
Basic

No Yes No Yes No Yes No No

KTP400 
Basic PN

No Yes No Yes No Yes No No

KTP600 
Basic DP

No No Yes2) No Yes No Yes1) Yes

KTP600 
Basic PN

No Yes No Yes No Yes No No

KTP700 
Basic PN

No Yes No Yes No Yes No No

KTP900 
Basic PN

No Yes No Yes No Yes No No

KTP1000 
Basic DP

No No Yes2) No Yes No Yes1) Yes

KTP1000 
Basic PN

No Yes No Yes No Yes No No

TP1500 
Basic PN

No Yes No Yes No Yes No No

 

1) only with RS 422-RS232 converter
Order number: 6AV6 671-8XE00-0AX0

2) Direct communication with PLC 5 or KF2 module, otherwise only approved with 
RS422-RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0
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Interfaces of the Basic Panels

Device dependency of the Basic Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.             

Table 10-153 Basic Panels

 KP300 Basic
KP400 Basic
KTP400 Basic PN
KTP600 Basic PN
KTP700 Basic PN
KTP900 Basic PN
KTP1000 Basic PN
TP1500 Basic PN

KTP600 Basic DP
KTP1000 Basic DP

SIMATIC S7 - PPI 1) — MPI/DP (X2)
SIMATIC S7 - MPI — MPI/DP (X2)
SIMATIC S7 - PROFIBUS — MPI/DP (X2)
SIMATIC S7 - PROFINET PROFINET (X1) —
SIMATIC HMI HTTP protocol — —
OPC — —
Allen-Bradley EtherNet/IP PROFINET (X1) —
Allen-Bradley DF1 — MPI/DP (X2) 2)

Mitsubishi TCP/IP PROFINET (X1) —
Mitsubishi FX — MPI/DP (X2) (RS422)
Modicon Modbus TCP PROFINET (X1) —
Modicon Modbus RTU — MPI/DP (X2) 3)

Omron Host Link — MPI/DP (X2) (RS422)

1) For SIMATIC S7-200 only
2) Direct communication with PLC5 or KF2 module, otherwise only approved with RS422-

RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

3) only approved with RS 422-RS232 converter
Order number: 6AV6 671-8XE00-0AX0
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Area pointers for Basic Panels

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.  

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointer

 KP300 
Basic

KTP400 
Basic PN

KTP600 
Basic PN

KTP600 
Basic DP

KTP700 
Basic PN

KTP900 
Basic PN

KTP1000 
Basic PN

KTP1000 
Basic DP

TP1500 
Basic PN

Screen 
number

Yes Yes Yes Yes Yes Yes Yes Yes Yes

Data record Yes Yes Yes Yes Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes Yes Yes Yes
Date/time 
PLC

Yes Yes Yes Yes Yes Yes Yes Yes Yes

Coordination Yes Yes Yes Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes Yes Yes Yes
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10.11.5.2 Panel

Communication drivers for Panels

SIMATIC communication drivers

Device dependency of the panels
Various communication drivers are configured for panels depending on the communication.

The following tables show the communication drivers released for integrated and non-
integrated communication.

There are different versions of the HMI devices within the integrated communication.

Communication drivers for integrated communication (V11.0)

HMI devices SIMATI
C 
S7-1200
 (V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

OP 73 No Yes Yes Yes Yes No Yes
OP 77A No Yes Yes Yes Yes No Yes
OP 77B No Yes Yes Yes Yes No Yes
TP 177A No Yes Yes Yes Yes No Yes
TP 177A Portrait No Yes Yes Yes Yes No Yes
TP 177B 4" No Yes Yes Yes No No Yes
TP 177B 6" mono No Yes Yes Yes Yes No Yes
TP 177B 6" No Yes Yes Yes Yes No Yes
OP 177B 6" mono No Yes Yes Yes Yes No Yes
OP 177B 6" No Yes Yes Yes Yes No Yes
TP 277 6" No Yes Yes Yes Yes No Yes
OP 277 6" No Yes Yes Yes Yes No Yes

Communication drivers for non-integrated communication

HMI devices SIMA
TIC 
S7-1
500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC 
LOGO!

SIMATIC HTTP 
protocol

OP 73 No No Yes Yes No No
OP 77A No Yes Yes Yes No No
OP 77B No Yes Yes Yes No No
TP 177A No Yes Yes Yes No No
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HMI devices SIMA
TIC 
S7-1
500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC 
LOGO!

SIMATIC HTTP 
protocol

TP 177A Portrait No Yes Yes Yes No No
TP 177B 4" No Yes Yes Yes Yes Yes
TP 177B 6" mono No Yes Yes Yes Yes No
TP 177B 6" No Yes Yes Yes Yes Yes
OP 177B 6" mono No Yes Yes Yes Yes No
OP 177B 6" No Yes Yes Yes Yes Yes
TP 277 6" No Yes Yes Yes Yes Yes
OP 277 6" No Yes Yes Yes Yes Yes

Other communication drivers

Device dependency of the panels
The following table shows the communication drivers you can configure with the various 
panels.                                         

Communication drivers

HMI devices OPC Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubishi 
FX

Modicon 
Modbus 
TCP/IP

Modicon 
Modbus 
RTU

Omron 
Host Link

OP 73 No No No No No No No No
OP 77A No No Yes2) 3) No Yes No Yes1) Yes3)

OP 77B No No Yes2) 3) No Yes No Yes Yes3)

TP 177A No No Yes2) 3) No Yes No Yes1) Yes3)

TP 177A Portrait No No Yes2) 3) No Yes No Yes1) Yes3)

TP 177B 4" No Yes Yes2) 3) Yes Yes Yes Yes1) 3) Yes3)

TP 177B 6" mono No No Yes2) 3) No Yes No Yes1) 3) Yes3)

TP 177B 6" No Yes Yes2) 3) Yes Yes Yes Yes1) 3) Yes3)

OP 177B 6" mono No No Yes2) 3) No Yes No Yes1) 3) Yes3)

OP 177B 6" No Yes Yes2) 3) Yes Yes Yes Yes1) 3) Yes3)

TP 277 6" No Yes Yes2) 3) Yes Yes Yes Yes1) 3) Yes3)

OP 277 6" No Yes Yes2) 3) Yes Yes Yes Yes1) 3) Yes3)

 

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6175



1) only approved with RS 422-RS232 converter
Order number: 6AV6 671-8XE00-0AX0

2) Direct communication with PLC 5 or KF2 module, otherwise only approved with 
RS422-RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

3) "PROFINET IO Enabled" must be disabled.

Interfaces of Panels

Device dependency of Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.   

Table 10-154 Panels

 OP 73 OP 77A OP 77B 3) TP 177A TP 177B 3)

OP 177B 3)
TP 277 3)

OP 277 3)

SIMATIC S7 - PPI 1) IF1B IF1B IF1B IF1B IF1B IF1B
SIMATIC S7 - MPI IF1B IF1B IF1B IF1B IF1B IF1B
SIMATIC S7 - PROFIBUS IF1B IF1B IF1B IF1B IF1B IF1B
SIMATIC S7 - PROFINET — — — — ETHERNE

T 2)
ETHERNE
T 2)

SIMATIC HMI HTTP protocol — — — — ETHERNE
T 2)

ETHERNE
T

OPC — — — — — —
Allen-Bradley Ethernet IP — — — — ETHERNE

T 2)
ETHERNE
T

Allen-Bradley DF1 — IF1B 5) IF1A 3), 
IF1B 3)4)

IF1B 5) IF1B 3) 5) 8) IF1B 3) 5) 8)

Mitsubishi MC TCP/IP — — — — ETHERNE
T 2)

ETHERNE
T

Mitsubishi FX — IF1B IF1A 3), 
IF1B 3)

IF1B IF1B 3) 8) IF1B 3) 8)

Modicon Modbus TCP — — — — ETHERNE
T 2)

ETHERNE
T

Modicon Modbus RTU — IF1B 7) IF1A 3), 
IF1B 3)6)

IF1B 7) IF1B 7) 3) 8) IF1B 7) 3) 8)

Omron Host Link — IF1B IF1A 3), 
IF1B 3)

IF1B IF1B 3) 8) IF1B 3) 8)

1) For SIMATIC S7-200 only
2) Not approved for TP 177B DP, OP 177B DP.
3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 

Transfer >Options" menu.
4) Only with PLC5 or KF2 module. 
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5) Direct communication with PLC5 or KF2 module, otherwise only approved with RS422-
RS232 converter 6AV6 671-8XE00-0AX0 (option)

6) Can be selected and used, but not approved.
7) Only with RS 422-RS 232 converter 6AV6 671-8XE00-0AX0 (option)
8) "PROFINET IO Enabled" must be disabled.

Area pointers for Panels

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions. 

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointers

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Screen number Yes Yes Yes Yes Yes Yes
Data record No Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes
Coordination Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes
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10.11.5.3 Comfort Panel

Communication drivers for Comfort Panels

SIMATIC communication drivers

Device dependency of the Comfort Panels
Various communication drivers are configured for Comfort Panels depending on the 
communication.

The following tables show the communication drivers released for integrated and non-
integrated communication.

There are different versions of the HMI devices within the integrated communication.

Communication drivers for integrated communication (V11.0)

HMI devices SIMATIC
 
S7-1200 
(V1)

SIMATIC
 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

KP400 Comfort No Yes Yes Yes Yes No Yes
KTP400 Comfort No Yes Yes Yes Yes No Yes
KTP400 Comfort 
Portrait

No Yes Yes Yes Yes No Yes

KP700 Comfort No Yes Yes Yes Yes No Yes
TP700 Comfort No Yes Yes Yes Yes No Yes
TP700 Comfort 
Portrait

No Yes Yes Yes Yes No Yes

KP900 Comfort No Yes Yes Yes Yes No Yes
TP900 Comfort No Yes Yes Yes Yes No Yes
TP900 Comfort 
Portrait

No Yes Yes Yes Yes No Yes

KP1200 Comfort No Yes Yes Yes Yes No Yes
TP1200 Comfort No Yes Yes Yes Yes No Yes
TP1200
Comfort
Portrait

No Yes Yes Yes Yes No Yes

KP1500 Comfort No Yes Yes Yes Yes No Yes
TP1500 Comfort No Yes Yes Yes Yes No Yes
TP1500 Comfort 
Portrait

No Yes Yes Yes Yes No Yes

TP1900 Comfort No Yes Yes Yes Yes No Yes

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6178 System Manual, 02/2014



HMI devices SIMATIC
 
S7-1200 
(V1)

SIMATIC
 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

TP1900 Comfort 
Portrait

No Yes Yes Yes Yes No Yes

TP2200 Comfort No Yes Yes Yes Yes No Yes
TP2200 Comfort 
Portrait

No Yes Yes Yes Yes No Yes

Communication drivers for integrated communication (V12.0)

HMI devices SIMATI
C 
S7-1200
 (V1)

SIMATIC
 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

KP400 Comfort No Yes Yes Yes Yes Yes Yes
KTP400 Comfort No Yes Yes Yes Yes Yes Yes
KTP400 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

KP700 Comfort No Yes Yes Yes Yes Yes Yes
TP700 Comfort No Yes Yes Yes Yes Yes Yes
TP700 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

KP900 Comfort No Yes Yes Yes Yes Yes Yes
TP900 Comfort No Yes Yes Yes Yes Yes Yes
TP900 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

KP1200 Comfort No Yes Yes Yes Yes Yes Yes
TP1200 Comfort No Yes Yes Yes Yes Yes Yes
TP1200
Comfort
Portrait

No Yes Yes Yes Yes Yes Yes

KP1500 Comfort No Yes Yes Yes Yes Yes Yes
TP1500 Comfort No Yes Yes Yes Yes Yes Yes
TP1500 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

TP1900 Comfort No Yes Yes Yes Yes Yes Yes
TP1900 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

TP2200 Comfort No Yes Yes Yes Yes Yes Yes
TP2200 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes
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Communication drivers for integrated communication (V13.0)

HMI devices SIMATI
C 
S7-1200
 (V1)

SIMATIC
 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

KP400 Comfort No Yes Yes Yes Yes Yes Yes
KTP400 Comfort No Yes Yes Yes Yes Yes Yes
KTP400 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

KP700 Comfort No Yes Yes Yes Yes Yes Yes
TP700 Comfort No Yes Yes Yes Yes Yes Yes
TP700 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

KP900 Comfort No Yes Yes Yes Yes Yes Yes
TP900 Comfort No Yes Yes Yes Yes Yes Yes
TP900 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

KP1200 Comfort No Yes Yes Yes Yes Yes Yes
TP1200 Comfort No Yes Yes Yes Yes Yes Yes
TP1200
Comfort
Portrait

No Yes Yes Yes Yes Yes Yes

KP1500 Comfort No Yes Yes Yes Yes Yes Yes
TP1500 Comfort No Yes Yes Yes Yes Yes Yes
TP1500 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

TP1900 Comfort No Yes Yes Yes Yes Yes Yes
TP1900 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

TP2200 Comfort No Yes Yes Yes Yes Yes Yes
TP2200 Comfort 
Portrait

No Yes Yes Yes Yes Yes Yes

Communication drivers for non-integrated communication

HMI devices SIMATIC 
S7-1500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC LOGO! SIMATIC HTTP 
protocol

KP400 Comfort Yes Yes Yes Yes Yes Yes
KTP400 Comfort Yes Yes Yes Yes Yes Yes
KTP400 Comfort 
Portrait

Yes Yes Yes Yes Yes Yes

KP700 Comfort Yes Yes Yes Yes Yes Yes
TP700 Comfort Yes Yes Yes Yes Yes Yes
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HMI devices SIMATIC 
S7-1500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC LOGO! SIMATIC HTTP 
protocol

TP700 Comfort Portrait Yes Yes Yes Yes Yes Yes
KP900 Comfort Yes Yes Yes Yes Yes Yes
TP900 Comfort Yes Yes Yes Yes Yes Yes
TP900 Comfort Portrait Yes Yes Yes Yes Yes Yes
KP1200 Comfort Yes Yes Yes Yes Yes Yes
TP1200 Comfort Yes Yes Yes Yes Yes Yes
TP1200
Comfort
Portrait

Yes Yes Yes Yes Yes Yes

KP1500 Comfort Yes Yes Yes Yes Yes Yes
TP1500 Comfort Yes Yes Yes Yes Yes Yes
TP1500 Comfort 
Portrait

Yes Yes Yes Yes Yes Yes

TP1900 Comfort Yes Yes Yes Yes Yes Yes
TP1900 Comfort 
Portrait

Yes Yes Yes Yes Yes Yes

TP2200 Comfort Yes Yes Yes Yes Yes Yes
TP2200 Comfort 
Portrait

Yes Yes Yes Yes Yes Yes

Other communication drivers

Device dependency of the Comfort Panels
The following table shows which communication drivers you can configure with the various 
Comfort Panels.

Communication drivers

HMI devices OPC 1)

 
Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubishi 
FX

Modicon 
Modbus 
TCP/IP

Modicon 
Modbus 
RTU

Omron 
Host Link

KP400 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

KTP400 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

KTP400 
Comfort Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

KP700 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP700 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP700 Comfort 
Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

KP900 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)
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HMI devices OPC 1)

 
Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubishi 
FX

Modicon 
Modbus 
TCP/IP

Modicon 
Modbus 
RTU

Omron 
Host Link

TP900 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP900 Comfort 
Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

KP1200 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP1200 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP1200
Comfort
Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

KP1500 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP1500 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP1500 
Comfort Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP1900 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP1900 
Comfort Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP2200 Comfort Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

TP2200 
Comfort Portrait

Yes Yes Yes2) 3) Yes Yes3) Yes Yes3) 4) Yes3)

1) OPC UA client (DA only) 
OPC UA server (DA only)
OPC DA client

2) Direct communication with PLC 5 or KF2 module, otherwise only approved with RS422-
RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

3) "PROFINET IO Enabled" must be disabled.
4) Only approved with RS 422-RS232 converter

Order number: 6AV6 671-8XE00-0AX0
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Interfaces of Comfort Panels

Device dependency of Comfort Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.     

Table 10-155 Comfort Panels

 KP400 
Comfor
t

KTP40
0 
Comfor
t

KP700 
Comfor
t

TP700 
Comfor
t

KP900 
Comfor
t

TP900 
Comfor
t

KP120
0 
Comfor
t

TP120
0 
Comfo
rt

KP150
0 
Comfo
rt 

TP150
0 
Comfo
rt 

TP190
0 
Comfo
rt 

TP2200
 
Comfor
t 

SIMATIC 
S7 - PPI 1)

IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B

SIMATIC 
S7 - MPI

IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B

SIMATIC 
S7 - 
PROFIB
US

IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B IF1B

SIMATIC 
S7 - 
PROFIN
ET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

SIMATIC 
HMI 
HTTP pro
tocol

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

OPC ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Allen-
Bradley 
EtherNet/
IP

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Allen-
Bradley 
DF1

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

IF1B 
1)3)4)

Mitsubish
i MC 
TCP/IP

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Mitsubish
i FX

IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 3)4)

Modicon 
Modbus T
CP/

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHER
NET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHE
RNET

ETHER
NET

Modicon 
Modbus 
RTU

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

IF1B 
2)3)4)

Omron 
Host Link

IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 3)4) IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 
3)4)

IF1B 3)4)
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1) Direct communication with PLC5 or KF2 module, otherwise only with RS422-RS232 
converter.
Order number: 6AV6 671-8XE00-0AX0

2) only with RS422-RS232 converter (option)
Order number: 6AV6 671-8XE00-0AX0

3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 
Transfer >Options" menu.

4) "PROFINET IO Enabled" must be disabled.

 

Area pointers for Comfort Panel

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.   

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointer

 KP40
0 
Comfo
rt

KTP4
00 
Comfo
rt

KP70
0 
Comfo
rt

TP700
 
Comfo
rt

KP90
0 
Comfo
rt

TP900
 
Comfo
rt

KP12
00 
Comfo
rt

TP120
0 
Comfo
rt

KP15
00 
Comfo
rt

TP150
0 
Comfo
rt

TP190
0 
Comfo
rt

TP220
0 
Comfo
rt

Screen number Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Data record Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
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 KP40
0 
Comfo
rt

KTP4
00 
Comfo
rt

KP70
0 
Comfo
rt

TP700
 
Comfo
rt

KP90
0 
Comfo
rt

TP900
 
Comfo
rt

KP12
00 
Comfo
rt

TP120
0 
Comfo
rt

KP15
00 
Comfo
rt

TP150
0 
Comfo
rt

TP190
0 
Comfo
rt

TP220
0 
Comfo
rt

Coordination Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Project ID Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes

10.11.5.4 Multi Panel

Communication drivers for Multi Panels

SIMATIC communication drivers

Device dependency of the Multi Panels
Various communication drivers are configured for Comfort Panels depending on the 
communication.

The following tables show the communication drivers released for integrated and non-
integrated communication.

There are different versions of the HMI devices within the integrated communication.

Communication drivers for integrated communication (V11.0)

HMI devices SIMATIC
 S7-1200 
(V1)

SIMATIC
 S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

MP 177 6" Touch No Yes Yes Yes No No No
MP 277 8" Key No Yes Yes Yes No No Yes
MP 277 10" Key No Yes Yes Yes No No Yes
MP 277 10" Touch No Yes Yes Yes No No Yes
MP 377 12" Key No Yes Yes Yes No No Yes
MP 377 12" Touch No Yes Yes Yes No No Yes
MP 377 15" Touch No Yes Yes Yes No No Yes
MP 377 19" Touch No Yes Yes Yes No No Yes
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Communication drivers for integrated communication (V12.0)

HMI devices SIMATIC
 S7-1200 
(V1)

SIMATIC
 S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

MP 177 6" Touch No Yes Yes Yes Yes Yes No
MP 277 8" Key No Yes Yes Yes Yes Yes Yes
MP 277 10" Key No Yes Yes Yes Yes Yes Yes
MP 277 10" Touch No Yes Yes Yes Yes Yes Yes
MP 377 12" Key No Yes Yes Yes Yes Yes Yes
MP 377 12" Touch No Yes Yes Yes Yes Yes Yes
MP 377 15" Touch No Yes Yes Yes Yes Yes Yes
MP 377 19" Touch No Yes Yes Yes Yes Yes Yes

Communication drivers for non-integrated communication

HMI devices SIMATIC 
S7-1500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC LOGO! SIMATIC HTTP 
protocol

MP 177 6" Touch Yes Yes Yes Yes Yes Yes
MP 277 8" Key Yes Yes Yes Yes Yes Yes
MP 277 10" Key Yes Yes Yes Yes Yes Yes
MP 277 10" Touch Yes Yes Yes Yes Yes Yes
MP 377 12" Key Yes Yes Yes Yes Yes Yes
MP 377 12" Touch Yes Yes Yes Yes Yes Yes
MP 377 15" Touch Yes Yes Yes Yes Yes Yes
MP 377 19" Touch Yes Yes Yes Yes Yes Yes

Other communication drivers

Device dependency of the Multi Panels
The following table shows which communication drivers you can configure with the various 
Multi Panels.

Communication drivers

HMI devices OPC 1)

 
Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubishi 
FX

Modicon 
Modbus 
TCP/IP

Modicon 
Modbus 
RTU

Omron 
Host Link

MP 177 6" 
Touch

No Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

MP 277 8" Key Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)
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HMI devices OPC 1)

 
Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubishi 
FX

Modicon 
Modbus 
TCP/IP

Modicon 
Modbus 
RTU

Omron 
Host Link

MP 277 10" Key Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

MP 277 10" 
Touch

Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

MP 377 12" Key Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

MP 377 12" 
Touch

Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

MP 377 15" 
Touch

Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

MP 377 19" 
Touch

Yes Yes Yes3)4) Yes Yes4) Yes Yes2)4) Yes4)

1) OPC-XML DA Server
OPC-DA Client (Inproc)

2) only approved with RS 422-RS232 converter 
Order number: 6AV6 671-8XE00-0AX0

3) Direct communication with PLC 5 or KF2 module, otherwise only with RS422-RS232 
converter (option).
Order number: 6AV6 671-8XE00-0AX0

4) "PROFINET IO Enabled" must be disabled.

Interfaces of Multi Panels

Device dependency of Multi Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.   

Table 10-156 Multi Panels

 MP 177 3) MP 277 3) MP 377 3)

SIMATIC S7 - PPI 1) IF1B IF1B IF1B
SIMATIC S7 - MPI IF1B IF1B IF1B
SIMATIC S7 - PROFIBUS IF1B IF1B IF1B
SIMATIC S7 - PROFINET ETHERNET ETHERNET ETHERNET
SIMATIC HMI HTTP protocol ETHERNET ETHERNET ETHERNET
OPC - ETHERNET ETHERNET
Allen-Bradley EtherNet/IP ETHERNET ETHERNET ETHERNET
Allen-Bradley DF1 IF1B 3) 4) 5) IF1B 3) 4) 5) IF1B 3) 4) 5)

Mitsubishi MC TCP/IP ETHERNET ETHERNET ETHERNET
Mitsubishi FX IF1B 3)5) IF1B 3)5) IF1B 3)5)

Modicon Modbus TCP ETHERNET ETHERNET ETHERNET
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 MP 177 3) MP 277 3) MP 377 3)

Modicon Modbus RTU IF1B 2) 3) 5) IF1B 2) 3) 5) IF1B 2) 3) 5)

Omron Host Link IF1B 3)5) IF1B 3)5) IF1B 3)5)

1) For SIMATIC S7-200 only
2) only with RS 422-RS232 converter (option)

Order number: 6AV6 671-8XE00-0AX0
3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 

Transfer >Options" menu.
4) Direct communication with PLC5 or KF2 module, otherwise only approved with RS422-

RS232 converter (option).
Order number: 6AV6 671-8XE00-0AX0

5) "PROFINET IO Enabled" must be disabled.

Area pointers for Multi Panel

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointers

 MP 177 MP 277 MP 377
Screen number Yes Yes Yes
Data record Yes Yes Yes
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 MP 177 MP 277 MP 377
Date/time Yes Yes Yes
Date/time PLC Yes Yes Yes
Coordination Yes Yes Yes
Project ID Yes Yes Yes
Job mailbox Yes Yes Yes

10.11.5.5 Mobile Panel

Communication drivers for Mobile Panels

SIMATIC communication drivers

Device dependency of theMobile Panels
Various communication drivers are configured for Comfort Panels depending on the 
communication.

The following tables show the communication drivers released for integrated and non-
integrated communication.

There are different versions of the HMI devices within the integrated communication. 

Communication drivers for integrated communication (V11.0)

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

Mobile Panel 177 
6" DP

No Yes Yes Yes Yes No Yes

Mobile Panel 177 
6" PN

No Yes Yes Yes Yes No Yes

Mobile Panel 277 
8"

No Yes Yes Yes Yes No Yes

Mobile Panel 277 
8" IWLAN V2

No Yes Yes Yes Yes No Yes

Mobile Panel 
277F 8" IWLAN 
V2

No No No No No No Yes

Mobile Panel 
277F 8" IWLAN 
V2 (RFID tag)

No No No No No No Yes

Mobile Panel 277 
10"

No Yes Yes Yes Yes No Yes
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Communication drivers for integrated communication (V12.0)

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

Mobile Panel 177 
6" DP

No Yes Yes Yes Yes Yes Yes

Mobile Panel 177 
6" PN

No Yes Yes Yes Yes Yes Yes

Mobile Panel 277 
8"

No Yes Yes Yes Yes Yes Yes

Mobile Panel 277 
8" IWLAN V2

No Yes Yes Yes Yes Yes Yes

Mobile Panel 
277F 8" IWLAN 
V2

No Yes1) Yes1) Yes1) Yes1) Yes Yes 

Mobile Panel 
277F 8" IWLAN 
V2 (RFID tag)

No Yes1) Yes1) Yes1) Yes1) Yes Yes 

Mobile Panel 277 
10"

No Yes Yes Yes Yes Yes Yes

1) Not as a master system 

Communication drivers for non-integrated communication

HMI devices SIMATIC 
S7-1500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC 
LOGO!

SIMATIC HTTP 
protocol

Mobile Panel 177 6" 
DP

Yes2) Yes Yes Yes No No

Mobile Panel 177 6" 
PN

Yes2) Yes Yes Yes Yes Yes

Mobile Panel 277 8" Yes Yes Yes Yes Yes Yes
Mobile Panel 277 8" 
IWLAN V2

Yes Yes Yes Yes Yes Yes

Mobile Panel 277F 
8" IWLAN V2

Yes Yes Yes Yes Yes Yes

Mobile Panel 277F 
8" IWLAN V2 (RFID 
tag)

Yes Yes Yes Yes Yes Yes

Mobile Panel 277 
10"

Yes Yes Yes Yes Yes Yes
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1) "PROFINET IO Enabled" must be disabled.
2) You must activate "Access via PUT/GET communication" for communication with the 

SIMATIC S7-1500 PLC. 
Activate PUT/GET communication in the PLC properties at:
 "General > Security > Enable PUT/GET communication with remote partner (PLC, HMI, 
OPC, etc.)"

Other communication drivers

Device dependency of theMobile Panels
The following table shows which communication drivers you can configure with the various 
Mobile Panels.

Communication drivers

HMI devices OPC Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubish
i FX

Modicon 
Modbus TC
P/IP

Modicon 
Modbus 
RTU

Omron Host Link

Mobile 
Panel 177 
6" DP

No No Yes1) No Yes1) No Yes1) Yes1) 

Mobile 
Panel 177 
6" PN

No Yes No Yes No Yes No No

Mobile 
Panel 277 8"

No Yes Yes1) Yes Yes1) Yes Yes1) Yes1) 

Mobile 
Panel 277 
8" IWLAN 
V2

No Yes No Yes No Yes No No

Mobile 
Panel 277F 
8" IWLAN 
V2

No Yes No No No No No No

Mobile 
Panel 277F 
8" IWLAN 
V2 (RFID 
tag)

No Yes No No No No No No

Mobile 
Panel 277 
10"

No Yes Yes1) Yes Yes1) Yes Yes1) Yes1) 
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1) "PROFINET IO Enabled" must be disabled.
2) You must activate "Access via PUT/GET communication" for communication with the 

SIMATIC S7-1500 PLC. 
Activate PUT/GET communication in the PLC properties at:
 "General > Security > Enable PUT/GET communication with remote partner (PLC, HMI, 
OPC, etc.)"

Interfaces of Mobile Panels

Device dependency of Mobile Panels
The following table shows which HMI device interfaces are available for the communication 
driver protocols.     

Table 10-157 Mobile Panels

 Mobile Panel 
177 DP 3)

Mobile Panel 
177 PN

Mobile Panel 
277 2)3)

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F V2 
IWLAN

Mobile Panel 
277F IWLAN 
V2 (RFID tag)

SIMATIC S7 - PPI 1) IF1B — IF1B — — —
SIMATIC S7 - MPI IF1B — IF1B — — —
SIMATIC S7 - 
PROFIBUS

IF1B — IF1B — — —

SIMATIC S7 - 
PROFINET

— ETHERNET ETHERNET ETHERNET ETHERNET ETHERNET

SIMATIC HMI 
HTTP protocol

— ETHERNET ETHERNET ETHERNET ETHERNET ETHERNET

OPC — — — ETHERNET ETHERNET ETHERNET
Allen-Bradley DF1 IF1A 3), IF1B 3) 

4) 6) (terminal 
box)

— IF1A 3), IF1B 3) 

4) 6) (terminal 
box)

— — —

Allen-Bradley 
EtherNet/IP

--- ETHERNET ETHERNET ETHERNET ETHERNET ETHERNET

Mitsubishi MC TCP/
IP

-- ETHERNET ETHERNET ETHERNET — —

Mitsubishi FX IF1A 3), IF1B 3) 
6) (terminal box)

— IF1A 3), IF1B 3) 
6) (terminal box)

— — —

Modicon 
Modbus RTU

IF1A 3), IF1B 3) 

5) 6) (terminal 
box)

— IF1A 3), IF1B 3) 

5) 6) (terminal 
box)

— — —

Modicon 
Modbus TCP/IP

— ETHERNET ETHERNET ETHERNET — —

Omron Host Link IF1A 3), IF1B 3) 
6) (terminal box)

— IF1A 3), IF1B 
3)6) (terminal 
box)

— — —
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1) For SIMATIC S7-200 only
2) Depending on the terminal box used
3) For serial communication, deselect "Remote Control" of "Channel 1" in the "File > 

Transfer >Options" menu.
4) With PLC5 and KF2 module only         
5) Can be selected and used, but not approved.
6) "PROFINET IO Enabled" must be disabled.

Area pointers for Mobile Panel

Introduction
Area pointers are parameter fields from which the HMI device obtains information about the 
location and size of data areas in the PLC. During communication, the PLC and the HMI device 
alternately access these data areas for read and write operations. Based on the evaluation of 
data stored in the data areas, the PLC and HMI device initiate mutually defined actions.

WinCC uses the following area pointers:

● Job mailbox

● Project ID

● Screen number

● Data record

● Date/time

● Date/time PLC

● Coordination

Availability of the area pointers
The following table shows the availability of the area pointers on the HMI devices. Note that 
the area pointers can be used only for available communication drivers. 

Area pointer

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile 
Panel 277 
IWLAN V2

Mobile 
Panel 277F 
IWLAN V2

Mobile 
Panel 277F 
IWLAN V2 
(RFID tag)

Mobile 
Panel 277

Screen number Yes Yes Yes Yes Yes Yes
Data record Yes Yes Yes Yes Yes Yes
Date/time Yes Yes Yes Yes Yes Yes
Date/time PLC Yes Yes Yes Yes Yes Yes
Coordination Yes Yes Yes Yes Yes Yes
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 Mobile 
Panel 177

Mobile 
Panel 277

Mobile 
Panel 277 
IWLAN V2

Mobile 
Panel 277F 
IWLAN V2

Mobile 
Panel 277F 
IWLAN V2 
(RFID tag)

Mobile 
Panel 277

Project ID Yes Yes Yes Yes Yes Yes
Job mailbox Yes Yes Yes Yes Yes Yes

10.11.5.6 PC systems with WinCC Runtime

Communication drivers for WinCC Runtime

SIMATIC communication drivers

Device dependency
The following table shows which communication drivers you can configure with the various 
Runtimes on a PC.

Communication drivers for integrated communication (V11.0)

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

WinCC RT 
Advanced

No Yes Yes Yes No No Yes

WinCC RT 
Professional

No Yes Yes Yes No No Yes

Communication drivers for integrated communication (V12.0)

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

WinCC RT 
Advanced

No Yes Yes Yes Yes Yes Yes

WinCC RT 
Professional

No Yes Yes Yes Yes Yes Yes
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Communication drivers for integrated communication (V13.0)

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

WinCC RT 
Advanced

No Yes Yes Yes Yes Yes Yes

WinCC RT 
Professional

No Yes Yes Yes Yes Yes Yes

Communication drivers for non-integrated communication

HMI devices SIMATIC S7-
1500

SIMATIC 
S7-1200

SIMATIC 
S7-300/400

SIMATIC 
S7-200

SIMATIC 
LOGO!

SIMATIC HTTP 
protocol

WinCC RT 
Advanced

Yes Yes Yes Yes Yes Yes

WinCC RT 
Professional

Yes Yes Yes No No No

1) OPC DA server
OPC DA client
OPC XML DA client
OPC UA server (DA only)
OPC UA client (DA only)

2) OPC DA server
OPC DA client
OPC XML DA server
OPC XML DA client
OPC UA server (DA only)

Other communication drivers

Device dependency
The following table shows which communication drivers you can configure with the various 
Runtimes on a PC.
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Communication drivers

HMI devices OPC Allen-
Bradley 
EtherNet/
IP

Allen-
Bradley 
DF1 

Mitsubishi 
MC TCP/IP

Mitsubish
i FX

Modicon 
Modbus TC
P/IP

Modicon 
Modbus 
RTU

Omron Host Link

WinCC RT 
Advanced

Yes1) Yes Yes Yes Yes Yes Yes Yes

WinCC RT 
Professional

Yes2) Yes No Yes No Yes No No

1) OPC DA server
OPC DA client
OPC XML DA client
OPC UA server (DA only)
OPC UA client (DA only)

2) OPC DA server
OPC DA client
OPC XML DA server
OPC XML DA client
OPC UA server (DA only)

Interfaces for PC systems

Device dependency
The following table shows which HMI device interfaces are available for the communication 
driver protocols.                 

 WinCC RT Advanced WinCC RT Professional
SIMATIC S7 - PPI MPI/DP 2) --
SIMATIC S7 - MPI MPI/DP 2) MPI/DP 2)

SIMATIC S7 - PROFIBUS MPI/DP 2) MPI/DP 2)

SIMATIC S7 - PROFINET ETHERNET ETHERNET
SIMATIC HMI HTTP protocol ETHERNET ETHERNET
OPC ETHERNET ETHERNET
OPC UA ETHERNET --
Allen-Bradley EtherNet/IP ETHERNET ETHERNET
Allen-Bradley DF1 COM1 to COM4 1) --
Mitsubishi MC TCPI/IP ETHERNET ETHERNET
Mitsubishi FX COM1 to COM4 1) --
Modicon Modbus TCP/IP ETHERNET ETHERNET
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 WinCC RT Advanced WinCC RT Professional
Modicon Modbus RTU COM1 to COM4 1) --
Omron Host Link COM1 to COM4 1) --

1) COM2 is blocked for Panel PC 477
2) for SIMATIC PC, via integrated interface; for standard PC, e.g., via SIMATIC NET CP 5611 
A2 

10.11.5.7 Parallel communication 

Parallel communication of communication drivers 
The following table shows an overview of which communication drivers you can use 
simultaneously on one HMI device. 

 

 Note

Parallel communication is not approved for Basic Panels.
 

Parallel communication over Ethernet interfaces
The approved combinations can be operated via the same Ethernet interface. Several Ethernet 
interfaces are not required.

Parallel communication only concerns the Ethernet-based communication drivers.

 Allen-
Bradley
 
EtherN
et/IP

Mitsubi
shi MC 
TCP/IP

Modico
n 
Modbu
s 
TCPIP

OPC 
(DA/
XML 
DA)

OPC 
UA 
(DA)

SIMAT
IC 
LOGO
!

SIMAT
IC S7 2
00

SIMATI
C S7 30
0/400

SIMATI
C S7 12
00

SIMATI
C S7 
1500

SIMATI
C 
HTTP 
protoco
l

Sinume
rik NC

Allen-
Bradley
 
EtherN
et/IP

-- No No Yes Yes Yes Yes Yes Yes Yes Yes Yes

Mitsubi
shi MC 
TCP/IP

No -- No Yes Yes No No No No No Yes No

Modico
n 
Modbu
s 
TCPIP

No No -- Yes Yes No No No No No Yes No

OPC 
(DA/
XML 
DA)

Yes Yes Yes -- Yes Yes Yes Yes Yes Yes Yes Yes
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 Allen-
Bradley
 
EtherN
et/IP

Mitsubi
shi MC 
TCP/IP

Modico
n 
Modbu
s 
TCPIP

OPC 
(DA/
XML 
DA)

OPC 
UA 
(DA)

SIMAT
IC 
LOGO
!

SIMAT
IC S7 2
00

SIMATI
C S7 30
0/400

SIMATI
C S7 12
00

SIMATI
C S7 
1500

SIMATI
C 
HTTP 
protoco
l

Sinume
rik NC

OPC 
UA 
(DA)

Yes Yes Yes Yes -- Yes Yes Yes Yes Yes Yes Yes

SIMATI
C 
LOGO!

Yes No No Yes Yes -- Yes Yes Yes Yes Yes Yes

SIMATI
C S7 20
0

Yes No No Yes Yes Yes -- Yes Yes Yes Yes Yes

SIMATI
C S7 30
0/400

Yes No No Yes Yes Yes Yes -- Yes Yes Yes Yes

SIMATI
C S7 12
00

Yes No No Yes Yes Yes Yes Yes -- Yes Yes Yes

SIMATI
C S7 
1500

Yes No No Yes Yes Yes Yes Yes Yes -- Yes Yes

SIMATI
C 
HTTP 
protoco
l

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes -- Yes

Sinume
rik NC

Yes No No Yes Yes Yes Yes Yes Yes Yes Yes --

Parallel communication over serial interfaces
The following applies for parallel communication over serial interfaces:

● One communication driver per interface.

● One interface per communication driver.

10.11.6 Communicating with SIMATIC S7 1500

10.11.6.1 Communication with SIMATIC S7 1500

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 1500 
PLC. 

You can configure the following communication channels for the SIMATIC S7 1500 PLC:     

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6198 System Manual, 02/2014



● PROFINET

● PROFIBUS

HMI connection for communication
Configure connections between the HMI device and a SIMATIC S7 1500 in the "Devices & 
Networks" Editor. 

10.11.6.2 Communication via PROFINET

Configuring an HMI connection

Communication via PROFINET

HMI connections via PROFINET
If you have inserted an HMI device and a SIMATIC S7 1500 into the project, interconnect the 
two PROFINET interfaces in the "Devices & Networks" editor.         

You can also connect multiple HMI devices to a single SIMATIC S7 1500 and multiple SIMATIC 
S7 1500 to a single HMI device. 
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The maximum number of communication partners that you can connect to an HMI device is 
dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1500 via 
PROFINET or Ethernet in the "Devices & Networks" editor.             

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with PROFINET or Ethernet interface

● SIMATIC S7 1500 with PROFINET interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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3. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the HMI device.

4. Click the connecting line.

5. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

6. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6213)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1500. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection

Communication via PROFINET

Communication via PROFINET
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
1500 controller via PROFINET.               

You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

● WinCC RT Professional

WinCC Runtime as HMI device
You configure the HMI connections between a WinCC Runtime and SIMATIC S7 1500 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.
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You can also connect multiple HMI devices to one SIMATIC S7 1500 and multiple SIMATIC 
S7 1500 controllers to one HMI device. 

The maximum number of communication partners that you can connect to an HMI device is 
dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.
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Configuring an HMI connection via PROFINET with a PC

Introduction
You configure an HMI connection between an HMI device and a SIMATIC S7 1500 via 
PROFINET or Ethernet in the "Devices & Networks" editor.                           

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFINET interface

● PC station with WinCC RT Advanced or WinCC RT Professional
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFINET-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the communication processor.

5. Click the connecting line.
The connection is displayed graphically in the Inspector window.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6213)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1500. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection via PROFINET with a SIMATIC PC

Introduction
You configure an HMI connection between an HMI device and SIMATIC S7 1500 via 
PROFINET or Ethernet in the "Devices & Networks" editor.                       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFINET interface

● SIMATIC PC with PROFINET interface
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6213)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1500. The IP 
address and subnet mask connection parameters are configured.
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PROFINET parameters

PROFINET parameters for the HMI connection

PROFINET parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection. 

Only limited changes are possible in this Inspector window.         

Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Shows the name of the HMI connection.
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"Connection path"
The communication partners of the selected HMI connection and the associated PROFINET 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area cannot be edited.

● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the selected IP address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFINET parameters for the HMI device

PROFINET parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.         
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Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under "Properties > 
General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.
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"IP protocol"
● "Set IP address in the project"

When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device. 

 

  Note

The device is automatically restarted in the case of HMI devices with the Windows CE 3.0 
operating system.

HMI devices with Windows CE 3.0:
● Mobile Panel 177 PN
● Mobile Panel 177 DP

 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.

● "Use IP router"
If you are using an IP router, select "Use IP router" and enter the router address in the 
"Router address" field.

● "Set IP address on the device"
If the "Set IP address on the device" function is enabled, the IP address is not taken from 
the project. You have to enter the IP address directly in the Control Panel of the HMI device.

PROFINET parameters for the PLC

PROFINET parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.         
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Displaying and changing PROFINET parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"IP protocol"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "IP address"
You assign the IP address of the HMI device in the "IP address" area. 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.
If you are using an IP router, select "Use IP router" and enter the router address in the field.
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Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.

IP address  
The IP parameters are visible if the communication-capable devices support the TCP/IP 
protocol.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of the following:

● The address of the (sub) net

● The address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The node address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0
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 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.

 

Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (e.g. IP address 129.80.xxx.xxx) and change the default 
subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The job of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, in this case you have 
to enter the address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.

Communication security

Security levels
If you want to protect the PLC and HMI device communication, you can assign protection levels 
for the communication.

For a SIMATIC S7-1500 CPU, you can enter multiple passwords and thereby set up different 
access rights for various user groups.
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The passwords are entered in a table, so that exactly one protection level is assigned to each 
password. 

The effect of the password is given in the "Protection" column.

For the SIMATIC S7-1200 controller, several aspects need to be considered when setting 
protection levels. For additional information on this, see: S7-1200 protection levels

Example
You select the "Complete protection" protection level for a standard CPU (i.e., not an F-CPU) 
when configuring it.

Afterwards, you enter a separate password for every protection level above it in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:

● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read and write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction    
Communication with a PLC with the"Complete protection" protection level is protected by a 
password. The password is stored in the properties of the PLC.

Enter the password from the PLC in the "Access password" area.

Communication to the PLC is denied if an incorrect password or no password is entered.
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Entering the access password
Enter the access password for the HMI connection in the "Connections" editor.

Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.
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Possible settings for transmission rate / duplex   
Depending on the selected device, you can make the following settings for "Transmission rate / 
duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option   
This option enables or disables port diagnostics. Examples of port diagnostics: The link status 
is monitored, in other words, the diagnostics are generated during link-down and the system 
reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "   
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.

You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 
 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 
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Wiring rules for disabled autonegotiation

Requirements
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission rate

● Autonegotiation incl. autocrossing disabled

The time for negotiating the transmission rate during startup has been saved.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation    
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.
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Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

10.11.6.3 Communication via PROFIBUS

Configuring an HMI connection

Communication via PROFIBUS

HMI connections via PROFIBUS
If you have inserted an HMI device and a SIMATIC S7 1500 into the project, interconnect the 
two PROFIBUS interfaces in the "Devices & Networks" editor.       

HMI connection in the "Devices & Networks" editor 
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.
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Configuring an HMI connection via PROFIBUS

Introduction
You configure an HMI connection over PROFIBUS between HMI devices and a SIMATIC S7 
1500 in the "Devices & Networks" editor.         

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 1500 with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Click the HMI device interface.

4. Select the "PROFIBUS" interface type in the Inspector window under "Properties > General 
> HMI MPIDP > Parameters".
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5. Click the interface of the PLC and use a drag-and-drop operation to draw a connection to 
the HMI device.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6232)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection over PROFIBUS between an HMI device and a SIMATIC 
S7 1500.

Configuring an HMI connection

Communication via PROFIBUS

Communication via PROFIBUS
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
1500 controller via PROFIBUS.

You can use the following WinCC Runtimes as an HMI device:               

● WinCC RT Advanced

● WinCC RT Professional
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WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 1500 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:

1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 1500 and multiple SIMATIC 
S7 1500 controllers to one HMI device. The maximum number of communication partners that 
you can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFIBUS 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS with a PC

Introduction
You configure an HMI connection between an HMI device and a SIMATIC S7 1500 via 
PROFIBUS in the "Devices & Networks" editor.                               

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFIBUS interface

● PC station with WinCC RT Advanced or WinCC RT Professional

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the communication processor.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6232)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1500 via 
PROFIBUS.

Configuring an HMI connection via PROFIBUS with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1500 via 
PROFIBUS in the "Devices & Networks" editor.                             
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Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1500 with PROFIBUS interface

● SIMATIC PC with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Click the MPI interface of the PC and select "PROFIBUS" for the interface type in the 
Inspector window.

3. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the PC.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6232)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1500 via 
PROFIBUS.

PROFIBUS parameters

PROFIBUS parameters for the HMI connection

PROFIBUS parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.
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Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFIBUS 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6231



● "Interface type"
Displays the selected interface type. This area cannot be edited.

● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the PROFIBUS address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.

Assigning password
Enter the "Access password" for the PLC in the "Connections" editor.
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PROFIBUS parameters for the HMI device

PROFIBUS parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.           

Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"Parameters"
● "Interface type"

You assign the interface type in the "Interface type" area. Depending on the HMI device 
type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.
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● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

PROFIBUS parameters for the PLC

PROFIBUS parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.           

Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.
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"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

Bus profiles with PROFIBUS

Introduction   
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.             

Devices with different profiles on the same PROFIBUS subnet   
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. 

Profiles and transmission rates   

Profiles Supported transmission speeds in Kbits/s
DP 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000 
Standard 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000
Universal 9,6 19,2 93,75 187,5 500 1500
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Meaning of profiles   

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal Select the "Universal" bus profile when individual devices on the PROFIBUS 
subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.

Communication security

Security levels
If you want to protect the PLC and HMI device communication, you can assign protection levels 
for the communication.

For a SIMATIC S7-1500 CPU, you can enter multiple passwords and thereby set up different 
access rights for various user groups.

The passwords are entered in a table, so that exactly one protection level is assigned to each 
password. 

The effect of the password is given in the "Protection" column.

For the SIMATIC S7-1200 controller, several aspects need to be considered when setting 
protection levels. For additional information on this, see: Auto-Hotspot

Example
You select the "Complete protection" protection level for a standard CPU (i.e., not an F-CPU) 
when configuring it.

Afterwards, you enter a separate password for every protection level above it in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:
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● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read and write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.

Assigning password
Enter the "Access password" for the PLC in the "Connections" editor.
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10.11.6.4 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Configuring area pointers (Page 6165) 

Restrictions
You can only configure the following data types for communication with SIMATIC S7 1500 for 
data exchange using area pointers:

● UInt and array of UInt

● Word and array of Word

● Int and array of Int

● "Array[0..15] of Bool" for area pointer "Coordination"

● Date_And_Time

● DTL and LDT

 

"Screen number" area pointer 

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.
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Use
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1st word Current screen type
2nd word Current screen number
3rd word Reserved
4th word Current field number
5th word Reserved

 

● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer 

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" or "40" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:
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Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Using data types
The data types "Date_And_Time, DTL" and "LDT" can only be used with the "Date/time" and 
"Date/time PLC" area pointers.

The data format of the "Date/time" area pointer depends on job mailbox 40/41. 

If there are no control tags linked to the area pointer, or a control tag is linked with the data 
type "Array[0..5] of UInt/Word/Int", the following applies: 

The configuration of the "Date/time" area pointer is only used for job mailbox 41.

If job mailbox 40 is used, the data format "DATE_AND_TIME (BCD-encoded)" is used (shown 
in the next section).

If the "Date/time" and "Date/time PLC" area pointers are linked to a control tag with the data 
type "DATE_AND_TIME", "DTL" or "LDT", the associated data format is used in the 
corresponding area pointer.

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.
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The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:

DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Using data types
The data types "Date_And_Time, DTL" and "LDT" can only be used with the "Date/time" and 
"Date/time PLC" area pointers.

The data format of the "Date/time" area pointer depends on job mailbox 40/41. 
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If there are no control tags linked to the area pointer, or a control tag is linked with the data 
type "Array[0..5] of UInt/Word/Int", the following applies: 

The configuration of the "Date/time" area pointer is only used for job mailbox 41.

If job mailbox 40 is used, the data format "DATE_AND_TIME (BCD-encoded)" is used (shown 
in the next section).

If the "Date/time" and "Date/time PLC" area pointers are linked to a control tag with the data 
type "DATE_AND_TIME", "DTL" or "LDT", the associated data format is used in the 
corresponding area pointer.

"Coordination" area pointer

Function  
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Usage
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.

 

Assignment of the bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 
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Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.

"Project ID" area pointer

Function    
When Runtime starts, a check can be carried out as to whether the HMI device is connected 
to the correct PLC. This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. If 
there is no concordance, a system event is given on the HMI device and Runtime is stopped.

 

Use
 

 Note
HMI connections cannot be switched "online".

The HMI connection in which the "Project ID" area pointer is used must be switched "online".
 

To use this area pointer, set up the following during the configuration:

● Define the version of the configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections" under "Address".

Connection failure    
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.
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Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

 

"Job mailbox" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
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No
.

Function  

14 Set time (BCD-coded)
15 Setting the date (BCD coded) 3) 4)

 Parameter 1 Left byte:  -
Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs to prevent overload 
of the HMI device.

 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 2)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
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No
.

Function  

14 Set time (BCD-coded)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only for devices supporting recipes.
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.
4) The weekday is ignored when you configure the "Date/Time PLC" area pointer.

"Data record" area pointer

"Data record" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization via the data mailbox

Data records are always transferred directly, which means that the tag values are read straight 
from an address or written straight to an address configured for this tag without being redirected 
via an interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions
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If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system alarm. 

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.

Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then, for example, process, edit, 
or save these values in the HMI device. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     
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Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"

Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data mailbox free
2 0000 0010 Transferring
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error
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Sequence of a transfer started by the operator in the recipe view

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
 

Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data record.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.
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 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of a transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxs No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1

No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
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Step Action
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

function from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.
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Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible

● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".
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Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
record.

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Configuring trend display for values from the PLC (Basic) (Page 3818) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:
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● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 
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The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Configuring Alarms (Page 3912) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER
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How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
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Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

10.11.6.5 Performance features of communication

S7-1500 device dependency

Device dependency
If you use devices from an earlier version of the TIA Portal with TIA Portal V13, it may not be 
possible to configure connections to certain HMI devices.

Basic Panels V11.0

HMI devices SIMATIC S7-1500
KP300 Basic No
KP400 Basic No
KTP400 Basic PN No
KTP600 Basic DP No
KTP600 Basic PN No
KTP1000 Basic DP No
KTP1000 Basic PN No
TP1500 Basic PN No
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Basic Panels V12.0

HMI devices SIMATIC S7-1500
KP300 Basic Yes
KP400 Basic Yes
KTP400 Basic PN Yes
KTP600 Basic DP Yes
KTP600 Basic PN Yes
KTP1000 Basic DP Yes
KTP1000 Basic PN Yes
TP1500 Basic PN Yes

Basic Panels V13.0

HMI devices SIMATIC S7-1500
KTP400 Basic Yes
KTP700 Basic Yes
KTP900 Basic Yes
KTP1200 Basic Yes

Panels V11.0

HMI devices SIMATIC S7-1500
OP 73 No
OP 77A No
OP 77B No
TP 177A No
TP 177A Portrait No
TP 177B 4" No
TP 177B 6" mono No
TP 177B 6" No
OP 177B 6" mono No
OP 177B 6" No
TP 277 6" No
OP 277 6" No
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Panels V12.0

HMI devices SIMATIC S7-1500
OP 73 No
OP 77A No
OP 77B No
TP 177A No
TP 177A Portrait No
TP 177B 4" No
TP 177B 6" mono No
TP 177B 6" No
OP 177B 6" mono No
OP 177B 6" No
TP 277 6" No
OP 277 6" No

Multi Panels V11.0

HMI devices SIMATIC S7-1500
MP 177 6" Touch No
MP 277 8" Key No
MP 277 10" Key No
MP 277 10" Touch No
MP 377 12" Key No
MP 377 12" Touch No
MP 377 15" Touch No
MP 377 19" Touch No

Multi Panels V12.0

HMI devices SIMATIC S7-1500
MP 177 6" Touch Yes
MP 277 8" Key Yes
MP 277 10" Key Yes
MP 277 10" Touch Yes
MP 377 12" Key Yes
MP 377 12" Touch Yes
MP 377 15" Touch Yes
MP 377 19" Touch Yes
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Mobile Panels V11.0

HMI devices SIMATIC S7-1500
Mobile Panel 177 6" DP No
Mobile Panel 177 6" PN No
Mobile Panel 277 8" No
Mobile Panel 277 8" IWLAN V2 No
Mobile Panel 277F 8" IWLAN V2 No
Mobile Panel 277F 8" IWLAN V2 (RFID tag) No
Mobile Panel 277 10" No

Mobile Panels V12.0

HMI devices SIMATIC S7-1500
Mobile Panel 177 6" DP Yes
Mobile Panel 177 6" PN Yes
Mobile Panel 277 8" Yes
Mobile Panel 277 8" IWLAN V2 Yes
Mobile Panel 277F 8" IWLAN V2 Yes
Mobile Panel 277F 8" IWLAN V2 (RFID tag) Yes
Mobile Panel 277 10" Yes

Comfort Panels V11.0

HMI devices SIMATIC S7-1500
KP400 Comfort No
KTP400 Comfort No
KTP400 Comfort Portrait No
KP700 Comfort No
TP700 Comfort No
TP700 Comfort Portrait No
KP900 Comfort No
TP900 Comfort No
TP900 Comfort Portrait No
KP1200 Comfort No
TP1200 Comfort No
TP1200 Comfort Portrait No
KP1500 Comfort No
TP1500 Comfort No
TP1500 Comfort Portrait No
TP1900 Comfort No
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HMI devices SIMATIC S7-1500
TP1900 Comfort Portrait No
TP2200 Comfort No
TP2200 Comfort Portrait No

Comfort Panels V12.0

HMI devices SIMATIC S7-1500
KP400 Comfort Yes
KTP400 Comfort Yes
KTP400 Comfort Portrait Yes
KP700 Comfort Yes
TP700 Comfort Yes
TP700 Comfort Portrait Yes
KP900 Comfort Yes
TP900 Comfort Yes
TP900 Comfort Portrait Yes
KP1200 Comfort Yes
TP1200 Comfort Yes
TP1200 Comfort Portrait Yes
KP1500 Comfort Yes
TP1500 Comfort Yes
TP1500 Comfort Portrait Yes
TP1900 Comfort Yes
TP1900 Comfort Portrait Yes
TP2200 Comfort Yes
TP2200 Comfort Portrait Yes

Comfort Panels V13.0

HMI devices SIMATIC S7-1500
KP400 Comfort Yes
KTP400 Comfort Yes
KTP400 Comfort Portrait Yes
KP700 Comfort Yes
TP700 Comfort Yes
TP700 Comfort Portrait Yes
KP900 Comfort Yes
TP900 Comfort Yes
TP900 Comfort Portrait Yes
KP1200 Comfort Yes
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HMI devices SIMATIC S7-1500
TP1200 Comfort Yes
TP1200 Comfort Portrait Yes
KP1500 Comfort Yes
TP1500 Comfort Yes
TP1500 Comfort Portrait Yes
TP1900 Comfort Yes
TP1900 Comfort Portrait Yes
TP2200 Comfort Yes
TP2200 Comfort Portrait Yes

Runtime V11.0

HMI devices SIMATIC S7-1500 
WinCC RT Advanced No

Runtime V12.0

HMI devices SIMATIC S7-1500 
WinCC RT Advanced Yes

Runtime V13.0

HMI devices SIMATIC S7-1500 
WinCC RT Advanced Yes

Valid data types for SIMATIC S7 1500

Valid data types for connections with SIMATIC S7-1500
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Length
BOOL 1 bit
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes
CHAR 1 byte
WCHAR 2 bytes
ARRAY of WCHAR --
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Data type Length
INT 2 bytes
DINT 4 bytes
REAL 4 bytes
TIME 4 bytes
DATE 2 bytes
TIME_OF_DAY 4 bytes
S5TIME 2 bytes
COUNTER 2 bytes
TIMER 2 bytes
STRING (2+n) bytes, n = 0 to 254
WSTRING (4+2*n) bytes, n = 0 to 65533
LINT 8 bytes
LREAL 8 bytes
LTIME 8 bytes
LTIME_OF_DAY 8 bytes
SINT 1 byte
UDINT 4 bytes
UINT 2 bytes
ULINT 8 bytes
USINT 1 byte
DATE_AND_TIME 8 bytes
DTL 12 bytes
LDT 8 bytes

 

Addressing

Addressing of tags with SIMATIC S7 1500        
WinCC supports the following types of addressing in communication of HMI devices with the 
SIMATIC S7 1500 controller:

● Symbolic addressing

● Absolute addressing
 

  Note
Addressing with Mobile Panel 177

The Mobile Panel 177 only supports absolute addressing of tags.
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10.11.6.6 Configuring connections in the "Connections" editor

Creating a PROFINET connection

Requirements
● A project is open.

● An HMI device with a PROFINET interface has been created.     

Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".
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3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select a PROFINET interface of the HMI device in the Inspector window under "Parameters 
> Interface".

6. Set the IP addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating a PROFIBUS connection

Requirements
● A project is open.

● An HMI device with a PROFIBUS interface has been created.          
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "IF 1 B" interface from "Parameters > interface" in the Inspector window.
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6. Select the "DP" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Parameters for the connection

Parameters for the connection

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.       

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.
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● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.

● "Only master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7-200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
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"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
Specifies the access point for the PG/PC interface that can be used to reach the 
communication partner.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

10.11.6.7 Configuring connections in the "Connections" editor

Creating a connection

Requirements
● A project is open.

● WinCC RT Professional is created        
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select an interface of the HMI device in the Inspector window under "Parameters > 
Interface".

6. Set the parameters for the connection in the Inspector window.

Interfaces
Select one of the following interfaces in the Inspector window under "Parameters > 
WinCC RT Professional > Interfaces".

● TCP/IP

● PROFIBUS

For additional information on the parameters of the interfaces see:

Auto-Hotspot 
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Parameters for the connection

TCP/IP

Introduction   
You assign the parameters for the HMI device and the PLC in the network under "Parameters". 

The parameters described in the following apply to the following interfaces:
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● ETHERNET

HMI device
● "Access point"

Specifies the access point for the PG/PC interface that can be used to reach the 
communication partner.

PLC
● "Address"

Enter the station address of the HMI device under "Address".

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.
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PROFIBUS

Introduction  
You assign the parameters for the HMI device and the PLC in the network under "Parameters". 

The parameters described in the following apply to the following interfaces:
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● PROFIBUS

HMI device
● "Access point"

Enter the logical device name under "Access point".

PLC
● "Address"

Enter the station address of the CPU under "Address".

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.
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10.11.6.8 Configuring time synchronization

Time synchronization

Introduction 
To have the same time of day throughout the plant, you can synchronize the time on various 
plant components using time synchronization. WinCC time synchronization is operated as a 
master-slave system. 

One system component must be a clock for all components of a plant to work with identical 
time. The component functioning as the clock is referred to as the time master. The 
components that receive the time are time slaves.

Properties of time synchronization
● The HMI device can define the time as master or can accept the time of the PLC as slave.

● In "master mode", the time is synchronized at each connection setup.

● In "slave mode", the time is synchronized at each connection setup and than at cyclic 
intervals of 10 minutes.

● The first time synchronization is performed on the HMI device immediately after the start 
of runtime.

● Time synchronization is only performed on the HMI device during operation of runtime.

 

Time synchronization restrictions

Approved HMI devices  
You can configure the time synchronization between a SIMATIC S7-1200 or SIMATIC S7-1500 
and an HMI device with the following HMI devices:

Device Operating system
Basic Panels -
TP177 4" Windows CE 5.0
Multi Panel 177 Windows CE 5.0
Multi Panel 277 Windows CE 5.0
Multi Panel 377 Windows CE 5.0
Mobile Panel 277 Windows CE 5.0
Mobile 277 IWLAN V2 Windows CE 5.0
Comfort Panels Windows CE 6.0
PC systems with WinCC RT Advanced Microsoft Windows XP

Microsoft Windows 7
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Configuration restrictions
● If an HMI device has several connections to SIMATIC S7-1200 or SIMATIC S7-1500, you 

can only configure one connection as "slave".

● If you have enabled time synchronization for the HMI device as "slave", you can no longer 
use the global area pointer "Date/time PLC".

● An HMI device can only request the time from a PLC with "Complete protection" security 
type configuration if the correct "Access password" is configured.  
Configure the "Access password" for communication with a PLC with "Complete protection" 
security type in the "Connections" editor of the HMI device.
This "Access password" must match the password configured on the PLC. The PLC 
password is assigned in the PLC properties at:  "General > Security"

● Basic Panels can only be configured as "Slave".

● If you use Basic Panels for the configuration, it is not possible to use time synchronization 
via NTP and the "Date/time PLC" area pointer simultaneously.

● Time synchronization with SIMATIC S7-1200 (V1.0) controllers is not possible.

● Time synchronization between the HMI device TP177 4" and SIMATIC S7-1200 (V4.0) 
controllers is not possible.

● Time synchronization between the HMI device TP177 4" and SIMATIC S7-1500 is not 
possible.

Configuring time synchronization for integrated connections

Introduction   
You configure time synchronization for an integrated connection in the "Devices & Networks" 
editor.

Requirements
● An HMI connection between an HMI device and a SIMATIC S7 1200 or SIMATIC S7 1500 

has been configured.

● The HMI device must support the "time synchronization" function.

● The "Devices & Networks" editor is open.
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Procedure
1. Click the line of the HMI connection in the "Devices & networks" editor.

2. Select the following in the inspector window under "General > Time synchronization > 
Settings":

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

Configuring time synchronization for non-integrated connections

Introduction  
You configure time synchronization for a non-integrated connection in the "Connections" editor.

Requirements
● An HMI device which supports the "time synchronization" function has been created.

● "Connections" editor is open.
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Procedure
1. Double-click "<Add>".

2. In the "Communication drivers" column, select the "SIMATIC S7 1200" PLC.

3. Select the following in the "HMI time synchronization mode" column:

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

10.11.7 Communicating with SIMATIC S7 1200

10.11.7.1 Communication with SIMATIC S7 1200

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 1200 
PLC. 

You can configure the following communication channels for the SIMATIC S7 1200 PLC:   
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● PROFINET

● PROFIBUS

HMI connection for communication
You configure connections between the HMI device and a SIMATIC S7 1200 in the "Devices 
& Networks" editor. If you have configured a HMI device with a serial port, you must configure 
a PROFIBUS-capable communication module to the SIMATIC S7 1200.

10.11.7.2 Communication via PROFINET

Configuring an HMI connection

Communication via PROFINET

HMI connections via PROFINET
If you have inserted an HMI device and a SIMATIC S7 1200 into the project, you interconnect 
the two PROFINET interfaces in the "Devices & Networks" editor.     

You can also connect multiple HMI devices to one SIMATIC S7 1200 and multiple SIMATIC 
S7 1200s to one HMI device. The maximum number of communication partners that you can 
connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFINET or Ethernet in the "Devices & Networks" editor.       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● HMI device with PROFINET or Ethernet interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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3. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the HMI device.

4. Click the connecting line.

5. Click "Highlight HMI connection" and select the HMI connection.

The connection is displayed graphically in the Inspector window.

6. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6294)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
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Result
You have created a connection between an HMI device and a SIMATIC S7 1200. The IP 
address and subnet mask connection parameters are configured.

Configuring an HMI connection

Communication via PROFINET

Communication via PROFINET
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
1200 PLC via PROFINET.  

You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

● WinCC RT Professional

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 1200 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 1200 and multiple SIMATIC 
S7 1200s to one HMI device. The maximum number of communication partners that you can 
connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFINET or Ethernet in the "Devices & Networks" editor.           

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● SIMATIC PC with PROFINET interface
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6294)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1200. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection via PROFINET with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFINET or Ethernet in the "Devices & Networks" editor.           

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● PC station with WinCC RT Advanced or WinCC RT Professional
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFINET-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the communication processor.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
For more detailed information on this, see Section "PROFINET parameters (Page 6294)"

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 1200. The IP 
address and subnet mask connection parameters are configured.

PROFINET parameters

PROFINET parameters for the HMI connection

PROFINET parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.       

Only limited changes are possible in this Inspector window.
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Displaying and editing HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

Connection
The "Connection" area displays the HMI connection created for communication between the 
devices.

You can edit the name of the HMI connection in this area.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFINET 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area cannot be edited.
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● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the selected IP address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFINET parameters for the HMI device

PROFINET parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.     

Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".
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"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"IP protocol"
● "Set IP address in the project"

When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device. 

 

  Note

The device is automatically restarted in the case of HMI devices with the Windows CE 3.0 
operating system.

HMI devices with Windows CE 3.0:
● OP 77B
● TP 177B color PN/DP
● TP 177B mono DP
● OP 177B color PN/DP
● OP 177B mono DP
● Mobile Panel 177 PN
● Mobile Panel 177 DP
● TP 277 6"
● OP 277 6"

 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.

● "Use IP router"
If you are using an IP router, select "Use IP router" and enter the router address in the 
"Router address" field.

● "Set IP address using a different method"
If the function "Set IP address using a different method" is activated, the IP address is not 
taken from the project. You have to enter the IP address directly in the Control Panel of the 
HMI device.

PROFINET parameters for the PLC

PROFINET parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.    
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Displaying and changing PROFINET parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"IP protocol"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "IP address"
You assign the IP address of the HMI device in the "IP address" area. 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.
If you are using an IP router, select "Use IP router" and enter the router address in the field.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6296 System Manual, 02/2014



Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.

IP address  
The IP parameters are visible if the communication-capable devices support the TCP/IP 
protocol.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of the following:

● The address of the (sub) net

● The address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The node address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0
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 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.

 

Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (e.g. IP address 129.80.xxx.xxx) and change the default 
subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The job of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, in this case you have 
to enter the address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.

Communication security

Security levels
If you want to protect the PLC and HMI device communication, you can assign protection levels 
for the communication.

For a SIMATIC S7-1500 CPU, you can enter multiple passwords and thereby set up different 
access rights for various user groups.
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The passwords are entered in a table, so that exactly one protection level is assigned to each 
password. 

The effect of the password is given in the "Protection" column.

For the SIMATIC S7-1200 controller, several aspects need to be considered when setting 
protection levels. For additional information on this, see: S7-1200 protection levels

Example
You select the "Complete protection" protection level for a standard CPU (i.e., not an F-CPU) 
when configuring it.

Afterwards, you enter a separate password for every protection level above it in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:

● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read and write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction    
Communication with a PLC with the"Complete protection" protection level is protected by a 
password. The password is stored in the properties of the PLC.

Enter the password from the PLC in the "Access password" area.

Communication to the PLC is denied if an incorrect password or no password is entered.
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Entering the access password
Enter the access password for the HMI connection in the "Connections" editor.

Setting port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.
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Possible settings for transmission rate / duplex   
Depending on the selected device, you can make the following settings for "Transmission rate / 
duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option   
This option enables or disables port diagnostics. Examples of port diagnostics: The link status 
is monitored, in other words, the diagnostics are generated during link-down and the system 
reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "   
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.

You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 
 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 
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Wiring rules for disabled autonegotiation

Requirements
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission rate

● Autonegotiation incl. autocrossing disabled

The time for negotiating the transmission rate during startup has been saved.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation    
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.
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Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

10.11.7.3 Communication via PROFIBUS

Configuring an HMI connection

Communication via PROFIBUS

HMI connections via PROFIBUS
If you want to connect a SIMATIC S7 1200 to a HMI device via PROFIBUS, you must configure 
a PROFIBUS-capable communication module to a slot of the controller first.    

HMI connection in the "Devices & Networks" editor 
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7-1200 via 
PROFIBUS in the "Devices & Networks" editor.       

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7-1200

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Use a drag-and-drop operation to move a PROFIBUS-capable communication module from 
the hardware catalog to the PLC.

4. Click the HMI device interface.

5. Select the "PROFIBUS" interface type in the Inspector window under "Properties > General 
> PROFIBUS address/ MPI address > Parameters".
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6. Click the interface of the communication module and use a drag-and-drop operation to draw 
a connection to the HMI device.

7. Click the name of the connection.
The connection is displayed graphically in the Inspector window.

8. Click "Highlight HMI connection" and select the HMI connection.

9. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the section "PROFIBUS parameters (Page 6315)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7-1200 via 
PROFIBUS.

Configuring an HMI connection

Communication via PROFIBUS

Communication via PROFIBUS
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
1200 PLC via PROFIBUS.               

You can use the following WinCC Runtimes as an HMI device:
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● WinCC RT Advanced

● WinCC RT Professional

If you want to connect a SIMATIC S7 1200 to an HMI device via PROFIBUS, you must 
configure a PROFIBUS-capable communication module in a slot of the PLC.

WinCC Runtime as HMI device
You configure the HMI connections between a WinCC Runtime and SIMATIC S7 1200 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:

1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.
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You can also connect multiple HMI devices to one SIMATIC S7 1200 and multiple SIMATIC 
S7 1200s to one HMI device. The maximum number of communication partners that you can 
connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFIBUS 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7-1200 via 
PROFIBUS in the "Devices & Networks" editor.                             

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7-1200

● SIMATIC PC with PROFIBUS interface

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6308 System Manual, 02/2014



Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Use a drag-and-drop operation to move a PROFIBUS-capable communication module from 
the hardware catalog to the PLC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the PROFIBUS interface of the communication module and use a drag-and-drop 
operation to draw a connection to the PROFIBUS interface of the PC.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the section "PROFIBUS parameters (Page 6315)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7-1200 via 
PROFIBUS.

Configuring an HMI connection via PROFIBUS with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 1200 via 
PROFIBUS in the "Devices & Networks" editor.                
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Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 1200

● WinCC RT Advanced or WinCC RT Professional

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication module from 
the hardware catalog to the PLC.
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3. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

5. Click the PROFIBUS interface of the communication module and use a drag-and-drop 
operation to draw a connection to the PROFIBUS interface of the communication processor.

6. Click the connecting line.
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7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6315)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 1200 via 
PROFIBUS.

PROFIBUS parameters

PROFIBUS parameters for the HMI connection

PROFIBUS parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.
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Displaying and editing HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
The "Connection" area displays the HMI connection created for communication between the 
devices.

You can edit the name of the HMI connection in this area.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFIBUS 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"

Displays the selected interface type. This area cannot be edited.
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● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the PROFIBUS address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.

Assigning password
Enter the "Access password" for the PLC in the "Connections" editor.

PROFIBUS parameters for the HMI device

PROFIBUS parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.      
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Displaying and changing PROFIBUS parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under "Properties > 
General > General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.
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● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

PROFIBUS parameters for the PLC

PROFIBUS parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.      

Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.
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"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

Bus profiles with PROFIBUS

Introduction   
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.             

Devices with different profiles on the same PROFIBUS subnet   
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. 

Profiles and transmission rates   

Profiles Supported transmission speeds in Kbits/s
DP 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000 
Standard 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000
Universal 9,6 19,2 93,75 187,5 500 1500
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Meaning of profiles   

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal Select the "Universal" bus profile when individual devices on the PROFIBUS 
subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.

Communication security

Security levels
If you want to protect the PLC and HMI device communication, you can assign protection levels 
for the communication.

For a SIMATIC S7-1500 CPU, you can enter multiple passwords and thereby set up different 
access rights for various user groups.

The passwords are entered in a table, so that exactly one protection level is assigned to each 
password. 

The effect of the password is given in the "Protection" column.

For the SIMATIC S7-1200 controller, several aspects need to be considered when setting 
protection levels. For additional information on this, see: Auto-Hotspot

Example
You select the "Complete protection" protection level for a standard CPU (i.e., not an F-CPU) 
when configuring it.

Afterwards, you enter a separate password for every protection level above it in the table. 

For users who do not know any of the passwords, the CPU is completely protected. Not even 
HMI access is possible.

For users who know one of the assigned passwords, the effect depends on the table row in 
which the password occurs:
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● The password in row 1 (no protection) allows access as if the CPU were completely 
unprotected.  Users who know this password have unrestricted access to the CPU.

● The password in row 2 (write protection) allows access as if the CPU were write-protected.  
Despite knowing the password, users who know this password only have read access to 
the CPU.

● The password in row 3 (read and write protection) allows access as if the CPU were read-
protected and write-protected, so that only HMI access is possible for users who know this 
password.

Access password for the HMI connection

Introduction  
Secure access to a PLC by assigning a password.

Assign the password when configuring the connection.

Input of the password of the PLC is mandatory as of "Complete protection" security level. 

Communication to the PLC is denied if an incorrect password or no password is entered.

Assigning password
Enter the "Access password" for the PLC in the "Connections" editor.
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10.11.7.4 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Configuration of area pointers 

See also
Data exchange using area pointers (Page 6162)

Area pointer "Date/time"

Function       
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. 

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:
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Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Permitted data types
You can use the following data types when you configure the "Date/Time" area pointer.

● Word

● UInt

● DTL

Use of the "DTL" data type
Use of data type "DTL" with communication driver S7-1200. A tag of the "DTL" data type has 
a length of 12 bytes and saves information on date and time in a predefined structure.

The "DTL" data type has the following structure:

Byte Component Data type Value range
0 Year UINT 1970 to 2554
1
2 Month USINT 0 to 12
3 Day USINT 1 to 31
4 Day of week USINT 1(Sunday) to 7(Saturday)

The weekday is not considered in the value entry.
5 Hour USINT 0 to 23
6 Minute USINT 0 to 59
7 Second USINT 0 to 59
8 Nanoseconds UDINT 0 to 999 999 999
9
10
11
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The "DTL" data type supports time information down to the nanosecond range. Because panels 
only support time information down to the millisecond, you may encounter the following 
restriction when using the area pointers: 

For the transmission of time information from a panel to the controller, the smallest unit of time 
is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" data type 
is filled with zeros.

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the date/time area pointer PLC to avoid any 
negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:

DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved
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1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

Permitted data types
You can use the following data types when you configure the "Date/Time PLC" area pointer:

● DTL

Use of the "DTL" data type
Use of data type "DTL" with communication driver S7-1200. A tag of the "DTL" data type has 
a length of 12 bytes and saves information on date and time in a predefined structure.

The "DTL" data type has the following structure:

Byte Component Data type Value range
0 Year UINT 1970 to 2554
1
2 Month USINT 0 to 12
3 Day USINT 1 to 31
4 Day of week USINT 1(Sunday) to 7(Saturday)

The weekday is not considered in the value entry.
5 Hour USINT 0 to 23
6 Minute USINT 0 to 59
7 Second USINT 0 to 59
8 Nanoseconds UDINT 0 to 999 999 999
9
10
11

The HMI devices do not support the use of nanoseconds. Values in the nanosecond range will 
be ignored during processing in Runtime.

The "DTL" data type supports time information down to the nanosecond range. Because panels 
only support time information down to the millisecond, you may encounter the following 
restriction when using the area pointers: 

For the transmission of time information from a controller to a panel, the range from 
microseconds to nanoseconds is ignored. The time information is processed on the panel down 
to milliseconds.
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Area pointer "Coordination"

Function     
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Usage
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.

 

Assignment of the bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.
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Processing in the PLC
For a simpler evaluation in the PLC program, use a Bool array for this area pointer when using 
the SIMATIC S7 1200 communication driver. You will have to map the complete 16-bit word 
of the area pointer. Configure a tag of the data type "Array [0 .. 15] of bool" for this purpose.

Permitted data types
You can use the following data types when you configure the "Coordination" area pointer.

● Word

● UInt

● Bool

Area pointer "Screen number"

Function     
The HMI devices store information about the screen called up on the HMI device in the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. Certain 
reactions can be triggered in the PLC, such as the call of a different screen.

Use
Before the "Screen number" area pointer can be used, it must be set up and activated by 
selecting "Communication ▶ Area pointer". You can create only one instance of the "Screen 
number" area pointer and only on one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1. Word Current screen type
2. Word Current screen number
3. Word Reserved
4th word Current field number
5. Word Reserved
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● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

 

  Note
Device dependency

Permanent windows are not available on Basic Panels.
 

Permitted data types
You can use the following data types when you configure the "Screen number" area pointer.

● Word

● UInt

Area pointer "Project ID"

Function     
When Runtime starts, a check can be carried out as to whether the HMI device is connected 
to the correct PLC. This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. 

A missing compatibility results in a corresponding alarm and Runtime will not be started.

Use
 

 Note
HMI connections cannot be switched "online".

The HMI connection in which the "Project ID" area pointer is used must be switched "online".
 

To use this area pointer, set up the following during the configuration:

● Define the version of the configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● This is where you select the PLC tag or the tag array that you have configured as the data 
area for the area pointer.
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Connection failure     
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

Permitted data types
You can use the following data types when you configure the "Project ID" area pointer.

● Word

● UInt

Area pointer "Job mailbox"

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.
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Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Set date (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 An interval of at least 5 seconds must be maintained between two successive jobs to prevent 

overload of the HMI device.
 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 An interval of at least 5 seconds must be maintained between two successive jobs to prevent 

overload of the HMI device.
 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Clear event buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Clear error alarm buffer
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No
.

Function  

14 Set time (BCD-coded)
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Display selection
 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only devices supporting recipes
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.

Permitted data types
You can use the following data types when you configure the "Screen number" area pointer:

● Word

● UInt

 

"Data record" area pointer

"Data mailbox" area pointer

Function     
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.
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Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization over the data mailbox

Data records are always transferred directly. That is, the tag values are read from an address 
or written to an address configured for this tag directly, without redirecting the values by means 
of interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a job mailbox, the data in the recipe view will be 
updated as well. Avoid operating the recipe view while job mailboxes for transfer of data records 
are being triggered. If you have already started editing a data record and a job mailbox is 
triggered for transfer of data records, then this job mailbox will be rejected. 

Permitted data types
You can use the following data types when you configure the "Data record" area pointer.

● Word

● UInt

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example, when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.
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Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then process, edit, or save these 
values, for example. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. Use this mechanism to prevent uncontrolled overwriting of data in either direction 
of your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Connections ▶ Area pointer" editor.

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data record free
2 0000 0010 Transfer is busy
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Sequence of a transfer started by the operator in the recipe display

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data mailbox and sets the data record number 
to 0. 

Abort with system 
alarm.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
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Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data mailbox.

Abort with system 
alarm.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.

 

 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxes No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data mailboxes from the PLC to the HMI device. The job mailbox 
is structured as follows:

 Most significant byte Least significant byte
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1
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No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox no. 70 transfers data mailboxes from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Most significant byte Least significant byte
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified 

in the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device reads the values and stores the values in the data 

record specified in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed". 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 
1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

Sequence writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified 

in the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

job from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The PLC program can now evaluate the transferred data. 

To allow further transfers, the PLC program must set the status word 
to 0 again.
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Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
alarm.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
alarm.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
mailbox.

 

 Note
Availability for specific devices

Notes in the status bar of the recipe view are not available in Basic Panels.
 

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:
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Outputting the tag values (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

See also
Displaying tags with Runtime Professional (Page 3828)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.
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Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.
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Alarms

Configuring alarms

Configure alarms  
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3910) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 
300/400

WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, REAL, 
COUNTER, TIME

How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0
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Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
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tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.
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The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

10.11.7.5 Performance features of communication

Device dependency S7 1200

Communication with the SIMATIC S7-1200 PLC
If you use devices from an earlier version of TIA Portal with TIA Portal V12 SP1, it may not be 
possible to configure integrated connections to certain HMI devices.

Basic Panels V11.0

HMI devices SIMATIC S7-1200 
(V1)

SIMATIC S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KP300 Basic Yes Yes Yes Yes Yes
KP400 Basic Yes Yes Yes Yes Yes
KTP400 Basic PN Yes Yes Yes Yes Yes
KTP600 Basic DP Yes Yes Yes Yes Yes
KTP600 Basic PN Yes Yes Yes Yes Yes
KTP1000 Basic DP Yes Yes Yes Yes Yes
KTP1000 Basic PN Yes Yes Yes Yes Yes
TP1500 Basic PN Yes Yes Yes Yes Yes

 

Basic Panels V12.0

HMI devices SIMATIC S7-1200 
(V1)

SIMATIC S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KP300 Basic No Yes Yes Yes Yes
KP400 Basic No Yes Yes Yes Yes
KTP400 Basic PN No Yes Yes Yes Yes
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HMI devices SIMATIC S7-1200 
(V1)

SIMATIC S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KTP600 Basic DP No Yes Yes Yes Yes
KTP600 Basic PN No Yes Yes Yes Yes
KTP1000 Basic DP No Yes Yes Yes Yes
KTP1000 Basic PN No Yes Yes Yes Yes
TP1500 Basic PN No Yes Yes Yes Yes

 

Basic Panels V13.0

HMI devices SIMATIC S7-1200 
(V1)

SIMATIC S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KTP700 Basic PN No Yes Yes Yes Yes
KTP900 Basic PN No Yes Yes Yes Yes

 

Panels V11.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 (V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

OP 73 No Yes Yes Yes Yes
OP 77A No Yes Yes Yes Yes
OP 77B No Yes Yes Yes Yes
TP 177A No Yes Yes Yes Yes
TP 177A Portrait No Yes Yes Yes Yes
TP 177B 4" No Yes Yes Yes No
TP 177B 6" mono No Yes Yes Yes Yes
TP 177B 6" No Yes Yes Yes Yes
OP 177B 6" mono No Yes Yes Yes Yes
OP 177B 6" No Yes Yes Yes Yes
TP 277 6" No Yes Yes Yes Yes
OP 277 6" No Yes Yes Yes Yes

Multi Panels V11.0

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

MP 177 6" Touch No Yes Yes Yes No
MP 277 8" Key No Yes Yes Yes No
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HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

MP 277 10" Key No Yes Yes Yes No
MP 277 10" Touch No Yes Yes Yes No
MP 377 12" Key No Yes Yes Yes No
MP 377 12" Touch No Yes Yes Yes No
MP 377 15" Touch No Yes Yes Yes No
MP 377 19" Touch No Yes Yes Yes No

Multi Panels V12.0

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

MP 177 6" Touch No Yes Yes Yes Yes
MP 277 8" Key No Yes Yes Yes Yes
MP 277 10" Key No Yes Yes Yes Yes
MP 277 10" Touch No Yes Yes Yes Yes
MP 377 12" Key No Yes Yes Yes Yes
MP 377 12" Touch No Yes Yes Yes Yes
MP 377 15" Touch No Yes Yes Yes Yes
MP 377 19" Touch No Yes Yes Yes Yes

Mobile Panels V11.0

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

Mobile Panel 177 6" DP No Yes Yes Yes Yes
Mobile Panel 177 6" PN No Yes Yes Yes Yes
Mobile Panel 277 8" No Yes Yes Yes Yes
Mobile Panel 277 8" 
IWLAN V2

No Yes Yes Yes Yes

Mobile Panel 277F 8" 
IWLAN V2

No No No No No

Mobile Panel 277F 8" 
IWLAN V2 (RFID tag)

No No No No No

Mobile Panel 277 10" No Yes Yes Yes Yes
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Mobile Panels V12.0

HMI devices SIMATIC 
S7-1200 (V1)

SIMATIC 
S7-1200 (V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

Mobile Panel 177 6" DP No Yes Yes Yes Yes
Mobile Panel 177 6" PN No Yes Yes Yes Yes
Mobile Panel 277 8" No Yes Yes Yes Yes
Mobile Panel 277 8" 
IWLAN V2

No Yes Yes Yes Yes

Mobile Panel 277F 8" 
IWLAN V2

No Yes1) Yes1) Yes1) Yes1) 

Mobile Panel 277F 8" 
IWLAN V2 (RFID tag)

No Yes1) Yes1) Yes1) Yes1) 

Mobile Panel 277 10" No Yes Yes Yes Yes

Comfort Panels V11.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KP400 Comfort No Yes Yes Yes Yes
KTP400 Comfort No Yes Yes Yes Yes
KTP400 Comfort Portrait No Yes Yes Yes Yes
KP700 Comfort No Yes Yes Yes Yes
TP700 Comfort No Yes Yes Yes Yes
TP700 Comfort Portrait No Yes Yes Yes Yes
KP900 Comfort No Yes Yes Yes Yes
TP900 Comfort No Yes Yes Yes Yes
TP900 Comfort Portrait No Yes Yes Yes Yes
KP1200 Comfort No Yes Yes Yes Yes
TP1200 Comfort No Yes Yes Yes Yes
TP1200
Comfort
Portrait

No Yes Yes Yes Yes

KP1500 Comfort No Yes Yes Yes Yes
TP1500 Comfort No Yes Yes Yes Yes
TP1500 Comfort Portrait No Yes Yes Yes Yes
TP1900 Comfort No Yes Yes Yes Yes
TP1900 Comfort Portrait No Yes Yes Yes Yes
TP2200 Comfort No Yes Yes Yes Yes
TP2200 Comfort Portrait No Yes Yes Yes Yes

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6346 System Manual, 02/2014



Comfort Panels V12.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KP400 Comfort No Yes Yes Yes Yes
KTP400 Comfort No Yes Yes Yes Yes
KTP400 Comfort Portrait No Yes Yes Yes Yes
KP700 Comfort No Yes Yes Yes Yes
TP700 Comfort No Yes Yes Yes Yes
TP700 Comfort Portrait No Yes Yes Yes Yes
KP900 Comfort No Yes Yes Yes Yes
TP900 Comfort No Yes Yes Yes Yes
TP900 Comfort Portrait No Yes Yes Yes Yes
KP1200 Comfort No Yes Yes Yes Yes
TP1200 Comfort No Yes Yes Yes Yes
TP1200
Comfort
Portrait

No Yes Yes Yes Yes

KP1500 Comfort No Yes Yes Yes Yes
TP1500 Comfort No Yes Yes Yes Yes
TP1500 Comfort Portrait No Yes Yes Yes Yes
TP1900 Comfort No Yes Yes Yes Yes
TP1900 Comfort Portrait No Yes Yes Yes Yes
TP2200 Comfort No Yes Yes Yes Yes
TP2200 Comfort Portrait No Yes Yes Yes Yes

Comfort Panels V13.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

KP400 Comfort No Yes Yes Yes Yes
KTP400 Comfort No Yes Yes Yes Yes
KTP400 Comfort Portrait No Yes Yes Yes Yes
KP700 Comfort No Yes Yes Yes Yes
TP700 Comfort No Yes Yes Yes Yes
TP700 Comfort Portrait No Yes Yes Yes Yes
KP900 Comfort No Yes Yes Yes Yes
TP900 Comfort No Yes Yes Yes Yes
TP900 Comfort Portrait No Yes Yes Yes Yes
KP1200 Comfort No Yes Yes Yes Yes
TP1200 Comfort No Yes Yes Yes Yes
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HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC S7-1200 
(V2.2)

SIMATIC S7-1200 
(V3)

SIMATIC S7-1200 
(V4)

TP1200
Comfort
Portrait

No Yes Yes Yes Yes

KP1500 Comfort No Yes Yes Yes Yes
TP1500 Comfort No Yes Yes Yes Yes
TP1500 Comfort Portrait No Yes Yes Yes Yes
TP1900 Comfort No Yes Yes Yes Yes
TP1900 Comfort Portrait No Yes Yes Yes Yes
TP2200 Comfort No Yes Yes Yes Yes
TP2200 Comfort Portrait No Yes Yes Yes Yes

Runtime V11.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

WinCC RT 
Advanced

No Yes Yes Yes No No Yes

WinCC RT 
Professional

No Yes Yes Yes No No Yes

Runtime V12.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

WinCC RT 
Advanced

No Yes Yes Yes Yes Yes Yes

WinCC RT 
Professional

No Yes Yes Yes Yes Yes Yes

Runtime V13.0

HMI devices SIMATIC 
S7-1200 
(V1)

SIMATIC 
S7-1200 
(V2)

SIMATIC 
S7-1200 
(V2.2)

SIMATIC 
S7-1200 (V3)

SIMATIC 
S7-1200 (V4)

SIMATIC 
S7-1500 

SIMATIC 
S7-300/400

WinCC RT 
Advanced

No Yes Yes Yes Yes Yes Yes

WinCC RT 
Professional

No Yes Yes Yes Yes Yes Yes
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Valid data types for SIMATIC S7-1200

Valid data types for connections with SIMATIC S7-1200
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Length
BOOL 1 bit
SINT 1 byte
INT 2 bytes
DINT 4 bytes
USINT 1 byte
UINT 2 bytes
UDINT 4 bytes
REAL 4 bytes
LREAL 8 bytes
TIME 4 bytes
DATE 2 bytes
DTL 12 bytes
TIME_OF_DAY, TOD 4 bytes
STRING (2+n) bytes, n = 0 to 254
CHAR 1 byte
Array of CHAR --
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes

 

 

Valid data types for SIMATIC S7-1200

Valid data types for connections with SIMATIC S7-1200
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Length
BOOL 1 bit
SINT 1 byte
INT 2 bytes
DINT 4 bytes
USINT 1 byte
UINT 2 bytes
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Data type Length
UDINT 4 bytes
REAL 4 bytes
LREAL 8 bytes
TIME 4 bytes
DATE 2 bytes
TIME_OF_DAY, TOD 4 bytes
STRING (2+n) bytes, n = 0 to 254
CHAR 1 byte
Array of CHAR --
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes
Date_And_Time 8 bytes
DTL 8 bytes
LDT 8 bytes

 

 

10.11.7.6 Configuring connections in the "Connections" editor

Creating a PROFINET connection

Requirements
● A project is open.

● An HMI device with a PROFINET interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".
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3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select a PROFINET interface of the HMI device in the Inspector window under "Parameters 
> Interface".

6. Set the IP addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating a PROFIBUS connection

Requirements
● A project is open.

● An HMI device with a PROFIBUS interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "MPI/DP" interface in the Inspector window under "Parameters > Interface".
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6. Select the "DP" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Parameters for the connection

Connection parameters

Parameters to be set
To assign the connection parameters, such as addresses and profiles, click the connection 
that you have created in the "Connections" editor.       

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
Specifies the access point for the PG/PC interface that can be used to reach the 
communication partner.
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.
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● "Only master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7-200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Access password"
Enter a password in the "Access password" field. This password must match the one you 
saved to the PLC.

 

  Note

You only need a password if you have set "Complete protection" at the PLC.

No connection is set up to the PLC if the "Complete protection" security level is stored on 
the PLC and you do not enter a password.

 

10.11.7.7 Configuring connections in the "Connections" editor

Creating a connection

Requirements
● A project is open.

● WinCC RT Professional is created    
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select an interface of the HMI device in the Inspector window under "Parameters > 
Interface".

6. Set the parameters for the connection in the Inspector window.

Interfaces
Select one of the following interfaces in the Inspector window under "Parameters > 
WinCC RT Professional > Interfaces".

● TCP/IP

● PROFIBUS

For additional information on the parameters of the interfaces see:

Parameters for the connection (Page 6363)
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Parameters for the connection

TCP/IP

Introduction
You assign the parameters for the HMI device and the PLC in the network under "Parameters".  
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HMI device
● "Access point"

The access point defines a logical device name through which the communication partner 
can be reached.

PLC
● "Address"

Enter the station address of the CPU under "Address".

PROFIBUS

Introduction
You assign the parameters for the HMI device and the PLC in the network under "Parameters". 
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HMI device
● "Access point"

Select the logical device name of the HMI device under "Access point".

PLC
● "Address"

Enter the station address of the CPU under "Address".

10.11.7.8 Configuring time synchronization

Time synchronization

Introduction 
To have the same time of day throughout the plant, you can synchronize the time on various 
plant components using time synchronization. WinCC time synchronization is operated as a 
master-slave system. 

One system component must be a clock for all components of a plant to work with identical 
time. The component functioning as the clock is referred to as the time master. The 
components that receive the time are time slaves.

Properties of time synchronization
● The HMI device can define the time as master or can accept the time of the PLC as slave.

● In "master mode", the time is synchronized at each connection setup.

● In "slave mode", the time is synchronized at each connection setup and than at cyclic 
intervals of 10 minutes.

● The first time synchronization is performed on the HMI device immediately after the start 
of runtime.

● Time synchronization is only performed on the HMI device during operation of runtime.
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Time synchronization restrictions

Approved HMI devices  
You can configure the time synchronization between a SIMATIC S7-1200 or SIMATIC S7-1500 
and an HMI device with the following HMI devices:

Device Operating system
Basic Panels -
TP177 4" Windows CE 5.0
Multi Panel 177 Windows CE 5.0
Multi Panel 277 Windows CE 5.0
Multi Panel 377 Windows CE 5.0
Mobile Panel 277 Windows CE 5.0
Mobile 277 IWLAN V2 Windows CE 5.0
Comfort Panels Windows CE 6.0
PC systems with WinCC RT Advanced Microsoft Windows XP

Microsoft Windows 7

Configuration restrictions
● If an HMI device has several connections to SIMATIC S7-1200 or SIMATIC S7-1500, you 

can only configure one connection as "slave".

● If you have enabled time synchronization for the HMI device as "slave", you can no longer 
use the global area pointer "Date/time PLC".

● An HMI device can only request the time from a PLC with "Complete protection" security 
type configuration if the correct "Access password" is configured.  
Configure the "Access password" for communication with a PLC with "Complete protection" 
security type in the "Connections" editor of the HMI device.
This "Access password" must match the password configured on the PLC. The PLC 
password is assigned in the PLC properties at:  "General > Security"

● Basic Panels can only be configured as "Slave".

● If you use Basic Panels for the configuration, it is not possible to use time synchronization 
via NTP and the "Date/time PLC" area pointer simultaneously.

● Time synchronization with SIMATIC S7-1200 (V1.0) controllers is not possible.

● Time synchronization between the HMI device TP177 4" and SIMATIC S7-1200 (V4.0) 
controllers is not possible.

● Time synchronization between the HMI device TP177 4" and SIMATIC S7-1500 is not 
possible.
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Configuring time synchronization for integrated connections

Introduction
You configure time synchronization for an integrated connection in the "Devices & Networks" 
editor.

Requirements
● An HMI connection between an HMI device and a SIMATIC S7 1200 has been configured.

● The HMI device must support the "time synchronization" function.

● The "Devices & Networks" editor is open.

Procedure
1. Click the line of the HMI connection in the "Devices & networks" editor.

2. Select the following in the inspector window under "General > Time synchronization > 
Settings":

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.

Configuring time synchronization for non-integrated connections

Introduction
You configure time synchronization for a non-integrated connection in the "Connections" editor.
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Requirements
● An HMI device which supports the "time synchronization" function has been created.

● "Connections" editor is open.

Procedure
1. Double-click "<Add>".

2. In the "Communication drivers" column, select the "SIMATIC S7 1200" PLC.

3. Select the following in the "HMI time synchronization mode" column:

– None: No time synchronization is used.

– Master: The HMI device sets the time.

– Slave: The PLC sets the time.
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10.11.8 Communicating with SIMATIC S7 300/400

10.11.8.1 Communication with SIMATIC S7 300/400

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 300 
and S7 400 PLCs. These two PLCs will be referred to jointly as SIMATIC S7 300/400.     

You can configure the following communication channels for the SIMATIC S7 300/400 PLC:

● PROFINET

● PROFIBUS

● MPI

HMI connection for communication
You configure connections between the HMI device and a SIMATIC S7 300/400 in the "Devices 
& Networks" editor. 
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10.11.8.2 Communication via PROFINET

Configuring an HMI connection

Communication via PROFINET

HMI connections via PROFINET
If you have inserted an HMI device and a SIMATIC S7 300/400 into the project, you 
interconnect the two PROFINET interfaces in the "Devices & Networks" editor.     

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.
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Configuring an HMI connection via PROFINET

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFINET or Ethernet in the "Devices & Networks" editor.       

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with PROFINET or Ethernet interface

● SIMATIC S7 300/400 with PROFINET interface.

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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3. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the HMI device.

4. Click the connecting line.

5. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

6. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6381)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 300/400. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection

Communication via PROFINET

Communication via PROFINET
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
300/400 PLC via PROFINET.        

You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

● WinCC RT Professional

WinCC Runtime as HMI device
You configure the HMI connections between a WinCC Runtime and SIMATIC S7 300/400 in 
the "Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFINET in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFINET 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFINET with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and SIMATIC S7 300/400 via 
PROFINET or Ethernet in the "Devices & Networks" editor.            

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with PROFINET interface

● SIMATIC PC with PROFINET interface
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET or Ethernet interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6381)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 300/400. The IP 
address and subnet mask connection parameters are configured.
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Configuring an HMI connection via PROFINET with a PC

Introduction
You configure an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
PROFINET or Ethernet in the "Devices & Networks" editor.              

 

 CAUTION

Communication via Ethernet

In Ethernet-based communication, the end user is responsible for the security of his data 
network. 

Targeted attacks can overload the device and interfere with proper functioning.
 

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with PROFINET interface

● PC station with WinCC RT Advanced or WinCC RT Professional
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFINET-capable communication processor 
from the hardware catalog to the WinCC Runtime.

3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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4. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the communication processor.

5. Click the connecting line.
The connection is displayed graphically in the Inspector window.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFINET parameters (Page 6381)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created a connection between an HMI device and a SIMATIC S7 300/400. The IP 
address and subnet mask connection parameters are configured.
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PROFINET parameters

PROFINET parameters for the HMI connection

PROFINET parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection. 

Only limited changes are possible in this Inspector window.         

Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".
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"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.

"Connection path"
The communication partners of the selected HMI connection and the associated PROFINET 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area cannot be edited.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area cannot be edited.

● "Subnet"
Displays the selected subnet. This area cannot be edited.

● "Address"
Displays the selected IP address of the device. This area cannot be edited.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFINET parameters for the HMI device

PROFINET parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.     
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Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under "Properties > 
General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.
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"IP protocol"
● "Set IP address in the project"

When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device. 

 

  Note

The device is automatically restarted in the case of HMI devices with the Windows CE 3.0 
operating system.

HMI devices with Windows CE 3.0:
● OP 77B
● TP 177B color PN/DP
● TP 177B mono DP
● OP 177B color PN/DP
● OP 177B mono DP
● Mobile Panel 177 PN
● Mobile Panel 177 DP
● TP 277 6"
● OP 277 6"

 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.

● "Use IP router"
If you are using an IP router, select "Use IP router" and enter the router address in the 
"Router address" field.

● "Set IP address using a different method"
If the function "Set IP address using a different method" is activated, the IP address is not 
taken from the project. You have to enter the IP address directly in the Control Panel of the 
HMI device.

PROFINET parameters for the PLC

PROFINET parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.     
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Displaying and changing PROFINET parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.

"IP protocol"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "IP address"
You assign the IP address of the HMI device in the "IP address" area. 

● "Subnet mask"
You assign data of the subnet mask in the "Subnet mask" area.
If you are using an IP router, select "Use IP router" and enter the router address in the field.
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Configuring Industrial Ethernet

Rules for the network configuration  
The Ethernet interfaces of the devices have a default IP address that you can change.

IP address  
The IP parameters are visible if the communication-capable devices support the TCP/IP 
protocol.

The IP address consists of 4 decimal figures in the range of 0 to 255. The decimal figures are 
separated from one another by a dot.

Example: 140.80.0.2 

The IP address consists of the following:

● The address of the (sub) net

● The address of the node (generally also called host or network node)

Subnet mask  
The subnet mask splits these two addresses. It determines which part of the IP address 
addresses the network and which part of the IP address addresses the node. 

The set bits of the subnet mask determine the network part of the IP address.

Example:

Subnet mask: 255.255.0.0 = 11111111.11111111.00000000.00000000

In the example given for the above IP address, the subnet mask shown here has the following 
meaning: 

The first 2 bytes of the IP address identify the subnet - i.e. 140.80. The last two bytes address 
the node, thus 0.2. 

It is generally true that: 

● The network address results from AND linking the IP address and subnet mask.

● The node address results from AND NOT linking the IP address and subnet mask.

Relation between IP address and default subnet mask  
An agreement exists relating to the assignment of IP address ranges and so-called "Default 
subnet masks". The first decimal number (from the left) in the IP address determines the 
structure of the default subnet mask. It determines the number of "1" values (binary) as follows:

IP address (decimal) IP address (binary) Address class Default subnet mask
0 to 126 0xxxxxxx.xxxxxxxx.... A 255.0.0.0
128 to 191 10xxxxxx.xxxxxxxx... B 255.255.0.0
192 to 223 110xxxxx.xxxxxxxx... C 255.255.255.0
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 Note
Range of values for the first decimal point

A value of between 224 and 255 is also possible for the first decimal number of the IP address 
(address class D etc). This is, however, not recommended because there is no address check 
for these values.

 

Masking other subnets  
You can use the subnet mask to add further structures and form "private" subnets for a subnet 
that is assigned one of the address classes A, B or C. This is done by setting other lower points 
of the subnet mask to "1". For each bit set to "1", the number of "private" networks doubles 
and the number of nodes they contain is halved. Externally, the network functions like an 
individual network as it did previously. 

Example:

You have a subnet of address class B (e.g. IP address 129.80.xxx.xxx) and change the default 
subnet mask as follows: 

Masks Decimal Binary
Default subnet mask 255.255.0.0 11111111.11111111.00000000.

00000000
Subnet mask 255.255.128.0 11111111.11111111.10000000.

00000000

Result: 

All nodes with addresses between 129.80.001.xxx and 129.80.127.xxx are on one subnet, all 
nodes with addresses between 129.80.128.xxx and 129.80.255.xxx are on another subnet.

Router  
The job of the routers is to connect the subnets. If an IP datagram is to be sent to another 
network, it first has to be conveyed to a router. To make this possible, in this case you have 
to enter the address of the router for each node in the subnet.

The IP address of a node in the subnet and the address of the router may only differ at the 
points at which there is a "0" in the subnet mask.
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Port options

Setting the port options

Changing connection settings for the PROFINET IO port
You can change the network settings for the PROFINET IO port as required. By default, the 
settings are made automatically. In normal situations, this guarantees problem-free 
communication.

Possible settings for transmission rate / duplex   
Depending on the selected device, you can make the following settings for "Transmission rate / 
duplex":

● Automatic setting
Recommended default setting of the port. The transmission settings are automatically 
"negotiated" with the peer port. The "Enable autonegotiation" option is also enabled as a 
default, in other words, you can use cross cables or patch cables for the connection.

● TP/ITP at x Mbps full duplex (half duplex)
Setting of the transmission rate and the full duplex/half duplex mode. The effectiveness 
depends on the "Enable autonegotiation" setting: 

– Autonegotiation enabled
You can use both cross cable and patch cable.

– Autonegotiation disabled
Make sure that you use the correct cable (patch cable or cross cable)! The port is also 
monitored with this setting.

● Deactivated
Depending on the module type, the drop down list box can contain the "- Disabled -" option. 
This option, for example, allows you to prevent access to an unused port for security 
reasons. With this setting, diagnostic events are not generated.

"Monitor" option   
This option enables or disables port diagnostics. Examples of port diagnostics: The link status 
is monitored, in other words, the diagnostics are generated during link-down and the system 
reserve is monitored in the case of fiber optic ports.

Option "Enable autonegotiation "   
The autonegotiation setting can only be changed if a concrete medium (for example, TP 100 
Mbps full duplex) is selected. Whether or not a concrete medium can be set depends on the 
properties of the module. 

If autonegotiation is disabled, this causes the port to be permanently specified, as for example, 
is necessary for a prioritized startup of the IO device.
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You must make sure the partner port has the same settings because with this option the 
operating parameters of the connected network are not detected and the data transmission 
rate and transmission mode can accordingly not be optimally set.

 
 

 Note

When a local port is connected, STEP 7 makes the setting for the partner port if the partner 
port supports the setting. If the partner port does not accept the setting, an error message is 
generated. 

 

Wiring rules for disabled autonegotiation

Requirements
You have made the following settings for the port in question, for example, to accelerate the 
startup time of the IO device:

● Fixed transmission rate

● Autonegotiation incl. autocrossing disabled

The time for negotiating the transmission rate during startup has been saved.

If you have disabled autonegotiation, you must observe the wiring rules.

Wiring rules for disabled autonegotiation    
PROFINET devices have the following two types of ports:

Type of port PROFINET devices Note
Switch port with crossed pin 
assignment

For IO devices: Port 2
For S7 CPUs with 2 ports: Ports 
1 and 2

Crossed pin assignment means 
that the pin assignment for the 
ports for sending and receiving 
between the respective 
PROFINET devices is 
exchanged internally. 

End device port with uncrossed 
pin assignment

For IO devices: Port 1
For S7 CPUs with one port: Port 
1

-

Validity of the wiring rules
The cabling rules described in the following paragraph apply exclusively for the situation in 
which you have specified a fixed port setting.
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Rules for cabling
You can connect several IO devices in line using a single cable type (patch cable). To do this, 
you connect port 2 of the IO device (distributed I/O) with port 1 of the next IO device. The 
following graphic gives an example with two IO devices.

Boundaries at the port

Requirements
To use boundaries, the respective device must have more than one port. If the PROFINET 
does not support boundary settings, they are not shown. 

Enable boundaries
"Boundaries" are limits for transmission of certain Ethernet frames. The following boundaries 
can be set at a port:

● "End of discovery of accessible devices"
No forwarding of DCP frames to identify accessible devices. Devices downstream from this 
port cannot be reached by the project tree under "Accessible devices". Devices downstream 
from this port cannot be reached by the CPU. 

● "End of topology discovery"
LLDP frames (Link Layer Discovery Protocol) are not forwarded for topology detection.

● "End of sync domain"
No forwarding of sync frames transmitted to synchronize nodes within a sync domain. 
If you operate, for example, a PROFINET device with more than two ports in a ring, you 
should prevent the sync frame from being fed into the ring by setting a sync boundary (at 
the ports not inside the ring). 
Additional example: If you want to use several sync domains, configure a sync domain 
boundary for the port connected to a PROFINET device from the other sync domain. 
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Restrictions
The following restrictions must be observed:

● The individual check boxes can only be used if the port supports the function in question.

● If a partner port has been determined for the port, the following check boxes cannot be 
used:

– "End of discovery of accessible devices"

– "End of topology discovery"

● If autonegotiation is disabled, none of the check boxes can be used.

10.11.8.3 Communication via PROFIBUS

Configuring an HMI connection

Communication via PROFIBUS

HMI connections via PROFIBUS
If you have inserted an HMI device and a SIMATIC S7 300/400 into the project, you 
interconnect the two PROFIBUS interfaces in the "Devices & Networks" editor.    

HMI connection in the "Devices & Networks" editor 
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFIBUS in the "Devices & Networks" editor.     

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 300/400 with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Click the HMI device interface.

4. Select the "PROFIBUS" interface type in the Inspector window under "Properties > General 
> HMI MPIDP > Parameters".
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5. Click the interface of the PLC and use a drag-and-drop operation to draw a connection to 
the HMI device.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFINET 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6401)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
PROFIBUS.
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Configuring an HMI connection

Communication via PROFIBUS

Communication via PROFIBUS
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
300/400 PLC via PROFIBUS.

You can use the following WinCC Runtimes as an HMI device:   

● WinCC RT Advanced

● WinCC RT Professional

WinCC Runtime as HMI device
You configure the HMI connections between WinCC Runtime and SIMATIC S7 300/400 in the 
"Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via PROFIBUS 
in the "Connections" editor of the HMI device.

Configuring an HMI connection via PROFIBUS with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via 
PROFIBUS in the "Devices & Networks" editor.               

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with PROFIBUS interface

● SIMATIC PC with PROFIBUS interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Click the MPI interface of the PC and select "PROFIBUS" for the interface type in the 
Inspector window.
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3. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the PC.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6401)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
PROFIBUS.
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Configuring an HMI connection via PROFIBUS with a PC

Introduction
You configure an HMI connection between an HMI device and a SIMATIC S7-300/400 via 
PROFIBUS in the "Devices & Networks" editor.                               

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7-300/400 with PROFIBUS interface

● PC station with WinCC RT Advanced or WinCC RT Professional

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the WinCC Runtime.
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3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the PROFIBUS interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFIBUS interface of the communication processor.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the PROFIBUS 
parameters in the Inspector window according to the requirements of your project.
See the chapter "PROFIBUS parameters (Page 6401)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7-1200 via 
PROFIBUS.
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PROFIBUS parameters

PROFIBUS parameters for the HMI connection

PROFIBUS parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.

Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.
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"Connection path"
The communication partners of the selected HMI connection and the associated PROFIBUS 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the device name. This area is not editable.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.

● "Interface type"
Displays the selected interface type. This area is not editable.

● "Subnet"
Displays the selected subnet. This area is not editable.

● "Address"
Displays the PROFIBUS address of the device. This area is not editable.

● "Find connection path" button
Enables the subsequent specification of connections. 

PROFIBUS parameters for the HMI device

PROFIBUS parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.      
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Displaying and changing PROFINET parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.

"Parameters"
● "Interface type"

You assign the interface type in the "Interface type" area. Depending on the HMI device 
type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6401



● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

PROFIBUS parameters for the PLC

PROFIBUS parameters for the PLC 
An overview of the configured parameters can be found in the properties for the PLC.      

Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".

"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the PLC is connected 
to the network. You use the "Add new subnet" button to create a new subnet.
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"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the PROFIBUS address of the HMI device in the "Address" area. The 
PROFIBUS address must be unique throughout the PROFIBUS network.

● "Highest address"
The "Highest address" area displays the highest address of the PROFIBUS network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

Bus profiles with PROFIBUS

Introduction   
Depending on the device types connected and protocols used on the PROFIBUS, different 
profiles are available. The profiles differ in terms of the setting options and calculation of bus 
parameters. The profiles are explained below.             

Devices with different profiles on the same PROFIBUS subnet   
The PROFIBUS subnet only functions without problem if the bus parameters of all devices 
have the same values. 

Profiles and transmission rates   

Profiles Supported transmission speeds in Kbits/s
DP 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000 
Standard 9,6 19,2 45,45 93,75 187,5 500 1500 3000 6000 12000
Universal 9,6 19,2 93,75 187,5 500 1500
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Meaning of profiles   

Profile Meaning
DP Select the "DP" bus profile when the only devices connected to the PROFIBUS 

subnet are those which satisfy the requirements of standard EN 50170 Volume 
2/3, Part 8-2 PROFIBUS. The bus parameter setting is optimized on these 
devices. 
This includes devices with DP master and DP slave interfaces of the SIMATIC 
S7 and distributed I/Os of other manufacturers. 

Standard Compared to the "DP" profile, the "Standard" profile also offers scope for 
devices of another project or devices which have not been configured here to 
be taken into account when calculating the bus parameters. The bus 
parameters are then calculated following a simple, non-optimized algorithm. 

Universal Select the "Universal" bus profile when individual devices on the PROFIBUS 
subnet use the PROFIBUS-FMS service. 
This includes the following devices for example: 
● CP 343-5
● PROFIBUS-FMS devices of other manufacturers
As with the "Standard" profile, this profile allows you to take other devices into 
account when calculating the bus parameters.

10.11.8.4 Communication via MPI

Configuring an HMI connection

Communication via MPI

HMI connections via MPI
If you have inserted an HMI device and a SIMATIC S7 300/400 into the project, you 
interconnect the two MPI interfaces in the "Devices & Networks" editor.    
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HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via PROFIBUS in the 
"Devices & Networks" editor. 

Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via MPI

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via MPI 
in the "Devices & Networks" editor.     

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● HMI device with MPI/DP interface

● SIMATIC S7 300/400 with MPI/DP interface
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Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed graphically in the network 
view.

2. Click the "Connections" button.
The devices available for connection are highlighted in color.

3. Click the interface of the PLC and use a drag-and-drop operation to draw a connection to 
the HMI device.

4. Click the connecting line.
The connection is displayed graphically in the Inspector window.
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5. Click "Highlight HMI connection" and select the HMI connection.

6. Click the communication partners in the "Network view" and change the MPI parameters 
in the Inspector window according to the requirements of your project.
See the chapter "MPI parameters (Page 6414)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. Use the table to monitor the connection parameters and change the 
connection partner. You can change the local name for the connection only in the table.

 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
MPI.

Configuring an HMI connection

Communication via MPI

Communication via MPI
This section describes the communication between a WinCC Runtime and the SIMATIC S7 
300/400 PLC via MPI.        

You can use the following WinCC Runtimes as an HMI device:

● WinCC RT Advanced

● WinCC RT Professional

WinCC Runtime as HMI device
You configure the HMI connections between a WinCC Runtime and SIMATIC S7 300/400 in 
the "Devices & Networks" editor.

If you want to use a WinCC Runtime as an HMI device, you have the following options:
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1. You create a SIMATIC PC and configure a WinCC Runtime on this SIMATIC PC.
In this way you use the SIMATIC PC with a WinCC Runtime as an HMI device.

2. You create a WinCC Runtime and configure a communication processor to the Runtime.
In this way you use your configuration PC with a WinCC Runtime as an HMI device.

You can also connect multiple HMI devices to one SIMATIC S7 300/400 and multiple SIMATIC 
S7 300/400s to one HMI device. The maximum number of communication partners that you 
can connect to an HMI device is dependent on the HMI device used. 

Additional information is available in the documentation for the respective HMI device. 

HMI connection in the "Devices & Networks" editor
You configure the HMI connection between the PLC and the HMI device via MPI in the "Devices 
& Networks" editor. 
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Connection in the "Connections" editor
Alternatively, you configure the connection between the PLC and HMI device via MPI in the 
"Connections" editor of the HMI device.

Configuring an HMI connection via MPI with a SIMATIC PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via MPI 
in the "Devices & Networks" editor.               

Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with MPI interface

● SIMATIC PC with MPI interface

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a WinCC Runtime from the hardware catalog to 
the PC.
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3. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.

4. Click the MPI interface of the PLC and use a drag-and-drop operation to draw a connection 
to the MPI interface of the PC.

5. Click the connecting line.

6. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

7. Click the communication partners in the "Network view" and change the MPI parameters 
in the Inspector window according to the requirements of your project.
See the chapter "MPI parameters (Page 6414)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
MPI.

Configuring an HMI connection via MPI with a PC

Introduction
You configure an HMI connection between HMI devices and a SIMATIC S7 300/400 via MPI 
in the "Devices & Networks" editor.                
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Requirements
The following communication partners are created in the "Devices & Networks" editor:

● SIMATIC S7 300/400 with MPI interface

● PC station with WinCC RT Advanced or WinCC RT Professional

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Use a drag-and-drop operation to move a PROFIBUS-capable communication processor 
from the hardware catalog to the  WinCC Runtime.

3. Click the PROFIBUS interface of the communication processor and change the interface 
to "MPI".

4. Click the "Connections" button and select "HMI connection" for the connection type.
The devices available for connection are highlighted in color.
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5. Click the MPI interface of the PLC and use a drag-and-drop operation to draw a connection 
to the MPI interface of the communication processor.

6. Click the connecting line.

7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Click the communication partners in the "Network view" and change the MPI parameters 
in the Inspector window according to the requirements of your project.
See the chapter "MPI parameters (Page 6414)" for additional details.

 

  Note

The created HMI connection is also shown in the tabular area of the editor on the 
"Connections" tab. You check the connection parameters in the table. 

You can change the local name for the connection only in the table.
 

Result
You have created an HMI connection between an HMI device and a SIMATIC S7 300/400 via 
MPI.

MPI parameters

MPI parameters for the HMI connection

MPI parameters for the HMI connection
An overview of the configured HMI connection parameters can be found in the properties for 
the HMI connection.           

Only limited changes are possible in this Inspector window.
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Displaying and changing the HMI connection parameters
1. Click the HMI connection in the "Devices & Networks" editor.

2. Change the parameters of the HMI connection in the Inspector window under "Properties 
> General > General".

"Connection"
Displays whether the devices are networked together. 

 - displayed if the devices are networked together.

 - displayed if the devices are not networked together.

"Connection path"
The communication partners of the selected HMI connection and the associated MPI 
parameters are displayed in the "Connection path" area. Some of the areas displayed cannot 
be edited in this dialog.

● "End point"
Displays the name of the device. This area is not editable.

● "Interface"
Displays the selected interface of the device. You can choose between several interfaces, 
depending on the device.
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● "Interface type"
Displays the selected interface type. This area is not editable.

● "Subnet"
Displays the selected subnet. This area is not editable.

● "Address"
Displays the MPI address of the device. This area is not editable.

● "Find connection path" button
Enables the subsequent specification of connections. 

MPI parameters for the HMI device

MPI parameters for the HMI device
An overview of the configured HMI device parameters can be found in the properties for the 
HMI device.      

Displaying and changing MPI parameters of the HMI device
1. Click the HMI device in the "Devices & Networks" editor.

2. Change the parameters of the HMI device in the Inspector window under  "Properties > 
General > General".

"Interface networked with"
In the "Interface networked with" area, select the subnet of the HMI connection via which the 
HMI device is connected to the network. You use the "Add new subnet" button to create a new 
subnet.
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"Parameters"
● "Interface type"

You assign the interface type in the "Interface type" area. Depending on the HMI device 
type, you have various interfaces to choose from.

● "Address"
You assign the MPI address of the HMI device in the "Address" area. The MPI address 
must be unique throughout the MPI network.

● "Highest address"
The "Highest address" area displays the highest address of the MPI network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

MPI parameters for the PLC

MPI parameters for the PLC
An overview of the configured parameters can be found in the properties for the PLC.      

Displaying and changing PROFIBUS parameters of the PLC
1. Click the PLC in the "Devices & Networks" editor.

2. Change the parameters of the PLC in the Inspector window under "Properties > General > 
General".
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"Interface networked with"
In the "Subnet" area, select the subnet of the HMI connection via which the HMI device is 
connected to the network. You use the "Add new subnet" button to create a new subnet.

"Parameters"
● "Interface type"

Depending on the HMI device type, you have various interfaces to choose from.

● "Address"
You assign the MPI address of the HMI device in the "Address" area. The MPI address 
must be unique throughout the MPI network.

● "Highest address"
The "Highest address" area displays the highest address of the MPI network.

● "Transmission speed"
The "Transmission speed" is determined by the slowest device connected to the network. 
The setting is identical throughout the network.

Addressing of the PLC via MPI

Introduction
     

Each communication partner must be assigned an MPI network address.

Each S7 module which supports communication functions and is operated the SIMATIC 
S7-300/400 PLC is assigned a unique MPI address. Only one CPU may be used per rack. 

 

 Note
HMI devices cannot be operated with incorrect addressing

Always avoid redundant addressing on the MPI bus.
 

MPI address of the communication partner of a SIMATIC S7-300
When assigning addresses, you have to distinguish between communication partners with and 
without separate MPI address.    

● If the communications partner has its own MPI address, you only need to define the MPI 
address.

● If the communication partners do not have a separate MPI address, specify the MPI address 
of the communications partner used for the connection. In addition, define the slot and rack 
of a communication partner without its own MPI address.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6416 System Manual, 02/2014



MPI address of the communication partner of a SIMATIC S7-400
Only S7 modules with an MPI connector are assigned an MPI address. Modules without an 
MPI connector are addressed indirectly:    

● MPI address of the module to which the HMI is connected.

● The slot and the rack of the module with which the HMI device communicates.

10.11.8.5 Communication via named connections

Named connections

Principle of Operation  
A Named Connection is an integrated, symbolic connection. 

WinCC can thus access redundant and non-redundant connection via a symbolic connection 
name. 

The symbolic connections are required, e.g., for communication with the SIMATIC S7-400 in 
connection with redundancy in H/F systems.

SDB
The connection information items are saved in system data blocks (SDB). The SDBs are then 
transferred to the Runtime station.

The connection name and the application name are saved in WinCC project. To reference 
connection information items.

A requirement for Named Connections is the station manager (S7RTM) on the Runtime station.

If no online connection to the Runtime station exists, use the XDB files. You generate the XDB 
files with WinCC. The XDB file contains connection information items 

The connection names, connection parameters and the application names are stored in a 
database (*.XDB). 

 

 Note

There should only be one XDB file per communication participant in the WinCC system. 
Hence, a XDB file should not be copied and used on multiple WinCC computers.

 

Configuring a connection via "Named connections"

Introduction   
For setting up a logical connection, one of the symbolic connection names listed in the 
"Connection name" field is assigned to a selected application name.

The symbolic connection names and application names are configured in STEP 7.
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NAMED CONNECTIONS can only be configured for integrated connections.

Requirements
A "Named connection" has been created in STEP 7.

The following communication partners are configured in the "Devices & Networks" editor:

● SIMATIC PC with WinCC RT Professional

● SIMATIC S7 300/400

Procedure
1. Double-click the "Devices & Networks" item in the project tree.

The available communication partners in the project are displayed in the network view.

2. Click the HMI device in the "Network view".

3. Select the entry "S7RTM is installed" in the Inspector window under "Parameters > XDB 
configuration".

If you have not installed S7RTM, select "Generate XDB file". Then select the path in which 
the XDB file will be stored.

4. Click the "Connections" button and select "HMI connection" for the connection type.

5. Click the PROFINET interface of the PLC and use a drag-and-drop operation to draw a 
connection to the PROFINET interface of the PC.

6. Click the connecting line.
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7. Click "Highlight HMI connection" and select the HMI connection.
The connection is displayed graphically in the Inspector window.

8. Select the "NAMED CONNECTION" interface in the Inspector window under "Properties > 
General > Connection path > Interface" of WinCC RT Professional.

 

  Note

The application and connection name can also be entered manually, for e.g. if an XDB 
file does not exist for the symbolic connection name or if the project is to be transferred 
to another computer. It is necessary to check the correct writing of the name in STEP 7 
because there is no name validation in the CS mode.

 

10.11.8.6 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Configuring area pointers (Page 6165) 

"Screen number" area pointer

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6419



Use
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1st word Current screen type
2nd word Current screen number
3rd word Reserved
4th word Current field number
5th word Reserved

 

● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" or "40" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.
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 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:

Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.
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"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:

DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Coordination" area pointer

Function    
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.
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Application
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.

 

Assignment of bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.

"Project ID" area pointer

Function    
When Runtime starts, a check can be carried out as to whether the HMI device is connected 
to the correct PLC. This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. If 
there is no concordance, a system event is given on the HMI device and Runtime is stopped.
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Use
 

 Note
HMI connections cannot be switched "online".

The HMI connection in which the "Project ID" area pointer is used must be switched "online".
 

To use this area pointer, set up the following during the configuration:

● Define the version of the configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections" under "Address".

Connection failure    
A connection failure to a device on which the "Project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "Project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the Engineering System.

 

"Job mailbox" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
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Word Most significant byte Least significant byte
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded) 3) 4)

 Parameter 1 Left byte:  -
Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
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No
.

Function  

14 Set time (BCD-coded)
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs to prevent overload 
of the HMI device.

 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 2)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only for devices supporting recipes.
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.
4) The weekday is ignored when you configure the "Date/Time PLC" area pointer.
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"Data record" area pointer

"Data record" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization via the data mailbox

Data records are always transferred directly, which means that the tag values are read straight 
from an address or written straight to an address configured for this tag without being redirected 
via an interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system alarm. 

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.
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Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then, for example, process, edit, 
or save these values in the HMI device. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data mailbox free
2 0000 0010 Transferring
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Sequence of a transfer started by the operator in the recipe view

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
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Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data record.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.

 

 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxs No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1
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No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

function from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.
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Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
record.

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Professional (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
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Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.
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The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:
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Working with Alarms  (Page 3910) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER

How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device
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Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6438 System Manual, 02/2014



10.11.8.7 Performance features of communication

Permitted data types for SIMATIC S7 300/400

Permitted data types for connections with SIMATIC S7 300/400
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Length
BOOL 1-bit
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes
CHAR 1 byte
INT 2 byte
DINT 4 bytes
REAL 4 bytes
TIME 4 bytes
DATE 2 bytes
TIME_OF_DAY, TOD 4 bytes
S5TIME 2 bytes
COUNTER 2 bytes
TIMER 2 bytes
DATE_AND_TIME 8 bytes
STRING (2+n) bytes, n = 0 to 254

Permitted data types for SIMATIC S7 300/400

Permitted data types for connections with SIMATIC S7 300/400
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Length
BOOL 1-bit
BYTE 1 byte
WORD 2 bytes
DWORD 4 bytes
CHAR 1 byte
INT 2 bytes
DINT 4 bytes
REAL 4 bytes
TIME 4 bytes
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Data type Length
DATE 2 bytes
TIME_OF_DAY, TOD 4 bytes
S5TIME 2 bytes
COUNTER 2 bytes
TIMER 2 bytes
STRING (2+n) bytes, n = 0 to 254

 

 

10.11.8.8 Creating a connection in the "Connections" editor

Creating a PROFINET connection

Requirements
● A project is open.

● An HMI device with a PROFINET interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".
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3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select a PROFINET interface of the HMI device in the Inspector window under "Parameters 
> Interface".

6. Set the IP addresses of the communication partners in the Inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating a PROFIBUS connection

Requirements
● A project is open.

● An HMI device with a PROFIBUS interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "MPI/DP" interface in the Inspector window under "Parameters > Interface".
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6. Select the "DP" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Creating an MPI connection

Requirements
● A project is open.

● An HMI device with an MPI interface has been created.     
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select the "MPI/DP" interface in the Inspector window under "Parameters > Interface".
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6. Select the "MPI" profile in the Inspector window under "Parameters > Network".

7. Set the addresses of the communication partners in the inspector window:

– HMI device: "Parameters > HMI device > Address"

– PLC: "Parameters > PLC > Address"

Parameters for the connection

Parameters for the connection (SIMATIC S7 300/400)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.    

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Expansion slot"
Defines the number of the expansion slot of the CPU to be addressed.
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● "Rack"
Defines the rack number of the CPU to be addressed.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance.
Disable cyclic mode if you are operating several HMI devices in parallel.

PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7 200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.
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Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200 
PLCs.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6450 System Manual, 02/2014



MPI parameters

Parameters for the HMI device 
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.         

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the MPI network. 

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
For "Address", you set the MPI address of the HMI device. The MPI address must be unique 
throughout the MPI network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). If you have connected only slaves to the HMI device, you must 
therefore disable the "Sole master on bus" safety feature.
In S7 200, you must set an HMI device as the master.

Parameters for the network
Under "Network", you set the parameters for the MPI network to which the HMI device is linked. 

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "MPI". 
The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual MPI address. The setting must be 
identical throughout the network.

● "Number of masters"
This setting is not required for MPI. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
For "Address", set the MPI address of the S7 module (CPU, FM, or CP) to which the HMI 
device is connected.

● "Cyclic mode"
When cyclic mode is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This improves system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200.

Cyclic operation

Handling the "Cyclic operation" selection
If "Cyclic operation" is enabled, the HMI device sends a message frame to the CPU at the 
beginning of communication indicating that certain tags are required on a recurring basis.

The CPU then always transmits the data at the same cyclic interval. This saves the HMI device 
from having to output new requests for the data.

If cyclic operation is disabled, the HMI device sends a request whenever information is required.

Additional properties:

● Cyclic operation reduces data transmission load at the HMI device. The PLC resources are 
used to relieve load on the HMI device.

● The PLC only supports a certain number of cyclic services. The HMI device handles the 
operation if the PLC cannot provide any further resources for cyclic services.

● The HMI device generates the cycle if the PLC does not support the cyclic mode.

● Screen tags are not integrated in cyclic operation.

● Cyclic mode is only set up at the restart of Runtime.

● The HMI device transfers several jobs to the PLC if cyclic mode is enabled, depending on 
the PLC.

● The HMI device only transfers one job to the PLC if cyclic mode is disabled.

 

10.11.8.9 Creating a connection in the "Connections" editor

Creating a connection

Requirements
● A project is open.

● WinCC RT Professional is created    
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Procedure
1. Open the "Connections" editor of the HMI device.

2. Double-click "<Add>".

3. Select the driver in the "Communication driver" column.

4. Click the name of the connection.

5. Select an interface of the HMI device in the Inspector window under "Parameters > 
Interface".

6. Set the parameters for the connection in the Inspector window.

Interfaces
Select one of the following interfaces in the Inspector window under "Parameters > 
WinCC RT Professional > Interfaces".

● Industrial Ethernet

● MPI

● PROFIBUS

● PLC slot

● Soft PLC

● TCP/IP
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For additional information on the parameters of the interfaces see:

Parameters for the connection (Page 6456)

Parameters for the connection

Ethernet

Introduction
You assign the parameters for the HMI device and the PLC in the network under "Parameters". 

The parameters described in the following apply to the following interfaces:

● Industrial Ethernet

● TCP/IP
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Channel Unit
● "Cycle management"

Select the following under "Cycle management":

– "By PLC"
Enabled: Cycle management is enabled by the PLC.
Disabled: Cycle management is not enabled by the PLC.

– "Transfer on change"
Enabled: A data transfer is carried out at data change.
Disabled: No data transfer is carried out at data change.

● "Select access point"
Enter the logical device name under "Access point".

● "Connection monitoring"
Connection monitoring is carried out when you select "Enable".
You can also specify an "interval" and a "Monitoring time" for connection monitoring.
Interval: Specified in milliseconds
Monitoring time: Specified in milliseconds

● "Monitoring of CPU stop"
If you select the "Enable" option under "Monitoring of CPU stop", the CPU state is monitored.

● "Job processing"
When you activate the "Write with priority" function, writing is transferred to the PLC with a 
higher priority than reading.

WinCC RT Prof connection
● "Ethernet address" or "TCP/IP address"

Enter the station address of the CPU under "Ethernet address".

● "Rack number"
Enter the rack number of the CPU to be addressed under "Rack number".

● "Slot number"
Enter the number of the slot of the CPU to be addressed of the already selected rack number 
under "Slot number".

● "Send/receive raw data block"
When you select the function "Send/receive raw data block", enable the sending of "raw 
data blocks" via BSEND/BRCV.

● "Connection"
This function can only be edited it you have selected "Send/receive raw data block".
You define the connection resource of the "raw data blocks" with the "Connection" function.

Serial communication

Introduction
You assign the parameters for the HMI device and the PLC in the network under "Parameters". 

The parameters described in the following apply to the following interfaces:

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6455



● PROFIBUS

● MPI

Channel Unit
● "Cycle management"

Select the following under "Cycle management":

– "By PLC"
Enabled: Cycle management is enabled by the PLC.
Disabled: Cycle management is not enabled by the PLC.

– "Transfer on change"
Enabled: A data transfer is carried out at data change.
Disabled: No data transfer is carried out at data change.

● "Select access point"
Enter the logical device name under "Access point".
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● "Connection monitoring"
Connection monitoring is carried out when you select "Enable".
You can also specify an "interval" and a "Monitoring time" for connection monitoring.
Interval: Specified in milliseconds
Monitoring time: Specified in milliseconds

● "Monitoring of CPU stop"
If you select the "Enable" option under "Monitoring of CPU stop", the CPU state is monitored.

● "Job processing"
When you activate the "Write with priority" function, writing is transferred to the PLC with a 
higher priority than reading.

WinCC RT Prof connection
● "Station address"

Enter the station address of the CPU under "Station address".

● "Segment ID"
Enter the segment ID of the CPU under "Segment ID".

● "Rack number"
Enter the rack number of the CPU to be addressed under "Rack number".

● "Slot number"
Enter the number of the slot of the CPU to be addressed of the already selected rack number 
under "Slot number".

● "Send/receive raw data block"
When you select the function "Send/receive raw data block", enable the sending of "raw 
data blocks" via BSEND/BRCV.

● "Connection"
This function can only be edited it you have selected "Send/receive raw data block".
You define the connection resource of the "raw data blocks" with the "Connection" function.
 

PLC

Introduction
You assign the parameters for the HMI device and the PLC in the network under "Parameters". 

The parameters described in the following apply to the following interfaces:
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● PLC slot

● Soft PLC

Channel Unit
● "Cycle management"

Select the following under "Cycle management":

– "By PLC"
Enabled: Cycle management is enabled by the PLC.
Disabled: Cycle management is not enabled by the PLC.

– "Transfer on change"
Enabled: A data transfer is carried out at data change.
Disabled: No data transfer is carried out at data change.

● "Select access point"
Enter the logical device name under "Access point".
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● "Connection monitoring"
Connection monitoring is carried out when you select "Enable".
You can also specify an "interval" and a "Monitoring time" for connection monitoring.
Interval: Specified in milliseconds
Monitoring time: Specified in milliseconds

● "Monitoring of CPU stop"
If you select the "Enable" option under "Monitoring of CPU stop", the CPU state is monitored.

● "Job processing"
When you activate the "Write with priority" function, writing is transferred to the PLC with a 
higher priority than reading.

WinCC RT Prof connection
● "Station address"

Enter the station address of the CPU under "Station address".

● "Slot number"
Enter the number of the slot of the CPU to be addressed of the already selected rack number 
under "Slot number".

● "Send/receive raw data block"
When you select the function "Send/receive raw data block", enable the sending of "raw 
data blocks" via BSEND/BRCV.

● "Connection"
This function can only be edited it you have selected "Send/receive raw data block".
You define the connection resource of the "raw data blocks" with the "Connection" function.

10.11.8.1
0

Troubleshooting of connection errors (commissioning)

Procedure for the localization of errors

S7 channel rectification in case of connection problems

Introduction
If you encounter problems during the commissioning of WinCC S7, the following description 
provides initial information. The description is for error localization and error correction and 
does not replace the WinCC description.    

Follow the following instructions to locate the error.

● Creating a new project

● Select the correct communication subsystem

● Select the correct channel unit

● Configure the correct AS network address
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● Check the system bus

● Check AS with STEP 7

● S7 log function

● Special settings of the S7 channel

● Error codes for connection fault

● API error texts

 

Error code
The most important error codes are listed in the section "Error codes for connection fault and 
errors in functions". If an error occurs with an error code that is not in the table, please call the 
WinCC hotline.

For error codes for a connection fault (SIMATIC S7-300/400) see under numbers 0112 to D406.

You will find errors which occur during editing of channel functions with the display "Error xx 
occurred in "function name" function!" under the numbers 1 to 100.

Creating a new project
If you communicate in your current project with several automation systems, create a new 
project with a single connection to a automation system. The errors can be easier localized 
here. 

Selection of the correct communication subsystem
The S7 channel communicates via the communication subsystem SAPI-S7 or S7DOS.   

SAPI-S7 
SAPI-S7 is a single product and is used for the communication to the S7 automation systems. 
SAPI-S7 products are adjusted to the corresponding CP. The correct SAPI-S7 product has to 
be installed to the available CP during communication via SAPI-S7. The S7 channel uses the 
tag services for reading and writing of tags from SAPI-S7. 

For more complex functions, e.g. PMC error message processing or the BSEND/BRCV 
function, activate the communication subsystem S7DOS.

S7DOS 
S7DOS is a part of STEP 7 and is also used for the communication to S7. In addition to the 
read and write jobs, the more complex PMC services are also activated during communication 
via S7DOS. For clients who have no STEP 7 installed on the WinCC target machine, S7DOS 
is also on the WinCC-DVD  delivered. For installation of S7DOS see WinCC setup description.

For the single communication subsystems, limitations for supported communication cards are 
possible. For information, refer to your current product information. 

The S7 channel uses the following method to recognize which communication subsystem will 
be used by  the S7 channel for communication: It first attempts to load the S7DOS 
communication subsystem. If S7DOS cannot be loaded, it attempts to load SAPI-S7. The error 
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message "Error during loading of S7 communication driver" will be displayed if SAPI-S7 cannot 
be loaded either.

Selection of the correct channel unit
The selection of the channel unit depends on the communication card in your PC. A specific 
type of communication card is assigned to each channel unit. 

Communication with the S7 takes place via so-called 'Logical devices'. The name of a logical 
device is assigned during installation of the communication card. In the case of some 
installations you can assign the name also via "Busprofile".

Depending on the installed communication card, the following defaults are standard:

● MPI card as well as the communication cards CP5411 and CP 5511: MPI

● "SIMATIC NET PROFIBUS" communication cards: e.g., CP5611, CP5613, CP5623

● "SIMATIC Industrial Ethernet" communication cards: CP_H1_1:

● Slot PLCs: SLOT_PLC

● TCP/IP communication cards: CP-TCPIP

The S7 communication driver differentiates accordingly the following units:

● MPI  for communication via the MPI card;i.e. logical device: MPI

● PROFIBUS communication via the SIMATIC NET PROFIBUS cards (CP5623), which 
means logical device: CP_L2_1:

● Industrial Ethernet for communication via SIMATIC Industrial Ethernet cards (e.g., CP1623 
or CP1628); which means logical device: CP_H1_1:

● Slot PLC for communication via a Slot PLC;i.e. logical device: SLOT_PLC

● TCP/IP for communication via the TCP/IP protocol; i.e. logical device: CP-TCPIP

During installation of the communication drivers the physical device is assigned via which the 
communication takes place.

You can change the default "logical device names" of the channel unit via the unit-specific 
setting of the system parameter. 

Configure the correct AS network address
For example, the TSAPs have a fixed setting for the S7 network address. This does not usually 
need to be configured. The set address as well as the rack and the slot number still have to 
be configured.  

Check the configured network address with the AS configured network address.

The rack number and the slot number have only to be specified, if the communication takes 
place on AS side via a communication processor and not via  the MPI interface installed on 
the CPU. In this case specify the rack and the slot number of the CPU that is to be addressed. 
If MPI interface installed in the CPU is used, enter  the value 0 for rack and slot number.
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Checking the bus system
Check the correct setup of the bus system. 

SIMATIC NET PROFIBUS
● Check the network for communication stations with the same station address.

● Check if  the highest station address (HSA) is correctly set for all communication stations.

● Check if an enabled device , e.g. an AS, is connected at the start and the end of the 
PROFIBUS.

● Check if the terminating resistors are correctly enabled or disabled. The terminating 
resistors may only be enabled at the first and the last bus terminal.

● If you have an MPI cable, connect the AS directly to your MPI card or your CP5623.

SIMATIC Industrial Ethernet
● Check the network for communication stations with the same Ethernet addresses.

Checking the AS with STEP 7
If you have installed STEP 7, check if you can access the automation system with STEP 7. If 
problems occur, follow the STEP 7 instructions for error correction.

S7 log function
The S7 channel has a logbook function. You can use this file to write the most important status 
changes and errors to an ASCII file on an external memory. These messages can be used to 
analyze a communication problem.

The individual messages are described below:

Start and end messages
● S7 channel DLL started

● S7 channel DLL terminated

Unit activated or deactivated
● S7 channel unit "unitname" activated

● S7 channel unit "unitname" deactivated

Version information
● S7DOS version: Version string

● S7CHN version: Version string
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Communication errors
● Cannot connect to "connectionname": Errorcode 0xhhhh ffff

The message is displayed if communication to the corresponding automation device cannot 
be established immediately after WinCC is activated. If the connection was established 
correctly at least once, the following message is displayed if errors occur:

● Connectionerror nnn " connectionname": Errorcode 0xhhhh ffff

 Description
nnn Number of connection terminations for this connection
Connectionname Connection name
hhhh 1. Error indicator in Hexa S7DOS / SAPI-S7
ffff 2. Error indicator in Hexa S7DOS / SAPI-S7

Channel API error
● Channel API error: Errorstring

The error string 'errorstring' is passed by the channel to the WinCC Explorer. Depending on 
the significance of the error, the error string may or may not be displayed in a notice box. For 
a description of the error strings, please see the API Error Text.

● Max. count of API errors reached - API logbook deactivated 

Errors on the API interface can cyclically occur depending on the error and function. To avoid 
filling the logbook file with these error messages, a maximum of 32 messages are output for 
an API error.

General channel error messages
● Cannot write storage data

● Cannot read storage data / use default data

● Storage data illegal or damaged / use default data

● No storage data / use default data

Initialization messages
● Devicename in unit "unitname" changed from "old devicename" to "new devicename" 

Error during exceeding the maximal file length
● Max. logbooksize reached - Logbook deactivated

In order to avoid filling of the data medium only with the logbook file, the logbook output has 
a length monitoring. As soon as the specified length is reached, the logbook is deactivated. 
The message is only output, when message output causes the max. file length to be exceeded. 
No message is output, if the file length is changed with an editor or the maximum file length is 
reduced in the INI file.

The output is not time critical, because the logbook functions are called only during activate/
deactivate and in the case of problems of the communication process.
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Example of a logbook protocol:
17.09.1996/15:16:18.33
0

S7 channel DLL started

17.09.1996/15:18:05.38
0

S7DOS version: @(#)TIS-Block Library DLL Version X3.060-DEB-BASIS

17.09.1996/15:18:05.49
0

S7CHN version: V2.0 / Sep 16 1996 / 18:42:48

17.09.1996/15:18:05.60
0

S7 channel unit "S7-MPI" activated

17.09.1996/15:36:48.49
0

Cannot connect to "MPI_CPU_3": Errorcode 0xFFDF 4107

17.09.1996/15:43:29.06
0

Connectionerror 1 "MPI_CPU_4": Errorcode 0xFFDF 410E

17.09.1996/16:43:44.83
0

Connectionerror 2 "MPI_CPU_4": Errorcode 0xFFDF 410E

17.09.1996/17:45:29.96
0

Connectionerror 3 "MPI_CPU_4": Errorcode 0xFFDF 410E

17.09.1996/18:54:02.63
0

Connectionerror 4 "MPI_CPU_4": Errorcode 0xFFDF 410E

17.09.1996/22:56:47.68
0

S7 channel unit "S7-MPI" deactivated

17.09.1996/22:56:56.74
0

S7 channel DLL terminated

The logbook texts are not language-dependent with the exception of "Channel API Errorstring" 
and are always displayed in English.

The S7 logbook is enabled by default. The logbook is stored in WinCC diagnose folder.

To settings and assigning parameters of the logbook function, see "Setup of an S7 logbook.

Special settings of the S7 channel

Special settings of the S7 channel
Edit with an ASCII-Editor, e. g. NOTEPAD.EXE, a file with name S7CHN.INI. Via the entries 
in the INI file you can modify the properties of the S7 channel. The S7CHN.INI file is expected 
in the directory which also contains the S7 communication driver "SIMATIC S7 300/400.CHN". 
If no file S7CHN.INI is found, the properties are not modified. The file is set to Windows INI 
file conventions. 

[section]

key=string

In the following the relevant parameters for modification of S7 channel are described. You just 
have to apply the lines in the INI file which create the setting you want. Comply with the 
specified examples:

● Change the default of the logical device name of the channel unit

● Change CP type of a channel unit

● Setup S7 logbook
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Additional specific settings:

● Modify channel characteristics via the S7chn.ini file

Change the default of the logical device name of a channel unit
[Unit:unitname]
CpName = name
Name 

Logical device name of the communication card (for example: CP_L2_1:).

Example: You want to set the channel unit "PROFIBUS" to a new logical device name 
"mein_cp".

 [Unit:PROFIBUS]
CpName = mein_cp

 

 Note

The modification via INI file is only for setup of the default. The setting of the logical device 
name takes place via the unit specific system parameter setting.

 

Change the CP type of a channel unit
[Unit:unitname] 

CpName = name
CpType = type
Name

Logical device name of the communication card (for example: CP_L2_1:). 

Type

Type of the communication card (for example: L2). The following settings are available:

● MPI

● L2

● H1

Example: You want to set the channel unit "PROFIBUS" to a new logical device name "cp_neu". 
You want to activate the connection configuration mask to configure the AS network address 
to enter a special AS address according to SCI convention.

CpName = cp_neu
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CpType = NNN
 

 Note

Only change the CP type if you want to activate the connection configuration mask to 
configure the AS network address to enter a special AS address according to SCI convention.

 

Setup of an S7 logbook
[Logbook]
FileName = C:\TMP\S7CHN.LOG
MaxKbFileSize = 32
MaxCycleBuffer= 2
Selection = FF.FF.FF.FF
FileName
Name of the diagnostics file incl. path specification. If no path is specified, the path of the called 
module is used. The name of the diagnostic file should be unique in the first 6 characters. In 
the circular buffer mode the file name is limited to maximum 6 characters and completed with 
the current cycle number 01 to 99. (Example: FileName = C:\TMP\S7CHN.LOG). The specified 
folder has to be available when the communication driver is started. The folder is not 
automatically created by S7 channel DLL.

MaxKbFileSize
Maximal length of the diagnostic file in k byte. If the maximal length is reached, the saving 
process is completed or switched to another file, depending on the "MaxCycleBuffer" setting. 
(Example: MaxKbFileSize = 32)

MaxCycleBuffer
Maximum number of circular buffer files. If the parameter is not specified or 
"MaxCycleBuffer=0" is specified, only one file is created. For input of a number 2..99 a new 
file is created if the maximum file length is reached. In the circular buffer mode the file name 
is limited to maximum 6 characters and completed with the current cycle number 01..99. If the 
maximum buffer number is reached, the saving process of the files continues with the file 01. 
(Example: MaxCycleBuffer = 2) ==> writing in files: S7CHN01.LOG -> S7CHN02.LOG -> 
S7CHN01.LOG ...

Selection
Number of the message to be saved. The selection is specified as 32 bit hexastring. Set for 
each desired kind of message the corresponding bit. (Example: Selection=FFFFFFFF). In 
order to simplify the input, an  ' ' or '.' character can be inserted byte by byte.  (Example: 
Selection = FF.FF.FF.FF)

The individual selection ID has the following values:
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Selection
 ID

Value

00.00.00.01 Start and end error message
00.00.00.02 Error message if unit activated/deactivated
00.00.00.04 Version information
00.00.00.08 Communication errors
00.00.00.10 Channel API error
00.00.00.20 General channel error messages
00.00.00.40 Initialization messages

The selection = FF.FF.FF.FF causes all logbook error messages to be output. The output is 
not time critical, because the logbook functions are called only during activate/deactivate and 
in the case of problems of the communication process.

s7chn.ini
The characteristics of the S7 channel can be modified via the S7CHN.INI file. The file is only 
for test or diagnostics and is not required for the normal operation.

Since the runtime characteristics of the S7 channel can be significantly changed using the INI 
file described below, the options for modifying this file should only be used for internal testing 
or error analysis!

The interpretation and modification of the parameters is only intended for "insiders". Therefore, 
we have not gone into more detail on the meaning and application of the parameters and 
constants.

 ; !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!   
 ; !!!!!    ATTENTION    !!!!!      ===========================
 ; !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!      
 ; The S7CHN.INI is not required for the runtime!  Only for 
 ; for testing and diagnostics. *) Default without S7CHN.INI
  
 ;[Debug]
 ;DebugMode     = 1      ; 0 = off *), 1 = DebugMessage, 2 = S7 Console
 ;DebugLevel    = 101    ; 100 = Info, 101 = Error *), 102 = CHN API, 103 = Trace, 104 = 

List
 ;DebugTime     = 1      ; 0 = off, 1 = on *)
  
 ;[SAPI]
 ;TraceTarget   = 1      ; 0 = BUFFER *), 1 = NEW_FILE
 ;TraceSelect   = 65535  ; 1 = ADMIN_SERVICES *), 65535 = SELECT_ALL
 ;TraceDepth    = 104    ; 0 = OFF *), 101 = INTERFACE, 103 = LIB0, 104 = LIB0_PDU
  
 ;[Timer]
 ;TimerMode     = 1      ; 0 = external, 1 = internal *)
 ;TimerCycle    = 1000   ; cycle time in milliseconds
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 ; !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!   
 ;CycleConnInit = 4000   ; Cycle time for autom. connection establishment
 ;FunTimeout    = 10000  ; Timeout time for function calls
 ;CloseTimeout  = 10000  ; Timeout time Close for unit deactivation
 ;MaxAsCycle    = 5000   ; Max. cycle for cycl. Reading jobs for AS
  
 ;[Channel]
 ;UnitStorage   = 1      ; Storage Read access: 0 = off, 1 = on
 ;LocalSlotId   = 0      ; Setting of the local slot number in the TSAP
 ;ThreadModel   = 1      ; Thread Model (0 ohne, 1 mit, 2 CHNCAP_REENTRANT)
 ;S7String      = 1      ; String processing (0 with, 1 without control word)
  
 ;[Driver]
 ;ComSystem     = 0      ; 0 = auto *), 1 = SAPI, 2 = S7DOS
 ;CnfAmqCalling = 0      ; max. rec.-jobs without acknowledgement (0 default)
 ;CnfAmqCalling = 0      ; max. send.-jobs without acknowledgement (0 default)
  
 ;[Unit:Industrial Ethernet]
 ;CpName        = CP_H1_1:
 ;CpType        = NNN
  
 ;[Diagnosis]
 ;ChkStopState  = 0      ; Stop check: 0 = off, 1 = on *)
 ;ChkLifeTime   = 60000  ; cycle time for lifebeat monitoring in milliseconds 0 = off
 ;LifeTimeAck   = 15000  ; lifebeat acknowledgement timeout in milliseconds
  
 ;[Logbook]
 ;FileName      = C:\TMP\S7CHN.LOG
 ;MaxKbFileSize = 20
 ;MaxCycleBuffer= 2
 ;Selection     = FF.FF.FF.FF
  
 ;[ChnTrace]
 ;FileName      = C:\TMP\S7CHN.TRC
 ;MaxKbFileSize = 50     ; max. length of the diagnostic file in k byte
 ;MaxCycleBuffer= 10     ; max. number circular buffer files
 ;DebugMode     = 0      ; 0 = Output in file, 1 = Output via 'OutputDebugString()’
 ;TimeStampMode = 2      ; 0 = no time stamp, 1 oder 2 = with time stamp
 ;Selection     = 00.00.30.27
                ; 00 00 00 01        // General alarms
                ; 00 00 00 02        // Connection status
                ; 00 00 00 04        // S7 Function calls # Tags services
                ; 00 00 00 08        // S7 Function calls # Tags services  
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 ; !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!   
                ; 00 00 00 10        // S7 Function call data
                ; 00 00 00 20        // Message event # Tags services
                ; 00 00 00 40        // Message event Tags services
                ; 00 00 00 80        // Message event data
  
                ; 00 00 01 00        // Message on start processing
  
                ; 00 00 10 00        // S7 raw data function
                ; 00 00 20 00        // S7 raw data 
  
                ; 00 01 00 00        // S7 Channel API # Tags services
                ; 00 02 00 00        // S7 Channel API Tags services
 ;MaxDump       = 512    ; Max. number bytes on data trace (Hex-Dump) of the channel 

diagnosis

Error codes

Error codes for connection faults (SIMATIC S7-300/400)
The most important error codes are listed in this section. If an error occurs with an error code 
that is not in the table, please call the WinCC hotline.

● Error 0112

● Error 4022

● Error 4102

● Error 4107

● Error 410E

● Error 4110

● Error 4116

● Error 411A

● Error 411C

● Error 4230

● Error 4231

● Error 4232

● Error 42B0

● Error 42B1

● Error 42B2

● Error 42B3

● Error 42B5
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● Error 42B7

● Error 42B8

● Error 42C0

● Error 42C2

● Error 42D2

● Error 7000

● Error 7001

● Error 7002

● Error 7003

● Error 7004

● Error 7005

● Error 7006

● Error 7007

● Error 7008

● Error 7101

● Error 7102

● Error 7900

● Error 8204

● Error 8305

● Error 8404

● Error 8405

● Error 8500

● Error D405

● Error D406
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Error 4230 - L4_SCI_E_UNPLUGGED
No further active partner available.

● PC not switched to the bus or power plug not correctly plugged.

Error 0112 - INVALID_PARAM
An incorrect parameter was transferred to the communication subsystem S7DOS.

● Message processing or CPU Stop Monitoring enabled and an outdated S7DOS version 
used.

Error 4022 - S7DOS_SRV_TIMEOUT
No feedback from AS:

● AS did not respond to job within the timeout period.

● Station address available several times on the bus.

Error 4102 - L4_INVALID_REQ
Request block not permitted.

● An invalid request block was returned by the communication driver. 

● A not yet processed request block was returned after a CLOSE_REQ.

Error 4107 - L4_OK_CLOSED_RESP
Connection was terminated.

● Rack/Slot not right configured. 

● Number of maximum permitted connections in AS exceeded.

Error 410E - L4_REM_ABORT
Connection was aborted.

● AS or CP disabled or reset.

● AS not connected to bus or error in bus system.

● Number of maximum permitted connections in AS exceeded.

Error 4110 - L4_LOC_TIMEOUT
No connection established. AS denies connection setup.

● Wrong internet address configured.

● AS disabled.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6471



● AS not connected to bus or error in bus system.

● Number of maximum permitted connections in AS exceeded.

Error 4116 - L4_CONN_REJECT
No connection established. AS denies connection setup.

● Rack/Slot not right configured. For external CP module, the slot of the CPU module has to 
be indicated.

● Number of maximum permitted connections in AS exceeded.

Error 411A - L4_ILLEGAL_ADDRESS
Invalid address.

● An invalid network address was specified during connection configuration.

Error 411C - L4_NETWORK_ERROR
Network error.

● A fatal error was encountered in the network.

● The network address or the segment ID was configured  incorrectly.

● Communication module defective.

Error 4231 - L4_SCI Error 4231 - L4_SCI
BUS disrupted.

Error 42B0 - L4_DLL_E_NO_HW
No communication hardware found.

● Communication module defective.

● Communication module not installed correctly.

● Wrong port address defined.

Error 42B1 - L4_DLL_E_HW_DEFECT
Communication module defective.

● Communication module not installed correctly.

● Wrong port address defined.
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Error 42B2 - L4_DLL_E_CNF
● Driver configured incorrectly or invalid parameter in the registry.

Error 42B3 - L4_DLL_E_BAUDRATE
Incorrect baudrate or incorrect interrupt vector defined.

Error 42B5 - L4_DLL_E_TS
The defined local participant number (TS_ADR) is already assigned.

Error 42B7 - L4_DLL_E_INT_NOT_PROV
The defined interrupt vector (IRQ) is not available on the communication module.

Error 42B8 - L4_DLL_E_INT_BUSY
The defined interrupt vector (IRQ) is already allocated on the communication module.

Error 42C0 - L4_DLL_E_NO_FILE
The selected communication driver cannot be installed. File not found.

● Communication driver not installed correctly.

Error 4232 - L4_DLL_E_HSA
Incorrect maximum number of set stations.

1. S7DOS error indicator
This value indicates the error detecting module. The value is not relevant for the initial error 
analysis.

1. SAPI-S7 error indicator
This value indicates the "S7_MINI_DB_RESPONSE_CODE". The value is not relevant for the 
initial error analysis.

2. SAPI-S7 error indicator
This value indicates the "s7_last_detailed_err_no". The table 
"s7_last_detailed_err_nos7_last_detailed_err_no" includes a list of SAPI-S7 error codes 
without additional details.

In case of problems with SAPI-S7, read the SAPI-S7 documentation or contact the SINEC or 
WinCC hotline.
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s7_last_detailed_err_no

Table 10-158

Error Decimal Hexa
S7_ERR_NO_ERROR 0 00
S7_ERR_UNKNOWN_ERROR 1 01
S7_ERR_WRONG_CP_DESCR 2 02
S7_ERR_NO_RESOURCE 3 03
S7_ERR_INVALID_PARAMETER 7 07
S7_ERR_TOO_LONG_DATA 8 08
S7_ERR_TOO_MANY_DLL_USERS 9 09
S7_ERR_WRONG_IND_CNF 10 0A
S7_ERR_SERVICE_NOT_SUPPORTED 11 0B
S7_ERR_INVALID_CREF 20 14
S7_ERR_CONN_NAME_NOT_FOUND 23 17
S7_ERR_INVALID_ORDERID 30 1E
S7_ERR_ORDERID_USED 31 1F
S7_ERR_OBJ_UNDEFINED 50 32
S7_ERR_OBJ_ATTR_INCONSISTENT 51 33
S7_ERR_OBJ_ACCESS_DENIED 53 35
S7_ERR_INVALID_DATA_SIZE 80 50
S7_ERR_RECEIVE_BUFFER_FULL 81 51
S7_ERR_FW_ERROR 90 5A
S7_ERR_MINI_DB_TYPE 100 64
S7_ERR_MINI_DB_VALUE 101 65
S7_ERR_SERVICE_VFD_ALREADY_USED 112 70
S7_ERR_SERVICE_CONN_ALREADY_USED 113 71
S7_ERR_CONN_ABORTED 120 78
S7_ERR_INVALID_CONN_STATE 121 79
S7_ERR_MAX_REQ 122 7A
S7_ERR_CONN_CNF 123 7B
S7_ERR_INVALID_CYCL_READ_STATE 130 82
S7_ERR_INSTALL 140 8C
S7_ERR_INTERNAL_ERROR 141 8D
S7_ERR_NO_SIN_SERV 142 8E
S7_ERR_NO_LICENCE 143 8F
S7_ERR_SYMB_ADDRESS 150 96
S7_ERR_SYMB_ADDRESS_INCONSISTENT 151 97

No help found for this error.
The help function contains only the most important error codes. Please contact the WinCC 
hotline.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6474 System Manual, 02/2014



Error 42C2 - L4_DLL_E_LOGDEV
The logical device is not defined in the registry.

● Communication driver not installed correctly.

● Entry damaged or deleted in the registry.

● Check the setting of the logical device name with the "Set PG/PC interface" program.

● Check the setting for the logical device name in the "System parameter - Device" mask.

Error 42D2 - L4_DLL_E_NO_SMC
The connection to the adapter is disturbed.
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Error 7000 - CEC_UDEACT
● Unit will be deactivated.

Error 7001 - CEC_STPCHK
Connection closed due to Stop check.

● The connection was terminated by the channel because a "STOP", "HOLD" or 
"DEFECTIVE" VMD status was detected for the CPU.

Error 7002 - CEC_LACKTO
Lifebeat acknowledgement error.

● The connection was terminated because the acknowledgment of the lifebeat frame was 
not received within the expected period.

Error 7003 - CEC_RAWFKT
Connection closed via raw data function

● The connection function was activated via a raw data function. 

Error 7004 - CEC_OIDERR
Order id invalid

● The order ID that has to be processed is invalid.

Error 7005 - CEC_DTLERR
Data length incorrect.

● In the received PDU the data length is greater than the expected data length or 0. This 
message is displayed, e.g., when an uneven number byts is read from a AS314 prototype 
CPU (314-1AE00-0AB0)

Error 7006 - CEC_CONERR
Connection closed or deactivated.

● Connection was terminated. That is why the job was rejected.

Error 7007 - CEC_VMDERR
It is not permitted to determine VMD status via lifebeat frame.
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● The connection was terminated by the channel because a "STOP", "HOLD" or 
"DEFECTIVE" VMD status was detected for the CPU.

Error 7008 - CEC_CONPRJ
Connection data incorrect or corrupted.

● No connection parameters have been configured.

● The configured connection parameters are not permitted.

Error 7101 - CEC_NORAM1
No memory available.

● No free memory could be allocated during creation of order list.

Error 7102 - CEC_NORAM2
No memory available.

● No free memory could be allocated during creation of tag feedback data area.

Error 7900 - CEC_S7DOSE
Necessary S7DOS version not loaded.

● A function was configured (for example, PMC message processing) that requires a specific 
version of the communication subsystem S7DOS.

The connection is ready to use.
 

The connection is currently being initialized
Communication is only possible after the completion of the initialization.

● If the state is pending for several seconds, an overloading of the communication on the AS 
side might be the reason for this.

● Check the PM configuration in your AS.

The connection to the AS is established
The CPU is in STOP mode.

● To communicate with the CPU via WinCC, switch the CPU to RUN mode.

● You have the possibility to also monitor the PLC in STOP mode. System Diagnostics and 
Alarming can continue to be run in this way.
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Error 8204 - L7_DEF_OBJ_INCONSISTENT
The object's type format is inconsistent.

Error 8305 - L7_FUNC_NOT_AVAIL
Functionality not available.

● AS-CPU type does not support the configured function.

● AS CPU does not contain the most recent firmware status.

Error 8404 - L7_FATAL_ERR
AS protocol error.

Error 8405 - L7_CPU_IN_PROTECTED_STATE
The remote block is in status DISABLE (PBK). The function cannot be executed. 

Error 8500 - L7_PDU_SIZE_ERR
Wrong PDU size.

Error D405 - L7_DGS_FKT_PAR_SYNTAX_ERR
Service is not supported or syntax error for function parameters.

● AS-CPU type does not support the configured function.

● AS CPU does not contain the most recent  firmware status.

Error D406 - L7_NO_INFO
Desired information not available.

● The requested data are not available.

● In the case of AS300 the message also occur, if two station at the same time access the 
desired data.

S7 connection status
Internal function correctly completed.

In this Property Page, the current connection status of the corresponding unit is displayed. 
You can use the displayed error code to quickly localize a communication error.

Select the corresponding connection and press the <F1> key, or double-click the error code.
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Column Description
Name Connection name
Status Connection status:

 Ready
The connection is ready to use.

 Faulty
The connection is faulty. In the Error column is an error code 
indicated.

 CPU Stop
The AS is in STOP mode.

 init
The connection is currently being initialized or deinitialized.

Fault Error code in hexadecimal. 
Note:
In each case the error code that occurred first is displayed.

PDU length The PDU length is displayed here in bytes after the 
commection has been established.

Number of errors Number of connection problems that occurred.
Note:
A connection problem is only counted if an available 
connection is disturbed , i.e. switches from 'available' to 
'disturbed' or 'CPU Stop'. 

Asyn. Events Number of asynchronous S7DOS events.

 
 

 Note

The table can contain additional columns that are not described here. These data are intended 
for additional error diagnostics and not relevant for the user.

 

Internal error codes and constants

Internal error codes and constants
The following tables contain the most important error codes and constants. The information is 
intended for "insiders". Therefore, we have not gone into more detail on the meanings of the 
codes and constants.

● iNA960 messages

● SCI messages

● S7DOS Function types

● S7DOS Error codes

● S7DOS Trace function
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iNA960 messages

Table 10-159

General iNA960 messages:
OK_RESP 1 0x01 Request executed with no errors
OK_EOM_RESP 3 0x03 Data block received with no errors
OK_DECIDE_REQ_RESP 5 0x05 Request executed with no errors
OK_CLOSED_RESP 7 0x07 Connection terminated by local user

iNA960 Error messages:
INVALID_REQ 2 0x02 Incorrect request block
NO_RESOURCES 4 0x04 No resources free in CP
UNKNOWN_REFERENCE 6 0x06 Incorrect OPEN reference defined
BUFFER_TOO_SHORT 8 0x08 User buffer too short
BUFFER_TOO_LONG 10 0x0A User buffer too long
ILLEGAL_REQ 12 0x0C Incorrect "negot_options" defined
REM_ABORT 14 0x0E Connection terminated by remote 

station
LOC_TIMEOUT 16 0x10 Timeout
UNKNOWN_CONN_CLASS 18 0x12 Unknown connection class
DUP_REQ 20 0x14 Connection already established
CONN_REJECT 22 0x16 Connection request rejected by remote
NEGOT_FAILED 24 0x18 Connection termination incorrect 

negot option
ILLEGAL_ADDRESS 26 0x1A Incorrect transport address
NETWORK_ERROR 28 0x1C Bus or CP faulted
PROTOCOL_ERR 30 0x1E Protocol error
ILLEGAL_RB_LENGTH 32 0x20 Incorrect request block length

SCI messages
See description in the "SINEC Communication Interface SCI" manual (A/5-15).

SCI messages
SCP_OK 0 0x00 No error
SCP_INCONS 201 0xC9 Minor device number is not 00
SCP_RESOURCE 202 0xCA DPRAM memory request invalid
SCP_CONFIG 203 0xCB Configuration error (NUM_PROCS)
SCP_NOCONFIG 204 0xCC SCP driver not configured
SCP_PARAM 206 0xCE Incorrect mode
SCP_DEVOPEN 207 0xCF Open already performed
SCP_BOARD 208 0xD0 Board not inserted/recognized
SCP_SOFTWARE 209 0xD1 IRQ error or software not found
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SCI messages
SCP_MEM 210 0xD2 Low memory in DPRAM
SCP_MODE 211 0xD3 Download process not yet completed
SCP_LOADER 212 0xD4 No response from loader
SCP_SIGNAL 213 0xD5 Process started asynchronously
SCP_NOMESS 215 0xD7 No message arrived for the process
SCP_USERMEM 216 0xD8 Buffer length length_of_buffer too small
SCP_WINDOW 217 0xD9 Too many SEND calls
SCP_TIMEOUT 219 0xDB Timeout on SCP
SCP_ATTACH 220 0xDC Reset not executed/channel still active
SCP_ILLEGAL_REQUEST 221 0xDD Incorrect request
SCP_ERECOVERF 223 0xDF Buffer not retrieved with scp_receive
SCP_ECLOSED 224 0xE0 All buffers assigned for the connection
EUSERMAX 225 0xE1  
SCP_EINTR 226 0xE2  
SCP_BOARD_OPEN 231 0xE7  
SCP_NO_WIN_SERV 233 0xE9  
EPROTECT 234 0xEA License not found 

SCI messages
SCP_DB_FILE_DOES_NOT_EXIST 240 0xF0
SCP_DB_FILE_CLOSE_NOT_OK 241 0xF1
SCP_SEND_NOT_SUCCESSFUL 242 0xF2
SCP_RECEIVE_NOT_SUCCESSFUL 243 0xF3
SCP_NO_DEVICE_AVAILABLE 244 0xF4
SCP_ILLEGAL_SUBSYSTEM 245 0xF5
SCP_ILLEGAL_OPCODE 246 0xF6
SCP_BUFFER_TOO_SHORT 247 0xF7
SCP_BUFFER_1_TOO_SHORT 248 0xF8
SCP_ILLEGAL_PROTOCOL_SEQUENCE 249 0xF9
SCP_ILLEGAL_PDU_ARRIVED 250 0xFA
SCP_REQUEST_ERROR 251 0xFB
SCP_NO_LICENSE 252 0xFC

Additional online DLL messages on the SCP interface
E_TIMER_INIT 768 0x0300 WIN Settimer call unsuccessful
E_INIT_COM 769 0x0301  
E_NO_HW 784 0x0310 MPI module not found
E_HW_DEFECT 785 0x0311 Problem with the hardware
E_CNF 786 0x0312 Incorrect configuration parameter
E_BAUDRATE 787 0x0313 Incorrect baudrate/incorrect IntVector
E_HSA 788 0x0314 Incorrect HSA configured
E_TS 789 0x0315 Configured address already assigned
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Additional online DLL messages on the SCP interface
E_OCC 790 0x0316 HW_Device already assigned
E_INT_NOT_PROV 791 0x0317 Interrupt not available
E_INT_BUSY 792 0x0318 Interrupt allocated
E_SAP 793 0x0319 SAP deactivate: SAP not allocated
E_UNPLUGGED 794 0x031a No remote station found
E_SYNI 795 0x031b Syni error occurred
E_AMPRO 796 0x031c AMPRO 2 reported a system error
E_BUFFSIZE 797 0x031d No buffer of this size created
E_NO_FILE 800 0x0320 DLL/VxD File not found or entries in registry damaged
E_NO_ENTRY 801 0x0321 Address does not exist in DLL
E_VERSION 816 0x0330 Version conflict between SMC driver and SMC firmware
E_COMCNF 817 0x0331 Problem with the COM port configuration
E_NO_SMC 818 0x0332 SMC no longer responds
E_COMMBADID 819 0x0333 COM port is not configured
E_COMMOPEN 820 0x0334 COM port is not available
E_SMCBUSY 821 0x0335 Serial driver is currently in use with another configuration
E_SMCMODEM 822 0x0336 No connection currently exists to a PC/MPI cable
E_SMCNOLEG 823 0x0337 PC/MPI cable refuses job, required authorization is 

missing
E_ONLINE 896 0x0380 Internal error at the IOCTL interface
E_LOGDEV 897 0x0381 Logical device not in registry
E_L2DRIVER 898 0x0382 L2DRIVER entry is missing in the registry
E_L4DRIVER 900 0x0384 L4DRIVER entry is missing in the registry
E_SYSERROR 1023 0x03FF System error

S7DOS Function types

Table 10-160

S7DOS Function types 
S7O_S7_EVENT  1
S7O_S7AG_BESY_UPDATE  2
S7O_S7AG_BUB_CYCL_READ_CREATE  3
S7O_S7AG_BUB_CYCL_READ_START  4
S7O_S7AG_BUB_CYCL_READ_STOP  5
S7O_S7AG_BUB_CYCL_READ_DELETE  6
S7O_S7AG_BUB_READ_VAR  7
S7O_S7AG_BUB_WRITE_VAR  8
S7O_S7AG_COMPRESS  9
S7O_S7AG_LINK_IN  10
S7O_S7AG_MEM_MODE  11
S7O_S7AG_MSG_MODE  12
S7O_S7AG_PASSWORD  13
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S7DOS Function types 
S7O_S7AG_READ_SZL  14
S7O_S7AG_READ_TIME  15
S7O_S7AG_RESUME  16
S7O_S7AG_START  17
S7O_S7AG_STOP  18
S7O_S7AG_TEST  19
S7O_S7AG_TEST_DELETE  20
S7O_S7AG_WRITE_TIME  21
S7O_S7BLK_DELETE  22
S7O_S7BLK_FINDFIRST  23
S7O_S7BLK_FINDNEXT  24
S7O_S7BLK_READ  25
S7O_S7BLK_WRITE  26
S7O_S7DB_CREATE  27
S7O_S7DB_OPEN  28
S7O_S7DB_COPY  29
S7O_S7DB_CLOSE  30
S7O_S7DB_DELETE  31
S7O_S7DOS_RELEASE  32
S7O_S7NET_GET_LIFE_LIST  33
S7O_S7NET_GET_DIRECT_PLC  34
S7O_S7DP_SET_SLAVE_ADDRESS  35
S7O_S7DP_SLAVE_DIAGNOSE  36
S7O_S7AG_PMC_MSG_MODE  37
S7O_S7AG_PMC_ON_OFF  38
S7O_S7AG_BRCV  39
S7O_S7AG_BSND  40
S7O_S7AG_PMC_ACK  41
S7O_S7AG_PMC_MLDG  42
S7O_S7AG_BUB_CYCL_READ_CREATE_CNF  43
S7O_S7AG_MSG_MODE_CNF  44
S7O_S7AG_PMC_UPDATE  45
S7O_S7L7_DOWNLOAD_DOMAIN  128
S7O_S7L7_UPLOAD_DOMAIN  129

S7DOS Error codes

Table 10-161

Define Dec Hex Error Message (Stand 7.1.99)
INVALID_BLOCK_TYPE_NUM 272 0110 Invalid block type or invalid block number.
INVALID_PARAM 274 0112 Invalid parameter.
INVALID_BLOCK_TYPE 275 0113 Invalid block type.
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Define Dec Hex Error Message (Stand 7.1.99)
BLOCK_NOT_FOUND 276 0114 Block not found.
BLOCK_ALREADY_EXIST 277 0115 The block is already available.
BLOCK_IS_PROTECTED 278 0116 The block is read-only.
BLOCK_TOO_LARGE 279 0117 The block is too large.
INVALID_BLOCK_NUM 280 0118 Invalid block number.
INCORRECT_PASSWORD 281 0119 You have entered an incorrect password.
PG_RESOURCE_ERROR 282 011A PG-Resources error.
PLC_RESOURCE_ERROR 283 011B AS resource error.
PROTOCOL_ERROR 284 011C Protocol error.
TOO_MANY_CPU_BLKS 285 011D Too many blocks ( module specific limitation).
DATABASE_DISCONNECTED 286 011E No connection to the database or S7DOS 

handle is invalid.
USER_BUFFER_TOO_SHORT 287 011F The application buffer is too small.
END_OF_BLOCK_LIST 288 0120 End of block list.
CALLOC_ERROR 320 0140 Insufficient memory available.
REQ_INI_ERR 321 0141 The job cannot be processed because of 

missing resources.
SIMULATION_ERR 368 0170 The simulator could not be found.    
DRIVER_NOT_INST 384 0180 The driver is not installed: Incompatible 

parameter or invalid driver handle.
DRIVER_ALREADY_OPEN 385 0181 The driver is already open or too many 

channels are open.
VERSION_MISMATCH 448 01C0 The versions are incompatible.
TABLE_STRUCT_MISMATCH 449 01C1 The field setup to the opened database does 

not correspond to the expected setup.
NO_VALID_SELECTION 450 01C2 s7blk_findnext() was called before 

s7blk_findfirst().
HEADER_MEMO_INCONSISTENC
Y

451 01C3 The length format in the block header does not 
correspond to the actual length of the section 
in the data storage system.

ID_FILE_ERROR 452 01C4 A problem occurred during processing of Last-
ID file.

WRONG_BLOCK_FORMAT 453 01C5 Incorrect block format.
FILE_NOT_FOUND 454 01C6 File not found.
INVALID_BESY_KOMP 455 01C7 Invalid Besy Update Component.
DBCPY_TARGET_EXISTS 456 01C8 The database specified as target is already 

available.
WR_TABLE_ALREADY_LOCKED 457 01C9 The database is already locked by another 

application.
SKIP_UNEXPECTED_ERROR 458 01C

A
An unexpected error occurred during 
positioning in the database. 

DHCLOSE_ERROR 459 01C
B

An invalid DATA4 pointer was transferred to 
the dhclose() call.

LIB_NOT_FOUND 460 01C
C

The TBI-DLL could not be loaded.
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Define Dec Hex Error Message (Stand 7.1.99)
FKT_NOT_FOUND 461 01C

D
A function in the dynamic downloaded DLL 
could not be found.

STPCPY_NOT_FOUND 462 01C
E

The StopCopy-DLL could not be loaded.

FILE_ACCESS_ERROR 463 01C
F

Access protection violation.

PASSWORD_NOT_FOUND 464 01D0 The password was not found.
DIAGNOSE_NOT_STARTED 480 01E0 The diagnosis is disabled.
DIAGNOSE_DATA_NOT_AVAILABL
E

481 01E1 No diagnostic data are available.

DIAGNOSE_DATA_INCONSISTENT 482 01E2 The diagnostic data are inconsistent.
NOT_IMPLEMENTED 496 01F0 Function is not implemented.
INTERN_ERR 511 01FF System error.
L7_UNKNOWN_ROSCTR 2049 0801 Internal error code, is being mapped 
L7_UNKNOWN_CN_ID 2050 0802 Internal error code, is being mapped
L7_UNKNOWN_DIENSTKENN 2051 0803 Internal error code, is being mapped
L7_TOO_MUCH_BLOCKS 2052 0804 Internal error code, is being mapped
L7_WRONG_FLAGS 2053 0805 S7 protocol: Invalid flags.
L7_INTERNAL_ERR 2054 0806 Internal error code, is being mapped
L7_UNKNOWN_ID1_ERR 2055 0807 Internal error code, is being mapped
L7_SEND_ERR 2064 0810 S7 protocol: Data could not be correctly sent.
L7_RECEIVE_ERR 2065 0811 S7 protocol: No job for the received data could 

be found.
L7_DIAG_ERR_UPDATE 3456 0D80 A diagnostic error has occurred.
EPR_VCC_ERROR 8208 2010 Internal error code, is being mapped
EPR_VPP_ERROR 8209 2011 Internal error code, is being mapped
EPR_NO_ADAPT 8210 2012 EPROM: The memory card adapter is missing.
EPR_REM_EXT_ADAPT 8211 2013 EPROM: The external memory card adapter 

has to be removed.
EPR_NO_MEM_CARD 8212 2014 EPROM: The memory card is missing.
EPR_CHECK_SUM_ERR 8213 2015 Internal error code, is being mapped
EPR_LEN_ERR 8214 2016 Internal error code, is being mapped
EPR_MOD_ADR_ERR 8215 2017 Internal error code, is being mapped
EPR_READ_ONLY 8216 2018 Internal error code, is being mapped
EPR_NOT_IMPLEMENT 8217 2019 Internal error code, is being mapped
EPR_AREA_NOT_PRES 8218 201A Internal error code, is being mapped
EPR_ALGO_UNKNOWN 8219 201B EPROM: Unknown configuration algorithm.
EPR_MOD_CHANGE 8220 201C EPROM: The memory card was changed 

without authorization.
EPR_NO_OPEN 8221 201D Internal error code, is being mapped
EPR_ILEG_BREAK 8222 201E Internal error code, is being mapped
EPR_NO_FLASH 8223 201F Internal error code, is being mapped
EPR_LEN_SEC_ERR 8224 2020 Internal error code, is being mapped
EPR_ADR_SEC_ERR 8225 2021 Internal error code, is being mapped
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Define Dec Hex Error Message (Stand 7.1.99)
EPR_ADR_ERR 8226 2022 Internal error code, is being mapped
EPR_DB_SHRT_ERR 8227 2023 Internal error code, is being mapped
EPR_MODE_ERR 8228 2024 Internal error code, is being mapped
EPR_PROG_ERR 8229 2025 EPROM: Hardware error in the memory card.
EPR_PROG0_ERR 8230 2026 Internal error code, is being mapped
EPR_ERA_ERR 8231 2027 Internal error code, is being mapped
EPR_RD_KENN_ERR 8232 2028 Internal error code, is being mapped
EPR_CMP_ERR 8233 2029 Internal error code, is being mapped
EPR_EMP_ERR 8234 202A EPROM: The memory card is not empty.
EPR_EE_WR_ERR 8235 202B Internal error, is being mapped
EPR_EE_TIMOUT_ERR 8236 202C Internal error, is being mapped
EPR_SYS_ERR 8237 202D EPROM: Internal error.
EPR_WR_PROT 8238 202E EPROM: Read-only memory card.
EPR_NO_EXPOWER 8239 202F EPROM: The external power supply is 

missing.
EPR_MINUS_12V_ERR 8240 2030 Internal error, is being mapped
EPR_REF_SP_ERR 8241 2031 Internal error, is being mapped
EPR_DEV_NOT_SUPPORTED 8242 2032 EPROM: The EPROM driver cannot support 

the set configuration interface on this 
computer.

EPR_PROM_ENTR_ERR 8256 2040 EPROM: External prommer is missing.
EPR_NO_BIOS_CENTADR 8257 2041 Internal error, is being mapped
EPR_QOUT_FACT_ERR 8258 2042 EPROM: Hardware error on the external 

prommer.
EPR_QUEUE_BUSY 8259 2043 Internal error, is being mapped
EPR_TIMER_ERR 8272 2050 Internal error, is being mapped
EPR_WRONG_WIN_MODE 8288 2060 Internal error, is being mapped
EPR_NO_GLOBAL_MEM 8289 2061 Internal error, is being mapped
EPR_PROGAS_ERR 8324 2084 EPROM: Configuration interface error.
EPR_FATAL_ERR 8328 2088 Internal error, is being mapped
EPR_ERR_KEYNOTFOUND 8452 2104 Internal error, is being mapped
EPR_ERR_RECBUFLEN 8470 2116 Internal error code, is being mapped
EPR_ERR_BLK_LEN 8488 2128 Internal error, is being mapped
EPR_ERR_FILEFULL 8534 2156 Internal error, is being mapped
EPR_DRV_NOT_INST 8560 2170 Internal error, is being mapped
EPR_DRV_ALREADY_OPEN 8561 2171 Internal error, is being mapped
EPR_INVALID_DRV_HANDLE 8562 2172 Internal error, is being mapped
EPR_DRIVER_NOT_OPEN 8563 2173 Internal error, is being mapped
EPR_WRONG_DEVICE_NAME 8564 2174 Internal error, is being mapped
EPR_NO_FLASH_AREA 8566 2176 EPROM: No flash area is available on the 

memory card.
EPR_WRONG_APPL_KEN 8567 2177 EPROM: The memory card has an incorrect 

application ID.
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Define Dec Hex Error Message (Stand 7.1.99)
EPR_MOD_CONTENS_UNKNOWN 8568 2178 EPROM: The content of the memory card 

cannot be interpreted.
EPR_MOD_CHKSUM_ERR 8569 2179 A growler error has occurred in the content of 

the memory card.
EPR_PROGRAMMING_ERR 8592 2190 EPROM: A configuration error has occurred.
SRVERR_NO_CONV_ESTABLISHE
D

16394 400A No communication with the S7OTBL server is 
possible. The server is not started.

SRVERR_SYS_ERROR 16399 400F System error during the S7OTBL server client 
communication.

NO_LIST_ENTRY 16415 401F No corresponding entry is available in the 
asynchronous list.

LOCAL_ALLOC_ERR 16416 4020 No local memory is available.
LOCAL_LOCK_ERR 16417 4021 The local memory cannot be locked.
S7DOS_SRV_TIMEOUT 16418 4022 Timeout during waiting on WM_ENDE_L7.
WRONG_WIN_MODE 16480 4060 Incorrect operating mode in Windows.
NO_GLOBAL_MEM 16481 4061 No global memory is available.
L4_OK_RESP 16641 4101 Internal error code, is being mapped
L4_INVALID_REQ 16642 4102 Online: Internal error.
L4_OK_EOM_RESP 16643 4103 Online: OK_EOM_RESPONSE.
L4_NO_RESOURCES 16644 4104 Online: No resources in the driver are 

available.
L4_OK_DECIDE_REQ_RESP 16645 4105 Internal error code, is being mapped
L4_UNKNOWN_REFERENCE 16646 4106 Online: Unknown shortcut.
L4_OK_CLOSED_RESP 16647 4107 Online: The connection was terminated.
L4_BUFFER_TOO_SHORT 16648 4108 Internal error code, is being mapped
L4_NO_SRD_RSP 16649 4109 Online: Sending and receiving of data is not 

acknowledged.
L4_BUFFER_TOO_LONG 16650 410A Internal error code, is being mapped
L4_OK_REJECT_CONN_RESP 16651 410B Internal error code, is being mapped
L4_ILLEGAL_REQ 16652 410C Internal error code, is being mapped
L4_REM_ABORT 16654 410E Online: Connection was terminated.
L4_LOC_TIMEOUT 16656 4110 Online: No connection was established. The 

station does not respond.
L4_UNKNOWN_CONN_CLASS 16658 4112 Internal error code, is being mapped
L4_DUP_REQ 16660 4114 Online: The connection already exists.
L4_CONN_REJECT 16662 4116 Online: No connection was established. The 

partner refuses to  establish the connection.
L4_NEGOT_FAILED 16664 4118 Internal error code, is being mapped
L4_ILLEGAL_ADDRESS 16666 411A Online: Invalid address.
L4_NETWORK_ERROR 16668 411C Online: Network error.
L4_PROTOCOL_ERR 16670 411E Internal error code, is being mapped
L4_ILLEGAL_RB_LENGTH 16672 4120 Internal error code, is being mapped
L4_PPI_T_TI_ERROR 16674 4122 Internal error code, is being mapped
L4_NO_RESOURCE 16897 4201 Online: No resources in the driver are 

available.
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Define Dec Hex Error Message (Stand 7.1.99)
L4_CONNECTION_EXIST 16898 4202 Internal error code, is being mapped
L2_OPEN_DONE 16899 4203 Internal error code, is being mapped
L4_SCI_STATION_NA 16913 4211 Online: No station is available on the subnet.
L4_SCI_STATION_DS 16914 4212 Online: The station is not online.
L4_SCI_STATION_NO 16915 4213 Online: Too many stations.
L4_SCI_NOTIMPLEMENTED 16917 4215 Online: The function is not implemented or is 

invalid in the current context.
L4_SCI_E_DPX2_ERROR 16918 4216 Online: Incorrect station address of the DP 

Slave or error message of the DP Slave.
L4_NO_CONFIG_FOUND 16936 4228 The bus parameters could not be retrieved 

automatically (ONLINE). No stations at the 
bus that send bus parameter frames.
Set your MPI/PROFIBUS interface manually.

L4_ONLY_BAUDRATE_FOUND 16937 4229 Online: Only the baud rates could be retrieved.
L4_ONLY_PROFILE_FOUND 16938 422A Online: Only the profile could be retrieved.
L4_SCI_E_UNPLUGGED 16944 4230 Online: No other active station is available.
L4_SCI_E_SYNI 16945 4231 Online: The bus is faulted.
L4_DLL_E_HSA 16946 4232 Online: Incorrect maximal number of stations 

(HIGHEST_ADR).
L4_SCI_E_AMPRO 16947 4233 Online: System error.
L4_DLL_E_TIMER_INIT 17056 42A0 Online: The Windows timer cannot be set.
L4_DLL_E_INIT_COM 17057 42A1 Online: The COM interface cannot be 

initialized or opened.
L4_DLL_E_NO_HW 17072 42B0 Online: No hardware found.
L4_DLL_E_HW_DEFECT 17073 42B1 Online: The hardware is defective.
L4_DLL_E_CNF 17074 42B2 Online: The driver is configured incorrectly or 

the registry contains invalid parameters.
L4_DLL_E_BAUDRATE 17075 42B3 Online: An incorrect baud rate or an incorrect 

interrupt vector is set, or the local MPI address 
is greater than the maximum station address.

L4_DLL_E_TS 17077 42B5 Online: The set local station address 
(TS_ADR) is already assigned.

L4_DLL_E_OCC 17078 42B6 Online: The hardware device (DEVICE) 
cannot be used several times.

L4_DLL_E_INT_NOT_PROV 17079 42B7 Online: The defined interrupt vector (IRQ) is 
not available on this module.

L4_DLL_E_INT_BUSY 17080 42B8 Online: The set interrupt vector (IRQ) is 
already allocated.

L4_DLL_E_SAP 17081 42B9 Internal error code, is being mapped
L4_DLL_E_NO_FILE 17088 42C0 Online: The selected communication driver 

cannot be loaded; the file was not found.
L4_DLL_E_NO_ENTRY 17089 42C1 Online: The function is not realized on the 

loaded communication driver.
L4_DLL_E_LOGDEV 17090 42C2 Online: The logical device is not defined in the 

registry.
L4_DLL_E_VERSION 17104 42D0 Online: The output inventory of driver and 

adapter or PC/MPI cable are incompatible.
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Define Dec Hex Error Message (Stand 7.1.99)
L4_DLL_E_COMCNF 17105 42D1 Online: No interrupt of PC/MPI cable was 

received.
L4_DLL_E_NO_SMC 17106 42D2 Online: The connection to the adapter is 

disturbed.
L4_DLL_E_COMMBADID 17107 42D3 Online: The COM interface is not configured 

under Windows.
L4_DLL_E_COMMOPEN 17108 42D4 Online: The COM interface is currently 

unavailable.
L4_DLL_E_SMCBUSY 17109 42D5 Online: The serial driver is currently used by 

another application with another configuration.
L4_DLL_E_SMCMODEM 17110 42D6 Online: There is still no remote connection or 

logical connection to the TS Adapter.
L4_DLL_E_SMCNOLEG 17111 42D7 Online: The TS Adapter refuses the job due to 

missing required legitimation.
L4_LIB_WIN_SYS_ERR 17120 42E0 Online: Windows system error in 

communication driver.
L4_LIB_NO_GLOBAL_MEM 17134 42E

E
Online: No global memory is available.

L4_LIB_NO_SIN_SERV 17135 42EF Online: SIN_SERV is not started.
L4_SCI_STATION_NOT_ONLINE 17146 42FA Online: The station is not online.
L4_SCI_RB_ERR 17147 42FB Internal error code, is being mapped
L4_SCI_MAX_REQ_NR 17148 42F

C
Internal error code, is being mapped

L4_SCI_DRV_ALREADY_OPEN 17149 42F
D

Internal error code, is being mapped

L4_SCI_DRV_ERR 17150 42FE Internal error code, is being mapped
L4_SCI_DRV_NOT_INST 17151 42FF Internal error code, is being mapped
NO_LOC_SUBNET_ENTRY 17153 4301 Invalid local subnet number in the file 

S7DPMPI.INI.
NO_TABLE_ENTRY 17154 4302 The station on this subnet is unavailable.
WRONG_RACK_SLOT 17155 4303 Incorrect rack/slot in the module table.
WRONG_NODENAME 17156 4304 Incorrect format of the node name in 

S7db_open (online).
INVALID_S7_TABUF 17157 4305 Invalid S7-Transport_Address_Buffer.
INVALID_S7_WUSERID 17158 4306 The job cannot be found. Incorrect wUserID or 

incorrect Window handle.
L7_DPT_ERROR 17456 4430 The data record cannot be read/written.
RES_VON 28672 7000 The area from 0x7000 to 0x7fff is reserved for 

applications.
RES_BIS 32767 7FFF The area from 0x7000 to 0x7fff is reserved for 

applications.
L7_INVALID_CPU_STATE 32769 8001 The function is invalid in this operating mode, 

or an incorrect minimum scan cycle time is set.
L7_DOMAIN_LOADING_ERR 32771 8003 S7 protocol error: A domain transfer error has 

occurred. The domain content (e.g. block) is 
incorrect.

L7_S5_INTERN_ERR 33023 80FF S7 protocol: Internal error.
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L7_COMMON_ERR 33024 8100 Application, general error: Unknown service 

for the remote module.
L7_MISSING_CONTEXT 33028 8104 The service is not supported. An unknown 

error in PDU adapter or service has occurred.
L7_DEF_OBJ_INCONSISTENT 33284 8204 The object's type format is inconsistent.
L7_ALREADY_COPIED 33285 8205 A copied object's variant is available.
L7_NO_RAM 33537 8301 The memory space on the module is not 

enough or the specified memory medium is not 
available.

L7_NO_RESOURCE 33538 8302 A resource bottleneck is available or the 
processor resources are unavailable.

L7_ERRCOD_INI_NO_RES 33540 8304 Domain: An additional simultaneous 
uploading is no longer possible. A resources 
bottleneck is available.

L7_FUNC_NOT_AVAIL 33541 8305 The functionality is not available. A resources 
bottleneck is available.

L7_INVALID_SEQUENCE 33793 8401 S7 protocol error: Incorrect sequence of 
services (e.g. during loading or uploading of a 
block).

L7_WRONG_PI_STATE 33794 8402 Error during the service sequence. The 
service cannot be performed due to the mode 
of the addressed object.

L7_FATAL_ERR 33796 8404 S7 protocol: A significant error has occurred. 
The function cannot be executed.

L7_CPU_IN_PROTECTED_STATE 33797 8405 The remote block is in status DISABLE (PBK). 
The function cannot be executed.

L7_PDU_SIZE_ERR 34048 8500 S5 protocol error: Wrong PDU size.
L7_SERVICE_CANCELED 34051 8503 The service has been prematurely canceled.
L7_NO_OBJ_ACCESS 34561 8701 The object access is not supported.
L7_INVALID_ADDRESS 34562 8702 S7 protocol error: Access to a remote object 

was rejected.
L7_OBJECT_ACCESS_DENIED 34563 8703 Access error: Access to a remote object was 

rejected.
L7_ACCESS_ERR_OBJ 34564 8704 Access error: The object is damaged.
L7_INVALID_REQ_NB 53249 D001 D001: Protocol error: Job number is invalid.
L7_INVALID_REQ_VER 53250 D002 D002: Parameter error: Job variant is invalid.
L7_INVALID_FKT 53251 D003 D003: Parameter error: The function is invalid.
L7_INVALID_REQ_STAT 53252 D004 D004: Parameter error: Job status is invalid.
L7_INVALID_END_OF_REQ 53253 D005 D005: Parameter error: Job termination is 

invalid.
L7_INVALID_ABORT_OF_CONN 53254 D006 D006: Parameter error: The ID for the 

connection termination is invalid.
L7_INVALID_NB_OF_BUF 53255 D007 D007: Parameter error: The number of buffer 

elements is invalid.
L7_INVALID_GEAR_DOWN 53256 D008 D008: Parameter error: The reduction factor is 

invalid.
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L7_INVALID_NB_OF_EXEC 53257 D009 D009: Parameter error: The execution number 

is invalid.
L7_INVALID_TRIG_EVENT 53258 D00

A
D00A: Parameter error: The trigger event is 
invalid.

L7_INVALID_TRIG_COND 53259 D00
B

D00B: Parameter error: The trigger 
requirement is invalid.

L7_TRIG_EVENT_ERR_NO_BLK 53265 D011 D011: Parameter error: The block is not 
available.

L7_TRIG_EVENT_WRONG_OFF 53266 D012 D012: Parameter error: Incorrect address in 
the block.

L7_TRIG_EVENT_ERR_BLKTYP 53267 D013 D013: Parameter error: The block type is 
invalid.

L7_TRIG_EVENT_BLK_IS_MOD 53268 D014 D014: Parameter error: The block is being 
deleted/overloaded.

L7_TRIG_EVENT_ERR_VARADDR 53269 D015 D015: Parameter error: The tag address is 
invalid.

L7_TRIG_EVENT_ERR_FOUND_BL 53270 D016 D016: Parameter error: No block can be 
activated.

L7_TRIG_EVENT_ERR_SYS_TRIG
GER

53271 D017 D017: Parameter error: The SYS trigger 
number is invalid.

L7_TRIG_COND_PATH_ERR 53285 D025 D025: Parameter error: The path is invalid.
L7_TRIG_COND_ACC_ERR 53286 D026 D026: Parameter error: The access type is 

invalid.
L7_TRIG_COND_NB_OF_DB_ERR 53287 D027 D027: Parameter error: The number of DBs is 

invalid.
L7_SEGMENT_NEXT_ERR 53297 D031 D031: Protocol error: CN-ID, S-ID or  ID1 in 

the following segment do not match the first 
segment.

L7_SEGMENT_LEN_ERR 53298 D032 D032: Parameter error: Incorrect length of the 
buffer result.

L7_REQUEST_LEN_ERR 53299 D033 D033: Protocol error: Job length is invalid.
L7_PARAM_CODING_ERR 53311 D03

F
D03F: Coding error: Other error in the 
parameter part (e.g. reserve bytes do not 
equal NULL).

L7_STALI_ID_ERR 53313 D041 D041: Data error: The stali ID is invalid.
L7_VAR_ADDR_ERR 53314 D042 D042: Data error: The tag address is invalid.
L7_REQ_DOES_NOT_EXIST 53315 D043 D043: Data error: The referenced job is not 

available.
L7_INVALID_VAR_VALUE 53316 D044 D044: Data error: The tag value is invalid.
L7_BASP_ERR 53317 D045 D045: Data error: Quitting the BASP control 

(ODIS) during HOLD is invalid.
L7_MEASUREMENT_ERR 53318 D046 D046: Data error: The measuring level during 

runtime measuring is invalid.
L7_HIERARCHY_ERR 53319 D047 D047: Data error: The hierarchy for 'Read job 

list' is invalid.
L7_INVALID_DEL_ID 53320 D048 D048: Data error: The delete ID for 'Delete job' 

is invalid.
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L7_INVALID_SUB_ID 53321 D049 D049: The replace ID for 'Replace job' is 

invalid.
L7_INVALID_ENTRANCE_DATA 53322 D04

A
D04A: Error during execution of 
'programstatus'.

L7_DATA_CODING_ERR 53343 D05
F

D05F: Coding error: Other error in the data 
part (e.g. reserve bytes do not equal NULL, ...).

L7_REQ_MEM_ERR 53345 D061 D061: Resource error: No memory for the job 
is available.

L7_FULL_REQ_LIST 53346 D062 D062: Resource error: The job list is full.
L7_TRIG_EVENT_IS_USED 53347 D063 D063: Resource error: The trigger event is 

allocated.
L7_TOO_SMALL_BUF 53348 D064 D064: Resource error: The memory space for 

an element of the result buffer is too small.
L7_TOO_MANY_BUF 53349 D065 D065: Resource error: The memory space for 

several elements of the result buffer is too 
small.

L7_NO_TIMER_AVAIL 53350 D066 D066: Resource error: Another job allocates 
the timer for the runtime measurement.

L7_PBUS_ALREADY_USED 53351 D067 D067: Resource error: Another job allocates 
the P bus during 'Control selection'.

L7_INVALID_FKT_IN_STATE 53377 D081 D081: Operation mode error: The function in 
the current operation mode is invalid.

L7_OPERATION_STATE_ERR 53378 D082 Operation mode error: Operating mode HOLD 
cannot be quit.

L7_PROT_LEVEL_ERR 53409 D0A
1

D0A1: Protection and coding: The function in 
the current protection level is not allowed.

L7_MOD_FKT_ERR 53410 D0A
2

D0A2: Protection and coding: The memory-
modifying OVS function is running.

L7_CTRL_IS_INST 53411 D0A
3

D0A3 Protection and coding: "Control 
selection" is already set up.

L7_FORCE_IS_INST 53412 D0A
4

D0A4: Protection and coding: "Forcing" is 
already set up.

L7_NO_REF_TO_REF 53413 D0A
5

D0A5: Protection and coding: The current job 
references another job in the communication 
partner which is not available.

L7_TE_AT_ONCE_REQ 53414 D0A
6

D0A6: Protection and coding: The job cannot 
be locked/unlocked.

L7_REQ_NO_DELETE 53415 D0A
7

D0A7: Protection and coding: The job cannot 
be deleted because e.g. it is currently being 
read.

L7_REQ_NO_CHANGE 53416 D0A
8

D0A8: Protection and coding: The job cannot 
be replaced because e.g. it is currently being 
read or deleted.

L7_REQ_NO_READ 53417 D0A
9

D0A9: Protection and coding: The job cannot 
be read because e.g. it is currently being 
deleted.

L7_TIME_LIMIT 53418 D0A
A

D0AA: Timeout in process mode is exceeded.
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L7_INVALID_INSTRUCT_PARAM 53419 D0A

B
D0AB: The job parameter are invalid in 
process moe.

L7_INVALID_INSTRUCT_DATA 53420 D0A
C

D0AC: The job data are invalid in process moe.

L7_OPERATIONS_MODE_REACHE
D

53421 D0A
D

D0AD: Operating mode is already set.

L7_TRIG_EVENT_ON_OTHER_CO
NN

53422 D0A
E

D0AE: The breakpoint is set using another 
connection. The job cannot be manipulated.

L7_VAR_ACC_ERR 53441 D0C
1

D0C1: Processing warning: During accessing 
tags at least one error was detected.

L7_BZUE_TO_STOP 53442 D0C
2

D0C2: Processing warning: Operating mode 
transition in STOP/HOLD during function call.

L7_BZUE_AFTER_VAR_ACC 53443 D0C
3

D0C3: Processing warning: Operating mode 
transition and access error: Access errors 
occurred during loading of the tag(s).

L7_FKT_TIMEOUT 53444 D0C
4

D0C4: Processing warning: Timer overflow 
during the runtime measuring.

L7_MOD_BLK_ERR 53445 D0C
5

D0C5: Processing warning: The blocks have 
been deleted/uploaded since transition STOP.

L7_REF_REQ_WAS_DEL 53446 D0C
6

D0C6: Processing error: The referenced job 
was deleted, because all jobs, that referenced 
it, were deleted.

L7_REQ_WAS_DEL_AFTER_BZUE 53447 D0C
7

D0C7: Processing error: The job was deleted 
due to quitting of the operating mode.

L7_EMPTY_STALI_ID 53448 D0C
8

D0C8: Processing error: The status block was 
interrupted, because an empty stali ID was 
detected during processing.

L7_VERL_STAT_RES_HGOB 53449 D0C
9

D0C9: Processing warning: Quitting the status 
area via reset of the background OB.

L7_VERL_STAT_RES_HGOB_ZUG
ERR

53450 D0C
A

D0CA: Processing warning: Quitting the status 
area via reset of the background OB and 
access error during reading of the tags before 
quitting.

L7_OUTPUT_LOCK_PA_ON 53451 D0C
B

D0CB: The output lock of the I/O outputs is 
again enabled.

L7_SHORT_RESULT 53452 D0C
C

D0CC: The data range for the test functions is 
limited by the timeout.

L7_INVALID_BL_NAME 53761 D201 D201: Syntax error in block name.
L7_INVALID_ARGUMENT 53762 D202 D202: Syntax error in the function parameters.
L7_INVALID_BL_TYPE 53763 D203 Internal error code, is being mapped
L7_NO_LINKED_BLK 53764 D204 Internal error code, is being mapped
L7_BL_ALREADY_INSERTED 53765 D205 D205: A linked block is already available in the 

RAM; no conditional copying is possible.
L7_INVALID_BL_NUMBER 53766 D206 D206: A linked block is already available in the 

EPROM; no conditional copying is possible.
L7_BL_IN_ROM 53767 D207 At least one block is already available in the 

EPROM.
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L7_TOO_MANY_COPIED_BL 53768 D208 The maximum number of copied (unlinked) 

blocks on the module has been exceeded.
L7_MISSING_BL 53769 D209 D209: At least one unspecified block on the 

module is unavailable.
L7_TOO_MANY_BL_INS 53770 D20

A
D20A: The maximum number of modules that 
could be linked with one job was exceeded.

L7_TOO_MANY_BL_DEL 53771 D20
B

D20B: The maximum number of modules that 
could be deleted with one job was exceeded.

L7_NO_AE 53772 D20
C

D20C: The OB cannot be copied, as the 
corresponding runtime level is not available.

L7_INVALID_YB 53773 D20
D

The SDB cannot be evaluated (e.g. unknown 
number).

L7_NO_MORE_BL 53774 D20
E

D20E: No block available.

L7_INVALID_BL_LEN 53775 D20
F

D20F: The module-specific maximum block 
size was exceeded.

L7_BLK_NB_ERR 53776 D210 D210: The block number is invalid.
L7_RUNTIME_REL_ATTRIB_ERR 53778 D212 D212: Incorrect header attribute (runtime 

relevant).
L7_TOO_MANY_SDB 53779 D213 D213: Too many SDBs.
L7_INVALID_BL 53780 D214 D214: Incorrect context in the block.
L7_INVALID_USER_PROG 53781 D215 D215: Incorrect user program.
L7_USER_PROG_ERR 53782 D216 D216: Invalid user program- clear/reset 

module.
L7_SDB0_PROTECTION_ERR 53783 D217 D217: The specified protection level in the 

SDB0 is invalid.
L7_ACT_PAS_ATTRIB_ERR 53784 D218 D218: Incorrect attribute (active/passive).
L7_BL_LEN_ERR 53785 D219 D219: Incorrect block lengths (e.g. incorrect 

length of the first section or the whole block).
L7_LOCAL_DATA_LEN_ERR 53786 D21

A
D21A: The length of the local data (e.g. odd. 
for OB<20, local data length/ data stack too 
large) or read-only ID is incorrect.

L7_COMPRESS_ERR 53787 D21
B

D21B: The module cannot compress, or the 
compress process was prematurely 
interrupted.

L7_WRONG_CPU_LIMITS 53789 D21
D

D21D: The transferred dynamic qualified 
project specifications are invalid. They do not 
match the removal of CPU or the current user 
program.
Check your settings and transfer them again.

L7_SDB_LINK_IN_ERR 53790 D21
E

D21E: Error during configuration of external 
modules inside linking of a SDB.

L7_INVALID_LANGUAGE 53792 D220 D220: The language setting is invalid.
L7_MPI_PARAM_ERR 53793 D221 D221: Error in the SDB for the connection 

management ( incorrect MPI parameter in the 
SDB0 or error in the connection description 
(SDBs)).
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L7_IK_PARAM_ERR 53794 D222 D222: Error in the SDB with GD configuration 

(incorrect parameter in the GD-SDB).
L7_PBK_PARAM_ERR 53795 D223 D223: Error in instance DB for PBK, or the 

maximum number of instance DBs was 
exceeded.

L7_PMC_ERR 53796 D224 There is an error in the setup of the SCAN-
SDB.

L7_DP_ERR 53797 D225 There is an error in the setup of the DP-SDB.
L7_BLK_STRUCT_WRONG 53798 D226 D226: A structure error occurred in a module.
L7_BL_TOO_LONG 53808 D230 D230: Incorrect resource specification. The 

block is longer than specifed, or the 
information provided at start of loading does 
not match.

L7_OB_WITHOUT_AE 53809 D231 D231: At least one loaded the OB cannot be 
copied, because the corresponding runtime 
level is not available.

L7_LOAD_PRG_BLK_NB_ERR 53810 D232 D232: At least one block number of a loaded 
module is invalid.

L7_EPR_BLK_ALREADY_EXIST 53811 D233 At least one loaded module is already 
available in EPROM.

L7_BLK_LOADING_2X 53812 D234 D234: The block is available twice in the 
specified memory medium or in the job.

L7_BLK_WRONG_CRC 53813 D235 D235: The block contains a checksum error.
L7_BLK_NO_CRC 53814 D236 D236: The block contains no checksum error.
L7_COORD_RULE 53824 D240 D240: The coding regulations were violated.
L7_FEW_PROT_LEVEL 53825 D241 D241: The protection level of the function is 

too small.
L7_SECURITY_LEVEL 53826 D242 AS protection error.
L7_OSUPDATE_WRONG_VER 53840 D250 D250: The update and module ID or the output 

release do not match.
L7_OSUPDATE_ORDER_ERR 53841 D251 D251: Incorrect sequence in the operation 

system components.
L7_OSUPDATE_CHECKSUM_ERR 53842 D252 D252: Checksum error.
L7_OSUPDATE_NO_LOADER 53843 D253 D253: There is no runtime download available, 

an update is only via the memory card 
possible.

L7_OSUPDATE_MEM_ERR 53844 D254 D254: Memory error in operating system.
L7_COMPILE_ERR 53888 D280 D280: Compiling error in AS 300.
L7_KOOR1_TRIGGER_ACTIVE 53921 D2A

1
D2A1: An additional block function or a trigger 
on a block is active. Close the other online 
function.

L7_KOOR2_TRIGGER_ACTIVE 53922 D2A
2

D2A2: A trigger is active on a block. Terminate 
the test function.

L7_KOOR3_TRIGGER_NOT_ACTIV
E

53923 D2A
3

D2A3: The block is not active (sequenced) or 
the block has to be deleted. Repeat the 
function later.
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L7_KOOR4_BLOCK_IN_WORK 53924 D2A

4
D2A4: The block is currently processed by 
another block function. Repeat the function 
later.

L7_KOOR6_PRG_SAVE 53926 D2A
6

D2A6: Saving and changing the user program 
are simultaneously impossible. Repeat the 
function later.

L7_KOOR7_BLOCK_NOT_RUNNIN
G

53927 D2A
7

D2A7: The block has the attribute ́ Unlinked´or 
is not being processed. A test function on this 
block is impossible.

L7_KOOR8_TST_RUNNING 53928 D2A
8

D2A8: A running test function prevents the 
CPU configuration. Terminate the test 
function.

L7_KOOR9_CPU_PARAM 53929 D2A
9

D2A9: The CPU is currently being re-
configured. "Load user program" is 
simultaneously impossible. Repeat the 
function later.

L7_KOOR4_BGR_PARAM 53930 D2A
A

D2AA: Modules are being currently re-
configured. Repeat the function later.

L7_H_CPU_REORG_MEM 53931 D2A
B

D2AB: Modifying the dynamic qualified project 
specifications is active. The user program is 
being re-evaluated.
Wait until the end of the reevaluation  and 
repeat your job.

L7_INVALID_SZL_ID 54273 D401 D401: Invalid SZL-ID.
L7_INVALID_INDEX 54274 D402 D402: Invalid INDEX.
L7_DGS_CONN_ALREADY_ANNO
U

54275 D403 D403: The service is already signed in/signed 
out (diagnose/PMC).

L7_MAX_USER_NB 54276 D404 D404: The maximum station number was 
reached.

L7_DGS_FKT_PAR_SYNTAX_ERR 54277 D405 D405: Service is not supported or syntax error 
for the function parameters.

L7_NO_INFO 54278 D406 D406: The desired information is not available.
L7_DIAGNOSE_ERR 54279 D407 A diagnostics error has occurred.
L7_DIAG_ERR_UPDATE 54280 D408 A diagnostics error has occurred.
L7_DIAG_ERR_DPBUS 54281 D409 A diagnostic error has occurred on the DB bus.
L7_PRT_FKT_PAR_SYNTAX_ERR 54785 D601 D601: Syntax error in function parameter.
L7_PASSWORD_ERR 54786 D602 D602: You have entered an incorrect 

password.
L7_PRT_CONN_ALREADY_ANNOU 54787 D603 D603: The connection is already allowed.
L7_PRT_CONN_ALREADY_FREE 54788 D604 D604: The connection is already approved.
L7_NO_PASSWORD 54789 D605 D605: Not allowed due to unavailable passord.
L7_INVALID_VAR_ADDR 55297 D801 D801: At least one tag address is invalid..
L7_UNKNOWN_REQ 55298 D802 D802: The specified job is not available.
L7_INVALID_REQ_STATUS 55299 D803 D803: Invalid job status.
L7_INVALID_CYCLIC_TIME 55300 D804 D804: Invalid cycle time (time basis or multiple 

is invalid).
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L7_NO_MORE_CYCLIC_REQ 55301 D805 D805: An additional cyclic reading job cann not 

be set up.
L7_INVALID_CYCLIC_REQ_STATE 55302 D806 D806: The referenced job is in a status, in 

which the requested function cannot be 
executed.

L7_CYCLIC_TIME_TOO_SHORT 55303 D807 D807: Interruption of the function due to 
overload, i.e., the processing of the reading 
cycle takes longer than the set cycle time.

L7_WRONG_TSY_FORMAT 56321 DC0
1

DC01: Error in the specification of date and 
time.

L7_H_CPU_IS_MASTER 57857 E201 E201: CPU is already master:
L7_H_CPU_AUA_MODULE 57858 E202 E202: Link-up and update impossible due to 

different user program in flash module.
L7_H_CPU_AUA_FW 57859 E203 E203: Link-up and update impossible due to 

different firmware.
L7_H_CPU_AUA_MEM 57860 E204 E204: Link-up and update impossible due to 

different memory expansion.
L7_H_CPU_AUA_SYNC 57861 E205 E205: Abort link-up/update due to 

synchronization error.
L7_H_CPU_AUA_KOORD 57862 E206 E206: Reject link-up/update due to 

coordination violation.
L7_INVALID_ID2 61185 EF01 S7 protocol error: Error in ID2: In the job only 

00H is valid.
L7_MISSING_CAPABILITY 61186 EF02 S7 protocol error: Error in ID2: The production 

facility record is not available.
DEMO_RETURN_CODE 65281 FF01 The function in the demo version is invalid.

S7DOS Trace function
The S7DOS trace can be controlled via the following registry entry:

HKEY_LOCAL_MACHINE/SOFTWARE/SIEMENS/SINEC/TrcParams
"Format"="long"
"Output"="file"
"Level"="0x71000000"

Format
The "Format" parameter can be set to "long" or "short". This affects the line layout of a trace 
line. A time stamp is input for "long".

Output
The "Output" parameter determines where the output is saved. If output is set to "file", the 
outputs are written to C:\tmp\S7FILE1.TRC or C:\tmp\S7FILE2.TRC. These files are limited to 
approx. 2 MB and are written according to the alternating buffer principle.

Level
The parameter level determines what kind of outputs are saved in the tracefile. This parameter 
is a bit-by-bit "OR" logic operation of the following constants:
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Level
S7TRCAI 0x10000000UL Application Interface
S7TRCL7 0x01000000UL Lower Interface (Layer 7 PDUs)
S7TRCL4 0x40000000UL Lower Interface (Layer 4)
S7TRCL2 0x20000000UL Lower Interface (Layer 2)

If all possible trace outputs have to be activated, the level has to be set to ‘0x7FFFFFFF’. The 
information is evaluated on activation of S7DOS. At this time the folder C:\tmp has to be 
available. The folder is not automatically created by S7DOS.

API error texts

API error messages
The most important error messages of S7 channel are listed in this section. If an error with an 
error code that is not in the table occurs, please call the WinCC hotline.

● Error during initialization of the S7 communication driver for 'unitname' unit 'devicename' 
device.

● Error during loading the S7 communication driver.

● For the configured functions is a S7DOS version xx or higher necessary.

● Error xx occurred in 'functionname' function

Error during initialization of the S7 communication driver for 'unitname' unit 'devicename' device.
An error occurred while the communication drivers were being initialized.

● The configured device is not available.

● An error occurred during the device driver is activated.

● Copy protection error occurred.

● The bus connector to the MPI card is not inserted.

Error during loading the S7 communication driver
The communication subsystem SAPI-S7 or S7DOS could not be loaded. 

● Communication driver not installed correctly.

● The DLLs  required by the communication driver could not be loaded correctly.

● Path setting incorrect or required communication drivers deleted or moved.

For the configured functions is a S7DOS version xx or higher necessary.
Functions were configured (for example, PMC message processing) that are not supported 
by the installed communication subsystem.
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Error xx occurred in 'functionname' function 
The error indication xx occurred during the processing of the specified channel function.

The most important error codes are listed in this section. If an error occurs with an error code 
that is not included in this table, please call the hotline.

Error 1 - EC_NOIMPL - Function not implemented
The called function is not implemented in the S7 channel.

Error 2 - EC_STRUFE - structure error
The language DLLs do not belong to the installed S7 channel.

Error 3 - EC_ILEGAL - Function call not permitted
The call of the function with the transferred parameters in S7 channel is not allowed

Error 4 - EC_NO_RAM - No free memory
The S7 channel could not create the memory that is required for the function.

Error 5 - EC_NOFILE - File not available
The specified file is not available.

Error 6 - EC_LNGERR - Error during switching languages
An error occurred while switching languages.

Error 7 - EC_UNITNV - Invalid unit ID
The specified UNIT-ID is invalid.

Error 8 - EC_NOUNIT - No unit available
The specified UNIT is not available.

Error 9 - EC_UNITNA - Unit not active
The specified UNIT is not active.

Error 10 - EC_PTRERR - Incorrect pointer
The pointer that is transferred in the function call is incorrect.
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Error 11 - EC_TIMERR - Error during starting the internal timer
An error occurred during starting of the internal timer.

Error 12 - EC_S7LERR - Error during loading of the S7 communication driver
The communication subsystem SAPI-S7 or S7DOS could not be loaded. 

● Communication driver not installed correctly.

● The DLLs  that are required by the communication driver could not be loaded correctly.

● Path setting incorrect or required communication drivers deleted or moved.

Error 13 - EC_S7IERR - Error during initializing of the S7 communication driver
An error occurred during initializing of the S7 communication driver.

● The configured device is not available.

● An error occurred during the device driver is activated.

● Copy protection error occurred.

● The bus connector to the MPI card is not inserted.

Error 14 - EC_CONERR - Connection fault
A read/write job was sent to a disrupted connection.

Error 15 - EC_PARERR - Incorrect parameter supply
An incorrect parameter was specified during a function call.

Error 16 - EC_DATERR - Data error occurred
The transferred connection data are invalid or damaged.

Error 17 - EC_CONDAT - Incorrect connection data
The transferred connection data are invalid or damaged.

Error 18 - EC_WNDERR - SINEC Windows incorrect
The SINEC Windows required for the communication could not be created.

Error 19 - EC_RAWERR - Error occurred in the raw data structure
The transferred raw data job is invalid or incorrect parameters were specified.
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Error 20 - EC_INTRDY - Internal function completed
Internal function correctly completed.

Error 21 - EC_EVNERR - EventNumber in MemberName n incorrect
Internal function correctly completed.

Tag configuration for status processing incorrect.

Error 22 - EC_GETERR - Error during GETVALUECB
Internal function correctly completed.

An error occurred during the function GETVALUECB

Error 23 - EC_EVMERR - EventMember variables incomplete
Internal function correctly completed.

Tag configuration for status processing incorrect.

Error 24 - EC_EIDERR - WinCC EV_ID for status processing incorrect
Internal function correctly completed.

Tag configuration for status processing incorrect.

Error 25 - EC_S7DOSV - function available after S7DOS version xx
Internal function correctly completed.

Functions were configured (for example, PMC message processing) that are not supported 
by the installed communication subsystem.

Error 26 - EC_EVSTDE - data not permitted during writing of .EventState
Internal function correctly completed.

During writing of an .EventState tag incorrect data were transferred.

Error 27 - EC_CONSTR - Configured connection too long as string
Internal function correctly completed.

The data of the configured connection result in string with invalid length.

Error 28 - EC_PDULEN - Configured data length greater than PDU length
Internal function correctly completed.

The data length of a configured tag exceeds the maximum PDU length.
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The permitted data length for a PDU length of 240 byte is 208 byte. A PDU length of 240 bytes 
is usual for AS300 and for communication via SAPI-S7.

For a PDU length of 480 bytes, 448 bytes can be transferred. A PDU length of 480 bytes is 
usual for AS400.

Error 29 - EC_OBJERR - configured data area is not supported
Internal function correctly completed.

The configured data area (for example area 0x80 I/O) is not supported.

Error 30 - EC_SYSPAR - Error during the setting of the system parameters
Internal function correctly completed.

An error occurred during the setting of the system parameters.

Error 31 - EC_SYPWRT - error during writing of the system parameters
Internal function correctly completed.

An error occurred during the writing of the system parameters in the storage file.

Error 32 - EC_NOVARI - Error during GetTagInfo call
Internal function correctly completed.

An error occurred during call GetTagInfo.

Error 33 - EC_ACKERR - Error during acknowledge via EventState
Internal function correctly completed.

An error was reported during the sending of jobs to the AS.

Error 34 - EC_LCKERR - Error during Lock/Release via EventState
Internal function correctly completed.

An error was reported during the sending of jobs to the AS.

Error 35 - EC_AUAOVL - buffer overflow during link-up and update
Internal function correctly completed.

A buffer overflow due to excess number of jobs occurred during link-up and update.

Error 100 - EC_VATERR - Incorrect type of transferred tag
Internal function correctly completed.

Transferred tag not from the right type 
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10.11.9 Communicating with SIMATIC S7 200

10.11.9.1 Communication with SIMATIC S7 200

Introduction
This section describes the communication between an HMI device and the SIMATIC S7 200 
PLC.   

You can configure the following communication channels for the SIMATIC S7 200 PLC:

● PROFINET and Ethernet

● PROFIBUS

● MPI

● PPI

HMI connection for communication
You configure connections between the HMI device and a SIMATIC S7 200 in the 
"Connections" editor of the HMI device. 

10.11.9.2 Creating a connection to SIMATIC S7 200

Introduction
You configure a connection to the SIMATIC S7 200 PLC in the "Connections" editor of the HMI 
device. The interfaces are named differently depending on the HMI device.     

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6503



3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "SIMATIC S7 200" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

See the chapter "Parameters for the connection (Page 6507)" for additional details.

10.11.9.3 Parameters for the connection

Parameters for the connection (SIMATIC S7 200)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.    

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Expansion slot"
Defines the number of the expansion slot of the CPU to be addressed.
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● "Rack"
Defines the rack number of the CPU to be addressed.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance.
Disable cyclic mode if you are operating several HMI devices in parallel.

PROFIBUS parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.   

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PROFIBUS network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
You set the PROFIBUS address of the HMI device under "Address". The PROFIBUS 
address must be unique in the PROFIBUS network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). 
In S7 200, you must set an HMI device as the master.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.
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Parameters for the network
Under "Network", you set the parameters for the PROFIBUS network to which the HMI device 
is linked.

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "DP", 
"Universal", or "Standard". The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual PROFIBUS address. The setting must 
be identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud in the OP 73 or the OP 77A, the highest station address 
must be less than or equal 63.

 

● "Number of masters"
For "Number of masters", set the number of masters in the PROFIBUS network. This 
information is necessary to correctly calculate the bus parameters. 

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.     

● "Address"
For "Address", set the PROFIBUS address of the S7 module (CPU, FM, or CP) to which 
the HMI device is connected.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200 
PLCs.
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MPI parameters

Parameters for the HMI device 
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.         

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the MPI network. 

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network.

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.         

 

● "Address"
For "Address", you set the MPI address of the HMI device. The MPI address must be unique 
throughout the MPI network.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). If you have connected only slaves to the HMI device, you must 
therefore disable the "Sole master on bus" safety feature.
In S7 200, you must set an HMI device as the master.

Parameters for the network
Under "Network", you set the parameters for the MPI network to which the HMI device is linked. 

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "MPI". 
The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual MPI address. The setting must be 
identical throughout the network.

● "Number of masters"
This setting is not required for MPI. 
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Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
For "Address", set the MPI address of the S7 module (CPU, FM, or CP) to which the HMI 
device is connected.

● "Cyclic mode"
When cyclic mode is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This improves system performance. Disable cyclic mode if you are 
operating several HMI devices in parallel. This setting is not required for SIMATIC S7-200.

PPI parameters

Parameters for the HMI device
You assign the parameters for the HMI device in the network once under "HMI device". The 
change applies to each communication partner.     

● "Type"
Specifies the physical connection used.

● "Interface"
For "Interface", you select the HMI device interface via which the HMI device is connected 
to the PP network.

● "Baud rate"
For "Baud rate", you set the transmission speed of the data in the network. The baud rate 
is determined by the slowest HMI device connected to the network. The setting must be 
identical throughout the network. 

 

  Note

If you set a baud rate of 1.5 Mbaud for OP 73 or OP 77A, the highest station address must 
be less than or equal to 63.     

 

● "Address"
For "Address", you set the PPI address of the HMI device. The PPI address must be unique 
throughout the PPI network.

● "Access point"
For "Access point", you set the access point via which the communication partner is 
reached.

● "Sole master on bus"
Disables an additional safety feature against bus faults when the HMI device is connected 
to the network. A passive station (slave) can only send data if it is requested to do so by 
an active station (master). If you have connected only slaves to the HMI device, you must 
therefore disable the "Sole master on bus" safety feature.
In S7 200, you must set an HMI device as the master.
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Parameters for the network 
Under "Network", you set the parameters for the network to which the HMI device is linked. 

● "Profile"
For "Profile", you select the network profile that is used in the network. In "Profile", set "PPI". 
The setting must be identical throughout the network.

● "Highest address"
For "Highest station address", set the highest station address. The highest station address 
must be greater than or equal to the highest actual MPI address. The setting must be 
identical throughout the network.

● "Number of masters"
Set the number of the master on the network to "1".

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner.   

● "Address"
For "Address", set the PPI address of the S7 module to which the HMI device is connected.

● "Cyclic operation"
This parameter is not required for communication via PPI.

Cyclic operation

Handling the "Cyclic operation" selection
If "Cyclic operation" is enabled, the HMI device sends a message frame to the CPU at the 
beginning of communication indicating that certain tags are required on a recurring basis.

The CPU then always transmits the data at the same cyclic interval. This saves the HMI device 
from having to output new requests for the data.

If cyclic operation is disabled, the HMI device sends a request whenever information is required.

Additional properties:

● Cyclic operation reduces data transmission load at the HMI device. The PLC resources are 
used to relieve load on the HMI device.

● The PLC only supports a certain number of cyclic services. The HMI device handles the 
operation if the PLC cannot provide any further resources for cyclic services.

● The HMI device generates the cycle if the PLC does not support the cyclic mode.

● Screen tags are not integrated in cyclic operation.

● Cyclic mode is only set up at the restart of Runtime.

● The HMI device transfers several jobs to the PLC if cyclic mode is enabled, depending on 
the PLC.

● The HMI device only transfers one job to the PLC if cyclic mode is disabled.
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10.11.9.4 Data exchange

Data exchange using area pointers

General information on area pointers

Introduction     
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.

Configuration of area pointers
Before you use an area pointer, you enable it under "Connections > Area pointer". You then 
assign the area pointer parameters.

You can find more detailed information on configuring area pointers in:

Auto-Hotspot 

"Screen number" area pointer

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Application
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.
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Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1st word Current screen type
2nd word Current screen number
3rd word Reserved
4th word Current field number
5th word Reserved

 

● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

 Note

Symbolic addressing is not possible if you are using the "Date/Time" area pointer.
 

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

The date/time data area has the following structure:
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Data word Most significant byte Least significant byte  
7       0 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute, if the process allows this.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The date/time data area has the following structure:
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DATE_AND_TIME format (in BCD code)

Data word Most significant byte Least significant byte
7 . . . . . . 0 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC flexible and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.

 

"Coordination" area pointer

Function    
The "Coordination" area pointer is used to implement the following functions:

● Detecting the startup of the HMI device in the control program

● Detecting the current operating mode of the HMI device in the control program

● Detecting whether the HMI device is ready to communicate in the control program

By default, the "Coordination" area pointer has the length of one word and cannot be changed.

Usage
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program can for this reason not make changes to the coordination area.
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Assignment of the bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
status of the operating mode bit is "0" during normal operation of the HMI device. You can 
determine the current operating mode of the HMI device by reading this bit in the control 
program.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not there is still a connection to the HMI device by querying this bit in the control 
program.

"Project ID" area pointer

Function    
When Runtime starts, a check can be carried out as to whether the HMI device is connected 
to the correct PLC. This check is important when operating with several HMI devices.

For this, the HMI device compares a value stored on the PLC with the value specified in 
configuration. This ensures compatibility of the configuration data with the PLC program. If 
there is no concordance, a system event is given on the HMI device and Runtime is stopped.

Use
 

 Note
HMI connections cannot be switched "online".

The HMI connection in which the "Project ID" area pointer is used must be switched "online".
 

To use this area pointer, set up the following during the configuration:
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● Define the version of the configuration. Values between 1 and 255 are possible.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections" under "Address".

Connection failure    
A connection failure to a device on which the "Project ID" area pointer is configured results in 
all the other connections of the device being switched to "offline".

This behavior has the following requirements:

● You have configured several connections in a project.

● You are using the "Project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the Engineering System.

 

"Job mailbox" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time

Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Most significant byte Least significant byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.
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Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

No
.

Function  

14 Set time (BCD-coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded) 3)

 Parameter 1 Left byte:  -
Right byte:  Weekday 
                        (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (In the S7 format DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs to prevent overload 
of the HMI device.

 Parameter 1, 2, 3 -
46 Update tag
 Causes the HMI device to read the current value of the tags from the PLC whose update ID 

matches the value transferred in Parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
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No
.

Function  

14 Set time (BCD-coded)
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 2)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Reading data record from PLC  1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Writing data record to PLC 1)

 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) Only devices supporting recipes
2) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job mailbox if 

the on-screen keyboard is active.
3) The weekday is ignored on HMI device KTP 600 BASIC PN.

"Data record" area pointer

"Data record" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization over the data record

Data records are always transferred directly. That is, the tag values are read from an address 
or written to an address configured for this tag directly, without redirecting the values by means 
of interim memory. 
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Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system event. 

Sequence of a transfer started by the operator in the recipe view

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
 

Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data mailbox.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized in the recipe view and tags and then written to the PLC.

 

3 The HMI device sets the status "Transfer completed."  
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Step Action
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.

 

 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a job mailbox
The transfer of data records between the HMI device and the PLC can be initiated by the HMI 
device or by the PLC.  

The two job mailboxes No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1-65,535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1

No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
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 Left byte (LB) Right byte (RB)
Word 3 Data record number (1-65,535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC using job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data mailbox.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

job from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
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Step Action
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data mailbox.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
mailbox.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of faults  
The section below shows possible causes of errors which lead to a data record transfer being 
terminated with errors: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system events

● Triggered by function
Output of system events

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
mailbox.

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example, when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.
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Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then process, edit, or save these 
values, for example. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the Inspector window the "Coordinated transfer of data records" option 
under "General > Synchronization > Settings".
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data record free
2 0000 0010 Transferring
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Professional (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.
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Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.
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Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3910) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted
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Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER

How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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10.11.9.5 Performance features of communication

Permitted data types for SIMATIC S7 200

Permitted data types for connections with SIMATIC S7 200
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Length
Bool 1 bit
Byte 1 byte
Char 1 byte
Word 2 bytes
Int 2 bytes
DWord 4 bytes
DInt 4 bytes
Real 4 bytes
StringChar --
Timer 2 bytes
Array --

 
 

 Note
Disconnection with a PPI network

If you are using arrays in the configuration, an array size of approximately 1000 bytes may 
cause an interruption of the connection.

Use smaller arrays in your configuration.
 

10.11.10 Communicating with SIMATIC LOGO!

10.11.10.
1

Communication with SIMATIC LOGO!

Introduction
This section describes the communication between an HMI device and the SIMATIC 
SIMATIC LOGO! controller.     

You can configure the following communication channels for the SIMATIC LOGO! controller:
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● PROFINET

● Ethernet

HMI connection for communication
You configure connections between the HMI device and SIMATIC LOGO! in the "Connections" 
editor of the HMI device. 

Data exchange
Data exchange with the SIMATIC LOGO! control system is possible by means of tags.

Data cannot be exchanged using area pointers.

10.11.10.
2

Creating a connection to SIMATIC LOGO!

Introduction
You configure a connection to the SIMATIC LOGO! controller in the "Connections" editor of 
the HMI device. The interfaces are named differently depending on the HMI device.         

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "SIMATIC LOGO!" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

See the chapter "Auto-Hotspot" for additional details.

10.11.10.
3

Connection parameters

Connection parameters 

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.       

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used.
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Ethernet parameters

Parameters for the HMI device
You set the parameters for the HMI device in the network under "HMI device".. The changes 
are not transferred automatically to the HMI device. You must change the settings in the Control 
Panel of the HMI device.   

● "Interface"
If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. 

 

  Note

The IP address in the Control Panel will be overwritten upon subsequent loading if you 
have already set up the IP address in the HMI device control panel.

The IP address already set up in the Control Panel will be retained upon subsequent 
loading if you activate "Set IP address using a different method".

 

The IP address is transferred to the HMI device during project transfer. 
To set up the IP address of the HMI device:

– Click the HMI device.

– Open the "Device configuration" editor.

– Click the Ethernet interface.

– Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

● "Address"
You assign the IP address of the HMI device in the "Address" area. 
When you transfer the WinCC project to the HMI device, this IP address is set up directly 
in the HMI device.

● "Access point"
The access point defines a logical device name through which the communication partner 
can be reached.

Parameters for the PLC
Under "PLC", you address the S7 module with which the HMI device will exchange data. Assign 
a name for the connection for each communication partner. 

● "Address"
Under "Address", set the IP address of the S7 module to which the HMI device is connected.

● "Expansion slot"
Defines the number of the expansion slot of the CPU to be addressed.
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● "Rack"
Defines the rack number of the CPU to be addressed.

● "Cyclic operation"
 

  Note

The setting "Cyclic operation" cannot be configured for the SIMATIC S7 1200 PLC.
 

When cyclic operation is enabled, the PLC optimizes the data exchange between the HMI 
device and the PLC. This increases system performance.
Disable cyclic mode if you are operating several HMI devices in parallel.

Cyclic operation

Handling the "Cyclic operation" selection
If "Cyclic operation" is enabled, the HMI device sends a message frame to the CPU at the 
beginning of communication indicating that certain tags are required on a recurring basis.

The CPU then always transmits the data at the same cyclic interval. This saves the HMI device 
from having to output new requests for the data.

If cyclic operation is disabled, the HMI device sends a request whenever information is required.

Additional properties:

● Cyclic operation reduces data transmission load at the HMI device. The PLC resources are 
used to relieve load on the HMI device.

● The PLC only supports a certain number of cyclic services. The HMI device handles the 
operation if the PLC cannot provide any further resources for cyclic services.

● The HMI device generates the cycle if the PLC does not support the cyclic mode.

● Screen tags are not integrated in cyclic operation.

● Cyclic mode is only set up at the restart of Runtime.

● The HMI device transfers several jobs to the PLC if cyclic mode is enabled, depending on 
the PLC.

● The HMI device only transfers one job to the PLC if cyclic mode is disabled.
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10.11.10.
4

Data exchange

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Auto-Hotspot 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)
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Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.
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Permitted data types for trends

For SIMATIC S7  
You assign one bit to each trend during configuration. Tags and array tags of the "Word" or 
"Int" data type are permitted.

Alarms

Configuring alarms

Configure alarms   
Several steps are needed to configure alarms, such as operational messages, error alarms, 
and acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Auto-Hotspot 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a SIMATIC communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

SIMATIC S7 PLCs WORD, INT BYTE, CHAR, WORD, INT, DWORD, DINT, 
REAL, TIMER
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How the bit positions are counted
For connections with a SIMATIC communication driver, the following counting method applies:

How the bit positions are 
counted

Byte 0 Byte 1
Most significant byte Least significant byte

In SIMATIC S7 
PLCs

7       0 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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10.11.10.
5

Performance features of communication

Valid data types for SIMATIC LOGO!

Valid data types for connections with SIMATIC LOGO!

Data type Length
Bool 1 bit
Byte 1 byte
Int 2 bytes
DInt 4 bytes
Word 2 bytes
DWord 4 bytes
Array --

10.11.11 Configuring direct keys

10.11.11.
1

Direct keys

Introduction
In addition to their standard use, the F, K and S keys of an HMI device with key operation can 
be used as direct keys.  

With HMI devices with touch operation, you configure the system function "Direct key" to a 
button 

You can configure the following direct keys:

● PROFINET connection: PROFINET IO direct keys

● PROFIBUS connection: PROFIBUS DP direct keys

Operating mode of HMI devices with direct keys
Before accessing the PLC from the HMI device using the direct keys you have to change the 
operating mode of the HMI device.
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10.11.11.
2

Changing the operating mode of the HMI device

Changing the operating mode for a PROFINET connection

Requirements 
The HMI device is networked with a PLC via PROFINET.

Procedure 
1. Click the PROFINET interface of the HMI device in the "Devices & Networks" editor.

2. Click "Operating mode" under "Properties > General" in the Inspector window.

3. Select the function "IO device" in the "Operating mode" area.

4. Select the PLC which is networked with the HMI device under "Assigned IO controller".

Changing the operating mode for a PROFIBUS connection

Requirements
The HMI device is networked with a PLC via PROFIBUS.
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Procedure 
1. Click the PROFIBUS interface of the HMI device in the "Devices & Networks" editor.

2. Click "Operating mode" under "Properties > General" in the Inspector window.

3. Select the function "DP slave" in the "Operating mode" area.

4. Select the PLC which is networked with the HMI device under "Assigned DP master".

10.11.11.
3

Configuring direct keys

Configuring direct keys for an HMI device with touch operation

Requirements
● An HMI device with key operation has been created.  

● You have created an LED tag.
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Procedure
1. Create a new screen.

2. Drag-and-drop a button from the "Tools" task card into the screen.

3. Click the button.

4. In the Inspector window, click "Properties > Events > Press".

5. Click "<Add function>".

6. Select the "Direct key" system function.

7. Under "Bit" enter the correct bit number.
The correct bit number depends on the HMI device and the input and output assignments 
on the HMI device.

Assignment of inputs and outputs
The exact assignment of inputs and outputs can be found under: 

● PROFINET IO direct keys: Inputs and outputs of HMI devices (Page 6553)

● PROFIBUS DP direct keys: Inputs and outputs of HMI devices (Page 6570)
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10.11.11.
4

PROFINET IO direct keys

PROFINET IO direct keys

PROFINET IO direct keys
You configure the HMI device created in WinCC as an active communication partner in the 
automation network.  

For the PROFINET IO direct keys, the HMI device can also be configured as a slave in the 
PROFINET IO network. 

The following figure shows the basic configuration based on an automation network with an 
HMI device and a PLC.

Mode of operation of the PROFINET IO direct keys
The cycle time of the Ethernet bus can be set between 8 ms and 512 ms. 

Thus, the reaction time of the PROFINET IO direct keys can also be determined. For a typical 
configuration with a cycle time of 64 ms, the response time of the PROFINET IO direct keys 
is < 100 ms.

A response time of < 100 ms to the CPU is usually ensured when using the PROFINET IO 
direct keys. This time can be exceeded significantly in the following cases:

● Complex functions run in the background, e.g. transmitting recipes, printing reports.

● At the same time, multiple connections can be maintained to the CPU.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6548 System Manual, 02/2014



HMI devices for the configuration of PROFINET IO direct keys

HMI devices
You can configure PROFINET IO direct keys with the following HMI devices:   

HMI device class HMI device
Panel OP 177B PN/DP

OP 277 6"
TP 177B 4" PN/DP
TP 177B 6" PN/DP
TP 277 6"

Mobile Panel Mobile Panel 177 PN
Mobile Panel 277 8"
Mobile Panel 277 10"
Mobile Panel 277 IWLAN V2
Mobile Panel 277(F) IWLAN V2
Mobile Panel 277(F) IWLAN V2 (RFID tags)

Multi Panel Multi Panel 177 6" Touch
Multi Panel 277 Key
Multi Panel 277 Touch
Multi Panel 377 Key
Multi Panel 377 Touch

Comfort Panel KTP400 Comfort
KP400 Comfort
KP700 Comfort
TP700 Comfort
KP900 Comfort
TP900 Comfort
KP1200 Comfort
TP1200 Comfort
KP1500 Comfort 
TP1500 Comfort 
TP1900 Comfort 
TP2200 Comfort 

 

Restrictions for PROFINET IO direct keys
 

 Note

Direct keys are still active when the HMI device is in "offline" mode.
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 Note

If an external application such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. The bit for the function 
"DirectKeyScreenNumber" is no longer set and the keys or buttons with the configured 
function "DirectKey" no longer trigger the associated bit in the PLC.

 

Restrictions   
● It is not permitted to operate PROFIBUS IO direct keys and PROFINET DP direct keys 

simultaneously.

● Establish the following via the "PROFINET IO enabled" option in the control panel of the 
HMI device:

– Option disabled = PROFIBUS DP direct keys enabled

– Option enabled = PROFINET IO direct keys enabled

● If communication is enabled with PROFINET IO, you are not permitted to use the serial 
interface.

● You can operate direct keys only on local HMI devices. On the Sm@rtClient it is possible 
to operate the key / button for the direct key. However, No bit is set in the I/O area of the 
CPU.

● Direct keys which are assigned to a button are only triggered through touch operation. 
Triggering with a mouse click, for example with a connected USB mouse, is not possible.

● With touch operation, direct keys are triggered independent of any configured password 
protection.

● The buttons used as direct keys on HMI devices with touch screen functionality may not 
be modified as follows by means of scripting:

– Moving

– Resizing

– Hiding

– Disabling for operation

● The LEDs are addressed either via the PROFINET IO direct keys or the HMI Runtime 
application. Avoid concurrent addressing via the PROFINET IO direct keys and the HMI 
Runtime application. The LEDs "ACK", "A-Z l", "A-Z r" and "HELP" are reserved for system 
functions and cannot be configured. It is not advisable to control the "ACK", "A-Z l", "A-Z r" 
and "HELP" LEDs by means of PROFINET IO direct key functionality.
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Inputs and outputs of HMI devices

Assignment of inputs and outputs

Assigning the inputs/outputs 
The keys or buttons of the device are assigning bytes in the input area. The LEDs are assigning 
bytes in the output area. The number of bytes used depends on the HMI device.   

The touch panels do not have any permanently assigned keys. They only have user-
configurable buttons. Via the "DirectKey system function you can assign a bit to a button in 
the input area. The counting direction of the bit in the input direction is from right to left. In 
contrast to the operator panels which have permanently assigned keys, the touch panel buttons 
can be assigned freely.

Assigning direct keys to screen numbers (only for touch devices)
If a PROFINET IO direct key is using the same bit for different functions in different screens, 
the SIMATIC PLC must differentiate between the respective functionality by means of the 
screen number. You can use the "DirectKeyScreenNumber" system function to avoid the 
delayed updating of the screen number following a screen change.

Using the "DirectKeyScreenNumber"system function you can set within the input area any 
number of bits in order to identify the screen and simultaneously transfer the direct key bits to 
the PLC. This ensures unambiguous allocation of a control bit to screen number at all times.

See also
Panel (Page 6553)

Multi Panel (Page 6556)

Mobile Panel (Page 6559)

Comfort Panel (Page 6562)

Panel

OP 177

Direct keys OP 177B

Inputs Outputs
9 bytes 4 bytes
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TP 177

Direct keys TP 177B 4"

Inputs Outputs
5 bytes –

Direct keys TP 177B 6"

Inputs Outputs
4 bytes --
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OP 277

Direct keys OP 277 6"

Inputs Outputs
4 bytes 4 bytes

  

TP 277

Direct keys TP 277 6"

Inputs Outputs
4 bytes  –
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Multi Panel

Multi Panel 177

Direct keys Multi Panel 177 6" Touch

Inputs Outputs
4 bytes -

  

Multi Panel 277

Direct keys Multi Panel 277 8" Key

Inputs Outputs
5 bytes 5 bytes
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Direct keys Multi Panel 277 10" Key

Inputs Outputs
5 bytes 5 bytes

 

Direct keys Multi Panel 277 8" Touch

Inputs Outputs
5 bytes –
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Direct keys Multi Panel 277 10" Touch

Inputs Outputs
5 bytes –

  

Multi Panel 377

Direct keys Multi Panel 377 Key

Inputs Outputs
5 bytes 5 bytes
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Multi Panel 377 Touch

Inputs Outputs
5 bytes –

  

Mobile Panel

Mobile Panel 177

Direct keys Mobile Panel 177 PN

Inputs Outputs
9 bytes 2 bytes
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Mobile Panel 277

Direct keys Mobile Panel 277 8"

HMI device Inputs Outputs
Mobile Panel 277 8" 10 bytes 4 bytes
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Direct keys Mobile Panel 277 10"

HMI device Inputs Outputs
Mobile Panel 277 10" 5 bytes --
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Mobile Panel 277 IWLAN V2

Direct keys Mobile Panel 277 IWLAN V2
The assignment of the inputs and outputs of the direct keys applies to the following HMI devices:

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2 (RFID tags)

Inputs Outputs
10 bytes 4 bytes

   

Comfort Panel

KTP400 Comfort

Direct keys KTP400 Comfort

HMI device Inputs Outputs
Touch operation 5 bytes 1 byte
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KP400 Comfort

Direct keys KP400 Comfort

Inputs Outputs
1 byte 1 byte

  

KP700 Comfort

Direct keys KP700 Comfort

Inputs Outputs
3 bytes 3 bytes
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TP700 Comfort

Direct keys TP700 Comfort

Inputs Outputs
4 bytes --

  

KP900 Comfort

Direct keys KP900 Comfort

Inputs Outputs
4 bytes 4 bytes

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6562 System Manual, 02/2014



  

TP900 Comfort

Direct keys TP900 Comfort

Inputs Outputs
5 bytes --

  

KP1200 Comfort

Direct keys KP1200 Comfort

Inputs Outputs
5 bytes 5 bytes

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6563



  

TP1200 Comfort

Direct keys TP1200 Comfort

Inputs Outputs
5 bytes --

   

TP1500, TP1900 and TP2200 Comfort

Inputs Outputs
5 bytes --

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6564 System Manual, 02/2014



KP1500 Comfort

Inputs Outputs
5 bytes 5 bytes

10.11.11.
5

PROFIBUS DP direct keys

PROFIBUS DP direct keys

PROFIBUS DP direct keys
You configure the HMI device created in WinCC as an active communication partner in the 
automation network.    

For the PROFIBUS DP direct keys, also configure the HMI device as a slave in the 
PROFIBUS DP network. 

The following figure shows the basic configuration based on an automation network with an 
HMI device and a PLC.
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Mode of operation of the PROFIBUS DP direct keys
With PROFIBUS DP direct keys, when the key or button is pressed, a bit is set in the I/O area 
of the CPU.

The cycle time of the PROFIBUS DP bus is calculated from the total of all configured inputs 
and outputs. 

The number of configured inputs and outputs can influence the reaction time of the 
PROFIBUS DP direct key. For a typical configuration the response time of the PROFIBUS DP 
direct key is < 100 ms.

HMI devices for the configuration of PROFIBUS DP direct keys

HMI devices
You can configure PROFIBUS DP direct keys with the following HMI devices:     

HMI device class HMI device
Panel OP 77B

OP 177B
OP 277 6"
TP 177B 4"
TP 177B 6"
TP 277 6"

Mobile Panel Mobile Panel 177 DP
Mobile Panel 277 8"
Mobile Panel 277 10"
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HMI device class HMI device
Multi Panel Multi Panel 177 6" Touch

Multi Panel 277 Key
Multi Panel 277 Touch
Multi Panel 377 Key
Multi Panel 377 Touch

Comfort Panel KTP400 Comfort
KP400 Comfort
KP700 Comfort
TP700 Comfort
KP900 Comfort
TP900 Comfort
KP1200 Comfort
TP1200 Comfort
KP1500 Comfort 
TP1500 Comfort 
TP1900 Comfort 
TP2200 Comfort 

 

Restrictions for PROFIBUS DP direct keys
 

 Note

If an external application such as Pocket Internet Explorer or Control Panel is started, it will 
run in the foreground and Runtime is placed in the background. The bit for the function 
"DirectKeyScreenNumber" is no longer set and the keys or buttons with the configured 
function "DirectKey" no longer trigger the associated bit in the PLC.

 

Restrictions   
● It is not possible to operate PROFIBUS DP direct keys and PROFINET IO direct keys 

simultaneously.
Establish the following via the "PROFINET IO enabled" option in the control panel of the 
HMI device: 

– Option disabled = PROFIBUS DP direct keys enabled

– Option enabled = PROFINET IO direct keys enabled

● You can operate direct keys only on local HMI devices. On the Sm@rtClient it is possible 
to operate the key / button for the direct key. However, No bit is set in the I/O area of the 
CPU.
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● The buttons used as direct keys on HMI devices with touch screen functionality may not 
be modified as follows by means of scripting:

– Moving

– Resizing

– Hiding

– Disabling for operation

● The LEDs are addressed either via the PROFIBUS DP direct keys or the HMI Runtime 
application. Avoid concurrent addressing via the PROFIBUS DP direct keys and the HMI 
Runtime application. The LEDs "ACK", "A-Z l", "A-Z r" and "HELP" are reserved for system 
functions and cannot be configured. We do not recommend addressing the LEDs "ACK", 
"A-Z l", "A-Z r" and "HELP" with the PROFIBUS DP direct keys.

● The PROFIBUS direct keys on an HMI device are triggered independent of any configured 
password protection.

Inputs and outputs of HMI devices

Assignment of inputs and outputs

Assigning the inputs/outputs 
The keys or buttons of the device are assigning bytes in the input area. The LEDs occupy 
bytes in the DP output area. The following table shows the number of bytes used in the various 
HMI devices. The precise assignment is shown in the following screens.   

The touch panels do not have any permanently assigned keys. They only have user-
configurable buttons. Via the direct keys function you can assign to a button a bit in the input 
area. The counting direction of the bit in the input direction is from right to left. In contrast to 
the operator panels which have permanently assigned keys, the touch panel buttons can be 
assigned freely. For more detailed information, refer to the "WinCC flexible - Configuring 
WinCC Windows-based Systems" user manual.

Assigning direct keys to screen numbers (only for touch devices)
If a PROFIBUS DP direct key is using the same bit for different functions in different screens, 
the S7 must differentiate between the respective functionality by means of the screen number. 
To combat the delayed updating of the screen number in the PLC after a change of screen 
you use the "DirectKeyScreenNumber" screen function.

Using the "DirectKeyScreenNumber" you can set within the input area any number of bits in 
order to identify the screen and simultaneously transfer the direct key bits to the PLC. This 
ensures unambiguous allocation of a control bit to screen number at all times.

See also
Panel (Page 6571)

Multi Panel (Page 6574)
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Mobile Panel (Page 6577)

Comfort Panel (Page 6580)

Panel

OP 77

Direct keys OP 77B

Inputs Outputs
4 bytes 4 bytes

  

OP 177

Direct keys OP 177B

Inputs Outputs
9 bytes 4 bytes
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TP 177

Direct keys TP 177B 4"

Inputs Outputs
5 bytes –

Direct keys TP 177B 6"

Inputs Outputs
4 bytes --
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OP 277

Direct keys OP 277 6"

Inputs Outputs
4 bytes 4 bytes

  

TP 277

Direct keys TP 277 6"

Inputs Outputs
4 bytes  –
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Multi Panel

Multi Panel 177

Direct keys Multi Panel 177 6" Touch

Inputs Outputs
4 bytes -

  

Multi Panel 277

Direct keys Multi Panel 277 8" Key

Inputs Outputs
5 bytes 5 bytes
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Direct keys Multi Panel 277 10" Key

Inputs Outputs
5 bytes 5 bytes

 

Direct keys Multi Panel 277 8" Touch

Inputs Outputs
5 bytes –
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Direct keys Multi Panel 277 10" Touch

Inputs Outputs
5 bytes –

  

Multi Panel 377

Direct keys Multi Panel 377 Key

Inputs Outputs
5 bytes 5 bytes
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Multi Panel 377 Touch

Inputs Outputs
5 bytes –

  

Mobile Panel

Mobile Panel 177

Direct keys Mobile Panel 177 DP

Inputs Outputs
9 bytes 4 bytes
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Mobile Panel 277

Direct keys Mobile Panel 277 8"

HMI device Inputs Outputs
Mobile Panel 277 8" 10 bytes 4 bytes
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Direct keys Mobile Panel 277 10"

HMI device Inputs Outputs
Mobile Panel 277 10" 5 bytes --
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Mobile Panel 277 IWLAN V2

Direct keys Mobile Panel 277 IWLAN V2
The assignment of the inputs and outputs of the direct keys applies to the following HMI devices:

● Mobile Panel 277 IWLAN V2

● Mobile Panel 277F IWLAN V2

● Mobile Panel 277 IWLAN V2 (RFID tags)

Inputs Outputs
10 bytes 4 bytes

   

Comfort Panel

KTP400 Comfort

Direct keys KTP400 Comfort

HMI device Inputs Outputs
Touch operation 5 bytes 1 byte
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KP400 Comfort

Direct keys KP400 Comfort

Inputs Outputs
1 byte 1 byte

  

KP700 Comfort

Direct keys KP700 Comfort

Inputs Outputs
3 bytes 3 bytes
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TP700 Comfort

Direct keys TP700 Comfort

Inputs Outputs
4 bytes --

  

KP900 Comfort

Direct keys KP900 Comfort

Inputs Outputs
4 bytes 4 bytes
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TP900 Comfort

Direct keys TP900 Comfort

Inputs Outputs
5 bytes --

  

KP1200 Comfort

Direct keys KP1200 Comfort

Inputs Outputs
5 bytes 5 bytes
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TP1200 Comfort

Direct keys TP1200 Comfort

Inputs Outputs
5 bytes --

   

KP1500 Comfort

Inputs Outputs
5 bytes 5 bytes
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TP1500, TP1900 and TP2200 Comfort

Inputs Outputs
5 bytes --

10.11.12 Communication via SIMATIC HMI HTTP

10.11.12.
1

Basic information on SIMATIC HMI HTTP

Introduction
You use the SIMATIC HMI HTTP Protocol for data exchange between HMI devices.      

The SIMATIC HMI HTTP Protocol is not suited for exchange of bulk data.

Data exchange occurs according to the Request-Response method. The HTTP client sends 
its request to the HTTP server, which processes it and returns a response.

A device can be configured as an HTTP client and HTTP server simultaneously.  

The client and server establish a connection via the Ethernet interface for data exchange.
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HTTP components
The components of the SIMATIC HMI HTTP Protocol are transferred to the HMI device in 
"Load to device".

HTTP components are:

● HTTP server

● HTTP client

If you use a Standard-PC or SIMATIC IPC, you must install WinCC RT Advanced or WinCC 
RT Professional first.

SMTP protocol
The SMTP protocol is not a requirement for communication via SIMATIC HMI HTTP Protocol .
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HTTP / HTTPS
TheSIMATIC HMI HTTP Protocol offers two standards:

● HTTP
Is implemented in local networks for a fast, uncoded transfer of uncritical data.

● HTTPS
Enables a reliable HTTP connection between devices. Initially there is an exchange of 
secret keys. Then, in a further step, the respective public keys can be securely exchanged 
in the form of digital certificates. The public keys are used to encode the utility data in order 
to guarantee a bug-proof communication.  

 

  Note

Due to the encryption, the HTTPS protocol has a lower transmission performance than 
the HTTP protocol.

 

 

 CAUTION

End users are responsible for the security of their own networks.
 

10.11.12.
2

Configuring a connection via SIMATIC HMI HTTP

Configuring a connection via SIMATIC HMI HTTP

Communication between HMI devices via SIMATIC HMI HTTP protocol
Several steps are needed to configure communication between HMI devices via the SIMATIC 
HMI HTTP protocol:

1. Configure HMI device as a server.

2. Configure HMI device as a client.

3. Assign tag parameters in the client.

4. Commission connection.

Access to tags via SIMATIC HMI HTTP protocol
If access to tags via the SIMATIC HMI HTTP protocol is to be enabled, these tags must be 
defined for the relevant HMI devices and interconnected.
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Configuring an HMI device as a server

Configuring a server

Requirements
● The HTTP communication channel must be set in the Control Panel of the HMI device.       

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click "Runtime settings".
The "Runtime settings" editor opens.

3. Click "Services".

4. Select the "HTTP channel server" option.

If you use the SMTP protocol, you assign the following values under "SMTP settings" according 
to your project specifications:
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● Server name

● Login

● Password

Result
The HMI device has been configured as a server.

Tags in the server

Tags used
The client can use the HTTP protocol for read and write access to tags configured on the server 
in runtime. This means that it is not necessary to configure additional tags for an HTTP 
communication.

However, the following aspects must be taken into account to ensure correct data exchange:

● The data type of the server tags must match the data type in the client.

● The tag name configured in the HTTP server must be identical to the name of the address 
tag of the HTTP client.

 

Configuring an HMI device as a client

Configuring a client

Requirements
● The HTTP communication channel must be set in the Control Panel of the HMI device.

● An HMI device has been configured as a server.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.

4. In the "Communication drivers" column, select the "SIMATIC HMI HTTP Protocol" driver.
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5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

6. Set the parameters in the Property window.
See "Setting parameters for the client" for more information about the parameters.

Setting parameters for the client

Requirements
● Connection has been created via SIMATIC HMI HTTP protocol. 

● "Connections" editor is open.

Procedure
1. Select "Ethernet" in the Inspector window under "Parameters > Interface".

2. Select protocol http:// or https://.

3. Enter the name of the server or its IP address.

User name and password
If the "Authentication required" check box was selected in the server in the "Control Panel > 
WinCC Internet Settings > Web Server" dialog, a user name and password must be entered 
here in the client.

Timeout
Assign a time after which a connection break is recognized.   
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HTTPS protocol
If the HTTPS protocol is selected, with the following settings you can establish how the HTTPS 
client should check the properties of the server certificate and how it should react in the event 
of error:

● "Allow invalid computer names for certificates"

● "Allow expired certificates"

● "Allow certificates signed by unknown publishers"

Reading out an IP address
If the server has already been commissioned, you can read out the IP address on the server 
as well:  

● For Panel
Click "Start > Programs > Command Prompt" on the server and enter the "ipconfig" 
command using the screen keyboard. The IP address is displayed after pressing <Ret>.

● For PC / Panel PC
Click "Start > Run" on the server, enter "Cmd", and press <Ret>: The command interpreter 
is displayed. Enter the "ipconfig" command. The IP address is displayed after pressing 
<Ret>.

Assigning tag parameters in the client

Assigning tag parameters in the client

Introduction
In order to be able to access tags on the server, they must be configured in the client as tag 
addresses.

Requirements
● Tags have been created in the "HMI tags" editor of the server. 

Procedure
1. Double-click the client under "Devices" in the project tree.

2. Double-click "HMI tags".

3. Create a new tag.

4. Select a data type.
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5. Open the selection dialog in the "Addresses" column.

6. Define the parameters in the working area:
See "Parameters for the client tags" for more information about the parameters.
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Parameters for the tags of the client

Parameters for the tags

Data type
● The client does not check the data type. Therefore, pay attention that the data type selected 

here matches the data type of the tags on the server.

● Array tags are not permitted.

Addressing
If the server and client are not within the same project, note the following: 

● Enter the exact name of the tag that is to be communicated with on the server.
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Commissioning a connection

Setting the server's Internet Settings

Introduction
To commission an HTTP/HTTPS connection, the WinCC Internet Settings must be set up in 
the Control Panel of both the server and client, in addition to the configuration in WinCC.   

The name and number of tabs contained in the "WinCC Internet Settings" dialog depend on 
the software installed.

Only the required tabs with the MP 277 HMI device as an example are shown below.

WinCC Internet Settings, Proxy tab
The valid network settings are specified by the network administrator.

Make the following settings:

● Internet settings for HMI devices with Windows CE
In this case, there are several options for calling the Control Panel: 

– In the startup phase, click on the "Control Panel" button in the Windows CE Loader 
menu.

– Select "Start > Settings > Control Panel" in the toolbar.

– During normal operation, pressing the key combination <CTRL + ESC> opens the 
toolbar. Start the Control Panel by selecting "Start > Settings > Control Panel".

– Using the RT function "OpenControlPanel"

The language in the Windows CE based devices is always English.

 

WinCC Internet Settings, Web Server tab
Settings for using the integrated Web Server are made in this tab. 

The "Web Server" tab is only available in the WinCC Internet Settings if the Web Server is 
installed on the HMI device.
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● Tag authenticate
Controls authentication for tag access: 

– "No authentication": Authentication (user name password) is not required for access.

– "Authentication required": Authentication (user name password) is required for access. 
The user name and password for the client are specified during configuration.

● Tag access
Controls access to tags: 

– "Read/write": Tags can be read and rewritten.

– "Read only": Tags can only be read.

● Group for defining operational performance
The following check boxes are not selected in conjunction with tag exchange via the HTTP/
HTTPS protocol:

– Enable remote transfer (project)
Select this check box to enable an HTTP transfer from the configuration computer to 
the HMI device.

– Start automatically after booting
Specifies when the HTTP server should be started:
Enabled: The HTTP server starts immediately after the HMI device is booted, 
irrespective of the runtime software
Disabled: The HTTP server starts at the same time as the runtime software.

– Close with Runtime
Enabling this check box causes the HTTP server to be closed at the same time as the 
runtime software.
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● User Administration
This button opens the "UserDatabase-Edit" dialog box.

In the "User Manager" tab of this dialog box, you can select, delete, or create a new user. 
The "Description" and "Authorizations" tabs always apply to the user currently selected.
(This example dialog box shows a user with the name 'Panel-1_HTTP-Server'.)

● User Manager
"Administrator" is the default user name, and "100" is the default password setting. If a user 
name and password have been entered for the HTTP server under "Connections" in your 
WinCC project, the same user name and password must be specified on the server.
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● Description
Enables input of a user description.

● Authorizations
The newly set up user must be assigned the authorizations for "RT Communication on the 
"Authorizations" tab control.

 

Establishing an HTTP connection

Introduction
To establish an HTTP connection, you must perform the following actions:

● In the "Connections" editor of WinCC, configure the connection as an "https://" protocol 
type and define how the HTTPS client should verify the properties of the server certificate 
and respond to errors.

● Install a valid certificate on the HTTPS client.
Certificates are necessary for server authentication. Using certificates you can ensure that 
the server with which the connection is to be developed is actually the server for which it 
is outputting.           

Principle of an HTTPS connection
After runtime start, the HTTPS client establishes a connection to the HTTPS server. The 
HTTPS server presents its certificate, which the client verifies for authenticity. The session 
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code that can only be read by the HTTPS server is then transmitted. The session code is now 
available on both sides and enables a symmetrical data encryption.

 

 Note

The certificate contains the current time. The current time can lead to problems if the time 
zones of the server and client are different. For example, a certificate generated on a server 
with an Asian time zone only becomes valid on a client with European time zone in the future 
(8 hours).

 

Preparation for installing a certificate on the client
With the first HTTPS client access, the HTTPS server generates the certificate itself and then 
saves it in the "Cert.cer" memory. The file is stored in the following directory:

● On a PC/panel PC (with Windows XP) in the directory "..\\Siemens\Automation\WinCC 
Runtime Advanced\SystemRoot\SSL"

● On Windows CE-based devices in the directory "Flash\Simatic\SystemRoot\SSL"
The certificate must be stored on the HTTPS client on a storage medium from which it can 
be launched with a double click. 

Server Client Possible file transfer
with Windows XP
(PC, Panel PC)

with Windows XP
(PC, Panel PC)

● Disk
● USB stick
● LAN (Ethernet)
● Internet Explorer (via TCP/IP, if 

Service is already running)
With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows XP
(PC, Panel PC)

● Memory card
● ActiveSync (serial)

with Windows XP
(PC, Panel PC)

With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

With Windows CE
(xP 270, xP 277, MP 370, 
MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

● Memory card
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Installing a certificate on a client with Windows XP
Insert the storage medium on which you have saved the "Cert.cer" file into the HTTPS client 
or open the directory in which the file is located. Double click on the file and follow the 
instructions in the Windows dialog.

Tip: The Internet Explorer provides an easy way to install a certificate. Connect to this device 
via HTTPS (e.g.: https://<my device>). The browser establishes if a certificate has not yet been 
imported. In this case, the browser asks if you want to install the certificate. Any errors in the 
certificate will be displayed.

Installing a certificate on a client with Windows CE
Insert the memory card on which you have saved the converted "Cert.cer" file into the HTTPS 
client. WinCC provides the "InstallCert.exe" tool for importing certificates with Windows CE.

You can implement the installation as follows:

● In Explorer: 
Double click the "Cert.cer" file to install the certificate.

● At the command prompt:
Enter "InstallCert /[command parameter] [filename]".

– command parameters:
/r parameter must be specified because the certificate used in WinCC Runtime is a root 
certificate. 
A root certificate is the main certificate and is used to verify the authenticity of all other 
certificates transferred.

– filename
You must specify the certificate file with its complete path (e.g. "\Storage Card\Cert.cer")

A status alarm is output when you completed the installation. Runtime has to be restarted after 
the installation of a certificate on Windows CE- HMI devices with HTTPS clients. It is necessary 
to restart Runtime so that an HTTPS connection can be established.

The file "Cert.cer" cannot be opened.
The "Cert.cer" file generated at the HTTPS server cannot be opened on HMI devices based 
on Windows CE 5.0 by double-clicking the client.

1. Open the Control Panel.

2. Select "Certificates > My Certificates."

3. Click the "Import" button.
A dialog box opens. 

4. Select the "From a File" menu in the file browser and select the "Cert.cer" file.
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10.11.12.
3

Performance features of communication

Permitted data types

Permitted data types
When configuring tags, the data types listed below can be used.   

Data type in the 
SIMATIC HMI 
HTTP protocol

Length Sign Range of values

Bool 0 No true (-1) or false (0)
SInt 1 Byte Yes -128 to 127
USint 1 Byte No  0 to 255
Int 2 Byte Yes -32768 to 32767
UInt 2 Byte No 0 to 65535
DInt 4 Byte Yes  -2,147,483,648 to 2,147,483,647
UDInt 4 Byte No 0 to 4,294,967,295
Real 4 Byte Yes  -3.402823E38 to -1.401298E-45 for negative values and 

1.401298E-45 to 3.402823E38 for positive values
LReal 8 Byte Yes  -1.79769313486231E308 to

-4.94065645841247E-324 for negative values and 
4.94065645841247E-324 to 1.79769313486232E308 for positive 
values

String 1 to 
255 byte

––––  

DateTime 8 Byte –––– 1.1.1970 00:00:00 up to 31.12.2037 23:59:59
 

 Note
Data types for third-party PLCs

Data types in third-party PLCs may differ from those in WinCC. 

Note the the tag definition of the third-party PLC for the correct assignment.
 

 Note

It is not possible to access array tags from an HTTP client.

Multiplex tags are not supported by the HTTP protocol. If you need a multiplex tag, you must 
configure it on the HTTP client. You will have to create the tags for the multiplex list on the 
server and the client and then connect them. You will then add these tags to the multiplex 
list on the client. 

Address multiplex tags are not supported by the HTTP protocol.
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10.11.13 Communication via OPC

10.11.13.
1

Communication via OPC

Introduction
This section describes the communication between an HMI device and a device via OPC.   

In this case, the HMI device is the OPC client and the device is the OPC server.

For more detailed information on OPC and on configuring OPC servers, refer to Section 
"OPC (Page 7552)".

10.11.13.
2

Configuring a connection via OPC

Introduction
You configure a connection to a device via OPC in the "Connections" editor of the HMI 
device.       

Requirements
● A project is open.

● An HMI device has been created.

● An entry has been stored for the HMI device in the OPC XML Manager.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click "Runtime settings".

3. Select the function "Operate as OPC server" under "Services > Services in runtime".

4. Double-click on the "Connections" entry in the project tree.

5. Double-click "<Add>" in the "Connections" editor.

6. In the "Communication drivers" column, select the "OPC" driver.
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7. Select the "OPC" interface for the HMI device under "Parameters > Interface".

8. Select an OPC server from the tree view under "Parameters > OPC servers".
The OPC server is entered in the "Name of OPC server" field.
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10.11.13.
3

Performance features of communication

Permitted data types for OPC DA

Permitted data types for connections with OPC DA
The table lists the user data types that can be used when configuring tags.     

Data type Length
VT_BOOL 1-bit
VT_I1 1 byte
VT_UI1 1 bytes
VT_I2 2 bytes
VT_UI2 2 bytes
VT_I4 4 bytes
VT_UI4 4 bytes
VT_R4 4 bytes
VT_R8 8 bytes
VT_BSTR --
VT_DATE 8 bytes
VT_DATE|VT_ARRAY --
VT_I1|VT_ARRAY --
VT_UI1|VT_ARRAY --
VT_I2|VT_ARRAY --
VT_UI2|VT_ARRAY --
VT_I4|VT_ARRAY --
VT_UI4|VT_ARRAY --
VT_R4|VT_ARRAY --
VT_R8|VT_ARRAY --
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Permitted data types for OPC XML DA

Permitted data types for connections with OPC DA XML
The table lists the user data types that can be used when configuring tags.     

Data type Length
boolean 1-bit
byte 1 byte
unsignedByte 1 byte
short 2 bytes
unsignedShort 2 bytes
int 4 bytes
unsignedInt 4 bytes
float 4 bytes
double 8 bytes
string --
dateTime --
time --
date --

 

 

Permitted data types for OPC UA

Permitted data types for connections with OPC UA
The table lists the user data types that can be used when configuring tags.     

Data type Length
Boolean 1-bit
SByte 1 byte
Byte 1 byte
Int16 2 bytes
UInt16 2 bytes
Int32 4 bytes
UInt32 4 bytes
Float 4 bytes
Double 8 bytes
String --
DateTime --
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10.11.13.
4

Performance features of communication

Permitted data types for OPC DA

Permitted data types for connections with OPC DA
The table lists the user data types that can be used when configuring tags.     

Data type Length
VT_EMPTY --
VT_BOOL 1-bit
VT_I1 1 byte
VT_UI1 1 byte
VT_I2 2 bytes
VT_UI2 2 bytes
VT_I4 4 bytes
VT_UI4 4 bytes
VT_R4 4 bytes
VT_R8 8 bytes
VT_BSTR --
VT_DATE|VT_ARRAY --
VT_I1|VT_ARRAY --
VT_UI1|VT_ARRAY --
VT_I2|VT_ARRAY --
VT_UI2|VT_ARRAY --
VT_I4|VT_ARRAY --
VT_UI4|VT_ARRAY --
VT_R4|VT_ARRAY --
VT_R8|VT_ARRAY --

 

 

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6603



Permitted data types for OPC XML DA

Permitted data types for connections with OPC XML DA
The table lists the user data types that can be used when configuring tags.     

Data type Length
boolean 1-bit
byte 1 byte
unsignedByte 1 byte
short 2 bytes
unsignedShort 2 bytes
int 4 bytes
unsignedInt 4 bytes
float 4 bytes
double 8 bytes
string --
base64Binary --
ArrayOfByte --
ArrayOfShort --
ArrayOfInt --
ArrayOfUnsignedInt --
ArrayOfLong --
ArrayOfUnsignedLong --
ArrayOfFloat --
ArrayOfDecimal --
ArrayOfDouble --
ArrayOfBoolean --
ArrayOfString --
ArrayOfDateTime --
ArrayOfAnyType --

10.11.14 Communication via routing

10.11.14.
1

Communication via routing

Introduction
If all stations in an automation system are not connected to the same subnet, these stations 
cannot be accessed directly online. 
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A connection between partners in different subnets is only possible via routing. 

You configure the routing settings with the properties of the interfaces.

Communication from connection partners in various different subnets can be routed via the 
following links: 

● PROFINET

● PROFIBUS 

● MPI

Requirements for routing
To establish a connection to these devices, a router must be interposed. In this case, a 
SIMATIC station can also act as a router if it has appropriate interfaces with the different 
subnets. 

Modules with communication capability (CPUs or CPs) used to establish gateways between 
the subnetworks must have routing capability.

A connection between partners in different subnets is only possible with IP routing. The routing 
settings can be edited in the corresponding interface properties.

Routing path
The routing path is determined in Runtime by the system and cannot be influenced by the user. 
During configuration, it is not possible to generate information about a faulty connection. 

HMI devices as routers
Only SIMATIC PCs or PC stations can be used as a router. 

All other HMI devices from the "HMI" area cannot be used as a router. 
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10.11.14.
2

Example for communication via routing

Communication via routing
Illustration of a hardware configuration with a routing connection

In the figure above, a routing connection has been established between an HMI device and 
the SIMATIC S7-300 controller. 

The SIMATIC S7-400 automation device serves as a router. 

A routing connection can be made directly in integrated projects. The communication partners 
are connected in the "Devices and Networks" editor. 

You configure the parameters of the connection and interface in the Inspector window.
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10.11.14.
3

Configuring communication via routing

Introduction
The following configuration describes a network for the following communication partners:

● KTP1000 Basic PN

● SIMATIC S7-400 with PROFINET and PROFIBUS interface

● SIMATIC S7-300 with PROFIBUS interface

Requirements
● KTP1000 Basic PN is connected via PROFINET to the SIMATIC S7-400.

● SIMATIC S7-400 is connected via PROFIBUS to the SIMATIC S7-300.

Procedure
1. Click on the PROFINET interface of the HMI device.

2. In the Inspector window, click "Properties > General > Ethernet addresses".
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3. Click "Use router" in the "IP protocol" area.

4. Enter the IP address of the router in the "Router address" field.

10.11.15 PROFINET IO and IRT

10.11.15.
1

PROFINET IO

What is PROFINET IO?

PROFINET IO  
PROFINET is an Ethernet-based automation standard of PROFIBUS Nutzerorganisation e.V. 
(PNO) which defines a manufacturer-neutral communication, automation and engineering 
model.
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Objective
The objective of PROFINET is:

● Integrated communication via field bus and Ethernet

● Open, distributed automation

● Use of open standards

Architecture
The PROFIBUS User Organisation e.V. (PNO) has designated the following aspects for 
PROFINET architecture:

● Communication between controllers as components within distributed systems.

● Communication between field devices, such as I/O devices and drives.

Implementation by Siemens
The demand for "Communication between controllers as components within distributed 
systems" is implemented by "Component Based Automation" (CBA). Component Based 
Automation is used to create a distributed automation solution based on prefabricated 
components and partial solutions. 

The demand for "Communication between field devices" is implemented by Siemens with 
"PROFINET IO". Just as with PROFIBUS DP, the complete configuration and programming 
of the components involved is possible using the Totally Integrated Automation Portal. 

The following sections deal with the configuration of communication between field devices 
using PROFINET IO.

PROFINET IO systems

PROFINET IO system
A PROFINET IO system is comprised of a PROFINET IO controller and its assigned 
PROFINET IO devices. 

● A PROFINET IO controller is a PLC that controls the automation task.
Example: SIMATIC S7 1500 PLC

● A PROFINET IO device is a device that is controlled by an IO controller.
Examples: HMI device TP 1200 Comfort, a head module of the distributed IO family ET 
200S

As soon as you connect an IO controller to an IO device, a controller-device link is established.
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10.11.15.
2

IRT communication

Introduction: Isochronous Realtime Ethernet

Introduction: Isochronous Realtime Ethernet
IRT is a transmission method by which PROFINET devices are synchronized with very high 
accuracy. 

A sync master specifies the clock to which sync slaves are synchronized. An IO controller or 
an IO device can have the role of sync master. 

Sync master and sync slaves are always devices in a sync domain. Bandwidth is reserved 
within the sync domain for IRT communication. Real-time and non-real-time communication 
(TCP/IP communication) is possible outside of the reserved bandwidth.

Time ranges of communication cycles
The communication cycle is divided into three time ranges, which are represented in the 
following chart:
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● IRT data (synchronized communication)
This area can be reserved in specific steps, depending on the send clock. Within this time 
range the IRT data is transmitted. 

● RT data (real-time communication)
In this time range the cyclic RT date is transmitted. RT data has a higher priority than 
"normal" TCP/IP data. TCP/IP data or Ethernet frames can have a priority between 1 and 
7. RT data has a priority of 6. 

● TCP/IP data (standard communication)
Standard communication (TCP/IP, etc.) is transmitted in the remaining interval of the 
communication cycle.

Applications of IRT
PROFINET with IRT is especially suited for:

● High performance and deterministics for large quantity structures with regard to user data 
communications (productive data)

● High performance even with many devices in the line topology with regard to user data 
communications (productive data). 

● Parallel transmission of production and TCP/IP data over wire, and securing the forwarding 
of production data when data volume is high by reserving transmission bandwidth.

Overview of RT classes

RT classes in PROFINET IO     
PROFINET IO is a scalable, real-time communication system based on Ethernet technology. 
The scalable approach is reflected in several real-time classes:

● RT: Transmission of data in prioritized, non-isochronous Ethernet frames. The required 
bandwidth is within the free bandwidth area for TCP/IP communication.

● IRT: Isochronous transmission of data with high stability for time-critical applications (for 
example, motion control). The required bandwidth is from the area of bandwidth reserved 
for cyclic data.

Device dependency
Depending on the device, not all real-time classes are supported. 

You can find further information on device dependency here: Auto-Hotspot 
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Basic procedures for configuring IRT

Basic procedures for configuring IRT
If you want to upgrade equipment with PROFINET IO to IRT, follow these three steps: 

1. Configure the PROFINET IO device. The PROFINET device must support IRT.

2. Set which device acts as the sync master and synchronizes the other devices. For this you 
must configure a sync domain with a sync master and at least one sync slave.

3. Download the configuration to all involved devices.

You can find further information on IRT configuration here: Auto-Hotspot 

Creating PROFINET IO configuration for IRT
As a prerequisite for IRT configuration, there must be an existing PROFINET IO configuration, 
i.e., one or more stations must be configured with an IO controller and IO devices.

You can read which components are suitable for IRT communication in the task card 
"Information", once you have selected the corresponding components in the hardware catalog.

The requirements for functioning IRT communication are met simply by configuring a 
PROFINET IO system with components that support IRT.

Sync domain

Sync domain
A sync domain is required for synchronization of PROFINET IO devices. The sync domain 
assures that all devices belonging to it communicate synchronously.

Prerequisite for IRT communication is a synchronization cycle to distribute a common time 
base for all PROFINET devices in a sync domain. With this base synchronization, a 
synchronous transmission cycle of PROFINET devices within a sync domain is achieved. The 
sync master (usually an IO controller) generates the common synchronization clock and 
specifies the time basis on which all other sync slaves (usually IO devices) are synchronized.

If the sync master fails, the communication between the IRT devices reverts to RT 
communication. 

Background processes during configuration of an IO system
If you configure an IO controller and network it with an Ethernet subnet, it will automatically be 
added to the default sync domain of the Ethernet subnet. The default sync domain is always 
available. The IO controller operates unsynchronized. 

If you assign an additional IO device to the IO system of the IO controller, the IO device 
automatically assigns the IO controller's sync domain. 
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10.11.15.
3

Configuring the HMI device as IO device

Introduction
An IO controller and at least one PROFINET IO device are necessary for a PROFINET IO 
system.

Requirements
● A SIMATIC S7 1200 or SIMATIC S7 1500 PLC has been created.

● An HMI device from the Comfort Panels device family has been created.

● The "Devices & Networks" editor is open.

Procedure
1. You network the PLC with the HMI device:

2. Click the HMI device in the "Devices & Networks" editor.

3. In the inspector window, you select the following:
"General > PROFINET Interface (X1) > Operating mode"

4. Select the "IO device".

5. You assign the parameters required for your PROFINET IO system
You can find further information on the parameters for PROFINET IO systems here: Auto-
Hotspot 
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10.11.15.
4

Parameters for PROFINET IO and IRT

I-device communication

I-device
The "I-device" functionality (intelligent IO device) of a CPU allows data to be exchanged with 
an IO controller and therefore to use the CPU, for example, as an intelligent preprocessing 
unit of subprocesses. The I-device is linked as an IO device to a "higher-level" IO controller.

Parameters for I-device communication

● Transfer areas
Display transfer areas of the I-device communication

● Diagnostics address of communication
Display of diagnostic data of the IO device

Configuring an I-device with a GSD file
If you use an I-device in another project, or if the I-device is used in another engineering system, 
then configure the higher-level IO controller and the I-device as described above.
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However, click on the "Export" button after configuring the transfer areas in order to create a 
GSD file from the I-device. This GSD file represents the configured I-device in other projects. 

The "Export" button is found in the "I-device communication" section of the inspector window. 

The hardware configuration is compiled and the export dialog opened. 

Assign a name for the I-device proxy as well as a description in the fields provided. Click the 
"Export" button to complete your process. 

Finally, import the GSD file, for example, into another project. 

Real-time settings

Parameters for real-time settings
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● Update time

– Display of update time used in network.

– Selection of update times available in network.

● Watchdog time

– Selection of available update cycles.

– Display of watchdog time used in network.

● Synchronization

– Display of sync domain used

– Selection of RT class.

– Selection of role in the sync domain.

10.11.15.
5

Performance features of PROFINET IO and IRT

Configuration of PROFINET and IRT

Setting up PROFINET with IRT
Keep in mind the following rules for the set up and operation of a PROFINET IO system in IRT 
operation. They serve to insure an optimal operation of your PROFINET IO system.

● When using IRT, you must configure the topology. This will enable exact calculation of the 
update time, bandwidth, and additional parameters. 

● If you would like to use multiple sync domains, configure a sync domain boundary for the 
port which is currently connected to the PROFINET device of another sync domain.

● In a sync domain you can only configure one sync master at a time.

● A PROFINET IO system may only be part of a single sync domain.

● If you configure a PROFINET device in a sync domain and want to synchronize with IRT, 
the PROFINET devices concerned must support IRT communication.

● Wherever possible, use the same PROFINET device as the PROFINET IO controller and 
sync master. 

● If only some of the PROFINET devices in a PROFINET IO system are synchronized, please 
keep in mind the following: PROFINET devices which are not part of IRT communication 
are placed outside of the sync domain.
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Device dependency 

IRT communication
The following HMI devices support IRT communication:

● TP700 Comfort and KP700 Comfort

● TP900 Comfort and  KP900 Comfort

● TP1200 Comfort and KP1200 Comfort

● TP1500 Comfort and KP1500 Comfort

● TP1900 Comfort

● TP2200 Comfort 

Communication options
The following configuration options are available for Comfort Panels:

● Comfort Panel with PROFINET Basis functionality without PROFINET IO

● Comfort Panel with PROFINET RT in an RT network networked with an RT controller

● Comfort Panel with PROFINET RT as end point in an IRT network networked with an RT 
controller

● Comfort Panel with PROFINET IRT in an IRT network networked with an IRT controller

10.11.16 Media redundancy

10.11.16.
1

Media redundancy

Media redundancy options  
To increase the network availability of an industrial Ethernet network with optical or electrical 
line topology, the following options are available:

● Meshing networks

● Parallel switching of transmission modes

● Consolidation of a line topology to a ring topology

Media redundancy in ring topologies
Devices in ring topologies can be the external switches and/or integrated switches of 
communication modules.

To set up a ring topology with media redundancy you must join both free ends of a line-shaped 
network topology to one device. 
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Consolidation of a line topology to a ring takes place over 2 ports (ring ports) in a device in the 
ring. 

This device is the redundancy manager. All other devices in the ring are the redundancy clients.

The following figure shows the ring type interconnection:

The two ring ports in a device are the ports which create the connection to both of its 
neighboring devices in a ring topology. 

The selection and set up of the ring ports takes place during configuration of the respective 
device.

Download the configuration in the individual devices before physically connecting the ring.

Functions of media redundancy in a ring topology
If a part of the ring is disconnected, then the data paths between the individual devices is 
automatically reconfigured. After the reconfiguration the devices are once again accessible in 
the newly created topology.

In the redundancy manager, 2 ring ports will be separated from each other during interruption-
free network operation, so that no data frames circulate. 

The ring topology is a line when viewed from the standpoint of data transfer. The redundancy 
manager monitors the ring topology. To do so it sends a test frame not only from ring port 1 
but also from ring port 2. The test frame passes through the ring in both directions until it arrives 
at the other ring port on the redundancy manager.

An interruption in the ring can occur from connection failure between two devices or device 
failure in the ring.

If the redundancy manager's test telegram does not reach the other ring port because of 
interruption in the ring, the redundancy manager connects via both ports. 

With this alternate route a functioning connection is again created among all remaining devices 
in a line-shaped topology.

The time between ring interruption and re-establishment of a functional line topology is called 
the reconfiguration time.

As soon as the interruption is eliminated, the original transmission route is again created, both 
ring ports in the redundancy manager are separated from each other, and the redundancy 
clients are notified of the change. 
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The redundancy clients then use the new route to the other devices.

If the redundancy manager fails, then the ring is changed to a functional line.

10.11.16.
2

Media Redundancy Protocol (MRP)

Media Redundancy Protocol (MRP)  
The MRP process works in conformity with Media Redundancy Protocol (MRP), which is 
specified in IEC 61158 Type 10 "PROFINET".

The reconfiguration time following an interruption of the ring amounts to a maximum of 0.2 
seconds.

Requirements for trouble-free operation
Requirements for trouble-free operation with media redundancy process MRP are:

● MRP is supported in ring topologies of up to 50 devices. Exceeding the device limit can 
lead to data traffic failure.

● All devices must be connected to each other via their ring ports.

● "MRP" must be activated on all devices in the ring.

● The connection settings (transfer medium / duplex) must be set to full duplex and for at 
least 100 Mbit/s for all ring ports. Otherwise data traffic failure can occur.

● In STEP 7 configuration in the properties dialog for all ports in the ring, set the connection 
in the register "Options" to "Automatic settings".

HMI devices for media redundancy
The following HMI devices support "Media Redundancy":

● KP700 Comfort

● TP700 Comfort

● KP900 Comfort

● TP900 Comfort

● KP1200 Comfort

● TP1200 Comfort

● KP1500 Comfort

● TP1500 Comfort

● TP1900 Comfort

● TP2200 Comfort
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10.11.16.
3

Configuring media redundancy for HMI devices 

Requirements        
● The participating components must support "media redundancy".

● IRT communication is not configured

● One device on the network must be configured as "Redundancy manager".

● A ring topology is set up by means of port interconnections.

Procedure
1. Click on the PROFINET interface of an HMI device.

2. Select "General > Advanced settings > Media redundancy" in the properties.

3. Select "Client" in the "Media redundancy role" area.
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Result
The HMI device is now operating as client on the MRP network.

The default ring ports will automatically be displayed in the subjacent fields.

10.11.16.
4

Parameters for media redundancy

 

MRP domain
This area displays the MRP domain. 

You can rename the MRP domain in the "Domain settings" dialog. 

Domain settings
Click "Domain settings" to open the "Domain settings" editor.

You also manage the MRP domains in the MRP domain area of the "Domain settings" editor.

Media redundancy role
Assign the role of the HMI device in the "Media redundancy role" area. 

You have the following options:

● Client
The HIM device is operated as "Client" in an MRP domain.

● Not a node of the ring
The HIM device is not operated within an MRP domain.

Ring port 1 and Ring port 2
Display of available ring ports
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Diagnostic interrupts
The following diagnostic interrupts can be generated if "Diagnostic interrupts" is activated:

● Wiring or port error
Diagnostics interrupts will be generated for the following errors in the ring ports:

– A neighbor of the ring port does not support MRP

– A ring port is connected to a non-ring port

10.11.16.
5

Managing MRP domains

You can monitor and adjust the media redundancy settings centrally.

Requirements        
The devices are configured and networked.

Procedure
1. Select the PROFINET interface of the HMI device.

2. Select the "Advanced options > Media redundancy" area in the Inspector window.
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3. Click the "Domain settings" button.

4. Navigate to the "Domain management > MRP domains" area in the Inspector window.

MRP domains
You can specify the default MRP domain in the "MRP domains" area.

You can rename all domains and check the redundancy roles and ring ports. 

For each MRP domain, you receive an overview of how many PROFINET interfaces are 
interconnected in the ring, how many PROFINET interfaces are located outside the ring, and 
the number of redundancy managers and redundancy clients.

You can have the devices in the ring, including device name, associated MRP domain, media 
redundancy role, and utilized ring ports, displayed in groups: 

● IO systems
The list shows you all configured devices of the selected IO system. 

● Rings
The list shows you all ring interconnections of the selected IO system. The identified rings 
are numbered consecutively. If all devices of this ring belong to one MRP domain, this is 
also displayed. 

● MRP domain
The list shows you the existing MRP domains of the selected IO system.
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10.11.16.
6

Restrictions with media redundancy

Diagnostic interrupts
If you have activated "Diagnostic interrupts", diagnostic interrupts pertaining to "Media 
redundancy" are only processed by PROFINET-compatible devices and displayed on the "IO 
Controller". 

If you do not use a PROFINET-compatible device, the "Diagnostic interrupts" selection does 
not have any function.

Diagnostic interrupts are only detected by the IO controller. There is no separate diagnostic 
interrupts for HMI devices that are detected and displayed by HMI devices.

10.11.17 Communication with other PLCs

10.11.17.
1

Communication with other PLCs

Introduction
Communication with other PLCs is communication with PLCs that are not in the SIMATIC 
family.       

These PLCs have proprietary protocols for data exchange. The protocols are configured as 
communication drivers in WinCC.

Communication drivers
The following communication drivers are supported in WinCC and are already installed:

● Allen-Bradley

– Allen-Bradley EtherNet/IP

– Allen-Bradley DF1

● Mitsubishi

– Mitsubishi MC TCP/IP

– Mitsubishi FX

● Modicon Modbus

– Modicon Modbus TCP/IP

– Modicon Modbus RTU

● Omron

– Omron Host Link
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Communication drivers in WinCC RT Professional
The following communication drivers are supported for RT Professional:

● Allen-Bradley

– Allen-Bradley EtherNet/IP

● Mitsubishi

– Mitsubishi MC TCP/IP

● Modicon Modbus

– Modicon Modbus TCP

Connections between HMI devices and other PLCs
You configure the connections between HMI devices and other PLCs in the "Connections" 
editor of the HMI device. These connections are non-integrated connections.

10.11.17.
2

Distinctive features when configuring

Distinctive features for data exchange
Distinctive features apply when configuring connections to other PLCs, compared to 
configuring integrated connections.

Note the following distinctive features when configuring:

● Addressing of tags

● Permitted data types

● Distinctive features when configuring area pointers

● Distinctive features when configuring alarms

● Distinctive features when configuring trends

For more detailed information on distinctive features when configuring, refer to Section "Data 
exchange" of the respective communication driver.
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10.11.17.
3

Parallel communication 

Parallel communication of communication drivers 
The following table shows an overview of which communication drivers you can use 
simultaneously on one HMI device. 

 

 Note

Parallel communication is not approved for Basic Panels.
 

Parallel communication over Ethernet interfaces
The approved combinations can be operated via the same Ethernet interface. Several Ethernet 
interfaces are not required.

Parallel communication only concerns the Ethernet-based communication drivers.

 Allen-
Bradley
 
EtherN
et/IP

Mitsubi
shi MC 
TCP/IP

Modico
n 
Modbu
s 
TCPIP

OPC 
(DA/
XML 
DA)

OPC 
UA 
(DA)

SIMAT
IC 
LOGO
!

SIMAT
IC S7 2
00

SIMATI
C S7 30
0/400

SIMATI
C S7 12
00

SIMATI
C S7 
1500

SIMATI
C 
HTTP 
protoco
l

Sinume
rik NC

Allen-
Bradley
 
EtherN
et/IP

-- No No Yes Yes Yes Yes Yes Yes Yes Yes Yes

Mitsubi
shi MC 
TCP/IP

No -- No Yes Yes No No No No No Yes No

Modico
n 
Modbu
s 
TCPIP

No No -- Yes Yes No No No No No Yes No

OPC 
(DA/
XML 
DA)

Yes Yes Yes -- Yes Yes Yes Yes Yes Yes Yes Yes

OPC 
UA 
(DA)

Yes Yes Yes Yes -- Yes Yes Yes Yes Yes Yes Yes

SIMATI
C 
LOGO!

Yes No No Yes Yes -- Yes Yes Yes Yes Yes Yes

SIMATI
C S7 20
0

Yes No No Yes Yes Yes -- Yes Yes Yes Yes Yes
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 Allen-
Bradley
 
EtherN
et/IP

Mitsubi
shi MC 
TCP/IP

Modico
n 
Modbu
s 
TCPIP

OPC 
(DA/
XML 
DA)

OPC 
UA 
(DA)

SIMAT
IC 
LOGO
!

SIMAT
IC S7 2
00

SIMATI
C S7 30
0/400

SIMATI
C S7 12
00

SIMATI
C S7 
1500

SIMATI
C 
HTTP 
protoco
l

Sinume
rik NC

SIMATI
C S7 30
0/400

Yes No No Yes Yes Yes Yes -- Yes Yes Yes Yes

SIMATI
C S7 12
00

Yes No No Yes Yes Yes Yes Yes -- Yes Yes Yes

SIMATI
C S7 
1500

Yes No No Yes Yes Yes Yes Yes Yes -- Yes Yes

SIMATI
C 
HTTP 
protoco
l

Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes -- Yes

Sinume
rik NC

Yes No No Yes Yes Yes Yes Yes Yes Yes Yes --

Parallel communication over serial interfaces
The following applies for parallel communication over serial interfaces:

● One communication driver per interface.

● One interface per communication driver.

10.11.17.
4

Communication drivers

Allen-Bradley

Allen-Bradley communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use Allen-
Bradley communication drivers.    

The following communication drivers are supported:

● Allen-Bradley EtherNet/IP

● Allen-Bradley DF1
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Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.

Allen-Bradley EtherNet/IP

Configuring a connection via Allen-Bradley EtherNet/IP

Introduction
You configure a connection to a PLC with an Allen-Bradley EtherNet/IP communication driver 
in the "Connections" editor of the HMI device. 

The Ethernet interfaces are named differently depending on the HMI device. 

Example: PROFINET interface corresponds to the Ethernet interface      

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Allen-Bradley EtherNet/IP" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Allen-Bradley EtherNet/IP)

Parameters to be set
To assign the connection parameters, such as addresses and profiles, click the connection 
that you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "PLC" area is available for assigning parameters according to the interface 
used. 
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Parameters for the HMI device
You can select only one interface for the HMI device in the Inspector window under 
"Parameters". Depending on the HMI device, there are several interfaces available.

If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. The IP address is transferred to the HMI device upon 
subsequent loading. 

 

 Note

The IP address in the control panel will be overwritten upon subsequent loading if you have 
already set up the IP address in the HMI device control panel.

The IP address already set up in the control panel will be retained upon subsequent loading 
if you activate "Set IP address using a different method".

 

To set up the IP address of the HMI device:

1. Click on the HMI device.

2. Open the "Device configuration" editor.
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3. Click the Ethernet interface.

4. Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

Parameters for the PLC
● CPU type

For "CPU type", set the CPU type of the PLC used.

● IP address
Set the IP address or host name of the Ethernet/IP module of the PLC. Only the IP address 
can be used on a Basic Panel.

● Communication path
Set the CIP path from the Ethernet module to the PLC. This establishes a logical connection 
between the Ethernet module and PLC, even if both devices are located in different CIP 
networks.
For additional information see: Examples: Communication path  

Connecting HMI device to PLC

Connections via Allen-Bradley EtherNet/IP

Connection
The HMI device can be connected to the Allen-Bradley PLC using the following components:   

● Existing Ethernet network that also contains the PLCs

● Cross-over Ethernet cable connected directly to the Ethernet interface of the CPU or the 
communication module

The connection of the HMI device to an Allen-Bradley PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the PLC.

Communication types 

Approved communication types with Allen-Bradley EtherNet/IP
The following communication types are system-tested and approved: 

● Point-to-point connection to the approved PLCs

● Multipoint connection from a HMI device (Allen-Bradley Ethernet/IP-Client) with up to 4 
PLCs with the respectively approved PLCs. CPU types can be mixed.
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Connection
Connection with the following PLCs is approved with Allen-Bradley EtherNet/IP:

● CPU type: "ControlLogix, Compact Logix"

– ControlLogix
556x(1756-L6x) with Ethernet module 1756-ENBT

– Guard Logix-System ControlLogix
556xS(1756-L6xS) with Ethernet module 1756-ENBT

– CompactLogix

– 533xE(1769-L3xE) with Ethernet interface onboard

– 532xE(1769-L2xE) with Ethernet interface onboard

– 534x (1768-L4x) with Ethernet module 1768-ENBT

● CPU type: "SLC, MicroLogix"

– MicroLogix 1100 (with Ethernet interface onboard)

– MicroLogix 1400 (with Ethernet interface onboard)

– SLC 5/05 (with Ethernet interface onboard)

Performance features of communication

Permitted data types for Allen-Bradley EtherNet/IP

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

CPU type: ControlLogix, CompactLogix 

Data type Length
Bool 1 bit
DInt 4 bytes
Int 2 bytes
Real 4 bytes
SInt 1 byte
String 1 to 80 characters
UDInt 4 bytes
UInt 2 bytes
USInt 1 byte

Permitted data types arrays
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Address Permitted data types
Array SInt, USInt, Int, UInt, DInt, UDInt, Real
Individual bits from the basic data types of 
the PLC SInt, USInt, Int, UInt, DInt, UDInt 

Bool*

* Any changed value of certain defined bits is written back to the PLC. There is no check to 
determine whether any other bits have changed. The PLC (or other PLCs) may only read 
access the value.

CPU type: SLC, MicroLogix 

Data type Operand type Length
ASCII A 0 to 80 characters
Bool N, R, C, T, B, S, I, O 1 bit
DInt N 4 bytes
Int N, R, C, T, S 2 bytes
Real N, F 4 bytes
String ST 1 to 82 characters
UDInt N 4 bytes
UInt N, R, C, T, B, I, O 2 bytes

Permitted data types arrays

Address Permitted data types
Array Int, UInt, DInt, UDInt, Real

Distinctive features for connections with Allen-Bradley Ethernet/IP
With the communication driver Allen Bradley Ethernet/IP and the CPU type SLC, MicroLogix, 
you can only use array tags for discrete alarms and trends. 

 

 Note

I/O modules with 8 or 16 ports occupy one data word on the PLC.

I/O modules with 24 or 32 ports occupy two data words. 

The HMI device does not output an error message if using non-existent bits.

You should always make sure that I/O modules with 8 or 24 ports only occupy the bits that 
are actually assigned to a port.
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Supported CPU types for Allen-Bradley EtherNet/IP

CPU types
The following CPU types are supported for configuring the Allen-Bradley EtherNet/IP 
communication driver.     

● CompactLogix

– 1769-L2xE with Ethernet interface onboard

– 1769-L3xE  with Ethernet interface onboard

– 1768-L4x with Ethernet module 1768-ENBT

● ControlLogix

– 1756-L6x  with Ethernet module 1756-ENBT

● GuardLogix

– 1756-L61S  with Ethernet module 1756-ENBT

– 1756-L62S  with Ethernet module 1756-ENBT

– 1756-L63S  with Ethernet module 1756-ENBT

● MicroLogix

– MicroLogix 1100 / 1400

● SLC50x

– SLC5/05

Addressing in the CompactLogix, ControlLogix CPU type

Addressing

Addressing
A tag is uniquely referenced in WinCC by means of an address in the PLC. The address must 
correspond with the tag name in the PLC. The tag address is defined by a string with a length 
of up to 128 characters.     

Using characters for addressing
Valid characters for tag addressing:

● Letters (a to z, A to Z)

● Numbers (0 to 9)

● Underscore ( _ )

The tag address consists of tag name and other character strings used to specify the tag in 
the PLC.
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Tag name properties:

● The tag name may begin but not end with an underscore character.

● Strings with successive underscore and space characters are invalid.

● The address may not exceed a length of 128 characters.
 

  Note

The characters reserved for tag addressing may not be used in program/tag names or at 
any other address instance.

 

The reserved characters are listed below:

Reserved character Function
. Element delimiter
: Definition of a program tag
, Delimiter for addressing multi-dimensional arrays
/ Reserved for bit addressing.
[ ] Addressing of array elements or arrays

PLC and program tags
The Allen-Bradley EtherNet/IP communication driver supports addressing of PLC tags (global 
project tags) and/or program tags (global program tags). 

A program tag is declared based on the program name in the PLC and actual tag name which 
are delimited by colon. PLC tags are simply addressed by their name.

 

 Note
Addressing errors

Addressing errors occur when the tag name and data type are inconsistent.

Note that the tag name defined in the address field in WinCC must match the tag name in 
the PLC. Make sure that the data types of tags in WinCC match the data types in the PLC.

 

 Note

Module-specific tags, e.g. for data on input and output modules, cannot be addressed directly. 
Instead, use an alias tag in the PLC.

Example: Local:3:O. Data cannot be addressed in WinCC. 

If the alias "MyOut" is defined for Local:3:O in the PLC, you can address with WinCC via 
MyOut.Data. 
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Addressing syntax

Notation of addresses
The tables below define the notation for the individual addressing options for Allen-Bradley 
EtherNet/IP. 

Table 10-162 Access to arrays, basic data types and structure elements

Data types Type Address
Basic data types PLC tag Tag name

Program tag Programname:tagname
Arrays PLC tag Array tag

Program tag Program name: array tag
Bits PLC tag Tagname/bitnumber

Program tag Programname:tagname/bitnumber
Structure elements PLC tag Structure tag. Structure element

Program tag Program name: structure tag. structure element
 

 Note

Bit addressing with the data types Bool, Real and String is not permitted and will cause an 
addressing fault.

 

Description of the syntax
Syntax description:

 (Programname:)tagname([x(,y)(,z)]){.tagname([x(,y)(,z)])}(/
bitnumber)
● The "( )" defines an optional, single instance of an expression.

● The "{ }" defines an optional expression with multiple single instances.

The address string length may not exceed 128 characters.

Addressing types

Arrays
An array is a data structure that includes a number of data of the same type. WinCC only 
supports one-dimensional arrays.  

In the address column of the tag editor, enter the array name possibly by specifying a start 
element. The length is defined in the Array Elements input box of the tag editor. If array limits 
in the PLC are exceeded (due to faulty indexing), addressing errors result.

These arrays must be declared in the PLC as controller or program tags.
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Two- or three-dimensional arrays in the PLC can only be addressed in WinCC if these can be 
mapped area-wise onto one-dimensional arrays .

 

 Note

During all read accesses and all write accesses, all array elements of a tag are always read 
or written, respectively. The contents of an array tag which is interconnected with a PLC are 
always transferred whenever there is a change. The HMI device and the PLC cannot 
concurrently write data to the same array tag for this reason. Instead of writing data only to 
a single element, the program writes the entire array to the PLC.

 

Array elements
Elements of one-dimensional, two-dimensional and three-dimensional arrays in the PLC are 
indexed by setting an index and the corresponding notation in the tag editor. Array addressing 
starts at element "0", with arrays of all basic types being valid for element addressing. Read/
write operations are only carried out at the addressed element, and not for the entire array.

Bits and bit tags
Bit access is allowed to all basic data types with the exception of Bool, Real and String. Bit 
addressing is also allowed at array/structure elements. The Bool data type is set in WinCC 
when bits and bit tags in the basic data types are addressed. 

Single-digit bit numbers are addressed with "/x" or "/0x" (x = bit number). Bit numbers are 
defined by up to two digits.

 

 Note

With the "Bool" data type in the data types SInt, Int and DInt, after changing the specified bit 
the complete tag is then written in the PLC again. In the meantime, no check is made as to 
whether other bits in the tag have since changed. Therefore, the PLC may have only read 
access to the specified tag.

 

Structures
User-defined data types are created by means of structures. These structures group tags of 
different data types. Structures may consist of basic types, arrays and of other structures. In 
WinCC, only structure elements are addressed and not entire structures.

Structure elements
Structure elements are addressed by means of the name of the structure and of the required 
structure element. This addressing is separated by point. In addition to basic data types, the 
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structure elements may represent arrays or other structures. Only one-dimensional arrays may 
be used as a structure element.

 

 Note

The nesting depth of structures is only limited by the maximum length of 128 characters for 
the address.

 

 

Address multiplexing

Address multiplexing
Address multiplexing is possible with the CompactLogix, ControlLogix CPU type.   

Address multiplexing requires two tags:

● "Tag_1" of data type "String"; contains a logical address such as "HMI:Robot5.Block5" as 
value.
The value may change to a second valid address, for example, "HMI:Robot4.Block3".

● "Tag_2" is a tag in which the "Allen-Bradley EtherNet/IP" communication driver is set up as 
a connection.
Enter a valid name of an HMI_tag in square brackets as the address.

– e.g.: "[Tag_1]"

– The tag must be of the String data type. 

– The square brackets indicate address multiplexing. 

– The address is derived from the actual value in "Tag_1".
 

  Note

You can only multiplex entire Allen-Bradley EtherNet/IP addresses. Multiplexing of 
address elements is not possible. "HMI:Robot[Tag_1].Block5" is an invalid address.

You can optionally click the arrow right icon in the "Address" column. Replace the 
"Constant" with the "Multiplex" entry by clicking the arrow on the left edge of the next 
address dialog box. Now the tag selection list only returns tags of data type "String".

You can also configure a function triggered by a "change of value" event for multiplexed 
tags.

 

Examples for addressing

Example of a table for addressing
The table below defines the basic variants for addressing PLC tags. Other addressing variants 
are possible by means of combination.
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Type Type Address
General PLC tag Tag name

Program tag Program:tagname
Array Access to an element of a 2-

dimensional array
Arraytag[Dim1,Dim2]

Element of structure array (1-
dimensional)

Arraytag[Dim1].structureelement

Bit in element basic type 
array (2-dimensional)

Arraytag[Dim1,Dim2]/Bit

Structure Array in structure Structuretag.arraytag
Bit in the element of an array 
in the substructure

Structuretag.structure2.arraytag [element]/
bit

 

 Note

Program tags are addressed by leading the address with the program name derived from the 
PLC with colon delimiter.

Example: Programname:arraytag[Dim1,Dim2]
 

Access to array elements

Type Address
PLC tag Arraytag[Dim1]

Arraytag[Dim1,Dim2]
Arraytag[Dim1,Dim2,Dim3]

Program tag Programname:arraytag[Dim1]
Programname:arraytag[Dim1,Dim2]
Programname:arraytag[Dim1,Dim2,Dim3]

Examples: Communication path 

Example 1:
Connection with a PLC in the same Allen-Bradley rack.

1,0

Number Meaning
1 Stands for a backplane connection.
0 Stands for a CPU slot number.
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Example 2:
Connection with a PLC in remote Allen-Bradley racks. Two Allen-Bradley racks are networked 
on Ethernet.

1,2,2,190.130.3.101,1,5

Number Meaning
1 Backplane connection
2 Stands for the CPU slot number of the second Ethernet module.
2 Stands for an Ethernet connection.
190.130.3.101 IP address of a remote AB rack on the network – in particular the third Ethernet 

module
1 Backplane connection
5 Slot number of the CPU

Addressing in the SLC, MicroLogix CPU type

Addressing

Addressing
The addressing in the SLC, MicroLogix CPU type is entered in the following order:

● Operand type

● File number

● Element number

● Child element

● Bit number
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The address then appears in the following format without spaces:

● File type file number : Element number . Child element

● e.g. T8:2.ACC

Operand type
You have the following options under operand type:

● I

● O

● S

● B

● C

● T

● R

● F

● N

● ST

● A

File number
Select the number between two limits under file number:

● Low limit

● High limit

The limit values depend on the selected operand type.

Child element
You can select a child element when you have selected one of the following operand types:

● R

● C

● T
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Address areas for PLC, SLC, MicroLogix

SLCMicro
 

Address 
areas

Bool SInt USInt Int UInt DInt UDInt Real String

N N3:0/0 - 
N999:199
9/15

-- -- N3:0 - 
N999:199
9 

N3:0 - 
N999:199
9 

N3:0 - 
N999:199
9 

N3:0 - 
N999:199
9 

N3:0 - 
N999:19
99 

N3:0 - 
N999:199
9 

R R3:0.EN - 
R999:199
9.ER - 
R999:199
9.DN - 
R999:199
9.FD - 
R999:199
9.IN - 
R999:199
9.EU - 
R999:199
9.EM - 
R999:199
9.UL 

-- -- R3:0.LEN 
- 
R999:199
9.POS

R3:0.LEN 
- 
R999:199
9.POS

-- -- -- R3:0.LEN 
- 
R999:199
9.POS

C C3:0.DN - 
C999:199
9.CU - 
C999:199
9.CD - 
C999:199
9.OV - 
C999:199
9.UN

-- -- C3:0.PRE 
- 
C999:199
9.ACC

C3:0.PRE 
- 
C999:199
9.ACC

-- -- -- C3:0.PRE 
- 
C999:199
9.ACC

T T3:0.EN - 
T999:1999
.TT - 
T999:1999
.DN

-- -- T3:0.PRE 
- 
T999:1999
.ACC 

T3:0.PRE 
- 
T999:1999
.ACC 

-- -- -- T3:0.PRE 
- 
T999:1999
.ACC 

B B3:0/0 - 
B999:1999
/15

-- -- B3:0 - 
B999:1999 

B3:0 - 
B999:1999 

-- -- -- B3:0 - 
B999:1999 

S S2:0/0 - 
S2:127/65
535

-- -- S2:0 - 
S2:127 

S2:0 - 
S2:127 

-- -- -- S2:0 - 
S2:127 

I I1:0/0 - 
I999:255/1
5 

-- -- I1:0 - 
I999:255 

I1:0 - 
I999:255 

-- -- -- I1:0 - 
I999:255 

O O0:0/0 - 
O999:255/
15 

-- -- O0:0 - 
O999:255 

O0:0 - 
O999:255 

-- -- -- O0:0 - 
O999:255 
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Address 
areas

Bool SInt USInt Int UInt DInt UDInt Real String

F -- -- -- -- -- F3:0 - 
F999:1999 

F3:0 - 
F999:1999 

F3:0 - 
F999:199
9 

F3:0 - 
F999:1999 

D D3:0/0 - 
D999:199
9/15 

-- -- D3:0 - 
D999:199
9 

D3:0 - 
D999:199
9 

-- -- -- D3:0 - 
D999:199
9 

A A3:0/0 - 
A999:1999
/15

A3:0 - 
A999:1999

A3:0 - 
A999:1999

A3:0 - 
A999:1999 

A3:0 - 
A999:1999 

A3:0 - 
A999:1999 

A3:0 - 
A999:1999 

A3:0 - 
A999:19
99 

A3:0 - 
A999:1999 

ST ST3:0/0 - 
ST999:19
99/15

ST3:0 - 
ST999:19
99

ST3:0 - 
ST999:19
99

ST3:0 - 
ST999:19
99 

ST3:0 - 
ST999:19
99 

ST3:0 - 
ST999:19
99 

ST3:0 - 
ST999:19
99 

ST3:0 - 
ST999:1
999 

ST3:0 - 
ST999:19
99 

PLC5
 

Address 
areas

Bool SInt USInt Int UInt DInt UDInt Real String

N N3:0/0 - 
N999:199
9/15 

-- -- N3:0/0 - 
N999:199
9/15 

N3:0/0 - 
N999:199
9/15 

N3:0/0 - 
N999:199
9/15 

N3:0/0 - 
N999:199
9/15 

N3:0/0 - 
N999:199
9/15 

N3:0/0 - 
N999:199
9/15 

R R3:0.EN - 
R999:199
9.ER - 
R999:199
9.DN - 
R999:199
9.FD - 
R999:199
9.IN - 
R999:199
9.EU - 
R999:199
9.EM - 
R999:199
9.UL 

-- -- R3:0.LEN 
- 
R999:199
9.POS 

R3:0.LEN 
- 
R999:199
9.POS 

-- -- -- R3:0.LEN 
- 
R999:199
9.POS 

C C3:0.DN - 
C999:199
9.CU - 
C999:199
9.CD - 
C999:199
9.OV - 
C999:199
9.UN 

-- -- C3:0.PRE 
- 
C999:199
9.ACC

C3:0.PRE 
- 
C999:199
9.ACC

-- -- -- C3:0.PRE 
- 
C999:199
9.ACC
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Address 
areas

Bool SInt USInt Int UInt DInt UDInt Real String

T T3:0.EN - 
T999:199
9.TT - 
T999:199
9.DN 

-- -- T3:0.PRE 
- 
T999:199
9.ACC

T3:0.PRE 
- 
T999:199
9.ACC

-- -- -- T3:0.PRE 
- 
T999:199
9.ACC

B B3:0/0 - 
B999:199
9/15 

-- -- B3:0 - 
B999:199
9  

B3:0 - 
B999:199
9  

-- -- -- B3:0 - 
B999:199
9  

S S2:0/0 - 
S2:127/65
535

-- -- S2:0 - 
S2:127 

S2:0 - 
S2:127 

-- -- -- S2:0 - 
S2:127 

I I1:0/0 - 
I999:277/1
7 

-- -- I1:0 - 
I999:277  

I1:0 - 
I999:277  

-- -- -- I1:0 - 
I999:277  

O O0:0/0 - 
O999:277/
17 

-- -- O0:0 - 
O999:277 

O0:0 - 
O999:277 

-- -- -- O0:0 - 
O999:277 

F -- -- -- -- -- F3:0 - 
F999:199
9 

F3:0 - 
F999:199
9 

F3:0 - 
F999:199
9 

F3:0 - 
F999:199
9 

D D3:0/0 - 
D999:199
9/15

-- -- D3:0/0 - 
D999:199
9/15

D3:0/0 - 
D999:199
9/15

-- -- -- D3:0/0 - 
D999:199
9/15

A A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

A3:0/0 - 
A999:199
9/15

ST ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

ST3:0/0 - 
ST999:19
99/15

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6646 System Manual, 02/2014



Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

 

  Note

If running the CompactLogix PLC with firmware earlier than version 18, you will possibly 
have to restart the HMI device following the transfer of the PLC program. 

You could also terminate the connection before transferring the PLC program and set up 
the connection again after having completed the transfer of the PLC program.

 

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.
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Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Allen-Bradley DF1

Configuring a connection via Allen-Bradley DF1

Introduction
You configure a connection to a PLC with an Allen-Bradley DF1 communication driver in the 
"Connections" editor of the HMI device.      

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Allen-Bradley DF1" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Allen-Bradley DF1)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.     

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used.
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Parameters for the HMI device
● Interface

Under "Interface", you select the interface of the HMI device to which the PLC is connected.
For additional information, refer to the device manual for the HMI device.

● Type
Specifies the physical connection used.

 

  Note

If you are using the IF1B interface, you must also reconnect the RS-485 receive data and 
the RTS signal to the rear of the HMI devices via 4 DIP switches.

 

● Baud rate
For "Baud rate", select the transmission speed between the HMI device and PLC.

● Data bits
For "Data bits", you can choose between "7 bits" and "8 bits".

● Parity
For "Parity", you can choose from "None", "Even", and "Odd".

● Stop bits
For "Stop bits", you can choose between 1 and 2 bits.
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Parameters for the network
● Checksum

For "Checksum", choose the method for determining the error code: "BCC" or "CRC".

Parameters for the PLC
● Destination address

For "Destination address", choose the PLC address. If there is a point-to-point DF1 
connection, you set the address "0".

● CPU type
For "CPU type", set the CPU type of the PLC used.

 

  Note

Assign the DF1 FULL-DUPLEX driver in the CPU as follows: "NO HANDSHAKING" for 
"Control Line" and "AUTO-DETECT" for "Embedded Responses".

 

Connecting HMI device to PLC

Connections via Allen-Bradley DF1

Connection
The connection is established when you have matched the parameters of the PLC and the 
HMI device. Special blocks for the connection are not required in the PLC.   

 

 Note

Rockwell offers a variety of communication adapters for integrating "DF1 devices" for the 
DH485, DH, and DH+ networks. Of these connections, the direct connection and the 
connection via KF2 and KF3 module are approved. None of the other connections have been 
system-tested by SIEMENS AG and are therefore not approved.

 

Communication types 

PLCs with Allen-Bradley DF1 communication driver
The communication between the HMI device and the following Allen Bradley PLCs is described 
in this section:

● SLC500

● SLC501

● SLC502

● SLC503
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● SLC504

● SLC505

● PLC5

● MicroLogix

In these PLCs the connection is made by the PLC-internal protocols Allen Bradley DF1, Allen 
Bradley DH485 and Allen Bradley DH+. 

The Allen-Bradley DF1 communication driver is used here, the protocol of which is converted 
into one of the other two PLC-internal protocols in multipoint communication with the 
communication modules KF2 (Allen Bradley DH+) and KF3(Allen Bradley DH485). 

Enabled types of communication with Allen-Bradley DF1
The following communication types are system-tested and enabled:

● HMI (Allen Bradley DF1)
Point-to-point connection

● HMI (Allen Bradley DF1)
Via KF2 module to Allen Bradley DH+ (communication with up to 4 PLCs)

● HMI (Allen Bradley DF1)
Via KF3 module to Allen Bradley DH485 (communication with up to 4 PLCs)

Connectable PLCs
The Allen Bradley DF1 communication driver is available for the following Allen-Bradley PLCs: 

PLC

DF1
(point-to-point)

RS 232

DF1
(point-to-point)

RS 422

DF1
(multipoint)

via KF2 module
to DH+ LAN

RS 232/RS 422

DF1
(multipoint)

via KF3 module
to DH485 LAN

RS 232 2) 
SLC500 – – – X
SLC501 – – – X
SLC502 – – – X
SLC503 X 2) – – X
SLC504 X 2) – X X
SLC505 X 2) – – X
MicroLogix X 2) – – X
PLC-5  1) X X X –

1) Only the following processors are approved for PLC-5: PLC-5/11, PLC-5/20, 
PLC-5/30, PLC-5/40, PLC-5/60 und PLC-5/80.

2) For HMI devices which only have an RS 422/485 interface and the communication 
partner is an RS 232 interface, the RS 422/232 converter is tested and approved.
Order number: 6AV6 671-8XE00-0AX0 
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DF1 protocol with multi-point connection

Point-to-point connection with DF1 protocol
Only point-to-point connections can be established with the DF1 protocol.  

1) Only RS 232 is possible for Panel PC and PC.
2) A point-to-point connection to the SLC500, SLC501, and SLC502 PLCs via DF1 is not possible.
3) For MicroLogix ML1500 LRP, Channel 1 (9-pin Sub D) is also possible.

 

Connecting cable

HMI panel interface used For connection to PLC5x For connection to 
SLC5/03, SLC5/04, 
SLC5/05

For connection to 
MicroLogix

RS 232 9-pin Allen-Bradley cable
1784-CP10

Allen-Bradley cable
1747-CP3

Allen-Bradley cable
1761-CBL-PM02

RS 422 9-pin Connecting cable 9-pin 
Sub D RS 422

— —

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Allen-Bradley".
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DF1 protocol with multi-point connection via KF2 module

DF1 protocol with multi-point connection via KF2 module to DH+ LAN
The use of a KF2 protocol interface module enables a connection to be made to PLCs in the 
DH+ LAN (Data Highway Plus Local Area Network).  

Connecting cable

HMI panel interface used For connection to
KF2 interface module

RS 232 9-pin Allen-Bradley cable
1784-CP10 and 25-pin socket/socket adapter

RS 422 9-pin 9-pin Sub D RS 422 connecting cable and 25-pin female/female adapter

 

Refer to the Allen-Bradley documentation for the cable connection from the PLCs to the DH+ 
data bus.

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Allen-Bradley".
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DF1 protocol with multi-point connection via KF3 module

DF1 protocol with multi-point connection via KF3 module to DH485 LAN

1) For MicroLogix ML1500 LRP, Channel 1 (9-pin Sub D) is also possible.

 

Connecting cable

HMI panel interface used For connection to
KF3 interface module

RS 232 9-pin Allen-Bradley cable
1784-CP10 and 25-pin socket/socket adapter

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Allen-Bradley".  

Connecting cables for Allen-Bradley DF1

Connecting cable 9-pin Sub D RS 422 for Allen-Bradley

Connecting cable 9-pin Sub D RS 422
For interconnecting the HMI device (RS 422, 9-pin sub D) - PLC5x, KF2, KF3

You require an additional 25-pin, female / female adapter (gender changer) for 
interconnections with KF2 and KF3.
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Shield with large-area contact to housing at both ends, interconnected shield contacts
Cable: 3 x 2 x 0.14 mm2, shielded,
max. length 60 m

 

Connecting cable 1784-CP10, RS 232, for Allen-Bradley

Allen-Bradley cable 1784-CP10
For interconnecting the HMI device (RS 232, 9-pin sub D) - PLC5x, KF2, KF3

You require an additional 25-pin, female / female adapter (gender changer) for 
interconnections with KF2 and KF3.
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Screen connected with housing over large area on both sides

max. length 15 m

 

Connecting cable 1747-CP3, RS-232, for Allen-Bradley

Allen-Bradley cable 1747-CP3
For interconnecting the HMI device (RS 232, 9-pin sub D) - SLC503, SLC504, SLC505 
(Channel 0), AIC+
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Screen connected with housing over large area on both sides

max. length 3 m

Connecting cable 1761-CBL-PM02, RS-232, for Allen-Bradley

Allen-Bradley cable 1761-CBL-PM02
For interconnecting the HMI device (RS 232, 9-pin sub D) - Micro Logix, AIC+

 

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6659



 

Screen connected with housing over large area on both sides

max. length 15 m

Performance features of communication

Permitted data types for Allen-Bradley DF1

Permitted data types for Allen-Bradley DF1
The table lists the user data types that can be used when configuring tags and area pointers.   

Data type Operand type Length
ASCII A 1) 1 to 80 characters
Bool N, R, C, T, B, S, I, O 1 bit
Int N, R, C, T, S 2 bytes
DInt N, D 2) 4 bytes
UInt N, R, C, T, B, I, O, D 2) 2 bytes
UDInt N, D 2) 4 bytes
Real N, F 1) 4 bytes
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1) Selectable depending on the selected CPU type.
2) Only for PLC5 CPU type

Abbreviations
In WinCC, formats of the data types are abbreviated as follows:

● UNSIGNED INT = UInt

● UNSIGNED LONG = UDInt

● SIGNED INT = Int

● SIGNED LONG = DInt

Distinctive features for connections with Allen-Bradley DF1
With Allen Bradley DF1, array tags may only be used for discrete alarms and trends. 

 

 Note

I/O modules with 8 or 16 ports occupy one data word on the PLC.

I/O modules with 24 or 32 ports occupy two data words. 

The HMI device does not output an error message if using non-existent bits.

You should always make sure that I/O modules with 8 or 24 ports only occupy the bits that 
are actually assigned to a port.
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Supported CPU types for Allen-Bradley DF1

CPU types
The following CPU types are supported for configuring the Allen-Bradley DF1 communication 
driver.      

● SLC

– SLC500

– SLC501

– SLC502

– SLC503

– SLC504

– SLC505

● MicroLogix

– MicroLogix 1x00

– MicroLogix 1100 / 1400

● PLC 5

– PLC-5/11

– PLC-5/20

– PLC-5/40

– PLC-5/60

– PLC-5/80

Addressing

Addressing
The addressing is entered in the following order in the Allen-Bradley DF1 communication driver:

● Operand type

● File number

● Element number
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● Child element

● Bit number

The address then appears in the following format without spaces:

● File type file number : Element number . Child element

● e.g. T8:2.ACC

Operand type
You have the following options under operand type:

● I

● O

● S

● B

● T

● C

● R

● N

● A

● D only for PLC5 CPU type

File number
Select the number between two limits under file number:

● Low limit

● High limit
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The limit values depend on the selected file type.

Child element
You can select a child element when you have selected one of the following data types:

● R

● C

● T

Address areas for Allen-Bradley DF1

MicroLogix
 

Address areas Data types
Bool Int UInt DInt UDInt Real

N N7:0/0 - 
N255:255/15 

N7:0 - 
N255:255 

N7:0 - 
N255:255 

N7:0 - 
N255:254 

N7:0 - 
N255:254 

N7:0 - 
N255:254 

F -- -- -- -- F8:0 - 
F255:255 

--

R R6:0.EN - 
R255:255.ER - 
R255:255.DN - 
R255:255.FD - 
R255:255.IN - 
R255:255.EU - 
R255:255.EM - 
R255:255.UL 

R6:0.LEN - 
R255:255.POS

R6:0.LEN - 
R255:255.POS

-- -- --

C C5:0.CU - 
C255:255.CD - 
C255:255.DN - 
C255:255.OV - 
C255:255.UN 

C5:0.PRE - 
C255:255.ACC

C5:0.PRE - 
C255:255.ACC

-- -- --

T T4:0.DN - 
T255:255.TT - 
T255:255.EN

T4:0.PRE - 
T255:255.ACC

T4:0.PRE - 
T255:255.ACC

-- -- --

B B3:0/0 - 
B255:255/15

-- B3:0 - 
B255:255 

-- -- --

S S2:0/0 - 
S2:65/15 

S2:0 - 
S2:65 

-- -- -- --

I I0:0/0 - 
I38:255/15 

-- I0:0 - 
I38:255 

-- -- --

O O0:0/0 - 
O38:255/15 

-- O0:0/0 - 
O38:255

-- -- --
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SLC500
 

Address areas Data types
Bool Int UInt DInt UDInt Real

N N7:0/0 - 
N255:255/15 

N7:0 - 
N255:255 

N7:0 - 
N255:255 

N7:0 - 
N255:254 

N7:0 - 
N255:254 

N7:0 - 
N255:254 

R R6:0.EN - 
R255:255.ER - 
R255:255.DN - 
R255:255.FD - 
R255:255.IN - 
R255:255.EU - 
R255:255.EM - 
R255:255.UL

R6:0.LEN - 
R255:255.POS

R6:0.LEN - 
R255:255.POS

-- -- --

C C5:0.CU - 
C255:255.CD - 
C255:255.DN - 
C255:255.OV - 
C255:255.UN 

C5:0.PRE - 
C255:255.ACC

C5:0.PRE - 
C255:255.ACC

-- -- --

T T4:0.DN - 
T255:255.TT - 
T255:255.EN 

T4:0.PRE - 
T255:255.ACC

T4:0.PRE - 
T255:255.ACC

-- -- --

B B3:0/0 - 
B255:255/15 

-- B3:0 - 
B255:255 

-- -- --

S S2:0/0 - 
S2:15/15 

S2:0 - 
S2:15 

-- -- -- --

I I0:0/0 - 
I38:255/15 

-- I0:0 - 
I38:255 

-- -- --

O O0:0/0 - 
O38:255/15

-- O0:0 - 
O38:255 

-- -- --

SLC501/502 
 

Address areas Data types
Bool Int UInt DInt UDInt Real

N N7:0/0 - 
N255:255/15 

N7:0 - 
N255:255 

N7:0 - 
N255:255 

N7:0 - 
N255:254 

N7:0 - 
N255:254 

N7:0 - 
N255:254 

R R6:0.EN - 
R255:255.ER - 
R255:255.DN - 
R255:255.FD - 
R255:255.IN - 
R255:255.EU - 
R255:255.EM - 
R255:255.UL 

R6:0.LEN - 
R255:255.POS

R6:0.LEN - 
R255:255.POS

-- -- --
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Address areas Data types
Bool Int UInt DInt UDInt Real

C C5:0.CU - 
C255:255.CD - 
C255:255.DN - 
C255:255.OV - 
C255:255.UN

C5:0.PRE - 
C255:255.ACC

C5:0.PRE - 
C255:255.ACC

-- -- --

T T4:0.DN - 
T255:255.TT - 
T255:255.EN 

T4:0.PRE - 
T255:255.ACC 

T4:0.PRE - 
T255:255.ACC

-- -- --

B B3:0/0 - 
B255:255/15 

-- B3:0 - 
B255:255 

-- -- --

S S2:0/0 - 
S2:32/15 

S2:0 - 
S2:32 

-- -- -- --

I I0:0/0 - 
I38:255/15 

-- I0:0 - 
I38:255

-- -- --

O O0:0/0 - 
O38:255/15 

-- O0:0 - 
O38:255 

-- -- --

PLC5 
 

Address 
areas

Data types
Bool Int UInt DInt UDInt Real ASCII

N N3:0/0 - 
N999:999/15

N3:0 - 
N999:999 

N3:0 - 
N999:999 

N3:0 - 
N999:999 

N3:0 - 
N999:998 

N3:0 - 
N999:998 

--

F -- -- -- -- -- F3:0 - 
F999:999 

--

A -- -- -- -- -- -- A3:0 - 
A999:999 

R R3:0.EN - 
R999:999.ER 
- 
R999:999.DN 
- 
R999:999.FD 
- 
R999:999.IN 
- 
R999:999.EU 
- 
R999:999.EM
 - 
R999:999.UL 

R3:0.LEN - 
R999:999.PO
S

R3:0.LEN - 
R999:999.PO
S

-- -- -- --
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Address 
areas

Data types
Bool Int UInt DInt UDInt Real ASCII

C C3:0.CU - 
C999:999.CD 
- 
C999:999.DN 
- 
C999:999.OV 
- 
C999:999.UN 

C3:0.PRE - 
C999:999.AC
C

C3:0.PRE - 
C999:999.AC
C

-- -- -- --

T T3:0.DN - 
T999:999.TT 
- 
T999:999.EN 

T3:0.PRE - 
T999:999.AC
C 

T3:0.PRE - 
T999:999.AC
C

-- -- -- --

B B3:0/0 - 
B999:999/15  

-- B3:0 - 
B999:999 

-- -- -- --

S S2:0/0 - 
S2:127/15 

S2:0 - 
S2:127 

-- -- -- -- --

I I1:0/0 - 
I1:277/17 

-- I1:0 - 
I1:277 

-- -- -- --

O O0:0/0 - 
O0:277/17 

-- O0:0 - 
O0:277 

-- -- -- --

D D3:0/0 - 
D999:999/15

D3:0 - 
D999:999 

D3:0 - 
D999:999 

-- D3:0 - 
D999:998 

-- --

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.
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Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.
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Data exchange

Area pointers for Allen-Bradley

Area pointers for connections using an Allen-Bradley communication driver
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section "Data 
exchange using area pointers (Page 6765)".     

Distinctive features for connections via Allen-Bradley EtherNet/IP
You can configure the following area pointers

Area pointer Allen-Bradley EtherNet/IP Allen-Bradley DF1
Screen number Yes Yes
Date/time Yes Yes
Date/time PLC Yes Yes
Coordination Yes Yes
Project ID Yes Yes
Job mailbox Yes Yes
Data record Yes Yes

Restrictions Allen-Bradley Ethernet/IP
The following restrictions apply for configuring area pointers.

CPU type Data types File types
ControlLogix,CompactLogix Int, UInt --
SLC, MicroLogix Int, UInt N, B

Restrictions Allen-Bradley DF1
The following restrictions apply for configuring area pointers.

CPU type Data types File types
MicroLogix -- N, O, I, B
SLC50x -- N, O, I, B
PLC5 -- N, O, I, B
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Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Professional (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.
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The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Restrictions to the trend control

For Allen-Bradley DF1 communication drivers
Tags of the following operand types are permitted:

● "N"

● "O"

● "I"
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● "S"

● "B"

Permitted data types:

● "UInt"

● "Int"

● Array tag of "UInt"

● Array tag of "Int"

You assign a bit to a trend during configuration. This sets a defined bit assignment for all trend 
areas.         

For Allen-Bradley EtherNet/IP communication drivers
Tags of data type "Int" or an array tag of data type "Int" are permitted. You assign a bit to a 
trend during configuration. This sets a defined bit assignment for all trend areas. 

ControlLogix and CompactLogix
The following data types are possible for tags for the ControlLogix and CompactLogix CPU 
types:

● "UInt"

● "Int"

● Array tag of "UInt"

● Array tag of "Int"

SLC and MicroLogix
The following operand types are permitted for tags of the SLC and MicroLogix CPU types:

● "N"

● "O"

● "I"

● "S"

● "B"

Permitted data types:

● "UInt"

● "Int"

● Array tag of "UInt"

● Array tag of "Int"
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Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3910) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Restrictions
Only tags whose "File type" is "N", "O", "I", "S" and "B" are allowed for use as a "trigger tag" 
for discrete alarms. These tags are only valid for the data types "Int" and "UInt".

Data types
For connections with an Allen-Bradley communication driver, the following data types are 
supported:             

Communication drivers PLC Permitted data types
Discrete alarms Analog alarms

Allen-Bradley DF1 SLC500, SLC501, 
SLC502, SLC503, 
SLC504, SLC505, 
PLC5, MicroLogix

Int, UInt Int, UInt, Long, 
ULong, Real

Allen-Bradley EtherNet/IP ControlLogix, 
CompactLogix, SLC, 
Micrologix

Int, UInt SInt, USInt, Int, UInt, 
DInt, UDInt, Real
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How the bit positions are counted
For connections with an Allen-Bradley communication driver, the following counting method 
applies:

How the bit positions are counted Left byte Right byte
In Allen-Bradley PLCs 15       8 7       0

In WinCC you configure: 15       8 7       0

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
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Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Mitsubishi

Mitsubishi communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use 
Mitsubishi communication drivers.    

The following communication drivers are supported:

● Mitsubishi MC TCP/IP

● Mitsubishi FX

Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.
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Mitsubishi MC TCP/IP

Configuring a connection via Mitsubishi MC TCP/IP

Introduction
You configure a connection to a PLC with a Mitsubishi MC TCPI/IP communication driver in 
the "Connections" editor of the HMI device. 

The Ethernet interfaces are named differently depending on the HMI device. 

Example: PROFINET interface corresponds to the Ethernet interface      

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.

3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Mitsubishi MC TCPI/IP" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Mitsubishi MC TCP/IP)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select only one interface for the HMI device in the Inspector window under 
"Parameters". Depending on the HMI device, there are several interfaces available.

If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. The IP address is transferred to the HMI device during 
project transfer. 

 

 Note

The IP address in the control panel will be overwritten upon subsequent loading if you have 
already set up the IP address in the HMI device control panel.

The IP address already set up in the control panel will be retained upon subsequent loading 
if you activate "Set IP address using a different method".

 

To set up the IP address of the HMI device:

1. Click on the HMI device.

2. Open the "Device configuration" editor.
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3. Click the Ethernet interface.

4. Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

Parameters for the PLC
● CPU type

For "CPU type", you set the type of PLC to which the HMI device is connected.
The following settings are possible:
–FX3
–Q
If you select the FX3 CPU type, the Mitsubishi MC protocol "1E" is used and "3E" for the 
"Q" CPU type. 
The "Binary code" protocol variant is always used.

 

  Note

If the CPU type is changed for a configured connection, tags with the following properties 
must be revised:

•  Operands that do not exist for the new CPU type, such as "W", "B", "F".

•  Inputs and outputs with different addressing (hexadecimal/octal)

•  Addresses greater than the valid address area of the new CPU type
 

● IP address
Set the IP address or host name of the Ethernet/IP module of the PLC. Only the IP address 
can be used on a Basic Panel.

● Port
Set the port number of the module of the PLC. 

Connecting HMI device to PLC

Connections via Mitsubishi MC TCP/IP

Connection
The HMI device can be connected to the Mitsubishi PLC using the following components:    

● Existing Ethernet network that also contains the PLCs

● Cross-over Ethernet cable connected directly to the Ethernet interface of the CPU or the 
communication module

The connection of the HMI device to a Mitsubishi PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the PLC.

Connect the HMI device to one or several Q-series and/or FX3 PLCs. Connect the HMI device 
via the following interfaces:
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● Communication interface OnBoard 

● Approved communication module suitable for the PLC
 

  Note
Timeout response with TCP/IP (Ethernet)

Due to the use of the TCP/IP protocol, the breakdown of a connection is detected at the 
earliest after approximately one minute. Communication failure cannot be reliably 
detected if no tags are requested, for example, no output tags in the current screen. 

Configure area pointer coordination for each PLC. This setting ensures that a 
communication failure is recognized after approximately two minutes, even in the 
aforementioned scenario.

 

Communication types 

Approved communication types
● Only applies for Mitsubishi FX(PG protocol):

The point-to-point connection from a HMI device to an approved Mitsubishi FX–CPU via 
Mitsubishi FX is system-tested and approved by Siemens AG.

● Only applies for Mitsubishi MC TCP/IP:
The following communication types are system-tested and approved: 

– Point-to-point connection to the approved PLCs

– Multipoint connection from a HMI device with up to 4 PLCs with the respectively 
approved PLCs. CPU types (FX3 and Q) can be mixed.

 

  Note

The HMI device is a client and the PLC must operate as a server.
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Connectable PLCs
Connections can be implemented for the following Mitsubishi PLCs:

PLC

Mitsubishi FX
(PG protocol)

Mitsubishi MC TCP/IP

MELSEC FX1n, FX2n Yes No
MELSEC FX3U, FX3UC, FX3G with 
communication module FX3U-ENET

No Yes

MELSEC System Q
● Q-series with the communication 

module QJ71E71-100
● QnUDEH CPU with Ethernet interface 

onboard

No Yes

Parameterization of the communications modules 

FX3 PLCs

Procedure
1. Start the FX-Configurator.

2. Select the module.

3. Assign the following settings in the "Operational settings" dialog:

– Communication data code:
Binary code

– Initial timing:
Always wait for OPEN

– IP address:
IP address 

– Send frame setting:
Ethernet(V2.0)

– TCP Existence confirmation setting:
Use the Ping
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4. Assign the following settings in the "Open Settings" dialog:

– Protocol:
TCP

– Open system:
Unpassive

– Fixed buffer:
Receive

– Fixed buffer communication procedure:
Procedure exist(MC)

– Pairing open
Disable

– Existence confirmation 
No confirm

– Host station Port No. (DEC)
Port number

 

  Note

The port number chosen in the communication module must match the port number 
in WinCC. A connection with a port number must be assigned for each connected HMI 
device.

You must specify port numbers in decimal values.
 

5. Confirm the default settings of the other dialog boxes.

The network no. and station no. parameters are not relevant for the connection and can be 
chosen as required.

Q PLCs

Procedure
1. Click "Edit network parameters".

2. Select the network type:

– Ethernet
The network number and the group / station number are not evaluated and can be freely 
assigned
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3. Assign the following settings in the "Operational settings" dialog:

– Communication data code:
Binary code

– Initial timing:
Always wait for OPEN

– IP address:
IP address

– Send frame setting:
Ethernet(V2.0)

– Enable write operations during RUN

4. Assign the following settings in the "Open settings" dialog:

– Protocol:
TCP

– Open system:
Unpassive

– Pairing open
Disable

– Existence confirmation
No confirm

– Host station Port No. (HEX)
Port-Nummer

 

  Note

The port number chosen in the communication module must match the port number 
in WinCC. A connection with a port number must be assigned for each connected HMI 
device.

You must specify port numbers in hexadecimal values.
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Internal Ethernet port of the Q0xUDEH CPU

Procedure
1. Assign the following settings in the "Internal Ethernet Port" dialog:

– IP address:
IP address

– Communication data code:
Binary code

– Enable online changes

2. Assign the following settings in the "Open settings" dialog:

– Protocol:
TCP

– Open system:
MC-Protocol

– Host station Port No. (HEX)
Port number

 

  Note

The port number chosen in the communication module must match the port number 
in WinCC. A connection with a port number must be assigned for each connected HMI 
device.

 

Performance features of communication

Permitted data types for Mitsubishi MC TCPI/IP

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Operand type Length
4-bit block M, X, Y, B, F 1 byte
8-bit block M, X, Y B, F 1 byte
12-bit block M, X, Y B, F 2 bytes
16-bit block M, X, Y B, F 2 bytes
20-bit block M, X, Y B, F 4 bytes
24-bit block M, X, Y B, F 4 bytes
28-bit block M, X, Y B, F 4 bytes
32-bit block M, X, Y B, F 4 bytes
Bool M, D, X, Y B, F 1-bit
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Data type Operand type Length
DInt D, W 4 bytes
DWord D, C, W 4 bytes
Int D, W 2 bytes
Real 1) D, W 4 bytes
String 1) D 1 to 80 characters
Word D, T, C, W 2 bytes

1) The "String" and "Real" data types are not available for all CPUs.
2) Operand types B, F and W are only available for CPU type "Q".

 
 

 Note

Note the following for write accesses:

Tags can only be written if "Enable online changes" or "Enable write operations during RUN" 
was selected when parameterizing the Mitsubishi communication modules. 

For data type "Bool" in operand type "D", the entire word is written back to the PLC following 
a change to the specified bit. There is no check to determine whether any other bits in the 
word have changed. As a result, the PLC only has read access to the specified word.

 

 Note

Array elements in I/O fields cannot be used in communication with a Mitsubishi PLC.
 

Supported CPU types for Mitsubishi MC TCP/IP

CPU types
The following CPU types are supported for configuring the Mitsubishi MC TCP/IP 
communication driver.       

● FX3 series

– FX 3G / FX 3G with communication modul FX3U-ENET

– FX 3U / FX 3U with communication modul FX3U-ENET

– FX 3UC / FX 3UC with communication modul FX3U-ENET

● Q series

– Q-Series with QJ71E71-100 communication module

● iQ series / QnUD

– QnUDEHCPU with built in ethernet module

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
6686 System Manual, 02/2014



Addresses for Mitsubishi MC TCP/IP

Address areas for connections via Mitsubishi MC TCP/IP
The address area boundaries differ for the different series; refer to the Mitsubishi Computerlink 
manuals for this information.

Examples of address area boundaries dependent on the CPU and communication format:     

Name Operand type Max. address 
FX3

Max. address 
Q-Series 

Output/Input Y/X Octal X/Y 0 - 777 HEX X/Y 0 - 7FF
Bit memory M M0 - M3071 and 

M8000 - M8255
M/L/S 0 - 8191

Data register D D0 - 7999
D8000 - D8255

D0 - 8191
D9000 - D9255 becomes SD1000 - 

SD1255 
Counter C C0 - 255 C0 - 1023
Timer T T0 - 255 T0 - 2047
Link register W -- Hex: W0 - FFF
Link flag B -- Hex: B0 - FFF
Error flag F -- F0 - 2047

Address areas for Mitsubishi MC TCP/IP

FX0
 

Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M9999 

-- -- -- -- M0 - 
M999
6 

M0 - 
M999
2

M0 - 
M998
8 

M0 - 
M998
4 

M0 - 
M9980 

M0 - 
M9976 

M0 - 
M9972 

M0 - 
M996
8 

D D0.0 - 
D999.1
5 

D0 - 
D999 

D0 - 
D998 

D0 - 
D998 

D0 - 
D998 

-- -- -- -- -- -- -- --

T  T0 - 
T255 

-- -- -- -- -- -- -- -- -- -- --

C-16-
Bit

-- C-16-
Bit 0 - 
C-16-
Bit 199

-- -- -- -- -- -- -- -- -- -- --
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Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

C-32-
Bit

-- -- C-32-
Bit 200 
- 
C-32-
Bit 255

-- -- -- -- -- -- -- -- -- --

X X0 - 
X255 

-- -- -- -- X0 - 
X252

X0 - 
X248 

X0 - 
X244 

X0 - 
X240 

X0 - 
X236 

X0 - 
X232

X0 - 
X228 

X0 - 
X224 

Y Y0 - 
X255

-- -- -- -- Y0 - 
Y252 

Y0 - 
Y248 

Y0 - 
Y244 

Y0 - 
Y240 

Y0 - 
Y236 

Y0 - 
Y232 

Y0 - 
Y228 

Y0 - 
Y224 

Address areas for Mitsubishi MC TCP/IP

FX3
 

Addr
ess 

areas

Data types
Bool Int Word DInt DWo

rd
Real Strin

g
Raw 4-bit 

block
8-bit 
block

12-
bit 
bloc
k

16-
bit 
bloc
k

20-
bit 
block

24-
bit 
bloc
k

28-
bit 
bloc
k

32-
bit 
block

D -- D0 - 
D655
35 

D0 - 
D655
35 

D0 - 
D655
34 

D0 - 
D655
34 

D0 - 
D655
34 

D0 - 
D655
35 

D0 - 
D655
35 

-- -- D0 - 
D65
535 

D0 - 
D65
535 

D0 - 
D655
34 

D0 - 
D65
534 

D0 - 
D65
534 

D0 - 
D655
34 

M M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M655
34 

M0 - 
M655
34 

M0 - 
M655
34 

M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M65
535 

M0 
- 
M65
535 

M0 - 
M655
34 

M0 - 
M65
534 

M0 - 
M65
534 

M0 - 
M655
34 

CN CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0
 - 
CN6
553
5 

CN0 
- 
CN65
534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

TN -- TN0 
- 
TN65
535 

TN0 
- 
TN65
535 

TN0 
- 
TN65
534 

TN0 
- 
TN65
534 

TN0 
- 
TN65
534 

TN0 
- 
TN65
535 

TN0 
- 
TN65
535 

-- -- TN0 
- 
TN6
5535 

TN0
 - 
TN6
553
5 

TN0 - 
TN65
534 

TN0 
- 
TN6
5534 

TN0 
- 
TN6
5534 

TN0 
- 
TN65
534 

R -- R0 - 
R655
35 

R0 - 
R655
35 

R0 - 
R655
34 

R0 - 
R655
34 

R0 - 
R655
34 

R0 - 
R655
35 

R0 - 
R655
35 

-- -- R0 - 
R65
535 

R0 - 
R65
535 

R0 - 
R655
34 

R0 - 
R65
534 

R0 - 
R65
534 

R0 - 
R655
34 

S S0 - 
S655
35 

S0 - 
S655
35 

S0 - 
S655
35 

S0 - 
S655
34 

S0 - 
S655
34 

S0 - 
S655
34 

S0 - 
S655
35 

S0 - 
S655
35 

S0 - 
S655
35 

S0 - 
S655
35 

S0 - 
S65
535 

S0 - 
S65
535 

S0 - 
S655
34 

S0 - 
S65
534 

S0 - 
S65
534 

S0 - 
S655
34 
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Addr
ess 

areas

Data types
Bool Int Word DInt DWo

rd
Real Strin

g
Raw 4-bit 

block
8-bit 
block

12-
bit 
bloc
k

16-
bit 
bloc
k

20-
bit 
block

24-
bit 
bloc
k

28-
bit 
bloc
k

32-
bit 
block

CS CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

CS0 
- 
CS65
534 

CS0 
- 
CS65
534 

CS0 
- 
CS65
534 

CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

CS0 
- 
CS6
5535 

CS0
 - 
CS6
553
5 

CS0 
- 
CS65
534 

CS0 
- 
CS6
5534 

CS0 
- 
CS6
5534 

CS0 
- 
CS65
534 

TS TS0 - 
TS65
535

TS0 - 
TS65
535

TS0 - 
TS65
535

TS0 - 
TS65
534 

TS0 - 
TS65
534 

TS0 - 
TS65
534 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 
- 
TS6
5535 

TS0 
- 
TS6
553
5 

X0 - 
X776 

X0 - 
X77
6 

X0 - 
X77
6 

X0 - 
X776 

X X0 - 
X777

X0 - 
X777

X0 - 
X777

X0 - 
X776 

X0 - 
X776 

X0 - 
X776 

X0 - 
X777 

X0 - 
X777 

X0 - 
X777 

X0 - 
X777 

X0 - 
X77
7 

X0 - 
X77
7 

X0 - 
X776 

X0 - 
X77
6 

X0 - 
X77
6 

X0 - 
X776 

Y Y0 - 
Y777 

Y0 - 
Y777 

Y0 - 
Y777 

Y0 - 
Y766 

Y0 - 
Y766 

Y0 - 
Y766 

Y0 - 
Y777 

Y0 - 
Y777 

Y0 - 
Y777 

Y0 - 
Y777 

Y0 - 
Y77
7 

Y0 - 
Y77
7 

Y0 - 
Y766 

Y0 - 
Y76
6 

Y0 - 
Y76
6 

Y0 - 
Y766 

Q
 

Addr
ess 
area

Data types
Bool Int Word DInt DWo

rd
Real Strin

g
Raw 4-bit 

block
8-bit 
block

12-
bit 
bloc
k

16-
bit 
bloc
k

20-
bit 
bloc
k

24-
bit 
bloc
k

28-
bit 
bloc
k

32-
bit 
block

B B0 - 
BFFF
F 

B0 - 
BFFF
F 

B0 - 
BFFF
F 

B0 - 
BFFF
E 

B0 - 
BFFF
E 

B0 - 
BFFF
E 

B0 - 
BFFF
F 

B0 - 
BFFF
F 

B0 - 
BFFF
F 

B0 - 
BFFF
F 

B0 - 
BFF
FF 

B0 - 
BFF
FF 

B0 - 
BFF
FE 

B0 - 
BFF
FE 

B0 - 
BFF
FE 

B0 - 
BFFF
E 

SB SB0 
- 
SBF
FFF 

SB0 
- 
SBF
FFF 

SB0 
- 
SBF
FFF 

SB0 
- 
SBF
FFE 

SB0 
- 
SBF
FFE 

SB0 
- 
SBF
FFE 

SB0 
- 
SBF
FFF

SB0 
- 
SBF
FFF

SB0 
- 
SBF
FFF

SB0 
- 
SBF
FFF

SB0 
- 
SBF
FFF

SB0 
- 
SBF
FFF

SB0 
- 
SBF
FFE 

SB0 
- 
SBF
FFE 

SB0 
- 
SBF
FFE 

SB0 
- 
SBF
FFE 

CC CC0 
- 
CC6
5535

CC0 
- 
CC6
5535

CC0 
- 
CC6
5535

CC0 
- 
CC6
5534 

CC0 
- 
CC6
5534 

CC0 
- 
CC6
5534 

CC0 
- 
CC6
5535 

CC0 
- 
CC6
5535 

CC0 
- 
CC6
5535 

CC0 
- 
CC6
5535 

CC0 
- 
CC6
5535 

CC0 
- 
CC6
5535 

CC0 
- 
CC6
5534  

CC0 
- 
CC6
5534 

CC0 
- 
CC6
5534 

CC0 
- 
CC6
5534 

SC SC0 
- 
SC65
535 

SC0 
- 
SC65
535 

SC0 
- 
SC65
535 

SC0 
- 
SC65
534 

SC0 
- 
SC65
534 

SC0 
- 
SC65
534 

SC0 
- 
SC65
535 

SC0 
- 
SC65
535 

SC0 
- 
SC65
535 

SC0 
- 
SC65
535 

SC0 
- 
SC6
5535 

SC0 
- 
SC6
5535 

SC0 
- 
SC6
5534 

SC0 
- 
SC6
5534 

SC0 
- 
SC6
5534 

SC0 
- 
SC65
534 

TC TC0 
- 
TC65
535 

TC0 
- 
TC65
535 

TC0 
- 
TC65
535 

TC0 
- 
TC65
534 

TC0 
- 
TC65
534 

TC0 
- 
TC65
534 

TC0 
- 
TC65
535

TC0 
- 
TC65
535

TC0 
- 
TC65
535

TC0 
- 
TC65
535

TC0 
- 
TC6
5535

TC0 
- 
TC6
5535

TC0 
- 
TC6
5534 

TC0 
- 
TC6
5534 

TC0 
- 
TC6
5534 

TC0 
- 
TC65
534 
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Addr
ess 
area

Data types
Bool Int Word DInt DWo

rd
Real Strin

g
Raw 4-bit 

block
8-bit 
block

12-
bit 
bloc
k

16-
bit 
bloc
k

20-
bit 
bloc
k

24-
bit 
bloc
k

28-
bit 
bloc
k

32-
bit 
block

D -- D0 - 
D655
35 

D0 - 
D655
35 

D0 - 
D655
34 

D0 - 
D655
34 

D0 - 
D655
34 

D0 - 
D655
35

 D0 - 
D655
35

 -- -- D0 - 
D65
535

 D0 - 
D65
535

D0 - 
D65
534  

D0 - 
D65
534 

D0 - 
D65
534 

D0 - 
D655
34 

SD -- SD0 
- 
SD65
535 

SD0 
- 
SD65
535 

SD0 
- 
SD65
534 

SD0 
- 
SD65
534 

SD0 
- 
SD65
534 

SD0 
- 
SD65
535 

SD0 
- 
SD65
535 

-- -- SD0 
- 
SD6
5535 

SD0 
- 
SD6
5535 

SD0 
- 
SD6
5534 

SD0 
- 
SD6
5534 

SD0 
- 
SD6
5534 

SD0 
- 
SD65
534 

F F0 - 
F655
35

F0 - 
F655
35

F0 - 
F655
35

F0 - 
F655
34 

F0 - 
F655
34 

F0 - 
F655
34 

F0 - 
F655
35 

F0 - 
F655
35 

F0 - 
F655
35 

F0 - 
F655
35 

F0 - 
F655
35 

F0 - 
F655
35 

F0 - 
F655
34 

F0 - 
F655
34 

F0 - 
F65
534 

F0 - 
F655
34 

L L0 - 
L655
35

L0 - 
L655
35

L0 - 
L655
35

L0 - 
L655
34 

L0 - 
L655
34 

L0 - 
L655
34 

L0 - 
L655
35 

L0 - 
L655
35 

L0 - 
L655
35 

L0 - 
L655
35 

L0 - 
L655
35 

L0 - 
L655
35 

L0 - 
L655
34

L0 - 
L655
34

L0 - 
L655
34

L0 - 
L655
34

M M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M655
35 

M0 - 
M655
34 

M0 - 
M655
34 

M0 - 
M655
34 

M0 - 
M655
35

M0 - 
M655
35

M0 - 
M655
35

M0 - 
M655
35

M0 - 
M65
535

M0 - 
M65
535

M0 - 
M65
534 

M0 - 
M65
534 

M0 - 
M65
534 

M0 - 
M655
34 

SM SM0 
- 
SM6
5535 

SM0 
- 
SM6
5535 

SM0 
- 
SM6
5535 

SM0 
- 
SM6
5534 

SM0 
- 
SM6
5534 

SM0 
- 
SM6
5534 

SM0 
- 
SM6
5535

SM0 
- 
SM6
5535

SM0 
- 
SM6
5535

SM0 
- 
SM6
5535

SM0 
- 
SM6
5535

SM0 
- 
SM6
5535

SM0 
- 
SM6
5534 

SM0 
- 
SM6
5534 

SM0 
- 
SM6
5534 

SM0 
- 
SM6
5534 

CN -- CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

-- -- CN0 
- 
CN6
5535 

CN0 
- 
CN6
5535 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

CN0 
- 
CN6
5534 

SN -- SN0 
- 
SN65
535 

SN0 
- 
SN65
535 

SN0 
- 
SN65
534 

SN0 
- 
SN65
534 

SN0 
- 
SN65
534 

SN0 
- 
SN65
535 

SN0 
- 
SN65
535 

-- -- SN0 
- 
SN6
5535 

SN0 
- 
SN6
5535 

SN0 
- 
SN6
5534 

SN0 
- 
SN6
5534 

SN0 
- 
SN6
5534 

SN0 
- 
SN65
534 

TN -- TN0 
- 
TN65
535

TN0 
- 
TN65
535

TN0 
- 
TN65
534 

TN0 
- 
TN65
534 

TN0 
- 
TN65
534 

TN0 
- 
TN65
535

TN0 
- 
TN65
535

-- -- TN0 
- 
TN6
5535

TN0 
- 
TN6
5535

TN0 
- 
TN6
5534 

TN0 
- 
TN6
5534 

TN0 
- 
TN6
5534 

TN0 
- 
TN65
534 

R -- R0 - 
R655
35 

R0 - 
R655
35 

R0 - 
R655
34 

R0 - 
R655
34 

R0 - 
R655
34 

R0 - 
R655
35 

R0 - 
R655
35 

-- -- R0 - 
R65
535 

R0 - 
R65
535 

R0 - 
R65
534 

R0 - 
R65
534 

R0 - 
R65
534 

R0 - 
R655
34 

S S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFFF
E 

S0 - 
SFFF
E 

S0 - 
SFFF
E 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFF
FF 

S0 - 
SFF
FF 

S0 - 
SFF
FE

S0 - 
SFF
FE

S0 - 
SFF
FE

S0 - 
SFFF
E

CS CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

CS0 
- 
CS65
535 

S0 - 
SFFF
E 

S0 - 
SFFF
E 

S0 - 
SFFF
E 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFFF
F 

S0 - 
SFF
FF 

S0 - 
SFF
FF 

S0 - 
SFF
FE 

S0 - 
SFF
FE 

S0 - 
SFF
FE 

S0 - 
SFFF
E 

SS SS0 
- 
SS65
535 

SS0 
- 
SS65
535 

SS0 
- 
SS65
535 

SS0 
- 
SS65
534 

SS0 
- 
SS65
534 

SS0 
- 
SS65
534 

SS0 
- 
SS65
535

SS0 
- 
SS65
535

SS0 
- 
SS65
535

SS0 
- 
SS65
535

SS0 
- 
SS6
5535

SS0 
- 
SS6
5535

SS0 
- 
SS6
5534 

SS0 
- 
SS6
5534 

SS0 
- 
SS6
5534 

SS0 
- 
SS65
534 
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Addr
ess 
area

Data types
Bool Int Word DInt DWo

rd
Real Strin

g
Raw 4-bit 

block
8-bit 
block

12-
bit 
bloc
k

16-
bit 
bloc
k

20-
bit 
bloc
k

24-
bit 
bloc
k

28-
bit 
bloc
k

32-
bit 
block

TS TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
534

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 - 
TS65
535 

TS0 
- 
TS6
5535 

TS0 
- 
TS6
5535 

TS0 
- 
TS6
5534 

TS0 
- 
TS6
5534 

TS0 
- 
TS6
5534 

TS0 - 
TS65
534 

V V0 - 
V655
35 

V0 - 
V655
35 

V0 - 
V655
35 

V0 - 
V655
34 

V0 - 
V655
34 

V0 - 
V655
34 

V0 - 
V655
34 

V0 - 
V655
34 

V0 - 
V655
34 

V0 - 
V655
34 

V0 - 
V65
534 

V0 - 
V65
534 

V0 - 
V65
534 

V0 - 
V65
534 

V0 - 
V65
534 

V0 - 
V655
34 

W -- W0 - 
WFF
FF 

W0 - 
WFF
FF 

W0 - 
WFF
FE 

W0 - 
WFF
FE 

W0 - 
WFF
FE 

W0 - 
WFF
FF

W0 - 
WFF
FF

-- -- W0 - 
WFF
FF 

W0 - 
WFF
FF 

W0 - 
WFF
FE 

W0 - 
WFF
FE 

W0 - 
WFF
FE 

W0 - 
WFF
FE 

SW -- SW0 
- 
SWF
FFF 

SW0 
- 
SWF
FFF 

SW0 
- 
SWF
FFE 

SW0 
- 
SWF
FFE 

SW0 
- 
SWF
FFE 

SW0 
- 
SWF
FFF 

SW0 
- 
SWF
FFF 

-- -- SW0
 - 
SWF
FFF 

SW0
 - 
SWF
FFF 

SW0
 - 
SWF
FFE 

SW0
 - 
SWF
FFE 

SW0
 - 
SWF
FFE 

SW0 
- 
SWF
FFE 

X X0 - 
XFFF
F 

X0 - 
XFFF
F 

X0 - 
XFFF
F 

X0 - 
XFFF
E 

X0 - 
XFFF
E 

X0 - 
XFFF
E 

X0 - 
XFFF
F 

X0 - 
XFFF
F 

X0 - 
XFFF
F 

X0 - 
XFFF
F 

X0 - 
XFF
FF 

X0 - 
XFF
FF 

X0 - 
XFF
FE 

X0 - 
XFF
FE 

X0 - 
XFF
FE 

X0 - 
XFFF
E 

DX DX0 
- 
DXF
FFF 

DX0 
- 
DXF
FFF 

DX0 
- 
DXF
FFF 

DX0 
- 
DXF
FFE 

DX0 
- 
DXF
FFE 

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFF

DX0 
- 
DXF
FFE

DX0 
- 
DXF
FFE

DX0 
- 
DXF
FFE

DX0 
- 
DXF
FFE

Y Y0 - 
YFFF
F 

Y0 - 
YFFF
F 

Y0 - 
YFFF
F 

Y0 - 
YFFF
E 

Y0 - 
YFFF
E 

Y0 - 
YFFF
E 

Y0 - 
YFFF
F 

Y0 - 
YFFF
F 

Y0 - 
YFFF
F 

Y0 - 
YFFF
F 

Y0 - 
YFF
FF 

Y0 - 
YFF
FF 

Y0 - 
YFF
FE 

Y0 - 
YFF
FE 

Y0 - 
YFF
FE 

Y0 - 
YFFF
E 

DY DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFE 

DY0 
- 
DYF
FFE 

DY0 
- 
DYF
FFE 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFF 

DY0 
- 
DYF
FFE 

DY0 
- 
DYF
FFE 

DY0 
- 
DYF
FFE 

DY0 
- 
DYF
FFE 

Z -- Z0 - 
Z655
35 

Z0 - 
Z655
35 

Z0 - 
Z655
34 

Z0 - 
Z655
34 

Z0 - 
Z655
34 

Z0 - 
Z655
35 

Z0 - 
Z655
35 

-- -- Z0 - 
Z655
35 

Z0 - 
Z655
35 

Z0 - 
Z655
34 

Z0 - 
Z655
34 

Z0 - 
Z65
534 

Z0 - 
Z655
34 
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Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.
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Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Mitsubishi FX

Configuring a connection via Mitsubishi FX

Introduction
You configure a connection to a PLC with a Mitsubishi FX communication driver in the 
"Connections" editor of the HMI device.     

The Mitsubishi FX protocol is also referred to as the Mitsubishi PG protocol.

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Mitsubishi FX" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Mitsubishi FX)

Parameters to be set
To assign the connection parameters, such as addresses and profiles, click the connection 
that you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device", "Network", and "PLC" areas are available for assigning 
parameters according to the interface used. 
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Parameters for the HMI device
You can select an interface for the HMI device in the Inspector window under "Parameters". 
Depending on the HMI device, there are several interfaces available.

● "Type"
Specifies the physical connection used.

 

  Note

If you use the IF1B interface, you must switch over the RS422 receive data and the RTS 
signal additionally by 4 DIL-switches on the back of the HMI device.

 

Parameters for the PLC
● Baud rate: For "Baud rate", select the transmission speed between the HMI device and 

PLC. Select the baud rate "9600".

● Data bits: Under "Data bits", select "7 bits".

● Parity: Under "Parity", select "Even".

● Stop bits: Under "Stop bits", select "1 bit".
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Connecting HMI device to PLC

Connections via Mitsubishi FX

Connection
Connect the HMI device to the programming interface of the CPU (RS 422) (see documentation 
of the PLC).

The connection between the HMI device and the Mitsubishi PLC is basically restricted to setting 
the interface parameters. Special blocks for the connection are not required in the PLC.

Connecting cable
The following connecting cables are available to connect the HMI device to the PLC.  

Interface to
HMI device or adapter

Mitsubishi Electric PLC via FX protocol
FX1n, Fx2n, Mini DIN, 8–pin

RS 232, 9-pin Mitsubishi SC-09 1)

RS 422, 9-pin Connecting cable RS422-2P
1)   Since the Mitsubishi PLCs communicate via RS 422 as a standard, the Mitsubishi programming 
cable SC–09 with integrated RS 422/RS 232 adaptor is necessary for connecting a HMI device via RS 
232.

 
 

 Note

Applies only to RS 232:

Cable length is restricted to 0.32 m.
 

Refer to the relevant device manual to determine which HMI device interface is to be used.

The cable pin assignments can be found in Section "Connecting cables for Mitsubishi FX".
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Communication types 

Approved communication types
● Only applies for Mitsubishi FX(PG protocol):

The point-to-point connection from a HMI device to an approved Mitsubishi FX–CPU via 
Mitsubishi FX (PG protocol := protocol for access to the program and memory elements of 
the FX series PC CPU version V1.21 and after) is system-tested and approved by Siemens 
AG.

● Only applies for Mitsubishi MC TCP/IP:
The following communication types are system-tested and approved: 

– Point-to-point connection to the approved PLCs

– Multipoint connection from a HMI device with up to 4 PLCs with the respectively 
approved PLCs. CPU types (FX3 and Q) can be mixed.

 

  Note

The HMI device is a client and the PLC must operate as a server.
 

Connectable PLCs
Connections can be implemented for the following Mitsubishi PLCs:

PLC

Mitsubishi FX
(PG protocol)

Mitsubishi MC TCP/IP

MELSEC FX1n, FX2n Yes No
MELSEC FX3U, FX3UC, FX3G with 
communication module FX3U-ENET

No Yes

MELSEC System Q
● Q-series with the communication 

module QJ71E71-100
● QnUDEH CPU with Ethernet interface 

onboard

No Yes

Connecting cables for Mitsubishi FX

Connecting cable RS 422 2P, for Mitsubishi

Connecting cable RS422-2P
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Shield with large-area contact to housing at both ends
Cable: 3 x 2 x 0.14 mm2, shielded,
max. length 500 m

 

Performance features of communication

Permitted data types for Mitsubishi FX

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

Data type Operand type Length
4-bit block M, X, Y 1 byte
8-bit block M, X, Y 1 byte
12-bit block M, X, Y 2 bytes
16-bit block M, X, Y 2 bytes
20-bit block M, X, Y 4 bytes
24-bit block M, X, Y 4 bytes
28-bit block M, X, Y 4 bytes
32-bit block M, X, Y 4 bytes
Bool D, M, X, Y 1-bit
DWord D, C-32 bit 4 bytes
Real D 4 bytes
String D 1 to 50 characters
Word D, T, C-16 bit 2 bytes

 

 Note

Note the following for write accesses:

For data type "Bool" in operand type "D", the entire word is written back to the PLC following 
a change to the specified bit. There is no check to determine whether any other bits in the 
word have changed. As a result, the PLC only has read access to the specified word.

 

 Note

Array elements in I/O fields cannot be used in communication with a Mitsubishi PLC.
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Supported CPU types for Mitsubishi FX

CPU types
The following CPU types are supported for configuring the Mitsubishi FX communication 
driver.     

● FX1 series

– FX1n

● FX2 series

– FX2n

Address areas for Mitsubishi FX

FX3
 

Addre
ss 

areas

Data types
Bool Int Word DInt DWor

d
Real String 4-bit 

block
8-bit 
block

12-
bit 
block

16-
bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M999
9 

-- -- -- -- -- -- M0 - 
M99
96 

M0 - 
M99
92 

M0 - 
M99
88 

M0 - 
M99
84

M0 - 
M998
0

M0 - 
M997
6 

M0 - 
M997
2 

M0 - 
M996
8 

D D0.0 
- 
D999
9.15

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

D0 - 
D999
9 

-- -- -- -- -- -- -- --

T -- -- T0 - 
T999 

-- -- -- -- -- -- -- -- -- -- -- --

C -- C0 - 
C999 

C0 - 
C999 

C0 - 
C998 

C0 - 
C998 

-- -- -- -- -- -- -- -- -- --

X X0 - 
X777 

-- -- -- -- -- -- X0 - 
X774 

X0 - 
X770 

X0 - 
X764 

X0 - 
X760 

X0 - 
X754 

X0 - 
X750 

X0 - 
X744

X0 - 
X740 

Y Y0 - 
Y777 

-- -- -- -- -- -- Y0 - 
Y774 

Y0 - 
Y770 

Y0 - 
Y764 

Y0 - 
Y760 

Y0 - 
Y754 

Y0 - 
Y750 

Y0 - 
Y744 

Y0 - 
Y740 
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Q
 

Addre
ss 

areas

Data types
Bool Int Word DInt DWor

d
Real String 4-bit 

block
8-bit 
block

12-
bit 
block

16-
bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M999
9 

-- -- -- -- -- -- M0 - 
M99
96 

M0 - 
M99
92 

M0 - 
M99
88 

M0 - 
M99
84 

M0 - 
M998
0 

M0 - 
M997
6 

M0 - 
M997
2 

M0 - 
M996
8 

F F0 - 
F999
9 

-- -- -- -- -- -- F0 - 
F999
6 

F0 - 
F999
2

F0 - 
F998
8 

F0 - 
F998
4 

F0 - 
F998
0 

F0 - 
F997
6 

F0 - 
F997
2

F0 - 
F996
8 

B B0 - 
BFFF
F 

-- -- -- -- -- -- B0 - 
BFF
FC 

B0 - 
BFF
F8 

B0 - 
BFF
F4

B0 - 
BFF
F0 

B0 - 
BFFE
C 

B0 - 
BFFE
8 

B0 - 
BFFE
4 

B0 - 
BFFE
0

D D0.0 
- 
D655
34.15 

D0 - 
D655
34 

D0 - 
D655
34 

D0 - 
D655
33 

D0 - 
D655
33 

D0 - 
D655
33 

D0 - 
D655
34 

-- -- -- -- -- -- -- --

T -- -- T0 - 
T204
7 

-- -- -- -- -- -- -- -- -- -- -- --

C  C0 - 
C204
7 

C0 - 
C204
7 

C0 - 
C204
6 

C0 - 
C204
6 

-- -- -- -- -- -- -- -- -- --

W -- W0 - 
WFF
FF 

W0 - 
WFF
FF 

W0 - 
WFF
FE

W0 - 
WFF
FE

W0 - 
WFF
FE

-- -- -- -- -- -- -- -- --

X X0 - 
XFFF
F 

-- -- -- -- -- -- X0 - 
XFF
FC

X0 - 
XFF
F8 

X0 - 
XFF
F4 

X0 - 
XFF
F0 

X0 - 
XFFE
C 

X0 - 
XFFE
8

X0 - 
XFFE
4 

X0 - 
XFFE
0 

Y Y0 - 
YFFF
F 

-- -- -- -- -- -- Y0 - 
YFF
FC

Y0 - 
YFF
F8 

Y0 - 
YFF
F4 

Y0 - 
YFF
F0 

Y0 - 
YFFE
C 

Y0 - 
YFFE
8 

Y0 - 
YFFE
4 

Y0 - 
YFFE
0 

FX0
 

Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

M M0 - 
M9999 

    M0 - 
M999
6 

M0 - 
M999
2

M0 - 
M998
8 

M0 - 
M998
4 

M0 - 
M9980 

M0 - 
M9976 

M0 - 
M9972 

M0 - 
M9968 

D D0.0 - 
D999.1
5 

D0 - 
D999 

D0 - 
D998 

D0 - 
D998 

D0 - 
D998 
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Addres
s areas

Data types
Bool Word DWord Real String 4-bit 

block
8-bit 
block

12-bit 
block

16-bit 
block

20-bit 
block

24-bit 
block

28-bit 
block

32-bit 
block

T  T0 - 
T255 

           

C-16-
Bit

 C-16-
Bit 0 - 
C-16-
Bit 199

           

C-32-
Bit

  C-32-
Bit 200 
- 
C-32-
Bit 255

          

X X0 - 
X255 

    X0 - 
X252

X0 - 
X248 

X0 - 
X244 

X0 - 
X240 

X0 - 
X236 

X0 - 
X232

X0 - 
X228 

X0 - 
X224 

Y Y0 - 
X255

    Y0 - 
Y252 

Y0 - 
Y248 

Y0 - 
Y244 

Y0 - 
Y240 

Y0 - 
Y236 

Y0 - 
Y232 

Y0 - 
Y228 

Y0 - 
Y224 

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.
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Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Data exchange

Area pointers for Mitsubishi

Area pointers for connections via Mitsubishi communication drivers
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section "Data 
exchange using area pointers".
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Special considerations for connections via Mitsubishi communication drivers
You can configure the following area pointers

Area pointers Mitsubishi MC TCP/IP Mitsubishi FX
Screen number Yes Yes
Date/time Yes Yes
Date/time PLC Yes Yes
Coordination Yes Yes
Project ID Yes Yes
Job mailbox Yes Yes
Data record Yes Yes

Restrictions Mitsubishi MC TCP/IP
The following restrictions apply for configuring area pointers.

CPU type Data types Operand type
FX3 Int, Word D
Q Int, Word D

Mitsubishi FX restrictions
You cannot use the D operand type for configuring area pointers.

See also
Data exchange using area pointers (Page 6765)

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Professional (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
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Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.
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The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Restrictions to the trend control

Data types for Mitsubishi MC TCPI/IP
For trend control you can create tags and array tags of the operand type "D" with the data type 
"Word" or "Int". 

Data types for Mitsubishi FX
For trend control you can create tags and array tags of the operand type "D" with the data type 
"Word".
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Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3910) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a Mitsubishi communication driver, the following data types are 
supported:             

PLC Permitted data types
Discrete alarms Analog alarms

FX1n, FX2n, FX3 series, Q-
Series, iQ-Series

Word,
Int 1)

4-bit block, 8-bit block,
12-bit block, 16-bit block,
20-bit block, 24-bit block,
28-bit block, 32-bit block,
Word, DWord, Int 1), DInt 1), Real, 

1)  Not for Mitsubishi FX communication driver
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How the bit positions are counted
For connections with a Mitsubishi communication driver, the following counting method applies:

How the bit positions are 
counted Left byte Right byte

In Mitsubishi 
PLCs

15       8 7       0

In WinCC you configure: 15       8 7       0

Restrictions on alarms
● Mitsubishi MC TCP/IP

Only tags of operand type "D" and data types "Word" and "Int" are permitted as trigger tags 
for discrete alarms. You can use array tags (operand type: "D"; data types: "ARRAY [x..y] 
of Word" or "ARRAY [x..y] of Int") for discrete alarms.

● Mitsubishi FX
Only tags of operand type "D" and data type "Word" are permitted as trigger tags for discrete 
alarms. You can use array tags (operand type "D"; data type "ARRAY [x..y] of Word") for 
discrete alarms."

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.
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Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.
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LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.

LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Modicon Modbus

Modicon Modbus communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use Modicon 
Modbus communication drivers.     

The following communication drivers are supported:

● Modicon Modbus TCP/IP

● Modicon Modbus RTU
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Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.

Modicon Modbus TCP/IP

Configuring a connection via Modicon Modbus TCP/IP

Introduction
You configure a connection to one of the PLCs with Modicon Modbus TCP/IP communication 
driver in the "Connections" editor of the HMI device.      

The Ethernet interfaces are named differently depending on the HMI device. 

Example: PROFINET interface corresponds to the Ethernet interface

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. Select the "Modicon Modbus TCP" driver in the "Communication driver" column.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Modicon Modbus TCP/IP)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.         

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select only one interface for the HMI device in the Inspector window under 
"Parameters". Depending on the HMI device, there are several interfaces available.

If you are directly connected to the HMI device during configuration, you can set up the IP 
address of the HMI device in WinCC. The IP address is transferred to the HMI device during 
project transfer. 

 

 Note

The IP address in the control panel will be overwritten upon subsequent loading if you have 
already set up the IP address in the HMI device control panel.

The IP address already set up in the control panel will be retained upon subsequent loading 
if you activate "Set IP address using a different method".

 

To set up the IP address of the HMI device:

1. Click the HMI device.

2. Open the "Device configuration" editor.
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3. Click the Ethernet interface.

4. Assign the IP address in the inspector window under:
"General > PROFINET interface > Ethernet addresses"

Parameters for the PLC
● "CPU type"

For "CPU type", you set the Modicon PLC to which the HMI device is connected.

● "Port"
For "Port", you set the port that is used for the TCP/IP connection. The port used by the 
Modicon PLCs is 502. 

● "Server"
You set the IP address or host name of the PLC under "Server". Only the IP address can 
be used on a Basic Panel.

● "Distributed slave address"
For "Distributed slave address", set the slave address of the remote PLC, but only if a bridge 
is used.
If a bridge is not used, the default value "255" (or "0") must be retained.

● "Change word order"    
The "Change word order " parameter only affects the word order of the 32-bit values display. 
The setting pertains to the data types Double, Double+/-, and Float. The byte order cannot 
be changed. 

– "Change word order" not activated
The most significant byte is sent first. 
For double words, the least significant word is sent before the most significant word. 
This setting has been system-tested for all approved PLCs. 

– "Change word order" activated
The most significant byte is sent first. 
For double words, the most significant word is sent before the least significant word.

 

  Note

This setting must be used for the SIEMENS SENTRON PAC3200 and PAC4200 multi-
function meters and can be used for PLCs of other manufacturers.

 

● "Use single write"
If you deselect this function, only function codes 15H and 16H are used for writing into the 
PLC.
If this function remains selected, the function codes 05H, 06H, 15H, and 16H are used.
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Connecting HMI device to PLC

Connections via Modicon Modbus TCP/IP

Connection
The HMI device can be connected to the Modicon Modbus PLC using the following 
components:    

● Existing Ethernet network that also contains the PLCs

● Cross-over Ethernet cable connected directly to the Ethernet interface of the CPU or the 
communication module

The connection of the HMI device to a Modicon Modbus PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the PLC.

 

 Note

Timeout response with TCP/IP (Ethernet)

Due to the use of the TCP/IP protocol, the breakdown of a connection is detected at the 
earliest after approximately one minute. Communication failure cannot be reliably detected 
if no tags are requested, for example, no output tags in the current screen. 

Configure area pointer coordination for each PLC. This setting ensures that a communication 
failure is recognized after approximately two minutes, even in the aforementioned scenario.
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Communication types 

Approved communication types
The following communication types are system-tested and approved: 

● Point-to-point coupling:

● Multiple point coupling of a HMI device (Modbus TCP/IP Client) with up to 4 PLCs, each 
with different couplings. CPU types can be mixed.
The following couplings are possible:

– Coupling the Ethernet CPU interface of the TSX Unity Quantum.

– Coupling via the communication modules for Ethernet 140 NOE 771 01 for the TSX 
Quantum and TSX Unity Quantum series

– Coupling via the Ethernet interface of the 171 CCC 980 30 CPU adapter of the 
Momentum series

– Coupling the Ethernet CPU interface of the TSX Unity Premium.

– Coupling via the Ethernet TCP/IP connect module TSX ETY 110 for the TSX Premium 
and TSX Unity Premium series

– Coupling via the Ethernet TCP/IP connect module TSX ETY 410 for the Micro series

– Coupling via the Ethernet TCP/IP Modbus Plus Bridge 174 CEV 200 40 to the Modbus 
Plus interface of the Compact, the TSX Quantum and the TSX Unity Quantum series

Via the TCP/IP Modbus Plus Bridge, 174 CEV 200 40, the PLCs can be accessed at their 
Remote Slave Address via the Ethernet interface of this bridge. 

 

 Note

Integration of the HMI device in a Modbus network via a bridge is not possible. The HMI 
device is the Modbus master.

 

Restrictions
The coupling of the HMI device to PLCs of other manufacturers who offer a Modbus TCP/IP 
interface is not system-tested and thus, not enabled. 

However, if another PLC is to be used, observe the following instructions:

● Use the following CPU types, because these operate without address offset and in the 
usual bit count manner.

– Unity, PL7: Premium, Micro, Quantum, M340

● The following function codes are used for the respective data areas:

Reading function codes Address range
01 ReadCoilStatus 0x / %M DIGITAL_OUT
02 ReadInputStatus 1x / %I DIGITAL_IN
03 ReadHoldingRegisters 4x / %MW USERDATA
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Reading function codes Address range
04 ReadInputRegisters 3x / %IW ANALOG_IN
20 (14Hex) ReadGeneralReference 6x / – EXTENDEDMEMORY

(not for all CPUs)

Writing function codes Address range
06 1) PresetSingleRegister 4x / %MW USERDATA Single
16 (10Hex) PresetMultipleRegisters 4x / %MW USERDATA Multiple
05 1) ForceSingleCoil 0x / %M DIGITAL_OUT with BIT
15 (0FHex) ForceMultipleCoils 0x / %M DIGITAL_OUT with 16 BIT GROUP
21 (15Hex) WriteGeneralReference 6x / – EXTENDEDMEMORY

(not for all CPUs)

1) Select use with "Use single write".

Connectable PLCs
Connections can be implemented for the following Modicon Modbus PLCs:

Modicon Modbus PLC Supported protocol
Modicon Modbus RTU 2) Modicon Modbus TCP/IP

TSX Compact x x 1)

TSX Quantum x x 
Momentum x x
Premium - x
Micro - x
M340 20x0 (without 2010) - x

1) Only via Ethernet TCP/IP Modbus Plus Bridge
2) Communication via RS 232 is tested and enabled for the PLC. In the HMIs that only have 

a RS 422/485 interface, the RS 422/232 converter with the order number 6AV6 
671-8XE00-0AX0 was tested and enabled.
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Performance features of communication

Permissible data types for Modicon Modbus TCP/IP

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.         

 

 Note

If you change the Modicon Modbus RTU communication driver to Modicon Modbus TCP/IP, 
the string in the "String" data type may be different.

 

Permitted data types for CPU type "Unity, PLC: Premium, Micro, Quantum M340"

Data type Operand type Length
+/- Double %MW 4 bytes
+/- Int %MW, %IW 2 bytes
16-bit group %MW, %I 2 bytes
ASCII %MW 0 to 80 characters
Bit %MW, %IW, 

%M, %I
1-bit

Double %MW 4 bytes
Float %MW 4 bytes
Int %MW, %IW 2 bytes

 

 Note

The ranges "%I" and "%IW" are not supported for the following CPU types:
● Premium
● Micro
● M340

 

Permitted data types for CPU type "Concept, ProWORX: Compact, Quantum, Momentum"

Data type Operand type Length
+/- Double 4x, 6x 4 bytes
+/- Int 3x, 4x, 6x 2 bytes
16-bit group 0x, 1x 2 bytes
ASCII 4x, 6x 0 to 80 characters
Bit 0x, 1x, 3x, 4x, 

6x
1-bit
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Data type Operand type Length
Double 4x, 6x 4 bytes
Float 4x, 6x 4 bytes
Int 3x, 4x, 6x 2 bytes

Bit counting method
The usual bit counting method "16 LSB - 1 MSB" in the following CPU types is only used in 
the "HMI tags" editor with the selected "Bit" data type:

● Concept, ProWORX: Compact, Quantum, Momentum

The following bit location assignment applies:

 Left byte Right byte
Counting with tags 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Format for "Signed" 
The placeholder "+/-" stands for the data types "Signed Int" and "Signed Double".

Supported CPU types for Modicon Modbus TCP/IP

CPU types
The following CPU types are supported for configuring the Modicon Modbus TCP/IP 
communication driver.  

● Compact

● Momentum

● Quantum

– Concept Quantum 

– Unity Quantum

● Micro

● Premium

● Modicon M340

– 20x0 (except 2010)
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Address areas for Modicon Modbus TCP/IP

Unity, Pl7  

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

%1 %I0 - 
 %I65535 

 %I65535   
%I0 - 
 %I65520  

-- -- -- -- -- --

%M %M0 - 
 %M65535 

 %M65535   
%M0 - 
 %M65520  

-- -- -- -- -- --

%IW %IW0.0 - 
 
%IW65535.
15 

--  %IW0 - 
 %IW65535 

 %IW0 - 
 %IW65535 

-- -- -- --

%MW %MW0.0 - 
 
%MW6553
5.15

--  %MW0 - 
 
%MW6553
5

 %MW0 - 
 
%MW6553
5 

%MW0 - 
 
%MW6553
4 

%MW0 - 
 
%MW6553
4 

%MW0 - 
 
%MW6553
4 

%MW0 - 
 
%MW6553
5 

Concept, ProWORX

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

0x 0x1 - 
0x65535

0x1 - 
0x65520 

-- -- -- -- -- --

1x 1x100001 - 
1x165535 

1x100001 - 
1x165520 

-- -- -- -- -- --

3x 3x300001.1
 - 
3x365535.1
6 

-- 3x300001 - 
3x365535 

3x300001 - 
3x365535 

-- -- -- --

4x 4x400001.1
 - 
4x465535.1
6 

-- 4x400001 - 
4x465535 

4x400001 - 
4x465535 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465535 

6x 6x60000.1:
1 - 
6x69999.16
:10 

-- 6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69999:10 
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Address areas for Modicon Modbus TCP/IP

UnityPl7  

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

%1  %I0 - 
 %I9999999 

 %I0 - 
 %I9999999 

-- -- -- -- -- --

%M  %M0 - 
 
%M999999
9 

 %M0 - 
 
%M999999
9 

-- -- -- -- -- --

%IW  %IW0.0 - 
 
%IW99999
99.15 

-- %IW0 - 
 
%IW99999
99 

%IW0 - 
 
%IW99999
99 

 %IW0 - 
 
%IW99999
98 

 %IW0 - 
 
%IW99999
98 

 %IW0 - 
 
%IW99999
98 

 %IW0 - 
 
%IW99999
99 

%MW  %MW0.0 - 
 
%MW9999
999.15

-- %MW0 - 
 
%MW9999
999

%MW0 - 
 
%MW9999
999

%MW0 - 
 
%MW9999
998 

%MW0 - 
 
%MW9999
998 

%MW0 - 
 
%MW9999
998 

%MW0 - 
 
%MW9999
999 

6x 6x0.0:1 - 
6x9999999.
15:10

-- 6x0:1 - 
6x9999999:
10 

6x0:1 - 
6x9999999:
10 

6x0:1 - 
6x9999998:
10 

6x0:1 - 
6x9999998:
10 

6x0:1 - 
6x9999998:
10 

6x0:1 - 
6x9999999:
10 

ConceptProWORX

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

0x 0x0 - 
0x9999999 

0x0 - 
0x9999999 

-- -- -- -- -- --

1x 1x0 - 
1x9999999 

1x0 - 
1x9999999 

-- -- -- -- -- --

3x 3x0.1 - 
3x9999999.
16 

-- 3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

4x 4x0.1 - 
4x9999999.
16 

-- 4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

6x 6x0.1:1 - 
6x9999999.
16:10

-- 6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10
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Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.
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Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Modicon Modbus RTU

Configuring a connection via Modicon Modbus RTU

Introduction
You configure a connection to a PLC with a Modicon Modbus RTU communication driver in 
the "Connections" editor of the HMI device.      

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. In the "Communication drivers" column, select the "Modicon Modbus RTU" driver.

5. Select all necessary connection parameters for the interface in the Inspector window under 
"Parameters".

Parameters for the connection (Modicon Modbus RTU)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.     

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select an interface for the HMI device in the Inspector window under "Parameters". 
Depending on the HMI device, there are several interfaces available.

● Type
Only RS 232 is system-tested.
No warranty is given for RS 485.

 

  Note

RS 422 is only approved in combination with the RS 422-RS 232 converter.

Order number: 6AV6 671-8XE00-0AX0
 

  Note

If you use the IF1B interface, you must switch over the RS422 receive data additionally 
by 4 DIL-switches on the back of the HMI device.

 

● Baud rate
For "Baud rate", select the transmission speed between the HMI device and Modicon PLC. 
A baud rate of 19200 or 9600 can be selected for the communication.
A baud rate of 4800 can be selected for certain HMI devices.

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6727



● Data bits
For "Data bits", only the value "8" can be selected.

● Parity
For "Parity", you can choose from "None", "Even", and "Odd".

● Stop bits
For "Stop bits", you can choose between 1 and 2 bits.

Parameters for the PLC
● CPU type

For "CPU type", you set the Modicon PLC to which the HMI device is connected.
You can select the following CPUs:

– Concept, ProWORX: Compact, Quantum

● Slave address
Under "Slave address" you set which slave address the CPU has.

Connecting HMI device to PLC

Connections via Modicon Modbus RTU

Connection
Connect the HMI device to the Modicon Modbus RTU interface of the Modicon Modbus RTU 
slave.     

The connection of the HMI device to Modicon is limited primarily to the physical connection of 
the HMI device. Special blocks for the connection are not required in the PLC.

Connection cable
The following connecting cables are available to connect the HMI device to Modicon 
Modbus.     

Interface to the 
HMI device

Modicon PLC
directly via Modbus 

interface (RS232) 9-pin 
Sub D male connector

Via MB Bridge
(RS 232)

directly via Modbus interface 
(RS232) 8-pin RJ45 

connector
RS 232, 9-pin PP1 PP1 PP2

The cable pin assignments can be found in Section "Connecting cables for Modicon Modbus 
RTU".
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Communication types 

Approved communication types
The following communication types are system-tested and approved:   

● Ppoint-to-point connection only via the RS-232 interface.

● Multipoint connection from a HMI device (Modbus-Master) with up to 4 PLCs: The HMI 
device must be connected with a Modbus Plus Bridge or a Compact, Momentum CPU or 
TSX Quantum CPU which is configured as a Modbus Plus Bridge.

● You connect the other PLCs via the Modbus Plus connection on the first PLC. The PLCs 
can be reached under their address via the bridge functionality of the first PLC.

 

  Note

It is not possible to integrate the HMI device into a Modbus network because the HMI 
device is Modbus-Master.

 

● Integration of the HMI device into a Modbus Plus network via the "bridge mode" of the 
Compact, Momentum or Quantum (logical point-to-point communication of the HMI device 
with a Compact, Momentum or Quantum).

Restrictions
The connection of the HMI device to PLCs of other manufacturers which offer a Modicon 
Modbus interface is not system-tested and therefore not approved.   

If you use another PLC nevertheless, observe the following information:

● These drivers only work for tags with the bit counting method typical for Modicon PLCs from 
left (bit1 = most significant bit) to right (bit16 = least significant bit in data type INT).

● The address offset displayed in the configuring is subtracted at protocol level in the 
message frame. E.g. in Holding Register 4x the offset "40001". The configured address 
"40006" therefore becomes address "5" in the message frame. The address (e.g. "5") 
transferred in the message frame is transformed to the PLC-specific address range in the 
different Non-Modicon PLCs.

● A reply message frame without "ExceptionCode" is expected within 500 ms.

● The following function codes are used for the respective data areas:

Reading function codes Address range
01 ReadCoilStatus 0x DIGITAL_OUT
02 ReadInputStatus 1x DIGITAL_IN
03 ReadHoldingRegisters 4x USERDATA
04 ReadInputRegisters 3x ANALOG_IN
20 (14Hex) ReadGeneralReference 6x EXTENDEDMEMORY

(not for all CPUs)
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Writing function codes Address range
06 PresetSingleRegister 4x USERDATA Single
16 (10Hex) PresetMultipleRegisters 4x USERDATA Multiple
05 ForceSingleCoil 0x DIGITAL_OUT with data type Bit
15 (0FHex) ForceMultipleCoils 0x DIGITAL_OUT with data type 16 bit 

group
21 (15Hex) WriteGeneralReference 6x EXTENDEDMEMORY

(not for all CPUs)

Connectable PLCs
Connections can be implemented for the following Modicon Modbus PLCs:

Modicon Modbus PLC Supported protocol
Modicon Modbus RTU 2) Modicon Modbus TCP/IP

TSX Compact x x 1)

TSX Quantum x x 
Momentum x x
Premium - x
Micro - x
M340 20x0 (without 2010) - x

1) Only via Ethernet TCP/IP-Modbus Plus Bridge
2) Communication via RS 232 is tested and enabled for the PLC. In the HMI devices which 

only have an RS 422/485 interface, the RS 422/232 converter with the order number 6AV6 
671-8XE00-0AX0 was tested and approved.
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Connecting cables for Modicon Modbus RTU

Connecting cable PP1, RS-232, for Modicon

Point-to-point cable 1: PLC > PC ...
 

 

Cables: 3 x 0.14 mm2, shielded,
max. length 15 m
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Connecting cable PP2, RS-232, for Modicon

Point-to-point cable 2: PLC (TSX Compact) > PC... 

 

Cables: 3 x 0.14 mm2, shielded,
max. length 15 m
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Performance features of communication

Permitted data types for Modicon Modbus RTU

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Operand type Length
+/- Double 4x, 6x 4 bytes
+/- Int 3x, 4x, 6x 2 bytes
16-bit group 0x, 1x 2 bytes
ASCII 4x, 6x 0 to 80 characters
Bit 1) 0x, 1x, 3x, 4x, 6x 1-bit
Double 4x, 6x 4 bytes
Float 4x, 6x 4 bytes
Int 3x, 4x, 6x 2 bytes

1) Note the following for write accesses:
For data type "Bit" with the operand types "4x" and "6x", the entire word is written back 
to the PLC following a change to the specified bit. There is no check to determine 
whether any other bits in the word have changed. As a result, the PLC only has read 
access to the specified word.

The usual bit counting method (16 LSB - 1 MSB) in the following CPU types is only used in 
the "HMI tags" editor with the selected "Bit" data type:

● Concept ProWORX: Compact, Quantum

The following bit location assignment applies:

 Left byte Right byte
Counting with tags 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Format for "Signed"
The placeholder "+/-" stands for the data types "Signed Int" and "Signed Double".
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Supported CPU types for Modicon Modbus RTU

CPU types
The following CPU types are supported in the configuration of the Modicon Modbus RTU 
communication driver.     

● Compact

● Momentum

● Quantum

Address areas for Modicon Modbus RTU

Concept, ProWORX  

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

0x 0x1 - 
0x65535

0x1 - 
0x65520 

-- -- -- -- -- --

1x 1x100001 - 
1x165535 

1x100001 - 
1x165520 

-- -- -- -- -- --

3x 3x300001.1
 - 
3x365535.1
6 

-- 3x300001 - 
3x365535 

3x300001 - 
3x365535 

-- -- -- --

4x 4x400001.1
 - 
4x465535.1
6 

-- 4x400001 - 
4x465535 

4x400001 - 
4x465535 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465534 

4x400001 - 
4x465535 

6x 6x60000.1:
1 - 
6x69999.16
:10 

-- 6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69999:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69998:10 

6x60000:1 - 
6x69999:10 
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Address areas for Modicon Modbus RTU

UnityPl7  

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

%1  %I0 - 
 %I9999999 

 %I0 - 
 %I9999999 

-- -- -- -- -- --

%M  %M0 - 
 
%M999999
9 

 %M0 - 
 
%M999999
9 

-- -- -- -- -- --

%IW  %IW0.0 - 
 
%IW99999
99.15 

-- %IW0 - 
 
%IW99999
99 

%IW0 - 
 
%IW99999
99 

 %IW0 - 
 
%IW99999
98 

 %IW0 - 
 
%IW99999
98 

 %IW0 - 
 
%IW99999
98 

 %IW0 - 
 
%IW99999
99 

%MW  %MW0.0 - 
 
%MW9999
999.15

-- %MW0 - 
 
%MW9999
999

%MW0 - 
 
%MW9999
999

%MW0 - 
 
%MW9999
998 

%MW0 - 
 
%MW9999
998 

%MW0 - 
 
%MW9999
998 

%MW0 - 
 
%MW9999
999 

6x 6x0.0:1 - 
6x9999999.
15:10

-- 6x0:1 - 
6x9999999:
10 

6x0:1 - 
6x9999999:
10 

6x0:1 - 
6x9999998:
10 

6x0:1 - 
6x9999998:
10 

6x0:1 - 
6x9999998:
10 

6x0:1 - 
6x9999999:
10 

ConceptProWORX

Address 
areas

Data types
Bool 16 Bit 

Group
Int +/- Int DInt +/- DInt Float ASCII 

0x 0x0 - 
0x9999999 

0x0 - 
0x9999999 

-- -- -- -- -- --

1x 1x0 - 
1x9999999 

1x0 - 
1x9999999 

-- -- -- -- -- --

3x 3x0.1 - 
3x9999999.
16 

-- 3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

3x0 - 
3x9999999 

4x 4x0.1 - 
4x9999999.
16 

-- 4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

4x0 - 
4x9999999 

6x 6x0.1:1 - 
6x9999999.
16:10

-- 6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10

6x0:1 - 
6x9999999:
10
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Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.

● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.
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Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Data exchange

Area pointers for Modicon Modbus

Area pointers for connections via Modicon Modbus communication drivers
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section "Data 
exchange using area pointers".

Special considerations for connections via Modicon communication drivers
You can configure the following area pointers

Area pointers Modicon Modbus TCP/IP Modicon Modbus RTU
Screen number Yes Yes
Date/time Yes Yes
Date/time PLC Yes Yes
Coordination Yes Yes
Project ID Yes Yes
Job mailbox Yes Yes
Data record Yes Yes
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Restrictions Modicon Modbus TCP/IP
The following restrictions apply for configuring area pointers.

CPU type Data types File types
Concept, ProWORX: Compact, 
Quantum, Momentum

+/- Int, Int 4x, 6x

Unity, PL7: Premium, Micro, 
Quantum, M340

+/- Int, Int %MW

Modicon Modbus RTU restrictions
The following restrictions apply for configuring area pointers.

CPU type Data types File types
Concept, ProWORX: Compact, 
Quantum, Momentum

+/- Int, Int 4x, 6x

Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Professional (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.
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To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.

The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.
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Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Permitted data types for trend control

Modicon Modbus TCP/IP
Tags of the following operand types are permitted for CPU type "Concept, ProWORX: 
Compact, Quantum, Momentum".

● "4x"

● "6x"

Tags of the following operand types are permitted for CPU type "Unity, PL7: Premium, Micro, 
Quantum, M340".

● "%MW"

The tags for trend control must have data type "Int" or "+/- Int" or be an array tag with data 
type "Int" or "+/-Int". 

You assign a bit to a trend during configuration. This sets a defined bit assignment for all areas.

Modicon Modbus RTU
Tags of the following operand types are permitted for CPU type "Concept, ProWORX: 
Compact, Quantum".

● "4x"

● "6x"

The tags for trend control must have data type "Int" or "+/- Int" or be an array tag with data 
type "Int" or "+/-Int". 

You assign a bit to a trend during configuration. This sets a defined bit assignment for all areas.
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Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3910) 

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with a Modicon Modbus communication driver, the following data types are 
supported:

PLC Permitted data types
Discrete alarms Analog alarms

All Modicon series Int, +/-Int 16 Bit Group, Int, +/-Int, 
Double, +/-Double, Float

Arrays and array tags cannot be used for discrete alarms.

How the bit positions are counted
For connections with a Modicon Modbus communication driver, the following counting method 
applies:

How the bit positions are counted Left byte Right byte
In WinCC you configure: 15 1

4
1
3

1
2

1
1

1
0

9 8 7 6 5 4 3 2 1 0
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See also
Alarm Logging in WinCC  (Page 3888)

Configuring Alarms (Page 3912)

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.

To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
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to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.
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LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Omron

Omron communication drivers 

Introduction
This section describes the communication between an HMI device and PLCs that use Omron 
communication drivers.    

The following communication drivers are supported:

● Omron Host Link

Data exchange
Data is exchanged by means of tags or area pointers.

● Tags
The PLC and the HMI device use process values for data exchange. You create tags in 
the configuration that point to addresses in the PLC. The HMI device reads the value from 
the defined address, and then displays it. The operator may also enter values on the HMI 
device, which are then written to the address in the PLC.

● Area pointers
Area pointers are used to exchange specific data and are only set up when these data are 
used.
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Omron Host Link

Configuring a connection via Omron Host Link

Introduction
You configure a connection to a PLC with an Omron Host Link communication driver in the 
"Connections" editor of the HMI device.           

 

 Note
Connection with Omron Host Link

A connection will not automatically be established when runtime is started if you have 
configured a connection via Omron. 

A tag which is in the valid PLC memory area must be configured in the runtime start screen. 

The connection will otherwise only be established once a corresponding screen has been 
selected.

This tag will be accessed when runtime is started and a connection will then be established.
 

The interfaces are named differently depending on the HMI device. 

Requirements
● A project is open.

● An HMI device has been created.

Procedure
1. Double-click the HMI device under "Devices" in the project tree.

2. Double-click the "Connections" item.
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3. Double-click "<Add>" in the "Connections" editor.
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4. Select the "Omron Host Link" driver in the "Communication driver" column.

5. Select all necessary connection parameters for the interface in the inspector window under 
"Parameters".

Parameters for the connection (Omron Hostlink)

Parameters to be set
To set the connection parameters, such as addresses and profiles, click the connection that 
you have created in the "Connections" editor.     

The communication partners are displayed schematically in the Inspector window under 
"Parameters". The "HMI device" and "PLC" areas are available for assigning parameters 
according to the interface used. 
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Parameters for the HMI device
You can select an interface for the HMI device in the Inspector window under "Parameters". 
Depending on the HMI device, there are several interfaces available.

● Type
Specifies the physical connection used.

● Baud rate
For "Baud rate", you set the transmission speed of the HMI device to OMRON. A baud rate 
of 19200 or 9600 can be selected for the communication.

● Data bits
For "Data bits", you can choose between "7 bits" and "8 bits".

● Parity
For "Parity", you can choose from "None", "Even", and "Odd".

● Stop bits
For "Stop bits", you can choose between 1 and 2 bits.
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Parameters for the PLC
● Station address

For "Station address", set the station number of the connected PLC.

Connecting HMI device to PLC

Connections via Omron Host Link

Connection
The connection of the HMI device to an OMRON PLC is limited primarily to the physical 
connection of the HMI device. Special blocks for the connection are not required in the 
PLC.       

Connection cable
The following connecting cables are available to connect the HMI device to an Omron 
PLC.     

Interface to the HMI 
device

Omron PLC
RS232, 9-pin RS232 I/O port RS422, 9-pin RS422, terminals/

pins
RS232, 9-pin PP1 Programming 

cable (standard 
cable of Omron)

— —

RS232 via converter — — — Multi-point cable 1
RS422, 9-pin — — PP2 Multi-point cable 2

Refer to the relevant device manual to determine which HMI device interface is to be used.

Communication types 

Approved communication types
The connection from a HMI device to an OMRON-CPU with the Omron Host Link protocol via 
RS232 and via RS 422 is system-tested and approved by Siemens AG.

This concerns the following CPU types: 

● CP1x (CP1L, CP1H, CP1E)

● CJ1x (CJ1M, CJ1H, CJ1G)

● CJ2H
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● CS1x (CS1G, CS1H, CS1D)

● CPM2C
 

  Note

Only the following CPU types have been tested and released for Basic Panels, TP 177A 
and OP 77A:
● CP1x (CP1L, CP1H, CP1E)
● CJ1x (CJ1M, CJ1H, CJ1G)

 

Multipoint connection
A multipoint connection to the up to 4 approved OMRON PLCs in a RS422-four-wire connection 
can be implemented with communication modules on the PLCs and is system-tested and 
approved by Siemens AG.

 

 Note

The HMI device can only be operated as a master. Exactly one master is possible in the 
RS422-four-wire-Multidrop connection.
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Connection cable for Omron Host Link

Connecting cable MP1, RS-232, over converter, for Omron

Multipoint cable 1: MP/TP/PC > PLC    

1) Inrush current max. 0.8 A

shielded, max. length 500 m
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Connecting cable MP2, RS-422, for Omron

Multipoint cable 2: RS422, MP/TP/PC > SPS_    

shielded, max. length 500 m

Connecting cable PP1, RS-232, for Omron

Point-to-point cable PP1, PC/TP/OP - PLC
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shielded, max. length 15 m

Connecting cable PP2, RS-422, for Omron

Point-to-point cable PP2, RS-422  
 

 

shielded, max. length 500 m

Performance features of communication

Permissible data types for Omron Host Link

Permitted data types
The table lists the data types that can be used when configuring tags and area pointers.     

Data type Operand type Length
Bool I/O, HR, AR, LR, DM, T/

C bit, CPU status
1-bit

Byte CPU type 1 byte
DInt HR, AR, LR, DM 4 bytes
Int I/O, HR, AR, LR, DM, T/

C Val
2 bytes

Real HR, DM 4 bytes
String HR, AR, LR, DM 0 to 80 characters
UDInt HR, AR, LR, DM 4 bytes
UInt I/O, HR, AR, LR, DM, T/

C Val
2 bytes

 

 Note

Read and write operations of all data areas in the OMRON PLC can only be reliably carried 
out in "STOP" or "MONITOR" mode.

"I/O" refers either to the IR/SR area or the CIO area depending on the PLC series. The 
operand types "LR", "HR" and "AR" are not available in all PLC series.

 

Visualize processes
10.11 Communicating with PLCs

WinCC Professional V13.0
System Manual, 02/2014 6753



 Note

Note the following for write accesses: 

For the "Bool" data type with the operand types "I/O", "HR", "AR", "LR" and "DM", the entire 
word is written back into the PLC when the specified bit is changed. There is no check to 
determine whether any other bits in the word have changed. As a result, the PLC only has 
read access to the specified word.

 

Operand type old PLC Operand type CS and CJ PLC
CPU Status  CPU Status
I/O CIO
HR H

Range 0-511
AR A
LR n/a 1)
DM D
T/C T/C
CPU type CPU type

1) You do not get an error message when you read or write the LR area in the 
following PLCs 
● CS
● CJ
● CP

Supported CPU types for Omron Host Link

CPU types
The following CPU types are supported in the configuration of the Omron Host Link 
communication driver.        

● CP1

– CP1L

– CP1H

– CP1E

● CJ1

– CJ1M

– CJ1H

– CJ1G 
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● CJ2

– CJ2H

● CS1

– CS1G

– CS1H

– CS1D

● CPM

– CPM2C

Addressing in Omron Host Link

Addressing of PLCs in Omron Host Link
In PLCs of the series CS, CP and CJ, the timers 0-4095 are addressed with T/C 0-2047.

The counters 0-4095 must be addressed with an offset of 2048 (T/C 2048-4095 correspond 
to the counters 0-2047). Counters and timers with addresses > 2047 cannot be addressed via 
Host Link.  

Counters and timers with addresses > 2047 cannot be addressed via Host Link.

Example:

If you want to address counter C20, you must address T/C 20+2048 = T/C 2068.

Address areas for Omron Hostlink

Omron   

Address 
areas

Data types
Bool Byte UInt Int UDInt DInt Real String

I/O I/O 0.0 - 
I/O 9999.15 

-- I/O 0 - 
I/O 9999 

I/O 0 - 
I/O 9999 

-- -- -- --

HR HR 0.0 - 
HR 9999.15 

 HR 0 - 
HR 9999 

HR 0 - 
HR 9999 

HR 0 - 
HR 9998 

HR 0 - HR 
9998 

HR 0 - 
HR 9999 

HR 0 - 
HR 9999 

AR AR 0.0 - 
AR 9999.15 

 AR 0 - 
AR 9999 

AR 0 - 
AR 9999 

AR 0 - 
AR 9998 

AR 0 - 
AR 9998 

 AR 0 - 
AR 9999 

LR LR 0.0 - 
LR 9999.15 

 LR 0 - 
LR 9999 

LR 0 - 
LR 9999 

LR 0 - 
LR 9998 

LR 0 - 
LR 9998 

 LR 0 - 
LR 9999 

DM DM 0.0 - 
DM 
9999.15 

 DM 0 - 
DM 9999 

DM 0 - 
DM 9999 

DM 0 - 
DM 9998 

DM 0 - 
DM 9998 

DM 0 - 
DM 9999 

DM 0 - 
DM 9999 

T/C Bit T/C Bit 0 - 
T/C Bit 
4095 
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Address 
areas

Data types
Bool Byte UInt Int UDInt DInt Real String

T/C Val   T/C Val 0 - 
T/C Val 
4095

T/C Val 0 - 
T/C Val 
4095

    

CPU Status RUN, 
MONITOR 

       

CPU type  CPU type       

Commissioning components

Transferring a project to the HMI device
1. Switch the HMI device to "transfer mode".

2. Set all necessary transfer parameters.

– Interface

– Transfer parameters

– Target storage location

3. Start the project transfer.
The project is compiled automatically.
All compilation and transfer steps are logged to a message window.

Interconnecting the PLC with the HMI device
1. Interconnect the PLC with the HMI device using a suitable cable.

2. The message "Connection to PLC .... is established" is output to the HMI device.

Optimizing the configuration

Acquisition cycle and update time
The acquisition cycles for the "Area pointers" and of the tags defined in the configuration 
software are decisive in terms of the update times which can actually be achieved.   

The update time is equivalent to the acquisition cycle + transmission time + processing time.

Items to observe when optimizing the update times in configuration data:

● Optimize the maximum and minimum size of the data areas.

● Acquisition cycles which are too short lead to unnecessary load on overall performance. 
Set the acquisition cycle according to the rate of change of the process values. The rate of 
temperature changes at a furnace, for example, is significantly slower compared to the 
speed rate of an electrical drive. A time of approx. 1 second is a benchmark for the 
acquisition cycle.
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● Avoid any gaps when entering the alarm or screen tags in a data area.

● Changes in the PLC can only be detected reliably if these are available at least within the 
actual acquisition cycle.

Screens
The refresh rate of screens is determined by the type and volume of data to be visualized.

Only configure short acquisition cycles for objects which actually require shorter refresh cycles. 
This procedure reduces update times.

Trends
The HMI device always updates all bit-triggered trends whose group bit is set in the "Trend 
transfer area". It resets the bits in the next cycle.

The group bit in the PLC program can only be set again after the HMI device has reset all bits.

Job mailboxes
A high rate and volume of job mailboxes transferred may lead to overload in communication 
between the HMI device and the PLC.

The HMI device confirms acceptance of the job mailbox by entering the value zero in the first 
data word of the job mailbox. The HMI device now processes the job for which it requires a 
certain time slice. It may take the HMI device some time to process a new job mailbox which 
is transferred in immediate succession to the job mailbox. The next job mailbox is only accepted 
if sufficient computing resources are available.

Data exchange

Area pointers for Omron

Area pointers in connections via Omron communication drivers
You use an area pointer to access a data area in the PLC.

For more detailed information on area pointers and their configuration, refer to Section:

"Data exchange using area pointers (Page 6765)".

Special features of connections via Omron Host Link
Area pointers can only be created in the following "File types": "DM", "I/O", "HR", "AR", and 
"LR".
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Trends

General information on trends

Trends    
A trend is the graphical representation of one or more values from the PLC. The value is read 
out either time- or bit-triggered, depending on the configuration. 

For additional information see:

Displaying tags with Runtime Professional (Page 3828) 
 

 Note

The value is read out time-triggered for Basic Panels.
 

Time-triggered trends
The HMI device reads in the trend values cyclically at an interval specified in the configuration. 
Time-triggered trends are suitable for continuous curves, such as the operating temperature 
of a motor.

Bit-triggered trends
Through a trigger bit set in the trend request tag, the HMI device either reads in a trend value 
or an entire trend buffer. This setting is defined in the configuration. Bit-triggered trends are 
normally used to represent fast changing values. One example might be the injection pressure 
in the production of plastic parts.

To trigger bit-triggered trends, appropriate external tags must be created in the "HMI tags" 
editor and connected to trend areas during configuration. The HMI device and PLC then 
communicate with each other via these trend areas.

The following areas are available for trends:

● Trend request area

● Trend transfer area 1

● Trend transfer area 2 (required only with switch buffers)

Trend request and trend transfer

Trend request area  
The HMI device sets corresponding bits in the trend request area when you open a screen 
which contains one or more trends on the HMI device. After closing the screen, the HMI device 
resets the relevant bits in the trend request area.
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The trend request area can be used for evaluation purposes in the PLC to determine which 
trend is currently being displayed on the HMI device. Trends can also be triggered without 
evaluation of the trend request area.

Trend transfer area 1
This area is used to trigger trends. You must set the bit assigned to the trend in the trend 
transfer area and set the trend group bit in your control program. The trend group bit is the last 
bit in the trend transfer area.

The HMI device detects the trigger. The HMI device reads either a value or the entire buffer 
from the PLC. It then resets the trend bit and the trend group bit.

The following picture shows the structure of a trend transfer area.

The trend transfer area must not be modified by the PLC program until the trend group bit has 
been reset.

Trend transfer area 2
Trend transfer area 2 is required for trends configured with a switch buffer. The trend transfer 
areas 1 and 2 have a similar structure.

Switch buffer
The switch buffer is a second buffer for the same trend that can be set up during configuration. 

The PLC writes to Buffer 2 while the HMI device reads values from Buffer 1, and writes to 
Buffer 1 when the HMI device is reading Buffer 2. This prevents the PLC from overwriting trend 
values while the trend is being read by the HMI device.

Restrictions to the trend control

For Omron Host Link communication drivers 
Tags of "Operand type" "DM", "I/O", "HR", "AR" or "LR" are permitted. 

They must be data type "UInt", "Int" or an array tag of data type "UInt", "Int". You assign a bit 
to a trend during configuration. This sets a defined bit assignment for all areas.     
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Alarms

Configuring alarms

Configuring alarms for non-integrated connections
Several steps are necessary to configure alarms such as warnings, error messages and 
acknowledgement.

● Step 1: Create tags

● Step 2: Configure alarms

● Step 3: Configure acknowledgment

You can find additional information in the section:

Working with Alarms  (Page 3910)

Distinctive features when configuring alarms
If you are configuring connections of HMI devices to PLCs of other manufacturers, note the 
following distinctive features when configuring:       

● Data types of the tags

● Addressing of tags

● How the bit positions are counted

Data types
For connections with an Omron communication driver, the following data types are supported:

PLC Permitted data types
Discrete alarms Analog alarms

CP1, CJ1, CJ2, CS1, CPM Uint, int UInt, Int,
UDInt, DInt

How the bit positions are counted
For connections with an Omron communication driver, the following counting method applies:

How the bit positions are 
counted Left byte Right byte

In Omron
PLCs

15       8 7       0

In WinCC you configure: 15       8 7       0

Only tags for the "DM", "I/O", "HR", "AR", and "LR" file types are allowed for use as a trigger 
tag for discrete alarms.
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Configuring discrete alarms
Use arrays for discrete alarms and append each individual alarm to one bit of the array tags 
themselves and not to the individual subelements. 

Only tags for the "DM", "I/O", "HR", "AR", LR" areas and the "Int" and "UInt" file types are 
permitted for discrete alarms and arrays.

Acknowledgment of alarms

Procedure
Create suitable tags on the PLC to acknowledge an error alarm. You assign these tags to an 
alarm in the "Bit messages" editor. You make the assignment in "Properties > 
Acknowledgment".     

Distinction in terms of acknowledgment: 

● Acknowledgment by the PLC

● Acknowledgment on the HMI device

Acknowledgment by the PLC
In "PLC acknowledgment tag", configure the tag or array tag and the bit number that the HMI 
device uses to identify a PLC acknowledgment.

A bit set in the tag triggers acknowledgment of the assigned error alarm bit at the HMI device. 
This tag bit returns a function similar to acknowledgment on the HMI device which is triggered 
by pressing the "ACK" button, for example.   

The acknowledgment bit must be located in the same tag as the bit for the error alarm.

Reset the acknowledgment bit before setting the bit in the alarm area again. The figure below 
shows the pulse diagram.

 

Acknowledgment on the HMI device
In the "HMI acknowledgment tag" area, configure the tag or array tag as well as the bit number 
that the HMI device writes to the PLC after acknowledgment. Make sure when you use an 
array tag that it is not longer than 6 words.
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To always create a signal change when setting an assigned acknowledgment bit of a discrete 
alarm that must be acknowledged, the HMI device will reset the acknowledgment bit assigned 
to the alarm as soon as it detects an alarm subject to acknowledgment and write the 
acknowledgment tag in the PLC. There will be a certain delay between detecting the message 
and writing the acknowledgment tag in the PLC because the HMI device has to process the 
operations.   

If a discrete alarm subject to acknowledgment is acknowledged by the HMI device, then the 
corresponding bit in the assigned acknowledgment tag will be set. The entire acknowledgment 
tag is then written to the PLC by the HMI device. This allows the PLC to recognize that a certain 
alarm message has been acknowledged at the HMI device.

 

 Note

All alarm bits acknowledged since the last Runtime start will remain in the acknowledgment 
tag until a new incoming of the respective discrete alarms is detected.

This area should only be read by the PLC because the entire section of the HMI device will 
be overwritten once the next acknowledgment tag is written.

 

The figure below shows the pulse diagram.

 

LED mapping

Function 
Keyboard devices have LEDs in the function keys. These LEDs can be activated from the PLC. 
Thus, it is possible, for example, to signal to the user which key he should press in a given 
situation by lighting up an LED.

 

 Note

The LED function cannot be configured for Basic Panels.
 

Requirements
In order to activate an LED, an LED tag or an array tag must be set up in the PLC and specified 
as an LED tag during configuration.
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LED assignment
The assignment of the individual LEDs to the bits in the LED tags is specified when the function 
keys are configured. In this process, the "LED tag" and the assigned "Bit" are specified for 
each function key in the "General" group of the properties window.

The "Bit" bit number designates the first of two consecutive bits that control the following LED 
statuses.

Bit n+ 1 Bit n

LED function
All Mobile Panels, all Operator Panels,

all Multi Panels, all Comfort Panels Panel PCs
0 0 Off Off
0 1 Rapid flashing Flashing
1 0 Slow flashing Flashing
1 1 On permanently On permanently

Communication Service Packages

10.11.17.
5

Data exchange using area pointers

General information on area pointers

Introduction   
You use an area pointer to access a data area in the PLC. During communication, the PLC 
and the HMI device alternately access these data areas for read and write operations. 

The PLC and the HMI device trigger defined interactions based on the evaluation of stored 
data.
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Configuration of area pointers
Before you use the area pointer, you enable it in "Connections ▶ Area pointers". You then 
assign the area pointer parameters.

● Active
Enables the area pointer.

● Pointer name
Name of the area pointer specified by WinCC.

● PLC tag
Here you select the PLC tag or the tag array that you have configured as the data area for 
the area pointer.

● Address
No address is entered into this field because of the symbolic access.

● Length
WinCC specifies the length of the area pointer.

● Acquisition cycle
You specify the acquisition cycle in this field for area pointers that are read by the HMI 
device. Note that a very short acquisition time may have a negative impact on HMI device 
performance.

● Comment
Enter a comment, for example, to describe the purpose of the area pointer.
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Accessing data areas

Accessing data areas
The following table shows how HMI devices and PLCs access individual data areas for read 
(R) or write (W) operations.   

Data area Required for HMI device PLC
Screen number Evaluation by the PLC in order to determine the active screen. W R
Data record Transfer of data records with synchronization R/W R/W
Date/time Transfer of the date and time from the HMI device to the PLC W R
Date/time PLC Transfer of the date and time from the PLC to the HMI device R W
Coordination Requesting the HMI device status in the PLC program W R
Project ID Runtime checks for consistency between the WinCC project 

ID and the project in the PLC
R W

Job mailbox Triggering of HMI device functions by the PLC program R/W R/W

"Screen number" area pointer

Function     
The HMI device saves information about the screen called on the HMI device to the "Screen 
number" area pointer.

This allows the transfer of the current screen contents from the HMI device to the PLC. The 
PLC can trigger specific reactions such as the call of a different screen.

Use
Configure and enable the area pointer in "Communication > Connections" before you put it 
into use. You can create only one instance of the "Screen number" area pointer and only on 
one PLC.

The screen number is always transferred to the PLC when a new screen is activated or when 
the focus within a screen changes from one screen object to another.

Structure
The area pointer is a data area in the memory of the PLC with a fixed length of 5 words.

 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1. word Current screen type
2. word Current screen number
3. word Reserved
4th word Current field number
5. word Reserved
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● Current screen type
"1" for root screen or
"4" for permanent window

● Current screen number
1 to 32767

● Current field number
1 to 32767

"Date/time" area pointer

Function     
This area pointer is used to transfer the date and time from the HMI device to the PLC.

The PLC writes control job "41" to the job mailbox.

When it evaluates the control job, the HMI device writes its current date and the time in the 
data area configured in the "Date/time" area pointer. All definitions are coded in BCD format.

The "Date/Time" area pointer when used in a project which contains multiple connections must 
be enabled for each configured connection.

 

 Note

You cannot use the "Date/Time PLC" area pointer if you have configured the "Date/Time" 
area pointer.

 

The date/time data area has the following structure:

Data word Left byte Right byte  
15       8 7       0

n+0 Reserved Hour (0 to 23)
Timen+1 Minute (0 to 59) Second (0 to 59)

n+2 Reserved Reserved
n+3 Reserved Weekday (1 to 7, 1=Sunday)

Daten+4 Day (1 to 31) Month (1 to 12)
n+5 Year (80 to 99/0 to 29) Reserved

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.
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"Date/time PLC" area pointer

Function     
This area pointer is used to transfer the date and time from the PLC to the HMI device. Use 
this area pointer if the PLC is the time master.

The PLC loads the data area of the area pointer. All definitions are coded in BCD format.

The HMI device reads the data cyclically within the configured acquisition cycle and 
synchronizes itself.

 

 Note

Set an acquisition cycle of sufficient length for the Date/time area pointer in order to avoid 
any negative impact on HMI device performance.
Recommended: Acquisition cycle of 1 minute if your process can handle it.

 

"Date/Time PLC" is a global area pointer and may be configured only once per project.
 

 Note

You cannot use the "Date/Time" area pointer if you have configured the "Date/Time PLC" 
area pointer.

 

The "Date/time PLC" data area has the following structure:

Data word Left byte Right byte
15 . . . . . . 8 7 . . . . . . 0

n+0 Year (80 to 99/0 to 29) Month (1 to 12)
n+1 Day (1 to 31) Hour (0 to 23)
n+2 Minute (0 to 59) Second (0 to 59)
n+3 Reserved Reserved Weekday

(1 to 7, 
1=Sunday)

n+4 1) Reserved Reserved
n+5 1) Reserved Reserved

1) The two data words must exist in the data area to ensure that the data format matches 
WinCC and to avoid reading false information.

 
 

 Note

When making entries in the "Year" data area, you should note that values 80 to 99 result in 
years 1980 through 1999, while the values 0 to 29 result in the years 2000 through 2029.
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"Coordination" area pointer

Function    
The "Coordination" area pointer is used to implement the following functionality:

● Detecting the startup of the HMI device in the control program

● detection in the control program of the current HMI device operating mode

● detection in the control program of the HMI devices ready to communicate state

The "Coordination" area pointer has a length of one word.

Use
 

 Note

The HMI device always writes the entire coordination area when updating the area pointer.
The control program may not make changes to the coordination area for this reason.

 

Assignment of bits in the "Coordination" area pointer

Startup bit
The startup bit is set briefly to "0" by the HMI device during startup. It sets the bit permanently 
to "1" when startup is completed. 

Operating mode
The operating mode bit is set to 1 as soon as the user switches the HMI device offline. The 
state of the operating mode bit is "0" during normal operation of the HMI device.  You can 
determine the current operating mode of the HMI device by reading this bit.

Life bit
The HMI device inverts the life bit at intervals of approximately one second. You can check 
whether or not the connection to the HMI device is still up by querying this bit in the control 
program.
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"Project ID" area pointer

Function     
You can check whether the HMI device is connected to the correct PLC at the start of runtime. 
This check is important when operating with several HMI devices.

The HMI device compares a value stored on the PLC with the value specified in configuration. 
This ensures compatibility of configuration data with the control program. If discrepancy is 
detected, a system event is displayed on the HMI device and runtime is stopped.

Use
To use this area pointer, set up the following during the configuration:

● Define the version of configuration. Possible values between 1 and 255.
You enter the version in the editor "Runtime settings > General" in the "Identification" area.

● Data address of the value for the version that is stored in the PLC:
You enter the data address in the editor "Communication > Connections".

Connection failure
A connection failure to a device on which the "project ID" area pointer is configured results in 
all the other connections in the project being switched to "offline".

This behavior has the following prerequisites:

● You have configured several connections in a project.

● You are using the "project ID" area pointer in at least one connection.

Causes which may set connections "offline":

● The PLC is not available.

● The connection has been switched offline in the engineering system.

 

"PLC job" area pointer

Function     
The PLC can use the job mailbox to transfer jobs to the HMI device to trigger corresponding 
actions on the HMI device. These functions include, for example:

● Display screen

● Set date and time
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Data structure
The first word of the job mailbox contains the job number. Depending on the job mailbox, up 
to three parameters can be transferred.

Word Left byte Right byte
n+0 0 Job number
n+1 Parameter 1
n+2 Parameter 2
n+3 Parameter 3

The HMI device evaluates the job mailbox if the first word of this job is not equal to zero. This 
means that the parameters must be entered in the job mailbox first, followed by the job number.

When the HMI device accepts the job mailbox, the first word is set to 0 again. The execution 
of the job mailbox is generally not completed at this point in time.

Job mailboxes
All job mailboxes and their parameters are listed below. The "No." column contains the job 
number of the job mailbox. Job mailboxes can only be triggered by the PLC when the HMI 
device is online.

 

 Note

Please note that not all HMI devices support job mailboxes.
 

No
.

Function  

14 Setting the time (BCD coded)
 Parameter 1 Left byte:  -

Right byte:  hours (0-23)
 Parameter 2 Left byte:  minutes (0-59)

Right byte:  seconds (0-59)
 Parameter 3 -
15 Setting the date (BCD coded)
 Parameter 1 Left byte:  -

Right byte:  weekday 
                      (1-7: Sunday-Saturday)

 Parameter 2 Left byte:  day (1-31)
Right byte:  month (1-12)

 Parameter 3 Left byte:  year
23 User logon
 Logs the user on with the name "PLC user" at the HMI device with the group number transferred 

in Parameter 1.
The logon is possible only when the transferred group number exists in the project.

 Parameter 1 Group number 1 to 255
 Parameter 2, 3 -
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No
.

Function  

14 Setting the time (BCD coded)
24 User logoff
 Logs off the current user.

(The function corresponds to the "logoff" system function)
 Parameter 1, 2, 3 -
40 Transfer date/time to PLC
 (in the S7 format  DATE_AND_TIME)

An interval of at least 5 seconds must be maintained between two successive jobs to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
41 Transfer date/time to PLC
 (In OP/MP format)

An interval of at least 5 seconds must be maintained between successive jobs in order to prevent 
overload of the HMI device.

 Parameter 1, 2, 3 -
46 Update tags
 Causes the HMI device to read the current value of the tags•from the PLC whose update ID 

matches the value transferred in parameter 1.
(Function corresponds to the "UpdateTag" system function.)

 Parameter 1 1 - 100
49 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Warnings" class from the alarm buffer.
 Parameter 1, 2, 3 -
50 Delete alarm buffer
 Deletes all analog alarms and discrete alarms of the "Errors" class from the alarm buffer.
 Parameter 1, 2, 3 -
51 Screen selection 1)

 Parameter 1 Screen number
 Parameter 2 -
 Parameter 3 Field number
69 Read data record from PLC
 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 0: Do not overwrite existing data record

1: Overwrite existing data record
70 Write data record to PLC
 Parameter 1 Recipe number (1-999)
 Parameter 2 Data record number (1-65535)
 Parameter 3 -

1) OP 73, OP 77A and TP 177A HMI devices also execute the "Screen selection" job 
mailbox if the on-screen keyboard is active.
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"Data record" area pointer

"Data mailbox" area pointer

Function  
When data records are transferred between the HMI device and PLC, both partners access 
common communications areas on the PLC.

Data transfer types
There are two ways of transferring data records between the HMI device and PLC:

● Transfer without synchronization

● Transfer with synchronization over the data record

Data records are always transferred directly. That is, the tag values are read from an address 
or written to an address configured for this tag directly, without redirecting the values by means 
of interim memory. 

Initiating the transfer of data records
There are three ways of triggering the transfer:

● Operator input in the recipe view

● Job mailboxes
The transfer of data records can also be triggered by the PLC.

● Triggering by configured functions

If the transfer of data records is triggered by a configured function or by a job mailbox, the 
recipe view on the HMI device remains operable. The data records are transferred in the 
background. 

Simultaneous processing of several transfer requests is, however, not possible. In this case, 
the HMI device rejects the other transfer requests with a system event. 

Transfer without synchronization
If you select asynchronous transfer of data records between the HMI device and PLC, there 
is no coordination over the common data areas. It is therefore unnecessary to set up a data 
area during configuration.   

Asynchronous data record transfer can be a useful alternative, for example, when: 

● The system is capable of excluding the risk of uncontrolled overwriting of data by the 
communication peer.

● The PLC does not require information about the recipe number and data record number.

● The transfer of data records is triggered by the operator of the HMI device.
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Reading values
When a read job is triggered, the values are read from the PLC addresses and transferred to 
the HMI device.

● Triggering by the operator in the recipe view:
The values are downloaded to the HMI device. You can then process, edit, or save these 
values, for example. 

● Triggering by a function or job mailbox:
The values are saved immediately to the data volume.

Writing values
When a write job is triggered, the values are written to the PLC addresses.

● Triggering by the operator in the recipe view:
The current values are written to the PLC. 

● Triggering by a function or job mailbox:
The current values are written to the PLC from the data medium.

Transfer with synchronization
If you select synchronous transfer, both communication partners set status bits in the common 
data area. You can use this mechanism to prevent uncontrolled overwriting of data in either 
direction in your control program.     

Application
Synchronous data record transfer can be a useful solution, for example, when: 

● The PLC is the "active partner" in the transfer of data records.

● The PLC evaluates the information about the recipe number and data record number.

● The transfer of data records is triggered by means of a Job mailbox.

Requirements
In order to synchronize transfer of data records between the HMI device and the PLC, the 
following requirements must be met during configuration: 

● An area pointer has been set up: "Communication > Connections" editor in "Area pointer".

● The PLC with which the HMI device synchronizes transfer of data records is specified in 
the recipe:
"Recipes" editor in the inspector window the option "Coordinated transfer of data records" 
under "General > Synchronization > Settings"
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Structure of the data area
The data area has a fixed length of 5 words. Structure of the data area:

 15  0
1. Word Current recipe number (1 - 999)
2. Word Current data record number (0 - 65535)
3. Word Reserved
4. Word Status (0, 2, 4, 12)
5. Word Reserved

 

● Status
The status word (word 4) can adopt the following values: 

Value Meaning
Decimal Binary

0 0000 0000 Transfer permitted, data record free
2 0000 0010 Transferring.
4 0000 0100 Transfer completed without error
12 0000 1100 Transfer completed with error

Sequence of a transfer started by the operator in the recipe display

Reading from the PLC started by the operator in the recipe view  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe number to be read and the status 

"Transferring" in the data record and sets the data record number to 
0. 

Abort with system 
event.

3 The HMI device reads the values from the PLC and displays them in 
the recipe view.
If the recipes have synchronized tags, the values from the PLC are 
also written to the tags.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program must reset the status word to zero in order to 

enable further transfers.
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Writing to the PLC started by the operator in the recipe view

Step Action
 Check: Status word = 0?

1 Yes No
The HMI device enters the recipe and data record number to be 
written and the status "Transferring" in the data record.

Abort with system 
event.

2 The HMI device writes the current values to the PLC.
If the recipes have synchronized tags, the changed values are 
synchronized between the recipe view and tags and then written to 
the PLC.

 

3 The HMI device sets the status "Transfer completed."  
4 If required, the control program can now evaluate the transferred 

data. 
 

5 The control program must reset the status word to zero in order to 
enable further transfers.

 

 

 Note

The status word may only be set by the HMI device. The PLC may only reset the status word 
to zero.

 

 Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency is 
detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Sequence of the transfer triggered by a PLC job
The transfer of data records between the HMI device and the PLC can be initiated by either 
one of these stations.  

The two job mailboxes No. 69 and No. 70 are available for this type of transfer.

No. 69: Read data record from PLC ("PLC → DAT")
Job mailbox no. 69 transfers data records from the PLC to the HMI device. The job mailbox is 
structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 69
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 Do not overwrite existing data record: 0

Overwrite existing data record: 1
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No. 70: Write data record to PLC ("DAT → PLC")
Job mailbox No. 70 transfers data records from the HMI device to the PLC. The job mailbox 
is structured as follows:

 Left byte (LB) Right byte (RB)
Word 1 0 70
Word 2 Recipe number (1-999)
Word 3 Data record number (1 to 65535)
Word 4 —

Sequence when reading from the PLC with job mailbox "PLC → DAT" (no. 69)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
3 The HMI device reads the values from the PLC and saves these to the 

data record defined in the job mailbox.
 

4 ● If "Overwrite" was selected in the job, an existing data record is 
overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "Do not overwrite" was selected in the job, and the data record 
already exists, the HMI device aborts the job and enters 0000 1100 
in the status word of the data record.

 

5 The control program must reset the status word to zero in order to enable 
further transfers.

 

Sequence of writing to the PLC with job mailbox "DAT → PLC" (no. 70)

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number specified in 

the job and the status "Transferring" in the data record.
Abort without 

return message.
3 The HMI device fetches the values of the data record specified in the 

function from the data medium and writes the values to the PLC.
 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order to enable 
further transfers.
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Sequence of the transfer when triggered by a configured function

Reading from the PLC using a configured function  

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
record.

Abort with system 
event.

3 The HMI device reads the values from the PLC and stores them 
in the data record specified in the function.

 

4 ● If "Yes" was selected for the "Overwrite" function, an existing 
data record is overwritten without any prompt for confirmation.
The HMI device sets the status "Transfer completed." 

● If "No" was selected for the "Overwrite" function and the data 
record already exists, the HMI device aborts the job and 
enters 0000 1100 in the status word of the data record.

 

5 The control program must reset the status word to zero in order 
to enable further transfers.

 

Writing to the PLC by means of configured function

Step Action
1 Check: Status word = 0?

Yes No
2 The HMI device enters the recipe and data record number 

specified in the function and the status "Transferring" in the data 
record.

Abort with system 
event.

3 The HMI device fetches the values of the data record specified 
in the function from the data medium and transfers the values to 
the PLC.

 

4 The HMI device sets the status "Transfer completed."  
5 The control program can now evaluate the transferred data. 

The control program must reset the status word to zero in order 
to enable further transfers.

 

Possible causes of error when transferring data records

Possible causes of error  
The section below shows possible error causes which lead to the cancellation of data record 
transfer: 

● Tag address not set up on the PLC

● Overwriting data records not possible
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● Recipe number does not exist

● Data record number does not exist
 

  Note

The status word may only be set by the HMI device. The PLC may only reset the status 
word to zero.

 

  Note

The PLC may only evaluate the recipe and data record numbers when data inconsistency 
is detected if one of the conditions outlined below has been met:
● The data mailbox status is set to "Transfer completed".
● The data mailbox status is set to "Transfer completed with error".

 

Reaction to an aborted transfer due to errors
If the transfer of data records is aborted due to errors, the HMI device reacts as follows:

● Triggering by the operator in the recipe view
Information in the status bar of the recipe view and output of system alarms

● Triggered by function
Output of system alarms

● Triggering by job mailbox
No return message on the HMI device

You can nonetheless evaluate the status of the transfer by querying the status word in the data 
record.

10.11.18 Special features of WinAC MP

10.11.18.
1

WinAC MP basics

WinAC MP basics 
WinAC MP is a software package for HMI devices. WinAC MP integrates a software PLC 
compatible with SIMATIC S7 in WinCC Runtime. 

Using WinAC MP you can execute STEP 7 programs on the HMI device.

The common use of WinAC MP and WinCC provides process control and visualization on one 
HMI device. 

The communications driver for WinAC MP supports the following protocols for controlling the 
process components:
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● Industrial Ethernet

● PROFIBUS DP

The following screen shows the principal connection of the process components on the 
PROFIBUS DP example.

If you wish to control your process using an HMI device and WinAC MP, then you must install 
WinAC MP on your configuration PC. Then transfer WinAC MP and the project to your HMI 
device. 

 

 Note
Notes about instructions

The following describes how to install WinAC MP and transfer WinAC MP to an HMI device.

To transfer a STEP 7 project with a WinAC MP controller to an HMI device, you require 
experience with STEP 7. 
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10.11.18.
2

Communication options with WinAC MP

Definition of "routing"  
If there are stations in an automation system that are not connected to the same bus, these 
stations cannot be accessed directly online. To establish a connection to these devices, a 
router must be included between them. 

An MP x77 HMI device with WinAC MP can function as the router. As a router, it connects the 
Ethernet and PROFIBUS networks.

You can use routing, for example, to do the following:

● Download STEP 7 user programs

● Download a hardware configuration

● Execute testing and diagnostics functions

Definition of "Softbus"  
Virtual bus that allows data exchange between WinCC Runtime and WinAC MP. This bus is 
also installed when you install WinCC . After installing WinAC MP, S7 connections from WinCC 
Runtime to external stations on PROFIBUS or Ethernet are routed over Softbus.

Prior to installation of WinAC MP (without Softbus)

After installation of WinAC MP (with Softbus)
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Routing from Ethernet to PROFIBUS DP with WinAC MP
With STEP 7 on Industrial Ethernet, you can access all nodes on PROFIBUS DP from the HMI 
device. With WinCC, you can access the HMI device but not the nodes connected over 
PROFIBUS DP.

If the configuration PC is not connected directly to PROFIBUS DP, the nodes on PROFIBUS 
can nevertheless be reached because the MP x77 HMI device serves as a router.
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Figure 10-7 Routing from Ethernet to PROFIBUS DP with WinAC MP

Routing from PROFIBUS DP to Ethernet with WinAC MP
With STEP 7 on PROFIBUS DP, you can access all nodes on Industrial Ethernet from the HMI 
device. With WinCC on PROFIBUS DP, you have access to the HMI device and to OPs 
connected over PROFIBUS DP. 

Figure 10-8 Routing with WinAC MP over PROFIBUS
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Visualization over WinAC MP
Visualization over the HMI device between Industrial Ethernet and PROFIBUS DP is possible 
with WinCC.

It is not necessary to program the communication links. A PC serves as the visualization 
platform.

Figure 10-9 Visualization over WinAC MP
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CPU-CPU communication over WinAC MP
CPU-CPU communication is possible with the HMI device.

Figure 10-10 CPU-CPU communication over WinAC MP

10.11.18.
3

Standard procedure for communication with WinAC MP

Overview
The section below shows how to configure WinAC MP in a SIMATIC HMI station using a 
configuration PC on which STEP 7 and WinCC are installed.

The configuration PC and WinAC MP in a SIMATIC HMI station are interconnected via 
PROFIBUS DP. Configuration via Ethernet is also possible. A description of the procedure can 
be found in the "WinAC MP" manual.

You can integrate DP slaves for WinAC MP in the STEP 7 project.
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Procedure
The basic steps are as follows:

1. Configure WinAC MP in STEP 7.

2. Create a connection between WinAC MP and WinCC Runtime.

3. In STEP 7, download the configuration to WinAC MP.

4. Configure (visualization) HMI objects with WinCC .

5. Download the (visualization) configuration (for example, visualization with histogram) from 
WinCC to the HMI device.

10.11.18.
4

Configuring the WinAC MP communications driver

Requirements for the use of WinAC MP

Requirements
In order to use WinAC MP in the process control, you must perform the installation and 
development steps on your configuration PC. Transfer the necessary components to the HMI 
device.
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Basic procedure  
The following steps are described in more detail in the following:

1. Check that your system meets the system requirements:

– STEP 7 and the authorization are installed on the configuration PC.

– WinCC and the authorization are installed on the configuration PC.
WinCC Runtime and ProSave were installed along with WinCC.

2. When WinCC is installed, the WinAC MP option is also automatically installed. Authorization 
of the WinAC MP is carried out via separate licenses.
The following components are installed alongside WinAC MP:

– WinAC MP Runtime files

– WinAC MP system library

3. Develop a STEP 7 project for controlling your process with WinAC MP on the HMI device.

4. Develop a WinCC project for operating and visualizing your controller.

5. Connect the process components via the PROFIBUS network and configure the hardware.

6. Transfer the WinAC MP Runtime files from the configuration PC to the HMI device.
Use ProSave for this.

7. Transfer the WinAC MP authorization from its storage location to the HMI device.
Use the Automation License Manager for this.

8. Transfer the STEP 7 project to the HMI device.

9. Transfer WinCC Runtime and the WinCC project to the HMI device.
To do this, use the "Transfer" function.

Changing the device type

Introduction
There are different ways to create a SIMATIC HMI‑station with an HMI device and a configured 
WinAC MP controller.

Procedure 1

Create an HMI device in a SIMATIC HMI‑station in the device and network view. Then add the 
corresponding variant of WinAC MP.

The advantage of this procedure is that you can choose the device type (MP 177, MP 277 or 
MP 377) and the design of the device type (monitor size and touch or key) directly on selection 
in the hardware catalog.

Procedure 2

Insert the desired variant of WinAC MP directly in the device and network view.

This procedure creates, by default, the largest touch design of the selected HMI device in the 
device and network view.
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Changing the device type
Select a device. You can change the device type using the shortcut menu command "Change 
device". When the device type MP277 is changed to MP377 and MP 177 or vice versa with a 
configured WinAC MP controller in a SIMATIC HMI station, the WinAC MP controller is 
automatically moved to the storage location of the non slotted modules. It can therefore not 
be used in the new HMI device. If the the device type is changed, the WinAC MP‑configuration 
must be created again.

Connecting the configuration PC and HMI device

Procedure for creating a connection via Ethernet or PROFIBUS DP

Basic procedure
WinAC MP supports the communication between the configuration PC and the HMI device via 
the following connections:         

● Industrial Ethernet

● PROFIBUS DP

● USB

To achieve successful communication, follow these steps:

1. Connect the configuration PC to the HMI device.

2. Make the parameter settings for data transfer on the control panel.

3. Make the parameter settings for data transfer on the configuration PC.

4. Set the communications parameters in ProSave.
With ProSave you can load the WinAC MP Runtime files in the HMI device. Therefore, you 
must set the communication parameters both in ProSave as well as on the HMI device.

5. Set the communications parameters in WinCC.
Use WinCC to download your project to the HMI device using the "Download" function.

Establishing a connection over Ethernet

Connect the configuration PC to the HMI device (Ethernet)
In order to communicate via an Ethernet network you can either use a direct connection or a 
networked connection. 

To connect a configuration PC to an HMI device via Ethernet, follow these steps:
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1. Connect the interfaces of the configuration PC and the HMI device with an Ethernet cable.
 

  Note

Use a crossover cable to create a direct connection between the configuration PC and 
the HMI device.

To connect the configuration PC and the HMI device to an Ethernet (LAN) use a 1 to 1 
cable with RJ45 connector.

The interface to be used on the HMI device can be established from the operating 
instructions of your HMI device.

 

Configuring the transmission settings in the Control Panel (Ethernet)

Requirements
The configuration PC and HMI device are connected to each other over an Ethernet cable. 

Setting up an IP address on the control panel
The set up the IP address on the control panel, follow these steps:

1. Switch on the HMI device.
Before the HMI device opens an existing project, the "Loader" selection field appears. 

2. Select "Control Panel".

3. Double click on the "Network and Dial-up Connection" symbol.

4. Double-click on the LAN connection.

5. Select the "IP Adress" tab.
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6. Select "Specify an IP address".

7. Enter the IP address and the subnet mask that you were given by your network 
administrator.

8. Confirm your entries with "OK".

Entering transfer settings
To make the data transfer settings, follow these steps:

1. In the control panel, double click on the "Transfer" symbol.

2. Select the "Channel" tab.

3. Select the "Ethernet" option in the "Channel 2" area.

4. Enable "Enable Channel" and confirm your entries.

5. Click "OK" and end the dialog "Transfer Settings".

The transmission settings are configured on the configuration PC

Requirement
● The configuration PC and HMI device are connected to each other over an Ethernet cable

● The data transfer settings have been made on the control panel  
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Procedure
To make the data transfer settings on the configuration PC, follow these steps:

1. Open the network settings of your PC.

2. Select the "Internet Protocol (TCP/IP)".

3. Enable the "General" tab.

4. Select the "Use the following IP address" check box in the protocol properties.

5. Enter an "IP address".

6. Enter a "subnetwork mask".

7. Confirm your entries.
 

  Note

The IP addresses of the configuration PC and the HMI device must not be the same.

The subnet mask must be the same for the configuration PC and the HMI device.
 

Set the communication parameters (Ethernet)

Requirement
● The configuration PC and HMI device are connected to each other over an Ethernet cable

● The data transfer settings have been made on the control panel

● The data transfer settings have been made on the configuration PC

Procedure
To make the communications parameter settings in ProSave, follow these steps:

1. Make the transfer settings first.

2. To do this, select the desired component in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.

4. Select the "Options" command from the "Online > HMI device maintenance" menu to start 
ProSave .
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5. Select an element under "Available options".

6. Click ">>".

 

Setting the communication parameters in WinCC (Ethernet)

Requirement
● The configuration PC and HMI device are connected to each other over an Ethernet cable.

● The data transfer settings have been made on the control panel.

● The data transfer settings have been made on the configuration PC.

Procedure
To make the connection settings in WinCC, follow these steps:

1. Open the transfer settings.

2. Select the desired HMI device in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.
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4. Select the "Ethernet" mode.

5. Specify the IP address or the computer name of the HMI device.

6. Switch the HMI device to "transfer" mode.

7. Transfer the WinCC project to the HMI device.
 

 
 WARNING

Death, serious bodily harm and / or damage to property from unexpected process or 
machine behavior.

If you use DHCP it is not guaranteed that every time the same IP address will be issued 
if a node is switched on.

Nodes could lose the connection in the Industrial Ethernet or be connected with incorrect 
nodes. Always enter a static IP address for the HMI device. Contact your network 
administrator for address allocations.
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Establishing a connection via PROFIBUS DP

Connect the configuration PC to the HMI device (PROFIBUS DP)
1. Connect the interfaces from the configuration PC and the HMI device with an 

PROFIBUS DP cable.
 

  Note

To communicate via an PROFIBUS DP network you must create a direct connection.

Check if your configuration PC has a suitable interface for connection to the PROFIBUS 
DP.

If this interface is missing, you must perform the following steps:
● Build a card into the configuration PC, e.g. CP 5611 for desktop PCs.
● Install the respective drivers.

 

Configuring the transmission settings in the Control Panel (PROFIBUS DP)

Requirement
● The configuration PC and HMI device are linked with each other via a PROFIBUS DP cable.

Procedure
Perform the following steps on the HMI device:

1. Switch on the HMI device.
Before the HMI device opens an existing project, the "Loader" selection field appears. 

2. Select "Control Panel".

3. Double click on "Transfer".

4. Select the "MPI/PROFIBUS" option from the "Channel 2" selection list under the "Channel" 
tab.
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5. Select "Enable Channel".

6. Confirm with "OK".

7. "Transfer Settings" End the dialog.

 

Setting the communication parameters in ProSave (PROFIBUS DP)

Requirement
The configuration PC and HMI device are linked with each other via a PROFIBUS DP cable.

The data transfer settings have been made on the control panel.

Procedure
To make the communications parameter settings in ProSave, follow these steps:

1. Make the transfer settings first.

2. To do this, select the desired component in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.

4. Select the "Options" command from the "Online > HMI device maintenance" menu to start 
ProSave .
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5. Select an element under "Available options".

6. Click ">>".

Set the communication parameters in WinCC (PROFIBUS DP)

Requirement
● The configuration PC and HMI device are linked with each other via a PROFIBUS DP cable.

● The data transfer settings have been made on the control panel.

Procedure
To make the connection settings in WinCC, follow these steps:

1. Open the transfer settings.

2. Select the desired HMI device in the project tree.

3. Select the "Download to device > Software" command in the shortcut menu.

– If you have not already established an online connection, the "Extended download to 
device" dialog will automatically open. In this case, set all the necessary parameters for 
the connection and click "Load".

– If you have already defined an online connection, the project data will be compiled 
immediately and the "Load preview" dialog will open. This dialog displays messages 
and proposes actions necessary for uploading.

4. Select the "MPI / PROFIBUS DP" mode.
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5. Specify the PROFIBUS address that is assigned to the HMI device.
The PROFIBUS address is the station address and corresponds to the address configured 
for the WinAC MP controller.

6. Switch the HMI device to "transfer" mode.

7. Transfer the WinCC project to the HMI device.
 

  Note

For PROFIBUS DP transmission the WinAC MP control must be started on the HMI device.
 

10.11.18.
5

Transferring WinAC MP to the HMI device

Procedure for transferring WinAC MP

Introduction
If you want to execute WinAC MP on the HMI device you must transfer the WinAC MP Runtime 
files from the configuration PC to the HMI device. For the transfer there must be a data 
connection between the configuration PC and the HMI device. The following screen shows the 
arrangement using example Industrial Ethernet.
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Basic procedure
To transfer WinAC MP Runtime files to an HMI device, follow these steps:

1. Setting up the HMI device.

2. Configure the ProSave  on the configuration PC.

3. Start transfer.

 

Switch the HMI device to transfer mode

Procedure
For the transfer of data you must switch the HMI device to "Transfer":

1. Switch on the HMI device.
Before the HMI device opens an existing project, the "Loader" selection field appears. 

2. Click on the "Transfer" button.
The dialog window displays the message "Connecting to host ...".

 

Configuring ProSave on the configuration PC

Requirement
The HMI device was switched to transfer mode.

Procedure
To set up a configuration PC to transfer WinAC MP, proceed as follows:

1. Start ProSave.

2. Select the "General" tab.

3. Select the device type of your HMI device.
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4. Select the "Ethernet" connection type.

5. Specify the IP address or the computer name of the HMI device.

6. Start the transfer of WinAC MP.

Start transfer

Requirement
● The HMI device was switched to transfer mode.

● ProSave is set up on the configuration PC.
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Procedure
To start the transfer of WinAC MP files, follow these steps:

1. Open the "Options" tab in transfer mode and click the "Device status" button. If no error 
message is shown then the communication connection is valid.  

 

  Note

If there is a communication error, then you must check the following circumstances: 

• The HMI device must be in Transfer mode.

• Check the cable connections for a correct and firm connection.

• The settings in ProSave and on the HMI device must be correctly defined for the 
connection.

 

2. In the "Options" tab, select "WinAC MP" below "Available options".
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3. To transfer WinAC MP to the HMI device, click the  button.

ProSave then starts to load the software of the WinAC MP control to the HMI device. While 
the files are being transferred the configuration PC shows the progress of the transfer.
The following messages are displayed on the HMI device in the "Transfer" dialog box:

– Progress of the file receipt on the HMI device.

– Unzip data in the Flash file system.

– Save data in the Flash file system.

At the end of the transfer, a message confirms a successful transfer.

4. When transfer is complete, you will be asked to restart the device. Restart the device.

Result
The WinAC MP control is now installed on the HMI device. Now, transfer the authorization for 
WinAC MP to the HMI device.
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10.11.18.
6

Transferring authorization to the HMI device

Introduction
You need a license key to operate WinAC MP. The license key is transferred with the 
Automation License Manager to the HMI device.

Requirements
The storage location of the license key can be called from the configuration PC.

Procedure
To transfer the WinAC MP authorization to an HMI device, follow these steps:

1. Select the "Authorize/License" command from the "Online > Device maintenance" menu 
to start WinAC MP authorization.
Automation License Manager is launched.

2. Select the "Connect HMI device" menu command.

3. Select the device type of the HMI device.

4. Select the type of connection and set the parameters for the connection.
The connection to the HMI device is established. The connected HMI device is displayed.

5. Select the source drive.
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6. Drag one or more license keys to the HMI device.
The license keys are then transferred to the HMI device.

7. Close the Automation License Manager after a successful transfer.   

10.11.18.
7

WinAC MP system library

Screens from the system library
The screens from the system library are optimized for a 6' display with a resolution of 320 x 
240. If you use a display of a different size, you can adapt the screens for your display in WinCC.

Standard screens and tags
The WinAC MP‑system library offers you the standard screens "WinAC_MP_Home" and 
"WinAC_MP_Tuning" and the tags "WinAC_MP_Tags". To use the standard screens, move 
them to the "Screens" folder in the project tree.

In addition to the standard screens, the tags must be copied separately. To do this, drag 
"WinAC_MP_Tags" from the WinAC MP‑system library to the "HMI_Tags" folder in the project 
tree.

10.12 Using global functions

10.12.1 Working with the HMI Device Wizard

10.12.1.1 HMI device wizard basics

Introduction
The HMI device wizard will automatically start when you create a new HMI device in your 
project. 
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HMI device wizard
The HMI device wizard will guide you through each dialog step by step and help you set up a 
device. You use the HMI device wizard to specify the basic settings for your HMI device, such 
as screen layout and the connection to your PLC.

 

See also
HMI device wizard basics (Page 6806)

Data exchange between projects and external applications (Page 6829)

General information about cross references (Page 6878)

Languages in WinCC (Page 6884)

Basics (Page 6912)
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10.12.1.2 HMI device wizard basics

Introduction  
The HMI device wizard will guide you through each dialog step by step and help you set up a 
device. You use the HMI device wizard to specify the basic settings for your HMI device, such 
as screen layout and the connection to your PLC.   
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Opening the HMI device wizard
1. Add a new device to your project, for example, RT Advanced.

2. Click on the device in the project tree.

3. Select "Start the HMI device wizard" in the shortcut menu. The "HMI device wizard" opens.
 

  Note

If you make changes after adding the device, such as adding a new screen, the HMI device 
wizard will not open again. 

 

  Note

When you create a device with a color display using the HMI device wizard, the graphics 
of the navigation buttons may be displayed in black and white. This error only occurs, 
however, if the new device is created with the same name as a device with a monochrome 
display which has been deleted in the meantime.

You can avoid this error by always deleting the associated graphics in the Graphics 
collection whenever you delete a device from the project.

 

See also
HMI device wizard basics (Page 6802)

10.12.2 Working with libraries

10.12.2.1 Basics on libraries

Introduction
Store all objects you need frequently in the libraries. An object that is stored in the library only 
has to be configured once. It can then be used repeatedly as often as required. Library objects 
extend the number of available screen objects and increase the effectiveness during 
configuration through the multiple usage of ready-to-use objects.

Your WinCC software package is supplied with comprehensive libraries that contain, for 
example, "Motor" or "Valve" objects. You may, however, define your own library objects. 

You manage libraries in the "Libraries" task card or library view. The following libraries are 
available:         
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● Project library

● Global libraries

 

 Note

There is a symbol library in the "Tools" task card in the "Graphics" palette.
 

Project library
There is one library for each project. Objects of the project library are stored alongside with 
the project data and are available only for the project in which the library was created. If the 
project is moved to another PC, any project library created in it is also moved. 

To use the library object of the project library in other objects, move or copy the object into a 
global library.

Global libraries
A global library is saved independently of the project data in its own file with the extension 
*.aI12.

A project can access several global libraries. A global library may be used concurrently in 
several projects. 

When a library object is changed by a project, this library will be changed in all projects in 
which these libraries are open. 
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Library objects   
A library can contain all WinCC objects. Examples: 

● Complete HMI device

● Screens

● Display and control objects including tags and functions

● Graphics

● Tags

● Alarms

● Text and graphics lists

● Faceplates

● User data types

 

See also
Copy templates and types (Page 6811)

Screen basics (Page 3299)

10.12.2.2 Overview of the library view

Function of the library view
The library view combines the functionality of the "Libraries" task card and the overview 
window. In the library view, the elements of a library are displayed in various views. In the 
details view, for example, you see additional properties of the individual elements. You can 
also edit and version the types in the library view.
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Layout of the library view
The following figure shows the components of the library view:

1 Library tree
2 Library overview
3 "Library view" button
4 "Open or close library overview" button

Library tree
The library tree is similar to the "Libraries" task card, apart from a few minor differences. In 
contrast to the task card, there is no "Elements" palette, because the elements are displayed 
in the library overview. In addition, you can close the library view in the library tree, or open 
and close the library overview.
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Library overview
The library overview corresponds to the overview window and displays the elements of the 
currently selected object in the library tree. You can display the elements in three different 
views. You can also perform the following actions in the library overview, for example:

● Copying elements 

● Moving elements

● Versioning types

● Editing faceplates and HMI user data types

● Editing type instances

10.12.2.3 Copy templates and types

Introduction
Both the "Project library" and the "Global library" contain the two folders "Master copies" and 
"Types". You can create or use the library objects either as a master copy or a type. 

Master copies     
Use master copies to create independent copies of the library object. 

Types     
Create instances of objects of the "Types" folder and use these in your project. The instances 
are bound to their respective type. 

Administration of the library objects   
You can copy and move library objects to another library. You can only copy master copies to 
the "Master copies" folder or any sub-folder of "Master copies". You can also only insert types 
in the "Types" folder or any sub-folder of "Types". 

See also
Basics on libraries (Page 6805)

State of type versions (Page 6825)
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10.12.2.4 Libraries in WinCC

Introduction
The WinCC software package includes extensive libraries. Sorted by topic into folders, they 
contain preassembled graphic objects which you can use in screens for operation and 
monitoring of your plant.

Global library "Buttons and Switches"
The libraries "Buttons and Switches" offer a wide selection of buttons and switches.     

The folders divide switches and buttons into categories. The "DiagnosticsButtons" folder 
contains the object "System diagnostics indicator", for example. You use the "System 
diagnostics indicator" object for system diagnostics in your plant. 

 

 Note

You can only use the objects in the "DiagnosticsButtons" folder on Comfort Panels. 

You cannot use objects which have "Switch" in the object name or in the associated folder 
name in Runtime Professional.
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Global library "Monitoring and Control objects"
The "Monitoring and Control objects" library offers more complex display and operating objects 
in several designs and corresponding control lights, buttons and switches. 

 

In addition, graphics views for the designs are stored in the "Design_Backgrounds" folder; they 
can be used as object backgrounds for the custom extension of the scope of the library.

 

 Note

You cannot use objects which have "Switch" in the object name in Runtime Professional. The 
same applies for the object "D5_Display_3" with the date/time field it contains.

 

10.12.2.5 Managing libraries

Overview of the library management

Function of the library management
Master copies and types with dependencies to other library elements are subject to some 
functional restrictions. They can, for example, not be deleted as long as dependencies still 
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exist. This prevents other library elements from becoming useless. The library management 
is used to identify the dependencies and to create an overview of the work progress.

The library management offers the following functions:

● Display of the correlations of types and master copies
If a type is referenced in other types or master copies, the correlations are displayed in the 
library management. You will also be able to see which library elements reference a type 
or a master copy.

● Display of points of use of types in the project

● Display all types that include a version with the "In testing" or "In progress" status

Layout of the library management
The following figure shows the components of the library management:

 

① Toolbar of the library management
② "Types" area
③ "Uses" area
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Toolbar of the library management
You can perform the following tasks in the toolbar of the library management:

● Update view
If the project was changed, you can update the view of the library management.

● Clean up library
You can clean up the project library and global libraries. By cleaning up a library, you delete 
all types and type versions that are not linked to an instance in the project.

● Harmonize project
By harmonizing a project, you adapt the names and the path structures of type uses in the 
project to the corresponding names and path structures of the types within a library.

"Types" area
The "Types" area displays the contents of the folder that you have selected in the library view. 
You can open or close all types by using the buttons in the toolbar of the "Types" area. You 
can also use the "Filter" drop-down list to filter the view and display all types with the "In testing" 
or "In progress" status only. For each type, the types that it references are displayed.

"Uses" area
The "Uses" area gives you an overview of the points of use of the selected types and master 
copies. The "Uses" area is divided into two tabs:

● "Uses in the project" tab
The "Uses in the project" tab is used to show the instances of type versions and their 
respective point of use in the project. When you select an instance, you can show the cross 
references of the instance in the project in the Inspector window.

● "Uses in the library" tab
The "Uses in the library" tab is used to show all points within the library at which a type or 
a master copy is used.

Opening library management

Procedure
To open the library management, follow these steps:

1. Open the library view.

2. Select a type or any folder that contains types.

3. Select the "Library management" command from the shortcut menu.

Result
The library management opens and the types are displayed with their versions.
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Filtering types in the library management

Introduction
A filter function in the library management enables you to limit the displayed types. The 
following filters are available:

● Display all types that include a version with "in progress" status

● Display all types that have no instances in the project

● Display all types that have more than one version

● Display all released types 

Requirement
At least one type has been created.

Filtering for all types with "in progress" status
1. Select the "Types" folder in the project library.

2. Select the "Library Management" command in the shortcut menu of the "Types" folder.
The library management opens.

3. Select "Pending changes" from the "Filter" drop-down list.
The "Types" area only displays types that have the "in progress" status.

Filtering for all types that have no instances in the project
1. Select the "Types" folder in the project library.

2. Select the "Library Management" command in the shortcut menu of the "Types" folder.
The library management opens.

3. Select "No instances in project" from the "Filter" drop-down list.
"Not used in project" or "No instances in the project"?
The "Types" area only displays types that have the "in progress" status.

Filtering for types with multiple versions
1. Select the "Types" folder in the project library.

2. Select the "Library Management" command in the shortcut menu of the "Types" folder.
The library management opens.

3. Select "Multiple versions" from the "Filter" drop-down list. 

4. The "Types" area only displays types that have more than one version.
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Filtering for all released types
1. Select the "Types" folder in the project library.

2. Select the "Library Management" command in the shortcut menu of the "Types" folder.
The library management opens.

3. Select "Released types" from the "Filter" drop-down list.
The "Types" area only displays types that have released versions.

See also
Opening library management (Page 6813)

Creating a global library

Introduction
In the libraries you store the configured objects that you want to use several times in your 
configuration. To use objects in several projects, create a global library.    

Requirement
● A project is open.

● The "Libraries" task card is displayed or the "Library view" is open.

Procedure
1. Click the  icon under "Global library".

The "Create new global library" dialog opens. 

2. Enter a name.

3. Select the path where the new library is to be stored.

4. Click "Create".
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Result
The new library is shown in the "Global libraries" palette. The global library contains the 
"Types", "Master copies" and "Common data" folders. Under the "Common data" you can find 
reports for the global library.

A folder with the name of the global library is created in the file system at the storage location 
of the global library. This actual library file is given the file name extension ".al12". 

Saving a global library

Introduction
A global library is stored in a separate file on your hard disk drive. The file contains the objects 
of the global library including the referenced objects. E.g. the reference of a tag which was 
configured on an I/O field is also saved in the library.       

WinCC prompts you to save the global libraries when you close WinCC or your project without 
saving. You also can store the global library during configuration, without storing the entire 
project. 

Requirement
● You have opened a project which contains at least one library.

● The "Libraries" task card is displayed or the library view is open.

● A library has been changed.

Procedure
1. Select the global library that you want to save.

2. Click the  icon in the "Global library" palette.

You can alternatively select the "Save Library" command in the shortcut menu. 

If you want to store the global library in a different folder, select "Save as" in the shortcut menu. 
Select the path in which you want to store the new library and enter a file name. 

Result
The global libraries are saved under their current file name or a file name you have specified. 

Opening a global library

Introduction
In WinCC, the global libraries are stored in separate files. You can use a global library in every 
project.       
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Requirement
● You have saved a global library.

● A project is open.

● The "Libraries" task card is displayed or the library view is open.

Procedure
1. Click the  icon in the "Global library" palette.

The "Open global library" dialog box is displayed. 

2. Select the path in which the library is stored.

3. Click "Open".
 

  Note

To have the access to a global library from multiple projects, open the global library read-
only. As soon as a global library is not opened read-only, access from other projects is 
blocked.

 

Result
WinCC displays the opened global library in the "Global library" palette. 

Displaying logs of global libraries
Logs listing all changes made to the global library are created when global libraries are 
updated. The logs are stored together with the global library and are always available once 
you have opened the global library.

Procedure
To open the logs of a global library, follow these steps:

1. Open the global library in the "Libraries" task card or in the library view.

2. Open "Common data > Logs" in the lower-level folder.

3. Double-click the required log.
The log opens in the work area.

Updating a project with the contents of a library

Introduction
After you have edited several types in the project library, update all instances in the project to 
the most recent version of the types from the project library. 
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Requirement
The "Libraries" task card or the library view is open.

Procedure
1. Select the project library.

2. Select "Update > Project" from the shortcut menu. A dialog opens.

3. Select either the entire project or individual devices for the update.

4. Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

5. Click "OK" to confirm.

Result
All instances of the types are updated in the project to the most recent version of the selected 
types in the project library. 

You can find a log of the update process in the project tree under "Common data".

Updating a library with the contents of another library
The following options are available for updating libraries:

● Updating a global library with types from another global library

● Updating the project library with types from a global library

Each of the following elements can be selected as source for the update:

● An entire library

● Individual folders within a library

● Individual types

Requirement
To update a global library, open the library with write rights.

Requirement
The "Libraries" task card or the library view is open.

Procedure
To update a library with the contents of a different library, follow these steps:

1. Select the entire library or a folder within the library or individual types.

2. Right-click the source and select the "Update > Library" command from the shortcut menu.
The "Update library" dialog box opens.
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3. Select the type of library you want to update:

– Select "Update the project library" to update the project library with types from a global 
library.

– Select "Update a global library" if you want to update a global library.

4. Optional: Select the global library you want to update from the drop-down list.

5. Select the "Delete all unused versions of affected types" check box to delete all older 
versions of the updated types from the project library.

6. Click "OK" to confirm.

Result
● Types not yet available in the target library are supplemented there with all their versions. 

More recent versions are added to the types that already exist in the target library. 
If a more recent version of a type already exists in the target library, the latest version is 
nevertheless copied and automatically assigned a newer version number.

● A log listing all performed changes to the target library is created for the update process. 
If you have updated the project library, you can find the log in the project tree under 
"Common data > Logs". 
If you have updated a global library, you can find the log in the "Common data > Logs" 
folder in the level below the global library.

10.12.2.6 Managing objects in a library

Displaying library objects

Introduction
The libraries are displayed as file folders in the corresponding palette. The elements contained 
in the library are displayed in the file folder and in the "Elements" palette.

Requirement
● At least one library object has been created in a library.

● The "Libraries" task card is opened.
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Procedure
1. Select the library in the corresponding palette whose library objects you want to display.

2. Click .
The contained library objects are displayed in the "Elements" palette. 

3. Click one of the following icons:
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Icon Description
Element view in detailed mode

Element view in list mode

Element view in overview mode with icons

When several objects are assigned to the library with a multiple selection, only one of the 
objects is shown in the "Elements" palette. The individual components of this element are 
displayed in the "Parts" palette.

Show parts of the library objects
1. Select the library in the corresponding palette from which you want to view the components 

of an element.

2. Click .

3. The contained library objects are displayed in the "Elements" palette.

4. Select the element.
The "Parts" palette shows the objects of which the element consists.

Result
The library objects are displayed in accordance with the configuration. The components of the 
faceplates are displayed.
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Storing an object in a library

Introduction
You can store all of WinCC objects, such as screens, tags, graphic objects or alarms in your 
libraries. You can use drag-and-drop to move the corresponding object from the work area, 
project window or detail view to the library. In a library you have divided into categories, you 
can directly add objects to a specific category.   

Requirement
● The "Screens" editor is open.

● A screen object has been created in the work area of the screen.

● The created libraries are displayed.

Procedure
1. Select the object in the work area of the "Screens" editor.

2. Drag-and-drop the object from the work area to the desired library.
The mouse pointer is transformed into a crosshair with an appended object icon.

Result
The object is saved to the library for further use in multiple instances of your configuration.

Inserting a library object

Introduction
The system always assigns the inserted library object a name which consists of the name of 
the object type and of a consecutive number. 
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If the inserted object already exists, you have the option of replacing the object or of saving it 
under a new name. 

You cannot insert library objects that are not supported by the HMI device.
 

 Note

If you insert a screen with interconnected template from the library, the template will also be 
inserted. Any existing matching template is not used.

 

Requirement
● The "Libraries" task card is opened.

● The editor in which you want to insert the library object is open.

Procedure
1. Select a library object from the library.

2. Drag-and-drop the library object to the position in the work area where you want to insert 
the object.
The library object is inserted.

Result
If the object was contained in the "Copy templates" folder, you have inserted an independent 
copy of the library object in the editor.

If the object was contained in the "Types" folder, you have inserted an instance of the library 
object in the editor.

See also
Copying and pasting (Page 6929)

10.12.2.7 Using types and their versions

State of type versions

Introduction
Depending on the point of use, the version of a type has different statuses.

Released version
The "released version" status is available for all types, regardless of the point of use.
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If you want to edit a released version, you must first create a new test version or an "in progress" 
version.

Released type versions of scripts and screens can be opened and viewed at their instance.

"In progress" version
The "in progress" status is possible for the following types:

● Faceplates

● User data

● Styles

When you create a new type or a new version of a released type, the type is assigned the 
status "in progress".

Types with the "in progress" status can be edited in the library view without the need for a 
reference to an instance in the project. Upon release, the compatibility of the type is tested by 
a consistency check.

"In testing" version
Only versions of scripts and HMI screens have the "in testing" status.

When you create a new version of a type, the type is assigned the status "in testing".

A version with "in testing" status is linked to an instance in the project. You can set only one 
version to "in testing" for each type at a given time.

A version in testing may only be linked to a single instance in the project. Therefore, it is not 
possible to copy an instance to the clipboard, to duplicate it or to create an additional type from 
the instance as long as it has "in testing" status.

See also
Generating a script as a type (Page 6826)

Generating a screen as a type (Page 6827)

Create a new version of a type (Page 6828)

Copy templates and types (Page 6809)

Generating a script as a type

Requirement
● A project is open.

● An HMI device has been created and opened.

● The project tree is open.

● The "Libraries" task card is opened.
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Procedure
1. Open the "Scripts" editor in the project tree.

2. Create a new script.

3. Select the script in the project tree.

4. Drag-and-drop the script into a library in the "Libraries" task card. A dialog opens.

5. Enter a name.

6. Enter a comment.

Result
You have created a type version of a script in the library. The created type is stored as a 
released version in the library. An instance of the type is used in the project.

To change the script create a new version of the script.

See also
State of type versions (Page 6823)

Generating a screen as a type

Requirement
A project is open.

An HMI device has been created and opened.

The project tree is open.

The "Libraries" task card is opened.

Procedure
1. Open the "Screens" editor in the project tree.

2. Create a new screen.

3. Select the screen in the project tree.

4. Drag-and-drop the screen into a library in the "Libraries" task card. A dialog opens.

5. Enter a name.

6. Enter a comment.

Result
You have created a type of a screen in the library. 

The created type is stored as a released version in the library. An instance of the type is used 
in the project.
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To change the screen create a new version of the screen.

See also
State of type versions (Page 6823)

Generating a style as a type

Introduction
To define a new style, add a new type in the project library. 

Adding a new style
1. Open the "Libraries" task card. 

2. Select the "Add new type" command under "Types" in the shortcut menu of the project 
library. A dialog opens.

3. Select "HMI style". 

Result
The new style is created and displayed under its selected name in the project library. The HMI 
style type is assigned the status "in progress" and the version 0.0.1. 

Create a new version of a type

Principle
If you create a new version of a type, the point of use of the type determines the status of the 
newly created version.

Requirement
The "Libraries" task card is opened.

A type has been created and released.

Procedure
1. Select the released type.

2. Select "Edit type" in the shortcut menu.

Result for types of faceplates, user data, and styles
A new version of the type is created.
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The version has the status "in progress". The library view opens.

Result for types of scripts and screens
A dialog opens.  

After you have selected the settings in the dialog, the version is set to the status "in testing". 
The instance used in the project is set to the status "in testing". The library view opens.

See also
State of type versions (Page 6823)

10.12.3 Importing and exporting project data

10.12.3.1 Data exchange between projects and external applications

Introduction
WinCC gives you the option of exchanging project data between the projects or copying them 
to external applications. 

Exporting and importing between projects
You can export the following project data from a project and import them into another project. 

● Recipe data records

● Alarms

● Tags

● Text lists

● Project texts

Exporting and importing reduces the workload. Instead of creating new data records, you use 
data already created in previous projects.

Editing the export file
The following file formats are available for export and import depending on the editor:

● *.xlsx for alarms, tags, project texts and text lists

● *.csv for recipe data records

You can edit the import file in Excel, for example.
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XLSX file format
XLSX format is a file format for Excel tables based on the Open XML format. XLSX files are 
optimized for Microsoft Excel 2007.

You can sort the columns as required in the XLSX file.

CSV file format
CSV stands for Comma Separated Value. In this format, the columns of the table that contain 
the names and the value of the entry are separated by semicolons. Each table row terminates 
with a line break. You can also open the CSV file for editing in Excel.

Importing project data
When project data is imported, the objects in the project are created.

The syntax of the import file is checked during import. The accuracy of the values imported 
and dependencies between the imported values are not checked.

Any errors found in the imported data are reported when the project is compiled.

Copying in Excel format
In all spreadsheet editors you can copy the content in Excel format into the buffer of your PC. 
Subsequently you insert the project data in Excel format directly into any application outside 
the TIA Portal. To this purpose you use the corresponding command in the shortcut menu of 
the work area:

● If you select the command in the shortcut menu of the line header, the complete line is 
copied into the buffer.

● If you select the command in the shortcut menu of a cell, only the cell content is copied into 
the buffer. 

● If you select several lines and select the command, all marked data are always copied into 
the buffer. 

This data exchange is only possible as an export.

 

See also
HMI device wizard basics (Page 6802)
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10.12.3.2 Importing and exporting recipe data records

Exporting recipe data records

Introduction
WinCC features an export function for exporting data records from recipes.     

Requirements
● The WinCC project for the export is open.

● Recipes have been created in a project.

● The "Recipes" editor is open.

Exporting recipes
1. In the "Recipes" editor, select the recipe with the data records you want to export.

2. Click .
The "Export" dialog box opens.

The selected recipe is shown under "Recipe selection".

3. Under "Content selection", specify if all or only selected data records are to be exported.

4. Under "File selection", specify the file in which the recipe data is to be stored.

5. Specify the list separator and decimal separator under "Data separation".

6. Click "Export."
The export will start. 
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Result
The exported data has been written to a CSV file. The CSV file will be stored in the specified 
directory. 

See also
Importing recipe data records (Page 6832)

Importing recipe data records

Introduction
Recipes are identified by their name. The recipe name must therefore be unique. Open the 
import file in a simple text editor to check that it has the correct data structure.

Specify whether or not existing data records should be overwritten by records with the same 
name during the import.    

Requirements
● A CSV file containing at least one recipe has been created.

● The WinCC project for the import is open.

● The "Recipes" editor is open with at least one recipe.
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Importing a recipe
1. In the "Recipes" editor, select the recipe with the data records you want to import.

2. Click .
The "Import" dialog box opens.

The selected recipe is shown under "Recipe selection".

3. Select the file you want to import under "File selection".

4. Under "Strategy", specify if existing data records should be overwritten by records of the 
same name.

5. Under "Data separation", select the list separator and the decimal separator to use in the 
CSV file.

6. Click "Import".
The import will start. 

Result
The data records are created in the selected recipe. Depending on the setting for "Strategy", 
existing data records are overwritten by records with the same name from the CSV file. 

Existing data records with the same name will also be imported from the CSV file if you 
deactivate the "Overwrite existing data records" option. 

See also
Exporting recipe data records (Page 6829)
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Exporting recipe data records

Introduction
WinCC features an export function for exporting data records from recipes.     

Requirements
● The WinCC project for export is open.

● Recipes have been created in a project.

● The "Recipes" editor is open.

Exporting recipes
1. In the "Recipes" editor, select the recipe with the data records you want to export.

2. Click .
The "Export" dialog box opens.

The selected recipe is displayed under "Recipe name".

3. Under "File name", specify the file in which the recipe data is to be stored.

4. Under "Content selection", specify if all or only selected data records are to be exported.

5. Click "Export."
The export will start. 
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Result
The exported data has been written to a CSV file. The CSV file will be stored in the specified 
directory. 

Importing recipe data records

Introduction
Recipes are identified by their name. The recipe name must therefore be unique. Open the 
import file in a simple text editor to check that it has the correct data structure.

Specify whether or not existing data records should be overwritten by records with the same 
name during the import.    

Requirements
● A CSV file containing at least one recipe has been created.

● The WinCC project for import is open.

● The "Recipes" editor is open with at least one recipe.

Importing a recipe
1. In the "Recipes" editor, select the recipe with the data records you want to import.

2. Click .
The "Import" dialog box opens.

The selected recipe is displayed under "Recipe name".
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3. Select the file you want to import under "File name".

4. Under "Strategy", specify if existing data records should be overwritten by records of the 
same name.

5. Click "Import."
The import will start. 

Result
The data records are created in the selected recipe. Existing data records may be overwritten 
by records with the same name from the CSV file depending on the setting for "Strategy". 

Editing exported recipe data records

Introduction
You can edit the exported recipe data records and import them again. You can, for example, 
add new data records to the file or modify existing records. You edit the exported recipe data 
records in CSV files in Microsoft Excel.

Procedure
1. Start Microsoft Excel.

2. In the "File" menu, click "Open".
The "Open File" dialog box opens. 

3. Select the path in which the exported data record file is stored.
In the "Open" dialog, select "All Files (*. *)" option in the drop-down list so that the exported 
file is detected.

4. Click "Open". 
The "Text Conversion Wizard" dialog opens. 

5. Click the "Next" button in the next step.

6. In the second step, select the semicolon as a delimiter.
Click "Next".

7. Close the wizard with the "Finish" button.

8. Make the desired changes to the file.

9. Save the changed file in CSV format (comma delimited).

10.Import the changed file.
If you have saved the file under a different name, adapt the file name in the "Import" dialog 
before importing. 

Result
The exported recipe data records were edited and saved in a recipe. 
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See also
Importing recipe data records (Page 6833)

Format of data from recipe data records

Introduction
This section describes the required format of the file for the import of recipes. The file containing 
the data of the recipes must be available in "*.csv" format. :    

Structure of recipe data
The structure of the import file is fixed. The following example shows the structure of a recipe 
containing two recipe elements, each with two data records:
"ID";<Name, recipe element 1>;< Name, recipe 
element 2>;"LastUser";"LastAccess[UTC]"<Line break>
<Recipe data record number 1>;<Recipe data record 1 value 1>;<Recipe 
data record 1 value 2>;"<Last user 1>";<Date and time 1><Line break>
<Recipe data record number 2>;<Recipe data record 2 value 1>;<Recipe 
data record 2 value 2>;"<Last user 2>";<Date and time 2><Line break>

ID of the language
The recipe always has the first line, which is the header and describes the column headings. 
Only the names of the recipe elements are added dynamically.

Each additional line represents one recipe data record with its recipe element values and 
change information.

10.12.3.3 Importing and exporting alarms

Exporting alarms

Introduction
WinCC has an export function for alarms.       

Requirements
● The WinCC project for the export is open.

● Alarms have been created in the project.

● The "HMI alarms" editor is open.
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Exporting alarms
1. Click the  button in "Discrete alarms" or "Analog alarms".

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Specify whether you want to export "Disrete alarms" or "Analog alarms".

4. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

See also
Format of the analog alarm data (Page 6841)

Format of the discrete alarm data (Page 6844)

Format of the analog alarm data (Page 6846)

Format of the discrete alarm data (Page 6850)

Importing alarms

Introduction
Alarms are identified by their alarm number. The alarm numbers must be unique in the analog 
and discrete alarm types. Alarms with redundant alarm numbers will be overwritten. An alarm 
without an existing alarm number is created.   

Any empty list entries for existing alarms contained in an xlsx file will be ignored for the 
purposes of the import. The entries of the existing alarms remain active and will not be replaced 
by empty ones.

Requirements
● An xlsx file with alarms has been created. 

● The structure of the xlsx file meets the requirements.
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● The WinCC project for the import is open.

● The "HMI alarms" editor is open.

Importing alarms
1. Click the  button in "Discrete alarms" or "Analog alarms". The "Import" dialog box opens.

2. Click the "..." button and select the file that you want to import.

3. Click on the "Import" button. The import will start. A progress bar indicates the progress of 
the import operation.    

Result
The corresponding alarms including alarm texts are created in WinCC on the basis of the import 
data. Alarms relating to the import operation are displayed in the output window. A log file is 
saved in the source directory of the import files. The log file has the same name as the 
respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a trigger tag 
of an incorrect type, such as string, to an alarm. An error will be reported during compilation.

 

 

See also
Format of the analog alarm data (Page 6841)

Format of the discrete alarm data (Page 6844)

Format of the analog alarm data (Page 6846)

Format of the discrete alarm data (Page 6850)
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Importing alarms

Introduction
Alarms are identified by their alarm name. An existing alarm will be overwritten with the data 
from the xlsx file if the alarm name already exists in the project. A new alarm is created if the 
alarm does not yet exist.

The alarm numbers must be unique in the project. If an alarm number is assigned more than 
once by import, the alarm is imported and the alarm number marked as invalid.   

Requirements
● An xlsx file with alarms has been created. 

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

● The "HMI alarms" editor is open.

Importing alarms
1. Click the  button in "Discrete alarms" or "Analog alarms". The "Import" dialog box opens.

2. Click the "..." button and select the file that you want to import.

3. Click on the "Import" button. The import will start. A progress bar indicates the progress of 
the import operation.    

 

  Note

There are no option settings for alarm import.
 

Result
The corresponding alarms including alarm texts are created in WinCC on the basis of the import 
data. Messages relating to the import operation are displayed in the output window. A log file 
is saved in the source directory of the import files. The log file has the same name as the 
respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 
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● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a trigger tag 
of an incorrect type, such as string, to an alarm. An error will be reported during compilation.

 

 

Format of the analog alarm data

Introduction
This chapter describes the required format of the file for the import of analog alarms. The file 
containing the analog alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of a number of worksheets:

● Analog alarms(Analog alarms)

● Limits (Limits)

Each alarm is assigned a separate row in the import file. The import file with the analog alarms 
must be formatted as follows:   

Example of the worksheet "Analog alarms"
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Table 10-163 Meaning of the entries

List entry Meaning
ID The alarm number is used to reference an alarm. The alarm number is unique. 

Alarms with identical alarm numbers are overwritten during import. An alarm 
without an existing alarm number is created.

Name Name of the analog alarm
Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts 

must be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts.

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = AlarmTag; Tag = Tag1; DisplayType = Decimal; Length = 
5;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textlist1; Tag = tag 2; 
Length = 5;>

Class The class of an alarm determines whether or not the alarm must be acknowledged. 
It can also be used to determine how the alarm appears when it is displayed on 
the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged together with these alarms of the same 
group in a single operation.

Trigger tag Specifies the tag monitored for limit value violation.
Delay time value Specifies the delay time. The alarm is not triggered until the duration of the limit 

value violation equals the specified delay time.
Delay time unit Specifies the time unit for the delay.
Report Enables reporting of the specific alarm on a printer.

True or "1" = Reporting enabled.
False or "0" = Reporting disabled.
Reporting must also be globally enabled in the project.

Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 
information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID. 
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Example of the worksheet "Limits"

 

Table 10-164 Meaning of the entries

List entry Meaning
Alarm ID Alarm number

The alarm number is used to reference an alarm. The alarm 
number is unique. Alarms with identical alarm numbers are 
overwritten during import. An alarm without an existing alarm 
number is created.

Limit mode Trigger mode
Indicates the method used for monitoring the limit value.

Limit type Specifies the limit that will be monitored. Both a tag and a 
constant can be used as limit value.

Limit value Limit value
Indicates the tag or constant monitored for limit violation.

Deadband mode Hysteresis mode
Specifies whether and in which cases hysteresis will be used.
For "Outgoing"
For "Incoming"
For "Incoming" and "Outgoing"

Deadband in percent 0 = The value specified for "Hysteresis" is considered to be 
absolute.
1 = The value specified for "Hysteresis" is referred to as a 
percentage of the limit value.

Deadband mode Hysteresis
Specifies a constant as a value of the hysteresis.
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 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 6835)

Importing alarms (Page 6836)

Format of the discrete alarm data (Page 6844)

Format of the discrete alarm data

Introduction
This chapter describes the required format of the file for the import of discrete alarms. The file 
containing the discrete alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of the worksheets "Discrete alarms" (discrete 
alarms). Each alarm is assigned a separate row in the import file. Structure of the import file 
containing the discrete alarms:   

Example of the worksheet "Discrete alarms"
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Table 10-165 Meaning of the entries

List entry Meaning
ID The alarm number is used to reference an alarm. The alarm number is unique. 

Alarms with identical alarm numbers are overwritten during import. An alarm 
without an existing alarm number is created.

Name Name of the analog alarm
Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. For import, 

a language ID must be assigned to alarm text.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts. 

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = AlarmTag; Tag = Tag1; DisplayType = Decimal; Length = 
5;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textlist1; Tag = tag 2; 
Length = 5;>

Class The class of an alarm determines whether or not the alarm must be acknowledged. 
It can also be used to determine how the alarm appears when it is displayed on 
the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged together with these alarms of the same 
group in a single operation.

Trigger tag Specifies the tag containing the bit that triggers the alarm.
Trigger bit Specifies the number of the bit that triggers the alarm.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon 

acknowledgment. Only available if the selected alarm class requires alarm 
acknowledgment.

Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the 
alarm.

PLC acknowledgement tag Specifies the tag containing the bit that acknowledges the alarm of the control 
program. Only available if the selected alarm class requires alarm 
acknowledgment.

PLC acknowledgment bit Specifies the number of the bit that acknowledges the alarm of the control program.
Delay time value
 

Specifies the delay time. The alarm is not triggered until the duration of the limit 
value violation equals the specified delay time.

Delay time unit Specifies the time unit for the delay.
Report Enables reporting of the specific alarm on a printer.

True or "1" = Reporting enabled.
False or "0" = Reporting disabled.
Reporting must also be globally enabled in the project.

Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 
information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID.
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 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 6835)

Importing alarms (Page 6836)

Format of the analog alarm data (Page 6839)

Format of the analog alarm data

Introduction
This chapter describes the required format of the file for the import of analog alarms. The file 
containing the analog alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of two worksheets:

● Analog alarms(Analog alarms)

● Limits (Limits)

Each alarm is assigned a separate line in the import file. The import file with the analog alarms 
must be formatted as follows:   
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Example of the worksheet "Analog alarms"

 

Table 10-166 Meaning of the entries

List entry Meaning
ID Shows the number of the analog alarm. The alarm number must be unique in the 

project.
Name Shows the name of the analog alarm. The name is used to reference an alarm. 

Alarms with identical names are overwritten during import. An alarm without an 
existing name is created.

Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts 
must be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts. 

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Parameter: <ref id = 0; type = AlarmAnalogParameter; Parameter = Limit; 
DisplayType = Decimal; Length = 1; Precision = 0; Alignment = Right; ZeroPadding 
= False;>
System parameters:  <ref id = 0; type = CommonSystemParameter; 
SystemParameter = UserName;>
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List entry Meaning
Class The alarm class of an alarm determines whether or not the alarm has to be 

acknowledged. It can also be used to determine how the alarm appears when it 
is displayed on the HMI device. The alarm class also determines whether and 
where the corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with 
other alarms, it can be acknowledged along with these alarms of the same group 
in a single operation.

Priority Indicates alarm priority. You can sort the alarms in the alarm view by priority. 
Range: 0 -16 

CPU number Specifies the CPU number. This option is only activated if you have enabled the 
"CPU/PLC number" alarm text block in the "Alarm blocks > System blocks" tab in 
the "HMI alarms" editor.

PLC number Shows the PLC number. This option is only activated if you have enabled the "CPU/
PLC number" alarm text block in the "Alarm blocks > System blocks" tab in the 
"HMI alarms" editor.

Trigger tag Specifies the tag monitored for limit value violation.
Verzögerung Specifies the delay time. The alarm is not triggered until the duration of the limit 

value violation equals the specified delay time.
Delay time unit Specifies the time unit for the delay.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon 

acknowledgment. Only available if the selected alarm class requires alarm 
acknowledgment.

Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the 
alarm.

Single acknowledgment Specifies whether each individual alarm must be acknowledged.
True = Alarms must be acknowledged individually.

Status tag Shows the tag which saves the Incoming and Outgoing alarm statuses and the
Acknowledgement request saved.

Status bit Specifies the number of the bit that is set and acknowledges the alarm.
Alarm annonciation Indicates whether an alarm is being suppressed.

True = suppressed alarm.
Display suppresion mask Indicates the display suppression method.
Additonal Text Shows the additional alarm text.
Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 

information about the alarm. A tooltip will be displayed in a separate window on 
the HMI device when the operator presses the <HELP> key.
The field designation contains a language ID.
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Example of the worksheet "Limits"

 

Table 10-167 Meaning of the entries

List entry Meaning
Alarm ID The alarm number is used to reference an alarm. The alarm 

number is unique. The alarm number allows alarms to be 
assigned limits.

Name Shows the name of the analog alarm.
Limit mode Indicates the method used for monitoring the limit value.
Grenzen
Limit type

Specifies the limit that will be monitored. Both a tag and a 
constant can be used as limit value.

Limit value Indicates the tag or constant monitored for limit violation.
Suppression Indicates whether an alarm is being suppressed.

True = suppressed alarm.
Deadband mode Specifies whether and in which cases hysteresis will be used.

For "Outgoing"
For "Incoming"
For "Incoming" and "Outgoing"

Deadband in percent 0 = The value specified for "Hysteresis" is interpreted as 
absolute.
1 = The value specified for "Hysteresis" is a percentage value 
of the limit value.

Deadband mode Specifies a constant as value of the hysteresis.

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 
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See also
Exporting alarms (Page 6835)

Importing alarms (Page 6836)

Format of the discrete alarm data

Introduction
This chapter describes the required format of the file for the import of discrete alarms. The file 
containing the discrete alarm data must be in "*.xlsx" format. 

Structure of the alarm data
The import file in Microsoft Excel consists of the worksheet "Discrete alarms" (discrete alarms). 
Each alarm is assigned a separate line in the import file. Structure of the import file containing 
the discrete alarms:     

Example of the worksheet "Discrete alarms"
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Table 10-168 Meaning of the entries

List entry Meaning
ID Shows the number of the discrete alarm. The alarm number is unique. 
Name Shows the name of the discrete alarm. The name is used to reference an alarm. Alarms 

with identical names are overwritten during import. An alarm without an existing name 
is created.

Event text [de-DE], Alarm text Displays the alarm text. The field designation contains a language ID. Alarm texts must 
be assigned a language ID for import.
An expression with a reference ID will be added to the alarm text if the text has a 
dynamic parameter. Example: text <field ref="0" />. Use the ID to assign dynamic 
parameters to alarm texts.

FeldInfo Specifies whether the alarm text contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Parameter: <ref id = 0; type = AlarmDiscreteParameter; Parameter = Parameter 1; Tag 
= HMI_Variable_1; DisplayType = Decimal; Length = 5; Precision = 0; Alignment = 
Right; ZeroPadding = False;>
System parameters: <ref id = 0; type = CommonSystemParameter; System Parameter 
= UserName;>

Class The alarm class of an alarm determines whether or not the alarm has to be 
acknowledged. It can also be used to determine how the alarm appears when it is 
displayed on the HMI device. The alarm class also determines whether and where the 
corresponding alarm will be logged.

Group Indicates the allocation to an alarm group. If an alarm belongs to a group with other 
alarms, it can be acknowledged along with these alarms of the same group in a single 
operation.

Priority Indicates alarm priority. You can sort the alarms in the alarm view by priority. Range: 
0 -16 

CPU number Specifies the CPU number. This option is only activated if you have enabled the "CPU/
PLC number" alarm text block in the "Alarm blocks > System blocks" tab in the "HMI 
alarms" editor.

PLC number Shows the PLC number. This option is only activated if you have enabled the "CPU/
PLC number" alarm text block in the "Alarm blocks > System blocks" tab in the "HMI 
alarms" editor.

Trigger tag Specifies the tag containing the bit that triggers the alarm.
Trigger bit Specifies the number of the bit that triggers the alarm.
Trigger mode Indicates the method used for monitoring the limit value.
Alarm parameter Indicates tag assigned to a parameter block to issue process values in alarm texts.
Acknowledge tag Specifies the tag containing the bit that is set by the operator upon acknowledgment. 

Only available if the selected alarm class requires alarm acknowledgment.
Acknowledgment bit Specifies the number of the bit that is set when the operator acknowledges the alarm.
Single acknowledgment Specifies whether each individual alarm must be acknowledged.

True = Alarms must be acknowledged individually.
Status tag Shows the tag which saves the Incoming and Outgoing alarm statuses and the

Acknowledgement request saved.
Status bit Specifies the number of the bit that is set and acknowledges the alarm.
Alarm annonciation Indicates whether an alarm is being suppressed.

True = suppressed alarm.
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List entry Meaning
Display suppresion mask Indicates the display suppression method.
Additonal Text Shows the additional alarm text.
Info text [de-DE], Info text The tooltip is an optional property of an alarm. Tooltips can contain additional 

information about the alarm. A tooltip will be displayed in a separate window on the 
HMI device when the operator presses the <HELP> key.
The field designation contains a language ID. 

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing alarm of the same name. 

 

 

See also
Exporting alarms (Page 6835)

Importing alarms (Page 6836)

10.12.3.4 Importing and exporting tags

Exporting tags

Introduction
WinCC has an export function for tags.     

Requirements
● The WinCC project for the export is open.

● Tags have been created in the project.

● The "HMI tags" editor is open.
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Exporting tags
1. Click on the  button in the "HMI Tags" tab.

The "Export" dialog box opens.

2. Click the "..." button and specify in which file the data are saved.

3. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

Importing tags

Introduction
Tags are identified by the tag name. An existing tag will be overwritten with the data from the 
xlsx file if the tag name already exists in the project. A new tag is created if the tag does not 
yet exist.

Requirements
● An xlsx file with tags has been created. 

● The structure of the xlsx file meets the requirements.

● The WinCC project for the import is open.

Importing tags
1. Click "HMI tags" in the project navigation.

2. Double-click "Show all tags". The "HMI tags" editor opens.
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3. Click on the  button. The "Import" dialog box opens.

4. Click the "..." button and select the file that you want to import.

5. Click on the "Import" button. The import will start.    

Result
The relevant tags have been created in WinCC. Alarms relating to the import operation are 
displayed in the output window. A log file is saved in the source directory of the import files. 
The log file has the same name as the respective import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

 Note

The syntax of the import file is checked during xlsx file import. The meaning of the properties 
or dependencies between the properties is not checked. It is possible to assign a tag a trigger 
tag of the wrong type, for example, string. An error will be reported during compilation.

 

 

Format of the tag data

Introduction
This section describes the format required for the file with tag data used for imports. The tag 
data file must be in "*.xlsx" format. 

Tag data structure
The import file in Microsoft Excel consists of a number of worksheets:

● HMI Tags (HMI tags)

● Multiplexing (multiplex tags)
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Each tag is on a separate line in the import file. The import file with the tag data must have the 
following format:   

Example of the worksheet "HMI Tags"

 

Table 10-169 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag. 
Path Specifies which folders in the project tree contain the tag. The folder structure is 

represented by "\" : "FolderName1\FolderName2\TagName".
PLC Tag Indicates whether the tag is linked to a PLC tag.
Connection Indicates the name of the connection to the PLC.
Data type Specifies the data type of a tag. The data types allowed depend on the 

communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

Length Specifies the length of the tag. This entry is only useful for data types with a 
dynamic length such as strings; it is left empty for all other data types.

Address Specifies the tag address in the PLC. The tag address must exactly match the one 
used in WinCC, for example, "%DB1.DBW0". The tag address is empty for internal 
tags.

Multiplexing Specifies whether multiplexing is used.
Index tag Shows the name of the index tag for multiplexing. 

In Runtime, the system first reads the value of the index tag. It then accesses the 
tag in the corresponding place in the tag list.

StartValue Specifies the start value of a tag. 

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
System Manual, 02/2014 6853



List entry Meaning
ID tag The update ID updates the value of a tag with the aid of a function or a PLC job. 

The update ID must be unique within an HMI device.
Coding Shows the coding method.
DiplayName [de_DE]
 

Shows the display name of an HMI tag. The field designation contains a language 
ID. The field designation contains a language ID. Display names must be assigned 
a language ID for import. Texts are imported to the corresponding project 
language.

Acquisition mode Specifies the tag acquisition mode.
Acquisition cycle Specifies the tag acquisition cycle. The acquisition cycle must correspond exactly 

to the one used in WinCC. The value is not language-dependent and should 
therefore be the same in every language. The default value is "1 s". The acquisition 
cycle is undefined if the tag acquisition mode is "on demand".
User-defined acquisition cycles must be created beforehand as the file will 
otherwise not be imported.

High High Limit type Indicates whether the limit value "High high" is monitored by a constant, a tag or 
not at all.

High High Limit Displays the limit value "High High". 
High Limit type Indicates whether the limit value "High" is monitored by a constant, a tag or not at 

all.
High Limit Displays the limit value "High".
Low Limit type Indicates whether the limit value "Low" is monitored by a constant, a tag or not at 

all.
Low Limit Displays the limit value "Low".
Low Low Limit type Indicates whether the limit value "Low Low" is monitored by a constant, a tag or 

not at all.
Low Low Limit Displays the limit value "Low Low".
Linear scaling Indicates whether linear scaling is enabled. This entry can only be used for external 

tags.
End value PLC Specifies the end value of the PLC tag.
Start value PLC Specifies the start value of the PLC tag.
End value HMI Specifies the end value of the HMI tag.
Start value HMI Specifies the start value of the HMI tag.

Example of the worksheet "Multiplexing"
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Table 10-170 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag which uses indirect addressing. The 

HMI tag must be available in the "HMI Tags" worksheet.
Index Shows the value which governs which tag is selected. 
Multiplex Tag Displays the tag from the tag list corresponding to the index value.

 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing tag of the same name. 

 

Format of the tag data 

Introduction
This section describes the format required for the file with tag data used for imports. The tag 
data file must be in "*.xlsx" format. 

Tag data structure
The import file in Microsoft Excel consists of a number of worksheets:

● HMI Tags (tags)

● SubstituteValueUsage (substitute value)

Each tag is on a separate line in the import file. The import file with the tag data must have the 
following format:     

Example of the worksheet "HMI Tags"
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Table 10-171 Meaning of the entries

List entry Meaning
Name Indicates the configured name of an HMI tag. 
Path Specifies which folders in the project tree contain the tag. The folder structure is 

represented by ",": "FolderName1,FolderName2,TagName".
PLC Tag Specifies which PLC tag is linked to the HMI tag.
Connection Indicates the name of the connection.
Date type Specifies the data type of the PLC tag. The data types allowed depend on the 

communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

HMI Data type Specifies the data type of the HMI tag. The data types allowed depend on the 
communication driver being used. See the "Communication" section of the 
documentation for additional information on the data types permitted for the 
various communication drivers.

Length Specifies the length of the tag in bytes. This entry is only useful for data types with 
a dynamic length such as strings; it is left empty for all other data types.

Address Specifies the tag address in the PLC. The tag address must exactly match the one 
used in WinCC, for example, "%DB1.DBW0". The tag address is empty for internal 
tags.

Start Value Specifies the start value of a tag. 
Substitute Value Indicates the substitute value. The substitute value is used when a process value 

with errors is read.
ID tag The update ID updates the value of a tag with the aid of a function or a PLC job 

within a device. The update ID must be unique.
High High Limit type Indicates whether the limit value "High high" is monitored by a constant or not at 

all.
High High Limit Displays the limit value "High High". 
High Limit type Indicates whether the limit value "High" is monitored by a constant or not at all.
High Limit Displays the limit value "High".
Low Limit type Indicates whether the limit value "Low" is monitored by a constant or not at all.
Low Limit Displays the limit value "Low".
Low Low Limit type Indicates whether the limit value "Low Low" is monitored by a constant or not at 

all.
Low Low Limit Displays the limit value "Low Low".
Linear scaling Indicates whether linear scaling is enabled. This entry can only be used for external 

tags.
End value PLC Specifies the end value of the PLC tag.
Start value PLC Specifies the start value of the PLC tag.
End value HMI Specifies the end value of the HMI tag.
Start value HMI Specifies the start value of the HMI tag.
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Example of the worksheet "SubstituteValueUsage"

 

Table 10-172 Meaning of the entries

List entry Meaning
Parent Specifies the tag for which a substitute value has been defined. The tag must be 

available in the "HMI-Tags" worksheet.
Substitute Value Usage Indicates the substitute value. The substitute value can be used in the following 

situations:
● As start value
● After communication error
● High High limit value
● Low Low limit value
 

 
 

 Note
"No value" in the table

Entries in the table which have the value "No value" delete the corresponding values in an 
existing tag of the same name. 

 

 

10.12.3.5 Importing and exporting text lists

Exporting text lists

Introduction
WinCC has an export function for text lists.         

Requirements
● The WinCC project for the export is open.

● Text lists have been created in the project.

● The "Text & graphics lists" editor is open.
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Exporting text lists
1. Click on the  button in the "TextLists" tab.

The "Export" dialog box opens.
 

2. Click the "..." button and specify in which file the data are saved.

3. By default, texts are exported in all defined project languages.
If you do not want to export specific languages, disable the unnecessary languages in the 
dialog.

4. Click "Export". The export will start.

Result
The exported data has been written to an xlsx file. The xlsx file will be stored in the specified 
folder. 

See also
Importing text lists (Page 6860)

Format of text list data (Page 6861)

Importing text lists

Introduction
You then import text lists from an xlsx file to WinCC.

Requirements
● An xlsx file with text lists has been created.

● The structure of the xlsx file meets the requirements.
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● The WinCC project for the import is open.

● The "Text & graphics lists" editor is open.

Importing text lists
1. Click on the  button in the "Text lists" tab.

The "Import" dialog box opens.

2. Select the file you want to import under "File selection".

3. Click on the "Import" button. The import will start.  

Result
You have now imported the text lists. The relevant text lists have been created in WinCC. 
Alarms relating to the import operation are displayed in the output window. A log file is saved 
in the source directory of the import files. The log file has the same name as the respective 
import file but with the "*.xml" extension.

Check when importing the data whether there are any links to objects, for example, dynamic 
parameters such as tags. 

● If an object with the same name already exists, the existing object is used.

● If no object of the same name yet exists, create an object with the relevant name or create 
a new link.

 

See also
Exporting text lists (Page 6857)

Format of text list data

Introduction
This section describes the format required for the file with the text lists used for imports. The 
text list data file must be in "*.xlsx" format. 
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Tag data structure
The import file in Microsoft Excel consists of two worksheets:

● TextList (Text lists)

● TextListEntry (Text list entry)

Each text list is assigned a separate line in the import file. The import file containing the data 
must be structured as follows:   

Example of the worksheet "TextList"

 

Table 10-173 Meaning of the entries

List entry Meaning
Name Shows the name of the text list.
ListRange Shows the text list range:

Number = Bit number (0-31)
Range = value/range (...-...)
Bit = Bit (0;1)

Comment Any comments on the text list. You can use up to 500 characters
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Example of the worksheet "TextListEntry"

Table 10-174 Meaning of the entries

List entry Meaning
Name Shows the name of the text list entry.
Parent Specifies the name of the corresponding text list.
DefaultEntry Indicates whether the text list entry is a default entry. The default entry is always 

displayed when the tag has an undefined value. 
Value Specifies the tag integer values or value ranges which are assigned to the text 

entries in the text list.
Text Shows the text list entry. The field designation contains a language ID. Text list 

entries must be assigned a language ID for import. 
An expression with a reference ID will be added to the text if the text list entry has 
a dynamic parameter. Example: text <field ref="0" />. Use the ID to assign the 
dynamic parameter to a text list entry.

FeldInfo Specifies whether the text list contains dynamic parameters. The settings are 
separated by a semicolon ";". 
Example of dynamic parameters:
Tag: <ref id = 0; type = CommonTagDisplayFormat; Tag = tag 1; DisplayType = 
Decimal; DisplayFormat = 9;>
Text list: <ref id = 1; type = CommonTextList; TextList = Textliste_1; Tag = tag 2; 
Length = 5;>
PLC tag: <ref id = 0; type = CommonControlTagDisplayFormat; DisplayType = 
Decimal; DisplayFormat = 9;>
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See also
Exporting text lists (Page 6857)

10.12.3.6 Importing and exporting project texts

Importing project texts
Edit the xlsx file or send it to a translator. Import the texts once they have been translated. The 
foreign languages will be imported to the relevant object in the project.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Importing project texts 
To import a project text file, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The lower-level elements will be displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Click on the  button. The "Import" dialog opens.

4. Select the path and file name of the import file from the "Import file" field.

5. Activate the "Import source language" check box if you have made changes to the source 
language in the export file and would like to overwrite the entries in the project with the 
changes.

6. Click on "Import".

Result
You have imported the project texts.

Exporting project texts
Project texts are exported for translation. Texts are exported to Office Open XML files ending 
in ".xlsx". These files can be edited in Microsoft Excel, for example.

You can exchange the file with the translators and import it back to the project as soon as it 
has been translated.
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Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Exporting project texts
To export individual project texts, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The child elements are displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Select the texts you want to export.

4. Click on the  button. The "Export" dialog opens.

5. From the "Source language" drop-down list, select the language from which you wish to 
translate, for example Italian.

6. From the "Target language" drop-down list, select the language into which the texts are to 
be translated, for example, French.
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7. Enter a file path and a file name for the export file in the "Export file" input field.

8. Click "Export".

Result
The texts selected in the "Project texts" editor are written to an xlsx file. The xlsx file will be 
stored in the specified folder. 

You can alternatively select and export all project texts from categories. Select "User texts" or 
"System texts" in the "Export" dialog in line with the type of texts you wish to export. In this 
case, export can additionally be limited by categories.

 

 Note

Project texts in library objects cannot be exported.
 

10.12.4 Using controller data from other projects

10.12.4.1 Basics of Inter Project Engineering (IPE)

What is IPE?   
You can use the IPE (Inter Project Engineering) function to read in controller data from other 
TIA Portal projects and use it for configuring. 

IPE enables you to transfer and merge the HMI configuration and PLC programming 
communication into various TIA Portal projects.

You can exchange controller data using IPE in two ways:
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● Initializing device proxy via an IPE file (Page 6867)

● Initializing a device proxy via a project file (Page 6873)

10.12.4.2 Controller data

Introduction
In the source project of the PLC, you can select which controller data is to be stored as device-
proxy data.

To this end, you create a device proxy data from a configured PLC.

Which device proxy data can be exchanged?
The following device proxy data can be exchanged via IPE:

● Program blocks

● Technology objects

● PLC tags

● PLC alarms

The following information is exchanged automatically:

● Interfaces of the PLC

● Configured communication processors and communication modules at the PLC

10.12.4.3 Initializing a device proxy via an IPE file

Initializing device proxy via an IPE file

How does initialization of a device proxy via an IPE file work?   
You can exchange controller data between two or more projects using IPE files.

Due to their small data volume, you can send IPE files by e-mail, for example.

You can create multiple IPE files with different device proxy data for each PLC.

A device proxy can only be filled with one device proxy data record in the target project.
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● An IPE file is exported from the source project.
The IPE file contains device proxy data of the PLC "PLC_A".

● A device proxy is created in the target project.

● In the target project, the device proxy is then initialized with the device proxy data from the 
IPE file.

● Following initialization, all device proxy data from the IPE file is contained in the device 
proxy.

● If changes are made in the source project, the device proxy of PLC_A in the target project 
can be updated via the new IPE file.

Initializing a device proxy via an IPE file

Introduction
You initialize device proxy data using a dialog on the device proxy in the TIA Portal.

The IPE file contains the device proxy data from the source project.

Requirement
IPE file is available.
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Procedure
1. Double-click "Add new device" in the project tree. 

2. Select the device proxy under "Controller".

A new device is created in the "Devices & Networks" editor.

3. Select the device proxy in the project tree.
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4. Click "Initialize device proxy" in the shortcut menu.

5. Select the IPE file and click "Open".
The "Initialize device proxy" dialog opens.

 

  Note

You cannot select the device proxy data before initialization in the target project. 

All device proxy data included in the IPE file is transferred.

Initialize a project file if you want to select specific device proxy data before initialization:  
Initializing a device proxy via a project file (Page 6873)

 

6. Click "OK".
Initialization of the device proxy is started.

Result
Following initialization, all device proxy data from the IPE file is contained in the device proxy.

You can now configure an HMI connection with the device proxy and connect PLC tags from 
the device proxy with HMI tags, for example.
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Updating a device proxy via an IPE file 

Introduction
If changes were made to the device proxy data in the device proxy source project, the device 
proxy data can be updated in the target project.

Requirement
● New IPE file contains the device proxy data from the source project.

● A device proxy has already been initialized using an IPE file in the target project.

Procedure
1. Select the device proxy in the project tree.

2. Click "Update device proxy" in the shortcut menu.
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3. Select the IPE file.

4. Select whether you wish to update the PROFINET or PROFIBUS addresses.

5. Click "OK".
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10.12.4.4 Initializing a device proxy via a project file

Initializing a device proxy via a project file

How does an initialization via project file work?  
You can transfer controller data using a project file in your TIA Portal project:

● There are two PLCs in the source project.

● Device proxy data objects of the two PLCs are created in the source project.

● The source project is saved.

● A device proxy is created in the target project.

● The source project (*.ap13) is first selected using the command for the initialization of device 
proxy in the device shortcut menu.

● The "PLC_A" and "PLC_B" controllers are available for selection and their device proxy 
data have already been created.

● After selection of device proxy data of "PLC_A", the data is stored in the PLC_Proxy of the 
target project.

● Changes from the source project can be transferred by an update via the project file.

Initializing a device proxy via a project file

Introduction
You initialize the device proxy using a project file.

Requirement
Project file (*.ap13) exists.
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Procedure
1. Double-click "Add new device" in the project tree. 

2. Select the device proxy under "Controller".

A new device is created in the "Devices & Networks" editor.

3. Select the device proxy in the project tree.
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4. Click "Initialize device proxy" in the shortcut menu.

5. Select the following entry in the "Open device proxy data source" dialog:
"TIA Portal projects (*.ap13)"

6. Select a project file and click "Open".
The "Initialize device proxy" dialog opens.

7. Select a device proxy data object already created from an available PLC to initialize the 
device proxy.

8. Click "OK".

Result
Following initialization, the controller data from the project file in the selected device proxy data 
object is stored in the device proxy.

You can now configure an HMI connection with the device proxy and connect PLC tags from 
the device proxy with HMI tags, for example.

Initialization via Classic projects
You can find more information on importing controller data from projects prior to TIA Portal 
V11 in an FAQ.

Entry ID: 73502293 (http://support.automation.siemens.com/WW/view/de/73502293)
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Updating a device proxy via a project file 

Introduction
If changes have been made to the controller data in the source project of the device proxy, 
you can update the device proxy in your TIA Portal project.

Requirement
● Project file has been generated from the source project of the device proxy.

● A device proxy that has already been initialized is available in the target project.

Procedure
1. Select the device proxy in the project tree.

2. Click "Update device proxy" in the shortcut menu.
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3. Select the project file.
The "Update device proxy" dialog opens.

4. Select a device.
 

  Note

If you have created several device proxy data objects in the source project, you need to 
select one device proxy data object.

 

  Note

Already initialized device proxies cannot be overwritten with controller data from a different 
PLC.

 

5. Select whether you wish to update the PROFINET or PROFIBUS addresses.

6. Click "OK".
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10.12.5 Using cross-references

10.12.5.1 General information about cross references

Introduction   
The cross-reference list provides an overview of the use of objects within the project.

Uses of cross-references
The cross-reference list offers you the following advantages:

● When creating and changing a program, you retain an overview of the objects, tags, and 
alarms etc. you have used.

● From the cross-references, you can jump directly to the object location of use.

● You can learn the following when debugging:

– The objects used in a specific screen.

– The alarms and recipes shown in a specific display.

– The tags used in a specific alarm or object.

● As part of the project documentation, the cross-references provide a comprehensive 
overview of all object, alarms, recipes, tags and screens.

See also
HMI device wizard basics (Page 6802)

10.12.5.2 Displaying the cross-reference list

Introduction
Details on the use of objects can be found in the cross-reference list. You can show cross-
references for HMI devices, folders and all editors in the project tree. The detail view also lets 
you select individual objects of the editors.

Requirement
You have created a project.

Several objects have been created.
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Procedure     
1. Select the required entry in the project tree or detail view.

2. Select "Cross-references" in the shortcut menu. The cross-reference list is opened in the 
work area.

3. Open the "Used by" tab to display where the objects shown in the cross-reference list are 
used.

4. Open the "Used" tab to view the users of the objects displayed in the cross-reference list.

5. You can sort the entries in the "Object" column in ascending or descending order by clicking 
on the corresponding column header.

6. To go to the location of use for a specific object, click on the displayed link.

Result
The cross-reference list for the selected object is displayed in the work area.

10.12.5.3 Structure of the cross-reference list

Views of the cross-reference list 
There are two views of the cross-reference list. The difference between the two views is in the 
objects displayed in the first column:

● Used by:
Display of the referenced objects. Here, you can see where the object is used.

● Used:
Display of the referencing objects. The users of the object are shown here.

The assigned tool tips provide additional information about each object.

Structure of the cross-reference list

Column Content/meaning
Object Name of the object that uses the lower-level objects or that is being 

used by the lower-level objects.
Numbers Number of uses
Location of use Each location of use, for example, an object or event
Property Function of the referenced objects, for example, tag for data record or 

process value
Connected to PLC tag with which the object is connected.
Type Type of object 
Path Path of object

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references. 
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Settings in the cross-reference list
You can make the following settings using the icons in the toolbar for the cross-reference list:

● Update cross-reference list
Updates the current cross-reference list.

● Making settings for the cross-reference list
Here, you specify whether all used, all unused, all defined or all undefined objects will be 
displayed. If the "Undefined objects" option is enabled, references to previously deleted 
objects are also displayed.

● Collapse entries
Reduces the entries in the current cross-reference list by closing the lower-level objects.

● Expand entries
Expands the entries in the current cross-reference list by opening the low-level objects.

Sorting in the cross-reference list
You can sort the entries in the "Object" column in ascending or descending order. Click on the 
column header to do this. 

10.12.5.4 Displaying cross-references in the Inspector window

Introduction
The Inspector window displays cross-reference information about a selected object in the "Info 
> Cross-references" tab. The Inspector window displays the cross-reference information in 
tabular format. 

Requirement
You have created a project.

Several objects have been created.
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Procedure   
1. Select an object in a screen or a tabular editor.

2. Select "Cross-reference information" in the shortcut menu. The cross-references are 
opened in the Inspector window.

Result
The instances where and the other objects by which the selected object is being used are 
displayed. 

The table below shows the additional information listed in the "About > Cross-reference" tab:

Column Meaning
Object Name of the object that uses the lower-level 

objects or that is being used by the lower-level 
objects.

Numbers Number of uses
Location of use Each location of use, for example an object or 

event
Property Function of the referenced objects, for example 

tag for data record or process value
Connected to PLC tag with which the object is connected.
Type Type of object
Path Path of object

Depending on the installed products, additional columns or different columns are displayed for 
the cross-references.

10.12.5.5 Rewiring tags in the screens

Introduction     
You can change the references of tags in the properties of screen objects using the "Change 
object references" dialog.
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This function lets you to replace a large number of tags in various screen objects.

You search for and replace individual or multiple characters in the tag names.

You can open the "Change object references" dialog with the command in the shortcut menu. 
You can open the dialog for one or more screen objects or a screen.

How to replace a tag
1. Select the objects in the screen that contains a tag that you want to change.

2. Select the "Change object references" command in the shortcut menu or in the "Edit" menu.
The "Change object references" dialog opens. You can see the selected screen objects 
and the tags used in the "Object" column. 

3. Enter the name or part of the name you want to find in the "Find in reference" input box.

4. Start the search with the "Find next" button. If a reference is found, it is highlighted in the 
"Reference" column. 
Another click on the "Find next" button continues the search process until the list has been 
completely searched. 
After this, the search process starts again from the top of the list.

5. Enter the name or part of the name you want to replace for the found name in the "Replace 
with" input box. 

6. Click the "Replace" button to replace the selected tag.
All references found are replaced by clicking the "Replace all" button. In this way, you can 
replace a large number of references with another 
reference.

7. To select a tag from the list of all tags created in the project, click on the  button in the 
"Replace" column. 
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8. To select a tag from the object list or to create a new tag, click on the  button in the 
"Replace" column.

9. Confirm your entry with "OK".

The rewiring of the tags is applied in the project. 

Additional options for searching
You can narrow down your search by enabling the following options:

● Use wildcards
Enter * for any number of characters. Example: You want to search for all tags starting with 
"HMI". Enter "HMI*" in the search key box.
Enter ? for an individual character.

● Find whole words
To search only for full names, enable the "Find whole words" option.

Replacing arrays and user-defined tags 
Variables whose names contain special characters . [ ] are shown in quotes. 

Array type tags and tags of user-defined data types (UDT) contain special characters to 
separate tags from their elements. However, they are not shown in quotation marks. To replace 
an array or a UDT with an HMI tag with special characters, enter the name of the HMI tag in 
quotation marks in the "Replace" input box. If you type the name without quotation marks, a 
reference to a non-existent array or UDT is created instead of a reference to the desired HMI 
tag with special characters.

Correcting entries
If an incorrect entry is made in the "Replace with" input box, the existing references can be 
replaced by references to non-existent tags.

If you detect an incorrect entry before confirming with "OK", you can correct the error. To do 
this, select the "Replace" column and press the "Remove" button. Any incorrect entries in the 
"Reference" column are deleted. 

If you confirm the dialog with "OK", the affected properties of the screen objects are marked 
in red. Non-existent tags are highlighted in red in the "Change cross references" dialog. 

If the new tag does not yet exist, you must subsequently create the tag. 
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10.12.6 Managing languages

10.12.6.1 Languages in WinCC

User interface language and project languages
A distinction is drawn between two different language levels in WinCC:

● User interface language
During configuration, the text in the WinCC menus and dialogs is displayed in the user 
interface language. The user interface language also affects the labeling of operating 
elements, the parameters of the system functions, the online help, etc. 

● Project languages
Project languages are all languages in which a project will later be used. Project languages 
are used to create a project in multiple languages. 

The two language levels are completely independent of one another. For example, you can 
create English projects at any time using a German user interface and vice versa.

Project languages
The following languages are differentiated within the project languages:

● Reference language
The reference language is the language that you use to configure the project initially.
During configuration, you select one of the project languages as the reference language. 
You use the reference language as a template for translations. All of the texts for the project 
are first created in the reference language and then translated. While you are translating 
the texts, you can have them displayed simultaneously in the reference language.

● Editing language
You produce translations of the texts in the editing language. 
Once you have created your project in the reference language, you can translate the texts 
into the remaining project languages. Select a project language respectively as an edit 
language and edit the texts for the appropriate language variant. You can change the editing 
language at any time.

 

  Note

When switching the project languages, the assignment to the keys on the keyboard also 
changes. For some languages (for example, Spanish), the operating system does not 
allow you to switch to the corresponding keyboard assignment. In this case, the keyboard 
assignment is switched to English. 

 

● Runtime languages
Runtime languages are those project languages that are transferred to the HMI device. You 
decide which project languages to transfer to the HMI device depending on your project 
requirements. 
You must provide appropriate controls so that the operator can switch between languages 
in runtime. 

 

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
6882 System Manual, 02/2014



See also
Language settings in the operating system (Page 6885)

Operating system settings for Asian languages (Page 6886)

Selecting the user interface language (Page 6887)

"Graphics" editor (Page 6898)

Languages in Runtime (Page 6902)

Example: Configuring a button for language switching (Page 6909)

HMI device wizard basics (Page 6802)

10.12.6.2 Language settings in the operating system

Introduction
The configuration PC operating system settings influence WinCC language management in 
the following areas:  

● Selection of project languages

● Regional format of dates, times, currency, and numbers

● Displaying ASCII characters

Project language selection
A language is not available as a project language unless it is installed in the operating system. 

Regional format of dates, times, currency, and numbers
WinCC specifies a fixed date and time format in the Date - Time field for the selected project 
language and runtime language.

In order for dates, times, and numbers to be presented correctly in the selected editing 
language, this language must be set in the Regional Options in the Control Panel.   

Displaying ASCII characters
With text output fields, the display of ASCII characters as of 128 depends on the set language 
and the operating system being used.

If the same special characters are to be displayed on different PCs, the PCs must use the 
same operating system and regional settings.

See also
Languages in WinCC (Page 6882)

Operating system settings for Asian languages (Page 6886)
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10.12.6.3 Operating system settings for Asian languages

Settings on Western operating systems
If you want to enter Asian characters, you must activate the support for this language in the 
operating system.   

The Input Method Editor (IME) is available in Windows for configuring Asian texts. Without this 
editor, you can display Asian text but not edit it. For more information on the Input Method 
Editor, refer to the documentation for Windows. To enter Asian characters when configuring, 
switch to the Asian entry method in the "Input Method Editor".

Switch the operating system to the appropriate language to have language-specific project 
texts, such as alarm texts, displayed in the simulator in Asian characters.

Settings on Asian operating systems
If you are configuring on an Asian operating system, you must switch to the English default 
input language to enter ASCII characters, for example, for object names. As the English default 
input language is included in the basic installation of the operating system, you do not need 
to install an additional input locale.    

Enable language support
1. Open the system controller.

2. Select "Regional and Language Options".

3. On the "Languages" tab, activate the check box "Install files for East Asian languages".

4. Then click on "Details" under "Text Services and Input Languages". The dialog "Text 
Services and Input Languages" is opened.

5. On the "Settings" tab add the required default input language under the "Installed Services".

6. Select the language of the operating system in the "Language for non-Unicode programs" 
area in the "Advanced" tab.

See also
Languages in WinCC (Page 6882)

Language settings in the operating system (Page 6883)
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10.12.6.4 Setting project languages

Selecting the user interface language

Introduction
The user interface language is used for displaying menu entries, title bars, infotexts, dialog 
texts and other designations in the WinCC user interface. 

You can switch between the installed user interface languages during configuration. The 
labeling of the operating elements remains in the language you set when you added the object 
even if you change the user interface language. 

Procedure
1. Select "Options > Settings" in the menu.

The "Settings" dialog box is opened.

2. Select the desired user interface language under "General > General settings".

Result
WinCC will use the selected language as user interface language. 

See also
Enable project languages (Page 6887)

Selecting the reference language and editing language (Page 6888)

Languages in WinCC (Page 6882)

Enable project languages

Introduction
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language. 
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Enable project languages
1. Click on the arrow to the left of "Languages & resources" in the project tree.

The lower-level elements will be displayed.

2. Double-click on "Project languages".
The possible project languages will be displayed in the working area.

3. Enable the relevant project languages.   
 

  Note
Copying multilingual objects

The copies of multilingual objects to a different project only include text objects in the 
project languages which are activated in the target project. Activate all project languages 
in the target project to include the corresponding text objects when transferring the copy.

 

Disabling project languages
1. Disable the languages which are not relevant for the project.   

 

 
 NOTICE

If you disable a project language, all text and graphic objects you have already created 
in this language will be deleted from the current project.

 

See also
Selecting the user interface language (Page 6885)

Selecting the reference language and editing language (Page 6888)

Selecting the reference language and editing language

Introduction
The project languages are set in the "Project languages" editor. You define which project 
language is to be the reference language and which the editing language. You can change 
the editing language at any time.

Requirements
The "Project languages" editor is open.

Several project languages have been activated.

Selecting the reference language and editing language
1. Click the arrow in the drop-down list in the "General > Editing language" section.    

2. Click on the required language in the drop-down list, for example, German.
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3. Click on the arrow in the drop-down list in the "General > Reference language" section.

4. Click on the required language in the drop-down list, for example, English.

The language selection is displayed in the list box.

Result
You have now selected the editing and reference languages.

If you change the editing language, all future text input will be stored in the new editing 
language.

 

See also
Selecting the user interface language (Page 6885)

Enable project languages (Page 6885)

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
System Manual, 02/2014 6887



10.12.6.5 Creating one project in multiple languages

Working with multiple languages

Multilingual configuration in WinCC
You can configure your projects in multiple languages using WinCC. There are various grounds 
for creating a project in multiple languages:

● You would like to use a project in more than one country.
You create the project in multiple languages but when the HMI device is commissioned, 
only the language spoken by the operators at the respective site will be transferred to the 
HMI device.

● The operators of a system speak a range of different languages.
Example: An HMI device is used in China, but the service personnel understand only 
English.   

Translating project texts
With WinCC, you can enter project texts directly in several languages in various different 
editors, for example, in the "Project texts" editor. WinCC also allows you to export and import 
your configuration for translation purposes. This is particularly advantageous if you configure 
projects containing a large amount of text and want to have it translated.

Language management and translation in WinCC
The following editors are used to manage languages and translate texts in WinCC:  

Editor Short description
Project languages Selection of project languages, editing language and reference 

language.
Languages and fonts Management of runtime languages and fonts used on the HMI device.
Project texts Central management of configured texts in all project languages.
Graphics Graphic library for managing graphics and their language-specific 

versions.

See also
Project text basics (Page 6891)

Translating texts directly (Page 6892)

Translating texts using reference texts (Page 6894)

Exporting project texts (Page 6895)

Importing project texts (Page 6897)
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Project text basics

Texts in different languages in the project  
Texts that are output on display devices during processing are typically entered in the language 
in which the automation solution is programmed. Comments and the names of objects are also 
entered in this language.

If operators do not understand this language, they require a translation of all operator-relevant 
texts into a language they understand. You can therefore translate all the texts into any 
language. In this way, you can ensure that anyone who is subsequently confronted with the 
texts in the project sees the texts in his/her language of choice.

User texts and system texts   
In the interests of clarity, a distinction is drawn between user texts and system texts:

● User texts are texts created by the user.

● System texts are texts created automatically and which are a product of configuration in 
the project.

The project texts are managed in the project text editor. This can be found in the project tree 
under "Languages & Resources > Project texts".

Examples of multilingual project texts
You can, for example, manage the following types of text in more than one language:

● Display texts

● Alarm texts

● Comments in tables

● Labels of screen objects

● Text lists

Translating texts
There are two ways of translating texts.

● Translating texts directly
You can enter the translations for the individual project languages directly in the "Project 
texts" editor.

● Translating texts using reference texts
You can change the editing language for shorter texts. You can enter the new texts in the 
editing language while the texts of the reference language are displayed. 

See also
Working with multiple languages (Page 6888)

Translating texts directly (Page 6892)
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Translating texts using reference texts (Page 6894)

Exporting project texts (Page 6895)

Importing project texts (Page 6897)

Translating texts directly

Translating texts  
If you use several languages in your project, you can translate individual texts directly. As soon 
as you change the language of the software user interface, the translated texts are available 
in the selected language.

Requirements
● You are in the project view.

● A project is open.

● You have selected at least two further project languages.
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Procedure
Proceed as follows to translate individual texts:

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The elements below this are displayed.

2. Double-click on "Project texts".
A list with the texts in the project is displayed in the work area. There is a separate column 
for each project language.

3. To group identical texts and translate them simultaneously, click on the " " button in the 
toolbar.

4. To hide texts that do not have a translation, click on the  button in the toolbar.

5. Click on an empty column and enter the translation.

Result
You have translated individual texts in the "Project texts" editor. The texts will then be displayed 
in the runtime language.
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See also
Working with multiple languages (Page 6888)

Exporting project texts (Page 6895)

Project text basics (Page 6889)

Importing project texts (Page 6897)

Translating texts using reference texts

Introduction  
After changing the editing language, all texts are shown in input boxes in the new editing 
language. If there is not yet a translation available for this language, the input boxes are empty 
or filled with default values.

If you enter text again in an input field, this is saved in the current editing language. Following 
this, the texts exist in two project languages for this input field, in the previous editing language 
and in the current editing language. This makes it possible to create texts in several project 
languages.

You can display existing translations for an input box in other project languages. These serve 
as a comparison for text input in the current editing language and they are known as the 
reference language.

Requirement
There is at least one translation into a different project language for an input field.

Procedure
To display the translation of an input cell in a reference language, follow these steps:

1. Select "Tasks > Languages & resources" in the task card.

2. Select a reference language from the "Reference language" drop-down list.

Result
The reference language is preset. If you click in a text block, translations that already exist in 
other project languages are shown in the "Tasks > Reference text" task card.

See also
Working with multiple languages (Page 6888)

Exporting project texts (Page 6895)

Project text basics (Page 6889)

Importing project texts (Page 6897)
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Exporting project texts
Project texts are exported for translation. Texts are exported to Office Open XML files ending 
in ".xlsx". These files can be edited in Microsoft Excel, for example.

You can exchange the file with the translators and import it back to the project as soon as it 
has been translated.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Exporting project texts
To export individual project texts, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The child elements are displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Select the texts you want to export.
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4. Click on the  button. The "Export" dialog opens.

5. From the "Source language" drop-down list, select the language from which you wish to 
translate, for example Italian.

6. From the "Target language" drop-down list, select the language into which the texts are to 
be translated, for example, French.

7. Enter a file path and a file name for the export file in the "Export file" input field.

8. Click "Export".

Result
The texts selected in the "Project texts" editor are written to an xlsx file. The xlsx file will be 
stored in the specified folder. 
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You can alternatively select and export all project texts from categories. Select "User texts" or 
"System texts" in the "Export" dialog in line with the type of texts you wish to export. In this 
case, export can additionally be limited by categories.

 

 Note

Project texts in library objects cannot be exported.
 

See also
Working with multiple languages (Page 6888)

Translating texts using reference texts (Page 6892)

Translating texts directly (Page 6890)

Project text basics (Page 6889)

Importing project texts (Page 6897)

Importing project texts
Edit the xlsx file or send it to a translator. Import the texts once they have been translated. The 
foreign languages will be imported to the relevant object in the project.

Requirements
● At least two languages have been enabled in the "Project languages" editor, for example, 

Italian and French.

Importing project texts 
To import a project text file, proceed as follows:     

1. Click on the arrow to the left of "Languages & resources" in the project tree.
The lower-level elements will be displayed.

2. Double-click on "Project texts". The "Project texts" editor will open.

3. Click on the  button. The "Import" dialog opens.

4. Select the path and file name of the import file from the "Import file" field.

5. Activate the "Import source language" check box if you have made changes to the source 
language in the export file and would like to overwrite the entries in the project with the 
changes.

6. Click on "Import".

Result
You have imported the project texts.

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
System Manual, 02/2014 6895



See also
Exporting project texts (Page 6893)

Working with multiple languages (Page 6888)

Project text basics (Page 6889)

Translating texts directly (Page 6890)

Translating texts using reference texts (Page 6892)

10.12.6.6 Using language-specific graphics

"Graphics" editor

Introduction
You use the "Graphics" editor to manage the configured graphic objects in different language 
versions. Multilingual projects sometimes also require language-specific versions of the 
graphics, for example, if

● the graphics contain text;

● cultural aspects play a role in the graphics.

Opening the "Graphics" editor
Double-click on "Languages and resources" in the project tree.    

Work area
The work area displays all configured graphic objects in a table. There is a separate column 
in the table for each project language. Each column in the table contains the versions of the 
graphics for one particular language.

In addition, you can specify a default graphic for each graphic to be displayed whenever a 
language-specific graphic for a project language does not exist.

Preview
The preview shows you how the graphics will look on various devices. 

See also
Storing an external image in the graphics library (Page 6900)

Storing an image in the graphics library (Page 6899)

Languages in WinCC (Page 6882)
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Storing an image in the graphics library

Introduction
You use the "Graphics" editor to import graphics you want to use in screens in the "Screens" 
editor. It also allows you to manage language-specific versions of graphics. A preview shows 
the graphic displays on various HMI devices.   

Requirement
● The language-dependent versions of a graphic are available.

● Multiple languages have been enabled in the "Project languages" editor.

● The "Graphics" editor is open.

Inserting graphics
1. Click "Add" in the "Graphics library" table. A dialog box opens.

2. Select the required graphic file.

3. Click "Open" in the dialog box.
The graphic will be imported to the project and displayed in all cells in this row in the 
"Graphics" editor. 

4. Click in the corresponding cell of a language for which a language-dependent version of 
this graphic exists.

5. Select  "Add graphic" from the shortcut menu. A dialog box opens.

6. Select the desired graphic file and click "Open."
The language-dependent version is inserted in the table in place of the reference language 
graphic. 

7. Then, in the "Default graphic" column, import a graphic to be displayed in runtime for those 
languages for which there is no language-specific graphic.

You can also drag&drop a graphic from Windows Explorer to the relevant position in the 
"Graphics library" table.

Displaying graphics in the HMI device preview
1. Click on a graphic in the table.

2. Select the required HMI device under "Properties > Graphics settings > Device preview" in 
the Inspector window.
The graphic will then be displayed as it will appear in runtime on the selected HMI device.

Result
The graphics added are available in the "Graphics" editor. The graphic assigned to the 
respective editing language will be displayed during editing. The default screen will be 
displayed in all editing languages for which no screen has been imported.
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The screens assigned to the respective runtime language are displayed during runtime. The 
default screen is displayed in all runtime languages for which a screen has not been imported.

 

 Note

If you disable a project language, all of the graphic objects you have already created in this 
language will be deleted from the current project. 

 

See also
"Graphics" editor (Page 6896)

Storing an external image in the graphics library

Introduction
To display graphics that have been created in an external graphics program in your screens, 
you will first have to store these graphics in the graphics browser of the WinCC project.      

Requirement
● Multiple languages have been enabled in the "Project languages" editor.

● The "Graphics" editor is open.

● There is a graphic in the "Graphics" editor.

Creating and adding a new graphic as an OLE object
1. Click "Add" in the "Graphics library" table. A dialog box opens.

2. Navigate to the folder in which the graphic is stored.

3. Click "Open" in the dialog box.
The graphic will be imported to the project and displayed in all cells in this row in the 
"Graphics" editor. 

4. Click in the corresponding cell of a language for which a language-dependent version of 
this graphic exists.

5. Select  "Insert object" from the shortcut menu. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

6. Select "Insert object > Create new" and an object type in the dialog.
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7. Click "OK." The associated graphic program is opened.

8. Close the graphics program once you have created the graphic.
The graphic will be stored in the graphic programming software standard format and added 
to the graphic browser.

Inserting created graphics in WinCC
1. Click in the corresponding cell of a language for which a language-dependent version of 

this graphic exists.

2. Select  "Insert object" from the shortcut menu. The "Insert object" dialog box opens.
 

  Note

In addition, the dialog "External application running..." will open. The dialog will not close 
until you exit the external application.

 

3. From the "Insert object" dialog box, select "Create from file."

4. Click the "Browse" button.

5. Navigate to the created graphic and select it.
 

  Note

To import graphics files, note the following size restrictions:

*.bmp, *.tif, *.emf, *.wmf  ≤4 MB

*.jpg, *.jpeg, *.ico, *.gif "*≤1 MB
 

Result
The OLE objects added are available in the "Graphics" editor. 

Versions of the graphics for the current editing language are displayed in the "Screens" editor. 
The default graphic is displayed in all editing languages for which no screen has been imported.

The graphic is displayed in runtime in the set runtime language. The default graphic is displayed 
in all runtime languages for which no graphic has been imported.

You can double-click OLE objects in your library to open them for editing in the corresponding 
graphic editor. 

See also
"Graphics" editor (Page 6896)
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10.12.6.7 Languages in runtime

Languages in Runtime

Using multiple runtime languages
You can decide which project languages are to be used in runtime on a particular HMI device. 
The number of runtime languages that can be available at one time on the HMI device depends 
on the device. To enable the operator to switch between languages during runtime, you must 
configure a corresponding operator control. 

When runtime starts, the project is displayed according to the most recent language setting. 
When runtime starts the first time, the language with the lowest number in the "Order for 
language setting" is displayed.

Setting runtime languages during configuration
In the "Languages and Fonts" editor you can specifiy: 

● The project languages to be available as runtime languages for the respective HMI device.

● The order in which the languages are to be switched.

See also
Methods for language switching (Page 6902)

Enabling the runtime language (Page 6903)

Setting the runtime language order for language switching (Page 6905)

Setting the default font for a runtime language (Page 6907)

Selecting the log language (Page 6908)

Languages in WinCC (Page 6882)

Methods for language switching

Introduction
You need to configure language switching if you want to have multiple runtime languages 
available on the HMI device. This is necessary to enable the operator to switch between the 
various Runtime languages. 
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Methods for language switching
You can configure the following methods for language switching:

● Direct language selection
Each language is set by means of a separate button. In this case, you create a button for 
each Runtime language.

● Language switching
The operator switches the languages using a button.

Regardless of the method used, the button names must be translated into each of the 
languages used. You can also configure an output field that displays the current language 
setting.

See also
Languages in Runtime (Page 6900)

Selecting the log language (Page 6908)

Enabling the runtime language (Page 6903)

Setting the runtime language order for language switching (Page 6905)

Setting the default font for a runtime language (Page 6907)

Enabling the runtime language

Introduction
The "Language & Font" editor shows all project languages available in the project. Here you 
select which project languages are to be available as runtime languages on the HMI device.   

Requirements
Multiple languages have been enabled in the "Project languages" editor.
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Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font".

3. Select the following languages:

– English

– Italian

– French

Result
You have now set three runtime languages. A number is automatically assigned to each 
language in the "Order" column. The enabled runtime languages are transferred with the 
compiled project to the HMI device. 

If the number of languages selected exceeds the number that can be transferred to the HMI 
device, the table background changes color.
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See also
Languages in Runtime (Page 6900)

Selecting the log language (Page 6908)

Setting the runtime language order for language switching (Page 6905)

Methods for language switching (Page 6900)

Setting the runtime language order for language switching

Introduction
You specify the language order for runtime language switching. The first time runtime starts, 
the project is displayed in the language with the lowest number in the "Order" column.     

Requirements
● Multiple languages have been enabled in the "Project languages" editor.

● "Language & Font" is open in the editor and three runtime languages have been set in the 
following order:
1. English
2. Italian
3. French
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Procedure
1. Select the runtime language "Italian".

2. Click the  button. The runtime language "Italian" is moved down a place. The number 
will automatically be changed to "2" in the "Order" column.

Result
You have changed the order of runtime languages. The first time runtime starts, the project 
will be displayed in the language with the smallest number, in other words Chinese. If the 
language is switched, this will happen in numerical order.

See also
Languages in Runtime (Page 6900)

Selecting the log language (Page 6908)

Enabling the runtime language (Page 6901)

Setting the default font for a runtime language (Page 6907)

Methods for language switching (Page 6900)
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Setting the default font for a runtime language

Introduction
You can specify the font used to display the texts for each runtime language on the HMI device 
in the "Language & Font" editor. The default font is used in all texts, such as dialog texts, for 
which you cannot define a specific font.   

WinCC offers only fonts supported by the HMI device.

Requirements
● Multiple languages have been enabled in the "Project languages" editor.

● Three runtime languages have been enabled in the "Language & Font" editor.
1. Chinese
2. German
3. French

Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font". The table shows the runtime languages and fonts set.

3. Click in the "French" row in the "Default font" column.

4. Select the font to be used by default if a font cannot be selected for a given text.

Result
The project texts for the runtime language "French" are displayed on the HMI device in the 
selected font.

These fonts are transferred to the HMI device during a transfer operation. 

The default font is also used for the representation of dialogs in the operating system of the 
HMI device. Select a smaller font as default if the full length of the dialog texts or headers is 
not displayed.

See also
Languages in Runtime (Page 6900)

Selecting the log language (Page 6908)

Setting the runtime language order for language switching (Page 6903)

Methods for language switching (Page 6900)
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Selecting the log language

Introduction
In the "Runtime settings > General" editor, select the language to be used for writing to logs 
in runtime.       

Requirements
● The languages used in your project are activated in the "Project languages" editor, for 

example "German" and "English" .

Procedure
1. Double-click on "Runtime settings" in the project tree.

2. Click on "Language & Font".

3. Activate the runtime languages, for example, "German" and "English".

4. Specify the "order":

– 1 German

– 2 English

5. Click on "Runtime settings > General".

6. Select "German" for "Logs > Log language".

Result
After loading, the project will start in the runtime language "German". The logs are now written 
in German. During runtime, the operator switches the runtime language to English. The logs 
will still to be written in German.

See also
Languages in Runtime (Page 6900)

Setting the default font for a runtime language (Page 6905)

Setting the runtime language order for language switching (Page 6903)

Methods for language switching (Page 6900)

Enabling the runtime language (Page 6901)
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10.12.6.8 Example of multilingual configuration

Example: Configuring a button for language switching

Introduction
In this example, you configure a button that can be used to toggle between multiple runtime 
languages during runtime.

Requirements
● You have completed the "Configuring a button in multiple languages" example.

● The "Screen_1" screen is open.

● The button on the screen has been selected.

Procedure
1. In the Inspector window, select "Properties > Events > Press".

2. Click on "Add function" in the table.

3. Select the "SetLanguage" system function and the "Switch" setting.

Result
You have assigned the button the function "SetLanguage". Pressing the button during runtime 
will switch the runtime language. The runtime languages are switched in the order specified 
by the number sequence in the "Languages and fonts" editor. 

See also
Example: Configuring a button in multiple languages (Page 6909)

Example: Configuring a button for language switching for each runtime language (Page 6910)

Languages in WinCC (Page 6882)

Example: Configuring a button in multiple languages

Introduction
In this example, you configure a "Sprache umschalten" button in German and "Switch 
language" button in English.
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Requirements
● The languages "German" and "English" have been enabled in the "Project languages" 

editor.

● German has been set as editing and reference language.

● You have created and opened the "Screen_1" screen.

● The Inspector window is open.

Procedure
1. Drag-and-drop a button from the "Tools" task card into the screen.

The button will be added to the screen.

2. In the Inspector window, open "Properties > Properties > General".

3. Enter the text ""Sprache umschalten" under "Text > off".

4. Press <Enter> to confirm. The button is named.

5. Open the "Tasks" task card.

6. Select "English" under "Languages & Resources > Editing language".

7. Enter the label "Switch Language" under "Properties > Properties > General > Text > Off" 
in the Inspector window.

Result
The button name is configured in German and English language. The button name 
corresponding with the current Runtime language is shown in Runtime. 

See also
Example: Configuring a button for language switching (Page 6907)

Example: Configuring a button for language switching for each runtime language (Page 6910)

Example: Configuring a button for language switching for each runtime language

Introduction
In this example, you configure a "Sprache umschalten" button in German and "Switch 
language" button in English.
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Requirements
● The following languages have been enabled in the "Project languages" editor

– German

– English

– Italian

● All languages have been set as runtime languages in the "Runtime settings > Language & 
Font" editor.

● You have created and opened the "Screen_1" screen.

● Three buttons have been created on the screen:

– Button_1 labelled "Deutsch"

– Button_2 labelled "English"

– Button_3 labelled "Italiano"

● The Inspector window is open.

Procedure
1. Select "Button_1".

2. In the Inspector window, select "Properties > Events > Press".

3. Click on <Add function> in the table.

4. Select the "SetLanguage" system function.

5. Click on the "Switch" field.

6. Click on the button.

7. Select "Runtime language". The field will be highlighted in red.

8. Select "German" from the drop-down list.

9. Repeat steps 1 - 8 for the other two buttons and select the corresponding runtime language.

Result
You have configured three buttons for switching language in runtime. Each button will switch 
to a different runtime language. For example, clicking on the "English" button during runtime 
will switch the runtime language to English.

See also
Example: Configuring a button for language switching (Page 6907)

Example: Configuring a button in multiple languages (Page 6907)
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10.12.7 Replacing devices

10.12.7.1 Basics

Introduction
You can use existing configurations for new devices and optimize these configurations with 
little manual effort.

All data configured by you is retained in the configuration data. This means you do not need 
to copy individual objects of one device and paste them to another. 

Principle  
The following applies when you replace devices:

● Only functions supported by the new device are available. Only configuration data 
supported by the new device are displayed.
This affects 

– recipes,

– objects available on the screens,

– available system functions,

– available communication logs, etc.

● The number of supported objects, such as screens or tags, may be limited on the new 
device. If the existing objects exceed the limitations on the new device, the objects are 
displayed in full. The objects are, however, highlighted in color in the individual editors. An 
error is generated when the project data is compiled.
Manual post processing is required when switching to a device with fewer features.
Example: Limited number of connections  
All connections will be highlighted in color as invalid if fewer connections are supported on 
the new device than have been configured. Delete any excess connections.

 

 Note

If you replace a Panel and select a PC Station as your new device, for example, WinCC 
Runtime Advanced will automatically be moved below the PC Station in the project tree.

 

See also
Device-specific functions (Page 6913)

Example: Replacing devices (Page 6925)

Basics (Page 6927)

HMI device wizard basics (Page 6802)

Engineering system (Page 7187)

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
6910 System Manual, 02/2014



Basic Panel (Page 7189)

Panel (Page 7196)

Mobile Panel (Page 7199)

Multi Panel (Page 7204)

Comfort Panel (Page 7207)

WinCC Runtime Advanced (Page 7212)

10.12.7.2 Device-specific functions

Device-specific functions

Functions dependent on the device
Functions dependent on the device are implemented as follows:

● Colors
The color is changed automatically when you switch from a device with full color display to 
one with a smaller color range. 
If you change the color manually and then change back again to a device with a larger 
range of colors, the reduced range of colors will be retained.

● Fonts
Any configured font not available on a device will be replaced by a similar one or by the 
configured default font. The default font depends on the device selected. 

● Character sets with different font sizes
Avoid using too many different font sizes when configuring the following devices:

– OP 73

– OP 77A

– TP 177A

A character set is downloaded to the device for each font size. Check the Inspector window 
during compilation to see how much of the device memory is being used by the character 
sets.
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● Font size
Use small Windows fonts to display the text on devices. If you use large Windows fonts, 
then, depending on the size of the display, the text will not be displayed in full.
Using font sizes of 28 pixels or more for the OP 77A and TP 177A devices will affect device 
performance. 
The character scope is much greater for Asian languages. The use of different font sizes 
therefore has serious implications on the memory requirements of all devices.
Use the same font type for all large characters throughout the project to ensure effective 
and efficient configuration.

● Screens and screen objects
If the new device supports a different resolution than the previous device when you replace 
a device, there are several ways to adjust the screens.
Adjust the size of the screens to the new device in the menu under "Options > Settings > 
Visualization > Fit to size screen".

See also
Basics (Page 6910)

Key assignment when replacing devices (Page 6914)

Key assignment when replacing devices (Page 6916)

Screen adjustment options (Page 6918)

Key assignment when replacing devices

Introduction
The devices available each have different function keys. The functions configured for these 
keys will be mapped to the available function keys of the new device if the device is replaced.

Function key mapping
The function keys below the display are mapped from left to right to the new device. If the new 
device has fewer keys, the keys it does not have are not mapped.

Example: Replacing a KTP1000 Basic with a KTP600 Basic
You have configured a function for F2 in KTP1000 Basic. This function is triggered by F2 
following replacement with a KTP600 Basic.

If you have used F7 in a KTP1000 Basic, this function will no longer be available if the panel 
is replaced with a KTP600 Basic.
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Mapping of control keys and cursor keys
The following keys are mapped only to the same keys of the new device:

● HELP

● ESC

● ACK

● ENTER

● PAGE UP

● PAGE DOWN

● CURSOR UP

● CURSOR DOWN
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See also
Key assignment when replacing devices (Page 6916)

Device-specific functions (Page 6911)

Key assignment when replacing devices

Introduction
The devices available each have different function keys. The functions configured for these 
keys will be mapped to the available function keys of the new device if the device is replaced.

Function key mapping
The function keys to the left and right of the display are mapped from top to bottom to the new 
device. If the new device has fewer keys, the keys it does not have are not mapped. The 
function keys below the display are mapped from left to right to the new device. If the new 
device has fewer keys, the keys it does not have are not mapped.       

Example: Exchange MP 377 with KP700 Comfort 
You have configured a function on key S3 on the MP 377. This function is triggered by F5 if 
the panel is replaced with an KP700 Comfort.

If you use the S8 key on an MP 377, this function is no longer available when the panel is 
replaced with a KP700 Comfort.
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Mapping K-keys
K-keys are only mapped to the same K-keys in the new device, e.g. K5 to K5.     

If the new device has no K keys, configurations for the K keys are lost.
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If you replace a KP700 with an OP 277,for example, the F1 - F14 keys are retained. The 
configuration of the K keys is lost, because the KP700 has no K keys.

 

Mapping of control keys and cursor keys
The following keys are mapped only to the same keys of the new device:

● HELP

● ESC

● ACK

● ENTER

● PAGE UP

● PAGE DOWN

● CURSOR UP

● CURSOR DOWN

Exception
"HELP" is triggered by "SHIFT+ ESC" on OP 73.

See also
Key assignment when replacing devices (Page 6912)

Device-specific functions (Page 6911)

10.12.7.3 Adjust screens to the new device

Screen adjustment options

Introduction
Select fit to size for screens before you replace a device. Fit to size is particularly important 
when switching devices with different display resolutions.
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Object adjustment to content can be prevented for objects such as graphic views or text fields. 
 

 Note

The objects are distorted if you replace a device with a landscape format display with a device 
with a portrait format display. The difference in display format can, for example, result in object 
labels being cut off and content not being fitted to the object. You must therefore adjust the 
screens to the new device once you have replaced devices.

 

Screen adjustment when replacing devices
Adjust the size of the screens to the new device in the menu under "Tools > Settings > 
Visualization > Resize screen".

Select one of the following settings.

None (default setting)
The screens are not scaled. The objects in the screen retain their position and size. Use this 
setting as first test for checking of a possible exchange result because there are no rounding 
losses during forth and back exchange. 

This option may result in objects being outside the configurable area if the display of the new 
device is smaller than the old one. 

Fit to screen
The position and object size are adjusted to the new display size. Resizing takes place along 
the x-axis and the y-axis. Graphics and font size are adjusted accordingly. 

Fit to height
The aspect ratio is maintained and the screens are adjusted to the height of the new device.

Use this option when you are replacing a device with display format 4:3, for example, with a 
device with widescreen. 
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Fit to width
The aspect ratio is maintained and the screens are adjusted to the width of the new device.

Use this option when you are replacing a device with widescreen, for example, with a device 
with display format 4:3. 

Free scale factor
You select a free scale factor for screen adjustment. You can specify a factor for the x-axis 
and the y-axis. 

Using a free scale factor of < 1 may distort the objects. Object labels may, for example, be cut 
off and the content may not be fitted to the object.

You must therefore adjust the screens to the new device once you have replaced devices. 

 
 

 Note

The aspect ratio is not adjusted for objects with a fixed aspect ratio, for example, gauge, 
circle. The objects are displayed on the new device with the same aspect ratio as prior to the 
replacement of the device. 

 

See also
Specifying the position of screen objects (Page 6923)

Fit objects to contents

Introduction
For some objects, you can specify fit to respective content in the Inspector window, for example:

● Text field: fit to text content

● I/O field: fit to text content

● Symbolic I/O field: fit to text content or to text list

● Graphic view: fit to included graphic

Fit to size for text and graphic objects
Disable automatic fit to size of the individual objects in the menu under "Options > Settings > 
Visualization > Resize screen and screen objects > Fit to content". This results in scaling of 
the objects as specified under "Options > Settings > Visualization > Resize screen and screen 
objects".

Select the objects which are not automatically fitted to size.
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● If "Disable 'fit to size' for text objects" is activated, automatic fit to size is ignored in the text 
object properties.
If you have activated "Fit screen to window height", the text field along with the other objects 
is scaled in accordance with the height of the new device.

● If "Disable 'fit to size' for graphic objects" is activated, automatic fit to size is ignored in the 
graphic object properties.
If you have activated "Fit screen to window width", the graphics view along with the other 
objects is scaled in accordance with the width of the new device.

 

  Note

The settings have no effect on screen objects whose size cannot be changed, such as 
alarm indicators or screen objects with a fixed aspect ratio. 

 

"Disable 'fit to size' for text objects" and "Disable 'fit to size' for graphic objects" have no effect 
if:

- You have activated "Resize screen and screen objects > None".

- You have activated "Fit screen to window width and height" and the new device has the same 
resolution as the current device.

- You have activated "Fit screen to window height" and the new device has the same resolution 
as the current device.

- You have activated "Fit screen to window width" and the new device has the same resolution 
as the current device. 

Example
The figure below shows the effects of automatic sizing using a graphic object with two buttons 
aligned as an example:
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① Initial situation: 
● Two buttons are aligned on a graphic object.
● The option "Fit object size to graphic" or "Adjust object size to graphic" is activated in the 

object properties of the graphic object under "Display > Sizing".
② Option 1: The original properties of the graphic object are to be maintained after switching the 

HMI device.
● Deactivate the option "Disable 'fit to size' for graphical objects" in the settings under "Size 

adaptation of objects".
Effect: The graphic object retains its original size after switching the HMI device. The alignment 
to the buttons is lost. 

③ Option 2: The graphic object is to be placed relative to the new screen resolution after switching 
the HMI device.
● Activate the option "Disable 'fit to size' for graphical objects" in the settings under "Size 

adaptation of objects".
The option "Fit graphic to object size" is activated automatically in the object properties of the 
graphic object. The two buttons are properly aligned on the graphic object even after switching 
the HMI device. 

 

See also
Specifying the position of screen objects (Page 6923)
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Specifying the position of screen objects

Introduction
There are various ways to adjust the position of screen objects to the new device.

Select position
Adjust the position of the screen objects to the new device in the menu under "Options > 
Settings > Visualization > Fit to size screen > Select position".

Example
The following option aligns the objects with the top left edge.

The following object centers the objects in the middle of the screen.

See also
Screen adjustment options (Page 6916)

Fit objects to contents (Page 6918)

10.12.7.4 Example: Replacing devices

Example: Procedures overview

Introduction
In the following example you replace a TP177 B 6'' PN/DP with a TP700 Comfort.
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Procedures overview
The procedure when replacing a device is as follows:

1. Adjust screens to the new device

2. Replacing devices

See also
Example: Adjusting screens (Page 6924)

Example: Replacing devices (Page 6925)

Example: Adjusting screens

Introduction
Adapt the screen before you replace a device. Screen adaptation is required as the display 
formats are different.

The TP 177B format is 320 x 240 pixels while the format of the TP700 Comfort is 800 x 480 
pixels. 

Requirements
● A project is open.

● The TP 177B 6'' PN/DP device is used in the project.

Adjusting screens
1. Open the "Options > Settings" menu.

2. Click on "Visualization > Resize screen".

3. Activate "Fit to height".

4. Select "Disable fit to size for text objects".

5. Select "Disable fit to size for graphical objects".
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Result
You have carried out screen adjustment in preparation for replacing devices. 

See also
Example: Replacing devices (Page 6925)

Example: Procedures overview (Page 6921)

Example: Replacing devices

Introduction
The following example shows you how to replace a device. 

Requirements
● A project has been created and opened.

● The TP 177B 6'' PN/DP device is used in the project.

Procedure       
1. Double-click on "Devices & Networks" in the project navigation. The editor opens.

2. Click on the "TP 177B" device.

3. Select "Change Device/Version" in the device shortcut menu. A dialog opens.

4. Select the TP700 Comfort device.
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5. Select the matching image for the HMI device version that suits your configuration under 
"Version".
When you change the image, the new image is automatically transferred to the target 
system with the next download. All runtime files are deleted during this step. 
Details of hardware differences can be found in the "Compatibility information".

6. Click "OK". Device replacement is started.

Result
You have replaced the TP 177B device used in the project. You now use the TP700 Comfort 
device. 

See also
Example: Procedures overview (Page 6921)

Basics on migration (WinCC flexible) (Page 167)
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Changing between device versions (Page 6968)

Changing the device version (Page 6969)

Basics (Page 6910)

Example: Adjusting screens (Page 6922)

10.12.8 Copying between devices and editors

10.12.8.1 Basics

Basics

Copying and pasting within an HMI device   
You can copy and paste objects, such as display objects, within an HMI device. If the object 
is already created in the editor, when the object name is inserted a number is automatically 
attached, in accordance with the following principle:

● "<Object_name>_1" is renamed to "<Object_name>_2".

● "<Object_name>_2" is renamed to "<Object_name>_3".

Copying and pasting between HMI devices
You can also copy and paste between HMI devices. If an object with the same name already 
exists, you have the following options:
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 Note
Exception to this basic rule

Copying and pasting of an alarm class that has been generated from project-wide alarm class 
is handled differently than with this basic rule. When the copied alarm class already exists in 
the target HMI device within the same project, the "Paste" command is not performed.

 

Copying user-defined folders  
You can create user-defined folders for editors, for example, for HMI tags, screens, etc.

You can copy user-defined folders and paste them into another HMI device. The objects 
contained in a user-defined folder may exceed the limitations applying to the other HMI device, 
such as the number of supported screens. After they have been pasted, all the objects are 
displayed. An error is displayed when the project data is compiled.

System folders cannot be copied. 

Copy and paste options

Copy and paste options  
Copy and pasting individual objects simplifies configuration. 

WinCC offers a number of options for copying and pasting objects.

Shortcut menu
To copy and paste objects using the shortcut menu, proceed as follows:

1. Select an object, for example a button.

2. Select "Copy" in the shortcut menu.

3. Move the mouse cursor to the place on the screen where you want to paste the button.

4. Select "Paste" in the shortcut menu.
The button will be pasted together with all properties already defined.

Drag&drop
To drag-and-drop objects, proceed as follows: 

1. Click on "Screens > Start" in the project tree of a device.

2. Drag-and-drop the "Start" screen into the "Screens" folder of another device.

3. A dialog will appear if the second device already contains a screen with the same name.

4. Choose whether to replace or rename the existing screen. 
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Unsupported objects and functionalities

Introduction 
When an object is copied, all its properties and settings are transferred to the target HMI device.

Unsupported objects   
Objects that are not supported in the target HMI device cannot be pasted.

 

 Note

When you copy a screen containing objects which are not supported by the destination HMI 
device, the objects remain in the background. When you copy the screen again and the new 
device supports the objects, they are displayed again.

 

Invalid objects
The following objects become invalid once they have been pasted into the target HMI device:

● Referenced objects that do not exist in the target HMI device.

● Objects with settings that are not supported in the target HMI device.

● System functions that were configured for objects and that are not supported in the target 
HMI device.

Invalid objects are highlighted by a color coding. Select a supported object or create a new 
one. If you retain an invalid object, an error will be displayed when the project data is compiled.

Colors and fonts     
Colors and fonts are supported to varying degrees by HMI devices. When unsupported colors 
and fonts are pasted, they are replaced by supported colors and fonts. When you paste the 
same object back into the source HMI device, the original settings become active again. 

10.12.8.2 Copying and pasting

Simple and extended pasting

Introduction
An object is linked to another object in the following situations, for example:

● You specify a tag for an alarm as a trigger tag.
The alarm is the object. The tag is the linked object.

● You specify a connection for an external tag.
The tag is the object. The connection is the linked object.
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The object is always fully inserted during copying and pasting. Whether or not the linked object 
is pasted depends on the command used to insert it.

Simple pasting  
The linked object is not copied. The linked object is transferred and handled as follows in the 
target HMI device:

● If an object with the same name exists, the existing object with its settings is used.

● If no object with the same name exists, the name of the object will be displayed. The object 
becomes invalid.

For some objects, linked objects are pasted automatically during simple pasting.

Extended pasting
Select the "Extended paste" command in the shortcut menu to paste the linked objects as well. 
If objects of the same name exist in the target HMI device, you need to decide whether or not 
to overwrite each of these objects. 

See also
Linked objects copied automatically (Page 6930)

Linked objects copied automatically

Copying linked objects   
The following table shows the objects for which linked objects are pasted automatically in 
simple pasting.

Object Linked object
Screen Template
Symbolic I/O field Text list
Graphic I/O field Graphics list
Graphic view Graphic
Tag Alarm

Cycle
Recipe element Text list
Scheduler Triggers

See also
Simple and extended pasting (Page 6927)
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Linked objects copied automatically

Copying linked objects   
The following table shows the objects for which linked objects are pasted automatically in 
simple pasting.

Object Linked object
Screen Cycle

Template
Symbolic I/O field Text list
Graphic I/O field Graphics list
Graphic view Graphic
Tag Alarm

Logging tag
Cycle

Log Logging tag
Logging tag Log type
Recipe element Text list
Scheduler Triggers

Drag & drop from the details view

Introduction
You can improve configuration efficiency with just a few simple measures. Below are a few 
examples of efficient configuration.

Pasting objects to a screen from the details view
You can drag objects in the details view from various different editors to other editors. 

Pasting a symbolic I/O field
1. Open a screen.

2. Click on the "Text and graphics lists" editor in the project tree. All existing text and graphics 
lists will be shown in the details view.

3. Click on a text list, for example, "Textlist1" in the Details view.

4. Drag-and-drop a text list from the Details view to a screen. A symbolic I/O field has been 
created and connected to the text list "Textlist1".
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Pasting a graphic I/O field
1. Open a screen.

2. Click on the "Text and graphics lists" editor in the project tree. All existing text and graphics 
lists will be shown in the details view.

3. Click on a graphics list in the Details view, for example "Graficlist1".

4. Drag-and-drop a graphics list from the Details view to a screen. A graphic I/O field has been 
created and connected to the graphics list  "Graficlist1".

Pasting an I/O field
1. Open a screen.

2. Click on the "HMI tags" editor in the project tree. All existing HMI tags will be shown in the 
Details view.

3. Click on an HMI tag in the Details view, for example "Tag1".

4. Drag-and-drop the HMI tag from the Details view to a screen. An I/O field has been created 
and connected to the HMI tag "Tag1".

 

Copying screens 

Introduction     
You copy one or more screens from the "Screens" folder and paste them into the "Screens" 
folder of another device.

Type and size of the displays         
In the case of HMI devices with keys, the available keys are displayed automatically in the 
screen. When a screen is copied between HMI devices, the keys are either displayed or hidden; 
functions configured for function keys are not transferred.

If there is less space for the screen in the target HMI device than in the source HMI device, 
you can adjust the size of and the spacing between existing objects. 

Automatic fit to size for objects
1. Select "Options > Settings > Visualization > Resize screen and screen objects" in the menu.

2. Activate, for example, "Fit to height".

See also
Screen adjustment options (Page 6916)
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Copying recipes within an HMI device

"Recipes" Editor
You can copy recipes, recipe elements and recipe data records within each table. You copy 
a recipe element to another recipe. 

Only WinCC Runtime Professional: You can copy a recipe view element to another recipe 
view. If a recipe view element of the same name already exists, a conflict dialog is displayed. 
You can select whether to replace or rename the recipe element. You can copy recipe elements 
to the first empty row of the "Recipe views" editor, "Elements" tab. 

You can copy a recipe data record to another recipe, if the other recipe contains the same 
number of recipe elements. If the data types differ, the value will be copied to the target data 
record but it is assigned an error flag.

"Tags" editor
You can drag-and-drop a tag to a recipe element in the "Tag" column. The tag is linked to the 
recipe element. If a tag is already linked, an error message will be generated.

"Screens" editor
If you drag-and-drop a recipe to a screen, a new recipe display will be created and linked to 
the recipe. 

Differences between Runtime Advanced and Panels and Runtime Professional

Overview   
The following table shows the availability of the various functions in Runtime Advanced and 
Panels and Runtime Professional.

Function in WinCC Runtime Advanced and Panels Runtime Professional
Logs Yes

Data log
Alarm log

Yes
Data log
Compressed log
Alarm log

Scheduler Yes Yes
User administration Yes Yes
Screens Yes Yes
Settings Yes Yes
Global elements Yes No
Alarms Yes

Alarm indicator
Alarm window
Alarm view

Yes
Alarm view with more functions than in 
Runtime Advanced and Panels
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Function in WinCC Runtime Advanced and Panels Runtime Professional
Menus and toolbars No Yes
Reports Yes

Printout using the "PrintReport" system 
function

Yes
Printout using print job and scheduler

Recipes Yes User archives from WinCC V6.2
Scripts Yes

VBS
Yes
VBS
C

Structures Yes Yes
Text and graphics lists Yes Yes
Tags Yes Yes
Connections Yes

Different communication drivers
Yes
Different communication drivers

Templates Yes No
Cycles Yes Yes

10.12.8.3 Copying and pasting between Runtime Advanced and Panels and Runtime Professional

Basics

Introduction
You can copy and paste project data such as screens, objects and tags between devices in 
different runtimes. 

Properties and settings  
Objects that are supported in both Runtimes can have different properties and settings. During 
copying and pasting these differences are implemented as follows:

● Properties not supported by the target HMI device are not displayed.

● Default settings are specified for properties that are only supported by the target HMI device.

● Settings which are not supported by the target HMI device are replaced by default settings.

If you copy an object back to the source HMI device without manually changing the settings 
in the target HMI device, all properties and settings originally set in the source HMI device will 
be reactivated.

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
6932 System Manual, 02/2014



Unsupported events and animations
When you paste an object into a different Runtime, the following cases are possible:

● The target HMI device does not support events or animations for the object copied.
Events or animations configured for the copied object are not displayed in the target HMI 
device.

● Events or animations for the object copied are only supported by the target HMI device.

● Certain events and animations are not supported by the target HMI device for the object 
copied.
Events or animations that were configured for the copied object and are not supported by 
the target HMI device are not displayed on the target HMI device.

● Certain events and animations for the object copied are only supported by the target HMI 
device.

All events and animations originally set will be reactivated if you copy the same object back to 
the source HMI device. 

System functions

Supported system functions
The following system functions are supported in Runtime Advanced and Panels as well as 
Runtime Professional:

● ActivateScreen

● IncreaseTag

● InvertBit

● InvertBitInTag

● InverseLinearScaling

● LinearScaling

● ResetBit

● ResetBitInTag

● SetBit

● SetBitInTag

● SetTag

● StopRuntime

● DecreaseTag

● ShowLogonDialog

Additional system functions are supported in Runtime Advanced and Panels.
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Limitations during copying

Differences between the Runtimes 
Some functions are supported exclusively in one Runtime. Some functionalities are supported 
in both Runtimes, but have different concepts. You cannot copy and paste These functions 
between the Runtimes.

Functionalities only supported by Runtime Advanced and Panels
● Templates

● Global elements

You cannot copy these functions to Runtime Professional.

Functionalities only supported in Runtime Professional
● Menus and toolbars

● C scripts

You cannot copy these functions to Runtime Advanced and Panels.

Functions with different concepts
● Configuration

● Recipes

These functions cannot be copied between the Runtimes. 

Objects in screens

Introduction 
When you copy an object from a screen and paste it into another screen, the object is inserted 
at the same position in the screen.

Text and graphics lists
When you copy a symbolic I/O field with a text list or a graphic I/O field with a graphics list and 
paste it into another runtime, the text list or graphics list will be copied to the target HMI device.

Copying objects from reports
You can copy objects that are supported in the screen from a report into a screen. Unsupported 
settings are replaced by supported settings. When you copy a copied object back into a report, 
the changed settings remain active.
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Recipe view and alarm view
The "Recipe view" and "Alarm view" objects have such different concepts that you cannot copy 
and paste these objects between the two Runtimes. 

See also
Screen objects (Page 6937)

Objects (Page 6953)

Screen objects

Supported objects
The following table shows which objects in screens are supported in which Runtime:

Object Runtime Advanced and Panels Runtime Professional
Line Yes Yes
Polyline Yes Yes
Polygon Yes Yes
Ellipse Yes Yes
Circle Yes Yes
Ellipse segment No Yes
Circle segment No Yes
Ellipse arc No Yes
Circular arc No Yes
Rectangle Yes Yes
Connector No Yes
Text field Yes Yes
Pipe No Yes
Double T-piece No Yes
T piece No Yes
Pipe elbows No Yes
I/O field Yes Yes
Symbolic I/O field Yes Yes
Date/time field Yes No
Button Yes Yes
Round button No Yes
Switch Yes No
Graphic view Yes Yes
Graphic I/O field Yes Yes
Bar Yes Yes
Status/Force Yes No
Clock Yes Yes
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Object Runtime Advanced and Panels Runtime Professional
Gauge Yes Yes
Slider Yes Yes
Symbol library Yes Yes
User view Yes Yes
HTML browser Yes Yes
Sm@rtClient view Yes No
Check box No Yes
Option buttons No Yes
Scroll bar No Yes
Screen window No Yes
Disk space view No Yes
Channel diagnostics No Yes
Print job/Script diagnostics No Yes
Recipe view Yes Yes
Alarm view Yes Yes
Trend view Yes No
f(t) trend view No Yes
f(x) trend view Yes Yes
Table view No Yes
Alarm view Yes Yes
Recipe view Yes Yes
Charge condition Yes No
Effective range name Yes No
Effective range name (RFID) Yes No
Effective range signal Yes No
Zone name Yes No
Zone signal Yes No

Connections

Differences between Runtime Advanced and Panels and Runtime Professional

Communication drivers
Please refer to the communications manual for information about the communication drivers 
possible in the Runtimes. Runtime Advanced and Panels and Runtime Professional support 
different communication drivers. There is no common communication driver for both runtimes.

Area pointer
The area pointers are not supported in Runtime Professional. 
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Copying connections 

Introduction
You can copy a connection in the "Connections" editor and paste it in the "Connections" editor 
of another Runtime.

Integrated connections
Integrated connections are created under "Devices & networks" in the network view. An 
integrated connection is displayed in the "Connections" editor. However, you cannot edit the 
integrated connection in the "Connections" editor. Any integrated connection you copy and 
paste from the "Connections" editor to another Runtime will become invalid in the target HMI 
device as it lacks a communication partner. You can only edit the copied integrated connection 
in the network view of the target device. 

Copying variables

Introduction
You can copy a tag in the "Tags" editor and paste it in the "Tags" editor of another Runtime.

Unsupported data types
If you copy a tag with a data type that is not supported in the other Runtime, then the data type 
will become invalid.

Logging tags
If you have linked the tag to a logging tag, this logging tag will be copied to the target HMI 
device together with the tag. A logging tag has to be assigned to a data log. A new log will be 
created if there is no corresponding data log in the target HMI device.

Alarms
Any analog or discrete alarms you have configured for a tag will be copied to the target HMI 
device together with the tag.

System tags
System tags are supported in Runtime Professional only. 

See also
Tag data types and properties (Page 6940)

Logging tags (Page 6949)
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Discrete alarms  (Page 6944)

Analog alarms (Page 6945)

Tag data types and properties

Data types
The following table shows which data types are supported in which Runtime.

Data type Runtime Advanced and Panels Runtime Professional
Boolean Yes Yes
Byte (Signed Byte) Yes Yes
UByte (Unsigned Byte) Yes Yes
Short (Signed Int) Yes Yes
UShort (Unsigned Int) Yes Yes
Long (Signed Long) Yes Yes
ULong (Unsigned Long) Yes Yes
Float Yes Yes
Double Yes Yes
String Yes Yes
UString (Unicode String) No Yes
Raw (Raw Data Type) No Yes
Ref (Text Reference) No Yes
Date Time Yes No

Properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

● Address

● Content (comment)

● Connection

● Control variable

● Data type

● Length
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● Limit values:

– Upper error

– Generate analog alarm for upper error

– Upper warning

– Generate analog alarm for upper warning

– Low

– Generate analog alarm for lower warning

– Lower error

– Generate analog alarm for lower error

● Linear scaling

● Name

● HMI device end value

● HMI device start value

● PLC end value

● PLC start value

● Start value

Structures

Structural elements 

Introduction
You can copy a structural element in the "Structures" editor and paste it in the "Structures" 
editor of another Runtime.

Unsupported data types
If you copy a structural element with a data type that is not supported in the other Runtime, 
the data type becomes invalid in the "Structure" editor. 

See also
Structure data types and properties  (Page 6942)
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Structure types

Introduction
You can copy a structure type from the "Structures" folder and paste it into the "Structures" 
folder of another Runtime.

Unsupported controller types
Since no controller type is supported in both Runtimes, the controller type will be invalid in the 
target HMI device.

Device family
The device family is adapted to the target HMI device when copied. If you copy a structure 
type from Runtime Advanced and Panels to Runtime Professional, for example, the "SmartCE" 
entry automatically becomes "SCADA."

Internal and external data types
In Runtime Advanced und Panels, a structure type can contain either exclusively internal data 
types or exclusively external ones. In Runtime Professional, both internal and external data 
types can be contained in one structure type.

If you copy a structure type that contains internal and external data types from Runtime 
Professional to Runtime Advanced und Panels, all internal data types become invalid. Since 
no communication peer is supported in both Runtimes, all external data types become invalid 
as well. 

Structure data types and properties 

Data types
The following table shows which data types are supported in which Runtime.

Data type Runtime Advanced and Panels Runtime Professional
Boolean Yes Yes
Byte (Signed Byte) Yes Yes
UByte (Unsigned Byte) Yes Yes
Short (Signed Int) Yes Yes
UShort (Unsigned Int) Yes Yes
Long (Signed Long) Yes Yes
ULong (Unsigned Long) Yes Yes
Float Yes Yes
Double Yes Yes
String Yes Yes
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Data type Runtime Advanced and Panels Runtime Professional
UString (Unicode String) No Yes
Raw (Raw Data Type) No Yes
Ref (Text Reference) No Yes
Date Time Yes No

Properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

Structure types:

● Comment: Contents

● Name

● Type of controller

● Device family

Structural elements:

● Comment: Contents

● Data type

● Length

● Linear scaling

● Name

● HMI device end value

● HMI device start value

● PLC end value

● PLC start value

● Error upper limit

● Error lower limit

● Start value

● Bit offset

● Offset
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Alarms

Differences between Runtime Advanced and Panels and Runtime Professional 

Supported objects in the screen
You can configure the following objects for screen alarm display in Runtime Advanced and 
Panels:

● Alarm view

● Alarm window

● Alarm indicator

In Runtime Professional, you can only configure an alarm view.

The concepts of the alarm view in the Runtimes are so different that it is not possible to copy 
an alarm view between the Runtimes.

Alarm text blocks
Alarm blocks are supported in Runtime Professional only. 

Discrete alarms 

Introduction  
You can copy a discrete alarm in the "Alarms" editor in the "Discrete alarms" tab and paste it 
to another Runtime. Pasting a tag with configured discrete alarms to the "Tags" editor will 
automatically also paste the corresponding discrete alarms to the "Alarms" editor.

Supported properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

● ID

● Alarm class

● Alarm group

● Acknowledgment: Tag

● Acknowledgment: Bit

● Tooltip

● Trigger: Tag

● Trigger: Bit

● Event text
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Alarm number
Alarm numbers which do not yet exist in the target HMI device are transferred unchanged 
when copied. If the alarm number already exists, the next free number is assigned 
automatically as the alarm number for the discrete alarm.

Tooltip
Copying a tooltip with more than 255 characters to Runtime Professional will make the entire 
tooltip invalid.

Event text
The event text is displayed in the following dialog boxes of the Inspector window:

● Runtime Panels and Advanced:
"Properties > Properties > General > Settings > Event text"

● Runtime Professional:
"Properties > Properties > Texts > Settings > Event text"

The event texts are copied into the corresponding dialog boxes with all the format data.

Event texts will become invalid:

● if you copy an event text with more than 254 characters to Runtime Advanced and Panels.

● if you copy an event text with a dynamic parameter to Runtime Panels and Advanced.

● if you copy an event text with a text list from Runtime Panels and Advanced to Runtime 
Professional.

Analog alarms

Introduction  
You can copy an analog alarm in the "Alarms" editor in the "Analog alarms" tab and paste it 
to another Runtime. Pasting a tag with configured analog alarms to the "Tags" editor will 
automatically also paste the corresponding analog alarms to the "Alarms" editor.

Supported properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

● Alarm number "ID"

● Event text

● Alarm class

● Alarm group

● Tooltip

● Trigger: Tag
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● Delay

● Limit value

● Trigger mode

● Synchronize limit value

● Hysteresis mode

● Hysteresis

● Hysteresis as a percentage

Alarm number "ID"
Alarm numbers which do not yet exist in the target HMI device are transferred unchanged 
when copied. If the alarm number already exists, the next free number is assigned 
automatically as the alarm number for the analog alarm.

Event text
The event text is displayed in the following dialog boxes of the Inspector window:

● Runtime Advanced and Panels:
"Properties > Properties > General > Settings > Event text"

● Runtime Professional:
"Properties > Properties > Texts > Settings > Event text"

The event texts are copied into the corresponding dialog boxes with all the format data.

Event texts will become invalid:

● if you copy an event text with more than 254 characters to Runtime Advanced and Panels.

● if you copy an event text with a dynamic parameter to Runtime Panels and Advanced.

● if you copy an event text with a text list from Runtime Panels and Advanced to Runtime 
Professional.

Tooltip
Copying a tooltip with more than 255 characters to Runtime Professional will make the entire 
tooltip invalid.

Delay
If you copy a delay with the "Minute" or "Hour" unit from Runtime Professional to Runtime 
Advanced and Panels, the setting becomes invalid. 

See also
Copying variables (Page 6937)
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Controller alarms and system alarms

Controller alarms
Since controller alarms are configured in the controller, it is not possible to copy controller 
alarms.

System alarms
Because system alarms are dependent on the HMI device, it is not possible to copy system 
alarms. 

Alarm classes

Introduction
You can copy an alarm class in the "Alarms" editor in the "Alarm classes" tab and paste it to 
another Runtime.

Predefined alarm classes
You cannot copy and paste predefined alarm classes.

Log
In Runtime Advanced and Panels, you configure an archive in which the alarm is stored. In 
Runtime Professional, you specify whether the alarm is logged for each alarm of an alarm 
class. 

During the copying process the logging specifications are implemented as follows:

● Copying from Runtime Advanced and Panels to Runtime Professional:
If a log has been created in Runtime Advanced and Panels, "Log" is activated in Runtime 
Professional.
If no log has been created in Runtime Advanced and Panels, "Log" is deactivated in 
Runtime Professional.

● Copying from Runtime Professional to Runtime Advanced and Panels:
If "Log" is activated in Runtime Professional, you need to specify a log in Runtime Advanced 
and Panels.
If "Log" is deactivated in Runtime Professional, the entry <No log> is specified in Runtime 
Advanced and Panels.

Flashing
The settings for the flash behavior are not copied. 
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Alarm groups 

Copying and pasting 
You can copy an alarm group in the "Alarms" editor in the "Alarm groups" tab and paste it to 
another Runtime.

Alarm groups from alarm classes
Alarm groups from alarm classes are only supported in Runtime Professional and cannot be 
copied and pasted to Runtime Advanced and Panels.

Hierarchy
Hierarchies of alarm groups are only supported in Runtime Professional. When copied 
between the Runtimes the hierarchy order is implemented as follows:

● Copying from Runtime Advanced and Panels to Runtime Professional
If you copy an alarm group into the "Alarm groups" tab of the "Alarms" editor, the alarm 
group is inserted regardless of any existing alarm groups.
If you copy an alarm group into a line containing an existing alarm group, the alarm group 
is inserted as an alarm group that is subordinate in the hierarchy.

● Copying from Runtime Professional to Runtime Advanced and Panels
Hierarchies cannot be shown in Runtime Advanced and Panels. Alarm groups from all 
hierarchy levels are inserted independently of each other.

ID of the alarm group
Alarm numbers which do not yet exist in the target HMI device are transferred unchanged 
when copied.

Logs

Differences between Runtime Advanced and Panels and Runtime Professional

Logs
Data logs are supported in both Runtimes. You can copy and paste alarm logs and compressed 
logs between the runtimes.

Properties
The following properties are supported in Runtime Advanced and Panels as well as Runtime 
Professional:

Data logs
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● Name

● Comment

● Storage location

Logging tags

● Name

● Process variable

● Triggers

● Logging cycle

● High limit

● Low limit

● Comment

Events
You cannot copy configured events between Runtime Advanced and Panels and Runtime 
Professional. 

Data logs 

Copying and pasting
You can copy a data log in the "Historical Data" editor in the "Data log" tab and paste it to 
another Runtime. All logging tags contained in the data log are included automatically. 

Logging tags

Introduction  
You can copy a logging tag in the "Historical Data" editor in the "Data log" tab and paste it in 
another Runtime.

In addition, you can copy a logging tag in the "Tags" editor of Runtime Professional and paste 
it into the "Historical Data" editor in Runtime Advanced and Panels. To copy a logging tag in 
Runtime Professional, open the "Tags" editor and select the "Alarms & Logs" tab in the upper 
work area. Copy the desired logging tag in the lower work area of the "Data logs" tab.

Tags used in the logging tags
Any logging tag you have linked to a tag will be automatically also copied if the tag is copied 
to the target HMI device. A new log will be created if there is no corresponding data log in the 
target HMI device. There may be performance problems if too much of this additional data is 
copied.
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Multiple logging of tags
When copying from Runtime Professional to Runtime Advanced and Panels, the process tags 
of a logging tag become invalid in the following situations:

● The tag has been logged more than once in Runtime Professional.

● Several logging tags are linked to the same process tag.

Triggers
If you paste a logging tag with a cycle, the cycle will be included in the target HMI device.

In Runtime Professional, configure the log cycle of logging tags in the form "factor x cycle", for 
example, twice an hour. The "Factor" property is not supported in Runtime Advanced and 
Panels. The Factor property is therefore set to the default of "1" when copying from Runtime 
Advanced and Panels to Runtime Professional. When copying from Runtime Professional to 
Runtime Advanced and Panels, only the cycle can be seen in Runtime Advanced and Panels; 
the factor is not taken into consideration. If you copy a cycle of "3 x 1h" from Runtime 
Professional to Runtime Advanced and Panels, for example, this is set in Runtime Advanced 
and Panels as "1h".

Copying logging tags from the "Tags" editor
When you copy a logging tag from the "Tags" editor in Runtime Professional into the "Historical 
Data" editor in Runtime Advanced and Panels, the "Process tag" property is linked to an 
existing tag with the same name. If there is no tag with the same name, the "Process tag" 
property becomes invalid. The "Data log" property is linked to the selected data log.

If you copy a logging tag from the "Tags" editor in Runtime Professional to the "Tags" editor 
of another HMI device, the "Data log" property will not be transferred.

Copying logging tags from the "Historical Data" editor
When you copy a logging tag from the "Historical Data" editor in Runtime Advanced and Panels 
into the "Tags" editor in Runtime Professional, the "Data log" property will not be transferred.

When you copy a logging tag from the "Historical Data" editor into the "Logs" editor of another 
HMI device, the "Process tag" property is linked to an existing tag with the same name. If there 
is no tag with the same name, the "Process tag" property becomes invalid. The "Data log" 
property is linked to the selected data log.

Logging tags used in compressed logging tags
When you copy a logging tag used in a compressed logging tag in Runtime Professional to 
Runtime Advanced and Panels, the settings for the compressed logging tag are also copied 
in the background. There may be performance problems if too many of these unnecessary 
settings are copied to Runtime Advanced and Panels. 

See also
Copying variables (Page 6937)
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Copying VB scripts

Object types, properties and methods in VB script
The objects, object types, properties and methods supported in Runtime Advanced and Panels 
and Runtime Professional are listed in the VBS reference. 

Pasting  
You can copy VB scripts

● using the shortcut menu or by drag & drop from the project tree

● from the code of an open VB script to another open VB script.

Objects called in VB script
You copy a VB script. Objects and their properties which do not exist in or are not supported 
by the target HMI device are called in the VB script. The syntax check reports an error. Correct 
the invalid object references.

Variables called up in a VB script
The syntax check will report errors if tags are called in the copied VB script that do not exist 
in the target HMI device or only exist with a different data type. Replace the invalid tags with 
tags that exist in the target HMI device.

If you are planning to copy scripts into different Runtimes, use the same variables in the 
Runtimes. 

Copying recipes between Runtime Advanced and Panels and Runtime Professional

Recipe and recipe element
The recipe elements and recipe data records will also be copied if a recipe is copied.

 

 Note
Inconsistent data

Properties not supported by the HMI device, for example data type, will be formally copied 
but will appear with an error flag.

Check the properties and reassign those flagged.
 

You can drag-and-drop a recipe element into the first empty line of the "Recipes Element" 
editor of another HMI device. The recipe element is inserted into the other recipe. If the recipe 
does not have the "Tags" communication type, the associated tag will be copied but it is 
assigned an error flag.
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Points to note when copying from WinCC Runtime Advanced and Panels to WinCC Runtime 
Professional

The properties below are preset as follows and may subsequently be edited:

● "Tags" communication type

● "Limited" size type

● Number of data records

The storage location of the recipe is changed to "Database".

With a recipe element, the link will be copied but not the linked tag. You need to copy the tag 
separately or create a new tag with the same name. The same applies to the text list.

 

 Note
Inconsistent data 

Array tags are not supported in WinCC Runtime Professional. After copying the recipe, create 
as many recipe elements and tags as there are array elements in the linked array tag. Link 
the new recipe elements to the tags. Copy the values of the source recipe data records to 
the target recipe data records.

 

Points to note when copying from WinCC Runtime Professional to WinCC Runtime Advanced and 
Panels

The following properties will be changed but cannot be edited:

● "Tags" communication type

● "Limited" size type

● Number of data records per HMI device

● "File" storage location with default path

Recipe data record and recipe query
You can copy a recipe data record to another recipe, if the other recipe contains the same 
number of recipe elements. If the data types differ, the value will be copied to the target data 
record but it is assigned an error flag.

Features specific to WinCC Runtime Professional
You can drag-and-drop a recipe query into the first empty row of the "Recipe queries" editor 
of another HMI device. The recipe query is copied but not the linked recipe elements and their 
recipes.
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Copying cycles

Introduction 
You can copy cycle in the "Cycles" editor and paste it in the "Cycles" editor of another Runtime. 
Referenced cycles are also copied whenever tags, logging tags or tasks are copied. The cycles 
are then displayed in the "Cycles" editor.

Supported properties
The date and time of the last change are updated during pasting.

Properties
The "Starting point" property is only supported in Runtime Professional.

Cycle units
Runtime Professional and Runtime Advanced and Panels support different cycle units. 

Reports

Objects

Introduction  
When you copy an object from a report and paste it into another report, the object is inserted 
at the same position in the report.

Supported properties
The concepts of the "Recipe display" and "Alarm view" objects differ so greatly that they cannot 
be copied and pasted between the various Runtimes.

Text and graphics lists
Text and graphics lists are automatically copied along with symbolic and graphic I/O fields and 
are then displayed in the "Text and graphics lists" editor.

Copying objects from screens
You can copy objects supported in the report from a screen to a report. Unsupported settings 
are replaced by supported settings. When you copy a copied object back into a screen, the 
changed settings remain active. 
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See also
Objects in reports (Page 6954)

Objects in screens (Page 6934)

Copying a report

Introduction  
You can copy a report from the "Reports" folder and paste it into another "Reports" folder. 

Watermarks
Watermarks are only supported in Runtime Professional. When you copy a report from 
Runtime Professional to Runtime Advanced and Panels, the areas for the watermarks will no 
longer be shown.

Print jobs
The print jobs in the "Reports" folder are only supported in Runtime Professional and cannot 
be copied and pasted between Runtimes. 

Objects in reports

Supported objects
The following table shows which objects are supported in which Runtime:

Basic object Runtime Advanced and Panels Runtime Professional
Line Yes Yes
Polyline Yes Yes
Ellipse Yes Yes
Circle Yes Yes
Ellipse segment No Yes
Circle segment No Yes
Elliptical arc No Yes
Circular arc No Yes
Rectangle Yes Yes
Polygon Yes Yes
Text field Yes Yes
I/O field Yes Yes
Symbolic I/O field Yes Yes
Date/time field Yes No
Graphic I/O field Yes Yes
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Basic object Runtime Advanced and Panels Runtime Professional
Alarm view No Yes
Recipe view No Yes
Table view No Yes
f(t) trend view No Yes
f(x) trend view No Yes
Page number Yes Yes
Report name No Yes
Project name No Yes
Hardcopy No Yes
ODBC database field No Yes
ODBC database table No Yes
Alarm sequence report No Yes
CSV provider tables No Yes
CSV provider trends No Yes
Alarm report Yes No
Recipe report Yes No
Control data No Yes
Control hard copy No Yes
Control screen No Yes

Text and graphics lists

Differences between Runtime Advanced and Panels and Runtime Professional 

Ranges in text lists
When specifying a range the following settings are supported in both Runtimes:

● Individual value

● Range

The following settings are supported in Runtime Professional:

● To (<=)

● From (>=)

Copying text lists and graphic lists

Introduction  
You can copy a text or graphics list in the "Text and graphics lists" editor and paste it to the 
same editor in another runtime. Text and graphics lists are also automatically copied along 
with symbolic and graphic I/O fields and displayed in the "Text and graphics lists" editor.
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List entries
When a text or graphics list is copied, the corresponding list entries are included in copying. 
You can also copy and paste the list entries individually. 

User administration

Differences between Runtime Advanced and Panels and Runtime Professional

Users
Properties for dynamic logon and web client administration are only supported in Runtime 
Professional.

User groups
The "DisplayName" and "Number" properties are only supported in Runtime Advanced and 
Panels. 

Properties for web client administration are only supported in Runtime Professional.

Copying users, user groups and authorizations

Copying and pasting    
You can copy users, user groups and authorizations in the "User administration" editor.

When you copy a user, the corresponding user group is not copied. 

When you copy a user group, the corresponding authorizations are not copied.

Default entries and system authorizations
The following users, user groups and authorizations are predefined. They cannot be deleted 
and may only be edited to a limited extent:

● predefined user "Administrator"

● predefined groups "Administrator" and "Operators"

● predefined authorizations, such as "Operate" and "Enable remote control"

You can copy the predefined entries and paste them into another Runtime. The entries copied 
are pasted as user-defined entries and can then be edited. 
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Scheduler

Copying scheduled tasks

Introduction  
You can copy a scheduled task in the "Scheduler" editor and paste it to the "Scheduler" editor 
of another device.

Task type
The "Print job" task type is supported in Runtime Professional only. Types that are not 
supported in both Runtimes become invalid after they have been pasted. 

See also
System functions (Page 6933)

Scheduler events (Page 6957)

Scheduler events

Events
The following table shows which events are supported in which Runtime:

Event Runtime Advanced and Panels Runtime Professional
Screen change Yes No
User change Yes No
Alarm buffer overflow Yes No
Runtime stop Yes Yes
When a dialog is opened Yes No
When a dialog is closed Yes No
Disabled Yes Yes
Once Yes Yes
250 milliseconds No Yes
500 milliseconds No Yes
1 second No Yes
2 seconds No Yes
5 seconds No Yes
10 seconds No Yes
1 minute Yes Yes
5 minutes No Yes
10 minutes No Yes
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Event Runtime Advanced and Panels Runtime Professional
1 hour Yes Yes
Once daily Yes Yes
Once weekly Yes Yes
Once monthly Yes Yes
Once yearly Yes Yes
Tag triggers No Yes

10.12.8.4 Copying between different RT and ES versions

Introduction
You can copy and paste project data such as screens, objects or tags between projects with 
different WinCC versions. 

All configurations that are supported in the target version are retained when you copy data 
between projects of different WinCC versions. Configurations that are not supported by the 
target version are marked as invalid with a color code.

Copy of control between HMI devices from different device versions
WinCC supports all configurations of a previous WinCC version. 

The following applies when copying within different ES versions:

● All the configurations that are also supported in the respective RT version are retained. 

● Default settings are defined for configurations that are only supported in the WinCC version 
of the target project.
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● Configurations that are not supported by the respective RT version are marked by color as 
invalid or are not displayed. 
All properties and settings originally defined in the source HMI device are reactivated when 
you copy an object back to the source HMI device unchanged.

● The HMI device must be valid for the current Runtime version.

 

Copying between different ES versions
Open a second instance of the TIA Portal to copy between two TIA projects. You can only 
copy between projects that have the same ES version. The ES version of a project is indicated 
by the file extension *.ap<version_number>.
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10.12.9 Using WinCC version compatibility

10.12.9.1 Basics on version compatibility

Introduction
Edit existing projects as follows with WinCC: 

● You edit, compile and download existing projects with the range of functions of the previous 
version of WinCC. You can continue to edit these projects afterwards with the previous 
version of WinCC. 

● You upgrade existing projects and use the functions of the current WinCC version.
 

  Note
WinCC functions

While editing a project of a previous WinCC version, you can only access the functions 
and HMI devices of this previous WinCC version.

 

Versions in WinCC
In WinCC, you work with different version types: 

● WinCC version
The WinCC version installed on the configuration PC, for example, WinCC V12.

● Project version
Projects are created using the WinCC version that is installed on the configuration PC. 
While you are editing a WinCC project from a previous version in the current WinCC version, 
the version ID is displayed behind the project name in the project tree. 

● Runtime version
You can configure HMI devices with different runtime versions in WinCC. You specify the 
runtime version once for an HMI device. The device version must match the Runtime 
version.

● Device versions
Depending on the used HMI device, the image is a combination of the operating system 
and / or runtime software. For each HMI device, WinCC provides various images which can 
be loaded onto the HMI device, if necessary, according to the configuration. The device 
version corresponds to a specific image. The device version must match the configuration.

Visualize processes
10.12 Using global functions

WinCC Professional V13.0
6958 System Manual, 02/2014



Compatibility of WinCC versions, Runtime versions and device versions
The figure below shows the interaction of versions in the TIA Portal:

Creating projects 
After you create a new project in WinCC, open and edit it in the WinCC version in which you 
created it. 

Saving
To save a project of a predecessor WinCC version in this version again, save it in the usual 
way. If you manually upgrade the project to your WinCC version, please note that you will no 
longer be able to open the project in the previous WinCC version.

To save a project of the previous WinCC version in the current version, upgrade the project to 
your WinCC version. You can then no longer edit the project with a previous version of WinCC. 

Compiling, simulating and loading 
If you are using a project of a previous WinCC version, you can use your current version to 
generate Runtime data for this previous version. This also allows you to load HMI devices that 
are no longer compatible with your WinCC version. 

Copying within projects with different WinCC versions
If objects and configurations are also available in the target version, copy these as required 
via the clipboard or using drag-and-drop. 
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Opening, editing and saving projects of a previous WinCC version
You can open and edit projects of previous WinCC versions as required. In doing so, you only 
utilize the functions of the previous WinCC version. Once you have completed editing, you can 
once again save and edit the project in the previous WinCC version.

Compiling, downloading and simulating projects of a previous WinCC version
You can compile, download and simulate projects of previous WinCC versions as required. 
Your current WinCC version will provide the Runtimes and device versions for the 
corresponding WinCC version.

10.12.9.2 Basic information on version compatibility

Introduction
You have the following options for editing existing projects in WinCC:

Edit existing projects as follows with WinCC: 

● You edit, compile and download existing projects with the range of functions of the previous 
version of WinCC. You can continue to edit these projects afterwards with the previous 
version of WinCC. 
You can save these projects with your WinCC version in the predecessor version, but not 
compile or load them. To do this, you have to use the corresponding WinCC predecessor 
version on your configuration PC or upgrade the project to your WinCC version.

● You upgrade existing projects and use the functions of the current WinCC version.
 

  Note
WinCC functions

While editing a project of a previous WinCC version, you can only access the functions 
and HMI devices of this previous WinCC version.

 

Versions in WinCC
In WinCC, you work with different version types: 

● WinCC version
The WinCC version installed on the configuration PC, for example, WinCC V12.

● Project version
Projects are created using the WinCC version that is installed on the configuration PC. 
While you are editing a WinCC project from a previous version in the current WinCC version, 
the version ID is displayed behind the project name in the project tree. 

● Runtime version
The Runtime project is generated for a specific Runtime version, depending on the version 
of the project. The device version must match the Runtime version.
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Compatibility of WinCC versions, Runtime versions and device versions
The figure below shows the interaction of versions in the TIA Portal:

Creating projects 
When you create a new project in WinCC, open and edit it with the WinCC version with which 
you created it, or with a higher version.

Saving
To save a project of a predecessor WinCC version in this version again, save it in the usual 
way. Only after you have manually upgraded the project to your WinCC version will it no longer 
be possible for you to open the project in the predecessor version.

To save a project of the previous WinCC version in the current version, upgrade the project to 
your WinCC version.

Compiling, simulating and loading 
You can only compile, simulate and load a project of a WinCC predecessor version in the 
current WinCC version if you upgrade the project to your WinCC version.

To compile, simulate and load the project of a WinCC predecessor version for the 
corresponding Runtime version, use the appropriate WinCC version on your configuration PC.

Copying within projects with different WinCC versions
If objects and configurations are also available in the target version, copy these as required 
via the clipboard or using drag-and-drop. 
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Opening, editing and saving projects of a previous WinCC version
You can open and edit projects of previous WinCC versions as required. In doing so, you only 
utilize the functions of the previous WinCC version. Once you have completed editing, you can 
once again save and edit the project in the previous WinCC version.

10.12.9.3 Upgrading projects

Introduction
If the project version is older than the WinCC version, the version ID is displayed in the project 
navigation. Your WinCC version also contains the previous version that you can use to edit 
projects as required. In order to use the functions and options of your WinCC version in a 
project, upgrade the project to your WinCC version. Then, change your device or runtime 
version(s) in accordance with the new project version. 

 

 Note
WinCC version compatibility

If you upgrade a project to your WinCC version, please note that you will no longer be able 
to edit it with the previous WinCC version.

 

Requirements
● The project version is a predecessor of your WinCC version.

● You have write access to your project drive.

● The project drive provides sufficient storage capacity for another project of this size.

Procedure
Proceed as follows to upgrade a project to your WinCC version:

1. Select the project in the project navigation.

2. Select the "Upgrade project" command from the shortcut menu of the project.
A dialog opens. 

3. Click "Confirm".
The project closes and the progress bar is displayed.

An alarm is output when the project has been upgraded.
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Result
● The project has been saved on the project drive in the previous WinCC version and with 

the corresponding file extension.

● The project is displayed on the project drive in the current WinCC version and with the 
corresponding file extension.

● The project is displayed without a WinCC version ID in the project navigation.

To make use of the functions of the new WinCC version, change your device or runtime 
version(s) in accordance with the new project version in the next step. 

See also
Changing the device version (Page 6969)

10.12.9.4 Upgrading a global library

Introduction
In order to process objects of a global library in a project, the global library must be available 
in the product version of the project. You can upgrade each global library from an older product 
version to the current product version. You are prompted accordingly when you open the global 
library.

Requirements
● The version of the global library is a predecessor of your WinCC version.

● You have write access to your project drive.

● All types in the library have been released.
 

 Note
Upgrading a user library 

If you want to use a user library from an earlier version of WinCC, you must upgrade it. Make 
sure that all types of the library have been released. The library being upgraded cannot 
contain a type with the "in progress" status.

 

Procedure
Proceed as follows to upgrade a global library from TIA Portal V12.x or lower:

1. Open the global library.
The "Upgrade global library" dialog box opens.

2. Click "OK".

A copy of the global library is created and upgraded. The copy of the global library receives 
the name extension "_V13". The global library opens.
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Result
The global library is stored with the appropriate file extension. 

See also
Basic information on version compatibility (Page 6960)

Managing libraries (Page 6811)

10.12.9.5 Editing projects of a previous WinCC version

Introduction
WinCC provides the option of editing projects of a previous WinCC version. While editing a 
project of a previous WinCC version, you can only access the functions of this version. In order 
to use the functions of your current WinCC version for this project, upgrade the project to your 
WinCC version.

 

 Note

If you upgrade a project to your WinCC version, please note that you will no longer be able 
to open and edit the project in the previous WinCC version.

 

Requirement
● A project of a previous WinCC version has been created.

● The current WinCC version is installed on the configuration PC.

Procedure
Proceed as follows to edit a project of a previous WinCC version:

1. Open the project.

2. Edit the project using the functions of the previous WinCC version.

3. Save the project.

4. Compile the project.

5. Download and simulate the project.

6. You can open the project in the previous WinCC version for further editing, if required.

Result
The modified project data can be edited further on a different configuration PC with the previous 
WinCC version for further processing. The Runtime project was generated and downloaded 
in the corresponding Runtime version.
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10.12.9.6 Editing a project of a WinCC predecessor version

Introduction
Your WinCC version provides the option of editing projects for a predecessor version without 
compiling, loading or simulating these projects.

While you are editing a project in a predecessor WinCC version, WinCC shows only the 
functions that are available in this predecessor version. 

To use all the functions of your WinCC version for this project, upgrade the project to your 
WinCC version.

To compile, simulate and load the project with your WinCC version, upgrade the project to 
your WinCC version. You then compile the project in the Runtime of your WinCC version.

 

 Note

If you upgrade the project to your WinCC version, you can no longer open or edit it in the 
predecessor WinCC version.

 

 Note

Note the compatibility of HMI device version and Runtime version.
 

Requirement
● A project from a predecessor WinCC version has been created.

● The current WinCC version is installed on the configuration PC.

Procedure
To edit a project for a predecessor WinCC version, follow these steps:

● Open the project.

● Edit the project with the functions of the predecessor WinCC version.

● Save the project.

● Open the project as required with the predecessor WinCC version and continue to edit it 
there.

Result
The changed project data can be further edited, compiled, loaded and simulated on another 
configuration PC with the predecessor WinCC version. 
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10.12.9.7 Changing between device versions

Selection of the device version
When you configure a new HMI device, WinCC automatically selects the latest version of the 
device.     

If you want to use a device version other than the one set in WinCC, transfer an image to the 
HMI device. WinCC provides the images required for the supported HMI devices.

Information on the device versions used in WinCC is available in the FAQs on the Internet, 
entry ID 21742389. 

 

 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, you 
should save existing Runtime data before changing the device version.

 

HMI device configuration
The following figure shows the software components of an HMI device:
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10.12.9.8 Changing the device version

Introduction
Depending on the required Runtime version, select the suitable device version for your 
configuration.

 

 Note
Selection of device versions

The selection of available devices versions depends on the version of the project.
 

Requirements
● A project has been created and opened.

● The project contains an HMI device.

Procedure
To change the device version, follow these steps:

1. Double-click on "Devices & Networks" in the project tree.
The editor opens.

2. Select the required HMI device from the device view.

3. Select "Change Device/Version" in the device shortcut menu of the HMI device.
A dialog opens.

4. Select the required HMI device.

5. Select the required device version under "Version".

6. Confirm your selection with "OK".

Result
You have changed the device version in the WinCC project.

 

 NOTICE

Changing the device version deletes all data on the HMI device.

All data is deleted from the HMI device when you change the device version and compile/
download the project. You should therefore backup your Runtime data prior to the download.
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10.12.10 Viewing memory card data

10.12.10.
1

Basics

Introduction
WinCC provides you with the possibility of viewing data stored on your memory card. The 
function supports the use of memory cards of the HMI device and of the CPU. 

You have the following options:

Viewing a backup (Page 6970)

Renaming and deleting backups (Page 6972)

Viewing HMI device images (Page 6973)

Deleting HMI device images (Page 6974)

Creating HMI device images on memory card (Page 6975)

See also
Viewing a backup (Page 6970)

Renaming and deleting backups (Page 6972)

Viewing HMI device images (Page 6973)

Deleting HMI device images (Page 6974)

Creating HMI device images on memory card (Page 6975)

10.12.10.
2

Working with backups

Viewing a backup

Introduction
The backup of a Basic Panel that is stored on a memory card can also be viewed in the TIA 
Portal.     

Requirements
● WinCC is installed.

● A memory card with a backup is available.

● The card reader is connected to the configuration PC.

● The project view is open.
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Backup on the memory card in the card reader
1. Insert the memory card into the card reader.

2. Open "SIMATIC Card Reader" in the project navigation.

3. Select the card reader drive.
The "Online Card Data" folder is displayed.

4. Open the "Online Card Data" folder

5. Click the backup to open the shortcut menu.

6. Select "Properties".

Backup on the memory card of the PLC
Proceed as follows if the backup is stored on the memory card of the PLC:

1. Connect the PLC with the configuration PC.

2. Click on the PLC in the project navigation.

3. Select "Connect online" from the shortcut menu.
A connection to the PLC is established. 
Once the PLC is connected, the "Online Card Data" folder is displayed.

4. Open the "Online Card Data" folder.
 

  Note
Accessing a password-protected PLC

When you attempt to access a PLC that is protected by a password, you will be prompted 
to enter the password.

You need at least read access rights in order to view the data that is stored on the memory 
card.

 

5. Click the backup to open the shortcut menu.

6. Select "Properties".

Result
The backup properties are displayed in a separate dialog.
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See also
Renaming and deleting backups (Page 6972)

Basics (Page 6968)

Renaming and deleting backups

Introduction
You may rename and delete backups from a memory card in the project navigation of the TIA 
Portal.         

Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.
The PLC is connected online with the configuration PC.

● A memory card with a backup is available.

● The project view is open.

● The backup is displayed in the project navigation.
 

  Note
Accessing a password-protected PLC

When you attempt to access a PLC that is protected by a password, you will be prompted 
to enter the password.

You need write access rights to rename or delete memory card data.
 

Procedure
1. Click on the backup in the project navigation.

2. Open the shortcut menu.

3. Select "Rename" to rename the file.

4. Enter a new name.

5. Select "Delete" to delete the file.

Result
The backup file is now renamed or deleted. 
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See also
Viewing a backup (Page 6968)

Basics (Page 6968)

10.12.10.
3

Working with HMI device images

Viewing HMI device images

Introduction
The HMI device image of a Comfort Panel that is stored on a memory card can be viewed in 
the TIA Portal.

Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.

● A memory card with the HMI device image is available.

● The project view is open.

Procedure 
1. Insert the memory card into the card reader.

2. Open "SIMATIC Card Reader" in the project navigation.

3. Select the card reader drive.
The "Online Card Data" dialog is displayed.

4. Open the "Online Card Data" folder.
The available images of the HMI device are displayed in additional folders.

5. Click the required HMI device image.

6. Select "Properties" in the shortcut menu.
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Result
The properties of the HMI device image are displayed in a separate dialog.

See also
Deleting HMI device images (Page 6974)

Creating HMI device images on memory card (Page 6975)

Basics (Page 6968)

Deleting HMI device images

Introduction
You may delete the HMI device image of a Comfort Panel from a memory card in the project 
navigation of the TIA Portal.    
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Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.

● A memory card with an HMI device image is available.

● The project view is open.

● The HMI device image is displayed in the project navigation.

Procedure
1. Click the HMI device image in the project navigation.

2. Open the shortcut menu.

3. Select "Delete" to delete the file.

Result
The HMI device image is deleted. 

See also
Viewing HMI device images (Page 6971)

Basics (Page 6968)

Creating HMI device images on memory card

Introduction
You may edit the HMI device image of a Comfort Panel without connecting the Comfort Panel 
to the configuration PC.

Simply create the HMI device image on an external memory card or USB stick and then transfer 
it from there to the Comfort Panel. 

Requirements
● WinCC is installed.

● The card reader is connected to the configuration PC.

● The project view is open.

Procedure 
1. Insert the memory card into the card reader.

2. Click on the memory card in the project navigation.

3. Open the shortcut menu.
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4. Select "Create HMI OS image on memory card".
A dialog opens.
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5. Select an HMI device image.

6. Select the settings for the restoration.

– Activate "Retain installed settings of the Control Panel"
The settings you have made on the Comfort Panel are retained. 

– Activate "Retain installed licenses":
The licenses on the Panel are retained.

– Activate "Lock settings on the Panel"
You can no longer change the selected settings for "Retain installed settings of the 
Control Panel" and "Retain installed licenses" on the Comfort Panel.

Result
You have created an HMI device images on memory card. You may use a USB stick instead 
of a memory card. 

See also
Viewing HMI device images (Page 6971)

Basics (Page 6968)

10.13 Compiling and loading

10.13.1 Compiling, downloading and simulating projects

10.13.1.1 Overview of compiling and loading projects

Overview     
The project is compiled in the background even as you are configuring it in WinCC. This 
reduces the time for final compilation. When you start compilation, you create a file that can 
be run on the corresponding HMI device. 

If an error occurs during compilation, WinCC provides support in locating and correcting it.

Once you have corrected any problems, you download the compiled project to the HMI devices 
on which the project is to run. If the configuration PC is not connected to the HMI device, save 
the compiled project on a data medium of your choice. The compiled project is then transferred 
from a PC connected to the HMI device to the HMI device. 

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device.
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Project
The term "project" has two different meanings in the contexts of compilation and loading. 
"Project" is the WinCC project on the configuration PC. "Project" is also the Runtime project 
you create by compiling the configuration data of an HMI device and download to the HMI 
device. 

● WinCC project: contains the configuration data of one or more HMI devices

● Runtime project: contains the compiled configuration data of an HMI device

The figure below illustrates the link between WinCC projects and Runtime projects using the 
example of the "Compile and load" process:

Runtime
Runtime is the software for process visualization. In Runtime, you execute the project in 
process mode. 

A distinction is made between two types of Runtime:

1. Runtime on a panel
Before running a Runtime project on a panel, you have to transfer the Runtime project to 
the panel before startup.

2. Runtime on a PC
You can execute the Runtime project directly on the configuration PC if Runtime has been 
installed on the configuration PC. 
If you want to execute the Runtime project on a different PC, you have to transfer the 
Runtime project to the PC before startup.

Runtime version
The Runtime version depends on the image of the configured HMI device. The Runtime version 
of the compiled project is displayed under "Info" in the Inspector window.
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Simulation
You test your configuration with a simulation. You can start a simulation without a link to the 
active process.

In a simulation, you test configured tags or screen changes, for example. During the simulation, 
the configured tags can be manipulated, activated and deactivated with the help of the tag 
simulator. 

There are two types of simulation:

1. Simulating a panel
If you created a panel in your project, the panel is displayed in the simulation. With the help 
of this type of simulation, you can test your configuration on the HMI device without 
transferring the project to the panel.

2. Simulating Runtime
Simulating Runtime allows you to test the project directly on the configuration PC. 

10.13.1.2 Compiling a project

Introduction     
The changes made to the project are compiled in the background even as you are configuring 
a project in WinCC. Projects are compiled automatically when you load them. This ensures 
that the latest version of the project is loaded at all times.

WinCC checks consistency of the project during compilation. The error locations in the project 
are listed in the Inspector window. You can jump directly to the source of the error from the 
entry in the Inspector window. Check and correct errors found.

Scope of the compilation
Configuration data is compiled in the background as soon as you start configuring an HMI 
device. If you compile a project manually, only the changes in the configuration made since 
the last compilation process are compiled in the background. 

You can start complete project compilation manually at any time; this may, for example, be 
done to test the consistency of the configured data.
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Requirement
● A project is open.

Procedure
Proceed as follows to compile a project:

1. If you want to compile several HMI devices at the same time, select all the relevant HMI 
devices with multiple selection in the project tree.

2. Compile the project:

– To only compile changes in the project, select the "Compile > Software (only changes)" 
command from the shortcut menu of the HMI device.

– To compile all project data, select the "Compile > Software (compile all)" command from 
the shortcut menu.

Result
The configuration data of all selected HMI devices is compiled. Any errors that occur during 
compilation are shown in the Inspector window. 

10.13.1.3 Loading projects

Overview for loading of projects

Overview
Delta data of the project is automatically compiled before you download it to one or several 
HMI devices. This always ensures that the latest version of the project is transferred. 
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Loading a project to an HMI device   
The following steps are completed prior to downloading:

1. The download settings are verified. The "Extended download to device" dialog box opens 
automatically during the initial download of a project to an HMI device. You use this dialog 
to define the protocol and interface or destination path for the project in accordance with 
the HMI device Runtime used.
If the HMI device is part of a subnet, for example, you also select the subnet and the first 
gateway.
You can open the "Extended download to device" dialog at any time with the menu 
command "Online > Advanced download to device...". 
The "Load preview" dialog opens. 

2. The project is compiled. Warnings and errors during compilation are displayed in the 
Inspector window and in the "Load preview" dialog.

3. The "Load preview" dialog shows you the following information for each HMI device:

– The individual steps for loading

– If the device version of the target HMI device does not match the configured device 
version, you are queried if you want to change the device version at this time. 
As long as the project with the selected device version of the target HMI device is not 
executable, you cannot start the download. 

 

 
 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, 
you should first back up the following data:
● User administration
● Recipes
● Licenses

Resetting to factory settings also deletes the license keys. Back up the license keys 
before you reset the system to factory settings.

With Comfort devices, the licenses can only be deleted when resetting to factory 
settings. Back up the licenses and license keys before you reset the system to factory 
settings.

 

– Presettings that take effect at loading. You can change the default settings for this 
download process, if necessary.

– Warning events (optional). You can download a project while ignoring the "warnings". 
The functionality may be restricted in runtime.

– Error events (optional). You cannot load the project. Eliminate the errors and then reload 
the project.
WinCC will open the invalid configuration in the corresponding editor if you double-click 
the error message in the Inspector window. Correct the errors and reload the project.

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device. 
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 Note

If the transfer is interrupted, WinCC V13 automatically ensures that no data is lost and that 
existing data is deleted on the HMI device only after complete transmission. 

 

Loading a project without a connected HMI device   
If you cannot establish a direct connection from the configuration PC to the HMI device, save 
the compiled project on a data medium of your choice. Additional steps depend on the Runtime 
used:

● Panel Runtime: Copy the compiled project to a PC connected to the HMI device, for 
example, via a network. Download the project from this PC to the HMI device ("Pack&Go").

● Runtime Advanced: Move the compiled project to the HMI device.

Loading with S7 routing
Configure the S7 routing settings in the "Devices & Networks" editor in the relevant PLC. The 
settings depend on the device configured. 

S7 routing supports the following protocols:

● MPI/PROFIBUS

● PN/IE

Transferring Runtime add-ons in WinCC V13
Projects can contain Runtime add-ons in the form of controls or CSP (Communication Support 
Packages). These Runtime add-ons are automatically transferred with the project.  

See also
Downloading the project to an HMI device (Page 7009)

Generating a "Pack&Go" file (Page 6988)

Starting Runtime Advanced and Panels (Page 6995)

Loading a project

Introduction
Before a project can run on an HMI device, you must first load it to the HMI device. During 
loading, you must most importantly specify whether existing data on the HMI device such as 
"user administration" and "recipe data" is to be overwritten. 

If the HMI device supports PROFINET, the name registered in the project tree is used for the 
PROFINET communication. The use of the name corresponds to the default settings of the 
PROFINET interface of the HMI device. For devices with more than one PROFINET interface, 
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the name of the IE CP is automatically added to the device name with a separating period. 
The name is written during download to the HMI device. If a device name for the PROFINET 
communication has already been entered in the HMI device, it will be overwritten.

You can find additional information about these settings in the information system in the 
"Assigning a device name and IP address" section.

As a general rule, only one project can be active in Runtime on an HMI device. An HMI device 
is generally configured to exit Runtime automatically when loading is started. If this is not the 
case, you will have to exit Runtime manually on the HMI device. 

You can alternatively enable the "Remote" option in the transfer settings in the control panel 
of the HMI device. This will then allow you to load a project to the HMI device without first 
having to set the transfer mode manually on the HMI device. For Mobile Panels, the "Remote" 
option is disabled for security reasons. 

If the device version of the target HMI device does not match the configured device version, 
you are asked whether you wish to change the device version at this time.

 

 Note

If your HMI device is a PC, the device version of the target system is not automatically updated 
during the download. 

Verify that the configured device version corresponds to the one of the target HMI device 
before you compile and download your project. If necessary, install the matching Runtime 
version on your HMI device or change the device version manually using the properties of 
the HMI device.

 

 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, you 
should first back up the following data:
● User administration
● Recipes
● Licenses

Resetting to factory settings also deletes the license keys. Back up the license keys before 
you reset the system to factory settings.

With Comfort devices, the licenses can only be deleted when resetting to factory settings. 
Back up the licenses and license keys before you reset the system to factory settings.
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Please refer to the documentation for the HMI device used for more detailed information on 
transfer settings. 

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.

 

 Note
Transfer to an HMI device with WinAC MP

The "PN/IE" channel is not approved for the project transfer on HMI devices with WinAC MP.

Use the "Ethernet" channel instead of "PN/IE" to transfer data to an HMI device that is running 
PLC WinAC MP.

 

Requirement
● You have created an HMI device in the project.

● The HMI device is connected to the configuration PC.

● Transfer mode is set in the HMI device.

Procedure
Proceed as follows to load a project:

1. To download a project simultaneously to several HMI devices, select the HMI devices by 
means of multiple selection in the project tree.

2. Select the "Download to device > Software" command from the shortcut menu of the HMI 
device.
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3. If the "Extended loading" dialog is open, configure the "Settings for loading". Make sure 
that the "Settings for loading" correspond to the "Transfer settings in the HMI device".

– Select the protocol used, for example, Ethernet or HTTP.

– Configure the relevant interface parameters on the configuration PC.

– Make any interface-specific or protocol-specific settings required in the HMI device.

– Click "Download".

You can open the "Extended download to device" dialog at any time with the menu 
command "Online > Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result is 
displayed in the "Load preview" dialog.

4. Check the displayed presettings and change them as necessary.

5. Click "Download".

Result
The project is loaded to all selected HMI devices. In WinCC V13, the project with the Runtime 
add-ons is loaded to the selected HMI devices. 

During the download, you can keep track of the files that are transferred. 

If errors or warnings occur during the download, corresponding alarms are displayed under 
"Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.
 

 Note

If the transfer is interrupted, WinCC V13 automatically ensures that no data is lost and that 
existing data is deleted on the HMI device only after complete transmission. 

 

See also
Starting Runtime on the configuration PC (Page 6994)

Starting Runtime Advanced and Panels (Page 6995)

Starting Runtime Professional (Page 7017)

Updating the operating system on the HMI device (Page 7032)

Loading projects to a file

Introduction
Load the Runtime project to the file system of your PC if that is your HMI device. Double-click 
the Runtime project to open it in runtime. 

During loading, you must most importantly specify whether existing data on the HMI device 
such as "user administration" and "recipe data" is to be overwritten. 
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If the HMI device supports PROFINET, the name registered in the project tree is used for the 
PROFINET communication. The use of the name corresponds to the default settings of the 
PROFINET interface of the HMI device. For devices with more than one PROFINET interface, 
the name of the IE CP is automatically added to the device name with a separating period. 
The name is written during download to the HMI device. If a device name for the PROFINET 
communication has already been entered in the HMI device, it will be overwritten.

You can find additional information about these settings in the information system in the 
"Assigning a device name and IP address" section.

As a general rule, only one project can be active in Runtime on an HMI device. An HMI device 
is generally configured to exit Runtime automatically when loading is started. If this is not the 
case, you will have to exit Runtime manually on the HMI device. 

You can alternatively enable the "Remote" option in the transfer settings in the control panel 
of the HMI device. This will then allow you to load a project to the HMI device without first 
having to set the transfer mode manually on the HMI device. 

 

 Note
Device version

If the device version of the target HMI device does not correspond to that of the configured 
device version, Runtime cannot be started after loading.

Verify that the device version of the target HMI device conforms to your configuration before 
you compile and download your project. 

If necessary, change the device version manually via the properties of the HMI device.
 

 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. It is therefore advisable 
to generate a backup copy of the Runtime data prior to such actions.

 

Please refer to the documentation for the HMI device used for more detailed information on 
transfer settings. 

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.
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Requirement
● You have created an HMI device in the project.

● The HMI device is a PC.

● The HMI device is connected to the configuration PC.

● Transfer mode is set in the HMI device.

Procedure     
Proceed as follows to load a project to a file:

1. Select the project in the project tree.

2. Select the "Download to device > Software" command from the shortcut menu of an HMI 
device.

3. If the "Extended loading" dialog is open, configure the "Settings for loading". Make sure 
that the "Settings for loading" correspond to the "Transfer settings in the HMI device".

– Select the "Type of the PG/PC interface > File" dialog,

– Select "PG/PC interface > File system" in the dialog,

– Select the file system path under "destination path".

– Click "Download".
You can open the "Extended download" dialog at any time with the menu command 
"Online > Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result 
is displayed in the "Load preview" dialog. 

4. Check the displayed presettings and change them as necessary.

5. Decide whether to overwrite user administration data and/or recipe data on the HMI device. 

6. Click "Download".

Result
The Runtime is loaded to the file system. If errors or warnings occur during the download, 
corresponding alarms are displayed under "Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.

Double-click the Runtime project file on the target system to launch the Runtime project. 
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Generating a "Pack&Go" file

Introduction
Create a "Pack&Go" file if you cannot connect the HMI device to the configuration PC. The 
"Pack&Go" file is a ZIP file containing the following data:

● The compiled project

● A program for transferring the project to the HMI device

● Image for the configured HMI device

Typical example of an application: An engineering company creates a project variant for a new 
HMI device. The project engineer of the engineering company does not have direct access to 
the plant. The project engineer therefore e-mails the "Pack&Go" file to his local contact. The 
contact unpacks the "Pack&Go" file on a PC connected to the HMI device via a network. He 
then transfers the project from the PC to the HMI device.

Requirement
● You have created an HMI device in the project.

Procedure         
To create a "Pack&Go" file, follow these steps:

1. Select the HMI device in the project tree.

2. Select the "Pack&Go" command from the menu under "Online > HMI Device maintenance".

3. The "Create Pack&Go file" opens.

4. Verify that the displayed device version corresponds with that of the target HMI device.

5. Select a protocol as transfer mode.

6. Select the storage location under "Pack&Go file" and enter the file name.

7. If necessary, specify if the "Pack&Go" file is split into several files.

8. Click "Create".
 

 Note

To unzip a "Pack&Go" file which is distributed over several files, you need a compression 
program. The compression program integrated into the operating system is not adequate to 
unzip distributed files.

 

Result
The "Pack&Go" file is created and saved to the specified folder in the file system. Now copy 
the "Pack&Go" file to the PC connected to the HMI device.
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Downloading projects from a "Pack&Go" file to the HMI device

Requirement
● .NET Framework with version 4.5

● ProSave is installed on the PC

● The "Pack&Go" file has been stored in the file system of a PC.

● The PC is connected to the HMI device.

● The device version of the HMI device is consistent with the device version in the project
 

 Note

To unzip a "Pack&Go" file which is distributed over several files, you need a compression 
program. The compression program integrated into the operating system is not adequate to 
unzip distributed files.

 

 Note

If the TIA Portal is not installed on your PC, install Microsoft Visual C++ 2010 Redisitributable 
Package (x86) and .Net Framework 4.5 in order to run the Pack&Go application. 
● You can find the Microsoft Visual C++ 2010 Redistributable Package (x86) in the 

Download Center of Microsoft at the following URL:
http://www.microsoft.com/en-us/download/details.aspx?id=5555

● You can find .Net Framework 4.5 at the following URL: 
http://www.microsoft.com/en-us/download/details.aspx?id=30653

 

Procedure     
To download the project from a "Pack&Go" file to an HMI device, follow these steps:

1. Unpack the "Pack&Go" file to a folder of your choice in the file system of the PC.

2. From the "PackNGo" subfolder of this directory, run "Siemens.Simatic.Hmi.PackNgo.exe".
The "Pack'n Go" dialog opens. The settings for loading are set by default. Exception: You 
must select the target device if you are using an S7 USB connection.

3. Adjust the settings for loading appropriately if they differ from the interfaces or protocols 
available on the PC.

4. Specify whether or not to overwrite the user management and recipe data already stored 
on the HMI device.

5. Click "Transfer".

Result
The connection to the HMI device is set up via the selected path. An alarm is output if the 
device version used in the project differs from that of HMI device. 
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If this is the case, update the operating system on the HMI device. To update the operating 
system on the HMI device, you need ProSave. A prompt for operating system update will 
appear automatically if ProSave has been installed and the selected connection supports the 
update of the operating system.

Loading via USB interface

Introduction
When you load a project via a USB port, connect the configuration PC and the HMI device 
with a USB cable.

Requirements for transfer via USB
The following conditions must be met to ensure successful data transfer using a USB port:     

● Use a USB host-to-host cable, USB 2.0 standard.

● You have installed the provided USB driver.
You can find the driver on the WinCC Product DVD under "Support\DeviceDriver\USB".

● The HMI device being used is based on Windows CE and has a USB port.

You can find more information on the cables used and the manufacturers/suppliers in the 
Internet at:

● http://support.automation.siemens.com (http://support.automation.siemens.com/WW/
view/en/19142034)

 

  Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the 
WinCC Product DVD.

 

  Note
Comfort HMI devices

Use the mini USB port to load projects via USB with Comfort HMI devices. This driver is 
installed automatically. 

 

Restrictions
A project can always be transferred to an HMI device. Simultaneous transfer to several HMI 
devices is not possible. 
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Installing a USB driver in Windows XP

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.           

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note

Comfort HMI devices

Use the mini USB port to load projects via USB with Comfort HMI devices. This driver is 
installed automatically.   

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB port.

Procedure
To install the USB driver under Windows XP, follow these steps:

1. Connect the USB host-to-host cable to the USB port of the configuration PC.
The USB cable is automatically detected by the hardware detection under Windows XP. 
The driver installation wizard starts automatically.

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. If you are prompted with "Can Windows connect to Windows Update to search for software", 
select "No, not this time" and click "Next".

3. Select "Install software from a list or specific source" and click "Next".

4. Select "Search removable media".

5. Insert the WinCC product DVD into the DVD drive and click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable. 
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows XP.
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6. Check the selection and click "Next".
 

  Note

The "Hardware installation" dialog box indicates that the software found has not passed 
Windows Logo testing. The Logo test does not have any effects on the functioning of the 
USB driver. Continue with the installation.

 

7. Click "Hardware Installation > Continue installation".
The driver is installed.

8. Click "Finish".
The installation is complete.

Result
The driver for the USB host-to-host cable has been installed. To load the project, connect the 
HMI device to the USB cable.

Installing a USB driver in Windows 7

Introduction
To load a project via the USB port, install the USB drivers provided on the WinCC product 
DVD.         

 

 Note
Driver installation

To avoid problems when transferring projects, only use the USB driver provided on the WinCC 
product DVD.

 

 Note
Comfort HMI devices

Use the mini USB port to load projects via USB with Comfort HMI devices. This driver is 
installed automatically.

 

Requirement
● The WinCC product DVD is available.

● You are using a USB host-to-host cable, USB 2.0 standard.

● The HMI device has a USB port.
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Procedure
To install the USB driver under Windows 7, follow these steps:

1. Connect the USB host-to-host cable to the PC's USB port.
The USB cable is detected, but the wizard for the driver installation does not find the driver. 

 

  Note

Connect the HMI device only when the driver has been completely installed on the PC.
 

2. Open the Device Manager in the Control Panel.

3. Select "Other devices > USB host-to-host cable".

4. Select "USB host-to-host cable" and then select "Update driver software..." in the shortcut 
menu.

5. When the "How do you want to search for driver software?" prompt appears, select "Search 
for driver software on the computer".

6. Click "Update driver software > Browse...".

7. Insert the WinCC product DVD as the source for driver installation.

8. Select "Include subfolders" and then click "Next".
The system will search the WinCC product DVD for the corresponding driver for the USB 
host-to-host cable.
The drivers available on the WinCC product DVD are displayed. The wizard highlights the 
appropriate driver for Windows 7. 

9. Check the selection and click "Next".

10.To continue with the installation, click "Hardware Installation > Continue installation".
The driver is installed.

11.Click "Finish".
The installation is complete.

Result
The driver required for the USB host-to-host cable has been installed. To load the project, now 
connect the HMI device to the USB cable.
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10.13.1.4 Starting Runtime

Starting Runtime on the configuration PC

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. The 
project settings defined in the "Runtime settings" of the HMI device are activated when the 
project is started in Runtime.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.

Procedure         
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 
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Starting Runtime Advanced and Panels

Introduction
You can start the project in Runtime as soon as you have downloaded the project to the HMI 
device. The project is generally started automatically on the HMI device. 

There may be several projects in the file system of the HMI device for HMI devices with Runtime 
Advanced. You can start one of these projects in Runtime. 

The project settings defined in the "Runtime settings" of the HMI device are activated when 
the project is started in Runtime. Make sure when defining the Runtime settings "Lock task 
switching" and "Full screen" that you will be able to stop Runtime again. You can, for example, 
configure a button with the system function "StopRuntime".

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● WinCC Runtime Advanced or Panels is installed on the HMI device.

● The project was downloaded to the HMI device

Starting Runtime on a PC     
The compiled project is saved in the PC file system with the extension "*.fwc" and is freely 
accessible.

1. To start the project once the HMI device has booted up, enter the automatic start of a project 
file under "Settings" in the "RT Loader" ("HmiLoad.exe").
You can also create a link to the project file in the Windows Autostart directory.

Starting Runtime on a panel     
The project will be stored on a panel in a folder you specify in the HMI device transfer settings. 
The "RT Loader" application is started on a panel. The project loaded is started automatically 
after expiration of the configured delay.

If the project does not start automatically:
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1. Click on "Start" to start the loaded project.

Refer to the documentation for the HMI device for additional information on startup of projects. 

Result
Runtime is started on the HMI device. 

10.13.1.5 Simulating projects

Simulation

Simulation basics

Introduction
You can use the simulator to test the performance of your configuration on the configuration 
PC. This allows you to quickly locate any logical configuration errors before productive 
operation. 

You can start the simulator as follows:

● In the shortcut menu of the HMI device or in a screen: "Start simulation"

● Menu command "Online > Simulation > [Start|With tag simulator|With script debugger]"

● Under "Visualization > Simulate device" in the portal view.

Requirement
The simulation/runtime component is installed on the configuration PC. 

Field of application
You can use the simulator to test the following functions of the HMI system, for example:

● Checking limit levels and alarm outputs

● Consistency of interrupts

● Configured interrupt simulation

● Configured warnings

● Configured error messages

● Check of status displays
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WinCC Runtime Advanced simulation

Introduction
There are two different simulation modes for Runtime Advanced simulation:

● Device simulation

● Tag simulation

Both types of simulation simulate the project without a direct process link to the configuration 
PC. Data such as logs or recipes generated during simulation are not deleted. This data is 
saved on the configuration PC in the paths configured in the project. 

Device simulation
Use device simulation to simulate operator control of the HMI device. Device simulation is, for 
example, used to test screen switching. 

Tag simulation
Use tag simulation to simulate the configured process tags. You can either have tag values 
generated automatically by a simulation table or define tag values yourself. 

Simulating a project

Introduction
You simulate your project with one of the following two methods:

● Without a connected PLC
You change the value of area pointers and tags in a tag simulator that is read for the 
simulation of WinCC Runtime.

● With a connected PLC without a running process
You simulate your project by running it directly in Runtime. The tags and area pointers 
become active. This allows you to create an authentic simulation of your configured HMI 
device in Runtime. 

 

  Note
Simulation restrictions

You cannot simulate the following system functions:
● CalibrateTouchScreen

You cannot simulate the Media Player. A static screen appears in the simulation window 
instead of the Media Player.

File access via scripts is not possible for HMI devices with Windows CE.
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Requirement
● Simulation without a connected PLC: Tags have been created

● Simulation with a connected PLC but no active process: A project with tags and area 
pointers has been created

Procedure     
To simulate a project using the tag simulator, follow these steps:

1. Open the project on the configuration PC.

2. Select the "Online > Simulation > With tag simulator" menu command.
For initial project simulation, the simulator is started with a new, empty table. The project 
is opened simultaneously in Runtime. 
Toggle between the tag simulator and Runtime using the <Alt +Tab> key combination.

3. To simulate a process value, select the corresponding "tag" from the tag simulator.
The table lists all configured tags. You can simulate up to 300 tags simultaneously. 

4. Select the simulation mode in the "Simulation" column.

5. Change the value of tags and area pointers in the respective columns.

6. Activate the "Start" check box to start the simulation for this tag.

7. To save the simulation, select the menu command "File > Save" and enter a descriptive 
name, for example, "Mixing".
The file name is assigned the extension "*.cors". 

Result
The process values are simulated in Runtime. The tag values are created at random, or 
incremented, depending on the simulation mode. 

To specify tag values, change the simulation mode to "<Display>" and enter a value at "Set 
value". 

The following figure shows a tag simulator with four tags whose values can be determined at 
random in a range of values from 10 to 1000:
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Managing simulation data
If you have saved data from a previous simulation, you can open the file at a later point in time 
and simulate your project again. The tags and area pointers listed in the tag simulator must 
still be available in the project. 

Proceed as follows to open a simulation file: 

1. Select the menu command "Online > Simulate Runtime > With tag simulator".

2. Select the menu command "File > Open" in the tag simulator.

3. Select the corresponding simulation file and click "Open".
The simulator loads the stored data.

Enabling and disabling tags
Start and stop the simulation for each tag separately in order to facilitate the transition from 
offline to online engineering. Activate "Start" in the corresponding row.

If a tag is activated, the simulation values are calculated and transferred to the WinCC 
simulator.

Deleting a tag
To delete a tag from the tag simulator, follow these steps:

1. Select the cell that contains the tag name.

2. Select the "Edit > Cut" menu command.
The tag is removed from the table. 

Simulating a screen

Introduction
If you have only made changes to one screen, you can temporarily specify this screen as the 
start screen for simulation. In this way, you can debug changes without having to modify the 
start screen, or opening the screen on the HMI device. 

Requirements
You created a project that contains at least one screen. 

Procedure  
To define a screen as temporary start screen for simulation, follow these steps:

1. In the project navigation, select the image to display as the start screen in the simulation.

2. Select the "Start simulation" command from the shortcut menu of the screen.
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Result
Project simulation is started. Instead of the configured start screen, the simulation window the 
screen you selected in the project navigation. 

Working with the tag simulator

About the tag simulator
The tag simulator has the following columns:

Column Description
Tag Specifies the tags for the simulation. 
Data type Shows the data type of the selected tag.
Current value Shows the simulated value of the defined tags.
Format Specifies the selected format in which the tag values are simulated: 

● Decimal (1, 2, 3, 4, ...)
● Hexadecimal (03CE, 01F3, ...)
● Binary (0 and 1)

Write cycle Specifies the selected time interval at which the current tag values are simulated. If 
you enter "2", for example, the current value of the tag will be shown every 2 seconds.

Simulation Shows the method by which the tag values are processed during simulation. 
Set value Sets the selected value for the respective tag. The simulation start with the specified 

value.
minValue 
maxValue

Specifies the value range of the tag. You set a minimum and maximum value for this 
range. The default values are -32768 for the minimum and 32767 for the maximum.

Period Contains the period during which the value of the tag is repeated for the "Increment" 
and "Decrement" simulation modes.

Start Starts simulation of the tag based on the previously entered information.

Simulation modes
The simulator has six different simulation modes. The configured tags are supplied with nearly 
realistic values during the simulation. 

Simulation mode Description
Sinusoidal Changes the tag value to form a sinusoidal curve. The value is visualized as a 

periodic, non-linear function.
Random Provides randomly generated values. The tag value is changed by means of a 

random function.
Increment Increases the value of the tag continuously up to a specified maximum value. 

Begins again at the minimum after the maximum has been reached. The value 
trend corresponds to a positive saw-tooth curve.

Decrement Reduces the value of the tag continuously down to a specified minimum value. 
Begins again at the maximum after the minimum has been reached. The value 
curve corresponds to a negative saw-tooth curve.
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Simulation mode Description
Shift bit Shifts a set bit continuously by one position. The previous position is always reset. 

This lets you test the alarms of an HMI device, for example.
<Display> The current tag value is displayed statically.

Example: Simulate tags with the "Shift bit" simulation mode
Proceed as follows to simulate tags with the "Shift bit" simulation mode:

1. Open the project you want to simulate.

2. Select the menu command "Online > Simulate Runtime > With tag simulator".
The tag simulator opens.

3. In the "Tag" column, select a tag from your project.

4. Select "Bin" in the "Format" column.

5. Enter the value "1" in the "Write cycle" column.

6. Select the "Shift bit" simulation mode in the "Simulation" column.

7. Enter the value "1" in the "Set value" column.

8. Enable the tag with the "Start" check box.

Result
The simulator tests the selected tag bit-by-bit as follows:

Simulation values Byte for alarms
Set start value 00000001
1. Simulation value 00000010
2. Simulation value 00000100
3. Simulation value 00001000
.... ...

In Runtime you see if the desired alarm is output at a given value. 

Simulation restrictions

Alarms with dynamic parameters
If you use tags or text lists as external tags for alarms, the dynamic parameters of the alarms 
are not displayed.

Only internal tags are enabled for the simulation of alarms in the tag simulator .

You can use PLCSim to simulate dynamic parameters.
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Working with the debugger

Debugging scripts

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.   

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE".

 

Error types
The following error types are distinguished when debugging:      

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.
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Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

For tips and tricks on debugging, common sources of error, and further information, refer to 
the online help for the Microsoft Script Debugger.

 

Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 

Start debugger

Introduction
Select the "With script debugger" script mode to test scripts. The debugger allows you to set 
breakpoints in the code, for example, or implement a script step by step.

Requirements
● A debugger that supports VBS is installed on the Engineering Station, e.g. "MS Script 

Debugger".

● WinCC Runtime is installed on the Engineering Station.

● A project is open.

Procedure  
1. Select the "Online > Simulation > With script debugger" menu command.

The Runtime software searches for debuggers installed on the Engineering Station. 

2. If several debuggers are found, click on a selected.

Result
The debugger is connected automatically with the runtime software. 
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10.13.2 Compiling, downloading and simulating projects

10.13.2.1 Overview of compiling and loading projects

Overview     
The project is compiled in the background even as you are configuring it in WinCC. This 
reduces the time for final compilation. When you start compilation, you create a file that can 
be run on the corresponding HMI device. 

If an error occurs during compilation, WinCC provides support in locating and correcting it.

Once you have corrected any problems, you download the compiled project to the HMI devices 
on which the project is to run. If the configuration PC is not connected to the HMI device, save 
the compiled project on a data medium of your choice. The compiled project is then transferred 
from a PC connected to the HMI device to the HMI device. 

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device.

 

 Note
WinCC version compatibility

To compile a project of a predecessor WinCC version, upgrade the project to your WinCC 
version. You can then no longer open the project in the predecessor WinCC version.

 

Project
The term "project" has two different meanings in the contexts of compilation and loading. 
"Project" is the WinCC project on the configuration PC. "Project" is also the Runtime project 
you create by compiling the configuration data of an HMI device and download to the HMI 
device. 

● WinCC project: contains the configuration data of one or more HMI devices

● Runtime project: contains the compiled configuration data of an HMI device

The figure below illustrates the link between WinCC projects and Runtime projects using the 
example of the "Compile and load" process:
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Runtime
Runtime is the software for process visualization. In Runtime, you execute the project in 
process mode. 

A distinction is made between two types of Runtime:

1. Runtime on a panel
Before running a Runtime project on a panel, you have to transfer the Runtime project to 
the panel before startup.

2. Runtime on a PC
You can execute the Runtime project directly on the configuration PC if Runtime has been 
installed on the configuration PC. 
If you want to execute the Runtime project on a different PC, you have to transfer the 
Runtime project to the PC before startup.

Simulation
You test your configuration with a simulation. You can start a simulation without a link to the 
active process.

In a simulation, you test configured tags or screen changes, for example. During the simulation, 
the configured tags can be manipulated, activated and deactivated with the help of the tag 
simulator. 

There are two types of simulation:

1. Simulating a panel
If you created a panel in your project, the panel is displayed in the simulation. With the help 
of this type of simulation, you can test your configuration on the HMI device without 
transferring the project to the panel.

2. Simulating Runtime
Simulating Runtime allows you to test the project directly on the configuration PC. 
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See also
Generating a "Pack&Go" file (Page 6986)

Starting Runtime Advanced and Panels (Page 6993)

10.13.2.2 Compiling a project

Introduction     
The changes made to the project are compiled in the background even as you are configuring 
a project in WinCC. Projects are compiled automatically when you load them. This ensures 
that the latest version of the project is loaded at all times.

WinCC checks consistency of the project during compilation. The error locations in the project 
are listed in the Inspector window. You can jump directly to the source of the error from the 
entry in the Inspector window. Check and correct errors found.

Scope of the compilation
Configuration data is compiled in the background as soon as you start configuring an HMI 
device. If you compile a project manually, only the changes in the configuration made since 
the last compilation process are compiled in the background. 

You can start complete project compilation manually at any time; this may, for example, be 
done to test the consistency of the configured data.

Requirement
● A project is open.

Procedure
Proceed as follows to compile a project:

1. If you want to compile several HMI devices at the same time, select all the relevant HMI 
devices with multiple selection in the project tree.

2. Compile the project:

– To only compile changes in the project, select the "Compile > Software (only changes)" 
command from the shortcut menu of the HMI device.

– To compile all project data, select the "Compile > Software (compile all)" command from 
the shortcut menu.

Result
The configuration data of all selected HMI devices is compiled. Any errors that occur during 
compilation are shown in the Inspector window. 
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10.13.2.3 Loading projects

Overview for loading of projects

Overview
Delta data of the project is automatically compiled before you download it to one or several 
HMI devices. This always ensures that the latest version of the project is transferred. 
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Loading a project to an HMI device   
The following steps are completed prior to downloading:

1. The download settings are verified. The "Extended download to device" dialog box opens 
automatically during the initial download of a project to an HMI device. You use this dialog 
to define the protocol and interface or destination path for the project in accordance with 
the HMI device Runtime used.
If the HMI device is part of a subnet, for example, you also select the subnet and the first 
gateway.
You can open the "Extended download to device" dialog at any time with the menu 
command "Online > Advanced download to device...". 
The "Load preview" dialog opens. 

2. The project is compiled. Warnings and errors during compilation are displayed in the 
Inspector window and in the "Load preview" dialog.

3. The "Load preview" dialog shows you the following information for each HMI device:

– The individual steps for loading

– If the device version of the target HMI device does not match the configured device 
version, you are queried if you want to change the device version at this time. 
As long as the project with the selected device version of the target HMI device is not 
executable, you cannot start the download. 

 

 
 NOTICE

Changing the device version deletes all data on the HMI device.

Data is deleted on the target system if you change the device version. For this reason, 
you should first back up the following data:
● User administration
● Recipes
● Licenses

Resetting to factory settings also deletes the license keys. Back up the license keys 
before you reset the system to factory settings.

With Comfort devices, the licenses can only be deleted when resetting to factory 
settings. Back up the licenses and license keys before you reset the system to factory 
settings.

 

– Presettings that take effect at loading. You can change the default settings for this 
download process, if necessary.

– Warning events (optional). You can download a project while ignoring the "warnings". 
The functionality may be restricted in runtime.

– Error events (optional). You cannot load the project. Eliminate the errors and then reload 
the project.
WinCC will open the invalid configuration in the corresponding editor if you double-click 
the error message in the Inspector window. Correct the errors and reload the project.

If you are using HMI tags in your project that are connected to PLC tags, you should also 
compile all modified S7 blocks with the command "Compile > Software" in the shortcut menu 
before you compile the HMI device. 

Visualize processes
10.13 Compiling and loading

WinCC Professional V13.0
7006 System Manual, 02/2014



 

 Note

If the transfer is interrupted, WinCC V13 automatically ensures that no data is lost and that 
existing data is deleted on the HMI device only after complete transmission. 

 

Loading a project without a connected HMI device   
If you cannot establish a direct connection from the configuration PC to the HMI device, save 
the compiled project on a data medium of your choice. Additional steps depend on the Runtime 
used:

● Panel Runtime: Copy the compiled project to a PC connected to the HMI device, for 
example, via a network. Download the project from this PC to the HMI device ("Pack&Go").

● Runtime Advanced: Move the compiled project to the HMI device.

Loading with S7 routing
Configure the S7 routing settings in the "Devices & Networks" editor in the relevant PLC. The 
settings depend on the device configured. 

S7 routing supports the following protocols:

● MPI/PROFIBUS

● PN/IE

Transferring Runtime add-ons in WinCC V13
Projects can contain Runtime add-ons in the form of controls or CSP (Communication Support 
Packages). These Runtime add-ons are automatically transferred with the project.  

Downloading the project to an HMI device

Introduction
Before a project can run on an HMI device, you must first load it to the HMI device. During 
loading, you must most importantly specify whether existing data on the HMI device such as 
"user administration" and "recipe data" is to be overwritten. As a general rule, only one project 
can be active in Runtime on an HMI device.

If the HMI device supports PROFINET, the name of the HMI device registered in the project 
tree is used as the device name for the PROFINET communication. The name is written during 
download to the HMI device. If a device name for the PROFINET communication has already 
been entered in the HMI device, it will be overwritten. 

Please note the following when downloading a project to an HMI device: 
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● You can download a project from the configuration PC to the HMI device if no project is 
open or in Runtime on the HMI device.

● If a project is open on the HMI device, you can only completely reload this particular project 
from the configuration PC to the HMI device. Close the project open on the HMI device to 
download a different project to the HMI device.
Example: The project "Mixing" is open on the HMI device but not in Runtime. If you change 
the project, download the changes to the HMI device with "Software (all)". Close the project 
"Mixing" on the HMI device to download the project "Bottling" to the HMI device, for example. 

● You can load certain changes to the configuration data without stopping Runtime (delta 
loading) if a project is in Runtime on the HMI device. You will be notified if a change means 
delta loading is no longer possible. If delta loading is no longer possible, you will only be 
able to download the project to the HMI device using "Load (completely)". Runtime is 
disabled, which may result in plant downtime.
You will have to exit Runtime and close the project on the HMI device to download another 
project to the HMI device. 

● To load a project of a predecessor WinCC version, first upgrade the project to your WinCC 
version.

 

 
 NOTICE

Device version

If the device version of the target HMI device does not correspond to that of the configured 
device version, Runtime cannot be started after loading.

Verify that the device version of the target HMI device conforms to your configuration 
before you compile and download your project. 

If necessary, change the device version manually via the properties of the HMI device.
 

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.

 

Requirement
● You have created an HMI device in the project.

● The HMI device is connected to the configuration PC.
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Procedure     
Proceed as follows to load a project:

1. To download a project simultaneously to several HMI devices, select the HMI devices by 
means of multiple selection in the project tree.

2. Select the "Download to device > Software" command from the shortcut menu of the HMI 
device.

3. If the "Extended loading" dialog opens:

– Select the "destination path" for the compiled project on the HMI device.
The Windows user group "SIMATIC HMI" must have full access to this destination path. 
Full access is usually set during installation of WinCC Runtime for the "WinCC Projects" 
file. The location of this folder in the file system depends on the operating system of the 
HMI device. 

– Click "Download".

You can open the "Extended download" dialog at any time with the menu command 
"Online > Advanced download to device...".
The "Load preview" dialog opens. The project is compiled at the same time. The result is 
displayed in the "Load preview" dialog.

4. Check the displayed presettings and change them as necessary.

5. Click "Download".

Result
The project is loaded to all selected HMI devices. If errors or warnings occur during the 
download, corresponding alarms are displayed under "Info > Load" in the Inspector window. 

On completion of the successful download of the project, you can execute it on the HMI device.

See also
Activating and deactivating projects on the WinCC server (Page 7483)

Overview of online delta transfers (Page 7013)

Downloading the project to a file system

Introduction
If the HMI device has no connection to the configuration PC, download the project to the HMI 
device offline via a USB data storage medium or a CD. 

To do this, first copy the Runtime project to your HMI device and start the project with "WinCC 
RT Start".

The PC on which Runtime is activated is referred to as the HMI device.
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The "Load preview" dialog opens. In this dialog, you can specify whether the user 
administration or logs, which have been changed on the HMI device in the meantime, are to 
be overwritten or retained. 

 

 Note

Existing data in the user management or in the logs are overwritten when you start the 
downloaded Runtime project.

To retain changes of the user administration, export the user administration and import the 
data again after starting the copied Runtime project.

 

Requirement
● A project is open.

 

Procedure
To download a project to a file system, follow these steps:

1. Select the project in the project tree.

2. Select the "Online > Download to file system" menu command.
A dialog opens.

3. Select the storage path and click "OK".
The project is compiled.

4. When the "Load preview" dialog opens, select the data to be transferred. 

5. Click "Download".
The Runtime project is saved on the drive. 
If necessary, transfer the Runtime project to a USB data storage medium or burn the project 
on a CD.

6. Transfer the Runtime project to your HMI device.

7. Start Runtime and open the downloaded project.

See also
WinCC RT Start (Page 7482)
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Online delta transfer for Runtime Professional

Overview of online delta transfers

Online delta loading       
WinCC lets you edit a project on the configuration PC while the same project is active in 
Runtime. You can in most cases load the configuration changes to the HMI devices using 
"Online delta loading" if you change the project on the configuration PC. Online delta loading 
requires less time compared to the transfer of the entire project.

The "Load preview" dialog opens for online delta loading. In this dialog you specify whether 
user administration or logs, which have been changed on the HMI device in the meantime, are 
overwritten or retained during online delta loading. 

 

 Note

Changes to the project made in the meantime on the HMI device, for example in the user 
administration or in the logs, are lost during the online delta loading. 

To retain changes to the user administration, export the user administration and import again 
following the online delta loading.

 

 Note
Device version

If the device version of the target HMI device does not correspond to that of the configured 
device version, delta loading is not possible.

Before delta loading your project, check whether the device version of the target HMI device 
corresponds to your configuration and, if necessary, update the version of your HMI device. 

 

Complete transfer
Fundamental changes to configuration data may prevent the online delta transfer. In this case, 
a message informs you of the failure of the online delta loading after you initiated the transfer.  
You then have to reload the entire project to the HMI device. You must explicitly confirm this 
Runtime restart on the HMI device in the "Load" dialog. You can cancel loading at this point. 

The following will happen if you start complete loading while the project on the configuration 
PC is in Runtime on the HMI device:

● Runtime is stopped

● The entire project is downloaded to the HMI device

● Runtime is restarted

Note that starting and stopping of Runtime can result in plant downtime. 

Visualize processes
10.13 Compiling and loading

WinCC Professional V13.0
System Manual, 02/2014 7011



Application scenarios
You will have to adapt your configuration in various different phases of your project, for 
example, commissioning, operation and maintenance. You can then transfer these changes 
to the HMI device online without having to exit Runtime. 

Cases in which online delta loading is used include:

● Continuous automation tasks:
All changes should be made online from a central configuration PC. This saves you having 
to make changes to the configuration locally. You can also add, change and delete runtime 
Runtime objects such as tags, alarms and logs without having to exit Runtime.

● Testing changes in a protected environment:
You can perform the planned changes offline on the configuration PC before these are 
downloaded to the HMI device. Configuration engineers can simulate the changes in a 
protected environment before activating the delta data in the process. This allows you to 
identify and clear configuration errors before they can cause any problems in the process 
or lead to a plant shutdown. 

See also
Starting Runtime on the configuration PC (Page 6992)

Exporting the user administration (Page 4411)

Importing the user administration (Page 4412)

Use and limitations of online delta loading

Introduction    
The online delta loading capability is lost in some configurations.

Files and elements
The table below shows for which actions the online delta transfer capability is retained and for 
which actions it is not retained:

Element Create Delete Edit Remarks
Project name/properties of the 
project

- - No -

HMI device Yes No No -
Properties of the HMI device - - No Edit:

Changes are only activated in Runtime by 
deactivating the project and restarting 
Runtime.

User cycle
(project properties)

No No No -

Connections
("HMI Tags" editor)

No No No -
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Element Create Delete Edit Remarks
Parameter of a connection
("HMI Tags" editor)

No No No -

Alarms - - - See the "Online configuration for alarms" 
table below

Menus and toolbars No No No -

Online configuration for alarms

Element Attribute Create Delete Edit Remarks
- ● Alarm number

● Alarm group
- - No -

- ● Alarm class Yes No Yes Inactive alarms are updated 
immediately if you change the 
alarm class without changing 
mandatory acknowledgment.
If the mandatory 
acknowledgment of a 
currently active alarm and of 
an unacknowledged alarm is 
changed, the system 
acknowledges the active 
alarm.
An active alarm that is 
changed to an alarm without 
"deactivated" state will be 
deactivated.

User-defined alarm group - Yes No Yes -
Limit values for analog 
alarms

- No No No -

Alarm classes - Yes No Yes Edit:
Valid for most attributes. 
Exceptions are listed 
individually:
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10.13.2.4 Starting Runtime

Starting Runtime on the configuration PC

Introduction
You can start your project in Runtime on the configuration PC while you are performing 
configuration in WinCC. The following restrictions apply to online configuration:

● The project cannot be compiled in the background while Runtime is running on the 
configuration PC.

● The delta data of the project is compiled automatically when you load the project to an HMI 
device after having closed Runtime. You can also start compilation manually.

● During startup of the project in Runtime, the project settings made in the "Runtime settings" 
of the HMI device are activated.

● If Runtime is running on the configuration PC, most changes are applied after compilation.

– Certain changes require a restart of Runtime for their activation.

– Changes to the screen that is currently open become visible after a screen change.

– With some changes, the option to compile configuration changes to the active Runtime 
is lost. The message that this option has been lost is only displayed when the project is 
compiled.

 

 Note
Automatic runtime termination

If automatic transfer is activated on the HMI device and a transfer is started on the 
configuration PC, the running project is automatically terminated. 

The HMI device then automatically switches to "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase to avoid the HMI device 
inadvertently going into transfer mode.

Transfer mode can result in undesired reactions in the system.

In order to disable the transfer settings and thus avoid unauthorized changes, enter a 
password in the Control Panel.

 

Requirement
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.
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Procedure         
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device with Runtime Professional in the project tree.

2. Select the "Online > Start Runtime" menu command.

3. To transfer configuration changes to the the active Runtime, select the "Compile > 
Software" command from the shortcut menu of the HMI device.

Result
Runtime is started and the updated project displayed on the configuration PC. 

See also
Use and limitations of online delta loading (Page 7012)

Starting Runtime Professional

Introduction             
Runtime in started on a configuration PC with installed WinCC Runtime via the WinCC menu 
bar. If only WinCC Runtime is installed on an HMI device, load the project to the HMI device. 
Use the "WinCC StartTool" for starting the project. 

Requirements
"WinCC Runtime" is installed on the HMI device. 

 

 Note

A least 100 MB free memory must be available on the storage medium before the Runtime 
of a project can be started.

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.
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Starting Runtime at an Engineering Station
1. Open the desired project in WinCC.

2. Select the "Start Runtime" command from the "Online" menu.

Result
The project is compiled and activated. During activation, all Runtime services that you selected 
in the Runtime settings of the HMI devices are started. 

See also
Activating and deactivating projects on the WinCC server (Page 7483)

10.13.2.5 Simulating projects

Simulation

Simulation basics

Introduction
You can use the simulator to test the performance of your configuration on the configuration 
PC. This allows you to quickly locate any logical configuration errors before productive 
operation. 

You can start the simulator as follows:

● In the shortcut menu of the HMI device or in a screen: "Start simulation"

● Menu command "Online > Simulation > [Start|With tag simulator|With script debugger]"

● Under "Visualization > Simulate device" in the portal view.

Requirement
The simulation/runtime component is installed on the configuration PC. 

Field of application
You can use the simulator to test the following functions of the HMI system, for example:

● Checking limit levels and alarm outputs

● Consistency of interrupts

● Configured interrupt simulation

● Configured warnings
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● Configured error messages

● Check of status displays

Runtime Professional simulation

Introduction
Simulating Runtime Professional allows you to test the project with process link directly on the 
configuration PC. You can also test the tags using the tag simulator. 

Function
Both process values and alarms are saved to a simulation log. The data generated is deleted 
from this log when you exit simulation mode.

The Runtime database is restored to the original state it had prior to simulation. Any changes 
to project data made during Runtime will be lost. You use the tag simulator to simulate the 
assignment of various values to the tags in your project. 

Project logging and backup operations are continued during simulation.
 

 WARNING

Possible damage to the plant

If you have changed tag values during the simulation with a PLC connection, unforeseen 
plant states can result in irreparable damage to the plant. Therefore, limit manual value 
manipulation to a minimum and select the test values carefully.

 

Limitations
Client-server operation is not possible during simulation. 

Simulating a project

Requirement
The project is open in the configuration PC.

 

 Note

The tag values of faulty connections to the process cannot be simulated.
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Procedure
Proceed as follows to simulate a project:

1. Disconnect the connection to the controller or switch the controller off if you do not want to 
test the function of the entire process.

2. Select the menu command "Online > Simulate Runtime > With tag simulator".
Runtime starts and the simulator opens with all the configured tags.

3. Select the "New tag" command in the "Edit" menu to add a tag to the tag simulator.

4. Select the tag from the WinCC tag management.

5. In the tag simulator, select the required tag on the "Tags" tab to supply a tag with simulated 
values.

6. Configure the simulation mode on the "Properties" tab:

– Select the simulation mode.

– Enter values for the simulation.

– Click "Active" to include the tag in the simulation.
 

 
 WARNING

Make sure once again that the configuration computer cannot pass any changed tags 
to the PLC in the active process. If you have not switched the PLC off, the simulated 
tag values will be passed to the PLC and the runtime process. 

 

7. Click the "Start simulation" button on the "Properties" tab.

8. Observe the effect the simulation has on your project in Runtime.

9. Click on the "Stop simulation" button to stop the simulation.

10.To save the settings for the simulation, select the menu command "File > Save" and enter 
a corresponding name.
The file is automatically given the *.sim extension.

Managing simulation data
If you have saved data from a previous simulation, you can open the file at a later point in time 
and simulate your project again. The tags and area pointers to be simulated must remain 
unchanged in the project, otherwise the saved simulation data will no longer match your project. 

Proceed as follows to open a simulation file: 

1. Select the menu command "Online > Simulate Runtime > With tag simulator".

2. Select the menu command "File > Open" in the tag simulator.

3. Select the corresponding simulation file and click "Open".
The simulator loads the stored data.
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Enabling and disabling tags
You can start and stop the simulation for each individual tag to enable a bumpless transition 
from the offline configuration to online configuration. Enable the "Active" check box in the 
"Properties" tab for this purpose.

When a tag is enabled, the simulation values are calculated and transferred to the tag simulator.

Deleting a tag
To delete a tag from the tag simulator, follow these steps:

1. Select the tag name.

2. Select the menu command "Edit > Delete".

The tag is removed from the table. 

Simulating a screen

Introduction
If you have only made changes to one screen, you can temporarily specify this screen as the 
start screen for simulation. In this way, you can debug changes without having to modify the 
start screen, or opening the screen on the HMI device. 

Requirements
You created a project that contains at least one screen. 

Procedure  
To define a screen as temporary start screen for simulation, follow these steps:

1. In the project navigation, select the image to display as the start screen in the simulation.

2. Select the "Start simulation" command from the shortcut menu of the screen.

Result
Project simulation is started. Instead of the configured start screen, the simulation window the 
screen you selected in the project navigation. 
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Working with the tag simulator

Simulation modes
The simulator has six different simulation modes. The configured tags are supplied with nearly 
realistic values during the simulation depending on the simulation mode. 

Simulation mode Description
Sinusoidal Changes the value of the tag to form a sinusoidal curve. The value is visualized 

as a periodic, non-linear function.
Settings:
● Amplitude
● Offset (zero point for value range)
● Period of oscillation

Oscillation For simulating jumps in a setpoint.
Settings:
● Overshoot
● Setpoint
● Period of oscillation
● Damping

Random Provides randomly generated values. The tag value is changed by means of a 
random function.
Settings:
● Minimum value
● Maximum value

Increment Increases the value of the tag continuously up to a specified maximum value. 
Begins again at the minimum after the maximum has been reached. The value 
trend corresponds to a positive saw-tooth curve.
Settings:
● Start value
● End value

Decrement Decreases the value of the tag continuously down to a specified minimum value. 
Begins again at the maximum after the minimum has been reached. The value 
curve corresponds to a negative saw-tooth curve.
Settings:
● Start value
● End value

Slider Sets a fixed value.
Settings:
● Minimum
● Maximum
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Simulation restrictions

Alarms with dynamic parameters
If you use tags or text lists as external tags for alarms, the dynamic parameters of the alarms 
are not displayed.

Only internal tags are enabled for the simulation of alarms in the tag simulator .

You can use PLCSim to simulate dynamic parameters.

Working with the debugger

Debugging user-defined VB functions

Introduction
Debugging allows you to test the user-defined VB functions for logical programming errors in 
Runtime. For example, you can test whether the proper values were transferred to the tags, 
and whether cancellation terms are realized correctly.   

The following VBScript-capable debuggers have been tested and approved:

● "Microsoft Script Debugger"

● "Microsoft Script Editor": The debugger is included in Microsoft Office XP.

"Microsoft Script Debugger" provides the following functionality:

● Viewing the source code of the function you are debugging

● Checking the step-by-step execution of the functions

● Viewing and editing tags and property values
 

  Note

Your code is displayed in the debugger, but is write-protected. You cannot edit the code 
directly in the debugger; you can only test the required changes. 

 

  Note
Difference with regard to VBScript for Windows and Windows CE 

The debugger checks the syntax for VBScript for Windows. If the function contains a 
VBScript function for Windows CE, a corresponding error message is output. Some 
VBScript functions are different, e.g., CreateObject. You can find a list of these VBScript 
functions under "VBScript for Windows CE".
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Error types
The following error types are distinguished when debugging:      

● Runtime error
A runtime error is generated if an attempt is made to execute an invalid or faulty instruction, 
e.g., if a tag is not defined. 
To intercept runtime errors, use the "On Error Resume Next" instruction in the user-defined 
VB function. With this instruction, the next instruction is executed after a runtime error. You 
check the error code with the Err object in the next line. To stop the handling of runtime 
errors in the user-defined VB function again, use the "On Error Goto 0" instruction. 

● Logical error
A logical error occurs when the event you are expecting does not take place, e.g., because 
a condition was checked incorrectly. To debug logical errors, you go through the user-
defined VB function step by step. This way, you identify the portion of the user-defined VB 
function that is not working.

Basic procedure
The debugger is only intended for identifying error locations in the user-defined VB function. 
For this purpose, for example, you use break points or execute the user-defined VB function 
step-by-step. For detailed information, refer to the documentation of the debugger you are 
using. In order to correct errors, you change to the "Scripts" editor in WinCC. After having 
recompiled and reloaded the script, you test the user-defined VB function once again using 
the debugger.

 

 Note

For tips and tricks on debugging, common sources of error, and further information, refer to 
the online help for the Microsoft Script Debugger.

 

Screen change while debugging
If you change to another screen while debugging, the user-defined VB function of the previous 
screen stays open but is no longer valid. The debugger could return invalid error messages in 
this case, as the objects called will no longer exist after the screen change. 

10.13.3 Servicing the HMI device

10.13.3.1 Overview of HMI device maintenance (Basic Panels)

Structure               
The following figure shows the software components of an HMI device and their relation to the 
engineering system.
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Runtime data
The Runtime data is generated during operation of the plant and stored on the HMI device. 
This data includes, for example, recipes and data for the user administration. This data is 
overwritten during loading. If required, save this data before loading a Runtime project.

Runtime project
The Runtime project contains the compiled configuration data for an HMI device. You download 
the Runtime project from WinCC to the HMI device.

Runtime software and operating system
Together, the Runtime software and operating system of an HMI device form the image. 
Various images are available for the HMI device. All images of an HMI device are available in 
WinCC. Depending on the configuration, download the appropriate image along with the 
Runtime project to the HMI device as required.

Firmware and hardware
The HMI device is delivered with preconfigured firmware and hardware. 

10.13.3.2 Overview of HMI device maintenance tasks (Basic Panels)

Structure               
The following figure shows the software components of an HMI device and their relation to the 
engineering system.
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Runtime data
The Runtime data is generated during operation of the plant and stored on the HMI device. 
This data includes, for example, recipes and data for the user administration. This data is 
overwritten during loading. If required, save this data before loading a Runtime project.

Runtime project and Runtime software
The Runtime project contains the compiled configuration data for an HMI device. Download 
the Runtime project along with the Runtime software from WinCC to the HMI device.

Operating system
The HMI operating system is referred to as image. Various images are available for the HMI 
device. All images of an HMI device are available in WinCC. Depending on the configuration, 
download the appropriate image along with the Runtime project to the HMI device as required.

Firmware and hardware
The HMI device is delivered with preconfigured firmware and hardware. 

10.13.3.3 Maintenance overview of the HMI device (RT Adv, RT Prof)

Structure               
The following figure shows the software components of an HMI device and their relation to the 
engineering system.
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Runtime data
The Runtime data is generated during operation of the plant and stored on the HMI device. 
This data includes, for example, recipes and data for the user administration. This data is 
overwritten during loading. If required, save this data before loading a Runtime project.

Runtime project 
The Runtime project contains the compiled configuration data for an HMI device. You download 
the Runtime project from WinCC to the HMI device.

Operating system and runtime software
The HMI device operating system and runtime software are installed on the HMI device 
independently of WinCC. This software is maintained in the same way as with every other PC.

Firmware and hardware
The HMI device is delivered with preconfigured firmware and hardware. 

10.13.3.4 ProSave

Introduction   
The "ProSave" service tool is installed by default when WinCC is installed. The ProSave 
functions are accessed in WinCC with the menu "Online > HMI Device maintenance". 

Functional scope
ProSave provides all of the functions you need to manage data on the HMI device:   

● Data backup and restoration of backed-up data

● Operating system update for HMI devices with Windows CE or below
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● Transferring License Keys

● Installing and uninstalling drivers and options as well as information on installed options 
and options that can be installed on an HMI device

● Communication settings (transferred from WinCC)

See also
Overview of HMI device maintenance (Basic Panels) (Page 7022)

10.13.3.5 Backup of HMI data

Introduction
Regular backups of HMI device data keep downtimes to a minimum, for example, when you 
replace a device. You simply transfer the backup data to the HMI device, restoring the original 
status. 

Data backup with WinCC
If an HMI device is connected to the configuration PC, you can back up and restore HMI device 
data from the configuration PC using WinCC. 

Scope of data backup
Which data is backed up and restored depends on the type of HMI device:

● Complete backup
Depending on the HMI device: Runtime, firmware, operating system, configuration, recipes, 
user administration, settings

 

  Note

License Keys can only be stored only in the following HMI devices: 
● HMI devices of the 177 series (except TP 177A)
● HMI devices of the 277 series 
● HMI devices of the 377 series 
● Mobile Panel Wireless 
● Comfort Panel 

The License Keys are not saved for the following HMI devices:
● OP 77A° 
● all other Windows CE HMI devices

 

● Firmware/configuration

● Recipes only
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● Only recipes in CSV format

● User administration only

A backup file with the extension *.psb is generated when you backup the data of an HMI device. 

As a general rule, you can backup the data to any storage medium. If the HMI device is 
networked, you can also backup the data to a server. 

 

 Note
Scope of data backup for Windows CE HMI devices

Data backup secures the contents of the flash memory. Alarm logs and process value logs 
are generally saved on the external storage medium. Alarm logs and process value logs are 
therefore not backed up. If necessary, back up the contents of the memory card separately. 

Please note the following when performing a complete data file backup and restore operation 
for Windows CE devices:
● A full backup includes all options installed. As a rule, the backup includes all options data 

that is still available after "POWER OFF".
● All data on the device, including License Keys and the operating system, are permanently 

deleted when you perform complete data restoration.
● If the data restoration was interrupted, execute the command "Reset to factory settings". 

Restart data restoration.
 

 Note

Use interfaces with high bandwidths, e.g. USB or Ethernet to backup and restore data. 
 

 Note

For Windows CE devices, you can also backup the data directly to a CF or PC card, 
independent of ProSave and WinCC. For additional information, refer to the relevant 
operating instructions.

 

 

See also
Backing up and restoring data of the HMI device (Page 7029)

Overview of HMI device maintenance (Basic Panels) (Page 7022)

10.13.3.6 Backing up and restoring data of the HMI device
 

 Note

Use the restore function for project data only on operating devices which were configured 
using the same configuration software. 
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Requirement
● The HMI device is connected to the configuration PC

● The HMI device is selected in the project tree.

● If a server is used for data backup: The configuration PC has access to the server

Backup of the data of the HMI device
Proceed as follows to backup the data of the HMI device:

1. Select the "Backup" command from the "Online > HMI Device maintenance" menu.
The "Create backup" dialog box opens.

2. Select the type of the PG/PC interface and the target device, and click "Create".
The "SIMATIC ProSave" dialog box opens. 

3. Select the data to backup for the HMI device under "Data type".

4. Enter the name of the backup file under "Save as".

5. Click "Start Backup".

This starts the data backup. The backup operation takes some time, depending on the 
connection selected.

Restoring the data of the HMI device
Proceed as follows to restore the data of the HMI device:

1. Select the "Restore" command from the "Online > HMI Device maintenance" menu.
The "Restore backup" dialog box opens. 

2. Select the type of the PG/PC interface and the target device, and click "Load". 
The "SIMATIC ProSave" dialog box opens. 

3. Enter the name of the backup file under "Save as".
Information about the selected backup file is displayed under "File information". 

4. Click "Start Restore".

This starts the restoration. This operation takes some time, depending on the connection 
selected.

Backup/Restore from the "Backup/Restore" dialog in the control panel of the HMI device
The "Backup/Restore" function is enabled for MMC, SD memory cards and USB mass storage 
devices. 

See also
Backup of HMI data (Page 7026)

Overview of HMI device maintenance (Basic Panels) (Page 7022)
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10.13.3.7 Updating the operating system

Introduction
Update the HMI device image if the version is incompatible with the configuration. The image 
version matches the device version. 

Update the operating system and Runtime software of the HMI device with the help of the 
device version. While loading the project, you may be prompted to run an automatic update 
of the device version, depending on the protocol used. 

Loading will then continue. Loading of the project is otherwise aborted. In this case, perform 
the update of the device version manually. 

 

 Note

A device version can only be updated on HMI devices that are not PC-based.
 

Updating the device version
Connect the HMI device to the configuration PC to update the device version. If possible, use 
the interface providing the highest bandwidth for this connection, e.g. Ethernet. An update of 
the device version via serial connection may take up to an hour. 

 

 Note
Transfer of operating systems for MP 377 via PROFIBUS

The size of the image and the baud rates available with PROFIBUS mean image transfer 
with an MP 377 via PROFIBUS can take up to an hour.

Updating the operating system via USB or Ethernet.
 

"Reset to factory settings"
If the operating system on the HMI device is no longer operational, update the operating system 
and reset the HMI device to the factory settings. 

 

 Note
Resetting to factory settings via Ethernet for Basic Panels

You require the following to reset the HMI device to the factory settings via Ethernet:
● the MAC address of the HMI device
● the available IP address
● the programming device/PC interface of the configuration PC set to Ethernet TCP/IP

The programming device/PC interface is configured using the control panel of the 
configuration PC. Select" "S7ONLINE (STEP7) -> TCP/IP" in the "Access point of the 
application" field.
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See also
Updating the operating system on the HMI device (Page 7032)

Overview of HMI device maintenance (Basic Panels) (Page 7022)

10.13.3.8 Updating the operating system on the HMI device
If possible, you should use the interface with the highest bandwidth for this connection, such 
as Ethernet. Updating the operating system via a serial connection can take up to an hour. 
When you update the operating system, the Runtime software on the HMI device is also 
updated and the device version is changed.

 

 NOTICE

Updating the operating system deletes all data on the HMI device

When you update the operating system you delete data on the target system. For this reason, 
you should back up the following data beforehand:
● User administration
● Recipes

Resetting to factory settings also deletes the License Keys. Back up the License Keys before 
you reset the system to factory settings.

 

Requirement
● The HMI device is connected to the configuration PC.

● The HMI device is selected in the project tree.

Updating the operating system
Proceed as follows to update the operating system:

1. Select the "Update operating system" command from the "Online > HMI Device 
maintenance" menu.
The "Update operating system" dialog box opens. 

2. Select the type of the PG/PC interface and the target device, and click "Update". 
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image is preset. 

3. If required, you can select a different path for the image that you want to transfer to the HMI 
device.

4. Click "Update OS".

This starts the update. The update operation can take time, depending on the connection 
selected.
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Resetting the HMI device to factory settings 
To reset the HMI device to factory settings, proceed as follows:

1. Switch off power to the HMI device.

2. Connect the HMI device to the Engineering Station.

3. Select the "Update operating system" command from the menu under "Online > HMI Device 
maintenance" on the configuration PC in WinCC.
The "Update operating system" dialog box opens. 

4. Select the type of the PG/PC interface and the target device, and click "Update". 
The "SIMATIC ProSave [OS-Update]" dialog opens. The path to the image is preset. 

5. If required, you can select a different path for the image that you want to transfer to the HMI 
device.

6. Activate "Reset to factory settings".

7. Click "Update OS".

8. To reset to factory settings, switch on the power to the HMI device again.
This operation can take time.

Result
The operating system of the HMI device is operational and up-to-date.

See also
Updating the operating system (Page 7029)

Transferring license keys (Page 7033)

Managing licenses (Page 7034)

Overview for loading of projects (Page 6978)

Backing up and restoring data of the HMI device (Page 7027)

Overview of HMI device maintenance (Basic Panels) (Page 7022)

10.13.3.9 Transferring license keys

Introduction  
You need a license for certain WinCC Runtime options you may want to install on an HMI 
device. Usually, the necessary licenses supplied as "License Keys" on a data medium, e.g. 
USB stick. The "License Keys" can also be made available on a license server. 

Use "Automation License Manager" to transfer the "License Keys" to or from an HMI device. 
The "Automation License Manager" is included automatically when you install WinCC. 
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 NOTICE

Backing up License Keys

In the following cases you have to backup the "License Keys" in order to prevent deletion of  
the "License Keys":
● Prior to the update of the operating system of a Windows CE HMI device
● Prior to restoring the data from a full backup

"License Keys" on an HMI device are backed up depending on the HMI device 
configuration. For more information, refer to the operating instructions of the 
corresponding HMI device.

 

See also
Managing licenses (Page 7034)

10.13.3.1
0

Managing licenses

Requirement
● The HMI device is connected to the configuration PC or the PC running the "Automation 

License Manager".

● If you are using the configuration PC: The HMI device is selected in the project tree.

Procedure
To transfer license keys, follow these steps:

1. Open the "Automation License Manager". Go to the Windows Start menu and start 
"Automation License Manager" on a PC on which WinCC is not installed.
The "Automation License Manager" starts. 

2. Select the "Connect HMI device" command from the "Edit > Connect target system" menu.
The "Connect target system" dialog opens. 

3. Select the HMI device type in the "Device type" area.

4. Select the "Connection".
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5. Configure the "connection parameters" associated with the selected connection.

6. Click "OK".
The connection to the HMI device is now set up. The connected HMI device is displayed 
in the left pane of "Automation License Manager".

7. Transfer the "License Keys" to the HMI device:

– In the left pane, select the drive on which the "License Keys" are located.
The "License Keys" are displayed on the right pane. 

– Select the "License Keys"

– Drag-and-drop the "License Keys" to the HMI device.

You can also remove License Keys from the HMI device using drag-and-drop.

Alternative procedure
You can also start the "Automation License Manager" from WinCC on a PC with a WinCC 
installation: Select the "Authorize/License" command in the "Online > HMI Device 
maintenance" menu.

Result
The "License Keys" are transferred to the HMI device. 

To backup the "License Keys" from the HMI device, drag-and-drop the "License Keys" from 
the HMI device to an available drive. 
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See also
Transferring license keys (Page 7031)

10.13.3.1
1

Installing and uninstalling an option

Introduction
You can install the following options on an HMI device: 

● Additional options supplied with WinCC

● Options purchased in addition to WinCC

Which options you can install depends on the HMI device type. 

Requirement
● The HMI device is connected to the Engineering Station, or to the PC with ProSave.

● The HMI device is selected in the project tree.

Procedure
To install an option on the HMI device, proceed as follows:

1. Select the "Options" command from the "Online > HMI Device maintenance" menu.
The "Load options" dialog opens. 

2. Select the type of the PG/PC interface and the target device, and click "Load". 
The "SIMATIC ProSave" dialog box opens. 
All available options and the previously installed options are displayed.

3. To display the installed options on the HMI device, click "Device status".

4. To install an option on the HMI device, select the option under "Available options" and click 
">>".

5. To uninstall an option from the HMI device, select the option under "Available options" and 
click "<<".

Result
The selected options are installed on or uninstalled from the HMI device. 
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10.13.4 Printer driver

10.13.4.1 Validity

Validity
This document includes a description of the enhancements made possible with optional 
package printer driver.

Install the optional package to implement the extended functionality. The installation provides 
new printer drivers for several HMI devices. 

If necessary you can install individual printer drivers with the tool SIMATIC ProSave on your 
HMI device. For more details on which printer drivers are available for which HMI devices 
please refer to the section "Supported HMI devices".

Installation
Please follow the instructions in the "Installation" section to install the "Optional package printer 
driver V1.3".

Application example
You can find an application example on the subject "Printing with HMI Panels" on the internet 
at

Auto-Hotspot 

 

10.13.4.2 Supported HMI devices

Contents of the Optional Package
The "Optional package printer driver V1.3" contains the following printer drivers for the 
specified HMI devices.

The printer driver supports all printer options of the HMI device. 

HMI device Brother P-Touch 
QL 650 TD 1)

Postscript PDF HTML

KP400 Comfort
KTP400 Comfort

USB Yes Yes Yes

KP700 Comfort 
TP700 Comfort

USB Yes Yes Yes

KP900 Comfort 
TP900 Comfort

USB Yes Yes Yes
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HMI device Brother P-Touch 
QL 650 TD 1)

Postscript PDF HTML

KP1200 Comfort 
TP1200 Comfort

USB Yes Yes Yes

KP1500 Comfort 
TP1500 Comfort

USB Yes Yes Yes

TP1900 Comfort USB Yes Yes Yes
TP2200 Comfort USB Yes Yes Yes
USB: Connect printer directly to HMI device via USB port
1) Report printout only. 

 

10.13.4.3 Installation

Requirements
ProSave is installed on the PC.

Procedure
1. Double click the "PROSAVE-OPT.exe" file.

2. Select "<Setup>" in the "WinZip Self-Extractor" dialog.

3. Select the language for the installation menu.

4. Select "<Continue>" in the "Optional package printer driver setup" dialog.

5. Confirm the next box with "<Install>".

6. Confirm the "Optional package printer driver setup" message with "<Finish>".
 

  Note

Please follow the instructions in the "Transferring the Options" chapter to transfer the 
printer driver onto the HMI device. 

 

10.13.4.4 Transferring the Options

Requirements
The HMI device is connected to a PC on which ProSave is installed.

Procedure
1. Restart ProSave on your PC.

2. Select the corresponding HMI device type in the "General" tab.
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3. Select the type of connection between the HMI device and the PC.

4. Set the connection parameters.

5. Select the "Options" tab.

6. Select the desired printer driver under "Available options".

7. Set "Transfer" mode on the HMI device.
If automatic transfer mode is enabled on the HMI device, the device automatically sets 
"Transfer" mode when a transfer is initiated. 

8. Select ">>" on the PC to start the transfer.

9. Follow the ProSave instructions and the instructions which appear on the HMI device.
During the installation of the printer driver, a status display appears indicating the progress 
of the operation.

Result
When the installation is complete, the new printer driver is displayed in ProSave in the "Installed 
options" area. The new printer driver can now be used on the HMI device. 

10.13.4.5 Setting up the printer driver

Postscript

Define PostScript V1.3 as printer on the HMI device
1. Open the Control Panel.

2. Start the "Printer" application.

3. In the "Printer Properties" dialog under "Printer Language:" select the entry "PostScript 
V1.3".

 

  Note

Not all printers support PostScript. Make sure that your printer supports this printer 
language. 

Select the "Draft mode" option to increase the print speed.
 

HTML

Introduction
The application "HTMLSettings.exe" is available on the desktop of the HMI device after 
installation of the "HMTL V1.3" printer driver. 
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Selecting the storage location
1. Open the application "HTMLSettings.exe" on the desktop of your HMI device.

2. Open "Storage Location" in the tab.

3. Under "Primary Location", select "USB-Stick", for example, for the storage location.

4. Select the directory in which the file is to be saved after printing.

Selecting the file name
1. Open the "HTMLSettings.exe" application

2. Open the "HTML File Names" tab

3. Select the settings for the names of the HTML file for the print-out.

4. Click on "Apply" to confirm your settings.

5. Select "Default" to retain the default settings for file name assignment.

Selecting columns for printing reports
1. Open the "HTMLSettings.exe" application

2. Open the "Columns Attributes" tab.

3. Select an attribute in the "Available Columns" category:

4. Add this attribute to your selection with the ">>" button.

5. If required, define whether the selected attribute is to be displayed as an image or as a 
hyperlink in the HTML file.

6. To deselect attributes from the "Selected Columns" category, select an attribute and click 
the "<<" button.

Selecting style sheets
1. Open the "HTMLSettings.exe" application

2. Open the "Advanced Options" tab.

3. Under "Enter Style Sheet File Path", select the storage location of the style sheets you wish 
to use.

4. Select the file to be used.

5. Select the directory for links.

6. Select the directory for images.

Defining HTML V1.3 as printer on the HMI device
1. Open the Control Panel.

2. Start the "Printer" application.
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3. Under "Printer Language" in the "Printer Properties" dialog, select: the entry "HTML V1.3".

4. Select "Draft Mode" for rapid storage of the HTML file.

PDF

Introduction
The application "PDFSettings.exe" is available on the desktop of the HMI device after 
installation of the "PDF V1.3" printer driver. 

 

Selecting the storage location
1. Start the application "PDFSettings.exe" on the desktop of your HMI device.

2. Open "Storage Location" in the tab.

3. Under "Primary Location", select "USB-Stick", for example, for the storage location.

4. Select the directory in which the file is to be saved after printing.

Selecting the file name
1. Open the "PDFSettings.exe" application

2. Open the "PDF File Names" tab

3. Select the settings for the names of the PDF file for the print-out.

4. Click on "Apply" to confirm your settings.

5. Select "Default" to retain the default settings for file name assignment.

Define PDF V1.3 as printer on the HMI device
1. Open the Control Panel.

2. Start the "Printer" application.

3. Under "Printer Language" in the "Printer Properties" dialog, select: the entry "PDF V1.3".

4. Select "Draft Mode" for rapid storage of the PDF file.
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10.13.5 Reference

10.13.5.1 Error messages during loading of projects

Possible problems during the download  
When a project is being downloaded to the HMI device, status messages regarding the 
download progress are displayed in the output window. 

Usually, problems arising during the download of the project to the HMI device are caused by 
one of the following errors:

● Wrong operating system version on the HMI device

● Incorrect download settings on the HMI device

● Incorrect HMI device type in the project

● The HMI device is not connected to the configuration PC.

The most common download failures and possible causes and remedies are listed below.

The serial download is cancelled
Possible remedy: Select a lower baud rate. 

The download is cancelled due to a compatibility conflict

Possible cause Remedy
Conflict between versions of the configuration 
software and the operating system of the HMI 
device

Synchronize the operating system of the HMI 
device with the version of the configuration 
software.
To update the operating system on the HMI 
device, select the "Update operating system" 
command from the "Online > HMI device 
maintenance" menu in WinCC. You can also use 
ProSave. 
For additional information, refer to the operating 
instructions for the HMI device. 

The configuration PC is connected to the wrong 
device, e.g. a controller.

Check the cabling. 
Correct the communication parameters. 
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Project download fails

Possible cause Remedy
Connection to the HMI device cannot be 
established (alarm in the output window)

Check the physical connection between the 
configuration PC and the HMI device. 
Check whether the HMI device is in transfer mode. 
Exception: Remote control

The default communication driver is not listed in 
the Windows Device Manager.

Check the device status of the COM connection in 
the properties window of the Device Manager.

Download over MPI/DP interface fails

Possible cause Remedy
"Configured mode" is set on the CP, for example, 
if you are using the SIMATIC NET CD. 

Set the CP to "PG mode" using the "Set PC 
station" application.
Check the "baud rate" and "MPI address" network 
parameters.
Download the project from WinCC to the CP.
Set the CP back to "configured mode".

On the programming device/PC panel, the 
"S7ONLINE" access point is not set to a hardware 
device such as CP5611 (MPI). This may be due 
to the installation of "SIMATIC NET CD".

Set the access point "S7ONLINE" on the selected 
device using the "PG/PC Panel" or "Set PC 
station" application.
Check the "baud rate" and "MPI address" network 
parameters.
Download the project from WinCC to the HMI 
device.
Restore the "S7ONLINE" access point to the 
original device.

The configuration is too complex

Possible cause Remedy
The configuration contains too many different 
objects or options for the HMI device selected.

Remove all objects of a specific type, for example 
all HTML browsers.
Alternatively, remove options such as 
Sm@rtServer or OPC server.

10.13.5.2 Adapting the project for another HMI device

Introduction
When you download a WinCC project to an HMI device, WinCC checks whether this is 
compatible with the HMI device type used in the project. If the types of HMI device do not 
match, you will see a message before the download starts.
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The download is aborted.

Adapting the project for the HMI device
You need to adapt the project accordingly to be able to download the project to the connected 
HMI device.    

● Add a new HMI device in the project tree. Select the correct type of HMI device from the 
HMI device selection.

● Copy the configured components from the previous to the new HMI device.
Copy large amounts of components directly in the project navigation and details view.
For example, copy the "Screens" folder to the screens folder of the new HMI device with 
the help of the shortcut menu.

● Use the detail view to copy entries in the project tree for which the "Copy" command is not 
available in the shortcut menu.

● Select the "Recipes" entry in the project tree, for example. The recipes are displayed in the 
detail view.

● Select the recipes in the detail view and drag them to the "Recipes" entry of the new HMI 
device. The recipes are copied. You can also select multiple objects in the detail view.

● Configure the components that cannot be copied, e.g. connections, area pointers, and 
alarms.

● Save the project at various points in time.

● Compile the full project.

● When the compilation is successfully completed, download the project to the HMI device.

Linking references
References to linked objects are included in the copying. The references are linked again once 
the linked objects are copied.

Example:

You copy a screen in which objects are linked to tags. The tag names are entered at the 
individual objects after the screen is added to the new HMI device. The tag names are marked 
in red because the references are open. When you then copy the tags and insert them into 
the new HMI device, the open references are closed. The red marking for the tag names 
disappears.

For complete references to connected objects in the PLC, you first need to configure a 
connection to the PLC.

Using the information area
When you compile the project for the HMI device, errors and warnings are displayed in the 
"Info" tab of the Inspector window. You can use the shortcut menu command "Go to" to go 
directly to the location where the error or warning can be corrected.

Work through the list of errors and warnings from top to bottom.

When the compilation is successfully completed, download the project to the HMI device. 
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See also
Loading a project (Page 6980)

10.13.5.3 Establishing a connection to the HMI device

Introduction
To download a WinCC project to an HMI device, a properly configured connection must be set 
up between the configuration PC and HMI device. The connection cannot be set up, the 
download is cancelled.

Setting up a connection between the configuration PC and HMI device
1. Check the cable connection between the HMI device and configuration PC.

2. Open the "Devices & Networks" editor in WinCC and start the network view.

3. Select the subnet in the network view and check the settings for the subnet.

4. Select the interface of the HMI device in the network view or device view and check the 
connection parameters in the Inspector window.

5. Switch on the HMI device and press the "Control Panel" button in the loader.
The Control Panel opens.

6. Press "Transfer" twice in the Control Panel.
The "Transfer Settings" dialog box opens.

7. Check the settings and then press "Advanced".
The [Protocol*] Settings" dialog opens.
*: The title of the dialog depends on the protocol used, for example, "PROFIBUS Settings". 

8. Check the advanced settings and close the dialog with "OK".

Important settings
Check the connection settings and in particular the following parameters:

● Network and station addresses

● Selected transmission rate

● Master on the bus; as a general rule, only one master is permitted.

If using a configurable adapter for the connection, check the adapter settings, for example, 
transmission rate, master on the bus. 

See also
Loading a project (Page 6980)
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10.14 Operating in Runtime

10.14.1 Basics

10.14.1.1 Overview

Configuration and process control phases     
HMI devices are used to operate and monitor tasks in process and production automation. 
The plant screens on the HMI devices provide a clear overview of active processes. The HMI 
device project, which includes the plant screens, is created during the configuration phase. 

Transfer the project to the HMI device for the process control phase. Another requirement for 
the process control phase is that the HMI device must be connected online to a PLC. The 
process control phase, operator control, and monitoring can then be carried out during an 
ongoing work process.

Figure 10-11 Configuration and process control phases

Downloading the project to the HMI device     
The following procedures are available to download a project to an HMI device:

● Downloading from the configuration PC

● Restore the project from a PC using ProSave
In this case, an archived project is downloaded from a PC to the HMI device. The 
configuration software need not be installed on this PC.

These procedures are available for commissioning and recommissioning a project.
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Commissioning and Recommissioning         
● When the HMI device is commissioned there is no project at first.

The HMI device is also in this state after the operating system has been updated. 

● When recommissioning, any project on the HMI device is replaced.

10.14.1.2 Behavior of the Runtime Advanced and Panels system

System functions and user-defined functions

Use
System functions and user-defined functions are used in Runtime for the following purposes: 

● To control the process.

● To utilize the properties of the HMI device.

● To configure system settings on the HMI device in online mode.

Each system function and user-defined function within WinCC is linked to an object and an 
event. As soon as the event occurs, the system function is triggered.

System functions
These default system functions are used to implement many tasks in Runtime, such as:

● Calculations, e.g. increasing a tag value by a specific or variable amount.

● Logging functions, e.g. starting a process value log.

● Settings, e.g. PLC changes or setting a bit in the PLC.

● Alarms, e.g after a different user logs on.

User-defined functions
User-defined functions may also be included in the project for specific applications which may 
require additional functions. WinCC provides an interface to Microsoft Visual Basic Script 
(VBScript or VBS for short) for creating user-defined functions. 

Examples:
● Conversion of values, e.g. between different physical units (temperatures).

● Automation of production sequences
The user-defined function controls a production sequence by transferring values to a PLC. 
The status is checked based on return values and corresponding measures are initiated.
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Events
The object and the selected function determine which events can be defined as triggers for 
executing a system function.

For example, the "Value change", "On exceeding" and "On falling below" events are associated 
with the "Tag" object. The "Loaded" and "Cleared" events are associated with the "Screen" 
object.

Reports

Overview
Logs are used to document process data and completed production cycles. The report content 
and layout are specified in the project, as is the event triggering the printout of the report. 

For example, a report can be configured for output at the end of a shift to record downtimes. 
A log can also be configured for the purpose of the documentation of product testing or quality 
inspections (ISO 9000).

Output
Reports are printed in Runtime either automatically, e.g. by means of a scheduler, or manually 
by means of a softkey.

Printing reports
Reports are output to the printer in graphic mode. The use of a serial printer is not 
recommended because of the accumulated data volume. 

For proper output, the printer must support the paper format and page layout of the report.
 

 Note

The value of a tag in the report is read and output at the moment of printing. A substantial 
time may elapse between printing out the first and the last page of a report consisting of 
several pages. This may lead to the same tag on the last page being output with a different 
value from that on the first page.

 

 

Logs

Overview
Alarm events and process values can be saved to log files. Alarm events are, for example, the 
"Incoming", "Acknowledge" and "Outgoing" events contained in an alarm message.

Data logging can be used for the following purposes: 
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● Early detection of danger / fault states

● Increase of productivity

● Enhancement of product quality

● Optimization of maintenance cycles

● Documentation of processes

● Quality assurance

Memory options
Depending on the configuration, the logs are written to a file or stored in a database set up for 
this purpose.

● Data logging to File – CSV(ASCII)
In CSV format, table columns are separated by separators and the table rows are 
terminated by a line break. This allows you to evaluate or edit your log data, for example, 
using an external text editor or a spreadsheet program.

 

  Note

Double quotation marks or multiple characters cannot be used as list separators for the 
storage location "File - CSV (ASCII)". The setting for list separators can be found under 
"Start > Settings > Control Panel > Regional and Language Options".

 

● Data logging to File – TXT (Unicode)
The data is saved in the Unicode format. This file format supports all characters than can 
be used in WinCC Runtime. For processing, you require a software that can save Unicode, 
such as Notepad.

 

  Note

To save Asian languages, use the storage location "File - TXT (Unicode)".
 

● Data logging to a File - RDB
Log files of this format can only be read or visualized in WinCC Runtime Advanced.
If you want to evaluate the logged data in a different manner, convert the data to the CSV 
format using the "CopyLog" system function.

● Data logging to a database
Data is saved in a database for which ODBC access was set up by the PC administrator. 

Logging methods
Logging methods used in WinCC:

● Circular log

● Segmented circular log

● Log with level-dependent system alarms

● Log with level-dependent triggering of an event
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Alarm logs
Alarms in the project indicate fault states and operating states of a process. They are generally 
triggered by the controller. Alarms are output on the HMI device in form of screen objects. All 
the data associated with an alarm and configuration data are saved in an alarm log, for 
example, alarm class, time stamp and alarm text. All alarm classes can be logged separately. 
Alarms can be logged either automatically or by operator intervention. For additional 
information, refer to "Logging alarms".

Data logs
In Runtime, the process values are logged, processed and, depending on the project, written 
either to files or to the log database.

Data logging is controlled by means of cyclic operations and events. Logging cycles are used 
to ensure continuous acquisition and storage of the process values. Data logging can also be 
triggered by events, for example, when a value has changed. For additional information, refer 
to "Logging tags".

Storing logs on network drives
Close all logs with the system function "CloseAllLogs" before disconnecting the HMI device 
from the network.

End Runtime if an unexpected network failure occurs. The logs will be available again after 
restarting Runtime.     

Storing files on a Windows 2003 server
Log files and recipes can only be stored on a Windows 2003 server with Active Directory for 
the following HMI devices:

● MP 277

● MP 377

● Mobile Panel 277

● Mobile Panel 277 IWLAN

Tags

Definition
Tags correspond to defined memory areas on the HMI device, to which values are written and/
or from which values are read. This action can be initiated by the PLC, or by the operator at 
the HMI device. 
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10.14.1.3 System characteristics of Runtime Professional

Reports

Overview
The protocol system in WinCC does not detect Runtime in the real sense of the meaning. 
Reports and print jobs can be configured and executed at any time. Only print jobs which 
represent log or process data are dependent on Runtime. 

Sequence
The protocol system is automatically started on every client during the startup routine. The 
server operates as a protocol server, the clients as protocol clients. The clients log on to the 
server during startup. The server provides current information about available print jobs and 
their status to the clients. After having started a print, the client requests the corresponding 
data from the server database. The print job is started locally. The protocol server receives 
the current data concerning the print job status from the client and transfers the information to 
the other clients.

Output
You have the following options for outputting a report in Runtime:

● Using the "Print" button for the following objects:

– f(x) trend view 

– f(t) trend view 

– Table view 

– Alarm view 

– Recipe view 

● Print job/Script diagnostics
The operator can initiate printing of a report in the "Print job/Script diagnostics" object in 
Runtime. All queued print jobs are displayed in the "Print job/Script diagnostics" object.

● Button
The operator can start printing the report using a configured button which is logically linked 
to a corresponding script. 

Alarms

Behavior
If alarms are displayed on a client, the clients will request the data from the alarm server. The 
message server receives the configured data from the database.  

Visualize processes
10.14 Operating in Runtime

WinCC Professional V13.0
System Manual, 02/2014 7049



Archive data and message lists can be displayed on every client. The data to be displayed 
always comes from the message server. When new messages are received, the messages 
are archived in the message server. 

When an alarm is acknowledged at an HMI device, the acknowledgement is transferred to the 
message server. The server enters the change of status in the archive and distributes the 
notification to all participating clients. The same process applies to the locking of messages.

If a message server is not available in Runtime, the corresponding message appears in the 
message window instead of the messages. When the server becomes available again, 
messages are displayed in the message window again. 

Data logs

Behavior
If the data logging system is activated on an HMI device, the tag logging in Runtime operates 
on the server as data log server and on the clients as data log client. Only the archive server 
accesses the database and compiles and archives the process data. The clients receive 
archive data from the archive server. 

The log data is visualized in tabular or graphic format on all clients running tag logging in 
Runtime. The data to be displayed always comes from the archive server. All operations on 
the client are transmitted to the server and the result of the processing is transferred back to 
the client. 

Screens 

Behavior
After a client has called a screen in Runtime, the "Graphic object in Runtime" function initially 
searches for locally stored screens. If no screen with the corresponding name is found locally, 
a search is made in the project folder on the server. A corresponding message is output if the 
screen is unavailable. 

If a screen selection requires data exchange with a different editor (alarms, custom C 
functions), this exchange is always local. A picture can be opened and processed by several 
operating stations in Runtime. 
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10.14.2 Commissioning projects

10.14.2.1 Commissioning projects for Runtime Advanced and Panels

Settings for Runtime Advanced and Panels

Settings in the Runtime software (Advanced)
Open the WinCC configuration software and make the following settings for the Runtime 
software: 

Display on the PLC
In WinCC, configure the visual representation of the generated project in Runtime: Select the 
full-screen or window mode for the project. The window has a smaller size than the screen. In 
full-screen mode, the project is zoomed to the full screen. There will be no window and operator 
control elements for this view.

Click "Screens" in the "Settings" editor to define activation of the full-screen at startup. Activate 
the "Full-screen mode" check box in the "Screen" field. 

You can hide the taskbar in Windows as required. Select "Start > Settings > Taskbar" and then 
deactivate the "Always on Top" and "Auto hide" check boxes in the "Taskbar properties" dialog.

 

 Note
Truncated view

If the HMI screen does not match the configured size (in pixels), the project opened in full-
screen mode only appears on a part of the screen.

 

Dialog fonts
The dialog text will be shown in the standard font. Define the default font by selecting 
"Languages and fonts" in the "Settings" editor.

Disabling program switching
You lock program switching to prevent operators from calling other applications in Runtime.
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Click "Screens" in the "Settings" editor and then activate the "Disable program switching" and 
"Full-screen mode" check boxes. Also hide the Windows taskbar.

 

 Note
Stop runtime

If you lock program switching, always configure in your project the system function 
"StopRuntime" for an object, e.g. a softkey or button. Otherwise, you cannot close Runtime 
or Windows.

The <CTRL+ALT+DEL> key shortcut is not available if program switching is disabled. On a 
Windows 2000 operating system this effect prevents you from logging on to your device again 
after the screensaver was started. Windows 2000 allows you to disable the <CTRL+ALT
+DEL> key shortcut required for logon. Open the "Control Panel > Users > Passwords > 
Advanced" tab and deactivate the "Press CTRL + ALT + DEL before logon" check box.

 

Screen saver
A screensaver is no longer required for most modern screens and can, in fact, even cause 
damage. These monitors switch to hibernate mode as soon as the video signal has not 
changed for a specified time. A conventional screensaver would prevent this and thus reduce 
the service life of your monitor. 

 

 Note
Approved screensavers

If you do want to use a screensaver, note that only the standard Windows screensavers are 
approved for use in Runtime.

 

Make sure that the correct time zone is set on the PC on which the runtime software is installed. 
To set the time zone in Windows, select Start > Settings > Control Panel > Date and Time. 

Additional operating options (Advanced)

Print functions
Print functions available in online mode: :

● Hardcopy
You can print the content of the currently displayed screen if you utilize the "Print screen" 
system function in your configuration. 

● Printing alarms
Each alarm event that occurs (incoming, outgoing, acknowledgment) is also sent to a 
printer. 

● Printing reports
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LED control
The light-emitting diodes (LEDs) in the function keys of the HMI devices can be controlled from 
the PLC. For example, a lit or flashing LED can signal the operator to press a specific function 
key on the device. 

Loading a project

Overview
Various scenarios are possible for loading the project: 

● The Runtime software is installed on the same system as the configuration software.

● The Runtime software and the configuration software are installed on different systems. 
The project must be loaded from the configuration computer to the target system. The HMI 
devices must be connected to the configuration PC for the transfer. Another requirement 
is that the transfer mode must match on the HMI devices and in WinCC.

 

  Note

Security prompts may appear during the loading process, depending on the configuration. 
The recipe data and password list on the HMI device are overwritten following a prompt.

 

The configuration software and the Runtime software are installed on the same system
If the configuration software and the Runtime software are installed on the same system, 
proceed as follows: 

1. Create and compile your project.

2. Start Runtime directly from the active configuration software. Select the "Start Runtime" 
command from the "Online" menu.

3. You may test and operate the project online with the controller if you have configured the 
corresponding communication.

The configuration software and the Runtime software are installed on different systems
If the configuration software and the Runtime software are installed on different systems, 
proceed as follows: 

1. Create and compile your project. For additional information, refer to "Compiling a project".

2. To download the file via cable:
Connect the HMI device to the configuration computer using a standard cable to match the 
desired transfer mode and then switch on the HMI device.
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3. Set the HMI device to transfer mode.
To start transfer mode, press the "Transfer" button in the Loader. You can also assign the 
system function "SetDeviceMode" to an operator control.

4. Load the project from the configuration computer to your target device. For further 
information, refer to "Loading projects".

 

  Note

If the HMI device is a PC, you can transfer the compiled file without using the loader, for 
example, via Ethernet. Double-click the corresponding file on your PC to start Runtime. 

 

Starting Runtime on the Engineering Station

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. The 
project settings defined in the "Runtime settings" of the HMI device are activated when the 
project is started in Runtime.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.
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Procedure         
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 

Starting Runtime Advanced and Panels

Introduction
You can start the project in Runtime as soon as you have downloaded the project to the HMI 
device. The project is generally started automatically on the HMI device. 

There may be several projects in the file system of the HMI device for HMI devices with Runtime 
Advanced. You can start one of these projects in Runtime. 

The project settings defined in the "Runtime settings" of the HMI device are activated when 
the project is started in Runtime. Make sure when defining the Runtime settings "Lock task 
switching" and "Full screen" that you will be able to stop Runtime again. You can, for example, 
configure a button with the system function "StopRuntime".

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● WinCC Runtime Advanced or Panels is installed on the HMI device.

● The project was downloaded to the HMI device
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Starting Runtime on a PC     
The compiled project is saved in the PC file system with the extension "*.fwc" and is freely 
accessible.

1. To start the project once the HMI device has booted up, enter the automatic start of a project 
file under "Settings" in the "RT Loader" ("HmiLoad.exe").
You can also create a link to the project file in the Windows Autostart directory.

Starting Runtime on a panel     
The project will be stored on a panel in a folder you specify in the HMI device transfer settings. 
The "RT Loader" application is started on a panel. The project loaded is started automatically 
after expiration of the configured delay.

If the project does not start automatically:

1. Click on "Start" to start the loaded project.

Refer to the documentation for the HMI device for additional information on startup of projects. 

Result
Runtime is started on the HMI device. 

Testing a project

Introduction
You have the following options for testing a WinCC project:

Testing projects on the configuration computer.
● Simulator

The Simulator is used to test WinCC projects with internal tags and process tags. For 
additional information, refer to "Simulating projects".
Tests supported by the Simulator:

– Offline testing of a configuration without connection to a PLC.

– Online testing of a configuration with connection to a PLC and inactive process.

– Implementation of a demo project.

● Script debugger
The script debugger tests your scripts in Runtime to find logical programming errors. For 
additional information, refer to "Working with the Debugger".
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Testing projects on the HMI device
● Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and the PLC is down 
for the duration of the test. You can operate the HMI device, however, without being able 
to exchange data with the PLC. Set the "Offline" mode on the HMI device by assigning the 
system function "SetDeviceMode" to an operating element.

● Online testing of the project on the HMI device
Online testing means that communication between the HMI device and the PLC is up for 
the duration of the test. You can use the HMI device to control the plant as configured. Set 
the "Online" mode on the HMI device by assigning the system function "SetDeviceMode" 
to an operating element.

Procedure
The following steps show the basic procedures for simulating a project offline on the 
configuration computer without PLC connection. 

1. Start by creating a project as it is going to be run later with an interconnected PLC.

2. Save and compile the project.

3. Start the Simulator directly from the active configuration software. Select "Online > Simulate 
Runtime > With tag simulator".
If simulating the project for the first time, the simulator is started with a new, empty 
simulation table. If you have already created a simulation table for your project, it will be 
opened. 
The simulation table "*.six" contains all your settings for the simulation of tags and area 
pointers. 

4. Make any changes to the tags and area pointers of your project in the simulation table.
Toggle between the simulation table and Runtime using the <ALT+TAB> key shortcut.
Save your simulation settings with "File > Save." Assign the file a meaningful name. The 
file name is automatically assigned the extension "*.six".

Backup and restoring projects
 

 Note

Use the restore function for project data only on operating devices which were configured 
using the same configuration software. 

 

Requirement
● The HMI device is connected to the configuration PC

● The HMI device is selected in the project tree.

● If a server is used for data backup: The configuration PC has access to the server
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Backup of the data of the HMI device
Proceed as follows to backup the data of the HMI device:

1. Select the "Backup" command from the "Online > HMI Device maintenance" menu.
The "Create backup" dialog box opens.

2. Select the type of the PG/PC interface and the target device, and click "Create".
The "SIMATIC ProSave" dialog box opens. 

3. Select the data to backup for the HMI device under "Data type".

4. Enter the name of the backup file under "Save as".

5. Click "Start Backup".

This starts the data backup. The backup operation takes some time, depending on the 
connection selected.

Restoring the data of the HMI device
Proceed as follows to restore the data of the HMI device:

1. Select the "Restore" command from the "Online > HMI Device maintenance" menu.
The "Restore backup" dialog box opens. 

2. Select the type of the PG/PC interface and the target device, and click "Load". 
The "SIMATIC ProSave" dialog box opens. 

3. Enter the name of the backup file under "Save as".
Information about the selected backup file is displayed under "File information". 

4. Click "Start Restore".

This starts the restoration. This operation takes some time, depending on the connection 
selected.

Backup/Restore from the "Backup/Restore" dialog in the control panel of the HMI device
The "Backup/Restore" function is enabled for MMC, SD memory cards and USB mass storage 
devices. 

Closing a project

Introduction
You define the steps in closing Runtime in the user program: 
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Procedure
Exit Runtime as follows:

1. When Runtime is running in window mode, you can close it by clicking the icon .

2. When Runtime is running in full-screen mode, you can close it by means of the program 
switching function and the Task Manager.

3. When Runtime is running in full-screen mode and program switching is disabled for the 
project, the closing sequence of Runtime must be configured separately. Actuate the 
relevant button to close Runtime.

10.14.2.2 Commissioning projects for Runtime Professional

Access rights within the operating system

Defining Access Rights in the Operating System

Introduction                
Certain folders can be released for network access when working with WinCC. For security 
reasons you should restrict access to these folders to specific users.

Access rights specified in WinCC
After its installation was completed, WinCC automatically sets up the following local groups in 
the Windows users and groups management: 

● "SIMATIC HMI". These members may create local projects, and may process, start, and 
access these projects remotely. The user who installs WinCC and the local administrator 
are included in this group by default. Additional users must be defined by the administrator. 
For additional information, refer to "Assigning users to the "SIMATIC HMI" user group".

● "SIMATIC HMI CS". These members may configure only but may not make any changes 
to runtime components directly. By default, this group is empty and reserved for later use.

● "SIMATIC HMI Viewer". These members have read access only to configuration and 
runtime data. This group is preferably used for Web publishing services accounts, e.g., IIS 
(Internet Information Services) for operation of WinCC Web Navigator.

The "InstallationDirectory/WinCC/aplib" folder named "SCRIPTFCT" is released after 
installation for the "SIMATIC HMI" user group. This folder contains central libraries for project 
script functions. 

Users of the "SIMATIC HMI" and "SIMATIC HMI CS" user group are granted access rights to 
the project folder when you recreate a project. Following a manual copy, the administrator or 
main user may have to open the project once to set the local authorizations properly. The 
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settings of the Auto-Hotspot released WinCC folders will not be changed afterwards. You may 
manually change settings, if necessary.

 

 Note

Configurators and users of runtime components must be registered not only in a "SIMATIC 
HMI" group but also in a user group of the operating system. Users of the "SIMATIC HMI" 
group are only granted access to the projects but not the operating system. In order to create 
a project, the configurator must be at least the main user and a member of the "SIMATIC 
HMI" group.

 

Including users in the "SIMATIC HMI" user group

Introduction
Include those local users in the "SIMATIC HMI" group whose login permits access to WinCC. 
You must first create local users to do so. Users of a domain may be directly included in the 
user group "SIMATIC HMI".

Procedure
You add users to the "SIMATIC HMI" user group as follows:

1. Open the workstation administration under Windows.

2. Select the entry "Local Users and Groups > Users" in the navigation window .
All local users are displayed in the data window.

3. Open the "New User" dialog via the shortcut menu.
Create a user account with the same login for each user who has to access WinCC.

4. Select the entry "Local Users and Groups > Groups" in the navigation window".
All groups are displayed in the data window.
Select the "SIMATIC HMI" group.

5. Using the pop-up menu, open the "Add Member" dialog and include those users as 
members of the "SIMATIC HMI" user group.

Result
The user has been added to the "SIMATIC HMI" user group. These changes become effective 
after system restart. 

Including domain-global user group in the "SIMATIC HMI" user group

Introduction
You can set up an additional domain-global user group for operation within a domain as 
member of the "SIMATIC HMI" user group.
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Requirement
● The domain administrator creates a domain-global user group.

● Within the domain, the domain administrator includes those users in the domain whose 
login permits access to WinCC.

Procedure
Set up the access rights of your operating system as follows:

1. Open the workstation administration under Windows.

2. In the navigation window, select the "Local Users and Groups > Users" entry. The data 
window displays all local users.

3. In the pop-up menu, select the "New User" dialog. Create an user account with the same 
login for the domain-global user group.

4. In the navigation window, select the "Local Users and Groups > Groups" entry. The data 
window displays all groups. Select the group "SIMATIC HMI".

5. Using the pop-up menu, open the "Add Member" dialog and include domain-global user 
group as members of the "SIMATIC HMI" user group.

Result
Access rights have been adapted. These changes become effective after system restart.

Sharing an existing project for access by the "SIMATIC HMI" user group 

Introduction
Start by deleting the currently shared access to the project directory if the "SIMATIC HMI" user 
group is to have access to an existing project. The project is then shared on opening.

Procedure
You grant the "SIMATIC HMI" user group access to the project as follows:

1. Open the workstation administration under Windows.

2. In the navigation window, select the entry "Shared Folders > Shares". The data window 
displays all shared directories.

3. Select the respective project directory and remove the enable through the "Cancel Share" 
pop-up menu.

4. If you now open the project in WinCC, the project directory is automatically shared by the 
"SIMATIC HMI" user group and all members of the user group have access to the project 
directory.

 

  Note

Do not change the share name of the directory shared by WinCC.
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Adapting security policies in Windows

Introduction
Before you install WinCC, you must check the operating system settings. The system must 
permit installation of unsigned drivers and files.

Procedure
You adapt the Windows security policies as follows:

1. In the Control Panel, open "Administrative Tools".

2. Double-click "Local Security Policy".

3. In the left pane, click "Local Policies".

4. In the right pane, double-click "Security Options".

5. Check the following setting of the security policies of Windows XP and Windows Server 
2003:
"Devices: Unsigned driver installation behavior"

For the policies, select either "Accept without warning" or "Warn, but permit installation".

Settings for Runtime Professional

Setting up the start sequence

Introduction       
When you activate a project, additional program modules will be loaded to execute Runtime. 

Select "Start sequence of WinCC Runtime" to specify the applications that will be started on 
activation of a project. "Graphics in Runtime" is always started and is enabled by default.

Start only the applications required in Runtime to obtain a high performance level. 
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Procedure
Set up the startup list as follows:

1. Open the "Runtime settings > Services" editor.

2. Enable the display of the online help in Runtime by activating "Enable help in Runtime".

3. Select the applications to load at the start of Runtime in the "Start sequence of WinCC 
Runtime" area.

4. You can load additional tasks or applications at the start of Runtime by clicking in the table 
row at "Additional tasks/application".

5. Enter a name for the additional task or application. Specify the working directory.

6. The project folder is used as working directory if you select the check box in the "Project 
directory" column.

7. If you clear the check box in the "Project directory" column, use the "Find" button to specify 
the folder in the "Working directory" column.

8. Specify any necessary parameters.

9. Specify the startup size of the task or application window in the "Window style" column, 
e.g. minimized, maximized or standard size. 
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Setting the language and fonts

Introduction 
Define the language and corresponding fonts for Runtime activation. Define the order by which 
languages are changed. 

Requirement
The "Runtime Settings > Language & Font style" editor is open.

Procedure
Set the Runtime language as follows:

1. Select "Runtime language for single-language objects:" to set the substitute text language 
for graphic objects. 

2. Select the required languages.
The project is started in the language assigned the lowest number at the initial start of 
Runtime on an HMI device.

3. Define the font for the Runtime language in the "Standard font" column.
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Activating the on-screen keyboard

Introduction
The on-screen keyboard is always displayed in Runtime after the operator has selected an 
input field. The on-screen keyboard is automatically hidden again after input was completed.

Requirement
The "Runtime settings" editor is open.

Procedure
Proceed as follows to activate the on-screen keyboard:

1. Activate "Runtime settings > General > Use screen keyboard".

Enabling the zoom functions

Introduction 
Zooming in Runtime is supported by three techniques:

● Declutter
The layers and their embedded objects can be shown and hidden.
For additional information, refer to "Dynamic visualization of an object".

● Extended Zooming
The Runtime view of the process screen can be enlarged or reduced using the scroll wheel 
of the mouse. Hold the <CTRL> key down while turning the mouse wheel. If you turn the 
mouse wheel away from the palm of your hand, you increase the zoom factor.

● Panning
You can move a cutout of a screen within the document if this screen is assigned a specific 
zoom factor that activates the scroll bars. A navigation crosshair appears upon clicking on 
the mouse wheel. Moving the mouse pointer scrolls in the desired direction. The distance 
between mouse pointer and navigation crosshair determines the scrolling speed. A second 
click cancels panning.

Requirement
● A driver for a Logitech mouse or Microsoft Intellimouse

● The mouse wheel must be set to "Autoscroll" mode.

● The "Runtime settings" editor is open.
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Enabling the zoom function
1. Click on "Screens".

2. Deactivate "Declutter" and "Extended zoom". 
The functions are disabled if you activate "Declutter" and "Extended zoom".

Configuring Extended Zooming Picture-Specific
The "Extended Zoom" function can be enabled/disabled for specific screens. Make the 
corresponding setting in the Inspector window of a screen under "Properties > Properties > 
Miscellaneous".

 

 Note

"Declutter" is now supported by the following objects:
● "Slider"
● "Clock"
● "Gauge"
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Defining hotkeys in the project 

Introduction
You can define various hotkeys to operate the project. The hotkeys can be used as an 
alternative to the mouse.

● Windows keys
Define the key shortcuts to be supported in Runtime in the "Windows keys" dialog. 

● Action keys

– "Logon" opens a window for user logon in Runtime.

– "Logoff" opens a window for user logoff in Runtime.

– "Hardcopy" opens a dialog for printing the screen in Runtime.

Requirement
The "Runtime settings" editor is open.

Procedure
Set up the hotkeys as follows:

1. Click on "Runtime settings > Keyboard".

2. Activate your hotkeys in the "Windows keys" dialog.

3. Select the action in the "Action keys" dialog. 

4. Click the  button in the selection list. The hotkeys dialog opens.
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5. Define your hotkeys.

6. Click the  button to close the dialog.

Configuring hotkeys for operating and screen navigation

Introduction
Screens can also be operated if mouse control is not available. Define corresponding hotkeys 
for the required operating functions. The operator calls the specific function by operating the 
hotkey. 

The most important hotkeys for operation without mouse in Runtime are defined in the 
"Runtime Settings > Keyboard" editor.
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Procedure
Set up the operator hotkeys as follows:

1. Click in the input field of the selected function.

2. Click the  button in the selection list. The hotkeys dialog opens.

3. Define your hotkeys.

4. Click the  button to close the dialog.
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You can also define single-key or a softkey <F1> - <F12> input instead of a hotkey.
 

 Note

The function key F12 may not be configured as a system wide hotkey.
 

Window control keys
These hotkey changes are activated after system restart.

Changing windows

This hotkey is used to navigate between multiple picture windows, which are configured in a 
main picture. Whenever the hotkey is pressed, the next picture window will be activated for an 
operation.

 

 Note

The <DEL> and <HOME> keys cannot be used as hotkeys.
 

Screen navigation keys
The "Forward" and "Back" buttons of most Internet browsers allow the navigation between 
Internet pages most recently called. A similar technique can be implemented in WinCC to 
navigate between individual process pictures.

Configure corresponding hotkeys in the "Screen selection" dialog to facilitate screen navigation 
in Runtime. Screens are logged to a temporary list after they were called. You can page through 
this list using the "Forwards" and "Backwards" functions, for example, to recall the last five 
screens. The valid maximum number of entries in this list is set in the field "Screen selection 
memory". If this number is exceeded, the oldest entry is replaced after a new screen was called.

 

 Note

The list logs up to 30 screen calls if the default is set for "Screen selection memory". As a 
rule, it is not reasonable to substantially increase this value, since the switchover can only 
be done in single steps. You can achieve more efficient screen navigation using picture 
modules. 

 

Configuring cursor control

Introduction
You can configure object navigation without mouse using defined cursor control functions in 
screens with tabular layout of the objects.

Define the cursor control hotkeys and the cursor characteristic in the "Runtime Settings > 
Keyboard" editor.
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Procedure
Set up the operator hotkeys as follows:

1. Click in the input field of the selected function.

2. Click the  button in the selection list. The hotkeys dialog opens.

3. Define your hotkeys.

4. Click the  button to close the dialog.

You can also define single-key or a softkey <F1> - <F12> input instead of a hotkey.

Activating time synchronization

Introduction
To have the same time of day throughout the plant, you can synchronize the time on various 
plant components using time synchronization. WinCC time synchronization is operated as a 
master-slave system. 

One system component must be a clock for all components of a plant to work with identical 
time. The component functioning as the clock is referred to as the time master. The 
components that receive the time are time slaves.

The time master can be a computer or an external clock, such as a SICLOCK. This master 
transmits the time signal to the other components. Only one time master can be the active 
clock in the network. 

To prevent the failure of time synchronization, two components can be configured as the time 
master. The redundant time master is a time slave as long as the active time master is 
transmitting the time message frames.

The time slaves receive the time signal transmitted by the time master via the bus and thus 
synchronizes its time of day. 
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Time synchronization in Runtime
The time synchronization of the computer is entered in the start sequence of the computer for 
the following events:

● Running the OS project editor

● After configuration of the time synchronization

Activating time synchronization
Proceed as follows to activate time synchronization:

1. Select the "Properties" command from the shortcut menu in the project tree of Runtime and 
then select "Time synchronization > General".

2. Under "Synchronization", activate "Activate time synchronization".
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3. Under "Time settings", select the time source, for example, "No external time source".

4. Specify how often the time message frame should be transmitted by the time master.

Synchronization via the terminal bus
Proceed as follows to synchronize the time via the terminal bus:

1. Select the "Properties" command from the shortcut menu in the project tree of Runtime and 
then select "Time synchronization > Terminal bus".

2. Under "Synchronization", activate the "Activate" check box.

3. If you also want to synchronize redundant components, activate the "Synchronize 
redundant partners" check box.

4. Under "Server 1", select the server from which the HMI device should receive the time 
message frame as the time slave.

5. Click "OK" or configure the synchronization via the system bus.
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Synchronization via the system bus
Proceed as follows to synchronize the time via the system bus:

1. Select the "Properties" command from the shortcut menu in the project tree of Runtime and 
then select "Time synchronization > System bus".

2. Under "Synchronization", activate the "Activate" check box.

3. Activate the "Show symbolic names of access points" check box. Note: If you configure 
time synchronization from another computer, the installed access points are unknown. The 
symbolic names are shown, however, and assigned to the physical names of the access 
points when Runtime starts.

4. Under "Access point 1", select an access point and assign it a role as master or slave.

5. You also select a second access point under the following conditions:

– If you want to use a redundant device.

– If you want to synchronize two system buses via a "bridge".

– If you want to synchronize two system buses as the master.

6. Also assign this access point a role as master or slave. The combination of these roles 
defines the response as shown in the table below.
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Access point 1 Access point 2 Response
Slave Slave The device always functions as a time slave.
Master Master The device functions as a cooperative master at both access 

points. 
Master Slave The devices functions at access point 1 as the master and 

transmits time message frames; at access point 2 the device 
synchronizes with the time signals received there.

Slave Master The device functions at access point 2 as the master and 
transmits time message frames; at access point 1, the device 
synchronizes with the time signals received there.

Set time base

Setting the time base for the time of day
To set the time display on the HMI device, proceed as follows:

1. Select the "Properties > Time settings" command from the shortcut menu in the project tree.

2. Select one of the following options under "Time basis for time display in Runtime":

– Time zone of server (migrated projects)

– Local time

– Coordinated Universal Time

3. Select one of the following options for the display format of the date and time:

– "Configure individual components": If you want to display the date in the configured 
format.

– "Use ISO8610 format on all components": If you want to display the date in ISO8610 
format on all components.
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Loading a project

Overview
Various scenarios are possible for loading the project: 

● The Runtime software is installed on the same system as the configuration software.

● The Runtime software and the configuration software are installed on different systems. 
The project must be loaded from the configuration computer to the target system. The HMI 
devices must be connected to the configuration PC for the transfer. Another requirement 
is that the transfer mode must match on the HMI devices and in WinCC.

 

  Note

Security prompts may appear during the loading process, depending on the configuration. 
The recipe data and password list on the HMI device are overwritten following a prompt.

 

The configuration software and the Runtime software are installed on the same system
If the configuration software and the Runtime software are installed on the same system, 
proceed as follows: 

1. Create and compile your project.

2. Start Runtime directly from the active configuration software. Select the "Start Runtime" 
command from the "Online" menu.

3. You may test and operate the project online with the controller if you have configured the 
corresponding communication.

The configuration software and the Runtime software are installed on different systems
If the configuration software and the Runtime software are installed on different systems, 
proceed as follows: 

1. Create and compile your project. For additional information, refer to "Compiling a project".

2. To download the file via cable:
Connect the HMI device to the configuration computer using a standard cable to match the 
desired transfer mode and then switch on the HMI device.

3. Set the HMI device to transfer mode.
To start transfer mode, press the "Transfer" button in the Loader. You can also assign the 
system function "SetDeviceMode" to an operator control.

4. Load the project from the configuration computer to your target device. For further 
information, refer to "Loading projects".

 

  Note

If the HMI device is a PC, you can transfer the compiled file without using the loader, for 
example, via Ethernet. Double-click the corresponding file on your PC to start Runtime. 
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Starting Runtime on the Engineering Station

Introduction
You can start a project in Runtime on the configuration PC if Runtime has been installed. The 
project settings defined in the "Runtime settings" of the HMI device are activated when the 
project is started in Runtime.

 

 Note

You can only simulate HMI devices with Runtime Panels on the configuration PC. Select the 
"Online > Start simulation" menu command.

 

 Note
Ending Runtime automatically

If automatic transfer is activated on the HMI device and if a transfer is started on the 
configuration PC, the running project is automatically ended. 

The HMI device then switches autonomously to the "Transfer" operating mode.

Deactivate automatic transfer after the commissioning phase so that the HMI device does 
not inadvertently go into transfer mode.

Transfer mode can cause undesired reactions in the system.

In order to restrict access to the transfer settings and thus avoid unauthorized changes, enter 
a password in the control panel.

 

Requirement
● A project is open on the configuration PC.

● Runtime is installed on the configuration PC.

● There is no project in Runtime on the configuration PC.

Procedure         
To start runtime on the configuration PC, follow these steps:

1. Select the desired HMI device in the project navigation.

2. Select the "Online > Start Runtime" menu command.

Result
Runtime is started and the project is displayed on the configuration PC. 
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Starting Runtime Professional

Introduction             
Runtime in started on a configuration PC with installed WinCC Runtime via the WinCC menu 
bar. If only WinCC Runtime is installed on an HMI device, load the project to the HMI device. 
Use the "WinCC StartTool" for starting the project. 

Requirements
"WinCC Runtime" is installed on the HMI device. 

 

 Note

A least 100 MB free memory must be available on the storage medium before the Runtime 
of a project can be started.

 

 Note
Closing Runtime automatically

If automatic transfer is enabled on the HMI device and a transfer is started on the configuration 
PC, the running project is automatically stopped. 

The HMI device then switches autonomously to "Transfer" mode.

After the commissioning phase, disable the automatic transfer function to prevent the HMI 
device from switching inadvertently to transfer mode.

Transfer mode can cause undesired reactions in the system.

To block access to the transfer settings and thus avoid unauthorized changes, assign a 
password in the Control Panel.

 

Starting Runtime at an Engineering Station
1. Open the desired project in WinCC.

2. Select the "Start Runtime" command from the "Online" menu.

Result
The project is compiled and activated. During activation, all Runtime services that you selected 
in the Runtime settings of the HMI devices are started. 

Testing a project

Introduction
The following options of test WinCC projects are available:
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Testing projects on the configuration computer.

● Simulator
The Simulator is used to simulate WinCC projects with internal tags and process tags. For 
additional information, refer to "Simulating projects".
Tests supported by the Simulator:

– Offline testing of a configuration without connection to a PLC.

– Online testing of a configuration with connection to a PLC and inactive process.

– Implementation of a demo project.

● Script debugger
The script debugger tests your scripts in Runtime to find logical programming errors. For 
additional information, refer to "Working with the Debugger".

Procedure
The following steps show the basic procedures for simulating a project offline without PLC 
connection. 

1. Start by creating a project as it is going to be run later with an interconnected PLC.

2. Save the project.

3. Select the HMI device in the project navigator.

4. Start the Simulator directly from the active configuration software. Select "Online > Simulate 
Runtime > With tag simulator".
If simulating the project for the first time, the simulator is started with a new, empty 
simulation table. If you have already created a simulation table for your project, it will be 
opened. 
The simulation table "*.sim" contains all your settings for the simulation of tags and flags. 

5. Make any changes to the tags and area pointers of your project in the simulation table.
Toggle between the simulation table and Runtime using the <ALT+TAB> key shortcut.
Save your simulation settings with "File > Save." Assign the file a meaningful name. The 
file name is automatically assigned the extension "*.sim".

Closing a project

Introduction
You define the steps in closing Runtime in the user program: 
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Procedure
Exit Runtime as follows:

1. When Runtime is running in window mode, you can close it by clicking the icon .

2. When Runtime is running in full-screen mode, you can close it by means of the program 
switching function and the Task Manager.

3. When Runtime is running in full-screen mode and program switching is disabled for the 
project, the closing sequence of Runtime must be configured separately. Actuate the 
relevant button to close Runtime.

10.14.3 Operating projects

10.14.3.1 Basics

Overview

Operation options
The hardware determines how you can operate the HMI device:

● Touch screen
The operating elements shown in the dialogs are touch-sensitive. Touch objects are 
basically operated in the same way as mechanical keys. You activate operating elements 
by touching them with your finger. To double-click them, touch an operating element twice 
in succession.

● HMI device keyboard
The operating elements shown in the screens are selected and operated using the keys of 
the HMI device.

● External keyboard

● External mouse

Operation feedback from operating elements     
The HMI device provides optical feedback as soon as it detects that an operating element has 
been selected. The operating element receives the focus and is selected. This selection is 
independent of any communication with the PLC. Therefore this selection does not indicate 
whether the relevant action is actually executed or not.

The configuration engineer can also configure the selection of an operating element so that it 
deviates from the standard.
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Optical feedback from operating elements    
The type of optical feedback depends on the operating element: 

● Buttons
The HMI device outputs different views of the "Pressed" and "Unpressed" states, provided 
the configuration engineer has configured a 3D effect:

– "Pressed" state:

– "Unpressed" state:

The configuration engineer determines the appearance of a selected field, for example, line 
width and color for the focus.

● Invisible buttons
By default, invisible buttons are not displayed as pressed when they are touched. No optical 
operation feedback is provided in this case.
The configuration engineer may, however, configure invisible buttons so that their outline 
appears as lines when touched. This outline remains visible until you select another 
operating element.

● I/O fields
When you select an I/O field, the content of the I/O field is displayed against a colored 
background. With touch operation, a screen keyboard is displayed for the entering of values. 

Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the I/O area of a SIMATIC S7. 

Direct keys enable operations with short reaction times that are, for example, a jog mode 
requirement. 

 

 Note

Direct keys are still active when the HMI device is in "offline" mode. 
 

 Note

If you operate a function key with direct key functionality in a running project, the direct key 
function is always executed, independent of the current screen contents.
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 Note

You can only use direct keys when there is a connection via PROFIBUS DP or PROFINET IO.

Direct keys result in additional basic load on the HMI device.
 

Direct keys
The following objects can be configured as a direct key: 

● Buttons

● Function keys

You can also define image numbers in the case of HMI devices with touch operation. In this 
way, the project engineer can configure the direct keys on an image-specific basis.

For additional information on configuring direct keys, refer to "WinCC  Communication." 

Touch operation

Overview

Screen keyboard
When you touch an operating element requiring entry on the HMI device touch screen, a screen 
keyboard appears. The screen keyboard is displayed in the following cases: 

● An I/O field is selected for input.

● A password must be entered for accessing a password-protected function.

The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen 
keyboards for entering numerical or alphanumerical values.

 

 Note

The screen keyboard display is independent of the configured project language.
 

General procedure
The operating elements of a screen are operated by touching the touch screen.

Proceed as follows:
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1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can be 
found under the respective operating element.
Examples:

– I/O field: Enter numerical, alphanumeric or symbolic values in the I/O field.

– Symbolic I/O field: Select an entry from the drop down list box.

– Slider control: Move the slider control.

Procedure for input fields
Values are entered in the project input fields. Based on your configuration, the values are 
saved to tags and transferred, for example, to the PLC.

Proceed as follows:

1. Touch the desired input field within the screen.
The screen keyboard opens. 
Depending on your configuration, you can enter values in the input field in the following 
manner:

– Numerical values, for example decimal numbers, hexadecimal numbers, binary values

– Alphanumerical values, for example digits and letters

– Date/time

2. Enter the value.

3. Confirm your entry with  or discard your entry using the button .

Entering and editing numerical values

Numerical screen keyboard  
When you touch an operating element for numerical input on the HMI device touch screen, 
the numerical screen keyboard appears. This is the case, for example, for an input field. The 
screen keyboard is automatically hidden again when input is complete. 

Figure 10-12 Numerical screen keyboard
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 Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen", has no effect.
 

Display formats for numerical values   
You can enter values of the following format type in numerical input fields: 

● Decimal

● Hexadecimal

● Binary

Limit test of numerical values   
Tags can be assigned limits. The current limits are indicated in the numerical screen keyboard. 
If you enter a value that lies outside of this limit, it will not be accepted, for example, 80 with a 
limit value of 78. In this case the HMI device will deliver a system event, if an alarm window is 
configured. The original value is displayed again.

Decimal places for numerical values   
The configuration engineer can define the number of decimal places for a numerical input field. 
The number of decimal places is checked when you enter a value in this type of I/O field.

● Decimal places in excess of the limit are ignored.

● Empty decimal places are filled with "0".

Procedure   
Numerical and hexadecimal values can be entered character-by-character via the buttons on 
the numerical screen keyboard. 

Proceed as follows:
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1. Touch the desired operating element within the screen.
The numerical screen keyboard opens. The existing value is displayed in the screen 
keyboard and is selected.

2. Enter the value.
You can only operate keys that are required for entering values. The keys with letters cannot 
be used, for example, for entering a decimal value. Which keys can be operated can be 
seen from the appearance of the keys.
You have the following options to enter a value:

– The selected value is deleted when you enter the first character. Completely reenter the 
value.

– Use the  and  keys to move the cursor within the current value. You can 
now edit the characters of the current value or add characters.
Use the  key to delete the next character to the left of the cursor. If the value is 
selected, use this key to delete the selected part of the value.

– Change the sign of the value using the  key.

– Use the  key to display the tooltip of the I/O field.
This key is only enabled if a tooltip was configured for the input object or for the current 
screen. 

3. Use the  key to confirm your entry or cancel it with . Either action closes 
the screen keyboard.

Result
You have changed the numerical value or entered a new one. 

Entering and editing alphanumerical values

Alphanumerical screen keyboard  
When you touch an operating element for numerical input on the HMI device touch screen, 
the alphanumerical screen keyboard appears. This is the case, for example, for an input field. 
The screen keyboard is automatically hidden again when input is complete. 

Figure 10-13 Alphanumerical screen keyboard, normal level
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 Note
Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen", has no effect.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard. 
The entry of Cyrillic or Asian characters is therefore not possible.  

 

Keyboard levels 
The alphanumerical screen keyboard has various levels. 

● Normal level

● Shift level

The key labels change when you change levels with the  key.

Procedure   
Alphanumerical values can be entered character-by-character via the buttons on the 
alphanumerical screen keyboard. 

Proceed as follows:

1. Touch the desired operating element within the screen.
The alphanumerical screen keyboard opens. The existing value is displayed in the screen 
keyboard and is selected.

2. Enter the value.
You have the following options to enter a value:

– The selected value is deleted when you enter the first character. Completely reenter the 
value.

– Use the  and  keys to move the cursor within the current value. You can 
now edit the characters of the current value or add characters.
Use the  key to delete the next character to the left of the cursor. If the value is 
selected, use this key to delete the selected part of the value.

– Use the  key to toggle between keyboard levels of the screen keyboard. On 
switchover, the key assignment of the screen keyboard changes.

– Use the  key to display the tooltip of the I/O field.
This key is only enabled if a tooltip was configured for the input object or for the current 
screen. 

3. Use the  key to confirm your entry or cancel it with . Either action closes 
the screen keyboard.

Result
You have changed the alphanumeric value or entered a new one. 
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Display tooltip

Purpose   
The configuration engineer uses tooltips to provide additional information and operating 
instructions. The configuration engineer can configure tooltips for screens and operating 
elements. 

The tooltip of an I/O field may, for example, contain information about the value to be entered. 

Figure 10-14 Tooltip for an I/O field, example

Opening tooltips for operating elements
1. Touch the required operating element.

The screen keyboard opens. The representation of the  key indicates whether a 
tooltip was configured for the operating element or for the current screen.

2. Touch the  key of the on-screen keyboard.
The tooltip for the operating element is displayed. If there is no tooltip for the selected screen 
object, the tooltip for the current screen is displayed if it has been configured.
You can scroll through the contents of long tooltips using the   and  buttons.

 

  Note
Switching between displayed tooltips  

The configuration engineer can configure a tooltip for an I/O field and the associated 
screen. You can switch between two tooltips by touching the tooltip window. 

 

3. Close the displayed tooltip by pressing .

Alternative procedure
Depending on your configuration, tooltips can also be called via a configured operating 
element. 

Additional information on this topic may be available in your plant documentation. 
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Key operation

Control keys

Introduction     
The following tables list the control keys available to operate the project. For detailed 
information, refer to the description of the individual operating elements.

 

 Note

The availability of system keys is determined by the HMI device used. 
 

Selecting operating elements

Key Function Description

+ 
Tabulator       Selects the next or previous operating element 

based on the configured tab sequence.

Cursor keys     Selects the next operating element on the left, right, 
above or below the current screen object.
Navigates in the operating element.

Operating operating elements     

Key Function Description
+ 
 + 
 + 
 + 

Positioning cursor Positions the cursor within an operating element, for 
example, in an I/O field.

Scrolling back         Scrolls the list back by one page.
+ Scroll to start Scrolls to the start page of a list.

Scrolling up         Scrolls the list up by one page.
+ Scroll to end Scrolls to the end of a list.
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Key Function Description
ENTER key       ● Controls buttons.

● Applies and ends an entry.
● Opens a selection list.
● Toggles between character mode and standard 

mode within an input field.
A single character is selected in character mode. 
In this mode, you can scroll within the character 
set using the cursor keys.     

Cancel       ● Deletes the input characters of a value and 
restores the original value.

● Closes the active dialog.
Delete characters     Deletes the next character to the right of the current 

cursor position.
Delete characters       Deletes the character to the left of the current cursor 

position.
+ Open selection list     Opens a selection list.
+ Accept value Accepts the value selected in the selection list 

without closing the list.

Enter hotkey

Key Function Purpose
Toggle (numbers/letters)   Toggles the assignment from numbers to letters.

● No LED is lit:
The number assignment is enabled. Pressing 
the key once switches to letter assignment.

● An LED is lit:
The left or right letter assignment is enabled. 

Each time the key is pressed, the system toggles 
between the left letter assignment, the right letter 
assignment and the number assignment.       

Shift
(upper/lower case)   

Use in hotkeys, for example, for switching to 
uppercase letters.

Toggle to additional keyboard 
layout 

Some of the keys contain a blue special character 
on their bottom left corner, for example, the "%" 
character. To input these characters, press the 
relevant key in combination with the special 
character key shown on the left.

General control function   Used in hotkeys, for example, for navigating trend 
views.

General control function   Used in hotkeys, for example, for the "Status/Force" 
screen object.
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Acknowledge alarms

Key Function Purpose
Acknowledge     Acknowledges the currently displayed error alarm 

or all alarms of an alarm group (group 
acknowledgment).   
The LED is lit as long as an unacknowledged alarm 
is active.   

 

Displaying infotext     

Key Function Description
Display tooltip     Opens the configured tooltip for the selected object, 

for example, alarm or I/O field. The LED is lit if a 
tooltip is available for the selected object. 

Function keys

Function keys
Function key assignment is defined during configuration. The configuration engineer can 
assign function keys globally and locally.

Function keys with global function assignment
A globally assigned function key always triggers the same action on the HMI device or in the 
PLC irrespective of the screen displayed. Such an action could be, for example, the activation 
of a screen or the closure of an alarm window.

Function keys with local function assignment
A function key with local function assignment is screen-specific and is therefore only effective 
within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one. 
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate 
operating elements with function keys, for example, the alarm view, trend view, recipe view or 
status / force. 
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General procedures

Introduction
The control keys and function keys of the HMI device are available for key operation. 

General procedure 
The operating elements of a screen are operated using the control keys of the HMI device.

Proceed as follows:

1. Continue pressing the  key or the cursor keys until the required operating element is 
selected in the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can be 
found under the respective operating element.
Examples:

– I/O field: Enter numerical, alphanumeric or symbolic values in the I/O field.

– Slider control: Move the slider control.

3. Confirm the your entry with  or cancel it with .

Entering and editing numerical values

Display formats for numerical values 
You can enter values of the following format type in numerical input fields: 

● Decimal

● Hexadecimal

● Binary

Limit test of numerical values 
Tags can be assigned limits. If you enter a value that lies outside of this limit, it will not be 
accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver a 
system event, if an alarm window is configured. The original value is displayed again.

Procedure
Numerical and hexadecimal values can be entered in character mode using the system keys. 

Proceed as follows:
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1. Select the input field within the screen using the  key.
The existing value is selected in the input field. 

2. Enter the value using the numerical keypad.
You have the following options to enter a value:

– The existing value is deleted when you enter the first character. Completely reenter the 
value.

– Press  and a cursor key simultaneously. This step cancels the field content selection. 
Move the cursor in the existing value. You can now edit the characters of the current 
value or add characters.
The  key deletes the next character to the right of the cursor. Use the  key to 
delete the next character to the left of the cursor. 
To enter the hexadecimal characters "A" to "F", switch the numerical keypad to alphabet 
mode using the  key.

– The lit LED of the  key indicates that a tooltip is available for the selected object or 
the active screen.
Use the key  to view the tooltip for the operating element or active screen.

3. Confirm your entry with the  key.

Result
You have changed the numerical value or entered a new one. 

Entering and editing alphanumerical values

Procedure
Alphanumerical values can be entered in character mode using the system keys. 

Proceed as follows:

1. Select the input field within the screen using the  key.
The existing value is selected in the input field. 

2. Enter the value using the system keys.
You have the following options to enter a value:

– The existing value is deleted when you enter the first character. Completely reenter the 
value.

– Press  and a cursor key simultaneously. This step cancels the field content selection. 
Move the cursor in the existing value. You can now edit the characters of the current 
value or add characters.
The  key deletes the next character to the right of the cursor. Use the  key to 
delete the next character to the left of the cursor. 
Switch the numerical keypad to alphabet mode using the  key to enter letters. 

– The lit LED of the  key indicates that a tooltip is available for the selected object or 
the active screen.
Use the key  to view the tooltip for the operating element or active screen.

3. Confirm your entry with the  key.
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Result
You have changed the alphanumeric value or entered a new one. 

Enter characters using the alphanumeric keyboard
Using the same keys of the alphanumeric keyboard you can enter up to six different characters. 
The entry result depends on the combination of the keys pressed.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key  of the keyboard. 
Use the keys ,  and  to select the key mode.

The following table shows the entry options using the key .

Key Key Key Result
No LED is lit. Not relevant Not pressed 5
Left LED is illuminated. Not pressed Not pressed m
Left LED is illuminated. Pressed Not pressed M
Right LED is illuminated. Not pressed Not pressed n
Right LED is illuminated. Pressed Not pressed N
Not relevant Not relevant Pressed %

Display tooltip

Use   
The configuration engineer uses tooltips to provide additional information and operating 
instructions. The configuration engineer can configure tooltips for screens and operating 
elements. 

The tooltip of an I/O field may, for example, contain information about the value to be entered. 

Figure 10-15 Tooltip for an I/O field, example

The lit LED of the  key indicates that a tooltip was configured for the selected screen object 
or for the active screen.
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Procedure
Proceed as follows:

1. Press the  key.
The tooltip for the selected screen object is displayed. If there is no tooltip for the selected 
screen object, the tooltip for the current screen is displayed if it has been configured.
You can scroll the contents of longer tooltips using the cursor keys  and .

 

  Note
Switching between displayed infotext  

The configuration engineer can configure a tooltip for an I/O field and the associated 
screen. You can switch between two tooltips by pressing the   key.

 

2. Close the tooltip by pressing the  key.

Alternative procedure
Depending on your configuration, tooltips can also be opened with a function key or via an 
existing operating element. 

Additional information on this topic may be available in your plant documentation. 

Mouse and keyboard operation

Operation with the keyboard
The navigation options listed in the table can be used for keyboard operations in a screen.     

Navigation PC SIMATIC Panel PC
Next field right/left <Shift+Right> / <Shift+Left> <Right> / <Left>
Next field up/down <Shift+Down> / <Shift+Up> <Down> / <Up>
To the right/left in the field <Right> / <Left> <Shift+Right> / <Shift+Left>

The other keys have identical functions on the PC and the SIMATIC Panel PC: 
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Key Function
<Enter> Applies a value (e.g. in unmarked input fields) or opens a 

selection list. 
If the I/O field is marked (highlighted in color), 
WinCC Runtime will switch to the special editing mode. Only 
one character at any time is marked in the field. 
Use the cursor keys <Up>/<Down> to scroll through a 
character table. 
Use the cursor keys Right/Left to move the cursor to the next 
or previous entry position. 
Press <Enter> or <Esc> to exit from the entry mode. The 
characters entered up to this point will be either applied or 
discarded. 

<Esc> Interrupts the input.
<Tab> Selects the next available screen object in the configured tab 

sequence. 
<Shift+Tab> Selects the previously available screen object in the 

configured tab sequence. 
<F1> -... <F12>, 
<Shift+F1>, ..., <Shift+F12>

On the PC: Triggers a function, e.g. screen selection. 

<F1>, ... or <S1>, ... or <K1>, ... On the SIMATIC Panel PC: triggers a global or local function. 

 
 

 CAUTION

If you press a function key after a screen change, the associated function in the new screen 
may be triggered before the new screen is fully displayed.

 

Controlling Windows with the keyboard
You may also use the keyboard to control the operating system of your HMI device. See your 
Windows manual for detailed information. The most important key combinations for SIMATIC 
Panel PCs are listed in the following table. 

Navigation HMI device
Open start menu <Ctrl+Esc>
Show the shortcut menu of the selected element <Shift+F10>
Select all <Ctrl+A>
Display properties of the selected element <Ctrl+Enter>
Explorer:  
Change folder <F4>
Change display areas <F6>
Enable menu bar <F10>
Dialogs:  
Go to next field <Tab>
Back to previous field <Shift+Tab>

Visualize processes
10.14 Operating in Runtime

WinCC Professional V13.0
System Manual, 02/2014 7095



Navigation HMI device
Open next tab <Ctrl+Tab>
Open previous tab <Ctrl+Shift+Tab>

Operation with the mouse
A lightning symbol attached to the mouse pointer indicates that the screen object, for example 
a switch, may be operated with the mouse.     

 

 Note

If a screen object is covered by another, e.g. a button from a rectangle with a transparent fill, 
it is not possible to operate with the mouse in runtime.

The screen object can be operated with the keyboard.
 

10.14.3.2 Setting the project language

Introduction
The HMI device supports multilingual projects. You must have configured a corresponding 
operating element which lets you change the language setting on the HMI device during 
runtime. 

The project always starts with the language set in the previous session.

Requirement
● The required language for the project must be available on the HMI device.

● The language switching function must be logically linked to a configured operating element 
such as a button.
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Selecting a language
You can change project languages at any time. Language-specific objects are immediately 
output to the screen in the new language when you switch languages.

The following options are available for switching the language:

● A configured operating element switches from one language to the next in a list.

● A configured operating element directly sets the desired language.

10.14.3.3 Project security 

Overview

Design of the security system 
The configuration engineer can protect the operation of a project by implementing a security 
system. 

The security system is based on authorizations, user groups and users. 

If you use an operator control with access protection, the HMI device first requests that you 
log on. A logon screen is displayed in which you enter your user name and password. After 
logging on, you can operate the operator controls for which you have the necessary 
authorizations. 

The logon dialog can be set up by the configuration engineer via an individual operator control. 

In the same way, the configuration engineer can set up an operator control to log off. After 
logging off, objects assigned access protection can no longer be operated; to do so, log on 
again. 

User groups and authorizations  
Project-specific user groups are created by the configuration engineer. The "Administrators" 
and "Users" groups are included in all projects by default. User groups are assigned 
authorizations. Authorization required for an operation is specifically defined for each individual 
object and function in the project.

Users and passwords   
Each user is assigned to exactly one user group. 

The following people are allowed to create users and assign them passwords: 

● The configuration engineer during configuration

● The administrator on the HMI device

● A user with user administration authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.
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Logoff times 
A logoff time is specified in the system for each user. If the time between any two user actions, 
such as entering a value or changing screens, exceeds this logoff time, the user is automatically 
logged off. The user must then log on again to continue to operate objects assigned access 
protection.

Backup and restore      
The user data is encrypted and saved on the HMI device to protect it from loss due to power 
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be 
backed up and restored. This prevents you having to enter all of the data again on another 
HMI device. 

 

 Note

The currently valid user data is overwritten in the following cases:
● Depending on settings for a new download of the project.
● Upon restore of a backed-up project
● Upon import of the user administration via an operator control. The newly downloaded or 

restored user data and passwords take effect immediately.
 

Displaying users

User view

Use
The user view is used by the administrator to manage user accounts, group assignments and 
user passwords.         

Users can change their passwords and logoff times.
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Layout
The user view contains four columns for the user, password, group and logoff time. The 
passwords are encrypted by means of asterisks.     

● All users on the HMI device are displayed in the User view to the administrator or to a user 
with administrator authorizations.

● When user administration authorization is lacking, only the personal user entry is displayed.

Operation
Depending on the configuration you can:     

● Manage users, e.g. create, delete.

● Change existing user data.

● Export or import user data.
 

  Note

On an HMI device the number is limited to 100 users and one PLC user. This restriction 
does not apply to PCs. On a PC, the maximum number of users is restricted by the physical 
memory. 

 

Runtime behavior
The user view on the HMI devices OP 73, OP 77A and TP 177A also displays the "PLC User" 
with administrator privileges who is logged on in Runtime.

Changing existing user data   
The following options are available for the changes that can be made:

● The administrator or a user with user administration authorization can change the data for 
all users on the HMI device system in the user view.

– User name

– Group assignment

– Password

– Logoff times

● A user without user administration authorization can only change their own user data:

– Password

– Logoff time
 

  Note

If you enter the value "0" in the logoff time, user is not logged off automatically.
 

Visualize processes
10.14 Operating in Runtime

WinCC Professional V13.0
System Manual, 02/2014 7099



Export or import user data
A user view contains all users, passwords, group assignments and logoff times set up on the 
HMI device. To not have to enter all data again on another HMI device, you can export the 
user view and then import it to another device. But you can only do this if this function has 
been configured.     

 

 Note

Do not export the password list immediately after changing it. Exit the "User view" object after 
making changes and wait until the changes have been written to the internal Flash memory 
before performing the export.

 

 Note

The currently valid user data are overwritten during an import. The imported user data and 
passwords are valid immediately.

 

Simple user view

Use   
On HMI devices with a small display, the simple user view is used to display users on the HMI 
device. 

 

 Note

The "Simple user view" object cannot be operated dynamically with a script.
 

Layout
The appearance depends on the authorizations. 

● All users on the HMI device are displayed in the User view to the administrator or to a user 
with administrator authorizations.

● When user administration authorization is lacking, only the personal user entry is displayed.  
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Operation  
Depending on the configuration you can:

● Manage users, e.g. create, delete.

● Change existing user data.

● Export or import user data.
 

  Note

On an HMI device the number is limited to 100 users and one PLC user. This restriction 
does not apply to PCs. On a PC, the maximum number of users is restricted by the physical 
memory. 

 

User login

Touch and key operation

Logon dialog    
Use the logon dialog to log on to the security system of the HMI device. Enter your user name 
and password in the logon dialog. 

The logon dialog opens in the following cases: 

● You use an operator control with access protection.

● You press an operator control that was configured for displaying the logon dialog.

● You enable the "<ENTER>" entry in the simple user view.

● You enable a blank entry in the extended user view.

● The logon dialog will be automatically displayed when the project is started, depending on 
the configuration.

Requirement
The logon dialog is open.
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Procedure for touch operation
Proceed as follows:

1. Enter the user name and password.
Touch the corresponding input field. The alphanumerical screen keyboard is displayed. 

2. Select "OK" to confirm logon.

Procedure for key operation
Proceed as follows:

1. Select the "User" input field within the logon dialog by pressing the  key.

2. Enter the user name using the system keys.
Switch the numerical keypad to alphabet mode using the  key to enter letters. 

3. Use the  key to select the "Password" input field.

4. Enter the password using the system keys.

5. Confirm your entries with "OK".
 

  Note

The user name is not case sensitive. 

The password is case sensitive. 
 

Result
After successful logon to the security system, you can execute functions on the HMI device 
which are access protected and for which you have authorization.

An alarm is output if an incorrect password has been entered and if an alarm view was 
configured. 

Mouse and keyboard operation

Requirement    
The logon dialog is open.

Procedure for mouse operation
Proceed as follows:

1. Click in the input field. The alphanumerical on-screen keyboard is displayed.

2. Enter the user name and the password.

3. Click "OK" in the logon dialog.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the "Users" input field is selected.

2. Enter the user name and the password.

3. Confirm your entries with "ENTER."
 

  Note

The user name is not case-sensitive. 

The password is case-sensitive. 
 

Result
After successful logon to the security system, you can execute functions on the HMI device 
which are access protected and for which you have authorization.

An alarm is output if an incorrect password has been entered and if an alarm view was 
configured. 

User logoff

Requirement
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:

● You press an operator control that was configured for logoff.

● You will be logged off automatically if you are not operating the project and if the logoff time 
has been exceeded.

You will also be automatically logged off if you enter an incorrect password. 

Result
You are no longer logged into the project. In order to use an operator control with access 
protection, you first have to log on again. 
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Creating users

Key operation 

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator. 

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Select the user view using the key TAB  or using the cursor keys.

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with ENTER .
The following dialog opens:

3. Enter the desired user name using the system keys.

4. Select the next text box with the TAB  key and enter a password using the system keys.

5. Confirm your entries with "OK."
The following dialog opens:
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6. Select the "Group" selection box with TAB .

7. Assign the user to a group.

– Select ENTER  to open the drop down list box. The drop down list box opens.

– Select the required entry using   or .

– Confirm your entry by pressing the key ENTER .

8. Select the text box "Logoff time" with TAB .

9. Enter the desired logoff time using the system keys.
Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

10.Confirm your entries with "OK."

Creating users in the advanced user view
Proceed as follows:

1. Select the user view with the TAB  key via the configured tab order.

2. Select a blank line with the  or  keys.

3. Select the desired field in the blank line of the user view with the  or  keys.

4. Confirm your entry by pressing the key ENTER .

5. Enter the desired user data:

– Enter the data using the system keyboard. To enter letters, switch the numerical keypad 
to letter assignment using the key A-Z .

– Assign the user to one of the groups from the drop down list box. Open the drop down 
list box with the ENTER  key and select the desired entry with the  or  keys.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

6. Confirm your entry by pressing the key ENTER .

Result
The new user is created. 
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Touch operation

Requirement  
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is created in the 
Engineering System. The designation of the user group is language-dependent.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Click the "<New user>" entry in the user view. A dialog opens.

2. Enter the desired user name and password.
Touch the corresponding text box. The alphanumerical on-screen keyboard is displayed.

3. Click on the text box of the group. A dialog opens.

4. Assign the user to a group. Select  and  to scroll the selection list.

5. Touch the required entry in the drop down list box.
The selected entry is accepted as input.

6. Touch the text box "Logoff time". The on-screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with "OK."

Result
The new user is created. 

Visualize processes
10.14 Operating in Runtime

WinCC Professional V13.0
7106 System Manual, 02/2014



Operation with the mouse

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "

 

Creating users in the simple user view
Proceed as follows:

1. Click the "<New User>" entry in the user view.
The following dialog opens:

2. Enter the desired user name and password.
Click in the corresponding input field. The alphanumerical on-screen keyboard is displayed.

3. Click "OK".
The following dialog opens:

4. Assign the user to a group.

5. Click the required entry in the selection list.
The selected entry is accepted as input.
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6. Click in the "Logoff time" input field. The on-screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with "OK."

Creating users in the advanced user view
Proceed as follows:

1. Double-click the desired field in the blank line of the user view.
The corresponding on-screen keyboard is displayed. 

2. Enter the respective user data in the field:

– Assign the user to one of the groups from the drop down list box.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

Result
The new user is created. 

Operation with the keyboard

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.

● A user group has been created.
 

  Note

Runtime users must be assigned to a user group. The user group is set up in the 
Engineering System. The user group name is language-specific.

 

  Note

The following characters cannot be used in passwords:
● Blanks
● Special characters * ? . % / \ ' "
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Creating users in the simple user view
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select the "<New user>" entry in the user view using the cursor keys and confirm it 
with <ENTER>.
The following dialog opens:

3. Enter the user name.

4. Press the <Tab> key to move to the next input field and enter a password.

5. Confirm your entries with <ENTER>.
The following dialog opens:

6. Select the "Group" selection list using the <TAB> key.

7. Assign the user to a group.

– Press <ENTER> to open the selection list. The drop down list box opens.

– Select the entry. Use the <Home>,<End>,<Up> and <Down> keys accordingly.

– Confirm the selection with <ENTER>.

8. Change to the "Logoff time" input field using the <TAB> key.

9. Enter the desired logoff time.
Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

10.Confirm your entries with <ENTER>.

Creating users in the advanced user view
Proceed as follows:

1. Press the <TAB> key until the user view is selected.

2. Select an empty line in the user view using the cursor keys.

3. Select the desired field in the empty line of the user view. Use the <Up> and <Down> keys 
accordingly.

4. Confirm the selection with <ENTER>.
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5. Enter the desired user data:

– Enter the user name and the password.

– Assign the user to one of the groups from the drop down list box. Open the selection 
list by pressing <ENTER> and then select the entry using the <Up> and <Down> cursor 
keys.

– Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic 
logoff."

6. Confirm your entries with <ENTER>.

Result
The new user is created. 

Changing user data

Touch operation

Requirement
The user view is open.

Your authorization level determines the data you can change:
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● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user management authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Changing user data in the advanced user view
Proceed as follows:

1. In the user view, touch the user whose user data you want to change.

2. When entering the data, use exactly the same procedure as for creating a user.

Result
User data have been changed. 
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Key operation

Requirement
The user view is open.

Your authorization level determines the data you can edit:

● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user administration authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. In the user view, use the cursor keys to select the user whose user data you want to change. 
Confirm your entry by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.
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Changing user data in the advanced user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. Use the cursor keys to select the field in which you want to change data. Confirm your entry 
by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.

Result
User data have been changed. 

Operation with the mouse (Advanced, Professional)

Requirement    
The user view is open.

Your authorization level determines the data you can edit:

● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user administration authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.
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Changing user data in the simple user view
Proceed as follows:

1. Double-click on an empty line in the "User" column of the user view. 
The "Logon" window opens. 

2. Enter the desired user name and password.

3. To do this, click in the corresponding input field. The alphanumerical screen keyboard is 
displayed.

4. Confirm your entries with the "OK" button.

5. Assign the user to a group.

6. Click in the "Logoff time" input field. The screen keyboard is displayed.

7. Enter a logoff time between 0 and 60 minutes. The value 0 stands for "no automatic logoff."

8. Confirm your entries with the "OK" button. 

Keyboard operation (Advanced, Professional)

Requirement
The user view is open.

Your authorization level determines the data you can edit:
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● You are an administrator or a user with user administration authorization. In these cases 
you are allowed to change the data for all the users on the HMI device in the user view:

– User name

– Group assignment

– Password

– Logoff time

● You are a user without user administration authorization. In this case you are only allowed 
to change your personal user data:

– Password

– Logoff time, if configured
 

  Note

You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging 
on via the PLC.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime 
are not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Changing user data in the simple user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. In the user view, use the cursor keys to select the user whose user data you want to change. 
Confirm your entry by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.

Changing user data in the advanced user view
Proceed as follows:

1. Confirm your entry by pressing the key TAB .

2. Use the cursor keys to select the field in which you want to change data. Confirm your entry 
by pressing the key ENTER .

3. When entering the data, use exactly the same procedure as for creating a user.

Result
User data have been changed. 
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Deleting a user

Touch and key operation

Requirement    
● You have opened a screen that contains the user view.

● You must be logged on with administrator rights or be authorized for user management to 
delete users.

 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for touch operation
Proceed as follows:

1. Touch the user to be deleted in the user view.

2. Delete the user name.

Procedure for key operation
Proceed as follows:

1. Select the user view using the  key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press  to delete the user.

Result
The user has been deleted and may no longer log onto the project. 
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Mouse and keyboard operation

Requirement
● The user view is open.

● You are either authorized for user administration or you are an administrator.
 

  Note

Changes in the user view are effective immediately in Runtime. Changes in Runtime are 
not updated in the Engineering System. 

When the user management is downloaded to the HMI device, all changes in the user 
view are overwritten.

 

Procedure for mouse operation
Proceed as follows:

1. Click the user to be deleted in the user view.

2. Delete the user name.

Procedure for keyboard operation
Proceed as follows:

1. Select the user view using the <TAB> key or the cursor keys.

2. Select the user in the user view by means of cursor keys.

3. Press <DEL> to delete the user.

Result
The user has been deleted and may no longer log onto the project. 

10.14.3.4 Operating recipes

Structure of a recipe

Recipes
The recipe collection for the production of a product family can be compared to a file cabinet. 
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet. 

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe, 
for example, for the flavors orange, grape, apple and cherry.
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① File cabinet Recipe collection Recipes for a fruit juice plant
② Drawer Recipe Orange flavored drinks
③ Drawer Recipe Grape flavored drinks
④ Drawer Recipe Apple flavored drinks
⑤ Drawer Recipe Cherry flavored drinks

Recipe data records
The drawers of the file cabinet are filled with suspension folders. The suspension folders in 
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example. 

① Drawer Recipe Product variants of apple flavored drinks
② Suspension 

folder
Recipe data record Apple drink  

③ Suspension 
folder

Recipe data record Apple nectar 

④ Suspension 
folder

Recipe data record Apple juice
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Elements
In the figure showing the file cabinet, each suspension folder contains the same number of 
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data 
record. All the records of a recipe contain the same elements. The records differ, however, in 
the value of the individual elements. 

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The records 
for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in production. 

Recipes in the project

Overview
If recipes are used in a project, the following components interact:

● HMI device recipe memory
Recipes are saved in the form of data records in the HMI device recipe memory. 

● Recipe view / recipe screen
On the HMI device, recipes are displayed and edited in the recipe view or in a recipe screen.

– The recipe data records from the internal memory of the HMI device are displayed and 
edited in the recipe view.

– The values of the recipe tags are displayed and edited in the recipe screen.
 

  Note

The same recipe tags can be configured in a variety of recipes. If you modify the value 
of a recipe tag, the synchronization changes the value of the recipe tag in all recipes. 

 

● Recipe tags
The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe 
values are stored in recipe tags. The point at which the recipe tag values are exchanged 
with the PLC depends on the configuration.
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Data flow
The following figure shows the data flow in a project with recipes:

① Editing, saving or deleting a recipe data record
② Display recipe data record
③ Synchronize or do not synchronize recipe tags
④ Display and edit recipe tags in the recipe screen
⑤ Write records from the recipe view to the PLC or read records from the PLC and display 

them in the recipe view.
⑥ Recipe tags are to the PLC online or offline
⑦ Export or import recipe data record to memory card

Operating recipes in Runtime Advanced and Panels

Displaying a Recipe

Displaying Recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view 
A recipe view is a screen object used to manage recipe data records. The recipe view shows 
recipe data records in tabular form. 

Depending on the configuration, the recipe view is displayed as follows: 
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● As enhanced recipe view

● As simple recipe view

The configuration engineer also defines which operator controls are displayed in the recipe 
view. Only the simple recipe view can be configured on the TP 177A.

Enhanced Recipe View
The figure below shows an example of the enhanced recipe view:

① Selection field for the recipe
② Selection field for the recipe data record
③ Element name

The element name designates a specific element in the recipe data record.
④ Display field

This show the number of the selected recipe or the selected recipe data record.
⑤ Value of the element 
⑥ Buttons for editing a recipe data record
⑦ Status bar for display of the status messages

Simple recipe view 
The simple recipe view consists of three areas:

● Recipe list

● Data record list

● Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on 
the configuration, the simple recipe view starts with the recipe list or data record list.

The figure below shows an example of the data record list:
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① Number of the recipe data record
② Recipe data records
③ Buttons for changing the displayed list and calling the menu

Display of Values
 

 Note
Changing the recipe data record in the background

Applies to the processing of a recipe data record: 
If values of the corresponding recipe data record are changed by a PLC job, the recipe view 
is not updated automatically. 

To update the recipe view, reactivate the respective recipe data record.
 

Recipe screen 
A recipe screen allows the correlation between the plant and the recipe data to be displayed 
in graphic form. The configuration engineer combines I/O fields and screen objects to form a 
custom input screen. The configuration engineer can distribute the I/O fields of a recipe over 
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe 
screen can be operated using buttons configured accordingly.

The figure below shows an example of the recipe screen:
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① Element names and corresponding values
The element name designates a specific element in the recipe data record.

② Buttons for editing a recipe data record
③ Modified recipe view
④ Buttons for transferring recipe data

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe 
values are exchanged with the PLC immediately or later via these tags. 

A configured recipe view can itself be a component of a recipe screen. You must synchronize 
the tags in order to synchronize data between the tags of the recipe screen and the recipe 
data records displayed in the recipe view. 

Recipe Values in the HMI Device and the PLC

Introduction
You can change the values of a recipe on the HMI device and therefore influence the 
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in different 
ways. 

● If you are editing recipes with a recipe view in your project, the values are saved in recipe 
data records.

● If you are editing recipes in a recipe screen in your project, the values are saved in recipe 
tags.

Differences may occur between the display values in the recipe view and the values saved in 
the associated tags in an ongoing project when you edit recipes with a recipe view and in a 
recipe screen. Synchronize the values of the recipe data records with the values of the recipe 
tags to prevent this effect. 

Synchronizing recipe tags
 

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Synchronization of the recipe tags depends on the configuration of the enhanced recipe view:
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● Automatic synchronization:
The values of the recipe view are synchronized with the associated recipe tags. In this case, 
changes to values in the recipe view have an immediate effect on the values of the 
associated recipe tags. The values are only synchronized, when an operating element that 
is outside the recipe view is operated. 

● Synchronization by the user:
The values of the recipe view and the associated recipe tags are not synchronized 
automatically. The project engineer has assigned the same function to the  button or 
to a different operator control in the recipe view. The recipe tags and the recipe view are 
only synchronized when you operate the buttons or the appropriate operator control.

Recipe Tags Online / Offline
The configuration engineer can configure a recipe so that changes to the values of the recipe 
tags do not have an immediate effect on the current process. 

Synchronization of the recipe values between the HMI device and the PLC depends on whether 
the configuration engineer has selected the settings "Tags online" or the setting "Tags offline" 
for a recipe.

● "Tags online":
This setting has the following effect:

– When you change recipe values in the recipe screen, these changes are applied 
immediately by the PLC and immediately influence the process.

– If recipe values are changed in the PLC, the changed values are displayed immediately 
in the recipe screen.

● "Tags offline":
With this setting, changed recipe values are not synchronized immediately between the 
HMI device and the PLC. 
In this case, the configuration engineer must configure operating elements for transferring 
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values 
are only synchronized between HMI device and PLC when you operate the appropriate 
operator control. 
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Operating the recipe view

Overview

Use
The recipe view is used to display, edit and manage data records.    

Operation
Depending on the configuration you can:   

● Creating, editing, copying or deleting recipe data records

● Synchronize recipe data records with the associated recipe tags

● Read recipe data records from or transfer to the PLC

Operator controls
The following operating elements can be configured in the recipe view:   

Button Hotkey Function
 The configured tooltip is displayed.

 + Creates a new recipe data record.
If a start value is configured, it is displayed in the input field.

 + Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

 + The recipe data record is saved under a different name 
regardless of the recipe view. A dialog box opens where you can 
enter the name.

 + The displayed recipe data record is deleted.
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Button Hotkey Function
 + The system always updates the current value of the recipe view 

with the latest recipe tag value.
When the value shown in the recipe view is more recent than the 
current recipe tag value, the system writes this value to the recipe 
tag.
"Synchronize tags" must be enabled in the recipe properties 
before you can use this function.

 + The values of the set recipe data record displayed in the recipe 
view are transferred to the PLC.

 + The recipe values from the PLC are displayed in the recipe view.

Mouse control or touchscreen control of the recipe view  
1. Select the recipe you want to use.

The data records of the recipe are displayed.

2. Click on the data record you wish to edit.

3. Press the button whose function you wish to execute.

Using the keyboard with the recipe view  
1. Press the <Tab> key until the "Recipe name" or "Data record name" field is activated.

2. Press <Enter>.
The selection list for the recipes or data records opens. 

3. Select a recipe or a data record from the list. Toggle between the next or previous entry by 
using the cursor keys <Left>, <Right>, <Up> and <Down>.

4. Press the <Tab> key until the operating element you wish to use is selected. You can also 
operate the recipe view via hotkeys.

Creating a recipe data record

Touch and key operation

Introduction
Create a new recipe data record by editing an existing data record.Save this data record under 
a new name. 

Requirement
A screen with a recipe view is displayed.
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Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Touch .
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Touch the button  .

5. Enter a name for the data record.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Press  + .
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Press  + .

5. Enter a name for the data record.

6. Confirm your input.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Result
The new recipe data records will be saved to the selected recipe. 

Mouse and keyboard operation 

Introduction   
Create a new recipe data record by editing an existing data record. Save this data record under 
a new name. 
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Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe for which you want to create 
a new recipe data record.

2. Click the button.
A new recipe data record with the next available number is created.
An existing data record is overwritten if you assign its number to a new data record.

3. Enter values for the data record elements.
The data record elements can be assigned default values, depending on the configuration.

4. Click the button.

5. Enter a name for the data record.
The data record is saved under the new name. 
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. If the recipe view contains several recipes: Press the <TAB> key until the recipe for which 
you are going to create a new data record is selected.

3. Press the <CTRL+Space> key shortcut to create a new recipe data record with the next 
available number.
An existing data record is overwritten if you assign its number to a new data record.

4. Enter values for the data record elements. The data record elements can be assigned 
default values, depending on the configuration.

5. Press the <CTRL+ENTER> key shortcut to save the recipe data record.

6. Enter a name for the data record. The data record is saved under the new name.
A dialog will open if the recipe data record already exists. In this dialog, define whether to 
overwrite the existing data record.

Result
The new recipe data records will be saved to the selected recipe. 

Visualize processes
10.14 Operating in Runtime

WinCC Professional V13.0
7128 System Manual, 02/2014



Editing recipe data records

Touch and key operation

Introduction
Edit the values of the recipe data records and save them in a recipe view. 

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view, you first have 
to read the current values from the PLC with .

You must transfer the data record to the PLC by pressing the  button to activate the changes 
you have made in the recipe view.

Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the recipe data 
record required.

2. Select the recipe data record you want to edit.

3. Edit the data record as required.

4. Press  to save the changes.
Touch the  key to save the recipe data record under a different name.

Procedure for key operation
Proceed as follows:

1. If the recipe list contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

2. Press the <TAB> key until the desired recipe data record is selected.

3. Edit the data record.

4. Press  to save the changes.
Touch the  key to save the recipe data record under a different name.

Result
The edited recipe data record is saved to the selected recipe. 
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Mouse and keyboard operation

Introduction   
Edit the values of the recipe data records and save them to a recipe view. 

Synchronization with the PLC
You must read the current values from the PLC by pressing the  button or the <CTRL+UP> 
key shortcut to display the current recipe values from the PLC in the recipe view.

You must transfer the data record you have edited to the PLC to activate the changes you 
have made in the recipe view by pressing the  button or the <CTRL+DOWN> key shortcut.

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the recipe data 
record required.

2. Select the recipe data record to be edited.

3. Edit the data record.

4. Click on  to save your changes.
Click the  button to save the recipe data record under a different name.

Procedure for keyboard operation
Proceed as follows:

1. If the recipe list contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

2. Press the <TAB> key until the desired recipe data record is selected.

3. Edit the data record.

4. Press the <CTRL+ENTER> key shortcut to save your changes.
Use the <CTRL + *> shortcut to save the recipe data record under a different name.

Result
The edited recipe data record is saved to the selected recipe. 
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Deleting recipe data records

Touch and key operation

Introduction
You can delete all recipe data records which are not required. 

Requirement
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Touch the button  .

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Press  + .

Result
The recipe data record is deleted. 

Mouse and keyboard operation

Introduction
You can delete all recipe data records which are not required. 

Requirement
A screen with a recipe view is displayed.
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Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record to be deleted.

3. Touch the button  .

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. If the recipe view contains several recipes: Press the <TAB> key until the recipe which 
contains the relevant data record is selected.

3. Select the recipe data record to be deleted.

4. Press the <CTRL+DEL> key shortcut to delete the data record.

Result
The recipe data record is deleted. 

Synchronize tags

Touch and key operation

Introduction
You can save the values of recipe elements to recipe tags, depending on your configuration. 

Differences may develop in your active project between the values displayed in the recipe view 
and the actual values of the tags. Synchronize the tags to compensate for such differences.

Synchronization encompasses all tags of a recipe data record.
 

 Note
Renamed tag

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.

 

 Note

Recipe tags can only be synchronized in the advanced recipe view.
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Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Touch the button  .

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Press  + .
 

Result
The values of the recipe data record are synchronized with the tag values. 

The most recently updated value is accepted if there is a difference between the values of the 
recipe view and the tag. 

Mouse and keyboard operation

Introduction
You can save the values of recipe elements to recipe tags, depending on your configuration. 

Differences may develop in your active project between the values displayed in the recipe view 
and the actual values of the tags. Synchronize the tags to compensate for such differences.

Synchronization encompasses all tags of a recipe data record.
 

 Note
Renamed tag

The tag and the value of the recipe data record cannot be associated if you have renamed 
the tag you want to synchronize. The tags in question are not synchronized.
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 Note

Recipe tags can only be synchronized in the advanced recipe view.
 

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record to be synchronized.

3. Click the button.

Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. You could also use the <CTRL+=> 
key shortcut for synchronizing.

Reading recipe data records from the PLC

Touch and key operation

Introduction
You can edit values which were saved to the recipes in the HMI device directly at plant level 
within the active project; this may be the case if a valve in the plant opens more than is indicated 
in the recipe. Inconsistency could have developed between the values of the recipe data 
records stored in the HMI device and the values in the PLC.

Read the values from the PLC and output these to the recipe view to synchronize the recipe 
values. 

Requirement
A screen with a recipe view is displayed.
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Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Touch the button  .
The values are read from the PLC.

4. Touch the button  to store the displayed values in the HMI device.

Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Press  + .
The values are read from the PLC.

4. Press the +  keys to store the displayed values in the HMI device.

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

Mouse and keyboard operation

Requirement
A screen with a recipe view is displayed.

Procedure for mouse operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which is to receive the values from the PLC.

3. Click the button.
The values are read from the PLC.

4. Click on  to store the displayed values in the HMI device.
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Procedure for keyboard operation
Proceed as follows:

1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. Press <Enter>.
You could also use the <CTRL+Down> key shortcut.

Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

Transferring recipe data records to the PLC

Touch and key operation

Introduction
You must transfer the values to the PLC to activate a changed recipe data record for the 
process. 

The values displayed in the recipe view are transferred to the PLC. 

Requirement
A screen with a recipe view is displayed.

Procedure for touch operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Touch the button  .
The values are transferred to the PLC.
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Procedure for key operation
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired 
recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Press  + .
The values are transferred to the PLC.

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 

Mouse and keyboard operation

Requirement
A screen with a recipe view is displayed. 

Operation with the mouse
1. If the recipe view contains several recipes: Select the recipe which contains the desired 

recipe data record.

2. Select the recipe data record which contains the values to be transferred to the PLC.

3. Click the button.
The values are transferred to the PLC.

Operation with the keyboard
1. Press the <TAB> key until the recipe view is selected.

2. Press <Enter>. The selection list opens. Select the recipe data record from the list.

3. Press the <TAB> key until the  button is selected. Press <Enter>. You could also use 
the <CTRL+Down> key shortcut.
The values are transferred to the PLC.

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 
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Using the simple recipe view

Overview

Layout
The simple recipe view consists of three areas:     

● Recipe list

● Data record list

● Element list

Figure 10-16 Simple recipe view - example with data record list

In the simple recipe view, each area is shown separately on the HMI device. You can use the 
shortcut menu to operate each of these display areas.

The simple recipe view always begins with the recipe list.

Operation    
You can use the simple recipe view as follows, depending on the configuration:

● Create, change, copy or delete recipe data records

● Read recipe data records from the PLC or transfer to the PLC

Operator controls of the simple recipe view 
Toggle between the display areas and the shortcut menus to operate the simple recipe views.

The table below shows the operation of the display area.

 Key Function
Touching an entry The next lowest display area is opened, i.e. the data record list or 

the element list.
The previous display area opens. 
The shortcut menu of the display area opens.

The table below shows the operation of the shortcut menu:
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 Key Function
The menu is closed. 
The display area opens.

Touching the menu 
command

Input of the number 
of the menu 
command

The menu command is executed.

Shortcut menus of the simple recipe view    
A shortcut menu can be called for each view area by pressing the  button or the  key. 
The shortcut menu lists the commands that are available in the active view area. A number is 
assigned to each command. You execute the command by entering its number. You can also 
use the system keys to execute certain commands. 

The scope depends on the HMI device.    

● Recipe list

No. Menu command Keys Function
0 New  + A new recipe data record is created for the selected recipe.

If a start value is configured, it is displayed in the input field.
1 Displaying infotext Displays the infotext configured for the simple recipe view.
2 Open The record list of the selected recipe opens.

● Data record list

 Menu command Keys Function
 New  + Creates a new recipe data record.

If a start value is configured, it is displayed in the input field.
 Deleting The displayed record is deleted.
 Save as  The selected data record is saved under a different name. 

A dialog box opens where you can enter the name.
 Rename  Renames the selected data record. A dialog box opens 

where you can enter the name.
 Open The element list of the selected data record opens.
 Previous The recipe list opens.
 To PLC  The displayed values of the selected data record are 

transferred from the HMI device to the PLC.
 From PLC  The recipe values from the PLC are displayed in the recipe 

view of the HMI device.
 Displaying infotext Displays the infotext configured for the simple recipe view.

● Element list

 Menu command Keys Function
 Save  The selected record is renamed.
 To PLC  The displayed values of the selected data record are 

transferred from the HMI device to the PLC.
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 Menu command Keys Function
 From PLC  The recipe values from the PLC are displayed in the recipe 

view of the HMI device.
 Save as  The data record is saved under a new name. A dialog box 

opens where you can enter the name.
 Displaying infotext Displays the infotext configured for the simple recipe view.
 Rename  Renames the selected data record. A dialog box opens 

where you can enter the name.
 Previous The data record list opens.

Mouse control or touchscreen control of the simple recipe view
1. Select the desired recipe from the recipe view.

2. Click on the  button.
The shortcut menu is opened.

3. Select the desired menu command.
The menu command is executed.

4. Alternatively, open the desired recipe in the recipe view.
The data record list is displayed.

5. Open the desired data record. You could also use the  button to open the shortcut menu 
and select a menu command.
The menu command is executed.

Using the keyboard with the simple recipe view
1. Press the key as many times as required to select the simple recipe view.

2. Select the desired recipe with the cursor keys.

3. Press the  key.
The shortcut menu is opened.

4. Press the cursor key as many times as required to select the menu command.

5. Confirm the menu command by pressing the key .

6. Alternatively, press the number of the desired menu command.
The menu command is executed.

 

Creating a recipe data record

Introduction  
Create a new recipe data record in the recipe list or in the record list. Then enter the values 
for the new record in the element list and save the record.
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Requirement
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows to create a recipe data record:

1. If the recipe list contains several recipes: Select the recipe for which you want to create a 
new recipe data record.

2. Open the recipe list menu.

3. Select the "0 new" menu command.
Creates a new record.
The element list of the new record opens.

4. Enter values for the data record elements.
The tags of the record can be assigned default values depending on the configuration.

5. Open the menu of the element list and select the "0 Save" menu command.

6. Enter a name for the new record.

7. Confirm your entries.
An existing data record is overwritten if you assign its number to a new data record.

Result
The new recipe data record is saved to the selected recipe. 

Editing a recipe data record

Introduction    
Edit the values of the recipe data records and save them to a recipe view. 

Synchronization with the PLC  
To display the current recipe values from the PLC in the simple recipe view, you first have to 
read the actual values in the element list from the PLC using menu command "2 From PLC". 

Values changed in the recipe view are only activated after you transferred the modified data 
record to the PLC by means of menu command "1 To PLC".

Requirement
A screen with a recipe view is displayed.
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Procedure 
Proceed as follows to copy a recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.

3. Select the recipe data record you want to edit.

4. Open the element list.

5. Edit the element values as required.

6. Save your changes using menu command "0 Save".

Result
The edited recipe data record is saved to the selected recipe. 

Deleting a recipe data record

Introduction  
You can delete all the data records which are not required. 

Requirement
A screen with a simple recipe view is displayed.

Procedure for touch operation
Proceed as follows to delete a new recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

4. Open the menu.

5. Select the menu command "1 Delete".

Procedure for key operation
Proceed as follows to delete a new recipe data record:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Open the data record list.
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3. Select the data record you want to delete.

4. Press 
INS

DEL .

Result
The data record is deleted. 

Reading a recipe data record from the PLC

Introduction      
The values of recipe elements are exchanged with the PLC via tags.

You can edit values which were saved to the recipes in the HMI device directly at plant level 
within the active project; this may be the case if a valve in the plant opens more than is indicated 
in the recipe. The values of the tags on the HMI device possibly no longer match the values 
in the PLC.

Read the values from the PLC and output these to the recipe view to synchronize the recipe 
values. 

Requirement
A screen with a simple recipe view is displayed. 

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the element list of the recipe data record to which you want to apply the values from 
the PLC.

3. Open the menu.

4. Select menu command "2 From PLC".
The values are read from the PLC.

5. Save the displayed values to the HMI device using menu command "0 Save".
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Result
The values were read from the PLC, are visible on the HMI device and were saved to the 
selected recipe data record. 

 

 Note
Basic Panels

With Basic Panels, the "From PLC" menu command can also be configured for the data record 
list: In this case, you can also select the "From PLC" menu command in the data record list.

 

Transferring recipe data records to the PLC

Introduction   
You must transfer the values to the PLC to activate a changed recipe data record for the 
process. 

The values displayed in the recipe view are transferred to the PLC. 

Requirement
A screen with a simple recipe view is displayed.

Procedure
To transfer a recipe data record to the PLC, proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the element list of the recipe data record whose values you want to transfer to the 
PLC.

3. Open the menu.

4. Select menu command "1 To  PLC".

Result
The values of the recipe data record were transferred to the PLC and are active in the process. 

 

 Note
Basic Panels

With Basic Panels, the "To PLC" menu command can also be configured for the data record 
list: In this case, you can also select the "To PLC" menu command in the data record list.
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Exporting a recipe data record

Introduction
You can export one or more recipe data records to a CSV file, depending on the configuration. 
After export, the values in the recipe data record can be further processed in a spreadsheet 
program such as MS Excel. The degree to which you can influence the export depends on the 
configuration: 

Requirement
● A screen with a recipe view is displayed.

● An operating element with the function "Export record" has been configured.

● The following tags are configured equally in the recipe view and for the "Export record" 
operating element.

– Recipe number

– Data record number

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the relevant 
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operator control which was configured for export, for example the "Export data 
record" button.
The data record is exported as a CSV file to an external data medium.

Result
The recipe data record is exported. 

Importing a recipe data record

Introduction
You can import values from a CSV file to a recipe data record, depending on the configuration. 

Requirement
● An operator control with the function "Import data record" has been configured, for example 

a button

● A screen with a recipe view is displayed.
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Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the recipe data 
record to be imported.

2. Operate the operator control with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in 
the recipe view after import.

Result
The imported recipe data record is saved on the HMI device.

Deviating structure
If the structure of the CSV file differs from the structure of the recipe, deviations are handled 
as follows:

● Any additional values in the CSV file will be rejected

● The system applies the configured default value to the recipe data record if the CSV file 
contains an insufficient number of values

● If the CSV file contains values of the wrong data type, the configured default value is set 
in the recipe data record
Example:
The imported CSV file contains values that were entered as floating point numbers
However, the corresponding tag expects an integer value. In this case, the system discards 
the imported value and uses the configured default 

Operating recipes in Runtime Professional

Recipe view

Functional scope     
The recipe display offers access to user archives, the recipes and recipe queries. In runtime, 
you can:

● Online configuration of recipe view

● Create, delete or modify new data records

● Scrolling in recipes

● Read and write tags for direct tag link

● Importing and exporting recipes
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● Defining selection criteria to display only a certain part of the recipes

● Defining sorting conditions for the displayed recipe elements

Properties
You connect a recipe view to a recipe or recipe query during the configuration. The online 
configuration and changing of selected recipe values in Runtime can be protected against 
unauthorized access respectively by own operator authorizations. If you cancel the access 
protection, you must reconnect the recipe view with the recipe in the configuration dialog box.

The access protection is queried when the recipe view screen opens.

● If the user has no authorization to read a recipe element, the corresponding column is not 
displayed in the table.

● If the user has no authorization to write a recipe element, the user cannot edit the data of 
the the corresponding column in the table.

Access protection for the control tags must be configured separately by the object properties, 
e.g. of a screen, an I/O field or a button.

Operating the recipe view

Mouse and keyboard operation

Introduction               
You operate the recipe view in Runtime by buttons in the toolbar. If you do not want to use the 
toolbar for operation, you can write the "ID" of the desired button in the "ToolbarButtonClick" 
object property with any dynamization type.
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Overview

Symbol Description ID
"Help"
Calls the help for the recipe view.

1

"Configuration dialog"
Opens the configuration dialog box in which you change the properties of 
the recipe view.

2

"Select data connection"
Opens a dialog for selecting a recipe or recipe query. The recipe data are 
then shown in the table of the recipe view.

3

"First line"
The first data record is displayed in the table by the button. 

4

"Previous line"
The previous data record is displayed in the table by the button.

5

"Next line"
The next data record is displayed in the table by the button.

6

"Last line"
The last data record is displayed in the table by the button.

7

"Delete lines"
The content of the marked lines are deleted.

8

"Cut lines"
The content of the marked lines are cut out.

9

"Copy lines"
The content of the marked lines are copied.

10

"Insert lines"
The content of the copied or cut-out lines is inserted starting from the marked 
line.

11

"Read tags"
The contents of the connected WinCC tags are read and written into the 
recipe elements by the button. The "Tags" communication type must be 
activated in the displayed recipe to be able to use the button. The recipe 
elements must be connected with tags.

12

"Write tags"
The contents of the recipe elements are written into the connected WinCC 
tags. The "Tags" communication type must be activated in the displayed 
recipe to be able to use the button. The recipe elements must be connected 
with tags.

13

"Import Archive"
Using a button, a CSV file is imported from the "ua" directory of the project 
folder into the table of the recipe view.

14

"Export archive"
The original contents of the table are exported with table headers by the 
button when loading. The recipe is stored as a CSV file in the "ua" directory 
of the project folder. 

15

"Sort dialog"
Opens a dialog box for setting a customized sorting of the displayed columns.

16
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"Print"
Starts the printout of the displayed values. The print job used for printing is 
defined in the configuration dialog in the "General" tab. 

18

"Export data"
Using a button, you can export the recipe or recipe query to a CSV file as 
configured but with the current runtime data. If the "Display dialog" option is 
active, a dialog opens in which you can view the settings for exporting and 
can start the export. With the appropriate operator authorizations you can 
also select the file and the directory for the export.
If no dialog box is displayed, the data export to the preset file starts 
immediately.

20

"Time base dialog"
Opens a dialog box for setting the time base for the used times.

19

"User-defined 1"
Displays the first button created by the user. The function of the button is 
customized.

1001

Possible elements of the status bar
The following elements may appear in the status bar of the recipe view:

Symbol Name Description
Archive name Displays the name of the selected recipe or recipe query.
Row Shows the number of the marked line.
column Shows the number of the marked column.
Date Shows the system date.
Time Shows the system time.
Time Base Shows the time base used in the display of times.

Navigation in the table
You can navigate in the table as follows:

● You enter the next cell with the "ENTER" key or with the "Right" cursor key.

● You enter the previous cell with "SHIFT+ENTER" key or with the "Left" cursor key.
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● You enter the next line by clicking with the mouse in the line or with the "Down" cursor key.

● You enter the previous line by clicking with the mouse in the line or with the "Up" cursor 
key.

 

  Note

If the "Error while connecting the data!" error message appears when Runtime starts, the 
recipe view has no connection to a recipe or recipe query. Check the following: 
● The name is specified correctly.
● The configuration is not changed.
● The connected recipe or recipe query still exists.

 

Editing recipe data

Introduction     
You can edit data in the Data recipe view. The following options are available:

● Enter new data

● Change existing data

● Delete lines

● Cut-out, copy and insert lines

Requirement
● You have permitted editing in the configuration dialog in the "General" tab.

● You have deactivated the "Write-protected" property for the column to be edited in the 
configuration dialog in the "Columns" tab.

● The "ID" column cannot be edited.

● If the recipe view is connected to a recipe query, you cannot delete and cut out a row.

Entering new data in the table
1. Click on  to move to the last line. The line is marked.

2. Double-click on the first cell of the marked line. You can also press on "F2", "Alt+Enter" or 
Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the new data 
record is written into the recipe. You move to another line by clicking with the mouse, with 
the "ENTER" key or with the "Up" and "Down" cursor keys.

4. You can copy the data of a marked line with "CTRL+C" or "CTRL+X" into the clipboard. 
The copied data is inserted into a marked line with "CTRL+V".
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Changing existing data in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Double-click on the desired cell of the marked line. You can also press on "F2", "Alt+Enter" 
or Ctrl+Enter" in the cell.

3. You enter the values in the cells one after the other and confirm each time by pressing 
Enter. After you have entered all values in the line and selected another line, the changed 
data record is written into the recipe.

Deleting a line in the table
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  to delete the marked line.

Cutting, copying and inserting lines
1. Click on  or  to move to the desired line. You can also use the scrollbars to move 

to the desired line.

2. Click on  or  to cut or copy the data of the line. As an alternative, you can also use 
key combination "CTRL+ALT+X" or "CTRL+ALT+C".

3. Go to the desired line into which you want to copy the data. Click on  to insert the cut-
out or copied data. If you do not want to overwrite the data of the marked line, move into 
the last line to insert the data.

Selecting and configuring data

Introduction   
The recipe view shows the data of the connected recipe in a table. The displayed content of 
the table is determined by the selected columns and the selection of contents of the columns.

Requirement
● You have created one or more recipes and/or recipe queries.

● You have connected the recipe view to a recipe or recipe query.
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Configuring the columns
1. Go to the "Columns" tab.

2. In the "Columns" list, you can see the fields of the connected recipe or recipe query. If the 
check box in front of the name of the column is checked, the column is displayed in the 
table. Deactivate the check box if you do not want it to appear.

3. Determine the order of the columns in the table using the "Up" and "Down" buttons.

4. Select a column to configure the properties and the format.

5. If necessary, change the width of the column in the table. Enter a value in the "Length in 
chars" field.
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6. Some columns can also show the content and the header as a symbol. Determine how 
these columns are displayed in the "Display" field. Text and symbols can be displayed at 
the same time.

7. Save the configuration.

Selection of column content that will be displayed in the table
Configure criteria used to display the content in the columns in the "Selection" area.

Procedure
1. Click "Edit...". The selection dialog is opened.

2. Specify the criteria for the display. More information on the selection of columns can be 
found under Auto-Hotspot.

3. Click "OK" to close the selection dialog. The selection is considered at the start of Runtime 
in the table of the recipe view.
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Configuring the Sorting of Columns
You configure the sorting of the columns in the table in the "Sorting" area. You can also specify 
the sorting criteria in Runtime using the key functions.

1. Click "Edit...". The sorting dialog opens.

2. Set a sorting sequence. More information on the sorting of columns can be found under 
Auto-Hotspot.

3. Click "OK" to close the sorting dialog.

4. Save the configuration of the contents.

Select data

Introduction    
Which contents of the recipe you want to show or export in the recipe view table can be defined 
in Runtime by the selection dialog box.  In the selection dialog box you defie selection criteria 
with regard to the displayed columns of the recipe.
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Requirement
● The selection dialog is open (see paragraph "Auto-Hotspot").

Procedure
Proceed as follows:

1. Double-click in the first empty line in the "Criteria" column. The list with the columns of the 
recipe view is shown. Select the desired columns, e.g. "field1".

2. Double-click in the "Operand" column to select an operand.

3. Double-click in the "Setting" column to enter a comparison value.

4. Double click in the "Logic operator" column to select an "AND" or "OR" function.

5. Repeat the procedure if you want to define further criteria.

6. Click "OK" to close the selection dialog. The selection is displayed in the table of the recipe 
view.

 

  Note
Ensuring the display of column content

Make sure of proper use of the settings and connections of criteria. 

Incorrect logical operations can lead to the data of the connected recipe not being 
displayed in the recipe view.

Therefore test every criterion separately before the logical operation and then the logically 
operated criteria respectively. Check that all expected contents are also displayed in 
combination.

This ensures that the selection is displayed completely in the recipe view.
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Sorting data

Introduction    
The data in the recipe view can be sorted by columns in Runtime. You sort the columns either 
via the "Sort dialog" button function or directly via the column headers.

 

 Note

You can define the  sorting criteria already in the configuration in the recipe view by clicking 
the "Edit..." button under "Sorting" on the "Columns" tab.

 

How to sort with the Sort dialog

Requirement
● You have activated the "Sorting dialog" button on the "Toolbar" tab of the UserArchive 

Control.

Procedure
1. Click the "Sort Dialog" button .

2. Select the column of the connected recipe from the "Sort by" list which is to be used for 
sorting first. Select the relevant check box to specify sorting in ascending or descending 
order. If you want to sort by more than one column, select the other columns in the desired 
order in the "Then sort by" lists.
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How to sort the column contents with the column heading 
When sorting using the column header, you are able to specify the sort order for more than 
four columns. A sorting icon and sorting index, displayed with right-justification in the column 
heading, show sorting order and sorting sequence of the column contents.

Requirement
● You have allowed sorting in the list field "Sort by column header" by click or double click 

on the "Parameters" tab of the recipe view.

● You have activated the "Show sorting icon" and "Show sorting index" checkboxes.

Procedure
1. Click the column header of the column you want to sort as first column. The sorting index 

"1" is displayed, and the sorting icon points upwards for ascending sort order.

2. If you want to sort in descending order, click the column header again.

3. If the sorting order has been defined with "up/down/none", you can undo the sorting of the 
column with a third click.

4. If you want to sort several message blocks, click the respective header columns in the 
desired sequence.

10.14.3.5 Operating alarms

Overview

Alarms  
Alarms indicate events and states on the HMI device which have occurred in the plant, in the 
process or on the HMI device itself. A status is reported when it is received. 

An alarm could trigger one of the following alarm events: 

● Incoming

● Outgoing

● Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user. 

An alarm may contain the following information: 

● Date

● Time

● Alarm text

● Event text

● Location of fault
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● Status

● Alarm class

● Alarm number

● Alarm group

● Supports diagnostics

Alarm classes  
Alarms are assigned to various alarm classes. The selection depends on the HMI device.

● "Warnings"
Alarms of this class usually indicate states of a plant such as "Motor switched on." Alarms 
in this class do not require acknowledgment.

● "Errors"
Alarms in this class must always be acknowledged. Alarms normally indicate critical errors 
within the plant such as "Motor temperature too high".

● "System"
System alarms indicate states or events which occur on the HMI device. 
System alarms provide information on occurrences such as operator errors or 
communication faults. 

● "Diagnosis Events"
SIMATIC diagnostic alarms show states and events in the SIMATIC S7 controllers.

 

 Note
Availability for specific devices

Diagnostic alarms are not available for Basic Panels.
 

● STEP 7 alarm classes
The alarm classes configured in STEP 7 are also available to the HMI device.

 

  Note
Availability for specific devices

STEP 7 alarm classes are not available for Basic Panels.
 

● Custom alarm classes
The properties of this alarm class must be defined in the configuration.

Alarm buffer 
Alarm events are saved to an internal buffer. The size of this alarm buffer depends on the HMI 
device type.  
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Alarm report 
When alarm report is enabled in the project, alarm events are output directly to the connected 
printer. 

You can set the reporting function separately for each alarm. The system outputs "Incoming" 
and "Outgoing" alarm events to the printer.

The output of alarms of the "System" alarm class to a printer must be initiated by means of the 
corresponding alarm buffer. This outputs the complete content of the alarm buffer to the printer. 
To be able to initiate this print function, you need to configure a corresponding control object 
in the project.

 

 Note
Availability for specific devices

Alarm reports are not available for Basic Panels.
 

Alarm log
Alarm events are stored in an alarm log, provided this log file is configured. The capacity of 
the log file is limited by the storage medium and system limits.  

 

 Note
Availability for specific devices

Alarm logs are not available for Basic Panels.
 

Alarm view
The alarm view shows selected alarms or alarm events from the alarm buffer or alarm log. 
Whether alarms have to be acknowledged or not is specified in your configuration. By means 
of configuration, the display can be filtered in such a way that only alarms that contain a specific 
character string will be shown.

Alarm window
If configured, an alarm window shows all pending alarms or alarms awaiting acknowledgment 
of a particular alarm class. The alarm window is displayed as soon as a new alarm occurs.  

You can configure the order in which the alarms are displayed. Either the current alarm or the 
oldest alarm is displayed. The alarm window can also be set to indicate the exact location of 
the fault, including the date and time of the alarm event. By means of configuration, the display 
can be filtered in such a way that only alarms that contain a specific character string will be 
shown.

Alarm indicator
The alarm indicator is a graphic icon that is displayed on the screen when an alarm of the 
specified alarm class is incoming.  
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The alarm indicator can assume one of two states:

● Flashing: At least one unacknowledged alarm is pending.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated. The 
number displayed indicates the number of pending alarms.

 

Operating alarms in Runtime Advanced and Panels

Detecting pending alarms

Introduction
You can recognize the presence of alarms which must be acknowledged by the following:

● For an HMI device with keys: The LED of the key  is lit.

● Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged or not. This is also 
defined by the alarm class which an alarm belongs to. 

LED in the "ACK" key   
An LED is integrated in the  key on HMI devices with keyboard. The LED is lit if there are 
alarms requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.

Alarm indicator  
The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring 
acknowledgment, depending on the configuration.

Figure 10-17 Alarm indicator with three pending alarms

Layout
The alarm indicator can assume one of two states:

● Flashing:
The alarm indicator flashes as long as alarms are pending for acknowledgment. The 
number displayed indicates the number of pending alarms. The project engineer can 
configure specific functions to be executed by operating the alarm indicator.

● Static: The alarms are acknowledged but at least one of them is not yet deactivated.
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Displaying dialogs
The displayed alarm indicator view is covered, for example, by the logon dialog, help dialog 
or alarm text windows. The alarm indicator is visible once you close these dialogs. 

Viewing alarms

Alarm view, alarm window

Use             
Alarms are displayed in the alarm view or in the alarm window on the HMI device. The layout 
and operation of the alarm window corresponds to that of the alarm view.

The alarm window is independent of the process screen. Depending on the configuration, the 
alarm window appears automatically as soon as a new, unacknowledged alarm has been 
received. The alarm window can be configured so that it only closes after all the alarms have 
been acknowledged. 

Control elements
The buttons have the following functions:         

Button Function
Display tooltip for an alarm

Edit alarms

Acknowledge alarm

Layout of the alarm classes   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed. If a filter is configured, only alarms that contain a 
specific character string are displayed in the alarm text.
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To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
(empty) "Warnings"
(depends on the configuration) Custom alarm classes
$ "System"
S7 "Diagnosis Events"

Operation         
Depending on the configuration you can:

● Change the column sequence

● Change the order in which the alarms are displayed

● Acknowledge alarms

● Edit alarms

Runtime behavior

Linked alarm windows for touch panels
When you configure the alarm window for a keyboard unit, select the property "Modal" under 
"Properties > Mode". This ensures that the alarm window does not lose its focus during screen 
changes. This is important, as the switching between the screen and different windows with 
<Ctrl+TAB> is not supported. If the linked alarm window has the focus, the buttons in the screen 
behind it cannot be operated. The functions configured on a function key are carried out.

Changing the order of the displayed alarms
Click in the column to sort the alarms by date and time. 
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Simple alarm view, alarm window 

Use   
The simple alarm view shows selected alarms or alarm events from the alarm buffer or alarm 
log. The layout and operation of the simple alarm window correspond to that of the simple 
alarm view.         

 

 Note

The "Single alarm view" object cannot be operated dynamically with a script. 

In the Engineering System you can dynamically control the visibility of an object, for example, 
in the "Animations" tab of the Inspector window. In Runtime, the "Simple alarm view" does 
not support animations. If you have configured an animation and wish to perform a 
consistency check of the project, for example, then an error alarm is issued in the Output 
window.

 

Layout   
Depending on the configuration, in the alarm view different columns with information regarding 
an alarm or an alarm event are displayed.

To differentiate between the different alarm classes, the first column in the alarm view contains 
an icon:     

Icon Alarm class
! "Errors"
(empty) "Warnings
(depends on the configuration) Custom alarm classes
$ "System"

Operation
Depending on the configuration you can:     

● Acknowledge alarms

● Edit alarms
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Control elements
The buttons have the following functions:     

Button Function
Acknowledge alarm

Edit alarm

Display tooltip for an alarm

Shows the full text of the selected alarm in a separate window, the alarm text window.
In the alarm text window, you can view alarm text that requires more space than is 
available in the alarm view. Close the alarm text window with 

.
Scrolls one alarm up

Scrolls one page up in the alarm view

Scrolls one page down in the alarm view

Scrolls one alarm down

Layout of the control elements
On the OP 73micro and TP 177micro HMI devices the simple alarm view has a button that 
displays the message text in a separate window. This button is not displayed during 
configuration of the simple alarm view in the Engineering System.

The layout of the buttons for operating the simple alarm view depends on the configured size. 
You should therefore check on the HMI device whether all required buttons are available.       

Display tooltip for alarm

Touch and key operation

Procedure for touch operation
Proceed as follows to display the info text:

1. Touch the relevant alarm in the alarm view or in the alarm window.
The alarm is selected.

2. Touch the  button in the simple alarm view or  in the advanced alarm view.
If configured, the info text assigned to this alarm is displayed. 

3. Close the screen for displaying the Info text by means of the  button.
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Procedure for key operation
Proceed as follows to display the info text:

1. Select the desired alarm in the alarm view.

2. Press the key .
If configured, the info text assigned to this alarm is displayed. 

3. Close the info text by pressing the  key.

Mouse and keyboard operation

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <TAB> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <ENTER>.

Acknowledge alarm

Touch and key operation

Requirement
The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure for touch operation    
To acknowledge an alarm, proceed as follows:

1. Touch the relevant alarm in the alarm view or in the alarm window.
The alarm is selected.

2. Touch the  button in the simple alarm view or  in the advanced alarm view.
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Procedure for key operation
The alarm view and the alarm window have a tab sequence with which you can select operator 
controls and the last selected alarm using the keyboard.

To acknowledge an alarm, proceed as follows:

1. Select the desired alarm view or alarm window using the  key.

2. Select the desired alarm. Use the , ,  or  keys accordingly.

3. Press the key .

Alternative operation
Depending on the configuration, you can also acknowledge an alarm with a function key.

Result
The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the 
associated group are acknowledged. 

Mouse and keyboard operation

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <Tab> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <Enter>.
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Edit alarm

Touch and key operation 

Introduction  
The configuration engineer can assign additional functions to each alarm. These functions are 
executed when the alarm is processed.

 

 Note

When you edit an unacknowledged alarm, it is acknowledged automatically.
 

Requirement
The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure for touch operation
Proceed as follows to edit an alarm:

1. Touch the relevant alarm in the alarm view or in the alarm window. The alarm is selected.

2. Touch the  button in the simple alarm view or  in the enhanced alarm view.

Procedure for key operation
Proceed as follows to edit an alarm:

1. Select the desired alarm view or alarm window with TAB .

2. Select the desired alarm. Use the HOME , END ,  or  keys.

3. Continue to press the key TAB until the button  is selected in the simple alarm view or 
 in the extended alarm view.

4. Confirm your entry by pressing the key ENTER .

Result
The system executes the additional functions of the alarm. Additional information on this topic 
may be available in your plant documentation. 
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Mouse and keyboard operation 

Procedure for mouse operation
Proceed as follows:

1. Click on the alarm to be edited.

2. Click the  button in the simple alarm view or  in the advanced alarm view.

Procedure for keyboard operation
Proceed as follows:

1. Press the <Tab> key until the list of displayed alarms is selected in the alarm view.

2. Click on the alarm to be edited. Use the <Home>, <END>, <Up> and <Down> keys 
accordingly.

3. Press the <Tab> key until the  button is selected in the simple alarm view or until 
 is selected in the advanced alarm view.

4. Press <Enter>.

Alternative operation
Depending on the configuration, you can also operate the alarm view via the function keys.
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Operating alarms in Runtime Professional

Alarm view

Overview

Application
The "Alarm view" object displays alarms that occur during the process in a plant. You also use 
the alarm view to visualize alarms in list format. WinCC offers various views, such as "Current 
alarms" or "Historical alarm list" (short-term).

Operation in Runtime
In Runtime, use the <TAB> key to successively move to different objects, to enter values or 
to click buttons. Set the tab sequence for the screen to "Tab sequence" to enable operation 
of the objects without mouse. You can also operate the alarm view using the mouse.

 

 Note

A message is shown with a crossed-out date and time stamp in the message list when any 
of the following occur:
● A locked message is unlocked.
● A message is reloaded after a power failure. This applies only to chronological messaging.
● The AS is restarted. This applies only to chronological messaging.
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Operator controls

Operator controls   
Select "Toolbar" in the Inspector window to define the operator controls and corresponding 
authorizations for the RT alarm view. The following control elements are available for the alarm 
view:

Button Function
Display "Current alarms" Shows the currently active alarms.

Display "Historical alarm 
list" (short-term)

Shows the alarms logged to the historical alarm list (short-
term).

Display "Historical alarm 
list" (long-term)

Shows the alarms logged to the historical alarm list (long-
term).

Display "Locked alarms" Shows all locked alarms in the system.

Alarm statistics Shows the alarm blocks and statistics information you 
configured in the alarm view.

Central alarm 
acknowledgment

Acknowledges a visual, or audible signaling device.

Single acknowledgment Acknowledges an individual alarm.

Group acknowledgment Acknowledges all active visible alarms in the alarm view that 
require acknowledgment, unless they require single 
acknowledgment.

Autoscroll Defines whether it is always the latest alarm that is selected 
in the alarm view. The visible area of the alarm view moves, 
if necessary. 
You can only select specific alarms if "Autoscroll" is inactive.

Filtering alarms Opens a dialog for filtering alarms in the alarm view. Even 
alarms that are not displayed in the filtered view will be 
logged.

Suppressing alarm output Opens a dialog for defining which alarms should be displayed 
in the alarm view. 
If the "All alarms" option is selected, the alarm view displays 
both hidden, and visible alarms.
If the "Visible alarms" option is activated, the alarm view 
contains only visible alarms.
If the "Hidden alarms" option is activated, the alarm view 
contains only hidden alarms.

Lock alarm Opens a dialog for locking alarms. Any alarms that meet 
these criteria are neither displayed, nor logged.

Print active view Starts printing the alarms displayed in the alarm view. 
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Button Function
Emergency 
acknowledgment

Applies emergency acknowledgment to an alarm that 
requires acknowledgment. The acknowledgment bit for an 
alarm is sent directly to the AS, even if the alarm is not active.

Initial value alarm Selects the first of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

Last alarm Selects the last of the active alarms. The visible area of the 
alarm view moves, if necessary. This button can only be used 
if the "Autoscroll" function is disabled.

Next alarm Selects the next alarm in relation to the currently selected 
alarm. The visible area of the alarm view moves, if 
necessary. This button can only be used if the "Autoscroll" 
function is disabled.

Previous alarm Selects the previous alarm in relation to the currently 
selected alarm. The visible area of the alarm view moves, if 
necessary. This button can only be used if the "Autoscroll" 
function is disabled.

Enter tooltip Opens a dialog for viewing infotext.

Enter comment Opens a text editor where you can enter comments.
This button is only available in the alarm view if the historical 
alarm list (long-term) is displayed. 

Loop-in-alarm If a screen change is configured, the display switches to a 
screen containing information about the alarm. 

Lock/unlock alarm Locks or unlocks an alarm in the current alarm list and in the 
alarm log lists. The alarm is entered in the lock list.

"Display options" dialog Opens a dialog for setting user-defined sort criteria for the 
displayed alarms. 

Set time base Opens a dialog for selecting the time base for the time data 
displayed in alarms.

Display "alarms with 
suppressed display"

Opens the list of hidden alarms. 

Suppress/do not suppress 
alarm

Hides an alarm in the alarm list and in the historical alarm 
lists (short-term, long-term). The alarm is entered in the list 
of hidden alarms.

Status bar  
Select "Status bar" in the Inspector window to specify the display of status bar elements. The 
following elements are available for the status bar in the alarm view:

Button Function
Date System date
Time System time

Lock is set.
A filter is activated.

List: Number of alarms currently active in the alarm list.
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Button Function
Window: Number of alarms in the window
Ack: Number of active alarms requiring acknowledgment

Filtering Alarms in Runtime

Introduction      
In Runtime, you can set specific criteria that define the alarms to be displayed in the alarm 
view. In the example below, only alarms that contain the alarm text "Motor on" are displayed. 

Requirement
The "Filter alarms" button  is configured in the alarm view.

Procedure
To filter alarms in the alarm view, proceed as follows:

1. Click  in Runtime.
The "Specify selection" dialog opens.

2. Double-click the "Text Blocks" folder in the tree structure, and click "Alarm Text". In the right 
pane, select the "Search string" option, and double-click "Search string".

3. The "Text input" dialog opens. Enter the search string "Motor on" and click "OK" to confirm.

4. In the "Specify selection" dialog, click "OK" to confirm your entries.
The alarm view only shows the selected alarms.

In the "Specify selection" dialog, specify the start and end times, or search strings, for alarm 
text blocks such as the "Date" and "Time" system blocks. Your input must be in the format 
required in the dialog. 

The following settings are available in the "Specify selection" dialog:

Field Description
Text filter by 
exact match 

If the "Text filter by exact match" option is not enabled, all text blocks that contain 
the specified string of characters are selected.
If the "Text filter by exact match" option is enabled, all text blocks that correspond 
exactly to the specified string of characters are selected. 

Persistence in 
RT

If the "Persistence in RT" option is enabled, changes to criteria are retained even 
after a screen change.

Persistence in 
CS and RT

If the "Persistence in RT and CS" option is enabled, the modified settings are also 
applied to the Engineering System. To do this, you must open the screen in the 
"Screens" editor, and save it again. The changed settings will also be used when 
you reactivate the project.

Delete filter Use this button to delete all configured criteria.
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Filter by process values 
You cannot enter text as the criterion for a process value.

To filter by the text of a process value block, or the process tags it represents, proceed as 
follows:

1. Insert this process value as the alarm text for a user text block in an alarm.

2. In Runtime, filter the alarms by the text in the "Alarm text" text block.
 

  Note

In multi-user systems, make sure that contents displayed in the "Specify selection" dialog 
on a client have the same names on all servers.

When filtering by time, the start and stop values are not adjusted automatically when the 
timebase of the alarm view is changed.

Example: At the PC location with time zone "UTC + 1h", the alarm view has the "Local 
time zone" time base. You should filter by the time 10:00 to 11:00. Change the timebase 
from "Local time zone" to "UTC". If you want to display the same alarms, change the filter 
to 9:00 to 10:00. 

 

Sorting Alarms in Runtime

Introduction   
In Runtime, you can sort the alarms in the alarm view by column header. 

Examples for sorting alarms: 
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● In descending order by date, time, and alarm number. The most recent alarm is displayed 
at the top.

● By priority
You must have defined the priority of the alarms in the "HMI alarms" editor and configured 
the "Priority" alarm text block in the alarm view. As a result, in a single-line alarm view, only 
the top-priority alarm appears in the alarm window. A lower-priority alarm will not be 
displayed, even if it is more recent. The alarms are displayed in chronological order.

● The "Alarm status" alarm text block is sorted by the type of state and not by the configured 
status texts. For an ascending sort order, the following order is used:

– Incoming

– Outgoing

– Acknowledged

– Locked

– Enabled

– Automatic acknowledgment 

– Emergency acknowledgment

– Incoming/outgoing
 

  Note
Specifying sorting criteria in the ES for the alarm view

You can set the sort criteria to configure the alarm view as required. In the Inspector 
window of the alarm view, select "Properties > Properties > View > Columns".

 

Sorting alarms
To sort the alarm view by column, define the sort order over up to four columns. An arrow and 
a number are shown on the right in the column header. The arrow indicates the sort order 
(ascending or descending). The number beside the arrow indicates the sort order of the column 
headers.

Requirement
● "Sort by click" or "Sort by double-click" is selected in the alarm view.

Click on "Properties > Properties > Table > Table - Sorting > Settings".

● The "Autoscroll" button is activated in the alarm view. 
Click "Properties > Properties > Toolbar > Toolbar buttons". 
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Procedure
To sort alarms in the alarm view by column, proceed as follows:

1. Click or double-click the column header by which you want to sort the alarms first.
The number "1" is displayed, and the arrow points upwards for ascending sort order.

– If sort order "Up and down" is enabled in the alarm view, each click or double-click in 
the column header toggles the sorting between the ascending and descending mode.

– If sort order "Up, down, none" is enabled, then the sort order is cancelled after the 3rd 
click.

2. If you want to sort by several columns, click the column header in the required order.
 

  Note

Sorting is not affected by events or changes to the alarm text block configuration.

An alarm text block corresponds to a field in an alarm. If you define an alarm text block 
as sorting criterion in the sort dialog and then remove this block from the alarm line under 
"Properties> Properties > Columns", the defined sort order remains unchanged. In the 
sort dialog, a blank field is displayed instead of the deleted alarm text block. 

If you do not define another sort order order and reactivate the removed alarm text block 
in the alarm text block configuration, the alarms will be sorted in the original sort order 
once more. 

 

Toggling the Alarm View in Runtime

Introduction
You filter the alarms to be displayed in the alarm view using preconfigured buttons.
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Requirements
● The six buttons needed to display a certain selection of alarms are configured in the alarm 

view.

Procedure
To display a certain selection of alarms in the alarm view, follow these steps:

● Click on one of the following buttons in the alarm view:
 Alarm list, to view alarms pending
 Historical alarm list (short-term), to view logged alarms

The display is updated immediately when new incoming alarms occur.
 Historical alarm list (long-term), to view logged alarms
 Lock list, to view the locked alarms
 Alarm statistics, to view statistical information
 List of hidden alarms, to view alarms which are logged but not visible.

Displaying archived alarms in Runtime

Introduction      
In Runtime, the alarm view displays alarms from the log, in addition to the current alarms. 

Requirements
● All the archived data that you intend to display in Runtime must be stored locally on the 

archive server. The SQL server does not allow access to backup files held elsewhere, such 
as another computer on the network.

● The  and  buttons are configured in the alarm view.

Procedure
To logged alarms in Runtime, follow these steps:

1. In the alarm view, click on the "Short-term archive list"  button to display the logged 
and current alarms. Any new incoming alarms will be immediately updated in the historical 
alarm list (short-term).

-OR-
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1. In the alarm view, click on the "Long-term archive list"  button to display only logged 
alarms. The historical alarm list (long-term) only displays logged alarms. You can enter or 
view comments in the historical alarm list (long-term).

Printing Alarms in Runtime

Introduction
You have the following options for printing alarms in Runtime, depending on the settings made 
in the "HMI alarms" and "Reports" editors:

Print alarm sequence report

If the alarm sequence report is activated, all alarm status transitions in Runtime are output 
continuously to a printer. No operator input is needed in Runtime. 

Printing report

The operator input in Runtime depends on your configuration. Your options for printing an 
alarm report in Runtime are as follows:

● Time-driven output

– One-off, time-driven output, e.g. at the start of a shift

– Repeated output at specific intervals, such as every two hours

● Event-driven output

– Change in value of a tag

– By clicking a configured button in a screen

– Click the  button in the alarm view

– Overflow of a log

– Script

Requirement
● Several alarms are displayed on the HMI device.

Procedure
To print the current view in the alarm window in Runtime, follow these steps:

1. Filter the alarm view using the alarm view controls, if necessary.

2. Click the  button in the alarm view.

Result
The alarms displayed in the alarm window are output to the printer that you configured in the 
"Reports" editor.
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Printer settings
Configure the printer in the HMI device's Control Panel. The settings will depend on which 
operating system is used on the HMI device. For detailed information, refer to the operating 
instructions of your HMI device and to the "Reporting alarms" chapter. 

Locking alarms

Locking Single Alarms

Introduction
If you lock an alarm, this alarm will not be displayed, and will not be logged. You can lock single 
alarms, alarm classes or alarm groups as required.

 

 Note
Locked alarm:

Locked alarms are automatically unlocked when WinCC Runtime restarts. Only alarms that 
are locked directly in the AS by means of data blocks will continue to be locked (locking at 
source).
Locked alarm classes / alarm groups:

The locked state of alarm classes and alarm groups is not affected by a restart of WinCC 
Runtime.

 

Requirement
● The alarm view has been configured.

● The alarm view is displayed in Runtime.

● The "Lock alarm / Unlock alarm" button  /  is configured.

● You are authorized to lock, and unlock alarms.
 

  Note

The "Lock alarm", and "Unlock alarm" authorizations must be configured directly one 
above the other. This is necessary because the authorization level used automatically for 
the "Unlock alarms" authorization is directly below the "Lock alarms" authorization.

 

Procedure
To lock alarms and prevent them being displayed using the button, follow these steps:

1. Select the alarm that you want to lock from the alarm view.

2. Click the button.
The alarm is removed from the alarm list.
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3. Click on the  button to view all locked alarms.
The lock list is displayed.

4. Select the alarm that you want to unlock.

5. Click the button.
The alarm is displayed again and removed from the lock list.

 

  Note

Locking/unlocking an Alarm_8(P) alarm by means of S7PMC always causes all 8 alarms 
of this block to be locked, or unlocked. 

 

Locking Alarms using the Alarm Number

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
Proceed as follows to lock alarms and prevent them being displayed using the alarm number:

1. Click the button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.

3. Click the "Add" button. In the subsequent dialog, enter the alarm number that you want to 
lock.
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4. You can lock multiple alarms at the same time. To do this, enter the alarm numbers, 
separated by commas. Enter a range of numbers in the format "5-10". Only contiguous 
number ranges are locked. If there are gaps in the specified range, an "Invalid range" 
message is output.

5. To unlock a locked alarm, select the alarm from the list of locked alarms, and click the 
"Delete" button.

 

  Note

You cannot lock, or unlock more than 50 alarms at the same time. 
 

Locking Alarms using the Alarm Class or Alarm Group

Introduction
You can also lock alarms to prevent them from being displayed by locking the entire alarm 
class, or the alarm group to which the alarm belongs. None of the alarms from these locked 
alarm groups and alarm classes will be displayed.

Requirements
● The "Lock dialog" button is configured in the alarm view.

Procedure
To lock, or unlock alarms via the alarm class, or the alarm group, proceed as follows:

1. In the alarm view, click the  button.
The "Configure Lock List" dialog opens.

2. Click a server in the server list, or click the local PC for single-user projects.
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3. In the tree structure, select an alarm class or user-defined alarm group that you want to 
lock.

4. Click the "Lock" button.
All alarms from this alarm class or user-defined alarm group are locked.

To unlock the alarms, select the alarm class or user-defined alarm group and click on the 
"Unlock" button.

Operator input alarm when an alarm is locked
You can define in the alarm view, whether an operator input alarm is generated when an alarm 
is locked or unlocked. You should configure the operator input alarm yourself if needed. The 
operator input alarm contains the following objects by default:

● A time stamp

● The user logged on

The time stamp for the alarm originates as follows:

● From the alarm source (such as an AS) for active locking.

Actively-locked alarms are visible, and can be used on all HMI devices.

Acknowledging alarms

Acknowledge alarms

Introduction
You can acknowledge alarms in Runtime according to your project configuration settings. You 
can acknowledge alarms as follows:

● Using the display and control object buttons

● With customized buttons

If an operator authorization is configured for an individual control, the alarms can only be 
acknowledged by authorized users.

To bypass the acknowledgement in Runtime, WinCC contains system functions and scripts 
that allow you to acknowledge alarms automatically.

Acknowledgement variants
You acknowledge individual alarms or multiple alarms together in Runtime. The following 
options are possible:

● Single acknowledgment
Acknowledgment of an alarm using a button or a function key. 

● Acknowledge alarm groups
Acknowledgement of all the alarms of an alarm group using a button, or a function key.
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● Group acknowledgement
Acknowledgement of all pending alarms in the alarm view that require acknowledgement 
using the  button in the alarm view.

● Dual-mode acknowledgment
If an alarm requires dual-mode acknowledgment, you acknowledge both the incoming, and 
the outgoing alarm.

Requirement
An alarm is displayed on the HMI device.

Procedure
To acknowledge an alarm, follow these steps:

● Select the alarm.

● Click the  button in the alarm view.

Result
The alarm status is set to "Acknowledged". If the trigger condition for an alarm no longer 
applies, the alarm status is also set to "outgoing" and no longer displayed on the HMI device. 

Group Alarm Acknowledgement

Introduction
The acknowledgement of all pending, and visible alarms in the alarm window that need to be 
acknowledged is known as a group acknowledgement. If the "Single alarm" option is not 
selected for an alarm, you can trigger a group acknowledgment. 

Requirement
There are several alarms that require acknowledgement in the alarm view.

Procedure
To group-acknowledge an alarm, follow these steps:

1. Read the alarm texts of the queued alarms and initiate remedial action, if necessary.

2. In the alarm view, click the  button.
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Result
All queued alarms with the following properties are acknowledged:

● Requires acknowledgement

● Does not require acknowledgement

● Visible

Emergency Acknowledgement of Alarms

Introduction
In exceptional situations, the operator acknowledges an alarm based on its alarm number. The 
acknowledgment bit is sent to the AS even if the alarm is currently not pending. This function 
is only intended for use in imminent emergency situations. 

Requirement
The  button is configured in the alarm view.

Procedure
To acknowledge an alarm in Runtime using an emergency acknowledgement, follow these 
steps:

1. Click the  button in the alarm view.
The "Emergency Acknowledgment for Alarms" dialog opens.

2. Select a server.
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3. To enter the alarm number, select "Alarm number".

4. Click the "Send acknowledge job" button.
The alarm then appears in the alarm view in the color that you defined for an acknowledged 
alarm.

 

  Note

In the dialog for selecting the servers, only server projects whose "Packages" are loaded 
onto the PC are shown. 

 

Acknowledging Alarm Alerts

Introduction
The way you acknowledge an alarm annunciator in Runtime will depend on how you configured 
its acknowledgement. 

Requirements
● The alarm annunciator and its acknowledgment are configured.

● The alarm annunciator is triggered.

Acknowledgment using a separate key
● To acknowledge the alarm annunciator, click the  button in the alarm view.

You only acknowledge the alarm annunciator. The alarm that triggered the alarm 
annunciator is still set to "incoming" status.

Single acknowledgment
● To acknowledge the alarm annunciator, select the current alarm, and click the  button 

in the alarm view. 
You thereby acknowledge the alarm annunciator and the alarm that triggered the alarm 
annunciator.

Acknowledgment tag
If the alarm annunciator is acknowledged using a tag, acknowledge the alarm annunciator 
using a customized button or function key, etc.

Result
This sets the acknowledgment bit of the alarm annunciator.
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10.15 Performance features

10.15.1 Engineering system

Engineering system
The following tables help you assess whether your project still meets the performance 
specifications of the engineering system.     

In addition to the specified limits, allowances must also be made for restrictions imposed by 
main memory resources. WinCC uses up to 2 GB of RAM, depending on the operating system. 
It is nonetheless useful to install more than 2 GB of main memory on the PC if running many 
applications with high memory requirements in parallel.

Project system limits
Different system limits apply for the engineering system, depending on whether a 32-bit or 64-
bit operating system is used.

 32-bit operating system 64-bit operating system
Number of HMI devices in the project 20 40
Number of HMI tags 1) 80,000 260,000
Number of logging tags 8,000 20,000
Number of blocks (faceplates, user data types)3) 10,000 20,000
Number of screens 3,000 6,000
Number of screen objects per screen 3,200 3,200
Number of screen objects 320,000 640,000
Number of alarms 2) 3) 20,000 60,000
Number of texts 3) 300,000 600,000
Number of text lists and graphic lists 3) 10,000 20,000
Number of entries per text list 3,000 3,000
Number of languages 32 32
Number of global libraries 3) 20 20
Number of objects in the project library 3) 300,000 800,000

1) Including logging tags.
2) With an average of 3 texts and a dynamic parameter
3) Including the objects configured in the "Program PLC" area
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WinCC system limits for an HMI device

 32-bit operating system 64-bit operating system
Number of HMI tags 1) 80,000 260,000
Number of logging tags 8,000 20,000
Number of logs 500 1,000
Number of screens 1000 2,000
Number of screen objects per screen 3,200 3,200
Number of screen objects 320,000 640,000
Number of function lists 30,000 60,000
Number of animations and local scripts 50,000 100,000
Number of user-defined functions 1,000 2,000
Number of tasks 500 1,000
Number of alarms 2) 20,000 60,000
Number of recipes 1,000 2,000
Number of recipe elements 10,000 20,000
Number of texts 300,000 600,000
Number of text lists and graphic lists 1,000 2,000
Number of entries per text list 5,000 10,000
Number of users 200 200
Number of reports 300 600

1) Including logging tags.
2) With an average of 3 texts and a dynamic parameter

System limits during migration
You can migrate projects which are beyond the specified system limits in one or more areas.

An alarm will be output if migration creates a project whose limits are beyond the specified 
system limits. You must then adapt the project after migration to within the specified system 
limits to ensure safe operation in WinCC.

See also
Basic Panel (Page 7189)

Panel (Page 7196)

Mobile Panel (Page 7199)

Multi Panel (Page 7204)

Comfort Panel (Page 7207)

WinCC Runtime Advanced (Page 7212)
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WinCC Runtime Professional (Page 7215)

Orientation help for performance in Runtime (WinCC Runtime Professional) (Page 7219)

10.15.2 Basic Panel

Basic Panel
The following table helps you assess whether your project meets the performance features of 
the HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of tags in the project 250 500 250 (mono)
500 (color)

500 500 500

Number of PowerTags -- -- -- -- -- --
Number of elements per array 100 100 100 100 100 100
Number of local tags -- -- -- -- -- --
Number of structures -- -- -- -- -- --
Number of structure elements -- -- -- -- -- --

Alarms

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of alarm classes 32 32 32 32 32 32
Number of discrete alarms 200 200 200 200 200 200
Number of analog alarms 15 15 15 15 15 15
Length of an alarm in characters 80 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8 8
Size of the alarm buffer 256 256 256 256 256 256
Number of queued alarm events 64 64 64 64 64 64
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Screens

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of screens 50 50 50 50 50 50
Number of fields per screen 30 30 30 30 30 30
Number of tags per screen 30 30 30 30 30 30
Number of complex objects per screen 1) 5 5 5 5 5 5
Number of array elements per screen 2) 100 100 100 100 100 100

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

2) Array elements contained in recipes are included in the count. 

Recipes

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of recipes 5 5 5 5 5 5
Number of elements per recipe1) 20 20 20 20 20 20
User data length in bytes per data record -- -- -- -- -- --
Number of data records per recipe 20 20 20 20 20 20
Reserved memory for data records in the 
internal Flash

40 KB 40 KB 40 KB 40 KB 40 KB 40 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of logs -- -- -- -- -- --
Number of entries per log (including all log 
segments) 1)

-- -- -- -- -- --

Number of log segments -- -- -- -- -- --
Cyclic trigger for tag logging -- -- -- -- -- --
Number of tags that can be logged per log -- -- -- -- -- --

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit
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Trends

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of trends 25 25 25 25 25 25

Text lists and graphics lists

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of graphics lists 100 100 100 100 100 100
Number of text lists 150 150 150 150 150 150
Number of entries per text or graphics list 30 30 30 30 30 30
Number of graphic objects 500 500 500 500 500 500
Number of text elements 500 500 500 500 500 500

Scripts

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of scripts -- -- -- -- -- --

Communication

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of connections 4 4 4 4 4 4
Number of connections based on "SIMATIC 
HMI HTTP"

-- -- -- -- -- --

Help system

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of characters in a help text 500 500 500 500 500 500

Languages

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of runtime languages 5 5 5 5 5 5
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Scheduler

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Time-triggered tasks 1) -- -- -- -- -- --

1) Event-triggered tasks are not relevant for the system limits

User administration

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Number of user groups 50 50 50 50 50 50
Number of authorizations 32 32 32 32 32 32
Number of users 50 50 50 50 50 50

Project

 KP300 
Basic

KP400 
Basic

KTP400 
Basic

KTP600 
Basic

KTP1000 
Basic

TP1500 
Basic

Size of the project file "*.srt" 1024 KB 1024 KB 1024 KB 1024 KB 1024 KB 1024 KB

See also
Engineering system (Page 7185)

S7-1200 manual (http://support.automation.siemens.com/WW/view/en/36932465/0/en)

10.15.3 Basic Panel 2nd Generation

Basic Panel 2nd Generation
The following table helps you assess whether your project meets the performance features of 
the HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         
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Tags

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of tags in the project 800 800 800 800
Number of PowerTags -- -- -- --
Number of elements per array 100 100 100 100
Number of local tags -- -- -- --
Number of structures -- -- -- --
Number of structure elements -- -- -- --

Alarms

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of alarm classes 32 32 32 32
Number of discrete alarms 1000 1000 100 100
Number of analog alarms 25 25 25 25
Length of an alarm in characters 80 80 80 80
Number of process values per alarm 8 8 8 8
Size of the alarm buffer 256 256 256 256
Number of queued alarm events 64 64 64 64

Screens

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of screens 250 250 250 250
Number of fields per screen 100 100 100 100
Number of tags per screen 100 100 100 100
Number of complex objects per screen 1) 150 150 150 150
Number of recipe displays per screen 10 10 10 10
Number of trend displays per screen 8 8 8 8
Number of alarm displays per screen 20 20 20 20
Number of user displays per screen 1 1 1 1
Number of system diagnostic displays per screen 150 150 150 150
Number of array elements per screen 2) 100 100 100 100

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

2) Array elements contained in recipes are included in the count. 
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Recipes

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of recipes 50 50 50 50
Number of elements per recipe1) 100 100 100 100
User data length in KB per data record 32 32 32 32
Number of data records per recipe 100 100 100 100
Reserved memory for data records in the internal Flash 256 KB 256 KB 256 KB 256 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of logs 2 2 2 2
Number of entries per log (including all log segments) 
1)

10 10 10 10

Number of log segments 10000 10000 10000 10000
Cyclic trigger for tag logging 400 400 400 400
Number of tags that can be logged per log 1 s 1 s 1 s 1 s

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of trends 25 25 25 25

Text lists and graphics lists

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of graphics lists 100 100 100 100
Number of text lists 300 300 300 300
Number of entries per text or graphics list 100 100 100 100
Number of graphic objects 1000 1000 1000 1000
Number of text elements 2500 2500 2500 2500
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Scripts

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of scripts -- -- -- --

Communication

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of connections 4 4 4 4
Number of connections based on "SIMATIC HMI 
HTTP"

-- -- -- --

Help system

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of characters in a help text 500 500 500 500

Languages

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of runtime languages 10 10 10 10

Scheduler

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Time-triggered tasks 1) -- -- -- --

1) Event-triggered tasks are not relevant for the system limits

User administration

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Number of user groups 50 50 50 50
Number of authorizations 32 32 32 32
Number of users 50 50 50 50
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Project

 KTP400 Basic KTP700 Basic KTP900 Basic KTP1200 Basic
Size of the project file "*.srt" 10 MB 10 MB 10 MB 10 MB

10.15.4 Panel

Introduction
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of tags in the project 1000 1000 1000 500 1000 2048
Number of PowerTags -- -- -- -- - --
Number of elements per array 50 100 1000 250 1000 1000
Number of local tags -- -- 500 -- 500 1000
Number of structures -- -- -- -- -- 999
Number of structure elements -- -- -- -- -- 400

Alarms

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of alarm classes 32 32 32 32 32 32
Number of discrete alarms 500 1000 1000 1000 2000 4000
Number of analog alarms 3 5 50 15 50 200
Length of an alarm in characters 80 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8 8
Size of the alarm buffer 150 256 256 256 256 512
Number of queued alarm events 50 64 64 64 64 250

Visualize processes
10.15 Performance features

WinCC Professional V13.0
7194 System Manual, 02/2014



Screens

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of screens 500 500 500 250 500 500
Number of fields per screen 20 30 30 30 50 200
Number of tags per screen 20 30 30 30 50 200
Number of complex objects per 
screen 1)

5 5 5 5 5 10

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of recipes -- 5 100 5 100 300
Number of elements per recipe1) -- 20 200 20 200 1000
User data length in bytes per data 
record

-- -- 800 -- 800 4000

Number of data records per recipe -- 20 200 20 200 500
Reserved memory for data records in 
the internal Flash

-- 40 KB 32 KB 40 KB 32 KB 64 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of logs -- -- -- -- -- 20
Number of entries per log (including all 
log segments) 1)

-- -- -- -- -- 10000

Number of log segments -- -- -- -- -- 400
Cyclic trigger for tag logging -- -- -- -- -- 1 s
Number of tags that can be logged per 
log

-- -- -- -- -- 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit
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Trends

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of trends -- -- -- 25 50 300
Number of measured values per trend -- -- -- 999 999 999

Text lists and graphics lists

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of graphics lists -- -- -- 100 100 400
Number of text lists 150 300 300 300 300 500
Number of entries per text or graphics 
list

30 30 30 30 30 256

Number of graphic objects 500 1000 1000 1000 1000 1000
Number of text elements 1000 1000 2500 1000 2500 10000

Scripts

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of scripts -- -- -- -- -- 50

Communication

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of connections 2 4 4 4 4 6
Number of connections based on 
"SIMATIC HMI HTTP"

-- -- -- -- 4 8

Maximum number of connected 
Sm@rtClients (including a service 
client)

-- -- -- -- 2 3

Help system

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of characters in a help text 320 320 320 320 320 320
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Languages

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of runtime languages 5 5 5 5 5 16

Scheduler

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Time-triggered tasks 1) -- -- 10 -- 10 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Number of user groups 25 50 50 50 50 50
Number of authorizations 32 32 32 32 32 32
Number of users 25 50 50 50 50 50

Project

 OP 73 OP 77A OP 77B TP 177A TP 177B
OP 177B

TP 277
OP 277

Size of the project files "*.fwc", "*.srt" 256 KB 320 KB 1 MB 6":512 KB 2 MB 4 MB

See also
Engineering system (Page 7185)

S7-1200 manual (http://support.automation.siemens.com/WW/view/en/36932465/0/en)

10.15.5 Mobile Panel

Mobile Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.
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The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of tags in the project 1000 2048 2048 2048 2048
Number of PowerTags -- -- -- -- --
Number of elements per array 1000 1000 1000 1000 1000
Number of local tags 500 1000 1000 1000 1000
Number of structures -- 999 999 999 999
Number of structure elements -- 400 400 400 400

Alarms

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of alarm classes 32 32 32 32 32
Number of discrete alarms 2000 4000 4000 4000 4000
Number of analog alarms 50 200 200 200 200
Length of an alarm in characters 80 80 80 80 80
Number of process values per 
alarm

8 8 8 8 8

Size of the alarm buffer 256 512 512 512 512
Number of queued alarm events 64 250 250 250 250

Screens

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of screens 500 500 500 500 500
Number of fields per screen 50 200 200 200 200
Number of tags per screen 50 200 200 200 200
Number of complex objects per 
screen 1)

5 10 10 10 10

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.
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Recipes

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of recipes 100 300 300 300 300
Number of elements per recipe1) 200 1000 1000 1000 1000
User data length in bytes per data 
record

800 4000 4000 4000 4000

Number of data records per 
recipe

200 500 500 500 500

Reserved memory for data 
records in the internal Flash

32 KB 64 KB 64 KB 64 KB 64 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of logs -- 20 20 20 20
Number of entries per log 
(including all log segments) 1)

-- 10000 10000 10000 10000

Number of log segments -- 400 400 400 400
Cyclic trigger for tag logging -- 1 s 1 s 1 s 1 s
Number of tags that can be 
logged per log

-- 2048 2048 2048 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of trends 50 300 300 300 300
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Text lists and graphics lists

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of graphics lists 100 400 400 400 400
Number of text lists 300 500 500 500 500
Number of entries per text or 
graphics list

30 256 256 256 256

Number of graphic objects 1000 1000 1000 1000 1000
Number of text elements 2500 10000 10000 10000 10000

Scripts

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of scripts -- 50 50 50 50

Communication

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of connections 4 6 6 6 6
Number of connections based on 
"SIMATIC HMI HTTP"

4 8 8 8 8

Maximum number of connected 
Sm@rtClients (including a 
service client)

2 2 8'': 3
10": 2

8'': 3
10": 2

8'': 3
10": 2

Mobile Wireless

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of zones -- -- 254 254 --
Number of effective ranges -- -- -- 127 --
Number of assigned 
transponders - zones

-- -- 255 255 --

Number of assigned 
transponders - effective ranges

-- -- -- 127 --

Number of effective ranges 
(RFID)

-- -- -- -- 127

Number of RFID tags that can be 
assigned to effective ranges 
(RFID) in a project

-- -- -- -- 127
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Help system

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of characters in a help 
text

320 320 320 320 320

Languages

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of runtime languages 5 16 16 16 16

Scheduler

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Time-triggered tasks 1) 10 48 48 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 
277F IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Number of user groups 50 50 50 50 50
Number of authorizations 32 32 32 32 32
Number of users 50 50 50 50 50

Project

 Mobile 
Panel 177

Mobile 
Panel 277

Mobile Panel 
277 IWLAN V2

Mobile Panel 277F 
IWLAN V2

Mobile Panel 277F 
IWLAN (RFID Tag)

Size of the project file "*.fwc" 2 MB 6 MB 6 MB 6 MB 6 MB

See also
Engineering system (Page 7185)

S7-1200 manual (http://support.automation.siemens.com/WW/view/en/36932465/0/en)
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10.15.6 Multi Panel

Multi Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.         

Tags

 MP 177 MP 277 MP 377
Number of tags in the project 1000 2048 4096
Number of PowerTags -- -- --
Number of elements per array 1000 1000 1000
Number of local tags 500 1000 2000
Number of structures -- 999 999
Number of structure elements -- 400 400

Alarms

 MP 177 MP 277 MP 377
Number of alarm classes 32 32 32
Number of discrete alarms 2000 4000 4000
Number of analog alarms 50 200 200
Length of an alarm in characters 80 80 80
Number of process values per alarm 8 8 8
Size of the alarm buffer 256 512 1024
Number of queued alarm events 64 250 500

Screens

 MP 177 MP 277 MP 377
Number of screens 500 500 500
Number of fields per screen 50 200 400
Number of tags per screen 50 200 400
Number of complex objects per screen 1) 5 10 20
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1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 MP 177 MP 277 MP 377
Number of recipes 100 300 500
Number of elements per recipe1) 200 1000 1000
User data length in KB per data record 0.8 4 128
Number of data records per recipe 200 500 1000
Reserved memory for data records in the 
internal Flash

32 KB 64 KB 128 KB

1) If arrays are used, each array element counts as one recipe element

Logs

 MP 177 MP 277 MP 377
Number of logs -- 20 50
Number of entries per log (including all log 
segments) 1)

-- 10000 50000

Number of log segments -- 400 400
Cyclic trigger for tag logging -- 1 s 1 s
Number of tags that can be logged per log -- 2048 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 MP 177 MP 277 MP 377
Number of trends 50 300 400

Text lists and graphics lists

 MP 177 MP 277 MP 377
Number of graphics lists 100 400 500
Number of text lists 300 500 500
Number of entries per text or graphics list 30 256 256
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 MP 177 MP 277 MP 377
Number of graphic objects 1000 1000 2000
Number of text elements 2500 10000 30000

Scripts

 MP 177 MP 277 MP 377
Number of scripts -- 50 100

Communication

 MP 177 MP 277 MP 377
Number of connections 4 6 6
Number of connections based on "SIMATIC 
HMI HTTP"

4 8 8

Maximum number of connected 
Sm@rtClients (including a service client)

2  6'': max. 3
10'': max. 2

12'': max. 3
15'': max. 2
 19": max: 1

Help system

 MP 177 MP 277 MP 377
Number of characters in a help text 320 320 320

Languages

 MP 177 MP 277 MP 377
Number of runtime languages 5 16 16

Scheduler

 MP 177 MP 277 MP 377
Time-triggered tasks 1) 10 48 48

1) Event-triggered tasks are not relevant for the system limits
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User administration

 MP 177 MP 277 MP 377
Number of user groups 50 50 50
Number of authorizations 32 32 32
Number of users 50 50 50

Project

 MP 177 MP 277 MP 377
Size of the project file "*.fwc" 2 MB 6 MB 12 MB

See also
Engineering system (Page 7185)

S7-1200 manual (http://support.automation.siemens.com/WW/view/en/36932465/0/en)

10.15.7 Comfort Panel

Comfort Panel
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.

 
 

 Note
Graphic objects on Comfort Panels

The use of 32-bit graphic objects increases memory requirements for the project file on 
Comfort Panels.
The use of jpeg graphic objects reduces memory requirements for the project file on Comfort 
Panels.
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Tags

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of tags in the project 1024 2048 4096 4096 4096
Number of PowerTags -- -- -- -- --
Number of elements per array 1000 1000 1000 1000 1000
Number of local tags 500 1000 2000 2000 2000
Number of structures 999 999 999 999 999
Number of structure elements 400 400 400 400 400

Alarms

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of alarm classes 32 32 32 32 32
Number of discrete alarms 2000 4000 6000 6000 6000
Number of analog alarms 50 200 200 200 200
Length of an alarm in characters 80 80 80 80 80
Number of process values per alarm 8 8 8 8 8
Size of the alarm buffer 256 1024 1024 1024 1024
Number of queued alarm events 64 500 500 500 500

Screens

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of screens 500 500 750 750 750
Number of fields per screen 50 400 600 600 600
Number of tags per screen 50 400 400 400 400
Number of complex objects per 
screen 1)

5 20 40 40 40

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.
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Recipes

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of recipes 100 300 500 500 500
Number of elements per recipe1) 200 1000 2000 2000 2000
User data length in KB per data 
record

32 256 512 512 512

Number of data records per recipe 200 500 1000 1000 1000
Reserved memory for data records 
in the internal Flash

512 KB 2 MB 4 MB 4 MB 4 MB

1) If arrays are used, each array element counts as one recipe element

Logs

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of logs 10 50 50 50 50
Number of entries per log (including 
all log segments) 1)

10000 20000 50000 50000 50000

Number of log segments 400 400 400 400 400
Cyclic trigger for tag logging 1 s 1 s 1 s 1 s 1 s
Number of tags that can be logged 
per log

100 2048 2048 2048 2048

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of trends 50 300 400 400 400
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Text lists and graphics lists

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of graphics lists 100 500 500 500 500
Number of text lists 300 500 500 500 500
Number of entries per text or 
graphics list

30 500 500 500 500

Number of graphic objects 1000 4000 4000 4000 4000
Number of text elements 2500 40000 40000 40000 40000

Scripts

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of scripts 50 100 200 200 200

Communication

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of connections 4 8 8 8 8
Number of OPC connections 
including OPC UA

4 8 8 8 8

Number of connections based on 
"SIMATIC HMI HTTP"

4 8 8 8 8

Maximum number of connected 
Sm@rtClients (including a service 
client)

2 3 3 2 1

Help system

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of characters in a help text 500 500 500 500 500
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Languages

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of runtime languages 32 32 32 32 32

Scheduler

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Time-triggered tasks 1) 10 48 48 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of user groups 50 50 50 50 50
Number of authorizations 32 32 32 32 32
Number of users 50 50 50 50 50

Project

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Size of the project file "*.fwc" 4 MB 12 MB 24 MB 24 MB 24 MB

See also
Engineering system (Page 7185)

S7-1200 manual (http://support.automation.siemens.com/WW/view/en/36932465/0/en)
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10.15.8 WinCC Runtime Advanced

WinCC Runtime Advanced
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.       

Tags

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of tags in the project 6144 12288
Number of PowerTags 128 - 4096 128 –8192
Number of elements per array 1600 1600
Number of local tags 2048 4096
Number of structures 999 999
Number of structure elements 400 400

Alarms

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of alarm classes 32 32
Number of discrete alarms 4000 6000
Number of analog alarms 500 500
Length of an alarm in characters 80 80
Number of process values per alarm 8 8
Size of the alarm buffer 1024 2048
Number of queued alarm events 500 500

Screens

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of screens 500 750
Number of fields per screen 400 600
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 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of tags per screen 400 400
Number of complex objects per screen 1) 40 40

1) Complex objects include: Bars, sliders, symbol library, clock, and all objects from the 
Controls area.

Recipes

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of recipes 999 1000
Number of elements per recipe1) 2000 2000
User data length in KB per data record 256 512
Number of data records per recipe 5000 5000
Reserved memory for data records in the internal Flash -- --

1) If arrays are used, each array element counts as one recipe element

Logs

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of logs 100 100
Number of entries per log (including all log segments) 
1)

500000 500000

Number of log segments 400 400
Cyclic trigger for tag logging 1 s 1 s
Number of tags that can be logged per log 6144 12288

1) The number of entries for the "segmented circular log" logging method is the total 
number for all sequential logs. The product of the number of sequential logs and the 
number of data records per sequential log may not exceed the system limit

Trends

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of trends 800 800
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Text lists and graphics lists

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of graphics lists 500 500
Number of text lists 500 500
Number of entries per text or graphics list 3500 500
Number of graphic objects 2000 4000
Number of text elements 30000 40000

Scripts

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of scripts 200 200

Communication

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of connections 8 8
Number of OPC connections including OPC UA 8 8
Number of connections based on "SIMATIC HMI HTTP" 16 16
Maximum number of connected Sm@rtClients 
(including a service client)

4 1) 4 1)

Help system

 KTP400
KP400

TP700, KP700
TP900, KP900
TP1200, 
KP1200

TP1500
KP1500

TP1900 TP2200

Number of characters in a help text 320 1)

500 2)

320 1)

500 2)

320 1)

500 2)

320 1)

500 2)

320 1)

500 2)

1)
2)

For devices with HMI device version 12 or lower
For devices with HMI device version higher than 12
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Languages

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of runtime languages 32 32

Scheduler

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Time-triggered tasks 1) 48 48

1) Event-triggered tasks are not relevant for the system limits

User administration

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Number of user groups 50 50
Number of authorizations 32 32
Number of users 100 100

Project

 WinCC Runtime Advanced
Device version prior to 13

WinCC Runtime Advanced
Device version as of 13

Size of the project file "*.fwc" No limiting No limiting

See also
Engineering system (Page 7185)

S7-1200 manual (http://support.automation.siemens.com/WW/view/en/36932465/0/en)

10.15.9 WinCC Runtime Professional

WinCC Runtime Professional
The following tables of system limits help you assess whether your project conforms to the 
system limits of a given HMI device. Keep the performance characteristics of the engineering 
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system in mind in this context. If they are lower, they have priority over the limits given for 
Runtime.

The specified maximum values are not additive. It cannot be guaranteed that configurations 
running on the devices at the full system limits will be functional.

In addition to the specified limits, allowances must be made for restrictions imposed by 
configuration memory resources.       

Tags
 

 WinCC Runtime Professional
Number of tags in the project 150,000
Number of PowerTags  
Number of elements per array 2,000
Number of local tags  
Number of structures  
Number of structure elements  

Screens

 WinCC Runtime Professional
Objects per screen 1) No limit 2)

Layers per screen 32
Screens per project No limit 2)

Fixed faceplate instances in a plant screen 31 instances of the same type screen
Screen size in pixels 10,000 x 10,000
Screen object nesting 20
Number of colors Depends on graphics card

1) The number and complexity of objects affects performance
2) Limited by system resources.

Alarms

 WinCC Runtime Professional
Configurable alarms per server/single-user station 150,000
Process tags per alarm line 10
User text blocks per alarm line 10
Alarm classes 256
Alarm priorities 17 (0...16)

Visualize processes
10.15 Performance features

WinCC Professional V13.0
7214 System Manual, 02/2014



Alarms in Runtime

 Maximum
Alarms per alarm log No limit 1)

Alarms per historical alarm list (short-term) 1,000
Alarms per historical alarm list (long-term) 1,000 2)

Alarms per alarm view 5,000 3)

1) Limited by system resources.
2) On single-user station, or server or client per server if "LongTimeArchiveConsistency" 

has been set to "no". On single-user station, server, or client if 
"LongTimeArchiveConsistency" has been set to "yes".

3) On single-user station or server, or on client per server.
 

 Note

Message bursts and continuous alarm load may be generated simultaneously on a single-
user station or server.

 

Logs

 WinCC Runtime Professional
Trend view per screen 25
Trends per trend view 80
Table view per screen 25
Columns per table view 12
Values per table view 30,000
Logs per single-user station/server 100
Logging tags per single-user station/server 1) 80,000

1) Depends on the Logging PowerPack used for logging tags. The basic version contains 
500 logging tags.

 

 Note

Screen selection times may be extremely long in the event of multiple maximum values.
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Recipes

 WinCC Runtime Professional
Number of recipes No limit 1)

Number of recipe elements 500 2)

Number of recipe data records 3,000 2)

Number of views No limit 1)

1) Limited by system resources.
2) The product of the number of fields and number of data records must not amount to 

more than 320,000 cells, e.g. 3000 data records for 106 fields, or 640 data records for 
500 fields. Both the first two columns (grey column and "ID" column) and the column 
titles must be counted when calculating the current number of cells.

Reports

 WinCC Runtime Professional
Configurable reports No limit 1)

Report lines per detail view 66
Tags per report 2) 300

1) Limited by system resources.
2) The number of tags per report depends on the performance of process communication.

Reports in runtime

 Maximum
Alarm sequence reports running simultaneously per server/client 1
Alarm log reports running simultaneously 3

Communication
 

 S7-1200 S7-1511 S7-1513 S7-1516
Maximum number of WinCC system 2 20

 
30 41

ISO-on-TCP connections  - 64 
(4 of which are 
reserved for ES)

96
(4 of which are 
reserved for ES)

128
(4 of which are reserved for 
ES)
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 S7-1200 S7-1511 S7-1513 S7-1516
Maximum number of connected 
PLCs per Runtime

32

Maximum number of connected 
PLCs with Softnet via a network 
adapter

16

● Note that a maximum of 200 tags per controller should be configured for communication 
with S7-1200 PLCs. 

● If several HMI devices access a PLC, this limit applies for all HMI devices.
● You can learn how many HMI devices can simultaneously access a SIMATIC S7-1200 

in the manual for the controller.
Entry ID: 36932465 (http://support.automation.siemens.com/WW/view/en/36932465/0/
en)

 

Configurations - quantity structure in the multi-station system

 WinCC Runtime Professional
WinCC clients in a system 32 1) 2)

Web clients in a system 50 3)

1) The number of clients is reduced to four if the server also used as operator station.
2) Mixed configuration: 32 clients + 3 Web clients
3) Mixed configuration: 50 Web clients + 1 WinCC client

See also
Engineering system (Page 7185)

10.15.10 Orientation help for performance in Runtime (WinCC Runtime Professional)

WinCC Runtime Professional
The following tables help you to assess operational performance of your project in 
Runtime.     

 

 Note

The values specified greatly depend on the hardware used.
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Screens in Runtime

Screen change from an empty screen to... Time in seconds
Screen with standard objects (100 objects) 1
Screen with 2480 I/O fields (8 internal tags) 2
Screen with 1000 I/O fields (1000 internal tags) 1
10 MB screen (bitmap) 1
Alarm view 2
Table view with 4 columns, each with 120 values 1) 1

1) The values specified are valid for data from "Tag Logging Fast".

Alarms in Runtime

 Maximum
Continuous alarm load without losses (single-user station/server) 10/sec
Message burst (single-user station/server) 2000/10 seconds at intervals of 5 minutes 1)

1) Alarms are possibly lost if the interval before the next message burst is less than five 
minutes.

 

 Note

Message bursts and continuous alarm load may be generated simultaneously on a single-
user station or server.

 

Logs in runtime

 Maximum
Logging in database for server/single-user station (Tag Logging Fast) 5000 values/second 1) 

Logging in database for server/single-user station (Tag Logging Slow) 1000 values/second 1) 2)

Number of values printed in a report The number of values printed depends on the 
number of values displayed in the trend view.

1) The values specified are valid for logging data without signature.
2) With Tag Logging Slow, expect longer screen selection times for a given amount of 

data than for Tag Logging Fast.
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Recipes in Runtime - boundary conditions

Hardware used Software used Configuration
1.5 GHz AMD Athlon 4
2 GB RAM
No hardware connection

Windows Server 2003 SP2
WinCC V11.0

One WinCC tag per field
300,000 entries each:
- 10 fields with 30,000 data records
- 500 fields with 600 data records

Recipes in Runtime - measured values

 10 fields 500 fields
Screen change to a screen with integrated recipe view.
Result of measurement depends on the fill level of the control: 
It can take up to 15 seconds for complete display upon initial 
loading or if considerable configuration changes are made in the 
user log.

1 second 5 seconds

Read data record:
Read the value to the corresponding tag after the button in the 
recipe view was clicked.

1 - 2 seconds 1) n seconds 2)

Write data record: 
Write the value to the corresponding tag and display of the tag 
in the I/O field after the button in the recipe view was clicked.

1 - 3 seconds 1) n seconds 2)

Focus change from the first to the last data record. 1 - 2 seconds 1 - 2 seconds

1) 10 fields with a total of 10 tags.
2) 500 fields with a total of 500 tags.

Scripting Runtime
The following measured values show the differences between VBS and C on the basis of guide 
values. The measured values are entered in milliseconds

Pentium 4 2.5 GHz, 512 MB RAM VBS ANSI-C
Setting the color of 1000 rectangles 220 1,900
Setting the output value of 200 I/O fields 60 170
Selection of a screen with 1000 static texts which retrieve the object name 
and output it as a return value.

460 260

Read 1000 internal tags 920 500
Re-read 1000 internal tags 30 120
Carry out 100,000 calculations 1) 280 70

Pentium III 700 MHz, 512 MB RAM VBS ANSI-C
Setting the color of 1000 rectangles 610 4,440
Setting the output value of 200 I/O fields 170 670
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Pentium III 700 MHz, 512 MB RAM VBS ANSI-C
Selection of a screen with 1000 static texts which retrieve the object name 
and output it as a return value.

770 310

Read 1000 internal tags 3,650 1,310
Re-read 1000 internal tags 70 250
Carry out 100,000 calculations 1) 820 170

1) Sample calculations:
 VBS

For i=1 To 100000
value=Cos(50)*i
Next

ANSI-C
for(i=1;i<=100000;i++)
{
dValue=cos(50)*i;
}

 

 Note

The measured values are also affected by the type of configuration and other processes, 
such as logging or alarm processing.

 

Reports in runtime

 Maximum
Alarm sequence reports running simultaneously per server/client 1
Alarm log reports running simultaneously 3

See also
Engineering system (Page 7185)

10.15.11 General technical specifications

10.15.11.
1

Permitted characters

Introduction
The following table shows the restrictions that must be observed when allocating names and 
passwords.
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Permitted characters
 

Names / passwords Restriction
Names of objects Do not use the special characters ?  "  /  \  *  <  >  %
Names and passwords in user view Do not use the special characters ?  "  /  \  §  &  $  %
Names of alarm logs In the storage location file - RDB, file - CSV (ASCII) and file -TXT (Unicode) 

do not use the characters \  /  *  ?  :  "  <  >  |
For the storage location database, use only the characters a-z  A-Z  0-9  _  @  #  
$
The characters _ @ # $ may not be used as the first character of a name

Name of HMI tags HMI tag names may not start with the @ character
Names of screens Do not use the special characters ?  "  /  \  *  <  >
Names of AuditTrails Do not use any special characters
Names of connections Do not use spaces or special characters
Name of VB functions Do not use spaces, special characters or VB keywords
Name of Windows user groups and 
Windows users when using SIMATIC 
Logon

Do not use the special characters /  \

10.15.11.
2

Recommended printers

Recommended printers
The current list of printers recommended for use with the HMI devices is available on the 
Internet at:

Link to the current printer list (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&caller=view&extranet=standard&viewreg=WW&nodeid0
=10805558&objaction=csopen) 

 

 Note

All HMI devices except for a PC and Panel PC support only one printer at their USB port, 
even if several ports are available.

 

See also
Printer list (http://support.automation.siemens.com/WW/llisapi.dll?
aktprim=0&lang=en&referer=%2fWW
%2f&func=cslib.csinfo&siteid=csius&caller=view&extranet=standard&viewreg=WW&nodeid0
=10805558&objaction=csopen)
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10.15.11.
3

Printing via print server

Introduction
Print servers enable access to network printers.  Print jobs are routed to a corresponding printer 
via the print server.     

 

 Note

Printing takes place via the print server for the following HMI devices:
● xP 177, Mobile Panel 177
● xP 277, Mobile Panel 277, Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
● Mobile Panel 277 IWLAN V2, Mobile Panel 277F IWLAN V2, Mobile Panel 277F IWLAN 

(RFID Tag)
● MP 377
● PC with WinCC Runtime Advanced

 

Requirements
● The print server deploys the "RAW" mode.

 

  Note

For additional information on settings, refer to the relevant print server documentation.
 

● The device is interconnected via Ethernet with the print server or with a printer featuring an 
integrated print server.

● External print servers are interconnected with a printer via USB port.

● The IP address and port used are identical in the "Printer Properties" of the HMI device and 
on the print server.

Procedure
1. Open the "Control Panel" on your HMI device.

2. Select "Printer". The "Printer Properties" dialog box opens.

3. Select a printer from the "Printer Language" selection list.
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4. Select the "PrintServer" entry from the "Port" selection list.

5. Enter the IP address and the port used for communication with the printer in the "IP:Port" 
input field.

 

  Note

Use the ":" character as delimiter between the IP address and the port number. For 
example: "192.168.56.23:9100".

 

6. Select any additional printer settings.

10.15.11.
4

Memory requirement of recipes

Introduction
The following calculation of memory requirements of recipes is only valid for Windows CE 
devices. 

Calculation of memory requirements
The memory space required by each recipe (in KB) is derived from the sum of D1 + D2 + D3.

Valid is:

● D1 = (number of entries x 5 + M + 8):1024
Applies to M:
M = Accumulated length of all tag names = sum of characters in all tag names (UTF8 coded, 
max. 255 bytes per tag name) used in the entries.

● D2 = [(number of data records x 12) + 4]:1024

● D3 = [number of data records x (data record length + N) + 4]:1024
Applies to N:

The total length of the name of the corresponding data record in all languages (max. 255 bytes 
per language) + overhead per data record (1 byte + number of languages * 3 bytes). 

D1, D2 and D3 are rounded to the next higher number.

Memory requirements for using arrays
The memory required by each recipe (in KB) is derived from the sum of D1 + D2 + D3.

Valid is:
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● D1 = (number of entries x 5 + M + 8):1024
Each element of the tag array used counts as a single entry.
Applies to M:
M = (length of the array tag name + K) x  number of array elements
Applies to K:
K = 3: 2 to 9 elements in the array
K = 4: 10 to 99 elements in the array
K = 5: 100 to 999 elements in the array
K = 6: 1000 to 9999 elements in the array
K = 7: 10000 to 12000 elements in the array

● D2 = [(number of data records x 12) + 4] : 1024

● D3 = [number of data records x (data record length + N) + 4] : 1024
Applies to N:

The total length of the name of the corresponding data record in all languages (max. 255 bytes 
per language) + overhead per data record (1 byte + number of languages * 3 bytes). 

D1, D2 and D3 are rounded to the next higher number.
 

 Note

If you use both tags and arrays in a recipe, you have to add the results of both formulas to 
calculate the total memory required.

 

 

10.15.11.
5

Memory requirements of recipes for Basic Panels, OP 77A, and TP 177A

Introduction
The following calculation of memory requirements of recipes is valid for Basic Panels, OP 77A, 
and TP 177A devices. 

Restrictions
The HMI device provides 39 KB of memory space for recipes. This memory space may not be 
exceeded. The total memory space for recipes is calculated as follows: Total of all recipes + 
recipe with highest memory requirement.

Each recipe may not exceed a maximum memory space of 19 KB.

Calculation of memory requirements
The memory space requirement of each recipe (in KB) is calculated based on the three 
addends D1 + D2 + D3.

Valid is::
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● D1 = number of data records x M
 
Rule for M (size of a data record):
M = 1 x number of elements of a byte + 2 x number of elements of 2 bytes + 4 x number 
of elements of 4 bytes + 8 x number of elements of 8 bytes + K
 
Rule for K (size of the string elements):
K = number of string elements x (string length + 1) x 2

 

● D2 - data record size
 
D2 = 4 + number of languages x 8 + number of languages x (4 + 4 x number of data records 
+ (length of the data record name + 1) x 2 x number of data records) + 8 + 8 x number of 
data records
 
Or rewritten:
 
D2 = 12 + 8 x number of data records + number of languages x (12 + number of data records 
x (4 + (length of the data record name +1) x 2))

 

● D3 - shared memory
D3 = 14 + number of elements

 

 Note

Arrays and single elements can be calculated as described above.
 

 

10.16 Options

10.16.1 WinCC Audit

10.16.1.1 Basics

GMP compliance

GMP compliant projects with WinCC    
Traceability and therefore the documentation of production data is becoming increasingly 
important in many industrial sectors such as the pharmaceuticals industry, the food and 
beverage industry. and in the related mechanical engineering sector. 
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Storage of production data in electronic form offers many advantages compared to paper 
documents, such as simple acquisition and logging of data. 

However, it is also important to ensure that data cannot be falsified and that it can be read at 
any time. 

Industry-specific and general standards for electronic documentation of production data have 
been developed for this purpose. 

The most important set of regulations is the FDA guideline 21 CFR Part 11 for electronic data 
records and electronic signatures issued by the FDA, the US Food and Drug Administration. 
The various EU regulations, such as EU 178/2002, also apply for particular industries.

Requirements for production systems in these industries have been developed on the basis 
of 21 CFR Part 11 and the corresponding layout to comply with GMP (Good Manufacturing 
Practice). They are also required for other industries.

The following primary requirements are derived from these directives and rules:

● Creation of an Audit Trail or operating trace in runtime
This document can be use to trace a complete log of which user has run what control 
function on the machine at what time.

● Important process stages must also be traceable to a specific responsibility, for example 
with an electronic signature.

GMP-compliant configuration

Introduction
"GMP compliant configuration" means creating projects in accordance with "Good 
Manufacturing Practice". The requirements are set out in FDA rules "21 CFR Part 11". The 
FDA is the U.S. Food and Drug Administration. 

GMP-compliant configuration means HMI devices have electronic production data 
documentation functionalities.

GMP relevant and the audit trail
WinCC offers the "Audit" option for implementing GMP compliance. Using the audit option, the 
"GMP compliant configuration" function can be enabled.

Enable the "GMP compliant configuration" function directly in the runtime settings of the HMI 
device. GMP relevant functionalities are then added to WinCC. These functionalities are:

● Audit Trail

● Electronic signature

● Option to label tags as "GMP relevant".

● Option to label tags as "GMP relevant" for recipes.

● NotifyUserAction system function

● Logging of tags using checksum
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● Logging of alarms using checksum

● Audit trail record for printing logged changes

A license is required to convert the GMP-relevant functions configured in WinCC in runtime.

Depending on the edition of WinCC, use one of the following licenses:

● WinCC Audit for RT Advanced

● WinCC Audit for SIMATIC Panel

If the labeled objects are executed or changed, then it is saved in a special log, the "Audit Trail".

See also
Configuring a checksum for a log (Page 3770)

Configuring a checksum for a log (Page 4020)

Audit option

Advanced functions    
The Audit option adds functions to WinCC to ensure that your project is GMP compliant.

The following functions are added:

● Audit Trail
For every HMI device, you can create an Audit Trail .
Operator actions and system processes that are relevant for the FDA-compliance of the 
process are recorded in an Audit Trail during runtime. 

– User actions such as changes in the values of GMP relevant tags or recipes or the 
acknowledgment of alarms.

– Actions by the system, such as starting up runtime or rejection of logon attempts.

● Electronic signature
You can set mandatory acknowledgement of important user actions in runtime, such as 
changing recipe data records or tag values. 
All  Audit-relevant user actions must be protected by authorization in the user administration.
The user will then only be able to run these actions if an electronic signature and, if 
configured appropriately, a comment have been input. The electronic signature and the 
comment are logged in the audit trail.

Extension of the WinCC engineering system  
For all HMI devices that support "GMP-compliant configuration", the WinCC engineering 
system is extended to include the following configuration options when GMP is enabled:

● The entry "AuditTrail" is added to the "Logs" editor.

● A "Good Manufacturing Practice Settings" entry is added to "HMI tags" editor in the 
inspector window of a "Properties > Properties" tag.
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● A "Good Manufacturing Practice" entry is added to "Recipes" editor in the inspector window 
of a "Properties > Properties" recipe.

● "NotifyUserAction" system function

 

Scope of logging

Introduction   
It is important to ensure that audit-related processes are always logged in runtime in the audit 
trail in a project with the option "Audit". 

Scope of logging  
The following operations are Audit-relevant and are automatically saved in the Audit Trail:

● Runtime sequence

– Runtime start and runtime stop

– Project information: Version and project name, of the configuration environment, device, 
and current runtime configuration

– Failure of the voltage supply of an active Uninterruptible Power Supply (UPS).

● User administration

– Logon and logoff of users

– Invalid logon attempts

– Import of user administration

– Changes of user administration

● Alarm system

– All alarms that are acknowledged by the user.

– All acknowledgment attempts of the user
 

  Note
Logging alarm text

To log alarm texts, select the "Log alarm text in Audit Trail" option in the Audit Trail 
editor:

"Audit trail > Properties > Settings" in the "Settings" area
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● Log operations

– Starting, stopping and copying a log

– Opening and closing all logs

– Deleting a log

– Starting a sequence log

– Long-term logging of a log

● Running specific system functions depending on their functionality and the triggering event

The following audit processes are logged depending on the configuration of the recipes and 
the tags of the project:

● Change values of GMP-relevant tags by the user

● for GMP-relevant recipes:

– Storing after changing and creating recipe data records

– Transfer of recipe data records to the PLC and from the PLC

– For recipe tags: Changing the setting for the synchronization of the tag values with the 
PLC ("offline"/"online")

● "NotifyUserAction" system function
You use the system function "NotifyUserAction" to record user actions that are not 
automatically recorded by the audit trail. 
You can configure this system function for screen calls, for example You can also configure 
function lists containing system functions that do not require signature or acknowledgement.

10.16.1.2 Enabling GMP compliant configuration

Introduction
The Audit Trail and "Electronic Signature" functions are qualified as "GMP compliant 
configuration". 

Requirements
● A project is created.

● A GMP compatible HMI device has been created.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Runtime settings".
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3. Click on "GMP".

4. Select "GMP compliant configuration".

Result
The Audit option is now enabled for the HMI device. 

The following functions can now be configured:

● Audit Trail log

● "NotifyUserAction" system function

● GMP relevant tags

● GMP relevant recipes

See also
Configuring a checksum for a log (Page 3770)

Evaluating the checksum of log data (Page 3771)

Configuring a checksum for a log (Page 4020)

Evaluating the checksum of log data (Page 4021)
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10.16.1.3 Using the Audit trail

Audit Trail

Introduction   
Configure a log in the settings for Audit Trail editor. This log is used to store changes in tag or 
recipe values made by the user and other user actions in runtime. 

"Settings for audit trail" editor
1. In the project view, double-click "AuditTrail" in the "Log" group.

2. Click on the "Settings for audit trail" tab.

3. Change the properties of Audit Trail in the inspector window.

Audit trail work area
You define the settings for the Audit Trail in the "Properties > Properties" inspector window. 
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You set the name of the log and the storage location and decide whether logging will begin on 
startup. Also determine if "Forcing" is permitted. 

"Forcing" is a function for administrators. It allows the administrator to continue the process 
even if the maximum log storage space has been exceeded. 

Thus, the Audit Trail switches off and must be rebooted using the "StartLogging" system 
function.

Creating an audit trail

Requirements
"GMP compliant configuration" has been selected on the HMI device.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Logs".
The "Logs" editor will open.
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3. Change to the "Audit Trail" tab.
An audit trail has been created.

4. Define the following in the inspector window:

– Name

– Storage location

– Logging with runtime start-up

– Forcing
 

  Note

No audit-related user actions are permitted in GMP relevant projects if there is 
insufficient storage space available for the audit trail. 

If the check box "Forcing permitted" is activated and, because of the hardware, there 
is insufficient storage space in runtime, the administrator can interrupt audit trail 
logging. The administrator can prevent the process from stopping in this way. 

If the administrator enables the "Forcing" function, the interruption of the audit trail by 
the administrator will be entered in the audit trail as the last entry.

At the end of "Forcing" restart the audit trail using the "StartLogging" system function.
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Configuring a function list
If necessary, configure a function list for the events "Low free storage space" and "Free space 
critically low". 

The "Low free storage space" event is triggered if the amount of free storage space available 
for the audit trail in runtime is less than the amount configured in "Minimum storage space in 
MB". 

The "Free space critically low" event is triggered if there is no longer sufficient free storage 
space for the audit trail in runtime. The value depends on the HMI device.

For more information refer to chapter: Low free storage space (Page 7241)

Result
Audit relevant user actions are entered in the configured audit trail in runtime.

Parameters for the audit trail

Introduction
Configure Audit Trail in the "Logs" editor if you have enabled "GMP compliant configuration" 
in the runtime settings.

There are two ways of assigning parameters for the audit trail:

● "Settings for audit trail" editor

● "Audit Trail" inspector window

Editor "Audit Trail"
The "Audit Trail" editor is an overview of the Audit Trail created.

Only one Audit Trail can be created per HMI device. 

Parameters that are assigned for the Audit Trail can be seen in the line. You can select or 
deselect the parameters displayed.

The parameters of an Audit Trail are also displayed and described in more detail in the 
inspector window.
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General inspector window
You can set the following parameters under "Audit trail > Properties > General":
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Name
● Under "Name", assign a name for the Audit Trail .

Special characters are not permitted when assigning the name.

Storage location
● Storage location

You can choose between:

– a CSV file (ASCII)

– a TXT file (Unicode)
 

  Note

Use "TXT (Unicode)" as storage location for logging Asian languages.
 

● Path
Depending on the HMI device, enter the storage location of the Audit Trail  under "Path".

● Minimum space in MB
Specify the size of remaining storage space that triggers the "Less free storage space" 
event.
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Inspector window settings
You can set the following parameters under "Audit trail > Properties > Properties > Settings":

Visualize processes
10.16 Options

WinCC Professional V13.0
System Manual, 02/2014 7237



Logging activation
● Enable logging at runtime start

Forcing
● Bypass electronic signature

Specifies whether the administrator is permitted to run operator actions without entering an 
electronic signature or comments.

● Forcing allowed if storage space is exhausted
This function allows the administrator to interrupt audit trail logging in the following 
scenarios:

– There is no free storage space available.

– The storage medium is missing.

– Access to required storage medium is not possible.

You can thus prevent the process from stopping. 
After Forcing was carried out, the audit trail log switches off.
After the end of "Forcing", the audit trail must be restarted with the system function 
"StartLogging".

Settings
● Logging alarm texts in the audit trail.

 

  Note

Use "TXT (Unicode)" as storage location for logging Asian languages.
 

For further details on setting the logging language, refer to the following section:
Setting the audit trail language (Page 7240) 

Setting the audit trail language

Introduction
The logging language for an Audit Trail is set in the runtime settings.

Procedure
1. Double-click on the HMI device in the project tree.

2. Double-click "Runtime settings".
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3. Click "General".

4. Select the logging language in the "Logs" area.
 

  Note

If an Asian language was selected, use the "TXT (Unicode)" storage location in the "Audit 
trail" editor.

 

Low free storage space

Low free storage space

Description
This event is triggered if the storage space available on the medium to which the Audit Trail 
is less than the configured minimum. 
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Free space critically low

Description
This event is triggered if the storage medium to which an Audit Trail is saved provides 
insufficient storage space due to hardware restrictions. 

 

Configuring the "Low free storage space" event

Requirements
● A GMP- compliant configuration is enabled

● An Audit Trail is created

Procedure
1. Click on the Audit Trail in the "Audit Trail" editor.

2. In the Inspector window, click "Properties > General".

3. In the "Free storage space limit in MB" area, select a value that triggers the "Little free 
space" event.

4. Click on Events in the Inspector window.

5. Click on the "Low free storage space" event.

6. In the function list, specify a system function to execute when an "Overflow" event is 
triggered.

Logging the audit trail

Reporting an audit trail

Introduction
You can print a report of the operations saved in an Audit Trail. All recorded actions are included 
in the printout.

Requirements for reporting
The "Audit trail report" report object is available for the printout of an Audit Trail. 

You can configure the report in the "Report" editor. The report object is only available if the 
"GMP-compliant configuration" option is set in the runtime settings of the HMI device.     
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If an Audit  must be printed in runtime, initially the logging of Audit Trail must be stopped using 
the "StopLogging" system function. 

Whilst an Audit Trail is being printed, no user actions are recorded. Ensure that no GMP-
relevant user actions are executed whilst the logging is stopped.

After printing is complete without any errors, restart the audit trail using the "StartLogging" 
system function.

The header of the report is printed in the current runtime language. Change the runtime 
language to the logging language accordingly. 

The logged data from Audit  are printed in the configured runtime logging language. 

In order to receive a complete report, the report object can also be used in a report in 
conjunction with the "Print alarm" and "Print recipe" report objects.

See also
Audit report (Page 4345)

Audit Trail reporting

Introduction
You use the "Audit Trail" report object to configure a report for the output of Audit Trail contents 
to a printer. 

Once the printout is started in runtime, all entries currently contained in the Audit Trail are 
printed out.

Procedure
To create a report, proceed as follows:

1. Double-click on the "Reports" entry in the project tree.

2. Double-click "Add new report".
A new report is created and opened in the "Report" editor.
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3. Drag & drop the "Audit trail report" object under "Tools > Controls" to the report created.

4. Click on the "Audit trail report" object.

5. Change the object properties of the "Audit trail report" object in the inspector window.

Result
You have created a report for the printout Audit Trail.

See also
Audit report (Page 4345)
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Parameters for the audit trail report

Introduction
The "Audit trail report" parameters can be edited in the inspector window. 

Inspector window appearance
Click on the "Audit trail report" object.

Change the appearance of the "Audit trail report" object in the appearance area of the Inspector 
window under "Properties > Properties > Layout".

You can configure the foreground color, the background color, the style, and the font settings. 

It is recommended to set a font size of 16 px for the output.   

Inspector window layout
Click on the "Audit trail report" object.

Change the position and size of the "Audit trail report" object in the appearance area of the 
Inspector window under "Properties > Properties > Layout".
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The "Audit trail report" object always fills the space down to the footer on the report page. If 
you change the height of the object, then you only change the distance of the object to the 
header. The report printout can involve a large amount of data. 

A page break is automatically inserted when the length of the page is exceeded to print out all 
data. 

In the "Visible entries" area, it is determined whether comments are visible on the printed report.

Inspector window miscellaneous
Click on the "Audit trail report" object. 

Change the name and layer position of the "Audit trail report" object in the appearance area 
in the Inspector window under "Properties > Properties > Miscellaneous".
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See also
Audit report (Page 4345)

Printing out an audit trail report

Introduction
Since logging of the Audit  must be stopped in order to print out an Audit Trail, a few details 
regarding this procedure must be noted. 

The following steps must be taken to print out an audit trail in a report file on a printer:

● Stop logging using the "StopLogging" system function.

● Start the printout using the "PrintReport" system function.

● Check if the printing is successfully completed.

● If needed, move or delete the Audit Trail using the system functions "ArchiveLogFile" or 
"DeleteLog".

● Start the logging of Audit  by selecting the "StartLogging" system function.
 

  Note

Make sure that the Audit Trail has been printed completely before you delete the Audit 
Trail.
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Requirements
● "GMP compliant configuration" has been enabled.

● A report for the printout of an Audit Trail has been configured.

● The screen for the operator control to be configured is open.

Procedure
1. Add a button to the screen and select "Events > Click" in the Properties window.

2. In the function list, assign the "StopLogging" system function to the "Click" event and select 
your Audit Trail log.

3. Insert an additional button and assign the "PrintReport" system function to the "Click" event 
of this button.

4. Configure the "StartLogging" system function in the same function list.

5. Assign unique labels to the buttons.

6. Save the project.

Result
You have configured the required buttons and system functions. The operator can perform the 
operating tasks described in the introduction during runtime to print out an Audit Trail report. 

 

 Note

You can also insert the report objects for the output of alarms and recipes in the report for 
the printout of an Audit Trail. However, since GMP-relevant operations and system processes 
are not recorded while you are printing, you should preferably print the Audit Trail in a separate 
operation.

 

See also
Audit report (Page 4345)

Evaluating an audit trail

Evaluating audit trails

Introduction
The Audit Trail has been saved to the memory card of the HMI device and is also read only. 

The Audit Trail is protected by a checksum. This checksum ensures that the entry has not 
been modified at any later time. 

There are two possible ways to evaluate the Audit Trail: 
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● Use the "Audit Viewer":
You can easily evaluate the Audit Viewer for external analysis on an Office PC with the 
help of the Audit Trail. 

● Use the "HmiCheckLogIntegrity" DOS program:
The DOS program makes it possible to carry out an automatic check of the Audit Trail using 
the return values. 

Evaluating Audit Trails in AuditViewer

Introduction
The Audit Viewer allows you to evaluate all Audit Trail data in a table.

Requirements
● Audit Viewer is installed

● The Audit Traillog is located on the computer which has Audit Viewer installed.
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Procedure
1. Start the Audit Viewer on the configuration PC:

"Start > SIMATIC > Audit Viewer > Audit Viewer"
This path may be different on your operating system version.

2. Click the button.

3. Load the Audit Trail:

The "Data Validity Indicator" is lit up in green to indicate that the loaded Audit Trail has not 
been manipulated.

Each entry in the Audit Trail is time-stamped to allow precise tracking of operator actions. In 
addition to system events, such as the attempt to import a password list, the system also 
records failed logon attempts:

See also
Evaluating the checksum of log data (Page 4021)

Evaluating the checksum of log data (Page 3771)
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Evaluating Audit Trails with DOS program

Introduction
Long-term archiving on a server allows an Audit Trail to be checked automatically using return 
values in a script. 

In addition the programmer can integrate the check using the DOS program 
"HmiCheckLogIntegrity" into the archiving process. "HmiCheckLogIntegrity" then provides the 
following return values:

● < 0: Different errors, for example, wrong file format or no file exists.

● 1: The checked Audit Trail is valid.

● > 0: The first line that was manipulated will be returned.

Audit Trail logging is only continued if the return value is "1". In both error cases, the 
administrator or the shift supervisor can be informed. 

HmiCheckLogIntegrity
The "HmiCheckLogIntegrity.exe" DOS program is in the installation directory under:

"SIEMENS > Automation > WinCC Runtime Advanced"

Audit trail logging concept

Format

Format - Audit Trail         
On an HMI device with "GMP compliant configuration", all events which are relevant to the 
audit are recorded at runtime in the Audit Trail. You have several format options. 

Selection is dependent on the display program and the runtime language used:
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● RDB file
Data is saved with quick access in a proprietary database. 
If you require maximum read performance in Runtime, use the "RDB file" storage location. 

● CSV file
To view and evaluate a CSV file use, e.g. Microsoft Excel on your PC.

 

  Note

Double quotation marks or several characters are not permitted as list separators for the 
storage site "File - CSV (ASCII)". You can find the settings for list separators under "Start 
> Settings > Control Panel > Regional and Language Options".

 

● TXT file
This file format supports all characters that can be used in WinCC. For editing, you will 
need software that can save files in Unicode, such as Notepad.

 

  Note

Use "File - TXT (Unicode)" to log Asian languages.
 

Audit Trail with checksum
The following files are generated under special circumstances:       

● *.keep

– If a log is started without checksum and will be continued with a checksum.

– If you update WinCC with a service pack or a new version and the Audit Trail or the log 
is continued with the checksum.

– The content of the keep file will remain the same when compared with the original log 
file.

 

  Note

Before you update WinCC with a Service Pack or a new version, exit and save the 
Audit Trail or the logs using checksum. After WinCC is updated, the audit trail or logs 
will be continued with new files using checksum. 

 

● *.bak

– If runtime has determined a serious, irregular problem in the file.
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Storage location and medium

Storage location and medium         
Depending on the hardware configuration of the HMI device, the data may be logged locally 
(on the hard disk of a PC or on the storage card of a panel) or, if present, on a network drive.

 

 Note
Logging on network drives

We do not recommend that you log audit trails directly on a network drive. Power supply can 
be interrupted at any time. This means there is no guarantee for a reliable operation of logs 
and audit trails.

We recommend you save the logs on your local hard drive, or on a storage medium of the 
HMI device. Use the system function "ArchiveLogFile" to save the logs long-term on a network 
drive.

 

A "GMP compliant configuration" cannot be operated at runtime to the full extent unless it is 
possible to save all user actions which are relevant to the audit to the Audit Trail. It must be 
ensured that sufficient storage space is available for the Audit Trail and that the connection to 
the storage location for the Audit Trail is not disturbed. 

Error-handling with insufficient free storage space  
If there is insufficient storage space, your project can be configured so that the administrator 
has an option of continuing the process without logging in the audit trail (forcing).

Error-handling if there is no storage medium or the connection to the server is interrupted
All audit-relevant user actions are blocked if insufficient storage space is available for the Audit 
Trai, e.g. due to missing storage medium. 

Blocking is canceled as soon as the storage location for the Audit Trail is available again. The 
block can be skipped by "forcing".

Error-handling with long-term logging
If the audit trail must be moved to a server for long-term logging and the connection to the 
server is interrupted at this time, the following error-handling is required: 

The system closes the audit trail and renames it. The system attempts to send the renamed 
audit trail to the server again in the background.

If disruption in the connection to the server persists, you receive a system alarm telling you 
that the connection is down. Then the system attempts to send the renamed audit trail every 
300 seconds.

The attempt to transmit the data is repeated until successfully completed. The data is also 
transmitted after a restart of the HMI device.
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"Forcing"     
If the storage space for the audit trail is insufficient, for example if there is no storage medium 
or it is full, all audit-relevant user actions are automatically blocked.

In this case the audit trail logging can be configured to give an administrator the option of 
continuing to operate the system without logging the audit trail (forcing). 

The administrator can also be given the option of running the system quickly out of a critical 
state in case of emergency. In this case the administrator can operate the system without the 
requirement to input the required electronic signatures or comments. 

If the administrator uses the "forcing" function, this is logged as the last entry in the audit trail.

After the end of forcing, the audit trail must be restarted with the system function "StartLogging".

Protection mechanisms

Protective mechanisms to prevent changes to audit trail data   
The audit trail data are protected against deliberate or accidental changes:

● The directory in which the audit trail is saved can only be accessed with special rights.

● The audit trail files are write-protected.

● Each data record contains a checksum that can be used to detect a change of its contents. 
This checksum also ensures that the number of lines has not changed in the audit trail file.

Use the "HmiCheckLogIntegrity" tool, included in the audit option, to check whether an audit 
trail has been changed:

Evaluating Audit Trails with DOS program (Page 7249)

WinCC upgrade

WinCC upgrade
Before you update WinCC with a Service Pack or a new version, you will have to exit and save 
the Audit Trail or the logs with checksum. After WinCC is updated, the audit trail or logs with 
checksum will be continued with new files. 

Make sure that the logs are started at a defined state with the new version.
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Audit trail behavior in runtime

Effects in runtime   
The configuration in Audit Trail has the following effects in runtime, depending on the 
configuration:

● Audit relevant user actions (such as tag changes and recipe changes) are recorded in an 
audit trail.

● "Enable logging at runtime start" check box enabled:
The audit trail is started with runtime.

● "Forcing" group, "Allowed if storage space has been exhausted" check box enabled:
A user with administrator rights can use "forcing" to run operations on the plant even though 
the audit trail can no longer be logged because of storage space limitations. Interrupting 
the audit trail prevents the process from being stopped.
If the check box "Signing may be bypassed" is enabled, the administrator is not required 
to input electronic signatures, acknowledgments or comments for operator actions that 
would normally require signing, acknowledgment or comment. 

● If the storage space available for the Audit Trail is less than the configured "Minimum 
storage space in MB", the function list configured for the "Low free storage space" event 
will be processed.

● If there is insufficient storage space for the audit trail because of hardware limits, the 
function list configured for the "Free space critically low" event will be processed.

10.16.1.4 Configuring audit functions

Logging tag value changes

Tag value change

Changes to tag values
User actions in runtime are recorded in a Audit Trail once "GMP compliant configuration" has 
been enabled.

When you configure a GMP compliant project, you specify which tags must meet the 
requirements of Good Manufacturing Practice (GMP).    
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If the user changes the value of a GMP-relevant tag in runtime, the value change action is 
logged in the Audit Trail .

 

 Note

The action of changing the value of GMP-relevant tags made by the PLC, or a system 
function, is not logged in the Audit Trail. 

The system functions used to change the values of GMP-relevant tags which are assigned 
to events that identify a direct user action will be logged.

In addition, configure the "NotifyUserAction" system function to make a manual entry in the 
Audit Trail or to prompt the user for an electronic signature, an acknowledgment, or a 
comment. 

With the "NotifyUserAction" system function only the value changes that are directly triggered 
by the event to which the system function is configured are entered in the Audit Trail. For 
example, if additional tags are changed by changing the value of one tag, the additional value 
changes are not logged in the Audit Trail.

 

Logging tag value changes

Requirement
● "GMP compliant configuration" has been enabled.

● The tags for which you want to configure the GMP settings are created.

● The property view is open.    
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Procedure
1. Open the HMI tags editor and select the tag for which you want to make GMP settings.

2. Click "GMP relevant" under "Properties > Properties > GMP" in the Inspector window.

3. Specify how the user must confirm a value change in the "Confirmation type" selection field:

– "Electronic signature"
If the user's electronic signature is required.

– "None"
If the value change is to be logged in the Audit Trail without user confirmation.

– "Acknowledgment"
If user acknowledgement of the value change is required.

4. Enable the "Comment required" check box if the user is required to input a comment as 
well as an electronic signature or acknowledgment.
This check box is only enabled if "Electronic signature" or "Acknowledgment" is specified 
under "Type of confirmation".

Result
If the user changes the value of a GMP-relevant tag in runtime, the value change is entered 
in the Audit Trail. 
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Effects of tag change

Effects in runtime
The configuration has the following effects in runtime depending on the properties of the GMP-
relevant tags:   

● If the user changes the value of a GMP-relevant tag in runtime, the value change is entered 
in the Audit Trail.

● Electronic signature  
If "Electronic signature" is specified as the "Type of confirmation", the user must log every 
user-related value change of the tags using an electronic signature. Otherwise the value 
change will be rejected.
The user name used to sign the change is logged in the audit trail.

● Acknowledgement  
If "Acknowledgment" is specified as the "Type of confirmation", the user must acknowledge 
every user-related value change of the tags. Otherwise the value change will be rejected.
The acknowledgement is logged in the Audit Trail.

● Comments  
If the "Comment required" check box is enabled, the user must also comment every user-
related value change of the tags, in addition to acknowledgment or input of the electronic 
signature. Otherwise the value change will be rejected.
The entered comment is logged in the Audit Trail.

Logging recipe data record changes

Recipe data changes

Changes to recipe data    
User actions in runtime that are relevant to the quality of the process, such as changes of tag 
values or recipe values, are recorded in an Audit Trail once "GMP compliant configuration" 
has been enabled. 

You specify during configuration which recipes must meet the requirements of "Good 
Manufacturing Practice" (GMP).

For GMP-relevant recipes, the following operations during runtime are recorded in the Audit 
Trail:
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● Storing after changing and creating recipe data records

● Transfer of recipe data records to the PLC and from the PLC

● For recipe tags: Changing the setting for the synchronization of the tag values with the PLC 
("offline"/"online") if the recipe tags are configured as "GMP-relevant".

 

  Note
Differences in the Audit Trail  with recipe display and recipe screen

If you use a recipe screen to save recipe data, enable the "GMP-relevant" property for the 
recipe tags. If the user changes the value of a GMP-relevant recipe tag in runtime, the 
changed value is recorded in the Audit Trail. You can also configure for the tag to require 
the user to confirm the value change with an electronic signature and enter a comment.

If you use a recipe display to edit data records of a GMP-relevant recipe, the Audit Trail 
includes a record of which recipe data records were saved or sent to the PLC. The value 
changes to the recipe tags are not logged in the Audit Trail. Use the "ExportDataRecords" 
system function to save the value change to data records in a csv file. 

If you want to make changes to recipe data records in conformance to the FDA, disable 
"Enable edit mode" in the recipe view. Use the recipe screen and "GMP relevant" recipe 
tags.

 

If you export recipe data records in a regulated project, you can assign the recipe data with a 
checksum. When you later import the recipe data back, you can use the checksum to determine 
if the recipe data has changed. The following system functions are available for exporting and 
importing recipe data with a checksum:

● "ExportDataRecordsWithChecksum"

● "ImportDataRecordsWithChecksum"

Logging recipe data changes

Requirement
● "GMP compliant configuration" has been enabled.

● The recipes for which you want to configure the GMP settings are created.

● The property view is open.
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Procedure     
1. Open the recipe editor and select the recipe for which you want to make GMP settings.

2. Click "GMP relevant" under "Properties > Properties > GMP" in the Inspector window.

3. Under "Settings", select the following:

– "Record operations in audit trail:"
If all user actions in runtime that affect this recipe are to be recorded in the Audit Trail.

– "Sign loading of recipe data":
If the user is required to confirm the transfer of recipe data records to or from the PLC 
using an electronic signature.

– "Signature for saving recipe data: "
If the user is required to confirm recipe data record saving with an electronic signature.

Result
If the user works with the GMP-relevant recipe in runtime, the change is entered in the Audit 
Trail. 

Effects of recipe data change

Effects in runtime   
The configuration has the following effects in runtime depending on the properties of the GMP-
relevant recipes:
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Entries in the Audit Trail
Entries are made in the following cases:

● You create and save new recipe data records of a GMP-relevant recipe at runtime.

● You edit recipe data records of a GMP-relevant recipe and save your changes at runtime.

● Recipe data records are transferred to the PLC or recipe data are read from the PLC.

● The "SetRecipeTags" system function is used to change the setting for synchronization of 
the tag values with the PLC.
This concerns the following changes:

– "offline" to "online"

– "online" to "offline"

Electronic signature
The user must enter an electronic signature in the following cases depending on the 
configuration:

● The "Sign loading of recipe data" check box is set:
Signature for the transfer of recipe data records to the PLC. Signing is always required if 
the transfer is triggered with the recipe display functions and even if it is triggered with 
"SetDataRecordToPLC" system functions.

● The "Sign saving of recipe data" check box is set:
Sign saving of recipe data records. The signature is always required if the save is triggered 
with the system functions of the recipe display, and even if it is triggered with the 
"SetDataRecordToPLC" or "SaveDataRecord" system function. 

● The user name used to sign the change is logged in the audit trail.
 

  Note

The triggering of the "ImportDataRecords" system function is entered in the Audit Trail but 
does not require a signature or a comment. In addition, call the "NotifyUserAction" system 
function to request an electronic signature with or without user comment. 

 

Logging user actions

User actions with GMP-compliant configuration

Introduction    
In GMP compliant configuration, user actions and system operations in runtime that are 
relevant for the quality of the process are recorded in an Audit Trail . 

For example, a user logon to the system or the change of a tag value are saved in the log.

In runtime, user actions are saved in an Audit Trail under the following conditions:
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● "GMP compliant configuration" has been enabled

● A user is logged on to the system

Logging modes

Automatic logging of user actions
The following user actions are recorded in runtime without the need for additional configuration 
steps if "GMP compliant configuration" is enabled:

● User Administration

– Logon and logoff of users

– Import of user administration

● Alarm system

– All alarms that are acknowledged by the user.
If an alarm from an alarm group is acknowledged, an entry is made in the Audit Trail 
indicating that all other alarms of this group have been acknowledged.

– All acknowledgment attempts of the user
 

  Note
Logging alarm text

To log alarm texts, select the "Log alarm texts in Audit Trail" option in the Audit Trail 
editor.

 

● Log operations

– Starting and stopping a log

– Opening and closing all logs

– Deleting a log

– Starting a sequence log

– Copying a log

– Long-term logging of a log
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Configuration-dependent logging
The following processes are logged depending on the configuration of the recipes and the tags 
of the project:

● Change values of GMP-relevant tags by the user

● for GMP-relevant recipes

– You create and save new recipe data records of a GMP-relevant recipe at runtime.

– You edit recipe data records of a GMP-relevant recipe and save your changes at runtime.

– Transfer of recipe data records to the PLC and from the PLC

– For recipe tags: Changing the setting for the synchronization of the tag values with the 
PLC ("offline"/"online")

In addition to logging user actions you can configure tags and recipes to require the user to 
confirm or acknowledge specific actions with an electronic signature or add a comment to the 
change.

Manual logging by means of "NotifyUserAction" system function   
This system function is used to record actions in the Audit Trail that are not automatically 
entered in the Audit Trail. This system function is also used to request the user to enter an 
electronic signature for the action.

Configuring the "NotifyUserAction" system function

Introduction
This system function is used to log user actions that are not entered automatically entered in 
the Audit Trail. This system function can also used to request an acknowledgment, or an 
electronic signature for the user's action.

In this example, the system function is assigned to a button.  All operations with this button 
are logged to the Audit Trail.

Requirements
● "GMP-compliant configuration" has been enabled.

● You created the object that is to be assigned the system function.
A button is used in this example.

● The properties window is open.

Procedure
1. Click the button.

2. Click on "Events" in the Inspector window.

3. Assign the "NotifyUserAction" system function to the "Click" event.
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GMP-compliant user administration 

SIMATIC Logon
To run a central user and user group administration for several applications or HMI devices, 
activate SIMATIC Logon. 

For more information on user administration and SIMATIC Logon, refer to the following chapter: 

Managing users on the server (Page 4395)

Logging system functions

Introduction       
If system functions are triggered in runtime, this is recorded in the Audit Trail for some system 
functions. If specific system functions are used on a GMP-relevant object, the user must 
confirm the triggering.

Some system functions are not supported when using Audit. If you use these system functions 
in your project, you are solely responsible for them.

The following table shows which system functions are Audit-relevant and whether the user's 
signature is required:

System functions and Audit

Function (call in script) Effect of /Audit
StartLogging (StartLogging) entered in Audit Trail
StopLogging (StopLogging) entered in Audit Trail
ClearLog (ClearLog) entered in Audit Trail
StartNextLog (StartNextLog) entered in Audit Trail
CloseAllLogs (CloseAllLogs) entered in Audit Trail
OpenAllLogs (OpenAllLogs) entered in Audit Trail
LogTag (---)  ---
CopyLog (CopyLog) entered in Audit Trail
ActivateScreen (ActivateScreen)  ---
ActivateScreenByNumber (ActivateScreenByNumber)  ---
ActivatePreviousScreen (ActivatePreviousScreen)  ---
SetBitInTag (SetBitInTag) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

ResetBitInTag (ResetBitInTag) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration
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Function (call in script) Effect of /Audit
InvertBitInTag (InvertBitInTag) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

SetBit (SetBit) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

ResetBit (ResetBit) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

InvertBit (InvertBit) entered in Audit Trail when tag is GMP-
relevant
System function must not be applied to 
tags that require signing or comment.

SetBitWhileKeyPressed (---) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

SetDataRecordToPLC (SetDataRecordToPLC) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

GetDataRecordTagsFromPLC (GetDataRecordFromPLC) entered in Audit Trail if the recipe is 
GMP-relevant

ImportDataRecords (ImportDataRecords) entered in Audit Trail if the recipe is 
GMP-relevant

ImportDataRecordsWithChecksum 
(ImportDataRecordsWithChecksum)

entered in Audit Trail if the recipe is 
GMP-relevant

ExportDataRecords (ExportDataRecords) ---
ExportDataRecordsWithChecksum 
(ExportDataRecordsWithChecksum)

---

LoadDataRecord (LoadDataRecord) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

SaveDataRecord (SaveDataRecord) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

SetDataRecordTagsToPLC (SetDataRecordTagsToPLC) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

GetDataRecordTagsFromPLC 
(GetDataRecordTagsFromPLC)

entered in Audit Trail if the recipe is 
GMP-relevant
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Function (call in script) Effect of /Audit
SetRecipeTags (SetRecipeTags) entered in Audit Trail if the recipe is 

GMP-relevant
GetDataRecordName (GetDataRecordName)  ---
ClearDataRecordMemory (ClearDataRecordMemory) Not supported
ClearDataRecord (ClearDataRecord) entered in Audit Trail if the recipe is 

GMP-relevant
PrintScreen (PrintScreen)  ---
PrintReport (PrintReport)  ---
RecipeViewSaveDataRecord (---) entered in Audit Trail if the recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewSaveAsDataRecord (---) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewNewDataRecord (---)  ---
RecipeViewClearDataRecord (---) entered in Audit Trail if the recipe is 

GMP-relevant
RecipeViewGetDataRecordFromPLC (---) entered in Audit Trail if the recipe is 

GMP-relevant
RecipeViewSetDataRecordToPLC (---) entered in Audit Trail if the recipe is 

GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewSynchronizeDataRecordWithTags (---) entered in Audit Trail if the recipe is 
GMP-relevant
Signing required depending on recipe 
configuration

RecipeViewRenameDataRecord (---) entered in Audit Trail if the recipe is 
GMP-relevant

RecipeViewBack (---)  ---
RecipeViewOpen (---)  ---
RecipeViewMenu (---)  ---
TrendViewScrollForward (---)  ---
TrendViewScrollBack (---)  ---
TrendViewExtend (---)  ---
TrendViewCompress (---)  ---
TrendViewBackToBeginning (---)  ---
TrendViewStartStop (---)  ---
TrendViewSetRulerMode (---)  ---
TrendViewBackToBeginning (---)  ---
StatusForceGetValues (---) Not supported
StatusForceSetValues (---) Not supported
AlarmViewAcknowledgeAlarm (---) entered in Audit Trail
AlarmViewEditAlarm (---)  ---
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Function (call in script) Effect of /Audit
AlarmViewShowOperatorNotes (---)  ---
HTMLBrowserBack (---) Not supported
HTMLBrowserForward (---) Not supported
HTMLBrowserRefresh (---) Not supported
HTMLBrowserStop (---) Not supported
ScreenObjectCursorUp (---)  ---
ScreenObjectCursorDown (---)  ---
ScreenObjectPageUp (---)  ---
ScreenObjectPageDown (---)  ---
PressButton (---)  ---
ReleaseButton (---)  ---
SmartClientViewConnect (---) Not supported
SmartClientViewDisconnect (---) Not supported
SmartClientViewReadOnlyOn (---) Not supported
SmartClientViewReadOnlyOff (---) Not supported
SmartClientViewRefresh (---) Not supported
SmartClientViewLeave (---) Not supported
ShowAlarmWindow (ShowAlarmWindow)  ---
ClearAlarmBuffer (ClearAlarmBuffer)  ---
ShowSystemAlarm (ShowSystemAlarm)  ---
SetAlarmReportMode (SetAlarmReportMode)  ---
Logoff (Logoff) entered in Audit Trail
GetPassword (GetPassword)  ---
GetGroupNumber (GetGroupNumber)  ---
ExportImportUserAdministration 
(ExportImportUserAdministration)

Import of user administration is entered 
in Audit Trail
Export is not entered in Audit Trail

Logon (Logon) entered in Audit Trail
GetUserName (GetUserName)  ---
TraceUserChange (---)  ---
ShowLogOnDialog (---)  ---
LinearScaling (LinearScaling) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

InverseLinearScaling (InverseLinearScaling) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration

IncreaseFocusedValue (---)  ---
DecreaseFocusedValue (---)  ---
OpenCommandPrompt (OpenCommandPrompt) Not supported
OpenControlPanel (OpenControlPanel) Not supported
ActivateCleanScreen (---)  ---
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Function (call in script) Effect of /Audit
AdjustContrast (---)  ---
CalibrateTouchScreen (CalibrateTouchScreen)  ---
OpenScreenKeyboard (OpenScreenKeyboard)  ---
OpenTaskManager (OpenTaskManager) Not supported
BackupRAMFileSystem (BackupRAMFileSystem) Not supported
SetAcousticSignal (SetAcousticSignal)  ---
ShowOperatorNotes (ShowOperatorNotes)  ---
AcknowledgeAlarm (AcknowledgeAlarm) entered in Audit Trail
GoToHome (GoToHome)  ---
GoToEnd (GoToEnd)  ---
EditAlarm (EditAlarm)  ---
DirectKeyScreenNumber (---) Not supported
DirectKey (---) Not supported
SetDeviceMode (SetDeviceMode) entered in Audit Trail
SetDisplayMode (SetDisplayMode)  ---
SetConnectionMode (SetConnectionMode) entered in Audit Trail
SetScreenKeyboardMode (SetScreenKeyboardMode)  ---
ChangeConnection (ChangeConnection) Not supported
SetLanguage (SetLanguage)  ---
SetWebAccess (---) Not supported
StartProgram (StartProgram) Not supported
ShowSoftwareVersion (ShowSoftwareVersion)  ---
SimulateTag (---) Not supported
StopRuntime (StopRuntime) entered in Audit Trail
ControlWebServer (ControlWebServer) Not supported
ControlSmartServer (ControlSmartServer) Not supported
OpenInternetExplorer (OpenInternetExplorer)  ---
SendEMail (SendEMail)  ---
UpdateTag (---)  ---
ClearAlarmBufferProTool (ClearAlarmBufferProtoolLegacy) Not supported
Encoding(Encode) entered in Audit Trail when tag is GMP-

relevant
Signature is mandatory, depending on 
the tag configuration

EncodeEx(Encode) entered in Audit Trail when tag is GMP-
relevant
Signature is mandatory, depending on 
the tag configuration
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10.16.1.5 Performance features of GMP-compliant configuration

Supported HMI devices

Supported HMI devices  
The qualification "GMP relevant configuration" can be configured for the following HMI devices:

● TP 277

● OP 277

● MP 277

● Mobile Panels 277

● MP 377

● Comfort Panels

● Panel PCs with WinCC RT Advanced

● WinCC RT Advanced
 

  Note

The qualification "GMP" is not supported by WinCC RT Professional.
 

Restrictions

Restrictions  
The following functions and configurations cannot be used simultaneously with the qualification 
"GMP relevant configuration":

● "Status/Force" object

● PN direct keys

● DP DirectKey

● Option /Sm@rtServer

● /Sinumerik option

● The functional scope of the HMI devices is only available to a restricted degree in some 
circumstances because of the limited storage space
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● Events of screen objects
You can set mandatory acknowledgement of important user actions in runtime, such as 
changing tag values. If you assign an event which has to be acknowledged to a screen 
object, you may not assign any other events to this graphic object. 
When the event of a screen object is assigned actions which open a user dialog (such as 
change of a tag value with mandatory acknowledgement), you may not be able to execute 
these actions at other events. 

● Controlling GMP-relevant tags using a slider
The slider is not suitable for controlling GMP-relevant tags. Any operation of the slider will 
continuously change the tag value. If this is a GMP-relevant tag, a flood of entries will be 
generated in the AuditTrail. 

10.16.2 WinCC DataMonitor 

10.16.2.1 The basics

DataMonitor

Introduction  
WinCC DataMonitor consists of a server component and a client component. The DataMonitor 
Server makes functions for analyzing and displaying data available to the DataMonitor client. 
Access rights govern access to the functions.

● WinCCViewerRT
Program for monitoring WinCC projects. The DataMonitor client is therefore a so-called 
"View Only Client".

● Excel Workbooks
Display of logged process values in an Excel table for analysis and storage in the Web or 
as a print template for reports

● Published Reports
Creation of reports from WinCC print jobs, or from published Excel worksheets. This allows 
you, for example, to generate statistics and analyses of specific process or history data. 
The reports are saved in PDF format and can be transferred by e-mail.

● WebCenter
Central information portal for access to WinCC data via user-specific views, clearly 
structured WebCenter pages through user groups with individual user rights for reading, 
writing and creating WebCenter pages.

● Trends & Alarms
Serves to display logged process values and alarms. The data is displayed in tables and 
diagrams on predefined WebCenter pages.
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Your benefit:
● Display and analysis of current process statuses on office PCs with, for example, MS 

Internet Explorer or MS Excel

● No additional configuration effort, as screens from the WinCC project are used directly.

● Evaluation via centrally administered templates for detailed analyses of corporate 
processes, e.g. reports, statistics

● Creation of event-driven or time-driven reports

● Information from the process is individually compiled online in runtime (information portal) 
and distributed to various people by e-mail.

● User administration with user groups and individual access authorizations, e.g. read, write, 
and creation of WebCenter pages

WinCCViewerRT

Overview     
The Web Viewer is solely a display program for WinCC projects that is installed using the 
DataMonitor Client. DataMonitor Client is therefore a so-called "View Only Client". 

Don't use Internet Explorer to run the "WinCCViewerRT.exe" application. Run it on the 
DataMonitor client instead. 

The Web Viewer uses its own communication resources to access the DataMonitor server. 
This prevents Internet users from accessing the system and protects the system against 
viruses and Trojan horses. 

Only the screens which are configured for Web access and published on the DataMonitor 
server are displayed.

The WinCC user needs authorization no. 1002 "Web access - view only". The cursor is a "View 
Only Cursor" and indicates that process-related operations are not possible. Certain operations 
are still possible, such as opening the properties dialog of an online trend control. 

If the WinCC user is not assigned authorization no. 1002, the DataMonitor Client runs in demo 
mode after logon.

You can also use the WebViewer as terminal services application. For more information, refer 
to "Setting up terminal services for WebNavigator servers".

See also
Configuring runtime settings (DataMonitor) (Page 7292)

WebCenter

Overview   
The WebCenter is the central information portal for access to WinCC data via Intranet/Internet. 
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With the help of WebCenter pages and Web parts, the user can arrange and save his view of 
the WinCC data. WebCenter pages are stored in directories.

WebCenter pages are like a construction kit. The form of the construction kit is specified by 
layout templates. Users can use either the supplied or self-created layout templates.

Web parts are the individual building blocks that prepare and display data. Within the 
WebCenter pages, the parameter definitions are stored for the respective Web parts and can 
be called up again at any time. A multiple use of the same web part is also possible with different 
parameter definitions. The WebCenter pages that have been created in this way can be opened 
by different users with the same parameter definitions depending on the assignment of rights.

To transfer the configuration data to a different computer, copy the corresponding project 
directory:

● ..\WebCenter\App_Data\Webcenter

Web parts
Up to 15 of the following Web objects can be combined into one screen view:

● Static process screens: WinCC screens are integrated into the WebCenter with no 
installation download. A JPG screenshot of the process screen is created on the WinCC/
DataMonitor Server at regular intervals.

● Process values as trend view (trend) or table (timestep): Several process values are 
displayed over a given period of time (compressed using specified functions) graphically 
or in table format.

● Process values in a bar chart or pie chart

● Statistics view

● Trend (timestep) provides a clear representation of precompressed values with the 
aggregate functions: initial value, minimum/maximum over time, sum/average/number over 
time, variance, one/two/three standard deviation(s).
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● Alarm view

● Alarm hit list

● Links (Favorites) to internal WebCenter pages and external Internet pages, such as stock 
market news

● Graphics in JPG format: This can be any type of information, such as a product logo, trade 
name, etc.

● Messages that are displayed at specific times.

● History of the most recently compiled reports with direct selection.

Basic procedure
1. Set up a directory for a WebCenter page (Page 7309)

2. Assign access rights (Page 7310)

3. Establish a connection to the WinCC data (Page 7311)

4. Publish screens for the WebCenter (Page 7319)

5. Create a layout template for WebCenter pages (Page 7322)

6. Create a WebCenter page (Page 7325)

7. Insert Web parts into the WebCenter page (Page 7327)

8. Configure Web parts within WebCenter pages (Page 7330)

See also
Trends and Alarms (Page 7273)

Trends and Alarms

Overview   
"Trends & Alarms" are used to display and analyze logged process values and messages in 
trends and tables and for evaluation with statistics functions.

Predefined Web pages contain the following:

● Display of a process value in a table (Page 7334).

● Display of a maximum of three process values in a diagram. (Page 7336).

● Statistics functions for process values (Page 7343).

● Alarm hit list (Page 7342).

● Display of messages in a table (Page 7338).

The functions of "Trends & Alarms" are configured with web parts. The same Web parts are 
used here as are used in the WebCenter pages (Page 7269).
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Excel workbooks

Overview  
With "Excel Workbooks", it is possible to display process data such as alarms and values of 
process or logging tags in an Excel table on the DataMonitor client. Data of logging tags of 
swapped out logs is not displayed.

The data is analyzed using Excel functions or graphically formatted trend view, e.g. mean value 
calculation, diagram presentation. 

You configure the Excel Workbook for displaying the process data using the Excel Add-In 
"Excel Workbook Wizard". The online display of the process data is performed via the Excel 
Add-In "Excel Workbook". 

The created Excel workbooks can also be configured as templates for the function "Reports". 
 

 Note

You need the DataMonitor client to use the "Excel Workbooks" function. The installation file 
can be found on the DataMonitor start page under "Reports > Download area",  on the 
installation medium, or at the download installations.

 

Configuring with XML file or online
Simultaneous online access to process data of different WinCC servers is possible using the 
Excel worksheet. This requires that you either take the data from an XML file or from a local 
WinCC project during the configuration in the Excel Workbook Wizard.

Separation between process and analysis by configuring with XML file 
By using the XML file for the project-relevant data, a separation between the process and the 
analysis is possible. 

You create the XML file on a DataMonitor server. Afterwards, transfer the XML file to a PC 
with Microsoft Excel, located in operation management for instance. You can configure the 
process data display in the sheet on the PC. 

Afterwards, transfer the workbook to a DataMonitor client where the process data is to be 
displayed online.

Configuration steps
The configuration of this function is carried out with the following steps:

1. In order to configure using the online data, configure directly on the WinCC server or on a 
WinCC client with an online connection to the respective WinCC server.

2. You have to create the XML file in order to configure with the data of an XML file. Use the 
"WinCC DataMonitor Configurator Export" application to create an XML file with the relevant 
data of the opened WinCC project on the DataMonitor server.
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3. Use the Excel add-in "Excel Workbook Wizard" to import the project-relevant data to an 
Excel workbook.

4. Configure the display of process data such as alarms and tag values.

5. To display process data in the Excel workbook in online mode, use the Excel add-in "Excel 
Workbook" on a DataMonitor Client. The values can also be further processed in Excel.

 

 Note

If you rename a table in an Excel workbook, the configuration data of the table will be lost.
 

Reports

Introduction         
Using Reports , you can use WinCC print jobs and published Excel Workbooks to output 
analysis results and process data. The data is output in PDF or XLS file format

When the reports are created is defined on the DataMonitor Server. The following options are 
available:

● Manually, for example, by a plant operators.

● Event-driven, for example, when a tag value has changed-

● Time-driven, for example, daily.

You can also transmit a report as e-mail attachment The various directories can only be 
accessed with the appropriate authorization; including access over an Intranet or the Internet.

Requirement
Output as PDF file (WinCC print jobs)

● PDF Reader The PDF reader can be obtained from www.adobe.com, for example.

Output as XLS file (Excel workbook)

● MS Excel as of Office XP is installed.
To use the DataMonitor Server for the automatic creation of Excel reports, you must install 
MS Excel on the server PC.

● The Excel workbook is created at and published as template at the DataMonitor Server.
For more information, refer to "Configuring an Excel workbook (Page 7345)".

 

  Note
Displaying data on the DataMonitor Client

In the Excel worksheet, the creation time and periods are always displayed in the local 
time zone of the DataMonitor Server.
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See also
Configuring an Excel workbook (Page 7345)

Access rights

Introduction   
When using DataMonitor, different authentications are required. You have to define specific 
users and user rights for this. 

● For the functions "Trends and Alarms", "Reports" and "Webcenter", a Windows user.

● For the functions "WinCCViewerRT" and "Excel Workbooks", a WinCC user.

SIMATIC logon allows the central administration of users. To use SIMATIC logon in conjunction 
with DataMonitor, the DataMonitor user is added to the user group "SIMATIC HMI VIEWER". 
The user group "SIMATIC HMI VIEWER" is created during the installation of WinCC Runtime 
Professional.

Checking certificates

Introduction 
Before you work with the DataMonitor, you need to adjust the settings in Internet Explorer.

Procedure
1. Open the Internet Explorer.

2. Open the "Internet Options" dialog under:
"Tools > Internet Options"
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3. Select the "Advanced" tab.

4. Deactivate the following option in the "Security" area:
"Check for publisher's certificate revocation".

10.16.2.2 Installing DataMonitor

Licensing

DataMonitor client    
DataMonitor client does not need a license.

Visualize processes
10.16 Options

WinCC Professional V13.0
System Manual, 02/2014 7275



DataMonitor server 
Licenses must be installed on the DataMonitor server for the DataMonitor clients. The license 
check is different for the following function groups. 

● "DataMonitor" with the functions:
"WinCCViewerRT" and "Excel Workbooks" 
A "WinCC DataMonitor" license is required on the server computer for each DataMonitor 
client.

● "Webcenter" with functions:
"Webcenter", "Trends and Alarms", "Reports"
It is not the number of clients but the number of connections that is relevant for the license 
count with the "Webcenter" function group. 
 

The following table shows the number of possible clients based on the function group and 
license.

License "DataMonitor" function group "WebCenter" function group
1 Client 1 3
3 Clients 3 6
10 Clients 10 20
25 Clients 25 50
50 Clients 50 100

Example
With a "3 Clients" license, the following users can log on simultaneously:

● 3 users of the "DataMonitor" function group

● 6 users of the "WebCenter" function group

Operation without valid license   
If no license is available, DataMonitor displays a page requiring acknowledgement indicating 
the missing license at start-up. 

● Click the "OK" button to acknowledge the notice.
The start page of the DataMonitor is displayed.

Help:
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● Check the existing licenses. If necessary, install the required licenses.
 

  Note

If the user does not log out with the "Logout" button and the browser is closed, the 
connection is maintained and the license remains occupied. The license will only be 
released again after approximately 20 minutes.

 

Installation of the DataMonitor server

Installing DataMonitor server

Requirement     
● Administrator rights

● Internet Information Service is installed.

● Installation disk with WinCC RT Professional

Procedure
Proceed as follows to install the DataMonitor server:

1. Place the installation disk in the drive.
The disk starts automatically if auto-run is enabled in the operating system. If auto-run is 
not activated, start the Setup.exe program on the disk.

2. Select "User defined" for "Installation mode".

3. Select the "DataMonitor Server" program package.

4. Start the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.

5. After installing the DataMonitor server, you can transfer the license key for the product. 
Click on "Transfer License Key" to do this. If you have already transferred the license key 
or you want to install it subsequently, select "Next".

 

  Note

License keys are not transferred automatically. Transfer the missing license keys during 
or after installation using Automation License Manager.

 

6. Reboot the PC when prompted by Setup.

Result
The DataMonitor server is installed.
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Installing the Internet Information Service

Settings 
Before installing the WebNavigator Server, you need to install the Internet Information Service 
(IIS). You specify the settings for the WebNavigator Server during installation.

Activate the following settings:

● Web management tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– Compatibility with IIS Metabasis and IIS 6 configuration

– Compatibility with WMI for IIS 6

● WWW services > General HTTP features:

– Standard document

– Static content

● WWW services > Application development features:

– .NET extension capability 3.5 and 4.5

– ASP

– ASP.NET 3.5 and 4.5

– ISAPI extensions

– ISAPI filters

● WWW services > Security:

– Requirement filtering

– Standard authentication

– Windows authentication
 

  Note

If the logging functions are active with IIS, the log files must be monitored and deleted, 
if necessary. The event views should be configured in such a way that the log files do 
not become too large.

 

Requirements
● Windows user with administrator rights

● Write access for the registry database
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Procedure
To install the IIS, follow these steps:

1. Insert the Windows installation disk into the drive.

Open the Control Panel. Click the "Programs and Features" entry.

1. Click the "Turn Windows features on or off" entry.

2. Activate the settings mentioned above.

3. Close the dialog with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

Alternative procedure
You can also use the command line "Start > Run > cmd" to install the IIS components located 
on the installation data carrier:

pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-NetFxExtensibility;IIS-
ASP;IIS-ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-
WindowsAuthentication;IIS-ManagementConsole;IIS-ManagementService;IIS-
IIS6ManagementCompatibility;IIS-Metabase;IIS-WMICompatibility;IIS-
ManagementScriptingTools

Installation of the DataMonitor client

Installation of the DataMonitor client

Installation Conditions DataMonitor Client  
You need not install the DataMonitor client if you only want to use "Webcenter" and "Trends 
and Alarms".

You can install "Excel Workbook Wizard" on the client PC as an add-on. "Office Excel 2007", 
"Office Excel 2010" or "Office Excel 2013" are required for the installation of "Excel Workbook" 
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on the client PC, because "Excel Workbook" and "Excel Workbook Wizard" are installed as 
Excel add-ins.

 

 Note
Installation of the DataMonitor client on the DataMonitor server

To also install DataMonitor client or WebNavigator client on a DataMonitor server, you need 
to proceed as follows: 
1. Switch the start type of the service to manual in the service manager.
2. Reboot the PC.
3. Install the DataMonitor client.

During the installation, ensure that no WebNavigator clients or DataMonitor clients access 
the server. 

4. When the installation is successfully completed, switch the start type of the 
"CCArchiveConnMon" service back to automatic.

 

Requirement
● Software and hardware requirements are met. For more information, refer to "Auto-Hotspot".

● Security settings in Internet Explorer are configured.

Installation options 
The following options are available for installing the DataMonitor client. 

● Installation via the installation disk
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via the Intranet/Internet
In this case, certain Windows user rights are necessary, depending on the operating system.

● Additional installation options.
The installation can also be performed without user interaction, under the Windows user 
rights of the current user or in networks using Group policy-based software distribution.

Configuring security settings in Internet Explorer

Requirement
Internet Explorer is open.
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Procedure
To configure the security settings in Internet Explorer, follow these steps:

1. Select the command "Internet Options" from the "Tools" menu in Internet Explorer.

2. Select the "Security" tab. Select the corresponding zone, e.g. "Local Intranet" or "Internet".

3. Click on the "Custom level" button. The "Security settings" dialog opens.
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4. Select the "Enable" option for "Script ActiveX controls marked safe for scripting" and 
"Download signed ActiveX controls".

5. Select the "Enable" option under "Scripting > Active Scripting".

6. Click the "OK" button. Carry out the modifications in the subsequent dialog.

7. Select the "Trusted Sites" icon. Click the "Sites" button. The "Trusted sites" dialog opens.

8. Enter the address of the web server in the field "Add this web site to the zone". Possible 
formats and placeholders include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com". Deactivate the "Require server verification (https:) for all sites in this zone" 
check box. Click "Add". Confirm your entries with "OK".

9. Select the "Trusted Sites" icon. Click the "Standard level" button and then the "Custom 
Level" button. The "Security settings" dialog opens.

10.Select the "Enable" option for "Initialize and script ActiveX controls not marked as safe for 
scripting". Confirm your entries with "OK".

11.Click on the "General" tab. Click on the "Settings" button in the "Temporary internet files" 
area . Select the "Automatic" option for "Check for newer versions of stored pages". Confirm 
the entry using the "OK" button.

12.Click "OK" to close the "Internet Options" dialog.

Result
The security settings in Internet Explorer are configured.

 

 

 

Installing with the installation disk

Requirements
● Security settings in Internet Explorer are configured.

● User possesses the necessary rights for installation.

Procedure
To install the DataMonitor client using the installation disk, follow these steps:

1. Place the installation disk in the drive.
The disk starts automatically if auto-run is enabled in the operating system. If auto-run is 
not activated, start the Setup.exe program on the installation disk.

2. Select "User defined" in the "Installation mode" dialog.

3. Select the "DataMonitor Client" program package.
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4. Start the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.

5. Reboot the PC when prompted by Setup.

Result
DataMonitor client is installed. The "WinCCViewerRT" function is activated.

Installing via the Intranet/Internet

Requirements 
● Security settings in Internet Explorer are configured.

● User possesses the necessary rights for installation.

● DataMonitor server is installed and configured.

● User is created in user administration.

● The WinCC project is in Runtime on the DataMonitor server.

● The server PC and client PC are interconnected via a TCP/IP-capable network.

Procedure
To install the DataMonitor client via the Intranet/Internet, follow these steps:

1. Enter the address of the DataMonitor server in the address bar.

– Default web site: "http://www.server_name.de"

– Web site in the virtual directory: "http://www.server_name.de/DataMonitor"

2. Log on to the DataMonitor server with your user name and password. If you are accessing 
the DataMonitor server for the first time, you will be prompted to install the DataMonitor 
client.

3. Click the "Click here to install" link.

4. Click the "Save" button in the "File Download" dialog to store the client setup on the client 
PC. It is recommended that you save the setup file. Then if the client PC needs to be 
restarted, it is not necessary to download the setup again.

5. Leave the Internet Explorer open and open Windows Explorer. Navigate to the directory in 
which you saved the setup file. Double-click the setup file.

6. Follow the instructions on the screen and enter the information and settings necessary. 
The client-end controls of the DataMonitor are installed. Close the Setup dialog.
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Result
After the successful completion of the installation, the DataMonitor client switches to the 
WinCC project currently in Runtime. 

 

 Note

If you have already installed the DataMonitor client and wish to install a current version of the 
client via the Intranet/Internet, open the Client Setup straight away without saving the 
installation file on the target PC. If you want to save the new installation file, uninstall the old 
installation file first or save the new version of the file in different directory than the older 
version of the file. (necessary)

 

 
 

 Note

When downloading the DataMonitor server client software, select the "Save" option to save 
the client setup on the client PC. It is recommended to save the Setup file because, in the 
event of a restart of the client computer being necessary, the Setup need not be downloaded 
again. 

If the DataMonitor client was installed previously from the DVD and you want to install an 
updated version of the client via the Intranet/Internet, the client setup must also be saved on 
the target PC.

 

User rights, user groups and optional installation possibilities

User rights, user groups and optional installation possibilities
The following conditions apply for the installation of the DataMonitor client:

● Windows user rights required for installation and first registration of the DataMonitor client

● Installation of the DataMonitor client with restricted windows user rights

● Installation for a configured group of users or PCs

● Group policy based software distribution

● Installation without user interaction

Windows user rights required for installation and first registration of the DataMonitor client
To install the DataMonitor client via Intranet/Internet or from the installation disk, you require 
certain minimum user rights. 

Operating system Required minimum user rights
Windows Server 2008 R2 SP1/ Windows Server 2012 R2 "Power user"
Windows 7/ Windows 8.1 "Power user"

Use the following for the first logon of the DataMonitor client to the DataMonitor server:
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● The user identification of the installation

● A user with equal or higher Windows user rights
If the first logon was successful, subsequent logons can be performed for a user without 
"Power user" or "Administrator" rights.

Installation of the DataMonitor client without "Power user" or "Administrator" rights
By using Microsoft Windows Installer technology (MSI), DataMonitor clients can also be 
installed with limited Windows user rights i.e. without possessing the "Power user" or 
"Administrator" rights. The add-ons and plug-ins for the DataMonitor client can also be installed 
this way. 

This procedure can be used for the following installations:

● Installation via group policy-based software distribution in networks

● Installation for a configured group of users or PCs.

Installation for a configured group of users or PCs
Using the Microsoft Systems Management server or group policy on a domain controller, it is 
possible to install a group of users or PCs configured by the administrator.

● The MSI file "WinCCDataMonitorClient.msi" is published on the domain controller and 
enabled for a user group. The installation is then performed according to the configuration 
of the group policy based software distribution either during logon of the defined users or 
when the computer is started.

● When using a Microsoft Systems Management Server, the installation is configured and 
triggered by the administrator, and executed when the relevant PC boots. Additional 
information on Microsoft Systems Management server is available on the Microsoft home 
page.

Group policy based software distribution
The software installation is normally executed with the access rights of the current Windows 
user. When using MSI technology, the installation is performed by an operating system service 
with higher rights. This enables installations to be performed for which the Windows user has 
no permission. Applications which require installations with a higher permission are referred 
to as "privileged installations" in MSI technology. Installation of these applications is possible 
when a Windows user is assigned the "Always install with elevated privileges" permission. 

To use group policy-based software distribution, a group policy is created on the domain 
controller. The software to be distributed is assigned or published using the active directory . 

● Assignment: The software distribution can be assigned to a user or a PC. The software to 
be distributed is automatically installed when the user logs on or the PC boots.

● Publication: The software distribution can be published for single users. When the user logs 
onto the client PC, the software to be distributed appears in a dialog and can be selected 
for installation.
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Installation without user interaction
During installation of the DataMonitor client, the user is normally prompted to enter information, 
e.g. the target directories, the agreement to the software license conditions or components to 
be installed. 

By implementing a configuration file, installation is possible without user interaction. The 
required path specification and user information are provided in the "options.ini" configuration 
file. The INI file must be located in the same directory as the setup file of the DataMonitor client. 
This installation procedure is advantageous when using the group policy-based software 
distribution. 

Installation from the product DVD occurs with user interaction. 

The settings given predefined in the table are used under the following conditions: 

● The "options.ini" configuration file is missing and there is no corresponding entry available 
in the registry of the client PC, e.g. due to another SIMATIC HMI product installed.

● Alternatively, the installation is performed via the group policy-based software distribution 
with assignment to the PC.

Information Parameter
Target directory for the DataMonitor client INSTALLDIR=" <syspath1>\Siemens\WinCC"
Target directory for common components COMMONDIR=" <syspath2>\Siemens "
User information / user name USER
User information / organization COMPANYNAME

The "<syspath?>" parameters result from the settings in the registry under the key 
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion" :

 - "<syspath1>" corresponds to the key "ProgramFilesDir" e.g. "C:\\Program Files"

 - "<syspath2>" corresponds to the key "CommonFilesDir", e.g. "C:\\Program Files\\Common 
Files"

Example of an "options.ini" configuration file 
[USERINFO]
USER=Integration 
COMPANYNAME=Siemens AG
[INSTALLPATH]
COMMONDIR=" C:\Programs\Common files\Siemens " 
INSTALLDIR=" C:\Programs\Siemens\WinCC "
[FEATURES]
FUNCTIONTRENDCONTROL=0
HARDCOPY=0
WINCCUSERARCHIVES=0
DEU=0
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FRA=0
ITA=0
ESP=0

10.16.2.3 Configuring the DataMonitor system
 

Introduction
For the use of the WinCC DataMonitor, the data and process screens are made available on 
the DataMonitor Server to be accessed and displayed on the DataMonitor client.

Requirement
● The server PC and client PC are interconnected.

● On the server PC

– Internet Information Service is installed.

– The DataMonitor Server is installed.

– A license key is installed.

– WinCC Runtime Professional is installed.

● On the client PC

– Internet Explorer V 8 or higher is installed.

Configuration steps
The following configuration steps are required to set up a DataMonitor system.

1. Configure the WinCC project.

– Configuring WinCC screens for Web access

– For WinCCViewerRT and the "Excel Workbooks" function, define the users and access 
rights in the "User administration" dialog.

– Configure Runtime settings

2. Transfer your WinCC project to the server PC. If the configuration PC and the WebNavigator 
server are interconnected, transfer the WinCC project using the command "Download to 
device > Software (all)". 

3. Configure the DataMonitor Server.

– Setting up the Web folder

– Define users and access rights in Windows for the functions "Trend and Alarms", 
"Reports" and "WebCenter".

4. Start WinCC Runtime on the server PC.
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5. Use the DataMonitor functions on the DataMonitor Client.

– Check the Internet Explorer security settings on the client PC

– Start Internet Explorer on the client PC and enter the address of the DataMonitor Server.

– After logging on to the DataMonitor Server you can access the DataMonitor functions.

6. Monitor the WinCC project at the DataMonitor Client.

– Setting up WinCCViewerRT

– Displaying screens

Configuring a WinCC project

Configuring WinCC screens for Web access

Configuring individual WinCC screens for Web access
1. Double-click the desired screen in the project tree. The screen is opened and the screen 

properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web access".

3. Activate "Web access".

or

1. select the desired screen in the project tree.

2. Select "Web access" command in the shortcut menu.

Configuring several screens for Web access
1. Select "Screens" in the project tree.

2. Select "Web access all" command in the shortcut menu.

Result
The WinCC screens are configured for Web access. During the transfer of the project, the 
WinCC screens are adapted for access via the Intranet/Internet and published on the 
DataMonitor Server.

For more information, refer to "Transferring when WinCC projects".

See also
Creating static process screens for the Web Center (Page 7319)
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WinCC screens as a gadget

Gadget on the Data Monitor Server

Introduction
Using the "Preview" property, you define which screens to group in a gadget. Gadgets are mini 
applications for the Windows sidebar. In order to use gadgets, a DataMonitor client must 
always be installed as well on the DataMonitor server.    

The following operating systems support gadgets:

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2

Procedure
To configure WinCC screens as a gadget, proceed as follows:

1. Double-click the desired screen in the project tree. The screen is opened and the screen 
properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web access".

3. Activate "Preview" and "Web access".

4. Save the WinCC project.

5. Select the "Compile > Software" command in the shortcut menu of the HMI device.

Result
The screens are assembled for the gadget on the WebNavigator server. As soon as the project 
is in runtime, the WebNavigator server generates a jpg snapshot image "pdlImage.jpg" of each 
screen at cyclic intervals and in consecutive order. 

The file is stored in the directory "\WinCC\Webnavigator\Server\Web\image\_gadget". The 
gadget accesses this file cyclically in the directory again.

Note that user interactions are not possible in the screens displayed. This includes, for 
example, calls from login dialogs or notice dialogs via functions.

The following objects are not supported for the display in a gadget:

● GSC diagnostics window

● Media Player
 

  Note

The WinCC project shown in the gadget cannot be operated.
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Gadget on the Data Monitor Client

Introduction
In order to use gadgets, a DataMonitor client must always be installed as well on the 
DataMonitor server. A preconfigured gadget for displaying WinCC screens is located on the 
DataMonitor client in the installation directory under ""\WinCC\Webnavigator\GADGET".   

The following operating systems support gadgets: 

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2

Requirement
The screens are published on the Data Monitor server and configured as "Preview".

Procedure
To access the gadget with the Data Monitor Client, follow these steps:

1. Double-click on the "_WebNavigator.gadget" gadget in the installation directory under 
"\WinCC\Webnavigator\GADGET". IN Windows 7 / Windows 2008, the gadget is installed 
in the sidebar.

2. Define the update cycle in which the gadget loads a screen from the Data Monitor Server, 
every 17 seconds for example.

3. Enter the address of the Data Monitor Server. The gadget establishes a connection to the 
Data Monitor Server.

4. If necessary, drag-and-drop the gadget onto the desktop.

Configuring runtime settings (DataMonitor)

Introduction    
You can configure the behavior in runtime in the "Runtime settings" editor. 
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Procedure
1. Open the "Runtime settings > Web access" editor.

2. To use the "WinCC Classic" design, activate "Use "WinCC-classic" design".

3. To use your own cursor as a "View only cursor", enter the path and file name of the cursor 
at "Cursor "View only". Alternatively, navigate to the file of the desired cursor using the "…" 
button.

4. To change the maximum number of concurrent connections, enter the desired number in 
the "Count of concurrent connections" field.

5. To change the maximum number of open tabs in the browser, enter a suitable value in the 
"Number of tabs per browser" field. Internet Explorer V7 or higher supports this setting.

 

  Note
Server load settings

Each tab that calls the server homepage uses a license on the server PC. A connection 
setting of "10" and a tab setting of  "2" corresponds to 20 clients. A license for at least 20 
clients must be available on the server PC.

 

6. Define whether the local user group is disabled on the WebNavigator Server.

7. To output an appropriate system message when a WebNavigator logs on and off, activate 
"Enable event log messages".

Result
The settings for Runtime are configured. 

See also
Display screens (Page 7306)
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Defining users in WinCC

Managing a user group for DataMonitor

Introduction
A different start screen and the language can be set for each user group.  This allows you to 
make various sections of a project immediately accessible or inaccessible for users.

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
● The "User groups" work area is open.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Procedure
1. Position the mouse cursor on the title of the "Groups" table.

2. Open the shortcut menu with the right mouse button and select the display of the "Start 
screen" and "Language" columns.

3. Double-click "Add..." in the "Groups" table.

4. Enter "DataMonitor operators" as the name of the user group. Activate at least the 
"DataMonitor - View only" authorization in the "Authorizations" table.

5. Click the  button in the "Start screen" column. A dialog box for selecting the start screen 
opens.

6. Select a start screen for Runtime.

7. Close the dialog box by using the  icon.

8. Click the  button in the "Language" column. A dialog box for selecting the language opens.

9. Select the language.

As an alternative, select the user group in the work area; the properties of the user group are 
then displayed in the Inspector window. In the Inspector window, select "Properties > 
Properties > Web options". Select the start screen and the language.

 

 Note

The name of the user group is language-dependent. You can specify the name in several 
languages and switch between languages in runtime. 
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Managing users for DataMonitor

Introduction
Create a corresponding user in user administration to enable the use of the "WinCCViewerRT" 
and "Excel Workbooks" functions. 

Requirements
● DataMonitor is installed.

● The "Users" work area is open.

● The "DM_Demo" user is created and assigned view-only rights.

● The "DataMonitor operators" user group has been created.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.

Setting the start screen and language
1. Position the mouse cursor on the title of the "Users" table.

2. Open the shortcut menu with the right mouse button and select the display of the "Start 
screen" and "Language" columns.

3. In the "Start screen" column, click on the  button in the row of the "DM_Demo" user. A 
dialog box for selecting the start screen opens.

4. Select the "Start" screen.

5. Close the dialog box by using the  icon.

6. Click the  button in the "Language" column. A dialog box for selecting the language opens.

7. Select "Spanish" as the Runtime language.

8. Activate the "DataMonitor operators" user group in the "Groups" table.

As an alternative, select the user in the work area; the properties of the user are then displayed 
in the Inspector window. In the Inspector window, select "Properties > Properties > Web 
options". Select the start screen and the language.

 

 Note

The language setting is retained when a user is moved from one group to another. The start 
screen will be overwritten.
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Transferring a WinCC project

Requirement     
● A WinCC project is configured

● DataMonitor Server is installed on the server PC.

● The configuration PC and server PC are interconnected.

Online transfer
Transfer the WinCC project using the command "Load to device > Software (all)". The project 
is compiled prior to the download. The screens are adapted for access via Intranet/Internet 
during compilation. 

During the download to the server PC, the configured WinCC project is transferred and the 
screens are published on the DataMonitor Server. For more information, refer to "Compiling 
and loading".

Configuring the DataMonitor Server

Setting up the DataMonitor Web page

Requirement
● Internet Information Service is installed.

● The WinCC DataMonitor is installed.

Procedure
Set up the DataMonitor Web page as follows:

1. In the Start menu select the command "Start > All Programs > Siemens Automation > Option 
and Tools > HMI Tools" > WinCC Web Configurator". This starts the Web Configurator.

2. The Web Configurator detects whether a configuration already exists.

– No configuration available: Select "Create a new standard website (stand-alone)" and 
click "Next".

– A configuration exists: Check the configuration
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3. Define the desired settings.

4. Enter the name of your Web site in the "Name of the Web site" field.

5. In the "Port" field, enter the port number used for access.

6. In the "IP address" field specify whether the PC is to be reached in the Intranet, Internet or 
in both networks. Only use addresses from the selection list.
If you want to make your PC accessible via the Intranet and the Internet, select "All not 
assigned".

7. Select "DataMonitor.asp" as the standard Web site.

8. Define the time interval after which the Web Navigator Clients automatically start to 
establish a connection following a connection breakdown. If "0 s" is set, the "Automatic 
connection establishment" function is disabled.

9. Define the way the Web site is started after configuration.

10.If you have not activated a firewall, click "Finish". If you have installed a firewall, click "Next".

Result
The Web directory has been created and the Web page is activated. If you have activated the 
firewall, configure the firewall settings with the Web Configurator. See "Setting up a firewall" 
for additional information.
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Setting up a firewall

Introduction
This section describes only the activation of the "HTTP" and "HTTPS" services for port 80 in 
the respective operating system.

To set up the Windows firewall with advanced security, or for a different port, contact your 
network administrator.

Requirement       
● You have created a standard Web site using the Web Configurator.

● The firewall is activated.

● A logged on Windows user has administrator rights

Procedure
To set up the firewall for a standard port, proceed as follows:

1. Click "Windows Firewall" in the "WinCC Web Configurator".

2. The "Windows Firewall" dialog will open.

3. In Windows 7 or 2008, click "Allow a program or feature through Windows Firewall".
In Windows 8.1 or 2012, click "Allow an app or feature through Windows Firewall".

4. Activate "Secure WWW Services (HTTPS)" or "WWW Services (HTTP)".

5. Exit the open Windows dialogs with "OK". 

6. Click "Finish" in the Web Configurator. The configuration of the server will be completed.

Defining users in Windows

User groups

User groups in Windows
The following user groups are created automatically in Windows when the DataMonitor server 
is installed:

"SIMATIC Report Administrators"

The membership in the user group "SIMATIC Report Administrators" is required for extended 
rights, especially for configuration purposes. You must create at least one user and assign the 
user group "SIMATIC Report Administrators".
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● The following is possible in the "Webcenter" function:

– Configuration of connections

– Creation of templates for WebCenter pages

– Creation and configuration of public and private WebCenter pages

● The following is possible in the "Reports" function:

– Configuration of reports on the basis of print jobs or Excel workbooks.

"SIMATIC Report Users"    

The membership in the user group "SIMATIC Report Users" or in your own user group is 
required for the functions "Webcenter", "Trends and Alarms" and "Reports".

● The following is possible in the "Webcenter" function:

– Setting and configuration of WebCenter pages. WebCenter pages are stored in different 
directories.

– Opening public pages

● The following is possible in the "Reports" function:

– Opening reports on the basis of print jobs or Excel workbooks.

Defining Users and Access Rights in Windows

Requirement
● WinCC Runtime Professional is installed

● DataMonitor Server is installed

Procedure
Proceed as follows to create a user under Windows:

1. Open the Control Panel. Double-click the "Administration" entry.

2. Double-click "Computer Management" in the "Administration" dialog.
The "Computer Management" dialog opens.

3. Navigate to the directory "System > Local Users and Groups / Groups". Select the "New 
User..." command in the shortcut menu.

4. Enter the name "DM_Demo" in the "User Name" field in the "New User" dialog. Enter the 
description "User for DataMonitor" in the "Complete Name" field. Type the desired 
password into the "Password" field and then repeat it in the "Repeat Password" field. Create 
the user with "Create". Close the "New user" dialog.

5. In the right part of the table window, click the newly created user. Open the shortcut menu 
and select  the command "Properties". Go to the "Member of" tab. Click "Add".

6. Click the "Advanced >" button in the dialog "Select Groups" and then "Find now".

7. In the dialog below, select the two entries "SIMATIC Report Administrators" and "SIMATIC 
HMI VIEWER" from the list. To close the dialog, click "OK" twice.
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8. The groups "SIMATIC Report Administrators" and "SIMATIC HMI VIEWER" are added to 
the membership list in the user properties. Click "OK."

9. Close the dialog "Computer Management" with the menu command "File > Exit".

10.Close the dialog "Management" with the menu command "File > Close".

Result
The user "DM_Demo" with membership of the user groups "SIMATIC Report Administrators" 
and "SIMATIC HMI VIEWER" has been set up. 

Starting the DataMonitor on the DataMonitor client 

Configuring security settings in Internet Explorer

Introduction     
To have the full functionality available on the DataMonitor client, adapt the security settings in 
Internet Explorer. 

● Internet Explorer V8 or higher

Procedure
To configure the security settings in Internet Explorer, proceed as follows:

1. Click "Tools" > "Internet Options" in the Internet Explorer. The "Internet Options" dialog 
opens.

2. Click the "Security" tab.

3. Select the "Trusted Sites" icon and click the "Sites..." button. The "Trusted Sites" dialog 
opens.

4. Enter the address of the DataMonitor Server in the "Add this Website to the zone" field.
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".

5. If necessary, clear the "Require server verification for all sites in this zone (https:) check 
box. Click "Add". Confirm the entry by clicking "OK".

6. Select the "Trusted Sites" icon.

7. Click "Default Level". Click "Customize Level" in the following dialog.
The "Security settings" dialog box opens. 

– Activate the "Activate" option under "Initialize and script ActiveX controls not marked as 
safe".

– Confirm the entry by clicking "OK".

8. Close the "Internet Options" dialog by clicking "OK".
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Result
The necessary settings of the DataMonitor client in the Internet Explorer are configured.

Starting the DataMonitor startup page on the DataMonitor client

Introduction         
The start page of the DataMonitor summarizes the functions of the DataMonitor. 

● "Working with reports (Page 7358)":
Creation and output of the analysis results and process data in print jobs and in published 
Working with Excel Workbooks (Page 7345).

● "Working with the WebCenter (Page 7307)"
Configuration of connections and creation of WebCenter pages for the display of logged 
data.

● "Working with Trends and Alarms   (Page 7334)"
Display of alarms and process values from logs in tables and diagrams.

You start the DataMonitor client on a standalone PC or on a DataMonitor server. 

Requirements
● User has been created in the Windows user group "SIMATIC Report Administrators".

● The WinCC project on the DataMonitor Server is in Runtime.

● A user is created in WinCC.
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Procedure
To access the Web page of the DataMonitor Server, proceed as follows:

1. Open the MS Internet Explorer on the DataMonitor client.

2. Enter the name of the DataMonitor server in the format "http://<servername>" in the URL. 
Confirm the entry with "Enter".

3. The logon dialog opens. Enter the name of a Windows user in the "User name" field. Enter 
the respective password and confirm with "OK".
The start page with the DataMonitor functions will be displayed.

Result
The start page with the DataMonitor functions will be displayed on the DataMonitor client. The 
use of the functions depends on the user's access right. 

See also
Working with WinCCViewerRT (Page 7304)
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General Operations of the DataMonitor Client

Introduction 
The DataMonitor Web pages have the following structure: 

① Header
② Current user
③ Link to logoff
④ Navigation control
⑤ Icon to hide the header
⑥ Interface language selection field
⑦ Tabs depending on the currently displayed contents
⑧ Contents
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Switching the user interface language 
1. Choose the desired language from the selection field in the header.

The GUI language is changed.

Hide and show the header  
1. To hide the header line, click the symbol .

This provides more room for displaying the content.

2. To show the header line again, click the symbol .

Logoff   
1. To log off from the DataMonitor server, click the "Log off" link.

2. Close Internet Explorer.
When you close Internet Explorer, the used license will be released immediately. 

10.16.2.4 Working with WinCCViewerRT

Setting up WinCCViewerRT

Requirement   
● On the server PC

– The DataMonitor Server is installed.

– A license key is installed.

– The WinCC project is in Runtime.

– The WinCC screens are configured for Web access and published.

● On the client PC

– DataMonitor Client is installed.
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Procedure
Set up WinCCViewerRT as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Enter the logon data in the "General" tab:

– Server address: http://<server name>, or http://<IP address>

– User name and password:

3. In the "Parameters" tab, specify the Runtime language and whether to disable keystrokes 
that the operator uses to change to other programs.

4. Define the WinCC Runtime Professional properties in the "Graphics Runtime" tab:

– Start screen

– Configuration file for screen navigation

– Window attributes

– Illegal user actions

5. Define additional user actions in the "Runtime" tab.

– Automatic logout

– Enable screen keyboard.

– Use <Ctrl+Alt+Del> to switch to the Task Manager and to the operating system. This 
setting is only valid for the on-screen keyboard.

– Open the "WinCCRTViewer" dialog by means of keystroke.
You can change the default keystroke <Ctrl+Alt+P>.

6. Close the dialog with "OK".
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Result
The WinCCViewerRT is configured. When the dialog is closed, the connection to the 
DataMonitor server is established. The settings are saved to the configuration file 
"WinCCViewerRT.xml". The settings in the configuration file are used at the next start of 
WinCCViewerRT.

The configuration file is stored in the directory "C:\Users\<User name>\Appdata\LocalLow
\Siemens\SIMATIC.WinCC\WebNavigator\Client". Under <User name>, enter the name of the 
user logged-on when the file is created. This allows different configurations to be used, 
depending on the logged on user. WinCCViewerRT applies the interface language from 
WinCC.

Renaming or removing WinCCViewerRT.xml

When you rename or remove the file WinCCViewerRT.xml, the configuration dialog of 
WinCCViewerRT is opened during the start. Reconfigure WinCCViewerRT, or select a different 
configuration file.

Display screens

Requirements   
● A license key is installed on the DataMonitor Server.

● The WinCC project on the DataMonitor Server is in Runtime.

● The WinCC screens are configured for Web access and published.

● A WinCC user with authorization no. 1002 "Web access - view only" is created.

Procedure
To view screens, proceed as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Log on to the WebNavigator server:

– If the user and password are configured in "WinCCViewerRT", no logon dialog displayed.

– If no user and password was configured in "WinCCViewerRT", the logon dialog 
displayed. Enter the user name and the password of the WinCC user. Click "OK."

3. Press the <Ctrl+Alt+P> keystroke to change the user. The "WinCCViewerRT" dialog opens.
Enter the user name and password on the General" tab.
You can also select the xml file that contains this data. 

Result
The Web Viewer connects to the activated WinCC project. The screens of the WinCC project 
are displayed. 

The cursor is a "View only cursor" and indicates that process-related operations are not 
allowed. 
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Certain operations are still possible, such as opening the properties dialog of an online trend 
control. 

If necessary, you can use your own cursor symbol as a "View only cursor". See "Configuring 
runtime settings (DataMonitor) (Page 7290)" for more detailed information.

10.16.2.5 Working with the WebCenter

Administration

User Groups and Directories

Overview       
WebCenter pages and reports are stored in directories on the DataMonitor Server. 

Its standard complement of directories is as follows:

● "Public"

● "Private"
Every user has a "Private" directory. Only the respective user has access rights to this 
directory.

More information on setting up directories can be found in chapter "Creating Directories 
(Page 7309) ".

Windows User Groups
The user groups "SIMATIC Report Administrators" and "SIMATIC Report Users" are created 
during the installation of the DataMonitor Server. You can create more user groups. More 
information on setting up user groups and users can be found in chapter "Assigning Access 
Rights (Page 7310) ".

To access the DataMonitor, you can assign all members of a user group with the same access 
rights to the directory of the DataMonitor server.

The following access authorization is possible:

● Read

● "Change"

● "Create"

A user, as a member of a user group, only has access to a directory if the respective user 
group has access rights to that directory. This permits user group-specific access. More 
information on assigning access authorization can be found in chapter "Defining users in 
Windows (Page 7296) ".
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The following screen shows the basic user administration for the WebCenter.
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Creating Directories

Introduction   
You store WebCenter pages in directories. The following directories exist as defaults:

● "Public"

● "Private"
Every Windows user has their own "Private" directory.

Requirement
● The logged on user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The DataMonitor start page is open.

Procedure
1. Click in the start page "Webcenter > Administration".

2. Click the "Directory administration" tab.

3. Enter the name "mypart" in the "New directory" field.

4. Click the "Create" button.

Result
You have created the directory "mypart". The user administration is opened automatically. 
Specify the access rights for the folder. You can also exit the page and configure the access 
rights at a later time.
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Assigning Access Rights

Introduction     
In the WebCenter, directories are created in which, for example, the WebCenter pages are 
stored. You can assign different access rights for the individual directories to Windows user 
groups.

The following access authorization is possible:

● Read

● "Change"

● "Create"

Requirement
● The logged on user is a member of the Windows user group "SIMATIC Report 

Administrators".

Procedure
1. Click in the start page "Webcenter > Administration".

2. Click the "User administration" tab.
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3. Select the desired directory from the "Current Directory".
All existing Windows user groups are listed.

4. Activate the access rights in the line of the desired Windows user group.

5. Click "Save".

Result
The access rights have been configured for the desired directory.

Establish a connection to the winCC data

Create connection and set up language

Introduction     
A connection is configured for access to the data in the "Webcenter". A connection is set up 
for each data source, e.g. WinCC server. The connection is required for example for the 
function "Trends and Alarms" and the WebCenter page. 

Requirement
The logged on user is a member of the Windows user group "SIMATIC Report Administrators".
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Procedure
1. Click in the start page "Webcenter > Administration".

2. Click the "Connection administration" tab.

3. Choose the language that corresponds with the linguistic region of the server or log to be 
linked in "Linguistic region".
If you do not select the language that corresponds with the respective linguistic region, 
characters may be displayed incorrectly on the page.

4. Select "New connection".
After the new installation, no selection is possible in the "Connection" field, as no 
connections have been configured yet.

5. Enter a name in the field "Connection name", e.g. "WinCC1_ Runtime".
Any name can be selected. However, it should contain a reference to the selected 
connection type. Do not use spaces and special characters in the connection name.

6. Enter the name of the PC whose data you would like to access in the "Computer name" 
field. As an alternative, select the name of the PC using the "Find" button.

7. Enter the desired database in the "Database" field. Alternatively, select the database using 
the "Find" button.
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8. Choose the desired option in the "Connection type" area.

– "Swapped WinCC Log"
Further steps are required to access data from logs. For additional information, refer to 
"Connecting and Disconnecting Swapped Logs (Page 7313)".

– "WinCC Runtime"
The Runtime database of the selected WinCC project is entered in the "Database" field.

– CAS
CAS is not available in this version.

– WinCC Runtime + all segments
"CC_ExternalBrowsing" is entered in the "Database" field.

9. Activate "Automatic adaption of RT database". When a segment is changed, the name of 
the database is adjusted in the connection administration.

10.Click the "Create" button.

Result
The connection to the data source is created and can be selected in "Connections". 

 

Connecting and Disconnecting Swapped Logs

Configuring a directory

Introduction 
To access data from swapped WinCC logs (log backup file), these logs must be connected to 
an SQL server again. 

You can connect all or individual log backup files of a directory to the SQL server.

Requirement
● Write protection of the log backup file has been removed

Archive backup files are write protected. Create a backup copy of the file before connecting 
and remove the write protection of the copied log backup file. 

● The log backup files are available on the local drive.

● The directories in which the log backup files are set for sharing.

– The directory must be set for sharing in the Windows Explorer before you start the 
DataMonitor Server.

– If you set the directories for sharing later, restart the DataMonitor Server.

● The user group "SIMATIC HMI VIEWER" must have "full access" to the directories.

● The logged on user is a member of the Windows user group "SIMATIC Report 
Administrators".
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● Windows Server 2003 / 2008: "Network service" has been added to the "Print operators" 
group.

● Windows 7: "Network service" has been added to the "Power user" group.

● Windows XP: "ASPNET" has been added to the "Power user" group.

Procedure
Proceed as follows to create a symbolic directory:

1. Click in the start page "Webcenter > Administration".

2. Click the "Archive administration" tab.

3. Enter a unique symbolic name name in the "Symbolic Name" field.
The name should only contain the characters permitted in the SQL syntax. You use the 
symbolic name for access via the DataMonitor client.

4. In "Directory", select the directory in which the log backups are located.
You can only select directories that have been set for sharing.

5. To connect all existing log backups of the directory, select "Automatically connect all logs 
in this directory".
To connect all individual log backup files of the directory, clear "Automatically connect all 
logs in this directory".

6. Click "Add".

Result
You have created the symbolic directory "Test". If you have cleared "Automatically connect all 
logs in this directory", define the log backups to be connected on the page "Connect/disconnect 
logs (Page 7315)".

To disconnect logs, clear the desired logs on the page "Connect/disconnect logs"
 

 Note
Connected logs on changeable media

Before changing the media in the drive you need to disconnect the logs on this medium. After 
changing the medium, check whether the logs are connected on the new medium.
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Deleting a symbolic directory
To remove a directory containing logs from the list of symbolic names, disconnect all logs 
contained in the list. The status of the logs can be seen on the page "Connect/disconnect logs".

Connecting and Disconnecting Logs

Requirement
● Write protection of the log backup has been removed

Log backups are write protected. Create a backup copy of the log before connecting and 
remove the write protection of the copied archive.

● The logged on user is a member of the Windows user group "SIMATIC Report 
Administrators".

● You have configured the symbolic directory "Test" (Page 7311).

Procedure
To connect or disconnect individual log backups, proceed as follows:

1. Click in the start page "Webcenter > Administration".

2. Click the "Connect/disconnect logs" tab.
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3. Select the directory "Test" in "Symbolic directories". Existing logs are displayed in a list. 
The "Info" column provides information about the status.

– Green: Connected

– Red: Disconnected

4. To restrict the display, click "Filter".

5. Enter the desired time period and click "Refresh display".

6. To connect a single archive, select the desired log in the "List of existing logs". Click "Save". 
The status "Green" indicates that the log is connected.

7. To disconnect a single archive, clear the desired log in the "List of existing logs". Click 
"Save". The status "Red" indicates that the log is disconnected.

Alternative procedure
Archive backups can be connected in the following ways:

● VB function using the "Restore" method. For detailed information, refer to "Restore".

● Automatic Connection: If you copy the log backups to the "CommonArchiving" folder, the 
logs are connected to the project in Runtime.

● Using Archive Connector (Page 7316).

Result
Logs are connected. If you connect signed logs, which have been changed after the swap, an 
alarm is output.

Connecting Logs using WinCC Archive Connector

Introduction
With the Archive Connector, already swapped out WinCC logs can be reconnected to an SQL 
Server.

Requirement
● Write protection of the log backup file has been removed

Archive backup files are write protected. Create a backup copy of the file before connecting 
and remove the write protection of the copied log backup file. 

● The log backup files are available on the local drive.
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● The directories in which the log backup files are set for sharing.

● The user group "SIMATIC HMI VIEWER" must have "full access" to the directories.

● The logged on user is a member of the Windows user group "SIMATIC Report 
Administrators".

Procedure
To connect log backup files, proceed as follows:

1. Start the "Archive Connector".

2. Click "Add" in the "Configuration" tab. The "New Directory" dialog is opened.

3. Navigate to the directory in which the log backup files are stored.

4. Enter a symbolic name for the directory. Click "OK." The directory is displayed on the 
"Configuration" tab.
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5. Click the "Connect/Disconnect Logs" tab. All the logs in the selected directory are listed in 
the "Connect/Disconnect Logs" tab.

6. Select the desired log and click "Connect".

Result
A connection has been created and the desired log backup files are connected to the SQL 
server.

The connection status of each log is displayed on the "Connect/Disconnect Logs tab". "From" 
and "To" columns contain the archiving period denoted in the local time zone.

The "Type"column contains the details for log type.

"A" Alarm logs
"TF" Fast data log
"TS" Slow data log
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Creating static process screens for the Web Center

Introduction   
In the screen management, specify the screens that you need for the Web element "Static 
process screens".

The DataMonitor Server generates copies of the screens at configurable cyclic intervals and 
provides these to the DataMonitor Client and the form of static process screens. 

Requirement
● The logged on user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The WinCC screens are configured for Web access and published. See "Configuring 
WinCC screens for Web access (Page 7288)" for additional information.

● The DataMonitor start page is open.

● The "Screen management" tab is open.
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Creating static process screens for the Web Center
1. Select the screens.

– To select all screens, activate the check box in the column header.

– To select individual screens screens, activate the check box leading the relevant screen.
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2. To display only part of the screen, define the following:

– X position: Start positions in x direction in pixels

– Y position: Start positions in y direction in pixels
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– Width: Width of screen in pixels

– Height: Height of screen in pixels

3. To set a language for a process screen, select the required language in the drop-down list. 

4. To output the time at which the static process screen screen was created by the 
DataMonitor Server, activate "Stamp".
The date time are shown in the static process screen.

5. To change the update cycle, enter the desired value in "Update time interval".
Select this cycle as large as possible. A cycle that is too small leads to performance 
problems.

6. Click "Save".

Result
The DataMonitor Server generates the static process screens from the selected screens. The 
static process screens can be configured in the Web part "Static process screens".

Removing static process screens
To remove static process screens, select the check box at the relevant entry in the "Delete 
graphic object" column. Click "Save" to remove the static process screen or copy. The deleted 
static process screens can no longer be configured in the Web part "Static process screens".

Finding screen names or limiting the view
Use a filter to find screen names, or to limit the view to specific screen names.

At the "Filter" entry, click  to show the filter above the table. Enter the search term in the 
text field and then click <Enter>. 

To hide the filter, click .

Create a layout template for WebCenter pages

Introduction         
You require a layout template to create a WebCenter page. Many prefabricated layouts have 
been installed during the installation. Additionally, you can create your own Layout Templates.

Requirements
● The logged on user is a member of the Windows user group "SIMATIC Report 

Administrators".

● The DataMonitor start page is open.
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Procedure
Proceed as follows to create your own layout template:

1. Click "WebCenter > Configuration" in the start page.

2. Click the "Create layout" tab.

3. Define the number of columns and rows.

4. Enter the name "mylayout_23" in the "Name of the layout file" field. Click "Next."
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5. If required, group the table fields. For this, click the appropriate arrow symbol, such as 
"Arrow up", in the desired field, for example line 3 / column 1.
The modified view will be displayed. 

To restore the original table form, click "Reset configuration".
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6. Click "Next."

7. You define the order of the Web parts in the table fields.
If necessary, select the corresponding symbol in a table field to place the web parts vertically 
or horizontally.

8. Click "Save".

Result
The layout template "mylayout_23" is created. You can use the layout template as a template 
for creating a WebCenter page. 

Create a WebCenter page

Introduction     

Requirements
● The directory "myPart" is set up.

● The user logged on is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the "Change" or "Create" access rights to the directory.

● The DataMonitor start page is open.
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Procedure
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Create Page" tab.

3. Click the desired layout template. The file name is displayed in the "Layout file" field.

4. Enter a name in the "WebCenter page" field, for example "My_Webcenter".

5. Click the directory in which the WebCenter page is stored. The selected directory is 
displayed in the field "Save WebCenter page as".

6. Click "Save".
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Result
The WebCenter page has been created and saved. 

Insert Web parts into the WebCenter page

Introduction       
You combine Web parts to create the contents of the WebCenter pages. 

Requirements
● The directory "myPart" is set up.

● The WebCenter page "My_Webcenter" is stored in the directory.

● The user logged on is a member of the Windows user group "SIMATIC Report 
Administrators" or "SIMATIC Report Users".

● The Windows user groups have the "Change" or "Create" access rights to the directory.

● The DataMonitor start page is open.

Procedure
Proceed as follows to insert Web parts in the WebCenter page:

1. Click "WebCenter > Pages" in the start page.

2. Click the "myPart" tab.

3. Click the "My_Webcenter" entry.
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4. To add Web parts, click the symbol  on the right side.
The available Web parts are listed.
If you have exported web parts that have already been configured, they are listed under 
"Imported web parts". If necessary, insert these web parts into your WebCenter page.

5. Select "Trend (Timestamp)".

6. Select the entry "WPZ_01_01" and click "Add".

7. Select "Alarm hit list".
If you insert several Web parts in a spreadsheet field, they are arranged horizontally or 
vertically. Specify this arrangement when creating the layout template.

8. Select the entry "WPZ_02_01" and click "Add".

9. Click "Close."
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Result
Web parts to display data have been inserted into the WebCenter page "My_Webcenter". The 
current summary of the WebCenter page is displayed.
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Configure Web parts within WebCenter pages 

Requirement
● The user logged on is a member of the Windows user group "SIMATIC Report 

Administrators" or "SIMATIC Report Users".

● The Windows user groups have the "Change" or "Create" access rights to the directory.

● The WebCenter page "My_Webcenter" is open.

● The WinCC project is in Runtime.
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Procedure
To configure Web parts within WebCenter pages, proceed as follows:

1. Click the icon  in the desired Web part. The configuration dialog opens.

2. Configure the web part.

– Displaying process values in a table (Page 7334)

– Displaying process values in a diagram (Page 7336) 

– Displaying messages in the alarm table (Page 7338) 

– Displaying the hit list of messages (Page 7342) 
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– Displaying statistics function for process values (Page 7343) 

3. To change the position of the web part, move the web part to the desired position with the 
mouse.

More Operational Capabilities         
The following operating options are available:

Delete Web part
Minimize Web part
Maximize Web part
Export Web part
Export configuration of the Web part as an XML file

 

Deleting WebCenter Pages and Layout Templates

Requirement
Deleting layout templates

● The user is a member of the Windows user group "SIMATIC Report Administrators".

● The DataMonitor start page is open.

Deleting a WebCenter page

● The logged-in user must have "Create" access rights for the directory in which the page to 
be deleted is stored.

● The DataMonitor start page is open.
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Deleting layout templates
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Delete layout" tab.

3. Delete the selected files.

– To delete several layout files, select the "Selection" check box for the files to be deleted. 
Click "Delete".

– To delete all the layout files, click "Select All". Click "Delete".

– To delete individual layout files, click the respective "Delete" button in the "Action" 
column.

Result
The selected layout file is deleted. Note that this also applies to the layout files included in your 
package.

Existing WebCenter pages which use this layout template are retained. You cannot use this 
layout to create new WebCenter pages. 

Deleting a WebCenter page
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Delete page" tab.

3. Activate the respective check box to mark the pages to be deleted.

4. Click "Delete".
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Exporting and importing WebCenter pages

Requirement
● The logged-on user has access rights.

● The WebCenter page is open.

Exporting a WebCenter page
1. Click  

2. Select if you want to open or save the file as a WebCenter page in the dialog that opens.
If you save the file, a file is generated with the format "*.Export". 
To open the file, select a program that can display "*.xml" format.

Importing a WebCenter page
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Import page" tab.

3. Enter a file name or click "Browse".

4. To load the file, click "Upload".

5. Enter a name for the WebCenter page.

6. Select the storage location for the WebCenter pages.

7. Click on "Import".

 

Result
The selected WebCenter page is imported and displayed in the DataMonitor.

 

10.16.2.6 Working with Trends and Alarms  

Displaying process values in a table

Requirements  
● A connection to the WinCC data is established (Page 7309)

● The DataMonitor start page is open.
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Procedure
Proceed as follows to display process values in a table:

1. Click "Trends & Alarms " in the start page. Click the "Process value table" tab. The Web 
part "Process Value Table" is displayed.

2. Click . The configuration dialog of the Web part opens.

3. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

4. Select the desired connection in the "Connection" field. The logging tags available via this 
connection will be displayed. You can limit the number of tags using the "Archive selection" 
and "Tag filter" fields.

5. Click "Add" for the desired logging tags.

6. Define the time range in the "Time period" area.
With relative times, enter a negative value in the respective field. To obtain additional 
information on the time specification, click the  symbol.
To check the set time range in the column "Preview time frame", click "Preview".

7. Define the number of decimal places in the "Displaying decimal places" section.

8. In the "Table size" area, define the size of the display window. For example, enter a height 
of "200" and a width of "400". 
If the value "0" is entered into both fields, the size is determined automatically. The size is 
oriented on spatial requirements of the Web part.

9. The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

10.Confirm your entries.
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Result
The values of the logging tags are output in the process value table.

Use the arrow keys to skip backward and forward with multi-page tables. You can export the 
displayed table in CSV format using the  icon. Click the  symbol to change your settings.

Displaying process values in a diagram

Requirements
● A connection to the WinCC data is established (Page 7309)

● The DataMonitor start page is open.

Procedure
Proceed as follows to display process values in a trend view:

1. Click "Trends & Alarms " in the start page. Click the "Trend (process values)" tab. The Web 
part "Trend (process values)" is displayed.

2. Click . The configuration dialog of the Web part opens.

3. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

4. Select the desired connection in the "Connection" field. The logging tags available via this 
connection will be displayed. You can limit the number of tags using the "Archive selection" 
and "Tag filter" fields.
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5. Click "Add" for the desired logging tags, e.g. "TREND_1", "TREND_2", "TREND_3. The 
logging tags are listed in the "Current selection" area.

6. Define the following for the individual logging tags in the "Current selection" area:

– color of time and value axis

– form of the trend display

7. In the section "Value axis editor", you can select the automatic scaling for the different value 
axes or you can assign a minimum and a maximum value to each axis.

8. Define the time range in the "Time period" area.
With relative times, enter a negative value in the respective field. To obtain additional 
information on the time specification, click the  symbol. To check the set time range in 
the column "Preview time frame", click "Preview".

9. In the section "Diagram settings", define the size of the display window. If the value "0" is 
entered into both fields, the size is determined automatically. The size is oriented on spatial 
requirements of the Web part.

10.To display the legend, select "Show legend".

11.The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

12.Confirm your entries.
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Result
The selected process values are displayed as trends in a diagram.

The legend shows the assignment of the colors to the logging tags. Skip forward or back by 
the selected time frame in the absolute time using the  and  buttons. 

Enlarge the display and you can zoom into the diagram area to the left and right of the center 
line using the "Zoom left"  and "Zoom right"  buttons. The  button is used to  restore 
the original view. 

Export the table displayed in CSV format using the  icon.

Click the  symbol to change your settings.

Displaying messages in the alarm table

Requirements
● A connection to the WinCC data is established (Page 7309)

● The DataMonitor start page is open.
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Procedure
To display alarms in the alarm table, proceed as follows:

1. Click "Trends & Alarms " in the start page. Click the "Alarm table" tab. The Web part "Alarm 
Table" is displayed.
Click . The configuration dialog of the Web part opens.

2. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

3. Select the connection in the "Connection" field. 

4. Select the corresponding WinCC server in the "Selection of WinCC Servers" area. 
You need this setting to be able to select a connection to a swapped out archive that 
contains log files from several WinCC servers.

5. Define the time range in the "Time period" area. With relative times, enter a negative value 
in the respective field. To obtain additional information on the time specification, click the 

 symbol. To check the set time range in the column "Preview time frame", click "Preview".

6. In the section "Language of the alarm texts", select the language in which the alarms are 
displayed.

7. In the section "Filter selection", limit the expected search results by means of filter conditions 
in SQL syntax. To obtain additional information on the filter conditions, click the  symbol.

8. Define the following for displaying the data:

– Sorting order: To obtain additional information on sorting, click the  symbol.

– Visible columns: To display all the columns, click "Select All". For further information, 
refer to "Alarm Log Column Names (Page 7340)".

– Number of decimal places

9. In the "Table size" area, define the size of the display window.
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10.The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

11.Confirm your entries.

Result
Use the arrow keys to skip backward and forward with multi-page tables. You can export the 
displayed table in CSV format using the  icon. Click the  symbol to change your settings.

Alarm Log Column Names

Introduction
You can select the alarm log columns while displaying alarms in "Trends and Alarms".
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Overview of column names

Position Name Type Comments
1 MsgNo Integer 4 Bytes Alarm number
2 State Small Integer 2 Bytes Alarm Log Status
3 DateTime DateTime 8 Bytes Time stamp of alarm (Date/time without milliseconds) 
4 Ms Small Integer 2 Bytes Time stamp of alarm (milliseconds)
5 Instance VarChar (255) Instance Name of the Alarm Log 
6 Flags1 Integer 4 Bytes (only for internal use)
7 PValueUsed Integer 4 Bytes Process Values used 
8 to 17 PValue1 to PValue10 Real 8 Bytes Numerical Process Value 1 to 10
18 to 27 PText1 to PText10 VarChar (255) Process Value Text 1 to 10
28 Computer name VarChar (255) Computer Name
29 Application VarChar (255) Application Name
30 Comment VarChar (255) Comments
31 UserName VarChar (255) User Name
32 Counter Integer 4 Bytes Running Alarm Message Counter
33 TimeDiff Integer 4 Bytes Time difference to "Incoming" status 
34 ClassName VarChar (255) Alarm class name
35 Type name VarChar (255) Alarm type name
36 Class Small Integer 2 Bytes Alarm class ID
37 Type Small Integer 2 Bytes Message type ID
38 to 47 Text1 to Text10 VarChar (255) Alarm Text 1 to 10
48 AG_NR Small Integer 2 Bytes Number of the PLC
49 CPU_NR Small Integer 2 Bytes Number of the CPU
50 CrComeFore Integer 4 Bytes Foreground Color for the "Incoming" Status
51 CrComeBack Integer 4 Bytes Background Color for the "Incoming" Status
52 CrGoFore Integer 4 Bytes Foreground Color for the "Outgoing" Status
53 CrGoBack Integer 4 Bytes Background Color for the "Outgoing" Status
54 CrAckFore Integer 4 Bytes Foreground Color for the "Acknowledged" Status
55 CrAckBack Integer 4 Bytes Background Color for the "Acknowledged" Status
56 LocaIID Integer 4 Bytes Location of the Alarm
57 Priority Integer 4 Bytes Priority
58 AP_type Integer 4 Bytes Loop-in alarm
59 AP_name VarChar (255) Loop-in-Alarm Function Name
60 AP_PAR VarChar (255) Loop-in-Alarm Screen
61 InfoText VarChar (255) Info text
62 TxtCame VarChar (255) Incoming text
63 TxtWent VarChar (255) Outgoing text
64 TxtCameNWent VarChar (255) Text came in and went out
65 TxtAck VarChar (255) Text acknowledged
66 AlarmTag Integer 4 Bytes Alarm tag
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Position Name Type Comments
67 AckType Small Integer 2 Bytes Acknowledgment Type
68 Params Integer 4 Bytes Parameter

See also
Displaying messages in the alarm table (Page 7336)

Displaying the hit list of messages

Requirements
● A connection to the WinCC data is established (Page 7309)

● The DataMonitor start page is open.

Procedure
To display alarms in a hit list, proceed as follows:

1. Click "Trends & Alarms " in the start page. Click the "Alarm hit list " tab. The web part "Hit 
list of the alarms" is displayed.
Click . The configuration dialog of the Web part opens.

2. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

3. Select the desired connection in the "Connection" field:

4. Define the time range in the "Time period" area. With relative times, enter a negative value 
in the respective field. To obtain additional information on the time specification, click the 

 symbol. To check the set time range in the column "Preview time frame", click "Preview".

5. In the section "Language of the alarm texts", select the language in which the alarms are 
displayed.

6. Select the corresponding WinCC server in the "Selection of the WinCC Server" area.
You need this setting to be able to select a connection to a swapped out archive that 
contains log files from several WinCC servers.

7. In the section "Filter selection", limit the expected search results by means of filter conditions 
in SQL syntax. To obtain additional information on the filter conditions, click the  symbol.

8. Define the following for displaying the data:

– Sorting order: To obtain additional information on sorting, click the  symbol.

– Visible columns: To display all the columns, click "Select All".

– Number of decimal places

9. In the "Table size" area, define the size of the display window. If the value "0" is entered 
into both fields, the size is determined automatically. The size is oriented on spatial 
requirements of the table.
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10.The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

11.Confirm your entries.

Result
The analysis values for the alarms are displayed in a hit list:

The table contains configured data and statistical values, e.g. InfoText, frequency of the alarm. 

Explanations for the columns are displayed as a tool tip when the mouse is moved over the 
respective column header. Use the arrow keys to skip backward and forward with multi-page 
tables.

With the icon , the displayed analysis values of the alarms can be exported in CSV format. 
Click the  symbol to change your settings.

 

 Note

The display of alarms in the hit list may take some time and may place a strong load on the 
CPU. A note is displayed in "Trends and Alarms" if the data volume is too high. You may then 
confirm the alarm and continue without any changes, or you may cancel the process to modify 
the filter criteria and thus reduce the expected amount of data.

 

Displaying statistics function for process values

Requirements
● A connection to the WinCC data is established (Page 7309)

● The DataMonitor start page is open.
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Procedure
Proceed as follows to display statistics functions for process values:

1. Click "Trends & Alarms " in the start page. Click the "Statistics functions for process values" 
tab. The Web part "Statistics functions for process values" is displayed.

2. Click . The configuration dialog of the Web part opens.

3. Change the title in the "Header" field. Enter a brief tip in the field "Tooltip".

4. Select the desired connection in the "Connection" field. The logging tags available via this 
connection will be displayed. You can limit the number of tags using the "Archive selection" 
and "Tag filter" fields.

5. Click "Add" for the desired logging tags.

6. Define the time range in the "Time period" area.
With relative times, enter a negative value in the respective field. To obtain additional 
information on the time specification, click the  symbol.
To check the set time range in the column "Preview time frame", click "Preview".

7. Define the following for displaying the data:

– Number of decimal places

– Aggregate selection: Define the analysis function for the process values.

8. In the "Table size" area, define the size of the display window. For example, enter a height 
of "200" and a width of "400". If the value "0" is entered into both fields, the size is determined 
automatically. The size is oriented on spatial requirements of the table.

9. The available WebCenter pages are displayed in the "Links to WebCenter Pages" area. To 
assign the Web part to one or more WebCenter pages, click the  symbol.

10.Confirm your entries.

Result
Statistics functions for the selected process values were executed and output in the table.

The log name and tag name are displayed as a tool tip when the mouse is moved over the 
respective column header.
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You can export the displayed table in CSV format using the  icon. Click the  symbol to 
change your settings.

10.16.2.7 Working with Excel Workbooks

Configuring an Excel workbook

Importing data from a WinCC project

Introduction     
You need the WinCC configuration data to configure Excel workbooks. 

Import this data from a local WinCC project when configuring the workbook using the Excel 
Workbook Wizard . 

Requirement
● Server PC

– Office 2007, Office 2010 or Office 2013 is installed

– The Excel add-In "Excel Workbook" is installed.

– DataMonitor Server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● On the configuration PC

– Office 2007, Office 2010 or Office 2013 is installed

– The Excel add-In "Excel Workbook Wizard" is installed.

Procedure
To import data from a WinCC project, proceed as follows on the configuration PC:

1. Open an empty Excel workbook. Select the "Excel Workbook Wizard..." command in the 
"DataMonitor" menu.

2. Activate the option "Establish connection with WinCC server".

3. The "WinCC Server" field is shown. Enter the name of the server PC and then click 
"Connect". The log in dialog is displayed.

4. Enter the name and password of a WinCC user.

5. Click "Next >". The "Add / delete tags" dialog opens.
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Result
The Excel workbook is configured. Create the view of process data.

Importing data from an xml file

Introduction
You can create the Excel workbook on a PC if, for example, Excel is not installed on the server 
PC.  Create the corresponding xml file on the DataMonitor Server. 

Requirement
● Server PC

– DataMonitor Server is installed.

– The WinCC project is in Runtime.

– A user is created in WinCC.

● On the configuration PC

–  Office 2007, Office 2010 or Office 2013 is installed

– The Excel add-in "Excel Workbook Wizard" is installed.

Creating an XML file on the server PC     
1. In the Start menu select the command "Start > All Programs > Siemens Automation > Option 

and Tools > HMI Tools" > WinCC DataMonitor Configurator Export".
The function creates an XML file and stores it in subdirectory "Web Navigator\Reports" of 
the current project. The file name is automatically generated using the format 
"<projectname>.XML". 

2. If no Excel installation exists on the server PC, transfer the XML file to another PC on which 
MS Excel and the Excel Workbook Wizard  are installed.

Configuring data access using an XML file
1. Open an empty Excel workbook. Select the "Excel Workbook Wizard..." command in the 

"DataMonitor" menu.

2. Activate the option "Load configuration data from file". Click "Next >".

3. Navigate to the required XML file.

4. Click "Next >". The "Add / delete tags" dialog opens.

Result
The Excel workbook is configured. Create the view of process data. Transfer the Excel 
workbook to the client PC. The DataMonitor Client displays the process data of the server PC. 
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Configuring the display of tag values

Requirements
● The dialog "Add / delete tags" is open.

Procedure
Proceed as follows to display tag values in Excel:

1. Check the option for the insert sequence of tag groups in the "Add tags" area.

2. In the "Tag tree" area, click the directory icon. The object list opens.

3. Select the desired tag in the object list and drag the tag to a field of the Excel table.

4. Close the object list. The tag will be displayed in the window "Tag list".

5. In the "Tag list" window, select the tag and the "Server settings" command from the shortcut 
menu.

6. In the "Server settings" dialog, enter the name and password of a WinCC user. Activate 
"Activate automatic login". Confirm your entries.
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7. In the window "Tag list", select the tag and select the menu command "Properties" from 
the shortcut menu. The dialog "Tag properties" will be opened.

8. Define the properties for the view in the table, e.g. the arrangement of headers, time stamps, 
and quality code.

9. To apply the set update cycle to all tags, select "Save as default".
Settings in the areas "Display in sheet" and "Additional Data" are not valid for all tags.

10.Confirm your entries. Click the "Next >" button in the dialog "Add tag". The dialog "Add/
delete logging tags (Page 7349)" is opened.

Result
The display of tag values in an Excel sheet is configured.     

In the Excel workbook, each table cell is assigned a short text and a comment which was 
configured for displaying a tag value. 

With tag values, the short text "OV" stands for online tags. 

In the comments, the source of the displayed values is shown in the format 
"WDWx_<number>_<tagname>". 
The value for x means: 
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● O = Online value
 

  Note

After deleting/moving cells filled with configuration data or deleting/inserting new lines/
columns in the Excel worksheet, the Excel Workbook Wizard must be executed again. 
The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed simply by using the "Next >" button. Save the workbook and close Excel.

 

 

Configuring the display of logging tags

Requirement
● The dialog "Add / delete logging tags" is open.

Procedure
Proceed as follows to display logging tags in Excel:

1. In the "Tag tree" area, click the directory icon. The object list opens.

2. Select the desired logging tag in the object list and drag the logging tag into a field of the 
Excel table.

3. Close the object list. The logging tag will be displayed in the window "Tag list".
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4. In the window "Tag list", select the logging tag and select the menu command "Properties" 
from the shortcut menu. The dialog "Archive tag properties" will be opened.

5. Define properties for display in the table, e.g. the insert sequence, data resolution, display 
time window.

6. To save the settings, select "Save as default". The settings in the "Additional data" area 
are not saved.

 

  Note

If you use the option "Number of data" for Data resolution > User-defined resolution", enter 
an even value in the input box. Even values ensure proper trend display.

 

7. Confirm your entries. Click the "Next >" button in the dialog "Add logging tag". The dialog 
"Add/remove alarms (Page 7351)" will open.

Result
The display of logging tag values in an Excel sheet is configured. 

In the Excel workbook, each table cell is assigned a short text and a comment which was 
configured for displaying a tag value. 

With tag values, the short text "AV" stands for logging tags. 

In the comments, the source of the displayed values is shown in the format 
"WDWx_<number>_<tagname>". 
The value for x means: 
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● A = Archive value
 

  Note

After deleting/moving cells filled with configuration data or deleting/inserting new lines/
columns in the Excel worksheet, the Excel Workbook Wizard must be executed again. 
The configuration data is checked and automatically adapted as a result. Confirm the data 
displayed simply by using the "Next >" button. Save the workbook and close Excel.

 

See also
Configuring the display of tag values (Page 7345)

Configuring the display of alarms

Requirement
The dialog "Add / Delete Alarms" is open.
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Procedure
Proceed as follows to display alarms in Excel:

1. Select the required cell in the Excel table. Click "Add alarm".

2. In the "Add alarm" area, click the directory icon. The dialog "Alarm - properties" will be 
opened.

3. Define the properties for the display of alarms in the Excel table, such as headings and 
insertion sequence of attributes.

4. Enter a filter condition in the "Filter string" field or use the selection dialog to define specific 
alarms to be displayed, for example.

5. Use the "Maximum number of alarms" option to limit the number of most recent alarms 
displayed. You can display maximum 1,000 alarms.

6. Activate the desired attributes in the list. For additional information, refer to "Alarm 
Attributes (Page 7356)".
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7. To save the setting, select "Save as default".

8. Confirm your entries. Click the "Next >" button in the dialog "Add logging tag": The 
"Description" dialog box will open.

Result
The display of alarms in an Excel sheet is configured. 

In the Excel workbook, each table cell is assigned a short text and a comment which was 
configured for displaying an alarm. 

With alarms, the short text "AL" and the comment are shown in the format 
"WDWL_<nummer>_<feldbezeichnung>".

 

 Note

After deleting/moving cells filled with configuration data or deleting/inserting new lines/
columns in the Excel worksheet, the Excel Workbook Wizard must be executed again. The 
configuration data is checked and automatically adapted as a result. Confirm the data 
displayed simply by using the "Next >" button. Save the workbook and close Excel.

 

See also
Configuring the display of logging tags (Page 7347)

Publishing an Excel workbook

Requirement
The display of tag values, logging tags and alarms is configured.

The "Description" dialog box is open.

Procedure
To access Excel workbooks on the DataMonitor Server, proceed as follows:

1. Click "Publish". The Excel workbook is made available for download on the DataMonitor 
Server.

2. Use the "Template" button to provide the Excel Workbook for the function "Published 
Reports".

3. Exit the Excel Workbook Wizard

4. Save the workbook and close Excel.

Alternative procedure
You publish the Excel template on the DataMonitor client. For additional information, refer to 
"Preparing an Excel Workbook as a Template (Page 7358)".
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Result
The Excel workbook is made available on the DataMonitor Server. If required, the Excel 
workbook is downloaded on the DataMonitor clients or opened directly in Internet Explorer.

Displaying process data in an Excel Workbook online

Requirements
● The Excel workbook with the configuration of the process value display must be available 

on the PC.

● One of the following Excel versions is necessary for online display in the Excel Workbook:

– Office 2007

– Office 2010

– Office 2013

● WinCC Runtime Professional is installed

● DataMonitor Server is installed.

● The WinCC project is in Runtime.

● The DataMonitor start page is open.

● The user "DM_Demo" has been created (Page 7292).

Procedure
1. Click "WebCenter > Configuration" in the start page.

2. Click the "Report tools" tab.
The Excel workbooks that were published in the Excel Workbook Wizard, are shown in an 
overview.

3. Select a workbook.

4. Click the Excel workbook symbol in the "Open / Save" column.

5. Click "Open >" in the next dialog. The Excel workbook opens.

6. Select the "Excel Workbook" command in the "DataMonitor" menu.
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7. The name of one of the servers, whose tags are configured in the Excel table, is displayed 
in the "WinCC Server" field.
The following options are available for the server name:

– Access via domain
In case of accesses from outside the network domain, the domain is indicated along 
with the server name.

– The DataMonitor start page is the standard Web page.
Only the server name is entered in the "WinCC Server" field.

– The DataMonitor start page is in the virtual directory:
The name of the virtual folder needs to be specified after the server name, e.g. "/
webnavigator".

8. Activate the "All servers" check box when the tags from several servers are configured in 
an Excel sheet. The tag values of all the servers are updated in the online display.

 

  Note

To establish connections to all the servers, select "All servers" before pressing the 
"Connect" button to establish the connection.

 

9. Activate the connection to the WinCC project via the button "Connect". After a successful 
connection, the log-in dialog will be opened. Enter the user name "DM_Demo" and the 
respective password. When several servers are used, the logon dialogs of the servers 
concerned open one after the other.
If no connection is established, a corresponding message is displayed. Clicking on the 
dialog will display further information about the error (if available).

 

  Note

The Excel Workbook dialog must not be closed as long as the logon dialog for connection 
establishment to the server persists.
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10.The connection status will be displayed in the dialog. Click the buttons "Read tags", "Read 
logging tags" and "Read alarms" buttons to update the respective values or displays.

If necessary, select the check box "Read cyclically" to update the tag values in cycles.

11.Close the dialog "Excel Workbook" after ending your calculations in Excel.

12.Save the results in the workbook and close Excel.

Result
The values of an online tag, a logging tag as well as a message window are displayed in the 
Excel table. 

Alarm Attributes

Introduction
While displaying messages in Excel Workbook  you can select the attributes to be displayed 
in the Excel sheet in the Excel Workbook Wizard .

Overview 

Position Attribute Type Comments
1 Alarm class name VarChar (255)  
2 Alarm type name VarChar (255)  
3 Foreground color Integer 4 Bytes  
4 Background color Integer 4 Bytes  
5 Flashing color Integer 4 Bytes  
6 to 15 Alarm Text 1 to 10 VarChar (255)  
16 to 25 Process value 1 to 10 Real 8 Bytes Numerical Process Value 1 to 10
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Position Attribute Type Comments
26 State VarChar (255) Status text
27 Info text VarChar (255)  
28 Alarm class ID Integer 4 Bytes  
29 Message type ID Integer 4 Bytes  
30 AS Number Small Integer 2 Bytes  
31 CPU Number Small Integer 2 Bytes  
32 Duration Integer 4 Bytes Time difference to "Incoming" status
33 Alarm counter Integer 4 Bytes Consecutive alarm counter
34 Acknowledgment Status VarChar (255) Text of the acknowledgement status
35 Priority Integer 4 Bytes  
36 Application  Application with which the comment was created.
37 Computer VarChar (255) Computer on which the comment was created.
38 Users VarChar (255) User who created the comment.
39 Comments VarChar (255)  

See also
Configuring the display of alarms (Page 7349)

VBA Functions of the Excel Workbook

Excel workbooks: VBA functions of the Excel workbook
The following functions are available to you in an Excel workbook if you have generated an 
instance of the Excel workbook object using the 
"Application.COMAddIns.Item("ExcelWorkbook.Connect").Object".

● ShowDialog(0): Opens the "Excel Workbook" dialog with a normal size.

● ShowDialog(1): Opens the "Excel Workbook" dialog with a minimized size.

● ShowDialog(2): Opens the "Excel Workbook" dialog hidden.

● CloseDialog: Closes the "Excel Workbook" dialog.

● GetServerID(server name): Gets the ID of the WinCC server with a specified name, for 
example: "http://Local_PC".

● Connect(ServerID): Connects the specified WinCC server to the Excel workbooks. You can 
get the "ServerID" using the "GetServerID(server name)" function. The "Excel Workbook" 
dialog must be opened before establishing a connection.

● ConnectAll: Connects all WinCC servers to Excel workbooks. The "Excel Workbook" dialog 
must be opened before establishing a connection.

● Disconnect(ServerID): Disconnects the Excel workbook from the specified WinCC server.

● DisconnectAll: Disconnects the Excel workbook from all WinCC servers.

● ReadTags(ServerID): Reads the tags from WinCC server with "ServerID". The connection 
must be established before tags can be read.
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● ReadArchives(ServerID): Reads the logs from WinCC server with "ServerID". The 
connection must be established before logs can be read.

● ReadAlarms(ServerID): Reads the alarms from WinCC server with "ServerID". The 
connection must be established before alarms can be read.

As soon as a connection is established or closed, the event "ServerConnected(ServerID)" or 
"ServerDisconnected(ServerID)" is output by the "ExcelWorkbook.Connect" object. These 
events can be integrated, for example, using "WithEvents" (VB standard).

10.16.2.8 Working with reports

Preparing an Excel Workbook as a Template

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
Proceed as follows to prepare Excel workbooks as a template:

1. Click "Reports" in the start page.

2. Click the "Upload templates" tag.

3. Select a directory, in which the template will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Click the "Browse" button in the "Selected template" field. Navigate to the required Excel 
workbook.

5. Click the "Upload" button.
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Result
The template is prepared for the function "Published Reports".

See also
Publishing an Excel workbook (Page 7351)

Configuring an Excel workbook (Page 7343)

Making an Excel workbook available as a report tool

Requirement
● The Excel workbook is created.

● The start page of the DataMonitor is open.

Procedure
Proceed as follows to prepare Excel workbooks as a report tool:

1. Click "Reports" in the start page.

2. Click the "Upload templates" tag.

3. Click the "Browse" button in the "Excel Workbook" field. Navigate to the required Excel 
workbook

4. Click the "Upload" button.

Result
The Excel workbook is ready in the "Report tools" section.
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Making Settings for Reports

Introduction      
Different settings are required for using the function "Reports" from DataMonitor. 

Requirements
● PDF Reader is installed.

● The WinCC project is selected on the DataMonitor server.

● The WinCC project is selected in "Scheduled print jobs in Runtime".

● The DataMonitor start page is open.

Visualize processes
10.16 Options

WinCC Professional V13.0
7358 System Manual, 02/2014



Procedure
To configure the reports settings, proceed as follows:

1. Click "Reports " in the start page. Click the "Settings" tab.
The "Settings" page is displayed.

2. Check the entries in the section "General project settings".
To enable output to a PDF file, select "Activate API print".

3. Enter the data for sending mail in the "Mail" area:

– Server
Outgoing mail server (SMTP)

– User name
Name for the sender

– Password

– Sender
Email account, through which you send your Email

4. Click the disk icon in the section "General project settings" to save your settings.
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5. In the "Circular buffer" area, you can define how many reports can be stored for the selected 
target directory. The field has a pre-assigned value of 20.

6. Click the disk icon in this section to save your settings.

Result
The settings for "Reports" have now been made. 

Displaying a report with an Excel Workbook

Requirements   
● PDF Reader is installed.

● The WinCC project is selected on the DataMonitor server.

● The WinCC project is selected in "Scheduled print jobs in runtime".

● The DataMonitor start page is open.
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Procedure
Proceed as follows to create a report with Excel workbooks:

1. Click "Reports" in the start page. Click the "Excel Workbooks" tab.
The "Excel Workbooks" page is displayed.

The icons in front of the lists "List of time-controlled Excel Workbooks" and "List of event-
controlled Excel Workbooks" are cleared and show that currently, no reports are triggered.

2. Select the desired Excel workbooks, e.g. "My_workbook_1.xls" in the "Existing Excel 
Workbooks" field.
This field only shows Excel Workbooks that meet the following conditions:

– Workbooks that are published as templates in the Excel Workbook Wizard

– Workbooks in directories for which the current user has the "Read" access right.

3. Select the directory, in which the reports will be stored in the "Target directory" field.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Enter an e-mail address in the field "E-mail recipient". The report is e-mailed to this address.
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5. To configure time-controlled triggering, define the following in the "Time-controlled Excel 
Workbooks" area.

– Date:
Enter the date in the field or define the date using the calendar. To open the calendar, 
click the "calendar" symbol.

– Time
Define the triggering time. 

– Repetition
Define the repetition rate, e.g. "Once" or "Weekly".

6. Click the "Add" button in the "Time-controlled Excel Workbooks" area. The report is 
displayed in the "List of time-controlled Excel workbooks".

7. To create the report immediately, click the symbol .

8. To configure event-controlled triggering, define the following in the "Event-controlled Excel 
Workbooks" area.

– Selected WinCC tag
Click . The object list opens. Select the desired tag from the object list.

– Define the event control
Define the triggering event, e.g. change of the tag value.
If you selected "Low limit", "High limit", or "Both limits" for event control, you need 
corresponding limit values.

9. Click the "Add" button in the "Event-controlled Excel Workbooks" area. The report is 
displayed in the "List of event-controlled Excel workbooks"

Result
A time-controlled or event-controlled report has been triggered with an Excel workbook. 

The report is displayed in one of the lists "List of time-controlled Excel workbooks" and "List 
of event-controlled Excel workbooks". The report can be changed or deleted in the list. 

 

 Note

An event-controlled print job will not be initiated if the time, in which the tag changes, is less 
than one minute.

Note that frequent initiation of the event-controlled print job OR simultaneous initiation of 
several print jobs over an extended period will lead to heavy load on memory space and 
resources, e.g. frequent signal changes of a tag.

 

Creating a report with a print job

Requirements 
● PDF Reader is installed.

● The WinCC project is selected on the DataMonitor Server.
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● The WinCC project is selected in "Scheduled print jobs in runtime".

● The DataMonitor start page is open.

Procedure
1. Click "Reports" in the start page. Click the "Print jobs" tab.

The "Print Jobs Configuration" page is displayed.

The icons in front of the lists "List of time-controlled print jobs" and "List of event-controlled 
print jobs" are cleared. The icons indicate that no reports are currently triggered.

2. Select the desired print job, such as "Report OnlineTableControl-CP" in the "Existing print 
jobs" field.
You can create the report immediately via the  icon.

3. In "Target directory: ", select the directory in which the reports are created.
Only the directories, for which the user that is logged in has "Create" access rights, can be 
selected. 

4. Enter an e-mail address in the field "E-mail recipient". The report is e-mailed to this address.

5. To configure time-controlled triggering, define the following in the "Time-controlled print 
jobs" area.

– Date:
Enter the date in the field or define the date using the calendar. To open the calendar, 
click the "calendar" symbol.

– Time
Define the triggering time. 

– Repetition
Define the repetition rate, e.g. "Once" or "Weekly".
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6. Click the "Add" button in the "Time-controlled print jobs" area. The report is displayed in 
the "List of time-controlled print jobs".

7. To configure event-controlled triggering, define the following in the "Event-controlled print 
jobs" area.

– Selected WinCC tag
Click the  icon. The object list opens. Select the desired tag from the object list.

– Define the event control
Define the triggering event, when the tag value is changed, for example

– Low limit and high limit
If you selected "Only low limit", "Only high limit" or "Both limits" for event control, limits 
are required. 

8. Click the "Add" button in the "Time-controlled print jobs" area. The report is displayed in 
the "List of event-controlled print jobs".

Result
A time-controlled or event-controlled report with print job in PDF format has been created. 

Depending on the type, the report is displayed in one the "List of time-controlled print jobs" or 
"List of event-controlled print jobs". The report can be changed or deleted in the list.

 

 Note

An event-controlled print job will not be initiated if the time, in which the tag changes, is less 
than one minute.

Please consider that a frequent triggering of the event-controlled print job over a long time 
period will use a lot of memory and resources, such as the frequent signal change of a tag.
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10.16.3 WinCC Redundancy

10.16.3.1 Basics

Overview

Introduction
WinCC Redundancy offers considerably increased availability of WinCC and the plant as a 
whole with parallel operation of two interconnected servers. 

WinCC

Client 

WinCC

Client 

WinCC

Client 

Standby

Server

Master

Server

HMI network

Data synchronization

after fault

Industrial network 

The servers monitor each other in runtime to allow for an early recognition of a failing partner 
server. 

If one server fails, the clients will automatically be switched from the failed server to the still 
active server. This ensures that all clients will always be available for monitoring and operating 
the process.

During the failure, the active server will continue to log all alarms and process data of the 
WinCC project. After the failed server comes back online, the contents of all alarm, process 
value and user logs will automatically be copied to the returned server. This will fill the log data 
gaps of the failed server. This action is also called synchronization after return.

The WinCC Redundancy Option offers:
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● The automatic synchronization of alarm, process value and user logs after a failed server 
comes back online.

● The automatic synchronization of alarm, process value and user logs after a process 
connection error.

● The online synchronization of internal alarms.

● The online synchronization of internal tags (tag synchronization).

● The online synchronization of user logs.

● The automatic switching of clients between the redundant servers if one of the servers fails.

● The automatic switching of clients if the process connection fails.

● The "Application Health Check" function to monitor the WinCC applications.

The "Application Health Check" function
In the WinCC / PCS7 environment the expression "Application Health Check" refers to the 
cyclic lifebeat monitoring of important applications. The function increases the sensitivity of 
the redundancy, since the lifebeat monitoring is extended via the servers themselves to the 
individual applications. All important WinCC applications are automatically monitored.  

The lifebeat monitoring detects a software error, sets the server status in the 
"@RedundantServerState" system tag to "Fault" and switches the linked clients to the 
redundant server.  

A process control message warns the user about the software error. 
 

 Note

If a software error was detected by the "Application Health Check" function and client 
switching was initiated, the relevant server must then be restarted. Only then can the clients 
be reconnected to the server. The redundant servers must be equipped with Windows 2003 
Server or newer and the client PCs with Windows 2000, Windows XP or Windows 7.

 

How Redundancy Works

WinCC Logging in Normal Operation
Normally, the master servers run completely in parallel with one another in Runtime. Each 
server computer has its own process driver connection and has its own data logs. The process 
data and alarms from the AS are sent to both servers simultaneously where they are processed 
accordingly. 

The servers monitor each other during runtime to allow early recognition of the failure of a 
partner, which is then indicated by an alarm to the instrumentation and control. 

User logs, internal alarms and internal tags can be continuously synchronized online (Online 
Synchronization).
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Both servers have equal rights and work independently of each other. Both are available to 
the user. Should one server fail, the partner server is always available for equivalent 
redundancy.

WinCC
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WinCC

Client 

WinCC

Client 

Standby

Server

Master

Server

HMI network

Industrial network

Logs Logs
Status

Monitoring

redundant

servers

The redundant servers communicate via the terminal bus to monitor the status and synchronize 
the logs. The network is a PC-LAN network with TCP/IP protocol. If there is an additional 
connection via a network adapter and/or a serial connection between the servers, this is used 
to monitor the status but not to synchronize the logs.  

Failure of a Server
Server failure refers to the physical failure of a server, for example, due to a power failure or 
by turning off the server without shutting it down properly.
If one of the servers fails, the server which is still operating receives and logs the process 
values and alarms from the AS. This guarantees data integrity with no gaps. 

The clients will automatically be switched from the failed server to the redundant partner server. 
All operator stations are thus available again after a short switchover time.
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Factors Triggering the Client Switch
The switch of the clients from the default (master) server to the partner server during a server 
failure is performed automatically by the system. The following factors cause a switch of 
servers:

● Network connection to server failed

● Server failure

● Process connection error

● The "Application Health Check" function has detected a defective WinCC application and 
triggers a switchover.  

● The project is deactivated.

Factors triggering log synchronization after the server returns
The synchronization of the logs between the servers is initiated after the following errors have 
been corrected:

● Process connection error. Process connection monitoring may be turned off. For further 
information see "Configuration".

● Network connection failure to the partner server

● Server failure

● Project is not activated

Synchronization after the server returns
After the failed server comes back online, the redundancy performs a log synchronization for 
the down time. The gap in the logs caused by the failure is closed by transferring the missing 
data to the filed server. This action equalizes and makes both servers available again.

The following logs are synchronized:

● Alarm log 

● Process value log 

● User log 

● Internal tags

The failed server receives its data after a slight time delay (caused by the failure). The log 
synchronization runs in the background, parallel to WinCC process management and logging. 
This guarantees the operator control and monitoring of the plant at all times.

Comparing internal tags
The internal tags must have the property "Tag synchronization".

Internal tags are compared on partner computers as soon as one of the tags is modified on 
one of the redundant servers.

The internal tags also include the system tags that start with the "@" character, e.g., 
@Current_User or @RM_Master. No online comparison should be configured for system tags.
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Synchronization after process connection error
If there is a network error during running operation between a server and one or multiple AS, 
synchronization is automatically started, if this was configured, after the error was handled.

Online Synchronization
A direct server-to-server synchronization (online synchronization) takes place during alarm 
logging for internal alarms, in user logs and with internal tags with tag synchronization.

Standard server and preferred server

Standard server
In distributed systems, WinCC Controls receive their data with server prefix from specific 
servers to display alarms and process data. 

You configure a standard server to clients in distributed systems so that data without unique 
server prefix are requested from this standard server. If no standard server is specified, an 
attempt is made to access the corresponding data locally. If there is no local data (e.g., alarms 
and archives), access is denied with an error message.

Preferred server
If you are using redundant servers in your multi-user system or distributed system, you can 
configure a preferred server for the clients.

A preferred server is the server of a redundant server pair with which the client in a multi-user 
system or distributed system primarily interconnects. The preferred server can be selected 
separately for each client so that the system can be permanently operated.

HMI system without redundancy

WinCC project
A WinCC project consists of a group of automation systems, a server computer and one or 
more client computers. The project also includes all programs, configuration data and 
miscellaneous settings.

The tasks of the control level are thus distributed over multiple PCs. The tasks are distributed 
following to a client server structure.
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The above figure shows the typical structure of the WinCC control level, with the corporate 
level above and the process level below. 

Tasks performed by the servers:

● Servers acquire process images and alarms from the automation systems.

● To acquire data, the servers are connected to the automation systems via industrial 
networks.

● The servers provide the process data to the clients and control the processing states.

Tasks performed by the clients:

● The client stations operate and monitor the entire plant.

● Clients retrieve the currently needed states from the corresponding server via PC networks.

● In general, all clients are equal and have the same rights.

HMI system with redundancy

WinCC project
A WinCC project consists of a group of automation systems, a server computer and one or 
more client computers. The project also includes all program data, configuration data and other 
settings. 
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Redundant WinCC Project
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The above figure shows the typical structure of a redundant WinCC control level, with the 
corporate level above and the process level below. 

A project with a redundant configuration is realized with two configured servers which run in 
parallel and are functionally identical. The two servers are connected to each other, the AS 
and the clients. Both servers are configured and displayed as a redundant system in the TIA 
Portal. The users must make sure that both servers are configured identically.

For further information see "Configuring an identical function".

Requirements
● Only PCs with the following server operating systems can be used for redundant WinCC 

servers with multi-user mode: 

– Microsoft Windows Server, Version 2003 or higher

● The servers are connected via the network. 

● The servers are time-synchronized. We recommend a time synchronization of the entire 
system (WinCC computer, automation systems, etc.). It can be performed with the "Time 
synchronization" option in WinCC.

● Alarms and acknowledgments from the AS and clients must always contain a time stamp 
in the frame to avoid double entries (chronological reporting). A way to achieve this is by 
using alarm blocks from the ASs.
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● Process values, alarms and active alarm blocks from the lower-level automation systems 
are sent to both servers in parallel.

● The redundancy option must be installed on both servers.

● The redundancy servers must be configured functionally identical.

● At least one of the following additional connections should exist between the redundant 
servers:

– Serial cable

– Additional network connection via a LAN card or via FireWire connection
This additional connection ensures exact definition of the "Master" or "Standby" status. 
You can also use both connection options parallel with each other.
Configure the additional LAN connection via FireWire or network card in the redundancy 
settings of the SIMATIC shell. Use the TCP/IP protocol with the corresponding IP 
address

 

 Note

To safely exit WinCC in the event of a power failure, the use of an uninterruptible power 
supply - UPS - is recommended.

 

Comparing blocked alarms
When a failed server is restored, currently blocked alarms are searched and compared with 
the general AS scan in Alarm Logging. 

If an alarm is blocked passively, i.e. only on one server, the blocking information is compared. 

If an alarm class is blocked on one server, the selection of the block is not compared on the 
redundant server.

Synchronizing user logs
Only data for the "new" user logs (starting with version 4.02) is synchronized. 

User logs that are configured in later versions but with the old structure are not compared. 
However, these user logs can be converted into the new structure. See your Recipe manual 
for additional information.

Setting up the servers

Structure of a redundant project

Requirements
For a redundant project, two servers must have an identical technical structure and 
configuration. Both servers can be connected to each other via an additional interface, for 
example, via additional Ethernet ports. 
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The setup of a redundant project under Windows Server 2003 is described using an example.

Example
Both servers must recognize each other in the network. 

To enter the user, proceed as follows:

● The dialog is opened via "Start / Settings / Control Panel" and the "Stored User Names and 
Passwords" icon. The users must be set up as at least Power Users in the "Users and 
Passwords" dialog box.

The dialog under Windows Server 2003 is shown here as an example.

 
 

 Note

The user must possess Administrator or Power User rights and be a member of the "SIMATIC 
HMI" user group.

The redundant servers must be equipped with Windows Server Version 2003 or higher, the 
client PCs with Windows 2000, Windows Server Version 2003 or higher, Windows XP 
Professional or Windows 7 Professional. 
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Also observe the information in the Installation Notes in section "Defining Access Rights in the 
Operating System".

Configuring an Identical Function

Tag logs and alarm logs
Archives must be configured with identical function for the redundant servers. Functionally 
identical means: 

● Identical logs, where additions can be made in the form of additional measurement points 
or logs.

The following logs are synchronized by WinCC:

● Archives held on hard disk, i.e. process value logs, compressed logs and alarm logs.

● On the other hand, no synchronization of main memory logs is performed.

Implementing configuration with identical functions
1. Create a project. 

2. Configure this project for redundant servers.

3. Load the project to the redundant server using the "Download to device" function.
During this process, the project is compiled and automatically transferred to the master 
server and the standby server.

This ensures that the project was saved with identical functions on both servers.

Redundant recipe data
User logs can be edited by operations, standalone programs, ASs or other functions. 

Requirements
The configuration of the logs must be identical on both servers. The projects are always 
identical when downloaded via the TIA Portal.

Editing user logs in parallel
Note the following when adding data records to redundant user logs in parallel:

● On the server that previously failed, data records can only be added after the server has 
been restored and the synchronization completed. Otherwise, an error message appears 
in the script or in the the User Archive Control.

● Even during the online synchronization, some time will pass before the data record has 
been synchronized in the redundant log.
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 Note

If both servers failed, the computer that was in operation last must be restarted first. 
Otherwise, changes that have not been saved could be lost.

 

Online Synchronized Messages
All internal alarm tags and alarms without tag connections are synchronized online. This also 
includes system operator alarms of alarm logging and alarms of Batch-Flexible.

10.16.3.2 Configuring the redundant system

Overview of configuration steps
This section describes the configuration of a redundant project using an example. The sample 
project consists of two identical servers and three clients. In the redundant project, one server 
is defined as master server and the other as standby server. During the configuration in the 
TIA Portal, both redundant servers are mapped as one server, symbolic for the redundant 
system.

Configuration steps
1. Creating a project (Page 7378)

– Configuring master servers (Page 7379) 

– Configuring clients (Page 7383)

– Controlling the plant

2. Configuring redundant servers (Page 7379)

– Configuring master servers (Page 7379)

– Configuring the standby server (Page 7380)

3. Configuring server reaction (Page 7381)

– Client switchover

– Synchronization selection

4. Configuring clients (Page 7383)

– Setting up clients

– Connecting clients with servers

– Configuring clients

5. Loading the project to a device (Page 7384)

6. Compiling a project (Page 7386)
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See also
Creating a project (Page 7378)

Creating a server (Page 7378)

Creating clients (Page 7379)

Creating a project
 

Configuration sequence
The TIA Portal is open. 

1. Click "Create new project".
A new project is created.

2. Change to project view.

You have created a project. You can now create devices in the project. 

See also
Overview of configuration steps (Page 7375)

Creating a server
You create only one server. You perform the division into a redundant system of master server 
and standby server in the section "Configuring redundant servers".

1. Double-click "Add new device" in the project navigation.
The "Add new device" dialog window opens.

2. Enter the required device name in the text box. 

3. Click the "PC systems" selection.

4. In the selection list, click "WinCC RT Professional" under "SIMATIC HMI application".

5. Confirm your selection by clicking "OK".
The server is created. The work area is opened with the device view and the new device 
is shown.
The new device is created with the selected name in the project navigation.

See also
Overview of configuration steps (Page 7375)
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Creating clients
Three clients are created to display the various options with the preferred servers:

1. Double-click "Add new device" in the project navigation.
The "Add new device" dialog window opens.

2. Enter the required device name in the text box. 

3. In the selection list, click "WinCC RT Client" under "SIMATIC HMI application".

4. Confirm your selection by clicking "OK".
The client is created. The work area is opened with the device view and the new device is 
shown.
The new device is created with the selected name in the project navigation.

5. Repeat these steps twice, until three clients have been created.

See also
Overview of configuration steps (Page 7375)

Control
Switch the work area to "Network view".  In the work area, you must have four devices displayed 
next to each other in the order in which they were created. 

The new devices are displayed one below the other in the project navigation.

Configuring redundant servers

Configuring master servers
1. In the network view, click the server that has been created.

The Inspector window is opened in the work area. 

2. In the Inspector window, click the "General" selection under the "General" tab.
The window displays the server name that you assigned.

3. Click the check box "Computer name identical to PC station name".
The name is applied as server name.

4. Double-click the name of your server in the project navigation.
The project navigation provides the following additional options:

– Device configuration

– Online & diagnostics

– HMI_RT_1 [WinCC RT Professional]

5. Double-click "HMI_RT_1 [WinCC RT Professional]".
Additional setting options are added to the project navigation.
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6. Double-click "Runtime settings".
The Runtime editor of the server opens in the work area. The "General" setting is opened 
by default.

7. Click "Redundancy" in the navigator of the Runtime editor.
The Runtime editor window opens. The name you specified was entered in the "General" 
box behind the "Server" entry. In this example, "Master" was entered. One of the servers 
has thus adopted the name "Master" or the name you assigned.

8. Activate redundancy by clicking in the "Configure redundant server" check box.

9. Define the server as "Standard master" by clicking the check box.

Information on configuring the standby server can be found in the next section.

See also
Overview of configuration steps (Page 7375)

Configuring the standby server
The name you specified was entered in the "General" box behind the "Server" entry. In this 
example, "Master" was entered. One of the servers has thus adopted the name "Master" or 
the name you assigned.

1. Enter a name for the redundant partner server in the text box. 
In this example, the second server received the name "Standby".

2. The configuration of the redundant server has now been completed.
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 Note
Only one device is displayed in the work area. This device includes the redundant server, 
comprising the master server and standby server.

 
 

See also
Overview of configuration steps (Page 7375)

Configuring server reaction

Client switchover
The reaction of the client to communication errors is selected in the "Client switchover" box.

1. By selecting the check box "Automatic client switchover in the case of a PLC error", you 
activate the automatic switchover of the client to the partner server when communication 
errors occur in the system.

2. Save the project.
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Synchronization
In the "Synchronization" field, you specify which actions are to take place during 
synchronization of the servers if an error occurs:

1. Click "Synchronize all data in failure time period:".
All data that was saved during the failure of a server is synchronized when the failed server 
returns.

2. Click "Synchronize data only for the following time period:" 
In the text box, enter the required time interval for periodic synchronization.
The data is synchronized periodically independently of server failures.

3. By clicking the four following check boxes, you select the data you want to synchronize 
after a failure.

4. The recipes used from your recipe log are entered in the "Recipes" list. By selecting the 
check box in the "Synchronized" column, you select the recipes that you you want to 
synchronize after a server failure.

5. Save the project.

See also
Overview of configuration steps (Page 7375)
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Configuring clients

Setting up clients
1. In the navigation tree, double-click "Devices & Networks" to switch the work area to network 

view.

2. Click the first client that was newly created.
The Inspector window is opened in the work area. 

3. In the Inspector window, click the "General" selection under the "General" tab.
The window indicates the client name that you assigned.

4. Click the check box "Computer name identical to PC station name".
The name you assigned is applied as client name.

5. Click the second client that was newly created. 

6. Repeat these steps until you have assigned your names to all clients.

7. Save the project.

Connecting clients with servers
The work area is in the network view.

1. Connect the redundant server to the Client_1 by clicking on the server connection. Drag 
the line with the mouse cursor to the Client_1 connection. Keep the left mouse button 
pressed in the process.

2. Release the left mouse button again at the client connection.
A HMI connection is generated from the server to Client_1 and displayed.

Figure 10-18 Connecting server and client

3. Repeat the procedure with Client_2 and Client_3.
You have now connected the server with the clients. 
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Configuring clients
1. Click Client_1 in the network view

2. Double-click the name of the client in the project navigation.
The project navigation provides the following additional options:

– Device configuration

– Online & diagnostics

– HMI_RT_2 [WinCC RT Professional]

3. Double-click "HMI_RT_2 [WinCC RT Client]".
Additional setting options are added to the project navigation.

4. Double-click "Runtime settings".
The Runtime editor of the server opens in the work area. The "General" setting is opened 
by default.

5. Click "Redundancy" in the navigator of the Runtime editor.
You can specify the preferred server of the client at this location.

– None: The current master is always used. After a change of master because of a failure, 
the client remains with the must recent current master, also after the return of the failed 
server.

– Master: The redundant server set as master is always preferred. After a failure of the 
master, the client switches back to the master server after its return.

– Standby: The redundant server set as standby is always preferred. After a failure of the 
standby, the client switches back to the standby server after its return.

6. Click the appropriate text box to specify the required option of the client.

7. Save the project.

The configuration of the redundant system has now been completed.

An additional activation of the redundant system is not necessary.

See also
Overview of configuration steps (Page 7375)

Loading the project to a device
As soon as the "Download to device" function is activated, the project is generally compiled 
before the actual loading process.

1. For this purpose, open the work area with the devices in the network view.

2. Right-click in the required device to open the shortcut menu.
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3. Four options are offered under the menu command "Download to device\":

– Hardware and software (only changes)

– Hardware configuration

– Software (only changes)

– Software (rebuild all)
If only the software was changed, the hardware correction options cannot be selected.

4. Click the required action to select it.
A dialog window opens. 

5. Set the type and the PG/PC interface.

6. Set the path of the destination folder. To do this, click the box at the end of the destination 
path.
A dialog window opens in which the destination path is set. The destination path is displayed 
after this:

7. Click the "Load" button.
The "Load preview" window and a progress window open. 
The project is compiled. The project is transferred to the device after the successful 
compilation.

An additional reloading of the changes is possible retrospectively, for example, after changes 
have been made in the hardware or software of the device. 

In the case of the first three options, only the changed part is recompiled. In the case of the 
fourth option, the entire project is recompiled.

See also
Overview of configuration steps (Page 7375)
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Compiling a project

Compiling data without "Download to device"
Alternatively, the changed data can be compiled using the "Compile" command, without 
downloading it immediately to the device.

1. Open the work area with the changed devices.

2. Right-click in the required device to open the shortcut menu.

3. Four options are offered under the menu command "Compile\":

– Hardware and software (only changes)

– Hardware (only changes)

– Software (only changes)

– Software (rebuild all)

4. Click the required action to select it.
In the bottom window, the result of the compilation is displayed in the "Info" tab.

 

See also
Overview of configuration steps (Page 7375)

10.16.3.3 Migrating a redundant project

Migrating a redundant project

Requirements for migration
You can only migrate projects that were created with the software WinCC as of Version 7.2 or 
Step 7 Plus as of Version 5.5. 

Migrating a project
To migrate a project, load it with "Migrate project":

1. Click "Migrate project" in the project view.
The work area is changed. You are prompted to enter a source path in the text box. 

2. Alternatively, click "..." at the end of the text box.
A dialog window opens. 

3. Navigate to your project.

4. Select your project. 

5. Click "Open". The source path and the name of your project are entered in the respective 
boxes. 
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6. You can use a check box to select whether the data should be copied from WinCC Runtime.

7. Enter the required destination path and, if necessary, another project name in the text boxes 
of the destination.
Alternatively: Click the box "..." at the end of the destination path. A navigation window 
opens in which the destination path can be entered. 

– Click the "Migrate" button. 

– The project is migrated. 

– The project data is then saved. 

– The portal view opens. 

– A window shows the progress of the migration.

– Finally, a windows indicates that the migration has been successfully completed.

8. Click "OK" to confirm the end of the migration.

The migration of the project was successfully completed. To check, double-click the "Devices 
& Networks" command in the project navigation. The project opens in the work area in the 
network view. 

10.16.3.4 System behavior in the event of a fault

Failure scenarios

Introduction
Some failures that might occur will be used to illustrate how WinCC Redundancy works. The 
following failures will be discussed: 

1. Project is on the redundant Server not in Runtime

2. Connection Fault to Partner Server

3. Faulty network connection to client

4. Faulty Process Connection

5. Software Error

6. Changing the client in case of a process coupling error (Page 7393)

WinCC Redundancy recognizes the current error itself or reacts to error or fault alarms with 
the following actions:

● Saving times and events

● Log synchronization

● Changing "Master"/"Standby" identifiers

● Switching clients

● Issuing alarms
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Startup of the Server PCs
When the server PCs are starting up, the redundancy component establishes whether the 
partner server is already active. If the partner server is active, a Standby identifier is set in the 
server PC. If the partner server is not active during startup, a master identifier is set in the 
server PC. Upon disruption of the network connection between servers or if the partner server 
has been turned off, the "Master" code is reset.

In order to identify that the server computer is set as "Master", the system tag @RM_MASTER 
is set. If the server computer is "Standby", the @RM_MASTER tag is reset. The 
@RM_MASTER_NAME tag contains the name of the server PC that has the "Master" status, 
for example, "SERVER1". The tag @RedundantServerState displays on each redundant 
server its redundancy status, for example, "Standby". These tags can be evaluated by other 
applications or by scripts. However, the only tag that can be changed is @RM_MASTER.   

Redundancy only sets the above tags. Both servers are always completely equal. 

If neither a client nor the redundant partner server can be reached for the master server (e.g. 
project not activated on the PCs, or the network connection between the PCs is interrupted), 
this then becomes the standby server. This behavior is necessary to ensure that both 
redundancy servers do not receive the "Master" state.

If there is an additional connection between the two partner servers, the redundancy status is 
controlled via this connection. This will prevent that redundant partner servers assume the 
identical status.

 

 Note

Please note that no log synchronization is performed via the serial interface. 
 

Server not in Runtime

Introduction
This scenario discusses the behavior of redundancy, if the project has been deactivated on 
Server 2.

The following actions will be triggered:

● Server 1 stores the failure time (date and time) of Server 2.

● Server 1 will report the failure of Server 2 through a system alarm.

● If Server 1 is the standby server, this takes over the role of the master by setting the 
@RM_MASTER tag. Correspondingly the @RM_MASTER_NAME and 
@RedundantServerState tags are changed.

● The clients connected to Server 2 switch over to Server 1.
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Server 2 Comes Back Online
The downtime means that there is a gap in the logs of Server 2. This gap is filled by the following 
measures:

● Server 1 stores the return time (date and time) of Server 2.

● Server 1 will report the return of Server 2 through a system alarm.

● A redundancy match is carried out for alarm data, process data and user logs from Server 
1 to Server 2.

● The @RM_MASTER tags remain unchanged in both servers, i.e., the @RM_MASTER tag 
in Server 1 remains set and the @RM_MASTER tag in Server 2 is reset. The 
@RM_MASTER_NAME and @RedundantServerState tags also remain unchanged.

● Clients which are configured with Server 2 as their preferred server switch back to that 
server.

Compared to online synchronization, log synchronization following a server failure can take 
noticeably longer depending on the number of data records to be synchronized and the 
computer/network loads.  

If failures alternate between the two servers (see diagram), they will be synchronized one after 
the other. After the synchronization, all data will be available in both logs. 

 

In the case above, Server 1 first passes all values to Server 2 for failure A, then Server 1 
synchronizes itself from Server 2 for downtime B. Synchronization always occurs on the 
"Standby" server based on the "Master" server.

All these processes run automatically and in the background, independently of the process 
value logging and alarm logging from the subordinate automation systems running in parallel.
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Connection Fault to Partner Server

Introduction
This scenario discusses the behavior of redundancy in case of connection failures to Server 
2. Prior to the occurrence of this event, both servers run in Runtime without failures. 

The described connection failure occurs if, for example, the terminal bus at Server 1 is pulled.

Initial Situation 1
Upon connection failure, Server 1 has the "Master" status and Server 2 the "Standby" status.

Connection failure occurs
The following reactions are triggered upon occurrence of the connection failure:

● Server 2 becomes the master server and saves the time of failure (date and time).

● Server 2 indicates by means of a system alarm that the partner server has failed and Server 
2 has switched to the "Master" status.

● Server 1 indicates by means of a system alarm that a failure has occurred in redundancy 
mode and that Server 1 has switched to "Standby" status.

● Tags @RM_MASTER, @RM_MASTER_NAME and @RedundantServerState are reset on 
both servers according to the switchover.

Connection is restored
During the connection fault, the alarms of Alarm Logging and the user logs could not be 
synchronized.

This situation is remedied by the following measures:

● Server 2, which is now the master, saves the time of the restoration (date and time).

● Server 2 indicates, by means of a system alarm, the return of the partner server.

● Redundancy synchronization from master server to standby server.

● Through the online synchronization of Alarm Logging, the system alarm concerning the 
return of the partner server is also displayed on Server 1.

● The @RM_MASTER, @RM_MASTER_NAME and @RedundantServerState tags remain 
unchanged in both servers.

Initial Situation 2
Upon connection failure, Server 1 has the "Standby" status and Server 2 the "Master" status.

Connection failure occurs
The following reactions are triggered upon occurrence of the connection failure:

● Server 2 becomes the master server and saves the time of failure (date and time).

● Server 2 displays, by means of a system alarm, the failure of the partner server.
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● Server 1 indicates, by means of a system alarm, that a failure occurred during redundancy 
mode and remains the standby server.

● The @RM_MASTER, @RM_MASTER_NAME and @RedundantServerState tags remain 
unchanged in both servers.

Connection is restored
During the connection fault, the alarms of Alarm Logging and the user logs could not be 
synchronized.

This situation is remedied by the following measures:

● Server 2 saves the time of return (date and time)

● Server 2 displays, by means of a system alarm, the return of the partner server

● Redundancy synchronization from master server to standby server

● Through the online synchronization of Alarm Logging, the system alarm concerning the 
return of the partner server is also displayed on Server 1

● The @RM_MASTER, @RM_MASTER_NAME and @RedundantServerState tags remain 
unchanged in both servers.

Faulty network connection to client

Introduction
In this third scenario, a disturbance occurs in the network connection between Server 2 and 
the client "CL5" that belongs to Server 2.

The following actions will be triggered:

● Client "CL5" automatically switches over from disturbed Server 2 to running Server 1. 

End of the Network Disturbance to the Client
The following reactions are triggered at the end of the network disturbance:

● The @RM_MASTER, @RM_MASTER_NAME and @RedundantServerState tags remain 
unchanged in both servers.

● If Server 2 is configured as the preferred server for client "CL5", then client "CL5" switches 
back to that server once more.

Faulty Process Connection

Introduction
In scenario 4, on Server 2 there is a fault on the process link due to an interrupted network 
connection to the automation systems. 
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An AS connection error is only recognized by Redundancy as a failure, if the connection is 
interrupted to only one server. If there is a connection fault from one AS to both servers (e.g. 
caused by an AS failure), this will not be recognized as a failure by Redundancy.

If WinCC recognizes a failure, the following actions will be triggered:

● The disturbance of the process link is reported on Server 2.

● Server 1 receives a message that partner Server 2 has failed.

● Server 1 stores the failure time (date and time) of Server 2.

● If in the server project "Client change with disturbance in the process link" is configured, 
the clients linked to this server are changed to the partner server.  

● In Server 1, the @RM_MASTER tag is set to Master, in Server 2 to "Standby". 
Correspondingly the @RM_MASTER_NAME and RedundantServerState tags are 
adapted. In sever 1, @RedundantServerState is set to "Fault".  

Correction of the Process Link Error on Server 2
Provided process connection monitoring has been activated, the gap in the archive of Server 
2 will be filled by the following measures:

● Server 1 stores the return time (date and time) of Server 2.

● A redundancy match is carried out from Server 1 to Server 2, since no faults were found 
for process connection at Server 1. The data of all ASs will be synchronized. This means 
that the data of ASs that have not failed will also be synchronized.

● On Server 2 the @RedundantServerState tag is changed from "Fault" to "Standby".

● The correction of the process link error on Server 2 is announced by a system message.

Software Error

Introduction
In scenario 5, an error occurs on Server 2 in software that is being monitored. When the error 
occurs, Server 2 is "Master" and Server 1 is on "Standby" status. There are several clients 
connected to each server. 

If the "Application Health Check“ function detects an error in the WinCC software, the following 
actions are initiated:

● Application Health Check reports the error to redundancy. The status of Server 2 is set in 
the @RedundantServerState tag to "Fault". The @RM_Master tag is set to "Standby".  

● The @RM_Master tag in Server 1 is set to the "Master". Correspondingly the 
@RM_MASTER_NAME and RedundantServerState tags are adapted.

● The clients connected to Server 2 switch over to Server 1. 

● A process control message warns the user about the software error.
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Correction of the Software Error on Server 2
The software error can be cleared by deactivating the server project and restarting server. 
When the project is activated on Server 2 the archives are automatically synchronized. 

● On Server 2 the @RedundantServerState tag is set to "Standby". Server 1 remains at 
"Master" status.

● Server 1 stores the return time (date and time) of Server 2.

● A redundancy match is carried out for the user archive from Server 1 to Server 2. 
 

 Note

When a software error is detected by the "Application Health Check" function resulting in a 
client switching process and process control message, the server affected must be 
deactivated and the computer restarted. Only then can the clients be reconnected to the 
server. An archive synchronization is only performed backdated to the moment a software 
error is detected by the server.

 

Changing the client in case of a process coupling error

Introduction
A redundant system consists of two functionally identical servers. One server is the "Master" 
server and the other is the redundant partner server. In the normal, undisturbed operating state 
the "Master" server has the status of "Master" and the redundant partner server has the status 
of "Standby". Clients are connected to the "Master" server unless a preferred server has been 
configured, in which case they are connected to the preferred server.

As soon as both servers are in Runtime, the processes coupling monitoring is activated. The 
number of defective logical connections to the "Master" server and the redundant partner 
server is cyclically determined. If the "Master" server has more defective logical connections 
than the redundant partner server, the status of the server becomes invalid ("Fault"). The 
clients are switched over to the redundant partner server, which now has the "Master" status.

 

 Note

The "Fault" status is not displayed in the "@RM_MASTER" system tag but in the 
"@RedundantServerState" tag.

 

Normal operating state
The plant consists of the redundant servers A and B. There are also three clients. Client 1 has 
entered server A as its preferred server, client 2 has entered no preference and client 3 has 
entered server B as its preferred server.
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 Note

The example below shows the logical connections, not the physical connections. In other 
words, the connection is shown as separated when the connection is terminated, because 
the data transfer is interrupted. The physical connection can remain intact at the same time.

 

WinCC

Client 1

WinCC

Client 3

WinCC

Client 2

Standby

Server

Master

Server
BA

Industrial network

HMI network

Preferred server

is server A

Preferred server

is server B

None 

Preferred server

Process connection error on server A
There is a process connection error on server A. The error is not present on server B. The 
number of defective logical connections on server A is greater than on server B. Server A 
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therefore receives the "Fault" status. As a result, clients 1 and 2 switch over to redundant server 
B.

WinCC

Client 1

WinCC

Client 3

WinCC

Client 2

Standby

Server

Master

Server
BA

Industrial network

HMI network

Preferred server

is server A

Preferred server

is server B

None 

Preferred server

Server A has 

a fault

End of the process connection error
When the process connection error on server A has been cleared, server A then has the status 
"Standby". As a result client 1 switches over to server A, since it has indicated this as its 
preferred server. Client 2 stays connected to server B because this has now become the 
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"Master" server since the Redundancy switchover and client 2 has indicated no preferred 
server.

WinCC

Client 1

WinCC

Client 3

WinCC

Client 2

Standby

Server

Master

Server
BA

Industrial network

HMI network

Preferred server

is server A

Preferred server

is server B

None 

Preferred server

Fault of 

server A

corrected

 
 

 Note

The OPC couplers are not monitored. Therefore, there will be no client switching in case of 
an error in the OPC couplers.

 

See also
Failure scenarios (Page 7385)
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10.16.4 WinCC Sm@rtServer

10.16.4.1 Basics

Sm@rt Options

Introduction
Using the Sm@rt Options from WinCC, you can communicate between HMI-systems or to an 
HMI-System by means of TCP/IP-connections (e.g.LAN).

Use of the Sm@rt Options
● Distributed operator stations with Sm@rtClients for controlling large machines or machines 

that are spread out over a large area.

● Operator stations with system-wide access to current process data via the communication 
driver "SIMATIC HTTP Protocol".

● Local servicing solution for the central archiving, analysis and additional processing of 
process data.

● Provision of current process data for higher-level systems (SCADA, production 
management systems, office applications).

● Remote control of an HMI-System by means of Internet, Intranet and LAN.

● Sending of E-Mails on the basis of messages and events

● Provisioning of Standard-HTML-Pages in HMI-system with service-and maintenance 
information as well as diagnostic functions.

User benefits: 

● Flexible solution for access to HMI systems and process data from any location

● Reduction of load on the field bus:
For example, the combination of WinCC Runtime and SIMATIC panels enables a factory 
control system to have access to process data. No load is placed by the factory level on 
the sensitive field level with respect to the necessary communication requirements. These 
requirements are handled by HMI Runtime along with the SIMATIC-panels.

● Expensive on-site service visits to be avoided by using the remote control. Unplanned non-
operation periods are reduced and the system productivity is increased.

 

  Note

On devices with version V11 or V12, the password "100" is preset for the Sm@rtServer 
and for the integrated Web server. This password should be changed for security reasons.

On devices with version V13, no passwords are preset.
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Application scenarios

E-Mailing and remote diagnostics
A factory has a service contract with an external service company. The HMI device and the 
service technician's PC are linked together over a TCP/IP-ready network. E-mail delivery of 
certain alarms to the service technician was configured in the project. The service technician 
accesses the HMI device via the Internet and executes remote diagnostics.

Application example:
Amongst other things,flow rates are measured in the process control of a cooling unit. 
Contamination in a feed line reduces the flow of coolant. When the flow rate drops below the 
configured threshold value, the operating device displays a warning. In addition,this warning 
is also dispatched as an e-mail to the assigned service technician. 

The service technician then establishes a connection with the remote device and takes the 
appropriate actions. 

Advantage: An alarm that reaches the service technician in a timely manner helps to minimize 
unplanned downtime.

Distributed operator stations
Distributed operator systems, the Sm@rtClients are used for controlling large machines or 
machines that are spread out over a large area.

The Client-HMI device connects to Sm@rtServer via the Sm@rtClient-Display. 
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The operator can operate and monitor the system from various locations. The operator sees 
the same image at each operator station, whereby only one station can be operated at one 
point of time.

The type of operation is also named as a coordinated operation. Then you must change the 
configuration only at Sm@rtServer.  

Access to the tags via SIMATIC HMI HTTP Protocol

Operator stations with system-wide access
For use of the SIMATIC HMI HTTP Protocol, you can provide tags of HMI-device (HTTP-
Server) to another device (HTTP-Client). 

Thus the local as well as centrally used HMI-systems have access to the tags of other stations. 
Cell-concepts or line-concepts can be simply implemented. De-centrally obtained information 
is available centrally.

This concept also permits the setting of cost-effective and small central servicing. There are 
additional options for archiving, analysis and additional processing of registered process data, 
if a PC is used for that.

Remote monitoring and remote control- servicing solution
If you connect the use of the SIMATIC HMI HTTP Protocol and the Sm@rtServer with each 
other, you can implement a complex servicing solution.  

For this,display the interested tags of the HMI-devices on the Service-PC. If necessary, use 
the PC for the remote monitoring and remote control of a specific HMI-device. 

The locally used HMI-devices are connected with each other and the total process is controlled 
comprehensively. 

The concept of the remote servicing is possible by using the Sm@rtClient-Display in the 
servicing HMI-Application. The operator has access to the respectively desired local HMI-
device through flexible configuration of the Sm@rtClient-Display.

Connection to the Office-world
The possibility of data exchange exists between HMI-device and office-applications, e.g. MS 
Excel, with help of VBA-Macro. 

For this, the HMI-device must support the Web-Service(SOAP). A script or macro is called in 
the external application, which has only read or write access to the concerned tags according 
to provided syntax. 

HMI devices suitable for use

HMI devices suitable for use
The following table shows the HMI-devices that are suitable for the use of Sm@rt Options.   
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The number of the connections based on "SIMATIC HMI HTTP Protocol" and the number of 
maximum connected Sm@rtClients depends on the HMI-device. For additional information 
see the "Performance features" documentation and in the technical manual of your HMI-device.

Technical data subject to change.

HMI device Sm@rt Options
270 series Yes
370 series Yes
OP 177B PN/DP
TP 177B PN/DP

Yes

Mobile Panel 177 PN
Mobile Panel 277

Yes

In view mode only:
● Mobile Panel 277 IWLAN
● Mobile Panel 277 IWLAN V2
● Mobile Panel 277F IWLAN (RFID Tag)

Yes

Comfort Panels Yes
WinCC Runtime Advanced Yes

Combining options on panels
The following table shows which options and functions on the panels can be combined with 
each other. 

Technical data subject to change.

 SIMATIC HMI 
HTTP Protocol 

Sm@rt Options HTML 
browser

WinAC/ MP

SIMATIC HMI HTTP 
Protocol 

-- Yes Yes Yes

Sm@rtServer Yes -- No No
HTML browser Yes No -- No
WinAC/ MP Yes No No --

Settings for Sm@rt Options 

Configuration in WinCC

Introduction
In the "Runtime-Settings" Editor, configure the requirements for using the Sm@rt Options.       

As an alternative, configure the settings in the Control Panel of the HMI-device. 

Note that the settings on the control unit have a higher priority than the settings in the WinCC-
project.
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Open
Double-click on the "Runtime-settings" entry in the project tree. In the "Runtime-settings" editor, 
click on the "Services". 
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"Remote control" Group.
Enter the settings for the selected HMI device in the work area: 

● "Remote control" Group.

– Start Sm@rtServer
Configures the HMI-device as Sm@rtServer. 

"Read/write tags" group for Panels
● Operate as OPC server

Configures the HMI device as an OPC server.

● SIMATIC HMI HTTP server
Configures the HMI device as HTTP server.

● Web service SOAP
Activates tag access via SOAP.

"Read/write tags" group for Comfort Panels
● Operate as OPC UA server

Configures the HMI device as an OPC UA server.

● SIMATIC HMI HTTP server
Configures the HMI device as HTTP server.

● Web service SOAP
Activates tag access via SOAP.

"Read/write tags" group for RT Advanced
● Operate as OPC server

– Operate as OPC DCOM server
Configures the HMI device as an OPC DCOM server.

– Operate as OPC UA server
Configures the HMI device as an OPC UA server.

● SIMATIC HMI HTTP server
Configures the HMI device as HTTP server.

● Web service SOAP
Activates tag access via SOAP.
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"Diagnostics" Group
● HTML pages

Activates service pages of the HMI device. 

"SMTP Communication" Group
Activates service pages of the HMI device. "SMTP Communication" Group

● Server name
Enter the name of SMTP server, through which you want to send E-mails.

● Name of the sender
Enter the sender name. The recipient sees in the E-Mail from which device the E-mail 
originates, e.g. "HMI device Production line 2". If the function is not supported by the SMTP-
Server, delete the entry. You can obtain more detailed information for this from your service 
provider.

● E-mail address
If you use an SMTP server that requires a valid e-mail address for authentication, enter it 
here, for example, "John.Doe@gmx.net. 

● User name
If you use an SMTP server that requires a user name for authentication, enter it here. You 
can obtain the user name from your service provider.

● Password
If you are using an SMTP server that requires a password for authentication, enter this 
password. You can obtain the user name from your service provider.

● The server requires a secure connection (SSL).
The data are sent via an SSL connection. Your service provider can tell you if your mail 
server supports an SSL connection. 

Configurations on the HMI device

Settings on the HMI device

Introduction
The Sm@rt Options settings in the HMI device are configured in the dialog box "WinCC 
Runtime Advanced Internet".  

Additional tabs may be included in the dialog "WinCC Runtime Advanced Internet". This 
depends on which options are activated for the network operation in the project. 

Note that the settings on the control unit have a higher priority than the settings in the WinCC-
project.

Tabs
You have opened the dialog "WinCC Runtime Advanced Internet" with the symbol "WinCC 
Runtime Advanced Internet" .
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The "WinCC Runtime Advanced Internet" dialog of the control panel can contain the following 
tabs: 

● WinCC Runtime Advanced Internet, "Email" tab (Page 7404)

● WinCC Runtime Advanced Internet, "Proxy" tab (Page 7405)

● WinCC Runtime Advanced Internet, "Web Server" tab (Page 7406)

● WinCC Runtime Advanced Internet, "Remote" tab (Page 7407)

Input area plan
At Sm@rtServer and Sm@rtClient, the same input area plan must be set.         

The Sm@rtServer uses the Standard-Input area plan of the operating system: 
(Start>Settings>Control Panel> Country settings>Tab "Entry"). These changes become 
effective after system restart.

At Sm@rtClient, the same input area plan must be set like at Sm@rtServer. No restart is 
necessary after the switchover of input area plan at Sm@rtClient. 

WinCC Runtime Advanced Internet, "Email" tab

Purpose of the dialog box
Specifies the settings for the E-Mailing.     

Settings
● SMTP server

– Enter the SMTP-server name.

– Use the default of project file
The SMTP-Server name from the WinCC-Project is used.

● Name

– Name of sender
Enter the sender name. The receipient sees in the E-Mail, from which device the E-mail 
originates, e.g. "HMI-device Production line 2".
If the function is not supported by the SMTP-Server, delete the entry. You can obtain 
more detailed information for this from your service provider.

– eMail Adress of sender
If you use an SMTP server that requires a valid e-mail address for authentication, enter 
it here, for example, "John.Doe@gmx.net. 

Dialog "Advanced Email Settings"
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● Authentication

– Use the default of project file
The user name and the password from the WinCc-Project are used.

– Disable authentication
Authentication is not required.

– Use panel settings for authentication
The settings of the HMI-device are used. Enter the user name under "Login" and the 
password under "Password". You can obtain the user name and the password from your 
service provider.

● Encryption

– Use the default of project file
The setting from the WinCC-Project is used.

– Enable SSL
The user information and e-mail are encrypted for transmission.

– Disable SSL
The user data and e-mail are sent un-encrypted. 

See also
Settings on the HMI device (Page 7401)

WinCC Runtime Advanced Internet, "Proxy" tab

Purpose of the dialog box
Settings for utilizing the Proxy-Server. 

 

 Note

Enter the Proxy-Server in "Internet Options" at PC.
 

Settings
● Use proxy server

Activate the "Use Proxy Server" if access is given in your network via Proxy-server. 

● Proxy
Enter the name or the address of the proxy-server. 

● Port
Enter the port of the proxy-server. 
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WinCC Runtime Advanced Internet, "Web Server" tab

Purpose of the dialog
The following is configured:         

● The utilization of the integrated web server and of the HTTP-Server

● User and user web authorizations 

Settings
Tag access

Governs the access to tags via the "SIMATIC HMI HTTP protocol": 

● "Read/write": Read/write access

● "Read only": read access only

Tag authenticate

Governs the authentification in case of access to variables via the SIMATIC HMI HTTP 
Protocol": 

● "No authentication": No authentification is required for access.

● "Authentication required": An authentification is required for access.
Specify the user name and password when configuring the communication driver "SIMATIC 
HMI HTTP Protocol". 

Enable Remote-Transfer for Projects

This setting enables remote transfer of project files. 

Start automatically after booting

(on panel only) 

The web server is automatically started after the HMI device boots. As a result, the web server 
is utilized independent of the runtime. 

 

 Note
Start web server automatically on PC 

Add a link with the program "Miniweb.exe" in the Autostart-Organizer in order to start the web 
server automatically after the PC starts. The program is located in the installation index of 
runtime. 

 

Close with Runtime

The web server is closed along with Runtime. 

User Administration

After entering the password, the "UserDatabase-Edit".  dialog opens. The "UserDatabase-Edit" 
dialog is the user administration of the web server. 

Start Webserver
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Starts the web server. 

Close Webserver

Ends the web server. 

WinCC Runtime Advanced Internet, "Remote" tab

Purpose of the dialog box
Settings for the Sm@rtServer     

Settings
Start automatically after booting

The Sm@rtServer is automatically started after the HMI device boots. Otherwise the 
Sm@rtServer starts together with the Runtime. 

Close with runtime

The Sm@rtServer is closed together with Runtime. 

Change settings

Opens the "Sm@rtServer: Current User Properties" dialog for specifying the passwords, 
authorizations, the screen update mechanism and the behavior when connections are 
disconnected.

 

 Note

This dialog is titled "Sm@rtServer: Default Local System Properties" on the panel. 
 

The dialog contains the following tabs:

● "Server" tab (Page 7408)

● "Polling" tab  (Page 7409)

● "Display" tab (Page 7410)

● "Query" tab (Page 7411)

● "Administration" tab (Page 7412)

Start Remoting

Starts the Sm@rt Server explicitly. 

Stop Remoting

Ends the Sm@rt Server explicitly. 
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"Sm@rtServer Dialog: Current User Properties" 

"Server" tab

Purpose of the dialog
Specifying passwords, web authorizations and the disconnection. 

Incoming connections
Settings for handling an attempt to establish a connection. 

● Accept socket connections
This setting enables the connection to the HMI device. It is a basic requirement for using 
the Sm@rtServers from the outside.
If this check box is deactivated, no remote monitoring and no remote control is possible.

● Encrypt communication
Allows an encrypted connection between Sm@rtClient and Sm@rtServer.

● Password 1
First password for remote access. "View only" is disabled as default.

● Password 2
Second password for remote access. "View only" is selected by default.
This password can be provided as a reserve password for third-party users (such as service 
technicians); it can be modified when necessary without significant effort within the 
organization.

● View only
If this check box is enabled, read access (monitoring mode) is the only access available 
when the corresponding password is entered.
Default: Enabled

 

  Note

For devices with HMI device version prior to V13, both passwords are preset as "100". 
Change this password during commissioning according to your requirements.

 

Enable network packets queuing (slower)
This setting enables splitting of data into multiple data packets, which are sent separately over 
the network. It is useful when multiple clients are connected.
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Display or port numbers to use
Here, you select the TCP/IP port in the network where the Sm@rtServer waits for attempts to 
establish a connection.

● "Auto": The Sm@rtServer automatically searches for the appropriate port by itself.

● "Display": The server uses port 5900 plus display number. For HTTP, the server utilizes 
Port 5800 plus display number.

● "Ports": You enter the port numbers for the "main" and "HTTP" yourself.

No local input during client session
The keyboard and mouse on the server-HMI device are disabled as long as connections are 
active.

For example, this setting is useful when an HMI device is being administered from outside.

Remove desktop wallpaper (on PC only)
This setting removes the screen background on the PC, thus saving transmission effort.

Default: Enabled

When last client disconnects (on PC only)
This setting governs the behavior after disconnection of the last client connection:

● "Do nothing": no response.

● "Lock workstation": Server PC is locked.

● "Logoff workstation": Server PC is logged off.

The latter two settings are only useful if the Sm@rtServer is running as a service. 

"Polling" tab 

Purpose of the dialog
Specifying the screen update and the use of virtual graphics driver. 

Polling modes(on PC only)
The settings govern the screen update.

Most changes are recognized automatically by the server. In case of problems, you can enter 
additional settings here.

The update method cannot be set on the panel. The settings is always "Poll Full Screen".
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● Poll foreground window (On PC only)
Updates the current window. 
It increases the load on the server.

● Poll window under cursor (On PC only)
Updates the window that is located under the mouse cursor. The window is updated when 
a change occurs in the operator control element under the mouse cursor.
Default: Enabled

● Poll full screen (On PC only)
This setting specifies an update each time the screen changes. This setting provides you 
the lowest display error but places a maximum load on the server.

● Polling cycle
Determine the suitable setting for your configuration. Make sure that the selected update 
cycle is not too short, since it affects the computer load.

Window polling
● Poll console windows Only (On PC only)

This setting specifies an additional update when changes occur in a console window (MS 
input requirement).

● Poll on event received only (Only on the PC)
This setting specifies an additional update each time an entry is made.
Default: Enabled

● Mirror driver status
(Only on the PC with a mirror driver installed)
Provides information about the status of the virtual graphics driver.

Mirror driver options (only on a PC with installed mirror driver)
Enable direct access to display driver's mirror screen

The shared-memory area of the virtual graphics driver is used for the display. The setting 
improves the performance.

Troubleshooting (on PC only)
● Don't use VNCHooks.DLL while polling full screen

VNCHooks.dll is used by default for the screen update. If VNCHooks.dll causes problems 
when using other program, select this setting.

● Don't use mirror display driver even if available
(Only on the PC with a mirror driver installed)
Use this setting only for troubleshooting. 

"Display" tab

Purpose of the dialog
Setting of the screen display.
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Sharing area(on PC only)
● Full desktop

The entire desktop of the server is accessed.

● Primary display
The main screen of the multi-monitor configuration is displayed.

Downscale to(on PC only) 
Scales the screen to be transferred according your inputs. Servers with Windows CE ignore 
this setting.

"Query" tab

Purpose of the dialog
Settings for incoming connection attempts.

 

 Note

This dialog is titled "Default Local System Advanced" on the panel. 
 

Query settings
These settings govern acceptance of incoming attempts to establish a connection. 

● Query console on incoming connections
The Sm@rtServer registers the incoming attempts to establish a connection and displays 
a dialog on the screen in which the connection attempt is accepted or rejected.

● Query timeout
Set the waiting time.

● Default action
Select the response to an attempt to establish a connection once the waiting time expires: 

– "Refuse": Reject attempt (operator control mode - single mode)

– "Accept": Accept attempt (operator control mode – shared mode)

Allow option to accept without authentication
The dialog for handling attempts to establish connections also contains the button "Accept 
without password" . This gives you the option to accept an attempt to establish connection 
without a password. 
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"Administration" tab

Purpose of the dialog
Specifications for session management.

 

 Note

This dialog is titled "Default Local System Advanced" on the panel.
 

Administration
● Disable empty passwords

Select this check box in order to allow an empty "Password 1". 
Default: Enabled

● Allow loopback connections
This setting allows connections to your own HMI device. It is useful and necessary when 
security software is used for secure (encoded) connections. 

● Allow only loopback
This setting allows only connections to your own HMI device.

Logging
● Log info to SmartServer.log

(On the panel: Log information to file)
This setting writes information to the server logbook. 

● Log detailed debugging information
This setting writes expanded information to the server logbook (for locating errors). 

With HMI devices operating with Windows CE, the log is only created when the MMC card is 
inserted. If the MMC card is inserted, the log is created directly on the card.

The log files are created in the following path on a PC: C:\Documents and Settings\All Users
\Application Data\Siemens\HmiRTm
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Forced write access
This setting governs forced access in an emergency contrary to normal session management. 

● Password needed
If this check box is not selected, every operator can force access in emergencies as follows:

– Pressing the <Shift> key four times

– Clicking four times

– Touching the screen four times

If this check box is enabled, to force access an attempt must be made to gain access and 
a password must also be entered. 
In this case, enter the applicable password in the input field underneath. If a password is 
not entered, it is not possible to force access in an emergency. 
Default: Enabled

 

  Note

On the server, access can only be forced by pressing the <Shift> key four times, clicking 
four times, or touching the screen four times. 

 

HTTP-Server
● Enable built-in HTTP server

If this check box is activated, the Java-Applet is automatically downloaded on the PC when 
the connection is first established.
The Java applet accesses the Java VM that is installed on the client and enables remote 
monitoring and remote control using Internet Explorer. 
Default: Enabled

● Enable applet params in URLs
Forwards all parameters of the URL to the Sm@rtClient application.

Connection priority
These settings govern handling of attempts to establish a connection by non-shared clients. 

● Disconnect existing connections
When an attempt is made to establish a connection by a non-shared client, the attempt is 
accepted; the existing connections are disconnected (single mode). 

● Automatic shared sesssions
When an attempt is made to establish a connection by a non-shared client, the attempt is 
accepted; the prior existing connections are retained. Access is controlled using session 
management in shared mode. 
Default: Enabled
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● Active user timeout 
For shared mode, enter the time that must elapse without any actions on the active HMI 
device before access can be changed. 
Default setting: 10 seconds

● Refuse concurrent connections
If a non-shared client is already connected to the server, attempts to establish a connection 
by other non-shared clients are rejected. 

See also
Remote control by means of Internet Explorer (Page 7429)

User administration for web server 

Introduction
Different web authorizations for the operation and monitoring are allocated to the users in the 
user administration.     

Requirement
● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Web Server" tab is displayed.

Entries and settings
Click "User Administration" in the "Web Server" tab and enter the password. 

 

 Note

By default, the password is set to "100" and all web authorizations are granted to users with 
"Administrator" rights. Change this password during commissioning according to your 
requirements.

 

The "UserDatabase-Edit" dialog is opened. 

The "UserDatabase-Edit" dialog has three tabs: 
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● Tab "User Manager"
User administration for creation or deletion of users. 
Create a new user using "New"; Delete a user using "Remove". The recreation and deletion 
become effective using "Apply". 

● Tab "Description"
You can store a description of or comments on the users selected on the "User Manager" 
tab. 

● Tab "Authorizations"
Specify the web authorizations for the users selected on the "User Manager" tab. You use 
"Add" to activate a web authorization and "Remove" to deactivate one. 
By default, the password is initially preset to "100" and all web authorizations are granted 
to users with "Administrator" rights. 
For read and write access to the file browser, the user must possess the web authorizations 
"FileBrowserAdministrator" and "FileBrowserUser".
 

 

  Note

In principle, every user who has access to the control panel can manage users and web 
authorizations. If necessary, protect the control panel from unwanted access.

 

List of web authorizations 
The following  web authorizations exist:     

Web authorization Authorized for: 
UserData Import and export of recipes 
UserAdministrator Import and export of password lists 
RuntimeAccess Starting and stopping of runtime
Engineering HTTP transfer from ES to the target device
FileBrowserUser Read access to the file browser
FileBrowserAdministrator Read/write access to the file browser 
RTCommunication Utilization of the SIMATIC HMI HTTP server
SoapUser Read/write access via web service (SOAP) 
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Settings for remote control

Session management for remote control 

Introduction
WinCC enables remote monitoring and remote control of HMI devices over a TCP/IP-ready 
network such as a LAN or the Internet. Remote monitoring and remote control is implemented 
in different ways:     

● Remote control by means of Internet Explorer

● Remote control by means of the Sm@rtClient-application

● Remote control by means of the Sm@rtClient-display in

Only one device can ever have access to the HMI-device. Which device is permitted access 
is determined by the session management. 

Session management options
Session management is used to control access. The client-server connection can be in one 
of two modes: 

● Monitoring mode

● Control mode

Monitoring mode
If the client accesses the server in monitoring mode, the operator can see the current screen 
of the HMI device and track all changes. He can monitor the server but cannot operate.     

In the monitoring mode, all the keys on the client retain their standard functions. 

If remote control was started from the Sm@rtClient display, the operator uses the <Tab> key 
or the cursor keys to go to the next object in the current screen of the client project. 

Control mode
If the client accesses the server in operator control mode, the operator can use the mouse and 
the keyboard to control the server from the client. If an access attempt is made from another 
client, the assignment of operating permission depends on the settings at the server and at 
the clients. 

In operator control mode, the client keys act on the server screen. Thus, the operator uses the 
<Tab> key to go to the next object in the current screen of the project running on the server. 

If remote control was started from the Sm@rtClient display, the operator can only go to another 
object or screen in the project on the client by using an additionally configured function or an 
additional menu command. The operator to this menu command as follows:
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● On the Touch-device, in which he touches the screen longer than 1 sec.

● On the keyboard =device, in which he masks on the menu with <Shift+Control> and  
operates  it with <Alt> and the keyboard.

In both operating modes, the Sm@rtServer is set so that the operator at the remotely controlled 
device, the server, can be prevented from performing any activities. 

In an emergency, the operator can exact the user rights on a remotely controlled HMI device 
as well as on an inactive HMI device. If no password is specified, he must click the user 
interface four times consecutively, touch the screen four times consecutively, or press the 
<Shift> key four times consecutively. If a password is specified, he must click once or press a 
key on the client and then enter the specified password. 

Settings for session management
You make settings for session management on the server and on the client in the Control 
Panel "WinCC Internet Settings". 

Configuring Sm@rtServer for remote control

Introduction
The Sm@rtServer has an internal security concept based on passwords and special settings 
for session management.         

Security concept for the Sm@rtServer
Remote monitoring and remote control of the Sm@rtServer from the Sm@rtClient is protected 
by two functions:

● Encrypt encryption of communication to the server 

● Passwords

Encrypt communication to the Sm@rtServer
The "Encrypt communication" function provides a secure connection between Sm@rtClient 
and Sm@rtServer.

After you have activated the "Encrypt communication" function, the Sm@rtServer sends a 
Sm@rtServer-specific certificate to the Sm@rtClient.

The Sm@rtClient must support the "Encrypt communication" function for encrypted 
communication.

The certificate sent by the Sm@rtServer must be accepted to establish communication on the 
Sm@rtClient. 

All connections between Sm@rtClient and Sm@rtServer are then only possible on the basis 
of the exchanged certificate.
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Passwords for the Sm@rtServer
Remote monitoring and remote control of the Sm@rtServer at the Sm@rtClient is protected 
by two passwords. 

The second password is used as a further password for additional access, for example, as a 
service password. 

 

 Note
Passwords for the Sm@rtServer

No default passwords are set. 

Therefore, assign the passwords before you use the Sm@rtServer.
 

 

Settings on the Sm@rtServer
The settings on the server govern which remote operators can access the runtime of the server.

The passwords for access are set on the server. Open "WinCC Runtime Advanced Internet" 
in the control panel. On the "Remote" tab, click "Change Settings". On the following Server 
tab of the subsequent dialog, enter the passwords of the Sm@rtClient. For both passwords, 
you can use "View only" to set the monitoring mode and to exclude operator control mode.

On the panel, this dialog is called "Sm@rtServer: Default Local System Properties" and 
contains fewer dialog elements than the dialog on the PC.

Control mode
To enable control mode, the "View only" check box must be cleared, at least for "Password 1" 
(Password 1).
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The manner in which the individual remote control station can access the server is set on the 
"Administration" tab.

● "Disconnect existing connections"
When an access attempt is made by an non-shared client, the previous connection is 
automatically disconnected and control is transferred to the new client.
When an attempt is made to access by a shared client, the behavior is the same as 
described for "Automatic shared sessions".

● "Automatic shared sessions"
When an access attempt is made, control is transferred to the new client.
The condition for transferring control is that no action has been undertaken by the previously 
active client for a period of time (in seconds) as specified in the "Active user timeout" setting.

● "Refuse concurrent connections"
When an attempt is made to access by a non-shared client, this access attempt is rejected 
so long as the operator station that currently has access is still connected to the server.
When an attempt is made to access by a shared client, the behavior is the same as 
described for "Automatic shared sessions".

Disabling local operator control of the server
To do so, open the "WinCC Internet Settings" in the Control Panel. On the "Remote" tab, click 
"Change Settings". On the "Server" tab in the subsequent dialog, select "No local input during 
client session".   

Password for forced access
A password can be specified in "Forced Write Access" for forced access in an emergency.   
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Sm@rtServer as a service
You can let the Sm@rtServer run as a service. The operator can then also access the service-
HMI device from the client-HMI device, for example, the screen saver is active with a password.

Select the check box "Start automatically after booting" in "WinCC Runtime Advanced Internet" 
on the "Remote" tab.   

Sm@rtServer as service in Windows 7
The Sm@rtServer always runs as a service under Windows 7. You cannot stop the 
Sm@rtServer in Runtime with the Notification Area in the taskbar. You have the following 
options for stopping the Sm@rtServer:

● Stop using the "ControlSmartServer" system function
Configure the "ControlSmartServer" system function to a button, for example. Select the 
"Stop" mode at the system function. You can stop the Sm@rtServer in Runtime by clicking 
the button.

● Stopping the Sm@rtServer in the Control Panel:
Open "WinCC Runtime Advanced Internet" in the Control Panel and select the "Remote" 
tab. Click on the "Stop" button. Sm@rtServer is stopped.

● Stopping Sm@rtServer by stopping Runtime:
Open "WinCC Runtime Advanced Internet" in the Control Panel and select the "Remote" 
tab. Activate the "Close with Runtime" option. The Sm@rtServer is stopped at the stop of 
Runtime. 
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Configure Sm@rtClient for remote control

Settings on the client PC
● Monitoring mode      

At the client-PC you limit the connection to observation mode, if required. This allows you 
to prevent unintended control operations.

– If connection is via the Sm@rtClient application
In the following "Sm@rtClient Connection" of Sm@rtClient-application, click "Options..." 
button.
In the "Sm@rtclient Options" dialog, select the setting"View only (inputs ignored)".

– If connection is via Internet Explorer
Click on the button "Options..." and select "View only" in the subsequent dialog.

● Layout
You can also specify whether or not the HMI-device is to be displayed with the same layout 
in the Sm@rtClient application. This is useful if you access from a PC on a touch device. 
In order to suppress the layout, select the "Sm@rtclient Options" setting in the "Suppress 
Device Layout" dialog. 
In addition, you can use "Scale by" to zoom in or out of the layout. To use "Scale by", the 
Suppress Device Layout setting must be selected or the HMI-device must not supply any 
layout. Otherwise, the desktop is always displayed with a zoom setting of 100%.

 

  Note

If you scale the display, the performance may be impaired in some situations: 
● Strong scaling, for example from 1600 x 1200 px to 640 x 480 px.
● Scaling with non-matching scaling factors, for example from a 4:3 resolution to 16:10 

resolution.
 

Configuring of the Sm@rtClient-display
You can configure the Sm@rtClient display in different ways, and thereby set certain inputs: 
The server name, the password for accessing Sm@rtServer or the restriction to the monitoring 
mode.
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Encrypted communication
You must enable the "Encrypt communication" function for encrypted communication with the 
Sm@rtServer.

● Support for the "Encrypt communication" function on the Sm@rtClient
If the Sm@rtClient does not support the "Encrypt communication" function, no 
communication is possible with a Sm@rtServer which has enabled the "Encrypt 
communication" function.
Enable the "Encrypt communication" function on the Sm@rtServer. 

● Enabling the "Encrypt communication" function on the Sm@rtServer by the Sm@rtClient
You can also enable the "Encrypt communication" function on the Sm@rtServer from the 
Sm@rtClient:

– Establish a connection to the server.

– Enable the  "Encrypt communication" function in the "Standard VNC Authentication" 
dialog.

– Certificates are exchanged between the Sm@rtServer and Sm@rtClient.

– The certificate sent by the Sm@rtServer must be accepted by the Sm@rtClient.

Sm@rtClient-Application

Dialog "New Sm@rtServer: Connection"

Introduction
This dialog opens when you click the "Sm@rtClient" button in the taskbar. 

Purpose of the dialog box
This dialog is used for selecting the server and the connection method. 

Sm@rtServer:

Enter the address of the server to which the connection is to be established. The various 
options for entering the address can be found in "Remote control by means of the Sm@rtClient 
application  (Page 7430)".

Connection profil

Select the type of connection to the server according to the network you are using. 

Listening mode

If you enable this function, the Sm@rtClient application is minimized and appears as a button 
in the Windows taskbar. The Sm@rtClient waits for the Sm@rtServer to establish a connection. 
To establish the connection, click the "Sm@rtServer" button in the Windows taskbar of the 
server. Select "Add new client" in the context menu.

Options

The "Sm@rtClient Options" dialog containing the technical settings for the Sm@rtClient-
application is displayed. 
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See also
"Options" dialog, "Globals" tab (Page 7425)

"Options" dialog, "Connections" tab (Page 7423)

"Options" dialog, "Connections" tab

Purpose of the dialog box
Technical settings for the Sm@rtClient-application are specified in this dialog box.

Only change the settings here in special cases.
 

 Note

You can also specify these settings in the Java Applet. Note that some of the dialog elements 
are named differently there.

 

Format and encodings

Settings for compressing (encoding) the screen data of the server. 

● Use encoding
Preassigned based on the selection under "Connection profile".
Select the desired compression or "Raw" (no compression).

● User 8-bit color
(Only in the Java-Applet): Reduces the color depth at the client to 8 bits (256 colors). The 
data are then transferred faster. However, incorrect colors may result.

● Custom Compression level
Allows individual customizing of the compression level in the "Level" input field:
1 = least compression (faster); 9 = maximum compression (slower).

● Allow JPEG compression
Allows the use of JPEG compression (involves losses).
Enter the "Screen quality" in the input field underneath: 
1 = least compression (faster); 9 = maximum compression (slower).

● Allow CopyRect encoding
(In the Java-Applet: Use CopyRect. Encoding)
Allows compression while using "similar rectangles".

Restrictions

● Viewonly (inputs ingnored)
Sets the view mode for this client irrespective of the settings on the server.

● Disable clipboard transfer
Disables the clipboard that is used to transfer data from one PC to another. Applies only 
to the copying and pasting of texts.
This functionality is not available at a Windows CE server.

Display

Settings for the screen display
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● Scale by
Zooms in or zooms out the desktop to be displayed. To use "Scale by", the Suppress Device 
Layout setting must be selected or the HMI-device must not supply any layout. Otherwise, 
the desktop is displayed with a zoom setting of 100%. 

● Fullscreen Mode
Displays the desktop to be shown in full-screen mode. If the server screen is larger than 
the screen of the client, it is scrolled automatically by the mouse movement.

● Suppress Device Layout
In the Sm@rtClient application window, the entire layout of remote HMI-device is not shown. 

● Use CTRL + Cursor Key for Scrolling
The key combinations <CTRL> + cursor key are used to scroll within the local screen. They 
are no longer transferred to the server.

Mouse

(In the Java-Applet: Mouse buttons 2 and 3)

Settings for the evaluation of mouse actions

● Emulate 3 Buttons (with 2-button click)
Emulation of a three-button mouse by a two-button mouse.

● Swap mouse buttons 2 and 3
(In the Java-Applet: reversed/normal)
Mouse buttons 2 and 3 are swapped.

Mouse cursor

(In the Java-Applet: Cursor shape updates)

Settings for the display of the cursor

Select the type of transfer of the mouse actions:

● Track remote cursor locally
The information on the location of the cursor is transferred separately from the screen 
information. This speeds up the transfer of the cursor. (JavaApplet: Enabled)

● Let remote server deal with mouse cursor
Tracks the server cursor to the client cursor. This allows more accurate cursor positioning. 
(YES: Ignore)

● Don't show remote cursor
The cursor at the server is not included in the transfer. (YES: Disable)

Request shared session

(In the Java-Applet: Share desktop)

Declares this client to be a non-exclusive client. 

See also
Dialog "New Sm@rtServer: Connection" (Page 7420)
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"Options" dialog, "Globals" tab

Purpose of the dialog box
Technical settings for the Sm@rtClient-application are carried out in this dialog box. 

Only change the settings here in special cases.
 

 Note

You can also carry out these settings in the Java Applet. Note that some of the dialog elements 
are named differently there.

 

Interface options

● Show toolbars by default
Displays the toolbar. 

● Warn at switching to the full-screen mode
Outputs a message before the full-screen mode is activated.

● Enable Onscreen keyboard
Enables the display of the on-screen keyboard

● Number of connection to remember
The client creates a list of the recently used connections. This setting specifies the number 
of connections listed.

● Clear the list of saved connections
The list is cleared.

Local cursor shape

Specifies the appearance of the local cursor. This allows you to better differentiate between 
the local cursor and remote cursor.

Listening mode

● Accept reverse VNC connections on TCP port
Specifies the TCP port number. The Sm@rtClient waits for the Sm@rtServer to establish 
the connection over this TCP port number.

Logging

● Write log to a file
Writes information in the logbook of the Sm@rtClient-application.

● Verbosity level
Writes expanded information to the server logbook of the Sm@rtClient-application (for 
locating faults). The amount of detail in the information is dependent on the verbosity level 
setting. 
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Remote control of key devices

Mapping of the function keys 
HMI devices are equipped with a variety of function keys. 

Example:

From the PC keyboard, you want to remotely control key F20 on the "MP 377 key" of HMI-
device. 

You can control the F20 key with the PC-keyboard shortcut <SHIFT + F8>.

The table provides you with an overview for controlling the keys.

xP177/277 xP377 PC keyboard shortcut 
F13 F13 SHIFT + F1
F14 F14 SHIFT + F2
F15 F15 SHIFT + F3
F16 F16 SHIFT + F4
F17 F17 SHIFT + F5
F18 F18 SHIFT + F6
F19 F19 SHIFT + F7
F20 F20 SHIFT + F8
K1 S1 SHIFT + F9
K2 S2 SHIFT + F10
K3 S3 SHIFT + F11
K4 S4 SHIFT + F12
K5 S5 CTRL + F1
K6 S6 CTRL + F2
K7 S7 CTRL + F3
K8 S8 CTRL + F4
K9 S9 CTRL + F5
K10 S10 CTRL + F6
K11 S11 CTRL + F7
K12 S12 CTRL + F8
K13 S13 CTRL + F9
K14 S14 CTRL + F10
K15 S15 CTRL + F11
K16 S16 CTRL + F12
HELP HELP ALT + H
ACK ACK ALT + F1
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Use and restrictions of Sm@rt Options

Use restrictions
While using the Sm@rt Options, observe the following instructions: 

● HMI devices suitable for use
For additional information, refer to "Usable HMI devices".

● Sm@rtServer and Sm@rtClient

– If a PC is used as a Sm@rtServer, select the highest-performance platform available.

– Use only simple projects.

– Avoid photographs and color gradients in screens.

– Avoid heavy background loads during operation, for example, those from user-defined 
functions or logs.

– The number of the maximum connected Sm@rt Clients depends on the Server-HMI 
device. For additional information, see the "Performance features" documentation.

– To improve the performance of the Sm@rtServer, you can disable hardware 
acceleration of the graphics card .  

– You inevitably loose performance at the HMI when you access the HMI-device using 
the Sm@rtClient functionality.

● SIMATIC HMI HTTP Protocol

– Tag exchange via the SIMATIC HMI HTTP Protocol is not suitable for exchanging bulk 
data.

– The maximum number of connections depends on the HMI device: For additional 
information, see the "Performance features" documentation

● Access protection
To protect access to an HMI-device using different passwords, you must use the first 
password for the protected, and the second password for the unprotected access e.g. 
remote control with a password, remote monitoring without password.   

● Port
The web server connects to the network at the port 80. To run it without problems, make 
sure port 80 is not in use by any other application, such as IIS World Wide Web Publishing 
Service.

● Integrated HTML-pages

– The size of the HTML pages must not exceed 100 Kb in case of Windows CE. In case 
of exceeding of the given value, these pages are spooled on external storage media.

– If you display tags on HTML-pages using the entry type "Cyclic on use", it can lead to 
data-inconsistency.
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● E-mailing
The E-mailing function is not suitable for the mass dispatch of E-Mails. It is meant for 
sending important messages. 

● Timeout
If the connection between server and client is interrupted, the server will register this 
disconnection only with a certain delay. The delay is based on the Windows standard 
configuration of TCP/IP Timeout.

Use-requirements in the company network 
In order to implement the mentioned scenario, the accesses to the company network must be 
enabled. If the company network is protected by a Firewall, the system administrator must 
release the appropriate ports for that. 

● Access to the integrated HTML-pages
The web server connects to the network at the port 80. 

● Access to Sm@rtServer for downloading the Java-Applet using the Internet Explorer
The Sm@rtServer is connected to the network at the Port 5800 for downloading the Java-
applet. 

● Access to the Sm@rtServer using the Internet Explorer for remote monitoring and remote 
control
The Sm@rtServer is connected to the network at the port 5900. 

 

  Note

If you change the ports of the Sm@rtServer you must customize the links in the used Html-
pages accordingly. Additional information to modify the Html-pages is provided in 
"Example: "Configure integrated webserver".

 

10.16.4.2 Remote control via Sm@rtServer

Types of the remote control

Remote control and remote monitoring by means of Sm@rtServer

Introduction
The Sm@rtOptions of WinCC enable the access from HMI device or PC to a remote HMI 
device via Ethernet.      
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Requirement
● The License Key "Sm@rtServer" is available at the Server-HMI device.

 

  Note

The 14-day license is not supported by Windows CE devices. 
 

● Both devices are linked via a TCP/IP-ready network, that is via a LAN or the Internet.

● "Sm@rtServer" is activated in the WinCC-Project of the Server-HMI device for the "Services 
in Runtime".

● Additional requirements must be satisfied according to the type of implementation.

Implementing remote access
The Sm@rtServer supports remote monitoring or remote control on the remote device (server). 

Remote monitoring or remote control can be implemented on the local device (client) in various 
ways: 

● By means of Internet Explorer

● By means of the Sm@rtClient-application

Access via HTML pages
The Sm@rt Options enable access for remote control with Microsoft Internet Explorer and by 
means of integrated HTML pages of the server.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rt Options and OPC, 
it is the end user who is responsible for the security of his data network. The proper functioning 
of the device cannot be guaranteed in all circumstances; targeted attacks, for example, can 
lead to an overloading of the device.

 

Remote control by means of Internet Explorer

Introduction
On the client HMI device, the connection to the remote HMI device is established by means 
of Internet Explorer.   

The window of the Internet Explorer displays only the screen of the remote HMI device, of the 
server HMI device. If task switching is not disabled at the server HMI device, you can access 
the complete desktop.
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Requirement
● The Client-HMI device is a PC.

● Internet Explorer from V6.0 SP1 is installed.

● The Client-and Server-certificates are installed to ensure the data security when transferred 
via internet.

● The Java-Applet is installed. The Java applet accesses the Java runtime environment that 
is installed on the client.

 

  Note

You achieve the best results in Internet Explorer by installing the current Java Runtime 
Environment (JRETM) of Sun Microsystems. Go to www.java.com to download this 
program.

 

Process flow
Enter the address of the remote device in Internet Explorer. The address consists of the server 
name and the HTTP port number that is set on the server. The default setting is: 5800.

Examples of addressing: "http://MyPanel:5800" or "http://192.168.168.1:5800".

Restrictions
The "Force write access with password" function cannot be implemented using the Java applet. 

See also
"Administration" tab (Page 7410)

Remote control by means of the Sm@rtClient application 

Introduction
The Sm@rtClient application provides the connection to the remote HMI device on the remote 
HMI device.     

Requirement
● The Client-and Server-certificates are installed to ensure the data security when transferred 

via internet.

● The Client-HMI device is a PC.
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Process flow
The remote control via the Sm@rtClient-application works as follows:

● Start Sm@rtClient application

● Establish connection

● Password input

● Perform operator control or monitoring on the HMI device

Start Sm@rtClient application
You can access the Sm@rtClient application, the program "SmartClient.exe", in various ways: 

● By installing WinCC Runtime on the client device you have automatically installed the 
Sm@rtClient application.

● You have several options if WinCC Runtime is not installed on the client device:

– Copy the Sm@rtClient application from the WinCC product-DVD from the folder "Support
\SmartClient".

– Copy the Sm@rtClient application from the "...\Siemens\Automation\WinCC RT 
Advanced" folder of another PC using a floppy disk or the Intranet.

Establish connection
In order to establish the connection to the remote HMI device, call the Sm@rtClient application 
and enter the IP address of the server.

● IP address or server name:port number

● IP address or server name:display number

Example: "192.168.0.1::5800"

You can also start the Sm@rtClient application with the command line input: "smartclient.exe 
192.168.0.1". The logon dialog box opens. 

You can include the password in the command line entry to start the Sm@rtClient application: 
"smartclient.exe 192.168.0.1 /password 100".

 

 Note

If the Sm@rtServer at the server HMI device does not run as a service, the connection 
established with the Sm@rtClient application is interrupted automatically as soon as the 
keyboard shortcut CTRL+ALT+DEL is pressed at the server HMI device or the screen saver 
is activated. In order for the Sm@rtServer to run as a service, the "Start automatically after 
booting" check box in the "Remote" tab in the "WinCC Runtime Advacned Internet Settings" 
dialog must be activated.
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Password input

Password input at the Sm@rtServer
Instead of the on-screen keyboard, the following message is displayed on the Sm@rtClient if 
you enter the password directly at the Sm@rtServer: "Remote access by Sm@rt Options is in 
Progress. Please wait until the input of values has been ended." This measure prevents 
keyboard input for entering the password from being displayed on the Sm@rtClient.

Password input at the Sm@rtClient
The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. Use the local on-screen keyboard for entries at the Sm@rtClient. 

The local on-screen keyboard will be displayed automatically on the Sm@rtClient or in the 
Sm@rtClient view.

Close the on-screen keyboard manually. Select "Input > Hide Input Panel" to hide the local on-
screen keyboard. 

 

 Note

The entries with full-screen keyboard are not protected on HMI devices with a screen size of 
≤ 6''. 

Entries in Control Panel Applets which do not use the full-screen keyboard are protected.
 

 Note

Hidden password input is not supported by the on-screen keyboards of third-party products.
 

 Note

You cannot enter special characters with the keyboard shortcut Alt Gr.
 

Perform operator control or monitoring on the HMI device
In the Sm@rtClient application window, the entire layout of the remote HMI device is shown. 
Depending on the configuration, you can specify monitoring only or operator control of all keys, 
including the function keys, with the mouse. In addition, the entire desktop can be accessed 
in the case of a PC.

For operator control via the keyboard, the following is available:

Keyboard shortcut Function
<ALT+CTRL+SHIFT+O> Opens the "Sm@rtClient Options" dialog
<ALT+CTRL+SHIFT+F> Switches over to full screen mode
<ALT+CTRL+SHIFT+R> Updates the display
<ALT+CTRL+SHIFT+N> Opens the "New Sm@rtServer Connection" dialog
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Keyboard shortcut Function
<ALT+CTRL+SHIFT+S> Save as
<ALT+CTRL+SHIFT+T> Displays and hides the toolbar

Remote control via the Sm@rtClient display during runtime

Introduction
The Sm@rt options of WinCC enables access from the HMI device or PC to a remote HMI 
device via Ethernet.     

Requirement
● The License Key "Sm@rtServer" is available at the Server-HMI device.

● Both devices are linked via a TCP/IP-ready network, that is, via a LAN or the Internet.

● HMI-device is configured as Sm@rtServer. For detailed instructions on this, refer to 
"Configure Sm@rtServer (Page 7437)".

● The Sm@rtClient-Display in an image is added in the client-HMI device project. For detailed 
information on this, refer to "Project Sm@rtClient (Page 7439)".

Implementing remote access
The Sm@rtServer supports remote monitoring or remote control on the remote device (server). 

On the client HMI device, the connection to the Sm@rtServer is made during runtime by means 
of the Sm@rtClient display. 

On the HMI device only the screen of the server, and not the soft keys, is displayed. 

The form of the cursor is not a part of the screen and is therefore not transmitted. Only the 
coordinates of the cursor are transmitted.

 

 Note

If a soft-key is activated on the client HMI device, then observe the following:

This signal is transferred to the Server-HMI device and becomes effective there, only if no 
function was configured at the soft-key.

Otherwise, the function projected on the client-HMI device is executed. 
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Use of direct keys for remote access  
You can only operate direct keys locally on the server. Although the key for the direct key can 
be operated on the Sm@rtClient, no bit is set in the I/O range of the PLC.

 

 CAUTION

Ethernet communication

In Ethernet-based communication, such as PROFINET IO, HTTP, Sm@rt Options and OPC, 
it is the end user who is responsible for the security of his data network. The proper functioning 
of the device cannot be guaranteed in all circumstances; targeted attacks, for example, can 
lead to an overloading of the device.

 

Password input     

Password input at the Sm@rtServer
Instead of the on-screen keyboard, the following message is displayed on the Sm@rtClient if 
you enter the password directly at the Sm@rtServer: "Remote access by Sm@rt Options is in 
Progress. Please wait until the input of values has been ended." This measure prevents 
keyboard input for entering the password from being displayed on the Sm@rtClient.

Password input at the Sm@rtClient
The on-screen keyboard is hidden on the Sm@rtServer due to the actions carried out on the 
Sm@rtClient. Use the local on-screen keyboard for entries at the Sm@rtClient. The local on-
screen keyboard will be displayed automatically on the Sm@rtClient or in the Sm@rtClient 
view.

Close the local on-screen keyboard manually. Select "Input > Hide Input Panel" to hide the 
local on-screen keyboard. 

 

 Note

The entries with full-screen keyboard are not protected on HMI devices with a screen size of 
≤ 6''. 

Entries in Control Panel Applets which do not use the full-screen keyboard are protected.
 

 Note

Hidden password input is not supported by the on-screen keyboards of third-party products.
 

 Note

You cannot enter special characters with the keyboard shortcut Alt Gr.
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Distributed operator stations

Configuration

Configuration
Multiple HMI devices are used as decentralized, coordinated operator stations that have 
access to a centralized HMI device connected to the PLC. 

The HMI devices are linked via a TCP/IP-network, (LAN or Intranet /Internet).

...

Figure 10-19 Distributed HMI

Only one HMI device, the Sm@rtServer contains the configuration data. The Sm@rtServer is 
controlled from the HMI devices. 

The decentralized operator stations are the Sm@rtClients. These operator stations display the 
same process screen of the server. A Sm@rtClient-Display is configured in the process screen 
for the operation and monitoring.

All devices have the same screen resolution. 

The operator stations are in shared mode. As soon as a defined period of time elapses without 
any action on an operator station, another operator station can become active. If Sm@rtClient 
display is configured accordingly, the user can also log off directly.
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Advantages
● Operator control and monitoring can be performed from various locations without significant 

efforts.
The project only has to run on one HMI device configured as a server. The same client 
project runs on all other HMI devices; the Sm@rtClient display object is contained in a 
screen on these devices. The screen of the server is displayed via the Sm@rtClient display. 

● The server is situated remotely from the machine and is thus not exposed to the 
environmental conditions of the machinery room.

● Coordinated operation is provided by the Sm@rtServer. Additional PLC investments are 
not required. For example, the load on the field bus is also reduced – the communication 
load on the bus is removed due to the interlocking mechanisms on the PLC side.

Configure distributed operator stations 

Introduction
Operator control of an extensive printing machine need to have the option to exercise control, 
when necessary, at multiple locations along the machinery. Depending on his current location, 
the operator must be able to access the process from an operator station in the vicinity.         

Requirement
● The HMI-device with the configuration data is connected with the control.

● The server-HMI device and the Client-HMI devices are networked with each other via TCP/
IP-Network.

● The License Key "Sm@rtServer" is available.

Configuration steps
The following basic steps are necessary for configuring the distributed operator stations:

Step  
1 Configuring Sm@rtServer (Page 7437) 
2 Setting WinCC Runtime Advanced Internet (Page 7437) 
3 Project Sm@rtClient (Page 7439) 
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Configure Sm@rtServer

Configuring Sm@rtServer

Requirement
● The WinCC-Project for the Server-HMI device is configured.

Procedure
Proceed as follows to configure the Sm@rtServer in WinCC:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enable "Sm@rtServer" in  the group "RemoteControl".

4. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The Server-HMI device is configured as Sm@rtServer . 

Setting WinCC Runtime Advanced Internet

Requirement
● The "Control Panel" opens.

● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Remote" tab is displayed.
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Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the 
Sm@rtServer:

1. On the "Remote" tab, select Start automatically after booting".

2. Click on the button "Change settings". The dialogue "Sm@rtServer: Current User 
Properties" is opened.

3. On the "Server" tab, select "Accept socket connections".

4. Enable "Encrypt communication" to establish an encrypted connection to the server.

5. Enter a password for "Password 1 "and "Password 2". Click "Apply".

6. Click on the "Administration" tab.
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7. In the area Connection priority", select Automatic shared sessions". For "Active user 
timeout" enter time that must elapse without any actions on the active HMI device before 
access can be changed.

8. Under the "Forced write access", clear Password needed" for the forced access to the HMI 
device Click "Apply". Click "OK" to close all opened dialogs.

Result
The settings were changed. The changes will be effective after restarting the Sm@rtServer. 

See also
Project Sm@rtClient (Page 7439)

Project Sm@rtClient

Requirement
● The WinCC project for the client HMI device is configured.

● The "Screens" editor is open.

● The Inspector window is shown.

● The "Tools" task card is open.

Procedure
Proceed as follows to configure the Sm@rtClient:

1. Insert the Sm@rtClient display in the start screen.

2. In the Inspector window, click "Properties > Properties > General".

3. Enter the IP address or the name of the server HMI device in the "Address Sm@rtServer" 
field.

4. Enter "Password 1" configured on the server in the "Password" field.

5. Activate the "Encrypt communication" function in the "Options" area.
When the "Encrypt communication" function is enabled, the connection to the server is 
encrypted through the exchange of certificates.
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6. Activate the setting "Allow Menu".
This provides the operator with the option of logging off using the menu. 

7. Transfer the compiled project to all operator stations.

Result
The Sm@rtClient display was added to the start screen in the WinCC project of the 
Sm@rtClient. 

After the Sm@rtServer and the operator stations are started for the first time, a check is carried 
out as to whether communication is encrypted. 

● If communication is encrypted, save the certificate of the Sm@rtServers on the HMI device. 
Afterwards, you connect the Sm@rtClient with the Sm@rtServer using encrypted 
communication.

● If communication is not encrypted, you connect the Sm@rtClient with the Sm@rtServer 
without a certificate.

In order to control the server from an operator station, the operator must wait a specified 
amount of time following the last action on another HMI device. 

If the operator uses the menu of the Sm@rtClient display to log off at the previously used HMI 
device, he can immediately control the server at the next HMI device. 

See also
Remote control via the Sm@rtClient display during runtime (Page 7431)

"Server" tab (Page 7406)

Setting WinCC Runtime Advanced Internet (Page 7435)
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10.16.4.3 E-mail notification from runtime

Process flow

Introduction
WinCC Runtime Advanced with the Sm@rtService offers the option of sending messages 
automatically via email.     

The automatic e-mailing feature ensures that all people affected by the machine status (for 
example, shift engineer and sales manager) are informed in a timely manner. 

Contents and triggers for e-mailing
The following events can trigger an e-mail to be sent: 

● Alarm of a certain alarm class

● Event in which a standard function has been configured, such as a tag value change, etc.

Such an e-mail can have the following contents: 

● Alarm text with process tags (maximum of 256 characters)

● Date/time

● E-mail address for replies

If you use e-mail gateways or SMS gateways, you receive access to standard networks, which 
requires external service providers. If configured accordingly, in critical situations the operator 
station sends an SMS to your mobile phone. 

Enabling e-mailing and SMS
The HMI device can send e-mails to an SMTP server only. The server sends the e-mails to 
the addresses configured in the server. 

Nothing else is required to send e-mails to addresses in the company network. However, an 
external service provider is required to access standard networks. 

If an SMS communication is to be sent to service personnel, an SMS gateway is required as 
well. 

Settings on the HMI device
The settings for emailing on the HMI device are made in the "Email" tab under "WinCC Runtime 
Advanced Internet" on the control panel. 

The "Sender" entry field is assigned the default value "Automation HMI device." A change is 
useful if you want the recipient to be able to identify the device from which the e-mail originated, 
e.g. "HMI device on production line 2" 

You can also use an SMTP server that support authentication to send e-mail. 

The following authentication modes can be configured:
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● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

Data can also be encrypted and sent via an SSL connection. This means the data cannot be 
manipulated or read. 

Specify trigger for E-Mailing

Requirement  
● You have to create WinCC project.

Procedure
Proceed as follows to send a message when an alarm is triggered:

1. Double-click on the "HMI-Alarms" entry in the project tree.

2. Click the "Alarm classes" tab in the "HMI-Alarms" editor.

3. Select the alarm class, e.g. "Errors".

4. Enter the E-Mail-Address in the inspector window under "Properties > Properties > 
General".

5. Create an analog or discrete message with this alarm class.

Result
The trigger to send a message was configured. A message is automatically sent when a 
message of this alarm class is triggered.

Configure secure e-mail notification from Runtime

Introduction
If you send e-mail via the SMTP protocol, the sender is not verified. To ensure secure 
transmission of e-mails, you can use SMTP servers that support SMTP AUTH 
(authentication).   

You must log on to the SMTP server to send e-mails. The following authentication modes can 
be configured:

● Authentication by means of a valid e-mail address

● Authentication by means of user name and password

The data can also be sent via an SSL connection. SSL (Secure Socket Layer) encrypts e-mails 
and user data for transmission. This means the e-mail cannot be manipulated or read during 
transmission. 
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Requirement
● The SMTP server supports SMTP AUTH and STARTTLS. You can obtain more detailed 

information from your service provider.

● User name and password or a valid e-mail address for logon to the SMTP Server. You can 
obtain this data from your service provider.

● The SMTP server is available.

● The e-mail address of the service technician is entered in the alarm class.

● An analog or discrete alarm has been created for this alarm class.

Procedure in WinCC
1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enter the sender name to be shown in e-mail under "Sender name". If the SMTP server 
does not support the function, delete the entry.

4. Assign a port number.
Port number 25 is assigned by default.
The port number in WinCC must match the port number in the "WinCC Internet Settings" 
on the HMI device.

 

  Note

You can only configure the port number with the following HMI devices:
● Comfort Panels
● RT Advanced

 

5. Enter the authentication data.

– Authentication by means of user name and password:
Enter the user name and click on  at the "Password" input field. Enter the password 
in the "Enter password" box in the next dialog. Enter the password again in the "Confirm 
password" box. Close the dialog.

– Authentication by means of a valid e-mail address
Type in the e-mail address required for SMTP authentication in the "E-mail address" 
input field.

6. Enable "The server requires a secure connection (SSL)".

 

Procedure on the HMI device
 

 Note

Note that the settings on the HMI device have a higher priority than the settings in the WinCC 
project. 
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1. Open the "WinCC Runtime Advanced Internet " dialog in the control panel of the HMI device.

2. Click on the "E-mail" tab.

3. Specify the SMTP server.

– Select "Use the default project file" if you want to use the SMTP server defined in the 
project.

– Deactivate "Use the default project file" if you do not want to use the SMTP server 
defined in the project. Specify the required SMTP server. For HMI devices with Windows 
CE, specify the computer name or the FQDN (Fully Qualified Domain Name).

4. Assign a port number.
Port number 25 is assigned by default.
The port number must match the port number in the WinCC Internet Settings in the HMI 
device.

 

  Note

You can only configure the port number with the following HMI devices:
● Comfort Panels
● RT Advanced

 

5. Enter the sender name given in the e-mail under "Name of the sender". If the SMTP server 
does not support the function, delete the entry.

6. Enter the authentication data.

7. Enter a valid e-mail address at "eMail adress of sender" if required for authentication.

– Click "Advanced" if you need a user name and password for authentication. The 
"Advanced Email Settings" dialog opens.

8. Type in the user name and password in the "Advanced Email Settings" dialog.

– Enable "Use the default of the project file" to use default user data you have defined in 
the project.

– Select "Use panel settings for authentication" if you do not want to use the user data 
defined in the project. Enter the user name and password.

9. Enable transmission via SSL.

– To use the project settings, enable "Use the default of project file" and SSL in WinCC.

Result
If a tag such as a mixer speed exceeds configured limits, a corresponding alarm is displayed 
on the HMI device. The data is sent to the SMTP server via SSL connection. The e-mail is sent 
to the field service technician after successful logon. 
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10.16.4.4 Display integrated Service-Pages

Integrated Webserver

Introduction
The operator can display and navigate between web pages during runtime using the web 
server integrated in the HMI device.  

The integrated web server displays the integrated service-pages. Depending on the 
configuration, own configured HTML-pages or Service-pages of a server accessible over 
Ethernet are be displayed. 

Requirement
● "HTML-Pages" is activated in the WinCC-Project of the Server-HMI device for the "Services 

in Runtime".
 

  Note

It is always possible on a PC to access HTML-pages in runtime, although the option 
"HTML-pages" is cleared. Setup always installs the standard pages of the Web Server on 
the PC. Assign an administrator password to prevent unauthorized access to the pages.

 

Purpose of the web server
The integrated web server permits HTML pages to be displayed during runtime over one of 
the following routes: 

● Internet Explorer

● HTML browser screen object during runtime (not on Windows CE devices)

The following are displayed: 

● internal Service-Pages available by default on the HMI-device

● Other pages that you configure

● Other Internet pages

An operator or service technician can access service-critical information via the HTML pages. 
The standard HTML pages provide the following options: 

● Remote control (if the HMI device is configured as a Sm@rtServer)

● Remote control using Microsoft Internet Explorer

● Starting and stopping of runtime

● Remote access to recipe data records and password lists

● Display of system information

● File management using a file browser

● Downloading of configuration data
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● A "DATETIME" tag always returns a date within the range from 1.1.1970 00:00:00 to 
31.12.2037 23:59:59. 

● The "Export recipes" function requires the following authorizations:

– PC: "UserData"

– other HMI devices: "UserData" and "FileBrowserUser"

HTML browser for HTML pages
The HTML-pages are also displayed using the configured "HTML browser" screen object (not 
on Windows-CE devices). 

You can can also arrange for input or activation of an Internet address. As soon as the operator 
enters or activates an address, the HTML browser opens the relevant page. 

The appearance and functionality of the HTML browser screen object depends on the HMI 
device type. On PCs, the HTML browser corresponds to the Internet Explorer installed.

 

 Note

Note that the HTML browser options during runtime are restricted due to operating device 
capacities and options. 

 

Service-pages of the web server

Introduction
The operator can use Internet Explorer or the HTML browser screen object during runtime to 
display service-pages without any additional configuration.     

You can also create own service-pages. For detailed information, refer to "Configure In-house 
service-pages".
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Requirement
● "HTML-Pages" is activated in the WinCC-Project of the Server-HMI device for the "Services 

in Runtime".
 

  Note

It is always possible on a PC to access HTML-pages in runtime, although the option"HTML-
pages" is cleared. Setup always installs the standard pages of the Web Server on the PC. 
Assign an administrator password to prevent unauthorized access to the pages.

 

Service-pages
WINCC Runtime has the following service-pages: 

● start.html: Home page

● RemoteControl.html: Remote control (only for Internet Explorer)

● Control.html: Control functions

● StatusDetails.html: System diagnostics

● Browse.html: File browser (only for Internet Explorer)

Home page: Start.html
The start page contains the links to all other pages and displays current information about the 
project: Mode, software versions, device data, etc.

"Remote control": RemoteControl.html
The "Remote control" page enables operator control of the HMI device for which a page is to 
be displayed. This page can only be displayed by using the Internet Explorer.
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"Control functions": Control.html
The "Control functions" page enables the following options on the HMI device for which a page 
is to be displayed: 

● Starting and stopping of HMI runtime
 

  Note

The transfer mode must be set in the Loader-menu on the HMI-device.
 

● Exporting and importing of recipes
 

  Note

After importing recipes with Sm@rtService (HTML pages), restart Runtime. The imported 
recipes only become active the next time Runtime is started. 

 

● Exporting and importing of password lists
 

  Note

The password list must be named "pdata.pwl." It is exported to the following directory: 

On Windows CE-devices: In the "\Flash\simatic\" target directory

On PCs: the folder that was set in the file "HMILoader.exe". 

The password list is exported and becomes active the next time Runtime is started. 
 

"System diagnostics": StatusDetails.html
The "System diagnostics" page contains system alarms from the alarm buffer.

"File Browser" – Browse.html
The "File Browser" page is used to administer directories and files on the remote device. This 
page can be displayed with any Internet browser. 

Installing the client and server certificates for SSL

Introduction
To ensure data security, data are encoded for transmission over the Internet. Encoding and 
decoding is performed by appropriate software – the certificates for SSL (Secure Sockets 
Layer). 

● The client certificate for SSL must be installed on devices that are to be used to control a 
remote device.

● The server certificate for SSL must be installed on HMI devices that are to allow remote 
control.
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Configure access to  service-pages

Configure integrated web server 

Configure WinCC-Project 

Requirement
● The WinCC-Project of the server-HMI-device is configured.

Procedure
Proceed as follows to configure the HMI device in such a way that other HMI devices or PCs 
can be connected to it:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Enable the "HTML-Pages" in the "Diagnostics" group.

4. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The Server-HMI-device is configured as web server. 

Setting WinCC Runtime Advanced Internet

Requirement
● The "WinCC Runtime Advanced Internet" dialog is open.

● The "Web Server" tab is displayed.

Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the HMI 
device:

1. Click "User Administration" in the "Web Server" tab. 

2. Open the "UserDatabase-Edit" dialog.

3. Click "Add" in the "User manager" tab to create a new user. 

4. Enter a user name and specify a password. 

5. Click on "Apply".

6. Click the "Authorizations" tab.
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7. Specify on the "Authorizations" tab, which functions can the user carry out on the HTML-
pages of an HMI-device.  See the section "User administration for web server  
(Page 7412)" for additional details.

8. Close the "UserDatabase-Edit" dialog.

9. On the "Remote" tab, select the "Start automatically after booting" check box.

10.Click "Change settings" and enable in the "Sm@rtServer dialog: Current User Properties", 
select the checkbox "Enable connections".

11.Specify a password for "Password2" so that the HMI device can be remotely controlled by 
the service technician.

Result
A user was created on the HMI-device in the user administration of the web server and 
configured for the remote control. 

The service technician can be connected to the HMI-device by means of the Internet Explorer 
and the Sm@rtClient Application. After disconnecting the connection, the HMI-device can be 
operated from his PC. 

See also
WinCC Runtime Advanced Internet, "Web Server" tab (Page 7404)

"Server" tab (Page 7406)

Display and remote-control Service-Pages

Requirement   
● A user is created on the HMI-device in the user administration for the web server.

● The web server is started.

● The Client-and Server-certificates are installed to ensure the data security when transferred 
via internet.
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Procedure
To display and control the service-pages, follow these steps: 

1. Start the Internet Explorer on the configuration-PC and connect with the "Homepage" of 
the HMI-device.

2. For "Name" and for "Password", enter the data of the user configured in the user 
administration of the web server. Click "Login".

3. Click "System Diagnostics". The system alarms from the alarm buffer are displayed on this 
page.

4. Click "Remote Control" to remotely control the HMI-device.

Result
The service-pages are displayed. The HMI-device can be operated or monitored via the 
service-pages. 

A keyboard units cannot be operated completely in the Internet Explorer, since only the screen 
content is displayed. Use the Sm@rtClient-Application to remotely control the keys of HMI-
device. The Sm@rtClient-Application can be located under "Start > Program > Siemens 
Automation > Runtime Systems > WinCC Runtime Advanced > Sm@rtClient"
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Create own Service-pages

Basics

Introduction
The basic framework of the service-pages corresponds to a normal HTML-file.

● Declaration of the document type

● Header with data for the title

● Body - content to be displayed.

Variable parameters in Service-pages
You can specify variable parameters in HTML documents. As soon as a page with variable 
parameters is opened, the parameters are replaced by specific values. 

<BODY > Welcome on <MWSL><!-- write(GetVar("[Parameter]")); --></MWSL></BODY>

Available variable parameter

Parameters Meaning
ProgramMemoryComplete CE only: Total program memory
ProgramMemoryFree CE only: Program memory available
ProgramMemoryUsed CE only: Program memory utilized
FlashComplete CE only: Total flash memory
ObjStrComplete CE only: Total available flash memory
ObjStrFree CE only: Volatile memory available
ObjStrUsed CE only: Volatile memory utilized
DeviceType Type of target device as specified in the control panel.
BtLdVer CE only: Bootloader-version, as specified in the control panel. 
BtLdRelDate CE only: Bootloader release date
ImageVersion CE only: Image version as it appears on the loader
DramSize CE only: Size of DRAM
HostName The name by which the device is logged on/identified in the network.
RtState Indicates whether Runtime is running on the target device. 
SystemMessageTable Outputs a table containing the current system events.

In the example below, the "HostName" parameter is replaced by the network-name of the 
device. 

<BODY > Welcome on <MWSL><!-- write(GetVar("[HostName]")); --></MWSL></BODY>
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Process tag
Process tag values can also be displayed in HTML pages. The syntax is the same as for device 
tags. Use the tag name as a placeholder for the tag value, , e.g. Tag_1.

<BODY > Welcome on <MWSL><!-- write(GetVar("[Tag_1")); --></MWSL></BODY>
 

 CAUTION

Data inconsistency caused by HTML pages

Note the information below if the "Cyclic in operation" acquisition mode is set at tag:
1. If this tag is not displayed on the HMI device, the HTML page displays the incorrect tag 

value in the following situations:
– The HTML page display a "0" value at its first call. The HTML page only displays the 

correct value after it is called again or updated.
– The last value is displayed if the connection to the PLC goes down.

2. The HTML page also displays the correct tag value if the tag is displayed on the HMI 
device.

 

Situation 1 is based on standard behavior: If a tag is currently not in use currently and its value 
is not acquired in "Cyclic continuous" mode, the tag is loaded with its initial value in Runtime. 
Instead of reading the values from the PLC, however, the HTML page receives these from 
Runtime.

Link own Service-pages
If a user connects to an HMI device, he is automatically forwarded to the start page http://
<Device name>/www/start.html. This page represents the starting point for the HTML-pages 
of the web server. Every standard page is accessible from the start page via a link. For this 
reason, you insert a link for each of your HTML pages in the start page.

 

 Note

When inserting links in the HTML page, you must differentiate between relative and absolute 
links. Make sure that absolute links start with "/www" to ensure that the document will be 
searched for in the correct directory. Example: "/www/MyDocument.HTML".

 

Storage location of the service-pages 
If files are to be located during a transfer, they must be in a specific directory: 

● on a PC with Windows 7: "C.\ProgramData\Siemens\CoRtHmiRTm\MiniWeb11.x.x
\WebContent"

● on a PC with Windows XP: "C:\Documents and Settings\All Users\Application Data
\Siemens\CoRtHmiRTm\MiniWeb11.x.x\WebContent"

● On xP 177B: "<ES-Installationspath>\Transfer\11.0\XP177B\WebContent.zip"

● On xP 277: "<ES-Installationspath>\Transfer\11.0\XP277\WebContent.zip"

● On MP 177: "<ES-Installationspath>\Transfer\11.0\MP177\WebContent.zip"
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● On MP 377: "<ES-Installationspath>\Transfer\11.0\MP377\WebContent.zip"

● on Mobile Panel 177 PN: "<ES-Installationspath>\Transfer\11.0\XP177B\WebContent.zip"

● On Mobile Panel 277: "<ES-Installationspath>\Transfer\11.0\XP277\WebContent.zip"

● On the Mobile Panel 277 (F) IWLAN: "<ES-Installationspath>\Transfer\11.0\XP277_W
\WebContent.zip"

● On the Mobile Panel 277 (F) IWLAN V2: "<ES-Installationspath>\Transfer
\11.0\XP277_W2\WebContent.zip"

Create service-page for displaying process values 

Requirement
The Ta_1 and Tag_2 tags are created in the WinCc-Project. 

Procedure
To create an own Service-page, follow these steps:

1. Copy the "WebContents" ZIP-file in a random work directory on your Configuration-PC and 
un-zip the ZIP-file.

2. Create a copy of start.html and rename the copy in "tag.hml".

3. Open the "tag.html" in a text editor, e.g. Notepad.

4. Replace the existing table with a new table, in which the process values of "Tag_1" and 
"Tag_2" tags are displayed. Save the file"tag.html".

5. Open the "start.html" file and add a hyperlink to page "tag.html". Expand the available 
navigation bar, in which you supplement the existing table by an entry.

6. Save start.html.

Result
You have created the service-page "tag.html". You have added a hyperlink on the start page 
in order to navigate to the service-page from the start-page. 
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Transfer Service-pages

Transfer files using the standard-path (Active Sync/CF- card)  
Proceed as follows to transfer files via the standard-path:

1. Copy the changed HTML pages and pictures according to "\Flash\Simatic\WebContent".
Access then takes place with "http://<device>/www/<HTML page>".

Transfer files via the project transfer
Proceed as follows to transfer the files via the project transfer:

1. Add the changed files to the ZIP-file "WebContents". This file must contain all HTML pages 
and associated pictures.
Make sure to provide the correct path information because the files are unpacked in the 
directories specified in the zip file. Incorrect path information results in errors in direct 
addressing or due to links. 

2. In order to transfer the ZIP-file "WebContents", copy this in a certain directory, e.g. for the 
transfer to an MP377"<ES-Installationspath>\Transfer\1.3\MP377\WebContent.zip".

3. Transfer the project to the HMI device.
The ZIP-file "WebContents" is transferred to the Windows CE device where it is unzipped. 

Transfer files using the File Browser
Proceed as follows in order to transfer files using the file transfer:

1. Start the Internet Explorer on the configuration-PC and connect with the "Homepage" of 
the HMI-device.

2. Log-on to the internal Web Server to work with the File Browser.
For read and write access to the file browser, the user must possess the web authorizations 
"FileBrowserAdministrator" and "FileBrowserUser" .

3. Click on "Browse" in the File Browser . The file selection dialog opens.
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4. Navigate to the file storage location by means of this dialog. Select the desired file and click 
"Open."

5. Click "Upload File". The file is copied in the directory of the internal web server.

See also
Basics (Page 7450)
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10.16.4.5 Access via SIMATIC HMI HTTP Protocol

Configuration

Configuration 
During the communication via  SIMATIC HMI HTTP Protocol, an HMI-device accesses the 
tags of a different HMI-device. The access is "read-only" or "read and write" depending on the 
configuration of the concerned HMI-device.

The HMI device providing the tags is the HTTP-server; the other HMI-device is the HTTP-client. 
However, access to tags functions in both directions.

Configure access via SIMATIC HTTP Protocol 

Introduction
The tags in service-application should be illustrated in an overview for a configuration from 
multiple HMI-devices. 

The panels in the machine level are used as tag server. The service-application illustrating 
tags of machines in an overview image runs on a PC.
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Requirement
● The HMI-devices are networked via a TCP/IP-network with each other.

Configuration steps
The following basic steps are required to configure the access via "SIMATIC HMI Protocol". 

Step  
1 Configure WinCC-Project  (Page 7459) 
2 Setting WinCC Runtime Advanced Internet (Page 7459) 
3 Configuring HTTP connections in the client (Page 7460) 
4 Configure the HTTP-Client tags (Page 7462) 

 

Permissible data types (SIMATIC HMI HTTP protocol)

Permitted data types
When configuring tags, the data types listed below can be used.   

Data types in 
the HTTP 
Protocol

Length Signs Range of values

Bool 0 No true (-1) or false (0)
Char 1 byte Yes -128 to 127
Byte 1 byte No  0 to 255
Int 2 bytes Yes -32768 to 32767
UInt 2 bytes No 0 to 65535
Long 4 bytes Yes  -2,147,483,648 to 2,147,483,647
ULong 4 bytes No 0 to 4,294,967,295
Float 4 bytes Yes  -3.402823E38 to -1.401298E-45 for negative values and 

1.401298E-45 to 3.402823E38 for positive values
Double 8 bytes Yes  -1.79769313486231E308 to

-4.94065645841247E-324 for negative values and 
4.94065645841247E-324 to 1.79769313486232E308 for 
positive values

String 1 to 
255 byte

––––  

DateTime 8 bytes –––– 1.1.1970 00:00:00 up to 31.12.2037 23:59:59
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Please note that data types may be defined in external controllers which have different names 
in WinCC. To ensure correct assignment, please observe the tag definition in the external 
controllers.

 

 Note

It is not possible to access array tags from an HTTP client.
 

See also
Configure WinCC-Project  (Page 7459)

Configure HTTP server

Configure WinCC-Project 

Requirement
● The WinCC-Project for the Server-HMI device is configured.

Procedure
Proceed as follows to configure the HTTP-Server:

1. Double-click on the "Runtime-settings" entry in the project tree.

2. In the "Runtime-settings" editor, click on the "Services".

3. Select "SIMATIC HMI HTTP Server" in the group "Read/write tags".

4. Check the data types of the tags. The HTTP-client can access only those tags, whose data 
type is supported by communication driver "SIMATIC HMI HTTP Protocol". For additional 
information, refer to "Permissible data types (SIMATIC HMI HTTP Protocol) (Page 7456)".

5. Transfer the compiled WinCC-project to the Server-HMI-device.

Result
The HMI-device is HTTP-server configured. 

Setting WinCC Runtime Advanced Internet

Requirement    
● The "Control Panel" opens.

● The "WinCC Runtime Advanced Internet " dialog is open.

● The "Web Server" tab is displayed.
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 Procedure
Proceed as follows to change the "WinCC Runtime Advanced Internet" settings on the HTTP 
server:

1. Specify the access to tags in case of "Tag access".

– "Read/write": read and write access 

– "Read only": read access 

2. Specify the authentification for access in case of "Tag authenticate":

– "No authentication": No authentication required.

– "Authentication required": A password is required for the access. Specify the password 
for configuring the connection via the SIMATIC HMI HTTP Protocol .

3. Click "User Administration" in the "Web Server" tab. Enter "100" as password. The 
"UserDatabase-Edit" dialog is opened. For detail instructions, refer to "User administration 
for Webserver (Page 7412) ".

4. Click "Add" in the "User manager" tab to create a new user. Enter a user name and specify 
a password. Click on "Apply".

5. Click the "Authorizations" tab.

6. Specify the web-authorizations on the tab "Authorizations". The user must have the Web-
authorization "RTCommunication" for utilizing the SIMATIC HTTP Server.

7. Close all open dialog boxes.

Result
The settings were changed. The changes will be effective after the restart of the WebServer.

See also
Settings on the HMI device (Page 7401)

WinCC Runtime Advanced Internet, "Web Server" tab (Page 7404)

User administration for web server  (Page 7412)

Configuring HTTP clients

Configuring HTTP connections in the client

Requirement
The communication driver "SIMATIC HMI HTTP Protocol" is installed. 
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Procedure
Proceed as follows to create an HTTP-connection:      

1. Double-click on the "Connections" entry in the project tree. The "Connections" editor opens.

2. Create a connection. Select "SIMATIC HMI HTTP Protocol" for "Communication driver".

3. Select "Ethernet" for "Interface". Select the protocol type "http://" or "https://" for address.

4. Enter the name of the HTTP-server or its IP address.
Ask your network administrator for the specific name or parameters of your network.
If the server has already been commissioned, you can read out the IP address on the server 
as well:

– Panel
Click "Start > Programs > Command Prompt" on the server and enter the "ipconfig" 
command using the screen keyboard. Press <Enter> to display the IP-address.

– For PC/Panel PC
Click on the server on "Start > Run", enter "Cmd", and press <Enter>. The command 
interpreter is displayed. Enter the "ipconfig" command. Press <Enter> to display the IP-
address.

5. If the "HTTPS" protocol type is selected, you can establish how the HTTPS-client verifies 
the properties of the server-certificate and how it should react in the event of error:

– "Allow invalid computer names for certificates"

– "Allow expired certificates"

– "Allow certificates signed by unknown publishers"

6. If the "Authentication required" option is selected on the HTTP-server, enter the user name 
and the password.

7. Enter the time for "Timeout" after which disconnection is identified.
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Result
A connection was created in the WinCC-Project of the HTTP-Client. For detail information for 
HTTPS-connection, refer to "Commissioning an HTTP- connection (Page 7463)".

Configure the HTTP-Client tags

Requirement
● An HTTP-connection was created in the WinCC-Project of the HTTP-Client.

● A tag is created in the WinCC-Project of the HTTP-Server. The data type of the tags is 
supported by SIMATIC HMI HTTP Protocols .

Procedure
To create tags on the HTTP-client, proceed as follows:

1. Open the "HMI- tags" folder in the project tree and double-click the entry "Standard-tag 
table". The "Tags" editor opens.

2. Enter a clear tag-name for "Name" in the Inspector window under "Properties > Properties 
> General".

3. Select the HTTP-connection for "Connection".

4. Select the data type for "data type".
The client does not check any verification of the tag name and the data type. Pay attention 
that the selected data type here matches the data type of the tags in the HTTP-server. For 
additional information, refer to "Permissible data types (SIMATIC HMI HTTP Protocol".
Array tags are not permitted.

5. Enter the exact name of the tag that is to be communicated with on the HTTP-server in the 
"Address" field.
If the tag to be addressed is in a sub-folder, the complete path along with tag name must 
be given as address, e.g.[folder name]\[Tag name]. 

Result
A tag was created in the WinCC-Project of the Client-HMI-device. The tag has access to the 
HTTP-server tag via an HTTP-connection. You can use an "E/A-Field" in an image to display 
the process value of this tag.
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Commissioning an HTTP- connection

Introduction
To establish an HTTP connection, you must perform the following actions:

● In the "Connections" editor of WinCC ES, configure the connection as an "https://" protocol 
type and define how the HTTPS client should verify the properties of the server certificate 
and respond to errors.

● Install a valid certificate on the HTTPS client.
Certificates are necessary for server authentication. Using certificates you can ensure that 
the server with which the connection is to be developed is actually the server for which it 
is outputting.           

Principle of an HTTPS connection
After runtime start, the HTTPS client establishes a connection to the HTTPS server. The 
HTTPS server presents its certificate, which the client verifies for authenticity. The session 
code that can only be read by the HTTPS server is then transmitted. The session code is now 
available on both sides and enables a symmetrical data encryption.

 

 Note

The certificate contains the current time. The current time can lead to problems if the time 
zones of the server and client are different. For example, a certificate generated on a server 
with an Asian time zone only becomes valid on a client with European time zone in the future 
(8 hours).

 

Preparation for installing a certificate on the client
With the first HTTPS client access, the HTTPS server generates the certificate itself and then 
saves it in the "Cert.cer" memory. The file is stored in the following directory:

● On a PC / Panel PC (with Windows XP) in the directory "<Runtime-Verzeichnis>
\SystemRoot\SSL"

● On Windows CE-based devices in the directory "Flash\Simatic\SystemRoot\SSL"

The certificate must be stored on the HTTPS client on a storage medium from which it can be 
launched with a double click. You can select from the following transfer options:
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Server Client Possible file transfer
with Windows XP
(PC, Panel PC)

with Windows XP
(PC, Panel PC)

● Diskette
● USB stick
● LAN (Ethernet)
● Internet Explorer (via TCP/IP if 

service is already running)
with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows XP
(PC, Panel PC)

● Memory card
● ActiveSync (serial)

with Windows XP
(PC, Panel PC)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

with Windows CE
( xP 277, MP 377, xP 177B,
Mobile Panel 177 PN, 
Mobile Panel 277, Comfort 
Panels)

● Memory card

Installing a certificate on a client with Windows XP
Insert the storage medium on which you have saved the "Cert.cer" file into the HTTPS client 
or open the directory in which the file is located. Double click on the file and follow the 
instructions in the Windows dialog.

Tip: The Internet Explorer provides an easy way to install a certificate. Connect to this device 
via HTTPS (e.g.: https://<my device>). The browser establishes if a certificate has not yet been 
imported. In this case, the browser asks if you want to install the certificate. Any faults in the 
certificate are displayed.

Installing a certificate on a client with Windows CE
Insert the memory card on which you have saved the converted "Cert.cer" file into the HTTPS 
client. WinCC includes the "InstallCert.exe" tool for importing certificates with Windows CE.

You can implement the installation as follows:

● In Explorer: 
Double click the "Cert.cer" file to install the certificate.

● At the command prompt:
Enter "InstallCert /[command parameter] [filename]".

– command parameters:
Parameter /r must be specified because the certificate used in WinCC Runtime 
Advanced is a root certificate. 
A root certificate is the main certificate and is used to verify the authenticity of all other 
certificates transferred.

– filename
You must specify the certificate file with its complete path (e.g. "\Storage Card\Cert.cer")
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A status alarm is output when you completed the installation. Runtime has to be restarted after 
the installation of a certificate on Windows CE- HMI devices with HTTPS clients. It is necessary 
to restart Runtime so that an HTTPS connection can be established.

The file "Cert.cer" cannot be opened.
The "Cert.cer" file generated at the HTTPS server cannot be opened on HMI devices based 
on Windows CE 5.0 by double-clicking the client.

1. Open the Control Panel.

2. Select "Certificates > My Certificates".

3. Click the "Import" button.
A dialog box opens. 

4. Select the "From a File" menu in the file browser and select the "Cert.cer" file.

 

10.16.4.6 Connection to the Office-world

Configuration

Data access via web service (SOAP) 
WinCC provides options for utilization of web-service (SOAP). Web service (SOAP) is based 
on the Simple Object Access Protocol. Use of this protocol enables an external application to 
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access tags of an HMI device via Ethernet. If the company network is protected by a Firewall, 
the system administrator must release the appropriate ports.

Figure 10-20 Communication with other applications

For example, a device is accessing two HMI devices. The operator sees the values of certain 
tags and can modify them. 

You can use Microsoft Excel, for example, to display tags. You will require the latest version 
of "MS SOAP Toolkit V2.0" for this purpose. This version is available from Microsoft as a 
download.   

The data access via SOAP is not supported by Windows 7. Use OPC to display the tags in 
MS Excel. For more information, refer to "Configuring OPC clients (Page 7554)".

Data access to Windows CE HMI-devices
The data access via the Web-service(SOAP) on Windows CE-HMI-devices functions using 
only the device name and not via the IP-address. 

Enter the device name of the HMI-device with the appropriate IP-address in the hosts-file. The 
hosts-file is given in the directory"%windir%\system32\drivers\etc\", z. B. C:\WINNT
\system32\drivers\etc.    

The device name, e.g.DEVICEMP377, must be set in the control panel on the HMI device 
under "System > Device Name". Please change the default device name to ensure that the 
device name is unique for the network.
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Example for the entry in the hosts-file:
192.168.56.198 DEVICEMP377

Replace the IP-address by the device name  in the SOAP-client:

objRuntime.mssoapinit http://DEVICEMP377/soap/RuntimeAccess?wsdl

Data access with GetValue, SetValue       
Access to a tag in SOAP using GetValue or SetValue functions require a special syntax.  

● GetValue: "Sinus_1"

● SetValue: Sinus_1

The tag name must be given in inverted commas for GetValue. The message "Runtime is 
offline" will otherwise be output when runtime is accessed.

 

 Note

Note that the tag name entry is case-sensitive.
 

Create VBA-Marko in MS Excel 

Introduction
Data access over the network via web service (SOAP) is to be used to permit certain tags of 
an HMI device to be displayed and reset.  

For this purpose, macros are written in Excel, which: 1) obtain the relevant tags on the PC 
over the network and display them, and 2) transfer reset values back to the HMI device.

The task can be solved using VBA macros "ReadTagValue" and "WriteTagValue," which obtain 
and display the relevant tags in Excel over an appropriate interface and return them to the HMI 
device over the network. Note that the tag name entry is case-sensitive.

Requirement
● The SOAP toolkit is installed.

● "Web-Service (SOAP)" is selected  in the WinCC-Project under "Services in Runtime".

Procedure
1. Insert the "Control element toolbox" toolbar in your workbook in Microsoft Excel.

2. Create a command button. Label the button "ReadTagValue" and name it "Read value".

3. Double-click this command button.
The macro editor is displayed. The "Click" event is already preset. 

4. Write the "ReadTagValue" macro ("intVarTag_1" designates the actual tag value):
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'--------------------------------------------------------------
Private Sub ReadTagValue_Click() 
 
Dim objRuntime 
Dim intVarTag_1 
Dim objWorksheet
 
Set objWorksheet = Excel.Worksheets("Sheet1") 
Set objRuntime = CreateObject("MSSOAP.SoapClient") 
objRuntime.mssoapinit "HTTP://servername/soap/RuntimeAccess?wsdl" 
objRuntime.ConnectorProperty("AuthUser") = "Administrator" 
objRuntime.ConnectorProperty("AuthPassword") = "100" 
Var = objWorksheet.Cells(1, 3) 
intVarTag_1 = objRuntime.GetValue(Var) 
objWorksheet.Cells(1, 1) = intVarTag_1 
 
End Sub
'---------------------------------------------------------------

 

1. Insert a command button. Label the command button "WriteTagValue" and name it "Write 
value".

2. Double-click this button.

3. Write the "WriteTagValue" macro ("intVarTag_1" designates the return value of the 
operation):

 
'---------------------------------------------------------------
Private Sub WriteTagValue()
 
Dim objRuntime 
Dim intVarTag_1 
Dim objWorksheet 
 
Set objWorksheet = Excel.Worksheets("Sheet1") 
Set objRuntime = CreateObject("MSSOAP.SoapClient") 
objRuntime.mssoapinit "HTTP://servername/soap/RuntimeAccess?wsdl" 
objRuntime.ConnectorProperty("AuthUser") = "Administrator" 
objRuntime.ConnectorProperty("AuthPassword") = "100" 
Var = objWorksheet.Cells(2,3) 
Value = objWorksheet.Cells(2,5) 
intVarTag_1 = objRuntime.SetValue(Var,Value) 
objWorksheet.Cells(2,8) = intVarTag_1 
 
End Sub
'---------------------------------------------------------------

Result
As soon as you call "ReadTagValue_Click" macro by clicking the button"Read-value", the 
specified intVarTag_1tag is obtained from the HMI device using the specified device address 
and displayed in the cell (1,1). 
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As soon as you call Macro "WriteTagValue" by clicking the "Write value" button, the tag name 
is read from the cell (2,3), and the tag value is transferred from cell (2,5) to the HMI device.

See also
Configuration in WinCC (Page 7398)

10.16.5 WinCC Server / WinCC Client

10.16.5.1 Guide to client server systems

Content
You can efficiently distribute operation and monitoring of your plant to multiple operator stations 
and servers. A WinCC Server with process connection records process data and logs alarms 
and process values. Moreover, a WinCC Server performs the following tasks in a WinCC 
network:

● Providing clients with the configuration data

● Providing clients with data from the process

Moreover, you can precisely map technologically or topologically complex systems.

This section  shows you:

● The system configurations you can implement with WinCC.

● How to configure the server and clients in the client/server system.

● How the client/server system reacts in runtime.

10.16.5.2 Clients and servers

Introduction
All process data of a WinCC project, e.g. alarms or trend values, is saved to different Runtime 
databases. Instead of being stored on each HMI device, these Runtime databases are located 
on the central WinCC server. The operator stations, i.e. the WinCC clients, access the WinCC 
server accordingly.

WinCC clients and WinCC servers are independent systems. You can activate WinCC clients 
at any time. It is also possible to activate and deactivate projects when you work on a WinCC 
client.
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Multiple-station system
You can user the server option to expand a WinCC single-station system to a high-performance 
multiple-station system with up to 32 coordinated operator control and monitoring stations.

Figure 10-21 Multiple-station system with up to 32 clients on one WinCC server

WinCC clients display the data of precisely one WinCC server with process connection. WinCC 
clients operating on a multiple-station system do not have an own project ("Client without 
project").  For this reason, it is not necessary to configure the clients. The WinCC server 
provides the process and log data, alarms, screens, and reports to its online WinCC clients.

Licenses required
● A WinCC license on the WinCC server.

● On the WinCC server, the " WinCC Server for RT Professional" license.

● On the WinCC clients, the "WinCC Client for RT Professional" license.

10.16.5.3 Plant configurations

Single-user system

Definition
An operator station has a view of its own project.

Visualize processes
10.16 Options

WinCC Professional V13.0
7468 System Manual, 02/2014



Application
Single-station systems are usually operated at the production level. They are used for operator 
control and monitoring of relatively small applications, but also for independent subprocesses 
or plant components within larger plants. A single-station system operates autonomously with 
its own screens and logs: all data are stored locally on one PC.

Structure

Figure 10-22 Single-station system

Single-station systems are based on the client-server principle:

● Runtime station: The WinCC data is stored in the integrated Microsoft SQL Server database 
on the operator station.

● The various Runtime components, including third-party components can access the 
Microsoft SQL Server database.

● Configuration PC: You can choose to use the actual operator station, or a different PC to 
configure your project.

Multi-user system

Definition
Up to 32 coordinated operator stations (WinCC clients) have a view of the same server project.

All WinCC data is stored in the integrated Microsoft SQL Server database on the WinCC server. 
Since the WinCC clients do not have their own WinCC project, they access the WinCC project 
on the WinCC server.
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Application
The same plant processes can be monitored on several operator stations (clients). Any user 
intervention on an operator station, e.g. value changes, is immediately visible on all other 
operator stations. A multiple-station system is typically configured for small and mid-sized 
plants in which distribution of data to several servers is not required.

Distribution of clients

● With different tasks: You operate and monitor different views of the same process, for 
example, process screens on one operating station and alarms on another operating station.

● With similar tasks: You monitor and control the same view of the process from several 
locations, for example, along a production line.

You use access rights to specify exactly which functions or plant sections are available to a 
given user on which operator stations.

Structure

Figure 10-23 Multiple-station system

The client-server technology makes it possible to easily separate WinCC clients from the 
WinCC server: Configure your project centrally in the TIA Portal on the engineering station 
and download it to the WinCC Server with process connection. The WinCC clients do not need 
a project planning, but merely a configuration:
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● Networking with the WinCC server using drag-and-drop.

● Separately for each WinCC client:

– Start screen

– Runtime language

– Toolbar

– Navigation buttons

– Deactivation of shortcut keys

– Window properties

The WinCC server automatically assumes the task of supplying the WinCC clients:

● Runtime environment

● Screens, process values, alarms, log data, and reports

● Interface with the automation system

● Communication and coordination of clients

● Logging

Process specifications or alarm acknowledgments on one operator station are consistently 
available to other operator stations.

10.16.5.4 Configuring a multiple-station system

Requirement

Requirement
● All HMI devices on a client-server system are interconnected via network (LAN) or ISDN 

and standard TCP/IP protocol.
You can also log on as client or server with PCs in adjacent subnets that are interconnected 
via router.

Server PC

● The server PC is connected to the automation systems via process bus.

● WinCC Runtime Professional is installed.
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● Operating system on the server PC:

– Microsoft Windows XP SP3, maximum 3 WinCC clients.
WinCC ServiceMode is not approved for this configuration.

– Microsoft Windows 7, maximum 3 WinCC clients

– Microsoft Windows 2003 SP2 Server, maximum 32 WinCC clients

– Microsoft Windows 2008 Server, maximum 32 WinCC clients

● Licenses:

– "WinCC Server for RT Professional" for the WinCC Server

– "WinCC RT Professional" for the project

Client PC

● A "WinCC Client for RT Professional" license on all WinCC clients.

●  

● A WinCC license on the WinCC server.

● The "WinCC Client for RT Professional" license on the WinCC clients.

●  

Configuration guidelines

Introduction
This chapter shows the basic procedure for setting up a multiple-station system. The multiple-
station system consists of a WinCC server and two WinCC clients.

Procedure
1. Configuring servers.

2. Configuring clients: Start screen, menus & toolbars, language & font

3. To enable users access to the WinCC server project from a WinCC client: Configure 
operator authorizations

4. Download the project to the server.

Configuring the server

Introduction
Set up a project as the WinCC server.
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Procedure
1. Create a project.

2. Add "WinCC RT Professional" to the HMI device.

3. Enter "WinCC Server" as the device name.

4. Configure the required screens, logs, tags, alarms, custom toolbars, project languages, 
etc. for the "WinCC Server".

5. In the Runtime settings under "General", select the start screen, a configuration and design 
for "Menus & Toolbars".

6. Under "Services", activate the server Runtime services you need for the specific 
configuration. Example: If the server screen displays recipes, select "Recipes".

7. Go to "Screens" to select the corresponding properties.

8. Under "Language & Font" select the Runtime languages required on the WinCC server.

Result
A project is set up and displayed on the WinCC clients. The project only becomes the server 
project when you link the "WinCC Server" with the WinCC clients.

Configuring the operator authorizations

Authorizations in WinCC
To enable access of a WinCC client to a server project, configure the appropriate operator 
authorizations for this WinCC client in the server project. The WinCC server provides the 
following operator authorizations:

● "Operate" The WinCC client is granted access to the WinCC server.

● "Enable remote control": A remote WinCC client can activate a server project, i.e. include 
it in runtime.

The computers on the network are not notified of a change to operator authorizations. This 
change is activated the next time a WinCC client wants to log on to a WinCC server.

The operator authorization "Enable remote control" is requested from the WinCC client as soon 
as the WinCC client requests activation of a project on a WinCC sever. If the corresponding 
operator authorization is not available on the WinCC server, the WinCC client is denied access 
to the project. Once the server project was closed on the WinCC client, a new logon is 
necessary at the next request to open the project.

 

 Note

The operator authorizations configured are user-related, not computer-related. An operating 
authorization assigned is therefore valid for all operating stations with the same login.
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Permissions in the operating system
To enable access of the WinCC clients to the server project, the corresponding project folder 
must be released for network access on the WinCC server. Set up authorizations in the 
operating system with all rights (write, read, modify) for the users who should have access to 
the projects. 

 

 Note

Different Windows permissions can be assigned for the shared project directories to enhance 
network security.

 

Detailed information on the assignment of permissions is provided in the Windows 
documentation.

Procedure
1. Open the WinCC user administration.

2. Select the user group of the user you want to edit.

3. To grant this user full access to the server project, activate the "Operate" and "Enable 
remote control" operator authorizations.

Configuring clients

Introduction
You create two WinCC clients and link them with the WinCC server.
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Procedure
1. Add the following HMI devices to the project:

– WinCC client, device name "WinCC Client1"

– WinCC client, device name "WinCC Client2"

2. In the "Devices & Networks" editor, "Relations" tab, link the two WinCC clients with the 
WinCC server by means of drag-and-drop. A multiple-station system will be created.

 

  Note

In contrast to connections, the physical connection (network) and logic connection (client-
server relation) are always created and deleted jointly. When you configure a relation, the 
devices will be linked automatically.

 

3. Select "WinCC-Client1".

4. In the inspector window, select Properties > Computer name" and enter the physical 
computer name of the HMI device.
The computer name identifies the HMI device in the network.

5. In the Runtime settings, "General" tab, select a screen as the "Start screen" of the WinCC 
server. In the multiple-station system, the WinCC client then displays this server screen in 
runtime.

6. Select a "Menus & Toolbars" configuration that was made on the WinCC server.

7. At "Services", activate the client Runtime services you need for the specific configuration, 
e.g. the scheduler.

8. Select additional design features under "Screens".
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9. Select a Runtime language for the WinCC server under "Language & Font". For example, 
you can configure a separate Runtime language for each WinCC client.

10.Repeat steps 3 to 9 for "WinCC Client2".

"Network data" editor
Using the arrow buttons below the network view, open the "Network data" editor.  The "Network 
data" editor displays the relations you created. You can edit and delete these relations. If you 
first select a device and then select "Project overview" from the shortcut menu in the "Network 
data" editor, only the relations of the selected device are displayed. 

Result
You have configured a multiple-station system with a WinCC server and two WinCC clients.

See also
Configuring an integrated connection in the "Devices & Networks" editor (Page 6148)
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Downloading the project to the server

Procedure
1. Compile the project using the "Compile" icon in the toolbar.

2. Once you successfully compiled your project, select "Project tree > WinCC Server" and 
then select "Download to device" from the shortcut menu of "WinCC RT Professional".

For the initial transfer, enter the computer's's target address "\\computer name\<shared 
folder>" in the next dialog and exit the dialog using the "Transfer" button.

A transfer to the WinCC clients is not necessary because the WinCC server provides all 
necessary data to the WinCC clients.

10.16.5.5 Characteristics in runtime

Characteristics (overview)

Editor characteristics in runtime                           
Logs

The Runtime database records and logs the process data on the WinCC server and 
simultaneously operates as log server. The WinCC clients receive their log data from the log 
server and display the data as table or graphics. All operations on the WinCC client are 
forwarded to the WinCC server. Processing results are returned to the WinCC client.

Screens

Data with other subsystems, for example, the log system are always exchanged locally. A 
screen can be opened and processed by several operating stations in runtime. 

Alarms

The "Alarms" Runtime database, which generates alarms on the WinCC server and logs these 
alarms, functions as an alarm server. The WinCC clients receive their alarms from the alarm 
server and display them together with log data in the alarm view or alarm window. 

When an operating acknowledges an alarm, the acknowledgement is transferred to the alarm 
server. The alarm server enters the change of status in the log and distributes the notification 
to all participating WinCC clients. The same process applies to the locking of alarms.

If an alarm server is temporarily unavailable in Runtime, an alarm window will open with a 
corresponding warning. When the alarm server becomes available again, alarms will be 
displayed in the alarm window once again.

Reports

The report system includes only print jobs which show log or process data based on Runtime. 

The report system is started automatically on all clients during startup. The WinCC server 
functions as a report server. During startup, the WinCC clients log on to the report server and 
obtain the latest information on available print jobs and their status. When a print job is started 
on a client (always local), it receives the corresponding data from the report server. The report 
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server, on the other hand, receives the status of the print job from the WinCC client. The report 
server then forwards this information to the other WinCC clients.

Runtime scripts

Project functions and standard functions of the WinCC server are always loaded and executed 
locally on the WinCC client.

Runtime user administration

The operator authorizations are checked by the Runtime component of the user administration. 
The Runtime component is automatically started on every computer when WinCC starts. On 
changes to the login, the current operating rights list is loaded.

Text library (project texts)

The Runtime text library runs on the WinCC server as a text server. The texts are always read 
from the database on the WinCC server.

Reaction to system errors
The WinCC clients are not provided any data if no WinCC server is available. All graphic objects 
that can be operated are grayed out and a connection error is displayed in the controls.

Scripts can be used to configure the display of connection errors on the WinCC client.

Once the WinCC server was recovered, the WinCC client will be reconnected.       

Delta compile in runtime
You create, change and test large, distributed projects with numerous operating stations mostly 
on a configuration computer. The finished and tested project is then transferred to the 
respective HMI device. The project is compiled or delta-compiled depending on whether or not 
the HMI device is in Runtime.

Compiling
The entire project is compiled, downloaded to the HMI device and it will replace the existing 
project.

Delta-compile (download changes) in Runtime
Instead of downloading the entire project or changing it locally, with a delta download the 
changes will be applied directly and locally in Runtime.

At any given time during, only the changed or added Runtime objects, e.g. tags, screens, 
alarms, and logs will be downloaded online to the active runtime of an HMI device, without 
stopping Runtime on that station. 

If you change a screen at runtime and download it to the HMI devices, for example, the modified 
screen is displayed automatically at the next screen selection in Runtime. 

The offline project on the configuration PC and the online project on the HMI device must be 
consistent.
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Field of application
Delta compile (download changes) offers the following options:

● During commissioning, operation, or maintenance, you edit the current project, download 
it to the HMI devices and immediately test it.

● You edit and download the project online at a central configuration station, instead of taking 
time-consuming local actions.

● You can first test the proposed changes on the configuration computer offline in a protected 
environment. Only then do you apply the changes in active operation. This approach helps 
you eliminate possible configuration errors before they result in downtime.

● Changes can be transferred consistently and take effect at the same time: Configuration 
changes are often interrelated and mutually dependent: they recalculate a value, create a 
corresponding tag and add it to a log and a trend display. These changes are completely 
closed and applied in full during operation. This approach prevents error states and 
instabilities in Runtime.

Characteristics of the server

Starting servers

General procedure        
The WinCC servers of a client-server system start independently of the WinCC clients. As 
soon as it has completed its startup, the WinCC makes its services available to the WinCC 
clients and informs itself about all the nodes on the network.

Communication with the automation system will be started.

If a WinCC server fails in runtime, the data on the WinCC client can no longer be updated. The 
WinCC clients will be informed of the absent WinCC server.

See also
Reaction to system errors (Page 7478)

Activating and deactivating projects on the WinCC server (Page 7483)

Server shutdown

General procedure      
When you shut down a WinCC server, it will no longer provide process data to the connected 
WinCC clients. The missing link is, for example, displayed in the alarm window or trend window 
of the active client projects. All fields with missing process values are displayed in gray in the 
process screen.
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See also
WinCC RT Start (Page 7482)

Characteristics of the client

Starting the Client

General procedure       
A WinCC client always remains in runtime, for example, regardless of whether the WinCC 
server is briefly unavailable. When using WinCCStart to start a WinCC client, the server project 
is also activated if the WinCC server is not in runtime.

See also
Activating and deactivating a project from the WinCC client (Page 7485)

Shutting down a client

General procedure       
Runtime is closed on the WinCC client, while runtime of the server project continues.

See also
Activating and deactivating a project from the WinCC client (Page 7485)

10.16.5.6 WinCC RT Start

Overview of WinCCStart

Application area
Using WinCC RT Start, you enable and disable Runtime on the WinCC server and display 
information about the installed product and components.
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Procedure
To open WinCC RT Start, follow these steps:

1. In the Windows Start menu, select "Start > All Programs > Siemens Automation > Runtime 
Systems > WinCC Runtime Professional V12 SP1 > WinCC RT Start".

Functions
● Activating and deactivating a project

● Autostart of WinCC Runtime

● Displaying installed products and components

Activating and deactivating projects on the WinCC server

Application area
You activate and deactivate Server Runtime on the WinCC server using WinCC RT Start.

To enable access from a WinCC client to the server project, the server project must be located 
in a shared folder. The "WinCCProjects" folder is released by default during installation:

Operating system Path
Windows 7 English C:\Users\Public\Public Documents\Siemens\WinCCProjects
Windows XP SP3 C:\Documents and Settings\All Users\Shared Documents\Siemens

\WinCCProjects
Windows Server 2003 C:\Documents and Settings\All Users\Shared Documents\Siemens

\WinCCProjects
Windows Server 2008 
English

C:\User\Public\Public Documents\Siemens\WinCCProjects

Windows Server 2008 C:\User\Public\Public Documents\Siemens\WinCCProjects
 

 Note

You can also use your own folders and release these with corresponding authorizations.
 

Visualize processes
10.16 Options

WinCC Professional V13.0
System Manual, 02/2014 7481



Requirement
● The WinCC client and WinCC server are interconnected via network.

● The server project is stored in the "WinCCProjects" folder, or in a different shared folder.

● WinCCStart is opened via the Windows Start menu, "Start > All Programs > Siemens 
Automation > Runtime Systems > WinCC Runtime Professional V12 SP1 > WinCC RT 
Start".

Procedure for activating a project
To activate the server project, proceed as follows:

1. Select the "File > Open" menu command. You can also click the file selection button in the 
"Project" field.

2. Select the server project. The name consists of the project name in the engineering system, 
e.g. "Project1", and the server name, e.g. "HMI_1".

3. You can select different diagnostic sources in the "Diagnostics" tab.

4. Activate the project using the toolbar icon . You can also activate the project using the 
"File > Start RT" menu. Activation of runtime is indicated by a checkmark leading the "File 
> Start RT" menu command.

The WinCC server is started and provides all necessary data to the WinCC clients.
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Procedure for deactivating a project
1. Deactivate the current project using the toolbar icon . The checkmark leading the "File 

> Start RT" menu command is cleared.

The modules for the execution of Runtime will be deactivated. The "WinCC Runtime" program 
window will be closed.

The WinCC clients are not provided any data if no WinCC server is available. All graphic objects 
that can be operated are grayed out and a connection error is displayed in the controls. Once 
the WinCC server was recovered, the WinCC client will be reconnected. 

See also
Loading a project (Page 6980)

Downloading the project to an HMI device (Page 7007)

Compiling a project (Page 6977)

Activating and deactivating a project from the WinCC client

Application area
Use WinCCStart to activate and deactivate runtime on the WinCC clients. 
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Requirement
● The WinCC client and WinCC server are interconnected via network.

● The is stored in a shared folder on the WinCC server. The "WinCCProjects" folder is 
released by default and displayed on the network.

● WinCCStart is opened via the Windows Start menu, "Start > All Programs > Siemens 
Automation > Runtime Systems > WinCC Runtime Professional V12 SP1 > WinCC RT 
Start".

Procedure for activating a project
To activate the server project, proceed as follows:

1. You can select different diagnostic sources in the "Diagnostics" tab.

2. Select the "File > Open" menu command. You can also click the file selection button in the 
"Project" field. The WinCC server "\\computer name\<shared folder>" is visible on the 
network.

3. Select the server project in the shared folder. The name consists of the project name in the 
engineering system, e.g. "Project1", and the server name, e.g. "HMI_1". A logon dialog 
opens when you connect to the WinCC server.

4. Enter the user name and password. Once you're successfully connected, the "Activate" 
toolbar icon is displayed if the WinCC server is not in runtime.
If the WinCC-Server is in runtime, the runtime of the WinCC client is started automatically. 
In this case, skip the next step.

5. Activate the server project using the toolbar icon . You can also activate the server project 
using the "File > Start RT" menu. Activation of runtime is indicated by a checkmark leading 
the "File > Start RT" menu command.
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Runtime of the WinCC server is started. Runtime of the WinCC client then starts automatically. 
The WinCC server provides all necessary data to the WinCC clients.

Procedure for deactivating a project
1. Deactivate the current runtime of the WinCC client using the toolbar icon . The checkmark 

leading the "File > Start RT" menu command is cleared.

The modules for the execution of Runtime will be deactivated. The "WinCC Runtime" program 
window will be closed.

 

 Note

When working on the WinCC client, you can only terminate runtime on the WinCC client, but 
not the project on the WinCC server.

 

See also
Shutting down a client (Page 7480)

Enabling time synchronization on the client (Professional)

Introduction       
You configure client-server systems with multiple clients and servers as needed in WinCC. 
You can efficiently operate and monitor large plants in this way. 

You have several options to ensure time synchronization in this system. 

The following shows how a client without its own project synchronizes the time via the server.  

Requirement
● A multi-user system is set up. 

● Time synchronization is set up on the server.

● No further time synchronization is enabled on the client.
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Procedure
Set up the startup list as follows:

1. Open the "Runtime settings > Services" editor.

2. Under "Additional tasks/applications", enter the "CCTMTimeSync.exe" application and the 
associated drive path. 
The file is stored in your Siemens installation directory.

3. Disable "Use project directory".

4. Specify the startup size of the task or application window in the "Window style" column, for 
example, minimized, maximized or standard size. 

Result
When you start Runtime, the application is loaded. The time of the client is automatically 
synchronized with the server.

Additional settings: Autostart and language

Introduction
The "Autostart" function automatically starts the server project at the time the server PC starts. 
Moreover, you can prevent users from canceling the start of runtime in order to gain 
unauthorized access to the operating system. To run this setup, you need a corresponding 
operator authorization in WinCC. 
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You can change the runtime language.

Procedure for Autostart 

1. Go to the "Autostart" tab.

2. Activate "Autostart".

3. Select a server project in the "Settings" area.
If you restart the computer with a project, the automatic start of runtime is initiated at the 
end of the load operation. You can prematurely cancel the automatic start and return to the 
operating system by pressing the "Cancel" button.

4. To prevent an operator from canceling the automatic start, deactivate "Allow cancelling of 
activation".

5. Click the "Apply" button. A Logon dialog opens.

6. Log on.

After you successfully logged on, server runtime is started automatically at the next restart of 
the WinCC server.

Language change procedure
1. Select the "View > Language" menu command. A dialog that displays all user interface 

languages available for WinCCStart opens.

2. Select a user interface language.
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Displaying products and components

Introduction
You can view your installed product software and options on the products tab:

The "Component" tab displays the following installed objects:

● Add-on software WinCC tools

● Interfaces

● Drivers
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● Databases

● Logs

Procedure
1. Select "Help > About". The "About WinCC SCADA RT" dialog opens.

2. Select a tab.

10.16.5.7 SIMATIC Shell

Remote Configuration

General procedure     
Clients provided with the corresponding operator authorizations can operate a server project 
from a remote station, e.g.:

● Enable a server project

● Disable a server project
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For remote configuration, the "Simatic Shell" dialog is available which you access through 
Windows Explorer. 

Function of Simatic Shell
In the "Simatic Shell" dialog you can view the enabled servers and projects of your client-server 
system available through the network. These include all projects which run under a demo 
license. 

The window can be used to access an enabled server project from a client:
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● to enable a project remotely

● to disable a project remotely
 

  Note
Different names with WinCC Start and SIMATIC Shell

When WinCC Start opens, the name of a client-server project is fully displayed with the 
name of the server PC as the ending, for example, "ClientServerProjectBuild11_1_A-
Server_1". 

SIMATIC Shell does not show PC names under "Object"; it shows the name of the server 
PC on which the client-server project is running, for example, "A-Server_1". This means 
different client-server projects can be referred to with the same object name. 

 

Accessing a computer outside a subnet

General procedure     
Computers located behind a router in a network may be introduced to the system by using the 
"Simatic Shell" dialog.

 

 Note

You use the "Simatic Shell" dialog for central maintenance and diagnostics of all computers 
integrated in your client/server system. 

 

Using the settings in "Simatic Shell", you introduce a computer within your subnet behind your 
router as an "Agent" who distributes the information from other computers to the computers 
within the subnet.

After having logged this computer on, all participating computers in the system can 
communicate even beyond the router limits. Each computer added to an existing group is 
informed of the current status of all computers, including those beyond the router limits. When 
the status of a computer changes, a alarm is issued to all participants, e.g.:

● If a computer has enabled a project

● If a computer is shut down.

● If a computer is started up and thus enters the group.
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Procedure
1. Click on the folder "My Computer > Simatic Shell" in the Windows Explorer of the client 

computer. The "Simatic Shell" dialog opens.

2. Select the "Settings" menu command in the shortcut menu of an entry in the navigation 
window. If no entry is displayed, open the shortcut menu in an empty window. The "Selection 
of the terminal bus" dialog opens. 

3. Check the setting in the field "Multicast Lifetime (TTL)". The value gives the maximum 
number of route jumps between various subnets (IP Parameters TTL).

4. Under "Multicast Proxy", enter the address of the computer that is the "Agent" for the subnet. 
This can be any computer of the subnet (client or server).

5. Add the computer to the list of network partners with the "Add" button.

6. Confirm your entry with "OK".

Activating a project

General procedure        
A client/server system makes it possible to enable and disable projects remotely. 

If you enable a server project from a client by using the "Simatic Shell" dialog, only the server 
project is enabled. 
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Requirements
In order to activate a server project on a client, the following conditions must be fulfilled:

● The user logged onto the client has the operator authorization to "Activate remote" in the 
WinCC project on the server.

● The project has been enabled for network access

Procedure
1. In Windows Explorer of the client, select the "Simatic Shell" entry. The "My Computer > 

Simatic Shell" window will be displayed. 
All the servers and projects available in the network with their current status will be 
displayed.

2. Select the project to be enabled.

3. Select the "Activate remote" command from the shortcut menu. 
A Login dialog appears.

4. Enter the user name and password for the current computer. The project is enabled on the 
server.

Deactivating a project

General procedure     
A client/server system makes it possible to enable and disable projects remotely. 

If you disable a server project from a client by using the "Simatic Shell" dialog, only the server 
project is disabled.

Requirements
In order to deactivate a server project on a client remotely, the following conditions must be 
fulfilled:

● The user logged onto the client has the operator authorization to "Activate remote" in the 
WinCC project on the server.

● The project has been enabled for network access

Procedure
1. In Windows Explorer of the client, select the "My Computer > Simatic Shell". The "Simatic 

Shell" window is displayed. 
All computers and projects available in the network will be displayed with their current status.

2. Select the project to be enabled.

3. Select the "Deactivate remote" command from the shortcut menu. A Login dialog appears.

4. Enter the user name and password for the current computer. The project is disabled on the 
server.
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10.16.6 WinCC WebNavigator

10.16.6.1 Unsupported functions
The following list is only an excerpt of the unsupported functions. The lists contains the 
functions which are explicitly declared as unsupported. 

Functions     

GetHWDiag OnDeactivateExecute ReportJob
GetHWDiagLevel OnErrorExecute RPTJobPreview
GetKopFupAwl OnTime RPTJobPrint
GetKopFupAwlLevel OpenPrevPicture RptShowError 

VBScript functions
● HMIRuntime.Stop: Terminates Internet Explorer and WinCCViewerRT, however not 

WinCC Runtime.

● AlarmLogs object

● DataLogs object

● Logging object

● Project object

Functions that are unnecessary:
● DeactivateRTProject: Terminates Internet Explorer and WinCCViewerRT, however not 

WinCC Runtime.

● ExitWinCC

● FillDiagnoseInTags

● InquireLanguage

● TraceText

● TraceTime

Other functions
These functions are contained in the range of functions in order to guarantee error-free 
compilation on the WebNavigator client.  The functions are not supported by the WebNavigator 
client.

AXC_OnBtnHornAckn GetCursorMode GmsgFunction 
AXC_OnBtnPrint SetCursorMode MSRTMsgWinCommand
AXC_OnBtnProtocol  TlgTableWindowPressHelpButton
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10.16.6.2 The basics

Function Overview

Introduction
You can use the WinCC WebNavigator option of WinCC Runtime Professional to monitor and 
control your WinCC project via the Intranet/Internet. This enables you to quickly and easily 
implement a new type of distribution of controlling and monitoring functions of your automation 
system. WebNavigator supports current Internet security methods.

The "WebNavigator" add-on package consists of the following components:

● WinCC WebNavigator Server

● WinCC Web Configurator

● WinCC WebNavigator Client

● WinCCViewerRT

WinCC WebNavigator Server
The WebNavigator server is installed on a PC along with WinCC Runtime Professional. The 
required WinCC screens and functions that are displayed on the WinCC WebNavigator Client 
are stored on the server PC. 

WinCC Web Configurator
The WebNavigator Server needs the Microsoft Internet Information Service (IIS) for 
communication with the WebNavigator Clients. The IIS is set up and managed with the WinCC 
Web Configurator. Accesses of the WebNavigator Client are governed via user administration. 
You can set a different start screen and language for every user. By assigning user 
authorizations, a scalable access to different project areas and functions is implemented for 
the various users.

WinCC WebNavigator Client
The WebNavigator Client is started via the MS Internet Explorer with activated ActiveX 
controls. You control and monitor a running WinCC project without the entire WinCC basic 
system on the PC.

WinCCViewerRT
Instead of the Internet Explorer, you use the Web viewer "WinCCViewerRT" to visualize the 
WinCC project.

WebNavigator diagnostics client
You can use the diagnostics client, for example, for the maintenance of several WebNavigator 
server.
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Licensing
Licensing is managed centrally on the WebNavigator Server in accordance with the number 
of concurrent accesses of 3, 10, 25, 50, 100 or 150 WebNavigator Clients, for example. A 
license is not required on the WebNavigator Clients.

Web Navigator Server on the WinCC server

Structure  
WinCC RT Professional and the server components of the WebNavigator are installed on a 
PC. The WebNavigator client can control and/or monitor the current server project both via the 
Internet and the Intranet. 

To protect against attacks from the Internet, two firewalls are employed. The first firewall 
protects the WebNavigator Server from Internet attacks. The second firewall provides 
additional security for the Intranet.
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WebNavigator diagnostics client

Introduction
The WebNavigator diagnostics client enables cost-effective access to several WebNavigator 
Servers. 

Several diagnostics clients and standard clients can be in operation at the same time. This 
procedure does not demand an additional license for a WebNavigator Server because 
licensing is handled on the diagnostics client. The diagnostics client can always access the 
WebNavigator server, regardless of whether the maximum number of simultaneous accesses 
has been reached. The diagnostics client always has guaranteed access to the WebNavigator 
server.

Possible applications:

● Remote maintenance: With the Diagnostics Client, different WinCC systems are accessed 
for service and maintenance purposes.

● Central Control Room: The diagnostics client is used for simultaneous access to several 
servers.

Diagnostics client

WinCC / WebNavigator Server

WinCCViewerRT

Overview     
Don't use Internet Explorer to run the "WinCCViewerRT.exe" application. Run it on the 
WebNavigator client instead. The WinCCViewerRT is installed along with the WebNavigator 
client.

WinCCViewerRT uses its own communication to access the WebNavigator server. This 
prevents Internet users from accessing the system and protects the system against viruses 
and Trojan horses. 
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Only the screens which are configured for Web access and published on the WebNavigator 
server are displayed. Users can operate and monitor the project, depending on their 
authorizations.

A user assigned authorization 1002 "Web access - view only" is only allowed to monitor the 
project. The WebNavigator client is therefore a so-called "View Only Client". 

The cursor is a "View only cursor" and indicates that process-related operations are not 
possible. Certain operations are still possible, such as opening the properties dialog of an 
online trend control. 

You can also use WinCCViewerRT as terminal server application. For more information, refer 
to "Setting up terminal services for WebNavigator servers".

Terminal services and Web Navigator

Introduction
Terminal services in the Windows Server operating systems enable access to the desktop of 
a Windows server. 

The terminal client only handles screen output, while the application runs on the terminal 
server, for example WinCCViewerRT.

The terminal services transmit only the user interface of the application to the clients. Each 
client's keyboard inputs and mouse operations are returned back to the server.

This behavior has the following advantages:

● Use of rugged hardware for the clients, for example without fans and hard drives, for 
application in dusty environments.

● Use of mobile clients with limited power consumption, for example handhelds, palmtops, 
PDA.

● All applications are located on the server in a secure environment.

● Easy, central administration and system maintenance.

● Support of different operating systems, for example Windows CE, Windows 95.
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The WebNavigator client created based on a "THIN²" architecture, i.e. the application running 
in multiple instances on the terminal server, e.g. WinCCViewerRT, is itself already "thin" with 
regard to hardware requirements.

For redundant system configurations with terminal services, please consult the corresponding 
Microsoft documentation.

 

 Note

The terminal client supports only 256 colors.

To reduce the strain on the terminal service, avoid large bitmaps whose size can change 
("live video"). 

 

10.16.6.3 Installing WebNavigator

Software and hardware requirements

Introduction                       
This section describes the hardware and operating system requirements for WinCC 
WebNavigator. 

WebNavigator Server on a WinCC single-user system 

Table 10-175 Hardware

 Minimum Recommended
CPU Intel Pentium 4; 2.5 GHz Intel Pentium 4; 3 GHz Dual Core
Working memory 1 GB 2 GB

Table 10-176 Software

Operating system: Windows 7 Professional, Enterprise, Ultimate, Embedded Standard 
SP1 (max. 3 clients)
Windows 8.1 Professional, Enterprise
Windows Server 2008 R2 Standard Edition SP1
Windows Server 2012 R2 Standard Edition

Software: Internet Explorer as of V8.0
WinCC V13 Runtime

Miscellaneous: Access to the intranet/Internet 
or TCP/IP connection to the WebNavigator client 
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WebNavigator Server on the WinCC server

Table 10-177 Hardware

 Minimum Recommended
CPU Dual Core; 2 GHz Multi Core; 2.4 GHz
Working memory 2 GB 4 GB

Table 10-178 Software

Operating system: Windows Server 2008 R2 Standard Edition SP1
Windows Server 2012 R2 Standard Edition

Software: Internet Explorer as of V8.0
WinCC Professional V13

Miscellaneous: Access to the Intranet / Internet
If you publish in the intranet, you need a system for name resolution, 
which can convert computer names into IP addresses. This allows 
users to use alias name instead of IP addresses when connecting to 
the server.
If you publish on the Internet, you need a DNS registry for the IP 
address. This allows users to use alias name instead of IP addresses 
when connecting to the server.

WebNavigator Client

Table 10-179 Hardware

 Minimum Recommended
CPU Intel Pentium 4; 2.5 GHz Intel Pentium 4; 3 GHz
Working memory 1 GB 2 GB

Table 10-180 Software 

Operating system: Windows 7 (Professional, Enterprise, Ultimate, Embedded Standard) SP1
Windows 8.1 (Professional, Enterprise)
Windows Server 2008 R2 Standard Edition SP1
Windows Server 2012 R2 Standard Edition
Other operating systems such as WinCE, Win95 via MS Terminal Services
Embedded XP in connection with Panel PC 477

Software: Internet Explorer as of V8.0
Miscellaneous: Access to the intranet/Internet 

or TCP/IP connection to the WebNavigator Server 

The use of the WebNavigator Client via WLAN is only authorized for the SIMATIC Mobile Panel 
PC 12".
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Web diagnostics client

Table 10-181 Software

Operating system: Windows 7 (Professional, Enterprise, Ultimate, Embedded Standard) SP1
Windows 8.1 (Professional, Enterprise)
Windows Server 2008 R2 Standard Edition SP1
Windows Server 2012 R2 Standard Edition

Software: Internet Explorer as of V8.0 
Miscellaneous: Access to the Intranet / Internet

Licensing

WebNavigator Client             
No license is required with server-end licensing on the WebNavigator Server on the PC with 
the WebNavigator Client. 

WebNavigator Server
The WebNavigator server runs without a license in Demo mode for 30 days.
A license is required, however, if you want to use the WebNavigator server for a longer period. 
Licenses are available for 1 / 3 / 5 / 10 / 25 / 50 / 100 / 150 clients that can simultaneously 
access the WebNavigator server. 

If the number of licensed clients is exceeded during a logon attempt of a Web Navigator client, 
a message appears. No further logon is allowed.

Overview of licenses on the server and client

Server WebNavigator Client Diagnostics client
WebNavigator server license + 
WinCC license

Web Navigator client, no local 
license required.
Maximum number of clients 
corresponds to the existing 
license on the server.

Diagnostics client 
One license per diagnostics 
client

Web diagnostics server license + 
WinCC license

WebNavigator client in Demo 
mode
Number unlimited
Valid for 30 days

Diagnostics client 
One license per diagnostics 
client

No WebNavigator license or 
no WinCC license

WebNavigator client in Demo 
mode
Number unlimited
Valid for 30 days

Diagnostics client in Demo 
mode 
Number unlimited
Valid for 30 days
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Restarting the Web client after changing licenses
If you change the WebNavigator licenses on the Web Navigator server, for example, by 
transferring a Powerpack, you must restart the Web viewer or Internet Explorer, if it used, on 
all connected WebNavigator Clients. Otherwise, the WebNavigator Client goes to Demo mode. 
This also applies to automatic reconnection of the WebNavigator Client.

Web diagnostics client
A diagnostics client license is required on the client PC for the diagnostics client. The 
diagnostics client can simultaneously access up to 12 WebNavigator Servers. 

When a license for WebNavigator Server or Web diagnostics server is installed on the server, 
the diagnostics client also has access even when the maximum number of clients is exceeded.

Web diagnostics server
This license allows the diagnostics Web client to access the WebNavigator Server when no 
WebNavigator Server license is installed on the Web Navigator server for the WebNavigator 
Client.

A total of 50 clients per server is allowed at the most for simultaneous access by diagnostics 
clients.

 

 Note
Diagnostics client without corresponding license

If you install the diagnostics client without its license, a message appears approximately 1 
hour after each start of the PC. Install the diagnostics client license or remove the diagnostics 
client software.
PC with WinCC Runtime Professional and diagnostics client

If you install a diagnostics client on a PC with WinCC Runtime Professional, you have to 
reinstall the diagnostics client after removing WinCC.

 

Requirements for the Use of Terminal Services
WebNavigator Client is authorized for use with Windows Terminal Services. A maximum of 25 
sessions per terminal server are permitted.     

Terminal server

Table 10-182 Hardware

 Minimum Recommended
CPU Dual Core CPU; 2 GHz Multi Core; 2.4 GHz
Working memory 2 GB 4 GB
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Table 10-183 Software

Operating system Windows Server 2008 R2 Standard Edition SP2
Windows Server 2012 R2 Standard Edition:
It must be possible to open and execute applications that are run on 
the clients multiple times.

Miscellaneous: If numerous users want to access the server, you need to use a high 
performance network adapter. 

 
 

 Note

The memory requirements and processor load increased with each terminal client. You 
therefore need to ensure that the terminal server has adequate memory and processor load 
reserves. 

 

Terminal client

Minimum requirement: Network adapter with TCP/IP
Terminal client RDP 5.0
Display or screen
Pointing device

Device recommended for use as a client: SIMATIC Mobile Panel PC 12".
 

 Note

As is the case with Windows Server Client Access License CAL, there are two different 
terminal service CALs:
● The TS Device CAL permits one device user-independent Windows sessions on a 

Windows server.
● The TS User CAL permits one user device-independent Windows sessions on a Windows 

server.

A Windows Server Terminal Server "TS CAL" is required for every user or every device.

You can find additional information under "http://www.microsoft.com/licensing/about-
licensing/client-access-license.aspx".
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Installation of WebNavigator server

Overview

Requirements
● The software requirements with regard to the Windows operating system apply.

The following operating systems have been authorized: 
Windows 7 (Professional, Enterprise, Ultimate) SP1
Windows 8 (Professional, Enterprise)
Windows Server 2008 R2 Standard Edition SP2
Windows Server 2012 R2 Standard Edition

● Local administrator rights

Installation sequence for the WebNavigator Server
When you install a WebNavigator Server on a PC, adhere to the following installation sequence:

1. Install the Internet Information Service (IIS).

2. Install the WebNavigator Server.
To install the WebNavigator Server, you also need to install WinCC Runtime Professional. 
Microsoft SQL Server is automatically installed.

Installing Internet Information Services (IIS)

Settings    
Before installing the WebNavigator Server, you need to install the Internet Information Service 
(IIS). You specify the settings for the WebNavigator Server during installation.

Activate the following settings under Windows 7 or Windows Server 2008:

● Web Management Tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– IIS compatibility to IIS metabasis and IIS 6 management

– Compatibility with WMI for IIS 6

● WWW Services > Shared HTTP Features:

– Standard document

– Static content
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● WWW services > Application development features:

– ASP

– ISAPI extensions

– ISAPI filters

● WWW services > Security:

– Request filter

– Standard authentication
 

  Note

If the logging functions are active with IIS, the log files must be monitored and deleted, 
if necessary. The event views should be configured so that the log files do not become 
too large.

 

Requirements
● Administrator rights

● Write access for the registration database

Procedure
1. Open the dialog for the activation of Windows features from the Windows 7 Control Panel. 

In Windows Server 2008, use the settings for the server manager. For detailed information, 
refer to the help of the operating system.

2. In the settings for the Internet Information Services, enable the settings described above.

3. Close the dialog with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

Alternative procedure
You can also use the command line "Start > Run > cmd" to install the IIS components located 
on the installation CD:

pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
RequestFiltering;IIS-StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-
ASP;IIS-ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-
WindowsAuthentication;IIS-ManagementConsole;IIS-ManagementService;IIS-
IIS6ManagementCompatibility;IIS-Metabase;IIS-WMICompatibility

Installing the WebNavigator Server

Requirements   
● Local administrator rights

● Internet Information Service is installed.
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Procedure
1. Insert the installation disk into the appropriate drive.

Setup runs automatically unless you have disabled autostart on the PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog to select the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The corresponding help file opens with instructions.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for the selection of product languages opens.

6. Select the languages for the product user interface, and click the "Next" button. The dialog 
for selecting the product configuration opens.

 

  Note

"English" is always installed as the basic product language.
 

7. Select the following components for installation:

– WinCC Runtime Professional

– WebNavigator Server

8. Choose whether you want a desktop shortcut to be created, and select a different 
destination directory for the installation if needed. Note that the length of the installation 
path must not exceed 89 characters.

9. Click the "Next" button.
The dialog for the licensing conditions opens.

10.To continue the installation, read and accept all license agreements and click "Next".
In the event that the security and permission settings need to be changed for the installation, 
the dialog for the security settings opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.

12.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking "Next".
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13.Click the "Install" button.
The installation begins.

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

14.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

15.If the computer does not reboot, click "Exit".

Result
WinCC Runtime Professional and the WebNavigator Server are installed.

Installation of WebNavigator client

Installing the WebNavigator Client

Introduction         
You can install the WebNavigator Client as follows: 

● Installation from the WinCC Runtime Professional Product DVD.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via Intranet/Internet.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation without user interaction:

– With the Windows user rights of the current user

– Or using group policy based software distribution in networks

You can also install the WebNavigator Client additionally on the WebNavigator server . This 
is useful, for example, if you want to check your WinCC project locally on the server in the 
Internet Explorer.

WinCCViewerRT
The "WinCCViewerRT" web viewer is installed together with the WebNavigator Client.
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Procedure
1. Entry and check of the settings of the client computer in Internet Explorer.

2. Installation of the WebNavigator Client.
 

  Note

When you install from the DVD or through group policy based software distribution, you 
can upgrade an older version of the WebNavigator Client directly without removal.
If you install Web Navigator Server on a computer after the WebNavigator Client, you 
need to reinstall the client.

 

Information on setup and installation of the WebNavigator Client:
● The setup of the WebNavigator Client is interrupted with the error message "WinCC Active" 

if the local WinCC project is open or has been opened since the PC was last restarted. 
Restart the computer. Check if WinCC has been entered in the Autostart directory. Remove 
the item, if required, and then reboot the computer to run the WebNavigator Client 
installation.

● At least 70 MB free disk space must be available on the local hard drive to install the 
WebNavigator Client. Otherwise, the installation aborts with a message.

● When installing the WebNavigator Client by downloading it from the Intranet/Internet, you 
can select between "Open" and "Save" for the Setup file. If you install plug-ins or ActiveX 
controls at a later time, you need to select the procedure used for installing the 
WebNavigator Client the first time. Otherwise, the error message "Error 1316" of the "MSI 
Installer" service appears.

● In the download area of the Web Navigation user interface, the Plug-Ins which can be 
installed are displayed. At least the same minimum user rights are required as for 
installation of the WebNavigator Client to install this plug-in. If you select a plug-in in the 
Web Navigation user interface, the WebNavigator Client Setup starts. You have to confirm 
the selected plug-in again.

Installing the WebNavigator Client under Windows Server
You cannot install the WebNavigator Client under Windows Server with user rights lower than 
"Administrator" with the default setting for group policies. 
In the group policies, release the installation of WebNavigator Client by

● Assigning and publishing the software

● Or, under "Administrative Templates / Windows Components / Windows Installer", enabling 
the setting "Always install with elevated privileges". You must activate "Never" for the 
"Disable Windows Installer" option.
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User rights, user groups and optional installation possibilities

Windows user rights required for installation and initial registration of the WebNavigator client
"Administrator" rights are required to install the WebNavigator client via Intranet/Internet or 
using the WinCC Runtime Professional Product DVD. For the initial registration of the client 
on the WebNavigator server, you need to use the same name as that used during installation 
and must log on with the same or higher Windows user rights. The connections must be 
established successfully. All subsequent logons can then be performed by users with different 
Windows user rights, which may be more restricted. 

Installing the WebNavigator client with restricted user rights
With the employed MSI technology, you can also install the WebNavigator client with restricted 
Windows user rights. This procedure can be set during the installation using the group policy 
based software distribution in networks.

The add-ons and plug-ins for the WebNavigator client can also be installed this way.

Installation for a configured group of users or computers
Using the Microsoft Systems Management server or group policy on a Domain Controller, it is 
possible to install a group of users or computers configured by the Administrator.

● For this the MSI file "WinCCWebNavigatorClient.msi" is published at the Domain Controller 
and enabled for a user group. Then, depending on the configuration of the group policy 
based software distribution, you perform the installation either during logon of the specified 
users or when the computer boots.

● When using a Microsoft Systems Management Server, the installation is configured by the 
administrator, triggered and executed when the relevant computer boots.

Group policy based software distribution
The software installation is normally executed with the access rights of the current Windows 
user. When using MSI technology, the installation is performed by an operating system service 
with a higher level of rights. This enables you to perform installations for which the Windows 
user is lacking permission. Applications which require installations with a higher-level 
permission are referred to as "privileged installations" in MSI technology. Installation of these 
applications is possible when a Windows user is assigned the "Always install with elevated 
privileges" permission. 

To use group policy based software distribution, a group policy is created on the domain 
controller. The software to be distributed is assigned or published using the active directory . 

● Assignment: The software distribution can be assigned to a user or a computer. The 
software to be distributed is automatically installed when the user logs on or computer boots.

● Publication: The software distribution can be published for single users. When the user logs 
onto the client computer, the software to be distributed appears in a dialog and can be 
selected for installation.
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Installation without user interaction
During installation of the WebNavigator client, the user is normally prompted to enter 
information, for examples, about the components to be installed. By implementing a 
configuration file, installation is possible without user interaction. The required path 
specification and user information are provided in the "options.ini" configuration file. The file 
must be in the same folder as the WebNavigator client Setup. 
This installation procedure is advantageous when using the group policy based software 
distribution. 

Installation from the product DVD requires user interaction. 

The settings given predefined in the table are used under the following conditions: 

● The "options.ini" configuration file is missing and there is no corresponding entry available 
in the client registry, for example, due to another SIMATIC HMI product installed.

● Alternatively, the installation is performed via the group policy based software distribution 
with assignment to the computer.

Information Parameters
Target directory for the WebNavigator client INSTALLDIR=" <syspath1>\Siemens\Automation

\SCADA-RT_V11\WinCC\WebNavigator"
Target directory for common components COMMONDIR=" <syspath2>\Siemens "
User information / user name USER
User information / organization COMPANYNAME

The "<syspath?>" parameter is derived from the setting in the registry under the key 
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion":

●  "<syspath1>" corresponds to the key "ProgramFilesDir" e.g. "C:\\Program Files"

●  "<syspath2>" corresponds to the key "CommonFilesDir", e.g. "C:\\Program Files\\Common 
Files"

Example of a "options.ini" configuration file for Windows 7
 
[USERINFO]
USER=Integration 
COMPANYNAME=Siemens AG
 
[INSTALLPATH]
COMMONDIR="C:\Program Files\Common Files\Siemens"
INSTALLDIR="C:\Program Files\Siemens\Automation\SCADA-RT_V11\WinCC
\WebNavigator"
 
[FEATURES]
FUNCTIONTRENDCONTROL=0
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HARDCOPY=0
WINCCUSERARCHIVES=0
DEU=0
FRA=0
ITA=0
ESP=0

Internet Explorer Settings

Introduction    
To have the full functionality available on the WebNavigator client, you need to adapt the 
security settings in Internet Explorer. 

Procedure
1. Click "Tools" > "Internet Options" in the Internet Explorer.

2. Select the "Security" tab. Select the corresponding zone, e.g. "Local Intranet" or "Internet".
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3. Click "Custom Level".

4. Select the options "Script ActiveX controls marked safe for scripting" and "Download signed 
ActiveX controls".

5. Select the "Active Scripting" option under "Scripting".

6. Click "OK". Carry out the modifications in the subsequent dialog.

7. Select the "Trusted Sites" icon. Open the "Trusted Sites" with the "Sites" button.

8. Enter the address of the WebNavigator server in the "Add this Website to the zone" field. 
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com". If necessary, clear the "Require server verification for all sites in this zone 
(https:) check box. Click "Add". Click "Close".

9. Select the "Trusted Sites" icon. Click the "Standard level" button and then the "Custom 
Level" button. Activate the "Activate" option under "Initialize and script ActiveX controls not 
marked as safe". Click "OK".

10.Click on the "General" tab. Click on the "Settings" button in the "Browser History" area . 
Select the "Automatic" option under "Check for newer versions of stored pages". Click "OK".

11.Close the "Internet Options" dialog by clicking "OK".
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Installation from the DVD

Requirements   
● The information provided in Auto-Hotspot applies to the installation and use of the 

WebNavigator client.

● Minimum user rights are required to install the WebNavigator Client depending on the 
operating system, see Auto-Hotspot.

Procedure
1. Insert the installation disk into the appropriate drive.

Setup runs automatically unless you have disabled autostart on the PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog to select the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The corresponding help file opens with instructions.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for the selection of product languages opens.

6. Select the languages for the product user interface, and click the "Next" button. The dialog 
for selecting the product configuration opens.

 

  Note

"English" is always installed as the basic product language.
 

7. Open the program group "SIMATIC WinCC Web Navigator" and select the "Web Navigator 
Client" component.

8. Choose whether you want a desktop shortcut to be created, and select a different 
destination directory for the installation if needed. Note that the length of the installation 
path must not exceed 89 characters.

9. Click the "Next" button.
The dialog for the licensing conditions opens.

10.To continue the installation, read and accept all license agreements and click "Next".
In the event that the security and permission settings need to be changed for the installation, 
the dialog for the security settings opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.

12.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking "Next".
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13.Click the "Install" button.
The installation begins.

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

14.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

15.If the computer does not reboot, click "Exit".

Result
The WebNavigator Client is installed and has been added as a function in the navigation 
window of the WinCC Explorer.

Installation via the Intranet/Internet

Requirements   
● The information provided in Auto-Hotspot applies to the installation and use of the 

WebNavigator client.

● Minimum user rights are required to install the WebNavigator Client depending on the 
operating system, see Auto-Hotspot.

● WebNavigator Server must be installed on a computer. The Internet Information Server 
must be configured with the WinCC Web Configurator. Users must be registered in the 
WinCC User Administrator. The WinCC project must be in runtime.

Procedure
1. Enter the address "http://www.servername" for the WebNavigator Server in the address 

bar of Internet Explorer. When installing in a virtual directory, the address can be as follows: 
"http:// www.servername/WebNavigator/".

2. Enter the user name and the password.
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3. If you are accessing the WebNavigator Server for the first time, you will be prompted to 
install the WebNavigator Client. Click the "Click here to install" link. Click the "Save" button 
in the "File Download" dialog to store the client setup on the target computer. It is 
recommended to save the Setup file because, in the event of a restart of the client computer 
being necessary, the Setup need not be downloaded again.

 

  Note

If you want to install a more current version for an existing WebNavigator client via the 
Intranet/Internet, go directly to the client setup. You do not need to save the installation 
file on the target computer. If you want to save the new installation file, remove the old 
installation file. Or save the new version of the file in another directory.

 

4. Leave the Internet Explorer open and open Windows Explorer. Navigate to the directory in 
which you saved the setup file. Start Setup by double-clicking the file.

5. Follow the instructions on the screen and enter the information and settings necessary. 
The client-end controls of the WebNavigator are installed. Close the Setup dialog.

Result
When the installation is completed successfully, the WebNavigator client switches to the 
WinCC project currently in runtime. 

Installing the Web Diagnostics Client

Introduction   
The software for the Web Diagnostics Client is installed from the WinCC Runtime Professional 
Product DVD on the client computer.

Requirements
● To do this, you must have administrator rights.

Procedure
1. Insert the installation disk into the appropriate drive.

Setup runs automatically unless you have disabled autostart on the PC.

2. If the setup program does not start up automatically, start it manually by double-clicking 
the "Start.exe" file.
The dialog to select the setup language opens.

3. Choose the language in which you want the setup program dialogs to be displayed.

4. To read the information on the product and installation, click the "Read Notes" or 
"Installation Notes" button.
The corresponding help file opens with instructions.

5. Once you have read the notes, close the help file and click the "Next" button.
The dialog for the selection of product languages opens.
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6. Select the languages for the product user interface, and click the "Next" button. The dialog 
for selecting the product configuration opens.

 

  Note

"English" is always installed as the basic product language.
 

7. Open the program group "SIMATIC WinCC Web Navigator" and select the "Diagnostics 
Client" component.

8. Choose whether you want a desktop shortcut to be created, and select a different 
destination directory for the installation if needed. Note that the length of the installation 
path must not exceed 89 characters.

9. Click the "Next" button.
The dialog for the licensing conditions opens.

10.To continue the installation, read and accept all license agreements and click "Next".
In the event that the security and permission settings need to be changed for the installation, 
the dialog for the security settings opens.

11.To continue the installation, accept the changes to the security and permissions settings, 
and click the "Next" button.

12.Check the selected installation settings. If you want to make any changes, click the "Back" 
button until you reach the point in the dialog where you want to make changes. Once you 
have completed the desired changes, return to the overview by clicking "Next".

13.Click the "Install" button.
The installation begins.

 

  Note

If no license key is found during installation, you have the chance to transfer it to your PC. 
If you skip the license transfer, you can register it later with the Automation License 
Manager.

If the installation was successful, a message to this effect is displayed on the screen. If 
errors occurred during installation, an error message is displayed informing you of the 
type of errors.

 

14.It may be necessary to restart the computer. If this is the case, select the "Yes, restart my 
computer now." option button. Then click "Restart".

15.If the computer does not reboot, click "Exit".
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Result
1. The Web Diagnostics Client is installed.

10.16.6.4 Configuring the Web Navigator system

Overview of configuration steps

Requirement   
● The server PC and client PC are interconnected via TCP/IP.

● On the server PC

– Internet Information Service is installed.

– The WebNavigator server is installed.

– A license key is installed.

– WinCC Runtime Professional is installed.

● On the client PC

– Internet Explorer V8.0 or higher is installed.

or

– WinCCViewerRT is installed.

Basic procedure
The following configurations are required to set up a WebNavigator system:

1. Configure the WinCC project in the TIA Portal. For more information about the TIA Portal, 
refer to "Getting started with the TIA Portal"

– Configure WinCC screens for Web access.

– Create users for WebNavigator client access

– Observe restrictions

– Compiling a project

2. Transfer your WinCC project to the server PC. If the configuration PC and the WebNavigator 
server are interconnected, transfer the WinCC project using the command "Load to device 
> Software (all)". 

3. Configure the WebNavigator Web page on the WebNavigator server.

4. Operate the WinCC project.

– Using WinCCViewerRT

– Using Internet Explorer
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Configuring a WinCC project

Configuring WinCC screens for Web access

Configuring individual WinCC screens for Web access 
1. Double-click the desired screen in the project tree. The screen is opened and the screen 

properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web access".

3. Activate "Web access".

or

1. select the desired screen in the project tree.

2. Select "Web access" command in the shortcut menu.

Configuring several screens for Web access
1. Select "Screens" in the project tree.

2. Select the "Web access for all" command in the shortcut menu.

Result
The WinCC screens are configured for Web access. During compilation of the project, the 
WinCC screens are adapted for access via the Intranet/Internet and published on the 
WebNavigator server.

For more information, refer to "Transferring a WinCC project (Page 7526)".

See also
Transferring a WinCC project (Page 7526)

WinCC screens as a gadget

Gadget on the Web Navigator Server

Introduction
Using the "Preview" property, you define which screens to group in a gadget. Gadgets are mini 
applications for the Windows sidebar. In order to use gadgets, a WebNavigator client must 
always be installed as well on the WebNavigator server.    

The following operating systems support gadgets: 

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2
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Procedure
To configure WinCC screens as a gadget, proceed as follows:

1. Double-click the desired screen in the project tree. The screen is opened and the screen 
properties are shown in the Inspector window.

2. In the Inspector window, click "Properties > Properties > Web Access".

3. Activate "Preview" and "Web access".

4. Save the WinCC project.

5. Select the "Compile > Software" command in the shortcut menu of the HMI device.

Result
The screens are assembled for the gadget on the WebNavigator server. As soon as the project 
is in runtime, the WebNavigator server generates a jpg snapshot image "pdlImage.jpg" of each 
screen at cyclic intervals and in consecutive order. 

The file is stored in the directory "\WinCC\Webnavigator\Server\Web\image\_gadget". The 
gadget accesses this file cyclically.

Note that user interactions are not possible in the screens displayed. This includes, for 
example, calls from login dialogs or notice dialogs via functions.

The following objects are not supported for the display in a gadget:

● GSC diagnostics window

● Media Player
 

  Note

The WinCC project shown in the gadget cannot be operated.
 

Gadget on the Web Navigator Client

Introduction
In order to use gadgets, a WebNavigator client must always be installed as well on the 
WebNavigator server. A preconfigured gadget for displaying WinCC screens is located on the 
WebNavigator client in the installation directory under "\WinCC\Webnavigator\GADGET".     

The following operating systems support gadgets: 

● Windows 7 (Professional, Enterprise, Ultimate, Embedded StdE 7)

● Windows Server 2008 Standard Edition SP2

Requirement
The screens are published on the WebNavigator server and configured as "Preview".
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Procedure
To access the gadget with the WebNavigator client, proceed as follows:

1. Double-click on the "_WebNavigator.gadget" gadget in the installation directory under 
"\WinCC\Webnavigator\GADGET". IN Windows 7 / Windows 2008, the gadget is installed 
in the sidebar.

2. Define the update cycle in which the gadget loads a screen from the WebNavigator server, 
every 17 seconds for example.

3. Enter the address of the WebNavigator server. The gadget establishes a connection to the 
WebNavigator server.

4. If necessary, drag-and-drop the gadget onto the desktop.

Configuring runtime settings (WebNavigator)

Introduction    
You can configure the behavior in runtime in the "Runtime settings" editor. 

Procedure
1. Open the "Runtime settings > Web access" editor.

2. To use the "WinCC Classic" design, activate "Use "WinCC-classic" design".

3. To use your own cursor as a "View only cursor", enter the path and file name of the cursor 
at "Cursor "View only". Alternatively, navigate to the file of the desired cursor using the "…" 
button.

4. To change the maximum number of concurrent connections, enter the desired number in 
the "Count of concurrent connections" field.
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5. To change the maximum number of open tabs in the browser, enter a suitable value in the 
"Number of tabs per browser" field. Internet Explorer V7 or higher supports this setting.

 

  Note
Server load settings

Each tab that calls the server homepage uses a license on the server PC. A connection 
setting of "10" and a tab setting of  "2" corresponds to 20 clients. A license for at least 20 
clients must be available on the server PC.

 

6. Define whether the local user group is disabled on the WebNavigator Server.

7. To output an appropriate system message when a WebNavigator logs on and off, activate 
"Enable event log messages".

Result
The settings for Runtime are configured. 

See also
Operating a WinCC project (Page 7537)

Setting up WinCCViewerRT (Page 7535)

Managing users for the Web Navigator Client

Administration of users for the WebNavigator client

Introduction
For each user to be logged onto the web client, you must configure the following: 

● A start screen of your choice enabled for web access

● A language of your choice

This allows you to make various sections of a project immediately accessible or inaccessible 
for users.

Requirements
● The "Users" work area is open.

● The user "Foreman" has been created.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.
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Setting the start screen and language
1. Position the mouse cursor on the title of the "Users" table.

2. Open the shortcut menu by right-clicking and activate the display of the "Web start screen" 
and "Web language" columns.

3. Click the  button in the "Master" user row in the "Start screen" column. A dialog box for 
selecting the start screen opens.

4. Select the "Start" screen.

5. Close the dialog box by using the  icon.

6. Click the  button in the "Web language" column. A dialog box for selecting the language 
opens.

7. Select the desired language as the runtime language of the web user.

As an alternative, select the user in the work area; the properties of the user are then displayed 
in the Inspector window. In the Inspector window, select "Properties > Properties > Web 
options". Select the start screen and the language.

 

 Note

The language setting is retained when a user is moved from one group to another one. The 
start screen will be overwritten.

 

Administration of user groups for the WebNavigator client

Introduction
For each user group to be administered for web clients, you must configure the following: 

● A start screen of your choice enabled for web access

● A language of your choice

This allows you to make various sections of a project immediately accessible or inaccessible 
for users.

 

 Note

The name of the user group has to be unique within the project. Otherwise the input is not 
accepted. 

 

Requirements
● The "User groups" work area is open.

● The "Start" screen has been created and the web access is activate.

● The selected project language is activated.
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Procedure
1. Position the mouse cursor on the title bar of the "Groups" table.

2. Open the shortcut menu by right-clicking and activate the display of the "Web start screen" 
and "Web language" columns.

3. Double-click "Add..." in the "Groups" table.

4. Enter "Web operators" as the name of the user group.

5. Click the  button in the "Web start screen" column. A dialog box for selecting the start 
screen opens.

6. Select a start screen for Runtime.

7. Close the dialog box by using the  icon.

8. Click the  button in the "Web language" column. A dialog box for selecting the language 
opens.

9. Select the runtime language.
As an alternative, select the user group in the work area; the properties of the user group 
are then displayed in the Inspector window. 

10.In the Inspector window, select "Properties > Properties > Web options". 

11.Select the start screen and the language.
 

  Note

The name of the user group is language-dependent. You can specify the name in several 
languages and switch between languages in runtime. 

 

 

Limitations

Introduction 
You can use your projects already created with WinCC to also make them available via the 
Internet/ Intranet.

Essentially, the step consists in publishing the already created WinCC screens and using user 
administration to set up Web users. 

The current version of the Web Navigator has a number of restrictions with regard to 
functionality, and as a "thin client" solution does not support all the functions offered by a 
standard WinCC basic system. 

You may therefore have to check your existing WinCC projects for these restrictions and if 
applicable, adapt them.
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Functionality restrictions
When using non-supported functions, the user will be informed of this in Runtime with plain 
text messages.

● The Web Navigator Client only offers the view of a running WinCC project. A configuration 
of the WinCC Server projects via the Web Navigator Client is not possible.

● Only those WinCC option packages/add-ons can run on the Web Navigator Client, whose 
documentation expressly states that.

● Not all Runtime API functions are supported on the Web Navigator Client. A list of the 
functions supported is provided in the Appendix.

● Nearly all the PCS7 options are supported. A list of the options that are not supported is 
provided in the Appendix.

● The "Reports" editor is an integrated reporting system of WinCC for the time-triggered or 
event-triggered documentation of alarm messages, operations and log contents. This 
reporting system is not supported via the Intranet/Internet. Thus, the output of reports is, 
for example, only possible on the Web Navigator Server and WinCC client.

● No separate logging system is running on the Web Navigator Client. The message log and 
message system can only be operated and monitored.

● C functions are created and executed in the project of the WinCC server. Functions cannot 
run on the Web Navigator Client. 

● If VB functions are used, there are only minor restrictions due to non-supported functions. 
If non-supported functions are used in a VB function, an alarm is output.

Transferring a WinCC project

Requirement     
● A WinCC project is configured

● WebNavigator server is installed on the server PC.

● The configuration PC and server PC are interconnected.

Online transfer
Transfer the WinCC project using the command "Load to device > Software (all)". The project 
is compiled prior to the download. The screens are adapted for access via Intranet/Internet 
during compilation. 

During the download to the server PC, the configured WinCC project is transferred and the 
screens are published on the WebNavigator server. For more information, refer to "Compiling 
and loading (Page 7002)".

See also
Configuring WinCC screens for Web access (Page 7518)
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Configuring the Web Navigator Server

Setting up the Web Navigator Web site

WinCC Web Configurator

Introduction
The Internet Information Service (IIS) is set up and managed with the WinCC Web Configurator.

Requirement
● WebNavigator Server is installed.

● Internet Information Service is installed.

Starting WinCC Web Configurator:
In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools > 
HMI Tools" > WinCC Web Configurator".
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Initial configuration with the WinCC Web Configurator 
During the initial configuration, you specify whether you want to create a new default Web site 
or a new virtual folder. 

● If you only wish to operate the WinCC WebNavigator Web site on your server, activate the 
option "Create a new standard Web site (stand-alone)".

● If the WinCC WebNavigator Web site is to be added as a subdirectory to your existing Web, 
activate the option "Add to an existing Web site (virtual folder)".
This option is necessary if the previous default Web site must remain active or if the 
operating system supports only the operation of one website.

Configuration management with the WinCC Web Configurator
If the IIS is already configured, change the settings of the existing Web server or virtual directory 
with the WinCC Web Configurator.
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The Web Configurator automatically detects whether a configuration already exists. If a 
configuration already exists, the dialog for changing the configuration opens.

 

 Note

When you delete the Web directory, restart the PC before creating a new Web directory with 
the WinCC Web Configurator.

Note the following:

When you change the Web directory and your Web communication is then no longer 
established, the Web Configurator attempts to automatically adjust the settings correctly.

If this does not work, delete the Web directory from the IIS. Restart the PC and create a new 
Web directory with the Web Configurator.

 

Creating a New Standard Web site (Stand-Alone)

Requirement     
● WinCC WebNavigator is installed.

● Internet Information Service is installed

● WinCC Web Configurator is started
 

  Note

If you have any questions or experience problems with the following settings, contact your 
Intranet/Internet administrator.
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Procedure
Proceed as follows to create a standard Web site:

1. Select "Create a new standard Web site (stand-alone)" and click "Next".

2. Enter the name of your Web site in the "Name of the Web site" field.

3. In the "Port" field, enter the port number used for access.

4. In the "IP address" field specify whether the PC is to be reached in the Intranet, Internet or 
in both networks. Only use addresses from the selection list.
If you want to make your PC accessible via the Intranet and the Internet, select "All not 
assigned".

5. Define the standard Web site that is displayed after selecting the Web server on the 
WebNavigator Client

– MainControl.asp
Starts the WinCC Navigation interface. You need the navigation interface, for example, 
for download installation.

– WebClient.asp
Opens the start screen configured in user administration after login.

6. Define the time interval after which the WebNavigator Clients automatically start to establish 
a connection following a connection breakdown. If "0 s" is set, the "Automatic connection 
establishment" function is disabled.

7. Define the way the Web site is started after configuration.

8. If you have not activated a firewall, click "Finish". If you have installed a firewall, click "Next".
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Result
The Web directory has been created and the Web page is activated. If you have activated the 
firewall, configure the firewall settings with the Web Configurator. For further information, refer 
to "Auto-Hotspot".

Creating a virtual folder

Requirement     
● Internet Information Service is installed

● WinCC WebNavigator is installed.

● WinCC Web Configurator is started
 

  Note

If you have any questions or experience problems with the following settings, contact your 
Intranet/Internet administrator.

 

Procedure
Proceed as follows to create a virtual directory:

1. Select "Add to an existing Web site (virtual folder)". Click "Browse."

2. In the following dialog, select the active Web site to which the virtual directory is to be added.
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3. Click "OK" to close the dialog box. Click the "Next" button in the following dialog.

4. Enter the name of your Web site in the "Name of the Web site" field.

5. The WinCC Web Configurator takes the IIS settings for the port number and IP address.

6. Define the standard Web site that is displayed after selecting the Web server on the 
WebNavigator Client.

– MainControl.asp
Starts the WinCC Navigation interface. You need the navigation interface, for example, 
for download installation.

– WebClient.asp
Opens the start screen configured in user administration after logon.

7. Define the time interval after which the WebNavigator Clients automatically start to establish 
a connection following a connection breakdown. If "0 s" is set, the "Automatic connection 
establishment" function is disabled.

8. Define the way the Web site is started after configuration.

9. Click "Finish" to complete the configuration.

Result
The virtual Web directory has been created and the Web site is activated. To access the Web 
site, with the WebNavigator Client, add the name of the virtual Web directory to the URL, for 
example http://WebServer/WebNavigator.
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No Active Website
If no active Web is found, the WinCC Web Configurator terminates with a message.

Click "OK" to close the dialog box.

To execute the Web Configurator again, first activate a Web site. For additional information, 
refer to "Checking of Activated Web site".

Setting up a firewall

Introduction
This section describes only the activation of the "HTTP" and "HTTPS" services for port 80 in 
the respective operating system.

To set up the Windows firewall with advanced security, or for a different port, contact your 
network administrator.

Requirement       
● You have created a standard Web site using the Web Configurator.

● The firewall is activated.

● A logged on Windows user has administrator rights

Procedure
To set up the firewall for a standard port, proceed as follows:

1. Click "Windows Firewall" in the "WinCC Web Configurator".

2. The "Windows Firewall" dialog will open.

3. In Windows 7 or 2008, click "Allow a program or feature through Windows Firewall".
In Windows 8.1 or 2012, click "Allow an app or feature through Windows Firewall".

4. Activate "Secure WWW Services (HTTPS)" or "WWW Services (HTTP)".

5. Exit the open Windows dialogs with "OK". 

6. Click "Finish" in the Web Configurator. The configuration of the server will be completed.
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Checking the Activated Web Site (Web)
 

 Note

Note that the operating system settings shown depend on the language set for the operating 
system.

 

Procedure
Proceed as follows to check the activated website:

1. In the Start menu, select "Programs" > "Administrative Tools" > "Internet Services Manager".

2. Click the name of the PC in the "Connections" area.

3. Click "Default Web Site".

4. Check the information displayed for the websites. If "Stopped" is displayed next to the 
desired Web site, e.g. "WebNavigator", start the Web site.

5. To start the Web site, select the "Start" command in the shortcut menu.
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10.16.6.5 Operating a WinCC project

Operating projects using WinCCViewerRT

Setting up WinCCViewerRT

Requirement   
● On the server PC

– The WebNavigator server is installed.

– A license key is installed.

– The WinCC project is in Runtime.

– The WinCC screens are configured for Web access and published.

● On the client PC

– WebNavigator client is installed.

Procedure
Set up WinCCViewerRT as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Enter the logon data in the "General" tab:

– Server address: http://<server name>, or http://<IP address>

– User name and password

Visualize processes
10.16 Options

WinCC Professional V13.0
System Manual, 02/2014 7533



3. In the "Parameters" tab, specify the Runtime language and whether to disable keystrokes 
that the operator uses to change to other programs.

4. Define the WinCC Runtime Professional properties in the "Graphics Runtime" tab:

– Start screen

– Configuration file for screen navigation

– Window attributes

– Illegal user actions

5. Specify additional user actions on the "Runtime" tab:

– Automatic logout

– Enable screen keyboard.

– Use <Ctrl+Alt+Del> to switch to the Task Manager and to the operating system. This 
setting is only valid for the on-screen keyboard.

– Open the "WinCCRTViewer" by means of keystroke.
You can change the default keystroke <Ctrl+Alt+P>.

6. Close the dialog with "OK".

Result
WinCCViewerRT is configured. When the dialog is closed, the connection to the WebNavigator 
server is established. The settings are saved to the configuration file "WinCCViewerRT.xml". 
The settings in the configuration file are used at the next start of WinCCViewerRT.

The configuration file is stored in the directory "C:\Users\<User name>\Appdata\LocalLow
\Siemens\SIMATIC.WinCC\WebNavigator\Client" . Under <User name>, enter the name of 
the user logged-on when the file is created. This allows different configurations to be used, 
depending on the logged on user. WinCCViewerRT applies the interface language from 
WinCC.

WinCCViewerRT.xml Renaming or removing 

When you rename or remove the file WinCCViewerRT.xml, the configuration dialog of 
WinCCViewerRT is opened during the start. Reconfigure WinCCViewerRT, or select a different 
configuration file.

See also
Configuring runtime settings (WebNavigator) (Page 7520)

Visualize processes
10.16 Options

WinCC Professional V13.0
7534 System Manual, 02/2014



Operating a WinCC project

Requirement   
● On the server PC:

– The "WinCC WebNavigator license is installed.

– The WinCC project is in Runtime.

– The WinCC screens are configured for Web access and published.

– A user is created in WinCC.

● On the client PC

– WinCCViewerRT is configured.

Procedure
To view screens, proceed as follows:

1. In the Start menu, select "Start > All Programs > Siemens Automation > Option and Tools 
> HMI Tools" > WinCCViewerRT".

2. Log on to the WebNavigator server:

– If the user and password are configured in "WinCCViewerRT", no logon dialog displayed.

– If no user and password was configured in "WinCCViewerRT", the logon dialog 
displayed. Enter the user name and the password of the WinCC user. Click "OK."

3. Press the <Ctrl+Alt+P> keystroke to change the user. The "WinCCViewerRT" dialog opens.
Enter the user name and password on the General" tab.
You can also select the xml file that contains this data. 

Result
WinCCViewerRT connects to the selected WinCC project. The start screen configured for the 
user is displayed. Users can operate and monitor the project, depending on their authorizations.

A user assigned authorization no. 1002 "Web access - view only" is only allowed to monitor 
the project.

The cursor is a "View only cursor" and indicates that process-related operations are not 
allowed. 

Certain operations are still possible, such as opening the properties dialog of an online trend 
control. 

If necessary, you can use your own cursor symbol as a "View only cursor". See "Configuring 
runtime settings (WebNavigator) (Page 7520)" for more detailed information.
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Operating projects in Internet Explorer

Operating a WinCC project

Requirement     
● WebNavigator client is installed. 

● A user for the WebNavigator Client has been created.

● Internet Explorer as of V8.0

Procedure
To operate the WinCC project, proceed as follows:

1. Enter the address of the WebNavigator Server in the address bar of Internet Explorer:

– Standard Web site: "http://servername"

– Web site in the virtual directory: "http://servername"

2. Confirm your entry

3. Enter the user name and the password. Confirm your entry.

Result
The standard Web site is displayed. The appearance depends on the configuration.

If "WebClient.asp" is set, the WebNavigator Client starts with the start screen defined in user 
administration. For more information, refer to "Managing users for the Web Navigator Client 
(Page 7521)".

If "MainControl.asp" is set, the WebNavigator client starts with the Web navigation interface. 
For more information, refer to "Working with the Web navigation interface (Page 7539)".

See also
Working with the Web navigation interface (Page 7539)
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Working with the Web navigation interface

Structure

Navigation interface menu
The Web Navigation interface combines various Web functions. The various functions are 
grouped in menus. 
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● "Change Server" menu:
Change to a different WebNavigator Server or Sm@rtServer.

● Menu of the current server:

– Screens: Display or screen navigation of the current WebNavigator Server.

– Report tools: Installed tools such as "DataWorkbook" for the display and analysis of 
current process values and historic data.

– Analysis tools: Installed tools such as "Dat@View" for the display of log data in tables 
and trends.

– Diagnostics tools: Status.html for diagnosing the WinCC project and the connection to 
the Web Navigation server.

– Additional tools: This can be expanded by the user.

– Download area:
The plug-ins which are stored on the WebNavigator Server in the directory "Install / 
Customize" are available, e.g download of add-ons for WebNavigator.

● "Settings" menu:
Settings for the WebNavigator Client e.g. adaptation of size of screens

● "Current" menu:
Links to Web pages, such as "SIMATIC HMI", "WinCC" or "WinCC flexible".

● "Language" menu:
Changing the language of the navigation interface. The standard version of the program 
includes five languages.

Functions

User logon      
When logging onto the WebNavigator server, the user can determine - through the address 
entered in Internet Explorer - whether he logs on via the Web navigation interface or the start 
page configured in the WinCC project. 

● The address "http://<server_name>/webnavigator" opens the start page configured in the 
User Administrator following the logon.

● The address "http://<server_name>/webnavigator/maincontrol.asp" starts the Web 
navigation interface.

Change of the Server
A different server can be selected via the menu command "Change Server". Enter the address 
of the new WebNavigator server in the upper input box. Examples of possible input formats 
are described under "User Logon". 
In the lower field, a symbolic name can be entered, which is shown in the menu as the current 
WebNavigator server. If the name is not specified, the address of the WebNavigator server is 
displayed.  
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Expansion Options
Menu

The menu of the navigation interface can be expanded by additional menu entries and 
functions, for example, depending on the operational area. An expansion is configured in an 
XML file. The XML file is saved on the WebNavigator server in the subdirectory 
"_custom_data". Further information is available in the topic "Extending the Web Navigation 
User Interface".  

Tools

The menu command "Additional tools" can be expanded by the user to provide additional tools 
on the WebNavigator client.

Plug-Ins

The "Download Plug-Ins" menu command provides plug-ins that have been stored on the 
WebNavigator server in the folder "Install/Customize". In order to display the version name of 
a plug-in, it must have been assigned the format "Vxx.xx.xx.xx" or "xx.xx.xx.xx". 

Languages

Adjustment of language options may be facilitated by adjusting the "Menu.xml" file. The 
languages are stored as CSV files on the WebNavigator server in the folder "_languages / 
<language_identifier>". When adding, these language files have to be referenced in the file 
"maincontrol.asp". 

Diagnosis of the Connections with "Status.html"

Introduction
You can retrieve status information about the WebNavigator server and the WebNavigator 
clients from a WebNavigator server or any WebNavigator client. 

The status information provides you with information about which users access the 
WebNavigator server via which WebNavigator clients. The name of the status page is 
"status.html". The page is displayed in Internet Explorer. 

The status information is displayed in blocks within the HTML page. There is one information 
block for the WebNavigator server and one information block for each connected 
WebNavigator client. The information is only displayed in English.
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Status information
Time specification is in UTC (i.e. minus one hour to CET; minus 2 hours to CEST).

Structure of the Information Block of the WebNavigator server

Field Description
Server Version Displays the version number of the WebNavigator server (build 

no.)
Server File Date reserved
License Count Displays the number of licenses
Runtime Mode Displays the status of Runtime, e.g. activated
Last Update Date and time of the last refresh of the display 
Connected WebNavigator client Number of connected WebNavigator clients 
Connected diagnostic clients Number of connected diagnostic clients 
Connected DataMonitor clients Number of connected DataMonitor clients 
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Structure of the information blocks of the Web Navigator clients

Below the caption "Logged on Users:", the information blocks of the connected clients are 
listed. Each block has the name of the client as a header.

Field Description
Login Login name of the current user
Time Login time of the current user or also time of the most recent automatic 

reconnect. 
Type Type of WebNavigator client, such as Default, Demo, View Only 
PID  Process ID of instance of WebNavigatorRT.exe on the WebNavigator 

server communicating with this WebNavigator client. 

Requirement
● User is created in user administration.

Display "Status.html"
To display the "Status.html", enter the corresponding address in the address bar:

● Standard Web site: "http://www.server_name.de/status.html"

● Web site in the virtual directory: "http://www.server_name.de/WebNavigator/status.html"

Save status information
The displayed status information can be saved. To do this, use the "Save As" menu command 
in Internet Explorer and select "(*.txt)" as the file type.

 If "(*.htm, *.html)" are selected, the contents displayed are not saved.

Use the "Hardcopy" function

Introduction
On the WebNavigator client it is possible to generate a hardcopy of the entire screen, of a 
section, or of the active window.

The hardcopy is output to the default printer by executing the "PrtScr.exe" application.

Requirement
● WebNavigator client is installed.

Starting the hardcopy application
The program is started on the WebNavigator client, for example, using the command input 
line, or a user-defined function.
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The application is saved to the folder "...\Common Files\Siemens\BIN\". The hardcopy is 
triggered depending on the parameters used.

Examples of the command line
"C:\Program Files\Common Files\Siemens\BIN\PrtScr.exe" –infinit –hotkey="<ALT>+p"

Starts PrtScr.exe and waits for the <ALT>+p keystroke. The entire screen is printed when you 
press the keystroke.

Parameters

Parameters Function
-infinit Used as parameter for launching PrtScr.exe on a system without WinCC. 

Always use the parameter in combination with "hotkey".
The print keystroke and output parameters are not determined in the 
WinCC project. They are transferred instead via command line input. The 
PrtScr.exe application is started and waits for the input of the print 
keystroke. The parameters were transferred once during startup. To edit 
these parameters close the PrtScr.exe application. Change the parameters 
and then restart PrtScr.exe . 

-end terminates an active instance of PrtScr.exe 
-hardcopy Starts PrtScr.exe, directly initiates a hard copy, and then waits for the 

keystroke.
Always use the parameters in combination with "infinit" and "hotkey".

-nomcp Starts PrtScr.exe , creates the hardcopy, and closes PrtScr.exe. 
/C= left;top;right;bottom Starts PrtScr, directly triggers a hardcopy of the specified screen area, and 

then ends PrtScr.exe (
-l Prints in landscape format.
-hotkey="x" Specifies the keystroke. 

Valid characters and combinations:
 <ALT>, <SHIFT>,<CTRL> +  {0-9, A-Z, 0xXX}
The hexadecimal notation "0xXX" can be used to specify the "Virtual Key 
Code". For more information on "Virtual-Key Codes", refer to the MSDN 
Library. 

10.16.6.6 Setting up terminal services for Web Navigator

Communication Using Terminal Services

Communication by means of terminal services
To use the WebNavigator Client as a terminal client, do not use a proxy server between the 
terminal server and WebNavigator Server.

If the terminal server and WebNavigator Server are not installed on the same PC, the 
WebNavigator Client cannot access the Web Navigation server via the terminal services. 
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This problem can be solved in various ways: 

● A minimal installation of WinCC without licenses is installed on the terminal server.

● After installing the WebNavigator Client, the file "CCEClient_service.vbs" is executed once 
on the terminal server. The file is located on the WebNavigator product DVD in the 
"\WebNavigator" directory. The Windows user right "Administrators" is required to execute 
the VBS file.

Access from the WebNavigator Client and WinCC clients to the WebNavigator Server
If a WebNavigator Client and a WinCC client access the WebNavigator Server, via terminal 
services in the former case, the WebNavigator Client, as a terminal client, may not open a 
Windows Desktop in its session. 

The following options are available to ensure the Windows desktop is not opened on the 
WebNavigator Client when beginning a session:

● Direct entry in the terminal services configuration for all users.

● Enter Internet Explorer as the start program in computer management for individual users.

For more information, refer to the FAQs on the Internet, contribution ID 17498344. 

Activating terminal services on the Windows server

Requirement 
● Windows user with administrator rights

● Windows 2008 Server, Windows Server 2012

Procedure
Proceed as follows to activate terminal services:

1. Open Control Panel and double-click "Software".

2. Open the "Add or Remove Programs" dialog and click "Add or Remove Windows 
Components". The "Windows Components Wizard" opens.

3. Activate "Terminal server" and "Terminal server licensing".

4. Click "Next". Follow the instructions.
 

  Note

Activate the terminal services on the server PC before you install the actual applications. 
Install the applications on the server PC via the "Add or Remove Programs" dialog of the 
Control Panel. If you install the application via the Control Panel, the application can be 
configured for all users. Otherwise, the application can only be used for the user who 
installed the application. 
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Setting Up a User with Access Rights to the Terminal Server

Requirements
The terminal server is installed.

Procedure
To set up a user for access to the terminal server, proceed as follows:

1. Go to "Control Panel > Administrative Tools > Computer Management > Local Users and 
Groups".

2. Select "New User" from the "Users" shortcut menu. The "New User" dialog is opened.

3. Click the "User" icon. Double-click the corresponding user. The user properties dialog 
opens.

4. Click the "Member of" tab. Click "Add". The "Select Group" dialog opens.

5. Add the group "Remote Desktop Users". Click "OK" to close all the open dialogs.

6. Check the membership of the new user in other groups. If required, add the user to a 
corresponding group to ensure that the user is assigned the necessary user rights.

7. Close "Computer Management".

Starting the Terminal Server Application on the Terminal Client

Requirement
● The terminal service on the Windows server is started.

● A user is set up for access to the terminal server.

Procedure
To start an application on the terminal server from the terminal client, proceed as follows:

1. On the terminal client, from the Start menu select the menu command "Programs" > 
Accessories > Communication > Remote Desktop Connection". The "Remote Desktop 
Connection" dialog opens.

2. Enter the name of the terminal server.

3. Click the "Connect" button. Log on as the user who was created for access to the terminal 
server.

Result
The connection is now established. The desktop of the terminal server is displayed. On the 
terminal server, start an application, e.g. the Web Navigator Client via Internet Explorer.

Visualize processes
10.16 Options

WinCC Professional V13.0
7544 System Manual, 02/2014



10.16.6.7 Troubleshooting

No Communication Between Web Navigator Server and Client
If a provider (participating proxy, firewall) has activated Content Filtering for an Internet 
connection, Web Navigator communication is no longer possible. With content filtering, only 
certain contents of HTML pages are permitted. The communication is directed via a defined 
port to a certain IP address, e.g. of the WinCC server.

● You have to deactivate Smart Filtering for the IP address of the Web Navigator Server - as 
there are no viruses or HTML contents on the WinCC Server, filtering is not useful in this 
case.

● If the customer uses SSL technology, the data is transferred in encrypted form. Smart 
Filtering for content is therefore not possible.

Connection Abort
In an Internet environment, aborted connections, delays and communication fluctuations may 
occur.

If the communication between the Web Navigator Client and Web Navigator Server is defect, 
the user receives an alarm on the Web Navigator Client.  

The Web Navigator Client then automatically tries to establish a connection in order to restore 
the connection.

The delay between attempts to establish a connection can be configured with the Web 
Configurator. If the value "0" is set, the Web Navigator Client does not attempt to reconnect 
automatically. In this case a message appears on the web client asking you whether the 
connection is to be reestablished. 

Confirm this query to reestablish the connection.

No Screens are Displayed
Make sure the correct Web site is activated on the PC running the Web Navigator Server. 
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Wrong Start Screen
You have edited a new screen in the "Screens" editor.

● Compile and load the screen on the server PC.

● Delete the temporary Internet files in the Internet Explorer via "Tools" > "Internet Options".

10.17 Interfaces

10.17.1 OPC

10.17.1.1 OPC for Runtime Advanced

Basics

OPC

Introduction
OPC refers to standardized manufacturer-specific software interfaces for data exchange in 
automation engineering.  

The OPC interfaces provide a standardized environment in which devices and applications 
from various manufacturers can be linked.

OPC is based on the Windows technology COM (Component Object Model) and DCOM 
(Distributed Component Object Model).

OPC UA (Unified Architecture) is the technology succeeding OPC. OPC UA is platform-
independent and can use different reports as a communication medium.

Principle of operation
In WinCC, you can configure HMI devices as OPC servers or OPC clients. The particular HMI 
device determines which OPC servers and OPC clients are available. 

OPC Specifications
OPC specifies interfaces to gain access to the following objects in WinCC:  

● Process values (OPC Data Access 1.0, 2.05a)

● Process values (DataAccess ClientFacet (OPC UA)

● Process values (OPC XML-Data Access 1.01)
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You can find additional information about the individual OPC specifications in the Internet at 
the website of OPC Foundation:.

● www.opcfoundation.org (www.opcfoundation.org)

See also
Supported OPC UA services of the OPC UA client (Page 7563)

Compatibility
Support of the mentioned specifications is checked regularly by the "Compliance Test Tool" 
(CTT) of the OPC Foundation. Interoperability with OPC products of other manufacturers is 
ensured through the participation in "OPC Interoperability Workshops". 

The test results submitted are published on the website of the OPC Foundation. The results 
can be called up from there using the search term "OPC Self-Certified Products".

Using OPC in WinCC

Configuration option
HMI devices configured with WinCC feature an OPC interface for data communication between 
automation devices or automation systems using the OPC communication driver. 

You can use an HMI device as an OPC server and/or as an OPC client. As an OPC client, the 
HMI device can be connected to a maximum of eight OPC servers. 

The software ensures up to eight client HTTP connections for an OPC XML DA server on a 
Multi Panel. For the exchange of data via an XML connection, some OPC XML DA clients 
create several HTTP connections to the OPC XML DA server.               

HMI device Data exchange over Operating system OPC server OPC client
PC, Panel PC (with 
WinCC Runtime 
Advanced)

DCOM or 
OPC UA binary (TCP/
IP)

Windows XP / 7 OPC DA server
OPC UA server (DA 
only)

OPC DA client
OPC UA client*

HMI devices with version 
V11.0 and V12.0:
● MP 277
● MP 377 

Mobile Panel 277 
● Comfort Panels 

SOAP Windows CE OPC XML DA server -

Comfort Panel with 
version V13.0

SOAP or 
OPC UA binary (TCP/
IP)

Windows CE OPC UA server (DA 
only)

OPC UA client

*: The OPC UA client exchanges data via TCP/IP. 

A communication via DCOM is only possible between HMI devices of the "PC" or the 
"Panel PC" type. In order for a control room PC to display the process values of Windows CE 
HMI devices in the plant, for example, install "OPC-XML-Gateway" on the control room PC 

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
System Manual, 02/2014 7547

http://www.opcfoundation.org


using the WinCC Runtime Advanced Setup. The "OPC-XML-Gateway" supports the 
communication within the SIMATIC HMI devices family between an OPC DA client and an 
OPC XML DA server. 

The area pointer is supported by any OPC connection. 

OPC server accessibility       
The following table lists the available OPC servers and how you can access them:

OPC server OPC server name
OPC DA server OPC.SimaticHMI.CoRtHmiRTm (ProgID)
OPC XML DA server http://<xxx>/soap/OpcXml (URL) 1

<xxx>: IP address or DNS name of the HMI device
OPC DA server OPC.Siemens.XML (ProgID) for accessing the OPC XML DA server via 

the OPC XML gateway from an OPC DA client
OPC UA server Server URL: opc.tcp://[HostName]:4870
1: For the access of an external OPC DA XML client. 

HMI device as OPC client     
To use an HMI device as an OPC client, create an "OPC" connection in the WinCC project. 
The OPC client accesses the tags of the OPC server over this connection. You need a separate 
connection for each OPC server. 

The following exception applies here:

If you want to connect your OPC DA client to multiple panels, you only need one OPC 
connection to the OPC XML gateway in your project. The multiplexing of this connection to 
multiple OPC XML connections to individual panels takes place in the OPC XML gateway. You 
configure the connections to the panels using he OPC XML Manager.

The following figure shows the use of an HMI device as a central operator control and 
monitoring device:

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
7548 System Manual, 02/2014



HMI device as OPC server     
An HMI device as OPC server makes the data available to other applications. The applications 
can run on the same HMI device or on HMI devices in the connected network environment. 

The following schematic diagram shows the use of MS Excel as an OPC client that displays 
process values of the OPC server: 

See also
Configuring an HMI device as OPC DA server (Page 7552)

Creating a connection to a WinCC OPC DA server (Page 7554)

OPC XML Gateway (Page 7558)
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Configuring an OPC server

Configuring an HMI device as OPC DA server

Introduction
Which OPC server is used depends on the HMI device:

● HMI devices with RT Advanced as OPC DA server

● HMI devices with version V11.0 and V12.0 as OPC XML DA server

● HMI devices with version V13.0 as OPC XML DA server

The following figure shows the two methods of accessing an OPC server:

Procedure     
To configure an HMI device as an OPC server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Select the "Operate as OPC server" option in the "Runtime settings" under "Services > 
Write/read tags".

3. Save the project.

4. Download the project to the HMI device.

5. Start runtime on the HMI device.

Result
The OPC server is accessible. If an OPC client connects to the OPC server, the OPC server 
on the HMI device is started. 
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See also
Using OPC in WinCC (Page 7547)

Creating a connection to a WinCC OPC DA server (Page 7554)

Configuring an HMI device as an OPC UA server

Introduction
The following HMI devices can be used as OPC UA servers:

● Comfort Panels

● RT Advanced 

Procedure    
1. Open the "Runtime settings" of the HMI device in the project tree.

2. Select the "Operate as OPC server" option under "Service" in the "Runtime settings".

3. Configure the server settings at "OPC settings > OPC Unified Architecture Server 
configuration":

– Change the "Port number", if required.

– Activate at least one "SecurityPolicy" and the respective "Message security mode".
 

  Note
Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.
 

4. Save the project.

5. Download the project to the HMI device.

6. Start runtime on the HMI device.

Result
The OPC server is accessible. 

If an OPC client connects to the OPC server, the OPC server on the HMI device is started. 

Configuring DCOM user permissions in Windows

Introduction    
The OPC DA client and OPC DA server are DCOM applications, whose security settings must 
be set in compliance with the DCOM security mechanisms:
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● The OPC client needs launch/activation rights and access rights for the OPC DA server.

● The OPC DA server only needs access rights for the OPC DA client

The following must be known on the PCs of the OPC DA server and the OPC DA client 
respectively:

● The user account for which the OPC DA client is executed

Requirement
You have administrator rights.

Procedure
The procedure for configuring DCOM user rights is described in the document (http://
www.opcfoundation.org/DownloadFile.aspx?CM=3&RI=326&CN=KEY&CI=282&CU=14) of 
the OPC-Foundation. 

For additional information on granting user rights, refer to the documentation for Windows XP, 
Windows Vista, or Windows 7. 

Configuring an OPC client

Creating a connection to a WinCC OPC DA server

Introduction
For an HMI device to access the OPC server data of another HMI device, you need to create 
a connection to this OPC server in the WinCC project. 

Depending on the target HMI device used, either an OPC DA server or an OPC XML DA server 
is employed. 

The following figure shows the two methods for accessing the OPC servers of the HMI devices:
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If a connection to one or more OPC XML DA servers is created using an OPC XML gateway, 
also enter the OPC XML DA servers in the "OPC XML Manager". 

Requirement
● An HMI device is configured as an OPC server.

● The project on the HMI device is in runtime.

● For connections to a OPC XML DA server: "OPC-XML-Gateway" is installed on the 
configuration PC and the HMI device with the OPC client.

Procedure     
To create a connection to an OPC server of an HMI device, follow these steps:

1. Open the "Connections" editor on the configuration PC in the WinCC project of the OPC 
client.

2. Create a new connection and enter a meaningful name.

3. Select the entry "OPC" as the "Communication driver".

4. Enter the communication partner under "Parameters > OPC server" in the work area:

– If the connection communicates directly with the OPC server or with the OPC server on 
a PC-based HMI device, select the "OPC.SimaticHMI.CoRtHmiRTm" item from the list.

– If the connection communicates directly with the OPC server of a Windows CE HMI 
device, select "OPC.Siemens.XML" from the list.

– If the OPC server is installed on a remote computer, enter the computer's IP address 
or name under "Remote computer name".
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Result
The OPC connection is configured. To access the data on the WinCC OPC DA server, create 
tags. 

See also
Using OPC in WinCC (Page 7547)

Configuring an HMI device as OPC DA server (Page 7550)

OPC XML Gateway (Page 7558)

Configuring an OPC XML Manager (Page 7559)

Creating a connection to an OPC UA server

Introduction
The OPC UA client can access process data in the hierarchical name space of an OPC UA 
server. 

For the OPC UA client to access the process values of an OPC UA server, the OPC UA server 
and the OPC UA client authorize each other by exchanging certificates. In addition, you can 
encode the data transfer. 

The OPC UA client usually classifies each certificate of an OPC UA server as a "trustworthy". 
How an OPC UA server responds to a connection request of the OPC UA client depends on 
the configuration of the OPC UA server. 

In order to establish communication to an OPC UA server, inform yourself from the OPC UA 
server operator about the following:

● URL of the OPC UA server

● Security settings

● Required certificates

Requirement
URL and security settings of the OPC UA server are known.

Procedure   
To create a connection to an OPC UA server, proceed as follows:

1. Open the "Connections" editor on the HMI device.

2. Create a new connection and enter a meaningful name.
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3. Select the entry "OPC UA" as the "Communication driver".

4. In the work area, under "Parameters", configure the "OPC server":

– Specify the "Discovery URL" of the OPC UA server or select the OPC UA server from 
the list.

– Select the "Security policy"

– Select the "Message security mode"

Result
The OPC UA connection is configured. You create tags to access data from the OPC UA 
server. 

See also
Supported OPC UA services of the OPC UA client (Page 7563)

Accessing process values of an OPC server

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● A connection to the OPC-Server is created

Procedure   
To access process values of an OPC-Server via the OPC connection, follow these steps:

1. On the configuration PC in the project navigation, open the "HMI tags" editor under the HMI 
device that you use as an OPC client.

2. Create a tag with the same data type as the tag on the OPC server.

3. Select the OPC connection for "Connection".

4. Enter the "Address", or select the desired tag on the OPC server via the object list.

Result
If you launch Runtime on the HMI device, the process value from the OPC server will be written 
to the tag on the HMI device via the OPC connection. 

See also
Permitted data types (OPC) (Page 7561)

Access to tags with OPC (Page 7562)
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OPC XML Gateway

Usage
The OPC DA client uses the "OPC XML Gateway" so that the OPC DA client can communicate 
with the OPC XML DA server. The "OPC XML Gateway" compiles the data in the respective 
"language" of the corresponding standard. The "OPC XML Gateway" communicates 
exclusively with the OPC XML DA server which runs on an SIMATIC HMI device. 

Installation
To install "OPC XML Gateway", activate the "OPC XML Gateway" entry during installation of 
WinCC runtime advanced in the component selection. To install "OPC XML Gateway" 
afterwards, re-execute the setup of WinCC Runtime Advanced. 

Proxy setting for the OPC XML Gateway
The configuration settings for the OPC XML Gateway can be found in the "SOPCSRVR.ini" 
file in the section "[Configuration]". The OPC XML Gateway is configured by default on the PC 
as the HMI device, so that a proxy server configured in the Internet settings of Internet Explorer 
is ignored: 

NOPROXY=1

If this entry is set to "0", the OPC XML Gateway uses a configured proxy server for HTTP 
connections. 

You can find the "SOPCSRVR.ini" file in the folder "C:\Program Files\\Siemens\Automation
\WinCC RT Advanced". 

 

 Note

When data is requested from an HMI device that cannot be accessed over the configured 
proxy server, the OPC XML Gateway uses a direct connection after a Timeout. The direct 
connection is set up again on every request for data and slows down OPC communication 
significantly.

 

 

See also
Configuring an OPC XML Manager (Page 7559)

Using OPC in WinCC (Page 7547)
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Configuring an OPC XML Manager

Introduction
The OPC XML DA server, to which the OPC DA client has access, is administered in the "OPC 
XML Manager". The OPC XML Manager can be found in the Windows Start menu under 
"SIMATIC > OPC-XML-Gateway > OPC XML Manager".

To enter an OPC server, you need the following information:

● Server prefix
Any string that is used in the name of the OPC tag. Use an abbreviation of the server, for 
example. You can find the characters permitted for tag names in the reference. 

● Name or IP address of the OPC XML DA server

Requirement
"OPC XML Manager" is open.

Procedure   
To configure the OPC XML Manager, proceed as follows:

1. To enter a new OPC XML DA server, click on the button "Add".
The "Add/Edit Webservice" dialog is opened.

2. Enter the server prefix and the name or IP address of the OPC XML DA server.

3. Close the two dialogs with "OK".

Result
The OPC XML DA server is entered. The OPC DA client can now access the data of the OPC 
XML DA server via the "OPC XML Gateway".

Editing or removing an OPC server     
To edit or delete a configured OPC XML DA server, select the required OPC XML DA server. 
Then click either "Edit" or "Remove" . 

See also
OPC XML Gateway (Page 7556)
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Security concept of OPC UA

Introduction
The WinCC OPC UA server uses the TCP/IP protocol for data exchange. For authorization 
between WinCC OPC UA server and OPC UA client certificates are exchanged. In addition, 
you can encode the data transfer. 

Security concept   
The WinCC OPC UA server and each OPC UA client authorize themselves mutually by 
exchanging certificates. 

By default, the WinCC OPC UA server creates during installation a self signed instance 
certificate. You can alternatively replace this instance certificate with a project-specific instance 
certificate. 

 

 Note
Private key and own certificates

If you have an own certification center, you can create your own certificates and make them 
available for all communication partners. In this case, delete the instance certificate created 
by WinCC OPC UA server. 

 

The instance certificate is stored under the following path:

● On PCs: \ProgramData\Siemens\CoRtHmiRTm\MiniWeb13.0.0\SystemRoot\SSL

● On Panels: \flash\simatic\SystemRoot\SSL

Security settings   
The following table lists the security settings supported by the WinCC OPC UA server: 

SecurityPolicy Message Security Mode
None1 None
Basic128Rsa15 2 None 3 Sign 4 SignAndEncrypt 5

1: The certificate exchange is switched off. Every OPC UA client can log on to the WinCC OPC UA server. 
2: Certificate exchange with depth of encryption of 128 bit.
3: The data packages are exchanged after certificate check unsecured between client and server. 
4: The data packages are signed with the certificates, but not encoded
5: The data packages are signed with the certificates and encoded
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Reference

Permitted data types (OPC)

Permitted data types
The following table lists the data types supported by the WinCC OPC servers:    

OPC data type WinCC data type
VT_BOOL BOOL
VT_I1 CHAR
VT_UI1 BYTE
VT_I2 SHORT
VT_UI2 WORD
VT_UI4 DWORD
VT_I4 LONG
VT_R4 FLOAT
VT_R8 DOUBLE
VT_DATE DATE
VT_BSTR STRING

The following table lists the ranges of values of the OPC data types:

OPC data type Range of values
VT_BOOL 0 or -1
VT_I1 -128 to 127
VT_UI1 0 to 255
VT_I2 -32768 to 32767
VT_UI2 0 to 65535
VT_I4 -2147483648 to 2147483647
VT_UI4 0 to 4294967295
VT_R4 3.402823466 e-38 through 3.402823466 e+38
VT_R8 1.7976931486231e-308 to 1.7976931486231e+308
VT_Date 1 January 100 to 31 December 9999

Special features in communication with the OPC-DA server
The array tag in the OPC-DA server belonging to the area pointer must be of the data type 
SHORT (VT_I2). 

Special features in communication with the OPC-XML server
Array tags are not supported by OPC-XML servers.
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Access to tags with OPC

Introduction  
When accessing tags with OPC, note the following when configuring tags:

● Permitted characters in tag names

● Permitted cycle times (OPC XML)

● Special features of the data type "STRING" (OPC XML)

● Special features of the data type "Date/Time" (OPC XML)

The OPC XML DA server is tested and enabled for eight connections, each with 2 groups and 
consisting of 35 tags. 

Permitted characters in tag names  
Only use the following characters in tag names:

● Letters from "a" to "z" (no umlauts)

● Numbers from "0" to "9"

● Special characters: "-" and "_"

Permitted cycle times (OPC XML)  
OPC XML connections are designed for the exchange of small volumes of data:

● For this reason use cycle times that are greater than one second

● In general, only request a small number of tags; a maximum of 30 per screen

Special features of the data type "STRING" (OPC XML)  
Only valid ASCII values from 0x20hex to 0x7Fhex are supported in the data type "STRING".

Special features of the data type "Date/Time" (OPC XML)  
Values of the data type "Date/Time" are always expected as UTC (Universal Time 
Coordinated) by the OPC-Gateway. If a tag of the type "Date/Time" is read by the OPC client, 
the returned value is a time in UTC. If a value is written to the tag, the value is treated as UTC. 
The time including the time zone and daylight saving time are shown as "local time" on an HMI 
device. 

Example:

The time zone GMT+1 and daylight saving time is set on the HMI device.

OPC DA client (UTC time): 01.01.2005 16:00

Display on the HMI device (OPC server): 01.01.2005 18:00
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Supported OPC UA services of the OPC UA client

OPC UA Services support
The OPC UA client supports the following OPC UA services:

● SecurityPolicy - Basic128Rsa15

● SecurityPolicy - Basic256

● SecurityPolicy - None

● DataAccess ClientFacet

You can additional information about OPC UA services in the "OPC UA Part 3 - Address Space 
Model 1.01 Specification" document under "§5.6". 

Explanation of the security settings
The following table lists the security settings supported by the OPC UA client: 

SecurityPolicy Message Security Mode
None1 None
Basic128Rsa152 None4 Sign5 SignAndEncrypt6

Basic2563 None Sign SignAndEncrypt
1: The certificate exchange is disabled. Every OPC UA client can log on to the WinCC OPC UA server. This setting can be 
disabled on each OPC UA server. 
2: Certificate exchange with depth of encryption of 128 bit.
3: Certificate exchange with depth of encryption of 256 bit.
4: The data packages are exchanged after certificate check unsecured between client and server. 
5: The data packages are signed with the certificates, but not encoded
6: The data packages are signed with the certificates and encoded

 
 

 Note
Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.

For a secure communication between client and server, use in operating mode at least the 
following settings:
● SecurityPolicy: Basic128Rsa15
● Message Security Mode: Sign

 

See also
Creating a connection to an OPC UA server (Page 7554)
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10.17.1.2 OPC for Runtime Professional

Basics

OPC
OPC refers to standardized manufacturer-specific software interfaces for data exchange in 
automation engineering.  

The OPC interfaces provide a standardized environment in which devices and applications 
from various manufacturers can be linked.

OPC is based on the Windows technology COM (Component Object Model) and DCOM 
(Distributed Component Object Model).

In addition, OPC XML DA offers a further software interface that is based on the Internet 
standards XML, SOAP, and HTTP.

OPC UA (Unified Architecture) is the technology succeeding OPC. OPC UA is platform-
independent and can use different reports as a communication medium.

See also
Using OPC in WinCC (Page 7565)

OPC Specifications (Page 7564)

Compatibility (Page 7565)

OPC Specifications
OPC specifies interfaces to gain access to the following objects in WinCC:  

● Process values (OPC Data Access 2.05a, 3.0; OPC XML Data Access 1.01; OPC UA 1.01)

● Log process values (OPC Historical Data Access 1.20; OPC UA 1.01)

● Logged alarms (OPC Historical Alarms and Events v0.92)

● Alarms (OPC Alarms and Events 1.10)

For detailed information about the individual OPC specifications, refer to the website of OPC 
Foundation. 

*: Draft from Siemens, which is available on the OPC Foundation website. 

See also
Using OPC in WinCC (Page 7565)

OPC Foundation (www.opcfoundation.org)
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Compatibility
Support of the mentioned specifications is checked regularly by the "Compliance Test Tool" 
(CTT) of the OPC Foundation. Interoperability with OPC products of other manufacturers is 
ensured through the participation in "OPC Interoperability Workshops". 

The test results submitted are published on the website of the OPC Foundation. The results 
can be called up from there using the search term "OPC Self-Certified Products".

See also
OPC (Page 7562)

Licensing

Licensing
For the operation of one of the supported WinCC OPC servers, the following license must be 
installed:

● WinCC Basic System

Using OPC in WinCC

Introduction
On a HMI device with "WinCC Runtime Professional" there are server for the following OPC 
interfaces available:

● OPC Data Access / OPC XML Data Access: Access to the data management of WinCC

● OPC Historical Data Access: Access to the WinCC log system

● OPC Alarms&Events: Access to the WinCC alarm system

● OPC Unified Architecture: Access to the data management and the WinCC log system

In addition, there is by default in WinCC an OPC channel that can access the corresponding 
OPC data access server as client via OPC DA or OPC XML DA.

All WinCC OPC servers are certified by the OPC Foundation.
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OPC communication concept of WinCC  
The following screen shows the OPC communication concept of WinCC:

See also
Licensing (Page 7563)

Functionality of the WinCC OPC DA Server (Page 7568)

Functionality of WinCC OPC XML DA server (Page 7568)

Functionality of the WinCC OPC HDA server (Page 7570)

Functionality of the WinCC OPC A&E server (Page 7579)

Principle of operation the WinCC OPC UA Server  (Page 7597)

Creating a connection to an OPC server (Page 7606)

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
7564 System Manual, 02/2014



Configuration

Basic settings for OPC

Introduction
For the following WinCC OPC servers, you configure the basic settings on the configuration 
PC for OPC in the HMI device runtime settings:

● OPC HDA

● OPC A&E

● OPC UA

Basic settings for OPC   
For HMI devices with Runtime Professional, you define the following in the runtime settings:

● OPC settings
You configure the following in this category:

– Exception rules for the validation of writing access to log data

– Security concept of the WinCC OPC UA server

● Alarms
In this category you configure the mapping of the WinCC alarm system for the alarm 
behavior of the following WinCC OPC servers: 

– OPC A&E

See also
Configure WinCC OPC HDA Server (Page 7578)

Configure WinCC OPC A&E server (Page 7590)

Configure WinCC OPC UA Server (Page 7605)

WinCC OPC server

Accessibility of WinCC OPC servers
Client-specific OPC clients data from the WinCC data management are available for the 
WinCC OPC servers, for example, process values or alarms. 

In order to access a WinCC OPC server, you must activate the related WinCC project on the 
HMI device. 
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WinCC OPC DA Server

Functionality of the WinCC OPC DA Server

Principle of operation    
The WinCC OPC DA server enables any OPC DA client to access process values from the 
data management of WinCC.

Supported specifications  
The WinCC OPC A&E Server supports OPC Data Access 2.05a and 3.0.

ProgID of the WinCC OPC DA servers   
You access the WinCC OPC DA server via the following ProgID: 
"OPCServer.WinCC_SCADA". 

Quality codes 
The "Quality Code" delivers information on the status and quality of the process values. For 
more information, refer to the "OPC Data Access 3.0" specification.

See also
Using OPC in WinCC (Page 7563)

Accessibility of WinCC OPC servers (Page 7565)

Licensing (Page 7563)

WinCC OPC XML DA server

Functionality of WinCC OPC XML DA server

Principle of operation       
WinCC's OPC XML DA Server is implemented as a web service of Microsoft Internet 
Information Server (IIS). The OPC XML DA client accesses the OPC XML DA server via an 
internet protocol to which process values from the data management of WinCC are available. 

Supported specifications   
The WinCC OPC XML DA Server supports the specification OPC XML Data Access 1.01. 

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
7566 System Manual, 02/2014



"OPC XML Data Access" is a standard that supports communication over the Internet by 
means of platform-independent protocol (SOAP/XML). The data access via OPC XML Data 
Access has an OPC Data Access leaning on the scope of operation. 

URL of the WinCC OPC XML DA servers       
You access the WinCC OPC XML DA server via the following URL: "http://<xxx>/WinCC-OPC-
XML/DAWebservice.asmx" 

<xxx>: IP address or DNS name of the OPC XML DA server
 

 Note

If automatic detection of settings is enabled on a PC for the internet options under 
Connections > LAN Settings", access to OPC XML DA through the web service will be slowed 
considerably. 

 

Quality codes 
The "Quality Code" delivers information on the status and quality of the process values. For 
more information, refer to the "OPC XML Data Access1.01" specification.

Special features of tags of "String" type
If you use tags of "string" type that logically stand for floating point values, there can be 
problems when OPC clients want to write and read.

An OPC client writes to a string tag and does not enter the new value in the form of a string 
but as float, double or decimal. The comma that indicated the decimal value (in German) can 
be lost. This will result in a wrong value. This behavior also occurs when string tags are read 
if the value being read is requested in float, double, or decimal format.

Only use the respective floating point tags for the floating point values. Get string tags only in 
string format. 

See also
Using OPC in WinCC (Page 7563)

Accessibility of WinCC OPC servers (Page 7565)

Installing WinCC OPC XML DA Server (Page 7570)
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Installing WinCC OPC XML DA Server

Introduction
To install the OPC XML DA server automatically in the framework of the WinCC setups, the 
following settings  on the HMI device must be fulfilled:

● Internet Information Service (IIS) is installed

● Microsoft .NET-Framework 2.0 is installed

If the requirements are not fulfilled, you must install the OPC XML DA server separately after 
you have installed the IIS and .Net-Framework 2.0. To avoid problems during installation, follow 
in any case the steps described below. 

Procedure   
To configure the OPC XML DA server on the HMI device, proceed as follows:

1. Install the "Microsoft Internet Information Service (IIS)".

2. Install the "Microsoft .NET-Framework 2.0".

3. Install the WinCC OPC XML DA Server via the WinCC setup.

4. Test the installation on the OPC server:

– Launch Internet Explorer on the PC running as the WinCC OPC XML Server.

– On the address bar enter the URL "http://localhost/WinCC-OPC-XML/
DAWebservice.asmx".

If a page with the supported operations is displayed in Internet Explorer, the installation 
was successful.

See also
Functionality of WinCC OPC XML DA server (Page 7566)

WinCC OPC HDA Server

Functionality of the WinCC OPC HDA server

Principle of operation    
The WinCC OPC HDA server enables any OPC HDA client to access process values from the 
data management of the WinCC log system.

Supported specifications  
The WinCC OPC HDA Server supports the OPC Historical Data Access 1.20 specification.
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ProgID of the WinCC OPC HDA server   
You access the WinCC OPC HDA server via the following ProgID: 
"OPCServerHDA.WinCC_SCADA". 

Quality codes   
The "Quality Code" delivers information on the status and quality of the raw data. For more 
information, refer to the "OPC Historical Data Access 1.20" specification.

Documentation contents
The WinCC OPC HDA Server documentation contains the following information:

● An overview of the data structure

● An overview of supported attributes, aggregates, and functions

For more information about the OPC HDA Server, refer to the "OPC Historical Data Access 
1.20" specification. 

See also
Using OPC in WinCC (Page 7563)

Accessibility of WinCC OPC servers (Page 7565)

Overview of the supported attributes (Page 7575)

Overview of the supported assemblies (Page 7576)

Overview of the supported interfaces and functions (Page 7577)

Configure WinCC OPC HDA Server (Page 7578)

Supported Write-Accesses

Introduction  
By default, any OPC HDA client can change process values in a data log. The tag log validates 
the data and inserts them to their corresponding time stamp.

If you frequently change a lot of process values, you can use the configuration dialog on the 
conifguration PC to deactivate the validation of the process values during writing to the data 
log. You speed up the large writing of process values in this way. The OPC HDA client must 
sort the data themselves chronologically, otherwise the data is not accepted. 

 

 Note
Deactivate writing access  

You can completely deactivate the writing via the WinCC OPC HDA server from log data via 
the (user-defined) WinCC setup.
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Write Accesses
An OPC HDA client does not have generally writing access to the following data logs.

● Compressed logs

● Data logs in main memory

● Swapped logs

The following table shows the supported writing accesses for a process value log on the hard 
disk of a HMI device:

Action Writing in process value log allowed?
Adding process values later Yes 1)

Adding process values in Runtime Yes 2)

Inserting future process values No
Replace process values (Replace) Yes
Deleting process values Yes 1)

1: If the time period is contained in the circular log.
2: The process value is added in the data buffer currently valid for the process value log.

 

See also
Storing Process Values (Page 3789)

Swapping Out Process Values (Page 3791)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 7573)

Configure WinCC OPC HDA Server (Page 7578)
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Special features of the OPC HDA server in WinCC for acyclic logging

Introduction
In WinCC. tags are logged cyclically or acyclically. The WinCC OPC HDA Server works 
differently depending on the logging method for tags:

● For all cyclically logged values, the OPC HDA Server operates in conformity to the HDA 
specification of the OPC foundation. The OPC aggregates are linearly interpolated.

● Acyclically logged tags are not included in the HDA specification of the OPC Foundation. 
The OPC aggregates are interpolated incrementally. If a tag value has not changed for a 
long period of time, no data are available during this time due to the interpolation.
To obtain valid data in spite of this, take note of the following particularities:

 

  Note

The OPC HDA Server is not OPC-compliant for acyclically logged tags. The OPC 
Foundation's HDA specification does not cover acyclically logged tags and therefore does 
not support log servers for acyclically logged tags. The supported aggregates are 
calculated in conformity to the OPC HDA specification. No non-explicitly called functions 
are supported.

 

Configuration of acyclically logged tags
When configuring acyclically logged tags, enable the "Log after segment change" option. This 
enters the most recent valid value in the the new log when a segment changes.

Supported aggregates of the WinCC OPC HDA Server for acyclically logged tags
The OPC HDA Server supports the following aggregates:

● OPCHDA_MINIMUM

● OPCHDA_MAXIMUM

● OPCHDA_AVERAGE

● OPCHDA_END

● OPCHDA_INTERPOLATIVE

● OPCHDA_TIMEAVERAGE

● OPCHDA_TOTAL

● OPCHDA_DURATIONGOOD

● OPCHDA_PERCENTGOOD
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Supported functions of the WinCC OPC HDA Server for acyclically logged tags
● ReadRaw only with "Boundings". To find the last value actually saved in an area where 

value changes are not logged, always use "Boundings" when executing "ReadRaw" on a 
tag.

● ReadProcessed

● DeleteRaw

● DeleteAtTime

● Insert

● InsertReplace

● Replace

Calculating the aggregates for acyclically logged tags
The calculation of the aggregates is based on an extended data record of raw data. The 
extended data record contains not only actually stored values, but also virtual data points for 
calculation. The WinCC OPC HDA Server prepares the raw data received according to the 
requirements of "ReadProcessed". The virtual data points needed for the calculation are 
formed from the bordering real data points. The following significant points are generated for 
virtual data points:

● Value for "StartTime"

● Value for "EndTime"

● Value for interval limits

Example
The values for "00:59:00", "01:02:00" and "01:03:00" are stored for an acyclical logging tag. 
An OPC HDA Client uses "ReadProcessed" to request an aggregate with the following 
parameters:

● StartTime = 01:00:00

● EndTime = 01:04:00

● Interval = 00:02:00
 

  Note

When generating virtual values at limits ("EndTime"/"Interval"), the time frame used for 
the calculation is always 1 µs less than the time stamp at the limit.

 

For the sake of clarity, a delta of 1 second is used in the following table. The OPC server uses 
the following raw data to calculate the aggregate:

Number Time stamp Real stored values Generated virtual values
1 00:59:00 1.00  
2 01:00:00  1.00
3 01:01:59  1.00
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Number Time stamp Real stored values Generated virtual values
4 01:02:00 2.00  
5 01:02:59  2.00
6 01:03:00 3.00  
7 01:03:59  3.00

The following figure elucidates the example:

1 2

2

3

3

Real values
Virtual values

① Interval start
② Interval end
③ Value change

 

See also
Supported Write-Accesses (Page 7569)

Overview of the supported attributes (Page 7575)

Overview of the supported assemblies (Page 7576)

Overview of the supported interfaces and functions (Page 7577)

Overview of the supported attributes
The following table contains the attributes supported by the WinCC OPC HDA Server. For 
more information, refer to the "OPC Historical Data Access 1.20" specification.

Attributes 

Attribute Attribute ID Description
ItemID OPCHDA_ITEMID Indicates the WinCC logging tag to be accessed. 
Item Datatype OPCHDA_DATA_TYPE Indicates the data type of the WinCC logging tag.

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
System Manual, 02/2014 7573



Attribute Attribute ID Description
Description OPCHDA_DESCRIPTIO

N
Returns a description of the WinCC logging tag. You 
define the description in the "HMI Tags" editor.

Engineering 
Units

OPCHDA_ENG_UNITS Sets the display of measurement units. You define the 
display in the "HMI Tags" editor.

See also
Functionality of the WinCC OPC HDA server (Page 7568)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 7571)

Overview of the supported assemblies
The following table lists the aggregates supported by the WinCC OPC HDA Server. For more 
information, refer to the "OPC Historical Data Access 1.20" specification.

Assemblies 

Assembly Description
OPCHDA_COUNT Detects the raw data count for the specified time interval.
OPCHDA_START Detects the initial value of the raw data at the beginning of 

the start time interval.
OPCHDA_END Detects the end value of the raw data at the end time interval.
OPCHDA_AVERAGE Detects the raw data mean value for the specified time 

interval.
OPCHDA_TIMEAVERAGE Detects the time-weighted raw data mean value for the 

specified time interval.
OPCHDA_TOTAL Returns the sum total value for the specified time interval.
OPCHDA_STDEV Detects the raw data standard deviation for the specified time 

interval.
OPCHDA_MINIMUMACTUALTIME Returns the minimum value of the raw data time stamp for 

the specified time interval.
OPCHDA_MINIMUM Detects the raw data minimum value for the specified time 

interval.
OPCHDA_MAXIMUMACTUALTIME Detects the maximum value and the raw data time stamp for 

the specified time interval.
OPCHDA_MAXIMUM Detects the raw data maximum value for the specified time 

interval.
OPCHDA_DELTA Detects the difference between the first and the last value of 

the raw data for the specified time interval.
OPCHDA_REGSLOPE Detects the slope of the regression line of the raw data for 

the specified time interval.
OPCHDA_REGCONST Detects the regression line value of the raw data at the 

starting point.
OPCHDA_REGDEV Detects the slope of the regression line of the raw data for 

the specified time interval.
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Assembly Description
OPCHDA_VARIANCE Detects the raw data variance for the specified time interval.
OPCHDA_RANGE Detects the difference between OPCHDA_MAXIMUM and 

OPCHDA_MINIMUM of the raw data for the specified time 
interval.

OPCHDA_DURATIONGOOD Detects the period of time in which the quality of the raw data 
was good. The period is indicated in seconds.

OPCHDA_DURATIONBAD Detects the period of time in which the quality of the raw data 
was bad. The period is indicated in seconds.

OPCHDA_PERCENTGOOD Detects the percentage of the raw data of good quality.
OPCHDA_PERCENTBAD Detects the percentage of the raw data of bad quality.
OPCHDA_WORSTQUALITY Detects the raw data worst quality for the specified time 

interval.

See also
Functionality of the WinCC OPC HDA server (Page 7568)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 7571)

Overview of the supported interfaces and functions
The WinCC OPC HDA Server supports the following interfaces: 

● IOPCHDA_Server

● IOPCHDA_SyncRead (no "ReadModified" method)

● IOPCHDA_SyncUpdate

● IOPCHDA_AsyncRead (no "ReadModified" method)

● IOPCHDA_AsyncUpdate

● IOPCCommon

For more information about the interfaces, refer to the "OPC Historical Data Access 1.20" 
specification.

See also
Functionality of the WinCC OPC HDA server (Page 7568)

Special features of the OPC HDA server in WinCC for acyclic logging (Page 7571)
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Configure WinCC OPC HDA Server

Introduction
On the configuration PC, define in the configuration settings for the WinCC OPC HDA server 
whether specific users or OPC HDA clients may change process values in the data logs without 
validation.

 

 Note

The configuration settings apply for the WinCC OPC HDA server as well as for the OPC UA 
server.

 

 Note
Deactivated writing access

If the writing access of OPC HDA clients was deactivated on the data logs in (user-defined) 
WinCC setup, these settings are ignored. 

 

Procedure   
To configure WinCC OPC HDA server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Define under "OPC settings" which users or OPC clients may change process values in 
the data logs without validation:

– To fully disable validation, select "Disable validation of the data during write access for 
selected OPC clients".

– To deactivate the validation for single users or OPC clients, double-click "Insert" in the 
corresponding table. Enter the name of the user or the OPC client.

– To re-select the validation for a single user or OPC client, clear the option in front of the 
respective user or OPC client.

See also
Functionality of the WinCC OPC HDA server (Page 7568)

Basic settings for OPC (Page 7565)
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WinCC OPC A&E server

Functionality of the WinCC OPC A&E server

Principle of operation    
The WinCC OPC A&E server enables the access to alarms of the WinCC alarm system. The 
OPC A&E Client is kept informed of status changes for WinCC alarms via Subscriptions. To 
avoid displaying all alarms and attributes on the OPC A&E client, configure in the Subscription 
filter. 

Supported specifications  
OPC Alarm & Events is a specification for the transmission of alarms and events. The WinCC 
OPC A&E Server supports the OPC Alarms&Events 1.10 specification.

In addition, the WinCC OPC A&E Server also supports access to historical alarms in 
accordance with the Siemens draft "OPC Historical Alarms and Events v0.92".

ProgID of the WinCC OPC A&E server   
You access the WinCC OPC A&E server via the following ProgID: 
"OPCServerAE.WinCC_SCADA". 

Quality codes
The "Quality Code" delivers information on the status and quality of an alarm. For more 
information, refer to the "OPC Alarms&Events 1.10" specification.

OPC A&E Server mapping rules  
To map the WinCC alarm system on OPC Alarms&Events, the WinCC OPC A&E server 
supports three mapping rules "Mode 1" to "Mode 3". 

"Mode 1" and "Mode 2" are supported because of compatibility reasons to WinCC OPC A&E 
server version 3.52 and earlier. "Mode 1" and "Mode 2" do not have a restricted scope of 
operation. 

"Mode 3" widens the restricted scope of operation of "Mode 1" and "Mode 2".

Documentation contents
The WinCC OPC A&E Server documentation contains the following information:

● A mapping of the alarm system on OPC A&E

● An overview of supported attributes

For more information, refer to the "OPC Alarm&Events 1.10" specification. 
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See also
Using OPC in WinCC (Page 7563)

Accessibility of WinCC OPC servers (Page 7565)

OPC A&E Server mapping rules (Page 7580)

Mapping rule "Mode 1": (Page 7586)

Mapping rules "Mode 2": (Page 7586)

Mapping rules "Mode 3": (Page 7586)

Restrictions for Mode 1 and Mode 2 (Page 7587)

Access to logged events (Page 7592)

OPC A&E Server mapping rules

General rules

OPC A&E Server mapping rules
During the configuration of the WinCC message system, settings are made to determine which 
process events generate a message. This message is shown as an alarm in OPC A&E.    

The following table shows the most important parameters of the alarm and how the WinCC 
alarm system prepares the information:

OPC WinCC message system Type of event
Source Source where the alarm was issued. The source has the 

format "<server prefix>::@LOCALMACHINE::".
S, C

Time Time of the event. Issues a time stamp in UTC (Universal 
Time Coordinated).

S, C

EventType Type of event. The WinCC OPC A&E Server supports 
"Simple Events" and "Condition Related Events".

S, C

Severity Priority of the alarm from WinCC S, C
EventCategory Category of the alarms. For more information on this topic, 

refer to "Displaying Message Classes and Types".
S, C

Message Alarm text for the corresponding alarm number. S, C
ConditionName Specified text that is delivered to the alarm additionally. 

Which text is returned, depends on the configured display 
rules:
● "Mode 1" and "Mode 2": Alarm number.
● "Mode 3": Alarm method, for example "Analog alarm". 

C

SubConditionName Corresponds "ConditionName", because WinCC 
supports no Multi-State Conditions.

C

ChangeMask Changed status of the alarm. For more information, refer 
to "Acknowledgment Theory".

C

NewState Status of the alarm. For more information, refer to 
"Acknowledgment Theory".

C
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OPC WinCC message system Type of event
ConditionQuality Returns the quality of the message. For more information, 

refer to "Quality Codes".
C

AckRequired Indicates whether the message requires 
acknowledgment.

C

ActiveTime Returns the time stamp for received messages. C
EventAttribute Lists the attributes required for the respective message. 

For more information, refer to "Attributes of the WinCC 
Message System".

C

Quality Returns the quality code of the message. C
Cookie Returns the cookie from the OPC A&E Server. C
ActorID Returns the logged user. C
S = "Simple Event"
C = "Condition Related Event"

See also
Acknowledgement theory (Page 7582)

Quality Codes for OPC A&E (Page 7584)

Attributes (Page 7584)

Priorities (Page 7589)

Alarm classes and alarm methods (Page 7588)

Alarm Logging in WinCC (Page 3887)

Alarm components and properties (Page 3910)

OPC A&E types of event  (Page 7581)

OPC A&E types of event 

Introduction
The WinCC OPC A&E Server supports "Condition Related Events" and "Simple Events".

Condition Related Events
"Condition Related Events" are alarms triggered by a condition. such as the limit violation of 
a tag, which is then output as an alarm on the HMI device. A "Condition Related Event"contains 
additionally the "Alarm" attribute. 

By default, each alarm as "Condition Related Event" is sent to the OPC A&A client. 

Simple Events
As "Simple Events" all other alarms are treated, which cannot be assigned to the "Condition 
Related Event" type of event.
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In order for an alarm to be treated as a "Simple Event", the following prerequisites must be 
met when the alarm class is configured:

● "Acknowledgment Came In" is not activated.

● "Alarm without outgoing state" is activated.
 

  Note

Note the following while using redundant systems:

"Simple Events" that are connected to internal tags are sent twice during tag comparison.

The first alarm is triggered by master, the second by the standby server.
 

See also
Acknowledgement theory (Page 7582)

OPC A&E Server mapping rules (Page 7578)

Mapping rule "Mode 1": (Page 7586)

Mapping rules "Mode 2": (Page 7586)

Mapping rules "Mode 3": (Page 7586)

Acknowledgement theory

Introduction   
For WinCC, the acknowledgment philosophy is how a message is displayed and processed 
from "came in" to "went out". On the WinCC OPC A&E Server, this alarm status is managed 
in the "ChangeMask" and "NewState" parameters.

ChangeMask
The "ChangeMask" parameter keeps track of where the alarm status changed. Possible 
parameter values are:

● OPC_CHANGE_ACTIVE_STATE

● OPC_CHANGE_ENABLE_STATE

● OPC_CHANGE_ACK_STATE

NewState
The "NewState" parameter indicates the alarm status after a change. Possible parameter 
values are:

● OPC_CONDITION_ACTIVE

● OPC_CONDITION_ENABLED

● OPC_CONDITION_ACKED
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Overview
The following table shows how WinCC alarm statuses are mapped to the "NewState" and 
"ChangeState" OPC parameters: 

WinCC NewState ChangeState
Received message OPC_CONDITION_ACTIVE

OPC_CONDITION_ENABLED
OPC_CHANGE_ACTIVE_STAT
E

Sent message with receipt OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACTIVE_STAT
E

Sent alarm without 
acknowledgment

OPC_CONDITION_ENABLED OPC_CHANGE_ACTIVE_STAT
E

Acknowledged messages 
(message pending)

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Acknowledged messages 
(message no longer pending)

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Locked message - OPC_CHANGE_ENABLED_STA
TE

Unlocked message OPC_CONDITION_ENABLED OPC_CHANGE_ENABLED_STA
TE

Received, acknowledged 
message

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACTIVE_STAT
E

Received, sent message with 
receipt

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Incoming, sent alarm without 
acknowledgment

OPC_CONDITION_ENABLED OPC_CHANGE_ACK_STATE

Message acknowledged by the 
system (message pending)

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Message acknowledged by the 
system (message no longer 
pending)

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Emergency-acknowledged 
message (message pending)

OPC_CONDITION_ACTIVE
OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

Emergency-acknowledged 
message (message no longer 
pending)

OPC_CONDITION_ACKED
OPC_CONDITION_ENABLED

OPC_CHANGE_ACK_STATE

See also
OPC A&E types of event  (Page 7579)
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Quality Codes for OPC A&E
The "Quality Code" is required to evaluate the status and quality of an alarm. 

Quality codes
OPC A&E's quality codes are presented in the following table:

Code Quality Status
0xC0 OPC_GOOD OK
0x40 OPC_UNCERTAIN Discrepancies, resulting from delayed 

acknowledgment, for example
0x00 OPC_BAD Connection to source is interrupted

Attributes
The following table lists the OPC attributes of the WinCC message system. You can configure 
the attributes in the "Alarms" editor. Some attributes are intended for internal use in WinCC 
only and are therefore not relevant to an OPC A&E Client. These attributes are not listed.  

OPC attribute WinCC message system Data type
CLASSNAME Returns the alarm class name. VT_BSTR
TYPENAME Returns the alarm method type name. VT_BSTR
FORECOLOR Returns the text color for received, sent and acknowledged alarms. VT_I4
BACKCOLOR Returns the background color for received, sent and acknowledged 

alarms.
VT_I4

FLASHCOLOR Returns the flashing color. VT_I4
FLAGS Indicates whether the message requires acknowledgment. VT_I4
TEXT01 Returns the content of UserTextBlock01. VT_BSTR
TEXT02 Returns the content of UserTextBlock02. VT_BSTR
TEXT03 Returns the content of UserTextBlock03. VT_BSTR
TEXT04 Returns the content of UserTextBlock04. VT_BSTR
TEXT05 Returns the content of UserTextBlock05. VT_BSTR
TEXT06 Returns the content of UserTextBlock06. VT_BSTR
TEXT07 Returns the content of UserTextBlock07. VT_BSTR
TEXT08 Returns the content of UserTextBlock08 VT_BSTR
TEXT09 Returns the content of UserTextBlock09 VT_BSTR
TEXT10 Returns the content of UserTextBlock10 VT_BSTR
PROCESSVALUE01 Returns the content of ProcessValueBlock01  VT_VARIANT
PROCESSVALUE02 Returns the content of ProcessValueBlock02 VT_VARIANT
PROCESSVALUE03 Returns the content of ProcessValueBlock03 VT_VARIANT
PROCESSVALUE04 Returns the content of ProcessValueBlock04 VT_VARIANT
PROCESSVALUE05 Returns the content of ProcessValueBlock05 VT_VARIANT
PROCESSVALUE06 Returns the content of ProcessValueBlock06 VT_VARIANT
PROCESSVALUE07 Returns the content of ProcessValueBlock07 VT_VARIANT
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OPC attribute WinCC message system Data type
PROCESSVALUE08 Returns the content of ProcessValueBlock08 VT_VARIANT
PROCESSVALUE09 Returns the content of ProcessValueBlock09 VT_VARIANT
PROCESSVALUE10 Returns the content of ProcessValueBlock10 VT_VARIANT
STATETEXT Returns the status alarm VT_BSTR
INFOTEXT Returns the information text for the alarm VT_BSTR
LOOPINALARM Indicates if loop-in alarm has been configured. VT_I4
CLASSID Returns the alarm class ID VT_I4
TYPEID Returns the message type ID VT_I4
MODIFYSTATE Returns the value of the status tag of the alarm VT_I4
AGNR Returns the number of the automation system that generated the 

alarm
VT_I2

CPUNR Returns the number of the CPU that generated the alarm VT_I2
DURATION Indicates the period of time between alarm received, sent and 

acknowledged
VT_I4

COUNTER Returns the number of alarms after the start of Runtime VT_I4
QUITSTATETEXT Indicates whether the alarm has been acknowledged VT_BSTR
QUITCOUNT Returns the number of active, unacknowledged alarms VT_I4
PARAMETER Outputs the message parameter. (Image of the message 

configuration)
VT_BSTR

BLOCKINFO Returns the current content of the alarm block VT_BSTR
ALARMCOUNT Outputs the number of alarms pending VT_I4
LOCKCOUNT Returns the number of locked alarms VT_I4
PRIORITY Indicates the configured priority of the alarm VT_I4
APPLICATION Returns the application which triggered the alarm VT_BSTR
COMPUTER Returns the name of the computer which processed the alarm VT_BSTR
USER Returns the name of the user who processed the alarm VT_BSTR
COMMENT Returns the alarm comment VT_BSTR
HIDDEN-COUNT* Number of locked alarms VT_I4
OS-HIDDEN* Indicates whether the alarm is locked VT_BOOL
OS_EVENTID* Indicates the WinCC alarm number VT_I4
BIG_COUNTER* Alarm counter VT_CY
UNIQUE EVENT ID* corresponds to the "BIG_COUNTER" VT_CY
*: Are supported only by "Mode 3". 

See also
Alarm classes and alarm methods (Page 7588)

Mapping rule "Mode 1": (Page 7586)

Mapping rules "Mode 2": (Page 7586)

Mapping rules "Mode 3": (Page 7586)
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Mapping rule "Mode 1":
"Mode 1" displays the whole WinCC alarm system under a "OPC Source" with the name 
"localhost::" The "TEXT01" WinCC attribute is written in the OPC alarm text. 

The WinCC alarm number is displayed on the "Condition" of the WinCC OPC A&E server. 

"Mode 1" supports the "Simple Events" and "Condition Related Events" types of event. Events 
can be filtered according to the "Event Type", "Category" and "Severity" criteria.  

See also
Restrictions for Mode 1 and Mode 2 (Page 7587)

Attributes (Page 7582)

OPC A&E types of event  (Page 7579)

Configure WinCC OPC A&E server (Page 7590)

Alarm classes and alarm methods (Page 7588)

Priorities (Page 7589)

Mapping rules "Mode 2":
"Mode 2" is implemented as of version 3.5.2. of the WinCC OPC A&E server. The WinCC 
alarm number is displayed on the "Condition" of the WinCC OPC A&E server. 

The text attribute of the WinCC alarm ("TEXT01" to "TEXT10") you have configured, is written 
in the OPC alarm text of "OPC Source".

"Mode 2" supports the "Simple Events" and "Condition Related Events" types of event. Events 
can be filtered according to the "Event Type", "Category" and "Severity" criteria.  

See also
Restrictions for Mode 1 and Mode 2 (Page 7587)

Attributes (Page 7582)

OPC A&E types of event  (Page 7579)

Configure WinCC OPC A&E server (Page 7590)

Alarm classes and alarm methods (Page 7588)

Priorities (Page 7589)

Mapping rules "Mode 3":
"Mode 3" is implemented as of version 3.6 of the WinCC OPC A&E server. "Mode 3" supports 
the hierarchical mapping of user-defined alarms. The hierarchy of "OPC Areas" is set by the 
user-defined alarm groups. 

With "Mode 3" you query the address space of the WinCC OPC A&E server according to 
"Areas" and "Sources". 
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"Mode 3" supports the "Simple Events" and "Condition Related Events" types of event. Events 
can be additionally filtered according to the "Area" and "Source" criteria. "Mode 3" supports 
the "System Message" OPC category.  

See also
Attributes (Page 7582)

OPC A&E types of event  (Page 7579)

Configure WinCC OPC A&E server (Page 7590)

Priorities (Page 7589)

Restrictions for Mode 1 and Mode 2

Notes on mapping rules "Mode 1" and "Mode 2":
The mapping rules for "Mode 1" and "Mode 2" contain significant restrictions. The mapping 
rules for "Mode 1" and "Mode 2" are therefore only because of compatibility reasons supported 
by the previous version and are not developed further. 

 

 Note

In order to ensure compatibility with the previous version, the WinCC OPC A&E server cannot 
use multiplexer.

 

The restrictions are solved in the mapping rule "Mode 3". 

Some of the restrictions of the mapping rules "Mode 1" and "Mode 2" are listed below: 
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● The WinCC alarm attributes are passed on via the OPC interface.
The IDs value range of WinCC alarm attributes is defined by the OPC specification by 
"Property sets":

– ID Set 1 contains the "OPC-specific Properties". Range: 1 … 99

– ID Set 2 contains the "Recommended Properties". Value range 100 to 199

– IDs 300…399 are especially reserved for OPC A&E

– IDs 400 to 4999 are reserved by OPC.

– ID Set 3 contains the "Vendor-specific Properties". Range: 5000 and higher
The IDs of the WinCC attributes must have values from 5000 and higher. 

Mode 1 and Mode 2 pass on the IDs of the WinCC alarm attributes via the OPC interface. 
These IDs are in the range of 0 to 61. 
If an OPC client, for example, requires the attribute with the IDs 2 ("Item Value") and 3 
("Item Quality") from the WinCC OPC A&E server, the OPC client receives instead the 
corresponding WinCC alarm atrocities. In this case the attributes are "ForeColor" and 
"BackColor".

● Restrictions for transfer of WinCC alarm numbers
Alarm numbers are only transferred as text in the "Condition" when "Condition Related 
Events". When "Simple Events", the alarm numbers are completely lost. 

● Some WinCC attributes are not supported, for example "UNIQUE_EVENT_ID"
You can use the "UNIQUE_EVENT_ID" attribute for alarm synchronization of redundant 
server couples. During switching between redundant servers, the following could happen:

– Alarms can be double- transferred

– Alarms can be lost

You can find an overview of all attributes supported by the different modes at "Attributes 
(Page 7582)". 

See also
Mapping rule "Mode 1": (Page 7584)

Mapping rules "Mode 2": (Page 7584)

Alarm classes and alarm methods

Introduction     
The WinCC message system informs the user of disturbances and operating conditions in the 
process. A WinCC alarm always belongs to a specific alarm class and alarm method that is 
related to the "Event Category". 
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Event Category
 

 Note
"Event Category" depends on the set mapping rules

The characteristics of the mapping rules "Mode 1" and "Mode 2" are described below: 
 

An "Event Category" is displayed on the WinCC OPC A&E Server for every combination of an 
alarm class and alarm method. 

An "Event Category" is determined by a "CategoryID" and a descriptive "Category Description". 
The "CategoryID" consists of the WinCC-internal ID of an alarm class and alarm method. The 
"Category Description" comes from the names of the alarm class and alarm method. 

The names of the alarm classes and alarm methods can be ascertained explicitly via the alarm 
attributes "CLASSNAME" and "TYPENAME". 

See also
Mapping rules "Mode 2": (Page 7584)

Mapping rule "Mode 1": (Page 7584)

Priorities

Introduction
The priority of WinCC alarms is displayed by the WinCC OPC A&E server on the "Severity" 
attribute. 

You can configure up to 17 priority levels in WinCC. The "Severity" OPC attribute has a value 
range from "1" to "1000":

● 1: Lowest priority

● 1000: Highest priority

Depending on the number of the configured WinCC priority levels, the value in the "Severity" 
attribute is automatically retrieved by linear scaling. 

Exception: For the mapping rules "Mode 1", the priority levels configured in WinCC are 
displayed directly on the "Severity" attribute. 

Example
If you do not change the default settings in the configuration settings of the WinCC OPC A&E 
server, the 17 priority levels are going to be displayed in the WinCC OPC A&E server as follows:

Priority level in WinCC Assigned value in the "Severity" attribute 
0 1
1 64
2 127
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Priority level in WinCC Assigned value in the "Severity" attribute 
3 190
... ...
15 937
16 1000

See also
Mapping rule "Mode 1": (Page 7584)

Mapping rules "Mode 2": (Page 7584)

Mapping rules "Mode 3": (Page 7584)

Description of the System Blocks (Page 4069)

Configure WinCC OPC A&E server

Introduction
Define the display of the WinCC alarm system in the configuration settings of the WinCC OPC 
A&E server.

The following screen shows the configuration settings in the "Runtime settings" of the HMI 
device:

Requirement
Alarms are configured.
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Procedure   
To configure WinCC OPC A&E server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. Configure the server settings at "Alarms > OPC Alarms & Events":

– Define the low and high limit for the display of the priority range.

– To activate the WinCC alarms with the mapping rule "Mode 3" in the WinCC OPC A&E, 
activate "Activated" and "OPC areas".
Use primarily this setting. 

– Assign to the "OPC event source" and the "OPC event alarm" respectively an alarm 
quality, for example, " User text block 3".

Result
The WinCC alarms are displayed completely in the WinCC OPC A&E. If you have configured 
user-defined alarms, areas and sources of the user-defined alarms are displayed in the WinCC 
OPC A&E server. 

Alternative procedure
You can display alternatively because of compatibility reasons the WinCC alarm also according 
to the "Mode 2" and "Mode 1" mapping rules in the WinCC OPC A&E server:

1. To display the WinCC alarms with the mapping rule "Mode 2" in the WinCC OPC A&E 
server, activate "Activated" and deactivate"OPC areas".

2. To display the WinCC alarms with the mapping rule "Mode 1" in the WinCC OPC A&E 
server, deactivate "Activated" and "OPC areas".

See also
OPC A&E types of event  (Page 7579)

Priorities (Page 7587)

Basic settings for OPC (Page 7565)

Mapping rule "Mode 1": (Page 7584)

Mapping rules "Mode 2": (Page 7584)

Mapping rules "Mode 3": (Page 7584)
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Accessing logged alarms

Access to logged events

Introduction
You can access the archived messages via the OPC A&E Server using an OPC client. Two 
methods are supported for accessing logged alarms:

● Output archived messages from a time period in the past

● Output archived messages from a time period in the past without mentioning end of period. 
After the output of archived messages, all other newly generated messages are 
automatically sent to the OPC client.

 

  Note

After reading tagged logs, you are not allowed to use the returned "ActiveTime" of an 
alarm to acknowledge the alarm or to track any transitions in the alarm. To ensure this 
does not happen, the OPC A&E Client must check the "EventType" of an alarm for the 
extra flag "OPC_HAE_HISTORICAL_EVENTFLAG". The "ActiveTime" is not correct on 
logged alarms. You can find information on the additional flag under "Identifying archived 
messages".

 

Polling the "Historic alarms and events" functionality
The table below lists the filters offered by the WinCC's extended OPC A&E Server, in addition 
to the standard filters:

Filter Filter Values Description
OPC_HAE_FILTER_BY_TIMEFRAME 0x80000000 Corresponds to the "ReadRaw" function 

for OPC Historical Data Access
OPC_HAE_FILTER_BY_STARTTIME 0x40000000 Corresponds to the "AdviseRaw" 

function for OPC Historical Data Access

Source filter and historical alarm request
In order for you to be able to request logged alarms, the OPC client must support the "SetFilter" 
functionality on a Subscription. The OPC server will also send logged alarms if you insert the 
keyword "OPCHAEServer" into the array of the "Source Filter" in a Subscription. In addition 
to this keyword, you can use other parameters to define which messages are to be read:

● Method

● Time period

● With or without limits

The lists of sources that are assigned in the filter can include other source names besides the 
"OPCHAEServer" source. In this a case, the Subscription delivers only the logged events of 
the given sources. The sequence of the source names is inconsequential.
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After configuring the source filter, you can retrieve the selected time period from the client with 
a "Refresh" call.

See also
Identifying logged alarms (Page 7596)

Syntax for accessing logged alarms using OPC (Page 7593)

Read methods for logged alarms (Page 7594)

Syntax for accessing logged alarms using OPC

Syntax
OPCHAEServer hMode=(read|advise) htStartTime=szTime 
[hEndTime=szTime] [bBounds=(TRUE|FALSE)]

Parameter

hMode = [read|advise]
Required Defines how the archived messages and events are to be read. 

● Read
Outputs logged alarms and events of a defined period from the past (comparable to 
ReadRaw for OPC Historical Data Access).
The following example shows how a filter is set to read over the past 30 minutes:
OPCHAEServer hMode=read htStartTime=NOW-30M bBounds=TRUE

● Advise
Outputs archived messages and events from a definite period, When all logged alarms are 
received, new alarms are sent in the same way as for an active subscription (comparable 
to AdviseRaw for OPC Historical Data Accesss).
The following example shows how alarms are read from 30 minutes ago until now 
(subscription must be active):
OPCHAEServer hMode=advise htStartTime=NOW-30M

 

  Note

The following notation is supported for the parameters "htStartTime" and "htEndTime":
● Relative notations such as "NOW"
● Symbolic values such as "NOW", "YEAR", "MONTH"
● Specification of absolute UTC data/time values according to XML notation: 

2006-09-01T10:00:00.000Z

The use of symbolic notation corresponds to the syntax of OPC Historical Data Access.
 

htStartTime = 
Required Defines the time from when the messages and events are to be read from the archive. 
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htEndTime = 
Optional Defines the time up to which the messages and events are to be read from the archive. 
For "hMode = read", the default setting "NOW" is used. 

bBounds = [TRUE|FALSE]
Optional Defines how messages close to the start and end time are to be handled. The function 
is identical to OPC historical data access.

● bBounds=FALSE: 
– Time stamp of the first transferred alarm >= htStartTime

– Time stamp of the last transferred alarm < htEndTime

● bBounds=TRUE:
– Time stamp of the first transferred alarm <= htStartTime

– Time stamp of the last transferred alarm >= htEndTime

The default setting is FALSE.

See also
Read methods for logged alarms (Page 7594)

Identifying logged alarms (Page 7596)

Read methods for logged alarms

Introduction
You can use one of the two read modes to read archived messages:

● read

● advise

"read" mode
"read" mode is used to read logged alarms from a defined period in the past. The sequence 
of read messages is always read from the alarms in chronological sequence in reference to 
each OS server. By setting the start and end time, you can specify whether the last message 
is to be read first or last. If the start time is earlier than the end time, the last message is last 
in the output.

If you want to use "read" mode, run the following functions on the subscription:

1. SetFilter

2. Refresh

A "SetFilter" during the "Refresh" will be rejected. Activating the subscription during "Refresh" 
does not affect how the Refresh is carried out.

The historic events will continue to be transferred with the Refresh flag. 
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The newly generated events are transferred according to the standard reaction of an active 
subscription:

● Taking into account the set filter values with the exception of "historic" source 
"OPCHAEServer"

● Without the Refresh flag

Enables the client to distinguish between the received events based on the Refresh flag. An 
event package never contains historic and new events at the same time.

● Event packets with the Refresh flag contain only historic events. These events can also be 
in queue.

● Event packets without the Refresh flag contain only newly generated events.

"advise" mode
"advise" mode is used to read logged alarms starting from a defined period in the past. After 
reading all archived messages, new messages are sent in the same way as for an active 
subscription. The archived messages are transferred in chronological sequence in reference 
to each OS server: The archived messages from a start time onwards are transmitted. 
Thereafter, the newly archived messages transferred. 

Note that you are not permitted to define an end time for "advise".

An active subscription is used for "advise" mode. If you run the "SetFilter" function on an active 
subscription, the historical alarms are transferred immediately. 

If you run the "SetFilter" function on an inactive subscription, the logged alarms are sent only 
after the subscription is activated. If you want to use "advise" mode with an inactive 
subscription, follow these steps:

1. SetFilter.

2. Set the subscription to "Active" using "SetState".

The transmission is interrupted if you deactivate the subscription.

The transmission is ended if you set the subscription to "inactive". A "SetFilter" is rejected 
when the subscription is active.

A "Refresh" on an active "historic" subscription in "advise" mode functions in the same way as 
it does for a standard subscription:

All queued condition related events are transferred to packages with Refresh flag. The last 
packet also contains an additional "Last Refresh" flag.

A "Refresh" call has no influence on the reading of historical alarms in "advise" mode. 

See also
Syntax for accessing logged alarms using OPC (Page 7591)
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Identifying logged alarms

Principle
Logged alarms are distinguished using an additional flag in EventType. This flag is ORed with 
the real EventType.

Name EventType EventType (archived message)
OPC_SIMPLE_EVENT 0x01 0x81
OPC_CONDITION_EVENT 0x04 0x84
OPC_TRACKING_EVENT 0x02 0x82
OPC_HAE_HISTORICAL_EVENTFLAG  0x80

Example 1
The following source filter is used to output logged alarms and events from the past 30 minutes 
in "read" mode. The oldest message for each OS server is output as the first one. The low limit 
value is also sent.

OPCHAEServer hMode=read htStartTime=NOW-30M bBounds=TRUE

Example 2
The following source filter is used to output events logged on September 1, 2006, from 10:00 
a.m. to 12:00 p.m. in "read" mode. The newest message for each OS server is output as the 
first one. The limits for this time period are also sent.

OPCHAEServer hMode=read htStartTime=2006-09-01T12:00:00.000Z 
htEndTime=2006-09-01T10:00:00.000Z bBounds=TRUE

Example 3
The following source filter is used to output logged alarms and events from the past 30 minutes 
in "advise" mode. After reading the archived messages, newly generated messages are sent 
in the same way as for an active subscription.

OPCHAEServer hmode=advise htStartTime=NOW-30M

See also
Access to logged events (Page 7590)

Syntax for accessing logged alarms using OPC (Page 7591)
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WinCC OPC UA Server

Principle of operation the WinCC OPC UA Server 

Principle of operation     
The WinCC OPC UA Server provides the following values:

● Process values

● Values from tag logs

The WinCC OPC UA server is installed as Windows service and started automatically. The 
WinCC OPC UA server supports only the "UA-TCP UA-SC UA Binary" communication profile. 
The used port number is adjustable.

Supported specifications  
OPC Unified Architecture is a specification for the transmission of process values and log data, 
as well as alarms and events. The WinCC OPC A&E Server supports the transfer of process 
values and log data. With this constraint, the WinCC OPC UA Server conforms to OPC UA 
specification 1.01.

URL of the WinCC OPC UA server   
You access the WinCC OPC UA server via the following URL: "opc.tcp://[NodeName]:[Port]/
OpcUaServerWinCC". 

[NodeName]: placeholder for the computer name. Is set automatically. 

[Port]: Port number. The default is "4861".

Discovery Server  
The "Discovery Server" is available by the OPC foundation. The "Discovery Server" is by 
default installed on the HMI device as Windows service. On the "Discovery Server" via OPC 
UA server UA clients information is available that is registered on the "Discovery Server".  

The WinCC OPC UA server registers for Runtime-Start, depending on the configuration, on 
no, one or all available "Discovery Servers" If you end the Runtime, the WinCC OPC UA server 
is automatically logged off from the "Discovery Server". 

Supported languages in the WinCC address area
The WinCC OPC A&E Server supports the WinCC address area in the following languages:

● German

● English

● French
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● Italian

● Spanish

See also
Using OPC in WinCC (Page 7563)

Accessibility of WinCC OPC servers (Page 7565)

Security concept of OPC UA (Page 7598)

OPC UA Services support (Page 7600)

Name area of the WinCC OPC UA server (Page 7601)

OPC UA Data Access (Page 7603)

OPC UA Log Access (Page 7603)

Configure WinCC OPC HDA Server (Page 7576)

Security concept of OPC UA

Introduction
The WinCC OPC UA server uses the TCP/IP protocol for data exchange. For authorization 
between WinCC OPC UA server and OPC UA client certificates are exchanged. In addition, 
you can encode the data transfer. 

Security concept  
The WinCC OPC UA server and each OPC UA client authorize themselves mutually by 
exchanging certificates. 

By default, the WinCC OPC UA server creates during installation a self signed instance 
certificate. You can alternatively replace this instance certificate with a project-specific instance 
certificate. 

 

 Note
Private key and own certificates

If you have an own certification center, you can create your own certificates and make them 
available for all communication partners. In this case, delete the instance certificate created 
by WinCC OPC UA server. 

 

The instance certificate is stored in the certificate memory. Depending on the configuration of 
the WinCC OPC UA server, one of the following certificate memory is used:

● Certificate memory of the WinCC OPC UA server

● Certificate memory of the operating system in "UA Applications" folder

In order for the WinCC OPC UA server and an OPC UA client to communicate with each other, 
the certificates must be known to each other:
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● You use the common certificate of the operating system
Or:

● You copy the certificates in the certificate memory of the participating communication 
partners:

– WinCC OPC UA Server

– OPC UA Client

– Discovery server (optional)

Security settings  
The following table lists the security settings supported by the WinCC OPC UA server: 

SecurityPolicy Message Security Mode
None1 None
Basic128Rsa152 None4 Sign5 SignAndEncrypt6

Basic2563 None Sign SignAndEncrypt
1: The certificate exchange is switched off. Every OPC UA client can log on to the WinCC OPC UA server. 
2: Certificate exchange with depth of encryption of 128 bit.
3: Certificate exchange with depth of encryption of 256 bit.
4: The data packages are exchanged after certificate check unsecured between client and server. 
5: The data packages are signed with the certificates, but not encoded
6: The data packages are signed with the certificates and encoded

 
 

 Note
Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.

For a secure communication between client and server, use in operating mode at least the 
following settings:
● SecurityPolicy: Basic128Rsa15
● Message Security Mode: Sign

You can deactivate the application of SecurityPolicy "none" in the configuration settings of 
the WinCC OPC UA server. 

 

User identification  
For user account identification of an OPC UA client, the WinCC OPC UA server supports the 
methods "Anonymous" and "User name / Password". Each user account must be known in 
the user administration of the operating system of the WinCC OPC UA server. 

The user identification is only used for setting up a communication session. Different access 
rights are not supported. 
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You can deactivate the support of anonymous users  in the configuration settings of the WinCC 
OPC UA server. 

See also
Configure WinCC OPC UA Server (Page 7605)

Principle of operation the WinCC OPC UA Server  (Page 7595)

OPC UA Services support

Introduction
The WinCC OPC A&E Server supports the following described functionality.

OPC UA Service Sets
The following table shows the supported OPC UA Service Sets: 

OPC UA Service Sets Services Comment
Discovery Service All -
Secure Channel 
Service
Session Service

All -

View Service Browse
BrowseNext
RegisterNodes
UnregisterNodes

Detect the displayed WinCC data: Process values 
and log process values

Attribute Service Read
Write

only WinCC tags
only WinCC tags

 HistoryRead
HistoryUpdate*

only logging tags
only logging tags

Subscription Service All only "Value" attribute of WinCC tags
MonitoredItem Service All only "Value" attribute of WinCC tags
*: With restrictions, see "Supported Write-Accesses (Page 7569)" 

OPC UA profile and Conformance Units
 

 Note

The OPC UA profiles for "Historical Access" are not yet released, that is why they are not 
listed in the following: 

 

The WinCC OPC A&E Server supports the following OPC UA profiles without restrictions:
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● 6.5.17 SecurityPolicy - Basic128Rsa15

● 6.5.18 SecurityPolicy - Basic256

● 6.5.19 SecurityPolicy - None

● 6.5.21 Base Server Behaviour Facet

● 6.5.22 Standard DataChange Subscription Server Facet

● 6.5.28 Enhanced DataChange Subscription Server Facet

● 6.5.39 UA-TCP UA-SC UA Binary

The WinCC OPC A&E Server supports the following OPC UA profiles shown in the following 
table, however with restrictions:

Profile "Group" Not supported "Conformance Unit"
6.5.25 Core Server Facet Attribute Services Attribute Write Index
6.5.26 DataAccess ServerFacet Data Access Data Access Analog

Data Access Multistate
Data Access PercentDeadBand
Data Access Semantic Changes
Data Access Two State

6.5.35 Standard UA Server Attribute Services Attribute Write StatusCode & 
TimeStamp

See also
Principle of operation the WinCC OPC UA Server  (Page 7595)

Name area of the WinCC OPC UA server

Introduction
The WinCC OPC UA server provides OPC UA clients with an hierarchical name area to display 
the following Runtime data:

● Process values (WinCC tags and WinCC tag groups)

● Data log inclusive logging tags

The name area of the WinCC OPC UA server is attached in the "Objects" default folder.

The following screen shows the name area of the WinCC OPC UA server of an active WinCC 
project on the local PC ("@LOCALMACHINE::"):
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1

2

3

① Start node of the specific name area of WinCC. 
② Display of the WinCC tags; the structure corresponds to the structure of the tags in WinCC. 
③ Display of the data log

 Display of the WinCC tags  
Tag groups, communication drivers and connections are displayed by OPC UA objects of the 
"FolderType" type. Each of these folders has references of the "Organizes" type to the 
subordinate objects and tags. 

Internal and external WinCC tags are displayed by OPC UA tags of the "DataItemType" type. 
If a WinCC tag is additionally logged, the displayed OPC UA tag has additionally a reference 
of the "HasHistoricalConfiguration" type for a log configuration. The "Historizing" and 
"AccessLevel" attributes are respectively set.

The following table shows the most important attributes of the OPC UA tags that represent a 
WinCC tag. You can find the complete list of attributes in the "OPC UA Part 3 - Address Space 
Model 1.01 Specification" document under "§5.6":

Attribute Description Comment
NodeId Unique designation of the WinCC tag  
BrowseName WinCC tag name  
DisplayName WinCC tag name  
Value Tag value and status  
DataType OPC UA data type that corresponds to the 

WinCC tag type, for example:
● Int32; signed 32 bit value
● UInt32; unsigned 32 bit value

-
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Attribute Description Comment
AccessLevel "CurrentRead" / "CurrentWrite"  

"HistoryRead" / "HistoryWrite" 
correspondingly to the WinCC 
tag configuration

ValueRank Always "Scalar" -

Display of the logging tags  
Process values and compressed logs are displayed by OPC UA objects of the "FolderType" 
type. Each of these folders has references of the "Organizes" type to the related logging tags. 

Logging tags from process value or compressed logs are displayed by OPC UA tags of the 
"BaseDateVariableType" type. A logging tag always has a reference of the 
"HasHistoricalConfiguration" type for a log configuration.

The following table shows the most important attributes of the OPC UA tags that represent a 
WinCC logging tag. You can find the complete list of attributes in the "OPC UA Part 3 - Address 
Space Model 1.01 Specification" document under "§5.6":

Attribute Description Comment
NodeId Unique designation of a logging tag  
BrowseName Name of the logging tag  
DisplayName Name of the logging tag  
Description Node description  
Value Not available For a logging tag, this attribute 

cannot be read nor changed. 
DataType OPC UA data type that corresponds to the 

WinCC tag type, for example:
● Double; 64-bit floating point number
● UInt32; unsigned 32 bit value

-

AccessLevel "HistoryRead" / "HistoryWrite" -
ValueRank Always "Scalar" -

OPC UA Data Access
Internal and external WinCC tags are displayed by OPC UA tags of the "DataItemType" type. 
Other DataAccess tag types as "AnalogItem" or "DiscreteType" are not supported. 

The WinCC OPC A&E Server supports the reading access on the OPC UA tag attributes as 
"DataType" or "AccessLevel". Writing access and subscriptions are only supported for the 
"Value" attribute. 

OPC UA Log Access

Introduction  
"OPC Historical Access" enables the access to logs and includes the "Historical Data" and 
"Alarms & Events" services. The WinCC OPC UA server supports only the "Historical Data" 
service. 
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The WinCC OPC UA Server offers the OPC clients access to the raw data of tag logs via 
"Services".

● HistoryRead (READRAW)

● HistoryUpdate (INSERTDATA, REPLACEDATA, UPDATEDATA, DELETE_RAW)

You can read and limitedly write with an OPC UA client the values of logging tags in the tag 
logs. Depending on the configuration of the tag log, the logging tag can contain either raw or 
already processed process values.

Characteristics of logging tags
According to the OPC "OPC UA Part 11 - Historical Access 1.00 Specification" document, the 
tags to be logged must have a precise reference to a tag configuration 
("HistoricalConfiguration"). A process tag can be contained in WinCC and also in several data 
logs. In this case the process tag is linked to one of the corresponding logging tags.

Attribute / Properties of log configurations
The following table shows the Properties of an OPC UA tag configuration of the 
"HistoricalConfigurationType" type: In the "Description" attribute, the logging tag comment 
configured in WinCC is displayed. You can find the complete list of attributes in the "OPC UA 
Part 11 - Historical Access 1.00 Specification" document under "§4.7.1.4":

Property Description / Value Comment
Definition WinCC process tag name For a process value log
Stepped True -

The following optional Properties are not supported:

● MaxTimeInterval

● MinTimeInterval

● ExceptionDeviation

● ExceptionDeviationFormat

Limitations for Service "HistoryUpdate"
You can use the Service "HistoryUpdate" only on process value logs. 

The following table lists the functions supported by the WinCC OPC UA server: Which functions 
are supported depends on the configuration of the WinCC OPC UA server as well as the 
process value log configuration. You will find additional information in the "OPC UA Part 11 - 
Historical Access 1.00 Specification" document under "§5.5":

Service Function Description
HistoryUpdate INSERTDATA Insert new log values
 REPLACEDATA Replace existing log values
 UPDATEDATA Replace of insert log values
 DELETE_RAW Delete log values
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See also
OPC UA Services support (Page 7598)

Name area of the WinCC OPC UA server (Page 7599)

Supported Write-Accesses (Page 7569)

Configure WinCC OPC HDA Server (Page 7576)

Configure WinCC OPC UA Server

Introduction
Define the following in the configuration settings of the WinCC OPC UA server: 

● OPC HDA Server settings

● Port number (Default: "4861)"

● Security settings

Requirement
A project with an HMI device is open. 

Procedure  
To configure WinCC OPC UA server, proceed as follows:

1. Open the "Runtime settings" of the HMI device in the project tree.

2. If necessary, configure the writing access validation at "OPC settings > OPC HDA settings". 
 

  Note

The "OPC HDA configuration" settings apply for the WinCC OPC HDA server as well as 
for the OPC UA server.

 

3. Configure the server settings at "OPC settings > OPC Unified Architecture Server 
configuration":

– Change the "Port number", if required

– Activate at least a "SecurityPolicy" and the respective "Message security mode".
 

  Note
Unsecured communication between client and server possible

Use the "none" setting only for test and diagnostics purposes.
 

Result
The WinCC OPC UA Server is configured. If you activate the project on the HMI device, the 
WinCC OPC UA server is accessible. 
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See also
Security concept of OPC UA (Page 7596)

OPC UA Log Access (Page 7601)

Supported Write-Accesses (Page 7569)

Basic settings for OPC (Page 7565)

WinCC OPC connection

Creating a connection to an OPC server

Introduction
If to an OPC DA server an external control is available, you can access its process values from 
WinCC with the help of the WinCC OPC connection. You configure for this in the engineering 
system an OPC connection to the desired OPC server. You configure afterwards WinCC tags 
for the process values of the OPC server.

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● The OPC server and the HMI device with WinCC Runtime Professional are located in a 
network

Procedure   
To create a connection to an OPC server, follow these steps:

1. On the HMI device, open the "Connections" editor.

2. Create a new connection and enter a meaningful name.

3. Choose "OPC" as the "Communication driver".

4. In the work area under "Parameters > OPC settings", enter the communication peer.

– Select the "Type of OPC server".

– Select the OPC server based on the OPC server type you chose, or enter the IP address 
or name of the remote computer.

Result
The OPC connection is configured. To access data from the OPC server, you create tags. 

See also
Accessing process values of an OPC server (Page 7607)

Using OPC in WinCC (Page 7563)
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Accessing process values of an OPC server

Requirement
● The OPC server to be addressed is ready-to-operate and in the "running" status

● A connection to the OPC-Server is created

Procedure   
To access process values of an OPC-Server via the OPC connection, follow these steps:

1. On the configuration PC in the project navigation, open the "HMI tags" editor under the HMI 
device that you use as an OPC client.

2. Create a tag with the same data type as the tag on the OPC server.

3. Select the OPC connection for "Connection".

4. Enter the "Address", or select the desired tag on the OPC server via the object list.

Result
If you launch Runtime on the HMI device, the process value from the OPC server will be written 
to the tag on the HMI device via the OPC connection. 

See also
Creating a connection to an OPC server (Page 7604)

Commissioning OPC

Configuring DCOM user permissions in Windows

Introduction   
The OPC DA client and OPC DA server are DCOM applications, whose security settings must 
be set in compliance with the DCOM security mechanisms:

● The OPC DA client needs launch/activation rights and access rights for the OPC DA server.

● The OPC DA server only needs access rights for the OPC DA client.

The following must be known on the PCs of the OPC DA server and the OPC DA client 
respectively:

● The user account for which the OPC DA client is executed

● The "Simatic HMI" user group

The "Simatic HMI" user group is already created on an HMI device during installation. The 
security settings of WinCC OPC DA server and the WinCC OPC channel are also 
preconfigured during installation.
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In order to create an additional user for the operation of the OPC DA client, add the user as a 
member to the "Simatic HMI" user group.

Requirement
You have administrator rights.

Setting up a user account on PCs with an external OPC DA server or external client
On PCs without a WinCC installation, you configure the access rights manually. 

1. Open Windows user administration.

2. Create the "SIMATIC HMI" user group.

3. Under "DCOM > My Computer > COM Security > Access Permissions > Edit Default" enter 
the permissions "Local Access" and "Remote Access".

4. Assign the user accounts for this user group.

For additional information on granting user rights, refer to the documentation for 
Windows XP / Vista / 7. 

Adjusting Windows firewall settings

Introduction
After installation of WinCC, the Windows firewall settings of the WinCC OPC servers are 
correctly configured.

If OPC clients access OPC servers in different subnets, you must adapt the configuration of 
the permitted network areas to the OPC servers. 

10.17.2 Customer controls

10.17.2.1 Overview

Introduction   
 

User-specific controls are used to create and standardize complex, frequently used screen 
objects. The WinCC Control Development add-on is required to develop controls. 
Programming is carried out in Visual Studio 2008 or Visual Studio 2010 with .NET Framework 
2.0, 3.0 or 3.5.

You can, for example, place several motors of a similar type in a plant. In a customer control, 
you can summarize motor data such as operating mode, setpoint, actual value, rotational 
speed, operational status, frequency. 
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Hz

Frequency

Value

Setpoint

Process value

Manual Auto

Mode

1/minute

Speed

M

Operating mode

Off

On
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When the customer control is finished, you can integrate it an unlimited number of times into 
WinCC screens, as well as in other applications.

Central changes to the customer control are automatically adopted at all usage locations. In 
this way, you can later expand a customer control with additional functionality. The changes 
are effective on all customer controls of this type used in WinCC screens that are already 
configured.

Target group of this documentation
This documentation is aimed at configuration engineers with knowledge of VB.net or C#.

Service & Support on the Internet
In addition to our documentation, we offer a comprehensive knowledge base on the Internet 
at: www.siemens.com/automation/service&support

 

10.17.2.2 Interfaces

Introduction       
To access the WinCC tag value, WinCC makes interfaces available for access to the WinCC 
data provider. The connection to the WinCC data provider is established or disconnected using 
methods. Methods are also used to read or write tag values synchronously or asynchronously.  

● Synchronous:
The customer control sends a request to the data provider for which a reply is expected 
immediately. The customer control waits until a reply comes from the data provider. 

● Asynchronous:
The customer control sends a request to the data provider for which a reply is not expected 
immediately. Sending the request and receiving the reply occur at separate times.

Interfaces 
● ITag

The ITag object supports the following methods:

Method Description
Register Registers the customer control as a consumer at the data provider. The 

consumer receives a cookie from the data provider. The cookie is used to 
assign a request from the data provider to a consumer.

ReadTag Reads the value of one or more tags at the same time
ReadTagAsync Reads the tag value asynchronously
ReadTagCyclic Cyclic reading of the tag values. The update cycle is used to determine how 

often the value is updated. 
RemoveCyclicTag Removes one or more tags
Cancel Cancels the cyclic reading of the tag values
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Method Description
WriteTag Writes values to one or more tags synchronously
WriteTagAsync Writes values to one or more tags asynchronously
Unregister Removes the consumer

● ITagSink
The ITagSink object reacts to specific events using methods.

Method Description
OnCanceled Occurs when the ITag method "Cancel" has ended.
OnDataChanged Occurs when a tag value is changed by the following ITag methods:

● ReadTagAsync
● ReadTagCyclic

OnError Occurs as an event of an error with the following methods:
● ReadTagAsync
● ReadTagCyclic
● WriteTagAsync
● OnDataChanged
● OnWriteComplete

OnRemoved Occurs when the ITag method "RemoveCyclicTag" has ended.
OnWriteComplete Occurs when the ITag method "WriteTagAsync" has finished.

Requirement
● This documentation is aimed at configuration engineers with knowledge of VB.net or C#.

● The "Siemens.Runtime.ControlDev.dll" reference is set. For further details, refer to "Setting 
the reference "Siemens.Runtime.ControlDev.dll". 
Storage of file:

– WinCC Runtime Professional: …\Siemens\WinCC\bin

– WinCC Runtime Advanced: ...\WinCC Runtime Advanced

Basic procedure
1. Create an ITag object to connect to the data provider.

2. The "Register" method is used to register the customer control as a consumer of the data 
provider. The consumer receives a cookie from the data provider. The cookie is used to 
identify the access by the consumer to the data provider.

3. When the connection is established, you can access the tag values using the methods of 
the ITag object.

See also
Cancel (Page 7625)

ReadTag (Page 7622)
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ReadTagAsync (Page 7623)

ReadTagCyclic (Page 7624)

Register (Page 7622)

RemoveCyclicTag (Page 7624)

Unregister (Page 7627)

WriteTag (Page 7625)

WriteTagAsync (Page 7626)

OnCanceled (Page 7627)

OnDataChanged (Page 7628)

OnError (Page 7629)

OnRemoved (Page 7629)

OnWriteComplete (Page 7630)

Check the reference "Siemens.Runtime.ControlDev.dll" (Page 7613)

10.17.2.3 Demo project

Requirement
● You need WinCC RT Professional or WinCC RT Advanced in order to test the demo 

projects.

● Correspondingly installed configuration software (Visual Studio 2008 or Visual Studio 2010) 
is required to open the demo projects.

Demo project "CCITagTestLibrary"
In the directory "%Program Files%\Siemens\Automation search for the folder "samples". The 
demo projects "CCITagTestLibrary" are contained there. The various methods of iTag-
Interfaces are used in these demo projects. 

● "VB100\CCITagTest\ CCITagTestLibrary" is the demo project for Visual Studio 2010.

Use the demo project as a template for your own customer controls. This demo project includes 
the interface to the data provider of WinCC.

To use the demo project, proceed as follows:

1. Copy the entire "CCITagTestLibrary" folder to a local destination directory.

2. Double-click on the "CCITagTestLibrary.sln" file.

See also
Creating and testing customer controls (Page 7613)
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10.17.2.4 Creating and testing customer controls

Creating and testing customer controls

Introduction
This section shows the basic procedure for creating and testing a customer control in VB.net. 

To follow the configuration steps, use a VB.net project that uses the provided 
"CCITagTestLibrary" demo project as a template.

Requirement
● Visual Studio 2008 or Visual Studio 2010 

● WinCC RT Advanced or WinCC RT Professional

● WinCC project for WinCC RT Professional or WinCC RT Advanced has been created. For 
additional information, refer to "Editing a project".

Basic procedure
To create and test the "ITagUserControl" customer control, proceed as follows:

1. Check the reference "Siemens.Runtime.ControlDev.dll" (Page 7613)

2. Create a user interface (Page 7615).

3. Create the program code (Page 7616).

4. Create customer controls (Page 7617).

5. Test customer controls in Visual Studio (Page 7618).

6. Test customer controls in WinCC (Page 7620).

See also
Demo project (Page 7610)

Creating a WinCC project (Page 7618)

Check the reference "Siemens.Runtime.ControlDev.dll"

Introduction   
To access the data provider of WinCC, the VB.net project is linked to the 
"Siemens.Runtime.ControlDev.dll" library.
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Requirement
● Visual Studio 2008 or Visual Studio 2010 is installed.

● A VB.net project is open. The VB.net project uses the demo project as a template.

Procedure
Proceed as follows to verify the reference:

1. In Solution-Explorer, double-click the "CCITagTestLibrary > My Project" item.

The Project Designer opens.

2. Click on "References" in the Project Designer.

3. If the reference is not set, click on "Add...". In the "Add Reference" dialog, click "Browse".

4. In WinCC Runtime Professional, navigate to the directory "...\Siemens\WinCC\bin".
In WinCC Runtime Advanced, navigate to the directory "...\WinCC Runtime Advanced".

5. Select the entry "Siemens.Runtime.ControlDev.dll". Click "OK".
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See also
Interfaces (Page 7608)

Creating a user interface

Settings
For the configuration you require objects with the following settings:

Object Quantity Property Setting
GroupBox 1 Text ReadTag
Label 2 Text

Text
TagName
Value

Textbox 2 (Name) txtReadTagTagName
(Name)
ReadOnly

txtReadTagValue
True

Button 1 Text
(Name)

Read
btnReadTagStart

Requirement
● A VB.net project is open. The VB.net project uses the demo project as a template.

● The toolbox is displayed.

● The properties window is displayed.

Procedure   
To create the user interface, follow these steps:

1. In Solution-Explorer, double-click the "CCITagTestLibrary > ITagUserControl.vb" item. The 
Form Designer opens.

2. Insert a GroupBox into the form from the tool window. Configure the GroupBox with the 
settings described above.

3. Insert two text box objects into the form from the tool window. Configure the objects with 
the settings described above.

4. Add two labels to the form. Configure the labels with the settings described above.

5. Add a button to the form. Configure the button with the settings described above.
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Result
The user interface for the "ITagUserControl" customer control has been created.

Creating program code

Introduction
To use customer control to access the WinCC tag values, implement the access to the ITag 
interface. 

Procedure     
To create the program code, proceed as follows:

1. For access to the ITag interface, enter the following:

 
   ' ITag interface
   Dim m_ITag As ITag ' get the Tagset Object from the container
   m_ITag = Site.GetService(GetType(ITag))
   ' Connect to server
   m_RegisterCookie = m_ITag.Register(Me)

 

1. Double-click the "btnReadTagStart" button in the Form Designer. The code window with 
the "btnReadTagStart_click" subprocedure opens automatically.

2. Insert the following code between "Sub btnReadTagStart_Click" and "End Sub".

 
Private Sub btnReadTagStart_Click(ByVal sender As Object, ByVal e As EventArgs) 
_Handles btnReadTagStart.Click
  Try
   Dim TagName As Object = "Tag_Test" ' name of the tag, e.g. coming from TextBox
   Dim Values As Object = m_ITag.ReadTag(m_RegisterCookie, TagName)
   Dim Value
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   Dim strResult
   For Each Value In Values
     strResult = CStr(Value) ' the result of the ReadTag could be written in a TextBox 
(Ensabled = False)
   Next
   Catch ex As Exception
     MsgBox("ReadTag:" & vbCrLf & ex.Message)
   End Try
End Sub

Result
Access to the ITag interface is implemented and the code for the button "btnReadTagStart" is 
created.

To access the ITag interface from Visual Studio, the ProgID of the data provider must be 
transferred.

● ProgID for WinCC Runtime Professional: CCITagControl.ITagControl.1

● ProgID for WinCC Runtime Advanced: FwTagDataProvider.FwTagDataProvider

Example:

 
' Create the TagServer Object
Dim oTagServer As Object = CreateObject("CCITagControl.ITagControl.1")
' Set the Tagset Object
m_ITag = oTagServer

You can find the full program code in the demo project "CCITagTestLibrary".

Creating customer controls

Procedure   
To create the customer control, proceed as follows.

1. Double-click the "My Project" entry in the project folder explorer. The Project Designer 
opens.

2. Click on the "Compile" button in the Project Designer. Specify the destination directory for 
the DLL file for "Build output path".

3. Save the change in the VB.net project "CCITagTestLibrary".

4. Select the "CCITagTestLibrary" entry in the project folder explorer. Select the "Build" 
command in the shortcut menu.

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
System Manual, 02/2014 7615



Result
The "ITagUserControl.dll" file is now located in the destination directory. The customer control 
"ITagUserControl" will be displayed in the toolbox.

Testing customer controls in Visual Studio

Creating a WinCC project

Introduction
To test the "ITagUserControl" customer control, you will have to create the "HMI_Variable_1" 
tag and the "CC_ITagUserControl" screen in WinCC.

Requirement
● WinCC project for WinCC RT Professional or WinCC RT Advanced has been created.

● The "CC_ITagUserControl" screen has been created and opened.

● The internal tag "HMI_Variable_1" has been created.

Procedure
To create the WinCC project for the test, proceed as follows:

1. Add an I/O field in the "CC_ITagUserControl" screen. Link the I/O field to the 
"HMI_Variable_1" tag.

2. Add a slider to the screen. Link the slider to the "HMI_Variable_1" tag.

3. Configure the "SetTag" system function at the "Change" event with the following settings.

Parameter Setting
Tag (output) HMI_Variable_1
Value HMI_Variable_1

Result
The "CC_ITagUserControl" screen has been created. The tag value in the I/O field will be 
displayed when you use the slider in Runtime.
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Creating a test form

Introduction   
You cannot test the "ITagUserControl" customer control in the Visual Studio Form Designer. 
You need a test form to test the customer control.

Requirement
"ITagUserControl" customer control has been created.

Procedure
Proceed as follows to create a test form:

1. In Solution-Explorer " select the project folder "CCITagTestLibrary". Select "Add > New 
Project..." in the shortcut menu. The "Add new project" dialog opens.

2. In the left window "Project types" under "Other languages > Visual Basic", select the entry 
"Windows". In the right window "Templates" select the entry "Windows Forms Application".

3. Enter "TestCustomControl" as the "Name". Click "OK".

4. A test form opens. Insert the "ITagUserControl" control into the test form.

5. Double-click the "TestCustomControl > My Project" entry in the project folder explorer. The 
Project Designer opens.

6. Click on "References" in the Project Designer. Verify that the reference to 
"Siemens.Runtime.ControlDev.dll" has been set.
Storage of file:

– WinCC Runtime Professional: …\Siemens\WinCC\bin

– WinCC Runtime Advanced: ...\WinCC Runtime Advanced

7. Save the project

Result
You have created the test form for testing the "ITagUserControl" customer control. 

Testing customer controls in Visual Studio

Requirement    
● WinCC runtime is started.

● Test form is created.
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Procedure
To test the customer control in Visual Studio, proceed as follows:

1. Start the test of the customer control with <F5>. The "Form1" form opens.

2. Enter "TK_Test5" in the "TagName" field. Click "Read".

Result
The tag value "TK_Test5" will be displayed in the "Value" field. Move the slider to change the 
tag value in WinCC. The current tag value will be displayed in the I/O field. Click on "Read" to 
update the tag value in the customer control. 

An error message will appear if you enter an incorrect tag name in the "TagName" field.

Testing customer controls in WinCC

Adding customer control in WinCC

Introduction
To use customer controls in WinCC, you need to add them to the "My Controls" palette.
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Procedure
To add customer controls, proceed as follows:

1. Open a screen.

2. Select the "Select object" command in the shortcut menu of the "Tools" task card.

3. Click "Specific .Net Controls" in the "Select control" dialog. Navigate to the desired customer 
control, for example "ITagUserControl", in the "Select assembly" field.

4. Select the "ITagUserControl" customer control.

5. Click "OK".

Result
The"ITagUserControl" customer control is displayed in the "My Controls" palette.

Testing customer controls in WinCC

Requirement
● The "CC_ITagUserControl" screen has been created and opened.

Procedure
To test the "ITagUserControl" customer control, proceed as follows:

1. Add a "ITagUserControl" to the screen.

2. Start WinCC Runtime with the start screen "CC_ITagUserControl".

3. Move the slider. The new value is displayed in the I/O field.

4. Enter "TK_Test5" in the "TagName" field.

5. Click on the button "Read".

Result
The "ITagUserControl" customer control has been added. If you activate WinCC Runtime, the 
tag value is displayed in the "Value" field.
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10.17.2.5 Reference

ITag methods

Register

Description  
Registers the customer control as a consumer at the data provider. The consumer receives a 
cookie from the data provider. The cookie is used to assign a request from the data provider 
to a consumer.

Syntax
RegisterCookie Object.Register (CustomerControl) 

Parameter

Object
Name of the ITag object

Customer Control
Name of the customer controls

Return value

RegisterCookie
Cookie to identify the consumer

ReadTag

Description  
Reads the value of one or more tags at the same time.

Syntax
Values Object.ReadTag(RegisterCookie, TagNames)

Parameter

Object 
Name of the ITag object
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RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

Return value

Values
Tag value

ReadTagAsync

Description  
Reads the value of one or more tags asynchronously.

Syntax
Object.ReadTagAsync (RegisterCookie, TagNames, ClientCookies, CacheDevice)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

ClientCookies
Cookie for identification of tags

CacheDevice
This parameter is only evaluated by WinCC RT Professional.

0 = The tag value is read from the process image (cache).

1 = The tag value is read directly from the AS.

See also
OnDataChanged (Page 7628)

OnError (Page 7629)
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ReadTagCyclic

Description
Cyclic reading of the tag values. The update cycle is used to determine how often the value is 
updated.  

Syntax
Object.ReadTagCyclic (RegisterCookie, TagNames, UpdateRates, ClientCookies, 
ServerCookies)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

UpdateRates
Update cycle of the tags. The value is entered in milliseconds.

ClientCookies
Cookie for identification of tags

Return value

ServerCookies
Cookie for identification of tags The return value is used by the ITag method 
"RemoveCyclicTag (Page 7624)".

See also
OnDataChanged (Page 7628)

OnError (Page 7629)

RemoveCyclicTag

Description   
Removes one or more tags.
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Syntax
Object.RemoveCyclicTag (RegisterCookie, ServerCookies)

Parameter

Object
Name of the ITag object.

ServerCookies
Cookie for identification of tags 

See also
ReadTagCyclic (Page 7622)

OnRemoved (Page 7629)

Cancel

Description  
Cancels the cyclic reading of the tag values.

Syntax
Object.Cancel (RegisterCookie)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

See also
OnCanceled (Page 7627)

WriteTag

Description  
Writes values to one or more tags at the same time.
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Syntax
Object.WriteTag(RegisterCookie, TagNames, Values)

Parameter

Object 
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

Values
Values written to the tags

WriteTagAsync

Description  
Writes values to one or more tags asynchronously.

Syntax
Object.WriteTagAsync(RegisterCookie, TagNames, ClientCookies, Values)

Parameter

Object 
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag name

ClientCookies
Cookie for identification of tags

Values
Values written to the tags
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See also
OnError (Page 7629)

Unregister

Description 
Removes the consumer.

Syntax
Object.Unregister (RegisterCookie)

Parameter

Object
Name of the ITag object

RegisterCookie
Cookie to identify the consumer

ITag methods

OnCanceled

Description  
Occurs when the ITag method "Cancel (Page 7623)" has ended.

Syntax
Object.OnCanceled (RegisterCookie)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer
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OnDataChanged

Description  
Occurs when a tag is changed by the following ITag methods.

● ReadTagAsync (Page 7621)

● ReadTagCyclic (Page 7622)

Syntax
Object.OnDataChanged (RegisterCookie, TagNames, Values, Qualities, VarStates, 
TimeStamps, ClientCookies)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

Qualities
Quality code of the tags

VarStates
Tag status of the tags

TimeStamps
Time stamp

ClientCookies
Cookie for identification of tags

See also
OnError (Page 7629)
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OnError

Description  
Occurs as an event of an error with the following methods:

● ReadTagAsync (Page 7621)

● ReadTagCyclic (Page 7622)

● WriteTagAsync (Page 7624)

● OnDataChanged (Page 7626)

● OnWriteComplete (Page 7630)

Syntax
Object.OnError (RegisterCookie, TagNames, ClientCookies, Errors)

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

ClientCookies
Cookie for identification of tags

Errors
Error code 

OnRemoved

Description  
Occurs when the ITag method "RemoveCyclicTag (Page 7622)" has ended.

Syntax
Object.Remove(RegisterCookie, ClientCookies)

Parameter

Object
Name of the ITagSink object
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RegisterCookie
Cookie to identify the consumer

ClientCookies
Cookie for identification of tags

OnWriteComplete

Description  
Occurs when the ITag method"WriteTagAsync (Page 7624)" has finished.

Syntax
Object.OnWriteComplete(RegisterCookies, TagNames, ClientCookies)

Parameter

Object
Name of the ITagSink object

RegisterCookie
Cookie to identify the consumer

TagNames
Tag names

ClientCookies
Cookie for identification of tags

See also
OnError (Page 7627)

10.17.3 Access to archive data via WinCC OLE DB Provider

10.17.3.1 Bases of OLE DB

Introduction          
Using the OLE DB interface and the associated database provider supplied by WinCC, you 
have access to process value and message archives.
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OLE DB
OLE DB is an open standard for a fast access to different databases. It is irrelevant whether 
the database is relational or not.

The connection between the OLE DB level and the database is established through a database 
provider.

OLE DB interfaces and providers are offered from various manufacturers. 

WinCC OLE DB Provider
Using WinCC OLE DB Provider, you may directly access WinCC archive data stored in the 
MS SQL server database. Depending on the configuration, process data of WinCC are stored 
in compressed form. WinCC OLE DB Provider permits transparent access even to these data.

Microsoft OLE DB 
Microsoft OLE DB only provides access to WinCC user archives. 

Access to WinCC User Archives using Microsoft OLE DB requires a Connectivity Pack license 
on the computer where the WinCC user archives will be accessed. A WinCC Client Access 
License is required for remote access to the MS SQL Server database. 

As protection from unauthorized access using MS OLE DB, the administrator of the databases 
can take appropriate actions. Additional information may be found in Chapter "Security Settings 
for Access to SQL Databases Using MS OLE DB".  

 

 Note

Microsoft OLE DB is only tested and released for access to WinCC user archives but not to 
alarm and process value archives. 
Use the WinCC OLE DB Provider to access message and process value archives.
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10.17.3.2 WinCC OLE DB Provider

Introduction                             
The WinCC OLE DB Provider makes access to the process value and alarm archives possible. 

The WinCC OLE DB Provider also provides analysis functions, such as minimum, maximum 
of archive tags.

Access to archive data
Access to archive data can take place under different constellations:

Simultaneous access to archive and Runtime databases 
The function "ArchiveMonitor" combines the data of the Runtime and archive databases of the 
activated WinCC project in an SQL database.

The SQL database is called "CC_ExternalBrowsing" and creates the views "AMT" and 
"ARCHIVE".

The views provide all necessary information for the WinCC OLE DB Provider.

Because these views provide all the necessary information for the WinCC OLE DB Provider, 
the "CC_ExternalBrowsing" database can be used as a data source for the provider. 

On deactivating WinCC runtime, views additionally created in "CC_ExternalBrowsing" are 
deleted once again. 

Because a long-term archive server does not contain any runtime databases, access to the 
archive databases using the "CC_ExternalBrowsing" database is not possible.  

WinCC OLE DB Provider as a "Linked Server"
 

 Note

When configuring WinCC OLE DB Provider as a "Linked Server", the "WinCC OLE DB-
Provider for Archives" entry must be selected in the "Provider Name" field of the ""Linked 
Server Properties" dialog.

Activate the "AllowInProcess" check box in the "Provider Options" dialog. 
Additional information is available here: "SQL Server Books Online" under "Configuring OLE 
DB Providers for Distributed Queries".

 

The WinCC OLE DB Provider can be registered in the SQL server in the list of "Linked Servers". 
Regardless if the database is stored locally or remote . 

Example:

WinCC OLE DB Provider as a Linked Server with the server name "WinCC":
select min(realvalue) from openquery(WINCC,'Tag:R,1,''0000-00-00 
00:01:00.000'',''0000-00-00 00:00:00.000''') 
select * from openquery(WINCC,'Tag:R,1,''0000-00-00 
00:01:00.000'',''0000-00-00 00:00:00.000''') 
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10.17.3.3 Installation

Installation of WinCC OLE DB-Provider
The WinCC OLE DB-Provider  is automatically installed along with WinCC V12.

The WinCC OLE DB Provider is available for the following systems after installation of 
WinCC V12:

● Engineering station with WinCC V12

● HMI device with WinCC RT Professional V12

 

10.17.3.4 WinCC Archive Connector

WinCC Archive Connector

Functionality
The WinCC "Archive Connector" is used for configuring the access to the archive database. 

The tool is an integral part of WinCC DataMonitor. 

With the Archive Connector, already swapped out WinCC archives can be reconnected to an 
SQL Server. 

The DataMonitor client or WinCC OLE DB Provider can then access the archives once again. 

Functions of the WinCC Archive Connector:

● Manual Connection: Local databases may be selected and connected to the local SQL 
server.

● Manual Disconnection: Connected databases may be selected and disconnected from the 
SQL server.

● Automatic Connection: Local directories can be selected in which WinCC archives are 
swapped. All archives which were added to the selected directories from the moment 
change monitoring was activated are automatically linked to the SQL server.

The Archive Connector may only be operated using a local SQL server and a WinCC 
DataMonitor license.
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Once the configuration has been completed, the Archive Connector may be closed. 
 

 Note

WinCC RT archives in the directory "<Project Directory> \ ArchiveManager" and the 
associated subdirectories must not be connected to or disconnected with the Archive 
Connector because their connection to the SQL server is managed by the WinCC RT 
Professional HMI device.

The path for the swapped out WinCC archives is set in WinCC with the Archive Configurator 
of tag logging, for example, not with the WinCC Archive Connector.

If access is to be made to swapped out archives which are on stored removable media, such 
as tape or MOD drives, pay attention that the connection to these archives on this medium 
is disconnected using the Archive Connector before changing the medium in the drive. After 
changing the medium, the user should check the Archive Connector whether or not the 
archives on the new medium are connected.

Configuration with the WinCC Archive Connector should be restricted to a limited group of 
people. This means access to the tool should be protected by using the Windows 
"Administrators" user right or other Windows protection mechanisms, such as storage in a 
protected directory.

 

 Note

Use the Archive Connector or DataMonitor to access the connected archives. 

The following objects do not give any access to the archives linked with the Archive Connector:
● Alarm view
● Table view
● f(t) trend view
● f(x) trend view
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The "Configuration" tab

The "Configuration" tab

In the "Configuration" tab, archiving folders are displayed and managed that are to be accessed 
through the web or the WinCC OLE DB-Provider.

Archiving folders can be added or removed by using the buttons. A symbolic, unique name 
has to be assigned during configuration for each archiving folder.

The DataMonitor client or the WinCC OLE DB-Provider  use the symbolic name to access the 
archive.

The name is also used for managing and connecting swapped out data from several computers 
or projects.

The symbolic names must only contain characters permitted in the SQL syntax. 

By activating the corresponding check box, all archives added to the selected folder at the time 
of activation will automatically be connected to the SQL server.

If you activate or deactivate monitoring, the changes will not be activated until you close the 
Archive Connector.
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The "Connect/Disconnect Archive" tab

The "Connect/Disconnect Archive" tab

The "Connect/Disconnect Archive" tab lists all archives existing in the archiving directories. 

The connection status of each archive is displayed. The connection to the archives can be 
established or terminated by using the buttons.

The archive type is shown in the "Type" field.

● "A" = Alarm Logging;

● "TF" = Tag Logging (Fast);

● "TS" = Tag Logging (Slow).
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The columns "From" and "To" provide information on the local time zone.
 

 Note

The connection of multiple, swapped-out archives to the SQL server may take several 
seconds.

It is not possible to connect a database file with the same name twice.

The WinCC Archive Connector connects finalized and backed up (swapped-out) archives to 
the SQL server. Archives not finalized are not supported.

The user interface language of the Archive Connector is based on the settings of the regional 
and language options in Windows.

 

 Note

Archives created with SQL Server 2000 can only be connected if you remove the write 
protection of the archive. Archives that are linked can no longer be linked with the Archive 
Connector under SQL Server 2000.

In order to connect swapped out archives on CD or DVD, copy the archives to a media on 
which you can remove the write protection.

 

10.17.3.5 Access to archive data via OLE DB Provider

Options for accessing archive data

Introduction        
Using OLE DB, you have the following options for accessing WinCC archive data and for 
displaying them using an external interface. 

Access with WinCC OLE DB Provider
WinCC OLE DB provides access to all WinCC archive data.

Depending on the configuration, process data of WinCC are stored in compressed form. 
WinCC OLE DB Provider permits transparent access even to these data. 

Use the "SQL Server Import / Export Wizard" to take advantage of standard SQL queries. You 
can save the unzipped files to an intermediate database using the wizard; you access the 
database with standard SQL queries. 

 

 Note

If WinCC closes a full archive and opens a new one, no data from the message and process 
value archives are read momentarily via the OLE DB Provider. 
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Access with Microsoft OLE DB 
Microsoft OLE DB provides access to all WinCC user archives. 

 

 Note

Microsoft OLE DB is only tested and released for access to WinCC user archives but not to 
alarm and process value archives. 
Use the WinCC OLE DB Provider to access message and process value archives.

 

 

Configuring access to archive data

Configuration options
For access to databases with WinCC OLE DB, you may write your own applications. 

For the communication with the WinCC OLE DB-Provider, ADO DB is used in applications 
created with, for example, Visual Basic, VBScript or VBA. 

 

 Note
Special characters in tag names

Please not that programming languages, such as Visual Basic, VBScript or VBA, only allow 
the following characters in the tag names: "A to Z", "a to z", "0 to 9" and "_". 

If you use special characters, such as "," or ";", in the tag names in WinCC, the script will be 
aborted with an error message. In this case use the "Tag ID" to access a tag with special 
characters in the script name. 

 

Requirements
● WinCC RT Professional or WinCC V12 must be installed on the accessing computer for 

access to archive data.

● For swapped out archives, establish the connection between the SQL database and the 
swapped out archives with the WinCC Archive Connector.

 

  Note

The WinCC RT archives in the directory "<Project directory> \ ArchiveManager" and the 
associated subdirectories must not be connected or disconnected with the Archive 
Connector, because their connection to the SQL server is managed by WinCC RT 
Professional.
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Procedure
1. Establish the connection to the database, for example, by using MS Excel or your own 

application.

2. Define the required selection criteria.

3. Read out the archive data.
The query result may be displayed in MS Excel, for example, or exported as a CSV file.

 

Establishing the Connection to the Archive Database

Introduction
For ActiveX data objects (ADO), the connection between the application and the archive 
database is established by the connection object. An important parameter here is the 
ConnectionString. The ConnectionString contains all necessary information for access to the 
database using OLE DB Provider.

Structure of the ConnectionString
"Provider = Name of the OLE DB Provider; Catalog=Datebase name;Data 
Source=Server name;"

Parameter Description
Provider Name of the OLE DB Provider: 

e.g. WinCCOLEDBProvider 
Catalog Names of the WinCC database

With WinCC RT databases, you will use database names that end in "R." 
<Datenbankname_R>.
The database "CC_ExternalBrowsing" can also be used. 
If you have connected swapped out WinCC archives to the SQL Server via the WinCC 
Archive Connector, use their symbolic name. 
Note
Enter the WinCC project name for "Catalog" for transparent access; for e.g.: 
"Catalog=WinCC_Project_Name".
Note
If you access message archives or swapped out archives via "CC_ExternalBrowsing", 
this access may take several minutes.

Data 
Source

Server name
Local: ".\WinCC" or "<Computer Name>\WinCC" 
Remote: "<Computer name>\WinCC"
Note
Enter the transparent access to the Central Archive Server and in case of redundant 
servers enter the following via the OLE DB-Provider for "Data Source":
<Symbolic Computer Name>::\WinCC. 
Note
Use the archive tag name to directly access an archive tag on the central archive server 
CAS. The central archive server CAS returns the CAS-ID and not the archive tag ID as ID: 
<SYMBOLIC COMPUTER NAME>\\<Achive_Var_Name>

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
System Manual, 02/2014 7637



 

Example Process Value and Message Archive:
In the following example, a connection object is created with subsequent opening of the 
connection to the WinCC database (process value and message archive).

Set conn = CreateObject("ADODB.Connection")
conn.open "Provider=WinCCOLEDBProvider.
1;Catalog=CC_OpenArch_03_05_27_14_11_46R;Data Source=.\WinCC"
 

Example User Archive:
In the following example, a connection object is created with subsequent opening of the 
connection to the WinCC user archive.

Set conn = CreateObject("ADODB.Connection")
conn.open "Provider=SQLOLEDB.1; Integrated Security=SSPI; Persist 
Security Info=false; Initial Catalog=CC_OpenArch_03_05_27_14_11_46R; 
Data Source=.\WinCC"

 

 Note

In order to improve performance during local access, enter "<Computer Name>\WinCC" as 
the data source instead of ".\WinCC".

 

10.17.3.6 Application cases

Use Case 1: Local Access to WinCC RT Databases

Requirements
The following licenses must be installed on the HMI device:

● WinCC RT Professional

Principles
An application uses the WinCC OLE DB-Provider to access the local WinCC Runtime 
database. 

You may locally analyze the archive data and may, for example, calculate the standard 
deviation of a process value.
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Use Case 2: Remote Access to WinCC RT Databases

Requirements
The following licenses must be installed on the HMI device:

● WinCC RT Professional

The access may take place under various configurations of the Connectivity Pack Client.

● A WinCC software, such as WinCC V12, Web Navigator server or DataMonitor server, is 
installed on the client computer. 
The client does not have to be installed explicitly. Licensing is provided through WinCC 
licenses.   

Principles     
The client accesses the WinCC runtime database of an HMI device with 
WinCC RT Professional remotely. The client reads the data of the process value archives and 
alarm logs using the WinCC OLE DB Provider. 

Since in this use case, the swapped-out WinCC archive is not accessed, the Archive Connector 
does not have to connect WinCC archives to an SQL server. 

You can display, evaluate or further process the data on the client by exporting it to a CSV file, 
for example. 
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Use Case 3: Local Access to WinCC Archive Databases

Requirements
The HMI device requires the following installations: 

● WinCC V12

● WinCC RT Professional

Principles
An application accesses the local archive database using WinCC OLE DB Provider. The older 
archive data are copied from the WinCC RT database to a separate directory on the same 
computer.

With the Archive Connector, the swapped out WinCC archives are reconnected to an SQL 
Server. The archives are then available for access using WinCC OLE DB Provider. 

Local archive data may be displayed, searched or analyzed, e.g. to search for process errors 
or to optimize processes.
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Use Case 4: Remote Access to WinCC Archive Databases

Software Requirements
The long-term archive server requires the following to be installed: 

● Connectivity Pack Server

Access may take place under various configurations of the client.

● A WinCC software, such as WinCC V12 RT Professional, WinCC V12, Web Navigator 
server or DataMonitor server, is installed on the client computer. 
The client does not have to be installed explicitly. 
Licensing is provided through WinCC licenses.  

Principles     
A long-term archive server is used to secure database files of process value and alarm logs, 
for example, in a monthly backup. 

With the Archive Connector, already swapped out WinCC archives can be reconnected to an 
SQL server. The archives are then available for access using WinCC OLE DB Provider. 

The client accesses the archives with the WinCC OLE DB-Provider . Using a VB application, 
for example, the archives may be analyzed, and process values of a specific day may be 
displayed. 

 

 Note

It may take several minutes if you access alarm logs or swapped out archives with 
"CC_ExternalBrowsing".
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Use Case 5: Local Access to WinCC User Archive

Requirements
The HMI device requires the following installations: 

● WinCC RT Professional

Principles
An application accesses the local WinCC user archives with the Microsoft OLE DB 
Provider.     

Using a VB application, for example, you may display, search and write back modified values 
to local archive data. 
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Use Case 6: Remote Access to WinCC User Archives

Requirements
The HMI device requires the following installations: 

● WinCC RT Professional

Access may take place under various configurations of the Connectivity Pack Client.

● A WinCC software, such as WinCC RT Professional, Web Navigator server or DataMonitor 
server, is installed on the client computer. 
The client does not have to be installed explicitly. Licensing is provided through WinCC 
licenses.

Principles     
The client accesses the WinCC user archives with the MS OLE DB Provider. 

Using a VB application, for example, you may display, search, and write back modified values 
for archive data. 

10.17.3.7 Querying the archive data

Displaying Process Value Archives

Introduction
The query result is returned as the Recordset. In this chapter, the structure of Recordset for 
process value archives is described.
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Recordset Structure

Field name Type Comments
ValueID Integer 4 Bytes or 

Integer 8 Bytes
Unique identification of value. 
The length depends on the type of query. 

TimeStamp DateTime Time Stamp
RealValue Real 8 Bytes Tag value
Quality Integer 4 Bytes QualityCode of value (e.g. "good" or "bad").
Flags Integer 4 Bytes Internal Control Parameter

 

 

Querying Process Value Archives

Principle      
With the following query, a process value archive can be accessed. The data can be selected 
using filter criteria. The queries are forwarded to the database by the command object. 

 

 Note

The length of the ValueID can be different. 
● For databases processed on a central archive server (CAS), the ValueID is 8 Bytes long 

and includes a server ID in the HI-DWORD area as well as the ValueID assigned by the 
respective server in the LO-DWORD area.

● For all other databases, the ValueID is 4 Bytes long and includes only the unique ValueID 
assigned by the WinCC server.

The 4-Bytes request via TAG:R is still available for compatibility. The 4-Byte ValueID returned 
is no longer unique in case of CAS databases. 

Queries for process value archives are limited to a maximum of 20 tags, each with a maximum 
of 128 characters per tag. 

 

Syntax
Note that the query may not contain any spaces.

Request of ValueIDs 8 Bytes long: 

TAG_LLVID:R,<ValueID oder 
ValueName>,<TimeBegin>,<TimeEnd>[,<SQL_clause>][,<TimeStep>]
Request of ValueIDs 4 Bytes long: 

TAG:R,<ValueID oder ValueName>,<TimeBegin>,<TimeEnd>[,<SQL_clause>]
[,<TimeStep>]
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Parameter

Parameter Description
ValueID Value ID from the database table 

Multiple namings are possible, e.g., 
"TAG:R,(ValueID_1;ValueID_2;ValueID_x),<TimeBegin>,<TimeEnd>" 

ValueName ValueName in format 'ArchiveName\Value_Name'. The <ValueName> parameter must be enclosed in 
single quotes. 
Multiple namings are possible, e.g., 
"TAG:R,('ValueName_1';'ValueName_2';'ValueName_x'), <TimeBegin>,<TimeEnd>"
Note
Please not that programming languages such as Visual Basic, VBScript or VBA only allow the following 
characters in the tag names: "A...Z", "a...z", "0...9" and "_". 
In WinCC if you use special characters such as "," or ";" in the tag names then the script will be aborted 
with an error message. In such a case use the "Tag-ID" to access a tag with special characters in the script 
name.

TimeBegin Start time in 
'YYYY-MM-DD hh:mm:ss.msc' format
When <TimeStep> is used, <TimeBegin> must be specified as an absolute time. Relative time information 
or "0000-00-00 00:00:00.000" is not possible. 

TimeEnd End time in 
'YYYY-MM-DD hh:mm:ss.msc' format

SQL_Clause Filter criterion in SQL syntax:
[WHERE search_condition] 
[ORDER BY {order_expression [ASC|DESC] } ] 
The "ORDER BY" criterion can only be used when the specified sorting order is "{order_expression [ASC|
DESC] }".
Example: The following query supplies all values of the "ValueName_1" and "ValueName_2" tags that are 
less than 50 or greater than 100.
"TAG:R,('ValueName_1';'ValueName_2'),<TimeBegin>,<TimeEnd>, 'WHERE RealValue > 100 OR 
RealValue < 50'" 

TimeStep Values within the specified time interval are collected, beginning with the start time <TimeBegin> 
Format: 'TIMESTEP=x,y' 
x = Interval in seconds 
y = Aggregation type, defines the interval result 
The following values are possible for aggregation type: 
Without interpolation With interpolation Description
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Parameter Description
1 (FIRST) 
2 (LAST) 
3 (MIN) 
4 (MAX) 
5 (AVG) 
6 (SUM) 
7 (COUNT) 

257 (FIRST_INTERPOLATED) 
258 (LAST_INTERPOLATED) 
259 (MIN_INTERPOLATED) 
260 (MAX_INTERPOLATED) 
261 (AVG_INTERPOLATED) 
262 (SUM_INTERPOLATED) 
263 (COUNT_INTERPOLATED)

First value
Last value
Minimum value
Maximum value
Mean value
Sum
Number of values

Without interpolation means: If no values are present in the interval, no interval result will be returned. 
With interpolation means: If no values are present in the interval, the value will be derived by linear 
interpolation from the results of the neighboring intervals that are not empty. No extrapolation is done. 
Example: When TIMESTEP=60,257, for each interval of 60 seconds, the first value of this interval or - if 
there are no values in this interval - the linear, interpolated value from the first values of the neighboring 
intervals are returned. 
"TAG:R,1,'2013-07-09 09:03:00.000','0000-00-00 00:10:00.000','TIMESTEP=60,257'" 

 
 

 Note

<TimeBegin> and <TimeEnd> must not both be "ZERO" = '0000-00-00 00:00:00.000'.

In order to improve performance, use the parameter "ValueID" instead of "ValueName" in the 
query. You can determine the "ValueID" from the "Archives" table.

Some applications cannot resolve the time of process values into 1 ms increments, which 
can lead to inaccuracies. 
An example of resolving the milliseconds from the time stamp of process values can be found 
in the VB script "SplitDateTimeAndMs" in section "Example: Reading Process Value Archive 
Using WinCC OLE DB Provider". The script is also implemented in the demo project 
"OpConPack". 

 

 

Selection of an Absolute Time Interval
Reads from start time <TimeBegin> to end time <TimeEnd>. 

Example A1:
Reads the values of the ValueID 1 from start time 9:03 hours to end time 9:10 hours.

"TAG:R,1,'2013-07-09 09:03:00.000','2013-07-09 09:10:00.000'"

Selection of a Relative Time Interval
Reads from beginning of recording:

<TimeBegin> = '0000-00-00 00:00:00.000' 
Reads until end of recording:

<TimeEnd> = '0000-00-00 00:00:00.000'
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<TimeBegin> and <TimeEnd> must not both be "ZERO" = '0000-00-00 00:00:00.000'.
 

 Note

Enter a relative period you want to query in a linked archive database using the following 
format: 
● 0000-00-DD hh:mm:ss.msc

If you indicate the time frame in months, the content can be faulty, because a month can have 
28 to 31 days.

 

Example B1:
Reads the absolute time from "TimeBegin" to end of recording, i.e. the last archived value. 

<TimeBegin> = '2013-02-02 12:00:00.000', <TimeEnd> = '0000-00-00 
00:00:00.000'

Example B2:
Reads the absolute time from "TimeBegin" for the next 10 seconds. 

<TimeBegin> = '2013-02-02 12:00:00.000', <TimeEnd> = '0000-00-00 
00:00:10.000'

Example B3:
Reads 10 seconds backward from the absolute time from "TimeEnd".

<TimeBegin> = '0000-00-00 00:00:10.000', <TimeEnd> = '2013-02-02 
12:00:00.000'

Example B4:
Reads the values of the last hour starting from the time of the last archived value for multiple 
valueIDs (1;3;5;6).

"TAG:R,(1;3;5;6),'0000-00-00 01:00:00.000','0000-00-00 
00:00:00.000'" 

Example B5:
Reads the values of the last five minutes starting from the time of the last archived value for 
"TAG_2" from the "ArTags" archive.

"TAG:R,'ArTags\TAG_2','0000-00-00 00:05:00.000','0000-00-00 
00:00:00.000'" 
The following diagrams shows a possible result of this example. The query was implemented 
using the Connectivity Pack Demo Project. 
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Multiple Return Values to a Query Using a Filter on Tag Value

Example C1:
The following query also uses the <SQL_Clause> parameter and returns all tag values that 
have the ValueID "3" and "6" and are below 50 or above 100.

"TAG:R,(3;6),<TimeBegin>,<TimeEnd>,'WHERE RealValue > 100 OR 
RealValue < 50'" 

Query with parameter <TimeStep>

Example C2:
The following query uses the <TimeStep> parameter and returns all values of ValueID "1" - 
starting from start time "TimeBegin" till 5 minutes later in intervals of "60" seconds with the 
aggregation type "5" = "Average value without Interpolation". 

"TAG:R,1,'2004-10-13 17:00:00.000','0000-00-00 00:05:00.000', 
'TIMESTEP=60,5'"
The following diagram shows the query result. The left table displays the archive data which 
were archived in an archiving cycle of 30 seconds. The right table displays the query result. It 
determines the average between two archive values at "0" seconds and "30" seconds, 
displayed with the first time stamp of the averaging interval, i.e. second "0". 
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Example C3:
The following query uses the <TimeStep> parameter and returns all values of ValueID "1" and 
"2" - starting from start time "TimeBegin" till 2 minutes later in intervals of "15" seconds with 
the aggregation type "261" = "Average value with linear Interpolation". 

"TAG:R,(1;2),'2004-10-13 17:00:00.000','0000-00-00 00:02:00.000', 
'TIMESTEP=15,261'"
The following diagram shows the query result. The left table displays the archive data which 
were archived in an archiving cycle of 30 seconds. The right table displays the query result. 
The archive values at "0" and "30" seconds are displayed in the query result unchanged with 
their time stamp. For second "15," the linear, interpolated value is formed of archive values at 
seconds "0" and "30". For the "45" second, the linear, interpolated value is taken from the 
archive values of "30" second of the same minute and the "0" second of the next minute. 

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
System Manual, 02/2014 7649



 

Querying Alarm Message Archives

Introduction              
With the following query, an alarm message archive can be accessed. The data can be 
selected using filter criteria. The queries are forwarded to the database by the command object.

You will find information about status of messages in the WinCC Information System under 
"Working with WinCC > ANSI-C Function for Creation of Functions and Actions > ANSI-C 
Function descriptions > Appendix > Structure Definitions > Structure Definition 
MSG_RTDATA_STRUCT".

When querying message archives, the result is summarized by archive, but without sorting the 
queried archive segments. The filter condition needs to be extended accordingly if the 
segments are to be sorted, e.g., for the chronological sorting "ORDER BY DateTime ASC, MS 
ASC".

Syntax
ALARMVIEW:SELECT * FROM <ViewName>[WHERE <Condition>...., optional]
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Parameter

Parameter Description
ViewName Name of the database table. The table has to be specified in the desired 

language. The "ViewName" for the five European language is e.g.:
ALGVIEWDEU: German alarm message archive data
ALGVIEWENU: English alarm message archive data
ALGVIEWESP: Spanish alarm message archive data
ALGVIEWFRA: French alarm message archive data
ALGVIEWITA: Italian alarm message archive data
The "ViewName" for the Asian language is e.g.:
ALGVIEWCHT: Chinese (simplified) alarm message archive data
ALGVIEWCHT: Chinese (traditional) alarm message archive data
ALGVIEWJPN: Japanese alarm message archive data
ALGVIEWKOR: Korean message archive data
Note
The languages that are installed in the WinCC base system or that are 
configured in the WinCC Text Library are supported. Information 
concerning the possible query-languages or the respective 
"ViewName" can be found in the SQL-Server in the linked alarm 
archives under "Views". All languages that are supported in the 
corresponding archive are shown with their IDs e.g. "GENVIEWENU" 
here. 

Condition Filter criterion, e.g.:
DateTime>'2003-06-01' AND DateTime<'2003-07-01'
DateTime>'2003-06-01 17:30:00'
MsgNr = 5
MsgNr in (4, 5)
State = 2

With DateTime, only absolute time indications can be used.

 Example 1: 
Reads all entries of message no. 5 that were captured after July 5, 2003.

"ALARMVIEW:SELECT * FROM ALGVIEWENU WHERE MsgNr = 5 AND 
DateTime>'2003-07-05'" 
Example 2: 
Reads all messages with the time stamp between July 3, 2003 and July 5, 2003.

"ALARMVIEW:SELECT * FROM ALGVIEWENU WHERE DateTime>'2003-07-03' AND 
DateTime<'2003-07-05'" 
The following picture shows a possible result of this example. The query was implemented 
using the Connectivity Pack Demo Project. 
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Displaying Alarm Message Archives

Introduction
The query result is returned as the Recordset. In this chapter, the structure of the Recordset 
for alarm log archives is described.

You will find information about status of messages in the WinCC Information System under 
"Working with WinCC > ANSI-C Function for Creation of Functions and Actions > ANSI-C 
Function descriptions > Appendix > Structure Definitions > Structure Definition 
MSG_RTDATA_STRUCT".

Recordset Structure

Location Field name Type Comments
1 MsgNo Integer 4 Bytes Message number
2 State Small Integer 2 

Bytes
Alarm Log Status

3 DateTime DateTime 8 Bytes Time stamp of the message (date/time without 
milliseconds)

4 Ms Small Integer 2 
Bytes

Time stamp of the message (milliseconds)

5 Instance VarChar (255) Instance Name of the Alarm Log 
6 Flags1 Integer 4 Bytes (only for internal use)
7 PValueUsed Integer 4 Bytes Process Values used 
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Location Field name Type Comments
8 to 17 PValue1 to 

PValue10
Real 8 Bytes Numerical Process Value 1 to 10

18 to 27 PText1 to PText10 VarChar (255) Process Value Text 1 to 10
28 ComputerName VarChar (255) Name of computer
29 Application VarChar (255) Application Name
30 Comment VarChar (255) Comments
31 UserName VarChar (255) User name
32 Counter Integer 4 Bytes Running Alarm Message Counter
33 TimeDiff Integer 4 Bytes Time difference to "Came in" status
34 ClassName VarChar (255) Name of the message class
35 Typename VarChar (255) Name of the message type
36 Class Small Integer 2 

Bytes
Message class ID

37 Type Small Integer 2 
Bytes

Message type ID

38 to 47 Text1 to Text10 VarChar (255) Message Text 1 to 10
48 AG_NR Small Integer 2 

Bytes
Number of the PLC

49 CPU_NR Small Integer 2 
Bytes

Number of the CPU

50 CrComeFore Integer 4 Bytes Foreground Color for the "Came in" Status
51 CrComeBack Integer 4 Bytes Background Color for the "Came in" Status
52 CrGoFore Integer 4 Bytes Foreground Color for the "Went out" Status
53 CrGoBack Integer 4 Bytes Background Color for the "Went out" Status
54 CrAckFore Integer 4 Bytes Foreground Color for the "Acknowledged" 

Status
55 CrAckBack Integer 4 Bytes Background Color for the "Acknowledged" 

Status
56 LocaIID Integer 4 Bytes Location of the Alarm
57 Priority Integer 4 Bytes Priority
58 AP_type Integer 4 Bytes Loop in Alarm
59 AP_name VarChar (255) Loop-in-Alarm Function Name
60 AP_PAR VarChar (255) Loop-in-Alarm Screen
61 InfoText VarChar (255) Infotext
62 TxtCame VarChar (255) Text came in
63 TxtWent VarChar (255) Text went out
64 TxtCameNWent VarChar (255) Text came in and went out
65 TxtAck VarChar (255) Text acknowledged
66 AlarmTag Integer 4 Bytes Message tag
67 AckType Small Integer 2 

Bytes
Acknowledgment Type

68 Params Integer 4 Bytes Parameter
69 Servername VarChar (255) Servername
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Query for User Archives

Introduction            
With the following query, you may use MS OLE DB Provider to access WinCC user archives. 
Access may be read or write enabled in order to analyze the saved data and to modify and 
save same.  

The data can be selected using filter criteria. The queries are forwarded to the database by 
the command object.

 

 Note

Consider the following when accessing WinCC user archives via the MS OLE DB Provider:
● Ensure that the write access is not enabled simultaneously via the MS OLE DB Provider 

and WinCC. This prevents inconsistencies in the archives.
● Changes via MS OLE DB Provider will not be displayed in WinCC Runtime until the user 

archive table controls are selected by a picture change. The current data of the user 
archives are read again.

● User archives changed via MS OLE DB Provider are not synchronized in a redundant 
system.

● Note that WinCC updates can cause changes in the database scheme. The scheme can 
also be changed by the installation of hot fixes and service packs. In this case, you must 
adapt the read and write access accordingly.

 

Syntax

Reading of Values
SELECT * FROM UA#<ArchiveName>[WHERE <Condition>...., optional]

Writing of Values
UPDATE UA#<ArchiveName> SET UA#<ArchiveName>.<Column_n> = <Value> 
[WHERE <Condition>...., optional]

Inserting a Data Set 
INSERT INTO UA#<ArchiveName> (ID,<Column_1>,<Column_2>,<Column_n>) 
VALUES (<ID_Value>, Value_1,Value_2,Value_n) 

Deleting a Data Set 
DELETE FROM UA#<ArchiveName> WHERE ID = <ID_Number> 
 

Visualize processes
10.17 Interfaces

WinCC Professional V13.0
7654 System Manual, 02/2014



Parameter

Parameter Description
ArchiveName Name of the user archive. 
Condition Filter criterion e.g.:

LastAccess>'2004-06-01' AND LastAccess<'2004-07-01'
DateTime>'2004-06-01 17:30:00'
ID = 5
ID > 3
 

 

Example 1: 
Reads all data in the user archive "Test". 

SELECT * FROM UA#Test 
 

Example 2: 
Reads all data in the user archive "Test" that were changed between June 1, 2004 and July 
1, 2004. 

SELECT * FROM UA#Test WHERE LastAccess>'2004-06-01' AND 
LastAccess<'2004-07-01'
 

Example 3: 
Enters the value 'New_String' in the field F_STRING of the ID 3.

UPDATE UA#TEST SET F_STRING = 'New_String' WHERE ID = 3
 

Example 4: 
Inserts a data set with the ID 100. 

INSERT INTO UA#Test (ID,F_Integer,F_Float,F_Double,F_String) VALUES 
(100.10,'10.0','AAAA') 
 

Example 5: 
Deletes the data set with the ID 100. 

DELETE FROM UA#Test WHERE ID = 100 
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Configure Access via the Wizard "SQL Server Import/Export"

Introduction
WinCC OLE DB Provider may be used to access WinCC databases while employing the 
Wizard "SQL Server Import/Export. You can save the unzipped files to an intermediate 
database using the wizard; you access the database with standard SQL queries. 

● Using WinCC computers, access to runtime and archive databases may be established 
locally or remotely.

● In the case of long-term archive servers, local or remote access is only possible to the 
archive databases since they have no runtime databases.

Procedure
1. Start the "SQL Server Management Studio" and select the desired database.

2. In the shortcut menu of the database select "Tasks > Export Date...".
The SQL Server Import/Export-Wizard opens.

3. Configure the data source. 
Click "Next". In the field Data source, select the entry WinCC OLE DB-Provider for 
Archives". Click the button "Properties...". The "Data Link Properties" dialog box opens.

4. Configure the correct Provider settings.
In the field "Data Source" enter the following text as data source: ".\WinCC"The entry for 
"Location" remains empty. 
Under "Enter the initial catalog to use" either enter the desired Runtime database or the 
symbolic name, which was configured in "Archive Connector Tool". The correct spelling of 
the name may be found in "SQL Server Management Studio" in the "Databases" directory. 
Alternatively you can also enter the database "CC_ExternalBrowsing" for Runtime data and 
Archive data.
Click the "Advanced" tab. For the Property "Connect timeout" select the desired time in 
seconds. In the property "Access permissions" only select the box "ReadWrite". 
Close the dialog by activating the "OK" button.

 

  Note

In order to improve performance during local access, enter " <Computer Name>\WinCC" 
in the field "Data Source" instead of ".\WinCC". 

 

5. Configure the data source. 
Click "Next". In the field "Destination", select the entry SQL Native Client" for example. The 
server name can be any SQL Server instance. The database name which you enter in the 
field "Database", can be any self-created target database.

 

  Note

Leave the "Database" field empty. No target tables are then created.
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6. Configure the query conditions.
Click "Next". Select "Write a query to specify the data to transfer". Click "Next". Enter the 
desired query conditions. With the query "Tag:R,1,'0000-00-00 00:10:00.000','0000-00-00 
00:00:00.000'' of the ValueID "1", for example, the values of the last ten minutes of the 
archiving are read. Additional information on the syntax may be found in Chapter "Query 
for Process Value Archives".

7. End the Wizard and export the data.
Click "Next" and on the last page of the Wizard click on "Finish". The Wizard executes the 
data export to the target database. If the data export was successful, the comprised data 
in the target database are saved in the newly created table"dbo.Query". You can change 
the table name. If you do not change the table name, data will be overwritten with a new 
export. New tables with names "Query1", "Query2" etc. are created by the wizard.

 

Meeting prerequisites for using the Reporting Services

Introduction
You can use the reporting services of the SQL server 2005 with WinCC. This makes it possible 
to provide reports created with Microsoft Visual Studio with archive data on the network. 

Requirements 
The use of the reporting services with WinCC requires the following other software 
prerequisites. 

● Internet Information Services

● Workstation Components of the MS SQL Server 2005, including the Business Intelligence 
Development Studio

● Reporting Services of the MS SQL Server 2005
 

  Note

Take the installation steps in precisely the indicated order. 
 

Installing Internet Information Services 
1. Select "Settings > Control Panel > Software".

2. On the left, click "Add/Remove Windows components".

3. Activate the "Internet Information Services (IIS)" checkbox in the "Windows Components 
Wizard" dialog.
Activate the "Details" for this under "Application Server" in Windows 2003. 
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Installing Business Intelligence Development Studio
You install the Business Intelligence Development Studio as another component of the MS 
SQL Server 2005. 

1. Select "Settings > Control Panel > Software".
The "Change or remove program" button is active.

2. Select "Microsoft SQL Server 2005" and click on "Change".

3. Select the option "Workstation Components" in the "Microsoft SQL Server 2005 
Maintenance" and click on "Next".
The Microsoft SQL Server Installation Wizard is opened. 

4. Run the Wizard:

– Select "Change Installed Components".

– Open the "Client Components" branch.

– Use the mouse to activate the hard drive symbol "Will be installed on local hard drive" 
for the Business Intelligence Development Studio.

– Leave the other settings unchanged.

The Business Intelligence Development Studio is installed. 

Installing Reporting Services of the MS SQL Server 2005
You install the Reporting Services of the MS SQL Server 2005 from the WinCC DVD or from 
its position in the file system. 

1. Select "Start > Run" and enter the following: 
\\<wincc-dvd-pfad>\instdata\SQL\servers\setup.exe SKUUPGRADE=1
The Microsoft SQL Server 2005 Setup is executed. Follow the on-screen instructions. 

2. Activate the "Reporting Services" checkbox in the "Components to Install" dialog. Services" 
and click on "Next".

3. Click on "Installed Instances" in the "Instance Name" dialog.

4. Activate the entry "SQL Server (WinCC) and continue in the "Installed instances" dialog.

5. Configure the reporting services according to your requirements in the "Service Account" 
dialog.
The settings made here apply globally for the reporting services. 

6. Close the project.

Installing the Service Pack
After installing the reporting services, you must reinstall Service Pack 2 for the SQL Server 
2005. 

1. Select "Start > Run" and enter the following: 
\\<wincc-dvd-pfad>\instdata\SQL\ServicePack\SQLServer2005SP2\setup.exe

2. Follow the instructions and do not make any changes in the setup menu.
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Configuring computer administration
The Internet Information Services are configured in the computer administration. 

1. Right-click on "Workstation" in the Windows Explorer and select the entry "Administration" 
in the pop-up menu.
The computer administration is opened. 

2. Select the "Properties" entry in the "Application Pool" pop-up menu under "Internet 
Information Services Manager".

3. Select the "Configurable" option on the "Identity" tab and enter the user name and your 
password in the >Domains or computer name>\<User> form.

4. Select the "Properties" entry in the "Web Sites" pop-up menu under "Internet Information 
Services Manager".

5. Select "Edit" on the "Directory Security" tab under "Authentication and Access Control" and 
enter the user name and your password in the >Domains or computer name>\<User> form.

 

  Note

We recommend restarting the computer after completing the installation. 
 

Result
This makes the prerequisites for using the reporting services. You can now create reports and 
provide them on the internet. 

Querying the Archive Data

Introduction               
The queries are forwarded to the database by the command object. An important parameter, 
aside from "ConnectionString", is CommandText. The CommandText transmits the query. The 
result is returned as the Recordset.

 

 Note
Time range for archive inquiries for message and process values

If the query for message or process value archives specifies a time range for which no 
messages or other values exist within the archives, no information message or other status 
display occurs. If this status is to be displayed, error handling must be implemented by the 
user. 

A simple version of this error handling routine is described in the sample script under the 
topic "Example: Reading message archive data via the WinCC OLE DB Provider".

 

In the following examples, a command object each is generated and the query transmitted as 
CommandText.

In the following structure examples, CommandText also includes the ConnectionString whose 
structure is described under "Establishing Connection to Archive Database". 
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Structure of CommandText

Process Value Archives:
Set oRs = CreateObject("ADODB.Recordset")
Set oCom = CreateObject("ADODB.Command")
oCom.CommandType = 1
Set oCom.ActiveConnection = conn
oCom.CommandText = "TAG:R,'PVArchive\Tag1','0000-00-00 
00:10:00.000','0000-00-00 00:00:00.000'"

Alarm Message Archives:
Set oRs = CreateObject("ADODB.Recordset")
Set oCom = CreateObject("ADODB.Command")
oCom.CommandType = 1
Set oCom.ActiveConnection = conn
oCom.CommandText = "ALARMVIEW:Select * FROM AlgViewEnu"

User archives
Set oRs = CreateObject("ADODB.Recordset")
Set oCom = CreateObject("ADODB.Command")
oCom.CommandType = 1
Set oCom.ActiveConnection = conn
oCom.CommandText = "SELECT * FROM UA#Test"

Specifying the Recordset location
To specify the location of Recordset for query of the archive data, you need to set the value 
"3" for the "CursorLocation" property, for example, "conn.CursorLocation = 3". The Recordset 
is created on the client.

Displaying User Archives

Introduction
Each user archive consists of data fields with editable properties. Each data field has properties 
such as name, alias name, type, lengths, value etc. The representation of the data fields and 
properties in the Editor User Archives is done in lines and columns. Therefore, we are talking 
of rows instead of data fields and of columns instead of properties.

In the following, the user archive "Test" is described as a structure example. This user archive 
is included in the Connectivity Pack Demo Project "OPConPack" in directory "\Samples
\Connectivity Pack\DemoProject." 
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Structure of User Archive "Test"

Field Name Type Comment
ID Integer Unique identification of Value.
F_Integer Integer Example for Value
F_Float Float Example for Value
F_Double Double Example for Value
F_String String Sample character sequence

 

10.17.3.8 Analysis functions for messages and process values

Analysis Functions for Messages and Process Values

Introduction            
Different analysis functions are available with WinCC for querying archived messages and 
process values. 

The analysis is triggered by a query with parameters for different aggregate functions. 
Calculation of the aggregate function is performed on the Connectivity Pack server, and only 
the result is transferred to the client.

Additional information on CommandText and ConnectionString which are used in the following 
examples may be found under "Establishing Connection to Archive Database" and "Querying 
Archive Data". 

Analysis Functions for Messages
The analysis query for alarm logs archives returns a specific recordset which contains 
configuration and runtime data for each message as well as results of the aggregate functions. 

The returned recordset for analysis queries of alarm logs is not identical to the recordset of 
normal queries of message archives. Additional information may be found in Chapter "Display 
of Alarm Logs for Analysis Queries". 

For each message, the following aggregate functions are calculated. The column descriptions 
of the result list are placed in parenthesis. 

● Sum of message frequency ("FreqOfAlarm")

● Cumulative duration from "Message Incoming" until "Message Outgoing" 
("CumDurationComeGo")

● Average duration from "Message Incoming" until "Message Outgoing" 
("AvDurationComeGo")

● Cumulative duration from "Message Incoming" until initial acknowledgment 
("CumDurationComeAckn1")
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● Average duration from "Message Incoming" until initial acknowledgment 
("AvDurationComeAckn1")

● Cumulative duration from "Message Incoming" until second acknowledgment 
("CumDurationComeAckn2")

● Average duration from "Message Incoming" until second acknowledgment 
("AvDurationComeAckn2")

● Cumulative duration from "Message Incoming" until "Message Incoming" 
("CumDurationComeGo")

● Average duration from "Message Incoming" until "Message Incoming" 
("AvDurationComeCome")

Syntax
For the calculation of aggregate functions for messages, the following command is issued to 
WinCC OLE DB Provider. 

"AlarmHitView: SELECT * FROM <ViewName>[WHERE <Condition>]" 
Here :
<ViewName> = Name of the database table in the required language, for e.g. ALGVIEWENU 
for English. 
[WHERE <Condition>] = optional filter criterion as WHERE condition in the SQL syntax. 

Additional information on the syntax may be found in Chapter "Query for Alarm Logs". 

Example
The example provides results of the aggregate functions for all messages for the time range 
between 7/15/2004 12:00 p.m. and 12:15 p.m. from the "ALGVIEWENU" database. 

ConnectionString:

"Provider=WinCCOLEDBProvider.
1;Catalog=CC_OpenArch_03_05_27_14_11_46R;Data Source=.\WinCC"
CommandText:

"AlarmHitView: SELECT * FROM ALGVIEWENU WHERE DateTime>'2004-07-15 
12:00:00' AND DateTime<'2004-07-15 12:15:00'" 

Analysis Functions for Process Values
The analysis of process values returns the result of an aggregate function. Only one aggregate 
function can be calculated in a query.

The following aggregate functions are available for process values. 

● MIN (minimum)

● MAX (maximum)

● AVG (average)

● SUM (sum of all values)

● COUNT (count of process values)

● COUNTER (number of entries with value "1", e.g., query of binary tags)
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● STDEV (statistical standard deviation)

● VAR (statistical variance)

Syntax
For the calculation of aggregate functions for process values, a query is issued to the MS SQL 
OLE DB Provider and the procedure "cp_TagStatistic" from database "SQL Server Master" is 
executed. 

 

 Note

The analysis functions for process values in transparent access function only with 
Connectivity Station on a client with own project.

 

The following parameters are transferred to the "cp_TagStatistic" procedure.

cp_TagStatistic @P1,@P2,@P3[,@P4]
Where:
"@P1" = database name (e.g. WinCC Runtime database or symbolic name of the directory 
with the swapped out archives). During transparent access, use the WinCC project name 
instead of the database name.
"@P2" = WinCC OLE DB Provider string for process values. 
"@P3" = required aggregate function.
"@P4" = <Symbolic computer name>::\WinCC (required only during transparent access).

Additional information on the syntax of parameters "@P1" and "@P2" may be found in Chapter 
"Query for Process Value Archives". 

 

 Note
Analysis functions for process values with Asian archive tag names

If you use archive tag names with Asian character sets to calculate an analysis function, the 
request for Unicode character sets has to be adapted. 

Add the prefix "N'" in front of both parameters.

Example: cp_TagStatistic N'TestDB',N'TAG:R,17,''2004-05-17 12:00:00'',''2004-05-17 
13:00:00''','AVG'

 

Example
This query will return the average of process values in the time range between 5/17/2004 12:00 
and 13:00 for ValueID "17" from database "TestDB". 

ConnectionString:

"Provider=SQLOLEDB.1;Integrated Security=SSPI;Persist Security 
Info=False;Initial Catalog=master ;Data Source=.\WinCC"
CommandText:

"cp_TagStatistic 'TestDB','TAG:R,17,''2004-05-17 
12:00:00'',''2004-05-17 13:00:00''','AVG'"
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Example of transparent access
This query delivers the average process value in the time range between 14.09.2006 10:00 
hrs and 11:00 hrs for the ValueID "7" from the "WinCCProj".

ConnectionString:

"Provider=SQLOLEDB.1;Integrated Security=SSPI;Persist Security 
Info=False;Initial Catalog=master ;Data Source=.\WinCC"
CommandText:

"cp_TagStatistic 'WinCCProj','TAG:R,7,''2006-09-14 
10:00:00'',''2006-09-14 11:00:00''','AVG','Symb_WinCCProj::\WinCC'"
 

Display of Message Archives for Analysis Queries

Introduction
The analysis query for message archives returns a specific recordset which contains 
configuration and runtime data for each message as well as results of the aggregate functions. 
This Recordset is not identical to the Recordset of normal queries of message archives. 

Recordset Structure for Analysis of Message Archives
Upon query of message archives using the analysis function "AlarmHitView", the result is 
returned as recordset with the following structure. 

Location Field name Type Comments
1 MsgNo Integer 4 Bytes Message number
2 State Small Integer 2 

Bytes
Alarm Log Status

3 DateTime DateTime 8 
Bytes

Time stamp of the message (date/time 
without milliseconds)

4 Ms Small Integer 2 
Bytes

Time stamp of the message (milliseconds)

5 Instance VarChar (255) Instance Name of the Alarm Log 
6 Flags1 Integer 4 Bytes (only for internal use)
7 Counter Integer 4 Bytes Running Alarm Message Counter
8 TimeDiff Integer 4 Bytes Time difference to "Came in" status
9 ClassName VarChar (255) Name of the message class.
10 Typename VarChar (255) Name of the message type.
11 Class Small Integer 2 

Bytes
Message class ID

12 Type Small Integer 2 
Bytes

Message type ID

13 to 22 Text1 to Text10 VarChar (255) Message Text 1 to 10
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Location Field name Type Comments
23 AG_NR Small Integer 2 

Bytes
Number of the PLC

24 CPU_NR Small Integer 2 
Bytes

Number of the CPU

25 CrComeFore Integer 4 Bytes Foreground Color for the "Came in" Status
26 CrComeBack Integer 4 Bytes Background Color for the "Came in" Status
27 CrGoFore Integer 4 Bytes Foreground Color for the "Went out" Status
28 CrGoBack Integer 4 Bytes Background Color for the "Went out" Status
29 CrAckFore Integer 4 Bytes Foreground Color for the "Acknowledged" 

Status
30 CrAckBack Integer 4 Bytes Background Color for the "Acknowledged" 

Status
31 Priority Integer 4 Bytes Priority
32 AP_type Integer 4 Bytes Loop in Alarm
33 AP_name VarChar (255) Loop-in-Alarm Function Name
34 AP_PAR VarChar (255) Loop-in-Alarm Screen
35 InfoText VarChar (255) Infotext
36 TxtCame VarChar (255) Text came in
37 TxtWent VarChar (255) Text went out
38 TxtCameNWent VarChar (255) Text came in and went out
39 TxtAck VarChar (255) Text acknowledged
40 AckType Small Integer 2 

Bytes
Acknowledgment Type

41 FreqOfAlarm Integer 4 Bytes Sum of message frequency
42 CumDurationComeGo Integer 4 Bytes Cumulative duration from "Message Came In" 

until "Message Went Out"
43 AvDurationComeGo Real 8 Bytes Average duration from "Message Came In" 

until "Message Went Out" 
44 CumDurationComeAck

n1
Integer 4 Bytes Cumulative duration from "Message Came In" 

until initial acknowledgment 
45 AvDurationComeAckn1 Real 8 Bytes Average duration from "Message Came In" 

until initial acknowledgment 
46 CumDurationComeAck

n2
Integer 4 Bytes Cumulative duration from "Message Came In" 

until second acknowledgment 
47 AvDurationComeAckn2 Real 8 Bytes Average duration from "Message Came In" 

until second acknowledgment 
48 CumDuration 

ComeCome
Integer 4 Bytes Cumulative duration from "Message Came In" 

until "Message Came In"
49 AvDurationComeCome Real 8 Bytes Average duration from "Message Came In" 

until "Message Came In"
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10.18 Migrating to WinCC in the TIA Portal

10.18.1 Overview

Overview of the section "Migration to WinCC in the TIA Portal"
SIMATIC WinCC offers a number of functional changes in the TIA Portal. Some functions differ 
from the functions that you know from familiar environments such as WinCC V7 or WinCC 
flexible.

This document provides an overview of the special functions and procedures in 
SIMATIC WinCC in the TIA Portal. 

These functions and procedures are fundamentally different from the WinCC V7 and 
WinCC flexible version, or have a different name.
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10.18.2 WinCC V7

10.18.2.1 Actions

Actions in WinCC V7
WinCC supports the use of actions for dynamic response of the processes in your WinCC 
project. These actions are written in ANSI-C code. Action sequences are event-triggered. 

Actions can be used to run the following background tasks independent of the screen:

● Daily printout of a report

● Tag monitoring

● Calculations

How do I configure tasks with WinCC in the TIA Portal?
To configure tasks in the TIA Portal, the WinCC Scheduler is used.

You can use the Scheduler to configure tasks to run independent of the screen in the 
background. Actions are mapped to tasks of the function list type.
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At each task, you configure exactly one function list which is processed line by line. 
Alternatively, you configure a C or VB script. To start the task, you define a trigger.

For more detailed information, see:

Work area of the "Scheduler" editor (Page 6092) 

Example: Reading the current user name (Page 6109) 

10.18.2.2 User objects

User objects in WinCC V7
Objects of the object pallet can be combined to form a group or user object based on a multiple 
selection. You can also insert a group or combined object into the project library.
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In contrast to a group, a user object enables the individual customization of properties and 
events that can be displayed and edited in the "Object properties" window. A user object can 
be edited in Graphics Designer, similar to an individual object of the object pallet. 

How do I configure faceplates with WinCC in the TIA Portal?
Faceplates are used to create individually configured display and operating objects in WinCC. 
In contrast to user objects, faceplates can be modified centrally.

WinCC provides the "Faceplates" Editor within the project library for creating faceplates and 
editing their properties.

Faceplates are based on a type-instance model to support the centralized editing. You create 
central properties for a faceplate in the types. The instances represent local places of use for 
the types.
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For more detailed information, see:

Basics on faceplates (Page 3478) 

Example: Configuring a faceplate (Page 3501) 

10.18.2.3 User administration

User administration in WinCC V7
The "User Administrator" editor is used to set up and manage user administration.

The user administrator enables the setup and management of access rights for WinCC 
functions and WinCC users. 

In the user administration, you can assign functions such as logon timeout, or log on using a 
key switch / smart card to the users.

The "User Administrator" editor is used for engineering and in runtime.
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How do I configure user administration with WinCC in the TIA Portal?
● User administration in the engineering system

You manage users, user groups and authorizations centrally in the WinCC user 
administration. You transfer users and user groups along with the project to the HMI device. 
Users are always assigned to a group and therefore inherit the group authorizations.

● User administration in runtime
You can employ a user view in a screen to manage users in runtime as well. You manage 
users and passwords directly in the user view on the HMI device.

For more detailed information, see:

Form of the user administration (Page 4375) 

User view (Page 4403) 

10.18.2.4 Direct connection

Direct connections in WinCC V7
A direct connection is used to respond to events. Whenever this event occurs in runtime, the 
value of a source element is applied to a target element. 

Example of the "Mouse click" event:
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● The fill pattern of the "Rectangle1" object is synchronized with the fill pattern of the "Circle1" 
object.

● A screen change is executed.

How do I configure system functions with WinCC in the TIA Portal?
In WinCC, direct connections are mapped to system functions.

You use system functions in a function list or in a user-defined function. When the event occurs, 
execute the configured system functions using the function list. 

When configuring a function list, select the system functions from a selection list that is sorted 
by categories. 

For the implementation of the direct connection, specific functions are integrated, such as 
"SetPropertyByProperty".
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For more detailed information, see:

Auto-Hotspot 

Auto-Hotspot 

10.18.2.5 Dynamic Wizard

Dynamic Wizard in WinCC V7
The Dynamic Wizard can be used to set up the dynamic response of an object by means of 
C-script actions. When a wizard runs, prepared C-script actions such as set bit / reset bit and 
trigger events are defined and saved in the object properties. 

You can always edit the C-script actions in the Events tab of the object properties.
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How do I configure system functions with WinCC in the TIA Portal?
In WinCC, objects are provided with dynamic properties, for example, using system functions.

You use system functions in a function list or in a user-defined function. When the event occurs, 
execute the configured system functions using the function list. 

When configuring a function list, select the system functions from a selection list that is sorted 
by categories. 

For more detailed information, see:

Auto-Hotspot 

Auto-Hotspot 
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10.18.2.6 Dynamics dialog

Dynamic dialog in WinCC V7
The Dynamic dialog is used to configure dynamic object properties. In the Dynamic dialog, 
you formulate an expression by using tags, functions and arithmetic operators. 

The value of the expression, the status, as well as the quality code of the tags used in the 
expression are used to generate the value of the object property in runtime.

The Dynamic dialog is used, for example, for the following purposes:

● Mapping the range of values of a tag to colors.

● Monitoring of individual tag bits and mapping the bit value to colors or texts.

● Monitoring of a Boolean tag and mapping the tag value to colors or texts.

● Monitoring the status of a tag.

● Monitoring the quality code of a tag.

How do I configure animations with WinCC in the TIA Portal?
Dynamic object properties can be realized, for example, using animations that you configure 
in the object property list, "Properties > Animations".

These animations dynamically change the background color of an object, for example.
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The function "Animate property" is of particular help to you when configuring dynamic 
properties for the dynamic dialog. 

Simple animations are also possible via a tag connection at display and operating objects.

For more detailed information, see:

Basics on dynamization in the property list (Page 3446) 

Configuring a new animation (Page 3426) 
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10.18.2.7 Working efficiently

Mass data processing in WinCC V7
The WinCC Configuration Tool is an Excel add-in. The tool enables the simple configuration 
of mass data, such as tags. 
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How do I work efficiently with WinCC in the TIA Portal?
WinCC enables efficient processing of process data in table editors. WinCC provides the 
following corresponding functions:

● Importing and exporting project data

● Multiple selection

● Global changes to a property

You export or import the following project data:

● Recipe data records

● Alarms

● Tags

● Text lists

● Project texts for translations

Exporting and importing reduces the workload. 

Instead of creating new data records, use the data you have already created in previous 
projects.

For more detailed information, see:

Data exchange between projects and external applications (Page 6827) 

10.18.2.8 Structures and structure tags

Structure tags in WinCC V7
Structures are used to enable grouping of a larger number of tags and tag types that form a 
logical unit. 

In WinCC V7, you also create structures which you can address by their names at the tag.
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How do I configure user data types with WinCC in the TIA Portal?
In WinCC, user data types enable you to group different tags that form a logical unit.

You create user data types as a type and use instances of this type in the project. 

User data types are project-specific data and are available for all HMI devices of the project. 

You create user data types and user data type elements in the project library. User data types 
must be enabled before they can be used in the project.

The configured properties of a user data type are used in the instances of the user data type. 
If needed, you can change individual properties directly at the point of use, for example, at a 
tag. Changes to a property at the tag do not affect the user data type created.

Checking tags
In order to determine whether a tag with the specified name exists, a check takes place at the 
point of use.

If the tag does not exist, the point of use is marked. The compiler does not output a warning.

If the tag name at the point of use begins with ".", no check takes place in the engineering 
system. 

In this case, it is assumed that the name is formed for Runtime Professional from a tag prefix 
and the string at the point of use and therefore does not exist in the engineering system.
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For user data types, the name of the instance of the user data type is typically used for the tag 
prefix. You use the name of the relevant user data type elements preceded by a period at the 
points of use in the screen.

For more detailed information, see:

Basics on user data types (Page 3729) 

Basics on user data types (Page 3729) 

10.18.3 WinCC flexible

10.18.3.1 Libraries

Libraries in WinCC flexible
Libraries are a collection of pre-configured screen objects. They expand the number of 
available screen objects and increase engineering efficiency, because library objects are 
always available for reuse; there is no need to reconfigure them. 

WinCC flexible enables you to create two library types: 

● Project library

● Global library

A library can contain all the WinCC flexible objects, such as screens, tags, graphic objects, or 
alarms. 

How do I configure libraries with WinCC in the TIA Portal?
In WinCC, you also configure the "Project library" and the "Global library".
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You can no longer store any system functions in libraries, as was the case in WinCC flexible.

Both the "Project library" and the "Global library" contain the two folders, "Copy templates" and 
"Types". You can create or use the library objects as a copy template, or as a type. 

● Copy templates
Use copy templates to create independent copies of the library object. 

● Types
Create instances of objects of the "Types" folder and use the instances in your project. The 
instances are bound to their respective type. Changes to an instance also change all other 
instances. Types are marked by a green triangle in the "Libraries" task card.

● Managing the library objects
You can only copy and move library objects within the same library. 

For more detailed information, see:

Libraries in WinCC 

Visualize processes
10.18 Migrating to WinCC in the TIA Portal

WinCC Professional V13.0
7682 System Manual, 02/2014



10.18.3.2 Screens and templates

Screens and templates in WinCC flexible
In WinCC flexible, you create screens that an operator can use to control and monitor machines 
and plants. When you create your screens, the object templates provided support you in 
visualizing your plant, displaying processes and defining process values.

The project has a template for every HMI device. You can centrally configure the function keys 
and objects for your project in these templates. 

Every screen based on this template will contain the function keys and objects that you 
configured in the template. Changes to an object or of a function key assignment in the template 
are applied to the object in all the screens, which are based on this template. 

How do I configure screens and templates with WinCC in the TIA Portal?
In WinCC, you also configure "Templates" and a "Global screen" along with the "Screens".

You determine functions and objects in the template which then apply to all screens based on 
this template. You can create multiple templates in WinCC.

In the "Global screen", define the elements which are independent of the template used for all 
screens of an HMI device. The "Alarm window" and "Alarm indicator" objects are available for 
use as global objects. For HMI devices with function keys, configure the function keys in the 
"Global Screen" editor. 

You can also configure a "System Diagnostics Window" in the global screen of Comfort Panels.
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Excluding the controls, the screens are displayed in runtime in the following order:

For more detailed information, see:

Screen basics 
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10.18.3.3 Scripts in faceplates

Scripts in faceplates in WinCC flexible
You configure a script in the "Scripts" tab of the "Faceplate configuration" dialog. This script 
is only available within the faceplate. 

Interconnect the script directly to the events of the objects contained in the faceplate, for 
example, with the "Click" event of a button. If you use the faceplate in a screen, a faceplate 
instance is generated. 

How do I configure scripts in faceplates with WinCC in the TIA Portal?
In the configuration area of the "Faceplates" editor, you create scripts that you only use within 
a faceplate type. 

In contrast to WinCC flexible, WinCC allows you to configure several scripts for a faceplate.
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For more detailed information, see:

Auto-Hotspot 

10.18.3.4 Synchronization of recipes

How do I configure a synchronization of recipes with WinCC in the TIA Portal?
You configure the synchronization of recipes in the "Recipes" editor in WinCC. 

A few terms have changed in WinCC as compared to WinCC flexible.

Synchronization for Panels and RT Advanced

 

● To synchronize recipe tags that are configured in I/O fields with the recipe view in Runtime, 
activate "Synchronize recipe view and recipe tags".

● Deactivate "Direct transfer of individually modified values" to specify that the recipe tags 
are automatically transferred to the PLC when you edit the I/O fields (teach-in mode).

● Activate "Coordinated data transfer" to monitor the transfer of recipe data in Runtime using 
area pointers.

For more detailed information, see:

Synchronization of recipe data records with the PLC 

Visualize processes
10.18 Migrating to WinCC in the TIA Portal

WinCC Professional V13.0
7686 System Manual, 02/2014



10.18.3.5 Special considerations for converting

Objects with object references in the project library
Two copying methods can be used in WinCC flexible.   

● With "simple copy", a WinCC flexible screen including an IO field is copied, for example. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. With regard to tags, it functions like 
"simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it functions 
like "copy" in WinCC flexible.

If you stored objects with references to tags in a library in WinCC flexible, you must reconfigure 
the referenced objects when using them in WinCC.

Changing the names of alarm classes
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows:

WinCC flexible WinCC
Errors Errors
System System
Warnings Warnings

The display names of the alarm classes can be changed as necessary after migration.

Objects with object references in the project library
Two copying methods can be used in WinCC flexible. 

● With "simple copy", a WinCC flexible screen including an IO field is copied, for example. 
Only the object name of a tag configured on the IO field is copied, as this is a reference.

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied.

These two methods can also be used for storing an object in a library. Project libraries and the 
objects contained there are migrated during migration and can be used in WinCC.

In WinCC, however, only one copying method is available. It functions like "simple copy" in 
WinCC flexible.

If you have stored objects with references to other objects in a library in WinCC flexible, you 
must reconfigure the referenced objects when using them in WinCC.
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Using technology functions 11
11.1 PID control

11.1.1 Principles for control

11.1.1.1 Controlled system and actuators

Controlled system
Room temperature control by means of a heating system is a simple example of a controlled 
system. A sensor measures the room temperature and transfers the value to a controller. The 
controller compares the current room temperature with a setpoint and calculates an output 
value (manipulated variable) for heating control.

A properly set PID controller reaches this setpoint as quickly as possible and then holds it a 
constant value. After a change in the output value, the process value often changes only with 
a time delay. The controller has to compensate for this response.

Actuators
The actuator is an element of the controlled system and is influenced by the controller. Its 
function modifies mass and energy flows. 

The table below provides an overview of actuator applications.

Application Actuator
Liquid and gaseous mass flow Valve, shutter, gate valve
Solid mass flow, e.g., bulk material Articulated baffle, conveyor, vibrator channel
Flow of electrical power Switching contact, contactor, relay, thyristor

Variable resistor, variable transformer, transistor
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Actuators are distinguished as follows:

● Proportional actuators with constant actuating signal
These elements set degrees of opening, angular positions or positions in proportion to the 
output value. The output value has an analog effect on the process within the control range.
Actuators in this group include spring-loaded pneumatic drives, as well as motorized drives 
with position feedback for which a position control system is formed.
An continuous controller, such as PID_Compact, generates the output value.

● Proportional actuators with pulse-width modulated signal
These actuators are used to generate the output of pulses with a length proportional to the 
output value within the sampling time intervals. The actuator - e.g. a heating resistor or 
cooling apparatus - is switched on in isochronous mode for durations that differ depending 
on the output value.
The actuating signal can assume unipolar "On" or "Off" states, or represent bipolar states 
such as "open/close", "forward/backward", "accelerate/brake".
The output value is generated by a two-step controller such as PID_Compact with pulse-
width modulation.

● Actuators with integral action and three-step actuating signal
Actuators are frequently operated by motors with an on period that is proportional to the 
actuator travel of the choke element. This includes elements such as valves, shutters, and 
gate valves. In spite of their different design, all of these actuators follow the effect of an 
integral action at the input of the controlled system. 
A step controller, such as PID_3Step. generates the output value.

11.1.1.2 Controlled systems
The properties of a controlled system can hardly be influenced as these are determined by the 
technical requirements of the process and machinery. Acceptable control results can only be 
achieved by selecting a suitable controller type for the specific controlled system and adapting 
the controller to the time response of the controlled system. Therefore, it is is indispensable 
for the configuration of the proportional, integral and derivative actions of the controller to have 
precise knowledge of the type and parameters of the controlled system.

Controlled system types 
Controlled systems are classified based on their time response to step changes of the output 
value. 

We distinguish between the following controlled systems:

● Self-regulating controlled systems

– Proportional-action controlled systems

– PT1 controlled systems

– PT2 controlled systems

● Non-self-regulating controlled systems

● Controlled systems with and without dead time
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Self-regulating controlled systems
Proportional-action controlled systems

In proportional-action controlled systems, the process value follows the output value almost 
immediately. The ratio between the process value and output value is defined by the 
proportional Gain of the controlled system.

Examples:

● Gate valve in a piping system

● Voltage dividers

● Step-down function in hydraulic systems

PT1 controlled systems

In a PT1 controlled system, the process value initially changes in proportion to the change of 
the output value. The rate of change of the process value is reduced as a function of the time 
until the end value is reached, i.e., it is delayed.

Examples:

● Spring damping system

● Charge of RC elements

● Water container that is heated with steam.

The time constants are often identical for heating and cooling processes, or for charging and 
discharge characteristics. With different time constants, controlling is clearly more complex.

PT2 controlled systems

In a PT2 controlled system, the process value does not immediately follow a step change of 
the output value, i.e., it increases in proportion to the positive rate of rise and then approaches 
the setpoint at a decreasing rate of rise. The controlled system shows a proportional response 
characteristic with second order delay element.

Examples:

● Pressure control

● Flow rate control

● Temperature control

Non-self-regulating controlled systems
Non-self-regulating controlled systems have an integral response. The process value 
approaches an infinite maximum value.

Example:

● Liquid flow into a container

Controlled systems with dead time
A dead time always represents the runtime or transport time that has to expire before a change 
to the system input can be measured at the system output. 
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In controlled systems with dead time, the process value change is delayed by the amount of 
the dead time.

Example:

Conveyor

11.1.1.3 Characteristic values of the control section

Determining the time response from the step response
Time response of the controlled system can be determined based on the time characteristic 
of process value x following a step change of output value y. Most controlled systems are self-
regulating controlled systems.

The time response can be determined by approximation using the variables Delay time Tu, 
Recovery time Tg and Maximum value Xmax. The variables are determined by applying tangents 
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to the maximum value and the inflection point of the step response. In many situations, it is 
not possible to record the response characteristic up to the maximum value because the 
process value cannot exceed specific values. In this case, the rate of rise vmax is used to identify 
the controlled system (vmax = Δx/Δt).

The controllability of the controlled system can be estimated based on the ratio Tu/Tg, or Tu × 
vmax/Xmax . Rule:

Process type Tu / Tg Suitability of the controlled system for controlling
I < 0,1 can be controlled well
II 0.1 to 0.3 can still be controlled
III > 0,3 difficult to control

Influence of the dead time on the controllability of a controlled system
A controlled system with dead time and recovery reacts as follows to a jump of the output value.

Tt Dead time
Tu Delay time
Tg Recovery time
y Output value
x Process value

The controllability of a self-regulating controlled system with dead time is determined by the 
ratio of Tt to Tg. Tt must be small compared to Tg. Rule: 

Tt/Tg ≤ 1 
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Response rate of controlled systems
Controlled systems can be judged on the basis of the following values:

Tu < 0.5 min, Tg < 5 min = fast controlled system

Tu > 0.5 min, Tg > 5 min = slow controlled system

 

Parameters of certain controlled systems 

Physical 
quantity

Controlled system Delay time Tu Recovery time Tg Rate of rise vmax

Temperature Small electrically heated furnace 0.5 to 1 min 5 to 15 min Up to 60 K/min.
Large electrically heated annealing furnace 1 to 5 min 10 to 20 min Up to 20 K/min.
Large gas-heated annealing furnace 0.2 to 5 min 3 to 60 min 1 to 30 K/min
Distillation tower 1 to 7 min 40 to 60 min 0.1 to 0.5° C/s
Autoclaves (2.5 m3) 0.5 to 0.7 min 10 to 20 min Not specified
High-pressure autoclaves 12 to 15 min 200 to 300 min Not specified
Steam superheater 30 s to 2.5 min 1 to 4 min 2°C/s
Injection molding machines 0.5 to 3 min 3 to 30 min 5 to 20 K/min
Extruders 1 to 6 min 5 to 60 min  
Packaging machines 0.5 to 4 min 3 to 40 min 2 to 35 K/min
Room heating 1 to 5 min 10 to 60 min 1° C/min

Flow rate Pipeline with gas 0 to 5 s 0.2 to 10 s Not relevant
Pipeline with liquid None None

Pressure Gas pipeline None 0.1 s Not relevant
Drum boiler with gas or oil firing None 150 s Not relevant
Drum boiler with impact grinding mills 1 to 2 min 2 to 5 min Not relevant

Vessel level Drum boiler 0.6 to 1 min Not specified 0.1 to 0.3 cm/s
Speed Small electric drive None 0.2 to 10 s Not relevant

Large electric drive None 5 to 40 s Not relevant
Steam turbine None Not specified 50 min–1

Voltage Small generators None 1 to 5 s Not relevant
Large generators None 5 to 10 s Not relevant

11.1.1.4 Pulse controller

Two-step controllers without feedback
Two-step controllers have the state "ON" and "OFF" as the switching function. This 
corresponds to 100% or 0% output. This behavior generates a sustained oscillation of process 
value x around setpoint w.

The amplitude and duration of the oscillation increase in proportion to the ratio between the 
delay time Tu and recovery time Tg of the controlled system. These controllers are used mainly 
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for simple temperature control systems (such as electrically directly heated furnaces) or as 
limit-value signaling units.

The following diagram shows the characteristic of a two-step controller

① ON
② OFF
Yh Control range
w Setpoint

The following diagram shows the control function of a two-step controller
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① Response characteristic without controller 
② Response characteristic with two-step controller
Tu Delay time
Tg Recovery time
XSd Switching difference

Two-step controllers with feedback
The behavior of two-step controllers in the case of controlled systems with larger delay times, 
such as furnaces where the functional space is separated from the heating, can be improved 
by the use of electronic feedback.

The feedback is used to increase the switching frequency of the controller, which reduces the 
amplitude of the process value. In addition, the control-action results can be improved 
substantially in dynamic operation. The limit for the switching frequency is set by the output 
level. It should not exceed 1 to 5 switches per minute at mechanical actuators, such as relays 
and contactors. In the case of voltage and current outputs with downstream thyristor or Triac 
controllers high switching frequencies can be selected that exceed the limit frequency of the 
controlled system by far.
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Since the switching pulses can no longer be determined at the output of the controlled system, 
results comparable with those of continuous controllers are obtained.

The output value is generated by pulse-width modulation of the output value of a continuous 
controller.

Two-step controllers with feedback are used for temperature control in furnaces, at processing 
machines in the plastics, textile, paper, rubber and foodstuff industries as well as for heating 
and cooling devices.

Three-step controllers
Three-step controllers are used for heating / cooling. These controllers have two switching 
points as their output. The control-action results are optimized through electronic feedback 
structures. Fields of applications for such controllers are heating, low-temperature, climatic 
chambers and tool heating units for plastic-processing machines.

The following diagram shows the characteristic of a three-step controller

y Output value, e.g. 
y11 = 100% heating
y12 = 0% heating
y21 = 0% cooling
y22 = 100% cooling 

x Physical quantity of the process value, e.g., temperature in° C 
w Setpoint
xSh Distance between Switching Point 1 and Switching Point 2
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11.1.1.5 Response to setpoint changes and disturbances

Response to setpoint changes
The process value should follow a setpoint change as quickly as possible. The response to 
setpoint changes is improved by minimizing fluctuation of the process value and the time 
required to reach the new setpoint.

x Process value
w Setpoint

Response to disturbances
The setpoint is influenced by disturbance variables. The controller has to eliminate the resulting 
control deviations in the shortest time possible. The response to disturbances is improved by 
minimizing fluctuation of the process value and the time required to reach the new setpoint. 

x Process value
w Setpoint
① Influencing a disturbance variable
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Disturbance variables are corrected by a controller with integral action. A persistent 
disturbance variable does not reduce control quality because the control deviation is relatively 
constant. Dynamic disturbance variables have a more significant impact on control quality 
because of control deviation fluctuation. The control deviation is eliminated again only by 
means of the slow acting integral action.

A measurable disturbance variable can be included in the controlled system. This inclusion 
would significantly accelerated the response of the controller.

11.1.1.6 Control Response at Different Feedback Structures

Control behavior of controllers
A precise adaptation of the controller to the time response of the controlled system is decisive 
for the controller's precise settling to the setpoint and optimum response to disturbance 
variables.

The feedback circuit can have a proportional action (P), proportional-derivative action (PD), 
proportional-integral action (PI), or proportional-integral-derivative action (PID).

If step functions are to be triggered by control deviations, the step responses of the controllers 
differ depending on their type.
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Step response of a proportional action controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller

 

Equation for proportional action controller

Output value and control deviation are directly proportional, meaning:

Output value = proportional gain × control deviation

y = GAIN × x
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Step response of a PD-action controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller
TM_LAG Delay of the Derivative action

Equation for PD-action controller

The following applies for the step response of the PD-action controller in the time range:

t = time interval since the step of the control deviation

The derivative action generates a output value as a function of the rate of change of the process 
value. A derivative action by itself is not suitable for controlling because the output value only 
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follows a step of the process value. As long as the process value remains constant, the output 
value will no longer change.

The response to disturbances of the derivative action is improved in combination with a 
proportional action. Disturbances are not corrected completely. The good dynamic response 
is advantageous. A well attenuated, non-oscillating response is achieved during approach and 
setpoint change. 

A controller with derivative action is not appropriate if a controlled system has pulsing 
measured quantities, for example, in the case of pressure or flow control systems.
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Step response of a PI-action controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller

An integral action in the controller adds the control deviation as a function of the time. This 
means that the controller corrects the system until the control deviation is eliminated. A 
sustained control deviation is generated at controllers with proportional action only. This effect 
can be eliminated by means of an integral action in the controller. 

In practical experience, a combination of the proportional, integral and derivative actions is 
ideal, depending on the requirements placed on the control response. The time response of 
the individual components can be described by the controller parameters proportional gain 
GAIN, integral action time TI (integral action), and derivative action time TD (derivative action).

Equation for PI-action controller
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The following applies for the step response of the PI-action controller in the time range:

t = time interval since the step of the control deviation
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Step response of a PID controller

① Control deviation
② Output value of a continuous controller
③ Output value of a pulse controller
TM_LAG Delay of the Derivative action
Ti Integral action time

Equation for PID controller

The following applies for the step response of the PID controller in the time range:
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t = time interval since the step of the control deviation

Response of a controlled system with different controller structures
Most of the controller systems occurring in process engineering can be controlled by means 
of a controller with PI-action response. In the case of slow controlled system with a large dead 
time, for example temperature control systems, the control result can be improved by means 
of a controller with PID action.

① No controller
② PID controller
③ PD-action controller
w Setpoint
x Process value

Controllers with PI and PID action have the advantage that the process value does not have 
any deviation from the setpoint value after settling. The process value oscillates over the 
setpoint during approach.
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11.1.1.7 Selection of the controller structure for specified controlled systems

Selection of the Suitable Controller Structures 
To achieve optimum control results, select a controller structure that is suitable for the 
controlled system and that you can adapt to the controlled system within specific limits.

The table below provides an overview of suitable combinations of a controller structure and 
controlled system. 

Controlled system Controller structure
P PD PI PID

With dead time only Unsuitable Unsuitable Suitable Unsuitable

PT1 with dead time Unsuitable Unsuitable Well suited Well suited

PT2 with dead time Unsuitable Suited conditionally Well suited Well suited

Higher order Unsuitable Unsuitable Suited conditionally Well suited

Not self-regulating Well suited Well suited Well suited Well suited

The table below provides an overview of suitable combinations of a controller structure and 
physical quantity.

Physical quantity Controller structure
P PD PI PID

Sustained control deviation No sustained control deviation
Temperature For low 

performance 
requirements and 
proportional action 
controlled 
systems with Tu/
Tg < 0,1

Well suited The most suitable controller structures 
for high performance requirements 
(except for specially adapted special 
controllers)

Pressure Suitable, if the 
delay time is 
inconsiderable

Unsuitable The most suitable controller structures 
for high performance requirements 
(except for specially adapted special 
controllers)

Flow rate Unsuitable, 
because required 
GAIN range is 
usually too large

Unsuitable Suitable, but 
integral action 
controller alone 
often better

Hardly required 
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11.1.1.8 PID parameter settings

Rule of Thumb for the Parameter Setting

Controller structure Setting
P GAIN ≈ vmax × Tu [° C ]
PI GAIN ≈ 1.2 × vmax × Tu [° C ]
PD GAIN ≈ 0.83 × vmax × Tu [° C ]

TD ≈ 0.25 × vmax × Tu [ min ]
TM_LAG ≈ 0.5 × TD[ min ]

PID GAIN ≈ 0.83 × vmax × Tu [° C ]
TI ≈ 2 × Tu [ min ]
TD ≈ 0.4 × Tu [ min ]
TM_LAG ≈ 0.5 × TD[ min ]

PD/PID GAIN ≈ 0.4 × vmax × Tu [° C ]
TI ≈ 2 × Tu [ min ]
TD ≈ 0.4 × Tu [ min ]
TM_LAG ≈ 0.5 × TD[ min ]

Instead of vmax = ∆x / ∆t , you can use Xmax / Tg.

In the case of controllers with PID structure the setting of the integral action time and differential-
action time is usually coupled with each other.

The ratio TI / TD lies between 4 and 5 and is optimal for most controlled systems.

Non-observance of the differential-action time TD is uncritical at PD controllers. 

In the case of PI and PID controllers, control oscillations occur if the integral action time TI has 
been select by more than half too small.

An integral action time that is too large slows down the settling times of disturbances. One 
cannot expect that the control loops operate "optimally" after the first parameter settings. 
Experience shows that adjusting is always necessary, when a system exists that is "difficult to 
control" with  Tu / Tg > 0.3.

11.1.2 Configuring a software controller

11.1.2.1 Overview of software controller
For the configuration of a software controller, you need an instruction with the control algorithm 
and a technology object. The technology object for a software controller corresponds with the 
instance DB of the instruction. The configuration of the controller is saved in the technology 
object. In contrast to the instance DBs of other instructions, technology objects are not stored 
for the program resources, but rather under CPU > Technology objects.
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Technology objects and instructions 

CPU Library Instruction Technology 
object

Description

S7-1200 Compact PID PID_Compact 
V1.X 

PID_Compact 
V1.X

Universal PID controller with integrated tuning

S7-1200 PID_3Step V1.X PID_3Step V1.X PID controller with integrated tuning for 
valves 

S7-1500
S7-1200 V4.x

PID_Compact 
V2.X

PID_Compact 
V2.X

Universal PID controller with integrated tuning

S7-1500
S7-1200 V4.x

PID_3Step V2.X PID_3Step V2.X PID controller with integrated tuning for valves

S7-1500/300/4
00

PID basic functions CONT_C CONT_C Continuous controller

S7-1500/300/4
00

CONT_S CONT_S Step controller for actuators with integrating 
behavior

S7-1500/300/4
00

PULSEGEN - Pulse generator for actuators with 
proportional behavior

S7-1500/300/4
00

TCONT_CP TCONT_CP Continuous temperature controller with pulse 
generator

S7-1500/300/4
00

TCONT_S TCONT_S Temperature controller for actuators with 
integrating behavior

S7-300/400 PID Self Tuner TUN_EC TUN_EC Optimization of a continuous controller
S7-300/400 TUN_ES TUN_ES Optimization of a step controller
S7-300/400 Standard PID 

Control (PID 
Professional 
optional package)

PID_CP PID_CP Continuous controller with pulse generator
S7-300/400 PID_ES PID_ES Step controller for actuators with integrating 

behavior
S7-300/400 LP_SCHED - Distribute controller calls 
S7-300/400 Modular PID 

Control (PID 
Professional 
optional package)

A_DEAD_B - Filter interfering signal from control deviation 
S7-300/400 CRP_IN - Scale analog input signal 
S7-300/400 CRP_OUT - Scale analog output signal 
S7-300/400 DEAD_T - Delay output of input signal 
S7-300/400 DEADBAND - Suppress small fluctuations to the process 

value 
S7-300/400 DIF - Differentiate input signals over time 
S7-300/400 ERR_MON  Monitor control deviation 
S7-300/400 INTEG - Integrate input signals over time 
S7-300/400 LAG1ST - First-order delay element 
S7-300/400 LAG2ND - Second-order delay element 
S7-300/400 LIMALARM - Report limit values 
S7-300/400 LIMITER - Limiting the manipulated variable 
S7-300/400 LMNGEN_C - Determine manipulated variable for 

continuous controller 
S7-300/400 LMNGEN_S - Determine manipulated variable for step 

controller
S7-300/400 NONLIN - Linearize encoder signal
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CPU Library Instruction Technology 
object

Description

S7-300/400 NORM - Scale process value physically 
S7-300/400 OVERRIDE - Switch manipulated variable from 2 PID 

controllers to 1 actuator 
S7-300/400 PARA_CTL - Switch parameter sets 
S7-300/400 PID - PID algorithm 
S7-300/400 PUSLEGEN_M - Generate pulse for proportional actuators 
S7-300/400 RMP_SOAK - Specify setpoint according to ramp / soak 
S7-300/400 ROC_LIM - Limit rate of change 
S7-300/400 SCALE_M - Scale process value 
S7-300/400 SP_GEN - Specify setpoint manually 
S7-300/400 SPLT_RAN - Split manipulated variable range
S7-300/400 SWITCH - Switch analog values 
S7-300/400 LP_SCHED_M - Distribute controller calls

11.1.2.2 Steps for the configuration of a software controller
All SW-controllers are configured according to the same scheme:

Step Description
1 Add technology object (Page 7712) 
2 Configure technology object  (Page 7713)
3 Call instruction in the user program (Page 7714) 
4 Download technology object to device (Page 7715)
5 Commission software controller (Page 7716) 
6 Save optimized PID parameters in the project (Page 7717) 
7 Comparing values (Page 7718)
8 Display instances of a technology object  (Page 7737)

11.1.2.3 Add technology objects

Add technology object in the project navigator
When a technology object is added, an instance DB is created for the instruction of this 
technology object. The configuration of the technology object is stored in this instance DB. 

Requirement
A project with a CPU has been created.
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Procedure
To add a technology object, proceed as follows:

1. Open the CPU folder in the project tree.

2. Open the "Technology objects" folder.

3. Double-click "Add new object".
The "Add new object" dialog box opens.

4. Click on the "PID" button.
All available PID-controllers for this CPU are displayed.

5. Select the instruction for the technology object, for example, PID_Compact.

6. Enter an individual name for the technology object in the "Name" input field.

7. Select the "Manual" option if you want to change the suggested data block number of the 
instance DB.

8. Click "Further information" if you want to add own information to the technology object.

9. Confirm with "OK".

Result
The new technology object has been created and stored in the project tree in the "Technology 
objects" folder. The technology object is used if the instruction for this technology object is 
called in a cyclic interrupt OB.

 

 Note

You can select the "Add new and open" check box at the bottom of the dialog box. This opens 
the configuration of the technology object after adding has been completed.

 

11.1.2.4 Configure technology objects
The properties of a technology object on a S7-1200 CPU can be configured in two ways.

● In the Inspector window of the programming editor

● In the configuration editor

The properties of a technology object on a S7-300/400 CPU can only be configured in the 
configuration editor.

Inspector window of the programming editor
In the Inspector window of the programming editor you can only configure the parameters 
required for operation. 

The offline values of the parameters are also shown in online mode. You can only change the 
online values in the commissioning window. 

To open the Inspector window of the technology object, follow these steps:
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1. Open the "Program blocks" folder in the project tree.

2. Double click the block (cyclic interrupt OB) in which you open the instruction of the SW-
controller.
The block is opened in the work area.

3. Click on the instruction of the SW-controller.

4. In the Inspector window, select the "Properties" and "Configuration" tabs consecutively.

Configuration window
For each technology object, there is a specific configuration window in which you can configure 
all properties. 

To open the configuration window of the technology object, follow these steps:

1. Open the "Technology objects" folder in the project tree.

2. Open the technology object in the project tree.

3. Double-click the "Configuration" object.

Symbols
Icons in the area navigation of the configuration and in the Inspector window show additional 
details about the completeness of the configuration:

The configuration contains default values and is complete.
The configuration exclusively contains default values. With these default values the use of the technology object is 
possible without further changes.
The configuration contains values defined by the user and is complete
All input fields of the configuration contain valid values and at least one default setting was changed.
The configuration is incomplete or faulty
At least one input field or a collapsible list contains no or one invalid value. The corresponding field or the drop-down 
list box has a red background. When clicked the roll-out error message indicates the cause of the error.

The properties of a technology object are described in detail in the chapter for the technology 
object.

11.1.2.5 Call instruction in the user program
The instruction of the software controller must be called in a cyclic interrupt OB. The sampling 
time of the software controller is determined by the interval between the calls in the cyclic 
interrupt OB.

Requirement
The cyclic interrupt OB is created and the cycle time of the cyclic interrupt OB is correctly 
configured.
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Procedure
Proceed as follows to call the instruction in the user program:

1. Open the CPU folder in the project tree.

2. Open the "Program blocks" folder.

3. Double-click the cyclic interrupt OB.
The block is opened in the work area.

4. Open the "Technology" group in the "Instructions" window and the "PID Control" folder.
The folder contains all instructions for software controllers that can be configured on the 
CPU.

5. Select the instruction and drag it to your cyclic interrupt OB.
The "Call options" dialog box opens.

6. Select a technology object or type the name for a new technology object from the "Name" 
list. 

Result
If the technology object does not exist yet, it is added. The instruction is added in the cyclic 
interrupt OB. The technology object is assigned to this call of the instruction.

11.1.2.6 Downloading technology objects to device
A new or modified configuration of the technology object must be downloaded to the CPU for 
the online mode. The following characteristics apply when downloading retentive data:

● Software (changes only)

– S7-1200, S7-1500: 
Retentive data is retained.

– S7-300/400: 
Retentive data is updated immediately. CPU does not change to Stop.

●  Download PLC program to device and reset

– S7-1200, S7-1500: 
Retentive data is updated at the next change from Stop to RUN. The PLC program can 
only be downloaded completely.

– S7-300/400: 
Retentive data is updated at the next change from Stop to RUN.
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Downloading retentive data to an S7-1200 or S7-1500 CPU
 

 Note

The download and reset of the PLC program during ongoing system operation can result in 
serious damages or injuries in the case of malfunctions or program errors.

Make sure that dangerous states cannot occur before you download and reset the PLC 
program.

 

Proceed as follows to download the retentive data:

1. Select the entry of the CPU in the project tree.

2. Select the command "Download and reset PLC program" from the "Online" menu.

– If you have not established an online connection yet, the "Extended download" dialog 
opens. In this case, set all required parameters for the connection and click "Download".

– If the online connection has been defined, the project data is compiled, if necessary, 
and the dialog "Load preview" opens. This dialog displays messages and recommends 
actions necessary for download.

3. Check the messages.
As soon as download is possible, the "Download" button becomes active.

4. Click on "Download".
The complete PLC program is downloaded and the "Load results" dialog opens. This dialog 
displays the status and the actions after the download.

5. If the modules are to restart immediately after the download, select the check box "Start 
all".

6. Close the dialog "Download results" with "Finish".

Result
The complete PLC program is downloaded to the device. Blocks that only exist online in the 
device are deleted. By downloading all affected blocks and by deleting any blocks in the device 
that are not required, you avoid inconsistencies between the blocks in the user program.

The messages under "Info > General" in the Inspector window indicate whether the download 
was successful. 

11.1.2.7 Commissioning software controller

Procedure
To open the "Commissioning" work area of the technology object, follow these steps:

1. Open the "Technology objects" folder in the project tree.

2. Open the technology object in the project tree.

3. Double-click the "Commissioning" object.

The commissioning functions are specific for each controller and are described there.
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11.1.2.8 Save optimized PID parameter in the project
The software controller is optimized in the CPU. Through this, the values in the instance-DB 
on the CPU no longer agree with those in the project. 

To update the PID parameter in the project with the optimized PID parameters, proceed as 
follows:

Requirement
● An online connection to the CPU is established and the CPU is in "RUN" mode.

● The functions of the commissioning window have been enabled by means of the "Start" 
button.

Procedure
1. Open the CPU folder in the project tree.

2. Open the "Technology objects" folder.

3. Open a technology object.

4. Double click on "Commissioning".

5. Click on the  icon "Upload PID parameters".

6. Save the project.

Result
The currently active PID parameters are stored in the project data. When reloading the project 
data in the CPU, the optimized parameters are used.

11.1.2.9 Comparing values

Comparison display and boundary conditions
The "Compare values" function provides the following options: 

● Comparison of configured start values of the project with the start values in the CPU and 
the actual values

● Direct editing of actual values and the start values of the project

● Immediate detection and display of input errors with suggested corrections

● Backup of actual values in the project

● Transfer of start values of the project to the CPU as actual values
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Icons and operator controls
The following icons and operator controls are available:

Icon Function
Start value PLC matches the configured Start value project

Start value PLC does not match the configured Start value project

The comparison of the Start value PLC with the configured Start value project cannot be 
performed
At least one of the two comparison values has a process-related or syntax error.

Transfers actual values to the offline project

Transfers updated start values in the project to the CPU (initialize setting values)

Opens the "Compare values" dialog

Boundary conditions
The "Compare values" function is available for S7-1200 and S7-1500 without limitations.

The following limitation applies to S7-300 and S7-400:

In monitoring mode, an S7-300/S7-400 cannot transfer the start values to the CPU. These 
values cannot be displayed online with "Compare values".

The actual values of the technology object are displayed and can be changed directly.

Comparing values
The procedure is shown in the following using "PID Parameters" as an example.

Requirements 
● A project with a software controller is configured.

● The project is downloaded to the CPU.

● The configuration dialog is open in the project navigator.

Procedure 
1. Open the desired software controller in the project navigation.

2. Double-click the "Configuration" object.

3. Navigate within the configuration window to the "PID Parameters" dialog.

4. Click the  icon to activate monitoring mode.
The icons and operator controls (Page 7715) of the "Compare values" function are shown 
behind the parameters.
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5. Click the desired parameter in the input box and change the parameter values manually 
by entering them directly.

– If the background of the input box is gray, this value is a read-only value and cannot be 
changed. 

– To change the values in the "PID Parameters" dialog, enable manual entry by selecting 
the "Enable manual entry" check box beforehand.

6. Click the  icon to open the dialog for the start values.
This dialog indicates two values of the parameter:

– Start value in CPU: The start value in the CPU is shown in the top part.

– Start value in the project: The configured start value in the project is shown in the bottom 
part.

7. Enter the desired value in the input box for the project.

Error detection 
The input of incorrect values is detected. Corrections are suggested in this case.

If you enter a value with incorrect syntax, a rollout containing the corresponding error message 
opens below the parameter. The incorrect value is not applied.

If you enter a value that is incorrect for the process, a dialog opens containing the error 
message and a suggested correction:

● Click "No" to accept this suggested correction and correct your input. 

● Click "OK" to apply the incorrect value.
 

 NOTICE

Malfunctions of the controller

Values incorrect for the process can result in controller malfunctions.
 

Backing up actual values 
Click the  icon to transfer the actual controller values to the start values of your configured 
project.

Using technology functions
11.1 PID control

WinCC Professional V13.0
System Manual, 02/2014 7717



Transferring project values to the CPU 
Click the  icon to transfer the configured values of your project to the CPU.

 

 CAUTION

Prevent personal injury and property damage!

Downloading and resetting of the user program while the plant is operating may result in 
significant property damage and severe personal injuries in the event of malfunctions or 
program errors.

Make sure that dangerous states cannot occur before you download and reset the user 
program.

 

11.1.2.10 Parameter view

Introduction to the parameter view
The Parameter view provides you with a general overview of all relevant parameters of a 
technology object. You obtain an overview of the parameter settings and can easily change 
them in offline and online mode.
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①      "Parameter view" tab

②      Toolbar (Page 7722)

③      Navigation (Page 7723)

④      Parameter table (Page 7723)

Function scope
The following functions are available for analyzing the parameters of the technology objects 
and for enabling targeted monitoring and modification.

Display functions:

● Display of parameter values in offline and online mode

● Display of status information of the parameters

● Display of value deviations and option for direct correction

● Display of configuration errors

● Display of value changes as a result of parameter dependencies

● Display of all memory values of a parameter: Start value PLC, Start value project, Monitor 
value

● Display of the parameter comparison of the memory values of a parameter

Operator control functions:

● Navigation for quickly changing between the parameters and parameter structures.

● Text filter for faster searches for particular parameters. 

● Sorting function for customizing the order of parameters and parameter groups to 
requirements.

● Memory function for backing up structural settings of the Parameter view.

● Monitoring and modifying of parameter values online.

● Function for saving a snapshot of parameter values of the CPU in order to capture 
momentary situations and to respond to them.

● Function for applying a snapshot of parameter values as start values.

● Download of modified start values to the CPU.

● Comparison functions for comparing parameter values with one another.

Validity
The Parameter view is available for the following technology objects:

● PID_Compact

● PID_3Step

● CONT_C (S7-1500 only)

● CONT_S (S7-1500 only)
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● TCONT_CP (S7-1500 only)

● TCONT_S (S7-1500 only)

● TO_Axis_PTO (S7-1200 Motion Control)

● TO_Positioning_Axis (S7-1200 Motion Control)

● TO_CommandTable_PTO (S7-1200 Motion Control)

● TO_CommandTable (S7-1200 Motion Control)

Structure of the parameter view

Toolbar
The following functions can be selected in the toolbar of the parameter view.

Icon Function Explanation
Monitor all Starts the monitoring of visible parameters in the active Parameter 

view (online mode).
Create snapshot of 
monitor values and 
accept setpoints of this 
snapshot as start values

Applies the current monitor values to the “Snapshot” column and 
updates the start values in the project.
Only in online mode for PID_Compact and PID_3Step.

Initialize setpoints Transfers the start values updated in the project to the CPU. 
Only in online mode for PID_Compact and PID_3Step.

Create snapshot of 
monitor values

Applies the current monitor values to the “Snapshot” column.
Only in online mode.

Modify all selected 
parameters immediately 
and once

This command is executed once and as quickly as possible without 
reference to any particular point in the user program.
Only in online mode.

Select navigation 
structure

Toggles between functional navigation and data navigation.

Text filter... After entry of a character string: Display of all parameters containing 
the specified string in one of the currently visible columns.

Selection of compare 
values

Selection of parameter values that are to be compared with one 
another in online mode (Start value project, Start value PLC, Snapshot)
Only in online mode.

Save window settings Saves your display settings for the Parameter view (e.g., selected 
navigation structure, activated table columns, etc.)
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Navigation
Within the "Parameter view" tab, the following alternative navigation structures can be selected.

Navigation Explanation
Functional 
navigation

In the functional navigation, the structure of the parameters is based 
on the structure in the configuration dialog ("Functional view" tab), 
commissioning dialog, and diagnostics dialog.
The last group "Other parameters" contains all other parameters of 
the technology object.

Data navigation In the data navigation, the structure of the parameters is based on 
the structure in the instance DB.
The last group "Other parameters" contains the parameters that are 
not contained in the instance DB.

You can use the "Select navigation structure" drop-down list to toggle the navigation structure. 

Parameter table
The table below shows the meaning of the individual columns of the parameter table. You can 
show or hide the columns as required.

● Column "Offline" = X: Column is visible in offline mode.

● Column "Online" = X: Column is visible in online mode (online connection to the CPU).

Column Explanation Offline Online
Name in functional 
view

Name of the parameter in the functional view.
The display field is empty for parameters that are not configured via the 
technology object.

X X

Full name in DB Complete path of the parameter in the instance DB.
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Name in DB Name of the parameter in the instance DB.
If the parameter is part of a structure or UDT, the prefix ". ./" is added. 
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Status of 
configuration

Display of the completeness of the configuration using status symbols.
see Status of configuration (offline) (Page 7731)

X  

Compare result Result of the "Compare values" function. 
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
see Comparing values (Page 7715)

 X
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Column Explanation Offline Online
Start value project Configured start value in the project.

Error indication if entered values have a syntax or process-related error.
X X

Default value Value that is pre-assigned to the parameter.
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Snapshot Snapshot of the current values in the CPU (monitor values).
Error indication if values have a process-related error.

X X

Start value PLC Start value in the CPU. 
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
Error indication if values have a process-related error.

 X

Monitor value Current value in the CPU. 
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
Error indication if values have a process-related error.

 X

Modify value Value that is to be used to change the monitor valuet.
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
Error indication if entered values have a syntax or process-related error.

 X

Selection for 
transmission

 

Selection of the Modify values that are to be transmitted using the "Modify all 
selected parameters immediately and once" button. 
This column is displayed together with the "Modify value" column.

 X

Minimum value Minimum process-related value of the parameter. 
If the minimum value is dependent on other parameters, it is defined:
● Offline: By the Start value project.
● Online: By the  Monitor values.

X X

Maximum value Maximum process-related value of the parameter. 
If the maximum value is dependent on other parameters, it is defined:
● Offline: By the Start value project.
● Online: By the Monitor values.

X X

Setpoint Designates the parameter as a setpoint. These parameters can be initialized 
online.

X X

Data type Data type of the parameter.
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Retain Designates the value as a retentive value. 
The values of retentive parameters are retained even after the voltage supply 
is switched off. 

X X

Accessible from HMI Indicates whether the HMI can access this parameter during runtime. X X
Visible in HMI Indicates whether the parameter is visible in the selection list of the HMI by 

default.
X X

Comment Brief description of the parameter. X X
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Opening the parameter view

Requirement
The technology object has been added in the project tree, i.e., the associated instance DB of 
the instruction has been created.

Procedure
1. Open the "Technology objects" folder in the project tree.

2. Open the technology object in the project tree.

3. Double-click the "Configuration" object.

4. Select the "Parameter view" tab in the top right corner.

Result
The Parameter view opens. Each displayed parameter is represented by one row in the 
parameter table.

The displayable parameter properties (table columns) vary depending on whether you are 
working with the Parameter view in offline or online mode.

In addition, you can selectively display and hide individual table columns. 

See also
Default setting of the parameter view (Page 7725)

Default setting of the parameter view

Default settings
To enable you to work efficiently with the Parameter view, you can customize the parameter 
display and save your settings. 

The following customizations are possible and can be saved:

● Show and hide columns

● Change column width

● Change order of the columns

● Toggle navigation

● Select parameter group in the navigation

● Selection of compare values
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Show and hide columns
To show or hide columns in the parameter table, follow these steps:

1. Position the cursor in the header of the parameter table.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the check box for the column.

4. To hide a column, clear the check box for the column.

or

1. Position the cursor in the header of the parameter table.

2. Select the "Show all columns" command in the shortcut menu if all columns of the offline 
or online mode are to be displayed.

Some columns can only be displayed in online mode: see Parameter table (Page 7721).

Change column width
To customize the width of a column so that all texts in the rows can be read, follow these steps:

1. Position the cursor in the header of the parameter table to the right of the column to be 
customized until the shape of the cursor changes to a cross.

2. Then double-click this location.

or

1. Open the shortcut menu on the header of the parameter table.

2. Click 

– "Optimize column width" or

– "Optimize width of all columns".

If the column width setting is too narrow, the complete content of individual fields are shown 
if you hover the cursor briefly over the relevant field.

Change order of the columns
The columns of the parameter table can be arranged in any way. 

To change the order of the columns, follow these steps:
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1. Click on the column header and use a drag-and-drop operation to move it to the desired 
location.
When you release the mouse button, the column is anchored to the new position.

Toggle navigation
To toggle the display form of the parameters, follow these steps:

1. Select the desired navigation in the “Select navigation structure” drop-down list.

– Data navigation

– Functional navigation

See also Navigation (Page 7721).

Select parameter group in the navigation
Within the selected navigation, you choose between the “All parameters” display or the display 
of a subordinate parameter group of your choice.

1. Click the desired parameter group in the navigation.
The parameter table only displays the parameters of the parameter group.

Selection of compare values (online)
To set the compare values for the “Compare values” function, follow these steps:

1. Select the desired compare values in the “Selection of compare values” drop-down list.

– Start value project / Start value PLC

– Start value project / Snapshot

– Start value PLC / Snapshot

The “Start value project / Start value PLC” option is set by default.

Save default setting of the Parameter view
To save the above customizations of the Parameter view, follow these steps:

1. Customize the Parameter view according to your requirements.

2. Click the “Save window settings” button  at the top right of the Parameter view.

Working with the parameter view

Overview
The following table provides an overview of the functions of the Parameter view in online and 
offline mode described in the following.

● Column "Offline" = X: This function is possible in offline mode.

● Column "Online" = X: This function is possible in online mode.
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Function/action Offline Online
Filtering the parameter table (Page 7728) X X
Sorting the parameter table (Page 7729) X X
Transferring parameter data to other editors (Page 7729) X X
Indicating errors (Page 7729) X X
Editing start values in the project (Page 7730) X X
Status of configuration (offline) (Page 7731) X  
Monitoring values online in the parameter view (Page 7732)  X
Create snapshot of monitor values (Page 7732)  X
Modifying values (Page 7733)  X
Comparing values (Page 7734)  X
Applying values from the online program as start values (Page 7735)  X
Initializing setpoints in the online program (Page 7736)  X

Filtering the parameter table
You can filter the parameters in the parameter table in the following ways:

● With the text filter

● With the subgroups of the navigation

Both filter methods can be used simultaneously.

With the text filter
Texts that are visible in the parameter table can be filtered. This means only texts in displayed 
parameter rows and columns can be filtered.

1. Enter the desired character string for filtering in the “Text filter...” input box.
The parameter table displays only the parameters containing the character string.

The text filtering is reset.

● When another parameter group is selected in the navigation.

● When navigation is changed from data navigation to functional navigation, or vice versa.

With the subgroups of the navigation
1. Click the desired parameter group in the navigation, e.g., "Static".

The parameter table only shows the static parameters. You can select further subgroups 
for some groups of the navigation.

2. Click “All parameters” in the navigation if all parameters are to be shown again.
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Sorting the parameter table
The values of the parameters are arranged in rows. The parameter table can be sorted by any 
displayed column.

● In columns containing numerical values, sorting is based on the magnitude of the numerical 
value. 

● In text columns, sorting is alphabetical.

Sorting by column
1. Position the cursor in the header cell of the desired column.

The background of this cell turns blue.

2. Click the column header.

Result
The entire parameter table is sorted by the selected column. A triangle with tip facing up 
appears in the column header. 

Clicking the column header again changes the sorting as follows:

● Symbol “▲”: Parameter table is sorted in ascending order.

● Symbol “▼”: Parameter table is sorted in descending order.

● No symbol: The sorting is removed again. The parameter table assumes the default display.

The “../“ prefix in the “Name in DB” column is ignored when sorting.

Transferring parameter data to other editors
After selecting an entire parameter row of the parameter table, you can use the following: 

● Drag-and-drop

● <Ctrl+C>/<Ctrl+V>

● Copy/Paste via shortcut menu 

Transfer parameters to the following editors of the TIA Portal:

● Program editor

● Watch table

● Signal table for trace function

The parameter is inserted with its full name: See information in “Full name in DB” column.

Indicating errors

Error indication
Parameter assignment errors that result in compilation errors (e.g., limit violation) are indicated 
in the Parameter view.
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Every time a value is input in the Parameter view, a check is made for process-related and 
syntax errors and the result is indicated.

Bad values are indicated by:

● Red error symbol in the "Status of configuration" (offline mode) or "Compare result" (online 
mode, depending on the selected comparison type) columns

and/or

● Table field with red background
If you click the bad field, a roll-out error message appears with information of the permissible 
value range or the required syntax (format)

Compilation error
From the error message of the compiler, you can directly open the Parameter view (functional 
navigation) containing the parameter causing the error in situations where the parameter is 
not displayed in the configuration dialog. 

Editing start values in the project
With the Parameter view, you can edit the start values in the project in offline mode and online 
mode.

● You make value changes in the “Start value project” column of the parameter table.

● In the “Status of configuration” column of the parameter table, the progress of the 
configuration is indicated by the familiar status symbols from the configuration dialog of the 
technology object.

Boundary conditions
● If other parameters depend on the parameter whose start value was changed, the start 

value of the dependent parameters are also adapted.

● If a parameter of a technology object is not editable, it is also not editable in the parameter 
view. The ability to edit a parameter can also depend on the values of other parameters.

Defining new start values
To define start values for parameters in the Parameter view, follow these steps:

1. Open the Parameter view of the technology object.

2. Enter the desired start values in the "Start value project" column. The value must match 
the data type of the parameter and must not exceed the value range of the parameter.
The limits of the value range can be seen in the “Maximum value” and “Minimum value” 
columns.

The "Status of configuration" column indicates the progress of the configuration with colored 
symbols.

See also Status of configuration (offline) (Page 7731)
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Following adaptation of the start values and downloading of the technology object to the CPU, 
the parameters take the defined value at startup if they are not declared as retentive (“Retain” 
column).

Error indication
When a start value is input, a check is made for process-related and syntax errors and the 
result is indicated.

Bad start values are indicated by:

● Red error symbol in the "Status of configuration" (offline mode) or "Compare result" (online 
mode, depending on the selected comparison type) columns

and/or

● Red background in the “Start value project” field 
If you click on the bad field, a roll-out error message appears with information of the 
permissible value range or the necessary syntax (format)

Correcting bad start values
1. Correct bad start values using information from the roll-out error message.

Red error symbol, red field background, and roll-out error message are no longer displayed.

The project cannot be successfully compiled unless the start values are error-free.

Status of configuration (offline)
The status of the configuration is indicated by icons:

● In the “Status of configuration” column in the parameter table

● In the navigation structure of the functional navigation and data navigation

Symbol in “Status of configuration” column

Symbol Meaning
The start value of the parameter corresponds to the default value and is valid. A start value has not yet been 
defined by the user.
The start value of the parameter contains a value defined by the user. The start value is different than the 
default value. The start value is error-free and valid.
The start value of the parameter is invalid (syntax or process-related error). 
The input box has a red background. When clicked, the roll-out error message indicates the cause of the 
error.
Only for S7-1200 Motion Control:
The start value of the parameter is valid but contains warnings.
The input box has a yellow background.
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Symbol in the navigation
The symbols in the navigation indicate the progress of the configuration in the same way as 
in the configuration dialog of the technology object.

See Configure technology objects (Page 7711)

Monitoring values online in the parameter view
You can monitor the values currently taken by the parameters of the technology object in the 
CPU (monitor values) directly in the Parameter view.

Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

Procedure
1. Start the monitoring by clicking .

As soon as the Parameter view is online, the following columns are additionally displayed:

– Compare result

– Start value PLC

– Monitor value

– Modify value

– Selection for transmission

The "Monitor value" column shows the current parameter values on the CPU. 
Meaning of the additional columns: see Parameter table (Page 7721)

2. Stop the monitoring by clicking  again.

Display 
All columns that are only available online have an orange background:

● Values in light-orange cells  can be changed.

● Values in cells with a dark orange background  cannot be changed. 

Create snapshot of monitor values
You can back up the current values of the technology object on the CPU (monitor values) and 
display them in the Parameter view.
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Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

Procedure
To show the current parameter values, follow these steps:

1. In the Parameter view, click the “Create snapshot of monitor values" icon .

Result
The current monitor values are transferred once to the "Snapshot" column of the parameter 
table.

You can analyze the values "frozen" in this way while the monitor values continue to be updated 
in the "Monitor values" column.

Modifying values
With the Parameter view, you can modify values of the technology object in the CPU.

You can assign values to the parameter once (Modify value) and modify them immediately. 
The modify request is executed as quickly as possible without reference to any particular point 
in the user program.

 
 

 DANGER

Danger when modifying:

Changing the parameter values while the plant is operating may result in severe damage to 
property and personal injury in the event of malfunctions or program errors. 

Make sure that dangerous states cannot occur before you use the "Modify" function.
 

Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.
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● The “Monitor all” button  is selected.

● The parameter can be modified (associated field in the "Modify value" column has a light-
orange background).

Procedure
To modify parameters immediately, follow these steps:

1. Enter the desired modify values in the “Modify values” column of the parameter table.

2. Check whether the check box for modifying is selected in the "Select for transmission" 
column. 
The modify values and associated check boxes of dependent parameters are automatically 
adapted at the same time.

3. Click the “Modify all selected parameters immediately and once” icon .

The selected parameters are modified once and immediately with the specified values and 
can be monitored in the "Modify values" column. The check boxes for modifying in the 
"Selection for transmission" column are automatically cleared after the modify request is 
complete.

Error indication
When a start value is input, a check is made immediately for process-related and syntax errors 
and the result is indicated.

Bad start values are indicated by:

● Red background in the “Modify value” field 

and

● If you click the bad field, a roll-out error message appears with information of the permissible 
value range or the necessary syntax (format)

Bad modify values
● Modify values with process-related errors can be transmitted.

● Modify values with syntax errors cannot be transmitted.

Comparing values
You can use comparison functions to compare the following memory values of a parameter:

● Start value project

● Start value PLC

● Snapshot
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Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

Procedure
To compare the start values on the various target systems, follow these steps:

1. Click the "Selection of compare values" icon .
A selection list containing the comparison options opens:

– Start value project - Start value PLC (default setting)

– Start value project - Snapshot

– Start value PLC - Snapshot

2. Select the desired comparison option.
The selected comparison option is executed as follows:

– A scales symbol appears in the header cells of the two columns selected for comparison.

– Symbols are used in the "Compare result" column to indicate the result of the 
comparison of the selected columns.

Symbol in "Compare result" column

Symbol Meaning
The compare values are equal and error-free.

The compare values are not equal and error-free.

At least one of the two compare values has a process-related or syntax error.

The comparison cannot be performed. At least one of the two compare values is not available (e.g., 
snapshot).

Symbol in the navigation
The symbols are shown in the same way in the navigation if the comparison result applies to 
at least one of the parameters below the displayed navigation structure.

Applying values from the online program as start values
In order to apply optimized values from the CPU to the project as start values, you create a 
snapshot of the monitor values. Values of the snapshot marked as a "Setpoint" are then applied 
to the project as start values.
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Requirements
● The technology object is of type "PID_Compact" or "PID_3Step".

● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

Procedure
To apply optimized values from the CPU, follow these steps:

1. Click the "Create snapshot of monitor values and accept setpoints of this snapshot as start 
values" icon .

Result
The current monitor values are applied to the "Snapshot" column and their setpoints are copied 
to the "Start value project" column as new start values.

 
 

 Note
Applying values of individual parameters 

You can also apply the values of individual parameters that are not marked as a setpoint from 
the "Snapshot" column to the "Start values project" column. To do so, copy the values and 
insert them into the "Start value project" column using the "Copy" and "Paste" commands in 
the shortcut menu. 

 

Initializing setpoints in the online program
You can initialize all parameters that are marked as a "Setpoint" in the Parameter view with 
new values in the CPU in one step. In so doing, the start values are downloaded from the 
project to the CPU. The CPU remains in "RUN" mode. 

To avoid data loss on the CPU during a cold restart or warm restart, you must also download 
the technology object to the CPU. 

 

 DANGER

Danger when changing parameter values

Changing the parameter values while the plant is operating may result in severe damage to 
property and personal injury in the event of malfunctions or program errors.

Make sure that dangerous states cannot occur before you reinitialize the setpoints.
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Requirements
● The technology object is of type "PID_Compact" or "PID_3Step".

● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

● The parameters marked as a "Setpoint" have a "Start value project" that is free of process-
related and syntax errors

Procedure
To initialize all setpoints, follow these steps:

1. Enter the desired values in the "Start value project" column.
Ensure that the start values are free of process-related and syntax errors. 

2. Click the "Initialize setpoints" icon .

Result
The setpoints in the CPU are initialized with the start values from the project.

11.1.2.11 Display instance DB of a technology object.
An instance DB, in which the parameter and static variables are saved, is created for each 
technology object.

Procedure
To display the instance DB of a technology object, proceed as follows:

1. Open the CPU folder in the project tree.

2. Open the "Technology objects" folder.

3. Highlight a technology object.

4. Select the command "Open DB editor" in the shortcut menu.

11.1.3 Using PID_Compact

11.1.3.1 Technology object PID_Compact
The technology object PID_Compact provides a continuous PID controller with integrated 
optimization. You can alternatively configure a pulse controller. Both manual and automatic 
mode are possible.   
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PID-Compact continuously acquires the measured process value within a control loop and 
compares it with the required setpoint. From the resulting control deviation, the instruction 
PID_Compact calculates an output value by which the process value is adapted as quickly 
and stable as possible to the setpoint. The output value for the PID controller consists of three 
actions:

● P action
The proportional action of the output value increases in proportion to the control deviation.

● I action
The integral action of the output value increases until the control deviation has been 
balanced. 

● D action
The derivative action increases with the rate of change of control deviation. The process 
value is corrected to the setpoint as quickly as possible. The derivative action will be 
reduced again if the rate of change of control deviation drops.

The instruction PID_Compact calculates the proportional, integral and derivative parameters 
for your controlled system during pretuning. Fine tuning can be used to tune the parameters 
further. You do not need to manually determine the parameters.

Additional information
● Overview of software controller (Page 7708)

● Add technology objects (Page 7710)

● Configure technology objects (Page 7711)

● Configuring PID_Compact V2 (Page 7738)

● Configuring PID_Compact V1 (Page 7754)

11.1.3.2 PID_Compact V2

Configuring PID_Compact V2

Basic settings

Introduction
Configure the following properties of the "PID_Compact" technology object under "Basic 
settings" in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)
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● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

Setpoint, process value and output value
You can only configure the setpoint, process value and output value in the Inspector window 
of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the physical quantity and unit of measurement for setpoint, process value, and 
disturbance variable in the "Controller type" group. Setpoint, process value, and disturbance 
variable is displayed in this unit of measurement.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 

PID_Compact does not work with negative proportional gain. Select the check box "Invert 
control logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.
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Startup characteristics
1. To switch to "Inactive" mode after CPU restart, clear the "Activate Mode after CPU restart" 

check box.
To switch to the operating mode saved in the Mode parameter after CPU restart, select the 
"Activate Mode after CPU restart" check box. 

2. In the "Set Mode to" drop-down list, select the mode that is to be enabled after a complete 
download to the device.
After a complete download to the device, PID_Compact starts in the selected operating 
mode. With each additional restart, PID_Compact starts in the mode that was last saved 
in Mode.

Example

You have selected the "Activate Mode after CPU restart" check box and the entry "Pretuning" 
in the "Set Mode to" list. After a complete download to the device, PID_Compact starts in the 
"Pretuning" mode. If pretuning is still active, PID_Compact starts in "Pretuning" mode again 
after restart of the CPU. If pretuning was successfully completed and automatic mode is active, 
PID_Compact starts in "Automatic mode" after restart of the CPU.  

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_Compact will scale the value of the analog input to the physical quantity if you use the 
analog input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 
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Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:

1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Output value
PID_Compact offers three output values. Your actuator will determine which output value you 
use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output
The output value needs to be processed by the user program, for example because of 
nonlinear actuator response.

● Output_PWM
The actuator is controlled via a digital output. Pulse width modulation creates minimum ON 
and minimum OFF times.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output_PER (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to process the output value using the user program:

1. Select the entry "Output" in the drop-down list "Output".

2. Select "Instance DB".
The calculated output value is saved in the instance data block.

3. For the preparation of the output value, use the output parameter Output.

4. Transfer the processed output value to the actuator via a digital or analog CPU output.

Proceed as follows to use the digital output value:

1. Select the entry "Output_PWM" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the digital output.
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Process value settings

Scaling the process value
If you have configured the use of Input_PER in the basic setting, you must convert the value 
of the analog input to the physical quantity of the process value. The current configuration is 
displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

Procedure
To scale the process value, follow these steps:

1. Enter the low pair of values in the "Scaled low process value" and "Low" input fields.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.

Default settings for the value pairs are stored in the hardware configuration. To use the value 
pairs from the hardware configuration, follow these steps:

1. Select the PID_Compact instruction in the programming editor.

2. Interconnect Input_PER with an analog input in the basic settings.

3. Click the "Automatic setting" button in the process value settings.

The existing values will be overwritten with the values from the hardware configuration.

Process value limits
You must specify an appropriate absolute high limit and low limit for the process value as limit 
values for your controlled system. As soon as the process value violates these limits, an error 
occurs (ErrorBits = 0001h). Tuning is canceled when the process value limits are violated. You 
can configure how PID_Compact reacts to an error in automatic mode in the output value 
settings.

Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_Compact instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.
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Example
Process value high limit = 98 °C; warning high limit = 90 °C 

Warning low limit = 10 °C; process value low limit = 0 °C

PID_Compact will respond as follows:

Process value InputWarnin
g_H 

InputWarnin
g_L

ErrorBi
ts

Operating mode

> 98 °C TRUE FALSE 0001h Inactive or 
Substitute output value with error 
monitoring

≤ 98 °C and > 90 °C TRUE FALSE 0000h Automatic mode
≤ 90 °C and ≥ 10 °C FALSE FALSE 0000h Automatic mode
< 10 °C and ≥ 0 °C FALSE TRUE 0000h Automatic mode
< 0 °C FALSE TRUE 0001h Inactive or 

Substitute output value with error 
monitoring

In the output value settings, you can specify the reaction of PID_Compact when the process 
value high limit or low limit is violated.

See also
Parameters State and Mode V2 (Page 3020)

PWM limits
The value at the output parameter Output is transformed into a pulse sequence that is output 
at output parameter Output_PWM by means of a pulse width modulation. Output is calculated 
in the PID algorithm sampling time, Output_PWM is output in the PID_Compact sampling time. 

The PID algorithm sampling time is determined during pretuning or fine tuning. If manually 
setting the PID parameters, you will also need to configure the PID algorithm sampling time. 
The PID_Compact sampling time is equivalent to the cycle time of the calling OB.

The pulse duration is proportional to the value at Output and is always an integer multiple of 
the PID_Compact sampling time. 
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① PID_Compact sampling time
② PID algorithm sampling time 
③ Pulse duration
④ Break time

The "Minimum ON time" and the "Minimum OFF time" are rounded to an integer multiple of 
the PID_Compact sampling time. 

A pulse or a break is never shorter than the minimum ON or OFF time. The inaccuracies this 
causes are added up and compensated in the next cycle.

Example

PID_Compact sampling time = 100 ms

PID algorithm sampling time = 1000 ms

Minimum ON time = 200 ms

Output is a constant 15%. The smallest pulse that PID_Compact can output is 20%. In the first 
cycle, no pulse is output. In the second cycle, the pulse not output in the first cycle is added 
to the pulse of the second cycle. 
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① PID_Compact sampling time
② PID algorithm sampling time 
⑤ Minimum ON time

In order to minimize operation frequency and conserve the actuator, extend the minimum ON 
and OFF times.

If you are using "Output" or "Output_PER", you must configure the value 0.0 for the minimum 
ON and OFF times.

 

 Note

The minimum ON and OFF times only affect the output parameter Output_PWM and are not 
used for any pulse generators integrated in the CPU.

 

Output value

Output value limits
In the "Output value limits" configuration window, configure the absolute limits of your output 
value in percent. Absolute output value limits are not violated in neither manual mode nor 
automatic mode. If an output value outside the limits is specified in manual mode, the effective 
value is limited in the CPU to the configured limits. 

The output value limits must match the control logic.

The valid output value limit values depend on the Output used.

Output -100.0 to 100.0%
Output_PER -100.0 to 100.0%
Output_PWM 0.0 to 100.0%
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Reaction to error
 

 NOTICE

Your system may be damaged.

If you output "Current value while error pending " or "Substitute output value while error 
pending" in the event of an error, PID_Compact remains in automatic mode. This may cause 
a violation of the process value limits and damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 

 

PID_Compact is preset so that the controller stays active in most cases in the event of an error. 
If errors occur frequently in controller mode, this default reaction has a negative effect on the 
control response. In this case, check the Errorbits parameter and eliminate the cause of the 
error.

PID_Compact generates a programmable output value in response to an error:
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● Zero (inactive)
PID_Compact outputs 0.0 as output value for all errors and switches to "Inactive" mode. 
The controller is only reactivated by a falling edge at Reset or a rising edge at ModeActivate.

● Current value while error is pending
If the following errors occur in automatic mode, PID_Compact returns to automatic mode 
as soon as the errors are no longer pending.
If one or more of the following errors occur, PID_Compact stays in 
automatic mode:

– 0001h: The "Input" parameter is outside the process value limits.

– 0800h: Sampling time error

– 40000h: Invalid value at Disturbance parameter. 

If one or more of the following errors occur in automatic mode, PID_Compact switches to 
"Substitute output value with error monitoring" mode and outputs the last valid output value:

– 0002h: Invalid value at Input_PER parameter.

– 0200h: Invalid value at Input parameter.

– 0400h: Calculation of output value failed.

– 1000h: Invalid value at Setpoint parameter.

If an error occurs in manual mode, PID_Compact continues using the manual value as the 
output value. If the manual value is invalid, the substitute output value is used. If the manual 
value and substitute output value are invalid, the output value low limit is used. 
If the following error occurs during a pretuning or fine tuning, PID_Compact remains in 
active mode:

– 0020h: Pretuning is not permitted during fine tuning.

When any other error occurs, PID_Compact cancels the tuning and switches to the mode 
from which tuning was started.
As soon as no errors are pending, PID_Compact returns to automatic mode.

● Substitute output value while error is pending
PID_Compact outputs the substitute output value. 
If the following error occurs, PID_Compact stays in "Substitute output value with error 
monitoring" mode and outputs the output value low limit: 

– 20000h: Invalid value at SubstituteOutput tag. 

For all other errors, PID_Compact reacts as described for "Current value while error is 
pending".

See also
Parameters State and Mode V2 (Page 3020)

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.
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The PID algorithm operates according to the following equation:

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint 
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:

All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_Compact. 

Downloading technology objects to device (Page 7713)

Proportional gain
The value specifies the proportional gain of the controller. PID_Compact does not work with 
a negative proportional gain. Control logic is inverted under Basic settings > Controller type.
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Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.

Proportional action weighting
The proportional action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.

If you use Output_PWM, the accuracy of the output signal is determined by the ratio of the PID 
algorithm sampling time to the cycle time of the OB. The PID algorithm sampling time 
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corresponds to the time period of the pulse width modulation. The cycle time should be at least 
10 times the PID algorithm sampling time.

Rule for tuning
Select whether PI or PID parameters are to be calculated in the "Controller structure" drop-
down list.

● PID
Calculates PID parameters during pretuning and fine tuning.

● PI
Calculates PI parameters during pretuning and fine tuning.

● User-defined
The drop-down list displays "User-defined" if you have configured different controller 
structures for pretuning and fine tuning via a user program. 

Commissioning PID_Compact V2

Pretuning
The pretuning determines the process response to a jump change of the output value and 
searches for the point of inflection. The PID parameters are calculated from the maximum rate 
of rise and dead time of the controlled system. You obtain the best PID parameters when you 
perform pretuning and fine tuning.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. This is most likely 
the case in operating modes "Inactive" and "manual mode". The PID parameters are backed 
up before being recalculated. 

Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● PID_Compact is in one of the following modes: "Inactive", "Manual mode", or "Automatic 
mode".

● The setpoint and the process value lie within the configured limits (see "Process value 
monitoring" configuration).

● The difference between setpoint and process value is greater than 30% of the difference 
between process value high limit and process value low limit.

● The distance between the setpoint and the process value is > 50% of the setpoint.
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Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_Compact > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list.

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it can be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_Compact switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_Compact responds with the configured reaction to errors.

See also
Parameters State and Mode V2 (Page 3020)

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are tuned for the operating point from the amplitude and frequency of this oscillation. All PID 
parameters are recalculated from the results. PID parameters from fine tuning usually have 
better master control and disturbance characteristics than PID parameters from pretuning. You 
obtain the best PID parameters when you perform pretuning and fine tuning.

PID_Compact automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

Requirement
● The PID_Compact instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE
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● The setpoint and the process value lie within the configured limits.

● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● PID_Compact is in one of the following operating modes: Inactive, automatic mode, or 
manual mode.

Process depends on initial situation
Fine tuning can be started from the following operating modes: "Inactive", "automatic mode", 
or "manual mode". Fine tuning proceeds as follows when started from:

● Automatic mode
Start fine tuning from automatic mode if you wish to improve the existing PID parameters 
through tuning.
PID_Compact controls the system using the existing PID parameters until the control loop 
has stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start. 

● Inactive or manual mode
If the requirements for pretuning are met, pretuning is started. The determined PID 
parameters will be used for control until the control loop has stabilized and the requirements 
for fine tuning have been met. Only then will fine tuning start. If pretuning is not possible, 
PID_Compact responds with the configured reaction to errors.
An attempt is made to reach the setpoint with the minimum or maximum output value if the 
process value for pretuning is already too near the setpoint. This can produce increased 
overshoot. 

Procedure
To perform fine tuning, follow these steps:

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 100% 
and it is to be assumed that tuning is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Using technology functions
11.1 PID control

WinCC Professional V13.0
7750 System Manual, 02/2014



Result
If no errors occurred during fine tuning, the PID parameters have been tuned. PID_Compact 
switches to automatic mode and uses the tuned parameters. The tuned PID parameters will 
be retained during power OFF and a restart of the CPU. 

If errors occurred during "fine tuning", PID_Compact responds with the configured response 
to errors.

See also
Parameters State and Mode V2 (Page 3020)

"Manual" mode
The following section describes how you can use the "manual mode" operating mode in the 
commissioning window of the "PID_Compact" technology object. Manual mode is also possible 
when an error is pending.

Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● An online connection to the CPU has been established and the CPU is in the "RUN" mode.

Procedure
Use "Manual mode" in the commissioning window if you want to test the controlled system by 
specifying a manual value. To define a manual value, follow these steps:

1. Click the "Start" icon.

2. Select the "Manual mode" check box in the "Online status of controller" area.
PID_Compact operates in manual mode. The most recent current output value remains in 
effect.

3. Enter the manual value in the "Output" field as a % value.

4. Click the  icon.

Result
The manual value is written to the CPU and immediately goes into effect.

Clear the "Manual mode" check box if the output value is to be specified again by the PID 
controller. The switchover to automatic mode is bumpless.

See also
Parameters State and Mode V2 (Page 3020)
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11.1.3.3 PID_Compact V1

Configuring PID_Compact V1

Basic settings

Introduction
Configure the following properties of the "PID_Compact" technology object under "Basic 
settings" in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

Setpoint, process value and output value
You can only configure the setpoint, process value and output value in the Inspector window 
of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the unit of measurement and physical quantity for the setpoint and process value in the 
"Controller type" group. The setpoint and process value will be displayed in this unit.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 
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PID_Compact does not work with negative proportional gain. Select the check box "Invert 
control logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Start-up behavior after reset
To change straight to the last active mode after restarting the CPU, select the "Enable last 
mode after CPU restart" check box.

PID_Compact will remain in "Inactive" mode if the check box is cleared.

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_Compact will scale the value of the analog input to the physical quantity if you use the 
analog input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:

Using technology functions
11.1 PID control

WinCC Professional V13.0
System Manual, 02/2014 7753



1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Output value
PID_Compact offers three output values. Your actuator will determine which output value you 
use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output
The output value needs to be processed by the user program, for example because of 
nonlinear actuator response.

● Output_PWM
The actuator is controlled via a digital output. Pulse width modulation creates minimum ON 
and minimum OFF times.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output_PER (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to process the output value using the user program:

1. Select the entry "Output" in the drop-down list "Output".

2. Select "Instance DB".
The calculated output value is saved in the instance data block.

3. For the preparation of the output value, use the output parameter Output.

4. Transfer the processed output value to the actuator via a digital or analog CPU output.

Proceed as follows to use the digital output value:

1. Select the entry "Output_PWM" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the digital output.

Process value settings
Configure the scaling of your process value and specify the process value absolute limits In 
the "Process value settings" configuration window.
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Scaling the process value
If you have configured the use of Input_PER in the basic settings, you will need to convert the 
value of the analog input into the physical quantity of the process value. The current 
configuration will be displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

1. Enter the low pair of values in the "Scaled low process value" and "Low" input fields.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.

Default settings for the value pairs are saved in the hardware configuration. Proceed as follows 
to use the value pairs from the hardware configuration:

1. Select the instruction PID_Compact in the programming editor.

2. Connect Input_PER with an analog input in the basic settings.

3. Click on the "Automatic setting" button in the process value settings.

The existing values will be overwritten with the values from the hardware configuration.

Monitoring process value
Specify the absolute high and low limit of the process value. As soon as these limits are violated 
during operation, the controller switches off and the output value is set to 0%. You must enter 
reasonable limits for your controlled system. Reasonable limits are important during 
optimization to obtain optimal PID parameters. 

The default for the "High limit process value" is 120 %. At the I/O input, the process value can 
be a maximum of 18% higher than the standard range (overrange). An error is no longer 
reported for a violation of the "High limit process value". Only a wire-break and a short-circuit 
are recognized and the PID_Compact switches to "Inactive" mode.

 

 WARNING

If you set very high process value limits (for example -3.4*1038...+3.4*1038), process value 
monitoring will be disabled. Your system may then be damaged if an error occurs. 

 

See also
Monitoring process value (Page 7758)

PWM limits (Page 7758)

Output value limits (Page 7760)

PID parameters (Page 7761)
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Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_Compact instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98° C; warning high limit = 90° C 

Warning low limit = 10° C; process value low limit = 0° C

PID_Compact will respond as follows:

Process value InputWarning_H InputWarning_L Operating mode
> 98° C TRUE FALSE Inactive
≤ 98° C and > 90° C TRUE FALSE Automatic mode
≤ 90° C and ≥ 10° C FALSE FALSE Automatic mode
< 10° C and ≥ 0° C FALSE TRUE Automatic mode
< 0° C FALSE TRUE Inactive

See also
Process value settings (Page 7754)

PWM limits (Page 7758)

Output value limits (Page 7760)

PID parameters (Page 7761)

PWM limits
The value at the output parameter Output is transformed into a pulse sequence that is output 
at output parameter Output_PWM by means of a pulse width modulation. Output is calculated 
in the PID algorithm sampling time, Output_PWM is output in the PID_Compact sampling time. 

The PID algorithm sampling time is determined during pretuning or fine tuning. If manually 
setting the PID parameters, you will also need to configure the PID algorithm sampling time. 
The PID_Compact sampling time is equivalent to the cycle time of the calling OB.

The pulse duration is proportional to the value at Output and is always an integer multiple of 
the PID_Compact sampling time. 
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① PID_Compact sampling time
② PID algorithm sampling time 
③ Pulse duration
④ Break time

The "Minimum ON time" and the "Minimum OFF time" are rounded to an integer multiple of 
the PID_Compact sampling time. 

A pulse or a break is never shorter than the minimum ON or OFF time. The inaccuracies this 
causes are added up and compensated in the next cycle.

Example

PID_Compact sampling time = 100 ms

PID algorithm sampling time = 1000 ms

Minimum ON time = 200 ms

Output is a constant 15%. The smallest pulse that PID_Compact can output is 20%. In the first 
cycle, no pulse is output. In the second cycle, the pulse not output in the first cycle is added 
to the pulse of the second cycle. 
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① PID_Compact sampling time
② PID algorithm sampling time 
⑤ Minimum ON time

In order to minimize operation frequency and conserve the actuator, extend the minimum ON 
and OFF times.

If you are using "Output" or "Output_PER", you must configure the value 0.0 for the minimum 
ON and OFF times.

 

 Note

The minimum ON and OFF times only affect the output parameter Output_PWM and are not 
used for any pulse generators integrated in the CPU.

 

See also
Process value settings (Page 7754)

Monitoring process value (Page 7756)

Output value limits (Page 7760)

PID parameters (Page 7761)

Output value limits
In the "Output value limits" configuration window, configure the absolute limits of your output 
value in percent. Absolute output value limits are not violated in neither manual mode nor in 
automatic mode. If a output value outside the limits is specified in manual mode, the effective 
value is limited in the CPU to the configured limits.

The valid output value limit values depend on the Output used.
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Output -100.0 to 100.0
Output_PER -100.0 to 100.0
Output_PWM 0.0 to 100.0

PID_Compact sets the output value to 0.0 if an error occurs. 0.0 must therefore always be 
within the output value limits. You will need to add an offset to Output and Output_PER in the 
user program if you want an output value low limit of greater than 0.0.

See also
Process value settings (Page 7754)

Monitoring process value (Page 7756)

PWM limits (Page 7756)

PID parameters (Page 7761)

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.

The PID algorithm operates according to the following equation:

y  =  K
p 
 (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
y Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint 
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:
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All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_Compact. 

Auto-Hotspot

Proportional gain
The value specifies the proportional gain of the controller. PID_Compact does not work with 
a negative proportional gain. Control logic is inverted under Basic settings > Controller type.

Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.
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Proportional action weighting
The proportional action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the cycle time. All other functions of 
PID_Compact are executed at every call.

If you use Output_PWM, the accuracy of the output signal is determined by the ratio of the PID 
algorithm sampling time to the cycle time of the OB. The PID algorithm sampling time 
corresponds to the time period of the pulse width modulation. The cycle time should be at least 
10 times the PID algorithm sampling time.

Rule for tuning
Select whether PI or PID parameters are to be calculated in the "Controller structure" drop-
down list.

● PID
Calculates PID parameters during pretuning and fine tuning.

● PI
Calculates PI parameters during pretuning and fine tuning.

● User-defined
The drop-down list displays "User-defined" if you have configured different controller 
structures for pretuning and fine tuning via a user program. 

See also
Downloading technology objects to device (Page 7713)

Using technology functions
11.1 PID control

WinCC Professional V13.0
System Manual, 02/2014 7761



Commissioning PID_Compact V1

Commissioning
The commissioning window helps you commission the PID controller. You can monitor the 
values for the setpoint, process value and output value along the time axis in the trend view. 
The following functions are supported in the commissioning window:

● Controller pretuning

● Controller fine tuning
Use fine tuning for fine adjustments to the PID parameters.

● Monitoring the current closed-loop control in the trend view

● Testing the controlled system by specifying a manual output value

All functions require an online connection to the CPU to have been established.

Basic handling
● Select the desired sampling time in the "Sampling time" drop-down list.

All values in the commissioning window are updated in the selected update time.

● Click the "Start" icon in the measuring group if you want to use the commissioning functions.
Value recording is started. The current values for the setpoint, process value and output 
value are entered in the trend view. Operation of the commissioning window is enabled.

● Click the "Stop" icon if you want to end the commissioning functions.
The values recorded in the trend view can continue to be analyzed.

Closing the commissioning window will terminate recording in the trend view and delete the 
recorded values.

See also
Pretuning (Page 7764)

Fine tuning (Page 7766)

"Manual" mode (Page 7767)

Pretuning
The pretuning determines the process response to a jump change of the output value and 
searches for the point of inflection. The tuned PID parameters are calculated as a function of 
the maximum slope and dead time of the controlled system.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. The PID parameters 
are backed up before being recalculated. 
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Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● PID_Compact is in "inactive" or "manual" mode.

● The setpoint may not be changed during controller tuning. PID_Compact will otherwise be 
deactivated.

● The setpoint and the process value lie within the configured limits (see "Process value 
monitoring" configuration).

● The difference between setpoint and process value is greater than 30% of the difference 
between process value high limit and process value low limit.

● The distance between the setpoint and the process value is > 50% of the setpoint.

Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_Compact > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list.

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it is to be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_Compact switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_Compact will change to "Inactive" mode. 

See also
Parameters State and sRet.i_Mode V1 (Page 3038)

Commissioning (Page 7762)
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Fine tuning (Page 7766)

"Manual" mode (Page 7767)

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are optimized for the operating point from the amplitude and frequency of this oscillation. All 
PID parameters are recalculated on the basis of the findings. PID parameters from fine tuning 
usually have better master control and disturbance behavior than PID parameters from 
pretuning.

PID_Compact automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

Requirement
● The PID_Compact instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● The setpoint and the process value lie within the configured limits (see "Process value 
monitoring" configuration).

● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● The setpoint may not be changed during controller tuning.

● PID_Compact is in inactive mode, automatic mode or manual mode.

Process depends on initial situation
Fine tuning can be started in "inactive", "automatic" or "manual" mode. Fine tuning proceeds 
as follows when started in:

● Automatic mode
Start fine tuning in automatic mode if you wish to improve the existing PID parameters using 
controller tuning.
PID_Comact will regulate using the existing PID parameters until the control loop has 
stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start. 

● Inactive or manual mode
If the requirements for pretuning are met, pretuning is started. The PID parameters 
established will be used for adjustment until the control loop has stabilized and the 
requirements for fine tuning have been met. Only then will fine tuning start. If pretuning is 
not possible, PID_Compact will change to "Inactive" mode.
An attempt is made to reach the setpoint with a minimum or maximum output value if the 
process value for pretuning is already too near the setpoint. This can produce increased 
overshoot. 
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Procedure
Proceed as follows to carry out "fine tuning":

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 100% 
and it is to be assumed the controller tuning function is blocked. Check the configuration 
of the technology object and, if necessary, restart controller tuning.

 

Result
The PID parameters will have been optimized if fine tuning has been executed without errors. 
PID_Compact changes to automatic mode and uses the optimized parameters. The optimized 
PID parameters will be retained during power OFF and a restart of the CPU. 

If errors occurred during "fine tuning", PID_Compact will change to "inactive" mode.

See also
Parameters State and sRet.i_Mode V1 (Page 3038)

Commissioning (Page 7762)

Pretuning (Page 7762)

"Manual" mode (Page 7767)

"Manual" mode
The following section describes how you can use the "Manual" operating mode in the 
commissioning window of the "PID Compact" technology object.

Requirement
● The "PID_Compact" instruction is called in a cyclic interrupt OB.

● An online connection to the CPU has been established and the CPU is in the "RUN" mode.

● The functions of the commissioning window have been enabled via the "Start" icon.
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Procedure
Use "Manual mode" in the commissioning window if you want to test the process by specifying 
a manual value. To define a manual value, proceed as follows:

1. Select the check box "Manual mode" in the "Online status of the controller" area.
PID_Compact operates in manual mode. The most recent current output value remains in 
effect.

2. Enter the manual value in the "Output" field as a % value.

3. Click the control icon .

Result
The manual value is written to the CPU and immediately goes into effect.

 

 Note

PID_Compact continues to monitor the process value. If the process value limits are 
exceeded, PID_Compact is deactivated.

 

Clear the "Manual mode" check box if the output value is to be specified again by the PID 
controller. The change to automatic mode is bumpless.

See also
Parameters State and sRet.i_Mode V1 (Page 3038)

Commissioning (Page 7762)

Pretuning (Page 7762)

Fine tuning (Page 7764)

11.1.4 Using PID_3Step

11.1.4.1 Technology object PID_3Step
The technology object PID_3Step provides a PID controller with tuning for valves or actuators 
with integral response.   

You can configure the following controllers:

● Three-point step controller with position feedback

● Three-point step controller without position feedback

● Valve controller with analog output value

PID_3Step continuously acquires the measured process value within a control loop and 
compares it with the setpoint. From the resulting control deviation, PID_3Step calculates an 
output value through which the process value reaches the setpoint as quickly and steadily as 
possible. The output value for the PID controller consists of three actions:
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● P action
The proportional action of the output value increases in proportion to the control deviation.

● I action
The integral action of the output value increases until the control deviation has been 
balanced. 

● D action
The derivative action increases with the rate of change of control deviation. The process 
value is corrected to the setpoint as quickly as possible. The derivative action will be 
reduced again if the rate of change of control deviation drops.

The instruction PID_3Step calculates the proportional, integral and derivative parameters for 
your controlled system during pretuning. Fine tuning can be used to tune the parameters 
further. You do not need to manually determine the parameters.

Additional information
● Overview of software controller (Page 7708) 

● Add technology objects (Page 7710) 

● Configure technology objects (Page 7711) 

● Configuring PID_3Step V2 (Page 7769) 

● Configuring PID_3Step V1 (Page 7786) 

11.1.4.2 PID_3Step V2

Configuring PID_3Step V2

Basic settings

Introduction
Configure the following properties of the "PID_3Step" technology object under "Basic settings" 
in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

● Position feedback (only in the Inspector window)
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Setpoint, process value, output value and position feedback
You can only configure the setpoint, process value, output value and position feedback in the 
Inspector window of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the physical quantity and unit of measurement for setpoint, process value, and 
disturbance variable in the "Controller type" group. Setpoint, process value, and disturbance 
variable is displayed in this unit of measurement.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 

PID_3Step does not work with negative proportional gain. Select the check box "Invert control 
logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Startup characteristics
1. To switch to "Inactive" mode after CPU restart, clear the "Activate Mode after CPU restart" 

check box.
To switch to the operating mode saved in the Mode parameter after CPU restart, select the 
"Activate Mode after CPU restart" check box. 

2. In the "Set Mode to" drop-down list, select the mode that is to be enabled after a complete 
download to the device.
After a complete download to the device, PID_3Step starts in the selected operating mode. 
With each additional restart, PID_3Step starts in the mode that was last saved in Mode.

Example

You have selected the "Activate Mode after CPU restart" check box and the entry "Pretuning" 
in the "Set Mode to" list. After a complete download to the device, PID_3Step starts in the 
"Pretuning" mode. If pretuning is still active, PID_3Step starts in "Pretuning" mode again after 
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restart of the CPU. If pretuning was successfully completed and automatic mode is active, 
PID_3Step starts in "Automatic mode" after restart of the CPU.  

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_3Step will scale the value of the analog input to the physical quantity if you use the analog 
input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:

1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Position feedback
Position feedback configuration depends upon the actuator used.

● Actuator without position feedback

● Actuator with digital endstop signals
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● Actuator with analog position feedback

● Actuator with analog position feedback and endstop signals

Actuator without position feedback 
Proceed as follows to configure PID_3Step for an actuator without position feedback:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

Actuator with digital endstop signals 
Proceed as follows to configure PID_3Step for an actuator with endstop signals:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

2. Activate the "Actuator endstop signals" check box.

3. Select "Instruction" as source for Actuator_H and Actuator_L.

4. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.

Actuator with analog position feedback 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

– Use the analog input value for Feedback_PER. Configure Feedback_PER scaling in the 
actuator settings.

– Process the analog input value for Feedback using your user program.

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

Actuator with analog position feedback and endstop signals 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback and 
endstop signals:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

4. Activate the "Actuator endstop signals" check box.

5. Select "Instruction" as source for Actuator_H and Actuator_L.

6. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.
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Output value
PID_3Step offers an analog output value (Output_PER) and digital output values (Output_UP, 
Output_DN). Your actuator will determine which output value you use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output_UP, Output_DN
The actuator is controlled via two digital outputs.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to use the digital output value:

1. Select the entry "Output (digital)" in the drop-down list "Output".

2. Select "Instruction" for Output_UP and Output_DN.

3. Enter the addresses of the digital outputs.

Proceed as follows to process the output value using the user program:

1. Select the entry corresponding to the actuator in the drop-down list "Output".

2. Select "Instruction".

3. Enter the name of the variable you are using to process the output value.

4. Transfer the processed output value to the actuator by means of an analog or digital CPU 
output.

Process value settings

Scaling the process value
If you have configured the use of Input_PER in the basic setting, you must convert the value 
of the analog input to the physical quantity of the process value. The current configuration is 
displayed in the Input_PER display. 

Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

Procedure
To scale the process value, follow these steps:

1. Enter the low pair of values in the "Scaled low process value" and "Low" text boxs.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.
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Default settings for the value pairs are stored in the hardware configuration. To use the value 
pairs from the hardware configuration, follow these steps:

1. Select the PID_3Step instruction in the programming editor.

2. Interconnect Input_PER with an analog input in the basic settings.

3. Click the "Automatic setting" button in the process value settings.

The existing values will be overwritten with the values from the hardware configuration.

Process value limits
You must specify an appropriate absolute high limit and low limit for the process value as limit 
values for your controlled system. As soon as the process value violates these limits, an error 
occurs (ErrorBits = 0001h). Tuning is canceled when the process value limits are violated. You 
can specify how PID_3Step responds to errors in automatic mode in the actuator settings.

Actuator settings

Actuator

Actuator-specific times
Configure the motor transition time and the minimum ON and OFF times to prevent damage 
to the actuator. You can find the specifications in the actuator data sheet.

The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. You can measure the motor transition time during 
commissioning.

The motor transition time is retentive. If you enter the motor transition time manually, you must 
completely download PID_3Step. 

Downloading technology objects to device (Page 7713)

If you are using "Output_UP" or "Output_DN", you can reduce the switching frequency with 
the minimum on and minimum OFF time.

The on or off times calculated are totaled in automatic mode and only become effective when 
the sum is greater than or equal to the minimum on or OFF time.

Manual_UP = TRUE or Manual_DN = TRUE in manual mode operates the actuator for at least 
the minimum ON or OFF time.

Reaction to error
PID_3Step is preset so that the controller stays active in most cases in the event of an error. 
If errors occur frequently in controller mode, this default reaction has a negative effect on the 
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control response. In this case, check the Errorbits parameter and eliminate the cause of the 
error.

 

 NOTICE

Your system may be damaged.

If you output "Current value while error pending" or "Substitute output value while error 
pending" in the event of an error, PID_3Step remains in automatic mode even if the process 
value limits are violated. This may damage your system. 

It is essential to configure how your controlled system reacts in the event of an error to protect 
your system from damage. 

 

PID_3Step generates a programmable output value in response to an error:

● Current value
PID_3Step is switched off and no longer modifies the actuator position.

● Current value for error while error is pending
The controller functions of PID_3Step are switched off and the position of the actuator is 
no longer changed.
If the following errors occur in automatic mode, PID_3Step returns to automatic mode as 
soon as the errors are no longer pending.

– 0002h: Invalid value at Input_PER parameter.

– 0200h: Invalid value at Input parameter.

– 0400h: Calculation of output value failed.

– 1000h: Invalid value at Setpoint parameter.

– 2000h: Invalid value at Feedback_PER parameter.

– 4000h: Invalid value at Feedback parameter.

– 8000h: Error during digital position feedback.

– 20000h: Invalid value at SavePosition tag.

If one or more of the following errors occur, PID_3Step stays in 
automatic mode:

– 0001h: The Input parameter is outside the process value limits.

– 0800h: Sampling time error

– 40000h: Invalid value at Disturbance parameter.

PID_3Step remains in manual mode if an error occurs in manual mode.
If an error occurs during tuning or transition time measurement, PID_3Step switches to the 
mode in which tuning or transition time measurement was started. Only in the event of the 
following error is tuning not aborted:

– 0020h: Pretuning is not permitted during fine tuning.
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● Substitute output value
PID_3Step moves the actuator to the substitute output value and then switches off.

● Substitute output value while error is pending
PID_3Step moves the actuator to the substitute output value. When the substitute output 
value is reached, PID_3Step reacts as it does with "Current value for while error is pending". 

Enter the substitute output value in "%". 

Only substitute output values 0% and 100% can be approached precisely in the case of 
actuators without analog position feedback.  A substitute output value not equal to 0% or 100% 
is approached via an internally simulated position feedback. This procedure does not, however, 
allow the exact approach of substitute output value. 

All substitute output values can be approached precisely with actuators with analog position 
feedback.

Scaling position feedback

Scaling position feedback
If you have configured the use of Feedback_PER in the basic settings, you will need to convert 
the value of the analog input into %. The current configuration will be displayed in the 
"Feedback" display. 

Feedback_PER is scaled using a low and high value pair.

1. Enter the low pair of values in the "Low endstop" and "Low" input boxes.

2. Enter the high pair of values in the "High endstop" and "High" input boxes.

"Low endstop" must be less than "High endstop"; "Low" must be less than "High".

The valid values for "High endstop" and "Low endstop" depend upon:

● No Feedback, Feedback, Feedback_PER

● Output (analog), Output (digital)

Output Feedback Low endstop High endstop
Output (digital) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (digital) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (digital) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%
Output (analog) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (analog) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (analog) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%

Output value limits

Limiting the output value
You can exceed or undershoot the output value limits during the transition time measurement 
and with mode = 10. The output value is limited to these values in all other modes. 
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Enter the absolute output value limits in the "Output value high limit" and "Output value low 
limit" input boxes. The output value limits must be within "Low endstop" and "High endstop".

If no Feedback is available and Output (digital) is set, you cannot limit the output value. 
Output_UP and Output_DN are then reset upon Actuator_H = TRUE or Actuator_L = TRUE. 
If no endstop signals are available, Output_UP and Output_DN are reset after a travel time of 
150% of the motor actuating time.

Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_3Step instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98° C; warning high limit = 90° C 

Warning low limit = 10° C; process value low limit = 0° C

PID_3Step will respond as follows:

Process value InputWarnin
g_H 

InputWarnin
g_L

ErrorBi
ts

Operating mode

> 98° C TRUE FALSE 0001h As configured
≤ 98° C and > 90° C TRUE FALSE 0000h Automatic mode
≤ 90° C and ≥ 10° C FALSE FALSE 0000h Automatic mode
< 10° C and ≥ 0° C FALSE TRUE 0000h Automatic mode
< 0° C FALSE TRUE 0001h As configured

In the actuator settings, you can configure the response of PID_3Step when the process value 
high limit or low limit is violated.

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.

The PID algorithm operates according to the following equation:
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Symbol Description
Δy Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:

All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_3Step. 

Downloading technology objects to device (Page 7713) 

Proportional gain
The value specifies the proportional gain of the controller. PID_3Step does not work with a 
negative proportional gain. Control logic is inverted under Basic settings > Controller type.
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Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.

Proportional action weighting
The proportional action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the PID_3Step sampling time. All other 
functions of PID_3Step are executed at every call.
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Deadband width
The deadband suppresses the noise component in the steady controller state. The deadband 
width specifies the size of the deadband. The deadband is off if the deadband width is 0.0.

Commissioning PID_3Step V2

Pretuning
The pretuning determines the process response to a pulse of the output value and searches 
for the point of inflection. The tuned PID parameters are calculated as a function of the 
maximum slope and dead time of the controlled system. You obtain the best PID parameters 
when you perform pretuning and fine tuning.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. This is most likely 
the case in operating modes "Inactive" and "manual mode". The PID parameters are backed 
up before being recalculated.

The setpoint is frozen during pretuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● The motor transition time has been configured or measured.

● PID_3Step is in one of the following modes: "Inactive", "Manual mode", or "Automatic mode".

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).
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Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_3Step > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list in the working area 
"Tuning".

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it is to be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_3Step switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_3Step responds with the configured reaction to errors. 

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are tuned for the operating point from the amplitude and frequency of this oscillation. All PID 
parameters are recalculated from the results. PID parameters from fine tuning usually have 
better master control and disturbance characteristics than PID parameters from pretuning. You 
obtain the best PID parameters when you perform pretuning and fine tuning.

PID_3Step automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

The setpoint is frozen during fine tuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● The motor transition time has been configured or measured.
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● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).

● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● PID_3Step is in inactive mode, automatic mode or manual mode.

Process depends on initial situation
Fine tuning proceeds as follows when started from:

● Automatic mode
Start fine tuning from automatic mode if you wish to improve the existing PID parameters 
through tuning.
PID_3Step controls the system using the existing PID parameters until the control loop has 
stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start.

● Inactive or manual mode
Pretuning is always started first. The determined PID parameters will be used for control 
until the control loop has stabilized and the requirements for fine tuning have been met. 
Only then will fine tuning start.

Procedure
To perform fine tuning, follow these steps:

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 100% 
and it is to be assumed the controller tuning function is blocked. Check the configuration 
of the technology object and, if necessary, restart controller tuning.

 

Result
If no errors occurred during fine tuning, the PID parameters have been tuned. PID_3Step 
switches to automatic mode and uses the tuned parameters. The tuned PID parameters will 
be retained during power OFF and a restart of the CPU. 
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If errors occurred during fine tuning, PID_3Step responds with the configured response to 
errors. 

Commissioning with manual PID parameters

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● Reset = FALSE

● The motor transition time has been configured or measured.

● PID_3Step is in "inactive" mode.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).

 

Procedure
Proceed as follows to commission PID_3Step with manual PID parameters:

1. Double-click on "PID_3Step > Configuration" in the project tree.

2. Click on "Advanced settings > PID Parameters" in the configuration window.

3. Select the check box "Enable direct input".

4. Enter the PID parameters.

5. Double-click the "PID_3Step > Commissioning" entry in the project tree.

6. Establish an online connection to the CPU.

7. Load the PID parameters to the CPU.

8. Click the "Start PID_3Step" icon.

Result
PID_3Step changes to automatic mode and controls using the current PID parameters.

See also
PID parameters (Page 7775)

Using technology functions
11.1 PID control

WinCC Professional V13.0
System Manual, 02/2014 7781



Measuring the motor transition time

Introduction
PID_3Step requires the motor transition time to be as accurate as possible for good controller 
results. The data in the actuator documentation contains average values for this type of 
actuator. The value for the specific actuator used may differ.

You can measure the motor transition time during commissioning if you are using actuators 
with position feedback or endstop signals. The output value limits are not taken into 
consideration during the motor transition time measurement. The actuator can travel to the 
high or the low endstop.

The motor transition time cannot be measured if neither position feedback nor endstop signals 
are available.

Actuators with analog position feedback
Proceed as follows to measure motor transition time with position feedback:

Requirement

● Feedback or Feedback_PER has been selected in the basic settings and the signal has 
been connected.

● An online connection to the CPU has been established.

1. Select the "Use position feedback" check box.

2. Enter the position to which the actuator is to be moved in the "Target position" input field.
The current position feedback (starting position) will be displayed. The difference between 
"Target position" and "Position feedback" must be at least 50% of the valid output value 
range.

3. Click the "Start" icon.

Result
The actuator is moved from the starting position to the target position. Time measurement 
starts immediately and ends when the actuator reaches the target position. The motor transition 
time is calculated according to the following equation:

Motor transition time = (output value high limit – output value low limit) × Measuring time / 
AMOUNT (target position – starting position).

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. When the transition time measurement is ended and 
ActivateRecoverMode = TRUE, PID_3Step switches to the operating mode from which the 
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transition time measurement was started. If the transition time measurement is ended and 
ActivateRecoverMode = FALSE, PID_3Step changes to "Inactive" mode.

 

 Note

Click on the icon  "Upload measured transition time" to load the motor transition time 
measured to the project.

 

Actuators with endstop signals
Proceed as follows to measure the transition time of actuators with endstop signals:

Requirement

● The "Endstop signals" check box in the basic settings has been selected and Actuator_H 
and Actuator_L are connected.

● An online connection to the CPU has been established.

Proceed as follows to measure motor transition time with endstop signals:

1. Select the "Use actuator endstop signals" check box.

2. Select the direction in which the actuator is to be moved.

– Open - Close - Open
The actuator is moved first to the high endstop, then to the low endstop and then back 
to the high endstop.

– Close - Open - Close
The actuator is moved first to the low endstop, then to the high endstop and then back 
to the low endstop.

3. Click the "Start" icon.

Result
The actuator is moved in the selected direction. Time measurement will start once the actuator 
has reached the first endstop and will end when the actuator reaches this endstop for the 
second time. The motor transition time is equal to the time measured divided by two.

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. When the transition time measurement is ended and 
ActivateRecoverMode = TRUE, PID_3Step switches to the operating mode from which the 
transition time measurement was started. If the transition time measurement is ended and 
ActivateRecoverMode = FALSE, PID_3Step changes to "Inactive" mode.

Cancelling transition time measurement
PID_3Step switches to "Inactive" mode if you cancel transition time measurement by pressing 
the Stop button.

Using technology functions
11.1 PID control

WinCC Professional V13.0
System Manual, 02/2014 7783



11.1.4.3 PID_3Step V1

Configuring PID_3Step V1

Basic settings

Introduction
Configure the following properties of the "PID_3Step" technology object under "Basic settings" 
in the Inspector window or in the configuration window:

● Physical quantity

● Control logic

● Start-up behavior after reset

● Setpoint (only in the Inspector window)

● Process value (only in the Inspector window)

● Output value (only in the Inspector window)

● Position feedback (only in the Inspector window)

Setpoint, process value, output value and position feedback
You can only configure the setpoint, process value, output value and position feedback in the 
Inspector window of the programming editor. Select the source for each value:

● Instance DB
The value saved in the instance DB is used.
Value must be updated in the instance DB by the user program.
There should be no value at the instruction.
Change via HMI possible.

● Instruction
The value connected to the instruction is used. 
The value is written to the instance DB each time the instruction is called.
No change via HMI possible.

Controller type

Physical quantity
Select the unit of measurement and physical quantity for the setpoint and process value in the 
"Controller type" group. The setpoint and process value will be displayed in this unit.

Control logic
An increase of the output value is generally intended to cause an increase in the process value. 
This is referred to as a normal control logic. 
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PID_3Step does not work with negative proportional gain. Select the check box "Invert control 
logic" to reduce the process value with a higher output value.

Examples

● Opening the drain valve will reduce the level of a container's contents.

● Increasing cooling will reduce the temperature.

Start-up behavior after reset
To change straight to the last active mode after restarting the CPU, select the "Enable last 
mode after CPU restart" check box.

PID_3Step will remain in "Inactive" mode if the check box is cleared.

Setpoint

Procedure
Proceed as follows to define a fixed setpoint:

1. Select "Instance DB".

2. Enter a setpoint, e.g. 80° C.

3. Delete any entry in the instruction.

Proceed as follows to define a variable setpoint:

1. Select "Instruction".

2. Enter the name of the REAL variable in which the setpoint is saved.
Program-controlled assignment of various values to the REAL variable is possible, for 
example for the time controlled change of the setpoint.

Process value
PID_3Step will scale the value of the analog input to the physical quantity if you use the analog 
input value directly.

You will need to write a program for processing if you wish first to process the analog input 
value. The process value is, for example, not directly proportional to the value at the analog 
input. The processed process value must be in floating point format. 

Procedure
Proceed as follows to use the analog input value without processing:

1. Select the entry "Input_PER" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the address of the analog input.

Proceed as follows to use the processed process value in floating point format:
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1. Select the entry "Input" in the drop-down list "Input".

2. Select "Instruction" as source.

3. Enter the name of the variable in which the processed process value is saved.

Position feedback
Position feedback configuration depends upon the actuator used.

● Actuator without position feedback

● Actuator with digital endstop signals

● Actuator with analog position feedback

● Actuator with analog position feedback and endstop signals

Actuator without position feedback 
Proceed as follows to configure PID_3Step for an actuator without position feedback:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

Actuator with digital endstop signals 
Proceed as follows to configure PID_3Step for an actuator with endstop signals:

1. Select the entry "No Feedback" in the drop-down list "Feedback".

2. Activate the "Actuator endstop signals" check box.

3. Select "Instruction" as source for Actuator_H and Actuator_L.

4. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.

Actuator with analog position feedback 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

– Use the analog input value for Feedback_PER. Configure Feedback_PER scaling in the 
actuator settings.

– Process the analog input value for Feedback using your user program.

2. Select "Instruction" as source.

3. Enter the address of the analog input or the variable of your user program.

Actuator with analog position feedback and endstop signals 
Proceed as follows to configure PID_3Step for an actuator with analog position feedback and 
endstop signals:

1. Select the entry "Feedback" or "Feedback_PER" in the drop-down list "Feedback".

2. Select "Instruction" as source.
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3. Enter the address of the analog input or the variable of your user program.

4. Activate the "Actuator endstop signals" check box.

5. Select "Instruction" as source for Actuator_H and Actuator_L.

6. Enter the addresses of the digital inputs for Actuator_H and Actuator_L.

Output value
PID_3Step offers an analog output value (Output_PER) and digital output values (Output_UP, 
Output_DN). Your actuator will determine which output value you use.

● Output_PER
The actuator is triggered via an analog output and controlled with a continuous signal, e.g. 
0...10V, 4...20mA.

● Output_UP, Output_DN
The actuator is controlled via two digital outputs.

Procedure
Proceed as follows to use the analog output value:

1. Select the entry "Output (analog)" in the drop-down list "Output".

2. Select "Instruction".

3. Enter the address of the analog output.

Proceed as follows to use the digital output value:

1. Select the entry "Output (digital)" in the drop-down list "Output".

2. Select "Instruction" for Output_UP and Output_DN.

3. Enter the addresses of the digital outputs.

Proceed as follows to process the output value using the user program:

1. Select the entry corresponding to the actuator in the drop-down list "Output".

2. Select "Instruction".

3. Enter the name of the variable you are using to process the output value.

4. Transfer the processed output value to the actuator by means of an analog or digital CPU 
output.

Process value settings
Configure the scaling of your process value and specify the process value absolute limits In 
the "Process value settings" configuration window.

Scaling the process value
If you have configured the use of Input_PER in the basic settings, you will need to convert the 
value of the analog input into the physical quantity of the process value. The current 
configuration will be displayed in the Input_PER display. 
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Input_PER will be scaled using a low and high value pair if the process value is directly 
proportional to the value of the analog input.

1. Enter the low pair of values in the "Scaled low process value" and "Low" input fields.

2. Enter the high pair of values in the "Scaled high process value" and "High" input boxes.

Default settings for the value pairs are saved in the hardware configuration. Proceed as follows 
to use the value pairs from the hardware configuration:

1. Select the instruction PID_3Step in the programming editor.

2. Connect Input_PER to an analog input in the basic settings.

3. Click on the "Automatic setting" button in the process value settings.
The existing values will be overwritten with the values from the hardware configuration.

Monitoring process value
Specify the absolute high and low limit of the process value. You must enter reasonable limits 
for your controlled system. Reasonable limits are important during optimization to obtain 
optimal PID parameters. The default for the "High limit process value" is 120 %. At the I/O 
input, the process value can be a maximum of 18% higher than the standard range (overrange). 
This setting ensures that an error is no longer signaled due to a violation of the "Process value 
high limit". Only a wire-break and a short-circuit are recognized and PID_3Step reacts 
according to the configured reaction to error.

 

 NOTICE

Your system may be damaged.

If you set very high process value limits (for example -3.4*1038...+3.4*1038), process value 
monitoring will be disabled. Your system may then be damaged if an error occurs. You need 
to configure useful process value limits for your controlled system.

 

Actuator settings

Actuator-specific times
Configure the motor transition time and the minimum ON and OFF times to prevent damage 
to the actuator. You can find the specifications in the actuator data sheet.

The motor transition time is the time in seconds the motor requires to move the actuator from 
the closed to the opened state. The maximum time that the actuator is moved in one direction 
is 110% of the motor transition time. You can measure the motor transition time during 
commissioning.

If you are using "Output_UP" or "Output_DN", you can reduce the switching frequency with 
the minimum on and minimum OFF time.

The on or off times calculated are totaled in automatic mode and only become effective when 
the sum is greater than or equal to the minimum on or OFF time.

A rising edge at Manual_UP or Manual_DN in manual mode will operate the actuator for at 
least the minimum on or OFF time.
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Reaction to error
PID_3Step is preset so that the controller stays active in most cases in the event of an error. 
If errors occur frequently in controller mode, this default reaction has a negative effect on the 
control response. In this case, check the Errorbits parameter and eliminate the cause of the 
error.

PID_3Step generates a programmable output value in response to an error:

● Current value
PID_3Step is switched off and no longer modifies the actuator position.

● Current value for error while error is pending
The controller functions of PID_3Step are switched off and the position of the actuator is 
no longer changed.
If the following errors occur in automatic mode, PID_3Step returns to automatic mode as 
soon as the errors are no longer pending.

– 0002h: Invalid value at Input_PER parameter.

– 0200h: Invalid value at Input parameter.

– 0800h: Sampling time error

– 1000h: Invalid value at Setpoint parameter.

– 2000h: Invalid value at Feedback_PER parameter.

– 4000h: Invalid value at Feedback parameter.

– 8000h: Error during digital position feedback.

If one of these error occurs in manual mode, PID_3Step remains in manual mode.
If an error occurs during the tuning or transition time measurement, PID_3Step is switched 
off.

● Substitute output value
PID_3Step moves the actuator to the substitute output value and then switches off.

● Substitute output value while error is pending
PID_3Step moves the actuator to the substitute output value. When the substitute output 
value is reached, PID_3Step reacts as it does with "Current value for while error is pending". 

Enter the substitute output value in "%". 

Only substitute output values 0% and 100% can be approached precisely in the case of 
actuators without analog position feedback. The actuator is moved in one direction at 110% 
of the motor transition time to ensure the high or low endstop is reached. There endstop signals 
take priority. A substitute output value not equal to 0% or 100% is approached via an internally 
simulated position feedback. This procedure does not, however, allow the exact approach of 
substitute output value. 

All substitute output values can be approached precisely with actuators with analog position 
feedback.

Scaling position feedback
If you have configured the use of Feedback_PER in the basic settings, you will need to convert 
the value of the analog input into %. The current configuration will be displayed in the 
"Feedback" display. 
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Feedback_PER is scaled using a low and high value pair.

1. Enter the low pair of values in the "Low endstop" and "Low" input boxes.

2. Enter the high pair of values in the "High endstop" and "High" input boxes.

"Low endstop" must be less than "High endstop"; "Low" must be less than "High".

The valid values for "High endstop" and "Low endstop" depend upon:

● No Feedback, Feedback, Feedback_PER

● Output (analog), Output (digital)

Output Feedback Low endstop High endstop
Output (digital) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (digital) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (digital) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%
Output (analog) No Feedback Cannot be set (0.0%) Cannot be set (100.0%)
Output (analog) Feedback -100.0% or 0.0% 0.0% or +100.0%
Output (analog) Feedback_PER -100.0% or 0.0% 0.0% or +100.0%

Limiting the output value
You can only exceed or undershoot the output value limits during the transition time 
measurement. The output value is limited to these values in all other modes. 

Enter the absolute output value limits in the "Output value high limit" and "Output value low 
limit" input boxes. The output value limits must be within "Low endstop" and "High endstop".

If no Feedback is available and Output (digital) is set, you cannot limit the output value. The 
digital outputs are reset with Actuator_H = TRUE or Actuator_L = TRUE, or after a travel time 
amounting to 110% of the motor transition time.

Advanced settings

Monitoring process value
Configure a warning high and low limit for the process value in the "Process value monitoring" 
configuration window. If one of the warning limits is exceeded or undershot during operation, 
a warning will be displayed at the PID_3Step instruction:

● At the InputWarning_H output parameter if the warning high limit has been exceeded

● At the InputWarning_L output parameter if the warning low limit has been undershot

The warning limits must be within the process value high and low limits. 

The process value high and low limits will be used if you do not enter values.

Example
Process value high limit = 98° C; warning high limit = 90° C 
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Warning low limit = 10° C; process value low limit = 0° C

PID_3Step will respond as follows:

Process value InputWarning_H InputWarning_L Operating mode
> 98° C TRUE FALSE Inactive
≤ 98° C and > 90° C TRUE FALSE Automatic mode
≤ 90° C and ≥ 10° C FALSE FALSE Automatic mode
< 10° C and ≥ 0° C FALSE TRUE Automatic mode
< 0° C FALSE TRUE Inactive

PID parameters
The PID parameters are displayed in the "PID Parameters" configuration window. The PID 
parameters will be adapted to your controlled system during controller tuning. You do not need 
to enter the PID parameters manually.

The PID algorithm operates according to the following equation:

Δ y  =  K
p 
 · s  ·  (w - x) + (c · w - x)[ (b · w - x) +

1

T
I 
 ·

  
s

T
D 

· s

a · T
D
 · s + 1

]

Symbol Description
Δy Output value of the PID algorithm
Kp Proportional gain
s Laplace operator
b Proportional action weighting
w Setpoint
x Process value
TI Integral action time
a Derivative delay coefficient (derivative delay T1 = a × TD)
TD Derivative action time
c Derivative action weighting

The diagram below illustrates the integration of the parameters into the PID algorithm:
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All PID parameters are retentive. If you enter the PID parameters manually, you must 
completely download PID_3Step. 

Auto-Hotspot 

Proportional gain
The value specifies the proportional gain of the controller. PID_3Step does not work with a 
negative proportional gain. Control logic is inverted under Basic settings > Controller type.

Integral action time
The integral action time determines the time behavior of the integral action. The integral action 
is deactivated with integral action time = 0.0.

Derivative action time
The derivative action time determines the time behavior of the derivative action. Derivative 
action is deactivated with derivative action time = 0.0.

Derivative delay coefficient
The derivative delay coefficient delays the effect of the derivative action. 

Derivative delay = derivative action time × derivative delay coefficient

● 0.0: Derivative action is effective for one cycle only and therefore almost not effective.

● 0.5: This value has proved useful in practice for controlled systems with one dominant time 
constant.

● > 1.0: The greater the coefficient, the longer the effect of the derivative action is delayed.

Proportional action weighting
The proportional action may weaken with changes to the setpoint.
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Values from 0.0 to 1.0 are applicable.

● 1.0: Proportional action for setpoint change is fully effective

● 0.0: Proportional action for setpoint change is not effective

The proportional action is always fully effective when the process value is changed.

Derivative action weighting
The derivative action may weaken with changes to the setpoint.

Values from 0.0 to 1.0 are applicable.

● 1.0: Derivative action is fully effective upon setpoint change

● 0.0: Derivative action is not effective upon setpoint change

The derivative action is always fully effective when the process value is changed.

PID algorithm sampling time 
The controlled system needs a certain amount of time to respond to changes in the output 
value. It is therefore not advisable to calculate the output value in every cycle. The sampling 
time of the PID algorithm represents the time between two calculations of the output value. It 
is calculated during tuning and rounded to a multiple of the PID_3Step sampling time. All other 
functions of PID_3Step are executed at every call.

Deadband width
The deadband suppresses the noise component in the steady controller state. The deadband 
width specifies the size of the deadband. The deadband is off if the deadband width is 0.0.

See also
Downloading technology objects to device (Page 7713)

Commissioning PID_3Step V1

Commissioning
You can monitor the setpoint, process value and output value over time in the "Tuning" working 
area. The following commissioning functions are supported in the curve plotter:

● Controller pretuning

● Controller fine tuning

● Monitoring the current closed-loop control in the trend view

All functions require an online connection to the CPU to have been established. 
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Basic handling
● Select the desired sampling time in the "Sampling time" drop-down list.

All values in the tuning working area are updated in the selected update time.

● Click the "Start" icon in the measuring group if you want to use the commissioning functions.
Value recording is started. The current values for the setpoint, process value and output 
value are entered in the trend view. Operation of the commissioning window is enabled.

● Click the "Stop" icon if you want to end the commissioning functions.
The values recorded in the trend view can continue to be analyzed.

● Closing the commissioning window will terminate recording in the trend view and delete 
the recorded values.

Pretuning
The pretuning determines the process response to a pulse of the output value and searches 
for the point of inflection. The tuned PID parameters are calculated as a function of the 
maximum slope and dead time of the controlled system.

The more stable the process value is, the easier it is to calculate the PID parameters and the 
more precise the result will be. Noise on the process value can be tolerated as long as the rate 
of rise of the process value is significantly higher compared to the noise. The PID parameters 
are backed up before being recalculated.

The setpoint is frozen during pretuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● PID_3Step is in "inactive" or "manual" mode.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).
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Procedure
To perform pretuning, follow these steps:

1. Double-click the "PID_3Step > Commissioning" entry in the project tree.

2. Select the entry "Pretuning" in the "Tuning mode" drop-down list in the working area 
"Tuning".

3. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– Pretuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon when the progress bar has reached 100% and it is to be assumed 
the controller tuning function is blocked. Check the configuration of the technology 
object and, if necessary, restart controller tuning.

 

Result
If pretuning was performed without an error message, the PID parameters have been tuned. 
PID_3Step switches to automatic mode and uses the tuned parameters. The tuned PID 
parameters will be retained during power OFF and a restart of the CPU.

If pretuning is not possible, PID_3Step changes to "Inactive" mode. 

Fine tuning
Fine tuning generates a constant, limited oscillation of the process value. The PID parameters 
are optimized for the operating point from the amplitude and frequency of this oscillation. All 
PID parameters are recalculated on the basis of the findings. PID parameters from fine tuning 
usually have better master control and disturbance behavior than PID parameters from 
pretuning.

PID_3Step automatically attempts to generate an oscillation greater than the noise of the 
process value. Fine tuning is only minimally influenced by the stability of the process value. 
The PID parameters are backed up before being recalculated.

The setpoint is frozen during fine tuning. 

Requirement
● The PID_3Step instruction is called in a cyclic interrupt OB.

● ManualEnable = FALSE

● The motor transition time has been configured or measured.

● The setpoint and the process value lie within the configured limits (see "Process value 
settings" configuration).
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● The control loop has stabilized at the operating point. The operating point is reached when 
the process value corresponds to the setpoint.

● No disturbances are expected.

● PID_3Step is in inactive mode, automatic mode or manual mode.

Process depends on initial situation
Fine tuning proceeds as follows when started in:

● Automatic mode
Start fine tuning in automatic mode if you wish to improve the existing PID parameters using 
controller tuning.
PID_3Step will regulate using the existing PID parameters until the control loop has 
stabilized and the requirements for fine tuning have been met. Only then will fine tuning 
start.

● Inactive or manual mode
Pretuning is always started first. The PID parameters established will be used for 
adjustment until the control loop has stabilized and the requirements for fine tuning have 
been met. Only then will fine tuning start.

Procedure
Proceed as follows to carry out "fine tuning":

1. Select the entry "Fine tuning" in the "Tuning mode" drop-down list.

2. Click the "Start" icon.

– An online connection will be established.

– Value recording is started.

– The process of fine tuning is started.

– The "Status" field displays the current steps and any errors that may have occurred. 
The progress bar indicates the progress of the current step.

 

  Note

Click the "Stop" icon in the "Tuning mode" group when the progress bar has reached 
100% and it is to be assumed the controller tuning function is blocked. Check the 
configuration of the technology object and, if necessary, restart controller tuning.

 

Result
The PID parameters will have been optimized if fine tuning has been executed without errors. 
PID_3Step changes to automatic mode and uses the optimized parameters. The optimized 
PID parameters will be retained during power OFF and a restart of the CPU. 

If errors occurred during fine tuning, PID_3Step will change to "inactive" mode.
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Commissioning with manual PID parameters

Procedure
Proceed as follows to commission PID_3Step with manual PID parameters:

1. Double-click on "PID_3Step > Configuration" in the project tree.

2. Click on "Advanced settings > PID Parameters" in the configuration window.

3. Select the check box "Enable direct input".

4. Enter the PID parameters.

5. Double-click on "PID_3Step > Commissioning" in the project tree.

6. Establish an online connection to the CPU.

7. Load the PID parameters to the CPU.

8. Click on the "Activate controller" icon.

Result
PID_3Step changes to automatic mode and controls using the current PID parameters.

Measuring the motor transition time

Introduction
PID_3Step requires the motor transition time to be as accurate as possible for good controller 
results. The data in the actuator documentation contains average values for this type of 
actuator. The value for the specific actuator used may differ.

You can measure the motor transition time during commissioning if you are using actuators 
with position feedback or endstop signals. The output value limits are not taken into 
consideration during the motor transition time measurement. The actuator can travel to the 
high or the low endstop.

The motor transition time cannot be measured if neither position feedback nor endstop signals 
are available.

Actuators with analog position feedback
Proceed as follows to measure motor transition time with position feedback:

Requirement

● Feedback or Feedback_PER has been selected in the basic settings and the signal has 
been connected.

● An online connection to the CPU has been established.
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1. Select the "Use position feedback" check box.

2. Enter the position to which the actuator is to be moved in the "Target position" input field.
The current position feedback (starting position) will be displayed. The difference between 
"Target position" and "Position feedback" must be at least 50% of the valid output value 
range.

3. Click the  "Start transition time measurement" icon.

Result
The actuator is moved from the starting position to the target position. Time measurement 
starts immediately and ends when the actuator reaches the target position. The motor transition 
time is calculated according to the following equation:

Motor transition time = (output value high limit – output value low limit) × Measuring time / 
AMOUNT (target position – starting position).

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. PID_3Step will change to "Inactive" mode once transition time 
measurement is complete.

 

 Note

Click on the icon  "Upload measured transition time" to load the motor transition time 
measured to the project.

 

Actuators with endstop signals
Proceed as follows to measure the transition time of actuators with endstop signals:

Requirement

● The "Endstop signals" check box in the basic settings has been selected and Actuator_H 
and Actuator_L are connected.

● An online connection to the CPU has been established.

Proceed as follows to measure motor transition time with endstop signals:

1. Select the "Use actuator endstop signals" check box.

2. Select the direction in which the actuator is to be moved.

– Open - Close - Open
The actuator is moved first to the high endstop, then to the low endstop and then back 
to the high endstop.

– Close - Open - Close
The actuator is moved first to the low endstop, then to the high endstop and then back 
to the low endstop.

3. Click the  "Start transition time measurement" icon.
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Result
The actuator is moved in the selected direction. Time measurement will start once the actuator 
has reached the first endstop and will end when the actuator reaches this endstop for the 
second time. The motor transition time is equal to the time measured divided by two.

The progress and status of transition time measurement are displayed. The transition time 
measured is saved in the instance data block on the CPU and displayed in the "Measured 
transition time" field. PID_3Step will change to "Inactive" mode once transition time 
measurement is complete.

Cancelling transition time measurement
PID_3Step will change to "Inactive" mode immediately if you cancel transition time 
measurement. The actuator will stop being moved. You can reactive PID-3Step in the curve 
plotter. 

11.2 Using S7-1200 Motion Control

11.2.1 Introduction

11.2.1.1 Motion functionality of the CPU S7-1200
The TIA Portal, together with the "Motion Control" functionality of the CPU S7‑1200, supports 
you in controlling stepper motors and servo motors with pulse interface:

● You configure the positioning axis and command table technology objects in the TIA Portal. 
The CPU S7-1200 uses these technology objects to control the pulse generator outputs 
that control the drives.

● In the user program you control the axis by means of Motion Control instructions and initiate 
motion commands of your drive.

You can find a multi-media introduction on the Internet (http://www.automation.siemens.com/
mcms/topics/en/simatic/simatic-technology/integrated-functions/simatic-s7-1200/Pages/
Default.aspx).

See also
Hardware components for motion control (Page 7802)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

Use of the command table technology object (Page 7851)

Command table technology object tools (Page 7851)
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11.2.1.2 Hardware components for motion control
The representation below shows the basic hardware configuration for a motion control 
application with the CPU S7-1200.  

CPU S7-1200:
CPU S7-1200 combines the functionality of a programmable logic controller with motion control 
functionality for operation of stepper motors and servo motors with pulse interface. The motion 
control functionality takes over the control and monitoring of the drives.    

The DC/DC/DC variants of the CPU S7-1200 have on-board outputs for direct control of drives. 
The relay variants of the CPU require one of the signal boards described below to control a 
drive.

Signal board
You add further inputs and outputs to the CPU with the signal boards. The digital outputs can 
be used as pulse generator outputs for controlling drives as required.

In CPUs with relay outputs, the pulse signal cannot be output on the on-board outputs because 
the relays do not support the necessary switching frequencies. A signal board with digital 
outputs must be used to enable you to work with the PTO (Pulse Train Output) on these CPUs.
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PROFINET
Use the PROFINET interface to establish the online connection between the CPU S7-1200 
and the programming device. In addition to the online functions of the CPU, additional 
commissioning and diagnostic functions are available for motion control.

Ordering information for CPU Firmware V4
The order information listed below applies to the currently installed product phase (without any 
installed Hardware Support Packages) of the TIA Portal.

Name MLFB (order number)
CPU 1211C DC/DC/DC 6ES7211-1AE40-0XB0
CPU 1211C AC/DC/RLY 6ES7211-1BE40-0XB0
CPU 1211C DC/DC/RLY 6ES7211-1HE40-0XB0
CPU 1212C DC/DC/DC 6ES7212-1AE40-0XB0
CPU 1212C AC/DC/RLY 6ES7212-1BE40-0XB0
CPU 1212C DC/DC/RLY 6ES7212-1HE40-0XB0
CPU 1214C DC/DC/DC 6ES7214-1AG40-0XB0
CPU 1214C AC/DC/RLY 6ES7214-1BG40-0XB0
CPU 1214C DC/DC/RLY 6ES7214-1HG40-0XB0
CPU 1214FC DC/DC/DC 6ES7214-1AF40-0XB0
CPU 1214FC DC/DC/RLY 6ES7214-1HF40-0XB0
CPU 1215C DC/DC/DC 6ES7215-1AG40-0XB0
CPU 1215C AC/DC/RLY 6ES7215-1BG40-0XB0
CPU 1215C DC/DC/RLY 6ES7215-1HG40-0XB0
CPU 1215FC DC/DC/DC 6ES7215-1AF40-0XB0
CPU 1215FC DC/DC/RLY 6ES7215-1HF40-0XB0
CPU 1217C DC/DC/DC 6ES7217-1AG40-0XB0
Signal board DI2/DO2 x DC24V 20kHz 6ES7223-0BD30-0XB0
Signal board DI2/DO2 x DC24V 200kHz 6ES7223-3BD30-0XB0
Signal board DO4 x DC24V 200kHz 6ES7222-1BD30-0XB0
Signal board DI2/DO2 x DC5V 200kHz 6ES7223-3AD30-0XB0
Signal board DO4 x DC5V 200kHz 6ES7222-1AD30-0XB0

Use a Hardware Support Package (HSP) to install new hardware components. The hardware 
component will then be available in the hardware catalog.

See also
Motion functionality of the CPU S7-1200 (Page 7799)

CPU outputs relevant for motion control (technology version V4) (Page 7804)
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11.2.2 Basics for working with S7-1200 Motion Control

11.2.2.1 CPU outputs relevant for motion control (technology version V4)
The number of usable drives depends on the number of PTOs (pulse train outputs) and the 
number of available pulse generator outputs.

The following tables provide information about the relevant dependencies:

Maximum number of PTOs
4 PTOs are available for each CPU with technology version V4. This means a maximum of 4 
drives can be controlled.

Signal type of the PTO
Depending on the signal type of the PTO, 1-2 pulse generator outputs are required per PTO 
(drive):

Signal type Number of pulse generator outputs
Pulse A and direction B (direction output disabled) 
*)

1

Pulse A and direction B *) 2
Count up A, count down B 2
A/B phase offset 2
A/B phase offset - quadruple 2

*) The direction output must be on-board or on a signal board.

Usable pulse generator outputs and limit frequencies
The relay variants of the CPUs can only access the pulse generator outputs of a signal board.

Depending on the CPU and signal board, the following pulse signal generator outputs can be 
used with the following limit frequencies: 

On-board Q0.0 Q0.1 Q0.2 Q0.3 Q0.4 Q0.5 Q0.6 Q0.7 Q1.0 Q1.1
CPU 1211 (DC/DC/
DC)

100 kHz 100 kHz 100 kHz 100 kHz - - - - - -

CPU 1212 (DC/DC/
DC)

100 kHz 100 kHz 100 kHz 100 kHz 30 kHz 30 kHz - - - -

CPU 1214(F) (DC/DC/
DC)

100 kHz 100 kHz 100 kHz 100 kHz 30 kHz 30 kHz 30 kHz 30 kHz 30 kHz 30 kHz

CPU 1215(F) (DC/DC/
DC)

100 kHz 100 kHz 100 kHz 100 kHz 30 kHz 30 kHz 30 kHz 30 kHz 30 kHz 30 kHz

CPU 1217 (DC/DC/
DC)

1 MHz 1 MHz 1 MHz 1 MHz 100 kHz 100 kHz 100 
kHz

100 kHz 100 
kHz

100 kHz

Signal board Qx.0 Qx.1 Qx.2 Qx.3 - - - - - -
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On-board Q0.0 Q0.1 Q0.2 Q0.3 Q0.4 Q0.5 Q0.6 Q0.7 Q1.0 Q1.1
Signal board DI2/DO2 
x DC24V 20kHz

20 kHz 20 kHz - - - - - - - -

Signal board DI2/DO2 
x DC24V 200kHz

200 kHz 200 kHz - - - - - - - -

Signal board DO4 x 
DC24V 200kHz

200 kHz 200 kHz 200 kHz 200 kHz - - - - - -

Signal board DI2/DO2 
x DC5V 200kHz

200 kHz 200 kHz - - - - - - - -

Signal board DO4 x 
DC5V 200kHz

200 kHz 200 kHz 200 kHz 200 kHz - - - - - -

The low limit frequency is always 1Hz.

The pulse generator outputs can be freely assigned to the PTOs.
 

 Note

If pulse generator outputs with different limit frequencies are used in accordance with the 
signal type, the low limit frequency is used in each case.

Signal type "Pulse A and direction B" is an exception. With this type of signal, the limit 
frequency of the pulse generator output is always used.

 

 Note
Access to pulse generator outputs via the process image

The firmware takes control via the corresponding pulse generator and direction outputs if the 
PTO (Pulse Train Output) is selected and assigned to an axis.

With this takeover of the control function, the connection between the process image and I/
O output is also disconnected. Although the user has the option of writing the process image 
of pulse generator and direction outputs via the user program or watch table, this is not 
transferred to the I/O output. Accordingly, it is also not possible to monitor the I/O output via 
the user program or watch table. The information read reflects the value of the process image 
and does not match the real status of the I/O output.

For all other CPU outputs that are not used permanently by the CPU firmware, the status of 
the I/O output can be controlled or monitored via the process image, as usual.

 

Outputs for drive signals
For motion control, you can optionally parameterize a drive interface for "Drive enabled" and 
"Drive ready". 

When using the drive interface the digital output for the drive enable and the digital input for 
"drive ready" can be freely selected.
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Acceleration/deceleration limits
The following limits apply to acceleration and deceleration:

Acceleration/deceleration Value
Minimum acceleration/deceleration 5.0E-3 pulses/s2

Maximum acceleration/deceleration 9.5E+9 pulses/s2

Jerk limits
The following limits apply to the jerk:

Jerk Value
Minimum jerk 4.0E-3 pulses/s3

Maximum jerk 1.0E+10 pulses/s3

See also
CPU outputs relevant for motion control (technology version V1...3) (Page 7958)

How the pulse interface works (Page 7806)

Relationship between the signal type and the direction of travel (Page 7807)

Hardware and software limit switches (Page 7811)

Jerk limit (Page 7812)

Homing (Page 7813)

Hardware components for motion control (Page 7800)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

11.2.2.2 How the pulse interface works
Depending on the settings of the stepper motor, each pulse affects the movement of the 
stepper motor by a specific angle. If the stepper motor is set to 1000 pulses per revolution, for 
example, it moves 0.36° per pulse.

The speed of the stepper motor is determined by the number of pulses per time unit.
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(The statements made here also apply to servo motors with pulse interface.) 

See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

Relationship between the signal type and the direction of travel (Page 7807)

Hardware and software limit switches (Page 7811)

Jerk limit (Page 7812)

Homing (Page 7813)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

11.2.2.3 Relationship between the signal type and the direction of travel
The CPU outputs the velocity and direction of travel via two outputs.

The relationships between the configuration and direction of travel differ depending on the 
selected signal type. You can configure the following signal types in the axis configuration 
under "Basic parameters > General":  

● "PTO (pulse A and direction B)"

● "PTO (count up A, count down B)" (as of V4)

● "PTO (A/B phase offset)" (as of V4)

● "PTO (A/B phase offset - quadruple)" (as of V4)

You configure the direction under "Extended Parameters > Mechanics" in the axis 
configuration. If you select the "Invert direction" option, the direction logic described below for 
the respective signal type is inverted.  

PTO (pulse A and direction B) 
The pulse output pulses and the direction output level are evaluated for this signal type.

The pulses are output via the pulse output of the CPU. The direction output of the CPU specifies 
the direction of rotation of the drive: 

● 5 V/24 V at direction output ⇒ positive direction of rotation

● 0 V at direction output ⇒ negative direction of rotation

The specified voltage depends on the hardware used. The indicated values do not apply to 
the differential outputs of CPU 1217.
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PTO (count up A, count down B) (as of V4)
The pulses of an output are evaluated for this signal type.

The pulse for the positive direction is output via the "Up pulse output" The pulse for the negative 
direction is output via the "Down pulse output" 

The specified voltage depends on the hardware used. The values indicated do not apply to 
the differential outputs of CPU 1217.

PTO (A/B phase offset) (as of V4)
The positive edges of one output in each case are evaluated for this signal type.

The pulse is output via the "Phase A" output and phase-shifted via the "Phase B" output. The 
phase shifting between the outputs defines the direction of rotation:
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● Phase A leads phase B by 90° ⇒ positive direction of rotation

● Phase B leads phase A by 90° ⇒ negative direction of rotation

PTO (A/B phase offset - quadruple) (as of V4)
The positive and negative edges of both outputs are evaluated for this signal type. A pulse 
period has four edges with two phases (A and B). The pulse frequency at the output is therefore 
reduced to a quarter.

The pulse is output via the "Phase A" output and phase-shifted via the "Phase B" output. The 
phase shifting between the outputs defines the direction of rotation:

● Phase A leads phase B by 90° ⇒ positive direction of rotation

● Phase B leads phase A by 90° ⇒ negative direction of rotation

The specified voltage depends on the hardware used. The indicated values do not apply to 
the differential outputs of CPU 1217.
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Invert direction
If you select the "Invert rotation signal" option, the direction logic is inverted:

● PTO (pulse A and direction B)

– 0 V at direction output (low level) ⇒ positive direction of rotation

– 5 V/24 V at direction output (high level) ⇒ negative direction of rotation

The specified voltage depends on the hardware used. The voltages indicated do not apply 
to the differential outputs of CPU 1217.

● PTO (count up A, count down B)
The outputs "Pulse output down" and "Pulse output up" are swapped.
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● PTO (A/B phase offset)
The "Phase A" and "Phase B" outputs are swapped.

● "PTO (A/B phase offset - quadruple)
The "Phase A" and "Phase B" outputs are swapped.

See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

How the pulse interface works (Page 7804)

Hardware and software limit switches (Page 7811)

Jerk limit (Page 7812)

Homing (Page 7813)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

11.2.2.4 Hardware and software limit switches
Use the hardware and software limit switches to limit the "permitted traversing range" and the 
"working range" of your positioning axis technology object. The relationships are shown in the 
following diagram: 

Hardware limit switches are limit switches that limit the maximum "permitted traversing range" 
of the axis. Hardware limit switches are physical switching elements that must be connected 
to interrupt-capable inputs of the CPU.

Software limit switches limit the "working range" of the axis. They should fall inside the 
hardware limit switches relative to the traversing range. Since the positions of the software 
limit switches can be flexibly set, the working range of the axis can be adapted on an individual 
basis, depending on the current traversing profile. In contrast to hardware limit switches, 
software limit switches are implemented exclusively via the software and do not require their 
own switching elements.

Hardware and software limit switches must be activated prior to use in the configuration or in 
the user program.. Software limit switches are only active after homing the axis.
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See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

How the pulse interface works (Page 7804)

Relationship between the signal type and the direction of travel (Page 7805)

Jerk limit (Page 7812)

Homing (Page 7813)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

Position limits (Page 7833)

11.2.2.5 Jerk limit
With the jerk limit you can reduce the stresses on your mechanics during an acceleration and 
deceleration ramp. The acceleration and deceleration value is not changed abruptly when the 
jerk limiter is active; it is gradually increased and decreased. The figure below shows the 
velocity and acceleration curve without and with jerk limit.  

Travel without jerk limit Travel with jerk limit

The jerk limit gives a "smoothed" velocity profile of the axis motion. This ensures, for example, 
soft starting and braking of a conveyor belt.

See also
Behavior of the axis when using the jerk limit (Page 7842)

CPU outputs relevant for motion control (technology version V4) (Page 7802)
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How the pulse interface works (Page 7804)

Relationship between the signal type and the direction of travel (Page 7805)

Hardware and software limit switches (Page 7809)

Homing (Page 7813)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

11.2.2.6 Homing
Homing means matching the axis coordinates of the technology object to the real, physical 
location of the drive. For position-controlled axes the entries and displays for the position refer 
exactly to these axis coordinates. Therefore, agreement between the axis coordinates and the 
real situation is extremely important. This step is necessary to ensure that the absolute target 
position of the axis is also achieved exactly with the drive. 

In the S7-1200 CPU, axis homing is implemented with the motion control instruction, 
"MC_Home". The following homing modes exist

Homing modes
● Active homing

In active homing mode, the motion control instruction "MC_Home" performs the required 
reference point approach. When the homing switch is detected, the axis is homed according 
to the configuration. Active traversing motions are aborted.

● Passive homing
During passive homing, the motion control instruction "MC_Home" does not carry out any 
homing motion. The traversing motion required for this step must be implemented by the 
user via other motion control instructions. When the homing switch is detected, the axis is 
homed according to the configuration. Active traversing motions are not aborted upon start 
of passive homing.

● Direct homing absolute
The axis position is set regardless of the homing switch. Active traversing motions are not 
aborted. The value of input parameter "Position" of motion control instruction "MC_Home" 
is set immediately as the reference point of the axis.

● Direct homing relative
The axis position is set regardless of the homing switch. Active traversing motions are not 
aborted. The following statement applies to the axis position after homing:
New axis position = current axis position + value of parameter "Position" of instruction 
"MC_Home".

 

See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

How the pulse interface works (Page 7804)

Relationship between the signal type and the direction of travel (Page 7805)
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Hardware and software limit switches (Page 7809)

Jerk limit (Page 7810)

Integration of the positioning axis technology object (Page 7822)

Tools of the positioning axis technology object (Page 7825)

Homing (positioning axis technology object as of V2) (Page 7844)

11.2.3 Guidelines on use of motion control
The guidelines described here present the basic procedure for using motion control with the 
CPU S7-1200.  

Requirements
To use the positioning axis technology object, a project with a CPU S7-1200 must be created.

Procedure
Follow the steps below in the order given to use motion control with the CPU S7-1200. Use 
the following links for this purpose:

1. Adding a positioning axis technology object (Page 7827)

2. Working with the configuration dialog (Page 7827)

3. Download to CPU (Page 7870)

4. Function test of the axis in the commissioning window (Page 7871)

5. Programming (Page 7892)

6. Diagnostics of the axis control (Page 7910)

11.2.4 Using versions

11.2.4.1 Overview of versions
The relationship between the relevant versions for S7-1200 Motion Control can be found in 
the following table:

Technology version
You can check the currently selected technology version in the "Instructions" task card in folder 
"Technology > Motion Control > S7-1200 Motion Control" and in the "Add new object" dialog. 

Select the technology version in the "Instructions" task card in folder "Technology > Motion 
Control > S7-1200 Motion Control". 
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If a technology object with an alternative version is added in the "Add new object" dialog, the 
technology version will also be changed.

 

 Note

The selection of an alternative technology version will also affect the Motion Control 
Instructions version (task card). 

The technology objects and Motion Control instructions will only be converted to the selected 
version upon compilation or "Load to device".

 

Version of the technology object
The version of a technology object can be checked in the inspector window under "Properties 
> General > Information" in the "Version" box.

Motion Control instruction version
The Motion Control instruction version can be checked in the inspector window under 
"Properties > General > Information" in the "Version" box.

If the Motion Control instruction version used is not in line with the following compatibility list, 
the relevant Motion Control instructions will be highlighted in the program editor.

Compatibility list

Technology CPU Technology object Motion Control Instruction
V1.0 V1.0, V2.0, V2.1, V2.2, 

V3.0
Axis V1.0 MC_Power V1.0

MC_Reset V1.0
MC_Home V1.0
MC_Halt V1.0

MC_MoveAbsolute V1.0
MC_MoveRelative V1.0
MC_MoveVelocity V1.0

MC_MoveJog V1.0
V2.0 Innovations:

● Jerk limit
● Command table
● MC_ChangeDynamic

V2.1, V2.2, V3.0 Axis V2.0, Command 
table V2.0

MC_Power V2.0
MC_Reset V2.0
MC_Home V2.0
MC_Halt V2.0

MC_MoveAbsolute V2.0
MC_MoveRelative V2.0
MC_MoveVelocity V2.0

MC_MoveJog V2.0
MC_CommandTable V2.0
MC_ChangeDynamic V2.0
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Technology CPU Technology object Motion Control Instruction
V3.0 Innovation:

Load in RUN operating 
mode

V2.2, V3.0, V4.0 Axis V3.0, Command 
table V3.0

MC_Power V3.0
MC_Reset V3.0
MC_Home V3.0
MC_Stop V3.0

MC_MoveAbsolute V3.0
MC_MoveRelative V3.0
MC_MoveVelocity V3.0

MC_MoveJog V3.0
MC_CommandTable V3.0
MC_ChangeDynamic V3.0

V4.0 Innovations:
● MC_ReadParam
● MC_WriteParam
● Standardization of 

S7‑1200 and S7‑1500 
Motion Control 
technology data blocks.

V4.0 Positioning axis V4.0, 
command table V4.0

MC_Power V4.0
MC_Reset V4.0
MC_Home V4.0
MC_Halt V4.0

MC_MoveAbsolute V4.0
MC_MoveRelative V4.0
MC_MoveVelocity V4.0

MC_MoveJog V4.0
MC_CommandTable V4.0
MC_ChangeDynamic V4.0

MC_ReadParam V4.0
MC_WriteParam V4.0

See also
Changing a technology version (Page 7816)

Compatibility list of tags (Page 7817)

Status of limit switch (Page 7820)

11.2.4.2 Changing a technology version
Before you can access all the benefits of a new technology version, you may need to set / 
modify the technology version for existing projects. 

 

 Note
Compatibility of the technology object tags

If you are switching from V1...3 and V4, please see the compatibility list (Page 7817) if you 
are using tags of the technology object in your user program, monitoring tables, etc.
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Setting/changing a technology version
To set or change the technology version, follow these steps:

1. Open the programming editor (e.g., by opening the OB1).

2. In the "Instructions" task card, open the desired technology version in the "Technology > 
Motion Control > S7-1200 Motion Control" folder.

3. Save and compile the project. Pay attention to any error information that is displayed during 
compilation. Deal with the causes of the errors indicated.

4. Check the configuration of the technology objects.

5. If necessary, adapt the tag names in the following objects in line with the compatibility list.

● User program

● Monitoring tables

● Force tables

● HMI configuration

● Trace configuration

See also
Overview of versions (Page 7812)

Status of limit switch (Page 7820)

11.2.4.3 Compatibility list of tags
The technology data blocks for S7-1200 Motion Control and S7-1500 Motion Control have 
been standardized within the framework of the V4 technology. This has resulted in new tags 
and tag names for the V4 positioning axis and V4 command table technology objects.

Note the following tables if you have used tags of the technology objects in the user program 
and you want to convert the project from V1...3 to V4 (or vice versa). 

The tags listed in the "Automatic conversion V1...3 to V4" column are converted automatically 
when the project is compiled. Tag names in monitoring and force tables or the HMI or trace 
configuration are not converted.  

The following tags are new or have been adapted and may have to be corrected in the user 
program, monitoring tables, etc.:
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Config tags (positioning axis)

Tag name V1.0 to V3.0 Tag name V4.0 Automatic 
conversion
V1..3 to V4

<Axis 
name>.Config.DynamicDefaults.Acceleratio
n

<Axis name>.DynamicDefaults.Acceleration Yes

<Axis 
name>.Config.DynamicDefaults.Deceleratio
n

<Axis name>.DynamicDefaults.Deceleration Yes

<Axis 
name>.Config.DynamicDefaults.Emergency
Deceleration

<Axis name>.DynamicDefaults.EmergencyDeceleration Yes

<Axis name>.Config.DynamicDefaults.Jerk <Axis name>.DynamicDefaults.Jerk Yes
<Axis 
name>.Config.DynamicDefaults.JerkActive

Not available
The jerk is activated if the configured jerk is > 0.004 
pulse/s3.

No

<Axis 
name>.Config.DynamicLimits.MaxVelocity

<Axis name>.DynamicLimits.MaxVelocity Yes

<Axis 
name>.Config.DynamicLimits.MinVelocity

<Axis name>.DynamicLimits.MinVelocity Yes

<Axis name>.Config.General.LengthUnit <Axis name>.Units.LengthUnit Yes
<Axis name>.Config.Homing.AutoReversal <Axis name>.Homing.AutoReversal Yes
<Axis name>.Config.Homing.Direction <Axis name>.Homing.ApproachDirection Yes
<Axis name>.Config.Homing.FastVelocity <Axis name>.Homing.ApproachVelocity Yes
<Axis name>.Config.Homing.Offset <Axis 

name>.Sensor[1].ActiveHoming.HomePositionOffset
Yes

<Axis 
name>.Config.Homing.SideActiveHoming

<Axis name>.Sensor[1].ActiveHoming.SideInput Yes

<Axis 
name>.Config.Homing.SidePassiveHoming

<Axis name>.Sensor[1].PassiveHoming.SideInput Yes

<Axis name>.Config.Homing.SlowVelocity <Axis name>.Homing.ReferencingVelocity Yes
<Axis name>.Config.Homing.SwitchedLevel <Axis name>.Sensor[1].ActiveHoming.SwitchLevel

<Axis name>.Sensor[1].PassiveHoming.SwitchLevel
No

<Axis 
name>.Config.Mechanics.InverseDirection

<Axis name>.Actor.InverseDirection Yes

<Axis name>.Config.Mechanics.LeadScrew <Axis name>.Mechanics.LeadScrew Yes
<Axis 
name>.Config.Mechanics.PulsesPerDriveRe
volution

<Axis 
name>.Actor.DriveParameter.PulsesPerDriveRevolutio
n

Yes

<Axis 
name>.Config.PositionLimits_HW.Active

<Axis name>.PositionLimitsHW.Active Yes

<Axis 
name>.Config.PositionLimits_HW.MaxSwitc
hedLevel

<Axis name>.PositionLimitsHW.MaxSwitchLevel Yes

<Axis 
name>.Config.PositionLimits_HW.MinSwitch
edLevel

<Axis name>.PositionLimitsHW.MinSwitchLevel Yes
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Tag name V1.0 to V3.0 Tag name V4.0 Automatic 
conversion
V1..3 to V4

<Axis 
name>.Config.PositionLimits_SW.Active

<Axis name>.PositionLimitsSW.Active Yes

<Axis 
name>.Config.PositionLimits_SW.MaxPositi
on

<Axis name>.PositionLimitsSW.MaxPosition Yes

<Axis 
name>.Config.PositionLimits_SW.MinPositio
n

<Axis name>.PositionLimitsSW.MinPosition Yes

Not available <Axis name>.Actor.DirectionMode No
Not available <Axis name>.Actor.Type No
Not available <Axis name>.Sensor[1].ActiveHoming.Mode No
Not available <Axis name>.Sensor[1].PassiveHoming.Mode No

ErrorBits tags (positioning axis)

Tag name V1.0 to V3.0 Tag name V4.0 Automatic 
conversion
V1..3 to V4

<Axis name>.ErrorBits.HwLimitMax <Axis name>.ErrorBits.HWLimit
(Note the new status bits and the section Status of the 
limit switch (Page 7820).)

No
<Axis name>.ErrorBits.HwLimitMin

<Axis 
name>.ErrorBits.SwLimitMaxExceeded

<Axis name>.ErrorBits.SWLimit
(Note the new status bits and the section Status of the 
limit switch (Page 7820).)

No

<Axis name>.ErrorBits.SwLimitMaxReached
<Axis name>.ErrorBits.SwLimitMinExceeded
<Axis name>.ErrorBits.SwLimitMinReached
Not available <Axis name>.ErrorBits.DirectionFault No

MotionStatus tags (positioning axis)

Tag name V1.0 to V3.0 Tag name V4.0 Automatic 
conversion
V1..3 to V4

<Axis name>.MotionStatus.Distance <Axis name>.StatusPositioning.Distance Yes
<Axis name>.MotionStatus.Position <Axis name>.Position Yes
<Axis name>.MotionStatus.TargetPosition <Axis name>.StatusPositioning.TargetPosition Yes
<Axis name>.MotionStatus.Velocity <Axis name>.Velocity Yes
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StatusBits tags (positioning axis)

Tag name V1.0 to V3.0 Tag name V4.0 Automatic 
conversion
V1..3 to V4

<Axis name>.StatusBits.Homing <Axis name>.StatusBits.HomingCommand Yes
<Axis name>.StatusBits.SpeedCommand <Axis name>.StatusBits.VelocityCommand Yes
Not available <Axis name>.StatusBits.HWLimitMaxActive No
Not available <Axis name>.StatusBits.HWLimitMinActive No
Not available <Axis name>.StatusBits.SWLimitMaxActive No
Not available <Axis name>.StatusBits.SWLimitMinActive No

Tags (command table)

Tag name V1.0 to V3.0 Tag name V4.0 Automatic 
conversion
V1..3 to V4

<Command 
table>.Config.Command[n].Position

<Command table>.Command[n].Position Yes

<Command 
table>.Config.Command[n].Velocity

<Command table>.Command[n].Velocity Yes

<Command 
table>.Config.Command[n].Duration

<Command table>.Command[n].Duration Yes

<Command 
table>.Config.Command[n].NextStep

<Command table>.Command[n].NextStep Yes

<Command 
table>.Config.Command[n].StepCode

<Command table>.Command[n].StepCode Yes

See also
Overview of versions (Page 7812)

Changing a technology version (Page 7814)

Tags of the positioning axis technology object as of V4 (Page 7938)

11.2.4.4 Status of limit switch
The status and error bits for the display of the reached limit switch have been adapted in version 
V4.

In order to replicate the behavior of the error bits of versions V1...3, use the following logical 
operators:
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V1...3 V4
<Axis name>.ErrorBits.HwLimitMin <Axis name>.ErrorBits.HWLimit AND <Axis 

name>.StatusBits.HWLimitMinActive
<Axis name>.ErrorBits.HwLimitMax <Axis name>.ErrorBits.HWLimit AND <Axis 

name>.StatusBits.HWLimitMaxActive
<Axis name>.ErrorBits.SwLimitMinReached <Axis name>.ErrorBits.SWLimit AND (<Axis name>.Position 

= <Axis name>.PositioningLimits_SW.MinPosition)
<Axis name>.ErrorBits.SwLimitMinExceeded <Axis name>.ErrorBits.SWLimit AND (<Axis name>.Position 

< <Axis name>.PositioningLimits_SW.MinPosition)
<Axis name>.ErrorBits.SwLimitMaxReached <Axis name>.ErrorBits.SWLimit AND (<Axis name>.Position 

= <Axis name>.PositioningLimits_SW.MaxPosition)
<Axis name>.ErrorBits.SwLimitMaxExceeded <Axis name>.ErrorBits.SWLimit AND (<Axis name>.Position 

> <Axis name>.PositioningLimits_SW.MaxPosition)

See also
Overview of versions (Page 7812)

Changing a technology version (Page 7814)

Compatibility list of tags (Page 7815)
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11.2.5 Positioning axis technology object

11.2.5.1 Integration of the positioning axis technology object
The following representation shows the relationships between the hardware and software 
components that are implemented when using the positioning axis technology object:   

S
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CPU hardware
The physical drive is controlled and monitored by the CPU hardware.

Drive
The drive represents the unit of power unit and motor. Stepper motors or servo motors with a 
pulse interface may be used.

Positioning axis technology object
The physical drive including mechanics is mapped in the TIA Portal as a positioning axis 
technology object. To do this, configure the positioning axis technology object with the following 
parameters:

● Selection of the PTOs (Pulse Train Output) to be used and configuration of the drive 
interface

● Parameter for mechanics and gear transmission of the drive (or the machine or system)

● Parameter for position monitoring, for dynamic parameters and for homing

The configuration of the positioning axis technology object is saved in the technology object 
(data block). This data block also forms the interface between the user program and the CPU 
firmware. The current axis data is saved in the data block of the technology object at the runtime 
of the user program.

User program
You start Motion Control instructions jobs in the CPU firmware with the user program. The 
following jobs for controlling the axis are possible:

● Enable and disable axis

● Position axis absolutely

● Position axis relatively

● Move axis with velocity set point

● Run axis commands as motion sequence (technology as of V2)

● Moving axes in jog mode

● Stop axis

● Reference axis; set reference point

● Change dynamic settings of axis

● Continuously read motion data of the axis

● Write tag of axis

● Acknowledge error

You determine the command parameters with the input parameters of the Motion Control 
instructions and the axis configuration. The output parameters of the instruction give you up 
to date information about the status and any errors of the command.
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Before starting a command for the axis, you must enable the axis with the Motion Control 
instruction "MC_Power".

You can read out configuration data and current axis data with the tags of the technology 
object. You can change individual, changeable tags of the technology object (e.g. the current 
acceleration) from the user program. 

You can also change the dynamic settings of the axis with the Motion Control instruction 
"MC_ChangeDynamic" and write additional configuration data with "MC_WriteParam". You 
can read the current motion status of the axis with the Motion Control instruction 
"MC_ReadParam".

CPU firmware
The motion control jobs started in the user program are processed in the CPU firmware. When 
using the axis control table, Motion Control jobs are triggered by operating the axis control 
table. The CPU firmware performs the following jobs depending on the configuration:

● Calculate the exact motion profile for motion jobs and emergency stop situations

● Control the drive enable and the pulse and direction signal

● Monitor the drive and the hardware and software limit switches

● Up to date feedback of status and error information to the Motion Control instructions in the 
user program

● Writing of current axis data into the data block of the technology object

See also
Tags of the positioning axis technology object as of V4 (Page 7938)

CPU outputs relevant for motion control (technology version V4) (Page 7802)

Relationship between the signal type and the direction of travel (Page 7805)

Tools of the positioning axis technology object (Page 7825)

Hardware and software limit switches (Page 7809)

Homing (Page 7811)
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11.2.5.2 Tools of the positioning axis technology object
The TIA Portal provides the "Configuration", "Commissioning", and "Diagnostics" tools for the 
positioning axis technology object. The following representation shows the interaction of the 
three tools with the technology object and the drive:   

① Reading and writing of configuration data of the technology object;
② Drive control via the technology object; Reading axis status for display on the control panel
③ Readout of the current status and error information of the technology object.
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Configuration   
Use the "Configuration" tool to configure the following properties of the positioning axis 
technology object:

● Selection of the PTO to be used and configuration of the drive interface

● Properties of the mechanics and the transmission ratio of the drive (or machine or system)

● Properties for position monitoring, dynamics, and homing

Save the configuration in the data block of the technology object.

Commissioning   
Use the "Commissioning" tool to test the function of your axis without having to create a user 
program. When the tool is started, the axis control table will be displayed. The following 
commands are available on the axis control table:

● Enabling and disabling the axis

● Move axis in jog mode

● Position axis in absolute and relative terms

● Home axis

● Acknowledge errors

The dynamic values can be adjusted accordingly for the motion commands. The axis control 
table also shows the current axis status.

Diagnostics   
Use the "Diagnostics" tool to keep track of the current status and error information for the axis 
and drive.

See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

Relationship between the signal type and the direction of travel (Page 7805)

Integration of the positioning axis technology object (Page 7820)

Hardware and software limit switches (Page 7809)

Homing (Page 7811)

Configuring the positioning axis technology object (Page 7827)

Commissioning the axis - Axis control panel (Page 7871)

Axis - Diagnostics (Page 7910)
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11.2.5.3 Adding a positioning axis technology object

Requirements
A project with a CPU S7-1200 has been created.

Procedure
To add a positioning axis technology object in the project tree, follow these steps:

1. Open the "CPU > Technology objects" folder in the project tree.

2. Double-click the "Add new object" command. 
The "Add new object" dialog opens.

3. Select the "Motion Control" technology.

4. Open the "Motion Contro > S7-1200 Motion Control" folder.

5. Select the desired technology version in the "Version" column.

6. Select the "TO_PositioningAxis" object. 

7. Enter the name of the axis in the "Name" input box.

8. To change the automatically assigned data block number, select the "Manual" option.

9. To display additional information about the technology object, click "Additional information". 

10.Confirm your entry with "OK".

Result
The new technology object is created and saved to the "Technology objects" folder in the 
project tree.

See also
Guidelines on use of motion control (Page 7812)

11.2.5.4 Configuring the positioning axis technology object

Working with the configuration dialog
You configure the properties of the technology object in the configuration window. Proceed as 
follows to open the configuration window of the technology object:

1. Open the group of the required technology object in the project tree.

2. Double-click the "Configuration" object.

The configuration is divided into the following categories:
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● Basic parameters 
The basic parameters contain all the parameters which must be configured for a functioning 
axis.

● Extended parameters 
The advanced parameters include parameters to adapt to your drive or your plant.

Configuration window icons 
Icons in the area navigation of the configuration show additional details about the status of the 
configuration:

The configuration contains default values and is complete.
The configuration contains only default values. With these default values you can use the technology object without 
additional changes.
The configuration contains values set by the user and is complete.
All input boxess of the configuration contain valid values and at least one preset value has changed.
The configuration is incomplete or incorrect
At least one input box or drop-down list contains an invalid value. The corresponding box or the drop-down list is 
displayed on a red background. Click the roll-out error message to indicate the cause of error.
The configuration is valid but contains warnings
For example, only one hardware limit switch is configured. Depending on the plant, the lacking configuration of a 
hardware limit switch may result in a hazard. The corresponding box or the drop-down list is displayed on a yellow 
background.

See also
Guidelines on use of motion control (Page 7812)

Basic parameters (Page 7829)

Extended parameters (Page 7831)

Compare values
The "Compare values" function provides the following options: 

● Comparison of configured start values of the project with the start values in the CPU and 
the actual values

● Direct editing of actual values and the start values of the project

● Immediate detection and display of input errors with suggested corrections

● Backup of actual values in the project

● Transfer of start values of the project to the CPU as actual values
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Icons and operator controls
The following icons and operator controls are available:

Icon Function
Start value in CPU matches the configured Start value in the project

Start value in CPU does not match the configured Start value in the project

The comparison of the Start value in CPU with the configured Start value in the project 
cannot be performed
Backs up the actual values in the project

Transfers updated start values in the project to the CPU (initialize setting values)

Opens the "Compare values" dialog

Basic parameters

Configuration - General (positioning axis technology object as of V4)
Configure the basic properties of the positioning axis technology object in the "General" 
configuration window.

Axis name   
Define the name of the axis or the name of the positioning axis technology object in this box. 
The technology object is listed under this name in the project navigation.

Hardware interface   
The pulses are output to the power unit of the drive by fixed assigned digital outputs.

In CPUs with relay outputs, the pulse signal cannot be output on these outputs because the 
relays do not support the necessary switching frequencies. A signal board with digital outputs 
must be used to enable you to work with the PTO (Pulse Train Output) on these CPUs.

 

 Note

The PTO requires the functionality of a fast counter (HSC). An internal HSC is used for this, 
the count of which cannot be evaluated.

 

Selecting the pulse generator
In the drop-down list, select the PTO (Pulse Train Output) which is to provide the pulses for 
controlling the stepper motors or servo motors with pulse interface. If the pulse generators and 
high-speed counters are not used elsewhere in the device configuration, the hardware 
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interface can be configured automatically. In this case, the PTO selected in the drop-down list 
is displayed with a white background.

"Device configuration" button
This button takes you to the settings for the pulse options in the device configuration of the 
CPU.

Signal type
Select the desired signal type in the drop-down list. The following signal types are available:

● PTO (pulse A and direction B)
A pulse output and a direction output are used for controlling the stepper motor.

● PTO (count up A, count down B)
One pulse output each for motion in positive direction and negative direction is used for 
controlling the stepper motor.

● PTO (A/B phase offset)
Both pulse outputs for Phase A and for Phase B run at the same frequency. 
The period of the pulse outputs is evaluated at the drive end as a step. 
The phase offset between Phase A and Phase B determines the direction of the motion.

● PTO (A/B phase offset - quadruple)
Both pulse outputs for Phase A and for Phase B run at the same frequency.
All positive edges and all negative edges of Phase A and Phase B are evaluated as a step 
at the drive end. 
The phase offset between Phase A and Phase B determines the direction of the motion.

Pulse output (signal type "PTO (pulse A and direction B)")
Select the desired output for the pulse output in this box.

You can select the output using a symbolic address or assign an absolute address. 

Activate direction output (signal type "PTO (pulse A and direction B)")
You can deactivate and activate the direction output in "pulse and direction" mode. This option 
enables you to limit the motion direction.

Direction output (signal type "PTO (pulse A and direction B)")
Select the desired output for the direction output in this box.

You can select the output using a symbolic address or assign an absolute address.

Pulse output up (signal type "PTO (count up A, count down B)")
Select the desired pulse output for motions in positive direction in this box.

You can select the output using a symbolic address or assign an absolute address.
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Pulse output down (signal type "PTO (count up A, count down B)")
Select the desired pulse output for motions in negative direction in this box.

You can select the output using a symbolic address or assign an absolute address.

Phase A (signal types "PTO (A/B phase offset)" and "PTO (A/B phase offset - quadruple)")
Select the desired pulse output for Phase A signals in this box.

You can select the output using a symbolic address or assign an absolute address.

Phase B (signal types "PTO (A/B phase offset)" and "PTO (A/B phase offset - quadruple)")
Select the desired pulse output for Phase B signals in this box.

You can select the output using a symbolic address or assign an absolute address.

User unit   
Select the desired unit for the dimension system of the axis in the dropdown list. The selected 
unit is used for further configuration of the positioning axis technology object and for displaying 
the current axis data.

The values at the input parameters (Position, Distance, Velocity, ...) of the Motion Control 
instructions also refer to this unit.

 

 Note

Later changing of the dimension system may not be converted correctly in all the configuration 
windows of the technology object. In this case check the configuration of all axis parameters.

The values of the input parameters of the Motion Control instructions may have to be adapted 
to the new unit of measurement in the user program.

 

See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

Relationship between the signal type and the direction of travel (Page 7805)

Configuration - General ("Axis" technology object V1...3) (Page 7962)

Extended parameters

Configuration - Drive interface
Configure the output for drive enable and the input for the "Drive ready" feedback signal of the 
drive in the "Drive signals" configuration window.  

Drive enable is controlled by Motion Control instruction "MC_Power" and enables power to the 
drive. The signal is provided to the drive via the output to be configured.   
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The drive signals "Drive ready" to the CPU if it is ready to start executing travel after receipt 
of drive enable. The "Drive ready" signal is reported back to the CPU via the input to be 
configured.  

If the drive does not have any interfaces of this type, you will not have to configure the 
parameters. In this case, select the value TRUE for the ready input.

See also
Configuration - Mechanics (Page 7832)

Position limits (Page 7833)

Dynamics (Page 7837)

Homing (positioning axis technology object as of V2) (Page 7844)

Configuration - Mechanics
Configure the mechanical properties of the drive in the "Mechanics" configuration window.  

Increments per motor revolution  
Configure the number of pulses required for one revolution of the motor in this box.

Limits (independent of the selected unit of measurement):

● 0 < Pulse per motor revolution ≤ 2147483647

Distance per revolution  
In this box, configure the load distance per motor revolution covered by the mechanical system 
of your unit.

Limits (independent of the selected unit of measurement):

● 0.0 < Distance per revolution ≤ 1.0e12

Permitted direction of rotation (technology version as of V4)
Configure this box to determine whether the mechanics of your system are to move in both 
directions or only in the positive or negative direction.

If you have not activated the direction output of the pulse generator in the "PTO (pulse A and 
direction B)" mode, the selection is limited to the positive or negative direction.  

Invert direction  
You can use the "Invert direction" check box to adapt the control system to the direction logic 
of the drive.

The direction logic is inverted according to the selected mode of the pulse generator:
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● PTO (pulse A and direction B)

– 0 V at direction output ⇒ positive direction of rotation

– 5 V/24 V at direction output ⇒ negative direction of rotation

The specified voltage depends on the hardware used. The indicated values do not apply 
to the differential outputs of CPU 1217.

● PTO (count up A, count down B)
The outputs "Pulse output down" and "Pulse output up" are swapped.

● PTO (A/B phase offset)
The "Phase A" and "Phase B" outputs are swapped.

● "PTO (A/B phase offset - quadruple)
The "Phase A" and "Phase B" outputs are swapped.

See also
Configuration - Drive interface (Page 7829)

Position limits (Page 7833)

Dynamics (Page 7837)

Homing (positioning axis technology object as of V2) (Page 7844)

Relationship between the signal type and the direction of travel (Page 7805)

Position limits

Requirements for hardware limit switches
Use only hardware limit switches that remain permanently switched after being approached. 
This switching status may only be revoked after a return to the valid travel range.

See also
Configuration - Position limits (Page 7833)

Behavior of axis when position limits is tripped (Page 7835)

Changing the position limits configuration in the user program (Page 7836)

Configuration - Position limits
Configure the hardware and software limit switches of the axis in the "Position limits" 
configuration window.

Enable hardware limit switch
Activate the function of the low and upper hardware limit switch with this check box. The 
hardware limit switches can be used for purposes of direction reversal during a homing 
procedure. For details, refer to the configuration description for homing.
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Lower / upper HW limit switch input
Select the digital input for the low or upper hardware limit switch from the drop-down list. The 
input must be interrupt-capable. The digital onboard CPU inputs and the digital inputs of a 
plugged signal board can be selected as inputs for the HW limit switches.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default. If these are used as hardware 
limit switches, undesired decelerations may occur. If this occurs, reduce the filter time for the 
relevant digital inputs.

The filter time can be set under "Input filter" in the device configuration of the digital inputs.
 

Active level
In the drop-down list, select the signal level available at the CPU when the hardware limit 
switch is approached. 

● "Lower level" selected
0 V (FALSE) at CPU input corresponds to hardware limit switch approached

● "High level" selected
5 V / 24 V (TRUE) at the CPU input = hardware limit switch approached (the actual voltage 
depends on the hardware used)
 

Enable software limit switch
Activate the function of the low and upper software limit switch with this check box. 

 

 Note

The enabled software limit switch only affects a homed axis.
 

High and lower software limit switch
Enter the position value of the low and upper software limit switch in these boxes.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ lower software limit switch ≤ 1.0e12

● -1.0e12 ≤ upper software limit switch ≤ 1.0e12

The value of the upper software limit switch must be greater than or equal to the value of the 
lower software limit switch.

See also
Requirements for hardware limit switches (Page 7831)

Behavior of axis when position limits is tripped (Page 7835)
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Changing the position limits configuration in the user program (Page 7836)

Configuration - Homing - Active (Page 7845)

Behavior of axis when position limits is tripped

Behavior of axis when hardware limit switches are approached
When the hardware limit switches are approached, the axis brakes to a standstill at the 
configured emergency stop deceleration. The specified emergency stop deceleration must be 
sufficient to reliably stop the axis before the mechanical stop. The following diagram presents 
the behavior of the axis after it approaches the hardware limit switches:

① The axis brakes to a standstill at the configured emergency stop deceleration. 
② Range in which the HW limit switches signal the status "approached".

The "HW limit switch approached" error is displayed in the motion control instruction to be 
initiated, in "MC_Power", and in the technology object tags. Instructions for eliminating errors 
can be found in the Appendix under "List of ErrorIDs and ErrorInfos".

Behavior of axis when software limit switches are reached
If software limit switches are activated, an active motion is stopped at the position of the 
software limit switch. The axis is braked at the configured deceleration. 

The following diagram presents the behavior of the axis until it reaches the software limit 
switches:
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① The axis brakes to a standstill at the configured deceleration.

The "SW limit switch approached" error is displayed in the initiating Motion Control instruction, 
at "MC_Power", and in the technology object tags. Instructions for eliminating errors can be 
found in the Appendix under "List of ErrorIDs and  ErrorInfos".

You can learn about the circumstances that can lead to exceeding the software limit switches 
in the sections "Software limit switches in conjunction with a homing operation (Page 7921)" 
and "Software limit switches in conjunction with dynamic changes (Page 7926)". 

Use additional hardware limit switches if a mechanical endstop is located after the software 
limit switches and there is a risk of mechanical damage.

See also
Requirements for hardware limit switches (Page 7831)

Configuration - Position limits (Page 7831)

Changing the position limits configuration in the user program (Page 7836)

Changing the position limits configuration in the user program
You can change the following configuration parameters during runtime of the user program in 
the CPU:

Hardware limit switches
You can also activate and deactivate the hardware limit switches during runtime of the user 
program. Use the following technology object tag for this purpose:

● <Axis name>.PositionLimitsHW.Active

Refer to the description of the technology object tags (Page 7938) in the appendix for 
information on when changes to the configuration parameter take effect.
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Software limit switches
You can also activate and deactivate the software limit switches and change their position 
values during runtime of the user program. Use the following technology object tags for this 
purpose:

● <Axis name>.PositionLimitsSW.Active
for activating and deactivating the software limit switches

● <Axis name>.PositionLimitsSW.MinPosition
for changing the position of the lower software limit switch

● <Axis name>.PositionLimitsSW.MaxPosition
for changing the position of the upper software limit switch

Refer to the description of technology object tags in the appendix for information on when 
changes to the configuration parameters take effect.

See also
Compatibility list of tags (Page 7815)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

Requirements for hardware limit switches (Page 7831)

Configuration - Position limits (Page 7831)

Behavior of axis when position limits is tripped (Page 7833)

Dynamics

Configuration - General dynamics
Configure the maximum velocity, the start/stop velocity, the acceleration and deceleration, and 
the jerk limit (positioning axis technology object as of V2) of the axis in the "General dynamics" 
configuration window.   

Velocity limiting unit   
Select the unit of measurement with which you want to set the velocity limits in the dropdown 
list. The unit set here depends on the unit of measurement set under "Configuration - General" 
and serves only for easier input.

Maximum velocity / Start/stop velocity   
Define the maximum permissible velocity and the start/stop velocity of the axis in these boxes. 
The start/stop velocity is the minimum permissible velocity of the axis.

Limit values:

The limits indicated below refer to the "Pulses/s" unit of measurement:

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
System Manual, 02/2014 7835



● Positioning axis technology object V4

– 1 ≤ start/stop velocity ≤ 20000 (signal board 20 kHz)
1 ≤ start/stop velocity ≤ 200000 (signal board 200 kHz)
1 ≤ start/stop velocity ≤ 100000 (on-board CPU outputs 100 kHz)
1 ≤ start/stop velocity ≤ 30000 (on-board CPU outputs 30 kHz)
1 ≤ start/stop velocity ≤ 1000000 (on-board CPU outputs 1 MHz CPU 1217)

– 1 ≤ maximum velocity ≤ 20000 (signal board 20 kHz)
1 ≤ maximum velocity ≤ 200000 (signal board 200 kHz)
1 ≤ maximum velocity ≤ 100000 (on-board CPU outputs 100 kHz)
1 ≤ maximum velocity ≤ 30000 (on-board CPU outputs 30 kHz)
1 ≤ maximum velocity ≤ 1000000 (on-board CPU outputs 1 MHz CPU 1217)

You can learn about the limits for the technology object positioning axis < V4 in the appendix 
Outputs of the CPU relevant for Motion Control (technology version V1...3) (Page 7958). 

The value of the maximum velocity must be greater or equal to the value of the start/stop 
velocity.

The limits for other units of measurement must be converted by the user to conform to the 
given mechanics.

Acceleration / Delay - Ramp-up time / Ramp-down time         
Set the desired acceleration in the "Ramp-up time" or "Acceleration" boxes. The desired 
deceleration can be set in the "Deceleration time" or "Deceleration" boxes.

The relation between the ramp-up time and acceleration and the deceleration time and 
deceleration is shown in the following equations:

Rampup time  =

Maximum velocity  -  Start/stop velocity

Acceleration

 

Deceleration time =

Maximum velocity  -  Start/stop velocity

Deceleration

Motion jobs started in the user program are performed with the selected acceleration / 
deceleration. 

The limits for acceleration and deceleration can be found in section Hardware components for 
motion control (Page 7800).

 

 Note

Changes to the velocity limits ("start/stop velocity" and "maximum velocity") influence the 
acceleration and deceleration values of the axis. The ramp-up and deceleration times are 
retained.
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Activate the jerk limit (positioning axis technology object as of V2)   
Activate the jerk limit with this check box.

 

 Note

If an error occurs, the axis decelerates with the configured emergency stop deceleration. An 
activated jerk limit is not considered here.

 

Smoothing time / jerk (positioning axis technology object as of V2)   
You can input the parameters of the jerk limit in the "Smoothing time" box or alternatively in 
the "Jerk" box.

● Set the desired jerk for acceleration and deceleration ramp in the "Jerk" box.

● Set the desired smoothing time for the acceleration ramp in the "Rounding time" box.
 

  Note
Smoothing time V2...3

The set smoothing time visible in the configuration only applies to the acceleration ramp.

If the values for acceleration and deceleration differ, the smoothing time of the deceleration 
ramp is calculated according to the jerk of the acceleration ramp and used. (See also 
Behavior of the axis when using the jerk limit (Page 7842)

The smoothing time of the deceleration is adapted as follows:
● Acceleration > deceleration

The smoothing time used for the deceleration ramp is shorter than that for the 
acceleration ramp.

● Acceleration < deceleration
The smoothing time used for the deceleration ramp is greater than that for the 
acceleration ramp.

● Acceleration = deceleration
The smoothing times of the acceleration and deceleration ramp are equal.

 

The relation between smoothing times and jerk is shown in the following equation:

 

 

Motion jobs started in the user program are performed with the selected jerk.
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The limits for the jerk can be found in section Hardware components for motion control 
(Page 7800).

See also
Behavior of the axis when using the jerk limit (Page 7842)

Hardware components for motion control (Page 7800)

Configuration - Dynamics emergency stop (Page 7840)

Changing the configuration of dynamics in the user program (Page 7843)

Configuration - Dynamics emergency stop
Configure the emergency stop deceleration of the axis in the "Dynamics emergency stop" 
configuration window. In the event of an error, and when disabling the axis, the axis is brought 
to a standstill with this deceleration using the Motion Control instruction "MC_Power" (input 
parameter StopMode = 0 or 2).  

Velocity limits
The velocity values configured in the "General dynamics" configuration window are once again 
displayed in this information area.

Deceleration
Set the deceleration value for emergency stop in the "Emergency stop deceleration" or 
"Emergency stop ramp-down time" field.

The relation between emergency stop deceleration time and emergency stop deceleration is 
shown in the following equation:

Emergency stop ramp-down =
Maximum velocity  -  Start/stop velocity

Emergency stop deceleration

The specified emergency stop deceleration must be sufficient to bring the axis to a standstill 
in a timely manner in the event of an emergency (for example, when the hardware limit switch 
is approached prior to reaching the mechanical endstop).

The configured maximum velocity of the axis must be used as a basis for selecting the 
emergency stop deceleration.

Limit values:

The limits indicated below refer to the "Pulses/s2" unit of measurement:

● As of CPU firmware V3
0.005 ≤ emergency stop deceleration ≤ 9.5E9

● CPU Firmware V1...2
0.28 ≤ emergency stop deceleration ≤ 9.5E9

The limits for other units of measurement must be converted to conform to the given mechanics.
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See also
Configuration - General dynamics (Page 7835)

Changing the configuration of dynamics in the user program (Page 7843)
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Behavior of the axis when using the jerk limit
Axis acceleration and deceleration is not stopped abruptly when the jerk limit is activated; it is 
adjusted gently according to the set step or smoothing time. The diagram below details the 
behavior of the axis with and without activated jerk limit:  

Without jerk limit With jerk limit

t Time axis
v Velocity
a Acceleration
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j Jerk
tru Rampup time
ta Time taken for the axis to accelerate
trd Deceleration time
td Time taken for the axis to decelerate
t1 Smoothing time of the acceleration ramp
t2 Smoothing time of the deceleration ramp

The example shows travel in which the deceleration value ② is twice the acceleration value 
①. The resulting ramp-down time trd is therefore only half the length of the ramp-up time tru.

Acceleration ① and deceleration ② change abruptly without a jerk limit. Acceleration ① and 
deceleration ② change gradually with activated jerk limiter. As the jerk applies to entire motion, 
the rate is the same for the increase and decrease in acceleration and deceleration.

The step value j becomes infinitely high ⑤ as soon as the change is made without jerk limit. 
The step is limited to the configured value ⑥ when the jerk limit is activated.

The smoothing time t1 given in the configuration applies to the acceleration ramp. The 
deceleration ramp smoothing time t2 is calculated from the configured jerk value and the 
configured deceleration.

See also
Configuration - General dynamics (Page 7835)

Changing the configuration of dynamics in the user program
You can change the following configuration parameters during runtime of the user program in 
the CPU:  

Acceleration and deceleration
You can also change the values for acceleration and deceleration during runtime of the user 
program. Use the following technology object tags for this purpose:

● <Axis name>.DynamicDefaults.Acceleration
for changing acceleration

● <Axis name>.DynamicDefaults.Deceleration
for changing deceleration

Refer to the description of the technology object tags (Page 7938) in the appendix for 
information on when changes to the configuration parameters take effect.
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Emergency stop deceleration
You can also change the value for the emergency stop deceleration during runtime of the user 
program. Use the following technology object tag for this purpose:

● <Axis name>.DynamicDefaults.EmergencyDeceleration

Refer to the description of the technology object tags in the appendix for information on when 
changes to the configuration parameter take effect.

 

 Note

After changes to this parameter, it may be necessary to adapt the positions of the hardware 
limit switches and other safety-relevant settings.

 

Jerk limit
You can also activate and deactivate the jerk limit at runtime of the user program and change 
the value for the jerk. To do this, use the technology object tag <Axis 
name>.DynamicDefaults.Jerk.

If you enter a value > 0.004 pulse/s3 for the jerk, the jerk limit is activated with the specified 
value.

If you enter a value = 0.0 for the jerk, the jerk limit is deactivated.

Refer to the description of the technology object tags in the appendix for information on when 
changes to the configuration parameter take effect.

See also
Changing configuration of dynamic values in user program ("Axis" technology object V1...3) 
(Page 7964)

Compatibility list of tags (Page 7815)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)

Configuration - General dynamics (Page 7835)

Configuration - Dynamics emergency stop (Page 7838)

Homing (positioning axis technology object as of V2)

Configuration - Homing - Passive
Configure the necessary parameters for passive homing in the "Homing - Passive" 
configuration window.   

The movement for passive homing must be triggered by the user (e.g. using an axis motion 
command). Passive homing is started using Motion Control instruction "MC_Home" with input 
parameter "Mode" = 2.
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Homing switch input 
Select the digital input for the homing switch from the drop-down list. The input must be 
interrupt-capable. The on-board CPU inputs and the inputs of an inserted signal board can be 
selected as inputs for the homing switch.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default.

When the digital inputs are used as a homing switch, this can result in undesired decelerations 
and thus inaccuracies. Depending on the homing velocity and extent of the homing switch, 
the home position may not be detected. The filter time can be set under "Input filter" in the 
device configuration of the digital inputs.

The specified filter time must be less than the duration of the input signal at the homing switch.
 

Active level
In the drop-list, select the level of the homing switch that is to be used for homing.

Side of the homing switch   
This is where you select whether the axis is to be homed on the low or high end of the homing 
switch.

Home position   
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.

 

 Note

If passive homing is carried out without an axis motion command (axis at a standstill), homing 
will be executed upon the next rising or falling edge at the homing switch.

 

Configuration - Homing - Active
Configure the necessary parameters for active homing in the "Active homing" configuration 
window. Active homing is started using Motion Control instruction "MC_Home" with input 
parameter "Mode" = 3.  
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Homing switch input 
Select the digital input for the homing switch from the drop-down list. The input must be 
interrupt-capable. The on-board CPU inputs and the inputs of an inserted signal board can be 
selected as inputs for the homing switch.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default.

When the digital inputs are used as a homing switch, this can result in undesired decelerations 
and thus inaccuracies. Depending on the homing velocity and extent of the homing switch, 
the home position may not be detected. The filter time can be set under "Input filter" in the 
device configuration of the digital inputs.

The specified filter time must be less than the duration of the input signal at the homing switch.
 

Active level
In the drop-list, select the level of the homing switch that is to be used for homing.

Allowing direction reversal at the hardware limit switch  
Activate the check box to use the hardware limit switch as a reversing cam for the homing 
procedure. The hardware limit switches must be enabled for the reversal of direction (at least 
the hardware limit switch in the direction of approach must be configured).

If the hardware limit switch is reached during active homing, the axis brakes at the configured 
deceleration (not with the emergency stop deceleration) and reverses direction. The homing 
switch is then sensed in reverse direction.

If the direction reversal is not active and the axis reaches the hardware limit switch during 
active homing, the homing procedure is aborted with an error and the axis is braked at the 
emergency stop deceleration.

 

 Note

If possible, use one of the following measures to ensure that the machine does not travel to 
a mechanical endstop in the event of a direction reversal:
● Keep the approach velocity low.
● Increase the configured acceleration/deceleration.
● Increase the distance between the hardware limit switch and the mechanical endstop.

 

Approach/homing direction  
With the direction selection, you determine the approach direction used during active homing 
to search for the homing switch, as well as the homing direction. The homing direction specifies 
the travel direction the axis uses to approach the configured end of the homing switch to carry 
out the homing operation.
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Side of the homing switch  
This is where you select whether the axis is to be homed on the low or high end of the homing 
switch.

Approach velocity
In this box, specify the velocity at which the homing switch is to be searched for during the 
homing procedure.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ approach velocity ≤ maximum velocity

Homing velocity  
In this box, specify the velocity at which the homing switch is to be approached for homing.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ Homing velocity ≤ Maximum velocity

Home position offset  
If the desired home position deviates from the position of the homing switch, the home position 
offset can be specified in this box. 

If the value does not equal 0, the axis executes the following actions following homing at the 
homing switch:

1. Move the axis at the homing velocity by the value of the home position offset

2. Upon reaching the "home position offset", the axis is at the home position that was specified 
in input parameter "Position" of the "MC_Home" Motion Control instruction.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ home position offset ≤ 1.0e12

Home position  
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.

Sequence - Passive homing
Passive homing is started with Motion Control instruction "MC_Home" (input parameter 
Mode  = 2). Input parameter "Position" specifies the absolute reference point position.   

The diagram below shows an example of a characteristic curve for passive homing with the 
following configuration parameters:
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● "Reference point switch side" = "High side"

Movement towards reference point switch (red section of curve)
The Motion Control instruction "MC_Home" does not itself carry out any homing motion when 
passive homing is started. The travel required for reaching the reference point switch must be 
implemented by the user via other motion control instructions such as "MC_MoveRelative". 
The tag <axis name>.StatusBits.HomingDone remains TRUE during passive homing if the 
axis has already been homed. 

Axis homing (transition from red to green section of curve)
The axis is homed when the configured side of the reference point switch is reached. The 
current position of the axis is set to the reference point position. This is specified at the 
"Position" parameter of the "MC_Home" Motion Control instruction. The variable <axis 
name>.StatusBits.HomingDone will be set to "TRUE" if the axis has not been been homed 
before. The travel previously started is not cancelled.

Movement beyond reference point switch (green section of curve)
Following homing at the reference point switch, the axis continues and completes the 
previously started travel with the corrected axis position.
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Sequence - Active homing
You start active homing with motion control instruction "MC_Home" (input parameter 
Mode = 3). The "Position" input parameter specifies the absolute home position. Alternatively, 
you can start active homing on the axis command table for test purposes. 

The diagram below shows an example of a characteristic curve for an active reference point 
approach with the following configuration parameters:

● "Approach/homing direction" = "Positive direction"

● "Side of the homing switch" = "Top side"

● Value of "home position offset" > 0

Search for homing switch (blue curve section)
When active homing starts, the axis accelerates to the configured "approach velocity" and 
searches at this velocity for the homing switch. The tag <axis name>.StatusBits.HomingDone 
is set to FALSE.

Reference point approach (red curve section)
When the homing switch is detected, the axis in this example brakes and reverses, to be homed 
to the configured side of the homing switch at the configured homing velocity. Homing causes 
the tag <axis name>.StatusBits.HomingDone to change to TRUE.

Travel to home position offset (green curve segment)
After homing, the axis moves at the homing velocity along the path to the home position offset. 
There the axis is at the homing point position that was specified in input parameter "Position" 
of the "MC_Home" Motion Control instruction.
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See also
Configuration - Homing - General (Axis technology object V2...3) (Page 7968)

Changing the homing configuration in the user program
With positioning axis technology object as of V2, you can change the following configuration 
parameters during runtime of the user program in the CPU: 

Passive homing
You can change the end of the homing switch for passive homing during the user program 
runtime. Use the following technology object tag for this purpose:

● <Axis name>.Sensor[1].PassiveHoming.SideInput
for changing the end of the homing switch

Refer to the description of the technology object tags (Page 7938) in the appendix for 
information on when changes to the configuration parameter take effect.

Active homing
You can change the direction of approach, the end of the homing switch, the approach velocity, 
the homing velocity, and the home position offset for active homing during the program runtime 
of the user program. Use the following technology object tags for this purpose:

● <Axis name>.Homing.AutoReversal 
for changing the auto reverse at the HW limit switch

● <Axis name>.Homing.ApproachDirection 
for changing the approach/homing direction

● <Axis name>.Sensor[1].ActiveHoming.SideInput 
for changing the end of the homing switch

● <Axis name>.Homing.ApproachVelocity 
for changing the approach velocity

● <Axis name>.Homing.ReferencingVelocity 
for changing the homing velocity

● <Axis name>.Sensor[1].ActiveHoming.HomePositionOffset
for changing the home position offset

Refer to the description of the technology object tags in the appendix for information on when 
changes to the configuration parameter take effect.

See also
Compatibility list of tags (Page 7815)

MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964)
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11.2.6 Technology object command table

11.2.6.1 Use of the command table technology object
The Motion Control instruction "Command table" allows you to combine multiple individual axis 
control commands in one movement sequence. The technology object can be used with 
technology version as of V2.  

You configure the movement sequence as a table in a configuration dialog.

The motion profile of the movement sequences can be checked on a graph before the project 
is loaded to the CPU. The command tables created are then linked to an axis and used in the 
user program with the "MC_CommandTable" Motion Control instruction. You can process part 
or all of the command table.

11.2.6.2 Command table technology object tools
The "Configuration" tool is provided in the TIA Portal for the "Command Table" technology 
object. The representation below shows the interaction of the tool with the technology object:  

① Writing and reading the configuration of the technology object
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Configuration
Configure the following properties of the "Command Table" technology object with the 
"Configuration" tool:

● You can create one or more movement sequences by configuring individual jobs.

● You can configure the graphic display to check your movement sequence using an axis 
already configured or a configurable default axis.

The movement sequence data are saved in the data block of the technology object. 

11.2.6.3 Adding the technological object command table

Requirements
● A project with a CPU S7-1200 has been created.

● The CPU firmware version is V2.1 or higher

Procedure
Proceed as follows to add a "Command table" technology object in the project tree:

1. Open the "CPU > Technology objects" folder in the project tree.

2. Double-click the "Add new object" command. 
The "Add new object" dialog opens.

3. Select the "Motion Control" technology.

4. Open the "Motion Contro > S7-1200 Motion Control" folder.

5. Select the desired technology version in the "Version" column.

6. Select the "TO_CommandTable" object.

7. Enter the name of the command table in the "Name" input box.

8. To change the automatically assigned data block number, select the "Manual" option.

9. To display additional information about the technology object, click "Additional information".

10.Confirm your entry with "OK".

Result
The new technology object is created and saved to the "Technology objects" folder in the 
project tree.

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
7850 System Manual, 02/2014



11.2.6.4 Configuring the command table technology object

Working with the configuration dialog
You configure the properties of the technology object in the configuration window. Proceed as 
follows to open the configuration window of the technology object:

1. Open the group of the required technology object in the project tree.

2. Double-click the "Configuration" object.

The configuration is divided into the following categories:

● Basic parameters 
The basic parameters contain all parameters which must be configured for a functional 
command table.

● Extended parameters 
The extended parameters contain the parameters of the default axis or display the 
parameter values of the axis selected.

Configuration window icons  
Icons in the area navigation of the configuration show additional details about the status of the 
configuration:

The configuration contains default values and is complete.
The configuration contains only default values. With these default values, you can use the technology object without 
additional changes.
The configuration contains values set by the user and is complete.
All input fields of the configuration contain valid values and at least one preset value has changed.
The configuration is incomplete or incorrect
At least one input field or drop-down list contains an invalid value. The corresponding field or the drop-down list is 
displayed on a red background. Click the roll-out error message to display the cause of the error.
The configuration contains mutually incompatible parameter values
The configuration contains parameter values that contradict each other either in size or logic. The corresponding field 
or the drop-down list is displayed on a yellow background.

See also
Guidelines on use of motion control (Page 7812)

Basic parameters (Page 7854)

Extended parameters (Page 7867)
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Compare values
The "Compare values" function provides the following options: 

● Comparison of configured start values of the project with the start values in the CPU and 
the actual values

● Direct editing of actual values and the start values of the project

● Immediate detection and display of input errors with suggested corrections

● Backup of actual values in the project

● Transfer of start values of the project to the CPU as actual values

Icons and operator controls
The following icons and operator controls are available:

Icon Function
Start value in CPU matches the configured Start value in the project

Start value in CPU does not match the configured Start value in the project

The comparison of the Start value in CPU with the configured Start value in the project 
cannot be performed
Backs up the actual values in the project

Transfers updated start values in the project to the CPU (initialize setting values)

Opens the "Compare values" dialog

Basic parameters

Configuration - General
Configure the name of the technology object in the "General" configuration window. 

Name
Define the name of the command table or the name of the "Command table" technology object 
in this field. The technology object will be listed under this name in the project tree.

See also
Configuration - Command table (Page 7855)

Shortcut menu commands - Command table (Page 7858)

Working with the trend diagram (Page 7859)

Shortcut menu commands - Curve chart (Page 7863)
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Transition from "Complete command" to "Blend motion" (Page 7864)

Changing the command table configuration in the user program (Page 7866)

Configuration - Command table
Create the desired movement sequence in the "Command Table" configuration window and 
check the result against the graphic view in the trend diagram.   

 

 Note

Small deviations are possible between the time behavior and position in the trend shown and 
the real movement of the axis. Movements in response to software limit switches being 
reached are not shown.

 

Activate warnings   
Activate the display of warnings in the command table with this checkbox.

Use axis parameters of   
From the drop-down list, select which axis parameters are to be used for selecting the graphic 
view of and checking the movement sequence. Select "Default axis" if you have yet to add an 
axis to the "Technology object" folder or wish to use value which have not been configured in 
any of the available axes. You configure the properties of the default axis under "Advanced 
parameters".

The axis parameters of the axis selected at the "Axis" parameter are used to process the 
command table in the user program.

Column: Step
Shows the step number of the command.

Column: Command type   
In this column, select the command types which are to be used for processing the command 
table. Up to 32 commands can be entered. The commands will be processed in sequence. 
You can choose between the following entries and command types:

● Empty
The entry serves as a placeholder for any commands to be added. The empty entry is 
ignored when the command table is processed.

● Halt
Stop axis 
(the command only takes effect after a "Velocity set point" command)

● Positioning Relative
Position axis relatively
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● Positioning Absolute
Position axis absolutely

● Velocity set point
Move axis at set velocity

● Wait
Waits until the given period is over. Wait does not stop active traversing.

● Separator
Adds a Separator line above the selected line. The Separator line acts as a range limit for 
the graphic display of the trend view. 
Use the Separator lines if you wish to process parts of the command table.

Column: Position   
Enter the position or travel path for the selected command in this column:

● Command "Positioning Relative"
The command will move the axis by the the given travel path.

● Command "Positioning Absolute"
The command will move the axis by the the given position.

● Separator
The value given specifies the start position for the graphic display.

Limit values (independent of the selected user unit):

● -1.0e12 ≤ position / distance ≤ -1.0e-12

● 1.0e-12 ≤ position / distance ≤ 1.0e12

● Position / travel path = 0.0

Column: Velocity   
In this column, you enter the velocity for the selected command:

● Command "Positioning Relative"
The command will move the axis at the the given velocity.
The given velocity will not be reached if the travel path selected is not large enough.

● Command "Positioning Absolute"
The command will move the axis at the the given velocity.
The given velocity will not be reached if the target position is too close to the starting position.

● Command " Velocity set point"
The command will move the axis at the the given velocity.
The given velocity will not be reached during the command if too short a runtime is selected.

Limit values (independent of the selected user unit):
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● For the commands: "Positioning Relative" and "Positioning Absolute"

– 1.0e-12 ≤ velocity ≤ 1.0e12

● For the command: "Velocity set point"

– -1.0e12 ≤ velocity ≤ -1.0e-12

– 1.0e-12 ≤ velocity ≤ 1.0e12

– Velocity = 0.0

Column: Duration   
Enter the duration of the selected command in this column:

● Command " Velocity set point"
The command will move the axis for the specified duration. The duration includes both the 
acceleration phase and the constant travel phase. The next command will be processed 
once the duration is over.

● Command "Wait"
Waits until the given duration is over.

Limit values (independent of the selected user unit):

● 0.001s ≤ duration ≤ 64800s

Column: Next step   
Select the mode of transition to the next step from the drop-down list:

● Complete command
The command will be completed. The next command will be processed immediately.

● Blend motion
The motion of the current command will be blended with the motion of the following 
command. The transition mode "Blend motion" is available with command types 
"Positioning Relative" and "Positioning Absolute".
Motion will be blended with motions of the following command types:

– Positioning Relative

– Positioning Absolute

– Velocity set point

No blending occurs with other command types.

For the exact behavior of the axis when a command is appended or overlapped, see: Transition 
from "Complete command" to "Blend motion" (Page 7864) 

Column: Step code   
Enter a numerical value / bit pattern in this column which is to be output at the "StepCode" 
output parameter of the "MC_CommandTable" Motion Control instruction while the command 
is being processed.

Limit values:
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● 0 ≤ code number ≤ 65535

 

See also
Configuration - General (Page 7852)

Shortcut menu commands - Command table (Page 7858)

Working with the trend diagram (Page 7859)

Shortcut menu commands - Curve chart (Page 7863)

Transition from "Complete command" to "Blend motion" (Page 7864)

Changing the command table configuration in the user program (Page 7866)

Shortcut menu commands - Command table
The following shortcut menu commands are available in the command table:   

Insert empty line  
Adds an empty line above the selected line.

This shortcut menu command can only be executed if there are enough empty lines at the end 
of the command table.

Add empty line  
Adds an empty line below the selected line.

This shortcut menu command can only be executed if there are enough empty lines at the end 
of the command table.

Insert separator line  
Adds a separator line above the selected line.

You cannot have two consecutive separator lines.

Add separator line  
Adds a separator line below the selected line.

You cannot have two consecutive separator lines, nor can you add a separator line at the end 
of the command table.

Cut
Removes the selected lines or content of the selected cell and saves them/it in the clipboard.

Selected lines will be deleted and the subsequent lines of the command table shifted up.
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Copy
Copies the selected lines or content of the selected cell and saves them/it in the clipboard.

Paste
● Selected lines:

Pastes the lines from the clipboard into the table above the selected line.

● Selected cell:
Pastes the content of the clipboard into the selected line.

This shortcut menu command can only be executed if there are enough empty lines at the end 
of the command table.

Replace
Replaces the selected lines with the lines in the clipboard.

Delete
Deletes the selected lines. The lines below in the command table shift up.

 

See also
Configuration - General (Page 7852)

Configuration - Command table (Page 7853)

Working with the trend diagram (Page 7859)

Shortcut menu commands - Curve chart (Page 7863)

Transition from "Complete command" to "Blend motion" (Page 7864)

Changing the command table configuration in the user program (Page 7866)

Working with the trend diagram
The following tools and information are available in the trend view.
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Trend view and components

① Trend view
② Position curve
③ Velocity curve 
④ Curve section of a selected command
⑤ Ruler
⑥ Ruler position marking
⑦ Software limit switch position
⑧ Start/stop velocity
⑨ Position axis scale range
⑩ Time axis scale range
⑪ Velocity axis scale range
⑫ Scroll bar, position axis
⑬ Scroll bar time axis
⑭ Scroll bar, velocity axis
⑮ Selecting the grid

Selecting separator sections
If the command table consists of multiple sections separated by separators, you can select 
these sections in the trend view by selecting a command in the section.
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Selecting commands
Commands can be selected in the trend view and in the command table:

● Click on a point on the velocity or position curve in the trend view. The corresponding 
command will be highlighted in the command table.

● Select a command in the command table.
The corresponding section of curve will be highlighted.

Selecting the visible range of the trend view
Follow the steps below to adjust the section of the trend view to be displayed:

Select the scaling in the shortcut menu:

● Scale to curves:
Scales the axes so the position and velocity curves are visible.

● Scale to curves and limits:
Scales the axes so the position and velocity curves, the positions of the activated software 
limit switches and the minimum and maximum velocity limits are visible.

The view selected will be marked in the shortcut menu with a tick.

 

Selecting the section to be shown within the range:
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① Range which the curve values and / or limits are within. (see Selecting in the shortcut menu)
② Selected range to be shown in the trend window.

You set the range with the margin cursor at the right-hand and left-hand margin.

You set the position within range ① with the drag cursor.

You can also define the position by clicking in range ①.

 

Selecting the section to be shown with the mouse:

Drag a section of the trend view by clicking and dragging with the mouse. The section of curve 
selected will be enlarged once you release the mouse.

 

Undoing the last change to the section:

Select the shortcut command "Undo zoom" to undo the last change to the section.

Synchronizing the grid
Click on the axis scales to select whether the grid is to be synchronized with the position axis 
or velocity axis.
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Reading off curve values from the ruler
Activate the ruler using the shortcut menu command "Show ruler". 

You can move the ruler to any point on the curves using the ruler cursor.

See also
Configuration - General (Page 7852)

Configuration - Command table (Page 7853)

Shortcut menu commands - Command table (Page 7856)

Shortcut menu commands - Curve chart (Page 7863)

Transition from "Complete command" to "Blend motion" (Page 7864)

Changing the command table configuration in the user program (Page 7866)

Shortcut menu commands - Curve chart
The following shortcut menu commands are available in the curve window:

Zoom 100%
Selects a zoom factor which will show 100% of the curve values and / or limits.

Undo zoom
Undoes the last zoom change.

Scale to curves
Scales the axes so the position and velocity curves are visible.

Scale to curves and limits
Scales the axes so the position and velocity curves, the positions of the activated software 
limit switches and the minimum and maximum velocity limits are visible.

Show velocity limits
Shows the lines of the velocity limits.
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Show software limit switches
Shows the lines of the software limit switches.

Show ruler
Fades the ruler in / out

Use the ruler when you want to see the individual values of the curves.

See also
Configuration - General (Page 7852)

Configuration - Command table (Page 7853)

Shortcut menu commands - Command table (Page 7856)

Working with the trend diagram (Page 7857)

Transition from "Complete command" to "Blend motion" (Page 7864)

Changing the command table configuration in the user program (Page 7866)

Transition from "Complete command" to "Blend motion"
The charts below show the transition between movements in various different transition modes 
in the "Next step" column:
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Motion transition with preceding positioning jobs
The following diagrams show a command sequence with two motion tasks. The first command 
is for positioning (green). The second command is for velocity (red) or positioning (blue):

Complete job Blend motion
Transition from lower to higher velocity

A job with high velocity is appended to a previous positioning 
job. The positioning job terminates at its target position at 
velocity "0". The second job starts from standstill.

Transition from lower to higher velocity

A job with high velocity is overlapped with a previous 
positioning job. The first positioning job terminates without 
standstill at its target position. The second job starts with the 
new velocity.

Transition from higher to lower velocity

A job with low velocity is appended to a previous positioning 
job. The positioning job terminates at its target position at 
velocity "0". The second job starts from standstill.

Transition from higher to lower velocity

A job with low velocity is overlapped with a previous 
positioning job. The first positioning job terminates without 
standstill at its target position. The first job starts with the new 
velocity.

1. Job "Positioning Relative" or "Positioning Absolute"

2. Job "Velocity set point"
2. Job "Positioning Relative" or "Positioning Absolute"
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Motion transition with preceding velocity jobs
The following diagrams show a command sequence with two motion tasks. The first command 
is for velocity (violet). The second command is for velocity (red) or positioning (blue):

Transition from lower to higher velocity

A job with a high velocity is appended to a previous velocity 
job. The first velocity job ends after the defined runtime. The 
second job starts with the new velocity.

Transition from higher to lower velocity

A command with lower velocity is blended with a previous 
velocity command. The second job starts with the new 
velocity.

1. Job "Velocity set point"

2. Job "Velocity set point"
2. Job "Positioning Relative" or "Positioning Absolute"

See also
Configuration - General (Page 7852)

Configuration - Command table (Page 7853)

Shortcut menu commands - Command table (Page 7856)

Working with the trend diagram (Page 7857)

Shortcut menu commands - Curve chart (Page 7861)

Changing the command table configuration in the user program (Page 7866)

Changing the command table configuration in the user program
You can change the following configuration parameters during runtime of the user program in 
the CPU:

Commands and corresponding values
You can also change the parameters of the command table during the runtime of the user 
program. Use the following technology object tags for this purpose:

● <Table name>.Command[1..32].Type
for changing the command type

● <Table name>.Command[1..32].Position
for changing the position/travel distance
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● <Table name>.Command[1..32].Velocity
for changing the velocity

● <Table name>.Command[1..32].Duration
for changing the duration

● <Table name>.Command[1..32].NextStep
for changing the parameter "Next step"

● <Table name>.Command[1..32].StepCode
for changing the step code

Refer to the description of the technology object tags (Page 7957) in the appendix for 
information on when changes to the configuration parameters take effect.

See also
Compatibility list of tags (Page 7815)

Configuration - General (Page 7852)

Configuration - Command table (Page 7853)

Shortcut menu commands - Command table (Page 7856)

Working with the trend diagram (Page 7857)

Shortcut menu commands - Curve chart (Page 7861)

Transition from "Complete command" to "Blend motion" (Page 7862)

Extended parameters

Chart parameters

Configuration - General
Configure the basic properties of the chart view of the "Command table" technology object in 
the "General" configuration window.

 

 Note

If the default axis has been selected under "Use axis parameters of", the unit of measurement 
can be edited. If a configured axis has been selected, the unit of measurement for this axis 
will be displayed.

 

Use axis parameters of
From the drop-down list, select which axis parameters are to be used for selecting the graphic 
view of and checking the movement sequence. Select "Default axis" if you have yet to add an 
axis to the "Technology object" folder or wish to use values which have not been configured 
in any of the available axes.
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The axis parameters of the axis selected at the "Axis" parameter will be used to process the 
command table in the user program.

Unit of measurement
Enter the unit of measurement for the default axis in this field. If a preconfigured axis has been 
selected under "Use axis parameters of", the unit of measurement configured in these 
parameter will be displayed.

Configuration - Dynamics
Configure the acceleration and deceleration and the jerk limit for the default axis in the 
"Dynamics" configuration window.

 

 Note

If the default axis has been selected under "Use axis parameters of", the following fields can 
be edited. If a configured axis has been selected, the values of this axis will be displayed.

 

Acceleration / deceleration
Set the desired acceleration of the default axis in the "Acceleration" field. The desired 
deceleration can be set in the "Deceleration" field.

Motion jobs configured in the command table will be calculated with the selected acceleration / 
deceleration.

Limit values:

● 1.0e-12 ≤ acceleration ≤ 1.0e12

● 1.0e-12 ≤ deceleration ≤ 1.0e12

Activate jerk limit
Activate the jerk limit with this checkbox.

Step
Set the desired step for ramping up and ramping down in the "Step" field.

Motion jobs configured in the command table will be calculated with the selected step.

Limit values:
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● 1.0e-12 ≤ jerk ≤ 1.0e12

Configuration - Limit values
Configure the maximum velocity, the start/stop velocity and the software limit switches of the 
default axis in the "Limits" configuration window.

 

 Note

If the default axis has been selected under "Use axis parameters of", the following fields can 
be edited. If a configured axis has been selected, the values of this axis will be displayed.

 

Maximum velocity / Start/stop velocity
Define the maximum permissible velocity and the start/stop velocity of the default axis in these 
fields. The start/stop velocity is the minimum permissible velocity of the default axis.

Limit values:

● 1.0e-12 ≤ start/stop velocity ≤ 1.0e12
Start/stop velocity = 0.0

● 1.0e-12 ≤ maximum velocity ≤ 1.0e12
Maximum velocity = 0.0

The value of the maximum velocity must be greater or equal to the value of the start/stop 
velocity.

Enable software limit switches
Activate the function of the low and high software limit switch with this checkbox. Movements 
in response to software limit switches being reached are not shown in the trend view.

Low / high software limit switch
Enter the position value of the low and high software limit switches in these fields.

Limits:

● -1.0e12 ≤ low software limit switch ≤ -1.0e-12
1.0e-12 ≤ low software limit switch ≤ 1.0e12
Low software limit switch = 0.0

● -1.0e12 ≤ high software limit switch ≤ -1.0e-12
1.0e-12 ≤ high software limit switch ≤ 1.0e12
High software limit switch = 0.0

The value of the high software limit switch must be greater than or equal to the value of the 
low software limit switch.
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11.2.7 Download to CPU
When loading to the CPU S7-1200 always ensure that the project files are consistent after the 
online and offline loading. It is not possible to load single blocks. When selecting single blocks, 
all new and modified blocks are always loaded.

The following object groups can be loaded to the CPU:

Context menu command
"Download to device"

Description

All Download all new and modified blocks and a new or modified hardware configuration
Hardware configuration Download a new or modified hardware configuration
Software Download all new and modified blocks
Software (all blocks) Download all blocks

The data of the Motion Control technology objects are saved in the data blocks. The conditions 
for downloading of "blocks" thus apply when loading a new or modified technology object.

 

 CAUTION

Possible malfunctions of the axis when loading without hardware configuration

The hardware configuration is modified when the following modifications are made to the axis 
configuration:
● Modification of the pulse generator (PTO)
● Modification of the HW limit switch address
● Modification of the homing switch address

If the modified configuration of the axis is loaded with the context menu commands "Software" 
or "Software (all blocks)" without downloading the hardware configuration, this can lead to 
malfunctions of the axis.

Ensure that the current hardware configuration is downloaded to the CPU under the 
conditions listed below.

 

Download in CPU S7-1200 RUN operating mode (from firmware version V2.2)
For CPU S7-1200 from firmware version V2.2, when loading in CPU RUN operating mode it 
is checked whether it is possible to load without stopping the CPU.

The following conditions apply when loading data blocks in RUN operating mode:

 Download to load memory Download to work memory
Data block modified values Yes No
Data block modified structure Yes (as of firmware V4) Yes (as of firmware V4)

● When downloading with 
reinitialization 

● For tags in reserve for downloading 
without reinitialization

No (firmware V2.2...3) No (firmware V2.2...3)
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 Download to load memory Download to work memory
New data block Yes Yes
Data block deleted Yes Yes

Also note the following when deleting data blocks and downloading data blocks with 
reinitialization:

● The axis must be locked when downloading a positioning axis technology object.

● When downloading a command table technology object, no MC_CommandTable command 
with this command table must be active (parameter "Busy" = FALSE).

● When downloading an MC_Power instance data block, no MC_Power instruction must be 
active (parameter "Busy" = FALSE).

From technology version V3.0, Motion Control technology objects (data blocks) can also be 
downloaded in CPU RUN operating mode. 

Technology objects after V3.0 cannot be downloaded in CPU RUN operating mode.

Select one of the actions described below to download the modified version of a Motion Control 
technology object (from version V3.0) to the work memory:

● Technology object axis and command table
Change the CPU operating mode from STOP to RUN.

● Technology object axis
Disable the axis and execute a "Restart" using the Motion Control instruction "MC_Reset".

● Technology object command table
Ensure that the command table is not being used. Download the data block of the command 
table to the work memory using the extended instruction "READ_DBL".

See also
Guidelines on use of motion control (Page 7812)

MC_Reset: Acknowledge fault V4 (Page 2940)

11.2.8 Commissioning the axis - Axis control panel
Use the axis command table to move the axis in manual mode, to optimize the axis settings, 
and to test your system.

The axis control table can only be used if an online connection to the CPU is established.
 

 Note
Response times of the axis control panel

The response time during axis control table operation depends on the communication load 
of the CPU. Close all other online windows of the TIA Portal to minimize the response time.
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"Manual control" button
Click "Manual control" to move the axis in manual control mode. Start by disabling the axis in 
the user program using Motion Control instruction "MC_Power". In "Manual control" mode, the 
axis control table takes over control priority for the axis functions. The user program has no 
influence on the axis functions until manual control is ended.

 

 CAUTION

Additional axes in automatic mode

The Manual control is active for one axis only. If additional axes are in automatic mode, 
dangerous situations may arise as a result.

In this happens, disable all other axes.
 

"Automatic mode" button
Click "Automatic mode" to end the "Manual control" mode. The axis control table passes back 
the control priority and the axis can be controlled by the user program again. The axis must 
be re-enabled in the user program and homed, if required.

Complete all active traversing motions before switching to automatic control; otherwise, the 
axis will be braked with the emergency stop deceleration.

"Enable" button
Click "Enable" to enable the axis in "Manual control" mode. When the axis is enabled, the axis 
control panel functions can be used.

If the axis cannot be enabled because certain conditions are not met, note the error message 
in the "Error message" box. Information on eliminating errors is available in the appendix under 
"List of ErrorIDs and ErrorInfos". After the error has been corrected, enable the axis again.

"Disable" button
Click "Disable" if you want to temporarily disable the axis in "Manual control" mode.
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"Command" area
Operation in the "Command" area is only possible if the axis is enabled. You can select one 
of the following command inputs:

● Jogging
This command is equivalent to Motion Control command "MC_MoveJog" in the user 
program.

● Positioning
This command is equivalent to the Motion Control commands "MC_MoveAbsolute" and 
"MC_MoveRelative" in the user program. The axis must be homed for absolute positioning.

● Homing
This command is equivalent to Motion Control command "MC_Home" in the user program.

– The "Set reference point" button corresponds to Mode = 0 (direct homing absolute)

– The "Active homing" button corresponds to Mode = 3 (active homing)

For active homing, the homing switch must be configured in the axis configuration. 
The values for approach velocity, homing velocity, and reference position offset are taken 
from the axis configuration unchanged.

Depending on the selection, the relevant boxes for entry of setpoints and the buttons for starting 
the command are displayed.

Jerk limitation can be activated and deactivated using the "Activate jerk limit" button. By default, 
the jerk is applied with 10% of the configured value. This value can be changed as required.

"Axis status" area
If "Manual control" mode is activated, the current axis status and drive status are shown in the 
"Axis status" area. The current position and velocity of the axis are displayed at "Process 
values".

Click "Acknowledge" to acknowledge all cleared errors.

The "Info message" box displays advanced information about the status of the axis.

"Current values" area
This area displays the current position and velocity of the axis.
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Error message
The "Error message"  box shows the current error. In "Manual control" mode, the error entry 
can be deleted by pressing the "Acknowledge" button once the error is eliminated.

 

 Note
Initial values for velocity, acceleration / deceleration and jerk

For safety reasons, the "Velocity", "Acceleration/deceleration" and "Jerk" parameters are 
initialized with values equivalent to only 10% of the configured values when the axis command 
table is activated. The "Jerk" parameter is only used for technology object "Axis" V2.0 and 
higher.

The values in the configuration view displayed when you select 
"Extended parameters > Dynamics > General" are used for initialization. 

The "Velocity" parameter on the control panel is derived from the "Maximum velocity" and 
the "Acceleration/deceleration" parameters from "Acceleration" in the configuration.

The "Velocity", "Acceleration/deceleration" and "Jerk" parameters can be changed in the axis 
command table; this does not affect the values in the configuration.

 

See also
Guidelines on use of motion control (Page 7812)
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11.2.9 Parameter view

11.2.9.1 Introduction to the parameter view
The Parameter view provides you with a general overview of all relevant parameters of a 
technology object. You obtain an overview of the parameter settings and can easily change 
them in offline and online mode.

①      "Parameter view" tab

②      Toolbar (Page 7720)

③      Navigation (Page 7721)

④      Parameter table (Page 7721)

Function scope
The following functions are available for analyzing the parameters of the technology objects 
and for enabling targeted monitoring and modification.

Display functions:
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● Display of parameter values in offline and online mode

● Display of status information of the parameters

● Display of value deviations and option for direct correction

● Display of configuration errors

● Display of value changes as a result of parameter dependencies

● Display of all memory values of a parameter: Start value PLC, Start value project, Monitor 
value

● Display of the parameter comparison of the memory values of a parameter

Operator control functions:

● Navigation for quickly changing between the parameters and parameter structures.

● Text filter for faster searches for particular parameters. 

● Sorting function for customizing the order of parameters and parameter groups to 
requirements.

● Memory function for backing up structural settings of the Parameter view.

● Monitoring and modifying of parameter values online.

● Function for saving a snapshot of parameter values of the CPU in order to capture 
momentary situations and to respond to them.

● Function for applying a snapshot of parameter values as start values.

● Download of modified start values to the CPU.

● Comparison functions for comparing parameter values with one another.

Validity
The Parameter view is available for the following technology objects:

● PID_Compact

● PID_3Step

● CONT_C (S7-1500 only)

● CONT_S (S7-1500 only)

● TCONT_CP (S7-1500 only)

● TCONT_S (S7-1500 only)

● TO_Axis_PTO (S7-1200 Motion Control)

● TO_Positioning_Axis (S7-1200 Motion Control)

● TO_CommandTable_PTO (S7-1200 Motion Control)

● TO_CommandTable (S7-1200 Motion Control)
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11.2.9.2 Structure of the parameter view

Toolbar
The following functions can be selected in the toolbar of the parameter view.

Icon Function Explanation
Monitor all Starts the monitoring of visible parameters in the active Parameter 

view (online mode).
Create snapshot of 
monitor values and 
accept setpoints of this 
snapshot as start values

Applies the current monitor values to the “Snapshot” column and 
updates the start values in the project.
Only in online mode for PID_Compact and PID_3Step.

Initialize setpoints Transfers the start values updated in the project to the CPU. 
Only in online mode for PID_Compact and PID_3Step.

Create snapshot of 
monitor values

Applies the current monitor values to the “Snapshot” column.
Only in online mode.

Modify all selected 
parameters immediately 
and once

This command is executed once and as quickly as possible without 
reference to any particular point in the user program.
Only in online mode.

Select navigation 
structure

Toggles between functional navigation and data navigation.

Text filter... After entry of a character string: Display of all parameters containing 
the specified string in one of the currently visible columns.

Selection of compare 
values

Selection of parameter values that are to be compared with one 
another in online mode (Start value project, Start value PLC, Snapshot)
Only in online mode.

Save window settings Saves your display settings for the Parameter view (e.g., selected 
navigation structure, activated table columns, etc.)
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Navigation
Within the "Parameter view" tab, the following alternative navigation structures can be selected.

Navigation Explanation
Functional 
navigation

In the functional navigation, the structure of the parameters is based 
on the structure in the configuration dialog ("Functional view" tab), 
commissioning dialog, and diagnostics dialog.
The last group "Other parameters" contains all other parameters of 
the technology object.

Data navigation In the data navigation, the structure of the parameters is based on 
the structure in the instance DB.
The last group "Other parameters" contains the parameters that are 
not contained in the instance DB.

You can use the "Select navigation structure" drop-down list to toggle the navigation structure. 

Parameter table
The table below shows the meaning of the individual columns of the parameter table. You can 
show or hide the columns as required.

● Column "Offline" = X: Column is visible in offline mode.

● Column "Online" = X: Column is visible in online mode (online connection to the CPU).

Column Explanation Offline Online
Name in functional 
view

Name of the parameter in the functional view.
The display field is empty for parameters that are not configured via the 
technology object.

X X

Full name in DB Complete path of the parameter in the instance DB.
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Name in DB Name of the parameter in the instance DB.
If the parameter is part of a structure or UDT, the prefix ". ./" is added. 
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Status of 
configuration

Display of the completeness of the configuration using status symbols.
see Status of configuration (offline) (Page 7729)

X  

Compare result Result of the "Compare values" function. 
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
see Comparing values (Page 7715)

 X
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Column Explanation Offline Online
Start value project Configured start value in the project.

Error indication if entered values have a syntax or process-related error.
X X

Default value Value that is pre-assigned to the parameter.
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Snapshot Snapshot of the current values in the CPU (monitor values).
Error indication if values have a process-related error.

X X

Start value PLC Start value in the CPU. 
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
Error indication if values have a process-related error.

 X

Monitor value Current value in the CPU. 
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
Error indication if values have a process-related error.

 X

Modify value Value that is to be used to change the monitor valuet.
This column is shown if there is an online connection and the "Monitor all" button 

 is selected.
Error indication if entered values have a syntax or process-related error.

 X

Selection for 
transmission

 

Selection of the Modify values that are to be transmitted using the "Modify all 
selected parameters immediately and once" button. 
This column is displayed together with the "Modify value" column.

 X

Minimum value Minimum process-related value of the parameter. 
If the minimum value is dependent on other parameters, it is defined:
● Offline: By the Start value project.
● Online: By the  Monitor values.

X X

Maximum value Maximum process-related value of the parameter. 
If the maximum value is dependent on other parameters, it is defined:
● Offline: By the Start value project.
● Online: By the Monitor values.

X X

Setpoint Designates the parameter as a setpoint. These parameters can be initialized 
online.

X X

Data type Data type of the parameter.
The display field is empty for parameters that are not contained in the instance 
DB.

X X

Retain Designates the value as a retentive value. 
The values of retentive parameters are retained even after the voltage supply 
is switched off. 

X X

Accessible from HMI Indicates whether the HMI can access this parameter during runtime. X X
Visible in HMI Indicates whether the parameter is visible in the selection list of the HMI by 

default.
X X

Comment Brief description of the parameter. X X
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11.2.9.3 Opening the parameter view

Requirement
The technology object has been added in the project tree, i.e., the associated instance DB of 
the instruction has been created.

Procedure
1. Open the "Technology objects" folder in the project tree.

2. Open the technology object in the project tree.

3. Double-click the "Configuration" object.

4. Select the "Parameter view" tab in the top right corner.

Result
The Parameter view opens. Each displayed parameter is represented by one row in the 
parameter table.

The displayable parameter properties (table columns) vary depending on whether you are 
working with the Parameter view in offline or online mode.

In addition, you can selectively display and hide individual table columns. 

See also
Default setting of the parameter view (Page 7723)

11.2.9.4 Default setting of the parameter view

Default settings
To enable you to work efficiently with the Parameter view, you can customize the parameter 
display and save your settings. 

The following customizations are possible and can be saved:

● Show and hide columns

● Change column width

● Change order of the columns

● Toggle navigation

● Select parameter group in the navigation

● Selection of compare values
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Show and hide columns
To show or hide columns in the parameter table, follow these steps:

1. Position the cursor in the header of the parameter table.

2. Select the "Show/Hide" command in the shortcut menu.
The selection of available columns is displayed.

3. To show a column, select the check box for the column.

4. To hide a column, clear the check box for the column.

or

1. Position the cursor in the header of the parameter table.

2. Select the "Show all columns" command in the shortcut menu if all columns of the offline 
or online mode are to be displayed.

Some columns can only be displayed in online mode: see Parameter table (Page 7721).

Change column width
To customize the width of a column so that all texts in the rows can be read, follow these steps:

1. Position the cursor in the header of the parameter table to the right of the column to be 
customized until the shape of the cursor changes to a cross.

2. Then double-click this location.

or

1. Open the shortcut menu on the header of the parameter table.

2. Click 

– "Optimize column width" or

– "Optimize width of all columns".

If the column width setting is too narrow, the complete content of individual fields are shown 
if you hover the cursor briefly over the relevant field.

Change order of the columns
The columns of the parameter table can be arranged in any way. 

To change the order of the columns, follow these steps:
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1. Click on the column header and use a drag-and-drop operation to move it to the desired 
location.
When you release the mouse button, the column is anchored to the new position.

Toggle navigation
To toggle the display form of the parameters, follow these steps:

1. Select the desired navigation in the “Select navigation structure” drop-down list.

– Data navigation

– Functional navigation

See also Navigation (Page 7721).

Select parameter group in the navigation
Within the selected navigation, you choose between the “All parameters” display or the display 
of a subordinate parameter group of your choice.

1. Click the desired parameter group in the navigation.
The parameter table only displays the parameters of the parameter group.

Selection of compare values (online)
To set the compare values for the “Compare values” function, follow these steps:

1. Select the desired compare values in the “Selection of compare values” drop-down list.

– Start value project / Start value PLC

– Start value project / Snapshot

– Start value PLC / Snapshot

The “Start value project / Start value PLC” option is set by default.

Save default setting of the Parameter view
To save the above customizations of the Parameter view, follow these steps:

1. Customize the Parameter view according to your requirements.

2. Click the “Save window settings” button  at the top right of the Parameter view.

11.2.9.5 Working with the parameter view

Overview
The following table provides an overview of the functions of the Parameter view in online and 
offline mode described in the following.

● Column "Offline" = X: This function is possible in offline mode.

● Column "Online" = X: This function is possible in online mode.
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Function/action Offline Online
Filtering the parameter table (Page 7726) X X
Sorting the parameter table (Page 7727) X X
Transferring parameter data to other editors (Page 7727) X X
Indicating errors (Page 7727) X X
Editing start values in the project (Page 7728) X X
Status of configuration (offline) (Page 7729) X  
Monitoring values online in the parameter view (Page 7730)  X
Create snapshot of monitor values (Page 7730)  X
Modifying values (Page 7731)  X
Comparing values (Page 7732)  X
Applying values from the online program as start values (Page 7733)  X
Initializing setpoints in the online program (Page 7734)  X

Filtering the parameter table
You can filter the parameters in the parameter table in the following ways:

● With the text filter

● With the subgroups of the navigation

Both filter methods can be used simultaneously.

With the text filter
Texts that are visible in the parameter table can be filtered. This means only texts in displayed 
parameter rows and columns can be filtered.

1. Enter the desired character string for filtering in the “Text filter...” input box.
The parameter table displays only the parameters containing the character string.

The text filtering is reset.

● When another parameter group is selected in the navigation.

● When navigation is changed from data navigation to functional navigation, or vice versa.

With the subgroups of the navigation
1. Click the desired parameter group in the navigation, e.g., "Static".

The parameter table only shows the static parameters. You can select further subgroups 
for some groups of the navigation.

2. Click “All parameters” in the navigation if all parameters are to be shown again.
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Sorting the parameter table
The values of the parameters are arranged in rows. The parameter table can be sorted by any 
displayed column.

● In columns containing numerical values, sorting is based on the magnitude of the numerical 
value. 

● In text columns, sorting is alphabetical.

Sorting by column
1. Position the cursor in the header cell of the desired column.

The background of this cell turns blue.

2. Click the column header.

Result
The entire parameter table is sorted by the selected column. A triangle with tip facing up 
appears in the column header. 

Clicking the column header again changes the sorting as follows:

● Symbol “▲”: Parameter table is sorted in ascending order.

● Symbol “▼”: Parameter table is sorted in descending order.

● No symbol: The sorting is removed again. The parameter table assumes the default display.

The “../“ prefix in the “Name in DB” column is ignored when sorting.

Transferring parameter data to other editors
After selecting an entire parameter row of the parameter table, you can use the following: 

● Drag-and-drop

● <Ctrl+C>/<Ctrl+V>

● Copy/Paste via shortcut menu 

Transfer parameters to the following editors of the TIA Portal:

● Program editor

● Watch table

● Signal table for trace function

The parameter is inserted with its full name: See information in “Full name in DB” column.

Indicating errors

Error indication
Parameter assignment errors that result in compilation errors (e.g., limit violation) are indicated 
in the Parameter view.
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Every time a value is input in the Parameter view, a check is made for process-related and 
syntax errors and the result is indicated.

Bad values are indicated by:

● Red error symbol in the "Status of configuration" (offline mode) or "Compare result" (online 
mode, depending on the selected comparison type) columns

and/or

● Table field with red background
If you click the bad field, a roll-out error message appears with information of the permissible 
value range or the required syntax (format)

Compilation error
From the error message of the compiler, you can directly open the Parameter view (functional 
navigation) containing the parameter causing the error in situations where the parameter is 
not displayed in the configuration dialog. 

Editing start values in the project
With the Parameter view, you can edit the start values in the project in offline mode and online 
mode.

● You make value changes in the “Start value project” column of the parameter table.

● In the “Status of configuration” column of the parameter table, the progress of the 
configuration is indicated by the familiar status symbols from the configuration dialog of the 
technology object.

Boundary conditions
● If other parameters depend on the parameter whose start value was changed, the start 

value of the dependent parameters are also adapted.

● If a parameter of a technology object is not editable, it is also not editable in the parameter 
view. The ability to edit a parameter can also depend on the values of other parameters.

Defining new start values
To define start values for parameters in the Parameter view, follow these steps:

1. Open the Parameter view of the technology object.

2. Enter the desired start values in the "Start value project" column. The value must match 
the data type of the parameter and must not exceed the value range of the parameter.
The limits of the value range can be seen in the “Maximum value” and “Minimum value” 
columns.

The "Status of configuration" column indicates the progress of the configuration with colored 
symbols.

See also Status of configuration (offline) (Page 7729)

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
System Manual, 02/2014 7883



Following adaptation of the start values and downloading of the technology object to the CPU, 
the parameters take the defined value at startup if they are not declared as retentive (“Retain” 
column).

Error indication
When a start value is input, a check is made for process-related and syntax errors and the 
result is indicated.

Bad start values are indicated by:

● Red error symbol in the "Status of configuration" (offline mode) or "Compare result" (online 
mode, depending on the selected comparison type) columns

and/or

● Red background in the “Start value project” field 
If you click on the bad field, a roll-out error message appears with information of the 
permissible value range or the necessary syntax (format)

Correcting bad start values
1. Correct bad start values using information from the roll-out error message.

Red error symbol, red field background, and roll-out error message are no longer displayed.

The project cannot be successfully compiled unless the start values are error-free.

Status of configuration (offline)
The status of the configuration is indicated by icons:

● In the “Status of configuration” column in the parameter table

● In the navigation structure of the functional navigation and data navigation

Symbol in “Status of configuration” column

Symbol Meaning
The start value of the parameter corresponds to the default value and is valid. A start value has not yet been 
defined by the user.
The start value of the parameter contains a value defined by the user. The start value is different than the 
default value. The start value is error-free and valid.
The start value of the parameter is invalid (syntax or process-related error). 
The input box has a red background. When clicked, the roll-out error message indicates the cause of the 
error.
Only for S7-1200 Motion Control:
The start value of the parameter is valid but contains warnings.
The input box has a yellow background.
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Symbol in the navigation
The symbols in the navigation indicate the progress of the configuration in the same way as 
in the configuration dialog of the technology object.

See Configure technology objects (Page 7711)

Monitoring values online in the parameter view
You can monitor the values currently taken by the parameters of the technology object in the 
CPU (monitor values) directly in the Parameter view.

Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

Procedure
1. Start the monitoring by clicking .

As soon as the Parameter view is online, the following columns are additionally displayed:

– Compare result

– Start value PLC

– Monitor value

– Modify value

– Selection for transmission

The "Monitor value" column shows the current parameter values on the CPU. 
Meaning of the additional columns: see Parameter table (Page 7721)

2. Stop the monitoring by clicking  again.

Display 
All columns that are only available online have an orange background:

● Values in light-orange cells  can be changed.

● Values in cells with a dark orange background  cannot be changed. 

Create snapshot of monitor values
You can back up the current values of the technology object on the CPU (monitor values) and 
display them in the Parameter view.
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Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

Procedure
To show the current parameter values, follow these steps:

1. In the Parameter view, click the “Create snapshot of monitor values" icon .

Result
The current monitor values are transferred once to the "Snapshot" column of the parameter 
table.

You can analyze the values "frozen" in this way while the monitor values continue to be updated 
in the "Monitor values" column.

Modifying values
With the Parameter view, you can modify values of the technology object in the CPU.

You can assign values to the parameter once (Modify value) and modify them immediately. 
The modify request is executed as quickly as possible without reference to any particular point 
in the user program.

 
 

 DANGER

Danger when modifying:

Changing the parameter values while the plant is operating may result in severe damage to 
property and personal injury in the event of malfunctions or program errors. 

Make sure that dangerous states cannot occur before you use the "Modify" function.
 

Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.
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● The “Monitor all” button  is selected.

● The parameter can be modified (associated field in the "Modify value" column has a light-
orange background).

Procedure
To modify parameters immediately, follow these steps:

1. Enter the desired modify values in the “Modify values” column of the parameter table.

2. Check whether the check box for modifying is selected in the "Select for transmission" 
column. 
The modify values and associated check boxes of dependent parameters are automatically 
adapted at the same time.

3. Click the “Modify all selected parameters immediately and once” icon .

The selected parameters are modified once and immediately with the specified values and 
can be monitored in the "Modify values" column. The check boxes for modifying in the 
"Selection for transmission" column are automatically cleared after the modify request is 
complete.

Error indication
When a start value is input, a check is made immediately for process-related and syntax errors 
and the result is indicated.

Bad start values are indicated by:

● Red background in the “Modify value” field 

and

● If you click the bad field, a roll-out error message appears with information of the permissible 
value range or the necessary syntax (format)

Bad modify values
● Modify values with process-related errors can be transmitted.

● Modify values with syntax errors cannot be transmitted.

Comparing values
You can use comparison functions to compare the following memory values of a parameter:

● Start value project

● Start value PLC

● Snapshot
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Requirements
● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

Procedure
To compare the start values on the various target systems, follow these steps:

1. Click the "Selection of compare values" icon .
A selection list containing the comparison options opens:

– Start value project - Start value PLC (default setting)

– Start value project - Snapshot

– Start value PLC - Snapshot

2. Select the desired comparison option.
The selected comparison option is executed as follows:

– A scales symbol appears in the header cells of the two columns selected for comparison.

– Symbols are used in the "Compare result" column to indicate the result of the 
comparison of the selected columns.

Symbol in "Compare result" column

Symbol Meaning
The compare values are equal and error-free.

The compare values are not equal and error-free.

At least one of the two compare values has a process-related or syntax error.

The comparison cannot be performed. At least one of the two compare values is not available (e.g., 
snapshot).

Symbol in the navigation
The symbols are shown in the same way in the navigation if the comparison result applies to 
at least one of the parameters below the displayed navigation structure.

Applying values from the online program as start values
In order to apply optimized values from the CPU to the project as start values, you create a 
snapshot of the monitor values. Values of the snapshot marked as a "Setpoint" are then applied 
to the project as start values.
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Requirements
● The technology object is of type "PID_Compact" or "PID_3Step".

● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

Procedure
To apply optimized values from the CPU, follow these steps:

1. Click the "Create snapshot of monitor values and accept setpoints of this snapshot as start 
values" icon .

Result
The current monitor values are applied to the "Snapshot" column and their setpoints are copied 
to the "Start value project" column as new start values.

 
 

 Note
Applying values of individual parameters 

You can also apply the values of individual parameters that are not marked as a setpoint from 
the "Snapshot" column to the "Start values project" column. To do so, copy the values and 
insert them into the "Start value project" column using the "Copy" and "Paste" commands in 
the shortcut menu. 

 

Initializing setpoints in the online program
You can initialize all parameters that are marked as a "Setpoint" in the Parameter view with 
new values in the CPU in one step. In so doing, the start values are downloaded from the 
project to the CPU. The CPU remains in "RUN" mode. 

To avoid data loss on the CPU during a cold restart or warm restart, you must also download 
the technology object to the CPU. 

 

 DANGER

Danger when changing parameter values

Changing the parameter values while the plant is operating may result in severe damage to 
property and personal injury in the event of malfunctions or program errors.

Make sure that dangerous states cannot occur before you reinitialize the setpoints.
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Requirements
● The technology object is of type "PID_Compact" or "PID_3Step".

● There is an online connection.

● The technology object is downloaded to the CPU.

● The program execution is active (CPU in "RUN").

● The Parameter view of the technology object is open.

● The “Monitor all” button  is selected.

● The parameters marked as a "Setpoint" have a "Start value project" that is free of process-
related and syntax errors

Procedure
To initialize all setpoints, follow these steps:

1. Enter the desired values in the "Start value project" column.
Ensure that the start values are free of process-related and syntax errors. 

2. Click the "Initialize setpoints" icon .

Result
The setpoints in the CPU are initialized with the start values from the project.

11.2.10 Programming

11.2.10.1 Overview of the Motion Control statements
You control the axis with the user program using Motion Control instructions. The instructions 
start Motion Control commands that execute the desired functions.

The status of the Motion Control commands and any errors that occur during their execution 
can be obtained from the output parameters of the Motion Control instructions. The following 
Motion Control instructions are available:

● MC_Power: Enable, disable axis V4 (Page 2936) 

● MC_Reset: Acknowledge fault V4 (Page 2940) 

● MC_Home: Home axes, set reference point V4 (Page 2942) 

● MC_Halt: Halt axes V4 (Page 2945) 

● MC_MoveAbsolute: Absolute positioning of axes V4 (Page 2948) 

● MC_MoveRelative: Relative positioning of axes V4 (Page 2951) 

● MC_MoveVelocity: Move axes at preset rotational speed V4 (Page 2955) 

● MC_MoveJog: Move axes in jog mode V4 (Page 2959) 

● MC_CommandTable: Run axis commands as motion sequence V4 (Page 2962) 
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● MC_ChangeDynamic: Change dynamic settings of axis V4 (Page 2964) 

● MC_ReadParam: Continuously read motion data of a positioning axis V4 (Page 2966)

● MC_WriteParam: Write tag of positioning axis V4 (Page 2968)

See also
Creating a user program (Page 7893)

Programming notes (Page 7896)

Behavior of the Motion Control commands after POWER OFF and restart (Page 7898)

Monitoring active commands (Page 7898)

Error displays of the Motion Control statements (Page 7909)

11.2.10.2 Creating a user program
In the section below you learn how to create a user program with the basic configuration for 
controlling your axis. All available axis functions are controlled using the Motion Control 
instructions to be inserted.

Requirement
● The technology object has been created and configured without errors.

Before creating and testing the user program, it is advisable to test the function of the axis and 
the corresponding parts of the system with the axis command table.

Procedure
Proceed as follows to create the user program in accordance with the principles described 
below:

1. In the project tree, double-click your code block (the code block must be called in the cyclic 
program).
The code block is opened in the programming editor and all available instructions are 
displayed.

2. Open the "Technology" category and the "Motion Control" and "S7-1200 Motion Control" 
folders.

3. Use a drag-and-drop operation to move the "MC_Power" instruction to the desired network 
of the code block.
The dialog box for defining the instance DB opens.

4. In the next dialog box, select from the following alternatives:
Single instance
Click "Single instance" and select whether you want to define the name and number of the 
instance DB automatically or manually.
Multi-instance
Click "Multi-instance" and select whether you want to define the name of the multi-instance 
automatically or manually.
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5. Click "OK".
The Motion Control instruction "MC_Power" is inserted into the network.

Parameters marked with "<???>" must be initialized; all other parameters are assigned 
default values.
Parameters displayed in black are required for use of the Motion Control instruction.
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6. Select technology object in the project tree and drag-and-drop it on <???>.

Following selection of the technology object data block, the following buttons are available:

Click the stethoscope icon if you want to open the diagnostics dialog for the technology 
object.

Click the toolbox icon if you want to open the configuration view of the technology object.

Click the arrow down icon to view additional parameters of the Motion Control instruction.

The grayed-out parameters now visible can be used optionally.

7. Add your choice of Motion Control instructions in accordance with steps 3 to 6.

Result
You have created the basic configuration for axis control in the user program.
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Initialize the input parameters of Motion Control instructions in other parts of the user program 
to initiate the desired jobs for the "Axis" technology object.

Evaluate the output parameters of the Motion Control instructions and the tags of the data 
block to track the initiated jobs and the status of the axis.

Refer to the detailed description for details on the parameters of Motion Control instructions.

See also
Overview of the Motion Control statements (Page 7890)

Programming notes (Page 7896)

Behavior of the Motion Control commands after POWER OFF and restart (Page 7898)

Monitoring active commands (Page 7898)

Error displays of the Motion Control statements (Page 7909)

11.2.10.3 Programming notes
When creating your user program, note the following information:

● Cyclic call of utilized motion control instructions
The current status of command execution is available via the output parameters of the 
motion control instruction. The status is updated with every call of the motion control 
instruction. Therefore, make sure that the utilized motion control instructions are called 
cyclically.

● Transfer of parameter values of a motion control instruction
The parameter values pending for the input parameters are transferred with a positive edge 
at input parameter "Execute" when the block is called.
The motion control command is started with these parameter values. Parameter values 
that are subsequently changed for the motion control instruction are not transferred until 
the next start of the motion control command.
Exceptions to this are input parameters "StopMode" of motion control instruction 
"MC_Power" and "Velocity" of motion control instruction "MC_MoveJog". A change in the 
input parameter is also applied when "Enable" = TRUE, or "JogForward" and 
"JogBackward". .
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● Programming under consideration of the status information
In a stepwise execution of motion control jobs, make sure to wait for the active command 
to finish before starting a new command. Use the status messages of the motion control 
instruction and the "StatusBits" tag of the technology object to check for completion of the 
active command.
In the examples below, observe the indicated sequence. Failure to observe the sequence 
will display an axis or command error.

– Axis enable with motion control instruction "MC_Power"
You must enable the axis before it can take on motion jobs. Use an AND operation of 
tag <Axis name>.StatusBits.Enable = TRUE with output parameter Status = TRUE  of 
motion control instruction "MC_Power" to verify that the axis is enabled.

– Acknowledge error with motion control instruction "MC_Reset"
Prior to starting a motion control command, errors requiring acknowledgement must be 
acknowledged with "MC_Reset". Eliminate the cause of the error and acknowledge the 
error with motion control instruction "MC_Reset". Verify that the error has been 
successfully acknowledged before initiating a new command. For this purpose, use an 
AND operation of tag <Axis name>.StatusBits.Error = FALSE with output parameter 
Done = TRUE  of motion control instruction "MC_Reset".

– Home axis with motion control instruction "MC_Home"
Before you can start an MC_MoveAbsolute command, the axis must be homed. Use an 
AND operation of tag <Axis name>.StatusBits.HomingDone = TRUE with output 
parameter Done = TRUE  of motion control instruction "MC_Home" to verify that the 
axis has been homed.

● Override of motion control command processing
Motion control jobs for moving an axis can also be executed as overriding jobs.
If a new motion control command is started for an axis while another motion control 
command is active, the active command is overridden by the new command before the 
existing command is completely executed. The overridden command signals this using 
CommandAborted = TRUE in the motion control instruction. It is possible to override an 
active MC_MoveRelative command with a MC_MoveAbsolute command.

● Avoiding multiple use of the same instance
All relevant information of a motion control command is stored in its instance.
Do not start a new command using this instance, if you want to track the status of the current 
command. Use different instances if you want to track the commands separately. If the 
same instance is used for multiple motion control commands, the status and error 
information of the individual commands will overwrite each other. 

● Call of motion control instructions in different priority classes (run levels)
Motion Control instructions with the same instance may not be called in different priority 
classes without interlocking. To learn how to call locked motion control instructions, refer 
to "Tracking commands from higher priority classes (run levels) (Page 7919)".

See also
Overview of the Motion Control statements (Page 7890)

Creating a user program (Page 7891)

Behavior of the Motion Control commands after POWER OFF and restart (Page 7898)

Monitoring active commands (Page 7898)
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Error displays of the Motion Control statements (Page 7909)

Tracking jobs from higher priority classes (execution levels) (Page 7919)

11.2.10.4 Behavior of the Motion Control commands after POWER OFF and restart
A POWER OFF or CPU-STOP aborts all active motion control jobs. All CPU outputs, including 
pulse and direction outputs, are reset.

After a subsequent POWER ON or CPU restart (CPU RUN), the technology objects and the 
motion control jobs will be reinitialized. 

All actual data of the technology objects as well as all status and error information of the 
previously active motion control jobs are reset to their initial values. 

Before the axis can be reused, it must be enabled again using the Motion Control instruction 
"MC_Power". If homing is required, the axis must be homed again with Motion Control 
instruction "MC_Home".

See also
Overview of the Motion Control statements (Page 7890)

Creating a user program (Page 7891)

Programming notes (Page 7894)

Monitoring active commands (Page 7898)

Error displays of the Motion Control statements (Page 7909)

11.2.10.5 Monitoring active commands

Monitoring active commands
There are three typical groups for tracking active Motion Control commands:

● Motion control instructions with output parameter "Done"

● Motion control instruction "MC_MoveVelocity"

● Motion control instruction "MC_MoveJog"

Motion control instructions with "Done" output parameter 
Motion control instructions with the output parameter "Done" are started via input parameter 
"Execute" and have a defined conclusion (for example, with Motion Control instruction 
"MC_Home": Homing was successful). The command is complete and the axis is at a standstill. 

The commands of the following Motion Control instructions have a defined conclusion:

● MC_Reset

● MC_Home

● MC_Halt
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● MC_MoveAbsolute

● MC_MoveRelative

● MC_CommandTable (technology object as of V2)

● MC_ChangeDynamic (technology object as of V2)

● MC_WriteParam (as of technology object V4)

● MC_ReadParam (as of technology object V4)

The output parameter "Done" indicates the value TRUE, if the command has been successfully 
completed.

The output parameters "Busy", "CommandAborted", and "Error" signal that the command is 
still being processed, has been aborted or an error is pending. The Motion Control instruction 
"MC_Reset" cannot be aborted and thus has no "CommandAborted" output parameter. The 
Motion Control instruction "MC_ChangeDynamic" is completed immediately and therefore has 
no "Busy" or "CommandAborted" output parameters.

During execution of the Motion Control command, the output parameter "Busy" indicates the 
value TRUE. If the command has been completed, aborted, or stopped by an error, the output 
parameter "Busy" changes its value to FALSE. This change occurs regardless of the signal at 
input parameter "Execute". 

Output parameters "Done", "CommandAborted", and "Error" indicate the value TRUE for at 
least one cycle. These status messages are latched while input parameter "Execute" is set to 
TRUE.

The behavior of the status bits is presented below for various example situations:
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Complete execution of command
If the Motion Control command has been completely executed by the time of its conclusion, 
this is indicated by the value TRUE in output parameter "Done". The signal status of the input 
parameter "Execute" influences the display duration at the output parameter "Done":

"Execute" changes its value to FALSE during processing of 
the command

"Execute" changes its value to FALSE after completion of the 
command

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after 
completion of the command.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ With conclusion of the command (for example, for Motion Control instruction "MC_Home": Homing was successful), 

output parameter "Busy" changes to FALSE and "Done" to TRUE.
④ If "Execute" retains the value TRUE until after completion of the command, then "Done" also remains TRUE and changes 

its value to FALSE together with "Execute".
⑤ If "Execute" has been set to FALSE before the command is complete, "Done" indicates the value TRUE for only one 

execution cycle.
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Abort command
If the Motion Control command is aborted during execution, this is indicated by the value TRUE 
in output parameter "CommandAborted". The signal status of the input parameter "Execute" 
influences the display duration at the output parameter "CommandAborted":

"Execute" changes its value to FALSE before the command 
is aborted.

"Execute" changes its value to FALSE after the command is 
aborted.

Abort Abort

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after 
completion of the command.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ During command execution, the command is aborted by another Motion Control command. If the command is aborted, 

output parameter "Busy" changes to FALSE and "CommandAborted" to TRUE.
④ If "Execute" retains the value TRUE until after the command is aborted, then "CommandAborted" also remains TRUE 

and changes its value to FALSE together with "Execute".
⑤ If "Execute" has been set to FALSE before the command is aborted, "CommandAborted" indicates the value TRUE for 

only one execution cycle.
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Error during command execution
If an error occurs during execution of the Motion Control command, this is indicated by the 
value TRUE in the output parameter "Error". The signal status of the input parameter "Execute" 
influences the display duration at the output parameter "Error":

"Execute" changes its value to FALSE before the error occurs "Execute" changes its value to FALSE after the error occurs
Error Error

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after 
completion of the command.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ An error occurred during command execution. When the error occurs, the output parameter "Busy" changes to FALSE 

and "Error" to TRUE.
④ If "Execute" retains the value TRUE until after the error occurs, then "Error" also remains TRUE and only changes its 

value to FALSE together with "Execute".
⑤ If "Execute" has been set to FALSE before the error occurs, "Error" indicates the value TRUE for only one execution 

cycle.

Motion control instruction MC_MoveVelocity
A "MC_MoveVelocity" command is started with a positive edge at the "Execute" parameter. 
The command objective is fulfilled when the assigned velocity is reached and the axis travels 
at constant velocity. When the assigned velocity is reached and maintained, this is indicated 
in the "InVelocity" parameter with the value TRUE. 

The motion of the axis can, for example, be stopped with an "MC_Halt" command.

The output parameters "Busy", "CommandAborted", and "Error" signal that the command is 
still being processed, has been aborted or an error is pending.
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During execution of the Motion Control command, the output parameter "Busy" indicates the 
value TRUE. If the command has been stopped by another command or by an error, the output 
parameter "Busy" changes its value to FALSE. This change occurs regardless of the signal at 
the input parameter "Execute".

The output parameters "CommandAborted" and "Error" show the value TRUE for at least one 
cycle. These status messages are latched while input parameter "Execute" is set to TRUE.

The behavior of the status bits is presented below for various example situations:

The parameterized velocity is reached
If the Motion Control command has been executed by the time the parameterized velocity is 
reached, this is indicated by the value TRUE in output parameter "InVelocity". The parameter 
"Execute" has no effect on the indication duration in the "InVelocity" parameter.

① The job is started with a positive edge at the "Execute" parameter. Depending on the programming, "Execute" can be 
reset to the FALSE value before or after the parameterized velocity has been reached. While the job is active, the 
parameter "Busy" shows the value TRUE.

② When the assigned velocity is reached, the "InVelocity" parameter changes to TRUE. The "Busy" and "InVelocity" 
parameters retain the TRUE value until the "MC_MoveVelocity" command is overridden by another Motion Control 
command or stopped by an error.

The command is aborted prior to reaching the parameterized velocity
If the Motion Control command is aborted before the parameterized velocity is reached, this 
is indicated by the value TRUE in output parameter "CommandAborted". The signal status of 
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input parameter "Execute" influences the display duration at the output parameter 
"CommandAborted".

"Execute" changes its value to FALSE before the command 
is aborted.

"Execute" changes its value to FALSE after the command is 
aborted.

Abort Abort

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after the 
command is aborted.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ During command execution, the command is aborted by another Motion Control command. If the command is aborted, 

output parameter "Busy" changes to FALSE and "CommandAborted" to TRUE.
④ If "Execute" retains the value TRUE until after the command is aborted, then "CommandAborted" also remains TRUE 

and changes its status to FALSE together with "Execute".
⑤ If "Execute" has been reset to FALSE before the command is aborted, "CommandAborted" indicates the value TRUE 

for only one execution cycle.
 

 Note

Under the following conditions, an abort is not indicated in output parameter 
"CommandAborted": 

The parameterized velocity has been reached, input parameter "Execute" has the value 
FALSE, and a new Motion Control command is initiated.
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An error has occurred prior to reaching the parameterized velocity
If an error occurs during execution of the Motion Control command before the parameterized 
velocity has been reached, this is indicated by the value TRUE in the output parameter "Error". 
The signal status of the input parameter "Execute" influences the display duration at the output 
parameter "Error":

"Execute" changes its value to FALSE before the error occurs "Execute" changes its value to FALSE after the error occurs
Error Error

① The command is started with a positive edge at the input parameter "Execute". Depending on the programming, 
"Execute" can still be reset to the value FALSE during the command, or the value TRUE can be retained until after the 
error has occurred.

② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ An error occurred during command execution. When the error occurs, the output parameter "Busy" changes to FALSE 

and "Error" to TRUE.
④ If "Execute" retains the value TRUE until after the error has occurred, then "Error" also remains TRUE and only changes 

its status to FALSE together with "Execute".
⑤ If "Execute" has been reset to FALSE before the error occurs, "Error" indicates the value TRUE for only one execution 

cycle.
 

 Note

Under the following conditions, an error is not indicated in output parameter "Error":

The parameterized velocity has been reached, input parameter "Execute" has the value 
FALSE, and an axis error occurs (software limit switch is approached, for example).

The error of the axis is only indicated in the "MC_Power" Motion Control instruction.
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Motion control instruction MC_MoveJog
The commands of Motion Control instruction "MC_MoveJog" implement a jog operation. 

The motion control commands "MC_MoveJog" do not have a defined end. The command 
objective is fulfilled when the parameterized velocity is reached for the first time and the axis 
travels at constant velocity. When the parameterized velocity is reached, this is indicated by 
the value TRUE in output parameter "InVelocity".

The order is complete when input parameter "JogForward" or "JogBackward" has been set to 
the value FALSE and the axis has come to a standstill.

The output parameters "Busy", "CommandAborted", and "Error" signal that the command is 
still being processed, has been aborted or an error is pending.

During processing of the motion control command, the output parameter "Busy" indicates the 
value TRUE. If the command has been completed, aborted, or stopped by an error, the output 
parameter "Busy" changes its value to FALSE.

The output parameter "InVelocity" indicates the status TRUE, as long as the axis is moving at 
the parameterized velocity. The output parameters "CommandAborted" and "Error" indicate 
the status for at least one cycle. These status messages are latched as long as either input 
parameter "JogForward" or "JogBackward" is set to TRUE.

The behavior of the status bits is presented below for various example situations:

The parameterized velocity is reached and maintained
If the motion control command has been executed by the time the parameterized velocity is 
reached, this is indicated by the value TRUE in output parameter "InVelocity".

Jog mode is controlled by input parameter "JogForward" Jog mode is controlled by input parameter "JogBackward".
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① The command is started with a positive edge at the input parameter "JogForward" or "JogBackward".
② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ When the parameterized velocity is reached, the output parameter "InVelocity" changes to TRUE.
④ When the input parameter "JogForward" or "JogBackward" is reset to the value FALSE, the axis motion ends. The axis 

starts to decelerate. As a result, the axis no longer moves at constant velocity and the output parameter "InVelocity" 
changes its status to FALSE.

⑤ If the axis has come to a standstill, the motion control command is complete and the output parameter "Busy" changes 
its value to FALSE.

The command is aborted during execution
If the motion control command is aborted during execution, this is indicated by the value TRUE 
in output parameter "CommandAborted". The behavior is independent of whether or not the 
parameterized velocity has been reached.

Jog mode is controlled by input parameter "JogForward". Jog mode is controlled by input parameter "JogBackward".
Abort Abort

① The command is started with a positive edge at the input parameter "JogForward" or "JogBackward".
② While the command is active, the output parameter "Busy" indicates the value TRUE.
③ During command execution, the command is aborted by another motion control command. If the command is aborted, 

output parameter "Busy" changes to FALSE and "CommandAborted" to TRUE.
④ When the input parameter "JogForward" or "JogBackward" is reset to the value FALSE, the output parameter 

"CommandAborted" changes its value to FALSE.
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 Note

The command abort is indicated in the output parameter "CommandAborted" for only one 
execution cycle, if all conditions below are met:

The input parameters "JogForward" and "JogBackward" have the value FALSE (but the axis 
is still decelerating) and a new motion control command is initiated.

 

 

An error has occurred during command execution
If an error occurs during execution of the motion control command, this is indicated by the 
value TRUE in output parameter "Error". The behavior is independent of whether or not the 
parameterized velocity has been reached.

Jog mode is controlled by input parameter "JogForward". Jog mode is controlled by input parameter "JogBackward".
Error Error

 

① The command is started with a positive edge at the input parameter "JogForward" or "JogBackward".
② While the command is active, the output parameter "Busy" indicates the value TRUE.
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③ An error occurred during command execution. When the error occurs, the output parameter "Busy" changes to FALSE 
and "Error" to TRUE.

④ When the input parameter "JogForward" or "JogBackward" is reset to the value FALSE, the output parameter "Error" 
changes its value to FALSE.

 
 

 Note

An error occurrence is indicated in the output parameter "Error" for only one execution cycle, 
if all the conditions below are met:

The input parameters "JogForward" and "JogBackward" have the value FALSE (but the axis 
is still decelerating) and a new error occurs (software limit switch is approached, for example).

 

 

11.2.10.6 Error displays of the Motion Control statements
The Motion Control instructions indicate any errors in motion control commands and the 
technology object at the output parameters "Error", "ErrorID" and "ErroInfo" of the Motion 
Control instructions.

Error display at output parameters "Error", "ErrorID" and "ErrorInfo"
If the output parameter "Error" indicates the value TRUE, the complete command, or portions 
thereof, could not be executed. The cause of the error is indicated by the value in output 
parameter "ErrorID". Detailed information about the cause of the error is returned by the value 
in output parameter ErrorInfo. We distinguish between the following error classes for error 
indication:

● Operating error with axis stop (for example, "HW limit switch was approached")
Operating errors with axis stop are errors that occur during runtime of the user program. If 
the axis is in motion, it is stopped with the configured deceleration or emergency stop 
deceleration, depending on the error. The errors are indicated in the error-triggering Motion 
Control instruction and in the Motion Control instruction "MC_Power".

● Operating error without axis stop (for example, "Axis is not homed")
Operating errors without axis stop are errors that occur during runtime of the user program. 
If the axis is in motion, the motion is continued. The errors are only indicated in the Motion 
Control instruction which triggers the error.

● Configuration error in Motion Control instruction 
(for example "Incorrect value in parameter "Velocity")
Parameterization errors occur when incorrect information is specified in the input 
parameters of Motion Control instructions. If the axis is in motion, the motion is continued. 
The errors are only indicated in the Motion Control instruction which triggers the error.
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● Configuration error on technology object "Axis" (for example, "Value for "Acceleration" is 
invalid")
A configuration error exists if one or more parameters are incorrectly configured in the axis 
configuration or if editable configuration data have been modified incorrectly during runtime 
of the program. An axis in motion is stopped with the configured emergency stop 
deceleration. The error is indicated in the error-triggering Motion Control instruction and in 
Motion Control instruction "MC_Power".

● Configuration error on technology object "Command table" (for example "Value for 
"Velocity" is invalid")
There is a configuration error if one or more parameters are incorrectly set in the axis 
command table or if programmable configuration data have been modified incorrectly 
during runtime of the program. If the axis is in motion, the motion is continued. The errors 
are only indicated in the "MC_CommandTable" Motion Control instruction.

● Internal error
When an internal error occurs, the axis is stopped. The errors are indicated in the error-
triggering Motion Control instruction and, in some cases, in the Motion Control instruction 
"MC_Power".
 

A detailed description of the ErrorIDs and ErrorInfos, as well as their remedies, is available in 
the Appendix (Page 7928).

See also
Overview of the Motion Control statements (Page 7890)

Creating a user program (Page 7891)

Programming notes (Page 7894)

Behavior of the Motion Control commands after POWER OFF and restart (Page 7896)

Monitoring active commands (Page 7896)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

11.2.11 Axis - Diagnostics

11.2.11.1 Status and error bits (technology objects as of V4) 
You use the "Status and error bits" diagnostic function to monitor the most important status 
and error messages for the axis in the TIA Portal. The diagnostic function display is available 
in online mode in "Manual control" mode and in "Automatic control" when the axis is active. 
The status error messages have the following meaning:
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Status messages

Status message - Axis Description
Enabled The axis is enabled and ready to be controlled via Motion Control commands.

(Tag of technology object: <Axis name>.StatusBits.Enable)
Homed The axis is homed and is capable of executing absolute positioning commands of Motion Control 

instruction "MC_MoveAbsolute". The axis does not have to be homed for relative positioning. 
Special situations:
● During active homing, the status is FALSE.
● If a homed axis undergoes passive homing, the status is set to TRUE during passive homing.
(Tag of technology object: <Axis name>.StatusBits.HomingDone)

Axis error An error has occurred in the "Axis" technology object. Additional information about the error is 
available in automatic control at the ErrorID and ErrorInfo parameters of the Motion Control 
instructions. In manual mode, the "Error message" box of the axis control panel displays detailed 
information about the cause of error.
(Tag of technology object: <Axis name>.StatusBits.Error)

Control panel active The "Manual control" mode was enabled in the axis control panel. The axis control panel has 
control priority over the "Axis" technology object. The axis cannot be controlled from the user 
program.
(Tag of technology object: <Axis name>.StatusBits.ControlPanelActive)

Restart necessary A modified configuration of the axis was downloaded to the load memory in CPU RUN operating 
mode. To download the modified configuration to the work memory, you need to restart the axis. 
Use the Motion Control instruction MC_Reset to do this.
(Tag of technology object: <Axis name>.StatusBits.RestartRequired)

Status message - Drive Description
Ready The drive is ready for operation.

(Tag of technology object: <Axis name>.StatusBits.DriveReady)
Drive error The drive has reported an error due to loss of its "Drive ready" signal.

(Tag of technology object: <Axis name>.ErrorBits.DriveFault)

Status message - Motion Description
Standstill The axis is at a standstill.

(Tag of technology object: <Axis name>.StatusBits.StandStill)
Acceleration The axis accelerates.

(Tag of technology object: <Axis name>.StatusBits.Accelerating)
Constant velocity The axis travels at constant velocity.

(Tag of technology object: <Axis name>.StatusBits.ConstantVelocity)
Deceleration The axis decelerates (slows down).

(Tag of technology object: <Axis name>.StatusBits.Decelerating)
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Status message - Motion 
type

Description

Positioning The axis executes a positioning command of the Motion Control instruction "MC_MoveAbsolute", 
"MC_MoveRelative" or the axis control panel.
(Tag of technology object: <Axis name>.StatusBits.PositioningCommand)

Travel with velocity 
specification

The axis executes a command with velocity specification of the Motion Control instruction 
"MC_MoveVelocity", "MC_MoveJog" or the axis control panel.
(Tag of technology object: <Axis name>.StatusBits.VelocityCommand)

Homing The axis executes a homing command of the Motion Control instruction "MC_Home" or the axis 
control panel.
(Tag of technology object: <Axis name>.StatusBits.HomingCommand)

Command table active The axis is controlled by Motion Control instruction "MC_CommandTable".
(Tag of technology object: <Axis name>.StatusBits.CommandTableActive)

Limit switch status messages

 Limit switch status message Description
Lower SW limit switch has 
been reached

A software limit switch was reached or exceeded.
(Tag of technology object: <Axis name>.StatusBits.SWLimitMinActive)

Upper SW limit switch has 
been reached

A hardware limit switch was reached or exceeded.
(Tag of technology object: <Axis name>.StatusBits.SWLimitMaxActive)

Lower HW limit switch was 
reached

The lower hardware limit switch was reached or exceeded.
(Tag of technology object: <Axis name>.StatusBits.HWLimitMinActive)

Upper HW limit switch was 
reached

The upper hardware limit switch was reached or exceeded.
(Tag of technology object: <Axis name>.StatusBits.HWLimitMaxActive)

Error messages

Error message Description
SW limit switch has been 
reached

A software limit switch was reached or exceeded.
(Tag of technology object: <Axis name>.ErrorBits.SWLimit)

HW limit switch has been 
reached

A hardware limit switch was reached or exceeded.
(Tag of technology object: <Axis name>.ErrorBits.HWLimit)

Impermissible motion direction The motion direction of the command does not match the configured motion direction.
(Tag of technology object: <Axis name>.ErrorBits.DirectionFault)

PTO already in use A second axis is using the same PTO (Pulse Train Output) and HSC (High Speed Counter) 
and is enabled with "MC_Power".
(Tag of technology object: <Axis name>.ErrorBits.HWUsed)

Configuration error The "Axis" technology object was incorrectly configured or editable configuration data were 
modified incorrectly during runtime of the user program.
(Tag of technology object: <Axis name>.ErrorBits.ConfigFault)

Internal error An internal error has occurred.
(Tag of technology object: <Axis name>.ErrorBits.SystemFault)
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The output window below shows the first reported and still unacknowledged error.

See also
StatusBits tags as of V4 (Page 7951)

ErrorBits tags as of V4 (Page 7955)

Diagnostics - Status and error bits ("Axis" technology object V1...3) (Page 7970)

Compatibility list of tags (Page 7815)

Motion status (Page 7913)

11.2.11.2 Motion status
Use the "Motion status" diagnostic function to monitor the motion status of the axis in the TIA 
Portal. The diagnostic function display is available in online mode in "Manual control" mode 
and in "Automatic control" when the axis is active. The displayed status information has the 
following meaning:

Status Description
Current position The "Current position" box indicates the current axis position. If the axis is not homed, the value 

indicates the position value relative to the enable position of the axis.
(Tag of technology object: <Axis name>.Position)

Current velocity The "Current velocity" box indicates the current axis velocity.
(Tag of technology object: <Axis name>.Velocity)

Target position The "Target position" box indicates the current target position of an active positioning command 
or of the axis command table. The value of the "Target position" is only valid during execution 
of a positioning command.
(Tag of technology object: <Axis name>.StatusPositioning.TargetPosition)

Remaining traversing 
distance

The "Remaining traversing distance" box indicates the traversing distance currently remaining 
for an active positioning command or the axis command table. The "Remaining traversing 
distance" value is only valid during execution of a positioning command.
(Tag of technology object: <Axis name>.StatusPositioning.Distance)

See also
Position tag as of V4 (Page 7938)

Velocity tag as of V4 (Page 7938)

StatusPositioning tags as of V4 (Page 7950)

Compatibility list of tags (Page 7815)

Status and error bits (technology objects as of V4)  (Page 7908)

11.2.11.3 Dynamics settings
Use the "Dynamics settings" diagnostic function to monitor the dynamic limits of the axis in the 
TIA Portal. The diagnostic function display is available in online mode in "Manual control" mode 
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and in "Automatic control" when the axis is active. The displayed status information has the 
following meaning:

Dynamic limit Description
Acceleration The "Acceleration" box indicates the currently configured acceleration of the axis.

(Tag of technology object: <Axis name>.DynamicDefaults.Acceleration)
Deceleration The "Deceleration" box indicates the currently configured deceleration of the axis.

(Tag of technology object: <Axis name>.DynamicDefaults.Deceleration)
Emergency stop 
deceleration

The "Emergency stop deceleration" box indicates the currently configured emergency stop 
deceleration of the axis.
(Tag of technology object: <Axis name>.DynamicDefaults.EmergencyDeceleration)

Jerk
(axis technology object as 
of V2)

The "Velocity" box indicates the current axis step velocity configured.
(Tag of technology object: <Axis name>.DynamicDefaults.Jerk)

See also
DynamicDefaults tags as of V4 (Page 7945)

Compatibility list of tags (Page 7815)

11.2.12 Appendix

11.2.12.1 Using multiple axes with the same PTO
Use the Motion Control functionality of the CPU S7-1200 to run multiple positioning axis 
technology objects with the same PTO (Pulse Train Output) and thus with the same CPU 
outputs. This is appropriate, for example, if different axis configurations are to be used for 
different production sequences via one PTO. As described below, it is possible to switch 
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between these axis configurations as often as necessary. The following diagram presents the 
basic functional relationships:

In this example, several positioning axis technology objects, each with its own axis 
configuration, use the same PTO. Each axis must be called in the user program with a separate 
call of Motion Control instruction "MC_Power" with a separate instance data block. Only one 
axis at a time may use the PTO. The axis that is currently using the PTO indicates this with 
tag <Axis name>.StatusBits.Activated = TRUE.

Switchover of the positioning axis technology object
The program scheme described below shows you how to switch between different technology 
objects and, thus, between different axis configurations. To use the same PTO with multiple 
axes without error indications, only the Motion Control instructions of the axis currently being 
used may be called. 

The following diagram presents this principle using Motion Control instruction "MC_Power" as 
an example:
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The tags of the activated axis ("Positioning axis_2" here) show the following typical indicators 
in the user program:

● <Axis name>.StatusBits.Activated = TRUE

● <Axis name>.ErrorBits.HWUsed = FALSE

To switch from one positioning axis technology object to another, follow the steps described 
below. In the example, a switch is made from "Positioning axis_2" to "Positioning axis_1":

1. End any active traversing motions of activated "Positioning axis_2"

2. Disable "Positioning axis_2" with the associated Motion Control instruction "MC_Power" 
using input parameter Enable = FALSE

3. To verify that "Positioning axis_2" has been disabled, use an AND operation of output 
parameter Status = FALSE of Motion Control instruction "MC_Power" and technology object 
tag <Axis name>.StatusBits.Enable = FALSE.

4. Deactivate the conditional call of the Motion Control instructions for "Positioning axis_2".

5. Activate the conditional call of the Motion Control instruction for "Positioning axis_1". At the 
first call of the corresponding Motion Control instruction "MC_Power", "Positioning axis_2" 
is deactivated and "Positioning axis_1" is activated.

6. Enable "Positioning axis_1" with the associated Motion Control instruction "MC_Power" 
using input parameter Enable = TRUE.

7. To verify that "Positioning axis_1" has been enabled, use an AND operation of output 
parameter Status = TRUE of Motion Control instruction "MC_Power" and technology object 
tag <Axis name>.StatusBits.Enable = TRUE.

It is also always possible to cyclically call all Motion Control instructions of all axes working 
with a single PTO.
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When an axis is enabled (here "Positioning axis_2"), this axis becomes active.

In contrast to the conditional call, the Motion Control instructions of the deactivated axes (here 
"Positioning axis_1" and "Positioning axis_x") indicate errors. The tags of these axes indicate 
the status <Axis name>.StatusBits.Activated = FALSE and <Axis 
name>.ErrorBits.HWUsed = TRUE.

Use the conditional call of the Motion Control instructions if you want to implement the user 
program without error indicators.

See also
Tags of the positioning axis technology object as of V4 (Page 7938)

Using multiple drives with the same PTO (Page 7918)

Tracking jobs from higher priority classes (execution levels) (Page 7919)

Special cases for use of software limit switches (Page 7921)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)
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11.2.12.2 Using multiple drives with the same PTO
If multiple drives are to be used, they can be run with a common PTO (Pulse Train Output) 
using changeover. The following diagram represents the basic circuit design:

S

The changeover between drives can be controlled, if required, by the user program via a digital 
output. If different axis configurations are required for the different drives, a changeover 
between these configurations is required for the PTO. For additional information on this topic, 
refer to "Using multiple axes with the same PTO (Page 7912)".

See also
Tags of the positioning axis technology object as of V4 (Page 7938)

Using multiple axes with the same PTO (Page 7912)

Tracking jobs from higher priority classes (execution levels) (Page 7919)

Special cases for use of software limit switches (Page 7921)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)
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11.2.12.3 Tracking jobs from higher priority classes (execution levels)
Depending on the application, it may be necessary to start Motion Control commands (for 
example, interrupt-controlled) in a higher priority class (execution level). 

The Motion Control instructions must be called at short intervals for status monitoring. Motion 
Control commands cannot be sufficiently closely monitored if the higher priority Motion Control 
commands are called only once or at too great an interval. Tracking in such cases can be 
carried out in the cycle OB. An instance data block that is not currently being utilized must be 
available for each start of a higher priority Motion Control command. Refer to the following flow 
chart to see how you start Motion Control commands in a higher priority class (for example, 
hardware interrupt OB) and continue tracking in the program cycle OB:
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Depending on the frequency of the Motion Control commands you want to start, you will have 
to generate a sufficient number of instance data blocks. Users determine which instance data 
block is currently used in the DBx_used tags.
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Start of Motion Control command in the hardware interrupt OB
Binary queries of the DBx_used tags (orange) are used to find an instance data block not 
currently in use. If such an instance data block is found, the utilized instance data block is 
marked as "used" (green) and the Motion Control command is started with this instance data 
block (blue).

Any other program sections of the hardware interrupt OB are then executed, followed by a 
return to the program cycle OB.

Tracking of started Motion Control commands in the program cycle OB
All instance data blocks available in the cycle OB are checked to determine if they are currently 
in use by means of the DBx_used tag (violet).

If an instance data block is in use (Motion Control command is being processed), the Motion 
Control instruction with this instance data block and input parameter Execute = TRUE is called 
to read out the status messages (red).

If the command is complete or has been aborted, the following actions are taken next (blue 
green):

● Call of Motion Control instruction with input parameter Execute = FALSE

● Resetting the DBx_used tag

This completes the command tracking, and the instance data block is now available for use 
again.

See also
Tags of the positioning axis technology object as of V4 (Page 7938)

Using multiple axes with the same PTO (Page 7912)

Using multiple drives with the same PTO (Page 7916)

Special cases for use of software limit switches (Page 7921)

List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7928)

11.2.12.4 Special cases for use of software limit switches

Software limit switches in conjunction with a homing operation
Due to unfavorably parameterized homing jobs, the braking action of the axis may be 
influenced at the software limit switch. Take the following examples into consideration when 
developing your program.
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Example 1:
During a travel command, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. It is still possible to bring the axis to 
a standstill before reaching the software limit switch:

① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. 

Following constant motion, the axis brakes at the configured emergency stop deceleration and comes to a standstill at 
the position of the software limit switch.

Example 2:
During a travel command, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. In contrast to example 1, it is no longer 
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possible to bring the axis to a standstill before reaching the software limit switch. The axis 
overruns the position of the software limit switch.

① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

well after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. The 

axis brakes with the configured emergency stop deceleration. However, the emergency stop deceleration is not sufficient 
to stop the axis at the position of the software limit switch. The position of the software limit switch is overrun.
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Example 3:
During a braking operation, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. It is still possible to bring the axis to 
a standstill before reaching the software limit switch:

① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. 

Following constant motion, the axis brakes at the configured emergency stop deceleration and comes to a standstill at 
the position of the software limit switch.

Example 4:
During a braking operation, a homing job (for example, Set reference point) offsets the current 
axis position in the direction of the software limit switch. In contrast to example 3, it is no longer 
possible to bring the axis to a standstill before reaching the software limit switch. The axis 
overruns the position of the software limit switch.
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① The green curve shows the motion without the homing job. The axis brakes at the configured deceleration and comes 
to a standstill at a position before the software limit switch.

② A new axis position is set as a result of the homing job. The area between the old and new axis position is thus "skipped".
③ Based on the new axis position, the axis would theoretically be stopped with the configured deceleration at a position 

well after the software limit switch (red curve).
④ Because braking with the configured deceleration is no longer sufficient, the axis actually follows the blue curve. The 

axis brakes with the configured emergency stop deceleration. However, the emergency stop deceleration is not sufficient 
to stop the axis at the position of the software limit switch. The position of the software limit switch is overrun.

See also
Software limit switches and software limit switch position changes. (Page 7925)

Software limit switches in conjunction with dynamic changes (Page 7926)

Behavior of axis when position limits is tripped (Page 7833)

Software limit switches and software limit switch position changes.
An incorrect change in the position of the software limit switch during the runtime of the user 
program can abruptly reduce the distance between the current axis position and the position 
of the software limit switch.
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The axis response is similar to that described in Software limit switches in conjunction with a 
homing operation (Page 7919).

See also
Software limit switches in conjunction with a homing operation (Page 7919)

Software limit switches in conjunction with dynamic changes (Page 7926)

Behavior of axis when position limits is tripped (Page 7833)

Software limit switches in conjunction with dynamic changes
It is possible to influence the deceleration of the axis in the area of the software limit switches 
in conjunction with overriding motion commands. This applies when the overriding motion 
command is started with a lower deceleration (tag <Axis 
name>.DynamicDefaults.Deceleration). Take the following examples into consideration when 
developing your program.

Example 1:
During axis motion, an active motion command is overridden by another motion command with 
a lower deceleration:
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① The green curve shows the motion of an active command without this command being overridden. The axis brakes at 
the configured deceleration and comes to a standstill at a position before the software limit switch.

② Based on the overriding motion command with lower deceleration, the axis would theoretically be stopped with the 
configured deceleration at a position after the software limit switch (red curve).

③ Because braking with the configured deceleration of the overriding motion command is no longer sufficient, the axis 
actually follows the blue curve. Following a constant motion, the axis brakes at the emergency stop deceleration and 
comes to a standstill at the position of the software limit switch.

Example 2:
During braking of the axis, an active motion command is overridden by another motion 
command with a lower deceleration:

① The green curve shows the motion of an active command without this command being overridden. The axis brakes at 
the configured deceleration and comes to a standstill at a position before the software limit switch.

② Based on the overriding motion command with lower deceleration, the axis would theoretically be stopped at a position 
well after the software limit switch (red curve).

③ Because braking with the configured deceleration of the overriding motion command is no longer sufficient, the axis 
actually follows the blue curve. Following a constant motion, the axis brakes at the emergency stop deceleration and 
comes to a standstill at the position of the software limit switch.
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See also
Software limit switches in conjunction with a homing operation (Page 7919)

Software limit switches and software limit switch position changes. (Page 7923)

Behavior of axis when position limits is tripped (Page 7833)

11.2.12.5 Reducing velocity for a short positioning duration
The CPU can reduce the velocity of a positioning command when the planned positioning 
duration is  < 2 ms. 

The velocity of command execution will then be reduced for the entire duration. The reduced 
velocity (pulses per s) is calculated as follows:

● Reduced velocity = Number of pulses to be output * 500Hz

Velocity is not reduced if the planned positioning duration is >= 2 ms.

11.2.12.6 Dynamic adjustment of start/stop velocity
The configuration of your velocity limits (start/stop velocity and maximum velocity), the dynamic 
values (acceleration, deceleration and jerk) and the target speed of the traversing command 
may under certain circumstances result in the start/stop velocity being dynamically adjusted 
by the CPU.

This is for example the case when, due to a low configured start/stop velocity, the time required 
for the first pulses would be longer than that possible for the entire acceleration. The first pulse 
is in these cases output at a greater velocity than the configured start/stop velocity. The 
subsequent pulses are also dynamically adjusted to ensure the acceleration process can be 
completed in the specified time.

Ensure in the event of any pulse loss that the hardware (drive) you use is adjusted to this 
situation, or change the dynamic settings of your axis to avoid dynamic adjustment of the start/
stop velocity.

 

11.2.12.7 List of ErrorIDs and ErrorInfos (technology objects as of V4)
The following table lists all ErrorIDs and ErrorInfos that can be indicated in Motion Control 
instructions. In addition to the cause of the error, remedies for eliminating the error are also 
listed:   

Operating error with axis stop

ErrorID ErrorInfo Description Remedy
16#8000 Drive error, loss of "Drive ready"
 16#0001 - Acknowledge error with instruction "MC_Reset"; 

provide drive signal; restart command, if necessary
16#8001 Lower SW limit switch has been tripped
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ErrorID ErrorInfo Description Remedy
 16#000E The position of the lower SW limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the positive direction out of the range of the 
SW limit switch16#000F The position of the lower SW limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the lower SW limit switch was 

exceeded with the emergency stop deceleration
16#8002 Upper SW limit switch has been tripped
 16#000E The position of the upper SW limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the negative direction out of the range of the 
SW limit switch16#000F The position of the upper SW limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the upper SW limit switch was 

exceeded with the emergency stop deceleration
16#8003 Lower HW limit switch was reached
 16#000E The lower HW limit switch was reached. The 

axis was stopped with the emergency stop 
deceleration.
(During an active homing procedure, the 
homing switch was not found)

Acknowledge the error for an enabled axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the positive direction out of the 
range of the HW limit switch.

16#8004 Upper HW limit switch was reached
 16#000E The upper HW limit switch has been reached. 

The axis was stopped with the emergency stop 
deceleration.
(During an active homing procedure, the 
homing switch was not found)

Acknowledge the error for an enabled axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the negative direction out of the 
range of the HW limit switch.

16#8005 PTO/HSC are already being used by another axis
 16#0001 - The axis was configured incorrectly:

Correct the configuration of the PTO (Pulse Train 
Output) / HSC (High Speed Counter) and download 
it to the controller
More than one axis is to run with one PTO:
Another axis is using the PTO / HSC. If the current 
axis is to assume the control, the other axis must 
be disabled with "MC_Power" Enable = FALSE.
(see also Using multiple axes with the same PTO 
(Page 7912))

16#8006 A communication error in the control panel has occurred 
 16#0012 A timeout has occurred Check the cable connection and press the "Manual 

control" button again.
16#8007 The axis cannot be enabled.
 
 

16#0025 Restarting Wait until the axis restart is complete.
16#0026 Executing loading process in RUN mode Wait until the loading process is complete.

16#8008 Impermissible motion direction
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ErrorID ErrorInfo Description Remedy
 16#002E The selected motion direction is not allowed. ● Adjust the motion direction and restart the 

command.
● Adjust the allowed direction of rotation in the 

technology object configuration under 
"Extended parameters > Mechanics" Restart 
the command.

16#002F A reversing motion is not possible with the 
selected motion direction.

Operating error without axis stop

ErrorID ErrorInfo Description Remedy
16#8200 Axis is not enabled
 16#0001 - Enable the axis; restart the command
16#8201 Axis has already been enabled by another "MC_Power" instance
 16#0001 - Enable the axis with only one "MC_Power" instance
16#8202 The maximum number of simultaneously active Motion Control commands has been exceeded 

(maximum of 200 commands for all motion control technology objects)
 16#0001 - Reduce the number of simultaneously active 

commands; restart the command
A command is active if parameter "Busy" = TRUE 
in the Motion Control instruction.

16#8203 Axis is currently operated in "Manual control" (axis control panel)
 16#0001 - Exit "Manual control"; restart the command
16#8204 Axis is not homed
 16#0001 - Home the axis with instruction "MC_Home"; restart 

the command
16#8205 The axis is currently controlled by the user program (the error is only displayed in the axis control 

panel)
 16#0013 The axis is enabled in the user program. Disable axis with instruction "MC_Power" and 

select "Manual control" again in the axis control 
panel

16#8206 Technology object not activated yet
 16#0001 - Enable the axis with instruction "MC_Power" 

Enable = TRUE or enable the axis in the axis control 
panel.

16#8207 Command rejected
 16#0016 Active homing is running; another homing 

method cannot be started.
Wait for active homing to finish or abort the active 
homing with a motion command, for example, 
"MC_Halt".

16#0018 The axis cannot be moved with a command 
table while it is being actively or passively 
homed.

Wait until direct or passive homing is complete.

16#0019 The axis cannot be actively or passively homed 
while a command table is being processed.

Wait for command table to finish or abort the 
command table with a motion command, for 
example, "MC_Halt".

16#8208 Difference between maximum and start/stop velocity is invalid
 16#0002 Number format of value is invalid Correct the value; restart the command
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ErrorID ErrorInfo Description Remedy
16#000A Value is less than or equal to 0

16#8209 Invalid acceleration for technology object "Axis"
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#820A It is not possible to restart the axis
 
 

16#0013 The axis is enabled in the user program. Disable the axis with the "MC_Power" instruction; 
restart again

16#0027 The axis is currently being operated in "Manual 
control" (axis control panel)

Exit "Manual control"; restart again

16#820B It is not possible to execute the command table
 16#0026 Executing loading process in RUN mode Wait until the loading process is complete.

Block parameter error

ErrorID ErrorInfo Description Remedy
16#8400 Invalid value at parameter "Position" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8401 Invalid value at parameter "Distance" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8402 Invalid value at parameter "Velocity" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0008 Value is greater than the configured maximum 
velocity

16#0009 Value is less than the configured start/stop 
velocity

16#0024 Value is less than 0
16#8403 Invalid value at parameter "Direction" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; restart the command
16#8404 Invalid value at parameter "Mode" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; restart the command

16#0015 Active/passive homing is not configured Correct the configuration and download it to the 
controller; enable the axis and restart the command
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ErrorID ErrorInfo Description Remedy
16#0017 The direction reversal is activated at the 

hardware limit switch, despite the fact that the 
hardware limit switches are disabled

● Activate the HW limit switch using the tag <Axis 
name>.PositionLimitsHW.Active = TRUE, 
restart the command

● Correct the configuration and download it to the 
controller; enable the axis and restart the 
command

16#8405 Invalid value at parameter "StopMode" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; enable the axis again
16#8406 Simultaneous forward and backward jogging is not allowed
 16#0001 - Take steps to ensure that parameters 

"JogForward" and "JogBackward" do not have 
signal status TRUE simultaneously; restart the 
command.

16#8407 Switching to another axis with instruction "MC_Power" is only permitted after disabling the active axis.
 16#0001 - Disable the active axis; it is then possible to switch 

to the other axis and enable it.
16#8408 Invalid value at parameter "Axis" of the Motion Control instruction
 16#001A The specified value does not match the 

required technology object version
Correct the value; restart the command

16#001B The specified value does not match the 
required technology object type

16#001C The specified value is not a Motion Control 
technology data block

16#8409 Invalid value at parameter "CommandTable" of the Motion Control instruction
 16#001A The specified value does not match the 

required technology object version
Correct the value; restart the command

16#001B The specified value does not match the 
required technology object type

16#001C The specified value is not a Motion Control 
technology data block

16#840A Invalid value at parameter "StartStep" of the Motion Control instruction
 16#000A Value is less than or equal to 0 Correct the value; restart the command

16#001D The start step is greater than the end step
16#001E Value is greater than 32

16#840B Invalid value at parameter "EndStep" of the Motion Control instruction
 16#000A Value is less than or equal to 0 Correct the value; restart the command

16#001E Value is greater than 32
16#840C Invalid value at parameter "RampUpTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840D Invalid value at parameter "RampDownTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840E Invalid value at parameter "EmergencyRampTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
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ErrorID ErrorInfo Description Remedy
16#840F Invalid value at parameter "JerkTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#8410 Invalid value at parameter "Parameter" of the Motion Control instruction
 
 

16#0028 Data types of VARIANT pointer "Parameter" 
and "Value" do not match.

Use a suitable data type; restart command

16#0029 VARIANT pointer "Parameter" does not point to 
a data block of the technology object.

Correct the VARIANT pointer; restart the command

16#002A The value at the VARIANT pointer "Parameter" 
cannot be read.

Correct the VARIANT pointer; restart the command

16#002B The value at the VARIANT pointer "Parameter" 
cannot be written.

Correct the VARIANT pointer or value; restart the 
command

16#002C The axis is not disabled. Disable the axis; restart the command
16#8411 Invalid value at parameter "Value" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

Configuration error of the axis

ErrorID ErrorInfo Description Remedy
16#8600 Parameter assignment of pulse generator (PTO is invalid
 16#000B The address is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#0014 The selected hardware is used by another 
application

16#8601 Parameter assignment of the high-speed counter (HSC) is invalid
 16#000B The address is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#0014 The selected hardware is used by another 
application

16#8602 Invalid parameter assignment of "Enable output"
 16#000B The address is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"
16#8603 Invalid parameter assignment of "Ready input"
 16#000B The address is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"
16#8604 Invalid "Pulses per motor revolution" value
 16#000A Value is less than or equal to zero Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"
16#8605 Invalid "Distance per revolution" value
 16#0002 Number format of value is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#0005 The value is outside the number range (greater 
than 1e12)

16#000A Value is less than or equal to zero
16#8606 Invalid "Start/stop velocity" value
 16#0002 Number format of value is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#0003 Value exceeds the upper hardware limit
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ErrorID ErrorInfo Description Remedy
16#0004 Value is less than the lower hardware limit
16#0007 The start/stop velocity is greater than the 

maximum velocity
16#8607 Invalid "maximum velocity" value
 16#0002 Number format of value is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#8608 Invalid "Acceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#8609 Invalid "Deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#860A Invalid "Emergency stop deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#860B Value for position of the lower SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#0030 The position value of the lower software limit 
switch is greater than that of the upper software 
limit switch

16#860C Value for position of the upper SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#860D Invalid address of the lower HW limit switch
 16#000B Invalid address Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#000C The address of the falling edge is invalid
16#000D The address of the rising edge is invalid
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ErrorID ErrorInfo Description Remedy
16#860E Invalid address of the upper HW limit switch
 16#000B Invalid address Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#000C The address of the falling edge is invalid
16#000D The address of the rising edge is invalid

16#860F Invalid "home position offset" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8610 Invalid "approach velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0008 The velocity is greater than the maximum 
velocity

16#0009 The velocity is less than the start/stop velocity

16#8611 Invalid "Homing velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0008 The velocity is greater than the maximum 
velocity

16#0009 The velocity is less than the start/stop velocity

16#8612 Invalid address of the homing switch
 16#000B Invalid address Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"16#000C The address of the falling edge is invalid
16#000D The address of the rising edge is invalid

16#8613 During active homing, direction reversal at the hardware limit switch is activated although the 
hardware limit switches are not configured

 16#0001 - ● Download error-free configuration to the 
controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#8614 Invalid "Jerk" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#001F Value is greater than the maximum jerk
16#0020 Value is less than the minimum jerk

16#8615 Value for "Unit of measurement" is invalid
 16#0011 The selection value is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"
16#8616 Address of homing switch is invalid (passive homing as of V4)
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ErrorID ErrorInfo Description Remedy
 16#0011 The selection value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#8617 Value of tag <Axis name>.Sensor.Sensor[1].ActiveHoming.Mode is invalid
 16#0011 The selection value is invalid

(Valid value: 2 = Homing via digital input)
● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#8618 Value of tag <Axis name>.Sensor.Sensor[1].PassiveHoming.Mode is invalid
 16#0011 The selection value is invalid

(Valid value: 2 = Homing via digital input)
● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#8619 Value of tag <Axis name>.Actor.Type is invalid
 16#0011 The selection value is invalid

(Valid value: 2 = Connection via pulse interface)
● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#861A Value for "Permitted direction of rotation" is invalid
 16#0011 The selection value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#002D "Both directions" not allowed when direction 
output is deactivated

Configuration error of the command table

ErrorID ErrorInfo Description Remedy
16#8700 Value for "Command type" in the command table is invalid
 16#0001 - ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#8701 Value for "Position / travel path" in the command table is invalid

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
7934 System Manual, 02/2014



ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8702 Value for "Velocity" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0008 Value is greater than the configured maximum 
velocity

16#0009 Value is less than the configured start/stop 
velocity

16#8703 Value for "Duration" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0021 Value is greater than 64800 s
16#0022 Value is less than 0.001 s

16#8704 Value for "Next step" in the command table is invalid
 16#0011 The selection value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0023 The command transition is not permitted for this 
command

Internal errors

ErrorID ErrorInfo Description Remedy
16#8FFF Internal error
 16#F0** - POWER OFF and POWER ON the CPU

If this does not work, contact Customer Support. 
Have the following information ready:
● ErrorID
● ErrorInfo
● Diagnostic buffer entries

See also
Tags of the positioning axis technology object as of V4 (Page 7938)

ErrorIDs and ErrorInfos (Page 7973)

Error displays of the Motion Control statements (Page 7907)

Using multiple axes with the same PTO (Page 7912)

Using multiple drives with the same PTO (Page 7916)
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Tracking jobs from higher priority classes (execution levels) (Page 7917)

Special cases for use of software limit switches (Page 7919)

11.2.12.8 Tags of the positioning axis technology object as of V4

Position tag as of V4
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to the tag in the user program:

RCC
P

The tag can be read in the user program and is updated at each cycle checkpoint.

RP The tag can be read with the Motion Control instruction "MC_ReadParam". The current value of the 
corresponding tag is determined at the start of the command.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Position
Current position of the axis
(indicated in the configured unit of measurement)
If the axis is not homed, the tag indicates the position value relative to the enable position of the axis.
Data type Start value Access Effective HMI
Real 0.0 RCCP, RP - X

See also
Motion status (Page 7911)

Tag of the axis technology object V1...3 (Page 7986)

Velocity tag as of V4
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to the tag in the user program:

RCC
P

The tag can be read in the user program and is updated at each cycle checkpoint.

RP The tag can be read with the Motion Control instruction "MC_ReadParam". The current value of the 
corresponding tag is determined at the start of the command.
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Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Velocity
Current velocity of the axis
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 0.0 RCCP, RP - X

See also
Motion status (Page 7911)

Tag of the axis technology object V1...3 (Page 7986)

Actor tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to the tag in the user program:

R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with the Motion Control 

instruction "MC_WriteParam".
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect:
2 When axis is enabled

HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Actor.Type
Drive connection
The drive is connected via a pulse interface.
Data type Start value Access Effective HMI
DInt 2 R - X

<Axis name>.Actor.InverseDirection
Invert direction
FALSE = The direction is not inverted.
TRUE = The direction is inverted.
Data type Start value Access Effective HMI
Bool FALSE R - X

WP 2 -
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<Axis name>.Actor.DirectionMode
Permitted direction of rotation
0 = Both directions
1 = Positive direction
2 = Negative direction
Data type Start value Access Effective HMI
Int 0 R - X

WP 2 -

<Axis name>.Actor.Interface.EnableDriveOutput
Enable output (internal parameter)
Data type Start value Access Effective HMI
VREF - - - -

<Axis name>.Actor.Interface.DriveReadyInput
Ready input (internal parameter)
Data type Start value Access Effective HMI
VREF - - - -

<Axis name>.Actor.Interface.PTO
Pulse output (internal parameter)
Data type Start value Access Effective HMI
DWord 0 - - -

<Axis name>.Actor.DriveParameter.PulsesPerDriveRevolution
Pulses per motor revolution
Data type Start value Access Effective HMI
DInt 1000 R - X

WP 2 -

See also
Tag of the axis technology object V1...3 (Page 7986)
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Sensor[1] tags as of V4

ActiveHoming tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
The tag can be written with Motion Control instruction "MC_WriteParam".

R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with the Motion Control 

instruction "MC_WriteParam".
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect:
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE → TRUE), 

disabled, or enabled
2 When axis is enabled
8 When an active homing command is started

HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Sensor[1].ActiveHoming.Mode
Active homing mode
2 = Homing via digital input
Data type Start value Access Effective HMI
DInt 2 R - X

WP 2 -

<Axis name>.Sensor[1].ActiveHoming.SideInput
End of the homing switch to which the axis is homed during active homing
FALSE = Lower end
TRUE = Upper end
Data type Start value Access Effective HMI
Bool FALSE RW 1, 8 X

<Axis name>.Sensor[1].ActiveHoming.DigitalInputAddress
Symbolic input address of the homing switch (internal parameter)
Data type Start value Access Effective HMI
VREF - - - -
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<Axis name>.Sensor[1].ActiveHoming.HomePositionOffset
Home position offset (active homing)
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 0.0 RW 1, 8 X

<Axis name>.Sensor[1].ActiveHoming.SwitchLevel
Selection of signal level that is present at the CPU input when the homing switch is reached
FALSE = Low level (Low-active)
TRUE = High level (High-active)
Data type Start value Access Effective HMI
Bool TRUE RW 1, 8 X

See also
Tag of the axis technology object V1...3 (Page 7986)

PassiveHoming tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
The tag can be written with Motion Control instruction "MC_WriteParam".

R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with the Motion Control 

instruction "MC_WriteParam".
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect:
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 

disabled, or enabled
2 When axis is enabled
7 When a passive homing command is started

HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Sensor[1].PassiveHoming.Mode
Passive homing mode
2 = Homing via digital input
Data type Start value Access Effective HMI
DInt 2 R - X

WP 2 -
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<Axis name>.Sensor[1].PassiveHoming.SideInput
End of the homing switch to which the axis is homed during passive homing
FALSE = Lower end
TRUE = Upper end
Data type Start value Access Effective HMI
Bool FALSE RW 1, 7 X

<Axis name>.Sensor[1].PassiveHoming.DigitalInputAddress
Symbolic input address of the homing switch (internal parameter)
Data type Start value Access Effective HMI
VREF - - - -

<Axis name>.Sensor[1].PassiveHoming.SwitchLevel
Selection of level that is present at the CPU input when the homing switch is reached
FALSE = Low level (Low-active)
TRUE = High level (High-active)
Data type Start value Access Effective HMI
Bool TRUE RW 1, 7 X

See also
Tag of the axis technology object V1...3 (Page 7986)

Units tag as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with the Motion Control 

instruction "MC_WriteParam".
Effective Specifies when a change to the tag takes effect:

2 When axis is enabled
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).
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<Axis name>.Units.LengthUnit
Configured unit of measurement of the parameter
-1 = "Pulse"
1005 = "°" (degrees)
1013 = "mm"
1010 =: "m"
1018 = "ft"
1019 = "in"
Data type Start value Access Effective HMI
Int 1013 R - X

WP 2 -

See also
Tag of the axis technology object V1...3 (Page 7986)

Mechanics tag as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with the Motion Control 

instruction "MC_WriteParam".
Effective Specifies when a change to the tag takes effect:

2 When axis is enabled
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Mechanics.LeadScrew
Distance per revolution
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 10.0 R - X

WP 2 -

See also
Tag of the axis technology object V1...3 (Page 7986)
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DynamicLimits tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with the Motion Control 

instruction "MC_WriteParam".
Effective Specifies when a change to the tag takes effect:

2 When axis is enabled
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.DynamicLimits.MaxVelocity
Maximum velocity of the axis
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 250.0 R - X

WP 2 -

<Axis name>.DynamicLimits.MinVelocity  
Start/stop velocity of the axis
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 10.0 R - X

WP 2 -

See also
Tag of the axis technology object V1...3 (Page 7986)

DynamicDefaults tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
The tag can be written with Motion Control instruction "MC_WriteParam".

Effective Specifies when a change to the tag takes effect:
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1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 
disabled, or enabled

5 The next time an MC_MoveAbsolute,  MC_MoveRelative, MC_MoveVelocity, MC_MoveJog, MC_Halt, 
MC_CommandTable, or active MC_Home command is started (Mode = 3).

6 When a MC_MoveJog command is stopped
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.DynamicDefaults.Acceleration
Acceleration of the axis 
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 48.0 RW 1, 5, 6 X

<Axis name>.DynamicDefaults.Deceleration
Deceleration of the axis
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 48.0 RW 1, 5, 6 X

<Axis name>.DynamicDefaults.EmergencyDeceleration
Emergency stop deceleration of the axis
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 120.0 RW 1, 5, 6 X

<Axis name>.DynamicDefaults.Jerk
Jerk during acceleration and deceleration ramp of the axis
(indicated in the configured unit of measurement)
The jerk is activated if the configured jerk is greater than 0.00004 mm/s².
Data type Start value Access Effective HMI
Real 192.0 RW 1, 5 X

See also
Tag of the axis technology object V1...3 (Page 7986)

PositionLimitsSW tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
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Access Access to the tag in the user program:
RW The tag can be read and written in the user program.

The tag can be written with Motion Control instruction "MC_WriteParam".
Effective Specifies when a change to the tag takes effect:

1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 
disabled, or enabled

5 The next time an MC_MoveAbsolute, MC_MoveRelative,  MC_MoveVelocity, MC_MoveJog, 
MC_Halt, MC_CommandTable, or active MC_Home command is started (Mode = 3).

6 When a MC_MoveJog command is stopped
HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.PositionLimitsSW.Active
Activation of the software limit switches
FALSE = The software limit switches are deactivated.
TRUE = The software limit switches are activated.
Data type Start value Access Effective HMI
Bool FALSE RW 1, 5, 6 X

<Axis name>.PositionLimitsSW.MinPosition
Position of the lower software limit switch
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real -10000.0 RW 1, 5, 6 X

<Axis name>.PositionLimitsSW.MaxPosition
Position of the upper software limit switch
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 10000.0 RW 1, 5, 6 X

See also
Tag of the axis technology object V1...3 (Page 7986)

PositionLimitsHW tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
The tag can be written with Motion Control instruction "MC_WriteParam".
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R The tag can be read in the user program.
WP If the axis is disabled (MC_Power.Status = FALSE), the tag can be written with Motion Control 

instruction "MC_WriteParam".
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect:
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 

disabled, or enabled
2 When axis is enabled
5 The next time an MC_MoveAbsolute, MC_MoveRelative,  MC_MoveVelocity, MC_MoveJog, 

MC_Halt, MC_CommandTable, or active MC_Home command is started (Mode = 3).
6 When a MC_MoveJog command is stopped

HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.PositionLimitsHW.Active
Activation of the hardware limit switches
FALSE = The hardware limit switches are deactivated.
TRUE = The hardware limit switches are activated.
Data type Start value Access Effective HMI
Bool FALSE RW 1, 5, 6 X

<Axis name>.PositionLimitsHW.MinSwitchLevel
Selection of signal level that is present at the CPU input when the lower hardware limit switch is reached
FALSE = Low level (Low-active)
TRUE = High level (High-active)
Data type Start value Access Effective HMI
Bool FALSE R - X

WP 2 -

<Axis name>.PositionLimitsHW.MinSwitchAddress
Symbolic input address of the lower hardware limit switch (internal parameter)
Data type Start value Access Effective HMI
VREF - - - -

<Axis name>.PositionLimitsHW.MaxSwitchLevel
Selection of signal level that is present at the CPU input when the upper hardware limit switch is reached
FALSE = Low level (Low-active)
TRUE = High level (High-active)
Data type Start value Access Effective HMI
Bool FALSE R - X

WP 2 -
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<Axis name>.PositionLimitsHW.MaxSwitchAddress
Input address of the upper hardware limit switch (internal parameter)
Data type Start value Access Effective HMI
VREF - - - -

See also
Tag of the axis technology object V1...3 (Page 7986)

Homing tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
The tag can be written with Motion Control instruction "MC_WriteParam".

Effective Specifies when a change to the tag takes effect:
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE → TRUE), 

disabled, or enabled
8 When an active homing command is started

HMI The tag can be used in an HMI system (according to the access to the tag in the user program).

<Axis name>.Homing.AutoReversal   
Activation of auto reverse at the hardware limit switch during active homing
FALSE = Auto reversal at the hardware limit switch is deactivated.
TRUE = Auto reversal at the hardware limit switch is activated.
Data type Start value Access Effective HMI
Bool FALSE RW 1, 8 X

<Axis name>.Homing.ApproachDirection
Approach and homing direction of axis during active homing
FALSE = Negative approach direction for finding the homing switch and negative homing direction
TRUE = Positive approach direction for finding the homing switch and positive homing direction
Data type Start value Access Effective HMI
Bool TRUE RW 1, 8 X
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<Axis name>.Homing.ApproachVelocity
Approach velocity of the axis during active homing
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 200.0 RW 1, 8 X

<Axis name>.Homing.ReferencingVelocity
Homing velocity of the axis during active homing
(indicated in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 40.0 RW 1, 8 X

See also
Tag of the axis technology object V1...3 (Page 7986)

StatusPositioning tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to the tag in the user program:

RCC
P

The tag can be read in the user program and is updated at each cycle checkpoint.

RP The tag can be read with the Motion Control instruction "MC_ReadParam". The current value of the 
corresponding tag is determined at the start of the command.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.StatusPositioning.Distance
Current distance of axis from target position
(indicated in the configured unit of measurement)
The value of the tag is only valid during execution of a positioning command with "MC_MoveAbsolute", "MC_MoveRelative", 
or the axis control panel. 
Data type Start value Access Effective HMI
Real 0.0 RCCP, RP - X
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<Axis name>.StatusPositioning.TargetPosition
Target position of the axis 
(indicated in the configured unit of measurement)
The value of the tag is only valid during execution of a positioning command with "MC_MoveAbsolute", "MC_MoveRelative", 
or the axis control panel.
Data type Start value Access Effective HMI
Real 0.0 RCCP, RP - X

See also
Motion status (Page 7911)

Tag of the axis technology object V1...3 (Page 7986)

StatusBits tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to the tag in the user program:

RCC
P

The tag can be read in the user program and is updated at each cycle checkpoint.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.StatusBits.Activated
Activation of the axis
FALSE = The axis is not activated.
TRUE = The axis is activated. It is connected to the assigned PTO (Pulse Train Output). The data of the technology data 
block will be updated cyclically.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.Enable
Enable status of the axis
FALSE = The axis is not enabled.
TRUE = The axis is enabled and ready to accept Motion Control commands.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X
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<Axis name>.StatusBits.HomingDone
Homing status of the axis
FALSE = The axis is not homed.
TRUE = The axis is homed and is capable of executing absolute positioning commands. 
The axis does not have to be homed for relative positioning.
The status is FALSE during active homing.
The status remains TRUE during passive homing if the axis was already homed beforehand.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.Done
Command execution on the axis
FALSE = A Motion Control command is active on the axis. 
TRUE = A Motion Control command is not active on the axis.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.Error
Error status on the axis
FALSE = No error is active on the axis.
TRUE = An error occurred on the axis. 
Additional information about the error is available in automatic control at the "ErrorID" and "ErrorInfo" parameters of the 
Motion Control instructions. 
In manual mode, the "Error message" box of the axis control panel displays detailed information about the cause of error.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.StandStill
Standstill of the axis
FALSE = The axis is in motion.
TRUE = The axis is at a standstill.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.PositioningCommand
Execution of a positioning command
FALSE = A positioning command is not active on the axis.
TRUE = The axis is executing a positioning command of the "MC_MoveRelative" or MC_MoveAbsolute Motion Control 
instruction.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X
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<Axis name>.StatusBits.VelocityCommand
Execution of a command with velocity specification
FALSE = A command with velocity specification is not active on the axis.
TRUE = The axis is executing a motion command with velocity specification of the "MC_MoveVelocity" or MC_MoveJog 
Motion Control instruction.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.HomingCommand
Execution of a homing command
FALSE = A homing command is not active on the axis.
TRUE = The axis is executing a homing command of the "MC_Home" Motion Control instruction.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.CommandTableActive
Execution of a command table
FALSE = A command table is not active on the axis.
TRUE = The axis is controlled by "MC_CommandTable" Motion Control instruction.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.ConstantVelocity
Constant velocity
FALSE = The axis is accelerating, decelerating, or at a standstill.
TRUE = The setpoint velocity has been reached. The axis is moving at constant velocity.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.Accelerating
Acceleration process
FALSE = The axis is decelerating, moving at constant velocity, or at a standstill. 
TRUE = The axis is accelerating.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.Decelerating
Deceleration process
FALSE = The axis is accelerating, moving at constant velocity, or at a standstill.
TRUE = The axis is decelerating.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X
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<Axis name>.StatusBits.ControlPanelActive
Activation status of the axis control panel
FALSE = "Automatic mode" is activated. The user program has control priority over the axis.
TRUE = The "Manual control" mode was enabled in the axis control panel. The axis control panel has control priority over 
the axis. The axis cannot be controlled from the user program.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.DriveReady
Operational status of the drive
FALSE = The drive is not ready. Setpoints will not be executed.
TRUE = The drive is ready. Setpoints can be executed.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.RestartRequired
Restart of axis required
FALSE = A restart of the axis is not required.
TRUE = Values were modified in the load memory.  To download the values to the work memory while the CPU is in RUN 
mode, the axis must be restarted. Use the MC_Reset Motion Control instruction to do this.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.SWLimitMinActive
Status of the lower software limit switch
FALSE = The axis is kept within its configured working range.
TRUE = The lower software limit switch was reached or exceeded.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.SWLimitMaxActive
Status of the upper software limit switch
FALSE = The axis is kept within its configured working range.
TRUE = The upper software limit switch was reached or exceeded.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.StatusBits.HWLimitMinActive
Status of the lower hardware limit switch
FALSE = The axis is kept within its configured permitted traversing range.
TRUE = The lower hardware limit switch was reached or exceeded.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X
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<Axis name>.StatusBits.HWLimitMaxActive
Status of the upper hardware limit switch
FALSE = The axis is kept within its configured permitted traversing range.
TRUE = The upper hardware limit switch was reached or exceeded.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

See also
Status and error bits (technology objects as of V4)  (Page 7908)

Tag of the axis technology object V1...3 (Page 7986)

ErrorBits tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to the tag in the user program:

RCC
P

The tag can be read in the user program and is updated at each cycle checkpoint.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.ErrorBits.SystemFault
Internal system error
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.ErrorBits.ConfigFault
Incorrect configuration of the axis
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.ErrorBits.DriveFault
Error in the drive. Loss of the "Drive ready" signal.
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.ErrorBits.SWLimit
Software limit switch reached or exceeded
Data type Start value Access Effective HMI
Bool FALSE RCCP - X
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<Axis name>.ErrorBits.HWLimit
Hardware limit switch reached or exceeded
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.ErrorBits.DirectionFault
Impermissible motion direction
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

<Axis name>.ErrorBits.HWUsed
Another axis is using the same PTO (Pulse Train Output) and is enabled with "MC_Power".
Data type Start value Access Effective HMI
Bool FALSE RCCP - X

See also
Status and error bits (technology objects as of V4)  (Page 7908)

Tag of the axis technology object V1...3 (Page 7986)

ControlPanel tags as of V4
The "ControlPanel" tags do not contain any user-relevant data. These tags cannot be accessed 
in the user program.

See also
Tag of the axis technology object V1...3 (Page 7986)

Internal tags as of V4
The "Internal" tags do not contain any user-relevant data. These tags cannot be accessed in 
the user program.

See also
Tag of the axis technology object V1...3 (Page 7986)

Update of the technology object tags
The status and error information of the axis indicated in the technology object tags is updated 
at each cycle control point.  

Changes to the values of configuration tags do not take effect immediately. For information on 
the conditions under which a change takes effect, refer to the detailed description of the 
relevant tag.
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11.2.12.9 Tags of the command table technology object as of V4

Command[1...32] tags as of V4
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the configuration of the command table.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Command table>.Command[n].Type
Command type
● 0 = "Empty" command
● 2 = "Hold" command
● 5 = "Relative positioning" command
● 6 = "Absolute positioning" command
● 7 = "Velocity setpoint" command
● 151 = "Wait" command
Data type Start value Access Effective HMI
Int 0 RW - X

<Command table>.Command[n].Position
Target position/traversing distance of the command
Data type Start value Access Effective HMI
Real 0.0 RW - X

<Axis name>.Command[n].Velocity
Command velocity
Data type Start value Access Effective HMI
Real 0.0 RW - X

<Command table>.Command[n].Duration
Command duration
Data type Start value Access Effective HMI
Real 0.0 RW - X

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
System Manual, 02/2014 7955



<Command table>.Command[n].NextStep
Mode for the transition to the next command
● 0 = "Complete command"
● 1 = "Blend movement"
Data type Start value Access Effective HMI
Int 0 RW - X

<Command table>.Command[n].StepCode
Command step code
Data type Start value Access Effective HMI
Word 0 RW - X

See also
Tags of the command table technology object V1...3 (Page 8001)

11.2.12.1
0

Versions V1...3

CPU outputs relevant for motion control (technology version V1...3)
The number of usable drives depends on the CPU, the number of PTOs (pulse train outputs) 
and the number of available pulse generator outputs.

The following tables provide information about the relevant dependencies:

Maximum number of PTOs
The maximum number of controllable PTOs (drives) depends on the order number of CPU:

Order number CPU Number of PTOs
 xxxxxxx-1xx30-xxxx 2
xxxxxxx-1xx31-xxxx 4

The maximum number of controllable PTOs (drives) applies regardless of the use of a signal 
board.

Usable pulse generator outputs
The CPU provides one pulse output and one direction output for controlling a stepper motor 
drive or a servo motor drive with pulse interface. The pulse output provides the drive with the 
pulses required for motor motion. The direction output controls the travel direction of the drive.

Pulse and direction outputs are permanently assigned to one another and form a pulse 
generator output. On-board CPU outputs or outputs of a signal board can be used as pulse 
generator outputs. You select between on-board CPU outputs and outputs of the signal board 
during device configuration under Pulse generators (PTO/PWM) on the "Properties" tab.
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The following table shows the number of usable drives per CPU or signal board:

CPU On-
board

Signal board

  DI2/DO2 x 
DC24V 
20kHz

DI2/DO2 x 
DC24V 
200kHz

DO4 x 
DC24V 
200kHz

DI2/DO2 x 
DC5V 
200kHz

DO4 x DC5V 
200kHz

CPU 1211C, CPU 
1212C, CPU 1214C
(MLFB - order number 
xxxxxxx-1xx30-xxxx)

DC/DC/
DC

2 2 2 2 2 2

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1211C 
(MLFB - order number 
xxxxxxx-1xx31-xxxx)

DC/DC/
DC

2 3 3 4 3 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1212C 
(MLFB - order number 
xxxxxxx-1xx31-xxxx)

DC/DC/
DC

3 4 4 4 4 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1214C 
(MLFB - order number 
xxxxxxx-1xx31-xxxx)

DC/DC/
DC

4 4 4 4 4 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

CPU 1215C DC/DC/
DC

4 4 4 4 4 4

AC/DC/
RLY

- 1 1 2 1 2

DC/DC/
RLY

- 1 1 2 1 2

The following table shows the address assignment of the pulse and direction outputs:

CPU 
S7-1200:

 Outputs PTO1 *) Outputs PTO2 **) Outputs PTO3 *) Outputs PTO4 **)
Pls. Dir. Pls. Dir. Pls. Dir. Pls. Dir.

CPU 1211C,
CPU 1212C,
CPU 1214C,
CPU1215C
(DC/DC/DC)

CPU Ax.0 Ax.1 Ax.2 Ax.3 Ax.4 Ax.5 Ax.6 Ax.7
Signal 
board

Ay.0 Ay.1 Ay.2 Ay.3 Ay.0 Ay.1 Ay.2 Ay.3

CPU 1211C,
CPU 1212C,
CPU 1214C,

CPU - - - - - - - -
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CPU 
S7-1200:

 Outputs PTO1 *) Outputs PTO2 **) Outputs PTO3 *) Outputs PTO4 **)
Pls. Dir. Pls. Dir. Pls. Dir. Pls. Dir.

CPU 1215C
(AC/DC/
RLY)

Signal 
board

Ay.0 Ay.1 Ay.2 Ay.3 Ay.0 Ay.1 Ay.2 Ay.3

CPU 1211C,
CPU 1212C,
CPU 1214C,
CPU 1215C
(DC/DC/
RLY)

CPU - - - - - - - -
Signal 
board

Ay.0 Ay.1 Ay.2 Ay.3 Ay.0 Ay.1 Ay.2 Ay.3

x = Initial byte address of on-board CPU outputs (default value = 0)

y = Initial byte address of signal board outputs (default value = 4)

* If a DC/DC/DC CPU variant is used together with a DI2/DO2 signal board, the signals of the 
PTO1/3 can be generated via the on-board CPU outputs or via the signal board.

** If a DC/DC/DC CPU variant is used together with a DO4 signal board, the signals for PTO1/3 
or PTO2/4 can be generated via the on-board CPU outputs or via the signal board.

 

PTO3 and PTO4 are only available for CPUs with the order numbers xxxxxxx-1xx31-xxxx.

 
 

 Note
Access to pulse generator outputs via the process image

The firmware takes control via the corresponding pulse generator outputs if the PTO (Pulse 
Train Output) is selected and assigned to an axis.

With this takeover of the control function, the connection between the process image and I/
O output is also disconnected. Although the user has the option of writing the process image 
of pulse generator outputs via the user program or watch table, this is not transferred to the 
I/O output. Accordingly, it is also not possible to monitor the I/O output via the user program 
or watch table. The information read reflects the value of the process image and does not 
match the real status of the I/O output.

For all other CPU outputs that are not used permanently by the CPU firmware, the status of 
the I/O output can be controlled or monitored via the process image, as usual.
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Limit frequencies of pulse outputs
The following limit frequencies apply to the pulse outputs:

Pulse output Limit frequencies for 
technology object positioning 
axis V1

Limiting frequencies of 
the technology object 
positioning axis V2/V3
with CPU < V3.0

Limiting frequencies of the 
technology object positioning 
axis V2/V3
with CPU V3.0

On-board (MLFB - order number 
xxxxxxx-1xx30-xxxx)

2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 100 kHz 1 Hz ≤ f ≤ 100 kHz

On-board (MLFB - order number 
xxxxxxx-1xx31xxxx)

2 Hz ≤ f ≤ 100 kHz (PTO 1+2)
2 Hz ≤ f ≤ 20 kHz (PTO 3+4)

2 Hz ≤ f ≤ 100 kHz 
(PTO 1+2)
2 Hz ≤ f ≤ 20 kHz (PTO 
3+4)

1 Hz ≤ f ≤ 100 kHz (PTO 1+2)
1 Hz ≤ f ≤ 20 kHz (PTO 3+4)

Signal board DI2/DO2 x DC24V 
20kHz

2 Hz ≤ f ≤ 20 kHz 2 Hz ≤ f ≤ 20 kHz 1 Hz ≤ f ≤ 20 kHz

Signal board DI2/DO2 x DC24V 
200kHz

2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz 1 Hz ≤ f ≤ 200 kHz

Signal board DO4 x DC24V 
200kHz

2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz 1 Hz ≤ f ≤ 200 kHz

Signal board DI2/DO2 x DC5V 
200kHz

2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz 1 Hz ≤ f ≤ 200 kHz

Signal board DO4 x DC5V 
200kHz

2 Hz ≤ f ≤ 100 kHz 2 Hz ≤ f ≤ 200 kHz 1 Hz ≤ f ≤ 200 kHz

Drive signals
For motion control, you can optionally parameterize a drive interface for "Drive enabled" and 
"Drive ready". When using the drive interface the digital output for the drive enable and the 
digital input for "drive ready" can be freely selected.

Acceleration/deceleration limits
The following limits apply to acceleration and deceleration:

Acceleration/deceleration Value (CPU < V3.0) Value (CPU V3.0)
Minimum acceleration/deceleration 2.8E-1 pulses/s2 5.0E-3 pulses/s2

Maximum acceleration/deceleration 9.5E+9 pulses/s2 9.5E+9 pulses/s2

Jerk limits
The following limits apply to the jerk:

Jerk Value (CPU < V3.0) Value (CPU V3.0)
Minimum jerk 4.0E-2 pulses/s3 4.0E-3 pulses/s3

Maximum jerk 1.5E+8 pulses/s3 1.0E+10 pulses/s3
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See also
CPU outputs relevant for motion control (technology version V4) (Page 7802)

Configuration dialogs

Configuration - General ("Axis" technology object V1...3)
Configure the basic properties of the "Axis" technology object in the "General" configuration 
window.

Axis name:   
Define the name of the axis or the name of the "Axis" technology object in this box. The 
technology object is listed under this name in the project navigation.

Hardware interface   
The pulses are output to the power unit of the drive by fixed assigned digital outputs.

In CPUs with relay outputs, the pulse signal cannot be output on these outputs because the 
relays do not support the necessary switching frequencies. A signal board with digital outputs 
must be used to enable you to work with the PTO (Pulse Train Output) on these CPUs.

 

 Note

The PTO requires the functionality of a fast counter (HSC). An HSC is used for this purpose 
with CPU version <V3.0. The HSC is then no longer available to the user. An internal HSC 
is used for this with CPU version ≥ V3.0. 

The count can not be evaluated from its input address.

The assignment between PTO and HSC is fixed. When the user activates PTO1, it is 
connected to the HSC1. If the PTO2 is activated, this is connected with the HSC2.  

 

In the "Pulse generator selection" drop-down list, select the PTO (Pulse Train Output) which 
is to provide the pulses for controlling the stepper motors or servo motors with pulse interface. 
If the pulse generators and high-speed counters are not used elsewhere in the device 
configuration, the hardware interface can be configured automatically. In this case, the PTO 
selected in the drop-down list is displayed with a white background. The interfaces used are 
listed in the output boxes "Output source", "Pulse output", "Direction output" and "Assigned 
fast counter".

Proceed as follows if you wish to change the interfaces or if the PTO could not be automatically 
configured (entry in the "Pulse generator selection" drop-down list is highlighted in red):
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1. Click on the "Device configuration" button.
The pulse generator device configuration opens.
Enlarge the property window of the device configuration if the configuration of the pulse 
generator is not visible.

2. Select the "Enable this pulse generator" check box.

3. Select the "Parameter assignment" entry in the area navigation.
The "Parameter assignment" opens.

4. In the "Pulse generator as:" dropdown list select the "PTO" entry.

5. In the "Output source:" dropdown list select the "Integrated CPU output" or "Signal board 
output" entry. The "Signal board output" entry can only be selected for PTO1 or for PTO1 
and PTO2 depending on the installed signal board. For more detailed information, see 
section: CPU outputs relevant for motion control (technology version V4) (Page 7802)

6. Go back to the axis configuration.
Unless the corresponding fast counter has already been used elsewhere, the PTO boxes 
of the "General" axis configuration are not shaded red. If this is not the case, correct the 
configuration based on the error messages.

User unit   
Select the desired unit for the dimension system of the axis in the dropdown list. The selected 
unit is used for additional configuration of the "Axis" technology object and for displaying the 
current axis data.
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The values at the input parameters (Position, Distance, Velocity, ...) of the Motion Control 
instructions also refer to this unit.

 

 Note

Later changing of the dimension system may not be converted correctly in all the configuration 
windows of the technology object. In this case check the configuration of all axis parameters.

The values of the input parameters of the Motion Control instructions may have to be adapted 
to the new unit of measurement in the user program.

 

See also
Configuration - General (positioning axis technology object as of V4) (Page 7827)

Changing configuration of dynamic values in user program ("Axis" technology object V1...3)
You can change the following configuration parameters during runtime of the user program in 
the CPU:  

Acceleration and deceleration
You can also change the values for acceleration and deceleration during runtime of the user 
program. Use the following technology object tags for this purpose:

● <Axis name>.Config.DynamicDefaults.Acceleration
for changing acceleration

● <Axis name>.Config.DynamicDefaults.Deceleration
for changing deceleration

Refer to the description of the technology object tags (Page 7986) in the appendix for 
information on when changes to the configuration parameters take effect.

Emergency stop deceleration
You can also change the value for the emergency stop deceleration during runtime of the user 
program. Use the following technology object tag for this purpose:

● <Axis name>.Config.DynamicDefaults.EmergencyDeceleration

Refer to the description of the technology object tags in the appendix for information on when 
changes to the configuration parameter take effect.

 

 NOTICE

After changes to this parameter, it may be necessary to adapt the positions of the hardware 
limit switches and other safety-relevant settings.
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Jerk limit (as of technology object "Axis" V2.0)
You can also activate and deactivate the jerk limit at runtime of the user program and change 
the value for the jerk. Use the following technology object tags for this purpose:

● <Axis name>.Config.DynamicDefaults.JerkActive
for activating and deactivating the jerk limit

● <Axis name>.Config.DynamicDefaults.Jerk
for changing the jerk

Refer to the description of the technology object tags in the appendix for information on when 
changes to the configuration parameter take effect.

See also
Changing the configuration of dynamics in the user program (Page 7841)

Configuration - Homing ("Axis" technology object V1)
Configure the parameters for active and passive homing in the "Homing" configuration window. 
The homing method is set using the "Mode" input parameter of the Motion Control instruction. 
Here, Mode = 2 means passive homing and Mode = 3 means active homing.

Reference point switch input
Select the digital input for the reference point switch from the drop-down list. The input must 
be interrupt-capable. The onboard CPU inputs and the inputs of an inserted signal board can 
be selected as inputs for the reference point switch.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default.

When the digital inputs are used as a reference point switch, this can result in undesired 
decelerations and thus inaccuracies. Depending on the homing velocity and extent of the 
reference point switch, the reference point may not be detected. The filter time can be set 
under "Input filter" in the device configuration of the digital inputs.

The specified filter time must be less than the duration of the input signal at the reference 
point switch.

 

Permitting direction reversal after reaching the HW limit switch (active homing only)
Activate the check box to use the hardware limit switch as a reversing cam for the homing 
procedure. The hardware limit switches must be activated for direction reversal. If the CPU 
firmware V1.0 is used, both hardware limit switches must be configured. If CPU firmware as 
of V2.0 is used, only the hardware limit switch in the approach direction must be configured.

If the hardware limit switch is reached during active homing, the axis brakes at the configured 
deceleration (not with the emergency stop deceleration) and reverses direction. The reference 
point switch is then sensed in reverse direction.
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If the direction reversal is not active and the axis reaches the hardware limit switch during 
active homing, the homing procedure is aborted with an error and the axis is braked at the 
emergency stop deceleration.

 

 Note

Use one of the following measures to ensure that the machine does not travel to a mechanical 
endstop in the event of a direction reversal:
● Keep the approach velocity low
● Increase the configured acceleration/deceleration
● Increase the distance between hardware limit switch and mechanical stop

 

Approach / homing direction (active and passive homing)
With the direction selection, you determine the "approach direction" used during active homing 
to search for the reference point switch, as well as the homing direction. The homing direction 
specifies the travel direction the axis uses to approach the configured end of the reference 
point switch to carry out the homing operation.

Refer to the table under "Reference point switches" for the effect of the approach direction 
setting on passive homing.

Side of the reference point switch (active and passive homing)
● Active homing

This is where you select whether the axis is homed on the low or high end of the reference 
point switch.

 

  Note

Depending on the start position of the axis and the configuration of the homing parameters, 
the homing procedure sequence can differ from the diagram in the configuration window.

 

● Passive homing
With passive homing, the traversing motions for purposes of homing must be implemented 
by the user via motion commands. The end of the reference point switch on which homing 
occurs depends on the following factors:

– "Approach direction" configuration

– "Reference point switch" configuration

– Current travel direction during passive homing

The table below presents details on the effect of factors:

Influencing factors: Result:
Configuration

Approach direction
Configuration

Reference point switch
Current travel direction Homing on

Reference point switch
Positive "Bottom side" Positive direction Top side

Negative direction Bottom side
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Influencing factors: Result:
Configuration

Approach direction
Configuration

Reference point switch
Current travel direction Homing on

Reference point switch
Positive "Top side" Positive direction Bottom side

Negative direction Top side
Negative "Bottom side" Positive direction Bottom side

Negative direction Top side
Negative "Top side" Positive direction Top side

Negative direction Bottom side

 

Velocity (active homing only)
In this box, specify the velocity at which the reference point switch is to be searched for during 
the homing procedure.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ approach velocity ≤ maximum velocity

Homing velocity (active homing only)
In this box, specify the velocity at which the axis approaches the reference point switch for 
homing.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ Homing velocity ≤ Maximum velocity

Home position offset (active homing only)
If the desired home position deviates from the position of the reference point switch, the home 
position offset can be specified in this box. 

If the value does not equal 0, the axis executes the following actions following homing at the 
reference point switch:

1. Move the axis at the homing velocity by the value of the home position offset

2. Upon reaching the "home position offset", the axis is at the home position that was specified 
in input parameter "Position" of the "MC_Home" Motion Control instruction.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ home position offset ≤ 1.0e12

Home position
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.
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Configuration - Homing ("Axis" technology object V2...3)

Configuration - Homing - General (Axis technology object V2...3)
Configure the reference point switch input for active and passive homing in the "Homing - 
General" configuration window.

Reference point switch input 
Select the digital input for the homing switch from the drop-down list. The input must be 
interrupt-capable. The on-board CPU inputs and the inputs of an inserted signal board can be 
selected as inputs for the homing switch.

 

 Note

The digital inputs are set to a filter time of 6.4 ms by default.

When the digital inputs are used as a homing switch, this can result in undesired decelerations 
and thus inaccuracies. Depending on the homing velocity and extent of the homing switch, 
the home position may not be detected. The filter time can be set under "Input filter" in the 
device configuration of the digital inputs.

The specified filter time must be less than the duration of the input signal at the homing switch.
 

Active level
In the drop-list, select the level of the homing switch that is to be used for homing.

See also
Sequence - Active homing (Page 7847)

Configuration - Homing - Passive (Axis technology object V2...3)
Configure the necessary parameters for passive homing in the "Homing - Passive" 
configuration window.   

The movement for passive homing must be triggered by the user (e.g. using an axis motion 
command). Passive homing is started using Motion Control instruction "MC_Home" with input 
parameter "Mode" = 2.

Side of the homing switch   
This is where you select whether the axis is to be homed on the low or high end of the homing 
switch.
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Home position   
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.

 

 Note

If passive homing is carried out without an axis motion command (axis at a standstill), homing 
will be executed upon the next rising or falling edge at the homing switch.

 

Configuration - Homing - Active (Axis technology object V2...3)
Configure the necessary parameters for active homing in the "Active homing" configuration 
window. Active homing is started using Motion Control instruction "MC_Home" with input 
parameter "Mode" = 3.  

Permit auto reverse at the hardware limit switch  
Activate the check box to use the hardware limit switch as a reversing cam for the homing 
procedure. The hardware limit switches must be enabled for the reversal of direction (at least 
the hardware limit switch in the direction of approach must be configured).

If the hardware limit switch is reached during active homing, the axis brakes at the configured 
deceleration (not with the emergency stop deceleration) and reverses direction. The homing 
switch is then sensed in reverse direction.

If the direction reversal is not active and the axis reaches the hardware limit switch during 
active homing, the homing procedure is aborted with an error and the axis is braked at the 
emergency stop deceleration.

 

 Note

If possible, use one of the following measures to ensure that the machine does not travel to 
a mechanical endstop in the event of a direction reversal:
● Keep the approach velocity low.
● Increase the configured acceleration/deceleration.
● Increase the distance between the hardware limit switch and the mechanical endstop.

 

Approach/homing direction  
With the direction selection, you determine the approach direction used during active homing 
to search for the homing switch, as well as the homing direction. The homing direction specifies 
the travel direction the axis uses to approach the configured end of the homing switch to carry 
out the homing operation.

Side of the homing switch  
This is where you select whether the axis is to be homed on the low or high end of the homing 
switch.
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Velocity
In this box, specify the velocity at which the homing switch is to be searched for during the 
homing procedure.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ approach velocity ≤ maximum velocity

Homing velocity  
In this box, specify the velocity at which the reference point switch is to be approached for 
homing.

Limits (independent of the selected unit of measurement):

● Start/stop velocity ≤ Homing velocity ≤ Maximum velocity

Home position offset  
If the desired home position deviates from the position of the homing switch, the home position 
offset can be specified in this box. 

If the value does not equal 0, the axis executes the following actions following homing at the 
homing switch:

1. Move the axis at the homing velocity by the value of the home position offset

2. Upon reaching the "home position offset", the axis is at the home position that was specified 
in input parameter "Position" of the "MC_Home" Motion Control instruction.

Limits (independent of the selected unit of measurement):

● -1.0e12 ≤ home position offset ≤ 1.0e12

Home position  
The position configured in the Motion Control instruction "MC_Home" is used as the home 
position.

 

Diagnostics - Status and error bits ("Axis" technology object V1...3)
You use the "Status and error bits" diagnostic function to monitor the most important status 
and error messages for the axis in the TIA Portal. The diagnostic function display is available 
in online mode in "Manual control" mode and in "Automatic control" when the axis is active. 
The status error messages have the following meaning:
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Status of the axis

Status Description
Enabled The axis is enabled and ready to be controlled via Motion Control commands.

(Tag of technology object: <Axis name>.StatusBits.Enable)
Homed The axis is homed and is capable of executing absolute positioning commands of Motion Control 

instruction "MC_MoveAbsolute". The axis does not have to be homed for relative positioning. Special 
situations:
● During active homing, the status is FALSE.
● If a homed axis undergoes passive homing, the status is set to TRUE during passive homing.
(Tag of technology object: <Axis name>.StatusBits.HomingDone)

Axis error An error has occurred in the "Axis" technology object. Additional information about the error is 
available in automatic control at the ErrorID and ErrorInfo parameters of the Motion Control 
instructions. In manual mode, the "Error message" box of the axis control panel displays detailed 
information about the cause of error.
(Tag of technology object: <Axis name>.StatusBits.Error)

Axis control panel 
enabled

The "Manual control" mode was enabled in the axis control panel. The axis control panel has control 
priority over the "Axis" technology object. The axis cannot be controlled from the user program.
(Tag of technology object: <Axis name>.StatusBits.ControlPanelActive)

Restart necessary A modified configuration of the axis was downloaded to the load memory in CPU RUN operating 
mode. To download the modified configuration to the work memory, you need to restart the axis. Use 
the Motion Control instruction MC_Reset to do this.

Drive status

Status Description
Drive ready The drive is ready for operation.

(Tag of technology object: <Axis name>.StatusBits.DriveReady)
Drive error The drive has reported an error due to loss of its "Drive ready" signal.

(Tag of technology object: <Axis name>.ErrorBits.DriveFault)

Status of the axis motion

Status Description
Standstill The axis is at a standstill.

(Tag of technology object: <Axis name>.StatusBits.StandStill)
Acceleration The axis accelerates.

(Tag of technology object: <Axis name>.StatusBits.Acceleration)
Constant velocity The axis travels at constant velocity.

(Tag of technology object: <Axis name>.StatusBits.ConstantVelocity)
Deceleration The axis decelerates (slows down).

(Tag of technology object: <Axis name>.StatusBits.Deceleration)
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Status of the motion mode

Status Description
Positioning The axis executes a positioning command of the Motion Control instruction 

"MC_MoveAbsolute", "MC_MoveRelative" or the axis control panel.
(Tag of technology object: <Axis name>.StatusBits.PositioningCommand)

Travel with velocity 
specification

The axis executes a command with velocity specification of the Motion Control instruction 
"MC_MoveVelocity", "MC_MoveJog" or the axis control panel.
(Tag of technology object: <Axis name>.StatusBits.SpeedCommand)

Homing The axis executes a homing command of the Motion Control instruction "MC_Home" or the 
axis control panel.
(Tag of technology object: <Axis name>.StatusBits.Homing)

Command table active
(as of technology object Axis 
V2.0)

The axis is controlled by Motion Control instruction "MC_CommandTable".
(Tag of technology object: <Axis name>.StatusBits.CommandTableActive)

Error messages

Error Description
Lower SW limit switch was 
reached

The lower software limit switch has been reached.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMinReached)

Lower SW limit switch was 
exceeded

The lower software limit switch has been exceeded.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMinExceeded)

Upper SW limit switch was 
reached

The upper software limit switch has been reached.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMaxReached)

Upper SW limit switch was 
exceeded

The upper software limit switch has been exceeded.
(Tag of technology object: <Axis name>.ErrorBits.SwLimitMaxExceeded)

Lower HW limit switch was 
reached

The lower hardware limit switch has been reached.
(Tag of technology object: <Axis name>.ErrorBits.HwLimitMin)

Upper HW limit switch was 
reached

The upper hardware limit switch has been reached.
(Tag of technology object: <Axis name>.ErrorBits.HwLimitMax)

PTO and HSC already in use A second axis is using the same PTO (Pulse Train Output) and HSC (High Speed Counter) 
and is enabled with "MC_Power".
(Tag of technology object: <Axis name>.ErrorBits.HwUsed)

Configuration error The "Axis" technology object was incorrectly configured or editable configuration data were 
modified incorrectly during runtime of the user program.
(Tag of technology object: <Axis name>.ErrorBits.ConfigFault)

Internal error An internal error has occurred.
(Tag of technology object: <Axis name>.ErrorBits.SystemFault)

See also
Status and error bits (technology objects as of V4)  (Page 7908)
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ErrorIDs and ErrorInfos

List of ErrorIDs and ErrorInfos (technology objects V2...3)
The following table lists all ErrorIDs and ErrorInfos that can be indicated in Motion Control 
instructions. In addition to the cause of the error, remedies for eliminating the error are also 
listed:   

Operating error with axis stop

ErrorID ErrorInfo Description Remedy
16#8000 Drive error, loss of "Drive ready"
 16#0001 - Acknowledge error with instruction "MC_Reset"; 

provide drive signal; restart command, if necessary
16#8001 Lower SW limit switch has been tripped
 16#000E The position of the lower SW limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the positive direction out of the range of the 
SW limit switch16#000F The position of the lower SW limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the lower SW limit switch was 

exceeded with the emergency stop deceleration
16#8002 Upper SW limit switch has been tripped
 16#000E The position of the upper SW limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the negative direction out of the range of the 
SW limit switch16#000F The position of the upper SW limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the upper SW limit switch was 

exceeded with the emergency stop deceleration
16#8003 Lower HW limit switch was reached
 16#000E The lower HW limit switch was reached. The 

axis was stopped with the emergency stop 
deceleration.
(During an active homing procedure, the 
reference point switch was not found)

Acknowledge the error for an enabled axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the positive direction out of the 
range of the HW limit switch.

16#8004 Upper HW limit switch was reached
 16#000E The upper HW limit switch has been reached. 

The axis was stopped with the emergency stop 
deceleration.
(During an active homing procedure, the 
reference point switch was not found)

Acknowledge the error for an enabled axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the negative direction out of the 
range of the HW limit switch.

16#8005 PTO/HSC are already being used by another axis
 16#0001 - The axis was configured incorrectly:

Correct the configuration of the PTO (Pulse Train 
Output) / HSC (High Speed Counter) and download 
it to the controller
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ErrorID ErrorInfo Description Remedy
More than one axis is to run with one PTO:
Another axis is using the PTO / HSC. If the current 
axis is to assume the control, the other axis must 
be disabled with "MC_Power" Enable = FALSE.
(see also Using multiple axes with the same PTO 
(Page 7912))

16#8006 A communication error in the control panel has occurred 
 16#0012 A timeout has occurred Check the cable connection and press the "Manual 

control" button again.
16#8007 The axis cannot be enabled.
 16#0025 Restarting Wait until the axis restart is complete.
 16#0026 Executing loading process in RUN mode Wait until the loading process is complete.

Operating error without axis stop

ErrorID ErrorInfo Description Remedy
16#8200 Axis is not enabled
 16#0001 - Enable the axis; restart the command
16#8201 Axis has already been enabled by another "MC_Power" instance
 16#0001 - Enable the axis with only one "MC_Power" instance
16#8202 The maximum number of simultaneously active Motion Control commands has been exceeded 

(maximum of 200 commands for all motion control technology objects)
 16#0001 - Reduce the number of simultaneously active 

commands; restart the command
A command is active if parameter "Busy" = TRUE 
in the Motion Control instruction.

16#8203 Axis is currently operated in "Manual control" (axis control panel)
 16#0001 - Exit "Manual control"; restart the command
16#8204 Axis is not homed
 16#0001 - Home the axis with instruction "MC_Home"; restart 

the command
16#8205 The axis is currently controlled by the user program (the error is only displayed in the axis control 

panel)
 16#0013 The axis is enabled in the user program. Disable axis with instruction "MC_Power" and 

select "Manual control" again in the axis control 
panel

16#8206 Technology object not activated yet
 16#0001 - Enable the axis with instruction "MC_Power" 

Enable = TRUE or enable the axis in the axis control 
panel.

16#8207 Command rejected
 16#0016 Active homing is running; another homing 

method cannot be started.
Wait for active homing to finish or abort the active 
homing with a motion command, for example, 
"MC_Halt".
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ErrorID ErrorInfo Description Remedy
16#0018 The axis cannot be moved with a command 

table while it is being actively or passively 
homed.

Wait until direct or passive homing is complete.

16#0019 The axis cannot be actively or passively homed 
while a command table is being processed.

Wait for command table to finish or abort the 
command table with a motion command, for 
example, "MC_Halt".

16#8208 Difference between maximum and start/stop velocity is invalid
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#8209 Invalid acceleration for technology object "Axis"
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#820A It is not possible to restart the axis
 16#0013 The axis is enabled in the user program. Disable the axis with the "MC_Power" instruction; 

restart again
 16#0027 The axis is currently being operated in "Manual 

control" (axis control panel)
Exit "Manual control"; restart again

16#820B It is not possible to execute the command table
 16#0026 Executing loading process in RUN mode Wait until the loading process is complete.

Block parameter error

ErrorID ErrorInfo Description Remedy
16#8400 Invalid value at parameter "Position" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8401 Invalid value at parameter "Distance" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8402 Invalid value at parameter "Velocity" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#0008 Value is greater than the configured maximum 
velocity

16#0009 Value is less than the configured start/stop 
velocity

16#0024 Value is less than 0
16#8403 Invalid value at parameter "Direction" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; restart the command
16#8404 Invalid value at parameter "Mode" of the Motion Control instruction
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ErrorID ErrorInfo Description Remedy
 16#0011 The selection value is invalid Correct the selection value; restart the command

16#0015 Active/passive homing is not configured Correct the configuration and download it to the 
controller; enable the axis and restart the command

16#0017 The direction reversal is activated at the 
hardware limit switch, despite the fact that the 
hardware limit switches are disabled

● Activate the hardware limit switch using the tag 
<axis>.Config.PositionLimits_HW.Active = 
TRUE, restart the command

● Correct the configuration and download it to the 
controller; enable the axis and restart the 
command

16#8405 Invalid value at parameter "StopMode" of the Motion Control instruction
 16#0011 The selection value is invalid Correct the selection value; enable the axis again
16#8406 Simultaneous forward and backward jogging is not allowed
 16#0001 - Take steps to ensure that parameters 

"JogForward" and "JogBackward" do not have 
signal status TRUE simultaneously; restart the 
command.

16#8407 Switching to another axis with instruction "MC_Power" is only permitted after disabling the active axis.
 16#0001 - Disable the active axis; it is then possible to switch 

to the other axis and enable it.
16#8408 Invalid value at parameter "Axis" of the Motion Control instruction
 16#001A The specified value does not match the 

required technology object version
Correct the value; restart the command

16#001B The specified value does not match the 
required technology object type

16#001C The specified value is not a Motion Control 
technology data block

16#8409 Invalid value at parameter "CommandTable" of the Motion Control instruction
 16#001A The specified value does not match the 

required technology object version
Correct the value; restart the command

16#001B The specified value does not match the 
required technology object type

16#001C The specified value is not a Motion Control 
technology data block

16#840A Invalid value at parameter "StartStep" of the Motion Control instruction
 16#000A Value is less than or equal to 0 Correct the value; restart the command

16#001D The start step is greater than the end step
16#001E Value is greater than 32

16#840B Invalid value at parameter "EndStep" of the Motion Control instruction
 16#000A Value is less than or equal to 0 Correct the value; restart the command

16#001E Value is greater than 32
16#840C Invalid value at parameter "RampUpTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840D Invalid value at parameter "RampDownTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
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ErrorID ErrorInfo Description Remedy
16#840E Invalid value at parameter "EmergencyRampTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0
16#840F Invalid value at parameter "JerkTime" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the value; restart the command

16#000A Value is less than or equal to 0

Configuration error of the axis

ErrorID ErrorInfo Description Remedy
16#8600 Parameter assignment of pulse generator (PTO is invalid
 16#000B The address is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#0014 The selected hardware is used by another 
application

16#8601 Parameter assignment of the high-speed counter (HSC) is invalid
 16#000B The address is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#0014 The selected hardware is used by another 
application

16#8602 Invalid parameter assignment of "Enable output"
 16#000B The address is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#8603 Invalid parameter assignment of "Ready input"
 16#000B The address is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#8604 Invalid "Pulses per motor revolution" value
 16#000A Value is less than or equal to zero ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#8605 Invalid "Distance per revolution" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#0005 The value is outside the number range (greater 
than 1e12)

16#000A Value is less than or equal to zero
16#8606 Invalid "Start/stop velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit
16#0007 The start/stop velocity is greater than the 

maximum velocity
16#8607 Invalid "maximum velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#0003 Value exceeds the upper hardware limit
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ErrorID ErrorInfo Description Remedy
16#0004 Value is less than the lower hardware limit

16#8608 Invalid "Acceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#8609 Invalid "Deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#860A Invalid "Emergency stop deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the upper hardware limit
16#0004 Value is less than the lower hardware limit

16#860B Value for position of the lower SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#0007 The position value of the lower software limit 
switch is greater than that of the upper software 
limit switch

16#860C Value for position of the upper SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#860D Invalid address of the lower HW limit switch
 16#000C The address of the falling edge is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#000D The address of the rising edge is invalid

16#860E Invalid address of the upper HW limit switch
 16#000C The address of the falling edge is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#000D The address of the rising edge is invalid

16#860F Invalid "home position offset" value
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ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8610 Invalid "approach velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0008 The velocity is greater than the maximum 
velocity

16#0009 The velocity is less than the start/stop velocity

16#8611 Invalid "Homing velocity" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0008 The velocity is greater than the maximum 
velocity

16#0009 The velocity is less than the start/stop velocity

16#8612 Invalid address of the reference point switch
 16#000C The address of the falling edge is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

16#000D The address of the rising edge is invalid

16#8613 During active homing, direction reversal at the hardware limit switch is activated although the 
hardware limit switches are not configured

 16#0001 - ● Download error-free configuration to the 
controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#8614 Invalid "Jerk" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#001F Value is greater than the maximum jerk
16#0020 Value is less than the minimum jerk

16#8615 Value for "Unit of measurement" is invalid
 16#0011 The selection value is invalid Download error-free configuration to the controller; 

enable the axis again with instruction "MC_Power"

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
System Manual, 02/2014 7977



Configuration error of the command table

ErrorID ErrorInfo Description Remedy
16#8700 Value for "Command type" in the command table is invalid
 16#0001 - ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#8701 Value for "Position / travel path" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12

16#8702 Value for "Velocity" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0008 Value is greater than the configured maximum 
velocity

16#0009 Value is less than the configured start/stop 
velocity

16#8703 Value for "Duration" in the command table is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0021 Value is greater than 64800 s
16#0022 Value is less than 0.001 s

16#8704 Value for "Next step" in the command table is invalid
 16#0011 The selection value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online and restart 
the command, if necessary

16#0023 The command transition is not permitted for this 
command

Internal errors

ErrorID ErrorInfo Description Remedy
16#8FFF Internal error
 16#F0** - POWER OFF and POWER ON the CPU

If this does not work, contact Customer Support. 
Have the following information ready:
● ErrorID
● ErrorInfo
● Diagnostic buffer entries
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See also
List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7926)

Using multiple axes with the same PTO (Page 7912)

List of ErrorIDs and ErrorInfos (technology objects V1)
The following table lists all ErrorIDs and ErrorInfos that can be indicated in Motion Control 
instructions. In addition to the cause of the error, remedies for eliminating the error are also 
listed:

Operating error with axis stop

ErrorID ErrorInfo Description Remedy
16#8000 Drive error, loss of "Drive ready"
 16#0001 - Acknowledge error with instruction "MC_Reset"; 

provide drive signal; restart command, if necessary
16#8001 Lower SW limit switch has been tripped
 16#000E The position of the lower SW limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the positive direction out of the range of the 
SW limit switch16#000F The position of the lower SW limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the lower SW limit switch was 

exceeded with the emergency stop deceleration
16#8002 Upper SW limit switch has been tripped
 16#000E The position of the upper SW limit switch was 

reached with the currently configured 
deceleration

Acknowledge the error with instruction 
"MC_Reset"; use a motion command to move the 
axis in the negative direction out of the range of the 
SW limit switch16#000F The position of the upper SW limit switch was 

reached with the emergency stop deceleration
16#0010 The position of the upper SW limit switch was 

exceeded with the emergency stop deceleration
16#8003 Lower HW limit switch was reached
 16#000E The lower HW limit switch was reached. The 

axis was stopped with the emergency stop 
deceleration.
(During an active homing procedure, the 
reference point switch was not found)

Acknowledge the error for an enabled axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the positive direction out of the 
range of the HW limit switch.

16#8004 Upper HW limit switch was reached
 16#000E The upper HW limit switch has been reached. 

The axis was stopped with the emergency stop 
deceleration.
(During an active homing procedure, the 
reference point switch was not found)

Acknowledge the error for an enabled axis with 
instruction "MC_Reset"; use a motion command to 
move the axis in the negative direction out of the 
range of the HW limit switch.

16#8005 PTO/HSC are already being used by another axis
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ErrorID ErrorInfo Description Remedy
 16#0001 - The axis was configured incorrectly:

Correct the configuration of the PTO (Pulse Train 
Output) / HSC (High Speed Counter) and download 
it to the controller
More than one axis is to run with one PTO:
Another axis is using the PTO / HSC. If the current 
axis is to assume the control, the other axis must 
be disabled with "MC_Power" Enable = FALSE.
(see also Using multiple axes with the same PTO 
(Page 7912))

Operating error without axis stop

ErrorID ErrorInfo Description Remedy
16#8200 Axis is not enabled
 16#0001 - Enable the axis; restart the command
16#8201 Axis has already been enabled by another "MC_Power" instance
 16#0001 - Enable the axis with only one "MC_Power" 

instruction 
16#8202 The maximum number of simultaneously active Motion Control commands was exceeded (maximum 

of 200 commands for all motion control technology objects)
 16#0001 - Reduce the number of simultaneously active 

commands; restart the command
A command is active if parameter "Busy" = TRUE 
in the Motion Control instruction.

16#8203 Axis is currently operated in "Manual control" (axis control panel)
 16#0001 - Exit "Manual control"; restart the command
16#8204 Axis is not homed
 16#0001 - Home the axis with instruction "MC_Home"; restart 

the command
16#8205 The axis is currently controlled by the user program (the error is only displayed in the axis control 

panel)
 16#0001 - Disable axis with instruction "MC_Power" and 

select "Manual control" again in the axis control 
panel

16#8206 Technology object Axis not yet enabled
 16#0001 - Enable the axis with instruction "MC_Power" 

Enable = TRUE or enable the axis in the axis control 
panel.

16#8207 Command rejected
 16#0016 Active homing is running; another homing 

method cannot be started.
Wait for active homing to finish or abort the active 
homing with a motion command, for example, 
"MC_Halt". The other homing type can then be 
started.
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Block parameter error

ErrorID ErrorInfo Description Remedy
16#8400 Invalid value at parameter "Position" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the "position" value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8401 Invalid value at parameter "Distance" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the "Distance" value; restart the command

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8402 Invalid value at parameter "Velocity" of the Motion Control instruction
 16#0002 Number format of value is invalid Correct the "Velocity" value; restart the command

16#0008 Velocity is greater than the maximum velocity
16#0009 Velocity is less than the start/stop velocity

16#8403 Invalid value at parameter "Direction" of the Motion Control instruction
 16#0011 Invalid selection value Correct the selection value; restart the command
16#8404 Invalid value at parameter "Mode" of the Motion Control instruction
 16#0011 Invalid selection value Correct the selection value; restart the command

16#0015 Active/passive homing is not configured Correct the configuration and download it to the 
controller; enable the axis and restart the command

16#0017 Axis reversal is activated at the HW limit switch, 
despite the fact that the hardware limit switches 
are disabled

● Activate the hardware limit switch using the tag 
<axis>.Config.PositionLimits_HW.Active = 
TRUE, restart the command

● Correct the configuration and download it to the 
controller; enable the axis and restart the 
command

16#8405 Invalid value at parameter "StopMode" of the Motion Control instruction
 16#0011 Invalid selection value Correct the selection value; enable the axis again
16#8406 Simultaneous forward and backward jogging is not allowed
 16#0001 - Take steps to ensure that parameters 

"JogForward" and "JogBackward" do not have 
signal status TRUE simultaneously; restart the 
command.

16#8407 Switching the axis with Motion Control instruction "MC_Power" is only permitted after disabling the 
axis.

 16#0001 - Disable the active axis; it is then possible to switch 
to the other axis and enable it.
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Configuration error

ErrorID ErrorInfo Description Remedy
16#8600 Parameter assignment of pulse generator (PTO is invalid
 16#000B Address is invalid Correct the configuration of the PTO (Pulse Train 

Output) and download it to the controller
16#8601 Parameter assignment of the high-speed counter (HSC) is invalid
 16#000B Address is invalid Correct the configuration of the HSC (High Speed 

Counter) and download it to the controller
16#8602 Invalid parameter assignment of "Enable output"
 16#000D Address is invalid Correct the configuration and download it to the 

controller
16#8603 Invalid parameter assignment of "Ready input"
 16#000D Address is invalid Correct the configuration and download it to the 

controller
16#8604 Invalid "Pulses per motor revolution" value
 16#000A Value is less than or equal to zero Correct the configuration and download it to the 

controller
16#8605 Invalid "Distance per revolution" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#000A Value is less than or equal to zero
16#8606 Invalid "Start/stop velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit
16#0007 The start/stop velocity is greater than the 

maximum velocity
16#8607 Invalid "Maximum velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#8608 Invalid "Acceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#8609 Invalid "Deceleration" value
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#860A Invalid "Emergency stop deceleration" value
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ErrorID ErrorInfo Description Remedy
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0003 Value exceeds the hardware limit
16#0004 Value is less than the hardware limit

16#860B Value for position of the lower SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#0007 The position value of the lower SW limit switch 
is greater than that of the upper SW limit switch

16#860C Value for position of the upper SW limit switch is invalid
 16#0002 Number format of value is invalid ● Download error-free configuration to the 

controller; enable the axis again with instruction 
"MC_Power"

● Correct the incorrect value online; acknowledge 
error with instruction "MC_Reset" and restart 
the command, if necessary

16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#860D Invalid address of the lower HW limit switch
 16#000C Address of falling edge is invalid Correct the configuration and download it to the 

controller16#000D Address of rising edge is invalid
16#860E Invalid address of the upper HW limit switch
 16#000C Address of falling edge is invalid Correct the configuration and download it to the 

controller16#000D Address of rising edge is invalid
16#860F Invalid "home position offset" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0005 The value is outside the number range (greater 
than 1e12)

16#0006 The value is outside the number range (less 
than -1e12)

16#8610 Invalid "approach velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0008 Velocity is greater than the maximum velocity
16#0009 Velocity is less than the start/stop velocity

16#8611 Invalid "Homing velocity" value
 16#0002 Number format of value is invalid Correct the configuration and download it to the 

controller16#0008 Velocity is greater than the maximum velocity
16#0009 Velocity is less than the start/stop velocity

16#8612 Invalid address of the reference point switch
 16#000C Address of falling edge is invalid Correct the configuration and download it to the 

controller16#000D Address of rising edge is invalid
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ErrorID ErrorInfo Description Remedy
16#8613 During active homing, direction reversal at the hardware limit switch is activated although the 

hardware limit switches are not configured
 16#0001 - Correct the configuration and download it to the 

controller

Internal errors

ErrorID ErrorInfo Description Remedy
16#8FFF Internal error
 16#F0** - POWER OFF and POWER ON the CPU

If this does not work, contact Customer Support. 
Have the following information ready:
● ErrorID
● ErrorInfo
● Diagnostic buffer entries

See also
List of ErrorIDs and ErrorInfos (technology objects as of V4) (Page 7926)

Using multiple axes with the same PTO (Page 7912)

Tag of the axis technology object V1...3

Config tags V1...3

Config.General tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.
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<Axis name>.Config.General.PTO
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWORD DW#16#00000000 - - -

<Axis name>.Config.General.HSC
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWORD DW#16#00000000 - - -

<Axis name>.Config.General.LengthUnit ("Axis" technology object as of V2.0)
The unit of measurement for the parameter selected in the configuration:
● 1013 = "mm"
● 1010 =: "m"
● 1019 = "in"
● 1018 = "ft"
● 1005 = "°" (degrees)
● -1 = "Pulse"
Data type Start value Access Effective HMI
Int 1013 R - X

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

Config.DriveInterface tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.DriveInterface.EnableOutput
Tags cannot be evaluated in the user program.
Data type Start value Access Effective HMI
- - - - -
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<Axis name>.Config.DriveInterface.ReadyInput
Tags cannot be evaluated in the user program.
Data type Start value Access Effective HMI
- - - - -

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

Config.Mechanics tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.Mechanics.PulsesPerDriveRevolution
Increments per motor revolution
Data type Start value Access Effective HMI
DInt L#1000 R - X

<Axis name>.Config.Mechanics.LeadScrew
Distance per revolution (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.0E+001 R - X

<Axis name>.Config.Mechanics.InverseDirection
Invert direction
Data type Start value Access Effective HMI
Bool FALSE R - X

See also
Tags of the positioning axis technology object as of V4 (Page 7936)
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Config.DynamicLimits tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.Config.DynamicLimits.MinVelocity
Start/stop velocity of axis (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.0E+001 R - X

<Axis name>.Config.DynamicLimits.MaxVelocity
Maximum velocity of axis (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 2.5E+002 R - X

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

Config.DynamicDefaults tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 

disabled, or enabled
2 When axis is enabled
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5 The next time an MC_MoveAbsolute,  MC_MoveRelative, MC_MoveVelocity, MC_MoveJog, MC_Halt, 
MC_CommandTable or active MC_Home command is started (Mode = 3).

6 When a MC_MoveJog command is stopped
HMI The tag can be used in an HMI system.

<Axis name>.Config.DynamicDefaults.Acceleration
Acceleration of axis (specified in the configured dimension unit)
Data type Start value Access Effective HMI
Real 4.8E+001 RW 5 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.DynamicDefaults.Deceleration
Deceleration of axis (specified in the configured dimension unit)
Data type Start value Access Effective HMI
Real 4.8E+001 RW 5, 

6
CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.DynamicDefaults.EmergencyDeceleration
Emergency stop deceleration of axis (specified in the configured dimension unit)
Data type Start value Access Effective HMI
Real 1.2E+002 RW 2, 

5, 
6

CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.DynamicDefaults.JerkActive ("Axis" technology object as of V2.0)
TRUE = the jerk limit is activated
Data type Start value Access Effective HMI
Bool FALSE RW 1, 5 X

<Axis name>.Config.DynamicDefaults.Jerk ("Axis" technology object as of V2.0)
Jerk during axis acceleration and deceleration ramp (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.92E+002 RW 1, 5 X

See also
Tags of the positioning axis technology object as of V4 (Page 7936)
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Config.PositionLimits_SW tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 

disabled, or enabled
4 Upon the next start of a Motion Control command after a standstill of the axis. The axis standstill can 

be checked with tag <Axis name>. StatusBits.Standstill.
5 The next time an MC_MoveAbsolute, MC_MoveRelative,  MC_MoveVelocity, MC_MoveJog, 

MC_Halt, MC_CommandTable or active MC_Home command is started (Mode = 3).
HMI The tag can be used in an HMI system.

<Axis name>.Config.PositionLimits_SW.Active
TRUE = The software limit switches are activated
Data type Start value Access Effective HMI
Bool FALSE RW 4 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.PositionLimits_SW.MinPosition
Position of lower software limit switch (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real -1.0E+004 RW 4 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.PositionLimits_SW.MaxPosition
Position of upper software limit switch (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 1.0E+004 RW 4 CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0
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See also
Tags of the positioning axis technology object as of V4 (Page 7936)

Config.PositionLimits_HW tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 

disabled, or enabled
3 After axis enable (the axis must have previously been at a standstill). The axis standstill can be 

checked with tag <Axis name>. StatusBits.Standstill.
4 Upon the next start of a Motion Control command after a standstill of the axis. The axis standstill can 

be checked with tag <Axis name>. StatusBits.Standstill.
5 The next time an MC_MoveAbsolute, MC_MoveRelative, MC_MoveVelocity, MC_MoveJog, 

MC_Halt, MC_CommandTable or active MC_Home command is started (Mode = 3).
HMI The tag can be used in an HMI system.

<Axis name>.Config.PositionLimits_HW.Active
TRUE = The hardware limit switches are active.
Data type Start value Access Effective HMI
Bool FALSE RW 3, 

4
CPU Firmware V1.0 X

1, 
5, 
6

CPU firmware as of 
V2.0

<Axis name>.Config.PositionLimits_HW.MinSwitchedLevel
TRUE = 24 V at CPU input corresponds to lower hardware limit switch approached
FALSE = 0 V at CPU input corresponds to lower hardware limit switch approached
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.Config.PositionLimits_HW.MinFallingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -
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<Axis name>.Config.PositionLimits_HW.MinRisingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

<Axis name>.Config.PositionLimits_HW.MaxSwitchedLevel
TRUE = 24 V at CPU input corresponds to upper hardware limit switch approached
FALSE = 0 V at CPU input corresponds to upper hardware limit switch approached
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.Config.PositionLimits_HW.MaxFallingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

<Axis name>.Config.PositionLimits_HW.MaxRisingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

Config.Homing tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag

The start value can be overwritten by the axis configuration.
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
1 When axis is activated (<Axis name>.StatusBits.Activated tag changes from FALSE -> TRUE), 

disabled, or enabled
7 When a passive homing command is started
8 When an active homing command is started

HMI The tag can be used in an HMI system.
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<Axis name>.Config.Homing.AutoReversal
TRUE = Direction reversal at hardware limit switch enabled (active homing)
FALSE = Direction reversal at hardware limit switch disabled (active homing)
Data type Start value Access Effective HMI
Bool TRUE R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.Direction
TRUE = Positive approach direction to search for reference point switch and positive homing direction (active homing)
FALSE = Negative approach direction to search for reference point switch and positive homing direction (active homing)
Data type Start value Access Effective HMI
Bool TRUE R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.SideActiveHoming ("Axis" technology object as of V2.0)
TRUE = Homing on high end of the reference point switch (active homing)
TRUE = Homing on lower end of the reference point switch (active homing)
Data type Start value Access Effective HMI
Bool TRUE RW 1, 8 X

<Axis name>.Config.Homing.SidePassiveHoming ("Axis" technology object as of V2.0)
TRUE = Homing on high end of the reference point switch (passive homing)
TRUE = Homing on lower end of the reference point switch (passive homing)
Data type Start value Access Effective HMI
Bool TRUE RW 1, 7 X

<Axis name>.Config.Homing.RisingEdge (as of technology object "Axis" V1.0)
TRUE = Homing with negative signal edge of the reference point switch (active homing)
FALSE = Homing with positive signal edge of the reference point switch (active homing)
For information on the effect of the tag on passive homing, refer to the description in "Configuration - Homing".
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.Config.Homing.Offset
Home position offset /specified in the configured unit of measurement (active homing)
Data type Start value Access Effective HMI
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<Axis name>.Config.Homing.Offset
Real 0.0 R

RW
- Technology object 

"Axis" V1.0
X

1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.FastVelocity
Approach velocity / specified in the configured unit of measurement (active homing)
Data type Start value Access Effective HMI
Real 2.0E+002 R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.SlowVelocity
Homing velocity / specified in the configured unit of measurement (active homing)
Data type Start value Access Effective HMI
Real 4.0E+001 R - Technology object 

"Axis" V1.0
X

RW 1, 
8

Technology object 
"Axis" V2.0

<Axis name>.Config.Homing.FallingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - - -

<Axis name>.Config.Homing.RisingEvent
Tag cannot be evaluated in the user program.
Data type Start value Access Effective HMI
DWord DW#16#00000000 - -  

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

MotionStatus tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
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R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.MotionStatus.Position
Current position of the axis (specified in the configured unit of measurement) If the axis is not homed, the tag indicates the 
position value relative to the enable position of the axis.
Data type Start value Access Effective HMI
Real 0.0 R - X

<Axis name>.MotionStatus.Velocity
Current velocity of the axis (specified in the configured unit of measurement)
Data type Start value Access Effective HMI
Real 0.0 R - X

<Axis name>.MotionStatus.Distance
Current distance to the target position of the axis (specified in the configured unit of measurement) The value of the tag is 
only valid during execution of a positioning command with "MC_MoveAbsolute" or "MC_MoveRelative" or of the axis 
command table. 
Data type Start value Access Effective HMI
Real 0.0 R - X

<Axis name>.MotionStatus.TargetPosition
Target position of axis (specified in the configured unit of measurement) The value of the tag is only valid during execution 
of a positioning command with "MC_MoveAbsolute" or "MC_MoveRelative" or of the axis command table.
Data type Start value Access Effective HMI
Real 0.0 R - X

See also
Motion status (Page 7911)

Tags of the positioning axis technology object as of V4 (Page 7936)

StatusBits tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
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- The tag cannot be used in the user program.
Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.StatusBits.Activated
TRUE = The axis is activated. It is connected to the assigned PTO (Pulse Train Output). The data of the technology data 
block will be updated cyclically.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Enable
TRUE = The axis is enabled and ready to take on Motion Control commands.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.HomingDone
TRUE = The axis is homed and is capable of executing absolute positioning commands. The axis does not have to be homed 
for relative positioning.
The status is FALSE during active homing. The status remains TRUE during passive homing if the axis has already been 
homed.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Done
TRUE = No Motion Control command is active on the axis.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Error
TRUE = An error occurred in the axis technology object. Detailed information about the error is available in automatic mode 
in the "ErrorID" and "ErrorInfo" parameters of the Motion Control instructions. In manual mode, the "Error message" box of 
the axis control panel displays detailed information about the cause of error.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.StandStill
TRUE = The axis is at a standstill.
Data type Start value Access Effective HMI
Bool FALSE R - X
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<Axis name>.StatusBits.PositioningCommand
TRUE = The axis is executing a positioning command.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.SpeedCommand
TRUE = The axis is executing a travel command at predefined velocity.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Homing
TRUE = The axis is executing a homing command of the "MC_Home" Motion Control instruction or axis command table.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.CommandTableActive
TRUE = The axis is controlled by Motion Control instruction "MC_CommandTable".
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.ConstantVelocity
TRUE = The axis travels at constant velocity.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Acceleration
TRUE = The axis accelerates.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.Deceleration
TRUE = The axis decelerates (slows down).
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.ControlPanelActive
TRUE = The "Manual control" mode has been enabled in the axis command table. The axis command table has control 
priority over the "Axis" technology object. The axis cannot be controlled from the user program.
Data type Start value Access Effective HMI
Bool FALSE R - X
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<Axis name>.StatusBits.DriveReady
TRUE = The drive is ready.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.StatusBits.RestartRequired
TRUE = Values were modified in the load memory. 
To download the values in the CPU RUN operating mode to the work memory, you need to restart the axis. Use the Motion 
Control instruction MC_Reset to do this.
Data type Start value Access Effective HMI
Bool FALSE R - X

See also
Status and error bits (technology objects as of V4)  (Page 7908)

Tags of the positioning axis technology object as of V4 (Page 7936)

ErrorBits tags V1...3
Legend

Data type Data type of tag
Start value Start value of tag
Access Access to tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.

Effective Specifies when a change to the tag takes effect.
HMI The tag can be used in an HMI system.

<Axis name>.ErrorBits.SystemFault
TRUE = Internal system error.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.ConfigFault
TRUE = Incorrect configuration of axis.
Data type Start value Access Effective HMI
Bool FALSE R - X

Using technology functions
11.2 Using S7-1200 Motion Control

WinCC Professional V13.0
System Manual, 02/2014 7997



<Axis name>.ErrorBits.DriveFault
TRUE = The drive has reported an error due to loss of its "Drive ready" signal.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMinReached
TRUE = The lower software limit switch has been reached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMinExceeded
TRUE = The lower software limit switch has been exceeded.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMaxReached
TRUE = The upper software limit switch has been reached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.SwLimitMaxExceeded
TRUE = The upper software limit switch has been exceeded.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.HwLimitMin
TRUE = The lower hardware limit switch has been approached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.HwLimitMax
TRUE = The upper hardware limit switch has been approached.
Data type Start value Access Effective HMI
Bool FALSE R - X

<Axis name>.ErrorBits.HwUsed
TRUE = A second axis is using the same PTO (Pulse Train Output) and is enabled with "MC_Power".
Data type Start value Access Effective HMI
Bool FALSE R - X
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See also
Status and error bits (technology objects as of V4)  (Page 7908)

Tags of the positioning axis technology object as of V4 (Page 7936)

Internal tags V1...3
The "Internal" tags contain no user-relevant data; these tags cannot be accessed in the user 
program.

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

ControlPanel tags V1...3
The "ControlPanel" tags contain no user-relevant data; these tags cannot be accessed in the 
user program.

See also
Tags of the positioning axis technology object as of V4 (Page 7936)

Update of the technology object tags
The status and error information of the axis indicated in the technology object tags is updated 
at each cycle control point.  

The change in values of editable configuration tags does not take effect immediately. For 
information on the conditions under which a change takes effect, refer to the detailed 
description of the relevant tag.

 

Tags of the command table technology object V1...3

Config.Command.Command[1 ... 32] tags V1...3
Legend

Data type Data type of the tag
Start value Start value of tag

The start value can be overwritten by the configuration of the command table.
Access Access to the tag in the user program:

RW The tag can be read and written in the user program.
R The tag can be read in the user program.
- The tag cannot be used in the user program.
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Effective Specifies when a change in the tag takes effect.
HMI The tag can be used in an HMI system.

<Command table>.Config.Command.Command[x].Type
Command type
● 0 = "Empty" command
● 2 = "Hold" command
● 5 = "Relative positioning" command
● 6 = "Absolute positioning" command
● 7 = "Velocity setpoint" command
● 151 = "Wait" command
Data type Start value Access Effective HMI
Int 0 RW - X

<Command table>. Config.Command.Command[x].Position
Command target position / travel path
Data type Start value Access Effective HMI
Real  RW - X

<Command table>. Config.Command.Command[x].Velocity
Command velocity
Data type Start value Access Effective HMI
Real 0.0 RW - X

<Command table>. Config.Command.Command[x].Duration
Command duration
Data type Start value Access Effective HMI
Real 0.0 RW - X

<Command table>. Config.Command.Command[x].BufferMode
Value for command "Next step"
● 0 = "Complete command"
● 1 = "Blend movement"
Data type Start value Access Effective HMI
Int 0 RW - X

<Command table>. Config.Command.Command[x].StepCode
Command step code
Data type Start value Access Effective HMI
Word 0 RW - X
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See also
Tags of the command table technology object as of V4 (Page 7955)
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Using Team Engineering 12
12.1 Shared commissioning of projects

12.1.1 Basics for shared commissioning

Introduction
As part of Team Engineering , you have the option to perform shared commissioning of 
projects. Several editors can access one CPU at the same time with up to five engineering 
systems (ES) in this process.

A special advantage is that parts of a master project can be edited independently and offline 
at the same time during the commissioning phase. The changes of the other editors are 
displayed in the dialog "Software synchronization" during loading and synchronized 
automatically, if possible.

Certain online functions can also be executed at the same time from several engineering 
systems on the shared CPU, for example:

● Monitoring blocks on the CPU

● Controlling blocks on the CPU

● Trace functions

The following online functions cannot be executed at the same time:

● Forcing: Only one ES can force on the CPU.

● Loading: Only one ES can load to the CPU.

You can also find additional information on the topic of Team Engineering at Service and 
support in Siemens Industry online support (http://support.automation.siemens.com/WW/view/
en/82142829).

Creating a master project
A "master project" structured according to the specified rules (Page 8011), which already 
contains the complete configured hardware configuration with all required tags and blocks, is 
used as the basis for the shared commissioning. This project is loaded in the jointly used CPU 
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and then distributed as "master project" by means of project copies to up to five participating 
engineering systems.  

Working with project copies 
Each engineering system only processes the parts it was assigned within the specific project 
copy. This is especially important to avoid conflicts during loading and unintentional overwriting 
of blocks that were already modified by other engineering systems. 

Each ES loads its parts to the shared CPU after editing. The TIA Portal helps you during 
download to the CPU. The changes made since the last download are displayed in the dialog 
"Software synchronization before loading to a device" (hereafter referred to as 
"synchronization dialog"), by means of an online-offline comparison. You are provided 
recommendations during download to the CPU about how you can synchronize the offline data 
you have edited with the existing online data.

If there are "competing changes", you may have to synchronize them manually. 

Competing changes are:

● when different editors edit the same block in different project copies at the same time.

● when PLC tags (I, Q, M, T, C) are added, changed or deleted in the project copies.

● when blocks that have relations to the hardware configuration are edited in the project 
copies.

● when F blocks are edited in the project copies.

Each editor loads their changes only after all conflicts have been removed.
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The procedure for editing and loading of project copies can be repeated as often as necessary 
by the individual engineering systems until the shared commissioning is complete. 

Integrating project copies into the master project once again
The individual project copies must once again be integrated into the master project at the end 
of commissioning at the same time. This way you also back up the data that only exist in the 
offline projects and have not been downloaded to the CPU. These include, for example, the 
project languages and text lists created in the project copies.

To do this, open the master project and one project copy as reference object. You determine 
the differences between the two projects by performing an offline/offline comparison using the 
comparison editor. Copy the edited objects from the respective project copy to the master 
project. Repeat this step for all project copies.

When the shared commissioning is completed, you have an executable master project with 
all created project data.

The integration of the project data into the master project is required even if you determine 
during the commissioning phase that the shared central elements need to be expanded or 
corrected, for example, the PLC tag table needs to be expanded, or a new hardware 
component needs to be added.

Notes on compatibility
The following compatibility rules apply to shared commissioning:

● If an engineering system with TIA Portal V13 or later is online on the CPU and performs a 
download, a second ES cannot establish an online connection regardless of the version.

● If an engineering system with TIA Portal < V13 is online on the CPU, a second ES cannot 
establish an online connection regardless of the version.

See also
Requirements for shared commissioning (Page 8007)

Procedure for shared commissioning (Page 8008)

12.1.2 Requirements for shared commissioning

Software and hardware requirements
For shared commissioning of projects, the minimum software and hardware requirements for 
the installation of TIA Portal V13 or later must be met.

The following requirements also apply:

Software:
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● You have installed TIA Portal V13 or later and the "SIMATIC STEP 7 Professional" software 
package on the involved engineering systems.

● The same software version must be installed on all engineering systems.

● The master project must be one created with V13 or later. 

Hardware:

● You have access to a fully configured CPU S7-1500 as of firmware version V1.5.

● The involved engineering systems (max. 5) can establish an online connection to this CPU. 

 

Requirements for shared, parallel working on the project
The following requirements are in effect for shared commissioning of projects:

● You have created a project with complete hardware configuration and fully programmed 
user program that can be commissioned. 

● The project was downloaded to the CPU and defined as "master project". 

● Multiple engineering systems have access to this CPU and can establish an online 
connection to this CPU.

● You are familiar with the defined rules and procedures for working together on one CPU. 

Note on compatibity mode
The functions for shared commissioning are not available in compatibility mode.

See also
Basics for shared commissioning (Page 8003)

Procedure for shared commissioning (Page 8008)

Rules for shared commissioning (Page 8011)

12.1.3 Procedure for shared commissioning

Introduction
If you are performing shared commissioning a project as part of team engineering, it is very 
important that all editors of the project observe a defined procedure.

Only when the specified procedure is observed are changes and corrections in the project 
automatically synchronized and applied, and changes of individual editors not unintentionally 
overwritten during loading or even lost in case of competing changes.
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Procedure for creating the master project
The master project is created in the following steps:

1. Create a master project that includes the entire project structure.

2. Fully configure the hardware for the master project.

3. Define a language as project language, which must also be used exclusively by all 
participating engineering systems.

4. Create all tags and blocks that are required in the master project.

5. Create your own folders and groups for the blocks to be edited by the individual engineering 
systems. 

6. Create a fully programmed and executable user program.

7. Download the master project to the shared CPU.

8. Save the master project following every download.

For this, also observe the Rules for shared commissioning (Page 8011).

Procedure for shared commissioning
Shared commissioning takes place with the following steps:

1. Download the master project to the shared CPU.

2. Create copies of the master project and distribute them to the editors involved in the project 
on the associated engineering systems.

3.  Inform all editors who is to edit the specific parts of the project copies and who may 
download to the CPU.

4. Have the project copies edited in the individual engineering systems. 

5. After editing, the individual engineering systems download the changes one after the other 
to the CPU. 

6. All changes are automatically detected during loading by means of an online-offline 
comparison. The displayed synchronization dialog offer you recommendations for 
synchronizing the modified data when possible. You may first have to download blocks that 
were edited by other editors to your ES before you can download your changes to the CPU. 
This may be needed to update the corrections of the other editors that have already been 
downloaded to the CPU in your project copy. 
The following synchronization options are available:

– Download block: There are edited blocks on the CPU that must be updated in your 
project copy.

– Download block: There are new blocks on the CPU that must be downloaded to your 
project copy.

– Blocks with competing changes: System-supported synchronization is not possible in 
this case; the conflict must be resolved manually.

7. Manually resolve any conflicts that may occur due to competing changes or changes to 
central objects.

8. Download your project copy to the CPU when all conflicts have been removed.
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9. Save your project copy following every download.

10.Repeat editing of project copies and download to the CPU as often as necessary until 
shared commissioning is complete.

11.Integrate the completely edited project copies into the master project once again in order 
to also back up the project data that only exist offline.

You should also observe the Rules for shared commissioning (Page 8011).

Procedure for manual synchronization of competing changes
Manual synchronization of competing changes is performed in the following steps:

1. Start the comparison editor to manually resolve a conflict displayed in the synchronization 
dialog during download to the CPU. Select the shared CPU in the project tree and select 
the "Compare > Offline/Online" command in the shortcut menu. You can define certain 
actions depending on the status of the objects. Note, however, that you can only perform 
actions in one direction during synchronizing.

2. First, select the action "Upload from device" for all blocks that were changed by other editors 
on the CPU and which you want to apply.

3. If necessary, perform a detailed comparison of the blocks to identify differences between 
your offline blocks and the online blocks loaded on the CPU.

4. Manually correct the competing changes to the blocks. 

5. Then download the affected blocks to the CPU using the "Continue without synchronization" 
command.

6. Save your project or project copy following every download.

For this, also observe the Rules for shared commissioning (Page 8011).   

 
 

 Note

To prevent online changes occurring again while an engineering system is being manually 
synchronized, no downloading to the shared CPU should be performed by another 
participating engineering system during the manual synchronizing.

 

Procedure for integrating project copies into the master project
You integrate project copies into the master project with the following steps:

1. Open the master project and the project copy to be integrated as a reference object.

2. Copy the program parts you have edited from the respective project copy to the master 
project and confirm overwriting the existing objects. You can also use the comparison editor 
to apply your program parts to the master project.

3. Save the master project and download it to the shared CPU with the "Continue without 
synchronization" command.

4. Save the master project following every download.
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For this, also observe the Rules for shared commissioning (Page 8011).

 

Procedure for modifying central objects within the master project
Modification of central objects that have an effect on all program parts is performed with the 
following steps:

1. Stop further processing of the project copies.

2. Integrate all existing project copies one after the other into the master project as described 
above.

3. Download the master project to the shared CPU with the "Continue without synchronization" 
command.

4. Make the required modification on the shared objects such as in the hardware configuration, 
for example, or in the PLC tag table. The procedure is the same for modification of other 
central objects such as technology objects, F blocks, OBs, etc.

5. Download the master project into the CPU once again when modification is complete.

6. Save the master project following every download.

7. Distribute the updated project copies to the respective engineering systems for further 
processing.

For this, also observe the Rules for shared commissioning (Page 8011).

 

 

See also
Basics for shared commissioning (Page 8003)

Requirements for shared commissioning (Page 8005)

Rules for shared commissioning (Page 8011)

12.1.4 Rules for shared commissioning

Introduction
If you are performing shared commissioning a project as part of team engineering, it is very 
important that all editors of the project observe predefined rules for successful cooperation.
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Rules for the master project
 The following rules are to be observed: 

● Create a master project that is suitable for shared editing.

● Divide the user program into program parts that are independent of each other.

● Use "Groups" to visually separate the program parts from each other. 

● Use a main OB and a central FC for each program part which calls the functions of the part 
program.

● If possible, create a separate PLC tag table for each part.

● In the master project, specify a project language which cannot be changed in the project 
copies.

● If you want to exchange data between the program parts, use the FC and FB interface 
parameters (IN, OUT, INOUT) or global data blocks.

● Use global data blocks to save the data for the individual program parts, no bit memories.

● Do not assign different names for blocks with identical addresses.

● Do not assign identical names for blocks with different addresses.

Example of the program structure in the master project
Here is an example of a team-capable, structured master project that is suitable for parallel 
editing during shared commissioning. 

The program parts edited by the individual Engineering Systems are:

● Program part 1: "Conveyer"

● Program part 2: "Drill"

● Program part 3:  "FurtherProgramPart"

Each program part contains a "main FB", which calls the specific lower-lever functions for this 
program part. 

Example: in the "Conveyer" program part, the "ConveyerMainFB" calls the "ConveyerStartup" 
function. 
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In team engineering, this subdivision within the project structure allows the parallel editing of 
individual program parts and the automatic synchronization of changes during the shared 
commissioning phase.

Rules for shared working on one CPU
Observe the following rules for shared working:

● Editor only edits the blocks they have been assigned in the project copy in the assigned 
groups.

● Only FBs, DBs, FCs and UDTs may be changed in the project copies, i.e. the following 
program elements should not be edited in the project copies:

– Hardware configurations

– PLC tag table

– Organization blocks

– Technological objects

– Text lists and project language

– F blocks

● Global data blocks should be used in programming instead of bit memories.
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● IEC timers and counters should be used during programming instead of SIMATIC timers 
and counters.

● The project language specified in the master project may not be changed in the project 
copies.

Rules for editing shared, central objects
Observe the following rules for shared central objects:

● Changes to shared central objects always have to be made by means of the master project. 
These objects include:

– Hardware configurations

– PLC tag table

– Organization blocks

– Technological objects

– Text lists and project language

– F blocks

● Before the shared central objects can be modified in the master project, the various working 
versions within the project copies must first be integrated into the master project once again.

● The modification can then be made within the master project, and the master project can 
then be downloaded to the shared CPU.

● Once modification is complete, new project copies can be created and distributed to the 
engineering systems for further processing.

Rules for downloading to the CPU
Observe the following rules for downloading:

● Editors may only download the project copies one after the other; only one engineering 
system can download at any given time.

● No other engineering system may be connected online with the CPU during download. 

● Perform the synchronization that is offered automatically in the synchronization dialog. This 
ensures that changes from other editors are not unintentionally overwritten.

● Correct the name conflicts that are shown in the synchronization dialog, which you rename 
in your offline block before downloading to the CPU. A name conflict is indicated if you want 
to download to the CPU a block that already exists with identical name on the CPU.
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● So-called "competing changes" must be corrected manually. Competing changes come 
about when two editors work on the same block on two engineering systems at the same 
time. The first editor can still download his or her changes to the CPU without any problems. 
However, if the second editor wants to download the same block with the changes the editor 
has made, the synchronization dialog displays a conflict that cannot be removed 
automatically. The previous changes made to this block would be undone by overwriting 
during download. The editors have to decide in this case which change is to be applied and 
which one is to be discarded. Alternatively, you can manually merge the changes with the 
help of the detailed comparison of the blocks in the comparison editor.
Such changes should always be avoided by implementing a good project structure and 
corresponding agreements between the editors. 

● Changes to central objects are displayed in the synchronization dialog but cannot be 
synchronized automatically. Changes to central objects always have to be made by means 
of the master project.

● Save your project or project copy following every download.
 

 Note
Creating and subsequent deleting of objects in the project copies

Please note that a software synchronization is also required before downloading when you 
create a new object in a project copy and then delete this again immediately afterwards. 

The creation of an object causes a change in the internal data management which cannot 
be undone by the subsequent deleting of the object. As a result it is necessary to perform a 
synchronization before the next loading if the newly created object was deleted immediately 
thereafter and no change in the existing object is visible within the project copy.

 

Rules for online functions
The following rules are to be observed when using online functions:

Monitoring and controlling:

● Up to five Engineering Systems can be monitored and controlled simultaneously on the 
CPU blocks.

● A specific code block can only be monitored and controlled by one Engineering System at 
a time. 

● However, additional Engineering Systems can simultaneously monitor and control other 
code blocks.

Force

● Forcing can only be implemented on the CPU from one Engineering System at a time. 

● The Engineering Systems that starts the forcing has taken over the forcing job exclusively. 
Although the other Engineering Systems receive the information that a forcing job is 
running, they cannot access this job and cannot also see any results. 

● As soon as the Engineering System to which the force job belongs ends the online 
connection, the force job can be applied by another ES that establishes an online 
connection to the CPU and changes the existing force job.

Using Team Engineering
12.1 Shared commissioning of projects

WinCC Professional V13.0
System Manual, 02/2014 8013



Trace functions:

● Up to four Engineering Systems can perform trace functions simultaneously.

● The Engineering Systems that starts the tracing has taken over the trace job exclusively. 
Although the other Engineering Systems can see this job in the trace editor, they cannot 
access it.

● As soon as the Engineering System to which the trace job belongs closes the trace editor, 
the trace job can be taken over by another ES that re-opens the trace editor. 

See also
Basics for shared commissioning (Page 8003)

Requirements for shared commissioning (Page 8005)

Procedure for shared commissioning (Page 8006)

12.2 Exchanging data with Inter Project Engineering (IPE)

12.2.1 Basics of Inter Project Engineering (IPE)

Introduction to Inter Project Engineering (IPE)
The functionality of Inter Project Engineering, hereinafter referred to as IPE, is used to 
exchange the controller data in a source project between different projects with the help of a 
device proxy. 

You can then transfer this data to other projects, for visualization in HMI, for example, and use 
it there for further configuration.

Inter Project Engineering gives you a simple way of providing controller data from a PLC 
programming across multiple projects for an HMI configuration.

Using the object "Device Proxy Data", you exchange controller data across multiple projects 
consistently and easily without redundant configuration overheads.

This makes it possible for HMI project engineers to work on a project without the hardware 
configuration having to be present in their project. This means they can work on the PLC project 
and on the HMI project at the same time.

You can exchange the following controller data between projects via the device proxy:

● Program blocks

● Technological objects

● PLC tags

● PLC alarms

The following data is automatically included in the exchange:
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● Controller interfaces

● Configured communication processors and communication modules

This automatic data exchange ensures that the interfaces and the configured communication 
processors and modules are transferred along with the data you selected. This data is required 
to allow you to continue working consistently and without problems in your target project.

Cross-project data exchange
The following options are available for cross-project data exchange with Inter Project 
Engineering:

● Exchanging controller data via IPE file

● Exchanging controller data via project file

Exchanging controller data via IPE file
The figure below shows cross-project data exchange via an IPE file.

The PLC controller data from the source project is transferred to the PLC in the target project 
via the object "Device Proxy Data". 

Controller data that is exchanged via an IPE file must originate from TIA Portal Projects V13 
or higher.

Exchanging controller data via a project file
  The figure below shows cross-project data exchange via a project file.
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The PLC controller data from the source project is transferred to the PLC in the target project 
via a project file. 

You can easily transfer and continue to use controller data from older TIA Portal projects as 
well as STEP 7 Classic projects that are not integrated in TIA Portal in your current TIA Portal 
projects. 

See also
Requirements for Inter Project Engineering (IPE) (Page 8018)

Procedure for working with Inter Project Engineering (IPE) (Page 8019)

12.2.2 Requirements for Inter Project Engineering (IPE)

Software and hardware requirements
To use the functionality of Inter Project Engineering, the minimum software and hardware 
requirements for the installation of TIA Portal V13 or higher must be met. 

The following requirements also apply:

● You have installed TIA Portal V13 or higher and the "SIMATIC STEP 7 Professional" 
software package.

● You are using a CPU of the S7-1200/1500 or S7-300/400 series.

● The same software version must be installed on all involved controllers.
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Requirements for IPE
The requirements for accepting controller data from projects are as follows:

● You have created a project with hardware configuration and PLC data that can be 
transferred to another project. 

● You have made sure that the project is consistent before you transfer the controller data 
by means of the device proxy data.

● You are familiar with the defined procedures for Inter Project Engineering. 

Notes on compatibility mode
The functions for Inter Project Engineering are not available in compatibility mode.

See also
Basics of Inter Project Engineering (IPE) (Page 8014)

Procedure for working with Inter Project Engineering (IPE) (Page 8019)

12.2.3 Procedure for working with Inter Project Engineering (IPE)

Exchanging controller data across projects
You can use the functionality of Inter Project Engineering to exchange existing controller data 
between different projects with the help of a device proxy and to continue using this data in 
another project. The device proxy provides you with a consistent and convenient way of 
exchanging data between projects without redundant configuration overheads.

Procedure for exchanging controller data via an IPE file 
To exchange data via an IPE file, follow these steps:

1. Using TIA Portal V13 or higher, create a project with all required controller data and an 
executable user program.

2. Configure the hardware required for the project.

3. Compile the project to ensure consistency in your project.

4. In your project, create the object "Device Proxy Data" below the required CPU by clicking 
the corresponding command "Add device proxy data" in the "Device Proxy Data" folder.
Result: The "Device Proxy Data" object has been created.

5. Select the required device proxy data in the project tree and double-click the object to open 
it in the editor.
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6. Enter the required data for the device proxy data in the editor under "General" or apply the 
default setting. You can change the name and enter a comment for export of the controller 
data.
In the "Define content" area of the editor select which of the existing controller data you 
wish to export as IPE file and click "Export device proxy data".

7. In the subsequent dialog, enter the name and storage location for the IPE file to be created 
and click "Save". You will be notified as soon as the export has been completed 
successfully. 
Result: The selected controller data are exported as IPE file.

8. In your target project, create a device proxy to be able to import the controller data contained 
in the IPE file. To do so, click the command "Add new device" and select the required device 
proxy in the dialog that opens.

9. Click the newly created device proxy and select the "Initialize device proxy" command from 
the shortcut menu. 

10.Select the previously created IPE file to be used for the initialization, and confirm the 
selection in the following dialog with "OK". This starts the initialization.
Result: The controller data from the source project contained in the IPE file is transferred 
to the device proxy in the target project.

After the successful exchange of controller data, you can continue with the configuration in 
your target project and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.

Procedure for exchanging controller data via a project file
When exchanging controller data via a project file, device proxy data can either be predefined 
in the source project or it can be defined and selected from the target project.

Follow these steps to exchange data via a project file:

1. Using TIA Portal V13 or higher, create a project with all required controller data and an 
executable user program.

2. Configure the hardware required for the project.

3. Compile the project to ensure consistency in your project.

4. Open the TIA Portal project from which you want to import the controller data into the target 
project.

5. In your project, create the object "Device Proxy Data" below the required CPU by clicking 
the corresponding command "Add device proxy data" in the "Device Proxy Data" folder.
Result: The "Device Proxy Data" object has been created.

6. Enter the required data for the device proxy data in the editor under "General" or apply the 
default setting. You can change the name and enter a comment for the device proxy data.

7. In the "Define content" area of the editor select which of the existing controller data you 
want to provide by means of the device proxy data.

8. Click "Save" to save the changes in the project.  
Result: You have successfully saved the selected controller data in your device proxy data.
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9. In your target project, create a device proxy to import the controller data contained in the 
project file. To do so, click the command "Add new device" and select the required device 
proxy in the dialog that opens.

10.Click the newly created device proxy and select the "Initialize device proxy" command from 
the shortcut menu.

11.Select the previously created project file with the prepared device proxy data to be used 
for the initialization, and confirm the selection in the following dialog with "OK". This starts 
the initialization.
Result: The controller data from the source project contained in the project file is transferred 
to the device proxy in the target project.

 After the successful exchange of controller data, you can continue with the configuration in 
your target project and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.

Procedure for updating already transferred controller data
System requirements for the update:

The following requirements must be met for updating already transferred controller data with 
the help of the already created "Device Proxy Data" object:

● You are using the same project for the update as for the previous transfer of the controller 
data.

● You are using the already created "Device Proxy Data" for transfer of the controller data.

● You have not made any changes to the hardware configuration or the communication 
interfaces in the meantime. You can add new hardware components. 

 

Updating procedure:

1. Open the TIA Portal project from which you want to update the controller data in the target 
project.

2. Double-click the existing "Device Proxy Data" object and select under content which 
controller data you want to make available for the update.

3. Save the project or export the IPE file once again.  

4. Open the required target project in the TIA Portal.

5. Click the existing device proxy in the target project and select the "Update device proxy" 
command from the shortcut menu. 

6. Select the source which is to be used for the update, and confirm the selection.

7. In the following dialog, select under "Device" the CPU that was previously used as source, 
from which the controller data is to be re-imported.

8. Under "Defined device proxy data", select the required object and exit the dialog with "OK". 

9. The update is then started and the selected device proxy data is transferred from the source 
project to the device proxy in the target project.
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After the successful update of the controller data, you can continue with the configuration in 
your target object and, for example, connect PLC tags with HMI tags. The controller data can 
be updated as often as required when it is changed in the source project.

See also
Basics of Inter Project Engineering (IPE) (Page 8014)

Requirements for Inter Project Engineering (IPE) (Page 8016)

Creating device proxy data (Page 1829)

Opening device proxy data (Page 1830)

Exchange of controller data via IPE file (Page 1830)
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Using online and diagnostics functions 13
13.1 Displaying accessible devices

Accessible devices
Accessible devices are all devices connected to an interface of the programming device / PC 
and that are turned on. Devices that allow only restricted configuration using the currently 
installed products or that cannot be configured at all can also be displayed.

Displaying accessible devices on an interface of the programming device / PC in the project tree   
To display accessible devices on a single interface of the programming device / PC, follow 
these steps:

1. Open the "Online access" folder in the project tree.

2. Click on the arrow to the left of the interface to show all the objects arranged below the 
interface.

3. Double-click on the "Update accessible devices" command below the interface.
All devices that are accessible over this interface are displayed in the project tree. When 
there is a large number of connected devices, the update process may take some time. 
You can see the progress of the update in the status bar. If you have found the desired 
device before the update is completed, you can cancel the update of accessible devices. 
To do this, click on the cross to the right of the progress bar.

Displaying accessible devices in a list   
To display the accessible devices on all available interfaces in an overview list, follow these 
steps:

1. Select the "Accessible devices" command in the "Online" menu.
The "Accessible devices" dialog is displayed.

2. Select the type of interface from the "Type of the PG/PC interface" drop-down list. The "PG/
PC interface" drop-down list then shows only the interfaces of the programming device / 
PC that match the selected interface type.

3. Select the required interface of the programming device / PC from the "PG/PC interface" 
drop-down list, for example an Industrial Ethernet adapter.
If no devices are available on an interface, an unbroken connecting line is displayed 
between the programming device / PC and the device. If devices are accessible, an 
unbroken connecting line is shown and the devices accessible on the selected interface of 
the programming device / PC are displayed in a list.
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4. If you have connected a new device in the meantime, click the "Refresh" button to refresh 
the list of accessible devices.

5. To go to a device in the project tree, select the device from the list of accessible devices 
and click the "Show" button.
The interface to which the selected device is connected is shown as selected in the project 
tree.

Displaying additional information about the accessible devices in the project tree
To display additional information on the accessible devices in the project tree, follow these 
steps:

1. Click on the arrow to the left of one of the accessible devices in the project tree.
All data available online, for example blocks and system data, is displayed for known 
devices. Objects that you cannot edit directly at this point are grayed out. If additional editing 
options are available for a device, for example, downloading using the shortcut menu, the 
device is shown in black text.

See also
Changing the device configuration online (Page 8024)

13.2 Changing the device configuration online
You can assign parameters to some devices, preferably in small hardware setups, directly 
online. You do not need to create a project or have offline data to do this. In this way, you can 
quickly and easily change the device configuration. You do not need to compile the hardware 
configuration or perform a download. Depending on the device, either all changes become 
active immediately or they are written to the device only after confirmation.

Requirement
● The device must support online parameter assignment. You can learn whether or not your 

specific devices support this function in the device manual.

● The device must be connected to the PG/PC and available in the list of accessible devices.

Procedure  
To change the device configuration online, follow these steps:

1. Show the accessible devices on the interface via which the device is connected. To learn 
how to show the accessible devices, see the previous chapter "Showing accessible 
devices (Page 8021)".

2. Expand the device to display the lower-level elements.

3. Double-click the "Parametrize device" item.
A configuration page for the device opens in the work area.
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4. Make all required settings.
With some devices, the new settings take effect immediately.

5. Optionally, depending on the device: Click on the "Upload to device" button.
The settings are transferred to the device.

13.3 Connecting devices online

13.3.1 General information about online mode

Online mode
In online mode, there is an online connection between your programming device / PC and one 
or more devices.   

An online connection between the programming device/PC and the device is required, for 
example, for the following tasks:

● Testing user programs

● Displaying and changing the operating mode of the CPU

● Displaying and setting the date and time of day of the CPU

● Displaying module information

● Comparing blocks

● Hardware diagnostics

Before you can establish an online connection, the programming device/PC and the device 
must be physically or remotely connected. As an alternative, some devices support a 
simulation mode. In this case, a connection to the device is simulated via the PLCSIM virtual 
interface.

After establishing a connection, you can use the Online and Diagnostics view or the "Online 
tools" task card to access the data on the device. The current online status of a device is 
indicated by an icon to the right of the device in the project tree. You will find the meaning of 
the individual status icons in the relevant tooltip.   

 

 Note

Some online functions depend on the scope of the installed software or whether a project is 
open.

 

Standby or hibernation of the programming device / PC     
If the programming device / PC is changed to the standby or hibernation mode when there is 
an online connection, all online connections are terminated. When the programming device / 
PC wakes up from hibernation, the online connections are not automatically re-established.
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Note that suddenly terminating an online connection can lead to loss of data or a connected 
device may interrupt program execution.

Performing an LED flash test
In many online dialogs you can perform an LED flash test, if the device connected online 
supports this feature. If you select the "Flash LED" check box, an LED flashes on the currently 
selected device. This feature is useful, for example, when you are not sure which device in the 
hardware configuration corresponds to the station currently selected in the software.

Read any additional information and learn about the possible limitations to the LED flash test 
in the respective device documentation.

See also
View in online mode (Page 8027)
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13.3.2 View in online mode

Online displays   
After the online connection has been established successfully, the user interface changes. If 
a device is unavailable, this is indicated by a symbol. The following figure shows a device 
connected online and the corresponding user interface:

① The title bar of the active window gets an orange background as soon as at least one of 
the devices currently displayed in the editor has been successfully connected online. If 
one or more devices are unavailable, a symbol for a broken connection appears in the 
title bar of the editor.

② The title bars of inactive windows for the relevant station now have an orange line below 
them.

③ An orange, pulsing bar appears at the right-hand edge of the status bar. If the connection 
has been established but is functioning incorrectly, an icon for an interrupted connection 
is displayed instead of the bar. You will find more information on the error in "Diagnostics" 
in the Inspector window.
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④ Operating mode symbols or diagnostics symbols for the stations connected online and 
their underlying objects are shown in the project tree. A comparison of the online and 
offline status is also made automatically. Differences between online and offline objects 
are also displayed in the form of symbols.

⑤ The "Diagnostics > Device information" area is brought to the foreground in the Inspector 
window.

Online connection abort
The online mode and its display are retained as long as at least one device is connected online. 
If the online connection to one or more devices aborts, the TIA Portal remains in online mode. 
The display of the TIA Portal changes to offline mode only when there is no longer an online 
connection to any device.

See also
General information about online mode (Page 8023)

Basics of project data comparison (Page 389)

13.3.3 Establishing and canceling an online connection

Requirement
At least one PG/PC interface is installed and is physically connected to a device, for example 
with an Ethernet cable. As an alternative, it is also possible to establish a virtual connection 
using PLCSIM.

Go online   
To establish an online connection, follow these steps:

1. In the project tree, select one or mote devices to which you want an online connection to 
be established.

2. Select the "Go online" command in the "Online" menu.
If the device was already connected to a specific PG/PC interface, the online connection 
is automatically established to the previous PG/PC interface. In this case, you can ignore 
the following steps. If there was no previous connection, the "Go online" dialog opens.

3. Select the type of interface from the "Type of the PG/PC interface" drop-down list. The "PG/
PC interface" drop-down list then shows only the interfaces of the programming device / 
PC that match the selected interface type.

4. Select the required interface of the programming device / PC from the "PG/PC interface" 
drop-down list, for example an Industrial Ethernet adapter.
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5. In the "Connection to subnet" drop-down list, select the interface via which the device is 
connected to the programming device or PC. In this case, a direct connection is established 
to the device, without a network node, for example, an interposed switch. Alternatively, 
select the appropriate subnet for the connection to the programming device or PC if the 
device can be accessed via a network node. If you do not know how the device is connected 
to the programming device or PC, choose the "Try all interfaces" entry.
If you selected an MPI or PROFIBUS subnet, the bus parameters configured in the 
programming device/PC interface are applied at this point.

6. If the device is accessible via a gateway, select the gateway that connects the two subnets 
involved in the "1st gateway" drop-down list.
If no devices are available on the interface, a broken connecting line is displayed between 
the programming device / PC and the device. If devices are accessible, an unbroken 
connecting line is shown and the devices accessible on the selected interface of the 
programming device/PC are displayed in the "Compatible devices in target subnet" list.

7. Optional: Click the "Update" button to update the "Compatible devices in target subnet" list.

8. Optional: Select the "Flash LED" check box to the left of the graphic to run an LED flash 
test. With this function, you can check that you have selected the correct device. The LED 
flash test is not supported by all devices. 

9. Select your device in the "Compatible devices in target subnet" table, and confirm your 
selection with "Go online".
The online connection to the selected target device is established.

Result   
After the online connection has been established, the title bars of the editors change to orange. 
An orange activity bar is also shown in the title bar of an editor and in the status bar. In the 
project tree, status symbols show the difference between online and offline objects.

The connection path is stored for future connection attempts. It is no longer necessary to open 
the "Go online" dialog unless you want to select a new connection path.

 

 Note

If no accessible device is displayed, select a different network access for the PG/PC interface 
or check the settings of the interface.

 

Canceling an online connection   
To disconnect the existing online connection, follow these steps:

1. Select the device you want to disconnect from in the project tree.

2. Select the "Go offline" command in the "Online" menu.

See also
Connecting online with several devices (Page 8030)

View in online mode (Page 8025)
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Assigning a temporary IP address (Page 8042)

Influence of user rights (Page 344)

13.3.4 Connecting online with several devices
You can establish an online connection to several devices at the same time without needing 
to select individual devices previously in the network view.

Requirement
● No device must be selected

● At least one PG/PC interface is installed and is physically connected to a device, for 
example with an Ethernet cable. As an alternative, it is also possible to establish a virtual 
online connection using PLCSIM or a remote connection.

Procedure  
To establish an online connection to several devices at the same time, follow these steps:

1. Select the project in the project tree.

2. Select the "Go online" command in the "Online" menu.
The "Select device for opening the online connection" dialog opens with a table of all 
available devices.

3. Select the devices to which you want to establish an online connection in the "Go online" 
column.

4. Click the "Go online" button.

Result
Without any further prompt for confirmation, a connection is established to all selected devices 
if a connection was already established to the selected devices at least once. If there was no 
previous online connection, the "Go online" dialog opens. In this case, first configure the online 
connection as described in the section "Go online and Go offline (Page 8026)".

See also
Establishing and canceling an online connection (Page 8026)

Assigning a temporary IP address (Page 8042)

13.3.5 Disconnecting online connections of multiple devices
You can disconnect the online connections to multiple devices at one time without needing to 
select individual devices beforehand in the network view.
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Requirement
● No device is selected.

● There is currently an online connection to at least one device.

Procedure  
To terminate the online connections to multiple devices at one time, follow these steps:

1. Select the "Go offline" command in the "Online" menu.
The "Select devices" dialog opens with a table of all available devices.

2. Select the device for which you want to terminate the online connection in the "Go offline" 
column.

3. Click the "Go offline" button.

Result
The online connection to the all the selected devices is terminated.

13.4 Backing up the software and hardware configuration of a device

13.4.1 Creating a backup of a device

Backing up the software and hardware configuration of an S7-300/400 CPU
If you have already downloaded a configuration to an S7-300/400 CPU, it is advisable to make 
a backup. You may have modified the configuration and want to test the new configuration. 
Before you download the new configuration to the CPU, you can create a backup of the current 
device state and then restore the current configuration at a later date. The backup is performed 
with the current values of the CPU. In the case of S7-400 CPUs with fail-safe function, the 
initial values are backed up.

You can create as many backups as you want and store a variety of configurations for a CPU. 
The backups are named with the name of the CPU and the time and date of the backup. You 
can find the backup in the project tree under the CPU in the "Online backups" folder.

The following figure shows an S7-319 CPU for which two backups were created:
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See also
Restoring the software and hardware configuration of a device (Page 8033)

Backing up a device configuration (Page 8032)

General information on loading (Page 381)

13.4.2 Backing up a device configuration
You can back up the configuration of a S7-300/400 CPU in the TIA Portal. So you can download 
and test a new configuration to a device without any risk. If needed, you can restore the initial 
configuration of the CPU.

Requirement
● The CPU must already be created in the project.

● It must be an S7-300/400 CPU.

● The CPU must be online. If there is no online connection, an online connection is 
established during the backup.
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Procedure     
To create a backup of the current configuration of a CPU, follow these steps:

1. Select the CPU in the project tree.

2. Select the "Backup from online device" command in the "Online" menu.

Result:
A backup of the entire hardware configuration and software is created. The backup is stored 
in the project tree in the "Name of the CPU > Online backups" folder. The backup is assigned 
the name of the CPU with the time and date of the backup. You can rename the backup, but 
you cannot make any changes to the contents of the backup.

See also
Establishing and canceling an online connection (Page 8026)

Restoring the software and hardware configuration of a device (Page 8033)

Creating a backup of a device (Page 8029)

13.4.3 Restoring the software and hardware configuration of a device
If you have backed up the configuration of a device at an earlier point in time, you can transfer 
the backup back to the device. The saved configuration is then restored on the device.

Requirement
You must have previously configure the device and stored a backup of the device in the project.

Procedure      
To restore older software and hardware state on a device, follow these steps:

1. Open up the folder of the device in the project tree to display the lower-level objects.

2. Open the "Online backups" folder.

3. Select the backup you want to restore.

4. In the "Online" menu, select the "Download to device" command.

– If you had previously established an online connection, the "Load preview" dialog opens. 
This dialog displays messages and proposes actions necessary for downloading.

– If you had not previously established an online connection, the "Extended download to 
device" dialog opens, and you must first select the interfaces via which you want to 
establish the online connection to the device.
See also: Establishing and terminating an online connection (Page 8026) 
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5. Check the messages in the "Load preview" dialog, and select the actions in the "Action" 
column, if necessary.

 

  Note

Performing the proposed actions while the plant is in operation can cause serious bodily 
injury and property damage in the event of malfunctions or program errors.

 

6. As soon as loading becomes possible, the "Load" button is enabled.

7. Click the "Load" button.
The backup is transferred to the device and device is restored. The "Load results" dialog 
then opens. In this dialog, you can check whether or not the loading operation was 
successful and take any further action that may be necessary.

8. Click the "Finish" button.

See also
Creating a backup of a device (Page 8029)

13.5 Configuring the PG/PC interface

13.5.1 Online access

Online access of the project
In the "Online access" folder of the project tree, you will find all active interfaces of your 
programming device/PC. Each interface icon provides you with information on the status of 
the interface. You can also display the accessible devices and display and edit the properties 
of an interface using the shortcut menu.   

The following figure shows the "Online access" folder in the project tree:
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① "Online access" folder in the project tree
All interfaces installed in the programming device/PC are displayed in the "Online access" folder.

② Show/hide interfaces
Use the function "Show/hide interfaces" to show or hide individual interfaces.

③ Status display for the interfaces
The current status of an interface is indicated by an icon to the right of the name. You can see 
the meaning of the icon in the tooltip.

④ Updating the list of accessible devices.
This function is available for each hardware interface of the programming device/PC. Software 
interfaces, such as a remote connection, do not offer this function.

⑤ Devices connected via the respective interface with the programming device/PC
The type of the respective device and its status are displayed by the preceding icon.

Displaying or updating accessible devices
You have the following options if you want to display all devices accessible online on your 
programming device/PC:

● Display of the accessible devices on a single interface of the programming device / PC in 
the project tree. In the project tree, you can also display additional information about the 
individual accessible devices.

● Display of the accessible devices of all interfaces in a list.

See also: Displaying accessible devices 
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Overview of icons for accessible devices
The accessible devices are identified with an icon according to their type and status. The 
following is an overview of all icons and their meaning.

Icon for unidentified modules
This icon is displayed whenever the identification of a module is not yet complete or when the 
identification of a module was not successful, for example, because the required online data 
could not be read.
Icon for the following device types:
● PLCs
● SIMOCODE pro devices
● IE/PB links
● CPs of PC systems
● SCALANCE head modules
● S7-300 and S7-400 CPs
● PROFINET IO devices and PROFINET CPs
● SCALANCE modules and gateways that could not be identified
PROFINET IO devices, encoders, switchgear, sensors and identification systems that were 
replaced by similar devices because these could not be identified
Icon for the following device types:
● HMI devices
● PROFINET IO devices of the HMI type if these could not be identified and were therefore 

replaced by a similar device
PROFINET IO devices of the drive type that could not be identified and were therefore replaced 
by a similar device
PROFINET IO devices of the type development kit and network components that could not be 
identified and were therefore replaced by a similar device
PROFINET IO devices of the type TeleService adapter that could not be identified and were 
therefore replaced by a similar device

See also
Displaying and modifying interface properties (Page 8037)

13.5.2 Basics of assigning parameters for the PG/PC interface

Options for connecting to target systems 
If the devices of the project are connected via different subnets, you assign a suitable network 
access to each PG/PC interface to be able to establish online connections to the target 
systems. The following interfaces are automatically supported:

● MPI

● PROFIBUS

● Industrial Ethernet (ISO and TCP/IP)
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You can make various settings for the interfaces. The following sections explain the parameter 
settings you can make.

 

 Note

Note that changes to interface parameters have a direct influence on the operating system 
and the programming device / PC. Remember that some parameter settings can only be 
changed if you have adequate user rights.

 

See also
Setting parameters for the Industrial Ethernet interface (Page 8039)

Setting parameters for the MPI and PROFIBUS interfaces (Page 8043)

13.5.3 Showing or hiding interfaces
To improve clarity, it is possible to hide individual interfaces of the PG/PC in the project tree 
and to show them again when necessary.

Procedure
To show or hide individual interfaces, follow the steps below:

1. Open the "Online access" folder in the project tree.

2. Double click on the "Display/hide interfaces" icon.
The "Display/hide interfaces" dialog opens.

3. Enable or disable the required interfaces in the "Display in the project tree" column.

4. Click the "Apply" button.
The changes are applied. The view of the interfaces in the "Online access" folder is 
refreshed.

13.5.4 Displaying and modifying interface properties

Introduction  
For each interface, you can display and, in some cases, modify properties, for example the 
network type, address, and status.
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Procedure
To open the properties, follow these steps:

1. Right-click on the required interface below "Online access" in the project tree.

2. Select the "Properties" command from the shortcut menu.
A dialog containing the properties of the interface opens. On the left of the dialog, you will 
see the area navigation. You can view the current parameter settings in the individual 
entries in the area navigation and, if necessary, change them.

13.5.5 Adding interfaces
You have the option of installing additional interfaces after installation of the TIA Portal.

Procedure 
To install an interface at a later time and add it to the TIA Portal, follow these steps:

1. Install or update the drivers in the operating system once you have installed the interface 
hardware.

2. Close the TIA Portal if it is still open.

3. Open the Windows control panel.

4. Open the entry "Setting the PG/PC Interface" in the Control Panel.
The "Setting the PG/PC Interface" dialog opens.

5. Make any necessary changes to the interface configuration and confirm them with "OK". 
You have to click "OK", even if you have not made any changes.

6. Restart the TIA Portal.

Result
The newly installed interface is now displayed in the project tree under the "Online access" 
folder.
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13.5.6 Setting parameters for the Ethernet interface

13.5.6.1 Setting parameters for the Industrial Ethernet interface

Options in the parameter settings for the Industrial Ethernet interface  
When setting parameters for the Industrial Ethernet interface, you have the following options:

● Parameters dependent on the operating system
The Industrial Ethernet interface has parameters that are set in the operating system and 
are valid for all connected devices. These parameter settings are only displayed here, they 
can, however, be changed in the network settings of the operating system.

● Parameters that can be set in the software
 

  Note

Note that changes to interface parameters have a direct influence on the operating system 
and the programming device / PC. Remember that some parameter settings can only be 
changed if you have adequate user rights.

 

Parameters for the Industrial Ethernet interface  
The following table contains an overview of the parameters of the Industrial Ethernet interface 
that are set by the operating system and can be changed by the user.

Parameter settings that cannot be changed Parameters that can be set
MAC address Fast acknowledge at the IE-PG access and for 

TCP/IP 
DHCP server activated/deactivated Timeout at the IE-PG access and for TCP/IP
APIPA activated/deactivated LLDP
IP address Additional, dynamic IP addresses for the network 

adapter
Subnet mask -
DNS addresses -
DHCP addresses -

See also
Basics of assigning parameters for the PG/PC interface (Page 8034)

Displaying operating system parameters (Page 8040)

Connecting the PG/PC interface to a subnet (Page 8040)

Setting parameters for the Ethernet interface (Page 8041)

Assigning a temporary IP address (Page 8042)
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Managing temporary IP addresses (Page 8042)

Influence of user rights (Page 344)

13.5.6.2 Displaying operating system parameters
The Ethernet interface is part of the operating system. All parameters of the network adapter 
can therefore be adapted in the network settings of the operating system.

You can display the following parameters in the software:

● Physical address of the network adapter

● Assignment of the IP address by a DHCP server activated or deactivated

● Assignment of a private IP address by the operating system activated or deactivated

● Current static IP address

● Assigned subnet mask

● DNS addresses

● DHCP addresses

If you want to modify the parameter settings, please refer to the documentation of the operating 
system or the network adapter.

Displaying current parameters of the Ethernet interface  
To display the current parameters of the Ethernet interface, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > Industrial Ethernet" in the area navigation.

See also
Setting parameters for the Ethernet interface (Page 8041)

13.5.6.3 Connecting the PG/PC interface to a subnet
If you have created several subnets, you can specify the subnet to which the Ethernet interface 
is connected.

Procedure 
To select the subnet to which the Ethernet interface is connected, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.
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3. Go to "General > Assignment" and select the subnet to which you want to connect the 
Ethernet interface of the programming device / PC in the "Connection to subnet" drop-down 
list.

4. Close the dialog with "OK".

13.5.6.4 Setting parameters for the Ethernet interface
You can adapt some parameter settings relating to the network protocol directly in the software.

Requirement
You must have adequate user rights.

See also: Influence of user rights (Page 344).

Procedure   
To change parameter settings relating to the network protocol, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > IE-PG access" to adapt the protocol settings relevant to network 
management.

– Select the "Fast acknowledge" check box to achieve faster reaction times with smaller 
network packets.

– From the "Timeout" drop-down list, select the maximum time that can elapse before a 
network node is detected.

4. To activate the LLDP protocol and discover the network topology more accurately, set the 
"LLDP active" check box in "Configurations > LLDP".

5. Select "Configurations > TCP/IP" to adapt the TCP/IP protocol for network traffic during 
runtime.

– Select the "Fast acknowledge" check box to achieve faster reaction times with smaller 
network packets.

– From the "Timeout" drop-down list, select the maximum time that can elapse before 
there is a timeout during communication with a network node.

See also
Influence of user rights (Page 344)

Displaying operating system parameters (Page 8038)
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13.5.6.5 Assigning a temporary IP address

Adding a dynamic IP address   
If the IP address of a device is located in a different subnet from the IP address of the network 
adapter, you will first need to assign an additional IP address with the same subnet address 
as the device. Only then is communication between the device and the programming device / 
PC possible.

The assignment of an additional temporary IP address is also proposed automatically if you 
want to perform an online action and the current IP address of the programming device/PC is 
not yet in the correct subnet.

A temporarily assigned IP address remains valid until the next time the programming device/
PC is restarted or until you delete it manually.

 

 Note

You require adequate permissions to be able to assign a temporary IP address.

See also: Influence of user rights (Page 344) 
 

See also
Managing temporary IP addresses (Page 8042)

13.5.6.6 Managing temporary IP addresses
If the IP address of a device is located in a different subnet from the current static IP address 
of the network adapter, the network adapter temporarily assigns a suitable IP address from 
the subnet of the device.

You can display all temporarily assigned addresses and delete them. Note that IP addresses 
that you manually assigned in the operating system are not displayed in the TIA Portal.

Requirement
To delete, you require adequate permissions.

Procedure  
To display and delete temporarily assigned addresses, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.
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3. Select "Configurations > IE-PG access".
A table with the assigned IP addresses is displayed.

4. Click the "Delete project-specific IP addresses" button to delete all the IP addresses at one 
time.

See also
Influence of user rights (Page 344)

13.5.6.7 Resetting the TCP/IP configuration
If you have changed the TCP/IP protocol settings, you can reset them to the defaults. 

Procedure
To restore the TCP/IP configuration to the default settings, follow these steps:

1. Select the Ethernet interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > TCP/IP".

4. Click the "Standard" button to reset all the settings.

13.5.7 Setting parameters for the MPI and PROFIBUS interfaces

13.5.7.1 Setting parameters for the MPI and PROFIBUS interfaces

Possible parameter settings for the MPI and PROFIBUS interfaces
The following parameter settings can be made for the MPI and PROFIBUS interfaces:

● Automatic configuration: You can use automatic detection functions to find out whether a 
device is connected to the PG/PC interface over PROFIBUS or MPI.

● Selecting a default configuration for PROFIBUS or MPI that can be adapted later.

Device- and network-related settings for MPI and PROFIBUS
You can set device- and network-related parameters for MPI and PROFIBUS interfaces. 
Device-related parameters are local settings for the interface. Network-related parameters, on 
the other hand, must match up on all devices.
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MPI interface parameters you can modify  
You can adapt the following default parameters for the MPI interface:

Device-related parameters Network-related parameters
Is the only master Highest address
Own address Transmission rate
Timeout  

PROFIBUS interface parameters you can modify  
You can adapt the following default parameters for the PROFIBUS interface:

Device-related parameters Network-related parameters
Is the only master Highest address
Own address Transmission rate
Timeout Profile
 Bus parameters
 Number of masters on bus
 Number of slaves on bus

See also
Basics of assigning parameters for the PG/PC interface (Page 8034)

13.5.7.2 Setting MPI or PROFIBUS interface parameters automatically

Setting up automatic bus parameter detection  
If you select an interface with automatic detection of the bus parameters (for example CP 5611 
(Auto)), you can connect the programming device or PC to MPI or PROFIBUS without needing 
to set bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute.

Requirement
● Masters that distribute bus parameters cyclically are connected to the bus.

● In PROFIBUS networks, the cyclic distribution of the bus parameters must be enabled.
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Procedure
To enable automatic bus parameter detection, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Go to "General > Configurations > Active configuration" and select the setting "Automatic 
protocol detection".

4. Go to "Configurations > Auto configuration > Local settings" and select the address of the 
PG/PC interface in the "Own address" drop-down list.

5. If you then want to display the current bus settings, click the "Network detection" button.

See also
Setting parameters for the MPI interface (Page 8045)

Setting parameters for the PROFIBUS interface (Page 8047)

13.5.7.3 Setting parameters for the MPI interface

Changing the parameter settings of the MPI interface  
The network-related parameters and bus parameters for the MPI network can be adapted. 
You should first select a default setting and then adapt this to the specific situation.

Setting defaults for the MPI interface
To adapt the parameters of the MPI interface, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.
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3. Go to "General > Assignment" and select the subnet with which you want to connect the 
interface in the "Connection to subnet" drop-down list.

4. Under "General > Configuration", select a default for the device and network-related 
parameters. The defaults are suitable for most configurations. Select one of the following 
settings:

– Automatic protocol detection
You can connect the programming device to MPI or PROFIBUS without having to set 
bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute. Prerequisite for the automatic detection is a 
connection to the bus master, which distributes the bus parameters cyclically. With 
PROFIBUS subnets, cyclic distribution of bus parameters may not be deactivated 
(default PROFIBUS network setting).

– MPI
The "MPI" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

– PROFIBUS
The "PROFIBUS" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

Changing the default parameter settings
To adapt the default settings to your requirements, change the parameter setting where 
necessary in "Configurations > MPI".

You can set the following device-related parameters:

● Is only master
An additional verification function to prevent bus disruptions when connecting the PG/PC 
to the network is disabled because the programming device or PC is the only master on 
the bus.

– Do not enable this option unless you have only connected slaves to your programming 
device or PC.

– If the "Is only master" check box is enabled, it is not possible to identify the directly 
connected device in the "Accessible devices" window.

● Own address
This setting relates to the programming device or PC on which you call up the parameter 
settings of the interface. Set the local device address of your programming device or PC 
here.

– This address must be unique throughout the network.

– The programming device or PC is addressed using this address in the MPI network.
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● Check
This enables an additional safety function to prevent bus disruptions when connecting the 
PG/PC to the network. The driver checks whether the local address is already being used 
by another station. Active as well as passive stations are taken into consideration in this 
case. The driver monitors this on the PROFIBUS. The connection of the PG/PC to the 
network will take longer with the automatic check. To use the check, the driver must support 
the function. Furthermore, the "Is only master" option must not be selected.

● Timeout
Set a higher timeout value if, for example, you have problems with long response times on 
the network.

You can set the following network-related parameters:

● Highest address:
Select the configured highest device address. Make sure that the same highest device 
address is set for all devices of a PROFIBUS or MPI network.

● Transfer rate:
Here, you select the transmission speed to be used on the MPI network.

See also
Setting MPI or PROFIBUS interface parameters automatically (Page 8042)

13.5.7.4 Setting parameters for the PROFIBUS interface

Changing the parameter settings of the PROFIBUS interface  
The network-related parameters and bus parameters for the PROFIBUS network can be 
adapted more precisely. You should first select a default setting and then adapt this to the 
specific situation.

Setting defaults for the PROFIBUS interface
To adapt the parameters of the PROFIBUS interface, follow these steps:

1. Select the interface in the project tree.

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.
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3. Go to "General > Assignment" and select the subnet with which you want to connect the 
interface in the "Connection to subnet" drop-down list.

4. Under "General > Configuration", select a default for the device and network-related 
parameters. The defaults are suitable for most configurations. Select one of the following 
settings:

– Automatic protocol detection
You can connect the programming device to MPI or PROFIBUS without having to set 
bus parameters. At a transmission speed lower than 187.5 Kbps, you may, however, 
have waiting times of up to one minute. Prerequisite for the automatic detection is a 
connection to the bus master, which distributes the bus parameters cyclically. With 
PROFIBUS subnets, cyclic distribution of bus parameters may not be deactivated 
(default PROFIBUS network setting).

– MPI
The "MPI" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

– PROFIBUS
The "PROFIBUS" transmission protocol is selected. Typical parameters are set that are 
adequate for most configurations. You can change the parameters to your needs, 
however.

Changing the default parameter settings
To adapt the default settings to your requirements, change the parameter setting where 
necessary in "Configurations > PROFIBUS".

You can set the following device-related parameters:

● Is only master
An additional verification function to prevent bus disruptions when connecting the PG/PC 
to the network is disabled because the programming device or PC is the only master on 
the bus.

– Do not enable this option unless you have only connected slaves to your programming 
device or PC.

– If the "Is only master" check box is enabled, it is not possible to identify the directly 
connected device in the "Accessible devices" window.

● Own address
This setting relates to the programming device or PC on which you call up the parameter 
settings of the interface. Set the local device address of your programming device or PC 
here.

– This address must be unique throughout the network.

– The programming device or PC is addressed using this address in the PROFIBUS 
network.
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● Check
This enables an additional safety function to prevent bus disruptions when connecting the 
PG/PC to the network. The driver checks whether the local address is already being used 
by another station. Active as well as passive stations are taken into consideration in this 
case. The driver monitors this on the PROFIBUS. The connection of the PG/PC to the 
network will take longer with the automatic check. To use the check, the driver must support 
the function. Furthermore, the "Is only master" option must not be selected.

● Timeout
Set a higher timeout value if, for example, you have problems with long response times on 
the network.

You can set the following network-related parameters:

● Highest address:
Select the configured highest device address. Make sure that the same highest station 
address is set for all devices of a PROFIBUS network.

● Transfer rate:
Here, you select the transmission speed to be used on the PROFIBUS network.

● Profile:
You have a choice of four alternatives for the PROFIBUS settings. "DP", "Standard" and 
"Universal (DP/FMS)" are predefined settings that you cannot change. If you select "User-
defined", you can adapt the bus parameters yourself.

– If you have selected "User-defined", go to "Configurations > PROFIBUS > Bus 
parameters" in area navigation.

– If you have selected one of the defaults (DP, Standard or Universal (DP/FMS)), you 
should select the "Include" check box in "Configurations > PROFIBUS > Bus parameters 
> Additional parameters". You can then set the number of masters and slaves on the 
bus. This allows a more precise calculation of the bus parameters and potential bus 
disruptions can be prevented. The option cannot be selected with a user-defined profile.

See also
Overview of the bus parameters for PROFIBUS (Page 8049)

Setting MPI or PROFIBUS interface parameters automatically (Page 8042)

13.5.7.5 Overview of the bus parameters for PROFIBUS

Introduction
The PROFIBUS subnet will only function problem-free if the parameters for the bus profile are 
matched to one another. You should therefore only change the default values if you are familiar 
with how to configure the bus profile for PROFIBUS. 

It may be possible for the bus parameters to be adjusted depending on the bus profile. The 
offline values of the bus parameters are always shown even if you are online and linked to the 
target system.

The displayed parameters are valid for the entire PROFIBUS subnet.

Using online and diagnostics functions
13.5 Configuring the PG/PC interface

WinCC Professional V13.0
System Manual, 02/2014 8047



Meaning of the individual parameters
● Tslot: Wait-to-receive time (slot time)

The wait-to-receive time (slot time) defines the maximum time the sender will wait to receive 
a response from the addressed partner.

● Max. Tsdr: Maximum protocol processing time (max. station delay responder)
The maximum protocol processing time defines the time after which the responding device 
must have processed the protocol.

● Min. Tsdr: Minimum protocol processing time (min. station delay responder)
The minimum protocol processing time specifies the minimum time required by the 
responding device to process the protocol.

● Tset: Trigger time (setup time)
The trigger time is the time that may lapse between the reception of a data frame frame 
and the reaction to it.

● Tqui: Quiet time for modulator
The quiet time for modulator specifies the time required to change from sending to receiving.

● GAP factor: GAP update factor (GAP factor)
The GAP factor specifies the number of token rotations before a new device is included in 
the token ring.

● Retry limit: Maximum number of repeated call attempts (retry limit)
This parameter defines the maximum number of attempts made to reach a device.

● Trdy: Ready time
The ready time is the time for an acknowledgment or response.

● Tid1: Idle time 1
Idle time 1 specifies the delay time after receiving a response.

● Tid2: Idle time 2
Idle time 2 specifies the delay time after sending a call without a response.

● Ttr: Target rotation time
The target rotation time is the maximum time made available for a token rotation. During 
this time, all active devices (masters) receive the token once. The difference between the 
desired token round-trip time and the actual token round-trip time decides how much time 
is left for masters to send data frames to the slaves.
As the minimum target rotation time (Ttr), select a value = 5000 times the HSA (Highest 
Station Address).

● Watchdog: Watchdog
The watchdog time specifies the time after which a device must be addressed. 
As the minimum watchdog time, select a value = 6250 times the HSA.

 

 Note

If you want to create a user-defined bus profile, please note that the minimum target rotation 
time (Ttr) should be 5000 times the HSA (highest PROFIBUS address). The minimum 
watchdog time should also be 6250 times the HSA.
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See also
Setting parameters for the PROFIBUS interface (Page 8045)

13.5.7.6 Resetting the MPI or PROFIBUS configuration
If you have changed the MPI or PROFIBUS protocol settings, you can reset them to the 
defaults.  

Procedure
To restore the MPI or PROFIBUS configuration to the default settings, follow these steps:

1. Select the MPI/PROFIBUS interface in the project tree in "Online access".

2. Select the "Properties" command in the shortcut menu of the interface.
The dialog for configuring the interface opens.

3. Select "Configurations > MPI" or "Configurations > PROFIBUS", depending on the interface 
properties you want to reset.

4. Click the "Standard" button to reset all the settings.

13.6 Using the trace and logic analyzer function

 Preface
 

Purpose of the documentation
The diagnostics options available with the trace and logic analyzer function are described in 
this documentation. Depending on the device used, the recording options can vary.

Required basic knowledge
In order to understand this documentation, the following knowledge is required:

● General knowledge in the field of automation

● Knowledge about the use of Windows-based computers

● S7-1200/1500 CPUs

– Knowledge of working with the SIMATIC industrial automation system

– Knowledge of working with TIA Portal >= V12.0

● SINAMICS G120

– Knowledge of working with the drive
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Validity of the documentation
This documentation applies to all products of the S7-1200, S7-1500 and SINAMICS G120 
product family.

Conventions
This documentation contains pictures of the devices described. The pictures may differ slightly 
from the devices supplied.

Please also observe notes marked as follows:
 

 Note

A note contains important information on the product described in the documentation, on the 
handling of the product and on the section of the documentation to which particular attention 
should be paid.

 

Further support
● The range of technical documentation for the individual SIMATIC products and systems is 

available on the Internet (http://www.siemens.com/simatic-tech-doku-portal).

● The online catalog and the online ordering system is available on the Internet (http://
mall.automation.siemens.com).

13.6.1 Security information
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, solutions, machines, equipment and/or networks. They are 
important components in a holistic industrial security concept. With this in mind, Siemens’ 
products and solutions undergo continuous development. Siemens recommends strongly that 
you regularly check for product updates. 

For the secure operation of Siemens products and solutions, it is necessary to take suitable 
preventive action (e.g. cell protection concept) and integrate each component into a holistic, 
state-of-the-art industrial security concept. Third-party products that may be in use should also 
be considered. You can find more information about industrial security on the Internet (http://
www.siemens.com/industrialsecurity).

To stay informed about product updates as they occur, sign up for a product-specific 
newsletter. You can find more information on the Internet (http://
support.automation.siemens.com).
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13.6.1 Description

13.6.1.1 Supported hardware
The following devices (Page 8078) support the trace and logic analyzer function: 

● SIMATIC S7-1200 CPUs (as of firmware version V4.0)

● SIMATIC S7-1500 CPUs

● SINAMICS G120

13.6.1.2 Recording of measured values with the trace function

Introduction
The trace and logic analyzer function can be called in the device folder in the project navigator 
under the name "Traces" (Page 8056).

You record device tags and evaluate the recordings with the trace and logic analyzer function. 
Tags are, for example, drive parameters or system and user tags of a CPU. The maximum 
recording duration is limited by the memory size. How much memory is available for the 
recording depends on the hardware used. 

The recordings are saved on the device and, when required, can be read out with the 
engineering system (ES) and saved permanently. The trace and logic analyzer function is 
therefore suitable for monitoring highly dynamic processes. The recorded values are 
overwritten when "Installed traces" is activated again.

Active recordings from the axis control panel or from the PID are displayed at "Installed traces". 
These recordings can be added to the measurements in the curve diagram of the axis control 
panel or the PID via a shortcut menu command.

Depending on the device (Page 8078) used, the recording options can vary.

A quick start (Page 8066) for working with the trace and logic analyzer function can be found 
in the Operation section.

The following figure shows the method of operation of the "Traces":
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① Trace configuration on the programming device (PG) in the TIA Portal

You can specify the signals to be recorded, the duration of the recording and the trigger 
condition in the trace configuration. The trace configuration depends on the device and is 
described at the respective device (Page 8078).

② Transferring the trace configuration from the PG to the device

You can transfer the complete trace configuration (Page 8073) to the device when an online 
connection is established.

③ Waiting for the recording

If the installed trace configuration is activated (Page 8073), then the recording is performed 
independently of the PG. The recording is started as soon as the trigger condition is satisfied.

④ Transferring the measurement from the device to the PG

The saving of the measurement in the project (Page 8075) stores the measurement in the 
opened project of the TIA Portal. The measurement can be saved at any time after completing 
the recording, irrespective of the time of the measurement.

⑤ Evaluating, managing and saving the measurement

Numerous options are available for the evaluation of the measurement in the curve diagram 
and in the signal table (Page 8074). Various display types are possible, for example, a bit 
representation for binary signals. 
Measurements can also be exported and imported as a file.
With the saving of the project (Page 8075) in the TIA Portal, the measurements transferred to 
the project are also saved.

13.6.1.3 Trace configuration, recording and measurement
This section explains the meaning of the terms: trace configuration, recording and 
measurement.
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Trace configuration
You can make the following settings in the trace configuration :

● Signals to be recorded

● Recording conditions

– Sampling

– Trigger

Recording
A recording is performed in the device. There is only one recording for each installed trace 
configuration. When a new recording is started, the old recording is overwritten.

An installed recording is not retentive (it is lost when the device is switched off/on) and can be 
saved permanently in the project as a measurement.

Installed traces
An installed trace  consists of a trace configuration and optionally a recording. The 
maximum number of installed traces depends on the device.

The status of an installed trace can be viewed online.

Measurement
A measurement  always consists of a trace configuration with an associated recording. If 
an installed trace contains a recording, it can be saved in the project as a measurement. 

The recording of a measurement can be viewed offline.

13.6.1.4 Data storage
The trace handling and the curve diagram also enable the transfer of the trace configuration 
and the viewing of the recording.      

The following figure is a schematic diagram of the data storage:

Using online and diagnostics functions
13.6 Using the trace and logic analyzer function

WinCC Professional V13.0
System Manual, 02/2014 8053



 

 Note
Saving the trace configuration and measurement

You save the trace configuration and measurement with the project in the TIA Portal.

If you close the project without saving, the trace configurations and the measurements 
transferred to the project are discarded. The trace editor can be closed and reopened without 
loss of data until the project is closed.

 

 

13.6.2 Software user interface
 

Display areas
The user interface of the trace and logic analyzer function consists of several areas.   

The example in the figure below shows the division of the user interface in the TIA Portal:
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1 Project navigator
 Working area
2  Title bar of the working area

Shows the device to which the current display belongs.
3a  Toolbar of the trace handling (Page 8062) 

Selection of recordings for display in the curve diagram and buttons for activation/
deactivation of installed traces. 

4  Toolbar of the curve diagram (Page 8058) 
Tools for editing the measurement and for adapting the display in the curve diagram.

5  Curve diagram (Page 8058) 
Display of the recorded values. 

6  Signal table (Page 8060) 
Signals of the shown measurement.
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3b  Trace handling (Page 8062) 
Creation of new trace configurations and the handling of the measurements.

 Device-specific area (see Devices (Page 8078))
7  Properties area in the Inspector window

Configuration dialog boxes for the recording duration, trigger condition and signal 
selection.

13.6.2.1 Project navigator
If a device supports the trace and logic analyzer function,  "Traces" is offered for selection 
in the project navigator below the device.  

Double-clicking  "Traces" opens the trace editor.

13.6.2.2 Working area

User interface - curve diagram
The curve diagram displays the selected signals of a recording. Bits are shown in the lower 
diagram as a bit track. You can adjust the display of the signals in the signal table 
(Page 8060) and with the aid of the toolbar of the curve diagram.     

Setting options and displays in the curve diagram
The following figure shows an example of the display in the TIA Portal:

The scale in the diagram applies to the selected (highlighted in gray) signal in the legend. The 
legend can be moved laterally with the mouse.

Using online and diagnostics functions
13.6 Using the trace and logic analyzer function

WinCC Professional V13.0
8056 System Manual, 02/2014



Shortcut menu commands
The following table shows the shortcut menu commands in the curve diagram:

Shortcut menu command Description
"Save diagram as image" Exports the current display as a bitmap.
"Copy image to clipboard" Copies the current display to the clipboard.
"Center measurement cursors" Positions the activated measurement cursors at a central point in 

the current display.
"Add to measurements"
(only axis control panel and PID)

Adds the shown recording to the "Measurements" table.

Toolbar of the curve diagram
Tools are available for adapting the display via buttons.

The following table shows the functions of the buttons:

Icon Function Description
Undo zoom Undoes the zoom function executed last. 

If several zoom functions have been executed, they can 
be undone step-by-step.

Redo zoom Redoes the last undone zoom function. If several zoom 
functions have been undone, they can be redone step-
by-step.

Standard view Uses the current view as standard for this recording. If 
the trace recording is shown again later, the standard 
view is restored.

Move view Moves the display with the mouse button pressed.

Zoom selection Selection of an arbitrary range with the mouse button 
pressed. The display is scaled to the range selection.

Vertical zoom selection Selection of a vertical range with the mouse button 
pressed. The display is scaled to the range selection.

Horizontal zoom selection Selection of a horizontal range with the mouse button 
pressed. The display is scaled to the range selection.

Display all Scales the display of the available data so that the entire 
time range and all values are displayed.
Note
The dynamic progress indicator of a running trace is 
stopped when a zoom function is activated. This button 
activates the progress indicator again.

Zoom in Enlargement of the display. The ranges of the time axis 
and value axis are reduced every time the button is 
clicked. The curves are displayed larger.

Zoom out Reduction of the display. The ranges of the time axis 
and value axis are increased every time the button is 
clicked. The curves are displayed smaller.

Scale automatically Scaling of the display so that all values are displayed 
for the currently displayed time range.
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Icon Function Description
Arrange in tracks Arranges signals one beneath the other without 

overlaps.
Unit changeover of the time axis Changeover of the unit between time and cycles.

Display samples The samples are displayed as small circles on the 
curves.

Display vertical measurement 
cursors

Display of the vertical measurement cursors.
The vertical position of the two measurement cursors 
can be moved with the mouse. The associated 
measured values and the difference of the 
measurement cursors corresponding to the position are 
shown in the signal table.

Display horizontal 
measurement cursors

Display of the horizontal measurement cursors.
The horizontal position of the two measurement cursors 
can be moved with the mouse.

Display chart legend Display or hiding of the chart legend in the curve 
diagram.

Align the chart legend to the left Display of the chart legend on the left side of the curve 
diagram.

Align the chart legend to the 
right

Display of the chart legend on the right side of the curve 
diagram.

Change background color Changeover between various background colors.

User interface - signal table
The signal table lists the signals of the selected measurement and provides setting options for 
some properties. If recording data of "Installed traces" is displayed and the settings are 
changed in the signal table, these settings are retained until there is a change to the offline 
mode. If the "Installed trace" is added to the measurements, the current settings of the signal 
table are saved in the measurement.

The signals can be sorted using drag-and-drop. The bits of a signal can be resorted within a 
signal. 

Setting options and displays in the signal table
The following figure shows an example of the display in the TIA Portal:

The following table shows the settings and displays of the recorded signals:
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Column Description
Static display of the signal icon
Selection for the display in the curve diagram
The point indicates that at least one bit has been selected for display as bit track 
for the signal in the bit selection. 

"Name" Display of the signal name
A click on the name of a displayed signal updates the scale in the curve diagram.

 Open bit selection
Individual bits can also be selected for the following data types for display as a bit 
track in the lower curve diagram.
● Byte, Word, DWord, LWord
● SInt, USInt, Int, UInt, DInt, UDInt, LInt, ULInt
Example of an opened bit selection for the DWORD data type:

Select or deselect the relevant bit for display by clicking the  icon.
"Data type" Display of the data type
"Address" Display of the address (not for symbolic tags)
"Color" Display and setting option for the color of the signal
"Min. Y-scale" Display or input of the minimum value for the scaling of the signal
"Max. Y-scale" Display or input of the maximum value for the scaling of the signal
"Signal group" Display or input of the signal group name for one signal group

The Y-scales are scaled identically for all signals of one signal group.
Enter an identical signal group name for those signals that are to be scaled 
identically.
Signals can be removed from the signal group by deleting the signal group name.
The signal groups can be saved via the function "Use current view as standard" 
(button ).

"Y(t1)" Display of the value at the position of the first measurement cursor
"Y(t2)" Display of the value at the position of the second measurement cursor
"ΔY" Display of the value difference between the first and the second measurement 

cursor
"Unit" Display of the unit (e.g. for technology objects)
"Comment" Display and input option for a comment about the signal

Shortcut menu commands
The following table shows the shortcut menu commands of the signal table:

Shortcut menu command Description
"Cut" Cannot be selected.
"Copy" Copies the contents of the selected lines to the clipboard.
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Shortcut menu command Description
"Paste" Cannot be selected.
"Show/hide signal" Shows/hides the signal in the curve diagram.
"Bring to foreground" Displays the selected signal in the foreground. The other signals 

are hidden.

User interface - trace management
The trace handling enables the configuration and handling of trace configurations.   

Setting options and displays in the trace handling
The following figure shows an example of the display in the TIA Portal:

  
① Trace configuration
② Recording (recorded values)

Toolbar of the trace handling
A recording can be selected for display via a drop-down list and buttons, and activated or 
deactivated.

The example in the figure below shows the toolbar of the trace handling

The following table describes the functions of the buttons:

Icon Description
Static icon display of the drop-down list selection in the curve diagram

Selection of an "Installed trace" or a "Measurement" for display in the curve diagram

Activation of the recording
The button is available for "Installed traces".
Deactivation of the recording
The button is available for "Installed traces".
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"Trace configurations" table   
The table contains all the trace configurations of the project that can be transferred to the 
device. Each trace configuration contains the tags to be recorded and the required recording 
settings. The data is displayed in offline and online mode.

The following table shows the settings and displays:

Column Icon Description
- Display of the icon for the trace configuration

Incorrect trace configurations are shown with a red border and 
cannot be transferred to the device. Check the configuration in 
the Inspector window.
Double-clicking the icon brings the Inspector window with the 
properties to the foreground.

"Trace configuration" - Name of the trace configuration.
The name can be changed after double-clicking the field.

"Comment" - Input field for a comment.

Shortcut menu commands

The following table shows the shortcut menu commands of the "Trace configurations" table 
when a line is selected:

Shortcut menu command Description
"Cut" Cannot be selected.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Pastes the contents of the clipboard.
"Delete" Deletes the selected lines from the table or deletes the name of the 

selected cell.
"Rename" Switches the selected cell to the editing mode.
"Transfer trace configuration to 
device"

Transfers the trace configuration selected in the "Trace 
configurations" table to the device.
The button is active when all the required settings in the device-
specific configuration have been configured correctly in the 
Inspector window and there is an online connection.

"Export trace configuration" Exports a trace configuration as a file with the "*.ttcfgx" file extension.
For compatibility reasons, the "*.ttcfg" file extension will be 
supported in V12, but does not contain any information about the 
device family.

"Import trace configuration" Imports a trace configuration from a file.
"Properties" Brings the Inspector window with the device-specific properties to 

the foreground.

"Installed traces" table 
The table contains the trace configurations already transferred to the device and their current 
status. The data is displayed in the online mode.

The following table shows the settings and displays:
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Column Icon Description
- Static display of the online icon

Double-clicking the icon brings the Inspector window with the device-
specific properties to the foreground.
Selection for the display in the curve diagram
A click on the icon shows/hides the recording in the curve diagram.

"Installed traces" - Name of the trace configuration.
"Active" Activation of the recording and feedback of the status.

The checkbox is reset at the end of the recording.
If the recording of an installed trace is repeated, then the settings 
relevant for the display (curve diagram and signal table) are also 
retained for the new recording.

"Status" - Status display of the trace configuration
The following states are possible:
● "Installing"
● "Waiting for trigger"
● "Recording"
● "Recording completed"
● "Aborted"
● "Fault"

"Comment" - Display of the trace configuration comment

Shortcut menu commands

The following table shows the shortcut menu commands of the "Installed traces" table when 
a line is selected:

Shortcut menu command Description
"Cut" Cannot be selected.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Cannot be selected.
"Delete" Deletes the selected lines from the table.
"Rename" Cannot be selected.
"Add to trace configurations" Transfers the installed trace configuration to the "Trace 

configurations" table.
"Add to measurements" Adds the selected "Installed trace" to the "Measurements" table.

Note
The "Installed trace" data can be saved as a measurement after 
being displayed once in the curve diagram. The recording data is 
loaded from the device for the display.

"Activate" Activates the recording and shows the status in the table
"Show/hide in curve diagram" Shows/hides the recording in the curve diagram.
"Properties" Brings the Inspector window with the device-specific properties to 

the foreground.
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"Measurements" table 
The table contains the trace configurations with recordings. The data is displayed in offline 
and online mode.

Measurements can also be exported and imported, see Exporting and importing 
measurements (Page 8075).

The following table shows the settings and displays:

Column Icon Description
- Static display of the icon for a measurement

Double-clicking the icon brings the Inspector window with the device-
specific properties to the foreground.
Selection for the display in the curve diagram
A click on the icon shows/hides the recording in the curve diagram.

"Measurements" - Name of the measurement
The name can be changed after double-clicking the field.

"Trigger time" - The meaning of the time stamp depends on the device
Examples:
● SIMATIC S7-1200/1500 CPUs

The absolute time of the controller is entered at the start of the 
recording.

● SINAMICS G120
The transfer time is entered with the transfer of the trace 
configuration to the device.

"Comment" - Input field for a comment.

Shortcut menu commands

The following table shows the shortcut menu commands of the "Measurements" table when a 
line is selected:

Shortcut menu command Description
"Cut" Cannot be selected.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Pastes the contents of the clipboard.
"Delete" Deletes the selected lines from the table or deletes the name of the 

selected cell.
"Rename" Switches the selected cell to the editing mode.
"Add to trace configurations" Transfers the trace configuration of the measurement to the "Trace 

configurations" table.
"Show/hide in curve diagram" Shows/hides the recording in the curve diagram.
"Export measurement" Exports a measurement as a file with the "*.ttrecx" or "*.csv" file 

extension. 
For compatibility reasons, the "*.ttrec" file extension will be 
supported in V12, but does not contain any information about the 
device family.

Using online and diagnostics functions
13.6 Using the trace and logic analyzer function

WinCC Professional V13.0
System Manual, 02/2014 8063



Shortcut menu command Description
"Import measurement" Imports a measurement from a file with the "*.ttrecx" file extension. 

For compatibility reasons, the "*.ttrec" file extension will be 
supported in V12, but does not contain any information about the 
device family.

"Properties" Brings the Inspector window with the device-specific properties to 
the foreground.

Buttons
The following table shows the functions available via buttons:

Icon Description
Button to transfer a selected trace configuration to the device
The selected trace configuration in the "Trace configurations" table is transferred to the 
device.
The button is active when all the required settings in the configuration have been correctly 
configured in the Inspector window and there is an online connection.
Button to transfer a selected trace configuration from the device 
The trace configuration selected in the "Installed traces" table is transferred from the 
device to the "Trace configurations" table.
Button to transfer a selected measurement from the device to the project
The selection in the "Installed traces" table is added to the "Measurements" table.
Note for S7 CPUs
In order to be able to save the "Installed trace" data as a measurement, it must first have 
been displayed once in the curve diagram. The recording data is loaded from the device 
when displayed.

13.6.2.3 Device-specific area
The device-specific area enables the trace configuration.

The signals to be recorded and the trigger condition are specified here. These and other 
configuration options are described in the device-specific part (Page 8078) for the individual 
devices.

13.6.3 Operation

13.6.3.1 Quick start
This description shows the steps for a recording of the S7-1500 CPU as an example. The 
displayed settings can differ depending on the device.  

Requirement
A device is configured that supports the trace and logic analyzer function.
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Calling the trace editor
The following figure shows the project navigator with "Traces" below the device:

Procedure:

1. Open the trace editor by double-clicking the "Traces" entry.

Creating a trace configuration
The following figure shows the "Trace configurations" table:

Procedure:
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1. Enter the name of the trace configuration in the "Trace configurations" table.

Selecting signals
The following figure shows the configuration of the signals:

Procedure:

1. Select the signals to be recorded in the "Signals" area of the Inspector window.

Or:

1. Drag a signal to the table using drag-and-drop.

Configuring the recording cycle 
The following figure shows the configuration of the sampling:

Procedure:
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1. Configure the sampling.

Configuring the trigger
The following figure shows the configuration of the trigger:

Procedure:

1. Configure the trigger mode and the condition for the selected trigger.

Transferring the trace configuration to the device
The following figure shows the trace handling in online mode:

Procedure:

1. Check whether the configuration is correct based on the icon in the "Trace configurations" 
table.
The  icon indicates a correct trace configuration.
The  icon indicates a faulty trace configuration.
Only correct trace configurations can be transferred to the device.

2. Establish an online connection to the device.

3. Select the trace configuration in the "Trace configurations" table and transfer it to the device 
with the  button.
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Activating a recording
The following figure shows the trace handling with an installed trace configuration:

Procedure:

1. Click the checkbox in the "Active" column in the "Installed traces" table.

Displaying the recording
The following figure shows the curve diagram with the recording of the "Installed trace":

Procedure:
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1. Wait until the "Recording" or "Recording completed" status is displayed in the "Installed 
traces" table.

2. Click the  icon in the "Installed traces" table to display the recording in the curve diagram.

3. Click the  icon of a signal in the signal table.
The individual bits of the signal are offered for display as a bit track.

4. In the signal table, select or deselect the individual signals and bits for display with the 
 icon.

Saving the measurement in the project
The following figure shows the measurement saved in the project:

Procedure:

1. Select the measurement in the "Installed traces" table and transfer it to the project with the 
 button.

13.6.3.2 Using the trace function - overview

Requirement
A device is configured in the TIA Portal that supports the trace and logic analyzer function and 
to which an online connection has been established.

Procedure
The following table shows a procedural overview with typical steps when working with the trace 
and logic analyzer function.

Step Description
1 Calling the trace editor (Page 8072) 
2 Configuring the trace (Page 8072) 
3 Transferring the trace configuration to the device (Page 8073) 
4 Activating/deactivating an installed trace (Page 8073) 
5 Monitoring the recording (Page 8074) 
6 Saving measurements in the project (Page 8075) 
7 Displaying the recording (Page 8074) 
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13.6.3.3 Calling the trace editor
A trace editor can be opened for each device in the project navigator.

The following instructions describe how you call the trace editor in the work area of the TIA 
Portal.   

Requirement
A device is configured that supports the trace and logic analyzer function.

Procedure
To call the trace editor, proceed as follows: 

1. In the project navigator, double-click the device.
The device folder opens.

2. Double-click "Traces".

13.6.3.4 Trace handling

Configuring the trace

Requirement
The trace editor is open.

Creating and deleting the trace configuration
To create a new trace configuration, proceed as follows:

1. Click the "<Add>" entry in the "Trace configurations" table in the Trace handling 
(Page 8060).

2. Enter the name for the trace configuration.
The new trace configuration is created.

 

To delete a trace configuration, proceed as follows:

1. Right-click a trace configuration in the "Trace configurations" table and select the shortcut 
menu command "Delete".
The trace configuration is deleted.

Configuring the trace
In the configuration, you specify the recording and trigger conditions and select the signals to 
be recorded.   
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See Section "Configuration" below the respective device (Page 8078).
 

 Note
Saving the trace configuration   

You save the trace configuration with the project in the TIA Portal. 

If you close the project without saving, the configuration is discarded. The trace editor can 
be closed and reopened without loss of data until the project is closed. 

 

Transferring the trace configuration to the device

Requirement
● A valid trace configuration  is located in the "Trace configurations" table.

● The maximum number of "Installed traces" has not been reached yet.

● There is an online connection to the device.

Procedure
To transfer a trace configuration to the device, proceed as follows:

1. Select a trace configuration  in the "Trace configurations" table.

2. Click the  button to transfer the trace configuration to the device.

Result
The trace configuration is transferred to the device and displayed in the "Installed traces" table. 

Activating/deactivating an installed trace

Requirement
A trace configuration is installed and there is an online connection to the device.
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Activating an installed trace   
To activate the recording for an installed trace, proceed as follows:

1. Activate the checkbox of the "Active" column in the "Installed traces" table.
The installed trace is activated and starts the recording according to the configured trigger 
condition. The trigger condition is device-specific and described in Section "Configuration" 
below the respective device (Page 8078).

 

  Note

When a recording is restarted, the previously recorded values are lost.

To save the recorded values, save the measurement in the project (Page 8075) before 
you activate the recording again.

 

Deactivating an installed trace 
To deactivate an activated installed trace, proceed as follows:

1. Deactivate the checkbox of the "Active" column in the "Installed traces" table.
The installed trace is deactivated. 

Displaying the recording

Requirement
A trace configuration with recording is in the device and there is an online connection to the 
device or there is an entry in the "Measurements" table.

Procedure
To display the recording, proceed as follows:

1. Select an entry in the "Installed traces" table.

2. Click  in the column for the selected entry.

 

Or:

1. Select an entry in the "Measurements" table.

2. Click  in the column for the selected entry.

 

Result
The recording is displayed in the curve diagram and the signal table. 
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Saving measurements in the project

Requirement
A trace configuration with recording is installed and there is an online connection to the device.

The "Installed trace" data must have been displayed at least once in the curve diagram. The 
recording data is loaded from the device for the display.

Procedure  
To save a recording in the project, proceed as follows:

1. Click an entry in the "Installed traces" table in the trace handling.

2. Click the  button to transfer the selected entry.
The selected entry in the "Installed traces" table is added to the "Measurements" table.

3. Save the project in the TIA Portal.

Exporting and importing measurements

Requirement
There is at least one measurement in the "Measurements" table.

Exporting measurements
To export a measurement, proceed as follows:

1. Right-click an entry in the "Measurements" table and select the shortcut menu command 
"Export measurement".

2. Select a folder, a file name and a data type to save the measurement.

3. Click the "Save" button.

Importing measurements
To import a measurement, proceed as follows:

1. Right-click in the "Measurements" table and select the shortcut menu command "Import 
measurement".

2. Select the file of the "*.ttrecx" file type with the measurement to be imported.

3. Click the "Open" button.
The imported measurement is displayed with the file name in the "Measurements" table.
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Transferring the trace configuration from the device to the project

Requirement
A trace configuration is installed and there is an online connection to the device.

Procedure   
To transfer a trace configuration to the project, proceed as follows:

1. Select an entry in the "Installed traces" table.

2. Click the  button to transfer the trace configuration from the device.

Result
The configuration of the "installed trace" is transferred to the "Trace configurations" table.

Deleting installed traces

Requirement
A trace is installed and there is an online connection to the device.

Deleting an installed trace   
To delete an installed trace, proceed as follows:

1. Select one or more lines to be deleted in the "Installed traces" table.

2. Press <Del> to delete the "Installed traces".

13.6.3.5 Signal table

Use of the signal table
The signal table shows the signals of an installed trace or a measurement. You can show or 
hide individual signals for the display in the table and adapt the properties for the display. 
Individual bits can be selected for some data types and displayed as a bit track.

The following operating instructions describe the operation of the signal table.

Requirement
● An entry is selected in the  column in the "Installed traces" or "Measurements" table.

● For the display of individual bits as a bit track:
At least one recorded signal supports the display as a bit track.
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Selecting individual signals in the signal table and changing the format
To adapt the display to suit your requirements, proceed as follows:

1. Click the icon of the respective signal in the  column to select or deselect it for the display.

2. Click in the "Color" column for the respective signal to change the default color of the signal.

3. Click the "Bring to foreground" entry in the shortcut menu of a signal to display it in the 
foreground.

Selecting individual bits in the signal table for display as a bit track
To display individual bits as a bit track in the lower curve diagram, proceed as follows:

1. Click the  icon of a signal in the signal table.

2. Click the  icon in the opened bit selection of the signal to select or deselect individual bits 
for the display.

13.6.3.6 Curve diagram

Use of the curve diagram
The curve diagram shows the signals of a recording selected in the signal table. Select the 
recording in the "Installed traces" or "Measurements" table of the trace handling.     

The display area can be zoomed as required. Measurement cursors can be used to select 
individual values for display in the signal table.

The following operating instructions describe the use of the measurement cursors.

Requirement
A recording has been selected for display.

Evaluation of a certain instant of a recording
To display the values for a specific sample, proceed as follows:

1. Display the vertical measurement cursors via the  button.

2. Move a measurement cursor with the mouse to the required position in the recording.
The values of the signals are displayed in the signal table. The time or sample for the 
measurement cursors is displayed in the lower area of the curve diagram.

Evaluation of the difference between two samples
To display the difference, proceed as follows:

1. Display the vertical measurement cursors via the  button.

2. Move both measurement cursors with the mouse to the required samples in the recording.
The values of the signals and the difference are displayed in the signal table. The time or 
sample for the measurement cursors is displayed in the lower area of the curve diagram.
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Using horizontal measurement cursors
To check whether a certain value has been reached, proceed as follows:

1. Display the horizontal measurement cursors via the  button.

2. Move a measurement cursor with the mouse to the required value of the recording.
The values of the measurement cursor for the selected signal are displayed in the lower 
area of the curve diagram.

Printing a recording
The curve diagram supports the saving of the display as a bitmap and the copying of the display 
to the clipboard. Also use these functions (Page 8056) for printing.   

13.6.4 Devices

13.6.4.1 S7-1200/1500 CPUs

Recordable variables

Device-dependent recording of tags
The following list shows the operand areas from which tags can be recorded:    

● Process image input

● Process image output

● Bit memory

● Data blocks

Data types
Elementary data types can be recorded. The availability of the individual data types depends 
on the device used:

The following table lists the elementary data types:

Data types Note
Binary numbers
BOOL -
Bit strings
BYTE -
WORD -
DWORD -
LWORD Symbolic name required
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Data types Note
Integers
SINT -
USINT -
INT -
UINT -
DINT -
UDINT -
LINT Symbolic name required
ULINT Symbolic name required
Floating-point numbers
REAL -
LREAL Symbolic name required

Lifetime of the installed trace configuration and recorded values
Installed trace configurations are retained after POWER OFF. The recording is activated again 
after the restart of the CPU.

Recorded values are lost during the restart.
 

 Note
Downloading a configuration to the device in the "STOP" operating state

Note that after downloading a configuration in the "STOP" operating state, you must check 
the installed traces and, if required, reactivate them or transfer them again.

 

 Note

If signals or trigger tags that affect the address are changed, the trace configuration must 
also be transferred to the device again. 

This is the case for example, when a data block is shortened or extended or the data type is 
changed.

 

Recording levels
The following list shows the execution levels that can be selected for the recording cycle:   

● Program cycle - OB 1

● Time-of-day interrupt - OB 1x

● Time-delay interrupt - OB 2x

● Watchdog interrupt - OB 3x

● Synchronized processing cycles - OB 6x, not OB 60
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● Servo task - OB 91 (S7-1500)

● IPO - OB 92 (S7-1500)
 

  Note

The measured values are recorded at the end of the OB after the processing of the user 
program. 

 

Quantity structure
The following table shows the maximum quantity structure that can be recorded with the trace 
and logic analyzer function: 

Device Maximum number of "Installed 
traces"

Maximum number of signals per 
trace configuration

S7-1200
(as of firmware version V4.0)

2 16

S7-1500 At least 4
(depending on the CPU type)

16

Example of S7-1516

● Maximum of 3854 samples for 16 long tags

● Maximum of 21844 samples for 16 binary tags

● Maximum of 58250 samples for 1 binary tag

Refer to respective manual for more detailed information.

CPU load through trace recording
A trace recording increases the runtime of the respective recording level that can result in an 
execution level overflow with high utilization of the CPU. 

Remedy
● Change the trace configuration

1) Configure fewer tags and signals.
2) Then increase the number of tags and signals up to the maximum number of signals 
step-by-step without an execution level overflow.

● Select a slower recording level

Using online and diagnostics functions
13.6 Using the trace and logic analyzer function

WinCC Professional V13.0
8078 System Manual, 02/2014



Software user interface of the device-specific area

Structure of the user interface

Display areas in the Properties window of the Inspector
The settings options differ depending on the configured device.   

The following figure shows an example of the display in the TIA Portal:

The area navigation provides the following entries for selection:

● General

● Configuration

– Signals (Page 8082)

– Recording conditions (Page 8083)

Display of the properties of a trace configuration
The trace configuration is selected in the trace handling:

● Selection in the "Trace configurations" table
The properties are displayed in the Inspector window and can be changed.

● Selection in the the "Installed traces" table or "Measurements" table
The properties are displayed write-protected in the Inspector window.

User interface - General
The "General" area shows the name of the trace configuration and input fields for the author 
and a comment.   
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Input options and displays in General
The following figure shows an example of the display in the TIA Portal:

The following table shows the input fields and displays:

Column Icon Description
"Name" - Name of the trace configuration
"Author" - Author of the trace configuration
"Comment" - Input field for a comment

User interface - Signals
The "Signals" area shows a table in which the signals to be recorded are configured for the 
selected trace configuration.   

Signals can also be inserted in the table using drag-and-drop. 
The signals can be sorted using drag-and-drop.

Setting options and displays in "Signals"
The following figure shows an example of the display in the TIA Portal:

The following table shows the settings and displays:
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Column Icon Description
 Display of the signal icon for a selected signal.
"Name" - Input field for the name or address of the signal.

Examples:
● M0.0
● DB1.DBW3
● "Data_block_1".pressure

- Button to open the signal selection table.
The button is displayed when the table line is selected.
Clicking the icon opens a table which offers possible signals for selection. 
The selected signal is displayed in the input field.

"Data type" - Text field with display of the data type for the signal.
"Address" - Input field for the address of the signal.

With purely symbolic signals the field remains empty.
"Color" - Text field for display and selection of the color.

Click the selected field to display the signal color. 
Click the signal color to open the color selection dialog.

"Comment"  Input field for a comment on the signal.

Shortcut menu commands
The following table shows the shortcut menu commands of the table:

Shortcut menu command Description
"Cut" Cannot be selected.
"Copy" Copies the contents of the selected lines to the clipboard.
"Paste" Pastes the contents of the clipboard to the selected line. The existing 

contents are overwritten.
"Delete" Deletes the selected lines from the table or deletes the name of the 

selected cell.
"Rename" Switches the selected cell to the editing mode.

Recording conditions

Supported data types
The following table shows the supported data types for the trigger tag:     

Memory requirement and format of the number Data type
1 byte BOOL
8-bit integers SINT, USINT, BYTE
16-bit integers INT, UINT, WORD
32-bit integers DINT, UDINT, DWORD
64-bit integers LINT, ULINT, LWORD (device-dependent)
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Memory requirement and format of the number Data type
32-bit floating-point numbers REAL
64-bit floating-point numbers LREAL

User interface - Recording conditions
The "Recording conditions" area shows the trigger condition for the selected trace configuration 
and in which cycle, how fast and how long the recording is made. The configuration is only 
possible if the trace configuration has been selected in the "Trace configurations" table of the 
trace handling.   

Setting options and displays in "Recording conditions"
The following figure shows an example of the display in the TIA Portal:

Setting/display Description
"Recording time"  
 Drop-down list Selection of the recording time.

See Recording levels (Page 8077) 
 Text field Detailed information on the selected recording time.
"Record every"  
 Input field Input of the reduction in relation to the cycles.  
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Setting/display Description
 Drop-down list Selection of the reduction factor.

The following settings are possible:
● "Cycle"

 Text field Display of the sampling time, taking into account the configured reduction.
"Recording duration"  
 Input field Input of the recording duration in relation to the samples.

If the "Recording duration = max. recording duration" checkbox is 
activated, entries are overwritten by the value displayed in "Max. 
recording duration".

 Drop-down list Select the time unit for the recording duration.
The following settings are possible:
● "Samples"

 Text field Displays the calculated recording duration.
"Max. recording duration"  
 Text field Displays the calculated maximum recording duration.

The "Max. recording duration" depends on how many signals are 
recorded and the data type of these signals.

 "Use max. recording 
duration"

Set the recording duration to the maximum value.
When the checkbox is activated, the recording duration is set to the 
maximum possible recording duration. The set reduction in the "Record 
every" input field is taken into account. The recording duration is also 
adapted when additional signals are added.

"Trigger mode" Selection of the trigger mode.   
 Drop-down list The following settings are possible:

● "Record immediately"
The recording is made immediately after the device is activated.

● "Trigger on tag"
The recording is made as soon as the installed trace is activated and 
the configured trigger condition is fulfilled.

 Text field Display of the trigger type.
"Trigger tag" The "Trigger tag" specifies a signal that is used to trigger the recording.   
 Input field Enter a signal.

Examples:
● M0.0
● DB1.DBW3
● "DataBlock_1".Temperature

  Opens the signal selection table.
Clicking the icon opens a table which offers possible signals for selection 
as trigger tag. The selected signal is displayed in the input field.

 Text field Display of the trigger tag address.
"Event" The events that can be used on this trigger tag are offered for selection 

according to the data type of the trigger tag.
The event can only be configured when a valid signal has been entered 
as trigger tag.
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Setting/display Description
 Drop-down list Event selection for which the trigger tag is checked.

The entries in the drop-down list are described in Section Trigger event 
(Page 8086).

 Text field Display of the comparison type.
"Value" Configuration of the selected event.

The configuration options differ depending on the format of the trigger 
tag and the selected event. 
See Trigger event (Page 8086).

"Pre-trigger" "Pre-trigger" defines the time during which the signals are already 
recorded before the actual trigger condition is fulfilled.
If the trigger event occurs immediately or shortly after the activation of 
the recording, this may result in a shorter recording duration.
Example of "recording duration" = 20 samples and "pre-trigger" = 
5 samples:
● Trigger event occurs 50 samples after activation of the recording

Actual recording duration = 20 samples
● Trigger event occurs 2 samples after activation of the recording

Actual recording duration = 17 samples
 Input field Input of the duration in relation to the selection in the drop-down list.
 Drop-down list Select the time unit

The following settings are possible:
● "Samples"

 Text field Displays the calculated "pre-trigger" period

Trigger event
Depending on the selection in the drop-down list box, the further settings differ for the 
"event".   

The individual events are described below.

"=TRUE"
Supported data types: Bit (Page 8081) 

The recording starts when the state of the trigger is TRUE.

"=FALSE"
Supported data types: Bit (Page 8081) 

The recording starts when the state of the trigger is FALSE.

"Rising edge"
Supported data types: Bit (Page 8081) 

The recording is started when the trigger state changes from FALSE to TRUE.
After activation of the installed trace, at least two cycles are required to identify the edge.
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"Rising signal"
Supported data types: Integers and floating-point numbers (Page 8081) 

The recording is started when the rising value of the trigger reaches or exceeds the value 
configured for this event.
After activation of the installed trace, at least two cycles are required to identify the edge.

"Falling edge"
Supported data types: Bit (Page 8081) 

The recording is started when the trigger state changes from TRUE to FALSE.
After activation of the installed trace, at least two cycles are required to identify the edge.

"Falling signal"
Supported data types: Integers and floating-point numbers (Page 8081) 

The recording is started when the falling value of the trigger reaches or falls below the value 
configured for this event.
After activation of the installed trace, at least two cycles are required to identify the edge.

"In the range"
Supported data types: Integers and floating-point numbers (Page 8081) 

The recording starts as soon as the value of the trigger is in the value range configured for this 
event.

"Outside of the range"
Supported data types: Integers and floating-point numbers (Page 8081) 

The recording starts as soon as the value of the trigger is outside the value range configured 
for this event.

"= value"
Supported data types: Integers (Page 8081) 

The recording starts when the value of the trigger is equal to the value configured for this event.

"<> value"
Supported data types: Integers (Page 8081) 

The recording starts when the value of the trigger is not equal to the value configured for this 
event.

"= bit pattern"
Supported data types: Integers (Page 8081) 
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The recording starts when the value of the trigger matches the bit pattern configured for this 
event.

The following figure shows the setting options for a "bit pattern":

It is possible to switch between the icons by clicking the respective button.

The following table shows the icons:

Icon Description
Bit is not evaluated

Bit is checked for FALSE

Bit is checked for TRUE

"<> bit pattern"
Supported data types: Integers (Page 8081) 

The recording starts when the value of the trigger does not match the bit pattern configured 
for this event.

See also
Configuring the trigger conditions (Page 8090)

Configuration

Trace configuration - overview
The configuration of the recording conditions and the signals to be recorded is device-specific. 
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Requirement
A trace configuration has been created and selected in the "Trace configurations" table of the 
trace handling.

Procedure   
The following table shows the procedure for configuring.

Step Description
1 Documentation of the configuration (optional)

Enter a comment and an author for the configuration.
2 Selecting signals (Page 8089) 

Select the signals to be recorded in the "Signals" area.
3 Configuring the recording cycle and duration 

Select a recording time, a cycle and the duration in the "Recording conditions" area.
4 Configuring the trigger conditions (Page 8090) 

In the "Recording conditions" area, select whether the recording is to be performed 
immediately or depending on a trigger condition.

Selecting signals

Requirement
● A trace configuration has been created and selected in the "Trace configurations" table of 

the trace handling.

● The "Signals" area is open in the Inspector window.

Procedure   
To configure the signals to be recorded, proceed as follows:

1. Click in the first empty line of the table.

2. Click in the first empty line of the "Name" column.

3. Select a signal. The following options are available:

– In the "Name" column, click the  button and select a tag.

– Enter the symbolic tag name in the cell in the "Name" column.

– Enter the address directly in the "Address" column.

– Drag a signal to the table using drag-and-drop.

4. Click in the "Display color" column and select a color for the display of the signal.

5. Click in the "Comment" column and enter a comment for the signal.

6. Repeat the procedure from step 1 until all the signals to be recorded have been entered in 
the table.
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Configuring the recording cycle and duration

Requirement
● A trace configuration has been created and selected in the "Trace configurations" table of 

the trace handling.

● The "Recording conditions" area is open in the Inspector window.

Procedure     
To configure the cycle and the duration of a recording, proceed as follows:

1. Click the  button for the recording time.

2. Select an OB for the recording time (Page 8077).

3. Select a unit for the reduction factor in the drop-down list box for "Record every".

4. Enter the factor for the reduction in the input field for "Record every".

5. Select a unit in the drop-down list box for "Recording duration".

6. Specify the recording duration. 
The following options are available:

– Enter a value for the duration in the input field for "Recording duration".

– Activate the "Use max. recording duration" checkbox.

Configuring the trigger conditions

Requirement
● A trace configuration has been created and selected in the "Trace configurations" table of 

the trace handling.

● The "Recording conditions" area is open in the Inspector window.
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"Record immediately" trigger condition
To start the recording immediately, proceed as follows:

1. Select the "Record immediately" entry in the drop-down list for "Trigger mode".
The input fields for the trigger tag are hidden.

"Trigger on tag" trigger condition
To start the recording depending on a condition, proceed as follows:

1. Select the "Trigger on tag" entry in the drop-down list for "Trigger mode".

2. Select a trigger tag. The following options are available:

– Click the  button for the trigger tag and select a tag.

– Enter the address or the symbolic name of the tag directly in the input field for the trigger 
tag.

A drop-down list with events and input fields is displayed. The display depends on the data 
type of the tag.

3. Configure the event.

4. Select a unit for the pre-trigger in the drop-down list for "Pre-trigger".

5. In order to record a period before the trigger event, enter a value greater than 0 in the input 
field for the pre-trigger.

 

 Note

The trigger condition is checked in every cycle irrespective of the setting in "Record every". 
To reliably identify the trigger, the trigger signal must be present for at least one full cycle.

 

13.7 Establishing a remote connection with TeleService

13.7.1 Basics of working with TeleService

13.7.1.1 Introduction to TeleService

Introduction
TeleService gives your controller telecommunication capability. You can manage, control and 
monitor distributed plants centrally by means of remote connections.
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Scope of functions
TeleService allows you to use the range of TIA portal functions via a telephone network or an 
Internet connection by establishing a remote connection to a remote plant. The online 
connection allows you to edit a remote plant as usual with the TIA Portal.

Advantages
Using TeleService offers the following advantages: 

● You can easily access even remote sections of plants and include them in a complete 
system.

● You can offer rapid help and support in the event of faults in a remote system without having 
to go there yourself.

● You can employ your resources effectively.

● It significantly reduces costs.

● It can significantly reduce plant downtimes.

● It improves the efficiency of your plant.

See also
TeleService functionality (Page 8092)

13.7.1.2 TeleService functionality

TeleService fields of application   
TeleService offers the following the fields of application:

● Access to remote systems (remote maintenance):
You can manage, control, and monitor remote systems centrally by means of remote 
connections. 
This is possible with an S7-300/400 CPU, an S7-1200 CPU and an S7-1500 CPU and a 
TS Adapter MPI  or a TS Adapter IE.

● Establishing connections from and to remote systems (PG-AS remote link):
You can use PRODAVE MPI V5.0 and newer to establish a remote connection to a remote 
system, and the communications instruction "PG_DIAL"  to establish a remote connection 
from a remote system.
This is possible with an S7-300/400 CPU and a TS Adapter MPI. 

● Data exchange between systems (AS-AS remote link):
The communications instruction "AS_DIAL" allows two automation systems to exchange 
process data over the telephone network. 
This is possible with an S7-300/400 CPU and a TS Adapter MPI. 
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● Sending an text message from a system:
An automation system can send a message (SMS) via a GSM wireless modem using the 
communications instruction "SMS_SEND" ".
This is possible with an S7-300/400 CPU and a TS Adapter MPI. 

● Sending an email from a system
An automation system can also send an email with the following communications 
instructions and a TS Adapter IE .

– S7-300/400 CPUs (CPU S7-31x-2PN/DP or CPU 41x-3PN/D) use the instruction 
"AS_MAIL"

– S7-1200 CPUs use the instruction "TM_MAIL"

– S7-1500 CPUs use the instruction "TMAIL_C"

       

 

13.7.1.3 Telephone book at TeleService

Introduction
By double clicking the "phone book" folder in the project tree you open the phone book editor 
displaying the TeleService  phone book.

Each version of the TIA Portal has its own "global phone book". If a global phone book from 
an earlier version of the TIA Portal is found in a more recent version of the TIA Portal, you will 
be asked once if you want to import this phone book. 

This gives you the advantage of being able to import the system data from the previous version 
into the more recent version of the TIA Portal.     

Global phone book properties
The global phone book is used in TeleService to manage specific system data that are required 
to establish a remote connection.   

When you open the phone book for the first time, you will see an empty phone book with all 
available columns; in all other cases, the last phone book edited is displayed.

You can enter any number of systems in a phone book. Systems contain the data required for 
establishing a remote connection, for example, the name and location of the device and the 
phone number to be dialed, along with all country-specific details. With VPN connections, you 
can enter an IP address or a DNS name instead of the phone number.

The TS adapters used for establishing the connection are distinguished by color, depending 
on whether a TS Adapter MPI or a TS Adapter IE is used for establishing the connection.

See also
Working with the phone book (Page 8094)
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13.7.2 Working with the phone book

13.7.2.1 Basics on working with the phone book

Working with the phone book
You have the following options when working with a phone book:   

● Open phone book

● Save phone book

● Import phone book data

● Export phone book data

● Printing the phone book

● Use phone book data to establish a remote connection

You can implement these functions simply and easily by using the buttons in the phone book 
toolbar.

 

 Note
Access to phone books

The phonebook is user specific in TeleService. However, it is not possible to access the global 
phone book with more than one instance of the TIA portal at the same time.   

 

 

See also
Open phone book (Page 8096)

Saving phone book (Page 8097)

Exporting phone book data (Page 8099)

Printing the phone book (Page 8100)

Structure of the phone book (Page 8094)

13.7.2.2 Structure of the phone book

Introduction
A global phone book in TeleService is used to manage the data you require for establishing a 
remote connection. Once you have created the connection data and saved it in the phone 
book, you can access it each time you want to establish a remote connection.
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Structure of the phone book
The integrated global phone book in TeleService contains the following columns:   

Column name Meaning
System name Enter a name for your system.
Adapter type Select the TS Adapter type used in the drop-down list: TS Adapter MPI or TS Adapter 

IE.
Connection type Select the required connection type: Dial-up connection or VPN connection.
Area code Enter the required area code.

This column is only active with dial-up connections. This column cannot be edited for 
VPN connections.

Phone number/remote address Enter the required connection data for establishing the remote connection. For dial-up 
connections, this can be a phone number, and for VPN connections a DNS name or 
an IP address.

Fingerprint Enter the corresponding fingerprint for establishing a VPN connection to the TS 
Adapter IE Advanced.

Country Enter the country code.
This column is only active with dial-up connections. This column cannot be edited for 
VPN connections.

User name Enter the user name you have logged on under.
Password Enter the password for this user name.
Group Enter the group if you have carried out grouping.
Company Enter the company to be contacted.
Department Enter the relevant department.
Street Enter the street.
Town/City Enter the town or city to which the remote connection is to be established.
Comment Enter a comment if required.

Showing or hiding columns
You can show or hide the individual columns. To do so, select the required column header 
and open the shortcut menu with the right mouse button.

13.7.2.3 Symbols in the phone book

Meaning of the TeleService icons     
The following table shows the meaning of the TeleService icons: 

Symbol Meaning
Open the global phone book

Imports a phone book

Exports a phone book
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Symbol Meaning
Establishes a remote connection

Terminates the active remote connection

Establishes a remote connection or terminates it

Displays the connection to a TS Adapter IE in the phone book

Displays the connection to a TS Adapter MPI in the phone book

Adds a new row to the phone book

Inserts a new row in the phone book

13.7.2.4 Manage phone book

Open phone book

Opening phone books
To open the phone book, follow these steps:  

1. In the project tree, double-click on the "Phone book" folder under "Online access" > 
"TeleService".

2. The phone book opens so that you can enter or edit the required system data.

Inserting rows in the phone book

Inserting rows in the phone book
To insert a new row in the phone book, follow these steps:

1. Select the row in front of which you want to insert a new row.

2. Click the "Insert row" button in the toolbar.

Result
A new row is inserted in the phone book above the selected row. 
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Showing and hiding columns in the phone book

Showing and hiding columns
To show or hide columns in the phone book, follow these steps:

1. Click a column header.

2. In the shortcut menu, select the "Show/hide columns" command.
The selection of available columns is displayed.

3. To show a column, select the column's check box.

4. To hide a column, clear the column's check box.

Result
The respective columns are shown or hidden when displaying the phone book. 

Saving phone book

Saving phone books
When you exit the phone book editor or leave the TIA portal, you are asked whether you want 
to save the global phone book.

Click "Yes" to save the phone book.   

 

Importing phone book data

Introduction
It is possible to import the phone book data from an external file or from an older version of 
the TIA Portal.  

Requirement
You have already created an import-capable phone book file.

You have already created a phone book with an older version of the TIA Portal.

Importing phone book data from a phone book file
To import phone book data from a phone book file, follow these steps:

1. Open the "TeleService" folder under "Online access" in the project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Import" button in the toolbar.
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4. Confirm the prompt asking if you want to save the current state of the phone book with 
"Yes", if applicable, and specify the location for storing the phone book in the dialog that 
follows.

5. If you do not want to save the current state of the phone book, answer the prompt with "No". 
In the subsequent dialog, select the phone book file to which the current phone book should 
be stored.

6. Close the dialog box with "OK".

Result
The imported phone book data is displayed in the global phone book.

 
 

 Note
Defining dialing rules

Dialing rules must be defined before the "area code" and "country" columns in the imported 
phone book can be edited for dial-up connections.

To define dialing rules, follow the link in the history.
 

Importing phone book data from an older version of the TIA Portal
To import phone book data from an older version of the TIA Portal, follow these steps:

1. Open the "TeleService" folder under "Online access" in the project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Import" button in the toolbar.

4. Confirm the prompt asking if you want to save the current state of the phone book with 
"Yes", if applicable, and specify the location for storing the phone book in the dialog that 
follows.

5. If you do not want to save the current state of the phone book, answer the prompt with "No".

6. Enter the following path in the dialog that follows: "%appdata%\siemens\automation
\TeleService\GlobalTeleServicePhoneBook.tel".

7. Close the dialog box with "OK".

Result
The phone book data imported from the older version of the TIA Portal is displayed in the global 
phone book.
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 Note
Defining dialing rules

Dialing rules must be defined before the "area code" and "country" columns in the imported 
phone book can be edited for dial-up connections.

To define dialing rules, follow the link in the history.
 

 

See also
Defining dialing rules (Page 8100)

Exporting phone book data

Introduction
It is possible to export phone book data to an external file.

Requirement
You have already created a phone book under TeleService with the corresponding system 
data.

Procedure
Proceed as follows to export the phone book data:

1. Open the "TeleService" folder in project tree.

2. Double-click on the "Phone book" folder.

3. Click the "Export" button in the toolbar.

4. In the next dialog box, select where the current phone book is to be exported.

5. Close the dialog box with "OK".

Result
The exported phone book data are saved in the specified export file.
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Printing the phone book

Printing phone books
You can print out all or some of the data in a phone book.  

Proceed as follows:
1. Open the phone book.

2. Select the Phone book > Print menu command or click on the appropriate button in the 
toolbar. The "Print" dialog will open.

3. Specify whether you wish to print the complete phone book or just part of it and set all other 
options.

4. Start the print job with "OK".

Result
The phone book data is printed on the default printer. If the printout is more than one page 
long, an identifier is printed after the page number at the bottom right corner of the page to 
indicate that there is another page. The last page does not have this symbol, indicating that 
no more pages are to follow.

Defining dialing rules

Procedure
 

To define location-specific dialing rules, follow these steps:

1. Open the folder "Online access" in the TIA portal and select the "TeleService" folder.

2. Use the shortcut menu to access the "TeleService" properties.

3. In the dialog that follows, open the "Advanced settings" tab and activate the "Use dialing 
rules" option.

4. Click the "Adapt" button.

5. In the dialog that follows, enter the required location information for connection 
establishment.

– For new locations, enter the country or region and the corresponding area code.

– If required, set the correct destination code and pre-dial line for local/long-distance calls.

– Select your chosen dialing mode for the location.

6. Exit the dialog by clicking "OK".

7. In the next dialog, select the location from which you wish to dial, and click "OK".
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8. In the TeleService dialog that follows, check that the correct location appears under 
"Location".

9. Confirm your entries by clicking "OK".
 

 Note
Modem operation on a local loop or extension

You do not need to specify a pre-dial line if you operate your modem on a local loop (main 
telephone line). The fields for the pre-dial lines for local calls and long-distance calls must be 
empty.
If you operate your modem on an extension, you should enter the pre-dial lines which need 
to be called to access a local loop.

 

 

Example of the use of dialing rules
The following example illustrates the use of location-specific dialing rules for the city of 
Karlsruhe in Germany.

● In the TeleService phone book, you enter the phone number "1234567", without the area 
code and without the country code.
Result: 
The phone number "1234567" is always dialed, irrespective of the location of the caller.

● In addition to the phone number "1234567", you enter the location-specific dial parameters 
for the Karlsruhe area code "0721" and the country code "+49" for Germany in the 
TeleService phone book.
Result: 
"1234567" is dialed from Karlsruhe.
"07211234567" is dialed from other towns in Germany.
"00497211234567" is dialed from other countries. 
 

 

 Note
Display in the phone book

The "area code" and "country" columns in the TeleService phone book can only be edited 
once you have defined the dialing rules as detailed above.
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13.7.3 Remote connections as dial-up connections

13.7.3.1 Basics for establishing a dial-up connection

Using a TS Adapter for dial-up connections
A TS Adapter is needed for establishing a remote dial-up connection using TeleService.   

The TS Adapter is used to prepare an automation system for use with TeleService by 
connecting it to a telephone network via a modem. The TS Adapter has an integrated 
parameter memory in which a parameter set for TeleService operation is stored. 

With the function "export adapter parameter", different parameter sets can be saved in external 
files, and reloaded in the TS Adapter  via the function "import adapter parameter".

Establishing a remote dial-up connection
You can choose between a number of different TS Adapters, each of which offers a different 
functionality and different connection options.

The figure below shows two possible configurations for establishing a dial-up connection to a 
system with the TS Adapter IE.   
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Overview of possible TS Adapter:
The TS Adapter comes in the following versions:   

● TS Adapter II  (also designated "TS Adapter MPI")

● TS Adapter IE Standard  (also designated "TS Adapter IE")

● TS Adapter IE Basic  (also designated "TS Adapter IE")

Designation "TS Adapter"   
In the following pages, the designation "TS Adapter" stands for all versions. The relevant 
product designation is listed beside information which only applies to a specific version, for 
example, "TS Adapter II" or "TS Adapter IE Standard".

 

 Note

For more detailed information on your TS Adapter, please refer to the documentation supplied 
with the TS Adapter.

 

See also
Short description of the TS adapter MPI (Page 8111)

Short description of the TS adapter IE (Page 8118)

Exporting adapter parameters (Page 8117)

Importing adapter parameters (Page 8118)

13.7.3.2 Telephone networks and modems

Supported telephone networks and modems

Telephone networks which can be used
TeleService can be used with digital networks (ISDN), analog networks and wireless networks 
(with GSM technology). This version supports a remote connection to a TS Adapter.

Modem support
TeleService has been implemented to be independent of the modem. This means that all 
standard modems which can be installed in the Windows Control Panel and are visible as 
modems can also be used by TeleService.   

The choice of modem type is determined primarily by the existing hardware of the programming 
device/PC and the telephone network to be used.
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The following modem types/media are supported:
● Modems (external modems at the COM interface, internal modems and PCMCIA cards) 

● External ISDN adapter at the COM interface or USB interface

● Internal ISDN adapter with virtual COM interface (for example AVM CAPI port)

● External ISDN modems (ISDN adapter with integrated analog modem functionality) at the 
COM interface or USB interface

● Radio network modems with GSM technology, PCMCIA adapter card or data cable and 
mobile phone

Gateways
Gateways between the various telephone networks are in principle possible. Remote 
connections from an ISDN adapter to an analog modem and vice versa only function with 
special ISDN telephone adapters.   

Performance in telephone networks
The data throughput of a remote connection depends on the modem and telephone network 
used and the quality of the telephone line.   

Installing the local modem

Introduction
If you have already installed a modem for data transfer in your operating system, this modem 
can also be used for TeleService.  

If a modem has not yet been installed for your operating system, one must be installed before 
you can establish a remote connection with TeleService.

Procedure
Proceed as follows:

1. Make sure your programming device/PC and the modem are switched off. 

2. Physically connect the external modem to a COM or USB interface on your programming 
device/PC. You can also install an internal modem or a PCMCIA card in accordance with 
the manufacturer's specifications.

3. Now switch on the modem and then the programming device or the PC.
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Result
Plug-and-play modems are recognized and installed automatically by the operating system. 
Dialogs will take you through the installation procedure.

 

 Note
Modems without plug-and-play

If your modem is not recognized automatically when switched on, you will have to install it 
yourself using the Control Panel. 

Please refer to the information in the documentation supplied with your modem.
 

Connecting and configuring the remote modem

Introduction
A modem must also be connected to the remote system before you can work with TeleService. 
This modem is designated the "remote modem".

Configuring the remote modem
The modem receives all parameters required for operation from the TS Adapter connected. 
These include data for initializing the modem and settings for serial transmission between the 
TS Adapter and the modem.   

The data required for the remote modem is specified during the configuration of the TS Adapter.

The modem may be internal or external depending on the TS Adapter used.

How to connect a TS Adapter with an internal modem  
1. Switch off the TS Adapter.

2. Connect the TS Adapter to the automation system.

3. Connect the TS Adapter to the telephone line.

4. Switch on the TS Adapter.

How to connect a TS Adapter with an external modem  
1. Switch off the modem.

2. Connect the TS Adapter to the automation system.

3. Connect the TS Adapter to the modem using a modem cable.

4. Connect the modem to the telephone line.

5. Switch on the modem.

6. Switch on the TS Adapter.
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 Note
Please note the following information on configuring the remote modem:
● The default parameters for the modem and the serial port set in the TS Adapter should in 

most cases ensure successful operation; changes in the parameter assignment will only 
be needed in rare cases.

● You need only change the parameter assignment of the TS Adapter if a modem connection 
is not established or if factory settings are to be adapted or optimized.

● TS Adapter parameter assignment can be changed via either a direct or a remote 
connection.

 

13.7.3.3 Access protection for dial-up connections

Access protection information

Introduction
When you assign the parameters for your TS adapter, you can restrict access to the parameters 
of the TS adapter and access to remote systems.

Scope of access protection
Access protection only exists for remote connections; TS adapter parameter assignment can 
be accessed at any time in direct connection mode.  

Access protection also exists in direct connection for the TS adapter IE.

Access protection information
The TS Adapter MPI is not delivered with access protection activated. There is a default 
password for the TS adapter IE.

The first user who assigns the parameters for this adapter can therefore activate access 
protection by defining the password for a user and/or a callback number.  

This is a multi-level access protection with several users, each with or without administrator 
rights. For the TS adapter MPI there is only one adminstrator and no more than two users.

For a modem connection, only an administrator can define the two users and change and, if 
necessary, delete their settings. Those logged in as users can only change their own 
passwords and their own callback numbers. However, with the TS adapter MP you can access 
the process of assigning parameters of the TS adapter in direct connection, without restriction.
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Advantages
Access protection offers the following advantages:  

● Unauthorized access by persons outside the system is almost impossible.

● The plant operator bears most of the telephone costs.

TeleService callback options

Callback variants
The costs of a telephone connection are normally borne by the caller who establishes the dial-
up connection.

TeleService can, however, be used so that after a short initial connection the modem 
connection is established again in the opposite direction, in other words initiated by the 
TS Adapter (callback). In this case, the plant operator bears the costs of the callback.

There are two callback variants in TeleService: 
1. Callback to a number specified during connection establishment.

2. Callback to a number stored on the TS Adapter.

Levels of protection

Introduction
You can set up one of two possible levels of access protection for TeleService access to the 
TS Adapter. Different options are available with each protection level.

Access protection options
Access protection level 1:

The TS Adapter  is protected by the user name and password. You can access the TS Adapter 
via any telephone line and specify any callback number during connection establishment.

Access protection level 2:

The TS Adapter is protected by the user name, password, and the callback number. You can 
only access the TS Adapter from one telephone connection per user.

The table below sets out the above conditions for the various protection levels:

Level of access 
protection

Administrator/User password Callback number

1 enter do not enter
2 enter enter
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Logging on to TS Adapter
When you log on to the TS Adapter and after you have set up access protection, enter your 
user name, the corresponding password and, if desired, a callback number:

Level of access 
protection

Administrator/User password Callback number

1 enter do not enter or enter any 
callback number

2 enter do not enter

 

If you have entered a callback number during connection establishment (access protection 
level 1) or stored a callback number in the TS Adapter (access protection level 2), the modem 
connection will be terminated and the TS Adapter will call back the given number.

 

Setting up access protection and callback number for the TS adapter

Introduction
During the parameter assignment for the TS adapter MPI in TeleService, you can set up access 
protection and a callback number for the parameter assignment of the adapter and connection 
to the remote system. The following describes the parameter assignment for a TS adapter 
MPI. The parameter assignment of a TS adapter IE is carried out in analog. The specific method 
is described in the web help of this adapter.  

Requirement 
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Accessible nodes".

Procedure
To set up access protection for the TS adapter, proceed as follows: 

1. Click on the command "Assign TS Adapter MPI parameters" in the project tree.

2. Open the "Access security" tab.

3. Enter a password for your user name and/or number that you want the modem to call back 
following logon.

– If you are an administrator, you can change all the settings for administrators and users, 
and delete or create users.

– If you are logged on as a user, you can only change your own settings (password and 
callback number).

4. Confirm all entries before exiting the dialog with "OK".

5. Click the "Yes" button to confirm the following query.
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Result
The parameter assignment for the access protection and the callback number is saved in the 
non-volatile memory of the TS adapter MPI.

 
 

 Note
Important points to note when setting up access protection:
● The settings in the "Modem" tab must correspond to the conditions at the plant if callback 

functionality is to be guaranteed.
● Entering an incorrect callback number in the role of "ADMIN" user will mean you are no 

longer able to access the TS Adapter MPI over a remote connection!
● Test the callback number before you enter it as the "ADMIN" user by calling the given 

callback number during connection establishment (access protection level 1).
 

 

Complete a callback in TeleService

Callback options
Two different callback variants can be set up in TeleService.

The following callback options are available:   

● Callback to a number specified during connection establishment.

● Callback to a number stored on the TS Adapter

Callback to a number specified during connection establishment   
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Click on the "TeleService" folder it contains.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. In the "Adapter type" drop-down list, select the adapter type used.

5. Select the "dial-up connection" under "Connection type" if it is not already selected.

6. Select the modem you are using under "Local Settings".

7. Enter the phone number to be dialed in the appropriate box or open the phone book by 
clicking on the button behind it and take the desired phone number from the phone book.

8. Enter your user name and associated password of the TS adapter.

9. If you want a "Connection setup with callback", select the appropriate option button.
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10.Click the "Connect" button to establish the required remote connection. This button only 
becomes active when you have entered all the parameters needed to establish a remote 
connection. Any remote connection is displayed under "Status".

11.Enter the desired callback number in the dialog that follows.

Result
The remote connection to the desired system is made with callback. 

The connected system is shown with the corresponding icon in the project tree.
 

 Note

This procedure is useful if the costs of the modem connection are to be borne by the plant 
operator and if the actual callback number is not fixed, i.e. callback is not always to the same 
receiver. It is particularly useful for mobile users.

 

Callback to a number stored on the TS Adapter 
1. Assign the parameters for the desired callback number in the TS adapter.

2. Establish a connection to the TS adapter as described above, and observe the following 
features:

– Enter the user name and password for which the callback number parameters are 
assigned in the TS adapter.

– The check box "Establish a connection with callback" does not have to be selected, 
since the callback number is already known by the TS adapter.

Result 
Callback to a number stored on the TS adapter has been established. If a remote connection 
is established, the callback occurs from the remote system. 

 

 Note

This procedure offers the highest level of access protection. However, it does pose a risk: if 
the callback number stored on the TS Adapter is not correct, it will no longer be possible to 
access the TS Adapter over a modem connection. The device can in such a case only be put 
back into operation by changing the parameter settings on site.
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13.7.3.4 TS adapter MPI

Short description of the TS adapter MPI

TS Adapter MPI:
The designation "TS Adapter MPI" is a collective term for allTS Adapter with an MPI/DP 
interface.   

The TS Adapter MPI comes in the following versions:

● As TS Adapter I (parameters cannot be assigned via the TIA Portal)

● as TS Adapter II

The table below provides a short description of the functionalities. For detailed information on 
your TS Adapter, please refer to the documentation supplied with your TS Adapter.

TS Adapter II:  
Direct connection Connection via the Universal Serial Bus (USB). The firmware can be 

replaced. 
The modem is integrated or can also be connected as external 
modem. The TS Adapter II switches automatically between the 
modems. As long as no external modem is connected, the adapter 
will use the internal modem.

There are two variants ● With internal analog modem. An external modem can also be 
connected to the RS232 port.

● With internal ISDN adapter. An external modem can also be 
connected to the RS232 port.

Use of the designation "TS Adapter"
For TeleService the designation "TS Adapter" is the generalization for all versions. The relevant 
product designation is listed beside information which only applies to a specific version of a 
TS Adapter, for example, "TS Adapter II", "TS Adapter IE Standard" or "TS Adapter IE Basic".  

How the TS adapter MPI works

How the TS Adapter MPI Works
In line with the configuration, the TS Adapter MPI connects the serial port or USB port of your 
programming device/personal computer (direct connection) or the serial port of a modem 
(modem connection) to the MPI/PROFIBUS network of your automation system.  

The TS Adapter MPI has a non-volatile memory. Parameters for the following functions are 
stored in this memory:

● The MPI/PROFIBUS network (network parameters)

● The mode of the modem used
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● The serial port to the modem

● Access protection

Default parameter assignment
The TS Adapter comes with default parameter assignment. The parameters can be set and 
saved to the non-volatile memory of the TS adapter in a parameter assignment session.  

When "Direct connection" is configured, the TS Adapter will only use the network parameters 
for access to the MPI/PROFIBUS network.

In the "Modem connection" configuration, all the parameters stored on the TS Adapter will be 
activated.

 

 Note

For more detailed information on the configuration of your TS Adapter, please refer to the 
documentation supplied with it.

 

Operating a TS adapter MPI in direct connection mode

Direct connection with TS Adapter MPI
The direct connection is used to assign the parameters of the TS Adapter MPI. The same 
configuration also allows you to go online in the TIA Portal and thereby check the configured 
MPI/PROFIBUS parameters for bus compatibility. This means that (as with a PC adapter) 
SIMATIC S7/C7 systems can be accessed via the MPI/DP interface without an MPI/
PROFIBUS module occupying a slot for a programming device/PC.   

Access protection for the TS Adapter is not active in direct connection configuration. This 
means that the parameter assignment of the TS Adapter can be changed without any 
problems, for example by importing adapter parameters. 

 
 

 Note
Display of the TS Adapter MPI in the TIA Portal

As soon as you have connected a TS Adapter MPI with the PG/PC using the USB port, the 
"TS Adapter" folder is displayed in the project tree of the TIA Portal. 

When you open the folder, you can assign the parameters of the connected TS Adapter MPI 
via the following dialog.

 

Establishing the direct connection for TS Adapter MPI
Direct connection mode means there is a direct connection via the TS Adapter MPI between 
the programming device/personal computer on which TeleService is installed and the 
automation system. No modem is required.   
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The figure below shows the configuration of the TS Adapter MPI with a direct connection.

 

Operating a TS adapter MPI in modem connection mode

Introduction to the modem connection with TS Adapter MPI
This configuration allows you to dial into a remote system. To do this, you establish a remote 
connection to a remote system using TeleService on a telephone network. Over the 
established modem connection, you can then work with the selected plant as usual with the 
TIA Portal.   

Establishing a modem connection with TS Adapter MPI
This connection between the programming device or PC on which TeleService is installed and 
the automation system in which the TS Adapter MPI is inserted in the MPI/DP interface is made 
through a modem route.   

The configuration therefore includes the programming device or PC via the telephone network 
and the TS Adapter MPI on the MPI/DP interface of the automation system.

The figure below shows the structure of the modem connection.
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 Note
Parallel operation between direct and modem connection

The TS Adapter II has two connections for communication with PG/PC, both of which can be 
connected at the same time. At the same time, connect the USB interface with the PG/PC 
and the modem interface with the telephone network.

In this configuration you can either use the direct or the modem connection.

A parallel operation is not possible!
 

TS adapter MPI configuration options

Useful information on configuring the TS Adapter MPI
The TS Adapter MPI can be configured in both direct connection mode and via an existing 
remote connection.  

The following parameter assignment options are available:

● Reconfiguration (Page 8115)

● Restoring default parameter assignment (Page 8116)

● Importing adapter parameters (Page 8118)

● Exporting adapter parameters (Page 8117)

● Setting up access protection (Page 8106)
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Parameter assignment
Configure your TS Adapter in accordance with the documentation supplied with the TS 
Adapter. It will detail the exact procedure for parameter assignment.

 

 Note
Please note the following when configuring the TS Adapter MPI
● If you change the current parameter settings when there is an established remote 

connection, there is a risk it will not subsequently be possible to establish a modem 
connection with the modified parameters. The TS Adapter MPI can in this case only be 
configured in direct connection mode.

● This means that either parameter assignment must be carried out with a programming 
device/personal computer at the plant location or the TS Adapter MPI must be brought to 
the location of the local programming device/personal computer in order to be configured.

 

Positive acknowledgement
During parameter assignment, the data is written to the non-volatile memory of the TS Adapter 
MPI. The parameter assignment process is not acknowledged positively until all precautions 
have been taken to ensure that parameter changes have been carried out correctly and will 
thus survive a power failure.

Changes become effective for the TS Adapter MPI as follows:
● The serial parameters, the modem parameters and the parameters for access protection 

are activated once the remote connection has been terminated.

● The modified network parameters are activated immediately.

Configuring TS adapter MPI

Introduction
The TS Adapter MPI  can be configured in both direct connection mode and via an existing 
remote connection in modem connection mode.   

The following describes the method for assigning parameters.

Requirement
A TS Adapter MPI  is connected to your computer and the folder "TS Adapter" is displayed in 
the project tree under "Online access".
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Procedure
To assign the parameters for the TS Adapter MPI im Direktanschluss  please proceed as 
follows:

1. Double-click the "Online access" folder in the project tree.

2. Open the required folder:

– The "TS Adapter" folder for a direct connection.

– For an existing remote connection, the "TeleService" folder followed by the folder with 
the required system name.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Set the required parameters in the individual tabs of the dialog.

5. Confirm your entries with "OK".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter MPI. 
Parameter assignment is then complete.

Restoring default parameter assignment for TS adapter MPI

Introduction
You can restore the default, factory state parameters of the TS Adapter MPI.

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
Proceed as follows to restore default parameters for the TS Adapter MPI:  

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Reset" button under "General".

5. Confirm your entries with "OK".
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Result
The TS Adapter MPI default parameters set on delivery are restored.

See also
TS adapter MPI configuration options (Page 8112)

Exporting adapter parameters

Introduction
You can export the configuration of a TS Adapter MPI to an external file. The configuration 
saved in this file can be imported in turn into any number of TS Adapter MPI.  

This can for example be useful if you want to assign identical parameters to 
multipleTS Adapter MPI or if you want save, document or distribute the parameter set. 

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
To export the adapter parameters of a TS Adapter MPI:

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Export" button.

5. A window will open in which you can select the file to which you wish to export the 
configuration of the TS Adapter MPI.

6. Confirm with "Save".

Result
The parameters of the TS Adapter MPI are saved in the specified file (*.tap). The export of the 
adapter parameters is now complete.
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Importing adapter parameters

Introduction
You can import the configuration of a TS Adapter MPI from a previously created export file 
(*.tap).  

The configuration saved in this file can be imported into any number of TS Adapter. This can 
for example be useful if you want to assign identical parameters to multiple TS Adapter MPI. 

You can import parameters locally in direct connection mode or via an existing remote 
connection in modem connection mode.

Requirement
A TS Adapter MPI is connected to your computer and is displayed in the project tree under 
"Online access" in the "TeleService" folder.

Procedure
To import the adapter parameters of a TS Adapter MPI:

1. Open the "TeleService" folder in project tree.

2. Double-click the "TS Adapter MPI" folder.

3. Select the command "Assign TS Adapter MPI parameters". The "Assign TS Adapter MPI 
parameters" dialog opens.

4. Click the "Import" button.

5. A dialog will open in which you can select the file to which you wish to import the 
configuration of the TS Adapter MPI.

6. Confirm the next dialog with "Yes".

Result
The parameters selected are saved in the non-volatile memory of the TS Adapter MPI. Adapter 
parameter import is then complete.

13.7.3.5 TS adapter IE

Short description of the TS adapter IE

TS Adapter IE
The designation "TS Adapter IE" is a collective term for allTS Adapter with an Ethernet port.   

The TS Adapter IE comes in the following versions:
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● as TS Adapter IE Standard

● as TS Adapter IE Basic

The tables below provide a short description of the functionalities. For detailed information on 
your TS Adapter, please refer to the documentation supplied with it.

TS Adapter IE Standard:
Direct connection by means of Industrial Ethernet (IE). Firmware update possible. Modem integrated 
or external. The TS Adapter IE cannot automatically switch between modems like the TS Adapter II. 
Parameters are assigned via a Web interface.
There are 2 variants:
● With internal analog modem. An external modem can also be connected to the RS232 port.
● With internal ISDN adapter. An external modem can also be connected to the RS232 port.

TS Adapter IE Basic:
Direct connection by means of Industrial Ethernet (IE). Firmware update possible. Plug-in modules. 
Parameters are assigned via a Web interface.
There are 4 variants:
● TS Adapter IE Basic MODEM:

Basic device TS Adapter IE Basic with TS Module MODEM for operation on the analog telephone 
network.

● TS Adapter IE Basic ISDN:
Basic device TS Adapter IE Basic with TS Module ISDN for operation on ISDN telephone systems.

● TS Adapter IE Basic GSM:
Basic device TS Adapter IE Basic with TS Module GSM for operation on the GSM radio network.

● TS Adapter IE Basic RS232:
Basic device TS Adapter IE Basic with TS Module RS232 for connecting an external modem.

Use of the designation "TS Adapter"
"TS Adapter" is used in the TeleService online help as a general designation for all versions. 
The relevant product designation is listed beside information which only applies to a specific 
version of a TS Adapter, e.g. "TS Adapter I", "TS Adapter II", "TS Adapter IE Standard" or 
"TS Adapter IE Basic".   

How the TS adapter IE works

How the TS Adapter IE works
The TS Adapter IE  connects the telephone network or the serial port of a modem with the 
Industrial Ethernet  of your automation system.  

The TS Adapter IE  has a non-volatile memory. Parameters for the following functions are 
stored in this memory:
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● The mode of the modem used

● The serial port to the modem

● Access protection

Default parameter assignment
The TS Adapter IE comes with default parameter assignment. The parameters can be set and 
saved to the non-volatile memory of the TS adapter in a parameter assignment session.  

 

 Note

For more detailed information on the configuration of your TS Adapter, please refer to the 
documentation supplied with it.

 

 

Connection Types

Connection types of the TS Adapter IE Basic
The following diagrams show the connection types possible with the TS Adapter IE Basic. 

Direct connection
In the direct connection to the PG/PC, you can set the TS Adapter IE Basic through Ethernet. 

 

 Note

The operation of the TS Adapter IE Basic  without a TS module is not permitted.
 

Figure 13-1 Direct connection
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Connection to the telephone network
In order to have a direct connection to the telephone network, you must connect the 
TS Adapter IE Basic together with one of the following TS modules:

● TS Module Modem

● TS Module ISDN

Figure 13-2 Direct connection to the telephone network

More information about the TS modules can be found in the TS Adapter modular manual.

Connection to the GSM network
In order to connect to the GSM network, you must operate the TS Adapter IE Basic together 
with this TS module:

● TS Module GSM

Figure 13-3 Connection to the GSM network

More information about the TS modules can be found in the TS Adapter modular manual. 
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Connection to the telephone network through an external modem
For the connection to an external modem, you must operate the TS Adapter IE Basic together 
with this module:

● TS Module RS232

Figure 13-4 Connection to an external modem

More information about the TS modules can be found in the TS Adapter modular manual. 

TS Adapter IE parameter assignment options

Useful information for configuring the TS Adapter IE
The TS Adapter IE is configured via a Web interface. 

Web help associated with the parameter assignment interface is made available for the 
configuring the TS Adapter IE.

The following parameter assignment options are available:

● Reconfiguration

● Restoring default parameter assignment

● Importing adapter parameters

● Exporting adapter parameters
 

 Note
Parameter assignment

Configure your TS Adapter in accordance with the documentation supplied with the TS 
Adapter. It will detail the exact procedure for parameter assignments.
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Parameter assignment for TS Adapter IE

Introduction
The TS Adapter IE  can be configured in both direct connection mode and via an existing 
remote connection in modem connection mode.   

Both parameter assignment options are described below. 

Specific details for assigning parameters of the TS Adapter IE can be obtained from the TS 
Adapter IE documentation.

Parameter assignment of the TS Adapter IE in direct connection
 

Requirement
There is a LAN connection to your TS Adapter IE . 

The TS Adapter IE Basic is connected to the power supply. 

Procedure
To assign the parameters for the TS Adapter IE , proceed as follows:

1. In the project tree of the TIA portal, open the "Online access" folder.

2. Double-click on the Ethernet port of your computer.

3. Double-click on the "Display accessible nodes" command. The TS Adapter IE is then 
displayed.

4. Double-click on the <TS Adapter IE> folder and then on "Online and diagnostic", and assign 
the desired IP address to the TS Adapter IE in the following dialogs. Please note that the 
IP address of the PG/PC interface card is located in the same subnet as the IP address 
that you issue for the TS Adapter IE.

5. Update the view in the project tree for the "Accessible nodes", so that the TS Adapter IE is 
displayed with the newly allocated IP address.

6. Open the folder <TS Adapter IE> in the device list.

7. Double-click the command "Assign TS Adapter IE parameters". The allocated web interface 
opens for assigning the TS Adapters IE parameters.

8. Complete the "logon" for the web interface.

9. Set the required parameters in the individual tabs of the dialog.

10.Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE. 
Parameter assignment is then complete.
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Parameter assignment of the TS Adapter IE using a remote connection
 

Requirement
There is an established remote connection to a TS Adapter IE .

Procedure
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Open the "TeleService" folder followed by the required system folder.

3. Double-click the command "Assign TS Adapter IE parameters". The associated web 
interface for assignment of the TS Adapter IE parameters opens. The "logon" for the web 
interface takes place automatically with the login data of the remote connection.

4. Set the required parameters in the individual tabs of the dialog.

5. Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE. 
Parameter assignment is then complete.

 

13.7.3.6 Establishing a dial-up connection to a remote system

Establishing a dial-up connection

Introduction to establishing a remote dial-up connection
A dial-up connection is established when you use TeleService to dial into a remote system via 
a telephone network. The programming device/personal computer is connected to the 
telephone network with TeleService via a modem. At the other end, the automation system is 
connected to the telephone line via a configured TS Adapter  and a modem.   

Requirements
A local modem is installed and configured.   

The TS Adapter is located in the remote system. 

A remote modem is installed and parameters have been assigned. 
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Proceed as follows:   
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Click on the "TeleService" folder it contains.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. In the "Adapter type" drop-down list, select the adapter type used.

5. Under "Connection type", select "Dial-up connection".

6. Select the modem you are using under "Local settings".

7. Enter the phone number to be dialed in the appropriate box or open the phone book by 
clicking on the button behind it and take the desired phone number from the phone book.

8. Enter your user name and the corresponding password.

9. If you want a "Connection setup with callback", select the appropriate option button.

10.Click the "Connect" button to establish the required remote connection. This button only 
becomes active when you have entered all the parameters needed to establish a remote 
connection. Any remote connection is displayed under "Status".

Result
The dial-up connection to the desired system is established. 

The dialog closes as soon as the dial-up connection is established. The following message 
appears in the TIA Portal status bar: "Remote connection is established". You can now use 
the remote connection with TIA Portal and communicate with the automation system. 

Connection cannot be established
If the connection cannot be established, try to find the cause using the "Notes on 
troubleshooting".   

Terminating the connection
Once you have finished editing the remote system, exit the remote connection in the project 
tree by double-clicking on the entry "Establish/disconnect remote connection". 

By exiting the TIA Portal you are also terminating the remote connection.   
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Terminating a dial-up connection

Terminating an active dial-up connection
 

 

 Note

Terminating the dial-up connection

You should go offline in the TIA Portal before you terminate the remote connection.
 

Proceed as follows:
1. Double-click the "Set up/close remote connection" entry in the TIA portal. 

2. Confirm the prompt in the dialog that follows with "Yes".

Result
The connection is terminated.

 

 

13.7.4 Remote VPN connections

13.7.4.1 Basics for establishing a VPN connection

Using a TS Adapter IE Advanced for VPN connections
A TS Adapter IE Advanced is required to establish a VPN connection using TeleService.   

 

VPN definition
VPN stands for "Virtual Private Network". This is a private network of computers based on a 
public network infrastructure.

VPN is used to create a connection that is as secure as possible between devices in a private 
network at different locations and the gateway of another network. 

A VPN device has direct access to the gateway in the other network over an encrypted 
connection.  
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VPN connections
When a VPN connection is established with TeleService, a CA certificate and a unique 
fingerprint generated from it are used for the unique identification of the TS Adapter IE 
Advanced. The VPN connection allows a communication that is secure from tapping and 
manipulation between the remote PC and the TS Adapter.  

If you want to establish a VPN connection to multiple remote networks, you will require a 
separate TS Adapter IE Advanced as an interface for each network. The networks connected 
by the TS Adapter can used identical IP addresses internally. Only the external IP addresses 
(WAN) of the TS Adapters need to be different. 

Only one VPN connection to a TS Adapter is possible at any one time.

 
 

 Note
Authentication

Please not that the CA certificate exclusively authenticates the TS Adapter IE Advanced.

As in the case of dial-up connections, users are authenticated via the login (user name and 
password).

Therefore, use only a secure password for the login.
 

See also
● Establishing VPN connections (Page 8132)

● Terminating VPN connections (Page 8134)

13.7.4.2 Basics of CA certificates

Introduction
To establish a secure VPN connection with TeleService, you need to generate a CA certificate 
with a unique fingerprint when you configure the TS Adapter IE Advanced. 

You can install this CA certificate as follows on each PC which is to access the TS Adapter IE 
Advanced:

● Using the automatic download in the TeleService connection dialog, by entering the 
fingerprint for the CA certificate

● Manually by using the Microsoft® Management Console.

Definition of CA certificate
A CA certificate is a digital certificate issued by a "certificate authority" or "certification 
authority", hereinafter referred to as "CA". In the case of the TS Adapter IE Advanced, self-
signed certificates are used; the certification authority in this case is the TS Adapter IE 
Advanced itself.
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Certificates for "SSTP" (Secure Socket Tunneling Protocol) and "HTTPS" (Hypertext Transfer 
Protocol Secure) are derived from the CA certificate. 

CA certificates contain a "key" and additional information used for authentication and for 
encrypting and decrypting confidential data. Additional information includes the validity period, 
references to certificate revocation lists, etc. which are included in the certificate by the CA.

 

Using CA certificates with TeleService
A CA certificate with a unique fingerprint is generated by the TS Adapter to uniquely identify 
the TS Adapter IE Advanced as connection partner for the remote PC.

This CA certificate must be saved in the Windows certificate store of your programming device/
PC before you can establish a VPN connection. When you access the Web server using a 
direct connection, a security warning will appear if no CA certificate exists. In such cases, 
however, you can choose to ignore the warning and allow the connection. 

 

 Note
Handling CA certificates

Specialist knowledge of the operating system is required for handling CA certificates. CA 
certificates should only be managed by trained personnel!

You require administrator rights to manage CA certificates.
 

Definition of fingerprint
The fingerprint is a 20-byte hexadecimal expression. It provides a unique value for a CA 
certificate and is used to identify a specific CA certificate.

A fingerprint is calculated dynamically using the SHA-1 algorithm and is not physically 
contained in the CA certificate. 

Use of fingerprints with TeleService
The CA certificate is used to uniquely identify the TS Adapter IE Advanced as connection 
partner. A unique 20-byte fingerprint of this certificate is generated each time a CA certificate 
is generated by the TS Adapter IE Advanced. It is calculated automatically by the TS Adapter 
IE Advanced when the certificate is generated. Each certificate has a specific, unique 
fingerprint. This fingerprint must be transferred securely to your computer, for example by 
phone or in an encrypted e-mail. You need to enter this fingerprint in the connection dialog 
when establishing a VPN connection with TeleService, unless the CA certificate is already 
saved on your PC in the Windows certificate store.

You will find the fingerprint for your TS Adapter IE Advanced in the Web interface for the TS 
Adapter IE Advanced. To open the Web interface, double-click the command "Assign TS 
Adapter IE Advanced parameters" in the device list in the TIA portal. Carry out the Web login 
to view the fingerprint in the "Security > Certificates" tab.
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CA certificate download during connection establishment
When the connection is established, TeleService checks whether a suitable CA certificate is 
installed in the Windows certificate store of your programming device/PC. If an appropriate 
certificate is found, the VPN connection is established as an SSTP connection (Secure Socket 
Tunneling Protocol).

If no appropriate CA certificate is found, the CA certificate is first loaded by the corresponding 
TS Adapter IE Advanced. The TS Adapter IE Advanced is called by the remote address entered 
in the connection dialog. If this download of the CA certificate is successful, the fingerprint of 
the downloaded CA certificate is calculated and compared with the fingerprint entered in the 
connection dialog. If the two fingerprints match, a dialog opens and you are prompted to save 
the CA certificate in the Windows certificate store of your programming device/PC. You require 
administrator rights to save the CA certificate.

The VPN connection is then established.

See also
● Installing CA certificates for VPN connections (Page 8129)

● Deleting CA certificates for VPN connections (Page 8132)

 

13.7.4.3 Installing CA certificates for VPN connections

Installing CA certificates
To establish a secure VPN connection between your programming device/PC and a remote 
system with TeleService, you require a valid CA certificate generated by the TS Adapter IE 
Advanced. This must be saved in the Windows certificate store of your programming device/
PC.

A CA certificate can be installed manually or using an automatic download.

CA certificates are managed with the Microsoft® Management Console. 

 
 

 Note
Handling CA certificates

Specialist knowledge of the operating system is required for handling CA certificates. CA 
certificates should only be managed by trained personnel!

You require administrator rights to manage CA certificates!
 

Requirement
A CA certificate has yet to be installed in the Windows certificate store on your computer.
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Installing CA certificates using the automatic download
Proceed as follows:

1. Log on to the system as administrator.

2. Transfer the fingerprint for the CA certificate from the TS Adapter IE Advanced to your 
computer using a "secure route", for example by phone or in an encrypted e-mail.
You will find the fingerprint for your TS Adapter IE Advanced in the Web interface for the 
TS Adapter IE Advanced. To open the Web interface, double-click the command "Assign 
TS Adapter IE parameters" in the device list in the TIA portal. Perform the Web login to 
view the fingerprint in the "Security > Certificates" tab. 

3. In the project tree of the TIA portal, open the "Online access" folder.

4. Click on the "TeleService" folder it contains.

5. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

6. Select the "TS Adapter IE Advanced" as Adapter type from the drop-down list.

7. Under "Connection type", select "VPN".

8. In the relevant input box, enter the IP address / DNS name for the TS Adapter IE Advanced 
to be contacted. Alternatively, you can apply any existing data from the phone book by 
clicking the corresponding button.

9. Enter your user name and the corresponding password.

10.Copy the fingerprint displayed in the Web interface for the TS Adapter IE Advanced to the 
"Fingerprint" column. 

11.Click the "Connect" button to establish the required remote connection. This button only 
becomes active when you have entered all the parameters needed to establish a remote 
connection.

12.No valid CA certificate is found, because no CA certificate has been installed on your PC 
yet. 
A "normal" connection (not a VPN connection) is therefore established and the certificate 
required is downloaded from the TS Adapter IE Advanced to the working memory of your 
computer. The fingerprint is then calculated (SHA-1 algorithm) and compared with the 
fingerprint entered in the connection dialog. If the two fingerprints match, a dialog opens 
and you are prompted to save the CA certificate in the Windows certificate store of your 
programming device/PC. 

13.Confirm that you want to save the CA certificate.

Result
The VPN connection to the required TS Adapter IE Advanced is established. The dialog closes 
once the connection is established.
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Manual installation of CA certificates
Proceed as follows:

1. Log on to the system as administrator.

2. Open the Windows Certificate Manager on your programming device/PC with the 
Microsoft® Management Console. 
Click "Start", enter "mmc" in the search field and press ENTER. 
The console will open.

3. Open the "File" menu and click "Add/remove snap-in...".
The "Add/remove snap-in..." dialog will open. 

4. Double-click "Certificates" in the "Snap-in" list and select "Computer account" in the dialog 
that opens.

5. Select "Local computer" in the next dialog and click "Finish" and "OK".
The console root opens and the "Certificates (local computer)" folder appears.

6. Open the displayed "Certificates (local computer)" folder and click "Trusted certification 
authorities".

7. Click the "Certificates " folder and use the shortcut menu to access the command "All tasks" 
> "Import...".

8. Note the information that appears in the "Certificate - Import wizard" dialog and click "Next".

9. In the dialog that follows, click "Browse ..." and select the required CA certificate.

10.Then click "Next" twice and subsequently "Finish" to install the CA certificate.

Result
The selected CA certificate is installed at the specified location in the Windows certificate 
memory.

 
 

 Note
Additional information ...

... on installing CA certificates can be found using the "F1" button in the online help of your 
operating system.
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13.7.4.4 Deleting CA certificates for VPN connections

Deleting CA certificates
Proceed as follows:

1. Log on to the system as administrator.

2. Open the Windows Certificate Manager on your programming device/PC with the 
Microsoft® Management Console. 
Click "Start", enter "mmc" in the search field and press the ENTER KEY. 
The console will open.

3. Open the "File" menu and click "Add/remove snap-in...". 
The snap-in selection dialog will open. 

4. Double-click "Certificates" in the "Snap-in" list and select "Computer account" in the dialog 
that opens.

5. Select "Local computer" in the next dialog and click "Finish" and "OK".
The console root opens and the "Certificates (local computer)" folder appears.

6. Open the displayed "Certificates (local computer)" folder and click "Trusted certification 
authorities".

7. Open the "Certificates" folder, select the required CA certificate and click "Delete" in the 
shortcut menu.

8. Confirm the next prompt with "Yes".

Result
The selected CA certificate is deleted from the list of available certificates.

13.7.4.5 Establishing a VPN connection to a remote system

Establishing VPN connections

Introduction to establishing VPN connections
A VPN connection is established when you use TeleService to connect to a remove system 
over the Internet. 

To do this, your programming device/PC with installed TIA Portal is connected to the Internet 
at one end. At the other end, the automation system is connected to the Internet via the WAN 
(Wide Area Network) interface of the configured TS Adapter IE Advanced.  

Requirement
Your programming device/PC is connected to the Internet.   

There is a TS Adapter IE Advanced in the remote system.
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The TS Adapter IE Advanced has been configured and is connected to the Internet. 

The CA certificate required for identifying the TS Adapter has been generated and installed in 
the Windows certificate store of your programming device/PC.

Proceed as follows:
1. In the project tree of the TIA portal, open the "Online access" folder.

2. Click on the "TeleService" folder it contains.

3. Double-click the "Set up/close remote connection" entry. The "Set up remote connection 
to the remote system" dialog opens.

4. Select the "TS Adapter IE Advanced" as "Adapter type" from the drop-down list. 

5. Enter "VPN" as "connection type".

6. Enter the IP address / DNS name for the TS Adapter IE Advanced to be contacted in the 
relevant field. Alternatively, you can apply any existing data from the phone book by clicking 
the corresponding button.

7. Enter your user name and the corresponding password.

8. Click the "Establish" button to establish the required VPN connection. This button only 
becomes active once you have entered all the parameters needed for establishing the 
remote connection. 

Result
The VPN connection to the required system is established. "Status" indicates the progress in 
establishing the connection. The dialog closes once the VPN connection is established. The 
following message appears in the TIA Portal status bar: "Remote connection is established". 
You can now use the remote connection with TIA Portal and communicate with the automation 
system.

 

Connection cannot be established
If the connection cannot be established, try to find the cause using the "Notes on 
troubleshooting".

 
 

 Note
Rules for IP addresses
● Only use IP addresses which have not yet been assigned in the system network. 
● If the IP address configured for the TS Adapter IE Advanced has already been assigned 

in the system network, the TS Adapter IE Advanced can only be addressed by its MAC 
address.
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See also
Installing CA certificates for VPN connections (Page 8127)

Terminating VPN connections

Terminating an active VPN connection
 

 

 Note
Terminating the VPN connection

You should go offline in the TIA portal before you terminate the VPN connection.
 

Proceed as follows:
1. Double-click the "Set up/close remote connection" entry in the TIA portal. 

2. Confirm the prompt in the dialog that follows with "Yes".

Result
The VPN connection is terminated. 

 

13.7.4.6 TS Adapter IE Advanced

Short description of the TS Adapter IE Advanced

TS Adapter IE Advanced
The TS Adapter IE Advanced has the following properties:

● Direct connection over Industrial Ethernet (IE), 2 ports

● WAN (Wide Area Network) interface for VPN connections

● Firmware update supported

● Plug-in modules

● Parameters are assigned via a Web interface.
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 Note
Further information on the TS Adapter IE Advanced

For detailed information on your TS Adapter, please refer to the documentation supplied with 
your TS Adapter.

 

Connection types

TS Adapter IE Advanced connection types
The following diagrams show the types of connection possible with the 
TS Adapter IE Advanced.

Direct connection
In the direct connection to the programming device/PC, you can set the 
TS Adapter IE Advanced parameters over the Ethernet.

Figure 13-5 TS Adapter IE Advanced - direct connection
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Connection to the Internet (DSL modem/router)
In order to connect to the Internet, you must operate the DSL modem/router at the WAN 
connection of the TS Adapter IE Advanced.

Figure 13-6 TS Adapter IE Advanced - connection to the Internet

Connection to the company network (Intranet)
In order to connect to the Intranet, you must operate system network (Ethernet) at one of the 
two LAN connections of the TS Adapter IE Advanced.

Figure 13-7 TS Adapter IE Advanced - connection to company network (Intranet)

Additional information
For more detailed information on the TS modules, please refer to the documentation supplied 
with your TS Adapter IE Advanced.

TS Adapter IE Advanced parameter assignment options

Basics on configuring the TS Adapter IE
The TS Adapter IE Advanced is configured via a Web interface. 

Web help in the Web interface is available for assigning TS Adapter IE Advanced parameters.

Parameter assignment options include:
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● Reconfiguration

● Restoring default parameter assignment

● Importing adapter parameters

● Exporting adapter parameters
 

 Note
Parameter assignment

Configure your TS Adapter IE Advanced in accordance with the documentation supplied. 
This details the exact procedure for parameter assignment.

 

Parameter assignment for TS Adapter IE Advanced

Introduction
The TS Adapter IE Advanced  can be configured in both direct connection mode and via an 
existing remote connection.   

Both parameter assignment options are described below. 

Specific details on assigning parameters for the TS Adapter IE Advanced are available in the 
TS Adapter IE Advanced documentation.

Assigning parameters for the TS Adapter IE Advanced in direct connection
 

Requirement
There is a LAN connection to your TS Adapter IE Advanced. 

Procedure
To assign the parameters for the TS Adapter IE Advanced, proceed as follows:

1. In the project tree of the TIA portal, open the "Online access" folder.

2. Double-click on the Ethernet port of your computer.

3. Double-click on the "Display accessible nodes" command. The TS Adapter IE Advanced 
is then displayed.

4. Double-click on the "TS Adapter IE Advanced" folder and then on "Online and diagnostics", 
and assign the desired IP address to the TS Adapter in the dialogs that follow. Please note 
that the IP address of the programming device/PC interface card must be located in the 
same subnet as the IP address that you assign for the TS Adapter IE Advanced.

5. Update the view in the project tree for the "Accessible nodes", so that the TS Adapter IE 
Advanced is displayed with the newly assigned IP address.
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6. Open the folder "TS Adapter IE Advanced" in the device list.

7. Double-click the command "Assign TS Adapter IE parameters". The corresponding Web 
interface opens for assigning TS Adapter IE Advanced parameters.

8. Complete the "logon" for the web interface.

9. Set the required parameters in the individual tabs of the dialog.

10.Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE 
Advanced. Parameter assignment is then complete.

Assigning parameters for the TS Adapter IE Advanced using a remote connection
 

Requirement
There is an established remote connection to a TS Adapter IE Advanced..

Procedure
1. In the project tree of the TIA Portal, open the "Online access" folder.

2. Open the "TeleService" folder followed by the required plant folder.

3. Double-click the command "Assign TS Adapter IE parameters". The associated web 
interface for assignment of the TS Adapter IE parameters opens. The "logon" for the web 
interface takes place automatically with the login data of the remote connection.

4. Set the required parameters in the individual tabs of the dialog.

5. Confirm your entries with "Save settings".

Result
The configured parameters are saved in the non-volatile memory of the TS Adapter IE 
Advanced. Parameter assignment is then complete.

 

Using online and diagnostics functions
13.7 Establishing a remote connection with TeleService

WinCC Professional V13.0
8136 System Manual, 02/2014



13.7.5 CPU controlled TeleService remote connections 

13.7.5.1 Overview of CPU controlled remote connections

Introduction
TeleService offers a range of options for establishing remote connections; these differ 
according to the CPU used. The initiative for establishing a connection starts from the CPU. 
The communications instructions given below are used for the individual connection options.

Connection establishment with S7-300/400 CPUs
The following communications instructions are available:   

● Communications instruction "PG_DIAL": Establish remote connection to programming 
device/PC

● Communications instruction "SMS_SEND": Send text message (SMS)

● Communications instruction "AS_DIAL": Establish remote connection to AS

● Communications instruction "AS_MAIL": Transfer email

Connection establishment with S7-1200 CPUs
The following communications instruction is available:   

● Communications instruction "TM_MAIL": Transfer email

Connection establishment with S7-1500 CPUs
The following communications instruction is available:   

● Communications instruction "TMAIL_C": Transfer email
 

 Note
Description of individual communications instructions

More detailed information on the available communications instructions can be found in the 
information system of the TIA Portal in the directory "References > Communication > 
TeleService".

 

 

See also
TS Adapter IE parameter assignment options (Page 8120)
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13.7.5.2 Establishing a connection from and to remote systens (PG-AS-remote coupling)

Remote plant access to a programming device/personal computer

Introduction
You can establish a remote connection to and communicate with a remote system using the 
application TeleService and a TS Adapter MPI. The initiative for establishing the remote 
connection comes from the programming device/personal computer. 

However, events which require rapid intervention often occur at a remote system. In such 
cases, the automation system can initiate a remote connection to a programming device/
personal computer if an asynchronous event occurs.

The graphic below shows the components which are required for establishing a connection 
from a plant to a programming device/personal computer.

Figure 13-8 How the "PG_DIAL" communications instruction works

Requirements for establishing a connection

Introduction
Certain hardware and software requirements must be fulfilled if a remote system is to establish 
a remote connection to a programming device/personal computer. These requirements are 
detailed below.  

Hardware requirements:
The only hardware required for establishing a remote connection from a remote system to a 
programming device/personal computer is that needed for accessing the remote system from 
the programming device/personal computer.  
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Your user program calls the communication instruction "PG_DIAL"  to establish the connection. 
This can only be executed on an S7-300 or S7-400 CPU on which S7 basic communication is 
implemented.  

A TS Adapter I , version 5.0 or later, or a TS Adapter II  must be used.

Software requirements at the plant end:
Communication instruction "PG_DIAL" is included in the TeleService scope of delivery and is 
installed when the TIA portal is installed. You will find the communication instructions installed 
in the "Communication > TeleService" folder of the block editor task card.  

If a remote system is to establish a remote connection to a programming device/personal 
computer, the plant user program must call the "PG_DIAL" function block. 

Software requirements for the programming device/personal computer
You require a software product in the programming device/personal computer which, with 
TeleService, waits for a call from a remote system, recognizes this call and informs your user 
program.  

13.7.5.3 Data exchange between remote systems (AS-AS-remote coupling)

AS-AS remote link basics

Introduction
The AS-AS remote link allows two automation systems to exchange process data via the 
telephone network.

Requirement
Communication instruction "AS_DIAL"  is available if you use a CPU from the S7-300/400 
family.  

Definition: Local and remote automation system   
● The automation system from which the initiative to establish the remote connection 

originates is described as local.

● The automation system to which the remote connection is to be established is described 
as remote.

Data exchange over the AS-AS remote link
Data exchange is carried out using specific communication instructions for non-configured S7 
connections. Use the communication instruction "AS_DIAL" to establish a remote connection 
to the automation system. 
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More detailed information on establishing the connection can be found in the information 
system in the directory "References > Communication > TeleService".

The following graphic shows the components required for establishing a connection from a 
local to a remote automation system.

Figure 13-9 Data exchange over the AS-AS remote link

Hardware and software requirements for AS-AS remote link

Introduction
Certain hardware and software requirements must be fulfilled before a local automation system 
can establish a remote connection to a remote automation system. These requirements are 
detailed below.  

Hardware requirements
The only hardware you need for transferring process data from a local to a remote automation 
system is that also needed for accessing the respective automation system from the 
programming device/personal computer.  

To establish and terminate the remote connection, the TIA Portal user program of the local 
CPU calls a communication instruction. This communication instruction can be executed on 
an S7-300/400 CPU or a C7 CPU. The communication instruction requires S7 basic 
communication to be implemented on the CPU. The remote CPU must also support S7 basic 
communication.

A TS Adapter I, version V5.1 or later, or a TS Adapter II must be used.
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Software requirements
The "AS_DIAL" communication instruction is included in the product package of TeleService, 
and is integrated into the library of the TIA Portal during the installation in the communication 
instructions folder of the Task Card under TeleService. In order to establish and terminate a 
remote connection to a remote automation system from a local automation system, call the 
communication instruction "AS_DIAL" in the TIA Portal user program of the local CPU.  

Figure 13-10 Hardware and software requirements for AS-AS remote link

13.7.5.4 Send SMS from a system

Requirements for sending an SMS

Introduction
Certain hardware and software requirements must be fulfilled before a system can send an 
SMS. These requirements are detailed below.     

Hardware requirements 
To send an SMS from a system, you will require a GSM wireless modem and a 
TS Adapter MPI.   

A TS Adapter I, version V5.2 or later, or a TS Adapter II  must be used.
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Software requirements at the system end
The "SMS_SEND" communications instruction is included in the scope of delivery of 
TeleService, and is integrated into the library of the TIA Portal during the installation in the 
communications instructions folder of the Task Card under TeleService. If a system is to send 
an SMS, the user program of the system must call the communications 
instruction "SMS_SEND".   

Figure 13-11 How the "SMS_SEND" communications instruction works

 
 

 Note

You may be able to send an SMS not only to a cell phone but also to an email address or a 
fax device by using additional services offered by the cell phone service provider.

 

13.7.5.5 Send an email from a system

Requirements for sending e-mails

Introduction
The following hardware and software requirements must be fulfilled if a system is to send an 
email:     
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Hardware requirements
You need a TS Adapter IE to send an email from a system and one of the CPUs listed below:  

● a CPU 31x2 PN/DP as of firmware version V2.5

● a CPU 41x-3 PN/DP

● a CPU of the S7-1200 series

● a CPU of the S7-1500 series

Software requirements at the system end
Different communications instructions are included in the scope of delivery of TeleService 
depending on the CPU that are integrated into the library of the TIA Portal during the installation 
in the communications instructions folder of the Task Card under TeleService.   

If a system is to send an email, the user program of the system must call the corresponding 
communications instruction for the CPU. 

The following communications instructions are available for sending an email:

● S7-300/400 CPUs: use the communications instruction "AS_MAIL": Transfer email

● S7-1200 CPU V 2.0 and V 3.0: use the communications instruction "TM_MAIL": Transfer 
email

● S7-1200 CPU >V3.0: use the communications instruction "TMAIL_C": Transfer email

● S7-1500 CPUs: use the communications instruction "TMAIL_C": Transfer email

The respective communications instruction transfers an email from a CPU to a mail server by 
means of the Simple Mail Transfer Protocol (SMTP) with the "LOGIN" authentication method. 
The data is transferred unencrypted with this SMTP process.

The figure below shows an example with the communications instruction "AS_MAIL":
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The "Use gateway/router" property must also be set for the Ethernet interface in the 
configuration of the CPU on which the communications instruction "AS_MAIL" runs. (available 
in the device configuration under Ethernet addresses and there under IP protocol)The IP 
address of the Ethernet interface of the TS Adapter IE is to be specified as "Address".

 
 

 Note

You can find further information in the task card in the "Communications instructions" folder 
under TeleService.
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13.7.6 Notes on troubleshooting

13.7.6.1 General information on troubleshooting for modem problems

Introduction
The information below should help you establish and eliminate the causes of any modem 
problems.  

1. Enable "Record log file" for data traffic between PG/PC and modem. The entries in this file 
can provide valuable information for determining the cause of errors.

2. Switch on the loudspeaker on your local modem. Select a volume loud enough to be clearly 
heard.
You can then hear whether:

– there is a dial tone at the connection

– the modem called is busy

– the modem called accepts the call.

Common modem problems
Modem connection problems are among the most common modem problems:  

● Modem connection is not established

● Modem connection is interrupted

The topics below contain tables detailing possible causes and providing information on 
eliminating the error in question.

See also
Dial-up connection to the TS Adapter is not established (Page 8148)

Dial-up connection from the TS Adapter is not established (Page 8149)

Modem connection is interrupted (Page 8150)

Modem alarms (Page 8151)

Recording a log file for the modem (Page 8147)

13.7.6.2 Recording a log file for the modem

Introduction
It is advisable to record a log file as this makes it easier to find the causes of faults in a modem.

Using online and diagnostics functions
13.7 Establishing a remote connection with TeleService

WinCC Professional V13.0
System Manual, 02/2014 8145



Procedure:
Proceed as follows:

1. Activate the properties dialog of the modem used via the "Phone and modem options" option 
in the Control Panel.

2. Check the settings of the "Log" option in the "Diagnostics" tab and if necessary change the 
log file settings so that the file is recorded.

Result:
Activity between the programming device/personal computer and the modem are entered in 
the log file. If there are problems establishing the connection, you can evaluate the data 
recorded in the log file to determine the cause of the error.

13.7.6.3 Dial-up connection to the TS Adapter is not established

Dial-up connection to TS Adapter is not established
The table below sets out possible causes and how to eliminate them if no remote connection 
to the TS Adapter can be established.   

Possible cause Check/Remedy
Cabling faulty ● Are all the connecting cables connected correctly?

● Are the connectors loose?
Dial parameters for main telephone 
line and extension incorrectly set

● Do the properties and dial parameters of your modem match the phone connection 
to main phone line or extension?

● Do not specify a dial-out code in the "Dial parameters" dialog if you operate your 
modem on a local loop (main telephone line).
The fields for the dial-out code for local calls and long-distance calls must be empty.

Dialing mode incorrectly set ● Is the correct dialing mode (tone/pulse) set in the dialog for the dial parameters of 
your modem?

● Use a connected telephone to check the connection on which you want to operate 
the modem. 
You should hear crackling noises on the telephone during pulse dialing and tones 
of varying pitches during tone dialing. 
Set the corresponding dialing mode in the modem dial parameters.
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Possible cause Check/Remedy
Dial disable active ● The dial disable function is a country-specific modem property which, depending 

on the modem, becomes effective after one or more unsuccessful attempts to 
establish a connection.

● If your modem still does not respond after several attempts to dial, the dial disable 
function may be active. Characters are still sent to the modem after the dial 
command but the modem does not start the dialing process. The driver receives a 
general error message.

● Refer to the modem documentation for information on how the dial disable function 
is implemented for your modem.

● Create a log file (Page 8145) (modemlog.txt) in which the activities between the 
programming device/personal computer and modem are recorded.
Then check whether the file contains an entry caused by dial disable (e.g. 
DELAYED).

Phone connection defective or busy ● Connect a phone and check whether a dial tone can be heard on this connection.
● Any analog phone connected on the same connection must be hung up. 

You cannot establish an additional modem connection on this connection if there 
is an existing phone connection.

Serial parameters set incorrectly ● Are the correct values entered in the "Settings" tab for modem properties (8 data 
bits, no parity, 1 stop bit)?
Is the correct COM interface set in the "General" tab for the modem properties?

Initialization string of the 
TS Adapter is not suitable for the 
modem.

● Familiarize yourself with the modem initialization string requirements and set the 
string accordingly.
Procedure for configuring the TS Adapter IE (Page 8117) 

Settings for error correction 
between the modem at the 
TS Adapter and the modem at the 
PC/programming device are not 
compatible.

● Adapt the modem settings.
Useful information on configuring the TS Adapter MPI (Page 8112) 
Restoring the default parameter assignment of a TS Adapter MPI (Page 8114) 
Procedure for configuring the TS Adapter IE (Page 8113) 

13.7.6.4 Dial-up connection from the TS Adapter is not established

No callback from TS Adapter
The table below sets out possible causes and how to eliminate them if there is no callback 
from the TS Adapter.

Possible cause Check/Remedy
Errors in the location or call 
settings in the TS Adapter 

Check the TS Adapter parameter assignment:
● Are the dialing mode and dial-out code set correctly for your phone connection?
● Does the modem at the TS Adapter  support the characters configured for the dial-

out code?
● Is "Wait for dial tone before dialing" deactivated for an extension?

Initialization of modem 
insufficient

Check the string for modem initialization:
● The modem may require a further initialization in order to establish a remote 

connection.
● Properties of the modem initialization string for the TS Adapter MPI 

Callback number is incorrect Check the configuration of the callback number you assigned.
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No call from TS Adapter MPI
The table below sets out possible causes and and how to remedy them if there is no call from 
the TS Adapter MPI.

Possible cause Check/Remedy
Phone number is incorrect Is the required number being transferred to the communication instruction "PG_DIAL" ?
TS Adapter MPI  parameter 
assignment incorrect

Check the TS Adapter MPI parameter assignment:
● Are the dialing mode and dial-out code set correctly for your phone connection?
● Does the modem at the TS Adapter MPI support the characters configured for the 

dial-out code?
● Is "Wait for dial tone before dialing" deactivated for an extension?

13.7.6.5 Modem connection is interrupted

Modem connection is interrupted
The table below sets out possible causes and and how to remedy them if the modem 
connection is interrupted.     

Possible cause: Check / Remedy:
Metering pulses in the line Metering pulses will be generated if you have applied to the phone company for a 

metering clock. This may mean that the modem no longer recognizes the carrier signal 
and switches off.
● Set a longer waiting or switch-off time at the modem.
● Have the metering pulse deactivated by the phone company.

Shielding ● Are the connection cables used shielded sufficiently?
● Make sure that the modem cables do not run next to power cables and that they 

are as far as possible from power supply units and monitors.
Protocol timeout ● Set fixed monitoring times.
Automatic connection termination ● Deactivate the option that terminates an existing connection automatically after a 

specified time without data transfer ("Terminate after idle of ...").
Data flow control deactivated ● Click on the "Extended" button in the "Settings" tab of the modem properties and 

activate the following options in the dialog displayed (if available and not yet set):
– Data flow control
– Hardware (RTS/CTS)
– Data compression
– Error control

Initialization string of the 
TS Adapter  is not suitable for the 
modem

● Set the modem initialization string in accordance with the following requirements.
See also: TS Adapter IE parameter assignment options (Page 8120) 

See also
TS adapter MPI configuration options (Page 8112)
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13.7.6.6 Checklist for troubleshooting the modem

Introduction
The following list should help you establish the potential cause of any problems with the 
modem. The help topics below set out how and in which dialogs you define the relevant 
settings.  

Modem connection cannot be established:
● Check the cabling and the connections. 

● Check whether the correct dialing mode (tone/pulse) is set. 

● If your modem does not react after several attempts to dial, a dial disable function may be 
active. Familiarize yourself with dial disable on your modem.

● Are you operating your modem on a main telephone line or on an extension line? Configure 
the properties and dialing parameters of the modem accordingly.

● Enable the log file option in the advanced properties. The next attempt to establish a 
connection will then be recorded in a file in the Windows directory.

● Ensure that the ISDN TAs used work with the same B and D channel protocol.

The modem connection is terminated:
● Metering pulses can have a negative affect on a connection. Have the pulses deactivated 

by your telephone company. 

● Set fixed monitoring times.

● Deactivate the option that terminates an existing connection automatically after a specified 
time without data transfer (idle).

● Make sure that you have activated RTS/CTS for data flow control.

13.7.6.7 Modem alarms

Information in the log file 
The modem alarms are entered in a log file if you have activated the recording function.  

The log file contains the following information:

Alarm: Possible cause: Remedy:
NO DIALTONE A phone call may currently be being carried out 

on this line.
● Repeat the process once the phone call is over.

NO CARRIER The device dialed is not ready, is not a modem 
or cannot establish a connection in the set 
operating mode.

● Check the numbers and the settings.
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Alarm: Possible cause: Remedy:
BUSY The device dialed is busy. ● Try again later.
DELAYED: ... Dial disable ● Refer to the modem documentation for 

information on how the dial disable function is 
implemented for your modem and if necessary 
remove it.

13.7.6.8 Possible error messages with VPN connections

VPN connection to TS Adapter IE Advanced is not established
The table below sets out possible errors and how to eliminate them if no VPN connection to 
the TS Adapter IE Advanced can be established.   

Possible errors Check/Remedy
The error message "The webpage 
cannot be displayed" appears when 
the Web interface is accessed.

● Note: This problem occurs when the Windows certificate store contains a CA 
certificate with the same name as the CA certificate which has just been generated.

● If a CA certificate for this TS Adapter is already installed in the Windows certificate 
store and you have generated a new CA certificate on the TS Adapter, you need 
to remove the old CA certificate from the Windows certificate store and install the 
newly generated CA certificate. 

● See also: Installing CA certificates for VPN connections (Page 8127)
● See also: Deleting CA certificates for VPN connections (Page 8130)

Error message: "Unexpected error 
in application".

● Check whether other users have been saved in the TS Adapter IE Advanced user 
database. 

● The user "Administrator" cannot establish a remote connection.
Error message: "No corresponding 
CA certificate was found in the 
Windows certificate store".

● Use the automatic certificate download. Enter the fingerprint in the corresponding 
field in the connection dialog.

● See also: Establishing VPN connections (Page 8130)
Or

● Export the CA certificate from the Web interface of the TS Adapter IE Advanced 
and install it manually in the Windows certificate store.

● See also: Installing CA certificates for VPN connections (Page 8127)
Error message: "The remote 
address specified does not 
correspond to the remote address 
of the TS Adapter".

● You must use the remote address which you specified in the TS Adapter IE 
Advanced to establish the connection. 

● You cannot use the IP address if you have entered the DNS name (and vice versa).

Error message: "The signature of 
the certificate could not be verified".

● If you have generated a new CA certificate on the TS Adapter IE Advanced, you 
need to delete the old CA certificate from the Windows certificate store and install 
the new one. 

● See also: Deleting CA certificates for VPN connections (Page 8130)
● See also: Installing CA certificates for VPN connections (Page 8127)

Error message: "Protocol error" ● Check to make sure that the IP address of the service PC is set in the configuration 
of the TS Adapter IE Advanced (Parameter > Plant Network)
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Possible errors Check/Remedy
Error message: "Connection setup 
error."

● Check to make sure that the LAN IP-address of the TS Adapter IE Advanced and 
the IP address of your network cards are in the same subnet. If this is the case, 
deactivate this network card before you establish the remote connection. 

An e-mail cannot be sent. ● Check whether there is a network/Internet connection at the WAN port.
● Check whether the mail server is accessible.
● Check whether the outgoing connections in the TS Adapter IE Advanced are valid.
● Check whether the SMTP port in the firewall is open for outgoing connections.
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Hardware documentation 14
14.1 General information on the hardware documentation

Additional information on the available hardware   
The TIA Portal can be used to configure a wide variety of hardware, depending on the installed 
products. You can find the available hardware in the hardware catalog. You can find all the 
current manuals, operating instructions and FAQs as well as updates for your devices in the 
Siemens Industry Online Support (https://support.automation.siemens.com/).

To help you locate the appropriate documents for your hardware in the Siemens Industry 
Online Support, the following sections list all modules and module families that are available 
in the current scope of the installation of the TIA Portal. You will find a link for each module 
that takes you directly to the relevant manuals and operating instructions in the Siemens 
Industry Online Support.

14.2 PLC

14.2.1 SIMATIC S7-1200

14.2.1.1 CPU

CPU 1211C (6ES7 211-1xxx-0XB0)
Information on the CPUs is available here:

● CPU 1211C AC/DC/Rly (6ES7 211-1BD30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111BD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C AC/DC/Rly (6ES7 211-1BE31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111BE310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C AC/DC/Rly (6ES7 211-1BE40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111BE400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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● CPU 1211C DC/DC/DC (6ES7 211-1AD30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111AD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C DC/DC/DC (6ES7 211-1AE31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111AE310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C DC/DC/DC (6ES7 211-1AE40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111AE400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C DC/DC/Rly (6ES7 211-1HD30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111HD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C DC/DC/Rly (6ES7 211-1HE31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111HE310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1211C DC/DC/Rly (6ES7 211-1HE40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72111HE400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

CPU 1212C (6ES7 212-1xxx-0XB0)
Information on the CPUs is available here:

● CPU 1212C AC/DC/Rly (6ES7 212-1BD30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121BD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C AC/DC/Rly (6ES7 212-1BE31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121BE310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C AC/DC/Rly (6ES7 212-1BE40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121BE400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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● CPU 1212C DC/DC/DC (6ES7 212-1AD30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121AD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C DC/DC/DC (6ES7 212-1AE31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121AE310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C DC/DC/DC (6ES7 212-1AE40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121AE400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C DC/DC/Rly (6ES7 212-1HD30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121HD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C DC/DC/Rly (6ES7 212-1HE31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121HE310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1212C DC/DC/Rly (6ES7 212-1HE40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72121HE400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

CPU 1214C (6ES7 214-1xxx-0XB0)
Information on the CPUs is available here:

● CPU 1214C AC/DC/Rly (6ES7 214-1BE30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141BE300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1214C AC/DC/Rly (6ES7 214-1BG31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141BG310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1214C AC/DC/Rly (6ES7 214-1BG40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141BG400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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● CPU 1214C DC/DC/DC (6ES7 214-1AE30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141AE300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1214C DC/DC/DC (6ES7 214-1AG31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141AG310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1214C DC/DC/DC (6ES7 214-1AG40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141AG400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1214C DC/DC/Rly (6ES7 214-1HE30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141HE300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1214C DC/DC/Rly (6ES7 214-1HG31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141HG310XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

● CPU 1214C DC/DC/Rly (6ES7 214-1HG40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72141HG400XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

CPU 1215C (6ES7 215-1xxx-0XB0)
Information on the CPUs is available here:

● CPU 1215C DC/DC/DC (6ES7 215-1BG31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151BG310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1215C DC/DC/DC (6ES7 215-1BG40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151BG400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1215C AC/DC/Rly (6ES7 215-1AG31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151AG310XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

Hardware documentation
14.2 PLC

WinCC Professional V13.0
8156 System Manual, 02/2014

http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141AG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HE300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72141HG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151BG400XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72151AG310XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view


● CPU 1215C AC/DC/Rly (6ES7 215-1AG40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151AG400XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● CPU 1215C DC/DC/Rly (6ES7 215-1HG31-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151HG310XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

● CPU 1215C DC/DC/Rly (6ES7 215-1HG40-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72151HG400XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

CPU 1217C (6ES7 217-1xxx-0XB0)
Information on the 1217C DC/DC/DC CPU is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72171AG400XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

14.2.1.2 Signal boards

Signal boards (6ES7 2xx-xxx30-0XB0)
Information on signal boards for S7-1200 is available here:

● DI 4x24VDC (6ES7 221-3BD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72233BD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● DI 4x5VDC (6ES7 221-3AD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72213AD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 4x24VDC (6ES7 222-1BD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221BD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● DQ 4x5VDC (6ES7 222-1AD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221AD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))
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● DI 2/DQ 2x24VDC (6ES7 223-0BD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72230BD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● DI 2/DQ 2x24VDC (6ES7 223-3BD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72213BD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 2/DQ 2x5VDC (6ES7 223-3AD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72233AD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● AI 1x12BIT (6ES7 231-4HA30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72314HA300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● AI 1xRTD (6ES7 231-5PA30-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315PA300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● AI 1xTC (6ES7 231-5QA30-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315QA300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

● AQ 1x12BIT (6ES7 232-4HA30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72324HA300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=viewB))

14.2.1.3 Communication boards

Point-to-point

CB 1241 (6ES7 241-1CH30-1XB0)
Information on the CB 1241 communication board is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH301XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.2.1.4 Battery boards

BB 1297 (6ES7 297-0AX30-0XA0)
Information on the BB 1297 communication board is available here (http://
support.automation.siemens.com/WW/llisapi.dll?aktprim=100&lang=en&referer=%2fWW
%2f&func=cslib.cssearch&nodeid0=41886045&viewreg=WW&siteid=csius&extranet=standar
d&groupid=4000002&objaction=cssearch&content=adsearch%2Fadsearch%2Easpx).

   

14.2.1.5 Digital input modules

Digital input modules (6ES7 221-1Bx3x-0XB0)
Information on the digital input modules is available here:

● DI8 x 24VDC (6ES7 221-1BF30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72211BF300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI8 x 24VDC (6ES7 221-1BF32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72211BF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view)) 

● DI16 x 24VDC (6ES7 221-1BH30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72211BH300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI16 x 24VDC (6ES7 221-1BH32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72211BH320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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14.2.1.6 Digital output modules

Digital output modules (6ES7 222-1xx3x-0XB0)
Information on the digital output modules is available here:

● DQ 8x24VDC (6ES7 222-1BF30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221BF300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 8x24VDC (6ES7 222-1BF32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221BF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 16x24VDC (6ES7 222-1BH30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221BH300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 16x24VDC (6ES7 222-1BH32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221BH320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 16xRelay (6ES7 222-1HH30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221HH300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 16xRelay (6ES7 222-1HH32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221HH320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 8xRelay (6ES7 222-1HF30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221HF300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 8xRelay (6ES7 222-1HF32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221HF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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● DQ 8xNO/NC Relay (6ES7 222-1XF30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221XF300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DQ 8xNO/NC Relay (6ES7 222-1XF32-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72221XF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

14.2.1.7 Digital input and digital output modules

Digital input and output modules (6ES7 223-1xx3x-0XB0)
Information on the digital input and output modules is available here:

● DI 8/DQ 8x24VDC (6ES7 223-1BH30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231BH300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 8/DQ 8x24VDC (6ES7 223-1BH32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231BH320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 16/DQ 16x24VDC (6ES7 223-1BL30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231BL300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 16/DQ 16x24VDC (6ES7 223-1BL32-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231BL320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 8x24VDC/DQ 8xRelay (6ES7 223-1PH30-0XB0 (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231PH300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 8x24VDC/DQ 8xRelay (6ES7 223-1PH32-0XB0 (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231PH320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI 16x24VDC/DQ 16xRelay (6ES7 223-1PL30-0XB0 (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231PL300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

Hardware documentation
14.2 PLC

WinCC Professional V13.0
System Manual, 02/2014 8161

http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72221XF320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231BL320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PH320XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES72231PL300XB0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view


● DI 16x24VDC/DQ 16xRelay (6ES7 223-1PL32-0XB0 (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231PL320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● DI/DO 8x120VAC/DQ 8xRelay (6ES7 223-1QH30-0XB0 (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231QH300XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

● DI/DO 8x120VAC/DQ 8xRelay (6ES7 223-1QH32-0XB0 (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72231QH320XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

14.2.1.8 Analog input modules

Analog input modules (6ES7 231-xxx3x-0XB0)
Information on the analog input modules is available here:

● AI 4x13BIT (6ES7 231-4HD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72314HD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 4x13BIT (6ES7 231-4HD32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72314HD320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 4x16BIT (6ES7 231-5ND30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315ND300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 4x16BIT (6ES7 231-5ND32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315ND320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 8x13BIT (6ES7 231-4HF30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72314HF300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 8x13BIT (6ES7 231-4HF32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72314HF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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● AI 4xRTD (6ES7 231-5PD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315PD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 4xRTD (6ES7 231-5PD32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315PD320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 8xRTD (6ES7 231-5PF30-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES723145PF300XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

● AI 8xRTD (6ES7 231-5PF32-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315PF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 4xTC (6ES7 231-5QD30-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315QD300XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

● AI 4xTC (6ES7 231-5QD32-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315QD320XB0&objaction=csviewmlfbbeitraege
&subtype=133300&caller=view))

● AI 8xTC (6ES7 231-5QF30-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315QF300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 8xTC (6ES7 231-5QF32-0XB0 (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72315QF320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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14.2.1.9 Analog output modules

Analog output modules (6ES7 234-4Hx3x-0XB0)
Information on the analog output modules is available here:

● AQ 2x14BIT (6ES7 232-4HB30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72344HB300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AQ 2x14BIT (6ES7 232-4HB32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72344HB320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AQ 4x14BIT (6ES7 232-4HD30-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72344HD300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AQ 4x14BIT (6ES7 232-4HD32-0XB0 (http://support.automation.siemens.com/WW/
llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72344HD320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

14.2.1.10 Analog input and analog output modules

Analog input and output module (6ES7 234-4HE3x-0XB0)
Information on the analog input and output modules is available here:

● AI 4x13BIT/AQ 2x14BIT (6ES7 234-4HE30-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72324HB300XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))

● AI 4x13BIT/AQ 2x14BIT (6ES7 234-4HE32-0XB0 (http://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72324HB320XB0&objaction=csviewmlfbbeitraege&
subtype=133300&caller=view))
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14.2.1.11 Communications modules

Industrial Remote Communication

CP 1242-7 (6GK7 242-7KX30-0XE00)
Information on the CP 1242-7 Telecontrol communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72427KX300XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CP 1243-1 (6GK7 243-1JX30-0XE0)
Information on the CP 1243-1 Ethernet communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72431JX300XE0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

PROFIBUS

CM 1242-5 (6GK7 242-5DX3x-0XE0)
Information on the CM 1242-5 PROFIBUS communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72425DX300XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1243-5 (6GK7 243-5DX3x-0XE0)
Information on the CM 1243-5 PROFIBUS communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK72435DX300XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

Point-to-point

CM 1241 RS232 (6ES7 241-1AH30-0XB0)
Information on the CM 1241 (RS232) communication module for point-to-point connections is 
available here (http://support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES72411AH300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS232 (6ES7 241-1AH32-0XB0)
Information on the CM 1241 (RS232) communication module for point-to-point connections is 
available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411AH320XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS485 (6ES7 241-1CH30-0XB0)
Information on the CM 1241 (RS485) communication module for point-to-point connections is 
available here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS422/485 (6ES7 241-1CH31-0XB0)
Information on the CM 1241 (RS422/485) communication module for point-to-point 
connections is available here (http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH310XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

CM 1241 RS422/485 (6ES7 241-1CH32-0XB0)
Information on the CM 1241 (RS422/485) communication module for point-to-point 
connections is available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72411CH320XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

Identification systems

RF120C (6GT2 002-0LA00)
Information on the communication module for Ident technology RFC120C is available here 
(http://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GT20020LA00&objaction=csviewmlfbbeitraege&subtype
=133300&caller=view).
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AS-Interface

AS-Interface CM 1243-2 (3RK7 243-2AA30-0XB0)
Information on the CM 1243-2 AS-i communication module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=3RK72432AA300XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

14.2.1.12 Technology modules

SIWAREX WP231 (7MH4 960-2AA01)
Information on the SIWAREX WP231 weighing module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=7MH4960-2AA01&objaction=csviewmlfbbeitraege&subtyp
e=133300&caller=view).

SIWAREX WP241 (7MH4 960-4AA01)
Information on the SIWAREX WP241 weighing module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=7MH4960-4AA01&objaction=csviewmlfbbeitraege&subtyp
e=133300&caller=view).

4SI IO-Link (6ES7 278-4BD32-0XB0)
Information on the 4SI IO-Link IO-Link Master technology module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES72784BD320XB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.3 Distributed I/O

14.3.1 ET 200MP

14.3.1.1 Interface modules

PROFINET

IM 155-5 PN ST (6ES7 155-5AA00-0AB0)
Information on the distributed I/O module IM 155-5 PN ST is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71555AA000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

IM 155-5 PN HF (6ES7 155-5AA00-0AC0)
Information on the IM 155-5 PN HF distributed I/O module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71555AA000AC0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

14.3.1.2 Digital input modules

DI 16x24VDC BA (6ES7 521-1BH10-0AA0)
Information on the DI 16x24VDC BA digital input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75211BH100AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DI 16x24VDC HF (6ES7 521-1BH00-0AB0)
Information on the digital input module DI 16x24VDC HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75211BH000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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DI 16x24VDC SRC BA (6xxx 521-1BH50-xAA0)
Information on the DI 16x24VDC HF digital input module (including SIPLUS variant) is available 
here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75211BH500AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DI 16x230VAC BA (6xxx 521-1FH00-xAA0)
Information on the DI 16x24VDC HF digital input module (including SIPLUS variant) is available 
here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75211FH000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DI 32x24VDC HF (6ES7 521-1BL00-0AB0)
Information on the digital input module DI 16x24VDC HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75211BL000AB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DI 32x24VDC BA (6ES7 521-1BL10-0AA0)
Information on the DI 16x24VDC BA digital input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75211BL100AA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

14.3.1.3 Digital output modules

DQ 8x24VDC/2A HF (6xxx 522-1BF00-xAB0)
Information on the DQ 8x24VDC/2A HF digital output module (including SIPLUS variant) is 
available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75221BF000AB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).
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DQ 8x230VAC/2A ST (6xxx 522-5FF00-xAB0)
Information on the DQ 8x230VAC/2A ST digital output module (including SIPLUS variant) is 
available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75225FF000AB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DQ 8x230VAC/5A ST (6xxx 522-5HF00-xAB0)
Information on the 8x230VAC/5A ST digital output module (including SIPLUS variant) is 
available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75225HF000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 16x24VDC/0.5A BA (6ES7 522-1BH10-0AA0)
Information on the DQ 16x24VDC/0.5A BA digital output module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75221BH100AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

DQ 16x24VDC/0.5A ST (6ES7 522-1BH00-0AB0)
Information on the digital output module DQ 16x24VDC/0.5A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75221BH000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

DQ 32x24VDC/0.5A BA (6ES7 522-1BL10-0AA0)
Information on the DQ 32x 24VDC/0.5A BA digital output module is available here (http://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75221BL100AA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

  

DQ 32x24VDC/0.5A ST (6ES7 522-1BL00-0AB0)
Information on the digital output module DQ 32x 24VDC/0.5A is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES75221BL000AB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

  

14.3.1.4 Digital input and digital output modules

DI16/DO 16x24VDC (6ES7 523-1BL00-0AA0)
Information on the DI 16/DO 16x24VDC  digital input and output module is available here 
(https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75231BL000AA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

  

14.3.1.5 Analog input modules

AI 4xU/I/RTD/TC ST (6ES7 531-7QD00-0AB0)
Information on the AI 4xU/I/RTD/TC ST analog input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75317QD00AB0&objaction=csviewmlfbbeitraege&subt
ype=133300&caller=view).

  

AI 8xU/I/RTD/TC ST (6ES7 531-7KF00-0AB0)
Information on the analog input module AI 8xU/I/RTD/TC ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75317KF000AB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

 

AI 8xU/I HS (6xxx 531-7NF10-xAB0)
Information on the AI 8xU/I HS analog input module (including SIPLUS variant) is available 
here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75317NF100AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.3.1.6 Analog output modules

AQ 2xU/I ST (6ES7 532-5NB00-0AB0)
Information on the AQ 2xU/I ST analog output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75325NB000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

AQ 4xU/I ST (6ES7 532-5HD00-0AB0)
Information on the analog output module AQ 4xU/I ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75325HD000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

AQ 8xU/I HS (6xxx 532-5HF00-xAB0)
Information on the AQ 8xU/I HS analog output module (including SIPLUS variant) is available 
here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75325HF000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

14.3.1.7 Analog input and analog output modules

AI/AQ 4xU/I/RTD/TC / 2xU/I ST (6ES7 534-7QE00-0AB0)
Information on the AI/AQ 4xU/I/RTD/TC / 2xU/I ST analog input and output module is available 
here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75347QE000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.3.1.8 Communications modules

PROFINET/Ethernet

CM 1542-1 (6GK7 542-1AX00-0XE)
Information on the CM 1542-1 PROFINET/Ethernet communication module is available here 
(https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK75421AX000XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

CP 1543-1 (6GK7 543-1AX00-0XE0)
Information on the CP 1543-1 PROFINET/Ethernet communications processor is available 
here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK75431AX000XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

PROFIBUS

CM 1542-5 (6GK7 542-5DX00-0XE0)
Information on the CM 1542-5 PROFIBUS communication module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6GK75425DX000XE0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

Point-to-point

RS232

CM PtP RS232 BA (6xxx 540-1AD00-xAA0)
Information on the CM PtP RS232 BA point-to-point communication module (including SIPLUS 
variant) is available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75401AD000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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CM PtP RS232 HF (6ES7 541-1AD00-0AB0)
Information on the CM PtP RS232 HF point-to-point communication module is available here 
(https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75411AD000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

RS422/485

CM PtP RS422/485 BA (6xxx 540-1AB00-xAA0)
Information on the CM PtP RS422/485 BA  point-to-point communication module (including 
SIPLUS variant) is available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75401AB000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

CM PtP RS422/485 HF (6xxx 541-1AB00-xAB0)
Information on the CM PtP RS422/485 HF  point-to-point communication module (including 
SIPLUS variant) is available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75411AB000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.1.9 Power supply module

PS 25W 24VDC (6ES7 505-0KA00-0AB0)
Information on the PS 25W 24VDC power supply module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75050KA000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

PS 60W 24/48/60VDC (6xxx 505-0RA00-xAB0)
Information on the PS 60W 24/48/60VDC power supply module (including SIPLUS variant) is 
available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75050RA000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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PS 60W 120/230VAC/DC (6xxx 507-0RA00-xAB0)
Information on the power supply module PS 60W 120/230VAC/DC (including SIPLUS variant) 
is available here (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75070RA000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

 

14.3.1.10 Technology modules

TM Count 2x24V (6ES7 550-1AA00-0AB0)
Information on the counter module TM Count 2x24V is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75501AA000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

TM PosInput 2 (6ES7 551-1AB00-0AB0)
Information on the positioning module TM PosInput 2 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75511AB000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

CM AS-i Master (3RK7 137-6SA00-0BC1)
Information on the CM AS-i Master module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=3RK71376SA000BC1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

F-CM AS-i (3RK7 136-6SC00-0BC1)
Information on the F-CM AS-i module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=3RK71366SC000BC1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.3.2 ET 200SP

14.3.2.1 CPU

CPU 1510SP-1 (6ES7 510-1DJ00-0AB0)
Information on the 1510SP-1 CPU is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75101DJ000AB0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

CPU 1512SP-1 (6ES7 512-1DK00-0AB0)
Information on the 1512SP-1 CPU is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES75121DK000AB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.2.2 Interface modules

PROFINET

IM 155-6 PN ST (6ES7 155-6AU00-0BN0)
You can find information on the interface module IM 155-6 PN ST here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000BN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

IM 155-6 PN HF (6ES7 155‑6AU00‑0CN0)
You can find information on the interface module IM 155-6 PN HF here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556AU000CN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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PROFIBUS

IM 155-6 DP HF (6ES7 155-6BU00-0CN0)
Information on the IM 155-6 DP HF interface module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556BU000CN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

Other fieldbuses

IM 155-6 Receive (6ES7 155-6DU00-0BN0)
Information on the IM 155-6 Receive interface module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71556DU000BN0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.2.3 Digital input modules

DI 4x120..230VAC ST (6ES7 131-6FD00-0BB1)
Information on the DI 4x120..230VAC ST digital input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316FD000BB1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DI 8x24VDC ST (6ES7 131-6BF00-0BA0)
Information on the digital input module DI 8x24VDC ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BF000BA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DI 8x24VDC HF (6ES7 131-6BF00-0CA0)
Information on the digital input module DI 8x24VDC HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

Hardware documentation
14.3 Distributed I/O

WinCC Professional V13.0
System Manual, 02/2014 8177

https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556BU000CN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556BU000CN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556BU000CN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556BU000CN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556DU000BN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556DU000BN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556DU000BN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71556DU000BN0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316FD000BB1&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316FD000BB1&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316FD000BB1&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316FD000BB1&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000BA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000BA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000BA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000BA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view
https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid=6ES71316BF000CA0&objaction=csviewmlfbbeitraege&subtype=133300&caller=view


DI 8xNAMUR HF (6ES7 131-6TF00-0CA0)
Information on the DI 8xNAMUR HF digital input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316TF000CA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DI 8x24VDC SRC BA (6ES7 131-6BF60-0AA0)
Information on the DI 8x24VDC SRC BA digital input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BF6000A0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DI 16x24VDC ST (6ES7 131-6BH00-0BA0)
Information on the digital input module DI 16x24VDC ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71316BH000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

14.3.2.4 Digital output modules

DQ 4x24VDC/2A ST (6ES7 132-6BD20-0BA0)
Information on the digital output module DQ 4x24VDC/2A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BD200BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 4x24..230VAC/2A ST (6ES7 132-6FD00-0BB1)
Information on the DQ 4x24..230VAC/2A ST digital output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326FD000BB1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 4x24VDC/2A HF (6ES7 132-6BD20-0CA0)
Information on the DQ 4x24VDC/2A HF digital output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES71326BD200CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

RQ 4x120..230VUC/5A NO ST (6ES7 132-6HD00-0BB0)
Information on the RQ 4x120..230VUC/5A NO ST relay output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326HD000BB0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

RQ 4x24VUC/2A CO ST (6ES7 132-6GD50-0BA0)
Information on the RQ 4x24VUC/2A CO ST relay output module is available here.

   

DQ 8x24VDC/0.5A ST (6ES7 132-6BF00-0BA0)
Information on the digital output module DQ 8x24VDC/0.5A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BF000BA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

DQ 8x24VDC/0.5A SNK BA (6ES7 132-6BF60-0AA0)
Information on the DQ 8x24VDC/0.5A SNK BA digital output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BF600AA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

DQ 8x24VDC/0.5A HF (6ES7 132-6BF00-0CA0)
Information on the digital output module DQ 8x24VDC/0.5A HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BF000CA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

DQ 16x24VDC/0.5A ST (6ES7 132-6BH00-0BA0)
Information on the digital output module DQ 16x24VDC/0.5A ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71326BH000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.3.2.5 Analog input modules

AI 2xU/I 2-/4-wire HF (6ES7 134-6HB00-0CA1)
Information on the AI 2xU/I 2-/4-wire HF analog input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346HB000CA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AI 2xU/I 2-/4-wire HS (6ES7 134-6HB00-0DA1)
Information on the  AI 2xU/I 2-/4-wire HS analog input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346HB000DA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

AI 4xI 2-/4-wire ST (6ES7 134-6GD00-0BA1)
Information on the analog input module AI 4xI 2-/4-wire ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346GD000BA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AI 4xU/I 2-wire ST (6ES7 134-6HD00-0BA1)
Information on the analog input module AI 4xU/I 2-wire ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346HD000BA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AI 4xRTD/TC 2-/3-/4-wire HF (6ES7 134-6JD00-0CA1)
Information on the analog input module AI 4xRTD/TC 2-/3-/4-wire HF is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346JD000CA1&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).
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AI 8xRTD/TC 2-wire HF (6ES7 134-6JF00-0CA1)
Information on the AI 8xRTD/TC 2-wire HF analog input module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346JF000CA1&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

   

AI EnergyMeter ST (6ES7 134-6PA00-0BD0)
Information on the AI EnergyMeter ST relay output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71346PA000BD0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.2.6 Analog output modules

AQ 2xU/I HF (6ES7 135-6HB00-0CA1)
Information on the AQ 2xU/I HF analog output module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71356HB000CA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AQ 2xU/I HS (6ES7 135-6HB00-0DA1)
Information on the analog output module AQ 2xU/I HS is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71356HB000DA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

AQ 4xU/I ST (6ES7 135-6HD00-0BA1)
Information on the analog output module AQ 4xU/I ST is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71356HD000BA1&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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14.3.2.7 Communication modules

CM PtP (6ES7 137-6AA00-0BA0)
Information on the CM PtP communication module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71376AA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.2.8 Power modules

PM 120..230VAC/10A ST (6ES7 133-6AA00-0BC0)
Information on the PM 120..230VAC/10A ST power module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71336AA000BC0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.2.9 Special modules

Server module (6ES7 193-6PA00-0AA0)
Information on the server module is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936PA000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

   

BusAdapter BA 2xSCRJ (6ES7 193-6AP00-0AA0)
Information on the BA 2xSCRJ BusAdapter is available here.

  

See also
Link to the device manual (https://support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AP000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view)

BusAdapter BA 2xRJ45 (6ES7 193-6AR00-0AA0)
Information on the BusAdapter BA 2xRJ45 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
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func=cslib.csinfo&lang=en&objid=6ES71936AR000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

BusAdapter FC (6ES7 193-6AF00-0AA0)
Information on the BusAdapter FC is available here (https://support.automation.siemens.com/
WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AF000AA0&objaction=csviewmlfbbeitraege&sub
type=133300&caller=view).

  

BusAdapter Send (6ES7 193-6AS00-0AA0)
Information on the BusAdapter Send is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AS000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

  

BusAdapter Receive (6ES7 193-6AE00-0AA0)
Information on the BusAdapter Receive is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71936AE000AA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

14.3.2.10 Technology modules

TM Count 1x24V (6ES7 138-6AA00-0BA0)
Information on the relay output module TMCount 1x24V is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71386AA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).

 

TM PosInput 1 (6ES7 138-6BA00-0BA0)
Information on the positioning module TM PosInput 1 is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71386BA000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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IO-Link Master Module (6ES7 137-6BD00-0BA0)
Information on the relay output module IO-Link Master Module is available here (https://
support.automation.siemens.com/WW/llisapi.dll?
func=cslib.csinfo&lang=en&objid=6ES71376BD000BA0&objaction=csviewmlfbbeitraege&su
btype=133300&caller=view).
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add external graphic , 6898
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 6ES7 155‑6AU00‑0CN0, 8176
 AboveUpperLimitColor property (VBS), 5182
 Absolute value, 1973, 2253
 Alarm report

Layout in reports, 4361
 Alarm view

 Status bar, 3844, 3857, 3863
Use in reports, 4359

 Autocompletion, 4440
 BelowLowerLimitColor property (VBS), 5231
 Configuring

Alarm text block, 3936
 Connection configuration

General, 590
 Create

Report (overview), 4300
 Creating

Report (overview), 4300
 CSV provider trends

Layout in reports, 4349
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 Date/time field
Use in reports, 4352

 External source file
Editing, 1680
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 f(t) trend view
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 License, 126, 7501
 Logging method

Segmented circular log, 3758
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 Page number
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 Recipe report
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 Reporting
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 SQL Server Import/Export-Wizard, 7656
 STARTUP

Warm restart, 1068
 Table view

 Online configuration, 3878
 Toolbar, 3844, 3857, 3863
Use in reports, 4372

 Trend view
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 TrendWindowRulerLayer property (VBS), 5691
 User-defined function

 Autocompletion, 4440
 Web Client, (See WebNavigator Client)
 Web Configurator

 Creating a standard Web site, 7527, 7529
Setting a firewall, 7296, 7531
Setting a port, 7527, 7529

 WebNavigator
Licenses, 7501

 WebNavigator Client, 7499
Licenses, 7501

 WebNavigator Server, 7499
Licenses, 7501

 Zoom in/out, (See Zoom)

"
"Local scripts" editor

Availability, 4471
Properties, 4471
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A
A&E Server, 7578

Mapping of the WinCC message system, 7578
AB, 1425
Ability to read back connection parameters, 612
abort function, 6047
ABS, 1973, 2253, 2464
abs function, 6046
Absolute Addressing

of a tag, 3680, 6159
Absolute value, 2464
Access

Tag, 4445
Access control, 948

Automatic learning, 948
Access point, 6090
Access Point, 6061, 6090
Access protection, 4418

Access protection level 1, 8105
Access protection level 2, 8105
Advantages, 8105
Configuring, 4422
Factory state, 8104
User administration, 4415, 4416
Validity, 8104

Access protection in Runtime
Alarm view, 3586

Access right, 7059, 7060, 7061
Access to operands, 1301, 1302, 1303, 1305, 1306, 
1308, 1309
Access Via the WinCC OLE DB, 7656
Accessibility

WinCC OPC server, 7565
Accessible devices, 1042, 6222, 6303, 6388
ACK, 7160

Key, 7090
acknowledge

Key, 7090
Acknowledge, 3897, 4788

Alarm, 7165
Error alarm, 7165

Acknowledge alarm
Alarm group, 3903

AcknowledgeAlarm, 4630, 4799
Acknowledgement

Audit Trail, 7256
Acknowledgment, 3901

Configuring, 3998, 3999, 4001
Acknowledgment bit, 4119

Resetting, 4119
Acknowledgment concept

Alarm with simple acknowledgment, 3903
Alarm without acknowledgment, 3903

Acknowledgment model, 3903
Alarm with dual-mode acknowledgment, 3903
Alarm with simple acknowledgment, 3903
Alarm without "outgoing" status with 
acknowledgment, 3903
Alarm without "outgoing" status without 
acknowledgment, 3904
Alarm without acknowledgment, 3903
First value alarm with flashing and single 
acknowledgment, 3904
New value alarm with flashing and dual-mode 
acknowledgment, 3904
New value alarm with flashing and single 
acknowledgment, 3904

Acknowledgment request, 3908
Acknowledgment tag, 4119
Acknowledgment theory, 7580
ACL, 948
ACOS, 1990, 2270, 2479
acos function, 6043
Acquisition cycle, 3776, 3783

Area pointer, 6164
Defining, 3718
Tag, 3714, 3715, 3736, 3738

Acquisition mode
Tag, 3714

ACT_TINT, 2819
Action

Migrate, 242, 244
Actions

Basics of redoing actions, 428
Basics of undoing, 428
Redoing, 432
Undoing, 431

activate, 4769
Activate

Autoscroll, 3586
Project language, 6886

Activate method, 5775
Activate property (VBS), 5184
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ActivateCleanScreen, 4568
ActivateDynamic, 5777
ActivateNextScreen, 5895
ActivatePreviousScreen, 4569, 4800, 5896
ActivateScreen, 4566, 4712, 4800, 4882, 5897
ActivateScreenByNumber, 4567, 4802
ActivateScreenInCurrentScreenWindow, 4713
ActivateScreenInScreenWindow, 4713, 4883, 5898
ActivateStartScreen, 5899
ActivateStoredScreen, 5900
ActivateSystemDiagnosticsView, 4677, 4802
Activating, 7492

Alarms blocks for the alarm view, 3978
Project, 7492

Active
Area pointer, 6164

Active bus module (ET 200M), 1188
Active nodes, 708
Active property (VBS), 5185
ActiveScreen property (VBS), 5187
ActiveScreenItem object, 5188
ActiveX control

Add, 3373
Remove, 3374

ActualPointLeft property (VBS), 5189
ActualPointTop property (VBS), 5190
Acyclic triggers, 6101, 6109
AD, 1425
AdaptBorder property (VBS), 5191
AdaptFontSizeToLineHeight property (VBS), 5191
Adapting a project

For a different HMI device, 7042
AdaptPicture property (VBS), 5192
AdaptScreenToWindow property (VBS), 5192
AdaptSize property (VBS), 5192
AdaptWindowtoScreen property (VBS), 5192
Add, 1964, 2242

.Net control, 3373
ActiveX control, 3373
Objects to the group, 3382

ADD, 1964, 2242
Add empty line, 7856
Add separator line, 7856
Adding

Adding timers with T_ADD, 2623
User text block for alarm, 3952

Additional field devices (PROFIBUS and 
PROFINET), 1016, 1045
Additional tasks

Runtime settings, 7062, 7485
Additional text for an alarm, 3952

Add-on
Installing, 120
Removing, 120

Address
Area pointer, 6164
Mitsubishi, 6687
Omron Host Link, 6755

address conversion
Instructions for, 2921

Address multiplexing
with absolute addresses, 3705
with symbolic addresses, 3705

Address overview, 541
Address packing, 1008
Address property (VBS), 5193
Address range, 678

Changing, 782
Address register, 1317, 1318
Addresses

Assigning, 784
Determining a module with GEO_LOG, 2929
Interrupt with packed, 1014
Pack, 1008
Read station address with GetStationInfo, 2864
Unpack, 1009

Addressing, 1078
Addressing tags indirectly, 3712, 3720
Allen-Bradley, 6640, 6662
Allen-Bradley Ethernet IP, 6636
Changing, 782
Ethernet/IP, 6640, 6662
General, 781
MPI, 6416
Multiplexing, 3712
SIMATIC S7 1500, 6264
Tags, 6264
Valid, 6642

Addressing operands, 1301, 1302, 1303, 1305, 1306, 
1308, 1309, 1312, 1313, 1314, 1316, 1317, 1318
AdjustBorder3DWithStyle property (VBS), 5193
AdjustContrast, 4570
AdjustRulerWindow property (VBS), 5194
Admin, 7116
Administrator, 656
Advanced Encryption Standard (AES), 704
Advanced mode

Global firewall rules, 664
Advanced recipe view, 3598, 4180

Configuring, 3598
AES, 704
AES-128, 699
Aggregate functions for analysis, 7661
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Aggressive mode, 704
Aging time, 952
Alarm

acknowledge, 4039, 4042
Acknowledge, 7165
Adding user text blocks, 3952
Calling the infotext, 4043
Components, 3910
Configuring, 3923, 3937, 3955, 3958
Display, 3578
Display in Runtime, 4054, 7175
Display suppression mask, 3984
Editing, 4040, 7167
Evaluation in Runtime , 3994
Event, 4066, 4067
Exporting, 6835
Filtering, 4051, 7172
Hiding, 4005
Importing, 6837, 6838
in Runtime, 7157
In Runtime, 4034, 4035, 4046
Inspector window, 67
Loop-in alarm, 4050
Output, 3584
Parameter blocks, 3934
Priority, 4069
Sequence is not adhered to, 4498
Suppress display, 3984
System blocks, 3934
System function, 4065
User text blocks, 3934

Alarm annunciator, 3975
Configuring, 3991

Alarm buffer, 4006
in Runtime, 7158
In Runtime, 4035, 4036, 4047
Memory size, 4007

Alarm buffer overflow, 4007, 4786
Alarm class, 3910

Diagnostics, 3967
Identifying, 3581
in Runtime, 7158
In Runtime, 4034, 4036, 4046
Layout, 4038, 4041, 7161, 7163

Alarm classes, 3898, 3899
Common, 3900
Custom, 3899, 3900
Migrate, 240
Name change through migration, 187
Predefined, 3899, 3900
Use, 3899, 3900

Alarm Control
Emergency acknowledgement of alarms, 4063, 
7183

Alarm display, 1060
"Active alarms" view, 1062
Acknowledging an alarm, 1063
Archive view, 1060
Clear archive, 1062
Export archive, 1062
Ignoring alarms, 1064
Layout of the alarms in the "Active alarms" view, 
1062
Layout of the alarms in the archive view, 1061
Receiving alarms, 1061
Using the keyboard, 1064

Alarm event
Acknowledge, 3897
Incoming, 3897
Outgoing, 3897

Alarm group, 3905, 3911
Acknowledge alarm, 3903
Configuring, 3920
Creating, 3920, 3921
Migration, 186
Status tag, 3975
Tags, 3908

Alarm groups
Migrate, 240

Alarm Groups from Alarm Classes, 3906
Alarm indicator, 66, 3590, 3962, 4043, 7160

Alarm classes, 3591
Application, 4043
Configuring, 3970
Events, 3591
in Runtime, 7159
In Runtime, 4035, 4037, 4048
Layout, 3591, 4043
Operation, 4043
Operation using the mouse, 4044

Alarm line, 3579
Alarm list, 4051, 4054, 7175
Alarm log, 4007, 4155, 4158

Backup, 4027
Configuring, 4013, 4024, 4026
Configuring an alarm view, 3974
Connecting, 4032
Creating, 4008, 4013
Disconnecting from project, 4032
Displaying contents, 3974
in Runtime, 7159
In Runtime, 4037, 4047
Migrating, 194
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Signing off of backup, 4027
Swapping, 4027

Alarm logging, 3888, 3889
Memory medium, 4010, 4024

Alarm message
Acknowledgment by the PLC, 6256, 6341, 6437, 
6530, 6542, 6674, 6708, 6742, 6761
Acknowledgment on the HMI device, 6257, 6341, 
6437, 6531, 6543, 6675, 6709, 6743, 6762
Configure acknowledgment, 6256, 6341, 6436, 
6530, 6542, 6674, 6708, 6742, 6761

Alarm number, 3909, 3910, 3911
Alarm object, 4947
Alarm Priority, 4069
Alarm property (VBS), 5194
Alarm report

Configuring, 7243
Use in reports, 4361

Alarm sequence report, 4312
Use in reports, 4360

Alarm sequence report , 3997
Alarm statistics, 3975, 3981

Configuring, 3982
Alarm statistics column property changed, 4776
Alarm status, 3911

Acknowledged, 3897
Incoming, 3897
Outgoing, 3897

Alarm system, 3886
Migrate, 240

Alarm Table
Display Alarms, 7336

Alarm text, 3911
Formatting, 3927
Output fields, 72
Removing format settings, 3928
Special characters, 72

Alarm text block, 3937
Configuring , 3936

Alarm types, 3890, 3891, 3892
Alarm view, 66, 3578, 3579, 3583, 3588, 3962, 3975, 
4037, 4042, 4048, 4054, 7161, 7164, 7175

 Configuring the display of S7 diagnostic alarms, 
3967
 Configuring the export of Runtime data, 3845, 
3858, 3866
 Online configuration, 3846, 3859, 3867
 Toolbar, 3844, 3857, 3863
~ configuring for logged alarms, 3968, 4018
Activating alarm text blocks for ~ , 3978
Alarm line, 3579
Alarm text window, 4042, 7164

Application, 4037
Column, 3581, 3587
Configuring, 3964, 3977
Configuring a filter, 3979
Configuring data export, 3993
Configuring the layout, 3966
Configuring the toolbar and status bar, 3978
Control element, 3584, 4038, 7161
Enable sorting, 3581
Filter display, 3973
Filtering alarms, 4051, 7172
Identifying an alarm class, 3581
Layout, 4038, 4041, 7162, 7163
Operation, 4038, 4042, 7162, 7164
Operation using the keyboard, 4039, 4049
Operation using the mouse, 4039, 4049
Operator control, 3580, 7170
Use, 7161

Alarm window, 66, 3962, 4037, 4054, 4055, 7161, 
7175, 7176

Application, 4037
Configuring, 3969, 4055, 7176
Control element, 4038, 7161
in Runtime, 7159
In Runtime, 4035, 4037, 4047
Operation, 4038, 7162
Operation using the keyboard, 4039, 4049
Operation using the mouse, 4039
Output of log data, 4055, 7176
Use, 7161

Alarm with simple acknowledgment, 3903
Alarm without acknowledgment, 3903
AlarmColor property (VBS), 5195
AlarmControl

Online configuration, 4254
Runtime data, 4253

AlarmControl object, 4981
AlarmFilter property (VBS), 5195
AlarmHigh property (VBS), 5196
AlarmHitView, 7661, 7664
AlarmID property, 5196
AlarmLogs object, 4949
AlarmLow property (VBS), 5197
AlarmLowerLimit property (VBS), 5198
AlarmLowerLimitColor property (VBS), 5198
AlarmLowerLimitEnabled property (VBS), 5199
AlarmLowerLimitRelative property (VBS), 5199
Alarms

Column names, 7338
Configuring, 6255, 6340, 6435, 6529, 6541
continuous reporting, 4312
Creating comments, 3916
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Data types, 6255, 6340, 6435, 6529, 6541
Display in the alarm table, 7336
Hit list, 7340
in reports, 4310
Migrate, 240
Modicon Modbus, 6741
Non-integrated connection, 6741
Output of a tag value, 3928
Output of texts from a text list, 3930
Parameter output in discrete alarms, 3947
Parameter output in the analog alarm, 3942
Parameter output in user alarms, 3950
Reloading, 4033
Restriction, 6708

Alarms and Trends
Displaying values in a table, 7332
Displaying values in a trend view, 7334

Alarms object (list), 4948
AlarmUpperLimit property (VBS), 5200
AlarmUpperLimitColor property (VBS), 5201
AlarmUpperLimitEnabled property (VBS), 5201
AlarmUpperLimitRelative property (VBS), 5202
ALARMVIEW, 7650
AlarmView object, 4992
AlarmViewAcknowledgeAlarm, 4623
AlarmViewEditAlarm, 4622
AlarmViewShowOperatorNotes, 4623
AlarmViewUpdate, 4622
Align

Object flush, 3350, 4340
Alignment property (VBS), 5202
AlignmentLeft property (VBS), 5203
AlignmentTop property (VBS), 5203
Allen Bradley Ethernet IP

Data types, 3755
Allen-Bradley, 6625, 6653

Allen-Bradley DF1 communication driver, 6653
Analog alarm, 6673
Basic Panel, 6170
Communication drivers, 6628
Data type, 6672, 6673
DF1, 6628
Ethernet/IP, 6642
EtherNet/IP, 6628
Mitsubishi, 6707
Panel, 6175

Allen-Bradley 
Area pointer, 6669

Allen-Bradley DF1
Configuring a connection, 6648
Connection, 6648, 6652
Connection parameters, 6650

CPU type, 6662
KF2 module, 6653
KF3 module, 6653
Migrating data types, 202
Valid data type, 6660

Allen-Bradley DH485
Migrating data types, 202

Allen-Bradley Ethernet IP
Address multiplexing, 6640
Addressing, 6636
Addressing type, 6638
Migrating data types, 203

Allen-Bradley EtherNet/IP
Configuring a connection, 6629
Connection, 6629, 6633
Connection parameters, 6631
Data type, 6634

AllowMenu property (VBS), 5204
AllowPersistence property (VBS), 5204
Alphanumeric key assignment, 7089
Alphanumerical screen keyboard, 7085
Alphanumerical value

Changing, 7086, 7092
Entering, 7086, 7092

ALT
Key, 7089

Analog alarm, 3890, 3891, 3892
Allen-Bradley, 6673
Configuring, 3923, 3937, 3959
Mitsubishi, 6707
Omron, 6760
Parameter output , 3942

Analog alarm limits
Configuring, 3945, 3949

Analog alarm types, 3890, 3891, 3892
Analog alarms

Configuring, 3912, 3913
Analog module

Resetting to factory settings, 1244
Analog property (VBS), 5205
Analog value, 2053, 2055, 2335, 2338, 2543, 2545
Analog value processing, 2053, 2055, 2335, 2338, 
2543, 2545
Analysis functions, 7661

Alarm logs, 7661
Alarm Message Archives, 7664
Process value archives, 7661
Recordset with the analysis of message archives, 
7664

AND, 1601, 1602, 2087, 2131, 2132, 2371
AngleMax property (VBS), 5205
AngleMin property (VBS), 5206
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Animation, 3424
Configuring, 3427, 4179
Diagonal movement, 3430
Direct movement, 3431
Green arrow in Overview, 3427
Horizontal movement, 3429
Multiple selection, 3445
Object group, 3443, 3444
Overview, 3427
Tag binding, 3434
Vertical movement, 3430

Antivirus programs, 103, 112
ANY, 1358
API error messages, 6498
Appearance

Dynamization of an object, 3428
Object, 3356

Applet, 658
Application, 1046, 7639, 7641, 7642, 7643

Access to local WinCC user archives, 7642
Alarm indicator, 4043
Alarm view, 4037
Alarm window, 4037
Control Data, 4346
Control Hardcopy, 4347
Control Information, 4348
Date/time field, 4351
f(x) trend view, 4355
Key switch, 3611
Recipe view, 4211
Remote access to WinCC archive databases, 
7641
Remote Access to WinCC RT Databases, 7639
Remote Access to WinCC User Archives, 7643
Simple alarm view, 4040
simple alarm window, 4040

Application example
Entering recipe data offline , 4224
Recipe with manual production sequence, 4225

Application Health Check, 7365, 7390
ApplicationWindow object, 5118
ApplyProjectSettings property (VBS), 5207
Arccosine, 1990, 2270, 2479
Archive Connector, 7630
Archive data, 7635, 7650, 7654, 7659

Access via WinCC OLE DB Provider, 7635
as reports on the network, 7657
Query, 7650, 7654, 7659

Archive database, 7637
Attach, 7637

ArchiveLogFile, 4572, 4803
Archiving projects, 374, 375

Arcsine, 1988, 2269, 2478
Arctangent, 2480
Arctangent value, 1991, 2272
Area of unplugged modules, 528
Area pointer, 6162, 6238, 6321, 6419, 6513, 6763

Acquisition cycle, 6164
Active, 6164
Address, 6164
Allen-Bradley, 6669
Basic Panel, 6173
Comment, 6164
Connection, 6162, 6167
Connections editor, 6163
Coordination, 6768
Data record, 4173, 6246, 6330, 6427, 6520, 6772
Date/time, 6321, 6323
Job mailbox, 6244, 6328, 6424, 6518, 6769
Length, 6164
Migration, 184
Mobile Panel, 6193
PLC tag, 6164
Pointer name, 6164
Project ID, 6243, 6327, 6423, 6517, 6769
Screen number, 6238, 6326, 6419, 6513, 6765
Tab, 6164
Trends, 6253, 6337, 6433, 6527, 6539, 6670, 
6704, 6738, 6758

Area pointers
Configuring, 6165
Coordination, 6242, 6325, 6422, 6516
Creating, 6165
Date/time, 6239, 6420, 6514, 6766
Date/time PLC, 6240, 6421, 6515, 6767
Length, 6166
Mitsubishi, 6703
Modicon Modbus, 6737
Omron, 6757

ARP, 758
Diagnostics, 758
Table, 758

Arrange
Object in the screen, 3342

Arrangement of byte sequence, 2304, 2498
Array, 70, 282, 1351, 1352, 3722, 3724, 3726, 3727

Creating, 3724, 3727
Indirect addressing, 3712
see ARRAY, 1499, 1647

ARRAY, 1314
Addressing, 1306
Declaration in global data blocks, 1647
Declaration in PLC data types, 1670
Declaration in the block interface, 1499
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Example, 1354
Format, 1351, 1352

ARRAY component, 49
Array data block, 2024, 2026, 2028, 2032, 2306, 
2308, 2310, 2314, 2500, 2502, 2503, 2506
ARRAY data block, 1264, 1267, 1303, 1306, 1450, 
1640, 1643, 1663
Array element

Location of use of HMI tag, 70
Name, 70

ARRAY limits, 1605
Array tag, 3722, 3726

Char, 70
AS interface, 1018
ASCII code table, 614
ASCII TSAP, 614
asctime function, 6048
Asian, 37
Asian operating system, 6884
ASIN, 1988, 2269, 2478
asin function, 6043
AskOperationMotive property (VBS), 5208
Assembling manuals, 355
Assign

Object of a layer, 3470
Assigning

a function to a function key, 3461
a graphic to a function key, 3464
Function key, 3456, 3458, 3460

Assigning an IP address
Basics, 1236
from the project context, 1237
Using "Accessible devices", 1236

Assigning global data blocks , 50
Assigning symbol, 784
Assigning tag, 784
Assignment, 1603, 1861, 2138

Negate, 1862, 2139
Assignment list

Enabling the display of retentive bit memories, 
1742

Assignment list 
 Meaning of symbols, 1736
Defining filter, 1739
Delete filter, 1739
Displaying, 1737
Example for displaying bit memory, 1735
Example for displaying inputs and outputs, 1735
Filter options, 1739
Filtering, 1740
Introduction, 1734
Setting view options, 1738

Structure, 1735
Assignments property (VBS), 5208
AssumeOnExit property (VBS), 5209
AssumeOnFull property (VBS), 5209
Asynchronous

Transferring data, 6247, 6331, 6427, 6525, 6772
Asynchronous error event

Delaying with DIS_AIRT, 2837
Disabling with DIS_IRT, 2834
Enabling with EN_AIRT, 2838
Enabling with EN_IRT, 2836

AT , 1309
ATAN, 1991, 2272, 2480
atan function, 6043
atan2 function, 6043
ATH, 2655
atof function, 6046
atoi function, 6046
atol function, 6046
ATTACH, 1084, 2808
AttachDB, 5781
ATTR_DB, 2918
Audit

Configuration, 7267
Enhancements in the ES, 7227
Forcing, 7252
Functional scope, 7227
Logging concept, 7228
Scope of logging, 7228
Screen object, 7268
Supported HMI devices, 7267

Audit log, 722, 724
Audit Trail

Acknowledgement, 7256
Checksum, 3759, 3771, 4021, 7250
Comments, 7256
CSV file, 7249
Editor, 7231
Effects in runtime, 7253
Electronic signature, 7256
File format, 7249
Log tag value change, 7253
Logging recipe data changes, 7256
Logging system functions, 7262
Logging user actions, 7259
Memory medium, 7251
Printing, 7240
Protection against change, 7252
Reporting, 7240
Storage location, 7251
Troubleshooting, 7251

Audit trail editor, 7231
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Authentication, 890, 983
Authentication methods, 702, 703
Authorization, 7097

Assignment, 4388, 4424
Changing the name, 4392
Configuring, 4414
Creating, 4385, 4422
Deleting, 4392
Managing, 4391

Authorization property (VBS), 5210
AutoCompleteColumns property (VBS), 5211
AutoCompleteRows property (VBS), 5212
Autocompletion

Function, 1487
Insert tag, 1487, 1488
Inserting an instruction, 1488

Automatic
Reporting, 3925

Automatic commissioning, 1042
Automatic display suppression, 3984
Automatic hide, 4121
Automation License Manager, 6802
Automation system, 6119, 6143

Local, 8139
Remote, 8139
Setting up, 6119

Autonegotiation, 1041
Disabled, 6221, 6302, 6387

Autoscroll
Activate, 3586

AutoScroll property (VBS), 5213
AutoSelectionColors property (VBS), 5213
AutoSelectionRectColors property (VBS), 5214
Availability

"Local scripts" editor, 4471
Object for Basic Panels, 3508
Object for Comfort Panel, 3511
Object for Mobile Panels, 3514
Object for Panels, 3509
Object for WinCC Runtime Advanced, 3515
Objects for Multi Panels, 3512

Availability for specific devices
Screen, 3302

Available system functions
Basic Panels, 4528
Comfort Panels, 4547
Mobile Panels, 4554
Multi Panels, 4542
Panels, 4536
WinCC Runtime, 4559
WinCC Runtime, 4564

Average property (VBS), 5215

AW, 1425
AWP command, 795, 796
AWP_In_Variable, 799
AWP_Out_Variable, 797
AX, 1425
Axis

common, 3835
Multiple, 3834

Axis and command table technology object
 List of ErrorIDs and ErrorInfo, 7926

B
Back page

in reports, 4305
Report, 4295, 4298

Back up RAM file system, 4663, 4805
BackColor color property (VBS), 5217
BackColor property (VBS), 5216
BackColorBottom property (VBS), 5219
BackColorTop property (VBS), 5219
BackFillStyle property (VBS), 5220, 5221
BackFillStyleReadOnlySpecial property (VBS), 5221
BackFlashingColorOff property (VBS), 5222
BackFlashingColorOn property (VBS), 5223
BackFlashingEnabled property (VBS), 5224
BackFlashingRate property (VBS), 5224
Background color

Dynamization, 3428
Backing up, 7098
BACKSPACE key, 7089
Backup, 4027

Deleting, 6970
of alarm log, configuring, 4027
Rename, 6970

Backup from online device, 8031
BackupRAMFileSystem, 4663, 4805
Bar, 3519, 3520

Color transition, 3519, 3521
Define scale gradation, 3521
Display limit lines, 3520, 3521

Bar object, 4996
Bar segment

Defining, 3520, 3521
BarBackColor property (VBS), 5225
BarBackFillStyle property (VBS), 5226
BarColor property (VBS), 5228
BarStartValue property (VBS), 5229
BaseScreenName property (VBS), 5229
Basic mode, 1772
Basic Panel

Area pointer, 6173
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Communication drivers, 6170
Display and operating object, 3508
ETHERNET, 6172
IF1B, 6172
Interface, 6172
Mitsubishi, 6170
Modicon Modbus, 6170
Omron, 6170
OPC, 6170

Basic Panels
Available system functions, 4528

Basic Process Control
Migrate, 251

Basic settings
OPC, 7565

Basics
HMI HTTP protocol, 6583
Migration, 167, 216

Battery object, 5001
BCDCPL, 2129, 2414, 2620
BeginTime(i) property (VBS), 5230
Behavior

Simple recipe view, 4206, 7139
Benefits of using TeleService, 8090
Bit (0, 1)

Graphics list, 3414
Text list, 3402

Bit field
Reset, 2142
Resetting, 1865
Set, 2141
Setting, 1864

Bit logic operations
AND, 2131, 2132
EXCLUSIVE OR, 2135
Insert input, 2136
OR, 2133, 2134

Bit mask, 2120, 2405, 2611
Bit memories

Enabling the display of retentive bit memories, 
1742

Bit number  (0 - 31)
Graphics list , 3416
Text list, 3403

Bit string, 1325, 1326, 1327
 64-bit, 1327

BitNumber property (VBS), 5231
Bits

Count, 2130, 2621
Counting, 2415

BITSUM, 2130, 2415, 2621

Bit-triggered trends, 6253, 6337, 6433, 6527, 6539, 
6670, 6704, 6738, 6758
BlinkColor property (VBS), 5232
BlinkMode property (VBS), 5232
BlinkSpeed property (VBS), 5233
BLKMOV, 2039, 2321, 2529
Block

Block, 2321
Changing passwords for know-how protected 
blocks, 1732
Closing, 1466
Comparing, 1686
Comparing code blocks, 1683
Comparing data blocks, 1684
Comparison, 1681
Compiling, 1710
Compiling in the program editor, 1713
Compiling in the project tree, 1712
Consistency check, 1710, 1747, 1753
Consistency check in the call structure, 1748
Copying, 1453, 1456
Deleting offline, 1468
Deleting online, 1468
Displaying properties, 1464
Download to device, 1715, 1719
Downloading to a memory card, 1724
Downloading to device in RUN operating mode, 
1718
Editing properties, 1464
Entering a comment, 1458
Entering a title, 1457
exporting to an external source file, 1678
Fill, 2018, 2043, 2300, 2326, 2495, 2534
Fill uninterruptible, 2020, 2302, 2496
Find and open, 1465
Inserting, 1453
Know-how protection, 1726
Leave, 2568
Move, 2291, 2488, 2529
Move uninterruptible, 2016, 2041, 2297, 2323, 
2493, 2531
Moving, 2010, 2039
Opening, 1465
Opening know-how protected blocks, 1730
Optimized access, 1267, 1269
Pasting, 1457
Printing know-how protected blocks, 1731
Properties, 1459
Removing copy protection, 1728
Renaming, 1467
Saving, 1466
Setting up copy protection, 1728

Index

WinCC Professional V13.0
System Manual, 02/2014 8197



Time stamp, 1462
Types, 1261
Upload from device, 1715
Uploading blocks from a memory card, 1725
Uploading blocks from device, 1723
Using a library, 1451

BLOCK, 1363
Block access

Data block, 1652
Block call

Basics, 1272
Calling as single instance or multiple instance, 
1274
Correcting the call type, 1536, 1577
Inserting, 1533, 1575, 1621, 1622, 1624, 1625, 
1626, 1627
Multi-instance, 1275
Nesting depth, 1273
Single instance, 1275
Updating, 1535, 1576, 1628

Block comment
Hiding, 1479
Showing, 1479

Block comparison
Basics, 1681
Changing the block, 1705
Comparing code blocks, 1683
Comparing data blocks, 1684
Detailed comparison, 1687, 1688, 1692, 1695, 
1698
Execute action, 403
Navigation, 1704
Synchronize scrolling, 1705
Updating comparison results, 400, 1706

Block consistency
Checking, 1748
Checking in the dependency structure, 1753

Block folder, 1447
Block interface

Declaring ARRAY, 1499
Declaring PLC data type, 1501
Declaring STRUCT, 1500
Declaring tags, 1497, 1498, 1502
Hiding, 1479
Importing and exporting tags, 1513
Multi-instance, 1503
Purpose of tag declaration, 1491
Retentivity, 1507
Showing, 1479
Structure, 1491
Tag properties, 1506, 1508
Updating, 1503

Valid data types, 1494, 1496
Block parameters, 1277, 1279, 1281, 1283, 1285, 
1286, 1287, 1288

Basics, 1129
Block interface, 1491

Block property
Displaying, 1464
Editing, 1464
Function, 1459
Overview, 1459

Block property changed, 4775
Bookmarks

Deleting, 1612
Function, 1610
Navigating, 1611
Setting, 1611

BOOL, 1324, 1372, 1389
BOOL_TO_, 1389
Border color property (VBS), 5237
BorderBackColor property (VBS), 5234
BorderBrightColor3D property (VBS), 5235
BorderColor property (VBS), 5236
BorderEndStyle property (VBS), 5239
BorderFlashingColorOff property (VBS), 5240
BorderFlashingColorOn property (VBS), 5241
BorderFlashingEnable property (VBS), 5242
BorderFlashingRate property (VBS), 5243
BorderInnerStyle3D property (VBS), 5244
BorderInnerWidth3D property (VBS), 5244
BorderOuterStyle3D property (VBS), 5245
BorderOuterWidth3D property (VBS), 5245
Borders

Placeholder for document information, 419
Specifying the print area, 418

BorderShadeColor3D property (VBS), 5246, 5247
BorderStyle property (VBS), 5247
BorderStyle3D property (VBS), 5249
BorderWidth property (VBS), 5250, 5251
BorderWidth3D property (VBS), 5252
Boundaries, 1042, 6222, 6303, 6388
Boundary reached, 4788
Branch, 2556, 2558

Closing, 1552
Definition, 1550, 1592
Deleting, 1553, 1593
Inserting, 1552, 1593
Rules, 1551
Rules , 1592

BRCV, 3205
Broadcast, 678, 686, 954
BrowserView object, 5057
bsearch function, 6047
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BSEND, 3202
Button, 3608

Adding a system diagnostics indicator, 4149
as release button, 98
Configuring, 4422
Configuring access protection, 4418
Creating, 3662
Define hotkey, 3609
for release of operator control, 96
Graphic, 3608
HTML Browser, 3558
Lock/unlock, 97
Mode, 3608
Recipe view, 4270, 7147
Status/Force, 3619
Text, 3608

Button object, 5002
ButtonCommand property (VBS), 5254
Buttons and Switches

Library, 6810
BY, 2560
BYTE, 1325, 1373, 1390
BYTE_TO_, 1390
Bytes

 Swap, 2498
Swap, 2022, 2304

C
C

Examples in WinCC, 4523
C function

Example, 4525, 4526, 4527, 4528
C functions

_ismbcalnum function, 6044
_ismbcalpha function, 6044
_ismbcdigit function, 6044
_ismbcgraph function, 6044
_ismbclower function, 6044
_ismbcprint function, 6044
_ismbcpunct function, 6044
_ismbcspace function, 6044
_ismbcupper function, 6044
_mbscat function, 6045
_mbschr function, 6045
_mbscmp function, 6044
_mbscpy function, 6045
_mbscspn function, 6044
_mbsdec function, 6045
_mbsinc function, 6045
_mbslen function, 6044
_mbsncat function, 6045

_mbsncmp function , 6044
_mbsncpy function, 6045
_mbspbrk function, 6045
_mbsrchr function, 6044
_mbsspn function, 6044
_mbsstr function, 6045
_mbstok function, 6045
_mbstrlen function, 6044
abort function, 6047
abs function, 6046
acos function, 6043
asctime function, 6048
asin function, 6043
atan function, 6043
atan2 function, 6043
atof function, 6046
atoi function, 6046
atol function, 6046
bsearch function, 6047
calloc function, 6047
ceil function, 6043
clearerr function, 6046
clock function, 6048
cos function, 6043
cosh function, 6043
ctime function, 6048
difftime function, 6048
div function, 6046
exit function, 6047
exp function, 6043
fabs function, 6043
fclose function, 6045
feof function, 6045
ferror function, 6045
fflush function, 6045
fgetc function, 6045
fgetpos function, 6045
fgets function, 6045
floor function, 6043
fmod function, 6043
fopen function, 6045
fputc function, 6045
fputs function, 6045
fread function, 6046
free function, 6047
freopen function, 6045
frexp function, 6043
fseek function, 6045
fsetpos function, 6046
ftell function, 6046
fwrite function, 6046
getc function, 6046

Index

WinCC Professional V13.0
System Manual, 02/2014 8199



getenv function, 6046
gmtime function, 6048
isalnum function, 6041
isalpha function, 6041
isdigit function, 6041
isgraph function, 6041
islower function, 6041
isprint function, 6042
ispunct function, 6042
isspace function, 6042
isupper function, 6042
isxdigit function, 6042
labs function, 6046
ldexp function, 6043
ldiv function, 6046
localtime function, 6048
log function, 6043
log10 function, 6043
malloc function, 6047
memchr function, 6044
memcmp function, 6044
memcpy function, 6044
memmove function, 6044
memset function, 6044
mktime function, 6048
modf function, 6043
pow function, 6043
putc function, 6046
qsort function, 6047
rand function, 6046
realloc function, 6047
remove function, 6046
rename function, 6046
rewind function, 6046
setbuf function, 6046
setvbuf function, 6046
sin function, 6043
sinh function, 6043
sqrt function, 6043
srand function, 6046
strcat function, 6047
strchr function, 6047
strcmp function, 6047
strcpy function, 6047
strcspn function, 6047
strerror function, 6047
strftime function, 6048
strlen function, 6047
strncat function, 6047
strncmp function, 6047
strncpy function, 6047
strpbrk function, 6047

strrchr function, 6047
strspn function, 6047
strstr function, 6047
strtod function, 6046
strtok function, 6047
strtol function, 6047
strtoul function, 6047
system function, 6047
tan function, 6043
tanh function, 6043
time function, 6048
tmpfile function, 6045
tmpnam function, 6045
tolower function, 6042
toupper function, 6042
ungetc function, 6046
vfprintf function, 6046
vsprintf function, 6046

C text lists
Configuration steps, 3418
Create entry, 3419
Use, 3417

CA certificate, 650, 653, 654, 8125
CA group certificate, 654
Cabling rules (PROFINET), 1041, 6221, 6302, 6387
CALC, 1961, 2239
Calculate, 1536, 1578, 1961, 2239
CALCULATE, 1536, 1578
CalculateStatistic, 5781
CalibrateTouchScreen, 4601, 4805
Calibrating, 1242

Overview, 1241
Call hierarchy, 1273
Call structure, 1742

 Meaning of symbols, 1744
Displaying, 1746
Introduction, 1742
Setting view options, 1747
Structure, 1745

Callback to a number specified during connection 
establishment, 8107
Calling FAQs for a module, 517
Calling manuals for a module, 517
calloc function, 6047
CAN_DINT, 2824
CAN_TINT, 2818
Cancel

Connection to the faceplate type, 3499
Canceling a calibration, 1244
Canceling printing, 424
Caption property (VBS), 5255
CaptionBackColor property (VBS), 5256
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CaptionColor property (VBS), 5257, 5258
CaptionText property (VBS), 5258
CaptionTop property (VBS), 5259
Cascaded counting function, 1155
CASE, 2558
Catalog, (see Hardware catalog)
CCTMTimeSync.exe, 7485

Startup list, 7485
CD, 1936, 2216
CEIL, 2049, 2331, 2539
ceil function, 6043
CellCut property (VBS), 5259
CellSpaceBottom property (VBS), 5260
CellSpaceLeft property (VBS), 5261
CellSpaceRight property (VBS), 5261
CellSpaceTop property (VBS), 5262
CenterColor property (VBS), 5262
CenterSize property (VBS), 5263
Central formatting of date and time

Runtime settings, 7075
CentrePoint property (VBS), 5263
CentrePointLeft property (VBS), 5264
CentrePointTop property (VBS), 5264
Certificate, 651, 703, 6595, 7461

Exporting, 650
Importing, 650
Importing on HTTP client, 6595, 7461
Installing on devices, 6595, 7461
Installing under Windows XP, 6595, 7461
Renewing, 653
Replace, 654
Replacing, 654
self-signed, 653
signed by certificate authority, 653

Certificate authority, 650, 651
Certificate manager, 651
change

Recipe data record in Runtime, 4215
Change, 4769
Change layout, 4784
Change property time axis, 4779
Change ruler, 4784
Change slider, 4790
Change the CP type of a channel unit, 6465
Change the logical device name of a channel unit, 
6465
Change video format, 4796
Change word order

Modicon MODBUS TCP/IP, 6715
ChangeConnection, 4684, 4806
ChangeMouseCursor property (VBS), 5265
Changeover contact, 1191

Changeover contact sensor type, 1190
Changing

Displayed name of user group, 4392
Logoff time in runtime, 4407
Name of the user, 4407
Object property, 4500
Object size, 3347, 4336
Password, 4390
User group in runtime, 4408
Users, 7110, 7112, 7113, 7114

Changing a port interconnection
Graphic view, 635

Changing and displaying operating mode (example), 
4504
Changing the configuration online, 8022
Changing the device configuration online, 8022
Changing the name

Authorization, 4392
User group, 4391
Users, 4390

Changing the PROFIBUS connection
Operating mode, 6545

Changing the PROFINET connection
Operating mode, 6545

Changing windows, 7068
Channel diagnostics, 3561
Channel DLL SIMATIC S7-300/400, 6459
ChannelDiagnose object, 5007
Char

Array tag, 70
CHAR, 1346, 1387, 1413
CHAR_TO_, 1413
Character, 1346, 1347
Character string, 1347, 1349

Combining character strings with CONCAT, 2660
Comparing string tags with S_COMP, 2638
Converting from a hexadecimal number with HTA, 
2657
Converting number to character string with 
VAL_STRG, 2642
Converting numeric character string with 
STRG_VAL, 2640
Converting to a hexadecimal number with ATH, 
2655
Converting with S_CONV, 2639
Copying characters to character string with 
Chars_TO_Strg, 2647
Deleting characters with DELETE, 2662
Determine maximum length with MAX_LEN, 2648
Determining length with LEN, 2659
Finding a character with FIND, 2665
Inserting characters with INSERT, 2663

Index

WinCC Professional V13.0
System Manual, 02/2014 8201



Reading out left character with LEFT, 2660
Reading out middle character with MID, 2661
Reading out right character with RIGHT, 2661
Replacing character with REPLACE, 2664

Characters, 37
Charging condition, 3570

Operation, 3571
Chars_TO_Strg, 2647
Check whether project can be migrated, 150
CheckBox object, 5008
Checking

Device version, 6967
Checking the AS with STEP 7, 6462
Checking the bus system, 6462
Checking the connection, 3273
Checklist for troubleshooting the modem, 8149
CheckMarkAlignment property (VBS), 5267
CheckMarkCount property (VBS), 5267
Checksum, 4009, 7252

Audit Trail, 3771, 4021, 7250
Log, 3759, 3771, 4021, 7250
Updating WinCC , 3771, 4021

Circle, 3565
Design, 3356
Fill level, 3356
Radius, 3565

Circle object, 5011
CircleSegment object, 5013
Circular log, 4009

Select size, 3765
CircularArc object, 5016
CJ1, 6754
CJ2, 6754
Class of Service, 918
Cleaning project for migration, 152
ClearAlarmBuffer, 4620, 4808
ClearAlarmBufferProTool, 4621, 4808
ClearAlarmBufferProtoolLegacy, 4621, 4808
ClearDataRecord, 4618, 4809
ClearDataRecordMemory, 4619, 4810
cleared, 4768
clearerr function, 6046
ClearLog, 4617, 4811
ClearOnError property (VBS), 5268
ClearOnFocus property (VBS), 5269
Click, 4782
Click toolbar button, 4790
Click when flashing, 4782
Client

Configuring, 6587
Deactivating a server project, 7493
Enabled remote server project, 7492

Parameters, 6588
Shutdown, 7480
Startup, 7480
Tags, 6591

Client/server
Runtime settings, 7473, 7475

Client/server system
Characteristics in Runtime, 7477
Response in Runtime, 7478
Shutting down the client, 7480
Shutting down the server, 7479
Starting up the client, 7480
Starting up the server, 7479

Clients, 7370
Clock, 3636

Display, 3636
Display dial, 3636
Length of the pointer, 3636
Width of hands, 3636

clock function, 6048
clock functions

asctime function, 6048
Clock memory, 1087, 1109
Clock object, 5018
Closable property (VBS), 5270
CloseAllLogs, 4642, 4812
Closing

Runtime, 7058, 7079
CMP <, 1947, 2226
CMP <=, 1943, 2223
CMP <>, 1939, 2219
CMP ==, 1937, 2217
CMP >, 1945, 2225
CMP >=, 1941, 2221
Code templates

inserting in user-defined functions, 4441
Coil, 1861

Negate, 1862
Color

Diagnostics of Ethernet cables, 1209
Diagnostics of ports, 1209

Color of individual ranges
Gauge, 3649

Color property (VBS), 5270, 5271
Color settings

Migrate, 239
Color transition

Bar, 3519, 3521
ColorChangeHysteresis property (VBS), 5272
ColorChangeHysteresisEnabled property (VBS), 
5273
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Column
Alarm view, 3581, 3587

Column property changed, 4776
ColumnColor(i) property (VBS), 5276
ColumnDisplayName(i) property (VBS), 5276
ColumnResize property (VBS), 5277
ColumnScrollbar property (VBS), 5278
ColumnSizingEnable property (VBS), 5277
ColumnTitle property (VBS), 5280
ColumnTitleAlign property (VBS), 5279
ColumnUpdateEnabled(i) property (VBS), 5280
Comfort Panel

Area pointer, 6184
Deleting HMI device images, 6972
Display and operating element, 3511
Interface, 6183
S7-1200, 81

Comfort Panels
Available system functions, 4547

Command property (VBS), 5281
Command table technology object

 Tools, 7849
Add new object, 7850
Basic parameters, 7851
Command table configuration, 7853
Command.Command[1...32] tags, 7955
Configuration window icons, 7851
Configuring activate warnings, 7853
Configuring duration, 7855
Configuring position / travel path, 7854
Configuring the command type, 7853
Configuring the next step, 7855
Configuring the step code, 7855
Configuring use axis parameters of, 7853
Configuring velocity, 7854
Extended parameters, 7851
General configuration, 7852
Usage, 7849

CommandText, 7659
Comment, 4069

Area pointer, 6164
Comments

Audit Trail, 7256
Electronic signature, 7256
For alarms, 3916
Inserting in SCL program, 1630

Commissioning
HMI device, 7045

Common alarm classes, 3900
CommonTimeAxisColor property (VBS), 5281
Communication, 1114, 6118, 6787

Basics, 6119

between HMI devices, 6585
Configuring, 6608
Definition, 6118
OPC, 6599
Routing, 6604, 6606, 6608
Runtime settings, 6586, 6599
S7 1200, 6281
S7 1500, 6198
S7 200, 6503
S7 300, 6367
S7 400, 6367
SIMATIC LOGO!, 6532
Third-party drivers, 6625
using area pointers, 6125
via raw data tags, 4259
WinAC MP, 6784

Communication drivers, 6125
Allen-Bradley, 6628
Basic Panel, 6170
Mitsubishi, 6676
Modicon Modbus, 6710
Omron, 6744
Panel, 6175

Communication load, 1087
Communication network, 6143

PROFINET, 6144
Communication partners

HMI device, 6118
Networking, 6147
PLC, 6118
SIMATIC S7, 6271, 6359, 6450, 6509, 6512

Communication types
Allen-Bradley, 6633
Connectable PLCs, 6718, 6730
Enabled, 6681, 6698, 6717, 6729, 6749
Ethernet/IP, 6633
Restriction, 6717, 6729

Communication via PUT/GET instructions
Basic information on PUT/GET instructions, 617
Creating and assigning parameters to a 
connection, 622
Deleting an interconnection, 623
Overview of connection configuration, 618
Requirements, 617
Starting connection parameter assignment, 621

Communications
Cycle load, 1092

Communications instruction
"AS_DIAL", 8139, 8140
"AS_MAIL", 8142
"PG_DIAL", 8138, 8139
"SMS_SEND", 8141
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Communications load, 1092
Communications module (CM), 3127
Communications modules, 1100

Properties, 1100
Communications parameters

Ethernet, 6790, 6791
PROFIBUS DP, 6794, 6795
ProSave, 6790, 6794
WinCC, 6791, 6795

Communications port
Configuring, 1101

Communications protocol
Defining, 1104
Overview, 1103

Compact, 6720, 6734
CompactLogix, 6636
Company level, 7370
Comparator operations

Time tags, 2622
Compare

Bit mask, 2120, 2405, 2611
Character strings with S_COMP, 2638
Equal, 1937, 2217
Greater or equal, 1941, 2221
Greater than, 1945, 2225
Less or equal, 1943, 2223
Less than, 1947, 2226
Not equal, 1939, 2219

Compare editor
Changing the view, 404
Filtering the view, 399
Overview, 392
Showing and hiding columns, 398
Specifying actions, 402

Compare offline/online
Automatic device assignment, 639

Compare scan matrix, 2122, 2407, 2613
Comparing, 51
Comparing library objects, 442
Compatibility, 44, 7547, 7563

Backward compatibility of projects, 359
Global libraries from older product versions, 455
Projects from older program versions, 359
Projects with add-on software, 360
S7-1200 CPU firmware versions, 1137
WinCC version, 6959, 6961

Compatibility mode, 3696
Compile

Block, 1712
Compiling

Address parameters, 81
Blocks, 1710

Consistency check, 1710
Correcting compilation errors, 1714
Migrated project, 171
Project, 6977, 7004

Complex user view
Configuring, 3522

Components
Alarm, 3910
Commissioning, 6647, 6667, 6692, 6702, 6723, 
6736, 6756

Compressed log, 3788, 3796, 4158
Configuring, 3796
How it works, 3788

Compressed tag, 3778
Compression, 3789
Computer properties, 4484
CONCAT, 2660
Configuration, 7370, 7374

Analog logging tag, 3800
Binary logging tag, 3798
Compressed log, 3796
Compressed tag, 3798
Data log, 3794
DP slave, 1004
DP slave, simple, 995
Hardware, 520
Large data log, 3804
Large log, 3804
Loading to device, 1050
Loading to PG/PC, 1051
Log, 3794
Logging tag, 3798
Process-controlled tag, 3798
Remote, 7489
Tag, 3693
WebNavigator, 7496

Configuration control, 1169, 1181
Configuration file

Menu, 3663
Toolbar, 3663

Configuration mode, 874
Configuration PC

Ethernet, 6788
HMI device , 6788, 6793
PROFIBUS DP, 6793
Starting Runtime, 6992, 7015, 7055, 7077
WinCC Runtime, 6205, 6227, 6290, 6310, 6376, 
6397, 6410

Configuration phase, 7044
Configuration rights, 658
Configure a PROFIBUS subnet

Matching parameters to one another, 555
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Setting bus parameters, 555
Configure acknowledgment

Alarm message, 6256, 6341, 6436, 6530, 6542, 
6674, 6708, 6742, 6761

Configure alarms
Allen-Bradley, 6673
Data types, 6707
Non-integrated connection, 6707
Special considerations, 6707

Configure the correct AS network address, 6461
Configured

Loop-in-alarm, 3956
ConfigureTimeAxis(i) property (VBS), 5282
Configuring, 3927, 3945, 3946, 3949, 3961, 4201

 Recipe view , 4251
Access protection, 4422
Alarm, 3937
Alarm acknowledgment, 3998, 3999, 4001
Alarm annunciator, 3991
Alarm group, 3920
Alarm log, 4013, 4024, 4026
Alarm statistics, 3982
Alarm view, 3964, 3977
Alarm view filters, 3979
Alarm view for logged alarms, 3968, 4018
Alarms, 6255, 6435, 6529, 6541
Analog alarm, 3923, 3937, 3959
Analog alarm limits, 3945, 3949
Analog alarms, 3912, 3913
Animation, 4179
Authorization, 4414
Connections, 6265, 6266, 6272, 6350, 6352, 
6359, 6440, 6442, 6444, 6452, 6503, 6533
Controller alarms, 3912, 3913
Customized C function, 4463
Data export from the alarm view, 3993
Data source of the table view, 3842, 3855
Data source of the trend view, 3842, 3855
Discrete alarm, 3926, 3958
Discrete alarms, 3912, 3913
Display of S7 diagnostic alarms, 3967
Evaluating alarms in Runtime, 3994
Event, 4178, 4183
Event-driven tasks, 3925, 3941
Function list, 4437
HART variable, 1189
Historical alarm list (long-term) , 3992
Historical alarm list (short-term), 3992
HMI connection, 6205, 6208, 6287, 6290, 6373, 
6376
HMI device as OPC DA server, 7550
HMI device as OPC DA Server, 7551

I-slave, 1005
Layout of the alarm view, 3966
Linking a log backup, 4031
Local script at event, 4472
Logging tag, 3774, 3814
Multiple tags, 3693
OPC XML DA server in the OPC XML Manager, 
7557
Project-wide alarm class, 3917
Recipe screen, 4201
Recipe view, 4196, 4199
Rectangle, 3394
Selection in table display, 3853
Server, 6586
Sorting a table column, 3854, 3866
System events, 3912, 3913
Table elements, 3852, 3865
Table view, 3849
Time axis, 3839
Toolbar and status bar in the alarm view, 3978
Trend, 3842
Trend view, 3837
Trend view for logging, 3826
Trend view for values from the PLC, 3818, 3825
Trigger user alarm, 3951
User-defined VB function, 4454
Value axis, 3840
Value column, 3851
Value table, 3863
WinCC OPC A&E server, 7589
WinCC OPC Client, 7555, 7605
WinCC OPC UA Server, 7603
X axis, 3840

Configuring a connection
Allen-Bradley DF1, 6648
Allen-Bradley EtherNet/IP, 6629
Mitsubishi FX, 6693
Mitsubishi MC TCP/IP, 6677
Modicon Modbus RTU, 6724
Modicon Modbus TCP, 6711
Omron Host Link, 6745
OPC, 6599

Configuring a filter
for fixed character string, 3973
Historical alarm list (long-term) , 3992
Historical alarm list (short-term) , 3992

Configuring a PROFIBUS subnet
Meaning of the bus parameters, 556

Configuring a tag
HTTP client, 6589
HTTP server, 6587

Configuring internal subnets manually, 753
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Configuring IP network nodes manually, 752
Configuring MAC network nodes manually, 753
Configuring the Control Panel

PROFIBUS DP, 6788
Configuring the network with Ethernet, 560, 6216, 
6297, 6384

Creating private subnets, 562, 6217, 6298, 6385
Linking networks, 562, 6217, 6298, 6385
Relationship between IP address and subnet 
mask, 561, 6216, 6297, 6384
Setting the IP address, 561, 6216, 6297, 6384
Setting the subnet mask, 561, 6216, 6297, 6384

Configuring the remote modem, 8103
Configuring the sorting

Historical alarm list (long-term) , 3992
Historical alarm list (short-term), 3992

Connecting, 3812
Alarm log, 4032
Log backup, 3812
PLC, 6633, 6680, 6697, 6716, 6749

Connecting a TS Adapter with an external modem, 
8103
Connecting a TS Adapter with an internal modem, 
8103
Connecting cable

6XV1440 - 2P for Mitsubishi PG protocol, 6698
Allen-Bradley cable 1784-CP10, 6657
Mitsubishi FX, 6697

Connecting cable 9-pole
Sub D, RS 422, 6656

Connecting cables
Point-to-point cable 1, 
Point-to-point cable 2, 6732

Connection, 567, 580, 6124
Address details, 1257
Allen-Bradley DF1, 6648, 6652
Allen-Bradley EtherNet/IP, 6629
Area pointer, 6162, 6167
Change after migration, 183, 227
Configuring, 6148, 6152, 6417, 6629, 6648, 6677, 
6693, 6711, 6724, 6745
Configuring a connection when there is no or no 
clear network assignment, 572
Connecting to server, 7309
Creating, 599, 6148, 6152
Deleting, 602
Establishing connection to the server, 7309
Highlighting, 6150
Integrated, 6148
integrated connection, 3680, 6159
Migrate, 225
Mitsubishi MC TCP/IP, 6677

Modicon, 6728
Modicon Modbus RTU, 6724
Modicon Modbus TCP, 6711
offline, 6243, 6328, 6424, 6518
Omron communication drivers, 6757
Omron Host Link, 6745
Parameters, 6631, 6650, 6678, 6695, 6713, 6726, 
6747
Password, 6218, 6232, 6237, 6299, 6315, 6320
S7 200, 6503, 6533
Table, 6147

Connection cable
Allen-Bradley cable 1747-CP3, 6658
Allen-Bradley cable 1761-CBL-PM02, 6659
Modicon, 6728
Multipoint cable 1:MP/TP/PC, 6751
Multipoint cable 2:RS422, MP/TP/PC, 6752
Omron Host Link, 6749
Point-to-point cable PP2 for Omron, 6752, 6753

Connection configuration
Connection parameters, 595
Overview, 592
Starting, 598

Connection description
Changing parameter values, 611
Data block , 605, 608, 609
Structure, 605, 608, 609

Connection details, 1257
Connection diagnostics

Detailed, 1255
Overview, 1253

Connection information, 1255
Diagnostics, 6132

Connection mechanisms, 1114
Connection modes, 820
Connection parameter assignment of PUT/GET 
instructions, 621
Connection parameters

Allen-Bradley DF1, 6650
Allen-Bradley EtherNet/IP, 6631
Mitsubishi FX, 6695
Mitsubishi MC TCP/IP, 6678
Modicon Modbus RTU, 6726
Modicon Modbus TCP, 6713
Omron Host Link, 6747
Runtime Professional, 6276

Connection parameters of PUT/GET instructions, 
620
Connection resource, 567, 580
Connection resources

Online, 1256
Connection rules, 768, 777
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Connection status
Displaying using icons, 1254

Connections
Allen-Bradley DF1, 6653
Configuring, 6265, 6266, 6272, 6350, 6352, 6359, 
6440, 6442, 6444, 6452, 6503, 6533
Editor, 6265, 6266, 6272, 6350, 6352, 6359, 6440, 
6442, 6444, 6452

ConnectionString, 7637
ConnectionType property (VBS), 5283
Connectivity Pack, 7630

Archive Connector, 7630
MS OLE DB Provider, 7630
OPC, 7630
WinCC OLE DB Provider, 7630

Connector, 3637
Connector object, 5020
ConnectTrendWindows property (VBS), 5283
Consistency

Slot rules, 522
Consistency check, 749, 1747, 1748, 1753

Introduction, 1747, 1753
local, 649
project-wide, 650

Consistency check before migration, 151
Constant

Data types, 1298
Definition, 1296
Global constant, 1297, 1298, 1299, 1435, 1436, 
1439
Local constant, 1297, 1298, 1299, 1491, 1497, 
1506
Non-typed constant, 1296
Symbolic constant, 1297
Typed constant, 1296

Context filter, 523
ContinousChange property (VBS), 5284
CONTINUE, 2565
Control Data

Application, 4346
Layout, 4346

Control element
 f(t) trend view, 3543
Alarm view, 3584, 4038, 7161
Alarm window, 4038, 7161
f(x) trend view, 3546
HTML Browser, 3558
Media Player, 3577
Recipe view, 3599, 3601
Simple alarm view, 4041, 7164
Status/Force, 3618
Table view, 3632

Trend view, 3569
Control Hardcopy

Application, 4347
Layout, 4347

Control Information
Application, 4348
Layout, 4348

Control panel
- assigning parameters, 6793
Transferring data, 6788, 6789

Control tag
Communication between the recipe and the PLC, 
4232

Control tags
Example, 4287

Controller alarm, 3891, 3892, 3894
System-defined, 3896

Controller alarms
Configuring, 3912, 3913
System-defined, 3891, 3893

Controller data, 6865
Initializing, 6864, 6866

ControlLogix, 6636
Controls

Migrate, 238
WinCC MediaControl, 5068

ControlSmartServer, 4674, 4813
Control-timer alarm, 2113, 2116, 2398, 2401, 2604, 
2607
ControlWebServer, 4674, 4814
Conversion, 1369

Explicit, 1389, 1390, 1396, 1398, 1399, 1401, 
1403, 1405, 1406, 1408, 1409, 1410, 1411, 1412, 
1413, 1414
Explicit , 1391, 1393
Implicit, 1372, 1373, 1374, 1375, 1376, 1377, 
1378, 1379, 1380, 1381, 1382, 1383, 1384, 1385, 
1386, 1387, 1388

Conversion operations
Converting timers with T_CONV, 2623

Convert, 2046, 2328, 2537
CONVERT, 2046, 2328, 2537
Converted name (PROFINET), 1028
Converting

A character string to a hexadecimal number with 
ATH, 2655
Character string in array with Ctrl_TO_Chars, 
2645
Character strings with S_CONV, 2639
Converting number to numeric character string 
with VAL_STRG, 2642
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Converting numeric character string to number 
with STRG_VAL, 2640
Converting timers with T_CONV, 2623
Copying characters to numerical character string 
with Chars_TO_Strg, 2647
Hexadecimal number to character string with HTA, 
2657

Converting an unspecified CPU, 262
Cookie, 800
Coordinated transfer, 4173

With PLC, 4173
Coordination, 6125
Copy

Recipe data record in runtime, 4214
Screen, 3309
Tag, 3692
Template, 3317

Copy protection, 1728
Copying

Adjusting screen size, 6930
Alarm class, 6945
Alarm group, 6946
Alarm indicator, 66
Alarm view, 66
Alarm window, 66
Analog alarm, 6943
Authorization, 6954
Color, 6927
Connection, 6937
Cycle, 6951
Data log, 6947
Discrete alarm, 6942
Excel format, 6828
Font, 6927
Function key, 6930
Graphics list, 6953
Hardware component, 537
HMI device, 60
Invalid object, 6927
Linked objects, 6928, 6929
Logging tag, 6947
Principle, 6925, 6926, 6932
Report, 6952
Report object, 6951
Restrictions, 6934
Scheduled task, 6955
Screen, 6930
Screen object, 6934
Structural element, 6939
Structure type, 6940
Tag, 6937
Text list, 6953

User group, 6954
User-defined folders, 6926
Users, 6954
VB script, 6949

CopyRows, 5782
Corner points, 3596
Corners, 3595
CornerStyle property (VBS), 5284
CoS, 918

Queue, 918
COS, 1986, 2266, 2476
CoS (Class of Service), 835
cos function, 6043
cosh function, 6043
Cosine, 1986, 2266, 2476
Count

Down, 1922, 1932, 1936, 2201, 2211, 2216, 2449, 
2456
Up, 1919, 1930, 1935, 2198, 2209, 2446, 2454
Up and down, 1924, 1928, 2204, 2451, 2458
Up and Down, 2207

Count (8 DI NAMUR), 1153
Count property (VBS), 5286
CountDivisions property (VBS), 5286
COUNTER, 1363, 1928, 2458
Counter input, 1096
Counter mode, 1096
Counter operations

Control high-speed counters, 2998
High-speed counters, 2998

Counter, high-speed, 1095
Counting

Up, 2214
CountOfElements, 2037, 2319, 2528
CountSubDivisions property (VBS), 5287
CountValueColumns property (VBS), 5287
CountVisibleItems property (VBS), 5288
Cover page

Placeholder for document information, 419
CP 1242-7, 47, 817
CP 1613, 39
CP 1623, 39
CP 343-2, 46
cp_TagStatistic, 7661
CP1, 6754
C-PLUG

Formatting, 908
CPM, 6754
CPU

Displaying the current LED status, 1219
Fill level of all types of memory, 1220, 1221
Inserting a signal board, 786
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Properties, 1086
Reading date and time-of-day with RD_SYS_T, 
2628
Reading out a diagnostics buffer, 1223
Selecting from the hardware catalog, 529
Setting time-of-day with WR_SYS_T, 2627
Switching operating mode, 1229

CPU control panel
Display area, 1220

CPU data block
Definition, 1266
Deleting, 1469

CPU firmware, 1137
CPU load through trace, 8078
CPU memory area

Displaying, 1757
CPU properties, 1087
CPU type

Allen-Bradley DF1, 6662
Allen-Bradley EtherNet/IP, 6636
FX3 series, 6686
Mitsubishi FX, 6700
Mitsubishi MC TCP/IP, 6686
Modicon Modbus RTU, 6734
Modicon Modbus TCP, 6720
Omron Host Link, 6754

Create
Connection, 6283
Faceplate type, 3483
Global library, 6815
Group, 3379
Recipe data record on the HMI device, 4214
Report, 4306
Screen, 3308
Template, 3315
Users, 4388
Users in runtime, 4404

Create entry
C text lists, 3419

Create script
Faceplate type, 3504

Create text
C text lists, 3419

CREATE_DB, 2912
CreateTagSet-Methode, 5783
Creating, 4189

Alarm group, 3920, 3921
Alarm log, 4008
Alarm log , 4013
Array, 3724, 3727
Button, 3662
Configuration file, 3663

Connection, 6148, 6152, 6200, 6369
Connection to an OPC UA Server, 7554
Connection to OPC DA server, 7553
Customer control, 7615
Customized C function, 4463
Cycle, 3737, 3740
Data log, 3762
External tag, 3685
Hierarchical alarm groups, 3921
Info text, 3941, 3949
Infotext, 3925, 3927, 3945
Internal tag, 3687
Main menu command, 3660
Menu item, 3660
OPC connection, 7604
Program code for customer control, 7614
Project-wide alarm class, 3917
Recipe, 4189, 4237
Recipe data record, 7126, 7127, 7140
Recipe data record on the HMI device, 4209, 
4210
Recipe query, 4245
Screen, 3307
Submenu command, 3660
Test form, 7617
Toolbar, 3661
User group, 4386, 4387, 4424
User interface, 7613
User-defined VB function, 4454
Users, 4425, 7101, 7104, 7106, 7107, 7108

Creating a new project, 6460
Creating a new type

Style, 6826
Creating a print preview, 420
Creating a route, 746
Creating a type

Screen, 6825
Script, 6824

Creating a watch table, 1775
Creating an analog logging tag, 3800
Creating binary logging tag, 3798
Creating custom documentation, 355
Creating labels, 425
Crossing

Definition, 1553
Deleting, 1555
Inserting, 1554
rearranging, 1554

Cross-reference
Inspector window, 67

Cross-reference list, (See cross-references), (See 
cross-references)
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Displaying, 1761, 6877
Overview, 1761, 6877
Settings, 1759, 6877
Sorting columns, 1759, 6877
Structure, 1759, 6877
Views, 1759, 6877

Cross-references
Displaying, 1761, 6877, 6879
Introduction, 1758, 6876
Linking, 6879
Replace, 6879
Uses, 1758, 6876

CS1, 6754
csv file

Example, 3822, 4068
Layout, 3822, 4068

CSV file, 6829, 6830, 6832, 6833, 6850
Audit Trail, 7249
Structure for tabular output, 4315
Structure for trend output, 4312

CSV provider table
CSV file structure, 4315
Use in report, 4350

CSV provider trends
CSV file structure, 4312

CTD, 1922, 2201, 2449
ctime function, 6048
CTRL

Key, 7089
CTRL_HSC, 2998
CTRL_PWM, 2880
CTU, 1919, 2198, 2446
CTUD, 1924, 2204, 2451
ctype functions

isalnum function, 6041
isalpha function, 6041
isdigit function, 6041
isgraph function, 6041
islower function, 6041
isprint function, 6042
ispunct function, 6042
isspace function, 6042
isupper function, 6042
isxdigit function, 6042
tolower function, 6042
toupper function, 6042

CU, 1935, 2214
Cu10 sensor, 1177
CurrentColumnIndex property (VBS), 5288
CurrentCurveIndex property (VBS), 5289
Cursor Control, 7070

Runtime settings, 7070

Cursor key, 7088
Cursor mode

Defining, 3387
CursorControl property (VBS), 5290
CurveColor(i) property (VBS), 5291
CurveLineWidth(i) property (VBS), 5291
CurvesCount property (VBS), 5292
CurveUpdateEnabled(i) property (VBS), 5292
Custom alarm classes, 3899, 3900
Custom alarm groups, 3906
Customer control, 7606

Creating, 7615
Creating program code, 7614
Setting a reference, 7611

Customer controls
 testing, 7617

customized
Menu, 3655
Toolbar, 3655

Customized C function, 4427
Rename, 4466
Validity range, 4461

Customized VB function, 4427
Rename, 4456

CutRows, 5784
Cycle, 3783

Creating, 3737, 3740
Define starting point, 3741
Online delta load, 62

Cycle load, 1092
Cycle monitoring time, 2574
Cycle time, 1087, 1091

display configured, 1213
display measured, 1218

Cycles
Migrate, 250

Cyclic
Continuous, 3715
In operation, 3715

Cyclic interrupt, 1122
Cyclic interrupt OB

Assigning parameters, 1131
Description, 1122
Querying parameters with QRY_CINT, 2812
Setting parameters with SET_CINT, 2810

Cyclic operation, 6452, 6512, 6538
Cyclic program execution

Options for interrupting, 1115
Programming, 1115

Cyclic triggers, 6094, 6102, 6106, 6110, 6113, 6116
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D
D_ACT_DP, 2707
DangerRangeColor property (VBS), 5293
DangerRangeStart property (VBS), 5294
DangerRangeVisible property (VBS), 5294
Data

External data in reports, 4310
Data areas

Area pointer, 6165, 6765
Reading, 6165, 6765
Writing, 6165, 6765

Data backup, 124
HMI device, 7026

Data bit (DBX), 1074
Data block

Adjusting data values during commissioning, 
1651, 1663, 1664, 1665
ARRAY data block, 1264, 1267, 1303, 1306, 1450, 
1640, 1643, 1663
Based on a PLC data type , 1649
CPU data block, 1266
Creating, 1450, 1643
Creating with CREATE_DB, 2912
Declaration table, 1641
Declaring ARRAY, 1647
Declaring STRUCT, 1648
Default value, 1649
Deleting with DELETE_DB, 2919
Displaying values, 1662
Global data block, 1264, 1640
Importing and exporting tags, 1661
Instance data block, 1265, 1640
Loading block changes without reinitialization, 
1645
Monitoring data values online, 1661
Optimized access, 1267, 1269
Programming, 1640, 1646
Reading attributes with ATTR_DB, 2918
Reading from load memory with READ_DBL, 
2914
Retentive behavior, 1652, 1653
Start value, 1649, 1650
Tag properties, 1654, 1656, 1657
Updating, 1644
Using setting values, 1651, 1663, 1664, 1665
Writing to load memory with WRIT_DBL, 2916

Data buffer, 3789
Data byte (DBB), 1074
Data consistency, 3190
Data double word (DBD), 1074

Data Encryption Standard (DES), 705
Data exchange, 6118

DP slave, 995
I-slave - DP master, 996
Tags, 6124
Trends, 6253, 6337, 6433, 6527, 6539, 6670, 
6704, 6738, 6758
using area pointers, 6125

Data exchange over the AS-AS remote link
Communication instruction "AS_DIAL", 8139

Data flow, 7120
Data Flow, 4166
Data flow control, 1102
Data format differences

between SIMATIC and Microsoft, 4268
Data log, 791, 3794, 4155, 4158

Acquisition cycle, 3758
Closing with DataLogClose, 2905
Configuring, 3794
Configuring the size, 3804
Creating, 3762
Creating with DataLogCreate, 2891
Creating with DataLogNewFile, 2908
Creating with DataLogTypedNewFile, 2910
Deleting with DataLogDelete, 2907
Empty with DataLogClear, 2901
Fast, 3810
Logging cycle, 3758
Name, 3763, 3796, 3797
Opening with DataLogOpen, 2898
Opening with DataLogTypedOpen, 2899
Output of the tag value, 3824
Processing method, 3783
Slow, 3810
Tags, 3760, 3766
Term definitions, 3776
Tolerance band, 3766
Writing with DataLogWrite, 2903

Data logging, 3757, 3777
Application, 3757, 3777
Basics, 3777
Configuration, 3777
Cyclic, 3785
Cyclic-selective, 3786
How it works, 3777
Memory medium, 3758
On demand, 3787
On value change, 3787

Data mailbox
For recipes, 4173

Data Monitor
Runtime settings, 7291, 7520
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Data record, 6125
Asynchronously reading data record of a module 
with RD_DPARA, 2802
Exporting, 4218
Importing, 4218
Making available on I-device with PRVREC, 2724
Reading, 4210, 4216
Reading from configured system data with 
RD_DPARM, 2804
Reading of a module with RD_DPAR, 2800
Reading with RD_REC, 2712
Reading with RDREC, 2674
Receiving on I-device with RCVREC, 2721
Recipe, 4230
Transfer, 4211, 4217
Transferring with WRREC, 2676
Writing and reading data records, 2798
Writing predefined parameters with WR_DPARM, 
2806
Writing with WR_REC, 2716

Data record list, 4176, 7121
Data transfer settings, 6793
Data type, 3678, 3689

 Convert explicit, 2328, 2537
 Explicit conversion, 2046
Allen-Bradley, 6672, 6673
Allen-Bradley EtherNet/IP, 6634
ANY, 1358
ARRAY, 1351, 1352
BOOL, 1324, 1372, 1389
BYTE, 1325, 1373, 1390
CHAR, 1346, 1387, 1413
Conversion, 1369, 1375, 1384, 1385, 1386
DATE, 1342, 1386, 1410
DINT, 1332, 1380, 1403
Discrete alarm, 6673, 6707, 6760
DT, 1344
DTL, 1345, 1385, 1412
DWORD, 1327, 1375, 1393
Explicit conversion, 1389, 1390, 1391, 1393, 
1396, 1398, 1399, 1401, 1403, 1405, 1406, 1408, 
1409, 1410, 1411, 1412, 1413, 1414
Format adjustment, 3689
Implicit conversion, 1372, 1373, 1374, 1376, 
1377, 1378, 1379, 1380, 1381, 1382, 1383, 1385, 
1387, 1388
INT, 1330, 1378, 1399
Internal tag, 3683, 3684, 6161
LDT, 1345
LINT, 1333
LREAL, 1337, 1383, 1408
LTIME, 1341

LTIME_OF_DAY, 1343
LWORD, 1327
Mitsubishi, 6707
Mitsubishi FX, 6699
Mitsubishi MC TCP/IP, 6685
Modicon Modbus RTU, 6733
Modicon Modbus TCP, 6719
Omron, 6759, 6760
Omron Host Link, 6753
PLC data type, 1364, 1667
POINTER, 1356
REAL, 1336, 1382, 1406
S5TIME, 1339
SCL instruction, 1615, 1616, 1617
SINT, 1328, 1376, 1396
STRING, 1347, 1388, 1414
STRUCT, 1355
TIME, 1341, 1384, 1409
TIME_OF_DAY, 1343
TOD, 1385, 1411
Trend, 6672
UDINT, 1332, 1381, 1405
UINT, 1331, 1379, 1401
ULINT, 1335
USINT, 1329, 1377, 1398
Valid, 6634, 6685, 6699, 6719, 6733, 6753
Validity, 1320
VARIANT, 1361
WCHAR, 1347
WORD, 1326, 1374, 1391
WSTRING, 1349

Data type conversion, 49
Data types, 274

Migration, 201, 253
Mitsubishi FX, 6706
Mitsubishi MC TCP/IP, 6706
Modicon Modbus RTU, 6740
Modicon Modbus TCP/IP, 6740
OPC DA, 6601, 6603
OPC UA, 6602
OPC XML DA, 6602, 6604
S7 200, 6532
S7 300/400, 6439
S7-1200, 6349
S7-1200 V1, 6349
S7-1500, 6263
Trends, 6255, 6339, 6435, 6529, 6541
Valid, 6263, 6349, 6439, 6532, 6601, 6602, 6603, 
6604

Data word (DBW), 1074
DataConnector, 7630
DataIndex(i) property (VBS), 5295
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DataItem object, 4951
DataLogClear, 2901
DataLogClose, 2905
DataLogCreate, 2891
DataLogDelete, 2907
DataLogNewFile, 2908
DataLogOpen, 2898
DataLogs object, 4952
DataLogTag property (VBS), 5296
DataLogTypedNewFile, 2910
DataLogTypedOpen, 2899
DataLogWrite, 2903
DataMonitor, 7268

General operation, 7301
Log off from server, 7302
Start Page, 7299
Starting the Client, 7299
WebCenter, 7269

DataMonitor client
Installing, 7279
License, 7275
Start, 7299

DataMonitor server
Installing, 7277
License, 7275

DataMonitor Server
Logging off from, 7302

DataSet object (list), 4954
DataX(i) property (VBS), 5297
DataXY(i) property (VBS), 5298
DataY(i) property (VBS), 5298
Date, 1342, 1344, 1345
DATE, 1342, 1386, 1410
Date/time, 6125

Area pointer, 6321
Date/time field, 3527

Application, 4351
Display system time, 3527
Format, 3528
Layout in reports, 4351, 4352
Using tags, 3528

Date/time PLC, 6125
DATE_AND_LTIME, 1345
DATE_AND_TIME, 1344
DATE_TO_, 1410
DateTimeField object, 5023
DB, 1450, 1643
DB variable

Definition, 1295
DB_ANY_TO_VARIANT, 2549
DCAT, 2113, 2398, 2604
DCP (Primary Setup Tool), 671

DCP server, 874
Deactivate, 4773
Dead peer detection (DPD), 711
Deadband

Setting, 3924, 3940
Debugger, 4484

Activating in WinCC, 4484
Closing, 4481
Error types, 4475, 4483, 7000, 7022
Opening after error message, 4484
Opening automatically, 4484
Starting, 4481, 7001
starting for user-defined functions, 4484
Windows, 4473, 7000, 7021
Windows CE, 4473, 7000, 7021

DEC, 1972, 2252
Decimal place, 7084
Decimal places, 40, 1992, 2273, 2481
DECO, 2093, 2377, 2585
Decode, 2093, 2377, 2585
DecreaseFocusedValue, 4683
DecreaseTag, 4683, 4743, 4815, 4884, 5901
Decrement, 1972, 2252
Default font, 6905
Default language

Runtime settings, 7064
Default style

Defining, 3332
Defective devices, 1202
Defective license, 109, 125
Define

Bar segment, 3521
Cursor mode, 3387
Reference object, 3349, 4338
Scale gradation on the bar, 3521

Define hotkey, 3609
Defining, 3773, 4023

For the assignment list, 1739
Text format, 3586

Delay time
Setting, 3924, 3940

Delete
Recipe data record, 7131
Template, 3317
Users, 7117

DELETE, 2662
Delete key, 7089
DELETE_DB, 2919
DeleteDataRecord, 4618, 4809
DeleteDataRecordMemory, 4619, 4810
DeleteDate(i) property (VBS), 5299
DeleteEnable property (VBS), 5299
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DeleteRows, 5786
Deleting

 Report page, 4318
Authorization, 4392
Filter in the assignment list, 1739
Hardware component, 536
Local script at event, 4472
Local script at object property, 3453, 4473
Object, 3345, 4331
OPC XML DA server in the OPC XML Manager, 
7557
Recipe data record, 7142
Recipe data record in runtime, 4215
Screen, 3309
Tag, 3692
User group, 4392
Users, 4391, 7116

Deleting a category
Faceplate type, 3487

Deleting a connection, 266
Deleting a property

Faceplate type, 3487
Deleting CA certificates, 8130
Delta transfer, 7011
Demultiplex, 2100, 2384, 2591
DEMUX, 2100, 2384, 2591
Dependencies of rights, 660
Dependency structure, 1749

Introduction, 1749
Meaning of symbols, 1751
Setting view options, 1752
Structure, 1750

Dependency structure 
Displaying, 1751

DES, 699, 705
Deserialization, 2482
Deserialize, 2000, 2281, 2482
Design

Applying design templates to controls, 3326
Applying layout specifications to basic elements 
and elements, 3325
Applying screen-specific layout templates, 3325
Applying the layout specifications of a design, 
3324
Changing, 3323
Creating, 3322
Delete, 3323

Designation
TS Adapter, 8101, 8109, 8117

Designing a background, 3355
Designing a border, 3355

Designs
Default design for screens, 3326

Destruction of license keys, 108
DETACH, 2809
DetachDB, 5787
Detail page

Adding to report, 4318
remove from report, 4318
Report, 4296, 4298
Sorting, 4318

Detailed comparison
Performing, 400
Starting, 1687
Visualization of the comparison result for GRAPH, 
1698
Visualization of the comparison result for LAD/
FBD, 1688
Visualization of the comparison result for SCL, 
1695
Visualization of the comparison result for STL, 
1692

Details view, 325
Determine diagnostics status, 1222
Determining time of day, 1230
Device

Adding to a hardware configuration , 531
Copying, 60, 537
Defective devices, 1202
Deleting, 536
Inserting, 6120
Moving, 538
Renaming, 638

Device address, 781
Device dependency

SIMATIC S7-1500 V1.0, 6258
Device information, 410, 1202

Diagnostics, 6132
Device name, 1022, 1028

Changing by the migration, 222
Device name, automatic commissioning 
(PROFINET), 1024
Device number, 1023
Device overview

Address range, 781
Device proxy

Initializing, 6871
Updating, 6869, 6874

Device replacement, 539
Device Tool, 1048, 1049
Device type

Changing, 6786
Device version, 7030
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Checking, 6967
Switching, 6966

Device view
Area of unplugged modules, 528
Edit parameters, 540
Edit properties, 540
Hardware and network editor, 506, 6134
Inserting a signal board, 785
Inserting module, 533
Racks, 524

Device wizard, 6802, 6804
Devices

Connecting, 6124
Networking, 6123, 6147

Devices & Networks, 6123, 6147
Devices and networks, 6123, 6147

Connections, 6148
Devices & Networks, 6308
HMI connections, 6148

DeviceStates, 2867
DHCP

Client, 887
Server configuration, 747

DHCP server, 748
Diagnose repeater, 1250
Diagnostic data

Reading out with GET_DIAG, 2875
Diagnostic error interrupt, 1125
Diagnostic interrupt OB, 1125
Diagnostics, 714, 1164, 4482, 4493, 4494

Alarm class, 3967
Connection, 6132
Connection information, 6132
Debugger, 4482
Device, 6132
Device information, 6132
DP slave, reading diagnostic data with 
DPNRM_DG, 2732

Diagnostics buffer
Basics, 1077, 1245
Organization, 1245

Diagnostics status
Determining and displaying online, 1203

Diagnostics user, 656
Diagnostics:GSC Diagnostics, 4494
Diagnostics:Inserting GSC diagnostics window in a 
screen, 4494
Diagonal movement

Animation, 3430
DialColor property (VBS), 5300
DialFillStyle property (VBS), 5300
Dialing rules in phone books, 8098

Dialog fonts
Runtime settings, 7051

DialSize property (VBS), 5301
dial-up connection

Establishing, 8122
Terminating, 8124

Differences
Runtimes, 6931

Diffie-Hellman key agreement, 704
difftime function, 6048
DINT, 1332, 1380
DINT , 1403
DINT_TO_, 1403
Direct access to the I/O, 1078
Direct key, 6544, 6551, 6568, 7082

Assigning the inputs/outputs, 6551, 6568
configuring, 3466, 6546
KP 1500 Comfort, 6565, 6582
KP1200 Comfort, 6564, 6582
KP700 Comfort, 6562, 6580
KP900 Comfort, 6563, 6581
KTP400 Comfort, 6561, 6579
Mobile Panel 177, 6558, 6576
Mobile Panel 277, 6559, 6577
Mobile Panel 277 IWLAN V2 , 6560, 6578
Multi Panel 277 , 6556, 6574
Multi Panel 377, 6557, 6575
Multi Panel 177 , 6554, 6572
OP 277, 6553, 6571
OP 177B, 6552, 6570
OP 77B, 6569
PROFIBUS DP, 6565, 6566, 6567
PROFINET IO, 6548, 6549, 6550
TP 177, 6553, 6571
TP 277, 6554, 6572
TP1200 Comfort, 6564, 6582
TP1500 Comfort, 6564, 6583
TP1900 Comfort, 6564, 6583
TP2200 Comfort, 6564, 6583
TP700 Comfort, 6562, 6580
TP900 Comfort, 6563, 6581

Direction output and travel direction
relation, 7805

Direction property (VBS), 5301
DirectKey, 4578
DirectKeyScreenNumber, 4581
DIS_AIRT, 2837
DIS_IRT, 2834
Disabling

Project language, 6886
Disabling program switching

Runtime settings, 7051
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Disconnecting
Alarm log, from project, 4032
Log backup, 3813

Discrete alarm, 3890, 3891, 3892, 3893
Allen-Bradley, 6673
Configuring, 3926, 3958
Mitsubishi, 6707
Omron, 6760
Parameter output , 3947
Structure for the import, 6848

Discrete alarm types, 3890, 3891, 3892
Discrete alarms

Configuring, 3912, 3913
DiskSpaceView object, 5025
display

Infotext, 7087, 7090, 7093
Display

HMI backup, 6968
Limit lines on the bar, 3521

Display , 3984
Display Caption property (VBS), 5256
Display classes, 3896
Display dial, 3636
Display format, 7084, 7091

I/O field, 3534
Display mode

Ruler window, 3862
Statistics area window, 3862
Statistics window, 3862

Display number, 3600
Display object

Availability, 3517
Availability for Basic Panels, 3508
Availability for Comfort Panels, 3511
Availability for Mobile Panels, 3514
Availability for Multi Panels, 3512
Availability for Panels, 3509
Availability for WinCC Runtime Advanced, 3515

Display on the PLC
Runtime settings, 7051

Display PDF files, 105
Display peak value

Gauge, 3648
Display peak value pointer property (VBS), 5557
Display program status

S7-GRAPH Overview, 3606
Display suppression

Define duration, 3987
Display suppression mask, 3984, 4121
Display suppression tag, 3984, 4121

of a customized group alarm, 4121

Display suppression timeout
Defining, 3987

Display system time, 3527
Display Welcome Tour, 105
Displaying

 Call structure, 1746
Assignment list , 1737
CPU memory area, 1757
Cross-reference, 6879
Cross-references, 1761, 6877
Dependency structure , 1751
Load memory, 1758
Maximum load memory available, 1758
Program information, 1733

Displaying a force table, 1803
Displaying alarms, 1060
Displaying memory types of a CPU, 1220, 1221
Displaying or hiding tag information, 1549, 1590, 
1618
Displaying support for a module, 517
Displaying the online status, 8027
Displaying values

As a trend, 3818
DisplayName(i) property (VBS), 5302
DisplayOptions property (VBS), 5302
Distribute

Objects evenly, 3351, 4340
Distributed I/O, 993, 1162
Distributed operator stations

Configure SmartClient, 7434
Configure SmartServer, 7434
configuring, 7434

Distributed system
Remote configuration, 7489

DIV, 1968, 2247
div function, 6046
Divide, 1968, 2247
DMSK_FLT, 2832
DNS client, 878
DO, 2560, 2562
Documentation editor

Layout, 415
Documentation settings 

Using frames and cover pages, 413
Domain-global user group, 7060
Double T-piece, 3528
Double word, 1327
double-click, 4774
DoubleClickAction property (VBS), 5303
Download, (See Loading to device)

Error messages, 7040
Project, 6985, 7009, 7044
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via USB, 6988
Downloading

Downloading blocks to a memory card, 1724
Downloading blocks to device, 1720, 1721

Downloading data to the PLC
Error message, 81

DP, 6235, 6318, 6403
DP interface, 998
DP master, 780, 1148

Add DP master system, 1001
Devices and modules, 998
Disconnection from DP master system, 1001
Display on DP slave, 1000
DP interface, 998

DP master system
Add DP slave, 1003
Creating, 994, 997, 998
Determining topology with DP_TOPOL, 2735
Disconnect DP slave, 1003
Disconnection from subnet, 1001
Edit properties, 1002
Highlight, 1000
Node disconnection, 1001

DP slave, 780
Activating and deactivating with D_ACT_DP, 
2707
Add to DP master system, 1003
Assign DP master system, 1003
configuring, 1004
Configuring, 995
Data exchange, 995
Disconnect from DP master system, 1003
DP master display, 1000
Hardware catalog, 994
Intelligent, (See I-slave)
Networking, 997
Reading diagnostic data with DPNRM_DG, 2732
Synchronizing groups with DP_SYC_FR, 2726
Types, 1002
With preprocessing, (See I-slave)

DP standard slave, 1016
DP standard slaves

Reading a portion of the inputs with 
GETIO_PART, 2679
Reading all inputs with GETIO, 2678
Reading consistent data with DPRD_DAT, 2717
Writing a part of the outputs with SETIO_PART, 
2680
Writing all outputs with SETIO, 2679
Writing consistent data with DPWR_DAT, 2719

DP/DP coupler, 994
DP_TOPOL, 2735

DPNRM_DG, 2732
DPRD_DAT, 2717
DPSYC_FR, 2726
DPV1

Configuring an ET 200S, 1014
DPWR_DAT, 2719
DrawAlwaysInsideFrame property (VBS), 5304
DrawEnhancedHTMLBrowser property (VBS), 5304
DrawInsideFrame property (VBS), 5305
DrawStylishButton property (VBS), 5306
Drive property (VBS), 5306
DRUM, 2110, 2395, 2601
DSCP, 918
DST

Daylight saving time, 892
DT, 1344
DTL, 1345, 1385, 1412
DTL data type

Restriction, 77
DTL_TO_, 1412
Dual-mode acknowledgment, 3903
Duration, 1339
DWORD, 1327, 1375, 1393
DWORD_TO_, 1393
Dynamic

Migrate, 236
Dynamic logon, 4384, 4393
Dynamic reference temperature, 1184
Dynamic time range, 3833
Dynamization

Color of an object, 3428
Control enable state of an object, 3432
Flashing, 3428
Object, 3420
Object property, 3420
Object property with a local script, 3453, 4473

Dynamize
Appearance of an object, 3428
Direct movement, 3431
Faceplate, 3500
Faceplate type, 3500
Green arrow in Overview, 3427
Movement of an object, 3429
Object appearance, 4149
Property animation, 3436
Property list, 3424
Quality Code, 3436, 3447
Tag binding, 3434

E
EB, 1425
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EC31-RTX, 46
ED, 1425
Edge

Negative, 1870, 1872, 1875, 2147, 2149, 2152, 
2417
Positive, 1869, 1871, 1873, 2146, 2148, 2151, 
2416

EdgeStyle property (VBS), 5307, 5308
Edit, 5787

Object within a group, 3384
Recipe, 6834

Edit networking
Disconnecting from a network, 552

Editable text field, 3536
Editable(i) property (VBS), 5309
EditAlarm, 4574, 4816
EditEnabled property (VBS), 5310
Editing

Alarm, 7167
Folder link, 3376
Function list, 4439
OPC XML DA server in the OPC XML Manager, 
7557
Recipe data record, 7129, 7130, 7141
System event, 3931, 3953

Editing a version of a type in testing, 479
Editing language, 366, 6882

Selecting, 6886
Editing networking

Copying a subnet, 552
Copying subnets and devices, 553

EditOnFocus property (VBS), 5310
Editor

Connection, 6152
Connections, 6265, 6266, 6272, 6350, 6352, 
6359, 6440, 6442, 6444, 6452
Designs, 3320, 3321
Devices and networks, 6150
Graphics, 6896

Effective range, 6061, 6074, 6077, 6079
Calculating signal quality, 3645
Configure effective range object, 6085
Configuring, 6083
Configuring logoff, 6084
Configuring logon, 6084
Logoff, 3642
Logon, 3641
Override function, 3645
Principle of Operation, 6062
Runtime, 6077
Work area, 6075

Effective range (RFID), 6077

Configuring, 6086
Configuring logoff, 6087
Configuring logon, 6087
Overview, 6085
Runtime, 6079
Work area, 6077

Effective range name, 3640
Effective range name (RFID), 3642
Effective range signal, 3644
Effective range (RFID)

Logoff, 3644
Logon, 3643

Effective ranges editor, 6074, 6077
Effects in runtime

Audit Trail, 7253
Effects in Runtime

Recipe data change, 7258
Value changes to GMP-relevant tags, 7256

Electronic signature, 7227
Element list, 4176, 7121
Elements

in reports, 4308
Ellipse

Horizontal radius, 3537
Vertical radius, 3538

Ellipse , 3537
Ellipse object, 5027
Ellipse segment, 3539
EllipseSegment object, 5029
Elliptical arc, 3538
EllipticalArc object, 5032
ELSE, 2556, 2558
ELSIF, 2556
E-mail

Transferring e-mail with TM_MAIL, 3290
Transferring e-mail with TMAIL_C, 3230

E-Mail
Setting at the HMI-device, 7402

E-mail attachment
Report, 7358

E-mail notification, 3962, 7439
Configuring, 7440
Setting up the trigger, 7440

Emergency acknowledgement, 4063, 7183
Empty box

Inserting a LAD element, 1528
Inserting an FBD element, 1570

EN/ENO mechanism
Basics, 1415
FBD example, 1418
LAD example, 1418
SCL example, 1419
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STL example, 1420
EN_AIRT, 2838
EN_IRT, 2836
Enable autonegation, 1040, 6220, 6301, 6386
Enable output ENO, 279
Enable sorting

Alarm view, 3581
Enabled property (VBS), 5311, 5312
Enabling

Reporting, 3996, 3997
S7 diagnostic alarm, 3933

Enabling the firewall
SCALANCE S, 738, 740

Enabling tunneled communication
CP x43-1 Adv., 761
SCALANCE S, 738, 740

ENCO, 2094, 2378, 2586
Encode, 2094, 2378, 2586, 4576, 4817
EncodeEx, 4577, 4817
Encryption, 644
Encryption software, 112, 116
End angle

Circular arc, 3566
Ellipse segment, 3540
Elliptical arc, 3539

End Angle
Circle segment, 3568

END key, 7088
End of detection of accessible devices, 1042
End of discovery of accessible devices, 6222, 6303, 
6388
End of sync domain, 1042, 6222, 6303, 6388
End of topology discovery, 1042, 6222, 6303, 6388
END_CASE, 2558
END_FOR, 2560
END_IF, 2556
END_REPEAT, 2564
END_WHILE, 2562
EndAngle property (VBS), 5314
Endian, 2518, 2520, 2522, 2523
ENDIS_PW, 2071, 2354, 2569
EndPoint property (VBS), 5315
EndPointLeft property (VBS), 5315
EndPointTop property (VBS), 5316
EndStyle property (VBS), 5316, 5317
EndTime(i) property (VBS), 5317
Energy-saving mode, 6089
Engineering station

Starting Runtime, 6992, 7015, 7055, 7077
Engineering system

Performance features, 7185
Enhanced Recipe View, 7121

ENO, 279
ENTER key, 7089
Entering

Alphanumerical value, 7086, 7092
Input field, 7083
Numerical value, 7084, 7091
Parameters in user-defined functions, 4440

Entry on the HMI device
By means of function key, 7090

Enumeration types, 802
Enumerations

Web server, 804
EQ_ElemType, 1955, 2234
EQ_Type, 1953, 2232
Equal, 1958, 2236
EQUAL ARRAY, 1960, 2238, 2463
Error

Logical error, 4475, 4483, 7000, 7022
Runtime error, 4475, 4483, 7000, 7022

Error alarm
Acknowledge, 7165

Error analysis with RET_VAL, 1854
Error codes during connection fault, 6469
Error codes for connection fault, 6460
Error handling, 1639

Basics, 1635
GetError, 2077, 2360, 2575
GetErrorID, 2080, 2364, 2578
Local error handling, 1637

Error information, 1637, 1854, 2077, 2080, 2360, 
2364, 2575, 2578
Error message

Downloading data to the PLC, 81
Error messages

Download, 7040
Error status, 853
Error xx occurred in 'function name' function!, 6460, 
6499
ESC key, 7089
ESP protocol, 705
Establishing a connection from a remote system 
("PG_DIAL"), 8138
Establishing a remote connection, 8122

Procedure, 8123
ET 200eco, 1146
ET 200eco PN, 1146, 1162
ET 200iSP, 1146
ET 200iSP distributed I/O station

Definition, 1148
ET 200L, 1146
ET 200M, 1146, 1188

Definition, 1187
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ET 200MP, 1179
ET 200pro, 1146
ET 200R, 1146
ET 200S, 1146

DPV1 mode, 1014
Option handling, 1010, 1013
Positioning module, 46
Reference junctions, 1006
Slot rules, 1006

ET 200S COMPACT, 1146
ET 200SP, 1168

Application area, 1168
ET 200M distributed IO device, 1187
Ethernet, 560, 562

Parameters, 6271, 6274, 6356, 6361, 6362, 6448, 
6454, 6507, 6537

ETHERNET
Basic Panel, 6172

Ethernet interface
Displaying parameters, 8038

Ethernet module
Removal/insertion, 43

Ethernet non IP frames, 663
Ethernet Statistics

Frame length, 862
Frame type, 863
Interface statistics, 861
Packet Errors, 863, 864

Ethernet/IP
Allen-Bradley, 6642

Event
 Block property changed, 4775
 Lock changed, 4791
 Operator input alarm property changed, 4774
 Status changed, 4792
Acknowledge, 4788
activate, 4769
Alarm buffer overflow, 4786
Alarm statistics column property changed, 4776
Assigning organization block (OB) with ATTACH, 
2808
Boundary reached, 4788
Canceling assignment to organization block (OB) 
with DETACH, 2809
Change, 4769
Change layout, 4784
Change property time column, 4779
Change ruler, 4784
Change slider, 4790
Change video format, 4796
cleared, 4768
Click, 4782

Click toolbar button, 4790
Click when flashing, 4782
Column property changed, 4776
Configuring, 4178, 4183
Deactivate, 4773
double-click, 4774
Dynamize, 3425
Execute, 4770
Exit full screen, 4797
For function lists, 3713
Free space critically low, 4797, 7240
Full screen, 4796
In the alarm range, 4781
In the tolerance range, 4781
In the warning range, 4782
Incoming, 4781
Input finished, 4780
Inspector window, 67
Loaded, 4770
Loop-In-Alarm, 4785
Low free storage space, 4797, 7239
Medium closed, 4787
Medium opened, 4786
Menu, 3667
Move mouse, 4786
Object changed, 4787
Outgoing, 4781
Overflow, 3768, 4794
Pause, 4788
Play ended, 4769
Press, 4774
Press ESC twice, 4780
Press key, 4793
Press key on keyboard, 4793
Press left mouse button, 4784
Press right mouse button, 4789
Property changed, 4775
Property diagram changed, 4775
release, 4785
Release key, 4793
Release key on keyboard, 4794
Release left mouse button, 4785
Release right mouse button, 4789
Replay, 4798
Runtime Stop, 4790
Screen change, 4772
Selection changed, 4770
Shortcut menu, 4783
Statistics area column name property changed, 
4777
Status bar element property changed, 4777
StepBack, 4791
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StepForward, 4791
Stop, 4792
Switch OFF, 4795
Switch ON, 4796
Tags, 3713
Time column property changed, 4779
Time expired, 4799
Toggle, 4795
Toggle toolbar, 4792
Toolbar, 3667
Toolbar button property changed, 4777
Trend property changed, 4776
User change, 4772
Value change, 4798
Value column property changed, 4778
Volume, 4783
When dialog is closed, 4772
When dialog is opened, 4771
When high limit is exceeded, 4770
When low limit is undershot, 4771
X-axis property changed, 4778
Y-axis property changed, 4779

Event name, 1132
Event trigger, 6095, 6104, 6112
Event-driven output

Report, 4319
Event-driven tasks

Configuring, 3941
Configuring:event-driven tasks, 3927, 3945, 3946, 
3949

Events, 3783
Configuration, 883
Log table, 852
Severity filter, 885
Start, 3783
Stop, 3783

EW, 1425
EX, 1425
Example

 Application for alarm classes, 3898, 3899
 Configuring a language switch (VBS), 4525
Accessing objects (C), 4524
Accessing objects (VBS), 4508
Changing and displaying operating mode, 4504
Communication, 6606
Controlling a conveyor belt, 1832, 1847
Controlling room temperature, 1838, 1845
Detecting the direction of a conveyor belt, 1834, 
1841, 1849
Detecting the fill level of a storage area, 1835, 
1842, 1850
Determining color of objects (C), 4524

For displaying bit memory in the assignment list, 
1735
For displaying inputs and outputs in the 
assignment list, 1735
For entering force values in the force table, 1806
Modify values in the watch table, 1779
System alarm, 3895
Triggering user alarm, 3951
User-defined function for temperature conversion, 
4500

Example C function in WinCC
 Writing tag values, 4527
Configuring a screen change via a property, 4526
Configuring diagnostic output via a trace, 4526
Deactivating Runtime, 4525
Reading tag values, 4527
Writing object properties, 4528

Example:
Discrete alarm, 3894
System event, 3896

Examples
C in WinCC, 4523
Configuring a language switch (VBS), 4509
Configuring a recipe view (VBS), 4519
Configuring a screen change via a property (VBS), 
4510
Configuring an alarm view (VBS), 4521
Configuring diagnostic output via a trace (VBS), 
4510
Controlling a conveyor belt, 1840
Deactivating Runtime (VBS), 4509
Determining color of objects (VBS), 4508
Evaluating tag values (VBS), 4522
Reading tag values (VBS), 4514
VBS in WinCC, 4507
Writing object properties (VBS), 4517
Writing tag values (VBS), 4512

Excel Workbook Assistant, 7343
Excel Workbook Wizard, 7343, 7354
Excel workbooks

Alarm Attributes, 7354
VBA functions, 7355

Excel Workbooks, 7272
Exchangeable medium, 1042
Exchanging, 6865
EXCLUSIVE OR, 2134, 2135

 Bit logic operations, 2134
Execute, 4770
Executing

User-defined functions in Runtime, 4495
Exit

User program, 2076, 2360, 2574
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EXIT, 2566
Exit full screen, 4797
exit function, 6047
EXP, 1984, 2264, 2474
exp function, 6043
Expanded mode, 1772
Expanding and collapsing sections of code, 1610
Exponential value, 1984, 2264
Exponentiate, 1994, 2274
Export, 5788

Alarm, 6835
Excel format, 6828
Project texts, 6863, 6893
Recipe, 4587, 4820, 6829, 6832
Runtime data, 4253
Tag, 6850
Text list, 6857
User administration, 4411

Export of labels, 425
Export of Runtime data

Configuring, 3845, 3858, 3866
ExportDataRecords, 4585, 4818
ExportDataRecordsWithChecksum, 4588, 4821
ExportDirectoryChangeable property (VBS), 5320
ExportDirectoryname property (VBS), 5320
ExportFileExtension property (VBS), 5321
ExportFilename property (VBS), 5321
ExportFilenameChangeable property (VBS), 5322
ExportFormatGuide property (VBS), 5323
ExportFormatName property (VBS), 5323
ExportImportUserAdministration, 4590, 4716, 4823, 
4886
Exporting

Recipe, 4218
Recipe data record, 4168, 4218, 7145

Exporting an NTP server, 695
ExportParameters property (VBS), 5324
ExportSelection property (VBS), 5324
ExportShowDialog property (VBS), 5325
Expression

Basics, 1596
Dynamize, 3436
Logical expression, 1601
Property animation, 3436
Relational expressions, 1600

Expression 
Arithmetic expression, 1597

EXPT, 1994, 2274
Extended download to device, 81
Extended status information, 1605
External, 49

External graphic
Edit folder, 3375
Link folder, 3376
Removing the folder link, 3375
Rename folder, 3375

External image file
add to graphics library, 6898
Managing, 3342
Storing in the image browser, 3377

External source file
Basics, 1676
Exporting blocks, 1678
inserting, 1679
Linking file types to an editor, 1680
Rules for programming, 1677

External sources, 49
External tags

Data exchange, 6124
ExtraSpaceForLabelDisplay property (VBS), 5327

F
f(t) trend view, 3541, (See trend view)

 Online configuration, 3846, 3859, 3867
Toolbar, 3543

f(x) trend view, 3544, 3547, (See trend view)
 Online configuration, 3846, 3859, 3867
Application, 4355
Rules for the data source, 3831
Toolbar, 3546, 3549

F_TRIG, 1877, 2154, 2417
fabs function, 6043
Faceplate, 3478

Cancel connection to faceplate type, 3499
Controlling properties dynamically, 3500
Create, 3502
Dynamically controlling included objects, 3507
Dynamize, 3500
Example, 3501
Faceplate type, 3478
Instance of the faceplate, 3478
Migrate, 230
Response to sizing, 3497

Faceplate type, 3478
 Deleting a property connection, 3486
Cancel connection, 3499
Create, 3483
Creating a tag, 3503
Defining properties, 3503
Deleting a category, 3487
Deleting a connection, 3486
Deleting a property, 3487
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Dynamic control, 3500
Edit, 3496
Enable, 3496
Event, 3482
Faceplate, 3498
Graphics list, 3483
Properties, 3482
Response to resizing, 3497
Script, 3483
Tag, 3482
Text list, 3483
Updating, 3496
Use, 3498
User text, 3483

Facility, 684
factory settings

Resetting to , 7029
Factory settings

Resetting to, 1233, 1234
FALSE, 2416, 2417
FAQs, 6142
Fault monitoring

Connection status change, 904
Power supply, 903
Redundancy, 904

Favorites
Adding, 1531, 1573, 1619
Hiding, 1479
Removing, 1533, 1574, 1620
Showing, 1479
Using, 1532, 1573, 1619

FB, 1263
FBD, 1557, 1840, 1841, 1842

Detailed comparison, 1688
Migration, 159

FBD element
Copying, 1582
Cutting, 1583
Deleting, 1588
Inserting, 1569, 1570
Inserting an operand , 1589
pasting from the clipboard, 1583
Replacing, 1584
Rules for inserting, 1567
Selecting, 1581

FBD network
Branch, 1592
Deleting a branch, 1593
Inserting a block call, 1533, 1575
Inserting a branch, 1593
Program status display, 1769
Rules for branches, 1592

FC, 1262
fclose function, 6045
FDA, 7225
Feedback

Optical, 7081
feof function, 6045
ferror function, 6045
FETCH/WRITE, 1114
fflush function, 6045
fgetc function, 6045
fgetpos function, 6045
fgets function, 6045
Field device, 1016, 1045
FieldLengthReadOnlySpecial property (VBS), 5327
FieldRead, 2007, 2287
FieldWrite, 2008, 2289
FIFO buffer, 3789

Basics, 3789
File Browser, 791
File format

Audit Trail, 7249
File sharing, 7059
Fill

Block, 2018, 2043, 2300, 2326, 2495, 2534
Block uninterruptible, 2020, 2302, 2496

FILL, 2043, 2326, 2534
Fill level, 3356
Fill style, 3620
FILL_BLK, 2018, 2300, 2495
FillColorMode property (VBS), 5329
FillPatternColor property (VBS), 5330
FillStyle property (VBS), 5331
Filter

Defining for the assignment list, 1739
Delete, 1739
Hardware catalog, 523
In the assignment list, 1739
Selecting, 1740

Filter property (VBS), 5332
Filtering

Alarm list:filter, 4051
the alarm view, 3973

Filtering alarms, 4051, 7172
Filters

Assignment list , 1740
FIND, 2665
Find and replace, 432

Additional options for searching, 433
Replacing search keys, 434
Start search, 434
Using the search function, 433
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Firewall
Creating service groups, 669, 671
Defining ICMP services, 668
Firewall rules, 663
Managing service groups, 669, 672
Under Windows, 7296, 7531

Firmware, 1137
Firmware card, 1071
Firmware update, 1231
Firmware update memory card, 1072
Firmware version V4, 37
First value alarm, 3904
FirstConnectedObjectIndex property (VBS), 5332
FirstConnectedObjectName property (VBS), 5333
Fixed aspect ratio, 3621
Fixed reference temperature, 1184
FixedAspectRatio property (VBS), 5333
Flash test, 1249
Flashing, 3368, 3428, 3937

Alarm text block , 3937
FlashingColorOff property (VBS), 5334
FlashingColorOn property (VBS), 5336
FlashingEnable property (VBS), 5337
FlashingRate property (VBS), 5338
FlashTransparentColor property (VBS), 5341
Flip, 3620

Object, 3342
Flip property (VBS), 5341
Flip-flop

Reset/set, 1867, 2145
Set/reset, 1866, 2143

Floating-point number, 1336, 1337
Check invalidity, 1952, 2231
Check validity, 1951, 2230

Floating-point numbers, 1338
Invalid , 1338

FLOOR, 2050, 2333, 2540
floor function, 6043
Flutter monitoring, 1191
fmod function, 6043
FocusColor property (VBS), 5342
FocusWidth property (VBS), 5343, 5344
Folder, 7059

Released folders, 7059
Folder link

Editing, 3376
Removing, 3376
Renaming, 3376

Font property (VBS), 5345
Font settings

Migrate, 180, 232
FontBold property (VBS), 5346

FontItalic property (VBS), 5347
FontName property (VBS), 5348
FontSize property (VBS), 5349
FontUnderline property (VBS), 5349
Footer

Report, 4296, 4298
fopen function, 6045
FOR, 2560
Force

Force all, 1820
Stop forcing, 1822, 1823

Force job
On SD card, 39

Force table
 Meaning of the icons, 1802
"Monitor once and now" command for tags, 1814
Basic mode, 1801
Display, 1803
Expanded mode, 1801
Functionality, 1798
Layout, 1800
Meaning of the columns, 1800
Monitoring and modifying modes, 1786
Opening, 1803
Overview of the display formats, 1807
Overview of the test options, 1798
Permitted operands, 1805
Permitted operands for force values, 1806
Saving, 1804
Switching between basic mode and expanded 
mode, 1801
Syntax check, 1804
Test options, 1798

Force value
Permitted operands, 1806

Forcing
Audit, 7252

Forcing tags
Safety precautions, 1800, 1816

ForeColor property (VBS), 5350, 5351
Foreground color

Dynamization, 3428
Form exponential value, 2474
Format, 3528
Format adjustment

Data type, 3689
Format DLL, 3778
FormatPattern property (VBS), 5352
FormatPatternReadOnlySpecial property (VBS), 
5353
Formatting

Alarm text, 3927
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Formatting codes
I/O field, 3534

FormatType property (VBS), 5353
fputc function, 6045
fputs function, 6045
FRAC, 1992, 2273, 2481
Fragment, 804, 810
fread function, 6046
free function, 6047
Free property (VBS), 5354
Free space critically low, 4797, 7240
Free-form comments

Deleting, 1540, 1581
Editing, 1538, 1580
Inserting, 1538, 1579
Introduction, 1537, 1579

FreePercent property (VBS), 5354
FreezeProviderConnections property (VBS), 5355
freopen function, 6045
Frequency meter, 1159, 1162
frexp function, 6043
fseek function, 6045
fsetpos function, 6046
ftell function, 6046
FTP, 658, 660, 1114
FTPS certificates, 650
Full screen, 4796
Function, 4427

 Unsupported functions, 7494
Assigning to a function key, 3461
Function list , 4441
Migrate, 242

Function (FC)
Creating, 1449
Definition, 1262
exporting to an external source file, 1678

Function block (FB)
Creating, 1449
Definition, 1263
exporting to an external source file, 1678
Instance data block, 1263

Function Block Diagram, 1557
Function key, 3456

Assigning a function, 3461
Assigning a graphic, 3464
Global assignment, 3458
Global screen, 3314
Local assignment, 3314, 3460
protect with password, 3463
Replacing devices, 6914
Use global assignment, 3314
used for screen navigation, 3468

Function keys
Global assignment, 7090
Local assignment, 7090

Function list, 3713, 4435, 6096
Asynchronous execution, 4497
Configuring, 4437
Converting to local script, 4472
Deleting local script, 4472
Editing, 4439
Execution in Runtime, 4496
Synchronous execution, 4496

Functional scope
ProSave, 7025

Functionality of the force table, 1798
Functions

Updating tag value, 3678, 6158
FunctionTrendControl

Online configuration, 4254
Runtime data, 4253

FunctionTrendControl object, 5038
fwrite function, 6046
FX1 series, 6700
FX2 series, 6700
FX3

PLC, 6682
FX3 series, 6686

G
Gadget, 7289, 7290, 7518, 7519
GADR_LGC, 2933
Gateway, 560
Gauge, 3647

Color of individual ranges, 3649
Display peak value, 3648
GMP-relevant tag, 3647
Maximum value, 3648
Minimum value, 3648
Normal range visible , 3648

Gauge object, 5046
GE Fanuc SNP

Migrating data types, 203
GEN_DIAG, 2873
General information on troubleshooting, 8145
General rules, 1278
Generating diagnostics information, 2873
Generation of packed addresses, 1009
GEO_LOG, 2929
GEO2LOG, 2922
Geographic coordinates, 876
GET, 3194
Get_AlarmState, 2841
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GET_DIAG, 51, 2875
Get_IM_Data, 2857
GET_NAME, 37, 2861
GetBlockName, 2667
GetBrightness, 4614, 4824
getc function, 6046
GetColumn, 5788, 5808, 5809, 5868, 5869, 5886, 
5887
GetColumnCollection, 5789
GetDataRecordFromPLC, 4609, 4825
GetDataRecordName, 4611, 4826, 4827
GetDataRecordTagsFromPLC, 4613, 4828
getenv function, 6046
GetError, 1638, 1639, 2077, 2360, 2575
GetError , 1637
GetErrorID, 1637, 1638, 1639, 2080, 2364, 2578
GetGroupNumber, 4613, 4829
GetHitlistColumn, 5792
GetHitlisteColumnCollection, 5791
GetInstanceName, 2666
GETIO, 2678
GETIO_PART, 2679
GetLanguageByLocaleID, 5905
GetLinkedTag, 5904
GetLocalScreen, 5903
GetMessageBlock, 5793
GetMessageBlockCollection, 5794
GetMessageColumn, 5795
GetMessageColumnCollection, 5801
GetMessageColumnCollection , 5797
GetOperatorMessage, 5796
GetOperatorMessageCollection, 5798
GetParentScreen, 5907
GetParentScreenWindow, 5908
GetPassword, 4614, 4829
GetPLCMode, 4615, 4720
GetPropBOOL, 5910
GetPropChar, 5911
GetPropDouble, 5913
GetPropLong, 5914
GetRow, 5800
GetRulerBlock, 5802
GetRulerBlockCollection, 5803
GetRulerColumn, 5805
GetRulerColumnCollection, 5806
GetRulerData, 5807
GetSelectionText property (VBS), 5355
GetStationInfo, 2864
GetStatisticAreaColumn, 5810
GetStatisticAreaColumnCollection, 5812
GetStatisticResultColumn, 5813
GetStatisticResultColumnCollection, 5814

GetStatusbarElement, 5815
GetStatusbarElementCollection, 5816
GetSymbolName, 2666
GetTagBit, 5917
GetTagBitState , 5924
GetTagBitStateQC, 5926
GetTagBitStateQCWait, 5929
GetTagBitStateWait, 5931
GetTagBitWait function, 5939
GetTagByte, 5917
GetTagByteState, 5924
GetTagByteStateQC, 5926
GetTagByteStateQCWait, 5929
GetTagByteStateWait, 5931
GetTagByteWait function, 5939
GetTagChar, 5917
GetTagCharState, 5924
GetTagCharStateQC, 5926
GetTagCharStateQCWait, 5929
GetTagCharStateWait, 5931
GetTagCharWait function, 5939
GetTagDouble, 5917
GetTagDoubleState, 5924
GetTagDoubleStateQC, 5926
GetTagDoubleStateQCWait, 5929
GetTagDoubleStateWait, 5931
GetTagDoubleWait function, 5939
GetTagDWord function, 5917
GetTagDWordState, 5924
GetTagDWordStateQC, 5926
GetTagDWordStateQCWait, 5929
GetTagDWordStateWait, 5931
GetTagDWordWait function, 5939
GetTagFloat, 5917
GetTagFloatState, 5924
GetTagFloatStateQC, 5926
GetTagFloatStateQCWait, 5929
GetTagFloatStateWait, 5931
GetTagFloatWait function, 5939
GetTagMultiStateQCWait function, 5919
GetTagMultiStateWait, 5921
GetTagMultiWait , 5922
GetTagRaw, 5918
GetTagRawState, 5924
GetTagRawStateQC, 5926
GetTagRawStateQCWait, 5929
GetTagRawStateWait, 5932
GetTagRawWait function, 5939
GetTagSByte, 5918
GetTagSByteState, 5924
GetTagSByteStateQC, 5926
GetTagSByteStateQCWait, 5929
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GetTagSByteStateWait, 5932
GetTagSByteWait function, 5939
GetTagSDWord function, 5918
GetTagSDWordState, 5924
GetTagSDWordStateQC, 5926
GetTagSDWordStateQCWait, 5929
GetTagSDWordStateWait, 5932
GetTagSDWordWait function, 5939
GetTagSWord, 5918
GetTagSWordState, 5924
GetTagSWordStateQC, 5927
GetTagSWordStateQCWait, 5929
GetTagSWordStateWait, 5932
GetTagSWordWait function, 5939
GetTagValue, 5933
GetTagValueStateQC, 5935
GetTagValueStateQCWait, 5936
GetTagValueWait, 5937
GetTagWord , 5918
GetTagWordState, 5924
GetTagWordStateQC, 5927
GetTagWordStateQCWait, 5929
GetTagWordStateWait, 5932
GetTagWordWait function, 5939
GetTimeAxis, 5817
GetTimeAxisCollection, 5819
GetTimeColumn, 5820
GetTimeColumnCollection, 5821
GetToolbarButton, 5823
GetToolbarButtonCollection, 5824
GetTrend, 5825
GetTrendCollection, 5826
GetTrendWindow, 5828
GetTrendWindowCollection, 5829
GetUserName, 4609, 4830
GetValue, 7465
GetValueAxis, 5830
GetValueAxisCollection, 5831
GetValueColumn, 5832
GetValueColumnCollection, 5833
GetXAxis, 5835
GetXAxisCollection, 5836
GetYAxis, 5837
GetYAxisCollection, 5838
Gigabit address, 653
Global assignment

Of a function key, 3456, 3458
Global C tags, 4461

Application, 4461
Definition, 4461

Global data block, 1264
Configuring, 6166

Creating, 6166
Retentive behavior, 1653

Global firewall rules, 664
Assigning, 666

Global libraries, 442
Archiving, 463
Backward compatibility with older product 
versions, 456
Compatibility mode V12 SP1, 455
Retrieving, 464

Global library, 6805
Adding types, 486
Archiving, 463
Cleaning up, 496
Closing, 461
Create, 6815
Creating, 454
Creating folders, 467
Deleting, 462
Displaying logs, 460, 6817
Migrating, 193
Open, 6816
Opening, 456
Save, 6816
Saving, 460
Showing properties, 459
Updating the project, 488
Upgrade, 6963
Using filter view, 469
Using the element view, 445
Using types, 487

Global packet filter rules, 666
Global screen, 3314

Function key, 3314
Template, 3315

Global softkey, 3458
Global tag, (See PLC tag)
GlobalColorScheme property (VBS), 5705
GlobalShadow property (VBS), 5706
GMP, 7225
GMP settings, 7254, 7258
GMP-relevant tag, 7254

Gauge, 3647
GMRP, 952
gmtime function, 6048
Go online, 1247

connecting several devices, 8028, 8029
Multiple TIA Portal instances, 43

Going offline, 1249
Good Manufacturing Process, 7225
GOTO, 2567
GoTo object, 4123
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GoToEnd, 4592, 4830
GoToHome, 4591, 4831
GPRS, 819
Gradation property (VBS), 5355
GRAPH

Detailed comparison, 1698
Migration, 160

GraphDirection property (VBS), 5356
Graphic

add to graphics library, 6897
Alignment, 3361
Assigning to a function key, 3464
Button, 3608
Distance, 3361
Graphic view, 3551, 4357
Inserting, 3343, 4330
managing, 3375
Size adjustment, 3361
Stretching, 3551, 3553, 4357
Using from the graphic browser, 3374
With transparent background, 3375

Graphic browser, 3374
Graphic browser , 6898
Graphic I/O field, 3552, 3553

Output graphics list, 3417
Scroll bar type, 3554
Use in reports, 4358

Graphic view, 3550, 4357
transparent color, 3551

GraphicIOField object, 5049
Graphics, 3377

Editor, 6896
Graphics list

Application, 3406
Bit (0, 1), 3414
Bit number  (0 - 31), 3416
Create, 3408
Creating, 3407
Graphic I/O field, 3417
Outputting configuration data, 3417
Range  (0 - 31), 3408
Range (... - ...), 3408, 3411, 3413

GraphicView object, 5052
GridBackColor property (VBS), 5357
GridlineColor property (VBS), 5357
GridLineWidth property (VBS), 5358
group

Cancel, 3381
Edit, 3379
Ungroup, 3381

Group
Adding objects, 3382

Cancel, 3381
Creating, 3379
Editing, 3379
Removing an object, 3383
Ungroup, 3381

Group acknowledgment, 7090
Group alarm

Display suppression tag, 4121
Group name, 667, 670
Group object, 5055
Group properties, 703
GSD files

Configuring devices (PROFIBUS), 1016
GSD revisions (PROFIBUS), 1015
Installation, 1016

GSD files (PROFINET), 1043
Changing revision, 1045
Installation, 1045

GSDML, (See GSD files (PROFINET))
GSM network, 819

H
Handshaking, 1103
Handwheel, 3555

Tag, 3555
Hardcopy

Layout in reports, 4359
Hardware, 51

Comparing, 37
Configuring and assigning parameters, 520
Detection, 46
Edit parameters, 540
Edit properties, 540
Requirement, 7499

Hardware acceleration
SmartServer, 7425

Hardware and network editor
Device view, 506, 6134
Network view, 503, 6128
Topology view, 508, 6136

Hardware and software limit switches
Function, 7809

Hardware catalog
Adding device, 531
Browsing, 523
DP slave, 994
DP/DP coupler, 994
I slave, 994
Selecting the hardware component, 529
Task card, 515, 6140
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Hardware configuration
Adding device, 531
Adding module, 533

Hardware configuration for Motion Control S7-1200, 
7800
Hardware data types, 1367
Hardware detection, 533
Hardware diagnostics, 1201
Hardware documentation, 8153
Hardware editor

Components, 502, 6126
Function, 501, 6126
Hardware catalog, 515, 6140
Inspector window, 6138
Inspector window , 513

Hardware identifier, 781, 1170, 1181
Determining with LOG2MOD, 2925

Hardware interrupt, 1123
How it works, 1084

Hardware interrupt OB
Description, 1123
Parameter assignment, 1132

Hardware requirements, 111
Communications instruction "AS_MAIL", 8143
Communications instruction "PG_DIAL", 8138
Communications instruction "SMS_SEND", 8141

Hardware requirements for AS-AS remote link
Communication instruction "AS_DIAL", 8140

Hardware support package
Installing, 131

Hardware version, 850
Hardware-controlled data flow control, 1102
Harmonizing

Object size, 3347, 4336
HART, 1150
HART variables

Configuring, 1189
Quality code, 1190
Structure, 1189

Header
Hide, 7302
Report, 4296, 4298
Show, 7302

Header file
Migrate, 244

Height property (VBS), 5359
Help

Browsing, 350
Call topic from favorites, 351
Delete topic from favorites, 352
Find keywords, 350
Full-text search, 350

Identification of help topics, 347
Open tooltip cascades automatically, 353
Opening, 349
Printing help topics, 352
Save topics in favorites, 351
Use index, 350

Help indicator, 3556
HelpText property (VBS), 5362
Hidden input, 3533
Hidden parameters, 1549, 1590
HiddenInput property (VBS), 5363
HideAlarm, 5840
HideTagNames property (VBS), 5363
Hiding

Report sections, 4319
Hierarchical alarm groups, 3906

Creating, 3921
Highlighting

Connection, 6150
HighLimitColor property (VBS), 5364
High-speed counter

Configuring, 1098
General, 1095
How it works, 1095

Historical alarm list (long-term)
Configuring a filter, 3992

Historical alarm list (long-term) 
Configuring, 3992
Configuring the sorting, 3992

Historical alarm list (short-term)
Configuring a filter, 3992
Configuring the sorting, 3992

Historical alarm list (short-term) 
Configuring, 3992

Hit list, 4054, 7175
Hit List of Alarms, 7340
HitlistColumnAdd property (VBS), 5364
HitlistColumnCount property (VBS), 5365
HitlistColumnIndex property (VBS), 5365
HitlistColumnName property (VBS), 5366
HitlistColumnRemove property (VBS), 5366
HitlistColumnRepos property (VBS), 5366, 5444
HitlistColumnSort property (VBS), 5367
HitlistColumnSortIndex property (VBS), 5367
HitlistColumnVisible property (VBS), 5368, 5445
HitlistDefaultSort property (VBS), 5368
HitlistMaxSourceItems property (VBS), 5369
HitlistMaxSourceItemsWarning property (VBS), 5369
HitlistRelativeTimeFactor property (VBS), 5370
HitlistRelativeTimeFactorType property (VBS), 5370
HitlistRelTime property (VBS), 5371
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HMI backup
Deleting, 6970
Display, 6968
Rename, 6970

HMI connection, 263, 580, 1114, 6124
Configuring, 6205, 6208, 6287, 6290, 6373, 6376
Creating, 6200, 6283, 6369
MPI, 6405, 6409, 6410
MPI parameters, 6412
Password, 6218, 6232, 6237, 6299, 6315, 6320
PC, 6205, 6227, 6290, 6310, 6376, 6397, 6410
PROFIBUS, 6224, 6227, 6228, 6308, 6310, 6390, 
6394, 6397
PROFIBUS parameters, 6230, 6313, 6399
PROFINET, 6199, 6200, 6202, 6205, 6208, 6282, 
6283, 6285, 6287, 6290, 6368, 6369, 6371, 6373, 
6376
PROFINET parameters, 6211, 6292, 6379
S7 1200, 6283
S7 1500, 6200
S7 300/400, 6369
SIMATIC PC, 6208, 6228, 6287, 6308, 6373, 
6394, 6409
WinCC RT Advanced, 6202, 6228, 6285, 6308, 
6310, 6371, 6394, 6409
WinCC RT Professional, 6202, 6227, 6228, 6285, 
6308, 6310, 6371, 6394, 6397, 6409, 6410
WinCC Runtime, 6202, 6285, 6371
WinCC RT Advanced, 6227, 6397, 6410

HMI connections
Devices & Networks, 6148

HMI device, 122
 WinCC Runtime Professional performance , 
7217
as OPC client, 7548
as OPC server, 7549
Changing the device type, 7042
Commissioning, 7045
Configuration, 6966
Data backup, 7022, 7023, 7024, 7026, 7028, 
7058
Image, 7022, 7023, 7024
Load, 6986, 7022, 7023, 7024
MPI parameters, 6414
Performance features, 7187, 7190, 7194, 7198, 
7202, 7205, 7210, 7214
PROFIBUS parameters, 6233, 6315, 6400
PROFINET parameters, 6212, 6294, 6380
Recommissioning, 7045
Reloading the operating system, 7029
Replacing, 6923
Reset to factory settings, 7031

Restoring data, 7026, 7028, 7058
Server, 6586
Software, 7022, 7023, 7024
System limits, 7187, 7190, 7194, 7198, 7202, 
7205
Transferring authorization, 6802
Transferring license key, 7032
Updating the operating system (Windows CE), 
7030
WinAC MP, 6787, 6797

HMI device configuration, 6966
HMI device dependency

in system function, 4444
HMI device image

Deleting, 6972
HMI device licensing

Non-PC-based, 122
HMI device on a PLC

Commissioning, 6647, 6667, 6692, 6702, 6723, 
6736, 6756

HMI device replacement, 61
by the migration, 177

HMI device type
Changing, 7042

HMI device version, 6923, 6966, 6967, (Device 
version), (Device version)
HMI device wizard, 6802, 6804
HMI HTTP protocol, 6583

Basics, 6583
HMI style, 6826
HMIRuntime, 4937
HMIRuntime object, 4937, 4956
HOME key, 7088
Homing

Homing modes, 7811
Horizontal radius, 3537

Ellipse segment, 3540
Elliptical arc, 3538

HorizontalAlignment property (VBS), 5372, 5373
HorizontalGridLines property (VBS), 5373
Hotkey, 7067

Defining, 7067
Hardcopy, 7067
Logging off, 7067
Logon, 7067

Hotkeys
Runtime settings, 7067

HourNeedleHeight property (VBS), 5374
HourNeedleWidth property (VBS), 5375
How the frequency meter works, 1160
HSC, 1095
HSP, (See support package)
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HTA, 2657
HTML Browser, 3557, 3559

Button, 3558
Connection to the FTP server, 3557, 3559
File explorer, 3557, 3559

HTML page
Displaying data type DATETIME, 7444

HTMLBrowserBack, 4594
HTMLBrowserForward, 4594
HTMLBrowserRefresh, 4593
HTMLBrowserStop, 4593
HTTP, 667, 6583

Load/save, 879
HTTP client, 7459

Configure HTTP-Connection, 7459
Configuring a tag, 6589
Configuring tags, 7460
Configuring the SIMATIC HMI HTTP protocol, 
7459
Importing certificates, 6595, 7461

HTTP connection
Client, 6587

HTTP protocol
Panel, 6175
Timeout, 6588

HTTP server
Configure WinCC-Project , 7457
Configuring a tag, 6587
Setting at the HMI-device, 7457
Setting up the WinCC Internet connections, 6592

HTTPS, 739, 790, 6583, 6585
HTTPS server only, 873
HW ID

See Hardware identifier, 781

I
I address, 781
I slave

Hardware catalog, 994
I&M data: read out with Get_IM_Data, 2857
I/O

Direct access to, 1078
I/O access error, 1076
I/O address, 781, 1078
I/O field, 3532

application in reports, 4353
Data format, 3533, 3534
Decimal format, 68
Display format, 3534
Display format in reports, 4354
Format, 68

Formatting codes, 3534
Hidden input, 3533
Lock/unlock, 97
Mode, 3532

I/O input, 1074
I/O output, 1074
I/Os, 1302
IB, 1425
ICMP, 673
Icon

For comparison, 1207
For comparison status, 1255
for connection status, 1254
For hardware diagnostics, 1206
for operating state, 1208
For software diagnostics, 1207
For value comparison, 7826, 7852
Overlay icon, 1208

Icons
in TeleService, 8093

Icons in the force table, 1802
Icons in the watch table, 1774
IconSpace property (VBS), 5376
ID, 1425
Identifying

Alarm class, 3581
I-device, 1031
IE/AS-i link PN IO, 1018
IEC check, 1369

Setting, 1372
IEC counters, 277
IEC timer, 1341
IEC timers, 277
IEEE 802.3, 663
IEEE tag, 1149
IF, 2556
IF1B

Basic Panel, 6172
IGMP, 952
IGMP querier, 952
IIS, (See Internet Information Service)
IKE settings, 703
Illuminated pushbutton, 3571

Tag, 3572
Image, 6966

HMI device, 7022, 7023, 7024
Image file

Storing in the image browser, 3377
Storing in the image browser , 6898

IMC, 2120, 2405, 2611
Import

Alarm, 6837, 6838
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Analog alarm structure, 6839, 6844
Project texts, 6862, 6895
Recipe, 6830, 6833
Structure of discrete alarms, 6842, 6848
Structure of recipe data, 6835
Tag, 6852
Tag data structure, 6855
Text list, 6859
User administration, 4413

ImportDataRecords, 4595, 4831
ImportDataRecordsWithChecksum, 4596, 4833
Importing

Recipe, 4218
Recipe data record, 4168, 4218, 7145

Importing a recipe
Structure for the import, 6835

Importing alarms
Structure for the import, 6848

Importing analog alarms
Structure for the import, 6839, 6844

Importing discrete alarms
Structure for the import, 6842, 6848

Importing NTP servers, 695
In the alarm range, 4781
in the screen

Arrange object, 3352, 4335
In the tolerance range, 4781
In the warning range, 4782
IN_RANGE, 1949, 2228
iNA960 messages, 6480
INC, 1971, 2251
Incoming, 3897, 4781
IncreaseFocusedValue, 4584
IncreaseTag, 4585, 4714, 4835, 4887, 5940
Increment, 1971, 2251
Indenting and outdenting

Lines, 1608
Index property (VBS), 5376
Index tag, 3712
Indirect addressing, 275, 1312, 1313, 1314, 1316, 
1317

Tags, 3719
Indirect addressing , 3712
Industrial Ethernet, 6143
Info text

Creating, 3941, 3949
Information

ARP table, 851
Ethernet Statistics, 862
Event log, 852
Frame type, 863
Packet Errors, 863, 864

Spanning Tree, 854
Versions, 849

Information system
Components of the information system, 346
Roll-out, 348
Tooltip, 348

Infotext, 3911
Creating, 3925, 3927, 3945
display, 7087, 7090, 7093
Key, 7090

Infotext 
Display, 4040

INIT_RD, 2083, 2367, 2581
Initialization

IPE file, 6865
Project file, 6871

Initialization (user-defined web pages), 793
Initialize all retain data, 2083, 2367, 2581
Initializing

Controller data, 6864
IPE file, 6866
Project file, 6871

InnerBackColorOff property (VBS), 5377
InnerBackColorOn property (VBS), 5378
Input

Inserting, 1544, 2136
remove, 1545, 1586

Input (I), 1074
Input area plan

SmartClient, 7402
SmartServer, 7402
SmartService, 7402

Input byte (IB), 1074
Input field, 7083

Character mode, 7089
Standard mode, 7089

Input finished, 4780
Input word (IW), 1074
InquireLanguage, 5942
INSERT, 2663
Insert empty line, 7856
Insert input, 1585
Insert separator line, 7856
InsertData(i) property (VBS), 5379
InsertEnable property (VBS), 5379
Inserting, 4494

Code template in user-defined functions, 4441
Graphic, 3343, 4330
Library object, 6823
Object, 3342, 3343, 4330
Rectangle, 3393

Inserting a comment section, 2569
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Inserting in a screen, 4494
Inserting:GSC diagnostics, 4494
Inspector window

Cross-reference, 67
Event, 67
Hardware and network editor, 6138
Layout, 319
Reducing automatically, 314

Inspector window 
Diagnostics tab, 1202
Hardware and network editor, 513

Install update, 131
Installation

Displaying software, 133
Internet Information Service, 7504
Licenses, 104
Log, 128
Modifying products, 133
ProSave, 81
Repairing products, 135
Requirement, 7499, 7502
run automatically, 103
Security settings, 7511
Smartdrive, 62
Starting, 129
Support package, 131
System requirements, 105
Target directory, 103
Updates, 131
Updating products, 133
Web diagnostics client, 7515
WebNavigator Client, 7507, 7511, 7513, 7514
WebNavigator Server, 7505

Installing, 120
Add-on, 120
DataMonitor client, 7279
DataMonitor server, 7277
OPC XML DA Server, 7568
Option, 7034
Powerpack, 127

Installing CA certificate, 8127
Installing license keys, 108
Installing support packages, 131
Installing the communications driver (WinAC MP), 
6786
Installing the local modem, 8102
Instance data block

Creating, 1265
Definition, 1265
Modifying the data types of IEC timers and IEC 
counters, 1617
Retentive behavior, 1652

Instruction
Copying, 1632
Cutting, 1632
Deleting, 1632
Inserting, 1632
Rules, 1613
Specify data type, 1529, 1530, 1570, 1572
Versions, 1481

Instruction profile
Activating and deactivating, 1485
Basics, 1482
Creating, 1483
Deleting, 1486
Editing, 1484
Opening, 1484

Instructions
Function list, 4441

Instructions for configuring a remote modem, 8104
INT, 1330, 1378, 1399
INT_TO_, 1399
Integer, 2051, 2334, 2542

16-bit, 1330, 1331
32-bit, 1332
64-bit, 1333, 1335
8-bit, 1328, 1329

IntegerDigits property (VBS), 5380
Integrated

Connection, 6148, 6152
Integrated connection, 3680, 6159
Integrated project

Converting an unspecified CPU, 262
Creating an integrated HMI connection, 263
Deleting an unspecified connection, 266
Linking HMI tags, 265
Migrate, 255
Migrating, 198, 258
Post-editing, 261

Intel format, 4268
Intelligent DP slave, (See I-slave)
Inter Project Engineering

Creating "Device Proxy Data" in the source 
project, 1829
Exchange of controller data via "IPE file", 1830
Exchanging controller data across projects, 1827, 
8017
Opening "Device Proxy Data", 1830
Procedure for exchanging controller data via a 
project file, 1828, 8018
Procedure for exchanging controller data via an 
IPE file, 1827, 8017
Procedure for updating already transferred 
controller data, 1828, 8019
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Requirements, 1826, 8017
Software and hardware requirements, 1826, 
8016

Inter Project Engineering (IPE)
Basics, 1824, 8014
Exchanging controller data via IPE file, 1825, 
8015
Exchanging controller data via project file, 1825, 
8015

Interconnecting, 562
Interconnecting ports

Graphic view, 635, 637
Table view, 636, 638

Interface, (See block interface)
Adding, 8036
Basic Panel, 6172
Comfort Panel, 6183
Displaying, 1214
Mobile Panel, 6192
Multi Panel, 6187
Panel, 6176
Parameters, 6455
PLC, 6457
Renaming, 638
Serial communication, 6455
WinCC RT Advanced, 6196
WinCC RT Professional, 6196
WinCC Runtime Advanced, 6196
WinCC Runtime Professional, 6196

Interface properties, 1214
Interfaces, 37
Interference frequency suppression, 1183
Internal

Ethernet port, 6685
Internal error codes and constants, 6479
Internal Ethernet port

Open settings, 6685
Internal network nodes

Configuring, 709
Diagnostics, 721

Internal reference junction, 1184
Internal tags

Data exchange, 6124
Internet Explorer

Security settings, 7298, 7511
Internet Information Service, 7504
Internet Key Exchange (IKE), 704
Inter-Project_Engineering

IPE, 6864
Interrupt event

Delaying with DIS_AIRT, 2837
Disabling with DIS_IRT, 2834

Enabling with EN_AIRT, 2838
Enabling with EN_IRT, 2836

Interrupts
Activating time-of-day interrupt with ACT_TINT, 
2819
Canceling time-delay interrupt with CAN_DINT, 
2824
Canceling time-of-day interrupt with CAN_TINT, 
2818
Querying time-delay interrupt with QRY_DINT, 
2824
Querying time-of-day interrupt with QRY_TINT, 
2820
Receiving from I/O module with RALRM, 2682
Setting time-of-day interrupt with SET_TINT, 
2813
Setting time-of-day interrupt with SET_TINTL, 
2816
Starting time-delay interrupt with SRT_DINT, 
2823
With packed addresses, 1014

Interval property (VBS), 5380
Intrusion Detection System (IDS), 112, 116
INV, 2092, 2376
Invalid license

With a time zone change, 109, 125
InverseLinearScaling, 4600, 4719, 4835, 4888, 5944
Invert, 1860, 2092, 2137, 2376
InvertBit, 4598, 4717, 4837, 4889, 5945
InvertBitInTag, 4599, 4718, 4838, 4890, 5946
InvertLinearScaling, 4600, 4719, 4835, 4888, 5944
IO device

Networking, 1034
Update time, 1037
Watchdog time, 1038

IO system, 1034
Creating, 1034

IO2MOD, 2926
IOField object, 5059
IO-Link, 1048
IP access control list, 659
IP address, 39, 560, 562, 1022

Reading out, 6589
IP address parameters, 1023, 1031
IP configuration

Change parameters from the user program, 3278
IP packet filter rules, 673
IP parameters, 1214
IP protocol, 6295
IP rule sets, 664
IP services, 667
IP subnet, 562
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IPE, 6864
File, 6865, 6866

IPE data
Updating, 6869, 6874

IPE file, 6865
Initialization, 6865
Initializing, 6866

IPsec settings, 703
IPv4 addresses, 678
IPv6

E-mail, 1200
FETCH/WRITE, 1200
FTP client, 1200
FTP server, 1200
Notation, 1200
SNMP, 1200
Use with the CP 1543-1, 1200

IPv6 addresses, 678
IQ sense, 1192
iQ series, 6686
IRT (Isochronous Realtime Ethernet), 6611
IS_ARRAY, 1960, 2238, 2463
IS_NULL, 1958, 2236
ISAKMP, 713
isalnum function, 6041
isalpha function, 6041
isdigit function, 6041
isgraph function, 6041
I-slave, 996, 1004

Configuring, 1005
Data access, 1005
Data exchange, 996

islower function, 6041
ISO protocol, 751
Isochronous mode, 1050, 1055
ISO-on-TCP

Characteristics, 604
TSAP, 613

isprint function, 6042
ispunct function, 6042
isspace function, 6042
isupper function, 6042
IsUserAuthorized, 5948
isxdigit function, 6042
ITag, 7608
ITag method

Cancel, 7623
ReadTag, 7620
ReadTagAsync, 7621
ReadTagCyclic, 7622
Register, 7620
RemoveCyclicTag, 7622

Unregister, 7625
WriteTag, 7623
WriteTagAsync, 7624

ITagSink, 7608
ITagSink methods

OnCanceled, 7625
OnError, 7627
OnRemove, 7627
OnUpdate, 7626
WriteTagAsync, 7628

Item methods, 5841
Item object, 4958
ItemBorderStyle property (VBS), 5381
IW, 1425
IX, 1425

J
Jerk limit

Function, 7810
JMP, 2062, 2345
JMP_LIST, 2065, 2348
JMPN, 2063, 2346
Job mailbox, 6125

Transferring data, 6250, 6334, 6430, 6522, 6775
Job types and error codes

Raw data communication for recipes, 4267
Jump, 2062, 2063, 2064, 2065, 2066, 2069, 2345, 
2346, 2347, 2348, 2350, 2353
Jump distributor, 2066, 2350
Jump label, 2064, 2347, 2567
Jump list, 2065, 2348
JumpToLimitsAfterMouseClick property (VBS), 5382

K
Key

Backspace, 7089
Cursor, 7088
Delete, 7089
END, 7088
ENTER, 7089
ESC, 7089
HOME, 7088
Infotext, 7090
Scrolling back, 7088
Scrolling up, 7088
TAB, 7088

Key assignment
Replacing devices, 6914

Key operation, 7088, 7091
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Key switch
Application, 3611
Layout, 3611
Tag, 3611

Keyboard operation, 518
Basic functions of the TIA Portal, 334
Customizing editors, 339
Editing objects, 340
Editing texts, 341
Navigation in the TIA Portal, 337
Online functions, 343
Project editing, 336
Selecting objects, 340
Tables, 342
Window, 336

KEY-PLUG, 906, 908
Formatting, 908

Keys, 7070
Keyword highlighting, 1605
Keywords, 1289
K-key

Replacing devices, 6915
Know-how protection

Changing a password, 1732, 4450
Introduction, 1726
opening a user-defined function, 4449
Opening blocks, 1730
Printing block, 1731
remove, 1732, 4450
Setting up, 1729, 4449

L
LABEL, 2064, 2347
LabelColor property (VBS), 5382
labs function, 6046
LACP, 944
LAD, 1514, 1834

Detailed comparison, 1688
Migration, 159

LAD element
Copying, 1541
Cutting, 1542
Deleting, 1547
Inserting, 1527, 1528
Inserting an operand, 1547
pasting from the clipboard, 1542
Replacing, 1543
Rules for inserting, 1525
Selecting, 1540

LAD network
Branch, 1550

Closing a branch, 1552
Crossing, 1553
Deleting a branch, 1553
Deleting a crossing, 1555
Insert crossing, 1554
Inserting a block call, 1533, 1575
Inserting a branch, 1552
Program status display, 1768
Prohibited interconnections, 1527
Rearranging a crossing, 1554
Rules for simultaneous branches, 1551

Ladder Logic, 1514
Language

Activate project language, 6886
Asian languages, 6884
Asian operating system, 6884
Disabling the project language, 6886
Editing language, 6886
Language support, 6884
Language-dependent format, 6883
Language-specific graphic, 6896
Log, 3773, 4022, 6906
multilingual project , 6888
Reference language, 6886
Regional format of the date, time, currency, and 
numbers, 6883

Language abbreviation, 814
Language behavior

On-screen keyboard, 83
Language property (VBS), 5383
Language setting

Runtime settings, 7064
Language Settings in Runtime, 7064
Language switching, 814, 6900

In Runtime, 4500
Log, 3773, 4022, 6906
Runtime language, 6903

Languages
Migrating, 191

LargeTicksBold property (VBS), 5384
LargeTicksSize property (VBS), 5384
LastConnectedObjectIndex property (VBS), 5385
LastConnectedObjectName property (VBS), 5385
Layer

Assigning objects to a layer, 3470
Layer 2, 663
Layer 3, 663, 908
Layer object, 4959
Layers object (list), 4960
Layout

 Alarm report , 4361
 Control data, 4346
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 Control Information, 4348
 CSV provider trends , 4349
 ODBC database field , 4363
 ODBC database table, 4364
 Project name in reports, 4366
 Recipe report , 4369
 Report name in reports, 4367
Alarm indicator, 3591, 4043
Alarm line, 3579
Alarm view, 3579, 3583, 3589, 4038, 4041, 4048, 
7162, 7163
Bar, 3519, 3521
Button, 3608
Charging condition, 3570
Circle, 3565
Clock, 3636
Connector, 3637
Control Hardcopy, 4347
Date/time field, 3527
Date/time field in reports, 4351, 4352
Editable text field, 3537
Effective range name, 3640
Effective range name (RFID), 3643
Effective range signal, 3644
Ellipse, 3537
Ellipse segment , 3539
Elliptical arc, 3538
f(t) trend view, 3541
f(x) trend view, 3545, 3547
Gauge, 3647
Graphic I/O field, 3552, 3554
Graphic I/O field in reports , 4358
Graphic view, 3551, 4357
Handwheel, 3555
Hardcopy in reports, 4359
HTML Browser, 3557, 3560
I/O field, 3532
I/O field in reports, 4354
Illuminated pushbutton, 3572
Key switch , 3611
Line, 3575
List box, 3576
Media Player , 3577
Page number in reports, 4370, 4371
Polygon, 3594
Polyline, 3596
Print job/Script diagnostics, 3529
Recipe view, 3599, 3601
Rectangle, 3597
S7-GRAPH Overview, 3606
Simple recipe view, 4205, 7138
Simple user view, 7100

Slider, 3610
Sm@rtClient view, 3614
Status/Force, 3618
Switch, 3607
Symbol library, 3619
Symbolic I/O field, 3621, 3623
Symbolic I/O field in reports, 4372
Table view, 3631
Text field, 3634, 4373
Trend view, 3569
User view, 3523, 7099
Value table, 3638
WLAN reception, 3645
Zone name, 3649
Zone signal, 3650

Layout of the force table, 1800
Layout template

Create, 7320
ldexp function, 6043
ldiv function, 6046
LDT, 1345
Lead and lag algorithm, 2124, 2409, 2615
LEAD_LAG, 2124, 2409, 2615
Learning functionality, 709
Learning mode, 750
LeaveMarginForBorder property (VBS), 5398
LeaveMarginForMarkers property (VBS), 5398
LED, 2856

Assignment, 6257, 6342, 6438, 6675, 6710, 6743, 
6762
Function, 6257, 6342, 6438, 6675, 6710, 6743, 
6762
Image, 6257, 6342, 6438, 6675, 6710, 6743, 
6762

LED ACK, 7160
LED control, 7053
LED status

Reading out with LED, 2856
LEFT, 2660
Left property (VBS), 5399
LEN, 2659
Length

Area pointer, 6164
Area pointers, 6166

LG GLOFA GM
Migrating data types, 204

LGC_GADR, 2934
Library, 6805

Adding a master copy, 468
Adding and using a block, 1451
Basics, 441
Buttons and Switches, 6810
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Cleaning up, 496
Comparing library elements, 497
Copying a library object, 6809
Copying types to the clipboard, 491
Creating folders, 467
Cutting library elements, 491
Cutting master copies, 491
Cutting types, 491
Deleting instances, 492
Deleting types and versions, 492
Displaying the properties of a type, 475
Harmonizing names and path structure, 495
Master copies, 441
Master copy, 6809
Moving library elements, 492
Open, 6816
Opening a released type version, 474
Pasting master copies from the clipboard, 492
Pasting types from the clipboard, 491
PLC data types generated by the system, 50
Released type version, 473
Save, 6816
Storing an object, 6822
Style, 6826
System diagnostics indicator, 4133, 4145
Task card, 443
Type, 6809
Type version in progress, 472
Type version in test, 472
Types, 441
Using filter view, 469
Using master copies, 467, 470
Using the element view, 445
Using types, 470
Versioning of types, 471

Library management
Displaying cross references of an instance, 453
Displaying instances of type versions, 453
Displaying relations between library objects, 454
Filtering, 6814
Filtering by non-released types, 452
Opening, 451, 6813
Overview, 449, 6811

Library object, 6805, 6807
Inserting, 6823

Library view
Exit, 449
Opening, 449
Overview, 446, 6807

License
DataMonitor client, 7275
DataMonitor server, 7275

Defective, 109, 125
Defective license, 109, 125
Invalid, 7276
Managing, 7032
OPC server, 7563
Starting without a valid license, 121
Starting without valid license, 107
Web diagnostics client, 7501
Web diagnostics server, 7501
WinCC Runtime Professional Asian, 126

License key, 108, 123
Handling license keys, 108
Working with license keys, 123

License Keys, 7031
Transfer to an HMI device, 7032

License Manager Panel Plugin, 122
Licenses, 104
Life of certificates, 702
Light emitting diode

acknowledge, 7090
Toggle, 7089

LIMIT, 1978, 2258, 2469
Limit and enable password legitimation, 2071, 2354, 
2569
Limit test, 7084, 7091
Limit value, 1174, 1978, 2258, 2469, 3911

Tag, 3699
Limit values

Tag, 3699
Limit4LowerLimit property (VBS), 5402
Limit4LowerLimitColor property (VBS), 5403
Limit4LowerLimitEnabled property (VBS), 5403
Limit4LowerLimitRelative property (VBS), 5404
Limit4UpperLimit property (VBS), 5404
Limit4UpperLimitColor property (VBS), 5405
Limit4UpperLimitEnabled property (VBS), 5405
Limit4UpperLimitRelative property (VBS), 5406
Limit5LowerLimit property (VBS), 5407
Limit5LowerLimitColor property (VBS), 5407
Limit5LowerLimitEnabled property (VBS), 5408
Limit5LowerLimitRelative property (VBS), 5408
Limit5UpperLimit property (VBS), 5409
Limit5UpperLimitColor property (VBS), 5410
Limit5UpperLimitRelative property (VBS), 5411
Line, 3575

Design, 3355
Line end, 3355, 3575
Line start, 3575

Line break, 1165
Line end

Line, 3575
Polyline, 3596
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Line object, 5063
Line report

Migrate, 249
Line start

Line, 3575
Polyline, 3596

Linear programming, 1260
LinearScaling, 4616, 4721, 4839, 4892, 5949
LineWidth property (VBS), 5414, 5415
Link folder

External graphic, 3376
Linked objects

Copying, 6928, 6929
Linked Server, 7630
Linking, 6879
Linking HMI tags, 265
LINT, 1333
List box, 3576
List of Hidden Alarms, 4005
Listbox, 5065
Lists, 4979
Lists in VBS

Alarms object (list), 4948
Lists:DataSet, 4954
Lists:Layers, 4960
Lists:Tags Object (List), 4978
LLDP, 659, 660, 1042
LLDP (Link Layer Discovery Protocol), 1042, 6222, 
6303, 6388
LN, 1982, 2263, 2473
load

Recipe data record in Runtime, 4215
Load

"Pack&Go" file to HMI device, 6987
Extended download to device, 81
HMI device, 6986, 7022, 7023, 7024
Migrated project, 221
Project, 6982
Recipe, 4237
SIMATIC PC station, 82

Load memory, 1073, 1754
Displaying, 1758

Load window layout
Loading additional window layouts, 331
Loading via quick access, 331

LoadDataImmediately property (VBS), 5415
LoadDataRecord, 4608, 4840
Loaded, 4770
Loading

Blocks to the device, 1718
Configurations with PROFIBUS, 1055
Configurations with PROFINET, 1055

Configurations with web server, 1054
Device configurations, 1052
Distributed I/O, 1053
Downloading project data to the device, 383
Downloading to a memory card, 385
from a device, 44, 50, 386
General information, 381
Going online, 1059
GSDML, 1056
HMI devices, 1059
I-device, 1056
IE/PB-Link, 1058
in RUN operating mode, 1718
Isochronous applications, 1050, 1055
Module comments, 45
Placeholder, 1056
Shared Devices, 1058
Subnets, 1054
to PG/PC, 1051
to the device, 44, 1050
Uploading blocks from a memory card, 1725
USB, 6989

Loading projects
with connected HMI device, 6979, 7006
Without connected HMI device, 6980, 7007

Local assignment
Of a function key, 3456, 3460

Local data bit (L), 1074
Local data byte (LB), 1074
Local data double word (LD), 1074
Local data word (LW), 1074
Local error handling, 1637

Error information, 1637
Instructions, 1637
Priorities, 1638

Local logging, 715
Local script, 4427

Configuring at event, 4472
Deleting at event, 4472
Deleting at object property, 3453, 4473
Dynamic control of object properties, 3453, 4473
Use, 4469
Using, 4469

Local tag, 1491, 4447
Local time, 1087

Calculating with SET_TIMEZONE, 2632
Reading out with RD_LOC_T, 2629
Writing with WR_LOC_T, 2629

LocalCursor property (VBS), 5417
Localizable property (VBS), 5416
localtime function, 6048
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Lock
Operator control, 96, 97

Lock bit, 4120
Lock changed, 4791
Lock key combinations

Runtime settings, 7067
Lock list, 4054, 7175
Lock tag, 4120

Alarm group, 4120
LockAlarm, 5843
LockSquaredExtent property (VBS), 5417
Log

Alarm log, 4155, 4158
Automatic entries, 4157
Characters which may be used in tag names, 
3763, 3796
Checksum, 3759, 3771, 4021
Compressed log, 4158
Configuration, 3794
Configuring the size, 3804
Connecting, 3812
Data log, 4155, 4158
Disconnecting, 3813
Language switching, 3773, 4022, 6906
Level-dependent management, 3765
Migrate, 246
Runtime language, 3773, 4022, 6906
Storage on network, 7048

Log backup
Connecting, 3812, 4031
Disconnecting, 3813

Log behavior
Control with system function, 3768
Level-dependent management, 3765
Managing upon system start, 3764

Log contents
Display, 3758, 4010

Log data, 4055, 7176
Migrating, 194
output in alarm window, 4055, 7176

Log database, 3789
Direct access with ODBC, 3823, 4018

Log entries, 4157
Log file

 Modem alarms , 8149
log function, 6043
Log language, 3773, 4022, 6906
Log memory, 7386, 7388
Log segments

Configuring, 3804
Log table

Event log, 852

Log tag value change
Audit Trail, 7253

Log type, 4009
Log types, 3810
Log with level-dependent execution of system 
functions, 4009
Log with level-dependent system alarm, 4009
LOG_GEO, 2930
log10 function, 6043
LOG2GEO, 2924
LOG2MOD, 2925
Logarithm, 1982, 2263, 2473
Logging, 714

Change to a recipe data record in Audit Trail, 
7256
Circular log, 3758
CP x43-1 Adv., 761
Cyclic, 3785
Cyclic-selective, 3786
Log type, 3758, 4009
On demand, 3787
On value change, 3787
SCALANCE S, 738, 740
Segmented circular log, 3758
Start, 3776
System functions in Audit Trail, 7262
Tag value, 3757
Tag value change in Audit Trail, 7253
Tags, 3760, 3766
Tolerance band, 3766
User actions in audit trail, 7259
Within/outside the limit values, 3766

Logging concept
Audit , 7228

Logging cycle, 3766, 3776, 3783
Tag, 3736, 3738

Logging method, 3776
Circular log, 3758
Level-dependent, 3758

Logging methods, 3782
Compression, 3782
Cyclic, 3782
Cyclic-selective, 3782
On change, 3782
On demand, 3782

Logging object, 4961
Logging recipe data changes

Audit Trail, 7256
Logging system functions

Audit Trail, 7262
Logging tag, 3778, 3798

analog, 3778
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binary, 3778
Configuration, 3798
Configuring, 3774, 3814
Creating, 3798

Logging user actions
Audit Trail, 7259

Logic analyzer function, 8051
Logic operation

AND, 2087, 2371
EXCLUSIVE OR, 2090, 2374
OR, 2089, 2373

Logic path
Deleting, 1595
Inserting, 1595
Use, 1594

Logical address
Determining a module with GADR_LGC, 2933
Determining a module with RD_LGADR, 2932
Determining associated slot with LGC_GADR, 
2934
Determining associated slot with LOG_GEO, 
2930

Logical error, 4475, 4483, 7000, 7022
Logoff, 4566, 4841

Configuring on the effective range, 6084
Configuring to effective range (RFID), 6087
Effective range, 3642
Effective range (RFID) , 3644
Users, 7103

Logoff time, 7098
Changing, 4391
Changing in runtime, 4407

Logon, 4571, 4842
Configuring on the effective range, 6084
Configuring to effective range (RFID), 6087
Dynamic, 4384
Effective range, 3641
Effective range (RFID), 3643
Logon failed, 4409, 4411
Reporting, 4419
User, 4408
Users, 4410, 7102

Logon dialog
Configuring access protection, 4418

Logon for web server, 788
Logon web server, 788
LogOperation property (VBS), 5418
LogTag, 4573
Long word, 1327
Long-term archive list, 4054, 7175
Long-term archive server, 3791

Installation (overview), 3791

LookupText, 4680, 4842
Loop, 2556, 2560, 2562, 2564, 2565, 2566
Loop-in alarm

trigger, 4043
LoopInAlarm, 5843
Loop-in-alarm

Configured, 3956
Setting, 3587

Loop-In-Alarm, 4785
Low free storage space, 4797, 7239
LowerLimit property (VBS), 5420
LowerLimitColor(i) property (VBS), 5421
LowerLimitValue(i) property (VBS), 5421, 5422
LowLimitColor property (VBS), 5423
LREAL, 1337, 1383, 1408
LREAL_TO_, 1408
LTIME, 1341
LTOD, 1343
LWORD, 1327

M
MAC packet filter rules, 676
MAC rule sets, 664
MAC services, 670
MachineName property (VBS), 5423
Main, 1115
Main mode, 704
malloc function, 6047
managing

Graphic, 3375
Managing

License, 7032
User group, 4391
Users, 4390
Users in runtime, 4406

Manual display suppression, 3984
Manual fragment, 810
Manual hiding, 4005
Manuals, 6142
Mapping rules (OPC A&E) 

"Mode 1", 7584
"Mode 2", 7584
"Mode 3", 7585

MarginToBorder property (VBS), 5424
Master copy

Library, 6809
math functions

acos function, 6043
asin function, 6043
atan function, 6043
ceil function, 6043

Index

WinCC Professional V13.0
System Manual, 02/2014 8241



cos function, 6043
cosh function, 6043
exp function, 6043
fabs function, 6043
floor function, 6043
fmod function, 6043
frexp function, 6043
ldexp function, 6043
log function, 6043
log10 function, 6043
modf function, 6043
pow function, 6043
sin function, 6043
sinh function, 6043
sqrt function, 6043
tan function, 6043
tanh function, 6043

Math functions
CALCULATE, 1536, 1578

MAX, 1976, 2256, 2467
MAX_LEN, 2648
Maximum, 1976, 2256, 2467
Maximum cycle time, 1070, 1091, 1092, 2076, 2359
Maximum length

Tag, 83
Maximum load memory available

Displaying, 1758
MaximumValue property (VBS), 5425
MB, 1425
MB_CLIENT, 3154, 3171
MB_COMM_LOAD, 3137
MB_MASTER, 3141
MB_SERVER, 3161, 3182
MB_SLAVE, 3148
MC_ChangeDynamic

 Instruction, 2964
 Parameter, 2964
Parameter, 2967

MC_CommandTable
Instruction, 2962
Parameter, 2963

MC_Halt
Function chart, 2947
Instruction, 2945
Parameter, 2979
Parameters, 2946

MC_Home
Instruction, 2942
Parameter, 2943

MC_MoveAbsolute
 Parameter, 2949
Function chart, 2950

Instruction, 2948
MC_MoveJog

Function chart, 2961
Instruction, 2959
Parameter, 2960

MC_MoveRelative
Function chart, 2954
Instruction, 2951
Parameter, 2952

MC_MoveVelocity
Function chart, 2958
Instruction, 2955

MC_Power
Function chart, 2939
Instruction, 2936
Parameters, 2936

MCAT, 2116, 2401, 2607
MD, 1425
MD5, 699, 705
MDM, 355
Meaning of the columns in the force table, 1800
Measure program runtime, 2085, 2369, 2583
Measuring window (GATE), 1162
Media Player , 3577
Media redundancy (MRP), 6618, 6620, 6621, 6623
MediaControl, 5068
Medium closed, 4787
Medium opened, 4786
memchr function, 6044
memcmp function, 6044
memcpy function, 6044
memmove function, 6044
Memory area

Load memory, 1073
Retentive memory areas, 1075
Work memory, 1073

Memory bit (M), 1074
Memory byte (MB), 1074
Memory card, 39, 1071, (See Memory Card)

Accessing, 440
Adding a card reader, 439
Formatting, 1235
Introduction, 438
Removal/insertion, 43
Showing properties, 440

Memory cards, 40
Memory double word (MD), 1074
memory functions

memchr function, 6044
memcmp function, 6044
memcpy function, 6044
memmove function, 6044
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memset function, 6044
Memory medium, 4010

Audit Trail, 7251
Memory requirements

Recipe, 7223, 7224
Memory reserve, 50
Memory reset, 1071

Making, 1230
Memory size

Alarm buffer, 4007
Memory word (MW), 1074
memset function, 6044
Menu

Configuring an event, 3667
Creating main menu commands, 3660
Creating menu commands, 3660
Creating submenu commands, 3660
customized, 3655, 3665

Menu command
Simple recipe view, 4206, 7139

Message
Sending, 1106
Specifying the end, 1107
Specifying the start, 1106

Message archive, 7650, 7659
Displaying data, 7652
Querying archive data, 7650, 7659
Recordset, 7652

MessageBlockAlign property (VBS), 5429
MessageBlockAutoPrecisions property (VBS), 5430
MessageBlockCaption property (VBS), 5431
MessageBlockCount property (VBS), 5431, 5435
MessageBlockDateFormat property (VBS), 5431
MessageBlockExponentialFormat property (VBS), 
5432
MessageBlockFlashOn property (VBS), 5433
MessageBlockHideText property (VBS), 5433
MessageBlockHideTitleText property (VBS), 5434
MessageBlockID property (VBS), 5434
MessageBlockLeadingZeros property (VBS), 5435
MessageBlockLength property (VBS), 5436
MessageBlockName property (VBS), 5436
MessageBlockPrecisions property (VBS), 5437
MessageBlockSelected property (VBS), 5437
MessageBlockShowDate property (VBS), 5438
MessageBlockShowIcon property (VBS), 5438
MessageBlockShowTitleIcon property (VBS), 5439
MessageBlockTextId property (VBS), 5439
MessageBlockTimeFormat property (VBS), 5440
MessageBlockType property (VBS), 5440
MessageColumnAdd property (VBS), 5441
MessageColumnCount property (VBS), 5442

MessageColumnIndex property (VBS), 5442
MessageColumnName property (VBS), 5443
MessageColumnRemove property (VBS), 5443
MessageColumnRepos property (VBS), 5366, 5444
MessageColumnSort property (VBS), 5444
MessageColumnSortIndex property (VBS), 5445
MessageColumnVisible property (VBS), 5368, 5445
MessageListType property (VBS), 5445
Methods, 5777, 5781, 5782, 5784, 5786, 5787, 5788, 
5789, 5791, 5792, 5793, 5794, 5795, 5796, 5797, 
5798, 5800, 5801, 5802, 5803, 5805, 5806, 5807, 
5808, 5809, 5810, 5812, 5813, 5814, 5815, 5816, 
5817, 5819, 5820, 5821, 5823, 5824, 5825, 5826, 
5828, 5829, 5830, 5831, 5832, 5833, 5835, 5836, 
5837, 5838, 5840, 5843, 5844, 5845, 5846, 5847, 
5848, 5849, 5850, 5851, 5852, 5853, 5854, 5855, 
5868, 5869, 5870, 5871, 5872, 5873, 5874, 5875, 
5876, 5877, 5878, 5879, 5880, 5881, 5882, 5883, 
5884, 5885, 5886, 5887, 5891, 5892, 5893, 5894
Methods (VBS), 5775, 5783

Activate, 5775
CreateTagSet, 5783
Item, 5841
Stop, 5884
Trace, 5885

Methods in VBS
Create, 5783
DeactivateDynamic, 5784

Methods:Add, 5779
Methods:Read, 5856
Methods:Refresh, 5859
Methods:Remove, 5860
Methods:RemoveAll, 5864
Methods:Restore, 5865
Methods:Write, 5888
MIB, 659
Micro, 6720
MicroLogix, 6636, 6662
Microsoft Script Debugger, 4482
MID, 2661
Migrated project

Compiling, 171
Load, 221
Starting, 221

Migrating projects
Procedure, 146
Requirements, 145

Migration, 39, 156, 159, 160, 161
 Faceplate, 230
Actions, 242, 244
Adaptations beforehand, 174
Alarm classes, 240
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Alarm groups, 186, 240
Allen-Bradley DF1 data types, 202
Allen-Bradley DH485 data types, 202
Allen-Bradley Ethernet IP data types, 203
Area pointer, 184
Basics, 167, 216
Changing the device name, 222
Color settings, 239
Connection, 225
Controls, 238
Cycles, 250
Data types Modicon Modbus, 206
Data types Modicon Modbus TCP/IP, 207
Data types Omron Hostlink/Multilink, 207
Data types OPC, 208
Data types SIMATIC 500/505 DP, 208
Data types SIMATIC 500/505 serial, 209
Data types SIMATIC HMI HTTP Protocol, 209
Data types SIMATIC S5 AS511, 210
Data types SIMATIC S5 DP, 210
Data types SIMATIC S7 200, 211
Data types SIMATIC S7 300/400, 211
Data types Telemecanique Uni-Telway, 214
Displaying a log file, 147
Displaying history, 147
Dynamic, 236
Font settings, 180, 232
Functions, 242
GE Fanuc SNP data types, 203
Global library, 193
Header file, 244
HMI device replacement, 177
Including the hardware configuration, 142
Integrated project, 258
Introduction, 166
Introduction to migration, 141
LG GLOFA GM data types, 204
Line report, 249
Log, 246
Migrating an integrated project, 198, 255, 258
Migrating projects, 170, 199, 218, 257
Mitsubishi FX data types, 205
Mitsubishi Protocol 4 data types, 205
Multilingual reports, 246
Object group, 233
of Basic Process Control, 251
of external tags, 201, 253
of languages, 191
of log data, 194
of project text, 191
of standard functions, 245
OLE object, 231

Position data, 233
Print job, 246
Project library, 193
Recipe data, 194
Reconfigure connection, 183, 227
Runtime data, 194, 252
Script, 189
Script for dynamization, 236
Size data, 233
Supported HMI devices, 172
Supported object types, 223
Supported products, 141
Tags, 228
Text, 191
The migration process, 141
User administration, 194, 249, 252
User log, 241, 252
VB-script, 189
WinCC Controls, 238
WinCC Push Button Control, 231
WinCC V7.0 SP3, 64

Migration of STEP 7 projects
Alarms, 156
CBA for IO controllers, 153
Device names of PROFINET IO devices, 152
GSD and GSDML devices, 154
I slaves and I-devices, 153
Introduction, 148
Isochronous mode with PROFINET IO, 153
Media redundancy, 153
Migratable types of connection, 154
Multiproject, 155
Names of modules and racks, 152
PROFIBUS isochronous mode, 154
Requirements, 149
Requirements for the project, 149
Scope of migration, 148
Shared devices, 153
System error messages, 156
Transfer areas, 153
Update groups PROFINET IO, 153

Migration tool, 168, 217
Creating a migration file, 145
Distribution and sources, 139
Including the hardware configuration, 143
Removing, 140
System requirements, 139
Using the migration tool, 142

MIN, 1974, 2254, 2465
Mini USB, 6989
Minimum, 1974, 2254, 2465
Minimum cycle time, 1070, 1091
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MinimumValue property (VBS), 5446, 5447
MinuteNeedleHeight property (VBS), 5447
MinuteNeedleWidth property (VBS), 5448
Mirroring, 925, 927
Missing supply voltage, 1174, 1182
Mitsubishi, 6625

Address, 6687
Analog alarm, 6707
Basic Panel, 6170
Communication drivers, 6676
Connection interruption, 76
FX, 6676
Panel, 6175
TCP/IP, 6676

Mitsubishi FX
Configuring a connection, 6693
Connection, 6693, 6697
Connection parameters, 6695
CPU type, 6700
Data type, 6699
Migrating data types, 205
Mitsubishi MC TCP/IP, 6681, 6698

Mitsubishi MC
Data types, 3756

Mitsubishi MC TCP/IP
Configuring a connection, 6677
Connection, 6677, 6680
Connection parameters, 6678
CPU type, 6686
Data type, 6685

Mitsubishi Protocol 4
Migrating data types, 205

Mixed mode, 706
mktime function, 6048
Mobile Panel

Area pointer, 6193
Display and operating element, 3514
Interface, 6192
OPC, 7547

Mobile Panels
Available system functions, 4554

Mobile Wireless, 6075, 6077
Work area, 6075
Zone ID / connection point ID, 6090

Mobile Wireless (RFID)
Work area, 6077

Mobile Wireless V2, 6077
MOD, 1597, 1969, 2248
Modbus communication

as a slave with MB_SLAVE, 3148
as Modbus master with MB_MASTER, 3141
Configuring a port with MB_COMM_LOAD, 3137

Mode, 3608
Graphic I/O field, 3552, 3554
I/O field, 3532
Symbolic I/O field, 3623

Mode property (VBS), 5448
Modem

Local, 8102
Problem, 8145
Remote, 8103

Modem alarms
Log file, 8149

Modem connection cannot be established, 8149
Modem connection is closed, 8149
Modem connection is interrupted, 8148

Causes and solutions, 8148
Modems without plug-and-play, 8103
modf function, 6043
Modicon

Approved communication with Modbus RTU, 
6729
Connection, 6728
Connection cable, 6728
Restrictions with Modbus RTU, 6729

Modicon M340, 6720
Modicon Modbus, 6625

Basic Panel, 6170
Communication drivers, 6710
Migrating data types, 206
Panel, 6175
RTU, 6710
TCP, 6710

Modicon Modbus connection
Data types, 6741

Modicon Modbus RTU, 6734
Configuring a connection, 6724
Connection, 6724
Connection parameters, 6726
Data type, 6733

Modicon Modbus TCP, 6720
Configuring a connection, 6711
Connection, 6711, 6716
Connection parameters, 6713
Data type, 6719

Modicon Modbus TCP/IP
Data types, 3756

Modicon MODBUS TCP/IP
Change word order, 6715

Modicon Modbus TCP/IP
Migrating data types, 207

Modify
High-speed counters, 2998
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Modify value
Permitted operands, 1779

Modifying mode, 1786
Modifying recipe structures, 4219, 4243
Module

Addressing, 781
Asynchronously reading data record with 
RD_DPARA, 2802
Communication Status, 720
Configuring and assigning, 43
Copying, 537
Deleting, 536
Determine diagnostics status, 1222
Determining logical address of the slot with 
LOG_GEO, 2930
Determining logical address with GADR_LGC, 
2933
Determining logical addresses with RD_LGADR, 
2932
Determining slot of a logical address with 
LGC_GADR, 2934
Determining start address with GEO_LOG, 2929
Inserting, 43, 535
Moving, 538
Reading data record with RD_DPAR, 2800
Removing, 43
Replacing, 539
Select, 526
Time of day on a module, 1230

Module addressing, 1078
Module arrangement, 523
Module comments, 45
Module replacement, 262
Module rights, 658
Module titles, 525
Module version

Updating, 542
ModuleStates, 2871
Momentum, 6720, 6734
Monitor, 1040, 6220, 6301, 6386
Monitoring

"Monitor all" command, 1788, 1813
"Monitor now" command, 1814
"Monitor once and now" command, 1789

Monitoring and modifying modes, 1786
Monitoring mode, 1786, 7414
Monitoring window, 1191
Mono-master system, 995
Motion Control CPU S7-1200

Guidelines, 7812
Movable property (VBS), 5449

Move
Block, 2010, 2039, 2291, 2321, 2488, 2529
Block uninterruptible, 2016, 2041, 2297, 2323, 
2493, 2531
Character string in array with Ctrl_TO_Chars, 
2645
Screen, 3309
Value, 1995, 2276

MOVE, 280, 1995, 2276
Move block, 2012, 2293, 2490
Move mouse, 4786
Move view

Keyboard operation, 519
Overview navigation, 504, 507, 509

MOVE_BLK, 2010, 2291, 2488
MOVE_BLK_VARIANT, 2012, 2293, 2490
MoveAxis, 5844
MoveToFirst, 5844
MoveToFirstLine, 5845
MoveToFirstPage, 5845
MoveToLast, 5846
MoveToLastLine, 5846
MoveToLastPage, 5847
MoveToNext, 5847
MoveToNextPage, 5848
MoveToPrevious, 5849
MoveToPreviousLine, 5849
MoveToPreviousPage, 5850
MoveVelocity

Parameter, 2956
Moving

Hardware components, 538
Moving the view

Overview navigation, 6129, 6135, 6137
MPI, 6143

Addressing, 6416
Connection, 6444
HMI connection, 6405, 6409, 6410
Network, 6145
Network architecture, 6145
Parameters, 6412, 6414, 6415
S7 200, 6451, 6510
S7 300/400, 6404, 6405, 6407, 6409, 6410
WinCC RT Advanced, 6407
WinCC RT Professional, 6407

MPI address
S7 300, 6416
S7 400, 6417

MPI communication
S7 300/400, 6404, 6407

MPI parameters
S7 300/400, 6412, 6414, 6415
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MRP (Media Redundancy Protocol), 6618, 6620
MRP domain, 1217, 6621, 6623
MRP domain properties, 1217
MS OLE DB, 7628
MsgFilterSQL property (VBS), 5450
MSK_FLT, 2831
MSTP, 939
MUL, 1966, 2245
Multi Panel

Area pointer, 6188
Display and operating element, 3512
Interface, 6187
OPC, 7547

Multi Panels
Available system functions, 4542

multibyte functions
_ismbcalnum function, 6044
_ismbcalpha function, 6044
_ismbcdigit function, 6044
_ismbcgraph function, 6044
_ismbclower function, 6044
_ismbcprint function, 6044
_ismbcpunct function, 6044
_ismbcspace function, 6044
_ismbcupper function, 6044
_mbscat function, 6045
_mbschr function, 6045
_mbscmp function, 6044
_mbscpy function, 6045
_mbscspn function, 6044
_mbsdec function, 6045
_mbsinc function, 6045
_mbslen function, 6044
_mbsncat function, 6045
_mbsncmp function , 6044
_mbsncpy function, 6045
_mbspbrk function, 6045
_mbsrchr function, 6044
_mbsspn function, 6044
_mbsstr function, 6045
_mbstok function, 6045
_mbstrlen function, 6044

Multicast, 686, 950
Multi-instance

Declaring, 1503
Definition, 1275

Multi-key operation, 90
MultiLineEdit, 5070
Multiple instance, 1305

Correcting the call type, 1536, 1577
Multiple selection, 526, 3348, 4337
Multiple Spanning Tree, 939

Multiplex, 2097, 2381, 2589
Multiplex/synchronous mode, 1196
Multiplexing, 3712

Address multiplexing, 3705
Address multiplexing Allen-Bradley Ethernet IP, 
6640
with absolute addresses, 3705
with symbolic addresses, 3705

Multiply, 1966, 2245
Multi-point connection

Allen-Bradley DF1, 6655, 6656
Multi-touch devices

Gestures, 94
Scrolling, 93
Two-hand operation, 96
Zoom in and out, 94
Zooming, 94

MUX, 2097, 2381, 2589
MW, 1425
MX, 1425
My Documentation Manager, 355

N
N, 1870, 1872, 2147, 2149
N_TRIG, 1875, 2152
Name

Array element, 70
Named connections, 6417

Configuring a connection, 6417
Names of alarm classes

Change through migration, 187
NAT/NAPT

Routing, 685
Navigation interface

Extending menus, 7538
Server change, 7538
Structure, 7537
User logon, 7538

NE_ElemType, 1957, 2235
NE_Type, 1954, 2233
NeedleBorderColor property (VBS), 5453
NeedleColor property (VBS), 5454
NeedleFillStyle property (VBS), 5454
NEG, 1970, 2249
Negate, 1970, 2249
Negotiation, 900
Nesting depth, 1273
Network, 48, 6118, 7491

Access to subnetworks, 7491
Closing, 1521, 1563
Copying, 1520, 1562
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Deleting, 1520, 1563
Entering a comment, 1523, 1566
Ethernet, 6144
Insert title, 1522, 1565
Inserting, 1518, 1520, 1561, 1562
MPI, 6145
Navigating blocks, 1524, 1567
Opening, 1521, 1563
PPI, 6146
PROFIBUS, 6144
PROFINET, 6144
Router, 7491
Selecting, 1519, 1561
Using, 1518, 1560

Network access
Opening the properties, 8035

Network adapter, 760
Network architecture

PPI, 6146
Network comments

Hiding, 1479
Showing, 1479

Network drive, 39
Storing logs, 7048

Network editor
Components, 502, 6126
Function, 501, 6126
Hardware catalog, 515, 6140
Inspector window, 6138
Inspector window , 513

Network ID, 746
Network overview

Basic functions, 549
Basic functions for editing the network overview 
table, 549

Network Syslog, 715
Network view, 6147

Adding device, 531
Hardware and network editor, 503, 6128

Networking
Communication partners, 6147
Devices, 6147

Networking devices
Basics of configuring networks, 545
Editing interface parameters, 551
Editing network parameters, 551
Networking several interfaces at the same time, 
547
Networking with an existing subnet, 548
Networking without an existing subnet, 546
Networks within a project, 545
Requirements, 550

Types of communication, 545
Networking in the device view

Networking options, 549
Procedure, 550

New data types, 274
New value alarm, 3904
NextColumn, 5850
NextTrend, 5851
Nodes with an unknown IP address, 707
Non-integrated

Connection, 6152
Non-licensed mode

Engineering System, 121
ES, 107
HMI devices, 123
Runtime, 122

NORM_X, 2055, 2338, 2545
Normal range visible, 3648
Normalize, 2055, 2338, 2545
Normally closed contact, 1859
Normally open contact, 1858
NormalRangeColor property (VBS), 5455
NormalRangeVisible property (VBS), 5456
NOT, 1601, 1602, 1860
Not equal, 1959, 2237
NOT_NULL, 1959, 2237
NOT_OK, 1952, 2231
NotifyUserAction, 4583, 4843, 7261
NTP, 950
NTP (secure), 695
NTP server, 695
NULL, 1356
NumberOfValues(i) property (VBS), 5456
Numerical

Screen keyboard, 7083
Numerical key assignment, 7089
Numerical value

Changing, 7084, 7091
Decimal places, 7084
Display format, 7084, 7091
Entering, 7084, 7091
Limit test, 7084, 7091

O
O, 8023
OB

Events and OBs, 1079
Overview, 1079

OB 1, 1115
OB 80, 1124
OB 82, 1125
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OB for manufacturer-specific interrupt, 1120
OB for profile-specific interrupt, 1120
OB 83, 1127
object

Group, 3379
Paste, 3369, 4332
Rotate, 3353, 4341

Object
Arrange, 3342, 3352, 4335
Assigning to a layer, 3470
Availability, 3517
Availability for Basic Panels, 3508
Availability for Comfort Panels, 3511
Availability for Mobile Panels, 3514
Availability for Multi Panels, 3512
Availability for Panels, 3509
Availability for WinCC Runtime Advanced, 3515
Creating a new OLE object, 3342
Creating an OLE object from a file, 3342
Deleting, 3345, 4331
Deleting local script, 3453, 4473
design, 3356
Design, 3355
Designing the background color, 3358
Designing the fill pattern, 3359
Dynamization, 3420
Dynamization of the appearance, 3428
Dynamize direct movement, 3431
Dynamizing a property with a local script, 3453, 
4473
editing within a group, 3384
Evenly distributing, 3351, 4340
Flashing, 3368
Flip, 3342
Flush alignment, 3350, 4340
Grouping, 3379
Inserting, 3342, 3343, 4330
Inserting of the same type, 3342
Inserting several times, 3369, 4332
Multiplying, 3369, 4332
outside the area, 3353
Referencing, 4451
Repositioning and resizing multiple objects, 3342, 
3371, 4339
Repositioning objects, 3345, 4333
Resize, 3347, 4336
Rotate, 3342, 3353, 3363, 4341
Select multiple objects, 3348, 4337
Selecting multiple objects, 3342
Storing in a library, 6822
Tab sequence, 3342
Transparency, 3359

Object changed, 4787
Object group

Animation, 3443, 3444
Editing an object within a group, 3384
Migrate, 233
Removing an object, 3383

Object list
Tag, 3686

Object names
Renaming upon migration, 167
Uniqueness, 167

Object property
Dynamization, 3420

Object size
Harmonizing, 3347, 4336

ObjectName property (VBS), 5458
Objects

 Alarm view , 4359
 CSV provider trends , 4349
 Date/time field, 4352
 f(t) trend view , 4355
 Page number , 4370, 4371
 Position in reports , 4303
 Project name, 4366
 Recipe view , 4368
 Size in reports , 4303
 Table view , 4372
 with dynamic length in reports , 4304
Alarm report, 4361
Alarm sequence report, 4360
CSV provider table, 4350
ODBC database field, 4363
ODBC database table, 4364
Recipe report, 4369
Report name , 4367

Objects (VBS)
ActiveScreenItem, 5188
AlarmControl object, 4981
AlarmView, 4992
ApplicationWindow, 5118
Bar, 4996
Battery, 5001
BrowserView, 5057
Button, 5002
ChannelDiagnose, 5007
CheckBox, 5008
Circle, 5011
CircleSegment, 5013
CircularArc, 5016
Clock, 5018
Connector, 5020
DateTimeField, 5023
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DiskSpaceView, 5025
Ellipse object, 5027
EllipseSegment, 5029
EllipticalArc, 5032
FunctionTrendControl, 5038
Gauge, 5046
GraphicIOField, 5049
GraphicView, 5052
Group object, 5055
HMIRuntime, 4937
IOField object, 5059
Line, 5063
Listbox, 5065
MultiLineEdit, 5070
OLEView object, 5073
OnlineTrend Control, 5083
OptionGroup, 5092
Polygon, 5095
Polyline, 5098
ProjectName object, 5100
ProtectedAreaName, 5102
RangeLabelView, 5103
RangeQualityView, 5105
Rectangle, 5112
RoundButton, 5112
Screen, 4940, 4964
Screen object (list), 4938
ScreenItem, 4941, 4966
ScreenItems (list), 4943, 4968
ScreenWindow, 5116
Slider, 5122
SmartClientView object, 5123
SmartTag, 4946, 4972
SmartTags (list), 4944, 4974
StatusForce, 5125
Switch, 5127
SymbolicIOField, 5130
SymbolLibrary, 5135
SystemDiagnoseView, 5137
SystemDiagnoseWindow, 5141
TableView object, 5075
TextField, 5144
TrendRulerControl, 5147
TrendView, 5155
TubeArcObject, 5158
TubeDoubleTeeObject, 5160
TubePolyline, 5162
TubeTeeObject, 5165
UserArchiveControl object, 5167
UserView, 5174
WindowSlider, 5177
WLanQualityView, 5179

ZoneLabelView, 5180
ZoneQualityView, 5181

Objects in VBS
Alarm object, 4947

Objects:AlarmLogs, 4949
Objects:DataItem, 4951
Objects:DataLogs, 4952
Objects:HMIRuntime, 4956
Objects:Item, 4958
Objects:Layer, 4959
Objects:Logging, 4961
Objects:Tag, 4975
Obtaining user rights

Logging on to the operating system with 
administrator privileges, 345
With Windows user account control, 345

OCXState property (VBS), 5461
ODBC database field

Layout in reports, 4363
Use in reports, 4363

ODBC database table
Layout in reports, 4364
Use in reports, 4364

OF, 2558
Off delay, 1883, 1891, 1909, 1918, 2160, 2186, 2196, 
2424, 2444
Offline, 644

Recipe tag, 7124
OK, 1951, 2230
OLE object

create from a file, 3342
Migration, 231
Recreate, 3342
Save in Graphics, 3377
Storing in the image browser , 6898

OLEView object, 5073
Omron, 6625

Analog alarm, 6760
Basic Panel, 6170
Communication drivers, 6744
Data type, 6759
Host Link, 6744
Panel, 6175
Trend, 6759

Omron Host Link, 6754
Address, 6755
Configuring a connection, 6745
Connection, 6745, 6749
Connection cable, 6749
Connection parameters, 6747
Data type, 6753
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Omron Hostlink/Multilink
Migrating data types, 207

On delay, 1881, 1889, 1904, 1915, 2158, 2181, 2192, 
2421, 2439

Retentive, 1907, 1916, 2184, 2194, 2441
On demand, 3715
Ones complement, 2092, 2376
OneToOneView, 5851
Online, 37, 644

Hardware detection, 533
Recipe tag, 4170, 7124

Online access, 8032
Online and Diagnostics view, 1201
Online configuration, 3846, 3859, 3867, 4254

 Table view, 3878
OnlineTrendControl, 3872
Table view, 3882
Trend view, 3882

Online connection, 8023
Multiple TIA Portal instances, 43

Online delta load
Cycle, 62

Online delta loading, 7011
Configuring, 7012
Limitations, 7012
WinCC Web Navigator support, 7012

Online diagnostics, 716
Online displays

Orange color, 1210
Online mode, 8023

Canceling an online connection, 8027
Display of the online mode, 8025
Displaying accessible devices on an interface, 
8021
Displaying all accessible devices as a list, 8021
Go online, 8026
Standby or hibernation of the programming 
device / PC, 8023

Online operation, 38, 43
Online property (VBS), 5461
Online Tools, 1201, 1211
OnlineTableControl

Online configuration, 4254
Runtime data, 4253

OnlineTrendControl, 5083
Online configuration, 3872, 4254
Runtime data, 4253

On-screen keyboard
Runtime settings, 7065

OP 177B mono
Symbol library, 3620

OP 73
Baud rate on PROFIBUS, 6270, 6357

OP 77A
Baud rate on PROFIBUS, 6270, 6357

OP 73
Baud rate on PROFIBUS, 6449, 6451, 6508, 
6510, 6511

OP 77A
Baud rate on PROFIBUS, 6449, 6451, 6508, 
6510, 6511

OP 77A and TP 177A
Differences in the recipe, 4171

OP73
Loading a project, 81

OP77A
Loading a project, 81

OPC, 6599, 7546, 7562, 7630
Accessing tags, 7560
Basic Panel, 6170
Basic settings, 7565
Basics, 6599
Communication, 6599
Communication concept, 7564
Compatibility, 7547, 7563
Configuring a connection, 6599
DCOM user rights, 7551, 7605
Functionality of the WinCC OPC A&E Server, 
7577
HMI device as OPC client, 7548
HMI device as OPC server, 7549
How the WinCC OPC DA Server works, 7566
HTTP connection, 7547
License, 7563
Migrating data types, 208
Mobile Panel, 7547
Multi Panel, 7547
OPC XML DA server, 7547
Panel, 6175
Permitted characters in tag names, 7560
Permitted data type, 7559
Principle of operation of the WinCC OPC HDA 
server , 7568
Principle of operation of the WinCC OPC UA 
Server , 7595
Principle of operation of the WinCC OPC XML DA 
server, 7566
Specifications, 7546, 7562

OPC A&E
License, 7563

OPC A&E Server, 7577
Access to logged events, 7590
Mapping rules, 7577
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Principle of operation, 7577
ProgID, 7577
Quality codes, 7582
supported specifications, 7577

OPC A&Raw Data, 7582
OPC connection

Creating, 7604
OPC DA

Data types, 3753, 6601, 6603
License, 7563

OPC DA server, 7566
Configuring HMI device as ~, 7550
Creating a connection, 7553
Principle of operation, 7566
ProgID, 7548, 7566
supported specifications, 7566

OPC DA Server
Configuring HMI device as ~, 7551

OPC Gateway
Proxy setting, 7556

OPC HDA
License, 7563

OPC HDA Server, 7568
Assemblies, 7574
Attributes, 7573
Deactivate writing access, 7569
Principle of operation, 7568
ProgID, 7569
Quality codes, 7569, 7582
Supported interfaces, 7575
supported specifications, 7568
Write Accesses, 7569

OPC server
Accessibility, 7548, 7565
License, 7563

OPC UA
 Display of the WinCC tags, 7600
 OPC UA Service Sets , 7598
Conformance units, 7598
Data types, 6602
Display of the logging tags, 7601
Profile, 7598

OPC UA Data Access, 7601
OPC UA Log Access, 7601
OPC UA server

Security concept, 7558
Security settings, 7558

OPC UA Server
Communication profile, 7595
Creating a connection, 7554
Principle of operation, 7595
Security concept, 7596

Security settings, 7597
supported specifications, 7595
URL, 7595
User identification, 7597

OPC XML
"Date/Time" data type, 7560
"STRING" data type, 7560
Configuring server, 7557
Permitted cycle time, 7560

OPC XML DA
Data types, 3754, 6602, 6604
Deleting a server, 7557
Editing a server, 7557
License, 7563

OPC XML DA client, 7547
OPC XML DA server

URL, 7548
OPC XML DA Server, 7566

Installing, 7568
Principle of operation, 7566
supported specifications, 7566
URL, 7567

Open
Global library, 6816
Selection list, 7089

Open a project, 360
Compatibility mode V12 SP1, 359

Open log file
Packet filter events, 722, 724
Security events, 722, 724
System events, 721, 724

Open User Communication
 Changing parameter values, 611
Ability to read back, 612
Changing IP configuration parameters with 
T_CONFIG, 3278
Connection configuration, 590, 592
Connection description, 605, 608, 609
Connection establishment, 590
Connection parameters, 595
Creating a connection, 599
Deleting an interconnection, 602
Establishing a communication connection with 
TCON, 3240, 3243
Establishing a connection and reading data with 
TRCV_C, 3218, 3223
Establishing a connection and sending data with 
TSEND_C, 3207, 3211
General, 589
Instructions, 590
Port numbers, 610
Protocols used, 603
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Receiving data via UDP with TURCV, 3269
Receiving data with TRCV, 3256, 3260
Sending data via UDP with TUSEND, 3266
Sending data with TSEND, 3250, 3253
Starting connection parameter assignment, 598
TCON_IP_RFC, 609
TCON_IP_v4, 608
TCON_Param, 605
Terminating a communications connection with 
TDISCON, 3248
TSAP, 613

OpenAllLogs, 4624, 4844
OpenCommandPrompt, 4628, 4845
OpenControlPanel, 4629
OpenControlPanelDialog, 4627, 4846
OpenFileBrowser, 4626
opening

Menus and Toolbars , 3658
Opening a force table, 1803
Opening a watch table, 1776
Opening phone books, 8094
Opening Siemens Industry Online Support, 517
OpenInternetExplorer, 4628, 4847
OpenScreenKeyboard, 4625, 4847
OpenTaskManager, 4630, 4848
Operability

Dynamization, 3432
Operand, 1289, 1295, 1296, 1297, 1298, 1299, 1301, 
1302, 1303, 1305, 1306, 1308, 1309

Inserting, 1547, 1589
Operand area, 1074
Operate recipe

Change recipe data record, 4215
Operating

Key, 7091
Runtime using the keyboard, 7094
Runtime with mouse, 7096

Operating behavior
Enabling system memory, 1108
Using clock memory, 1109
Using time-of-day functions, 1094

Operating element
Availability for Comfort Panels, 3511
Availability for Mobile Panels, 3514
Availability for Multi Panels, 3512
Availability for WinCC Runtime Advanced, 3515
operation, 7088
Recipe view, 4212, 7125

Operating mode, 760
  , 6545
Introduction, 1065
RUN, 1070

STARTUP, 1067
STOP, 1070
Transitions, 1066

Operating object
Availability, 3517
Availability for Basic Panels, 3508
Availability for Panels, 3509

Operating recipes
Change recipe data record, 4215
Copying a recipe data record, 4214
Creating a recipe data record, 4209
Creating recipe data records, 4209, 4210, 4214
Delete recipe data record, 4215
Load recipe data record, 4215
Modifying the recipe structure, 4219, 4243
Read recipe data record, 4210, 4216
Transfer data record, 4211, 4217

Operating system
Access rights, 7059
Asian language setting, 6884
Setting to Western, 6884

Operating system , 1259
operation

Key, 7088
Operating element, 7088

Operation, (Two-hand)
Alarm indicator, 4043
Alarm view, 4038, 7162
Alarm window, 4038, 7162
Feedback, 7080
Recipe view, 4212, 7125
Simple alarm view, 4041, 7163
Simple recipe view, 4205, 7138
Simple user view, 7101

Operation feedback, 7080
Operation in runtime

Multi-key operation, 90
Operation using the keyboard

Alarm view, 4039, 4049
Alarm window, 4039, 4049
Simple alarm view, 4042

Operation using the mouse
Alarm indicator, 4044
Alarm view, 4039, 4049
Alarm window, 4039, 4049
Simple alarm view, 4042

Operation with the keyboard
Recipe view, 4213, 7126

Operation with the mouse
Recipe view, 4213, 7126

OperationSteps property (VBS), 5463
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Operator control
Alarm view, 3580, 3589, 7170
f(x) trend view, 3549
Lock/unlock, 97
Locked, 96
Value table, 3639

Operator input alarm property changed, 4774
Operator input in the recipe view

Transferring data, 6249, 6333, 6429, 6521, 6774
OperatorMessageID property (VBS), 5463
OperatorMessageIndex property (VBS), 5464
OperatorMessageName property (VBS), 5465
OperatorMessageNumber property (VBS), 5465
OperatorMessageSelected property (VBS), 5466
OperatorMessageSource1 property (VBS), 5466
OperatorMessageSource10 property (VBS), 5471
OperatorMessageSource2 property (VBS), 5467
OperatorMessageSource3 property (VBS), 5467
OperatorMessageSource4 property (VBS), 5468
OperatorMessageSource5 property (VBS), 5468
OperatorMessageSource6 property (VBS), 5469
OperatorMessageSource7 property (VBS), 5469
OperatorMessageSource8 property (VBS), 5470
OperatorMessageSource9 property (VBS), 5470
OperatorMessageType1 property (VBS), 5471
OperatorMessageType10 property (VBS), 5476
OperatorMessageType2 property (VBS), 5472
OperatorMessageType3 property (VBS), 5472
OperatorMessageType4 property (VBS), 5473
OperatorMessageType5 property (VBS), 5473
OperatorMessageType6 property (VBS), 5474
OperatorMessageType7 property (VBS), 5474
OperatorMessageType8 property (VBS), 5475
OperatorMessageType9 property (VBS), 5475
Optical feedback, 7081
Optimized access, 1267, 1269
Optimized block access, 273
Optimized drawing

Runtime settings, 7065
Optimizing the configuration

Allen-Bradley DF1, 6647, 6668, 6692, 6702, 6723, 
6736, 6756

Option
Installing, 7034
Uninstalling, 7034

Option handling, 1010, 1013, (See Configuration 
control (ET 200SP)), (See Configuration control (ET 
200MP))
OptionGroup object, 5092
OR, 1602, 2089, 2133, 2134, 2373
Order number, 515, 850

Organization block (OB)
Assigning event with ATTACH, 2808
Canceling event assignment with DETACH, 2809
Creating, 1448
Cyclic interrupt OB, querying parameters with 
QRY_CINT, 2812
Cyclic interrupt OB, setting parameters with 
SET_CINT, 2810
exporting to an external source file, 1678
Function, 1262
Reading start information with RD_SINFO, 2845
Start information, 1262

Orientation property (VBS), 5476
OSPF

Area range, 973
Areas, 841, 972
Configuration, 970
Interfaces, 974
Link State Advertisement, 841
OSPFv2 Interfaces, 867
OSPFv2 LSDB (information), 871
OSPFv2 neighbors, 868
OSPFv2 virtual neighbors, 870
Router, 841
Router status, 841
Virtual Links, 976

Other PLCs
Addressing, 6626
Data types, 6626
Special features, 6626

OUT_RANGE, 1950, 2229
Outgoing, 3897, 4781
Output

Inserting, 1544, 1585
remove, 1545, 1586

Output (O), 1074
Output alarm, 3584
Output byte (QB), 1074
Output double word (QD), 1074
Output fields

Multiplex tag, 72
Output word (QW), 1074
Overflow, 1166, 1174, 4794
Overlay icon, 1208
Overlaying

Tag, 1309
Overlaying tags, 1502
Override function, 3645
Overview

using the display formats in the force table, 1807
via the display formats in the watch table, 1781
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Overview navigation, 504, 507, 509, 6129, 6135, 
6137
Overview of the cross-reference list, 1761
Overview of TS Adapters that can be used, 8101
Overview window, 61, 326

Comparing objects, 328
Display all blocks, 329
Showing and hiding columns, 329
Sorting details view, 329

P
P, 1869, 1871, 2146, 2148
P_TRIG, 1873, 2151
Pack&Go file

Create, 6986
Download to HMI device, 6987

Packet filter log, 722, 724
Page

 Deleting report page, 4318
 Sorting report page, 4318
Adding to report, 4318
Maximum number of configurable in report, 4301

Page number
Layout in reports, 4370, 4371

PageDown, 4645, 4849
PageMode property (VBS), 5477
PageModeMessageNumber property (VBS), 5478
PageUp, 4645, 4849
Pane mode, 323
Panel

Area pointer, 6177
Communication drivers, 6175
Display and operating object, 3509
HTTP protocol, 6175
Interface, 6176
Mitsubishi, 6175
Modicon Modbus, 6175
Omron, 6175
OPC, 6175
S7 200, 6175
S7 300, 6175
S7 400, 6175
S7-1200, 6175

Panels
Available system functions, 4536

Panning, (See move view)
Parallel communication

Communication drivers, 6197, 6627
Parameter

For CPU, 1087
Hidden parameters, 1549, 1590

Predefined - writing with WR_DPARM, 2806
SIMATIC LOGO!, 6535

Parameter assignment, 1278
Parameter assignment parameters

Hardware, 520
Parameter block

Configuring , 3936
Parameter blocks, 3934
Parameter transfer, 1277, 1279, 1281, 1283, 1285, 
1286, 1287, 1288

User-defined function, 4444
Parameter types, 1363
Parameters

Client, 6588
Configurable, 6457
Connection, 6631, 6650, 6678, 6695, 6713, 6726, 
6747
Ethernet, 6454
Interface, 6455
MPI, 6412, 6414, 6415
Output in analog alarm, 3942
output in discrete alarms, 3947
output in user alarms, 3950
PLC, 6457
PROFIBUS, 6230, 6233, 6234, 6276, 6313, 6315, 
6317, 6399, 6400, 6402
S7 1200, 6354
S7 1500, 6268
S7 200, 6446, 6451, 6505, 6510, 6511
Tags, 6591

Parent property (VBS), 5478
Part number, (see Order number)
Password, 7097

Backing up, 7098
Changing, 4390
For CPU access protection, 1087
for function key, 3463
Hierarchy level, 4380, 4382
HMI connection, 6218, 6232, 6237, 6299, 6315, 
6320
Password aging, 4381
Password complexity, 4381, 4383
Restoring, 7098
SmartServer, 7425

Password legitimation, 2071, 2354, 2569
Password list, 7097
Password property (VBS), 5480
Password protection, 788, 1087, 1110, 1111

Protection concept, 404
Revoking access rights, 405

PasteRows, 5852
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Pasting
Adjusting screen size, 6930
Color, 6927
Font, 6927
Function key, 6930
Invalid object, 6927
Principle, 6925, 6932

Pause, 4788
PC

HMI connection, 6205, 6227, 6290, 6310, 6376, 
6397, 6410
S7 1500, 6205
S7 300/400, 6376
WinCC RT Advanced, 6310
WinCC RT Professional, 6205, 6227, 6290, 6310, 
6376, 6397, 6410
WinCC RT Advanced, 6205, 6227, 6290, 6376, 
6397, 6410

PC CP, 643
PDF file, 7273
PE_CMD, 2751
PE_DS3_Write_ET200S, 2757
PE_End_RSP, 2788
PE_Error_RSP, 2785
PE_Get_Mode_RSP, 2790
PE_I_DEV, 2781
PE_List_Modes_RSP, 2789
PE_Measurement_List_RSP, 2795
PE_Measurement_Value_RSP, 2797
PE_PEM_Status_RSP, 2792
PE_Start_End, 2747
PE_Start_RSP, 2786
PE_WOL, 2758
PEEK, 2509

Read memory address, 2509
PEEK_BOOL, 2511

Read memory bit, 2511
Perfect Forward Secrecy, 705
Performance, 272
Performance features

Engineering system, 7185
HMI device, 7187, 7190, 7194, 7198, 7202, 7205, 
7210, 7214
WinCC Runtime, 7210
WinCC Runtime Professional, 7214
WinCC Runtime Professional performance, 7217

Permanent connection, 820
Permanent station, 820
Permanent window, 3317
Permit access with PUT/GET communication from 
remote partners, 1114
Permit overwriting of device name, 1042

Permitted data type
OPC, 7559
SIMATIC HMI HTTP Protocol, 7456

Permitted data types
Trends, 6255, 6339, 6435, 6529, 6541

Permitted operands for the force table, 1805
Permitted operands for the watch table, 1778
PersistentRTAuthorization property (VBS), 5481
PersistentRTCSAuthorization property (VBS), 5482
PersistentRuntime property (VBS), 5482
PersistentRuntimeAuthorization property (VBS), 
5483
PersistentToDownload property (VBS), 5484
PersistentToDownloadAuthorization property (VBS), 
5484
PG/PC interface

Go online, 8027
Modifiable MPI interface parameters, 8042
Modifiable PROFIBUS interface parameters, 
8042

Picture cycle, 3738
Picture property (VBS), 5486
PictureDeactivated property (VBS), 5487
PictureOff property (VBS), 5488
PictureOn property (VBS), 5489
PID_3Step

In/out parameters, 3060
Input parameters, 3056, 3087
Instruction, 3047, 3079
Output parameters, 3058, 3088
Static tags, 3089

PID_Compact
 Input parameters, 3009, 3031
In/out parameters, 3011
Instruction, 3028
Output parameters, 3010, 3032
Static tags, 3012, 3033

Pin assignment
6XV1440 - 2P for Mitsubishi PG protocol, 6698
Allen-Bradley, 6656
Allen-Bradley cable 1747-CP3, 6658
Allen-Bradley cable 1761-CBL-PM02, 6659
Allen-Bradley cable 1784-CP10, 6657
Multipoint cable 1:MP/TP/PC, 6751
Multipoint cable 2:RS422, MP/TP/PC, 6752
Point-to-point cable 1, 
Point-to-point cable 2, 6732
Point-to-point cable PP1 for Omron, 6752
Point-to-point cable PP2 for Omron, 6753

Ping, 910
Pipe, 3604
Pipe bends, 3605
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Angle, 3605
Radius, 3605

Placeholder device, 1056
Play ended, 4769
PLC

Connecting, 6633, 6680, 6697, 6716, 6749
Enabling system diagnostics, 4127, 4145
MPI parameters, 6415
PROFIBUS parameters, 6234, 6317, 6402
PROFINET parameters, 6214, 6295, 6382
Reading recipe data record, 7134, 7135, 7143
System diagnostics view, 4127, 4145
Tag, 3702
Transferring recipe data record, 7136, 7137, 
7144

PLC code display, 3593
PLC data, 6865
PLC data type, 3750, 3751, 3753, 3754, 3755, 3756

Addressing, 1307
Comparing, 1709
Creating, 1668
Declaration in data blocks, 1649
Declaration in the block interface, 1501
Declaration table for PLC data types, 1667
Declaring, 1671
Declaring ARRAY, 1670
Declaring STRUCT, 1671
Definition, 1364, 1667
Deleting, 1669
Offline/offline comparison, 1685
PLC data types generated by the system in 
libraries, 50
Programming the structure, 1669
Tag properties, 1672, 1673

PLC data type in WinCC, 3679
PLC data types, 48, 274, 3750, 3752
PLC prefix, 3696
PLC tag

 Importing and exporting, 1443, 1444, 1445
Automatically filling in cells, 1443
Comparing, 1707
Comparing a PLC tag table, 1685
Comparison, 1681
Copying, 1441
Declaring, 1429, 1430, 1432, 1434
Definition, 1295
Monitor, 1440
Offline/offline comparison, 1685
Permissible addresses and data types, 1427
PLC tag table, 1421, 1422, 1427, 1428, 1429
Properties, 1437, 1438
Reconnecting, 3697

Retentive behavior, 1431
Rules, 1427
Sorting rows, 1442
Updating comparison results, 400

PLC tags, 796, 797, 799
PLC UDTs

WinCC, 3752
PLC5, 6662
PLUG, 908

C-PLUG, (C-PLUG)
KEY-PLUG, (KEY-PLUG)

PN/PN couplers
Grouping, 1047
Linking Ethernet subnets, 1047

Pointer
ANY, 1358
POINTER, 1356
VARIANT, 1361

POINTER, 1356
Pointer name

Area pointer, 6164
PointerColor property (VBS), 5491
PointsCount property (VBS), 5491
point-to-point, 839
Point-to-point communication (PtP), 1100

Freeport protocol, 1100
Point-to-point connection

Allen-Bradley DF1, 6654
Configuring communication parameters with 
PORT_CFG, 3108
Configuring receive parameters with RCV_CFG, 
3112
Configuring serial transmission parameters with 
SEND_CFG, 3111
Deleting receive buffer with RCV_RST, 3122
Enable receiving with RCV_PTP, 3121
Initiating data transfer with SEND_PTP, 3119
Querying the signal state with SGN_GET, 3123
Setting output signals with SGN_SET, 3124

POKE, 2513
Write memory address, 2513

POKE_BLK, 2516
Write memory area, 2516

POKE_BOOL, 2515
Write memory bit, 2515

Polygon, 3594
Configuring corners, 3595
Layout, 3594
Radii, 3595

Polygon object, 5095
Polyline, 3596

Configuring corners, 3596
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Line end, 3596
Line start, 3596
Radii, 3596

Polyline object, 5098
Port, 562

102 (S7 protocol - TCP), 667
123 (NTP), 687, 694
161 (SNMP), 687
20/21 (FTP), 667
443 (HTTPS), 687
4500 (IPsec), 687
500 (IPsec), 687
500 (ISAKMP - UDP), 713
514 (Syslog), 687
80 (HTTP), 667
8448 (security diagnostics), 773
Configuration, 901
Interconnecting, 1036
Port configuration, 900, 903
Renaming, 638
Setting, 7527, 7529

Port configuration, 903
Port diagnostics

SFP diagnostics, 913
Port numbers, 610
Port options, 1041, 6221, 6302, 6387

Enable autonegation, 1040, 6220, 6301, 6386
Monitor, 1040, 6220, 6301, 6386
Transmission medium/duplex, 1039
Transmission rate / duplex, 6220, 6301, 6386

PORT_CFG, 3108
Portal view, 303
Position

Editing multiple objects, 3371, 4339
Of objects, 3345, 4333
of objects in the report, 4301

Position data
Migrate, 233

Positioning axis technology object
 Configuring approach/homing direction, 7844
 Configuring distance per motor revolution, 7830
 Configuring end of reference point switch, 7843
 Configuring maximum velocity / start/stop 
velocity, 7835
 Configuring passive homing, 7842
 Configuring the homing speed, 7845
 Drive enable configuration, 7829
 Drive ready configuration, 7830
 PTO and HSC configuration, 7827
 User unit configuration, 7829
Active homing, 7847
ActiveHoming tags, 7939

Actor tags, 7937
Add new object, 7825
Axis name configuration, 7827
Basic parameters, 7826
Changing the configuration parameters for 
dynamics in the user program, 7841
Changing the configuration parameters for 
homing in the user program, 7848
Commissioning overview, 7824
Configuration overview, 7824
Configuration window icons, 7826
Configuring acceleration, 7836
Configuring active homing, 7843
Configuring deceleration, 7836
Configuring end of reference point switch, 7845
Configuring home position offset, 7845
Configuring invert direction signal, 7830
Configuring jerk limiter, 7837
Configuring permit auto reverse at the hardware 
limit switch, 7844
Configuring pulses per motor revolution, 7830
Configuring ramp-down time, 7836
Configuring ramp-up time, 7836
Configuring reference point position, 7843, 7845
Configuring reference point switch input, 7843, 
7844
Configuring smoothing time, 7837
Configuring the velocity limiting unit configuration, 
7835
Diagnostics overview, 7824
Drive signal configuration, 7829
DynamicDefaults tags, 7944
DynamicLimits tags, 7943
Emergency stop deceleration configuration, 7838
ErrorBits tags, 7953
Extended parameters, 7826
General dynamics configuration, 7835
Hardware and software components, 7820
Hardware interface configuration, 7827
Homing tags, 7947
Mechanics configuration, 7830
Mechanics tag, 7942
Passive homing, 7845
PassiveHoming tags, 7940
Position tag, 7936
PositionLimitsHW tags, 7946
PositionLimitsSW tags, 7945
Response when jerk limiter is activated, 7840
StatusBits tags, 7949
StatusPositioning tags, 7948
Tools, 7823
Units tag, 7942
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Updating the tags, 7954
Velocity tag, 7937

Possible cause of error
Transferring data, 6252, 6336, 6432, 6524, 6777

pow function, 6043
Power budget, 1180
Power Management, 6089
Powerpack, 127

Engineering system, 127
Installing, 127
Runtime, 127

PPI, 6143
Network, 6146
Network architecture, 6146
S7 200, 6511

Precision property (VBS), 5492
Predefined alarm classes, 3899, 3900
Predefined firewall rules

CP 1543-1, 773
CP 1628, 764
CP x43-1 Adv., 762
SCALANCE S, 738, 740

Predefined styles, 3360
Premium, 6720
Preparing migration, 152
Prerequisites for establishing a VPN connection, 
8130
Preshared keys, 703
Press, 4774
Press ESC twice, 4780
Press key, 4793
Press key on keyboard, 4793
Press left mouse button, 4784
Press right mouse button, 4789
PressButton, 4639
Pressed property (VBS), 5493
PreviousColumn, 5852
PreviousTrend, 5853
Print, 5853
Print alarm

Configuring print parameters, 7243
Print job

Creating a task for automatic start, 4325
creating for the report, 4322
Migrate, 246
Print job/Script diagnostics, 3530

Print job list, 4319
Print job/Script diagnostics

Function, 3530
Print job, 3530

Print job/Script diagnostics , 3529
Print scope, 407

Print server, 7222
Printable contents, 407
PrintConfiguration property (VBS), 5493
Printing

Alarms, 7052
Audit Trail, 7240
Changing the settings, 408
Creating a cover page, 413
Creating frames, 412
Documentation settings, 406
Elements in the library, 411
Elements in the project tree, 411
Non-printable contents, 407
Non-printable objects, 408
Print contents, 410
Print server, 7222
Printing device view, 510
Printing network view, 510
Process a cover page, 414
Process borders, 414
Report, 4320, 4343, 4344
Runtime, 7052
Screen, 7052
Specify layout, 409
Specify print layout, 409
Specifying the print area, 418
Structure of printout, 406
Use borders, 411
Use borders and cover pages, 406
Use cover page, 409

Printing a project, 423
Printing labels, 427

Determining the correction value for the print shift, 
428

Printing of alarms
Configuring:printing of alarms, 3961

PrintJobName property (VBS), 5494
PrintReport, 4582, 4850
PrintScreen, 4581, 4850
PrintVisibleColumnsOnly property (VBS), 5494
Priorities

Local error handling, 1638
Priority, 4069

Setting, 3941
Process control level, 7370
Process control phase, 7044
Process data area

Module addressing, 1078
Module start address, 1078

Process image, 1078
Basics, 1076
I/O access error, 1076

Index

WinCC Professional V13.0
System Manual, 02/2014 8259



Reading inputs with GETIO, 2678
Reading the process image area with 
GETIO_PART, 2679
Synchronizing the inputs with SYNC_PI, 2671
Synchronizing the outputs with SYNC_PO, 2672
Transferring the process image area with 
SETIO_PART, 2680
Updating, 1076
Updating inputs with UPDAT_PI, 2667
Updating the outputs with UPDAT_PO, 2669
Writing outputs with SETIO, 2679

Process level, 7370
Process value

 display, 3829
Displaying Statistics Function, 7341
Saving to database, 3789
Swapping out, 3791

Process value archive, 7643, 7644, 7659
Displaying data, 7643
Query, 7644
Querying archive data, 7659
Recordset, 7643

Process value logging, 3757
Process-controlled tag, 3778
Processing method, 3784

Data log, 3783
ProcessValue

Assigning SmartTags, 5497
Processvalue property (VBS), 5495
ProcessValue property (VBS), 5496
Product support, 6142
PROFIBUS, 557, 6143, 6235, 6318, 6362, 6403

Connection with PROFINET, 1018
ET 200S in DPV1 mode, 1014
HMI connection, 6224, 6227, 6228, 6305, 6308, 
6310, 6390, 6394, 6397
Network, 6144
OP 73, 6270, 6357
OP 77A, 6270, 6357
OP 73, 6449, 6451, 6508, 6510, 6511
OP 77A, 6449, 6451, 6508, 6510, 6511
Parameters, 6230, 6233, 6234, 6269, 6313, 6315, 
6317, 6357, 6399, 6400, 6402, 6449, 6508
S7 1200, 6304, 6306, 6310
S7 1500, 6223, 6225, 6227, 6228
S7 300/400, 6224, 6389, 6390, 6392, 6394
S7-1200, 6305, 6308
S7-300/400, 6397
Standard, 6235, 6318, 6403
Universal, 6235, 6318, 6403
WinCC RT Advanced, 6225, 6306, 6392
WinCC RT Professional, 6225, 6306, 6392

PROFIBUS cable configuration
Optical ring, 559

PROFIBUS communication
S7 1200, 6304, 6306
S7 1500, 6223, 6225
S7 300/400, 6389, 6392

PROFIBUS DP, 997, 6144
Configuring the Control Panel, 6788
Connection, 6266, 6352, 6442
Direct key, 6566

PROFIBUS parameters
S7 1200, 6313, 6315, 6317
S7 1500, 6230, 6233, 6234
S7 300/400, 6399, 6400, 6402

PROFIBUS profile, 557, 6235, 6318, 6403
Different profiles on the same subnet, 557, 6235, 
6318, 6403
Effect on the transmission rate, 557, 6235, 6318, 
6403
Meaning of profiles, 558, 6236, 6319, 6404

PROFIBUS DP
DirectKey, 4581
Network configuration, 6793

PROFIenergy
Control PROFIenergy commands in the I-Device, 
2781
Description, 2745
Generate answer to command at end of pause, 
2788
Generate answer to command at start of pause, 
2786
Generate list of supported measured values as 
answer, 2795
Generate negative answer to command, 2785
Generate PEM status as answer, 2792
Generate queried energy data as answer, 2790
Generate queried energy savings modes as 
answer, 2789
Generate queried measured values as answer, 
2797
Generate supported PROFIenergy commands as 
answer, 2794
PE_CMD, 2751
PE_DS3_Write_ET200S, 2757
PE_End_RSP, 2788
PE_Error_RSP, 2785
PE_Get_Mode_RSP, 2790
PE_I_DEV, 2781
PE_Identify_RSP, 2794
PE_List_Modes_RSP, 2789
PE_Measurement_List_RSP, 2795
PE_Measurement_Value_RSP, 2797
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PE_PEM_Status_RSP, 2792
PE_Start_End, 2747
PE_Start_RSP, 2786
Reading out status information, 2751
Set power module switching behavior, 2757
Start and exit energy-saving mode, 2747, 2751
Wake on LAN, 2758

Profile, (See bus profile)
Profiles, 1120
PROFINET, 562, 751, 6143, 6611, 6621, 6623

Connection, 6265, 6350, 6440
Connection with PROFIBUS, 1018
Device replacement without exchangeable 
medium, 1042
HMI connection, 6199, 6200, 6202, 6205, 6208, 
6282, 6283, 6285, 6287, 6368, 6369, 6371, 6373, 
6376
S7 1200, 6282, 6285
S7 1500, 6199, 6202
S7 300/400, 6368, 6371

PROFINET address, 653
PROFINET device name, 1028
PROFINET interface, 1031, 1087, 1214
PROFINET IO, 1017, 1022, 1023, 1033, 1034, 6609

Port options, 1039, 6220, 6301, 6386
PROFINET IO device

Assigning a name, 1238
Name assignment in the dialog, 1240
Name assignment in the online and diagnostics 
view, 1239

PROFINET IO devices
Reading a portion of the inputs with 
GETIO_PART, 2679
Reading consistent data with DPRD_DAT, 2717
Writing a part of the outputs with SETIO_PART, 
2680
Writing all outputs with SETIO, 2679
Writing consistent data with DPWR_DAT, 2719

PROFINET IO system, 1034
PROFINET parameters

HMI connection, 6211, 6292, 6379
HMI device, 6212, 6294, 6380
PLC, 6214, 6295, 6382
S7 1200, 6292, 6295
S7 1500, 6211, 6214
S7 300/400, 6379, 6380, 6382
S7-1500, 6212

PROFINET RT class, 1018, 6612
PROFIsafe address, 6088
ProgID

OPC A&E Server, 7577
OPC DA server, 7566

OPC HDA Server, 7569
OPC XML DA Server, 7567

Program alarm
generating with Program_Alarm, 2838

Program card, 1071
Program control operations, 2076, 2360, 2574
Program cycle OB

Description, 1115
Program editor

"Instructions" task card, 1472
Block interface, 1472
Enlarging the programming window, 1478
Favorites, 1472
Function, 1470
General settings, 299, 301, 302, 1489
Programming window, 1472
Structure, 1471
Testing task card, 1472
Toolbar, 1472
Using the keyboard, 1474

Program execution
Cyclic, 1115

Program information
Displaying, 1733
In the assignment list, 1734
In the call structure, 1742
In the dependency structure, 1749
in the tab , 1754
Views, 1733

Program resources, 1447
Program status

Editing blocks, 1767
FBD, 1769
Function, 1764
LAD, 1768
Modify tag, 1767
SCL, 1770
Switching off, 1765
Switching on, 1765

Program_Alarm, 2838
Programming

Linear, 1260
Structured, 1260

Programming language
Changeover, 1635
FBD, 1557
LAD, 1514
Rules for changing, 1634

Programming recommendations, 275
Programming window

Customizing, 1607
SCL, 1606
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Project, 7018, 7370
Activating, 7015, 7078, 7492
Basics, 357
Carrying out an online/offline comparison, 390
Carrying out offline/offline comparisons, 390
Closing, 365
Comparing data, 44, 389
compile (overview), 6975, 7002
Compiling , 6977, 7004
Compiling project data, 380
Creating, 358
Deactivating, 7493
Deleting, 365
Detailed comparison, 400
Download, 6985, 7009, 7044
download (overview), 6975, 7002
Harmonizing, 495
Include in user group, 7061
Load, 6982
Migrate, 199, 218, 257
Migrating, 170
multilingual, 6888
Multiple connections, 6243, 6328, 6424, 6518
Operating with WinCC WebNavigator client, 7536
Saving, 364
Showing properties, 364
Simulation with a tag simulator, 6996
Upgrade, 6962

Project archives, 374
Project data

Compiling, 380
Downloading to a memory card, 385
Export alarm, 6835
Export text list, 6857
Exporting a recipe, 6829, 6832
Exporting tag, 6850
Importing alarms, 6836, 6838
Information on compiling, 379
Information on loading, 381
IO-Link master module, 44
Loading, 383
Uploading from a device, 386

Project file
Initialization, 6871
Initializing, 6871

Project ID, 6125
Project language, 366, 6882

Activate, 6886
Disabling, 6886

Project languages
Changing the editing language, 369
Specifying project languages, 368

System texts, 6889
Use, 366
User texts, 6889

Project library, 442, 6805, 7687
Adding types, 475
Assigning a common version to types, 489
Cleaning up, 496
Creating folders, 467
Discarding all versions, 481
Discarding the type version, 481
Migrating, 193
Performing a consistency check for a type version, 
480
Release all versions, 483
Release the type versions, 482
Updating the project, 484
Using filter view, 469
Using the element view, 445
Using types, 476

Project name
Changing by the migration, 222

Project text
Exporting, 6863, 6893

Project texts
Application example, 373
Changing the text of selected objects, 370
Displaying reference text, 370, 6892
Exporting all texts, 372
Exporting individual texts, 371
Importing, 372, 6862, 6895
Migrating, 191
Translating individual texts, 3495, 6890
Translating project texts, 369
Translation into project languages, 366, 6889

Project tree
Adding device, 531
Function, 308
Hiding, 1478
Reducing automatically, 314
Showing, 1478

Project version
Upgrade, 6962

Project view, 305
ProjectName object, 5100
ProjectPath property (VBS), 5497
Project-wide alarm class

Create, 3917
Use, 3917

Properties
"Local scripts" editor, 4471

Properties (CPU), 1087
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Properties (VBS)
 RotationCenterLeft, 5506
 TrendWindowRulerLayer , 5691
AboveUpperLimitColor, 5182
AcceptOnExit, 5183
AcceptOnFull, 5183
AccessPath, 5184
ActiveProject, 5186
ActiveScreen, 5186, 5187
ActualPointIndex, 5189
ActualPointLeft, 5189
ActualPointTop, 5190
AdaptBorder, 5191
AdaptFontSizeToLineHeight, 5191
AdaptPicture, 5192
AdaptScreenToWindow, 5192
AdaptSize, 5192
AdaptWindowToScreen, 5192
Address, 5193
AdjustBorder3DWithStyle, 5193
AdjustRulerWindow, 5194
Alarm, 5194
AlarmColor, 5195
AlarmFilter, 5195
AlarmHigh, 5196
AlarmID, 5196
AlarmLow, 5197
AlarmLowerLimit, 5198
AlarmLowerLimitColor, 5198
AlarmLowerLimitEnabled, 5199
AlarmLowerLimitRelative, 5199
AlarmUpperLimit, 5200
AlarmUpperLimitColor, 5201
AlarmUpperLimitEnabled, 5201
AlarmUpperLimitRelative, 5202
Alignment, 5202
AlignmentLeft, 5203
AlignmentTop, 5203
AllowMenu, 5204
AllowPersistence, 5204
Analog, 5205
AngleMax, 5205
AngleMin, 5206
ApplyProjectSettings, 5207
AskOperationMotive, 5208
Assignments, 5208
AssumeOnExit, 5209
AssumeOnFull, 5209
Authorization, 5210
AutoCompleteColumns, 5211
AutoCompleteRows, 5212
AutoScroll, 5213

AutoSelectionColors, 5213
AutoSelectionRectColors , 5214
Average, 5215
BackColor, 5216, 5217
BackColorBottom, 5219
BackColorTop, 5219
BackFillStyle, 5220, 5221
BackFillStyleReadOnlySpecial, 5221
BackFlashingColorOff, 5222
BackFlashingColorOn, 5223
BackFlashingEnabled, 5224
BackFlashingRate, 5224
BackPictureAlignment, 5487
BackPictureName, 5488
BarBackColor, 5225
BarBackFillStyle, 5226
BarColor, 5228
BarStartValue, 5229
BaseScreenName, 5229
BeginTime(i), 5230
BelowLowerLimitColor, 5231
BitNumber, 5231
BlinkColor, 5232
BlinkMode, 5232
BlinkSpeed, 5233
BorderBackColor, 5234
BorderBrightColor3D, 5235
BorderColor, 5236, 5237
BorderEndStyle, 5239
BorderFlashingColorOff, 5240
BorderFlashingColorOn, 5241
BorderFlashingEnable, 5242
BorderFlashingRate, 5243
BorderInnerStyle3D, 5244
BorderInnerWidth3D, 5244
BorderOuterStyle3D, 5245
BorderOuterWidth3D, 5245
BorderShadeColor3D, 5246, 5247
BorderStyle, 5247
BorderStyle3D, 5249
BorderWidth, 5250, 5251, 5403
BorderWidth3D, 5252
ButtonCommand, 5254
Caption, 5255, 5256
CaptionBackColor, 5256
CaptionColor, 5257, 5258
CaptionText, 5258
CaptionTop, 5259
CellCut , 5259
CellSpaceBottom, 5260
CellSpaceLeft, 5261
CellSpaceRight, 5261
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CellSpaceTop, 5262
CenterColor, 5262
CenterSize, 5263
CentrePoint, 5263
CentrePointLeft, 5264
CentrePointTop, 5264
ChangeMouseCursor, 5265
CheckMarkAlignment, 5267
CheckMarkCount, 5267
ClearOnError, 5268
ClearOnFocus, 5269
Closable, 5270
Color, 5270, 5271
ColorChangeHysteresis, 5272
ColorChangeHysteresisEnabled, 5273
ColumnColor(i), 5276
ColumnDisplayName(i), 5276
ColumnResize, 5277
ColumnScrollbar, 5278
ColumnSizingEnable, 5277
ColumnTitle, 5280
ColumnTitleAlign, 5279
ColumnUpdateEnabled(i), 5280
comma,EdgeStyle, 5308
Command, 5281
CommonTimeAxisColor, 5281
ConfigureTimeAxis(i), 5282
ConnectionType, 5283
ConnectTrendWindows, 5283
ContinousChange, 5284
CornerStyle, 5284
Count, 5286
CountDivisions, 5286
CountSubDivisions, 5287
CountValueColumns, 5287
CountVisibleItems, 5288
CurrentColumnIndex, 5288
CurrentCurveIndex, 5289
CursorControl, 5290
CurveColor(i), 5291
CurveLineWidth(i) , 5291
CurvesCount, 5292
CurveUpdateEnabled(i), 5292
DangerRangeColor, 5293
DangerRangeStart, 5294
DangerRangeVisible, 5294
DataIndex(i), 5295
DataLogTag, 5296
DataX(i), 5297
DataXY(i), 5298
DataY(i), 5298
DeleteDate(i), 5299

DeleteEnable, 5299
DialColor, 5300
DialFillStyle, 5300
DialSize, 5301
Direction , 5301
DisplayName(i), 5302
DisplayOptions, 5302
DoubleClickAction, 5303
DrawAlwaysInsideFrame, 5304
DrawEnhancedHTMLBrowser, 5304
DrawInsideFrame, 5305
DrawStylishButton, 5306
Drive, 5306
EdgeStyle, 5307
Editable(i), 5309
EditEnabled, 5310
EditOnFocus, 5310
Enabled, 5311, 5312
EndAngle, 5314
EndPoint, 5315
EndPointLeft, 5315
EndPointTop, 5316
EndStyle, 5316, 5317
EndTime(i), 5317
ExportDirectoryChangeable , 5320
ExportDirectoryname, 5320
ExportFileExtension, 5321
ExportFilename, 5321
ExportFilenameChangeable , 5322
ExportFormatGuid, 5323
ExportFormatName, 5323
ExportParameters, 5324
ExportSelection, 5324
ExportShowDialog, 5325
ExtraSpaceForLabelDisplay, 5327
FieldLengthReadOnlySpecial, 5327
FillColorMode, 5329
FillPatternColor, 5330
FillStyle, 5331
Filter, 5332
FirstConnectedObjectIndex, 5332
FirstConnectedObjectName, 5333
FixedAspectRatio, 5333
FlashingColorOff, 5334
FlashingColorOn, 5336
FlashingEnable, 5337
FlashingRate, 5338
FlashTransparentColor, 5341
Flip, 5341
FocusColor, 5342
FocusWidth, 5343, 5344
Font , 5345
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FontBold, 5346
FontItalic, 5347
FontName, 5348
FontSize, 5349
FontUnderline, 5349
ForeColor, 5350, 5351
FormatPattern, 5352
FormatPatternReadOnlySpecial, 5353
FormatType, 5353
Free, 5354
FreePercent, 5354
FreezeProviderConnections, 5355
GetSelectionText, 5355
GlobalColorScheme, 5705
GlobalShadow, 5706
Gradation, 5355
GraphDirection, 5356
GridBackColor, 5357
GridlineColor, 5357
GridLineWidth, 5358
Height, 5359
Help text, 5362
HelpText, 5362
HiddenInput, 5363
HideTagNames, 5363
HighLimitColor, 5364
HitlistColumnAdd, 5364
HitlistColumnCount, 5365
HitlistColumnIndex, 5365
HitlistColumnName , 5366
HitlistColumnRemove , 5366
HitlistColumnRepos, 5366, 5444
HitlistColumnSort, 5367
HitlistColumnSortIndex, 5367
HitlistColumnVisible, 5368, 5445
HitlistDefaultSort, 5368
HitlistMaxSourceItems, 5369
HitlistMaxSourceItemsWarning, 5369
HitlistRelativeTimeFactor, 5370
HitlistRelativeTimeFactorType, 5370
HitlistRelTime, 5371
HorizontalAlignment, 5372, 5373
HorizontalGridLines, 5373
HourNeedleHeight, 5374
HourNeedleWidth, 5375
IconSpace, 5376
Index, 5376
InnerBackColorOff, 5377
InnerBackColorOn, 5378
InsertData(i), 5379
InsertEnable, 5379
IntegerDigits, 5380

Interval, 5380
ItemBorderStyle, 5381
JumpToLimitsAfterMouseClick, 5382
LabelColor, 5382
Language, 5383
LargeTicksBold, 5384
LargeTicksSize, 5384
LastConnectedObjectIndex, 5385
LastConnectedObjectName, 5385
LeaveMarginForBorder, 5398
LeaveMarginForMarkers, 5398
Left, 5399
Limit4LowerLimit, 5402
Limit4LowerLimitRelative, 5404
Limit4LowrLimitColor , 5403
Limit4UpperLimit, 5404
Limit4UpperLimitColor, 5405
Limit4UpperLimitEnabled, 5405
Limit4UpperLimitRelative, 5406
Limit5LowerLimit, 5407
Limit5LowerLimitColor, 5407
Limit5LowerLimitEnabled, 5408
Limit5LowerLimitRelative, 5408
Limit5UpperLimit, 5409
Limit5UpperLimitColor, 5410
Limit5UpperLimitEnabled, 5410
Limit5UpperLimitRelative, 5411
LineWidth, 5414, 5415
LoadDataImmediately, 5415
LocalCursor, 5417
Localizable, 5416
LockSquaredExtent, 5417
LogOperation, 5418
LowerLimit, 5420
LowerLimitColor(i), 5421
LowerLimitValue(i), 5421, 5422
LowLimitColor, 5423
MachineName , 5423
MarginToBorder, 5424
MaximumValue, 5425
MessageBlockAlign , 5429
MessageBlockAutoPrecisions, 5430
MessageBlockCaption, 5431
MessageBlockCount, 5431, 5435
MessageBlockDateFormat, 5431
MessageBlockExponentialFormat, 5432
MessageBlockFlashOn, 5433
MessageBlockHideText, 5433
MessageBlockHideTitleText, 5434
MessageBlockID, 5434
MessageBlockLeadingZeros, 5435
MessageBlockLength, 5436
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MessageBlockName, 5436
MessageBlockPrecisions, 5437
MessageBlockSelected, 5437
MessageBlockShowDate, 5438
MessageBlockShowIcon, 5438
MessageBlockShowTitleIcon, 5439
MessageBlockTextId, 5439
MessageBlockTimeFormat, 5440
MessageBlockType, 5440
MessageColumnAdd, 5441
MessageColumnCount, 5442
MessageColumnIndex, 5442
MessageColumnName , 5443
MessageColumnRemove, 5443
MessageColumnRepos, 5366, 5444
MessageColumnSort, 5444
MessageColumnSortIndex, 5445
MessageColumnVisible, 5368, 5445
MessageListType, 5445
MinimumValue, 5446, 5447
MinuteNeedleHeight, 5447
MinuteNeedleWidth, 5448
Mode, 5448
Movable, 5449
MsgFilterSQL, 5450
NeedleBorderColor, 5453
NeedleColor, 5454
NeedleFillStyle, 5454
NormalRangeColor, 5455
NormalRangeVisible, 5456
NumberOfValues(i), 5456
ObjectName, 5458
Online, 5461
OperationSteps, 5463
OperatorMessageID, 5463
OperatorMessageIndex, 5464
OperatorMessageName, 5465
OperatorMessageNumber, 5465
OperatorMessageSelected, 5466
OperatorMessageSource1, 5466
OperatorMessageSource10, 5471
OperatorMessageSource2, 5467
OperatorMessageSource3, 5467
OperatorMessageSource4, 5468
OperatorMessageSource5, 5468
OperatorMessageSource6, 5469
OperatorMessageSource7, 5469
OperatorMessageSource8, 5470
OperatorMessageSource9, 5470
OperatorMessageType1, 5471
OperatorMessageType10, 5476
OperatorMessageType2, 5472

OperatorMessageType3, 5472
OperatorMessageType4, 5473
OperatorMessageType5, 5473
OperatorMessageType6, 5474
OperatorMessageType7, 5474
OperatorMessageType8, 5475
OperatorMessageType9, 5475
Orientation, 5476
PageMode, 5477
PageModeMessageNumber, 5478
Parent, 5478
Password, 5480
PersistentRTAuthorization, 5481
PersistentRTCSAuthorization, 5482
PersistentRuntime, 5482
PersistentRuntimeAuthorization, 5483
PersistentToDownload, 5484
PersistentToDownloadAuthorization, 5484
Picture, 5486
PictureAlignment, 5487
PictureDeactivated, 5487
PictureName, 5488
PictureOff, 5488
PictureOn, 5489
PointerColor, 5491
PointsCount, 5491
Precision, 5492
Pressed, 5493
PrintConfiguration, 5493
PrintJobName, 5494
PrintVisibleColumnsOnly, 5494
Processvalue, 5495
ProcessValue, 5496
ProjectPath, 5497
RadiusHeight, 5499, 5500
RadiusWidth, 5500, 5501
ReadOnly, 5501
RecipeName, 5502
RecipeNumber, 5502
RecordName, 5502
RecordNumber, 5503
RelativeFillLevel, 5503
Rotation, 5505
RotationAngle, 5505
RotationCenterTop, 5507
RowNumber, 5508
RowScrollbar, 5508
RowSizingEnable, 5509
RTPersistence, 5510
RTPersistencePasswordLevel, 5511
RTPersistenceType, 5511
RulerColor, 5512
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RulerPrecision(i), 5512
RulerXPrecision(i), 5513
RulerYPrecision(i), 5514
ScaleColor, 5514
ScaleDenumerator, 5520
ScaleGradation, 5515
ScaleLabelColor, 5516
ScaleNumerator, 5516
ScalePosition, 5517
ScaleTickColor, 5517
ScaleTickLabelPosition, 5518
ScaleTickLength, 5518
ScaleTickPosition, 5519
ScalingType, 5521
ScreenItems, 5522
Screens, 5522
Scrollable, 5523
SecondNeedleHeight, 5524
SecondNeedleWidth, 5524
SegmentColoring, 5525
SelectBackColor, 5526
SelectedCellColor, 5526
SelectedCellForeColor, 5527
SelectedRowColor, 5528
SelectedRowForeColor, 5528
SelectedTitleColor, 5529
SelectedTitleForeColor , 5530
SelectForeColor, 5530
SelectionBackColor, 5531, 5532
SelectionColoring, 5532
SelectionForeColor, 5533, 5534
SelectionMode, 5534, 5535
SelectionRect, 5535
SelectionRectColor, 5536
SelectionRectWidth, 5537
SeparatorBackColor, 5538
SeparatorColor, 5538
SeparatorWidth, 5540
SeperatorCornerStyle, 5539
SeperatorStyle, 5539
ServerNames, 5541
ServerScale, 5540
SetpointTrendArchiveStartId(i), 5542
SetpointTrendColor(i), 5543
SetpointTrendNumberOfValues(i), 5543
Shared, 5546
ShareTimeColumn, 5544
ShareValueAxis, 5545
ShareXAxis, 5545
ShareYAxis, 5546
ShiftDecimalPointReadOnlySpecial, 5547
ShortenCellText, 5547

ShortenColumnHeaderText, 5548
ShowAlarmsFromDate, 5548
ShowBar, 5549
ShowBorder, 5549
ShowCaption, 5550
ShowColumn(i), 5551
ShowCurve(i), 5551
ShowDecimalPoint, 5552
ShowFillLevel, 5552
ShowFocusRectangle, 5553
ShowInputControls, 5553
ShowLimitMarkers, 5554
ShowMainFrame, 5554
ShowMessagesAtDate, 5555
ShowOverflowIndicator, 5556
ShowPeakValuePointer, 5556, 5557
ShowPosition, 5557
ShowRowHeaders, 5558
ShowRuler, 5558, 5559
ShowRulerInAxis, 5559
ShowScale, 5560
ShowScrollbars, 5560
ShowSetpointTrend(i), 5561
ShowSortButton, 5561
ShowSortIcon, 5562, 5563
ShowStatusBar, 5563
ShowTableGridlines, 5564
ShowThumb, 5565
ShowTickLabels, 5565
ShowTicks, 5566
ShowTitle, 5567
ShowToolBar, 5567
ShowTrendIcon, 5568
ShowTrendIndicator, 5569
ShowVerticalGridlines, 5569
ShowXValuesExponential(i), 5570
ShowYValuesExponential(i) , 5570
SkinName, 5571
SmartTags, 5572
Sort, 5572
SortByTimeDirection , 5573
SortByTimeEnable, 5573
SortByTimeEnabled, 5574
SortOnColumnHeaderClick, 5574
SortSequence, 5575
SortTimeAscending, 5575
SortTimeEnable, 5576
StartAngle, 5576
StartLeft, 5577
StartPointTop, 5579
StartStyle, 5578
StatusbarBackColor, 5580
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StatusbarElementAdd, 5580
StatusbarElementAutoSize, 5581
StatusbarElementCount, 5581
StatusbarElementIconId, 5582
StatusbarElementID, 5582
StatusbarElementIndex, 5583
StatusbarElementName, 5583
StatusbarElementRemove, 5584
StatusbarElementRename, 5584
StatusbarElements, 5584
StatusbarElementTooltipText, 5585
StatusbarElementUserDefined, 5585
StatusbarElementVisible, 5586
StatusbarElementWidth, 5587
StatusbarFontColor, 5587
StatusbarShowArchiveName, 5587
StatusbarShowColumn, 5588
StatusbarShowRecord, 5588
StatusbarShowRow, 5589
StatusbarShowText, 5589
StatusbarShowTooltips, 5589
StatusbarText, 5590
StatusbarUseBackColor, 5591
StatusbarVisible, 5591
Style, 5592, 5593
SwapDimensionsWithOrientation, 5594
SwapFirstWithLastConnection, 5594
TableBackColor, 5595
TableColor, 5596
TableColor2, 5596
TableFocusOnButtonCommand, 5597
TableForeColor, 5597, 5598
TableForeColor2, 5599
TableGridLineColor, 5599, 5600
TableHeaderBackColor, 5600
TableHeaderForeColor, 5601
Text, 5605
TextList, 5606
TextOff, 5606, 5607
TextOn, 5607, 5608
TextOrientation, 5608
ThumbBackColor, 5609, 5610
TicksColor, 5610
TickStyle, 5611
TimeAxisBeginTime(i), 5612
TimeAxisEndTime, 5612
TimeAxisLabel(i), 5613
TimeAxisRange, 5613
TimeAxisShowGridLines(i), 5614
TimeAxisShowLargeIncrements(i), 5615
TimeAxisShowSmallIncrements(i), 5615
TimeAxisTimeFormat(i), 5616

TimeBase, 5617
TimeColumnActualize, 5618, 5624
TimeColumnAdd, 5618
TimeColumnAlign, 5618
TimeColumnAlignment(i), 5619
TimeColumnBackColor, 5620
TimeColumnBeginTime, 5620
TimeColumnCaption, 5621
TimeColumnCount, 5621
TimeColumnDateFormat, 5621
TimeColumnEndTime, 5622
TimeColumnForeColor , 5622
TimeColumnFormat(i), 5623
TimeColumnHideTitleText, 5624
TimeColumnIndex, 5625
TimeColumnLength, 5625
TimeColumnMeasurePoints, 5625
TimeColumnName, 5626
TimeColumnRangeType, 5626
TimeColumnRemove, 5627
TimeColumnRename , 5627
TimeColumnRepos, 5628
TimeColumnShowDate, 5628
TimeColumnShowIcon, 5629
TimeColumnShowTitleIcon, 5629
TimeColumnSort , 5630
TimeColumnSortIndex, 5630
TimeColumnTimeFormat, 5631
TimeColumnTimeRangeBase, 5631
TimeColumnTimeRangeFactor, 5632
TimeColumnUseValueColumnColors, 5632
TimeColumnVisible, 5633
TimeJumpColor(i), 5633
TimeJumpEnabled(i), 5634
TimeOverlapColor(i), 5634
TimeOverlapEnabled(i), 5635
TimeRangeBase(i), 5635
TimeRangeFactor(i), 5636
TitleColor, 5638
TitleDarkShadowColor, 5639
TitleForeColor, 5639
TitleGridLineColor, 5640
TitleLightShadowColor, 5640
TitleSort, 5640
TitleStyle, 5641
Toggle, 5642
Tolerance, 5642
ToleranceColor, 5643
ToleranceLowerLimit, 5644
ToleranceLowerLimitColor, 5644
ToleranceLowerLimitEnabled, 5645
ToleranceLowerLimitRelative, 5645
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ToleranceUpperLimit, 5646
ToleranceUpperLimitColor, 5646
ToleranceUpperLimitEnabled, 5647
ToleranceUpperLimitRelative, 5648
ToolbarAlignment, 5648
ToolbarBackColor, 5649
ToolbarButtonActive, 5649
ToolbarButtonAdd, 5650
ToolbarButtonBeginGroup, 5650
ToolbarButtonCount, 5651
ToolbarButtonEnabled, 5651
ToolbarButtonHotKey, 5652
ToolbarButtonID, 5652
ToolbarButtonIndex, 5652
ToolbarButtonLocked, 5653
ToolbarButtonName, 5653
ToolbarButtonPasswordLevel, 5654
ToolbarButtonRemove, 5654
ToolbarButtonRename, 5654
ToolbarButtonRepos, 5655
ToolbarButtonTooltipText, 5655, 5672, 5679
ToolbarButtonUserDefined, 5656, 5675
ToolbarShowTooltips, 5656
ToolbarUseBackColor, 5657
ToolbarUseHotKeys, 5658
ToolbarVisible, 5658, 5659
ToolTipText, 5659
Top, 5661
Total, 5664
TransparentColor, 5666
TransparentColorDeactivatedPicture, 5667
TransparentColorPictureOff, 5667
TransparentColorPictureOn, 5668
TrendActualize, 5668
TrendBeginTime, 5669
TrendCount, 5670
TrendEndTime, 5670
TrendExtendedColorSet, 5670
TrendFill, 5671
TrendIndicatorColor, 5672
TrendLineStyle, 5673
TrendLineType, 5674
TrendLowerLimit, 5675
TrendLowerLimitColor, 5675
TrendName, 5676
TrendPointStyle, 5677
TrendProvider, 5678
TrendRangeType, 5678
TrendSelectTagNameX, 5680
TrendSelectTagNameY, 5680
TrendTag, 5681
TrendTagNameX, 5681

TrendTagNameY, 5682
TrendTimeRangeBase, 5682
TrendTimeRangeFactor, 5683
TrendUncertainColor, 5683
TrendUncertainColoring, 5684
TrendUpperLimit, 5684
TrendUpperLimitColoring, 5685
TrendWindowCoarseGrid, 5686
TrendWindowFineGrid, 5687
TrendWindowForegroundTrendGrid, 5688
TrendWindowGridInTrendColor, 5688
TrendWindowHorizontalGrid, 5689
TrendWindowIndex, 5690
TrendWindowRename, 5690
TrendWindowRulerStyle, 5692
TrendWindowVerticalGrid, 5693
Type, 5695
UncertainStateColor(i), 5697
UncertainStateEnabled(i), 5697
UnitColor, 5698
UnitText, 5699
UnitTop, 5700
UpdateEnable, 5701
UpperLimit, 5701
UpperLimitColor(i), 5702
UpperLimitEnabled(i), 5702
UpperLimitValue(i), 5703
UseAllServers, 5704
UseBarBorderConstraints, 5704
Used, 5717
UsedPercent, 5718
UseEffectiveProcessValue, 5707
UseExponentialFormat, 5708
UseFlashTransparentColor, 5708
UseGDI, 5709
UseMeasurePoints(i), 5709
UseMessageColor, 5710
UseMultipleLimits, 5710
UserArchiveNumberOfValues(i) , 5718
UserArchiveStartId(i), 5719
UseScaleConstraints, 5711
UseScaledBarBorder, 5711
UseSelectedTitleColor, 5712
UseSeparateDiagrams, 5712
UseSimplePresicionOffset, 5713
UseTableColor2, 5713
UseTimeRange(i), 5714
UseTransparentColor, 5715
UseTransparentColorDeactivatedPicture, 5715
UseTransparentColorPictureOff, 5716
UseTransparentColorPictureOn, 5716
UseTrendNameAsLabel, 5717
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UsingDesignColorScheme, 5705
UsingDesignShadowSettings, 5706
ValidateFormatPattern, 5721
ValueAxisAutorange(i), 5723
ValueAxisBegin(i), 5723
ValueAxisDecimalPrecision(i), 5724
ValueAxisEnd(i), 5724
ValueAxisGridLineInterval(i), 5725
ValueAxisLabel(i), 5725
ValueAxisLargeIncrementsSize(i), 5726
ValueAxisScalingType(i), 5726
ValueAxisShowGridLines(i), 5727
ValueAxisShowLargeIncrements(i), 5728
ValueAxisShowSmallIncrements(i), 5728
ValueAxisSmallIncrementSize(i), 5729
ValueColumnAlignment(i), 5730
ValueColumnPrecision(i), 5730
VerticalAlignment, 5731
VerticalGridLines, 5732
ViewOnly, 5733
Visible, 5733
Warning, 5736
WarningColor, 5736
WarningLowerLimit, 5737
WarningLowerLimitColor, 5738
WarningLowerLimitEnabled, 5738
WarningLowerLimitRelative, 5739
WarningRangeColor, 5740
WarningRangeStart, 5740
WarningRangeVisible, 5741
WarningUpperLimit, 5742
WarningUpperLimitColor, 5742
WarningUpperLimitEnabled, 5743
WarningUpperLimitRelative, 5743
Width, 5744
WindowCloseEnabled, 5746
WindowSizingEnabled, 5748
WindowsStyle, 5748
XAxisAdd, 5749
XAxisAlign, 5749
XAxisAutoPrecisions, 5750
XAxisAutorange(i), 5750
XAxisBegin(i), 5751
XAxisBeginValue, 5751
XAxisCount, 5752
XAxisDecimalPrecision(i), 5753
XAxisEnd(i), 5753
XAxisEndValue, 5754
XAxisExponentialFormat, 5754
XAxisGridLineInterval(i), 5754
XAxisIndex, 5755
XAxisInTrendColor, 5755

XAxisLabel(i), 5756
XAxisLargeIncrementSize(i), 5756
XAxisMode(i), 5757
XAxisName, 5757
XAxisPrecisions , 5758
XAxisRemove, 5758
XAxisRepos, 5758
XAxisScalingType(i), 5759
XAxisShowGridLines(i), 5759
XAxisShowLargeIncrements(i), 5760
XAxisShowSmallIncrements(i), 5760
XAxisSmallIncrementSize(i), 5761
XAxisTrendWindow, 5761
XAxisVisible, 5762
XDataLogTag(i), 5762
XOnlineTag(i), 5763
YAxisAdd, 5763
YAxisAlign, 5764
YAxisAutoPrecisions, 5764
YAxisBeginValue, 5765
YAxisColor, 5766
YAxisCount, 5766
YAxisEndValue, 5766
YAxisExponentialFormat, 5767
YAxisIndex, 5767
YAxisInTrendColor, 5768
YAxisLabel, 5768
YAxisName, 5768
YAxisPrecisions , 5769
YAxisRemove, 5769
YAxisRename, 5769
YAxisRepos, 5770
YAxisTrendWindow, 5771
YAxisVisible, 5771
YDataLogTag(i), 5771
YOnlineTag(i), 5772
ZeroPoint, 5773
Zoomable, 5774

Properties in VBS
Comment, 5281
ComputerName, 5282
Context, 5284
InputValue, 5378
Instance, 5380
SelIndex, 5528
SelText, 5526
State, 5579
Transparency, 5665
UserName, 5720
WinCCStyle, 5593, 5746

Properties in VBS/HorizontalScrollPosition, 5374
Properties in VBS/ScrollPositionX, 5523
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Properties in VBS/ScrollPositionY, 5524
Properties in VBS/VerticalScrollPosition, 5733
Properties in VBS:AngleAlpha, 5205
Properties in VBS:AngleBeta, 5205
Properties in VBS:Application, 5207, 5748
Properties in VBS:Axe, 5215
Properties in VBS:AxisSection, 5215
Properties in VBS:BackBorderWidth, 5215
Properties in VBS:BackColor2, 5218
Properties in VBS:BackColor3, 5218
Properties in VBS:BackFlashColorOff, 5222
Properties in VBS:BackFlashColorOn, 5222
Properties in VBS:Background, 5225
Properties in VBS:BarDepth, 5228
Properties in VBS:BarHeight, 5228
Properties in VBS:BarWidth, 5229
Properties in VBS:BaseX, 5230
Properties in VBS:BaseY, 5230
Properties in VBS:BorderColorBottom, 5238
Properties in VBS:BorderColorTop, 5238
Properties in VBS:BorderFlashColorOff, 5239
Properties in VBS:BorderFlashColorOn, 5239
Properties in 
VBS:BottomConnectedConnectionPointIndex, 5252
Properties in VBS:BottomConnectedObjectName, 
5253
Properties in VBS:BoxAlignment, 5253
Properties in VBS:BoxCount, 5253
Properties in VBS:BoxType, 5253
Properties in VBS:Button1Width, 5253
Properties in VBS:Button2Width, 5253
Properties in VBS:Button3Width, 5254
Properties in VBS:Button4Width, 5254
Properties in VBS:ButtonColor, 5254
Properties in VBS:CheckAlarmHigh, 5266
Properties in VBS:CheckAlarmLow, 5266
Properties in VBS:CheckLimitHigh4, 5266
Properties in VBS:CheckLimitHigh5, 5266
Properties in VBS:CheckLimitLow4, 5266
Properties in VBS:CheckLimitLow5, 5267
Properties in VBS:CheckToleranceHigh, 5268
Properties in VBS:CheckToleranceLow, 5268
Properties in VBS:CheckWarningHigh, 5268
Properties in VBS:CheckWarningLow, 5268
Properties in VBS:ClearOnNew, 5269
Properties in VBS:CloseButton, 5270
Properties in VBS:ColorAlarmHigh, 5272
Properties in VBS:ColorAlarmLow, 5272
Properties in VBS:ColorBottom, 5272
Properties in VBS:ColorChangeType, 5273
Properties in VBS:ColorLimitHigh4, 5274
Properties in VBS:ColorLimitHigh5, 5274

Properties in VBS:ColorLimitLow4, 5274
Properties in VBS:ColorLimitLow5, 5274
Properties in VBS:ColorToleranceHigh, 5274
Properties in VBS:ColorToleranceLow, 5275
Properties in VBS:ColorTop, 5275
Properties in VBS:ColorWarningHigh, 5275
Properties in VBS:ColorWarningLow, 5275
Properties in VBS:CurrentContext, 5289
Properties in VBS:DataFormat, 5295
Properties in VBS:EditAtOnce, 5309
Properties in VBS:Exponent, 5319
Properties in VBS:ExtendedOperation, 5326
Properties in VBS:ExtendedZoomingEnable, 5326
Properties in VBS:FillColor, 5328
Properties in VBS:Filling, 5329
Properties in VBS:FillingIndex, 5329
Properties in VBS:FillStyle2, 5332
Properties in VBS:FlashBackColor, 5334
Properties in VBS:FlashBorderColor, 5334
Properties in VBS:FlashFlashPicture, 5334
Properties in VBS:FlashForeColor, 5334
Properties in VBS:FlashPicReferenced, 5339
Properties in VBS:FlashPicture, 5339
Properties in VBS:FlashRate, 5339
Properties in VBS:FlashRateBackColor, 5340
Properties in VBS:FlashRateBorderColor, 5340
Properties in VBS:FlashRateFlashPic, 5340
Properties in VBS:FlashRateForeColor, 5340
Properties in VBS:ForeFlashColorOff, 5352
Properties in VBS:ForeFlashColorOn, 5352
Properties in VBS:Hotkey, 5374
Properties in VBS:Hysteresis, 5375
Properties in VBS:HysteresisRange, 5376
Properties in VBS:ItemBorderBackColor, 5381
Properties in VBS:ItemBorderColor, 5381
Properties in VBS:ItemBorderWidth, 5382
Properties in VBS:LanguageSwitch, 5384
Properties in VBS:Layer, 5387
Properties in VBS:Layer00Checked, 5390
Properties in VBS:Layer00Color, 5390
Properties in VBS:Layer00Value, 5391
Properties in VBS:Layer01Checked, 5391
Properties in VBS:Layer01Color, 5391
Properties in VBS:Layer01Value, 5391
Properties in VBS:Layer02Checked, 5391
Properties in VBS:Layer02Color, 5392
Properties in VBS:Layer02Value, 5392
Properties in VBS:Layer03Checked, 5392
Properties in VBS:Layer03Color, 5392
Properties in VBS:Layer03Value, 5392
Properties in VBS:Layer04Checked, 5393
Properties in VBS:Layer04Color, 5393
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Properties in VBS:Layer04Value, 5393
Properties in VBS:Layer05Checked, 5393
Properties in VBS:Layer05Color, 5393
Properties in VBS:Layer05Value, 5394
Properties in VBS:Layer06Checked, 5394
Properties in VBS:Layer06Color, 5394
Properties in VBS:Layer06Value, 5394
Properties in VBS:Layer07Checked, 5394
Properties in VBS:Layer07Color, 5395
Properties in VBS:Layer07Value, 5395
Properties in VBS:Layer08Checked, 5395
Properties in VBS:Layer08Color, 5395
Properties in VBS:Layer08Value, 5395
Properties in VBS:Layer09Checked, 5396
Properties in VBS:Layer09Color, 5396
Properties in VBS:Layer09Value, 5396
Properties in VBS:Layer10Checked, 5396
Properties in VBS:Layer10Color, 5396
Properties in VBS:Layer10Value, 5397
Properties in VBS:LayerDeclutteringEnable, 5397
Properties in VBS:Layers, 5397
Properties in VBS:LeftComma, 5401
Properties in VBS:LeftOffset, 5401
Properties in VBS:LightEffect, 5402
Properties in VBS:LimitHigh4, 5411
Properties in VBS:LimitHigh5, 5411
Properties in VBS:LimitLow4, 5412
Properties in VBS:LimitLow5, 5412
Properties in VBS:LimitMax, 5412
Properties in VBS:LimitMin, 5412
Properties in VBS:ListType, 5415
Properties in VBS:LockStatus, 5418
Properties in VBS:LockText, 5418
Properties in VBS:LockTextColor, 5418
Properties in VBS:Logging, 5418
Properties in VBS:LongStrokesBold, 5419
Properties in VBS:LongStrokesOnly, 5419
Properties in VBS:LongStrokesSize, 5419, 5554
Properties in VBS:LongStrokesTextEach, 5420
Properties in VBS:Marker, 5424
Properties in VBS:Max, 5424
Properties in VBS:MaximizeButton, 5425, 5747
Properties in VBS:MCGUBackColorOff, 5426
Properties in VBS:MCGUBackColorOn, 5426
Properties in VBS:MCGUBackFlash, 5426
Properties in VBS:MCGUTextColorOff, 5426
Properties in VBS:MCGUTextColorOn, 5426
Properties in VBS:MCGUTextFlash, 5427
Properties in VBS:MCKOBackColorOff, 5427
Properties in VBS:MCKOBackColorOn, 5427
Properties in VBS:MCKOBackFlash, 5427
Properties in VBS:MCKOTextColorOff, 5427

Properties in VBS:MCKOTextColorOn, 5427
Properties in VBS:MCKOTextFlash, 5428
Properties in VBS:MCKQBackColorOff, 5428
Properties in VBS:MCKQBackColorOn, 5428
Properties in VBS:MCKQBackFlash, 5428
Properties in VBS:MCKQTextColorOff, 5428
Properties in VBS:MCKQTextColorOn, 5428
Properties in VBS:MCKQTextFlash, 5429
Properties in VBS:MCText, 5429
Properties in VBS:MessageClass, 5441
Properties in VBS:Min, 5446
Properties in VBS:Movable, 5747
Properties in VBS:Name, 5450
Properties in VBS:NumberLines, 5456
Properties in VBS:ObjectSizeDeclutteringEnable, 
5459
Properties in VBS:ObjectSizeDeclutteringMax, 5460
Properties in VBS:ObjectSizeDeclutteringMin, 5460
Properties in VBS:OnTop, 5462
Properties in VBS:OperationMessage, 5462
Properties in VBS:OperationReport, 5463
Properties in VBS:OutputFormat, 5477
Properties in VBS:OutputValue, 5477
Properties in VBS:Path, 5480
Properties in VBS:PicDeactReferenced, 5485
Properties in VBS:PicDeactTransparent, 5485
Properties in VBS:PicDeactUseTransColor, 5485
Properties in VBS:PicDownReferenced, 5485
Properties in VBS:PicDownTransparent, 5486
Properties in VBS:PicDownUseTransColor, 5486
Properties in VBS:PicReferenced, 5486
Properties in VBS:PicTransColor, 5486
Properties in VBS:PictureUp, 5489
Properties in VBS:PicUpReferenced, 5490
Properties in VBS:PicUpTransparent, 5490
Properties in VBS:PicUpUseTransColor, 5490
Properties in VBS:PicUseTransColor, 5490
Properties in VBS:PointCount, 5490
Properties in VBS:Position, 5492
Properties in VBS:PredefinedAngles, 5492
Properties in VBS:Process, 5495
Properties in VBS:QualityCode, 5498
Properties in VBS:ReferenceRotationLeft, 5503
Properties in VBS:ReferenceRotationTop, 5503
Properties in VBS:Relevant, 5504
Properties in VBS:RightComma, 5505
Properties in VBS:RoundCornerHeight, 5507
Properties in VBS:RoundCornerWidth, 5508
Properties in VBS:SameSize, 5514
Properties in VBS:ScaleTicks, 5520
Properties in VBS:Scaling, 5520
Properties in VBS:ScreenName, 5522
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Properties in VBS:ScrollBars, 5523
Properties in VBS:SelBGColor, 5525
Properties in VBS:SelTextColor, 5538
Properties in VBS:ServerPrefix, 5541
Properties in VBS:SignificantMask, 5571
Properties in VBS:Sizeable, 5571
Properties in VBS:SmallChange, 5572
Properties in VBS:StartValue, 5579
Properties in VBS:TagName, 5602
Properties in VBS:TagPrefix, 5602
Properties in VBS:Tags, 5603
Properties in VBS:Template, 5604
Properties in VBS:TimeStamp, 5637
Properties in VBS:TitleCut, 5639
Properties in VBS:Titleline, 5640
Properties in VBS:ToleranceHigh, 5643
Properties in VBS:ToleranceLow, 5643
Properties in 
VBS:TopConnectedConnectionPointIndex, 5663
Properties in VBS:TopConnectedObjectName, 5664
Properties in VBS:TopOffset, 5664
Properties in VBS:Trend, 5668
Properties in VBS:TrendColor, 5669, 5670
Properties in VBS:TypeAlarmHigh, 5695
Properties in VBS:TypeAlarmLow, 5695
Properties in VBS:TypeLimitHigh4, 5695
Properties in VBS:TypeLimitHigh5, 5695
Properties in VBS:TypeLimitLow4, 5696
Properties in VBS:TypeLimitLow5, 5696
Properties in VBS:TypeToleranceHigh, 5696
Properties in VBS:TypeToleranceLow, 5696
Properties in VBS:TypeWarningHigh, 5696
Properties in VBS:TypeWarningLow, 5696
Properties in VBS:UnselBGColor, 5700
Properties in VBS:UnselTextColor, 5700
Properties in VBS:UpdateCycle, 5701
Properties in VBS:UserValue1, 5720
Properties in VBS:UserValue2, 5720
Properties in VBS:UserValue3, 5721
Properties in VBS:UserValue4, 5721
Properties in VBS:Value, 5721
Properties in VBS:WarningHigh, 5737
Properties in VBS:WarningLow, 5737
Properties in VBS:WindowBorder, 5238, 5746
Properties in VBS:WindowOnTop, 5747
Properties in VBS:ZeroPointValue, 5773
Properties in VBS:Zoom, 5773
Properties of the VPN group, 703
Property animation

Expression, 3436
Quality Code, 3436, 3447
Section type, 3436

Type, 3436
Type binary, 3436
Type bit, 3436
Type Bool, 3436
Type direct, 3436

Property changed, 4775
Property diagram changed, 4775
Property list

Dynamize, 3424
ProSave, 6787, 7025

Installation, 81
Protect

Function key with password, 3463
ProtectedAreaName object, 5102
Protection concept, 1111, 1114

Introduction, 404
Revoking access rights, 405

Protection level, 1110, 1111
Revoking access rights, 405

Protocol, 667
Proxy ARP, 758
PRVREC, 2724
PT, 2174
PTC resistor, 1177
PTO, 50
Pull/plug interrupt (ET 200M), 1188
Pull/plug interrupt OB, 1127
Pulse, 1878, 1887, 1898, 1912, 2155, 2175, 2189, 
2419, 2433

Extended, 1901, 1913, 2178, 2190, 2436
Pulse extension, 1173
Pulse generator

Enabling/disabling with CTRL_PWM, 2880
Pulse interface

Principle, 7805
Pulse stretching, 1191
PUT, 3197
PUT / GET, 1114
putc function, 6046
PWM, 50

Q
Q

PLC, 6683
Q address, 781
Q series, 6686
Q0xUDEH CPU

PLC, 6685
QB, 1425
QD, 1425
QRY_CINT, 2812
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QRY_DINT, 2824
QRY_TINT, 2820
qsort function, 6047
Quality Code

Dynamize, 3436, 3447
Quality codes, 7569, 7582
Quantum, 6720
Query, 7644, 7650, 7654

Message archive, 7650
Process value archive, 7644
User archive, 7654

QuitHorn, 5854
QuitSelected, 5854
QuitVisible, 5855
QW, 1425
QX, 1425

R
R, 557, 1863, 2139
R_TRIG, 1876, 2153, 2416
Rack error OB, 1128
Rack or station failure, 1128
Racks, 524

Inserting a module, 534
Radius, 3565, 3595, 3596

Circle segment, 3567
Circular arc, 3566

RADIUS, 982
RadiusHeight property (VBS), 5499, 5500, 5501
RadiusWidth property (VBS), 5500, 5501
RALRM, 2682
rand function, 6046
Range

Value outside range, 1950, 2229
Value within range, 1949, 2228

Range (... - ...)
Graphics list, 3411, 3413
Text list, 3401

RangeLabelView object, 5103
RangeQualityView object, 5105
Raw data tag, 3778, 4263

Acknowledgement Data, 4263
Acknowledgement header structure, 4262
Acknowledgment message frame, 4262
Communication between the recipe and the PLC, 
4232
Structure of job header, 4261
Structure of the message frame header, 4260

Raw Data Tag
for BSEND/BRCV functions, 4265

Raw data tags, 4259

Raw data type, 3778
RCV_CFG, 3112
RCV_PTP, 3121
RCV_RST, 3122
RCVREC, 2721
RD_ADDR , 2927
RD_DPAR, 2800
RD_DPARA, 2802
RD_DPARM, 2804
RD_LGADR, 2932
RD_LOC_T, 2629
RD_REC, 2712
RD_SINFO, 2845
RD_SYS_T, 2628
RDREC, 2674
RE_TRIGR, 2076, 2359, 2574
Read continuously

Tag, 3715
Read field, 2007, 2287
Read memory address, 2509
Read memory bit, 2511
Read system time with TIME_TCK, 2635
READ_BIG, 2522
READ_DBL, 51, 2914
READ_ERR, 2833
READ_LITTLE, 2518
ReadFromArrayDB, 2024, 2306, 2500
ReadFromArrayDBL, 2028, 2310, 2503
Reading

A data record with RD_REC, 2712
Asynchronously- data record of a module with 
RD_DPARA, 2802
Data record of a module with RD_DPAR, 2800
from a data block in load memory with 
READ_DBL, 2914
Local time with RD_LOC_T, 2629

Reading data
From DP standard slaves/PROFINET IO devices 
with DPRD_DAT, 2717
From remote CPU with GET, 3194

Reading out
IP address, 6589
LED status with LED, 2856
Recipe data record, 7143

Reading out a diagnostics buffer, 1223
Reading tags, 797
Read-only, 1110
ReadOnly property (VBS), 5501
ReadPLCMode, 4615, 4720
ReadTags, 5855
REAL, 1336, 1382, 1406
REAL_TO_, 1406
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realloc function, 6047
Receiving data

on I-device with RCVREC, 2721
Recipe, 791, 4160, 4162, 4163, 4228, 4229, 6835, 
7117

Application example: Machine parameter 
assignment, 4162
Application example:Batch production, 4162
Basics, 4160, 4162, 4229
Communication by means of control tags, 4232
Configuration option, 4169
Control, 7119
Creating new, 4189, 4237
Data flow, 7120
Data Flow, 4166
Data record, 4163, 4230, 7118
Differences in TP 177A and OP 77A, 4171
Display in I/O fields, 4248
Display in Runtime, 4232
Edit, 6834
Element, 4230
Entry, 4163
Example, 4230
Export format, 4587, 4820
Exporting, 4218, 6829, 6832
Exporting to CSV file, 2882
GMP settings, 7258
Importing, 4218, 6830, 6833
Importing into data block, 2884
Load, 4237
Memory requirements, 7223, 7224
Principles, 4228
Raw data communication, 4232
Raw data tag communication type, 4256
Recipe screen, 4175, 7120
Recipe view, 4175, 7120
Synchronizing recipe tag, 4215
Synchronizing tags, 7132, 7133
Table view in Runtime, 4247
Tags communication type, 4255
Use, 4162, 4228
Use of text lists, 4175

Recipe data
in reports, 4309
Migration, 194, 252

Recipe data record
change, 4215
Copy, 4214
Create on the HMI device, 4209, 4210, 4214
Creating, 7140
Creating new, 4189, 4237
Creating on the HMI device, 4209

Creating, key operation, 7126
Creating, keyboard operation, 7127
Creating, mouse operation, 7127
Creating, touch operation, 7126
Delete, key operation, 7131
Delete, keyboard operation, 7131
Delete, mouse operation, 7131
Deleting, 4215, 7142
Deleting, touch operation, 7131
Editing, 7141
Editing, key operation, 7129
Editing, keyboard operation, 7130
Editing, mouse operation, 7130
Editing, touch operation, 7129
Export format, 4587, 4820
Exporting, 4218, 7145
Importing, 4218, 7145
Importing and exporting, 4168
load, 4215
Reading from PLC, 7134, 7135, 7143
Reading, key operation, 7134
Reading, keyboard operation, 7135
Reading, mouse operation, 7135
Reading, touch operation, 7134
Synchronize with PLC, 7141
Synchronizing, 4215
Synchronizing, key operation, 7132
Synchronizing, keyboard operation, 7133
Synchronizing, mouse operation, 7133
Synchronizing, touch operation, 7132
Transfer option, 4166
Transfer, key operation, 7136
Transfer, keyboard operation, 7137
Transfer, mouse operation, 7137
Transfer, touch operation, 7136
Transferring the project, 91
Transferring to PLC, 7136, 7137, 7144
Use of text lists, 4175

Recipe data record change
Effects in Runtime, 7258

Recipe data record name
Writing to a tag, 4178, 4182

Recipe data record number
Writing to a tag, 4178, 4182

Recipe element
Creating new, 4189, 4237

Recipe list, 4176, 7121
Recipe name

Writing to a tag, 4178, 4182
Recipe number

Writing to a tag, 4178, 4182
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Recipe query
Creating new, 4245
Restrictions in Runtime, 4244

Recipe query editor, 4244
Recipe report

application in reports, 4369
Recipe screen, 4186, 7122

Automatic transfer, 4186
Configuring, 4201
Overview, 7122
Recipe tag, 4165
Synchronizing recipe value, 4186
Visual machine simulation, 4185

Recipe tag
Offline, 7124
Online, 7124
Synchronizing, 4169, 4215, 7123
Teach-in mode, 4170

Recipe value, 4186
Automatic transfer in the recipe screen, 4186
Synchronizing in the recipe screen, 4186

Recipe view, 3598, 3600, 4176, 4180, 4211, 4232, 
4247, 7120, 7125

 Configuring the export of Runtime data, 3845, 
3858, 3866
 Online configuration, 3846, 3859, 3867
 Toolbar, 3844, 3857, 3863
Advanced recipe view, 3598
Application, 4211
Behavior with screen change, 4183
Buttons, 4270, 7147
Configurable events, 4178, 4183
Configuring, 4196, 4199, 4251
Control element, 3599, 3601
Display number, 3600
Displaying one recipe only, 4182
Displaying values only, 4178
Dynamic properties, 4179
Edit data, 4279, 7156
Expanded, 4180, 7121
Layout, 3601
Operating element, 4212, 7125
Operation, 4212, 7125
Operation using the function key, 4184
Operation with the keyboard, 4213, 7126
Operation with the mouse, 4213, 7126
Recipe data record, 4164, 4165, 4184
Simple, 4176, 7121
Simple recipe view, 3598
Status bar, 4270, 7147
Toolbar, 4270, 7147
Updating, 4177, 4181

Use, 7125
UserArchiveControl, 4273, 7150
Using as a drop-down list, 4182

RecipeExport, 2882
RecipeImport, 2884
RecipeName property (VBS), 5502
RecipeNumber property (VBS), 5502
Recipes

 Export CSV file from ES, 4204, 4243
Acknowledgement data for the raw data tag, 
4263
Acknowledgment message frame structure for raw 
data tag , 4262
Communication via raw data tags, 4260, 4262
Import CSV file into ES, 4202, 4242
Job types and error codes for raw data 
communication, 4267
Message frame structure for raw data tags , 4260
Structure of acknowledgement header for raw 
data tag, 4262
Structure of job header for raw data tag, 4261
Structure of message frame header for raw data 
tag, 4260

RecipeViewBack, 4636
RecipeViewClearDataRecord, 4632
RecipeViewGetDataRecordFromPLC, 4631
RecipeViewMenu, 4632
RecipeViewNewDataRecord, 4631
RecipeViewOpen, 4633
RecipeViewRenameDataRecord, 4635
RecipeViewSaveAsDataRecord, 4634
RecipeViewSaveDataRecord, 4634
RecipeViewSetDataRecordToPLC, 4633
RecipeViewShowOperatorNotes, 4636
RecipeViewSynchronizeDataRecordWithTags, 4635
Recommissioning

HMI device, 7045
Reconnecting

Tag, 3697
Reconnecting a PLC tag, 3697
Recording a log file for the modem, 8145
RecordName property (VBS), 5502
RecordNumber property (VBS), 5503
Recordset, 7643, 7652
Rectangle

Configuring, 3394
Inserting, 3393
Inserting and configuring, 3392
Radius corners X, 3597
Radius corners Y, 3597

Rectangle object, 5112
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Redoing actions
Basics of redoing actions, 428
Redoing actions, 432

Redundancy, 7365, 7370
Application Health Check, 7365, 7390
Log synchronization, 7368
Principle of operation, 7366
Serial connection between servers, 7385
System alarms, 7386

Redundancy 
Recipe data, 7374

Reference channel, 1174
Reference channel error, 1182
Reference channel of the module, 1184
Reference junction, 1007, 1151, 1166, 1174, 1184
Reference language, 366, 6882

Selecting, 6886
Reference object

Defining, 3349, 4338
Reference project

Basics, 377
Closing, 377
Comparing, 378
Opening, 377

Reference temperature, 1174, 1184
References, 275
Referencing

Object, 4451
RelativeFillLevel property (VBS), 5503
release, 4785
Release

User data type, 3733
Release button, 96

Configuring, 98
Release key, 4793
Release key on keyboard, 4794
Release left mouse button, 4785
Release right mouse button, 4789
ReleaseButton, 4640
Reloading

Alarms, 4033
Remainder of division, 1969, 2248
Remote access user, 656
Remote configuration, 7489

Activating a project, 7492
Deactivating a project, 7493

Remote connection
as CPU-controlled remote connection, 8137
as dial-up connection, 8100
As VPN connection, 8124

Remote connection cannot be established, 8123

Remote connection from the TS Adapter is not 
established, 8147
Remote connection to the TS Adapter is not 
established, 8146
Remote control

By means of Internet Explorer, 7427
By means of SmartClient application, 7428
Configure SmartClient, 7419
Configure SmartServer, 7415
Devices with  keys, 7424
Direct keys, 7432
Monitoring mode, 7414
Session Management, 7414
Smart Options, 7426
SmartClient display, 7431

Remote desktop, 38
Remote monitoring

Smart Options, 7426
Remote system access to a programming device/
personal computer, 8138
Remove

Formatting in the alarm text, 3928
Object from the group, 3383

remove function, 6046
Removing, 120

Add-on, 120
Folder link, 3376

Rename
Customized VB function, 4456
Screen, 3309
Tag, 3692
Template, 3317
user-defined C function, 4466

rename function, 6046
Renewing the CA group certificate, 708
REPEAT, 2564
Replace

Cross-references, 6879
HMI device, 6923

REPLACE, 2664
Replace delimiter, 3696
Replace modules during operation, 1188
Replacing

Module, 539
Replacing devices, 539

Function key, 6914
K-key, 6915
Limitations on connections, 6910
Principle, 6910

Replay, 4798
Report

Adding a detail page, 4318

Index

WinCC Professional V13.0
System Manual, 02/2014 8277



Back page, 4295, 4298
Create a print job, 4322
Creating, 4306
creating (overview), 4300, 4302
Creating a task for the automatic start of a print 
job, 4325
Deleting page, 4318
Detail page, 4296, 4298
Device dependency, 6193
Event-driven output, 4319
Footer, 4296, 4298
Header, 4296, 4298
Maximum configurable number of pages, 4301, 
4305
Objects with dynamic length, 4304
Position of objects, 4303
print, 4320
printing, 4343
Printing, 4344
Showing and hiding sections, 4319
Size and position of objects, 4301
Size of objects, 4303
Sorting pages, 4318
Steps for configuring report output in Runtime 
(Advanced), 4320
Steps for configuring report output in Runtime 
Professional, 4321
Time-driven output, 4319
Title page, 4295, 4298
Title page and back page, 4305
Watermarks, 4298

Report name
Use in reports, 4367

Report objects
in reports, 4310

Reporting
Audit Trail, 7240
enabling, 3996

Reporting Services
Requirements, 7657

ReportJob, 5950
Reports, 7273, 7358, 7360, 7362

 CSV provider trends , 4349
 ODBC database field, 4363
 ODBC database table, 4364
 Recipe report , 4369
Alarm report , 4361
Alarm sequence report, 4312
As e-mail, 7358
Data output in tabular format, 4309
Data output in trends, 4309
Date/time field, 4351, 4352

Elements, 4308
Excel workbook, 7360
Graphic I/O field, 4358
Hardcopy, 4359
I/O field, 4353
Output of a Runtime snapshot, 4310
Output of alarms, 4310
Output of external data via ODBC interface, 4310
Output of recipe data, 4309
Page number, 4370, 4371
PDF file, 7273
PDF Report, 7358
Print job, 7362
Project name, 4366
Report name, 4367
Report objects, 4310
Settings, 7358
Symbolic I/O field, 4372
XLS file, 7273

Reports with archive data
Available on the network, 7657

Requirement
Hardware, 7499
Installation, 7499
Operating system, 7499
Software, 7499

Requirements for establishing a remote connection, 
8122
Requirements for sending an SMS, 8141
Requirements for sending emails, 8142
Reset, 879

Bit field, 1865, 2142
IEC timer, 1895, 2430
Operand, 1863, 1867, 2139, 2145
To factory settings, 1233, 1234
to factory settings , 7029

Reset timer, 2172
RESET_BF, 1865, 2142
ResetBit, 4637, 4722, 4851, 4893, 5951
ResetBitInTag, 4638, 4723, 4852, 4894, 5952
ResetTagToHandWheel , 4681
Resetting

Acknowledgment bit, 4119
HMI device to factory settings, 7031
to factory settings, 7029

Resetting the connection, 3272
Resetting the MPI/PROFIBUS settings, 8049
Resetting the TCP/IP settings, 8041
Resetting the user interface layout, 333
Resizing

Faceplate, 3497
Resources, 1754
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Code work memory, 1754
Data work memory, 1754
Introduction, 1754
Load memory, 1754
Retentive memory, 1754
Retentive memory data, 1754
Work memory, 1754

Resources tab
Structure, 1756

Response to resizing
Faceplate type, 3497

Restart, 879
Restore

Data of the HMI device, 7026, 7028, 7058
Restore window layout, 331
Restoring, 7098
Restoring a backup, 8031
Restoring a device, 8031
Restoring data

HMI device, 7026, 7028, 7058
Restriction

Modicon Modbus RTU, 6738
Modicon Modbus TCP/IP, 6738

Restrictions due to user rights, 344, 345
Recognizing, 345

RET, 2069, 2353
Retain, 1269
Retentive behavior

Bit memory, timers, counters, 1431
Retentive bit memories

Enabling the display, 1742
Retentive memory, 1754
Retentivity, 1075, 1267

Bit memory, timers, counters, 1431
Block interface, 1507
Data block, 1652
Data block , 1653
PLC tag, 1431

Retentivity of IP address parameters, 1031
Retrieving projects, 376
RETURN, 2568
rewind function, 6046
RFID tag, 6064
RIGHT, 2661
Rights

Access rights, 7274
Access rights to directories, 7308
User Rights, 7274

Ring port, 6621, 6623
Ring Redundancy, 932
RIP

RIPv2 statistics, 873

RIPv2
Configuration, 979
Interfaces, 979

RLO
Invert, 1860, 2137

RMON
History, 957
Statistics, 956

ROL, 2108, 2393, 2599
Role name, 657
Roles, 656

System-defined, 656
User-defined, 657

Root certification authorities, 652
Root, square, 2472
ROR, 2106, 2391, 2597
Rotate

Left, 2108, 2393, 2599
Object, 3342, 3363
Right, 2106, 2391, 2597

Rotation, 3363
T piece, 3635

Rotation property (VBS), 5505
RotationAngle property (VBS), 5505
RotationCenterLeft property (VBS), 5506
RotationCenterTop property (VBS), 5507
Round, 2047, 2049, 2050, 2051, 2330, 2331, 2333, 
2334, 2538, 2539, 2540
ROUND, 2047, 2330, 2538
RoundButton object, 5112
Router, 560, 7491
Router IP address, 746
Routing, 840, 6780

Routing table, 866
Static routes, 840
VRRP, 840

Routing connection
Configuring, 6604

Routing mode, 684
RowNumber property (VBS), 5508
RowScrollbar property (VBS), 5508
RowSizingEnable property (VBS), 5509
RS, 1867, 2145
RS-232/PIP multi-master cable, 1104
RT, 1895, 2172, 2430
RT class, 1018, 6612
RT_INFO, 2853
RTM, 1367, 2636
RTPersistence property (VBS), 5510
RTPersistencePasswordLevel property (VBS), 5511
RTPersistenceType property (VBS), 5511
RulerColor property (VBS), 5512
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RulerControl, 3638
Online configuration, 4254
Runtime data, 4253

RulerPrecision(i) property (VBS), 5512
RulerXPrecision(i) property (VBS), 5513
RulerYPrecision(i) property (VBS), 5514
Rules for configuring MPI networks

Rules for assigning the MPI address, 553
Rules for network configuration for PROFIBUS 
networks

Assigning device addresses, 553, 554
RUN, 1070
Rung

Deleting, 1557
Inserting, 1557
Use, 1555

Runtime, 6077, 6079, 7009, 7011, 7070, 7477, 7478
 configuring in Runtime, (See Online 
Configuration)
Alarms, 7477
Buttons, 4270, 7147
Changing object property, 4500
Displaying logged alarms, 4055, 7176
Effective range, 6077
Effective range (RFID), 6079
Emergency acknowledgement of alarms, 4063, 
7183
Executing user-defined functions, 4495
Execution of the function list, 4496
Filtering alarms, 4051, 7172
Graphics, 7477
Language switching, 4500
Logs, 7477
Mouse wheel, 85
Multiple-station system, 7015, 7078
Operation with the keyboard, 7094
Operation with the mouse, 7096
Reaction to system errors, 7477
Redundant system, 7015, 7078
Reports, 7477
Requirements, 7015, 7078
Response to system errors, 7478
Scripts, 7477, 7478
Sorting alarms, 4052, 7173
Start screen, 3310, 3311
Starting, 7015, 7078
starting on a panel, 6993, 7056
starting on PC, 6993, 7056
System characteristics, 7477
Text library, 7477
User administration, 7477

RUNTIME, 2085, 2369, 2583

Measure program runtime, 2085, 2369, 2583
Runtime data

Migration, 194, 252
Runtime error, 4475, 4483, 7000, 7022
Runtime language, 6882, 6900

Font, 6905
Log, 3773, 4022, 6906
Order for language switching, 6903
Selecting, 6901

Runtime meters
Handling with RTM, 2636

Runtime Professional
Connection parameters, 6274
Defining hotkeys, 7067
Language settings, 7064
Setting up the cursor control, 7068
Setting up the startup list, 7062, 7485
Setting up the zoom functions, 7065

Runtime screen
in reports, 4310

Runtime scripting, 4427
Functions, 4427
Local script, 4427
System functions, 4427
User-defined functions, 4427

Runtime settings, 7016, 7078, 7398
Additional tasks, 7062, 7485
Central formatting of date and time, 7075
Client/server, 7473, 7475
Communication, 6586, 6599
Cursor Control, 7070
Data Monitor, 7291, 7520
Default language, 7064
Dialog fonts, 7051
Disabling program switching, 7051
Dynamic logon, 4384
Hotkeys, 7067
Language setting, 7064
Lock key combinations, 7067
On-screen keyboard, 7065
Optimized drawing, 7066
Screen navigation, 7068
Screen saver, 7052
Start sequence, 7062, 7485
Startup language, 7064
Switch off, (Zoom functions)
Time base for time display, 7075
Time synchronization in Runtime, 7072
User administration, 3311, 3312, 4380, 4381, 
4384, 4393, 4394, 4398, 4399, 4408, 4409

Runtime Stop, 4790
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Runtimes
Differences, 6931

S
S, 1864, 2140
S_AVERZ, 1909
S_CD, 1932, 2211
S_COMP, 2638
S_CONV, 2639
S_CU, 1930, 2209, 2454
S_CUD, 2207
S_EVERZ, 1904
S_MOVE, 2637
S_ODT, 1904, 2181, 2439
S_ODTS, 1907, 2184, 2441
S_OFFDT, 1909, 2186, 2444
S_PEXT, 1901, 2178, 2436
S_PULSE, 1898, 2175, 2433
S_SEVERZ, 1907
S5TIME, 1339
S7 1200

Communication, 6281
Connection parameters, 6354
HMI connection, 6283
Parameters, 6354
PROFIBUS, 6304, 6306, 6310
PROFIBUS parameters, 6313, 6315, 6317
PROFINET, 6282, 6285

S7 1500
Communication, 6198
Connection parameters, 6268
HMI connection, 6200
Parameters, 6268
PC, 6205
PROFIBUS, 6223, 6224, 6225, 6227, 6228
PROFIBUS parameters, 6230, 6233, 6234
PROFINET, 6199, 6202
PROFINET parameters, 6211, 6214

S7 200
Communication, 6503
Connection, 6503, 6533
Connection parameters, 6505
Data types, 6532
MPI, 6451, 6510
Parameters, 6451, 6505, 6510, 6511
PPI, 6511

S7 300
Communication, 6367
MPI address, 6416
Panel, 6175

S7 300/400
Connection parameters, 6446
Data types, 3750, 6439
HMI connection, 6369
MPI, 6404, 6405, 6407, 6409, 6410
MPI parameters, 6412, 6414, 6415
Parameters, 6446
PC, 6376
PROFIBUS, 6389, 6390, 6392, 6394
PROFIBUS parameters, 6399, 6400, 6402
PROFINET, 6368, 6371
PROFINET parameters, 6379, 6380, 6382

S7 400
Communication, 6367
MPI address, 6417
Panel, 6175

S7 channel troubleshooting of connection errors, 
6459
S7 communication

Parameter, 3191
Receive data from a remote partner instruction 
with BRCV, 3205
Receive data from a remote partner instruction 
with URCV, 3201
Send and receive parameters, 3193
Send data to a remote partner instruction with 
BSEND, 3202
Send data to a remote partner instruction with 
USEND, 3199
User data size, 3193

S7 connection, 567
TSAP, 578

S7 connection status, 6478
S7 CPU

 Work memory, 1073
Load memory, 1073
Operand area, 1074

S7 diagnostic alarm
enabling, 3933

S7 diagnostic alarms, 3896
S7 log function, 6462
S7 Protocol Suite

Raw data tag, 4263
Raw data tag for BSEND/BRCV functions, 4265

s7_last_detailed_err_no, 6474
S7-1200, 45

Data types, 6349
Panel, 6175
PROFIBUS, 6305, 6308

S7-1200 modules, 45
S7-1200 V2

Data types, 3750, 3752, 6349
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S7-1500
Data types, 3751, 6263
PROFINET parameters, 6212

S7-300/400
PROFIBUS, 6397

s7chn.ini, 6467
S7-CP, 643
S7DOS Error codes, 6483
S7DOS Function types, 6482
S7DOS Trace function, 6497
S7-GRAPH Overview, 3606

Display program status, 3606
S7-PCT, 1049
SA lifetime, 705
SafelyRemoveHardware, 4592, 4853
Safety, 7059
Safety guidelines, 353
Safety instruction

Changing the recipe data record in the 
background, 4177
Direct key, 7081
Recipe data record in background, 4181, 7122
Renamed tag, 7132
Switching infotext, 7087, 7094

Safety precautions when forcing tags, 1800, 1816
Save

Data of the HMI device, 7026, 7028, 7058
Global library, 6816

Save table layout, 330
Save user interface

Save layout in editors, 330
Save window layout, 330

Save window layout, 330
SaveDataRecord, 4669, 4854
Saving a force table, 1804
Saving a watch table, 1777
Saving phone books, 8095
Saving the user interface, 330
SC, 1934, 2213
SCALANCE S, 642
Scale, 2053, 2057, 2335, 2340, 2543, 2551
SCALE, 2057, 2340, 2551
SCALE_X, 2053, 2335, 2543
ScaleColor property (VBS), 5514
ScaleDenumerator property (VBS), 5520
ScaleGradation property (VBS), 5515
ScaleLabelColor property (VBS), 5516
ScaleNumerator property (VBS), 5516
ScalePosition property (VBS), 5517
ScaleTickColor property (VBS), 5517
ScaleTickLabelPosition property (VBS), 5518
ScaleTickLength property (VBS), 5518

ScaleTickPosition property (VBS), 5519
Scaling

Applying linear scaling to a tag, 3703, 3704
ScalingType property (VBS), 5521
Scan operand for negative signal edge, 1870, 2147
Scan operand for positive signal edge, 1869, 2146
Scan RLO for negative signal edge, 1875, 2152
Scan RLO for positive signal edge, 1873, 2151
Scenario, 7385
Scheduler, 6090

Acyclic triggers, 6094, 6101
Administer task, 6105
Cyclic triggers, 6094, 6110, 6113, 6116
Deactivated task, 6094
Event trigger, 6093, 6095, 6104, 6112
Function list, 6096
Print report, 6113
Tag triggers, 6095
Timers for cyclic and acyclic triggers, 6095
Triggers, 6093, 6094
Work area, 6092

SCI messages, 6480
SCL, 49, 1596, 1847, 1849

Detailed comparison, 1695
Insert comment, 2569
Migration, 161
Programming window, 1606

SCL instruction
Changing the data type, 1616, 1617
Data type basics, 1615
Inserting, 1614, 1615
Rules, 1613
Selecting, 1631

SCL program
Inserting a block call, 1621, 1622, 1624, 1625, 
1626, 1627
Inserting an instruction, 1614, 1615
Inserting comments, 1630
Program status display, 1770
Selecting an instruction, 1631
Showing and hiding the parameter list, 1629

Screen
Availability for specific devices, 3302
Configuring, 7518
Copy, 3309
Copying, 6930
Create, 3308
Creating, 3307
Creating a type, 6825
Define customized menu, 3665
Define customized toolbars, 3665
Deleting, 3309
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Font, 3303
Inserting, 3309
Library, 6825
Move, 3309
Preview, 7289, 7290, 7518, 7519
Printing, 7052
Rename, 3309
Use template, 3319
Web access, 7288, 7518
Working steps in creating, 3306, 3307
Zooming, 3305

Screen change, 4772
Displaying the screen on entering a zone, 6080

Screen designs, 3319
Screen keyboard, 7082

Alphanumerical, 7085
Keyboard level, 7086
Language behavior, 83
Language change, 7086
Numerical, 7083

Screen navigation
Runtime settings, 7068

Screen number, 6125
Screen object, 4940, 4964

Dynamic movement, 3429
Dynamization of the control enable state, 3432

Screen object (list), 4938
Screen saver

Runtime settings, 7052
Screen selection

Setting up, 7068
Screen template, 3458
Screen window

Configuring a menu, 3666
Configuring a toolbar, 3666

ScreenItem, 5068
Control, 5034

ScreenItem object, 4941, 4966
ScreenItems object (list), 4943, 4968
ScreenItems property (VBS), 5522
ScreenObjectCursorDown, 4574
ScreenObjectCursorUp, 4575
ScreenObjectPageDown, 4575
ScreenObjectPageUp, 4576
Screens

 Applying a design, 3324
Designs, 3319

Screens property (VBS), 5522
ScreenWindow object, 5116
Script

Creating a type, 6824
Library, 6824

Migrating, 189
Print job/Script diagnostics, 3530
Updating tag value, 3678, 6158

Script for dynamization
Migrate, 236

Scrollable property (VBS), 5523
Scrolling

Multi-touch devices, 93
Scrolling back key, 7088
Scrolling up key, 7088
SD, 1913, 1915, 2192
SD card

Open force job, 39
SE, 1913, 2190
Search

Hardware catalog, 523
SecondNeedleHeight property (VBS), 5524
SecondNeedleWidth property (VBS), 5524
Security, 48
Security Configuration Tool

Configuration views, 644
Security events, 722, 724
Security module, 643
Security program, 112, 116
Security settings, 888

Internet Explorer, 7298
Security system, 7097
SEG, 2127, 2412, 2618
Segment, 3789
Segment diagnostics

Graphic display, 1252
Icons, 1251
Text display, 1252

SegmentColoring property (VBS), 5525
Segmented circular log, 4009
Segments

Define for log, 3804
SEL, 2095, 2380, 2587
Select, 2095, 2380, 2587

Multiple objects, 3348, 4337
SelectBackColor property (VBS), 5526
SelectedCellColor property (VBS), 5526
SelectedCellForeColor property (VBS), 5527
SelectedRowColor property (VBS), 5528
SelectedRowForeColor property (VBS), 5528
SelectedStatisticArea, 5869
SelectedTitleColor property (VBS), 5529
SelectedTitleForeColor property (VBS), 5530
SelectForeColore property (VBS), 5530
Selecting

Multiple objects, 3342
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Selection
Selection dialog box, 4277, 7154

Selection changed, 4770
Selection list

Open, 7089
Selection of the correct channel unit, 6461
Selection of the correct communication subsystem, 
6460
SelectionBackColor property (VBS), 5531, 5532
SelectionColoring property (VBS), 5532
SelectionForeColor property (VBS), 5533, 5534
SelectionMode property (VBS), 5534, 5535
SelectionRect property (VBS), 5535
SelectionRectColor property (VBS), 5536
SelectionRectWidth property (VBS), 5537
Send clock cycle, 1037
SEND_CFG, 3111
SEND_PTP, 3119
SendEMail, 4646, 4855
SeparatorBackColor property (VBS), 5538
SeparatorColor property (VBS), 5538
SeparatorWidth property (VBS), 5540
SeperatorCornerStyle property (VBS), 5539
SeperatorStyle property (VBS), 5539
Sequence of columns, 3619
Sequencer, 2110, 2395, 2601
Serial communication

Interface, 6455
Serial number, 850
Serialization, 2284, 2485
Serialize, 2003, 2284, 2485
Server, 7370

Activating a project from client, 7492
Configuring, 6586
Deactivating a project from client, 7493
HMI device, 6586
Shutdown, 7479
Startup, 7479

ServerExport, 5870
ServerImport, 5871
ServerNames property (VBS), 5541
ServerScale property (VBS), 5540
Service & Support, 6142
Service data

Saving, 1228
Service groups, 669, 671
Service-pages, 7444

Create own , 7452
Display, 7448
remote control, 7448
Transfer, 7453

Servo motor, 7800

Session
Closing, 7302

Session Management, 7414
Setting, 7415

Set
Bit field, 1864, 2141
Counter start value, 1934, 2213
Operand, 1864, 1866, 2140, 2143

Set limit value, 1978, 2258, 2469
Set operand on negative signal edge, 1872, 2149
Set operand on positive signal edge, 1871, 2148
Set tag on negative signal edge, 1877, 2154, 2417
Set tag on positive signal edge, 1876, 2153, 2416
Set the services 

SmartClient, 7398
SmartServer, 7398

Set up
Sort, 3587

SET_BF, 1864, 2141
SET_CINT, 2810
SET_TIMEZONE, 2632
SET_TINT, 2813
SET_TINTL, 2816
SetAccessModeViaWeb, 4663
SetAcousticSignal, 4647, 4856
SetAlarmReportingMode, 4656, 4857
SetAlarmReportMode, 4656, 4857
SetAndGetBrightness, 4659, 4857
SetBacklightColor, 4653
SetBit, 4649, 4724, 4858, 4895, 5954
SetBitInTag, 4650, 4725, 4859, 4896, 5955
SetBitWhileKeyPressed, 4651
SetBrightness, 4653, 4860
setbuf function, 6046
SetConnectionMode, 4661, 4861
SetDataRecordTagsToPLC, 4644, 4862
SetDataRecordToPLC, 4643, 4863
SetDaylightSavingTime, 4658, 4864
SetDeviceMode, 4648, 4865
SetDisplayMode, 4647, 4865
SETIO, 2679
SETIO_PART, 2680
SetLanguage, 4658, 4866, 5956
SetPLCMode, 4655, 4867
SetpointTrendArchiveStartId(i) property (VBS), 5542
SetpointTrendColor(i) property (VBS), 5543
SetpointTrendNumberOfValues(i) property (VBS), 
5543
SetPropBOOL, 5958
SetPropChar, 5959
SetPropDouble, 5960
SetPropertyByConstant, 4730, 4898, 5963
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SetPropertyByProperty, 4729, 4899, 5965
SetPropertyByTag, 4732, 4901, 5966
SetPropertyByTagIndirect, 4734, 4902, 5968
SetPropertyCurrentWindow, 4727
SetPropertyCurrentWindowByProperty, 4728
SetPropertyCurrentWindowByTagIndirect, 4728
SetPropLong, 5962
SetRecipeTags, 4656, 4867
SetScreenKeyboardMode, 4654, 4869
SetStart at boot, 4706, 4881
SetTag, 4660, 4735, 4869, 4904, 5985
SetTagBit, 5969
SetTagBitState, 5975
SetTagBitStateWait, 5977
SetTagBitWait, 5983
SetTagByProperty, 4736, 4905, 5986
SetTagByte, 5969
SetTagByteState, 5975
SetTagByteStateWait, 5977
SetTagByteWait, 5983
SetTagChar, 5969
SetTagCharState, 5975
SetTagCharStateWait, 5977
SetTagCharWait, 5983
SetTagDouble, 5969
SetTagDoubleState, 5975
SetTagDoubleStateWait, 5977
SetTagDoubleWait, 5983
SetTagDWord, 5969
SetTagDWordState, 5975
SetTagDWordStateWait, 5977
SetTagDWordWait, 5983
SetTagFloat, 5969
SetTagFloatState, 5975
SetTagFloatStateWait, 5977
SetTagFloatWait, 5983
SetTagIndirect, 4739, 4907, 5988
SetTagIndirectByProperty, 4737, 4740, 4906, 4908, 
5987, 5989
SetTagIndirectByTagIndirect, 4742, 4909, 5990
SetTagIndirectWithOperatorInputAlarm, 4738, 4743, 
4910, 4911, 5991, 5992
SetTagMultiStateWait, 5971
SetTagMultiWait, 5973
SetTagRaw, 5969
SetTagRawState, 5975
SetTagRawStateWait, 5978
SetTagRawWait, 5983
SetTagSByte, 5969
SetTagSByteState, 5975
SetTagSByteStateWait, 5978
SetTagSByteWait, 5983

SetTagSDWord, 5969
SetTagSDWordState, 5975
SetTagSDWordStateWait, 5978
SetTagSDWordWait, 5983
SetTagSWord, 5969
SetTagSWordState, 5975
SetTagSWordStateWait, 5978
SetTagSWordWait, 5983
SetTagToHandWheel, 4682
SetTagValue , 5979
SetTagValueWait, 5981
SetTagWord, 5969
SetTagWordState, 5975
SetTagWordStateWait, 5978
SetTagWordWait, 5983
Setting

Deadband, 3924, 3940
Delay time, 3924, 3940
Language, 7096
Languages in the operating system, 6883
Priority, 3941
Style, 3360
Time base, 3586
View options for the assignment list, 1738
View options for the dependency structure, 1752

Setting AS-i network configuration parameters, 566
Setting at the HMI-device

E-Mail, 7402
HTTP server, 7404, 7457
SmartServer, 7405
Web authorization, 7404
Web server, 7404

Setting ENO automatically, 1605
Setting language, 7096
Setting parameters for the Ethernet interface, 8039

Adding a dynamic IP address, 8040
Connecting to a subnet, 8038
Deleting dynamic IP addresses, 8040
Modifiable parameters, 8037
Options in the parameter settings, 8037

Setting the communication load, 560
Setting the font, size and color , 1607
Setting the Internet Settings

HTTP server, 6592
Setting the mnemonics, 1480
Setting the tab spacing , 1607
Setting up

DCOM user rights, 7551, 7605
Setting up DCOM user rights, 7551, 7605
Settings

Changing, 302, 1490, 1517, 1560, 1606
FBD, 1517, 1559
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General, 299, 301, 302, 1489
LAD, 1517, 1559
SCL, 1605

Settings for tags, 3696
Settings for the PG/PC interface, 8034

Automatic bus parameter detection, 8042
Setting parameters for the MPI interface, 8043
Setting parameters for the PROFIBUS interface, 
8045

Setup of an S7 logbook, 6466
SetValue, 7465
setvbuf function, 6046
SetWebAccess, 4663
Seven-segment display, 2127, 2412, 2618
Severity, 684
SF, 1918, 2196
SFP diagnostics, 913
SGN_GET, 3123
SGN_SET, 3124
SHA algorithm, 889
SHA1, 699, 705
Share, 7059
Shared device

Associated IO controllers, 1216
Shared property (VBS), 5546
ShareTimeColumn property (VBS), 5544
ShareValueAxis property (VBS), 5545
ShareXAxis property (VBS), 5545
ShareYAxis property (VBS), 5546
Shift

Left, 2104, 2389, 2595
Right, 2102, 2387, 2593

SHIFT
Key, 7089

ShiftDecimalPointReadOnlySpecial property (VBS), 
5547
SHL, 2104, 2389, 2595
Short-circuit to ground, 1172
Short-circuit to L+, 1173
Shortcut menu, 4783
ShortenCellText property (VBS), 5547
ShortenColumnHeaderText property (VBS), 5548
Short-term archive list, 4054, 7175
Show

Limit lines on the bar, 3520
Show line numbers, 1608
Show/hide interfaces, 8035
ShowAlarmsFromDate property (VBS), 5548
ShowAlarmWindow, 4687, 4688, 4872, 4875
ShowBar property (VBS), 5549
ShowBorder property (VBS), 5549
ShowCaption property (VBS), 5550

ShowColumn(i) property (VBS), 5551
ShowColumnSelection, 5871
ShowComment, 5872
ShowCurve(i) property (VBS), 5551
ShowDecimalPoint property (VBS), 5552
ShowDisplayOptionsDialog, 5872
ShowEmergencyQuitDialog, 5873
ShowFillLevel property (VBS), 5552
ShowFocusRectangle property (VBS), 5553
ShowHelp, 5873
ShowHideList, 5874
ShowHitList, 5874
Showing

Report sections, 4319
Showing and hiding absolute operands, 1608
Showing and hiding columns, 398, 1443, 1513, 1661, 
1675
ShowInputControls property (VBS), 5553
ShowLimitMarkers property (VBS), 5554
ShowLockDialog, 5875
ShowLockList, 5876
ShowLogonDialog, 4685, 4746, 4912
ShowLongTermArchiveList, 5876
ShowMainFrame property (VBS), 5554
ShowMessagesAtDate property (VBS), 5555
ShowOperatorNotes, 4686, 4873
ShowOverflowIndicator property (VBS), 5556
ShowPeakValuePointer property (VBS), 5556
ShowPercentageAxis, 5877
ShowPosition property (VBS), 5557
ShowPropertyDialog, 5878
ShowRowHeaders property (VBS), 5558
ShowRuler property (VBS), 5558, 5559
ShowRulerInAxis property (VBS), 5559
ShowScale property (VBS), 5560
ShowScrollbars property (VBS), 5560
ShowSelectArchive, 5878
ShowSelection, 5879
ShowSelectionDialog, 5879
ShowSelectTimeBase, 5880
ShowSetpointTrend(i) property (VBS), 5561
ShowShortTermArchiveList, 5880
ShowSoftwareVersion, 4687, 4874
ShowSort, 5881
ShowSortButton property (VBS), 5561
ShowSortDialog, 5881
ShowSortIcon property (VBS), 5562, 5563
ShowStatusBar property (VBS), 5563
ShowSystemAlarm, 4689, 4875
ShowSystemDiagnosticsWindow, 4688, 4875
ShowTableGridlines property (VBS), 5564
ShowTagSelection, 5882
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ShowThumb property (VBS), 5565
ShowTickLabels property (VBS), 5565
ShowTicks property (VBS), 5566
ShowTimebaseDialog, 5882
ShowTimeSelection, 5883
ShowTitle property (VBS), 5567
ShowToolBar property (VBS), 5567
ShowTrendIcon property (VBS), 5568
ShowTrendIndicator property (VBS), 5569
ShowTrendSelection, 5883
ShowVerticalGridlines property (VBS), 5569
ShowXValuesExponential(i) property (VBS), 5570
ShowYValuesExponential(i) property (VBS), 5570
SHR, 2102, 2387, 2593
Shutdown, 7480

Of the client, 7480
Of the server, 7479

Shutting down, 7479, 7480
Of the client, 7480
Of the server, 7479

SiClock, 671
Sign, 1973, 2253
Signal board, 785

Inserting, 786
Signal quality

Calculating the effective range, 3645
signature

electronic, 7227
Signing the log backup file, 3808, 4027
SIMATIC

Differences in data format from Microsoft, 4268
SIMATIC 500/505 DP

Migrating data types, 208
SIMATIC 500/505 serial

Migrating data types, 209
SIMATIC HMI, 7060, 7061

User group, 7059
SIMATIC HMI HTTP protocol

Valid data type, 6598
SIMATIC HMI HTTP Protocol

Configuring HTTP clients, 7459
Configuring the connection, 7459
HTTP Protocol, 6585
HTTPS Protocol, 6585
Migrating data types, 209
Permitted data type, 7456

SIMATIC LOGO!
Communication, 6532
Connection parameters, 6535
Parameter, 6535

SIMATIC Logon, 4395

SIMATIC memory card
Formatting, 1235

SIMATIC PC
HMI connection, 6208, 6228, 6287, 6308, 6373, 
6394, 6409
S7 1500, 6208
S7 300/400, 6373
WinCC RT Advanced, 6208, 6308, 6373
WinCC RT Professional, 6208, 6228, 6287, 6308, 
6373, 6394, 6409
WinCC RT Advanced, 6228, 6287, 6394, 6409

SIMATIC S5 AS511
Migrating data types, 210

SIMATIC S5 DP
Migrating data types, 210

SIMATIC S7
Communication partners, 6271, 6359, 6450, 
6509, 6512

SIMATIC S7 Embedded Controller, 46
SIMATIC S7-300/400, 6459
SIMATIC Shell, 7489, 7491
SIMATIC Logon, 4384
SIMATIC S7 1500

Addressing, 6264
SIMATIC S7 200

Migrating data types, 211
SIMATIC S7 300/400

Migrating data types, 211
simple alarm view, 7163

Use, 7163
Simple alarm view, 4040

Application, 4040
Control element, 4041, 7164
Operation, 4041, 7163
Operation using the keyboard, 4042
Operation using the mouse, 4042

simple alarm window
Application, 4040
Use, 7163

Simple recipe view, 3598, 4176, 7121
Behavior, 4206, 7139
Configuring, 3598
Constraints, 4180
Layout, 4205, 7138
Menu command, 4206, 7138, 7139
Operation, 4205, 7138

Simple user view, 7100
Configuring, 3523
Layout, 7100
Operation, 7101
Use, 7100

Simulate hardware, 498
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Simulate modules, 498
Simulate software, 498
SimulateSystemKey, 4664
SimulateTag, 4665
Simulating, 7018

Define temporary start screen, 6997, 7019
Project with tag simulator, 6996

Simulating devices, 498
Simulation, 90

PLC connection, 90
Project:simulate, 7018

Simulation data, 7018
SIN, 1985, 2265, 2475
sin function, 6043
Sine, 1985, 2265, 2475
Single alarm

Filtering, 4051, 7172
Hiding alarms, 4005

Single instance
Correcting the call type, 1536, 1577
Definition, 1275
Example, 1275

sinh function, 6043
SINT, 1328, 1376, 1396
SINT_TO_, 1396
Size

Editing multiple objects, 3371, 4339
of objects in the report, 4301

Size data
Migrate, 233

SkinName property (VBS), 5571
SLC, 6662
Slice access, 1308
Slicing, 275
Slider, 3609

Display bar, 3610
Display current value, 3610
Lock/unlock, 97
Maximum value, 3610
Minimum value, 3610

Slider object, 5122
Slot

Determining logical address with LGC_GADR, 
2934
Determining logical address with LOG_GEO, 
2930
Racks, 525
Select, 526

Slot rules, 522
ET 200S, 1006

Sm@rtClient view, 3614
Shared use, 3615

View only, 3615
Smart Objects

Control, 5034
Smart Options, 7426

HMI devices suitable for use, 7397
Remote control, 7426
Remote control by means of Internet Explorer, 
7427
Remote monitoring, 7426

Smart tags
ProcessValue, 5497

SmartAccess
Distributed operator stations, 7434
Editing tag values in MS Excel, 7465

SmartClient
Monitoring mode, 7419
Password input, 7432
SmartClient display, 7419

SmartClient display, 7431
SmartClientView object, 5123
SmartClientViewConnect, 4668
SmartClientViewDisconnect, 4667
SmartClientViewLeave, 4668
SmartClientViewReadOnlyOff, 4666
SmartClientViewReadOnlyOn, 4667
SmartClientViewRefresh, 4666
Smartdrive

Installation, 62
SmartServer, 4674, 4813

As a service, 7418
Control mode, 7415
Forced access, 7417
Hardware acceleration, 7425
Local operator control, 7417
Monitoring mode, 7415
Password, 7425
Password input, 7432
Setting at the HMI-device, 7405

SmartService
E-mail notification, 7439
Input area plan, 7402
Remote control by means of the SmartClient 
application, 7428

SmartTag object, 4946, 4972
SmartTags object (list), 4944, 4974
SmartTags property (VBS), 5572
SMC, 2122, 2407, 2613
Smoothing, 1165, 1183
SMTP Client, 885
SNC_RTCB, 2634
SNMP, 659, 836, 874, 888

Groups, 888
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SNMP trap, 888
SNMPv1, 836
SNMPv2c, 836
SNMPv3, 836
Users, 889

SNMPv1, 699
SNMPv3, 699
SOAP

Access from Excel, 7464
GetValue, 7465
SetValue, 7465
Windows CE, 7464

Softbus, 6780
Softkey, 3456, 3460

global, 3458
SOFTNET Security Client

Configuring in the project, 726
Creating a configuration file, 726
Database, 726
Using, 725

SOFTNET Security Client, 642
Software

HMI device, 7022, 7023, 7024
Requirement, 7499

Software controller
Configuring, 7709

Software requirements at the plant end
Communications instruction "PG_DIAL", 8139

Software requirements at the system end
 Communications instruction "AS_MAIL", 8143
Communications instruction "SMS_SEND", 8142

Software requirements for AS-AS remote link
Communication instruction "AS_DIAL", 8141

Software requirements for the programming device/
personal computer

Communications instruction "PG_DIAL", 8139
Software version, 850
Software-controlled data flow control, 1103
Sort

Set up, 3587
Sort order

Sorting dialog, 4279, 7156
Sort property (VBS), 5572
SortByTimeEnable property (VBS), 5573
SortByTimeEnabled property (VBS), 5574
Sorting

 Report page, 4318
Sorting alarms, 4052, 7173
SortOnColumnHeaderClick property (VBS), 5574
SortSequence property (VBS), 5575
SortTimeAscending property (VBS), 5575
SortTimeEnable property (VBS), 5576

SP, 1912, 2189
Spanning Tree

Information, 854
Rapid Spanning Tree, 839

Special characters
Alarm text, 72

Special considerations
Omron Host Link, 6757

Special settings of the S7 channel, 6464
Special tag (web server), 800
Specific .Net control

Add, 3373
Remove, 3374

Speedy Splitter, 503, 506, 508, 518
SQL, 4290
SQL queries

to WinCC databases, 7656
SQL statements for filtering alarms, 4072
SQR, 2471
SQR , 1980, 2260
SQRT, 1981, 2262, 2472
sqrt function, 6043
Square, 1980, 2260, 2471
Square root, 1981, 2262, 2472
SR, 1866, 2143
srand function, 6046
SRT_DINT, 2823
SS, 1916, 2194
SSH server, 873
SSL certificate, 653
Stamping, 3369, 4332
Standard

PROFIBUS, 6235, 6318, 6403
Standard device, 1043
Standard router, 746
Standard slave, 1016
Standard SQL queries

to WinCC databases, 7656
Standard user, 656
Standard Web site, 7527, 7529
Standby module

Substitute value, 1011
Start

Logging, 3776
Migrated project, 221

Start address, 781, 1078
Start angle

Circular arc, 3566
Ellipse segment, 3540
Elliptical arc, 3539

Start Angle
Circle segment, 3568
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Start information, 1262
Start off-delay timer, 2168
Start on-delay timer, 2166
Start pulse timer, 2164
Start screen, 3310, 3311, 3652
Start sequence

Runtime settings, 7062, 7485
Start the online and diagnostics view, 1210
Start the simulation, 499
Start value, 49

Tag, 3701
Start value of danger range

Gauge, 3648
Start value of warning range

Gauge, 3648
StartAngle property (VBS), 5576
Starting

Debugger, 4481, 7001
Runtime at Engineering Station, 6992, 7015, 
7055, 7077
Runtime on a panel, 6993, 7056
Runtime on PC, 6993, 7056
Runtime on the configuration PC, 6992, 7015, 
7055, 7077

Starting point
Defining, 3741

Starting point of logging, 3783
Starting removal, 137
Starting the migration tool, 144
Starting the topology view, 628
StartLeft property (VBS), 5577
StartLogging, 4670, 4876
StartNextLog, 4671, 4876
StartPointTop property (VBS), 5579
StartProgram, 4671, 4877, 5993
StartSequenceLog, 4671, 4876
StartStopUpdate, 5884
StartStyle property (VBS), 5578
Startup, 1115, 7479, 7480

Of the client, 7480
Of the server, 7479
Organization blocks, 1115

STARTUP
Function, 1067
STARTUP activities, 1068

Start-up behavior, 7480
Start-up characteristics, 7479

Of the client, 7480
Of the server, 7479

Startup language
determine:Startup language, 3773, 4023
Runtime settings, 7064

Startup list, 7062, 7485
Setting up, 7062

Startup OB
Description, 1115

Start-up parameters, 1069
Startup routine, 1115
Startup type, 1087
Stateful packet inspection, 663
Static time range, 3833
Station

Copying, 537
Deleting, 536
Moving, 538
Read information with GetStationInfo, 2864
Renaming, 638

Station name, (See device name)
Statistics area column name property changed, 
4777
Statistics function

Displaying for process values, 7341
Status, 1119

Module defective, 1223
Status bar, 3586, 3844, 3857, 3863, 7171

Recipe view, 4270, 7147
Table view, 3885
Trend view, 3885

Status bar element property changed, 4777
Status changed, 4792
Status display

Channel diagnostics, 3562
Status interrupt, 1119
Status interrupt OB, 1119
Status of the online connection, 1247
Status tag, 3908

Alarm group, 3975
Status/Force

Button, 3619
Column header, 3619
Control element, 3618
Sequence of columns, 3619
Visible column, 3618

StatusbarBackColor property (VBS), 5580
StatusbarElementAdd property (VBS), 5580
StatusbarElementAutoSize property (VBS), 5581
StatusbarElementCount property (VBS), 5581
StatusbarElementIconId property (VBS), 5582
StatusbarElementID property (VBS), 5582
StatusbarElementIndex property (VBS), 5583
StatusbarElementName property (VBS), 5583
StatusbarElementRemove property (VBS), 5584
StatusbarElementRename property (VBS), 5584
StatusbarElements property (VBS), 5584
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StatusbarElementTooltipText property (VBS), 5585
StatusbarElementUserDefined property (VBS), 5585
StatusbarElementVisible property (VBS), 5586
StatusbarElementWidth property (VBS), 5587
StatusbarFontColor property (VBS), 5587
StatusbarShowArchiveName property (VBS), 5587
StatusbarShowColumn property (VBS), 5588
StatusbarShowRecord property (VBS), 5588
StatusbarShowRow property (VBS), 5589
StatusbarShowText property (VBS), 5589
StatusbarShowTooltips property (VBS), 5589
StatusbarText property (VBS), 5590
StatusbarUseBackColor property (VBS), 5591
StatusbarVisible property (VBS), 5591
StatusForce object, 5125
StatusForceGetValues, 4673
StatusForceSetValues, 4673
stdio functions

clearerr function, 6046
fclose function, 6045
feof function, 6045
ferror function, 6045
fflush function, 6045
fgetc function, 6045
fgetpos function, 6045
fgets function, 6045
fopen function, 6045
fputc function, 6045
fputs function, 6045
fread function, 6046
freopen function, 6045
fseek function, 6045
fsetpos function, 6046
ftell function, 6046
fwrite function, 6046
getc function, 6046
putc function, 6046
remove function, 6046
rename function, 6046
rewind function, 6046
setbuf function, 6046
setvbuf function, 6046
tmpfile function, 6045
tmpnam function, 6045
ungetc function, 6046
vfprintf function, 6046
vsprintf function, 6046

stdlib functions
abort function, 6047
abs function, 6046
atof function, 6046
atoi function, 6046

atol function, 6046
bsearch function, 6047
calloc function, 6047
div function, 6046
exit function, 6047
free function, 6047
getenv function, 6046
labs function, 6046
ldiv function, 6046
malloc function, 6047
qsort function, 6047
rand function, 6046
realloc function, 6047
srand function, 6046
strtod function, 6046
strtol function, 6047
strtoul function, 6047
system function, 6047

StepBack, 4791
StepForward, 4791
Stepper motor, 7800
STL

Detailed comparison, 1692
Migration, 159

STL source
Generating blocks, 1680

Stop, 4792
STOP, 1070
Stop forcing, 1822, 1823
Stop method, 5884
StopLogging, 4675, 4878
Stopping

Debugger, 4481
StopRuntime, 4676, 4745, 4880, 4913, 5994
Storage location, 4010

Audit Trail, 7251
Storing

External graphic, 3377
STP, 2076, 2360, 2574
strcat function, 6047
strchr function, 6047
strcmp function, 6047
strcpy function, 6047
strcspn function, 6047
strerror function, 6047
strftime function, 6048
Strg_TO_Chars, 2645
STRG_VAL, 2640
String

Comparing tags with S_COMP, 2638
STRING, 1316, 1347, 1388, 1414

Addressing, 1307
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String functions
strcat function, 6047
strchr function, 6047
strcmp function, 6047
strcpy function, 6047
strcspn function, 6047
strerror function, 6047
strlen function, 6047
strncat function, 6047
strncmp function, 6047
strncpy function, 6047
strpbrk function, 6047
strrchr function, 6047
strspn function, 6047
strstr function, 6047
strtok function, 6047

STRING_TO_, 1414
strlen function, 6047
strncat function, 6047
strncmp function, 6047
strncpy function, 6047
strpbrk function, 6047
strrchr function, 6047
strspn function, 6047
strstr function, 6047
strtod function, 6046
strtok function, 6047
strtol function, 6047
strtoul function, 6047
STRUCT

Addressing, 1307
Declaration in global data blocks, 1648
Declaration in the block interface, 1500
Declaring in a PLC data type, 1671
Structure, 1355

Structure, 1168, 1180
Call structure, 1745
of the cross-reference list, 1759, 6877
Of the dependency structure, 1750
Resources tab, 1756
STRUCT, 1355

Structured programming, 1260
Style

Changing, 3332
Creating a new type, 6826
Define, 3329
Deleting, 3331
Duplicate, 3331
Edit, 3332
Setting, 3360

Style property (VBS), 5592, 5593
SUB, 1965, 2244

Subdivision
Trend view, 3840

Subnet, 562
Subnet mask, 560, 1023
Substitute value, 3716

Defining, 3716
Standby module, 1011

Subtract, 1965, 2244
Subtracting

Subtracting timers with T_SUB, 2624
Supply voltage, 1174
SWAP, 2022, 2304, 2498
Swap bytes, 2022
SwapDimensionsWithOrientation property (VBS), 
5594
SwapFirstWithLastConnection property (VBS), 5594
Swapping, 4027

Alarm log, 4027
Signing off alarm log, 4027

Swapping out, 3791
of process values, 3791

Swapping out of process values, 3791
Switch, 3607

Type, 3607
SWITCH, 2066, 2350
Switch buffer, 6254, 6338, 6434, 6528, 6540, 6670, 
6705, 6739, 6758
Switch object, 5127
Switch OFF, 4795
Switch ON, 4796
Switching between basic mode and expanded mode 
in the force table, 1801
Switching between basic mode and expanded mode 
in the watch table, 1773
Switching operating mode, 1229
Switchover time, 1105
Switchport, 1041, 6221, 6302, 6387
Symbol

Alarm classes, 3963
For value comparison, 7715

Symbol library, 3619
Fill style, 3620
Fixed aspect ratio, 3621
Flip, 3620
OP 177B mono, 3620
Rotate, 3620
TP 177B mono, 3620

Symbolic addressing, 276
of a tag, 3681, 6160

Symbolic I/O field, 3621, 3622
 application in reports, 4372
Mode, 3621, 3623

Index

WinCC Professional V13.0
8292 System Manual, 02/2014



Text list, 3404, 3405, 3622, 3623
Symbolic programming

Displaying absolute addresses, 1481
SymbolicIOField object, 5130
Symbolism, 273
SymbolLibrary object, 5135
Symbols

In the assignment list, 1736
In the call structure, 1744
In the dependency structure, 1751

Sync domain, 1042, 1216, 6222, 6303, 6388
Sync domain properties, 1216
SYNC_PI, 2671
SYNC_PO, 2672
Synchronization

From DP slaves with DP_SYC_FR, 2726
Slave clocks with SNC_RTCB, 2634

Synchronization (user-defined web pages), 793
Synchronization of variables, 7368
Synchronize, 3677, 3679, 3696, 6158
Synchronizing

Object in user-defined functions, 4442
Recipe data record, 4215
Recipe tag, 4169, 7123, 7132, 7133
Recipe view and recipe screen, 4165
Tag in user-defined functions, 4442

Synchronizing a PLC tag, 3697
Synchronizing user-defined web pages, 3288
Synchronous

Transferring data, 6247, 6332, 6428, 6526, 6773
Synchronous errors

Masking with MSK_FLT, 2831
Querying the error register with READ_ERR, 
2833
Unmasking with DMSK_FLT, 2832

Syntax
Addressing, 6638

Syntax errors
Basics, 1633
Finding errors, 1633

Syntax for AWP commands, 796
Syntax highlighting

User-defined function, 4442
Syslog Client, 900
Syslog server, 715
System

General information, 875
System configuration, 873

System alarm, 3895
Meaning, 4074, 4076, 4084, 4089, 4092, 4104

System block, 4069
Configuring, 3936

System blocks folder, 1447
System blocks, 3934
System characteristics, 7477
System diagnostic view

Icon, 3626, 3628
System diagnostics, 4123, 4137, 4142

Button, 4149
Detail view, 4123, 4138, 4142
Device view, 4123, 4138, 4142
Diagnostic buffer view, 4123, 4138, 4143
Matrix view, 4141
Settings in the PLC, 4127, 4145
System diagnostics view, 4123, 4137, 4142
System diagnostics window, 4123, 4137, 4148

System diagnostics indicator, 4123
Button as system diagnostics indicator, 4149
Inserting, 4133, 4145
System diagnostics window, 4133, 4145

system diagnostics view
Layout, 3625, 3627
Show split view, 3626, 3628, 4129, 4152
Single display, 3628
System diagnostics indicator, 4133, 4145

System diagnostics view, 4137
Configuring, 4128, 4129, 4150, 4151, 4152
Detail view, 3624
Device view, 3624
Diagnostic buffer view, 3624
Settings in the PLC, 4127, 4145

System diagnostics window, 4137, 4148
Configuring, 4148
Layout, 3630

System error, 7478
System errors, 7477
System event, 3890, 3891, 3893, 3896

Editing, 3931, 3953
Meaning, 4075, 4077, 4080, 4083, 4084, 4085, 
4086, 4088, 4090, 4092, 4093, 4094, 4096, 4097, 
4099, 4100, 4105
Parameters, 4074

System events, 721, 724
Configuring, 3912, 3913

system function, 6047
System function, 4427, 4701

 SetStart at boot, 4706, 4881
 WinACMPUpdateINTFLED, 4697
Application, 4430, 4431
DirectKeyScreenNumber, 4581
HMI device dependency, 4444
In function list, 4430
in user-defined functions, 4430, 4496
Language dependency in function lists, 4431
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NotifyUserAction, 7261
SafelyRemoveHardware, 4592, 4853
Sequence is not adhered to, 4498
WinACMPArchive, 4704
WinACMPClearCycleTimeBuffer, 4706
WinACMPControl, 4710
WinACMPGetStartMode, 4705
WinACMPGetVersion, 4705, 4880
WinACMPRestore, 4711
WinACMPSetHMIEnableTime, 4707
WinACMPSetKeySwitch, 4707
WinACMPSetRestartMethod, 4708
WinACMPSetSleeptime, 4708
WinACMPSetStartMode, 4709, 4882
WinACMPStartHistogram, 4709
WinACMPUpdateAverageCycleTime, 4694
WinACMPUpdateAverageExecTime, 4693
WinACMPUpdateBUSF1LED, 4691
WinACMPUpdateBUSF2LED, 4692
WinACMPUpdateEXTFLED, 4695
WinACMPUpdateKeySwitchSetting, 4690
WinACMPUpdateLastCycleTime, 4698
WinACMPUpdateMaximumCycleTime, 4699
WinACMPUpdateMinimumCycleTime, 4700
WinACMPUpdatePowerLED, 4700
WinACMPUpdateRUNLED, 4702
WinACMPUpdateSleepTime, 4701
WinACMPUpdateStartupCharacteristics, 4689
WinACMPUpdateSTOPLED, 4703

System functions
 ActivateScreenInCurrentScreenWindow, 4713
 ActivateScreenInScreenWindow, 4713, 4883, 
5898
AcknowledgeAlarm, 4630, 4799
ActivateCleanScreen, 4568
ActivatePreviousScreen, 4569, 4800
ActivateScreen, 4566, 4712, 4800, 4882, 5897
ActivateScreenByNumber, 4567, 4802
ActivateSystemDiagnosticsView, 4677, 4802
AdjustContrast, 4570
AlarmViewAcknowledgeAlarm, 4623
AlarmViewEditAlarm, 4622
AlarmViewShowOperatorNotes, 4623
AlarmViewUpdate, 4622
ArchiveLogFile, 4572, 4803
Available for WinCC Runtime, 4559, 4564
Available on Comfort Panels, 4547
Available on mobile panels, 4554
Available on Multi Panels, 4542
Available on Panels, 4536
BackupRAMFileSystem, 4663, 4805
CalibrateTouchScreen, 4601, 4805

ChangeConnection, 4684, 4806
ClearAlarmBuffer , 4620, 4808
ClearAlarmBufferProTool , 4621, 4808
ClearDataRecord, 4618, 4809
ClearDataRecordMemory, 4619, 4810
ClearLog, 4617, 4811
CloseAllLogs, 4642, 4812
ControlSmartServer, 4674, 4813
ControlWebServer, 4674, 4814
DecreaseFocusedValue, 4683
DecreaseTag, 4683, 4743, 4815, 4884, 5901
DirectKey, 4578
EditAlarm, 4574, 4816
Encode, 4576, 4817
EncodeEx, 4577, 4817
ExportDataRecords, 4585, 4818
ExportDataRecordsWithChecksum, 4588, 4821
ExportImportUserAdministration, 4590, 4716, 
4823, 4886
GetBrightness, 4614, 4824
GetDataRecordFromPLC, 4609, 4825
GetDataRecordName, 4611, 4826
GetDataRecordTagsFromPLC, 4613, 4828
GetGroupNumber, 4613, 4829
GetPassword, 4614, 4829
GetUserName, 4609, 4830
GoToEnd, 4592, 4830
GoToHome, 4591, 4831
HTMLBrowserBack, 4594
HTMLBrowserForward, 4594
HTMLBrowserRefresh, 4593
HTMLBrowserStop, 4593
ImportDataRecords, 4595, 4831
ImportDataRecordsWithChecksum, 4596, 4833
IncreaseFocusedValue, 4584
IncreaseTag, 4585, 4714, 4835, 4887, 5940
InvertBit, 4598, 4717, 4837, 4889, 5945
InvertBitInTag, 4599, 4718, 4838, 4890, 5946
InvertLinearScaling, 4600, 4719, 4835, 4888, 
5944
LinearScaling, 4616, 4721, 4839, 4892, 5949
LoadDataRecord, 4608, 4840
Logoff, 4566, 4841
Logon, 4571, 4842
LogTag, 4573
LookupText, 4680, 4842
NotifyUserAction , 4583, 4843
OpenAllLogs, 4624, 4844
OpenCommandPrompt, 4628, 4845
OpenControlPanel, 4629
OpenControlPanelDialog, 4627, 4846
OpenInternetExplorer, 4628, 4847
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OpenScreenKeyboard, 4625, 4847
OpenTaskManager, 4630, 4848
PageDown, 4645, 4849
PageUp, 4645, 4849
PressButton, 4639
PrintReport, 4582, 4850
PrintScreen, 4581, 4850
RecipeViewBack, 4636
RecipeViewClearDataRecord, 4632
RecipeViewGetDataRecordFromPLC, 4631
RecipeViewMenu, 4632
RecipeViewNewDataRecord, 4631
RecipeViewOpen, 4633
RecipeViewRenameDataRecord, 4635
RecipeViewSaveAsDataRecord, 4634
RecipeViewSaveDataRecord, 4634
RecipeViewSetDataRecordToPLC, 4633
RecipeViewShowOperatorNotes, 4636
RecipeViewSynchronizeDataRecordWithTags, 
4635
ReleaseButton, 4640
ResetBit, 4637, 4722, 4851, 4893, 5951
ResetBitInTag, 4638, 4723, 4852, 4894, 5952
ResetTagToHandWheel , 4681
SaveDataRecord, 4669, 4854
ScreenObjectCursorDown, 4574
ScreenObjectCursorUp, 4575
ScreenObjectPageDown, 4575
ScreenObjectPageUp, 4576
SendEMail, 4646, 4855
SetAcousticSignal, 4647, 4856
SetAlarmReportMode, 4656, 4857
SetAndGetBrightness, 4659, 4857
SetBit, 4649, 4724, 4858, 4895, 5954
SetBitInTag, 4650, 4725, 4859, 4896, 5955
SetBitWhileKeyPressed, 4651
SetBrightness, 4653, 4860
SetConnectionMode, 4661, 4861
SetDataRecordTagsToPLC, 4644, 4862
SetDataRecordToPLC, 4643, 4863
SetDaylightSavingTime, 4658, 4864
SetDeviceMode, 4648, 4865
SetDisplayMode, 4647, 4865
SetLanguage, 4658, 4866
SetPropertyByConstant, 4730, 4898, 5963
SetPropertyByProperty, 4729, 4899, 5965
SetPropertyByTag, 4732, 4901, 5966
SetPropertyByTagIndirect, 4734, 4902, 5968
SetPropertyCurrentWindow, 4727
SetPropertyCurrentWindowByProperty, 4728
SetPropertyCurrentWindowByTagIndirect, 4728
SetRecipeTags, 4656, 4867

SetScreenKeyboardMode, 4654, 4869
SetTag, 4660, 4735, 4869, 4904, 5985
SetTagByProperty, 4736, 4905, 5986
SetTagIndirect, 4739, 4907, 5988
SetTagIndirectByProperty, 4737, 4740, 4906, 
4908, 5987, 5989
SetTagIndirectByTagIndirect, 4742, 4909, 5990
SetTagIndirectWithOperatorInputAlarm, 4743, 
4910, 5991
SetTagToHandWheel , 4682
SetTagWithOperatorInputAlarm, 4738, 4911, 
5992
SetWebAccess, 4663
ShowAlarmWindow, 4687, 4872
ShowLogonDialog, 4685, 4746, 4912
ShowOperatorNotes, 4686, 4873
ShowSoftwareVersion, 4687, 4874
ShowSystemAlarm, 4689, 4875
ShowSystemDiagnosticsWindow, 4688, 4875
SimulateSystemKey, 4664
SimulateTag, 4665
SmartClientViewConnect, 4668
SmartClientViewDisconnect, 4667
SmartClientViewLeave, 4668
SmartClientViewReadOnlyOff, 4666
SmartClientViewReadOnlyOn, 4667
SmartClientViewRefresh, 4666
StartLogging, 4670, 4876
StartNextLog, 4671, 4876
StartProgram, 4671, 4877
StatusForceGetValues, 4673
StatusForceSetValues, 4673
StopLogging, 4675, 4878
StopRuntime, 4676, 4745, 4880, 4913, 5994
SystemDiagnosticsViewBack, 4679
SystemDiagnosticsViewDetailView, 4678
SystemDiagnosticsViewDeviceView, 4679
SystemDiagnosticsViewDiagnosticsBuffer, 4678
SystemDiagnosticsViewRefreshPLCBuffer, 4678
TraceUserChange, 4682
TrendViewBackToBeginning, 4607
TrendViewCompress, 4604
TrendViewExtend, 4604
TrendViewRulerLeft, 4606
TrendViewRulerRight, 4605
TrendViewScrollBack, 4604
TrendViewScrollForward, 4603
TrendViewSetRulerMode, 4606
TrendViewStartStop, 4607
UpdateTag, 4570

System limits
HMI device, 7187, 7190, 7194, 7198, 7202, 7205
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System log, 721, 724
System memory, 1087, 1108

Diagnostics buffer, 1077, 1245
Operand areas, 1074
process image input/output, 1076

System power supply, 1180
System print job

Changing, 4327
Deleting, 4328

System report
Changing, 4327
Deleting, 4328

System requirements STEP 7 Basic, 110
System response, 7478
System status, 3984, 4121
System texts, 367
System Time

NTP Client, 895
PTP Client, 897
SNTP Client, 894

System-defined controller alarm, 3896
System-defined controller alarms, 3891, 3893
System-defined role

Administrator, 656
diagnostics, 656
Remote access, 656
standard, 656

System-defined text lists
Editing, 437
Modifying texts, 438

SystemDiagnoseView object, 5137
SystemDiagnoseWindow object, 5141
SystemDiagnosticsViewBack, 4679
SystemDiagnosticsViewDetailView, 4678
SystemDiagnosticsViewDeviceView, 4679
SystemDiagnosticsViewDiagnosticsBuffer, 4678
SystemDiagnosticsViewRefreshPLCBuffer, 4678
System-relevant information

Module information, 1211
Vendor information, 1211

T
T piece, 3635

Rotation, 3635
T_ADD, 2623
T_COMBINE, 2626
T_COMP, 2622
T_CONFIG, 51, 3278
T_CONV, 2623
T_DIAG, 3273
T_DIFF, 2625

T_RESET, 3272
T_SUB, 2624
TAB key, 7088
Table

 Table view, (See table view)
Configuring table elements, 3852, 3865
Connection, 6147

Table column
Configuring the sorting, 3854, 3866

Table view, 3631, 3829
 Configuring the export of Runtime data, 3845, 
3858, 3866
 Online configuration, 3846, 3859, 3867
 Status bar, 3844, 3857, 3863
 Toolbar, 3836
Buttons, 3869
Changing the data connection in Runtime, 3879
Changing the time range in Runtime, 3880
Configuring, 3849
Configuring a data source, 3631
Configuring selection, 3853
Configuring the data source, 3842, 3855
Configuring the value column, 3851
Editing the table field in Runtime, 3881
Elements of the status bar, 3885
Hide column in Runtime, 3879
Hide columns in Runtime, 3882
Move columns in Runtime, 3882
Online configuration, 3882
Opening the configuration dialog in Runtime, 
3879
operation in Runtime, 3869, 3871
Scrolling through archived data, 3884
Show column in Runtime, 3879
Show columns in Runtime, 3882
Toolbar, 3632, 3869

Table:Designing a border, 3364
TableBackColor property (VBS), 5595
TableColor property (VBS), 5596
TableColor2 property (VBS), 5596
TableFocusOnButtonCommand property (VBS), 
5597
TableForeColor property (VBS), 5597, 5598
TableForeColor2 property (VBS), 5599
TableGridLineColor property (VBS), 5599, 5600
TableHeaderBackColor property (VBS), 5600
TableHeaderForeColor property (VBS), 5601
Tables

in reports, 4309
TableView object, 5075
Tag, 3778

absolute addressing, 3680, 6159
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Access in user-defined function, 4445
Access the local script, 4445
Acquisition cycle, 3714, 3715, 3736
Acquisition mode, 3714
Addressing, 3685
Changing the PLC, 3702
Coding, 3743
Comment, 3687
Configuration, 3693
Configuring several tags, 3693
Connection to PLC, 3685
Copy, 3692
Creating external tags, 3685
Creating internal tags, 3687
Creating the user data type, 3730
Data log, 3760, 3766
Data type, 3687, 3689
Defining a substitute value, 3716
Defining acquisition cycle, 3718
Deleting, 3692
Displaying or hiding tag information, 1549, 1590, 
1618
Displaying values, 3818
Event, 3713
Exporting, 6850
external, 3778
External tag, 3677, 3678, 6157
Faceplate type, 3503
GMP settings, 7254
GMP-relevant tag, 7254
Handwheel, 3555
Illuminated pushbutton, 3572
Importing, 6852
in Runtime, 3714
Index tag, 3712
Indirect addressing, 3712, 3719, 3720
internal, 3778
Internal tag, 3683, 6161
Key switch , 3611
Length, 3687
Limit value, 3699
Limit values, 3699
Linear scaling, 3703, 3704
Local, 4447
Logging, 3760, 3766
Logging cycle, 3736, 3738
Maximum length, 83
Multiplexing, 3712
Name, 3687
Negative, 1877, 2154
Object list, 3686
Output in alarm, 3928

Overlaying, 1309
Overview, 1295
PLC tag, 1421
PLC tags and DB tags, 1295
Positive, 1876, 2153
R, 7644
Raw data tag, 3778
Read continuously, 3715
Reconnecting, 3697
Rename, 3692
RFID tag, 6061
Start value, 3701
symbolic addressing, 3681, 6160
Tag type, 3689
Tolerance band, 3760, 3766
Transponder, 6061
Update, 3715
User data type, 3729
User data type element, 3729
Value range, 3743

Tag array, 3722, 3726
Tag binding

Animation, 3434
Tag data

Structure for the import, 6853, 6855, 6860
Tag declaration

Automatically filling in cells, 1443, 1513, 1660, 
1675
Based on a PLC data type, 1649
Block interface, 1491
Declaring ARRAY, 1499
Declaring PLC data type, 1501
Declaring STRUCT, 1500
Declaring tags, 1497, 1498, 1502
Deleting a tag, 1442, 1512, 1659, 1674
Importing and exporting tags, 1513, 1661
Inserting a table row, 1440, 1511, 1658, 1674
Inserting table rows at the end, 1512, 1659, 1674
Multi-instance, 1503
Overlaying tags, 1502
Purpose of tag declaration, 1491
Reserved key words, 1289
Retentivity, 1507
Showing and hiding columns , 1443, 1513, 1661, 
1675
Sorting rows, 1442
Tag properties, 1506, 1508, 1654, 1656, 1657
Updating the block interface, 1503
Valid data types, 1494, 1496

Tag import
Tag data structure, 6853, 6860
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Tag list
Indirect addressing, 3712

Tag log
Migrating, 194

Tag name
Valid names in logs, 3763, 3796

Tag object, 4975
Tag simulator, 6998
Tag table

Default, 3675, 6156
for HMI devices, 3675, 6156
user-defined, 3675, 6156

Tag triggers, 6095, 6109
Tag type, 3689
Tag value

Output, 3818, 3824
Updating, 3679

Tags, 4978, 4979
Addressing, 6264
Alarm group, 3908
Basics, 3674, 6155
Data exchange, 6124
Migrate, 228
Migration, 201, 253
Monitor all, 1788, 1813
Monitor now, 1814
Monitor once and now, 1789

Tags object (list), 4979
Tan, 2477
TAN, 1987, 2268
tan function, 6043
Tangent, 1987, 2268, 2477
tanh function, 6043
Task, 6091

Changing during Runtime, 6114
Changing the name, 6105
Creating for the automatic start of a print job, 
4325
Deactivate, 6094, 6095
Deleting, 6106

Task card, 3303
Changing the pane mode, 323
Function, 321
Hardware catalog, 515, 6140
Reducing automatically, 314

Task Card
Online Tools, 1211
Toolbox, 3333
Tools, 3336, 3339

TCI (Tool Calling Interface), 1048
TCON, 3240, 3243
TCON_IP_RFC, 609

TCON_IP_v4, 608
TCON_Param, 605
TCP, 667

Characteristics, 604
Port numbers, 610

TCP/IP
Parameters, 6274, 6361

TDISCON, 3248
Teach-in mode, 4170

Recipe tag, 4170
Team Engineering

Creating a master project, 8003
Example of the program structure in the master 
project, 8010
Integrating project copies into the master project 
once again, 8005
Introduction to shared commissioning, 8003
Notes on compatibility, 8005
Procedure for creating the master project, 8007
Procedure for integrating project copies into the 
master project, 8008
Procedure for manual synchronization of 
competing changes, 8008
Procedure for modifying central objects within the 
master project, 8009
Procedure for shared commissioning, 8007
Requirements for shared, parallel working on the 
project, 8006
Rules for downloading to the CPU, 8012
Rules for editing shared central objects, 8012
Rules for online functions, 8013
Rules for shared working on one CPU, 8011
Rules for the master project, 8010
Software and hardware requirements, 8005
Working with project copies, 8004

Technology object command table: Shortcut menu 
commands, 7856
Technology objects

PID_3Step, 7766
PID_Compact, 7735

Telecontrol server, 819
TELECONTROL SERVER BASIC, 819
Telegram tag, 3778
Telemecanique Uni-Telway

Migrating data types, 214
TeleService

 Meaning of the icons, 8093
 Phone book properties, 8091
Access to phone books, 8092
AS_DIAL, 8139
Callback variants, 8105
Communications instruction:"AS_DIAL", 8090
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Communications instruction:"AS_MAIL", 8091
Communications instruction:"PG_DIAL", 8090
Communications instruction:"SMS_SEND", 8091
Communications instruction:"TM_MAIL", 8091
Communications instruction:"TMAIL_C", 8091
Connection establishment options:S7-1200 
CPUs, 8137
Connection establishment options:S7-1500 
CPUs, 8137
Connection establishment options:S7-300/400 
CPUs, 8137
Defining dialing rules, 8098
Establish connection to AS, 8139
Export phone book, 8097
Functionality, 8090
Gateways, 8102
Import phone book, 8095
Inserting rows in the phone book, 8094
Modem support, 8101
Modem types / media, 8102
Open phone book, 8094
Performance in telephone networks, 8102
Phone book, 8091
Printing the phone book, 8098
Save phone book, 8095
Showing or hiding columns in the phone book, 
8095
Structure of the phone book, 8093
Transferring e-mail with TM_MAIL, 3290
Working with the phone book, 8092

TeleService callback options, 8107
TeleService phone book, 8091
TeleService via GPRS, 823

Establish connection, 824
Temperature coefficient, 1164, 1183
Temperature compensation, 1151
template

Template, 3317
Template, 3456

Copy, 3317
Creating, 3315
Deleting, 3317
Global screen, 3315
Inserting, 3317
Move, 3317
Rename, 3317
Use in screen, 3319

temporary, 820
Temporary connection, 820
Temporary station, 820
Tens complement, 2129, 2414, 2620
Terminal modules and electronic modules, 1148

Terminal service, 7502
Terminal services, 7542

activate, 7543
Creating users, 7544
WebNavigator Client, 7542

Terminating the remote connection, 8123
Test form

Creating, 7617
Test options in the force table, 1798
testing, 7617

Customer controls, 7617
Testing, 4482

User-defined function, 4448
with debugger, 4482

Text
Button, 3608
Define text format, 3586
Editable text field, 3537
Text field, 3634, 4374

Text field, 3634, 4373
Size, 3634, 4374

Text list
Application, 3396
Bit (0, 1), 3402
Bit number  (0 - 31), 3403
Creating, 3397
Exporting, 6857
Importing, 6859
Output in alarm, 3930
Range (... - ...), 3401
Symbolic I/O field, 3404, 3405, 3622, 3623
Value/Range, 3399

Text lists
Introduction, 435
System-defined, 435
Use in recipe data records, 4175
User-defined, 435

Text property (VBS), 5605
TextField object, 5144
TextList property (VBS), 5606
TextOff property (VBS), 5606, 5607
TextOn property (VBS), 5607, 5608
TextOrientation property (VBS), 5608
Texts

Migrating, 191
TFTP

Load/save, 881
THEN, 2556
Third-party drivers

Communication, 6625
Special features, 6626

THIS, 1303

Index

WinCC Professional V13.0
System Manual, 02/2014 8299



ThumbBackColor property (VBS), 5609, 5610, 5611
TIA Portal

Exiting, 299
Starting, 299

TicksColor property (VBS), 5610
Time, 874, 1087, 1339, 1341
TIME, 1341, 1384, 1409
Time accumulator, 1885, 2162, 2170, 2427
Time axis

Configuring, 3839
Time base

Setting, 3586
Time base for time display

Runtime settings, 7075
Time base for time display in Runtime

Setting, 7075
Time column property changed, 4779
Time delay, 2084, 2368, 2582
Time delay interrupt, 1121
Time duration, 1896, 2174, 2431
Time error interrupt, 1124
Time error OB, 1124
Time expired, 4799
time function, 6048
time functions

asctime function, 6048
ctime function, 6048
difftime function, 6048
gmtime function, 6048
localtime function, 6048
mktime function, 6048
strftime function, 6048
time function, 6048

Time of day
Precision Time Protocol, 897
Setting the time of day in the Online and 
Diagnostics view, 1230
SNTP (Simple Network Time Protocol), 894
System Time, 891
Time-of-day synchronization, 894

Time range, 3833
Dynamic, 3833
static, 3833

Time stamp, 3911
Time stamping, 1152
Time synchronization, 695, 1087, 6278, 6363, 7485

Configuring, 6279, 6280
integrated connection, 6279
Non-integrated connection, 6280, 6365
Restriction, 6278, 6364
System limits, 6278, 6364

Time synchronization in Runtime
Activating, 7072
Runtime settings, 7072

Time synchronization of the PLC, 7072
TIME_TCK, 2635
TIME_TO_, 1409
TimeAxisBeginTime(i) property (VBS), 5612
TimeAxisEndTime property (VBS), 5612
TimeAxisLabel(i) property (VBS), 5613
TimeAxisRange property (VBS), 5613
TimeAxisShowGridLines(i) property (VBS), 5614
TimeAxisShowLargeIncrements(i) property (VBS), 
5615
TimeAxisShowSmallIncrements(i) property (VBS), 
5615
TimeAxisTimeFormat(i) property (VBS), 5616
TimeBase property (VBS), 5617
TimeColumnActualize property (VBS), 5618, 5624, 
5632
TimeColumnAdd property (VBS), 5618
TimeColumnAlign property (VBS), 5618
TimeColumnAlignment(i) property (VBS), 5619
TimeColumnBackColor property (VBS), 5620
TimeColumnBeginTime property (VBS), 5620
TimeColumnCaption property (VBS), 5621
TimeColumnCount property (VBS), 5621
TimeColumnDateFormat property (VBS), 5621
TimeColumnEndTime property (VBS), 5622
TimeColumnForeColor property (VBS), 5622
TimeColumnFormat(i) property (VBS), 5623
TimeColumnHideTitleText property (VBS), 5624
TimeColumnIndex property (VBS), 5625
TimeColumnLength property (VBS), 5625
TimeColumnMeasurePoints property (VBS), 5625
TimeColumnName property (VBS), 5626
TimeColumnRangeType property (VBS), 5626
TimeColumnRemove property (VBS), 5627
TimeColumnRename property (VBS), 5627
TimeColumnRepos property (VBS), 5628
TimeColumnShowDate property (VBS), 5628
TimeColumnShowIcon property (VBS), 5629
TimeColumnShowTitleIcon property (VBS), 5629
TimeColumnSort property (VBS), 5630
TimeColumnSortIndex property (VBS), 5630
TimeColumnTimeFormat property (VBS), 5631
TimeColumnTimeRangeBase property (VBS), 5631
TimeColumnTimeRangeFactor property (VBS), 5632
TimeColumnVisible property (VBS), 5633
Time-delay interrupt

Canceling with CAN_DINT, 2824
Instructions, 2821
Querying with QRY_DINT, 2824
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Starting with SRT_DINT, 2823
Time-delay interrupt OB, 1121
Time-driven output

Report, 4319
TimeJumpColor(i) property (VBS), 5633
TimeJumpEnabled(i) property (VBS), 5634
Time-of-day, 1343, 1344, 1345

Calculating local time with SET_TIMEZONE, 
2632
Reading the system time of the CPU with 
TIME_TCK, 2635
Reading time-of-day and date of CPU with 
RD_SYS_T, 2628
Setting for CPU with WR_SYS_T, 2627

Time-of-day function
Basics, 1094
Clock parameters, 1095
Reading the time-of-day, 1094
Setting the time-of-day, 1094
Time-of-day format, 1094

Time-of-day interrupt
Activating with ACT_TINT, 2819
Cancel, 1117
Canceling with CAN_TINT, 2818
Function, 1117
Querying with QRY_TINT, 2820
Rules, 1117
Set and activate, 1117
Setting with SET_TINT, 2813, 2816
Status query, 1117

Time-of-day interrupt OB
Parameter assignment, 1130

Timeout
HTTP protocol, 6588

TimeOverlapColor(i) property (VBS), 5634
TimeOverlapEnabled(i) property (VBS), 5635
Timer, 1341, 1898, 2175, 6095

Acyclic triggers, 6095
Cyclic triggers, 6095, 6106
Recording, 1893

TIMER, 1363
TimeRangeBase(i) property (VBS), 5635
TimeRangeFactor(i) property (VBS), 5636
Timers

Adding with the instruction T_ADD, 2623
Combine date and time with T_COMBINE, 2626
Comparing time tags with T_COMP, 2622
Converting with T_CONV, 2623
Determining difference with T_DIFF, 2625
Subtracting with T_SUB, 2624

TIMESTEP, 7644

Time-triggered trends, 6253, 6337, 6433, 6527, 6539, 
6670, 6704, 6738, 6758
Title page

in reports, 4305
Report, 4295, 4298

TitleColor property (VBS), 5638
TitleDarkShadowColor property (VBS), 5639
TitleForeColor property (VBS), 5639
TitleGridLineColor property (VBS), 5640
TitleLightShadowColor property (VBS), 5640
TitleSort property (VBS), 5640
TitleStyle property (VBS), 5641
TM_MAIL, 3290
TMAIL_C, 3230
tmpfile function, 6045
tmpnam function, 6045
TO, 2560
TO_PositioningAxis, 7825
TOD, 1343, 1385, 1411
TOD_TO_, 1411
TOF, 1883, 1891, 2160, 2168, 2424
Toggle, 4795

Between Runtime languages, 6900
Key, 7089

Toggle property (VBS), 5642
Toggle toolbar, 4792
Tolerance band

Tags, 3760, 3766
Tolerance property (VBS), 5642
ToleranceColor property (VBS), 5643
ToleranceLowerLimit property (VBS), 5644
ToleranceLowerLimitColor property (VBS), 5644
ToleranceLowerLimitEnabled property (VBS), 5645
ToleranceLowerLimitRelative property (VBS), 5645
ToleranceUpperLimit property (VBS), 5646
ToleranceUpperLimitColor property (VBS), 5646
ToleranceUpperLimitEnabled property (VBS), 5647
ToleranceUpperLimitRelative property (VBS), 5648
tolower function, 6042
TON, 1881, 1889, 2158, 2166, 2421
TONR, 1885, 1893, 2162, 2170, 2427
Tool Calling Interface (TCI), 1048
Toolbar, 3543, 3546, 3549, 3632, 3844, 3857, 3863

 Table view, 3836
Button with screen change:, 3671
Configuring a system function, 3671
Configuring an event, 3667
Creating, 3661
customized, 3655, 3665
Order, 3342, 3352, 4335
Recipe view, 4270, 7147

Toolbar button property changed, 4777
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ToolbarAlignment property (VBS), 5648
ToolbarBackColor property (VBS), 5649
ToolbarButtonActive property (VBS), 5649
ToolbarButtonAdd property (VBS), 5650
ToolbarButtonBeginGroup property (VBS), 5650
ToolbarButtonCount property (VBS), 5651
ToolbarButtonEnabled property (VBS), 5651
ToolbarButtonHotKey property (VBS), 5652
ToolbarButtonID property (VBS), 5652
ToolbarButtonIndex property (VBS), 5652
ToolbarButtonLocked property (VBS), 5653
ToolbarButtonName property (VBS), 5653
ToolbarButtonPasswordLevel property (VBS), 5654
ToolbarButtonRemove property (VBS), 5654
ToolbarButtonRename property (VBS), 5654
ToolbarButtonRepos property (VBS), 5655
ToolbarButtonTooltipText property (VBS), 5655, 
5672, 5679
ToolbarButtonUserDefined property (VBS), 5656, 
5675
ToolbarShowTooltips property (VBS), 5656
ToolbarUseBackColor property (VBS), 5657
ToolbarUseHotKeys property (VBS), 5658
ToolbarVisible property (VBS), 5658, 5659
Toolbox, 3333
Tools, 3336, 3339

for the design of reports, 4308
ToolTipText property (VBS), 5659
Top property (VBS), 5661
Topology discovery, 1042, 6222, 6303, 6388
Topology editor, 562
Topology view

Adding device, 531
Adopt devices identified online, 642
Adopt port interconnections identified online, 641
Configured topology, 628, 629
Diagnostics status in the graphic view, 631
Diagnostics status in the table view, 631
Differences compared with the network view, 627
Functions, 626
Hardware and network editor, 508, 6136
Interconnecting ports, 634
Offline/online comparison, 632

Total property (VBS), 5664
toupper function, 6042
TP, 1878, 1887, 2155, 2164, 2419
TP 177B mono

Symbol library, 3620
TP177A

Loading a project, 81
Trace, 8051

Bit track, 8056

CPU load, 8078
Curve diagram, 8056, 8075
Data storage, 8053
Installed traces, 8061
Lifetime of the values, 8077
Measurement, 8053, 8063, 8073
Measurement cursor, 8075
Pre-trigger, 8084
Printing, 8076
Project navigator, 8056
Quantity structure, 8078
Quick start, 8064
Recordable tags, 8076
Recording, 8053, 8072
Recording conditions, 8081, 8082, 8084
Recording cycle, 8066, 8088
Recording duration, 8088
Recording levels, 8077
Reduction, 8082
Sampling, 8066
Saving the trace configuration, 8071
Signal table, 8058, 8075
Signals, 8080, 8087
Supported devices, 8051
Trace configuration, 8053, 8061, 8070, 8071, 
8074, 8087
Trace editor, 8070
Trace handling, 8060
Trigger, 8089
Trigger mode, 8083
Trigger tag, 8081, 8083
Trigger time, 8063
User interface, 8054, 8079

Trace function, 8051
Trace methods, 5885
Trace S7-1200/1500, 8076
TraceUserChange, 4682
Transfer

 License key to HMI device, 7032
Transfer card, 1071
Transfer card; see Transfer card, 1071
Transfer to the HMI device

WinAC MP, 6799
Transferring

Recipe data record, 7136, 7137, 7144
Transferring authorization

HMI device, 6802
Transferring data

Area pointer, 6162, 6238, 6321, 6419, 6513, 
6763
Area pointer screen number, 6238, 6326, 6419, 
6513, 6765
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Control panel, 6788, 6789
Coordination area pointer, 6242, 6325, 6422, 
6516, 6768
Data record are pointer, 6772
Data record area pointer, 6246, 6330, 6427, 6520
Date/time area pointer, 6239, 6321, 6323, 6420, 
6514, 6766
Date/time PLC area pointer, 6240, 6421, 6515, 
6767
Job mailbox, 6250, 6334, 6430, 6522, 6775
Job mailbox area pointer, 6244, 6328, 6424, 6518, 
6769
Operator input in the recipe view, 6249, 6333, 
6429, 6521, 6774
Possible cause of error, 6252, 6336, 6432, 6524, 
6777
Project ID area pointer, 6243, 6327, 6423, 6517, 
6769
Triggering by means of a configured function, 
6251, 6336, 6432, 6523, 6777
With synchronization, 6247, 6332, 6428, 6526, 
6773
Without synchronization, 6247, 6331, 6427, 6525, 
6772

Transferring recipe values
between HMI device and PLC, 4255

Transferring the project
HMI device, 91
Recipe data record, 91

Translate
Editor, 6888

Translating texts, 366
Transmission medium/duplex, 1039
Transmission rate / duplex, 6220, 6301, 6386
Transparency

In graphic, 3375
transparent color, 3551

Display on panels, 3551
TransparentColor property (VBS), 5666
TransparentColorDeactivatedPicture property (VBS), 
5667
TransparentColorPictureOff property (VBS), 5667
TransparentColorPictureOn property (VBS), 5668
Transponder, 6061, 6062
TRCV, 3256, 3260
TRCV_C, 51, 3218, 3223
Trend, 3820

Common axes, 3835
Configuring, 3842
Data type, 6672, 6759
Multiple axes, 3834
Representation formats, 3832

Text orientation, 3833
Trend curve, 3833

Trend control, 6740
Trend display

Resolution, 3829
Trend property changed, 4776
Trend request

Trend transfer, 6254, 6338, 6434, 6528, 6540, 
6670, 6705, 6739, 6758

Trend request area, 6254, 6338, 6434, 6528, 6540, 
6670, 6705, 6739, 6758
Trend transfer area, 6254, 6338, 6434, 6528, 6540, 
6670, 6705, 6739, 6758
Trend transfer area 1

Trend transfer area 2, 6254, 6338, 6434, 6528, 
6540, 6670, 6705, 6739, 6758

Trend view, 3568, 3820, 3830, 3831
Button, 3569
Buttons, 3869
Changing the order of trends, 3876
Configure trend, 3842
Configuring, 3837
Configuring for logging, 3826
Configuring for values from the PLC, 3818, 3825
Configuring the data source, 3842, 3855
Configuring the export of Runtime data, 3845, 
3858, 3866
Configuring the value axis, 3840
Configuring the X axis, 3840
Configuring the Y axis, 3840
Configuring time axis, 3839
Elements of the status bar, 3885
Moving a trend area in Runtime, 3875
Number of trends, 3829
Online configuration, 3882
operation in Runtime, 3869, 3871
Range proportion, 3841
Representation formats, 3832
Resolution of Trend Display, 3829
Scrolling through archived data, 3884
Status bar, 3844, 3857, 3863
Subdivision, 3840
Text orientation, 3833
Toolbar, 3869
Trend curve, 3833
Trend in the foreground, 3876
Zooming in on ~  area in Runtime, 3874
Zooming in on a trends in Runtime, 3874
Zooming in on the time axis in Runtime, 3875
Zooming in on the value axis in runtime, 3875
Zooming out on a trend in Runtime, 3874

TrendActualize property (VBS), 5668
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TrendBeginTime property (VBS), 5669
TrendCount property (VBS), 5670
TrendEndTime property (VBS), 5670
TrendExtendedColorSet property (VBS), 5670
TrendFill property (VBS), 5671
TrendIndicatorColor property (VBS), 5672
TrendLineStyle property (VBS), 5673
TrendLineType property (VBS), 5674
TrendLowerLimit property (VBS), 5675
TrendLowerLimitColor property (VBS), 5675
TrendName property (VBS), 5676
TrendPointStyle property (VBS), 5677
TrendProvider property (VBS), 5678
TrendRangeType property (VBS), 5678
TrendRulerControl, 5147
Trends

in reports, 4309
Trends and alarms, (See Trends and Alarms)
Trends and Alarms, 7271

Alarm Table, 7336
Analysis function, 7340, 7341
Display Alarms, 7336
Hit List of Alarms, 7340
Message Column Names, 7338

TrendSelectTagNameX property (VBS), 5680
TrendSelectTagNameY property (VBS), 5680
TrendTag property (VBS), 5681
TrendTagNameX property (VBS), 5681
TrendTagNameY property (VBS), 5682
TrendTimeRangeBase property (VBS), 5682
TrendTimeRangeFactor property (VBS), 5683
TrendUncertainColor property (VBS), 5683
TrendUncertainColoring property (VBS), 5684
TrendUpperLimit property (VBS), 5684
TrendUpperLimitColoring property (VBS), 5685
TrendView object, 5155
TrendViewBackToBeginning, 4607
TrendViewCompress, 4604
TrendViewExtend, 4604
TrendViewRulerLeft, 4606
TrendViewRulerRight, 4605
TrendViewScrollBack, 4604
TrendViewScrollForward, 4603
TrendViewSetRulerMode, 4606
TrendViewStartStop, 4607
TrendWindowCoarseGrid property (VBS), 5686
TrendWindowFineGrid property (VBS), 5687
TrendWindowForegroundTrendGrid property (VBS), 
5688
TrendWindowGridInTrendColor property (VBS), 
5688
TrendWindowHorizontalGrid property (VBS), 5689

TrendWindowIndex property (VBS), 5690
TrendWindowRename property (VBS), 5690
TrendWindowRulerStyle property (VBS), 5692
TrendWindowVerticalGrid property (VBS), 5693
Trigger mode, 3782
Trigger tag, 3911
Trigger user alarm

Configuring, 3951
Triggering by means of a configured function

Transferring data, 6251, 6336, 6432, 6523, 6777
Triggering user alarm

Example, 3951
TriggerOperatorEvent, 5996
Triggers, 6093

Acyclic, 6094, 6101, 6109
Changing, 6106
Cyclic, 6094, 6102, 6110, 6113, 6116
Event trigger, 6093, 6095, 6104, 6112
Standard cycle, 6094
Tag triggers, 6095, 6109

TRUE, 2416, 2417
TRUNC, 2051, 2334, 2542
TS adapter, 90
TS Adapter IE Advanced

Brief description, 8132
Connection types, 8133
Parameter assignment, 8135
Parameter assignment options, 8134

TS Adapter MPI
Brief description, 8109
Default parameter assignment, 8110
Direct connection, 8110
Establishing a modem connection, 8111
Establishing the direct connection, 8110
Exporting adapter parameters, 8115
Importing adapter parameters, 8116
Modem connection, 8111
parameter Assignment, 8113
Parameter assignment , 8113
Parameter assignment options, 8112
Principle of operation, 8109
Restoring the default parameter assignments, 
8114
Setting up access protection, 8106

TS Adapter IE
Brief description, 8116
Default parameter assignment, 8118
Parameter assignment, 8121, 8135
Principle of operation, 8117

TS Adapter IE Basic
Connection to the GSM network, 8119
Connection to the telephone network, 8119
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Connection to the telephone network through an 
external modem, 8120
Connection types, 8118

TSAP
ASCII code table, 614
Structure, 578, 613

TSAP assignment
Examples, 615

TSEND, 3250, 3253
TSEND_C, 3207, 3211
TubeArcObject, 5158
TubeDoubleTeeObject, 5160
TubePolyline, 5162
TubeTeeObject, 5165
TURCV, 3269
TUSEND, 3266
Two-hand operation

Multi-touch devices, 96
Twos complement, 1970, 2249
Type

Library, 6809
Type property (VBS), 5695
TypeOf, 2460
TypeOfElements, 2461
Types of DP slave, 1002

U
uaAddArchive, 5997
uaAddField, 5998
uaArchiveClose, 5999
uaArchiveDelete, 5999
uaArchiveExport, 6000
uaArchiveGetCount, 6001
uaArchiveGetFieldLength, 6002
uaArchiveGetFieldName, 6002
uaArchiveGetFields, 6003
uaArchiveGetFieldType, 6003
uaArchiveGetFieldValueDate, 6004
uaArchiveGetFieldValueDouble, 6005
uaArchiveGetFieldValueFloat, 6006
uaArchiveGetFieldValueLong, 6007
uaArchiveGetFieldValueString, 6007
uaArchiveGetFilter, 6008
uaArchiveGetID, 6009
uaArchiveGetName, 6009
uaArchiveGetSort, 6010
uaArchiveImport, 6011
uaArchiveInsert, 6012
uaArchiveMoveFirst, 6012
uaArchiveMoveLast, 6013
uaArchiveMoveNext, 6014

uaArchiveMovePrevious, 6014
uaArchiveOpen, 6015
uaArchiveReadTagValues, 6016
uaArchiveReadTagValuesByName, 6017
uaArchiveRequery, 6018
uaArchiveSetFieldValueDate, 6018
uaArchiveSetFieldValueDouble, 6019
uaArchiveSetFieldValueFloat, 6020
uaArchiveSetFieldValueLong, 6021
uaArchiveSetFieldValueString, 6022
uaArchiveSetFilter, 6023
uaArchiveSetSort, 6023
uaArchiveUpdate, 6024
uaArchiveWriteTagValues, 6025
uaArchiveWriteTagValuesByName, 6026
uaConnect, 6026
uaDisconnect, 6027
uaGetArchive, 6028
uaGetField, 6028
uaGetLastError, 6029
uaGetLastHResult, 6031
uaGetNumArchives, 6031
uaGetNumFields, 6032
uaQueryArchive, 6033
uaQueryArchiveByName, 6034
UaQueryConfiguration, 6035
uaReleaseArchive, 6035
uaReleaseConfiguration, 6036
uaRemoveAllArchives, 6037
uaRemoveAllFields, 6037
uaRemoveArchive, 6038
uaRemoveField, 6039
UART data transmission, 1099
uaSetArchive, 6040
uaSetField, 6040
UBLKMOV, 2041, 2323, 2531
UDINT, 1332, 1381, 1405
UDINT_TO_, 1405
UDP, 667, 673, 694

Characteristics, 605
Port numbers, 610

UDT, 48, 274, 284
UFILL_BLK, 2020, 2302, 2496
UINT, 1331, 1379, 1401
UINT_TO_, 1401
ULINT, 1335
UMOVE_BLK, 2016, 2297, 2493
UncertainStateColor(i) property (VBS), 5697
UncertainStateEnabled(i) property (VBS), 5697
Underflow, 1166, 1174
Undoing actions

Basics of undoing, 428
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Undoing last action, 431
Undoing multiple actions, 431

ungetc function, 6046
UnhideAlarm, 5885
Uninstalling

Option, 7034
Uninstalling license keys, 108
Uniqueness

of object names, 167
UnitColor property (VBS), 5698
UnitText property (VBS), 5699
UnitTop property (VBS), 5700
Universal

PROFIBUS, 6235, 6318, 6403
Universal Serial Interface Protocol, (See USS 
protocol)
Universal symbolism, 273
Unknown peers, 707
Unlock

Operator control, 97
User, 4408

UnlockAlarm, 5886
Unplugged module, 528
Unscale, 2059, 2343, 2554
UNSCALE, 2059, 2343, 2554
Unspecified CPU, 532
UNTIL, 2564
UPDAT_PI, 2667
UPDAT_PO, 2669
Update, 1120

Operating system of the HMI device (Windows 
CE), 7030
Tag, 3715

Update cycle, 3736
Update interrupt, 1120
Update interrupt OB, 1120
Update time, 1037
UpdateEnable property (VBS), 5701
UpdateTag, 4570
Updating

Device proxy, 6869, 6874
Faceplate type, 3496
IPE data, 6869, 6874
Tag, 3679

Updating a library, 493, 6818
Updating the device version, 7029
Updating the firmware, 7029
Updating the operating system, 7029
Updating types to the latest version, 493, 6818
Upgrade

Global library, 6963
Project, 6962

Project version, 6962
Upgrading a global library, 458
Upload, 1051
UpperLimit property (VBS), 5701
UpperLimitColor(i) property (VBS), 5702
UpperLimitEnabled(i) property (VBS), 5702
UpperLimitValue(i) property (VBS), 5703
URCV, 3201
URL, 3560

OPC UA Server, 7595
OPC XML DA Server, 7567

USB
Download, 6988
Loading, 6989, 6990

USB card readers, 40
USB driver, 6989, 6990

Installation under Windows 7, 6990
Installation under Windows XP, 6989

USB port, 6989, 6990
Use, 4162

Alarm view, 7161
Alarm window, 7161
Faceplate type, 3498
Local script, 4469
Of recipes, 4162
Project-wide alarm class, 3917
Recipe view, 7125
Screen navigation function keys, 3468
simple alarm view, 7163
simple alarm window, 7163
Simple user view, 7100
User view, 7099
User view , 7098

Use global assignment
Function key, 3314

UseAllServers property (VBS), 5704
UseBarBorderConstraints property (VBS), 5704
Used property (VBS), 5717
UsedPercent property (VBS), 5718
UseEffectiveProcessValue property (VBS), 5707
UseEyponentialFormat property (VBS), 5708
UseFlashTransparentColor property (VBS), 5708
Useful information on configuring the TS Adapter 
MPI, 8112
UseGDI property (VBS), 5709
UseMeasurePoints(i) property (VBS), 5709
UseMessageColor property (VBS), 5710
UseMultipleLimits property (VBS), 5710
USEND, 3199
User

Assigning roles, 658
Changing, 4407
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Creating roles, 656
Deleting in runtime, 4407
Dynamic logon, 4393
Logon, 4408
Setting up, 655
Unlock, 4408

User administration, 4374
Central user administration, 4395
exporting, 4411
importing, 4413
Migrate, 249
Migration, 194, 252
Object with access protection, 4415, 4416
Runtime settings, 3311, 3312, 4380, 4381, 4384, 
4393, 4394, 4398, 4399, 4408, 4409
Setting up, 4420
SIMATIC Logon, 4395
WebCenter, 7305

User alarm, 3895
Parameter output , 3950

User archive, 7654, 7660
Displaying data, 7660
Querying archive data, 7654

User change, 4772, 6111
User data

Area, 1078
Backing up, 7098
Restoring, 7098

User data type, 3729
Create, 3729, 3730
Creating a user data type element, 3730
Deleting, 3734
Editing, 3733
Release, 3733
Tags, 3729

User data type element
Create, 3730

User group, 7059, 7097, 7305
Administer authorizations, 4391
Assigning, 4425
Assigning users, 4389
Change displayed name, 4392
Changing in runtime, 4408
Changing the name, 4391
Creating, 4387, 4424
Deleting, 4392
Domain-global user group, 7060
Include project, 7061
Individual groups, 7297
Managing, 4391
SIMATIC HMI, 7059, 7060, 7061
SQLServer2005MSSQLUser, 7059

Unauthorized, 4410
User group 

SIMATIC HMI, 7060
User interface

"Reference projects" palette, 323
Details view, 325
Inspector window, 319
Maximizing the work area, 313
Minimizing the work area, 313
Overview window, 326
Portal view, 303
Project tree, 308
Project view, 305
Task card, 321
Views, 303
Work area, 311

User interface language, 6882
Selecting, 6885
Switching, 7302

User log
 Recipe view, 4279, 7156
Migrate, 241
UserArchiveControl, 4277, 7154

User logs
Migrate, 241

User name, 656
User program

Finding errors, 1633
Function, 1259
Testing, 1763

User text block
Configuring , 3936

User text blocks, 3934
User texts, 367
User view, 4402, 7098

Changing user data, 7099
Columns moveable, 3523
Complex user view, 3522
Complex user view , 4403
Configuring, 4404
Export user data, 7100
Import user data, 7100
Layout, 7099
Number of lines, 3523
Simple user view, 3523
Use, 7098, 7099

UserArchiveControl, 4269, 7146
Configuring, 4274, 7151
Edit data, 4277, 7154
Online configuration, 4254
Runtime data, 4253

UserArchiveControl object, 5167
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UserArchiveNumberOfValues(i) property (VBS), 
5718
UserArchiveStartId(i) property (VBS), 5719
User-defined, 37
User-defined function, 4427, 4432

Adapting display properties, 4442
Changing object property, 4500
Code templates, 4441
configuring in C, 4463
configuring with VBS, 4454
Entering parameters, 4440
Executing in Runtime, 4495
Opening know-how protected functions, 4449
Parameter transfer, 4444
Return value in C, 4468
Return value in VBS, 4458
Sequence is not adhered to, 4498
Synchronizing object, 4442
Synchronizing tag, 4442
Syntax highlighting, 4442
Temperature conversion, 4500
Testing, 4448
Using a system function, 4496

User-defined roles, 657
User-defined text lists

Creating, 436
Editing, 437
Editing value ranges and texts, 437

User-defined web pages, 792, 795, 804, 806, 807
Users, 7097

Admin, 7116
Assigning a user group, 4389
Changing the name, 4390
Changing, key operation, 7112, 7113, 7114
Changing, touch operation, 7110
Create, 4388
Creating, 4425, 7101
Creating in runtime, 4404
Creating, keyboard operation, 7108
Creating, mouse operation, 7107
Creating, touch operation, 7101, 7104, 7106
Delete, keyboard operation, 7117
Delete, mouse operation, 7117
Deleting, 4391, 7116
Logging logons, 4419
Logoff, 7103
Logon, 4410, 7102
Logon, keyboard operation, 7102
Logon, mouse operation, 7102
Managing, 4390, 4406
Updating after change of user, 6111

UserView object, 5174

UseScaleConstraints property (VBS), 5711
UseScaledBarBorder property (VBS), 5711
UseSelectedTitleColor property (VBS), 5712
UseSeparateDiagrams property (VBS), 5712
UseSimplePresicionOffset property (VBS), 5713
UseTableColor2 property (VBS), 5713
UseTimeRange(i) property (VBS), 5714
UseTransparentColor property (VBS), 5715
UseTransparentColorDeactivatedPicture property 
(VBS), 5715
UseTransparentColorPictureOff property (VBS), 
5716
UseTransparentColorPictureOn property (VBS), 
5716
UseTrendNameAsLabel property (VBS), 5717
Using

Local script, 4469
Using a TS Adapter for TeleService, 8100, 8124
Using frames and cover pages from the library, 413
Using tags, 3528
Using the keyboard

Editing texts, 1474
FBD, 1474
GRAPH, 1474
LAD, 1474
Program editor, 1474
SCL, 1474
STL, 1474

Using the on-screen keyboard, 344
Using the recipe in Runtime

Access protection for control tags, 4257
Using UDTs, 284
UsingDesignColorScheme property (VBS), 5705
UsingDesignShadowSettings property (VBS), 5706
USINT, 1329, 1377, 1398
USINT_TO_, 1398
USS communication

Controlling a transmission to a drive with 
USS_PORT, 3130
Data exchange with drives via USS_DRIVE, 3131
Modifying parameters in the drive with 
USS_WPM, 3135
Reading parameters from the drive with 
USS_RPM, 3133

USS protocol
Instructions, 3125

USS status codes, 3136
USS_DRIVE, 3131
USS_PORT, 3130
USS_RPM, 3133
USS_WPM, 3135
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V
VAL_STRG, 2642
Valid

Data type, 6634, 6685, 6699, 6719, 6733, 6753
Data types, 6263, 6349, 6439, 6532, 6601, 6602, 
6603, 6604

Valid data type
Allen-Bradley DF1, 6660
SIMATIC HMI HTTP protocol, 6598

ValidateFormatPattern property (VBS), 5721
Validity range, 4461
Value, 1973, 2253
Value assignment, 1603
Value axis

Configuring, 3840
Value change, 4798
Value changes to GMP-relevant tags

Effects in Runtime, 7256
Value column

Configuring, 3851
Value column property changed, 4778
Value display

 Configuring the export of Runtime data, 3845, 
3858, 3866
 Status bar, 3844, 3857, 3863
 Toolbar, 3844, 3857, 3863

Value range
Tag coding, 3743

Value table, 3861
 Online configuration, 3846, 3859, 3867
Configuring, 3863
Display modes, 3862
Displaying data in the statistics area window, 
3883
Displaying the coordinates of a point, 3877
Operator controls, 3639

Value/Range
Text list, 3399

ValueAxisAutorange(i) property (VBS), 5723
ValueAxisBegin(i) property (VBS), 5723
ValueAxisDecimalPrecision(i) property (VBS), 5724
ValueAxisEnd(i) property (VBS), 5724
ValueAxisGridLineInterval(i) property (VBS), 5725
ValueAxisLabel(i) property (VBS), 5725
ValueAxisLargeIncrementSize(i) property (VBS), 
5726
ValueAxisScalingType(i) property (VBS), 5726
ValueAxisShowGridLines(i) property (VBS), 5727
ValueAxisShowLargeIncrements(i) property (VBS), 
5728

ValueAxisShowSmallIncrements(i) property (VBS), 
5728, 5729
ValueColumnAlignment(i) property (VBS), 5730
ValueColumnPrecision(i) property (VBS), 5730
Values

Comparing, 7715, 7826, 7852
Variable index, 282
VARIANT, 290, 1361, 1953, 1954, 1955, 1957, 2035, 
2036, 2037, 2232, 2233, 2234, 2235, 2317, 2318, 
2319, 2460, 2461, 2525, 2526, 2528, 2547, 2549
VARIANT_TO_DB_ANY, 2547
VariantGet, 2035, 2317, 2525
VariantPut, 2036, 2318, 2526
VBS

Examples in WinCC, 4507
Object model, 4934
Reference, 4934

VBScript
Debugging, 4482

VB-script
Migrating, 189

Vendor ID, 850
Version overview, 1137
Versioning of types

Released version, 473
Version in progress, 472
Version in test, 472

Versions in WinCC, 6958, 6960
Vertical movement

Animation, 3430
Vertical radius, 3538

Ellipse segment, 3540
Elliptical arc, 3538

VerticalAlignment property (VBS), 5731
VerticalGridLines property (VBS), 5732
vfprintf function, 6046
View

Purpose, 4229
View options

For the assignment list, 1738
Setting the call structure, 1747
Setting the dependency structure, 1752

ViewOnly property (VBS), 5733
Views of the cross-reference list, 1759, 6877
Virtual Machine (VM)

Supported virtualization platforms, 111, 115
Virus scanners, 116
Visible column , 3618
Visible property (VBS), 5733
VLAN, 833

Day, 923
Port VID, 923
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Priority, 923
VLAN ID, 836
VLAN tag, 835

VLAN operation, 703
VLAN tagging, 703
VMware - PC CPs, 47
VOID, 1363
Volume, 4783
VPN connection

Deleting CA certificates, 8130
Establishing, 8130
Installing CA certificate, 8127
Terminating, 8132

VPN connection is not established
Check and remedy, 8150

VPN group, 701
VRRP

Address overview, 969
Backup router, 840
Configuration, 968
Master router, 840
Router, 967
Virtual router, 840
VRRP router, 840
VRRP Statistics, 856

vsprintf function, 6046

W
WAIT, 2084, 2368, 2582
Wake on LAN, 2758
Wake-up call, 820
Wake-up SMS, 820
WAN IP address

Specifying, 712
Warm restart, 1068
Warning property (VBS), 5736
WarningColor property (VBS), 5736
WarningLowerLimit property (VBS), 5737
WarningLowerLimitColor property (VBS), 5738
WarningLowerLimitEnabled property (VBS), 5738
WarningLowerLimitRelative property (VBS), 5739
WarningRangeColor property (VBS), 5740
WarningRangeStart property (VBS), 5740
WarningRangeVisible property (VBS), 5741
WarningUpperLimit property (VBS), 5742
WarningUpperLimitColor property (VBS), 5742
WarningUpperLimitEnabled property (VBS), 5743
WarningUpperLimitRelative property (VBS), 5743
Watch table

 Meaning of the icons, 1774
Basic mode, 1772

Copying, 1776
Creating, 1775
Example of filling out a watch table, 1777
Expanded mode, 1772
Layout, 1772
Loading data blocks during an active control job, 
52
Meaning of the columns, 1772
Monitoring and modifying modes, 1786
Multiple access to the same CPU, 52
Opening, 1776
Overview of the display formats, 1781
Overview of the test options, 1771
Permitted operands, 1778
Permitted operands for modify values, 1779
Possible applications, 1771
Saving, 1777
Switching between basic mode and expanded 
mode, 1773
Syntax check, 1777
Testing wiring, 1771

Watchdog time, 1038
Watermarks

Report, 4298
WCHAR, 1347
Web access

WebNavigator, 7290, 7520
Web address, 3557, 3560
Web application, 792
Web authorization, 7413

Setting at the HMI-device, 7404
Web Control DB, 808
Web data blocks, 806
Web diagnostics client

Installation, 7515
Web pages in browser, 813
Web part

insert in WebCenter page, 7325
Web Part, 7325

Delete, 7330
Export, 7330
Minimize, 7330
Moving, 7330

Web server, 779, 786, 788, 792, 795, 806, 7443
Configure WinCC-Project , 7447
Enable, 789
Enumerations, 804
Fragment, 804
HTTPS, 790
Service-pages, 7444
User administration, 7412
Web authorization, 7412, 7413
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WebCenter, 7269
Access rights to directories, 7308
Create a WebCenter page, 7323
Layout template, 7320
Static process screens, 7317
Template file, 7320
User administration, 7305

WebCenter page
Create, 7323
Creating directory, 7307
Inserting web parts, 7325
Template file, 7320

WebNavigator
Configuring, 7517
Functions, 7494
Installation requirements, 7499
Publishing screens, 7294, 7524
Runtime settings, 7290, 7520
Terminal services, 7498
Transferring the project, 7294, 7524

WebNavigator client
Navigation interface, 7537

WebNavigator Client, 7513, 7514
Installation, 7507
Installation under the Windows Server, 7507
Operating projects, 7536

WebNavigator diagnostics client, 7499
WebNavigator Server

Installation, 7505
When dialog is closed, 4772
When dialog is opened, 4771
When high limit is exceeded, 4770
When low limit is undershot, 4771
WHILE, 2562
Width property (VBS), 5744
WinAC MP, 6778

HMI device, 6797
Transfer, 6796
Transfer to the HMI device, 6799
Transferring, 6797

WinACMPArchive, 4704
WinACMPClearCycleTimeBuffer, 4706
WinACMPControl, 4710
WinACMPGetStartMode, 4705
WinACMPGetVersion, 4705, 4880
WinACMPRestore, 4711
WinACMPSetHMIEnableTime, 4707
WinACMPSetKeySwitch, 4707
WinACMPSetSleeptime, 4708
WinACMPSetStart at boot, 4706, 4881
WinACMPSetStartMode, 4709, 4882
WinACMPStartHistogram, 4709

WinACMPStopHistogram, 4711
WinACMPUpdateAverageCycleTime, 4694
WinACMPUpdateAverageExecTime, 4693
WinACMPUpdateBUSF1LED, 4691
WinACMPUpdateBUSF2LED, 4692
WinACMPUpdateEXTFLED, 4695
WinACMPUpdateHMIEnableTime, 4696
WinACMPUpdateINTFLED, 4697
WinACMPUpdateKeySwitchSetting, 4690
WinACMPUpdateLastCycleTime, 4698
WinACMPUpdateMaximumCycleTime, 4699
WinACMPUpdateMinimumCycleTime, 4700
WinACMPUpdatePowerLED, 4700
WinACMPUpdateRUNLED, 4702
WinACMPUpdateStartupCharacteristics, 4689
WinACMPUpdateSTOPLED, 4703
WinACSetStartMode, 4709, 4882
WinCC

Limit access, 7059
Starting Runtime, 7015, 7078
WinCC MediaControl, 5068

WinCC Archive Connector, 7630
WinCC data provider

accessing, 7608
WinCC DataConnector, 7630
WinCC DataMonitor, (See DataMonitor)
WinCC flexible

Configuring, 6784
WinCC flexible project

Migrate, 199, 257
Migrating, 170

WinCC message system
Attributes, 7582
Display of the WinCC alarm classes and alarm 
methods, 7586
on OPC A&OPC-A&WinCC message system, 
7578
WinCC alarm methods on OPC A&E server, 
7586
WinCC Message Classes on OPC A&E Server, 
7586

WinCC OLE DB, 7628
Basics, 7628
Microsoft, 7628
WinCC, 7628

WinCC OLE DB Provider, 7630, 7635
Access to archive data, 7635
Linked Server, 7630
SQL Server, 7630

WinCC OPC A&E server
Condition Related Events, 7579
Configuring, 7589

Index

WinCC Professional V13.0
System Manual, 02/2014 8311



Simple Events, 7579
WinCC OPC Client

Configuring, 7555, 7605
WinCC OPC HDA Server

Configuring, 7576
WinCC OPC server

Accessibility, 7565
WinCC OPC UA Server, 7595

Configuring, 7576, 7603
Discovery Server, 7595

WinCC Professional system requirements, 113
WinCC project

Include in user group, 7061
WinCC projects, 7489

Activating remote, 7492
Calling, 7479
Remote deactivating, 7493

WinCC Push Button Control
Migration, 231

WinCC RT Advanced
HMI connection, 6228, 6308, 6310, 6394, 6409
Interface, 6196
MPI, 6407
PC, 6310
PROFIBUS, 6225, 6306, 6392
SIMATIC PC, 6208, 6308, 6373

WinCC RT Professional
HMI connection, 6227, 6228, 6308, 6310, 6394, 
6397, 6409, 6410
Interface, 6196
MPI, 6407
PC, 6205, 6227, 6290, 6310, 6376, 6397, 6410
PROFIBUS, 6225, 6306, 6392
SIMATIC PC, 6208, 6228, 6287, 6308, 6373, 
6394, 6409

WinCC Runtime
Available system functions, 4559

WinCC Runtime Advanced
Display and operating element, 3515
Interface, 6196

WinCC Runtime Advanced Internet, 7401
WinCC Runtime Professional

Interface, 6196
WinCC Runtime Professional Asian

Licensing, 126
WinCC system events, 4106
WinCC tag @RM_MASTER, 7385
WinCC tag @RM_MASTER_NAME, 7385
WinCC UserArchiveControl, (See 
UserArchiveControl), (See UserArchiveControl)
WinCC V7.0 SP3, 64

WinCC V7.2 project
Migrate, 218

WinCC version
Compatibility, 6959, 6961

WinCC flexible, 6787
WinCC flexible Runtime

Closing, 7058, 7079
WinCC RT Advanced

HMI connection, 6227, 6397, 6410
PC, 6205, 6227, 6290, 6376, 6397, 6410
SIMATIC PC, 6228, 6287, 6394, 6409

WinCC Runtime
Available system functions, 4564

WinCCViewerRT, 7269, 7497
Displaying screens, 7269, 7304, 7497
Monitoring projects, 7535
Setting up, 7302, 7533

Window, 4494
Window layouts

Changing order, 332
Deleting window layouts, 332

WindowCloseEnabled property (VBS), 5746
Windows, 7059

Access rights, 7059
User Rights, 7059

WindowSizingEnabled property (VBS), 5748
WindowSlider object, 5177
WindowsStyle property (VBS), 5748
Wire break, 1165, 1182
Wireless LAN/PB link, 1018
Wiring tests, 1771
Wizard

Device wizard, 6802, 6804
WLAN area, 6061
WLAN reception, 3645

Layout, 3645
WLanQualityView object, 5179
WORD, 1326, 1374, 1391
WORD_TO_, 1391
Work area

Effective range, 6075
Effective range (RFID), 6077
Embedding floating elements, 316
Floating elements, 316
Function, 311
Maximizing, 313
Maximizing elements, 318
Minimizing, 313
Minimizing elements, 318
Mobile Wireless, 6075
Mobile Wireless (RFID), 6077
Saving a layout of editors and tables, 332
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Splitting, 315
Switching between elements, 318
Using grouped elements, 316
Zone, 6073

Work memory, 1073, 1754
Working step

to create screens, 3306, 3307
WR_DPARM, 2806
WR_LOC_T, 2629
WR_REC, 2716
WR_SYS_T, 2627
WRIT_DBL, 51, 2916
Write field, 2008, 2289
Write memory address, 2513
Write memory area, 2516
Write memory bit, 2515
WRITE_BIG, 2523
WRITE_LITTLE, 2520
WriteTag, 5891
WriteToArrayDB, 2026, 2308, 2502
WriteToArrayDBL, 2032, 2314, 2506
Writing

A data record with WR_REC, 2716
Writing data

in remote CPU with PUT, 3197
To DP standard slaves/PROFINET IO devices 
with DPWR_DAT, 2719

Writing tags, 799
WRREC, 2676
WSTRING, 1316, 1349

Addressing, 1307
WWW (instruction), 807
WWW Synchronizing user-defined web pages, 3288

X
X axis

Configuring, 3840
X-axis property changed, 4778
XAxisAdd property (VBS), 5749
XAxisAlign(VBS), 5749
XAxisAutoPrecisions property (VBS), 5750
XAxisAutorange(i) property (VBS), 5750
XAxisBegin(i) property (VBS), 5751
XAxisBeginValue property (VBS), 5751
XAxisCount property (VBS), 5752
XAxisDecimalPrecision(i) property (VBS), 5753
XAxisEnd(i) property (VBS), 5753
XAxisExponentialFormat property (VBS), 5754
XAxisGridLineInterval(i) property (VBS), 5754
XAxisIndex property (VBS), 5755
XAxisInTrendColor property (VBS), 5755

XAxisLabel(i) property (VBS), 5756
XAxisLargeIncrementSize(i) property (VBS), 5756
XAxisMode(i) property (VBS), 5757
XAxisName property (VBS), 5757
XAxisPrecisions property (VBS), 5758
XAxisRemove property (VBS), 5758
XAxisRepos property (VBS), 5758
XAxisScalingType(i) property (VBS), 5759
XAxisShowGridLines(i) property (VBS), 5759
XAxisShowLargeIncrements(i) property (VBS), 5760
XAxisShowSmallIncrements(i) property (VBS), 5760
XAxisSmallIncrementSize(i) property (VBS), 5761
XAxisTrendWindow property (VBS), 5761
XDataLogTag(i) property (VBS), 5762
xlsx file, 6836, 6838, 6851, 6857, 6858
XML file

Create, 7344
Storage location, 7344

XOnlineTag(i) property (VBS), 5763
XOR, 1601, 1602, 2090, 2134, 2135, 2374

Y
Y axis

Configuring, 3840
Y-axis property changed, 4779
YAxisAdd property (VBS), 5763
YAxisAlign(VBS), 5764
YAxisAutoPrecisions property (VBS), 5764
YAxisBeginValue property (VBS), 5765
YAxisColor property (VBS), 5766
YAxisCount property (VBS), 5766
YAxisExponentialFormat property (VBS), 5767
YAxisIndex property (VBS), 5767
YAxisInTrendColor property (VBS), 5768
YAxisLabel property (VBS), 5768
YAxisName property (VBS), 5768
YAxisPrecisions property (VBS), 5769
YAxisRemove property (VBS), 5769
YAxisRename property (VBS), 5769
YAxisRepos property (VBS), 5770
YAxisTrendWindow property (VBS), 5771
YDataLogTag(i) property (VBS), 5771
YOnlineTag(i) property (VBS), 5772

Z
ZeroPoint property (VBS), 5773
Zone, 6061, 6062, 6073

Calculating quality, 3650
Configuring a screen change, 6080
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Displaying an object in relation to the zone, 6081
ID Zone, 6081
On entry, 3649
Work area, 6073
Zone ID, 3649
Zone ID / connection point ID, 6090

Zone name, 3649
Zone signal, 3650
ZoneLabelView object, 5180
ZoneQualityView object, 5181
Zones editor, 6073
Zoom

Adjusting the zoom setting, 504, 506, 509, 6129, 
6135, 6137
Keyboard operation, 519

Zoom functions
Runtime settings, 7065
Setting up, 7065

Zoomable property (VBS), 5774
ZoomArea, 5891
Zooming

Multi-touch devices, 94
Screen, 3305

ZoomInOut, 5892
ZoomInOutTime, 5892
ZoomInOutValues, 5893
ZoomInOutX, 5893
ZoomInOutY, 5894
ZoomMove, 5894
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